# Contents

<table>
<thead>
<tr>
<th>Chapter 1</th>
<th>Introduction</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>What's New in Autodesk 3ds Max 2010</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>3ds Max Documentation Set</td>
<td>17</td>
<td></td>
</tr>
<tr>
<td>About MAXScript</td>
<td>21</td>
<td></td>
</tr>
<tr>
<td>Copyrights and Trademarks</td>
<td>22</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 2</th>
<th>Getting Started with 3ds Max</th>
<th>25</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Workflow</td>
<td>26</td>
<td></td>
</tr>
<tr>
<td>Setting Up Your Scene</td>
<td>32</td>
<td></td>
</tr>
<tr>
<td>Modeling Objects</td>
<td>33</td>
<td></td>
</tr>
<tr>
<td>Using Materials</td>
<td>34</td>
<td></td>
</tr>
<tr>
<td>Placing Lights and Cameras</td>
<td>36</td>
<td></td>
</tr>
<tr>
<td>Animating Your Scene</td>
<td>40</td>
<td></td>
</tr>
<tr>
<td>Rendering Your Scene</td>
<td>41</td>
<td></td>
</tr>
<tr>
<td>The 3ds Max Window</td>
<td>42</td>
<td></td>
</tr>
<tr>
<td>Special Controls</td>
<td>46</td>
<td></td>
</tr>
<tr>
<td>Managing Files</td>
<td>51</td>
<td></td>
</tr>
<tr>
<td>Importing, Merging, Replacing, and Externally Referencing Scenes</td>
<td>54</td>
<td></td>
</tr>
<tr>
<td>Using the Asset Browser</td>
<td>57</td>
<td></td>
</tr>
<tr>
<td>Startup Files and Defaults</td>
<td>59</td>
<td></td>
</tr>
<tr>
<td>The Initialization File</td>
<td>60</td>
<td></td>
</tr>
<tr>
<td>Backing Up and Archiving Scenes</td>
<td>61</td>
<td></td>
</tr>
</tbody>
</table>
Chapter 3 Viewing and Navigating 3D Space

General Viewport Concepts .................................................. 66
Home Grid: Views Based on the World Coordinate Axes ............ 68
Understanding Views ............................................................ 72
Setting Viewport Layout ....................................................... 76
Controlling Viewport Rendering ........................................... 79
Controlling Display Performance ......................................... 81
Using Standard View Navigation ......................................... 82
Zooming, Panning, and Rotating Views .................................. 84
ViewCube .............................................................................. 86
   ViewCube Menu .................................................................... 88
   Change the View of the Scene with the ViewCube ............... 89
      Change the Current View .............................................. 89
      Set the View Projection Mode ..................................... 92
      Define the Home View ............................................. 93
SteeringWheels ..................................................................... 93
   Wheel Menu ....................................................................... 97
Navigation Wheels ............................................................... 98
      View Object Wheels .................................................... 99
      Tour Building Wheels ............................................. 100
      Full Navigation Wheels .......................................... 101
Navigation Tools ................................................................. 103
      Center Tool .................................................................. 103
      Forward Tool ............................................................ 104
      Look Tool .................................................................... 105
      Orbit Tool .................................................................... 107
      Pan Tool ....................................................................... 109
      Rewind Tool .............................................................. 109
      Up/Down Tool ............................................................ 111
      Walk Tool .................................................................... 112
      Zoom Tool .................................................................... 113
Using Walkthrough Navigation ............................................ 115
Navigating Camera and Light Views ....................................... 119
Adaptive Degradation ........................................................... 123
Grab Viewport ...................................................................... 125
View-Handling Commands .................................................. 126
      Undo View Change / Redo View Change ...................... 126
      Save Active View ...................................................... 127
      Restore Active View ................................................ 128
      Viewport Background Dialog ................................... 128
      Select Background Image Dialog .............................. 137
      Update Background Image ........................................ 142
      Reset Background Transform .................................... 143
      Show Transform Gizmo .............................................. 143
Select Similar ................................................. 228
Select By ....................................................... 229
  Select By Color ......................................... 229
  Select By Name (Edit Menu) .......................... 229
  Select By Layer ......................................... 230
Selection Region ........................................... 230
  Rectangular Selection Region .......................... 230
  Circular Selection Region .............................. 231
  Fence Selection Region ................................ 232
  Lasso Selection Region ................................ 233
  Paint Selection Region ................................ 234
  Select Region Window .................................. 235
  Region ...................................................... 237
  Select Region Crossing .................................. 237
  Window/Crossing Selection Toggle ....................... 239
Edit Commands ............................................. 239
  Undo/Redo ................................................ 240
  Hold/Fetch .............................................. 242
  Delete .................................................... 243
Groups and Assemblies .................................. 243
  Using Groups ........................................... 243
  Using Assemblies ....................................... 247
  Character Assembly .................................... 254
Group Commands ......................................... 258
  Group ..................................................... 258
  Open ..................................................... 260
  Close ..................................................... 260
  Ungroup .................................................. 261
  Explode ................................................... 261
  Detach .................................................... 262
  Attach ..................................................... 263
Assembly Commands ....................................... 263
  Assemble .................................................. 263
  Open Assembly .......................................... 267
  Close Assembly ......................................... 268
  Disassemble ............................................. 269
  Explode Assembly ...................................... 269
  Detach Assembly ........................................ 270
  Attach Assembly ........................................ 270
Assembly Head Helper Objects ............................ 270
  Assembly Head Helper Object .......................... 271
  Luminaire Helper Object ............................... 271
Character Assembly Commands ............................ 274
  Create Character ....................................... 274
  Destroy Character ...................................... 278
  Lock/Unlock Character .................................. 279
Chapter 5  **Object Properties**  ........................................ 283

Object Properties Dialog Panels ........................................ 283
  General Panel (Object Properties Dialog) ..................... 283
  Advanced Lighting Panel (Object Properties Dialog) .......... 295
  mental ray Panel (Object Properties Dialog) ............... 300
  User Defined Panel (Object Properties Dialog) .......... 303

Rename Objects Tool ..................................................... 306
Custom Attributes ......................................................... 307
Parameter Collector ....................................................... 325
  Parameter Collector Menu Bar .................................. 334
  Notes Dialog (Parameter Collector) ............................ 337
Expression Techniques ................................................... 339
  Trigonometric Functions ....................................... 349
  Vectors ............................................................... 352

Chapter 6  **Creating Geometry** ..................................... 357

Basics of Creating and Modifying Objects ......................... 358
  Using the Create Panel ........................................ 360
  Identifying the Basic Building Blocks ....................... 361
  Creating an Object ............................................... 364
Assigning Colors to Objects ........................................ 367
  Object Color Dialog ............................................. 368
  Color Selector Dialog ........................................... 371
  Color Clipboard Utility ....................................... 378
Adjusting Normals and Smoothing .................................. 380
  Viewing and Changing Normals ............................... 380
  Viewing and Changing Smoothing ............................ 383
Geometric Primitives ................................................... 385
Creating Primitives from the Keyboard ......................... 386
Standard Primitives .................................................... 388
  Box Primitive ...................................................... 389
  Cone Primitive ..................................................... 392
  Sphere Primitive .................................................. 396
  GeoSphere Primitive ........................................... 401
  Cylinder Primitive .............................................. 403
  Tube Primitive .................................................... 406
  Torus Primitive ................................................... 409
  Pyramid Primitive ................................................ 413
  Teapot Primitive .................................................. 416
  Plane Primitive .................................................... 419
Extended Primitives ..................................................... 421
Star Spline .................................................   .599
Text Spline ..............................................   .600
Helix Spline .............................................   .605
Section Spline ..........................................   .607
Extended Splines .......................................   .611
WRectangle Spline ....................................   .611
Channel Spline .........................................   .613
Angle Spline ............................................   .615
Tee Spline ................................................   .617
Wide Flange Spline ..................................   .618
Editable Spline .........................................   .620
Editable Spline (Object) ..............................   .630
Editable Spline (Vertex) ...............................   .634
Editable Spline (Segment) ..............................   .646
Editable Spline (Spline) ...............................   .655
Shape Check Utility .....................................   .665
Compound Objects ........................................   .667
Morph Compound Object ..................................   .667
Scatter Compound Object ...............................   .674
Conform Compound Object ...............................   .688
Connect Compound Object ...............................   .695
BlobMesh Compound Object .............................   .701
ShapeMerge Compound Object .........................   .709
Boolean Compound Object ..............................   .713
Material Attach Options Dialog .......................   .728
Terrain Compound Object ...............................   .730
Loft Compound Object ...................................   .742
Creation Method Rollout ...............................   .745
Surface Parameters Rollout ............................   .746
Path Parameters Rollout ................................   .750
Skin Parameters Rollout ................................   .753
Deformations .............................................   .770
Path Commands ...........................................   .790
Shape Commands .........................................   .790
Mesher Compound Object ...............................   .794
ProBoolean/ProCutter Compound Objects .............   .799
   ProBoolean Compound Object .......................   .801
   ProCutter Compound Object .........................   .823
Quad Meshing and Smoothing .........................   .831
Dynamics Objects ........................................   .841
Damper Dynamics Object ...............................   .842
Spring Dynamics Object ...............................   .849
Systems ...................................................   .856
Bones System .............................................   .857
Using Objects as Bones ................................  .870
Bone Tools ...............................................   .871

Contents | ix
Point Cache Modifier (World Space) ........................................... 1156
Subdivide Modifier (World Space) .............................................. 1156
Surface Mapper Modifier (World Space) ................................. 1156
SurfDeform Modifier (World Space) ........................................... 1159
Object-Space Modifiers .......................................................... 1159
Affect Region Modifier ........................................................... 1159
Attribute Holder Modifier ......................................................... 1163
Bend Modifier ................................................................. 1165
Bevel Modifier ............................................................... 1169
Bevel Profile Modifier ......................................................... 1176
Camera Map Modifier (Object Space) ........................................ 1180
Cap Holes Modifier ............................................................. 1185
Cloth and Garment Maker Modifiers ........................................ 1187
  Cloth Modifier ............................................................... 1204
  Garment Maker Modifier .................................................. 1266
CrossSection Modifier .......................................................... 1299
Delete Mesh Modifier ............................................................ 1305
Delete Patch Modifier ........................................................... 1307
Delete Spline Modifier .......................................................... 1308
Disp Approx Modifier ............................................................. 1310
Displace Modifier .............................................................. 1313
Edit Mesh Modifier ............................................................. 1321
Edit Normals Modifier .......................................................... 1322
Edit Patch Modifier ............................................................. 1329
Edit Poly Modifier ............................................................... 1332
  Selection Rollout (Edit Poly Modifier) ................................ 1346
  Edit Poly (Object) ............................................................ 1357
  Edit Poly (Vertex) ............................................................ 1359
  Edit Poly (Edge) ............................................................. 1368
  Edit Poly (Border) ........................................................... 1389
  Edit Poly (Polygon/Element) ............................................... 1395
  Edit Geometry Rollout (Polymesh and Edit Poly) .................... 1409
  Align Geometry Dialog .................................................... 1422
 Detach Dialog ................................................................. 1423
Edit Spline Modifier ............................................................ 1424
Extrude Modifier ................................................................. 1425
Face Extrude Modifier .......................................................... 1428
FFD (Free-Form Deformation) Modifiers .................................... 1431
FFD (Box/Cylinder) Modifiers ................................................ 1436
FFD (Free-Form Deformation) Select Modifier .......................... 1441
Fillet/Chamfer Modifier ......................................................... 1442
Flex Modifier ................................................................. 1445
  Spring Option Dialog ....................................................... 1462
HSDS Modifier ................................................................. 1464
  Adaptive Subdivision Dialog .............................................. 1472
<table>
<thead>
<tr>
<th>Modifier</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load Envelopes Dialog (Skin Modifier)</td>
<td>1693</td>
</tr>
<tr>
<td>Weight Tool Dialog (Skin Modifier)</td>
<td>1697</td>
</tr>
<tr>
<td>Weight Table (Skin Modifier)</td>
<td>1704</td>
</tr>
<tr>
<td>Skin Morph Modifier</td>
<td>1706</td>
</tr>
<tr>
<td>Skin Wrap Modifier</td>
<td>1717</td>
</tr>
<tr>
<td>Skin Wrap Patch Modifier</td>
<td>1726</td>
</tr>
<tr>
<td>Slice Modifier</td>
<td>1727</td>
</tr>
<tr>
<td>Smooth Modifier</td>
<td>1733</td>
</tr>
<tr>
<td>Spherify Modifier</td>
<td>1736</td>
</tr>
<tr>
<td>Spline IK Control Modifier</td>
<td>1738</td>
</tr>
<tr>
<td>Spline Select Modifier</td>
<td>1741</td>
</tr>
<tr>
<td>Squeeze Modifier</td>
<td>1744</td>
</tr>
<tr>
<td>STL Check Modifier</td>
<td>1746</td>
</tr>
<tr>
<td>Stretch Modifier</td>
<td>1749</td>
</tr>
<tr>
<td>Subdivide Modifier (Object Space)</td>
<td>1756</td>
</tr>
<tr>
<td>Substitute Modifier</td>
<td>1759</td>
</tr>
<tr>
<td>Surface Modifier</td>
<td>1763</td>
</tr>
<tr>
<td>SurfDeform Modifier (Object Space)</td>
<td>1774</td>
</tr>
<tr>
<td>Sweep Modifier</td>
<td>1776</td>
</tr>
<tr>
<td>Pick Shape Dialog (Sweep Modifier)</td>
<td>1796</td>
</tr>
<tr>
<td>Extract Shape Dialog (Sweep Modifier)</td>
<td>1798</td>
</tr>
<tr>
<td>Merge File (Sweep Modifier)</td>
<td>1799</td>
</tr>
<tr>
<td>Symmetry Modifier</td>
<td>1803</td>
</tr>
<tr>
<td>Taper Modifier</td>
<td>1807</td>
</tr>
<tr>
<td>Tessellate Modifier</td>
<td>1812</td>
</tr>
<tr>
<td>Trim/Extend Modifier</td>
<td>1815</td>
</tr>
<tr>
<td>TurboSmooth Modifier</td>
<td>1818</td>
</tr>
<tr>
<td>Turn To Mesh Modifier</td>
<td>1825</td>
</tr>
<tr>
<td>Turn To Patch Modifier</td>
<td>1827</td>
</tr>
<tr>
<td>Turn To Poly Modifier</td>
<td>1830</td>
</tr>
<tr>
<td>Twist Modifier</td>
<td>1833</td>
</tr>
<tr>
<td>UVW Mapping</td>
<td>1837</td>
</tr>
<tr>
<td>Unwrap UVW Modifier</td>
<td>1837</td>
</tr>
<tr>
<td>UVW Map Modifier</td>
<td>1932</td>
</tr>
<tr>
<td>UVW Mapping Add Modifier</td>
<td>1954</td>
</tr>
<tr>
<td>UVW Mapping Clear Modifier</td>
<td>1954</td>
</tr>
<tr>
<td>UVW Mapping Paste Modifier</td>
<td>1955</td>
</tr>
<tr>
<td>UVW XForm Modifier</td>
<td>1955</td>
</tr>
<tr>
<td>Vertex Weld Modifier</td>
<td>1957</td>
</tr>
<tr>
<td>VertexPaint Modifier</td>
<td>1959</td>
</tr>
<tr>
<td>VertexPaint Paintbox</td>
<td>1969</td>
</tr>
<tr>
<td>Adjust Color Dialog (VertexPaint Modifier)</td>
<td>1982</td>
</tr>
<tr>
<td>Color Palette (VertexPaint Modifier)</td>
<td>1984</td>
</tr>
<tr>
<td>Painter Options Dialog (VertexPaint Modifier)</td>
<td>1989</td>
</tr>
<tr>
<td>Volume Select Modifier</td>
<td>1992</td>
</tr>
<tr>
<td>Wave Modifier</td>
<td>2000</td>
</tr>
</tbody>
</table>
Chapter 10 Surface Modeling .................................................. 2013
Subdivision Surfaces .......................................................... 2013
Soft Selection Rollout ......................................................... 2014
Collapse Utility ................................................................. 2022
Graphite Modeling Tools ..................................................... 2025
    New Tools .................................................................... 2026
    The Ribbon Interface .................................................... 2030
        Using the Ribbon ..................................................... 2030
        Modeling Ribbon Controls ....................................... 2036
Graphite Modeling Tools Tab ................................................. 2045
    Polygon Modeling Panel ................................................ 2045
    Modify Selection Panel ................................................ 2063
    Edit Panel ................................................................ 2075
    Geometry (All) Panel .................................................... 2088
    [Sub-object] Panel ......................................................... 2099
    Loops Panel ................................................................ 2130
    Additional Panels ........................................................ 2147
Freeform Tab ................................................................ 2155
    PolyDraw Panel ........................................................... 2156
    Paint Deform Panel ....................................................... 2165
Selection Tab ................................................................ 2180
    General Selection Panels .............................................. 2180
    Select By Panels .......................................................... 2186
Editable Mesh Surface ......................................................... 2192
    Working with Mesh Sub-Objects ..................................... 2196
    Selection Rollout (Editable Mesh) .................................... 2198
    Editable Mesh (Object) .................................................. 2200
    Editable Mesh (Vertex) .................................................. 2203
    Editable Mesh (Edge) ..................................................... 2209
    Editable Mesh (Face/Polygon/Element) ........................... 2216
    Edit Geometry Rollout (Mesh) ......................................... 2220
    Attach Options Dialog (Editable Mesh) ............................ 2233
    Cut and Slice (Editable Mesh) .......................................... 2235
Editable Poly Surface ......................................................... 2240
    Selection Rollout (Polymesh) .......................................... 2245
    Editable Poly (Object) .................................................... 2256
    Editable Poly (Vertex) .................................................... 2258
    Editable Poly (Edge) ...................................................... 2269
    Editable Poly (Border) ................................................... 2289
    Editable Poly (Polygon/Element) ..................................... 2296
    Edit Geometry Rollout (Polymesh and Edit Poly) ............... 2311
Subdivision Surface Rollout (Polymesh) ................................. 2325
Subdivision Displacement Rollout (Polymesh) ......................... 2330
Paint Deformation Rollout (Polymesh) .......................... 2333
Editable Poly Settings Dialogs .................................... 2337
Bevel Polygons Dialog (Polymesh) ................................ 2337
Bridge Borders/Polygons Dialog (Polymesh) ..................... 2339
Bridge Edges Dialog (Polymesh) ................................... 2341
Chamfer Vertices/Edges/Borders Dialog (Polymesh) ............. 2344
Connect Edges Dialog (Polymesh) .................................. 2345
Extrude Polygons Along Spline Dialog (Polymesh) .............. 2347
Extrude Polygons Dialog (Polymesh) .............................. 2349
Extrude Vertices/Edges Dialog (Polymesh) ....................... 2350
Hinge Polygons From Edge Dialog (Polymesh) .................... 2352
Inset Polygons Dialog (Polymesh) .................................. 2353
MeshSmooth Selection Dialog (Polymesh) ......................... 2354
Preserve Map Channels Dialog (Polymesh) ....................... 2355
Relax Dialog (Polymesh) ........................................... 2357
Tessellate Selection Dialog (Polymesh) ........................... 2358
Weld Vertices/Edges Dialog (Polymesh) ........................... 2359
Patch Objects .......................................................... 2360
Editable Patch Surface ............................................... 2360
Selection Rollout (Editable Patch) ................................ 2366
Editable Patch (Object) ............................................. 2370
Editable Patch (Vertex) ............................................. 2373
Editable Patch (Handle) ............................................ 2380
Editable Patch (Edge) ............................................... 2382
Editable Patch (Patch) ............................................. 2385
Editable Patch (Element) .......................................... 2391
Geometry Rollout (Patch) ........................................... 2394
Patch Grids .............................................................. 2408
Quad Patch ............................................................. 2410
Tri Patch ................................................................. 2413
NURBS Modeling .......................................................... 2416
NURBS Models: Objects and Sub-Objects ......................... 2417
Creating NURBS Models ............................................. 2419
Working with NURBS Models ....................................... 2419
NURBS Surface Trimming ........................................... 2420
Modifying NURBS Models and Creating Sub-Objects .......... 2423
Quad Menu for NURBS Objects .................................... 2424
Using the NURBS Toolbox to Create Sub-Objects .............. 2426
NURBS Sub-Object Selection ....................................... 2428
CV Sub-Objects and Point Sub-Objects ............................ 2429
Dependent Sub-Objects (NURBS) ................................... 2433
Rigid NURBS Surfaces ............................................... 2436
NURBS and Modifiers ................................................ 2436
NURBS and Animation ............................................... 2439
NURBS Concepts ...................................................... 2440
NURBS Tips and Techniques ........................................ 2444
NURBS Surfaces .................................................. 2454
  Point Surface ............................................. 2456
  CV Surface .................................................. 2460
NURBS Curves ................................................ 2464
  Point Curve ................................................ 2466
  CV Curve .................................................... 2473
Creating NURBS Curve and Surface Objects .............. 2480
  Creating Independent Surfaces from NURBS Curve
     Objects ................................................... 2480
  Creating NURBS Curves from Splines .................... 2481
  Creating NURBS Surfaces from Geometric Primitives ... 2483
  Nonrelational NURBS Surfaces ......................... 2484
  Display Controls for NURBS Models ................... 2486
  Display Line Parameters for NURBS Surfaces ........... 2489
Creating and Editing NURBS Sub-Objects ................. 2490
  Attaching and Importing 3ds Max Objects ............. 2490
  Common Sub-Object Controls ............................ 2494
  Editing Point Sub-Objects ............................... 2496
  Editing Curve CV Sub-Objects ........................... 2503
  Editing Surface CV Sub-Objects ......................... 2509
  Editing Curve Sub-Objects ............................... 2518
  Editing Surface Sub-Objects ............................. 2530
  Soft Selection Rollout (NURBS) ......................... 2541
  Material Properties Rollout (NURBS) .................... 2544
  Creating Curve Sub-Objects .............................. 2549
  Creating Surface Sub-Objects ........................... 2603
  Creating and Editing Point Sub-Objects ............... 2694
  NURBS Editing Dialogs ..................................... 2708
NURBS Curve and Surface Approximation .................. 2736
  NURBS Curve Approximation .............................. 2736
  NURBS Surface Approximation ............................. 2737
  Advanced Surface Approximation Dialog (NURBS) ...... 2747
  Surface Approximation Utility (NURBS) ................. 2748
Tools for Low-Polygon Modeling .......................... 2760
  Show Statistics ........................................... 2760
  Level of Detail Utility ................................... 2762
  Optimization Modifiers ................................. 2767
  Batch ProOptimizer Utility .............................. 2768
  Batch ProOptimizer Rollout ............................. 2770
  Batch Optimization Dialog ............................... 2771

Chapter 11  **Precision and Drawing Aids** ............. 2781
  Tools for Precision ......................................... 2782
  Using Units .................................................. 2784
  Using Grids .................................................. 2785
    Using the Home Grid .................................... 2787

Contents | xvii
| Using Grid Objects                                      | 2789 |
| Viewing Grid Objects                                    | 2791 |
| AutoGrid                                               | 2792 |
| Grid Commands                                          | 2796 |
| Show Home Grid                                         | 2796 |
| Activate Home Grid                                     | 2797 |
| Activate Grid Object                                   | 2797 |
| Align Grid to View                                     | 2798 |
| Alignment                                              | 2799 |
| Aligning Objects                                       | 2799 |
| Aligning Normals                                       | 2803 |
| Using Snaps                                            | 2804 |
| Snap Commands                                          | 2807 |
| 2D Snap, 2.5D Snap, 3D Snap                            | 2807 |
| Angle Snap Toggle                                      | 2810 |
| Percent Snap Toggle                                    | 2811 |
| Spinner Snap Toggle                                    | 2811 |
| Ortho Snapping Mode                                    | 2812 |
| Polar Snapping Mode                                    | 2814 |
| Setting Snap Options                                   | 2816 |
| Grid and Snap Settings                                 | 2819 |
| Snap Settings                                          | 2819 |
| Snap Override                                          | 2826 |
| Snap Options                                           | 2828 |
| Home Grid Settings                                     | 2833 |
| User Grid Settings                                     | 2836 |
| Helpers                                                | 2837 |
| Select And Manipulate                                  | 2838 |
| Standard Helper Objects                                | 2839 |
| Dummy Helper                                           | 2840 |
| Expose Transform Helper                                | 2841 |
| Grid Helper                                            | 2847 |
| Point Helper                                           | 2853 |
| Tape Helper                                            | 2855 |
| Protractor Helper                                      | 2858 |
| Compass Helper                                         | 2860 |
| Manipulator Helper Objects                             | 2861 |
| Cone Angle Manipulator                                 | 2861 |
| Plane Angle Manipulator                                | 2865 |
| Slider Manipulator                                     | 2868 |
| Drawing Assistants                                     | 2873 |
| xView                                                  | 2873 |
| Measuring Distances                                    | 2878 |
| Measure Distance Tool                                  | 2881 |
| Measure Utility                                        | 2882 |
| Rescale World Units Utility                            | 2884 |
Chapter 13 Animation ................................................................. 3367
  Animation Concepts and Methods ........................................... 3368
    Animation Concepts .......................................................... 3368
    Using Auto Key Mode ......................................................... 3373
    Using Set Key Mode .......................................................... 3376
    Spinner Right-Click Menu ..................................................... 3380
    Viewing and Copying Transform Keys ...................................... 3382
    Controlling Time .............................................................. 3385
    Setting Time Segments ....................................................... 3387
    Moving Through Time ........................................................ 3388
    Choosing a Frame Rate and Playback Speed ............................ 3390
  Working with Controllers .................................................... 3391
    Understanding Controllers ................................................ 3392
    Changing Controller Properties ......................................... 3395
    Assigning Controllers ...................................................... 3397
    Specifying Default Controllers ......................................... 3400
    General-Purpose Controllers .............................................. 3401
    Special-Purpose Controllers .............................................. 3403
    Explicit Axis Keys ........................................................... 3404
    Float Controllers ............................................................ 3405
    Controlling Transforms ..................................................... 3406
    Controlling Position ........................................................ 3407
    Controlling Rotation ........................................................ 3408
    Controlling Colors ........................................................... 3409
    Morph Controllers ............................................................ 3410
  Motion Panel Commands ....................................................... 3411
    Trajectories ................................................................. 3411
    PRS Parameters Rollout ..................................................... 3416
    Key Info (Basic) Rollout/Dialog ......................................... 3418
    Tangent Types ............................................................... 3420
    Key Info (Advanced) Rollout/Dialog .................................... 3422
  Animation Controllers ....................................................... 3424
    Audio Controller ............................................................. 3425
    Audio Controller Dialog .................................................... 3426
    Barycentric Morph Controller ............................................ 3429
    Barycentric Morph Controller Key Info Dialog ....................... 3431
    Bezier Controllers .......................................................... 3432
    Block Controller ............................................................ 3436
      Attach Controls Dialog (Block Controller) .......................... 3442
      Block Parameters Dialog (Block Controller) ......................... 3444
      Master Block Parameters Dialog (Block Controller) ............... 3444
      Slave Parameters Dialog (Block Controller) ......................... 3446
      Track View Pick Dialog (Block Controller) .......................... 3448
    Boolean Controller ........................................................ 3449
    Color RGB Controller (Point3 XYZ Controller) ....................... 3451
    Euler XYZ Rotation Controller ............................................ 3453
Animating with Forward Kinematics ........................................... 3642
Using Dummy Objects ......................................................... 3651
Animating Links ................................................................. 3653
Adjusting Object Transforms ................................................ 3656
Locking Object Transforms .................................................. 3657
Animating Attachment ....................................................... 3658
Changing Link Inheritance .................................................. 3659
Link Inheritance (Selected) Utility ........................................ 3660
Inverse Kinematics (IK) ........................................................ 3661
IK Terminology ........................................................................ 3665
Inverse Kinematics Methods .................................................. 3667
Joint Controls .......................................................................... 3753
Hierarchy Panel Commands .................................................... 3761
Pivot ....................................................................................... 3762
IK .......................................................................................... 3772
Link Info .................................................................................. 3787
Track View ............................................................................... 3790
Working with Track View ....................................................... 3794
Track View Workspace ............................................................ 3795
Curve Editor Introduction ........................................................ 3804
Dope Sheet ............................................................................. 3805
Time Ruler ............................................................................... 3810
Track View Shortcuts .............................................................. 3810
Track View Hierarchy ............................................................... 3817
Track View Hierarchy Icons .................................................... 3824
Hierarchy Right-Click Menu .................................................... 3825
Properties (Track View Hierarchy) ........................................... 3832
Sound ...................................................................................... 3833
Track View Menu Bar .............................................................. 3849
Modes Menu ........................................................................... 3849
Controller Menu ..................................................................... 3849
Tracks Menu ........................................................................... 3853
Keys Menu ............................................................................... 3853
Curves Menu .......................................................................... 3855
Time Menu ............................................................................... 3856
Options Menu ......................................................................... 3856
Display Menu .......................................................................... 3862
View Menu ............................................................................... 3867
Utilities Menu ......................................................................... 3867
Track View Quad Menus .......................................................... 3870
Track View Toolbars ............................................................... 3873
Curve Editor Toolbars ............................................................. 3873
Dope Sheet Toolbars ............................................................... 3879
Name Toolbar .......................................................................... 3883
Controllers Toolbar ................................................................. 3884
Tools Toolbar .......................................................................... 3885
Ranges Toolbar (Dope Sheet) .......................... 3886
Extras Toolbar (Dope Sheet) .................. 3887
Filtering Track View Display .................. 3888
Filters Dialog (Track View) .................. 3889
Managing Controllers .......................... 3894
Copy Controller .......................... 3894
Paste Controller .......................... 3895
Assign Controller .......................... 3897
Delete Controller .......................... 3899
Ignore Animation Range .................. 3900
Respect Animation Range .................. 3901
Make Controller Unique .................. 3902
Note Tracks .................................. 3903
Add Note Track .................................. 3903
Remove Note Track .................. 3906
Editing Keys .................................. 3906
Edit Keys .................................. 3906
Snap Frames .................................. 3907
Lock Selection .................................. 3909
Align to Cursor .................................. 3909
Add Visibility Track .................. 3910
Move Keys (Dope Sheet) .................. 3913
Slide Keys .................................. 3914
Scale Keys - Time .......................... 3916
Add Keys (Dope Sheet) .................. 3917
Properties (Track View Key Window) ................. 3918
Track View Utilities .......................... 3919
Randomize Keys Utility .................. 3921
Create Out of Range Keys Utility ................. 3923
Select Keys By Time Utility .................. 3925
Euler Filter .................................. 3926
Soft Selection Settings .................. 3927
Current Value Editor .................. 3928
Edit Time .................................. 3929
Select Time .................................. 3930
Delete Time .................................. 3932
Cut Time .................................. 3932
Copy Time .................................. 3933
Paste Time .................................. 3934
Reverse Time .................................. 3936
Insert Time .................................. 3937
Scale Time .................................. 3937
Exclude Left End Point .................. 3938
Exclude Right End Point .................. 3940
Reduce Keys .................................. 3941
Edit Ranges .................................. 3943
Position Ranges .................................................. 3944
Recouple Ranges ................................................ 3945
Editing Tracks: Copying, Pasting, and Handling Instances and
References ....................................................... 3946
  Copying and Pasting Items ................................... 3946
  Copying and Pasting Objects ................................. 3948
  Making Instance and Reference Controllers and Objects
    Unique .......................................................... 3950
Curve Editor ..................................................... 3951
  Move Keys (Curve Editor) ..................................... 3953
  Scale Keys ...................................................... 3954
  Scale Values .................................................... 3955
  Add Keys (Curve Editor) ....................................... 3956
  Draw Curves ..................................................... 3957
  Show Tangents .................................................. 3958
  Lock Tangents ................................................... 3960
  Parameter Curve Out-of-Range Types ....................... 3961
  Apply Ease Curve / Apply Multiplier Curve ................. 3964
  Remove Ease/Multiplier Curve ............................... 3965
  On/Off (Curves) ................................................ 3966
  Ease Curve Out-of-Range Types ............................. 3966
  Multiplier Curve Out-of-Range Types ....................... 3968
  Freeze Non-Selected Curves .................................. 3970
Status Bar and View Controls ................................. 3971
  Track Selection Toolbar ...................................... 3971
  Key Stats Toolbar .............................................. 3981
  Navigation Toolbar ............................................ 3984
Managing Track View Windows ................................. 3989
  New Track View ................................................ 3989
  Delete Track View .............................................. 3990
  Saved Track Views ............................................. 3991
Customizing the Track View Window .................... 3992
Track View Toolbar Right-Click Menu .................... 3999
Motion Mixer ................................................... 4001
Using the Motion Mixer ....................................... 4002
  Adding Tracks to the Mixer .................................. 4007
  Importing Clips to the Mixer ............................... 4011
  Working with Clips in the Mixer ......................... 4015
  Filtering Mixer Tracks ........................................ 4018
  Adjusting Clip Timing ........................................ 4023
  Working with Transitions .................................... 4026
  Adjusting Track Weight ....................................... 4032
  Adding Time Warps .............................................. 4034
  Adjusting Biped Balance in the Mixer ..................... 4038
  Exporting Animation to the Biped ......................... 4043
  Using the Reservoir .......................................... 4047
Chapter 15  character studio  .............................................. 4465

What Is character studio? .............................................. 4466
What You Should Know to Use character studio ............ 4467
Understanding Biped .................................................. 4468
Understanding Physique ............................................. 4470
Understanding Track Editing ....................................... 4473
Understanding the Workbench ..................................... 4475
Understanding Motion Flow ......................................... 4476
Understanding Crowds ................................................ 4478
Understanding character studio Workflow ...................... 4480
Biped ................................................................. 4487
  Creating a Biped .................................................... 4490
  Understanding Biped Anatomy ................................... 4492
  Changing Initial Biped Anatomy ................................. 4494
  Naming the Biped .................................................. 4494
  Posing the Biped .................................................. 4496
  Scaling Links ........................................................ 4505
  Rubber-Banding Arms and Legs ................................. 4507
  Biped Display Options ........................................... 4510
  Deleting a Biped ................................................... 4510
  Linking Character Body Parts to the Biped ................. 4511
  Saving and Loading FIG Files .................................... 4513
Footstep Animation ................................................... 4515
  Creating Footsteps .................................................. 4522
  Editing Footstep Motion .......................................... 4537
  Footstep and Freeform Animation ............................... 4564
Freeform Animation .................................................. 4571
  Creating Freeform Animation .................................... 4575
  Freeform and IK ..................................................... 4598
  Editing Freeform Animation ..................................... 4618
Working with Biped Animation .................................... 4631
  Working with Euler Curves on Biped Animation ............ 4631
  Working with XRef Bipeds ......................................... 4635
Loading, Saving, and Displaying Biped Motion ................. 4636
  Working with Biped Motion Files ............................... 4636
  Loading and Saving BIP Animation ............................. 4638
  Importing and Exporting Animation Data ...................... 4640
  Motion Mapping: Retargeting Biped Motion ................... 4640
  Merging and Cloning a Character ................................ 4642
  Combining BIP Motions ............................................ 4645
  Loading and Saving STP Files .................................... 4646
  Using Motion-Capture Data ....................................... 4647
  Correcting Posture .................................................. 4648
Copying and Pasting Tracks ...................... 4649
Repositioning the Biped ......................... 4651
Previewing Biped Motion ........................ 4654
In Place Mode .................................. 4656
Trajectory Display .............................. 4657
Display Preferences ............................. 4659
Biped User Interface ............................. 4661
Motion Panel (Biped) ............................ 4662
Center of Mass .................................. 4663
Motion Panel Rollouts (Biped) ................. 4666
Track View (Biped) .............................. 4801
Biped Color-coded Keys and Trajectories .... 4806
Biped Shortcuts ................................. 4811
Working with the Workbench .................... 4816
Navigating the Workbench ...................... 4818
Selecting Workbench Tracks ..................... 4821
Analyzing Curves ................................ 4822
Fixing Curves ................................... 4823
Workbench User Interface ...................... 4823
Working with Motion Flow ...................... 4848
Placing Motions on the Motion Flow Graph .... 4850
Creating Transitions ............................ 4853
Creating a Motion Flow Script ................. 4858
Saving, Loading, and Appending Motion Flow
   Graphs ........................................ 4861
Customizing Transitions ......................... 4865
Creating Random Motion ........................ 4868
Unifying Motion .................................. 4873
Sharing Motion Flow ............................. 4876
Setting Up Paths for Motion Flow Files ....... 4883
Motion Flow Mode ............................... 4886
Working with Motion-Capture Data ............. 4916
Importing Motion-Capture Data .................. 4918
Filtering Motion-Capture and Marker Data .... 4919
Sliding Footsteps ................................ 4923
Prop Bone ........................................ 4924
Motion Capture Rollout ......................... 4925
Physique ....................................... 4944
Using Physique ................................. 4946
Creating a Skin .................................. 4946
Using Physique with a Biped .................... 4956
Using Physique with 3ds Max Bones .......... 4958
Using Physique with 3ds Max Objects ......... 4963
Applying and Initializing Physique ............ 4966
Previewing Motion ................................ 4968
Envelopes ....................................... 4970
Chapter 17  Material Editor, Materials, and Maps  
Designing Materials  
Sample Slots and Material Name  
Choosing a Material Type  
Lights and Shading  
Applying a Material to an Object  
Using Maps to Enhance a Material  
Mapping Coordinates  
Saving a Material  
Material XML Exporter Utility  
Material Editor  
Copying and Pasting: Right-Click Menu for Materials, Maps, Bitmaps, and Colors  
Sample Slots  
Sample Slot Right-Click Menu  
Dragging and Dropping Maps and Materials  
Drag and Drop Sub-Object Material Assignment  
Creating a Custom Sample Object  
Material Editor Tools  
Material Editor Menu Bar  
Reflectance and Transmittance Display  
Sample Type  
Propagate Materials to Instances  
Backlight  
Sample Slot Background  
Sample UV Tiling  
Video Color Check  
Make Preview, Play Preview, Save Preview  
Material Editor Options
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>mental ray Materials</td>
<td>5772</td>
</tr>
<tr>
<td>ProMaterials</td>
<td>5772</td>
</tr>
<tr>
<td>Arch &amp; Design Material (mental ray)</td>
<td>5858</td>
</tr>
<tr>
<td>Special-Purpose mental ray Materials</td>
<td>5921</td>
</tr>
<tr>
<td>Standard Material and Related Materials (Not Photometric)</td>
<td>5960</td>
</tr>
<tr>
<td>Shading Type</td>
<td>5960</td>
</tr>
<tr>
<td>Standard Material</td>
<td>5962</td>
</tr>
<tr>
<td>Raytrace Material</td>
<td>6064</td>
</tr>
<tr>
<td>Matte/Shadow Material</td>
<td>6099</td>
</tr>
<tr>
<td>Compound Materials</td>
<td>6106</td>
</tr>
<tr>
<td>Ink ‘n Paint Material</td>
<td>6132</td>
</tr>
<tr>
<td>Photometric Materials (Non-mental ray)</td>
<td>6148</td>
</tr>
<tr>
<td>Architectural Material</td>
<td>6148</td>
</tr>
<tr>
<td>Advanced Lighting Override Material</td>
<td>6166</td>
</tr>
<tr>
<td>Materials to Support Hardware Shading and Rendering to Texture</td>
<td>6174</td>
</tr>
<tr>
<td>Shell Material</td>
<td>6174</td>
</tr>
<tr>
<td>DirectX Shader Material</td>
<td>6175</td>
</tr>
<tr>
<td>XRef Material</td>
<td>6183</td>
</tr>
<tr>
<td>Maps and Shaders</td>
<td>6185</td>
</tr>
<tr>
<td>Real-World Mapping</td>
<td>6188</td>
</tr>
<tr>
<td>Output Rollout</td>
<td>6192</td>
</tr>
<tr>
<td>Missing Map Coordinates Dialog</td>
<td>6198</td>
</tr>
<tr>
<td>UVW Remove Utility</td>
<td>6200</td>
</tr>
<tr>
<td>2D Maps</td>
<td>6200</td>
</tr>
<tr>
<td>Coordinates Rollout (2D)</td>
<td>6201</td>
</tr>
<tr>
<td>Noise Rollout (2D)</td>
<td>6211</td>
</tr>
<tr>
<td>Bitmap 2D Map</td>
<td>6213</td>
</tr>
<tr>
<td>Checker Map</td>
<td>6227</td>
</tr>
<tr>
<td>Combustion Map</td>
<td>6229</td>
</tr>
<tr>
<td>Gradient Map</td>
<td>6253</td>
</tr>
<tr>
<td>Gradient Ramp Map</td>
<td>6258</td>
</tr>
<tr>
<td>Swirl Map</td>
<td>6266</td>
</tr>
<tr>
<td>Tiles Map</td>
<td>6269</td>
</tr>
<tr>
<td>3D Maps</td>
<td>6278</td>
</tr>
<tr>
<td>Coordinates Rollout (3D)</td>
<td>6278</td>
</tr>
<tr>
<td>Cellular Map</td>
<td>6279</td>
</tr>
<tr>
<td>Dent Map</td>
<td>6286</td>
</tr>
<tr>
<td>Falloff Map</td>
<td>6294</td>
</tr>
<tr>
<td>Marble Map</td>
<td>6300</td>
</tr>
<tr>
<td>Noise Map</td>
<td>6303</td>
</tr>
<tr>
<td>Particle Age Map</td>
<td>6306</td>
</tr>
<tr>
<td>Particle MBlur Map</td>
<td>6308</td>
</tr>
<tr>
<td>Perlin Marble Map</td>
<td>6310</td>
</tr>
<tr>
<td>Smoke Map</td>
<td>6313</td>
</tr>
</tbody>
</table>
Chapter 18  Rendering .......................... 6505
  Render Setup Dialog .......................... 6506
  Rendered Frame Window ....................... 6513
  mental ray Rendering Options ............... 6524
  Render Output File Dialog .................... 6529
  View Image File ............................. 6535
  Rendering Commands .......................... 6538
  Render Setup ................................. 6539
Contents
Strips Setup Dialog ........................................ 6967
Advanced Settings Dialog .................................. 6970
Manager and Server ........................................ 6974
   Initial Setup for Manager and Server Programs .... 6974
Installing Network Services ............................... 6976
Logging Properties Dialog ................................ 6978
The backburner.xml File ................................... 6981
Network Rendering Manager ............................... 6982
Network Rendering Server ................................ 6989
The Queue Monitor Application .......................... 6995
   Module Info Report Dialog .............................. 7006
   Queue Monitor: Job Settings Dialog ................ 7008
Viewing Jobs and Servers with the Queue Monitor .... 7013
   Job Report Dialog ...................................... 7014
   Job Archives Dialog ................................... 7016
Activating and Deactivating Jobs in the Queue ........ 7017
Activating and Deactivating Servers in the Queue ..... 7018
Managing Jobs in the Queue .............................. 7019
   Week Schedule Dialog ................................ 7020
Batch Rendering .......................................... 7021
   Quick Start Batch Rendering .......................... 7022
Using Backburner for Batch Rendering .................. 7023
   Batch Rendering: Batch Render Dialog ............... 7026
   Batch Render Tool: Batch Render Warning Dialog .. 7033
Command-Line Rendering ................................ 7035
   Command-Line Rendering Switches ................... 7039
Backburner Command Line Control ....................... 7052

Chapter 19 Effects and Environments .................... 7055
   Environment and Effects Dialog ....................... 7056
   Rendering Effects ...................................... 7057
   Rendering Effects Command ........................... 7058
   Effects Panel and Rollout .............................. 7058
   Merging Effects ........................................ 7060
   Hair And Fur Render Effect ............................ 7061
Lens Effects Rendering Effects .......................... 7068
   Glow Lens Effect ....................................... 7073
   Ring Lens Effect ....................................... 7080
   Ray Lens Effect ........................................ 7090
   Auto Secondary Lens Effect ........................... 7097
   Manual Secondary Lens Effect ......................... 7105
   Star Lens Effect ...................................... 7112
   Streak Lens Effect ..................................... 7119
Lens Effects Dialogs ...................................... 7126
Blur Rendering Effect ..................................... 7141
Brightness and Contrast Rendering Effect ............... 7149

Contents | xxxvii
Chapter 20  Video Post ................................. 7247

Video Post Queue ..................................... 7248
Video Post Status Bar / View Controls ........... 7250
Troubleshooting Video Post ........................ 7252
Useful Video Post Procedures ...................... 7255
Video Post Toolbar .................................... 7271
New Sequence ....................................... 7271
Open Sequence ...................................... 7272
Save Sequence ....................................... 7273
Edit Current Event ................................... 7273
Delete Current Event ................................ 7274
Swap Events ......................................... 7275
Execute Sequence .................................... 7276
Configure Presets .................................... 7278
Edit Range Bar ....................................... 7279
Align Selected Left .................................. 7280
Align Selected Right ................................ 7281
Make Selected Same Size ............................ 7281
Abut Selected ........................................ 7282
Add Scene Event ...................................... 7282
Add Image Input Event ............................... 7288
Image Input Options .................................. 7292
Missing External Files Dialog ........................................ 7612
File-Handling Utilities ............................................. 7614
   Asset Browser Utility ........................................ 7614
      Preferences Dialog (Asset Browser) ....................... 7625
      Internet Download Dialog ................................ 7626
      Favorite Location Dialog ................................ 7628
Bitmap/Photometric Path Editor Utility ......................... 7629
   Bitmap / Photometric Path Editor Dialog ................. 7630
   Resource Information Dialog ............................... 7633
MAX File Finder Utility ......................................... 7634
   Resource Collector Utility ................................ 7637
   Fix Ambient Utility ....................................... 7639
   Bitmap Pager Statistics Dialog ........................... 7642
Internet Access .................................................. 7643
   i-drop Indicator ........................................... 7644
Geometry File Formats .......................................... 7645
   Working with MAX Files from Autodesk VIZ ............. 7647
VIZ Render (DRF) Files ......................................... 7650
   Working with DRF Files in 3ds Max ...................... 7653
3D Studio Mesh (3DS, PRJ) Files .............................. 7655
   Importing 3DS Files .................................. 7655
   Importing PRJ Files .................................. 7657
   Exporting to 3DS ..................................... 7659
Importing SHP Files ........................................... 7660
Adobe Illustrator Files ......................................... 7661
   Importing Adobe Illustrator 88 Files .................... 7662
   Exporting to Adobe Illustrator .......................... 7662
Exporting to ASCII ............................................. 7663
AutoCAD (DWG) Files ........................................... 7665
   Importing AutoCAD Drawing Files ....................... 7666
   DWG/DXF Import: Geometry Panel ...................... 7670
   DWG/DXF Import: Layers Panel .......................... 7680
   DWG/DXF Import: Spline Rendering Panel ............ 7682
   Legacy AutoCAD Import ................................ 7685
   Exporting AutoCAD DWG Files ........................... 7690
AutoCAD Interchange (DXF) Files .............................. 7693
   Importing DXF Files .................................. 7693
   Exporting to DXF Files ................................ 7694
Importing Autodesk Inventor Files ............................ 7695
Exporting 3D DWF Files ....................................... 7700
FBX Files: Data Sharing with Maya, MotionBuilder, Revit,
   Softimage, and Toxik .................................... 7706
OpenFlight (FLT) Files ........................................ 7707
   Importing OpenFlight (FLT) Files ...................... 7712
   Exporting OpenFlight (FLT) Files ..................... 7714
<table>
<thead>
<tr>
<th>File Format</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flight Studio Utility</td>
<td>7716</td>
</tr>
<tr>
<td>IGES Files</td>
<td>7727</td>
</tr>
<tr>
<td>Overview of IGES in 3ds Max</td>
<td>7727</td>
</tr>
<tr>
<td>IGES Log Files</td>
<td>7729</td>
</tr>
<tr>
<td>Importing IGES Files</td>
<td>7730</td>
</tr>
<tr>
<td>IGES to 3ds Max Import Table</td>
<td>7732</td>
</tr>
<tr>
<td>Exporting IGES Files</td>
<td>7734</td>
</tr>
<tr>
<td>3ds Max to IGES Export Table</td>
<td>7736</td>
</tr>
<tr>
<td>JSR-184 Files</td>
<td>7737</td>
</tr>
<tr>
<td>JSR-184 Object Parameters</td>
<td>7741</td>
</tr>
<tr>
<td>JSR-184 Texture Tool</td>
<td>7746</td>
</tr>
<tr>
<td>JSR-184 Log Files</td>
<td>7747</td>
</tr>
<tr>
<td>JSR-184 Standalone Player</td>
<td>7749</td>
</tr>
<tr>
<td>LandXML (XML, DEM) Files</td>
<td>7752</td>
</tr>
<tr>
<td>Importing LandXML/DEM Models</td>
<td>7752</td>
</tr>
<tr>
<td>LandXML/DEM Model Import Dialog</td>
<td>7753</td>
</tr>
<tr>
<td>Lightscape Files (LP, LS, and Other Formats)</td>
<td>7756</td>
</tr>
<tr>
<td>Lightscape Materials Utility</td>
<td>7759</td>
</tr>
<tr>
<td>Motion Analysis Files (HTR/HTR2, TRC)</td>
<td>7762</td>
</tr>
<tr>
<td>Importing HTR/HTR2 Files</td>
<td>7762</td>
</tr>
<tr>
<td>Importing TRC Files</td>
<td>7765</td>
</tr>
<tr>
<td>Exporting HTR/HTR2 Files</td>
<td>7766</td>
</tr>
<tr>
<td>Exporting to Shockwave 3D</td>
<td>7769</td>
</tr>
<tr>
<td>Shockwave 3D Scene Export Options Dialog</td>
<td>7770</td>
</tr>
<tr>
<td>Shockwave 3D Export Preview</td>
<td>7777</td>
</tr>
<tr>
<td>Shockwave 3D File Analysis Window</td>
<td>7779</td>
</tr>
<tr>
<td>Stereolithography (STL) Files</td>
<td>7781</td>
</tr>
<tr>
<td>Importing STL Files</td>
<td>7781</td>
</tr>
<tr>
<td>Exporting to STL</td>
<td>7784</td>
</tr>
<tr>
<td>Wavefront (OBJ) Files</td>
<td>7785</td>
</tr>
<tr>
<td>Exporting Wavefront Object (OBJ) Files</td>
<td>7786</td>
</tr>
<tr>
<td>Importing Wavefront Object (OBJ) Files</td>
<td>7789</td>
</tr>
<tr>
<td>Map-Export Dialog (OBJ)</td>
<td>7796</td>
</tr>
<tr>
<td>VRML Files</td>
<td>7798</td>
</tr>
<tr>
<td>Importing VRML Files</td>
<td>7798</td>
</tr>
<tr>
<td>Exporting to VRML97</td>
<td>8000</td>
</tr>
<tr>
<td>Image File Formats</td>
<td>7831</td>
</tr>
<tr>
<td>AVI Files</td>
<td>7832</td>
</tr>
<tr>
<td>BMP Files</td>
<td>7834</td>
</tr>
<tr>
<td>CIN (Kodak Cineon) Files</td>
<td>7834</td>
</tr>
<tr>
<td>CWS (Combustion Workspace) Files</td>
<td>7835</td>
</tr>
<tr>
<td>DDS Files</td>
<td>7836</td>
</tr>
<tr>
<td>EPS and PS (Encapsulated PostScript) Files</td>
<td>7839</td>
</tr>
<tr>
<td>GIF Files</td>
<td>7841</td>
</tr>
<tr>
<td>IFL Files</td>
<td>7841</td>
</tr>
<tr>
<td>Image File List Control Dialog</td>
<td>7844</td>
</tr>
<tr>
<td><strong>Contents</strong></td>
<td></td>
</tr>
<tr>
<td>--------------</td>
<td>---</td>
</tr>
<tr>
<td>IFL Manager Utility</td>
<td>7845</td>
</tr>
<tr>
<td>IMSQ Files</td>
<td>7847</td>
</tr>
<tr>
<td>JPEG Files</td>
<td>7848</td>
</tr>
<tr>
<td>MOV (QuickTime Movie) Files</td>
<td>7849</td>
</tr>
<tr>
<td>MPEG Files</td>
<td>7850</td>
</tr>
<tr>
<td>OpenEXR Files</td>
<td>7850</td>
</tr>
<tr>
<td>Saving OpenEXR Files</td>
<td>7852</td>
</tr>
<tr>
<td>Opening OpenEXR Files</td>
<td>7857</td>
</tr>
<tr>
<td>PIC Files</td>
<td>7861</td>
</tr>
<tr>
<td>PNG Files</td>
<td>7862</td>
</tr>
<tr>
<td>PSD Files</td>
<td>7863</td>
</tr>
<tr>
<td>Radiance Image Files</td>
<td>7866</td>
</tr>
<tr>
<td>RLA Files</td>
<td>7873</td>
</tr>
<tr>
<td>RPF Files</td>
<td>7875</td>
</tr>
<tr>
<td>RGB (SGI Image) Files</td>
<td>7877</td>
</tr>
<tr>
<td>TGA (Targa) Files</td>
<td>7878</td>
</tr>
<tr>
<td>TIFF Files</td>
<td>7880</td>
</tr>
<tr>
<td>YUV Files</td>
<td>7882</td>
</tr>
<tr>
<td>RAM Player</td>
<td>7882</td>
</tr>
<tr>
<td>RAM Player Configuration Dialog</td>
<td>7886</td>
</tr>
<tr>
<td>Scene Explorer</td>
<td>7888</td>
</tr>
<tr>
<td>Using Scene Explorer</td>
<td>7891</td>
</tr>
<tr>
<td>Scene Explorer Columns</td>
<td>7896</td>
</tr>
<tr>
<td>Scene Explorer Menus</td>
<td>7900</td>
</tr>
<tr>
<td>Scene Explorer Toolbars</td>
<td>7904</td>
</tr>
<tr>
<td>Manage Scene Explorer</td>
<td>7908</td>
</tr>
<tr>
<td>Advanced Search Dialog</td>
<td>7909</td>
</tr>
<tr>
<td>Advanced Filter Dialog</td>
<td>7912</td>
</tr>
<tr>
<td>Scene States</td>
<td>7915</td>
</tr>
<tr>
<td>Manage Scene States Dialog</td>
<td>7917</td>
</tr>
<tr>
<td>Schematic View</td>
<td>7922</td>
</tr>
<tr>
<td>Using Schematic View</td>
<td>7926</td>
</tr>
<tr>
<td>Schematic View Menus</td>
<td>7930</td>
</tr>
<tr>
<td>Schematic View List Views</td>
<td>7934</td>
</tr>
<tr>
<td>Schematic View Preferences Dialog</td>
<td>7936</td>
</tr>
<tr>
<td>Schematic View Toolbars</td>
<td>7942</td>
</tr>
<tr>
<td>Schematic View Display Floater</td>
<td>7946</td>
</tr>
<tr>
<td>Schematic View Selection Right-Click Menu</td>
<td>7949</td>
</tr>
<tr>
<td>Schematic View Commands</td>
<td>7952</td>
</tr>
<tr>
<td>New Schematic View</td>
<td>7952</td>
</tr>
<tr>
<td>Delete Schematic View</td>
<td>7952</td>
</tr>
<tr>
<td>Saved Schematic Views</td>
<td>7953</td>
</tr>
<tr>
<td>Using Layers to Organize a Scene</td>
<td>7953</td>
</tr>
<tr>
<td>Layer Manager</td>
<td>7956</td>
</tr>
<tr>
<td>Layer Properties Dialog</td>
<td>7966</td>
</tr>
<tr>
<td>Layer List</td>
<td>7974</td>
</tr>
</tbody>
</table>
Chapter 22 Utilities ................................................. 7977

List of Available Utilities ........................................ 7977

Chapter 23 User Interface ........................................... 7981

Additional Keyboard Commands .................................. 7982
Toggling Dialogs ..................................................... 7983
Starting 3ds Max from the Command Line ....................... 7985
Caption Bar ............................................................. 7988
Application Menu ..................................................... 7989
Quick Access Toolbar ............................................... 7995
InfoCenter .............................................................. 7997
Menu Bar ............................................................... 7998
Edit Menu ............................................................... 7999
Tools Menu ............................................................. 8001
Containers Submenu .................................................. 8003
Align Submenu ........................................................ 8003
Grids and Snaps Submenu .......................................... 8004
Group Menu ........................................................... 8005
Views Menu ............................................................ 8006
Create Menu ........................................................... 8008
Modifiers Menu ........................................................ 8016
Animation Menu ....................................................... 8023
Graph Editors Menu .................................................. 8027
Rendering Menu ........................................................ 8028
Customize Menu ....................................................... 8029
MAXScript Menu ....................................................... 8031
Help Menu ............................................................. 8032
Toolbars ................................................................. 8034
Main Toolbar .......................................................... 8035
Axis Constraints Toolbar ............................................. 8039
Layers Toolbar ........................................................ 8040
reactor Toolbar ........................................................ 8041
Extras Toolbar ........................................................ 8041
Render Shortcuts Toolbar ............................................ 8042
Snaps Toolbar .......................................................... 8043
Animation Layers Toolbar .......................................... 8044
Container Toolbar ..................................................... 8044
Brush Presets Toolbar ............................................... 8044
Brush Preset Manager ............................................... 8047
Right-Click Menu for Scripted Toolbar Buttons .................. 8051
<table>
<thead>
<tr>
<th>Feature</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quad Menu</td>
<td>8052</td>
</tr>
<tr>
<td>Additional Quad Menus</td>
<td>8057</td>
</tr>
<tr>
<td>Animation Quad Menu</td>
<td>8058</td>
</tr>
<tr>
<td>Snaps Shortcut Menu</td>
<td>8062</td>
</tr>
<tr>
<td>Tools 1 Quadrant for Light Objects</td>
<td>8063</td>
</tr>
<tr>
<td>Status Bar Controls</td>
<td>8064</td>
</tr>
<tr>
<td>Prompt Line</td>
<td>8065</td>
</tr>
<tr>
<td>MAXScript Mini Listener</td>
<td>8065</td>
</tr>
<tr>
<td>Status Line</td>
<td>8068</td>
</tr>
<tr>
<td>Time Slider</td>
<td>8068</td>
</tr>
<tr>
<td>Track Bar</td>
<td>8071</td>
</tr>
<tr>
<td>Selection Lock Toggle</td>
<td>8079</td>
</tr>
<tr>
<td>Coordinate Display</td>
<td>8081</td>
</tr>
<tr>
<td>Adaptive Degradation Button</td>
<td>8083</td>
</tr>
<tr>
<td>Grid Setting Display</td>
<td>8084</td>
</tr>
<tr>
<td>Time Tag</td>
<td>8084</td>
</tr>
<tr>
<td>Add Time Tag Dialog</td>
<td>8085</td>
</tr>
<tr>
<td>Edit Time Tag Dialog</td>
<td>8087</td>
</tr>
<tr>
<td>Animation and Time Controls</td>
<td>8089</td>
</tr>
<tr>
<td>Auto Key Animation Mode</td>
<td>8090</td>
</tr>
<tr>
<td>Set Key Animation Mode</td>
<td>8093</td>
</tr>
<tr>
<td>Default In/Out Tangents For New Keys</td>
<td>8098</td>
</tr>
<tr>
<td>Go To Start</td>
<td>8101</td>
</tr>
<tr>
<td>Previous Frame/Key</td>
<td>8101</td>
</tr>
<tr>
<td>Play/Stop</td>
<td>8102</td>
</tr>
<tr>
<td>Next Frame/Key</td>
<td>8104</td>
</tr>
<tr>
<td>Go To End</td>
<td>8104</td>
</tr>
<tr>
<td>Current Frame (Go To Frame)</td>
<td>8104</td>
</tr>
<tr>
<td>Key Mode</td>
<td>8105</td>
</tr>
<tr>
<td>Time Configuration</td>
<td>8106</td>
</tr>
<tr>
<td>Viewport Controls</td>
<td>8113</td>
</tr>
<tr>
<td>Viewport Label Menus</td>
<td>8117</td>
</tr>
<tr>
<td>General Viewport Label Menu</td>
<td>8117</td>
</tr>
<tr>
<td>Point-Of-View (POV) Viewport Label Menu</td>
<td>8122</td>
</tr>
<tr>
<td>Shading Viewport Label Menu</td>
<td>8130</td>
</tr>
<tr>
<td>Viewport Navigation</td>
<td>8135</td>
</tr>
<tr>
<td>Controls Available in All Viewports</td>
<td>8138</td>
</tr>
<tr>
<td>Walkthrough Controls for Perspective and Camera Viewports</td>
<td>8139</td>
</tr>
<tr>
<td>Perspective and Orthographic Viewport Controls</td>
<td>8141</td>
</tr>
<tr>
<td>Camera Viewport Controls</td>
<td>8154</td>
</tr>
<tr>
<td>Light Viewport Controls</td>
<td>8165</td>
</tr>
<tr>
<td>Command Panel</td>
<td>8181</td>
</tr>
<tr>
<td>Object Name and Wireframe Color</td>
<td>8182</td>
</tr>
<tr>
<td>Create Panel</td>
<td>8182</td>
</tr>
<tr>
<td>Modify Panel</td>
<td>8184</td>
</tr>
</tbody>
</table>
Chapter 24  Customizing the User Interface ................................. 8235

Useful Customization Techniques ................................. 8235
Customize Display Right-Click Menu ................................. 8239
Show UI ................................................. 8241
Lock UI Layout ........................................ 8242
Plug-In Manager ........................................... 8242
Custom UI and Defaults Switcher ................................. 8244
Market-Specific Defaults ......................................... 8246
COM/DCOM Server Control Utility ................................. 8248
Customize User Interface Dialog ................................. 8249
  Keyboard Panel ............................................. 8250
  Toolbars Panel ............................................. 8252
      Edit Button Appearance Dialog ..................... 8258
  Quads Panel ................................................. 8259
      Advanced Quad Menu Options ...................... 8264
  Menus Panel ................................................. 8269
  Colors Panel ................................................. 8272
Saving and Loading Custom User Interfaces ............................. 8276
Load Custom UI Scheme ........................................ 8279
Save Custom UI Scheme ......................................... 8280
Revert to Startup Layout ......................................... 8283
Configure Paths ................................................. 8283
  Configure User Paths ......................................... 8284
Adaptation ........................................ 8498
Adaptive Degradation .......................... 8498
Additive Opacity ................................. 8499
Adjust Talent Pose ............................. 8501
Affine Transformation ......................... 8501
Airborne Period ............................... 8501
Aliasing/Antialiasing ........................... 8501
Alpha Channel .................................. 8502
Ambient Color .................................. 8504
Ambient Light ................................... 8504
Animated Texture ............................... 8505
Animation ........................................ 8505
Animation Controllers/Transform Controllers 8506
Animation Layers ............................... 8507
Applied IK ...................................... 8507
Area Lights (mental ray Renderer) ........... 8507
Area Shadows .................................... 8510
Aspect Ratio .................................... 8511
Attachments (IK) .............................. 8513
Attenuation ..................................... 8513
AutoGrid ........................................ 8514
Avoid Behavior ................................ 8515
Avoidance Behavior ............................ 8515
Axonometric View ............................... 8515
B-Spline ......................................... 8516
Balance Factor .................................. 8516
Balance Track ................................... 8517
Ballistic Gait ................................... 8517
Ballistic Tension ................................ 8517
Barycentric Coordinates ....................... 8517
Behaviors ....................................... 8518
Bend Links ....................................... 8518
Bezier Curve ..................................... 8519
BioVision Files .................................. 8520
BIP Files ........................................ 8520
Biped ............................................ 8521
Biped Dynamics ................................ 8521
Birth Event ...................................... 8521
Bitmap ........................................... 8523
Blend Object ..................................... 8524
Block Reference ................................ 8524
Block/Style Parent ............................. 8525
Blur/Blur Offset ................................ 8525
Body Space ...................................... 8527
Boolean Operation ............................. 8527
Bound Vertex ................................... 8528
<table>
<thead>
<tr>
<th>Content</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bounding Box</td>
<td>8528</td>
</tr>
<tr>
<td>Bulge</td>
<td>8529</td>
</tr>
<tr>
<td>Bulge Angle</td>
<td>8529</td>
</tr>
<tr>
<td>BVH Files</td>
<td>8530</td>
</tr>
<tr>
<td>By Layer</td>
<td>8530</td>
</tr>
<tr>
<td>Center of Mass (COM)</td>
<td>8530</td>
</tr>
<tr>
<td>CGFX File</td>
<td>8530</td>
</tr>
<tr>
<td>Chamfer</td>
<td>8531</td>
</tr>
<tr>
<td>character studio Marker Files</td>
<td>8531</td>
</tr>
<tr>
<td>CIBSE Files</td>
<td>8532</td>
</tr>
<tr>
<td>Clip Controller</td>
<td>8532</td>
</tr>
<tr>
<td>Clipping Planes</td>
<td>8532</td>
</tr>
<tr>
<td>Codec</td>
<td>8533</td>
</tr>
<tr>
<td>Cognitive Controller</td>
<td>8534</td>
</tr>
<tr>
<td>Composite</td>
<td>8534</td>
</tr>
<tr>
<td>Compound Materials</td>
<td>8535</td>
</tr>
<tr>
<td>Constrained Point</td>
<td>8535</td>
</tr>
<tr>
<td>Contact Object</td>
<td>8536</td>
</tr>
<tr>
<td>Container</td>
<td>8536</td>
</tr>
<tr>
<td>Containers</td>
<td>8537</td>
</tr>
<tr>
<td>Continuity</td>
<td>8537</td>
</tr>
<tr>
<td>Continuity Level</td>
<td>8537</td>
</tr>
<tr>
<td>Control Lattice</td>
<td>8538</td>
</tr>
<tr>
<td>Control Point</td>
<td>8539</td>
</tr>
<tr>
<td>Control Vertex (CV)</td>
<td>8539</td>
</tr>
<tr>
<td>Controller</td>
<td>8540</td>
</tr>
<tr>
<td>Convex Hull Property</td>
<td>8540</td>
</tr>
<tr>
<td>Cool</td>
<td>8541</td>
</tr>
<tr>
<td>Coordinate Space</td>
<td>8541</td>
</tr>
<tr>
<td>CPY Files</td>
<td>8542</td>
</tr>
<tr>
<td>Creation Parameters</td>
<td>8542</td>
</tr>
<tr>
<td>Cross Section</td>
<td>8542</td>
</tr>
<tr>
<td>Crowd</td>
<td>8542</td>
</tr>
<tr>
<td>Crowd System</td>
<td>8542</td>
</tr>
<tr>
<td>CSM Files</td>
<td>8543</td>
</tr>
<tr>
<td>Curve View</td>
<td>8543</td>
</tr>
<tr>
<td>CV</td>
<td>8543</td>
</tr>
<tr>
<td>CV Curve</td>
<td>8544</td>
</tr>
<tr>
<td>CV Surface</td>
<td>8545</td>
</tr>
<tr>
<td>Deformable Envelope</td>
<td>8546</td>
</tr>
<tr>
<td>Deformation</td>
<td>8547</td>
</tr>
<tr>
<td>Deformation Spline</td>
<td>8547</td>
</tr>
<tr>
<td>Degree</td>
<td>8549</td>
</tr>
<tr>
<td>Delegates</td>
<td>8549</td>
</tr>
<tr>
<td>Dependent</td>
<td>8549</td>
</tr>
<tr>
<td>Dependent (NURBS)</td>
<td>8550</td>
</tr>
<tr>
<td>Depot</td>
<td>8550</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Description Panel</td>
<td>8551</td>
</tr>
<tr>
<td>Diagonal</td>
<td>8551</td>
</tr>
<tr>
<td>Diffuse Color</td>
<td>8552</td>
</tr>
<tr>
<td>Dithering</td>
<td>8553</td>
</tr>
<tr>
<td>Dock and Float</td>
<td>8555</td>
</tr>
<tr>
<td>Double Support Period</td>
<td>8555</td>
</tr>
<tr>
<td>Dummy Object</td>
<td>8555</td>
</tr>
<tr>
<td>DWG Files</td>
<td>8556</td>
</tr>
<tr>
<td>DXF Files</td>
<td>8556</td>
</tr>
<tr>
<td>Dynaflector</td>
<td>8557</td>
</tr>
<tr>
<td>Dynamics</td>
<td>8557</td>
</tr>
<tr>
<td>Dynamics Blend</td>
<td>8557</td>
</tr>
<tr>
<td>Ease Curve</td>
<td>8558</td>
</tr>
<tr>
<td>Edge</td>
<td>8559</td>
</tr>
<tr>
<td>Editable Mesh</td>
<td>8559</td>
</tr>
<tr>
<td>Editable Poly</td>
<td>8559</td>
</tr>
<tr>
<td>Element</td>
<td>8559</td>
</tr>
<tr>
<td>Emitter</td>
<td>8560</td>
</tr>
<tr>
<td>End Effector</td>
<td>8560</td>
</tr>
<tr>
<td>Envelopes</td>
<td>8561</td>
</tr>
<tr>
<td>Environment Map</td>
<td>8561</td>
</tr>
<tr>
<td>Event</td>
<td>8564</td>
</tr>
<tr>
<td>Event Display</td>
<td>8566</td>
</tr>
<tr>
<td>Event Level</td>
<td>8567</td>
</tr>
<tr>
<td>Extents</td>
<td>8567</td>
</tr>
<tr>
<td>Face/Polygon</td>
<td>8568</td>
</tr>
<tr>
<td>Faceted</td>
<td>8568</td>
</tr>
<tr>
<td>FFD</td>
<td>8569</td>
</tr>
<tr>
<td>FGM File</td>
<td>8569</td>
</tr>
<tr>
<td>Field of View</td>
<td>8569</td>
</tr>
<tr>
<td>Fields</td>
<td>8570</td>
</tr>
<tr>
<td>Figure Mode</td>
<td>8572</td>
</tr>
<tr>
<td>Fillet</td>
<td>8572</td>
</tr>
<tr>
<td>Filter Color / Filter Opacity</td>
<td>8573</td>
</tr>
<tr>
<td>Filtering (Antialiasing)</td>
<td>8574</td>
</tr>
<tr>
<td>Filtering (Character Animation)</td>
<td>8575</td>
</tr>
<tr>
<td>Final Gathering (mental ray Renderer)</td>
<td>8576</td>
</tr>
<tr>
<td>First Vertex</td>
<td>8578</td>
</tr>
<tr>
<td>Flat Mirror</td>
<td>8579</td>
</tr>
<tr>
<td>Flow</td>
<td>8581</td>
</tr>
<tr>
<td>Fluorescence</td>
<td>8581</td>
</tr>
<tr>
<td>Flyout</td>
<td>8582</td>
</tr>
<tr>
<td>Follow Object</td>
<td>8583</td>
</tr>
<tr>
<td>Foot States</td>
<td>8583</td>
</tr>
<tr>
<td>Footstep Animation</td>
<td>8584</td>
</tr>
<tr>
<td>Contents</td>
<td></td>
</tr>
<tr>
<td>----------</td>
<td></td>
</tr>
</tbody>
</table>

| Footsteps Method | 8584 |
| Forward Kinematics | 8585 |
| Forward Kinematics (Biped) | 8585 |
| Frame/Frame Rate | 8585 |
| Freeform Animation | 8586 |
| Freeform Method | 8586 |
| Freeze/Unfreeze | 8587 |
| Function Curve | 8588 |
| Fusing | 8588 |
| FX File | 8589 |
| G-Buffer | 8589 |
| Gait Pattern | 8591 |
| Gait Type | 8591 |
| Gamma Correction | 8592 |
| Geometric Primitives | 8593 |
| Gizmo/Center | 8593 |
| Global Event | 8594 |
| Global Motion Clip Controller | 8596 |
| Glossiness and Specular Level Settings | 8596 |
| GravAccel | 8597 |
| Gravity | 8597 |
| Grid Object | 8597 |
| Head Object | 8598 |
| Helper Object | 8599 |
| Hide/Unhide | 8599 |
| Hierarchical Linkage | 8599 |
| Home Grid | 8600 |
| Horizon | 8602 |
| Hot | 8603 |
| Hotspot/Falloff | 8604 |
| IGES (Initial Graphics Exchange Specification) | 8605 |
| IK Blend | 8605 |
| IK Goal | 8605 |
| IK Solution | 8606 |
| Illuminance | 8606 |
| Image Motion Blur | 8606 |
| In Place Mode | 8608 |
| Independent | 8609 |
| Influence | 8609 |
| Initial Pose | 8609 |
| Initialize | 8609 |
| Inputs: Event | 8609 |
| Instance | 8610 |
| Instance (Motion Mixer) | 8611 |
| Interactive Renderer | 8612 |
| Interpolation | 8612 |
| Contents |
|----------------------------------------|-----------------|
| Inverse Kinematics                     | 8612            |
| Inverse Kinematics (Biped)             | 8613            |
| Iso Line                               | 8613            |
| Isometric View                         | 8614            |
| Keyframe Mode                          | 8615            |
| Keyframes/Keys                         | 8616            |
| Kinematic Chain                        | 8616            |
| Knot                                   | 8617            |
| Launch Script                          | 8617            |
| Layer Track                            | 8617            |
| Layers                                 | 8617            |
| Layout Mode                            | 8618            |
| Lift                                   | 8618            |
| Light Map                              | 8618            |
| Linked Geometry                        | 8620            |
| Links                                  | 8620            |
| Listener Window                        | 8620            |
| Local Container                        | 8620            |
| Local Coordinate System                | 8621            |
| Local Event                            | 8623            |
| Lofting                                | 8623            |
| Log File (mental ray Renderer)         | 8624            |
| Look At Object                         | 8624            |
| LTLI Files                             | 8625            |
| Luminance                              | 8625            |
| Luminous Flux                          | 8625            |
| Luminous Intensity                     | 8625            |
| LZF Files                              | 8625            |
| LZG Files                              | 8626            |
| LZH Files                              | 8626            |
| LZO Files                              | 8626            |
| LZV Files                              | 8626            |
| Map Channel                            | 8627            |
| Mapped Material                        | 8628            |
| Mapping Coordinates                    | 8628            |
| Maps                                   | 8631            |
| Marker Data                            | 8631            |
| Marker Files                           | 8632            |
| Markers                                | 8632            |
| Master Motion Clip Controller          | 8632            |
| Match Frame                            | 8632            |
| Material ID                            | 8633            |
| Material/Map Hierarchy                 | 8634            |
| Materials                              | 8635            |
| Matte Object                           | 8636            |
| MAX Files                              | 8638            |
MAXScript ........................................ 8638
Mesh ........................................... 8638
Metaballs ....................................... 8638
MFE Files ....................................... 8639
MI Files ......................................... 8639
Mirroring ........................................ 8639
Mix ............................................... 8639
MIX Files ........................................ 8640
Mixdown ......................................... 8640
MNM Files ....................................... 8640
Modal/Modeless ................................. 8641
Modifier Stack .................................. 8641
Modifiers ........................................ 8643
Morphing ........................................ 8643
Motion Blending ................................ 8644
Motion Blur ..................................... 8644
Motion Capture ................................ 8646
Motion Clip ...................................... 8646
Motion Files .................................... 8646
Motion Flow ..................................... 8647
Motion Flow Editor ............................. 8647
Motion Flow Scripts ............................ 8647
Motion Mixer .................................... 8647
Motion Synthesis ............................... 8648
MSP (MAXScript Package) Files ............... 8649
Multiplicity .................................... 8649
Multiplier ....................................... 8649
Multiplier Curve ............................... 8651
N Links ........................................... 8651
Network Manager ............................... 8651
Network Rendering .............................. 8652
Network Rendering Server ...................... 8653
Newton ........................................... 8653
Node ............................................. 8653
Normal .......................................... 8654
NTSC ............................................. 8654
NURBS ........................................... 8655
NURBS Curve .................................... 8655
NURBS Model .................................... 8656
NURBS Surface .................................. 8656
NURMS ........................................... 8656
Object ........................................... 8657
Object Instance .................................. 8657
Object Motion Blur .............................. 8658
Object Space ................................... 8659
Object Space (Biped) ........................... 8661
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Obstacle-Avoidance Behavior</td>
<td>8661</td>
</tr>
<tr>
<td>Object-Space Modifiers</td>
<td>8661</td>
</tr>
<tr>
<td>Omnidirectional Light</td>
<td>8661</td>
</tr>
<tr>
<td>Omnilector</td>
<td>8663</td>
</tr>
<tr>
<td>Opacity Falloff</td>
<td>8663</td>
</tr>
<tr>
<td>Operand</td>
<td>8665</td>
</tr>
<tr>
<td>Operator</td>
<td>8665</td>
</tr>
<tr>
<td>Operator Icon</td>
<td>8665</td>
</tr>
<tr>
<td>Optical Markers</td>
<td>8666</td>
</tr>
<tr>
<td>Orientation Behavior</td>
<td>8667</td>
</tr>
<tr>
<td>Origin</td>
<td>8667</td>
</tr>
<tr>
<td>Orthographic View</td>
<td>8668</td>
</tr>
<tr>
<td>Out-of-Range Types</td>
<td>8670</td>
</tr>
<tr>
<td>Outputs: Source / Test</td>
<td>8671</td>
</tr>
<tr>
<td>Overshoot</td>
<td>8672</td>
</tr>
<tr>
<td>PAL</td>
<td>8674</td>
</tr>
<tr>
<td>Parameter Space</td>
<td>8674</td>
</tr>
<tr>
<td>Parameters Panel</td>
<td>8674</td>
</tr>
<tr>
<td>Parameter/Parametric</td>
<td>8675</td>
</tr>
<tr>
<td>Parent Particle</td>
<td>8676</td>
</tr>
<tr>
<td>Particle Diagram</td>
<td>8677</td>
</tr>
<tr>
<td>Particle Level</td>
<td>8678</td>
</tr>
<tr>
<td>Particle System</td>
<td>8678</td>
</tr>
<tr>
<td>Particle System (Particle Flow)</td>
<td>8678</td>
</tr>
<tr>
<td>PASS File</td>
<td>8678</td>
</tr>
<tr>
<td>Patch</td>
<td>8679</td>
</tr>
<tr>
<td>Patch-Based Objects</td>
<td>8679</td>
</tr>
<tr>
<td>Path</td>
<td>8679</td>
</tr>
<tr>
<td>Path Follow Behavior</td>
<td>8681</td>
</tr>
<tr>
<td>Period</td>
<td>8681</td>
</tr>
<tr>
<td>Perspective View</td>
<td>8681</td>
</tr>
<tr>
<td>Phases of Leg Motion</td>
<td>8683</td>
</tr>
<tr>
<td>Photometry</td>
<td>8683</td>
</tr>
<tr>
<td>Photon Map</td>
<td>8684</td>
</tr>
<tr>
<td>PHY Files</td>
<td>8685</td>
</tr>
<tr>
<td>Physique</td>
<td>8685</td>
</tr>
<tr>
<td>Pivot Point</td>
<td>8686</td>
</tr>
<tr>
<td>Pixel</td>
<td>8687</td>
</tr>
<tr>
<td>Plant</td>
<td>8687</td>
</tr>
<tr>
<td>Plug-Ins</td>
<td>8687</td>
</tr>
<tr>
<td>PMAP File</td>
<td>8687</td>
</tr>
<tr>
<td>Point</td>
<td>8687</td>
</tr>
<tr>
<td>Point Curve</td>
<td>8688</td>
</tr>
<tr>
<td>Point Surface</td>
<td>8689</td>
</tr>
<tr>
<td>Poses</td>
<td>8689</td>
</tr>
<tr>
<td>Positional Markers</td>
<td>8689</td>
</tr>
</tbody>
</table>
Posture ........................................ 8690
Precedence .................................... 8690
Premultiplied Alpha ............................ 8690
Procedural Maps ................................ 8691
Projector Light .................................. 8693
ProMaterials Library for mental ray ............ 8694
Prop Bone ...................................... 8694
Quadtree ....................................... 8694
Queue Monitor ................................... 8695
Radiosity ....................................... 8695
Radiosity Solution ......................... 8695
Ray-Trace Acceleration (mental ray Renderer) .... 8696
Ray-Traced Shadows ............................. 8696
RAYHOSTS File .................................. 8697
Real Time ...................................... 8697
Recognize Scene-Loading Technology ............. 8698
Red, Green, Blue / Hue, Saturation, Value ....... 8698
Reference ...................................... 8699
Reference Object .................................. 8700
Refine ......................................... 8700
Reinitialize .................................... 8700
Repel Behavior .................................. 8700
Reservoir ....................................... 8701
Resolution ...................................... 8701
Reveal Rendering ................................ 8701
Review ......................................... 8701
Rotoscoping .................................... 8702
Rubber-Band Mode ............................... 8702
RVT Link ........................................ 8703
Safe Frame ..................................... 8703
Sample Range .................................. 8704
Sampling (mental ray Renderer) .................... 8705
Scale Stride .................................... 8709
Scanline Renderer ............................... 8709
Scene Extents .................................... 8710
Scene Motion Blur ............................... 8710
Schematic View .................................. 8712
Script .......................................... 8712
Script Editor Window .......................... 8712
Scripted Behavior ................................ 8713
Scripted Utility Panel ........................... 8713
Scripts (Motion Flow) ........................... 8713
Scripting ....................................... 8713
Seed Value ..................................... 8714
Seek Behavior ................................... 8714
Segment ........................................... 8714
Self-Illumination .......................................................... 8714
Shaders (mental ray Renderer) ........................................ 8716
Shaders (Standard Materials) .......................................... 8716
Shadow Bias .............................................................. 8718
Shadow Map ............................................................. 8719
Shapes and Splines ....................................................... 8720
SHP Files ................................................................. 8723
Skylight ................................................................. 8723
Sliding Footstep ......................................................... 8724
Smoothing Groups ...................................................... 8724
SMPTE ................................................................. 8725
Source Container ....................................................... 8725
Space Warp Behavior .................................................. 8726
Space Warps ............................................................ 8727
Spawn Particles .......................................................... 8727
Specular Color .......................................................... 8728
Speed Vary Behavior .................................................... 8728
Splice ................................................................. 8729
Spline ................................................................. 8729
Spline Dynamics ........................................................ 8730
Startup Script .......................................................... 8730
SteeringWheels Navigation ............................................ 8731
Sub-Object ............................................................. 8732
Sub-Object Level ...................................................... 8733
Subtractive Opacity .................................................... 8733
Sunlight ............................................................... 8734
Super Black ............................................................ 8735
Supersampling .......................................................... 8735
Support Period ........................................................ 8736
Surface Arrive Behavior ............................................... 8736
Surface Follow Behavior .............................................. 8736
Synthesis, Synthesize .................................................. 8736
Talent Figure Mode .................................................... 8736
Tangents ............................................................... 8737
TCB (Biped) ............................................................ 8737
TCB (Tension, Continuity, Bias) .................................... 8738
Tendons ............................................................... 8738
Tension, Continuity, Bias (Biped) .................................. 8739
Terrain ................................................................. 8739
Test ................................................................. 8741
Texel ................................................................. 8741
Texture ............................................................... 8741
Ticks ................................................................. 8741
Tile/Mirror ............................................................. 8742
Topology ............................................................. 8743
Topology-Dependent Modifier ........................................ 8744
Introduction

Autodesk 3ds Max 2010 is a 3D modeling, animation, and rendering solution for design visualization, games, film, and television.
Chapter 1   Introduction
What's New in Autodesk 3ds Max 2010

Autodesk 3ds Max 2010 is more powerful and easier to use, thanks to a wealth of new tools and a redesign to place often-used commands at your fingertips. File functions such as Open and Save are available at the click of a button on the new Caption bar, and the remaining controls are more clearly organized on the Application menu. The Graphite Modeling Tools set combines familiar features with a host of new ones in a dynamic, innovative “ribbon” interface. The third generation of Review technology offers viewport support for ambient occlusion, High Dynamic Range Image (HDRI)-based lighting, soft shadows, and more. For descriptions of these and other new features, consult the remainder of this topic.
NOTE This topic lists all significant new features, but does not include every change in 3ds Max. As you proceed through the documentation, keep an eye out for the icon, which indicates a new feature.

You can also use the index in this help to find topics that contain information about new features. For topics that describe new program features, check the index entry "new feature." For changes in existing features, check the index entry "changed feature."

Following is a list of major new features with brief descriptions and links to the relevant reference topic:

**General Improvements**

- **Viewport Improvements**  With hardware support, you can now preview soft-edged shadows, ambient occlusion, and exposure control in viewports, saving rendering time. For details, see Previewsing Shadows and Other Lighting in Viewports on page 5335 and Lighting and Shadows on page 8392.

  ![Hardware-shaded viewport with shadows and Ambient Occlusion](image)

- The viewport label menus on page 8117 have been reorganized to improve ease of use, and offer quicker access to more display options.

- **Appearance**  The 3ds Max window has been updated for ease of use. See Caption Bar on page 7988 for a description of the most visible menu and toolbar changes.
Also, many graphic buttons have been redesigned for greater clarity. These changes are reflected throughout the help.

**Modeling**

- **Graphite Modeling Tools** on page 2025 combines a wealth of new polygon-modeling features on page 2026, including freeform sculpting and powerful loop-modeling tools, with the tried and true toolset in a dynamic, configurable new “ribbon” interface.

- The new **ProOptimizer modifier** on page 1614 provides a convenient way to improve your models’ polygon count. With the **Batch ProOptimizer utility** on page 2768, you can use the same controls to optimize multiple scenes all at once. Support for optimization of explicit normals has been enhanced in this release.

- **ProBoolean** on page 801 offers two new operations: Attach, which simply combines objects without affecting their geometry, and Insert, which subtracts one shape from another while leaving both operands in place. Also, the new **Quadify Mesh modifier** on page 1641 lets you apply the quadrilateral tessellation feature from ProBoolean to any object, making it easier to obtain nicely rounded edges with MeshSmooth.
Transform Toolbox on page 936 contains functions for easy object rotation, scaling, and positioning as well as for moving object pivots.

xView on page 2873 analyzes mesh models, flags various potential problems and errors, and displays the results in the viewports both graphically and as text. Tests include isolated and overlapping vertices, open edges, various UVW statistics, and more.
Scene and Project Management

The addition of the Containers toolset facilitates collaboration and flexible workflows by giving you the ability to collect multiple objects into a single organizing device when dealing with complex scenes. You can place related objects, such as sections of a city, in a container and treat them as a single element. Opening the container exposes the content, while closing the container externalizes the data. Containers can be temporarily unloaded from the scene, toggling data in and out as needed to manage complexity. Such workflows can save memory, increase viewport performance and decrease load and save times. You can also grant or withhold editing privileges for containers, so that a scene aggregator won’t necessarily be able to alter the contents.

Expanded support for the OBJ file format facilitates importing and exporting 3D model data between Autodesk Mudbox and Autodesk 3ds Max 2010 as well as other 3D applications. You can now see whether an OBJ file contains texture coordinates and smoothing groups. Also new are options for triangulating polygons on import, choosing how normals...
are imported, and for saving presets for normal and polygon import for future use.

- The **AutoCAD 2010** on page 7692 option for exporting DWG files includes support for the new MESH object type as implemented in Autocad 2010 for Subdivision Surfaces workflows. This object type removes size limitations and provides tools within AutoCAD to convert as true ACIS Solid entities.

- The **Scene Explorer** on page 7888 interface has been rearranged and updated for ease of use, and new features have been added. For instance, you can now switch Explorer columns and change Advanced Search terms on the fly. To see all the changes, browse the Scene Explorer topics for the icon.
Scene Explorer interface
Enhanced Autodesk FBX® software data-translation fidelity improves interoperability between 3ds Max and other Autodesk products such as Autodesk MotionBuilder®, Autodesk Toxik® and Autodesk Maya® software.

Materials and Mapping

A new Material Explorer interface on page 5734 makes it easier for you to browse and manage the materials in your scene.
■ **Viewport Canvas** on page 6455 provides tools for painting onto an object's texture directly in the viewport. It turns the active viewport into a
two-dimensional canvas that you can use to paint on and then apply the result to the object’s texture.

Viewport Canvas interface

- **Render Surface Map** on page 6466 provides tools for creating bitmaps automatically based on an object’s UVW mapping. The generated bitmaps display surface properties of the object, including concavity/convexity (dirt map), mesh density, facing direction (dust map), and object thickness. There’s also a Bitmap Select function for selecting sub-objects based on mapping attributes.

- Autodesk 3ds Max 2010 is the first 3D package to integrate the powerful mental mill technology from mental images. With mental mill (installed separately), you can design, test, and maintain hardware-agnostic shaders
and complex shader graphs for hardware and software rendering with real-time visual feedback.

- New tools on the Edit UVWs dialog on page 1856 of the Unwrap UVW modifier significantly ease the tasks of selecting loops and rings of texture sub-objects as well as aligning them, stitching clusters, and more.

- New mental ray shaders are Multi/Sub-Map on page 6414, with which you can vary the surface appearance of multiple objects assigned the same material, and Object Color on page 6418, which lets you incorporate an object’s wireframe color into its material.

![Multi/Sub-Map randomly varies the stains on the seats in a stadium model.](image)

- The DirectX Shader material on page 6175 now supports shaders in MetaSL format, the shader language that is used when you create new shaders using the mental mill® product from mental images®. Also, now mapped components of a DirectX Shader material can use Radiance Image (HDR) files on page 7866 and Photoshop (PSD) files on page 7863 as maps.

**Rendering**

- The Rendered Frame Window on page 6513 (Reveal) interface has been redesigned for Autodesk 3ds Max 2010. When rendering with mental ray, the Render button and Production/Iterative switch now appear on the lower panel with the rest of the mental ray-specific controls; otherwise,
they remain in their former location on the upper panel. Also, the lower panel has been streamlined for greater ease of use. Most important, new global-tuning sliders let you temporarily override the precision of reflections, refractions, and soft shadows for faster or higher-quality rendering. The latter controls are also available on the Render Setup dialog > new Global Tuning Parameters rollout on page 6731.

- The Photon Map and Final Gather Map controls have been enhanced and are now available on their own Reuse rollout on page 6778. New on this rollout are controls for reducing flickering in animations that use final gathering.

- Another new setting for reducing flickering in animations that use final gathering, specific to those with a moving viewpoint, is Project Points from Positions Along Camera Path on page 6764.

- When rendering with mental ray, final gathering on page 6760 now provides a fast progressive-feedback display so you can get an idea of the overall scene lighting more quickly. This feature is automatic whenever Final Gather is enabled.

- Improved bitmap paging allows you to render larger images than previous versions would support. In Autodesk 3ds Max 2010, bitmap paging is always active, and is managed automatically. A new Page File system path allows you to assign the area used for bitmap paging. If you are creating large renderings and have a dedicated, high-performance disk you can use for caching, this option can greatly improve render time. See System Paths on page 8294.

- Changes to how 3ds Max handles gamma correction on page 8330 improve its ease of use. The new topic Gamma Pipeline on page 8341 gives additional information on using this feature, especially with the mental ray renderer.

**Animation**

- PFlowAdvanced, a collection of new Particle Flow tools, makes it easier to organize particles, place them precisely in the scene, customize the system, and more. For details, see What's New in Particle Flow on page 2998.
New features in Particle Flow

PFlowAdvanced also includes the new PFlowElements library with at least 100 samples created by an industry-leading effects artist. You’ll find them on the Sample Files DVD included with Autodesk 3ds Max 2010.

- You can now lock animation tracks on page 3826 and animation layers on page 3467 to prevent inadvertent changes.
- The Link constraint on page 3580 has been enhanced so that assigning a link target creates a key that you can manipulate on the track bar and in Track View.
- ProSound on page 3835 is a real-time, multitrack audio solution for 3ds Max that includes full support for and integration with Track View. Features include up to 100 independent audio tracks and PCM audio in both AVI and WAV files with up to six output channels.

Hair Improvements

A new spline deformation option on page 1090 lets you control hair shape by matching the hair to a spline object.

What's New in Autodesk 3ds Max 2010 | 15
Cloth Improvements

Enhancements to the Cloth and Garment Maker modifiers enable a range of new effects:

■ A new Inherit Velocity toggle makes it easier to create Cloth animations one portion at a time. When this toggle is on, a simulation can begin where the previous one ended. See Cloth Properties on page 1225.

■ A closed volume of cloth can now behave as if it were filled with gas. You can control the pressure within the volume. See Pressure group on page 1233.

■ You can now tear cloth. The interface provides a few different ways to set up cloth tearing. See Tearing Cloth on page 1207.

■ New group-level functions let you shrink and grow vertex selections, select rings and loops of vertices, and select all vertices in an element.

Character-Animation Improvements

The new Knuckles on page 4768 feature allows you to create detailed, more subtle hand animation.
A standard biped hand. This setup doesn’t allow for finely detailed hand animation.

A biped hand with Knuckles turned on. The hand has a small base and individual bones for all its digits, allowing for detailed animation.

3ds Max Documentation Set

The documentation set for 3ds Max® comprises online material only. Most documents are available from the Start menu > Programs > Autodesk >
Help folder, as well as from the Help menu within 3ds Max or the Additional Help dialog.

- **Autodesk 3ds Max 2010 and Autodesk 3ds Max Design 2010 Installation Guide**: Contains complete installation, configuration, and troubleshooting instructions, including system requirements. Also includes information on uninstalling and maintaining 3ds Max, as well as descriptions of the full install documentation set. View the *Installation Guide* in the Installation Wizard.

  **NOTE** The complete installation documentation set is found on your install DVD in the `Docs` folder at the root of the DVD. If you are deploying 3ds Max over a network, refer to the *Autodesk 3ds Max 2010 and Autodesk 3ds Max Design 2010 Network Administrator’s Guide* instead of the *Installation Guide*.

- **Autodesk 3ds Max 2010 Readme (3ds_Max_Readme.rtf)**: Contains the latest information about 3ds Max. You can access this file by clicking View Readme in the Autodesk 3ds Max 2010 Installation Wizard.

- **Autodesk 3ds Max 2010 Help**: This document covers fundamental concepts and strategies for using the product, as well as details about the features of 3ds Max. Access the reference by choosing Help > Autodesk 3ds Max Help.

- **Autodesk 3ds Max 2010 Tutorials**: Contains tutorial information and detailed procedures to walk you through increasingly complex operations. This is the best source for learning 3ds Max. Access the tutorials by choosing Help > Tutorials.

  **NOTE** All the scene files required to do the tutorials are installed by default.

- **MAXScript Help**: Describes the MAXScript scripting language on page 21. Check out the “Learning MAXScript” chapter there if you're new to MAXScript. Access the MAXScript Help by choosing Help > MAXScript Help.

- **Additional mental ray® Help Files**: Documentation from mental images® is available from Help menu > Additional Help. There, you'll find the *mental ray Reference*, comprising the *mental ray Manual, mental ray Shader Reference, and LumeTools Collection*. You’ll also find PDF files documentating various mental ray shader libraries.
NOTE The Autodesk 3ds Max 2010 Help documents most mental ray components available in the 3ds Max user interface. This includes documentation for lights for mental ray and specific shadow types, controls for adding mental ray shaders to lights and cameras, mental ray materials, custom shaders for 3ds Max, and the mental ray renderer controls.

■ Additional Backburner Files: Procedures for using Backburner from inside 3ds Max are documented in this Autodesk 3ds Max Help File. For further information on using and configuring Backburner, refer to the additional Backburner documentation available from Additional Help as well as from the Start menu location described in the introduction of this topic. The two documents related to Autodesk Backburner are called:
  ■ Backburner Installation Guide
  ■ Backburner User’s Guide

NOTE For information on installing Autodesk Backburner, see the Autodesk 3ds Max 2010 and Autodesk 3ds Max Design 2010 Installation Guide.

■ FBX Plug-in Help: Access the FBX Plug-in Help from the Additional Help menu. You can also click the ? (Help) button on the FBX Importer/Exporter dialog. The FBX plug-in changes often, with the result that Autodesk updates it more frequently than it does this program. Be sure to check regularly for updated versions by clicking the Web Updates button on the dialog.

How to Print from the Online Help

If your computer is connected to a printer, you can print single help topics or entire chapters.

To print a topic or chapter, highlight the topic or chapter title and click the Print button at the top of the help display. A dialog opens.
Choose to print only the selected topic, or to print all topics in that chapter. After you make your selection, another dialog appears where you can choose your printer and other options.

The tabs available at the top of the dialog depend on the selected printer. Choose options for the print job, and click OK to begin printing.
How to Contact Us

We are also interested in hearing your views about 3ds Max. We’d like to hear ways you think we can improve our program, features you’re interested in, as well as your views on the documentation set.

Please send us email about the documentation set at:
me.documentation@autodesk.com

About MAXScript

MAXScript is the built-in scripting language for 3ds Max.

With MAXScript, you have the ability to:

■ Script all aspects of 3ds Max use, such as modeling, animation, materials, rendering, and so on.

■ Control 3ds Max interactively through a command-line shell window.

■ Package scripts within custom utility panel rollouts or modeless windows, giving them a standard 3ds Max user interface.

■ Build custom import/export tools using the built-in file I/O.

■ Write procedural controllers that can access the entire state of the scene. Build batch-processing tools, such as batch-rendering scripts.

■ Set up live interfaces to external system using OLE Automation.

The MAXScript language is specifically designed to complement 3ds Max. It is object-oriented, and has several special features and constructs that mirror high-level concepts in the 3ds Max user interface. These include coordinate-system contexts, an animation mode with automatic keyframing, and access to scene objects using hierarchical path names that match the 3ds Max object hierarchy.

The syntax is simple enough for non-programmers to use, with minimal punctuation and formatting rules.

Visual MAXScript

Visual MAXScript is a powerful addition to MAXScript, making the MAXScript feature easier to learn and use. With Visual MAXScript, you can quickly create UI elements and layouts for scripting.
For detailed information about Visual MAXScript, open the MAXScript Help, available from Help menu > MAXScript Help.

See also:
- MAXScript Menu on page 8031

Procedures

To access MAXScript, do one of the following:

1 On the menu bar, choose MAXScript. The MAXScript menu appears.
2 Choose Utilities panel > MAXScript.
   From here, you can either write new scripts, edit or run existing scripts, open the MAXScript Listener, or use the Macro Recorder.
   To access the MAXScript Listener, you can also right-click in the Mini Listener and choose Open Listener Window from the right-click menu.
   For detailed information about the MAXScript utility, open the MAXScript Help, available from Help menu > MAXScript Help.

Copyrights and Trademarks

Autodesk® 3ds® Max 2010 Software

© 2009 Autodesk, Inc. All rights reserved. Except as otherwise permitted by Autodesk, Inc., this publication, or parts thereof, may not be reproduced in any form, by any method, for any purpose.

Certain materials included in this publication are reprinted with the permission of the copyright holder.

The following are registered trademarks or trademarks of Autodesk, Inc., in the USA and other countries: 3DEC (design/logo), 3December, 3December.com, 3ds Max, ADI, Alias, Alias (swirl design/logo), AliasStudio, AliasWavefront (design/logo), ATC, AUGI, AutoCAD, AutoCAD Learning Assistance, AutoCAD LT, AutoCAD Simulator, AutoCAD SQL Extension, AutoCAD SQL Interface, Autodesk, Autodesk Envision, Autodesk Insight, Autodesk Intent, Autodesk Inventor, Autodesk Map, Autodesk MapGuide, Autodesk Streamline, AutoLISP, AutoSnap, AutoSketch, AutoTrack, Backdraft, Built with ObjectARX (logo), Burn, Buzzsaw, CAiCE, Can You Imagine, Character Studio, Cinestream, Civil 3D, Cleaner, Cleaner Central, ClearScale, Colour Warper, Combustion,
Trademarks

The following are registered trademarks or trademarks of Autodesk Canada Co. in the USA and/or Canada and other countries: Backburner, Multi-Master Editing, River, and Sparks.

The following are registered trademarks or trademarks of Moldflow Corp. in the USA and/or other countries: Moldflow MPA, MPA (design/logo), Moldflow Plastics Advisers, MPI, MPI (design/logo), Moldflow Plastics Insight, MPX, MPX (design/logo), Moldflow Plastics Xpert.

clothfx™ is a trademark of Size8 Software, Inc. Havok.com™ is a trademark or registered trademark of Havok.com Inc. or its licensors. Intel is a registered trademark of Intel Corporation. mental ray is a registered trademark of mental images GmbH licensed for use by Autodesk, Inc. All other brand names, product names or trademarks belong to their respective holders.

Disclaimer

THIS PUBLICATION AND THE INFORMATION CONTAINED HEREIN IS MADE AVAILABLE BY AUTODESK, INC. "AS IS." AUTODESK, INC. DISCLAIMS ALL WARRANTIES, EITHER EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED
TO ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE REGARDING THESE MATERIALS.
Getting Started with 3ds Max

You use 3ds Max to quickly create professional-quality 3D models, photorealistic still images, and film-quality animation on your PC.

Before using this reference material, we highly recommend you get to know 3ds Max firsthand by following the included tutorials. You can access the tutorials using the Help menu > Tutorials command.
Project Workflow

Once you’ve installed 3ds Max (see the Installation Guide included with your software package), you open it from the Start menu, or use any other Windows method. The figure below shows the application window with a scene file loaded.

Main program window

NOTE If you open 3ds Max from a Command Prompt window or batch file, you can add command-line switches. See Starting 3ds Max from the Command Line on page 7985.
NOTE 3ds Max is a single-document application, meaning you can work on only one scene at a time. You can run 3ds Max several times and open a different scene in each instance, but doing so requires a lot of RAM. For best performance, open only one instance and work on one scene at a time.

Modeling Objects

You model and animate objects in the viewports, whose layout is configurable. You can start with a variety of 3D geometric primitives. You can also use 2D shapes as the basis for lofted or extruded objects. You can convert objects to a variety of editable surface types, which you can then model further by pulling vertices and using other tools.

Another modeling tool is to apply modifiers to objects. Modifiers can change object geometry. Bend and Twist are examples of modifiers.

Modeling, editing, and animation tools are available in the command panels and toolbar. See Modeling Objects on page 33. Also, you can learn a good deal about modeling from the tutorials available from Help menu > Tutorials.
Material Design

You design materials using the Material Editor, which appears in its own window. You use the Material Editor to create realistic materials by defining hierarchies of surface characteristics. The surface characteristics can represent static materials, or be animated. See Material Editor on page 5641. Tutorials especially helpful for learning about materials include "Overview of Creating a Scene: Still Life" and "Using Materials."

Lights and Cameras

You create lights with various properties to illuminate your scene. The lights can cast shadows, project images, and create volumetric effects for atmospheric lighting. Physically-based lights let you use real-world lighting data in your scenes and Radiosity on page 6615 provides incredibly accurate light simulation in renderings. See Lights on page 5314. You can learn more about lighting by following the Introduction to Lighting tutorial.
The cameras you create have real-world controls for lens length, field of view, and motion control such as truck, dolly, and pan. See Cameras on page 5545.

**Animation**

You can begin animating your scene at any time by turning on the Auto Key button. Turn the button off to return to modeling. You can also perform animated modeling effects by animating the parameters of objects in your scene. You can learn more about animating in the Animating Your Scene topic on page 40 and from most of the tutorials.
When the Auto Key button is on, 3ds Max automatically records the movement, rotation, and scale changes you make, not as changes to a static scene, but as keys on certain frames that represent time. You can also animate many parameters to make lights and cameras change over time, and preview your animation directly in the 3ds Max viewports.

You use Track View on page 3790 to control animation. Track View is a floating window where you edit animation keys, set up animation controllers, or edit motion curves for your animated effects.

**Rendering**

Rendering adds color and shading to your scene. The renderers available with 3ds Max include features such as selective ray tracing, analytical antialiasing, motion blur, volumetric lighting, and environmental effects. See Rendering Your Scene on page 41. The tutorials can help you learn about rendering.
When you use the default scanline renderer, a radiosity solution can provide accurate light simulation in renderings, including the ambient lighting that results from reflected light. When you use the mental ray renderer, a comparable effect is provided by global illumination.

If your workstation is part of a network, network rendering can distribute rendering jobs over multiple workstations. See Network Rendering.

With Video Post, you can also composite the scene with animations stored on disk.

A Typical Project Workflow

These topics explain the basic procedures for creating scenes:

Setting Up Your Scene
Modeling Objects
Using Materials
Placing Lights and Cameras
Animating Your Scene
Setting Up Your Scene

You start with a new unnamed scene when you open 3ds Max. You can also start a new scene at any time by choosing New or Reset from the Application menu on page 7989.

Choosing a Unit Display

You choose a system of unit display on the Units Setup dialog on page 8366. Choose from Metric, Standard US, and Generic methods, or design a custom measuring system. You can switch between different systems of unit display at any time.

NOTE For best results, use consistent units when you are going to:
- Merge scenes and objects on page 7572.
- Use XRef objects on page 7450 or XRef scenes on page 7477.

Setting the System Unit

The System Unit setting, in the Units Setup dialog on page 8366, determines how 3ds Max relates to distance information you input to your scene. The setting also determines the range for round-off error. Consider changing the system unit value only when you model very large or very small scenes.

Setting Grid Spacing

Set spacing for the visible grid in the Grid And Snap Settings dialog > Home Grid panel on page 2833. You can change grid spacing at any time.

See Precision and Drawing Aids on page 2781 for information about the system unit, unit display, and grid spacing.
Setting the Viewport Display

The default four viewports in 3ds Max represent an efficient and popular screen layout. Set options in the Viewport Configuration dialog on page 8374 to change viewport layout and display properties.

See Viewing and Navigating 3D Space on page 65 for more information.

Saving Scenes

Save your scene frequently to protect yourself from mistakes and loss of work. See Backing Up and Archiving Scenes on page 61.

Modeling Objects

You model objects in your scene by creating standard objects, such as 3D geometry and 2D shapes, and then applying modifiers to those objects. 3ds Max includes a wide range of standard objects and modifiers.

Creating Objects

You create objects by clicking an object category and type on the Create panel and then clicking or dragging in a viewport to define the object's creation.
parameters. 3ds Max organizes the Create panel into these basic categories: Geometry, Shapes, Lights, Cameras, Helpers, Space Warps, and Systems. Each category contains multiple subcategories from which you can choose.

You can also create objects from the Create menu by choosing an object category and type and then clicking or dragging in a viewport to define the object's creation parameters. 3ds Max organizes the Create menu into these basic categories: Standard Primitives, Extended Primitives, AEC Objects, Compound, Particles, Patch Grids, NURBS, Dynamics, Shapes, Lights, Cameras, Helpers, Space Warps, and Systems.

See Basics of Creating and Modifying Objects on page 358.

Selecting and Positioning Objects

You select objects by clicking or dragging a region around them. You can also select objects by name or other properties such as color or object category.

After selecting objects, you position them in your scene using the transform tools Move, Rotate, and Scale. Use alignment tools to precisely position objects.

See Selecting Objects on page 171, Moving, Rotating, and Scaling Objects on page 885, and Precision and Drawing Aids on page 2781.

Modifying Objects

You sculpt and edit objects into their final form by applying modifiers from the Modify panel. The modifiers you apply to an object are stored in a stack. You can go back at any time and change the effect of the modifier, or remove it from the object.

See Basics of Creating and Modifying Objects on page 358.

Using Materials

You use the Material Editor to design materials and maps to control the appearance of object surfaces. Maps can also be used to control the appearance of environmental effects such as lighting, fog, and the background.
A variety of materials in the Material Editor’s sample slots

Room on left uses the a neutral, gray material. Room on right uses a realistic materials, including transparent glass and a snowfall.

**Basic Material Properties**

You set basic material properties to control such surface characteristics as default color, shininess, and level of opacity. You can create realistic, single-color materials using just the basic properties.
Using Maps

You extend the realism of materials by applying maps to control surface properties such as texture, bumpiness, opacity, and reflection. Most of the basic properties can be enhanced with a map. Any image file, such as one you might create in a paint program, can be used as a map, or you can choose procedural maps that create patterns based on parameters you set.

3ds Max also includes a raytrace material and map for creating accurate reflections and refraction.

Viewing Materials in the Scene

You can view the effect of materials on objects in a shaded viewport, but the display is just an approximation of the final effect. Render your scene to view materials accurately.

See Designing Materials on page 5620.

Placing Lights and Cameras

You place lights and cameras to complete your scene in much the same way lights and cameras are placed on a movie set prior to filming.
Lights and cameras placed to compose a scene
The resulting scene

**Default Lighting**

Default lighting evenly illuminates the entire scene. Such lighting is useful while modeling, but it is not especially artistic or realistic.

**Placing Lights**

You create and place lights from the Lights category of the Create panel or menu when you are ready to get more specific about the lighting in your scene.

3ds Max includes the following standard light types: omni, spot, and directional lights. You can set a light to any color and even animate the color to simulate dimming or color-shifting lights. All of these lights can cast shadows, project maps, and use volumetric effects.

See *Guidelines for Lighting* on page 5330.
Photometric Lights

Photometric lights on page 5348 provide you with the ability to work more accurately and intuitively using real-world lighting units (lumens and candelas). Photometric lights also support industry-standard photometric file formats (IES on page 5376, CIBSE on page 8532, LTLI on page 8625) so that you can model the characteristics of real-world manufactured luminaires, or even drag ready-to-use luminaires from the Web. Used in conjunction with the 3ds Max radiosity solution on page 6615, photometric lights let you evaluate more accurately (both physically and quantitatively) the lighting performance of your scene.

Photometric lights are available from the Create panel > Lights drop-down list.

Daylight System

The Daylight system on page 5491 combines sunlight on page 8734 and skylight on page 8723 to create a unified system that follows the geographically correct angle and movement of the sun over the earth at a given location. You can choose location, date, time, and compass orientation. You can also animate the date and time. This system is suitable for shadow studies of proposed and existing structures.

Viewing Lighting Effects in the Scene

When you place lights in a scene, the default lighting turns off and the scene is illuminated only by the lights you create. The illumination you see in a viewport is just an approximation of the true lighting. Render your scene to view lighting accurately.

TIP If the Daylight system appears to wash out the scene, try using the Logarithmic exposure control on page 7215.

Placing Cameras

You create and place cameras from the Cameras category of the Create panel. Cameras define viewpoints for rendering, and you can animate cameras to produce cinematic effects such as dollies and truck shots.

You can also create a camera automatically from a Perspective viewport by using the Create Camera from View command on page 150 found on the Views menu. Just adjust your Perspective viewport until you like it, and then choose
Views > Create Camera From View. 3ds Max creates a camera and replaces the Perspective viewport with a Camera viewport showing the same perspective. See Common Camera Parameters on page 5570.

**Animating Your Scene**

You can animate almost anything in your scene. Click the Auto Key button to enable automatic animation creation, drag the time slider, and make changes in your scene to create animated effects.

![Auto Key]

**Controlling Time**

3ds Max starts each new scene with 100 frames for animation. Frames are a way of measuring time, and you move through time by dragging the time slider on page 8068. You can also open the Time Configuration dialog on page 8106 to set the number of frames used by your scene and the speed at which the frames are displayed.

**Animating Transforms and Parameters**

While the Auto Key button is on, 3ds Max creates an animation key on page 8616 whenever you transform an object or change a parameter. To animate a parameter over a range of frames, specify the values at the first and last frames of the range. 3ds Max calculates the values for all of the frames in between. See Animation Concepts and Methods on page 3368.

**Editing Animation**

You edit your animation by opening the Track View window or by changing options on the Motion panel. Track View is like a spreadsheet that displays animation keys along a time line. You edit the animation by changing the keys.

Track View has two modes. You can display the animation as a series of function curves that graphically show how a value changes over time in the Curve Editor mode. Alternatively, you can display your animation as a sequence of keys or ranges on a grid in the Dope Sheet mode. See Track View on page 3790.
Rendering Your Scene

Use the rendering features to define an environment and to produce the final output from your scene.

Rendering "fills in" geometry with color, shadow, lighting effects, and so on.

Defining Environments and Backgrounds

Rarely do you want to render your scene against the default background color. Open the Environment And Effects dialog > Environment panel on page 7163 to define a background for your scene, or to set up effects such as fog.

Setting Rendering Options

To set the size and quality of your final output, you can choose from many options on the Render Setup dialog on page 6506. You have full control over professional grade film and video properties as well as effects such as reflection, antialiasing, shadow properties, and motion blur.
Rendering Images and Animation

You render a single image by setting the renderer to render one frame of your animation. You specify what type of image file to produce and where 3ds Max stores the file.

Rendering an animation is the same as rendering a single image except that you set the renderer to render a sequence of frames. You can choose to render an animation to multiple single frame files or to popular animation formats such as AVI or MOV.

See Render Setup Dialog on page 6506.

The 3ds Max Window

Most of the main window is occupied by the viewports, where you view and work with your scene. The remaining areas of the window hold controls and show status information.

1. Application button
2. Quick Access toolbar
One of the most important aspects of using 3ds Max is its versatility. Many program functions are available from multiple user-interface elements. For example, you can open Track View for animation control from the Main toolbar as well as the Graph Editors menu, but the easiest way to get to a specific object’s track in Track View is to right-click the object, and then choose Track View Selected from the quad menu.

You can customize the user interface in a variety of ways: by adding keyboard shortcuts, moving toolbars and command panels around, creating new toolbars and tool buttons, and even recording scripts into toolbar buttons.

MAXScript lets you create and use custom commands in the built-in scripting language. For more information, access the MAXScript Help from the Help menu.

**Application Button and Quick Access Toolbar**

The Application button and Quick Access toolbar provide file-handling commands. To the right of them on the Caption bar, the InfoCenter controls give you quick access to 3ds Max help and other learning resources. See Caption Bar on page 7988.
Menu Bar

A standard Windows menu bar with typical Edit on page 7999 and Help on page 8032 menus. Special menus include:

- **Tools** on page 8001 contains many important program functions, including precision functions. Many of these options are duplicated on the Main toolbar.
- **Group** on page 8005 contains commands for managing combined objects.
- **Views** on page 8006 contains commands for setting up and controlling the viewports.
- **Create** on page 8008 contains commands for creating objects.
- **Modifiers** on page 8016 contains commands for modifying objects.
- **Animation** on page 8023 contains commands for animating and constraining objects, plus commands such as Bone Tools for setting up animated characters.
- **Graph Editors** on page 8027 provides graphical access to editing objects and animation: Track View lets you open and manage animation tracks in Track View on page 3790 windows, and Schematic View on page 7926 gives you an alternate way to work with the objects in your scene and navigate to them.
- **Rendering** on page 8028 contains commands for rendering, using radiosity on page 6615, and changing the environment.
- **Customize** on page 8029 gives you access to controls that let you customize the user interface.
- **MAXScript** on page 8031 has commands for working with MAXScript, the built-in scripting language.

For more information about the 3ds Max menus, see Menu Bar on page 7998.

Time Controls

The **Auto Key button** on page 3373 turns on animation mode. The other controls navigate through time and play back an animation.
Command Panel

This collection of six panels provides handy access to most of the modeling and animation commands.

You can "tear off" the command panel and place it anywhere you like.

By default, the command panel is docked at the right of your screen. You can access a menu that lets you float on page 8555 or dismiss the command panel by right-clicking just above it. If it is not displayed, or you want to change its location and docking or floating status, right-click in a blank area of any toolbar, and choose from the shortcut menu.

- **Create** on page 8182 holds all object creation tools.
- **Modify** on page 8184 holds modifiers and editing tools.
- **Hierarchy** on page 8213 holds linking and inverse kinematics parameters.
- **Motion** on page 8215 holds animation controllers and trajectories.
- **Display** on page 8217 holds object display controls.
- **Utilities** on page 8223 holds miscellaneous utilities.

Status Bar and Prompt Line

These two lines display prompts and information about your scene and the active command. They also contain system toggles controlling selections, precision, and display properties. See Status Bar Controls on page 8064.
Viewports

You can display from one to four viewports. These can show multiple views of the same geometry, as well as the Track View, Schematic View, and other informational displays. See Viewports on page 8113.

Viewport Navigation Buttons

The button cluster at the lower-right corner of the main window contains controls for zooming, panning, and navigating within the viewports. See Viewport Controls on page 8113.

Special Controls

3ds Max uses some special user interface controls, which are described in this topic.

- Right-click menus on page 46
- Flyouts on page 47
- Rollouts on page 47
- Scrolling panels and toolbars on page 48
- Spinners on page 49
- Numerical Expression Evaluator on page 49
- Entering numbers on page 50
- Controls and color on page 50
- Undoing actions on page 50

Right-Click Menus

3ds Max uses several different types of right-click menus.

For object editing and ActiveShade control on page 6558, you use the quad menu on page 8052. Commands on the quad menu vary depending on the kind of object you are editing and the mode you are in.

Each viewport has three labels that are menus you can access by either clicking or right-clicking. These let you change viewport display settings, choose the
point-of-view to display, how to shade the viewport, and so on. See Viewport Label Menus on page 8117.

Also, the command panel and the Material Editor have right-click menus that let you manage rollouts and navigate the panel quickly. And most other windows, including Schematic View and Track View, have right-click menus that provide fast access to commonly used functions.

**Flyouts**

A flyout on page 8582 is similar to a menu, except that its items are buttons. A flyout button is indicated by a small arrow in the lower-right corner. To display the flyout, click and hold the button for a moment, then choose a button by dragging the cursor to it and then releasing the mouse button.

NOTE You can define customized text annotations for flyouts by editing the maxstart.cui file. See Customize Menu on page 8029.

**Rollouts**

Rollouts are areas in the command panels and dialogs that you can expand (roll out) or collapse (roll in) to manage screen space. In the illustration above, the Keyboard entry rollout is collapsed, as indicated by the + sign, and the Parameters rollout is expanded, as indicated by the − sign.
To open and close a rollout:

- Click the rollout title bar to toggle between expanded and collapsed.

To move a rollout:

- You can move a rollout in the expanded or collapsed state. To move the rollout, drag the rollout title bar to another location on the command panel or dialog. As you drag, a semi-transparent image of the rollout title bar follows the mouse cursor. When the mouse is positioned over or near a qualifying position for the rollout, a blue, horizontal line appears at the position where the rollout will drop when you release the mouse button.

Scrolling Panels and Toolbars

Sometimes a command panel or dialog is not large enough to display all of its rollouts. In this case, a pan ("hand") cursor appears over the inactive parts of the panel. You can scroll command panels and dialogs vertically, and you can scroll a toolbar along its major axis.

To scroll a panel:

1. Place the pointer over an empty area of a panel to display the pan cursor.
2. When the pointer icon changes to a hand, drag the panel up or down. A thin scroll bar also appears on the right side of the scrolling panel. You can use the pointer to drag the scroll bar as well.

To scroll a toolbar:

You can scroll a toolbar only when some tool buttons are not visible. This typically occurs when 3ds Max window is smaller than full screen.

1. First, follow either of the procedures below:
   - Place the pointer over an empty area of a toolbar to display the pan cursor.
   - Place the pointer over any part of a toolbar, then press and hold the middle mouse button.
2. When the pointer icon changes to a hand, drag the toolbar horizontally.
Spinners

A spinner is a mouse-based control for numeric fields. You can click or drag the spinner arrows to change the value in the field.

To change a value using a spinner, do any of the following:

1. Click the spinner's up arrow to increment the value; click the down arrow to decrement the value. Click and hold for continuous change.
2. Drag upward to increase the value, or drag downward to decrease it.
3. Press Ctrl while you drag to increase the rate at which the value changes.
4. Press Alt while you drag to decrease the rate at which the value changes.
5. Right-click a spinner to reset the field to its minimum value.

Numerical Expression Evaluator

While a numeric field is active, you can display a calculator called the Numerical Expression Evaluator. To display the calculator, press Ctrl+N.

The expression you enter is evaluated, and its result is displayed in the Result field. Click Paste to replace the field value with the result of the calculation. Click Cancel to exit the Expression Evaluator.

The expressions you can enter are described in Expression Techniques on page 339. You can't use variables in the Expression Evaluator, but you can enter the constants pi (circular ratio), e (natural logarithm base), and TPS (ticks per second). These constants are case-sensitive: the Expression Evaluator does not recognize PI, E, or tps.
You can also enter a vector expression or an Expression Controller function call, but the result of the expression or function must be a scalar value. Otherwise, the Expression Evaluator won’t evaluate it.

**Entering Numbers**

You can change a numeric value by a relative offset by highlighting the contents of a numeric field (not in the Numerical Expression Evaluator) and typing \texttt{R} or \texttt{r} followed by the offset amount.

For example, a Radius field shows 70 and you highlight it:

- If you enter \texttt{R30}, 30 is added to the radius and the value changes to 100.
- If you enter \texttt{R-30}, 30 is subtracted from the radius and the value changes to 40.

**Controls and Color**

The user interface uses color cues to remind you what state 3ds Max is in.

NOTE You can customize most of these colors by using the Colors panel on page 8272 of the Customize User Interface dialog on page 8249.

- **Red for animation:** The Auto Key button, the time slider background, and the border of the active viewport turn red when you are in Animate mode.

- **Yellow for modal function buttons:** When you turn on a button that puts you in a generic creation or editing mode, the button turns yellow.

- **Yellow for special action modes:** When you turn on a button that alters the normal behavior of other functions, the button is highlighted in yellow. Common examples of this behavior include sub-object selection and locking your current selection set.

You can exit a functional mode by clicking another modal button. Other exit methods supported by some buttons include right-clicking in a viewport, or clicking the modal button a second time.

**Undoing Actions**

You can easily undo changes you make to your scene and your viewports. There are separate Undo buffers for both the scene objects and each viewport.
Use the toolbar **Undo and Redo buttons** on page 240 or the Edit menu > Undo and Redo commands to reverse the effects of most scene operations. You can also use Ctrl+Z for Undo and Ctrl+Y for Redo. Most things you do in 3ds Max can be undone.

Use the Views menu > **Undo and Redo commands** on page 126 to reverse the effects of most viewport operations, such as zooming and panning. You can also use Shift+Z for Undo View Change and Shift+Y for Redo View Change.

You can also undo actions by using the Hold and Fetch commands on the Edit menu. Choose Edit menu > Hold to save a copy of your scene in a temporary file. Then choose Edit menu > Fetch to discard your current scene and revert to the held scene at any time.

**Managing Files**

3ds Max supports many types of files for working with plug-ins, image maps, models from other programs, rendering images and animations, and of course saving and opening your scene files.
File-management dialogs

File dialogs (such as Open, Save, Save As) uniformly remember the previous path you used, and default to that location.

**Configuring File Paths**

The locations that 3ds Max searches to locate all file types are specified on the Customize menu > Configure Paths dialogs on page 8283.
You can choose to open and save files in any path location. The Configure Paths dialog contains four panels for the general categories of support files.

### Setting General File Paths

The File I/O panel on page 8287 contains paths for most of the standard support files. You can specify one path for each of file types 3ds Max uses.

### Setting Plug-In File Paths

Many features of 3ds Max are implemented as plug-ins. This means you can change and extend 3ds Max functionality by adding new plug-ins from Autodesk Media and Entertainment or from third-party developers.

You tell 3ds Max where to find additional plug-in files by adding path entries on the 3rd Party Plug-Ins panel on page 8296. If you place all of your plug-ins in a single directory, plug-in file management can become messy. That's why 3ds Max supports multiple entries on the 3rd Party Plug-Ins panel.

### Setting Bitmap, FX, and Download File Paths

The External Files panel on page 8289 contains multiple path entries that 3ds Max searches for image files on page 7831, downloaded files (via i-drop on page...
7644), and FX files on page 8589. Image files are used for many purposes, such as material and map definition, light projections, and environment effects.

**Setting XRefs File Paths**

The XRefs panel on page 8292 contains multiple path entries that 3ds Max uses to search for externally referenced files. These are used for sharing files in a workgroup situation.

**Importing, Merging, Replacing, and Externally Referencing Scenes**

You can realize great productivity gains when you reuse work by combining geometry from scenes or other programs. 3ds Max supports this technique with the Import, Merge, and Replace commands. You can also share scenes and objects with others working on the same project using XRef functionality.
Gear model imported to become part of another scene

Importing Geometry from Other Programs

Use Application menu on page 7989 > Import on page 7446 to bring objects from other programs into a scene. The types of files that you can import are listed in the Files Of Type list in the Select File To Import dialog.

Depending on the file type you choose, you might have options available for that import plug-in.

Merging Scenes Together

Use Merge on page 7572 to combine multiple scenes into a single large scene. When you merge a file, you can select which objects to merge. If objects being merged have the same name as objects in your scene, you have the option to rename or skip over the merged objects.
Pipe and ashtray models merged into one scene

**Merging Animation into Scenes**

Use [Merge Animation](#) on page 4126 to merge the animation from one scene into another with the same (or similar) geometry.
Replacing Scene Objects

Use Replace on page 7578 to replace objects in your scene with objects in another scene that have duplicate names. Replace is useful when you want to set up and animate your scene with simplified objects, and then replace the simple objects with detailed objects before rendering.

The Replace dialog looks and functions the same as Merge, except that it lists only objects that have the same name as objects in your current scene.

Using External References

Use XRef Objects on page 7450 and XRef Scenes on page 7477 to use objects and scene setups in your scene that are actually referenced from external MAX files. These functions allow sharing files with others in your workgroup, with options for updating and protecting external files.

Using the Asset Browser

The Asset Browser provides access from your desktop to design content on the World Wide Web. From within 3ds Max you can browse the Internet for texture samples and product models. This includes bitmap textures (BMP, JPG, GIF, TIF, and TGA) and geometry files (MAX, 3DS, and so on).
You can drag these samples and models into your scene for immediate visualization and presentation. You can snap geometry into predefined locations, or drag and drop them interactively in your scene.

You can also use the Asset Browser to browse thumbnail displays of bitmap textures and geometry files on your hard disk or shared network drives. Then you can either view them or drag and drop them into your scene or into valid map buttons or slots.

**NOTE** The thumbnail display of a geometry file is a bitmap representation of a view of the geometry. Since the thumbnail display is not a vector-based representation, you can't rotate it or perform zooms on it.

You can drag and drop most graphic images that are embedded in a Web page into your scene. The exception is images or regions of a Web page that are tagged as hyperlinks or other HTML controls (such as when a bitmap is tagged as a button).
Startup Files and Defaults

When you start 3ds Max, several auxiliary files load, setting things like program defaults and UI layout. You can even create a scene, named `maxstart.max`, that automatically loads when you start or reset 3ds Max. In some cases, 3ds Max updates files when you change settings and when you quit 3ds Max.

**NOTE** 3ds Max comes with several different *market-specific defaults* on page 8246. These set different program defaults on startup, based on the type of files you expect to work on most often. You can load the preset defaults that come with 3ds Max, or you can create your own.

In general, you don’t need to work directly with the auxiliary files, but it’s good to know about them. Among the auxiliary files 3ds Max uses are:

- **3dsmax.ini** on page 60: This file gets updated when you start and exit 3ds Max, as well as when you change most Preferences settings. It contains values relating to program defaults, including the graphics driver, directories used to access external files such as sounds and images, preset render sizes, dialog positions, snap settings, and other preferences and default settings. If you edit this file, be sure to make a copy first, so you can return to the original if anything goes wrong.

  **NOTE** Many program defaults are set in `currentdefaults.ini`, found within the `\defaults` directory. For more information on this file, see *Market-Specific Defaults* on page 8246.

- **maxstart.max**: At startup and when you reset 3ds Max, 3ds Max looks for this file in the `MaxStart` folder specified in Configure User Paths > File I/O panel on page 8287, and if found, loads it. This allows you to specify the default state of the workspace whenever you start or reset 3ds Max. For example, if you always use a ground plane, you can make it the default setup by creating one, and then saving it as `maxstart.max`. If you save a different file over `maxstart.max`, you can return to program defaults by deleting the `maxstart.max` file, and then resetting 3ds Max.
maxstart.cui: This is the default custom user interface file. You can load and save CUI files, and set 3ds Max to use a different default CUI file. See Customize Menu on page 8029.

plugin.ini: This file contains directory paths for plug-ins. Most other paths are kept in 3ds Max INI file, but plugin.ini is maintained as a separate file because third-party plug-ins often add entries to the list at installation.

NOTE It is possible to use multiple plug-in configuration files by nesting additional paths in your plugin.ini file. This can be very useful for allowing an entire network of users to share one plugin.ini file, making the system easier to maintain for the network administrator. For more information, see Network Plug-In Configuration on page 8297.

startup.ms: A MAXScript file that automatically executes at startup time. For more information, see Startup Script on page 8730.

The Initialization File

The file 3ds Max uses to store settings between sessions is named 3dsmax.ini. In most cases, you don’t need to access this file directly. To find it, if necessary, use the Windows Search function.

You can make changes to 3ds Max startup conditions by editing the 3dsmax.ini file in a text editor such as Notepad. If you do edit the file, be sure to maintain the structure and syntax of the original file.

TIP If you encounter unusual and unexplained user-interface problems using 3ds Max, try deleting the 3dsmax.ini file and restarting. 3ds Max writes a new INI file to replace the deleted one. Often this fixes problems related to the state of the user interface.

NOTE Startup scene conditions are defined by the maxstart.max file. To save a particular startup condition, such as a Plane object representing the ground, create a scene file with the condition present and then save it as maxstart.max. 3ds Max automatically opens this file when you start 3ds Max.

The 3dsmax.ini file includes the following categories of settings:

[Directories] Defines the default paths for various file operations.

[Performance] Controls that speed up viewport performance.
[PlugInKeys] Turns on or off the keyboard shortcuts for plug-ins.
[Renderer] Controls for rendering alpha and filter backgrounds.
[RenderPresets] Defines the paths for Rendering Preset files.
[BitmapDirs] Defines the default map paths for bitmaps used by materials.
[Modstack] Controls modifier stack button sets and icon display.
[WindowState] Settings for software display, OpenGL, or Direct3D drivers.
[CustomMenus] Defines path for the .mnu file.
[CustomColors] Defines the path for the .clr file.
[KeyboardFile] Defines the path for the .kbd file.
[ObjectSnapSettings] Settings associated with snaps.
[CommandPanel] Sets number of columns, and controls rollout display in multiple columns.

**Backing Up and Archiving Scenes**

You should regularly back up and archive your work. One convenient method is to save incremental copies of your scenes. This method creates a history of your work process.

**Saving Incremental Files**

If you turn on the Increment On Save option on the Files panel on page 8305 of the Preferences dialog, the current scene is renamed by appending a two-digit number to the end of the file and incrementing the number each time you save. For example, if you open a file named myfile.max and then save it, the saved file is named myfile01.max. Each time you save the file its name is incremented, producing the files myfile02.max, myfile03.max, and so on.

You can also use Save As on page 7441 to increment the file name manually with a two-digit number by clicking the increment button (+) on the Save As dialog.
Using Auto Backup

You can automatically save backup files at regular intervals by setting the Auto Backup options on page 8307 on the Preferences dialog (see File Preferences on page 8305). The backup files are named AutoBackupN.max, where N is a number from 1 to 99, and stored, by default, in the \autoback folder. You can load a backup file like any other scene file.

Archiving a Scene

3ds Max scenes can make use of many different files. When you want to exchange scenes with other users or store scenes for archival purposes, you often need to save more than just the scene file.

Use the Application menu on page 7989 > Archive command on page 7445 to pass the scene file and any bitmap files used in the scene to an archiving program compatible with PKZIP® software.

Crash Recovery System

If 3ds Max encounters an unexpected crash, it attempts to recover and save the file currently in memory. This is fairly reliable, but it does not always work: the recovered scene could be damaged during the crash. The recovered file is stored in the configured Auto Backup path. It is saved as "<filename>_recover.max" in this path. It is also placed in the INI file as the most recently used file in the Application menu on page 7989. This makes it easy to return to the file, if you choose to do so.

The crash recovery system identifies when something in an object's modifier stack is corrupt. In these cases, the corrupt object is replaced with a red dummy object to maintain the object's position and any linked object hierarchy.
NOTE We recommend that you not rely on this file-recovery mechanism as an alternative to good data backup practices:

■ Save your work frequently.

■ Take advantage of automatic incremental file naming: Go to Customize menu > Preferences > Files panel on page 8305 > File Handling group, and turn on Increment On Save.

■ Use Application menu on page 7989 > Save > Save As, and click the Increment button (+) to save incremental copies of work in progress.

■ If you are forgetful about saving, use the Auto Backup feature. Go to Customize menu > Preferences > Files tab > Auto Backup group, and turn on Enable.
Viewing and Navigating 3D Space

Everything in 3ds Max is located in a three-dimensional world. You have a variety of options for viewing this enormous stage-like space, from the tiniest details to the full extent of your scene.

Different viewports can display different angles; on the right, the largest viewport shows a camera view.

Using the view options discussed in this section you move from one view to another, as your work and imagination require. You can fill your screen with a single, large viewport, or set
multiple viewports to track various aspects of your scene. For exact positioning, flat drawing views are available, as are 3D perspective on page 8681 and axonometric views on page 8515.

You navigate 3D space by adjusting the position, rotation and magnification of your views. You have full control over how objects are rendered and displayed on the screen.

You can also use the Grab Viewport command on page 125 to create snapshots of your work as you go.

This section presents brief topics designed to help you quickly start learning how to organize viewports and navigate through 3D space. For details about viewport commands, see Viewport Controls on page 8113.

**General Viewport Concepts**

Viewports are openings into the three-dimensional space of your scene, like windows looking into an enclosed garden or atrium. But viewports are more than passive observation points. While creating a scene, you can use them as dynamic and flexible tools to understand the 3D relationships among objects.
At times you might want to look at your scene through a large, undivided viewport, giving you a “picture-window” view of the world you’re creating. Often you use multiple viewports, each set to a different orientation.

If you want to move an object horizontally in the world space, you might do this in a top viewport, looking directly down on the object as you move it. At the same time, you could be watching a shaded perspective viewport to see when the object you’re moving slides behind another. Using the two windows together, you can get exactly the position and alignment you want.

You also have pan and zoom features available in either view, as well as grid alignment. With a few mouse clicks or keystrokes, you can reach any level of detail you need for the next step in your work.

Another way to use viewports is to place a camera in your scene and set a viewport to look through its lens. When you move the camera, the viewport tracks the change. You can do the same thing with spotlights.
In addition to geometry, viewports can display other views such as Track View and Schematic View, which display the structure of the scene and the animation. Viewports can be extended to display other tools such as the MAXScript Listener and the Asset Browser. For interactive rendering, the viewport can display the ActiveShade window.

**Active Viewport**

One viewport, marked with a highlighted border, is always active. The active viewport is where commands and other actions take effect. Only one viewport can be in the active state at a time. If other viewports are visible, they are set for observation only; unless disabled, they simultaneously track actions taken in the active viewport.

**Saving the Active Viewport**

You can save the view in any active viewport and later restore it with the Views menu's Save Active View on page 127 and Restore Active View on page 128 commands. One view can be saved for each of the following view types: Top, Bottom, Left, Right, Front, Back, Orthographic, Perspective.

For example, while in the Front view, you choose Save Active Front View, and then zoom and pan that view. You then activate the Top viewport, choose Save Active Top View, and then click Zoom Extents. You return to the Front view, and choose Restore Active Front View to return to its original zoom and pan. At any time, you can activate the Top viewport, and then choose Restore Active Top View to restore its saved view.

**Home Grid: Views Based on the World Coordinate Axes**

The grid you see in each viewport represents one of three planes that intersect at right angles to one another at a common point called the origin. Intersection occurs along three lines (the world coordinate axes: X, Y, and Z) familiar from geometry as the basis of the Cartesian coordinate system.
The three planes based on the world coordinate axes are called the home grid; this is the basic reference system of the 3D world.

To simplify the positioning of objects, only one plane of the home grid is visible in each viewport. The figure shows all three planes as they would appear if you could see them in a single perspective viewport.
Axes, Planes, and Views

Two axes define each plane of the home grid. In the default Perspective viewport, you are looking across the XY plane (ground plane), with the X axis running left-to-right, and the Y axis running front-to-back. The third axis, Z, runs vertically through this plane at the origin.
Home Grid and Grid Objects

Above: Inactive grid object in a scene
Below: Activated grid object

The home grid is aligned with the world coordinate axes. You can turn it on and off for any viewport, but you can’t change its orientation.

For flexibility, the home grid is supplemented by grid objects: independent grids you can place anywhere, at any angle, aligned with any object or surface. They function as "construction planes" you can use once and discard or save for reuse. See Precision and Drawing Aids on page 2781.
AutoGrid

The AutoGrid feature lets you create and activate temporary grid objects on the fly. This lets you create geometry off the face of any object by first creating the temporary grid, then the object. You also have the option to make the temporary grids permanent. See AutoGrid on page 2792.

Understanding Views

Each viewport can be set to display either of two types of views: axonometric or perspective.

- Axonometric views on page 8515 show the scene without perspective. All lines in the model are parallel to one another. The Top, Front, Left, and Orthographic viewports are axonometric views.
Perspective views on page 8681 show the scene with lines that converge at the horizon. The Perspective and Camera viewports are examples of perspective views.

Perspective view of the same model

Perspective views most closely resemble human vision, where objects appear to recede into the distance, creating a sense of depth and space. Axonometric views provide an undistorted view of the scene for accurate scaling and placement. A common workflow is to use axonometric views to create the scene, then use a perspective view to render the final output.

Axonometric Views

There are two types of axonometric views you can use in viewports: head-on and rotated.

An orthographic view on page 8668 is often a head-on view of the scene, such as the view shown in the Top, Front, and Left viewports. You can set a viewport to a specific orthographic view using the Point-Of-View (POV) viewport label menu on page 8122, keyboard shortcuts on page 8419, or the ViewCube on page 86. For example, to set an active viewport to Left view, press L.
You can also rotate an orthographic view to see the scene from an angle while retaining parallel projection. However, when viewing the scene from an angle, it’s often more helpful to use a perspective view.

**Perspective Views**

A perspective viewport, labeled Perspective, is one of the startup viewports in 3ds Max. You can change any active viewport to this "eye-like" point of view by pressing P.

**Camera View**

Once you create a camera object in your scene, you can change the active viewport to a camera view by pressing C and then selecting from a list of cameras in your scene. You can also create a camera view directly from a perspective viewport, using the Create Camera from View command.

A camera viewport tracks the view through the lens of the selected camera. As you move the camera (or target) in another viewport, you see the scene move accordingly. This is the advantage of the Camera view over the Perspective view, which can’t be animated over time.

If you turn on Orthographic Projection on a camera’s Parameters rollout, that camera produces an axonometric view. See Cameras on page 5545.
The viewport on the right is seen through a camera in the scene.

Two and Three-Point Perspective and the Camera Correction Modifier

By default, camera views use three-point perspective, in which vertical lines appear to converge with height (in traditional photography this is known as *keystoning*). The Camera Correction modifier on page 5607 applies two-point perspective to a camera view. In two-point perspective, vertical lines remain vertical. A similar effect can be attained by putting a Skew modifier on a camera.

Light View

Light view works much like a targeted camera view. You first create a spotlight or directional light and then set the active viewport to that spotlight. The easiest way is to press the keyboard shortcut $. See Lights on page 5314.
The viewport on the right looks through the lens of a spotlight in the scene.

**Setting Viewport Layout**

3ds Max defaults to a 2 x 2 arrangement of viewports. Thirteen other layouts are available, but the maximum number of viewports on the screen remains four.

Using the Layout panel on page 8379 of the Viewport Configuration dialog, you can pick from the different layouts and customize the viewports in each. The viewport configuration is saved with your work.
Resizing the Viewport

After choosing a layout you can resize the viewports so they have different proportions by moving the splitter bars that separate the viewports. This is available only when multiple viewports are displayed.
Changing the View Type

As you work, you can change the view in any viewport quickly. For example, you can switch from front view to back view. You can use either of two methods: menu or keyboard shortcut.

- Click or right-click the Point-Of-View (POV) viewport label of the viewport you want to change. Then from the POV viewport label menu on page 8122, click the view type that you want.
- Click the viewport you want to change, and then press one of the keyboard shortcuts in the following table.

<table>
<thead>
<tr>
<th>Key</th>
<th>View type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>T</td>
<td>Top view</td>
<td></td>
</tr>
<tr>
<td>B</td>
<td>Bottom view</td>
<td></td>
</tr>
<tr>
<td>F</td>
<td>Front view</td>
<td></td>
</tr>
<tr>
<td>L</td>
<td>Left view</td>
<td></td>
</tr>
<tr>
<td>C</td>
<td>Camera view. If your scene has only one camera, or you select a camera before using this keyboard shortcut, that camera supplies the view. If your scene has more than one camera, and none are selected, a list of cameras appears.</td>
<td></td>
</tr>
<tr>
<td>P</td>
<td>Perspective view. Retains viewing angle of previous view.</td>
<td></td>
</tr>
<tr>
<td>U</td>
<td>Orthographic User view. Retains viewing angle of previous view. Allows use of Zoom Region on page 8149.</td>
<td></td>
</tr>
<tr>
<td>none</td>
<td>Right view. Use the POV viewport label menu on page 8122.</td>
<td></td>
</tr>
</tbody>
</table>
Controlling Viewport Rendering

You can choose from multiple options to display your scene. You can display objects as simple boxes, or render them with smooth shading and texture mapping. If you want, you can choose a different display method for each viewport.

<table>
<thead>
<tr>
<th>Key</th>
<th>View type</th>
</tr>
</thead>
<tbody>
<tr>
<td>none</td>
<td>Shape view. Use the <strong>POV viewport label menu</strong> on page 8122. Automatically aligns view to the extents of a selected shape and its local XY axes.</td>
</tr>
</tbody>
</table>

See also:

- Viewport Layout on page 8379
- Camera Viewport Controls on page 8154
- Spotlight Parameters on page 5439
- Precision and Drawing Aids on page 2781
- Track View on page 3790
Box display, wireframe display, and smooth shading

**TIP** If you want to display and render an individual object as wireframe, you can use a Standard or Raytrace material and set its shader to Wire on page 5971. Or, to display an individual object to display as a box, select the object and choose Display as Box on page 166 on the Display properties rollout on the display panel.

**Using Viewport Rendering Controls**

Viewport rendering options are found on the Shading viewport label menu on page 8130 and on the Rendering Method panel on page 8374 of the Viewport Configuration dialog. Using these controls you can set a rendering level and any options associated with that level. The viewport label menu settings apply to the active viewport only, but the Rendering Method panel lets you apply settings to the active viewport, all viewports, or to all but the active viewport.

The rendering level you choose is determined by your need for realistic display, accuracy, and speed. For example, Bounding Box display level can be much faster than Smooth + Highlights, depending on scene complexity. The more realistic the rendering level, the slower the display speed.

After choosing a rendering level, you can set rendering options. Different options are available for different rendering levels.
You can also use ActiveShade on page 6557 in a viewport. This feature helps you quickly preview changes you make to lighting and materials.

Viewport rendering has no effect on final renderings produced by clicking Render Scene.

Rendering Methods and Display Speed

The rendering methods not only affect the quality of your view display, they can also have a profound effect on display performance. Using higher quality rendering levels and realistic options slows display performance.

After setting a rendering method, you can choose additional options that adjust display performance. One of these controls, Adaptive Degradation, speeds up display performance when you use realistic rendering levels.

See Rendering Method on page 8374.

Controlling Display Performance

3ds Max contains controls to help you adjust display performance: the balance between quality and time in displaying objects.

Depending on your needs, you might give up some display speed to work at higher levels of rendering quality, or you might choose to maximize display speed by using Wireframe or Bounding Box display. Which method you choose depends on your preferences and the requirements of your work.

Display Performance Controls

You use display performance controls to determine how objects are rendered and displayed.

Viewport Preferences

The Customize > Preferences dialog's Viewports panel contains options for fine-tuning the performance of the viewport display software. See Viewport Preferences on page 8308.

How Objects Are Displayed

To see and modify an object's display properties, right-click the object, select Properties, and go to the Display Properties group box; see Object Properties on page 283. These options affect display performance much the same way as
viewport rendering options. For example, turning on Vertex Ticks for an object with a lot of vertices will slow performance.

**NOTE** Display Properties are only available when the By Object/By Layer toggle is set to By Object.

To see and modify how objects are displayed, you can use layers on page 7953. You can then quickly control the visibility and editability of similar objects from the quad menu.

### Which Objects Are Displayed

One way to increase display speed is not to display something. You can use the Hide and Freeze functions on the Display panel, quad menu, Layer Manager on page 7956, and Scene Explorer on page 7888 to change the display state of objects in your scene. The Hide and Freeze features also affect final Rendering and Video Post output. See Hide Rollout on page 161 and Freeze Rollout on page 163.

### Setting Adaptive Degradation

Adaptive Degradation dynamically adjusts viewport rendering levels to maintain a desired level of display speed. You have direct control over how much "degradation" occurs and when it occurs.

The active levels determine which rendering levels 3ds Max falls back to when it cannot maintain the desired display speed. You can choose as many levels as you want but you are advised to choose only one or two levels for each type of degradation.

See Adaptive Degradation on page 8498.

### Using Standard View Navigation

To navigate through your scene, use the view navigation buttons located at the lower-right corner of the 3ds Max window. All view types, except Camera and Light views, use a standard set of view navigation buttons.
Button Operation

Clicking standard view navigation buttons produces one of two results:

- Executes the command and returns to your previous action.
- Activates a view navigation mode.

You can tell that you are in a navigation mode because the button remains highlighted (orange background). This mode remains active until you right-click or choose another command.

While in a navigation mode, you can activate other viewports of the same type, without exiting the mode, by clicking in any viewport. See Viewport Controls on page 8113.

Undoing Standard View Navigation Commands

Use the Undo View Change and Redo View Change commands on page 126 on the Views menu to reset standard view navigation commands without affecting other viewports or the geometry in your scene. Undo View Change also appears on the Point-Of-View (POV) viewport label menu on page 8122. Or you can use the keyboard shortcuts: Shift+Z for Undo View Change and Shift+Y for Redo View Change.

Views menu > Undo View Change and Views menu > Redo View Change are different from Undo and Redo commands on the Edit menu and main toolbar. 3ds Max maintains separate Undo/Redo buffers for scene editing and for each viewport.

The View Change Undo/Redo buffer stores your last 20 view navigation commands for each viewport. You can step back through the Undo View/Redo View buffer until you have undone all of the stored view-navigation commands.
Zooming, Panning, and Rotating Views

When you click one of the view navigation buttons, you can change these basic view properties: zooming, panning, and rotating.

**NOTE** You can also navigate the viewport with the **ViewCube** on page 86 and **SteeringWheels** on page 93 toolsets.

![Zoom](image1.png) **Zoom** Controls zooming in and out.

**Pan View** Controls panning in any direction.

![Orbit](image2.png) **Orbit** Controls rotating in any direction

Before and after zooming a viewport

Before and after rotating a viewport
Zooming a View

Click Zoom on page 8142 or Zoom All on page 8143 and drag in a viewport to change the view magnification. Zoom changes only the active view, while Zoom All simultaneously changes all non-camera views.

If a perspective view is active, you can also click Field of View (FOV) on page 8146. The effect of changing FOV is similar to changing the lens on a camera. As FOV gets larger you see more of your scene and perspective becomes distorted, similar to using a wide-angle lens. As FOV gets smaller you see less of your scene and the perspective flattens, similar to using a telephoto lens.

**WARNING** Be cautious using extreme Field of View settings. These can produce unexpected results.

Zooming a Region

Click Zoom Region on page 8149 to drag a rectangular region within the active viewport and magnify that region to fill the viewport. Zoom Region is available for all standard views.

In a perspective viewport, Zoom Region mode is available from the Field of View flyout on page 8146.

Zooming to Extents

Click the Zoom Extents or Zoom Extents All flyout buttons to change the magnification and position of your view to display the extents of objects in your scene. Your view is centered on the objects and the magnification changed so the objects fill the viewport.

The **Zoom Extents, Zoom Extents Selected buttons** on page 8138 zoom the active viewport to the extents of all visible or selected objects in the scene.
The Zoom Extents All, Zoom Extents All Selected buttons on page 8138 zoom all viewports to the extents of all objects or the current selection.

Panning a View

Click Pan View on page 8150 and drag in a viewport to move your view parallel to the viewport plane. You can also pan a viewport by dragging with the middle mouse button held down while any tool is active.

Rotating a View

Click Orbit, Orbit Selection, or Orbit Sub-Object on page 8152 to rotate your view around the view center, the selection, or the current sub-object selection respectively. When you rotate a head-on viewport, such as a Top view, it is converted to an Orthographic view, as reflected by the viewport label.

With Orbit, objects near the edges of the viewport can rotate out of view.

With Orbit Selected, selected objects remain at the same position in the viewport while the view rotates around them. If no objects are selected, the function reverts to the standard Orbit function.

With Orbit Sub-Object, selected sub-objects or objects remain at the same position in the viewport while the view rotates around them.

NOTE You can rotate a view by holding down the Alt key while you drag in a viewport using middle-button. This uses the current Orbit mode, whether or not the Orbit button is active. You can also activate Orbit by pressing Ctrl+R.

ViewCube

The ViewCube® 3D navigation control provides visual feedback of the current orientation of a viewport, lets you adjust the view orientation, and also switch between standard and isometric views.

Once the ViewCube is displayed, it appears by default in the upper-right corner of the active viewport, superimposed over the scene in an inactive state. It
does not appear in camera, light, or shape viewports, or in other types of views such as ActiveShade or Schematic. While the ViewCube is inactive, its primary function is to show the orientation of the scene based on the North direction of the model.

When you position the cursor over the ViewCube, it becomes active. Using the left mouse button, you can switch to one of the available preset views, rotate the current view, or change to the Home view of the model. Right-clicking opens a context menu with additional options.

**NOTE** If you are using the software display driver on page 8317, the ViewCube doesn’t appear.

**Control the Appearance of the ViewCube**

The ViewCube is displayed in one of two states: inactive and active. When the ViewCube is inactive, it appears transparent over the viewport by default so as not to completely obscure the view of the model. When the ViewCube is active, it is opaque and might obscure the view of objects in the scene.

You can control the opacity level of the ViewCube when it is inactive as well as its size, the viewports it appears in, and the display of the compass. These settings are located on the ViewCube panel on page 8400 of the Viewport Configuration dialog.

**Using the Compass**

The ViewCube compass indicates the North direction for the scene. You can toggle the compass display below the ViewCube and specify its orientation with the Compass settings on page 8402.

**Procedures**

**To display or hide the ViewCube:**

- Do one of the following:
  - Press the default keyboard shortcut: Alt+Ctrl+V.
Open the Viewport Configuration dialog to the **Viewport panel** on page 8400 and toggle the Show The ViewCube check box.

Click or right-click the **General (+) viewport label menu** on page 8117 and choose ViewCube > Show The ViewCube.

**To control the size and inactive opacity of the ViewCube:**

1. Open the Viewport Configuration dialog to the **Viewport panel** on page 8400.
2. In the Display Options group, click the ViewCube Size drop-down list and choose a size. The choices are Large, Normal, Small, and Tiny.
3. Also in the Display Options group, click the Inactive Opacity drop-down list and choose an opacity value. The choices range from 0% (invisible when inactive) to 100% (always fully opaque).
4. Click OK.

**To display the compass for the ViewCube**

1. Open the Viewport Configuration dialog to the **Viewport panel** on page 8400.
2. In the Compass group, turn on Show Compass Below The ViewCube. The compass is displayed below the ViewCube and indicates the North direction in the scene.
3. Click OK.

**Viewport Menu**

Right-click the ViewCube.

The ViewCube menu provides options to define the orientation of the ViewCube, switch between orthographic and perspective projection, define the Home and Front views for the model, and control the appearance of the ViewCube.

The following options can be found on the shortcut menu of the ViewCube:

- **Home**  Restores the Home view saved with the model.
- **Orthographic**  Switches the current view to orthographic projection.
- **Perspective**  Switches the current view to perspective projection.
- **Set Current View as Home**  Defines the Home view of the model based on the current view.
- **Set Current View as Front**  Defines the Front view of the model based on the current view.
- **Reset Front**  Resets the Front view of the scene to its default orientation.
- **Configure**  Opens the Viewport Configuration dialog to the ViewCube panel on page 8400, where you can adjust the appearance and behavior of the ViewCube.
- **Help**  Launches the online Help system and displays the topic on the ViewCube.

**Procedure**

To display the ViewCube menu:

- Right-click the compass, Home icon, or the main area of the ViewCube.

**Change the View of the Scene with the ViewCube**

You can change the view of a model by choosing a preset view or dragging the ViewCube, roll the current view 90 degrees, switch to an adjacent face view, define and restore the Front and Home views, and switch between projection modes.

**Change the Current View**

You can change the current view of a model by clicking predefined areas on the ViewCube or dragging the ViewCube.

The ViewCube provides 26 defined areas you can click to change the current view of a model. The defined areas are categorized into three groups: corner, edge, and face. Of the 26 defined areas, six represent standard orthographic views of a model: top, bottom, front, back, left, and right. You set an orthographic view by clicking one of the faces on the ViewCube.
You access angled views of the scene with the other 20 defined areas. Clicking one of the corners of the ViewCube changes the current view of the model to a three-fourths view, based on a viewpoint defined by three sides of the model. Clicking one of the edges changes the view of the model to a three-fourths view based on two sides of the model.

In addition, you can click and drag the ViewCube to change the view of the scene to a custom angled viewpoint other than one of the predefined viewpoints.

**Roll a Face View**

When you view a model from one of the face views such as Front, two additional icons, called roll arrows, are displayed near the ViewCube. To roll or rotate the current view 90 degrees in the positive or negative directions around the center of the view, click one of the roll arrows.

**Switch to an Adjacent Face**

While viewing a model from one of the face views, you can use the ViewCube to switch to one of the adjacent face views without first changing the view of the model, in order to see the adjacent view. When the ViewCube is active and a face view is current, four triangles are displayed, one on each side of the ViewCube. To rotate the current view to display the face view indicated by one of the triangles, click the triangle.
**Front View**

You can define the Front view of a model. The Front view is used to define the direction of the face views on the ViewCube. Along with the Front view, the Up direction of a model is also used to define the direction of the face views on the ViewCube.

**Procedures**

**To change the current view to a preset view:**

1. Activate the ViewCube.
2. Click one of the faces, edges or corners on the ViewCube.

**To view an adjacent face:**

1. Activate the ViewCube.

   **NOTE** Make sure a face view is current.

2. Click one of the triangles displayed near the edges of the ViewCube.

**To roll a face view:**

1. Activate the ViewCube.

   **NOTE** Make sure a face view is current.

2. Click one of the roll arrows displayed above and to the right of the ViewCube.
   - Click the left roll arrow to rotate the view 90 degrees in a counterclockwise direction or click the right roll arrow to rotate the view 90 degrees in a clockwise direction.

**To change the view interactively:**

- Click the ViewCube, hold down the button on your pointing device and drag to orbit the model.
Drag in the direction that you want to orbit the model.

To define the Front view:
- Right-click on the ViewCube and click Set Current View as Front.

**NOTE** You first need to orient the view using a view tool so that you are looking at what you consider to be the Front of the model with its Top facing upward and then choose Set Current View as Front.

To restore the default Front view:
- Right-click the ViewCube and click Reset Front.

**Set the View Projection Mode**

View projection produces realistic visual effects of a model.

The ViewCube supports two different view projections:

- **Perspective**  Perspective projected views involve foreshortening (closer objects appear larger than more distant ones) and are calculated based on the distance between a theoretical camera and target point. The shorter the distance between the camera and the target point, the more severe the perspective effect appears; greater distances produce less severe affects on the model.

- **Orthographic** Orthographic projected views display all the points of a model being projected parallel to the screen.

The following illustration shows the same model viewed from the same viewing direction, but with different view projections.

When you change the view for a scene, the view is updated using the current projection mode.
Procedure

To change the view projection mode:
➤ Right-click the ViewCube and click one of the following options:
  ■ Orthographic
  ■ Perspective

Define the Home View

You can define a Home view for a model so you can restore a familiar view when using the navigation tools.

The Home view is a special view of the model. The default Home position is the same as that of the Perspective viewport. You can also define a view of the scene as the Home view so you can easily return to the familiar view by clicking the Home icon or by choosing Home from the shortcut menu.

Procedure

To define the Home view, do one of the following:
■ Right-click the ViewCube and click Set Current View as Home.
■ Click or right-click the General (+) viewport label menu on page 8117 and choose ViewCube > Set Current View As Home.

To restore the Home view:

Use one of the following methods to restore the Home view:

■ Click the Home icon located near the active ViewCube.
■ Right-click the ViewCube and then choose Home.

SteeringWheels

The SteeringWheels® 3D navigation controls are tracking menus that allow you to access different 2D and 3D navigation tools from a single tool.
SteeringWheels are divided into different sections known as wedges. Each wedge on a wheel represents a single navigation tool. You can pan, zoom, or manipulate the current view of a scene in different ways.

SteeringWheels, also known as wheels, can save you time by combining many of the common navigation tools into a single interface. Wheels are specific to the context that a scene is being viewed in.

The Full Navigation wheel

NOTE If you are using the software display driver on page 8317, SteeringWheels don’t appear.

First Contact Balloon

By default, the wheel is “pinned” at startup to the lower-left corner of the Perspective viewport. It does not follow the cursor and, when you position the cursor over the wheel, the First Contact balloon for the SteeringWheels opens. The First Contact balloon serves as an introduction to the purpose of the wheels and how you can use them.
Display and Use Wheels

To toggle display of a wheel, use the Views menu > SteeringWheels > Toggle SteeringWheels command or the keyboard shortcut (Shift+W, by default). When a wheel is displayed, you can activate its navigation tools either by clicking one of the wedges on the wheel or clicking and holding down the button on the pointing device. While the button is held down, dragging over the viewport causes the current view to change. Releasing the button returns you to the wheel, and right-clicking at any time closes the wheel.

Not all navigation tools on a wheel support click actions. The following navigation tools support click actions:

- **Zoom** - Adjusts the magnification of the view.
- **Center** - Centers the view based on the position of the cursor over the wheel.
- **Rewind** - Restores the previous view.
- **Forward** - Increases the magnification of the view.

Control the Appearance of Wheels

You can control the appearance of the wheels by changing the current mode, or by adjusting the size and opacity. Wheels are available in two different modes: big and mini. To use a different wheel, choose it from the Wheel menu on a full-size wheel (click the lower-right button on the wheel) or from the Views menu > SteeringWheels submenu.
In addition to changing the current mode, you can adjust the opacity and size for the wheels. The size of a wheel controls how large or small the wedges and labels appear on the wheel; the opacity level controls the visibility of the objects in the viewport behind the wheel. The settings used to control the appearance of the wheels are on the SteeringWheels panel on page 8402 of the Viewport Configuration dialog.

Control Tooltips for Wheels and Messages for Tools

ToolTips are displayed for each wedge and button on a wheel as the cursor hovers over them. The tooltips appear below the wheel and identify the action that is performed if the wedge or button is clicked. You can toggle the display of tooltips on the SteeringWheels panel on page 8402 of the Viewport Configuration dialog.

Similar to tooltips, tool messages are displayed when you use one of the navigation tools from a wheel. Tool messages are displayed over the viewport and provide instructions for using the active navigation tool. Like tooltips, you can turn tool messages on or off on the SteeringWheels panel on page 8402 of the Viewport Configuration dialog. Disabling tool messages affects only messages that are displayed when using the Full Navigation wheel.

Procedures

To close a wheel:

Use one of the following methods to close a wheel:

- Press the Esc key.
- Press Shift+W (this toggles the wheel).
- Click the Close button (the small x in the upper right-hand corner of the wheel).
- Right-click the wheel.

To change the size of the wheels:

1. Display a wheel, if necessary (press Shift+W).
2. Open the SteeringWheels panel on page 8402 of the Viewport Configuration dialog.
3. In the Display Options group, under Big Wheels or Mini Wheels, drag the Wheel Size slider left or right.
Dragging the slider to the left decreases the size of the wheel, while sliding the slider to the right increases the size of the wheel.

4 Click OK.

To change the opacity of the wheels:

1 Display a wheel, if necessary (press Shift+W).

2 Open the SteeringWheels panel on page 8402 of the Viewport Configuration dialog.

3 In the Display Options group, under Big Wheels or Mini Wheels, drag the Wheel Opacity slider left or right.
   Dragging the slider to the left increases the transparency of the wheel, while sliding the slider to the right decreases the transparency of the wheel.

4 Click OK.

To control the startup display of the wheels:

1 Open the SteeringWheels panel on page 8402 of the Viewport Configuration dialog.

2 In the Display Options group, toggle the Always Show Pinned Wheel On Start check box.
   When on, the wheel appears at the cursor position (pinned) whenever you start 3ds Max. When off, you must invoke the wheel explicitly (press Shift+W).

3 Click OK.

Wheel Menu

From the Wheel menu, you can switch among different wheels and change the behavior of some of the navigation tools on the current wheel.

Use the Wheel menu, which is available from the down arrow in the lower-right corner of the wheel, to switch among the big and mini wheels that are available, go to the Home view, change the wheels configuration, and control the behavior of the walk navigation tool. The availability of some items on the Wheel menu depends on the current wheel.
The Wheel menu has the following options:

- **Mini View Object Wheel** Displays the mini version of the View Object wheel.
- **Mini Tour Building Wheel** Displays the mini version of the Tour Building wheel.
- **Mini Full Navigation Wheel** Displays the mini version of the Full Navigation wheel.
- **Full Navigation Wheel** Displays the big version of the Full Navigation wheel.
- **Basic Wheels** Displays the big version of the View Object or Tour Building wheel.
- **Go Home** Restores the Home view saved with the scene.
- **Restore Original Center** Pans the view to the world center (0,0,0).
- **Increase Walk Speed** Doubles the walk speed used for the Walk tool.
- **Decrease Walk Speed** Halves the walk speed used for the Walk tool.
- **Help** Launches the online Help system and displays the topic about the wheels.
- **Configure** Displays the dialog box where you can adjust the preferences for the wheels.

**Procedure**

To display the wheel menu

- Click the down arrow in the lower-right corner of the wheel.

**Navigation Wheels**

You can choose from several different wheels. Each has its own drafting theme, and is designed for a different type of 3D navigation.

Wheels are available in two sizes: big and mini. The big wheel is larger than the cursor. A label is on each wedge in the wheel. The mini wheel is about the same size as the cursor. Labels are not displayed on the wheel wedges.
You can choose from the following wheels:

- View Object
- Tour Building
- Full Navigation

**View Object Wheels**

The View Object wheel is for general 3D navigation; it includes the orbit 3D navigation tool. Use the View Object wheel to examine 3D objects from the outside.

The big View Object wheel is divided into the following wedges:

- **Center** on page 103 Specifies a point on a model to adjust the center of the current view or change the target point used for some of the navigation tools.
- **Zoom** on page 113 Adjusts the magnification of the current view.
- **Rewind** on page 109 Restores the most recent view. You can move backward or forward through previous views.
- **Orbit** on page 107 Rotates the current view around a fixed pivot point.

The mini View Object wheel is divided into the following wedges:

- **Zoom (Top wedge)** on page 113 Adjusts the magnification of the current view.
- **Rewind (Right wedge)** on page 109 Restores the most recent view. You can move backward or forward through previous views.
- **Pan (Bottom wedge)** on page 109 Repositions the current view by panning.
- **Orbit (Left wedge)** on page 107 Rotates the current view around a fixed pivot point.
Procedures

To switch to the big View Objects wheel:
Use one of the following methods:
■ From the Views menu, choose SteeringWheels > View Object Wheel.
■ Click the wheel menu button at the lower-right corner of a big wheel and choose Basic Wheels > View Object Wheel.

To switch to the mini View Objects wheel:
Use one of the following methods:
■ Click the wheel menu button at the lower-right corner of a big wheel and choose Mini View Object Wheel.
■ From the Views menu, choose SteeringWheels > Mini View Object Wheel.

Tour Building Wheels

The Tour Building wheels are designed for 3D navigation within the interior of a model.

The big Tour Building wheel is divided into the following wedges:
■ **Forward on page 104** Adjusts the distance between the current point of view and the defined pivot point of the model.
■ **Look on page 105** Swivels the current view.
■ **Rewind on page 109** Restores the most recent view. You can move backward or forward through previous views.
■ **Up/Down on page 111** Moves the view on the vertical axis of the screen.
The mini Tour Building wheel is divided into the following wedges:

- **Walk (Top wedge) on page 112** Simulates walking through a model.
- **Rewind (Right wedge) on page 109** Restores the most recent view. You can move backward or forward through previous views.
- **Up/Down (Bottom wedge) on page 111** Moves the view on the vertical axis of the screen.
- **Look (Left wedge) on page 105** Swivels the view.

**Procedures**

To switch to the big Tour Building wheel:

- From the Views menu, choose SteeringWheels > Tour Building Wheel.
- Click the wheel menu button at the lower-right corner of a big wheel and choose Basic Wheels > Tour Building Wheel.

To switch to the mini Tour Building wheel:

- Click the wheel menu button at the lower-right corner of a big wheel and choose Mini Tour Building Wheel.
- From the Views menu, choose SteeringWheels > Mini Tour Building Wheel.

**Full Navigation Wheels**

The Full Navigation wheel combines navigation tools found on the View Object and Tour Building wheels.

The big Full Navigation wheel is divided into the following wedges:

- **Zoom on page 113.** Adjusts the magnification of the current view.
Rewind on page 109. Restores the most recent view. You can move backward or forward through previous views.

Pan on page 109. Repositions the current view by panning.

Orbit on page 107. Rotates the current view around a fixed pivot point.

Center on page 103. Specifies a point on a model to adjust the center of the current view or change the target point used for some of the navigation tools.

Walk on page 112 Simulates walking through the scene.

Look on page 105 Swivels the view.

Up/Down on page 111 Moves the view on the vertical axis of the screen.

The mini Full Navigation wheel is divided into the following wedges:

Zoom (Top wedge) on page 113 Adjusts the magnification of the view.

Walk (Upper-right wedge) on page 112 Simulates walking through a model.

Rewind (Right wedge) on page 109 Restores the most recent view. You can move backward or forward through previous views.

Up/Down (Lower-right wedge) on page 111 Moves the view on the vertical axis of the screen.

Pan (Bottom wedge) on page 109 Repositions the current view by panning.

Look (Lower-left wedge) on page 105 Swivels the current view.

Orbit (Left wedge) on page 107 Rotates the current view around a fixed pivot point.

Center (Upper-left wedge) on page 103 Specifies a point on a model to adjust the center of the current view or change the target point used for some of the navigation tools.

Procedures

To switch to the big Full Navigation wheel:

Use one of the following methods:

- From the Views menu, choose SteeringWheels > Full Navigation Wheel.
Click the wheel menu button at the lower-right corner of a big wheel and choose Full Navigation Wheel.

To switch to the mini Full Navigation wheel:
Use one of the following methods:
- Click the wheel menu button at the lower-right corner of a big wheel and choose Mini Full Navigation Wheel.
- From the Views menu, choose SteeringWheels > Mini Full Navigation Wheel.

Navigation Tools

The navigation tools change the current view of the scene.

The availability of a navigation tool depends on the current wheel mode.

Center Tool

The Center tool specifies a point on an object as the center of the current view. It also changes the target point used for some of the navigation tools.

When using the Center tool, you adjust the location of the center of the current view by clicking and dragging. As you do so, the cursor changes to a sphere, indicating where the new center of the view will be established when you release the button on the pointing device. Releasing the button pans the model until the sphere is centered in the view and you are returned to the wheel.

The center point defined by the Center tool is used to constrain the Zoom tool and define the pivot point for the Orbit tool. The Zoom tool is only
constrained to the center point when used from the View Object wheel unless the Ctrl key is held down when using the Zoom tool on the Full Navigation wheel.

**Procedure**

**To specify a point on an object as the center of a view:**

1. Display a wheel that has the Center tool.
2. Click the Center wedge. Hold down the button on your pointing device and drag the cursor to the object.
3. When the cursor changes to an arrow with a sphere at the tip, release the button on your pointing device.
   The viewport is panned until the sphere is centered.

   **NOTE** This also sets the pivot point for the Orbit tool on page 107. Also, in the context of the View Object wheel on page 99, it sets the pivot point for the Zoom tool on page 113.

4. To exit the wheel, right-click.

**Forward Tool**

The Forward tool adjusts the distance between the current point of view and the defined pivot point of the model.

With the Forward tool, you can change the magnification of the model by increasing or decreasing the distance between the current point of view and the pivot point. The distance that you can move forward or backward is limited by the position of the pivot point.
To adjust the distance between the current point of view and the pivot point, you drag the cursor up or down after the pivot point is defined. As you drag the cursor, the current distance from the pivot point is displayed on a graphical element called the Drag Distance indicator. The Drag Distance indicator has two marks on it that show the start and ending distances from the current point of view. While changing the distance with the Drag Distance indicator, the current distance is shown by the bright orange indicator.

**To change a view by moving towards or away from the model**

1. Display a wheel that has the Forward tool.
2. Click the Forward wedge. Hold down the button on your pointing device.
3. When the Drag Distance indicator is displayed, drag the cursor up or down to change the distance from which you view the model.
4. Release the button on your pointing device to return to the wheel.
5. To exit the wheel, right-click.

**Look Tool**

The Look tool rotates the view horizontally and vertically from a fixed point. With the Look tool, you can rotate the current view vertically and horizontally. When rotating the view, the Look tool rotates your line of sight about the current eye position, like turning your head. Look is comparable to standing in a fixed location while looking up, down, left, and right.

When using the Look tool, you adjust the view of the model by dragging the cursor. As you drag the cursor, the cursor icon changes to the Look cursor and the model rotates around the location of the current view.
Walking through a Model

When using the Look tool, you can walk through a model by using the arrow keys on the keyboard. You can adjust the walk speed with the Walk tool settings on page 8404.

Invert Vertical Axis

By default, when you drag the cursor upward, the target point of the view raises; dragging the cursor downward lowers the target point of the view. If you prefer, you can reverse this behavior by turning on the Invert Vertical Axis on page 8404 option.

Procedures

To look around the scene:

1. Display a wheel that has the Look tool.
2. Click the Look wedge. Hold down the button on your pointing device.
3. When the Look cursor is displayed, drag the cursor up, down, left, and right to change the direction in which you are looking.
4. Release the button on your pointing device to return to the wheel.
5. To exit the wheel, right-click.

To look around the view and walk through the model

1. Display the Full Navigation wheel.
2. Click the Look wedge. Hold down the button on your pointing device.
3. When the Look cursor is displayed, drag the cursor up, down, left, and right to change the direction in which you are looking.
4. While holding down the button on your pointing device, press the arrow keys to walk in the model.
5. Release the button on your pointing device to return to the wheel.
6. To exit the wheel, right-click.
**Orbit Tool**

The Orbit tool rotates the current view around a model based on a fixed pivot point.

You use the Orbit tool to change the orientation of a model. The cursor changes to the Orbit cursor. As you drag the cursor, the model rotates around a pivot point while the view remains fixed.

![Orbit Tool](image)

**Specify the Pivot Point**

The pivot point is the base point used when rotating the model with the Orbit tool. You can specify the pivot point in the following ways:

- **Default pivot point** When you first open a model, the target point of the current view is used as the pivot point for orbiting the model.

- **Select objects** With [Selection Sensitivity](page 8405) enabled, you can select objects before using the Orbit tool to calculate the pivot point. The pivot point is calculated based on the center of the extents of the selected objects.

- **Center tool.** You can specify a point on the model to use as the pivot point for orbiting with the [Center tool](page 103) on page 103.

**Maintain Up Direction**

You can control how the model orbits around the pivot point by choosing to maintain the Up direction of the model. When the Up direction is maintained, orbiting is constrained to the XY plane and along the Z axis. If you drag the cursor horizontally, the camera moves parallel to the XY plane. If you drag the cursor vertically, the camera moves along the Z axis. To control if the Up direction is maintained for the Orbit tool, use the [Keep the Scene Upright](page 8404) on page 8404 option.
Procedures

To orbit around the center of the view:

1. Display a wheel that has the Orbit tool.
2. Click the Orbit wedge. Hold down the button on your pointing device.
3. When the cursor changes to the Orbit cursor, drag the cursor to rotate the model.

**NOTE** If you need to change the part of the model that is displayed in the center of the view, use the Center tool.

4. Release the button on your pointing device to return to the wheel.
5. To exit the wheel, right-click.

To orbit around a selection set:

1. Press Esc to make sure no commands are active.
2. Make sure Selection Sensitivity on page 8405 is on.
3. Select the objects in the scene that are to define the pivot point location.
4. Display a wheel that has the Orbit tool.
5. Click the Orbit wedge. Hold down the button on your pointing device.
6. When the cursor changes to the Orbit cursor, drag the cursor to rotate the model.
7. Release the button on your pointing device to return to the wheel.
8. To exit the wheel, right-click.

To maintain the up direction for the Orbit tool:

1. Display a wheel that has the Orbit tool.
2. On the SteeringWheels panel on page 8402 of the Viewport Configuration dialog, make sure the Orbit Tool > Keep the Scene Upright on page 8404 check box is on.
   Orbiting the model is constrained to the XY plane and Z axis.
3. Click OK.
Pan Tool

The Pan tool adjusts the viewpoint of the model by moving it within the screen plane.

When the pan tool is active, the cursor changes to a four-sided arrow. As you drag the cursor, the direction you drag moves the scene in the same direction. For example, dragging upward moves the scene up while dragging the cursor downward moves the scene down.

TIP If the cursor reaches the edge of the screen, you can continue panning by dragging the cursor further to force it to wrap around the screen.

Procedure

To pan the view with the wheel Pan tool:

1. Display a wheel that has the Pan tool.
2. Click the Pan wedge. Hold down the button on your pointing device and drag to reposition the model.
3. Release the button on your pointing device to return to the wheel.
4. To exit the wheel, right-click.

Rewind Tool

The Rewind tool restores the most recent view. You can also move backward and forward through a series of saved views.

As you pan, zoom, orbit, and use the other navigation tools (including the ViewCube) to change the view of a scene, each previous view is saved automatically to the navigation history. The navigation history holds the previous views along with a thumbnail image for each. A separate navigation
history is maintained for each viewport; the histories are not saved with the scene.

With the Rewind tool, you can retrieve the navigation history of a model. You can restore the previous view or you can scroll through any of the views saved to the navigation history.

When you hold down the button on the pointing device over the Rewind tool on the wheel, the Rewind interface is displayed as a horizontal strip of thumbnails showing each stored view. You can scroll through the navigation history. To restore one of the previous views in the navigation history, drag the bracket horizontally in the Rewind interface. Dragging to the left goes to previous views, and if you’ve rewound but haven’t changed the view, you can restore later stored views by “unwinding” to the right.

If you rewind to a previous view and then use a navigation tool, 3ds Max deletes the history after the current frame. However, it still remembers all saved views prior to the current frame.

Procedures

To restore the previous view:

1. Display a wheel.
2. Click the Rewind wedge.
3. Click Close to exit the wheel.

To restore a previous view with the Rewind interface:

1. Display a wheel.
2. Click the Rewind wedge. Hold down the button on your pointing device. The Rewind interface is displayed.
3. While holding down the button on your pointing device, drag to the left or to the right to restore a previous view.
Dragging to the left restores an older previous view. Dragging to the right restores one of the more-recent previous views. The current position in the navigation history is indicated by the orange box that is dragged along the Rewind UI.

4 To exit the wheel, click Close.

Up/Down Tool

The Up/Down tool slides the current view of a model along the vertical screen axis.

Unlike the Pan tool, the Up/Down tool does not significantly displace the model being viewed because the view is sliding along the vertical axis of the screen. You can think of the Up/Down tool as similar to looking in a fixed direction while riding in a glass elevator.

To adjust the vertical elevation of the current view, drag the cursor up or down. As you drag, the current elevation and the allowed range of motion are shown on a graphical element called the Vertical Distance indicator. This indicator has two marks that show the highest (Top) and lowest (Bottom) elevation the view can have. While changing the elevation with the Vertical Distance indicator, the current elevation is shown by the bright orange indicator while the previous elevation is shown by the dim orange indicator.

Procedure

To change the elevation of a view:

1 Display a wheel that has the Up/Down tool.
2 Click the Up/Down wedge. Hold down the button on your pointing device.

3 When the Vertical Distance indicator is displayed, drag the cursor up or down to change the elevation of the view.

4 Release the button on your pointing device to return to the wheel.

5 To exit the wheel, click Close.

Walk Tool

The Walk tool simulates walking through a model.

With the Walk tool, you can navigate through a model as if you were walking through it. Once you start the Walk tool, the Center Circle icon is displayed near the center of the view and the cursor changes to display a series of arrows. To walk through the model, you drag the cursor in the direction that you want to move in.

Constrain the Walk Angle

When walking through a model, you can constrain the movement angle to the ground plane. If the Constrain Walk Movement Angle to Ground Plane on page 8404 option is on (the default setting), you can look around freely while the current view moves parallel to the ground plane. If the walk angle is not constrained, you “fly” in the direction you are looking.

Movement Speed

As you walk or “fly” through a model, you can control the movement speed. You control the walk speed by the distance you move the cursor from the Center Circle icon. To set the base movement speed, you use the Speed Factor on page 8404 setting or the Increase Walk Speed and Decrease Walk Speed options on the Wheel menu.
Change the Elevation of the View

As you use the Walk tool, you can adjust the elevation of the view by holding down the Shift key. You switch temporarily to the Up/Down tool on page 111. To change the current elevation of the view for the model, you drag up and down.

Procedure

To use the Walk tool to move through the model:

1. Display a wheel that has the Walk tool.
2. Click the Walk wedge. Hold down the button on your pointing device.
3. When the Center Circle icon is displayed, drag the cursor in the direction that you want to walk.
4. Release the button on your pointing device to return to the wheel.
5. Click Close to exit the wheel.

Zoom Tool

The Zoom tool adjusts the magnification of the current view of a model.

With the Zoom tool, you can change the zoom magnification of a model in the following ways:

- **Click** If you click the Zoom tool on a wheel, the current view is zoomed in by a factor of 25 percent. If you are using the Full Navigation wheel, Incremental Zoom-in on page 8404 must be enabled on the SteeringWheels panel of the Viewport Configuration dialog.

- **Shift + click** If you hold down the Shift key before you click the Zoom tool on a wheel, the current view is zoomed out by a factor of 25 percent.

- **Ctrl+click** If you hold down the Ctrl key before you click the Zoom tool on a wheel, the current view is zoomed in by a factor of 25 percent.

- **Click and drag** If you click the Zoom tool and hold down the button on your pointing device, you can adjust the magnification of the model by dragging up and down.
Ctrl+click and drag When using the Full Navigation wheel, you can control the target point used by the Zoom tool. By holding down Ctrl, the Zoom tool uses the center point defined by the Center tool.

NOTE When you invoke the Zoom tool from the Full Navigation Wheel, Ctrl+click causes zooming to occur about the current pivot point rather than the current cursor position. Click and Shift+click perform incremental zooming only if Incremental Zoom-in on page 8404 is enabled on the SteeringWheels panel of the Viewport Configuration dialog.

Zoom Constraints

When changing the magnification of a model with the Zoom tool, you cannot zoom in any further than the focus point or out past the extents of the model. The direction you can zoom in and out is controlled by the center point set by the Center tool.

NOTE Unlike the Zoom tool on the View Object wheels, the Zoom tool on the Full Navigation wheels is not constrained.

Procedures

To zoom the view with a single click:

To use this function with the Full Navigation wheel, you must enable the Incremental Zoom-in option on page 8404.

1 Display a wheel that has the Zoom tool.

2 Click the Zoom wedge.

The magnification of the model is increased and you are zoomed in closer to the model. If you hold down the Shift key while clicking the Zoom wedge, the model is zoomed out or you can hold down the Ctrl key to zoom in.
3 Click Close to exit the wheel.

**To zoom a view in and out by dragging:**
1 Display a wheel that has the Zoom tool.
2 Click the Zoom wedge. Hold down the button on your pointing device and drag vertically to zoom in and out.
3 Release the button on your pointing device to return to the wheel.
4 To exit the wheel, right-click.

## Using Walkthrough Navigation

Walkthrough navigation lets you move through a viewport by pressing a set of shortcut keys, including the arrow keys, much as you can navigate a 3D world in many video games.

When you enter the walkthrough navigation mode, the cursor changes to a hollow circle that shows a directional arrow while you are pressing one of the directional keys (forward, back, left, or right).

This feature is available for perspective and camera viewports. It is not available for orthographic views or for spotlight viewports.

### Animating a Walkthrough

When you use walkthrough navigation in a Camera viewport, you can animate the camera walkthrough using either Auto Key on page 8090 or Set Key on page 3376. In either case, to get an animated camera you have to change the frame number manually (the easiest way is to use the Time Slider on page 8068), and in the case of Set Key, you have to change the frame number and click Set Keys.

**TIP** Select the camera before you animate it. If the camera isn't selected, its keys won't appear in the Track Bar on page 8071.

### Procedures

**To begin using walkthrough navigation, do one of the following:**

1 Press the Up Arrow key.
Click the **Walk Through button** on page 8140 to turn it on. This button is found on the **Pan/Truck And Walkthrough flyout** on page 8140.

**To stop using walkthrough navigation, do one of the following:**

1. Right-click.
2. Activate a different viewport.
3. Change the active viewport to a different type.
4. Turn on a different viewport navigation tool (such as Zoom or Pan).
5. Turn on Select Object or one of the transform tools.

**NOTE** You do not exit walkthrough mode when you select an object or change the viewport shading type (between shaded and wireframe, for example).

**Interface**

The Walk Through button is the only graphical element of the interface to walkthrough navigation. The other features are provided by mouse actions or by keyboard shortcuts. The following table shows the keyboard actions:

<table>
<thead>
<tr>
<th>Command</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accelerate Toggle</td>
<td>Q</td>
</tr>
<tr>
<td>Back</td>
<td>S, Down Arrow</td>
</tr>
<tr>
<td>Decelerate Toggle</td>
<td>Z</td>
</tr>
<tr>
<td>Decrease Rotation Sensitivity</td>
<td></td>
</tr>
<tr>
<td>Decrease Step Size</td>
<td>[</td>
</tr>
<tr>
<td>Down</td>
<td>C, Shift+Down Arrow</td>
</tr>
<tr>
<td>Forward</td>
<td>W, Up Arrow</td>
</tr>
<tr>
<td>Command</td>
<td>Shortcut</td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>Increase Rotation Sensitivity</td>
<td></td>
</tr>
<tr>
<td>Increase Step Size</td>
<td>]</td>
</tr>
<tr>
<td>Invert Vertical Rotation Toggle</td>
<td></td>
</tr>
<tr>
<td>Left</td>
<td>A, Left Arrow</td>
</tr>
<tr>
<td>Level</td>
<td>Shift+Spacebar</td>
</tr>
<tr>
<td>Lock Horizontal Rotation</td>
<td></td>
</tr>
<tr>
<td>Lock Vertical Rotation</td>
<td>Spacebar</td>
</tr>
<tr>
<td>Reset Step Size</td>
<td>Alt+[</td>
</tr>
<tr>
<td>Right</td>
<td>D, Right Arrow</td>
</tr>
<tr>
<td>Up</td>
<td>E, Shift+Up Arrow</td>
</tr>
</tbody>
</table>

If nothing appears in the Shortcut column, no default key is assigned to this command. You can set custom keystrokes using the Keyboard panel on page 8250 of the Customize User Interface dialog.

**Forward, Backward, and Sideways Movement**

For movement, you can use either the arrow keys, or letters at the left of the keyboard pad.

**TIP** When you are in a Perspective viewport, you can use Undo View Change and Redo View Change (Shift+Z, Shift+Y) to undo or redo your navigation. However, when you are in a Camera viewport, walkthrough animation transforms the camera object, so you must use Edit > Undo and Edit > Redo (Ctrl+Z and Ctrl+Y).

Holding down any of these keys causes the motion to be continuous.

**Forward** W or the Up Arrow. Moves the camera or the viewpoint forward.
NOTE If you are not already in walkthrough navigation mode, pressing Up Arrow enters it.

Back S or Down Arrow. Moves the camera or the viewpoint backward.
When you are in a camera viewport, Forward and Back are equivalent to dollying in or out.

Left A or Left Arrow. Moves the camera or the viewpoint to the left.
Right D or Right Arrow. Moves the camera or the viewpoint to the right.
When you are in a camera viewport, Left and Right are equivalent to trucking left or right.

Up E or Shift+Up Arrow. Moves the camera or the viewpoint up.
Down C or Shift+Down Arrow. Moves the camera or the viewpoint down.

Acceleration and Deceleration

Accelerate Toggle and Decelerate Toggle Pressing Accelerate (Q) causes motion to be quicker. Pressing Decelerate (Z) causes movement to be slower. These controls are toggles: pressing the key a second time restores the default motion rate (and pressing the alternate key turns off the first). They are especially useful when you are navigating by holding down keys.
The acceleration and deceleration toggles are independent of the step size.

Adjusting Step Size

Increase Step Size and Decrease Step Size Pressing Increase Step Size (]) increases the motion increments when you move the camera or viewpoint. Pressing Decrease Step Size ([) reduces them. You can press either of these shortcuts repeatedly, to increase the effect. Changing the step size is apparent when you navigate either by single clicks, or by holding down keys. Step size changes are useful for adjusting movement to the scale of the scene. They are saved with the MAX file.

Reset Step Size Pressing Reset Step Size (Alt+]) restores the step size to its default value.
The step size is independent of acceleration or deceleration.

Rotation (Tilting)

Tilt View Click+drag to tilt the camera or viewpoint.
When you are in a camera viewport, Tilt View is equivalent to panning the camera.

**Increase Rotation Sensitivity and Decrease Rotation Sensitivity** Pressing Increase Rotation Sensitivity (no default key) increases the motion increments when you use Tilt View. Pressing Decrease Rotation Sensitivity (no default key) decreases them. You can press either of these shortcuts repeatedly, to increase the effect. They are useful for adjusting movement to the scale of the scene. They are saved with the MAX file.

**Lock Horizontal Rotation** Pressing Lock Horizontal Rotation (no default key) locks the horizontal axis, so the camera or viewpoint tilts only vertically.

**Lock Vertical Rotation** Pressing Lock Vertical Rotation (Spacebar) locks the vertical axis, so the camera or viewpoint tilts only horizontally.

**Invert Vertical Rotation Toggle** Pressing Invert Vertical Rotation (no default key) inverts the tilt direction when you drag the mouse. When this toggle is off, dragging up causes scene objects to descend in the view, and dragging down causes them to rise (this is like tilting a physical camera). When this toggle is on, objects in the view move in the same direction you are dragging the mouse.

**Level** Pressing Level (Shift+Spacebar) removes any tilt or roll the camera or viewpoint might have, making the view both level and vertical.

### Navigating Camera and Light Views

The Camera and Light view navigation buttons are the same with a few exceptions. The buttons are visible when a viewport with a Camera or Light view is active. The Camera and Light view navigation buttons do more than adjust your view. They transform and change the parameters of the associated camera or light object.

![The camera navigation buttons](image)

Light views treat the light (spotlight or directional light) as if it were a camera. The light falloff is treated the same as the camera field of view.
Keep in mind the following:

■ Using the Camera and Light viewport navigation buttons is the same as moving or rotating the camera or Light, or changing their base parameters.

■ Changes made with Camera or Light view navigation buttons can be animated the same as other object changes.

### Zooming a Camera or Light View

![Zooming a camera](image)

You zoom a camera view by clicking FOV on page 8146 and then dragging in the Camera viewport.

The field of view defines the width of your view as an angle with its apex at eye level and the ends at the sides of the view. The effect of changing FOV is exactly like changing the lens on a camera. As the FOV gets larger you see more of your scene and the perspective becomes distorted, similar to using a wide-angle lens. As the FOV gets smaller you see less of your scene and the perspective flattens, similar to using a telephoto lens. See Cameras on page 5545.
Click **Light Hotspot** on page 8169 for a light viewport to achieve the same effect as zooming.

The hotspot is the inner of the two circles or rectangles visible in a light viewport. Objects inside the hotspot are illuminated with the full intensity of the light. Objects between the hotspot and falloff are illuminated with decreasing intensity as objects approach the falloff boundary. See **Using Lights** on page 5318.

**Moving a Camera or Light View**

You move a camera or light view by clicking one of the following buttons and dragging in the camera or light viewport.

- **Dolly** on page 8155 moves the camera or light along its line of sight.
- **Truck** on page 8161 moves the camera or light and its target parallel to the view plane.
- **Pan** on page 8162 moves the target in a circle around the camera or light. This button is a flyout that shares the same location with Orbit.
- **Orbit** on page 8162 moves the camera or light in a circle around the target. The effect is similar to Orbit for non-camera viewports.
Rolling a Camera or Light View

Click Roll on page 8159, and drag in a camera or a light viewport to rotate the camera or light about its line of sight. The line of sight is defined as the line drawn from the camera or light to its target. The line of sight is also the same as the camera’s or the light’s local Z axis.
Changing Camera Perspective

Click **Perspective** on page 8157, and drag in a camera viewport to change the Field of View (FOV) and dolly the camera simultaneously. The effect is to change the amount of perspective flare while maintaining the composition of the view.

Adaptive Degradation

Status bar > Adaptive Degradation button
Views menu > Adaptive Degradation
Keyboard > O (the letter O)

Adaptive degradation can improve viewport performance when you transform geometry, change the view, or play back an animation. It does so by decreasing the visual fidelity of certain objects temporarily; for example, by drawing...
larger objects or those closer to the camera as bounding boxes instead of wireframes.

Without adaptive degradation, the geometry is displayed as usual, even if that slows down viewport display and animation playback. Animation playback might drop frames if the graphics card cannot display the animation in real time.

Turn on adaptive degradation if you have large models you need to navigate around and if you are finding performance sluggish.

The Adaptive Degradation button on the status bar has three states:

- **Off**: No degradation occurs.
- **On**: Degradation can occur under the specified conditions. This is the default setting.
- **Active**: Degradation is being applied currently.

You can change the display options and set other adaptive degradation parameters, on the Viewport Configuration dialog (Customize menu > Viewport Configuration > Adaptive Degradation panel on page 8384). Also, you can toggle adaptive degradation for individual objects with the Object Properties > Never Degrade setting on page 291.

**Procedures**

To toggle adaptive degradation, do one of the following:

- Choose Views menu > Adaptive Degradation.
- Press O (the letter O).

To change the level of adaptive degradation in the viewports:

1. Click or right-click the General viewport label (“[ + ]”). On the General viewport label menu on page 8117, choose Configure.
   
3ds Max opens the Viewport Configuration dialog.
2 On the Viewport Configuration dialog, open the Adaptive Degradation panel and adjust the settings.

Grab Viewport

Tools menu > Grab Viewport

Grab Viewport creates a snapshot of the active viewport in the Rendered Frame Window on page 6513, where you can save it as an Image file on page 7831.

Procedures

To create a snapshot of a viewport:

1 Activate the viewport you want to capture.
2 Choose Tools menu > Grab Viewport.
   A dialog appears that allows you to add a label to your snapshot.
3 Enter a label for your snapshot, if desired.
   The label appears in the lower-right corner of the image as you enter it into the dialog.
4 Click Grab.
   The Rendered Frame Window opens to display a snapshot of your viewport.
5 Use the controls in the Rendered Frame Window to save your image.

Interface

![Grab Active Viewport](image.png)
Label  Enter text here to add a label to your screenshot. The text you enter is displayed in the lower-right corner of your screenshot.

Grab  Opens the Rendered Frame Window with a snapshot of the active viewport.

Cancel  Cancels the Grab Viewport command.

**View-Handling Commands**

Most viewport-handling commands are found on the Views menu on page 8006 and on the viewport label menus on page 8117.

See also:

- Viewing and Navigating 3D Space on page 65
- Quad Menu on page 8052

**Undo View Change / Redo View Change**

Views menu > Undo View Change or Redo View Change

Keyboard > Shift+Z (Undo) or Shift+Y (Redo)

Undo View Change cancels the last change made to the current viewport. Redo View Change cancels the last Undo in the current viewport.

These commands act like Undo and Redo on the main toolbar and Edit menu, but operate on a different list of events. They affect changes made to the viewport, rather than changes made to objects in the viewport.

Use Undo View Change and Redo View Change when you have inadvertently made a view unusable by zooming in too close, or rotating the wrong way. You can keep stepping back until a useful view appears. The keyboard shortcuts are handy for multiple commands.

You can also access Undo View Change by right-clicking the Point-Of-View viewport label and choosing Undo View Change from the POV viewport label menu on page 8122. This menu choice shows the last change you made in that viewport: for example, “Undo View Zoom.” Each viewport has its own independent undo/redo stack.
Camera and Spotlight viewports use object-based Undo and Redo, because the viewport change is actually a change to the camera or spotlight object. In these viewports, use Edit > Undo (Ctrl+Z) or Edit > Redo (Ctrl+Y).

Interface

**Undo View Change** Cancels viewport changes. The name of the change you're undoing is displayed in the View menu beside the command.

Undo is useful when you are working with a background image in the viewport. You can zoom into the geometry to adjust it, then use Undo Viewport Zoom to restore the original alignment of the geometry with the background.

**Redo View Change** Cancels the previous Undo View Change. The name of the change you're redoing appears in the View menu beside the command.

Save Active View

Views menu > Save Active View (the name of the active viewport is part of the command)

Save Active View stores the active view to an internal buffer. If you have framed a shot in any view other than a camera, use Save Active View to preserve the viewport’s appearance. The saved active view is saved with the scene file. Once saved, you can retrieve it using Restore Active View on page 128.

The viewport that will be restored is displayed in the menu item (for example, "Save Active Perspective View"). You can save and restore up to eight different views (Top, Bottom, Left, Right, Front, Back, Orthographic, Perspective).

Viewport changes that are saved include viewport shading type and point of view (POV): perspective or orthographic, zoom and rotations, and field-of-view (FOV).

Show Safe Frames and Viewport Clipping settings are not saved. If these settings are important to the view, make a note of what they are so you can reset them after restoring the view.

**Procedures**

To save an active view:

1. Activate the viewport with the view you want to save.
2. Choose Views menu > Save Active View. The view is now saved and can be recalled using Restore Active View.
Restore Active View

Views menu > Restore Active View (the name of the active viewport is part of the command.)

Restore Active View displays the view previously stored with Save Active View on page 127.

The viewport to be restored is displayed in the menu item (for example, "Restore Active Perspective View").

The active view is restored if the same viewport and layout are active.

If an active view won’t restore with this command, check the following:

■ Be sure the viewport is active.

■ Make sure the layout is the same as before. Use Viewport Configuration (right-click any viewport label and choose Configure) and choose Layout.

■ If the layout and active viewport are the same, be sure Viewport Clipping on the Point-Of-View (POV) viewport label menu on page 8122 is set the same as it was when the viewport was saved.

Procedures

To restore a saved view:

1. Activate the viewport where you saved the view.

2. Choose Views menu > Restore Active View. This option is available only in a viewport with a saved view.

3. The viewport returns to the saved view.

   If you’re not sure whether a viewport has a saved view, check the Views menu. Restore Active View is unavailable unless a view is saved in the active viewport.

Viewport Background Dialog

Views menu > Viewport Background > Viewport Background dialog
Click or right-click the Shading viewport label. > Shading viewport label menu on page 8130 > Viewport Background > Viewport Background > Viewport Background dialog

Keyboard > Alt+B

The Viewport Background dialog controls display of an image or animation as the background for one or all viewports. You can use this for modeling, for example, by placing front, top or side view sketches in the corresponding viewports. Or use Viewport background to match 3D elements with digitized camera footage, or for rotoscoping on page 8702.

You select the image or animation to display in the active viewport, set the frame synchronization between the animated image file and the current scene, and turn the assigned image on and off. These changes do not affect the rendered scene.

To place an image in the background of the rendered scene, use the Environment And Effects dialog > Environment panel on page 7162, accessed from the Rendering menu.

NOTE When safe frames are displayed in a viewport, and the Aspect Ratio options are set to either Match Viewport or Match Rendering Output, the assigned viewport background image is confined to the Live area of the safe frames and will correctly match the rendered background bitmap.

TIP If you are using a viewport driver with hardware acceleration (OpenGL or Direct3D), the viewport background might not appear. If this happens, choose Customize > Preferences. In the Viewports preferences on page 8308, click Configure Driver. Then in the Configure OpenGL dialog on page 8319 or the Configure Direct3D dialog on page 8325, go to the Background Texture Size group and turn on Match Bitmap Size As Closely As Possible (do not change the numeric setting). Click OK in both dialogs to accept your change.

See also:

■ Select Background Image Dialog on page 137
■ Update Background Image on page 142
■ Reset Background Transform on page 143
Procedures

To assign an image to one or all viewports:

1. Activate the viewport that is to display the background image.
2. Choose Views menu > Viewport Background > Viewport Background or press Alt+B.
   This opens the Viewport Background dialog.
3. In the Background Source group, click the Files button.
   This opens the Select Background Image dialog.
4. Use the dialog to open the image or animation to use.
5. To display the image in all viewports, choose All Views in the Apply Source And Display To group.
6. Click OK.
   The image is displayed in a single viewport or all viewports.

To update the image or map in the viewport:

Because of the time it takes to render the image or map in the viewport, the map is not automatically updated when you alter the bitmap or assign a new bitmap.

- Choose Views menu > Viewport Background > Update Background Image.
  The revised image or map is displayed in the viewport.

To display the environment map in a viewport:

1. In the Environment dialog, assign an environment map. (See the procedure “To choose an environment map.” on page 7163)
2. In the Environment dialog > Background group, be sure Use Map is turned on (the default).
3. Activate the viewport where you want the map displayed.
4. Choose Views menu > Viewport Background > Viewport Background.
5 In the Viewport Background dialog > Background Source group, turn on Use Environment Background.

6 Click OK.
   The map is displayed in the viewport.

To display an animated background:

1 Assign an animation file (AVI, MOV, or IFL file) as the viewport background.

2 Turn on Animate Background.

3 Choose Customize > Preferences. On the Viewports panel, turn on Update Background While Playing.
   Now the background plays when you click Play, or when you drag the time slider.

   **TIP** If you follow these steps and the background still doesn't appear to animate, open the Time Configuration dialog on page 8106 and in the Playback group, turn off Real Time.

To use the environment map with animation controls:

This procedure is useful if you’ve assigned an animated environment map and want access to the animation controls on the Viewport Background dialog.

1 In the Viewport Background dialog > Background Source group, turn off Use Environment Background.

2 In the same group, click File.

3 Choose the same map you’re using as the environment map.

4 Set parameters in the Animation Synchronization group.

5 Click OK.
   The environment map appears in the viewport. The image is renderable.

To match the viewport background with the rendered background:

1 Activate the viewport to render.

2 Click or right-click the General viewport label (“[ + ]”). On the General viewport label menu on page 8117. choose Show Safe Frame.
This turns on Safe Frames on page 8380 in the viewport.

**NOTE** You can also use Views menu > Configure > Safe Frame tab. In the Application group, turn on Show Safe Frames In Active View.

3 In the Material Editor, create a material that contains the bitmap for your rendered background.

4 At the bitmap level of the Material Editor, on the Coordinates rollout, choose Environ.
   The Mapping control is automatically set to Screen. This is the only mapping type that works for this purpose.

5 On the main menu, choose Rendering > Environment.

6 Drag the map from the Material Editor > Maps rollout to the Environment Map button on the Environment dialog. Click OK on the Instance (Copy) Map dialog.

7 In the Viewport Background dialog > Background Source group, click Files to assign the same bitmap.

8 In the Aspect Ratio group, turn on either Match Viewport or Match Rendering Output. Click OK.

9 Render the viewport.
   The background displayed in the rendered scene should exactly match the background displayed in the Live area of the safe frames.

**NOTE** When you use the Match Bitmap option, the bitmap reverts to its original aspect ratio and does not match the rendered scene, unless you're rendering to the same aspect ratio.

**To remove a background image:**

1 Activate the viewport in which the background image is visible.

2 On the Views menu, choose Viewport Background > Viewport Background.
   Notice that the name and path of the background file is displayed in the Current field in the Background Source group

3 In the Background Source group, click Devices.
4  On the Select Image Input Device dialog, choose No I/O Handlers from
the drop-down list, then click OK.

5  On the Bitmap Manager Error dialog, click OK.
   The current field no longer displays the background file name. Instead
   No I/O Handler is listed in the Current field.

6  Click OK to close the Viewport Background dialog.
   Next time you open up the Viewport Background dialog, no file name
   will be displayed in the Current field.

TIP  This technique will work only on systems that don’t have any other Image
Input Devices installed.
Interface

Background Source group

Options let you select the background image, either from a bitmap image file on page 8523, a video file, or from a device such as a video recorder.

Files Displays the Select Background Image dialog on page 137, which lets you select a file or sequence of files for your background.
Devices Displays the Select Image Input Device dialog. This lets you use a background from a digital device. (No device is supported by the default 3ds Max installation.)

Use Environment Background Lets you display in the viewports the map you’ve assigned as your environment background. If no environment map has been assigned in the Environment dialog, or Use Map in that dialog is off, then the Use Environment Background check box is not available.

Animation Synchronization group

Controls how sequences of images (for example, from IFL on page 7841, AVI on page 7832, or MOV on page 7849 files) are synchronized to the viewport for rotoscoping on page 8702.

Use Frame The first field sets the first frame of the incoming sequence that you want to use, and the second field sets the last one.

Step Sets the interval between the frames you want to use. For example, if this spinner is set to 7, 3ds Max uses every seventh frame.

Start At Specifies the frame number at which you want the first input frame to appear. What happens in the viewport before the start frame depends on the option you choose for "Start Processing," below.

Sync Start To Frame Determines which frame from your incoming sequence is displayed at the Start At frame. For example, you could have a 30-frame IFL sequence that starts in your scene at frame 10, but you could use the 5th frame from the IFL on frame 10 by setting Sync Start to 5.

Start Processing group

Determines what happens in the viewport background before the start frame.

Blank Before Start Makes the viewport background blank before the start frame.

Hold Before Start Specifies that the viewport background will contain the start frame.

End Processing group

Determines what happens in the viewport background after the last input frame.

Blank After End Makes the viewport background blank after the last input frame.
Hold After End Specifies that the viewport background will contain the last input frame until the last frame in the animation.

Loop After End Specifies that the viewport background will loop from the end frame back to the start frame, ad infinitum.

Aspect Ratio group

Controls the proportions of the viewport background by matching it to the bitmap, rendering output, or to the viewport itself.

Match Viewport Changes the aspect ratio on page 8511 of the image to match the aspect ratio of the viewport.

Match Bitmap Locks the aspect ratio of the image to the native aspect ratio of the bitmap.

Match Rendering Output Changes the aspect ratio of the image to match the aspect ratio of the currently chosen rendering output device.

NOTE When the Match Bitmap or Match Rendering Output option is chosen, 3ds Max centers the image and clears the edges of the viewport to the background color.

Display Background

Turns on display of the background image or animation in the viewport.

Lock Zoom/Pan

Locks the background to the geometry during zoom and pan operations in orthographic or user viewports. When you Zoom or Pan the viewport, the background zooms and pans along with it. When Lock Zoom/Pan is turned off, the background stays where it is, and the geometry moves independently of it. Use Match Bitmap or Match Rendering Output to enable Lock Zoom/Pan. This control is disabled if you choose Match Viewport.

Keyboard shortcut: Ctrl+Alt+B

WARNING If you zoom in too far, you can exceed the limit of virtual memory, and crash 3ds Max. When you perform a zoom that requires more than 16 megabytes of virtual memory, an alert asks if you want to display the background during the zoom. Choose No to perform the zoom and turn off the background. Choose Yes to zoom with the background image. Your machine might run out of memory as a result.
Animate Background

Turns on animation of the background. Shows the appropriate frame of the background video in the scene.

Apply Source And Display To group

All Views Assigns the background image to all viewports.
Active Only Assigns the background image to only the active viewport.

Viewport

The name of the currently active viewport appears in a list to the left of the OK and Cancel buttons. This reminds you which viewport you're working with and lets you change the active viewport by selecting its name from the list.

NOTE When you use different images for different viewports, the settings for each viewport are stored separately. Each time you display the Viewport Background dialog, the settings of the currently active viewport are displayed. If you switch the viewport using the list, the settings remain the same. This is useful for copying settings from one viewport to another.

Select Background Image Dialog

Views menu > Viewport Background > Viewport Background > Viewport Background dialog > Background Source group > Files > Select Background Image dialog

The Select Background Image dialog allows you to choose a file or sequence of files for a viewport background.
You can also convert a set of sequentially numbered files to an Image File List (IFL) on page 7841. This is the same process used by the IFL Manager Utility on page 7845.

**Procedures**

To select a background image for a viewport:

1. Activate the viewport where you want the image.
2. Choose Views menu > Viewport Background > Viewport Background.
3. Under Background Source in the dialog that displays, click Files.
4. In the Look In field, navigate to the directory containing the file you want to use for the background.
   
   **NOTE** The Select Background Image File dialog uses the last location where a bitmap was chosen, rather than the default bitmap path defined on the Configure User Paths dialog on page 8284.

5. Highlight the file name in the file list window.
6. Click Open to select the image and close the dialog.
7 Click OK to close the Viewport Background dialog and display the background image.

**To select a set of still images as a viewport background:**

1 Activate the viewport where you want the image.
2 Choose Views menu > Viewport Background > Viewport Background.
3 Under Background Source, click Files.
4 In the Look In field, navigate to the directory containing the sequence of files.
The files must be sequentially numbered (for example, `image01.bmp`, `image02.bmp`, `image03.bmp`).

**TIP** If necessary, change Files Of Type to match the file extension of the sequence, or choose All Formats.

5 Turn on Sequence, and choose the name of the first sequential file (for example, `image01.bmp`).

**TIP** Click the Setup button to display the Image File List Control dialog on page 7844.

6 In the Image File List Control dialog, use the Browse button to set the Target Path to a directory on your hard disk. Do not set this path to a CD-ROM drive, because you cannot save the file there.

7 Choose the options you want, and then click OK.
The Image File List (IFL) file is saved to the target directory.
Interface

History Displays a list of the directories most recently searched.

Look In Opens a navigation window to move to other directories or drives.

Up One Level Move up a level in the directory structure.

Create New Folder Lets you create a new folder while in this dialog.

List Displays the contents of a directory by file name.
Details Displays the contents of a directory including all the file details.

List Window When Details is on, the contents of the directory are displayed with Name, Size, Type, Date Modified, and Attributes. You can sort the files by clicking the label of each parameter.

File Name Displays the name of the file selected in the list.

Files of Type Displays all the file types that can be displayed. This serves as a filter for the list.

Open Selects the highlighted file and closes the dialog.

Cancel Cancels the selection and closes the dialog.

Devices Lets you select a background image from a digital device. (No device is supported by the default 3ds Max installation.)

Setup Displays the Image File List Control dialog on page 7844 to create an IFL file. Available only when Sequence is on and there are sequentially numbered files in the displayed directory.

Info Displays expanded information about the file, such as frame rate, compression quality, file size, and resolution. The information here is dependent on the type of information that is saved with the file type.

View Displays the file at its actual resolution. If the file is a movie, the Media Player is opened to play the file.

Gamma group

Selects the type of gamma to be used for the selected file. Available only when Enable Gamma Selection is turned on in the Gamma panel on page 8330.

Use Image's Own Gamma Uses the gamma of the incoming bitmap.

Use System Default Gamma Ignores the image's own gamma and uses the system default gamma instead, as set in the Gamma panel on page 8330.

Override Defines a new gamma for the bitmap that is neither the image's own, nor the system default.

Sequence Creates an "Image File List" to your specifications. Each selected image is checked to see if a valid IFL sequence can be created. If the selected image doesn’t yield a list, this option is still available, but doesn’t do anything.
**Preview** Displays the image as a thumbnail in the Image Window.

**Image Window** Displays a thumbnail of the selected file if Preview is on.

---

**Statistics** Displays the resolution, color depth, file type and number of frames of the selected file.

**Location** Displays the full path for the file. With this information at the bottom of the dialog, you always know exactly where you are.

**Update Background Image**

Views menu > Viewport Background > Update Background Image (available only when a viewport background is displayed)

This command updates the background image displayed in the active viewport. If the active viewport is not displaying a background image, this command is unavailable.

Use this command to update the background for changes that are not updated automatically, such as the following:

- Reassigning the map, or changing any parameters affecting the map in the Materials Editor, the Environment dialog, or the Viewport Background dialog.

- Changing the rendering resolution and aspect ratio. The following changes update the viewport background image automatically:
  - Changing the camera view.
  - Undo (for views).
  - Undo (for objects).
  - Assigning a different view type.
  - Toggling Safe Frames display on or off.
  - Changing the rendering parameters.
  - Moving the time slider when the viewport contains an animated background image.
NOTE Viewports can use the current Environment Map (set on the Environment panel on page 7163 of the Environment and Effects dialog) as the background image.

Procedures

To update the background image displayed in a viewport:

1. Activate a viewport that contains a background image.
2. Choose Views menu > Update Background Image.

Reset Background Transform

Views menu > Reset Background Transform (available only when a viewport background image is displayed and Lock Zoom/Pan is turned on)

Reset Background Transform rescales and recenters the current background to fit an orthographic or user viewport. Use this command when you want to reset the background to the new position of your geometry. See Procedure for detailed requirements.

Procedures

To reset the background to fit the viewport:

1. Activate an orthographic or user viewport that has a background image.
2. Press Alt+B.
3. Turn on either Match Bitmap or Match Rendering Output, and then turn on Lock Zoom/Pan.
4. Click OK.
5. Choose Views menu > Reset Background Transform. The background image readjusts in the viewport.

Show Transform Gizmo

Views menu > Show Transform Gizmo

Keyboard > X
Show Transform Gizmo toggles the display of the Transform gizmo axis tripod on page 905 for all viewports when objects are selected and a transform is active.

Additional controls for the Transform gizmo are found on the Gizmo Preferences settings on page 8354.

When the Transform gizmo is turned off, Show Transform Gizmo controls the display of the axis tripod on selected objects.

The state of Transform gizmo is saved in 3dsmax.ini, so it's maintained between scenes and sessions.

The related entries in the 3dsmax.ini file are:

- INI: Transformgizmo=1 (for Transform Gizmo visibility, controlled by Preferences)
- INI: ShowAxisIcon=1 (for Axis Icon visibility, controlled in Views menu)

The visibility of the Axis tripod overrides the visibility of the Transform Gizmo. If you turn off the Transform Gizmo in Preferences, the Axis tripod remains on the selected object. If you then turn off the Show Transform Gizmo in the Views menu, it actually turns off the Axis tripod. When the Axis tripod is disabled, the Transform Gizmo is also hidden.

**TIP** The converse is not true. If the transform gizmo is turned off, turning on the axis tripod visibility does not display the transform gizmo.

### Procedures

**To scale the transform gizmo, do one of the following:**

1. Press – (hyphen) to shrink the Transform gizmo.
2. Press = (equal sign) to enlarge the Transform gizmo.

### Show Ghosting

**Views menu > Show Ghosting**

Ghosting is a method of displaying wireframe "ghost copies" of an animated object at a number of frames before or after the current frame. Use it to analyze and adjust your animation. Ghosts that overlap indicate slower motion; ghosts that are spread further apart show faster motion.
When this command is active, ghosting is displayed for selected objects in the scene. Only currently selected objects display the ghosting.

![Ghosting helps to visualize animation.](image)

To change Ghosting parameters choose Customize > Preferences. On the Viewport panel of the Preferences dialog you can determine the number of ghosting frames, whether to ghost before or after the current frame, or both, and you can also show frame numbers with the ghosts.

**Procedures**

To show wireframe ghost copies of an animated object:

- Choose Views menu > Show Ghosting.

**Show Key Times**

Select an object with animation. > Views menu > Show Key Times
Key Times shows the frame numbers along a displayed animation trajectory on page 3411. Key times correspond to the settings in Time Configuration on page 8106 for Frames or SMPTE on page 8725. By default, key times are shown as frame numbers.

**Procedures**

**To display trajectory time values in the viewport:**

1. Select an object with animation.

2. On the Display panel > Display Properties rollout, turn on Trajectory.

   **TIP** If the rollout controls are unavailable, right-click the object in the active viewport, choose Object Properties, and in the Display Properties group, click By Layer to change to By Object. This will make the Trajectory option become available.

3. Choose Views menu > Show Key Times.

   The time values are displayed as white numbers along the trajectory. They remain displayed in red when the animated object is deselected.
Shade Selected

Select an object to be shaded. > Views menu > Shade Selected
Shade Selected shades only the selected objects in the scene when the viewport is set to Wireframe or Other. When Smooth + Highlights is on, all objects are shaded whether they are selected or not.
Shade Selected lets you work with a wireframe scene and shade only the selected objects when you want to visualize them more clearly. All other objects in the scene will appear in wireframe.
Selected objects shaded in a wireframe viewport.

**Procedures**

**To shade only selected objects in a scene:**

1. Choose Views menu > Shade Selected.
2. Click or right-click the Shading viewport label and choose Wireframe from the Shading viewport label menu on page 8130.
3. Select the object.
   Only the selected object is shaded.

**Show Dependencies**

Views menu > Show Dependencies

While you are using the Modify panel, this command toggles viewport highlighting of objects dependent on the currently selected object.
When Show Dependencies is on and the Modify panel is active, any object that is dependent upon the currently selected object in any way appears magenta. This includes instances on page 8611, references on page 8699, and shared modifiers on page 8643. Default=off.

You can also see similar dependencies in Schematic View on page 7922.

Procedures

To show dependencies between objects:

1. Select an object with an instanced modifier on page 1063.
2. On the Modify panel, choose the instanced modifier in the modifier stack.
3. Choose Views menu > Show Dependencies
   Other objects with instances of the same modifier appear in a different color.
Example: To use Show Dependencies when animating with Linked XForm:

1. Select the sub-object geometry you want to animate, and apply a Linked XForm modifier on page 1484.
2. On the Parameters rollout, click Pick Control Object.
3. Click an object to be the control object. Choose a dummy object if you want to keep the control hidden in final rendering.
4. The chosen object is now linked as parent to the sub-object selection and its name is listed on the Parameters rollout.
5. Choose Views menu > Show Dependencies to make the link visible when the control object is selected.
6. Use any of the transforms to animate the control object. The selection is animated in parallel with the control object.

Create Camera From View

Activate a Perspective viewport. > Views menu > Create Camera From View
Activate a Perspective viewport. > Create menu > Cameras > Create Camera From View
Activate a Perspective viewport. > Keyboard > Ctrl+C

Create Camera From View creates a Target camera on page 5556 whose field of view matches an active Perspective viewport. At the same time, it changes the viewport to a Camera viewport on page 8154 for the new camera object, and makes the new camera the current selection.
Alternatively, if the scene already contains a camera and the camera is selected, then Create Camera From View does not create a new camera from the view. Instead, it simply matches the selected camera to the active, Perspective viewport. This functionality was adopted from the Match Camera to View command, which is now available only as an assignable main user interface shortcut (see Keyboard Shortcuts on page 8419).

**NOTE** Create Camera From View is available only when a Perspective viewport is active.

To create a camera from a view, assuming any existing cameras are unselected:

1. Activate a Perspective viewport.
2. If necessary, adjust the viewport using Pan, Zoom, and Orbit, or the ViewCube, until you have a view you like.
3. Leaving the viewport active, on the Views menu choose Create Camera From View or press Ctrl+C.

3ds Max creates a new camera, matching its view to that of the Perspective viewport, and then switches the Perspective viewport to a Camera viewport, showing the view from the new camera.
Add Default Lights to Scene

Click or right-click the General viewport label (“[ + ]”). > General viewport label menu on page 8117 > Configure > Viewport Configuration dialog > Lighting And Shadows panel > Illuminate Scene With group > Choose Default Lighting and then choose 2 Lights (to activate the Add Default Lights To Scene menu item) > Click OK. > Create menu > Lights > Standard Lights > Add Default Lights To Scene

This command opens the Add Default Lights To Scene dialog, which provides options that let you convert the default scene lighting into actual light objects on page 5314.

The default lighting for viewports consists of a key light, positioned in front and to the left of the scene, which behaves as an omni light on page 5410.

This command is unavailable unless you use the Viewport Configuration dialog on page 8374 to configure the active viewport to use two lights. When viewports use two lights, and you invoke this command, the lights are added to the scene as omni lights. You can add either the key light, the fill light, or both.

Two default lights are placed opposite to each other.
A, the key light is in front of the object, on the upper left side, while B, the fill light is behind on the lower right side.

You can add either the key light, the fill light, or both. The omni light objects have the names DefaultKeyLight and DefaultFillLight.

If you have already added one or both default lights, a warning prompts you to rename or delete the previous default light object before you add another.

**Procedures**

**To add the default lights as objects:**

1. Click or right-click the General viewport label (“[ + ]”).
   3ds Max opens the General viewport label menu on page 8117.
2. Choose Configure.
3. On the Viewport Configuration dialog > Rendering Method tab, in the Rendering Options group, turn on Default Lighting and choose 2 Lights. Click OK to close the dialog.
5. On the Add Default Lights To Scene dialog, toggle Add Default Key Light, Add Default Fill Light, or both. Click OK.

   ![Add Default Lights to Scene](image)

6. Activate the Top viewport, and on the status bar, click Zoom Extents.
   The lights are now visible in the viewport.
Interface

Add Default Key Light When on, adds the default key light to the scene. The key light is in front of the scene and to the left. The key light becomes an omni light on page 5410 with the name, DefaultKeyLight. Default=on.

Add Default Fill Light When on, adds the default fill light to the scene. The fill light is behind the scene and to the right. The fill light becomes an omni light on page 5410 with the name, DefaultFillLight. Default=on.

Distance Scaling Affects how far the lights are placed from the origin (0,0,0). The default value leaves the scene's lighting unchanged. Larger values move the lights farther away, dimming the scene, and smaller values move them closer, brightening the scene. Default=1.0. Range=0.0 to 1000.0.

Redraw All Views

Views menu > Redraw All Views

Keyboard > ` (accent grave)

Redraw All Views refreshes the display in all viewports. When you move, rotate, scale, or otherwise manipulate geometry, the viewports may display the scene with some irregularities, or with objects or parts of objects missing. Use Redraw All Views to redisplay your scene with all lines and shading restored.
Show Materials in Viewport As

Views menu > Show Materials in Viewport As > Standard Display
Views menu > Show Materials in Viewport As > Standard Display with Maps
Views menu > Show Materials in Viewport As > Hardware Display
Views menu > Show Materials in Viewport As > Hardware Display with Maps
Material Editor > Material menu > Show Materials in Viewport As > Standard Display
Material Editor > Material menu > Show Materials in Viewport As > Standard Display with Maps
Material Editor > Material menu > Show Materials in Viewport As > Hardware Display
Material Editor > Material menu > Show Materials in Viewport As > Hardware Display with Maps

These commands turn on and off display of all maps in the viewports, using software or hardware rendering. Software rendering applies to all maps and materials, but tends to be less accurate. Hardware rendering is highly accurate, showing highlights very close to the way they render, but applies primarily to the Arch & Design material on page 5858, although it also supports the Standard material on page 5962.

NOTE Hardware viewport rendering is not available on computers with older graphics systems. Also, hardware viewport rendering is supported only by the Direct3D display driver on page 8325.

NOTE These commands do not apply to XRef materials on page 6183, including materials from XRef objects on page 7450 and XRef scenes on page 7477.

See also:
- Show Standard/Hardware Map in Viewport on page 5696

Interface

Standard Display Uses the legacy software shader, which works on a per-face basis, and turns off viewport display of all maps at the material level. This applies only to materials used in the scene.
**Standard Display with Maps** Uses the legacy software shader, which works on a per-face basis, and turns on viewport display of all maps.

**Hardware Display** Uses the hardware viewport shader, which works on a per-pixel basis, and turns off viewport display of all maps at the material level. The hardware shader applies only to the Standard on page 5962 and Arch & Design on page 5858 materials; when it’s active, 3ds Max still uses the software shader to display all other materials.

**Hardware Display with Maps** Uses the hardware viewport shader, which works on a per-pixel basis, and turns on viewport display of all maps at the material level. This switch applies only to the Standard on page 5962 and Arch & Design on page 5858 materials; when it’s active, 3ds Max still uses the software shader to display all other materials. Also, it doesn’t affect viewport display of maps for materials other than those two.

### Update During Spinner Drag

Views menu > Update During Spinner Drag

When Update During Spinner Drag is on, dragging a spinner (such as a Radius spinner for a sphere) updates the effects in real time in the viewports. Default=on.

When Update During Spinner Drag is off, the effect is updated after the drag, when you release the mouse. Use this option when you're adjusting processor-intensive controls.

### Diagnose Video Hardware

Help menu > Diagnose Video Hardware

This command runs a MAXScript script that displays information about your system’s graphic display configuration. This can be useful for telling you whether some interactive viewport features such as shadows on page 5335 are supported.
Expert Mode

Views menu > Expert Mode

Keyboard > Ctrl+X

When Expert mode is on, the title bar, toolbar, command panel, status bar, and all of the viewport navigation buttons are removed from the display, leaving only the menu bar, time slider, and viewports. Use Expert mode when you need to view your composition alone without the rest of the interface.

With the ability to customize the user interface in 3ds Max, you can create your own versions of Expert mode by hiding whatever you want item-by-item. Expert mode is only a quick way to hide everything that can be hidden at once.

You can assign keyboard shortcuts to hide and unhide the command panel, toolbars, and so on and then use these while in Expert mode. You can also use the quad menu to access tools quickly in Expert mode as well.

Procedures

To turn on Expert mode, do one of the following:

- Choose Views menu > Expert Mode.
- Press Ctrl+X.
To turn off Expert mode and return to full display, do one of the following:

- Click the Cancel Expert Mode button to the right of the time slider.
- Press Ctrl+X.
- Choose Views menu > Expert Mode.

**Controlling Object Display**

You use the Display panel, *layers* on page 7953, and *Scene Explorer* on page 7888 to control how objects are displayed in viewports, and to hide or freeze objects. This section covers usage of the Display panel controls.

*TIP* You can also use the *Isolate Selection command* on page 198 to hide everything except your selection set.

**See also:**

- *Object Display Properties* on page 288

**Display Color Rollout**

Display panel > Display Color rollout

The Display Color rollout specifies whether 3ds Max displays objects using their wireframe colors (also known as object colors) or their diffuse material colors on page 8552, when the objects have their display properties set to By Object. If the display properties of an object is set to By Layer, the layer color is used for viewport display. You can choose one method for wireframe display and a different one for shaded display. In each shading mode you can specify whether the material or the object color is used.

By default, all new objects have their display properties set to By Object. You can change this default by turning on *Default to By Layer for New Nodes* on page 8304. When this switch is off (the default), all new objects created in 3ds Max display in the viewports using the settings on the Display Color rollout. A toggle for switching individual objects between By Object and By Layer is available in the Object Properties dialog > *Display Properties group* on page 288.
If the object color box displays black and white rectangles, this indicates that the object has its display properties set to By Layer.

Interface

![Display Color](image)

**Wireframe** Controls the color of objects when the viewport is in wireframe display mode.
- **Object Color** Displays the wireframes in object color.
- **Material Color** Displays the wireframes using the material color.

**Shaded** Controls the color of the object when the viewport is in any shaded display mode.
- **Object Color** Displays the shaded objects using the object color.
- **Material Color** Displays the shaded objects using the material color.

**Hide By Category Rollout**

Display panel > Hide By Category rollout

The Hide By Category rollout toggles the display of objects by category (objects, cameras, lights, and so on).

By default, 3ds Max displays all objects in the scene. Objects hidden by category aren’t evaluated in the scene, so hiding objects by category improves performance.

You can use any of the default display filters provided, or add new display filters for fast selection of objects to hide.
Interface

Turn on the check boxes to hide objects of that category. You can use the All, None, and Invert buttons to quickly change the settings of the check boxes.

The Display Filter box gives you finer control in creating categories to hide. Click the Add button to display a list of display filters. Hold down the Ctrl key and click the filter name to select whatever category you'd like to hide.

Geometry Hides all geometry in the scene.
Shapes Hides all shapes in the scene.
Lights Hides all lights in the scene.
Cameras Hides all cameras in the scene.
Helpers Hides all helpers in the scene.
Space Warps Hides all space warps in the scene.
Particle Systems Hides all particle systems in the scene.
Bone Objects Hides all bones in the scene.
Bones Hides all bones in the scene.
IK Chain Hides all IK chains in the scene.
Point Hides all points in the scene.
All Hides everything in the scene.
None Unhides everything in the scene
Invert Hides everything that is visible and unhides everything currently hidden.
Add Adds a display filter category to the list.
Remove Removes a display filter category.
None Deselects all highlighted display filters in the list.

Hide Rollout

Display panel > Hide rollout

The Hide rollout provides controls that let you hide and unhide individual objects by selecting them, regardless of their category.

You can also hide and unhide objects using the Display Floater on page 8218.

See also:

| Hide By Category Rollout on page 159 | Hide Rollout | 161 |
Interface

Hide Selected  Hides the selected objects.

Hide Unselected  Hides all visible objects except the selected ones. Use this to hide all objects except the one you're working on. Objects hidden by category aren’t affected.

Hide by Name  Displays a dialog you use to hide objects you choose from a list. See Select From Scene on page 206, which describes nearly identical controls.

Hide by Hit  Hides any object you click in the viewport. If you hold the Ctrl key while selecting an object, that object and all of its children are hidden. To exit Hide by Hit mode, right-click, press Esc, or select a different function. This mode is automatically turned off if you hide all objects in the scene.

Unhide All  Unhides all hidden objects. The unhide buttons are available only when you have specifically hidden one or more objects. They won’t unhide objects hidden by category.

NOTE  If you click Unhide All in a scene with hidden layers, a dialog will pop up prompting you to unhide all layers. You cannot unhide an object on a hidden layer.

Unhide by Name  Displays a dialog you use to unhide objects you choose from a list. See Select From Scene on page 206, which describes nearly identical controls.

NOTE  If you select an object on a hidden layer, a dialog will pop up prompting you to unhide the object’s layer. You cannot unhide an object on a hidden layer.
Hide Frozen Objects  Hides any frozen objects. Turn it off to display hidden frozen objects.

Freeze Rollout

Display panel > Freeze rollout

The Freeze rollout provides controls that let you freeze or unfreeze on page 8587 individual objects by selecting them, regardless of their category.

Frozen objects remain on the screen, but you can’t select, transform, or modify them. By default, frozen objects turn dark gray. Frozen lights and cameras, and their associated viewports, continue to work as they normally do.

You can choose to have frozen objects retain their usual color or texture in viewports. Use the Show Frozen In Gray toggle in the Object Properties dialog on page 283.

Interface

Freeze Selected  Freezes the selected object(s).

Freeze Unselected  Freezes all visible objects except the selected ones. Use this to quickly freeze all the objects except the one you’re working on.

Freeze by Name  Displays a dialog that lets you choose objects to freeze from a list. See Select From Scene on page 206, which describes nearly identical controls.
**Freeze by Hit**  Freezes any object you click in a viewport. If you press Ctrl while selecting an object, that object and all of its children are frozen. To exit Freeze by Hit mode, right-click, press Esc, or select a different function. This mode is automatically turned off if you freeze all objects in the scene.

**Unfreeze All**  Unfreezes all frozen objects.

**NOTE**  If you click Unfreeze All in a scene with frozen layers, a dialog opens prompting you to unfreeze all layers. You cannot unfreeze an object on a frozen layer.

**Unfreeze by Name**  Displays a dialog that lets you choose objects to unfreeze from a list. See Select From Scene on page 206, which describes nearly identical controls.

**NOTE**  If you unfreeze by name an object on a frozen layer, a dialog opens prompting you to unfreeze the object's layer. You cannot unfreeze an object on a frozen layer.

**Unfreeze by Hit**  Unfreezes any object you click in the viewport. If you press Ctrl while selecting an object, that object and all of its children are unfrozen. If you select an object on a frozen layer, a dialog will pop up prompting you to unfreeze the object's layer. You cannot unfreeze an object on a frozen layer.

**Display Properties Rollout**

Display panel > Display Properties rollout

The Display Properties rollout provides controls for altering the display of selected objects.

**See also:**

- Link Display Rollout on page 169

**Procedures**

To display trajectories using the Display panel:

1. Select one or more animated objects.
2. Right-click the selection, and choose Properties.
3 In the Display properties group, click By Layer to change it to By Object, and then click OK.

4 Expand the Display Properties rollout in the Display panel.

5 Turn on Trajectory.

   By default, object trajectories appear with the following properties:
   ■ The trajectory curve is drawn in red.
   ■ Frame increments display as white dots on the curve.
   ■ Position keys display as red boxes surrounding the appropriate frame dot on the curve. The boxes are white when the object is selected.
   ■ If Views > Show Key Times is turned on, the keyframe numbers are displayed along side the keys on the trajectory.

   Trajectories can also be displayed through Object Properties. Right-click any object and choose Properties, then in the Display properties group change By Layer to By Object. Turn on Trajectories when it becomes available in the Display Properties group.

   You can change the colors for these items on the Colors panel on page 8272 of the Customize User Interface dialog.

You can also use object properties to display trajectories: right-click any object and choose Properties, then turn on Trajectory.

**Interface**

![Display Properties Rollout](image-url)
The first three options reduce the displayed geometric complexity of selected objects in a scene, resulting in faster response time because the computer has less to calculate. These options are also available in the Display Properties group of the Object Properties dialog > General panel on page 283 and the Display floater on page 8218.

**Display as Box** Toggles the display of selected objects, including 3D objects and 2D shapes, as bounding boxes on page 8528. Produces minimum geometric complexity.

Particle systems appear as bounding boxes when adaptive degradation takes effect. Because particle systems exist in world space, their bounding box is always oriented parallel to the world planes.

![Bounding Boxes](image)

**Backface Cull** Toggles the display of faces, edges, and vertices with normals on page 8654 pointing away from the point of view. When off, all entities are visible. Default=off.

![Backface Cull](image)

**Edges Only** Toggles the display of hidden edges and polygon diagonals on page 8551. When on, only outside edges appear. When off, all mesh geometry appears. Applies to Wireframe viewport display mode, as well as other modes with Edged Faces turned on.
**Vertex Ticks** Displays the vertices in the selected geometry as tick marks. If the current selection has no displayed tick marks, the check box is clear. If some of the vertices in the current selection display tick marks, the check box contains a gray X. If all vertices in the current selection display tick marks, the check box contains a black X.

**Trajectory** Toggles trajectory on page 8746 display for the selected object so its trajectory is visible in viewports.
See-Through  Makes the object or selection translucent in viewports. This setting has no effect on rendering: it simply lets you see what’s behind or inside an object in a crowded scene, and is especially useful in adjusting the position of objects behind or inside the See-Through object. This is very handy when you have objects within other objects in your scene.

This option is also available from Object Properties dialog on page 283 and the Tools > Display Floater on page 8218.

You can customize the color of see-through objects by using the Colors panel on page 8272 of the Customize > Customize User Interface dialog on page 8249.

Keyboard shortcut (default): Alt+X

Ignore Extents  When turned on, the object is ignored when you use the display control Zoom Extents. Use this on distant lights.

Show Frozen in Gray  When on, the object turns gray in viewports when you freeze it. When off, viewports display the object with its usual color or texture even when it is frozen. Default=on.

Never Degrade  When on, the object is not subject to adaptive degradation on page 8498.

Vertex Colors  Displays the effect of assigned vertex colors. You assign vertex colors using the Assign Vertex Color utility, or the VertexPaint modifier. Once vertex colors have been assigned they can also be edited in the Vertex Properties rollout in the editable mesh or editable poly in vertex or face sub-object level.

The Shaded button determines whether the object with the assigned vertex colors appears shaded in the viewport. When this button is off, the colors are unshaded and appear in their pure RGB values, looking a little like self-illuminated materials. When the Shaded button is on, the colors appear like any other assigned color in the viewports.
Link Display Rollout

Display panel > Link Display rollout

The Link Display rollout provides controls that alter the display of hierarchical linkages on page 8599.

Interface

![Link Display Rollout]

**Display Links** Displays a wireframe representation of any hierarchical links affecting the selected object.

**NOTE** Display Links must be turned on in order to see Joint Limits on a inverse kinematics chain.

**Link Replaces Object** Replaces the selected object with the wireframe representation of the hierarchical link. This option offers another way to reduce the geometric complexity of selected objects in a scene. See also Display Properties rollout on page 164.

The Draw Links As Lines option on the Viewports panel on page 8308 of the Preference Settings dialog further reduces the display of links to a single line.
Selecting Objects

In most cases, before you can perform an action on an object or objects in your scene, you must first select them. Thus, the act of selection is an essential part of the modeling and animation process.

A battlefield scene

Below: Different selections in a wireframe viewport
3ds Max provides you with a variety of selection tools, which are covered in this chapter. Besides the basic techniques of selecting single and multiple objects using mouse and keyboard, the topics here discuss the use of named selection sets and other features that help you manage object selection, such as hiding and freezing objects and layers. Also included is an introduction to sub-object selection, essential to working with an object's underlying geometry.

Lastly, a technique for grouping objects is presented. Grouping lets you create more permanent selections that have many of the characteristics of independent objects.

**Introducing Object Selection**

3ds Max is an object-oriented program. This means that each object in the 3D scene carries instructions that tell 3ds Max what you can do with it. These instructions vary with the type of object. Because each object can respond to a different set of commands, you apply commands by first selecting the object and then selecting the command. This is known as a noun-verb interface, because you first select the object (the noun) and then select the command (the verb).

**Identifying the Selection Interface**

In the user interface, selection commands or functions appear in the following areas:

- Main toolbar
- Edit menu
- Quad menu (while objects are selected)
- Tools menu
- Track View
- Display panel
- Schematic View

The buttons on the main toolbar provide a direct means of selection. The Select From Scene dialog on page 206 is easy to use, while the Edit menu provides more general selection commands, plus methods of selecting objects by property. Perhaps the most powerful selection tool is Scene Explorer on page 7888, which lets you select objects by various methods, and also edit object
hierarchies and properties. Track View and Schematic View let you select objects from a hierarchical list.

**Selecting From the Quad Menu**

The quickest way to select an object is from the Transform quadrant of the quad menu, where you can easily switch among the Move, Rotate, Scale, and Select modes. Choose any of these and click the object you want to select in the viewport.

**Selecting by Name**

Another quick way to select an object is to use the keyboard shortcut for the Select By Name command. Press H on the keyboard to open the Select From Scene dialog on page 206 and then select the object by name from the list. This is a foolproof way to ensure you select the correct object when the scene contains many overlapping objects.

**Selection Buttons**

Another way to select an object is to click one of these buttons, and then click the object.

- ![Select Object](image)
- ![Select by Name](image)
- ![Select And Move](image)
- ![Select And Rotate](image)
- ![Select And Scale](image)
- ![Select And Manipulate](image)
The main toolbar has several selection-mode buttons. When any of the selection buttons is active, 3ds Max is in a state where you can select objects by clicking them.

Of the selection buttons, you use Select Object when you want selection only. The remaining buttons let you both select and transform or manipulate your selection. Use transforms to move, rotate, and scale your selection. See Moving, Rotating, and Scaling Objects on page 885 and Select and Manipulate on page 2838.
Crossing Versus Window Selection

Above: Window selection selects the trash can and bench, but not the streetlight.
Below: Crossing selection selects all three: trash can, bench, and streetlight.

One way to select multiple objects simultaneously is to drag a region, such as a rectangle, around them. The Window/Crossing toggle, available from the main toolbar, switches between Window and Crossing modes when you select by region. In Window mode, you select only the objects within the selection. In Crossing mode, you select all objects within the region, plus any objects crossing the boundaries of the region.

**Edit Menu Commands**

The Edit menu contains selection commands that operate globally on your objects.

Edit menu selection commands include:

- **Select All** on page 227
- **Select None** on page 227
- **Select Invert** on page 228
- **Select Similar** on page 228
- **Select By > Color** on page 229
- **Select By > Name** on page 229 (also a toolbar button)
- **Select By > Layer** on page 230
- **Selection Region > Rectangular Region** on page 230
- **Selection Region > Circular Region** on page 231
- **Selection Region > Fence Region** on page 232
- **Selection Region > Lasso Region** on page 233
- **Selection Region > Paint Selection Region** on page 234
- **Selection Region > Window** on page 235 (also a toolbar button)
- **Selection Region > Crossing** on page 237 (also a toolbar button)
- **Edit Named Selection Sets** on page 219

176 | Chapter 4  Selecting Objects
Tools Menu Commands

The Tools menu provides the Scene Explorer commands as well as access to modeless selection dialogs or "floaters." You can place them anywhere on the screen, or minimize them by right-clicking the title bar and choosing Minimize:

- **New Scene Explorer (and related commands)**  See Scene Explorer on page 177.
- **Display Floater**  Provides options for hiding and freezing selections as well as some display options. See Display Floater on page 8218.
- **Layer Manager**  This modeless dialog lets you select objects individually and by layer, and change display properties such as Hide and Freeze. See Layer Manager on page 7956.

Scene Explorer

Scene Explorer on page 7888 gives you a modeless dialog for selecting and linking objects as well as changing object properties such as the name and display characteristics. You can manipulate hierarchical relationships via drag-and-drop techniques, and use various search methods including a powerful Boolean editor to fine-tune your selection. You can also edit properties for multiple objects at once simply by selecting them and then changing one of them.

Track/Schematic View Selection

Track View on page 3790 is primarily designed as an animation tool, but you can also use its Hierarchy List window as an alternative method of selecting objects by name and hierarchy. This works in both the Curve Editor and Dope Sheet modes of Track View.

Schematic View on page 7922 is specifically designed to let you navigate your scene efficiently, presenting a hierarchical view and letting you select objects and their properties by name.
Display Panel Selection

The Display panel provides options for hiding and freezing objects. These techniques exclude objects from other selection methods, and are useful in simplifying complex scenes. Frozen objects are still visible, but hidden objects are not.

Basics of Selecting Objects

The most basic selection techniques use either the mouse, or the mouse in conjunction with a keystroke.
Bed selected in wireframe

Bed selected in smooth and shaded view
Procedures

To select an object in the viewport:

1. Click one of the selection buttons on the toolbar: Select Object, Select And Move, Select And Rotate, Select And Scale, or Select And Manipulate. Alternatively, right-click in a viewport to open the quad menu, and from the Transform menu choose Move, Rotate, Scale, or Select.

2. In any viewport, move the cursor over the object you want to select. The cursor changes to a small cross when it’s positioned over an object that can be selected.

   The valid selection zones of an object depend on the type of object and the display mode in the viewport. In shaded mode, any visible surface of an object is valid. In wireframe mode, any edge or segment of an object is valid, including hidden lines.

3. While the cursor displays the selection cross, click to select the object (and to deselect any previously selected object).

   A selected wireframe object turns white. A selected shaded object displays white brackets at the corners of its bounding box.

   **NOTE** When you use the mouse to select overlapping objects or sub-objects, the first click selects the object under the mouse cursor closest to your point of view; the second click selects the next-closest object, and so on. If you move the mouse more than five pixels at any point in the sequence, the next click begins again with the closest object. And with the farthest object selected, clicking selects the closest object again.

To select all objects do one of the following:

- Choose Edit menu > Select All.
  
  This selects all objects in your scene.

- On the keyboard press Ctrl+A.

To invert the current selection do one of the following:

- Choose Edit menu > Select Invert.
  
  This reverses the current selection pattern. For example, assume you begin with five objects in your scene, and two of them are selected. After choosing Invert, the two are deselected, and the remaining objects are selected.

- On the keyboard press Ctrl+I.
To extend or reduce a selection:

- Hold down Ctrl while you click to make selections. This toggles the selection state of the objects you select. Use this method to select or deselect objects. For example, if you have two objects selected and Ctrl+click to select a third, the third object is added to the selection. If you now Ctrl+click any of the three selected objects, that object is deselected.

  **TIP** You can also hold down Alt while you click to remove objects from selections.

To lock a selection:

1. Select an object.

2. Click the Selection Lock Toggle on page 8079 on the status bar to turn on locked selection mode.

   While your selection is locked, you can drag the mouse anywhere on the screen without losing the selection. The cursor displays the current selection icon. When you want to deselect or alter your selection, click the Lock button again to turn off locked selection mode. The keyboard toggle for locked selection mode is Spacebar.

To deselect an object, do any of the following:

- Hold down the Alt key, and either click an object, or drag a region around the object to deselect it.

- Hold down the Ctrl key and click to deselect a selected object. This is a toggle; it also selects non-selected objects.

- To deselect all objects in the scene, choose Edit menu > Select None, or click an empty area of a viewport anywhere outside the current selection.

**Selecting by Region**

The region-selection tools let you use the mouse to select one or more objects by defining an outline or area.
Region Selection

By default, when you drag the mouse a rectangular region is created. When you release the mouse all objects within and touched by the region are selected. The remainder of this topic describes how you can change each of these settings.

NOTE If you hold down Ctrl while specifying a region, the affected objects are added to the current selection. Conversely, if you hold down Alt while specifying a region, the affected objects are removed from the current selection.
Setting Region Type

The type of region you define when you drag the mouse is set by the Region flyout button to the right of the Select By Name button. You can use any of five types of region selection:

- **Rectangular Region** Dragging the mouse selects a rectangular region. See Rectangular Selection Region on page 230.

- **Circular Region** Dragging the mouse selects a circular region. See Circular Selection Region on page 231.

- **Fence Region** Draw an irregular selection-region outline by alternating between moving the mouse and clicking (begin with a drag). See Fence Selection Region on page 232.

- **Lasso Region** Dragging the mouse outlines an irregular selection region. See Lasso Selection Region on page 233.

- **Paint Region** Drag the mouse over objects or sub-objects to be included in the selection. See Paint Selection Region on page 234

Setting Region Inclusion

This option lets you specify whether to include objects touched by the region border. It applies to all region methods.
Choose Edit menu > Region to display a submenu of the following two items. Only one can be active at a time. The option is also available on the main toolbar.

■ **Window**  Selects only objects that are completely within the region. See Select Region Window on page 235.

■ **Crossing**  Selects all objects that are within the region and crossing the boundaries of the region. This is the default region. See Select Region Crossing on page 237.

The Window/Crossing toggle on page 239 on the main toolbar also switches between these two modes. You can set up a preference to switch automatically between Window and crossing based on the direction of your cursor movement. See Auto Window/Crossing by Direction on page 8303 in General Preferences.

**Procedures**

**To make a region selection using defaults:**

1. Click Select Object on page 204.

2. Drag the mouse to define a region. A rubber-band rectangle appears.

3. Release the mouse button to select all objects within or touching the region.
   The selected objects turn white.

You can also use the Select and Transform buttons on the main toolbar to select by region. You must start defining the region over an unselectable area of the viewport. Otherwise, you'll transform the object beneath your mouse when you begin to drag.

**Using Select By Name**

The Select By Name command opens the Select From Scene dialog, which lets you select objects by their assigned names without having to click in the viewports.
Procedures

To select objects by name:

1 Do one of the following:

- On the main toolbar, click Select By Name.
- Choose Edit menu > Select By > Name.
- Press H.

The Select From Scene dialog opens. By default, this dialog lists all objects in the scene. Any selected objects are highlighted in the list.

2 Use the mouse to highlight one or more objects in the list. To select multiple objects, drag vertically in the list or use Ctrl to add to the selection.

3 Click OK to make the selection.

The dialog closes and the objects are selected.

4 Alternatively, to select a single object and close the dialog at the same time, double-click the object name.

For more information, see Select From Scene on page 206.

Using Named Selection Sets

You can assign a name to the current selection, and then later reselect those objects by choosing their selection name from a list.

You can also edit the contents of named sets from the Named Selection Sets dialog on page 219.
**Editing Named Selections**

As you model and create a scene, you’re likely to rearrange the objects making up your named selection sets. If you do, you’ll need to edit the contents of those sets.

**Procedures**

**To assign a name to a selection set:**

1. Select one or more objects or sub-objects using any combination of selection methods.
2. Click in the Named Selection field on the main toolbar.
3. Enter a name for your set. The name can contain any standard ASCII characters, including letters, numerals, symbols, punctuation, and spaces. 
   
   **NOTE** Names are case-sensitive.
4. Press Enter to complete the selection set.

You can now select another combination of objects or sub-objects and repeat the process to create another named selection set.

**To retrieve a named selection set:**

1. In the Named Selection field, click the arrow.
   
   **NOTE** If you’re working with a sub-object selection set, you must be at the same level at which you created the selection set (for example, editable mesh > vertex) for it to appear on the list.
2. On the list, click a name.

**To edit named selection sets:**

1. On the main toolbar, click Edit Named Selection Sets to open the Named Selection Sets dialog.
Using Selection Filters

You can use the Selection Filter list on the main toolbar to deactivate selection for all but a specific category of object. By default, all categories can be selected, but you can set the Selection Filter so that only one category, such as lights, can be selected. You can also create combinations of filters to add to the list.

For greater ease of use while working with animations, you can choose filters that let you select only Bones, objects in IK chains, or Points.

Using Combos

The Combos feature allows you to combine two or more categories into a single filter category.

Procedures

To use the selection filter:

- Click the Selection Filter arrow and click a category from the Selection Filter list.
  Selection is now limited to objects defined in this category. The category remains in effect until you change it.
  The following categories are available:
    - All
      All categories can be selected. This is the default setting.
    - Geometry
      Geometry
Only geometric objects can be selected. This includes meshes, patches, and other kinds of objects not specifically included in this list.

**Shapes**
Only shapes can be selected.

**Lights**
Only lights (and their targets) can be selected.

**Cameras**
Only cameras (and their targets) can be selected.

**Helpers**
Only helper objects can be selected.

**Warps**
Only space warps can be selected.

**Combos**
Displays a Filter Combinations dialog on page 215 that lets you create custom filters.

**Bone**
Only bones objects can be selected.

**IK Chain**
Only objects in IK chains can be selected.

**Point**
Only point objects can be selected.

**To create a combination category:**

1. From the drop-down list, choose Combos to display the Filter Combinations dialog on page 215.
   All single categories are listed.

2. Select the categories you want to combine.

3. Click Add.
   The combination appears in a list to the right, abbreviated by the first letter of each category. Click OK.

   For example, if you selected Geometry, Lights, and Cameras, the Combo would be named GLC. This name appears below Combo on the drop-down list. For more information, see Selection Filters List on page 214.
Selecting with Track View

Track View provides sophisticated methods to edit your animation tracks. In addition, its Hierarchy list displays all objects in the scene by name and hierarchy. Using Track View, you can select any object in the scene by clicking its object icon in the Hierarchy list.

Procedures

You can use Track View selection functionality in both the Curve Editor Introduction on page 3804 and the Dope Sheet on page 3805. This procedure illustrates usage of the Curve Editor; the same methods work in the Dope Sheet.
To open Track View and display and select objects:

1. On the main toolbar, click Curve Editor (Open).
2. Click any cube icon in the list to select the named object.

You can make the following kinds of selections:

- Select several adjacent objects in the list. Click the first object, hold down Shift, and click another object elsewhere in the list.
- Modify the selection by pressing Ctrl while clicking. Ctrl lets you toggle individual items on and off without deselecting others in the list.
- Select an object and all its descendants. Press and hold Alt, right-click the object’s cube icon (keep the right mouse button held down), and choose Select Children from the menu.

You can open a Track View window for the sole purpose of selecting objects by name. Shrink the window until only a portion of the Hierarchy appears, and then move the window to a convenient area on your screen.

Selecting with Schematic View

Schematic view is a window that displays the objects in your scene in a hierarchical view. It gives you an alternate way to select and choose the objects in your scene and navigate to them.

When the Modify panel is open, double-clicking an object modifier in Schematic view navigates the modifier stack to that modifier for quick access to its parameters.

Procedures

To open Schematic View and display and select objects:

1. Click Open Schematic View on the main toolbar.
2. Click the rectangle containing the name of your object.
You can select any number of objects in Schematic View using standard methods, including dragging a region. For more information, see Using Schematic View on page 7926.

**Freezing and Unfreezing Objects**

You can freeze any selection of objects in your scene. By default, frozen objects, whether wireframe or rendered, turn a dark gray. They remain visible, but can’t be selected, and therefore can’t be directly transformed or modified. Freezing lets you protect objects from accidental editing and speeds up redraws.

Above: No layers frozen
Below: Trash can and streetlight are frozen, and displayed in gray

You can choose to have frozen objects retain their usual color or texture in viewports. Use the Object Properties dialog > General panel > Display Properties > Show Frozen In Gray toggle on page 291.
Frozen objects are similar to hidden objects. Linked, instanced, and referenced objects behave when frozen just as they would if unfrozen. Frozen lights and cameras and any associated viewports continue to work as they normally do.

For more information, see Freeze Rollout on page 163.

**Freezing Objects**

You can freeze one or more selected objects. This is the usual method to put objects "on hold."

You can also freeze all objects that are not selected. This method lets you keep only the selected object active, useful in a cluttered scene, for example, where you want to be sure no other objects are affected.

**IMPORTANT** Objects on a frozen layer cannot be unfrozen. If you try to unfreeze an object on a frozen layer (with Unfreeze All or Unfreeze By Name), you are prompted (by default on page 8304) to unfreeze the object’s layer.

**Procedures**

To access Freeze options, select one or more objects and then do one of the following:

- Open a scene explorer on page 7888 and use the check boxes in the Frozen column to freeze and unfreeze objects.

- Open the Display panel and then expand the Freeze rollout.

- Choose Tools menu > Display Floater. This modeless dialog has the same options as the Freeze rollout. It also contains Hide options.

- Access the Object Properties dialog on page 283 from either the right-click (quad) menu or the Edit menu. Turn on Hide and/or Freeze.

- In the Layer Manager, click in the Freeze column to freeze/unfreeze each layer in the list.

- Right-click in the active viewport and choose a Freeze or Unfreeze command from the quad menu > Display quadrant.
Hiding and Unhiding Objects by Selection

You can hide any selection of individual objects in your scene. They disappear from view, making it easier to select remaining objects. Hiding objects also speeds up redraws. You can then unhide all objects at once or by individual object name. You can also filter the list contents by category, so only hidden objects of a certain type are listed.

**NOTE** Hiding a light source doesn't alter its effect; it still illuminates the scene.

Hiding objects is similar to freezing objects. Linked, instanced, and referenced objects behave when hidden just as they would if unhidden. Hidden lights and cameras and any associated viewports continue to work normally.

For more information, see [Hide Rollout](#) on page 161.
Hiding Objects

Hiding objects is similar to freezing objects. See Freezing and Unfreezing Objects on page 191. You can hide one or more selected objects. You can also hide all objects that are not selected.

Another option is to hide objects by category. See Hiding and Unhiding Objects by Category on page 195.

Unhiding Objects

You can unhide objects in either of two ways:

- Use Unhide All to unhide all objects at the same time.
- Use All On to display all objects at the same time.
- Use Unhide By Name to unhide object selectively. When you click Unhide By Name, the same dialog is displayed as for hiding, now called Unhide Objects.

The Unhide buttons are unavailable when no object in the scene is hidden.

Objects that were first hidden by selection and then hidden by category do not reappear. Although they are unhidden at the selection level, they are still hidden at the category level. For details, see Hiding and Unhiding Objects by Category on page 195.

IMPORTANT Objects on a hidden layer cannot be unhidden. If you try to unhide an object on a hidden layer (with Unhide All or Unhide By Name), you are prompted (by default on page 8304) to unhide the object's layer.

Procedures

To access Hide options, do one of the following:

- Open a scene explorer on page 7888 and use the check boxes in the Hidden column to hide and unhide objects.
- Open the Layer Manager on page 7956.
  In the Layer Manager, you can easily hide groups of objects or layers.
- Open the Display panel. Click Hide, if necessary, to expand the rollout.
Choose Tools menu > Display Floater. This modeless dialog has the same options as the Hide rollout. It also contains Freeze options.

Access the **Object Properties dialog** on page 283 from either the right-click (quad) menu or the Edit menu. Turn on Hide, Freeze, or both. If the button is unavailable because By Layer is turned on, click By Layer to change it to By Object.

Right-click in the active viewport and choose a Hide or Unhide command from the quad menu > Display quadrant.

**Hiding and Unhiding Objects by Category**

You can hide objects by category, the basic types of objects. For example, you can hide all lights in your scene at one time, or all shapes, or any combination of categories. By hiding all categories, your scene appears empty. Hidden objects, while not displayed, continue to exist as part of the geometry of your scene but cannot be selected.
Above: All objects displayed
Below: Lights and shapes are hidden
Hiding Geometry and Particle Systems

Geometry and particle systems have separate categories, even though particle systems are also geometry.

- Selecting Geometry hides all geometry in the scene, including particle systems. The option for particle systems becomes unavailable.
- Selecting Particle Systems hides only these objects, leaving the other geometry unaffected.

Effects of Hiding by Category

- If you create an object in a category that is hidden, 3ds Max turns off hiding for that category and unhides the objects within the category.
- Unhiding by category has no effect on objects hidden with the controls on the Hide rollout (see Hiding and Unhiding Objects by Selection on page 193). These objects remain hidden. You need to use the controls on that rollout to unhide them.
- Unhiding by category has no effect on objects that are on a layer that is turned off. These objects remain invisible. You need to turn on their layer to display them.
- Unhiding by selection does not return a hidden object to the scene if the category of the object is hidden. The Unhide All and Unhide By Name controls continue to work, but the effect is not seen until the category is cleared.
- Lights hidden by category continue to shine. Views through cameras and targeted lights are still active.
- Linked, instanced, and referenced objects behave when hidden just as they would if visible.

Procedures

To hide a category of objects:

1. Open the Display panel.
2. Click Hide by Category, if necessary, to expand the rollout. By default, all categories are off (unhidden) on this rollout.
Choose the category you want to hide. All objects of that category disappear from your scene as soon as you make the choice.

The same Hide By Category options appear on the Object Level panel of the Display Floater (Tools menu > Display Floater).

**To unhide a category of objects:**

- Deselect the category.

All objects in the category reappear, unless some have been hidden by selection. See Effects of Hiding by Category on page 197.

---

**Isolate Selection**

Tools menu > Isolate Selection

Right-click to open the quad menu. > Display (upper-right) quadrant > Isolate Selection

Keyboard > Alt + Q

The Isolate Selection tool lets you edit a single object or selection set of objects while hiding the rest of the scene on a temporary basis. This guards against selecting other objects while working on a single selection. It allows you to focus on the objects you need to see, without the visual distraction of the surroundings. It also reduces the performance overhead that can come from displaying other objects in the viewports.

When you turn on Isolate Selection, the active viewport (Perspective and axonometric on page 8515 only) performs the Zoom Extents on page 8138 action on the isolated objects. When you exit Isolate Selection mode, Perspective viewports return to the previous zoom level, but axonometric viewports do not.

When an isolated selection includes multiple objects, you can select a subset of these, and choose Isolate Selection once again. This isolates the subset. However, clicking Exit Isolation unhides the entire scene. You can’t “step back” through individual levels of isolation.

---

**NOTE** Isolate Selection works only at the object level. You can’t choose it while at the sub-object level. If you go to a sub-object level while working with an isolated object, you can click Exit Isolation, but you can’t isolate sub-objects.
Interface

While the Isolate tool is active, a dialog labeled Warning: Isolated Selection appears.

**Exit Isolation Mode** Click to end isolation, close the dialog, and unhide the rest of the scene.

The views are restored to what they showed before you chose Isolate Selection.

## Introduction to Sub-Object Selection

This is a general introduction to sub-object selection. For specific information, see [Editable Mesh](#) on page 2192, [Editable Patch](#) on page 2360, [Editable Poly](#) on page 2240, and [Editable Spline](#) on page 620; for a discussion of NURBS sub-object selection, see [Sub-Object Selection](#) on page 2428.

When you model an object, often you edit a portion of its underlying geometry, such as a set of its faces or vertices. Or when you are working with a model, you may want to apply mapping coordinates to a portion of its underlying geometry. Use the methods described in this topic to make sub-object selections.
You can access sub-object geometry through a variety of methods. The most common technique is to convert an object into "editable" geometry such as a mesh, spline, patch, NURBS, or poly object. These object types let you select and edit geometry at the sub-object level.

If you have a primitive object and want to retain control of its creation parameters, you can apply a modifier such as Edit Mesh on page 1321, Edit Poly on page 1332, Edit Spline on page 1424, Edit Patch on page 1329, or Mesh Select on page 1500.

The Line Spline on page 584 and NURBS curves and surfaces are the exception: you can edit their sub-objects as soon as you create these kinds of objects.
sub-object level appears to the right of both its name and the name of the top-level object.

Stack display shows the sub-object hierarchy, letting you choose a sub-object level.

**Editing at the Sub-Object Level**

When you edit an object at the sub-object level, you can select only components at that level: vertices, edges, polygons, and so on. You can’t deselect the current object, nor can you select other objects. To leave sub-object editing and return to object-level editing, click the top-level name of the object in the modifier stack, or click the highlighted sub-object level.
Click the top-level object name to exit sub-object editing.

**TIP** You can also access sub-object levels from the buttons at the top of the Selection rollout on the Modify panel.

### Procedures

**To make a sub-object selection:**

These methods assume the object has sub-object levels. If the object has no sub-object levels (for example, a primitive such as a sphere), the + icon is not present. In that case, you need to collapse the object or apply an Edit modifier before you can edit its sub-object geometry.

**TIP** When working with an editable poly or Edit Poly object, we highly recommend that you use the Graphite Modeling tools on page 2025 instead of the Modify panel.

1. Select the object you want to edit.
2. If the object doesn’t already have sub-object levels, apply an Edit ... modifier such as Edit Mesh.
3. Open the Modify panel.
4. On the modifier stack display, click the + icon to expand the object’s hierarchy.
5. On the stack display, click a sub-object level such as Vertex, Edge, or Face.
For a detailed selection, you might want to zoom in on the object.

6 Click one of the toolbar selection buttons, and then use the same selection methods you’d use on objects to select the sub-object components. Or from the quad menu > Transform quadrant, choose one of the selection methods and select the sub-object components.

There are two alternative ways to go to a sub-object level:

■ Select the object and go to the Modify panel. Then right-click the object, and use the quad menu > Tools 1 (upper-left) quadrant > Sub-objects submenu.

■ Choose the selection level using buttons on the Modify panel’s Selection rollout, if one is present for the type of object you’re editing.

Once you’re at a sub-object level, the Insert key cycles through the levels of other kinds of sub-objects.

To exit a sub-object level, do one of the following:

■ In the stack display, click the highlighted sub-object name or the top-level name of the object.

■ If the object has a Selection rollout, click the button of the active sub-object level to turn it off.

■ Right-click the object, and then in the Tools 1 (upper-left) quadrant of the quad menu, choose Top-level.

■ Access a different command panel. This turns off sub-object editing.

If you think you’ve turned off sub-object editing but top-level object selection is still not restored, it might be due to the following reasons:

■ Your selection is locked. Click the Lock Selection Set button on the prompt line to turn it off.
You’ve set the Selection Filter on page 187 on the main toolbar to a specific category of object, so you can’t select any of the other categories. To fix this, select All in the Selection Filter list.

**Selection Commands**

Selection commands appear on the quad menu, on the main toolbar, on the Edit menu, and on the status bar.

**Main toolbar** By default, important selecton commands appear on the main toolbar.

**Edit menu** The Edit menu contains selection commands that operate globally on your objects. **Status bar** The Selection Lock Toggle on page 8079 is located on the status bar. Locking a selection is useful when you are doing a lot of editing on a selection, and don’t want to select something else by mistake.

The simplest method of selection is to turn on Select Object mode on page 204, and then click an object in a viewport (or drag to surround the object). While the method is simple, it is not effective for selecting multiple objects, especially in a crowded scene. Other tools let you select objects by name, filter out the kinds of objects you want to select, and to create named selection sets you can select repeatedly.

**See also:**
- Introducing Object Selection on page 172
- Basics of Selecting Objects on page 178
- Isolate Selection on page 198
- Scene Explorer on page 7888

**Select Object**

Main toolbar > Select Object
Right-click to open quad menu. > Transform quadrant > Select
Select Object lets you select an objects and sub-objects for manipulation.
Object selection is affected by several other controls:

- The active Selection Region type: Rectangular on page 230, Circular on page 231, Fence on page 232, Lasso on page 233, or Paint on page 234.
- The active selection filter on page 214 (All, Geometry, Shapes, Lights, and so forth).
- The state of the crossing selection tool (which determines whether completely surrounded objects or surrounded and crossing objects are selected).

You can also select objects by name with the Select From Scene dialog Select From Scene on page 206 list; press the H key to access the dialog.

A number of objects selected together is called a selection set on page 185. You can name selection sets in the Named Selection Sets field on the main toolbar and then recall them for later use.

**NOTE** The Smart Select command activates the Select Object function and, with repeated invocations, cycles through the available Selection Region methods. By default, Smart Select is assigned to the Q key; you can use Customize User Interface on page 8249 to assign it to a different keyboard shortcut, a menu, etc.

**Procedures**

**To add or remove individual objects from a selection set:**

1. Hold down the Ctrl key and select the objects to add or remove.
2. Hold down the Alt key and select objects to remove from the current selection set.

**NOTE** Adding and removing objects doesn't change a named selection set.

**To toggle the selected/deselected state of multiple objects in the selection set:**

- Hold down the Shift key and drag to region-select the objects to toggle.
To select objects and move, rotate, or scale them:

- Use Select And Move, Select And Rotate, or Select And Scale, available from the main toolbar and the quad menu > Transform quadrant.

When you rotate a selection set, the pivot of rotation depends on which option is selected on the Use Center flyout on page 930 on the toolbar.

These tools are restricted to a specific axis or plane, which you can choose from the Axis Constraints toolbar on page 8039 or specify with the transform gizmo on page 889.

Select From Scene

main toolbar > Select By Name

Keyboard > H

Edit menu > Select By > Name

This dialog, named Select From Scene or Select Objects in most contexts, lets you select or designate objects by choosing them from a list of all objects currently in the scene. Select From Scene is a modal on page 8641, read-only version of Scene Explorer on page 7888; you can’t use it to change object properties such as name and color. Other differences between Select From Scene and Scene Explorer include:

- No hierarchy manipulation; you can’t link or unlink objects.
- Hidden and frozen objects don’t appear in the list.
- Because the dialog is modal, you must close it before continuing.
- To select an object and close the dialog, double-click the object’s list entry.
- All toggle settings such as Select Dependents, Display > Children, and the Display buttons persist. That means they survive Reset operations and even quitting and restarting 3ds Max. This also applies to the position and size of the dialog. To return all dialog settings to their defaults, delete this file: [program folder]\plugcfg\DefaultModalSceneExplorer.ini.

206 | Chapter 4  Selecting Objects
NOTE The Select From Scene dialog name and functionality are context dependent. When a transform such as Select And Move is active, the dialog lets you choose from all objects in the scene. But when certain modes are active, the choices in the dialog are more limited. For example, when Select and Link on page 3631 is active, the dialog is entitled Select Parent, and shows linkable objects but not the child object already selected. Similarly, if Group > Attach is active, the dialog is named Attach To Group and lists groups but not solitary objects.

TIP If you prefer to use the legacy Select Objects dialog instead of Select From Scene, it’s available as an option. Open the CurrentDefaults.ini file (see Market-Specific Defaults on page 8246), find the [Scene Explorer] section, and change SelectByNameUsesSceneExplorer setting. If set to 1, then Select By Name and related commands use the Select From Scene dialog. If set to 0, then Select By Name and related commands use the legacy Select Objects dialog. The latter’s functionality is essentially the same as the Selection Floater on page 209, except that it’s modal, not modeless.

See also:

■ Selection Floater on page 209
Procedures

To select objects by name:

1. Do one of the following:
   - Click the Select By Name button on the main toolbar.
   - Choose Edit menu > Select By > Name.
   - Press H.

   The Select From Scene dialog opens. By default, it lists all objects in
   the scene, displaying any hierarchies as collapsible branches. Currently
   selected objects are highlighted in the list.

2. Choose one or more objects in the list by doing one of the following:
   - To select a single object and close the dialog, double-click the object
     name.
   - Drag, or click and then Shift+click to select a contiguous range of
     objects and Ctrl+click to select noncontiguous objects.
   - In the field above the list, type a search phrase. As you type, all
     matches for the current phrase are highlighted in the list. To highlight
     only objects whose case matches the search phrase exactly, turn on
     Find Case Sensitive (from the Select menu).

   **NOTE** In some cases, such as when linking objects, you can select only one
   object.

3. Click Select.

   The selection is made as the dialog closes.

To highlight a single item from among multiple highlighted items:

Clicking one list item among several highlighted items does not unhighlight
the rest. When several items are highlighted, but you want to highlight only
one of them, do either of the following:

- If any items are not highlighted, click one of them to remove highlighting
  from the rest, and then highlight the one you want.
If all items are highlighted, the preceding method isn't practical. In that case, on the upper toolbar click Select None, and then highlight the one you want.

Selection Floater

[Available only as a CUI action]

This modeless dialog lets you select objects in the scene. You can keep the dialog open while you work in your scene, making it easier to select objects.

IMPORTANT The Selection Floater command is available only as a Customize User Interface on page 8249 action; to use it you must first add it explicitly to the user interface.

See also:

- Scene Explorer on page 7888
Interface

[select objects field] Enter a name to highlight objects in the list whose names begin with the text you specify.

Find Case Sensitive When on, the select objects field above the list is case-sensitive. For example, if the list contains objects named apple and Apple and Find Case Sensitive is on, typing “a” will highlight only the apple entry. Also, sorts the list so uppercase names come before lowercase.

[objects list] Lists objects according to the current Sort and List Types choices. Does not display hidden and frozen objects.
To highlight an object name in the list, click with the mouse. To highlight multiple object names, drag, or click and then Ctrl+click or Shift+click, or use the search field above the list. To select highlighted objects, click the Select button.

Alternatively, you can highlight and select a single object in the list by double-clicking its name.

After selecting objects, the dialog remains open until you close it explicitly.

**All/None/Invert** These buttons alter the pattern of selection in the list window.

**Influences** When you highlight an object in the list window and then click the Influences button, the selected object’s influences on page 8609 are highlighted as well.

**Display Subtree** Displays each item in the list so that its hierarchical branch on page 8599 is included (for example, Thigh/Shin/Foot). Hierarchical branches are indented.

**Display Influences** When this is on and you select an item in the list window, all of its influences are shown in blue. If you want to highlight these influences, click Influences.

**Select Subtree** When this is on and you select an item in the list window, all of its hierarchical children are selected as well.

**Select Dependents** When this is on and you select an item in the list window, all of its dependent on page 8549 objects are selected as well. Dependents include instances, references, and objects sharing a common modifier (the same objects that appear green when Show Dependencies is on in the View menu).

When both Select Subtree and Select Dependents are on, the subtree of any newly selected node is first selected, and then the dependents are selected. In other words, dependents of the subtree are selected, but not the subtrees of all dependents.

**Sort group**

Lets you choose the sort order of the items displayed in the list. This option is unavailable when Display Subtree is on; in that case, sorting is always alphabetical.

**Alphabetical** Sorts from numeric characters at the top, then A to Z at the bottom. When Find Case Sensitive is on, all upper-case names come before lower-case names.
By Type Sorts by category, using the same order as the check boxes in the List Types group.

By Color Sorts by object wireframe color. The sorting order is arbitrary; the value of this option is that objects of the same color are grouped together.

By Size Sorts based on the number of faces in each object. The object with the least number of faces is listed first, followed by objects with successively greater number of faces.

List Types group

Determines the types of objects to display in the list.

All/None/Invert These buttons alter the pattern of activation of the List Types options.

Selection Sets group

Lists any named selection sets on page 217 that you have defined in the scene. When you choose a selection set from the drop-down list, 3ds Max highlights its component objects in the main list.

Selection Region Flyout

Main toolbar > Selection Region flyout

The Selection Region flyout provides access to five methods you can use to select objects by region. Clicking the Selection Region button displays a flyout containing the Rectangle on page 230, Circular on page 231, Fence on page 232, Lasso on page 233, and Paint on page 234 Selection Region buttons.
For the first four methods, you can select either objects that are completely within the selection region (window method), or objects that are within or touched by the selection shape (crossing method). Toggle between the window and crossing selection methods by using the Window/Crossing Selection button on page 237 on the main toolbar.

**NOTE** If you hold down Ctrl while specifying a region, the affected objects are added to the current selection. Conversely, if you hold down Alt while specifying a region, the affected objects are removed from the current selection.

**NOTE** The Smart Select command activates the Select Object on page 204 function and, with repeated invocations, cycles through the available Selection Region methods. By default, Smart Select is assigned to the Q key; you can use Customize User Interface on page 8249 to assign it to a different keyboard shortcut, a menu, etc.

**Procedures**

**To select using a region (general method):**

1. Choose a Selection Region method from the flyout.

2. Drag in a viewport, then release the mouse. The first location you click is one corner of the rectangle, and where you release the mouse is the opposite corner.
**IMPORTANT** If you’re using Select Object on page 204, you can start dragging anywhere to select a region: on an object or off. However, if you’re using one of the transform tools, such as Select and Move on page 914, start the drag operation away from an object; that is, in an empty part of the viewport. Otherwise, if you start dragging on an object, most likely 3ds Max will assume you intend to select where you click and will begin the transform operation immediately.

To cancel the selection, right-click before you release the mouse.

## Selection Filter List

Main toolbar > Selection Filter

The Selection Filter list lets you restrict to specific types and combinations of objects that can be selected by the selection tools. For example, if you choose Cameras, you can select only cameras with the selection tools. Other objects do not respond. When you need to select objects of a certain type, this is useful as a quick method of freezing all other objects.

![Selection Filter List](image)

Use the drop-down list to select a single filter. Choose Combos from the drop-down list to use multiple filters from the Filter Combinations dialog on page 215.
Filter Combinations Dialog

Main toolbar > Selection Filter list > Combos > Filter Combinations dialog

Use the Filter Combinations dialog to create your own custom combinations of categories to add to the Selection Filters list on page 214.

You can also add specific types of objects, or Class IDs, to the list. For example, you can set a filter that lets you select only Sphere primitives.

Procedures

To create a combination filter:

1. Open the Selection Filter list and choose Combos.
   The Filter Combinations dialog appears.

2. Turn on one or more of the check boxes in the Create Combination group.

3. Click the Add button.
   The specified combination appears in the Current Combinations list to the right as a combination of the first letters of each selected category.

4. Click OK.
   The new combo item appears at the bottom of the Select Filter list.
   Combos are stored in the 3dsmax.ini on page 60 file, so they remain in effect for all scenes through all sessions.

To delete a combination filter:

1. Open the Selection Filter list and choose Combos.
   The Filter Combinations dialog appears.

2. Choose one or more of the combos in the Current Combinations list.

3. Click the Delete button.

4. Click OK.
Chapter 4   Selecting Objects
Create Combination group

**Geometry, Shapes, Lights, Cameras, Helpers, Space Warps** Choose the category or categories you want included in the combination.

**Add** After choosing the categories to include in a combination, click this button to place the categories, labeled with the categories’ initials, in the Current Combinations list, as well as at the bottom of the Selection Filter list.

Current Combinations group

**Current Combinations list** Lists current combinations. To delete one or more combinations, choose them, and then click **Delete**.

**Delete** After choosing one or more combinations in the Current Combinations list, click this button to delete them.

All Class ID group

**Class ID list** Lists all the available categories that can be added to custom filters for display and selection. Highlight a category to add, then click **Add**.

**Add** After choosing a class to include in the filter list, click this button to place the class in the Current Class ID Filter list, as well as at the bottom of the Selection Filter list.

Current Class ID Filter group

**Class ID list** Lists current classes to filter. To delete a class, choose it, and then click **Delete**.

**Delete** After choosing a class in the Current Class ID Filter list, click this button to delete the class.

Named Selection Sets

Main toolbar > Edit Named Selection Sets and the Named Selection Sets text field and drop-down list

The Named Selection Sets list allows you to name a selection set and recall the selection for later use. It supports selection sets both at the object level and at sub-object levels. You edit named object-level selection sets with the
Named Selections Sets dialog on page 219 and sub-object level sets with the Edit Named Selections dialog on page 224.

A named selection set is removed from the list if all of its objects have been deleted from the scene, or if all of its objects have been removed from the named set in the Named Selections Sets dialog.

Selection set names are case sensitive at both the object level and at sub-object levels.

You can transfer sub-object named selections from one level in the stack to another. The Copy and Paste buttons let you copy named selections from one modifier to another.

While at a specific sub-object level, such as Vertex, you can make selections and name those selections in the Named Selection Sets field of the toolbar. The named sets are specific to both the selection level and the level on the stack.

Keep in mind the following restrictions:

- You can transfer named selections only between the same type of sub-object level. In other words, you can transfer named selections from vertex sub-object to another vertex sub-object, but you can't transfer it to face or edge sub-object level.

- You must transfer the selection between modifiers that handle like geometry. You can copy and paste between an editable mesh and a mesh select modifier, but you can't copy and paste between a mesh select modifier and an editable spline.

- You can copy and paste between two modifiers in two different objects, as long as you're at the same level and both modifiers handle the same type of geometry.

- If you change the topology of a mesh after creating a named selection (such as deleting some vertices), the named selections will probably no longer select the same geometry.

Procedures

To create a named selection set:

1. Select the objects you want to be in a set.
2 Type the name of the set in the Named Selection Sets field, and then press Enter.

3 Whenever you want to access the selection, choose its name from the Named Selection Sets drop-down list.

**To select a named selection set, do one of the following:**

1 To select a single item, click it in the list.

2 To select more than one item in the list, select one, and then select others while holding down the Ctrl key.

3 To deselect single items after you’ve selected multiple items, hold down the Alt key.

---

### Named Selection Sets Dialog

Edit menu > Manage Selection Sets

Main toolbar > Edit Named Selection Sets

The Named Selection Sets dialog, available from the Edit menu and the toolbar, is a modeless dialog on page 8641 that lets you create named selection sets or select objects to add to (or remove from) a selection set, directly from the viewport. The dialog also lets you organize your current named selection sets, browse their members, delete or create new sets, or identify which named selection sets a particular object belongs to.

**NOTE** This dialog applies to objects only. For editing sub-object named selection sets, see Edit Named Selections Dialog on page 224.

**See also:**

- Named Selection Sets on page 217
- Using Named Selection Sets on page 185
- Edit Named Selections Dialog on page 224
Procedures

To create a named selection:

1. In the viewport, select the objects you want to gather as a selection set.

2. Click the Edit Named Selection Sets button on the main toolbar, or choose Edit > Manage Selection Sets.

3. On the Named Selection Sets dialog, click Create New Set.

4. Enter a name for the new selection set.

To add objects to a named selection set:

1. Click the Edit Named Selection Sets button on the main toolbar, or choose Edit > Manage Selection Sets.

2. Choose the named selection set in the dialog.

3. Select one or more objects in the viewport.

4. In the dialog, click Add Selected Objects.

To remove objects from a named selection set:

1. Click the Edit Named Selection Sets button on the main toolbar, or choose Edit > Manage Selection Sets.

2. Choose the named selection set in the dialog.

3. In the viewport, select the objects you want to remove.

4. In the dialog, click Subtract Selected Objects.
NOTE You can also remove objects by selecting them in the Named Selection Sets dialog, then clicking Remove or pressing Delete.

To move an object from one set to another:

1. Click the Edit Named Selection Sets button on the main toolbar, or choose Edit > Manage Selection Sets.
2. In the Named Selection Sets dialog, expand the selection sets.
3. Drag an object from one set to another.
   The object is moved into the second set. If you use Ctrl+drag, the object will be copied into the second set.

   TIP You can also copy the contents of an entire set into another, by dragging them into the desired selection set.

To select objects in a set:

1. Highlight the set in the Named Selection Sets dialog.
2. Click Select Objects In Set to select all of the objects in the highlighted set.
Interface

In the Named Selection Sets dialog, all of the current named selection sets are displayed. By clicking the plus (+) or minus (-) icon, you can expand or collapse (respectively) the object list for each set.

The buttons along the top of the dialog let you create or delete sets, add or remove objects from a set, select objects (independently or as a selection set), and see which named selection set(s) a particular object belongs to.

![Create New Set][1] Creates a new selection set, including any currently selected objects as members.

**NOTE** If no objects are selected, an empty set is created.
Remove  Removes the selected object or selection set.

**NOTE** Deleting an object or its selection set does not delete the object; it only destroys the named set.

Add Selected Objects  Adds the currently selected objects to the selected named selection set.

Subtract Selected Objects  Removes currently selected objects from the selected named selection set.

Select Objects in Set  Selects all members of the current named selection.

Select Objects by Name  Opens the Select Objects dialog on page 206, where you can select a group of objects. The selected objects can then be added to or removed from any named selection set.

Highlight Selected Objects  Highlights all of the named selection sets that contain the current scene selection.

Status Bar  Displays the current named selection set, as well as what’s currently selected in the scene. If more than one object is selected, the number of selected objects is displayed.

**Right-click menu**

Additional commands are available when you right-click in the Named Selection Sets dialog.

Rename  Lets you rename the selected set or object.

**TIP** You can rename objects or sets by pressing F2.

Cut  Removes the selected object or set and stores it in a buffer for reuse with the Paste command, similar to the Cut command in Windows.
Tip: You can cut an object or set by pressing Ctrl+X.

Copy copies the selected object or set and stores it in a buffer for reuse with the Paste command, similar to the Copy command in Windows.

Tip: You can copy an object or set by pressing Ctrl+C.

Paste adds a Cut or Copied object or set into another set.

Tip: You can paste an object or set by pressing Ctrl+V.

Collapse All collapses all expanded selection sets.

Expand All expands all collapsed selection sets.

Create New Set creates a new selection set, including any currently selected objects as members.

Remove removes the selected object or selection set.

Add Selected Objects adds currently selected objects to the selected named selection set.

Subtract Selected Objects removes currently selected objects from the selected named selection set.

Select Objects in Set selects all members of the current named selection.

Select Objects by Name opens the Select Objects dialog on page 206, and adds all objects selected there to the current named selection set.

Highlight Selected Objects highlights all of the named selection sets that contain the current scene selection.

Find Next toggles through selection sets containing the selected object, when used in collaboration with the Highlight Selected Objects command.

Tip: You can use Ctrl+G to toggle through the sets.

Edit Named Selections Dialog

Make a sub-object selection. > Edit menu > Manage Selection Sets

Make a sub-object selection. > Main toolbar > Edit Named Selection Sets
Edit Named Selections displays the Edit Named Selections dialog, letting you manage named selection sets of *sub-objects on page 199*. Unlike the *Named Selection Sets dialog* on page 219, which applies to *objects only*, it is a modal dialog, which means that you must close it in order to work in other areas of 3ds Max. Also, you can work only with existing named sub-object selections; you cannot use the dialog to create new selections.

**Procedures**

To edit named sub-object selections:

1. At a sub-object level, create one or more *named selection sets* on page 217.

2. Click the Edit Named Selection Sets button on the main toolbar, or choose Edit > Manage Selection Sets. The Edit Named Selections dialog opens, listing all named selection sets for the current sub-object level.

3. Use the dialog controls to edit the named selection sets.
The dialog window lists all named selections at the current sub-object level. The buttons beneath the windows let you delete, merge, and edit the listed items. Use standard mouse-plus-keyboard methods (using Ctrl or Shift) to highlight list items and designate them for subsequent operations.
To rename a set, click it in the list, and then edit its name in the one-line window immediately below the list.

**Combine** Merges all objects from the highlighted selection sets into a single, new selection set. Select two or more selection sets, and then click Combine and enter a new name for the selection set. Use Delete to delete the original sets.

**Delete** Deletes all highlighted items from the Named Selections window. This affects only selection sets, not the sub-objects they refer to.

**Subtract (A-B)** Removes the sub-objects contained in one selection set from another. Select one item in the Named Selections window, and then select the other. The top highlighted item in the window is operand A, and the bottom is operand B (regardless of the order of their selection). Click Subtract (A-B) to subtract the sub-objects in the bottom item from those in the top item. There must be some overlap between the two selection sets for this command to have any effect.

**Subtract (B-A)** Subtracts the sub-objects in the top selected item from those in the bottom item.

**Intersection** Creates a selection set that consists only of sub-objects that all highlighted selection sets have in common. Highlight two or more items in the Named Selections window, and then click Intersection. In the dialog that appears, enter a new set name and click OK.

### Select All

- **Edit menu > Select All**
- **Keyboard > Ctrl+A**

This command selects all objects in the scene matching the current selection filter type on page 214 on the main toolbar.

### Select None

- **Edit menu > Select None**
- **Keyboard > Ctrl+D**

This command deselects all objects in the scene conforming to the current selection filter type on page 214 on the main toolbar.
Select Invert

Edit menu > Select Invert

Keyboard > Ctrl+I

This command inverts the current selection set. All objects not currently selected are selected, and all objects currently selected are deselected, respecting the current selection filter type on page 214 on the main toolbar.

Select Similar

Select one or more objects. > Edit menu > Select Similar

Select one or more objects. > Right-click > quad menu > Transform quadrant > Select Similar

Select one or more objects. > Ctrl+Q

Select Similar automatically selects all items that are “similar” to the current selection. In general, this means that the objects must be on the same layer, and have the same material (or no material) applied. The specific functionality depends on the objects’ source:

- Selects all items imported in the DWG format in the selected object’s or objects’ layer that have the same style(s) on page 7535 or categories as defined in AutoCAD Architecture (formerly known as ADT, or Architectural Desktop), or the same families and types as defined in Revit. For example, if you’ve imported or linked to a DWG file that contains walls in several different styles, such as CMU-8, Concrete-8, and Stud-4, you could select all CMU-8 wall segments in the same layer by selecting one and then invoking Select Similar.
  
  If you start by selecting multiple objects with different styles, Select Similar will select all objects with those styles.

- This command also applies to objects native to 3ds Max. It selects all objects of the same type. This includes primitives and editable object types. For example, if you add some boxes and cylinders, select one of the cylinders, and then invoke Select Similar, all of the cylinders will be selected, but not the boxes. If you then convert all of the objects to Editable Poly format and repeat the test, all of the objects will be selected. If you then apply a material to one of the objects or move it to a different layer, it’s no longer “similar” to the rest and won’t be selected by Select Similar.
Select By

Edit menu > Select By

The Select By submenu on the Edit menu provides commands for selecting objects in the scene by color, name, and other characteristics. It also gives quick access to the various Region selection options.

See also:
■ Selection Tab on page 2180

Select By Color

Edit menu > Select By > Color

Select By Color lets you select all objects having the same color as the selected object. Selection is made by wireframe color (see Object Color Dialog on page 368), rather than by any materials associated with the objects.

After you choose this command, click any object in the scene to determine the color for the selection set.

TIP To select objects by material, use Schematic View on page 7926.

Select By Name (Edit Menu)

Edit menu > Select By > Name

Keyboard > H

Select By Name lets you select objects by choosing them from a list of all objects in the scene.

For a full description of the Select By Name function, see Select From Scene on page 206.

TIP To select objects by material, use Select By Material on page 5686.
Select By Layer

Edit menu > Select By > Select By Layer

Select By Layer lets you select all objects in one or more layers by picking them from a list of all layers in the scene. Choosing this command opens the Select By Layer dialog; use standard methods to highlight one or more layers, and then click OK. The dialog closes, and all objects in the highlighted layer or layers are selected.

Selection Region

Edit Menu > Selection Region

The Selection Region submenu on the Edit menu provides quick access to the various region selection options.

See also:
- Selecting by Region on page 181

Rectangular Selection Region

main toolbar > Rectangular Selection Region (Selection Region flyout)

Edit menu > Selection Region > Rectangular Region

The Rectangular Selection Region option, available from the Selection Region flyout on page 212 and the Edit menu, provides one of five methods you can use to select objects by region. The other methods are Circular on page 231, Fence on page 232, Lasso on page 233, and Paint on page 234.

You can use Rectangular to select either objects that are completely within the selection region (window method), or objects that are either within or touched by the selection shape (crossing method). Toggle between the window and crossing selection methods by using the Window/Crossing Selection button on page 237 on the main toolbar.

NOTE If you hold down Ctrl while specifying a region, the affected objects are added to the current selection. Conversely, if you hold down Alt while specifying a region, the affected objects are removed from the current selection.
Procedures

To select using a rectangle:

1. Click the Rectangular Selection Region button.

2. Drag in a viewport, then release the mouse. The first location you click is one corner of the rectangle, and where you release the mouse is the opposite corner.

   To cancel the selection, right-click before you release the mouse.

Circular Selection Region

main toolbar > Circular Selection Region (Selection Region flyout)

Edit menu > Selection Region > Circular Region

The Circular Selection Region option, available from the Selection Region flyout on page 212 and the Edit menu, provides one of five methods you can use to select objects by region. The other methods are Rectangular on page 230, Fence on page 232, Lasso on page 233, and Paint on page 234.

You can use Circular to select either objects that are completely within the selection region (window method), or objects that are either within or touched by the selection shape (crossing method). Toggle between the window and crossing selection methods by using the Crossing Selection button on page 237 on the main toolbar.

NOTE If you hold down Ctrl while specifying a region, the affected objects are added to the current selection. Conversely, if you hold down Alt while specifying a region, the affected objects are removed from the current selection.

Procedures

To select using a circle:

1. Click the Circular Selection Region button.
2 Drag in a viewport, then release the mouse. The first location you click is the center of the circle, where you release the mouse defines the circle's radius.

To cancel the selection, right-click before you release the mouse.

**Fence Selection Region**

Main toolbar > Fence Selection Region (Selection Region flyout)

Edit menu > Selection Region > Fence Region

The Fence Selection Region option, available from the Selection Region flyout on page 212 and the Edit menu, provides one of five methods you can use to select objects by region. The other methods are Rectangular on page 230, Circular on page 231, Lasso on page 233, and Paint on page 234.

You can use Fence to select either objects that are completely within the selection region (window method), or objects that are either within or touched by the selection shape (crossing method). Toggle between the window and crossing selection methods by using the Window/Crossing button on page 239 on the main toolbar.

**NOTE** If you hold down Ctrl while specifying a region, the affected objects are added to the current selection. Conversely, if you hold down Alt while specifying a region, the affected objects are removed from the current selection.

**Procedures**

To select using a fence:

1. Click the Fence Selection Region button.

2. Drag to draw the first segment of a polygon, then release the mouse button.

   A "rubber-band line" is now attached to the cursor, anchored at the point of release.

3. Move the mouse and click to define the next segment of the fence. You can make as many steps as you want.

4. To complete the fence, either click the first point, or double-click.
A pair of cross hairs appears when you're near enough to click the first point. This creates a closed fence.

Double-clicking creates an open fence, which can select objects only by the crossing method.

To cancel the selection, right-click before you release the mouse.

---

**Lasso Selection Region**

Main toolbar > Lasso Selection Region (Selection Region flyout)

Edit menu > Selection Region > Lasso Region

The Lasso Selection method lets you select multiple objects within a complex or irregular region with a single mouse action.

The Lasso Selection Region option, available from the Selection Region flyout on page 212 and the Edit menu, provides one of five methods you can use to select objects by region. The other methods are Rectangular on page 230, Circular on page 231, Fence on page 232, and Paint on page 234.

You can use Lasso to select either objects that are completely within the selection region (window method), or objects that are either within or touched by the selection shape (crossing method). Toggle between the window and crossing selection methods by using the Window/Crossing button on page 239 on the main toolbar.

---

**NOTE** If you hold down Ctrl while specifying a region, the affected objects are added to the current selection. Conversely, if you hold down Alt while specifying a region, the affected objects are removed from the current selection.

---

**Procedures**

**To select using a lasso:**

1. Click the Lasso Selection Region button.

2. Drag to draw a shape around the object(s) that should be selected, then release the mouse button.

   **NOTE** To cancel the selection, right-click before you release the mouse.
Paint Selection Region

main toolbar > Paint Selection Region (Selection Region flyout)

Edit menu > Selection Region > Paint Region

The Paint Selection method lets you select multiple objects or sub-objects by dragging the mouse over them. To change the brush size, right-click the Paint Selection Region button, and then, on the Preference Settings dialog > General tab > Scene Selection group, change the Paint Selection Brush Size value on page 8303.

If you hold down Ctrl while specifying a region, the affected objects are added to the current selection. Conversely, if you hold down Alt while specifying a region, the affected objects are removed from the current selection.

TIP You can also create custom tools for changing the brush size; choose Customize menu > Customize User Interface and set keyboard shortcuts or other user interface items for the actions Paint Selection Size Up and Paint Selection Size Down.

NOTE Paint Selection Region respects the Window/Crossing selection toggle on page 239 setting. If the toggle is set to Select Region Window on page 235 and the brush is smaller than an object or sub-object to be selected, you won’t be able to select the item. To resolve this, enlarge the brush or choose Select Region Crossing on page 237.

NOTE With editable poly on page 2240 and Edit Poly on page 1332 objects, you can also paint soft selections on page 2021 and deformation on page 2245.

The Paint Selection Region button, available from the Selection Region flyout on page 212, provides one of five methods you can use to select objects by region. The other methods are Rectangular on page 230, Circular on page 231, Lasso on page 233, and Fence on page 232.

Procedures

To select by painting a region:

1 Choose Paint Selection Region from the flyout.
2 Drag over the object(s) to select, then release the mouse button. As you drag, a circle showing the brush radius appears attached to the mouse.

**NOTE** To cancel the selection, right-click before you release the mouse.

3 To change the brush size, right-click the Paint Selection Region button, and then, on the Preference Settings dialog > General tab > Scene Selection group, change the Paint Selection Brush Size value on page 8303.

You can also set keyboard shortcuts for changing the brush size. To do so, use the Paint Selection Size Up and Paint Selection Size Down action items. See Keyboard Panel on page 8250.

---

**Select Region Window**

Edit menu > Selection Region > Window
main toolbar > Window/Crossing Selection

Select Region Window selects objects within a [selection region](#) on page 212.

After you choose this command, draw a selection region around any objects in the scene. Only those objects that are entirely inside the region boundary are selected.
Select Region Window selects only those objects completely inside the window: the trash can and bench.

Procedures

To select objects within a selection region:

1. Do one of the following:
   - Choose Edit > Selection Region > Window.
   - Click the Window/Crossing Selection Toggle on page 239 to display the Window icon.

2. On the main toolbar, click the Selection Region flyout on page 212 and choose a method: Rectangular, Circular, Fence, or Lasso Selection region.

   **NOTE** This setting also applies to Paint Selection Region, but in this case the boundary is that of the brush, not the region. In other words, when painting a selection region, the brush must completely encompass an object or sub-object to select it.

3. Drag to specify the region and select the objects.
Region

Edit menu > Region
main toolbar > Window Selection or Crossing Selection

When dragging the mouse to select one or more objects, the Region options let you switch between selecting objects within, or crossed by, a window region that you draw with the mouse. Choose the appropriate Selection Region submenu command, or use the Window/Crossing Selection Toggle on page 239 on the main toolbar.

You can automatically switch between Window and Crossing Region Selection based on cursor movement direction. To set this up, choose Customize > Preferences and on the General tab in the Scene Selection group turn on Auto Window/Crossing Selection by Direction.

See also:

- Select Region Window on page 235
- Select Region Crossing on page 237

Select Region Crossing

Edit menu > Selection Region > Crossing
main toolbar > Crossing Selection

Select Region Crossing selects objects within and crossed by a selection region on page 212 boundary.
Select Region Crossing selects objects within the window and also objects it crosses: the trash can, bench, and streetlight.

After you choose this command, draw a selection region around or crossing objects in the scene. Objects within the region boundary as well as those that intersect the boundary are selected.

Procedures

To select objects within and crossed by a selection region:

1. Do one of the following:
   - Choose Edit > Selection Region > Crossing.
   - Click the Window/Crossing Selection Toggle on page 239 to display the Crossing icon.

2. From the main toolbar, click the Selection Region flyout on page 212 and choose a method: Rectangular, Circular, Fence or Lasso Selection region.
NOTE This setting also applies to Paint Selection Region, but in this case the boundary is that of the brush, not the region. In other words, when painting a region in Crossing mode, the brush selects every object or sub-object it touches or encompasses.

3 Drag to specify the region and select the objects.

Window/Crossing Selection Toggle

main toolbar > Crossing Selection or Window Selection from the Window/Crossing toggle
Edit menu > Region > Window or Crossing
The Window/Crossing Selection toggle switches between window and crossing modes when you select by region.
- In Window mode on page 235, you select only the objects or sub-objects within the selection.
- In Crossing mode on page 237, you select all objects or sub-objects within the region, plus any objects or sub-objects crossing the boundaries of the region.

TIP If you’re making sub-object selections of faces and you select more faces than you want, make sure you’re in Window mode.

The Selection Region flyout on page 212 on the toolbar allows you to create different-shaped boundaries.
3ds Max automatically saves the Window/Crossing setting in the 3dsmax.ini file.

Edit Commands

These commands on the Edit menu on page 7999 are for basic edit manipulations of selections.
Undo and Redo work as in standard Windows applications. These commands are available on the default main toolbar as well. 3ds Max also provides a history of commands. Right-clicking the Undo or Redo buttons displays a list of commands you can undo or redo. Not all operations are reversible using Undo.

**NOTE** Viewport changes such as panning and zooming have a separate Undo and Redo. See View-Handling Commands on page 126.

The Hold and Fetch command pair serves as an alternative to Undo and Redo. Hold saves the current state of the scene. After using Hold, you can restore that state at a later point by using Fetch. Sometimes, when you are about to perform a risky operation, an alert prompts you to first use Hold.

3ds Max does not have the Cut or Paste functions found in many Windows applications. The Delete command simply removes the selection from the scene.

---

**Undo/Redo**

Quick Access toolbar on page 7995 > Undo button or Redo button
Edit menu > Undo or Redo
Keyboard > Ctrl+Z (Undo) or Ctrl+Y (Redo)

The Undo command reverses the last operation, including selection actions and those performed on selected objects. Redo reverses the last Undo operation.

Some actions cannot be undone: for example, applying the Collapse utility or Reset Transform utility, or saving a file, which overwrites the previous version. When you know an action cannot be undone, use Hold on page 242 first. Then if you want to undo it, use Fetch. Hold and Fetch are also commands on the Edit menu on page 7999.

After you perform an action that is undoable, the Undo command on the Edit menu shows the name of the function to be undone. After you undo an action, the Redo command Edit menu shows the name of the function you can redo.

Undo and Redo are also available as buttons on the Quick Access toolbar. You can click the Undo or Redo down-arrow to display a drop-down list that shows the last operations performed. You can highlight and reverse any number of these operations in sequence with the respective Undo or Redo command. By
default, there are 20 levels of Undo. You can change the number of levels with the Customize > Preferences > General tab on page 8299 > Scene Undo group.

**Undo/Redo and Object Creation**

When you create an object, the Create operation is recorded by 3ds Max and displayed next to the activated Undo command in the Edit menu. If you undo the Create operation, the Create operation appears next to the activated Redo command in the Edit menu. The Undo and Redo commands in the Edit menu are unavailable when no valid operation was performed or recorded.

**Procedures**

To undo the most recent action:

Do one of the following:

- Click Undo.
- Choose Edit menu > Undo.
- Press Ctrl+Z.

To undo several actions:

1. Click the Undo drop-down arrow.
2. From the list, select the level where you want to return. You must choose a continuous selection; you can’t skip over items in the list.
3. Click the Undo button.
   To exit the list without performing an action, click the Cancel button, or click somewhere outside of the list.

To redo an action, do one of the following:

1. Click Redo.
2. Edit menu > Redo.
3. Press Ctrl+Y.
To redo several actions:

1. Click the Redo drop-down arrow.

2. From the list, click the action to return to.
   Your selection must be continuous: you can't skip over any items in the list.

3. Click the Redo button.
   To exit the list without performing an action, click the Cancel button or click somewhere outside of the list.

Hold/Fetch

Edit menu > Hold or Fetch

Hold saves the scene and its settings to a disk-based buffer. Fetch restores the contents of the buffer stored by the previous Hold command. The information stored includes geometry, lights, cameras, the viewport configuration, and selection sets.

Use Hold before you perform an operation that might not work as expected, that is new or unfamiliar to you, or that cannot be undone. If the results aren’t as expected, you can use Fetch to return to the point where you chose Hold.

TIP Also use Save or Save As before you perform an operation that cannot be undone: for example, applying the Reset Transform utility.

If you experience an unexpected end of operation or crash after you perform Hold, you can retrieve your scene from the buffer with the Fetch command after you restart 3ds Max.

Additional Details

- The Hold buffer is a temporary file (maxhold.mxx) in the directory specified by the AutoBackup path on the Configure User Paths dialog > File I/O panel on page 8287.
- Fetch also deletes all operations recorded in the Undo and Redo History lists.
Delete

Make a selection. > Edit menu > Delete
Make a selection. > Keyboard > Delete
The Delete command deletes the current selection from the model.
The Undo command on page 240 can restore the deleted selection to the model.
(Undo is also available as a button on the Quick Access toolbar on page 7995.)

NOTE Actively file-linked objects on page 7538 cannot be deleted.

Groups and Assemblies

You use groups and assemblies in 3ds Max to combine arbitrary sets of scene entities into a single, non-hierarchical object that you can then manipulate as one. Grouping works best when you don’t need to manipulate components of the group; assemblies are best for articulated models such as light fixtures; character assemblies are specifically for modeling bipedal characters.

See also:
- Container on page 7395

Using Groups

Grouping lets you combine two or more objects into a single grouped object. The grouped object is given a name, and then treated much like any other object.
Object on the right is a group and treated as a single entity.

Group names are similar to object names, except that they're carried by the group object. In lists like the one in the Selection Floater on page 209, group names appear in square brackets. For example: [Group01]. In Scene Explorer on page 7888 and related dialogs, the square brackets enclose the group object icon instead.

The commands to manage groups are on the default Group menu on page 8005.

**General Features of Groups**

Once you group objects, you can treat them as a single object in your scene. You can click any object in the group to select the group object.

When you create a group, all of its member objects are rigidly linked to an invisible dummy object. The group object uses the pivot point and the local transform coordinate system of this dummy object.

Groups can be nested. That is, groups can contain other groups, up to any level.
Transforming and Modifying a Group

You can transform and modify a group as if it were a single object, and you can animate the transforms and the modifiers.

When you apply a modifier to the group, this applies an instance of the modifier to each object in the group. A grouped object retains its modifier instance, even if you later remove it from the group.

When you apply a transform to the group, on the other hand, this applies only to the group as a whole. More precisely, 3ds Max applies transforms to the dummy object that represents the group.

You can transform and animate individual objects within a group independently from the group itself. However, when you transform the group itself, the transform affects all grouped objects equally. The group transform is uniformly added to objects that have independent motions. An analogy is a cage of birds, each flying around on its own, while the cage itself is being moved. In the case of groups, the "cage" (the dummy object) expands to surround all objects in the group, wherever the objects' independent transforms take them.

Accessing Objects in a Group

You can open and close groups to access the individual objects contained in them without dissolving the group. These commands maintain the integrity of the group.

- **Open** on page 260: Temporarily opens the group so that you can access its member objects. While a group is open, you can treat the objects (or nested groups) as individuals. You can transform them, apply modifiers, and access their modifier stacks.

- **Close** on page 260: Restores the group when you’re finished working with the individual objects.

Dissolving Groups

You can permanently dissolve groups by either ungrouping or exploding them. Both commands dissolve groups, but to different levels.

- **Ungroup** on page 261: Goes one level deep in the group hierarchy. It separates the current group into its component objects (or groups), and deletes the group dummy object.
■ **Explode** on page 261: Similar to Ungroup, but dissolves all nested groups as well, leaving independent objects.

When you Ungroup or Explode a group, the objects within the group lose all group transforms not on the current frame. However, objects retain any individual animation.

To transform or modify the objects within a group, you must first remove them from the group, either temporarily or permanently. The Open command lets you do this.

**Comparing Groups with Other Selection Methods**

Compared to the other methods you can use to combine objects in 3ds Max, grouping is more permanent than selection sets, but less permanent than attaching objects.

■ **Selection sets** on page 178: Form a temporary collection of objects to which you apply the current commands. As soon as you select another object, the selection set is gone.

■ **Named selection sets** on page 185: Let you reselect the same pattern of objects, but the positional relationship between those objects (their transforms) might be different each time you recall the named set.

■ Grouped objects: Maintain their positional relationships unless you open the group and rearrange them. A group also keeps its identity as an individual object.

Each object in a group retains its modifier stack, including its base parameters. At any time, you can open the group to edit an object, and then close the group to restore the group identity.

■ Attached objects (see **Editable Mesh (Object)** on page 2200): Attached objects form a single object. The modifier stacks of the original objects are lost, including their base parameters. You can regain the form of the original objects by detaching them, but they become plain meshes.

■ **Assemblies** on page 247 are useful for creating combinations of geometry and light objects that act as lighting fixtures.
Using Assemblies

Assemblies are useful for creating combinations of geometry and light objects that act as lighting fixtures; you use them to represent the housing of a lamp and its light source or sources. You can use assemblies to represent lighting fixtures such as simple desk lamps, lighting strips, track systems, wall sconces with fluorescent or incandescent lights, chandelier systems, line voltage cable systems, and so on.

Object on the right is an assembly and is treated as a single entity.

When you create light assemblies, first you create your objects and build a hierarchy, then set joint parameters and assign inverse kinematics (IK) on page 3661. As a final step, you assemble the object hierarchy. The lights you use in the assembly have light-multiplier and filter color controls. You wire on page 3610 the Dimmer and Filter Color parameters of the Luminaire helper object to the parameters of the light sources that are members of the light assembly.
NOTE In order to wire the Luminaire controls to the light parameters, you must first open on page 267 the assembly; then, after wiring, you close on page 268 it.

You can use IK to point a luminaire’s beam by simply moving the light’s target object.

Assemblies and Groups

Assembly functionality is a superset of grouping on page 243. Like grouping, creating an assembly lets you combine two or more objects and treat them as a single object. The assembled object is given a name, and then treated much like any other object.

The main difference with assemblies is that, when you assemble on page 263 the member objects, you specify a head object on page 271: a Luminaire helper object on page 271. The head object acts as a front end for the assembly, and its parameters appear in the Modify panel when the assembly is selected. You can use these parameters to control the light sources in the assembly via parameter wiring on page 3610. You can create other types of head objects with MAXScript; for further information, open the MAXScript Help, available from the Help menu, and look in Creating MAXScript Tools > Scripted Plug-ins > Scripted Helper Plug-ins.

Assembly names are similar to object names, except that they’re carried by the assembly. In lists like the one in the Selection Floater on page 209, assembly names appear in square brackets; for example: [Assembly01]. In Scene Explorer on page 7888 and related dialogs, the square brackets enclose the assembly object icon instead.
**TIP** After you’ve created one fixture and assembled the parts, use instancing on page 8611 to copy on page 981 the fixture, and then distribute them in your scene. That way, if you change the attributes for a light source in an assembly, the change will be reflected in all the instanced light sources. For example, in the early design stages, you might use shadow maps, but later you might want to switch to advanced ray-trace shadows for greater accuracy in rendering. Using instancing makes it easier to change such settings globally.

### General Features of Assemblies

Once you assemble objects, you can treat them as a single object in your scene. You can click any object in the assembly to select the entire assembly.

When you create an assembly, all of its member objects are rigidly linked to an invisible Luminaire helper object. The assembly uses the pivot point and the local transform coordinate system of this helper object.

You can nest assemblies. That is, assemblies can contain other assemblies (or groups), up to any level.

The head object parameters appear in the Modify panel when the assembly is selected. You can use the 3ds Max Wire Parameters on page 3610 functionality to connect these parameters to those of light objects in the assembly. For a step-by-step procedure, see To wire a head object to a light source on page 265.

---

**Luminaire types**

- **Left:** Fixed
- **Middle:** Orientable
- **Right:** Multiple lights
Transforming and Modifying an Assembly

You can transform or modify an assembly as if it were a single object, and you can animate the transforms.

Unlike a group, when you apply a modifier to the assembly, only the luminaire receives the modifier. Thus, deforming modifiers such as Bend don’t have any effect on assemblies.

When you apply a transform to the assembly, it applies to the assembly as a whole. More precisely, 3ds Max applies transforms to the dummy object that represents the assembly. To modify member objects, you must first open the assembly, select the objects, and then apply modifiers. Such modifiers do not appear in the modifier stack when the assembly is closed.

You can transform and animate individual objects within an assembly independently from the assembly itself. However, when you transform the assembly itself, the transform affects all assembled objects equally. The assembly transform is uniformly added to objects that have independent motions. An analogy is a cage of birds, each flying around on its own, while the cage itself is being moved. In the case of assemblies, the "cage" (the dummy object) expands to surround all objects in the assembly, wherever the objects’ independent transforms take them.

Accessing Objects in an Assembly

You can open and close assemblies to access the individual objects contained in them without dissolving the assembly. These commands maintain the integrity of the assembly.

- Open on page 267: Temporarily opens the assembly so that you can access its member objects. While an assembly is open, you can treat the objects (or nested assemblies/groups) as individuals. You can transform them, apply modifiers, and access their modifier stacks.

- Close on page 268: Restores the assembly when you’re finished working with the individual objects.

Using Make Unique with Assemblies

When you clone assemblies using instancing, and then make the clones unique, it’s important to consider how this affects parameter wiring. Consider the following typical usage case:

1. Drag an assembly, such as a light fixture, into the scene.
2 Clone the assembly several times using the Instance option and position the instances in the scene.

3 To make the scene look more realistic, giving the appearance of randomness to the objects in the scene, make some of the assembly instances unique and adjust their parameters to differ from the rest of the instances.

When you clone-instance an assembly, all objects in the assembly, along with all the parameter wires, are instanced. So if you change a wired luminaire parameter, all instanced assemblies are affected.

When the modifier stack displays an assembly head that is an instance or reference, the Make Unique button is active. By clicking it, the assembly head object is made unique with respect to its instances and all the assembly members are also made unique.

The parameter wiring between the unique assembly head and its members is de-coupled from the other instances of the assembly. Changing the parameters of the unique assembly head object affects only the parameters of its own members, not the members of the other instances of the assembly.

When multiple assembly instances are selected, the Make Unique command works the same as when multiple instances of an object are selected. You’re asked whether you want to make the selected assemblies unique one with respect to each other.

- If you answer Yes, 3ds Max makes the assemblies unique one with respect to another and parameter wires are reconnected inside each unique assembly. That is, the parameters of each unique assembly head drives only the parameters of its own members, not that of the members in any other assembly instances.

- If you answer No, then the selected assemblies are made unique only with respect to the other assembly instances. The parameters of unique assembly heads drive only the parameters of their members, not the members of the other assembly instances.

**NOTE** If you chose to instance the controllers when you instanced the assembly, the Modify panel > Make Unique command does not make the controllers unique. You can make them unique by doing the following: Open Track View, select the Transform track for object whose controller you want to make unique, and click the Make Unique button in the Track View toolbar.
Dissolving Assemblies

You can permanently dissolve assemblies by either *disassembling* or *exploding* them. Both commands dissolve assemblies, but to different levels.

- **Disassemble** on page 269: Goes one level deep in the assembly hierarchy. It separates the current assembly into its component objects (or assemblies/groups), and deletes the assembly head object.
- **Explode** on page 269: Similar to Disassemble, but dissolves all nested assemblies and groups as well, leaving independent objects.

When you disassemble or explode an assembly, any transform animation applied to the assembly is lost, and objects remain as they were in the frame at which the dissolution is performed. However, objects retain any individual animation.

To transform or modify the objects within an assembly, you must first remove them from the assembly, either temporarily or permanently. The Open command lets you do this.

Comparing Assemblies with Other Selection Methods

Compared to the other methods you can use to combine objects in 3ds Max, assembling is more permanent than selection sets, but less permanent than attaching objects.

- **Selection sets** on page 178: Form a temporary collection of objects to which you apply the current commands. As soon as you select another object, the selection set is gone.
- **Named selection sets** on page 217: Let you reselect the same pattern of objects, but the positional relationship between those objects (their transforms) might be different each time you recall the named set.
- **Assembled and grouped** on page 243 objects: Maintain their positional relationships unless you open the assembly and rearrange them. An assembly also keeps its identity as an individual object. Each object in an assembly retains its modifier stack, including its base parameters. At any time, you can open the assembly to edit an object, and then close the assembly to restore the assembly identity.
- **Attached objects** (see *Editable Mesh (Object)* on page 2200): Attached objects form a single object. The modifier stacks of the original objects are lost, including their base parameters. You can regain the form of the original objects by detaching them, but they become plain meshes.
See also:

- Lights on page 5314

Procedures

To insert and place an existing assembly:

1. Turn on AutoGrid on page 2792.

2. Drag the assembly from a Web page (if it's an i-drop object on page 7644) or from your local disk and drop it into your scene, placing it on any existing surface.

3. On the main toolbar, click Use Pivot Point Center on page 931.

4. Position the assembly as you would any other object to aim it in a specific direction.

5. If necessary, wire on page 265 the assembly luminaire to its light source or sources.

6. Select the assembly, and then use the Modify panel settings to adjust the intensity of the light with the Dimmer control.

To create your own luminaire:

1. Create the geometry of the lighting fixture.

2. Create a light source on page 5314 or on the Create panel, click Lights to add a standard or photometric light to the geometry of the lighting fixture you just made.

3. Select all the objects in the assembly, including geometrical objects and lights.

   **NOTE** If using IK, leave the light targets out of the assembly so that you can manipulate them independently.

4. Choose Assembly menu > Assemble.
   A dialog appears requesting a name for the assembly and that you specify a head object. The only head object type available by default is Luminaire on page 271.
5 Enter a name for the assembly and click OK.
6 Wire on page 265 the assembly luminaire to its light source or sources. More information on parameter wiring is available at the link in this step. If more than one light source is present inside the assembly, create a chain of wired parameters. Then enter the desired relationship expression in the expression text box.

To adjust the pivot location of an assembly:
- When you adjust the pivot point of a closed group or assembly, the pivot point of all group and assembly members are affected, not only the pivot point of the group or assembly head object. Therefore, we recommend that you open the assembly, adjust the pivot of the head object, and then close the assembly.

To use an assembly with radiosity:
- Right-click the Luminaire, choose Properties, and on the Object Properties dialog on page 283 choose the Radiosity tab. You can exclude and control radiosity parameters of the geometry and lights independently.

To adjust the properties of an assembly:
1 After wiring the Dimmer and Filter Color parameters, select the Luminaire, and then go to Modify panel to display the luminaire parameters.
2 Adjust the parameters.
The effect is visible in the viewport.

Character Assembly

A character assembly is a special type of group for objects particular to a character setup: the character mesh, bones, IK chains, helper objects, controllers, and other objects used to animate characters. Once the objects are grouped (assembled), you can perform various functions on the group as a whole, such as saving and loading animation for the entire bone/mesh set.
The objects that make up a typical character assembly

Unlike an ordinary group, there is no need to open a character assembly to work with its individual members.

When a character assembly is created, it is designated by a placeholder object called a *node*, placed near the bottom of the character assembly. Selecting the node gives access to special tools for working with character models and animation.
A character assembly will not create a character mesh or bone structure for you. The character assembly tool is designed for use on character structures that have already been set up using other tools.

Although the character assembly feature was designed for use with character structures, it will work equally well with any type of hierarchy or related set of objects.

**Adding Character Assembly Commands to the UI**

By default, the character-assembly commands described here are not part of the 3ds Max user interface. To add them, choose Customize menu > Customize User Interface, click the tab representing the part of the UI to which you'll add the commands (Keyboard, Toolbars, etc.) and then, from the Category drop-down list, choose Characters. Use standard CUI functionality on page 8249 to add the commands.

**TIP** To add a fully populated Character menu to the menu bar, on the Customize User Interface dialog, scroll the Menus list to Character, and then drag the Character item over to the Main Menu Bar list on the right side of the dialog.
Creating a Character Assembly

To create a character assembly, first select the objects that will make up the assembly. Next, you need to add any character-assembly commands you wish to use to the user interface; see Adding Character Assembly Commands to the UI on page 256. Last, choose the Create Character command.

All selected objects become members of the assembly, and the character assembly node is created. Other objects can be manually added to the assembly after it has been created.

Once the character assembly has been created, you can work with it in a variety of ways. For information about the Modify panel options available after a character assembly is created, see Create Character on page 274.

Linked Objects in Character Assemblies

Any or all members of the character assembly can be linked to a single object outside the assembly, but no more than one. For example, ThighLeft and ThighRight, which are both part of the assembly, can both be linked to Pelvis, which is not part of the assembly. However, if ThighLeft and ThighRight are each linked to different objects outside the assembly, the creation of the assembly will fail, and will show the following error message:

![Error Message]

A character assembly cannot be created since more than one object is parented to objects outside of current selection.

Error Nodes:
- ThighRight
- ThighLeft

Ok
Parameter Wiring and Animation

If you plan to wire parameters between two objects, create the assembly first and then set up the wiring. Be sure to include both objects in the assembly.

Because wiring should be done after the assembly is created, you will probably find it easiest to create the character assembly before animating the character.

See also:
- Create Character on page 274
- Destroy Character on page 278
- Lock/Unlock Character on page 279
- Save Character on page 279
- Insert Character on page 279
- Skin Pose Commands on page 280
- Merge Animation on page 4126

Group Commands

The commands to manage groups are on the Group menu on page 8005.

See also:
- Using Groups on page 243

Group

Group menu > Group
Scene Explorer on page 7888 > Highlight one or more entries. > Right-click a highlighted entry. > Groups > Group

The Group command combines a selection set of objects or groups into a single group.

Once you group objects, you can treat them as a single object in your scene. You can click any object in the group to select the group object. You can
transform the group as a single object, and you can apply modifiers as if it were a single object.

Groups can contain other groups, up to any level.

Group names are similar to object names, except that they’re carried by the group object. In lists like the one in the Selection Floater on page 209, group names appear in square brackets. For example: [Group01]. In Scene Explorer on page 7888 and related dialogs, the square brackets enclose the group object icon instead.

A group in Scene Explorer

If a group is selected, its name will appear in “bolded” text in the Name And Color rollout.

All members of a group inherit the visibility of the parent when a visibility controller is assigned to the parent.

Groups are considered whole objects in the Light Exclude/Include dialog, so you can exclude (or include) all objects in a group by selecting the group in the list. If a group is nested within another group, only the "outer" group is available in the list. To exclude only certain objects in a group, open the group before displaying the Exclude/Include dialog.

**Procedures**

**To define a group:**

1. Select two or more objects.
2. Choose Group menu > Group.
   
   A dialog appears requesting a name for the group.
3. Enter a name for the group and click OK.

**To define a nested group:**

1. Select two or more groups or any combination of groups and objects.
2. Choose Group > Group.
A dialog appears requesting a name for the group.

3 Enter a name for the new group object and click OK.

**Open**

Select one or more groups. > Group menu > Open

*Scene Explorer* on page 7888 > Right-click a group entry. > Groups > Open Group

The Open command lets you ungroup a group temporarily, and access objects within a group.

You can transform and modify the objects within the group independently from the rest of the group, then restore the original group using the Close command.

**Procedures**

**To open a group:**

1 Select one or more groups.

2 Choose Group > Open. A pink bounding box appears, and the objects in the group are now accessible.

**To open nested groups:**

1 Select the group within the opened group.

2 Choose Group > Open.

**Close**

Select the pink dummy object of an opened group. > Group menu > Close

*Scene Explorer* on page 7888 > Right-click a group entry. > Groups > Close Group

The Close command regroups an opened group. For nested groups, closing the outermost group object closes all open inner groups.

When you link an object to a closed group, the object becomes a child of the group parent rather than of any member of the group. The entire group flashes to show that you’ve linked to the group.
Procedures

To close all opened groups nested within a main group:
1 Select the pink bounding box representing the main group.
2 Choose Group > Close.

To close a nested group:
1 Select any object in the nested group or its dummy.
2 Choose Group > Close.

Ungroup

Select one or more groups. > Group menu > Ungroup

Scene Explorer on page 7888 > Right-click a group entry. > Groups > Ungroup

Ungroup separates the current group into its component objects or groups.
The Ungroup command ungroups one level, unlike Explode on page 261, which ungroups all levels of nested groups.
When you Ungroup a group, the objects within the group lose all group transforms that were applied on nonzero frames, but they retain any individual animation.
All ungrouped entities remain in the current selection set.

Procedures

To ungroup a group:
1 Select one or more groups.
2 Choose Group > Ungroup.
   All components of the group remain selected, but are no longer part of the group. The group dummy is deleted.

Explode

Select one or more groups. > Group menu > Explode
The Explode command ungroups all objects in a group, regardless of the number of nested groups, unlike Ungroup on page 261, which ungroups one level only.

As with the Ungroup command, all exploded entities remain in the current selection set.

**WARNING** Ungroup and Explode remove all transform animations that have been applied to the group as a whole. As with the Ungroup command, all exploded entities remain in the current selection set.

### Procedures

**To explode a group:**

1. Select one or more groups.
2. Choose Group > Explode.
   
   All objects in the groups remain selected but no longer belong to groups. All nested groups are exploded. All group dummies in the selection are deleted.

### Detach

Select a group. > Group menu > Open > Select one or more objects detach. > Group menu > Detach

Scene Explorer on page 7888 > Right-click a member of an open group. > Groups > Exclude From Group

The Detach (or, in Scene Explorer, Exclude From Group) command detaches the selected object from its group.

This command becomes available when you select a member of an open group.

### Procedures

**To detach an object from a group:**

1. Open the group.
2. Choose Group > Detach.
   
   The selected objects are now separate, independent objects, no longer members of the group.
**Attach**

Select one or more objects. > Group menu > Attach

The Attach command makes the selected object part of an existing group. With an object selected, choose this command, and then click a group in the scene.

**Procedures**

To attach an object to a group:

1. Select one or more objects to attach.
2. Choose Group > Attach.
3. Click any member of a closed group.
   The selected objects become part of the group, which is now selected.

**NOTE** To attach an object to an open group, click the pink bounding box.

---

**Assembly Commands**

The commands to manage assemblies are available from the Group > Assembly submenu.

**See also:**

- Using Assemblies on page 247

---

**Assemble**

Select the objects to assemble. > Group menu > Assembly > Assemble

The Assemble command combines a selection set of objects, assemblies, and/or groups into a single assembly, and adds a Luminaire helper object on page 271 as a head object on page 271.

Once you assemble objects, you can treat them as a single object in your scene. You can click any object in the group to select the entire assembly. You can...
transform the assembly as a single object, and you can apply modifiers as if it were a single object.

Assemblies can contain other assemblies and/or groups, up to any level.

Assembly names are similar to object names, except that they’re carried by the assembly. In lists like the one in the Selection Floater on page 209, assembly names appear in square brackets; for example: [Assembly01]. In Scene Explorer on page 7888 and related dialogs, the square brackets enclose the assembly object icon instead.

Each member of an assembly inherits the visibility of the parent when a visibility controller is assigned to the parent, providing its Object Properties > Rendering Control group > Inherit Visibility check box is turned on, or if its Rendering Control is set to By Layer and Inherit Visibility is turned on for its layer.

Assemblies are considered whole objects in the Light Exclude/Include dialog, so you can exclude (or include) all objects in an assembly by selecting the assembly in the list. If an assembly is nested within another assembly, only the "outer" assembly is available in the list. To exclude only certain objects in an assembly, open the assembly before displaying the Exclude/Include dialog.

See also:

- Using Assemblies on page 247

Procedures

To define an assembly:

1. Select two or more objects.

2. Choose Group menu > Assembly > Assemble.
   
   The Create Assembly dialog appears. It requests you to specify a name for the assembly and a head object on page 271. The default head object type is Luminaire on page 271.

3. Enter a name for the assembly, choose Luminaire on page 271 from the list, and click OK.
   
   The selected objects are assembled. The assembly head object position and orientation is determined as follows:

   - If there are multiple immediate children of the assembly head (for example, you’re assembling several non-hierarchical objects), the head
object is aligned with center of bottom face of the assembly bounding box.

- If there's only one immediate child of the assembly head, the assembly head pivot point is aligned with that object's pivot point. For example, if you're assembling a single hierarchy, the topmost object in the hierarchy would be the single immediate child of the assembly head.

To define a nested assembly:

1. Select two or more assemblies or any combination of assemblies and objects.
2. Choose Group menu > Assembly > Assemble. The Create Assembly dialog appears. It requests a name for the assembly, and a head object.
3. Enter a name for the new assembly object and click OK.

To wire a head object to a light source:

1. Create a hierarchy of lights and geometrical objects that models a lighting fixture. Sets up all the necessary IK chains and other constraints that make the model behave properly when the user interacts with it (orients, positions, aims, etc.).

   **IMPORTANT** For any photometric lights that you want to control with the head object, be sure to turn on the Multiplier check box on the Intensity/Color/Distribution rollout.

2. Select all objects in the fixture and define them as an assembly. When the assembly is selected, the luminaire parameters Dimmer and Filter Color appear in the Modify panel.
3. From the Animation menu, choose Wire Parameters > Parameter Wire Dialog.
4. The Parameter Wiring dialog appears.
5. On one side of the dialog, find the assembly and expand the branch titled Object (LuminaireHelper). Click the Dimmer item to highlight it.
6. On the other side, find the assembly and expand its hierarchy branch (click the + symbol in the square box). Find and expand the branch for
the light source, and then expand its Object branch. Click the Multiplier item to highlight it.

7 Between the two hierarchy lists, click the Control Direction arrow button that points from the selected Dimmer item to the selected Multiplier item.

8 If you're wiring a photometric light, skip this step. If you're wiring a standard light, or any light whose default Multiplier setting is 1.0, do this:

- The Expression box below the selected Multiplier item contains the word "Dimmer." Edit this to read "Dimmer/100". This divides the Dimmer value by 100, giving a 1:1 value ratio between it and the Multiplier setting.

9 Click the Connect button.

Now, when you change the luminaire’s Dimmer setting, the light source intensity changes as well.

10 If you like, use the same method to wire the luminaire to any additional light sources in the light fixture.

You can also use this method to wire the luminaire's Filter Color parameter to any light sources' color settings.
Interface

Name Specifies the name of the new assembly. The default name is "Assembly" followed by a two-place number starting with 01 and incremented by one for each new assembly.

Choose Head Object Lets you choose the type of object to serve as the assembly head object.

Open Assembly

Select one or more assemblies. > Group menu > Assembly > Open

The Open command lets you temporarily disassemble an assembly and access its head and member objects individually.
You can transform and modify the head and member objects within the assembly independently from the rest of the assembly, then restore the original assembly using the Close command on page 268.

Procedures

To open nested assemblies:

1. Select an assembly within the opened assembly.
2. Choose Group menu > Assembly > Open.

Close Assembly

Select the luminaire. > Group menu > Assembly > Close

The Close command reassembles an opened assembly. For nested assemblies, closing the outermost assembly object closes all open inner assemblies.

When you link an object to a closed assembly, the object becomes a child of the assembly parent rather than of any member of the assembly. The entire assembly flashes to show that you've linked to the assembly.

Procedures

To close all opened assemblies nested within a main assembly:

1. Select any object in the main assembly or its luminaire head object.

   **NOTE** If you select an object within an opened inner assembly, using Close will close only that assembly.

2. Choose Group menu > Assembly > Close.

To close a nested assembly:

1. Select any object in the nested assembly or its luminaire.
2. Choose Group menu > Assembly > Close.
Disassemble

Select one or more assemblies. > Group menu > Assembly > Disassemble

Disassemble separates the current assembly into its component objects or assemblies.

The Disassemble command separates one level, unlike Explode on page 269, which separates all levels of nested assemblies.

When you disassemble an assembly, all components of the assembly remain selected, but are no longer part of the assembly. Any transform animation applied to the assembly is lost, and objects remain as they were in the frame at which the dissolution is performed. However, objects retain any individual animation.

All disassembled entities remain in the current selection set.

**NOTE** If you have wired the luminaire head to any other parameters, those parameters are still controlled by the wiring setup after disassembly and are not adjustable until you apply a standard controller, such as Bezier Float. Use Track View to do this.

Explode Assembly

Select one or more assemblies. > Group menu > Assembly > Explode

The Explode command separates all objects in an assembly, regardless of the number of nested assemblies and/or groups, unlike Disassemble on page 269, which separates one level only.

When you explode an assembly, all components of the assembly remain selected, but are no longer part of the assembly. Any transform animation applied to the assembly is lost, and objects remain as they were in the frame at which the dissolution is performed. However, objects retain any individual animation.

**NOTE** If you have wired the luminaire head to any other parameters, those parameters are still controlled by the wiring setup after exploding and are not adjustable until you apply a standard controller, such as Bezier Float. Use Track View to do this.
**Detach Assembly**

Select an assembly. > Group menu > Assembly > Open > Select one or more objects to detach. > Assembly > Detach

Select one or more objects to detach in an open assembly. > Group menu > Assembly > Detach

The Detach command detaches the selected object from its assembly. If the object is a member of a nested assembly, after you detach it, it is no longer a member of any assembly.

This command becomes active when you open the assembly by choosing **Open** on page 267 from the Assembly menu.

**Attach Assembly**

Select one or more objects. > Group menu > Assembly > Attach

The Attach command makes the selected object part of an existing assembly.

With an object selected, choose this command, and then click either a closed assembly in the scene, or the head object of an open assembly.

**Procedures**

To attach an object to an assembly:

1. Select one or more objects to attach.
2. Choose Group menu > Assembly > Attach.
3. Click any member of an assembly.
   The selected objects become part of the assembly, which is now selected.

**Assembly Head Helper Objects**

Assembly head helper objects are for controlling the assembly.
**Assembly Head Helper Object**

When you create an assembly on page 247, 3ds Max automatically adds a special type of helper object called a head object, or assembly head. This object serves as the fulcrum of the assembly and also exposes parameters, available in the Modify panel when the assembly is selected, that you can wire to properties of objects inside the assembly. Thus, you can change and animate parameters of assembly member objects without having to open the assembly, as you would with a group.

**Luminaire Helper Object**

Create panel > Helpers > Assembly Heads > Object Type rollout > Luminaire

The Luminaire helper object serves primarily as a head, or control, object for light fixtures. When you assemble on page 263 a set of objects into a light fixture, you specify that a new luminaire object should be used as the assembly head object. The luminaire's parameters, available from the Modify panel, let you control the light sources in the fixture. See Using Assemblies on page 247 for more information.

You can also add a Luminaire object separately from the Create panel, but in general it's not necessary.
A luminaire object groups and manages the components as a whole.

**Interface**

When a selected assembly is closed, the Modify panel displays the Luminaire parameters. However, when you open an assembly, 3ds Max shows you the parameters of the whichever object is selected. The Luminaire object provides Dimmer and Filter Color parameters. You wire these to the light objects that are part of the assembly.
**Luminaire rollout**

**Dimmer** Emulates the dimmer switch of a real-world lighting fixture. The setting determines the percentage of the default light intensity is emitted by the light source of a lighting fixture. You wire this parameter to one or more light sources' Multiplier settings.

**Filter Color** An RGB color parameter that you link to a light source's color or filter color.

The Dimmer option can control the intensity of all the lights in the luminaire.
Character Assembly Commands

A character assembly is a special type of group for objects particular to a character setup: the character mesh, bones, IK chains, helper objects, controllers, and other objects used to animate characters. Once the objects are grouped (assembled), you can perform various functions on the group as a whole, such as saving and loading animation for the entire bone/mesh set.

By default, the character-assembly commands listed here are not part of the 3ds Max user interface. To add them, choose Customize menu > Customize User Interface, click the tab representing the part of the UI to which you’ll add the commands (Keyboard, Toolbars, etc.) and then, from the Category drop-down list, choose Characters. Use standard CUI functionality on page 8249 to add the commands.

TIP  To add a fully populated Character menu to the menu bar, on the Customize User Interface dialog, scroll the Menus list to Character, and then drag the Character item over to the Main Menu Bar list on the right side of the dialog.

See also:

- Merge Animation on page 4126

Create Character

See Adding Character Assembly Commands to the UI on page 256.

This command creates a character assembly on page 254.

See also:

- Destroy Character on page 278
- Lock/Unlock Character on page 279
- Save Character on page 279
- Merge Animation on page 4126
Procedures

To create a character assembly:

1. Create a linked structure of bones or other objects. The structure can have several chains. You can also use the linked structure with the Skin modifier, and/or set up character rigs and controllers as needed.

2. Select all objects that will become members of the assembly.

3. Use this method on page 256 to add the character-assembly commands to the user interface, and then choose the Create Character command. The character-assembly node is created at the bottom of the entire selection, as viewed in the Front viewport.

4. On the Modify panel, use the character assembly tools to work with the character structure.

The character assembly is given the default name of Character01, which can be changed. All members of the assembly are listed in the Character Members rollout.
Interface

To work with the character assembly, select the character assembly node and work with the parameters on the Modify panel.

Character Assembly rollout

![Character Assembly rollout]

Skin Pose group

The *Skin pose* is the bone structure pose used by the Skin modifier for associating bones with the mesh. When the Skin modifier is first applied, the
current bone structure pose is used as the Skin pose. The Skin pose can sometimes be accidentally altered by animating the bone structure on frame 0. If this occurs, you can use these options to fix the Skin pose.

You can use these options both before and after applying the Skin modifier. You can also invoke these options when any member of the character assembly is selected.

**Set as Skin Pose** Sets the Skin pose to the current bone structure's pose. The Skin modifier's envelopes and vertex weighting are automatically recalculated to work with the new pose.

**Assume Skin Pose** Causes the bone structure to take on the Skin pose. This feature can be useful during the animation phase. For example, if you have animated the character on various keyframes and want the character to animate back to its Skin pose at frame 50, you can turn on Auto Key at frame 50 and click Assume Skin Pose.

**Skin Pose Mode** Poses the character in its Skin pose and allows the Skin pose to be refined. Changes to the bone structure when Skin Pose Mode is on will affect only the Skin pose and not the animation. When Skin Pose Mode is turned off, the bone structure returns to its pose at the current frame.

**Display group**

When a high resolution character model is animated, redraw time can slow the animation process. To speed up your work, a low resolution version of the model can be used for the animation process, then switched for the full resolution version at render time. Character assembly objects can be designated as Full Res or Low Res on the Character Members rollout.

**Low Res Objects** Displays only the objects checked in the Low Res display in the Character Members rollout.

**Full Res Objects** Displays only the objects not checked in the Low Res display in the Character Members rollout.

**All Objects** Displays all objects in the character assembly.

**Animation group**

Animation for the character assembly can be saved or reset in this group. Previously saved animation from another character can also be inserted to the current character assembly.

**Insert Animation** Displays the Merge Animation dialog on page 4126, and prompts for a previously saved animation file.
**Save Animation** Saves the character assembly animation in an ANM or XML file. Both file types contain the character assembly and its animation. An ANM file is a proprietary format that can be read and saved only by 3ds Max. An XML file formats the information as XML code, and can be edited with a text editor.

Animation saved as an ANM file loads and saves faster than an XML file. Saving and editing an XML animation file is recommended only for users who are familiar with the XML language, and who have a specific need for editing the file.

**Reset All Animation** Removes all animation from the character assembly.

**Character Members rollout**

**Add** Allows you to select individual objects to add to the character assembly.

**Add List** Displays the Pick Character Members dialog, where you can select multiple objects from a list and add them to the character assembly.

**Remove** Removes highlighted object(s) from the assembly. Bones and objects upon which other assembly objects depend, cannot be removed.

**Low Res** All members of the character assembly are displayed on this list. By default, all members are designated as Full Res objects. To designate a member as Low Res, check the object on the list. The Full Res and Low Res designations are used in conjunction with the Display group selection in the Character Assembly rollout.

**Destroy Character**

See Adding Character Assembly Commands to the UI on page 256.

Destroying a character deletes the character assembly node.

This command is available only when a character assembly node is selected.

See also:

- **Character Assembly** on page 254
- **Lock/Unlock Character** on page 279
Lock/Unlock Character

See Adding Character Assembly Commands to the UI on page 256.

Locking a character assembly prevents the character from being animated. Use these commands when you want to prevent accidental animation of the character, such as when the animation process is complete.

Unlocking a locked character assembly allows you to animate the character. These commands are available only when a character-assembly node is selected.

See also:

■ Character Assembly on page 254

Insert Character

See Adding Character Assembly Commands to the UI on page 256.

Choose this command to insert a previously saved character into the current scene.

You save a character assembly as a CHR file with Save Character on page 279. A CHR file contains the character assembly node, all members of the assembly and any animation on the members.

When a character is inserted into the scene, it is placed at the same world-space location it had when saved.

See also:

■ Character Assembly on page 254
■ Save Character on page 279

Save Character

See Adding Character Assembly Commands to the UI on page 256.

Saving a character saves a character assembly on page 254 at its current location, including its node, all members, and any animation on its members. Use this
command for storing a character assembly to disk prior to inserting it into another scene.

Saving a character with this command saves the assembly as a CHR file. You can then insert the CHR file into a scene with Insert Character on page 279. This option is available only when a character assembly node is selected.

**Skin Pose Commands**

Animation menu > Set as Skin Pose

Animation menu > Assume Skin Pose

Animation menu > Skin Pose Mode

When the Skin modifier is first applied to a mesh, the bone structure's current pose is used as the skin pose. Subsequent animation of the bone structure on frame 0 can cause the skin pose to be altered. The skin pose commands allow you to change and set the skin pose either before or after you apply the Skin modifier.

The skin pose stores a specific position, rotation and scale for an object. Its intended use is for storing a character assembly's pose for the Skin modifier. However, a skin pose can be used for any object to store its current transforms for later retrieval.

These commands work on any object, regardless of whether the structure is part of a character assembly, or whether the bones have been assigned to a mesh with the Skin modifier.

**Set as Skin Pose** Stores the selected objects' current position, rotation and scale as the skin pose. If the selected objects are assigned as bones for the Skin modifier, the envelopes and vertex weighting are automatically recalculated to work with the new pose.

**Assume Skin Pose** Causes the selected objects to take on the stored skin pose. This feature can be useful during the animation phase. For example, if you have animated the character on various keyframes and want the character to animate back to its skin pose at frame 50, you can turn on Auto Key at frame 50 and click Assume Skin Pose.

**Skin Pose Mode** Poses the character in its skin pose and allows the skin pose to be refined. Changes to the objects when Skin Pose Mode is on will affect only the skin pose and not the animation. When Skin Pose Mode is turned off, the structure returns to its pose at the current frame.
See also:

- Character Assembly on page 254
The Object Properties dialog, available from the Edit and right-click menus, lets you view and edit parameters for how selected objects behave in viewports and renderings. Note that you cannot necessarily edit all properties; parameters that apply to renderable geometry are unavailable for non-renderable objects. However, parameters that apply to any object, such as Hide/Unhide, Freeze/Unfreeze, Trajectory, and so on, remain available for these non-renderable objects.

With the Object Properties dialog you can specify settings per object or by layer on page 8530. Object settings affect only the object or objects selected. When an object is set to By Layer, it inherits its properties from the layer settings, which you set with the Layer Properties dialog on page 7966.

The Object Properties dialog panels are:

- General Panel (Object Properties Dialog) on page 283
- Advanced Lighting Panel (Object Properties Dialog) on page 295
- mental ray Panel (Object Properties Dialog) on page 300
- User Defined Panel (Object Properties Dialog) on page 303

Object Properties Dialog Panels

The Object Properties dialog has four panels for managing properties.

General Panel (Object Properties Dialog)

Edit menu > Object Properties > Object Properties dialog > General panel
Select object or objects. > Right-click. > Transform (lower-right) quadrant of the quad menu > Object Properties > Object Properties dialog > General panel
Layer manager > Click the icon next to an object's name. > Object Properties dialog > General panel
This panel of the Object Properties dialog displays general object information, as well as controls for rendering the object and displaying it in viewports.
Interface
Object Information group

This group displays information about the selected object, including the following:

**Name** Shows the name of the object. When a single object is selected, you can edit this field to give the object a new name. When multiple objects are selected, this field shows "Multiple Selected," and cannot be edited.

**Color** The color swatch shows the object's color. You can click it to display the Object Color dialog on page 368 and select a different color.

**Dimensions** Displays the X, Y, and Z dimensions of the object's extents on page 8567.

**Vertices and Faces** Display the number of vertices and faces in the object. For shapes on page 572, these values are the values used if you have made the shape renderable. Faces for renderable shapes are generated only at rendering time.

**Shape Vertices and Shape Curves** Appear only for shape objects. Shape Vertices is the number of vertices in the shape, and Shape Curves is the number of polygons. (Shape Curves is the value that appeared as "Polygons" in previous releases.)

These values can change over time: they are valid only for the current frame and the current view.

**Parent** Displays the name of the object's parent in a hierarchy. Shows "Scene Root" if the object has no hierarchical parent.

**Material Name** Displays the name of the material assigned to the object. Displays "None" if no material is assigned.

**Num. Children** Displays the number of children hierarchically linked to the object.

**In Group/Assembly** Displays the name of the group or assembly to which the object belongs. Displays "None" if the object is not part of a group.

**Layer** Displays the name of the layer which the object is assigned to.

Interactivity Group

**Hide** Hides the selected object or objects. Hidden objects exist in the scene, but do not appear in the viewports or rendered images. To unhide hidden objects, use the Display panel on page 8217 or choose Tools > Display Floater on page 8218.
NOTE Objects residing on a hidden layer are automatically hidden, regardless of this setting.

TIP The Layer Manager on page 7956 is the easiest way to hide groups of objects or layers.

Freeze Freezes the selected object or objects. Frozen objects appear in the viewports, but cannot be manipulated. To unfreeze frozen objects, use the Display panel on page 8217 or choose Tools > Display Floater on page 8218.

NOTE Objects residing on a frozen layer are automatically frozen, regardless of this setting.

TIP The Layer Manager on page 7956 is the easiest way to freeze groups of objects or layers.

Display Properties group

NOTE Most of these options are also available on the Display panel on page 8217 and by choosing Tools > Display Floater on page 8218.

By Object/By Layer Toggles between setting display properties on a per-object basis and at the layer level. When set to By Layer, the object display properties are unavailable; set the layer properties on the Layer Properties dialog on page 7966.

NOTE If multiple objects are selected and have different values for this setting, this button reads “Mixed.”

See-Through Makes the object or selection translucent in viewports. This setting has no effect on rendering: it simply lets you see what is behind an object in a crowded scene, and especially to adjust the position of objects behind the see-through object. Default=off.

You can customize the color of see-through objects by using the Colors panel on page 8272 of the Customize > Customize User Interface dialog on page 8249.

Keyboard shortcut (default): Alt+X
**Display as Box** Toggles the display of selected objects, both 3D objects and 2D shapes, as *bounding boxes* on page 8528. Produces minimum geometric complexity for rapid display in viewports. Default=off.

**Backface Cull** Toggles the display of faces with *normals* on page 8654 that point away from the view. When on, you see through the wireframe to the backfaces. Applies only to wireframe viewports. Default=off.

**Edges Only** Toggles the display of hidden edges and polygon *diagonals* on page 8551. When on, only outside edges appear. When off, all mesh geometry
appears. Applies to Wireframe viewport display mode, as well as other modes with Edged Faces turned on.

**NOTE** This option is also available in the Display panel on page 8217 and by choosing Tools > Display Floater on page 8218.

**Vertex Ticks** Displays the object's vertices as tick marks. Default=off.

**Trajectory** Displays the object's trajectory on page 8746. Default=off.
Ignore Extents When on, this object is ignored when you use the display controls Zoom Extents on page 8144 and Zoom Extents All on page 8138. Keyboard shortcut: No default, but you can customize it using the Keyboard panel on page 8250 of the Customize > Customize User Interface dialog on page 8249.

Show Frozen in Gray When on, the object turns gray in viewports when you freeze it. When off, viewports display the object with its usual color or texture even when it is frozen. Default=on.

Never Degrade When on, the object is not subject to adaptive degradation on page 8498.

Vertex Channel Display For editable mesh on page 2192, editable poly on page 2240, and editable patch on page 2360 objects, displays the assigned vertex colors in viewports. The drop-down list lets you choose to display Vertex Color, Vertex Illumination, Vertex Alpha, Map Channel Color, or Soft Selection Color. Default=off.

You can assign vertex colors at all sub-object levels except Edge.

Map Channel Sets the map channel for the vertex color. Available only when the Map Channel Color option is active.

Shaded When on, shaded viewports add shading to the vertex coloring. When off, colors are unshaded. Default=off.

Rendering Control group

By Object/By Layer Toggles between setting rendering controls on a per-object basis and at the layer level. When set to By Layer, the object rendering control settings are unavailable; set the layer properties on the Layer Properties dialog on page 7966.

NOTE If multiple objects are selected and have different values for this setting, this button reads “Mixed.”
Visibility** Controls the rendered visibility of the object. At 1.0, the object is fully visible. At 0.0, the object is completely invisible when rendered. Default=1.0.

You can animate this parameter. Animating Visibility assigns a visibility controller to the object. By default this is a Bezier float controller on page 3432.

**Renderable** Makes an object or selected objects appear or disappear from rendered output. Nonrenderable objects don’t cast shadows or affect the visual component of the rendered scene. Like dummy objects, nonrenderable objects can manipulate other objects in the scene.

For lights, this is the only available control in the Rendering Controls group. Making a light non-renderable effectively turns it off.

**Shape** on page 572 objects have the Renderable option turned on by default. In addition, each shape has an Enable In Renderer parameter. When both check boxes are on, the shape appears in rendered output. If the Renderable object properties setting is off, the shape is not renderable, regardless of the state of its local Enable In Renderer check box.

If you apply a modifier that converts the shape into a mesh object, such as a Lathe modifier on page 1474 or Extrude modifier on page 1425, the shape automatically becomes renderable regardless of the state of its local Enable In Renderer setting.

**Inherit Visibility** Causes the object to inherit a percentage of the visibility of its parent (as determined by the parent’s Visibility track in Track View). When a group parent is assigned a visibility track, Inherit Visibility is automatically turned on for all children in the group. The children will have the maximum visibility of the parent. Transparent materials and hidden objects have no effect on this function.

**Visible to Camera** When on, the object is visible to cameras in the scene. When off, cameras do not view this object; however, its shadows and reflections are rendered. Default=on.

**Visible to Reflection/Refraction** When on, the object has “secondary” visibility: it appears in rendered reflections and refractions. When off, the object does not appear in rendered reflections or refractions. Default=on.

**NOTE** An object can have Visible To Camera on but Visible To Reflection/Refraction off, in which case the object renders in the scene but does not appear in reflections or refractions.

**Receive Shadows** When on, the object can receive shadows. Default=on.

**Cast Shadows** When on, the object can cast shadows. Default=on.
Apply Atmospherics  When on, atmospheric effects are applied to the object. When off, atmospheric effects do not change the rendered appearance of this object. Default=on.

Render Occluded Objects  Allows special effects to affect objects in the scene that are occluded by this object. The special effects, typically applied by plug-ins on page 8687 such as Glow on page 7073, use G-buffer on page 8589 layers to access occluded objects. Turning on this control makes the object transparent for the purposes of special effects. This makes no difference when you render to most image files. When you render to either the RLA on page 7873 or RPF on page 7875 file format, however, occluded objects appear with the effect applied on their designated G-buffer layer. Default=off.

G-Buffer group

Allows you to tag an object as a target for a render effect on page 7057 based on the G-buffer on page 8589 channel. Assigning the object a nonzero ID creates a G-buffer channel that can be associated with a render effect.

The Object ID property is also used with the Multi/Sub-Map shader on page 6414, and can be displayed in the Rendered Frame Window when rendering to RLA on page 7873 and RPF on page 7875 formats.

WARNING  The mental ray renderer on page 6675 does not recognize Z-depth with G-buffers. G-buffer data is saved on a single layer. Also, the mental ray renderer does not support the following effects:

- Glow lens effect on page 7073 (rendering effect)
- Ring lens effect on page 7080 (rendering effect)
- Lens effects Focus filter on page 7339 (Video Post)

Object ID  Setting Object ID to a nonzero value means that the object will receive the rendering effects associated with that channel in Render Effects and the post-processing effects associated with that channel in Video Post. To save the channel data with the rendering, render to either the RLA on page 7873 or RPF on page 7875 file format.

Motion Blur group

By Object/By Layer  Toggles between setting motion blur properties on a per-object basis and at the layer level. When set to By Layer, the motion blur settings are unavailable; set the layer properties on the Layer Properties dialog on page 7966.
If multiple objects are selected and have different values for this setting, this button reads “Mixed.”

**Multiplier** Affects the length of the motion-blur streak.

If you choose either form of motion blur here in the Object Properties dialog, you must also choose to apply that type of blur in the Render Setup dialog on page 6506.

The rendering speed of object motion blur depends on the complexity of the geometry to which it’s assigned. The rendering speed of image motion blur depends on the amount of rendered screen space taken up by the blurring object. In most cases image motion blur renders more quickly. Object motion blur renders more quickly when applied to very simple objects, and image motion blur renders more slowly when the object takes up a lot of screen space, and moves all the way across the screen in a single frame.

**Changing the Object Blur Multiplier value.**

**Enabled** When on, enables motion blur for this object. When off, motion blur is disabled regardless of the other blur settings. Default=on.

You can animate the Enabled check box. The main use of animating Enable is to apply motion blur over only a limited range of frames. This can save a tremendous amount of time when you are rendering an animation.

You can enable motion blur for lights and cameras. With the mental ray renderer, moving lights and cameras can generate motion blur. However, they do not generate motion blur with the default scanline renderer.

**None** Turns off the state of motion blur for the object.
- **Object**  
  Object motion blur on page 8658 provides a time-slice blur effect.

- **Image**  
  Image motion blur on page 8606 blurs the object's image based on the velocity of each pixel.

**Advanced Lighting Panel (Object Properties Dialog)**

Select object or objects. > Edit menu > Object Properties > Object Properties dialog > Advanced Lighting panel

Select object or objects. > Right-click. > Transform (lower-right) quadrant of the quad menu > Object Properties > Object Properties dialog > Advanced Lighting panel

Layer manager > Click the icon next to an object's name. > Object Properties dialog > Advanced Lighting panel

This panel of the Object Properties dialog lets you customize how objects behave under advanced lighting (the Light Tracer on page 6601 or radiosity on page 6615).
Chapter 5  Object Properties

Interface

**Adv. Lighting**

<table>
<thead>
<tr>
<th>Selection Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Num. Geometric Objects: 1</td>
</tr>
</tbody>
</table>

**Geometric Object Radiosity Properties**

- **Exclude from Adv. Lighting Calculations**
- **By Layer**
- **Adv. Lighting General Properties**
  - **Cast Shadows**
  - **Receive Illumination**
  - Num. Regathering Rays Multiplier: 1.0
- **Radiosity-only Properties**
  - **Diffuse (reflective & translucent)**
  - **Specular (transparent)**
  - **Exclude from Regathering**
- **Object Subdivision Properties**
  - **Use Global Subdivision Settings**
  - **Subdivide**
  - **Use Adaptive Subdivision**
- **Mesh Settings**
  - **Max Mesh Size**: 33.37
  - **Contrast Threshold**: 75.0
  - **Min Mesh Size**: 3.937
  - **Initial Mesh Size**: 78.74
  - **Radiosity Refine Iterations**: 0
  - **Iterations Done**: 0

**Light Object Radiosity Properties**

- **Exclude from Radiosity Processing**
- **Mixed**
- **Store Direct Illumination in Mesh**
Selection Information rollout

Num. Geometric Objects The number of geometric objects present in the current selection.

Num. Light Objects The number of lights present in the current selection.

Geometric Object Radiosity Properties rollout

Exclude from Adv. Lighting Calculations When on, the current selection is excluded from advanced lighting (radiosity or light tracing). Objects excluded from advanced lighting will not contribute to indirect illumination.

By Object/By Layer Toggles between object settings and object layer settings. Object settings affect only the object or objects selected. Object layer settings affect all objects on the same layer as the selected object. Most settings on this rollout are available only when this toggle is set to By Object. Default=By Object.

NOTE If multiple objects with different settings are selected, this button will read “Mixed.”

Adv. Lighting General Properties group

Cast Shadows Determines whether objects will cast shadows in the radiosity solution.

NOTE When disabling Cast Shadows, you should also turn off Diffuse (reflective & translucent) and Specular (transparent) in the Radiosity-only Properties group. If these switches are left turned on, objects will still generate light that can produce artifacts in the solution.

Receive Illumination Determines whether objects will receive indirect illumination.

Num. Regathering Rays Multiplier Lets you adjust the number of rays cast by this object, per pixel. If an object looks “blotchy” after rendering, Increasing this value can improve its appearance. Default=1.0.

TIP Increasing this setting is most useful for objects with large, smooth surfaces. More complex geometry tends not to show advanced lighting artifacts as much as smooth surfaces do.
Radiosity-only Properties group

Diffuse (reflective & translucent) When on, the radiosity solution will process diffuse reflection and translucency on page 8751 of the selected objects.

Specular (transparent) When on, radiosity will process transparency of the selected objects.

Exclude from Regathering When on, objects are excluded from the regathering process when rendering.

For more information on the Radiosity-only Properties group, see Radiosity Control Panel on page 6634.

Object Subdivision Properties group

Use Global Subdivision Settings When on, the object’s meshing settings correspond to the global subdivision settings on the Radiosity Control Panel. When off, you can change the meshing settings for each object. Default=on.

Subdivide When on, a radiosity mesh is created for the objects regardless of the global meshing state. The subdivision that is performed is determined by the Use Adaptive Subdivision switch. When off, the settings in the Mesh Settings group are unavailable. Default=on.

Use Adaptive Subdivision Toggles adaptive subdivision. Default=on.

TIP Adaptive meshing is computed for an object only if Shoot Direct Lights is turned on in the Radiosity Meshing Parameters rollout on page 6645.

NOTE The Mesh Settings group parameters Contrast Threshold, Min Mesh Size, and Initial Mesh Size are available only when Use Adaptive Subdivision is turned on.

Mesh Settings group

Max Mesh Size The size of the largest faces after adaptive subdivision. Default=36” for imperial units and 100cm for metric units.

When Use Adaptive Subdivision is off, Max Mesh Size sets the size of the radiosity mesh in world units.

Min Mesh Size Faces are not divided smaller than the minimum mesh size. Default=3 inches for Imperial units and 10cm for metric units.

Contrast Threshold Faces that have vertex illuminations that differ by more than the Contrast Threshold setting are subdivided. Default=75.0.
Initial Mesh Size When improving the face shape, faces that are smaller than the Initial Mesh Size are not subdivided. The threshold for deciding whether a face is poorly shaped also gets larger as the face size is closer to the Initial Mesh Size. Default=12 inches for Imperial units and 30cm for metric units.

Radiosity Refine Iterations The number of refine iterations in the radiosity process for the current selection.

Iterations Done The number of refine iterations performed on the current selection.

Light Object Radiosity Properties rollout

These options are available only for light objects.

Exclude from Radiosity Processing When on, the current selection is excluded from the radiosity solution. When lights are excluded from radiosity, their direct contribution is only used for rendering. This option is available only when By Object is selected.

By Object/By Layer Toggles between object settings or object layer settings. Object settings affect only the object or objects selected. Object layer settings affect all objects on the same layer as the selected object.

NOTE If multiple objects are selected and have different settings, this button reads “Mixed.”

Store Direct Illumination in Mesh When on, the light’s direct illumination is added to the radiosity mesh, even if the global rendering mode is Render Direct Illumination. This is comparable to the Re-Use Direct Illumination option when rendering radiosity, but only for this particular light.

When off, the light’s direct illumination is used only when you render the scene. This is comparable to the Render Direct Illumination option.

for more information about the Re-Use Direct Illumination and Render Direct Illumination options, see Rendering Parameters Rollout (Radiosity) on page 6653. In general, re-using direct illumination stored in the radiosity mesh improves render time, but shadows appear coarse and inaccurate unless the mesh is very fine. Rendering direct illumination and shadows (using the radiosity mesh to provide only indirect light) takes more time but gives you a more finished and accurate image.
mental ray Panel (Object Properties Dialog)

Edit menu > Object Properties > Object Properties dialog > mental ray panel

Select object or objects. > Right-click. > Transform (lower-right) quadrant of the quad menu > Object Properties > Object Properties dialog > mental ray panel

Layer manager > Click the icon next to an object's name. > Object Properties dialog > mental ray panel

This panel of the Object Properties dialog supports mental ray rendering; specifically, the indirect illumination features caustics on page 6700 and global illumination on page 6706. They control whether objects generate or receive caustics or global illumination.

These settings are ignored where they aren't appropriate. For example, lights can be set to generate caustics, but for a light, the Receive Caustics setting has no effect, as lights aren't renderable. Similarly, these settings have no meaning for cameras.

Also available on this panel are controls for setting displacement parameters on a per-object basis.

TIP Most of these settings, as well as additional rendering-related settings, are also available on the quad menu that opens when you Alt+Ctrl+right-click a selected object.
**Interface**

The mental ray panel contains object properties for the mental ray renderer.

**Final Gather group**

These settings let you specify how an object interacts with the final gather process.

**When Object is Hit by a Final Gather Ray**

- **Return Object Color (Physically Correct)** Returns the object’s material color at the point that the final gather ray intersects it, and contributes to final gather illumination. This is the default mode.
■ **Return Black**  Blocks final gather rays, returning no color, thus not shading the object at all.

■ **Pass through (Invisible to FG)**  Prevents the final gather process from seeing the object during ray casting. This is useful for ignoring the light contribution from small, complex objects like blades of grass. The final gather rays pass through and strike the underlying object, such as a ground plane that is easier to shade.

**Receive Illumination from Final Gather**  When on, the object is subject to illumination from final gather rays. When off, the object is not illuminated by final gather rays. Default=on.

### Caustics and Illumination group

These settings determine whether and how the object participates in the simulation of caustics and global illumination (photons). To use these capabilities, the respective check boxes must also be enabled on the Render Setup dialog’s Caustics And Global Illumination rollout on page 6771.

**Exclude from Caustics**  When on, the object does not participate in the caustics solution. When off, the additional caustics-related object properties are available. Default=off.

**Generate Caustics**  When on, the object can generate caustics. When off, the object does not generate caustics. Default=off.

**Receive Caustics**  When on, the object can receive caustics. That is, caustic effects are cast onto this object. When off, the object does not receive caustics. Default=on.

**Exclude from GI**  When on, the object does not participate in the global-illumination solution. When off, the additional global-illumination-related object properties are available. Default=off.

**Generate Global Illumination**  When on, the object can generate global illumination. When off, the object does not generate global illumination. Default=off.

**Receive Global Illumination**  When on, the object can receive global illumination. That is, reflected light is cast onto this object. When off, the object does not receive global illumination. Default=on.

### Displacement group

These settings let you apply displacement parameters on a per-object basis.
Use Global Settings When on, applies to all objects the Displacement settings on the Render Setup dialog > Renderer panel > Shadows and Displacement rollout on page 6756. Turn off to make settings on a per-object basis. Default=on.

View-Dependent defines the space for displacement. When View-Dependent is on, the Edge Length setting specifies the length in pixels. When off, Edge Length is specified in world-space units. Default=on.

Smoothing Turn off to have the mental ray renderer correctly render height maps. Height maps can be generated by normal mapping; see Creating and Using Normal Bump Maps on page 6856.

When on, mental ray simply smoothes the geometry using the interpolated normals, making the geometry look better. This result, however, cannot be used for height map displacement because smoothing affects geometry in a way that is incompatible with height mapping.

Edge Length Defines the smallest allowable edge length. The mental ray renderer will stop subdividing an edge once it reaches this size. Default=2.0 pixels.

Max. Displace Controls the maximum offset, in world units, that can be given to a vertex when displacing it. This value can affect the bounding box of an object. Default=20.0.

TIP If displaced geometry appears to be “clipped,” try increasing the value of Maximum Displace.

NOTE When using placeholders (see the Translator Options rollout on page 6787), if this value is larger than it needs to be, it can reduce performance. If you experience slow times while displaced objects when Use Placeholder Objects is on, try lowering the Max. Displace value.

Max. Level Controls how many times a triangle can be subdivided. Default=6.

User Defined Panel (Object Properties Dialog)

Edit menu > Object Properties > Object Properties dialog > User Defined panel

Select object or objects. > Right-click. > Transform (lower-right) quadrant of the quad menu > Object Properties > Object Properties dialog > User Defined panel

Layer manager > Click the icon next to an object’s name. > Object Properties dialog > User Defined panel

User Defined Panel (Object Properties Dialog) | 303
This panel of the Object Properties dialog lets you enter properties or comments that you define yourself.
Interface

User Defined Panel (Object Properties Dialog)
**User Defined Properties** In this text box, you can enter properties for the object, or comments about it, that you define yourself. 3ds Max doesn't use these properties, but it saves them with the scene, and they reappear whenever you view the Object Properties dialog for the object.

**Rename Objects Tool**

Tools menu > Rename Objects

The Rename Objects tool helps you rename several objects at once.

**Interface**

![Rename Objects interface](image)

- **Selected** or **Pick**
- **Base Name**: 
- **Prefix**: 
- **Remove First**: 
- **Suffix**: 
- **Remove Last**: 
- **Numbered**: 
  - **Base Number**: 
  - **Step**: 

  Rename
Selected When chosen, renaming affects currently selected objects.

Pick Click to open the Pick Objects To Rename dialog, which lets you choose the objects to rename. This dialog has the same controls as Select From Scene on page 206.

Base Name Enter a base name for all objects. The toggle enables or disables this name.

Prefix When on, lets you enter a string that will be a prefix to the name of all renamed objects.

Remove First N Digits When on, the first N characters in the base name are removed from object names. The spinner sets the value of N.

Suffix When on, lets you enter a string that will be a suffix to the name of all renamed objects.

Remove Last N Digits When on, the last N characters in the base name are removed from object names. The spinner sets the value of N.

Numbered When on, lets you number object names incrementally.

- **Base Number** The base number appended to the name of the first renamed object.

- **Step** The step by which the base number is incremented in succeeding renamed objects.

Rename Click to rename the affected objects and have your changes take effect.

### Custom Attributes

Animation menu > Parameter Editor

Keyboard > Alt+1

Use the Parameter Editor to assign custom attributes to objects, modifiers, materials, and animation tracks. A custom attribute is an additional, abstract parameter; abstract in the sense that it does not directly extend the functionality of the object by default. It affects an object only after wire parameters on page 3610, reaction controllers on page 3527, or expression controllers on page 3456 are set up to connect the custom attribute to another parameter in the scene. You can also use custom attributes to store job-specific notes and data.
Custom attributes behave like other object parameters in several ways:

- They are saved and loaded in the scene file along with the object.
- They can be animated and keyframed.
- They are displayed in Track View along with the base parameters.

Each custom attribute parameter can be one of a number of different data types, including integers, floating numbers, Booleans, arrays, nodes, colors, and texture maps. Parameters added to an object or modifier appear on a Custom Attributes rollout on the Modify panel. For each custom attribute parameter you create, you can specify the name, layout, value range, default value, and UI type: spinner or slider for floats and integers, check box for Booleans, etc.

As you customize an attribute, the result is displayed on the Testing Attribute rollout at the bottom of the dialog.

See also:
- Parameter Collector on page 325
- Attribute Holder Modifier on page 1163

Custom Attributes Special Features

The Custom Attributes feature offers an array of workflow-enhancing functionality, including:

- the ability to add custom attributes to specific animation tracks.
- the ability to edit existing custom attributes.
- 13 available data types.
- a variety of available UI options, such as ComboBox and ListBox for the Array data type.
- the ability to position UI elements precisely with X and Y Offset controls.
- the ability to preserve custom attributes on page 8205 when collapsing the stack.
- A special Attribute Holder modifier on page 1163 that lets you collect attributes from different entities and access them in one place on the Modify panel.
Procedures

To add a parameter to an object:

1. Select the object.
2. Choose Animation menu > Parameter Editor.
   The Parameter Editor opens.
3. Change settings as desired.
4. Click Add.
   The parameter is added to the level specified in the Add To Type list. If an object has no custom attributes, Parameter Editor first adds a Custom Attributes entry to the current Add To Type level, and then adds the parameter to the Custom Attributes entry. If an object has more than one Custom Attributes entry as a result of collapsing its stack, the parameter is added to the first Custom Attributes entry.
   If a custom attribute parameter is assigned to an object or modifier, you can see and edit its value on the Modify panel after adding it by activating the entity to which the attribute is assigned. If the custom attribute is assigned to a material, it’s available for that material in the Material Editor, on the Custom Attributes rollout. To access a parameter that’s assigned to an animation track, open Track View, highlight the track's Custom Attributes entry, and then right-click and choose View Attribute Dialog.

To edit a parameter or custom attribute:

1. Select the object.
2. Choose Animation menu > Parameter Editor.
   The Parameter Editor opens.
310 | Chapter 5  Object Properties

3. From the Add To Type drop-down list, choose the type of parameter to edit, and then click Edit/Delete. The Edit Attributes/Parameters dialog opens.
NOTE: If you chose Add To Type > Picked Track, the Track View Pick dialog might open first to prompt you to choose the animation track whose attribute to edit.

4. In the Edit Attributes/Parameters dialog, highlight the parameter to edit. Its settings appear in the Parameter Editor.

5. Change the settings in the Parameter editor, and then click Accept Parameter changes.

6. With multiple parameters or custom attributes, to change the ordering, click the entity to move, and then use the up and down arrow buttons to move the entity in the list. Moving a Custom Attributes entry also moves its parameters.

NOTE: You cannot rename a Custom Attributes entry.
7 When finished editing, click Apply Changes, and then exit the dialog by clicking the Close or Cancel button.

To delete a custom attribute or parameter:

1 Select the object.

2 Choose Animation menu > Parameter Editor. The Parameter Editor opens.

3 From the Add To Type drop-down list, choose the type of parameter to delete, and then click Edit/Delete. The Edit Attributes/Parameters dialog opens.

   **NOTE** If you chose Add To Type > Picked Track, the Track View Pick dialog might open first to prompt you to choose the animation track from which to delete the attribute.

4 In the Edit Attributes/Parameters dialog, highlight the parameter to delete, and then click Delete Parameter. Alternatively, to delete all parameters under the same Custom Attributes heading as the highlighted parameter, click Delete All Parameters.

   To delete one or more custom attributes instead, click a Custom Attributes heading, and then click Delete Attribute or Delete All Attributes. Multiple attributes can result from collapsing an object’s stack with Preserve Custom Attributes on. For example, one set of custom attributes might be applied to an object and a second set of attributes assigned to one of its modifiers. Collapsing such an object results in two sets of custom attributes.

5 Click Apply Changes, and then close the dialog by clicking its Close box or the Cancel button.

**Interface**

The Parameter Editor takes the form of a dialog with several rollouts: The first rollout sets general options for the attribute; the central rollout sets options for the current parameter type; and the third lets you preview the attribute user interface (UI).
Add to Type group

Add to Type list Choose whether the custom attribute is assigned to the selected object, its active modifier (as highlighted in the modifier stack), its
material, or a picked track. Also use this drop-down list to choose the attribute type to delete or edit.

If the text “Pick Explicit Track” appears in the box below the drop-down list before you choose Picked Track, the Track View Pick dialog appears showing the Track View hierarchy. Expand the hierarchy as necessary, click the track to add the attribute to, and then click OK.

**NOTE** If you choose Selected Object’s Current Modifier and multiple modifiers are highlighted in the stack when you click Add, Parameter Editor applies the custom attribute to the first modifier you highlighted and removes the highlighting from the other modifiers.

[pick explicit track] Click this button to open a Track View hierarchy window from which to choose an animation track. Navigate the hierarchy to find the desired track, highlight the track, and then click OK. The controller information for the track then appears in the text box to the right of the button, and the Parameter Editor will then use this track for adding or editing custom attributes and parameters.
Add/Edit/Delete group

Add Applies the custom attribute parameter to the current object, modifier, material, or track, depending on the current choice in the Add To Type list. If a custom attribute parameter is assigned to an object or modifier, you can see and edit its value on the Modify panel after adding it by activating the entity to which the attribute is assigned. If the custom attribute is assigned to a material, it's available for that material in the Material Editor. To access a parameter that's assigned to an animation track, open Track View, highlight the track's Custom Attributes entry, and then right-click and choose View Attribute Dialog.

Edit/Delete Opens the Edit Attributes/Parameters dialog.
This dialog displays a list of all of the custom attribute parameters assigned to the currently object at the current level. Dialog behavior is described in these two procedures: To edit a parameter or custom attribute: on page 309 and To delete a custom attribute or parameter: on page 312.
Parameter Type group

Parameter Type Use the drop-down list to choose the data type for the current parameter. The following list includes links to the sections describing the UI settings for each parameter’s data type:

- Angle: Spinner on page 317 or Slider on page 317
- Array on page 320
- Boolean: CheckBox on page 319 or CheckButton on page 319
- Color on page 322
- Float: Spinner on page 317 or Slider on page 317
- fRGBA on page 322
- Integer: Spinner on page 317 or Slider on page 317
- Material on page 323
- Node on page 322
- Percent: Spinner on page 317 or Slider on page 317
- String on page 324
- TextureMap on page 323
- WorldUnits: Spinner on page 317 or Slider on page 317

UI Type group

UI Type Selects the type of UI element that controls the parameter. The UI types available depend on which parameter type you specify. For example, float and integer values are controlled by spinners or sliders, and Boolean values by check boxes or check buttons. Array values are always controlled by drop-down lists, node values by pick buttons, color values by color pickers, and texture map values by map buttons.

Full descriptions of each UI Options rollout follow, and the list of parameter types, above, includes links to the respective UI Options rollout descriptions.

Name The name of the parameter. Parameter Editor gives the parameter the default name Param#, with # being a number. Change the name by editing this field.
Angle/Float/Integer/Percent/WorldUnits UI Options rollout: Spinner

This is a numeric value that the user can set with a standard 3ds Max spinner.

Size group

Width Sets the width of the spinner.

Range group

From Sets the minimum value of the spinner.
To Sets the maximum value of the spinner.
Default Sets the default value of the spinner.

Alignment group

Left/Right/Center Sets the alignment of the spinner in the rollout.
Offsets X/Y Fine-tune the position of the spinner on the horizontal and vertical axes.

Angle/Float/Integer/Percent/WorldUnits UI Options rollout: Slider

This is a numeric value that the user can set with a standard 3ds Max slider.
Size group

**Width** Sets the width of the slider.

Range group

**From** Sets the minimum value of the slider.
**To** Sets the maximum value of the slider.
**Default** Sets the default value of the slider.

Alignment group

**Left/Right/Center** Sets the alignment of the slider in the rollout.

**Offsets X/Y** Fine-tune the position of the slider on the horizontal and vertical axes.

Orientation And Ticks group

**Vertical** When on, the slider will be displayed vertically. When off, the slider is displayed horizontally.

**Ticks** Sets the number of ticks along the slider. The ticks are distributed evenly along the length of the slider.
Boolean UI Options rollout: Check Box

This is a standard 3ds Max check box that the user can turn on and off by clicking it with the mouse.

Size group

Width Sets the width of the check box.

Height Sets the height of the check box.

Alignment group

Left/Right/Center Sets the alignment of the check box in the rollout.

Offsets X/Y Fine-tune the position of the check box on the horizontal and vertical axes.

Boolean UI Options rollout: Check Button

This is a standard 3ds Max check button that the user can turn on and off by clicking it with the mouse.
Size group

Width Sets the width of the check button.
Height Sets the height of the check button.

Alignment group

Left/Right/Center Sets the alignment of the check button in the rollout.
Offsets X/Y Fine-tune the position of the check button on the horizontal and vertical axes.

Check Button Options group

Highlight Color Sets the color of the button when it is pressed.

Array UI Options rollout: Drop-Down List/ComboBox/ListBox

This lets the user of the custom attribute choose a named option from a list. The options for the three Array UI types are the same; they differ in how they appear on the Custom Attributes rollout. The types are:

- Drop-Down List: Only the current choice is visible by default. The user clicks the field to open the list and then clicks to choose a different item.
- ComboBox: Displays an editable field above a list box. The user clicks to choose from the list, or edits the field.
- ListBox: Displays a list. The user clicks the desired item; the highlighting indicates the current choice.
**Size group**

*Width* Sets the width of the list.

*Height* Sets the height of the list.

**Alignment group**

*Left/Right/Center* Sets the alignment of the drop-down list in the rollout.

*Offsets X/Y* Fine-tune the position of the array list on the horizontal and vertical axes.

**Array group**

*Item name* Lets you enter a name into the list.

Click Add Item to add the name to the array list. To remove an item, highlight its name and click Delete Item. Click Clear Array to remove all items from the list.
[array list] Displays the contents of the list. The item at the top of the array list is the default selection.

**Node UI Options rollout: Pick Button**

A node is any object in the 3ds Max scene. The Node UI element creates a button that, when clicked, lets the user pick a scene node other than the one to which the attribute is attached. After selecting the node, its name appears on the button.

### Size group

**Width** Sets the width of the pick button.  
**Height** Sets the height of the pick button.

### Alignment group

**Left/Right/Center** Sets the alignment of the pick button in the rollout.  
**Offsets X/Y** Fine-tune the position of the pick button on the horizontal and vertical axes.

**Color UI Options rollout: Color Picker**

This creates a color swatch that displays the current color and lets the user click it to choose a new color with the Color Selector dialog.
**Size group**

- **Width** Sets the width of the color picker.
- **Height** Sets the height of the color picker.

**Alignment group**

- **Left/Right/Center** Sets the alignment of color picker in the rollout.
- **Offsets X/Y** Fine-tune the position of the color picker on the horizontal and vertical axes.

**ColorPicker Default Color group**

- **Default Color** Sets the default color of the color picker.

**Material/TextureMap Options rollout: MaterialButton/MapButton**

The options for the Material UI type (MaterialButton) and TextureMap UI type (MapButton) are the same. The difference is that, when the user clicks the resulting button to open the Material/Map Browser, the former displays only materials and the latter displays only maps.
Size group

**Width** Sets the width of the material/map button.

**Height** Sets the height of the material/map button.

Alignment group

**Left/Right/Center** Sets the alignment of the material/map button in the rollout.

**Offsets X/Y** Fine-tune the position of the material/map button on the horizontal and vertical axes.

String Options rollout: EditText

The String parameter type creates a text box that the user can edit with the keyboard, with optional default text.

Size group

**Width** Sets the width of the material/map button.

**Height** Sets the height of the material/map button.

Alignment group

**Left/Right/Center** Sets the alignment of the text box in the rollout.

**Offsets X/Y** Fine-tune the position of the text box on the horizontal and vertical axes.
Label group

**Label above text box** When off, the label (parameter name) appears to the left of the text box. When on, the label appears above the text box.

EditText Default Text group

**Default Text** Enter any default text that should appear in the box before the user edits it.

Testing Attribute rollout

This rollout displays the UI layout for the custom attribute that you are working on. It updates continuously so that you can see how different settings in the various rollouts affect the UI display of the attribute.

The UI element is operational in this rollout in the sense that it can be moved, clicked, toggled, and so on.

Parameter Collector

Animation menu > Parameter Collector

Keyboard > Alt+2

Parameter Collector lets you sort and present animatable parameters so that you can access and key selected parameter sets with a click or two. It takes the form of a resizable dialog that regenerates dynamically as parameters change. The dialog supports drag-and-drop rollout reordering. Collections are saved with their scenes and can be merged into other scenes.

One of Parameter Collector's most powerful features is the ability to change all parameters in a collection simultaneously, in an absolute or relative mode. For example, if you're animating a character's hand, you can use Parameter Collector to easily make all the fingers curl up together to form a fist.

**NOTE** Parameter Collector does not support parameters of externally referenced objects on page 7450 or objects in externally referenced scenes on page 7477.
Procedures

Example: To use Parameter Collector:

This exercise demonstrates some basic Parameter Collector functions.

In general, start with a scene containing one or more objects whose parameters you'll collect. Ideally, they should be animated, but it's not absolutely necessary.

1 For this example, reset 3ds Max and then add a sphere.
2 Open Parameter Collector from the Animation menu, or press Alt+2.
3 On the Parameter Collector toolbar, click the Add To New Rollout button.
The Track View Pick dialog opens. This lets you specify parameters to collect.
4 On the Track View Pick dialog, expand Objects > Sphere01 > Transform: Position/Rotation/Scale > Position: Position XYZ.
5 Click X Position: Bezier Float.
The parameter highlights.
6 Click OK to close the dialog.
A new rollout named Parameters 1 appears, containing the X Position parameter.

NOTE A parameter in Parameter Collector can contain only a single value (for example: float, integer, color), so 3ds Max doesn't let you add parameters such as Position: Position XYZ, which contains three distinct values.

7 Click Add To Selected Rollout and then use the same method to add the Y Position and Z Position parameters: Highlight both parameters on the Track View Pick dialog and then click Add To Selected Rollout to add both at once to the Parameters 1 rollout.
8 Drag each spinner in turn to move the sphere on the respective axis. As you change each parameter value, the sphere moves in real time in the viewports.

9 Set all three parameters to 0.0.

10 Click the check button next to each parameter to select all three.

11 On the toolbar, turn on Multiple Edits.

12 Drag one of the spinners. All three change by the same amount, so that the sphere moves diagonally in the scene.

13 Use the keyboard to change the Y Position value to 30.0. Again, the other two change.

14 Click the Absolute/Relative button to turn on Relative mode. All the values display 0.0, as with Offset mode on the status bar coordinate display.

15 Use the spinner to set Y Position to 0.65. The three change in unison, and then reset back to 0.0 when you release the mouse button. This has added the value you set to each of the three positions, as you'll see in the next step.

16 Click the Absolute/Relative button to return to Absolute mode. The values are all set to 30.65, reflecting the relative change that you made.

17 Click the Y Position check button to deselect the parameter.

18 From the Edit menu, choose Select Invert.
The Y Position parameter is now selected, and the other two are deselected.

19 Click the Move Parameters Up button.
The Y Position parameter now sits above the X Position parameter.

20 Click the Move Parameters Down button.
The Y Position returns to its position below the X Position parameter.

21 Choose Edit > Edit Notes.
The Notes dialog opens. Here you can change the parameter name, set a URL or file location with further information about the parameter, and enter comments.

22 In the box below Parameter Name, type Sphere Y Loc., and then press Enter.
The new name replaces the old one on the rollout. You can see the original name by hovering the mouse cursor over the parameter name; it appears on a tooltip.
To conclude this exercise, you'll use Parameter Collector to set and edit animation keyframes.

23 On the Collection menu, turn on Show Keys In Track Bar if necessary.

24 On the 3ds Max status bar, turn on Auto Key.

25 Change the Sphere Y Loc. (the old Y Position) parameter value to 20.0.
Because you're at frame 0, no key is set. This is the same way Auto Key works normally.

26 Go to frame 20 and then set Sphere Y Loc. to 30.0.
This sets animation keys at frames 0 and 20.

27 Right-click the key at frame 20.
The menu shows that a key exists at frame 20 only for Y Position. Normally, 3ds Max would create keys for all three axes, even if you moved the sphere only on one axis.
Parameter Collector can set keys for unselected objects as well.
28 Click in an empty area of the active viewport to deselect the sphere, and then go to frame 30 and change the Sphere Y Loc. value to 40.0. This sets another key for Y Position at frame 30.

29 In Parameter Collector, select the X Position and Z Position parameters, and then click Key Selected. This button is available only when Auto Key is on.

30 Check the track bar key again. Now there are keys for all three parameters, as demonstrated by the red brackets on the spinners in Parameter Collector.

31 Click the Properties button to the right of the Sphere Y Loc. parameter. This opens a Key Info dialog on page 3418 for the parameter, with the ability to edit the key time and value as well as interpolation with other keys. The dialog is also available from the track bar right-click menu, but it’s much easier to access the data for a specific key from Parameter Collector.
Parameter Collector takes the form of a dialog with a menu bar, a toolbar, and rollouts that you create and modify using the dialog tools. You can resize the dialog horizontally and vertically; expanding it lets you see all rollouts simultaneously.
Menu Bar

The menu bar provides a range of functions for using Parameter Collector. See Parameter Collector Menu Bar on page 334 for details. Also, you can open the Spinner Right-Click menu on page 338 by right-clicking a numeric field in Parameter Collector.

Toolbar

The Parameter Collector toolbar provides button access to the most commonly used functions.

[collection name] If empty, enter a name for the current collection, or choose a different collection from the drop-down list. If a name appears and you edit it, pressing Enter duplicates the current collection with the new name.

New Collection Creates a new, empty collection, clearing the current collection name and the rollout area. You can restore any existing collection by choosing it from the drop-down list. This button is unavailable if you have not entered a name for the collection.

Duplicate Collection Creates a new, unnamed collection containing the same data as the current collection. Enter a name for the duplicate selection in the editable field. This button is unavailable if you have not entered a name for the collection.

TIP You can also duplicate a collection and name it at the same time by editing the name of an existing collection and then pressing Enter.

Delete Collection Removes the current collection from memory. This button is unavailable if you have not entered a name for the collection.

Multiple Edits Enables multiple editing, in which changing the value of any selected parameter simultaneously changes all selected parameters of Parameter Collector | 331
the same type by the same amount. This applies to both Absolute and Relative modes (see following).

**Absolute/Relative** Works the same way as the Absolute/Offset mode toggle on the Coordinate Display on page 8081. When Absolute is chosen, modifying a value changes it to the exact amount you specify. When Relative is chosen, the displayed value is 0, and modifying the parameter adds the specified change to the original value. The actual value appears only in Absolute mode.

This applies to numeric values only; any changes to other values, such as color, are always absolute.

**NOTE** With multiple parameters selected, and Multiple Edits on, changing the value of a selected parameter changes the other selected parameter values by the same amount, not to the same amount. This happens in both Absolute and Relative modes.

**Key Selected** Sets keys on page 8616 for selected parameters only at the current frame. Available only when Auto Key on page 8090 is on.

**Reset Selected** Sets all selected numeric parameters to 0. Has no effect on other parameter types.

**Move Parameters Down** Moves each selected parameter down one position within its rollout, if possible.

**Move Parameters Up** Moves each selected parameter up one position within its rollout, if possible.

**Add to Selected Rollout** Lets you add new parameters to the selected rollout. Click this button to open the Track View Pick dialog, and then choose the parameters from the dialog.

**NOTE** You can add several parameters at once by highlighting them in the dialog before clicking OK.
Add to New Rollout  Lets you add new parameters to a new rollout. Click this button to open the Track View Pick dialog, and then choose the parameter from the dialog. Parameter Collector creates a new rollout to hold the parameters.

NOTE You can add several parameters at once by highlighting them in the dialog before clicking OK.

Delete Selected  Deletes all selected parameters.

Delete All  Deletes all parameters and rollouts.

Rollouts

Rollouts work the same way in Parameter Collector as they do on the command panel on page 47. You can expand and collapse a rollout by clicking its title bar, and move it to another location by dragging the title bar. You can resize the dialog to be able to see all rollouts at once.

Only one rollout can be selected at a time. You select a rollout by clicking the horizontal bar beneath the title; when selected, this bar is orange-yellow in color, and angle brackets surround the rollout title (for example, “> Hand Parameters <”).

The interface for each parameter on a rollout is as follows:

[Select Parameter] A small check button on the left side of the rollout. Click it to toggle the parameter's selection status. When selected, the button appears pressed in and is colored yellow-orange.

[parameter name] By default, the parameter has the same name as is shown in Track View, but you can change it with the Edit menu > Edit Notes command. You can see the default name for a parameter as well as the object it controls, if any, by hovering the mouse over the parameter name; the information appears on a tooltip.

[parameter value] Shows the current value of the parameter. The parameter type determines how this appears: numeric field/spinner, color swatch, etc. You can edit the value the same way as on the command panel or a dialog. If a key exists for the value at the current frame, the spinner or swatch appears with red brackets at the corners.
[Properties] Opens a Key Info dialog on page 3418 for the parameter. Available only if the parameter has an animation controller. Use the Key Info dialog to edit an animation key's value, time, and interpolation methods.

Parameter Collector Menu Bar

Animation menu > Parameter Collector > Parameter Collector menu bar
Keyboard > Alt+2 > Parameter Collector menu bar

The Parameter Collector dialog menu bar provides access to a number of important commands. Some of these commands are replicated on the dialog toolbar; others, such as the Select tools, are available only from the menus. Also, you can open the Spinner Right-Click menu on page 3380 by right-clicking a numeric field in Parameter Collector.

Interface

Collection menu

The first three items in this menu are unavailable until you enter a name for the current collection in the editable field (drop-down list) just below the menu bar.

New Collection Creates a new, empty collection, clearing the current collection name and the rollout area. You can restore any existing collection by choosing it from the drop-down list.

Duplicate Collection Creates a new, unnamed collection containing the same data as the current collection. Enter a name for the duplicate selection in the editable field.

Delete Collection Removes the current collection from memory.

Show Keys in Track Bar Displays in the track bar on page 8071 animation keys for all objects with parameters in the current collection, whether or not the objects are selected in the scene.

Isolate Keys in Track Bar The track bar displays only keys for parameters in the Parameter Collector.
Show Selected Keys in Track Bar Displays in the track bar on page 8071 animation keys for all objects with selected parameters in the current collection, whether or not the objects are selected in the scene.

Isolate Selected Keys in Track Bar The track bar displays only keys for selected parameters in the Parameter Collector.

Put to Object Stores the current collection as part of an object in the scene. Opens the Put To Object dialog; highlight an object in the list, and then click Pick.

Although parameter collections are stored with the scene in which they're created, you can use this function to transfer a collection to a different scene. After putting the collection to an object, save the scene. Open or create another scene, merge the object from the saved scene to the new one, and then use Get from Object.

You can also back up, organize and streamline parameter collections by putting and getting different collections to and from various objects in your scene. Just remember that if you add, reorder, or remove parameters or rollouts to a collection that has been put to an object, you must then put it to the object again so the changes are saved to the collection.

Link to Object Stores the current collection using a live link as part of an object in the scene. Any change to the collection instantly updates the version of the collection stored in the object. Opens the Link To Object dialog; highlight an object in the list, and then click Pick.

Link to Object has basically the same function as Put To Object (see previous entry), except that it guarantees an up-to-date stored version of the collection, especially when merging the object into another scene that is a common production workflow.

NOTE Only one “linked-to” object can be active in a scene, but you can use Put To Object on any number of objects at a time.

Get from Object Retrieves a collection that you stored with Put To Object or Link To Object.

Remove from Object Deletes a collection that you stored with Put To Object or Link To Object.

Edit menu

Parameter Collector lets you select parameters in any combination, but you can select no more than one rollout at a time. To select or deselect a parameter, click the small button on its left side. To select or deselect a rollout, click the
A wide horizontal button just below the rollout title. Selecting a rollout deselects any other selected rollout.

**Select All** Selects all parameters and rollouts.

**Select All Rollout** Selects all parameters on the current rollout. Unavailable if no rollout is selected.

**Select None** Deselects all parameters.

**Select Invert** Inverts the current selection of parameters.

**Delete Selected** Deletes all selected parameters.

**Delete All** Deletes all parameters and rollouts.

**Multiple Edits** Enables multiple editing, in which changing any parameter simultaneously changes all selected parameters of the same or similar type.

---

**NOTE** The changed parameter need not be selected.

**Absolute/Relative** This works the same as the Absolute/Offset mode toggle on the Coordinate Display on page 8081. When Absolute is chosen, modifying a value changes it to the exact amount you specify. When Relative is chosen, the displayed value shows 0, and modifying the parameter adds the specified change to the original value. This applies to numeric values only; changes to any other value types such as color are always absolute.

**Edit Notes** Opens a single Notes dialog on page 337 for all selected parameters. You can open the Notes dialog for a single parameter by right-clicking its Select Parameter button.

**Parameters menu**

**Add to Selected** Lets you add new parameters to the selected rollout.

**Add to New Rollout** Lets you add new parameters to a new rollout.

**Move Up** Moves selected parameters up one position within their rollout, if possible.

**Move Down** Moves selected parameters down one position within their rollout, if possible.

**Move Up By Rollout** Moves selected parameters to the rollout above, if possible. If the same parameter already exists in the rollout above, the selected parameter is simply deleted.
**Move Down By Rollout** Moves selected parameters to the next rollout, if possible. If the same parameter already exists in the next rollout, the selected parameter is simply deleted.

**Key All** Sets keys on page 8616 for all parameters at the current frame. Available only when Auto Key on page 8090 is on.

**Key Selected** Sets keys on page 8616 for selected parameters only at the current frame. Available only when Auto Key on page 8090 is on.

**Reset All** Sets all numeric parameters to 0. Has no effect on other parameter types.

**Reset Selected** Sets all selected numeric parameters to 0. Has no effect on other parameter types.

**Rollout menu**

*NOTE* While there are no menu commands for moving rollouts, you can do so simply by dragging the rollout title bar to a new location.

**New Rollout** Creates a new, empty rollout.

**New Rollout Selected Parameters** Creates a new rollout and populates it with copies of any selected parameters.

**Rename Rollout** Opens a small dialog that lets you rename the selected rollout.

**Delete Rollout** Deletes the selected rollout.

**Delete Rollout Move Up** Deletes the selected rollout and moves its parameters to the rollout above.

**Delete Rollout Move Down** Deletes the selected rollout and moves its parameters to the rollout below.

**Notes Dialog (Parameter Collector)**

Parameter Collector > Select one or more parameters. > Parameter Collector menu bar > Edit menu > Notes

Parameter Collector > Right-click a Parameter Select button.

The Notes dialog lets you enter a name, URL, and comments for one or more selected parameters in Parameter Collector.
Choosing Notes from the Edit menu with multiple parameters selected opens a single dialog common to all selected parameters. Right-clicking a Parameter Select button opens a dialog for that parameter only.

When you open Notes from the Edit menu with multiple parameters selected, if the text contents for a box in all selected parameters are the same (or null), its check box is on, indicating that changes to the text will apply to all selected parameters. If a text box has different contents for different selected parameters, the check box is off, and the corresponding text box is empty and unavailable, preventing any changes. If you turn on a check box, you can edit the text, and changes will be applied to all selected parameters.

**Interface**

![Notes dialog interface](image)

The Notes dialog interface comprises three text boxes, each with its respective check box, and a button. By default, the text boxes are empty; you can enter any text into each box, although each has a specific purpose, as described below.

**Parameter Name** Lets you change the parameter name shown in Parameter Collector.

338 | Chapter 5  Object Properties
By default, the parameter name displayed in Parameter Collector is the same as the name that appeared in the Track View Pick dialog when you added it to Parameter Collector. If you enter a different name in the Notes dialog, Parameter Collector then displays that name. The changed name is used only in Parameter Collector; elsewhere, such as the Modify panel, it remains the same as before.

You can see the original parameter name, as well as the object to which it’s attached, by hovering the mouse over the parameter name in Parameter Collector; the information appears in a tooltip.

**URL** Lets you enter a URL, such as www.discreet.com. This could be a link to a Web or intranet page, or even a network location or file pertaining to the selected parameter. To access the link, click the Go button.

**Go** If the URL text box contains a valid URL, clicking Go opens the URL in a separate browser window.

**Notes** Contains any comments on the parameters. This field is strictly for informational purposes.

### Expression Techniques

In 3ds Max, you can use mathematical expressions (rather than constant numbers) to express parameter values. For example, you could use the expression $24 \times 6$ to represent the number 144.

You can use mathematical expressions to control the following object properties:

- Object parameters, such as length, width, and height
- Transform and modifier values, such as an object’s position coordinates

*Parameter wiring* on page 3610, the *expression controller* on page 3456, and the *numerical expression evaluator* on page 49 all use expressions, which are described in this topic.
An expression is a mathematical function that returns a value. You can use expressions to control the following scene elements:

<table>
<thead>
<tr>
<th>Scene element</th>
<th>Calculatable property</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creation parameters</td>
<td>Any numeric creation parameter</td>
</tr>
<tr>
<td>Transforms</td>
<td>Position [X, Y, Z]</td>
</tr>
<tr>
<td></td>
<td>X Rotation</td>
</tr>
<tr>
<td></td>
<td>Y Rotation</td>
</tr>
<tr>
<td></td>
<td>Z Rotation</td>
</tr>
<tr>
<td></td>
<td>Scale [X%, Y%, Z%]</td>
</tr>
<tr>
<td>Modifiers</td>
<td>Any numeric modifier parameter (including creation parameters)</td>
</tr>
<tr>
<td>Materials</td>
<td>Colors [R, G, B]</td>
</tr>
<tr>
<td></td>
<td>Any numeric material parameter</td>
</tr>
</tbody>
</table>

**NOTE** Expressions only work with the individual XYZ components of Euler rotation. You can't assign an expression to TCB rotation or other kinds of rotation controllers.

The links below are to the sections that follow in this topic.

- Expression Return Types on page 341
- Operators on page 341
- Variables on page 344
- Functions on page 346

**See also:**
- Trigonometric Functions on page 349
- Vectors on page 352
- Expression Controller Techniques on page 3463
Expression Return Types

The type of value returned by an expression depends on the kind of controller:

- Float expressions return a floating-point scalar value (For example, 5.617). Scalars are used in the animation controllers of numeric parameters. If the parameter has an integer value, the expression rounds the float value to the nearest integer.

- Position, Scale, and Point3 expressions return a three-component vector. For example, [5, 18, 24]. The vector can represent an object’s X,Y,Z location, percent scaling in X, Y, and Z, or a color (RGB values) in a material.

Operators

In the following tables, p and q are any scalar value or expression, V and W are any vector value or expression. (The character “x” is used as the vector cross-product operator.)

Scalar Operators

These are the arithmetic operators for scalar values:

<table>
<thead>
<tr>
<th>Operator</th>
<th>Use</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>p+q</td>
<td>Addition</td>
</tr>
<tr>
<td>-</td>
<td>p-q</td>
<td>Subtraction</td>
</tr>
<tr>
<td>-</td>
<td>-p</td>
<td>Additive inverse</td>
</tr>
<tr>
<td>*</td>
<td>p*q</td>
<td>Multiplication</td>
</tr>
<tr>
<td>/</td>
<td>p/q</td>
<td>Division</td>
</tr>
<tr>
<td>^</td>
<td>p^q</td>
<td>power (p to the power of q)</td>
</tr>
<tr>
<td>**</td>
<td>p**q</td>
<td>^ and ** are the same operation</td>
</tr>
</tbody>
</table>
You can also use logical (Boolean) operators with scalar values. These operators all return 1 if true, 0 otherwise:

<table>
<thead>
<tr>
<th>Operator</th>
<th>Use</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>=</td>
<td>p=q</td>
<td>equal to</td>
</tr>
<tr>
<td>&lt;</td>
<td>p&lt;q</td>
<td>less than</td>
</tr>
<tr>
<td>&gt;</td>
<td>p&gt;q</td>
<td>Greater than</td>
</tr>
<tr>
<td>&lt;=</td>
<td>p&lt;=q</td>
<td>less than or equal to</td>
</tr>
<tr>
<td>&gt;=</td>
<td>p&gt;=q</td>
<td>Greater than or equal to</td>
</tr>
<tr>
<td></td>
<td>p</td>
<td>q</td>
</tr>
<tr>
<td>&amp;</td>
<td>p&amp;q</td>
<td>Logical AND, returns 1 if p and q are both nonzero; otherwise, returns 0</td>
</tr>
</tbody>
</table>

**TIP** Logical operators are useful with the "if" function.

**Vector Operators**

For vectors that have a variable name, you can use a special component operator (.) to refer to the three scalar components of the vector:

<table>
<thead>
<tr>
<th>Use</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>V.x</td>
<td>first component (X)</td>
</tr>
<tr>
<td>V.y</td>
<td>second component (Y)</td>
</tr>
<tr>
<td>V.z</td>
<td>third component (Z)</td>
</tr>
</tbody>
</table>
These are the operators for vector arithmetic:

<table>
<thead>
<tr>
<th>Operator</th>
<th>Use</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>V+W</td>
<td>Addition</td>
</tr>
<tr>
<td>-</td>
<td>V-W</td>
<td>subtraction</td>
</tr>
<tr>
<td>*</td>
<td>p*V</td>
<td>scalar multiplication</td>
</tr>
<tr>
<td>*</td>
<td>V*p</td>
<td>scalar multiplication</td>
</tr>
<tr>
<td>*</td>
<td>V*W</td>
<td>dot product</td>
</tr>
<tr>
<td>X</td>
<td>VxW</td>
<td>cross product</td>
</tr>
<tr>
<td>/</td>
<td>V/p</td>
<td>scalar division</td>
</tr>
</tbody>
</table>

**Operator Precedence**

Expressions have eight levels of precedence. The higher the operator is on the list, the earlier it is evaluated.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Level of Precedence</th>
</tr>
</thead>
<tbody>
<tr>
<td>- +</td>
<td>as unary operators, as in -8, +25</td>
</tr>
<tr>
<td>.</td>
<td>the component operator, as in V.x</td>
</tr>
<tr>
<td><strong>^</strong></td>
<td></td>
</tr>
<tr>
<td>X</td>
<td>cross product</td>
</tr>
<tr>
<td>* /</td>
<td></td>
</tr>
<tr>
<td>+ -</td>
<td></td>
</tr>
<tr>
<td>Operator</td>
<td>Level of Precedence</td>
</tr>
<tr>
<td>----------</td>
<td>---------------------</td>
</tr>
<tr>
<td>= &lt; &gt; &lt;=</td>
<td></td>
</tr>
<tr>
<td>&gt;=</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&amp;</td>
</tr>
</tbody>
</table>

Parentheses are a special case. They are a grouping or subexpression operator that is provided so you can override the precedence order of the other operators.

**Variables**

In expressions you write for expression controllers on page 3456, variables are represented by symbolic names. You create them to contain constant or variable values in your expressions. Several predefined variables are also provided. Some of these have a constant value, others can vary.

In expressions used for parameter wiring on page 3610 and the numerical expression evaluator on page 49, you can use predefined variables with constant values.

**Predefined Variables with Constant Values**

These are the predefined variables that have a constant value (variable names are case-sensitive):

<table>
<thead>
<tr>
<th>Variable Name</th>
<th>Constant Value</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>pi</td>
<td>3.14159</td>
<td>Ratio of a circle's circumference to its diameter.</td>
</tr>
<tr>
<td>e</td>
<td>2.71828</td>
<td>Base of natural logarithms.</td>
</tr>
<tr>
<td>TPS</td>
<td>4800</td>
<td>Ticks per second. The tick is the basic time unit of 3ds Max animation.</td>
</tr>
</tbody>
</table>
Predefined Variables with Variable Values

These are the predefined variables that have a variable, time-based value (variable names are case-sensitive).

<table>
<thead>
<tr>
<th>Variable Name</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>F</td>
<td>Frame number. For each frame, F equals the current frame number, counting from zero. The range of frames can vary depending on the number of frames in the active time segment.</td>
</tr>
<tr>
<td>NT</td>
<td>Normalized time. By definition, normalized time (NT) ranges from 0 to 1 over the active time segment, regardless of how many frames are in the segment. If you base an expression on NT, its effect happens exactly once over the range. You can also multiply NT by a factor for the expression's effect to occur a certain number of times (for example, 2*NT causes the expression's effect to occur twice). Expressions based on NT speed up or slow down if you change the length of the time segment.</td>
</tr>
<tr>
<td>S</td>
<td>Seconds (elapsed time in seconds). Elapsed time is measured from the first frame to the current frame. The range of seconds can vary depending on the total time of the active time segment.</td>
</tr>
<tr>
<td>T</td>
<td>Ticks (elapsed time in ticks). There are 4800 ticks per second. Elapsed time is measured from the first frame to the current frame. The range of ticks can vary depending on the total time of the active time segment.</td>
</tr>
</tbody>
</table>
Rules for Variable Names

- Variable names can contain as many alphanumeric characters as you like. Their length is not limited.
- Variable names cannot contain spaces.
- The variable name must begin with a letter. Numbers are valid within a variable name (as in "Pos1" or "M23").
- Variable names are case-sensitive. For example, "pos", "Pos", and "POS" designate three different variables.
- You can’t create a variable with a name that duplicates another name, including the variable names that are predefined.

Functions

Following is a list of the functions provided for expressions. In this list, p, q, and r represent scalar values or scalar expressions. V and W represent vector values or vector expressions.

To use a function in an expression, enter the name of the function and appropriate arguments to it.

Trigonometric Functions

The sine, cosine, and tangent functions take an angle in degrees and return a floating-point value. The arc functions take a floating-point value and return a value in degrees.

<table>
<thead>
<tr>
<th>Function</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>sin(p)</td>
<td>sine</td>
</tr>
<tr>
<td>cos(p)</td>
<td>cosine</td>
</tr>
<tr>
<td>tan(p)</td>
<td>tangent</td>
</tr>
<tr>
<td>asin(p)</td>
<td>arc sine</td>
</tr>
<tr>
<td>acos(p)</td>
<td>arc cosine</td>
</tr>
</tbody>
</table>
### Hyperbolic Functions

Hyperbolic functions take a floating-point value and return a floating-point value.

<table>
<thead>
<tr>
<th>Function</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>sinh(p)</td>
<td>hyperbolic sine</td>
</tr>
<tr>
<td>cosh(p)</td>
<td>hyperbolic cosine</td>
</tr>
<tr>
<td>tanh(p)</td>
<td>hyperbolic tangent</td>
</tr>
</tbody>
</table>

### Conversion Between Radians and Degrees

<table>
<thead>
<tr>
<th>Function</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>radToDeg(p)</td>
<td>takes p in radians and returns the same angle in degrees</td>
</tr>
<tr>
<td>degToRad(p)</td>
<td>takes p in degrees and returns the same angle in radians</td>
</tr>
</tbody>
</table>

### Rounding Functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>ceil(p)</td>
<td>smallest integer greater than or equal to p</td>
</tr>
<tr>
<td>floor(p)</td>
<td>largest integer less than or equal to p</td>
</tr>
</tbody>
</table>
## Standard Calculations

<table>
<thead>
<tr>
<th>Function</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>ln(p)</td>
<td>natural (base e) logarithm</td>
</tr>
<tr>
<td>log(p)</td>
<td>common (base 10) logarithm</td>
</tr>
<tr>
<td>exp(p)</td>
<td>exponential function exp(p)=e^p</td>
</tr>
<tr>
<td>pow(p,q)</td>
<td>p to the power of q (p^q)</td>
</tr>
<tr>
<td>sqrt(p)</td>
<td>square root</td>
</tr>
<tr>
<td>abs(p)</td>
<td>absolute value</td>
</tr>
<tr>
<td>min(p,q)</td>
<td>minimum returns p or q, depending on which is smaller</td>
</tr>
<tr>
<td>max(p,q)</td>
<td>maximum returns p or q, depending on which is greater</td>
</tr>
<tr>
<td>mod(p,q)</td>
<td>remainder of p divided by q</td>
</tr>
</tbody>
</table>

## Conditional Functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>if(p,q,r)</td>
<td>works like the common spreadsheet &quot;if&quot; (If p is nonzero then &quot;if&quot; returns q, otherwise &quot;if&quot; returns r.)</td>
</tr>
<tr>
<td>vif(c,V1,V2)</td>
<td>&quot;Vector If&quot; (Value is V1 if c is true, else V2.)</td>
</tr>
</tbody>
</table>
Vector Handling Functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>length(V)</td>
<td>length of V</td>
</tr>
<tr>
<td>comp(V,i)</td>
<td>i'th component (i=0,1,2):</td>
</tr>
<tr>
<td></td>
<td>comp([5,6,7],1)=6</td>
</tr>
<tr>
<td>unit(V)</td>
<td>returns a unit vector in the same direction as V</td>
</tr>
</tbody>
</table>

**NOTE** The comp function is an alternative to the notation V.x, V.y, V.z.

Special Animation Function

<table>
<thead>
<tr>
<th>Function</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>noise(p,q,r)</td>
<td>3D noise: returns a randomly generated position</td>
</tr>
</tbody>
</table>

The arbitrary values p, q and r, are used as a random-generation seed. You can reuse these values to ensure that noise() returns the same value.

Trigonometric Functions

This topic is a quick review for readers who need a reminder about this area of mathematics. If you’re familiar with trigonometry, you can skip this topic. If you find this topic difficult to follow, you might consult a more basic reference on mathematics.

Trigonometric functions are principally used to model or describe:

- The relation between angles in a triangle (hence the name).
- Rotations about a circle, including locations given in polar coordinates.
- Cyclical or periodic values, such as sound waves.
The three basic trigonometric functions are derived from an angle rotating about a unit circle.

![Diagram of a unit circle with trigonometric functions](image)

**Trigonometric functions based on the unit circle**

\[
\sin \theta = \frac{y}{r} \quad \cos \theta = \frac{x}{r} \quad \tan \theta = \frac{y}{x}
\]

The tangent function is undefined for \(x=0\). Another way to define the tangent is:

\[
\tan \theta = \frac{\sin \theta}{\cos \theta}
\]

Because \(XYR\) defines a right-angled triangle, the relation between the sine and cosine is:

\[
(\cos \theta)^2 + (\sin \theta)^2 = 1
\]

The graphs of the basic trigonometric functions illustrate their cyclical nature.
Graphs of basic trigonometric functions

The sine and cosine functions yield the same values, but the phase differs along the X axis by $\pi/2$: in other words, 90 degrees.

The inverse functions for the trigonometric functions are the arc functions; the inverse only applies to values of x restricted by $-\pi/2 \leq x \leq \pi/2$. The graphs for these functions appear like the basic trigonometric function graphs, but turned on their sides.

Graphs of basic arc functions

The hyperbolic functions are based on the exponential constant $e$ instead of on circular measurement. However, they behave similarly to the trigonometric functions and are named for them. The basic hyperbolic functions are:
The topic is a quick review for readers who need a reminder about vector arithmetic. If you’re familiar with vectors and vector calculations, you can skip this topic. If this topic is difficult to follow, you might consult a more basic reference on mathematics.

A vector expresses a length and a direction in a particular space. The vector is expressed as a point; for example, [5, 5, 7]. The length is the distance from the origin to that point, and the direction is similarly from the origin to (and through) the point.

In 3ds Max, vectors have three values and describe positions in three-dimensional space. They can also represent percent scaling in X, Y, and Z; and (more abstractly) describe locations in RGB color space.
**Unit Vectors and Basic Vectors**

A unit vector has a length of one. Unit vectors are often used to express direction only. The three basic vectors are unit vectors that describe the three axes (X, Y, and Z) of 3D space.

![Basic vectors and the XYZ axes](image)

**Adding and Subtracting Vectors**

Adding two vectors creates a new vector that combines the length and direction of the original two. Vector addition is commutative: $V + W = W + V$.

![Adding two vectors](image)
\[ \mathbf{V} + \mathbf{W} = [v_1 + w_1, v_2 + w_2, v_3 + w_3] \]

Subtracting two vectors gives the vector between the two points.

\[ \mathbf{V} - \mathbf{W} = [v_1 - w_1, v_2 - w_2, v_3 - w_3] \]

**Scalar Multiplication and Division**

Multiplying a vector by a scalar changes the vector's length, as does dividing the vector by a scalar.

\[ y \mathbf{V} = \mathbf{V} y = [yv_1, yv_2, yv_3] \]
\[ \mathbf{V} / y = [v_1 / y, v_2 / y, v_3 / y] \]

**Vector Length and Direction**

The length of a vector is obtained from the Pythagorean theorem.

\[ |\mathbf{V}| = \sqrt{v_1^2 + v_2^2 + v_3^2} \]
In 3ds Max expressions, the length() function returns this value.
The direction of the vector is the vector divided by its length; this gives you a unit vector with the same direction.

\[ \frac{\mathbf{V}}{|\mathbf{V}|} \]

The distance between two points is the length of the vector between them.

\[ |\mathbf{VW}| = |\mathbf{W} - \mathbf{V}| \]

*Subtracting vectors to obtain a distance*
The solid 3D objects in the scene, and the objects used to create them, are known as *geometry*. Usually, geometry comprises the subject of your scene and the objects that you render.

Villa with a swimming pool was created using a variety of geometry.

This section describes the types of geometry you can create using the *Create panel* on page 8182.

**See also:**
- [Surface Modeling](#) on page 2013
Basics of Creating and Modifying Objects

This section provides an introduction to techniques for creating and modeling objects.

The Create panel contains controls for creating new objects, the first step in building a scene. Despite the variety of object types, the creation process is consistent for most objects.

The Modify panel provides controls to complete the modeling process. You can rework any object, from its creation parameters to its internal geometry. Both object-space and world-space modifiers let you apply a wide range of effects to objects in your scene. The modifier stack allows editing of the modifier sequence.

In 3ds Max, you model basic parametric objects into more complex ones by:
- Changing parameters
- Applying modifiers
- Directly manipulating sub-object geometry

Varying the Parameters

Unlike physical objects, with a fixed shape and size, you can change the creation parameters of objects and shapes to dramatically alter topology. Here are some examples of changes you can make:
- Turn a cone into a four-sided pyramid by reducing the number of sides and turning the Smooth option off.
- Slice any circular object as if it were a pie.
- Animate almost all creation parameters, and interactively change their settings during animation playback.
- Render splines directly at any assigned width.
- Break, detach, and divide wall segments.
- Change the number of risers without affecting the overall rise of the stairs.

**Collapsing Primitives to Base Geometry**

You can collapse a geometric primitive or shape to one of a variety of base geometric types once you no longer need access to its creation parameters. For example, you can convert any standard primitive to an **editable mesh** on page 2192, **editable poly** on page 2240, **editable patch** on page 2360, or **NURBS** on page 2440 object, and you can convert a spline shape to an **editable mesh**, **editable spline** on page 620, or NURBS object. The easiest way to collapse an object is to select it, right-click it, and choose a "Convert to" option from the quad menu > Transform quadrant. This lets you use explicit editing methods with the object, such as transforming vertices. You can also use the Modify panel to collapse a primitive.

**Mapping Coordinates**

Most Geometry objects have an option for generating mapping coordinates. Objects need these mapping coordinates if you plan to apply a mapped material to them. Mapped materials include a wide range of rendered effects, from 2D bitmaps to reflections and refractions. See **Mapping Coordinates** on page 5636 and **Using Maps to Enhance a Material** on page 5627. If mapping coordinates have already been applied to an object, the check box for this feature is turned on.

**See also:**
- Using the Modify Panel on page 1041
- Using the Modifier Stack on page 1045
- Editing the Stack on page 1049
- Modifying at the Sub-Object Level on page 1054
- Using the Stack at the Sub-Object Level on page 1057
- Modifying Multiple Objects on page 1059
- How Instanced Modifiers Work on page 1063
- Transforms, Modifiers, and Object Data Flow on page 1034
Using the Create Panel

The Create panel provides the controls for creating objects and adjusting their parameters.

To access the Create panel:

1. Click the Create tab in the command panels on page 8181.
   By default, this panel is open when you start 3ds Max. If the command panel isn't visible, choose it from the Customize Display right-click menu on page 8239.
2. Click an object type to display its Parameters rollout.

The Creation Process

The actual creation of objects is accomplished with a single click of the mouse, a drag, or some combination, depending on the object type. This is the general sequence:

- Choose an object type.
- Click or drag in a viewport to create an object of approximate size and location.
- Adjust the object's parameters and position, either immediately or later.

See Creating an Object on page 364.

Create Panel Interface

Controls in the Create panel vary depending on the kind of object you are creating. However, certain controls are always present, and others are shared by nearly all object types.

**Category** Buttons at the top of the panel access the seven main categories of objects. Geometry is the default category.

**Subcategory** A list lets you select subcategories. For example, subcategories under Geometry include Standard Primitives, Extended Primitives, Compound Objects, Particle Systems, Patch Grids, NURBS Surfaces, and Dynamics Objects.

**Object Type** A rollout contains labeled buttons for creating objects in a particular subcategory, plus the AutoGrid on page 2792 check box.
Name and Color  The Name shows the automatically assigned name of the object. You can edit this name or replace it with another. (Different objects can have the same name, though this is not recommended.) Clicking the square color swatch brings up an Object Color dialog on page 368 to change the color of the object as it appears in viewports (the wireframe color).

Creation Method  This rollout provides a choice of how you use the mouse to create an object. For example, you can use either the center (radius) or edge (diameter) to define the size of a Circle shape.

A default creation method is always selected when you access the tool. If you want to use an alternate method, choose the option before you create the object. The creation method has no effect on a finished object; the options are for your convenience during creation.

Keyboard Entry  This rollout lets you enter creation parameters from the keyboard for geometric primitive and shape objects.

Parameters  This rollout shows creation parameters: the defining values for an object. Some parameters can be preset, while others are only for adjustment after an object has been created.

Other rollouts  Additional rollouts can appear on the Create panel, depending on what kind of object you create.

Identifying the Basic Building Blocks

On the Create panel, the categories for Geometry and Shapes supply the "building blocks" to combine and modify into more sophisticated objects. These parametric on page 8675 objects are ready to use. By adjusting values and turning some buttons on or off, you can create dozens of "new" building blocks from the ones listed here.

You can choose these types from the sub-categories list on the Create panel.

Geometry Types

Standard Primitives  Relatively simple 3D objects such as Box, Sphere, and Cylinder, as well as Torus, Plane, Cone, GeoSphere, Tube, Teapot, and Pyramid.

Extended Primitives  More complex 3D objects such as Capsule, OilTank, Spindle, Hedra, Torus Knot, and Prism.

Compound Objects  Compound objects include Scatter, Connect, ShapeMerge, Booleans, Morph, BlobMesh, Terrain, and Loft. Booleans combine the geometry
of two objects using union, intersection, and difference operations. Morphys
are animated objects that change one geometric shape into other shapes over
time. ShapeMerge lets you embed a spline shape into a geometric mesh. Loft
on page 742 uses shapes as cross sections along a path to produce a 3D object.

**Particle Systems** Animated objects that simulate spray, snow, blizzard, and
similar collections of small objects.

**Patch Grids** Simple 2D surfaces ready for modeling or repairing existing
meshes.

**NURBS Surfaces** Analytically generated surfaces especially suited for modeling
surfaces with complicated curves.

**AEC Extended** Elements useful for AEC design, including Terrain, Foliage
(plants and trees), Railing, for creating custom railings, and Wall, for the
production of Wall objects.

**Stairs** Four types of stairs: Spiral, L-Type, Straight, and U-Type.

**Doors** Parametric door styles include Pivot, BiFold, and Sliding.

**Windows** Parametric window styles include Awning, Fixed, Projected,
Casement, Pivoted, and Sliding.

**NOTE** Default materials are automatically applied to Foliage, as well as to the
following object types: Railing, Stairs, Doors, and Windows.

**Dynamics Objects** Objects designed for use in dynamics simulations.

**Shape Types**

**Splines** Common 2D shapes such as a Line, Rectangle, Circle, Ellipse, Arc,
Donut, NGon, and Star. Text shapes support TrueType fonts. Section creates
a spline from the cross-section of an object. Helix is a 3D shape.

**NURBS Curves** A Point Curve and CV Curve provide the starting points for
complex surfaces. See *Introduction to NURBS Modeling* on page 2416.

**Extended Splines** More complex 2D shapes including Walled Rectangle,
Channel Spline, Angle Spline, Tee Spline, and Wide Flange Spline. Extended
splines can be used in architectural and similar applications.
Varying the Parameters

Unlike physical building blocks, with fixed shape and size, you can change the parameters of objects and shapes to dramatically alter topology. Here are some examples of changes you can make:

- Turn a cone into a four-sided pyramid by reducing the number of sides and turning the Smooth option off.
- Slice any circular object as if it were a pie.
- Animate almost all creation parameters, and interactively change their settings during animation playback.
- Render splines directly at any assigned width.
- Break, detach, and divide wall segments.
- Change the number of risers without affecting the overall rise of the stairs.

Collapsing Primitives to Base Geometry

You can collapse a building-block object to one of a variety of base geometric types once you no longer need access to its creation parameters. For example, you can convert any standard primitive to an editable mesh on page 2192, editable poly on page 2240, editable patch on page 2360, or NURBS on page 2440 object, and you can convert a spline shape to an editable mesh, editable spline on page 620, or NURBS object. The easiest way to collapse an object is to select it, right-click it, and choose a "Convert to" option from the quad menu > Transform quadrant. This lets you use explicit editing methods with the object, such as transforming vertices. You can also use the Modify panel to collapse a primitive.

Mapping Coordinates

Most Geometry objects have an option for generating mapping coordinates. Objects need these mapping coordinates if you plan to apply a mapped material to them. Mapped materials include a wide range of rendered effects, from 2D bitmaps to reflections and refractions. See Mapping Coordinates on page 5636 and Using Maps to Enhance a Material on page 5627. If mapping coordinates have already been applied to an object, the check box for this feature is turned on.
Creating an Object

With some variations, the steps shown in the following images apply to creating any type of object on the Create panel. For specific examples, see the Procedures section in any object’s topic.

1. Radius defined
2. Height defined
3. Sides increased
4. Height Segments increased

To choose an object category:

1. Click the Create tab to view the Create panel.
2. Click one of the buttons at the top of the Create panel. For example, Geometry.
3. Choose the subcategory Standard Primitives from the list. A number of buttons appear on the Object Type rollout.

To choose an object type:

- Click the button for the type of object you want to create. The button highlights, showing that it is active. Four rollouts appear: Name and Color, Creation Method, Keyboard Entry, and Parameters.
To choose a creation method (optional):
You can accept the default method and skip this step.
■ Choose a method in the Creation Method rollout.

To preset the creation parameters (optional):
You can adjust all creation parameters after you create an object. Skip this step if you prefer.
■ In the Parameters rollout, you can set parameters before you create an object. However, the values of parameters you set by dragging the mouse (for example, the Radius and Height of a cylinder) have no effect until after you create the object.

To create the object:
1 Put the cursor at a point in any viewport where you want to place the object, and hold the mouse button down (do not release the button).
2 Drag the mouse to define the first parameter of the object; for example, the circular base of a cylinder.
3 Release the mouse button. The first parameter is set with this release. In some cases, such as Sphere, Teapot, and Plane, this completes the object. You can skip the remaining steps.
4 Move up or down without touching the mouse button. This sets the next parameter; for example, the height of a cylinder.
   If you want to cancel! Until you complete the next step, you can cancel the creation process with a right-click.
5 Click when the second parameter has the value you want, and so on.
The number of times you press or release the mouse button depends on how many spatial dimensions are required to define the object. (For some kinds of objects, such as Line and Bones, the number is open-ended.)

When the object is complete, it is in a selected state and ready for adjustments.

To name the object (optional):
■ Highlight the default object name in the Name and Color rollout, and then enter a name. This option is available only when a single object is selected.
Naming objects is a good practice for organizing your scenes. To name a set of selected objects, see Named Selection Sets on page 185.

**To change the object’s display color (optional):**

- The color swatch next to the object name field displays the selected object’s color and lets you select a new one. The color is the one used to display the object in viewports. Click the color swatch to display the Object Color dialog on page 368. You can also change object colors with Layers on page 7956.

**To adjust the object’s parameters:**

- You can change the creation parameters immediately after you complete an object, while it’s still selected. Or, you can select the object later and adjust its creation parameters on the Modify panel.

While making adjustments, you can use viewport navigation controls like Zoom, Pan, and Orbit to change your view of the selected object. You can also adjust the time slider.

**To end the creation process:**

While the object type button remains active, you can continue creating objects of the same type until you do one of the following:

1. Select an object other than the one you created most recently.
2. Transform an object.
3. Change to another command panel.
4. Use commands other than viewport navigation or the time slider.

After you end the creation process, changing parameters on the Create panel will have no effect on the object; you must go to the Modify panel to adjust the object’s parameters. See Using the Modify Panel on page 1041.

---

**Assigning Colors to Objects**

3ds Max is a truecolor program. When you pick a color in 3ds Max, you are specifying 24 bits of color data, which provide a range of over 16 million colors.
Object wireframe colors are used primarily as an organizational tool. Object naming strategies, named selection sets, and object wireframe color strategies provide a rich set of tools for organizing even the most complex scenes.

You can use two dialogs to specify colors:

- The Object Color dialog on page 368 contains two preset palettes of colors that you use to set an object’s wireframe color. This is also the surface color you see in a rendered viewport. The two color palettes are Default palette and AutoCAD ACI palette.

- The Color Selector on page 371 is a generic dialog that you use to define any color in the 24-bit color range. For the purpose of defining colors to assign to objects, it is available only through the Default palette.

The Layers functionality lets you organize your scene and can also be used for assigning object colors. For more information, see Layer Manager on page 7956.

**Object Color Dialog**

Click the color swatch by the object's name in any command panel.

The Object Color dialog contains two preset palettes of colors that you use to set an object’s wireframe color. This is also the surface color you see in a shaded viewport.

**Using Random Color Assignment**

By default, 3ds Max assigns colors randomly as objects are created. The colors are chosen from the current palette in the Object Color dialog. If you turn on Customize > Preferences > General panel on page 8299 > Default to By Layer for New Nodes, new objects are assigned the color set by the layer.

For individual objects, you can click the By Layer/By Object button on the Object Color dialog to change the method used to set the object color.

**Defining Custom Colors**

When using the 3ds Max palette, the Object Color dialog contains a palette of 16 custom color swatches. You can define any color for each of the 16 color swatches by selecting a swatch from the Custom Colors group, then clicking Add Custom Colors.
Switching Between Palettes

You can alternate between two versions of the Object Color dialog at any time by clicking the appropriate Basic Colors toggle:

- **3ds Max palette**: Contains a fixed palette of 64 colors, plus a custom palette of 16 user-defined custom colors.
  Use this version when you want to work with a smaller palette of colors or when you want to define custom object wireframe colors.

- **AutoCAD-compatible version**: Contains a fixed palette of 256 colors matching the colors in the AutoCAD Color Index (ACI).
  Use this version when you want to assign object colors that match the AutoCAD Color Index. Using ACI colors is useful if you plan to export objects to AutoCAD and want to organize them by object color, or when you want a wide selection of colors to choose from.

Procedures

To set object color:

This is the general procedure for selecting object color.

1. Select one or more objects.
2. On any command panel, click the color swatch to the right of the Object Name field to display the Object Color dialog.
3. On the Object Color dialog, click the By Layer / By Object toggle to set it to By Object.
4. Click a color swatch from the palette, and then click OK to apply the color to the selection.

To create objects of the same color:

- Choose the color you want to use and turn off Assign Random Colors. Newly created objects appear in this color until you change the setting.

To define a custom color:

1. With the 3ds Max palette option active, click one of the 16 custom color swatches.
2. Click Add Custom Colors to display the Color Selector on page 371.
Define a custom color and click Add Color.
The custom color is stored in the selected color swatch of the Object
Color dialog and is set as the current color.

To copy a custom color from an object in your scene to one of your custom
color swatches:

- Drag the Active Color swatch up to one of the custom color swatches.
The Active Color swatch is in the Object Color dialog, to the left of the
OK button.

To select objects by color:

- Click Select By Color. This displays the Select Objects dialog on page
206. All objects that have the same color as the current object are highlighted
in the list. Click Select.

Interface

Palette Choose one of these:

- **3ds Max palette** When chosen, the dialog displays Basic Colors and
  Custom Colors groups, and you have the option to add custom colors.
AutoCAD ACI palette

When chosen, the AutoCAD ACI palette is shown. When you click a color, its ACI# is displayed at the bottom of the dialog.

Basic Colors

A set of 64 default colors, available only when 3ds Max Palette is active.

Custom Colors

Displays 16 custom colors when 3ds Max Palette is active. To choose a custom color, click its swatch. To define or change a custom color, click its swatch and then click Add Custom Colors.

Add Custom Colors

Available only when 3ds Max Palette is active. Clicking this option displays the Color Selector on page 371, which allows you to modify the currently selected custom color. If you click Add Custom Colors with a basic color chosen, the dialog switches to the first custom color before opening the Color Selector.

By Layer/By Object

Sets the object’s color by layer or by object. If color is set by object, choosing a new color on the Object Color dialog changes the object’s wireframe color in viewports.

ACI# Displays the ACI number for the selected color. Available only when AutoCAD ACI palette is active.

Select by Color

Opens the Select Objects dialog on page 206 listing all objects that use the current color as their wireframe color.

NOTE

This button is available only if at least one object in the scene has the Current Color as its wireframe color.

Assign Random Colors

When on, 3ds Max will assign a random color to each object created. When off, 3ds Max will assign the same color to every object created until the color swatch is changed. This setting affects wireframe colors only when By Object is turned on as the color method.

Active/Current Color

Displays the active color (if no object is selected) or current color. When you click the color swatch, the Color Selector dialog on page 371 opens, where you can mix a custom color.

Color Selector Dialog

Any command panel > Name and Color fields > Click color swatch. > Object Color dialog > Add Custom Colors button or Current Color swatch.
Material Editor > Click any color swatch.
Select or add a light object. > Modify panel >
Intensity/Color/(Distribution/Attenuation) rollout > Click color or Filter Color swatch.

Rendering menu > Environment > Environment and Effects dialog > Click color swatch for Background, Tint, and Ambient components of Global Lighting, and various components of atmospheric effects such as Fire, Fog, and so on..

The Color Selector dialog lets you specify a custom color parameter in 3ds Max. You can work simultaneously with three different color models to help you zero in on the exact color you want.

You can use the Color Selector to specify many color parameters, such as light colors, material colors, background colors, and custom object colors. (Another way to choose an object's viewport color is to use the predefined colors in the Object Color dialog on page 368.)

In most contexts, the Color Selector is modeless on page 8641; that is, it remains on the screen until you dismiss it, and you can use other controls or work in a viewport while the dialog is still visible. In other contexts, the Color Selector is modal, and you must close the dialog before proceeding.

The dialog is divided into three different color selection models. You can use the controls for any model to define a color. The three color models are:

- **Hue/Blackness/Whiteness (HBW)**
  The most prominently displayed and intuitive color model is the HBW model. This model represents a natural, pigment-based way of mixing color by starting with a pure color (hue) and then making it darker by adding black, or lighter by adding white.
  The main feature of the HBW model is a large square box displaying the color spectrum. Across the top of this box you have the spectrum of pure colors, or hue. Down the side of the box you see increasing levels of blackness, making the color dark as you approach the bottom.
  To the right of the color spectrum box is the Whiteness box, which controls the amount of white in the color. Use higher positions to decrease the whiteness, or lower positions to increase the whiteness.

- **Red/Blue/Green (RGB)**
  The RGB model adjusts the mix of Red, Green, and Blue to define a color. This model represents the way colored light can be mixed. This is additive color mixing, as opposed to the subtractive color mixing for paint and other pigments. You can adjust values using the color sliders, the numeric
fields to their right (via the keyboard), or the spinners to the right of the numeric fields.

■ Hue/Saturation/Value (HSV)
The HSV color model adjusts Hue, Saturation, and Value. Hue sets the color; Saturation (labeled "Sat") sets the color's purity; and Value sets the color's brightness, or intensity. You can adjust values using the color sliders, the numeric fields to their right (via the keyboard), or the spinners to the right of the numeric fields.

As you adjust the controls of one color model, the controls of the other two models change to match. The color defined by the color model is displayed in the right half of the Color Output box. The original color, before you began making changes, is displayed in the left half.

Procedures

To display the Color Selector:

1. Click the color swatch of a color parameter such as the color of a light or of a material component.

   **NOTE** The object color displayed next to an object's name on command panels uses the Object Color dialog on page 368. On the Object Color dialog, clicking the Active (or Current) Color swatch or the Add Custom Colors button displays a Color Selector.

2. Make a color selection and click OK or Cancel, or the Close button (X).
   If using the Add Color version of the Color Selector, be sure to click Add Color first.

3. To revert to the original color, click Reset.

To choose the hue of a color, do one of the following:

1. Click anywhere in the Hue rainbow (the large, multicolored square).
2. Drag the Hue slider at the top of the rainbow.
3. Drag the Red, Green, and Blue sliders.
4. Drag the Hue slider.
5. Use the Red, Green, Blue, or Hue spinners.
To make a color lighter, do one of the following:

1. Drag the vertical Whiteness slider (at the right of the Hue rainbow) downward.
2. Drag the vertical Blackness slider (at the left of the Hue rainbow) upward.
3. Drag the Saturation (Sat.) slider to the left.
4. Use the Saturation spinner to decrease saturation.
5. Drag the Value slider to the right.
6. Use the Value spinner to increase the value.

To make a color darker, do one of the following:

1. Drag the vertical Whiteness slider (at the right of the Hue rainbow) upward.
2. Drag the vertical Blackness slider (at the left of the Hue rainbow) downward.
3. Drag the Saturation (Sat.) slider to the right.
4. Use the Saturation spinner to increase saturation.
5. Drag the Value slider to the left.
6. Use the Value spinner to decrease the value.

To return to the original color:

- Click Reset.
  The new color is replaced by the original color, and all parameter values are reset.

To dismiss the Color Selector, do one of the following:

1. Click Close.
2. Click OK or Cancel.
3. Click the dialog's Close (X) button.
Interface

Hue Define a pure color by dragging the hue pointer across the top of the box.

Blackness Drag the blackness pointer down the side to darken the pure color by adding black. You can also click or drag inside the box to change hue and blackness at the same time.

Whiteness The vertical bar to the right controls the amount of whiteness. The color set by the hue and blackness pointers is displayed at the top of the bar and pure white at the bottom. Drag the whiteness pointer down to lighten the color by adding white.

Red, Green, and Blue When a red, green, or blue slider is all the way to the left, its numeric field contains 0; none of the color controlled by that slider is used. If the slider is all the way to the right, the field reads 255; the maximum amount of that color is being used.

The spinners to the right of each slider are another way of setting the red, blue, or green component.

The colors in the sliders change to show an approximation of what the color result will be if you move the slider to that location, without adjusting any other color parameter.

Hue Sets the pure color. Locating the slider all the way to the left gives you pure red. As you drag the slider to the right you move through the spectrum of Red, Yellow, Green, Cyan, Blue, Magenta, and back to Red again. Hue is more accurately represented as a color wheel rather than a linear slider. That is why the Hue slider is red at both ends. Think of the hue range from 0 to
255 as being points on a circle where the numbers 0 and 255 are right next to each other.

**Saturation ("Sat")** Sets the purity or strength of the color. A weak color, with a saturation near 0, is dull and gray. A strong color, with a saturation near 255 is very bright and pure.

**Value** Sets the lightness or darkness of a color. Low values darken the color toward black. High values lighten the color toward white. A value in the middle, at a setting of 127, gives you the color defined only by hue and saturation.

**Color Output** This pair of color swatches, below the Value slider, lets you compare the new color, shown on the right, to the original color, shown on the left.

**Sample Screen Color** Lets you pick a new color from anywhere on the screen. After clicking this button, the mouse cursor changes to the eyedropper icon shown on the button. While this cursor appears, use any of these methods:

- Click anywhere on the screen to replace the current color with the color of the pixel under the lower-right corner of the cursor.
- Drag to continually update the current color with the color of the pixel under the lower-right corner of the cursor. This makes it easier to make sure you get the right color if the desired color area is small (say, a one-pixel-thick line).
- At any time, press and hold Shift to average the current color with colors the cursor moves over. Instead of replacing the current color with the new sampled color, smoothed sampling gradually mixes the sampled color with the current color, giving a smoothed color transition during sampling. This is useful for sampling noisy areas, where the variations in colors are accumulated to provide a representative general color.

Unlike the other methods, releasing the left mouse button only does not exit the sampler mode; you can move the mouse elsewhere (without sampling) and then start dragging again to continue smoothed sampling in other areas. Releasing Shift only returns to regular sampling. Releasing both Shift and the left mouse button exits the sampler mode, returning the mouse cursor and behavior to normal.

Sampling can occur under any conditions anywhere within any windows that belong to the current instance of 3ds Max. To sample anywhere outside of
3ds Max (for example, the desktop), drag the mouse from within one of these 3ds Max windows.

The color sampler tool compensates for any gamma applied to the color selector using the Customize > Preferences > Gamma And LUT on page 8330 > Affect Color Selectors option. This means that the color-corrected, displayed sampled visual color in the color selector always matches the on-screen visual color of the sampled location. If the gamma of the color selector does not match the gamma of the sampled location, the true color values (RGB/HSV) of the sampled color will differ from the true color values of the sampled location. This behavior applies to both regular gamma and Autodesk LUT gamma correction modes.

Reset Click to restore color settings to the original color.

OK Accepts any changes and closes the dialog.

NOTE If you opened the dialog by clicking Add Custom Colors on the Object Color dialog, the button label reads “Add Color.”

Cancel Restores the original color and closes the dialog.

**Color Selector for mental ray Materials and Shaders**

When you click a color swatch in the interface for a mental ray material on page 5772 or mental ray shader on page 6385, or a DirectX material on page 6175, you see a variant of the Color Selector.
This dialog differs from the standard Color Selector in two ways:

- The RGB and HSV values appear as normalized values between 0.0 and 1.0, rather than as 8-bit integers (0–255).
- An additional Alpha slider and spinner let you explicitly set the alpha value for this color. This value is also normalized, where 0.0 represents fully transparent, and 1.0 represents fully opaque.

This version of the Color Selector also appears when you use the DirectX Shader material on page 6175 and the mental ray renderer's Sampling Quality rollout on page 6735.

Color Clipboard Utility

Tools menu > Color Clipboard

Utilities panel > Utilities rollout > Color Clipboard button

The Color Clipboard utility stores color swatches for copying from one map or material to another.

For example, if in the Material Editor, you want to copy a color from a swatch in one level of a material to a swatch in another level (or from another material), there would be no way to do it with drag and drop. This is because you can't have two materials/maps visible at the same time. However, you can drag the color from one material to the color clipboard, switch to the other material, and then drag the color from the clipboard to the swatch in the new material.

You can save and load color clipboard files. The saved file, which is given a .ccb (color clipboard) extension, is an ASCII file that contains a palette description. The first 12 lines of the file consist of three RGB numbers, so you can easily edit or create your own clipboard files. This file format is also used by the VertexPaint modifier on page 1959.

Procedures

To copy a color from a swatch to the color clipboard:

1. On the Utilities panel, click Color Clipboard.
2. Open the Material Editor.
3. Select a color from any swatch in a material.
4 Drag the color to a swatch in the color clipboard.

5 A dialog appears asking if you want to copy or swap the material. Choose copy to replace the swatch in the color clipboard with the swatch from the material you selected. Choose swap to swap colors on the Color Clipboard swatch and material swatch.

Interface

**Color swatches** Click a color swatch to edit its value with the Color Selector.

**NOTE** The Color Selector invoked by this utility uses decimal numbers in the range 0.0 to 1.0, instead of integers in the range 0 to 255 as with other color-selection dialogs in 3ds Max.

**New Floater** Displays a floating clipboard with 12 slots, plus buttons for opening and saving color clipboard files. You can open up as many of these floaters as you want and you can minimize them. If you exit the Utilities panel or select the Close button to exit the Color Clipboard utility, any visible floaters remain open. When you close a floater, any changed values are lost.
Adjusting Normals and Smoothing

In general, you adjust normals and smoothing to prepare objects for rendering. A normal is a unit vector that defines which way a face or vertex is pointing. Smoothing groups define whether a surface is rendered with sharp edges or smooth surfaces.

The direction in which a normal points represents the front, or outer surface of a face or vertex, which is the side of the surface that is normally displayed and rendered. You can manually flip or unify face normals to fix surface errors caused by modeling operations or by importing meshes from other programs.

Smoothing groups are numbers assigned to the faces of an object. Each face can carry any number of smoothing groups, up to the maximum of 32. If two faces share an edge and share the same smoothing group, they render as a smooth surface. If they don’t share the same smoothing group, the edge between them renders as a corner. You can change and animate smoothing group assignments manually. Changing smoothing groups does not alter geometry in any way: it simply changes the way faces and edges are shaded.

Viewing and Changing Normals

When you create an object, normals are generated automatically. Usually objects render correctly using these default normals. Sometimes, however, you need to adjust the normals.
Left: The normals shown as spikes indicate the orientation of faces on the pyramid.
Right: Flipping normals can make faces invisible (or visible) in shaded viewports and renderings.

Undesired normals can appear in these objects:

- Meshes imported from other applications.
- Geometry generated by complex operations such as Boolean objects, lathe objects, or lofts.

Normals are used to define which side of a face or vertex is considered the "out" side. The out side of a face or vertex is the side that gets rendered unless you are using two-sided materials, or turn on the Force 2-Sided option in the Render Setup dialog > Common panel > Common Parameters rollout on page 6568.

Do one of the following to view or change face normals:

- Apply a Normal modifier on page 1551. If a Face sub-object selection is active, Normal applies to the selected faces. If no faces are selected, Normal applies to the entire object.
Apply an Edit Mesh modifier on page 1321, enable Face, Polygon or Element sub-object mode, and then use the features on the Surface Properties rollout to change the directions in which normals point.

Convert the object to an editable mesh on page 2192, enable Face, Polygon or Element sub-object mode, and use the features on the Surface Properties rollout.

**Viewing Normals**

The easiest way to view normals is to look at an object in a shaded viewport. In this case, you are not viewing the normal arrows themselves, but rather their effects on the shaded surface. If the object looks as if it is inside-out, or has holes, then some of the normals might be pointing in the wrong direction.

You can display the normal vectors for selected faces or vertices by enabling Show Normals on the Selection rollout of an editable mesh object or the Edit Mesh modifier.

**Unifying Normals**

Use Unify Normals to make normals point in a consistent direction. If an object has normals that are inconsistent (some point outward and others inward) the object will appear to have holes in its surface.

Unify Normals is found on the Surface Properties rollout and on the Normal modifier.

If you are animating the creation of a complex object such as a nested Boolean or a loft, and you think the operation might result in inconsistent faces, apply a Normal modifier on page 1551 to the result, and turn on Unify Normals.

**Flipping Normals**

Use Flip Normals to reverse the direction of all selected faces. Flipping the normals of an object turns it inside-out.

Flip Normals is found on the Surface Properties rollout and on the Normal modifier.

The Lathe modifier on page 1474 sometimes creates an object with normals pointing inward. Use the Flip Normals check box on the Lathe modifier's Parameters rollout to adjust the normals. You can also use the Normal modifier with both Unify and Flip turned on to fix inside-out lathed objects.
Viewing and Changing Smoothing

Smoothing blends the shading at the edges between faces to produce the appearance of a smooth, curved surface. You can control how smoothing is applied to a surface so your objects can have both smooth surfaces and sharp, faceted edges where appropriate.

The face labeled “1-2” shares smoothing groups with adjacent faces, so the edges between them are smoothed over in renderings.

The face labeled “3” does not share a smoothing group, so its edge is visible in renderings.

Smoothing does not affect geometry. It affects only the way geometry is colored when rendered.

Smoothing is controlled by smoothing groups, which are numbered groups ranging from 1 to 32. You can assign each face to one or more smoothing groups. When a scene is rendered, the renderer checks each adjacent pair of faces to see if they share a smoothing group, and renders the object as follows:

- If faces have no smoothing groups in common, the faces are rendered with a sharp edge between them.
If faces have at least one smoothing group in common, the edge between the faces is “smoothed”, meaning it is shaded in such a way that the area where the faces meet appears smooth.

Because each face has three edges, only three smoothing groups can be in effect for any face. Extra smoothing groups assigned to a face are ignored.

Do one of the following to view or change smoothing group assignments:

■ Turn on the Smooth check box on the Parameters rollout of a parametric object to set default smoothing for the object.

■ Turn on the Auto Smooth check box on the Rendering rollout of a spline shape to turn on smoothing.

■ Apply a Smooth modifier on page 1733. If a Face sub-object selection is active, Smooth applies to the selected faces. If no faces are selected, Smooth applies to the entire object.

■ Convert the object to editable poly on page 2240 format or apply the Edit Poly modifier on page 1332, access the Polygon or Element sub-object level, then use the features on the Polygon: Smoothing Groups rollout.

■ Convert the object to editable mesh on page 2192 format or apply the Edit Mesh modifier on page 1321, access the Face (or Polygon or Element) sub-object level, then use the features on the Surface Properties rollout.

**Viewing Smoothing Groups**

The easiest way to view smoothing is to look at an object in a shaded viewport. In this case, you are not viewing the smoothing groups themselves but rather their effects on the shaded surface.

You can see the smoothing group numbers for selected faces of an editable mesh object or the Edit Mesh modifier by looking at the Smoothing Group buttons on the Surface Properties rollout, or of an editable poly object on the Polygon Properties rollout.

Smoothing Group buttons appear as follows:

■ Group numbers not used by any face in the selection, appear normal.

■ Group numbers used by all faces in the selection, appear selected.

■ Group numbers used by some, but not all, faces in the selection, appear blank.
Automatically Smoothing an Object

Click Auto Smooth to assign smoothing automatically. You set a Threshold angle to determine whether to smooth adjacent faces.

- If the angle between face normals is less than or equal to the threshold, the faces are assigned to a common smoothing group.
- If the angle between face normals is greater than the threshold, the faces are assigned to separate groups.

Auto Smooth is found on the Surface Properties rollout and on the Smooth modifier.

Manually Applying Smoothing Groups

You manually assign smoothing groups to a selection of faces by clicking Smoothing Group buttons on the Surface Properties rollout or the Smooth modifier. The smoothing group of each button you click is assigned to the selection.

Selecting Faces by Smoothing Group

You can also select faces according to the assigned smoothing groups. Click Select By SG on the Surface Properties rollout (editable mesh) or Polygon Properties rollout (editable poly) and then click the smoothing group of the faces to select.

This is a convenient way to examine smoothing groups on an object someone else created.

Geometric Primitives

Geometric primitives are basic shapes that 3ds Max provides as parametric objects on page 8675. Primitives are divided into two categories: standard primitives and extended primitives.

See also:

- Basics of Creating and Modifying Objects on page 358
- Creating an Object on page 364
Creating Primitives from the Keyboard

You can create most geometric primitives from your keyboard using the Keyboard Entry rollout. In a single operation, you define both the initial size of an object and its three-dimensional position. 3ds Max automatically assigns the object’s name and color. See Object Name and Wireframe Color on page 8182.

This method is generally the same for all primitives; differences occur in the type and number of parameters. The Hedra primitive, a complex and highly visual family of objects, is unsuited to this method and has no keyboard entry.

Procedures

To open the Keyboard Entry rollout:

1. On the Create panel for Standard or Extended Primitives, click any of the primitive Object Type rollout buttons, except Hedra, RingWave, or Hose.
2. Click the Keyboard Entry rollout to open it. This rollout is closed by default.

   **NOTE** The buttons on the Creation Method rollout have no effect on keyboard entry.

To create a primitive from the keyboard:

1. On the Keyboard Entry rollout, select a numeric field with the mouse and then enter a number.
2. Press Tab to move to the next field. You do not have to press Enter after entering a value. Press Shift+Tab to reverse direction.
3. When you have all fields set, click Create.
4. The object appears in the active viewport.

Once created, a new primitive is unaffected by the numeric fields in the Keyboard Entry rollout. You can adjust parameter values on the Parameters rollout, either immediately after creation or on the Modify panel.
Interface

The Keyboard Entry rollout contains a common set of position fields, labeled X, Y, and Z. The numbers you enter are offsets along the axes of the active construction plane; either the home grid or a grid object. Plus and minus values correspond to positive and negative directions for these axes. Defaults=0,0,0; the center of the active grid.

The location set by X,Y is equivalent to the first mouse-down position in the standard method of creating objects.

Each standard primitive has the following parameters on its Keyboard Entry rollout.

<table>
<thead>
<tr>
<th>Primitive</th>
<th>Parameters</th>
<th>XYZ point</th>
</tr>
</thead>
<tbody>
<tr>
<td>Box</td>
<td>Length, Width, Height</td>
<td>Center of base</td>
</tr>
<tr>
<td>Cone</td>
<td>Radius 1, Radius 2, Height</td>
<td>Center of base</td>
</tr>
<tr>
<td>Sphere</td>
<td>Radius</td>
<td>Center</td>
</tr>
<tr>
<td>GeoSphere</td>
<td>Radius</td>
<td>Center</td>
</tr>
<tr>
<td>Cylinder</td>
<td>Radius, Height</td>
<td>Center of base</td>
</tr>
<tr>
<td>Tube</td>
<td>Radius 1, Radius 2, Height</td>
<td>Center of base</td>
</tr>
<tr>
<td>Torus</td>
<td>Radius 1, Radius 2</td>
<td>Center</td>
</tr>
<tr>
<td>Pyramid</td>
<td>Width, Depth, Height</td>
<td>Center of base</td>
</tr>
</tbody>
</table>

Creating Primitives from the Keyboard | 387
Standard Primitives

Geometric primitives are familiar as objects in the real world such as beach balls, pipes, boxes, doughnuts, and ice cream cones. In 3ds Max, you can model many such objects using a single primitive. You can also combine primitives into more complex objects, and further refine them with modifiers.

A collection of standard primitive objects
3ds Max includes a set of 10 basic primitives. You can easily create the primitives with the mouse in the viewport, and most can be generated from the keyboard as well. These primitives are listed in the Object Type rollout and on the Create menu on page 8008.

Also available from the Object Type rollout is the AutoGrid option on page 2792.

You can convert standard primitive objects to editable mesh objects on page 2192, editable poly objects on page 2240, and NURBS surfaces on page 2483. You can also convert primitives to patch objects; see the path annotation at Editable Patch on page 2360 (the information at the start of the topic that tells you how to create this type of object).

All primitives have name and color controls, and allow you to enter initial values from the keyboard. See these topics:

Object Name and Wireframe Color on page 8182
Creating Primitives from the Keyboard on page 386

The remaining rollouts are covered in the topic for each primitive.

**Box Primitive**

Create panel > Geometry button > Standard Primitives > Object Type rollout > Box button

Create menu > Standard Primitives > Box

Box produces one of the simplest of the primitives. Cube is the only variation of Box. However, you can vary the scale and proportion to make many different kinds of rectangular objects, from large, flat panels and slabs to tall columns and small blocks.
Examples of boxes

Procedures

To create a box:

1. On the Object Type rollout, click Box.
2. In any viewport, drag to define a rectangular base, then release to set length and width.
3. Move the mouse up or down to define the height.
4. Click to set the finished height and create the box.

To create a box with a square base:

- Hold down Ctrl as you drag the base of the box. This keeps length and width the same. Holding the Ctrl key has no effect on height.

To create a cube:

1. On the Creation Method rollout, choose Cube.
2 In any viewport, drag to define the size of the cube.
3 As you drag, a cube emerges with the pivot point at the center of its base.
4 Release to set the dimensions of all sides.

Interface

Creation Method rollout

**Cube** Forces length, width, and height to be equal. Creating a cube is a one-step operation. Starting at the center of the cube, drag in a viewport to set all three dimensions simultaneously. You can change a cube's individual dimensions in the Parameters rollout.

**Box** Creates a standard box primitive from one corner to the diagonally opposite corner, with different settings for length, width, and height.

Parameters rollout

The defaults produce a box with one segment on each side.

**Length, Width, Height** Sets the length, width, and height of the Box object. These fields also act as readouts while you drag the sides of the box. Default=0,0,0.

**Length, Width, Height Segments** Sets the number of divisions along each axis of the object. Can be set before or after creation. By default, each side of
the box is a single segment. When you reset these values, the new values become the default during a session. Default=1,1,1.

**TIP** Increase the Segments settings to give objects extra resolution for being affected by modifiers. For example, if you're going to bend on page 1165 a box on the Z axis, you might want to set its Height Segments parameter to 4 or more.

**Generate Mapping Coords** Generates coordinates for applying mapped materials to the box. Default=on.

**Real-World Map Size** Controls the scaling method used for texture mapped materials that are applied to the object. The scaling values are controlled by the Use Real-World Scale settings found in the applied material's Coordinates rollout on page 6201. Default=off.

### Cone Primitive

Create panel > Geometry button > Standard Primitives > Object Type rollout > Cone button

Create menu > Standard Primitives > Cone

The Cone button on the Creation command panel lets you produce round cones, either upright or inverted.
Examples of cones

Procedures

To create a cone:

1 On the Create menu choose Standard Primitives > Cone.

2 In any viewport, drag to define a radius for the base of the cone, then release to set it.

3 Move to up or down to define a height, either positive or negative, then click to set it.

4 Move to define a radius for the other end of the cone. Decrease this radius to 0 for a pointed cone.

5 Click to set the second radius and create the cone.
Interface

Creation Method rollout

Edge Draws a cone from edge to edge. You can change the center location by moving the mouse.

Center Draws a cone from the center out.

Parameters rollout

The defaults produce a smooth, round cone of 24 sides with five height segments, one cap segment, and the pivot point at the center of the base. For improved rendering of smoothly shaded cones, particularly those with pointed tips, increase the number of height segments.

Radius 1, Radius 2 Set the first and second radii for the cone. The minimum value for both is 0.0. If you enter a negative value, 3ds Max converts it to 0.0. You can combine these settings to create pointed and flat-topped cones, upright or inverted. The following combinations assume a positive height:

<table>
<thead>
<tr>
<th>Radius Combinations</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>Radius 2 is 0</td>
<td>Creates a pointed cone</td>
</tr>
</tbody>
</table>
### Radius Combinations

<table>
<thead>
<tr>
<th>Radius Combinations</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>Radius 1 is 0</td>
<td>Creates an inverted pointed cone</td>
</tr>
<tr>
<td>Radius 1 is larger than Radius 2</td>
<td>Creates a flat-topped cone</td>
</tr>
<tr>
<td>Radius 2 is larger than Radius 1</td>
<td>Creates an inverted flat-topped cone</td>
</tr>
</tbody>
</table>

If Radius 1 and 2 are the same, a cylinder is created. If the two radius settings are close in size, the effect is similar to applying a Taper modifier to a cylinder.

### Effect of Radius settings

- **Height** Sets dimension along the central axis. Negative values create the cone below the construction plane.

- **Height Segments** Sets the number of divisions along the cone’s major axis.

- **Cap Segments** Sets the number of concentric divisions around the center of the cone’s top and bottom.

- **Sides** Sets the number of sides around the cone. Higher numbers shade and render as true circles with Smooth selected. Lower numbers create regular polygonal objects with Smooth off.

- **Smooth** Blends the faces of the cone, creating a smooth appearance in rendered views.

- **Slice On** Enables the Slice function. Default=off.
  
  When you create a slice and then turn off Slice On, the complete cone reappears. You can use this check box to switch between the two topologies.

- **Slice From, Slice To** Sets the number of degrees around the local Z axis from a zero point at the local X axis.
  
  For both settings, positive values move the end of the slice counterclockwise; negative values move it clockwise. Either setting can be made first. When the ends meet, the whole cone reappears.
**Generate Mapping Coords** Generates coordinates for applying mapped materials to the cone. Default=on.

**Real-World Map Size** Controls the scaling method used for texture mapped materials that are applied to the object. The scaling values are controlled by the Use Real-World Scale settings found in the applied material's Coordinates rollout on page 6201. Default=off.

---

**Sphere Primitive**

Create panel > Geometry button > Standard Primitives > Object Type rollout > Sphere button

Create menu > Standard Primitives > Sphere

Sphere produces a full sphere, or a hemisphere or other portion of a sphere. You can also "slice" a sphere about its vertical axis.

![Examples of spheres](image)

---

396 | Chapter 6  Creating Geometry
Procedures

To create a sphere:

1  On the Create menu choose Standard Primitives > Sphere.
2  In any viewport, drag to define a radius.
   As you drag, a sphere emerges with its center at the pivot point.
3  Release the mouse to set the radius and create the sphere.

To create a hemisphere:

You can reverse the order of the following steps, if you like.

1  Create a sphere of desired radius.
2  Type 0.5 in the Hemisphere field.
   The sphere is reduced to exactly the upper half, a hemisphere. If you use
   the spinner, the sphere changes in size.

Interface

Creation Method rollout

Edge  Draws a sphere from edge to edge. You can change the center location
   by moving the mouse.

Center  Draws a sphere from the center out.
Parameters rollout

The defaults produce a smooth sphere of 32 segments with the pivot point at its center.

**Radius** Specifies the radius of the sphere.

**Segments** Sets the number of polygonal divisions for the sphere.

**Smooth** Blends the faces of the sphere, creating a smooth appearance in rendered views.

**Hemisphere** Increasing values progressively will "cut off" the sphere, starting at the base, to create a partial sphere. Values range from 0.0 to 1.0. The default is 0.0, producing a full sphere. A setting of 0.5 produces a hemisphere, and 1.0 reduces the sphere to nothing. Default=0.0.

Chop and Squash toggle creation options for Hemisphere.

**Chop** Reduces the number of vertices and faces in the sphere by "chopping" them out as the hemisphere is cut off. Default=on.

**Squash** Maintains the number of vertices and faces in the original sphere, "squashing" the geometry into a smaller and smaller volume toward the top of the sphere.
Effects of Chop and Squash during hemisphere creation

**Slice On** Uses the From and To angles to create a partial sphere. The effect is similar to lathing a semicircular shape fewer than 360 degrees.

**Slice From** Sets the start angle.

**Slice To** Sets the stop angle.

For both settings, positive values move the end of the slice counterclockwise; negative values move it clockwise. Either setting can be made first. When the ends meet, the whole sphere reappears.

Smoothing groups are assigned to sliced spheres as follows: The surface of the sphere is always assigned group 1; the bottom, when Smooth is on, gets group 2. Facing the pie-slice surfaces, the cut on the left gets group 3, and the cut on the right gets group 4.

Material IDs are assigned to sliced spheres as follows: The bottom is 1 (when Hemisphere is greater than 0.0), the surface is 2, and the slice surfaces are 3 and 4.

**Base To Pivot** Moves a sphere upward along its local Z axis so the pivot point is at its base. When off, the pivot point is on the construction plane at the center of the sphere. Default=off.

Turning on Base To Pivot lets you place spheres so they rest on the construction plane, like pool balls on a table. It also lets you animate a hemisphere so it appears to grow out of the construction plane or sink into it.
Effect of using Base To Pivot setting

**Generate Mapping Coords** Generates coordinates for applying mapped materials to the sphere. Default=on.

**Real-World Map Size** Controls the scaling method used for texture mapped materials that are applied to the object. The scaling values are controlled by the Use Real-World Scale settings found in the applied material’s Coordinates rollout on page 6201. Default=off.
GeoSphere Primitive

Create panel > Geometry button > Standard Primitives > Object Type rollout > GeoSphere button

Create menu > Standard Primitives > GeoSphere

Use GeoSphere to make spheres and hemispheres based on three classes of regular polyhedrons.

Examples of geospheres

Geospheres produce a more regular surface than standard spheres. They also render with a slightly smoother profile than a standard sphere given the same number of faces. Unlike a standard sphere, a geosphere has no poles, which can be an advantage when you apply certain modifiers such as Free-Form Deformation (FFD) modifiers on page 1436.

Procedures

To create a geosphere:

2 In any viewport, drag to set the center and radius of the geosphere.
3 Set parameters such as Geodesic Base Type and Segments.

To create a geo-hemisphere:

1 Create a geosphere.
2 In the Parameters rollout, turn on the Hemisphere check box. The geosphere is converted to a hemisphere.

Interface

Creation Method rollout

Diameter Draws a geosphere from edge to edge. You can change the center location by moving the mouse.
Center Draws a geosphere from the center out.

Parameters rollout

Radius Sets the size of the geosphere.
Segments Sets the total number of faces in the geosphere. The number of faces in a geosphere is equal to the sides of the base polyhedron times the segments squared.
Lower segment values work best. Using the maximum segment value of 200 can generate up to 800,000 faces, impairing performance.

**Geodesic Base Type group**

Lets you choose one of three types of regular polyhedrons for the geosphere's basic geometry.

- **Tetra** Based on a four-sided tetrahedron. The triangular facets can vary in shape and size. The sphere can be divided into four equal segments.

- **Octa** Based on an eight-sided octahedron. The triangular facets can vary in shape and size. The sphere can be divided into eight equal segments.

- **Icosa** Based on a 20-sided icosahedron. The facets are all equally sized equilateral triangles. The sphere can be divided into any number of equal segments, based on multiples and divisions of 20 faces.

**Smooth** Applies smoothing groups to the surface of the sphere.

**Hemisphere** Creates a half-sphere.

**Base To Pivot** Sets the pivot point location. When on, the pivot is at the bottom of the sphere. When off, the pivot is at the center of the sphere. This option has no effect when Hemisphere is on.

**Generate Mapping Coords** Generates coordinates for applying mapped materials to the geosphere. Default=on.

**Real-World Map Size** Controls the scaling method used for texture mapped materials that are applied to the object. The scaling values are controlled by the Use Real-World Scale settings found in the applied material's Coordinates rollout on page 6201. Default=off.

**Cylinder Primitive**

Create panel > Geometry button > Standard Primitives > Object Type rollout > Cylinder button

Create menu > Standard Primitives > Cylinder

Cylinder produces a cylinder, which you can "slice" around its major axis.
Examples of cylinders

Procedures

To create a cylinder:

2. In any viewport, drag to define the radius of the base, then release to set the radius.
3. Move up or down to define a height, either positive or negative.
4. Click to set the height and create the cylinder.

Interface

Creation Method rollout

Edge Draws a cylinder from edge to edge. You can change the center location by moving the mouse.

Center Draws a cylinder from the center out.
The defaults produce a smooth cylinder of 18 sides with the pivot point at the center of the base. There are five height segments and one cap segment. If you don't plan to modify the cylinder's shape, such as with a Bend modifier, set Height Segments to 1 to reduce scene complexity. If you plan to modify the ends of the cylinder, consider increasing the Cap Segments setting.

**Radius** Sets the radius of the cylinder.

**Height** Sets the dimension along the central axis. Negative values create the cylinder below the construction plane.

**Height Segments** Sets the number of divisions along the cylinder's major axis.

**Cap Segments** Sets the number of concentric divisions around the center of the cylinder's top and bottom.

**Sides** Sets the number of sides around the cylinder. With Smooth on, higher numbers shade and render as true circles. With Smooth off, lower numbers create regular polygonal objects.

**Smooth** The faces of the cylinder are blended together, creating a smooth appearance in rendered views.

**Slice On** Enables the Slice function. Default=off.
When you create a slice and then turn off Slice On, the complete cylinder reappears. You can use this check box to switch between the two topologies.

**Slice From, Slice To** Sets the number of degrees around the local Z axis from a zero point at the local X axis.

For both settings, positive values move the end of the slice counterclockwise; negative values move it clockwise. Either setting can be made first. When the ends meet, the whole cylinder reappears.

**Generate Mapping Coords** Generates coordinates for applying mapped materials to the cylinder. Default=on.

**Real-World Map Size** Controls the scaling method used for texture mapped materials that are applied to the object. The scaling values are controlled by the Use Real-World Scale settings found in the applied material's Coordinates rollout on page 6201. Default=off.

---

**Tube Primitive**

Create panel > Geometry button > Standard Primitives > Object Type rollout > Tube button

Create menu > Standard Primitives > Tube

Tube produces both round and prismatic tubes. The tube is similar to the cylinder with a hole in it.
Examples of tubes

Procedures

To create a tube:
2. In any viewport, drag to define the first radius, which can be either the inner or outer radius of the tube. Release to set the first radius.
3. Move to define the second radius, then click to set it.
4. Move up or down to define a height, either positive or negative.
5. Click to set the height and create the tube.

To create a prismatic tube:
1. Set the number of sides for the kind of prism you want.
2. Turn Smooth off.
3. Create a tube.
**Interface**

**Creation Method rollout**

*Edge* Draws a tube from edge to edge. You can change the center location by moving the mouse.

*Center* Draws a tube from the center out.

**Parameters rollout**

The defaults produce a smooth, round tube of 18 sides with the pivot point at the center of the base. There are five height segments and one cap segment. If you don’t plan to modify the cylinder’s shape, such as with a Bend modifier, set Height Segments to 1 to reduce scene complexity. If you plan to modify the ends of the cylinder, consider increasing the Cap Segments setting.

**Radius 1, Radius 2** The larger setting specifies the outside radius of the tube, while the smaller specifies the inside radius.

**Height** Sets the dimension along the central axis. Negative values create the tube below the construction plane.

**Height Segments** Sets the number of divisions along the tube’s major axis.
**Cap Segments** Sets the number of concentric divisions around the center of the tube's top and bottom.

**Sides** Sets the number of sides around the tube. Higher numbers shade and render as true circles with Smooth on. Lower numbers create regular polygonal objects with Smooth off.

**Smooth** When on (the default), faces of the tube are blended together, creating a smooth appearance in rendered views.

**Slice On** Enables the Slice feature, which removes part of the tube's circumference. Default=off.

When you create a slice and then turn off Slice On, the complete tube reappears. You can therefore use this check box to switch between the two topologies.

**Slice From, Slice To** Sets the number of degrees around the local Z axis from a zero point at the local X axis.

For both settings, positive values move the end of the slice counterclockwise; negative values move it clockwise. Either setting can be made first. When the ends meet, the whole tube reappears.

**Generate Mapping Coords** Generates coordinates for applying mapped materials to the tube. Default=on.

**Real-World Map Size** Controls the scaling method used for texture mapped materials that are applied to the object. The scaling values are controlled by the Use Real-World Scale settings found in the applied material's Coordinates rollout on page 6201. Default=off.

---

**Torus Primitive**

Create panel > Geometry button > Standard Primitives > Object Type rollout > Torus button

Create menu > Standard Primitives > Torus

Torus produces a torus, or a ring with a circular cross section, sometimes referred to as a doughnut. You can combine three smoothing options with rotation and twist settings to create complex variations.
Examples of tori

Procedures

To create a torus:

1. From the Create menu, choose Standard Primitives > Torus.
2. In any viewport, drag to define a torus.
3. As you drag, a torus emerges with its center at the pivot point.
4. Release to set the radius of the torus ring.
5. Move to define the radius of the cross-sectional circle, then click to create the torus.

Interface

Creation Method rollout

Edge: Draws a torus from edge to edge. You can change the center location by moving the mouse.
Center Draws a torus from the center out.

Parameters rollout

The defaults produce a smooth torus with 12 sides and 24 segments. The pivot point is at the center of the torus on the plane, cutting through the center of the torus. Higher settings for sides and segments produce a more dense geometry that might be required for some modeling or rendering situations.

Radius 1 Sets the distance from the center of the torus to the center of the cross-sectional circle. This is the radius of the torus ring.

Radius 2 Sets the radius of the cross-sectional circle. This value is replaced each time you create a torus. Default = 10.
Rotation 1 and Rotation 2

**Rotation** Sets the degree of rotation. Vertices are uniformly rotated about the circle running through the center of the torus ring. Positive and negative values for this setting “roll” the vertices in either direction over the surface of the torus.

**Rotation and Twist**

**Twist** Sets the degree of twist. Cross sections are progressively rotated about the circle running through the center of the torus. Beginning with twist, each successive cross section is rotated until the last one has the number of degrees specified.

Twisting a closed (unsliced) torus creates a constriction in the first segment. You can avoid this by either twisting in increments of 360 degrees, or by turning Slice on and setting both Slice From and Slice To to 0 to maintain a complete torus.

**Segments** Sets the number of radial divisions around the torus. By reducing this number, you can create polygonal rings instead of circular ones.

**Sides** Sets the number of sides on the cross-sectional circle of the torus. By reducing this number, you can create prism-like cross sections instead of circular ones.

**Smooth group**

Choose one of four levels of smoothing:

- **All** (default) Produces complete smoothing on all surfaces of the torus.
- **Sides** Smooths the edges between adjacent segments, producing smooth bands running around the torus.
- **None**  Turns off smoothing entirely, producing prism-like facets on the torus.

- **Segments**  Smooths each segment individually, producing ring-like segments along the torus.

**Slice On**  Creates a portion of a sliced torus rather than the entire 360 degrees.

**Slice From**  When Slice On is on, specifies the angle where the torus slice begins.

**Slice To**  When Slice On is on, specifies the angle where the torus slice ends.

**Generate Mapping Coords**  Generates coordinates for applying mapped materials to the torus. Default=on.

**Real-World Map Size**  Controls the scaling method used for texture mapped materials that are applied to the object. The scaling values are controlled by the Use Real-World Scale settings found in the applied material's Coordinates rollout on page 6201. Default=off.

**Pyramid Primitive**

Create panel > Geometry button > Standard Primitives > Object Type rollout > Pyramid button

Create menu > Standard Primitives > Pyramid

The Pyramid primitive has a square or rectangular base and triangular sides.
Examples of pyramids

Procedures

To create a Pyramid:

2. Choose a creation method, either Base/Apex or Center.

   NOTE Hold the Ctrl key while using either creation method to constrain the base to a square.

3. In any viewport, drag to define the base of the pyramid. If you're using Base/Apex, define the opposite corners of the base, moving the mouse horizontally or vertically to define the width and depth of the base. If you're using Center, drag from the center of the base.
4. Click, and then move the mouse to define the Height.
5. Click to complete the pyramid.
Interface

Creation Method rollout

**Base/Apex** Creates the pyramid base from one corner to the diagonally opposite corner.

**Center** Creates the pyramid base from the center out.

Parameters rollout

![Parameters rollout](image)

**Width, Depth and Height** Sets the dimension of the corresponding side of the pyramid.

**Width, Depth and Height Segs** Sets the number of segments to the corresponding sides of the pyramid.

**Generate Mapping Coords** Generates coordinates for applying mapped materials to the pyramid. Default=on.

**Real-World Map Size** Controls the scaling method used for texture mapped materials that are applied to the object. The scaling values are controlled by the Use Real-World Scale settings found in the applied material's Coordinates rollout on page 6201. Default=off.
Teapot Primitive

Create panel > Geometry button > Standard Primitives > Object Type rollout > Teapot button

Create menu > Standard Primitives > Teapot

Teapot produces a teapot. You can choose to make the whole teapot at once (the default), or any of its parts. Since the Teapot is a parametric object, you can choose which parts of the teapot to display after creation.

Examples of teapots

History of the Teapot

This teapot derives from the original data developed by Martin Newell in 1975. Beginning with a graph-paper sketch of a teapot that he kept on his desk, Newell calculated cubic Bezier splines on page 8519 to create a wireframe model. James Blinn, also at the University of Utah during this period, produced early renderings of exceptional quality using this model.
The teapot has since become a classic in computer graphics. Its complexly curved and intersecting surfaces are well suited to testing different kinds of material mappings and rendering settings on a real-world object.

**Procedures**

**To create a teapot:**

2. In any viewport, drag to define a radius.
   As you drag, a teapot emerges with the pivot point at the center of its base.
3. Release the mouse to set the radius and create the teapot.

**To create a teapot part:**

1. In Parameters rollout > Teapot Parts group, turn off all parts except the one you want to create.
2. Create a teapot.
   The part you left on appears. The pivot point remains at the center of the teapot's base.
3. In Parameters rollout > Teapot Parts group, turn off all parts except the one you want.

The teapot has four separate parts: body, handle, spout, and lid. Controls are located in the Teapot Parts group of the Parameters rollout. You can check any combination of parts to create at the same time. The body alone is a ready-made bowl, or a pot with optional lid.

**To turn a part into a teapot:**

1. Select a teapot part in the viewport.
2. On the Modify panel > Parameters rollout, turn on all parts. (This is the default.)
   The whole teapot appears.

You can apply modifiers to any separate part. If you later turn on another part, the modifier affects the additional geometry as well.
Interface

Creation Method rollout

Edge Draws a teapot from edge to edge. You can change the center location by moving the mouse.

Center Draws a teapot from the center out.

Parameters rollout

Radius Sets the radius of the teapot

Segments Sets the number of divisions for the teapot or its individual parts.

Smooth Blends faces of the teapot, creating a smooth appearance in rendered views.

Teapot Parts group

Turn check boxes on or off for teapot parts. By default, all are on, producing a complete teapot.

Generate Mapping Coords Generates coordinates for applying mapped materials to the teapot. Default=on.
Real-World Map Size  Controls the scaling method used for texture mapped materials that are applied to the object. The scaling values are controlled by the Use Real-World Scale settings found in the applied material's Coordinates rollout on page 6201. Default=off.

Plane Primitive

Create panel > Geometry button > Standard Primitives > Object Type rollout > Plane button
Create menu > Standard Primitives > Plane

The Plane object is a special type of flat polygon mesh that can be enlarged by any amount at render time. You can specify factors to magnify the size or number of segments, or both. Use the Plane object for creating a large-scale ground plane that doesn't get in the way when working in a viewport. You can apply any type of modifier to the plane object, such as Displace on page 1313 to simulate a hilly terrain.

Example of plane
Procedures

To create a plane:

2. In any viewport, drag to create the Plane.

Interface

Creation Method rollout

Rectangle: Creates the plane primitive from one corner to the diagonally opposite corner, interactively setting different values for length and width.

Square: Creates a square plane where length and width are equal. You can change dimensions in the Parameters rollout subsequent to creation.

Parameters rollout

<table>
<thead>
<tr>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Length: 0.0</td>
</tr>
<tr>
<td>Width: 0.0</td>
</tr>
<tr>
<td>Length Segs: 4</td>
</tr>
<tr>
<td>Width Segs: 4</td>
</tr>
</tbody>
</table>

Render Multipliers:

| Scale: 1.0          |
| Density: 1.0        |
| Total Faces: 32     |

Generate Mapping Coords: 

Real-World Map Size: 

Length, Width: Sets the length and width of the plane object. These fields act also as readouts while you drag the sides of the box. You can revise these values. Defaults= 0.0, 0.0.
Length Segs, Width Segs Sets the number of divisions along each axis of the object. Can be set before or after creation. By default, each side of the plane has four segments. When you reset these values, the new values become the default during a session.

Render Multipliers group

Render Scale Specifies the factor by which both length and width are multiplied at render time. Scaling is performed from the center outward.

Render Segs Specifies the factor by which the number of segments in both length and width are multiplied at render time.

Generate Mapping Coords Generates coordinates for applying mapped materials to the plane. Default=on.

Real-World Map Size Controls the scaling method used for texture mapped materials that are applied to the object. The scaling values are controlled by the Use Real-World Scale settings found in the applied material's Coordinates rollout on page 6201. Default=off.

Extended Primitives

Extended Primitives are a collection of complex primitives for 3ds Max. The topics that follow describe each type of extended primitive and its creation parameters.
A collection of extended primitive objects

These primitives are available from the Object Type rollout on the Create panel and from the Create menu on page 8008 > Extended Primitives.

All primitives offer AutoGrid. They all have name and color controls, and allow you to enter initial values from the keyboard. See these topics:

AutoGrid on page 2792
**Hedra Extended Primitive**

Create panel > Geometry button > Extended Primitives > Object Type rollout > Hedra button

Create menu > Extended Primitives > Hedra

Use Hedra to produce objects from several families of polyhedra.

**Procedures**

**To create a polyhedron:**

1. From the Create menu, choose Extended Primitives > Hedra.
2 In any viewport, drag to define a radius, then release to create the polyhedron.
   As you drag, a polyhedron emerges from the pivot point.

3 Adjust the Family Parameter and Axis Scaling spinners to vary the Hedra's appearance.

**Interface**
Family group

Use this group to select the type of polyhedron to create.

Tetra Creates a tetrahedron.

Cube/Octa Creates a cubic or octahedral polyhedron (depending on parameter settings).

Dodec/Icos Creates a dodecahedron or icosahedron (depending on parameter settings).

Star1/Star2 Creates two different star-like polyhedra.

TIP You can animate between Hedra types. Turn on the Auto Key button, go to any frame, and change the Family check box. There is no interpolation between types; the model simply jumps from a star to a cube or tetrahedron, and so on.

Family parameters group

P, Q Interrelated parameters that provide a two-way translation between the vertices and facets of a polyhedron. They share the following:

■ Range of possible values is 0.0 through 1.0.

■ The combined total of the P and Q values can be equal to or less than 1.0.

■ Extremes occur if either P or Q is set to 1.0; the other is automatically set to 0.0.

■ Midpoint occurs when both P and Q are 0.

In the simplest terms, P and Q change the geometry back and forth between vertices and facets. At the extreme settings for P and Q, one parameter represents all vertices, the other represents all facets. Intermediate settings are transition points, with the midpoint an even balance between the two parameters.

Axis Scaling group

Polyhedra can have as many as three kinds of polygonal facets, such as triangle, square, or pentagon. These facets can be regular or irregular. If a polyhedron has only one or two types of facet, only one or two of the axis scaling parameters are active. Inactive parameters have no effect.
P, Q, R Controls the axis of reflection for one of the facets of a polyhedron. In practice, these fields have the effect of pushing their corresponding facets in and out. Defaults=100.

Reset Returns axes to their default setting.

**Vertices group**

Parameters in the Vertices group determine the internal geometry of each facet of a polyhedron. Center and Center & Sides increase the number of vertices in the object and therefore the number of faces. These parameters cannot be animated.

**Basic** Facets are not subdivided beyond the minimum.

**Center** Each facet is subdivided by placing an additional vertex at its center, with edges from each center point to the facet corners.

**Center & Sides** Each facet is subdivided by placing an additional vertex at its center, with edges from each center point to the facet corners, as well as to the center of each edge. Compared to Center, Center & Sides doubles the number of faces in the polyhedron.

**NOTE** If you scale the axis of the object, the Center option is used automatically, unless Center & Sides is already set.

To see the internal edges shown in the figure, turn off Edges Only on the Display command panel.

**Radius** Sets the radius of any polyhedron in current units.

**Generate Mapping Coords** Generates coordinates for applying mapped materials to the polyhedron. Default=on.

**Torus Knot Extended Primitive**

Create panel > Geometry > Extended Primitives > Object Type rollout > Torus Knot button

Create menu > Extended Primitives > Torus Knot

Use Torus Knot to create a complex or knotted torus by drawing 2D curves in the normal planes around a 3D curve. The 3D curve (called the Base Curve) can be either a circle or a torus knot.

You can convert a torus knot object to a [NURBS surface](#) on page 2483.
Example of torus knot

Procedures

To create a Torus Knot:

1. On the Create menu, choose Extended Primitives > Torus Knot.
2. Drag the mouse to define the size of the torus knot.
3. Click, then move the mouse vertically to define the radius.
4. Click again to finish the torus.
5. Adjust the parameters on the Modify panel.

Interface

Creation Method rollout

Diameter Draws the object from edge to edge. You can change the center location by moving the mouse.

Radius Draws the object from the center out.
Parameters rollout > Base Curve group

Provides parameters that affect the base curve.

**Knot/Circle** With Knot, the torus interweaves itself, based on various other parameters. With Circle, the base curve is a circle, resulting in a standard torus if parameters such as Warp and Eccentricity are left at their defaults.

**Radius** Sets the radius of the base curve.

**Segments** Sets the number of segments around the perimeter of the torus.

**P and Q** Describes up-and-down (P) and around-the-center (Q) winding numbers. (Active only when Knot is chosen.)

**Warp Count** Sets the number of "points" in a star shape around the curve. (Active only when Circle is chosen.)

**Warp Height** Sets the height of the "points" given as a percentage of the base curve radius.
Parameters rollout > Cross Section group

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Radius</td>
<td>Sets the radius of the cross section.</td>
</tr>
<tr>
<td>Sides</td>
<td>Sets the number of sides around the cross section.</td>
</tr>
<tr>
<td>Eccentricity</td>
<td>Sets the ratio of the major to minor axes of the cross section. A value of 1 provides a circular cross section, while other values create elliptical cross sections.</td>
</tr>
<tr>
<td>Twist</td>
<td>Sets the number of times the cross section twists around the base curve.</td>
</tr>
<tr>
<td>Lumps</td>
<td>Sets the number of bulges in the torus knot. Note that the Lump Height spinner value must be greater than 0 to see any effect.</td>
</tr>
<tr>
<td>Lump Height</td>
<td>Sets the height of the lumps, as a percentage of the radius of the cross section. Note that the Lumps spinner must be greater than 0 to see any effect.</td>
</tr>
<tr>
<td>Lump Offset</td>
<td>Sets the offset of the start of the lumps, measured in degrees. The purpose of this value is to animate the lumps around the torus.</td>
</tr>
</tbody>
</table>

Parameters rollout > Smooth group

Provides options to alter the smoothing displayed or rendered of the torus knot. This smoothing does not displace or tesselate the geometry, it only adds the smoothing group information.
All Smoothes the entire torus knot.

Sides Smoothes only the adjacent sides of the torus knot.

None The torus knot is faceted.

**Parameters rollout > Mapping Coordinates group**

![Mapping Coordinates]

Provides methods of assigning and adjusting mapping coordinates.

**Generate Mapping Coords** Assigns mapping coordinates based on the geometry of the torus knot. Default=on.

**Offset U/V** Offset the mapping coordinates along U and V.

**Tiling U/V** Tile the mapping coordinates along U and V.

**ChamferBox Extended Primitive**

Create panel > Geometry button > Extended Primitives > Object Type rollout > ChamferBox button

Create menu > Extended Primitives > Chamfer Box

Use ChamferBox to create a box with beveled or rounded edges.
Examples of chamfered boxes

Procedures

To create a standard chamfered box:

1. From the Create menu, choose Extended Primitives > Chamfer Box.

2. Drag the mouse to define the diagonal corners of the base of the chamfered box. (Press Ctrl to constrain the base to a square.)

3. Release the mouse button, and then move the mouse vertically to define the height of the box. Click to set the height.

4. Move the mouse diagonally to define the width of the fillet, or chamfer (toward the upper left increases the width; toward the lower right decreases it).

5. Click again to finish the chamfered box.

To create a cubic chamfered box:

1. On the Creation Method rollout, click Cube.
2 Beginning at the center of the cube, drag in a viewport to set all three dimensions simultaneously.

3 Release the button, and move the mouse to set the fillet or chamfer.

4 Click to create the object.

You can change a cube’s individual dimensions in the Parameters rollout.

Interface

Creation Method rollout

Cube Forces length, width, and height to be equal. You can change a cube’s individual dimensions in the Parameters rollout.

Box Creates a standard chamfered box primitive from one corner to the diagonally opposite corner, with individual settings for length, width, and height.

Parameters rollout

<table>
<thead>
<tr>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Length: 0.1</td>
</tr>
<tr>
<td>Width: 0.1</td>
</tr>
<tr>
<td>Height: 0.1</td>
</tr>
<tr>
<td>Fillet: 0.01</td>
</tr>
<tr>
<td>Length Segs: 1</td>
</tr>
<tr>
<td>Width Segs: 1</td>
</tr>
<tr>
<td>Height Segs: 1</td>
</tr>
<tr>
<td>Fillet Segs: 3</td>
</tr>
</tbody>
</table>

- Smooth
- Generate Mapping Coords.
- Real-World Map Size

Length, Width, Height Sets the corresponding dimensions of the chamfered box.
**Fillet** Slices off the edges of the chamfered box. Higher values result in a more refined fillet on the edges of the chamfered box.

**Length, Width, Height Segs** Sets the number of divisions along the corresponding axis.

**Fillet Segs** Sets the number of segments in the filleted edges of the box. Adding fillet segments increases the edge roundness.

**Smooth** Blends the display of the faces of the chamfered box, creating a smooth appearance in rendered views.

**Generate Mapping Coords** Generates coordinates for applying mapped materials to the chamfered box. Default=on.

**Real-World Map Size** Controls the scaling method used for texture mapped materials that are applied to the object. The scaling values are controlled by the Use Real-World Scale settings found in the applied material's Coordinates rollout on page 6201. Default=off.

---

**ChamferCyl Extended Primitive**

Create panel > Geometry button > Extended Primitives > Object Type rollout > ChamferCyl button

Create menu > Extended Primitives > Chamfer Cylinder

Use ChamferCyl to create a cylinder with beveled or rounded cap edges.
Examples of chamfered cylinders

Procedures

To create a chamfered cylinder:

1. From the Create menu, choose Extended Primitives > Chamfer Cylinder.
2. Drag the mouse to define the radius of the base of the chamfered cylinder.
3. Release the mouse button, and then move the mouse vertically to define the height of the cylinder. Click to set the height.
4. Move the mouse diagonally to define the width of the fillet, or chamfer (toward the upper left increases the width; toward the lower right decreases it).
5. Click to finish the cylinder.
Interface

Creation Method rollout

**Edge** Draws the object from edge to edge. You can change the center location by moving the mouse.

**Center** Draws the object from the center out.

Parameters rollout

- **Radius** Sets the radius of the chamfered cylinder.
- **Height** Sets the dimension along the central axis. Negative values create the chamfered cylinder below the construction plane.
- **Fillet** Chamfers the top and bottom cap edges of the chamfered cylinder. Higher numbers result in a more refined fillet along the cap edge.
- **Height Segs** Sets the number of divisions along the corresponding axis.
- **Fillet Segs**
- **Sides**
- **Cap Segs**
- **Smooth**
- **Slice From**
- **Slice To**
- **Generate Mapping Coords**
- **Real-World Map Size**

Extended Primitives | 435
**Fillet Segs** Sets the number of segments in the filleted edges of the cylinder. Adding fillet segments curves the edges, producing a filleted cylinder.

**Sides** Sets the number of sides around the chamfered cylinder. Higher numbers shade and render as true circles with Smooth on. Lower numbers create regular polygonal objects with Smooth off.

**Cap Segs** Sets the number of concentric divisions along the center of the chamfered cylinder’s top and bottom.

**Smooth** Blends the faces of the chamfered cylinder, creating a smooth appearance in rendered views.

**Slice On** Enables the Slice function. Default=off. When you create a slice and then turn off Slice On, the complete chamfered cylinder reappears. You can use this check box to switch between the two topologies.

**Slice From, Slice To** Sets the number of degrees around the local Z axis from a zero point at the local X axis. For both settings, positive values move the end of the slice counterclockwise; negative values move it clockwise. Either setting can be made first. When the ends meet, the whole chamfered cylinder reappears.

**Generate Mapping Coords** Generates coordinates for applying mapped materials to the chamfered cylinder. Default=on.

**Real-World Map Size** Controls the scaling method used for texture mapped materials that are applied to the object. The scaling values are controlled by the Use Real-World Scale settings found in the applied material’s Coordinates rollout on page 6201. Default=off.

**OilTank Extended Primitive**

Create panel > Geometry button > Extended Primitives > Object Type rollout > OilTank button

Create menu > Extended Primitives > Oil Tank

Use OilTank to create a cylinder with convex caps.
Examples of oil tanks

Procedures

To create an oil tank:

1. From the Create menu, choose Extended Primitives > Oil Tank.
2. Drag the mouse to define the radius of the base of the oil tank.
3. Release the mouse button, and then move the mouse vertically to define the height of the oil tank. Click to set the height.
4. Move the mouse diagonally to define the height of the convex caps (toward the upper left to increase the height; toward the lower right to decrease it).
5. Click again to finish the oil tank.
**Interface**

**Creation Method rollout**

Edge Draws the object from edge to edge. You can change the center location by moving the mouse.

Center Draws the object from the center out.

**Parameters rollout**

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Radius</td>
<td>0.0</td>
</tr>
<tr>
<td>Height</td>
<td>0.0</td>
</tr>
<tr>
<td>Cap Height</td>
<td>0.1</td>
</tr>
<tr>
<td>Blend</td>
<td>0.0</td>
</tr>
<tr>
<td>Sides</td>
<td>12</td>
</tr>
<tr>
<td>Height Segs</td>
<td>1</td>
</tr>
<tr>
<td>Smooth</td>
<td></td>
</tr>
<tr>
<td>Slice On</td>
<td></td>
</tr>
<tr>
<td>Slice From</td>
<td>0.0</td>
</tr>
<tr>
<td>Slice To</td>
<td>0.0</td>
</tr>
<tr>
<td>Generate Mapping Coords</td>
<td>✔</td>
</tr>
<tr>
<td>RealWorld Map Size</td>
<td></td>
</tr>
</tbody>
</table>

**Radius** Sets the radius of the oil tank.

**Height** Sets the dimension along the central axis. Negative values create the oil tank below the construction plane.

**Cap Height** Sets the height of the convex caps. The minimum value is 2.5 percent of the Radius setting. The maximum value is 99 percent the Radius setting, unless the absolute value of the Height setting is less than twice the Radius setting, in which case cap height cannot exceed 49.5 percent of the absolute value of the Height setting.
**Overall/Centers** Determines what the Height value specifies. Overall is the overall height of the object. Centers is the height of the midsection of the cylinder, not including its convex caps.

**Blend** When greater than 0, creates a bevel at the edge of the caps.

**Sides** Sets the number of sides around the oil tank. To create a smoothly rounded object, use a higher number of sides and turn Smooth on. To create an oil tank with flat sides, use a lower number of sides and turn Smooth off.

**Height Segs** Sets the number of divisions along the oil tank's major axis.

**Smooth** Blends the faces of the oil tank, creating a smooth appearance in rendered views.

**Slice On** Turns on the Slice function. Default=off. When you create a slice and then turn off Slice On, the complete oil tank reappears. You can therefore use this check box to switch between the two topologies.

**Slice From, Slice To** Sets the number of degrees around the local Z axis from a zero point at the local X axis. For both settings, positive values move the end of the slice counterclockwise; negative values move it clockwise. Either setting can be made first. When the ends meet, the whole oil tank reappears.

**Generate Mapping Coords** Generates coordinates for applying mapped materials to the oil tank. Default=on.

**Real-World Map Size** Controls the scaling method used for texture mapped materials that are applied to the object. The scaling values are controlled by the Use Real-World Scale settings found in the applied material's Coordinates rollout on page 6201. Default=off.

### Capsule Extended Primitive

Create panel > Geometry button > Extended Primitives > Object Type rollout > Capsule button

Create menu > Extended Primitives > Capsule

Use Capsule to create a cylinder with hemispherical caps.
Examples of capsules

Procedures

To create a capsule:

1. From the Create menu, choose Extended Primitives > Capsule.
2. Drag the mouse to define the radius of the capsule.
3. Release the mouse button, and then move the mouse vertically to define the height of the capsule.
4. Click to set the height and finish the capsule.

Interface

Creation Method rollout

Edge Draws the object from edge to edge. You can change the center location by moving the mouse.

Center Draws the object from the center out.
Parameters rollout

Radius Sets the radius of the capsule.

Height Sets the height along the central axis. Negative values create the capsule below the construction plane.

Overall/Centers Determines what the Height value specifies. Overall specifies the overall height of the object. Centers specifies the height of the midsection of the cylinder, not including its domed caps.

Sides Sets the number of sides around the capsule. Higher numbers shade and render as true circles with Smooth on. Lower numbers create regular polygonal objects with Smooth off.

Height Segs Sets the number of divisions along the capsule's major axis.

Smooth Blends the faces of the capsule, creating a smooth appearance in rendered views.

Slice On Turns on the Slice function. Default=off.
When you create a slice and then turn off Slice On, the complete capsule reappears. You can use this check box to switch between the two topologies.
Slice From, Slice To Sets the number of degrees around the local Z axis from a zero point at the local X axis. For both settings, positive values move the end of the slice counterclockwise; negative values move it clockwise. Either setting can be made first. When the ends meet, the whole capsule reappears.

Generate Mapping Coords Generates coordinates for applying mapped materials to the capsule. Default=on.

Real-World Map Size Controls the scaling method used for texture mapped materials that are applied to the object. The scaling values are controlled by the Use Real-World Scale settings found in the applied material’s Coordinates rollout on page 6201. Default=off.

Spindle Extended Primitive

Create panel > Geometry button > Extended Primitives > Object Type rollout > Spindle button
Create menu > Extended Primitives > Spindle

Use the Spindle primitive to create a cylinder with conical caps.
Examples of spindles

Procedures

To create a spindle:

1. From the Create menu, choose Extended Primitives > Spindle.
2. Drag the mouse to define the radius of the base of the spindle.
3. Release the mouse button, and then move the mouse vertically to define the height of the spindle. Click to set the height.
4. Move the mouse diagonally to define the height of the conical caps (toward the upper left to increase the height; toward the lower right to decrease it).
5. Click again to finish the spindle.
Interface

Creation Method rollout

**Edge** Draws the object from edge to edge. You can change the center location by moving the mouse.

**Center** Draws the object from the center out.

Parameters rollout

- **Radius**: Sets the radius of the spindle.
- **Height**: Sets the dimension along the central axis. Negative values create the spindle below the construction plane.
- **Cap Height**: Sets the height of the conical caps. The minimum value is 0.1; the maximum value is ½ the absolute value of the Height setting.
Overall/Centers  Determines what the Height value specifies. Overall specifies the overall height of the object. Centers specifies the height of the midsection of the cylinder, not including its conical caps.

Blend  When greater than 0, creates a fillet where the caps meet the body of the spindle.

Sides  Sets the number of sides around the spindle. Higher numbers shade and render as true circles with Smooth on. Lower numbers create regular polygonal objects with Smooth off.

Cap Segs  Sets the number of concentric divisions along the center of the spindle's top and bottom.

Height Segs  Sets the number of divisions along the spindle's major axis.

Smooth  Blends the faces of the spindle, creating a smooth appearance in rendered views.

Slice On  Turns on the Slice function. Default=off.
When you create a slice and then turn off Slice On, the complete spindle reappears. You can therefore use this check box to switch between the two topologies.

Slice From, Slice To  Sets the number of degrees around the local Z axis from a zero point at the local X axis.
For both settings, positive values move the end of the slice counterclockwise; negative values move it clockwise. Either setting can be made first. When the ends meet, the whole spindle reappears.

Generate Mapping Coords  Sets up the required coordinates for applying mapped materials to the spindle. Default=on.

Real-World Map Size  Controls the scaling method used for texture mapped materials that are applied to the object. The scaling values are controlled by the Use Real-World Scale settings found in the applied material's Coordinates rollout on page 6201. Default=off.

L-Ext Extended Primitive

Create panel > Geometry button > Extended Primitives > Object Type rollout > L-Ext button

Create menu > Extended Primitives > L-Extrustion

Use L-Ext to create an extruded L-shaped object.
Example of L-Ext

**Procedures**

To create an L-Ext object:

1. From the Create menu, choose Extended Primitives > L-Ext.
2. Drag the mouse to define the base. (Press Ctrl to constrain the base to a square.)
3. Release the mouse and move it vertically to define the height of the L-extrusion.
4. Click, and then move the mouse vertically to define the thickness or width of the walls of the L-extrusion.
5. Click to finish the L-extrusion.
Interface

Creation Method rollout

Corners Draws the object from corner to corner. You can change the center location by moving the mouse.

Center Draws the object from the center out.

Parameters rollout

Side/Front Length Specify the lengths of each "leg" of the L.

Side/Front Width Specify the widths of each "leg" of the L.

Height Specifies the height of the object.

Side/Front Segs Specify the number of segments for a specific "leg" of the object.

Width/Height Segs Specify the number of segments for the overall width and height.
NOTE The object's dimensions (Back, Side, Front) are labeled as though it were created in the Top or Perspective viewports, and seen from the front in world space.

**Generate Mapping Coords** Sets up the required coordinates for applying mapped materials to the object. Default=on.

**Real-World Map Size** Controls the scaling method used for texture mapped materials that are applied to the object. The scaling values are controlled by the Use Real-World Scale settings found in the applied material's Coordinates rollout on page 6201. Default=off.

### Gengon Extended Primitive

Create panel > Geometry button > Extended Primitives > Object Type rollout > Gengon button

Create menu > Extended Primitives > Gengon

Use Gengon to create an extruded, regular-sided polygon with optionally filleted side edges.

Examples of gengons
Procedures

To create a gengon:

1. From the Create menu, choose Extended Primitives > Gengon.
2. Set the Sides spinner to specify the number of side wedges in the gengon.
3. Drag the mouse to create the radius of the gengon.
4. Release the mouse button, then move the mouse vertically to define the height of the gengon. Click to set the height.
5. Move the mouse diagonally to specify the size of the chamfer along the side angles (toward the upper left to increase the size; toward the lower right to decrease it).
6. Click to finish the gengon.

TIP In the Parameters rollout, increase the Fillet Segs spinner to round the chamfered corners into fillets.

Interface

Creation Method rollout

Edge Draws the object from edge to edge. You can change the center location by moving the mouse.

Center Draws the object from the center out.
Parameters rollout

**Parameters**

- **Sides**: Sets the number of sides around the gengon. Higher numbers shade and render as true circles with Smooth on. Lower numbers create regular polygonal objects with Smooth off.

- **Radius**: Sets the radius of the gengon.

- **Fillet**: Sets the width of the chamfered corners.

- **Height**: Sets the dimension along the central axis. Negative values create the gengon below the construction plane.

- **Side Segs**: Sets the number of divisions around the gengon.

- **Height Segs**: Sets the number of divisions along the gengon’s major axis.

- **Fillet Segs**: Sets the number of divisions for the edge filleting. Increasing this setting will produce round, filleted corners instead of chamfers.

- **Smooth**: Blends the faces of the gengon, creating a smooth appearance in rendered views.

- **Generate Mapping Coords**: Sets up the required coordinates for applying mapped materials to the gengon. Default=on.

- **Real-World Map Size**: Controls the scaling method used for texture mapped materials that are applied to the object. The scaling values are controlled by
the Use Real-World Scale settings found in the applied material's Coordinates rollout on page 6201. Default=off.

**C-Ext Extended Primitive**

Create panel > Geometry > Extended Primitives > Object Type rollout > C-Ext button

Create menu > Extended Primitives > C-Extrusion

Use C-Ext to create an extruded C-shaped object.

![Example of C-Ext](image)

**Procedures**

**To create a C-Ext object:**

1. From the Create menu, choose Extended Primitives > C-Extrusion.
2. Drag the mouse to define the base. (Press Ctrl to constrain the base to a square.)
3. Release the mouse and move it vertically to define the height of the C-extrusion.
4. Click, and then move the mouse vertically to define the thickness or width of the walls of the C-extrusion.
5. Click to finish the C-extrusion.
Interface

Creation Method rollout

**Corners** Draws the object from corner to corner. You can change the center location by moving the mouse.

**Center** Draws the object from the center out.

Parameters rollout

<table>
<thead>
<tr>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Back Length: 0.0</td>
</tr>
<tr>
<td>Side Length: 0.0</td>
</tr>
<tr>
<td>Front Length: 0.0</td>
</tr>
<tr>
<td>Back Width: 0.1</td>
</tr>
<tr>
<td>Side Width: 0.0</td>
</tr>
<tr>
<td>Front Width: 0.1</td>
</tr>
<tr>
<td>Height: 0.0</td>
</tr>
<tr>
<td>Back Segs: 1</td>
</tr>
<tr>
<td>Side Segs: 1</td>
</tr>
<tr>
<td>Front Segs: 1</td>
</tr>
<tr>
<td>Width Segs: 1</td>
</tr>
<tr>
<td>Height Segs: 1</td>
</tr>
</tbody>
</table>

**Generate Mapping Coords**

**Real-World Map Size**

**Back/Side/Front Length** Specify the length of each of the three sides.

**Back/Side/Front Width** Specify the width of each of the three sides.

**Height** Specifies the overall height of the object.

**Back/Side/Front Segs** Specify the number of segments for a specific side of the object.
NOTE The object’s dimensions (Back, Side, Front) are labeled as though it were created in the Top or Perspective viewports, and seen from the front in world space.

**Width/Height Segs** Set these to specify the number of segments for the overall width and height of the object.

**Generate Mapping Coords** Sets up the required coordinates for applying mapped materials to the object. Default=on.

**Real-World Map Size** Controls the scaling method used for texture mapped materials that are applied to the object. The scaling values are controlled by the Use Real-World Scale settings found in the applied material’s Coordinates rollout on page 6201. Default=off.

### RingWave Extended Primitive

Create panel > Geometry button > Extended Primitives > Object Type rollout > RingWave button

Create menu > Extended Primitives > RingWave

Use the RingWave object to create a ring, optionally with irregular inner and outer edges whose shapes can be animated. You can also animate the growth of the ringwave object, and you can use keyframing to animate all numeric settings. Use RingWave for various types of special-effects animation, for example, to depict the shock wave emanating from the explosion of a star or planet.
Example of ringwave

**Procedures**

**To create a basic animated ringwave:**

1. On the menu bar choose Create > Extended Primitives > RingWave.
2. Drag in a viewport to set the outer radius of the ringwave.
3. Release the mouse button, and then move the mouse back toward the center of the ring to set the inner radius.
4. Click to create the ringwave object.
5. Drag the time slider to see the basic animation. This is determined by the Inner Edge Breakup group > Crawl Time settings.
6. To animate the ring's growth, choose RingWave Timing group > Grow And Stay or Cyclic Growth.
Interface

Parameters rollout
**RingWave Size group**

Use these settings to change the ringwave's basic parameters.

**Radius** Sets the outside radius of the ringwave.

**Radial Segs** Sets the segment count between the inner and outer surfaces in the direction of the radius.

**Ring Width** Sets the mean ring width as measured inward from the outer radius.

**Sides** Sets the number of segments in the circumferential direction for both the inner, outer, and end (cap) surfaces.

**Height** Sets the height of the ringwave along its major axis.

---

**TIP** If you leave the Height at 0 for an effect like a shock wave, you will want to apply a two-sided material so that the ring can be seen from both sides.

**Height Segs** Sets the number of segments in the direction of the height.

---

**RingWave Timing group**

Use these settings for ringwave animation where the ringwave grows from nothing to its full size.

**No Growth** Sets a static ringwave, which appears at Start Time and disappears after End Time.

**Grow and Stay** Animates a single growth cycle. The ringwave begins growing at the Start Time and reaches its full size at Start Time plus Grow Time.

**Cyclic Growth** The ringwave grows repeatedly from the Start Time to Start Time plus Grow Time.

For example, if you set Start Time to 0 and Grow Time to 25, leaving End Time at the default value of 100, and choose Cyclic Growth, the ringwave grows from nothing to its full size four times over the course of the animation.

**Start Time** The frame number where the ringwave appears, and begins to grow if you choose Grow and Stay or Cyclic Growth.

**Grow Time** The number of frames after Start Time the ringwave takes to reach full size. Grow Time is available only if Grow and Stay or Cyclic Growth is chosen.

**End Time** The frame number after which the ringwave disappears.
Outer Edge Breakup group

Use these settings to change the shape of the ringwave’s outer edge.

**TIP** For effects like shock waves, the ringwave typically has little or no breakup on the outer edge but relatively massive breakup on the inner edge.

**On** Turns on breakup of the outer edge. The remaining parameters in this group are active only when this is on. Default=off.

**Major Cycles** Sets the number of major waves around the outer edge.

**Width Flux** Sets the size of the major waves, expressed as a percentage of the unmodulated width.

**Crawl Time** Sets the number of frames each major wave takes to move around the outer circumference of the RingWave.

**Minor Cycles** Sets the number of random-sized smaller waves in each major cycle.

**Width Flux** Sets the average size of the smaller waves, expressed as a percentage of the unmodulated width.

**Crawl Time** Sets the number of frames each minor wave takes to move across its respective major wave.

Inner Edge Breakup group

Use these settings to change the shape of the ringwave’s inner edge.

**On** Turns on the breakup of the inner edge. The remaining parameters in this group are active only when this is on. Default=on.

**Major Cycles** Sets the number of major waves around the inner edge.

**Width Flux** Sets the size of the major waves, expressed as a percentage of the unmodulated width.

**Crawl Time** Sets the number of frames each major wave takes to move around the inner circumference of the RingWave.

**Minor Cycles** Sets the number of random-sized smaller waves in each major cycle.

**Width Flux** Sets the average size of the smaller waves, expressed as a percentage of the unmodulated width.
Crawl Time  Sets the number of frames each minor wave takes to move across its respective major wave.

NOTE  Negative values in the Crawl Time parameters change the direction of the wave. To produce interference patterns, use Crawl Time settings of opposite sign for major and minor waves, but similar Width Flux and Cycles settings.

TIP  To produce the best "random" results, use prime numbers for major and minor cycles that differ by a multiple of two to four. For example, a major wave of 11 or 17 cycles using a width flux of 50 combined with a minor wave of 23 or 31 cycles with a width flux of 10 to 20 makes a nice random-appearing edge.

Texture Coordinates  Sets up the required coordinates for applying mapped materials to the object. Default=on.

Smooth  Applies smoothing to the object by setting all polygons to smoothing group 1. Default=on.

Prism Extended Primitive

Create panel > Geometry button > Extended Primitives > Object Type rollout > Prism button
Create menu > Extended Primitives > Prism

Use Prism to create a three-sided prism with independently segmented sides.

Example of a prism
Procedures

To create a prism with an isosceles triangle as its base:

1. Choose Isosceles on the Creation Method rollout.

2. Drag horizontally in the viewport to define the length of Side 1 (along the X axis). Drag vertically to define the length of Sides 2 and 3 (along the Y axis).
   (To constrain the base to an equilateral triangle, press Ctrl before performing this step.)

3. Release the mouse, and move it vertically to define the height of the prism.

4. Click to complete the prism.

5. On the Parameters rollout, alter the length of the sides as needed.

To create a prism with a scalene or obtuse triangle at its base:

1. Choose Base/Apex in the Creation Method rollout.

2. Drag horizontally in the viewport to define the length of Side 1 (along the X axis). Drag vertically to define the length of Sides 2 and 3 (along the Y axis).

3. Click, and then move the mouse to specify the placement of the apex of the triangle. This alters the length of sides 2 and 3, and the angles of the corners of the triangle.

4. Click, and then move the mouse vertically to define the height of the prism.

5. Click to complete the prism.

Interface

Creation Method rollout

Isosceles Draws a prism with an isosceles triangle at its base.

Base/Apex Draws a prism with a scalene or obtuse triangle at its base.
Parameters rollout

![Parameters rollout](image)

**Side (n) Length** Sets the length of triangle's corresponding side (and thus the triangle's corner angles).

**Height** Sets the dimension of the prism's central axis.

**Side (n) Segs** Specifies the number of segments for each side of the prism.

**Height Segs** Sets the number of divisions along the prism's central axis.

**Generate Mapping Coordinates** Sets up the required coordinates for applying mapped materials to the prism. Default=off.

### Hose Extended Primitive

Create panel > Geometry > Extended Primitives > Object Type rollout > Hose button

Create menu > Extended Primitives > Hose

The Hose object is a flexible object that you can connect between two objects, whereupon it reacts to their movement. It's similar to Spring on page 849, but does not have dynamics properties. You can specify the overall diameter and length of the hose, the number of turns, and the diameter and shape of its "wire."
Hose models a workable spring on a motorcycle

Procedures

To create a hose:

1. From the menu bar, choose Create > Extended Primitives > Hose.
2. Drag the mouse to define the radius of the hose.
3. Release the mouse, and then move it to define the length of the hose.
4. Click to finish the hose.

To bind a hose to two objects:

1. Add a hose and two other objects. Select the hose.
2. In the Modify panel > Hose Parameters rollout > End Point Method group, choose Bound To Object Pivots.
3. In the Binding Objects group, click Pick Top Object, and then select one of the two objects.
4. In the Binding Objects group, click Pick Bottom Object, and then select the second of the two objects.
   The two ends of the hose attach themselves to the two objects.
5. Move one of the objects.
   The hose adjusts itself to remain attached to both objects.
Interface

Hose Parameters rollout > End Point Method group

Free Hose Choose this when using the hose as a simple object that’s not bound to other objects.

Bound to Object Pivots Choose this when binding the hose to two objects, using the buttons in the Binding Objects group.

Hose Parameters rollout > Binding Objects group

Available only when Bound To Object Pivots is chosen. Use the controls to pick the objects to which the hose is bound and to set the tension between them. "Top" and "Bottom" are arbitrary descriptors; the two bound objects can have any positional relationship to each other.

Each end point of the hose is defined by the center of the overall diameter. This end point is placed at the pivot point of the object to which it is bound. You can adjust the relative position of the binding object to the hose by transforming the binding object while the Affect Object Only button is turned on in the Hierarchy panel > Adjust Pivot rollout.

Top (label) Displays the name of the "top" binding object.

Pick Top Object Click this button and then select the "top" object.
Tension Determines the tension of the hose curve near the Top object as it reaches for the Bottom object. Lower the tension to have the bend occur closer to the Top object, raise the tension to have the bend occur further away from the Top object. Default=100.

Bottom (label) Displays the name of the "bottom" binding object.

Pick Bottom Object Click this button and then select the "bottom" object.

Tension Determines the tension of the hose curve near the Bottom object as it reaches for the Top object. Lower the tension to have the bend occur closer to the Bottom object, raise the tension to have the bend occur further away from the Bottom object. Default=100.

**Hose Parameters rollout > Free Hose Parameters group**

![Free Hose Parameters](image)

**Height** Use this field to set the straight-line height or length of the hose when it is not bound. This is not necessarily the actual length of the hose. Available only when Free Hose is chosen.
Hose Parameters rollout > Common Hose Parameters group

Segments The total number of segments in the hose's length. Increase this setting for a smooth profile when the hose is curved. Default=45.

Flex Section Enable When on, lets you set the following four parameters for the central, flexible section of the hose. When off, the hose's diameter is uniform throughout its length.

Starts The percentage of the hose length from the starting extremity of the hose at which the flex section begins. By default, the starting end of the hose is the end at which the object pivot appears. Default=10%.

Ends The percentage of the hose length from the end extremity of the hose at which the flex section ends. By default, the end extremity of the hose is opposite the end at which the object pivot appears. Default=90%.

Cycles The number of corrugations in the flex section. The number of visible cycles is limited by the number of segments; if Segments isn't high enough to support the number of cycles, then not all cycles will appear. Default=5.

**TIP** To set the appropriate number of segments, first set Cycles, and then increase Segments until the number of visible cycles stops changing.
**Diameter** The relative width of the "outside" parts of the cycles. At negative settings, these are smaller than the overall hose diameter. At positive settings, these are larger than the overall hose diameter. Default=-20%. Range=-50% to 500%.

**Smoothing** Defines the geometry that gets smoothed. Default=All:
- **All** The entire hose is smoothed.
- **Sides** Smoothing is applied along the length of the hose but not around its circumference.
- **None** No smoothing is applied.
- **Segments** Smoothing is applied only on the inner section of the hose.

**Renderable** When on, the hose is rendered using the specified settings. When off, the hose is not rendered. Default=on.

**Generate Mapping Coords** Sets up required coordinates for applying mapped materials to the hose. Default=on.
Hose Parameters rollout > Hose Shape group

Sets the shape of the hose cross section. Default=Round Hose.

**Round Hose** Sets a circular cross section.

**Diameter** The maximum width of the hose at the ends.

**Sides** The number of sides of the hose. A Sides setting of 3 gives a triangular cross section; 4 gives a square cross section; and 5 gives a pentagonal cross section. Increase Sides for a circular cross section. Default=8.

**Rectangular Hose** Lets you specify different settings for width and depth.

**Width** The width of the hose.

**Depth** The height of the hose.
Fillet The amount by which the cross-section corners are rounded. For this to be visible, Fillet Segs must be set to 1 or higher. Default=0.

Fillet Segs The number of segments across each filleted corner. A Fillet Segs setting of 1 cuts the corner straight across; use higher settings for rounded corners. Default=0.

Rotation The orientation of the hose along its long axis. Default=0.

D-Section Hose Similar to Rectangular Hose, but rounds one side for a D-shaped cross-section.

Width The width of the hose.

Depth The height of the hose.

Round Sides The number of segments on the rounded side. Increase for a smoother profile. Default=4.

Fillet The amount by which the two cross-section corners opposite the rounded side are rounded. For this to be visible, Fillet Segs must be set to 1 or higher. Default=0.

Fillet Segs The number of segments across each filleted corner. A Fillet Segs setting of 1 cuts the corner straight across; use higher settings for rounded corners. Default=0.

Rotation The orientation of the hose along its long axis. Default=0.

Architectural Objects

3ds Max provides an array of architectural objects, useful as building blocks for models of homes, businesses, and similar projects. These include: AEC Extended objects (Foliage, Railing, and Wall), Stairs, Doors, and Windows.

AEC Extended Objects

Create panel > Geometry > AEC Extended

Create menu > AEC Objects
AEC Extended objects are designed for use in the architectural, engineering, and construction fields. Use Foliage to create plants, Railing to create railings and fences, and Wall to create walls.

The Object Name and Wireframe Color rollout on page 8182 in each AEC Extended object's creation panel functions identically. The remaining rollouts are covered in each object's topic.

Working with AEC Design Elements

3ds Max includes such features as Foliage, Doors, Windows, Stairs, Railing, and Wall to make exploring three-dimensional design ideas much easier.

This section provides general information about these features. For detailed explanations and procedures, see the topics listed below:

- Doors on page 525
- Windows on page 541
- Stairs on page 506
- Railing on page 482
- Wall on page 491
- Foliage on page 474

Doors and Windows

3ds Max supplies a number of parametric window and door objects that you can place into wall openings to add realism to an architectural model. These objects let you control details like trim and panel fill in your model.

TIP Use Snaps on page 2828 for added precision when adding doors and windows.

When you create a new door or window, you must select four points in the scene that define the size and orientation of the rectangle that will be the
door or window. You may find it easier to select these points in a given sequence, depending on your scene and views of the scene.

If you already have a rectangular hole you want to fill, you can still create a door or window to your specifications by using the following procedure.

To create a door or window:

1. Set up an angled User view so that you can see the bottom and one vertical edge of the opening and its full height.

2. Set the appropriate object snaps, such as Vertex or Endpoint. This helps make the model more precise.

3. After clicking Window or Door, choose one of two Creation Methods: Width/Depth/Height or Width/Height/Depth.

4. Make parameter adjustments to define details.

The width and orientation of the door/window is always defined by the first mouse click and subsequent mouse drag. Depending on the creation method you use, either the height or depth of the object is defined next.

If you have no object snaps set and are working in a Perspective or User Viewport, using the Width/Depth/Height Creation Method creates an upright Door or Window. The Width/Height/Depth Creation Method creates the object as if it were lying on its side.

Allowing Non-vertical Jambs

The Allow Non-vertical Jambs toggle is useful for creating doors or windows that do not fit in a vertical plane, such as a skylight window in a sloping roof. By default, this toggle is off, making the third point in the creation sequence either directly above (Width/Height/Depth) or on the same horizontal plane (Width/Depth/Height) with the second point.

When you turn on Allow Non-vertical Jambs, the third point in the creation sequence falls wherever you choose and the fourth point is added by 3ds Max. Its offset from the plane is determined by the first three points.

Using the Width/Height/Depth Creation Method in Perspective and User viewports with Allow Non-vertical Jambs off can be an efficient way to create doors and windows with Object Snaps. However, it can also be confusing at first. Keep in mind that the third point you define, the Height, is interpreted as a point on the home grid until you indicate a point higher or lower than the grid. If you are using an Object Snap setting, 3ds Max might not know
you mean a point off the grid unless you bring the cursor in proximity to a nonplanar point to which it can snap.

**Additional Parameters**

There are additional parameters specific to each door and window type that control overall dimension parameters, as well as detailed parameters for sub-object components such as mullions, trim, and panels within leaves. See [Doors on page 525](#) and [Windows on page 541](#) for more information on these parameters.

**Animating Doors and Windows**

Certain door and window creation parameters, including the Open parameter, can be animated. See [Doors on page 525](#) and [Windows on page 541](#) for more information.

**Creating Stairs and Railings**

3ds Max contains four types of stair objects: [spiral stairs on page 514](#), [U-type stairs on page 522](#) with an intermediate landing, [L-type stairs on page 511](#) with a landing at the bend in the stair, and [straight stairs on page 519](#) with no intermediate landing. A complementary Railing object can be used to create any number of handrail designs that follow along a spline path.

For more information, see [Stairs on page 506](#).

**The Railing Object**

Use the Railing button on the Create panel in the to produce railing objects. Railing components include rails, [AEC Extended category on page 467](#) posts, and fencing. Fencing includes pickets (balusters) or solid-filled material (such as glass or wood strips).

You can create a railing in two ways: specify the orientation and height of the railing, or pick a spline path and apply the railing to that path. The spline path with a railing is called a rail path. Later, if you edit the rail path, the Railing object automatically updates to follow the changes you make. Rail paths can occupy three-dimensional space.

When you create the lower rails, posts, and fencing components of a Railing object, you use a special version of the Spacing Tool to specify the spacing of those components. 3ds Max displays the Spacing Tool dialog for each railing component: Lower Rail, Post Spacing, or Picket Spacing. For more information on the Spacing Tool, see [Spacing Tool on page 953](#).
Creating Walls

Use the Wall button on page 491 on the Create panel, in the AEC Extended category, to produce straight-wall objects. A wall object is made up of sub-object segments that you can edit with the Modify panel.

You can:

■ Break or insert wall segments to create separate wall objects.
■ Delete wall segments.
■ Connect two wall objects.

When you create two wall segments that meet at a corner, 3ds Max removes any duplicate geometry. This “cleaning up” of the corners might involve trimming. 3ds Max cleans up only the first two wall segments of a corner, not other wall segments that might share the corner. 3ds Max does not clean up intersections. You can edit the segments of a wall using sub-object selection mode on the Modify panel. For example, you can define a wall’s height profile. 3ds Max moves the active grid to the plane of the wall you’re editing. This allows you to snap to the profile vertices in the plane of the wall.

If you move, scale, or rotate the wall object, the linked door and window moves, scales, or rotates along with the wall. If you move the linked door or window along the wall, using the door or window’s Local coordinate system and activating Restrict to XY Plane in the Axis Constraints toolbar on page 910, the opening will follow. Also, if you change a door or window's overall width and height in the Modify panel, the hole will reflect those changes.

Usage Tips

The following are a few tips for working with wall objects:

■ Use the Top viewport when creating wall objects.
■ Single walls with many windows and doors can slow down snap calculations and movement of the wall object. To speed up insertion and editing, use multiple walls instead of a single wall.
■ You can speed up performance in a scene with many walls, windows, and doors by collapsing them. First save an uncollapsed version for any future
parametric changes you might want to make. Then right-click the wall and pick Select Children from the right-click menu. Next use Collapse in the Utility rollout to collapse them all.

For complete information, see Wall on page 491.

To create a wall:

1. On the Create panel, in the AEC Extended category, click Wall.
2. Use Customize > Units Setup to establish precision, and then set the parameters for the Width, Height, and Justification of the wall.
3. In any viewport, click, release the mouse, drag the wall segment to the length you want and click again. This creates a wall segment. You can end the wall or you can continue to create another wall segment.
4. To complete the wall, right-click, or to add another wall segment, drag the next wall segment to the length you want and click again. If you create a room by ending a segment at the end of another segment of the same wall object, 3ds Max displays the Weld Point dialog. This dialog lets you convert the two end vertices into a single vertex, or keep the two end vertices separate.
5. If you want the wall segments to be welded at a corner (when you move one wall, the other wall stays at the corner), click Yes. Otherwise, click No.
6. Right-click to complete the wall, or continue to add another wall segment.

To attach separate walls:

1. Select a wall object.
2. On the Modify panel, click Attach, and then pick another wall object. The two wall objects become part of the same wall object, but are not physically connected.

Attach stays active, and you can continue clicking wall segments to attach. To stop attaching, click the Attach button or right-click in the active viewport.

To attach multiple wall objects simultaneously to the selected wall object, click Attach Multiple on the Modify panel to open the Attach Multiple dialog. This works the same as the Select From Scene dialog on page 206,
except that it shows only wall objects; choose multiple walls to attach, and then click the Attach button.

**To connect vertices in a wall:**

This method lets you connect two separate wall sections with a new segment.

TIP: It is easier to work with wall vertices in wireframe view mode.

1. Select a wall object that has more than one section. Typically you would use Attach to create such an object.
2. In the **modifier stack** on page 8187, go to the Vertex sub-object level.
3. Click Connect and point the mouse over an end vertex until the cursor changes to a cross.
4. Click once over the end vertex.
5. Move the cursor to another end vertex, and then click to connect the two segments.

**To insert a vertex in a wall:**

It is easier to work with wall vertices in wireframe view mode.

1. Select a wall segment.
2. In the **modifier stack** on page 8187, go to the Vertex sub-object level.
3. Click Insert.
   A highlighted line appears along the bottom of the wall, showing where you can insert vertices.
4. Click anywhere on the highlighted line to insert a vertex.
   The new vertex is attached to the mouse cursor.
5. Move the mouse to position the vertex, and then click to place it.
   Now the mouse is attached to one of the new segments.
6. Move the mouse along the segment and click to add vertices.
7. Right-click to finish working on this segment. You can now insert vertices in other segments, or right-click again to exit Insert mode.
Foliage

Create panel > Geometry > AEC Extended > Foliage button
Create menu > AEC Objects > Foliage

Foliage produces various types of plant objects such as tree species. 3ds Max generates mesh representations to create fast, efficient, and good-looking plants.

You control height, density, pruning, seed, canopy display, and level of detail. The seed on page 480 option controls creation of different representations of the same species. You can create millions of variations of the same species, so each object can be unique. With the viewport canopy mode on page 481 option, you can control the amount of plant detail, reducing the number of vertices and faces 3ds Max uses to display the plant.
Some of the plants that can be created from the standard library

Tips

- Use the Spacing tool on page 953 to place plants along a path.
- Use vertex or face snapping (see Snaps Settings on page 2819) to position plants on a surface.

Procedures

To add plants to a scene:

1. Click the Favorite Plants rollout > Plant Library button to display the Configure Palette dialog.
2. Double-click the row for each plant you want to add or remove from the Palette and click OK.
3. On the Favorite Plants rollout, select a plant and drag it to a location in a viewport. Alternatively, select a plant in the rollout and then click in the viewport to place the plant.
4 On the Parameters rollout, click the New button to display different seed variations of the plant.

5 Adjust the remaining parameters to show elements of the plants, such as leaves, fruit, branches, and if you want, to view the plant in canopy mode.

Interface

Object Name and Wireframe Color rollout

This rollout lets you set the foliage object’s name, color, and default material. For detailed information, see Object Name and Wireframe Color on page 8182.

When Favorite Plants rollout > Automatic Materials is on, each plant is assigned its own default material. For more information, see Favorite Plants rollout, following.

Keyboard Entry rollout

See Creating Primitives from the Keyboard on page 386.
Favorite Plants rollout

The palette displays the plants currently loaded from the Plant Library on page 478. There are three ways to add a plant to the scene:

- Use keyboard entry.
- Click the icon in the Favorite Plants list and then click a location in a viewport. Double-click the icon to place the plant at the world origin.
- Drag the plant from the palette and drop it into a viewport.

**Automatic Materials** Assigns default materials for the plant. To modify these material assignments, use the Material Editor on page 5641. Select the plant in the viewport, and click Main toolbar > Material Editor. Click the Get Material button on page 5687 to display the Material/Map Browser. Under Browse From, choose Selected. Then, from the list pane, double-click the material list item.
for the plant to display the materials in the Basic Parameters rollout of the Material Editor.

If you turn off Automatic Materials, 3ds Max assigns no materials to the object, unless the Name And Color rollout > Default Material check box is on and a default material is assigned. This way you can specify a particular default material for all foliage objects. For more information, see Object Name and Wireframe Color on page 8182.

When on, Automatic Materials overrides the Default Material settings.

---

**NOTE** Even if Automatic Materials is off, 3ds Max still assigns material IDs to the foliage objects, so that the object is ready for a multi/sub-object material.

**Plant Library** Displays the Configure Palette dialog. Using this window, you can view information on the available plants including their names, whether they’re in the palette, their scientific names, types, descriptions, and the approximate number of faces per object. You can also add and remove plants from the palette, and clear the palette, which removes all plants from the palette.

**TIP** To quickly add or remove a plant from the palette, double-click its row in the Configure Palette dialog. The Fav. (Favorite Plants) column entry switches between “no” and “yes.” Click OK to accept the changes and exit the window.
Parameters rollout

**Height** Controls the approximate height of the plant. 3ds Max applies a random noise factor to the height of all of the plants. Therefore, the actual height of a plant, as measured in the viewports, won't necessarily match the setting given in the Height parameter.

**Density** Controls the amount of leaves and flowers on the plant. A value of 1 displays a plant with all its leaves and flowers, .5 displays a plant with half its leaves and flowers, and 0 displays a plant with no leaves or flowers.
Two trees with varying foliage densities

**Pruning** Applies only to plants with branches. Removes branches that lie below an invisible plane parallel to the construction plane. A value of 0 prunes nothing, a value of 0.5 prunes the plant at a plane halfway up its height from the construction plane, and a value of 1 prunes everything possible from the plant. What 3ds Max prunes from the plant depends on the type of plant. The trunk is never pruned.

Three pairs of trees, showing different values of pruning

**New** Displays a random variation of the current plant. 3ds Max displays the seed value in the numeric field next to the button.

**TIP** Click the New button repeatedly until you find the variation you want. This is often easier than trying to adjust the tree using modifiers.

**Seed** A value between 0 and 16,777,215 representing the possible variations of branch and leaf placement and shape and angle of the trunk of the current plant.

**Generate Mapping Coords** Applies default mapping coordinates on page 8628 to the plant. Default=on.
Show group

Controls the display of leaves, fruit, flowers, trunk, branches, and roots of plants. Available options depend on the type of plant you select. For example, if a plant doesn’t have fruit, 3ds Max disables that option. Turning off options reduces the number of vertices and faces displayed.

Viewport Canopy Mode group

In 3ds Max, the canopy of a plant is a shell covering the outermost parts of the plant, such as the leaves or the tips of the branches and trunk. The term derives from "forest canopy." Use reasonable parameters when you create many plants and want to optimize display performance.

Because this setting applies only to the plant’s representation in the viewports, it has no effect on how 3ds Max renders the plant. For information on how 3ds Max renders the plant, see Level-of-Detail on page 481.

**When Not Selected** Displays the plant in canopy mode when it’s not selected.

**Always** Always displays the plant in canopy mode.

**Never** Never displays the plant in canopy mode. 3ds Max displays all the features of the plant.

Level-of-Detail group

AEC Extended Objects | 481
Controls how 3ds Max renders the plant. For information on how 3ds Max displays the plant in the viewports, see Viewport Canopy Mode on page 481.

**Low** Renders the plant canopy, providing the lowest level of detail.

**Medium** Renders a reduced-face-count version of the plant. How 3ds Max reduces the face count varies from plant to plant, but it usually involves removing smaller elements of the plant or reducing the number of faces in the branches and trunk.

**High** Renders all the faces of the plant, providing the highest level of detail.

---

**TIP** Set the parameters before creating multiple plants. This can avoid slowing down the display, and might reduce editing you have to do on the plants.

---

### Railing

Create panel > Geometry > AEC Extended > Railing button

Create menu > AEC Objects > Railing

Components of the railing object include rails, posts, and fencing. Fencing includes either pickets (balusters) or solid-filled material, such as glass or wood strip.

Railings used to create fences in a field.

You can create a railing object either by specifying the orientation and height of the railing, or by picking a spline path and applying the railing to that path. When 3ds Max applies railing to a spline path, the latter is called a *rail path*. Later, if you edit the rail path, the railing object automatically updates to follow the changes you made. You can use three-dimensional splines as rail paths.

When you create the lower rails, posts, and fencing components of a railing, you use the Spacing tool on page 953 to specify the spacing of those components.
components. 3ds Max names the Spacing tool dialog for each railing component: Lower Rail Spacing, Post Spacing, or Picket Spacing.

**TIP** Use Railing to create complete railings for stairs. See Stairs on page 506 for more information.

### Railings and Materials

By default, 3ds Max assigns five different material IDs to railings. The `aectemplates.mat` material library includes *Rail-Template*, a multi/sub-object material on page 6120 designed to be used with railings. Each component of the railing/material is listed below along with its corresponding Material ID.

<table>
<thead>
<tr>
<th>Material ID</th>
<th>Railing/Material Component</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Lower rails</td>
</tr>
<tr>
<td>2</td>
<td>Posts of the railing</td>
</tr>
<tr>
<td>3</td>
<td>Solid fill of the railing</td>
</tr>
<tr>
<td>4</td>
<td>Top of the railing</td>
</tr>
<tr>
<td>5</td>
<td>Pickets of the railing</td>
</tr>
</tbody>
</table>

**NOTE** 3ds Max does not automatically assign a material to the railing object. To use the included material, open the library and then assign the material to your object.

### Procedures

The following procedures describe how to create railings combining each of the components: upper rail, lower rails, posts, picket fencing, and solid filled fencing.

You can create a railing object in any viewport, but for best results, use a Perspective, Camera, or Top viewport.

**To create a railing:**

1. Click and drag the railing to the desired length.
2 Release the mouse button, and then move the mouse vertically to set the height. Click to finish.

By default, 3ds Max creates the top rail along with two posts, a lower rail at half the railing height, and two evenly spaced pickets.

3 If you need to, change any of the parameters to adjust the segments, length, profile, depth, width, and height of the rail.

To adjust lower rails:

1 To modify the lower rail, or add more, choose an option from the Lower Rail(s) group > Profile list.

2 Specify the depth and width for the lower rails and then click the Lower Rail(s) > Spacing button.

3 Specify the number of lower rails you want using the Count option. Click Close to apply your changes. For more information on spacing options in this dialog, see Spacing Tool on page 953.

To create posts:

1 If you want to modify the posts, or add more, choose an option from the Profile list under the Posts rollout.

2 Specify the depth and width of the posts and how much they should extend above the top rail. Then click the Posts rollout > Spacing button.

3 Specify the number of posts you want using the Count option. Click Close to apply your changes. For more information on spacing options in this dialog, see Spacing Tool on page 953.

To create picket fencing:

1 Choose Fencing rollout > Type list > Pickets. The Solid Fill options will be unavailable.

2 Choose an option from the Profile list, specify the depth and width of the pickets, and then click the Picket rollout > Spacing button.
3 Specify the number of pickets you want using the Count option. Click Close to apply your changes. For more information on spacing options in this dialog, Spacing Tool on page 953.

To create solid-fill fencing:

1 Choose Fencing rollout > Type list > Solid Fill. (The options under Picket are unavailable).
2 Under Solid Fill, adjust the options for Thickness and offsets.

To create railings along a spline path:

Before you can create railings along a spline path, you need to create a spline, or use an existing spline from your scene.

1 Click Create panel > Geometry > AEC Extended > Railing.
2 Click Pick Railing Path, then select a spline in your scene. Since the number of segments is 1 by default, the upper rail extends for one segment between the start and end of the spline.
3 Change the amount of segments using the Modify panel > Segment setting.
   The higher the segment value, the more closely the railing approximates the spline shape.
4 If you want the railing to contain corners where the spline does, turn on Respect Corners.
5 Complete the remainder of the railing options as described in the preceding procedures.
   Thereafter, the spline is associated with the railing; any changes you make to the spline shape are reflected in the railing.

Interface

Name and Color rollout

This rollout lets you set the selected railing's name and color. For detailed information, see Object Name and Wireframe Color on page 8182.
Railing rollout

Pick Railing Path  Click this, and then click a spline in the viewport to use as the railing path. 3ds Max uses the spline as the path along which to apply the railing object.

If you edit the spline you’ve used as a railing path, the railing adjusts to the changes you make. 3ds Max doesn’t immediately recognize 2D Shapes from a linked AutoCAD drawing. To recognize Shapes from a linked AutoCAD drawing, edit the Shape with Edit Spline on page 1424 in the Modify panel.

TIP  When you create a railing using a closed spline for the rail path, open the Post Spacing dialog on page 953, turn off Start Offset and End Offset, and lock End Offset. This will ensure that 3ds Max properly creates the railing with any fill, pickets, and posts you specify.
NOTE Railing objects that use Pick Path do not stay on the path when substituted using the Substitute modifier. Substituted externally referenced railings do not undo when railings are associated with a path.

**Segments** Sets the number of segments of the railing object. Available only when you're using a railing path.

For a close approximation to a railing path, increase the number of segments. Be aware that a high number of segments increases file size and slows down the rendering speed. You might use fewer segments when the spline path has a low curvature (or none) and fewer segments provide an adequate approximation.

**Respect Corners** Puts corners in the railing to match the corners of the railing path.

**Length** Sets the length of the Railing object. When you drag the mouse, the length displays in the edit box.

**Top Rail group**

The defaults produce a top rail component, consisting of one segment by the length you specify, a square profile, four units deep, three units wide, and the height you specify.

1. Width
2. Depth
3. Height
4. Profile for the square top rail
5. Profile for the round top rail

**Profile** Sets the cross-section shape of the top rail.

**Depth** Sets the depth of the top rail.

**Width** Sets the width of the top rail.
**Height** Sets the height of the top rail. During creation, you can drag the top rail to the height you want using the mouse in the viewport. Or you can enter the height amount from the keyboard or use the spinners.

**Lower Rail(s) group**

Controls the profile, depth, width, and spacing between the lower rails. You specify how many lower rails you want using the Lower Rail Spacing button.

![A railing with the rails defined by their profile, depth, and width as planks.](image)

**Profile** Sets the cross-section shape of the lower rails.

**Depth** Sets the depth of the lower rails.

**Width** Sets the width of the lower rails.

**Lower Rail Spacing** Sets the spacing of the lower rails. When you click this button, the Lower Rail Spacing dialog displays. Specify the number of lower rails you want using the Count option. For more information on spacing options in this dialog, see [Spacing Tool](#) on page 953.

**Generate Mapping Coords** Assigns mapping coordinates on page 8628 to the railing object.

---

**NOTE**

If a visible viewport is set to a non-wireframe or non-bounding-box display, Generate Mapping Coordinates is on for all primitives to which you apply a material containing a map with Show Map In Viewport on. If all viewports are set to wireframe or bounding box, 3ds Max turns on Generate Mapping Coordinates for primitives containing mapped materials at render time.

**Real-World Map Size** Controls the scaling method used for texture mapped materials that are applied to the object. The scaling values are controlled by the Use Real-World Scale settings found in the applied material’s Coordinates rollout on page 6201. Default=off.
Posts rollout

Controls the profile, depth, width, extension, and spacing between the posts. You specify how many posts you want using the Post Spacing button.

**Profile** Sets the cross-section shape of the posts: none, Square, or Round.

**Depth** Sets the depth of the posts.

**Width** Sets the width of the posts.

**Extension** Sets the amount the posts extend above the bottom of the top railing.

**Post Spacing** Sets the spacing of the posts. When you click this button, the Post Spacing dialog displays. Specify the number of posts you want using the Count option. For more information on spacing options in this dialog, see Spacing Tool on page 953.

**TIP** Setting Profile to (none) makes an "invisible" post. You might want to do this to create a railing with gaps between solid fill fencing. Or you could use it to make a railing with openings between groups of pickets. This is different from setting the post count to 0 in the Post Spacing dialog.
Fencing rollout

**Type**
Sets the type of fencing between the posts: none, Pickets, or Solid Fill.

**Picket group**
Controls the profile, depth, width, and spacing between the pickets. Specify how many pickets you want using the Picket Spacing button. Available only when you set Type to Pickets.

1. A railing with pickets using a square profile
2. A railing with pickets using a round profile
Profile Sets the cross-section shape of the pickets.

Depth Sets the depth of the pickets.

Width Sets the width of the pickets.

Extension Sets the amount the pickets extend above the bottom of the top railing.

Bottom Offset Sets the amount the pickets are offset from the bottom of the railing object.

Picket Spacing Sets the spacing of the pickets. When you click this button, the Picket Spacing dialog displays. Specify the number of pickets you want using the Count option. For more information on spacing options in this dialog, see Spacing Tool on page 953.

Solid Fill group

Controls the thickness and offsets of the solid fill between the posts. Available only when you set Type to Solid.

Thicknes Sets the thickness of the solid fill.

Top Offset Sets the offset of the solid fill from the bottom of the top rail.

Bottom Offset Sets the offset of the solid fill from the bottom of the railing object.

Left Offset Sets the offset between the solid fill and the adjacent left post.

Right Offset Sets the offset between the solid fill and the adjacent right post.

Wall

Create panel > Geometry > AEC Extended > Object Type rollout > Wall button
Create menu > AEC Objects > Wall

The Wall object is made up of three sub-object types that you can edit in the Modify panel. Similarly to the way you edit splines, you can edit the wall object on page 501, its vertices on page 502, its segments on page 503, and its profile on page 504.

When you create two wall segments that meet at a corner, 3ds Max removes any duplicate geometry. This "cleaning up" of the corners might involve
trimming. 3ds Max cleans up only the first two wall segments of a corner, not any other wall segments that might share the corner. 3ds Max does not clean up intersections.

**Inserting Doors and Windows in a Wall**

3ds Max can automatically make openings for doors and windows in a wall. At the same time, it links the door or window to the wall as it child. The most effective way of doing both is to create the doors and windows directly on a wall segment by snapping to the faces, vertices, or edges of the wall object.

If you move, scale, or rotate the wall object, the linked door or window moves, scales, or rotates along with the wall. If you move the linked door or window along the wall, using the door or window's local coordinate system and constraining motion to the XY plane on page 8039, the opening will follow. Also, if you change a door or window's overall width and height on the Modify panel, the hole will reflect those changes.

For further information, see the procedure To create and place a window or door in a wall on page 497.

**Walls and Materials**

By default, 3ds Max assigns five different material IDs to walls. The aectemplates.mat material library includes Wall-Template, a multi/sub-object material on page 6120 designed to be used with walls. Each component of the wall/material is listed below along with its corresponding Material ID.

<table>
<thead>
<tr>
<th>Material ID</th>
<th>Wall/Material Component</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Vertical ends of the wall</td>
</tr>
<tr>
<td>2</td>
<td>Outside of the wall</td>
</tr>
<tr>
<td>3</td>
<td>Inside of the wall</td>
</tr>
<tr>
<td>4</td>
<td>Top of the wall, including any edges cut out of the wall</td>
</tr>
<tr>
<td>5</td>
<td>Bottom of the wall</td>
</tr>
</tbody>
</table>
NOTE 3ds Max does not automatically assign a material to the wall object. To use the included material, open the library and then assign the material to your object.

NOTE The definitions of slots 2 and 3 are interchangeable; inside and outside simply depend on your point of view, and how you created the wall.

See also:
- Editing Wall Objects on page 500

Tips
- To make a passageway through a wall you can perform a Boolean operation on page 713 with the wall as Operand A, and another object, such as a box or an extruded archway shape, as Operand B. The wall will still be accessible at the Boolean sub-object level. Then, you can add a window or door in the passageway, and link on page 3630 it as a child of the wall.
- Single walls with many windows and doors can become slow to use because of the amount of boolean calculations used. To speed up movement and editing, you might consider using multiple walls instead of a single wall.
- You can speed up performance in a scene with many walls, windows and doors by collapsing them. First save an uncollapsed version for any future parametric changes you might want to make. Then double-click the wall to select it and its children. Next use Convert To from the right-click menu to convert them to an editable mesh, and so on.

Procedures

To create a wall:

You can create a wall in any viewport, but for vertical walls, use a Perspective, Camera, or Top viewport.

1. Set parameters for the Width, Height, and Justification of the wall.

2. In a viewport, click and release, move the mouse to set the desired length for the wall segment, and click again.

   This creates a wall segment. You can end the wall by right-clicking or you can continue to create another wall segment.
To add another wall segment, move the mouse to set the length of the next wall segment and click again.

If you create a room by ending a segment at the end of another segment of the same wall object, 3ds Max displays the Weld Point dialog. This dialog lets you convert the two end vertices into a single vertex, or to keep the two end vertices distinct.

If you want the wall segments to be welded at that corner so that when you move one wall, the other wall stays correct at the corner, click Yes. Otherwise, click No.

Right-click to end the wall, or continue to add other wall segments.

To attach separate walls:

1. Select a wall object.
2. On the Modify panel, click Attach, and then pick another wall object. The two wall objects become part of the same wall object, but are not physically connected.

Attachment stays active, and you can continue clicking wall segments to attach.

To stop attaching, click the Attach button or right-click in the active viewport.

To attach multiple wall objects simultaneously to the selected wall object, click Attach Multiple on the Modify panel to open the Attach Multiple dialog. This works the same as the Select From Scene dialog on page 206, except that it shows only wall objects; choose multiple walls to attach, and then click the Attach button.

To connect vertices in a wall:

This method lets you connect two separate wall sections with a new segment.

TIP It is easier to work with wall vertices in wireframe view mode.

1. Select a wall object that has more than one section. Typically you would use Attach to create such an object.
2. In the modifier stack on page 8187, go to the Vertex sub-object level.
3. Click Connect and point the mouse over an end vertex until the cursor changes to a cross.
4. Click once over the end vertex.
5 Move the cursor to another end vertex, and then click to connect the two segments.

To insert a vertex in a wall:
To insert a vertex in a wall: It is easier to work with wall vertices in wireframe view mode.

1 Select a wall segment.
2 In the modifier stack on page 8187, go to the Vertex sub-object level.
3 Click Insert.
   A highlighted line appears along the bottom of the wall, showing where you can insert vertices.
4 Click anywhere on the highlighted line to insert a vertex.
   The new vertex is attached to the mouse cursor.
5 Move the mouse to position the vertex, and then click to place it.
   Now the mouse is attached to one of the new segments.
6 Move the mouse along the segment and click to add vertices.
7 Right-click to finish working on this segment. You can now insert vertices in other segments, or right-click again to exit Insert mode.

To detach and reorient a copy of a wall segment:

TIP It is easier to work with wall vertices in wireframe view mode.

1 Select a wall.
2 In the modifier stack on page 8187, go to the Segment sub-object level.
3 Select a wall segment.
4 Turn on both Reorient and Copy, and then click Detach.
5 Enter a name for the new wall object in the Detach dialog or click OK to accept the default name.
   3ds Max copies the original wall’s Local coordinate system on page 8621 when it makes the copy of the detached segment. It places the new object so that its Local coordinate system is coincident with the World space origin on page 8768.
To add a gable point to a wall profile or adjust for uneven terrain:

**TIP** It is easier to work with wall vertices in wireframe view mode.

1. Select a wall.
2. In the modifier stack on page 8187, go to the Profile sub-object level.
3. Select a wall profile by clicking a wall segment.
   A grid appears.
4. To add a gable point procedurally, set the height and click Create Gable. If you prefer to add the profile point manually, click Insert, click a point on the highlighted top profile, drag the new point into place and then release where you want to place the new gable point. You can move profile points you create with Insert only within the plane of the wall segment, and you cannot move them below the original top edge.

   If you want to adjust the profile for uneven terrain below a wall, click Insert, pick the highlighted bottom profile and add points as necessary.

   If you want to extend multiple segments uniformly downward below floor level, do the following: At the Segment sub-object level, select the segments and, on the Edit Segment rollout, enter a negative Bottom Offset value to move the segments downward. Add the absolute value of the Bottom Offset setting back to the Height value to bring the top of the wall height back up and make it flush with the other wall segments.

To apply a texture to a wall:

Walls are created with five different material IDs on page 8633 for their various parts.
The \textit{aectemplates.mat} material library includes \textit{Wall-Template}, a Multi/Sub-Object material designed for use with walls. You can copy or copy and modify this template, or create your own material as follows:

1. Create a \textbf{Multi/Sub-Object material} on page 6120 using five textures for the following Material IDs:
   - Slot #1 is the material for the vertical ends on the wall
   - Slot #2 is the material for the outside of the wall
   - Slot #3 is the material for the inside of the wall
   - Slot #4 is the material for the top of the wall, as well as any inside edges cut out of the wall
   - Slot #5 is the material for the bottom of the wall

   \textbf{NOTE}: The definitions of slots 2 and 3 are interchangeable; inside and outside simply depend on your point of view, and how you created the wall.

2. If the top and bottom surfaces of the wall aren't visible in the rendered scene, you can use a three-sided material instead. The inside and outside of the wall are relative to the direction in which the wall was created. To swap a texture between slots in the Material Editor, drag one of the textures over the other slot in the Basic Parameters rollout of the Multi/Sub-Object material, and then choose Swap.

3. For greater control in tiling across the wall surface, apply a \textbf{Map Scaler world-space modifier} on page 1147 to the wall. Then adjust the scale of the map in the Map Scaler's Parameters rollout.

\textbf{To create and place a window or door in a wall:}

For best results, perform this procedure in a wireframe viewport.

1. Create a \textbf{window} on page 541 or \textbf{door} on page 525 (hereafter referred to as "window" for brevity) directly on an existing wall. You can define the window's exact dimensions after insertion. Use \textbf{edge snap} on page 2819 for the first snaps to place and align the window on the wall and to establish its exact depth. Snap to and then click the near top edge of the wall to start creation. Drag to another edge snap point on the near top edge of the wall and release to align the window with the wall segment and to set its width. Snap to the rear top edge of the wall to set the proper depth and click. Move the cursor downward and click to define the window.
height. This final click doesn't require a snap, as it simply defines a rough height.

2 The window should now be cut out of the wall. On the Modify panel for windows or doors, set the correct width and height. Change the depth if it's different from the snap depth you set above.

3 Use vertex snap to move the window or door from a reference point to a known point on the wall segment. Then
   Next, use relative offset values from this new position to accurately locate the window or door. As an example, following the next two steps, you could move a window from its top left corner to the top left corner of the wall segment so that you can then move it 3 feet to the right and 2 feet down.

4 With the window or door selected, set the coordinate system to Local.

5 On the Coordinate Display on page 8081, activate Offset mode and then enter the offset distances on the X axis for horizontal and the Y axis for vertical.

NOTE For best results, do not position an inserted window or door at the bottom of a wall.

Interface

Keyboard Entry rollout

![Keyboard Entry rollout](image)

- **X**: Sets the coordinate position along the X axis for the start point of a wall segment in the active construction plane.

498 | Chapter 6  Creating Geometry
Y Sets the coordinate position along the Y axis for the start point of a wall segment in the active construction plane.

Z Sets the coordinate position along the Z axis for the start point of a wall segment in the active construction plane.

Add Point Adds the point from the X, Y, and Z coordinate values you enter.

Close Ends creation of the wall object and creates a segment between the end point of the last segment and the start point of the first segment, to make a closed wall.

Finish Ends creation of the wall object, leaving it open ended.

Pick Spline Lets you use a spline as the wall path. Click this, and then click a spline in the viewport to use as the wall path. 3ds Max uses the spline as the path along which to apply the wall object. 3ds Max doesn’t immediately recognize 2D Shapes from a linked AutoCAD drawing. To recognize Shapes from a linked AutoCAD drawing, edit the Shape with Edit Spline on page 1424 from the Modify panel.

NOTE If you designate a curved spline as the path, 3ds Max creates straight wall segments that approximate the spline as closely as possible, with one wall segment per spline segment.

Parameters rollout

![Parameters rollout](image)

AEC Extended Objects | 499
The defaults produce a wall object 5 units wide, 96 units high, and justified at the center of the wall.

**Width** Sets the thickness of the wall. Range=0.01 unit to 100,000 units. Default=5.

**Height** Sets the height of the wall. Range=0.01 unit to 100,000 units. Default=96.

**Justification group**

**Left** Justifies the wall at the left edge of its baseline (the line between the wall's front and back sides, which is equal to the wall thickness). If you turn Grid Snap on, the left edge of the wall's baseline snaps to the grid line.

**Center** Justifies the wall at the center of its baseline. If you turn Grid Snap on, the center of the wall's baseline snaps to the grid line. This is the default.

**Right** Justifies the wall at the right edge of its baseline. If you turn Grid Snap on, the right edge of the wall's baseline snaps to the grid line.

**Generate Mapping Coords** Assigns mapping coordinates on page 8628 to the wall. Default=on.

**Real-World Map Size** Controls the scaling method used for texture mapped materials that are applied to the object. The scaling values are controlled by the Use Real-World Scale settings found in the applied material's Coordinates rollout on page 6201. Default=off.

**Editing Wall Objects**

Select a wall object. > Modify panel

This topic describes the Wall options on the Modify panel.

**TIP** It’s generally easiest to edit wall objects in wireframe mode.

**See also:**

■ **Wall** on page 491
Interface

Edit Object rollout

This rollout appears when you select a wall object at the object level; other rollouts, discussed below appear at the different sub-object levels.

Attach  Attaches another wall in a viewport to the selected wall by a single pick. The object you attach must also be a wall. 3ds Max applies the material of the selected wall to the wall being attached.

Attach Multiple  Attaches other walls in a viewport to the selected wall. Click this button to open the Attach Multiple dialog, which lists all the other wall objects in the scene. Select the walls you want to attach from the list and click the Attach button. 3ds Max applies the material of the selected wall to the walls being attached.

Justification group

See Justification on page 500.

Generate Mapping Coords.  Assigns mapping coordinates on page 8628 to the wall. Default=on.

Real-World Map Size  Controls the scaling method used for texture mapped materials that are applied to the object. The scaling values are controlled by the Use Real-World Scale settings found in the applied material's Coordinates rollout on page 6201. Default=off.
**Edit Vertex rollout**

Appears at the Vertex sub-object level. Each wall segment has two vertices; one in each bottom corner. In wireframe views, wall vertices appear as + symbols. Connected segments in the same wall object each share a vertex. Moving a wall vertex has the effect of scaling attached segments as well as rotating them about their other vertices. You cannot rotate or scale wall vertices.

**Connect** Lets you connect any two vertices, creating a new linear segment between the vertices.
Click this button, click a vertex, and then click a second vertex on a different segment. When you move the cursor over a valid second vertex, the mouse icon changes to a Connect icon.

**Break** Lets you disconnect segments at a shared vertex.

**TIP** Select a vertex shared between wall segments, and then click the Break button. The segments become disconnected, and each has its own end vertex at the position of the previously shared vertex.

**Refine** Adds a vertex to the position along a wall segment that you click.
When you move the cursor over a valid Refine point, the mouse icon changes to a Refine icon.

**Insert** Inserts one or more vertices, creating additional segments. When you move the cursor over a valid Insert point, the mouse icon changes to an Insert icon. Right-click to stop inserting new vertices and segments.

**Delete** Deletes the currently selected vertex or vertices, including any segments in between.
Deleting vertices shared by two or more segments doesn’t create a gap, but rather results in a single segment connecting vertices adjacent to those being deleted.
Edit Segment rollout

This rollout appears when you select a wall object and then access Segment sub-object level.

Each wall segment is defined by, and effectively connects, two wall vertices. Moving a segment is the same as moving its two vertices in tandem. It has the effect of scaling adjacent wall segments as well as rotating them about their other vertices. You can scale a wall segment horizontally only (any Scale function does this). You cannot rotate a segment.

Break Specifies a break point in a wall segment.
You needn't select a segment first. When you move the cursor over the object, the mouse icon changes to a Break icon. The position you select on the segment becomes two coincident vertices, and 3ds Max breaks the segment in two.

Detach Detaches wall segments you select and creates a new wall object out of them.

Same Shape Detaches the wall segment keeping it part of the same wall object. If you also turn on Copy, 3ds Max places a detached copy of the segment in the same location.
Reorient Detaches the wall segment, copies the object’s Local coordinate system on page 8621, and places the segment so that its object Local coordinate system is coincident with the World space origin on page 8768. If you also turn on Copy, 3ds Max detaches a copy of the segment and leaves the original segments in place.

Copy Copies the detached wall segment rather than moving it.

Divide Subdivides each segment by the number of vertices specified in the Divisions spinner. Select one or more segments, set the Divisions spinner, and then click Divide.

Divisions Sets the number by which to divide the segment.

Insert Provides the same function as the Insert button on page 502 in Vertex sub-object selection. Inserts one or more vertices, creating additional segments. When you move the cursor over the a valid Insert point, the mouse icon changes to an Insert icon. Right click to stop inserting new vertices and segments.

Delete Deletes any selected wall segments in the current wall object.

Refine Provides the same function as the Refine button on page 502 at the Vertex sub-object level. Adds a vertex to the position along a wall segment you select. When you move the cursor over a valid Refine point, the mouse icon changes to a Refine icon.

Parameters group

Width Changes the width of a selected segment or segments.

Height Changes the height of a selected segment or segments.

Bottom Offset Sets the distance of the bottom of the selected segment or segments from the floor.

Edit Profile rollout

This rollout appears when you select a wall object and then access Profile sub-object level.

The term "profile" refers to the outline of a wall segment's top and bottom edges. When in Profile sub-object mode, the selected wall object's inner horizontal edges appear dark orange. Click any of these edges to select the corresponding segment, highlight it in red, and place a temporary active grid in the plane of the segment. At that point, you can insert and delete vertices.
along the horizontal edges, move an inserted vertex along the grid to change
the profile, create gables, and change the grid properties.

![Edit Profile](image)

**Insert** Inserts a vertex so that you can adjust the profile of the selected wall segment.

Use this option to adjust the profile of walls under gables or to align walls to a slope. When you move the cursor over the selected segment, the mouse icon changes to an Insert icon. Click to insert a new profile point, then drag and release to position and place it. You can add new profile points to both the top and the bottom of the wall, but you cannot position profile points below the original top edge or above the original bottom edge.

**Delete** Deletes the selected vertices on the profile of the selected wall segment.

**Create Gable** Creates a gable by moving the center point of the top profile of the selected wall segment to a height you specify.

Select the segment, set the height, and then click Create Gable.

**Height** Specifies the height of a gable.

**Grid Properties group**

The grid constricts profile point insertion and movement to the plane of the wall and allows you to snap to grid points on the plane of the wall.

**Width** Sets the width of the active grid.

**Length** Sets the length of the active grid.

**Spacing** Sets the size of the smallest square in the active grid.
Stairs

Create panel > Geometry > Stairs
Create menu > AEC Objects

You can create four different types of stairs in 3ds Max: Spiral Stair on page 514, Straight Stair on page 519, L-Type Stair on page 511, or U-Type Stair on page 522.

Railings and Materials

By default, 3ds Max assigns seven different material IDs to stairs. The aectemplates.mat material library includes Stair-Template, a multi/sub-object material on page 6120 designed to be used with stairs. Each component of the stair/material is listed below along with its corresponding Material ID.

<table>
<thead>
<tr>
<th>Material ID</th>
<th>Railing/Material Component</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Treads of the stairs</td>
</tr>
<tr>
<td>2</td>
<td>Front riser of the stairs</td>
</tr>
<tr>
<td>3</td>
<td>Bottom, back, and sides of the risers of the stairs</td>
</tr>
<tr>
<td>4</td>
<td>Center pole of the stairs</td>
</tr>
<tr>
<td>5</td>
<td>Handrails of the stairs</td>
</tr>
<tr>
<td>6</td>
<td>Carriage of the stairs</td>
</tr>
<tr>
<td>7</td>
<td>Stringers of the stairs</td>
</tr>
</tbody>
</table>

NOTE 3ds Max does not automatically assign a material to the stairs object. To use the included material, open the library and then assign the material to your object.
Procedures

To create railings on stairs:

1. Create the stairs. See individual stair-type topics for more information.

2. In the Generate Geometry group, turn on Rail Path > Left and Right. 3ds Max places left and right rail paths above the stairs.

3. In the Railings rollout, set Height to 0.0.

4. Click Create panel > AEC Extended > Railing on page 482 to create the first railing.

5. Click Railing rollout > Pick Railing Path and select one of the rail paths on the stairs.

6. Adjust the railing parameters. 3ds Max remembers the parameters you set. When you create the next railing, it will have the same parameters as you set for the first railing.

7. Right-click to end the creation of the first railing.

8. Click Railing again to create the second railing.

9. Click Pick Railing Path and select the other rail path on the stairs.

Interface

Object Type rollout

Stair Selection Buttons Click one of these to specify the type of stairs you want to create.

Name and Color rollout

This rollout lets you set the stairs object’s name and color. For detailed information, see Object Name and Wireframe Color on page 8182.
Parameters rollout > Type group

Open Creates an open riser stair, as shown on the left in the illustration above.

Closed Creates a closed riser stair, as shown in the center in the illustration above.

Box Creates a stair with closed risers and closed stringers on both sides, as shown on the right in the illustration above.

Rise group

3ds Max keeps one Rise option locked while you adjust the other two. To lock an option, you click a push pin. To unlock an option you click a raised push pin. 3ds Max locks the spinner value of the parameter with the depressed push pin and allows the spinner values of the parameter with the raised push pins to change.

Overall Controls the height of the flight of stairs.

Riser Ht Controls the height of the risers.

Riser Ct Controls the number of risers. There will always be one more riser than steps. This implied riser is between the top step of the stair and the upper floor.
Linear stair with five risers
1 through 4. Risers
5. The implied riser
6. The upper floor you snap to
7. The lower floor you snap to
8. The steps

**Stringers rollout**

These controls are available only when you turn on Stringers on the Parameters rollout > Generate Geometry group.

- **Depth** Controls how far down the stringers reach toward the floor.
- **Width** Controls the width of the stringers.
- **Offset** Controls the vertical distance of the stringers from the floor.
- **Spring from Floor** Controls whether the stringer starts at the floor, flush with the start of the first riser, or if the stringer extends below the floor. You control the amount the stringer extends below the floor with the Offset option.
Carriage rollout

These controls are available only when you turn on Carriage on the Parameters rollout > Generate Geometry group.

Depth Controls how far down the carriage reaches toward the floor.

Width Controls the width of the carriage.

Carriage Spacing Sets the spacing of the carriage. When you click this button, the Carriage Spacing dialog displays. Specify the number of carriages you want using the Count option. For more information on spacing options in this dialog, see Spacing Tool on page 953.

Spring from Floor Controls whether the carriage starts at the floor, flush with the start of the first riser, or if the carriage extends below the floor. You control the amount the carriage extends below the floor with the Offset option.
**Railings rollout**

These controls are available only when you turn on one or more of the Handrail or Rail Path options on the Parameters rollout > Generate Geometry group. Also, Segments and Radius aren’t available if neither of the Handrail options is on.

**Height** Controls the height of the railings from the steps.

**Offset** Controls the offset of the railings from the ends of the steps.

**Segments** Controls the number of segments in the railings. Higher values display smoother railings.

**Radius** Controls the thickness of the railings.

**L-Type Stair**

Create panel > Geometry > Stairs > L-Type Stair button
Create menu > AEC Objects > L-Type Stair

The L-Type Stair object lets you create a staircase with two flights at right angles to each other.

Types of L-type stair: open, closed, and boxed
L-type stairs have two flights at right angles, and a landing.

Procedures

To create L-Type stairs:

1. In any viewport, drag to set the length for the first flight. Release the mouse button, then move the cursor and click to set the length, width, and direction for the second flight.

2. Move the cursor up or down to define the rise of the stairs, then click to end.

3. Adjust the stairs by using the options in the Parameters rollout.

Interface

Generate Geometry group
**Stringers** Creates stringers along the ends of the treads of the stairs. To modify the stringers’ depth, width, offset and spring from the floor, see Stringers rollout on page 509.

**Carriage** Creates an inclined, notched beam under the treads which supports the steps or adds support between the stringers of the stairs. You might also know this as a *carriage piece*, a *horse*, or a *rough string*. See Carriage rollout on page 510 to modify the parameters.

**Handrail** Creates left and right handrails. See Railings rollout on page 511 to modify the handrails’ height, offset, number of segments, and radius.

**Rail Path** Creates left and right paths you can use to install railings on the stairs. See Stairs on page 506 for the instructions on how to do this.

**Layout group**

<table>
<thead>
<tr>
<th>Layout</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Length 1</td>
<td>0.0</td>
</tr>
<tr>
<td>Length 2</td>
<td>0.0</td>
</tr>
<tr>
<td>Width</td>
<td>33.0</td>
</tr>
<tr>
<td>Angle</td>
<td>45.0</td>
</tr>
<tr>
<td>Offset</td>
<td>0.0</td>
</tr>
</tbody>
</table>

**Length 1** Controls the length of the first flight of stairs.

**Length 2** Controls the length of the second flight of stairs.

**Width** Controls the width of the stairs, including the steps and the landing.

**Angle** Controls the angle of the second flight from the landing. Range=-90 to 90 degrees.

**Offset** Controls the distance of the second flight from the landing. The length of the landing adjusts accordingly.

**Steps group**

<table>
<thead>
<tr>
<th>Steps</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Thickness</td>
<td>2.0</td>
</tr>
<tr>
<td>Depth</td>
<td>12.0</td>
</tr>
</tbody>
</table>

Stairs | 513
**Thickness** Controls the thickness of the steps.

**Depth** Controls the depth of the steps.

---

**Generate Mapping Coords** Applies default mapping coordinates on page 8628 to the stairs.

**NOTE** If a visible viewport is set to a non-wireframe or non-bounding-box display, Generate Mapping Coordinates is on for all primitives to which you apply a material containing a map with Show Map In Viewport on. If all viewports are set to wireframe or bounding box, 3ds Max turns on Generate Mapping Coordinates for primitives containing mapped materials at render time.

**Real-World Map Size** Controls the scaling method used for texture mapped materials that are applied to the object. The scaling values are controlled by the Use Real-World Scale settings found in the applied material’s Coordinates rollout on page 6201. Default=off.

---

**Spiral Stair**

Create panel > Geometry > Stairs > Spiral Stair button
Create menu > AEC Objects > Spiral Stair

The Spiral Stair object lets you specify the radius and number of revolutions, add stringers and a center pole, and more.

Types of spiral stair: open, closed, and boxed

Spiral stairs wind around a center

Procedures

To create spiral stairs:

1 In any viewport, click for the start point of the stairs, and drag to specify the radius you want.
2 Release the mouse button, move the cursor up or down to specify the overall rise, and click to end.
3 Adjust the stairs with options in the Parameters rollout.

Interface

Generate Geometry group

Generate Geometry
- Stringers
- Carriage
- Center Pole
Handrail: Inside
Outside
Rail Path: Inside
Outside
Stringers Creates stringers along the ends of the treads of the stairs. To modify the stringers’ depth, width, offset and spring from the floor, see Stringers rollout on page 509.

Carriage Creates an inclined, notched beam under the treads which supports the steps or adds support between the stringers of the stairs. You might also know this as a carriage piece, a horse, or a rough string. See Carriage rollout on page 510 to modify the parameters.

Center Pole Creates a pole at the center of the spiral. See Center Pole rollout on page 518 to modify the parameters of the pole.

Handrail Creates inside and outside handrails. See Railings rollout on page 511 to modify the handrails’ height, offset, number of segments, and radius.

Rail Path Creates inside and outside paths which you can use to install railings on the stairs. See Stairs on page 506 for the instructions on how to do this.

Layout group

CCW Orient the spiral stairs to be a right-hand flight of stairs.

CW Orient the spiral stairs to be a left-hand flight of stairs.

Left: CCW (counterclockwise) right-hand spiral stairs. The arrow indicates “Up.”

Right: CW (clockwise) left-hand spiral stairs. The arrow indicates “Up.”
**Radius** Controls the size of the radius of the spiral.

**Revs** Controls the number of revolutions in the spiral.

**Width** Controls the width of the spiral stairs.

**Steps group**

**Thickness** Controls the thickness of the steps.

**Depth** Controls the depth of the steps.

**Segs** Controls the number of segments 3ds Max uses to construct the steps.

**Generate Mapping Coords** Applies default mapping coordinates on page 8628 to the stairs.
NOTE If a visible viewport is set to a non-wireframe or non-bounding-box display, Generate Mapping Coordinates is on for all primitives to which you apply a material containing a map with Show Map In Viewport on. If all viewports are set to wireframe or bounding box, 3ds Max turns on Generate Mapping Coordinates for primitives containing mapped materials at render time.

Real-World Map Size Controls the scaling method used for texture mapped materials that are applied to the object. The scaling values are controlled by the Use Real-World Scale settings found in the applied material’s Coordinates rollout on page 6201. Default=off.

Center Pole rollout

These controls are available only when you turn on Center Pole on the Parameters rollout > Generate Geometry group.

Radius Controls the radius size of the center pole.

Segments Controls the number of segments in the center pole. Higher values display a smoother pole.

Height The spinner controls the height of the center pole. Turning on Height lets you adjust the height of the pole independently of the stairs. Turning off Height makes the spinner unavailable and locks the top of the pole to the top of the implied last riser. Typically, this riser would attach to the fascia of a landing.
Left: The center pole locked to the top of the implied last riser. (Height turned off.)

Right: The center pole adjusted to the height you specify. (Height turned on.)

**Straight Stair**

Create panel > Geometry > Stairs > Straight Stair button

Create menu > AEC Objects > Straight Stair

The Straight Stair object lets you create a simple staircase, with optional stringers, carriage, and handrail.

Types of straight stair: open, closed, and boxed

Straight stairs have a single flight.

**Procedures**

To create straight stairs:

1. In any viewport, drag to set the length. Release the mouse button, then move the cursor and click to set the width you want.

2. Move the cursor up or down to define the rise of the stairs, and click to end.
3 Adjust the stairs with the options in the Parameters rollout.

**Interface**

**Generate Geometry group**

![Generate Geometry panel]

**Stringers** Creates stringers along the ends of the treads of the stairs. To modify the stringers’ depth, width, offset and spring from the floor, see Stringers rollout on page 509.

**Carriage** Creates an inclined, notched beam under the treads which supports the steps or adds support between the stringers of the stairs. You might also know this as a carriage piece, a horse, or a rough string. See Carriage rollout on page 510 to modify the parameters.

**Handrail** Creates left and right handrails. See Railings rollout on page 511 to modify the handrails’ height, offset, number of segments, and radius.

**Rail Path** Creates left and right paths you can use to install railings on the stairs. See Stairs on page 506 for the instructions on how to do this.

**Layout group**

![Layout panel]

**Length** Controls the length of the stairs.

**Width** Controls the width of the stairs.
Steps group

**Thickness** Controls the thickness of the steps.

**Depth** Controls the depth of the steps.

**Generate Mapping Coords** Applies default mapping coordinates on page 8628 to the stairs.

**NOTE** If a visible viewport is set to a non-wireframe or non-bounding-box display, Generate Mapping Coordinates is on for all primitives to which you apply a material containing a map with Show Map In Viewport on. If all viewports are set to wireframe or bounding box, 3ds Max turns on Generate Mapping Coordinates for primitives containing mapped materials at render time.

**Real-World Map Size** Controls the scaling method used for texture mapped materials that are applied to the object. The scaling values are controlled by
the Use Real-World Scale settings found in the applied material's Coordinates rollout on page 6201. Default=off.

**U-Type Stair**

Create panel > Geometry > Stairs > U-Type Stair button
Create menu > AEC Objects > U-Type Stair

The U-Type Stair object lets you create a two-flight staircase, with the two flights parallel to each other and a landing between them.

Types of U-type stair: open, closed, and boxed

U-type stairs have two flights in opposite directions, and a landing.

**Procedures**

To create U-Type stairs:

1. In any viewport, drag to set the length for the first flight. Release the mouse button, then move the cursor and click to set the width of the landing, or the distance separating the two flights.
2. Click and move the cursor up or down to define the rise of the stairs, then click to end.
3. Adjust the stairs by using the options in the Parameters rollout.
Interface

Generate Geometry group

Stringers Creates stringers along the ends of the treads of the stairs. To modify the stringers’ depth, width, offset and spring from the floor, see Stringers rollout on page 509.

Carriage Creates an inclined, notched beam under the treads which supports the steps or adds support between the stringers of the stairs. You might also know this as a carriage piece, a horse, or a roughstring. See Carriage rollout on page 510 to modify the parameters.

Handrail Creates left and right handrails. See Railings rollout on page 511 to modify the handrails’ height, offset, number of segments, and radius.

Rail Path Creates left and right paths you can use to install railings on the stairs. See Stairs on page 506 for the instructions on how to do this.

Layout group

Left/Right Controls the position of the two flights (Length 1 and Length 2) relative to each other. If you select left, then the second flight is on the left
from the landing. If you select right, then the second flight is the right from the landing.

**Length 1** Controls the length of the first flight of stairs.

**Length 2** Controls the length of the second flight of stairs.

**Width** Controls the width of the stairs, including the steps and the landing.

**Offset** Controls the distance separating the two flights and thus the length of the landing.

**Steps group**

![Steps](image)

**Thickness** Controls the thickness of the steps.

![Step thickness variance between two stairs](image)

**Depth** Controls the depth of the steps.

![Step depth variance between two stairs](image)
Generate Mapping Coords  Applies default mapping coordinates on page 8628 to the stairs.

NOTE  If a visible viewport is set to a non-wireframe or non-bounding-box display, Generate Mapping Coordinates is on for all primitives to which you apply a material containing a map with Show Map In Viewport on. If all viewports are set to wireframe or bounding box, 3ds Max turns on Generate Mapping Coordinates for primitives containing mapped materials at render time.

Real-World Map Size  Controls the scaling method used for texture mapped materials that are applied to the object. The scaling values are controlled by the Use Real-World Scale settings found in the applied material's Coordinates rollout on page 6201. Default=off.

Doors

Create panel > Geometry > Doors
Create menu > AEC Objects

The door models provided let you control details of a door's appearance. You can also set the door to be open, partially open, or closed, and you can animate the opening.
Different door types in a model of a house

There are three kinds of doors. The **Pivot door** on page 535 is the familiar door that is hinged on one side only. The **Bifold door** on page 539 is hinged in the middle as well as the side, like many closet doors. You can also make these kinds of doors a set of double doors. The **Sliding door** on page 537 has a fixed half and a sliding half.

The topic for each kind of door describes its unique controls and behavior. Most door parameters are common to all kinds of doors, and are described here.

**Doors and Materials**

By default, 3ds Max assigns five different material IDs to doors. The `aectemplates.mat` material library includes **Door-Template**, a multi/sub-object material designed to be used with doors. Each component of the door/material is listed below along with its corresponding Material ID.
<table>
<thead>
<tr>
<th>Material ID</th>
<th>Door/Material Component</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Front</td>
</tr>
<tr>
<td>2</td>
<td>Back</td>
</tr>
<tr>
<td>3</td>
<td>Inner Bevel (used for glazing when Panels set to Glass or Beveled).</td>
</tr>
<tr>
<td>4</td>
<td>Frame</td>
</tr>
<tr>
<td>5</td>
<td>Inner Door</td>
</tr>
</tbody>
</table>
NOTE 3ds Max does not automatically assign a material to the door object. To use the included material, open the library and then assign the material to your object.

Making an Opening for a Door

To make an opening in a wall, you can perform a Boolean operation on page 713 with the wall as Operand A, and another object, such as a box, as Operand B. Then, you can create and add a door in the opening, and link on page 3630 it, if you choose, as a child of the wall.

NOTE Using snaps, you can insert a door in a wall object, automatically linking the two and creating a cutout for the door. See the procedure To create and place a window or door in a wall: on page 497.

Procedures

To create a door:

1. On the Object Type rollout, click the button for the type of door you want to create.

2. Choose options as needed, such as changing the default creation method. Turn off Create Frame to eliminate the door frame. Turn on Allow Non-vertical Jambs if you want an inclined door.

3. Drag the mouse in the viewport to create the first two points, defining the width and angle of the base of the door.

4. Release the mouse and move to adjust the depth of the door (default creation method), and then click to set. By default, the depth is perpendicular to the line between the first two points and parallel to the active grid.

5. Move the mouse to adjust the height, and then click to finish. The height is perpendicular to the plane defined by the first three points and perpendicular to the active grid.

You can adjust the Height, Width, and Depth values on the Parameters rollout.

On the Creation Method rollout, you can change the creation order to width-height-depth instead of width-depth-height.
To create a door material:

1. Create a door or select an existing door.
2. Open the Material Editor, and select a slot for the material.
3. Click the Type button below the Material Editor toolbar. The Material/Map Browser dialog opens.
4. In the Material list, double-click the Multi/Sub-Object item, and then on the Replace Material dialog that appears, choose either option and click OK.
5. On the Multi/Sub-Object Basic Parameters rollout, click Set Number and change Number Of Materials to 5. Click OK.
6. Optionally, change the sub-material names to those specified in the above table on page 527.
7. Edit the material as you would any Multi/Sub-Object material.

To animate a door:

You can animate a door opening and closing by keyframing the Open setting.

1. Create a door or select an existing door.
   If using an existing door, also access the Modify panel.
2. Set the Parameters rollout > Open parameter to the amount you want the door to be open at the start of the animation. If you want it to be closed, set it to 0.
3. Click the Auto Key button and advance to the first keyframe.
4. Change the Open setting.
5. Continue moving to any additional keyframes and changing the Open setting as necessary.
6. Play the animation.

Interface

The topic for each kind of door describes its unique controls and behavior. Most door parameters are common to all kinds of doors, and are described here.
Object Type rollout

There are three kinds of doors in 3ds Max:

**Pivot** The familiar door type that is hinged on one side only. See Pivot Door on page 535.

**Sliding** Has a fixed half and a sliding half. See Sliding Door on page 537.

**BiFold** Hinged in the middle as well as the side, like many closet doors. You can also use this type of door to make a set of double doors. See BiFold Door on page 539.

Name and Color rollout

See Object Name and Wireframe Color on page 8182.

Creation Method rollout

You define each type of door with four points: Drag the first two, followed by two move-click sequences. The Creation Method setting determines the order in which these actions define the door's dimensions.

**Width/Depth/Height** The first two points define the width and angle of the base of the door. You set these points by dragging in a viewport, as the first step in creating a door. The first point, where you click and hold before dragging, defines a point on the jamb at the hinge for single-pivot and bifold doors (both jambs have hinges on double doors, and sliding doors have no hinge). The second point, where you release the button after dragging, specifies the width of the door, as well as the direction from one jamb to the other.
This lets you align the door with a wall or opening when you place it. The third point, where you click after moving the mouse, specifies the depth of the door, and the fourth click, where you click after moving the mouse again, specifies the height.

**Width/Height/Depth** Works like the Width/Depth/Height option, except that the last two points create first the height and then the depth.

**NOTE** With this method, the depth is perpendicular to the plane set by the first three points. Thus, if you draw the door in the Top or Perspective viewport, the door lies flat on the active grid.

**Allow Non-vertical Jambs** Lets you create tilted doors. Set snaps on page 2807 to define points off the construction plane. Default=off.
Parameters rollout

Height Sets the overall height of the door unit.

Width Sets the overall width of the door unit.

Depth Sets the depth of the door unit.

Open With Pivot doors, specifies in degrees the extent to which the door is open. With Sliding and BiFold doors, Open specifies the percent that the door is open.
Frame group

This rollout has controls for the door-jamb frame. Though part of the door object, the frame behaves as if it were part of the wall. It doesn't move when you open or close the door.

Create Frame This is turned on as a default to display the frame. Turn this off to disable display of the frame.

Width Sets the width of the frame parallel to the wall. Available only when Create Frame is on.

Depth Sets the depth of the frame as it projects from the wall. Available only when Create Frame is on.

Door Offset Sets the location of the door relative to the frame. At 0.0, the door is flush with one edge of the trim. Note that this can be a positive or negative value. Available only when Create Frame is on.

Generate Mapping Coords Assigns mapping coordinates to the door.

Real-World Map Size Controls the scaling method used for texture mapped materials that are applied to the object. The scaling values are controlled by the Use Real-World Scale settings found in the applied material's Coordinates rollout on page 6201. Default=off.
Leaf Parameters rollout

Provides controls that affect the door itself (as opposed to the door unit, which includes the frame). You can adjust the dimensions of the door, add panels, and adjust the dimensions and placement of those panels. The total number of panels for each door element is the number of horizontal divisions times the number of vertical divisions. Pivot doors have a single door element unless they are double doors. BiFold doors have two door elements, or four if they are double doors. Sliding doors have two door elements.

**Thickness** Sets the thickness of the door.

**Stiles/Top Rail** Sets the width of the panel framing on the top and sides. This setting is apparent only if the door is paneled.

**Bottom Rail** Sets the width of the panel framing at the base of the door. This setting is apparent only if the door is paneled.
# Panels Horiz. Sets the number of panel divisions along the horizontal axis.
# Panels Vert. Sets the number of panel divisions along the vertical axis.
Muntin Sets the width of the separations between the panels.

**Panels group**

Determines how panels are created in the door.

None The door has no paneling.
Glass Creates glass panels with no beveling.
Thickness Sets the thickness of the glass panels.
Beveled Choose this to have beveled panels.
The remaining spinners affect the beveling of the panels.
Bevel Angle Specifies the angle of the bevel between the outer surface of the door and the surface of the panel.
Thickness 1 Sets the outer thickness of the panel.
Thickness 2 Sets the thickness where the bevel begins.
Middle Thick. Sets the thickness of the inner part of the panel.
Width 1 Sets the width where the bevel begins.
Width 2 Sets the width of the inner part of the panel.

**Pivot Door**

Create panel > Geometry > Doors > Pivot button
Create menu > AEC Objects > Pivot Door
The Pivot door is hinged on one side only. You can also make the door a double door, with two door elements, each hinged on its outer edge.
Single and double pivot doors

This topic describes only controls and behavior unique to the Pivot door. Most door parameters are common to all kinds of doors; see Doors on page 525.
Interface

Parameters rollout

The Parameters rollout contains three check boxes specific to Pivot doors.

**Double Doors** Makes a double door.

**Flip Swing** Changes the direction the door swings.

**Flip Hinge** Places the door hinges on the opposite side of the door. This option is unavailable for double doors.

**Sliding Door**

Create panel > Geometry > Doors > Sliding button
Create menu > AEC Objects > Sliding Door

The Sliding door slides as if on a track or railing. It has two door elements: one remains stationary while the other moves.
Sliding doors with different numbers of panels

This topic describes only controls and behavior unique to the Sliding door. Most door parameters are common to all kinds of doors; see Doors on page 525.
Interface

Parameters rollout

Flip Front Back Changes which element is in front, compared to the default.

Flip Side Changes the current sliding element to the stationary element, and vice versa.

BiFold Door

Create panel > Geometry > Doors > BiFold button
Create menu > AEC Objects > BiFold Door

The BiFold door is hinged in the middle as well as on the side. It has two door elements. You can also make the door a double door, with four door elements.
Single and double bifold doors

This topic describes only controls and behavior unique to the BiFold door. Most door parameters are common to all kinds of doors; see Doors on page 525.
Interface

Parameters rollout

The Parameters rollout contains three check boxes specific to BiFold doors.

**Double Doors** Makes the door a double door, with four door elements, meeting in the center.

**Flip Swing** Makes the door swing in the opposite direction from the default.

**Flip Hinge** Makes the door hinged on the opposite side from the default. Flip Hinge is unavailable when Double Doors is on.

Windows

Create panel > Geometry > Windows
Create menu > AEC Objects

The window object lets you control details of a window's appearance. You can also set the window to be open, partially open, or closed, and you can animate the opening over time.
Different types of windows in a model of a house

3ds Max offers six kinds of windows:

- The **Casement window** on page 552 has one or two door-like sashes that swing inward or outward.
- The **Pivoted window** on page 556 pivots at the center of its sash, either vertically or horizontally.
- The **Projected window** on page 558 has three sashes, two of which open like awnings in opposite directions.
- The **Sliding window** on page 560 has two sashes, one of which slides either vertically or horizontally.
- The **Fixed window** on page 554 doesn't open.
- The **Awning window** on page 549 has a sash that is hinged at the top.

**Windows and Materials**

By default, 3ds Max assigns five different material IDs to windows. The *aeetemplates.mat* material library includes *Window-Template*, a multi/sub-object
material designed to be used with windows. Each component of the window/material is listed below along with its corresponding Material ID.

<table>
<thead>
<tr>
<th>Material ID</th>
<th>Window/Material Component</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Front Rails</td>
</tr>
<tr>
<td>2</td>
<td>Back Rails</td>
</tr>
<tr>
<td>3</td>
<td>Panels (glazing), with 50% opacity</td>
</tr>
<tr>
<td>4</td>
<td>Front Frame</td>
</tr>
<tr>
<td>5</td>
<td>Back Frame</td>
</tr>
</tbody>
</table>
NOTE 3ds Max does not automatically assign a material to the window object. To use the included material, open the library and then assign the material to your object.

Making an Opening for a Window

To make an opening in a wall, you can perform a **Boolean operation** on page 713 with the wall as Operand A, and another object, such as a box, as Operand B. Then, you can create and add a window in the opening, and **link** on page 3630 it, if you choose, as a child of the wall.

NOTE Using snaps, you can insert a window in a wall object, automatically linking the two and creating a cutout for the window. See the procedure **To create and place a window or door in a wall**: on page 497.

Procedures

To create a window:

1. On the Object Type rollout, click the button for the type of window you want to create.

2. Choose options as needed, such as changing the default creation method. Turn on **Allow Non-vertical Jambs** if you want an inclined window.

3. Drag the mouse in the viewport to create the first two points, defining the width and angle of the base of the window.

4. Release the mouse and move to adjust the depth of the window (default creation method), and then click to set.
   
   By default, the depth is perpendicular to the line between the first two points and parallel to the active grid.

5. Move the mouse to adjust the height, and then click to finish.
   
   The height is perpendicular to the plane defined by the first three points and perpendicular to the active grid.

   You can adjust the height, width, and depth values on the **Parameters rollout**.

   In the Creation Method rollout, you can change the creation order to **width-height-depth** instead of **width-depth-height**.
To create a window material:

1. Create a window or select an existing window.
2. Open the Material Editor, and select a slot for the material.
3. Click the Type button below the Material Editor toolbar. The Material/Map Browser dialog opens.
4. In the Material list, double-click the Multi/Sub-Object item, and then on the Replace Material dialog that appears, choose either option and click OK.
5. On the Multi/Sub-Object Basic Parameters rollout, click Set Number and change Number Of Materials to 5. Click OK.
6. Optionally, change the sub-material names to those specified in the above table on page 543.
7. Edit the material as you would any Multi/Sub-Object material.

To animate a window:

You can animate a window opening and closing by keyframing the Open setting.

1. Create a window or select an existing window.
2. If using an existing window, also access the Modify panel.
3. Set the Parameters rollout > Open parameter to the amount you want the window to be open at the start of the animation. If you want it to be closed, set it to 0.
4. Click the Auto Key button on page 8090 to turn it on, and advance to the first keyframe.
5. Change the Open setting.
6. Continue moving to any additional keyframes and changing the Open setting as necessary.
7. Play the animation.
**Interface**

Most window parameters are common to all kinds of windows, and are described here. The topic for each window type describes its unique controls and behavior.

**Object Type rollout**

Six types of window are available in 3ds Max:

- **Awning** Has a sash that is hinged at the top. See Awning on page 549.
- **Casement** Has one or two door-like sashes that swing inward or outward. See Casement on page 552.
- **Fixed** Doesn't open. See Fixed on page 554.
- **Pivoted** Pivots at the center of its sash, either vertically or horizontally. See Pivoted on page 556.
- **Projected** Has three sashes, two of which open like awnings in opposite directions. See Projected on page 558.
- **Sliding** Has two sashes, one of which slides vertically or horizontally. See Sliding on page 560.

**Name and Color rollout**

See Object Name and Wireframe Color on page 8182.
**Creation Method rollout**

You define each type of window with four points: Drag the first two, followed by two move-click sequences. The Creation Method setting determines the order in which these actions define the window's dimensions.

**Width/Depth/Height** The first two points define the width and angle of the base of the window. You set these points by dragging in a viewport, as the first step in creating a window. This lets you align the window with a wall or opening when you place it. The third point, where you click after moving the mouse, specifies the depth of the window, and the fourth click, where you click after moving the mouse again, specifies the height.

**Width/Height/Depth** Works like the Width/Depth/Height option, except that the last two points create first the height and then the depth.

**NOTE** With this method, the depth is perpendicular to the plane set by the first three points. Thus, if you draw the window in the Top or Perspective viewport, the door lies flat on the active grid.

**Allow Non-vertical Jambs** Select to create tilted windows. Set snaps on page 2807 to define points off the construction plane. Default=off.
Parameters rollout

Height/Width/Depth Specifies the overall dimensions of the window.
Frame group

**Horiz. Width** Sets the width of the horizontal part of the window frame (at the top and bottom). This setting also affects the glazed portion of the window's width.

**Vert. Width** Sets the width of the vertical part of the window frame (at the sides). This setting also affects the glazed portion of the window's height.

**Thickness** Sets the thickness of the frame. This also controls the thickness of casements or railings on the window's sashes.

Glazing group

**Thickness** Specifies the thickness of the glass.

**Generate Mapping Coordinates** Creates the object with the appropriate mapping coordinates on page 8628 already applied.

**Real-World Map Size** Controls the scaling method used for texture mapped materials that are applied to the object. The scaling values are controlled by the Use Real-World Scale settings found in the applied material's Coordinates rollout on page 6201. Default=off.

Awning Window

Create panel > Geometry > Windows > Awning button
Create menu > AEC Objects > Awning Window

The Awning window has one or more sashes that are hinged at the top.
Awning window
Interface

Parameters rollout

The topic for each kind of window describes its unique controls and behavior. Some window parameters are common to all kinds of windows; see Windows on page 541.

Rails and Panels group

**Width** Sets the width (depth) of the rails in the sashes.

**Panel Count** Sets the number of sashes in the window. If you use more than one sash, each is hinged at its top edge. Range=1 to 10.

Open Window group

**Open** Specifies the percent the window is open. This control is animatable.
Casement Window

Create panel > Geometry > Windows > Casement button
Create menu > AEC Objects > Casement Window
The Casement window has one or two sashes that are hinged on the side, like a door.

Casement window
The topic for each kind of window describes its unique controls and behavior. Some window parameters are common to all kinds of windows; see Windows on page 541.

Casements group

Panel Width Changes the size of the glazed panel within each sash.

One/Two Specifies the number of window panels: one or two. Using two panels creates a window like a double door; each panel is hinged on its outside side edge.
**Open Window group**

*Open* Specifies the percent that the window is open. This control is animatable.

*Flip Swing* Turn this on to have the sashes open in the opposite direction.

**Fixed Window**

Create panel > Geometry > Windows > Fixed button
Create menu > AEC Objects > Fixed Window

Fixed windows do not open, thus have no Open Window control. In addition to the standard window object parameters, the Fixed window provides the Rails And Panels group of settings for subdividing the window.

![Fixed windows](image.png)
Interface

Parameters rollout

The topic for each kind of window describes its unique controls and behavior. Some window parameters are common to all kinds of windows; see Windows on page 541.

Rails and Panels group

**Width** Sets the width (depth) of the rails in the sashes.

**# Panels Horiz** Sets the number of horizontal divisions in the window.

**# Panels Vert** Sets the number of vertical divisions in the window.

**Chamfered Profile** Chamfers the rails between the glazed panels, as in a conventional wooden window. When Chamfered Profile is off, the rails have a rectangular profile.
Pivoted Window

Create panel > Geometry > Windows > Pivoted button
Create menu > AEC Objects > Pivoted Window

A pivoted window has one sash only, hinged midway through the side of the sash. It can swing open either vertically or horizontally.
Interface

Parameters rollout

The topic for each kind of Window describes its unique controls and behavior. Most Window parameters are common to all kinds of Windows; see Windows on page 541.

Rails group

Width Sets the width of the rails in the sash.

Pivots group

Vertical Rotation Switches the pivot axis from horizontal to vertical.
Open Window group

Open Specifies the percent that the window is open. This control is animatable.

Projected Window

Create panel > Geometry > Windows > Projected button
Create menu > AEC Objects > Projected Window

Projected windows have three sashes: The top sash doesn’t move, while the bottom two sashes swing open like awning windows, but in opposite directions.
Interface

Parameters rollout

The topic for each kind of window describes its unique controls and behavior. Some window parameters are common to all kinds of windows; see Windows on page 541.

Rails and Panels group

**Width** Sets the width (depth) of the rails in the sashes.

**Middle Height** Sets the height of the middle sash, relative to the window's frame.

**Bottom Height** Sets the height of the bottom sash, relative to the window’s frame.
**Open Window group**

*Open* Specifies the percent that the two movable sashes are open. This control is animatable.

**Sliding Window**

Create panel > Geometry > Windows > Sliding button
Create menu > AEC Objects > Sliding Window

Sliding windows have two sashes: one fixed, one movable. The sliding part can move either vertically or horizontally.
The topic for each kind of Window describes its unique controls and behavior. Most Window parameters are common to all kinds of Windows; see Windows on page 541.

**Rails and Panels group**

**Rail Width** Sets the width of the rails in the sash.

# **Panels Horiz** Sets the number of horizontal divisions in each sash.

# **Panels Vert** Sets the number of vertical divisions in each sash.
Chamfered Profile  Chamfers the rails between the glazed panels, as in a conventional wooden window. When Chamfered Profile is off, the rails have a rectangular profile.

Open Window group

Hung  When on, the window slides vertically. When off, the window slides horizontally.

Open  Specifies the percent that the window is open. This control is animatable.

mental ray Object

The mental ray object category contains one object type: the mr Proxy object. Use this object to lighten the rendering load with geometry-heavy scenes.

mr Proxy Object

Set mental ray as the current renderer. > Create panel > Geometry button > mental ray > Object Type rollout > mr Proxy button

The mr Proxy object is intended for use in large scenes to be rendered with mental ray. This object type is useful when scenes contain many instances of an object, such as an auditorium with hundreds or thousands of instances of a seat model. It is also particularly useful for objects with extremely high polygon counts, in that it obviates both the conversion to mental ray format and the presence of the source object at render time, thus saving time and freeing up a great deal of memory for rendering. The only drawbacks are the reduced fidelity of the proxy object in the viewports and the inability to edit proxies directly.

The basic usage of the mr Proxy object is that you create and optionally animate the “source” object, apply a material, and then save a copy to disk for possible future modification. Next, you convert the object to mr Proxy format and write the proxy to a disk file or series of files, after which it appears in the viewports as a point cloud (a set of vertices showing the object size and approximate shape). Finally, you delete the source object, as its presence in the scene is no longer necessary. You can then use the mr Proxy object like any object in the scene, instancing it, transforming it, and so on. When you
render, mental ray loads the disk files and uses the geometry defined therein. However, if you need to modify it (such as changing a modifier parameter, or editing a sub-object), you need to load the source object, modify it, reconnect it to the proxy object, and rewrite the files.

**NOTE** Using Select Similar on page 228 with an mr Proxy object selects all mr Proxy objects, even if they use different source objects.

### Procedures

**To use the mr Proxy object:**

1. Make sure mental ray is the active renderer.
2. Create or load the object that is to serve as the source object. Apply any necessary modifiers and material. Be sure to save a copy for future reference.
3. Add an mr Proxy object. Until you define the source object, the mr Proxy object appears in the scene as a wireframe cube.
4. Go to the Modify panel. The mr Proxy object requires that you specify the source object from the Modify panel.
5. Click the source object button, which currently reads “None,” and then select the source object. The name of the source object appears on the button.

**TIP** If you plan to modify the source object, do so before converting it to mr Proxy format. Because the mr Proxy geometry is loaded by mental ray at render time, the renderer ignores any modifiers that change the geometry. The one exception is the Skew modifier on page 1664, which affects the object’s transformation matrix rather than its sub-object geometry, and thus can modify a proxy.

6. Click the Write Object To File button, enter a file name, and click Save. This opens the mr Proxy Creation dialog, which lets you set parameters for the proxy object file, including animation frames and preview settings. Change settings as necessary and then click OK to continue. The file is saved in the MIB format and its path and file name are placed in the Proxy File field. After you save the file, the Display group shows...
the proxy geometry and the viewport shows the object, by default, as a **point cloud**: a group of vertices that roughly defines the object’s shape. You can change the number of points in the cloud and use a bounding box to represent the object, with or without the point cloud. (When the point cloud is on, you can toggle the bounding box, but when you turn off the point cloud, the bounding box always displays.)

If you like, you can now delete the original object.

**TIP** To select an mr Proxy object when represented as a point cloud, click one of the vertices.

If the object is difficult to visualize in the viewports, increase the Display group > Viewport Verts value.

You can now use this object as any other object in 3ds Max, applying materials, copying it, animating with it, and so on.
To use materials with the mr Proxy object:

When you convert an object to mr Proxy format, the proxy does not inherit the object’s material. An efficient way to handle this is with the XRef material.

1. Create or load the object that is to serve as the source object. Apply any necessary modifiers and material, and then save a copy.

2. Create the mr Proxy object and then convert the source object, as described in the preceding procedure. Delete the source object.

3. Apply an XRef material on page 6783 to the proxy object.

4. Set the material to use the material from the source object file you saved in step 1.

Then, to modify the material on the proxy, load the source object, edit its material, and save the file. Because the material on the proxy object is externally referenced, it updates automatically.

Example: To use an animated source object:

The mr Proxy object supports vertex-level animation as well as topological changes in the source object. For example, you could create a fluid simulation with a particle system to which BlobMesh on page 701 is applied, and then bake it out to a series of mr Proxy files. This procedure gives an example of how to use this feature.

1. Create a source object and add vertex-level animation. For example, you could apply the Bend modifier and then set keys for different values of the Angle parameter.

2. Add an mr Proxy object.

3. Go to the Modify panel, click the source object (“None”) button and then select the object from step 1.

4. Click the Write Object To File button, enter a file name, and click Save. On the mr Proxy Creation dialog, choose either animation option (Active Time Segment or Custom Range) and, if you like, toggle the Preview Generation switches. Click OK to continue.

3ds Max writes a pair of files (geometry and thumbnail) for each animation frame.

5. You control animation playback in the Proxy object with the Animation Support group settings. When you save or load an animated Proxy, 3ds Max automatically enables the On check box in this group and sets Frames
to the number of frames in the animation. You can change the value to the number of frames you want to use from the animation. Also, you can adjust the rate at which the animation appears in the proxy object by adjusting the Replay Speed value, and change the frame at which the playback begins with the Frame Offset parameter. Last, to have the animation play back and forth, turn on Ping-Pong Replay.

Interface

NOTE Before using the mr Proxy object, make sure mental ray is the active renderer.
Parameters rollout

Source Object group

[source object button] Shows the name of the source object, or, if you haven’t assigned one, the text “None.” To assign an object, click the button and then
select the source object. The name of the source object then appears on the
button, unless you delete the source object subsequently. In that case, the
button label returns to “None,” although the mr Proxy object still functions
normally, assuming you’ve saved the object to an MIB file.

**Clear source object slot** Restores the source object button label to
“None,” but doesn’t otherwise affect the proxy object.

**Write Object to File** Lets you save the object as an MIB file, which you can
then load into another mr Proxy object using the Proxy File controls.
Clicking the button opens a File Name dialog, where you can navigate to the
desired folder and enter a file name. Then, when you click Save, 3ds Max
opens the **mr Proxy Creation dialog** on page 570. Set parameters as desired and
then click OK.

This saves a file named `[file name].mib`, containing the geometry data, and
another named `[file name].mib.bmp`, which contains the thumbnail image that
appears on the Parameters rollout.

**NOTE** The MIB file contains only geometry, not materials. You can apply different
materials to each instance or copy of an mr Proxy object.

If Animation Support is on, 3ds Max writes a sequence of both types of file,
with a four-digit frame number appended to the base file name for each file.
For example, if you use the file name `Test` and set Animation Support group
> Frames to 10, then the first pair of files are named `Test0000.mib` and
`Test0000.mib.bmp`, the second pair are named `Test0001.mib` and
`Test0001.mib.bmp`, and so on.

**Proxy File group**

**Proxy File** This editable field shows the location and name of the base MIB
file stored with the Write Object To File command. To use a different file you
can edit the field manually or click the [...] button and use the File Name
dialog to choose a new file.

... [browse] Click this button to choose an MIB file to load into the proxy
object. You can use this button to load an existing MIB file into a new proxy
object, allowing you to easily transfer objects between different scenes.
NOTE If you load an MIB file that’s part of an animated sequence, you’re given the opportunity to load the entire sequence. Confirming automatically turns on animation support and sets the animation parameters to appropriate values. For details, see Animation Support group on page 569.

Scale Adjusts the size of the proxy object. Alternatively, you can use the Scale tool to resize the object.

Display group

Viewport Verts The number of vertices displayed in the point cloud for the proxy object. For best performance, display only enough vertices to make the object recognizable.

Show Point Cloud When on, the proxy object appears as a point cloud (group of vertices) in the viewports. When on, you can combine this with Show Bounding Box (see following).

NOTE When the object is selected, the point cloud always displays.

Show Bounding Box When on, the proxy object appears as a bounding box in the viewports. Available only when Show Point Cloud is on. When Show Point Cloud is off, the bounding box always displays.

[preview window] Shows the thumbnail image stored for the current frame of the MIB file. The thumbnail is generated when you click Write Object To File. The image includes the current scene background. Also, if you turn off Exclude Other Objects on the Preview Generation Options rollout, it includes other objects in the scene.

Animation Support group

These settings control animation playback; animation recording is controlled by the mr Proxy Creation settings (see following) when you save the Proxy object.
On

When enabled, plays animation in the proxy object if the current MIB file is part of an animation sequence. When off, the proxy object remains in the state of the last animation frame.

Saving or loading an animated Proxy object automatically enables animation playback.

The remaining Animation Support settings are available only when animation is enabled.

Frames

The number of frames to use from the animation, starting at the first frame of the animation + the Frame Offset value.

After the last frame plays, the animation repeats, either from the first frame forward again, or, if Ping-Pong Replay is on, back and forth.

Saving or loading an animated Proxy object automatically sets Frames to the correct value.

Replay Speed

Lets you adjust the playback speed as a multiplier. For example, if you load a 100-frame animation and then set Replay Speed to 0.5 (half speed), 3ds Max plays back each frame twice, so the animation takes 200 frames to play back fully. Default=1.0 (full speed).

Frame Offset

Lets you start the animation playback at a frame other than the first. Add this value to the start frame (see Geometry to Write on page 571) to determine at which frame the animation starts playing back.

Ping-Pong Replay

When on, the animation plays forward, then in reverse, then forward again and so on. When off, it plays forward only.

mr Proxy Creation dialog

This dialog opens when you click Write Object To File on page 568 and then enter a file name and click Save. They determine whether and how animation is saved to the proxy file, and how to display the preview.
Geometry to Write Choose the option that specifies how to save deformation animation, such as that produced by modifiers, in the proxy file. Transform animation, such as rotation of the entire object, is not saved.

- **Current Frame** Saves no animation; only the state of the object in the current frame.

- **Active Time Segment** Saves all animation in the active time segment on page 8496.

- **Custom Range** Saves animation only in the frame range you specify with the Start and End values.

Preview Generation group

These settings determine how to display the object preview on page 569, and are saved with the proxy file.

**Include only Source Object in Preview** When on, the preview image contains only the geometry in the proxy object. When off, the preview shows any additional geometry in the scene within the extent of the image zoom (see Automatic Zoom Extents, following). Default=on.
**Automatic Zoom Extents** When on, zooms the preview image to the bounding box of the proxy object before rendering the image. Default=on.

---

**Shapes**

Create panel > Shapes
Create menu > Shapes

A shape is an object made from one or more curved or straight lines. 3ds Max includes the following shape types: *Splines and Extended Splines* on page 577 and *NURBS Curves* on page 2464.

**Using Shapes**

Shapes are 2D and 3D lines and groups of lines that you typically use as components of other objects. Most of the default shapes are made from splines. You use these spline shapes to do the following:

- Generate planar and thin 3D surfaces
- Define loft components such as paths, shapes, and fit curves
- Generate surfaces of revolution
- Generate extrusions
- Define motion paths

3ds Max supplies 11 basic spline shape objects, two types of NURBS curves, and five extended splines. You can quickly create these shapes using mouse or keyboard entry and combine them to form compound shapes. For information about the methods and parameters used to create these shapes, see *Splines and Extended Splines* on page 577.

**Creating Shapes**

To access the shape-creation tools, go to the Create panel and click the Shapes button. You'll find the standard shapes under Splines in the category list, Point Curve and CV Curve under NURBS curves, and WRectangle, Channel, Angle, Tee, and Wide Flange under Extended Splines.

As you add plug-ins, other shape categories might appear in this list.

---

572 | Chapter 6  Creating Geometry
The Object Type rollout contains the spline creation buttons. You can combine one or more of these spline types into a single shape.

**Create Shape from Edges**

You can create shapes from edge selections in mesh objects. In Edit/Editable Mesh objects, at the Edge selection level, in the Edit Geometry rollout, is a button called Create Shape from Edges that creates a spline shape based on selected edges. See [Editable Mesh (Edge)] on page 2209. Similarly, with Editable Poly objects, you can use the Create Shape button at the Edge selection level. See [Editable Poly (Edge)] on page 2269.

**Editable Splines**

You can convert a basic spline to an editable spline object on page 620. The editable spline has a variety of controls that let you directly manipulate it and its sub-objects. For example, at the Vertex sub-object level you can move vertices or adjust their Bezier handles. Editable splines let you create shapes that are less regular, more free-form than the basic spline options.

When you convert a spline to an editable spline, you lose the ability to adjust or animate its creation parameters.

**Renderable Shapes**

When you use a shape to create a 3D object by lofting, extruding, or other means, the shape becomes a renderable 3D object. However, you can make a shape render without making it into a 3D object. There are three basic steps to rendering a shape:

1. On the Rendering rollout of the shape's creation parameters, turn on Enable In Renderer.
2. Specify the thickness for the spline using the Thickness spinner in the Rendering rollout.
3 If you plan to assign a mapped material to the spline, turn on Generate Mapping Coords.

When Enable In Renderer is on, the shape is rendered using a circle as a cross section. Mapping coordinates are generated with U mapped once around the perimeter, and V mapped once along the length.

3ds Max provides control over renderable shapes; viewports, including wireframe viewports, can display the geometry of renderable shapes. The rendering parameters for shapes appear in their own rollout.

The Steps settings affect the number of cross sections in the renderable shape.

Please observe the following:

- When you apply a modifier that converts a shape into a mesh (such as Extrude on page 1425 or Lathe on page 1474), the object automatically becomes renderable, regardless of the state of the Enable in Renderer check box.
You need to turn on the Enable in Renderer check box only when you want to render an unmodified spline shape in the scene.

- As with all objects, a shape's layer must be on for the shape to render. See Layer Properties on page 7956.
- The Object Properties dialog on page 283 also has a Renderable check box, which is turned on by default. Both this check box and the General rollout > Renderable check box must be turned on in order to render a shape.

### Shapes as Planar Objects

A straightforward usage for shapes is 2D cutouts or planar objects. Examples include ground planes, text for signs, and cutout billboards. You create a planar object by applying an Edit Mesh modifier on page 1321 to a closed shape, or by converting it to an editable mesh object on page 2192.

![2D objects](image)

2D objects

You can also apply an Edit Mesh modifier to a 3D shape (for example, a shape whose vertices have been moved vertically away from the construction plane by different amounts) to create a curved surface. The resulting 3D surface often requires manual editing of faces and edges to smooth surface ridges.

### Extruded and Lathed Shapes

You can apply modifiers to a shape to create a 3D object. Two of these modifiers are Extrude and Lathe. Extrude on page 1425 creates a 3D object by adding height to a shape. Lathe on page 1474 creates a 3D object by rotating a shape about an axis.
Lofting Shapes

You create Lofts on page 742 by combining two or more splines in special ways. Shapes form the lofting path, loft cross-sections, and loft fit curves.

Shapes as Animation Paths

You can use shapes to define the position of an animated object. You create a shape and use it to define a path that some other object follows.

Some possible ways for a shape to control animated position are:

- You can use a Path constraint on page 3596 to use a shape to control object motion.
You can convert a shape into position keys using the Motion panel > Trajectories > Convert From function (see Trajectories on page 3411).

See also:
- Edit Modifiers and Editable Objects on page 1052
- Modifying at the Sub-Object Level on page 1054
- Modifier Stack Controls on page 8187

Splines and Extended Splines

Create panel > Shapes > Splines
Create menu > Shapes
Create panel > Shapes > Extended Splines

Splines include the following object types: Line on page 584, Rectangle on page 588, Circle on page 590, Ellipse on page 591, Arc on page 592, Donut on page 596, NGon on page 597, Star on page 599, Text on page 600, Helix on page 605, and Section on page 607. Extended Splines include the following object types: WRectangle on page 611, Channel on page 613, Angle on page 615, Tee on page 617, and Wide on page 618. This topic covers aspects of spline and extended spline creation that are common to all spline object types, including the parameters available in the General rollout.

For parameters unique to a particular spline or extended spline type, see its section.

Procedures

To control starting a new shape manually:

1. On the Create panel, turn off the check box next to the Start New Shape button.
2. Click the Start New Shape button.
   
   Each spline is added to the compound shape. You can tell you are creating a compound shape because all the splines remain selected.
4. Click Start New Shape to complete the current shape and prepare to start another.

Issues to remember about creating shapes:

■ You can go back and change the parameters of a shape containing a single spline after the shape is created.

■ You can create a compound shape by adding splines to a shape: Select the shape, turn off Start New Shape, and then create more splines.

■ You cannot change the parameters of a compound shape. For example, create a compound shape by creating a circle and then adding an arc. Once you create the arc, you cannot change the circle parameters.

To create a spline using keyboard entry:

1. Click a spline creation button.

2. Expand the Keyboard Entry rollout.

3. Enter X, Y, and Z values for the first point.

4. Enter values in any remaining parameter fields.

5. Click Create.

Interface

Object Type rollout (Splines and Extended Splines)
**AutoGrid** Lets you automatically create objects on the surface of other objects by generating and activating a temporary construction plane based on normals of the face that you click.

For more information, see *AutoGrid* on page 2792.

**Start New Shape** A shape can contain a single spline or it can be a compound shape containing multiple splines. You control how many splines are in a shape using the Start New Shape button and check box on the Object Type rollout. The check box next to the Start New Shape button determines when new shapes are created. When the box is on, 3ds Max creates a new shape object for every spline you create. When the box is off, splines are added to the current shape until you click the Start New Shape button.

**Shape Selection buttons** Lets you specify the type of shape to create.

**Name and Color rollout**

Lets you name an object and assign it a viewport color. For details, see *Object Name and Wireframe Color* on page 8182.
Rendering rollout

Lets you turn on and off the renderability of a spline or NURBS curve, specify its thickness in the rendered scene, and apply mapping coordinates.

You can animate render parameters, such as the number of sides, but you cannot animate the Viewport settings.

You can convert the displayed mesh into a mesh object by applying an Edit Mesh or Edit Poly modifier or converting to an editable mesh or editable poly object. If Enable In Viewport is off when converting, closed shapes will be “filled in” and open shapes will contain only vertices; no edges or faces. If Enable In Viewport is on when converting, the system will use the Viewport settings for this mesh conversion. This gives maximum flexibility, and will always give the conversion of the mesh displayed in the viewports.

**Enable In Renderer** When on, the shape is rendered as a 3D mesh using the Radial or Rectangular parameters set for Renderer.
Enable In Viewport  When on, the shape is displayed in the viewport as a 3D mesh using the Radial or Rectangular parameters set for Renderer.

Use Viewport settings  Lets you set different rendering parameters, and displays the mesh generated by the Viewport settings. Available only when Enable in Viewport is turned on.

Generate Mapping Coords  Turn this on to apply mapping coordinates. Default=off.

3ds Max generates the mapping coordinates in the U and V dimensions. The U coordinate wraps once around the spline; the V coordinate is mapped once along its length. Tiling is achieved using the Tiling parameters in the applied material. For more information, see Mapping Coordinates on page 5636.

Real-World Map Size  Controls the scaling method used for texture mapped materials that are applied to the object. The scaling values are controlled by the Use Real-World Scale settings found in the applied material's Coordinates rollout on page 6201. Default=off.

Viewport  Choose this to specify Radial or Rectangular parameters for the shape as it will display in the viewports when Enable In Viewport is on.

Renderer  Choose this to specify Radial or Rectangular parameters for the shape as it will display when rendered or when viewed in the viewport when Enable In Viewport is turned on.

Radial  Displays the 3D mesh as a cylindrical object.

Thickness  Specifies the diameter of the viewport or rendered spline mesh. Default=1.0. Range=0.0 to 100,000,000.0.

Splines rendered at thickness of 1.0 and 5.0, respectively

Sides  Sets the number of sides (or facets) for the spline mesh in the viewport or renderer. For example, a value of 4 results in a square cross section.
**Angle** Adjusts the rotational position of the cross-section in the viewport or renderer. For example, if the spline mesh has a square cross section you can use Angle to position a "flat" side down.

**Rectangular** Displays the spline's mesh shape as a rectangle.

**Length** Specifies the size of the cross-section along the local Y axis.

**Width** Specifies the size of the cross-section along the local X axis.

**Angle** Adjusts the rotational position of the cross-section in the viewport or renderer. For example, if you have a square cross-section you can use Angle to position a "flat" side down.

**Aspect** Sets the aspect ratio for rectangular cross-sections. The Lock check box lets you lock the aspect ratio. When Lock is turned on, Width is locked to Length that results in a constant ratio of Width to Length.

**Auto Smooth** If Auto Smooth is turned on, the spline is auto-smoothed using the threshold specified by the Threshold setting below it. Auto Smooth sets the smoothing based on the angle between spline segments. Any two adjacent segments are put in the same smoothing group if the angle between them is less than the threshold angle.

**NOTE** Turning Auto Smooth on for every situation does not always give you the best smoothing quality. Altering the Threshold angle may be necessary or turning Auto Smooth off may produce the best results.

**Threshold** Specifies the threshold angle in degrees. Any two adjacent spline segments are put in the same smoothing group if the angle between them is less than the threshold angle.

**Interpolation rollout**

These settings control how a spline is generated. All spline curves are divided into small straight lines that approximate the true curve. The number of divisions between each vertex on the spline are called steps. The more steps used, the smoother the curve appears.
**Steps** Spline steps can be either adaptive (that is, set automatically by turning on Adaptive) or specified manually.

When Adaptive is off, use the Steps field/spinner to set the number of divisions between each vertex. Splines with tight curves require many steps to look smooth while gentle curves require fewer steps. Range=0 to 100.

**Optimize** When on, removes unneeded steps from straight segments in the spline. Optimize is not available when Adaptive is on. Default=on.

**Adaptive** When off, enables manual interpolation control using Optimize and Steps. Default=off.

When on, Adaptive sets the number of steps for each spline to produce a smooth curve. Straight segments always receive 0 steps.

Optimized spline left and adaptive spline right. Resulting wireframe view of each, respectively, on the right.

The main use for manual interpolation of splines is in morphing or other operations where you must have exact control over the number of vertices created.

**Creation Method rollout**

Many spline tools use the Creation Methods rollout. On this rollout you choose to define splines by either their center point or their diagonal.

**Edge** Your first click defines a point on the side or at a corner of the shape and you drag a diameter or the diagonal corner.
Center Your first click defines the center of the shape and you drag a radius or corner point.

Text on page 600 and Star on page 599 do not have a Creation Methods rollout.

Line on page 584 and Arc on page 592 have unique Creation Methods rollouts that are discussed in their respective topics.

**Keyboard Entry rollout**

You can create most splines using keyboard entry. The process is generally the same for all splines and the parameters are found under the Keyboard Entry rollout. Keyboard entry varies primarily in the number of optional parameters. The image above shows a sample Keyboard Entry rollout for the Circle shape.

The Keyboard Entry rollout contains three fields for the X, Y, and Z coordinates of the initial creation point, plus a variable number of parameters to complete the spline. Enter values in each field and click the Create button to create the spline.

**Line Spline**

Create panel > Shapes > Splines > Object Type rollout > Line

Create menu > Shapes > Line

Use Line to create a free-form spline made of multiple segments.
Procedures

To create a line:

1. Go to the Create panel and choose Shapes.
2. On the Object Type rollout, click the Line button.
3. Choose a creation method.
4. Click or drag the start point. Clicking creates a corner vertex; dragging creates a Bezier vertex.
5. Click or drag additional points. Clicking creates a corner vertex; dragging creates a Bezier vertex.
6. Do one of the following:
   - Right-click to create an open spline.
   - Click the first vertex and click Yes in the "Close spline?" dialog to create a closed spline.

To create a line using rectilinear and angle-snap options:

These two options aid in creating regular shapes:

- While creating a spline with the mouse, press and hold Shift to constrain new points to 90-degree-angle increments from previous points. Use the
default Initial type setting of Corner and click all subsequent points to create fully rectilinear shapes.

- While creating a spline with the mouse, press and hold Ctrl to constrain new points to angle increments determined by the current Angle Snap setting on page 2816. To set this angle, go to Tools menu > Grids And Snaps > Grid And Snap Settings, click the Options tab on page 2828 in the Grid And Snap Settings dialog, and change the value in the Angle (deg) field.

The angle for each new segment relates to the previous segment, so the angle snap works only after you've placed the first two spline vertices (that is, the first segment). Angle Snap need not be enabled for this feature to work.

To create a line from the keyboard:

1. Enter values in the X, Y, and Z fields to specify a vertex coordinate.
2. Click Add Point to add a vertex to the current line at the specified coordinate.
3. Repeat steps 1 and 2 for each additional vertex.
4. Do one of the following:
   - Click Finish to create an open spline.
   - Click Close to connect the current vertex to the first vertex and create a closed spline.

Interface

Automatic Conversion to an Editable Spline

Because the Line object has no dimension parameters to be carried over to the Modify panel, it converts to an editable spline on page 620 when you move from the Create panel to the Modify panel. While you are creating the line, the Create panel displays the original controls, such as Interpolation, Rendering, Creation Method, and Keyboard Entry. After creating the line, when you go to the Modify panel you have immediate access to the Selection and Geometry rollouts to edit the vertices or any part of the shape.

Rendering and Interpolation rollouts

All spline-based shapes share these parameters. See Splines on page 577 for an explanation of these parameters.
Creation Method rollout

Creation method options for lines are different from other spline tools. You choose options to control the type of vertex created when you click or drag vertices.

You can preset the default types of spline vertices during line creation with these settings:

**Initial Type group**

Sets the type of vertex you create when you click a vertex location.

- **Corner**: Produces a sharp point. The spline is linear to either side of the vertex.
- **Smooth**: Produces a smooth, nonadjustable curve through the vertex. The amount of curvature is set by the spacing of the vertices.

**Drag Type group**

Sets the type of vertex you create when you drag a vertex location. The vertex is located at the cursor position where you first press the mouse button. The direction and distance that you drag are used only when creating Bezier vertices.

- **Corner**: Produces a sharp point. The spline is linear to either side of the vertex.
- **Smooth**: Produces a smooth, nonadjustable curve through the vertex. The amount of curvature are set by the spacing of the vertices.
- **Bezier**: Produces a smooth, adjustable curve through the vertex. The amount of curvature and direction of the curve are set by dragging the mouse at each vertex.
Keyboard Entry rollout

Keyboard entry for lines is different from keyboard entry for other splines. Entering keyboard values continues to add vertices to the existing line until you click Close or Finish.

Add Point Adds a new point to the line at the current X/Y/Z coordinates.

Close Closes the shape, adding a final spline segment between the most recent vertex and the first.

Finish Finishes the spline without closing it.

Rectangle Spline

Create panel > Shapes > Splines > Object Type rollout > Rectangle
Create menu > Shapes > Rectangle
Use Rectangle to create square and rectangular splines.

Examples of rectangles
Procedures

To create a rectangle:

1. Go to the Create panel and choose Shapes.
2. Click Rectangle.
3. Choose a creation method.
4. Drag in a viewport to create a rectangle.
   Optionally, press Ctrl while dragging to constrain the spline to a square.

Interface

Rendering and Interpolation rollouts

All spline-based shapes share these parameters. See Splines on page 577 for an explanation of these parameters.

Creation Method rollout

The Rectangle shape uses the standard creation methods of Center or Edge. Most spline-based shapes share the same Creation Method parameters. See Splines on page 577 for an explanation of these parameters.

Parameters rollout

Once you have created a rectangle, you can make changes using the following parameters:

Length Specifies the size of the rectangle along the local Y axis.

Width Specifies the size of the rectangle along the local X axis.

Corner Radius Creates rounded corners. When set to 0, the rectangle contains 90-degree corners.
Circle Spline

Create panel > Shapes > Splines > Object Type rollout > Circle
Create menu > Shapes > Circle
Use Circle to create closed circular splines made of four vertices.

Example of circle

Procedures

To create a circle:

1. Go to the Create panel and choose Shapes.
2. Click Circle.
3. Choose a creation method.
4. Drag in a viewport to draw the circle.

Interface

Rendering and Interpolation rollouts

All spline-based shapes share these parameters. See Splines on page 577 for explanations of these parameters.
Creation Method rollout

The Circle shape uses the standard creation methods of Center or Edge. Most spline-based shapes share the same Creation Method parameters. See Splines on page 577 for an explanation of these parameters.

Parameters rollout

Once you have created a circle, you can make changes using the following parameter:

Radius  Specifies the radius of the circle.

Ellipse Spline

Create panel > Shapes > Splines > Object Type rollout > Ellipse
Create menu > Shapes > Ellipse

Use Ellipse to create elliptical and circular splines.

Examples of ellipses

Procedures

To create an ellipse:

1  Go to the Create panel and choose Shapes.
2  Click Ellipse.
3  Choose a creation method.
4 Drag in a viewport to draw the ellipse. Optionally, press Ctrl while dragging to constrain the spline to a circle.

Interface

Rendering and Interpolation rollouts

All spline-based shapes share these parameters. See Splines on page 577 for explanations of these parameters.

Creation Method rollout

The Ellipse shape uses the standard creation methods of Center or Edge. Most spline-based shapes share the same Creation Method parameters. See Splines on page 577 for an explanation of these parameters.

Parameters rollout

Once you have created an Ellipse, you can make changes using the following parameters:

- **Length** Specifies the size of the Ellipse along the local Y axis.
- **Width** Specifies the size of the Ellipse local X axis.

**Arc Spline**

Create panel > Shapes > Splines > Object Type rollout > Arc
Create menu > Shapes > Arc
Use Arc to create open and closed circular arcs made of four vertices.
Procedures

To create an arc using the end-end-middle method:

1. Go to the Create panel and choose Shapes.
2. Click Arc.
3. Choose the End-End-Middle creation method.
4. Drag in a viewport to set the two ends of the arc.
5. Release the mouse button, then move the mouse and click to specify a third point on an arc between the two endpoints.

Creating an arc using the End-End-Middle creation method

To create an arc using the center-end-end method:

1. Go to the Create panel and choose Shapes.
2. Click Arc.
3. Choose the Center-End-End creation method.
4. Press the mouse button to define the center of the arc.
5. Drag and release the mouse button to specify the start point of the arc.
Move the mouse and click to specify the other end of the arc.

Creating an arc using the Center-End-End creation method

**Interface**

**Rendering and Interpolation rollouts**

All spline-based shapes share these parameters. See Splines on page 577 for an explanation of these parameters.

**Creation Method rollout**

These options determine the sequence of mouse clicks involved in the creation of the arc.

**End-End-Middle** Drag and release to set the two endpoints of the arc, and then click to specify the third point between the two endpoints.

**Center-End-End** Press the mouse button to specify the center point of the arc, drag and release to specify one endpoint of the arc, and click to specify the other endpoint of the arc.
Parameters rollout

Once you have created an arc, you can make changes using the following parameters:

**Radius** Specifies the arc radius.

**From** Specifies the location of the start point as an angle measured from the local positive X axis.

**To** Specifies the location of the end point as an angle measured from the local positive X axis.

**Pie Slice** When on, creates a closed spline in the form of a pie. The start point and end point are connected to the center with straight segments.

Closed pie slice arcs

**Reverse** When on, the direction of the arc spline is reversed, and the first vertex is placed at the opposite end of an open arc. As long as the shape remains an original shape (and not an editable spline), you can switch its direction by toggling Reverse. Once the arc is converted to an editable spline, you can use Reverse at the Spline sub-object level to reverse direction.
Donut Spline

Create panel > Shapes > Splines > Object Type rollout > Donut
Create menu > Shapes > Donut
Use Donut to create closed shapes from two concentric circles. Each circle is made of four vertices.

Example of donut

Procedures

To create a donut:

1. Go to the Create panel and choose Shapes.
2. Click Donut.
3. Choose a creation method.
4. Drag and release the mouse button to define the first donut circle.
5. Move the mouse and then click to define the radius of the second concentric donut circle.
   The second circle can be larger or smaller than the first.
Interface

Rendering and Interpolation rollouts

All spline-based shapes share these parameters. See Splines on page 577 for explanations of these parameters.

Creation Method rollout

The Donut shape uses the standard creation methods of Center or Edge. Most spline-based shapes share the same Creation Method parameters. See Splines on page 577 for an explanation of these parameters.

Parameters rollout

Once you have created a donut, you can make changes using the following parameters:

- **Radius 1** Sets the radius of the first circle.
- **Radius 2** Sets the radius of the second circle.

NGon Spline

Create panel > Shapes > Splines > Object Type rollout > NGon
Create menu > Shapes > NGon

Use NGon to create closed flat-sided or circular splines with any number (N) of sides or vertices.

Examples of NGons
Procedures

To create an NGon:

1. Go to the Create panel and choose Shapes.
2. Click NGon.
3. Choose a creation method.
4. Drag and release the mouse button in a viewport to draw the NGon.

Interface

Rendering and Interpolation rollouts

All spline-based shapes share these parameters. See Splines on page 577 for an explanation of these parameters.

Creation Method rollout

The NGon shape uses the standard creation methods of Center or Edge. Most spline-based shapes share the same Creation Method parameters. See Splines on page 577 for an explanation of these parameters.

Parameters rollout

Once you have created an NGon, you can make changes using the following parameters:

- **Radius**: Specifies the NGon radius. You can use either of two methods to specify the radius:
  - **Inscribed**: The radius from the center to the corners of the NGon
- **Circumscribed**  The radius from the center to the sides of the NGon.

**Sides**  Specifies the number of sides and vertices used by the NGon. Range=3 to 100.

**Corner Radius**  Specifies the degree of rounding to apply to the corners of the NGon. A setting of 0 specifies a standard unrounded corner.

**Circular**  When on, specifies a circular NGon.

### Star Spline

Create panel > Shapes > Splines > Object Type rollout > Star

Create menu > Shapes > Star

Use Star to create closed star-shaped splines with any number of points. Star splines use two radiiuses to set the distance between the outer points and inner valleys.

![Examples of stars](image)

**Procedures**

**To create a star:**

1. Go to the Create panel and choose Shapes.
2. Click Star.
3. Drag and release the mouse button to define the first star radius.
4. Move the mouse and then click to define the second star radius.
Interface

Rendering and Interpolation rollouts

All spline-based shapes share these parameters. See Splines on page 577 for explanations of these parameters.

Parameters rollout

Once you have created a star, you can make changes using the following parameters:

**Radius 1** Specifies the radius of the inner vertices (the valley) of the star.

**Radius 2** Specifies the radius of the outer vertices (the points) of the star.

**Points** Specifies the number of points on the star. Range=3 to 100.

A star has twice as many vertices as the specified number of points. Half the vertices lie on one radius, forming points, and the remaining vertices lie on the other radius, forming valleys.

**Distortion** Rotates the outer vertices (the points) about the center of the star. This produces a sawtooth affect.

**Fillet Radius 1** Rounds the inner vertices (the valleys) of the star.

**Fillet Radius 2** Rounds the outer vertices (the points) of the star.

Text Spline

Create panel > Shapes > Splines > Object Type rollout > Text

Create menu > Shapes > Text
Use Text to create splines in the shape of text.

The text can use any Windows font installed on your system, or a Type 1 PostScript font installed in the directory pointed to by the Fonts path on the Configure System Paths dialog on page 8293. Because fonts are loaded only at first use, changing the font path later has no immediate effect: once you have used the font manager, you must restart 3ds Max before you can use a new font path.

Examples of text

You can edit the text in the Create panel, or later in the Modify panel.

**Using Text Shapes**

Text shapes maintain the text as an editable parameter. You can change the text at any time. If the font used by your text is deleted from the system, 3ds Max still properly displays the text shape. However, to edit the text string in the edit box you must choose an available font.

The text in your scene is just a shape where each letter and, in some cases, pieces of each letter are individual splines. You can apply modifiers like Edit Spline on page 1424, Bend on page 1165, and Extrude on page 1425 to edit Text shapes just like any other shape.

**Procedures**

**To create text:**

1. Go to the Create panel and choose Shapes.
2. Click Text.
Enter text in the Text box.

Do either of the following to define an insertion point:
- Click in a viewport to place the text in the scene.
- Drag the text into position and release the mouse button.

**To enter a special Windows character:**

1. Hold down the Alt key.
2. Enter the character’s numeric value on the numeric keypad.
   - You must use the numeric keypad, not the row of numbers above the alphabetic keys.
   - For some characters, you must enter a leading zero. For example, 0233 to enter an e with an acute accent.
3. Release the Alt key.

**Interface**

Settings available for text include kerning, leading, justification, multiple lines, and a manual update option.

**Rendering and Interpolation rollouts**

All spline-based shapes share these parameters. See Splines on page 577 for an explanation of these parameters.
Once you have created text, you can make changes using the following parameters:

**Font list** Choose from a list of all available fonts. Available fonts include:
- Fonts installed in Windows.
- Type 1 PostScript fonts located in the directory pointed to by the Fonts path on the Configure System Paths dialog on page 8293.

**Italic style button** Toggles italicized text.

**Underline style button** Toggles underlined text.

**Align Left** Aligns text to the left side of its bounding box.
**Center** Aligns text to the center of its bounding box.

**Align Right** Aligns text to the right side of its bounding box.

**Justify** Spaces all lines of text to fill the extents of the bounding box.

**NOTE** The four text-alignment buttons require multiple lines of text for effect because they act on the text in relation to its bounding box. If there's only one line of text, it's the same size as its bounding box.

**Size** Sets the text height where the height measuring method is defined by the active font. The first time you enter text, the default size is 100 units.

**Kerning** Adjusts the kerning (the distance between letters).

**Leading** Adjusts the leading (the distance between lines). This has an effect only when multiple lines of text are included in the shape.

**Text edit box** Allows for multiple lines of text. Press Enter after each line of text to start the next line.

- The initial session default is "VIZ Text."
- The initial session default is "MAX Text."
- The edit box does not support word wrap.
- You can cut and paste single- and multi-line text from the Clipboard.

**Update group**

These options let you select a manual update option for situations where the complexity of the text shape is too high for automatic updates.

**Update** Updates the text in the viewport to match the current settings in the edit box. This button is available only when Manual Update is on.

**Manual Update** When on, the text that you type into the edit box is not shown in the viewport until you click the Update button.
**Helix Spline**

Create panel > Shapes > Splines > Object Type rollout > Helix
Create menu > Shapes > Helix
Use Helix to create open flat or 3D helices or spirals.

![Example of helixes](image)

**Examples of helixes**

**Procedures**

**To create a helix:**

1. Go to the Create panel and choose Shapes.
2. Click Helix.
3. Choose a creation method.
4. Press the mouse button to define the first point of the Helix start circle.
5. Drag and release the mouse button to define the second point of the Helix start circle.
6. Move the mouse and then click to define the height of the Helix.
7. Move the mouse and then click to define the radius of the Helix end.

**Interface**

**Rendering rollout**

All spline-based shapes share these parameters. See Splines on page 577 for explanations of these parameters.
Interpolation

The helix differs from other spline-based shapes in that it always uses *adaptive interpolation*: the number of vertices in a helix is determined by the number of turns.

Creation Method rollout

The Helix shape uses the standard creation methods of Center or Edge. Most spline-based shapes share the same Creation Method parameters. See Splines on page 577 for an explanation of these parameters.

Parameters rollout

Once you have created a helix, you can make changes using the following parameters:

**Radius 1** Specifies the radius for the Helix start.

**Radius 2** Specifies the radius for the Helix end.

**Height** Specifies the height of the Helix.

**Turns** Specifies the number of turns the Helix makes between its start and end points.

**Bias** Forces the turns to accumulate at one end of the helix. Bias has no visible affect when the height is 0.0.
Helical spline varied only by bias settings

- A bias of –1.0 forces the turns toward the start of the helix.
- A bias of 0.0 evenly distributes the turns between the ends.
- A bias of 1.0 forces the turns toward the end of the helix.

CW/CCW The direction buttons set whether the Helix turns clockwise (CW) or counterclockwise (CCW).

Section Spline

Create panel > Shapes > Splines > Object Type rollout > Section
Create menu > Shapes > Section
Section is a special type of spline that generates shapes based on a cross-sectional slice through mesh objects.

The Section object appears as a bisected rectangle. You simply move and rotate it to slice through one or more mesh objects, and then click the Create Shape button to generate a shape based on the 2D intersection.
Red line shows the section shape based on the structure.

Procedures

To create and use a section shape:

1. Go to the Create panel and choose Shapes.
2. Click Section.
3. Drag a rectangle in the viewport in which you want to orient the plane. (For example, create it in the Top viewport to place the Section object parallel with the XY home grid.)
   The Section object appears as a simple rectangle with crossed lines indicating its center. With the default settings, the rectangle is for display purposes only, because the effect of the Section object extends along its plane to the full extents of the scene.
4. Move and rotate the section so that its plane intersects mesh objects in the scene.
   Yellow lines are displayed where the sectional plane intersects objects.
On the Create panel, click Create Shape, enter a name in the resulting dialog, and click OK. An editable spline on page 620 is created, based on the displayed cross sections.

**Interface**

**Rendering and Interpolation rollouts**

All spline-based shapes share these parameters. See Splines on page 577 for an explanation of these parameters.

**Section Parameters rollout**

Create Shape Creates a shape based on the currently displayed intersection lines. A dialog is displayed in which you can name the new object. The resulting shape is an editable spline consisting of curve segments and corner vertices, based on all intersected meshes in the scene.

**Update group**

Provides options for specifying when the intersection line is updated.
When Section Moves Updates the intersection line when you move or resize the Section shape.

When Section Selected Updates the intersection line when you select the section shape, but not while you move it. Click the Update Section button to update the intersection.

Manually Updates the intersection line only when you click the Update Section button.

Update Section Updates the intersection to match the current placement of the Section object when using When Section Selected or Manually option.

NOTE When using When Section Selected or Manually, you can offset the generated cross section from the position of the intersected geometry. As you move the section object, the yellow cross-section lines move with it, leaving the geometry behind. When you click Create Shape, the new shape is generated at the displayed cross-section lines in the offset position.

Section Extents group

Choose one of these options to specify the extents of the cross-section generated by the section object.

Infinite The section plane is infinite in all directions, resulting in a cross section at any mesh geometry in its plane.

Section Boundary The cross-section is generated only in objects that are within or touched by the boundary of the section shape.

Off No cross section is displayed or generated. The Create Shape button is disabled.

Color swatch Click this to set the display color of the intersection.

Section Size rollout

![Section Size rollout](image)
Provides spinners that let you adjust the length and width of the displayed section rectangle.

**Length/Width** Adjust the length and width of the displayed section rectangle.

**NOTE** If you convert the section grid to an editable spline, it's converted to a shape based on the current cross section.

---

**Extended Splines**

Extended splines are enhancements to the original spline set.

**WRectangle Spline**

Create panel > Shapes > Extended Splines > Object Type rollout > WRectangle
Create menu > Shapes > WRectangle

Use WRectangle to create closed shapes from two concentric rectangles. Each rectangle is made of four vertices. The WRectangle is similar to the Donut tool except it uses rectangles instead of circles.

WRectangle stands for “walled rectangle”.

**Example of WRectangle**

**Procedures**

**To create a wrectangle:**

1. Go to the Create panel and choose Shapes.
2. Open the Shapes List and choose Extended Splines.
3  Click WRectangle.
4  Drag and release the mouse button to define the outer rectangle.
5  Move the mouse and then click to define the inner rectangle.

Interface

Rendering and Interpolation rollouts

All spline-based shapes share these parameters. For explanations, see Splines and Extended Splines on page 577.

Creation Method rollout

The WRectangle shape uses the standard creation methods of Center or Edge. Most spline-based shapes share the same Creation Method parameters. For explanations, see Splines and Extended Splines on page 577.

Parameters rollout

Length  Controls the height of the wrectangle section.
Width  Controls the width of the wrectangle section.
Thickness  Controls the thickness of the walls of the wrectangle.
Sync Corner Fillets  When turned on, Corner Radius 1 controls the radius of both the interior and exterior corners of the wrectangle. It also maintains the thickness of the section. Default=on.
Corner Radius 1 Controls the radius of all four interior and exterior corners of the section.
If Sync Corner Fillets is turned off, Corner Radius 1 controls the radius of the four exterior corners of the rectangle.

Corner Radius 2 Controls the radius of the four interior corners of the rectangle.
Corner Radius 2 is only available when Sync Corner Fillets is turned off.

NOTE Take care when adjusting these settings. There are no constraining relationships between them. Therefore, it’s possible to set an inside radius (Corner Radius 2) that is greater than the length and width of the sides.

Channel Spline

Create panel > Shapes > Extended Splines > Object Type rollout > Channel
Create menu > Shapes > Channel

Use Channel to create a closed “C” shaped spline. You have the option to specify the interior and exterior corners between the vertical web and horizontal legs of the section.

Example of Channel

Procedures

To create a channel:

1. Go to the Create panel and choose Shapes.
2. Open the Shapes List and select Extended Splines.
3. Click Channel.
4 Drag and release the mouse button to define the outer perimeter of the channel.

5 Move the mouse and then click to define the thickness of the walls of the channel.

Interface

Rendering and Interpolation rollouts

All spline-based shapes share these parameters. For explanations, see Splines and Extended Splines on page 577.

Creation Method rollout

The Channel shape uses the standard creation methods of Center or Edge. Most spline-based shapes share the same Creation Method parameters. For explanations, see Splines and Extended Splines on page 577.

Parameters rollout

![Parameters rollout image]

**Length** Controls the height of the vertical web of the channel.

**Width** Controls the width of the top and bottom horizontal legs of the channel.

**Thickness** Controls the thickness of both legs of the angle.

**Sync Corner Fillets** When turned on, Corner Radius 1 controls the radius of both the interior and exterior corners between the vertical web and horizontal legs. It also maintains the thickness of the channel. Default=on.
Corner Radius 1 Controls the exterior radius between the vertical web and horizontal legs of the channel.

Corner Radius 2 Controls the interior radius between the vertical web and horizontal legs of the channel.

**NOTE** Take care when adjusting these settings. There are no constraining relationships between them. Therefore, it's possible to set an inside radius (Corner Radius 2) that is greater than the length of the web or width of the legs.

**Angle Spline**

Create panel > Shapes > Extended Splines > Object Type rollout > Angle
Create menu > Shapes > Angle

Use Angle to create a closed “L” shaped spline. You have the option to specify the radii of the corners between the vertical and horizontal legs of the section.

![Example of Angle](image)

**Procedures**

**To create an Angle spline:**

1. Go to the Create panel and choose Shapes.
2. Open the Shapes List and select Extended Splines.
3. Click Angle.
4. Drag and release the mouse button to define the initial size of the angle.
5. Move the mouse and then click to define the thickness of the walls of the angle.
Interface

Rendering and Interpolation rollouts

All spline-based shapes share these parameters. For explanations, see Splines and Extended Splines on page 577.

Creation Method rollout

The Angle shape uses the standard creation methods of Center or Edge. Most spline-based shapes share the same Creation Method parameters. For explanations, see Splines and Extended Splines on page 577.

Parameters rollout

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Length</th>
<th>Width</th>
<th>Thickness</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
</tr>
</tbody>
</table>

- **Sync Corner Fillets** When turned on, Corner Radius 1 controls the radius of both the interior and exterior corners between the vertical and horizontal legs. It also maintains the thickness of the section. Default=on.

- **Corner Radius 1** Controls the exterior radius between the vertical and horizontal legs of the angle.

- **Corner Radius 2** Controls the interior radius between the vertical and horizontal legs of the angle.
**Edge Radii** Controls the interior radius at the outermost edges of the vertical and horizontal legs.

**NOTE** Take care when adjusting these settings. There are no constraining relationships between them. Therefore, it's possible to set an inside radius (Corner Radius 2) that is greater than the length or width of the legs of the angle.

---

**Tee Spline**

Create panel > Shapes > Extended Splines > Object Type rollout > Tee

Create menu > Shapes > Tee

Use Tee to create a closed T-shaped spline. You can specify the radius of the two interior corners between the vertical web and horizontal flange of the section.

---

![Example of Tee](image)

**Example of Tee**

**Procedures**

**To create a Tee spline:**

1. Go to the Create panel and choose Shapes.
2. Open the Shapes List and select Extended Splines.
3. Click Tee.
4. Drag and release the mouse button to define the initial size of the tee.
5. Move the mouse and then click to define the thickness of the walls of the tee.
Interface

Rendering and Interpolation rollouts

All spline-based shapes share these parameters. For explanations, see Splines and Extended Splines on page 577.

Creation Method rollout

The Tee shape uses the standard creation methods of Center or Edge. Most spline-based shapes share the same Creation Method parameters. For explanations, see Splines and Extended Splines on page 577.

Parameters rollout

<table>
<thead>
<tr>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Length: 0.0</td>
</tr>
<tr>
<td>Width: 0.0</td>
</tr>
<tr>
<td>Thickness: 0.0</td>
</tr>
<tr>
<td>Corner Radius: 0.0</td>
</tr>
</tbody>
</table>

Length Controls the height of the vertical web of the tee.

Width Controls the width of the flange crossing the tee.

Thickness Controls the thickness of the web and flange.

Corner Radius Controls the radius of the two interior corners between the vertical web and horizontal flange of the section.

NOTE Take care when adjusting these settings. There are no constraining relationships between them. Therefore, it's possible to set a radius (Corner Radius) that is greater than the length of the web or width of the flange.

Wide Flange Spline

Create panel > Shapes > Extended Splines > Object Type rollout > Wide Flange
Create menu > Shapes > Wide Flange
Use Wide Flange to create a closed spline shaped like a capital letter I. You can specify the interior corners between the vertical web and horizontal flanges of the section.

Example of Wide Flange

**Procedures**

To create a Wide Flange spline:

1. Go to the Create panel and choose Shapes.
2. Open the Shapes List and select Extended Splines.
3. Click Wide Flange.
4. Drag and release the mouse button to define the initial size of the wide flange.
5. Move the mouse and then click to define the thickness of the walls of the wide flange.

**Interface**

**Rendering and Interpolation rollouts**

All spline-based shapes share these parameters. For explanations, see Splines and Extended Splines on page 577.

**Creation Method rollout**

The Wide Flange shape uses the standard creation methods of Center or Edge. Most spline-based shapes share the same Creation Method parameters. For explanations, see Splines and Extended Splines on page 577.
Parameters rollout

![Parameters Rollout](image)

**Length** Controls the height of the vertical web of the wide flange.

**Width** Controls the width of the horizontal flanges crossing the wide flange.

**Thickness** Controls the thickness of the web and flanges.

**Corner Radius** Controls the radius of the four interior corners between the vertical web and horizontal flanges.

**NOTE** Take care when adjusting these settings. There are no constraining relationships between them. Therefore, it's possible to set a radius (Corner Radius) that is greater than the length of the web or width of the flanges.

---

**Editable Spline**

Create or select a spline > Modify panel > Right-click spline entry in the stack display > Convert To: Editable Spline

Create a line > Modify panel

Create or select a spline > Right-click the spline > Transform (lower-right) quadrant of the quad menu > Convert To: > Convert to Editable Spline

Editable Spline provides controls for manipulating an object as a spline object and at three sub-object levels: vertex, segment, and spline.

The functions in Editable Spline are the same as those in the Edit Spline modifier on page 1424. The exception is that when you convert an existing spline shape to an editable spline, the creation parameters are no longer accessible or animatable. However, the spline's interpolation settings (step settings) remain available in the editable spline.

When a spline-editing operation (typically, moving a segment or vertex) causes end vertices to overlap, you can use the Weld on page 640 command to weld...
the overlapping vertices together or the **Fuse** on page 641 command if you want the two overlapping vertices to occupy the same point in space but remain separate vertices.

---

**NOTE** Welding coincident vertices is controlled by the **End Point Auto-Welding feature** on page 7.

---

### Show End Result

If you have several modifiers higher in the modifier stack, and want to see the results of edits in an Edit Spline modifier or Editable Spline object, then turn on **Show End Result** on the Modify panel. As you edit the spline network, you’ll be able to see the result of modifiers above the Editable Spline object. This is useful for Surface Tools work where you add a Surface modifier above an Editable Spline object in the modifier stack.

**See also:**
- [Edit Modifiers and Editable Objects](#) on page 1052
- [Modifying at the Sub-Object Level](#) on page 1054
- [Modifier Stack Controls](#) on page 8187

### Procedures

To **produce an editable spline object**, first select the shape, and then do one of the following:

1. Right-click the shape entry in the stack display and choose **Convert To: Editable Spline**.

2. In a viewport, right-click the object and choose Convert To: > **Convert to Editable Spline** from the Transform (lower-right) quadrant of the quad menu.

3. Create a shape with two or more splines by first turning off **Start New Shape** (on the Create panel). Any shape made up of two or more splines is automatically an editable spline.

4. Apply an Edit Spline modifier to a shape, and then collapse the stack. If you use the **Collapse utility** on page 2022 to collapse the stack, be sure to choose Output Type > **Modifier Stack Result**.
5 Import a .shp file.
6 Merge a shape from a 3ds Max file.

To select shape sub-objects:
1 Expand the object’s hierarchy in the stack display and choose a sub-object level, or click one of the sub-object buttons at the top of the Selection rollout.

You can also right-click the object in the viewports and choose a sub-object level from the quad menu: Tools 1 (upper-left) quadrant > Sub-objects > Choose the sub-object level.

2 Click a selection or transform tool, and then select sub-objects using standard click or region-selection techniques.

Because sub-object selections can be complex, you might consider using one of the following techniques to prevent clearing the sub-object selection by accident:
■ Use Lock Selection on page 8079.
■ Name the sub-object selection (see Named Selection Sets List on page 185).

To clone sub-object selections:
■ Hold down the Shift key while transforming the sub-objects.

You can clone segment and spline sub-objects, but not vertices.

To draw a spline cage:
1 Select a segment sub-object on a spline.
2 On the Geometry rollout in the Connect Copy group, turn on Connect.
3 Hold down the Shift key and transform the selected segment. You can move, rotate or scale using the transform gizmo to control the direction. Notice that with Connect Copy on, new splines are drawn between the locations of the segment and its clone.

Tip Use Area Selection or Fuse before selecting and moving these vertices. They will not move together as they do with the Cross-Section modifier. Or use Fuse to keep the vertices together.
Interface

The following controls are available at the object (top) level and at all sub-object levels.

Rendering and Interpolation rollouts

These creation parameters appear in these rollouts for editable splines. For splines to which the Edit Spline modifier has been applied, creation parameters are available by selecting the object type entry (for example, Circle or NGon) at the bottom of the modifier stack on page 8187.

Rendering rollout

Controls here let you turn on and off the renderability of the shape, specify its thickness in the rendered scene, and apply mapping coordinates. The spline mesh can be viewed in the viewports. You can animate the render parameters, such as the number of sides. Viewport settings cannot be animated.
You can also convert the displayed mesh into a mesh object by applying an Edit Mesh modifier or converting to an Editable Mesh. The system will use the Viewport settings for this mesh conversion if Use Viewport Settings is turned on; otherwise it will use the Renderer settings. This gives maximum flexibility, and will always give the conversion of the mesh displayed in the viewports.

**Enable In Renderer** When on, the shape is rendered as a 3D mesh using the Radial or Rectangular parameters set for Renderer.

**Enable In Viewport** When on, the shape is displayed in the viewport as a 3D mesh using the Radial or Rectangular parameters set for Renderer.

**Use Viewport settings** Lets you set different rendering parameters, and displays the mesh generated by the Viewport settings. Available only when Enable in Viewport is turned on.

**Generate Mapping Coords** Turn this on to apply mapping coordinates. Default=off.

The U coordinate wraps once around the thickness of the spline; the V coordinate is mapped once along the length of the spline. Tiling is achieved using the Tiling parameters in the material itself.

**Real-World Map Size** Controls the scaling method used for texture mapped materials that are applied to the object. The scaling values are controlled by the Use Real-World Scale settings found in the applied material’s Coordinates rollout on page 6201. Default=off.

**Viewport** Choose this to specify Radial or Rectangular parameters for the shape as it will display in the viewport when Enable In Viewport is turned on.

**Renderer** Choose this to specify Radial or Rectangular parameters for the shape as it will display when rendered or when viewed in the viewport when Enable In Viewport is turned on.

**Radial** Displays the 3D mesh as a cylindrical object.

- **Thickness** Specifies the diameter of the viewport or rendered spline mesh. Default=1.0. Range=0.0 to 100,000,000.0.
Splines rendered at thickness of 1.0 and 5.0, respectively

- **Sides** Sets the number of sides (or facets) for the spline mesh in the viewport or renderer. For example, a value of 4 results in a square cross section.

- **Angle** Adjusts the rotational position of the cross-section in the viewport or renderer. For example, if the spline mesh has a square cross section you can use Angle to position a "flat" side down.

**Rectangular** Displays the spline's mesh shape as rectangular.

- **Aspect** Sets the aspect ratio for rectangular cross-sections. The Lock check box lets you lock the aspect ratio. When Lock is turned on, Width is locked to Depth that results in a constant ratio of Width to Depth.

- **Length** Specifies the size of the cross-section along the local Y axis.

- **Width** Specifies the size of the cross-section along the local X axis.

- **Angle** Adjusts the rotational position of the cross-section in the viewport or renderer. For example, if you have a square cross-section you can use Angle to position a "flat" side down.

- **Aspect** The ratio of length to width. This control is linked to the Length setting: when Aspect is unlocked, changing Length changes Aspect and vice-versa. When Aspect is locked, the control is unavailable, and changing Length or Width automatically changes the Width or Length (respectively) to maintain the current aspect ratio.

**Auto Smooth** When on, the spline is auto-smoothed using the threshold specified by the Threshold setting. Auto Smooth sets the smoothing based on the angle between spline segments. Any two adjacent segments are put in the
same smoothing group if the angle between them is less than the threshold angle.

**Threshold** Specifies the threshold angle in degrees. Any two adjacent spline segments are put in the same smoothing group if the angle between them is less than the threshold angle.

**Interpolation rollout**

The Interpolation controls set how 3ds Max generates a spline. All spline curves are divided into small straight lines that approximate the true curve. The number of divisions between each vertex on the spline is called *steps*. The more steps used, the smoother the curve appears.

![Interpolation rollout](image)

Splines used in above lathed objects contained two steps (left) and 20 steps (right)

**Steps** Use the Steps field to set the number of divisions, or steps, 3ds Max uses between each vertex. Splines with tight curves require many steps to look smooth while gentle curves require fewer steps. Range=0 to 100.

Spline steps can be either adaptive or manually specified. The method used is set by the state of the Adaptive check box. The main use for manual interpolation is to create splines for morphing or other operations where you must have exact control over the number of vertices created.

**Optimize** When on, removes unneeded steps from straight segments in the spline. Default=on.
NOTE Optimize is not available when Adaptive is on.

Optimize was used to create spline in this lathed object.

Adaptive When on, automatically sets the number of steps for each spline to produce a smooth curve. Straight segments always receive 0 steps. When off, enables manual interpolation control using Optimize and Steps. Default=off.

Selection rollout
Provides controls for turning different sub-object modes on and off, working with named selections and handles, display settings, and information about selected entities.

When you first access the Modify panel with an editable spline selected, you're at the Object level, with access to several functions available as described in *Editable Spline (Object)* on page 630. You can toggle the sub-object modes and access relevant functions by clicking sub-object buttons at the top of the Selection rollout.

You can work with parts of shapes and splines using shape sub-object selection of the Editable Spline object. Clicking a button here is the same as selecting a sub-object type in the Modifier List. Click the button again to turn it off and return to object selection level.

- **Vertices** Define points and curve tangents.
- **Segments** Connect vertices.
- **Splines** Are a combination of one or more connected segments.

**Named Selections group**

- **Copy** Places a named selection into the copy buffer.
- **Paste** Pastes a named selection from the copy buffer.
- **Lock Handles** Normally you can transform the tangent handles of only one vertex at a time, even when multiple vertices are selected. Use the Lock Handles controls to transform multiple Bezier and Bezier Corner handles simultaneously.
- **Alike** As you drag the handle of an incoming vector, all incoming vectors of the selected vertices move simultaneously. Likewise, moving the outgoing tangent handle on one vertex moves the outgoing tangent handle for all selected vertices.
- **All** Any handle you move affects all handles in the selection, regardless of whether they're broken. This option is also useful when working with a single Bezier Corner vertex when you want to move both handles.
Shift+click a handle to "break" the tangent and move each handle independently. The Alike option must be chosen to break the tangent.

**Area Selection** Lets you select automatically all vertices within a specific radius of the vertex you click. At the Vertex sub-object level, turn on Area Selection, and then set the radius with the spinner to the right of the Area Selection check box. This is useful when moving vertices that have been created using Connect Copy or Cross Section button.

**Segment End** Select a vertex by clicking a segment. In Vertex sub-object, turn on and select a segment close to the vertex that you want selected. Use this when there are a number of coincident vertices and you want to select a vertex on a specific segment. The cursor changes to a cross when it is over a segment. By holding down the Ctrl key you can add to the selection.

**Select By** Selects vertices on the selected spline or segment. First select a spline or segment in sub-object spline or segment, then turn on vertex sub-object and click Select By and choose Spline or Segment. All the vertices on the selected spline or segment are selected. You can then edit the vertices.

**Display group**

**Show Vertex Numbers** When on, 3ds Max displays vertex numbers next to the selected spline's vertices at any sub-object level.

**Selected Only** When on, the vertex number or numbers appear only next to selected vertices.

**Soft Selection**

For information on the Soft Selection rollout settings, see **Soft Selection Rollout** on page 2014.

**Selection Info**

At the bottom of the Selection rollout is a text display giving information about the current selection. If 0 or more than one sub-object is selected, the text gives the number selected.

At the Vertex and Segment sub-object levels, if one sub-object is selected, the text gives the identification numbers of the current spline (with respect to the current object) and of the current selected sub-object. Each spline object contains a spline number 1; if it contains more than one spline, the subsequent splines are numbered consecutively higher.
When a single spline is selected at the Spline sub-object level, the first line displays the identification number of the selected spline and whether it’s open or closed, and the second line displays the number of vertices it contains. When more than one spline is selected, the number of splines selected is displayed on the first line, and the total number of vertices they contain is displayed on the second line.

**Geometry rollout**

The Geometry rollout provides functions for editing a spline object and sub-objects. The functions available at the spline object level (when no sub-object level is active; see Editable Spline (Object) on page 630) are also available at all sub-object levels, and work exactly the same at each level. Other functions are also available, depending on which sub-object level is active. Those that apply to other sub-object levels are unavailable.

**Editable Spline (Object)**

Select an editable spline > Modify panel > Editable spline (not a sub-object level) selected in the modifier stack

Select an editable spline > Right-click the spline > Tools 1 (upper-left) quadrant of the quad menu > Sub-objects > Top-level

The functions available at the editable spline object level (that is, when no sub-object level is active) are also available at all sub-object levels, and work exactly the same at each level.

**Interface**

**Rendering, Interpolation, and Selection rollouts**

See the Editable Spline topic for information on the Rendering and Interpolation rollouts on page 623, and Selection rollout on page 627 settings.
**New Vertex Type group** The radio buttons in this group let you determine the tangency of the new vertices created when you Shift+Clone segments or splines. If you later use Connect Copy, vertices on the splines that connect the original segment or spline to the new one will have the type specified in this group.

This setting has no effect on the tangency of vertices created using tools such as the Create Line button, Refine, and so on.

- **Linear** New vertices will have linear tangency.
- **Smooth** New vertices will have smooth tangency. When this option is chosen, new vertices that overlap are automatically welded.
- **Bezier** New vertices will have bezier tangency.
- **Bezier Corner** New vertices will have bezier corner tangency.
Create Line Adds more splines to the selected spline. These lines are separate spline sub-objects; create them in the same way as the line spline on page 584. To exit line creation, right-click or click to turn off Create Line.

Break Splits a spline at the selected vertex or vertices. Select one or more vertices and then click Break to create the split. There are now two superimposed non-connected vertices for every previous one, allowing the once-joined segment ends to be moved away from each other.

Attach Lets you attach another spline in the scene to the selected spline. Click the object you want to attach to the currently selected spline object. The object you're attaching to must also be a spline.

Unattached splines (left) and attached splines (right)

When you attach an object, the materials of the two objects are combined in the following way:

- If the object being attached does not have a material assigned, it inherits the material of the object it is being attached to.
- Likewise if the object you're attaching to doesn't have a material, it inherits the material of the object being attached.
- If both objects have materials, the resulting new material is a multi/sub-object material on page 6120 that encompasses the input materials. A dialog appears offering three methods of combining the objects' materials and material IDs. For more information, see Attach Options Dialog on page 2233.

Attached shapes lose their identity as individual shapes, with the following results:
The attached shape loses all access to its creation parameters. For example, once you attach a circle to a square you cannot go back and change the radius parameter of the circle.

The modifier stack of the attached shape is collapsed. Any edits, modifiers, and animation applied to the attached shape are frozen at the current frame.

**Reorient** When on, rotates the attached spline so that its creation local coordinate system is aligned with the creation local coordinate system of the selected spline.

**Attach Mult.** Click this button to display the Attach Multiple dialog, which contains a list of all other shapes in the scene. Select the shapes you want to attach to the current editable spline, then click OK.

**Cross Section** Creates a spline cage out of cross-sectional shapes. Click Cross Section, select one shape then a second shape, splines are created joining the first shape with the second. Continue clicking shapes to add them to the cage. This functionality is similar to the Cross Section modifier, but here you can determine the order of the cross sections. Spline cage tangency can be defined by choosing Linear, Bezier, Bezier Corner or Smooth in New Vertex Type group.

**End Point Auto-Welding group**

- **Automatic Welding** When Automatic Welding is turned on, an end point vertex that is placed or moved within the threshold distance of another end point of the same spline is automatically welded. This feature is available at the object and all sub-object levels.

- **Threshold** A proximity setting that controls how close vertices can be to one another before they are automatically welded. Default=6.0.

**Insert** Inserts one or more vertices, creating additional segments. Click anywhere in a segment to insert a vertex and attach the vertex to the mouse. Optionally move the mouse and then click to place the new vertex. Continue moving the mouse and clicking to add vertices. A single click inserts a corner vertex, while a drag creates a Bezier (smooth) vertex.

Right-click to complete the operation and release the mouse. At this point, you're still in Insert mode, and can begin inserting vertices in a different segment. Otherwise, right-click again or click Insert to exit Insert mode.
Editable Spline (Vertex)

Select an editable spline > Modify panel > Expand the editable spline in the stack display > Vertex sub-object level

Select an editable spline > Modify panel > Selection rollout > Vertex button

Select an editable spline > Right-click the spline > Tools 1 (upper-left) quadrant of the quad menu > Sub-objects > Vertex

While at the Editable Spline (Vertex) level, you can select single and multiple vertices and move them using standard methods.

If the vertex is of the Bezier or Bezier Corner type, you can also move and rotate handles, thus affecting the shapes of any segments joined at the vertex. You can copy and paste the handles between vertices using tangent copy/paste. You can reset them or switch between types using the quad menu. The tangent types are always available on the quad menu when a vertex is selected; your cursor doesn't have to be directly over them in the viewport.

Procedures

To set a vertex type:

1. Right-click any vertex in a selection.
2. Choose a type from the shortcut menu. Each vertex in a shape can be one of four types:
   - **Smooth**: Nonadjustable vertices that create smooth continuous curves. The curvature at a smooth vertex is determined by the spacing of adjacent vertices.
   - **Corner**: Nonadjustable vertices that create sharp corners.
   - **Bezier**: Adjustable vertex with locked continuous tangent handles that create a smooth curve. The curvature at the vertex is set by the direction and magnitude of the tangent handles.
   - **Bezier Corner**: Adjustable vertex with discontinuous tangent handles that create a sharp corner. The curvature of the segment as it leaves the corner is set by the direction and magnitude of the tangent handles.
To copy and paste vertex tangent handles:

1. Turn on Vertex Selection, then Select the vertex you want to copy from.

2. On the Geometry rollout scroll down to the Tangent group and click Copy.

3. Move your cursor over the vertices in the viewport. The cursor changes to a copy cursor. Click the handle you wish to copy.

4. On the Geometry rollout scroll down to the Tangent group and click Paste.

5. Move your cursor over the vertices in the viewport. The cursor changes to a paste cursor. Click the handle you wish to paste to.
The vertex tangency changes in the viewport.

To reset vertex handle tangency:
It is easy to make the handles very small and coincident with the vertex, which makes them hard to select and edit. Reset the vertex handle tangency to redraw your handles

1. Select the vertex that is problematic.
2. Right-click and choose Reset Tangents.

Any vertex handle editing you have done is discarded and the handles are reset.

Interface

Soft Selection rollout
For information on the Soft Selection rollout settings, see Soft Selection Rollout on page 2014.

Geometry rollout

New Vertex Type group

The radio buttons in this group let you determine the tangency of the new vertices created when you Shift+Clone segments or splines. If you later use Connect Copy, vertices on the splines that connect the original segment or spline to the new one will have the type specified in this group.

This setting has no effect on the tangency of vertices created using tools such as the Create Line button, Refine, and so on.

- **Linear**  New vertices will have linear tangency.
- **Smooth**  New vertices will have smooth tangency.
  When this option is chosen, new vertices that overlap are automatically welded.
- **Bezier**  New vertices will have bezier tangency.
■ **Bezier Corner**  New vertices will have bezier corner tangency.

---

**Create Line** Adds more splines to the selected object. These lines are separate spline sub-objects; create them in the same way as the line spline on page 584. To exit line creation, right-click or click to turn off Create Line.

**Break** Splits a spline at the selected vertex or vertices. Select one or more vertices and then click Break to create the split. There are now two superimposed non-connected vertices for every previous one, allowing the once-joined segment ends to be moved away from each other.

**Attach** Attaches another spline in the scene to the selected spline. Click the object you want to attach to the currently selected spline object. The object you're attaching must also be a spline.

For further details, see **Attach** on page 632.

**Attach Mult.** Click this button to display the Attach Multiple dialog, which contains a list of all other shapes in the scene. Select the shapes you want to attach to the current editable spline, then click OK.

■ **Reorient**  When on, reorients attached splines so that each spline's creation local coordinate system is aligned with the creation local coordinate system of the selected spline.

**Cross Section** Creates a spline cage out of cross-sectional shapes. Click Cross Section, select one shape then a second shape, splines are created joining the first shape with the second. Continue clicking shapes to add them to the cage. This functionality is similar to the Cross Section modifier, but here you can determine the order of the cross sections. Spline cage tangency can be defined by choosing Linear, Bezier, Bezier Corner or Smooth in New Vertex Type group.

**TIP** When you edit the spline cage, use Area Selection before selecting your vertices. This will keep their positions together as you transform them.

---

Editable Spline | 637
Refine group

The Refine group includes a number of functions useful for building spline networks for use with the Surface modifier on page 1763.

**Refine** Lets you add vertices without altering the curvature values of the spline. Click Refine, and then select any number of spline segments to add a vertex each time you click (the mouse cursor changes to a "connect" symbol when over an eligible segment). To finish adding vertices, click Refine again, or right-click in the viewport.

You can also click existing vertices during a refine operation, in which case 3ds Max displays a dialog asking if you want to **Refine** or **Connect Only** to the vertex. If you choose Connect Only, 3ds Max will not create a vertex: it simply connects to the existing vertex.

The Refine operation creates a different type of vertex depending on the types of vertices on the endpoints of the segment being refined.

- If the bordering vertices are both Smooth types, the Refine operation creates a Smooth type vertex.
- If the bordering vertices are both Corner types, the Refine operation creates a Corner type vertex.
- If either of the bordering vertices is a Corner or Bezier Corner, the Refine operation creates a Bezier Corner type.
- Otherwise, the operation creates a Bezier type vertex.

**Connect** When on, creates a new spline sub-object by connecting the new vertices. When you finish adding vertices with Refine, Connect makes a separate copy of each new vertex and then connects all of the copies with a new spline.

**NOTE** For Connect to work, you must turn it on before you click Refine.
After turning on Connect and before beginning the refinement process, turn on any combination of these options:

- **Linear**  When on, makes all segments in the new spline straight lines by using Corner vertices. When Linear is off, the vertices used to create the new spline are of the Smooth type.

- **Bind First**  Causes the first vertex created in a refinement operation to be bound to the center of the selected segment. See Bound Vertex on page 8528.

- **Closed**  When on, connects the first and last vertices in the new spline to create a closed spline. When Closed is off, Connect always creates an open spline.

- **Bind Last**  Causes the last vertex created in a refinement operation to be bound to the center of the selected segment. See Bound Vertex on page 8528.

**End Point Auto-Welding group**

![End Point Auto-Welding](image)

**Automatic Welding**  When Automatic Welding is turned on, an end point vertex that is placed or moved within the threshold distance of another end point of the same spline is automatically welded. This feature is available at the object and all sub-object levels.

**Threshold**  The threshold distance spinner is a proximity setting that controls how close vertices can be to one another before they are automatically welded. Default=6.0.
Weld Converts two end vertices, or two adjacent vertices within the same spline, into a single vertex. Move either two end vertices or two adjacent vertices near each other, select both vertices, and then click Weld. If the vertices are within the unit distance set by the Weld Threshold spinner (to the right of the button), they’re converted into a single vertex. You can weld a selection set of vertices, as long as each pair of vertices is within the threshold.

Connect Connects any two end vertices, resulting in a linear segment, regardless of the tangent values of the end vertices. Click the Connect button, point the mouse over an end vertex until the cursor changes to a cross, and then drag from one end vertex to another end vertex.

Insert Inserts one or more vertices, creating additional segments. Click anywhere in a segment to insert a vertex and attach the mouse to the spline. Then optionally move the mouse and click to place the new vertex. Continue moving the mouse and clicking to add vertices. A single click inserts a corner vertex, while a drag creates a Bezier (smooth) vertex. Right-click to complete the operation and release the mouse. At this point, you’re still in Insert mode, and can begin inserting vertices in a different segment. Otherwise, right-click again or click Insert to exit Insert mode.

Make First Specifies which vertex in the selected shape is the first vertex. The first vertex of a spline is indicated as a vertex with a small box around it. Select one vertex on each spline within the currently edited shape that you want to change and click the Make First button. On open splines, the first vertex must be the endpoint that is not already the first vertex. On closed splines, it can be any point that isn’t already the first vertex. Click the Make First button, and the first vertices will be set.
The first vertex on a spline has special significance. The following table defines how the first vertex is used.

<table>
<thead>
<tr>
<th>Shape Use</th>
<th>First Vertex Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loft Path</td>
<td>Start of the path. Level 0.</td>
</tr>
<tr>
<td>Loft Shape</td>
<td>Initial skin alignment.</td>
</tr>
<tr>
<td>Path Constraint</td>
<td>Start of the motion path. 0% location</td>
</tr>
<tr>
<td></td>
<td>on the path.</td>
</tr>
<tr>
<td>Trajectory</td>
<td>First position key.</td>
</tr>
</tbody>
</table>

**Fuse** Moves all selected vertices to their averaged center. Fuse is useful for making vertices coincide when building a spline network for use with the Surface modifier on page 1763.

**NOTE** Fuse doesn't join the vertices; it simply moves them to the same location.

![Three selected vertices (left); fused vertices (right)](image)

**Cycle** Selects successive coincident vertices. Select one of two or more vertices that share the exact same location in 3D space, and then click Cycle repeatedly until the vertex you want is selected.
Cycle is useful for selecting a specific vertex from a group of coincident vertices at a spline intersection when building a spline network for use with the Surface modifier on page 1763.

**TIP** Watch the info display at the bottom of the Selection rollout to see which vertex is selected.

**CrossInsert** Adds vertices at the intersection of two splines belonging to the same spline object. Click CrossInsert, and then click the point of intersection between the two splines. If the distance between the splines is within the unit distance set by the CrossInsert Threshold spinner (to the right of the button), the vertices are added to both splines. You can continue using CrossInsert by clicking different spline intersections. To finish, right-click in the active viewport or click the CrossInsert button again. CrossInsert is useful for creating vertices at spline intersections when building a spline network for use with the Surface modifier on page 1763.

**NOTE** CrossInsert doesn’t join the two splines, but simply adds vertices where they cross.

**Fillet** Lets you round corners where segments meet, adding new control vertices. You can apply this effect interactively (by dragging vertices) or numerically (using the Fillet spinner). Click the Fillet button, and then drag vertices in the active object. The Fillet spinner updates to indicate the fillet amount as you drag.
If you drag one or more selected vertices, all selected vertices are filleted identically. If you drag an unselected vertex, any selected vertices are first deselected.

You can continue using Fillet by dragging on different vertices. To finish, right-click in an active viewport or click the Fillet button again.

A fillet creates a new segment connecting new points on both segments leading to the original vertex. These new points are exactly <fillet amount> distance from the original vertex along both segments. New fillet segments are created with the material ID of one of the neighboring segments (picked at random).

For example, if you fillet one corner of a rectangle, the single corner vertex is replaced by two vertices moving along the two segments that lead to the corner, and a new rounded segment is created at the corner.
**NOTE** Unlike the Fillet/Chamfer modifier, you can apply the Fillet function to any type of vertex, not just Corner and Bezier Corner vertices. Similarly, adjoining segments need not be linear.

- **Fillet Amount** Adjust this spinner (to the right of the Fillet button) to apply a fillet effect to selected vertices.

**Chamfer** Lets you bevel shape corners using a chamfer function. You can apply this effect interactively (by dragging vertices) or numerically (using the Chamfer spinner). Click the Chamfer button, and then drag vertices in the active object. The Chamfer spinner updates to indicate the chamfer amount as you drag.

If you drag one or more selected vertices, all selected vertices are chamfered identically. If you drag an unselected vertex, any selected vertices are first deselected.

You can continue using Chamfer by dragging on different vertices. To finish, right-click in an active viewport or click the Chamfer button again.

A chamfer "chops off" the selected vertices, creating a new segment connecting new points on both segments leading to the original vertex. These new points are exactly <chamfer amount> distance from the original vertex along both segments. New chamfer segments are created with the material ID of one of the neighboring segments (picked at random).

For example, if you chamfer one corner of a rectangle, the single corner vertex is replaced by two vertices moving along the two segments that lead to the corner, and a new segment is created at the corner.

**NOTE** Unlike the Fillet/Chamfer modifier, you can apply the Chamfer function to any type of vertex, not just Corner and Bezier Corner vertices. Similarly, adjoining segments need not be linear.

- **Chamfer Amount** Adjust this spinner (to the right of the Chamfer button) to apply a chamfer effect to selected vertices.

**Tangent group**

![Tangent group interface](image)
Tools in this group let you copy and paste vertex handles from one vertex to another.

**Copy**  Turn this on, then choose a handle. This action copies the selected handle tangent into a buffer.

**Paste**  Turn this on, then click a handle. This pastes the handle tangent onto the selected vertex.

**Paste Length**  When this is on, the handle length is also copied. When this is off, only the handle angle is considered, the handle length is unchanged.

**Hide and Bind group**

- **Hide**  Hides selected vertices and any connected segments. Select one or more vertices, and then click Hide.
- **Unhide All**  Displays any hidden sub-objects.
- **Bind**  Lets you create bound vertices on page 8528. Click Bind, and then drag from any end vertex in the current selection to any segment in the current selection except the one connected to the vertex. Before dragging, when the cursor is over an eligible vertex, it changes to a + cursor. While dragging, a dashed line connects the vertex and the current mouse position, and when the mouse cursor is over an eligible segment, it changes to a "connect" symbol. When you release over an eligible segment, the vertex jumps to the center of the segment and is bound to it.
  
  Bind is useful for connecting splines when building a spline network for use with the **Surface modifier** on page 1763.

- **Unbind**  Lets you disconnect bound vertices on page 8528 from the segments to which they're attached. Select one or more bound vertices, and the click the Unbind button.

- **Delete**  Deletes the selected vertex or vertices, along with one attached segment per deleted vertex.
Display group

Show selected segs When on, any selected segments are highlighted in red at the Vertex sub-object level. When off (the default), selected segments are highlighted only at the Segment sub-object level.
This feature is useful for comparing complex curves against each other.

Editable Spline (Segment)

Select an editable spline > Modify panel > Expand the editable spline in the stack display > Segment sub-object level
Select an editable spline > Modify panel > Selection rollout > Segment button
Select an editable spline > Right-click the spline > Tools 1 (upper-left) quadrant of the quad menu > Sub-objects > Segment

A segment is the portion of a spline curve between two of its vertices. While at the Editable Spline (Segment) level, you can select single and multiple segments and move, rotate, scale or clone them using standard methods.

Procedures

To change segment properties:

1. Select an editable spline segment, and then right-click.

2. On the Tools 1 (upper-left) quadrant of the quad menu, choose Line or Curve.
The effect of changing segment properties varies according to the type of vertices at the segment end.

- Corner vertices always result in line segments regardless of the segment property.
- Smooth vertices can support both line or curve segment properties.
- Bezier and Bezier Corner vertices apply their tangent handles only to curve segments. Tangent handles are ignored by line segments.
- A tangent handle associated with a line segment displays an X at the end of the handle. You can still transform the handle, but it has no effect until the segment is converted to a curve segment.

**TIP** If you have problems transforming the handles, display the axis constraints toolbar and change the transform axis there.

### Interface

#### Rendering, Interpolation, and Selection rollouts

For information on the Rendering, Interpolation on page 623 and Selection rollout on page 627 settings, see Editable Spline on page 620.

#### Soft Selection rollout

For information on the Soft Selection rollout settings, see Soft Selection Rollout on page 2014.

#### Geometry rollout

##### New Vertex Type group

The radio buttons in this group let you determine the tangency of the new vertices created when you Shift+Clone segments or splines. If you later use Connect Copy, vertices on the splines that connect the original segment or spline to the new one will have the type specified in this group.
This setting has no effect on the tangency of vertices created using tools such as the Create Line button, Refine, and so on.

- **Linear**  New vertices will have linear tangency.
- **Smooth**  New vertices will have smooth tangency. When this option is chosen, new vertices that overlap are automatically welded.
- **Bezier**  New vertices will have bezier tangency.
- **Bezier Corner**  New vertices will have bezier corner tangency.

---

**Create Line** Adds more splines to the selected spline. These lines are separate spline sub-objects; create them in the same way as the line spline on page 584. To exit line creation, right-click or click to turn off Create Line.

**Break** Lets you specify a break point at any segment in the shape (you do not have to first select a segment). When on, the mouse icon changes to a Break icon. You can now click any spot on a segment. The clicked spot becomes two coincident vertices, and the segment is split into two parts.

**Attach** Attaches another spline in the scene to the selected spline. Click the object you want to attach to the currently selected spline object. The object you're attaching to must also be a spline.

For further details, see Attach on page 632.

**Reorient** Reorients the attached spline so that its creation local coordinate system is aligned with the creation local coordinate system of the selected spline.

**Attach Mult.** Click this button to display the Attach Multiple dialog, which contains a list of all other shapes in the scene. Select the shapes you want to attach to the current editable spline, then click OK.

**Cross Section** Creates a spline cage out of cross-sectional shapes. Click Cross Section, select one segment then another sub-object segment, splines are
created joining the first shape with the second. Continue clicking segments
to add them to the cage. All segments must be part of the same object to build
cross sections. This functionality is similar to the Cross Section modifier, but
here you can determine the order of the cross sections. Spline cage tangency
can be defined by choosing Linear, Bezier, Bezier Corner or Smooth in New
Vertex Type group.

TIP When you want to move these vertices, turn on Area Selection before you
select them. When you transform them, the vertices will stay together.

**Refine group**

The Refine group includes a number of functions useful for building spline
networks for use with the Surface modifier on page 1763.

**Refine** Lets you add vertices without altering the curvature values of the spline.
Click Refine, and then select any number of spline segments to add a vertex
each time you click (the mouse cursor changes to a "connect" symbol when
over an eligible segment). To finish adding vertices, click Refine again, or
right-click in the viewport.

You can also click existing vertices during a refine operation, in which case
3ds Max displays a dialog asking if you want to **Refine** or **Connect** to the
vertex. If you choose Connect, 3ds Max will not create a vertex: it simply
connects to the existing vertex.

The Refine operation creates a different type of vertex depending on the types
of vertices on the endpoints of the segment being refined.

- If the bordering vertices are both Smooth types, the Refine operation creates
  a Smooth type vertex.

- If the bordering vertices are both Corner types, the Refine operation creates
  a Corner type vertex.

- If either of the bordering vertices is a Corner or Bezier Corner, the Refine
  operation creates a Bezier Corner type.

- Otherwise, the operation creates a Bezier type vertex.
Connect When on, creates a new spline sub-object by connecting the new vertices. When you finish adding vertices with Refine, Connect makes a separate copy of each new vertex and then connects all of the copies with a new spline.

**NOTE** For Connect to work, you must turn it on before you click Refine.

After turning on Connect and before beginning the refinement process, turn on any combination of these options:

- **Linear** When on, makes all segments in the new spline linear by using Corner vertices. When Linear is off, the vertices used to create the new spline are of the Smooth type.

- **Bind First** Causes the first vertex created in a refinement operation to be bound to the center of the selected segment.
  For more information, see Bound Vertex on page 8528.

- **Closed** When on, connects the first and last vertices in the new spline to create a closed spline. When Closed is off, Connect always creates an open spline.

- **Bind Last** Causes the last vertex created in a refinement operation to be bound to the center of the selected segment.
  For more information, see Bound Vertex on page 8528.

**Connect Copy group**

**Connect Copy** When on, Shift+cloning a segment creates a new spline sub-object with additional splines that connect the new segment’s vertices to the vertices of the original segment. It is analogous to Shift+cloning edges in Editable Mesh and Editable Poly objects.

**NOTE** For Connect Copy to work, you must turn it on before you Shift+Clone.

**Threshold** Determines the distance soft selection will use when Connect Copy is on. A higher threshold results in more splines being created; a lower threshold results in fewer splines.
End Point Auto-Welding group

Automatic Welding When Automatic Welding is turned on, an end point vertex that is placed or moved within the threshold distance of another end point of the same spline is automatically welded. This feature is available at the object and all sub-object levels.

Threshold The threshold distance spinner is a proximity setting that controls how close vertices can be to one another before they are automatically welded. Default=6.0.

Insert Inserts one or more vertices, creating additional segments. Click anywhere in a segment to insert a vertex and attach the mouse to the spline. Then optionally move the mouse and click to place the new vertex. Continue moving the mouse and clicking to add vertices. A single click inserts a corner vertex, while a drag creates a Bezier (smooth) vertex.

Right-click to complete the operation and release the mouse. At this point, you're still in Insert mode, and can begin inserting vertices in a different segment. Otherwise, right-click again or click Insert to exit Insert mode.
**Hide** Hides selected segments. Select one or more segments, and then click Hide.

**Unhide All** Displays any hidden sub-objects.

**Delete** Deletes any selected segments in the current shape.

**Selected and deleted segment**

**Divide** Subdivides the selected segment or segments by adding the number of vertices specified by the spinner. Select one or more segments, set the Divisions spinner (to the button's right), and then click Divide. Each selected segment is divided by the number of vertices specified in the Divisions spinner. The distance between the vertices depends on the segment's relative curvature, with areas of greater curvature receiving more vertices.
Detach  Lets you select several segments in various splines and then detach them (or copy them) to form a new shape. Three options are available:

- **Same Shp**  (Same Shape) When on, Reorient is disabled, and a Detach operation keeps the detached segment as part of the shape (rather than producing a new shape). If Copy is also on, you end up with a detached copy of the segment in the same location.

- **Reorient**  The detached segment copies the position and orientation of the source object's creation Local coordinate system. The new detached object is moved and rotated so that its Local coordinate system is positioned and aligned with the origin of the current active grid.

- **Copy**  Copies the detached segment rather than moving it.
Original and detached splines

Display group

Show selected segs When on, any selected segments are highlighted in red at the Vertex sub-object level. When off (the default), selected segments are highlighted only at the Segment sub-object level. This feature is useful for comparing complex curves against each other.

Surface Properties rollout
Material group

You can apply different material IDs to spline segments (see Material ID on page 8633). You can then assign a multi/sub-object material on page 6120 to such splines, which appears when the spline is renderable, or when used for lathing or extrusion. Be sure to turn on Generate Material IDs and Use Shape IDs when lofting, lathing or extruding.

Set ID Lets you assign a particular material ID number to selected segments for use with multi/sub-object materials and other applications. Use the spinner or enter the number from the keyboard. The total number of available IDs is 65,535.

Select ID Selects the segments or splines corresponding to the Material ID specified in the adjacent ID field. Type or use the spinner to specify an ID, then click the Select ID button.

Select By Name This drop-down list shows the names of sub-materials if an object has a Multi/Sub-object material assigned to it. Click the drop arrow and select a material from the list. The segments or splines that are assigned that material are selected. If a shape does not have a Multi/Sub-Object material assigned to it, the name list will be unavailable. Likewise, if multiple shapes are selected that have an Edit Spline modifier applied to them, the name list is inactive.

Clear Selection When turned on, selecting a new ID or material name forces a deselection of any previously selected segments or splines. When turned off, selections are cumulative so new ID or material name selections add to a previous selection set of segments or splines. Default=on.

Editable Spline (Spline)

Select an editable spline > Modify panel > Expand the editable spline in the stack display > Spline sub-object level
Select an editable spline > Modify panel > Selection rollout > Spline button
Select an editable spline > Right-click the spline > Tools 1 (upper-left) quadrant of the quad menu > Sub-objects > Spline

While at the Editable Spline (Spline) level, you can select single and multiple splines within a single spline object and move, rotate, and scale them using standard methods.
Procedures

To change spline properties:

- You change the properties of a spline from Line to Curve by right-clicking and choosing Line or Curve from the Tools 1 (upper-left) quadrant of the quad menu.
  Changing the spline property also changes the property of all vertices in the spline:
  - Choosing Line converts vertices to Corners.
  - Choosing Curve converts vertices to Beziers.

Interface

Rendering, Interpolation and Selection rollouts

For information on the Rendering, Interpolation on page 623 and Selection rollout on page 627 settings, see Editable Spline on page 620.

Soft Selection rollout

### Geometry rollout

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Vertex Type</td>
<td></td>
</tr>
<tr>
<td>Linear</td>
<td></td>
</tr>
<tr>
<td>Bezier</td>
<td></td>
</tr>
<tr>
<td>Smooth</td>
<td></td>
</tr>
<tr>
<td>Bezier Corner</td>
<td></td>
</tr>
<tr>
<td>Create Line</td>
<td>Break</td>
</tr>
<tr>
<td>Attach</td>
<td>Reorient</td>
</tr>
<tr>
<td>Attach Multi.</td>
<td></td>
</tr>
<tr>
<td>Cross Section</td>
<td></td>
</tr>
<tr>
<td>Refine</td>
<td></td>
</tr>
<tr>
<td>Linear</td>
<td></td>
</tr>
<tr>
<td>Closed</td>
<td></td>
</tr>
<tr>
<td>Connect</td>
<td></td>
</tr>
<tr>
<td>Connect</td>
<td></td>
</tr>
<tr>
<td>Threshold (inches)</td>
<td>0.3937</td>
</tr>
<tr>
<td>End Point Auto-Welding</td>
<td></td>
</tr>
<tr>
<td>Automatic Welding</td>
<td></td>
</tr>
<tr>
<td>Threshold (inches)</td>
<td>1.9822</td>
</tr>
<tr>
<td>Weld</td>
<td></td>
</tr>
<tr>
<td>Connect</td>
<td>Insert</td>
</tr>
<tr>
<td>Make First</td>
<td>Fuse</td>
</tr>
<tr>
<td>Reverse</td>
<td>Cycle</td>
</tr>
<tr>
<td>Cross Insert</td>
<td></td>
</tr>
<tr>
<td>Fillet</td>
<td></td>
</tr>
<tr>
<td>Chamfer</td>
<td></td>
</tr>
<tr>
<td>Outline</td>
<td></td>
</tr>
<tr>
<td>Center</td>
<td></td>
</tr>
</tbody>
</table>
New Vertex Type group

The radio buttons in this group let you determine the tangency of the new vertices created when you Shift+Clone segments or splines. If you later use Connect Copy, vertices on the splines that connect the original segment or spline to the new one will have the type specified in this group.

This setting has no effect on the tangency of vertices created using tools such as the Create Line button, Refine, and so on.

- **Linear**  New vertices will have linear tangency.
- **Smooth**  New vertices will have smooth tangency. When this option is chosen, new vertices that overlap are automatically welded.
- **Bezier**  New vertices will have bezier tangency.
- **Bezier Corner**  New vertices will have bezier corner tangency.

---

**Create Line** Adds more splines to the selected spline. These lines are separate spline sub-objects; create them in the same way as the line spline on page 584. To exit line creation, right-click or click to turn off Create Line.

**Attach** Attaches another spline in the scene to the selected spline. Click the object you want to attach to the currently selected spline object. The object you're attaching to must also be a spline.

For further details, see Attach on page 632.

**Reorient** Reorients the attached spline so that its creation local coordinate system is aligned with the creation local coordinate system of the selected spline.

**Attach Mult.** Click this button to display the Attach Multiple dialog, which contains a list of all other shapes in the scene. Select the shapes you want to attach to the current editable spline, then click OK.

**Cross Section** Creates a spline cage out of cross-sectional shapes. Click Cross Section, select one shape then a second shape, splines are created joining the first shape with the second. Continue clicking shapes to add them to the cage. This functionality is similar to the Cross Section modifier, but here you can determine the order of the cross sections. Spline cage tangency can be defined in the New Vertex Type group.
**TIP** When you edit the spline cage, use Area Selection before selecting your vertices. This will keep their positions together as you transform them.

**Connect Copy group**

Connect Copy When on, Shift+Cloning a spline creates a new spline sub-object with additional splines that connect the new spline's vertices to the vertices of the original segment. It is analogous to Shift+Cloning edges in Editable Mesh and Editable Poly objects.

**NOTE** For Connect Copy to work, you must turn it on before you Shift+Clone.

Threshold Determines the distance soft selection uses when Connect Copy is on. A higher value results in more splines being created, a lower value results in fewer splines.

**End Point Auto-Welding group**

Automatic Welding When Automatic Welding is turned on, an endpoint vertex that is placed or moved within the threshold distance of another endpoint of the same spline is automatically welded. This feature is available at the object and all sub-object levels.

Threshold A proximity setting that controls how close vertices can be to one another before they are automatically welded. Default=6.0.

**Insert** Inserts one or more vertices, creating additional segments. Click anywhere in a segment to insert a vertex and attach the mouse to the spline. Then optionally move the mouse and click to place the new vertex. Continue moving the mouse and clicking to add vertices. A single click inserts a corner vertex, while a drag creates a Bezier (smooth) vertex.

Right-click to complete the operation and release the mouse. At this point, you're still in Insert mode, and can begin inserting vertices in a different segment. Otherwise, right-click again or click Insert to exit Insert mode.

**Reverse** Reverses the direction of the selected spline. If the spline is open, the first vertex will be switched to the opposite end of the spline. Reversing the direction of a spline is usually done in order to reverse the effect of using the Insert tool at vertex selection level.
Outline makes a copy of the spline, offset on all sides to the distance specified by the Outline Width spinner (to the right of the Outline button). Select one or more splines and then adjust the outline position dynamically with the spinner, or click Outline and then drag a spline. If the spline is open, the resulting spline and its outline will make a single closed spline.

**NOTE** Normally, if using the spinner, you must first select a spline before using Outline. If, however, the spline object contains only one spline, it is automatically selected for the outlining process.
**Center** When off (default), the original spline remains stationary and the outline is offset on one side only to the distance specified by Outline Width. When Center is on, the original spline and the outline move away from an invisible center line to the distance specified by Outline Width.

**Boolean** Combines two closed polygons by performing a 2D Boolean operation that alters the first spline you select, and deletes the second one. Select the first spline, then click the Boolean button and the desired operation, and then select the second spline.

**NOTE** 2D Booleans only work on 2D splines that are in the same plane.
There are three Boolean operations:

- **Union**  Combines two overlapping splines into a single spline, in which the overlapping portion is removed, leaving non-overlapping portions of the two splines as a single spline.

- **Subtraction**  Subtracts the overlapping portion of the second spline from the first spline, and deletes the remainder of the second spline.

- **Intersection**  Leaves only the overlapping portions of the two splines, deleting the non-overlapping portion of both.

---

**Mirror**  Mirrors splines along the length, width, or diagonally. Click the direction you want to mirror first so it is active, then click Mirror.

- **Copy**  When selected, copies rather than moves the spline as it is mirrored.

- **About Pivot**  When on, mirrors the spline about the spline object’s pivot point (see Pivot on page 3762). When off, mirrors the spline about its geometric center.
Mirrored splines

**Trim** Use Trim to clean up overlapping segments in a shape so that ends meet at a single point.

To trim, you need intersecting splines. Click the portion of the spline you want to remove. The spline is searched in both directions along its length until it hits an intersecting spline, and deleted up to the intersection. If the section intersects at two points, the entire section is deleted up to the two intersections. If the section is open on one end and intersects at the other, the entire section is deleted up to the intersection and the open end. If the section is not intersected, or if the spline is closed and only one intersection is found, nothing happens.

**Extend** Use Extend to clean up open segments in a shape so that ends meet at a single point.

To extend, you need an open spline. The end of the spline nearest the picked point is extended until it reaches an intersecting spline. If there is no intersecting spline, nothing happens. Curved splines extend in a direction tangent to the end of the spline. If the end of a spline lies directly on a boundary (an intersecting spline), then it looks for an intersection further along.

**Infinite Bounds** For the purposes of calculating intersections, turn this on to treat open splines as infinite in length. For example, this lets you trim one linear spline against the extended length of another line that it doesn't actually intersect.
Hide  Hides selected splines. Select one or more splines, and then click Hide.

Unhide All  Displays any hidden sub-objects.

Delete  Deletes the selected spline.

Close  Closes the selected spline by joining its end vertices with a new segment.

Detach  Copies selected splines to a new spline object, and deletes them from the currently selected spline if Copy is clear.

-  Reorient  The spline being detached is moved and rotated so that its creation local coordinate system is aligned with the creation local coordinate system of the selected spline.

-  Copy  When selected, copies rather than moves the spline as it is detached.

Explode  Breaks up any selected splines by converting each segment to a separate spline or object. This is a time-saving equivalent of using Detach on each segment in the spline in succession.

You can choose to explode to splines or objects. If you choose Object, you're prompted for a name; each successive new spline object uses that name appended with an incremented two-digit number.

**Surface Properties rollout**

![Surface Properties rollout](image)

**Material group**

You can apply different material IDs (see material ID on page 8633) to splines in shapes containing multiple splines. You can then assign a multi/sub-object material on page 6120 to such shapes, which appears when the spline is renderable, or when used for lathing or extrusion.
Set ID Lets you assign a particular material ID number to selected segments for use with multi/sub-object materials and other applications. Use the spinner or enter the number from the keyboard. The total number of available IDs is 65,535.

Select ID Selects the segments or splines corresponding to the Material ID specified in the adjacent ID field. Type or use the spinner to specify an ID, then click the Select ID button.

Select By Name This drop-down list shows the names of sub-materials if an object has a Multi/Sub-object material assigned to it. Click the drop arrow and select a material from the list. The segments or splines that are assigned that material are selected. If a shape does not have a Multi/Sub-Object material assigned to it, the name list will be unavailable. Likewise, if multiple shapes are selected that have an Edit Spline modifier applied to them, the name list is inactive.

Clear Selection When turned on, selecting a new ID or material name, forces a deselection of any previously selected segments or splines. If turned off, selections are cumulative so new ID or material name selections add to a previous selection set of segments or splines. Default=on.

Shape Check Utility

Utilities panel > Utilities rollout > More button > Utilities dialog > Shape Check

The Shape Check utility tests spline and NURBS-based shapes and curves for self-intersection and graphically displays any instances of intersecting segments. Self-intersecting shapes used to produce lathed, extruded, lofted, or other 3D objects can result in rendering errors.

The utility is "sticky" in that once you've picked a shape object for it to check, you can pan/zoom viewports and it will continually display the locations of intersecting curves in the shape you pick.

If a shape is animated, moving the time slider will recheck the shape on each frame of the animation, allowing for easy checking of these changing shapes.
Intersection points highlighted by Shape Check

Interface

**Pick Object** Click this button, and then click the shape for the utility to check. You can pick only spline- and NURBS-based shapes and curves. Points of intersection discovered by the utility are highlighted with red boxes. The text below the button indicates whether any points of intersection occur.

**Close** Closes the utility.
**Compound Objects**

Create panel > Geometry > Compound Objects
Create menu > Compound

Compound objects typically combine two or more existing objects into a single object.

![Compound Objects](image)

**Morph Compound Object**

Select an object. > Create panel > Geometry > Compound Objects > Object Type rollout > Morph
Select an object. > Create menu > Compound > Morph

Morphing is an animation technique similar to tweening in 2D animation. A Morph object combines two or more objects by interpolating the vertices of the first object to match the vertex positions of another object. When this interpolation occurs over time, a morphing animation results.
Seed or base object, and the target objects at specific frames
The resulting animation

The original object is known as the seed or base object. The object into which the seed object morphs is known as the target object.

You can morph one seed into multiple targets; the seed object's form changes successively to match the forms of the target objects as the animation plays.

Before you can create a morph, the seed and target objects must meet these conditions:

- Both objects must be mesh, patch, or poly objects.
- Both objects must have an equal number of vertices.

If these conditions don't apply, the Morph button is unavailable.

You can use any kind of object as a morph target, including an animated object or another morph object, as long as the target is a mesh that has the same number of vertices as the seed object.

Creating a morph involves the following steps:

- Model the base object and target objects.
Select the base object.

Click Create panel > Geometry > Compound Objects > Morph.

Add the target objects.

Animate.

**Setting Up the Morph Geometry**

Make sure that the objects you want to use as the seed and targets have the same number of vertices.

**TIP** When you create Loft objects that you want to use as morph seeds and targets, make sure that Morph Capping is on and Adaptive Path Steps and Optimize are turned off. All shapes in the Loft object must have the same number of vertices.

You should also turn off Adaptive and Optimize for other shape-based objects that you want to use with Morph, such as those with Extrude or Lathe modifiers.

**WARNING** The selected object is permanently converted to a morph object as soon as you click Morph, whether or not you proceed to select a target object. The only way to restore the original object is to undo the Morph click.

**Morph Object and Morpher Modifier**

There are two ways to set up morphing animations: the Morph compound object and the Morpher modifier.

The Morpher modifier on page 1518 is more flexible because you can add it multiple times at any place in an object's modifier stack display. This flexibility lets you animate the base object or the morph targets before reaching the Morpher modifier, for example with a noise modifier. The Morpher modifier works hand in hand with the Morpher material. The Morpher modifier is the ideal way to morph characters.

The Barycentric Morph controller can be simpler to use in Track View. The Track View display for Compound Morph has only one animation track regardless of the number of targets. Each key on the track represents a morph result based on a percentage of all the targets. For basic morphing needs, Compound Morph may be preferable to the Morpher modifier.

Lastly, you can add the Morpher modifier to the stack of a Compound Morph object.
Procedures

Example: To create a basic morph:

1. On the Create panel > Geometry > Patch Grids > Object Type rollout, click Quad Patch.
2. In the Top viewport, click and drag to create a patch on the left side of the viewport.
3. Right-click the modifier stack display in the Modify panel and select Convert To Editable Patch from the pop-up menu.
4. Right-click the patch, and then click Move in the Transform quadrant of the quad menu.
5. In the Top viewport, hold Shift and drag with the patch to create a copy on the right side of the viewport.
6. On the Modify panel > Selection rollout, go to the Vertex sub-object level.
7. In the Front viewport, select and move vertices on the selected patch to alter its shape.
8. On the Modify panel, in the stack display, click Editable Patch again to return to the top level.
9. Select the original patch in the viewports.
10. On the Create panel > Geometry > Compound Objects > Objects Type rollout, click Morph.
11. On the Pick Targets rollout, click Pick Target.
12. In the viewports, click the second patch object. Both patch objects are listed in the Morph Targets list.
13. Click Modify panel.
   Morph displays above the Editable Patch in the modifier stack.
14. Move the time slider to frame 10.
15. In the Morph Targets list, click M_QuadPatch01.
16. On the Current Targets rollout, click Create Morph Key.
    On the track bar, a key is displayed at frame 10.
17. On the track bar, right-click the key at frame 10 and click QuadPatch01:Morph in the menu.
A Key Info dialog displays.

18 On the Key Info dialog, select M_QuadPatch01 from the list.

19 On the Key Info dialog, drag the percentage spinner.
   The base object changes shape.

20 Close the Key Info dialog and drag the time slider back and forth. The
   patch morphs its shape.

To select the targets for a morph:

1 Select the seed object.

2 On the Create panel > Geometry > Compound Objects, click Morph.
   The name of the seed object is displayed at the top of the Morph Targets
   list on the Current Targets rollout.

3 On the Pick Targets rollout, choose the method for creating targets:
   Reference, Move, Copy, or Instance.

4 Click Pick Target.

5 Select one or more target objects in the viewports.
   As you select each target, its name is added to the Morph Targets list. If
   an object can't be a target (for example, if it has a different number of
   vertices than the morph seed), you can't select it.
   If you select a target object while you are not at frame 0, creating the
   target also creates a morph key. You can create additional morph keys
   from targets you've already selected, as described in the following
   procedure.

To create morph keys from existing targets:

1 Drag the time slider to the frame where you want to place the morph
   key.

   NOTE The Auto Key button does not need to be on to set morph keys.

2 Highlight the name of a target object on the Morph Targets list.
   The Create Morph Key button is available only when a target object name
   is selected.

3 Click Create Morph Key.
3ds Max places a morph key at the active frame.

4 To preview the effect of the morph, drag the time slider back and forth. You can view and edit the morph keys in Track View, which also lets you view the morph’s target object parameters.

Interface

Pick Targets rollout

![Pick Targets](image)

When you pick target objects, you designate each target as a Reference, Move (the object itself), Copy, or Instance. Base your selection on how you want to use the scene geometry after you create the morph.

**Pick Target** Use this button to designate the target object or objects.

**Reference/Copy/Move/Instance** Lets you specify how the target is transferred to the compound object. It can be transferred either as a reference on page 8699, a copy, an instance on page 8611, or it can be moved, in which case the original shape is not left behind.

- Use Copy when you want to reuse the target geometry for other purposes in the scene.

- Use Instance to synchronize morphing with animated changes to the original target object.

- Use Move if you've created the target geometry to be only a morph target, and have no other use for it.

You can use an animated object or another morph as the target of a morph.
Current Targets rollout

Morph Targets Displays a list of the current morph targets.

Morph Target Name Use this field to change the name of the selected morph target in the Morph Targets list.

Create Morph Key Adds a morph key for the selected target at the current frame.

Delete Morph Target Deletes the currently highlighted morph target. If morph keys reference the deleted target, then those keys are deleted as well.

Scatter Compound Object

Select an object. > Create panel > Geometry > Compound Objects > Object Type rollout > Scatter

Select an object. > Create menu > Compound > Scatter

Scatter is a form of compound object that randomly scatters the selected source object either as an array, or over the surface of a distribution object.
The plane of the hill is used to scatter the trees and two different sets of rocks.

Procedures

To create a Scatter object:

1. Create an object to be used as a source object.
2. Optionally, create an object to be used as a distribution object.
3. Select the source object, and then click Scatter in the Compound Objects panel.

**NOTE** The source object must be either a mesh object or an object that can be converted to a mesh object. If the currently selected object is invalid, the Scatter button is unavailable.
Results of scattering source object with distribution object visible (above) and hidden (below)

You now have two choices. You can either scatter the source object as an array without using a distribution object, or use a distribution object to scatter the object. See the following procedures.

To scatter the source object without a distribution object:

1. Choose Use Transforms Only in the Scatter Objects rollout > Distribution group.
2. Set the Duplicates spinner to specify the desired total number of duplicates of the source object.
3. Adjust the spinners on the Transforms rollout to set random transformation offsets of the source object.

To scatter the source object using a distribution object:

1. Make sure the source object is selected.
2 Choose the method by which you want to clone the distribution object (Reference, Copy, Move, or Instance.)

3 Click Pick Distribution Object, and then select the object you want to use as a distribution object.

4 Make sure that Use Distribution Object on the Scatter Object rollout is chosen.

5 Use the Duplicates spinner to specify the number of duplicates. (This is not necessary if you're using the All Vertices, All Edge Midpoints or All Face Centers distribution methods.)

6 Choose a distribution method in the Scatter Object rollout > Distribute Object Parameters group under Distribute Using.

7 Optionally, adjust the Transform spinners to randomly transform the duplicates.

8 If the display is too slow, or the meshes too complicated, consider choosing Proxy on the Display rollout or decreasing the percentage of displayed duplicates by reducing the Display percentage.

Most of the spinner values are animatable, so you can animate things like the number of duplicates, their transformations, and so on.
Scatter objects (the grass) with a high number of duplicates

Interface

Pick Distribution Object rollout

Contains the options for selecting a distribution object.

**Object** Displays the name of the distribution object selected with the Pick button.

**Pick Distribution Object** Click this button, then click an object in the scene to specify it as a distribution object.
Reference/Copy/Move/Instance Lets you specify how the distribution object is transferred to the scatter object. It can be transferred either as a reference on page 8699, a copy, an instance on page 8611, or moved, in which case the original shape is not left behind.

Scatter Objects rollout

The options on this rollout let you specify how the source object is scattered, and let you access the objects that make up the compound Scatter object.

Distribution group

These two options let you choose the basic method of scattering the source object.

Use Distribution Object Scatters the source object based on the geometry of the distribution object.

Use Transforms Only This options doesn't need a distribution object. Instead, duplicates of the source object are positioned using the offset values on the Transforms rollout. If all of the Transform offsets remain at 0, you won't see the array because the duplicates occupy the same space.
Objects group

Contains a list window showing the objects that make up the Scatter object.

List Window Click to select an object in the window so that you can access it in the Stack. For example, if your distribution object is a sphere, you can click Distribution: D_Sphere01, open the Stack list, and select Sphere to access the sphere’s parameters.

Source Name Lets you rename the source object within the compound Scatter object.

Distribution Name Lets you rename the distribution object.

Extract Operand Extract a copy or an instance of the selected operand. Choose an operand in the list window to enable this button.

NOTE This button is available only on the Modify panel. You can’t extract an operand while the Create panel is active.

Instance/Copy This option lets you specify how the operand is extracted: as either an instance or a copy.

Source Object Parameters group

These options affect the source object locally.

Duplicates Specifies the number of scattered duplicates of the source object. This number is set to 1 by default, but you can set it to 0 if you want to animate the number of duplicates, beginning with none. Note that the Duplicates number is ignored if you’re distributing the duplicates using either Face Centers or Vertices. In these cases, one duplicate is placed at each vertex or face center, depending on your choice.
**Base Scale** Alters the scale of the source object, affecting each duplicate identically. This scale occurs before any other transforms.

**Vertex Chaos** Applies a random perturbation to the vertices of the source object.

**Animation Offset** Lets you specify the number of frames by which each source object duplicate’s animation is offset from the previous duplicate. You can use this feature to produce wave-type animation. At the default setting of 0, all duplicates move identically.

**Distribution Object Parameters group**

These options affect how the duplicates of the source object are arranged, relative to the distribution object. These options have an effect only when a distribution object is used.

**Perpendicular** When on, orients each duplicate object perpendicular to its associate face, vertex, or edge in the distribution object. When off, the duplicates maintain the same orientation as the original source object.

**Use Selected Faces Only** When on, limits distribution to the selected faces passed up the Stack. Perhaps the easiest way to do this is to use the Instance option when picking the distribution object. You can then apply a Mesh Select modifier to the original object and select only those faces you want to use for the distribution of the duplicates.
Distribute Using

The following options let you specify how the geometry of the distribution object determines the distribution of the source object. These options are ignored if you're not using a distribution object.

**Area** Distributes duplicate objects evenly over the total surface area of the distribution object.

**Even** Divides the number of faces in the distribution object by the number of duplicates, and skips the appropriate number of faces in the distribution object when placing duplicates.

**Skip N** Skips N number of faces when placing duplicates. The editable field specifies how many faces to skip before placing the next duplicate. When set to 0, no faces are skipped. When set to 1, every other face is skipped, and so on.

**Random Faces** Applies duplicates randomly over the surface of the distribution object.

**Along Edges** Assigns duplicates randomly to the edges of the distribution object.
All Vertices Places a duplicate object at each vertex in the distribution object. The Duplicates value is ignored.

All Edge Midpoints Places a duplicate at the midpoint of each segment edge.

All Face Centers Places a duplicate object at the center of each triangular face on the distribution object. The Duplicates value is ignored.

Volume Scatters objects throughout the distribution object’s volume. All other options restrict distribution to the surface. Consider turning on Display rollout > Hide Distribution Object with this option.

Objects fill a spherical volume with Volume turned on

Display group

<table>
<thead>
<tr>
<th>Display:</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>✔ Result</td>
<td></td>
</tr>
<tr>
<td>□ Operands</td>
<td></td>
</tr>
</tbody>
</table>

Result/Operands Choose whether to display the results of the scatter operation or the operands before the scattering.
The settings in the Transforms rollout let you apply random transform offsets to each duplicate object. The values in the transform fields specify a maximum offset value that’s applied randomly with a positive or negative value to each duplicate. Thus, if you set a rotation angle of 15 degrees, duplicates are rotated randomly from -15 to +15 degrees. For example, one duplicate might be rotated 8 degrees, another -13, another 5, and so on. You can use the Transform...
settings with or without a distribution object. When there is no distribution object, you must adjust the Transform settings in order to see the duplicates.

**Rotation group**

Specifies random rotation offsets.

**X, Y, Z deg** Enter the maximum random rotational offset you want about the local X, Y, or Z axis of each duplicate.

**Use Maximum Range** When on, forces all three settings to match the maximum value. The other two settings become disabled, and the setting containing the maximum value remains enabled.

**Local Translation group**

Specifies translation of the duplicates along their local axes.

**X, Y, Z** Enter the maximum random movement you want along the X, Y, or Z axis of each duplicate.

**Use Maximum Range** When on, forces all three settings to match the maximum value. The other two settings become disabled, and the setting containing the maximum value remains enabled.

**Translation on Face group**

Lets you specify the translation of duplicates along barycentric on page 8517 face coordinates of the associate face in the distribution object. These settings have no effect if you're not using a distribution object.

**A, B, N** The first two settings specify the barycentric coordinates on the surface of the face, while the N setting sets the offset along the normal of the face.

**Use Maximum Range** When on, forces all three settings to match the maximum value. The other two settings become disabled, and the setting containing the maximum value remains enabled.

**Scaling group**

Lets you specify the scaling of duplicates along their local axes.

**X, Y, Z %** Specifies the percent of random scaling along the X, Y, or Z axis of each duplicate.
Use **Maximum Range** When on, forces all three settings to match the maximum value. The other two settings become disabled, and the one containing the maximum value remains enabled.

Lock **Aspect Ratio** When on, maintains the original aspect ratio of the source object. Typically, this provides uniform scaling of duplicates. When Lock Aspect Ratio is off, and any of the X, Y, and Z settings contain values greater than 0, the result is non-uniform scaling of duplicates because the values represent random scaling offsets in both positive and negative directions.

**Display rollout**

Provides options that affect the display of the Scatter object.

**Display Options group**

These options affect the display of the source and destination objects.

**Proxy** Displays the source duplicates as simple wedges and speeds up viewport redraws when manipulating a complex Scatter object. This has no effect on the rendered image, which always displays the mesh duplicates.

**Mesh** Displays the full geometry of the duplicates.

**Display %** Specifies the percentage of the total duplicate objects that appear in the viewports. This has no effect on the rendered scene.

**Hide Distribution Object** Hides the distribution object. The hidden object does not appear in the viewport or in the rendered scene.
**Uniqueness group**

Lets you set a seed number upon which the random values are based. Thus, altering this value changes the overall effect of the scattering.

**New** Generates a new, random seed number.

**Seed** Use this spinner to set the seed number.

**Load/Save Presets rollout**

Let you store preset values to use in other Scatter objects. For example, after setting all of your parameters for a specific Scatter object and saving the settings under a specific name, you can then select another Scatter object and load the preset values into the new object.

**Preset Name** Lets you define a name for your settings. Click the Save button to save the current settings under the preset name.

**Saved Presets group**

A list window containing saved preset names.

**LOAD** Loads the preset currently highlighted in the Saved Presets list.
SAVE Saves the current name in the Preset Name field and places it in the Saved Presets window.

DELETE Deletes the selected items in the Save Presets window.

NOTE Animated parameter values subsequent to frame 0 are not stored.

Conform Compound Object

Select an object. > Create panel> Geometry > Compound Objects > Object Type rollout > Conform

Select an object. > Create menu > Compound > Conform

Conform is a compound object created by projecting the vertices of one object, called the Wrapper, onto the surface of another object, called the Wrap-To. There is also a space-warp version of this function; see Conform space warp on page 2987.

Conform fits the road to the surface of the hills.
Because the space-warp version is somewhat easier to use, it's a good idea to read that topic first, try the example, and then return here. This topic provides additional methods of projecting the wrapper vertices.

**NOTE** This tool gives you the ability to morph between any two objects, regardless of the number of vertices in each object. See **Vertex Projection Direction group** on page 692 for more information.

### Procedures

**Example: To create a Conform object:**

1. Position two objects, one of which will be the Wrapper, and the other the Wrap-To. (For this example, create a box as the Wrap-To object, and then create a larger sphere that completely surrounds it. The sphere will be the Wrapper.)

2. Select the Wrapper object (the sphere), and click Create panel > Geometry > Compound Objects > Object Type rollout > Conform button.

   **NOTE** Both objects used in Conform must be either mesh objects or objects that can be converted to mesh objects. If the selected Wrapper object is invalid, the Conform button is unavailable.

3. Specify the method of vertex projection in the Vertex Projection Direction group. (Use Along Vertex Normals for this example.)

   **NOTE** If you were to choose Use Active Viewport, you would next activate whichever viewport looks in the direction that you want to project the vertices. For example, if the Wrapper hovered over a Wrap-To terrain on the home plane, you’d activate the Top viewport.

4. Choose Reference, Copy, Move, or Instance to specify the type of cloning to perform on the Wrap-To object. (Choose Instance for this example.)

5. Click Pick Wrap-To Object, and then click the object onto which to project the vertices. (You can press the H key and use the Pick Object dialog on page 206 to select the box.)

   The list windows display the two objects, and the compound object is created with the Wrapper object conforming to the Wrap-To object. (In the example, the sphere is wrapped into the shape of the box.)

6. Use the various parameters and settings to alter the vertex projection direction, or adjust the vertices that are being projected.
To project a road onto terrain:

1. Create the road and terrain objects.

   **TIP** You can quickly make a terrain by creating a patch grid on page 2408 and applying the Noise modifier on page 1544 to it. For the road, you can use a Loft compound object on page 742 by lofting a rectangle along a curved line. Both objects must have a sufficient level of detail to conform smoothly.

2. Orient both the road and the terrain so you are looking straight down at them in the Top viewport. Position the road so it's completely above the terrain (higher on the world Z axis).

   **NOTE** For the conform projection to work correctly, the road should not extend beyond the boundaries of the terrain when viewed in the Top viewport.

3. Select the road object.

4. Click Conform.

5. In the Pick Wrap-To Object rollout, make sure the Instance option is selected.

6. Click Pick Wrap-To Object, and click the terrain.

   An instance of the terrain object is created, with the same object color as the road.

7. Activate the Top viewport. In the Parameters rollout > Vertex Projection Direction group, choose Use Active Viewport, and click Recalculate Projection.

8. In the Update group, turn on Hide Wrap-To Object.

   This hides the instance of the terrain so you can clearly see the road projected onto it.

   The Parameters rollout > Wrapper Parameters group > Standoff Distance value sets the number of units by which the road sits above the terrain along the world Z axis.

9. If necessary, adjust the Standoff Distance to raise or lower the road.
Interface

Pick Wrap-To Object rollout

Object Displays the name of the selected Wrap-To object.

Pick Wrap-To Object Click this button, and then select the object to which you want the current object to wrap.

Reference/Copy/Move/Instance This option lets you specify how the Wrap-To object is transferred to the Conform object. It can be transferred either as a reference on page 8699, a copy, an instance on page 8611, or it can be moved, in which case the original is not left behind.

Parameters rollout

Contains all parameters for the Conform object.

Objects group

Provides a list window and two edit fields that let you navigate the compound object and rename its components.
**List Window** Lists the Wrapper and the Wrap-To objects. Click to select an object in the window so that you can access it in the Modifier stack.

**Wrapper Name** Lets you rename the wrapper object within the compound Conform object.

**Wrap-To Object Name** Lets you rename the Wrap-To object.

**Vertex Projection Direction group**

Choose one of these seven options to determine the projection of the vertices.

- **Use Active Viewport** The vertices are projected away (inward) from the active viewport.

- **Recalculate Projection** Recalculates the projection direction for the currently active viewport. Because the direction is initially assigned when you pick the Wrap-To object, if you want to change viewports after assignment, click this button to recalculate the direction based on the new active viewport.

- **Use Any Object's Z Axis** Lets you use the local Z axis of any object in the scene as a direction. Once an object is assigned, you can alter the direction of vertex projection by rotating the direction object.

- **Pick Z-Axis Object** Click this button, and then click the object you want to use to indicate the direction of the projection source.
Object Displays the name of the direction object.

- **Along Vertex Normals** Projects the vertices of the Wrapper object inward along the reverse direction of its vertex normals. A vertex normal is a vector produced by averaging the normals of all faces attached to that vertex. If the Wrapper object encloses the Wrap-To object, the Wrapper takes on the form of the Wrap-To object.

- **Towards Wrapper Center** Projects the vertices toward the bounding center of the Wrapper object.

- **Towards Wrapper Pivot** Projects the vertices toward the original pivot center of the Wrapper object.

- **Towards Wrap-To Center** Projects the vertices toward the bounding center of the Wrap-To object.

- **Towards the Wrap-To Pivot** Projects the vertices toward the pivot center of the Wrap-To object.

**NOTE** Towards Wrapper Pivot and Towards the Wrap-To Pivot operate on the position of the original pivot point of the object before the Conform object is created. Once you create the Conform object, it's a new compound object with a single pivot point.

**TIP** You can animate the conforming effect by morphing between the compound object and a previously made copy of the original wrapper object. To do this, however, you must turn on Hide Wrap-To Object in the Update group so that the original object and the compound object have the same number of vertices. Using this technique, you can effectively morph between two objects with a different number of vertices.

**Wrapper Parameters group**

![Wrapper Parameters](image-url)
Provides controls that determine how far the vertices are projected.

**Default Projection Distance** The distance a vertex in the Wrapper object will move from its original location if it does not intersect the Wrap-To object.

**Standoff Distance** The distance maintained between the vertex of the Wrapper object and the surface of the Wrap-To object. For example, if you set Standoff Distance to 5, the vertices can be pushed no closer than 5 units from the surface of the Wrap-To object.

**Use Selected Vertices** When turned on, only the selected vertex sub-objects of the Wrapper object are pushed. When turned off, all vertices in the object are pushed, regardless of the Modifier stack selection. To access the Modifier stack of the Wrapper object, select the Wrapper object in the list window, open the Modifier stack, and select the base object name. At this point you can apply a Mesh Select modifier, for example, and select the vertices you want to affect.

**Update group**

The items in this group determine when the projection for the compound object is recalculated. Because complex compound objects can slow performance, you can use these options to avoid constant calculation.

- **Always** The object is updated constantly.
- **When Rendering** The object is recalculated only when the scene is rendered.
- **Manually** Activates the Update button for manual recalculation.

**Update** Recalculates the projection.

**Hide Wrap-To Object** When on, hides the Wrap-To object.
Display group

Determines whether the shape operands are displayed.

- **Result**  Displays the result of the operation.
- **Operands**  Displays the operands.

**Connect Compound Object**

Select an object. > Create panel > Geometry > Compound Objects > Object
Type rollout > Connect

Select an object. > Create menu > Compound > Connect

The Connect compound object lets you connect two or more objects between "holes" in their surfaces. To do this, you delete faces in each object to create one or more holes in their surfaces, position them so that the holes face one another, and then apply Connect.
**NOTE** Connect is not suited to NURBS objects, because they convert into many separate meshes instead of one big mesh. The workaround is simple: apply a Weld modifier to the NURBS object (thus converting it to a mesh and zipping up its seams) before using it as part of a connect.

Connect generates the best mapping coordinates it can for the bridges between the various holes in the meshes. While some ideal cases, such as a cylinder above another cylinder, can generate good UVW map interpolations, most cases cannot. You’ll need to apply mapping to the bridge faces with a UVW Map modifier on page 1932.

Vertex colors, on the other hand, interpolate smoothly.

**Notes:**

- You can use Connect on objects that have multiple sets of holes. Connect will do its best to match up the holes between the two objects.

- The mapping coordinates assigned to the original two objects are maintained to the extent possible. You might find irregularities in the
bridged area, depending on the complexity and difference between the two original sets of mapping coordinates and the types of geometry.

**Procedures**

To create a Connect object:

1. Create two mesh objects.
2. Delete faces on each to create holes where you want to bridge the objects. Position the objects so that the normals of the deleted faces of one object point toward the normals of the deleted faces of the other object (assuming that deleted faces could have normals).
3. Select one of the objects. On the Create panel > Geometry > Compound Object Type rollout, click Connect.
4. Click the Pick Operand button, and then select the other object.
5. Faces are generated connecting the holes in the two objects.
6. Adjust the connection with the various options.

**Example: To connect two cylinders:**

1. Create a cylinder with a radius of 15 and a height of 30. Use the default settings for the remaining parameters.
2. Create a second cylinder centered on the first with a radius of 30, a height of 30, and 13 sides. (The fewer sides are to demonstrate the mesh interpolation in the connection.)
3. Move the first, narrower cylinder straight up along Z so its bottom cap is about 15 units above the top cap of the larger cylinder.
4. Convert both cylinders to editable meshes.
5. Delete the lower cap of the upper cylinder, and the upper cap of the bottom cylinder. (Hint: Go to Editable Mesh (Polygon) mode, select each end in turn, and then press the Delete key.)
6. Exit sub-object mode, select the lower cylinder, and click Connect.
7. Click the Pick Operand button, and then click the upper cylinder. New faces are created that span the openings in the two cylinders.
Example continued: To try out some options and create animation:

1. Go to the Modify panel and increase the Segments spinner to 5 or more. As the segments increase, the connection becomes curved.
2. Set the Tension spinner to 0 to straighten the connecting surface, increase it to 1, and then return it to 0.5.
3. Try different combinations of the Bridge and Ends options.
4. Select the upper cylinder, turn on the Auto Key button, and apply various transforms at different frames.
5. Play the animation.

Interface

Pick Operand rollout

Pick Operand Click this button to connect an additional operand to the original object.
For example, you might begin with a single object with two holes, and arrange two additional objects, each with one hole, outside of those holes. Click the Pick Operand button and select one of the objects, which is connected, and then click Pick Operand again and select the other object, which is connected. Both connected objects are added to the Operands list.

Reference/Copy/Move/Instance Lets you specify how the operand is transferred to the compound object. It can be transferred either as a reference on page 8699, a copy, an instance on page 8611, or moved, in which case the original is not left behind.

NOTE Connect works only with objects that are capable of being converted into editable surfaces, such as editable meshes on page 2192.
Parameters rollout

Operands group

Operands list Displays the current operands. Select an operand to rename, delete or extract by clicking it in this list.

Name Renames a selected operand. Type in a new name, and then press Tab or Enter.

Delete Operand Deletes a selected operand from the list.

Extract Operand Extracts a copy or an instance of the selected operand. Choose an operand in the list to enable this button.

NOTE This button is available only in the Modify panel. You can't extract an operand while in the Create panel.

Instance/Copy Lets you specify how the operand is extracted: as either an instance or a copy.

Connect Compound Object | 699
Interpolation group

**Segments** Sets the number of segments in the connecting bridge.

**Tension** Controls the curvature in the connecting bridge. A value of 0 provides no curvature, while higher values create curves that attempt to more smoothly match the surface normals on either end of the connecting bridge. This spinner has no apparent effect when Segments is set to 0.

Smoothing group

**Bridge** Applies smoothing between the faces in the connecting bridge.

**Ends** Applies smoothing between the faces that border the old and new surfaces of the connecting bridge and the original objects. When turned off, 3ds Max assigns a new material ID number to the bridge. The new number is one higher than the highest ID number assigned to either of the original objects. When on, the ID number is taken from one of the original objects.

**NOTE** If both Bridge and Ends are on, but the original objects contain no smoothing groups, then smoothing is assigned to the bridge and to the faces bordering the bridge.

Display/Update rollout

Display group

Determines whether the shape operands are displayed.

- **Result** Displays the result of the operation.
Operands
Displays the operands.

Update group
These options determine when the projection for the compound object is recalculated. Because complex compound objects can slow performance, you can use these options to avoid constant calculation.

- **Always**  The object is updated constantly.
- **When Rendering**  The object is recalculated only when the scene is rendered.
- **Manually**  Activates the Update button for manual recalculation.

Update  Recalculates the projection.

BlobMesh Compound Object

Create panel > Geometry > Compound Objects > Object Type rollout > BlobMesh
Create menu > Compound > BlobMesh

The BlobMesh compound object creates a set of spheres from geometry or particles, and connects the spheres together as if they were made of a soft, liquid substance. When the spheres move within a certain distance of one another, they connect together. When they move apart, they take on a spherical form again.
In the 3D industry, the general term for spheres that operate in this way is metaballs on page 8638. The BlobMesh compound object generates metaballs based on specified objects in the scene, and the metaballs, in turn, form a mesh result called a blobmesh. A blobmesh is ideal for simulating thick liquids and soft substances that move and flow when animated.

When you associate an object or particle system with the BlobMesh compound object, the metaballs are placed and sized differently depending on the object used to generate them:

- For geometry and shapes, a metaball is placed at each vertex, and the size of each metaball is determined by the size of the original BlobMesh object. Soft selection can be used to vary the sizes of the metaballs.
- For particles, a metaball is placed at each particle, and the size of each metaball is determined by the size of the particle on which it's based.
For helpers, a metaball is placed at the pivot point, and the size of the metaball is determined by the original BlobMesh object.

**NOTE** You can apply motion blur on page 8644 to a BlobMesh object to enhance the effects of motion in renderings. For particle systems other than Particle Flow, use Image motion blur. For Particle Flow particle systems and all other types of objects including geometry, shapes, and helpers, use Object motion blur.

### Procedures

**To create a blobmesh from geometry or helpers:**

1. Create one or more geometry or helper objects. If the scene requires animation, animate the objects as desired.

2. Click BlobMesh, and click anywhere on the screen to create the initial metaball.

3. Go to the Modify panel.

4. In the Blob Objects group, click Add. Select the objects you wish to use to create metaballs. A metaball appears at each vertex of each selected object, or at the centers of helper objects.

5. In the Parameters rollout, set the Size parameter as necessary to cause the metaballs to connect.

**To create a blobmesh with soft selection on geometry:**

1. Create a geometry object, and convert it to an Editable Mesh or Editable Poly.

2. Apply a Mesh Select modifier to the object, and select some of the vertices on the object.

3. In the Soft Selection rollout, turn on Use Soft Selection. Set the Falloff value as desired.

4. Apply a Turn to Mesh or Turn to Poly modifier to the object. This will retain the soft selection and pass it up the stack regardless of whether you exit the sub-object mode.

5. Click Create panel > Compound Objects > BlobMesh, and click anywhere on the screen to create the initial metaball.

6. Go to the Modify panel.
In the Blob Objects group, click Add. Select the Editable Mesh or Editable Poly object. A metaball appears at each vertex of the selected object.

In the Parameters rollout, turn on Use Soft Selection. Metaballs are limited to those vertices that are affected by the soft selection.

Set the Size and Min. Size parameters to set the sizes of the metaballs.

To create a blobmesh with soft selection on a spline:

1. Create the spline, and convert it to an Editable Spline.
2. In the Rendering rollout, turn on both Enable In Renderer and Enable In Viewport.
3. Apply a Mesh Select modifier, and select the appropriate vertices for soft selection.
4. In the Soft Selection rollout, turn on Use Soft Selection. Set the Falloff value as desired.
5. Apply a Turn to Mesh or Turn to Poly modifier to the object.
   This will retain the soft selection and pass it up the stack regardless of whether you exit the sub-object mode.
6. Click Create panel > Compound Objects > BlobMesh, and click anywhere on the screen to create the initial metaball.
7. Go to the Modify panel.
8. In the Blob Objects group, click Add. Select the Editable Spline. A metaball appears at each vertex of the selected object.
9. In the Parameters rollout, turn on Use Soft Selection. Metaballs are limited to those vertices that are affected by the soft selection.
10. Set the Size and Min. Size parameters to set the sizes of the metaballs.
To create a blobmesh from a particle system:

When you use BlobMesh with a particle system, a metaball is created at each particle's location. The size of the metaball is determined by the size of the particle.

1. Create a particle system on page 2997, and set up its parameters to animate the particles.

2. Click Create panel > Compound Objects > BlobMesh, and click anywhere on the screen to create the initial metaball.

3. Go to the Modify panel.

4. In the Blob Objects group, click Add. Select the particle system. A metaball appears at each particle in the system.

5. If you have added a Particle Flow system on page 2997 to the blobmesh and you want to create metaballs only for particles in specific events, click Add on the Particle Flow Parameters rollout to choose the events from a list.

**TIP** If you need to prevent the particles from rendering, do not hide them as this can prevent the blobmesh from generating correctly. Instead, turn off the particle system's Renderable option on the Object Properties dialog on page 283.
Interface

Parameters rollout

Size The radius of each metaball for objects other than particles. For particles, the size of each metaball is determined by the size of the particle, which is set by parameters in the particle system. Default=20.
NOTE The apparent size of the metaballs is affected by the Tension value. When Tension is set to its lowest possible value, the radius of each metaball accurately reflects the Size setting. Higher Tension values will tighten the surface, and make the metaballs smaller.

**Tension** Determines how relaxed or tight the surface will be. A smaller value makes a looser surface. This value can range from 0.01 to 1.0. Default=1.0.

**Evaluation Coarseness** Sets the coarseness, or density, of the resulting blobmesh. When Relative Coarseness (see following) is off, the Render and Viewport values set the absolute height and width of blobmesh faces, and lower values create a smoother, denser mesh. When Relative Coarseness is on, the height and width of blobmesh faces is determined by the ratio of metaball size to this value. In this case, higher values create a denser mesh. Range (both)=0.001 to 1000.0. Render default=3.0, Viewport default =6.0.

The lower end of the range for both Coarseness settings is 0.001, which allows for high-resolution metaball geometry when Relative Coarseness is off. Using such low values can also cause lengthy calculation delays; if this happens and you wish to halt calculation, press Esc.

**Relative Coarseness** Determines how the coarseness values will be used. If this option is turned off, the Render Coarseness and View Coarseness values are absolute, where the height and width of each face on the blobmesh is always equal to the coarseness value. This means the faces on the blobmesh will retain a fixed size even if the metaballs change size. If this option is turned on, the size of each blobmesh face is based on the ratio of the metaball size to the coarseness, which will cause the blobmesh face size to change as the metaballs become larger or smaller. Default=Off.

**Large Data Optimization** This option provides an alternate method for calculating and displaying the blobmesh. This method is more efficient than the default method only when a large number of metaballs are present, such as 2,000 or more. Turn on this option only when using a particle system or other object that produces a large number of metaballs. Default=Off.

**Off in Viewport** Turns off the display of the blobmesh in viewports. The blobmesh will still appearing in renderings. Default=Off.

**Use Soft Selection** If soft selection has been used on geometry you add to the blobmesh, turning on this option causes the soft selection to be used for the size and placement of metaballs. Metaballs are placed at selected vertices with the size set by the Size parameter. For vertices that lie within the falloff set on the geometry’s Soft Selection rollout, smaller metaballs are placed. For vertices outside the falloff, no metaballs are placed. This option has an effect only if the Vertex sub-object level for the geometry is still enabled, and Use Soft
Selection on the geometry’s Soft Selection rollout is turned on. If Use Soft Selection is turned off either for the blobmesh for the geometry, metaballs are placed at all vertices on the geometry. Default=Off.

**Min Size** Sets the minimum size for metaballs within the falloff when Use Soft Selection is turned on. Default=10.0.

**Pick** Allows you to pick objects or particle systems from the screen to add to the blobmesh.

**Add** Displays a selection dialog where you can select objects or particle systems to add to the blobmesh.

**Remove** Removes objects or particles from the blobmesh.

**Particle Flow Parameters rollout**

Use this rollout if you have added a Particle Flow system to the blobmesh, and want particles to generate metaballs only during specific events. Before you can specify events on this rollout, you must add the Particle Flow system to the blobmesh on the Parameters rollout.

**All Particle Flow Events** When turned on, all Particle Flow Events will generate metaballs. When turned off, only Particle Flow Events specified in the PFlow Events list will generate metaballs.
**Add** Displays a list of PFlow events in the scene so you can pick events to add to the PFlow Events list.

**Remove** Removes the selected event from the PFlow Events list.

---

**ShapeMerge Compound Object**

Select an object. > Create panel > Geometry > Compound Objects > Object Type rollout > ShapeMerge

Select an object. > Create menu > Compound > ShapeMerge

ShapeMerge creates a compound object consisting of a mesh object and one or more shapes. The shapes are either embedded in the mesh, altering the edge and face patterns, or subtracted from the mesh.

ShapeMerge combines the lettering, a text shape, with the mesh that models the tire.
Procedures

To create a ShapeMerge object:

1. Create a mesh object and one or more shapes
2. Align the shapes in the viewport so they can be projected toward the surface of the mesh object.
3. Select the mesh object, and click the ShapeMerge button.
4. Click Pick Shape, and then select the shape.

The geometry of the surface of the mesh object is altered to embed a pattern matching that of the selected shape.

Interface

Pick Operand rollout

Pick Shape Click this button, and then click the shape you want to embed in the mesh object. The shape is projected onto the mesh object in the direction of the shape's local negative Z axis. For example, if you create a box, and then create a shape in the Top viewport, the shape is projected onto the top of the box. You can repeat this process to add shapes, and the shapes can be projected in different directions. Simply click Pick Shape again, and then pick another shape.

Reference/Copy/Move/Instance Lets you specify how the shape is transferred to the compound object. It can be transferred either as a reference on page 8699, a copy, an instance on page 8611, or moved, in which case the original shape is not left behind.
Parameters rollout

Operands group

**Operands list** Lists all operands in the compound object. The first operand is the mesh object, and any number of shape-based operands can follow.

**Delete Shape** Remove selected shapes from the compound object.

**Extract Operand** Extracts a copy or an instance of the selected operand. Choose an operand in the list window to enable this button.

**Instance/Copy** Lets you specify how the operand is extracted. It can be extracted either as an instance on page 8611 or a copy.

Operation group

These options determine how the shape is applied to the mesh.
Cookie Cutter Cuts the shape out of the mesh object's surface.

Merge Merges the shape with the surface of the mesh object.

Invert Reverses the effect of Cookie Cutter or Merge. With the Cookie Cutter option, the effect is obvious. When Invert is off, the shape is a hole in the mesh object. When Invert is on, the shape is solid and the mesh is missing. When you're using Merge, Invert reverses the sub-object mesh selection. As an example, if you merge a circle shape and apply a Face Extrude, the circular area is extruded when Invert is off, and all but the circular area is extruded when Invert is on.

Output Sub-Mesh Selection group

Provides options that let you specify what selection level is passed up the Stack. The ShapeMerge object stores all selection levels; that is, it stores the vertices, faces, and edges of the merged shape with the object. (If you apply a Mesh Select modifier and go to the various sub-object levels, you'll see that the merged shape is selected.) Thus, if you follow the ShapeMerge with a modifier that acts on a specific level, such as Face Extrude, that modifier will work properly.

If you apply a modifier that can work on any selection level, such as Volume Select or XForm, the options will specify which selection level is passed to that modifier. Although you can use a Mesh Select modifier on page 1500 to specify a selection level, the Mesh Select modifier considers the selection only at frame 0. If you've animated the shape operand, that animation will be passed up the Stack for all frames only by using the Output Sub-Mesh Selection options.

- None Outputs the full object.
- Face Outputs the faces within the merged shape.
- Edge Outputs the edge of the merged shape.
- Vertex Outputs the vertices defined by the spline of the shape.
Display/Update rollout

Display group

Determines whether the shape operands are displayed.

- **Result**  Displays the result of the operation.
- **Operands**  Displays the operands.

Update group

These options specify when the display is updated. Typically, you use them when you've animated the merged shape operands and the viewport display is slow.

- **Always**  Updates the display at all times.
- **When Rendering**  Updates the display only when the scene is rendered.
- **Manually**  Updates the display only when you click the Update button.

**Update** Updates the display when any option except Always is chosen.

Boolean Compound Object

Select an object. > Create panel > Geometry > Compound Objects > Object Type rollout > Boolean
Select an object. > Create menu > Compound > Boolean
A Boolean object combines two other objects by performing a Boolean operation on them.

**TIP**  ProBoolean on page 799 is an improved, up-to-date, and more-complete implementation of the Boolean compound object. In general, it is recommended that you use ProBoolean rather than Boolean for combining 3D objects.

These are the Boolean operations for geometry:

**Union**  The Boolean object contains the volumes of both original objects. The intersecting or overlapping portion of the geometry is removed.

**Intersection**  The Boolean object contains only the volume common to both original objects (in other words, where they overlapped).

**Subtraction (or difference)**  The Boolean object contains the volume of one original object with the intersecting volume removed.

The two original objects are designated operands A and B.

You can layer Booleans in the stack display, so that a single object can incorporate many Booleans. By navigating through the stack display, it's possible to revisit the components of each Boolean and make changes to them.
Subtraction: A-B (above); B-A (below)
Booleans with Objects That Have Materials Assigned to Them

Most primitives use several material IDs on page 8633 on their surfaces. For example, a box uses material IDs 1–6 on its sides. If you assign a Multi/Sub-Object material on page 6120 with six sub-materials, 3ds Max automatically assigns one to each side. If you assign a Multi/Sub-Object material with two sub-materials, 3ds Max assigns the first material to sides 1, 3, and 5, and the second to sides 2, 4, and 6.

When you create a Boolean from objects that have materials assigned to them, 3ds Max combines the materials in the following way:

- If operand A doesn't have a material, it inherits operand B's material.
- If operand B doesn't have a material, it inherits operand A's material.
- If both operands have materials, the resulting material is a Multi/Sub-Object material that combines the materials from both operands.

For more information, see Material Attach Options Dialog on page 728.

Solutions When Working with Booleans

The Boolean algorithm caused unpredictable behavior in earlier releases. The solutions are discussed here.
Surface Topology

Boolean requires that operands' surface topology be intact: This means no missing or overlapping faces and no unwelded vertices. The surface should be one continuous closed surface.

The Boolean corrects operands that fail to meet this requirement. However, the automatic correction may not be exactly what you want, so in some cases it might be safer to correct the surfaces manually.

To check for holes in the geometry, use the STL-Check modifier on page 1746 or the Measure utility on page 2882.

To fill holes, use the Cap Holes modifier on page 1185.

Face Normals

Booleans require that the face normals of the surface be consistent. Flipped normals can produce unexpected results. Surfaces where some faces are facing one way and adjacent faces are flipped are also problematic, and are commonly found in geometry imported from CAD programs. The Boolean fixes these faces as best it can. Again, it might make more sense to correct these manually.

Use shaded viewports to look for normal problems, watching for objects that appear inside-out or look otherwise incorrect. You can also turn on Show in the Editable Mesh (Face) on page 2216 > Surface Properties rollout > Normals group. Fix normals here, or with a Normal modifier on page 1551.

Overlapping Elements

Because Boolean operations depend on a clear understanding of what is inside and what is outside a mesh, meshes that overlap themselves can produce invalid results. For instance, if you use the Collapse utility on page 2022 with two overlapping objects without turning on the Boolean feature, the resulting object will not make a good Boolean operand. This is also a problem for the Teapot primitive on page 416 (with all parts turned on), which overlaps itself.

If you need to use such an object as a Boolean operand, you might reconstruct it as a single non-overlapping mesh by separating the components and combining them with Boolean.

Working with Inverted Meshes

Boolean doesn't always produce the ideal result on "inverted meshes" (meshes that have been turned inside-out by having their normals flipped). The problem is that the area inside the flipped mesh is correctly seen as "outside," but the
area outside it may also be seen as “outside.” To remedy this, instead of inverting the mesh, make a very large box or other primitive centered on (but not touching) the mesh and subtract the mesh from it using Boolean. Then convert it to an editable mesh, and delete the box faces. This produces a correctly inverted mesh that works correctly with Boolean.

Alignment

If two Boolean operands are perfectly aligned without actually intersecting, the Boolean operation might produce the wrong result. Although this is rare, if it does occur, you can eliminate it by making the operands overlap slightly.

Relative Complexity Between Operands

Boolean works best when the two operands are of similar complexity. If you wish to subtract text (a complex object made of many faces and vertices) from a box without any segments, the result is many long, skinny faces that are prone to rendering errors. Increasing the number of box segments produces better results. Try to maintain a similar complexity between operands.

Coplanar Faces/Colinear Edges

Previously, Boolean required that objects overlap. If two objects did not overlap but merely touched an edge to an edge, or a face to a face, the Boolean would fail.

Boolean allows for non-overlapping objects. Coincident faces/edges and vertices are no longer a problem. You can use objects completely encased within another object, where no edges intersect, to create Booleans.

See also Collapse Utility on page 2022 to create Booleans with multiple objects.

See also:

- Fixing Boolean Problems on page 8463

Procedures

To create a Boolean object:

1. Select an object. This object becomes operand A.
2. Click Boolean. The name of operand A appears in the Operands list on the Parameters rollout.
3 On the Pick Boolean rollout, choose the copy method for operand B: Reference, Move, Copy, or Instance. (These methods are described in the Pick Boolean rollout section, later in this topic.)

4 On the Parameters rollout, choose the Boolean operation to perform: Union, Intersection, Subtraction (A-B), or Subtraction (B-A). You can also choose one of the Cut operations, described later in the Operation group section.

5 On the Pick Boolean rollout, click Pick Operand B.

6 Click in a viewport to select operand B. 3ds Max performs the Boolean operation.

The operand objects remain as sub-objects of the Boolean object. By modifying the creation parameters of the Boolean's operand sub-objects, you can later change operand geometry in order to change or animate the Boolean result.

Example: To create and modify a single object that contains multiple Boolean:

Suppose you want to create a box with two holes in it. One hole is to be cut by a sphere, and the second by a cylinder. If you want to make changes to the sphere or the cylinder later, you can do so by following these steps:

1 Create a Boolean following the steps in the previous sections. The original object (the box) is converted to a Boolean, and is designated operand A. The second object (the sphere) is converted to operand B.

2 Deselect the Boolean object. Build the cylinder if it does not already exist.

3 Select the Boolean object; and under Compound Objects, click Boolean again.

4 Click Pick Operand B and click the cylinder in the viewport. It is converted to operand B.

5 On the Modify panel, choose Operand B from the Parameters rollout > Operands list. If you want to see operand B, choose Display/Update rollout > Display group > Operands or Result + Hidden Ops.

If you want to animate the Cylinder or the Cylinder's parameters you can now access them in the modifier stack display.

6 If you want to modify the sphere’s parameters, choose the box in the Operands list.

7 Now there are two entries labeled Boolean in the stack display. Choose the lower entry. The Sphere is displayed in the Operands list.
Choose the Sphere from the Operands list. The sphere’s parameters are available by clicking the sphere’s name in the modifier stack display.

Use this technique to change parameters or animate any of the operands within the multiple Boolean.

You can also navigate multiple Booleans through Track View. Clicking the operand in Track View gives you direct access to its entry in the modifier stack display. In complex objects with many Booleans, this is an easier method than the one outlined above.

Interface

Pick Boolean rollout

When you select operand B, you designate it as a Reference, Move (the object itself), Copy, or Instance, according to your choice in the Pick Boolean rollout for Boolean objects. Base your selection on how you want to use the scene geometry after you create the Boolean.

Because you usually create Boolean objects from overlapping objects, if the B object isn’t removed (if you don’t use the default Move option), it often obstructs your view of the completed Boolean. You can move the Boolean or the B object to better see the result.

Pick Operand B Use this button to select the second object to use to complete the Boolean operation.

Reference/Copy/Move/Instance Lets you specify how operand B is transferred to the Boolean object. It can be transferred either as a reference on page 8699, a copy, an instance on page 8611, or moved.

Use Reference to synchronize modifier-induced changes to the original object with operand B, but not vice-versa.

Use Copy when you want to reuse the operand B geometry for other purposes in the scene.
- Use Instance to synchronize animation of the Boolean object with animated changes to the original B object, and vice-versa.

- Use Move (the default) if you've created the operand B geometry only to create a Boolean, and have no other use for it. Object B geometry becomes part of the Boolean object regardless of which copy method you use.

**Parameters rollout**

**Operands group**

**Operands list field** Displays the current operands.

**Name** Edit this field to change the name of the operands. Choose an operand in the Operands list and it will also appear in the Name box.

**Extract Operand** Extracts a copy or an instance of the selected operand. Choose one of the operands in the list window to enable this button.
NOTE  This button is available only in the Modify panel. You can't extract an operand while the Create panel is active.

Instance/Copy  Lets you specify how the operand is extracted: as either an instance on page 8611 or a copy.

Operation group

Union  The Boolean object contains the volume of both original objects. The intersecting or overlapping portion of the geometry is removed.

Intersection  The Boolean object contains only the volume that was common to both original objects (in other words, where they overlapped).

Subtraction (A-B)  Subtracts the intersection volume of operand B from operand A. The Boolean object contains the volume of operand A with the intersection volume subtracted from it.

Subtraction (B-A)  Subtracts the intersection volume of operand A from operand B. The Boolean object contains the volume of operand B with the intersection volume subtracted from it.

Cut  Cuts operand A with operand B, but doesn't add anything to the mesh from operand B. This works like the Slice modifier on page 1727, but instead of using a planar gizmo, Cut uses the shape of operand B as the cutting plane. Cut treats the geometry of the Boolean object as volumes rather than closed solids. Cut does not add geometry from operand B to operand A. Operand B intersections define cut areas for altering geometry in operand A.

There are four types of Cut:

■  **Refine**  Adds new vertices and edges to operand A where operand B intersects the faces of operand A. 3ds Max refines the resulting geometry of operand A with additional faces inside the intersected area of operand B. Faces cut by the intersection are subdivided into new faces. You might use this option to refine a box with text so that you can assign a separate material ID to the object.

■  **Split**  Works like Refine but also adds a second or double set of vertices and edges along the boundary where operand B cuts operand A. Split produces two elements belonging to the same mesh. Use Split to break an object into two parts along the bounds of another object.

■  **Remove Inside**  Deletes all operand A faces inside operand B. This option modifies and deletes faces of operand A inside the area intersected by operand B. It works like the subtraction options, except that 3ds Max adds...
no faces from operand B. Use Remove Inside to delete specific areas from your geometry.

- **Remove Outside**  Deletes all operand A faces outside operand B. This option modifies and deletes faces of operand A outside the area intersected by operand B. It works like the Intersection option, except that 3ds Max adds no faces from operand B. Use Remove to delete specific areas from your geometry.

### Display/Update rollout

![Display/Update rollout](image)

**Display group**

Visualizing the result of a Boolean can be tricky, especially if you want to modify or animate it. The Display options on the Boolean Parameters rollout help you visualize how the Boolean is constructed.

The display controls have no effect until you've created the Boolean.

- **Result**  Displays the result of the Boolean operation; that is, the Boolean object itself.

- **Operands**  Displays the operands instead of the Boolean result.

  **TIP** When operands are difficult to see in a viewport, you can use the Operand list to select one or the other. Click the name of the A or B operand to select it.

- **Results + Hidden Ops**  Displays the "hidden" operands as wireframe.
Operand geometry remains part of the compound Boolean object, although it isn't visible or renderable. The operand geometry is displayed as wireframes in all viewports.
Displaying the result (A-B)
Displaying the hidden operand after A-B
Displaying the hidden operand after B-A

Update group

By default, Booleans are updated whenever you change the operands. A scene that contains one or more complicated, animated Booleans can impede performance. The update options provide alternate methods to improve performance.

■ **Always**  Updates Booleans immediately when you change an operand, including the original object of an instanced or referenced B operand. This is the default behavior.

■ **When Rendering**  Updates Booleans only when you render the scene or click Update. With this option, viewports don’t always show current geometry, but you can force an update when necessary.

■ **Manually**  Updates Booleans only when you click Update. With this option, the viewports and the render output don’t always show current geometry, but you can force an update when necessary.

**Update** Updates the Boolean. The Update button is not available when Always is selected.
Material Attach Options Dialog

Use objects with different materials assigned to them. > Create panel > Geometry > Compound Objects > Object Type rollout > Boolean > Pick Boolean rollout > Pick Operand B button > Select object in the viewport that is operand B.

When you use Boolean operations with objects that have been assigned different materials, 3ds Max displays the Material Attach Options dialog. This dialog offers five methods for handling the materials and the material IDs on page 8633 in the resultant Boolean object.

**NOTE** If operand A has no material, and operand B has a material assigned, the Boolean dialog lets you choose to inherit the material from operand B.

If operand A has a material assigned and operand B has no material assigned, the Boolean object automatically inherits materials from operand A.

**Procedures**

To create a Boolean from objects that match material IDs to material:

1. Create a Boolean on page 718 using at least one object that has a multi/sub-object material on page 6120 assigned to it.
2. On the Pick Boolean rollout, click Pick Operand B.
3. Click in a viewport and select the B operand. 3ds Max displays the Match Attach Options dialog.
4. Choose Match Material IDs to Material to complete the Boolean operation.
Match Material IDs to Material 3ds Max modifies the number of material IDs in the combined object to be no greater than the number of sub-materials assigned to the operands. For example, if you combine two boxes that have standard materials and each box is assigned six material IDs (the default), the resulting combined object has two operands with one material ID each, rather than the 12 that would result from using the Match Material to Material ID option. After you complete the operation, 3ds Max creates a new multi/sub-object material with two slots. 3ds Max assigns the sub-materials to the operands as they appeared before the operation. The number of resulting material IDs matches the number of materials between the original objects. You might use this option to reduce the number of material IDs.

Match Material to Material IDs Maintains the original material ID assignment in the operands by adjusting the number of sub-materials in the resultant multi/sub-object material. For example, if you combine two boxes, both assigned single materials, but with their default assignment of six material IDs, the result would be a multi/sub-object material with 12 slots (six containing instances of one box's material, and six containing instances of the other box's material). Use this option when it's important to maintain the original material ID assignments in your geometry. Also use this option when material IDs have been assigned, but materials have not been assigned.

NOTE To make the instanced sub-materials unique, select them in Track View, and click the Make Unique button on the Track View toolbar. You can also make them unique one at a time with the Make Unique button on page 5692 in the Material Editor.

Do Not Modify Mat IDs or Material If the number of material IDs in an object is greater than the number of sub-materials in its multi/sub-object material, then the resultant face-material assignment might be different after the Boolean operation.
Discard New Operand Material Discards the material assignment of operand B. 3ds Max assigns operand A's material to the Boolean object.

Discard Original Material Discards the material assignment of operand A. 3ds Max assigns operand B's material to the Boolean object.

NOTE A UVW Map modifier on page 1932 must be used with compound objects to apply mapping coordinates.

Terrain Compound Object

Select spline contours. > Create panel > Geometry > Compound Objects > Object Type rollout > Terrain
Select spline contours. > Create menu > Compound > Terrain

The Terrain button lets you produce terrain objects. 3ds Max generates these objects from contour line data.

To create Terrain, you select editable splines representing elevation contours and create a mesh surface over the contours. You can also create a "terraced" representation of the terrain object so that each level of contour data is a step, resembling traditional study models of land forms.
Using contours to build a terrain

Upper left: The contours
Upper right: The terrain object
Lower left: Terrain object used as the basis of a landscape

If you import an AutoCAD drawing file to use as contour data, 3ds Max names each object based on the AutoCAD object’s layer, color, or object type. A number is appended to each name. For example, an AutoCAD object on the layer BASE becomes an object named BASE.01. See Importing DWG Files on page 7666 for more information.

After you import or create the contour data, select the objects, and click the Terrain button, 3ds Max creates a new triangulated mesh object based on the contour data. The name of the first selected spline becomes the name of the terrain object. Other splines in the selection are treated according to the previously set Reference, Move, Copy, or Instance selection in the Pick Operand rollout, described below.

Keep in mind that the Terrain object can use any spline objects as operands, whether they are horizontal splines or not. Though the most common scenario is when sets of elevational contours are used to create terrain forms, it is possible to append or refine Terrain objects by using non-horizontal splines.
NOTE To ensure that 3ds Max imports polylines as splines, when you import an AutoCAD drawing file, turn off Import AutoCAD DWG File dialog > Geometry Options group > Cap Closed Entities.

Following are examples of uses of the Terrain feature:

- Visualizing the effects of grading plans in 3D.
- Maximizing views or sunlight by studying topographical undulation of land forms.
- Analyzing elevation changes by using color on the data.
- Adding buildings, landscaping, and roads to a terrain model to create virtual cities or communities.
- Viewing corridors and completing ridge analyses from particular locations on a site by adding cameras to the scene.

Procedures

To analyze elevation changes:

1. Import or create contour data.
2. Select the contour data, and click the Terrain button.
3. On the Color By Elevation rollout, enter elevation zone values between the maximum and minimum elevations in the Base Elev box. Click Add Zone after entering the value. 3ds Max displays the zones in the list under the Create Defaults button.
4. Click the Base Color swatch to change the color of each elevation zone. For example, you could use a deep blue for low elevations, a light blue for intermediate elevations, and perhaps greens for higher elevations.
5. Click Solid To Top of Zone to see the elevation changes in a striped effect.
6. Click Blend To Color Above to see the elevation changes blended.

Interface

Name and Color rollout

Displays the name of the terrain object. 3ds Max uses the name of one of the selected objects to name the terrain object.
**Pick Operand rollout**

- **Pick Operand** Adds splines to the terrain object. You might do this if you didn't select all the objects before generating the terrain object, or if some objects in the imported data weren't included in the terrain object. You can also use this option to add existing splines in the current scene to the terrain object.

- **Reference/Copy/Move/Instance** When you click Pick Operand, the copy method you designate determines how the operands are used. When Move is the method, the original contour data is moved from the scene and into the operands of the new terrain object. Copy, Reference, and Instance retain the original contour data in the scene and create copies, references or instances of the contour data as operands in the terrain object. This is similar to the copy method for **Boolean** on page 713.

- **Override** Allows you to select closed curves that override any other operand data within their interior. Within the area an Override operand encloses (as seen in plan), other curves and points of the mesh are disregarded and the elevation of the Override operand supersedes them. An Override operand is indicated in the operands list by a # after its name. Override is only effective on closed curves. If multiple override operands overlap, later overrides (higher operand numbers) take preference.
Parameters rollout

Operand list Displays the current operands. Each operand is listed as "Op" followed by a number and the name of the object that is being used as the operand. The operand name comprises layer, color, or object type name plus a numeric suffix.

Delete Operand Deletes a selected operand from the Operands list.

Operand list Displays the current operands. Each operand is listed as "Op" followed by a number and the name of the object that is being used as the operand. The operand name comprises layer, color, or object type name plus a numeric suffix.

Delete Operand Deletes a selected operand from the Operands list.
Form group

- **Graded Surface**  Creates a graded surface of the mesh over the contours.

Terrain created as a graded surface

- **Graded Solid**  Creates a graded surface with skirts around the sides and a bottom surface. This represents a solid that is visible from every direction.

- **Layered Solid**  Creates a "wedding cake" or laminated solid similar to cardboard architectural models.
Terrain created as a "layered solid" surface, with levels

Stitch Border When on, suppresses the creation of new triangles around the edges of terrain objects when edge conditions are defined by splines that are not closed. Most terrain forms display more reasonably when this is turned off.

Retriangulate The basic Terrain algorithm tends to flatten or notch contours when they turn sharply upon themselves. A typical situation in which this may happen is when a narrow creek bed is described with contours; the resulting form may look more like a series of cascades at each elevational contour, rather than a smoothly descending ravine. When Retriangulate is checked, a somewhat slower algorithm is used that follows contour lines more closely. This may be particularly evident in the Layered Solid display mode. For additional precision, try using Retriangulate in conjunction with horizontal interpolation.

Display group

- Terrain Displays only the triangulated mesh over the contour line data.
- **Contours** Displays only the contour line data of the terrain object.
- **Both** Displays both the triangulated mesh and the contour line data of the terrain object. You can select the terrain object by clicking its surface, but not by clicking a contour line. When Both is selected, contour lines may not be apparent in Wireframe display modes or when Edged Faces are displayed.

**Update group**

The items in this group box determine when 3ds Max recalculates the projection for the terrain object. Because complex terrain objects can slow performance, you can use these options to avoid constant calculation.

- **Always** Updates the terrain object immediately when you change an operand, including the original object of an instanced or referenced operand.
- **When Rendering** Updates the terrain object when you render the scene or when you click Update. With this option, viewports won’t show current geometry unless you click Update.
- **Manually** Updates the terrain object when you click Update.

**Update** Updates the terrain object. This button is not enabled only when Always is the active option.
Simplification rollout

Horizontal group

- **No Simplification**  Uses all the operands' vertices to create a complex mesh. This results in greater detail and a larger file size than the two fractional options.

- **Use 1/2 of Points**  Uses half the set of vertices in the operands to create a less complex mesh. This results in less detail and a smaller file size than using No Simplification.

- **Use 1/4 of Points**  Uses a quarter of the vertices in the operands to create a less complex mesh. This results in the least detail and smallest file size of these options.

- **Interpolate Points * 2**  Doubles the set of vertices in the operands to create a more refined but more complex mesh. This is most effective in terrain forms that use constructive curves such as circles and ellipses. This results in more detail and a larger file size than using No Simplification.

- **Interpolate Points * 4**  Quadruples the set of vertices in the operands to create a more refined but more complex mesh. This is most effective in terrain forms that use constructive curves such as circles and ellipses. This results in more detail and a larger file size than using No Simplification.
Vertical group

- **No Simplification**  Uses all the spline operands vertices of the terrain object to create a complex mesh. This results in greater detail and a larger file size than the other two options.

- **Use 1/2 of Lines**  Uses half the set of spline operands of the terrain object to create a less complex mesh. This results in less detail and a smaller file size than using No Simplification.

- **Use 1/4 of Lines**  Uses a quarter of the spline operands of the terrain object to create a less complex mesh. This results in the least detail and smallest file size of the three options.
Color by Elevation rollout

Maximum Elev. Displays the maximum elevation in the Z axis of the terrain object. 3ds Max derives this data from the contour data.

Minimum Elev. Displays the minimum elevation in the Z axis of the terrain object. 3ds Max derives this data from the contour data.

Reference Elev. This is the reference elevation, or datum, that 3ds Max uses as a guide for assigning colors to zones of elevation. After entering a reference elevation, click the Create Defaults button. 3ds Max treats elevations above the reference elevation as solid land and those below the reference elevation as water.
If you enter a value no greater than the minimum elevation in the object, 3ds Max divides the range between the reference and minimum elevations into five color zones: dark green, light green, yellow, purple, and light gray. If you enter a value between the minimum and maximum elevations, 3ds Max creates six color zones. Two zones (dark blue and light blue) are used for elevations below the reference elevation. These are considered to be under water. One zone (dark yellow) is used for a narrow range around the reference elevation. Three zones (dark green, light green, light yellow) are used for elevations above the reference elevation. If you enter a value at or above the maximum elevation, 3ds Max divides the range between the minimum and reference elevations into three zones (dark blue, medium blue, light blue).

**Zones by Base Elevation group**

Create Defaults Creates elevation zones. 3ds Max lists the elevation at the bottom of each zone, referenced to the datum (the reference elevation). 3ds Max applies the color of the zone at the base elevation. Whether the colors blend between zones depends on your choice of the Blend to Color Above or Solid to Top of Zone option.

**Color Zone group**

The items in this group box assign colors to elevation zones. For example, you might want to change levels of blue to indicate the depth for water. Your changes in the Color Zone area don't affect the terrain object until you click the Modify Zone or Add Zone button.

- **Base Elev** This is the base elevation of a zone to which you assign color. After entering a value, click Add Zone to display the elevation in the list under Create Defaults.
- **Base Color** Click the color swatch to change the color of the zone.
- **Blend to Color Above** Blends the color of the current zone to the color of the zone above it.
- **Solid to Top of Zone** Makes a solid color at the top of the zone without blending to the color of the zone above it.

Modify Zone Modifies selected options of a zone.
Add Zone Adds values and selected options for a new zone.
Delete Zone Deletes a selected zone.
Loft Compound Object

Select a path or shape. > Create panel > Geometry > Compound Objects >
Object Type rollout > Loft

Select a path or shape. > Create menu > Compound Objects > Loft

Loft objects are two-dimensional shapes extruded along a third axis. You create
loft objects from two or more existing spline objects. One of these splines
serves the path. The remaining splines serve as cross-sections, or shapes, of
the loft object. As you arrange shapes along the path, 3ds Max generates a
surface between the shapes.

Roadway created as a lofted shape

You create shape objects to serve as a path for any number of cross-section
shapes. The path becomes the framework that holds the cross sections forming
your object. If you designate only one shape on the path, 3ds Max assumes
an identical shape is located at each end of the path. The surface is then
generated between the shapes.

3ds Max places few restrictions on how you create a loft object. You can create
curved, three-dimensional paths and even three-dimensional cross sections.
When using Get Shape, as you move the cursor over an invalid shape, the reason the shape is invalid is displayed in the prompt line.

Unlike other compound objects, which are created from the selected object as soon as you click the compound-object button, a Loft object is not created until you click Get Shape or Get Path, and then select a shape or path.

Loft is enabled when the scene has one or more shapes. To create a loft object, first create one or more shapes and then click Loft. Click either Get Shape or Get Path and select a shape in the viewports.

Once you create a loft object, you can add and replace cross-section shapes or replace the path. You can also change or animate the parameters of the path and shapes. Another method is to use the Modify panel's Deformations rollout to add complexity. See Deformations on page 770 for further information.

Once you've created a loft object, you can also use the Modify panel's Deformations rollout to add complexity. See Deformations on page 770 for further information.

You can't animate the path location of a shape.

You can convert loft objects to NURBS surfaces on page 2483.

**Procedures**

**To create a loft object:**

Creating loft objects is detailed and offers many choices, but the basic process is quite simple.

1. Create a shape to be the loft path.

2. Create one or more shapes to be loft cross sections.

3. Do one of the following:
   - Select the path shape and use Get Shape to add the cross sections to the loft.
   - Select a shape and use Get Path to assign a path to the loft. Use Get Shape to add additional shapes.

You can use the loft display settings to view the skin generated by your loft in both wireframe and shaded views.
NOTE 3ds Max builds the loft at the location of the first object you select: if you
select a path and use Get Shape, it appears at the location of the path, and if you
select a shape and use Get Path, it appears at the location of the shape.

To create a loft with Get Path:
1. Select a shape as the first cross-section shape.
2. Click Create panel > Geometry > Compound Objects > Loft.
3. On the Creation Method rollout, click Get Path.
4. Choose Move, Copy, or Instance.
5. Click a shape for the path.
   The cursor changes to the Get Path cursor as you move it over valid path
   shapes. If the cursor does not change over a shape, that shape is not a
   valid path shape and cannot be selected. The first vertex of the selected
   path is placed at the first shape's pivot and the path tangent is aligned
   with the shape's local Z axis.
   When you click the path, 3ds Max builds the loft at the location of the
   shape. The location of the path doesn’t matter.

To create a loft with Get Shape:
1. Select a valid path shape as the path.
2. If the selected shape is not a valid path, the Get Shape button is
   unavailable.
3. Click Create panel > Geometry > Compound Objects > Loft.
4. On the Creation Method rollout, click Get Shape.
5. Choose Move, Copy, or Instance.
6. Click a shape.
   The cursor changes to the Get Shape cursor as you move it over potential
   shapes. The selected shape is placed at the first vertex of the path.
   When you click the shape, 3ds Max builds the loft at the location of the
   path. The location of the shape doesn’t matter.

TIP You can flip the shape along the path by holding down Ctrl when using
Get Shape. For example, if you select the lowercase letter “b” with a Ctrl+click,
the loft will look like the letter “d”.

744 | Chapter 6   Creating Geometry
Creation Method Rollout

Select a path or shape. > Create panel > Geometry > Compound Objects > Object Type rollout > Loft > Creation Method rollout

Select a path or shape. > Create menu > Compounds > Loft > Creation Method rollout

You can choose between a shape or a path for creating the loft object using the Creation Method rollout, as well as the type of action for the loft object.

Interface

On the Creation Method rollout, you determine whether to use a shape or path for creating the loft object, and the type of action you want for the resulting loft object.

NOTE 3ds Max builds the loft at the location of the first object you select: if you select a path and use Get Shape, it appears at the location of the path, and if you select a shape and use Get Path, it appears at the location of the shape.

Get Path Assigns a path to the selected shape or changes the current assigned path.

Get Shape Assigns a shape to the selected path or changes the current assigned shape.

TIP Hold down Ctrl while getting the shape to flip the direction of the shape’s Z axis.

Move/Copy/Instance Lets you specify how the path or shape is transferred to the loft object. It can be moved, in which case no copy is left behind, or transferred as a copy or an instance on page 8611.

TIP Use the Instance option if you expect to edit or modify the path after the loft is created.
Surface Parameters Rollout

Select a path or shape. > Create panel > Geometry > Compound Objects > Object Type rollout > Loft > Surface Parameters rollout

Select a path or shape. > Create menu > Compounds > Loft > Surface Parameters rollout

On the Surface Parameters rollout, you control smoothing of the surface of the loft as well as designate if texture mapping is applied along the loft object.

Interface
Smoothing group

Left: Smoothing the length
Right: Smoothing the width
Rear: Smoothing both length and width

**Smooth Length** Provides a smooth surface along the length of the path. This type of smoothing is useful when your path curves or when shapes on the path change size. Default=on.

**Smooth Width** Provides a smooth surface around the perimeter of the cross-section shapes. This type of smoothing is useful when your shapes change the number of vertices or change form. Default=on.
Mapping group

Bitmap used to create the lines on the road

Mapped roadway showing U and V dimensions for the loft

**Apply Mapping** Turns lofted mapping coordinates on and off. Apply Mapping must be on in order to access the remaining items.

**Real-World Map Size** Controls the scaling method used for texture mapped materials that are applied to the object. The scaling values are controlled by the Use Real-World Scale settings found in the applied material's Coordinates rollout on page 6201. Default=off.
Length Repeat Sets the number of times a map repeats along the length of the path. The bottom of the map is placed at the first vertex of the path.

Width Repeat Sets the number of times a map repeats around the perimeter of cross-section shapes. The left edge of a map is aligned with the first vertex of each shape.

Normalize Determines how path vertex spacing affects a map along both the path length and shape width. When on, vertices are ignored. Map coordinates and Repeat values are applied evenly along the length of the path and around the shapes. When off, major path divisions and shape vertex spacing affects map coordinate spacing. Map coordinates and Repeat values are applied proportionally according to the path division spacing or shape vertex spacing.

Before and after applying Normalize to loft

Materials group

Generate Material IDs Creates Material IDs during the loft process.

Use Shape IDs Offers the choice of using the spline material IDs to define the material IDs.

NOTE Prior to version 3 of 3ds Max, splines could not hold material IDs.
**NOTE**  Shape IDs are inherited from shape cross sections, not from the path spline.

Shape material IDs used to give the roadway two materials: concrete for supports and railings, asphalt with white lines for the traffic lanes

---

**Output Group**

**Patch**  The lofting process produces a patch object.

**Mesh**  The lofting process produces a mesh object. This is the default, and was the only output type available with Loft in versions prior to version 3 of 3ds Max.

You can also create NURBS objects from lofting by choosing Convert To: NURBS from the **modifier stack right-click menu** on page 8200.

**Path Parameters Rollout**

Select a path or shape. > Create panel > Geometry > Compound Objects > Object Type rollout > Loft > Path Parameters rollout
Select a path or shape. > Create menu > Compounds > Loft > Path Parameters rollout

The Path Parameters rollout lets you control the position of shapes at various intervals along the path of the loft object.

**Interface**

On the Path Parameters rollout, you control the position of multiple shapes at different intervals along the path of the loft object.

**Path** Lets you set a path level by entering a value or dragging the spinner. If Snap is on, the value will jump to the previous snap increment. The Path value depends on the selected measuring method. Changing the measuring method causes the Path value to change.

**Inserting different shapes at different positions on the path**

**Snap** Lets you set a consistent distance between shapes along the path. The Snap value depends on the selected measuring method. Changing the measuring method also changes the Snap value to keep snap spacing constant.

**On** When On is turned on, Snap is active. Default=off.

**Percentage** Expresses the path level as a percentage of the total path length.

**Distance** Expresses the path level as an absolute distance from the first vertex of the path.
**Path Steps** Places shapes on path steps and vertices, rather than as a percentage or a distance along the path.

When Path Steps is on, the following take place:

- The Path spinner specifies the step along the path. The first step, at 0, is the first vertex.
- The total number of steps, including vertices, appears in parentheses beside the Path spinner.
- The current path level is indicated by the standard yellow X when it's a step, and by a small boxed X when it's a vertex.
- Get Shape places a selected shape on the specified step or a vertex of the path.
- Adaptive Path Steps on the Skin Parameters rollout is unavailable. (If it were available, the path steps and shapes would change positions along the path, depending on the result of the adaptive algorithm.)

Please note the following when using the Path Steps option:

- When you switch to Path Steps with a loft object that already contains one or more shapes, an alert message tells you that this action may relocate shapes. This is because there are a limited number of path steps, and only one shape can be on a single step or vertex. The Percentage and Distance options, on the other hand, provide an almost unlimited number of levels on which to place shapes. Thus, if you change from Percentage or Distance to Path Steps, the shapes must be moved to existing steps. If there are more shapes than can be moved to nearby steps, you could end up with more than one shape on a step. Switching from Path Steps to either Percentage or Distance, however, can always be done without loss of data.
- If you alter the Path Steps spinner while in Path Steps mode, the location of your shapes might change. An alert message warns you of this.
- If you animate the topology of the path while in Path Steps mode (such as animating the number of sides of an NGon), your shapes might jump around trying to find a legitimate position, and you could end up with more than one shape on the same path level.

**Pick Shape** Sets the current level at any shape on the path. When you pick a shape on the path, Snap is turned off and Path is set to the level of the picked shape, where a yellow X appears. Pick Shape is available only from the Modify panel.
**Previous Shape** Jumps the path level from its current location to the previous shape along the path. A yellow X appears at the current level. Clicking this button turns Snap off.

**Next Shape** Jumps the path level from its current location to the next shape along the path. A yellow X appears at the current level. Clicking this button turns Snap off.

**Skin Parameters Rollout**

Select a path or shape. > Create panel > Geometry > Compound Objects > Object Type rollout > Loft > Skin Parameters rollout

Select a path or shape. > Create menu > Compounds > Loft > Skin Parameters rollout

On the Skin Parameters rollout, you adjust the complexity of the mesh of the loft object. You can also optimize the mesh by controlling the face count.

**Procedures**

**Example: To use a constant cross-section:**

1. Enlarge the Front viewport to full screen, and then draw a Rectangle object on page 588 with Ctrl held down to create a square about 20 x 20 units.

2. Create another rectangle beside it about 200 x 100 units.

3. Apply a Skew modifier to the large rectangle, but don't alter the Skew parameters.

4. Create a loft object in which the larger rectangle is the path and the square is the shape.

5. On the Modify panel, open the Skin Parameters rollout, and make sure Skin is on in the Display group.

   You can now see the wireframe structure of the lofted rectangle, with cross-sectional sides parallel to its corners.

   Make sure the color assigned the loft object is easily visible. Change it if necessary.

6. Turn off Constant Cross-Section, and observe the corners.

   When Constant Cross-Section is off, the corners become pinched.
7 Turn on Constant Cross-Section to restore the corners. Acute angles can cause problems when the cross sections formed by the path steps intersect at the corners. You can mitigate this by avoiding acute angles or by reducing the path steps.

8 Press H on the keyboard to open the Select From Scene dialog on page 206, and select Rectangle02 (the second larger rectangle).

9 On the Modify panel, change the Skew Axis to Y, and then set the Amount spinner to 95.

10 Use Zoom Region to zoom in on the upper-right corner of the rectangle so you can see the mesh in detail. At a skew of less than 100, the acute angle still works because the path cross-sections haven't intersected.

11 Set the Skew Amount to 300, and examine the same corner. At this angle, the path cross sections intersect, causing problems in the mesh.

12 Select the loft object, and set Path Steps to 1. The cross sections no longer intersect, and the corner is clean. When creating straight-edge molding for architectural modeling, you can avoid mangled corners simply by reducing the path steps to 0.
Interface

Capping group

**Cap Start** When on, the end of a loft at the first vertex of the path is covered, or capped. When off, the end is open, or uncapped. Default=on.

**Cap End** When on, the end of a loft at the last vertex of the path is covered, or capped. When off, the end is open, or uncapped. Default=on.

**Morph** Arranges cap faces in a predictable, repeatable pattern necessary for creating morph targets. Morph capping can generate long, thin faces that do not render or deform as well as those created with grid capping.

**Grid** Arranges cap faces in a rectangular grid trimmed at the shape boundaries. This method produces a surface of evenly sized faces that can be deformed easily by other modifiers.
Roadway lofted with capping turned off
Roadway lofted with capping turned on

**Options group**

**Shape Steps** Sets the number of steps between each vertex of the cross-section shapes. This value affects the number of sides around the perimeter of the loft.
Left: Shape Steps=0.
Right: Shape Steps=4.

Path Steps Sets the number of steps between each main division of the path. This value affects the number of segments along the length of the loft.
Frame lofted with Path Steps=1
Frame lofted with Path Steps=5

**Optimize Shapes** When on, the Shape Steps setting is ignored for straight segments of cross-section shapes. If multiple shapes are on the path, only straight segments that have a match on all shapes are optimized. Default=off.
Optimize Shapes turned on

Optimize Path When on, the Path Steps setting is ignored for straight segments of the path. Curved sections respect the Path steps setting. Available only with Path Steps mode. Default=off.
When Optimize Path is off, the lofted roadway uses more steps.
When Optimize Path is on, straight sections of the lofted roadway don't require additional steps.

Adaptive Path Steps When on, analyzes the loft and adapts the number of path divisions to generate the best skin. Main divisions along the path occur at path vertices, shape locations, and deformation curve vertices. When off, main divisions along the path occur only at path vertices. Default=on.

Contour When on, each shape follows the curvature of the path. The positive Z axis of each shape is aligned with the tangent to the path at the shape's level. When off, shapes remain parallel and have the same orientation as a shape placed at level 0. Default=on.
Lofting the roadway with Contour off causes it to twist.
Banking When on, shapes rotate about the path whenever the path bends and changes height in the path’s local Z axis. The bank amount is controlled by 3ds Max. Banking is ignored if the path is 2D. When off, shapes do not rotate about their Z axis as they traverse a 3D path. Default=on.
Constant Cross Section When on, the cross sections are scaled at angles in the path to maintain uniform path width. When off, the cross sections maintain their original local dimensions, causing pinching at path angles.
Frame lofted with Constant Cross Section turned off
Frame lofted with Constant Cross Section turned on

**Linear Interpolation** When on, generates a loft skin with straight edges between each shape. When off, generates a loft skin with smooth curves between each shape. Default=off.
Flip Normals When on, reverses the normals 180 degrees. Use this option to correct objects that are inside-out. Default=off.

Quad sides When on, and when two sections of a loft object have the same number of sides, the faces that stitch the sections together are displayed as quads. Sides between sections with different numbers of sides are not affected, and are still connected with triangles. Default=off.

Transform Degrade Causes the loft skin to disappear during sub-object shape/path transformations. For example, moving a vertex on the path causes the loft to disappear. When off, you can see the skin during these Sub-Object transformations. Default=off.

Display group

Skin When on, displays a loft's skin in all views using any shading level and ignores the Skin In Shaded setting. When off, displays only the loft sub-objects. Default=on.
Skin in Shaded When on, displays a loft’s skin in shaded views regardless of the Skin setting. When off, skin display is controlled by the Skin setting. Default=on.
The loft object now retains the Skin and Skin In Shaded settings from one loft object to the next one created.

Deformations

Select a Loft object. > Modify panel > Deformations rollout

Deformation controls let you scale, twist, teeter, bevel or fit shapes along the path. The interface for all deformations is a graph. Lines with control points on the graph represent the deformations along the path. Control points on the graphs can be moved or animated for modeling purposes or for various special effects.

Manually creating and placing shapes along the path to produce these models would be a difficult task. Lofts solve this problem through the use of deformation curves. The deformation curves define changes in scale, twisting, teetering, and beveling along the path.

You gain access to loft deformation curves through the Modify panel's Deformations rollout. Deformations are not available in the Create panel. You must open the Modify panel after you've lofted to access the Deformations rollout, which offers the following features:

- Each deformation button displays its own deformation dialog.
- You can display any or all of the deformation dialogs simultaneously.
- The button to the right of each deformation button is a toggle to enable or disable the deformation's effect.

See also:
- Deformation Dialog on page 781

Procedures

To apply deformations to a loft:

1. Select a loft object.
2  Go to the Modify panel and choose Loft from the modifier stack display if it's not already displayed.

3  Expand the Deformations rollout.

4  Click the deformation that you want to use.
   The window for the selected deformation appears.

**To toggle the deformation effect:**

- Click Enable/Disable to the right of the deformation buttons.

**Interface**

![Deformations rollout]

- **Deform Scale** on page 771
- **Deform Twist** on page 773
- **Deform Teeter** on page 774
- **Deform Bevel** on page 777
- **Deform Fit** on page 779

**Deform Scale**

Select a Loft object. > Modify panel > Deformations rollout > Scale

You can loft objects such as columns and bugles from a single shape that changes only its scale as it travels along a path. Use Scale deformation when you want to make these types of objects.
TIP By animating scale, a loft object can appear to travel along a path. Using this technique, you can create animations in which letters or lines write themselves onto the screen.

These are the properties of Scale deformation curves:

- The two curves are red for X-axis scaling and green for Y-axis scaling.
- Default curve values are at 100%.
- Values greater than 100% make the shape larger.
- Values between 100% and 0% make the shape smaller.
- Negative values scale and mirror the shape.

See Deformation Dialog on page 781 for specific information on the dialog controls.

Scale deformation curve dialog

Procedures

To use Scale deformation:

1. Select a loft object.
2. Click Loft in the modifier stack display.
3. Click Scale on the Deformations rollout.

4. Edit the deformation curves for the X axis and Y axis.

**Deform Twist**

Select a Loft object. > Modify panel > Deformations rollout > Twist

Twist deformation lets you create objects that spiral or twist along their length. Twist specifies the amount of rotation about the path.

![Twist deformation curve dialog](image1)

Twist deformation curve dialog

![Using twist to deform the lofted roadway](image2)

Using twist to deform the lofted roadway
These are the properties of Twist deformation curves:

■ A single red curve determines shape rotation about the path.
■ The default curve value is 0 degrees of rotation.
■ Positive values produce counterclockwise rotation, when viewed from the start of the path.
■ Negative values produce clockwise rotation.
■ Both twist deformation and banking produce rotation about the path. Twist rotation is added to a shape after the banking angle is applied. You can use Twist deformation to exaggerate or reduce the amount of banking.

See Deformation Dialog on page 781 for specific information on the dialog controls.

**Procedures**

**To use Twist deformation:**

1. Select a loft object.
2. Click Loft in the modifier stack display.
3. Click Twist on the Deformations rollout.
4. Edit the single deformation curve to specify rotation about the path.

**Deform Teeter**

Select a Loft object. > Modify panel > Deformations rollout > Teeter

Teeter deformation rotates shapes about their local X axis and Y axis. Teetering is what 3ds Max does automatically when you select Contour on the Skin Parameters rollout. Use Teeter deformation when you want to manually control contour effects.
Teeter deformation curve dialog

Roadway lofted with no teeter
These are the properties of Teeter deformation curves:

■ The two curves are red for X-axis rotation and green for Y-axis rotation.
■ Default curve values are at 0 degrees rotation.
■ Positive values rotate the shape counterclockwise about the shape's positive axis.
■ Negative values rotate the shape clockwise about the shape's positive axis.

See Deformation Dialog on page 781 for specific information on the dialog controls.

**Procedures**

**To use Teeter deformation:**

1. Select a loft object.
2. Click Loft in the modifier stack display.
3. Click Teeter on the Deformations rollout.
4. Edit the deformation curves for X axis and Y axis rotation.

**Deform Bevel**

Select a Loft object. > Modify panel > Deformations rollout > Bevel

Nearly every object that you encounter in the real world is beveled. Because it is difficult and expensive to manufacture a perfectly sharp edge, most objects are created with chamfered, filleted, or eased edges. Use Bevel deformation to simulate these effects.

![Roadway with beveled edges](image)

**NOTE** Bevel is not available when loft output is set to Patch.

These are the properties of Bevel deformation curves:

- The single red curve is for bevel amount.
- Bevel values are specified in current units.
• The default curve value is 0 units.
• Positive values reduce the shape, bringing it closer to the path.
• Negative values add to the shape, moving it away from the path.

When shapes are nested, the bevel direction is reversed for interior shapes. See Deformation Dialog on page 781 for specific information on the dialog controls.

**Normal and Adaptive Beveling**

The Bevel Deformation dialog provides three types of beveling: Normal, Adaptive Linear, and Adaptive Cubic. These are available from a flyout at the right end of the dialog toolbar.

With normal beveling, the beveled shape remains parallel to the original, regardless of the crotch angle of the shape. Steep crotch angles combined with excessive bevel amounts result in overshooting at the crotch.

Adaptive beveling alters the length of the bevel shape based on the crotch angle. Adaptive Linear alters the length-to-angle in a linear fashion. Adaptive Cubic alters it more on steep angles than on shallow angles, producing a subtly different effect. Both forms of adaptive beveling result in nonparallel beveled edges, and both are less likely to produce invalid bevels due to overshoots at the crotch.

To see the differences in the three types of beveling, loft a star shape along a straight path and apply a bevel. When you switch among the three types of beveling, you'll see the difference in the bevel outline. Alter one radius of the star to examine the beveling with shallow and with sharp crotch angles.

**Procedures**

**To use Bevel deformation:**

1. Select a loft object.
2. Click Loft in the modifier stack display.
3. Click Bevel on the Deformations rollout.
4. Adjust the deformation curve.
**Deform Fit**

Select a Loft object. > Modify panel > Deformations rollout > Fit

Fit deformation lets you use two Fit curves to define the top and side profiles of your object. Use Fit deformation when you want to generate loft objects by drawing their profiles.

Fit curves define a lofted shape.

Fit shapes are really scale boundaries. As your cross-section shape travels along the path, its X axis is scaled to fit the boundaries of the X-axis fit shape and its Y axis is scaled to fit the boundaries of the Y-axis fit shape.

**NOTE** Fit is not available when loft output is set to Patch.

**Procedures**

**To use Fit deformation:**

1. Select a loft object.
2. Click Loft in the modifier stack display.
3 Click Fit on the Deformations rollout.
4 Select shapes in the viewport to use as fit curves.

Interface

Fit Deformation dialog

The Fit Deformation dialog contains different buttons than the other deformations. For descriptions of the first eight buttons on the toolbar, see Deformation Dialog on page 781. The following descriptions apply to the tools specific to Fit deformation, and are listed from left to right in the order they appear on the toolbar.

Fit Deformation toolbar

Mirror Horizontally Mirrors the shape across the horizontal axis.

Mirror Vertically Mirrors the shape across the vertical axis.
Rotate 90 CCW Rotates the shape 90 degrees counterclockwise.

Rotate 90 CW Rotates the shape 90 degrees clockwise.

Delete Control Point Deletes the selected control point.

Reset Curve Replaces the displayed Fit curve with a rectangle 100 units wide and centered on the path. If Make Symmetrical is on, both Fit curves are reset even though only one might be displayed.

Delete Curve Deletes the displayed Fit curve. If Make Symmetrical is on, both Fit curves are deleted even though only one might be displayed.

Get Shape Lets you select the shape to use for Fit deformation. Click Get Shape, and then click the shape to use in a viewport.

Generate Path Replaces the original path with a new straight-line path.

Deformation Dialog

Select a Loft object. > Modify panel > Deformations rollout > Scale, Twist, Teeter, Bevel, or Fit

The Deformation dialogs for Scale, Twist, Teeter, Bevel, and Fit use the same basic layout.
The buttons in the window's toolbar and prompt area perform the following functions:

- Change deformation curve display.
- Edit control points (these can be animated).
- Navigate the Deformation dialog.

**Editing Deformation Curves**

A deformation curve starts as a straight line using a constant value. To produce more elaborate curves, you insert control points and change their properties.

Use the buttons in the center of the Deformation dialog toolbar to insert and change deformation curve control points (see Interface, later in this topic).

**Control Point Types**

Control points on a deformation curve can produce curves or sharp corners, depending on the control point type. To change a control point type, right-click the control point and choose one of these from the shortcut menu:

- **Corner** Non-adjustable linear control point producing a sharp corner.
- **Bezier Corner** Adjustable Bezier control point with discontinuous tangent handles set to produce a sharp corner. This type produces a curve that looks like the corner type but has control handles like the Bezier Smooth type.
- **Bezier Smooth** Adjustable Bezier control point with locked continuous tangent handles set to produce a smooth curve.

**Selecting Control Points**

Use the Move Control Point and Scale Control Point buttons with standard selection techniques to select control points.

**Procedures**

**To drag Bezier tangent handles:**

1. Select one or more Bezier Smooth or Bezier Corner control points to display their tangent handles.
2. Click one of the Move Control Point buttons.
3 Drag any tangent handle.

- Only the tangent handle you drag is affected. Tangent handles on other selected control points do not change.

- If the tangent handle you drag is part of a Bezier Smooth control point, both handles move to maintain the Bezier Smooth type.

- If the tangent handle you drag is part of a Bezier Corner control point, only that handle moves.

**To move a control point using the Position and Amount fields:**

1 Select a single control point.

2 Do one of the following:

- Move the control point horizontally by entering a value in the Position field.

- Move the control point vertically by entering a value in the Amount field.

**To change the control point type:**

You can change control point types at any time by right-clicking a selection of one or more control points.

1 Select one or more control points.

2 Right-click any selected control point.

3 Choose a control point type from the shortcut menu.

The following conditions apply to changing control point types:

- The first and last control points must use the Corner or Bezier Corner type.

- Converting a Bezier Smooth point to a Bezier Corner point unlocks the tangent handles but does not change their position. The curve appears smooth until you drag one of the tangent handles.

- Converting a Bezier Corner point or inserted Bezier point to Bezier Smooth locks the tangent handles and changes their position and magnitude. The handles are rotated to the average between their two angles. The handle magnitudes are averaged and set equal.
Interface

Buttons for working with a second curve are disabled for the Twist and Bevel deformations, which use only one curve. The disabled buttons are Make Symmetrical, Display X Axis, Display Y Axis, Display XY Axes, and Swap Deform Curves.

Make Symmetrical  You can apply the same deformation to both axes of a shape using Make Symmetrical, which is both an action button and a curve editing mode. Turning on Make Symmetrical has the following effect:

- When a single curve is displayed, it copies the displayed deformation curve to the curve for the hidden axis.
- When both axes are displayed, the Apply Symmetry dialog is also displayed. Click the button for the curve you want to apply to both axes.
- Changes you make to the selected curve are duplicated on the other curve.

When Make Symmetrical is not active, curve editing is applied only to the selected curve.

Display X Axis / Y Axis / XY Axes  You can display one or both deformation curves using the curve display buttons near the upper-left corner of the Deformation dialog.
Turn on the following buttons to display deformation curves:

- **Display X Axis** Displays only the X axis deformation curve in red.

- **Display Y Axis** Displays only the Y axis deformation curve in green.

- **Display XY Axes** Displays X axis and Y axis deformation curves together, each using its own color.

**Swap Deform Curves** Copies curves between the X axis and Y axis. This button is disabled when Make Symmetrical is on.

Click Swap Deform Curves to copy the X axis curve to the Y axis, and the Y axis curve to the X axis. It doesn’t matter which curve is currently displayed or selected.

**Move Control Points** This flyout contains three buttons for moving control points and Bezier handles:

- **Move Control Point** Changes the amount of deformation (vertical movement) and the location of the deformation (horizontal movement).

- **Move Vertical** Changes the amount of deformation without changing the location.

- **Move Horizontal** Changes the location of the deformation without changing the amount.

If one control point is selected, you can move it by entering values in the control point Position and Amount fields at the bottom of the Deformation dialog.
You cannot move end points horizontally. Intermediate control points are constrained horizontally to stay between the points on either side. The amount of horizontal constraint is determined by the control point type.

- You can move corner control points very close together, until one is directly above the other.
- You can move Bezier control points no closer than the length of their tangent handles.

**Moving Bezier Tangent Handles** You can use the Move Control Point buttons to drag a tangent handle's angle and magnitude on Bezier Smooth and Bezier Corner vertices.

Dragging a tangent handle has the following constraints:

- You cannot move tangent angles beyond vertical. This prevents deformation curves from doubling back on themselves.
- You cannot move tangent magnitudes beyond the preceding or next control point on the path.

Pressing Shift while moving a Bezier Smooth tangent handle converts the control point to a Bezier Corner type.

**Scale Control Point** Scales the value of one or more selected control points with respect to 0. Use this function when you want to change only the deformation amounts of selected control points while maintaining their relative ratio of values.

- Drag downward to reduce values.
- Drag upward to increase values.

**Insert Control Point** This flyout contains buttons for inserting two control point types.

**Insert Corner Point** Click anywhere on a deformation curve to insert a corner control point at that location.
Insert Bezier Point  Click anywhere on a deformation curve to insert a modified Bezier control point at that location. The tangent handles of the Bezier control point are set to maintain the shape of the curve before the point was inserted.

If you are not sure which type of control point you need, or if you change your mind, you can convert the point to another type by right-clicking the point and selecting the type from the shortcut menu.

Both Insert Control Point buttons put you in insertion mode. Right-click or choose another button to exit the mode.

Delete Control Point  Deletes selected control points. You can also delete selected points by pressing the Delete key.

Reset Curve  Deletes all but the end control points and sets the curves back to their default values.

Bevel Type  This flyout, available only in the Bevel Deformation dialog, lets you choose Normal, Adaptive Linear or Adaptive Cubic as the bevel type. For more information, see Deform Bevel on page 777.

Deformation grid

The area in the Deformation dialog that displays the deformation curves is called the deformation grid. This grid charts the value of the deformation along the length of the path.

These are the main grid components:

Active area  The light-colored area of the grid defines the first and last vertex boundaries of the path. The ends of the deformation curve lie on each boundary and cannot be moved off the boundary.

Horizontal lines  Mark deformation values on the vertical scale. The following table lists each deformation curve type and the meaning of the deformation values.

<table>
<thead>
<tr>
<th>Deformation Type</th>
<th>Deformation Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scale</td>
<td>Percentage</td>
</tr>
</tbody>
</table>
### Deformation Type

<table>
<thead>
<tr>
<th>Deformation Type</th>
<th>Deformation Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Twist</td>
<td>Rotation Angle</td>
</tr>
<tr>
<td>Teeter</td>
<td>Rotation Angle</td>
</tr>
<tr>
<td>Bevel</td>
<td>Current Units</td>
</tr>
</tbody>
</table>

The thick horizontal line at 0 represents the deformation value at the loft path.

**Vertical lines** Mark levels of the path. The levels displayed vary with the Adaptive Path Steps setting on the Skin Parameters rollout on page 753. If Adaptive Path Steps is on, levels are displayed at all path vertices and shape locations. If Adaptive Path Steps is off, levels are displayed only at path vertices.

**Path ruler** Measures the length of the path. The values on the ruler measure percentage along the path. You can drag the path ruler vertically in the Deformation dialog.

**Deformation curves** You can see one or two curves in the Deformation dialog, based on the deformation type and the curve display setting. The curves are color-coded by axis.

A red curve displays deformation along the shape's local X axis. A green curve displays deformation along the shape's local Y axis.

**Control Point fields** At the bottom of the Deformation dialog are two edit fields. When a single control point is selected these fields display the path location and deformation amount of the control point.

**Control Point Position** The left field displays the location of the control point on the loft path as a percentage of the total path length.

**Control Point Amount** The right field displays the deformation value of the control point.

**Deformation Dialog status bar**

The Deformation dialogs have their own view navigation buttons in the lower-right corner. These give you controls for zooming and panning the view of the deformation grid as you edit the curve values. The status bar also displays information about the current tool and the selected control point.
Numeric fields These two fields are accessible only if a single control point is selected. The first gives the point's horizontal position, and the second gives its vertical position, or value. You can edit these fields with the keyboard.

Lock Aspect This button is present only in the Fit Deformation dialog. When active, it restricts zooming to vertical and horizontal at the same time.

Zoom Extents Changes the view magnification so the entire deformation curve is visible.

Zoom Horizontal Extents Changes the view magnification along the path length so the entire path area is visible in the dialog.

Zoom Vertical Extents Changes the view magnification along the deformation values so the entire deformation curve is displayed in the dialog.

Zoom Horizontally Changes magnification along the path length.

- Drag to the right to increase magnification.
- Drag to the left to decrease magnification.

Zoom Vertically Changes magnification along the deformation value.

- Drag upward to increase magnification.
- Drag downward to decrease magnification.

Zoom Changes magnification along both the path length and the deformation value, preserving the curve aspect ratio.

- Drag upward to increase magnification.
- Drag downward to decrease magnification.
**Zoom Region** Drag a region on the deformation grid. The region is then magnified to fill the deformation dialog.

**Pan** Drag in the view to move in any direction.

**Scroll bars** Drag the horizontal and vertical scroll bars to pan the view in a single direction.

**Path Commands**

Select a Loft object. > Modify panel > Modifier stack display > Sub-object level > Path > Path Commands

The Path Commands rollout appears only when you are modifying an existing loft object and have selected Path from the Sub-Object list. The Put command allows you to make a copy or instance of the loft path.

**Interface**

The Path Commands rollout contains the following button:

- **Put** Places the path into the scene as a separate object (as a Copy or Instance).

**Shape Commands**

Select a Loft object. > Modify panel > Modifier stack display > Sub-object level > Shape > Shape Commands rollout

Shape Commands let you align and compare shapes along the loft path.
Interface

Path Level Adjusts the shape's position on the path.

Compare Displays the Compare dialog on page 792 in which you can compare any number of cross-section shapes.

Reset Undoes rotation and scale of the shape performed with the Select and Rotate or Select and Scale.

Delete Deletes the shape from the loft object.

Align group

The six buttons in this group let you align the selected shape in relation to the path. Looking down at a shape from the viewport in which it's created, the orientation is left to right along the X axis, and top to bottom along the Y axis.

You can use a combination of these buttons for placements such as corner alignment. The operations are additive. In other words, you can use both Bottom and Left to place the shape in the lower-left quadrant.

Center Centers the shape on the path, based on the bounding box of the shape.

Default Returns the shape to its position when first placed on the loft path. When you use Get Shape, the shape is placed so that the path goes through its pivot point. This is not always the same as the center of the shape. Therefore, clicking Center is different than clicking Default.
**Left** Aligns the left edge of the shape to the path.

**Right** Aligns the right edge of the shape to the path.

**Top** Aligns the top edge of the shape to the path.

**Bottom** Aligns the bottom edge of the shape to the path.

**Put group**

**Put** Puts the shape into the scene as a separate object.

**Compare Dialog**

Select a Loft object. > Modify panel > Modifier stack display > Sub-object level > Shape > Shape Commands rollout > Compare button

The Compare dialog lets you compare any number of cross-section shapes in a loft object for purposes of making sure their first vertices are properly aligned. If shapes' first vertices aren't aligned, unexpected lofting results can occur.
**Interface**

**Pick Shape** Lets you select shapes to display from the selected loft object. Click the Pick Shape button in the upper-left corner of the dialog. Then, in the viewport, select the shapes to display. Select a shape a second time to remove it from the display.

When you position the mouse cursor over a shape in the loft object, the cursor image changes to show whether the shape appears in the dialog window: a + sign appears if the shape isn't selected (indicating that if you select the shape, it will be added to the dialog window), and a - sign appears if the shape is already selected.
With each shape, the Compare dialog displays the first vertex as a small square. For correct lofting, the first vertices of all shapes on the path need to be in the same position.

**Reset** Removes all shapes from the display.

**Dialog controls**

You can scroll the Compare dialog with the scroll bars at the bottom and right sides. You can also use the buttons in the lower-right corner to perform View Extents, Pan, Zoom, and Zoom Region functions.

**Align group**

While the Compare dialog is open, you can affect the shapes' positions in the dialog window with the Shape Commands rollout > Align group buttons. Turn off Pick Shape, select a shape in the viewport, and then click the Align group buttons. See *Shape Commands* on page 790 for further information.

**Mesher Compound Object**

Create panel > Geometry > Compound Objects > Object Type rollout > Mesher

Create menu > Compound > Mesher

The Mesher compound object converts procedural objects to mesh objects on a per-frame basis so that you can apply modifiers such as Bend or UVW Map. It can be used with any type of object, but is designed primarily to work with *particle systems* on page 3292. Mesher is also useful for low-overhead instancing of objects with complex modifier stacks.

**Procedures**

**To use a Mesher object:**

1. Add and set up a particle system.
2. Click the Create panel > Geometry > Compound Objects > Object Type rollout > Mesher button.
3. Drag in a viewport to add the Mesher object. The size doesn’t matter, but the orientation should be the same as that of the particle system.
Go to the Modify panel, click the Pick Object button, and then select the particle system. The Mesher object becomes a clone of the particle system, and shows the particles as mesh objects in the viewports no matter what the particle system's Viewport Display setting is.

Apply a modifier to the Mesher object, and set its parameters. For example, you might apply a Bend modifier and set its Angle parameter to 180.

Play the animation. Depending on the original particle system and its settings, as well as any modifiers applied to the Mesher object, you might be getting unexpected results. This typically occurs because the bounding box for the modifier, as applied to the particle system, is recalculated at each frame. For example, with a bent Super Spray particle system set to spread out over time, as the particles stream away and separate, the bounding box becomes longer and thicker, potentially causing unexpected results. To resolve this, you can use another object to specify a static bounding box.

To use another object's bounding box to limit the modified Mesher object, first add and set up the object. Its position, orientation, and size are all used in calculating the bounding box.

Select the Mesher object, and go to the Mesher stack level.

In the Parameters rollout, turn on Custom Bounding Box, click the Pick Bounding box button, and then select the bounding box object. The particle stream uses the new, static bounding box.

**TIP** You can use any object as a bounding box, so it is often fastest to use the particle system itself. Move to the frame where the particle system is the size you want and pick it.

In the following illustration, you can see a Super Spray particle system (left) and a Mesher object derived from the Super Spray (right). A Bend modifier is applied to the Mesher. In the center is a box object being used as a custom bounding box. The bounding box applied to the Bend modifier is visible as an orange wireframe when the modifier is highlighted in the stack.
Using a custom bounding box with a bent particle system

To modify the particles aspect of the Mesher, edit the original particle system.

To modify the custom bounding box, move, rotate, or scale the bounding box object, and then reapply it using the Mesher object.

At this point, both particle systems will render. The original particle system must exist in order to be able to be used by the Mesher object, so if you want only the Mesher replica to render, hide the original system before rendering.
Interface

Parameters rollout

Pick Object
Click this button and then select the object to be instanced by the Mesher object. After doing so, the name of the instanced object appears on the button.
**Time Offset** The number of frames ahead of or behind the original particle system that the Mesher's particle system will run. Default=0.

**Build Only At Render Time** When on, the Mesher results do not appear in the viewports, but only when you render the scene. Default=off.

Use this option to reduce the amount of computation required for the viewport display.

**Update** After editing the original particle system settings or changing the Mesher Time Offset setting, click this button to see the changes in the Mesher system.

**Custom Bounding Box** When on, Mesher replaces the dynamic bounding box derived from the particle system and modifier with a static bounding box of the user's choice.

**Pick Bounding Box** To specify a custom bounding box object, click this button and then select the object.

The custom bounding box appears as an orange wireframe when the modifier is highlighted in the stack.

---

**TIP** You can use any object as a bounding box, so it is often fastest to use the particle system itself. Move to the frame where the particle system is the size you want and pick it.

---

**coordinate values** Displays the coordinates of the opposite corners of the custom bounding box.

**Use All PFlow Events** When on, and you've applied Mesher to a Particle Flow system, Mesher automatically creates mesh objects for every event in the system.

To use only certain events, turn this off and specify the events to use with the PFlow Events group controls (see following).

---

**PFlow Events group**

When the Mesher object is applied to a Particle Flow system, use these controls to create meshes for specific events in the system. Mesher does not create meshes for the remaining events.

**list box** Displays all Particle Flow events currently affected by Mesher.

**Add** Lets you specify Particle Flow events to be affected by Mesher.
If the Mesher object is applied to a Particle Flow system, when you click Add, an Add PF Events dialog opens listing all events in the system. Highlight the events to add, and then click OK. The events now appear in the list.

Remove Deletes highlighted events from the list.

ProBoolean/ProCutter Compound Objects

The ProBoolean and ProCutter compound objects provide you with modeling tools for combining 2D and 3D shapes in ways that would be difficult or impossible otherwise.

The ProBoolean compound object on page 801 takes a 3ds Max mesh and adds extra intelligence to it prior to performing Boolean operations. First it combines the topologies, then it determines coplanar triangles and removes incident edges. The Booleans are then performed not on triangles but N-sided polygons. Once the Boolean operations are completed, the result is retriangulated and sent back into 3ds Max with coplanar edges hidden. The result of this extra work is twofold: The reliability of the Boolean object is extremely high, and the resulting output is much cleaner in terms of having fewer small edges and triangles.
Objects combined by using ProBoolean

Advantages of ProBoolean over the legacy 3ds Max Boolean compound object include:

- **Better quality mesh**: fewer small edges, fewer narrow triangles.
- **Smaller mesh**: fewer vertices and faces.
- **Easier and faster to use**: unlimited objects per Boolean operation.
- **Cleaner-looking mesh**: coplanar edges remain hidden.
- **Integrated decimation and quad meshing**

In addition, ProCutter on page 823 is an excellent tool for exploding, breaking apart, assembling, sectioning, or fitting together objects such as a 3D puzzle. See the following illustration for an example of a goblet shattering.
ProBoolean Compound Object

Select an object. > Create panel > Geometry > Compound Objects > Object
Type rollout > ProBoolean

A Boolean object combines two or more other objects by performing a Boolean
operation or operations on them. ProBoolean adds a range of functionality
to the traditional 3ds Max Boolean object, such as the ability to combine
multiple objects at once, each using a different Boolean operation.

ProBoolean can also automatically subdivide the Boolean result into
quadrilateral faces, which lends itself well to smoothing edges with
MeshSmooth on page 1505 and TurboSmooth on page 1818.

Materials, Textures, Vertex Colors

ProBoolean and ProCutter transfer texture coordinates, vertex colors, optionally
materials, and maps from the operands to the final results. You can choose
to apply the operand material to the resulting faces, or you can retain the
original material. If one of the original operands had material maps or vertex
colors, the resulting faces derived from that operand maintain those graphical
attributes. However, when texture coordinates or vertex colors are present, it
is impossible to remove coplanar faces, so the resulting mesh quality will be
lower. We suggest that you apply textures after the ProBoolean operations.
ProBoolean provides two options for applying materials, available in the Apply Material group on the Parameters rollout (see above illustration). The default method is Apply Operand Material, which applies the operand material to the resulting faces. The alternative, Retain Original Material, causes the resulting faces to use the material of the first selected object in the Boolean operation.

The following illustration shows the difference between the two methods. The Boolean operation starts with a red box and a blue sphere, on the left. The box is used as the base object and the sphere is the subtracted operand. Using the default Apply Operand Material option gives the result shown in the center of the illustration. Choosing Retain Original Material yields the result shown on the right side of the illustration.

**Left:** Original operands  
**Middle:** Apply Operand Material active  
**Right:** Retain Original material active

**Supported Boolean Operations**

ProBoolean supports Union, Intersection, Subtraction, Merge, Attach, and Insert. The first three operations work similarly to their counterparts in the standard Boolean compound object. The Merge operation intersects and
combines two meshes without removing any of the original polygons. This can be useful for cases in which you need to selectively remove parts of the mesh.

The Attach operation combines multiple objects into one without affecting their topology; they remain essentially separate elements on page 8559 of the compound object. And the Insert operation subtracts the bounding shape of operand A from operand B, and then replaces the cut-out part with operand A.

Also supported are two variants of the Boolean operations: Imprint and Cookie Cutter. The Imprint option inserts (imprints) the intersection edges between the operands and the original mesh without removing or adding faces. Imprint only splits faces and adds new edges to the mesh of the base object (original selected object). Cookie Cutter performs the specified Boolean operation but does not add the faces from the operands into the original mesh. It can be used to cut a hole in a mesh or to get the portion of a mesh inside of another object.

Editing the Boolean Object

When you access a ProBoolean or ProCutter object from the Modify panel, you can add operands to the existing set. You can also remove and transform (move, rotate, etc.) operands.

Polygon Reduction

ProBoolean and ProCutter have a built-in decimation function. Typically, decimation is of better quality if it is integrated with the Boolean operations. The reason for this is that the Boolean object contains meta-information about which edges are intersection edges. The decimation function takes this information into account and uses it to properly maintain intersection edges.

Text, Lofts and NURBS

When performing Boolean operations with text objects on page 600, make sure characters don’t intersect each other and that each letter is closed. Also, it’s easy to inadvertently create loft objects on page 742 and NURBS objects on page 2416 in such a way as to have self-intersections. With loft objects, check the ends and points where the loft curve bends.

See also:

■ ProCutter Compound Object on page 823
Procedures

To create a ProBoolean compound object:

1. Set up objects for the Boolean operation. For example, to subtract spherical shapes from a box, create the box and spheres and arrange the spheres so that their volumes intersect the box where the subtractions should take place.

2. Select the base object. In the example in step 1, you would select the box.

3. On the Create panel > Geometry section, choose Compound Objects from the drop-down list, and then click ProBoolean.

4. On the Parameters rollout, choose the type of Boolean operation you want to use: Union, Intersection, Subtraction, etc. Also choose how 3ds Max will transfer the next operand you pick into the Boolean object: Reference, Copy, Move, or Instance. You can also choose to retain the original material, or keep the default Apply Material choice: Apply Operand Material.

5. Click the Start Picking button.

6. Pick one or more objects to participate in the Boolean operation.

7. As you pick objects, you can also change, for each newly picked object, the Boolean operation (Merge, etc.) and options (Cookie or Imprint), as well as how the next operand is transferred to the Boolean (Reference, Copy, etc.) and the Apply Material choice. You can continue picking operands as long as the Start Picking button stays pressed in. Each of the objects you pick is added to the Boolean operation.

When the Modify panel is active, you can add objects to a selected ProBoolean object by clicking the Start Picking button and then picking the objects to add.

Example: To change an existing Boolean with sub-object operations:

ProBoolean offers a great deal of flexibility in combining various Boolean operations simultaneously, plus the ability to change the way operands combine both as you build the Boolean object and after the fact.

1. Start by adding a box, a sphere, a smaller box, and a cylinder, as shown in the following illustration.
Top: Front viewport

Bottom: Perspective viewport

2 Select the box.
3 On the Create panel > Geometry section, choose Compound Objects from the drop-down list, and then click ProBoolean.

4 On the Parameters rollout, in the Operation group, choose Intersection.

5 On the Pick Boolean rollout, click Start Picking, and then click the sphere. The result is the intersection of the sphere and the box; that is, a single object that represents the common volume both objects occupy. In this case, it's the overlap of the sphere and the box. Although neither has a material at this point, the result uses the default color originally assigned by 3ds Max, at random, to the box when it was created.

6 Set Operation to Union, and then click the small box. The result is the union (adding) of the small box with the intersection of the sphere and larger box. Again, the original object's color is assigned to the result.

806 | Chapter 6  Creating Geometry
7 Set Operation to Subtraction, and then click the cylinder.
The cylinder's intersecting volume is subtracted from the previous Boolean result.

Note that the entire history of operands and operations used to build the Boolean object is listed in the hierarchy view list at the bottom of the Parameters rollout. Box01 starts the Boolean with Union, Sphere01 is
then incorporated with Intersection, Box02 is incorporated with Union, and finally Cylinder01 is incorporated with Subtraction.

**NOTE** The operation for the first object in the list has no effect on the Boolean object, but if you move it to another position in the list it does. You’ll see an example of this at the end of this exercise.

You can use the list and the other controls in the Sub-object Operations group to change the results.

8. In the list, highlight the Subtr - Cylinder01 entry, and then set Operation to Union.

9. In the Sub-object Operations group, click the Change Operation button. As a result of the change of operation, the cylinder appears in the Boolean object as an additive volume instead of a subtractive one. Also, its entry in the list changes to “Union - Cylinder01”, showing that the Boolean operation for the cylinder is now Union.

You can also change the order of the operations, which can affect the results.
10 In the list, click the Union - Cylinder01 entry to remove the highlighting, and then highlight the entry 1: Inter - Sphere01. Note that its position in the list, 1, appears in the editable field next to the Reorder Ops button.

![Image of list with operations]

11 Change the value in the field from 1 to 3, and then click the Reorder Ops button. The Inter - Sphere01 item jumps to the end of the list.

![Image of list with operations after reorder]

The Boolean object changes significantly. The new order in the list tells you how this shape was achieved: The two boxes and the cylinder were all combined with Union, adding their volumes together, and then the sphere was incorporated into that result with Intersection, leaving only the volume shared by all four objects.
Interface

Modifier stack

With an unmodified ProBoolean object selected, the modifier stack shows a single, expandable entry: ProBoolean.

Expanding this entry (by clicking the + icon) reveals a single subsidiary branch: Operands.
To transform operands in the ProBoolean object independent of the entire object, click the Operands branch to highlight it.

You can then select one or more operands, either by using standard selection methods in the viewport, or by highlighting their names in the hierarchy view on page 820 list at the bottom of the Parameters rollout.

When one, and only one, operand is selected, the object type (not its name) appears as a separate stack entry below the ProBoolean entry. Clicking this entry provides direct access to the operand's parameters on the Modify panel.
If Parameters rollout > Display is set to Result, selecting an operand displays the operand's axis tripod or transform gizmo in the viewport, although the operand itself is not visible by default.
To view the operand, set Parameters rollout > Display to Operands.

Whether or not the operands are visible, you can transform and animate them at the Operands sub-object level, as with any other object in 3ds Max.

Changing a ProBoolean object by animating the position of the subtracted operand

You can also transform and animate the base object; that is, the first object in the hierarchy view list.

**Pick Boolean rollout**

**Start Picking** Click this and then click each operand to transfer to the Boolean object in turn. Before picking each operand, you can change the Reference/Copy/Move/Instance choice, the Operation options, and the Apply Material choice.
**TIP** When you’re adding many operands to a Boolean object using the default settings, calculating the result each time you pick an object can slow down the process. To maintain optimum feedback, set Parameters rollout > Display to Operands. Then, when you’re finished, set it back to Result. Alternatively, on the Advanced Options rollout set Update to Manually, and then click the Update button to view the results after performing the Boolean operations.

Choose a radio button to specify how the next operand you pick is transferred to the Boolean object:

- **Reference** The Boolean operation uses a reference on page 8699 to the picked operand, so the object remains after being incorporated into the Boolean object. Future modifications to the originally picked object will also modify the Boolean operation. Use Reference to synchronize modifier-induced changes to the original operand with the new operand, but not vice-versa.

- **Copy** The Boolean operation uses a copy of the picked operand. The selected object is unaffected by the Boolean operation, but a copy of it participates in the Boolean operation.

- **Move** The picked operand becomes part of the Boolean operation and is no longer available as a separate object in the scene. This is the default choice.

- **Instance** The Boolean operation makes an instance on page 8611 of the selected object. Future modifications of the selected object will also modify the instanced object participating in the Boolean operation and vice-versa.
Parameters rollout

Operation group

These settings determine how the Boolean operands interact physically.

Union Combines two or more separate entities into a single Boolean object.

Intersection Creates a "new" object from the physical intersection between the original objects; the non-intersecting volumes are removed.

Subtraction Removes the volume of a selected object from the original object.
**Merge** Combines objects into a single object without removing any geometry. New edges are created where the objects intersect.

**NOTE** In the following illustration, the display property Backface Cull was turned off so that all edges are visible.

![Illustration of Merge and Union operations](image)

Left: Original object (box) and operand (small box)  
Center: Union operation; part of the smaller box is removed.  
Right: Merge operation, showing new edges at intersection

**Attach** Combines two or more separate entities into a single Boolean object without changing their topology. In essence, the operands remain separate elements within the whole.

![Illustration of Attach and Union operations](image)

Box and sphere primitives combined with Attach (left) and Union (right)
**Insert** First subtracts the second operand's bounding volume from the first, and then groups the two objects.

In effect, Insert treats the first operand as a liquid volume, so that if there's a hole in the inserted operand or some other way for the "liquid" to enter its volume, it does. The following illustration shows examples of this effect, with shaded geometry on the left and wireframe equivalents on the right.

A bowl inserted in liquid; if the bowl has a hole in it or is tilted, the liquid enters its cavity.

**NOTE** Insert does not simulate the displacement of liquid; the overall dimensions of the first operand remain constant.

**Cookie** Cuts the faces of the original mesh shape, affecting only those faces. The faces of the selected operand are not added to the Boolean result.
1. Original object (box) and operand (sphere)
2. Standard Subtraction operation
3. Subtraction with Cookie on
4. Standard Intersection operation
5. Intersection with Cookie on

**Imprint** Prints the outline of the shape (or intersection edges) onto the original mesh object.

**NOTE** The result of the Imprint operation is always the same; the main Operation choice has no effect on it.

---

**Display** Choose one of the following display modes:

- **Result** Displays only the result of the Boolean operations, not the individual operands.
  Choosing Result also activates the ProBoolean level in the modifier stack on page 810.

- **Operands** Displays the operands that define the Boolean result. Use this mode to edit the operands and modify the result.
Choosing Operands also activates the Operands level in the modifier stack on page 810.

Also, when picking many operands, use this mode to avoid having to recalculate the result each time, and then set Display back to Result at the end.

**Apply Material** Choose one of the following material application modes:

- **Apply Operand Material** New faces created by the Boolean operation acquire the material of the operand.

- **Retain Original Material** New faces created by the Boolean operation retain the material of the original object.

**Sub-object Operations group**

These functions operate on operands highlighted in the hierarchy view list (see following).

**NOTE** For these operations, you need not be at the Operands sub-object level in the modifier stack.

**Extract Selected** Based on the chosen radio button (Remove, Copy, or Inst; see following), Extract Selected applies the operation to the highlighted operand in the hierarchy view list. Three modes of extraction are available:

- **Remove** Removes the operand or operands highlighted in the hierarchy view list from the Boolean result. It essentially undoes the addition of the highlighted operand(s) to the Boolean object. Each extracted operand becomes a top-level object again.

- **Copy** Extracts a copy of the operand or operands highlighted in the hierarchy view list. The original operand remains part of the Boolean result.

- **Inst** Extracts an instance of the operand or operands highlighted in the hierarchy view list. Subsequent modifications to this extracted operand also modify the original operand, thus affecting the Boolean object.

**Reorder Ops** Changes the ordering of the highlighted operand in the hierarchy view list. The reordered operand is moved to the position listed in the text field next to the Reorder Ops button.

**Change Operation** Changes the type of operation (see Operation group on page 815) for the highlighted operand. To change the operation type, highlight...
the operand in the hierarchy view, then choose the operation type radio option, and then click Change Operation.

**Hierarchy View**

The hierarchy view, found at the bottom of the Parameters rollout, displays a list of all of the Boolean operations that define the selected mesh. Each time you perform a new Boolean operation, 3ds Max adds an entry to the list.

You can highlight operands for modification by clicking them in the hierarchy view list. To highlight multiple contiguous items in the list, click the first, and then Shift+click the last. To highlight multiple non-contiguous entries, use Ctrl+click. To remove highlighting from a list entry, Alt+click the highlighted item.

At the ProBoolean level in the modifier stack, you can perform only sub-object operations on highlighted items. At the Operands sub-object level, you can transform highlighted operands as well as perform sub-object operations; see Modifier stack on page 810 for details.
Advanced Options rollout

These options determine when updates are performed on the Boolean object after you make changes. Choose one of the following:

- **Always** Updates occur as soon as you make changes to the Boolean object.
- **Manually** Updates occur only when you click the Update button.
- **When Selected** Updates occur whenever the Boolean object is selected.
- **When Rendering** Updates are applied to the Boolean object only at render time, or when you click Update.

**Update** Applies changes to the Boolean object. Available with all options except Always.

**NOTE** When you first create a ProBoolean object with Manually or When Rendering active, no operands, including the base object, are visible until you update at least once. Thereafter, the base object is visible, but no subsequently picked operands are until you update again.
Decimation % The percentage of edges to remove from the polygons in the Boolean object, thus reducing the number of polygons. For example, a Decimation % setting of 20.0 removes 20 percent of the polygon edges.

1. Decimation % = 0.0
2. Decimation % = 30.0
3. Decimation % = 60.0
4. Decimation % = 80.0

Quadrilateral Tessellation group

These options enable quadrilateral tessellation of the Boolean object. This makes the object suitable for editing subdivision surfaces on page 2013 and for smoothing meshes. It also makes the object suitable for conversion to Editable Poly format.

For further discussion of this option, see the topic Quad Meshing and Smoothing on page 831.

Make Quadrilaterals When on, changes the tessellation of the Boolean object from triangles to quadrilaterals.

NOTE When Make Quadrilaterals is on, the Decimation setting has no effect.

Quad Size % Determines the size of the quadrilaterals as a percentage of the overall Boolean object length.

Planar Edge Removal group

This option determines how the polygons on planar faces are handled. Choose one of the following:

- Remove All Removes all extra coplanar edges on a face such that the face itself will define the polygon.
- **Remove Only Invisible**  Removes invisible edges on each face.
- **No Edge Removal**  No edges are removed.

**ProCutter Compound Object**

Select an object. > Create panel > Geometry > Compound Objects > Object Type rollout > ProCutter

The ProCutter Compound object lets you perform specialized Boolean operations, primarily for the purpose of breaking apart or subdividing volumes.

The results of ProCutter operations are particularly suitable for use in dynamics simulations where an object explodes or is shattered by impact with a force or another object.

![ProCutter used as a cookie cutter](image)

Following is a list of ProCutter features:

- Break apart a stock object into elements of an editable mesh or into separate objects using cutters that are either solids or surfaces.
Use one or more cutters on one or more stock objects at the same time.

- Perform a volume decomposition of a set of cutter objects.
- Use a single cutter many times without maintaining the history.

See also:
- ProBoolean Compound Object on page 801

Procedures

To use ProCutter:

1. Select an object to use as a cutter.
2. Activate the ProCutter compound object.
3. On the Cutter Picking Parameters rollout, click Pick Cutter Objects, and then select additional cutters.
4. On the Cutter Picking Parameters rollout, click Pick Stock Objects, and then select objects to be cut by the cutter objects.
5. In the Cutter Parameters rollout > Cutter Options group, choose the parts of the originals you wish to keep: Stock Outside Cutters, Stock Inside Cutters, Cutters Outside Stock.
6. To get separate objects to manipulate or animate, collapse the result to an Editable Mesh on page 2192 object and use the Explode tool set to 180.0. Alternatively, use Auto Extract Mesh and Explode By Elements, described below.
Interface

Cutter Picking Parameters rollout

Pick Cutter Objects When on, objects you select are designated as cutters, used to subdivide stock objects.

Pick Stock Objects When on, objects you select are designated as stock objects; that is, objects that are subdivided by cutters.

Choose a radio button to specify how the next object you pick is transferred to the ProCutter object:

- **Reference**  The Boolean operation uses a reference on page 8699 to the picked operand, so the object remains after being incorporated into the Boolean object. Future modifications to the originally picked object will also modify the Boolean operation. Use Reference to synchronize modifier-induced changes to the original operand with the new operand, but not vice-versa.

- **Copy**  The Boolean operation uses a copy of the picked operand. The selected object is unaffected by the Boolean operation, but a copy of it participates in the Boolean operation.

- **Move**  The picked operand becomes part of the Boolean operation and is no longer available as a separate object in the scene. This is the default choice.

- **Instance**  The Boolean operation makes an instance on page 8611 of the selected object. Future modifications of the selected object will also modify the instanced object participating in the Boolean operation and vice-versa.
**Cutter Tool Mode group**

These options let you use the cutter as a sculpting tool, cutting the same object repeatedly in different places. You can also get separate objects without having to go through Editable Mesh conversion.

**Auto Extract Mode** Automatically extracts the result when you select a stock object. It does not maintain the stock as a sub-object, but edits it and replaces the object with the result of the cut. This lets you quickly cut, move the cutter, and cut again.

**Explode By Elements** When Auto Extract is on, detaches each element into a separate object automatically. Has no effect when Auto Extract is off.

This convenient option makes it unnecessary to convert the ProCutter object to Editable Mesh format and then use Explode, as mentioned in this procedure on page 824. This is useful when cutting up an object. For example, you could use it to slice a loaf of bread. You use the cutter to cut a piece off, move the cutter, and then cut again.

**Parameters rollout**

You can choose any combination of the three cutting options to get the desired result. If you have non-closed meshes, the orientation of the mesh might determine which part of the stock is considered to be inside or outside the cutter.
Stock Outside Cutter The result contains the parts of the stock outside of all of the cutters. This option gives you a similar result to a Boolean subtraction of the cutters from the stock objects. The gold part of the object in the following illustration results from this option.

Stock Inside Cutter The result contains the parts of the stock inside one or more cutters. This option gives you similar results to a Boolean intersection of the cutters and the stock objects. There is some difference because each cutter is treated individually. The green, blue and red parts of the object on the left side of the following illustration are the results of this option.

Cutters Outside Stock The result contains the parts of the cutters that are not inside the stock objects. Note that the cutters will cut each other if they intersect also. You can see in the following illustration. The parts on the right side of the following illustration that are not present on the left side are results of this option.
Cylinder and sphere as cutters and box as stock
Left: Keeping stock inside and outside cutters
Right: Keeping stock inside/outside cutters and cutters outside stock

Display
Choose one of the following display modes:
■ Show Result Displays the result of the Boolean operations.
■ Show Ops Displays the operands that define the Boolean result. Use this mode to edit the operands and modify the result.

Apply Material
Choose one of the following material application modes:
■ Apply Operand Material New faces created by the Boolean operation acquire the material of the operand.
■ Retain Original Material New faces created by the Boolean operation retain the material of the original object.

Sub-object Operations group
These functions operate on operands highlighted in the hierarchy view list (see following).

Extract Selected Based on the chosen radio button (Remove, Copy, or Inst; see following), Extract Selected applies the operation to the highlighted operand in the hierarchy view list. Three modes of extraction are available:
■ Remove Removes the operand or operands highlighted in the hierarchy view list from the Boolean result. It essentially undoes the addition of the
highlighted operand(s) to the Boolean object. Each extracted operand becomes a top-level object again.

- **Copy**  
  Extracts a copy of the operand highlighted in the hierarchy view list. The original operand remains part of the Boolean.

- **Inst**  
  Extracts an instance of the operand highlighted in the hierarchy view list. Subsequent modifications to this extracted operand also modify the original operand, thus the Boolean object.

**Hierarchy View**

The hierarchy view displays a list of all operands: cutters and stock objects. You can select and edit objects using the hierarchy view, as with ProBoolean.

**Advanced Options rollout**

- **Update:**
  - Always
  - Manually
  - When Selected
  - When Rendering
  
- **Decimation %:** 0.0

- **Quadrilateral Tessellation**
  - Make Quadrilaterals
  - Quad Size %: 3.0

- **Planar Edge Removal**
  - Remove All
  - Remove Only Invisible
  - No Edge Removal
Update group

These options determine when updates are performed on the Boolean object after you make changes. Choose one of the following:

- **Always** Updates occur as soon as you make changes to the Boolean object.
- **Manually** Updates occur only when you click the Update button.
- **When Selected** Updates occur whenever the Boolean object is selected.
- **When Rendering** Updates are applied to the Boolean object only at render time, or when you click Update.

**Update** Applies changes to the Boolean object. Available with all options except Always.

**NOTE** When you first create a ProCutter object with Manually or When Rendering active, no operands, including the base object, are visible until you update at least once. Thereafter, the base object is visible, but no subsequently picked operands are until you update again.

---

**Decimation %** The percentage of edges to remove from the polygons in the Boolean object, thus reducing the number of polygons. For example, a Decimation % setting of 20.0 removes 20 percent of the polygon edges.

**Quadrilateral Tessellation group**

**Make Quadrilaterals** When on, changes the tessellation of the Boolean object from triangles to quadrilaterals. This makes the object suitable for editing subdivision surfaces on page 2013 and for smoothing meshes. It also makes the object suitable for conversion to Editable Poly format.

**Quad Size %** Determines the size of the quadrilaterals as a percentage of the overall Boolean object length.

**Planar Edge Removal group**

This option determines how the polygons on planar faces are handled. Choose one of the following:

- **Remove All** Removes all extra coplanar edges on a face such that the face itself will define the polygon.
- **Remove Only Invisible**  Removes invisible edges on each face.
- **No Edge Removal**  No edges are removed.

**Quad Meshing and Smoothing**

ProBoolean, ProCutter, and the *Quadify Mesh modifier* on page 1641 can re-mesh planar surfaces using a quadrilateral meshing algorithm. This capability, in combination with the subdivision surface tools in MeshSmooth, TurboSmooth, and Editable Poly, can produce dramatic results.

It does require some level of expertise to understand what is possible and how to achieve the best results using the quadrilateral tessellation. This topic shows the basics of how to use quad meshing and also contains tips and tricks about what works and how it works.

**TIP** To apply quadrilateral tessellation to a mesh object without performing a Boolean operation on it, simply apply the *Quadify Mesh modifier* on page 1641.

**Quad Meshing Basics**

![ProBoolean of an object containing several primitives](image-url)
To make a quadrilateral mesh, apply the Quadify Mesh modifier, or select a ProBoolean or ProCutter object, go to the Modify panel, and expand the Advanced Options panel as shown following.

To get a result similar to the following illustration, turn on Make Quadrilaterals check box:
Result of a quad mesh with Quad Size % = 3.0

To change the size of the individual quadrilaterals, adjust the Quad Size % parameter. Typically a value between 1 and 4 percent achieves the desired results. The smaller the quad size, the smaller the resulting fillets or blends between the surfaces when the mesh is smoothed. The default Quad Size value is 3.0 percent. A Quad Size value of 2.0 percent produces the following result:
Quad meshing with Quad Size % = 2.0

If you know that you have the desired result and don't plan to go back and change the quad size or the original primitives, you can convert the object to Editable Poly format and apply smoothing with the Subdivision Surface settings. If this is not the case, however, and you plan to make further adjustments, use the MeshSmooth on page 1505 or TurboSmooth on page 1818 modifier to retain the history of the ProBoolean object. The following illustration shows the result of a MeshSmooth modifier with Subdivision Amount > Iterations=1 applied to a ProBoolean object with Quad Size % set to 3.0.
MeshSmooth modifier with NURMS and Iterations=1
Quad Meshing Tips and Tricks

Sometimes the results of quad meshing can produce undesirable results in the smoothed model.

**Problem #1**: Stripes along cylinders or bumpiness on other surface

**Solution**: Increase the number of subdivisions around cylinders or along other surfaces.
To fix the problem depicted above, the number of sides on the two cylinders was changed from 18 to 30 and the number of segments on the torus was changed from 24 to 36. The following illustration shows the improved result:

**Problem #2**: Triangles along boundaries caused by conflicts with visible edges from original mesh
**Solution:** Make sure Advanced Options rollout > Planar Edge Removal is set to Remove All or create the original primitives without subdivisions on coplanar faces.

Coplanar edges not removed from original box

When rendered, misshapen geometry results from the presence of coplanar edges.
Problem #3: Poor alignment of original primitive meshes causes undesirable results.

Solution: Rotate or move original primitives into position to maximize mesh quality.

The following illustration shows the result of subtracting three spheres of the same size from a box. The left-hand sphere is aligned properly so that there are good quads along both boundaries. This should produce a good result when smoothed. The middle sphere was lifted so that there is a strip of very thin quads near the boundary. This produces very little smoothing along that edge, as you can see in the rendered image. The right-hand sphere was rotated, producing poor alignment and many triangles on the sphere as well as small quads on the plane of the box. You can see the undesirable results in the rendered image.
Quads produced by three spheres with different rotations and translations
Dynamics Objects

Create panel > Geometry > Dynamics Objects
Create menu > Dynamics

Dynamics objects are similar to other mesh objects, except that they can be made to react to the motion of objects to which they are bound, or they can provide dynamic forces when included in a dynamics simulation on page 4190.
**Damper Dynamics Object**

Create panel > Geometry > Dynamics Objects > Object Type rollout > Damper button

Create menu > Dynamics > Damper

The Damper object provides a dynamic object that can behave as either a shock-absorber or an actuator. It consists of a base, a main housing, and a piston, with an optional boot. The piston slides within the main housing, providing different heights. The overall height can be affected by binding objects, in the same way as the Spring dynamic object.

*NOTE* Damper is similar to Spring in many respects. See Spring object on page 849 for more detailed descriptions of similar parameters and procedures.

**Procedures**

To create a damper:

1. Drag and release to specify the diameter.
2. Move the mouse and click to specify the overall height of the damper.

To use a damper in a dynamics simulation:

The following must be in place to use the damper forces in a dynamics simulation:

1. Bind two objects to the ends of the damper, and choose Bound to Object Pivots in the End Point Method group box at the top of the command panel.
2. In the dynamics simulation, add the damper to the Object List. (The damper itself is not adjusted in the dynamics simulation, so all of the dynamics parameters will be disabled for the damper object.)
3. Include at least one of the bound objects or a parent of one of the bound objects in the simulation. For example, you can bind two dummy objects to the ends of a damper, and one of the dummies can be the child of an object that’s included in the simulation. In this case, the dummy itself does not need to be in the simulation.
NOTE Damper is an "ideal" object with no mass. While it can be used in dynamics simulations, it cannot participate directly in collisions or effects. As a result, when you assign a damper object to a dynamics simulation, and then view it in the Edit Object dialog, all of the parameter settings are disabled.

Interface

End Point Method group

Free Damper/Actuator Choose this when using the damper as a simple object that's not bound to others or used in a dynamics simulation.

Bound to Object Pivots Choose this option when binding the damper to two objects, using the buttons described next.
Binding Objects group

Use these controls to pick the objects to which the damper is bound. To complete the binding, you must select two binding objects, and then click Bound to Object Pivots.

Piston (label) Displays the name of the object bound to the piston of the damper.

Pick Piston Object Click this button and then select the object to be bound to the piston of the damper.

Base (label) Displays the name of the object bound to the base of the damper.

Pick Base Object Click this button and then select the object to be bound to the base of the damper.

Free Damper Parameters group

Pin-to-Pin Height Use this field/spinner to specify the distance between the bottom center of the base and the top center of the piston when the damper is not bound.

Common Damper Parameters group

Renderable When on, the object appears in the rendering; when off, the object does not appear.

Material IDs are assigned to the damper object as follows:
1: Base
2: Main housing
3: Piston
4: Boot Stop (appears only if you enable Boot Parameters)
5: Boot (appears only if you enable Boot Parameters)

Generate Mapping Coords Sets up the required coordinates for applying mapped materials to the object. Default=on.
Cylinder Parameters group

Provides parameters for the base and main cylinder of the damper.

**Base Dia** The diameter of the base, or "mount" of the damper.

**Height** The height of the base.

**Main Dia** The diameter of the main housing of the damper.

**Height** The height of the main housing.

**Sides** The number of sides of both the base and the main housing.

**Fillet 1** The size of the fillet on the lower edge of the main housing.

**Fillet Segs** The number of segments for Fillet 1. The higher this setting, the rounder the fillet profile appears.

**Fillet 2** The size of the fillet on the upper edge of the main housing.

**Fillet Segs** The number of segments for Fillet 2. The higher this setting, the rounder the fillet profile appears.

**Inside Dia** Specifies the inside diameter of the main housing, which is actually a tube rather than a cylinder.
Smooth Cylinder When on, smoothing is applied to both the base and the main housing.

**Piston Parameters group**

Provides parameters for the piston of the damper.

- **Diameter** The diameter of the piston.
- **Height** The height of the piston.
- **Sides** The number of sides in the piston.
- **Smooth Piston** When on, smoothing is applied to the piston.
The boot is an optional component of the damper that’s similar to the rubber "accordion" boot found on various types of dampers, such as shock absorbers. The boot acts like a bound dynamic object, in that one of its ends is bound to the main housing, while the other is bound to the piston. Thus, as the piston moves within the housing, the boot expands and contracts to follow.

**Enable** Turn this on to add the boot to the damper.

**Min Dia** The minimum diameter of the boot. This and the next parameter affect the depth of the accordion folds in the boot.

**Max Dia** The maximum diameter of the boot.

**Sides** The number of sides making up the boot.

**Folds** The number of accordion folds (bulges) along the height of the boot.

**Resolution** The number of segments in each fold.

**Stop Dia** The diameter of the stop, which is the ring at the top of the boot.

**Stop Thick** The thickness (height) of the stop ring.

**Setback** The distance of the stop ring from the top of the piston.
Stop Fillet  The size of the fillet on the upper edge of the stop ring.

Fillet Segs  The number of segments the stop fillet. The higher this setting, the round the fillet profile appears.

Smooth Boot  When on, smoothing is applied to the boot.

Dynamics Parameters group

Unlike the Spring object, the damper can also be used as an actuator. Basically, a damper absorbs force (like a shock absorber) while an actuator applies force.

The parameters in this group box, available only when End Point Method is set to Bound to Object Pivots, specify how forces are applied by the damper object in a dynamics simulation.

Damper Parameters  Provides parameters for a damper type of object. Specifically, this simulates a viscous linear damper, which provides linear...
resistance to motion (between the two binding objects) proportional to the rate at which the damper experiences displacement. The faster it gets hit, the harder it fights back. Push it slowly, and there’s almost no resistance.

- **Object is Damper**  Select this option to use the damper object as a damper rather than an actuator.

**Drag** Specifies the force per unit linear speed, measured in one of the methods specified below.

- **Drag is measured in**  Lets you specify the measurement of drag to use:
  - Pounds per in(ch)/sec or Newtons per m(eter)/sec.

- **Damper works in**  Provides directional options for the damper.

**Compression Only** The damper reacts only to compression forces.

**Extension Only** The damper reacts only to expansion forces.

**Both** The damper reacts to both compression and expansion forces.

**Actuator Parameters** Provides parameters for an actuator. When used as an actuator, the damper object exerts force between the two binding objects. A real-world example might be the thrusting piston in a log splitter. When used in a simulation, the force is applied by adjusting the value in the Force spinner. You can see the result only after solving the dynamics simulation.

- **Object is Actuator**  Choose this when using the damper object as an Actuator.

**Force** Specifies the amount of force exerted between the two bound objects. Positive values push the objects apart, while negative values pull them together.

- **Force is measured in**  Lets you specify the measurement of force to use:
  - Pounds per inch or Newtons per meter.

---

**Spring Dynamics Object**

Create panel > Geometry > Dynamics Objects > Object Type rollout > Spring button

Create menu > Dynamics > Spring

The Spring object is a dynamics object in the shape of a coiled spring that lets you simulate a flexible spring in dynamics simulations. You can specify the overall diameter and length of the spring, the number of turns, and the
diameter and shape of its “wire.” When used in a dynamics simulation, the compression and extension pressure of the spring are calculated as well.

**Procedures**

**To create a spring:**

1. Drag and release to specify the outside diameter.
2. Move the mouse and click to specify the overall length of the spring.

**To use a spring in a dynamics simulation:**

The following must be in place to use the spring forces in a dynamics simulation:

1. Bind two objects to the ends of the spring, and choose Bound to Object Pivots in the End Point Method group box at the top of the command panel.
2. In the dynamics simulation, add the spring to the Object List. (The spring itself is not adjustable in the dynamics Edit Object dialog, so all of the dynamics parameters will be disabled for the spring object.)
3. Include at least one of the bound objects or a parent of one of the bound objects in the simulation. For example, you can bind the ends of a spring to two dummy objects, and one of the dummies can be the child of an object that’s included in the simulation. The dummy without a parent will be stationary and the spring will pass its force through the other dummy to its parent.

**NOTE** Spring is an “ideal” object with no mass. While it can be used in dynamics simulations, it cannot participate directly in collisions or effects. A spring can only exert force on other objects in simulations. As a result, when you assign a spring object to a dynamics simulation, and then view it in the Edit Object dialog, all of the parameter settings are disabled.
Interface

Spring Parameters rollout

End Point Method group

Free Spring Choose this when using the spring as a simple object that’s not bound to other objects or used in a dynamics simulation.

Bound to Object Pivots Choose this when binding the spring to two objects, using the buttons described next.

Binding Objects group

Use these controls to pick the objects to which the spring is bound. "Top" and "Bottom" are arbitrary descriptors; the two bound objects can have any positional relationship to each other. To complete the binding, select two binding objects, and then click Bound to Object Pivots.

Each end point of the spring is defined by the center of the overall diameter and the center of the wire. This end point is placed at the pivot point of the object to which it is bound. You can adjust the relative position of the binding object to the spring by transforming the binding object while the Affect Object Only button is turned on in the Hierarchy > Pivot panel.
Top (label) Displays the name of the "top" binding object.
Pick Top Object Click this button and then select the "top" object.

Bottom (label) Displays the name of the "bottom" binding object.
Pick Bottom Object Click this button and then select the "bottom" object.

Free Spring Parameters group

Height Use this field/spinner to set the straight-line height or length of the spring when it is not bound. This is not the actual length of the spring's wire.

Common Spring Parameters group

Diameter The overall diameter of the spring, as measured at the center of the wire. (The diameter of the wire itself has no effect on this setting.)

Turns The number of full 360-degree turns in the spring.

CCW/CW Specifies whether the coils of the spring are counterclockwise (CCW) or clockwise (CW).

Automatic Segments Choose this option to force each turn of the spring to contains the same number of segments, as specified in the Segs/Turn spinner.
Thus, if you increase the number of turns, the number of segments also increases.

**Segs/Turn** This spinner lets you specify the number of segments in each 360-degree turn of the spring.

**Manual Segments** When this option is chosen, the length of the spring contains a fixed number of segments, no matter how many turns in the spring. Thus, as you increase the number of turns, you must manually increase the number of segments to maintain a smooth curve.

**Segments** This spinner lets you specify the total number of manual segments in the spring.

**Smoothing** Provides various methods of smoothing the object. The options here work the same as those in the Torus primitive on page 409.

- **All** All surfaces are smoothed.
- **Sides** Smoothing runs along the length of the wire, but not around its perimeter.
- **Segments** Smoothing runs around the perimeter of the wire, but not along its length.
- **None** No smoothing is applied.

**Renderable** When on, the object appears in the rendering; when off, the object does not appear.

**Generate Mapping Coords** Assigns mapping coordinates to the object. Default=on.
Wire Shape group

Provides three different types of wire cross-sections for the spring: round, rectangular, or D-shaped. Each type has its own set of parameters.

**Round Wire** Specifies a round wire for the spring.
- **Diameter** The diameter of the wire.
- **Sides** The number of sides that make up the cross section.

**Rectangular Wire** Specifies a rectangular wire.
- **Width** Determines the width of the cross section.
- **Depth** Determines the depth of the cross section.
- **Fillet** When combined with Fillet Segs (below), this lets you fillet (round) the corners of the cross section.
- **Fillet Segs**: Specifies the number of segments in the fillet.
- **Rotation**: Rotates the angle of the cross section along the entire length of the spring.

**D-Section Wire** Specifies a D-shaped wire.
- **Width**: Determines the width of the cross section.
- **Depth**: Determines the depth of the cross section.
- **Round Sides**: Specifies the number of segments that make up the rounded side of the D-shape.
- **Fillet**: When combined with Fillet Segs (below), this lets you fillet (round) the corners of the cross section.
- **Fillet Segs**: Specifies the number of segments in the fillet.
- **Rotation**: Rotates the angle of the cross section along the entire length of the spring.

**Dynamics Parameters group**

These parameters specify the forces that the spring contributes to a dynamic simulation.

Relaxed Hgt: 258.1
Constant k: 226.0
Spring constant is in:
- Pounds per inch
- Newtons per meter

Spring works in:
- Compression Only
- Extension Only
- Both
- Enable Nonlinearity

These parameters specify the forces that the spring contributes to a dynamic simulation.
Relaxed Hgt Specifies the height (or length) at which the spring is "relaxed" and therefore contributes no force--either compression or extension. For example, if the placement of the binding objects stretches the spring to a length of 50 units but the Relaxed Len is set to 30, then an extension force is in effect because the spring is stretched further than its relaxed length.

Constant k The amount of force exerted per unit change in length with respect to the Relaxed Hgt value. This could also be described as the measure of force-per-units-change in length as compared to the Relaxed Length. For example, if your spring is set to a Spring Constant of \( k = 10 \) lb per in, and you stretch it to be ten inches longer than the Relaxed Hgt value, it will try to close with a force of 100 pounds. If you compress it two inches shorter than the Relaxed Hgt value, it will push back with 20 pounds of force.

Spring constant is in Lets you specify the measurement of force to use: Pounds per inch or Newtons per meter.

Spring works in Lets you specify the type of force you want the spring to exert. While most springs actually provide both compression and extension force, if your simulation requires only one, you can save calculation time by using one instead of both.

- **Compression Only** This type of spring provides only expansive force when its length is shorter than the specified Free Length.

- **Extension Only** Provides contractive force when its length is greater than the specified Free Length.

- **Both** Provides both expansive and contractive force, depending on the variation from Relaxed Hgt.

Enable Nonlinearity When on, the compression and extension of the spring are non-linear, based on the assumption that a spring has physical limits to the amount it can stretch or contract. Thus, the further the spring gets from the Relaxed Hgt setting, the less linear the feedback. The non-linear compression is calculated using the relationship between the coil dimensions, wire diameter, and length. Extension compares the relationship between the wire diameter and overall spring diameter.
A system combines objects, linkages, and controllers to produce an object set that has behavior as well as geometry. Systems help you create animations that would be much more difficult or time-consuming to produce using features independently. Systems can range from simple object generators to full-scale subsystem programs.

Systems are primarily intended for plug-in on page 8687 component software. Additional systems might be available if your configuration includes plug-in systems.

You can externally reference system objects in your scene. For more information, see XRef Objects on page 7450.

**Procedures**

**To create a system:**

1. On the Create panel, click Systems. The Systems panel is displayed.
2. On the Object Type rollout, choose a system to create.
3. Drag in a viewport to create the system.

**See also:**

- Sunlight on page 5491
- Daylight on page 5491
- Biped on page 4487

**Bones System**

Create panel > Systems > Bones button

Bones System | 857
Animation menu > Bone Tools > Create Bones

A Bones system is a jointed, hierarchical linkage of bone objects that can be used to animate other objects or hierarchies.

Bones are especially useful for animating character models that have a continuous skin mesh. You can animate bones with forward or inverse kinematics. For inverse kinematics, bones can use any of the available IK solvers on page 3669, or through Interactive on page 3747 or applied IK on page 3750.

Dinosaur character modeled using bones

Bones are renderable objects. They have several parameters, such as taper and fins, that can be used to define the shape the bone represents. The fins make it easier to see how the bone is rotating.

For animation, it is very important that you understand the structure of a bone object. The bone's geometry is distinct from its link. Each link has a pivot point at its base. The bone can rotate about this pivot point. When you move a child bone, you are really rotating its parent bone.

It might be useful to think of bones as joints, because it is their pivot placements that matter, more than the actual bone geometry. Think of the
geometry as a visual aid that is drawn lengthwise from the pivot point to the bone's child object. The child object is usually another bone.

Bones system seen alone and inside a wireframe model

Any hierarchy can display itself as a bone structure (see Using Objects as Bones on page 870), by simply turning on Bone On in the Bone Editing Tools rollout on page 872.

See also:
- Bone Tools on page 871

Creating Bones

You start creating bones by clicking the Create Bones button on the Bone Editing Tools rollout on page 872, or by clicking the Bones button in the Systems category on the Create panel.

To create bones, do the following.

1. Your first click in a viewport defines the start joint of the first bone.

2. The second click in a viewport defines the start joint of the next bone. Visually only one bone is drawn at this point because bones are visual aids drawn between two pivot points. It is the actual pivot point's placement that is important.

3. Each subsequent click defines a new bone as a child of the previous bone. The result of multiple clicks is a single chain of bones.
4 Right-click to exit bone creation.
This creates a small “nub” bone at the end of the hierarchy, which is used when assigning an IK chain. If you are not going to assign an IK chain to the hierarchy, you can delete the small nub bone.

Creating a simple chain of three bones

3ds Max lets you create a branching hierarchy of bones. To create a branching hierarchy, such as legs branching from a pelvis, do the following:

1 Create a chain of bones, and then right-click to exit bone creation.

2 Click Bones (or Create Bones) again, and then click the bone where you want to begin branching. The new chain of bones branches from the bone you click.

**WARNING** The behavior of a branching bone hierarchy is not always intuitive.

**NOTE** You can also use Select And Link on page 3631 to connect one bone hierarchy to its branches. However, except for this one special case, using Select And Link with bones is not recommended. To edit an existing bone structure, whether branching or not, use the Bone Tools on page 871 instead.

**Assigning IK Controllers to Bones**

By default, bones are not assigned inverse kinematics (IK). Assigning an IK solver can be done in one of two ways. Typically, you create a bone hierarchy,
then manually assign an IK solver. This allows for very precise control over where IK chains are defined.

The other way to assign an IK solver is more automatic. When you create bones, choose IK solver from the list in the IK Chain Assignment rollout, and then turn on Assign To Children. When you exit bone creation, the chosen IK solver is automatically applied to the hierarchy. The solver extends from the first bone in the hierarchy to the last.

For more information about IK, see Introduction to Inverse Kinematics on page 3661.

Setting the Initial Position of Bones

When you first create a bones system, the position of the bones is the initial state. Before you assign an IK solver or method, you can change the initial state of the bones by moving, rotating, or stretching the bones individually.

Bone Color

By default, bones are assigned the color specified for Bones in the Colors panel on page 8272 of the Customize User Interface dialog on page 8249. Choose Object as the Element and then choose Bones in the list. You can change the color of individual bones by selecting the bone, clicking the active color swatch next to the bone’s name in the Create panel or Modify panel, and then selecting a color in the Object Color dialog on page 368.

You can also use the Bone Tools on page 871 to assign bone colors, or to assign a color gradient to a bone hierarchy.

Bone Fins

Fins are visual aids that help you clearly see a bone’s orientation. Fins can also be used to approximate a character’s shape. Bones have three sets of fins: side, front, and back. By default, fins are turned off.
Bones can have fins.
Bones with various fin configurations

**Renderable Bones**

Bones can be renderable, though by default, they are not. To make a bone renderable, turn on the Renderable check box in the bone's Object Properties dialog on page 283.
Bones can be renderable.

Object Properties for Bones

In addition to visual properties, bones have behavioral properties. The controls for these are located on the Bone Tools floater on page 871.

You can use these controls to turn other kinds of objects into bones.

Using Constraints with Bones

You can apply constraints on page 3574 to bones as long as an IK solver or method is not controlling the bones. If the bones have an assigned IK controller, you can constrain only the root of the hierarchy or chain. However, applying position controllers or constraints to a linked bone can cause undesirable effects, such as breaking of the bone chain.
The “nub” bone at the end of the chain has a Spring controller applied to it. The Spring controller is connected to an animated sphere.

Right: The sphere’s movement breaks the bone chain.

To avoid this problem, don’t apply position controllers directly to child bones. Instead, create an IK chain and apply the controller to the IK chain’s end effector.
A IK chain has been applied, connecting the end nub to its parent bone. The IK chain's end effector is connected to the ball by a Spring controller.

Right: Now when the sphere moves, the IK chain prevents the bones from breaking.

Constraints and controllers that affect orientation only, such as Orientation or Look At, do not present this problem when applied to child bones.

**Procedures**

**To create a bones system:**

1. On the Create panel, click Systems, and then click Bones. You can also access Create Bones through the Bone Tools rollout.
2. Click in a viewport. This creates a joint that is the base of the bone's hierarchy.
3. Drag to define the length of the second bone.
4. Click to set the length of the second bone, and then drag to create the third bone. Drag and click to continue creating new bones.
5. Right-click to end creation.
3ds Max creates a small “nub” bone at the end of the hierarchy. This bone is used when assigning an IK chain.

The first bone you create is at the top of the hierarchy. The last bone you create is at the bottom. For more about linked objects, see the Hierarchy Panel on page 8213.

To create a bones hierarchy with an IK solver automatically applied:

1. In the Create panel, click Systems, and then click Bones.
2. In the IK Chain Assignment rollout, select an IK solver from the list.
3. Turn on Assign To Children.
4. In a viewport, click and drag to create the bones. Right-click to end bone creation.

After the bones are created, the chosen IK solver is applied to them.

To edit the appearance of a bone:

1. Select a bone.
2. Click the Modify tab on the command panel.

To change the length of bones after they’ve been created:

**IMPORTANT** Repositioning a bone affects its length visually. More important, it affects the bone’s pivot position. The length of the bone is only a visual aid drawn between each bone’s pivot point. A bone has only one pivot. The bone you see visually is connecting its pivot point to the next bone’s pivot point.

1. Choose Animation menu > Bone Tools.
2. On the Bone Tools dialog, click Bone Edit Mode.
3. Move the child of the bone you want to change. The length of its immediate parent changes to reach the child bone.
4. Turn off Bone Edit Mode when you are finished editing the bones.
To add fins to bones:

1. Select the bone.
2. Choose Animation menu > Bone Tools.
3. Select the bones to which you want to add fins.
4. In the Fin Adjustment Tools rollout, turn on Side Fins, Front Fin or Back Fin.
5. Adjust the size and appearance of the fins with the appropriate spinners.

**NOTE** You can also add fins to an individual bone on the Modify panel.

**Interface**

**IK Chain Assignment rollout (creation time only)**

- **IK Solver drop-down list** Specifies the type of IK solver to be automatically applied if Assign To Children is turned on.
- **Assign To Children** When on, assigns the IK solver named in the IK solver list to all the newly created bones except the first (root) bone. When off, assigns a standard PRS Transform controller on page 3526 to the bones. Default=off.

**NOTE** Choosing the SplineIKSolver and turning on Assign To Children causes the **Spline IK Solver dialog** on page 3740 to appear after bones have been created.

- **Assign To Root** When on, assigns an IK solver to all the newly created bones including the first (root) bone. Turning on Assign To Children also automatically turns on Assign To Root.
Bone Parameters rollout (creation and modification time)

These controls change the appearance of the bones.

**Bone Object group**

**Width** Sets the width of the bone to be made.

**Height** Sets the height of the bone to be made.

**Taper** Adjusts the taper of the bone shape. A Taper of 0 produces a box-shaped bone.
**Bone Fins group**

**Side Fins** Lets you add a set of fins to the sides of the bones you create.
- **Size** Controls the size of the fin.
- **Start Taper** Controls the start taper of the fin.
- **End Taper** Controls the end taper of the fin.

**Front Fin** Lets you add a fin to the front of the bone you create.
- **Size** Controls the size of the fin.
- **Start Taper** Controls the start taper of the fin.
- **End Taper** Controls the end taper of the fin.

**Back Fin** Lets you add a fin to the back of the bone you create.
- **Size** Controls the size of the fin.
- **Start Taper** Controls the start taper of the fin.
- **End Taper** Controls the end taper of the fin.

**Generate Mapping Coords** Creates mapping coordinates on the bones. Since the bones are renderable, they can also have materials applied, which can use these mapping coordinates.

**Using Objects as Bones**

Select a linked object or multiple objects linked to each other. > Animation menu > Bone Tools > Object Properties rollout > Bone On toggle

You can use arbitrary objects such as cylinders or boxes as bones, controlling their animation as if they were bones in a bones system on page 857. You can apply an IK solver on page 3669 to the boned objects.

To use objects as bones, select them and then turn on the Bone On toggle on the Object Properties rollout of the Bone Tools dialog on page 871.

---

**WARNING** Turning on Freeze Length has no visible effect unless you transform the child of the object to which Freeze Length is applied.
Once you've set objects to function as bones, applying an IK solution behaves as it does for standard bone objects. The geometry of the boned objects can stretch or squash during animation.

**Procedures**

To use objects as bones:

1. Link the objects you want to display as bones.
2. Select all of these objects.
   
   **NOTE** You can set a single object to work as a bone, but this doesn't have much use.
3. Choose Animation menu > Bone Tools. The floating Bone Tools dialog is displayed.
4. On the Object Properties rollout, turn on Bone On. 3ds Max now treats the selected objects as bones.
5. Select the object to use as the start of the IK chain.
6. Choose Animation > IK Solvers > HI Solver. You can choose a different IK solver, but the HI Solver is the preferred choice.
7. Click to select the end of the IK chain. Now when you transform the boned objects, their movement is governed by the IK solver.

**Bone Tools**

Animation menu > Bone Tools

This command opens the Bone Tools floater, which provides functions for working with bones. The floater contains three rollouts, described in the following topics.
Bone Editing Tools Rollout

Animation menu > Bone Tools > Bone Tools floater > Bone Editing Tools rollout

Controls on the Bone Editing Tools rollout let you create and modify bone geometry and structure, and set bone color for one or more bones.

See also:
- Bones System on page 857

Interface

Bone Pivot Position group

Bone Edit Mode Lets you change the lengths of bones and their positions relative to one another.
When this button is on, you can change the length of a bone by moving its child bone. In effect, you can scale or stretch a bone by moving its child bone while in this mode. You can use this tool both before and after assigning an IK chain to the bone structure.

When Bone Edit Mode is on, you cannot animate, and when Auto Key or Set Key is on, Bone Edit Mode is unavailable. Turn off Auto/Set Key to edit bones.

**NOTE** Moving a bone in Bone Edit mode affects the length of both the child and its parent. If the bones aren't spatially aligned in the usual way (for example, if you are using other objects as bones), this might have unexpected results.

**Bone Tools group**

**Create Bones** Begins the bone-creation process. Clicking this button is the same as clicking Create panel > Systems > Bones on page 857.

**Create End** Creates a nub bone at the end of the currently selected bone. If the selected bone is not at the end of a chain, the nub is linked in sequence between the currently selected bone and the next bone in the chain.

**Remove Bone** Removes the currently selected bone. The bone's parent bone is stretched to reach the removed bone's pivot point, and any children of the removed bone are linked to its parent. Any IK chains that included the removed bone will remain intact.

**Connect Bones** Creates a connecting bone between the currently selected bone and another bone. When you click this button, a dotted line appears in the active viewport from the first selected bone. Move the cursor to another bone to create a new connecting bone. The first selected bone will become a parent to the connecting bone, which is in turn a parent to the second selected bone.

**Delete Bone** Deletes the currently selected bone, removing all its parent/child associations. A nub is placed at the end of the deleted bone's parent. Any IK chains that included this bone become invalid.

**Reassign Root** Makes the currently selected bone the root (parent) of the bone structure.

If the current bone is the root, clicking this has no effect. If the current bone is the end of the chain, the chain is completely reversed. If the current bone is in the middle of the chain, the chain becomes a branching hierarchy.

**Refine** Splits a bone in two. Click Refine, and then click a bone where you want it to split.
Mirror Opens the Bone Mirror dialog (see following), which lets you create mirror copies of selected bones without changing the sign of the bones' scale. Instead, Mirror flips one of the bone axes: Y or Z. You can specify the mirroring axis and the flip axis with the dialog controls.

**Bone Mirror Dialog**

![Bone Mirror Dialog](image)

Opens when you click the Mirror button. Use it to specify the mirroring axis, the flip axis, and an offset value.

While the dialog is open, you can see a preview of the mirrored bone(s) in the viewports. Click OK to create the bones, or Cancel to prevent creation.

**Mirror Axis** Choose an axis or plane about which the bones will be mirrored: X/Y/Z or XY/YZ/ZX.

**Bone Axis to Flip** To avoid creating a negative scale, choose the bone axis to flip: Y or Z.

**Offset** The distance between the original bones and the mirrored bones. Use this to move the mirrored bones to the other side of the character.

**Bone Coloring group**

**Selected Bone Color** Sets the color for selected bones.

**Apply Gradient** Applies a gradient color across several bones based on the Start Color and End Color values. This option is available only when two or more bones are selected. The Start Color is applied to the highest parent bone in the selected chain, while the End Color is applied to the last child object in the selected chain. Intermediate colors in the gradient are applied to bones in between.
Start Color Sets the starting color for the gradient.

End Color Sets the ending color for the gradient.

**Fin Adjustment Tools Rollout**

Animation menu > Bone Tools > Bone Tools floater > Fin Adjustment Tools rollout

Controls on the Fin Adjustment Tools rollout are for adjusting some aspects of bone geometry, including fins.
**Interface**

**Absolute** Sets the fin parameters as absolute values. Use this option to set the same fin values for all selected bones.

**Relative** Sets the fin parameters relative to their current values. Use this option to retain size relationships between bones with different-sized fins.

**Copy**Copies the bone and fin settings for the currently selected bone, in preparation for pasting to another bone.
Paste Pastes the copied bone and fin settings to the currently selected bone.

**Bone Objects group**

**Width** Sets the width of the bone.

**Height** Sets the height of the bone.

**Taper** Adjusts the taper of the bone shape. A Taper with a 0 value produces a box-shaped bone. Higher values pinch the bone where it joins its child bone, while lower values expand that end of the bone.

**Fins group**

**Side Fins** Adds side fins to selected bones.
- **Size** Controls the size of the fin.
- **Start Taper** Controls the start taper of the fin.
- **End Taper** Controls the end taper of the fin.

**Front Fin** Adds front fins to selected bones.
- **Size** Controls the size of the fin.
- **Start Taper** Controls the start taper of the fin.
- **End Taper** Controls the end taper of the fin.

**Back Fin** Adds fins to the backs of selected bones.
- **Size** Controls the size of the fin.
- **Start Taper** Controls the start taper of the fin.
- **End Taper** Controls the end taper of the fin.

**Object Properties Rollout (Bone Tools)**

Animation menu > Bone Tools > Bone Tools floater > Object Properties rollout

Controls on the Object Properties rollout for bones let you turn other objects into bones. They also control bone rigidity and alignment.

**NOTE** You can reset the scale of bones with the Reset Scale option.
Interface

**Bone On/Off** When turned on, the selected bone or object behaves as a bone. Turning this option off causes the object to stop behaving like a bone: there is no auto alignment or stretching. Default=on for bone objects, off for other kinds of objects.

**NOTE** Turning this option on doesn’t immediately cause objects to align or stretch. However, future transforms of children can cause rotation and stretching.

**Freeze Length** When turned on, the bone maintains its length. When turned off, the bone’s length is based on the translation of its child bone. This option is available only if Bone On is on. Default=on.

**WARNING** When you turn on Freeze Length, this has no visible effect unless you transform the child of the object to which Freeze Length is applied.

**Auto-Align** When turned off, the bone’s pivot point doesn’t align to its child object. The translation of a child bone will not be converted into rotation of the parent. Instead, the child is allowed to move away from the parent’s X axis. This option is available only if Bone On is on. Default=on.

**NOTE** Changing the Auto-Align state does not have an immediate visual effect on the skeleton. It affects future behavior when bones are moved.
Correct Negative Stretch  When turned on, any stretching of the bone that results in a negative scale factor will be corrected to a positive number. This option is available only if Bone On is on. Default=on.

Realign  Causes the bone's X axis to realign and point at the child bone (or the average pivot of multiple children). Normally this alignment is maintained, and there is no need to use this option. However, it is possible for the bones to come out of alignment by turning off Auto-Align and moving a child bone. Use Realign to align the bone back to its child. This option is available only if Bone On is on.

Reset Stretch  Stretches the bone to reach its child object if the child has been moved away from the bone. This option is available only if Bone On is on.

Reset Scale  Resets a stretched bone's internally calculated scale to 100% on each axis. Using this option avoids unexpected behavior due to objects which are both linked and scaled. This option has no visual effect on the bone. This option is available only if Bone On is on.

Stretch Factor Information

Under the Correct Negative Stretch options is a text display giving information about the number of bones selected and the respective stretch factor for all three axes. If more than one bone is selected, the Stretch Factor text displays undefined.

NOTE  The Stretch Factor text only updates when you are in Bone Edit Mode on page 872.

Stretch and Axis Options

Stretch  Determines what kind of stretch takes place when the child bone is transformed and Freeze Length is off. Default=Scale.

■  None  No stretch takes place.

■  Scale  Lets the bone scale. The stretch happens along one axis.

■  Squash  Lets the bone squash. The bone gets fatter as it gets shorter, and thinner as it gets longer.

Axis  Determines the axis used for the stretch.

■  X/Y/Z  Choose the axis for scaling or squashing.

■  Flip  Flips the stretch along the selected axis.
Ring Array System

Create panel > Systems > Ring Array button

The Ring Array object consists of a dummy object on page 2840 surrounded by a ring of boxes. You can arrange the boxes in the ring along a sine curve, vary their number, and animate the ring array’s parameters. You can also replace the boxes with other objects using Track View, as described in the Procedures section, below.

![Example of ring array]

Procedures

To create the ring array system:

1. On the Create panel, click Systems, and then click Ring Array.
2. Drag in a viewport to set the center and radius of the array.
   A dummy object appears at the center. By default, four boxes are evenly spaced in a circle around it.

To animate the ring array:

1. Turn on Auto Key.
2. Move to a nonzero frame.
3. Adjust the ring array parameters.
   You can't animate the number of boxes in the ring.
4. Repeat steps 2 and 3 for additional keyframes.
NOTE To animate the ring array after creation, use the Motion panel, not the Modify panel.

To put other kinds of objects in the ring:
You can use either version of Track View: Curve Editor or Dope Sheet.

1 In the Track View Controller window, click the name of object container of the object to put in the ring.
The name highlights.

2 Still in the Controller window, right-click and choose Copy from the menu.

3 Highlight the object container of one of the ring array boxes.
4 Right-click and choose Paste.

5 In the Paste dialog, choose Copy or Instance. Optionally, to replace all the boxes with the copied object, turn on Replace All Instances. Click OK.

The box or boxes are replaced with the copied object.

**TIP** To see the replacement objects, you might need to refresh the viewports.
Top: Object substituted for boxes in array
Bottom: The result
Interface

These parameters control ring arrays. To adjust and animate the ring array after creation, select one of the array objects (not the dummy), and then go to the Motion panel, not the Modify panel.

**Radius** Sets the radius of the ring. You set the initial Radius value when you drag to create the ring array.

**Amplitude** Sets the amplitude of the ring's sine curve, in active units. Amplitude is a height offset from the local origin of the center dummy object.

**Cycles** Sets the number of cycles in the ring's sine curve. When Cycles is 0.0, the ring is flat. When Cycles is 1.0, the ring is tilted. Greater values increase the number of peaks in the curve.

**Phase** Offsets the phase of the wave. That is, it has the effect of moving the wave along the circumference of the ring. Whole values have no effect; only fractional values do.

**Number** Sets the number of boxes in the ring.
Moving, Rotating, and Scaling Objects

To change an object’s position, orientation, or scale, click one of the three transform buttons on the main toolbar or choose a transform from a shortcut menu. Apply the transform to a selected object using the mouse, the status bar Coordinate Display fields, a type-in dialog, or any combination of the above.

The column can be moved, rotated, and scaled.
Scaling and Dimensions

If you scale an object and later check its base parameters in the Modify panel, you see the dimensions of the object before it was scaled. The base object exists independently of the scaled object that is visible in your scene.

You can use the Measure utility on page 2882 to measure the current dimensions of an object that has been scaled or changed by a modifier.

See also:
- Creating Copies and Arrays on page 981
- Using Shift+Clone on page 996

Using Transforms

A transform is an adjustment of an object’s position, orientation, or scale, relative to the 3D world (or world space) in which you’re working.

Changing a model by changing its position, rotation, or scale

You can apply three types of transform to an object:

- Position on page 914
- Rotation on page 915
This section presents these brief topics designed to help you quickly start learning how to transform objects, and how to animate your transforms:

- Using Transform Gizmos on page 889
- Animating Transforms on page 902
- Transform Managers on page 904
- Specifying a Reference Coordinate System on page 906
- Choosing a Transform Center on page 907
- Using the Axis Constraints on page 910

**Failure to Move or Rotate**

In some cases, an object might fail to move or rotate, even when the proper button is on and the object is selected. This could be due to one of the following reasons:

- The object is frozen on page 191.
- A transform controller has been assigned to the object. See Animation Controllers on page 3424.
- Inverse Kinematics mode is on and the preference called Always Transform Children of the World is off. See Introduction to Inverse Kinematics (IK) on page 3661.

**Procedures**

To transform an object using the main toolbar:

1. On the main toolbar, click one of the three transform buttons: Select And Move on page 914, Select And Rotate on page 915, or Select And Scale on page 917. These buttons are usually referred to as Move, Rotate, and Scale.
2 Position the mouse over the object you want to transform.
   ■ If the object is already selected, the cursor changes to indicate the transform.
   ■ If the object is not selected, the cursor changes to a crosshairs to show that the object can be selected.

3 Drag the mouse to apply the transform.
   If you drag the mouse over an unselected object, it becomes selected and is also transformed.
   You can restrict transforms to one or two axes easily with the transform gizmo on page 889.

To cancel a transform:
   ■ Right-click while you’re dragging the mouse.

To transform an object from the quad menu:
   1 Right-click a selected object. The quad menu on page 8052 lists the three transforms.
   2 Choose one of the transforms. The equivalent transform button is selected on the main toolbar.
   3 Drag the object to apply the transform.

To use transform type-in:
   1 Choose Tools menu > Transform Type-In to display the dialog.
   2 Apply a transform to a selected object.
   3 You can do any of the following, switching from one to the other as required.
      ■ Type a value in an axis field and press Enter to apply the transform change to the selection.
      ■ Drag a spinner in an axis field to update the selection.
      ■ Drag the object to apply the transform and read the resulting change in the dialog.
For example, if Move is active, the dialog fields read out both the absolute and offset positions of the selected object in world space. If no object is selected, the fields turn gray.

**To use transform type-in on the status bar:**

1. Select an object or a group of objects.
2. On the main toolbar, choose a transform (Move, Rotate, or Scale) to perform on the objects.
3. On the status bar, you can do any of the following, switching from one to another as required:
   - Type a value in an axis field and press Enter to apply the transform change to the selection. The Absolute/Offset toggle, to the right of the X, Y, and Z fields, lets you switch between entering values that are absolute (in world space) or offset (relative to the selection’s present position, orientation, and dimensions).
   - Drag a spinner in an axis field to update the selection.
   - Drag the object to apply the transform and read the resulting change in the X, Y, and Z fields.

**TIP** To see the Z field, drag the transform type-in portion of the toolbar while a pan hand is visible.

**Using Transform Gizmos**

Select an object. > main toolbar > Click any transform button to display the object’s Transform Gizmo icon.

The Transform gizmos are viewport icons that let you quickly choose one or two axes when transforming a selection with the mouse.

You choose an axis by placing the mouse over any axis of the icon, and then drag the mouse to transform the selection along that axis. In addition, when moving or scaling an object, you can use other areas of the gizmo to perform transforms along any two axes simultaneously. Using a gizmo avoids the need to first specify a transform axis or axes on the **Axis Constraints toolbar** on page 8039, and also lets you switch quickly and easily between different transform axes and planes.
Chapter 7   Moving, Rotating, and Scaling Objects
A Transform gizmo appears when one or more objects are selected and one of the transform buttons (Select And Move on page 914, Select And Rotate on page 915, or Select And Scale on page 917) is active on the main toolbar. Each transform type uses a different gizmo. By default, each axis is assigned one of three colors: X is red, Y is green, and Z is blue. The corners of the Move gizmo are assigned the two colors of the related axes; for example, the corner for the XZ plane is red and blue.

When you position the mouse over any axis, it turns yellow to indicate that it’s active. Similarly, position the mouse over one of the plane handles, and both associated axes turn yellow. You can now drag the selection along the indicated axis or axes. Doing so changes the Axis Constraints toolbar "Restrict to ..." setting on page 910.
NOTE When no transform tool is active and you select one or more objects, axis tripods appear in the viewport.

The axis tripod appears when the transform gizmo is inactive.

Each axis tripod consists of three lines, labeled X, Y, and Z, and shows you three things:

- The orientation of the tripod reveals the orientation of the current reference coordinate system.
- The location of the junction of the three axis lines shows where the current transform center is.
- The highlighted red axis lines show the current axis constraints on page 910.

Move Gizmo

The Move gizmo includes plane handles, and the option to use a center box handle.
You can select any of the axis handles to constrain movement to that axis. In addition, the plane handles allow you to constrain movement to the XY, YZ, or XZ planes. The selection hotspot is within the square formed by the plane handles. You can change the size and offset of the handles and other settings on the Gizmos panel on page 8354 of the Preferences dialog on page 8298.

The Move gizmo with the YZ axes selected.

You can constrain translation to the viewport plane by dragging the center box. To use this optional control, turn on Move In Screen Space on page 8356.

Rotate Gizmo

The Rotate gizmo is built around the concept of a virtual trackball. You can rotate an object freely, about the X, Y, or Z axis, or about an axis perpendicular to the viewport.
The axis handles are circles around the trackball. Drag anywhere on one of them to rotate the object about that axis. As you rotate about the X, Y, or Z axis a transparent slice provides a visual representation of the direction and amount of rotation. If you rotate more than 360°, the slice overlaps and the shading becomes increasingly opaque. 3ds Max also displays numerical data to indicate a precise rotational measurement.
In addition to XYZ rotation, you can also use free rotation or the viewport handle to rotate objects.

Drag inside the Rotate gizmo (or the outer edge of the gizmo) to perform free rotation. Rotation should behave as if you were actually spinning the trackball.

The outermost circle around the Rotate gizmo is the Screen handle, which lets you rotate the object on a plane parallel to the viewport.

You can adjust settings for the Rotate gizmo on the Gizmos panel on page 8354 of the Preferences dialog on page 8298.

**Scale Gizmo**

The Scale gizmo includes plane handles and scaling feedback through the stretching of the gizmo itself.

The plane handles let you perform uniform and non-uniform scaling without changing your selection on the main toolbar:

- To perform Uniform scaling, drag in the center of the gizmo.
The Transform gizmo with Uniform scaling selected.

- To perform non-uniform scaling, drag on a single axis or a plane handle.
To perform a Squash operation, you must choose Select and Squash on page 920 on the main toolbar.

The Scale gizmo provides feedback by changing its size and shape; in the case of a uniform scale operation, it will grow or shrink as the mouse moves, and during non-uniform scaling, the gizmo will stretch and deform while dragging. However, once the mouse button is released, the gizmo returns to its original size and shape.

You can adjust settings for the Scale gizmo on the Gizmos panel on page 8354 of the Preferences dialog on page 8298.

**Notes**

Using a Transform gizmo sets the default axis constraint to the last axis or plane you used.
If Lock Selection Set is on, you can drag anywhere in the viewport to transform the object. Dragging an axis, however, still applies the constraint along that axis.

See also:

- Gizmos Preferences on page 8354

Procedures

Example: To explore use of the transform gizmo:

1. Reset 3ds Max, then create a sphere, and then click the Select and Move button.
   The Transform gizmo appears at the center of the sphere. Because the default axis constraint on the Axis Constraints toolbar is XY Plane, the X and Y shafts of the Transform gizmo are yellow (active), while the Z shaft is blue.

2. Use Orbit on page 8152 to adjust the Perspective view for a better view of the Transform gizmo. When you’re done, right-click to return to Select And Move.

3. Point to any part of the sphere away from the Transform gizmo, and drag to confirm that the sphere is locked to the XY plane.

4. Point to the Z-axis shaft, and drag.
   The Z shaft turns yellow, the X and Y shafts turn red and green, respectively, and the sphere moves along the Z axis.

5. Point to the Y shaft, and drag.
   The Y shaft turns yellow, and the sphere moves along only the Y axis.

6. Point to the red-and-green corner mark opposite the ends of the X and Y axes, and drag.
   The sphere moves along the XY plane.

7. Press the Spacebar to turn on Selection Lock on page 8079.

8. Drag the mouse anywhere in a viewport away from the selection.
   The sphere moves along the XY plane.
Point to the X shaft, and drag.

The sphere moves along only the X axis.

Experiment with other transformations, such as rotation and scale. Try different reference coordinate systems. Experiment with sub-object transformations.

**Interface**

**Change default colors** Customize menu > Customize User Interface dialog > **Colors panel** on page 8272 > Gizmos Element > Active Transform Gizmo and Transform Gizmo X/Y/Z.

**Enable/disable Transform Gizmo** Customize menu > Preferences > **Gizmos panel** on page 8354 > On check box.

---

**NOTE** When you turn off the Transform gizmo in Preferences, the standard axis tripod appears instead. To toggle display of either the gizmo or the tripod, press the X key or use Views menu > Show Transform Gizmo.

There are additional controls for each Gizmo in the **Gizmos panel** on page 8354 of the Preferences dialog.

---

**Transform Type-In**

Status bar > Transform Type-In

Edit menu > Transform Type-In

F12

Main toolbar > Right-click Select And Move, Select And Rotate, or one of the Select And Scale buttons.

Transform Type-In is a dialog that lets you enter precise values for move, rotate, and scale **transforms** on page 8750. You can use Transform Type-In with anything that can display an axis tripod or Transform gizmo.

You can also use the Transform Type-In boxes on the **status bar** on page 8064. To use the Transform Type-In boxes on the status bar, simply enter the appropriate values in the boxes and press Enter to apply the transformation. You can alternate between entering absolute transform values or offset values by clicking the Relative/Absolute Transform Type-In button to the left of the transform boxes.
If you choose Transform Type-In from the Edit menu, press F12, or right-click one of the transform toolbar buttons, Transform Type-In pops up as a dialog. The title of the dialog reflects the active transform. If Rotate is active, the dialog's title is Rotate Transform Type-In and its controls affect rotation. If Scale is active, its title is Scale Transform Type-In, and so on. You can enter either absolute transform values or offset values.

In most cases, both absolute and offset transforms use the active reference coordinate system on page 922. The exceptions are View, which uses the World coordinate system, and Screen, which uses World for absolute moves and rotations. Also, absolute scaling always uses the Local coordinate system. The dialog labels change to show the reference coordinate system being used.

When you use the Transform Type-In at a sub-object level, you transform the transform gizmo of the sub-object selection. So, for example, the absolute position values represent the absolute world position of the transform gizmo. If you've selected a single vertex, it's the absolute world position of the vertex. If multiple vertices are selected, the Transform gizmo is placed at the center of the selection, so the position you specify in the Transform Type-In sets the absolute position of the center of the selected vertices.

When multiple vertices are selected in Local transform mode, you end up with multiple transform gizmos. In this case, only the Offset control is available. Because the axis tripods are not scaled, the Absolute Scale control is not available at the sub-object level. Only Offset is available.

When you use the Transform Type-In for Absolute rotation, the state of the Center flyout is respected. You can perform absolute rotations about the pivot point of the object, the selection center, or transform coordinate center. See Choosing a Transform Center on page 907.

**Using Type-In with Sub-Object Selection**

You can use Transform Type-In with any sub-object selection or gizmo. The transform affects the axis tripod for the selection. Absolute and offset world coordinates are those of the object's or selection's coordinate system, whose origin is indicated by the axis tripod. If multiple vertices are selected, the tripod is at the center of the selection and its location is given in world coordinates. Because axis tripods cannot be scaled, Absolute Scale fields are unavailable when you are at a sub-object level.

See Basics of Creating and Modifying Objects on page 358 for information on sub-object selection and gizmos.
Procedures

To use transform type-in:

1 Select an object or a group of objects.

2 Choose a transform to perform on the objects (Move, Rotate, or Scale).

3 You can do any of the following, switching from one to another as required:
   - Type a value in an axis field and press Enter to apply the transform change to the object in the viewport.
   - Drag a spinner in an axis field to update the object in the viewport.
   - Drag the object to apply the transform and read the resulting change in the axis fields.
     For example, if Move is active, the fields read out both the absolute positions of the selected object in world space. If no object is selected, the fields turn gray.

Interface

Status bar

Absolute/Offset Mode Transform Type-In When this is off, 3ds Max treats values you enter into the X, Y, and Z fields as absolutes. When this is on, 3ds Max applies transform values you enter as relative to current values; that is, as an offset. Default=off.

X, Y, and Z Display and accept entry for values of position, rotation, and scale along each axis.

Absolute group (Dialog)
X, Y, and Z Display and accept entry for absolute values of position, rotation, and scale along each axis. Position and rotation are always displayed, as world scale is always local.

Offset group (Dialog)

X, Y, and Z Display and accept entry for offsets of the position, rotation, and scale values along each axis.

Displayed offset values revert to 0.0 after each operation. For example, if you enter 45 degrees in a Rotate Offset field, when you press Enter, 3ds Max rotates the object 45 degrees from its previous position, increases the Absolute field value by 45 degrees, and resets the Offset field to 0.0.

Offset labels reflect the active reference coordinate system. The Offset can be Offset: Local, Offset: Parent, and so on. If you use Pick to select the reference coordinate system of a particular object, the Offset will be named with that object.

Animating Transforms

You can animate changes in position, rotation, and scale (transforms) by turning on the Auto Key button and then performing the transform at any frame other than frame 0. This creates a key for that transform at the current frame.

Example: To animate an object moving among three points:

1. Turn on the Auto Key button on page 3373.
   
   The Auto Key button and the highlight border around the active viewport both turn red.

2. Drag the time slider to frame 25.

3. Move the object from its current position (point A) to another location (point B).
   
   3ds Max creates Move keys at frames 0 and 25. These appear on the track bar on page 8071. The establishing key at frame 0 describes the object’s original position, at point A. The key at frame 25 describes the object’s position at point B.

4. Drag the time slider to frame 50.
5 Move the object from point B to a third location (point C).
3ds Max creates a Move key at frame 50 that describes the object’s position at point C.

6 Click the Auto Key button to stop recording.

7 Click the Play button on page 8102.
The object moves from point A to point B over frames 0 to 25, and then proceeds to point C over frames 26 to 50.

8 The Play button has turned into a Stop button; click Stop to stop playback.

You can combine different transforms in a single animation sequence, so that an object appears to move as it rotates and changes in size.

See Animation Concepts and Methods on page 3368 for more information on animation techniques.
Transform Managers

3ds Max provides three controls, collectively referred to as the transform managers, for modifying the action of the transform tools.

The transform manager controls are as follows:

- The Reference Coordinate System drop-down list on page 922, which controls the orientation of the transform axes, is found to the right of the Move, Rotate, and Scale transform buttons on the main toolbar.

- The Transform Center flyout on page 930, which controls the center about which 3ds Max applies the transform, is found to the right of the Reference Coordinate System drop-down list.

- The Axis Constraint setting on page 910 lets you restrict the transform to a single axis or two axes (that is, a plane). The axis constraint tools appear on the Axis Constraints toolbar, which is off by default. You can open the toolbar by right-clicking an empty spot on the main toolbar and choosing Axis Constraints from the menu.

**TIP** You can also restrict transforms with the transform gizmos on page 889.

Definitions

Certain terms are used in the description of transforms and the transform managers.

- **An axis** is a straight line along which an object is moved or scaled, or about which an object is rotated. When you work in 3D, you use three axes, labeled X, Y, and Z, which are oriented 90 degrees from each other.

- **A coordinate system** specifies the orientation of the X, Y, and Z axes used by a transform. For example, in the World coordinate system, as seen from the Front view, the X axis runs horizontally from left to right, the Y axis runs from back to front, and the Z axis runs vertically, from bottom to top.

On the other hand, each object carries its own Local coordinate system. If the object has been rotated, its Local coordinate system might be different from the world coordinate system.

- The **transform center**, or pivot point, is the spot about which a rotation takes place, or to and from which scaling occurs.
Using the transform managers, you can specify any combination of axes, transform coordinate systems, and transform centers.

**Axis Tripod Icon**

An axis tripod appears in the viewports when you select one or more objects, to assist you visually in your transforms. This tripod consists of three lines, labeled X, Y, and Z, and shows you three things:

- The orientation of the tripod reveals the orientation of your coordinate system.
- The location of the junction of the three axis lines shows you where your transform center is.
- The highlighted red axis lines show you the axis or axes to which the transform is constrained. For example, if only the X axis line is red, you can move objects only along the X axis.

**NOTE** The Transform gizmo supplants the axis tripod for selections when a transform mode is active. Besides providing all of the above functions, it lets you specify the transform axis or axes without explicitly setting constraints; see Using the Axis Constraints on page 910. For more on the Transform gizmo, see Using Transform Gizmos on page 889.

You can toggle the display of the axis tripod in all viewports by choosing Views menu > Show Transform Gizmo, or by pressing the X key.

**Transform Manager Settings**

The state of the three transform managers (coordinate system, center, and axis constraints) is stored with each type of transform. When you switch from Move to Rotate to Scale, the transform managers change to whatever combination they were in when you last used that transform.

For example, if you click Rotate and set the transform managers to Local, Selection Center, and Y constraint, when you click Move, the controls might shift to View, Pivot Point, and XY constraint (whichever combination was set the last time you used Move). When you go back to Rotate, the controls revert to Local, Selection Center, and Y constraint.
To avoid surprises, always click the transform button first, and then set the transform managers. If, instead, you first set the transform managers, their settings are likely to change as soon as you choose a new transform button. One way to remember this is always to set the transform and managers by working from left to right on the toolbar. Alternatively, you can turn on Customize menu > Preferences > General tab > Reference Coordinate System group > Constant, which keeps the transform manager settings the same for all transforms.

Specifying a Reference Coordinate System

The reference coordinate system determines the orientation of the X, Y, and Z axes used by the transform. The type of transform system you use affects all transform operations.

You specify the transform coordinate system using the Reference Coordinate System list on page 922.

Creating a Local Axis

While modeling, it's often helpful to have a temporary, movable local axis so you can rotate or scale about an arbitrary center.

NOTE This technique does not work for animation. See Choosing a Transform Center on page 907 for animation tips.

TIP As an alternative to this method, you can use the Working Pivot on page 3766.

To create an adjustable local axis:

1. Create a Point helper object on page 2853.
2. From the Transform Coordinate System list, choose Pick, and then click the point object.
   The name of the point object appears in the list as the active coordinate system.

Now you can use the point object's coordinate system as an adjustable axis.

To use the adjustable axis:

1. Place the point object where you want the rotate or scale transform to be centered.
2 Select the object you want to transform.
3 Choose the point object’s name in the Transform Coordinate System drop-down list.
4 From the Use Center flyout on page 930 choose Use Transform Coordinate Center. For more information, see Choosing a Transform Center on page 907.
5 Proceed with the transform.

Choosing a Transform Center

The transform center affects scale and rotation transforms, but has no effect on position transforms.

3ds Max lets you choose from three types of transform center using the Use Center flyout on page 930 on the main toolbar. When you change the transform center, the junction of the axis tripod icon moves to the location you specify.

By default, 3ds Max sets the transform center to Use Pivot Point center for single objects. When you select multiple objects, the default transform center changes to Use Selection Center, because selection sets have no pivot point. You can change the transform center in either case, and 3ds Max remembers and restores the transform center setting separately for selections of single and multiple objects (during the current session).

TIP You can transform an object’s pivot with the Hierarchy panel > Adjust Pivot controls on page 3763. Alternatively, you can transform objects using the working pivot on page 3766.

For example, you might select a single object and choose Use Transform Coordinate Center, and then select multiple objects and choose Use Pivot Point Center. When you next select a single object, 3ds Max switches back to Use Transform Coordinate Center. Then, when you select multiple objects, the center switches back to Pivot Point.
1. User selects single object.
2. User clicks Use Transform Coordinate Center from Use Center flyout on Main toolbar.
3. User adds second object to selection.
4. Transform center changes to Use Selection Center when selection set contains more than one object.
5. User clicks Use Pivot Point Center while multiple objects still selected.
6. User selects single object.
7. Transform center returns to Use Transform Coordinate Center (see step 2).
8. User selects multiple objects.
9. Transform center returns to Use Pivot Point Center (see step 5).

Transforming About Snapped Points

While the transform center choices are often useful at the object level, they are not usually convenient when transforming sub-object selections. You can override the active transform center and perform the current transform about a temporary point by using snaps. When Snaps is active, and your selection is locked, the point you snap to will set the point about which the transform is performed. Using this technique, you can:

- Move relative to two snap points.
- Rotate about a snapped point.
- Scale about a snapped point.

For more details, see Snap Settings on page 2819.

Animation and the Transform Center

Because of the nature of keyframing, you can animate rotation and scale transforms properly only by using an object’s local pivot point. For example, while modeling, you can rotate an object that’s offset from the world origin around the world center coordinate system. The object sweeps around the origin in a large arc. However, if you attempt to animate this, the object rotates about its local axis and moves in a straight line from one end of the arc to the other.

To avoid this discrepancy, when Auto Key on page 8090 is on and either the Rotate or Scale button is active, the Use Center flyout is unavailable and set to Use Pivot Point. When Auto Key button is off, all transforms use the center settings previously described.

You can override this behavior by turning off Local Center During Animate on page 8349 in the Animation Preferences settings.

Keep in mind that this affects only the center of the transform. The orientation of the selected transform coordinate system is still in effect.
**Animating "Off-Center"**

You can animate a rotation or scale about an off-center point by linking your object as the child of a dummy helper object, and then rotating or scaling the dummy.

Another technique is to offset the pivot point of your object using the Hierarchy panel.

For information about linking, dummy objects, and the Hierarchy panel, see [Hierarchies on page 3618](#).

**Using the Axis Constraints**

Axis Constraints toolbar > Restrict to X, Y, Z, or a plane

Keyboard >

F5 restricts to X
F6 restricts to Y
F7 restricts to Z

F8 cycles through the three plane restrictions

The Restrict to ... buttons, also called the Axis Constraint buttons, are located on the Axis Constraints toolbar on page 8039, which is off by default.

You can turn on the Axis Constraints toolbar by right-clicking an empty spot on the main toolbar and choosing Axis Constraints from the pop-up menu. These buttons let you specify one or two axes about or along which the transform takes place. They help you avoid transforming an object in a direction you didn't intend.

**NOTE** It's generally easier to use the Transform gizmos than these buttons; see [Using Transform Gizmos on page 889](#). However, it is helpful to understand the concepts explained below.
Axis Constraint buttons

Only one axis constraint can be active at a time. When a button is turned on, transforms are constrained to the specified axis (or plane). For example, if you turn on the Restrict To X button, you can rotate an object only about the X axis of the current transform coordinate system.

The axis or axes to which you’re constrained are highlighted in red on the axis tripod icon in viewports, or in yellow on the Transform gizmo.

**NOTE** By default, axis constraints don’t apply when using Snap. You can override this by turning on Snaps Use Axis Constraint Toggle on the Axis Constraints toolbar on page 8039, or by turning on Use Axis Constraints in Snap Options on page 2828.

**NOTE** Constraints are set on a transform-by-transform basis, so select the transform before you select the axis constraint. If you do not want the constraints to change, turn on Customize menu > Preferences > General tab > Reference Coordinate System group > Constant.

The axis constraints are stored separately at object and sub-object levels. If you set these three controls one way while in sub-object mode and another way while in object selection level, when you return to sub-object mode, they’re restored to the way they were previously set. For example, if you're using XY constraints at object level, then switch to sub-object level and use Z constraint, when you return to object level, XY will be restored.
**Restrict to Plane Flyout**

The Restrict To Plane flyout, available from the Axis Constraints toolbar, lets you limit all transformations (move, rotate, scale) to the XY, YZ, or ZX planes (by default, parallel with the Top view).

You can also select planar constraint by using the Move Transform Gizmo on page 889. Instead of dragging one of the axis indicators, drag one of the plane indicators near the center of the gizmo.

When you move an object along a plane that is head-on to your view, the object moves along the single available axis shown in the view.

**Reset XForm Utility**

Utilities panel > Utilities rollout > Reset XForm button

Use the Reset XForm (Transform) utility to push object rotation and scaling values onto the modifier stack and align object pivot points and bounding boxes with the World coordinate system. Reset XForm removes all Rotation and Scale values from selected objects and places those transforms in an XForm modifier.

To reset the transform of a group, use the Transform button in the Reset group box of the Hierarchy > Pivot command panel.

**Procedures**

**To reset an object's transform:**

1. Select an object.
2. On the Utilities panel, click Reset XForm.
3. On the Utilities panel > Utilities rollout, click the More button and choose Reset XForm.
4 On the Reset Transform rollout, click Reset Selected. Object rotation and scaling are now carried by an XForm modifier placed at the top of the modifier stack.

When you apply the Reset Transform utility, an XForm modifier on page 2010 that carries the rotation and scale values is placed at the top of the Modifier Stack display. You can apply other modifiers above and below the XForm modifier. You can select the XForm modifier and add other Move, Rotate, and Scale transforms. You can delete the XForm modifier to completely remove the transforms from the object. You can collapse the object to absorb the rotation and scale values into the object mesh.

Interface

Reset Selected Removes all Rotation and Scale values from selected objects and places those transforms in an XForm modifier.

NOTE Reset Selected is not available if the object is contained in a Group on page 243.

Transform Commands

The basic transform commands are the most straightforward way to change an object’s position, rotation, or scale. These commands appear on the default main toolbar on page 8035. They are also available from the default quad menu on page 8052.
Select and Move

Main toolbar > Select and Move
Right-click an object. > quad menu > Transform quadrant > Move
Edit menu > Select and Move

Use the Select And Move button or the Move command on the Edit or quad menu to select and move objects.

To move a single object, you do not need to select it first. When this button is active, clicking an object selects it and dragging the mouse moves it.

The direction of the movement is determined both by your mouse and by the current reference coordinate system. To restrict object movement to the X, Y, or Z axis, or to any two axes, click the appropriate button on the Axis Constraints toolbar on page 8039, use the Transform gizmo on page 889, or right-click the object, and select the constraint from the Transform submenu.
Moving an object

See also:

■ Move Gizmo on page 892

Select and Rotate

Main toolbar > Select and Rotate
Right-click an object. > quad menu > Transform quadrant > Rotate
Edit menu > Select and Rotate
Use the Select and Rotate button or the Rotate command on the Edit or quad menu to select and rotate objects.

To rotate a single object, you don't need to select it first. When this button is active, clicking an object selects it and dragging the mouse rotates it.
When you are rotating an object about a single axis (as is usually the case), don't rotate the mouse, expecting the object to follow the mouse movement. Just move the mouse straight up and straight down. Up rotates the object one way, down rotates it the opposite way.

The center of rotation is determined by the Transform Center setting on page 922.

To restrict rotation about the X, Y, or Z axis, or to any two axes, click the appropriate button on the Axis Constraints toolbar on page 8039, use the Transform gizmo on page 889, or right-click the object, and select the constraint from the Transform submenu.

Rotating an object

See also:
- Rotate Gizmo on page 893

Procedures

This procedure illustrates the intuitive usage of the default Euler XYZ rotation controller on page 3453.
To animate object rotation interactively:

1. Add an object.

2. Move the time slider to a frame other than 0 and turn on Auto Key.

3. Choose Select And Rotate.

4. Rotate the object on any axis by any amount.

5. Move the time slider to a later frame.

6. Rotate the object on the same axis by an amount greater than 180 degrees.

7. Play back the animation.
   The rotation plays back exactly as you recorded it.

---

**Select and Scale**

Main toolbar > Select and Scale flyout
Right-click an object. > quad menu > Transform quadrant > Scale
Edit menu > Select and Scale

The Select And Scale flyout on the main toolbar provides access to three tools you can use to change object size.

From top to bottom, these are:

- Select and Uniform Scale on page 918
- Select and Non-Uniform Scale on page 919
- Select and Squash on page 920
In addition, the Scale command is available on the Edit menu and the Transform quadrant of the quad (right-click) menu; this activates whichever scale tool is currently chosen in the flyout.

**NOTE** The Smart Scale command activates the Select And Scale function and, with repeated invocations, cycles through the available scaling methods. By default, Smart Scale is assigned to the R key; you can use Customize User Interface on page 8249 to assign it to a different keyboard shortcut, a menu, etc.

### Select and Uniform Scale

Main toolbar > Select and Uniform Scale (on Select And Scale flyout)

Right-click an object. > Scale (selects current toolbar Scale mode)

The Select And Uniform Scale button, available from the Select And Scale flyout on page 917, lets you scale objects by the same amount along all three axes, maintaining the object's original proportions.

Uniform scale does not change an object's proportions.
To scale a single object, you don't need to select it first. When this tool is active, clicking an object selects it and dragging the mouse scales it.

See also:

- Scale Gizmo on page 895

Select and Non-Uniform Scale

Main toolbar > Select and Non-Uniform Scale (on Select And Scale flyout)
Right-click an object. > Scale (selects current toolbar Scale mode)

The Select And Non-Uniform Scale button, available from the Select And Scale flyout on page 917, lets you scale objects in a non-uniform manner according to the active axis constraint.

Non-uniform scale can change proportions with different values for different axes.
You can restrict the objects' scaling about the X, Y, or Z axis, or to any two axes, by first clicking the appropriate button on the Axis Constraints toolbar on page 8039, or with the Transform gizmo on page 889.

To scale a single object, you don't need to select it first. When this tool is active, clicking an object selects it and dragging the mouse scales it.

**IMPORTANT** Avoid applying non-uniform scale at the object level. Non-uniform scaling is applied as a transform and changes the axes of the object, so it affects other object properties. It also alters the properties passed hierarchically from parent to child. When you perform other operations on the object, such as rotation, inverse kinematic calculations, and other positioning operations, you might not get the results you expect. To recover from these problems, use the Hierarchy panel's Reset Scale button or the Utilities panel's Reset XForm utility. Either of these options will reset the axes to use the non-uniform scale as the fundamental scale for the object.

As an alternative to non-uniform scaling, consider using the XForm modifier on page 2010.

See also:
- Scale Gizmo on page 895

**Select and Squash**

Main toolbar > Select And Squash (on Select And Scale flyout)

Right-click an object. > Scale (selects current toolbar Scale mode)

The Select And Squash tool is useful for creating different phases of the “squash and stretch”-style animation often found in cartoons. The Select And Squash tool, available from the Select And Scale flyout on page 917, lets you scale objects according to the active axis constraint. Squashing an object always involves scaling down on one axis while simultaneously scaling up uniformly on the other two (or vice-versa).
Squash scales two axes in opposite directions, maintaining the object’s original volume.

You can restrict object scaling to the X, Y, or Z axis, or to any two axes, by first clicking the appropriate button on the Axis Constraints toolbar on page 8039.

When the Select And Squash tool is active, clicking an object selects it and dragging the mouse scales it.

**IMPORTANT** Avoid using Select And Squash at the object level. The non-uniform scaling that it effects is applied as a transform and changes the axes of the object, so it affects other object properties. It also alters the properties passed hierarchically from parent to child. When you perform other operations on the object, such as rotation, inverse kinematics calculations, and other positioning operations, you may not get the results you expect. To recover from these problems, use the Hierarchy panel’s Reset Scale button or the Utilities panel’s Reset XForm utility. Either of these options will reset the axes to use the non-uniform scale as the fundamental scale for the object.

As an alternative to non-uniform scaling with Select And Squash, consider using the XForm modifier on page 2010.
See also:
- Scale Gizmo on page 895

## Transform Coordinates and Coordinate Center

Controls for setting the coordinate system and the active center for transforms to use are on the default main toolbar on page 8035.

![Reference Coordinate System list](image)

See also:
- Moving, Rotating, and Scaling Objects on page 885

## Reference Coordinate System

Main toolbar > Reference Coordinate System list

The Reference Coordinate System list lets you specify the coordinate system used for a transformation (Move, Rotate, and Scale). Options include View, Screen, World on page 8768, Parent, Local on page 8621, Gimbal, Grid, Working on page 3766, and Pick.

In the Screen coordinate system, all views (including perspective views) use the viewport screen coordinates.

View is a hybrid of World and Screen coordinate systems. Using View, all orthographic views use the Screen coordinate system, while perspective views use the World coordinate system.
TIP The coordinate system is set on a transform-by-transform basis, so choose the transform before you specify the coordinate system. If you do not want the coordinate system to change, turn on Customize menu > Preferences > General panel > Ref. Coord. System group > Constant.

Interface

View In the default View coordinate system, X, Y, and Z axes are the same in all orthographic viewports. When you move an object using this coordinate system, you are moving it relative to the space of the viewport.

- X always points right.
- Y always points up.
- Z always points straight out of the screen toward you.
Different orientations of the View coordinate system:

1. Top viewport.
2. Front viewport.
3. Left viewport.
4. Perspective viewport.

**Screen** Uses the active viewport screen as the coordinate system.
- X is horizontal, running in a positive direction toward the right.
- Y is vertical, running in a positive direction upward.
- Z is depth, running in a positive direction toward you.

Because the Screen mode depends on the active viewport for its orientation, the X, Y, and Z labels on an axis tripod on page 905 in an inactive viewport show the orientation of the currently active viewport. The labels on that tripod change when you activate the viewport it is in.
The coordinate system in Screen mode is always relative to the point of view.

World Uses the world coordinate system. Seen from the front:
- X runs in a positive direction to the right.
- Z runs in a positive direction upward.
- Y runs in a positive direction away from you.
The World coordinate system is always fixed.

**NOTE** The world axis shows the current orientation of the viewport with respect to world coordinate system. You can find it in the lower-left corner of each viewport. The world axis colors are red for X, green for Y, and blue for Z. You can toggle the display of the world axis in all viewports by turning off Display World Axis on page 8311 on the Viewports panel of the Preference Settings dialog.

The world axis shows the current viewport orientation.
**Parent** Uses the coordinate system of the parent of the selected object. If the object is not linked to a specific object, it’s a child of the world, and the parent coordinate system is the same as the world coordinate system.

**Example of a Parent object coordinate system**

**Local** Uses the coordinate system of the selected object. An object’s local coordinate system is carried by its pivot point on page 8686. You can adjust the position and orientation of the local coordinate system, relative to its object, using the options on the Hierarchy command panel.

When Local is active, the Use Transform Center button is inactive and all transforms use the local axis as the center of transformation. In a selection set of several objects, each uses its own center for the transform.
Local uses an individual coordinate system specific to each object.

**Gimbal** The Gimbal coordinate system is meant to be used with the Euler XYZ Rotation controller on page 3453. It is similar to Local, but its three rotation axes are not necessarily perpendicular to each other.

When you rotate about a single axis with the Local and Parent coordinate systems, this can change two or three of the Euler XYZ tracks. The Gimbal coordinate system avoids this problem: Euler XYZ rotation about one axis changes only that axis’s track. This makes function curve editing easier. Also, absolute transform type-in with Gimbal coordinates uses the same Euler angle values as the animation tracks (as opposed to Euler angles relative to the World or Parent coordinate system, as those coordinate systems require).

For move and scale transforms, Gimbal coordinates are the same as Parent coordinates. When the object does not have an Euler XYZ Rotation controller assigned, Gimbal rotation is the same as Parent rotation.

The Euler XYZ controller can be the active controller in a List controller, too.

**Grid** Uses the coordinate system of the active grid.
Using an active grid coordinate system.

**Working** Uses the coordinate system of the working pivot on page 3766. You can use this coordinate system at any time, whether or not the working pivot is active. When **Use Working Pivot** on page 3769 is on, this is the default coordinate system.

**Pick** Uses the coordinate system of another object in the scene. After you choose Pick, click to select the single object whose coordinate system the transforms will use. The object's name appears in the Transform Coordinate System list.

Because 3ds Max saves an object's name in the list, you can pick an object's coordinate system, change the active coordinate system, and then use the object's coordinate system again at a later time. The list saves the four most recently picked object names.

When using Pick to specify an object as a reference coordinate system, you can press H to open the Pick Object dialog, which works like **Select From Scene** on page 206, and pick the object from there.

**NOTE** You can pick objects within an XRef scene as coordinate reference system.
Using another object as the coordinate system

**Use Center Flyout**

Main toolbar > Use Center flyout

The Use Center flyout provides access to three methods you can use to determine the geometric center for scale and rotate operations.

From top to bottom, they are:

[Use Pivot Point Center on page 931]
Use Pivot Point Center

Main toolbar > Use Pivot Point Center (on Use Center flyout)

The Use Pivot Point Center option, available from the Use Center flyout on page 930, lets you enable rotation or scaling of one or more objects around their respective pivot points on page 8686. When Auto Key on page 8090 is active, Use Pivot Point Center is automatically chosen and no other option is available. The axis tripods on page 905 show the centers that are currently being used.

**NOTE** The transformation center mode is set on a transform-by-transform basis, so select the transform before you select the center mode. If you do not want the center setting to change, turn on Customize menu > Preferences > General tab > Reference Coordinate System group > Constant.
Applying a rotation with the Pivot Point rotates each object around its own local axis.

**Rotating Multiple Linked Objects**

When rotating a chain of linked objects (that is, a hierarchy) with Use Pivot Point Center active, the rotation is applied equally to each object...
in the chain. This results in accumulated rotations, which makes it easy to animate such effects as fingers curling.

Use Selection Center

Main toolbar > Use Selection Center (on Use Center flyout)

The Use Selection Center button, available from the Use Center flyout on page 930, lets you enable rotation or scaling of one or more objects around their collective geometric center. If you transform multiple objects, 3ds Max calculates the average geometric center of all the objects and uses that for the transform center.
The *axis tripod* on page 905 shows the center that is currently being used.

**NOTE** The transformation center mode is set on a transform-by-transform basis, so select the transform before you select the center mode. If you do not want the center setting to change, turn on Customize menu > Preferences > General tab > Reference Coordinate System group > Constant.

With the Selection Center option, an averaged coordinate system is used to rotate the objects.

**Use Transform Coordinate Center**

Main toolbar > Use Transform Coordinate Center (on Use Center flyout)

The Use Transform Coordinate Center button, available from the Use Center flyout on page 930, lets you enable rotation or scaling of an object or objects around the center of the current coordinate system. When you designate another object as the coordinate system with the Pick function (see Specifying
a Reference Coordinate System on page 906), the coordinate center is the location of that object's pivot.

The axis tripod on page 905 shows the center that is currently being used.

**NOTE**  The transformation center mode is set on a transform-by-transform basis, so select the transform before you select the center mode. If you do not want the center setting to change, turn on Customize menu > Preferences > General tab > Reference Coordinate System group > Constant.

An example of the World coordinate center

**Transform Tools**

The transform tools can transform objects according to certain conditions. Some of them, such as Array, can also create copies of objects.

These tools (except for Array, Snapshot, Spacing Tool, and Clone And Align) are available on the default main toolbar on page 8035; the remainder are on the Extras toolbar on page 8041. Also, they all appear on the default Tools menu on page 8001.
See also:

- Moving, Rotating, and Scaling Objects on page 885
- Using Shift+Clone on page 996
- Creating Copies and Arrays on page 981

Transform Toolbox

Edit menu > Transform Toolbox

The Transform Toolbox contains functions for easy object rotation, scaling, and positioning as well as for moving object pivots.

Interface
Quick Navigation

- **Rotate group** on page 937
- **Size group** on page 938
- **Align Pivot group** on page 939
- **Object group** on page 939

**Rotate group**

Rotates the current selection (including sub-objects) clockwise and counter-clockwise based on the view direction; clockwise always rotates clockwise in the current view. Align the view roughly to any axis and click an arrow button to rotate the object by the amount specified by the Degrees value. If the Reference Coordinate System on page 922 is set to Local, you can rotate the object on its local axis by first aligning the view roughly to the object’s local axis. If the coordinate system is set to Screen, the object will be rotated accordingly.

The drop-down list on the left side is for quickly selecting a predefined rotation amount.

**NOTE** You can assign CUI shortcuts on page 8249 (PolyTools category) for both Rotate commands. When assigned as shortcuts, the Rotate functions work as follows:

- **Normal (no key)** Rotates 90 degrees.
- **Shift** Rotates 30 degrees.

[presets list] Opens a list of rotation-amount presets; click one to place it in the Degrees field.

[Rotate Counter-clockwise] Click to rotate the selection counter-clockwise (roughly) about the view direction by the Degrees amount.
Rotate Clockwise Click to rotate the selection clockwise (roughly) about the view direction by the Degrees amount.

Degrees The amount of rotation applied by either of the Rotate buttons. To change the value, use the drop-down list, keyboard, or spinner controls.

Size group

Sets the size in 3ds Max units for the selected object on a single axis or all axes simultaneously.

TIP You can use this feature to set an object’s size on any axis or all three axes to its previous size on one axis. First choose the axis and click Put Size, then choose a different axis or All and click Set Size.

Set Size Applies the Size value to the object on the current axis or axes, thus resizing it.

R Resets the object’s transform. Applies a Reset Xform on page 912 and converts it to the base geometry type, such as editable poly.

Size The size that is applied when you click Set Size. Edit this value with the keyboard or mouse (spinner), or retrieve the object’s current size with the Put Size button (see following).

X/Y/Z/All Choose the axis or axes on which to resize when you click Set Size. Also determines which axis size to retrieve with Put Size (see following).

Get Opens a small, non-modal dialog that shows the dimensions of the selected object’s bounding box on all three axes. If you change the size, the displayed values update automatically.
**Put Size** Places the dimension value specified by the current axis choice in the Size field. If All is chosen, has no effect.

**Align Pivot group**

These tools align the pivot on page 8686 of the selected object. Choose the location to move the pivot to and then click X, Y, or Z.

[align location] Choose the location to which the pivot moves when you click an axis button:

- **Min** Moves the pivot to the minimum value of the object's bounding box on the specified axis.
- **Max** Moves the pivot to the maximum value of the object's bounding box on the specified axis.
- **Center** Moves the pivot to the center of the object on the specified axis.
- **Origin** Moves the pivot to the center of the world on the specified axis.

**X/Y/Z** Specifies the axis to work on and also applies the operation.

- **Center** Moves the pivot to the center of the object on all three axes.
- **Origin** Moves the pivot to the center of the world on all three axes.

**Object group**

- **Center** Moves the object to the center of the world (origin).

**QClone (Quick Clone)** Makes a copy of the selected object and moves it to the side by the same amount as the object's width. Align the view roughly to any axis and apply.

Like the Rotate tool (see preceding), QClone works based on the direction the object is viewed in the viewport. In general it moves the clone to the right, except when the model is viewed from above or below, in which case it moves the clone toward the point of view.

Uses the following keyboard modifiers:

- **Normal (no key)** Makes a copy of the selected object.
- **Shift** Makes an instanced copy of the selected object.
- **Alt** Makes two copies or instances of the selected object. (Does not apply to use as a shortcut.)
If the distance the clone moves is too little or too much, reset the object’s transform first. Use the **R button** on page 938 in the Size group, or use **Reset Xform** on page 912.

---

**Mirror Selected Objects**

Main toolbar > Mirror Selected Objects

Tools menu > Mirror

Clicking Mirror displays the Mirror dialog, which enables you to move one or more objects while mirroring their orientation.

The Mirror dialog also allows you to mirror the current selection about the center of the current coordinate system. You can create a clone with the mirror dialog at the same time. If you mirror a hierarchical linkage, you have the option to mirror the IK limits.

![Mirroring an object](image-url)
The Mirror dialog uses the current reference coordinate system on page 922, as reflected in its name. For example, if Reference Coordinate System is set to Local, the dialog is named Mirror: Local Coordinates. There is one exception: If Reference Coordinate System is set to View, Mirror uses Screen coordinates.

As you adjust the various settings in the Mirror dialog, you see the results in the viewports.

For more information on using Mirror, see Mirroring Objects on page 1026.

**Procedures**

**To mirror an object:**

1. Make any object selection.

2. Click Mirror on the Main toolbar, or choose Tools menu > Mirror.
   The Mirror dialog opens.

3. Set the mirror parameters in the dialog and click OK.
   The active viewport changes to show the effect of each parameter as you set it. When you click OK, 3ds Max creates the choice of mirror that you see previewed.

**To make a clone using mirror:**

1. Make any object selection.

2. Click Mirror on the Main toolbar, or choose Tools menu > Mirror.
   The Mirror dialog opens.

3. In the Clone Selection group, choose Copy, Instance, or Reference.

4. Make any additional settings as desired and then click OK.
Interface

Mirror Axis group

The mirror axis choices are X, Y, Z, XY, XZ, and YZ. Choose one to specify the direction of mirroring. These are equivalent to the option buttons on the Axis Constraints toolbar on page 8039.

Offset Specifies the distance of the mirrored object's pivot point from the original object's pivot point.

Clone Selection group

Determines the type of copy made by the Mirror function. Default is No Clone.

No Clone Mirrors the selected object without making a copy.
Copy Mirrors a copy of the selected object to the specified position.

Instance Mirrors an instance on page 8611 of the selected object to the specified position.

Reference Mirrors a reference on page 8699 of the selected object to the specified position.

If you animate on page 3368 the mirror operation, mirroring generates a Scale key. If you set Offset to a value other than 0.0, mirroring also generates Position keys.

________

Mirror IK Limits Causes the IK constraints to be mirrored (along with the geometry) when you mirror the geometry about a single axis. Turn this off if you don’t want the IK constraints to be affected by the mirror command.

The end effectors used by the IK are not affected by the Mirror command. To successfully mirror an IK hierarchy, first delete the end effectors: Go to the Motion panel > IK Controller Parameters rollout > End Effectors group and, under Position, click the Delete button. After the mirror operation, create the new end effector using the tools on the same panel.

Array Flyout

Extras toolbar > Array flyout

The Array flyout, available from the Extras toolbar on page 8041, provides access to various tools for creating arrays of objects.

From top to bottom, these are:

Array on page 944

Snapshot on page 950
Array

Extras toolbar > Array
Tools menu > Array

The Array command displays the Array dialog, which enables you to create an array of objects based on the current selection.

A one-dimensional array

The items in the Array Dimensions group let you create one-, two-, and three-dimensional arrays. For example, a row of five objects is a single-dimension array, even though it takes up three-dimensional space in the scene. An array of objects that's five rows by three columns is a...
two-dimensional array, and an array of objects that's five rows by three
columns by two levels is a three-dimensional array.

**TIP** You can preview the array by turning on the Preview button. With Preview on, changing the array settings updates the viewports in real time.

For more information on using Array, see *Arranging Objects* on page 1009.

**Procedures**

**To create an array:**

1. Select the objects to array.
2. Click the Array button, or choose Tools > Array.
3. Choose Tools > Array.
4. On the Array dialog, select the type of object to output: Copy, Instance, on page 8611 or Reference on page 8699).
5. In the Preview group, click the Preview button to turn it on. This lets you see the results of the array operation in the viewports, with changes appearing in real time.
6. In the Array Transformation group, click the arrows to set Incremental or Totals array parameters for Move, Rotate, and Scale.
7. Enter coordinates for the array Transformation parameters.
8. Indicate whether you want a 1D, 2D, or 3D array.
9. Set Count to the number of copies on each axis.
10. Enter the appropriate values in the numeric fields for Incremental Row Offsets.
11. Click OK. The current selection is duplicated the specified number of times, with each object transformed as indicated.

**To replace an array:**

1. Undo the array to replace, using Edit > Undo Create Array, or press Ctrl+Z.
2 Change the coordinate system and transform center, if needed.

3 Click the Array button, or choose Tools > Array, and adjust any parameters on the Array dialog that is displayed.

4 Choose Tools > Array, and adjust any parameters on the Array dialog that is displayed.

5 Click OK to create a new array, which replaces the previous version. Repeat these steps to fine-tune the array.

Example: To create an array of objects that numbers 5 x 4 x 3:

1 Create a teapot with a radius of 10 units.

2 Choose Tools > Array to display the Array dialog.

3 In the Incremental set of parameters, set Move X (the upper-left field) to 50. This causes each object in the array to be positioned 50 units apart on the X axis.

4 In the Array Dimensions group, choose the 3D button to enable all the spinners in that group.

5 Set the 1D Count spinner to 5, the 2D Count spinner to 4, and the 3D Count spinner to 3.

   This creates a row of 5 objects that are 50 units apart, and then 4 rows of those five objects, and then 3 rows of the 5 x 4 matrix of objects, resulting in a box array.

6 In the 2D row, set the Y spinner to 80.

7 In the 3D row, set the Z spinner to 100.

8 Click OK.

   A box array of teapots appears. The first dimensional array is five teapots created along the X world axis, 50 units apart (as specified in the Array Transform group). The second dimensional array is four layers created along the Y world axis, 80 units apart (as specified in the Array Dimensions group). The third dimensional array is three layers created along the Z world axis, 100 units apart. The total number of objects in the array is 60.
Example: To create a 360-degree array:

1. Reset 3ds Max.

2. Near the top of the Front viewport (away from its center), create a long, thin box at the twelve-o’clock position (as if the viewport were a clock face).

3. From the User Center flyout on the main toolbar, choose Use Transform Coordinate Center.


5. Click the arrow button to the right of the Rotate label to enable the three Rotate fields in the Totals section.

6. Set the Z parameter to 360.0.

7. In the Array Dimensions group, choose 1D and set Count to 12.

8. Click OK.

   3ds Max creates an array of 12 boxes in a full circle.

Interface

![Array interface](image)
Array Transformation group

Specifies which combination of the three transforms to use to create the array. You also specify the extent, along the three axes, for each transform. You can specify the extent of the transform in increments between each object, or in totals for all objects. In either case, the distances are measured between the pivot points of the objects. The arrays occur using the current transform settings, so the group title changes depending on the transform settings.

Click the left or right arrow button for Move, Rotate, or Scale to indicate whether you want to set Incremental or Total array parameters.

Incremental

Move Specifies the distance between each arrayed object along the X, Y, and Z axes, in units.

Rotate Specifies the degree of rotation about any of the three axes for each object in the array, in degrees.

Scale Specifies the percentage of scale along any of the three axes for each object in the array, in percentages.

Totals

Move Specifies the overall distance, along each of the three axes, between the pivot points of the two outer objects in the resulting array. For example, if you'rearraying 6 objects and set Move X total to 100, the six objects will be arrayed in a row that's 100 units between the pivot points of the two outer objects in the row.

Rotate Specifies the total degrees of rotation applied to the objects along each of the three axes. You can use this, for example, to create an array that totals 360 degrees.

Re-Orient Rotates the generated objects about their local axes while rotating them about the world coordinates. When clear, the objects maintain their original orientation.

Scale Specifies the total scale of the objects along each of the three axes.

Uniform Disables the Y and Z spinners and applies the X value to all axes, resulting in a uniform scale.
**Type of Object group**

Determine the type of copies made by the Array function. The default is Copy.

**Copy** Arrays copies of the selected object to the specified position.

**Instance** Arrays instances of the selected object to the specified position.

**Reference** Arrays references of the selected object to the specified position.

**Array Dimensions group**

 Lets you add to the Array Transformation dimension. The additional dimensions are positional only. Rotation and scale are not used.

**1D** Creates a one-dimensional array, based on the settings in the Array Transformation group.

**Count** Specifies the total number of objects along this dimension of the array. For 1D arrays, this is the total number of objects in the array.

**2D** Creates a two-dimensional array.

**Count** Specifies the total number of objects along this second dimension of the array.

**X/Y/Z** Specifies the incremental offset distance along each axis of the second dimension of the array.

**3D** Creates a three-dimensional array.

**Count** Specifies the total number of objects along this third dimension of the array.

**X/Y/Z** Specifies the incremental offset distance along each axis of the third dimension of the array.

---

**Total in Array** Displays the total number of entities that the array operation will create, including the current selection. If you’re arraying a selection set, the total number of objects will be the result of multiplying this value times the number of objects in the selection set.

**Preview** Toggles a viewport preview of the current array settings. Changing a setting updates the viewports immediately. If the update slows down feedback with large arrays of complex objects, turn on Display As Box.
**Display as Box** Displays the array-preview objects as bounding boxes instead of geometry.

**Reset All Parameters** Resets all the parameters to their default settings.

---

**Snapshot**

Extra toolbar > Snapshot (on Array flyout)

Tools menu > Snapshot

Choosing Tools > Snapshot opens the Snapshot dialog. This enables you to clone an animated object over time.

---

Using an ice-cream cone animated along a path, Snapshot creates a stack of cones.

Snapshot spaces the clones equally in time. Adjustments in Track View let you space the clones equally along the path instead (see the second procedure, below).
Like other clone techniques, Snapshot creates copies, instances, or references. You can also choose a mesh option for use with particle systems.

**Particle Snapshots**

You can clone particle systems as static mesh objects. You can also produce clones of the particles themselves as meshes, when using the Snapshot dialog > Clone Method > Mesh option. This works with all configurations of particle systems, including those using MetaParticles. Usage is the same as with other types of objects.

**Procedures**

**To clone an object over time:**

1. Select an object with an animation path.
   
   Snapshot also shows the effect of any other transform animations, such as rotate or scale as well as parametric modifier animation.

2. Click the Snapshot button on the Extras toolbar > Array flyout, or choose Tools menu > Snapshot.

3. Set parameters in the dialog, and click OK.

**To space clones evenly by distance:**

1. Select an object with an animated position.

2. Open Track View and find the Position track for the original object.

3. Click Assign Controller and check that the track is using a Bezier Position controller. Do one of the following:
   
   - If the track is already using a Bezier Position controller, proceed to step 4.
   
   - If the track is not using a Bezier Position controller, change the controller on page 3897, then proceed to step 4.

4. Select all the transform keys and right-click one of the selected keys to display the Key Info dialog on page 3418.

5. Click Advanced to expand the dialog.
6 Click Normalize Time.
7 Set Constant Velocity on.
8 Choose Tools menu > Snapshot. The Snapshot dialog appears.
9 Set parameters in the dialog, and click OK.

Interface

**Snapshot group**

**Single** Makes a clone of the geometry of the object at the current frame.

**Range** Makes clones of the geometry of the object along the trajectory over a range of frames. Specify the range with the From/To settings and the number of clones with the Copies setting.

**From/To** Specifies the range of frames to place the cloned object along the trajectory.
Copies Specifies the number of clones to place along the trajectory. They are evenly distributed over the time period, but not necessarily over the spatial distance along the path.

Clone Method group

With the Copy, Instance, and Reference methods, the clone retains any animation within the object, so all the clones will be animated in the same way.

Copy Clones copies of the selected object.

Instance Clones instances on page 8611 of the selected object. Not available with particle systems.

Reference Clones references on page 8699 of the selected object. Not available with particle systems.

Mesh Use this to create mesh geometry out of particle system. Works with all kinds of particles.

Spacing Tool

Extras toolbar > Spacing Tool (on Array flyout)

Tools menu > Spacing Tool

The Spacing tool lets you distribute objects based on the current selection along a path defined by a spline or a pair of points.

The distributed objects can be copies, instances on page 8611, or references on page 8699 of the current selected object. You define a path by picking a spline or two points and by setting a number of parameters. You can also specify how the spacing between objects is determined and whether the pivot points of the objects align to the tangent of the spline.
The Spacing tool distributes the vases along the sides of the curved street. The vases are all the same distance from each other; fewer appear on the shorter side.

**TIP** You can use compound shapes containing multiple splines as the spline path for distributing objects. Before creating shapes, turn off Start New Shape on the Create panel. Then create your shapes. 3ds Max adds each spline to the current shape until you turn Start New Shape back on. When you select the compound shape so that the Spacing tool can use it as a path, objects are distributed along all of the splines of the compound shape. For example, you might find this technique useful in spacing light standards along a path defined by separated splines.

You can pick splines within an XRef scene as path reference.

For more information, see Using the Spacing Tool on page 1027.

**Procedures**

**To distribute objects along a path:**

1. Select the objects to distribute.
2 Click Spacing Tool, or choose Tools menu > Spacing Tool.

**NOTE** The Spacing tool is also available on rollouts for various components of the Railing object on page 482.

3 On the Spacing Tool dialog, click Pick Path or Pick Points to specify a path.
   If you click Pick Path, select a spline from your scene to use as the path.
   If you click Pick Points, pick a start and an end to define a spline as the path. When you're finished with the Spacing tool, 3ds Max deletes this spline.

4 Choose a spacing option from the Parameters list.
   The parameters available for Count, Spacing, Start Offset, and End Offset are dependent on the spacing option you choose.

5 Specify the number of objects to distribute by setting the value of Count.

6 Depending on the spacing option you choose, adjust the spacing and offsets.

7 Under Context, choose Edge to specify that spacing be determined from the facing edges of each object's bounding box, or choose Centers to specify that spacing be determined from the center of each object's bounding box.

8 Turn on Follow if you want to align the pivot points of the distributed objects to the tangent of the spline.

9 Under Type of Object, select the type of object to output (copy, instance on page 8611, or reference on page 8699).

10 Click Apply.
The Spacing tool gives you a choice of two basic methods for setting spacing: using a path, or specifying endpoints explicitly.

**Pick Path** Click this, and then click a spline in the viewport to use as the path. 3ds Max uses the spline as the path along which to distribute objects.

**Pick Points** Click this, and then click a start and an end to define a path on the construction grid. You can also use object snap to specify points in space. 3ds Max uses these points to create a spline as the path along which to distribute objects. When you’re finished with the Spacing tool, 3ds Max deletes the spline.

**Parameters group**

**Count** The number of objects to distribute.

**Spacing** Specifies the space in units between the objects. 3ds Max determines this spacing based on whether you chose Edges on page 960 or Centers on page 960.
**Start Offset** The number of units specifying an offset from the start of the path. Clicking the lock icon locks the start offset value to the spacing value and maintains the count.

**End Offset** The number of units specifying an offset from the end of the path. Clicking the lock icon locks the end offset value to the spacing value and maintains the count.

**Distribution drop-down list** This list contains a number of options for how to distribute the objects along the path, as follows:

- **Free Center** Distributes equally spaced objects along a straight line toward the end point of the path, beginning at the start of the path. A spline or a pair of points defines the path. You specify the number of objects and the spacing.

- **Divide Evenly, Objects at Ends** Distributes objects along a spline. The group of objects is centered at the middle of the spline. The Spacing tool evenly fills the spline with the number of objects you specify and determines the amount of space between objects. When you specify more than one object, there are always objects at the ends of the spline.

- **Centered, Specify Spacing** Distributes objects along a path. The group of objects is centered at the middle of the path. The Spacing tool attempts to evenly fill the path with as many objects as it can fit along the length of the path using the amount of space you specify. Whether there are objects at the ends of the path depends on the length of the path and the spacing you provide.

- **End Offset** Distributes the number of objects you specify along a straight line. The objects begin at an offset distance that you specify. This distance is from the end of the spline to its start point, or from the second pair of points to the first point. You also specify the spacing between objects.

- **End Offset, Divide Evenly** Distributes the number of objects you specify between the start of a spline or a pair of points and an end offset that you specify. 3ds Max always places an object at the end or its offset. When you specify more than one object, there is always an object placed at the start. The Spacing tool attempts to evenly fill the space with the objects between the end offset and the start.

- **End Offset, Specify Spacing** Distributes objects toward the start of a spline or a pair of points, starting at the end or its offset. 3ds Max always places an object at the end or its offset. You specify the spacing between objects and the offset from the end. The Spacing tool attempts to evenly fill the space with as many objects as it can fit between the end or its offset and the start. There might not always be an object placed at the start.
- **Start Offset**  Distributes the number of objects you specify along a straight line. The objects start at an offset distance that you specify. This distance is from the start of the spline to its end point, or from the first of a pair of points to the second. You also specify the spacing between objects.

- **Start Offset, Divide Evenly**  Distributes the number of objects you specify between the end of a spline or a pair of points, starting at an offset that you specify from the start. 3ds Max always places an object at the start or its offset. When you specify more than one object, there is always an object placed at the end. The Spacing tool attempts to evenly fill the space with the objects between the start or its offset and the end.

- **Start Offset, Specify Spacing**  Distributes objects toward the end of a spline or a pair of points, starting at the start. 3ds Max always places an object at the start or its offset. You specify the spacing between objects and the offset from the start. The Spacing tool attempts to evenly fill the space with as many objects as it can fit between the start or its offset and the end. There might not always be an object placed at the end.

- **Specify Offsets and Spacing**  Distributes as many equally spaced objects as possible along a spline or between a pair of points. You specify the spacing between objects. When you specify offsets from the start and end, 3ds Max distributes equally spaced objects between the offsets. There might not always be an object placed at the start and ends.

- **Specify Offsets, Divide Evenly**  Distributes the number of objects you specify along a spline or between a pair of points. If you specify one object, 3ds Max places it at the center of the path. If you specify more than one object, 3ds Max always places an object at the start offset and the end offset. If you specify more than two objects, 3ds Max evenly distributes the objects between the offsets.

- **Space from End, Unbounded**  Distributes the number of objects you specify along a straight line from the end toward the start of a spline or a pair of points. You specify the spacing between objects. 3ds Max locks the end offset so that it's the same as the spacing.

- **Space from End, Specify Number**  Distributes the number of objects you specify toward the start of a spline or a pair of points, starting at the end. The Spacing tool determines the amount of space between objects based on the number of objects and the length of the spline or the distance between the pair of points. 3ds Max locks the end offset so that it's the same as the spacing.

- **Space from End, Specify Spacing**  Distributes as many equally spaced objects as possible toward the start of a spline or a pair of points, starting
at the end. You specify the spacing between objects. 3ds Max locks the end offset so that it's the same as the spacing.

- **Space from Start, Unbounded**  Distributes the number of objects you specify along a straight line toward the end of a spline or a pair of points, starting at the start. You specify the spacing between objects. 3ds Max locks the start offset so that it's the same as the spacing.

- **Space from Start, Specify Number**  Distributes the number of objects you specify toward the end of a spline or a pair of points, starting at the start. The Spacing tool determines the amount of space between objects based on the number of objects and the length of the spline or the distance between the pair of points. 3ds Max locks the start offset so that it's the same as the spacing.

- **Space from Start, Specify Spacing**  Distributes as many evenly spaced objects as possible toward the end of a spline or a pair of points, starting at the start. You specify the spacing between objects. 3ds Max locks the start offset so that it's the same as the spacing.

- **Specify Spacing, Matching Offsets**  Distributes as many evenly spaced objects as possible along a spline or between a pair of points (and their offsets). You specify the spacing. 3ds Max locks the start and end offsets so that they're the same as the spacing.

- **Divide Evenly, No Objects at Ends**  Distributes the number of objects you specify along a spline or between a pair of points (and their offsets). The Spacing tool determines the amount of space between objects. 3ds Max locks the start and end offsets so that they're the same as the spacing.
**Context group**

1. Edge-to-edge spacing
2. Center-to-center spacing

*Edges* Use this to specify that spacing is determined from the facing edges of each object's bounding box.

*Centers* Use this to specify that spacing be determined from the center of each object's bounding box.

*Follow* Use this to align the pivot points of the distributed objects to the tangent of the spline.

**Type of Object group**

Determines the type of copies made by the Spacing tool. The default is Copy. You can copy, *instance* on page 8611, or *reference* on page 8699 objects.

*Copy* Distributes copies of the selected object to the specified position.

*Instance* Distributes instances of the selected object to the specified position.

*Reference* Distributes references of the selected object to the specified position.
TIP  You can use compound shapes containing multiple splines as the spline path for distributing objects. Before creating shapes, turn off Start New Shape under Shapes on the Create panel. Then create your shapes. 3ds Max adds each spline to the current shape until you click the Start New Shape button so that it's checked. When you select the compound shape so that the Spacing tool can use it as a path, objects are distributed along all of the splines of the compound shape. For example, you might find this technique useful in spacing light standards along a path defined by separated splines.

Clone and Align Tool

Extras toolbar > Clone and Align Tool (on Array flyout)

Tools menu > Clone and Align

The Clone And Align tool lets you distribute source objects based on the current selection to a second selection of destination objects. For example, you can populate several rooms simultaneously with the same furniture arrangement. Similarly, if you import a CAD file that contains 2D symbols that represent chairs in a conference room, you can use Clone And Align to replace the symbols with 3D chair objects en masse.

The distributed objects can be copies, instances on page 8611, or references on page 8699 of the current selected object. You determine the number of clones or clone sets by specifying any number of destination objects. You can also specify position and orientation alignment of the clones on one, two, or three axes, with optional offsets.

You can use any number of source objects and destination objects.

You can pick objects within an XRef scene as destination objects.

With multiple source objects, Clone And Align maintains the positional relationships among the members of each cloned group, aligning the selection center with the destination's pivot.

Procedures

To use the Clone And Align tool:

1  Create or load an object or objects to be cloned, as well as one or more destination objects.
2 Select the object or objects to be cloned.

3 Open the Clone And Align dialog.

**NOTE** The order of steps 2 and 3 can be reversed.

4 Do either of the following:
   - Click Pick once and then click each destination object in turn. Next, click Pick again to turn it off.
   - Click Pick List and then use the Pick Destination Objects dialog to pick all destination objects simultaneously.

5 On the Clone Parameters rollout, choose the type of clone, and, if appropriate, how to copy the controller. For details, see Clone Options Dialog on page 992.

6 Use the Clone Parameters rollout settings to specify position, orientation, and scale options.

7 At any time, when Pick is off, you can change the source selection in a viewport. This causes the dialog to lose focus; click it again to regain focus and refresh the viewport preview of the clone operation.

8 To make the clones permanent, click Apply, and then click Cancel or the close button (X, in upper-right corner) to close the dialog.
Interface

The Clone and Align tool takes the form of a non-modal dialog; it remains open while you work in the viewports. While the dialog is active, the results of the current settings appear as a preview in the viewports. Because of the
dialog's non-modal nature, you can change the selection of source and destination objects on the fly and see the results immediately in the viewports.

When the dialog focus is lost by activating another dialog or clicking in a viewport (that is, its title bar is gray rather than blue), the preview no longer appears in the viewports. To make the cloned objects permanent, click Apply when the dialog is active.

**Source and Destination Parameters rollout**

Designate source objects by selecting them in a viewport. If you do this with the Clone And Align dialog open, the dialog loses focus; click the dialog to regain focus and update the settings.

**Destination Objects** [label] This read-only field shows the number of destination objects. To change this value, use Pick, Pick List, and Clear.

**Pick** When on, each object you click in the viewports is added to the list of destination objects. Click again to turn off after picking all destination objects. To qualify as a valid destination object, an object must:

- not have been designated as a source or destination object.
- be selectable (frozen objects can’t be selected).
- not be a temporary cloned object.

**Pick List** Opens the Pick Destination Objects dialog, which lets you pick all destination objects simultaneously, by name. In the dialog, highlight the destination objects, and then click Pick.

**Clear All** Removes all destination objects from the list. Available only when at least one destination object is designated.

**Source Objects** [label] This read-only field shows the number of source objects. To change this value, keep the dialog open, make sure Pick is off, and then select source objects in the viewports. When you click the dialog, the field updates.

**Link to Destination** Links each clone as a child of its destination object.

**Clone Parameters rollout**

These settings let you determine the type of clone to create, and, if appropriate, how to copy the controller. For details, see **Clone Options Dialog** on page 992.
**Align Parameters rollout**

The Align Position and Align Orientation group names are followed by the current reference coordinate system on page 922, in parentheses, which they use as the coordinate system for positioning and aligning the clones. When the View coordinate system is active, alignment uses the World coordinate system.

The Offset parameters always use each destination object's Local coordinate system.

**Align Position group**

* X/Y/Z Position Specifies the axis or axes on which to align the clones' position. Turning on all three options positions each set of clones at the respective destination object's location.

* X/Y/Z Offset The distance between the destination object's pivot and the source object's pivot (or source objects' coordinate center). For an Offset value to take effect, the respective Position check box must be on.

**Align Orientation group**

* X/Y/Z Orientation Specifies the axis or axes about which to align orientation. Turning on all three options aligns each set of clones' orientation fully with that of the respective destination object.

* X/Y/Z Offset The angle by which the source objects are rotated away from the destination object's orientation about each axis. For an Offset value to take effect, the respective Orientation check box must be on.

---

**Match Scale** Use the X Axis, Y Axis, and Z Axis options to match the scale axis values between the source and destination.

This matches only the scale values you'd see in the coordinate display on page 8081. It does not necessarily cause two objects to be the same size. Matching scale causes no change in size if none of the objects has previously been scaled.

---

**Reset All Parameters** Returns all settings in the Align Parameters rollout to their default values.
Apply  Generates the clones as permanent objects. After clicking Apply, you can use Clone And Align to generate additional clones, using the results of previous clonings as source or destination objects if you like.

Cancel  Aborts the current cloning operation and closes the dialog.

Align Flyout

Main toolbar > Align flyout

The Align flyout, available from the Main toolbar on page 8035, provides access to six different tools for aligning objects.

From top to bottom, these are:

- Align on page 967
- Quick Align on page 972
- Normal Align on page 973
- Place Highlight on page 976
- Align Camera on page 978
- Align to View on page 979
Align

Main toolbar > Align (on Align flyout)

Keyboard > Alt+A

Interface on page 971

Align lets you align the current selection to a target selection. After selecting an object to align, you click Align, available on the Align flyout on page 966, and then select another object to align the first object to. This opens the Align dialog with the name of the target object on its title bar. When performing sub-object alignment, the title bar of the Align dialog reads "Align Sub-Object Selection."

Aligning objects along an axis
Left: X position, center
You can align the position and orientation of the bounding box of the source object to the bounding box of a target object.

You can use the Align tool with any selection that can be transformed. If an axis tripod is displayed, you can align the tripod (and the geometry it represents) to any other object in the scene. You can use this to align an object’s pivot point.

You can use objects within an XRef scene as references with all alignment tools on the Align flyout, except Align to View.

When performing sub-object alignment, the Current Object options and the Match Scale boxes are disabled. If you plan to align orientation for sub-objects, first switch to Local transform mode on the main toolbar so that the axis tripod is properly aligned with your sub-object selection.

Other alignment tools on the Align flyout are Quick Align on page 972, Normal Align on page 973, Place Highlight on page 976, Align to Camera on page 978, and Align to View on page 979.

**Procedures**

**To align an object with a point object:**

1. Create a point helper object and position it at a target location in your scene. Rotate it as necessary to adjust final orientation.

2. Select a source object.

3. On the Main toolbar, click Align, or choose Tools > Align.

   The Align cursor appears attached to a pair of cross hairs.

4. Move the cursor over the point object and click.

   The Align Selection dialog appears. If necessary, move the dialog out of the way so you can see the active viewport.

5. In the Align Position group, turn on X Position.

   The selected source object shifts to align with the X axis of the point object.

6. Turn on Y Position and Z Position.
The source object moves so its center is at the point object.

7 Turn on X Axis, Y Axis, and Z Axis in the Align Orientation group to reorient the object to match the coordinates of the point.

To align objects by position and orientation:

1 Select a source object (the object to move into alignment with the target object).

2 On the Main toolbar, click Align, or choose Tools > Align.
   The Align cursor appears. When over an eligible target object, the cursor also shows crosshairs.

3 Position the cursor over the target object and click.
   The Align Selection dialog appears. By default, all options in the dialog are turned off.

4 In the Current Object and Target Object groups, choose Minimum, Center, Pivot Point, or Maximum.
   These settings establish the points on each object that become the alignment centers.

5 Begin alignment by turning on any combination of X Position, Y Position, and Z Position.
   The source object moves in relation to the target object, along the axes of the reference coordinate system. Setting all three moves the objects as close as possible, given the Current Object and Target Object settings.

6 In the Align Orientation group, turn on any combination of X Axis, Y Axis, or Z Axis.
   The source object realigns accordingly. If the objects already share an orientation, turning on that axis has no effect. Once two axes are aligned in orientation, the third is automatic.

To align a gizmo to another object:

1 Display the gizmo level of the Sub-Object selection.
On the Main toolbar, click Align, or choose Tools > Align.

Choose Tools > Align.

Click to select a target object in the viewport. (You can select the same object containing the gizmo to align the gizmo to a part of its own object.)

Use the available settings in the Align dialog to adjust the transformation of the gizmo.

To align a sub-object selection of geometry to another object:

1. Do one of the following:
   - Convert the object to an editable mesh, and then make the sub-object selection at any level.
   - Apply a Mesh Select or Poly Select modifier, make a sub-object selection, apply an XForm modifier (The Mesh/Poly Select modifier by itself doesn’t allow transforms.), and then activate the Gizmo sub-object level of the XForm modifier.

On the Main toolbar, click Align, or choose Tools > Align, and then select a target object.

Use the Align dialog controls to perform the alignment.
Interface

Align Selection (Max Icon Box)

Align Position (World):

- X Position
- Y Position
- Z Position

Current Object:
- Minimum
- Center
- Pivot Point
- Maximum

Target Object:
- Minimum
- Center
- Pivot Point
- Maximum

Align Orientation (Local):
- X Axis
- Y Axis
- Z Axis

Match Scale:
- X Axis
- Y Axis
- Z Axis

Align Position group

X/Y/Z Position Specifies the axis or axes on which to perform the alignment. Turning on all three options moves the selection to the target object’s location.

Current Object/Target Object groups

Specify the points on the objects' bounding boxes to use for the alignment. You can choose different points for the current object and the target object. For example, you can align the current object’s pivot point on page 8686 with the center of the target object.

Minimum Aligns the point on the object's bounding box with the lowest X, Y, and Z values with the chosen point on the other object.

Center Aligns the center of the object's bounding box with the chosen point on the other object.
**Pivot Point** Aligns the object's pivot point with the chosen point on the other object.

**Maximum** Aligns the point on the object's bounding box with the highest X, Y, and Z values with the chosen point on the other object.

**Align Orientation (Local) group**

These settings let you match the orientation of the local coordinate systems between the two objects on any combination of axes.

This option is independent of the position alignment settings. You can leave the Position settings alone and use the Orientation check boxes to rotate the current object to match the orientation of the target object.

Position alignment uses world coordinates on page 8768, while orientation alignment uses local coordinates. on page 8621

**Match Scale group**

Use the X Axis, Y Axis, and Z Axis options to match the scale axis values between the two selected objects. This matches only the scale values you'd see in the Transform Type-In on page 899. It does not necessarily cause two objects to be the same size. There will be no change in size if neither of the objects has previously been scaled.

**Quick Align**

Main toolbar > Quick Align (on Align flyout)

Tools menu > Quick Align

Keyboard > Shift+A

Quick Align lets you instantly align the position of the current selection to that of a target object. If the current selection is a single object, Quick Align uses the two objects' pivots on page 8686. If the current selection comprises multiple objects or sub-objects, Quick Align aligns the source's selection center on page 933 with the pivot of the target object.
Procedures

To use Quick Align:

1. Select one or more objects or sub-objects to align.

2. Press Shift+A or choose Quick Align from the Tools menu or Main toolbar > Align flyout.
   The mouse cursor turns into a “lightning-bolt” symbol. When positioned over an acceptable alignment target, a crosshairs symbol also appears.

3. Click an object to which to align the selection from step 1.
   The alignment is performed.

Normal Align

Main toolbar > Normal Align (on Align flyout)
Tools menu > Normal Align
Keyboard > Alt+N

Normal Align uses the Normal Align dialog to align two objects based on the direction of the normal on page 8654 of a face or selection on each object. To open the Normal Align dialog, select the object to be aligned, click a face on the object, and then click a face on a second object. Upon releasing the mouse, the Normal Align dialog appears.

If you use Normal Align while a sub-object selection is active, only that selection is aligned. This is useful when aligning sub-object selections of faces, since otherwise there’s no valid face normal for the source object.

Normal Align respects smoothing groups and uses the interpolated normal, based on face smoothing. As a result, you can orient the source object face to any part of the target surface, rather than having it snap to face normals.

For an object with no faces (such as helper objects, space warps, particle systems, and atmospheric gizmos), Normal Align uses the Z axis and origin of the object as a normal. Thus, you can use a Point object on page 2853 with Normal Align.
Other alignment tools on the Align flyout are Align on page 967, Quick Align on page 972, Place Highlight on page 976, Align to Camera on page 978, and Align to View on page 979.

**Procedures**

To align normals:

1. Select a source object. This is the object that moves during alignment.

2. Click Normal Align on the Main toolbar, or choose Tools > Normal Align.

3. Drag across the surface of the source object.
   The Normal Align cursor appears, attached to a pair of cross hairs. A blue arrow at the cursor indicates the current normal.

4. Move the cursor and blue arrow until you locate the normal you want to use, then release.
   The blue arrow remains as reference to the source normal.

5. Drag across the surface of the target object.
   A green arrow at the cursor indicates the current normal.

6. Move the cross hairs and green arrow until you locate the normal you want to use as a target, then release.
   The source object moves into alignment with the target normal, and the Normal Align dialog appears.

7. Do one of the following:
   - Click OK to accept the alignment.
   - Using the dialog, make modifications to the alignment before clicking OK.
   - Click Cancel Align to cancel the alignment procedure.
Interface

The Normal Align dialog lets you adjust or cancel the current alignment, and contains the following controls:

**Position Offset group**

Lets you translate the source object perpendicular to the normal on the X, Y or Z axes.

X/Y/Z These three fields let you affect how much of an offset will be given to the selected faces.

**Rotation Offset group**

Lets you rotate the source object about the normal's axis. You see the rotation in real time.

Angle This field lets you define the angle for the rotational offset.

**Flip Normal** Determines whether the source normal matches the target normal's direction. This defaults to off, since you usually want the two normals to have opposing directions. When you turn this on or off, the source object flips 180 degrees.

**OK/Cancel Align** The Cancel button is labeled Cancel Align to make it clear that you're not only canceling the settings in the dialog, but canceling the original transform on page 8750 of the source object.
Place Highlight

Main toolbar > Place Highlight (on Align flyout)
Tools menu > Place Highlight
Keyboard > Ctrl+H

Place Highlight, available from the Align flyout on page 966, enables you to align a light or object to another object so that its highlight or reflection can be precisely positioned.

In Place Highlight mode, you can click and drag the mouse around in any viewport. Place Highlight is a viewport-dependent function, so use the viewport that you’re going to be rendering. As you drag the mouse in the scene, a ray is shot from the mouse cursor into the scene. If it hits a surface, you see the surface normal on page 8654 at that point on the surface.

When you designate a surface, any selected objects are positioned along a line that represents the ray reflected off the surface about the surface normal. The objects are positioned along this line based on their original distance from the surface point. For example, if the object is 100 units from the surface point before being moved, it will be positioned 100 units from the surface point along the reflected ray.

If the object is a light, the position of the highlight on the surface of the object will be the surface point that you’ve chosen.

**TIP** Place Highlight works with any kind of selected object. It can be used to move objects based on a combination of face normals and initial distance from the face. You can also use Place Highlight with a selection set that contains more than one object. All objects maintain their initial distance from the face. In this case it has nothing to do with highlights, but is simply being used to position objects.

**NOTE** Highlight rendering depends on the material’s specular properties and the type of rendering you use.
Place Highlight aligns a camera and a spotlight to the same face.

Other alignment tools on the Align flyout are Align on page 967, Quick Align on page 972, Normal Align on page 973, Align to Camera on page 978, and Align to View on page 979.

Procedures

To position a light to highlight a face:

1. Make sure the viewport you plan to render is active, and that the object you want to highlight is visible in it.
   The result of Place Highlight depends on what is visible in the viewport.

2. Select a light object.
3 Click Place Highlight, or choose Tools > Place Highlight.
   Choose Tools > Place Highlight.
   If the button is not visible on the toolbar, choose it from the Align flyout.

4 Drag over the object to place the highlight.
   When you place an omni, free spot, or directional light, 3ds Max displays a face normal for the face the mouse indicates.
   When you place a target spotlight, 3ds Max displays the light's target and the base of its cone.

5 Release the mouse when the normal or target display indicates the face you want to highlight.
   The light now has a new position and orientation. You can see the highlight illumination in shaded viewports that show the face you chose, and when you render those views.

### Align Camera

Main toolbar > Align Camera button (on Align flyout)
Tools menu > Align Camera

Align Camera, available from the Align flyout on page 966, lets you align a camera to a selected face normal.

Align Camera works similarly to Place Highlight on page 976, except that it operates on face normals instead of the angle of incidence, and occurs when you release the mouse button instead of dynamically acting during the mouse drag. Its purpose is to let you align a Camera viewport to a specified face normal.

Other alignment tools on the Align flyout are Align on page 967, Quick Align on page 972, Normal Align on page 973, Place Highlight on page 976, and Align to View on page 979.
**Procedures**

To use Align Camera:

1. Select the camera used for the viewport you want to align.

2. Click Align Camera or choose Tools menu > Align Camera.

3. In any viewport, drag the mouse over an object surface to choose a face. The chosen face normal appears as a blue arrow beneath the cursor.

4. Release the mouse to perform the alignment. 3ds Max moves the camera so it faces and centers the selected normal in the camera viewport.

**Align to View**

Main toolbar > Align to View (on Align flyout)

Tools menu > Align to View

Align to View, available from the Align flyout on page 966, displays the Align To View dialog, which lets you align the local axis of an object or sub-object selection with the current viewport.

You can use Align to View with any selection that can be transformed.

Other alignment tools on the Align flyout are Align on page 967, Quick Align on page 972, Normal Align on page 973, Place Highlight on page 976, and Align to Camera on page 978.

**Procedures**

To align the local axis of a selection with the current viewport:

1. Select the objects or sub-objects to align.

2. Click Align to View.
3 Specify the local axis of the selected object to align with the current viewport's Z axis.

4 Select the Flip check box when you switch the direction of the alignment. The alignment takes place while the dialog is displayed.

5 Click OK to complete the process.

**Interface**

The Align to View dialog contains the following options:

- **Align X, Align Y, Align Z** Specifies which local axis of the selected object will be aligned with the current viewport's Z axis.

- **Flip** Switches the direction of the alignment.
Creating Copies and Arrays

With 3ds Max, you can quickly create multiple versions of one or more selected objects during a transform operation. You do this by holding down the Shift key as you move, rotate, or scale the selection.

Portico created from arrays of columns

The general term for duplicating objects is cloning. This section presents all the methods and choices available for cloning objects. In addition to the transform method, the tools include the following:

- **Array** lets you set all three transforms, in all three dimensions, at the same time. The results are precise linear and circular arrays in 2D or 3D space.
Mirror produces a “reflected” clone about one or more axes. If you mirror an object without cloning, the result is a “flip” of the geometry, optionally to a new location.

Snapshot lets you create clones equally spaced over time or distance, based on an animation path.

Spacing Tool distributes objects based on the current selection along a path defined by a spline or pair of points.

You can animate any of the cloning techniques.

Overview of Copies, Instances, and References

To duplicate an object, you use one of three methods. For all three methods, the original and clone (or clones) are identical at the geometry level. Where the methods vary is in the way they handle modifiers (for example, Bend or Twist).

An object can be a copy of another.
Copy method: Creates a completely separate clone from the original. Modifying one has no effect on the other.

Instance method: Creates a completely interchangeable clone of the original. Modifying an instanced object is the same as modifying the original.

Reference method: Creates a clone dependent on the original up to the point when the object is cloned. Changing parameters for modifiers that were applied to the object before the object was referenced, will change both objects. However, a new modifier can be applied to one of the reference objects, and it will affect only the object to which it is applied.

Depending on the method used to create them, cloned objects are called copies, instances, or references.

The following discussion focuses on how you might use these methods.

Copies

Copies are the most familiar kind of clone object. When you copy an object, you create a new, independent master object and data flow resulting in a new, named object. The copy duplicates all of the data of the original object at the time it is copied. The copy has no connection to the original object.

Example of Using Copied Objects

If you modeled a basic building shape and wanted to create a group of varied buildings, you could make copies of the basic shape and then model different features on each building to distinguish them from each other.

Copying Actively Linked Objects

When you copy objects that are actively linked through the File Link Manager on page 7538, 3ds Max automatically converts the copies to editable mesh objects. If your selection contains several objects that instance another object, the resulting copies also instance the same object.

Instances

Instances are alike not only in geometry, but also in every other way as well. Instancing an object results in multiple named objects based on a single master object. Each named object instance has its own set of transforms, space warp bindings, and object properties, but it shares the object modifiers and master object with the other instances. The data flow for an instance branches just after evaluating object modifiers.
When you change one instance by applying or adjusting a modifier, for example, all the other instances change with it.

Within 3ds Max, instances derive from the same master object. What you’re doing “behind the scenes” is applying a single modifier to a single master object. In the viewport, what you see as multiple objects are multiple instances of the same definition.

**Example of Using Instanced Objects**

If you wanted to create a school of swimming fish, you might begin by making many instanced copies of a single fish. You could then animate the swimming motion by applying a Ripple modifier to any fish in the school. The whole school would swim with exactly the same motions.

**Instances of Actively Linked Objects**

Creating instances of actively linked objects is not recommended. Reliability issues can arise if the instanced object is deleted in the linked file.

**References**

*References* are based on the original object, as are instances, but can also have their own unique modifiers. Like instances, references share, at minimum, the same master object and possibly some object modifiers.

The data flow for a reference branches just after the object modifiers but then evaluates a second set of object modifiers unique to each reference. When you create references, 3ds Max displays a gray line, called the *derived-object line*, at the top of the modifier stack for all clones. Any modification made below the line is passed on to other references, and to the original object. New modifiers added above the line are not passed on to other references. Changes to the original object, such as in its creation parameters, are passed on to its references.

This effect is useful for maintaining an original that will affect all its references, while the references themselves can take on individual characteristics.

All shared modifiers reside below the derived-object line and are displayed in bold. All modifiers unique to the selected reference reside above the derived-object line and are not bold. The original object does not have a derived object line: its creation parameters and modifiers are all shared, and all changes to this object affect all references.
The results of changing or applying a modifier to a named object reference depends on where in the modifier stack it is applied:

- Applying a modifier to the top of the modifier stack affects only the selected named object.
- Applying a modifier below the gray line affects all references branching above that line.
- Applying a modifier at the bottom of the modifier stack affects all references derived from the master object.

References of Actively Linked Objects

Creating references of actively linked objects is not recommended. Reliability issues can arise if the referenced object is deleted in the linked file.

Example of Using Referenced Objects

In the example of modeling heads, you might want to keep a family resemblance in your characters. You could model basic features on the original, then model specifics on each reference.

At some point, if you wanted to see what your characters would look like as "cone-heads," you could apply a Taper modifier to the original head, and have all the other characters take on the same feature. You could give the original character a very pointed head, then apply a separate Taper to some referenced characters to reduce the point toward normal.

For swimming fish, you might choose to make all members of the school as referenced objects based on a single, original fish. You could still control the swimming motion from the original fish, and also add modifiers to individual fish in the school to vary their behavior.

Techniques for Cloning Objects

3ds Max provides several techniques for copying or duplicating objects; cloning is the general term for this process. These techniques can be used to clone any selection set.

- Clone
- Shift+Clone
■ Snapshot
■ Array
■ Mirror
■ Spacing Tool
■ Clone and Align Tool

**Shared Features**

While each technique has distinct uses and advantages in cloning objects, in most cases the cloning techniques share some similarities in how they work:

■ You can apply a transform when you clone. New objects are moved, rotated, or scaled as they are created.

■ The transform is relative to the current coordinate system, axis constraint, and transform center.

■ When cloning creates new objects, you have the choice of making them copies, instances, or references.

Each of the following items is discussed later in this chapter.

**Clone**

Using the Clone command on the Edit menu is the easiest method for copying an object in place; no transformation is involved. See Clone on page 992.
**Shift+Clone**

You can clone an object as you transform it interactively in the viewport. The process is referred to as Using Shift+Clone on page 996: the technique of holding down the Shift key while transforming a selected object with the mouse.

Quick and versatile, this technique is probably the one you’ll use most often to duplicate objects. Snap settings give you precise results.

How you set the center and axes for the transforms determines the arrangement of the cloned objects. Depending on the settings, you can create both linear and radial arrays.

You need a working knowledge of transform features to take full advantage of Shift+Clone. See Using Transforms on page 886.
Snapshot

Using an ice-cream cone animated along a path, Snapshot creates a stack of cones.

Snapshot on page 950 clones an animated object over time. You can create a single clone on any frame, or space multiple clones along the animation path. The spacing is a uniform time interval; it can also be a uniform distance.
A one-dimensional array

Array on page 1009 creates repeating design elements: for example, the gondolas of a Ferris wheel, the treads of a spiral stair, or the battlements along a castle wall.

Array gives you precise control over all three transforms and in all three dimensions, including the ability to scale along one or more axes. It is the combination of transforms and dimensions, coupled with different centers, that gives you so many options with a single tool. A spiral stair, for example, would be a combination of Move and Rotate around a common center. Another array using Move and Rotate might produce the interlocked links of a chain.
Mirror

Mirror on page 1026 produces a symmetrical copy around any combination of axes. There is also a "No Clone" option that performs the mirror operation without copying. The effect is a flip or move of the object to a new orientation.

Mirror has an interactive dialog. As you change settings, you see the effect in the active viewport; in other words, a preview of what the mirror will look like.

There is also a Mirror modifier that gives you parametric control of the mirror effect.
Spacing Tool

The Spacing Tool distributes the vases along the sides of the curved street.

The Spacing tool on page 953 distributes along a path defined by a spline or pair of points. You define a path by picking a spline or two points and by setting a number of parameters. You can also specify how the spacing between objects is determined and whether the insertion points of the objects align to the tangent of the spline.

Clone and Align Tool

The Clone And Align tool on page 961 lets you distribute source objects based on the current selection to a second selection of destination objects. For example, you can use Clone And Align to populate several rooms simultaneously with the same furniture arrangement. Similarly, if you import a CAD file that contains 2D symbols that represent chairs in a conference room, you can use Clone And Align to replace the symbols with 3D chair objects en masse.
Clone

Make a selection. > Edit menu > Clone

Make a selection. > Hold down Shift key. > Move, rotate, or scale the selection with the mouse.

With the Clone command you can create copies, instances, or references of a selected object or a set of objects.

Clone creates a copy, instance, or reference of an object.

The Clone command on the Edit menu creates a single copy of your selection. Alternatively, you can clone multiple copies by holding down the Shift key as you move on page 914, rotate on page 915, or scale on page 917 your selection. Either method displays the Clone Options dialog on page 992.

Clone Options Dialog

Make a selection. > Edit menu > Clone
Make a selection. Hold down Shift key. Move, rotate, or scale the selection with the mouse.

Scene Explorer on page 7888 > Paste a copied node.

Clone creates a copy, instance on page 8611, or reference on page 8699 of a selected object or set of objects. The Clone command on the Edit menu creates a single copy. You can clone multiple copies by holding down the Shift key as you transform the selection.

**Procedures**

**To clone an object without transforming it:**

1. Select an object, or set of objects.
2. From the Edit menu, choose the Clone command. The Clone Options dialog opens.

   **NOTE** All options are present except Number Of Copies.

3. Change the settings or accept the defaults, and then click OK. Each new, cloned object occupies the same space as the original. Select a clone by name to move or modify it.

**To clone an object with Scene Explorer on page 7888:**

**NOTE** Cloning objects with Scene Explorer requires that the new copies be hierarchical children of an existing object.

1. In Scene Explorer, highlight one or more objects.
2. Do either of the following:
   - Right-click one of the highlighted items and choose Copy Nodes.
   - From the Edit menu, choose Copy Nodes.

3. Do either of the following:
   - Right-click an item and choose Paste Nodes.
   - Highlight an object and from the Edit menu, choose Paste Nodes. The Clone Options dialog opens.
4 Change the settings or accept the defaults, and then click OK.
   The copied objects are cloned as children of the highlighted object.
   Each new, cloned object occupies the same space as the original. Select
   a clone by name to move or modify it.

To clone and transform an object:

1 On the main toolbar, click the Move, Rotate, or Scale
   button.

2 Select an object, multiple objects, group, or sub-object.

3 Hold down the Shift key and drag the selection.
   As you drag your selection, the clone is created, selected, and transformed.
   The original object is deselected and unaffected by the transform.
   When you release the mouse button, the Clone Options dialog opens.

4 Change the settings or accept the defaults, and then click OK.
Interface

![Clone Options Dialog]

**Object group**

**Copy** Places a copy of the selected object at the specified position.

**Instance** Places an instance of the selected object at the specified position.

**Reference** Places a reference of the selected object at the specified position.

**Controller group**

Lets you choose to copy or instance the transform controllers on page 8506 of the original object's child objects. This option is available only when the selection you are cloning includes two or more hierarchically linked objects on page 8599.

When cloning non-linked objects, transform controllers are simply copied.

Also, when cloning linked objects, the highest-level cloned object's transform controller is simply copied. This option applies only to the transform controllers of objects at levels below the top of the cloned hierarchy.

**Copy** Copies the cloned objects' transform controllers.
**Instance** Instances the cloned objects' transform controllers below the top level of the cloned hierarchy. With instanced transform controllers, you can change the transform animation of one set of linked children, and automatically have the change affect any cloned sets.

This allows you to animate all clones identically with a single animation setup. For example, consider a scene containing three objects named Torso, Thigh, and Calf. The objects are linked hierarchically so that Torso is the parent of Thigh and Thigh is the parent of Calf. Say you select all three objects and then clone them, and choose Clone Options > Controller > Instance. Thereafter, if you transform either Thigh or Calf object, the corresponding object in the other hierarchy is transformed identically, along with any child objects. However, if you transform either Torso object, the other hierarchy is not affected.

**Number of Copies** Specifies the number of copies of the object you want to create. Available only when you Shift+Clone an object.

Using Shift+Clone to generate multiple copies applies the transform successively to each additional copy. If you Shift+Move an object and specify two copies, the second copy is offset from the first copy by the same distance that the first copy is offset from the original. For Rotate, two copies of the rotated object are created, with the second copy rotated twice as far as the first. For Scale, two copies of the scaled object are created, with the second copy scaled from the first copy by the same percentage that the first copy was scaled from the original.

**Name** Displays the name of the cloned object.

You can use this field to change the name; additional copies use the same name followed by a two-digit number, starting at 01 and incrementing by one for each copy. So, for instance, if you Shift+Move an object and then specify the name building and two copies, the first copy will be named building and the second will be named building01.

**Using Shift+Clone**

Shift+Clone is the primary way to duplicate objects in 3ds Max. You hold down the Shift key and drag during any of the standard transform operations: Move, Rotate, or Scale.
To **Shift+Clone an object**:

1. On the main toolbar, click the Move, Rotate, or Scale button.

2. Select a transform coordinate system and constraints. Each transform carries its own settings. To avoid surprises, always click the transform button first, and then set your transform coordinate system and constraints.

   **NOTE** You can also use the Transform Gizmo to set axis constraints.

3. Select the object or set of objects you want to clone. The selection can be a single object, multiple objects, a group, or a sub-object selection.

4. Hold down the Shift key and drag the selection to apply the transform. As you drag, a clone is created and selected; it is now the object being transformed. The original object is no longer selected and is unaffected by the transform.

When you release the mouse button, the Clone Options dialog appears. Change settings in this dialog or accept the defaults, and then click OK.

Shift+Clone uses the Clone Options dialog on page 992 for any transform you choose.

**See also:**
- Cloning with Shift+Move on page 998
- Cloning with Shift+Rotate on page 1000
- Cloning with Shift+Scale on page 1003

**Animating Shift+Clone**

You can animate any Shift+Clone operation. See Animating Shift+Rotate and Shift+Scale on page 1005.

**Cloning Without Transforming**

Cloning objects with Shift+Clone requires transforming them at the same time, by moving, rotating, or scaling them. In some cases, you might want to
clone an object without transforming it in any way. The Edit menu Clone command gives you this option, which lets you create only one clone at a time.

To clone objects without transforming:

1. Select the object or objects to clone.
2. Choose Edit menu > Clone. The Clone Options dialog appears. This is the same dialog used with Shift+Clone except that there's no Number Of Copies setting. The Clone command lets you create only one copy.
3. Change settings in this dialog or accept the defaults, and click OK.

**NOTE** The cloned object occupies the exact same space as the original, and is selected when cloning is complete. Use Select By Name on page 206 to select the original or reselect the clone.

**Cloning with Shift+Move**

Cloning objects while moving them is quick and easy. It produces a linear array of two or more objects.
Shift+Move creates a clone in a different location.

To clone with Shift+Move:

1. Click the Move button on the main toolbar.
2. Choose a coordinate system and axis constraint.
3. Make the selection you want to clone.
4. Hold down Shift and drag to move a clone of the selection away from the original.
5. Choose the number of copies you want to make on the Clone Options dialog, and whether you want them to be copies, instances, or references.
**About Arrays Created with Shift+Move**

Multiple clones produced by Shift+Move form an equally spaced linear array with these characteristics:

- The line of the array runs from the center of the original through the centers of the clones.
- The distance between each neighboring pair of copies is the same the distance between the original and the first clone.

By using snaps as you move the selection, you can make precise arrays.

An example of the Shift+Move array is a picket fence. From a single picket, you can generate long runs of fencing. You can array the fence along a major axis of the home grid, then group the pickets, rotate them to a particular angle, and move them into position.

You can also make three-dimensional arrays with Shift+Move. The main choice is the combination of axes to allow movement off the construction plane. For example, to build a stairway, you can create a box that forms the top step, then use Shift+Move to copy it diagonally downward, using an array to create a downward flight.

**Cloning with Shift+Rotate**

Cloning objects while rotating them produces a variety of effects, depending on how you set up the transformation.
Shift+Rotate creates a clone with a different orientation.

To clone with Shift+Rotate:

1. Click the Rotate button on the main toolbar.
2. Choose a coordinate system, transformation center, and axis constraint.
3. Make the selection you want to clone.
4. Hold down the Shift key and drag to rotate the selection.
5. Choose the number of copies you want to make on the Clone Options dialog, and whether you want them to be copies, instances, or references.

Effects of Transform Settings

Where you locate the transform center determines how 3ds Max positions clones when using Shift+Rotate.

- For all settings, the direction of rotation is constrained by the active axis or axes of the viewport’s coordinate system.
Each clone is rotated from the previous one by the same amount as the first clone from the original.

**Local Pivot at Center**

An object’s default pivot point is often located at its center or its base. When you use Shift+Rotate around an object’s default pivot point, the clones overlap evenly as each one is rotated the same amount. This is true for multiple objects with a local-pivot setting, since each object uses its own local center.

Clones of a circular object, like a sphere or cylinder, can be overlaid exactly on the original. You might need to move them away from the original to see them.

With angle snap on page 2816 set to divide a circle evenly, you can produce complex symmetrical objects from simple ones. For example, you can clone a tetrahedron around one axis, then clone the new set about another axis to produce a faceted star.

**Local Pivot at a Distance**

When you separate the local pivot from the original, clones create a wheel-like arrangement. Long shapes like petals or blades, cloned with the center near one end, can create flowers or propellers. See Adjust Pivot Rollout on page 3763.

You can move the local pivot any distance from the object, creating large circular arrays. Since direct animation is limited to the local pivot, this is a key technique in animating circular arrays. See Animating Shift+Rotate and Shift+Scale on page 1005.

**Selection Center**

For either single or multiple objects, the selection center is the geometric center of the bounding box on page 8528 enclosing the entire selection. Clones are arrayed around this center, forming wheel-like arrays.

For a single object, this center is usually different from its local center, but the effects are similar to those based on a local pivot.

**Coordinate Center**

Using the coordinate center, Shift+Rotate can produce circular arrays of any size.
The rotation takes place around the center of the home grid, the screen, or whichever coordinate system you choose. While clones can be created this way, the process cannot be directly animated. For details on overcoming this limitation, see Animating Shift+Rotate and Shift+Scale on page 1005.

**Cloning with Shift+Scale**

Cloning objects while scaling them can produce a variety of nested objects and arrays, depending on the center you choose.

![Shift+Scale creates a clone of a different size.](image)

To clone with Shift+Scale:

1. Click a Scale button on the main toolbar.
2. Choose a coordinate system, axis constraint, and transform center.
3. Make the selection you want to clone.
4. Hold down Shift and drag to scale the selection.
5 Use the Clone Options dialog to choose the number of clones you want to make and whether you want them to be copies, instances, or references.

**Effects of Transform Settings**

Transform settings determine how 3ds Max distributes clones of a selection during Shift+Scale. In all scaling operations, the transform center acts as the center of scaling:

- When clone objects decrease in size, they shrink toward the transform center.
- When clone objects increase in size, they expand away from the transform center.

The distance between cloned objects is scaled like the clones themselves, based on the initial distance from the original to the first clone. The spacing increases or decreases proportionately with respect to the transform center.

**Nested Copies**

When the selection center is used as the transform center for a single object, scaling occurs symmetrically around that center, producing nested copies.

- As you scale in toward the center, smaller and smaller copies are created.
- In the other direction, the original object is enclosed by increasingly larger copies.

Variations are possible, depending on the type of scale and axis limitations. For example, you can scale a flat box into a progressively stepped pyramid by using Squash on page 920 and cloning inward on the Z axis.

**Offset Centers**

For Shift+Scale, any center other than the local pivot has the effect of creating an array of progressively scaled objects. Again, objects scale down in size toward the center, while increasing in size further away. However, this effect is limited by the particular scale option and the axis constraints, as discussed next.
Axis Constraints

Uniform Scale is unaffected by axis constraints, which you can set with the Transform Gizmo. Copies are always arrayed in or out from the center of the current coordinate system.

For Non-Uniform Scale and Squash, scaling occurs only along the axis or axes set with the restricted axes.

NOTE The Restrict To ... buttons (also called the Axis Constraints buttons) are available on the Axis Constraints toolbar on page 8039, which is off by default. You can toggle display of this toolbar by right-clicking an empty area of a toolbar and choosing Axis Constraints from the Customize Display right-click menu on page 8239.

Animating Shift+Rotate and Shift+Scale

You can use the Auto Key button on page 8090 to animate Shift-clone. However, there are some restrictions.

When the Auto Key button is on, the transform center defaults to local pivot, and the Use Center flyout on page 930 on the toolbar is unavailable. If you choose one of the other centers and activate Auto Key, the center returns to the local pivot. This means you can’t directly animate about a non-local pivot center with Shift+Rotate and Shift+Scale. For example, you can’t use this method to create clones in an arc or circular array around a common center.

Using Non-Local Centers

To use a center separate from the object you’re cloning, you can do any of the following:

■ Use a dummy object.
■ Offset the local pivot.
■ Change the default animation center.

Using a Dummy Object as Center

In this procedure, you use the axis tripod of the dummy object as the center for rotation or scale.
To use a dummy object as center:

1. Create a dummy object on page 2840 at the center of rotation or scaling.

2. Link the object or objects you want to clone to the dummy object, which becomes the parent.

3. Select both the dummy and the objects, then transform them with Shift+Rotate or Shift+Scale.
   - For Shift+Rotate, the dummy's center becomes the pivot.
   - For Shift+Scale, the dummy and selected objects scale together toward the center of the dummy.

For details of dummy object use in hierarchies, see Using Dummy Objects on page 3651.

Offsetting the Local Pivot

In this procedure, you move the object's pivot to the center of rotation or scale. This works much like using a dummy object.

To offset the local pivot:

1. Select the object whose pivot you wish to move.

2. On the Hierarchy command panel, choose Pivot and then turn on Affect Pivot Only.

3. Move the local pivot of the original object to another location in your scene.

4. On the Hierarchy panel, click Affect Pivot Only again to turn it off. Shift+Rotate or Shift+Scale now animates around the offset center. This works with the default setting for local center.

NOTE Moving the local pivot can adversely affect linking and inverse kinematics. If this is a possibility, consider changing the default axis instead of moving the local pivot.
To change the default axis while animating:
In this procedure, you set 3ds Max to allow animation of transforms about any center on the Use Center flyout.

1 Choose Customize menu > Preferences and click the Animation tab of the Preference dialog.

2 In the Animate group, turn off Local Center During Animate. This changes the default and makes all the transform center options available when animating. You can now animate around either the selection or transform coordinate center, as well as local pivot.

**NOTE** Changing the default setting animates the rotation you see in viewports as a rotation plus translation, which might not be the effect you wanted.

---

**Cloning Objects Over Time with Snapshot**

The **Snapshot tool** on page 950 lets you clone an object along its animation path. You can make a single clone at any frame, or multiple clones spaced over a selected number of frames.
Snapshot can also clone a particle system’s particles.

Snapshot spaces the clones equally in time. Adjustments in Track View let you space the clones equally along the path instead.

Like other clone techniques, Snapshot creates copies, instances, or references. You can also choose a mesh option.

To clone an object with Snapshot, the object must already be animated. You can use Snapshot from any frame on the path. The Auto Key button has no effect on Snapshot, since Snapshot creates static clones, not animation. This is the general procedure:

**To clone an object with Snapshot:**

1. Select an object with an animation path, or a particle system. The animation can result from applying transforms, controllers, or any combination of effects.
On the **Array flyout** on page 943 click Snapshot, or choose Tools menu > Snapshot to display the Snapshot dialog.

**NOTE** The Array flyout is on the Extras toolbar, which is off by default. You can toggle display of this toolbar by right-clicking an empty spot on the main toolbar and choosing Axis Constraints from the *Customize Display right-click menu* on page 8239.

3 Set parameters in the dialog, and click OK.

## Arraying Objects

Array is a dedicated tool for cloning and precisely transforming and positioning groups of objects in one or more spatial dimensions. For each of the three transforms (move, rotate, and scale), you can specify parameters for individual objects in the array, or for the array as a whole. Many results you can get with Array would be laborious or impossible using Shift+Clone techniques.
A one-dimensional array

Creating an Array

This is the general procedure. For more details, see the topics that follow.

To create an array:

1. Select one or more objects to be in the array.
2. Choose a coordinate system and transform center.
3. Click Array on the Array flyout, or choose Array on page 944 from Tools menu.
   The Array dialog appears.

   NOTE The Array flyout is on the Extras toolbar, which is off by default. You can toggle display of this toolbar by right-clicking an empty spot on the main toolbar and choosing Axis Constraints from the Customize Display right-click menu on page 8239.
4 Set array parameters on this dialog, then click OK.

Reuse of Array Settings

Generally you should approach Array creation as an iterative process. The dialog settings are not interactive, so you get feedback only after creating the array. By revising the current settings and repeating the array, you develop a solution that meets your needs.

After creating an array and checking its result, you can undo the array using Edit menu > Undo Create Array or Ctrl+Z. This leaves the original selection set in place.

Repeating an Array

When you create an array, object selection moves to the last copy or set of copies in the array. By simply repeating current settings, you create a seamless continuation of the original array.

During a session, 3ds Max maintains all the dialog settings for your current array.

Array settings are saved only during the current session, not with the file. Be sure you’ve finished an array before you quit 3ds Max.

General Considerations

When you create an array, keep these points in mind:

- Array is relative to the current viewport settings for coordinate system and transform center.
- Axis constraints do not apply, because Array allows you to specify transforms along all axes.
- You can animate array creation. By changing the default Animate preferences setting, you can activate all the transform center buttons, allowing direct animation around either the selection or coordinate center, as well as local pivot. For information about changing the default setting, see the procedure, To change the default axis while animating on page 1006.
- To make an array of a hierarchically linked object, select all the objects in the hierarchy before you click Array.
Using the Array Dialog

The Array dialog provides two main control areas where you set the important parameters: Array Transformation and Array Dimensions.

You can set parameters in any order, but in practice it’s useful to start with Array Transformation. This creates the basic building block for the larger array, as defined by Array Dimensions.

These topics discuss specific strategies for using these controls:

Creating Linear Arrays on page 1018

Creating Circular and Spiral Arrays on page 1022

See also:

■ Array on page 944

Array Transformation

This area lists the active coordinate system and transform center. It’s where you set the transforms that define the first row of the array. You decide here on the distance, rotation, or scale of individual elements, and along what axes. You then repeat this row in other dimensions to produce the finished array.
Move, Rotate, and Scale Transforms

You set Move, Rotate, and Scale parameters along any of the three axes of the current coordinate system.

- **Move** is set in current units. Use a negative value to create the array in the negative direction of the axis.
- **Rotate** is set in degrees. Use a negative value to create the array in a clockwise direction around the axis.
- **Scale** is set as a percentage. 100 percent is full size. Settings below 100 decrease the size, and above 100 increase it.

Incremental and Totals

For each transform, you have the choice of whether to apply the transforms successively to each newly created element in the array or to the overall array.

For example, if you set Incremental > X > Move to 120.0 and Array Dimensions > 1D > Count to 3, the result is an array of three objects, each of whose transform centers is 120.0 units apart. However, if you set Totals > X > Move to 120.0 instead, the three elements are spaced 40.0 units apart for a total array length of 120.0 units.

- **Click arrows on either side of the transform labels to choose between Incremental or Totals.**

Incremental and Totals settings are toggles for each transform. When you set a value on one side, the other side is unavailable. However, the unavailable value updates to show the equivalent setting.

**Incremental:** Parameters set on this side apply to individual objects in the array. Here are examples:

- An Incremental Move X setting of 25 specifies a spacing of 25 units on the X axis between centers of arrayed objects.
- An Incremental Rotate Z setting of 30 specifies a progressive rotation of 30 degrees on the Z axis for each object in the array. In the finished array, each object is rotated 30 degrees farther than the one before it.
**Totals:** Parameters set on this side apply to the overall distance, number or degrees, or percentage scale in the array. Here are examples:

- A Totals Move X setting of 25 specifies a total distance of 25 units on the X axis between the centers of the first and last arrayed objects.
- A Totals Rotate Z setting of 30 specifies a combined rotation of 30 degrees on the Z axis divided equally among every object in the array.

**Type of Object**

**Copy** Creates new array members as copies of the originals.

**Instance** Creates new array members as instances of the originals.

**Reference** Creates new array members as references of the originals.

For further information, see [Overview of Copies, Instances, and References](#) on page 982.

**Array Dimensions**

The Array Dimensions controls determine the number of dimensions used in the array and the spacing between the dimensions.

**Count:** The number of objects, rows, or layers in each dimension.

**1D:** One-dimensional arrays form a single line of objects in 3D space, like a line of columns. 1D Count is the number of objects in a row. Spacing for these objects is defined in the Array Transformation area.
A one-dimensional array, with 1D Count=6

2D: Two-dimensional arrays form a layer of objects along two dimensions, like the rows of squares on a chess board. 2D Count is the number of rows in the array.
A two-dimensional array, with 1D Count=7 and 2D Count=4

3D: Three-dimensional arrays form multiple layers of objects in 3D space, like neatly stacked boxes. 3D Count is the number of layers in the array.
A three-dimensional array, with 1D Count=10, 2D Count=6, 3D Count=3

Incremental Row Offsets

These parameters become available when you choose a 2D or 3D array. These are distances along any of the three axes of the current coordinate system.

- If you set a Count value for 2D or 3D, but no row offsets, the array is created with overlapping objects. You need to specify at least one offset distance to prevent this.

- If some objects appear to be missing from the array, it is possible that some objects have been created exactly on top of other objects in the array. To determine whether this has occurred, use Select By Name on page 206 to see the full listing of objects in your scene. If objects are on top of one another and you don’t want this effect, click Ctrl+Z to undo the array, and try again.
Creating Linear Arrays

A linear array is a series of clones along one or more axes. A linear array can be anything from a line of trees or cars to a stairway, a picket fence, or a length of chain. Any scene requiring repeated objects or shapes is a candidate for a linear array.

Examples of linear arrays

For an explanation of interface terms used here, see Using the Array Dialog on page 1012. For the basic steps in making an array, see Arraying Objects on page 1009.

Creating Simple Linear Arrays

The simplest 2D linear array is based on moving a single object along a single axis. These are the basic choices to make on the Array dialog.

Make these choices in the Array Transformation group:

- Use Incremental Move settings where you know the spacing you want between objects.
Use *Totals Move* settings when you know the overall space or volume you want the array to occupy.

For either of these two types of arrays, enter a value for one axis. Leave the other transforms at their default values.

Make these choices in the Array Dimensions group:

- Choose 1D.
- Enter a Count value for the number of objects in the array. The Total In Array field updates to show you the current total of objects in the array you are designing.
- Click OK to create a linear array along the chosen axis, with the number of objects specified by Count.

**2D and 3D Linear Arrays**

Arrays in 2D and 3D have the same Array Transformation group setup as 1D, with the addition of Incremental Row Offsets settings for moving the additional dimensions apart.

- Set 2D or 3D and enter a Count value.
  - If you set 3D, the 2D values also become available. Both Count values are 1 by default, which has the same effect as 1D. Set the 2D and 3D Count values greater than 1 to produce a more complex array.
- Set a nonzero value for at least one Incremental Row Offsets setting for 2D and 3D. Otherwise, there will be no separation between the 1D row and the new clones.

A wide variety of linear arrays are possible. Experiment with moving along all three axes and varying the row offsets in 2D and 3D.
Using Rotation in Linear Arrays

You can rotate elements in a linear array by applying a Rotate value for a specified axis. When you add rotation to a linear array, the choice of transform center becomes important.
Using Scale in Linear Arrays

Linear array with progressive scaling

When you apply a Scale factor, 3ds Max scales each copy from the previous copy. Objects in the array become progressively smaller or larger, as in the illustration.
Scale and Movement in Nested Arrays

Using only Scale settings and the local pivot of an object produces nested arrays, like Russian dolls, just as it does when you Shift+Scale from the local pivot. However, with the Array tool, you can add movement as well. This means you can create increasingly larger or smaller copies and array them at the same time.

Using Uniform Scaling

By default, all axes are available for scaling.

If you turn on Uniform, only the Scale X field is active; the Y and Z fields are unavailable. The X value is applied as uniform scaling on all axes of the arrayed objects.

Creating Circular and Spiral Arrays

Creating circular and spiral arrays typically involves some combination of moving, scaling, and rotating copies along one or two axes and around a common center. The effects can vary from the uniform radial arrangement of bolts on a wheel hub to the complex geometry of a spiral staircase. You can model many circular patterns with these techniques.

See Using the Array Dialog on page 1012 for an explanation of interface terms used here. See Arraying Objects on page 1009 for the basic steps in making an array.

Using a Common Center

Both circular and spiral arrays require a common center for the arrayed objects. This can be the world center, the center of a custom grid object, or the center of the object group itself. You can also move the pivot point of an individual object and use that as the common center.
Circular Arrays

Circular arrays are similar to linear arrays, but based on rotation around a common center rather than movement along an axis. The following procedure makes a circle of objects on the XY plane of the home grid with the Z axis as the center.

To create a circular array:

1. On the main toolbar, choose a transform center to become the center of the array. In this case, choose Use Transform Coordinate Center so the center of the grid becomes the array center.

2. Select an object and position it at some distance from the center of the grid. This distance is the radius of the finished circle.
3 Choose Array from the Array flyout or the Tools menu to display the Array dialog.

**NOTE** The Array flyout is on the Extras toolbar, which is off by default. You can toggle display of this toolbar by right-clicking the main toolbar and choosing Axis Constraints from the Customize Display right-click menu on page 8239.

4 On the Array dialog, enter **360** in the Totals Rotate Z field.
   This is the total rotation for the array, a complete circle. To create a partial circle, enter a smaller value.

5 Choose 1D and enter a Count value (this can be any number) and click OK.
   3ds Max arrays that number of clones within the total rotational angle you specify.
Spiral Arrays

The simplest spiral arrays are rotated circular arrays with a movement along the central axis. The same circle is formed, but now the circle rises upward.

If $Z$ is the central axis, enter a value for Incremental Move $Z$. Each clone is then moved upward this amount as the circle is formed.

**Rotation in Spiral Arrays**

In spiral arrays, the direction of rotation determines the direction of the spiral: which way it winds up or down.

Enter a positive rotation for a counterclockwise spiral.

Enter a negative rotation for a clockwise spiral.

**Reorienting an Array**

By default, each object, when copied into the array, rotates around its own center to follow the main rotation around the common center. This is controlled by the Re-Orient option.
To cause objects to maintain their original orientation while being rotated, turn off Re-Orient. In effect, objects remain "facing the same direction" as the original object.

**Mirroring Objects**

The Mirror tool uses a dialog that either creates a mirrored clone of a selected object, or mirrors the orientation of the object without creating a clone. You can preview the effects of settings before committing to the operation.

**Mirroring an object**

This is the general procedure for mirroring an object. Begin by selecting the object.

- Click the Mirror button on the main toolbar, or choose Tools menu > Mirror. This displays the Mirror dialog. The title bar indicates the coordinate system currently in use.
For information on the Mirror dialog options, see Mirror Selected Objects on page 940.

**Mirrored Arrays**

You can combine the Mirror and Array tools by using them in succession. An entire array can be mirrored, or you can set up mirrored objects before creating an array.

**Animating Mirror**

When you use Mirror with Auto Key turned on, you see the transition occur as the mirrored object moves into place. For example, a cylinder mirrored to the other side of an axis appears to flatten and reshape itself. The object is, in fact, scaled from 100% to 0% to –100%. This effect is not visible unless the mirror operation is animated.

**Mirror Modifier**

The Mirror modifier on page 1516 provides a parametric method of mirroring an object or sub-object selection within the modifier stack. You can apply the Mirror modifier to any type of geometry. You can animate the mirror effect by animating the modifier’s gizmo.

### Using the Spacing Tool

The Spacing Tool distributes objects based on the current selection along a path defined by a spline or pair of points. The distributed objects can be copies, instances, or references of the current selected object. You define a path by picking a spline or two points and by setting a number of parameters. You can also specify how the spacing between objects is determined and whether the insertion points of the objects align to the tangent of the spline.
The Spacing Tool distributes the vases along the sides of the curved street. The vases are all at the same distance from each other; fewer of them appear on the shorter side.

For details on the Spacing Tool parameters, see Spacing Tool on page 953.

To distribute objects along a path:

1. Select one or more objects to distribute.

2. Choose Spacing tool from the Array flyout or the Tools menu.

   **NOTE** The Array flyout is on the Extras toolbar, which is off by default. You can toggle display of this toolbar by right-clicking an empty area on the main toolbar and choosing Axis Constraints from the Customize Display right-click menu on page 8239.

3. On the Spacing Tool dialog, click Pick Path or Pick Points to specify a path.
   If you click Pick Path, select a spline from your scene to use as the path.
If you click Pick Points, click a start point and an end point to define a spline as the path. When you’re finished with the Spacing Tool, 3ds Max deletes this spline.

4 From the drop-down list at the bottom of the Parameters group, choose a spacing option.
   The parameters available for Count, Spacing, Start Offset, and End Offset depend on the spacing option you choose.

5 Specify the number of objects to distribute by entering a Count value, or by using the spinner.

6 Depending on the spacing option you choose, adjust the spacing and offsets.

7 In the Context group, choose one of the following:
   ■ **Edges** specifies that spacing be determined from the facing edges of each object’s bounding box.
   ■ **Centers** specifies that spacing be determined from the center of each object’s bounding box.

8 To align the insertion points of the distributed objects to the tangent of the spline, turn on Follow.

9 In the Type Of Object group, choose the type of object to output (copy, instance, or reference) and click Apply.
Modifiers

Modifiers provide a way for you to sculpt and edit objects. They can change the geometry of an object, and its properties.

Example: effects of the Twist modifier on an object

The modifiers you apply to an object are stored in a stack on page 8641. By navigating up and down the stack, you can change the effect of the modifier, or remove it from the object. Or you can choose to “collapse” the stack and make your changes permanent.

There are other general things to know about using modifiers:

- You can apply an unlimited number of modifiers to an object or part of an object.
- When you delete a modifier, all its changes to the object disappear.
- You can move and copy modifiers to other objects using controls in the modifier stack display on page 8187.
- The order or sequence in which you add modifiers is important. Each modifier affects those that come after it. For instance, adding a Bend modifier on page 1165 before a Taper on page 1807 can give you distinctly different results than if you first added the Taper followed by the Bend.

See also:
- Modifier Stack Controls on page 8187

How Modifiers Differ from Transforms

Modifiers and transforms differ in how they affect an object and the order in which they are applied to an object.

Transforms

The transform is the most basic of 3D manipulations. Unlike most modifiers, transforms are independent of an object’s internal structure, and they always act in world space on page 8769. An object can carry any number of modifiers, but it always has only a single set of transforms.

The transforms of an object are expressed as a matrix of values that contain the following information:

- Position of the object center in world space
- Rotation of the object in world space
- Scale of the object along its local axes

The matrix is called the transformation matrix, and its information relates directly to the transforms Move, Rotate, and Scale. Applying one of these transforms alters the values in the transformation matrix.

Transforms have the following properties. They are:

- Applied to the entire object.
- Independent of their order of application. No matter how many times you transform an object, the results are stored as one set of values in the matrix.
Applied after all object-space modifiers have been evaluated, but before the world-space modifiers. See Using the Modifier Stack on page 1045.

Most transforms produce equal displacement along one or more axes of an object, or part of an object. For Move on page 914, Rotate on page 915, and Uniform Scale on page 918 transforms, the displacement is equal along all three axes. When you rotate a box, all sides remain parallel. In general, all vertices keep the same relative position to one another. The exceptions are Squash on page 920 and Non-Uniform Scale on page 919, which displace axes by different amounts.

**TIP** Use the XForm modifier on page 2010 if you want to transform an object at a specific location in the stack (that is, after some object-space modifiers but before others), or if you want to transform a sub-object selection. See Modifying at the Sub-Object Level on page 1054.

**Modifiers**

Most modifiers allow you to perform operations on the internal structure of an object in object space on page 8659. For example, when you apply a modifier such as Twist on page 1833 to a mesh object, the position of each vertex of the object is changed in object space to produce the twisting effect.

Modifiers can operate at the sub-object level, and are dependent on the internal structure of the object when the modifier is applied.

Modifiers have the following properties. They are:

- Applied to all of an object or part of an object (using a sub-object selection).
- Dependent on the order of application. Applying a Bend followed by a Twist produces a result different from applying a Twist followed by a Bend.
- Displayed as individual entries in the modifier stack, where you can turn them on or off, and change the order in which they're applied.

Some modifiers operate in world space. These use world-space coordinates, and are applied to the object after all object-space modifiers and transforms have been applied. Otherwise, they have the same overall properties as object-space modifiers.
Transforms, Modifiers, and Object Data Flow

Once you have defined an object, 3ds Max evaluates changes affecting the base object and displays the result in the scene. What these changes are, and the order in which they are evaluated, is called the object data flow.

Master Object

*Master object* refers to an object defined by a set of creation parameters and the original position and orientation of its pivot point. You never see the master object. What you see in the viewport is always the result of at least the following data flow:
Object creation parameters in the Modify panel and Track View
An example of master objects with different creation parameters.

**Object-Space Modifiers**

The object-space modifiers on page 1159 are the next group evaluated in the data flow. Each modifier is evaluated in the order it was placed on the modifier stack. The modifications all occur in the object’s object space and the result is called the modified object.
Object modifiers in the Modify panel and Track View
The effect of modifiers on a master object.

Object Transforms

Once the modified object has been evaluated, it is transformed within the world coordinate system. Transforms cover the position, rotation, and scale changes applied from the transform buttons on the toolbar.

The method of evaluating all modifiers first and then evaluating the combined transforms has ramifications for the way you work with 3ds Max. The effect of transforms is independent of the order in which they are applied. The order in which you apply modifiers, on the other hand, does affect the resulting geometry. If you want to apply a transform that is evaluated in a specific order in the modifier stack, use the XForm modifier on page 2010.
Transforming a modified object

Space Warps

Space warps on page 2887 are evaluated after transforms. They distort objects bound to the space warp based on the position of the object in world space. For example, a Wave space warp on page 2979 causes the surface of an object to undulate in the form of a wave. As the object or the space warp moves through world space, the waves move across the object’s surface.

Like space warps, world-space modifiers on page 1067 are evaluated after transforms. A world-space modifier is like a space warp bound to a single object.

Object Properties

Object properties are the last to be evaluated before the object is displayed. These are values specific to an object such as its name or settings you specify on the Object Properties dialog on page 283, such as shadow-casting properties; and materials you have applied to the object.

This is the end of the data flow, and the result is the named object you see in your scene.
Right-click an object and choose Properties to display its Object Properties dialog.

Object Properties affect the look of an object’s rendered output.

**Using Modifiers**

This section contains a number of topics intended to help you learn how to use modifiers and the Modify panel.
Using the Modify Panel

After adding objects to your scene from the Create panel, you often move to the Modify panel to change an object’s original creation parameters and to apply modifiers. Modifiers are the basic tools for reshaping and adjusting primitive geometry.

NOTE You can float on page 8555 or dismiss the command panel using the Customize Display right-click menu on page 8239. The default setting is to display the command panel docked at the right of your screen. If it is not displayed or you want to change its location and docking or floating status, right-click in a blank area on any toolbar, and choose from the shortcut menu.

The Modify panel stays in view until you click another command panel tab. The panel updates to show the options and controls that are available for the currently selected object or modifier.
Using Modifiers

Once you’ve applied modifiers to an object, you can use the Modifier Stack on page 8187 to find a particular modifier, change its parameters, edit its sequence in the modifier stack, copy its settings to another object, or delete it entirely.

You can find alphabetical lists of modifiers in Object-Space Modifiers on page 1159 and World-Space Modifiers (WSMs) on page 1067.

General Guidelines

You can generally do the following with the Modify panel:

- Modify anything you can select. This includes any object or set of objects, or any part of an object down to the sub-object level. For example, you can use the Mesh Select modifier to select a single face, then apply a Taper modifier to it.

- Apply an unlimited number of modifiers to an object or part of an object. The order or sequence in which you make modifications is important. Each modification affects those that come after it. See Using the Modifier Stack on page 1045.

**NOTE** Some modifiers can be applied only to certain types of objects.

Modifier Sub-Object Levels

In addition to its own set of parameters, a modifier typically has one or more sub-object levels that you access through the modifier stack on page 1045. The most common of these are a gizmo and a center.

**Gizmo** Displays in viewports as a wireframe that initially surrounds the selected object. A gizmo acts like a mechanical apparatus that transfers its modification to the object it’s attached to. To alter the effect of the modifier on the object, you can move, scale, and rotate the gizmo as you would any object.

**Center** The center is the modifier’s pivot point on page 8686. You can move a modifier’s center, which alters the effect of the modifier on the object.

Parametric Deformations and Other Modifier Types

One set of object-space modifiers is known as parametric deformations ("parametric deforms" on the Modifiers menu). Twist on page 1833 and Bend
on page 1165 are examples. Parametric deformations alter the selection passed to them without explicitly depending on topology.

Many other types of modifiers, however, perform operations on the explicit topology of sub-object selections. The Edit modifiers and Select modifiers are examples. When a topology-dependent modifier is present on the stack, you can adversely affect its results if you visit previous stack operations and change the number or order of sub-objects (such as faces or vertices) in the selection. If you try to do this, a warning alerts you to the situation.

You can safely edit the stack beneath the topology-dependent modifier, as long as you do not add or remove sub-objects from the selection on which it operates.

**Procedures**

**To use the Modify panel:**

1. Select an object in your scene.

2. Click the Modify tab to display the Modify panel.
   
   The name of the selected object appears at the top of the Modify panel, and fields change to match this object.
   
   The object's creation parameters appear in rollouts on the Modify panel, below the modifier stack display. You can use these rollouts to change the creation parameters for an object. As you change them, the object updates in the viewports.

3. Apply a modifier to an object (described in the next procedure).
After you apply a modifier, it becomes active, and rollouts below the modifier stack display settings specific to the active modifier.

To apply a modifier to an object:

1. Select the object.
2. Do one of the following:
   - Choose a modifier from the Modifier List. This is a drop-down list at the top of the Modify panel.
     - **TIP**: You can use the mouse or keyboard to choose a modifier from the Modifier List. To use the keyboard, first open the list with the mouse, and then type the first letter in the modifier’s name. From there you can use the arrow keys or the method described in the following paragraph to highlight the desired modifier, and then press Enter to assign the modifier. In many cases, several modifier names start with the same letter. You can go directly to a particular modifier if you type the first few letters (enough for a unique combination) in the desired modifier’s name quickly. For example, say you want to assign the Mirror modifier to an object. Typing \texttt{M} goes to Mesh Select, which isn’t anywhere near Mirror in the Modifier list, but typing \texttt{MI} goes directly to Mirror.
   - Choose a modifier from the Modifiers menu. This menu is organized into sets by functionality. Not all modifiers appear on the Modifiers menu.
   - If the modifier buttons are visible on the Modify panel and the modifier you want is one of them, click the button.
     - If the buttons are not visible but you want to use them, click the Configure Modifier Sets button on page 8210 (below the modifier stack display) and choose Show Buttons. A set of buttons with the names of modifiers appears between the modifier list and the stack display. Click Configure Modifier Sets again, choose the set of modifiers you want to use (for example, Free-Form Deformations), and then click the button for the modifier you want to apply.

Rollouts are now displayed below the modifier stack display, showing settings for the modifier. As you change these settings, the object updates in viewports.
To drag a modifier to an object:

1. Select an object that already has a modifier you would like to use on another object.

2. To copy the modifier without instancing it, drag the modifier's name from the stack display to the object in a viewport that you want to use the same modifier. To move the modifier, use Shift+drag; this removes it from the original object and applying it to the new one. To instance the modifier, use Ctrl+drag; this creates an instanced modifier applied to both the original object and the new one.

**NOTE** Instancing a modifier causes its name to be displayed in italics in the modifier stack. This indicates that the modifier is instanced, meaning that a change to the modifier parameters of one object will affect the other.

---

### Using the Modifier Stack

The modifier stack and its editing dialog are the keys to managing all aspects of modification. You use these tools to:

- Find a particular modifier and adjust its parameters.
- View and manipulate the sequence of modifiers.
- Copy, cut, and paste modifiers between objects, or sets of objects.
- Deactivate the effect of a modifier in the stack, the viewport display, or both.
- Select a modifier's components, such as gizmo or center.
- Delete modifiers.

**See also:**

- [Editing the Stack](#) on page 1049
- [Modifier Stack Controls](#) on page 8187
- [Modifier Stack Right-Click Menu](#) on page 8200
Examining the Modifier Stack

The modifier stack (or "stack" for short) is a list on the Modify panel. It contains the accumulated history of a selected object and any modifiers you have applied to it.

Internally, 3ds Max "evaluates" an object beginning at the bottom of the stack and applies changes to the object by moving sequentially to the top of the stack. You should therefore "read" the stack from bottom up to follow the sequence used by 3ds Max in displaying or rendering the final object.

Here is an example of stack entries for a capsule object (an extended primitive):

- At the bottom of the stack, the first entry always lists the object type (in this case, Capsule). You click this entry to display the original object creation parameters so you can adjust them. If you haven’t applied any modifiers yet, this is the only entry in the stack.

- Object-space modifiers appear above the object type. You click a modifier entry to display the modifier’s parameters so you can adjust them, or to delete the modifier.

  Modifiers are preceded by a plus or minus icon if they have sub-object (or sub-modifier) levels. See Using the Stack at Sub-Object Level on page 1057.

- At the top of the stack are world-space modifiers and space warps bound to the object. (In the illustration, Displace Mesh is a world-space modifier.) These always appear at the top, and are described as "bindings."
Basics of Using the Stack

With the stack feature, no modification has to be permanent. By clicking an entry in the stack, you can go back to the point where you made that modification. You can then rework your decisions, temporarily turn off the modifier, or discard the modifier entirely by deleting it. You can also insert a new modifier in the stack at that point. The changes you make ripple upward through the stack, changing the current state of the object.

Adding Multiple Modifiers

You can apply any number of modifiers to an object, including repeated applications of the same modifier. As you start applying object modifiers to an object, the modifiers "stack up" in the order they're applied. The first modifier appears just above the object type at the bottom of the stack.

■ 3ds Max inserts a new modifier in the stack just above the current selection, but always in the proper location. If you try to insert a world-space modifier between two object-space modifiers, 3ds Max automatically places it at the top of the stack.

■ If you select the object type on the stack and apply a new object-space modifier, it appears just above the object type and becomes the first modifier evaluated.

Effect of Stack Sequence

3ds Max applies modifiers in their stack order (beginning at the bottom and carrying the cumulative change upward), so a modifier’s location in the stack can be critical.

The following figure shows the difference between the objects based entirely on a reversal in the stack order of two modifiers. On the left-hand tube, a Taper modifier is applied before a Bend modifier, and on the right-hand tube, the Bend is applied first.
Results of reversing stack order of two modifiers

Using the Buttons

These buttons, found just below the modifier stack, help you manage the stack:

- **Pin Stack** Locks the stack and all Modify panel controls to the selected object’s stack. You can continue to edit the object even if you select a different object in the viewports.

- **Show End Result** When on, shows the effect of the entire stack on the selected object. When off, shows the effect of the stack only up to the currently highlighted modifier.

- **Make Unique** Makes an instanced object unique, or an instanced modifier unique to a selected object. See details in Editing the Stack on page 1049. This option is also available from the Modifier Stack right-click menu on page 8200.

- **Remove Modifier** Deletes the current modifier from the stack, eliminating all changes caused by that modifier.

- **Configure Modifier Sets** Click to display a pop-up menu that lets you configure how to display and choose modifiers on the Modify panel.
Editing the Stack

You can copy, cut, and paste modifiers within an object’s stack, or into the stacks of other objects. Among other features, you can give modifiers explicit names to help you remember the intended effect.

**To edit the stack:**

1. Choose an item in the stack.
2. Right-click.
   This displays the Modifier Stack right-click menu on page 8200, which is briefly introduced in this topic.

**Rearranging and Sharing Modifiers**

**To rearrange modifiers:**

The easiest way to move a modifier to a different location in the stack is simply to drag it there. Alternatively, you can use the following cut/copy and paste procedure.

1. Choose one or more modifiers, right-click, and choose Copy or Cut.
2. Choose a new location in the list, right-click, and choose Paste. The paste occurs immediately above the new location.

**To share modifiers with other objects:**

1. Choose one or more modifiers, right-click, and choose Copy.
2. Select a different object or group of objects.
3. Choose a location in the new stack, right-click, and choose Paste.
   You can also drag from the modifier stack display to an object in a viewport.

---

**TIP** Select world-space and object-space modifiers separately. Cut, Copy, and Paste are disabled if both types are selected. If you try to paste a world-space modifier into the section for object-space types, the paste occurs at the top of the world-space section. The reverse is also true.
Unique and Instanced Modifiers

By default, pasted modifiers are unique: they lose all connection with the modifier from which they were copied. Compare with an instanced modifier, which is shared between two or more objects. Changing a parameter on an instanced modifier automatically changes the same parameter on the other instanced objects.

To create an instance of a modifier:

- After copying or cutting the modifier, right-click and choose Paste
  Instanced.
  In the stack, the name of an instanced modifier appears in italics.

Any instance of a modifier controls all other instances. Use this feature when you want a number of objects to take on the same feature.

For example, copying an instanced Bend modifier on page 1165 to a number of trees would make them all bend identically. Changing Bend parameters on any one tree would change the bend on all the others.

To remove the instancing from a modifier:

- Select the instanced modifier and click Make Unique. This converts
  the modifier from instanced to unique.

Using Make Unique with Multiple Items

Assume you have a group of trees all sharing the same instanced Bend modifier. If you select two of them and click Make Unique on page 8206, a message asks, "Do you want to make the selected objects unique with respect to each other?"

- If you click Yes, the two trees become independent of one another. Each
  has a unique copy of the modifier and can be bent separately.

- If you click No, the two trees continue to share the same instanced modifier,
  but separately from the instance in the original group. The two trees can
  be bent together.

See How Instanced Modifiers Work on page 1063.
Collapsing the Stack

You can use Collapse All or Collapse To to collapse all or part, respectively, of an object's stack to an editable object that preserves the cumulative effect of the collapsed modifiers on the base object. You might choose to do this in these cases:

■ You've finished modifying an object and want to keep it as is.
■ You want to discard an object's animation tracks. Alternatively, you can Alt+right-click a selected object and choose Delete Selected Animation.
■ You want to simplify a scene and save some memory.

NOTE In most cases, collapsing all or part of the stack will save memory. However, collapsing some modifiers, such as Bevel, increases file size and memory use.

After you collapse an object's stack, you can no longer parametrically adjust either its creation parameters or the individual modifiers affected by the collapse. Animation tracks that were assigned to such parameters also disappear.

Collapsing the stack does not affect the object's transforms; it affects world-space bindings only if you use Collapse To. Collapsing the stack does not save memory if the stack contains no modifiers.

TIP Before you use either Collapse option, use Application menu on page 7989> Save > Save Selected to preserve a copy of the original parametric object.

To collapse the stack:

1 Right-click the modifier stack display.

2 If modifiers have been applied to the object, choose Collapse To or Collapse All.
   ◦ Collapse To Collapses the stack, up to and including the chosen modifier, into an editable object. Modifiers on the stack above the chosen modifier are not affected, and you can still adjust them individually.
   The resultant object type depends on the uppermost modifier that outputs a specific geometry type, if any. If the stack contains no such modifier, the result is an editable mesh on page 2192. If the collapsed portion of the stack contains a modifier that outputs a specific geometry type, and no other such modifier is above it, the result is that type of object. For example, if the topmost such collapsed modifier is Edit Poly, the resultant object is Editable Poly.
**Collapse All** Collapses the entire stack into an editable object, other than world-space bindings. Any world-space bindings on the stack are left intact.

The resulting stack list shows a single entry: Editable Mesh, unless any modifiers on the stack output a different type of geometry. For example, if the topmost such modifier is Edit Poly, the resultant object is Editable Poly.

If no modifiers are applied to the object, choose one of the Convert To options:
- Editable Mesh
- Editable Spline
- Editable Patch
- Editable Poly
- NURBS

**NOTE** Depending on the object type, not all Convert To options might be available.

---

**Edit Modifiers and Editable Objects**

To achieve highly detailed modeling effects, you can directly transform, modify, and align the geometry of objects at a sub-object level on page 8733, using the Modify panel on page 8184. The following table shows the different object types and their respective sub-objects.

<table>
<thead>
<tr>
<th>Object Type</th>
<th>Sub-Object Geometry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mesh</td>
<td>Vertex, Edge, Face, Polygon, Element</td>
</tr>
<tr>
<td>Poly</td>
<td>Vertex, Edge, Border, Polygon, Element</td>
</tr>
<tr>
<td>Spline</td>
<td>Vertex, Segment, Spline</td>
</tr>
<tr>
<td>Patch Surface</td>
<td>Vertex, Edge, Patch, Element, Handle</td>
</tr>
</tbody>
</table>
With the exception of NURBS, to gain access to an object’s sub-objects, in most cases you must first either convert the object into an editable object, or apply any of various modifiers to the object, such as Edit Mesh/Spline/Patch or Mesh/Spline Select. The Select modifiers simply let you specify sub-objects for modification by subsequently applied modifiers. The distinctions between transforming an object into an editable object and applying an Edit modifier to it are as follows:

<table>
<thead>
<tr>
<th>Method</th>
<th>Advantage</th>
<th>Disadvantage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Editable object</td>
<td>More efficient</td>
<td>Lose creation parameters</td>
</tr>
<tr>
<td></td>
<td>Can animate sub-objects</td>
<td></td>
</tr>
<tr>
<td>Edit/Select modifier</td>
<td>Keep creation parameters</td>
<td>Less efficient</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Cannot animate sub-objects</td>
</tr>
</tbody>
</table>

To convert a parametric object to an editable object, see any of the following topics:

- **Editable Mesh Surface** on page 2192
- **Editable Poly Surface** on page 2240
- **Editable Spline** on page 620
- **Editable Patch Surface** on page 2360

To apply an Edit modifier, see any of the following topics:

- **Edit Mesh Modifier** on page 1321
- **Edit Spline Modifier** on page 1424
- **Edit Patch Modifier** on page 1329

To apply a Select modifier, see the following topics:
Modifying at the Sub-Object Level

To achieve highly detailed modeling effects, you can directly transform, modify, and align the geometry of objects at the sub-object level on page 8733.

Sub-objects are the pieces that make up objects, such as vertices and faces. You can also access and transform the sub-object components of modifiers.

The particular geometry available at sub-object level depends on the object type. See Edit Modifiers and Editable Objects on page 1052 for details on each object type.
In a row of column sub-objects, a single column has been modified at the sub-object level.

Making a Sub-Object Selection

These are the general steps in setting up an object for sub-object selection. See Edit Modifiers and Editable Objects on page 1052 for more information.

1. Convert the object into an editable object such as an editable mesh, editable spline, editable poly, and so on. (Some modifiers you can apply
to the object, such as Edit Mesh, Mesh Select or Spline Select, also have sub-object levels.)

**TIP** Work in a wireframe viewport so you can see the geometry.

2. On the modifier stack display, click the plus icon to the left of the name of the modifier or editable object. This expands the object’s hierarchy, showing the names of the sub-object levels at which you can work.

3. On the stack display, choose the kind of sub-object geometry you want to work with: for example, Vertex, Face, or Edge. Each sub-object selection level has rollouts with their own sets of options.
   The sub-object level highlight is yellow by default.

4. Use standard selection techniques to select sub-object geometry, from a single sub-object to the entire object. By default, the sub-object selection highlights in red.

Once you make a sub-object selection of geometry, you can do any of the following:

- Apply any options supplied for the kind of object and the selection level.
- Apply standard transforms: Move, Rotate, Scale. For more information, see Transforming a Sub-Object Selection, following.
- Apply object-space modifiers (Bend, Taper, and Twist, for example) to perform useful modeling operations.
- Apply object-space modifiers (UVW Map or Smooth, for example) to perform useful surfacing operations.
- Bind a space warp on page 2887 to the selection. The rest of the object is unaffected by the warping.
- Use the toolbar commands Align on page 967, Normal Align on page 973, and Align To View on page 979 with face selections.

**Transforming a Sub-Object Selection**

Using an editable mesh, poly, patch, or spline, you can directly transform any sub-object selection. However, “Select” modifiers like Mesh Select on page 1500 and Spline Select on page 1741 enable only selection.
To transform a sub-object selection made with a Select modifier:

1. Add an XForm modifier on page 2010 to the stack, following (or somewhere above) the Select modifier.

2. In the stack, open the Select modifier and make a sub-object selection.

3. Choose XForm in the stack. You then transform the XForm gizmo, which applies the transform to the selection.

Selecting and Transforming Modifier Components

Most modifiers have sub-object components, such as a gizmo and center. Like sub-object geometry, these components can be accessed and transformed at sub-object level, directly modifying the object’s shape.

Other modifiers, like those for free-form deformation, have control points and lattices at a sub-object level. Moving these components creates the modeling effects of the modifier.

Using the Stack at the Sub-Object Level

With editable objects such as meshes and splines, or modifiers with sub-object levels such as Mesh Select and Spline Select, you can continue to model a single sub-object selection by applying any number of other modifiers. When you go back and change the original selection, the new selection is "passed up the stack" to the modifiers that follow.

Editable meshes and splines have "built-in" sub-object selection at their base level. But the selections you make with Mesh Select and Spline Select work exactly the same way on the stack.

This topic uses meshes for its examples. You can apply the same concepts to editable splines, patches, and poly objects.

Working at Two Levels

When you select an object and apply modifiers (for example, Bend and Taper), you’re working with the object as a single unit, or "whole object", at the object level.

When you make a sub-object selection, the stack display changes to show you are no longer working with the whole object. Consider the effect of a Mesh Select applied between Bend and Taper modifiers (Bend is below Taper). To the right of the Mesh Select and Taper modifiers, a sub-object icon (similar to
the sub-object button in the Selection rollout) appears to show that sub-object selection is now in effect.

The vertex sub-object selection made at the Mesh Select level is passed up the stack to the Taper modifier. This means the Taper modifier is applied only to the vertices selected at the Mesh Select level.

![Sub-object icon (in this case, for Vertex) to the right of modifier names in the stack display]

Sub-object selection carries upward through the stack. If you add more modifiers, each shows the sub-object icon to indicate this state.

By learning to "read the stack," you can move back and forth between the object and sub-object levels while you work on an object.

**Returning to Whole-Object Level**

When you finish modeling a certain sub-object selection, you can return to work on the whole object.

**To return the stack to object level:**

1. At any point in the stack, apply another Mesh Select modifier.

2. Leave this Mesh Select modifier at the top level (the object level, which highlights in gray). Any modifiers already on the stack above this modifier no longer show the sub-object icon. Any modifiers you add above the second Mesh Select now apply to the whole object.

3. To continue sending the sub-object selection up the stack, delete the second Mesh Select.

**Naming Sub-Object Selections**

Sub-object selections are often quite complex, involving a great many small elements that would be difficult to select a second time. For this reason, it's a good idea to name important selection sets using the Named Selection Sets list on page 185 on the main toolbar.
Named sub-object selections only appear at the type of level where they were first named. For example, if you select a set of vertices, you can name the selection at that vertex sub-object level. Then, when you later go to retrieve the named selection, you can access it only from the same modifier's vertex sub-object level.

Copying Sub-Object Selections

Once you name a sub-object selection set, you can copy it between modifiers in the same stack, or to the stack of another object of the same type. Editable meshes and Mesh Select (and their spline, patch, and poly counterparts) have buttons for Copy and Paste at each level of geometry, in the Modify panel > Selection rollout.

To copy/paste named sub-object selections:

1. Make a sub-object selection.
2. In the Selection rollout, click Copy. From the dialog, choose any available named selection set for that level of geometry.
3. Go to another Select modifier or to an editable mesh or poly, at the same level of geometry. Click Paste to complete the copy.

Modifying Multiple Objects

You can apply modifiers to multiple objects. In general, the process is parallel to modifying a single object. You make a selection set and apply an available modifier. The modifier then appears on a special stack that refers only to the commonality of that selection set.
The Principle of Commonality

When you select multiple objects, 3ds Max determines what the particular selected set of geometry has in common, if anything. Given any "commonality" among objects, 3ds Max presents the options as available modifiers. Unavailable modifiers represent areas where commonality does not hold.

You can apply modifiers to different categories of objects, depending on the modifier. For example, you might apply Bend to both a 3D object and a 2D...
shape. You can apply Mesh Select to a spline primitive and convert it to a mesh, but the reverse is not true: Spline Select is restricted to objects of the spline category.

**To modify multiple objects:**

1. Select two or more objects.
   - For selection sets, the name at the top of the Modify panel changes to read "Multiple Selected." If the objects are grouped, the group name appears.

2. Choose the kind of pivot point you want to use. See Using Pivot Points, (below).

3. Apply a modifier and adjust its parameters.
   - If you apply a Mesh Select modifier, you can select geometry on one or more of the objects to use as a sub-object selection set.

**Using Pivot Points**

The first item in the Modifier List is a toggle called Use Pivot Points. This toggle is available only when multiple objects are selected.

- When on, 3ds Max uses the pivot point of each object as the center of a modifier's operation. For example, if you bend a line of trees around the Z axis, each bends along its own trunk.

- When off, 3ds Max calculates a central pivot point for the entire selection set, and modifies the selection as a whole. For a Z-axis bend, trees at the end of a line would deform more than those at the center where the pivot is located.

**IMPORTANT** Choose the pivot setting before you apply the modifier. You can't change the pivot point afterward, although you can delete the modifier and start over without deselecting the selection set.
Original objects

Single modifier applied to all objects
when you apply a modifier to multiple objects, each object receives an identical version of the modifier. these are called instanced modifiers. they are interchangeable. a change to any one of the instances affects all the other instances. how instanced modifiers work on page 1063 covers instanced modifiers in detail.

**tip** sometimes you might apply modifiers to a selection set, perform some other operations, and select the set again, only to find its modifier stack is empty. this happens if you applied another modifier to an individual object in the original selection set. when you select the set again, the modifier stack is empty because all members of the set no longer have all modifiers in common. you can still access the instanced modifiers by selecting a single object in the set. the individual object's stacks still contain the modifiers you applied to the set as a whole.
In the stack, the name of an instanced modifier appears in *italic*.

**Objects sharing a single instanced modifier**

**Identifying Instanced Modifiers**

You can quickly lose track of which objects share the same modifier. An option on the Views menu highlights those objects.

**To identify objects sharing instanced modifiers:**

1. Select an object with an instanced modifier. Choose the instanced modifier in its stack.

2. Choose Views menu > Show Dependencies. Other objects with instances of the same modifier appear in a distinctive color (purple by default).

**Adjusting Instanced Modifiers**

You can make changes to an entire set of objects from a single instance. This is a major advantage of instanced modifiers.
To adjust instanced modifiers:

1. Select any object in a set of objects with instances of the same modifier.
2. Choose the instanced modifier in its stack.

   The single object highlights and the appropriate gizmos appear for the entire selection set. Adjustments to this modifier now affect the entire set.

Changing the parameter of an instanced modifier for one object affects all the objects sharing the modifier.

Making Instanced Modifiers Unique

At some point in your work, you might want to turn a modifier instance into a local copy that affects only a single object. To do so, click Make Unique on page 8206 on the Modify panel. This button appears beneath the modifier stack display. (Make Unique is also available as a pop-up menu choice when you right-click the instanced modifier's name in the stack display.)
To make an instanced modifier unique:

1. Select an object with an instanced modifier.
2. Choose the instanced modifier in its stack.
3. Click Make Unique beneath the modifier stack display. The modifier is no longer listed in italic text and if Show Dependencies is set, the highlight disappears from the other objects.

The modifier is now separate from the set of instanced modifiers. Adjustments you make to this modifier no longer affect other objects. Its parameters and gizmo remain unchanged from their original, instanced settings until you adjust them.

To make multiple modifier instances unique:

1. Select two or more objects with the same instanced modifier. The stack now shows what the objects have in common.
2. Choose the instanced modifier in the stack.
   There can be more than one instanced modifier in this stack. Click the one you want to make unique for each of the selected objects.
3. Click Make Unique.
4. Right-click and choose Make Unique from the menu. The modifier is no longer listed in italic text and if Show Dependencies is set, the highlight disappears from the other objects.
5. Click Yes to make the two objects become independent of one another. Click No for the two objects to continue to share the same instanced modifier, but separate from the instance in the original group.

The parameters for this modifier disappear, because the objects no longer share the modifier. For each object, the modifier is now separate from the set of instanced modifiers.

As with a single object, the parameters and gizmo are unchanged in the now unique modifiers.

■ To access the unique modifiers, select the objects individually.

NOTE If both the object and the modifier are instances, you can choose either in the stack before you click Make Unique.
World-Space Modifiers (WSMs)

World-space modifiers act as object-specific space warps. They are carried with the object, but like space warps use world space on page 8769 rather than object space for their effects. World-space modifiers eliminate the need for binding to a separate space-warp gizmo, making them convenient for modifying a single object or selection set.

You apply world-space modifier like you apply standard object-space modifier. You can access world-space modifiers from the Modifiers menu, the Modifier List in the Modify panel, and applicable modifier sets on page 8209. A world-space modifier is indicated by either an asterisk or the text “(WSM)” next to its name. (The asterisk or “(WSM)” distinguishes the world-space version from the object-space version of the same modifier, if one exists.)

When you assign a world-space modifier to an object, it appears at the top of the modifier stack, listed as a binding, in the same area as the space warp bindings.

Camera Map Modifier (World Space)

Modify panel > Select an object. > Modifier List > World-Space Modifiers > Camera Map (WSM)

Select an object. > Modifiers menu > UV Coordinates > Camera Map (WSM)

The Camera Map world-space modifier is similar to the Camera Map modifier on page 1180, in that it applies UVW mapping coordinates to the object based on a specified camera. As a result, if you assign the same map as a Screen environment to the background as you apply to the object, the object is invisible in the rendered scene.

The main difference between the world-space version of Camera Map and the object-space version is that, when you move the camera or the object using the object-space version, the object becomes visible, because the UVW coordinates are fixed to the object's local coordinates. When you move the camera or object using the world-space version, the object remains invisible because world coordinates are used instead.
Interface

![Camera Mapping Interface]

**Current Camera Object group**

**Label** Names the current camera used for mapping. If there is no current camera, reads "None."

**Pick Camera** Click this button, and then select the camera you want used for mapping.

**Channel group**

**Map Channel** Specifies use of a map channel on page 8627. Map channels are specified in the Material Editor on page 5641.

**Vertex Color Channel** Specifies use of the Vertex Color Channel (see UVW Map Modifier on page 1932).

**Displace Mesh Modifier (World Space)**

Select an object. > Modify panel > Modifier List > World-Space Modifiers > Displace Mesh (WSM)

The Displace Mesh world-space modifier (World Space) lets you see the effect of displacement mapping on page 6059 on editable mesh objects on page 2192 and objects with a Disp Approx modifier on page 1310 applied to them. If a displacement map is applied to the object, the mesh shows the effect of the displacement map. Displace Mesh replaces the mesh with its displaced version.
There are two main reasons for using Displace Mesh:

- As a visualization aid to see the effect of a displacement map in viewports, and to compare the placement of displaced objects with other objects in the scene. For example, if you use an animated displacement map to create waves on a water surface, you might temporarily apply Displace Mesh to see where the ripples meet the waterline of a boat. When you use Displace Mesh in this way, usually you delete it once you’ve obtained the effect you want.

- To obtain an editable mesh created from a displacement map
  To use the Displace Mesh this way, you apply it to the object that has a displacement map, then apply the Snapshot command on page 950 from the Tools menu, and choose Mesh as the clone method.

  Snapshot creates a permanently displaced mesh. As it does for other kinds of objects, Snapshot also leaves the original, displacement-mapped object in the scene. After applying Snapshot, you can delete the original object, or you can keep it in your scene to use for other purposes.

  **TIP** Use Disp Approx to displace editable meshes. Use Displace Mesh for previewing, as in the first item, but avoid using Snapshot. The mesh created by using Displace Mesh and Snapshot can have a high polygon count. This makes it slow to use interactively, and can cause smoothing problems, where the underlying mesh edges are visible.

**Interface**

The rollout for Displace Mesh lets you choose which surface approximation settings are used to produce the mesh.
Update Mesh Updates the mesh if you have changed the displacement mapping and want to see the results of the change. The mesh isn't updated automatically because that can become extremely time consuming.

Custom Settings When turned off, Displace Mesh uses default settings to subdivide the mesh for the purposes of displacement mapping. When turned on, the subdivision controls in this rollout are enabled. Default=off.

Subdivision Displacement Subdivides mesh faces to accurately displace the map, using the method and settings you specify in the Subdivision Presets and Subdivision Method group boxes. When turned off, the modifier applies the map by moving vertices in the mesh, the way the Displace modifier on page 1313 does. Default=on.

Split Mesh Affects the seams of displaced mesh objects; also affects texture mapping. When on, 3ds Max splits the mesh into individual faces before displacing them; this helps preserve texture mapping. When off, 3ds Max uses an internal method to assign texture mapping. Default=on.
TIP This parameter is required because of an architectural limitation in the way displacement mapping works. Turning Split Mesh on is usually the better technique, but it can cause problems for objects with clearly distinct faces, such as boxes, or even spheres. A box’s sides might separate as they displace outward, leaving gaps. And a sphere might split along its longitudinal edge (found in the rear for spheres created in the Top view) unless you turn off Split Mesh. However, texture mapping works unpredictably when Split Mesh is off, so you might need to add a Displace Mesh modifier and make a snapshot on page 950 of the mesh. You would then apply a UVW Map modifier on page 1932 and then reassign mapping coordinates to the displaced snapshot mesh.

Subdivision Presets group and Subdivision Method group

The controls in these two group boxes specify how the modifier applies the displacement map when Custom Settings and Subdivision Displacement are both turned on. They are identical to the surface approximation controls on page 2737 for NURBS surfaces.

Displace NURBS Modifier (World Space)

Select a NURBS object. > Modify panel > Modifier List > World-Space Modifiers > Displace NURBS (WSM)

The Displace NURBS world-space modifier (World Space) converts a NURBS object into a mesh. If a displacement map is applied to the object, the mesh shows the effect of the displacement map in viewports. There are two main reasons for using Displace NURBS:

- As a visualization aid to see the effect of a displacement map in viewports
  When you use Displace NURBS this way, you usually delete the modifier once you've obtained the effect you want.

- To obtain an editable mesh created from a displacement map on a NURBS object
  To use Displace NURBS this way, you apply it to the object that has a displacement map, then use the Snapshot command on page 950 from the Tools menu, and choose Mesh as the Clone Method.

  Snapshot creates a permanently displaced mesh. As it does for other kinds of objects, Snapshot also leaves the original, displacement-mapped object in the scene. After applying Snapshot, you can delete the original object, or you can keep it in your scene to use for other purposes.
Interface

The rollout for Displace NURBS lets you choose which surface approximation settings are used to produce the mesh.

**Animated Displacement Map** If you use an animated displacement map on the mesh, turn on this toggle to have the NURBS Modifier correctly update the mesh as the displacement map animates.
You can apply a displacement map on page 6059 using the Material Editor on page 5641.

**Update Mesh** Click to update the mesh if you have changed the displacement mapping and want to see the results of the change. The mesh isn’t updated automatically because that could become extremely time consuming.

**Viewport** Uses the tessellation that the NURBS object currently uses in viewports.

**Renderer** Uses the tessellation that the NURBS object currently uses for the renderer.

**Custom** Set the tessellation directly in the Tessellation Method group box.

**Base Surface, Surface Edge, Displaced Surface, and Lock** These controls are the same as in the surface approximation controls on page 2737 for NURBS objects.

**Tessellation Method group**

The controls in this group are the same as the surface approximation controls for NURBS objects.

---

**Ignore Surface Settings** When turned off, Displace NURBS uses the surface approximation settings for surface sub-objects. When turned on, Displace NURBS uses the settings in the Tessellation Method group and overrides settings for surface sub-objects. Default=off.

**Auto Weld** All vertices closer than the **Threshold** value are automatically welded together. This can simplify the mesh geometry. It is useful to turn this on when you have increased the Merge value in order to eliminate gaps between surface edges in the approximation of the NURBS object.

---

**Hair And Fur Modifier (World Space)**

Modify panel > Make a selection. > Modifier List > World-Space Modifiers > Hair And Fur (WSM)

The Hair And Fur modifier is the heart of the Hair And Fur feature. You apply it to any object that you want to grow hair from: either a mesh object or a spline object. If object is a mesh, the hair grows from the entire surface unless
you make a sub-object selection. If the object is a spline, hair grows between the splines.

When you select an object modified by Hair And Fur, hair is displayed in viewports. The hair itself as displayed in the viewports is not selectable, though hair guides are selectable when you work at the Guides sub-object level or style hair (see below).

**NOTE** Hair And Fur renders only in Perspective and Camera views. If you attempt to render an orthographic view, 3ds Max displays a warning that says the hair will not appear.

Hair And Fur renders by “tiles,” which are 2D projections of the 3D space that the hair or fur occupies. In Autodesk 3ds Max 2010, each tile is displayed in the rendered frame window as soon as it is generated. Also in Autodesk 3ds Max 2010, you can set the maximum memory that a tile uses at render time: see Hair And Fur Render Effect on page 7061.

Hair And Fur can take advantage of multiple processors, improving rendering time on multiprocessor systems.

**Components of the Hair And Fur Feature**

Hair And Fur in 3ds Max has a few different components in the interface:

- The Hair And Fur modifier is the main component. This is where you style the hair guides, and set parameters for size and coloration, kinkiness, frizziness, and so on.

- The Hair And Fur render effect on page 7061 more directly controls how hair is rendered. Typically you don't need to change the render effect parameters, unless you have special rendering requirements. A Hair And Fur render effect is automatically added to your scene when you apply the Hair And Fur modifier.

- A Hair Light Attributes rollout on page 5443 appears for all supported lights when a Hair And Fur render effect is active using the scanline renderer, and the render effect’s Use All Lights At Render Time toggle is turned on. Controls on this rollout let you fine-tune how hair shadows appear under specific lights. The following light types are not supported when rendering hair with the “buffer” method (see “Lighting Considerations,” below): Skylight, mr Area Omni, mr Area Spot, IES Sun, IES Sky, mr Sky and mr Sun. However, mr Area Omni, mr Area Spot, mr Sky, and mr Sun are supported for hair when you use the “mr prim” method and the mental ray renderer.
NOTE For the purposes of rendering shadows in hair, Direct lights are treated as point (omni) lights.

- There is also a Hair And Fur render element on page 6825, which you can use when you are doing your own compositing.

Growth Objects

You can grow Hair either from a surface or from splines.

To grow hair from a surface, select the object and then apply the Hair And Fur modifier. You can use either geometric primitives or an editable surface type such as Polymesh.

To grow hair from splines, you can draw several splines and combine them into a single object (or turn off Start New Shape during creation), and then apply the Hair And Fur modifier. You will see some preview interpolated hairs appear in viewports. The order of the spline sub-objects is important because Hair uses this order to interpolate hair in between the splines. If the interpolation seems incoherent, you might need to physically rearrange the splines.

Using a spline emitter, Hair interpolates hair growth between pairs of splines in logical, numerical order.

Left: Splines in sequential order result in predictable hair growth.
Right: Splines in nonsequential order can produce undesirable results.

TIP To check the numerical order of splines, go to the Editable Spline level of the modifier stack and access the Spline sub-object level. Then click each spline in turn and check its ID number at the bottom of the Selection rollout. It also can help to make sure that each spline’s first vertex is where the hair roots should be.
Guide Hairs

Storing and manipulating millions of dynamic, simulated hairs is demanding on today’s technology. Therefore, just as standard 3D graphics technology uses boundaries such as surfaces to describe solid objects, Hair uses hair “guides” to describe basic hair shape and behavior.

Guides (yellow) occur at each polygon corner. Hairs (red) are interpolated between guides.

When the growth object is a surface, Hair And Fur generates guide hairs at the corners of polygons. When the growth object is a spline, the spline sub-objects are themselves the guides.

For surface-grown hair, you can manipulate the guides with styling tools on page 1095 to form a “control volume” that gets populated by interpolated hairs. The hairs can then be further manipulated with distorting controls such as Kink on page 1131 and Frizz on page 1126, which can be driven by maps or solid textures.
Frizz settings affect the hairs but not the guides.

By default, a percentage of hairs are displayed in the viewports, but surface-grown guides do not appear except when you are working at the Guides sub-object level. You can adjust the viewport display of guides and hairs with settings on the Display rollout on page 1143.

Guides are also used to calculate dynamics. After this calculation, hair interpolation takes place when you render. This is when parameters such as Frizz, as well as displacement and coloration, are calculated. You don't have control of every single hair, but this two-phase process makes the creation of realistic hair computationally feasible on a typical computer.

**Styling Hair**

The Hair And Fur modifier's growth settings have a great effect on the hair’s appearance and behavior, but you can also manipulate the guides directly (or in other words, style the hair).

For surface-grown hair, use the tools on the Styling rollout on page 1095. First, select the surface whose hair you want to edit, and then on the Modify panel, either click the Style Hair button on the Styling rollout or choose the Guides...
sub-object level from the Selection rollout on page 1082 or the modifier stack display.

After guides have been styled, hair is interpolated between neighboring guide pairs.

Mesh-based hair guides before and after styling.

With spline growth, you style the hair by editing the growth splines in the viewports.
Copying and Pasting Hair

You can copy and paste a Hair And Fur modifier from one stack to another, but you need to line up the objects as closely as possible, because Hair uses proximity to determine how to position copied guides. If the objects have significantly different geometry, the transfer of guides can be inaccurate.

Copying and pasting the Hair And Fur modifier automatically adjusts the hair scaling. Copying from a large object to a small object, for instance, results in a smaller default size in the copied modifier.

If you copy an object that has Hair And Fur in its modifier stack, Hair will also copy the modifier’s data to a new modifier that will track the new object.

Textures, Vertex Maps, and Shaders

You can control many Hair And Fur modifier parameters with maps. If you apply a map to a parameter that is not a color, such as Density, Hair uses the texture as a grayscale map that is multiplied by the parameter value (0.0 to 100.0).

You apply a map by clicking the square button to the right of the parameter. After applying a map, the letter “M” appears on the button. To place this map in the first slot in the Material Editor, Shift+click the button. To disable the map temporarily, Ctrl+click the button. A disabled map is indicated by a lower-case “m”.

Lighting Considerations

When you render using the default “buffer” method, Hair And Fur provides its own default lighting (a single omni light), unless you have one or more supported lights in the scene.
Supported lights for the scanline renderer and “buffer” method include spotlights, omni lights, direct lights (which are treated as omni lights for hair purposes), and photometric lights except for IES Sun and IES Sky. Supported lights for the mental ray renderer and “mr prim” method include the lights supported by the scanline renderer, and these mental ray light types: mr Area Omni Light, mr Area Spotlight, mr Sky, and mr Sun.

If supported lights exist in the scene, by default they are used to light the hair, and the internal default omni light is not used. This is because in the Hair And Fur render effect on page 7061, the Use All Lights At Render Time option is on by default. Also, any supported lights set to cast shadow-mapped shadows will cast shadows from rendered hair.

For Hair’s “buffer” render to consider only certain lights, select the lights you’d like Hair to use, go to the Hair And Fur render effect, turn off Use All Lights At Render Time, and then click Add Hair Properties. This causes only the designated lights to illuminate the hair. It also adds a Hair Light Attr rollout on page 5443 to each of the designated lights. This lets you fine-tune the light’s shadow settings for Hair.

With the “buffer” method, you can also raytrace your scene.

NOTE The other rendering methods provided are “geometry” and “mr prim.” The “geometry” method creates actual geometry for the rendered hair at render time. The “mr prim” method uses a mental ray shader to generate hair, and is for use only with the mental ray renderer. Use the Hair And Fur render effect to choose the rendering method.

Loading and Saving

Hair And Fur data in your scene is automatically saved when you save your MAX scene file. The state data for the hair can consume quite a bit of space, so your scene file will probably be significantly larger than it was before you applied hair.

Animating Hair

You cannot keyframe hair styling. You can keyframe Modify panel parameters to create special effects such as hair growing. But to animate hair motion, you can use the Frizz Animation parameters or use dynamics.

To animate frizz, use the Frizz Anim. on page 1131, Anim. Speed, and Frizz Anim. Dir. parameters. It’s not necessary to keyframe these to create animation; just set them to values other than the defaults.
To animate with dynamics, use the Dynamics rollout on page 1136. See To
generate a precomputed dynamics simulation with Hair on page 1137. A gravity
force is built in to Hair And Fur. You can add space warps to act as external
forces (for example, Wind).

See also:

- Hair And Fur Render Effect on page 7061
- Hair And Fur Render Element on page 6825
- Hair Light Attributes Rollout on page 5443

Procedures

To use the Hair And Fur modifier:

This procedure lists the essential steps for growing hair on an object. For more
information, see other Hair And Fur topics in this help, and the tutorials in
the Autodesk 3ds Max Tutorials, available from Help menu > Tutorials.

1. Apply the Hair And Fur modifier to a mesh or spline object.
   The hairs appear in the viewports as brown lines.

2. Set the modifier parameters according to the desired results (see Topics
   in this Section, following). Available settings include the number of hairs,
   length, thickness, and coloring.

3. Activate a Perspective or Camera viewport, and then render the scene.
   Hair cannot render in an orthographic viewport.

To apply hair to a limited area of a high-resolution object:

An efficient working method for applying hair to part of a high-poly-count
object is to use a low-poly proxy object.

1. Create the object to which you wish to apply hair.

2. Make a copy of the object in the same location as the original, remove
   any geometry where hair shouldn't grow, and reduce the polygon count.
   For example, you could use the MultiRes modifier on page 1537.

3. If the original object is to move, make the low-resolution proxy object a
   child of the original object.
4 Apply the Hair And Fur modifier to the low-resolution proxy object and adjust as necessary.

5 Make the low-resolution proxy object non-renderable (see General Panel (Object Properties Dialog) on page 283). The hair will still render.

Selection Rollout (Hair And Fur)

Select an object with the Hair And Fur modifier applied. > Modify panel > Selection rollout

The Selection rollout provides tools for accessing different sub-object levels and display settings and for creating and modifying selections, and displays information about selected entities.

When you first apply the Hair And Fur modifier to an object, the entire object is affected by the modifier. You can specify that the only part of an object should grow hair by accessing a sub-object level and making a selection.

Clicking a button here is the same as choosing a sub-object level in the modifier stack display. Click the button again to turn it off and return to the Object selection level.

Interface

NOTE Controls on this rollout are available only when the growth object is a mesh. If the growth object is a spline, the Selection controls have no effect, and sub-object levels for the Hair And Fur modifier are not visible in the modifier stack.
Guides Accesses the Guides sub-object level, which lets you edit the styling guides using tools on the Styling rollout on page 1095. When you click Guides, the Style Hair button on the Styling rollout is automatically turned on, and vice versa.

Face Accesses the Face sub-object level, which lets you select a triangular face beneath the cursor; region selection selects multiple triangular faces within the region.

Polygon Accesses the Polygon sub-object level, which lets you select polygons beneath the cursor. Region selection selects multiple polygons within the region.

Element Accesses the Element sub-object level, which lets you select all contiguous polygons in an object by clicking once. Region selection lets you select multiple elements.

By Vertex When on, you can select a sub-object only by selecting a vertex that it uses. When you click a vertex, all sub-objects that use the selected vertex are selected.

Ignore Backfacing When on, using the mouse to select sub-objects affects only those facing you. When off (the default), you can select any sub-objects under the mouse cursor, regardless of their visibility or facing. If there are more than one sub-object under the cursor, repeated clicking cycles through them. Likewise, with Ignore Backfacing off, region selection includes all sub-objects, regardless of the direction they face.

NOTE The state of the Backface Cull setting on the Display panel does not affect sub-object selection. Thus, if Ignore Backfacing is off, you can still select sub-objects, even if you can’t see them.

Named Selection Set group

Copy Places a named selection into the copy buffer.

Paste Pastes a named selection from the copy buffer.
**TIP** You can use this to grow hair from an existing selection lower on the stack. However, because the Hair And Fur modifier outputs an editable mesh, the copied sub-object selection should be from a mesh-based modifier. For example, if your base object is an editable poly, you can use tools such as Ring, Loop, and Grow to make a procedural edge selection, and then Ctrl+click the Polygon button on the Selection rollout to convert the selection to polygons. Next, apply a Mesh Select modifier (*not* Poly Select), and go to the Polygon sub-object level; the Mesh Select modifier inherits the Editable Poly selection. Use the Named Selection Sets field on the main toolbar to name the selection, and then use the Mesh Select modifier’s Copy function on the named selection. Finally, apply the Hair And Fur modifier, go to the Poly sub-object level, and paste the selection.

---

**Update Selection** Recalculates the area from which hair is grown, based on the current sub-object selection, and refreshes the display. When you access a sub-object level within the Hair modifier and make a selection, the area of hair growth doesn't automatically update. Click Update Selection to view the results of a change in sub-object selection.

**Tools Rollout (Hair And Fur)**

Select an object with the Hair And Fur modifier applied. > Modify panel > Tools rollout

This rollout provides tools for accomplishing a variety of tasks with Hair, including creating a hairstyle from an existing spline object, resetting the hair, and loading and saving general presets for the modifier as well as specific hairdos. Here you can also specify an object from the current scene to be used as hair, such as a flower or group of flowers for creating a garden.

**Using Instanced Hair**

Besides the built-in hair strands, which are created at render time, you can assign any source object as hair strands, using the Instance Node controls on the Tools rollout. For example, in the following illustration, the original orientation of the source object affects its orientation when it is used as hair strands.
Rotating the source object affects the hair orientation.

The next illustration shows how increasing the Frizz Root value creates greater amounts of distortion in the resulting instanced hairs. This image also shows how a raised pivot in the source object causes the root of the hair to go below the surface of the growth object (the red square). Compare this with the previous illustration, in which the pivot rests at the base of the source object.

Frizz causes the instanced hairs to change shape.

The next illustration shows the effect of the Merge Material check box. On the left side, Merge Material was left on, with the result that the flower model
retained its original material and coloring when used as hair. On the right, Merge material was turned off, so the flower-hairs took on the material of the flower pot growth object.

In the next illustration, the Root Thick setting, from left to right, is 2.0, 10.0, 20.0, and 30.0. With instanced geometry, the Root Thick value affects the thickness of the resulting object uniformly along its height, while the Tip Thick value has no effect. (The Root Thick and Tip Thick settings are on the General Parameters rollout on page 1111.)
Increasing Root Thick affects the overall thickness of the hair geometry.
From left to right: Root Thick = 2.0, 10.0, 20.0, and 30.0

The final illustration, below, shows how the instanced hair aligns itself faithfully to the guides, no matter how they’re styled. The styled hair was brushed from the center, and the instances align perfectly in all directions, face up, without twisting or other distortion. This makes it easy to style instances as scales, for example.
Top left: The original styled hair
Top right: The instanced hair (arrows) conforms to the styling.
Bottom: Close-up view of instanced hair
Interface

Recomb From Splines Lets you use a spline object to style the hair. Click this button and then select an object that is made up of spline curves. Hair will turn the curves into guides and populate each guide of the selected growth mesh with a replica of the closest curve.

This tool is particularly useful for creating a specific style and length, such as short hair with a part on the side, without having to manually groom the hair in the Style dialog. For optimal control, position the splines fairly closely together and use as many as possible.
Hair and guides are recombed by the spline object (white).

**Spline Deform group**

Spline deformation lets you style or animate hair by having it conform to the shape of a spline on page 577.

**Pick** Click to choose the spline you will use to deform the hair, then click the spline in a viewport, or press H and use the Pick Object dialog to select the spline.

When no spline is picked, the label of this button shows “None.” When a spline is in active use, the label shows the name of the spline you picked.

The deformation applies to all hair guides, and is a one-time operation: while splines are active, the guides are “locked” to the spline, and moving a point on a spline deforms the closest guides. However, the base of the spline (for example, where it’s attached to the head) does not move. If you deform the spline near the base of the guide, you will move the spline away from the base, because the base is fixed and will not follow the deformation.
**TIP** Clicking Recomb From Splines readjusts the hair (but not the guides) to align to the spline deformation better. However, you can’t animate Recomb From Splines.

Left: The spline picked to deform hair  
Right: Hair deformed by the spline

Animating the spline (for example, by animating the position of its vertices) animates the deformed hair, but not if you later alter the hair position by styling. This includes animating a modifier applied to the spline. The spline can be a *spline cage*: in other words, an Editable Spline object that consists of multiple splines.

Left and right: Spline cage formed of two spiral spline sub-objects  
Middle: Hair deformed by the spline cage

3ds Max interpolates between the spline shapes in the spline cage, and the shape of a hair depends on its proximity to one or another spline sub-object in the cage.

**TIP** One way to create a spline cage is to style hair, then click Tools rollout > Convert group > Guides -> Splines.
To stop using spline deformation, click the Clear Spline button (labeled “X”).

**Reset Rest** Performs an averaging of hair guides using the growth mesh’s connectivity.

This function is particularly useful after using Recomb From Splines. It’s also advantageous when you change the size ratios of polygons in the growth object. For example, if you stretch part of the mesh by moving some vertices, by default the larger polygons will contain fewer hairs per unit area. Use Reset Rest to redistribute the number of hairs on the surface for more even coverage.

![Even hair distribution before resizing polygons](image1)
![Uneven hair distribution after moving edges, altering polygon size ratios](image2)
![After using Reset Rest, distribution is again evened out.](image3)

**Regrow Hair** Discards any styling information, resetting the hair to its default state, retaining all current Modify panel settings.

**Presets group**

Lets you load and save hair presets. Each preset contains all current Modify panel settings (except Display settings), but *not* any styling information.

**Load** Opens the Hair Presets dialog, which contains a list of presets in the form of named swatches. To load a preset, double-click its swatch. Several sample presets are included with 3ds Max.
Save Creates a new preset. You're prompted for a preset name; after entering one, Hair renders the swatch, as shown by a message on the status bar. You can abort the creation of the preset by clicking the Cancel button on the status bar during rendering. If you enter an existing preset name, Hair asks you to confirm overwriting the preset.

Hairdo group

Lets you copy and paste hairdos. Each hairdo contains all the current Modify panel settings (except Display settings) and styling information. This lets you apply all hair settings from one object to another.

Copy Copies all hair settings and styling information into a paste buffer.

Paste Pastes all hair settings and styling information to the current Hair-modified object.
Instance Node group

Lets you specify an object to use as custom hair geometry. The hair geometry is not instanced from the original object, but all hairs created from it are instances of each other, to save memory.

**NOTE** Hair does not use animation from instance objects. If an object is animated, Hair uses its state at the first animation frame.

**Pick** To specify a hair object, click the Pick button and then pick an object to use. Thereafter, the button shows the name of the object you picked. To use a different instance object, or to use a modified version of the original object, click this button and then pick the new object.

**TIP** In order for the instances to be properly scaled and fit to the hair, place the model's pivot at the “root” of the object. Hair will then scale your model appropriately so that the height of each instance matches the length of the hair it has been applied to. Any part of your model that extends below the pivot will intersect the surface. This can be useful; if the hair grows at an oblique angle to the growth surface, you can raise the pivot in the original model to make sure the instanced hairs will extend all the way to the growth surface.

Also, bear in mind that the instancing engine will be deforming your model as it fits it to the hairs. Make sure that your model has enough divisions along the Z (vertical) axis for the deformation to look as smooth as it needs to; the number of subdivisions should be approximately equal to the Hair Segments value. Hair doesn't perform automatic subdivision on the geometry.

**X** To stop using the instance node, click the Clear Instance button (labeled “X”).

**Merge Material** When on, combines the material applied to the growth object and the material applied to the hair object into a single Multi/Sub-Object material and applies it to the growth object. When off, the growth object's material is applied to the instanced hair. Default=on.

**NOTE** The merged material is instanced from the instance node, so that changing the original material affects the resulting material applied to the hair.

Convert group

Use these controls to convert guides or hair generated by the Hair And Fur modifier to 3ds Max objects that you can operate on directly.
**Guides -> Splines** Copies all guides to a new, single spline object. The original guides are left intact.

**Hair -> Splines** Copies all hairs to a new, single spline object. The original hairs are left intact.

**Hair -> Mesh** Copies all hair to a new, single mesh object. The original hairs are left intact.

---

**Render Settings** Opens the Effects panel and rollout on page 7058 and adds a Hair And Fur render effect on page 7061 to the scene, if one doesn't already exist.

**NOTE** The Hair And Fur render effect settings are global, so even if you click Render Settings to open the effect settings from different Hair And Fur modifiers, you'll get the same render-effect settings.

---

**Styling Rollout (Hair And Fur)**

Select an object with the Hair And Fur modifier applied. > Modify panel > Styling rollout

The Guides sub-object level of the Hair And Fur modifier on page 1073 lets you style hair interactively in viewports. Interactive styling controls are on the Styling rollout, which has a Style Hair button that you can also click to begin styling.

**Styling with Hair Guides**

Styling tools aren't available until you click Style Hair to turn it on, or choose the Guides sub-object level in either the Selection rollout or the modifier stack.

Each guide hair has 15 segments and 14 vertices (there's an additional, non-selectable vertex at the root); for a tool to affect a guide, at least one of its vertices must be selected. To select vertices, click Select (in the Styling group) to turn it on, then use standard 3ds Max selection tools to select a portion of the guides. For example, you might drag a selection rectangle to select vertices on adjacent hair guides. By default, selected guides are displayed as orange, and unselected guides are displayed as yellow.

Selections you make this way are constrained by the buttons at the top of the Selection group: Select Hair By Ends, Select Whole Guide (the default), Select Guide Vertices, or Select Guide By Root. As these names imply, the constraints
affect how the Hair Brush modifies hair guides. The best way to get a feel for
the difference between selection constraints is to practice using the various
selection constraints with tools such as Translate. The Hair Brush uses a
combination of these constraints and IK to alter guide geometry.

Left: Hair guide before styling
Center: Translating while Select Whole Guide is active
Right: Translating while Select Hair By Ends is active

Once you've made a selection, typically you will click Hair Brush (also in the
Styling group, to the left of Select), and then use the brush in conjunction
with one of the tools at the bottom of the Styling group: Translate, Stand,
Puff Roots, Clump, Rotate, or Scale.

While you style, only selected guides are affected, and in addition, only guides
that fall within the brush area are affected at any given time. You can change
the brush size using the slider in the Styling group, or by holding down
Ctrl+Shift and dragging the mouse.

The Hair Cut tool on the Styling rollout (between Hair Brush and Select) cuts
hair guides by scaling them based on the brush location.

Interface

NOTE Controls on this rollout are available only when the growth object is a mesh.
If the growth object is a spline, the Styling controls have no effect. Instead, you
can style the hair by editing the underlying spline object.
Hair And Fur Modifier (World Space)
Style Hair / Finish Styling Click Style Hair to begin styling. Click Finish Styling to turn off styling mode. When you turn this button on, a brush is immediately available and by default the active tool is Translate. Turning on Style Hair turns on the Guides sub-object level in the Selection rollout on page 1082, and vice versa.

Selection group

Select Hair by Ends You can select only the vertex at the end of each guide hair.

Select Whole Guide (The default.) Selecting any vertex on a guide hair selects all vertices on the guide hair. When you first turn on Style Hair, Hair activates this mode and selects all vertices of all guide hairs.

Select Guide Vertices You can select any vertices on a guide hair.

Select Guide by Root You can select only the vertex at the root of each guide hair, and doing so selects all vertices on the guide hair.

Vertex display drop-down list Chooses how selected vertices are displayed in viewports.

- **Box Marker** (The default.) Selected vertices display as small squares.
- **Plus Marker** Selected vertices display as small plus signs.
- **X Marker** Selected vertices display as small Xes.
- **Dot Marker** Selected vertices display as dots.

Selection Utilities The buttons labeled “Selection Utilities” are for handling selections.
**Invert Selection** Inverts the vertex selection.
Keyboard shortcut: Ctrl+I

**Rotate Selection** Rotates the selection in space.

**Expand Selection** Expands the selection by growing its area incrementally.

**Hide Selected** Hides selected guide hairs.

**TIP** If interactive styling in viewports seems to be slow, try hiding those guides you aren’t working on.

**Show Hidden** Unhides any hidden guide hairs.

**Styling group**

**Hair Brush** (The default.) In this styling mode, dragging the mouse affects only selected vertices within the brush area.
While Hair Brush is on, a brush gizmo is displayed in viewports. In the active viewport, the brush appears as a circle, but as you can see in the other viewports, the brush is actually a three-dimensional cylindrical region.
In the active viewport, the brush appears to be a circle.
Inactive viewports show the brush to be a cylindrical region.

**Hair Cut** Lets you trim the guide hairs. To cut hair, follow this suggested procedure:

1. In Selection mode, choose any selection method.
2. Drag the mouse to select guide hairs to trim.
3. Turn on Hair Cut.
4. Resize the brush using the slider.
5. Position the brush circle over hairs to cut, and then click to cut the hairs. Hairs with vertices inside the brush circle are shortened so that their endpoints touch the brush circle.
NOTE  Cutting hair doesn’t actually remove vertices; it only scales the guide hairs. You can restore guide hairs to their original length with Scale or one of the Pop commands on page 1105.

Left: Hair guides before cutting
Right: Hair guides after cutting

Select  Goes into selection mode, where you can use 3ds Max selection tools to select guide vertices according to the constraints chosen in the Selection group (Whole Guide, Ends, and so on).

Distance Fade  Available only for Hair Brush. When on, the effect of brushing fades toward the edges of the brush, giving a gentler effect. When off, brushing affects all selected vertices equally, giving a hard-edged effect. Default=on.

Ignore Back Hairs  Available only for Hair Brush and Hair Cut. When on, hairs on back faces are not affected by the brush. Default=off.

Brush size slider  Drag this slider to change the size of the brush.
Keyboard shortcut: Ctrl+Shift+drag
The styling buttons below the Brush Size Slider are available only while Hair Brush is on.
**Translate** Moves selected vertices in the direction that you drag the mouse.

**Stand** Pushes selected guides toward a perpendicular orientation to the surface.

Left: Guide hairs before styling with Stand  
Right: Guide hairs after styling with Stand (on the right)

**Puff Roots** Pushes selected guide hairs toward a perpendicular orientation to the surface. The bias for this tool is closer to the root of the hair than to the endpoint.

Left: Hair guides before puffing roots  
Right: Hair guides after puffing roots
**Clump** Forces selected guides to move towards each other (drag mouse leftward) or farther apart (drag mouse rightward).

Left: Hair guides before clumping  
Right: Hair guides after clumping (at the right)

**Rotate** Rotate or swirls guide hair vertices around the cursor location (at the center of the brush).

Left: Hair guides before rotating  
Right: Hair guides after rotating (at the forelock)

**Scale** Scales selected guides larger (drag mouse rightward) or smaller (drag mouse leftward).
Left: Hair guides at original lengths
Right: Hair guides after scaling shorter

Utilities group

**Attenuate Length** Scales selected guides according to the surface area of underlying polygons. This is useful, for example, in applying fur to an animal model, which typically has smaller polygons in areas with shorter hair. For example, the polygons on an animal's paws are usually smaller than the ones on the chest, and the chest fur tends to be longer.

**Pop Selected** Pops selected hairs out along the surface normal.
**Right: Hair guides after using Pop Selected**

**Pop Zero-Sized** Works like Pop Selected, but only operates on zero-length hairs.

**Left: Hair guides on top of head were scaled to zero length.**

**Right: Using Pop Zero affects only the zero-length hair guides.**

**Recomb** Makes a guide parallel to the surface, using the guide's current direction as a hint.

Here's a suggested procedure: Turn on Hair Brush, select guides using Select Whole Guide, and then move the guides around not worrying about skin penetration or hair shape. You're just trying to indicate the direction of the hair flow. Click Recomb frequently, and you will soon start to see hair flowing smoothly wherever you want it to. Once you have this flow, you can do your other styling. With the Recomb tool, you probably won't need to use Comb Away. Once you have the flow as you like it, you can go in and start styling in scale, cut guides, and move some of the tips around, “shaping” or “styling” the hair.
Left: Hair guides in their default position
Right: Hair guides after clicking Recomb

**Reset Rest** Performs an averaging of hair guides using the growth mesh’s connectivity.
This function is particularly useful after using Recomb.

**Toggle Collisions** When on, styling takes hair collisions into account. When off, styling ignores collisions. Default=off.
For collisions to be used while styling, you need to have already added at least one collision object using the Dynamics rollout on page 1136. If no collisions are specified, this button has no effect.

_TIP_ If you collisions are enabled and styling interaction seems slow, try turning off Toggle Collisions.

**Toggle Hair** Toggles viewport display of generated (interpolated) hair. This doesn't affect display of the hair guides. Default=on (hair is displayed).
**Lock**  Locks selected vertices with respect to the orientation to and distance from the nearest surface. Locked vertices can be selected, but they can't be moved.

This is useful for creating different types of hair shapes. For example, to make a braid, you would comb hair down some straight tubes, and then lock the vertices to the tubes. Then, in 3ds Max, when you twist the tubes, the hairs will follow. Locked vertices are no longer dynamic, although they will follow whatever the surface does, but if other vertices on the same guides aren't locked, they can still move freely, as usual.

**Unlock**  Unlocks all locked guide hairs.

**Undo**  Reverses the most recent action.

Keyboard shortcut: Ctrl+Z

**Hair Groups group**

**Split Selected Hair Groups**  Splits the selected guides into a group. This can be useful for creating a part or a cowlick, for example.

**Merge Selected Hair Groups**  Recombines selected guides.

If you don't use Split Selected Hair Groups, then when you render hair, the generated hairs are interpolated across a styled part. When Split Selected Hair Groups is on, there is no interpolation between the split group and other hairs. To remove this effect and make the part less “clean,” click Merge Selected Hair Groups.
Quad Menu for Hair Styling

While you are styling hair at the Guides sub-object level, right-clicking a viewport displays a quad menu that contains shortcuts to many styling controls that are also found on the Styling rollout on page 1095.

Interface

<table>
<thead>
<tr>
<th>Utilities</th>
<th>Styling</th>
</tr>
</thead>
<tbody>
<tr>
<td>Merge Hairgroups</td>
<td>Ignore Back</td>
</tr>
<tr>
<td>Split Hairgroups</td>
<td>Soft Falloff</td>
</tr>
<tr>
<td>Unlock</td>
<td>Scale</td>
</tr>
<tr>
<td>Lock</td>
<td>Rotate</td>
</tr>
<tr>
<td>Toggle Hairs</td>
<td>Clump</td>
</tr>
<tr>
<td>Toggle Collisions</td>
<td>Puff</td>
</tr>
<tr>
<td>Reset Rest</td>
<td>Stand</td>
</tr>
<tr>
<td>Recomb</td>
<td>Translate</td>
</tr>
<tr>
<td>Pop Zerosized</td>
<td>Cut</td>
</tr>
<tr>
<td>Pop Selected</td>
<td></td>
</tr>
<tr>
<td>Attenuate</td>
<td></td>
</tr>
<tr>
<td>Invert Selection</td>
<td>Tip</td>
</tr>
<tr>
<td>Rotate Selection</td>
<td>Guide</td>
</tr>
<tr>
<td>Expand Selection</td>
<td>Verts</td>
</tr>
<tr>
<td>Hide Selected</td>
<td>Root</td>
</tr>
<tr>
<td>Show Hidden</td>
<td></td>
</tr>
</tbody>
</table>

Utilities quadrant

The first two choices are shortcuts to the buttons in the Hair Groups group:

- **Merge Hairgroups** on page 1108
- **Split Hairgroups** on page 1108

The other choices in this quadrant are shortcuts to the buttons in the Utilities group:

- **Unlock** on page 1108
- **Lock** on page 1108
Styling quadrant

The choices in this quadrant are shortcuts to most of the controls in the Styling group:

- **Ignore Back** on page 1102
- **Soft Falloff** on page 1102
- **Scale** on page 1104
- **Rotate** on page 1104
- **Clump** on page 1104
- **Puff** on page 1103
- **Stand** on page 1103
- **Translate** on page 1103
- **Cut** on page 1101
  To exit Cut mode and return to the hair brush, choose one of the other styling modes in this quadrant.

**TIP** While the brush is active, you can resize it in viewports by holding down Ctrl+Shift and dragging the mouse.

Selection Utils quadrant

These choices are shortcuts to the buttons under “Selection Utilities” in the Selection group:

- **Invert Selection** on page 1099
Selection quadrant

These choices are shortcuts to the buttons at the top of the Selection group that constrain how you can select hair guides:

- **Tip** on page 1098
- **Guide** on page 1098
- **Verts** on page 1098
- **Root** on page 1098

**General Parameters Rollout (Hair And Fur)**

Select an object with the Hair And Fur modifier applied. > Modify panel > General Parameters rollout

This rollout lets you set the hair count and density, the length, thickness at the root and tip, and various other comprehensive parameters.
Interface

Hair Count
The total number of hairs generated by Hair. In some cases this is an approximate count, but the actual count is usually very close to the specified quantity. Default=15000. Range=0 to 10000000 (ten million).

Top: Hair Count=1000
Bottom: Hair Count=9000
By default, Hair normalizes density to surface area; that is, larger polygons receive more hairs than smaller ones. If you edit the growth object in a way that changes the polygon-size ratios, use Reset Rest on page 1092 to adjust the hair distribution automatically.

**Hair Segments** The number of segments per hair. Default=5. Range=1 to 150. This is equivalent to spline segments; with more segments, curly hair looks more natural, but the generated mesh object is larger. For perfectly straight hair, set Hair Segments to 1.

**Left:** Hair Segments=5  
**Right:** Hair Segments=60

**Hair Passes** Sets the number of transparency passes. Default=1. Range=1 to 20.

Hair's buffer render on page 7064 has a fairly novel way of handling hair transparency. Instead of resolving actual hair transparency, the hair is rendered multiple times (as opaque hair) with different random seeds. These buffers are then blended together. As you increase the Hair Passes value, the transparency (or wispiness) of the hair increases. In addition, increasing the value increases the actual number of rendered hairs as well, although the apparent density, or fill, seems about the same because of the additional transparency. Render time also increases linearly.
NOTE For best results when using the “mr prim” hair rendering method (see Hair And Fur Render Effect on page 7061) with the mental ray renderer, be sure to set the Trace Depth > Max. Depth value (see Rendering Algorithms Rollout (mental ray Renderer) on page 6741) higher than the Hair Passes value.

Density The numeric value sets the overall hair density; that is, it acts as a percentage multiplier of the Hair Count value. Default=100.0. Range=0.0 to 100.0.

This attribute is also mappable via the map button to the right of the spinner. Mapping lets you add a texture map to control the amount of hair. An area of the map whose gray value is 50% will reduce the amount of hair grown in that area by 50%. To change the overall hair count, use the Hair Count value (see above).
Top: Density=100.0 + map
Bottom: The bitmap used to control density

**TIP** For optimal efficiency, use the Hair Count value to set the actual number of hairs, leave Density at 100.0, and use mapping to create uneven hair distribution. Simply lowering the Density value without specifying a map causes hairs to be created and then discarded, which unnecessarily increases rendering time.

**Scale** Sets the overall scaling for the hairs. Default=100.0. Range=0.0 to 100.0.
At the default value of 100.0, the hairs are full size. Reduce this value to make the hairs smaller. To make the hairs larger, use the styling tools on page 1095. Default=100.0. Range=0.0 to 100.0.
This attribute is also mappable via the map button to the right of the spinner. Mapping allows you to add a texture map to control the length of the hair. An area of the map whose gray value is 50% will cut the hair grown in that area to 50% of its original length, with no shape change.
NOTE The default size of the hairs depends on the size of the object to which the modifier is applied. The larger the object, the greater the initial size.

**Cut Length** The numeric value sets the overall hair length as a percentage multiplier of the Scale value. Default=100.0. Range=0.0 to 100.0.
This attribute is also mappable via the map button to the right of the spinner. Mapping allows you to add a texture map to control the length of the hair. An area of the map whose gray value is 50% will cut the hair grown in that area to 50% of its original length, with no shape change.
This parameter is more computationally expensive than a density map, since each curve is re-parameterized on the fly, and should not be confused with a density map. It's really more useful as an animated effect for growing hair (for example, creating a wolfman character).

**Rand. Scale** Introduces random scaling into the rendered hairs. Default=40.0. Range=0.0 to 100.0.
At the default value of 40.0, 40 percent of the hairs are scaled down randomly by varying amounts. At 0.0, no random scaling is introduced.

**Root Thick** Controls the thickness of the hair at its root. With instanced hair, this controls the overall thickness as a multiplier of the original object’s dimensions on the X and Y axes in object space.

This setting affects both native hair and instanced hair. With instanced hair, Root thick controls the overall thickness of the hair, not just at the root.

**Tip Thick** Controls the thickness of the hair at its tip.

This setting affects native hair only, not instanced hair. To create tapering in instanced hair, apply the tapering when modeling the object to be instanced within Hair.

Hair is translucent if its width is less than one pixel. On the other hand, setting Root Thick and Tip Thick to small values (close to or less than 1.0) can be a good way to obtain translucent hair.

**Displacement** Displaces the hair roots from the surface of the growth object. Default=0.0. Range=–999999.0 to 999999.0.

When you render an object with a high polygon count, but use a low-polygon proxy object to grow the hair, adjusting Displacement can help make the hair seem to grow from the high-polygon object, rather than floating above it.
Another use for this setting can be animating the hair falling onto or moving away from the growth object.

**Interpolate** When on, hair growth is interpolated among the guide hairs, and the surface is fully populated with hair according to the General Parameters settings. When off, Hair generates only one hair per triangular face on the growth object, up to the limit imposed by the Hair Count setting. Default=on.

**Material Parameters Rollout (Hair And Fur)**

Select an object with the Hair And Fur modifier applied. > Modify panel > Material Parameters rollout

The parameters on this rollout apply to buffer-rendered hair on page 7064 generated by Hair. In the case of geometry-rendered hair on page 7064, the hair coloring is derived from the growth object. In the case of hair rendered by “mr prim”, all parameters apply except Self Shadow and Geom. Shadow. With instanced hair, Hair uses the material from the instanced object.

You can apply a map to any value by clicking the blank button to the right of the parameter. Values in the map act as multipliers to the base value.

**TIP** If you apply a colored texture map to a color attribute such as Tip Color, start by setting the base color to white. Because the map acts as a multiplier, not doing so can lead to unexpected results. For example, if Tip Color is set to yellow and you apply a blue texture map, the hair will be black: this is because if you multiply those RGB values, they zero each other out.
**Interface**

**Occluded Amb.** Controls the bias of the ambient/diffuse contributions of the illumination model. A setting of 100.0 renders the hair with flat lighting. A value of 0.0 is lit only by scene light sources, typically resulting in a higher-contrast solution. Default=40.0. Range=0.0 to 100.0.
**Tip Fade** Applies only to mr prim on page 7064 rendering (with the mental ray renderer). When on, the hair fades to transparent toward its tip. When off, the hair is equally opaque for its entire length.

**Tip Color** Hair color at the tips, farthest from the growth object surface. To change the color, click the color swatch and use the Color Selector.

**Root Color** Hair color at the roots, closest to the growth object surface. To change the color, click the color swatch and use the Color Selector.
Tip Color=red
Root Color=blue
Hue Variation=0.0

The Tip Color and Root Color attributes are also mappable via the map buttons to the right of the spinners. These let you add texture maps to control the hair coloring, separately at the tip and base. The UVW mapping used for the texture is the same as that of the growth object.

For results closest to the map colors, set Tip Color and Root Color to white. Alternatively, set a different color to tint the map coloring.

Left: The texture map used for the hair (center and right)
Center: The map applied to Tip Color and Root Color causes the hair to use the same coloring.
Right: Setting Tip Color and Root Color to orange adds an orange tint to the hair.

Hue Variation The amount by which Hair varies the color of the hairs. The default value results in natural-looking hair. Default=10.0. Range=0.0 to 100.0.
**Value Variation** The amount by which Hair varies the brightness of the hairs. The default value results in natural-looking hair. Default=50.0. Range=0.0 to 100.0.

**Top: Hue/Value Variation=0.0**

**Middle: Value Variation=100.0**

**Bottom: Hue Variation=100.0**

**Mutant Color** The color for mutant hairs. Mutant hairs are randomly selected, based on the Mutant % value (see following), and receive this color. One example of mutant hairs are the gray hairs that appear as we age.

**Mutant %** The percentage of hairs that receive the mutant color (see above). You can animate the Mutant % value to produce, for example, a rapidly aging character. Default=0.0. Range=0.0 to 100.0.
Left: Mutant % = 30.0
Right: Mutant % = 0.0
Both: Color = brown, Mutant Color = white

**Specular** The brightness of highlights on the hairs.

**Glossiness** The relative size of highlights on the hairs. Smaller highlights result in glossier-looking hair.

The combined results of the Specular and Glossiness settings appear in a graph to the right of the two parameters.
Left: Specular=0.0, Glossiness=0.0
Center: Specular=100.0, Glossiness=75.0
Right: Specular=100.0, Glossiness=0.1

**Specular Tint** This color tints specular highlights. Click the color swatch to use the Color Selector. Default=white.

**Self Shadow** Controls the amount of self-shadowing; that is, hairs casting shadows on other hairs within the same Hair And Fur modifier. A value of 0.0 disables self shadowing, while a value of 100.0 results in maximum self-shadowing. Default=100.0. Range=0.0 to 100.0.
NOTE You can adjust the shadow characteristics by changing the Hair Light Attr rollout on page 5443 settings for lights that illuminate the hair.

**Geom. Shadow** The amount of shadow contribution hair receives from geometry in the scene. Default=100.0. Range=0.0 to 100.0.

**Geom. Mat. ID** The material ID assigned to geometry-rendered hair on page 7064. Default=1.

### mr Parameters Rollout (Hair And Fur)

Select an object with the Hair And Fur modifier applied. > Modify panel > mr Parameters rollout

Lets you assign a mental ray shader on page 6385 to generate hair. 3ds Max passes the object’s UV coordinate data, including map channels, to the mental
ray shader; strictly speaking, the shader generates hair from this UV and mapping data, not from the object geometry itself. (Multiple map channels are supported.)

When you use a mental ray shader for hair, you must render your scene using the mental ray renderer on page 6675 and set the Hair And Fur render effect on page 7061 method to “mr prim”.

Aside from the “mr prim” option that you can choose as a render effect (see Hair And Fur Render Effect on page 7061), no mental ray hair shaders are provided with 3ds Max. This feature is meant to support third-party hair shader products or custom-coded hair shaders.

NOTE When you assign a mental ray shader, the shader controls supersede other Hair And Fur material settings. On the other hand, if you use this rollout to assign a shader that is not supported, the renderer uses the regular Hair And Fur material settings. (“Geometric” settings such as Hair Count, Hair Segments, and so on, still apply.)

Interface

Apply mr Shader When on, lets you apply a mental ray shader to generate hair.

[shader button] Enabled only when “Apply mr Shader” is on. Click to display a Material/Map Browser on page 5724 and assign the shader.

When no shader is assigned, this button is labeled “None”. When a shader is assigned, the button's label shows the shader's name.

Frizz Parameters Rollout (Hair And Fur)

Select an object with the Hair And Fur modifier applied. > Modify panel > Frizz Parameters rollout

Frizz displacement is accomplished by doing a Perlin noise lookup at the hair's rest position root, and then displacing the hair much the way bump mapping displaces a surface normal. The frequency of the noise function is set by the
Frizz X/Y/Z Frequency parameters. The magnitude of the displacement is controlled with Frizz Root and Frizz Tip. If you set dynamics mode on page 1140 to Live, the viewports show the effects of changing these settings in real time.

1. Frizz Root/Tip=0.0
2. Frizz Root=50.0, Frizz X/Y/Z Freq=14.0
3. Frizz Root=150.0, Frizz X/Y/Z Freq=60.0
4. Frizz Tip=30.0, Frizz X/Y/Z Freq=14.0
5. Frizz Root=50.0, Frizz Tip=100.0, Frizz X/Y/Z Freq=60.0
Frizz actually calculates two noise fields, both of which use the same frequency settings and tip/root amplitudes. One of the noise fields is static relative to the hair. The Anim parameters let you animate the second noise field through the hair over time. This is useful for things like grassy fields, where it would be overkill to compute real dynamics. These parameters give you a similar result, at a small fraction of the computational overhead.

All Frizz/Kink settings=0.0; this reference image provided for comparison with the Frizz and Kink illustrations (below).
**Interface**

**Frizz Root** Controls the displacement of the hair at its root. Default=15.5. Range=0.0 to 360.0.

**Frizz Tip** Controls the displacement of the hair at its tip. Default=130.0. Range=0.0 to 360.0.
Frizz Root=30.0, Frizz Tip=100.0, Frizz X/Y/Z Freq=14.0

Top: Styled
Bottom: Unstyled

Left: Differing values for Frizz Root and Frizz Tip result in curved hairs.
Right: When Frizz Root=Frizz Tip, the hairs are straight.

Chapter 9  Modifiers
**Frizz X/Y/Z Frequency** Controls the frequency of the frizz effect on each of the three axes. Default=14.0. Range=0.0 to 100.0.

Like frizz, Frizz Anim displaces the hair with a noise field. The difference is that you can move the noise field to create animated displacement, resulting in wavy movement without having to resort to dynamics.

**Frizz Anim.** Sets the amplitude of the wavy motion. Default=0.0. Range=–9999.0 to 9999.0.

**Anim. Speed** This multiplier controls the speed at which the animating noise field moves through space. This value is multiplied by the X, Y, and Z components of the Frizz Anim Dir attribute to determine the per-frame offset of the animating noise field. Default=0.0. Range=–9999.0 to 9999.0.

**Frizz X/Y/Z Anim. Dir(ection)** Sets the direction vector of the frizz animation. Default=0.0. Range=–1.0 to 1.0.

This vector is not normalized before use. This means that you can apply small tweaks to the values to achieve fine control over the speed of the animation on a given axis. To reduce confusion it’s a good idea to keep these directions either –1, 0, or 1. Once you’ve got the animation close to what you want, you can diverge from these and adjust the values to achieve the exact result you need.

**Kink Parameters Rollout (Hair And Fur)**

Select an object with the Hair And Fur modifier applied. > Modify panel > Kink Parameters rollout

Kink displacement works similarly to Frizz, but evaluates noise lookups along the whole length of the guide. The result is a noise pattern that works on a larger scale than the Frizz noise. The effect is similar to crimped hair.
1. All settings=0.0 (no kink)
2. Kink Root=0.5 (rest=0.0)
3. Kink Tip=10.0, Kink Root=0.0, Kink X/Y/Z Freq=4.0,
4. Kink Tip=10.0, Kink Root=0.0, Kink X/Y/Z Freq=50.0,
Interface

**Kink Root** Controls the amount of kink displacement of the hair at its root. Default=0.0. Range=0.0 to 100.0

Kink Root=0.5, Kink Tip=0.0, Kink X/Y/Z Freq=4.0

Top: Styled
Bottom: Unstyled
**Kink Tip** Controls the amount of kink displacement of the hair at its tip. Default=0.0. Range=0.0 to 100.0

**Kink X/Y/Z Frequency** Controls the frequency of the kink effect on each of the three axes. Default=0.0. Range=0.0 to 100.0.

---

**Multi Strand Parameters Rollout (Hair And Fur)**

Select an object with the Hair And Fur modifier applied. > Modify panel > Multi Strand Parameters rollout

Some degree of clumping gets naturally created when you use Frizz at low frequencies, but you can go a bit further here with the Multi Strand parameters. For each hair that is normally rendered, Multi Strand renders a clump of additional hairs scattered around the original hair. The Splay settings control the degree of scattering at the roots and tips, and Multi Strand Count controls the number of hairs to create for the clump. You can use Splay to shape the clump by spreading or compressing the roots and tips.
**TIP** For each original hair, Multi Strand creates a cluster of hairs around that hair, offset at the bottom by the Root Splay factor. The hair is offset in the plane tangent to the root of the hair, which is not necessarily the surface of the object. To make sure Multi Strand hairs actually make contact with the surface, make the growth surface a bit smaller than the rendered surface.

1. Multi Strand Count=0, Hair Count=500
2. Multi Strand Count=10, Root Splay=0.1, Tip Splay=0.1, Hair Count=500
3. Multi Strand Count=10, Root Splay=0.4, Tip Splay=0.1, Hair Count=500
4. Multi Strand Count=10, Root Splay=0.0, Tip Splay=1.0, Hair Count=500
Interface

Count | The number of hairs per clump.
Root Splay | Provides a random offset for each hair in a clump, at the root.
Tip Splay | Provides a random offset for each hair in a clump, at the tip.
Randomize | Randomizes the size of each hair in a clump.

Dynamics Rollout (Hair And Fur)

Select an object with the Hair And Fur modifier applied. > Modify panel > Dynamics rollout

For hair to seem natural in an animation, it must respond to the motion of the body it's attached to and to external influences such as wind and gravity. Hair's Dynamics functions let the hair behave like real-world hair, in interactive (Live) or Precomputed mode.

Designating Collision Surfaces

Hair dynamics uses guide hairs to calculate collision. To reduce computation, you have to explicitly designate the objects with which hair will collide. The object from which the hair grows is a special case: to have hair collide with this object (for example, a human head), simply turn on Use Growth Object.

If there is a collision object that you want more than one Hair modifier to interact with, you have to add that object as a collision object for each different Hair And Fur modifier.

There are two different methods for calculating collision: Sphere and Polygon. Spherical collision uses a bounding sphere for collision objects; polygonal collision uses the collision object’s actual geometry. The Polygon option is more accurate, but the Sphere option is quicker to calculate.
Procedures

Example: To view hair dynamics in real time:

1 Apply the Hair And Fur modifier to an object.

2 On the Dynamics rollout (scroll the command panel down to view it), set Mode to Live.

3 Move the object around.
The hair moves realistically.

4 On the Tools rollout, click Regrow Hair.
The hair resumes its default position, growing straight out of the object.

5 Click the Play Animation button.

6 The hair settles and droops, as if affected by gravity. Note that, as the animation repeats, the effects of gravity are cumulative; the hair animation doesn’t restart at the first frame.

7 On the Tools rollout, click Regrow Hair again.

8 Add a Wind space warp to the scene.

9 On the Dynamics rollout, set Dynamics Params > Gravity to 0.0.

10 In the External Forces group (at the bottom of the Dynamics rollout), click Add and then select the Wind space warp.

11 Play the animation again.
This time, the hair isn’t affected by gravity, but simply blown by the wind. Again, the effect is cumulative and the animation doesn’t repeat.

All of this animation takes place only in real time; no keyframes are set, so it can’t be rendered. To learn how to set up a renderable dynamics simulation with Hair, see the following procedure.

To generate a precomputed dynamics simulation with Hair:

1 Apply the Hair And Fur modifier to an object.

2 Set up the animation. It could simply be motion of the growth object, or you could use the Dynamics rollout > External Forces group to add space warps, such as Wind, that should affect the hair. Actually, because
the hair is affected by its own gravity by default, you don’t need to set up any explicit animation at all to see hair dynamics.

3 On the Modify panel > Dynamics rollout, use the Collisions group to set objects the hair should collide with. Also set other simulation parameters in the Dynamics Params group.

4 In the Stat Files group, click the ellipsis (...) button. Use the Save As dialog to specify the location and name of the stat files to be generated.

**NOTE** When you run the simulation, Hair will generate a separate stat file for each animation frame.

**IMPORTANT** If you plan to render the animation with a networked render farm, make sure the path you specify can be seen in exactly the same way from each node on the render farm. If stat files aren’t found, hair will be stiff and just oriented to the skin as it moves. If the wrong stat files are found, hair can float right off an object.

**TIP** If using Windows XP, click the My Network Places button to set a path using the Universal Naming Convention (UNC), even if it’s on a local drive. Such a path can be accessed readily by other computers on the network.

The path and stat file name appear in the text field next to the ellipsis button.

5 In the Simulation group, set the frame range for the simulation and then click Run.

Hair runs the dynamics simulation and generates a stat file for each frame in the animation. It also automatically sets the mode to Precomputed, so when you play or render the animation, it reads the stat files and uses the information for the hair positioning in each frame.

6 Play the animation.

The dynamics simulation stored in the stat files appears in the viewports.

7 In the Mode group, choose None, and then play the animation again.

The dynamics animation no longer appears. However, it’s still stored in the stat files, and will reappear if you choose Precomputed.

8 Make sure Precomputed is on, and then render the animation.
Interface
**Mode group**

Chooses the method Hair uses to generate dynamics. Live mode is suitable for experimentation, but for best results when rendering animation with Hair, use Precomputed mode.

- **None** Hair doesn’t simulate dynamics.
- **Live** Hair simulates dynamics interactively in the viewports, but doesn’t generate animation keyframes or stat files for the dynamics. For best results with Live mode, turn off Display rollout > Display Hairs group > As Geometry.

  For some methods of using live dynamics, see this procedure: Example: To view hair dynamics in real time: on page 1137.

  If you press ESC while using live dynamics, 3ds Max displays a dialog that asks whether you want to stop live dynamics. Both Freeze and Stop reset the mode to None, but Freeze freezes the hair in its current position. You can use this as a starting point for precomputed dynamics, or as a point from which you style the hair.

- **Precomputed** Lets you generate stat files for rendering dynamics-animated hair. Available only after setting a name and location for stat files (see following and To generate a precomputed dynamics simulation with Hair: on page 1137).

**Stat Files group**

Stat files let you record and play back a Hair-generated dynamics simulation. For a workflow example, see this procedure: To generate a precomputed dynamics simulation with Hair: on page 1137.

**Text field** Displays the path and file name for the stat files.

... (ellipsis) button Click to choose a name prefix and location for stat files using the Save As dialog.
Hair adds a four-digit frame number (with leading zeroes) and the file name extension ".stat" to the name you provide (for example, hair_test0001.stat).

Delete all files Deletes stat files from the target directory. The files must have the name prefix you assigned using the ... button.

**TIP** You can still use stat files even if you move them to another location. Follow this procedure:

1. Open the MAX file used to generate the stat files.
2. On the Modify panel > Dynamics rollout, click the ... [ellipsis] button.
3. Use the Save As dialog to navigate to the directory with the stat files, and then click any stat file. Its name appears in the File Name field.
4. Edit the File Name field to delete the four-digit extension after the stat file name. For example, if the stat file name is test0033.stat, delete the "0033" so that it reads test.stat.
5. Click the Save button. The new stat file path appears in the Stat Files field.

Now, when you play or render the animation, Hair uses the stat files as originally generated.

**Simulation group**

Determines the extent of the simulation, and lets you run it. These controls become available only after you choose Precomputed mode and specify stat files in the Stat Files group. Set Start and End to the frames at which to begin and end the simulation, and then click the Run button. 3ds Max then computes the dynamics and saves the stat files.

**Start** The first frame to consider in calculating the simulation.

**End** The final frame to consider in calculating the simulation.

**Run** Click to run the simulation and generate the stat files within the frame range indicated by Start and End.

To abort a simulation while it's running, click Cancel on the status bar.

**Dynamics Params group**

These controls specify the basic parameters for the dynamics simulation. The Stiffness, Root Hold, and Dampen values can be mapped: click the map button
to the right of the spinner to assign a map. Grayscale values in the map multiply the parameter’s value at that hair location.

**Gravity** Lets you specify a force that moves hair vertically in world space. Negative values pull hair up while positive values pull it down. To cause hair not to be affected by gravity, set the value to 0.0. Default=1.0. Range=–999.0 to 999.0.

**Stiffness** Controls the magnitude of the effect of dynamics. If you set Stiffness to 1.0, the dynamics will have no effect. Default=0.4. Range=0.0 to 1.0.

**Root Hold** Comparable to stiffness, but affects the hair only at the roots. Default=1.0. Range=0.0 to 1.0.

**Dampen** Dynamic hair carries velocity forward to the next frame. Increasing dampening increases the amount by which these velocities are diminished. Thus, a higher Dampen value means that hair dynamics will be less active (the hair can also start to get “floaty”). Default=0.0. Range=0.0 to 1.0.

**Collisions group**

Use these settings to determine which objects hair collides with during a dynamic simulation and the method by which collision is calculated.

- **None** Collisions are not considered during the dynamic simulation. This can cause the hair to penetrate its growth object as well as other objects it comes into contact with.

- **Sphere** Hair uses a spherical bounding box to calculate collisions. This method is faster because it requires less computation, but can cause inaccurate results. It’s most effective when the hair is seen from a distance.

- **Polygon** Hair considers each polygon in the collision objects. This is the slowest method, but the most accurate.

**Use Growth Object** When on, hair collides with the growth (mesh) object.

**Objects list** Lists the names of scene objects with which hair should collide.

**Add** To add an object to the list, click Add and then click the object in a viewport.

**Replace** To replace an object, highlight its name in the list, click Replace, then click a different object in a viewport.

**Delete** To remove an object, highlight its name in the list, then click Delete.
**External Forces group**

This group lets you specify space warps on page 2887 that will affect the hair during the dynamics simulation. For example, you can add a Wind space warp on page 2926 to cause the hair to be blown by a breeze.

**NOTE** Hair dynamics already has a built-in gravity force, so it’s not necessary to add one.

**Objects list** Lists the names of forces that dynamically affect the hair.

**Add** To add a space warp to the list, click Add and then click the warp's icon in a viewport.

**Replace** To replace a space warp, highlight its name in the list, click Replace, then click a different warp's icon in a viewport.

**Delete** To remove a space warp, highlight its name in the list, then click Delete.

**Display Rollout (Hair And Fur)**

Select an object with the Hair And Fur modifier applied. > Modify panel > Display rollout

These settings let you control how hairs and guides display in the viewports. By default, Hair displays a small percentage of the hairs as lines. Alternatively, you can display the hairs as geometry, and you can also choose to display the guides.
Interface

Display Guides group

Display Guides toggle When on, Hair displays guides in the viewports, using the color shown in the color swatch. Default=off.

**NOTE** At the Guides sub-object level, guides always appear in the viewports.

Guide Color Click to display the Color Selector and change the color used to display guides.

Guides do not reflect some settings made to the hair, such as Frizz. Use the Guides display mainly to see where hair will appear on the growth object. Hair places one guide at each vertex on the growth surface.

Display Hairs group

Display Hairs toggle When on, Hair displays hairs in the viewports. Default=on.

Override When off, 3ds Max displays hairs using an approximation of their rendered color. When on, displays hairs using the color shown in the color swatch. Default=off.

Color swatch Click to display the Color Selector and change the color used to display hairs when Override is on.

**NOTE** When hair is displayed as geometry (see below), the color setting is ignored.
**Percentage** The percentage of total hairs displayed in the viewports. Lower this value to improve real-time performance in the viewports.

**Max. Hairs** The maximum number of hairs displayed in the viewports, regardless of the Percentage value.

**As Geometry** When on, displays the hairs in the viewports as the actual geometry to be rendered, rather than the default lines. Default=off.

### LS Colors Modifier (World Space)

Select a Lightscape mesh object. > Modify panel > Modifier List > World-Space Modifiers > LS Colors (WSM)

The LS Colors modifier converts Lightscape radiosity values to 3ds Max vertex colors.

When you import a Lightscape model into 3ds Max, the radiosity values are kept as irradiances; that is, they describe the intensity of light falling on a mesh in physical units. This modifier converts the physical units to RGB colors. In conjunction with the Lightscape Mesh modifier on page 1486, this modifier can be used to produce meshes suitable for game engines.

**See also:**

- Lightscape Files (LP, LS, and Other Formats) on page 7756
**Interface**

**Brightness** Controls the brightness of the displayed image on your monitor. The setting of this control does not affect the actual lighting levels in the model. Default=50.0.

**Contrast box** Controls the contrast between light and dark regions in the model. Default=50.0.

**Daylight** Determines whether you want natural daylight to be used in the calculation. Default=on.

**Exterior Scene** Turn on for exterior daylight simulations. Default=off.

**TIP** Use the logarithmic exposure control on page 7215 to control the brightness and contrast of the colors when you render.

**Use exposure control** When on, disregards the settings of Brightness, Contrast, Daylight, and Exterior, and instead uses the settings of the active exposure control. If no exposure control is active in the scene, this toggle is disabled. Default=off.
The three radio buttons that follow choose how to handle irradiance values.

- **Convert light falling on the surface**  When chosen, converts the irradiance values directly to RGB values. In order to properly render the mesh, the vertex colors need to be interpolated and multiplied by the color of the material on the mesh.

- **Convert light reflecting from the surface**  When chosen, takes the irradiance values and multiplies them by the material's ambient color, then converts the result to RGB. To properly render the mesh, you need to interpolate the vertex colors over the faces. If textures are displayed by multiplying them by the vertex colors, they will not be correctly displayed unless the material color is white. By default, this is the active option.

- **Convert light reflecting from the surface, except for textured materials**  When chosen, takes the irradiance values and multiplies them by the material's ambient color, and then converts the result to RGB, unless a texture is applied to the material's ambient component. If the ambient component has a map, this method converts the irradiance value directly to the vertex color. To properly render the mesh, you need to interpolate the vertex colors over the faces, unless the material is textured. If textures are displayed by multiplying them by the vertex colors, they will be correctly displayed.

**Add to colors**  When on, the result of the color conversion is added to existing vertex color values, if there are any. Default=off.

**Use self-illumination**  When on, the material's self illumination is included in the final vertex colors. Default=on.

## MapScaler Modifier (World Space)

Select an object. > Modify panel > Modifier List > World-Space Modifiers > MapScaler (WSM)

Select an object. > Modifiers menu > UV Coordinates > Map Scalar (WSM)

MapScaler maintains the scale of a map applied to an object. This lets you resize the object without altering the scale of the map. Typically, you might use this to maintain the size of a map regardless of how the geometry is scaled.
MapScaler sets the scale of a map on an object.

This differs from the MapScaler (OSM) modifier on page 1487, which maintains the scale of the map with respect to the object size when scaled with a Select And Scale tool. See the latter’s definition for other differences between the two versions.

**NOTE** This world-space modifier is for use primarily with vertically oriented objects, such as walls in an architectural model, or objects with large, flat surfaces. While you can apply the MapScaler to any object, the results are less realistic on curved surfaces, especially complex ones, which can show cracks in the finished texture.
Interface

Scale Represents the size of one repetition of the texture pattern. Size is measured in current system units. Repetitions occur across the object in the U and V directions. Default=1.0.

NOTE When the Use Real-World Texture Coordinates switch is active in the General Preferences dialog, the scale setting defaults to 1.0. If Use Real-World Texture Coordinates is turned off, scale defaults to 100.0.

U/V Offset Specify horizontal and vertical offsets respectively. Available only when Wrap Texture is off.

Wrap Texture When on, Map Scaler attempts to wrap the texture evenly around the object. This option requires more computing, but usually produces the most satisfactory results. Default=on.

Wrap Using Smoothing Groups When turned on, textures are wrapped around corners when they share the same smoothing groups. Curved walls will map smoothly while sharp corners get a new texture origin. This switch is only available when the Wrap Textures switch is turned on. Default=off.

Channel Specifies the map channel on page 8627. Default=1.
Up Direction group

World Z Axis Aligns the map with the Z axis of the world.
If you choose this option and then rotate the object, the mapping is not fixed to the object.

Local Z Axis Aligns the map with the local Z axis of the object.
With this option, the mapping remains fixed to the object.

PatchDeform Modifier (World Space)

Select an object. > Modify panel > Modifier List > World-Space Modifiers > PatchDeform (WSM)

The PatchDeform world-space modifier lets you deform an object based on the contours of a patch object. It works the same as the PathDeform (World Space) on page 1150, but uses a patch instead of a curve. With the exception of the Move to Patch button, its parameters are the same as those in the object-space PatchDeform modifier on page 1567.

PathDeform Modifier (World Space)

Select an object. > Modify panel > Modifier List > Animation Modifiers > PathDeform (WSM)

The PathDeform world-space modifier deforms an object based on a shape, spline or NURBS curve path. With the exceptions noted in the Interface section, this world-space modifier works the same as the object-space PathDeform modifier on page 1569.

Procedures

The first two examples, below, demonstrate the basic differences in orientation and the relationship between the object and its path when using the PathDeform modifier and the PathDeform (WSM) modifier.
Example: To use the PathDeform modifier to curve text:

1 In the Top viewport, create a circle that's 100 units in radius.

2 In the Front viewport, create a text shape with six or seven letters, and a size of 25.

3 Apply an Extrude modifier to the text shape, and set the Amount to -5.0.

4 On the Main toolbar, set the Reference Coordinate System to Local.
Looking at the axis tripod for the extruded text object, you can see that its Z axis runs from back to front relative to world space.

5 Apply a PathDeform on page 1569 object-space modifier to the text object.
Click the Pick Path button, and then select the circle.
A circular gizmo appears. The circle runs through the local Z axis of the text object. Because of its orientation, its effect is minimal, but you can see a slight wedge-shaped deformation from the top view.

6 In the Path Deform Axis group, choose the Y option, and then the X option.
The circle gizmo rotates to run through the specified axes, deforming the text object differently with each change.

7 Adjust the Percent spinner to view its effect, and then set it to zero. Try the same with Stretch, Rotation, and Twist, and then restore them to their original values.

TIP Use the Ctrl key with Twist to amplify the effect.

8 Turn on Flip to switch the direction of the path, and then turn it off.

9 Go to the Gizmo sub-object level, and move the gizmo path around.
The text object is further deformed by its relative position to the gizmo.
10 Select the original circle shape, and change its radius.
   The deformation of the text object alters because its gizmo is an instance of the shape object.

Example: To use the PathDeform world space modifier:

This procedure continues from the previous one.

1 Select the text object, and then remove the Path Deform modifier from the stack.
2 Apply a Path Deform (WSM) modifier.
3 Click Pick Path, and select the circle.
   The text object flips around and moves in world space. Note that its orientation and deformation are difficult to analyze because there's an offset distance between the path and the object.
4 Click Move to Path.
   The text object is transformed so that its local Z axis is aligned with the path and its position is at the first vertex of the path.
   In the following steps, you'll use various controls to re-orient the text object so that it's at the front of the circle and readable from the Front viewport.
5 Choose the X option in the Path Deform Axis group to place the length of the text object along the path.
6 Adjust the Percent spinner to –25 to move the text to the front of the circle.
7 Adjust the Rotation spinner to –90 to rotate the text so it faces the Front viewport.
8 Turn on Auto Key, go to frame 100, and set Percent to –125.
9 Play the animation to watch the text run around the circle.
Example: To create a growing vine:

1. Use the Line tool and, optionally, Editable Spline to create a path along which the vine will grow.

2. Create a Cone, and apply the Path Deform (WSM) modifier.
3 Pick the path, and then click Move to Path. (The local Z axis of the cone should be along the path.)

Go to frame 100, and turn on Auto Key.

Increase the Stretch value to stretch the cone along the path until it reaches the end. There won't be enough height segments in the cone, but you can fix that in step 7.

Turn off Auto Key.

In the stack, click Cone, and then in the Parameters rollout increase the Height Segments setting until the stretched cone is smooth on the path.

Play the animation.

The cone grows along the path, like a vine.

Interface

Because this is a world-space rather than an object-space modifier, the object is affected in world-space coordinates, and also by the position of the path relative to the object. Thus, if you transform the object relative to the path, or vice-versa, it has an effect on the deformation.

Generally speaking, the Path Deform world-space modifier leaves the path in place while moving the object to the path, while the Path Deform object-space modifier leaves the object in place while moving the path to the object.
For all parameters except the following, refer to the PathDeform modifier on page 1569.

**Path Deform group**

**Move to Path** Moves the object from its original position to the start of the path.

When you first pick a path, the object is deformed by the path based on the offset distance between the first vertex in the path and the object's location. Thus, as you adjust the Percent spinner, for example, the result will be distorted depending on the offset distance.

**IMPORTANT** Using the Move To Path button applies a transform to the object that's not removed if you later remove the Path Deform binding from the object. However, you can undo on page 240 the transform immediately after it's been performed.

**NOTE** If the Auto Key button is on when you perform Move To Path, transform keys are created.
Point Cache Modifier (World Space)

Select an object. > Modify panel > Modifiers List > World-Space Modifiers > Point Cache (WSM)

The world-space version of the Point Cache modifier works exactly the same as the Point Cache modifier on page 1574, except that it uses world-space coordinates instead of local-space coordinates. Use this version when animating with world-space modifiers such as PatchDeform (WSM) modifier on page 1150 or PathDeform (WSM) modifier on page 1150.

Subdivide Modifier (World Space)

Make a selection. > Modify panel > Modifier List > World-Space Modifiers > Subdivide (WSM)

Make a selection. > Modifiers menu > Radiosity Modifiers > Subdivide (WSM)

The Subdivide (WSM) modifier is similar to the object-space Subdivide modifier on page 1756, and has the same parameters. In the world-space version of Subdivide, the size limit is on the mesh after it is transformed into world space coordinates.

Surface Mapper Modifier (World Space)

Make a selection. > Modify panel > Modifier List > World-Space Modifiers > Surface Mapper (WSM)

The Surface Mapper (WSM) modifier takes a map assigned to a NURBS on page 2416 surface and projects it onto the modified object or objects. Surface Mapper is especially useful for seamlessly applying a single map to a group of surface sub-objects within the same NURBS model. You can also use it for other kinds of geometry.

The NURBS surface's map is projected onto the other geometry in the direction of the NURBS surface's normals, or opposite the normals if the modified object is on the other side of the NURBS surface.
Procedures

To use the surface mapper world-space modifier:

1. Create the NURBS surface to use for projection, and transform it so it wraps the objects you want to map.

2. Use the Material Editor on page 5641 to assign a mapped material to the NURBS surface.

3. Select the objects you want to map.

4. Use the Material Editor to assign the same material to the objects you want to map.

5. Apply the Surface Mapper world-space modifier.

6. In the Parameters rollout, turn on Pick NURBS Surface, and then click the NURBS projection surface in a viewport. 3ds Max now uses the NURBS surface's normals to project the texture onto the modified objects.

TIP To fine-tune the map placement on the mesh, you can use the NURBS surface's Edit Texture Surface dialog on page 2719.
Source Texture Surface group

These controls let you choose the NURBS surface to project.

Pick NURBS Surface Picks the NURBS surface to use for projection. Click to turn on this button, then click the NURBS surface in an active viewport.

Surface Shows "<none>" before you pick a NURBS surface; shows the name of the surface after you pick one.

Map Channels group

These controls let you choose which map channels on page 8627 to use.

Input Channel Selects the NURBS surface map channel to use before projection.

Output Channel Selects the modified object’s map channel to use after projection.
**Update Options group**

These controls let you choose how to update the mapping displayed in viewports. They have no effect if Show Map In Viewport on page 5696 is turned off.

*Always* Updates viewports whenever the mapping changes.

*Manually* Updates viewports only when you click Update.

*Update* Updates viewports. This is unavailable unless you've chosen Manually.

**SurfDeform Modifier (World Space)**

Select an object. > Modify panel > Modifier List > World-Space Modifiers > Surf Deform (WSM)

Select an object. > Modifiers menu > Animation Modifiers > Surf Deform (WSM)

The SurfDeform (WSM) modifier works the same as the PathDeform (WSM) modifier on page 1150, except that it uses a NURBS Point or CV surface instead of a curve.

**Object-Space Modifiers**

Object-space modifiers directly affect an object's geometry in local space on page 8621.

When you apply an object-space modifier, it appears directly above the object with other object-space modifiers in the modifier stack on page 8187. The order in which the modifiers appear in the stack can affect the resulting geometry.

**Affect Region Modifier**

Modify panel > Make a vertex sub-object selection. > Modifier List > Object-Space Modifiers > Affect Region

Make a vertex sub-object selection. > Modifiers menu > Parametric Deformers > Affect Region

The Affect Region modifier is a surface modeling tool, primarily used with vertex sub-object selections while surface modeling. With Affect Region,
transforming a selection of vertices can also transform vertices in the region that surrounds the selection. This can help you form a bubble or indentation in the surface of an object. The easiest way to see this modifier’s effect is with a shallow, flat box object with plenty of subdivisions. The Affect Region modifier has a two-part, arrow-shaped gizmo, plus numeric controls.

When you apply the Affect Region modifier, it assigns an arrow-like gizmo consisting of two points connected by a line. The base of the arrow is the start point. The length and direction of the arrow defines the amount of movement of the vertices. Any vertices within Falloff distance of the base of the arrow are translated in the direction of the arrow.

Because no points on the mesh are directly selected, this modifier doesn’t depend on the topology of the input object. You can apply it to any renderable object. However, you can limit the effect by using a selection modifier like Mesh Select on page 1500 or Volume Select on page 1992 to pass a sub-object selection up the stack.

**NOTE** The Affect Region modifier is ideal for simple animated effects, especially when you need to use interactive parameters. However, for fine-tuned modeling, you’ll probably prefer the expanded capabilities of Soft Selection on page 2014 in Editable Mesh on page 2192, Editable Poly on page 2240, Edit Mesh on page 1321, Mesh Select on page 1500, Volume Select on page 1992, the HSDS modifier on page 1464, and NURBS on page 2436.
Affect Region modifier applied

Procedures

Example: To form a bubble over the surface of a plane:

1. Create a plane with 15 width and length segments.
2. Set the length and width of the plane to 50 units.
3. Apply the Affect Region modifier.
4. In the Parameters group, set Falloff to 50.
5. Adjust the parameters to achieve different effects.

Interface

NOTE The parameters of this modifier are similar to those of the Soft Selection function on page 2014 of an Editable Mesh.
**Modifier Stack**

![Modifier Stack Image]

**Point sub-object level** At this sub-object level, the base and tip of the gizmo arrow are points that can be selected. You can select, translate, and animate these two points together or individually.

For more information on the stack display, see *Modifier Stack* on page 8187.

**Parameters rollout**

![Parameters Rollout Image]

**Parameters group**

**Falloff** Sets the radius of affected vertices, in units, from the base of the gizmo arrow. (Spinner value range: float, 0.0 to 999,999.0)

**Ignore Back Facing** Affects only those vertices whose face normals are in the same general direction as the gizmo arrow. When turned off, all vertices in the Falloff group are affected.
Curve group

Pinch  Affects the tangency of the curve where it meets the arrow tip. Positive values produce a pointed tip while negative values produce a dimple. (Spinner value range: float, -999,999.0 to 999,999.0)

Bubble  Changes the curvature of the affected vertices. A value of 1.0 produces a half-dome. As you reduce this value, the sides of the dome slope more steeply. Negative values lower the base of the curve below the base of the arrow gizmo. (Spinner value range: float, -999,999.0 to 999,999.0)

Attribute Holder Modifier

Create or select an object. > Modify panel > Modifier List > Object-Space Modifiers > Attribute Holder

Create or select an object > Modifiers menu > Animation > Attribute Holder

The Attribute Holder modifier is an empty modifier that provides a readily accessible user interface on the Modify panel to which you can add custom attributes on page 307. It has no user interface of its own; the interface consists solely of those attributes you assign to it. In essence, Attribute Holder is a stripped-down version of Parameter Collector on page 325 that can collect only custom attributes and appears on the Modify panel instead of a floating dialog.

Procedures

Example: To collect different custom attributes in an Attribute Holder modifier:

Before undertaking this procedure, you should be familiar with basic usage of the Parameter Wiring dialog on page 3612.

1  Add a small box to an empty scene. Make it about 20.0 units on a side.

2  Apply a Taper modifier and an Attribute Holder modifier, in that order. In the modifier stack, the Attribute Holder modifier should be highlighted.

3  From the Animation menu, choose Parameter Editor.
In Parameter Editor, on the Attribute Rollout, make or ensure the following settings:

■ Add to Type=Selected Object's Current Modifier
■ Parameter Type=Float
■ UI Type=Slider
■ Name=Box Height

On the Float UI Options rollout, keep all the default settings.

On the Attribute Rollout, click Add.
The Custom Attributes rollout appears on the Modify panel, containing the new Box Height slider.

Add another attribute:

■ Add to Type=Selected Object's Current Modifier
■ Parameter Type=Integer
■ UI Type=Spinner
■ Name=Box Height Segs
■ Integer UI Options > Range=From 1 to 50.

Add two more Float/Spinner attributes named Taper Amount and Taper Curve.
The Attribute Holder modifier now has four custom attributes, but they don't do anything because they're not connected. You'll use Parameter Wiring to hook them up.

Close the Parameter Editor dialog.

In the active viewport, right-click the box and choose Wire Parameters.
From the pop-up menu that appears, choose Modified Object > Box (Object) > Height.
A rubber-band dashed line appears connecting the mouse cursor to the box.

You can't connect this “wire” directly to the custom attribute, so just left-click in an empty part of the viewport to open the Parameter Wiring dialog.
The hierarchy list on the left side, Box01, is expanded to the box's Height parameter, which is highlighted.
On the right side, expand this path: Object > Box01 > Modified Object > Attribute Holder > Custom Attributes, and then click Box Height to highlight it.

Click the Two-way Connection button (double-headed arrow), and then click Connect.

Similarly, connect Height Segments on the left side to Box Height Segments on the right.

Close the Parameter Wiring dialog.

Right-click the box again, choose Parameter Wiring, choose Modified Object > Taper > Amount, and then left-click to open the Parameter Wiring dialog.

The Amount parameter is highlighted on the left side of the dialog.

On the right side, click the Attribute Holder's Taper Amount parameter, and then connect them.

Connect Curvature on the left side to Taper Curve on the right side, and then close the dialog.

All the parameters are now hooked up.

Experiment with changing the values on the Custom Attributes rollout.

The Attribute Holder modifier lets you change the box's creation parameters as well as the Taper modifier's settings without switching back and forth in the modifier stack. In this way you can access, in one convenient location, as many different parameters from different levels in an object's modifier stack, or even from different objects, as you like.

You might notice that you can't set the taper to curve inward. You can resolve this by reopening Parameter Editor, clicking Edit/Delete, and then modifying the Taper Curve attribute to allow negative values. The change takes effect immediately, with no rewiring required.

### Bend Modifier

Modify panel > Make a selection. > Modifier List > Object-Space Modifiers > Bend

Make a selection. > Modifiers menu > Parametric Deformers > Bend

The Bend modifier lets you bend the current selection up to 360 degrees about a single axis, producing a uniform bend in an object's geometry. You can
control the angle and direction of the bend on any of three axes. You can also limit the bend to a section of the geometry.

Bend applied to a streetlight model

**Procedures**

**To bend an object:**

1. Select an object and apply the Bend modifier.

2. On the Parameters rollout, set the axis of the bend to X, Y, or Z. This is the axis of the Bend gizmo, not the axis of the selected object. You can switch between axes at any time, but the modifier carries only one axis setting.

3. Set the angle of the bend along the chosen axis. The object bends to this angle.

4. Set the direction of the bend. The object swivels around the axis.
You can reverse angle and direction by changing a positive value to a negative value.

To limit the bend:

1. Turn on Limit Effect in the Limits group.
2. Set values for the upper and lower limits. These are distances in current units above and below the modifier's center, which is at zero on the gizmo's Z axis by default. You can make the upper limit zero or positive, and the lower limit zero or negative. If the limits are equal, the result is the same as turning off Limit Effect.
   The bend is applied between these limits. The surrounding geometry, while unaffected by the bend itself, rotates to keep the object intact. This is analogous to bending a pipe, where the unbent sections rotate but remain straight.
3. At the sub-object level, you can select and move the modifier's center.

The Limit settings remain on either side of the center as you move it. This lets you relocate the bend area to another part of the object.

Interface

Modifier Stack

Gizmo sub-object You can transform and animate the gizmo like any other object at this sub-object level, altering the effect of the Bend modifier. Translating the gizmo translates its center an equal distance. Rotating and scaling the gizmo takes place with respect to its center.

Center sub-object You can translate and animate the center at this sub-object level, altering the Bend gizmo's shape, and thus the shape of the bent object. For more information on the stack display, see Modifier Stack on page 8187.
Parameters rollout

**Bend group**

*Angle* Sets the angle to bend from the vertical plane. Range=-999,999.0 to 999,999.0.

*Direction* Sets the direction of the bend relative to the horizontal plane. Range=-999,999.0 to 999,999.0.

**Bend Axis group**

*X/Y/Z* Specifies the axis to be bent. Note that this axis is local to the Bend gizmo and not related to the selected entity. Default=Z.

**Limits group**

*Limit Effect* Applies limit constraints to the bend effect. Default=off.

*Upper Limit* Sets the upper boundary in world units from the bend center point beyond which the bend no longer affects geometry. Default=0. Range=0 to 999,999.0.

*Lower Limit* Sets the lower boundary in world units from the bend center point beyond which the bend no longer affects geometry. Default=0. Range=-999,999.0 to 0.
Bevel Modifier

Select a shape. > Modify panel > Modifier List > Bevel

The Bevel modifier extrudes shapes into 3D objects and applies a flat or round bevel to the edges. A common use for this modifier is to create 3D text and logos, but you can apply it to any shape.

Bevel takes a shape as the base of a 3D object. You then extrude the shape up to four levels and assign an outline amount for each level.

Beveled text

Procedures

Example: To create beveled text:

This example produces typical 3D beveled text, with equal bevels in front and back.

1 Create text on page 600 using default settings.
   Font=Arial, Size=100.0.
2 Apply the Bevel modifier.
3 Type -1.0 in the Start Outline field.
4 For Level 1, do the following:
   ■ Type 5.0 for Height.
   ■ Type 2.0 for Outline.
5 Turn on Level 2, and do the following:
   ■ Type 5.0 for Height.
   ■ Type 0.0 for Outline.
6 Turn on Level 3 and do the following:
   ■ Type 5.0 for Height.
   ■ Type -2.0 for Outline.
7 If needed, turn on Keep Lines From Crossing.
Interface

Parameters rollout

- Capping
  - Start
  - End

- Cap Type
  - Morph
  - Grid

- Surface
  - Linear Sides
  - Curved Sides
  - Segments: [1]
  - Smooth Across Levels
  - Generate Mapping Coords.
  - Real-World Map Size

- Intersections
  - Keep Lines From Crossing
  - Separation: [1.0]

- Bevel Values
  - Start Outline: [0.0]
  - Level 1:
    - Height: [0.0]
    - Outline: [0.0]
  - Level 2:
    - Height: [0.0]
    - Outline: [0.0]
  - Level 3:
    - Height: [0.0]
    - Outline: [0.0]
Capping group

You can determine whether or not the beveled object is capped at either end with the check boxes in the Capping group.

**Start** Caps the end with the lowest local Z value (bottom) of the object. When turned off, the bottom is open.

**End** Caps the end with the highest local Z value (top) of the object. When turned off, the end is left open.

Cap Type group

Two radio buttons set the type of cap used.

**Morph** Creates cap faces suitable for morphing.

**Grid** Creates cap faces in a grid pattern. This cap type deforms and renders better than morph capping.

Surface group

Controls the side curvature, smoothing, and mapping of the surface.

The first two radio buttons set the interpolation method used between levels; a numeric field sets the number of segments to interpolate.

**Linear Sides** When active, segment interpolation between levels follows a straight line.

**Curved Sides** When active, segment interpolation between levels follows a Bezier curve. For visible curvature, use multiple segments with Curved Sides.

**Segments** Sets the number of intermediate segments between each level.

![Four-level bevels with 1 and 2 segments](image)
Bevels with linear and curved sides

Rounding and smoothing the bevel object sides

**Smooth Across Levels** Controls whether smoothing groups are applied to the sides of a beveled object. Caps always use a different smoothing group than the sides.

- When turned on, smoothing groups are applied to the sides. The sides appear rounded.
- When turned off, smoothing groups are not applied. The sides appear as flat bevels.

**Generate Mapping Coordinates** When turned on, mapping coordinates are applied to the beveled object.
**Real-World Map Size** Controls the scaling method used for texture mapped materials that are applied to the object. The scaling values are controlled by the Use Real-World Scale settings found in the applied material’s Coordinates rollout on page 6201. Default=on.

**Intersections group**

Prevents sharp corners from overlapping neighboring edges.

Bevel works best with rounded shapes or shapes with corners greater than 90 degrees. Acute angles (less than 90 degrees) produce extreme bevels and often overlap nearby edges.

**Keep Lines From Crossing** Prevents outlines from crossing over themselves. This is accomplished by inserting extra vertices in the outline and replacing sharp corners with a flat line segment.

- **Using Keep Lines From Crossing:**
  - Left: Off
  - Right: On
**Separation** Sets the distance to be maintained between edges. The minimum value is 0.01.

---

**Changing the Separation value**

**Bevel Values rollout**

Contains the parameters that set the height and bevel amount of up to four levels.

A beveled object requires a minimum of two levels: a start and an end. You add more levels to vary the amount and direction of bevel from start to end.

You can think of bevel levels as layers on a cake. The Start Outline is the bottom of the cake and the Level 1 parameters define the height and size of the first layer.

Turning on Level 2 or Level 3 adds another layer to the beveled object with the height and outline specifying the amount of change from the previous level.

The last level on is always the top of the object.

You must always set the Level 1 parameters.
**Start Outline** Sets the distance the outline is offset from the original shape. A non-zero setting changes the original shape's size.

- Positive values make the outline larger.
- Negative values make the outline smaller.

**Level 1** Includes two parameters that indicate the change from the Start level.

**Height** Sets the distance of Level 1 above the Start level.

**Outline** Sets the distance to offset the Level 1 outline from the Start Outline. Levels 2 and Level 3 are optional and allow you to change the bevel amount and direction.

**Level 2** Adds a level after Level 1.

**Height** Sets the distance above Level 1.

**Outline** Sets the offset distance of the Level 2 outline from Level 1.

**Level 3** Adds a level after the previous level. If Level 2 is not on, Level 3 is added after Level 1.

**Height** Sets the distance above the previous level.

**Outline** Sets the offset distance of Level 3 from the previous level.

Traditional beveled text uses all levels with these typical conditions:

- Start Outline can be any value, usually 0.0.
- Level 1 Outline is a positive value.
- Level 2 Outline is 0.0. No change from Level 1.
- Level 3 Outline is the negative of Level 1. Returns Level 3 to the same size as the Start Outline.

---

**Bevel Profile Modifier**

Select a shape. > Modify panel > Modifier List > Bevel Profile

The Bevel Profile modifier extrudes a shape using another shape path as the "beveling profile." It's a variation on the **Bevel modifier** on page 1169.

**IMPORTANT** Bevel Profile fails if you delete the original beveling profile. Unlike a loft object, which incorporates the shape, Bevel Profile is simply a modifier.
**NOTE** Although this modifier might seem similar to a loft object with varying scale settings, it’s actually different because it uses different outline values as distances between line segments rather than as scale values. This more complex method of resizing a shape results in some levels having either more or less vertices than others, and generally works better with text, for example.

Bevel Profile creates an object using an open spline.
Bevel Profile creates an object using a closed spline, yielding a different result.

**Procedures**

**To use the Bevel Profile modifier:**

1. Create the shape you want to bevel (preferably in the Top viewport).
2. In the Front (XZ) viewport, create a shape to use as the beveling profile.
3. Select the first shape and apply the Bevel Profile modifier.
4. Click the Pick Profile button in the Bevel Profile modifier, and then click the profile shape.
Interface

Modifier Stack

For more information on the stack display, see Modifier Stack on page 8187.

Parameters rollout

Bevel Profile group

Pick Profile Selects a shape or NURBS curve to be used for the profile path.

Generate Mapping Coords Assigns UV coordinates.

Real-World Map Size Controls the scaling method used for texture mapped materials that are applied to the object. The scaling values are controlled by the Use Real-World Scale settings found in the applied material's Coordinates rollout on page 6201. Default=on.
Capping group

Start Caps the bottom of the extruded shape.
End Caps the top of the extruded shape.

Cap Type group

Morph Selects a deterministic method of capping that provides the same number of vertices for morphing between objects.
Grid Creates gridded caps that are better for cap deformations.

Intersections group

Keep Lines From Crossing Prevents beveled surfaces from self intersecting. This requires more processor calculation and can be time-consuming in complex geometry.
Separation Sets the distance that sides should be kept apart to prevent intersections.

Camera Map Modifier (Object Space)

Select one object. > Modify panel > Modifier List > Object-Space Modifiers > Camera Map
Select one object. > Modifiers menu > UV Coordinates > Camera Map
The Camera Map modifier (object-space version) assigns planar mapping coordinates based on the current frame and the camera specified in the Camera Map modifier. This differs from the Camera Map (WSM) modifier on page 1067 that updates the object’s mapping coordinates on every frame.
Left: The texture of an object with a camera map modifier matches the background when seen by the camera the modifier uses.

Right: When seen by a camera not used by camera map, the object’s texture is based on object geometry.

**Blending an Object into the Background**

In the Procedures section (below), you’ll be blending an object into the background using the Camera Map modifier. If the background uses the same image as the object’s texture map, then the object blends with the background at the frame where the modifier is applied and a camera is specified. The object becomes visible if either the camera or object moves. In order to make the illusion work, you must assign the same map to the background that you assign to the object.

**Mapping Coordinates**

Because the accuracy of mapped objects depends partly on the complexity of the mesh, the “blend to background” effect works best when applied to an object with a relatively high density of triangular faces. The necessary density also depends on the distance of the object from the camera.
A simple box might look fine when it occupies only a small portion of the background, but up close the mapping will look distorted without adequate tessellation. Some experimentation is required to get an ideal mapping and still minimize the complexity of the geometry. (In general, for a box object that’s filling a quarter of the screen, a tessellation of 4x4x4 works well.)

**NOTE** When using the Camera Map modifier, apply the modifier to a single object at a time. If it’s applied to a selection set, only the first item in the selection will be mapped properly.

Use Camera Map (WSM) on page 1067 if you want to move the camera and maintain the match to the background.

**Using the Plate Match/MAX R2.5 Rendering Filter**

Prior to 3ds Max 3, the antialiasing affected only geometric edges, with the filtering of bitmaps being controlled in the Bitmap Map parameters (pyramidal, summed area, or no filtering). Antialiasing filters affect every aspect of the object, filtering textures along with geometric edges. While antialiasing provides superior results, it produces inconsistencies when rendering objects that are supposed to match the environment background. This is because the antialiasing filters do not affect the background by default. You can turn on background antialiasing in Customize > Preferences > Rendering > Background Antialiasing > Filter Background. To correctly match an object’s map to an unfiltered background image, you need to use the Plate Match/MAX R2.5 filter so the texture is not affected by the antialiasing.

There are three ways you can render objects in 3ds Max to blend seamlessly into a background environment:

- By assigning a Matte/Shadow Material
- By assigning a 100% self-illuminated diffuse texture to an object using Camera Mapping
- By assigning a 100% self-illuminated diffuse texture using Environment/Screen projection

The Plate Match/MAX R2.5 antialiasing should be used whenever trying to match foreground objects with an unfiltered background or when trying to match the antialiasing qualities of the 3ds Max 2.5 renderer.
Procedures

The following steps show how to apply the Camera Map modifier, and how to set up your scene.

To apply the Camera Map modifier:

1. Create a scene with a camera and one or more objects. Make sure the object you want to map is visible in the Camera viewport.

2. Select the object, and apply the Camera Map modifier. Be sure to use the Object-Space version of the Camera Map modifier.

3. If you have animation in the scene, move to the frame where you want the object map to match the background. For example, if the camera is animated, the mapping will match only at this frame.

4. On the Camera Mapping rollout, click Pick Camera, and then select the camera used for the rendered view.

To assign a background image to the Camera viewport:

NOTE This procedure is not necessary for successful rendering, but if you want to see the effect in a viewport, follow these steps.

1. Activate the Camera viewport and turn off the grid.

2. Choose Views menu > Viewport Background.

3. On the Viewport Background dialog that displays, click the Files button, and choose the same bitmap that you plan to apply as a background for the rendered scene, and as a diffuse map on the object.

4. In the Aspect Ratio group, choose Match Rendering Output.

5. Turn on Display Background, and click OK. The dialog is dismissed and the map is displayed in the viewport.

To assign a mapped material to the object:

1. In the Material Editor, create a standard material to whose Diffuse component you've assigned the same bitmap as you assigned to the background.

2. At the Diffuse Map level of the material, turn on the Show Map In Viewport button.
3 Select the object, and click Assign Material To Selection.
The map on the object in the viewport matches the viewport background,
but the shading makes the object visible. To make the object truly
invisible, go to the next step.

4 At the top level of the object’s material, set Specular Level and Glossiness
to 0. Turn off Self Illumination Color, and set Self Illumination to 100.
The object is now camouflaged against the background.

To assign the background to the rendered background:
1 Choose Rendering menu > Environment.

2 In the Environment dialog that displays, click the button below
"Environment Map" to open the Material/Map Browser.

3 Under the Browse From group box, choose Material Editor.

4 Turn off Root Only, find the map in the list window, highlight it, and
choose OK.

5 Choose Copy in the dialog, and click OK.

6 In the Exposure Control rollout on the Environment dialog, make sure
the exposure is set to <no exposure control> or the turn off the Active
switch.
   If this is not done, you will be able to see the object in the rendering.

7 Render the Camera viewport.
The mapped object is camouflaged against the background in the rendered
scene.
Interface

Pick Camera To apply the UVW coordinates, click this button, and then select the camera through which you're going to view the scene.

Map Channel Turn on and choose a map channel to use. Map channels are specified in the Material Editor.

Vertex Color Channel Uses the Vertex Color channel.

Cap Holes Modifier

Select a mesh object. > Modify panel > Modifier List > Cap Holes
Select a mesh object. > Modifiers menu > Mesh Editing > Cap Holes

The Cap Holes modifier builds faces in the holes in a mesh object. A hole is defined as a loop of edges, each of which has only one face. For example, one or more missing faces from a sphere would produce one or more holes. The modifier works best on reconstructing planar holes, but can do a reasonable job on non-planar holes as well.
Cap Holes used to make the cake appear solid

**NOTE** This modifier can cap holes in a sub-object selection passed up the stack. It caps any part of the hole that’s adjacent to, or within the selected geometry, whether vertex, edge, or face.

**Tips**

- If the Cap Holes modifier doesn’t appear to work, remove it, apply a Mesh Select modifier on page 1500 to select the faces surrounding the hole, then apply Cap Holes to the sub-object selection.

- The Cap Holes modifier creates faces with invisible edges unless you turn on All New Edges Visible before you apply it.

**Procedures**

Example: To cap a hole in a sphere:

1. Create a sphere.
2. Apply an Edit Mesh modifier to the sphere.
3. In the stack display, choose the Face selection level.
4. Select and delete a contiguous group of faces.
5. Turn off the Face selection level.
6. Apply a Cap Holes modifier.
The hole you created should be filled.

**TIP** Turning on Smooth With Old Faces makes the cap less visible.

### Interface

![Parameters Interface](image)

**Smooth New Faces** Assigns the same smoothing group number to all new faces. If possible, this will be a smoothing group number not used elsewhere in the object.

**Smooth With Old Faces** Smooths new triangular faces using the smoothing groups from bordering old faces. This smooths only one level in from the perimeter of the border of the hole, so you might need to use both this and the Smooth New Faces option to properly smooth a large hole.

**NOTE** When Smooth With Old Faces is turned on, the faces in the capped holes inherit a material face ID from one of the surrounding faces. When this item is turned off, the faces in the capped holes are assigned a new ID.

**Triangulate Cap** Makes all of the edges visible in the new faces.

### Cloth and Garment Maker Modifiers

Cloth provides you with advanced tools for creating realistic fabrics and tailor-made clothing for characters and creatures.
The Cloth system comprises two modifiers:

- The **Cloth modifier** on page 1204 is responsible for simulating the motion of cloth as it interacts with the environment, which may include collision objects (a character or a table, for example) and external forces, such as gravity and wind.

- The **Garment Maker modifier** on page 1266 is a specialized tool for creating 3D garments from 2D splines, similarly to the way real clothes are made, by stitching together flat pieces of cloth.

You can model clothing in two ways: by creating the cloth objects with standard 3ds Max modeling methods and applying the Cloth modifier to them, or by designing virtual clothing patterns with splines and stitching together these various virtual panels to form a full garment using the Garment Maker modifier. With Garment Maker, you can even import spline patterns from external applications and use these as your pattern panels.
Cloth and Garment Overview

Cloth is an advanced cloth-simulation engine that lets you create realistic garments for your characters and other creations. Cloth is designed to work in concert with the modeling tools in 3ds Max and can turn just about any 3D object into clothing; it also allows you to build garments from scratch.

Before you begin working with Cloth, we recommend that you read this overview. It provides background information on cloth-simulation technology, so you can begin to grasp exactly the way Cloth works. It will give you a better overall understanding of how to set up Cloth scenes, the way the cloth behaves, and the array of advanced controls you will have at your disposal.

As an artist and creator, you can use this knowledge to tailor (no pun intended) how Cloth will affect and interact with your scenes, and how you can best take advantage of this software.

Cloth-Simulation Technology

Cloth simulation is the process of replicating the movement and deformation of a piece of fabric or clothing to mimic how cloth would react in the real world. To make cloth simulation work, first you need a cloth object, such as a tablecloth or a pair of pants. Next, you need something for the fabric to interact with. This can be a collision object such as a table top or character's leg, or a force such as wind or gravity.

Limitations

While Cloth is designed to help you create clothing for your models, you should be aware that, by its very nature, cloth simulation is only an approximation of how real fabric would react under certain circumstances; this system does have some limitations.

One of the most important aspects of working with Cloth is the amount of time it can take to create a simulation. If you're looking to create a fully physically correct simulation, you might run into problems. Even with a fast computer, cloth dynamics at that level of accuracy (and geometric detail) could take virtually forever. So you must learn to scale your simulations back to a reasonable level. This doesn't mean you can't get believable clothing; it simply means that there are tradeoffs you should be willing to make.
Tradeoffs

In order to create a believable simulation, you need to balance time against quality and accuracy. The more time you have, the more accuracy and quality your simulation can have. There's no reason to make a model with 10,000 polygons if you can define the form equally well with 3,000. The same rule applies to cloth simulations.

Internal and External Forces

When simulating cloth, different forces come into play. Some internal forces like bend, stretch, and shear allow the fabric to deform in a realistic manner. External forces such as gravity, wind, and collisions make the cloth interact with its environment. To obtain a good-looking simulation, most or all of these things need to come into play. Without these forces, a piece of cloth will remain a flat, lifeless plane.

Collision Detection

When putting a shirt or pair of pants on a character, you don't want any part of the body to protrude through the fabric. The desired result is to have the garment deform around the mesh (rather than through it) so there are no intersections. This is done with collision detection; with Cloth, you tell the simulation system which objects will act as cloth, and which ones will act as collision objects.

Basically, virtual feelers are sent out from the vertices of the cloth objects to see if there are any other objects that they might collide with. When one of the feelers hits something, the simulation knows that it must deform the fabric. It is important to remember that a cloth mesh with more vertices has more feelers and can do a better job of collision detection. This is critical, because if you are working with a high-poly character (collision object), you will need to increase the density of your cloth, or the high-poly mesh will protrude through the lower-poly cloth object. The reason is that there aren't enough feelers to detect all of the detail in the collision object.

The alternative to this is to add one or more low-polygon proxy meshes for the character so there doesn't need to be such high density cloth objects that will slow down simulation. We'll cover the mesh density a bit more in the next section.

Lastly, if you are simulating with fast-moving cloth objects, you might need to increase the Density value to give you the benefit of more feelers. You also might adjust the Step size to check more often for collision objects in the way.
Clothing and Pattern Design Overview

Traditionally, sewing patterns are cut from flat pieces of cloth and stitched together. The place where one piece of cloth is sewn to another is called a seam. Patterns are generally symmetrical, where the left side of the garment matches the right.

Skirt

The simplest is a skirt pattern with two pieces, with a similar shape for the front and back. The back shape is a little larger than the front to account for the hips and buttocks.

The shapes are sewn together at the sides to form a simple skirt.
The bottom edge of a garment is called a hem. In the skirt pattern, the waistline and hem are slightly curved. When a person puts on the skirt, the curve sits flat on the waist, while the skirt falls in folds to the hem. Because both the waistline and hem are curved, the skirt falls to the same length all the way around.

**Shirt**

A shirt pattern is slightly more complicated. A simple T-shirt pattern is made of two pieces, one for the front and another for the back. The collar on the back piece is higher than the collar on the front. You sew seams up the sides and at the shoulders, leaving the arm hole open.
You can also add sleeves to the shirt. A sleeve pattern is bell-shaped.

It might not be immediately obvious how this pattern turns into a sleeve. The large hump of the bell fits over the shoulder, to give room for it to move.
Pants

A pants pattern has a curved shape at the top to accommodate the hips. The longer straight edge is the outside seam, while the shorter edge is the inseam. The curve near the top fits around the belly or buttocks, and under the crotch area.
Each piece is cut twice. The two front pieces are sewn together along the crotch, and the two back pieces are sewn together in the same way. Then the front is attached to the back at the outside seams and inseams.
Darts

Darts are diamond-shaped holes inside a panel or V-shaped cutouts at an edge of a garment panel (see figure below), which when closed up cause the garment to assume a curved shape.
Darts used to be a common part of women’s everyday clothing, especially in blouses and dresses. However, darts are not needed with loose garments or stretchy clothing. Today, they are used mostly in formal wear and tailored garments.

**Clothing Design and Techniques**

One way to create clothing is to lay out a pattern and put it together with Garment Maker. Garment Maker is a modifier that is used to make seams, lay out cloth panels and define fabric densities. You can use Garment Maker to create seams for the pattern either in a traditional, flat layout or in a visual, easy-to-use 3D layout.

In the real world, clothes are made by cutting out shapes from pieces of cloth and sewing them together along seams with thread. Garment Maker emulates this approach. First you must create a pattern that will define the shapes of the panels. Clothing patterns typically use shapes that we don’t encounter in everyday life. Those of us who aren’t an experienced clothing designers might have a hard time creating these shapes from scratch. It’s often best to start out with a pattern made by somebody else. Cloth includes a variety of patterns
for shirts, pants, jackets and so forth. You can also buy software that will generate these patterns in DXF format.

One program that does this is PatternMaker, available from http://www.patternmaker.com. When you want to move beyond editing the patterns included with Cloth, it’s often helpful to use such applications to help create patterns and familiarize yourself with the process.

![Shirt pattern and shirt sewn together with Garment Maker](image)

**Modeling Clothing**

Garment Maker is a useful tool for putting together patterns and adjusting seams, but you can also achieve good results by modeling with the standard 3ds Max tools and using Cloth on top of these meshes. You can create clothing with polygons, patches, or NURBS.

**IMPORTANT** Keep in mind that modeled clothing must not have any overlapping vertices or interpenetrating faces. This type of geometry can cause the simulation to fail. Using Garment Maker, you will not run into this problem. If you are careful in creating your mesh, then this is an easy rule to follow.

**Pros and Cons**

When designing clothing, Garment Maker is usually the best way to go. It lets you define seams, seam strength, pleats, and other clothing parameters that cannot be defined with clothing modeled via other methods. Either methods lets you define separate portions of your clothing with different fabrics, but Garment Maker gives you greater control over this. The advantage to using modeled clothing is that it can sometimes be a faster setup with familiar methods and it’s a great way to repurpose older clothing models you have.
made in the past. Using polygon-modeled clothing can result in overly regular creases and folds. Garment Maker uses a Delaunay mesh, which tends to avoid this problem. However, the irregular triangulation can result in rendering artifacts for low-resolution clothes, so it is advisable to apply the **HSDS modifier** after Cloth on garments created with Garment Maker and subdivide all the triangles once.

**NOTE** MeshSmooth does not give good results with Garment Maker meshes.

**Left: Garment Maker Delaunay mesh**  
**Right: Modeled quad mesh**

### How Cloth Works

Cloth exists within 3ds Max as a pair of modifiers: Garment Maker and Cloth. Between these two, you can turn just about any 3D object into a cloth object, or you can create clothing in a more traditional method from 2D patterns, and then sew the panels together. However, before getting into the specifics of the two modifiers, it’s useful to discuss how to preplan for using Cloth. This includes how geometry affects Cloth behavior as well as the density of the meshes you use as fabric.
Effect of Geometry on Cloth

Ideally, the way you model your cloth should not affect how it behaves. However, in practice, the nature of the cloth geometry impacts the simulation. First of all, the density of the mesh defines how fine the folds are that can develop. If you create a plane with only nine vertices, when you drape it over a sphere, you are obviously not going to get much detailed folding.

In addition to this aspect, there is the nature of the edges in the mesh. Folding can occur only at edges between triangles, so the regularity or irregularity of the mesh also dictates the resulting deformation. For example, a plane all of whose triangle hypotenuse edges are aligned will result in a cloth with folds aligned along those edges. Garment Maker creates meshes with an irregular layout (but with fairly equal-sized and close-to-equilateral triangles) that avoids this folding bias. However, this can also result in rendering artifacts with low-resolution cloths, so it is advisable to apply the HSDS modifier after Cloth on garments created with Garment Maker and subdivide all the triangles once.

NOTE MeshSmooth does not give good results with Garment Maker meshes.

Left: A low-density shirt.
Right: The same shirt with HSDS applied, above Cloth in the modifier stack

NOTE There should never be any modifiers that can alter topology between Garment Maker and Cloth. For example, you can use Unwrap UVW, but not modifiers such as Edit Mesh, MeshSmooth, or HSDS.

The type of geometry you work with can have a great impact on how the cloth will react. You're probably accustomed to using triangular and quadrilateral polygons for modeling. Garment Maker uses a Delaunay mesh subdivision
that promotes non-uniform deformation. When using quad polygons for cloth simulation be careful of getting uniform or symmetrical results.

Left: A quad mesh
Right: A Delaunay mesh

**Cloth Mesh Density**

It is important to think about how dense your mesh has to be to achieve the result you want. Making the mesh too dense will slow down the system, while having your mesh at too low resolution might not give you the folds or detail you want to see.

For example, if you applied a Bend modifier to a cylinder with only a few height segments, the result would be angular and unsmooth. On the other hand, if you created the cylinder with 1,000 height segments, you’d be wasting resources. The same is true for Cloth. You must find a balance between level of detail and performance that is appropriate for your scene.

Low, medium, and high-density meshes and the way they deform
Notes on the HSDS Modifier

Using the HSDS modifier to add detail to your model can be an effective solution that lets you simulate with a lower resolution mesh, and still get high-quality results. However, if you choose to use the HSDS modifier on top of your Cloth garments, you may want to apply an Edit Mesh modifier below it to weld the vertices together along the seams. This prevents the mesh from coming apart at the seams as it is subdivided.

Shown above is how the modifier stack should look when using HSDS. The intermediate Edit Mesh modifier is used to weld the panel edge vertices together. If you want to preserve the seam creases, you should apply further Mesh Select and Smooth modifiers to reselect the panels and apply different smoothing groups across the garment.

Pattern-Making Software

Below is a list of traditional pattern-making software that you can use to create patterns for import into 3ds Max and use with Cloth. After ensuring that your Internet connection is active, click the software names to display the makers' Web sites.

- Fashion CAD
- PatternMaker
- Wild Ginger Software
- Autometrix
Cloth Modifier

Select an object. > Modify panel > Modifier List > Object-Space Modifiers > Cloth

The Cloth modifier is the heart of the Cloth system, and is applied to all objects in your scene that need to be part of the Cloth simulation. This is where you define cloth and collision objects, assign properties, and execute the simulation. Other controls include creating constraints, interactively dragging the cloth, and erasing parts of the simulation.

Left: Cloth modifier not yet applied
Right: Cloth modifier applied and simulated

See also:

- Object Properties Dialog (Cloth) on page 1222
- Cloth and Garment Maker Modifiers on page 1187
Basic Concepts

In a Cloth simulation, you will let Cloth know which objects will be part of the simulation, and which objects will not. Once you have done this, you define what the objects are made of. You can specify what is made of cloth, and what is a solid, collision object.

Because Cloth is a modifier, an instance of it is assigned to each object to be included in the Cloth simulation. This includes all cloth and collision objects. Be aware that two cloth objects with two separate applications of the Cloth modifier will not interact with one another. There are a couple of ways to include objects in the simulation:

- Select all of the objects at once and apply the Cloth modifier to them.
- Apply Cloth to one or more objects and then add objects with the Add Objects button, available on both the Object rollout and the Object Properties dialog on page 1222.

Units of Measure

IMPORTANT The following information is necessary only if you change the system unit after applying the Cloth modifier. If you change the system unit before applying Cloth, the modifier automatically adjusts the cm/unit setting.

It is important to think about size in doing clothing simulations. A very large flag behaves differently from a handkerchief. If the scale is off, then the simulation will be off. Because Cloth deals with real-world physics, it works in real-world units. This means that Cloth needs to know the relationship between units in 3ds Max and units in its own world.

For example, suppose you create a plane that is 10 x 10 3ds Max units. If you want this plane to behave like a 10-inch x 10-inch handkerchief, you would tell Cloth that 1 3ds Max unit=1 inch. If you want it to behave like a 10-foot x 10-foot bed sheet, you would tell Cloth that 1 3ds Max unit=1 foot.

Except as noted at the start of this section, Cloth ignores the 3ds Max System Units Setup (under Customize menu > Units Setup > System Units Setup). Cloth has its own units setup, which is determined by the cm/unit parameter on page 1241 on the Simulation Parameters rollout. This tells Cloth how many centimeters (cm) correspond to each 3ds Max unit. One inch equals 2.54 cm,
so the default setting of 2.54 means that one 3ds Max unit corresponds to 1 inch.

Following is the procedure to follow to determine what setting to use here.

1 Use the measure utility or tape helper to measure some dimension of your cloth (or character) in 3ds Max units (call this number x).
2 Decide how big you want this object to be in the real world. Convert this number to centimeters. If you have the dimension in inches, simply multiply by 2.54 (call this number y).
3 \[ \text{cm/unit} = \frac{y}{x} \]

Here is a quick example: You import a file, man.obj, into 3ds Max, and want to put a shirt on him.

1 Using the Measure utility, you find that the man is 170 3ds Max units tall. So \( y = 170 \).
2 You determine that this man is about 6 feet tall.
   - 6 feet = 72 inches.
   - And 72 inches = 72 \times 2.54 = 182.88 cm. So \( x = 182.88 \)
3 So now you have the values to make sure the shirt behaves correctly. \[ \text{cm/unit} = \frac{170}{182.88} = 0.929 \] Or you can round the spinner's value up to 1.0, since pinpoint accuracy is not needed here.

**Fabric Behavior**

Cloth provides many different ways to set up fabric behaviors. You can make your cloth behave like leather, silk, burlap, and anything in between.

**The Simulation**

Once all of your parameters are set and you’re ready to go, it’s time to simulate. In many cases, you will first perform a local simulation to fit your fabric to your character. Once your fabric is in place, you can simulate over time.

Running a simulation in Cloth is very freeform. You are able to make many changes and edits to a simulation, making it more of a work in progress than a click and a “hope for the best” scenario.
Constraints

You can constrain fabric in various ways to create different fabric effects during simulations. Cloth can constrain cloth to have extra drag as it flies through the air, or can cause it to be affected by a space warp in the scene. Linking a portion of the fabric to an animated object or attaching to a surface are other common constraints. If you wanted to create a pair of pants you would constrain the top portion of the pants to the waist of the character or a curtain can be constrained to a rod. Constraints are a very important and robust part of Cloth. Cloth has the ability to make multiple groups of constrained vertices for great flexibility. You can constrain many different parts of a piece of clothing to different nodes' surfaces or other cloth objects.

You build constraints in Cloth at the modifier's Group sub-object level on page 1244. At this level, you can see vertices of all selected objects, both cloth and collision. You can then select these and place them in groups. Once a group is defined, you can then attach or "constrain" the selection set to another object, or have it affected by some external force.

Tearing Cloth

You can tear cloth. For an example of how to do so, see this procedure on page 1211.

Cloth tears during the course of a simulation under a couple of circumstances:

- The forces affecting the cloth pull it in a way that causes it to tear. A Strength or Tear Threshold value (they are the same) lets you set how easily cloth is torn.
- The cloth collides with a collision object that is set to Cuts Cloth. See Collision Properties on page 1234.

You must specify where the cloth will tear before you run the simulation. There are a few different ways to do this:

- In either Cloth or Garment Maker, set a seam to be tearable. See Seams Sub-Object Level (Cloth) on page 1263, Curves Sub-Object Level (Garment Maker) on page 1287, and Seams Sub-Object Level (Garment Maker) on page 1294.
- In the Cloth modifier, use the Group sub-object level to choose vertices that will tear, and then click Make Tear to create the tear. See Group Rollout (Cloth) on page 1245.
With the Cloth modifier, choose two cloth elements that will tear apart, then at the Group sub-object level, join their edges by choosing vertices and then clicking Weld. See Group Rollout (Cloth) on page 1245.

Tearing Cloth and the Point Cache Modifier

If you use a Point Cache modifier on page 1574 to optimize a Cloth animation, there is a chance that tears will not be smoothed correctly before tearing occurs. To fix this problem, you can add a Welder modifier on page 2004 to the stack. Place the Welder above the Point Cache modifier.

Procedures

Example: To use the Keep Shape option:

If your cloth object starts out with 3D shape that you'd like to retain during the simulation, you can use the Keep Shape option and setting to preserve this shape, or even reverse it. This simple procedure provides an example of how to use Keep Shape.

1 In the Top or Perspective viewport, add a Plane primitive object of about 90 x 90 units, with 20 x 20 segments.

2 Apply a Bend modifier, set Angle to 250.0, and set Bend Axis to X. This produces the initial tubular shape.

3 Copy the bent plane twice so you have three planes in a row. Rename the planes as follows:
   - don't keep shape
   - keep shape
   - reverse shape
4 Select all three planes and apply the Cloth modifier.

5 On the Simulation Parameters rollout, turn off Gravity and set cm/unit to 0.5.
   Turning off Gravity keeps the cloth objects from falling during the simulation, so they stay in view, and lowering the cm/unit setting compensates for the planes’ relatively large size.

6 On the Object rollout, click Object Properties.
   This opens the Object Properties dialog.

7 In the Objects In Simulation list, highlight all three planes (by dragging), and then, above the Cloth Properties group, choose Cloth. Also set U Bend to 500.0.
   This sets V Bend also to 500.0 automatically.
   Using high Bend values allows the simulation to proceed more quickly.
   Next, you’ll set different Keep Shape properties separately for each object.

8 Highlight the reverse shape object in the list and set the Bend % value to -100.0.

   NOTE The default value is 100.0.
Click OK to exit the dialog.

Select the *don't keep shape* object and note that Object rollout > Selected Objects Manip group > Use Target State is off.

Select both the *reverse shape* and the *keep shape* objects, but not *don't keep shape*, and then turn on Use Target State.

On the Object rollout, click Simulate Local.

After a few seconds, the *don't keep shape* object starts to flatten out, the *keep shape* object doesn't change, and the *reverse shape* object has, in fact, reversed its shape, effectively creating a negative bend angle.

**TIP** You can also use Use Target State with Grab State to maintain or reverse a shape created with a previous cloth simulation or shape-changing modifier.
Example: To tear a piece of cloth:

1. In the Top viewport, create a Plane. Make it about 150 units on each side. Set its Length Segments and Width Segments both equal to 7.

2. Also in the Top viewport, create two dummy objects: one on each side of the plane.

   ![The plane flanked by two dummy objects]

3. Turn on Auto Key. Go to frame 100, then animate each dummy object so it moves about 300 units away from the plane along its X axis: move the left-hand dummy to the left, and the right-hand dummy to the right.

4. Turn off Auto Key.
5 Go back to Frame 0.

6 Select the plane. Go to the Modify panel, and apply a Cloth modifier to the plane.

7 On the Object rollout, click Object Properties. 3ds Max opens the Object Properties dialog for cloth. In the list of objects, click Plane01 to highlight it, choose the Cloth radio button to make Plane01 behave as cloth, and then click OK (keep all the default Cloth Property settings).

8 In the Modifier stack, go to the Group sub-object level.

9 Select the vertices along the left-hand side of the plane, and then on the Group rollout, click Make Group. Click OK to accept the default name of Group01. With Group01 still highlighted in the Group list, click Node, and then in a viewport click the left-hand dummy object to assign it to this group.

10 Repeat step 9 for the right-hand column of vertices and the right-hand dummy object.

11 Select the two center columns of plane vertices, and then on the Group rollout, click Make Tear. Click OK to accept the default name of Group03.
Central vertices selected to create a tear in the cloth

3ds Max creates a new Weld constraint that comprises the vertices at the center of the cloth plane.

After clicking Make Tear

12 On the Modifier stack, go back to the top Cloth level.
13 In the Object rollout > Simulation group, click Simulate.  
3ds Max animates the dummies pulling at the cloth. As this happens,  
the cloth tears along the vertices that you set to tear.
Cloth tearing in the center as its edges are pulled apart

Depending on the position of the dummy objects, the tear you see in your example might differ from the one shown in these illustrations.
To run a cloth simulation with a networked render farm:

A complex cloth simulation can require extensive computation and take a long time. Cloth includes commands that make it easy to run a simulation on a networked machine (part of a render farm), freeing up your machine for working on other parts of the scene.

1. Set up the simulation.
2. For each cloth object in the simulation, select the object, and then on the Selected Object rollout click Set and specify a path and file name for the cache.
   For best results, specify a mapped drive and turn on Force UNC Path. This specifies the path using the Universal Naming Convention so that it can be found by all computers in the network. Also, it’s probably a good idea to keep all the cache files in the same directory.
3. On the Simulation Parameters rollout, turn on Sim On Render.
4. Save the scene file.
5. On the Render Setup dialog, turn on Net Render, and then click Render. Submit the job to a single Server.

Unlike rendering, network Cloth simulation cannot be split up among multiple Server machines.

NOTE You needn’t render the entire animation to trigger the cache creation; a single frame suffices.

As soon as the Server machine starts the render, it begins computing the simulation and saving it to disk. At any point you can load the simulation in its current state from the cache file to check its progress by clicking the Load button.

Object Rollout (Cloth)

Select an object. > Modify panel > Modifier List > Object-Space Modifiers > Cloth > Object rollout

The Object rollout is the first rollout you see on the Command panel once you apply the Cloth modifier. It comprises mostly controls to create a Cloth simulation and adjust fabric properties.
Object Properties  Opens the Object Properties dialog on page 1222, where you can define which objects to include in the simulation, whether they are cloth or collision objects, and the parameters associated with them.

Cloth Forces  Add forces (that is, space warps in the scene) such as wind to the simulation. Click Cloth Forces to open the Forces dialog. To add forces to the simulation, in the Forces In Scene list on the left side, highlight the forces to add, and then click the > button to move them to the Forces In Simulation list, thus adding them to the simulation. Thereafter, the forces affect all cloth objects in the simulation.

To remove forces from the simulation, in the Forces In Simulation list on the right side, highlight the forces to remove, and then click the < button to move them to the Forces In Scene list.

Simulation group

To run a cloth simulation, click any of the three Simulate buttons in this group. To halt a simulation, press Esc or if the Cloth Simulation dialog is open (i.e., Progress on page 1219 is on), click the Cancel button.

Simulate Local  Starts the simulation process without creating animation. Use this to drape the clothes on a character or sew the panels of a garment together.

Simulate Local (damped)  Same as Simulate Local, but with a large amount of damping added to the cloth. When sewing a garment together, sometimes the panels come together at high speed, causing problems. Using a damped simulation alleviates this problem.

Simulate  Creates a simulation over the active time segment. Unlike Simulate Local, this creates animation data in the form of a simulation cache at every frame.
The simulator advances by a time step called $dT$. The initial value is the Step setting on page 1242 on the Simulation Parameters rollout. When the simulator encounters certain situations, it decreases $dT$ in order to overcome the obstacles. Sometime later, the simulator increases $dT$ again up to the maximum Step value you set. The current value of $dT$ appears on the Cloth Simulation dialog that shows the progress of the simulation as it takes place (see following).

When the simulator decreases $dT$, it shows "$dT$ decreased" on the Cloth Simulation dialog along with one of the following messages (explanation follows each message):

- **could not solve equations** – The solver could not solve the equations of motion.
- **cloth has become over-stretched** – In attempting to solve one step, some edges of the cloth became too elongated, indicating a failure of the solver.
- **cloth-solid collision velocity was too large** – The speed of the cloth relative to that of the collision object is too high.
- **cloth-cloth collision velocity was too large** – The speed of colliding cloth parts is too high.

**Progress** When on, opens the Cloth Simulation dialog during the simulation. The dialog shows the progress of the simulation, including information about time, and messages about errors or time step size adjustments.

![Cloth Simulation Dialog](image)

The Cloth Simulation dialog shows information about the simulation while it's running.

**Simulated Frames** Shows the number of frames simulated so far.

**Erase Simulation** Deletes the current simulation. This deletes the cache of all cloth objects and sets the Simulated Frames count back to 1.
**Truncate Simulation** Deletes animation created by the simulation after the current frame.

For example, if you've simulated an animation to frame 50 but want to keep only animation keys from frames 0 to 30, set the time slider to frame 30, then click this button. The simulation is then deleted from frame 31 on.

**Selected Object Manip group**

**Set Initial State** Updates the first frame of the selected cloth object's cache to the current position.

**Reset State** Resets the selected cloth object's state to the state before Cloth in the modifier stack. When you click this, the simulation is erased; that is, Simulated Frames returns to 1.

**Delete Object Cache** Deletes the cache for selected non-cloth objects. If an object is simulated as cloth, and is then turned into a collision object (or inactive) via the Object Properties dialog, it will retain the cloth motion in its cache.

This is useful for simulating clothes in layers. For example, you may simulate a character's pants, then turn the pants into a collision object for simulating a coat. By simulating in layers, you avoid the problems of cloth-to-cloth collision detection. If you want to remove the cached motion from the selected object(s), click this button.

**Grab State** Grabs the current state from the top of the modifier stack and updates the cache for the current frame.

Following is an example of how this might be used:

1. Simulate to frame 100. When you play back the simulation, you see a collision object poking through the cloth at frame 24.
2 Add an Edit Mesh modifier after Cloth and pull the cloth vertices so the object doesn't poke through.

3 Go down the stack to Cloth and click Grab State. The vertices are now moved twice as far as you intended because the vertex displacement was applied once by Cloth, and again with Edit Mesh.

4 Remove the Edit Mesh modifier. The vertices should now be where you want them.

Grab Target State Lets you specify the target shape for Keep Shape on page 1233. Grabs the current deformation from the top of the modifier stack and uses that mesh to define the target bend angles between triangles. Also turns on Use Target State on page 1221.

**NOTE** Only the bend angles from the Target State mesh are used, not the edge lengths.

**TIP** To add some natural creasing to your cloth, drop the cloth on the floor, click Grab Target State, and then run the simulation. After clicking Grab Target State and before running the simulation, click Reset State (unless you want the cloth to stay on the floor!).

Reset Target State Resets the default bend angles to the mesh below Cloth in the stack.

**NOTE** For Garment Maker on page 1266 objects, the target bend angles will depend on the output method set in the Garment Maker modifier. To see what is actually being used, use Show Target State on page 1222.

Use Target State When on, preserves the shape of the mesh as stored by Grab Target State on page 1221. It uses the Bend % and Stretch % settings in the Keep Shape on page 1233 group on the Object Properties dialog for Cloth.

If multiple cloth objects with different Use Target State settings are selected, this check box appears unavailable, but you can click it to make the setting for all selected objects.

**NOTE** In previous versions, this check box was labeled Keep Shape and was found on the Object Properties dialog for Cloth.
Create Keys Creates keys for a selected cloth object. The object is collapsed to an editable mesh, and any deformation is stored as vertex animation.

Add Objects Lets you add objects to the simulation without opening the Object Properties dialog. Click Add Objects, and then click an object to add. To add multiple objects at once, press H and use the Pick Objects dialog.

Show Current State Shows the current state of the cloth at the end of the last simulation time step. If the simulation is cancelled, the last time step could lie between two frames. If the simulation is allowed to successfully finish, the last time step corresponds to the last frame.

Show Target State Shows the current target state of the cloth; that is, the desired bend angles used by the Keep Shape option.

Show enabled solid collision When on, highlights all groups of vertices for which Solid Coll on page 1254 is on. This is handy for seeing exactly which vertices will be involved in solid-object collisions.

Show enabled self collision When on, highlights all groups of vertices for which Self Coll on page 1254 is on. This is handy for seeing exactly which vertices will be involved in cloth-to-cloth collisions.

Object Properties Dialog (Cloth)

Select an object. > Modify panel > Modifier List > Object-Space Modifiers > Cloth > Object rollout > Object Properties button

Use the Object Properties dialog to specify which objects are included in a Cloth simulation, whether they are cloth or collision objects, and define parameters associated with them.
Interface

Cloth and Garment Maker Modifiers | 1223
Objects in Simulation

The list below the caption “Objects in Simulation” shows the objects currently included in the Cloth simulation.

To change an object’s role and properties, first highlight its name in the list. You can highlight multiple object names using standard methods: Ctrl+click, Shift+click, and dragging.

Add Objects Click to open a Select From Scene dialog on page 206 that lets you select objects from your scene to be added to the Cloth simulation. After you add an object, the object name appears in the Objects In Simulation list, and an instance of the Cloth modifier is applied to the object.

Remove Removes objects highlighted in the Objects In Simulation list from the simulation. You cannot remove an object that is currently selected in 3ds Max.

Choosing the Role of an Object

Three radio buttons in the Object Properties dialog, to the right of the Objects In Simulation list, let you choose how the Cloth simulation treats each individual object.

Inactive Choose to make the highlighted object inactive in the simulation. The object can still be in the simulation, but it will not react to anything. This option is helpful for testing how different objects react, and for isolating dynamic effects.

When you first add an object to the Cloth simulation, by default it is Inactive.

Cloth Choose to make the highlighted object behave as a cloth object. Once you designate an object as Cloth, you can set its parameters in the Cloth Properties group on page 1225.

NOTE Each cloth object can actually have two sets of properties. See the following section, “High-Level Cloth Options,” for more details.

Collision Object Choose to make the highlighted object behave as a collision object. Cloth objects bounce off, wrap around, or are torn by collision objects. Once you designate an object as a Collision Object, you can set its properties in the Collision Properties group on page 1234.
High-Level Cloth Options

Use Panel Properties When on, tells Cloth to use the cloth properties specified at the Panel sub-object level on page 1259. This allows you to define different cloth properties on a panel-by-panel basis. Default=off.

While this option is on, controls in the Cloth Properties group are unavailable.

Property 1 / Property 2 These two radio buttons let you assign two different sets of cloth properties to a Cloth object.

If you assign both Property 1 and Property 2 sets, you can then use the Property Assignment group on page 1238 settings to interpolate or animate between the sets.

Three options can be set only for Property 1, and are unavailable in the Property 2 set. Both sets use the same settings for these options. The options are Use Cloth Depth/Offset, Use Edge Springs, and Use Solid Friction.

Cloth Properties

Select an object. > Modify panel > Modifier List > Object-Space Modifiers > Cloth > Object rollout > Object Properties button > Object Properties dialog > Highlight an object in the list. > Choose Cloth. > Cloth Properties group

Cloth Properties control how a cloth object behaves in a Cloth simulation.

The 3ds Max interface provides a few different ways to set cloth properties. Setting these values here in the Object Properties dialog for cloth applies them to the object globally. You can also apply these values locally at either the Group sub-object level on page 1244 or the Panel sub-object level on page 1259.

If you turn on Use Panel Properties (see Object Properties Dialog (Cloth) on page 1222), 3ds Max disables the global settings in this group. Setting properties locally for panels is useful mainly when you are modeling a multi-panel garment created by the Garment Maker modifier on page 1266.

You can assign two sets of properties to a single cloth object: Property 1 and Property 2. If both sets are assigned, you can then use the Property Assignment group on page 1238 to interpolate or animate between the sets. See also High-Level Cloth Options on page 1225.
Interface

Presets group
Sets the Cloth Properties parameters to the preset chosen from the drop-down list. Any presets that are built into the system or that have been previously saved and loaded will show up here.

**Load** Loads presets from your hard drive. Click this button and then navigate to the directory with your presets to load them into Cloth Properties. Presets have the file name extension `.sti`.

**Save** Saves Cloth Properties parameters to a file to be loaded at a later time. By default, all Cloth preset files are saved to your `\scenes\cloth` folder.

![Cloth Properties](image)

**U Bend** / **V Bend** Resistance to bending. The higher this value is set, the less the fabric will be able to bend. A cotton fabric might bend more easily than leather, so a value of 15.0 for both U and V Bend might be good for cotton, while 50.0 would work well for leather.

By default, the U Bend and V Bend parameters are locked together so that changing one sets the other to the same value. You can set different values for the two only when Anisotropic on page 1232 is off. We recommend that you do this only for Garment Maker on page 1266 objects.
Left: U and V Bend=50, simulating a burlap material
Right: U and V Bend=2.5, simulating silk or other light fabric

**U B-Curve / V B-Curve** Resistance to bending as the fabric folds. The default value of 0 sets the bend resistance to be constant. A setting of 1 makes the fabric very resistant to bending as the angle between triangles approaches 180 degrees. You never want two adjacent triangles to pass through each other, so you can increase this value to prevent this from happening.

By default, the U B-Curve and V B-Curve parameters are locked together so that changing one sets the other to the same value. You can set different values for the two only when Anisotropic on page 1232 is off. We recommend that you do this only for Garment Maker on page 1266 objects.

**U Stretch / V Stretch** Resistance to stretching. The default value of 50.0 is a reasonable value for most types of cloth. A larger value will be stiffer, while a smaller one will be stretchy like rubber.

By default, the U Stretch and V Stretch parameters are locked together so that changing one sets the other to the same value. You can set different values for the two only when Anisotropic on page 1232 is off. We recommend that you do this only for Garment Maker on page 1266 objects.

**U Compress / V Compress** Resistance to compression. Although these values default to 50.0, like their counterpart Stretch values, assigning values lower than the Stretch values can give good results, because when cloth is compressed along the length of its fibers, it tends to buckle rather than shrink.

By default, the U Compress and V Compress parameters are locked together so that changing one sets the other to the same value. You can set different
values for the two only when Anisotropic on page 1232 is off. We recommend that you do this only for Garment Maker on page 1266 objects.

**Shear** Resistance to shearing. Higher values result in stiffer cloth fabrics. Shear defines how much the individual triangles can deform. If you were to lay the edges of the triangle out in a straight line, this value would represent how long this line can stretch. With a high value, this length will be only the sum of the length of all of the sides at rest. A low value allows this length to be greater than that of all of the triangle sides at rest. This length of stretched sides is not on a one-to-one basis. One side of the polygon can stretch more than another, as long as the total shear value is not exceeded.

**Density** The weight of the cloth per unit area (in gm/cm²). Higher values mean heavier cloth like denim. Use smaller values for lighter cloth like silk.

**Damping** The larger this value, the more sluggishly the fabric will react. With a lower value, the fabric will behave with more spring. Cloth with more damping will come to rest sooner than cloth with less damping. High damping results in cloth that behaves as though it is moving through oil. Excessive damping can cause simulation instabilities.

---

**TIP** Begin by setting Damping to 0.01. If your simulation requires more damping, try increasing this value gradually.

---

**Plasticity** The tendency of the cloth to keep its current deformation (that is, the bend angles).

This is different from **Keep Shape** on page 1233, which determines the extent to which the cloth tends to keep its original deformation (or the one defined by the Target State). If you set Plasticity to 100.0, the cloth will not attempt to change the angles between triangles. If you want stiffer cloth, but you don’t want the cloth to “balloon” up, increase the Plasticity value.

**Thickness** Defines the virtual thickness of a fabric for the purpose of detecting cloth-to-cloth collisions. This value is irrelevant if cloth-to-cloth collisions are disabled. Larger values keep the cloth separated by greater distances. Be careful not to use too large or small values in this field. Very large values will interfere with the natural behavior of the cloth. Very small values will cause the simulator to take too long to calculate. This distance is measured in cm (centimeters) and should be smaller than the size of the triangles that make up the cloth object. A setting of 0.0 will let Cloth automatically assign a reasonable value for thickness.
**Repulsion** The amount of force used to repel other cloth objects. This value is irrelevant if cloth-to-cloth collisions are disabled. The simulator will apply a repulsion force scaled by this value to keep the cloth from coming in contact with other cloth objects. Increase this value if there are a lot of collisions between different parts of cloth, or if the cloth is tending to interpenetrate.

**Air Res.** Resistance to air. This value will determine how much the air will affect the cloth. A higher Air Resistance value is useful for a tightly woven fabric, while a lower value is suitable for a loose-knit garment.

**Dyn. Fric.** Dynamic friction between the cloth and solid objects. A larger value will add more friction and cause the fabric to slide less across an object. A lower value will allow the fabric to slip off an object easily, similarly to how silk behaves.

**Static Fric.** Static friction between the cloth and solid objects. When the cloth is in a stationary position, this value will control its ability stay where it is, or slip away.

**Self Fric.** Friction between the cloth and itself. This is similar to dynamic and static friction, but applies to cloth-to-cloth or self-collisions. A larger value will cause more friction between the cloth and itself.
**Seam Force** Not presently used and kept only for backward compatibility with older versions of the former product, called Stitch. This was a global seam strength, but seam strength is now defined on a seam-by-seam basis at the Seams sub-object level.

**U Scale** Controls how much to shrink or expand the cloth along the U direction (as defined by Garment Maker). For non-Garment Maker meshes, this applies a uniform scaling to the cloth along both axes, and the V Scale parameter is ignored. A value of less than 1 will shrink the fabric at simulation time, while a value of more than 1 will stretch it.

**V Scale** Controls how much to shrink or expand the cloth along the V direction (as defined by Garment Maker). A value of less than 1.0 will shrink the fabric at simulation time, while a value of more than 1.0 will stretch it.

**Depth** Collision depth for the cloth object. If a portion of cloth reaches this depth inside a collision object, then the simulation will no longer try to push the cloth out of the mesh. This value is measured in 3ds Max units.

To specify a Depth value specific to the cloth object, use this setting and be sure to turn on Use Cloth Depth/Offset on page 1233.

**Offset** The distance maintained between the cloth object and the collision object. A very low value can cause the collision mesh to protrude from under the cloth. A very high value causes the fabric to appear to be floating above the collision object. This value is measured in 3ds Max units.

To specify an Offset value specific to the cloth object, use this setting and be sure to turn on Use Cloth Depth/Offset on page 1233.

**Cling** The extent to which the cloth object adheres to a collision object. Range=0.0 to 99999.0. Default=0.0.

You can use this parameter to simulate effects such as wet cloth. A setting of 1.0 should be just enough to hold the default material onto a surface against its own weight.

**Layer** Indicates the correct “order” of cloth pieces that might come in contact with each other. Range=–100 to 100. Default=0.

If your garments and/or panels are all correctly oriented to begin with, then cloth-to-cloth collision detection should keep items from interpenetrating. However, the initial state of a garment or panel might have some interpenetration that cannot be resolved. For example, suppose you make a jacket with Garment Maker where the front right panel is supposed to sit on top of the front left panel. When you sew together the garment (generally with self-collision off), the front panels will interpenetrate, so to make sure that the right panel sits outside the left panel, you might have to use constraints or Live Drag. Using the Layers option on the panels can help here.
Here is the logic of layers: When two pieces of cloth (A and B) are in collision-detection range, their layers (layerA and layerB) are compared and the following rules are applied:

- If either layerA or LayerB is 0, then Cloth uses the regular cloth-to-cloth collision method.
- If layerA=layerB, then Cloth uses the regular cloth-to-cloth collision method.
- If abs(layerA) > abs(layerB) then piece A is pushed to the appropriate side of piece B. Which side? If layerB > 0, then to the side indicated by the face normals. If layerB<0 then to the opposite side.

The sign of the Layer value indicates what the "outside" of that piece of cloth is. A positive sign means "The side that the normals face is the outside".

---

**Based on** This text field displays the name of the preset that the initial Cloth Property values are based on. If you have not chosen a preset, it displays “default.”

When you modify some parameters and save a preset, 3ds Max saves the file using the name of the last preset you loaded.

---

**Inherit Velocity** When on, the cloth inherits the velocity of the mesh at the start of the simulation. This can be useful if you are generating a simulation in stages: generating one simulation, and then generating another that begins where the first one ended. Turning on Inherit Velocity can help create a smooth transition between the two simulations. Default=off.

**Use Edge Springs** Enables an alternative method for calculating stretch. When on, stretch force is based on springs along triangle edges. When off, the stretch and shear forces are calculated in a more sophisticated manner to more accurately reflect the underlying physics. Default=off.

**Anisotropic (unlock U,V)** When on, you can set different U and V values for the Bend, B-Curve, and Stretch parameters. The U and V directions are defined by Garment Maker on page 1266 and do not apply to non-Garment Maker meshes, for which setting different U/V values might result in unexpected behavior. Default=off.
Use Cloth Depth/Offset When on, uses the Depth on page 1231 and Offset on page 1231 values set in Cloth Properties. When on, the cloth object ignores the collision object Depth and Offset values. Default=off.

Use Collision Obj Friction When on, uses the friction of the collision object to determine friction. Values for collision can be assigned either to the cloth or the collision objects. This enables you to set different friction values for each collision object. Default=off.

Keep Shape group

These settings preserves the shape of the mesh based on the values of Bend % and Stretch %. In normal operation, when Cloth creates a simulation, it tries to "flatten out" the cloth. To enable these settings, turn on Use Target State on page 1221.

Bend % Modulates the target bend angles to a value between 0.0 and the angles defined by the target state on page 1221. A negative value inverts the angles. Range=–100.0 to 100.0. Default=100.0.

Stretch % Modulates the target stretch angles to a value between 0.0 and the angles defined by the target state on page 1221. Range=0.0 to 100.0. Default=100.0.

Pressure group

A closed volume of cloth (for example, a polymesh based on a sphere) can behave as if it is filled with gas.

Pressure The pressure of the gas filling the mesh. Increase this value to observe the pressure effect. At pressures near 100.0, the cloth volume behaves much like a balloon; lower values slow down the effect of gravity. Default=0.0.
**Damping** Increase the Damping value to slow down the effect of the pressure force. Default=0.0.

**Track Volume** When Track Volume is on, Pressure changes as the cloth volume changes. This models real-world gas, where compressing the volume increases the pressure, and so on. Default=off.

While Track Volume is on, the Pressure value sets only the pressure at the start of the simulation.

**Cap Holes** If there are holes in the mesh, turning on Cap Holes adjusts the pressure so the mesh behaves as if the holes were capped. Default=off.

**Collision Properties**

Select an object. > Modify panel > Modifier List > Object-Space Modifiers > Cloth > Object rollout > Object Properties button > Object Properties dialog > Highlight an object in the list. > Choose Collision Object. > Collision Properties group

Collision Properties control how a collision object behaves in a Cloth simulation. Cloth objects bounce off, wrap around, or are torn by collision objects.

**Interface**

![Collision Properties Interface](image)

**Depth** Collision depth for the collision object. If a portion of cloth reaches this depth inside a collision object, then the simulation will no longer try to push the cloth out of the mesh. This value is measured in 3ds Max units.

**Offset** The distance maintained between the cloth object and the collision object. A very low value can cause the collision mesh to protrude out from under the cloth. A very high value will look like the fabric is floating on top of the collision object. This value is measured in 3ds Max units.
**Dyn. Fric.** Dynamic friction between the cloth and this particular solid object. A larger value will add more friction and cause the fabric to slide across an object less. A lower value will allow the fabric to slip of an object very easily, similarly to how silk would react. This value is only used for interaction with cloth objects that have Use Solid Friction enabled, otherwise the friction value is taken from the cloth’s own properties.

**Static [Friction]** Static friction between the cloth and solid objects. When the cloth is in stationary position, this value will control its ability stay where it is, or slip away. This value is only used for interaction with cloth objects that have Use Solid Friction enabled otherwise the friction value is taken from the cloth’s own properties.

**Enable Collisions** Enables or disables collisions for this object while still allowing it to be in the simulation. This means the object can still be used for making surface constraints.

**Cuts Cloth** When on, the Collision Object can cut the cloth if it intersects with the cloth during the course of a simulation. The cloth object must be set up to have a tear along either a seam or a group of vertices. Default=off.

**TIP** When you turn on Cuts Cloth, turn off Enable Collisions. This gives the most realistic results for most models.

---

**Selected Object Rollout (Cloth)**

Select an object. > Modify panel > Modifier List > Object-Space Modifiers > Cloth > Selected Object rollout

The Selected Object rollout lets you control the simulation caches, control and optionally animate the cloth properties with a texture map or interpolation, and specify a bend map. This rollout appears only when a single object in the simulation is selected.
Cache group

Use these settings for network simulation. When you render with Sim On Render on page 1243 on, Cloth can run the simulation on a networked machine, leaving your local machine free for other work. For a procedure, see To run a cloth simulation with a networked render farm: on page 1216.

[Text field] Shows the current path and file name for the cache file. You can edit this field, but the path must exist; the file will be created if necessary. For any cloth object for which you have not specified a file name, Cloth creates one based on the object name.

Force UNC Path If the text field path is to a mapped drive, converts the path to UNC format on page 8753. This makes the path readily accessible to any computer on the network. To convert cache paths for all cloth objects in the current simulation to UNC format, click the All button.

Overwrite Existing When on, Cloth can overwrite existing cache files. To enable overwriting for all cloth objects in the current simulation, click the All button.

Set Lets you specify the path and filename of the cache file for the selected object. Click Set, navigate to the directory, enter the file name, and then click Save.

Load Loads the specified file into the selected object’s cache.

Import Opens a file dialog to load a cache file other than the specified one.

Load All Loads the specified cache file for every cloth object in the simulation.
Save Saves the current cache, if any, using the specified file name and path. If no file is specified, Cloth creates one based on the object name.

Export Opens a file dialog to save the cache to a file other than the specified one. You can save in the default CFX format or in PointCache2 format.

Extra Cache To create a second cache in PointCache2 format, turn on Extra Cache and click Set to specify a path and file name. This file is also created when you render with Sim On Render on.

**Property Assignment group**

Interpolate Interpolates between the two different property settings in the Object Properties dialog on page 1222 (as determined by the Property 1 and Property 2 radio buttons at the top right corner). You can use this slider to animate between these two properties to adjust the type of fabric settings the garment is using.

Texture Map Set a texture map and apply the Property 1 and Property 2 settings to the cloth object. You can add a grayscale texture map in this slot to blend between the two properties set in the Object Properties dialog. Black will represent property 1 and white property 2. Any grayscale value will blend between these two properties. You can drag a texture map onto this button.
Cloth object with a burlap material in Property 1 and silk in Property 2 being controlled by a Checker procedural map

**Mapping Channel** Lets you specify the mapping channel the Texture map will work from, or choose Vertex Color to use that instead. Vertex color can be particularly useful in conjunction with the new painting tools in 3ds Max. You can paint vertex colors directly onto your object and use the painted areas for material assignment.

**Bend Map group**

The Bend Map option lets you use a texture map, map channel, or vertex colors to modulate the target bend angles. The value of this is that you can paint deformations onto your cloth, or use some kind of noise map to add irregularity to the cloth.

**Bend Map** Toggles the use of the Bend Map option.
Set the strength of the modulation with the numeric value. In most cases, the value should be less than 1.0. Range=0.0 to 100.0. Default=0.5.
Choose the map type for the Bend map:

- **Vertex Color**
  Uses the Vertex Color channel for modulation.

- **Map Channel**
  Uses a map channel other than Vertex Color for modulation. Set the channel with the spinner.

- **Texture Map**
  Uses a texture map for modulation. To specify a texture map, click the button (labeled None by default) and then use the Material/Map Browser to choose the map. Thereafter the map name appears on the button.

### Simulation Parameters Rollout (Cloth)

Select an object. > Modify panel > Modifier List > Object-Space Modifiers > Cloth > Simulation Parameters rollout

The Simulation Parameters rollout settings let you specify general properties of the simulation such as gravity, start and end frames, and sewing-spring options. These settings apply to the simulation on a global scale, that is, to all objects in the simulation.
**Interface**

![Simulation Parameters](image)

**cm/unit** Determines how many centimeters there are per 3ds Max system unit.

Cloth automatically sets cm/unit to the equivalent of 2.54 centimeters per inch (the default system unit in 3ds Max). For example, if you set the system unit to one foot, Cloth automatically sets cm/unit to 30.48 (12x2.54).

Size and scale are important when doing cloth simulation because a 10-foot curtain behaves much differently from a one-foot square handkerchief, even if they are made from the same fabric.

**Earth** Click this button to set the Gravity value to that of planet Earth.

**Gravity** When on, the Gravity value (see following) affects cloth objects in the simulation.
[Gravity value] The force of gravity in cm/sec\(^2\). A negative value applies gravitational force downward. A positive value (i.e., no sign) means gravity will act to move cloth objects upward. The default value is set to be the same as Earth's gravity: -980.0 cm/sec\(^2\).

**Step** The maximum size of the time step the simulator takes.
This value is measured in seconds. The value must be less than the length of one frame (less than 0.033333 for 30 fps animation). A value of 0.02 is generally the largest value you want to use. Reducing this value causes the simulator to take longer to calculate, but will in general give better results. The simulator will automatically reduce its time steps as needed, but this is the maximum value that it will try. This value works in conjunction with the Subsample parameter: The actual maximum value=Step value divided by Subsampl value.

**Subsample** The number of times per frame that 3ds Max samples the position of solid objects. Default=1.
At the default value, Cloth samples the solid objects in the simulation once every frame. Increasing this value should help when objects are moving or rotating quickly, but be aware that the higher you set the value, the slower the simulation will be.

**Start Frame** The frame at which the simulation starts. If you change this value after the simulation has been performed, the cache will be moved to this frame. Default=0.

**End Frame** When on, determines the frame at which the simulation will stop. Default=100.

**Self Collision** When on, detects cloth-to-cloth collisions. Leaving this off will speed up the simulator, but will allow cloth objects to interpenetrate.
The numeric setting specifies the extent to which Cloth tends to avoid self-colliding cloth objects, at the cost of simulation time. Range=0 to 10. Default=0.
This is a maximum limit. If Cloth needs fewer calculations to resolve all collisions, it will use fewer. In most cases, a value greater than 1 isn't necessary.

**Check Intersections** (Discontinued feature. This check box has no effect.)

**Solid Collision** When on, the simulator takes into account cloth-to-solid object collisions. This is almost always left on.

**Use Sewing Springs** When on, uses the sewing springs created with Garment Maker to pull the fabric together.
This works only with objects that have been made with Garment Maker on page 1266. Turn this option off once the garment has been pulled together.
When off, Cloth will identify vertices that are sewn together and will always keep them coincident. When on, there is always a chance for the vertices to come apart if the sewing springs are not strong enough (actually, there will always be some slight gap between the vertices in this case).

**Show Sewing Springs** Toggles the visual representation of the sewing springs in the viewports. These do not render.

**Sim on Render** When on, triggers the simulation at render time. Use this for generating a simulation with a network computer, which lets you continue to work on other aspects of your scene with your own computer. See a procedure [here](#) on page 1215.

After the render is completed, Cloth writes a cache for each cloth object. You can specify this cache file on the **Selected Object Rollout (Cloth)** on page 1235 (which is available only when a single object is selected). If you do not specify a name, 3ds Max creates one.

The numeric value indicates the priority of the simulation; the simulations are run in ascending order. For modifiers with the same priority, the order is undefined.

**NOTE** Each object has its own cache file, which is temporarily created when the MAX file is opened. On saving the file, the cache is incorporated into the MAX file. When Sim On Render is on, the cache file specified is created and written to, but is not read from as you change the time slider. The cache file must be [loaded into the internal cache file](#) on page 1237 before you can see it.

**Advanced Pinching** When on, Cloth tests for cloth pinched between two parts of the same collision object.

This option helps with cloth colliding with small features of the collision objects, such as fingers. There is a significant performance hit for high-resolution collision objects.

**Tension** Lets you visualize the compression/tension in the fabric by means of vertex coloring. Stretched cloth is indicated by red, compressed by blue, neutral by green. The numeric setting lets you change the range of tension/compression illustrated by a complete traversal from red to blue. The higher this value, the more gradual the shading. This works only for Garment Maker objects.

**Weld group**

Controls how cloth is smoothed across a tear that you set up, before the cloth has been torn.
The difference between these two options is primarily in whether they are compatible with a Point Cache modifier. See Point Cache Modifier (Object Space) on page 1574.

- **Verts**  When chosen, Cloth welds the vertices before tearing occurs. This creates a smooth mesh; however, its topology changes when the tear occurs, so when you choose this option you can’t use a Point Cache modifier with the Cloth animation.

- **Normals**  (The default.) When chosen, uses face normals to generate smoothing. The topology of the Cloth object does not change, so when this option is chosen, you can use a Point Cache modifier with the Cloth animation.

### Group Sub-Object Level (Cloth)

Select an object. > Modify panel > Modifier List > Object-Space Modifiers > Cloth > Modifier stack > Highlight the Group sub-object level

Groups let you select groups of vertices and constrain them to surfaces, collision objects, or other cloth objects.

At the Group sub-object level, all selected objects that are part of the Cloth simulation are shown with their vertices visible so that you can select them in an efficient fashion.

When you create or select a group at this sub-object level, the Group Parameters rollout on page 1252 becomes available.

**IMPORTANT**  The concept of a group for Cloth can be applied to both the cloth objects and to the collision objects in the simulation. And when created, groups can then be given unique properties. For example, a group on a collision object can have a different collision offset from the rest of the object. This is a powerful feature when working with groups.

**NOTE**  You can select groups of vertices explicitly, with the mouse in the viewports, and you can also specify a soft selection or use a texture map to select vertices using controls on the Group Parameters rollout. See Soft Selection group on page 1258. In addition, named selection set on page 217 tools are available at this level.
**Groups and Constraints**

The main reason for creating a group is to make it a *constraint*. A group becomes a constraint when you assign its vertices to behave in a particular way: for example, to follow another object or another piece of cloth. Until you make a group into a constraint, the group is described as *unassigned*.

You create and manage groups, and constrain them, using the controls on the Group rollout on page 1245. You can fine-tune the behavior of an individual group using the controls on the Group Parameters rollout on page 1252.

**Group Rollout (Cloth)**

Select an object. > Modify panel > Modifier List > Object-Space Modifiers > Cloth > Modifier stack > Highlight the Group sub-object level > Group rollout

The Group sub-object rollout is for selecting groups of vertices and constraining them to surfaces, collision objects, or other cloth objects.
Interface

[Group management buttons]

1246 | Chapter 9  Modifiers
Make Group Makes a group out of selected vertices. Select the vertices to include in the group, and then click this button. Name the group, and it will then show up in the list below for you assign to an object.

Delete Group Deletes the group highlighted in the list.

Detach Removes any constraint assigned to the group and sets it back to being unassigned (that is, without any constraint). Any unique properties assigned to this group will remain in effect.

Initialize Constraints that involve attaching the vertices to another object (Node, SimNode, Surface and Cloth constraints) contain information regarding the relative positions of the group vertices to the other object. This information is created upon the creation of the constraint. To regenerate this information, click this button.

Change Group Lets you modify the vertex selection in the group. To use, follow this procedure:
1. Choose the group in the list.
2. Change the selection of vertices.
3. Click Change Group.

Rename Renames the highlighted group.

[Constraint creation buttons]

Node Constrains the highlighted group to the transforms of an object or node in the scene. To use, click Node, and then select the node for constraining.
The node cannot be an object in the simulation; for that purpose, use the SimNode constraint on page 1248.

**NOTE** Node and SimNode simply constrain the group to an object's transforms, not to the object itself. They need not be near each other. When the cloth and the constraining object should be in close proximity, such as with clothing on a character mesh, use the Surface constraint instead (see following).

**Surface** Attaches the selected group to the surface of a collision object in the scene. To use, click Surface, and then select the node for attaching.

**TIP** This constraint is best suited for when the cloth and the constraining object should be in close proximity, such as with clothing on a character mesh.

**Cloth** Attaches the selected group of cloth vertices to another cloth object.

**Preserve** This group type preserves the motion from below the Cloth modifier in the modifier stack. For example, you might have a dress that you've skinned to a skeleton. You want the upper portion of the dress to be unaffected by the Cloth simulation (that is, to retain its deformation defined by the skinning), and the lower part to be simulated. In this case, you'd make a Preserve constraint from the upper vertices.

**Drag** This group type locks the vertices in place or adds a damping force to selected group. When Group Parameters rollout > Soft on page 1253 is off, you can use this constraint for “nailing” vertices in place so that they do not move at all. When Soft is on, the vertices will have a drag force applied where the amount of drag is controlled by the Strength and Damping values, also on the Group Properties rollout.

**SimNode** This option works the same as the Node option on page 1247, except that the node must be part of the Cloth simulation.

**Group** Attaches one group to another. This is recommended only for single-vertex groups. (that is, groups that contain only one vertex). With this, you can make one cloth vertex stick to another cloth vertex. Select one group, click this button to open the Pick Group dialog, and then choose another group.

**NoCollide** Causes collisions between the currently selected group and another group to be ignored. When you click this button, you're prompted to choose another group. You could use this option to prevent the simulator from processing collisions between cloth and the body under an arm or between the legs.
**Forcefield** Allows you to link a group to a space warp and have the space warp affect the vertices.

**Sticky Surf** The group sticks to a surface only after it has collided with that surface. **Solid Coll** on page 1254 must be enabled for this constraint to work.

**Sticky Cloth** The group sticks to a surface only after it has collided with that surface. **Self Coll** on page 1254 must be enabled for this constraint to work.

**Weld** Click to make an existing group into a Weld constraint. You must first highlight the name of the group in the Group list. Weld *does not* create a tear; it only welds vertices that are in close proximity. Use Weld if you create a tear by modeling two elements with matching edges and then applying the Cloth modifier later.

**Make Tear** Click to make a vertex selection into a tear with a Weld constraint. First, select the vertices, and then click Make Tear.

**Clear Tears** Click to remove all tears from the Cloth modifier. You cannot remove individual tears.

**NOTE** Deleting a Weld constraint does not remove a tear: instead, it causes the mesh to break along those vertices, because the Weld constraint holds vertices together until tearing occurs.

**[Group list]**

Shows all current groups. The number of vertices associated with the highlighted group is shown below the list. To assign, copy, paste, delete, or edit a created group, first highlight the group name in the list.
**Copy** Copies a named selection set to the copy buffer.

**Paste** Pastes the named selection set from copy buffer.

**Shrink** Click to shrink the current vertex selection. 3ds Max removes the outer row and column from the selection.

**Grow** Click to grow the current vertex selection. 3ds Max adds an outer row and column to the selection.

**Ring** Select two vertices, and then click Ring to select the vertices that are perpendicular to these two.

Ring also works with selections of more than two vertices, but the results might not be what you expect. This is especially likely if Ignore Backfacing is turned off, as it is by default.
**Ring selection based on two vertices**

**Loop** Select two vertices, and then click Loop to select the vertices that are parallel to these two.

Loop also works with selections of more than two vertices, but the results might not be what you expect. This is especially likely if Ignore Backfacing is turned off, as it is by default.

**Element** Select one or more vertices, then click Element to select all the vertices in an element. An element corresponds to an Element in the underlying geometry: use this option with Editable Poly, Editable Patch, or Editable Mesh objects.

**Get Stack Selection** Gets a sub-object selection from below the Cloth modifier on the stack, and applies it to the Group vertex selection. For example, if you...
create an Editable Poly object, make a vertex sub-object selection for the Editable Poly object, apply the Cloth modifier, and then at the Group level click Get Stack Selection, the vertex selection is identical to the one you made for the Editable Poly object.

If the underlying selection is of a different sub-object type, such as Edge or Poly, clicking Get Stack Selection creates a selection whose vertices correspond to vertices in the underlying selection: for example, all vertices that belong to the Edges or the Polys selected below.

---

**Ignore Backfacing** When on, you can select only vertices that face you in a viewport. When off (the default), you can select any vertices under the mouse cursor, regardless of whether they face you in the viewport.

---

**Group Parameters Rollout (Cloth)**

Select an object. > Modify panel > Modifier List > Object-Space Modifiers > Cloth > Modifier stack > Highlight the Group sub-object level > In a viewport, select vertices. > Group rollout > Click Make Group > Group Parameters rollout

Select an object. > Modify panel > Modifier List > Object-Space Modifiers > Cloth > Modifier stack > Highlight the Group sub-object level > Group rollout > In the Group list, highlight the name of an existing group. > Group Parameters rollout

The Group Parameters rollout appears after you use Make Group on a vertex selection to create at least one group. Thereafter, highlight the group in the Group rollout list to display and edit the group's settings with the Group Parameters rollout.

**Interface**

**Constraint Parameters group**

If the currently highlighted group is unassigned (that is, not a constraint), then controls in this group are not available.
On When on, enables the constraint specified for the current group in the group list on the Group rollout, using remaining settings in this group box.

Soft Sets the constraint type to soft. A soft constraint uses springs between vertices. When off, the constraint is hard or rigid. The constraint types Node, Surface, Preserve, Drag, and SimNode can be hard or soft. Cloth, Group, and Forcefield constraints are always soft.

ID Uses a Material ID to attach the group to an object. This option applies only to Surface and Cloth constraints. If, when the constraint is created or initialized, the cloth vertices are not over a triangle, then the constraint will be created to the center of the nearest triangle that has the requisite Material ID. This could mean that several vertices might be constrained to the center of the same triangle. In this case, you should only use soft constraints. A hard constraint would pull all those cloth vertices to the same exact point on the triangle, which would look strange.

Offset The variance in the distance between a constrained group and its constraining, or target, object. The default value is 1.0 with Rel on (see following). This sets the constrained group to maintain its original distance from the target object. When set to 0.0, the constraint seeks to set the distance to the target object to zero.
  ■ rel Specifies the offset as a ratio of the original value. Available only with the Surface and Cloth constraint types. For example, if you want to move a constrained vertex by half its original distance, turn on the Rel. check box and set Offset to 0.5. Default=on.

Strength The stiffness of the springs used if the constraint is soft.
  ■ vc Sets vertex colors to determine the strength of the constraint. Default=off.

Damping The damping of the springs if the constraint is soft.
1-to-1 (The default.) When the mesh density is changed in Garment Maker, the group selection is reassigned. The 1-to-1 option selects the vertex closest to the original vertex.

Blob When the mesh density is changed in Garment Maker, the group selection is reassigned. The Blob option selects the original vertex and the ones created within a certain radius of it. The radius can be left at default or auto, or it can be set manually.

- **Radius**  When on, lets you set the radial distance used by the Blob option. When off, Blob uses an automatic radial value. Default=off; default value = 2.0.

**Behavior Settings group**

**Behavior Settings** Toggles the availability of the other settings in this group. When off, the other settings have no effect.

**Solid Coll** When on, the group vertices are used in solid-collision detection.

**Self Coll** When on, the group vertices are used in self-collision detection.

**Layer** Indicates the correct "order" of cloth pieces that might come in contact with each other. Range=–100 to 100. Default=0.

If your garments and/or panels are all correctly orientated to begin with, then cloth-to-cloth collision detection should keep items from interpenetrating. However, the initial state of a garment/panel might have some interpenetration that cannot be resolved. For example, suppose you make a jacket with Garment Maker where the front right panel is supposed to sit on top of the front left
panel. When you sew together the garment (generally with self-collision off), the front panels will interpenetrate, so to make sure that the right panel sits outside the left panel, you might have to use constraints or Live Drag. Using the Layers option on the panels can help here.

Here is the logic of layers: When two pieces of cloth (A and B) are in collision-detection range, their layers (layerA and layerB) are compared and the following rules are applied:

- If either layerA or LayerB is 0, then Cloth uses the regular cloth-to-cloth collision method.
- If layerA=layerB, then Cloth uses the regular cloth-to-cloth collision method.
- If abs(layerA) > abs(layerB) then piece A is pushed to the appropriate side of piece B. Which side? If layerB > 0, then to the side indicated by the face normals. If layerB<0 then to the opposite side.

The sign of the Layer value indicates what the "outside" of that piece of cloth is. A positive sign means "The side that the normals face is the outside".

Keep Shape When on, preserves the shape of the mesh based on the Bend % and Stretch % settings. In normal operation, when Cloth creates a simulation, it tries to "flatten out" the cloth. Default=off.

- Bend % Modulates the target bend angles to a value between 0.0 and the angles defined by the target state on page 1221. A negative value inverts the angles. Range=–100.0 to 100.0. Default=100.0.
- Stretch % Modulates the target stretch angles to a value between 0.0 and the angles defined by the target state on page 1221. A negative value inverts the angles. Range=0.0 to 100.0. Default=100.0.

Presets group

Sets the Cloth Properties parameters to the preset selected in the drop-down list. Any presets that are built into the system or that have been loaded will show up here.
**Load** Loads presets from the hard drive. Click this button and then navigate to the directory with your presets to load them into your Cloth Properties. Presets have the file name extension `.sti`.

**Save** Saves your Cloth Properties parameters to a file that you can then load at a later time.
**[Group properties]**

*Use These Properties* Turn on to set the cloth properties for the individual group, using the controls on this rollout. Default=off.
Get From Object  Click to sets the cloth properties of the group to be the same as the object to which the group belongs.

The remaining Properties controls are the same as those found in the Cloth Properties group on page 1225 of the Object Properties dialog for Cloth.

**Soft Selection group**

![Soft Selection controls](image)

The Soft Selection controls apply on a per-group basis to permit soft selection of vertices neighboring the explicitly selected group members. This works the same as soft selection of vertices in other parts of 3ds Max. For details, see *Soft Selection Rollout* on page 2014. Alternatively, you can select vertices for a group based on a texture map.

![Use Texture Map](image)

**Use Texture Map**  When on, Cloth uses a texture map to specify a soft selection of vertices that belong to the current group. Click the button (by default,
labeled “None”) to choose a texture map. Use the Mapping Channel controls to choose a map channel or vertex color channel. You can add a grayscale texture map in this slot to blend between unselected and fully selected pixels in the group. Black represents unselected and white represents fully selected. Any grayscale value blends between the two. You can drag a texture map onto this button.

NOTE For a texture map to apply to a group, at least one vertex must be explicitly selected. However, when Use Texture Map is on, the group’s explicit vertex selection has no effect.

Panel Sub-Object Level (Cloth)

Select an object. > Modify panel > Modifier List > Object-Space Modifiers > Cloth > Modifier stack > Highlight the Panel sub-object level

At the Panel sub-object level, you can select one panel (cloth section) at a time and change its cloth properties.

A panel, which must be created by the Garment Maker modifier on page 1266, is a closed spline that is not enclosed by another spline. If a closed spline is enclosed by another spline, it forms a hole in the outer spline.

NOTE To be able to select a panel at this sub-object level, you must first use Object Properties on page 1222 to specify that the object is cloth. Also, to be able to change settings on this rollout, first turn on Object Properties > Use Panel Properties on page 1225.
Interface
**Presets group**

**Presets** Sets the selected panel's properties parameters to the preset selected in the drop-down list. Any presets that are built into the system or that have been previously saved and loaded will show up here. Presets have the file name extension `.sti`.

**Load** Load presets from a specified location on your hard drive. Click this button and navigate to the directory with your presets to load them into your Cloth Properties.

**Save** Save your Cloth Properties parameters to a file to be loaded at a later time. By default, Cloth preset files are saved to the `cloth` folder inside 3ds Max install directory.
These Properties controls are the same as those found in the Cloth Properties group on page 1225 of the Object Properties dialog for Cloth.
**Keep Shape group**

![Keep Shape](image)

**Keep Shape** When on, preserves the shape of the mesh based on the Bend % and Stretch % settings (see following). In a normal operation, when Cloth creates a simulation, it tries to "flatten out" the cloth.

**Bend %** Modulates the target bend angles to a value between 0.0 and the angles defined by the target state on page 1221. A negative value inverts the angles. Range=-100.0 to 100.0. Default=100.0.

**Stretch %** Modulates the target stretch angles to a value between 0.0 and the angles defined by the target state on page 1221. A negative value inverts the angles. Range=-100.0 to 100.0. Default=100.0.

**Layer** Sets the layer for the selected panel. See Behavior Settings group on page 1254.

**Seams Sub-Object Level (Cloth)**

Select an object. > Modify panel > Modifier List > Object-Space Modifiers > Cloth > Modifier stack > Highlight the Seams sub-object level

The Seams sub-object rollout is used to define seam properties.
Interface

**On** Turn the seam on or off to make it active or inactive.

**Crease angle** Creates a crease at your seam. The angle value will determine the angle of the crease that will be between the two panels. (Can be positive or negative depending on which way you want to crease)

Left: High crease angle

Right: Low crease angle

**Crease Strength** Increase or decrease the strength of your seam. This value will effect how much the seam will resist bending in relation to the rest of the cloth object. A value of 2.0 means that the cloth will have twice the resistance to bending that it would otherwise have (as defined by the object/panel/vertex group properties).
Sewing Stiffness  The amount of force with which the panels will be pulled together at simulation time. A larger value will pull the panels together harder and faster.

Tearable When on, sets the selected seam to be tearable. Default=off.

- Tear Threshold  Sets a threshold value for tearing the seam. This value is equivalent to the Strength value of a Weld constraint at the Group sub-object level on page 1244. Default=10.0.

Enable All  Sets all seams on selected garment to be active.

Disable All  Sets all seams on selected garment to be off. This button deactivates the On check box for all seams.

Faces Sub-Object Level (Cloth)

Select an object. > Modify panel > Modifier List > Object-Space Modifiers > Cloth > Modifier stack > Highlight the Faces sub-object level

The Faces sub-object rollout enables interactive dragging of cloth objects while they are simulated locally. This sub-object level is useful for positioning cloth within your scenes in a more interactive way.

NOTE  If you position your cloth incorrectly, you can restore the original position by returning to the Object level and clicking the Reset State button.

Interface
Simulate Local  Starts local simulation of the cloth. In order for the real-time interactive feedback with the cloth to occur, this button must be on.

Live Drag!  When active you can drag selected faces as the local simulation is taking place.

Live Rotate!  When active, you can rotate selected faces as the local simulation is taking place.

Sim on mouse down  Runs the local simulation only when the left mouse button is clicked. This mode is usually preferred since you can start and stop the local simulation simply by releasing the mouse button. As a result, it makes it far easier to position and rotate the faces of your cloth within your scene.

Ignore Backfacing  When on, you can select only faces facing you. When off (the default), you can select any faces under the mouse cursor, regardless of visibility or facing.

**Garment Maker Modifier**

Select a shape object (spline or NURBS curve). > Modify panel > Modifier List > Object-Space Modifiers > Garment Maker

Garment Maker is a modifier that is designed to put together 2D patterns that you can then use with Cloth on page 1204. With Garment Maker you can take a simple, flat, spline-based pattern and convert it to a mesh, arrange its panels, and create seams to sew the panels together. You can also specify internal seam lines on page 1274 for creases and cuts.

See also:

- Troubleshooting and Error Codes in Garment Maker on page 1298
- Cloth and Garment Maker Modifiers on page 1187
- Cloth and Garment Overview on page 1189
- Cloth Modifier on page 1204

**Basic Concepts**

**Splines**

When you start working with Garment Maker, you begin either by importing or drawing traditional 2D splines in the 3ds Max Top viewport. To use a spline
with Garment Maker and eventually Cloth, it must be a closed shape. This does not mean that you cannot have splines inside of splines, but if you have multiple spline shapes inside of one another, the inner splines are treated as "holes" in the fabric, as shown below.

Two closed splines - one with a nested spline inside

Resulting geometry after applying Garment Maker
TIP For best results, when applying Garment Maker to multiple splines, first combine the splines into a single object.

Also, to keep your patterns precise, no rounding of boundary edges and corners, you must break the splines at the corner vertices. This is also important because it directly impacts the segments of the splines that are to be used to create seams between the individual panels. To understand this better, take a look at the following example.

In the image below are two rectangular splines to which a user might want to apply Garment Maker. After applying Garment Maker, the idea is to then create a seam between the two panels along the inner edge. First, it should be noted that both splines are closed shapes and have been attached so they are part of the same editable spline object.

When Garment Maker is assigned, look what happens:
Garment Maker seems to have "chopped" corners of the rectangular splines off, altering the pattern. Beyond that, if the user tried to select the edges of the panels that make up the seam, they will not be able to. This is because Garment Maker currently has only a single spline to work with for each panel.

To keep the pattern clean, do the following:

1. Access the Vertex sub-object level of the editable spline.
2. Select the vertices where seams are to be created.
3. Click Break to create unique segments that Garment Maker can use to create a seam.

Shown below are the results when all of the vertices are selected and then broken.
All vertices in both panels selected and then "broken"

Garment Maker applied to “broken” splines

The corners are now preserved. When the user goes to select the edges between the panels to act as seams, they will be selected independently of the other panel edges and highlight in red. This is what you want in order to create seams.
Garment Panels

Garment Maker’s Panels sub-object level lets you arrange the panels of the pattern around the character. You can then create seams where the panels should connect and be “sewn” together. This lets you create the seams you need while seeing how the clothing will look around your character. Creating seams like this is in many cases far superior to making them in a flat layout because it allows you to visualize what is being done.
Pattern Creation

To make patterns you can use the basic 2D spline tools in 3ds Max. Cloth comes with several patterns, but after you learn to use them, you will most likely want to start making your own. Patterns can take advantage of many features that real sewing patterns have, such as darts and multi-segment seams. To learn about other pattern making software, see Pattern-Making Software on page 1203.

Tricky Assemblies

As you begin to move beyond the basic patterns for your garments, there are a number of rules that you should follow in order to work effectively with Cloth:

- Always create your pattern splines in the Top viewport. Garment Maker assumes that the pattern is laid out this way.
- When seaming garments with MultiSegment edges, you must take care of the order in which the seams are made.
NOTE A MultiSegment comprises two or more individual segments acting as a single segment; you create it with Garment Maker.

When creating a seam you cannot use:

- A MultiSegment that has multiple gaps in it, unless all but one of those gaps are bridged by another seam.
- A segment or MultiSegment that forms a closed loop (that is, a path directly, or via seams, completely encloses the MultiSegment).

Both these issues arise in the common sleeve assembly shown below. The sleeve needs to be sewn to the armhole. When assembled, both the sleeve and the armhole form closed loops. The sleeve forms a loop via the seam along its underside. The armhole is closed by two seams: one across the shoulder and one down the side.

Now, since you cannot seam closed loops together, it therefore follows that both the armhole and sleeve must be left open when creating the seam connecting them. So the order is as follows:

1 Because the sleeve is one segment and the armhole is two segments, you must make a MultiSegment out of those two segments first.

2 When dealing with MultiSegment seams, the order of creation is important. If you attempt to create seams in the wrong order, you might get a “Seamline topology is wrong” error, and the seams will not be created. When dealing with MultiSegment seams, create the minimum number of seams necessary to make the MultiSegment seam match the topology of the other piece to that you are going to connect.

In this case, you have an arm seam that is open at the bottom, and a MultiSegment that is open at both the top and the bottom. If you closed the side of the garment, you'd end up with the situation illustrated in the center image below, where the seam is twisted (it cannot be "untwisted" by reversing the seam). By closing the top of the armhole MultiSegment with a seam at the shoulder, you'll create proper topology to make the MultiSegment seam.

3 Next, you can seam up the sleeve to the armhole. See the leftmost image below.

4 Finally, you can add the seam down the side of the garment and across the underside of the sleeve (the order is irrelevant here).
Left: Seam created for shoulder first and then for the MultiSegment, producing the desired result.

Middle: Seam created at the bottom of the body MultiSegment first, resulting in an irreversible MultiSegment seam from the arm to the body.

Right: No seams made on the body to connect its MultiSegment, resulting in a seam topology error.

Internal Seam Lines

When drawing panels, you can use extra open splines to define seam lines within the panels, also known as internal seam lines. Triangulation always occurs along these internal seam lines, so you can use them to help define the structure of the cloth panel, and as crease lines on page 1296. Also, you can specify that an internal seam line should be cut on page 1290, so that the cloth separates along the line during the simulation.

To create an internal seam line, simply specify a Material ID of 2 for the internal spline, which should not be closed. Also, for best results, keep its endpoints away from other splines in the shape. And, as with outside seam lines, an internal spline should not cross over itself or other splines.
Left: Open spline, set to Material ID 2, specifies internal seam line.  
Center: At Garment Maker > Curves or Seams sub-object level, seam line is selected 
and Cut is turned on.  
Right: Cloth separates along cut line during simulation.

Procedures

To place garment panels automatically:

The Garment Maker modifier provides tools for positioning garment panels 
on a humanoid character model. This automatic placement is approximate; 
further adjustment is typically necessary.

1. Load or create your character model.
2. Create your panels as splines or NURBS curves parallel to the world XY 
   plane (that is, create them in the Top viewport).

Shirt panels, as seen in the Top viewport
When applying Garment Maker to multiple splines, for best results, first combine the splines into a single object. You can still manipulate the separate pieces within the Garment Maker modifier at the Panels sub-object level.

3 Apply the Garment Maker modifier. Set parameters as necessary.

4 On the Main Parameters rollout, click the None button, and then click the character model. The object’s name appears on the button.

5 Below this button, click the Mark Points On Figure button. A character outline appears in the corner of each viewport. Superimposed on the outline are seven asterisk-shaped points; the one at the center-top of the chest is highlighted in red.
The character outline lets you mark points for positioning panels.

6 Click the corresponding point on the front of your model.
As you move the mouse cursor over the surface of the model, a red circle shows where the marker will be placed. When you click, an axis tripod appears on the surface at that location, and the next point on the character outline, at the center of the pelvic region, is highlighted in red.
7 Continue to click at each location on your model that corresponds to the highlighted marker on the character outline until you’ve designated all seven points.

All seven points are marked on the character model.

To finish, right-click in the viewport.

8 Go to the Panels sub-object level and select a panel.
The front shirt panel is selected.

9 At the bottom of the Panels rollout, choose a Level, and then in the Panel Position group, click the button corresponding to the desired position for the panel.

The panel moves to the designated position.
Adjust as necessary. For example, in the above illustration, Level should probably be set to Top At Neck. To correct this, you would choose Top At Neck, and then click Panel Position > Front Center again.
Of course, you can also move the panel manually; in fact, in most cases it will probably be necessary to do so. Panel Position serves primarily as a starting point for placing panels.

11 Continue selecting panels and placing them, adjusting as necessary.

All panels placed with Panel Position. Note that sleeve panels need to be rotated 90 degrees, and cuff panels need to be rotated and moved to the wrists.

**Main Parameters Rollout (Garment Maker)**

Select a shape object (spline or NURBS curve). > Modify panel > Modifier List > Object-Space Modifiers > Garment Maker > Main Parameters rollout

The Main Parameters rollout is the first rollout you see on the Modify panel once you apply the Garment Maker modifier.

This rollout comprises mostly controls to create and adjust the mesh. The remaining rollouts are available at the sub-object levels.
Interface

**Density** Adjusts the relative density of the mesh (in other words, the number of triangles per unit area). Possible values range between 0.01 and 10.0. A value of 10.0 creates a very dense mesh, while 0.01 creates a comparatively low-resolution mesh.

For best results, use the lowest possible density to achieve the desired result. This speeds up simulation time and overall performance.
Auto mesh When on, Garment Maker updates the mesh automatically if you change the density or add/remove seams. This setting is active at all sub-object levels, so it's recommended you leave it on to see changes as you make them. The only time you might want to turn off Auto Mesh is while creating the seams at the Curves sub-object level. Re-meshing can take some time, so you might want to define a number of seams before re-meshing.

Preserve When on along with Auto mesh, Garment Maker preserves the 3D shape of the object. When off, if you change the Density value, the panels are flat.

Relax When on, relaxes the default mesh to produce a smoother result. Default=off. (The default mesh is a standard Delaunay triangulation.)

Mesh It! Applies a change in the Density value. If Auto mesh is off when you change the Density value, you must click the Mesh It! button to apply the change.

TIP Sometimes in an error condition Mesh It! will no longer respond. If this happens, go to the spline level in the modifier stack, and then return to the Garment Maker level.

Mesh It and Preserve Applies a Density change and also preserves the 3D shape of the object. This lets you change the density of the cloth or the

---

Cloth and Garment Maker Modifiers | 1283
The following setting, comprising three radio buttons, determines how the cloth panels are passed up the modifier stack to the Cloth modifier:

- **Arranged Panels** With this option, the mesh passed up the stack will be have the panels arranged/bent around the figure as they were placed by the user in panels sub-object mode.

- **Preserved Surface** When both Auto mesh and Preserve are on, or when you click Mesh It And Preserve, Garment Maker takes a snapshot of the mesh at the top of the stack (where Cloth is applied). This snapshot is passed up the stack when you choose Preserved Surface. This way, if you change the Density value, the mesh will retain its deformation. Once a snapshot has been taken, at the Panel sub-object level, the panels will have the Use Preserved check box on. This means you can move the panels around while maintaining their deformation. Also note that once a snapshot has been taken, Garment Maker automatically chooses the Preserved Surface option.

- **Flat Panels** Displays all the panels as flat surfaces. This mode defines the texture coordinates of the garment vertices. With this output mode active, you can adjust texture coordinates at the Panel sub-object level by moving and rotating the panels.

**Stretch Map Coords** When on, the UV coordinates are based on the square bounding rectangle whose edge is the longer edge of the actual bounding box, and so have an aspect ratio of 1:1. When off, the UV coordinates do not maintain a 1:1 aspect ratio but use the actual bounding box.
Figure group

Use these controls to specify locations for each panel on the figure to be clothed.

[counter] Click this button, labeled “None” by default, and then click the object, or figure, to which the clothing is to be applied. Typically this is a character model. Thereafter, the name of the object appears on the button.

Mark Points on Figure After specifying a figure using the “None” button (see preceding), use this control to specify locations on the figure for automatically positioning panels in the garment.

When you click Mark Points On Figure, this character outline appears in the corner of each Viewport:
The character outline lets you mark points for positioning panels.

As each point highlights in red, click the corresponding location on your figure. When you do so, an axis tripod appears on the object surface and the next point on the outline highlights. During this process you can manipulate the viewport as usual, zooming, panning, and rotating freely. You can continue clicking points as long as you like; to stop, right-click in the viewport, or turn the button off.

**NOTE** If you return to marking points later, 3ds Max starts again where you left off earlier.

The points highlight in this order:

1. Upper Chest
2. Pelvis
3. Neck
4. Right shoulder
5. Left shoulder
6. Right hand
7. Left hand
After setting the points, you can use the Panel Position on page 1293 and Level on page 1294 controls at the Panels sub-object level to place the panels automatically.

**Curves Sub-Object Level (Garment Maker)**

Select a shape object (spline or NURBS curve). > Modify panel > Modifier List > Object-Space Modifiers > Garment Maker > Curves sub-object level > Curves rollout

Use the Curves sub-object level to stitch your pattern panels together.

You can also connect seams in the Seams sub-object mode with a more three-dimensional representation of the panels. The Curves sub-object level provides a flat layout to work in that can be useful for more complex patterns.

You can create and delete seams and adjust the way your pattern fits together.

**Interface**

![Curves sub-object level interface](image)
Create Seam Creates a seam between two segments. Select two segments of the panels you would like to sew together, and click Create Seam. This will make a seam between these two panels that will be sewn together at simulation time. Seams get a randomly-generated color to distinguish them from the panels.

Top: Segments selected  
Bottom: Seam made between two panels

Delete Seam Deletes selected seam. (Selected seam is colored red).

Reverse Seam Reverses or flips a twisted seam.  
When creating seams, the first vertex on each segment is used to line up the resulting seam panel. Sometimes you can end up with a twisted seam and will need to use Reverse Seam to untwist it.
A twisted seam that needs to be reversed

Make MultiSegment A MultiSegment is a combination of two or more segments that will be treated as one segment for the purpose of creating seams. Select the segments you want to combine then click this button. Note that if the segments are not contiguous, the gaps must be bridged by seams before this MultiSegment can be used in a seam.

Break MultiSegment Break apart selected MultiSegments.

On Turns the selected seam on or off, making it active or inactive.

Crease angle Creates a crease at the selected seam. The angle value determines the target angle of the crease between the two panels or along an internal seam line on page 1274.

Left: High crease angle
Right: Low crease angle

Crease Strength Increase or decrease the strength of the selected seam. This value affects how much the seam will resist bending in relation to the rest of the cloth.
the cloth object. A value of 2.0 means that the cloth will have twice the resistance to bending that it would otherwise have (as defined by the object/panel/vertex group properties).

**Sewing Stiffness** The amount of force with which the panels are pulled together at simulation time. A larger value pulls the panels together harder and faster.

**Cut** Applies only to an internal seam line on page 1274. Makes a cut in the fabric at this seam line.

**Tearable** When on, sets the selected seam to be tearable. Default=off.

**Tear Threshold** Sets a threshold value for tearing the seam. This value is equivalent to the Strength value of a Weld constraint at the Group sub-object level on page 1244. Default=10.0.

**Seam Tolerance** The amount of difference in length between two edges that is permitted in the formation of a seam. The two segments that comprise a seam should be about the same length. If they have different lengths, the difference must be within this tolerance range. If you seam together two segments that are significantly different in length, the cloth will tend to bunch up (which could be a desired effect). In order to allow the creation of such a seam, the Seam Tolerance will need to be increased. The default value is 0.06, which means that the two segment lengths must be within 6 percent of each other's lengths.

**Draw Seams** Shows the seams in the viewport; hides them when off.

**Show Mesh** Shows the mesh in the viewport, or hides it to work on your pattern. When this option is off, the mesh is represented with a bounding box.

### Panels Sub-Object Level (Garment Maker)

Select a shape object (spline or NURBS curve). > Modify panel > Modifier List > Object-Space Modifiers > Garment Maker > Panels sub-object level > Panels rollout

The Panels sub-object level of the Garment Maker modifier lets you position and bend the panels of your pattern to fit your object or figure.

You can also use these controls to adjust the texture mapping of your garment.
Density Controls the mesh density of a selected panel. This value is applied as a multiplier of the Main Parameters rollout > Density setting on page 1282. You can increase the density of a particular panel by raising this value.

If Main Parameters rollout > Auto Mesh is off when you change this value, go back to the Main Parameters rollout (Cloth level in modifier stack) and click Mesh It! on page 1283 to update the mesh. For this reason, it is recommended that you leave Auto Mesh on. The only time you might want to turn off Auto Mesh is while creating the seams at the Curves sub-object level. Re-meshing can take some time, so you might want to define a number of seams before re-meshing.

Different Density settings applied to separate panels

Mat ID Set the material ID for the selected panel. Using this option enables you to assign different materials to select portions of the clothing.

Position group

Reset Resets the position of the selected panels to their original locations (that is, the locations immediately after Garment Maker was applied).

Reset All Resets the position of all panels to their original locations.

Deformation group

Most controls in this group are available only when one or more panels are selected.

Reset Removes the deformation of the selected panels (restoring the flat state).
Reset All Removes the deformation from all panels.

Use Preserved Turn this on to override the None or Curved deformation options. When on, the panel gets its shape from the preserved mesh instead of the deformation options.

None Makes this panel flat.

Curved Use the value in the Curvature field to bend the panel.

Curvature Sets the amount of curve or bend of a panel. The higher this value is, the more the panel will curve.

X-axis Sets the axis for the curvature to the panel's local X axis.

Y-axis Sets the axis for the curvature to the panel's local Y axis.

Panel Position group

These buttons move the selected panel to a specified position. These positions are determined by 3ds Max based on the positions you set with the Mark Points On Figure on page 1285 controls at the Garment Maker object level. The positions are:

- Front Center
- Front Right
- Front Left
- Back Center
- Back Right
- Back Left
- Right Side
- Left Side
- Right Arm
- Left Arm

NOTE The terms Front, Back, Right, and Left refer to the character's orientation.
**Level group**

Sets where the top of the panel should go. Garment Maker derives these locations from the locations you specify with the Mark Points On Figure on page 1285 controls. The choices are:

- Top at neck
- Top at shoulder
- Top at underarm
- Top at waist

If you change the setting here, it affects the subsequent Panel Position results.

**Adjusting Texture Coordinates**

When Garment Maker is in Flat Panels mode (that is, the Main Parameters rollout > Flat Panels option on page 1284 is chosen), the texture coordinates are defined by the positions of the panels. Imagine the panels are being cut out of a large piece of fabric. The location and orientation of a panel in that large piece of fabric determine how the texture is aligned on it. By moving and rotating a panel, you can change its texture coordinates. Remember, you must be in Flat Panels mode to do this.

**Seams Sub-Object Level (Garment Maker)**

Select a shape object (spline or NURBS curve). > Modify panel > Modifier List > Object-Space Modifiers > Garment Maker > Seams sub-object level > Seams rollout

At the Seams sub-object level, you can define and edit seams and their properties.

Seams behave the same as curves, but at this level the mesh is displayed three-dimensionally instead of in a flat layout. Also, at this level the mesh is always updated when you add or remove a seam.
Create Seam Creates a seam between two segments. Select two segments of the panels you would like to sew together and then click Create Seam. This creates a seam between the two panels that will be sewn together at simulation time.
Right: Seam created between the two segments

**Delete Seam** Deletes selected seam. (Selected seam is colored red).

**Reverse Seam** Reverses or flips a seam that has been made with a twist in it. When creating seams, the first vertex on each segment is used to line up the resulting seam panel. Sometimes you can end up with a twisted seam and will need to use Reverse Seam to untwist it.

![A twisted seam that needs to be reversed](image)

**Make MultiSegment** A MultiSegment is a combination of two or more segments that will be treated as one segment for the purpose of creating seams. Select the segments you want to combine then click this button. Note that if the segments are not contiguous, the gaps must be bridged by seams before this MultiSegment can be used in a seam.

**Break MultiSegment** Break apart selected MultiSegments.

**On** Turns the selected seam on or off, making it active or inactive.

**Crease angle** Creates a crease at the selected seam. The angle value determines the target angle of the crease between the two panels or along an internal seam line on page 1274.
Crease Strength Specifies the strength of the selected seam. This value affects the extent to which the seam resists bending in relation to the rest of the cloth object. A value of 2.0 means that the cloth will have twice the resistance to bending that it would otherwise have (as defined by the object/panel/vertex group properties).

Sewing Stiffness The amount of force with which the panels are pulled together at simulation time. A larger value will pull the panels together harder and faster.

Cut This applies only to an internal seam line on page 1274. Makes a cut in the fabric at this seam line.

Tearable When on, sets the selected seam to be tearable. Default=off.

Tear Threshold Sets a threshold value for tearing the seam. This value is equivalent to the Strength value of a Weld constraint at the Group sub-object level on page 1244. Default=10.0.

Seam Tolerance The amount of difference in length between two edges that is permitted in the formation of a seam. The two segments that comprise a seam should be about the same length. If they have different lengths, the difference must be within this tolerance range. If you seam together two segments that are significantly different in length, the cloth will tend to bunch up (which may be a desired effect). In order to allow the creation of such a seam, the Seam Tolerance will need to be increased. The default is 0.06, which means that the two segment lengths must be within 6%.

Remove All Deletes all seams.
Draw Seams  Shows the seams in the viewport; hides them when turned off.

Show Mesh  Show the mesh in the viewport, or hide it to work on your pattern. When this option is off, the mesh is represented with a bounding box.

Troubleshooting and Error Codes in Garment Maker

When you are working with Garment Maker, you may encounter errors if your splines are set up incorrectly. This topic lists the common error messages you might see, and how to correct the problems they report.

Cannot remesh: the number of panels has changed:  This error occurs when the user has modified the original pattern, and added new closed splines to it. The only way to correct this is to delete the original Garment Maker modifier and reapply a new one.

Number of boundary curves has changed:  Users will get this error if they add or remove splines from the pattern after the initial application of Garment Maker. To correct it, delete the original Garment Maker modifier and reapply a new one.

Boundary splines do not form a closed loop:  In this case, the splines that the user has tried to apply Garment Maker to don't form closed loops. Often, this is caused by an extra vertex and segment attached to one of the splines, and usually this segment is so small you cannot see it. It can be difficult to find the offending part. To remedy this situation, select all the vertices, weld them, then re-break them at the corners.

Splines form overlapping loops:  When a user gets this error, it means that some panel loops overlap others (in the XY plane of the local view). If you create the shape in the Top view this should not happen (provided you don't create overlapping loops). Most commonly, this occurs when the user create the splines in a viewport other than Top and on a plane other than the XY plane.

Unable to create seam:  This error happens in when trying to create a seam in two cases:

- One (or more) of the segments/MultiSegments in the attempted seam forms a closed loop (for example, if you make a MultiSegment from the armhole segments, that MultiSegment forms a closed loop if you create seams at the shoulder and below the armhole). You will have to delete one of the seams so that the MultiSegment is no longer closed. For an armhole, you generally keep the seam below the armhole open when you join it.
with the sleeve. You can then close the seam. For the same reason, the sleeve cannot be seamed at the underside before joining to the armhole.

- A MultiSegment in the attempted seam contains segments that are not contiguous and that are not linked by any seam.

**Seam line topology is wrong:** This error usually occurs when you try to make a closed loop into a seam. The loop might be natural, or it might be the result of seams created earlier.

For example, when creating a shirt, if you first create the sleeve seam along the length of the sleeve, and then attempt to sew the sleeve to the armhole, this message appears. This is because a loop has been created in the spline that defines the top of the sleeve. The solution in this example is to create the seams in the correct order:

1. Shoulder-front to shoulder-back
2. Sleeve to armhole
3. Side-front to side-back
4. Along the length of the sleeve

See *Tricky Assemblies* on page 1272 for more information.

**CrossSection Modifier**

Select a spline object with spline cross sections. > Modify panel > Modifier List > CrossSection

Make a selection. > Modifiers menu > Patch/Spline Editing > CrossSection

The CrossSection modifier creates a "skin" across multiple splines. It works by connecting the vertices of 3D splines to form a skin. The resulting object is another spline object that can be used with the Surface modifier on page 1763 to create a patch surface. These two modifiers, when used together, are sometimes referred to collectively as “Surface Tools.”
CrossSection uses splines to create a model of a boat.

CrossSection can build a skin across various-shaped splines with different vertex counts and open/closed status. The more different the splines in vertex count and complexity, the more likely the skin will have discontinuity.

**NOTE** Similar functionality is provided by the Editable Spline object on page 620. At the Editable Spline > Segment and Spline sub-object levels, you can create a spline cage using Connect Copy and Cross Section. Using this method, you need to region-select the created vertices to transform them. Also, this method lets you define the ordering of the spline more easily than does the CrossSection modifier.

**Procedures**

**Example: To explore the CrossSection modifier:**

1. On the Create panel, click Shapes, then click Circle.
2. Drag in the Top viewport to create a circle about 100 units in radius.
3 On the Modify panel, choose Edit Spline from the Modifier List.

4 In the modifier stack display, turn on Spline sub-object, then select the circle.

5 In the Front viewport, Shift+Move the spline up to copy it.

6 Shift+Move the copy up to create a third circle.

**NOTE** The order that you attach or clone splines is important: this is the order that CrossSection uses to create the skin.

7 On the Modify panel, choose CrossSection from the Modifier List. CrossSection joins the vertices of the three circles. A basic spline cylinder is displayed.

8 On the Modify panel, on the Modifiers List, choose Surface to add the Surface modifier. The spline cylinder is transformed into a patch surface by the Surface modifier.

9 To edit the model's surface, change the splines using controls in the Edit Spline modifier. Or, since the output of the Surface modifier is a patch surface, add an Edit Patch modifier and use patch edit controls to change the surface.
An Edit Patch modifier above the Surface modifier was used to create the image.

Example: Using the CrossSection modifier to skin several splines with different shapes:

1. On the Create panel, click Shapes.
2. On the Object Type rollout, turn on Start New Shape, then click NGon.
3. In the Top viewport, create two five-sided circular NGons.
4. On the Create panel, with Shapes still active, click Line.
   Create two lines, each with four vertices. Create the vertices left-to-right.
On the main toolbar, click Select And Move, then move the objects in the viewport to order them along the Z axis with the NGons at the bottom and the lines above the NGons.

Select the bottom NGon.

On the Modify panel, choose Edit Spline from the Modifier List.

In the Geometry rollout, click Attach.

Select the remaining NGon and lines in an ascending order, as numbered in the image.
NOTE  The order of selection is important. The CrossSection modifier uses
the selection order to define the skin.

Example continued: Lining up the vertices:

1  On the Modify panel, choose the Vertex sub-object level in the
   stack display.
   Lining up the first vertex of each spline is important to prevent the surface
   from twisting.

2  Use Ctrl+click to select the rightmost vertex of each line and the
   bottommost vertex of each NGon.

3  On the Geometry rollout, click Make First.

Aligning the first vertex is important. This is where the seam forks, going
from a closed to an open spline.

Example continued: Using CrossSection and Surface to "skin" the shapes:

1  On the Modify panel, choose CrossSection from the Modifier List.
   The CrossSection modifier connects the splines at the vertices.

2  On the Modifiers List, choose Surface.
   The Surface modifier generates a patch surface based on the splines.

3  In the modifier stack display, choose the CrossSection modifier.
4 On the CrossSection Parameters rollout, toggle between Linear and Smooth. Notice how the splines change.

5 On the Modify panel, toggle the Show End Result On/Off Toggle button to display the final patch surface. The toggle won’t remain on if the CrossSection modifier is current. Drop down to the Editable Patch in the stack and turn on the Show End Result toggle if you like.

**TIP** When you use CrossSection, draw splines in a consistent direction. A twisted surface results when lines are created from vertices that are not lined up.

**Interface**

| Linear/Smooth/Bezier/Bezier Corner | Determines what type of curve will be used through the spline vertices. |

**Delete Mesh Modifier**

Modify panel > Make a sub-object selection. > Modifier List > Delete Mesh

Modify panel > Make a sub-object selection. > Modifiers menu > Mesh Editing > Delete Mesh

Delete Mesh provides parametric deletion based on the current sub-object selection level in the stack. The possible choices are faces, vertices, edges, and objects. Apply the Delete Mesh modifier to delete the geometry specified at that sub-object level.
Delete Mesh used to remove the faces where the handle joins the cup.

For example, you can apply a Mesh Select modifier on page 1500, select a row of faces in a cylinder, and then apply a Delete Mesh modifier to delete those faces. To undo the deletion, you can simply remove the Delete Mesh modifier.

**TIP** Try applying a Delete Mesh modifier following an animated Vol. Select modifier on page 1992.

### Procedures

**Example: To delete a row of faces in a cylinder:**

1. Create a cylinder on page 403.
2. Apply a Mesh Select modifier and select a row of faces in the cylinder.
3. Apply the Delete Mesh modifier to delete those faces.

   To undo the deletion, remove the Delete Mesh modifier.

### Interface

This modifier has no parameters.
Delete Patch Modifier

Modify panel > Make a patch selection. > Modifier List > Delete Patch
Make a selection. > Modifiers menu > Patch/Spline Editing > Delete
Delete Patch provides parametric deletion based on the current sub-object
level in the stack. The possible choices are vertices, edges, patches, and
elements. Apply the Delete Patch modifier to delete the geometry specified at
that sub-object level.

For example, you can apply a Patch Select modifier, select a row of patches in
a patch sphere, and then apply a Delete Patch modifier to delete those patches.
To undo the deletion, remove the Delete Patch modifier.

Delete Patch used to remove sections of a patch sphere.

Procedures

Example: To delete a patch in a sphere:
1. Create a sphere.
2 Right-click the sphere, and choose Convert To > Convert To Editable Patch on the quad menu.

3 On the Modify panel, in Editable Patch, choose the Patch sub-object level, and select a patch.

4 In the Modifier List, choose the Delete Patch modifier. This deletes the selected patch.
To undo the deletion, remove the Delete Patch modifier.

**Interface**

There are no parameters for this modifier.

**Delete Spline Modifier**

Modify panel > Select a spline sub-object. > Modifier List > Delete Spline
Modify panel > Select a spline sub-object. > Modifiers menu > Patch/Spline Editing > Delete Spline

The Delete Spline modifier provides parametric deletion of spline geometry based on the current sub-object selection level in the stack. The possible selection levels include vertices, segments, and splines. Apply the Delete Spline modifier to delete the geometry specified at that sub-object level.
Delete Spline used to remove a segment in the middle of a spline.

Procedures

To use the delete spline modifier:

1. Create a shape that contains multiple splines.
2. Apply a Spline Select modifier on page 1741 and select a section of the spline for deletion.
3. Apply a Delete Spline modifier to delete the section.

To undo the deletion, remove the Delete Spline modifier.

Interface

This modifier has no parameters.
Disp Approx Modifier

Modify panel > Make a selection. > Modifier List > Object-Space Modifiers > Disp Approx

Make a selection. > Modifiers menu > Surface Deformers > Disp Approx

Make a selection. > Modifiers menu > NURBS Editing > Disp Approx

The Disp Approx modifier (short for Displacement Approximation) lets you make the displacement mapping settings on an object in the modifier stack on page 8187. It converts its input object to an editable mesh on page 2192, so you can use this modifier to add displacement mapping to geometry primitives on page 388 and any other kind of object that can convert to an editable mesh.

Using an image to displace the surface of a cylinder
Displacement mapping on page 6059 uses a map to change surface geometry. You apply the map using the Material Editor on page 5641.

You don’t need to apply this modifier to NURBS on page 2416 surfaces, patches on page 2408, editable meshes on page 2192, or editable polymeshes on page 2240, because you can apply displacement mapping directly to these kinds of objects.

Procedures

To apply displacement mapping:

1. Select an object other than a NURBS surface, patch, editable mesh, or editable poly.
2. Apply the Disp Approx modifier.
   Now you can apply displacement mapping to the object. The Displacement Approx. rollout has parameter that you can adjust, but displacement mapping will work using the default settings.
3. Go to the Material Editor. Apply a Standard material to the object.
4. In the material’s Maps rollout, click the Displacement button, then use the Material/Map Browser to apply a displacement map.
Interface

Subdivision Displacement Subdivides mesh faces to accurately displace the map, using the method and settings you specify in the Subdivision Presets and Subdivision Method group boxes. When turned off, the modifier applies the map by moving vertices in the mesh, the way the Displace modifier on page 1313 does. Default=on.

Split Mesh Affects the seams of displaced mesh objects; also affects texture mapping. When on, the mesh is split into individual faces before displacing them; this helps preserve texture mapping. When off, texture mapping is assigned using an internal method. Default=on.
TIP  This parameter is required because of an architectural limitation in the way
displacement mapping works. Turning Split Mesh on is usually the better technique,
but it can cause problems for objects with clearly distinct faces, such as boxes, or
even spheres. A box’s sides might separate as they displace outward, leaving gaps.
And a sphere might split along its longitudinal edge (found in the rear for spheres
created in the Top view) unless you turn off Split Mesh. However, texture mapping
works unpredictably when Split Mesh is off, so you might need to add a Displace
Mesh modifier on page 1068 and make a snapshot on page 950 of the mesh. You
would then apply a UVW Map modifier on page 1932 and then reassign mapping
coordinates to the displaced snapshot mesh.

Subdivision Presets and Subdivision Method group boxes

The controls in these two group boxes specify how the modifier applies the
displacement map when Custom Settings and Subdivision Displacement are
both turned on. They are identical to the Surface Approximation controls on
page 2737 used for NURBS surfaces.

Displace Modifier

Modify panel > Make a selection. > Modifier List > Object-Space Modifiers >
Displace

Make a selection. > Modifiers menu > Parametric Deformers > Displace

The Displace modifier acts as a force field to push and reshape an object’s
geometry. You can apply its variable force directly from the modifier gizmo,
or from a bitmapped image.
Displace used to change the surface in the container

There are two basic ways to use the Displace modifier:

- Apply displacement effects directly by setting Strength and Decay values.
- Apply the grayscale component of a bitmapped image to generate the displacement. Lighter colors in the 2D image push outward more strongly than darker colors, resulting in a 3D displacement of the geometry.

The Displace space warp on page 2930 has similar features. It’s useful for applying effects to a large number of objects or a particle system.

**Force Distribution**

Displace distributes its force through four different gizmos: Planar, Cylindrical, Spherical, and Shrink Wrap. Gizmos are also used as mapping coordinates for applying bitmaps. Sphere and Shrink Wrap have the same effect when modeling, but differ in the way they map.

The Spherical and Shrink Wrap gizmos begin with a uniform field around them. The Cylinder and Planar gizmos are both directional. Cylinder pushes at right angles to its axis, and Planar pushes at right angles to its surface.
By default, gizmos are centered on the object. However, you can transform any of these shapes and use it directly as a tool to deform the geometry of an object.

**Modeling Options**

Displace is a versatile modifier with many possible applications. Here are some options:

- Produce interior modeling effects by scaling down the gizmo and moving it inside the object. The outward force shapes the geometry from within.
- Animate the modeling process. One result is a roving, magnetic-like field that pushes and pulls on a surface.
- Add additional Displace modifiers to an object, using each one to create a different modeling effect.
- Collapse a finished model into a plain mesh. This reduces the object's complexity and removes all modifiers, but keeps the modeled surface intact.

**Procedures**

**To displace an object:**

1. Select an object and apply the Displace modifier.
2. In the Parameters rollout > Map group, select one of the four gizmo types.
3. In the Displacement group, set values for Strength and Decay. Vary these settings to see the effect of the displacement on the object.

Depending on the object and the complexity of the bitmap, you might need to use dense geometry to see the effect clearly. Try a test run and, if necessary, add tessellation in the areas of greatest detail.

**To apply a bitmap as a displacement map:**

1. In the Parameters rollout > Image group, click the Bitmap button (which is labeled "None" until a map has been chosen). Use the file dialog to choose a bitmap.
2. Adjust the Strength value. Vary the strength of the field to see the effect of the bitmap displacing the object's geometry.
After you get the image you want from bitmapped displacement, you can apply an **Optimize modifier** on page 1557 to reduce the complexity of the geometry while retaining the detail.

**To model with the displace modifier:**

1. Apply Displace to the object you want to model. Choose a gizmo from the Map group.
2. Increase the Strength setting until you begin to see a change in the object.
3. Scale, rotate, and move the gizmo to concentrate the effect. As you do this, adjust the Strength and Decay settings to fine-tune the effect.

**Interface**

**Displacement group**

![Displacement group interface](image)

**Strength** When set to 0.0, Displace has no effect. Values greater than 0.0 displace object geometry or particles away from the position of the gizmo. Values less than 0.0 displace geometry toward the gizmo. Default=0.0.

**Decay** Varies the displacement strength with distance.

By default, Displace has the same strength throughout world space. Increasing Decay causes the displacement strength to diminish as distance increases from the position of the Displace gizmo. This has the effect of concentrating the force field near the gizmo, similar to the field around a magnet repelling its opposite charge. Default=0.0.

**Luminance Center** Determines which level of gray Displace uses as the zero displacement value.

By default, Displace centers the luminance by using medium (50 percent) gray as the zero displacement value. Gray values greater than 128 displace in the outward direction (away from the Displace gizmo) and gray values less than 128 displace in the inward direction (toward the Displace gizmo). Use the
Center spinner to adjust the default. With a Planar projection, the displaced geometry is repositioned above or below the Planar gizmo. Default=0.5. Range=0 to 1.0.

**Image group**

![Image group](image)

Lets you choose a [bitmap](#) on page 8523 and [map](#) on page 8631 to use for displacement. Both are assigned and removed in the same way.

**Bitmap button** Assigns a bitmap or map from a selection dialog. After you make a valid choice, these buttons display the name of the bitmap or map. This button is labeled "None" until you choose a map.

**Remove Bitmap/Map** Removes the bitmap or map assignment.

**Blur** Increase this value to blur or soften the effect of the bitmapped displacement.
Map group

Contains mapping parameters for bitmapped displacement. See UVW Map modifier on page 1932.

The four mapping modes control how Displace projects its displacement. The type of Displace gizmo and its location in the scene determine the final effect.
Displace gizmos: Planar, Cylindrical, Spherical, and Shrink Wrap

**Planar** Projects the map from a single plane.

**Cylindrical** Projects the map as if it were wrapped around the cylinder. Turn on Cap to project a copy of the map from the ends of the cylinder.

**Spherical** Projects the map from a sphere, with singularities at the top and bottom of the sphere where the bitmap edges meet at the sphere's poles.

**Shrink Wrap** Projects the map from a sphere, as Spherical does, but truncates the corners of the map and joins them all at a single pole, creating only one singularity at the bottom.

**Length, Width, Height** Specifies the dimensions of the Displace gizmo's bounding box. Height has no effect on Planar mapping.

**U/V/W Tile** Sets the number of times the bitmap repeats along the specified dimension. The default value of 1.0 maps the bitmap exactly once; a value of 2.0 maps the bitmap twice, and so on. Fractional values map a fractional portion of the bitmap in addition to copies of the whole map. For example, a value of 2.5 maps the bitmap two and a half times.

**Flip** Reverses the orientation of the map along the corresponding U, V, or W axis.

**Use Existing Mapping** Has Displace use mapping set earlier in the stack. This has no effect if the object is not mapped.
Apply Mapping Applies the Displace UV mapping to the bound object. This lets you apply material maps to the object using the same mapping coordinates as the modifier.

Channel group

Specifies whether to apply the displacement projection to a mapping channel or a vertex color channel, and which channel to use. For more information on these channels, see UVW Map modifier on page 1932.

Map Channel Choose this to specify a UVW channel to use for the mapping, and use the spinner to its right to set the channel number.

Vertex Color Channel Choose this to use the vertex color channel for the mapping.

Alignment group

Contains controls for adjusting the mapping gizmo's size, position, and orientation.

X, Y, Z Flips the alignment of the mapping gizmo along its three axes.

Fit Scales the gizmo to fit the object's bounding box.

Center Centers the gizmo relative to the object's center.

Bitmap Fit Displays a Select Bitmap dialog. The gizmo is scaled to fit the aspect ratio of the bitmap you select.

Normal Align Turns on Pick mode to let you select a surface. The gizmo is aligned to the normal of that surface.

View Align Orients the gizmo in the same direction as the view.
Region Fit  Turns on Pick mode to let you drag two points. The gizmo is scaled to fit the specified area.

Reset  Returns the gizmo to its defaults.

Acquire  Turns on Pick mode to let you choose another object and acquire its Displace gizmo settings.

Edit Mesh Modifier

Create or select an object > Modify panel > Modifier List > Object–Space Modifiers > Edit Mesh

Create or select an object > Modifiers menu > Mesh Editing > Edit Mesh

The Edit Mesh modifier provides explicit editing tools for different sub-object levels of the selected object: vertex, edge, and face/polygon/element. The Edit Mesh modifier matches all the capabilities of the base Editable Mesh object, except that you cannot animate sub-objects in Edit Mesh. See Editable Mesh on page 2192 for a complete parameter reference.

When possible, it’s far more efficient and reliable to perform explicit modeling at the Editable Mesh level rather than store those edits within the Edit Mesh modifier. The Edit Mesh modifier must copy the geometry passed to it, and this storage can lead to large file sizes. The Edit Mesh modifier also establishes a topological dependency that can be adversely affected if earlier operations change the topology being sent to it.

There are, however, situations where using the Edit Mesh modifier is the preferred method.

- You want to edit a parametric object as a mesh, but want to retain the ability to modify its creation parameters after the edit.

- You want to store your edits temporarily within Edit Mesh until you are satisfied with the results, before collapsing them permanently to an editable mesh object.

- You need to make edits across several objects at once, but do not want to convert them to a single editable mesh object.

- You have a modifier in the stack that must remain parametric, and the mesh must be edited after the modifier is applied.
NOTE Collapsing an object that has an Edit Mesh modifier applied to it results in an Editable Mesh object.

Edit Normals Modifier

Select a mesh, patch, spline or NURBS object. > Modify panel > Modifier List > Edit Normals
Select a mesh, patch, spline, or NURBS object. > Modifiers menu > Mesh Editing > Edit Normals

The Edit Normals modifier gives you explicit and procedural, interactive control over each of an object's vertex normals on page 8654. It is meant to be used primarily with mesh objects destined for output to game engines and other 3D rendering engines that support specified normals. The results are visible in the viewports and in rendered images.

The orientation of a vertex normal affects how neighboring surfaces reflect light. By default, normals are set so that reflection of light in 3ds Max follows the rules of real-world physics: The angle of reflection equals the angle of incidence. But by reorienting vertex normals, you can set the angle of reflection to be anything you want. The Edit Normals modifier lets you specify vertex normals' directions, combine and separate them, change the type, and copy and paste values among normals.

WARNING Don't apply an Edit Normals modifier to the low-res object used in normal bump projection on page 6856. Normal bump projection relies on the low-res object having standard normals, and altering them causes normal bump maps to have unpredictable results.

Types of Normals

Three types of normals are available with the Edit Normals modifier:

- **Unspecified**: These are the normals that the modifier derives from smoothing groups and initially assigns to the modified mesh vertices. 3ds Max calculates the direction of an unspecified normal based on the average facing of all polygons to which it belongs that are in its smoothing group. By default, each vertex has as many normals as the number of unique smoothing groups used by surrounding polygons. For example, each side of a box uses a different smoothing group by default, so each vertex at which three sides meet (typically a corner) has three different normals: one perpendicular to each of the three sides. On the other hand, a sphere
uses a single smoothing group, so each of its vertices has one normal, perpendicular to the average facing of the polygons that share it. By default, unspecified normals are displayed as blue.

- **Specified:** These are normals that are intended for use by particular corners of particular faces, without regard to smoothing groups. For instance, you might create a box, apply Edit Normals, select a group of normals at a particular vertex, and click Unify. Now those three faces are told specifically to use that one unified normal, and they ignore their smoothing groups at that vertex. But specified normals are not set to explicit values; they ignore smoothing groups, but they're still based on the face normals of the faces that use them. Specified normals are displayed as cyan.

- **Explicit:** These are normals that are set to particular values. For instance, if you use the Move or Rotate command to change a normal from its default value, it has to be made explicit, so it won't be recomputed based on the face normals. Explicit normals are green by default.

**NOTE** Explicit normals are also considered to be specified.

**NOTE** A selected normal is always red. When not selected, its color indicates as type, as noted above. You can find the customizable color entries on page 8272 for these normal types in the Elements > Geometry list. The three entry names are:
- Normals - Explicit
- Normals - Specified
- Normals - Unspecified

**Usage Examples**

Following are two instances in which a 3D artist creating content for output to a game engine might find practical use for the Edit Normals modifier:

- An artist is working on a knight with a chrome shield. The chrome shield has a DirectX cube map shader on page 8716 on it so that the artist can see the reflections in the viewport. The artist would like to make the reflections in the shield look "dented" by fights in battle. The artist applies the Edit Normals modifier to the shield object. He then adjusts several of the normals slightly, viewing the results in real time, thanks to the pixel shader. He then exports the character with a custom export tool designed to handle normal information.
A game artist is working on an object that will explode in the game. To do this, the game engine requires the object to be split into multiple objects: the broken pieces that will result from the explosion. When the object is broken apart in 3ds Max (using Slice), the normals are pointing in different directions; this makes it easy to see the seams between the broken pieces. To fix this, the artist selects all the pieces of the breaking object and applies the Edit Normal modifier to all of them at once. She then selects the normals across the seam and unifies them so they are pointing in the same direction. The artist then exports to the game engine.

**Usage Notes**

Please observe the following notes and precautions when using the Edit Normals modifier:

- Edit Normals supports both poly objects (polygon-based) and mesh objects (triangle-based). If you apply Edit Normals to a poly object, the result is a poly object. If you apply Edit normals to any other object type, the result is a mesh object.

- Edit Normals also supports embedding of edited-normal data when collapsing the stack, and when converting from poly object to mesh object, but not when converting from a mesh object to any other object type. If you apply Edit Normals to a primitive object, adjust the normals, and then collapse the stack (or convert to Editable Mesh), 3ds Max embeds any changes to the normals in the mesh object, including selection status. Primitive objects are mesh-based, so if you convert the same object to Editable Poly, the edited normals are lost. On the other hand, if you convert a primitive object to Editable Poly, apply Edit Normals, adjust the normals, and then collapse the stack, resulting in a poly object, the normals are retained. You can subsequently regain access to embedded, edited normals in a collapsed object by applying another Edit Normals modifier.

- Any modifiers that change topology will remove changes applied to the normals with the Edit Normals modifier. These include MeshSmooth, Tessellate, Slice, Mirror, Symmetry, Face Extrude, and Vertex Weld. Oddly enough, it also means that the Normal modifier (used to flip face orientations) will not support the edited normals. Since Turn To Poly can be used to modify face topology, it also strips off the edited normals.

- All compound objects strip off the edited normals from their operands.

- The good news: All deformation and map modifiers preserve the normals. For instance, if you apply a Bend, the normals should be bent along with
the geometry. Map modifiers, such as Unwrap UVW, won't affect the normals at all.

■ However, a few geometric modifiers do not fully support the new normals. They won't strip them away, but neither will they correctly deform any explicit normals. Modifiers in this category include Push and Relax.

■ The Smooth modifier correctly modifies any non-specified normals, while leaving the specified and explicit normals alone.

■ Like Mesh Select and Poly Select, Edit Normals “inherits” attributes from below it in the stack. For example, if you create a box, apply an Edit Normals modifier, change some normals, and then apply a second Edit Normals modifier, the top Edit Normals “inherit” the user-specified normals from the pipeline, just as Mesh Select adopts the current selection when you apply it. But the top Edit Normals modifier ignores any subsequent changes to the original Edit Normals modifier, just as Mesh Select ignores any changes made to the selection below it in the stack after it is applied.
The Edit Normals modifier is useful mainly at the sub-object level, Normal, so this level is active by default as soon as you apply the modifier to an object. At this point, you can see the normals as lines emanating from the mesh vertices, select and transform them, copy and paste them, and change their settings on the Modify panel.

You can transform normals only by moving and rotating them, not by scaling them. However, moving a normal effectively rotates it, so in most cases you’ll have better control by using the Rotate tool.

The following command reference includes keyboard shortcuts, which are available when the Keyboard Shortcut Override Toggle on page 8420 (on the toolbar) is on. In addition, you can use Ctrl+0 (zero) to access the object level of the modifier.
Select By group Lets you specify how to select normals in the viewport:

- **Normal (Ctrl+1):** Click a normal to select it.
- **Vertex (Ctrl+2):** Click a mesh vertex to select all of its normals.
- **Edge (Ctrl+3):** Click a mesh edge to select the normals associated with the neighboring polygons.
- **Face (Ctrl+4):** Click a mesh face (or polygon) to select the associated normals.

Of course, with all of these methods, you can also use region selection to select multiple normals at once.

**Ignore Backfacing** When on, selection of sub-objects affects only those facing you. When off (the default), you can select any sub-object(s) under the mouse cursor, regardless of their visibility or facing. If there are more than one sub-object under the cursor, repeated clicking cycles through them. Likewise, with Ignore Backfacing off, region selection includes all sub-objects, regardless of the direction they face.

**Show Handles** Enables the display of handles, which are small squares at the end of each normal. Turn this on to make it easier to select normals.

**Display Length** Specifies the length of each normal. This is for display purposes only; the length has no effect on the normal's functionality.

**Unify (U)** Combines all selected normals at each vertex into a single specified normal on page 1322. By default, with Unify/Break To Average off, Unify sets the direction for each unified normal to be perpendicular to the averaged surface at that point. With Unify/Break To Average on, Unify sets the direction be the average of the combined normals at each location.

**Break (B)** Separates all selected, unified normals into their original components. With Unify/Break To Average off, Break orients each separated normal perpendicular to its respective face, thus splaying out the normals at each vertex if the connected faces are at different angles (as with a sphere). With Unify/Break To Average on, each separated normal uses the orientation of the original normal.

Break converts any selected normals to specified normals.

**Unify/Break to Average** Determines normal orientation as the result of a Unify or Break operation. See the descriptions above for details. Default=off.
Average group

These controls give you different methods of averaging vertex normals; that is, setting them all to the same absolute angle, which is the average of their combined angles.

**Selected** Sets selected normals to the same absolute angle: the average angle of all of them. If Use Threshold is on, averages only normals whose distance from each other is less than that specified in the Average Threshold spinner (to the button’s right).

**Use Threshold** Activates the Average Threshold setting, and causes the Selected to average only normals whose distance from each other is less than the specified value.

**Target** Enters an interactive mode in which you specify pairs of normals to average. Click Target, and then select a normal. When the mouse cursor is over a normal, it changes to a + cursor. After clicking the first normal, a rubber-band dashed line connects the normal to the mouse cursor. Click a second normal to average the angles of the two normals.

The pixels spinner to the right of the Target button sets the maximum distance in screen pixels between the mouse cursor and the target normal.

---

**Copy Value** (Ctrl+C) Copies the selected normal’s orientation to the copy buffer. Available only when a single normal is selected.

Use Copy Value and Paste Value to apply a normal’s orientation to one or more others within the same Edit Normals modifier. You cannot copy normals between modifiers.

**Paste Value** (Ctrl+V) Applies the paste buffer contents to the current selection. Available only after Copy Value has been used to place a normal’s orientation in the copy, and one or more target normals are selected.

**Specify** (S) Converts selected normals to specified normals on page 1323.

**Reset** (R) Causes all selected normals to revert to unspecified on page 1322 status, and returns them to their initial, calculated positions. Also breaks apart unified normals.

**Make Explicit** (E) Converts selected normals to explicit normals on page 1323.

[Selection Display] When one normal is selected, shows its ID number. When 0 or more than one normal is selected, shows the number of normals selected.
**Edit Patch Modifier**

Create or select an object > Modify panel > Modifier List > Object-Space Modifiers > Edit Patch

Create or select an object > Modifiers menu > Patch/Spline Editing > Edit Patch

The Edit Patch modifier provides editing tools for different sub-object levels of the selected object: vertex, handle, edge, patch, and element. The Edit Patch modifier matches all the capabilities of the base Editable Patch object, except that you cannot animate sub-objects in Edit Patch. See Editable Patch on page 2360 for a parameter reference.

Other than the inability to animate sub-objects with Edit Patch, the main difference between Edit Patch and Editable Patch is that the modifier incorporates the ability of the Surface modifier to generate a patch object from a spline cage. For details, see Spline Surface on page 1330.

When possible, it's far more efficient and reliable to perform explicit editing on an Editable Patch object rather than store those edits within the Edit Patch modifier. The Edit Patch modifier must copy the geometry passed to it, and this storage can lead to large file sizes. The Edit Patch modifier also establishes a topological dependency that can be adversely effected if earlier operations change the topology being sent to it.

There are, however, situations where using the Edit Patch modifier is the preferred method.

- You want to edit a parametric object as a patch, but want to retain the ability to modify its creation parameters after the edit.
- You want to store your edits temporarily within Edit Patch until you are satisfied with the results, before committing them permanently to an editable patch.
- You want to streamline your workflow with the Spline Surface tools, which are unique to Edit Patch.
- You need to make edits across several patch objects at once, but do not want to convert them to a single editable patch object.
- You have a modifier in the stack that must stay parametric, and the resulting patch must be edited after the modifier is applied.
Procedures

To create a patch object using the Cross Section and Spline Surface tools:

This procedure describes how to simplify the workflow of building objects using a spline cage to which a patch surface is applied, a method described in the Surface modifier on page 1763 topic as “Surface Tools.”

1. Create a spline object.
   Make sure that the spline vertices form valid three-sided or four-sided polygons. Vertices on splines that cross one another should be coincident.
   To make spline vertices coincident, drag vertices over each other with 3D Snap turned on. 3D Snap must have the Vertex or End Point option turned on. With 3D Snap turned on, you can snap to vertices on existing splines as you create new splines. You can also select vertices and use the Fuse option in an Editable Spline to make vertices coincident.

2. Convert the spline object to an Editable Spline, if necessary, or apply an Edit Spline modifier.

3. Use the Cross Section command on page 633 in Edit/Editable Spline to add splines connecting different splines in the spline object, thus creating a spline cage.
   This replaces the previous workflow of using the CrossSection modifier.

4. Apply the Edit Patch modifier to the spline object.
   By default, in Edit Patch the Geometry rollout > Spline Surface group > Generate Surface option is on, causing the modifier to create patches over all valid three- and four-sided polygons in the spline cage.
   This replaces the previous workflow of using the Surface modifier.

5. Adjust the Spline Surface settings and edit the object as necessary. If you modify the spline object, for best results, edit at the Vertex sub-object level, and be sure to select all vertices at an intersection before moving them.
Interface

Spline Surface group

The Geometry rollout > Spline Surface group is found only in the Edit Patch modifier; it's not available in the Editable Patch object. The group becomes available when the object to which the Edit Patch modifier is applied consists of splines. Its controls replicate the functionality of the Surface modifier on page 1763.

For best results, apply the Spline Surface controls after creating a spline cage with the CrossSection modifier on page 1299 or the Editable Spline Cross Section command on page 633. The latter approach approximates the Surface Tools workflow (described in the Surface Modifier topic), but with a simpler modifier stack; instead of additional CrossSection and Surface modifiers, the stack need contain only an Editable Spline object and an Edit Patch modifier. Alternatively, you can use the Edit Spline modifier's Cross Section command.

Generate Surface Creates a patch surface using existing splines to define the patch edges. Default=on.

Threshold Determines the overall distance that is used to weld the vertices of the spline object. All vertices/vectors within the threshold distance of each other are treated as one. Threshold uses units set in the Units Setup dialog on page 8366. Default=1.0.

NOTE Spline control handles are also treated as vertices, so setting high Threshold levels can produce unexpected results.

Flip Normals Reverses the facing direction of the patch surface. Default=off.

Remove Interior Patches Removes interior faces of an object that you would not normally see. These are the faces created within the caps or other interior patches of the same type of a closed polygon. Default=on.
**Use Only Selected Segs** Only segments selected in the Edit Spline modifier or the editable spline object will be used by the Surface modifier to create patches. Default=off.

**NOTE** Segment Sub-Object does not have to be left on in the Edit Spline modifier or editable spline object.

---

**Edit Poly Modifier**

Create or select an object. > Modify panel > Modifier List > Object-Space Modifiers > Edit Poly

Create or select an object. > Modifiers menu > Mesh Editing > Edit Poly

Create or select an object. > **modeling ribbon** on page 2025 > Polygon Modeling panel > Apply Edit Poly Mod

The Edit Poly modifier provides explicit editing tools for different sub-object levels of the selected object: vertex, edge, border, polygon, and element. The Edit Poly modifier includes most capabilities of the base Editable Poly object, except for Vertex Color information, Subdivision Surface rollout, Weight and Crease settings, and Subdivision Displacement rollout. Edit Poly lets you animate sub-object transforms and parameter changes. In addition, because it's a modifier, you can retain the object creation parameters and change them later. For detailed information about animating with Edit Poly, see these procedures on page 1340.

Edit Poly gives you these options:

- Transform or Shift+Clone the selection, as with any object.
- Use the options supplied on the Edit rollouts to modify the selection or object. Later topics discuss these options for each of the polymesh components.
- Pass a sub-object selection to a modifier higher in the stack. You can apply one or more standard modifiers to the selection.

**TIP** You can exit most Edit Poly command modes, such as Extrude, by right-clicking in the active viewport.
Overriding Actions with Press/Release Keyboard Shortcuts

While working with poly objects, you can use a “press/release keyboard shortcut” to temporarily override the current operation and perform a different one. As soon as you release the keyboard shortcut, you return to the previous operation.

For example, you might be working at the Polygon sub-object level, moving polygons, and need to rotate the object to access a different part of it. Instead of having to exit the Polygon sub-object level, rotate the object and then re-enter the sub-object level, you could simply press and hold 6, rotate the object, release the key, and immediately return to moving polygons.

To see a list of press/release keyboard shortcuts, go to Customize > Customize User Interface > Keyboard panel, open the Group drop-down list, and choose Edit Poly or Editable Poly. The actions in boldface are the ones that you can assign as press/release shortcuts. Not all are assigned; for information about assigning keyboard shortcuts, see Keyboard Panel on page 8250.

Differences Between Edit Poly and Editable Poly

Functionality in Edit Poly is mostly the same as that of Editable Poly. Please note the following differences:

- Edit Poly is a modifier, with all properties that modifier status entails. These include the ability to place Edit Poly above a base object and other modifiers
on the stack, to move the modifier to different locations in the stack, and to apply multiple Edit Poly modifiers to the same object, each containing different modeling or animation operations.

- Edit Poly has two distinct modes of operation: Model and Animate. See Edit Poly Mode rollout on page 1342.

- Delete Isolated Vertices is now an option on the Edit Geometry rollout. Previously, it appeared as a dialog every time you deleted contiguous polygons. Now you can set it and forget it.

- Edit Poly eliminates the Full Interactivity switch; this feature is on all the time.

- Edit Poly provides two new ways of obtaining an existing selection from lower in the stack: Use Stack Selection on page 1350 and Get Stack Selection on page 1355.

- In addition to the Settings dialogs from Editable Poly, Edit Poly gives you an Align Geometry dialog on page 1422, available from the Settings button on the Edit Poly Mode rollout on page 1342.

- Edit Poly lacks Editable Poly's Subdivision Surface and Subdivision Displacement rollouts. There are no Weight or Crease settings for vertices, edges, or borders. If you need to use Weight and Crease settings with Edit Poly, apply a Meshsmooth modifier on page 1505, set Iterations to 0, and then make the settings as desired. Also, there is no provision for setting vertex properties such as color.

- In Animate mode, you begin a slice operation by clicking Slice, not Slice Plane. You still need to click Slice Plane to move the plane around. You can animate the slice plane.

- In some cases, several Undo commands on page 240 might be required to revert from changes made with certain Edit Poly operations, such as Extrude.

  For example, if you extrude a polygon using the Extrude Polygons dialog on page 2349, there will be three Undo actions. The first undoes the Commit, which happens automatically when you click the dialog OK button at the end; the second undoes the change in height (from 0 to the height you set); and the third undoes the entry into the Extrude operation.

Following is a table showing the Edit Poly functions that are and are not animatable. Functions that are not animatable are unavailable in Animate mode. Functions marked “Yes” can be animated explicitly in Animate mode.
Functions marked “Proc” cannot be animated explicitly, but can be animated procedurally. This means they can be applied to different parts of the Edit Poly object at different points in the animation by means of an animated sub-object selection passed up the stack. For further information, see this procedure on page 1341.

<table>
<thead>
<tr>
<th>Function</th>
<th>Animatable?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transform sub-objects</td>
<td>Yes</td>
</tr>
<tr>
<td>Shift+Transform sub-objects</td>
<td>Yes</td>
</tr>
<tr>
<td>Constraints</td>
<td>No</td>
</tr>
<tr>
<td>Preserve UVs</td>
<td>No</td>
</tr>
<tr>
<td>By Vertex</td>
<td>No</td>
</tr>
<tr>
<td>Ignore Backfacing</td>
<td>No</td>
</tr>
<tr>
<td>Ring</td>
<td>No</td>
</tr>
<tr>
<td>Loop</td>
<td>No</td>
</tr>
<tr>
<td>Shrink</td>
<td>No</td>
</tr>
<tr>
<td>Grow</td>
<td>No</td>
</tr>
<tr>
<td>Selection conversion</td>
<td>No</td>
</tr>
<tr>
<td>Named Selection copy/paste</td>
<td>No</td>
</tr>
<tr>
<td>Soft Selection (most settings)</td>
<td>Yes (but not painting soft selection)</td>
</tr>
<tr>
<td>Shaded Face toggle</td>
<td>No</td>
</tr>
<tr>
<td>Delete</td>
<td>Proc</td>
</tr>
<tr>
<td>Function</td>
<td>Animatable?</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Create Vertex</td>
<td>No</td>
</tr>
<tr>
<td>Create Face</td>
<td>No</td>
</tr>
<tr>
<td>Create Edge</td>
<td>No</td>
</tr>
<tr>
<td>Collapse</td>
<td>Proc</td>
</tr>
<tr>
<td>Attach / Attach List</td>
<td>No</td>
</tr>
<tr>
<td>Detach</td>
<td>No</td>
</tr>
<tr>
<td>Slice</td>
<td>Yes</td>
</tr>
<tr>
<td>Quickslice</td>
<td>No</td>
</tr>
<tr>
<td>Cut</td>
<td>No</td>
</tr>
<tr>
<td>MSMOOTH</td>
<td>Proc</td>
</tr>
<tr>
<td>Tessellate</td>
<td>Proc</td>
</tr>
<tr>
<td>Make Planar</td>
<td>Proc</td>
</tr>
<tr>
<td>View Align</td>
<td>Yes</td>
</tr>
<tr>
<td>Grid Align</td>
<td>Yes</td>
</tr>
<tr>
<td>Relax</td>
<td>Yes</td>
</tr>
<tr>
<td>Hide Selected</td>
<td>No</td>
</tr>
<tr>
<td>Hide Unselected</td>
<td>No</td>
</tr>
<tr>
<td>Unhide All</td>
<td>No</td>
</tr>
<tr>
<td>Function</td>
<td>Animatable</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>Remove</td>
<td>Proc</td>
</tr>
<tr>
<td>Break</td>
<td>Proc</td>
</tr>
<tr>
<td>Extrude</td>
<td>No</td>
</tr>
<tr>
<td>Chamfer</td>
<td>Yes</td>
</tr>
<tr>
<td>Bridge</td>
<td>Yes</td>
</tr>
<tr>
<td>Weld (selected)</td>
<td>Proc (can animate Weld Threshold)</td>
</tr>
<tr>
<td>Target Weld</td>
<td>No</td>
</tr>
<tr>
<td>Connect</td>
<td>No</td>
</tr>
<tr>
<td>Remove Isolated Vertices</td>
<td>Proc</td>
</tr>
<tr>
<td>Remove Unused Map Verts</td>
<td>Proc</td>
</tr>
<tr>
<td>Remove</td>
<td>Yes</td>
</tr>
<tr>
<td>Split</td>
<td>No</td>
</tr>
<tr>
<td>Insert Vertex</td>
<td>Yes</td>
</tr>
<tr>
<td>Weld (selected)</td>
<td>Yes (Threshold)</td>
</tr>
<tr>
<td>Target Weld</td>
<td>No</td>
</tr>
<tr>
<td>Connect (Vertex)</td>
<td>Proc</td>
</tr>
<tr>
<td>Connect (Edge)</td>
<td>Yes</td>
</tr>
<tr>
<td>Create Shape</td>
<td>No</td>
</tr>
<tr>
<td>Function</td>
<td>Animatable?</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Edit Triangulation</td>
<td>No</td>
</tr>
<tr>
<td>Cap</td>
<td>Proc</td>
</tr>
<tr>
<td>Insert Vertex</td>
<td>No</td>
</tr>
<tr>
<td>Extrude</td>
<td>Yes</td>
</tr>
<tr>
<td>Bevel</td>
<td>Yes</td>
</tr>
<tr>
<td>Outline</td>
<td>Yes</td>
</tr>
<tr>
<td>Inset</td>
<td>Yes</td>
</tr>
<tr>
<td>Retriangulate</td>
<td>Proc</td>
</tr>
<tr>
<td>Flip</td>
<td>Proc</td>
</tr>
<tr>
<td>Hinge from Edge</td>
<td>Yes</td>
</tr>
<tr>
<td>Extrude Along Spline</td>
<td>Yes</td>
</tr>
<tr>
<td>Set Material ID</td>
<td>Yes</td>
</tr>
<tr>
<td>Select by Material ID</td>
<td>No</td>
</tr>
<tr>
<td>Set Smoothing Group</td>
<td>Yes</td>
</tr>
<tr>
<td>Select by Smoothing Group</td>
<td>No</td>
</tr>
<tr>
<td>Auto Smooth</td>
<td>Proc</td>
</tr>
</tbody>
</table>
**Edit Poly Workflow**

Edit Poly differs from other Edit modifiers in 3ds Max in that it provides two different modes, available on the Edit Poly Mode rollout: one for modeling and another for animating. By default, Edit Poly operates in Model mode, whose functionality is mostly the same as that of Editable Poly. Alternatively, you can work in Animate mode, which makes available only functions that you can animate.

Each Edit Poly modifier can preserve any number of keyframes animating a single operation type, such as transforming faces, on the same sub-object selection. To animate other parts of the object, or to animate a different operation on the same sub-object selection, just use another Edit Poly modifier.

You’ll find functions specific to the active sub-object level on a special rollout, leaving the Edit Geometry rollout with functions that can be used at most sub-object levels, as well as at the object level.

Also, many commands are accompanied by a Settings button, which gives you a second way to use the command:

- In Direct Manipulation mode, activated by clicking the command button, you apply the command by manipulating sub-objects directly in the viewport. An example of this is Extrude: You click the Extrude button, and then click and drag sub-objects in the viewports to extrude them.

**NOTE** Some buttons, such as Tessellate, operate on the mesh immediately, with no viewport manipulation required.

- Interactive Manipulation mode is well suited to experimentation. You activate this mode by clicking the command’s Settings button. This opens a non-modal settings dialog and places you in preview mode, where you can set parameters and see the results immediately in the viewport on the current sub-object selection. You can then accept the results by clicking OK, or reject them by clicking Cancel. You can also use this mode to apply the same or different settings to several different sub-object selections in a row. Make the selection, optionally change the settings, click Apply, and then repeat with a different selection.

**IMPORTANT** When you click Apply, the settings are “baked into” the selection, and then applied again to the selection as a preview. If you then click OK to exit, you will have applied the settings twice. If your intention is to apply them only once, simply click OK the first time, or click Apply, and then Cancel.
NOTE  Changes implemented in Interactive Manipulation mode with editable poly objects cannot be animated. However, they can with Edit Poly objects.

See also:
- Poly Select Modifier on page 1582
- Turn To Poly Modifier on page 1830
- Editable Poly Surface editable poly on page 2240

Procedures

To animate an Edit Poly operation on a sub-object selection:

1. Select an object.
2. Apply the Edit Poly modifier.
3. Go to the first frame at which to set a key and turn on Auto Key.
4. On the Modify panel > Edit Poly Mode rollout, choose Animate.
5. Make a sub-object selection.
6. Perform an operation on the selection, such as a transform or extrusion.
7. Proceed to the next keyframe and continue to change settings for the current operation and sub-object selection.

   If you change the selection, the existing animation is applied to the new selection, and lost from the previous one. If you change the operation, any changes from the previous animation are frozen (that is, “baked” into the model) at the current frame, and only new keyframes are recorded in the current Edit Poly modifier.

   To animate different sub-object selections using different operations, use multiple applications of the Edit Poly modifier.
To apply an Edit Poly operation to an animated sub-object selection:

This procedure demonstrates procedural animation with Edit Poly: the ability to change the location of application on an object during an animation using an existing, animated sub-object selection.

1. Select an object.
2. Create an animated sub-object selection. One way to do this is to apply a Volume Select modifier on page 1992 and animate the gizmo's transform, or animate the modifier effect by using an animated texture map.
3. Apply the Edit Poly modifier.
4. Go to the same sub-object level in Edit Poly, and then, on the Selection rollout, turn on Use Stack Selection.
5. Scrub the time slider.
   The animated selection appears on the Edit Poly object.
6. On the Modify panel > Edit Poly Mode rollout, choose Animate.
7. Perform an operation on the sub-object selection, such as a chamfer or extrusion. You needn't turn on Auto Key or use Set Key.

**NOTE** With Use Stack Selection on, you can't change the selection.

Now, when you play the animation, the Edit Poly effect moves along with the animation of the sub-object selection.

If you decide to animate a different function procedurally, first click Edit Poly Mode rollout > Cancel.

**Example: To apply an Edit Poly operation procedurally to an animated model:**

Edit Poly lets you layer an animated sub-object operation on top of an existing animation. Try this brief example:

1. Create an animated model, such as a box with an animated Bend modifier.
2. Apply an Edit Poly modifier, and on the Edit Poly Mode rollout, choose Animate. Also turn on Auto Key.
3. Go to the Polygon sub-object level.
4. Go to frame 20 and extrude a polygon.
5. Play the animation.
The extrusion animation plays “on top” of the existing animation. This isn’t possible with the Edit Mesh modifier.

**Interface**

**Stack Display**

For more information on the stack display, see Modifier Stack on page 8187.

**Show End Result** Because Edit Poly is a modifier, if you apply further modifiers and then return to the Edit Poly stack entry, Show End Result is on by default, and you can still see the results of any modifiers above Edit Poly on the stack. This is different from the Editable Poly object, where if you apply a modifier such as Symmetry on page 1803 and then return to the Editable Poly stack entry, you cannot see the effect of the modifier on the object’s geometry. While at a sub-object level, if you turn on Show Cage on the Edit Poly Mode rollout, you can see the final object as a white mesh, the original sub-object selection as a yellow mesh, and the original Edit Poly object as an orange mesh.

**Edit Poly Mode rollout**

This rollout provides access to Edit Poly’s two modes of operation: Model, for modeling, and Animate, for animation of modeling effects. For example, you can animate the Taper and Twist settings for polygons extruded along a spline.

During and between sessions, 3ds Max remembers the current mode for each object separately. The same mode remains active at all sub-object levels.

Edit Poly Mode also gives you access to the current operation’s Settings dialog, if any, and lets you commit to or cancel out of modeling and animation changes.

**Model** Lets you model using the Edit Poly functions. Operations in Model mode cannot be animated.
**Animate** Lets you animate using the Edit Poly functions. In addition to choosing Animate, you must turn on Auto Key on page 8090 or use Set Key on page 8093 for animating sub-object transforms and parameter changes. Alternatively, in Animate mode you can apply a single command, such as Extrude or Chamfer, to an animated sub-object selection passed up the stack.

**TIP** If you use Set Key to animate with Edit Poly, be sure to turn on Key Filters > Modifiers.

**NOTE** The Edit Poly modifier can store any number of keyframes animating a single operation, such as transforming polygons, on the same sub-object selection. Use additional Edit Poly modifiers to:
- animate other parts of the object
- animate repeated applications of the same operation on the same sub-object selection
- animate repeated applications of a different operation on the same sub-object selection

For example, say you want to animate a polygon extruding from an object from frame 1 to 10, and then moving back to the original position over the next 10 frames. You can accomplish this with a single Edit Poly modifier using the Extrude function, setting one keyframe at 10 and another at 20. However, say you want to animate a polygon extruding outward, and then animate movement of one of the resultant side polygons. In that case, you’d need two Edit Poly modifiers: one for the extrusion, and another for the poly transform.

**TIP** While modeling in Animate mode, you can use Commit on page 1344 to freeze the animation at the current frame.

**[label]** Shows the current command, if any. Otherwise, it shows <No Current Operation>.

When you're working in Model mode using direct manipulation (that is, working in the viewports), the label shows the current operation during drag operations, and then returns to the unavailable state.

When you're working in Model mode using a Settings dialog, or in Animate mode using direct manipulation or a Settings dialog, the label continually shows the current operation.
Commit In Model mode, using a Settings dialog, accepts any changes and closes the dialog (same as the OK button on the dialog). In Animate mode, freezes the animated selection in its state at the current frame and closes the dialog. Any existing keyframes are lost.

**TIP** Commit lets you use animation as a modeling aid. For example, you could animate a vertex selection between two positions, scrub between the two to find a suitable in-between position, and then use Commit to freeze the model at that point.

**Settings** Toggles the Settings dialog for the current command.

**Cancel** Cancels the most recently used command.

**Show Cage** Toggles the display of a two-color wireframe that shows the editable poly object before modification or subdivision. The cage colors are shown as swatches to the right of the check box. The first color represents unselected sub-objects, and the second color represents selected sub-objects. Change a color by clicking its swatch. The Show Cage toggle is available only at sub-object levels.

The cage displays the original structure of the edited object.
Typically this feature is used in conjunction with the MeshSmooth modifier on page 1505 because it lets you easily toggle visibility of the unsmoothed base object while simultaneously viewing the smoothed result, but it works with any modifier.

**TIP** Show Cage is also particularly helpful when used with the Symmetry modifier on page 1803.

### Selection rollout

The Selection rollout provides tools for accessing different sub-object levels and display settings and for creating and modifying selections. See Selection Rollout (Edit Poly Modifier) on page 1346.

### Soft Selection rollout

Soft Selection controls apply a smooth falloff between selected sub-objects and unselected ones. When Use Soft Selection is on, unselected sub-objects near your selection are given partial selection values. These values are shown in the viewports by means of a color gradient on the vertices, and optionally on the faces. They affect most types of sub-object deformations, such as the Move, Rotate, and Scale functions and any deformation modifiers (such as Bend) applied to the object. This provides a magnet-like effect with a sphere of influence around the selection.

For more information, see Soft Selection Rollout on page 2014.

### Edit (sub-object) rollout

The Edit (sub-object) rollouts provide sub-object-specific functions for editing an Edit Poly object and its sub-objects. For specific information, click any of the following links:

- Edit Poly (Object) on page 1357
- Edit Poly (Vertex) on page 1359
- Edit Poly (Edge) on page 1368
- Edit Poly (Border) on page 1389
- Edit Poly (Polygon/Element) on page 1395
**Edit Geometry rollout**

The Edit Geometry Rollout (Polymesh and Edit Poly) provides global functions for editing an Edit Poly object and its sub-objects.

**Paint Deformation rollout**

Paint Deformation lets you stroke elevated and indented areas directly onto object surfaces. For more information, see Paint Deformation Rollout (Polymesh) on page 2333.

**Selection Rollout (Edit Poly Modifier)**

Select an Edit Poly object. > Modify panel > Selection rollout

The Selection rollout provides tools for accessing different sub-object levels and display settings and for creating and modifying selections. It also displays information about selected entities.

When you first access the Modify panel with an Edit Poly object selected, you're at the Object level, with several functions available as described in Edit Poly (Object) on page 1357. You can toggle the various sub-object levels and access relevant functions by clicking the buttons at the top of the Selection rollout.

Clicking a button here is the same as choosing a sub-object type in the modifier stack display. Click the button again to turn it off and return to the Object selection level.
NOTE You can convert sub-object selections in three different ways with the use of the Ctrl and Shift keys:

- To convert the current selection to a different sub-object level, clicking a sub-object button on the Selection rollout with Ctrl held down. This selects all sub-objects at the new level that touch the previous selection. For example, if you select a vertex, and then Ctrl+click the Polygon button, all polygons that use that vertex are selected.

- To convert the selection to only sub-objects all of whose source components are originally selected, hold down both Ctrl and Shift as you change the level. For example, if you convert a vertex selection to a polygon selection with Ctrl+Shift+click, the resultant selection includes only those polygons all of whose vertices were originally selected.

- To convert the selection to only sub-objects that border the selection, hold down Shift as you change the level. The selection conversion is inclusive, meaning:
  - When you convert faces, the resulting selection of edges or vertices all belong to selected faces that bordered unselected faces. Only the edges or vertices that bordered unselected faces are selected.
  - When you convert vertices to faces, the resulting selection of faces had all of their vertices selected and bordered unselected faces. When you convert vertices to edges, the resulting selection contains only edges all of whose vertices were previously selected and only edges of faces that did not have all vertices selected; that is, of faces around the border of the vertex selection.

Face selection (left) converted to vertex border (center) and edge border (right)
When you convert edges to faces, the resulting selection of faces had some but not all of their edges selected, and were next to faces with no edges selected. When you convert edges to vertices, the resulting vertices are on previously selected edges, but only at intersections where not all edges were selected.

Conversion commands are also available from the quad menu.
**Interface**

- **Vertex** Accesses the Vertex sub-object level, which lets you select a vertex beneath the cursor; region selection selects vertices within the region.

- **Edge** Accesses the Edge sub-object level, which lets you select a polygon edge beneath the cursor; region selection selects multiple edges within the region.

- **Border** Accesses the Border sub-object level, which lets you select a sequence of edges that borders a hole in the mesh. A border comprises only connected edges with faces on only one side of them, and is always a complete loop. For example, a default box primitive doesn't have a border, but the teapot object has a couple of them: one each on the lid, the body, and the spout, and two on the handle. If you create a cylinder and delete one end, the row of edges around that end forms a border.

When Border sub-object level is active, you can't select edges that aren't on borders. Clicking a single edge on a border selects that whole border.
You can cap a border, either with the Cap function on page 1392 or by applying the Cap Holes modifier on page 1185. You can also connect borders between objects with the Connect compound object on page 695.

NOTE
The Edge and Border sub-object levels are compatible, so if you go from one to the other, any existing selection is retained.

**Polygon** Accesses the Polygon sub-object level, which lets you select polygons beneath the cursor. Region selection selects multiple polygons within the region.

**Element** Accesses the Element sub-object level, which lets you select all contiguous polygons in an object. Region selection lets you select multiple elements.

NOTE
The Polygon and Element sub-object levels are compatible, so if you go from one to the other, any existing selection is retained.

**Use Stack Selection** When on, Edit Poly automatically uses any existing sub-object selection passed up the stack, and prevents you from manually changing the selection.

**By Vertex** When on, you can select sub-objects only by selecting a vertex that they use. When you click a vertex, all sub-objects that use the selected vertex are selected.
Not available at the Vertex sub-object level.

**Ignore Backfacing** When on, selection of sub-objects affects only those facing you. When off (the default), you can select any sub-object(s) under the mouse cursor, regardless of their visibility or facing. If there are more than one sub-object under the cursor, repeated clicking cycles through them. Likewise, with Ignore Backfacing off, region selection includes all sub-objects, regardless of the direction they face.

NOTE The state of the Backface Cull on page 166 setting on the Display panel does not affect sub-object selection. Thus, if Ignore Backfacing is off, you can still select sub-objects even if you can’t see them.
**By Angle** When on, selecting a polygon also selects neighboring polygons based on the angle setting to the right of the check box. This value determines the maximum angle between neighboring polygons to select. Available only at the Polygon sub-object level.

For example, if you click a side of a box and the angle value is less than 90.0, only that side is selected, because all sides are at 90-degree angles to each other. But if the angle value is 90.0 or greater, all sides of the box are selected. This function speeds up selection of contiguous areas made up of polygons that are at similar angles to one another. You can select coplanar polygons with a single click at any angle value.

**Shrink** Reduces the sub-object selection area by deselecting the outermost sub-objects. If the selection size can no longer be reduced, the remaining sub-objects are deselected.

**Grow** Expands the selection area outward in all available directions. For this function, a border is considered to be an edge selection.

![Grow and Shrink](image)

With Shrink and Grow, you can add or remove neighboring elements from the edges of your current selection. This works at any sub-object level.

**Ring** Expands an edge selection by selecting all edges parallel to the selected edges. Ring applies only to edge and border selections.
Ring selection adds to the selection all the edges that are parallel to the ones selected originally.

**TIP** After making a ring selection, you can use Connect on page 1383 to subdivide the associated polygons into new edge loops.

[Ring Shift] The spinner next to the Ring button lets you move the selection in either direction to other edges in the same ring; that is, to neighboring, parallel edges. If you have a loop selected, you can use this function to select a neighboring loop. Applies only to Edge and Border sub-object levels.
Left: Original loop selection

Upper right: Ring Shift up moves selection outward (from center of model).

Lower right: Ring Shift down moves selection inward (toward center of model).

To expand the selection in the chosen direction, Ctrl+click the up or down spinner button. To shrink the selection in the chosen direction, Alt+click the up or down spinner button.

**Loop** Expands the selection as far as possible, in alignment with selected edges.
Loop applies only to edge and border selections, and propagates only through four-way junctions.
Loop selection extends your current edge selection by adding all the edges aligned to the ones selected originally.

[Loop Shift] The spinner next to the Loop button lets you move the selection in either direction to other edges in the same loop; that is, to neighboring, aligned edges. If you have a ring selected, you can use this function to select a neighboring ring. Applies only to Edge and Border sub-object levels.
Left: Original ring selection

Upper right: Loop Shift up moves selection outward.

Lower right: Loop Shift down moves selection inward.

To expand the selection in the chosen direction, Ctrl+click the up or down spinner button. To shrink the selection in the chosen direction, Alt+click the up or down spinner button.

Get Stack Selection Replaces the current selection with the sub-object selection passed up the stack. You can then modify this selection using standard methods.

If no selection exists in the stack, all sub-objects are unselected.
Preview Selection

This option lets you preview a sub-object selection before committing to it. You can preview at the current sub-object level, or switch sub-object levels automatically based on the mouse position. The choices are:

- **Off**  No preview is available.
- **SubObj**  Enables previewing at the current sub-object level only. As you move the mouse over the object, the sub-object under the cursor highlights in yellow. To select the highlighted object, click the mouse. To select multiple sub-objects at the current level, press and hold Ctrl, move the mouse to highlight more sub-objects, and then click to select all highlighted sub-objects.

To deselect multiple sub-objects at the current level, press and hold Ctrl+Alt, move the mouse to highlight more sub-objects, and then click a selected sub-object. This deselects all highlighted sub-objects.

_Polygon sub-object selection preview with Ctrl held down_
- **Multi**  Works like SubObj, but also switches among the Vertex, Edge, and Polygon sub-object levels on the fly, based on the mouse position. For example, if you position the mouse over an edge, the edge highlights, and then clicking activates the Edge sub-object level and selects the edge.

To select multiple sub-objects of the same type, press and hold Ctrl after highlighting a sub-object, move the mouse to highlight more sub-objects, and then click to activate that sub-object level and select all highlighted sub-objects.

To deselect multiple sub-objects at the current sub-object level, press and hold Ctrl+Alt, move the mouse to highlight more sub-objects, and then click a selected sub-object. This deselects all highlighted sub-objects. Note that this method does not switch sub-object levels.

**NOTE** When Ignore Backfacing on page 1350 is off, you’ll see back-facing vertices and edges highlight while previewing a sub-object selection.

**Selection Information**

At the bottom of the Selection rollout is a text display giving information about the current selection. If 0 or more than one sub-object is selected, the text gives the number and type selected; for example, “4 Polygons Selected.”

If one sub-object is selected, the text gives the identification number and type of the selected item; for example, “Polygon 73 Selected.”

When using Preview Selection on page 1356, a second line gives additional information about the identity or number of highlighted sub-objects.

**Edit Poly (Object)**

Select an Edit Poly object. > Modify panel

Edit Poly (Object) functions are available when no sub-object levels are active. These functions are also available at all sub-object levels, and work the same in each mode, except as noted below.
Interface

Edit Geometry rollout

For detailed descriptions of these controls, see Edit Geometry Rollout (Polymesh and Edit Poly) on page 1409.

Paint Deformation rollout

Paint Deformation lets you stroke elevated and indented areas directly onto object surfaces. For more information, see Paint Deformation Rollout (Polymesh) on page 2333.
**Edit Poly (Vertex)**

Select an Edit Poly object. > Modify panel > Selection rollout > Vertex

Select an Edit Poly object. > Modify panel > Modify Stack display > Expand Edit Poly. > Vertex

Select an Edit Poly object. > Quad menu > Tools 1 quadrant > Vertex

Vertices are points in space: They define the structure of other sub-objects that make up the poly object. When vertices are moved or edited, the geometry they form is affected as well. Vertices can also exist independently; such isolated vertices can be used to construct other geometry but are otherwise invisible when rendering.

At the Edit Poly (Vertex) sub-object level, you can select single and multiple vertices and move them using standard methods. This topic covers the Edit Vertices and Edit Geometry rollouts; for other controls, see [Edit Poly Modifier on page 1332](#).

**Procedures**

**To weld polygon vertices:**

You can use either of two methods to combine several vertices into one, also known as welding. If the vertices are very close together, use the Weld function. You can also use Weld to combine a number of vertices to the average position of all of them.

Alternatively, to combine two vertices that are far apart, resulting in a single vertex that's in the same position as one of them, use Target Weld.

1. To use Weld:
   1. On the Selection rollout, turn on Ignore Backfacing, if necessary. This ensures that you're welding only vertices you can see.
   2. Select the vertices to weld.
   3. If the vertices are very close together, simply click Weld. If that doesn't work, proceed to the next step.

   4. Click the Settings button to the right of the Weld button. This opens the [Weld Vertices dialog on page 2359](#).
5 Increase the Weld Threshold value gradually using the spinner (click and hold on the up-down arrow buttons to the right of the numeric field and then drag upward). If you need the value to change more quickly, hold down the Ctrl key as you drag. When the threshold equals or exceeds the distance between two or more of the vertices, the weld occurs automatically, and the resulting vertex moves to their average location.

6 If not all the vertices are welded, continue increasing the Weld Threshold value until they are.

7 Click OK to exit.

2 To use Target Weld:

1 On the Selection rollout, turn on Ignore Backfacing, if necessary. This ensures that you're welding only vertices you can see.

2 Find two vertices you want to weld, and determine the ultimate location of the resulting vertex. The two vertices must be contiguous; that is, they must be connected by a single edge.

For this example, we'll call the vertices A and B, and the resulting vertex will be at vertex B's location.

3 Click the Target Weld button.

The button stays highlighted, to indicate that you're now in Target Weld mode.

4 Click vertex A and then move the mouse.

A rubber-band line connects the vertex and the mouse cursor.

5 Position the cursor over vertex B, whereupon the cursor image changes from an arrow to a crosshairs. Reminder: Only vertices connected to the first vertex by a single edge qualify for target welding.

6 Click to weld the two.

The resulting vertex remains at vertex B's position.

7 Click Target Weld again to turn it off.
Interface

Edit Poly Mode rollout

See Edit Poly Mode rollout on page 1342 for information on the Edit Poly Mode rollout settings.

Selection rollout

See Selection Rollout (Edit Poly Modifier) on page 1346 for information on the Selection rollout settings.

Soft Selection rollout

Soft Selection controls apply a smooth falloff between selected sub-objects and unselected ones. When Use Soft Selection is on, unselected sub-objects near your selection are given partial selection values. These values are shown in the viewports by means of a color gradient on the vertices, and optionally on the faces. They affect most types of sub-object deformations, such as the Move, Rotate, and Scale functions, as well as any deformation modifiers (such as Bend) applied to the object. This provides a magnet-like effect with a sphere of influence around the selection.

For more information, see Soft Selection Rollout on page 2014.

Edit Vertices rollout

This rollout includes commands specific to vertex editing.
NOTE To delete vertices, select them and press the Delete key. This can create one or more holes in the mesh. To delete vertices without creating holes, use Remove (see following).

Remove Deletes selected vertices and combines the polygons that use them. The keyboard shortcut is Backspace.

Removing one or more vertices deletes them and retriangulates the mesh to keep the surface intact. If you use Delete instead, the polygons depending on those vertices are deleted as well, creating a hole in the mesh.

WARNING Use of Remove can result in mesh shape changes and non-planar polygons.

Break Creates a new vertex for each polygon attached to selected vertices, allowing the polygon corners to be moved away from each other where they were once joined at each original vertex. If a vertex is isolated or used by only one polygon, it is unaffected.

Extrude Lets you extrude vertices manually via direct manipulation in the viewport. Click this button, and then drag vertically on any vertex to extrude it.

Extruding a vertex moves it along a normal and creates new polygons that form the sides of the extrusion, connecting the vertex to the object. The extrusion has the same number of sides as the number of polygons that originally used the extruded vertex.
Following are important aspects of vertex extrusion:

- When over a selected vertex, the mouse cursor changes to an Extrude cursor.
- Drag vertically to specify the extent of the extrusion, and horizontally to set the size of the base.
- With multiple vertices selected, dragging on any one extrudes all selected vertices equally.
- You can drag other vertices in turn to extrude them while the Extrude button is active. Click Extrude again or right-click in the active viewport to end the operation.

Chamfer box showing extruded vertex

- Extrude Settings Opens the Extrude Vertices dialog on page 2350, which lets you perform extrusion via interactive manipulation.
If you click this button after performing a manual extrusion, the same extrusion is performed on the current selection as a preview and the dialog opens with Extrusion Height set to the amount of the last manual extrusion.

**Weld** Combines contiguous, selected vertices that fall within the tolerance specified in Weld dialog on page 2359. All edges become connected to the resulting single vertex.

![Using Weld at the Vertex level](image)

Vertices farther apart than the Threshold distance are not welded.

Weld is best suited to automatically simplifying geometry that has areas with a number of vertices that are very close together. Before using Weld, set the Weld Threshold via the Weld dialog on page 2359. To weld vertices that are relatively far apart, use Target Weld on page 1366 instead.

**Weld Settings** Opens the Weld dialog on page 2359, which lets you specify the weld threshold.

**Chamfer** Click this button and then drag vertices in the active object. To chamfer vertices numerically, click the Chamfer Settings button and use the Chamfer Amount value.

If you chamfer multiple selected vertices, all of them are chamfered identically. If you drag an unselected vertex, any selected vertices are first deselected.

Each chamfered vertex is effectively replaced by a new face that connects new points on all edges leading to the original vertex. These new points are exactly <chamfer amount> distance from the original vertex along each of these edges. New chamfer faces are created with the material ID of one of the neighboring
faces (picked at random) and a smoothing group which is an intersection of all neighboring smoothing groups.

For example, if you chamfer one corner of a box, the single corner vertex is replaced by a triangular face whose vertices move along the three edges that led to the corner. Outside faces are rearranged and split to use these three new vertices, and a new triangle is created at the corner.

Alternatively, you can create open space around the chamfered vertices; for details, see Chamfer Vertices dialog on page 2344.

Top: The original vertex selection
Center: Vertices chamfered
Bottom: Vertices chamfered with Open on

Chamfer Settings Opens the Chamfer Vertices dialog on page 2344, which lets you chamfer vertices via interactive manipulation and toggle the Open option.
If you click this button after performing a manual chamfer, the same chamfer is performed on the current selection as a preview and the dialog opens with Chamfer Amount set to the amount of the last manual extrusion.

**Target Weld** Allows you to select a vertex and weld it to a neighboring target vertex. Target Weld works only with pairs of contiguous vertices; that is, vertices connected by a single edge.

In Target Weld mode, the mouse cursor, when positioned over a vertex, changes to a + cursor. Click and then move the mouse; a dashed, rubber-band line connects the vertex to the mouse cursor. Position the cursor over another, neighboring vertex and when the + cursor appears again, click the mouse. The first vertex moves to the position of the second and the two are welded. Target Weld remains active until you click the button again or right-click in the viewport.

**Connect** Creates new edges between pairs of selected vertices.

Connect does not let the new edges cross. Thus, for example, if you select all four vertices of a four-sided polygon and then click Connect, only two of the vertices will be connected. In this case, to connect all four vertices with new edges, use **Cut** on page 1417.

**Remove Isolated Vertices** Deletes all vertices that don’t belong to any polygons.

**Remove Unused Map Verts** Certain modeling operations can leave unused (isolated) map vertices that show up in the Unwrap UVW editor on page 1856, but cannot be used for mapping. You can use this button to automatically delete these map vertices.
**Edit Geometry rollout**

![Edit Geometry Rollout](image)

For detailed descriptions of these controls, see *Edit Geometry Rollout (Polymesh and Edit Poly)* on page 1409.

**Paint Deformation rollout**

Paint Deformation lets you stroke elevated and indented areas directly onto object surfaces. For more information, see *Paint Deformation Rollout (Polymesh)* on page 2333.
Edit Poly (Edge)

Select an Edit Poly object. > Modify panel > Selection rollout > Edge

Select an Edit Poly object. > Modify panel > Modifier Stack display > Expand Edit Poly. > Edge

Select an Edit Poly object. > Quad menu > Tools 1 quadrant > Edge

An edge is a line connecting two vertices that forms the side of a polygon. An edge can't be shared by more than two polygons. Also, the normals of the two polygons should be adjacent. If they aren't, you wind up with two edges that share vertices.

At the Edit Poly Edge sub-object level, you can select single and multiple edges and transform them using standard methods. This topic covers the Edit Geometry and Edit Edges rollouts; for other controls, see Edit Poly Modifier on page 1332.

Procedures

Example: To use the Cut and Turn features:

3ds Max provides a convenient function for turning edges, which, along with the Cut feature, streamlines the custom modeling process considerably. Specifically, cutting a new polygon into existing geometry minimizes the number of extra visible edges, typically adding none or one. And after using cut, the Turn function lets you adjust any diagonal with a single click.

1  In the Perspective viewport, add a Plane object. This object is available from the Create panel > Standard Primitives > Object Type rollout.
   By default, the Plane object is divided into 4 x 4 polygons. If you don't see the polygons in the Perspective viewport, press F4 to activate Edged Faces view mode.
2 Convert the Plane object to Editable Poly format. If you’re not sure how, continue in this step; otherwise, skip to the next step after converting. To convert the object, right-click once in the Perspective viewport to exit create mode. This leaves the object selected. Right-click again in the Perspective viewport, and then at the bottom of the Transform quadrant, choose Convert To > Convert To Editable Poly. Alternatively, apply the Edit Poly modifier.
The object is now an editable poly and the command panel switches to the Modify panel.

3 Cut is available at the object level as well as at every sub-object level. On the Edit Geometry rollout, find the Cut button, and then click it.

4 In the Perspective viewport, position the mouse cursor in the center of a corner polygon, such as the one closest to you, click once, and then move the mouse around the viewport.
Two or three lines appear and move as you move the mouse. One line connects the mouse cursor to the original click location, and indicates where the next cut will appear when you click the mouse button. Another connects to a corner of the polygon; this connection changes depending on the mouse position. And, if the cursor isn’t over an edge or a vertex (it changes appearance if it is, depending on which), a third line connects the mouse cursor to another vertex.

This demonstrates one aspect of the new Cut functionality; in previous versions, the first click in a Cut operation connected to two corners of the polygon.

5 Continue cutting in a rectangular pattern, clicking once at the center of a different polygon, finish by clicking once more at the starting point, and then right-click to exit Cut mode.
The result is a rectangle across four polygons, without any connecting visible edges. In previous versions, you would have had eight connecting visible edges: two in each of the original polygons. Note that all the edges you created are selected, and ready for further transformation or editing.

6 Cut a rectangle into the center of a single polygon.
   In this case you end up with a single, additional visible edge instead of seven, as in previous versions. The edge connects corner of the new polygon with a corner of the original one. This new edge is not selected, but the ones you created explicitly are.
Connecting the remaining corners are a number of diagonals on page 8551, which serve to fully triangulate the polygons. The new Turn function lets you manipulate each of these with a single click.

7 Go to the Edge sub-object level, and then, on the Edit Edges rollout, click Turn.

All diagonals, including those created from the Cut operations, appear as dashed lines.
Click a diagonal to turn it, and then click it again to return it to its original status.

In Turn mode, click a diagonal (dashed line) once to turn it.

Each diagonal has only two different available positions, given no changes in any other diagonals' or edges' positions.

Compare this with the Edit Triangulation tool, with which you must click two vertices to change a diagonal's position.

This simple demonstration shows how, when manually subdividing a polygon mesh for modeling and animation purposes, you can save a good deal of time by using the Cut and Turn tools in 3ds Max.

To create a shape from one or more edges:

1. Select the edges you want to make into shapes.
2. On the Edit Edges rollout, click Create Shape From Selection.
3. Make changes, as needed, on the Create Shape dialog that appears.
   - Enter a curve name or keep the default.
   - Choose Smooth or Linear as the shape type.
4. Click OK.

The resulting shape consists of one or more splines whose vertices are coincident with the vertices in the selected edges. The Smooth option results in vertices using smooth values, while the Linear option results in linear splines with corner vertices.

If the selected edges are not continuous, or if they branch, the resulting shape will consist of more than one spline. When the Create Shape function runs into a branching 'Y' in the edges, it makes an arbitrary decision as to which edge produces which spline. If you need to control
this, select only those edges that will result in a single spline, and perform a Create Shape operation repeatedly to make the correct number of shapes. Finally, use Attach on page 655 in the Editable Spline to combine the shapes into one.

Above: Original object

Below: Object with edges selected
Above: Selected edges removed from original object

Below: Unwanted edges removed

Interface

Edit Poly Mode rollout

See Edit Poly Mode rollout on page 1342 for information on the Edit Poly Mode rollout settings.
Selection rollout

See Selection Rollout (Edit Poly Modifier) on page 1346 for information on the Selection rollout settings.

Soft Selection rollout

Soft Selection controls apply a smooth falloff between selected sub-objects and unselected ones. When Use Soft Selection is on, unselected sub-objects near your selection are given partial selection values. These values are shown in the viewports by means of a color gradient on the vertices, and optionally on the faces. They affect most types of sub-object deformations, such as the Move, Rotate, and Scale functions, as well as any deformation modifiers (such as Bend) applied to the object. This provides a magnet-like effect with a sphere of influence around the selection.

For more information, see Soft Selection Rollout on page 2014.

Edit Edges rollout

This rollout includes commands specific to edge editing.

**NOTE** To delete edges, select them and press the Delete key. This deletes all selected edges and attached polygons, which can create one or more holes in the mesh. To delete edges without creating holes, use Remove (see following entry).

**Insert Vertex** Lets you subdivide visible edges manually.

After turning on Insert Vertex, click an edge to add a vertex at that location. You can continue subdividing polygons as long as the command is active.
To stop inserting edges, right-click in the viewport, or click Insert Vertex again to turn it off.

**Remove** Deletes selected edges and combines the polygons that use them.

Removing one edge is like making it invisible. The mesh is affected only when all or all but one of the edges depending on one vertex are removed. At that point, the vertex itself is deleted and the surface is retriangulated.

To delete the associated vertices when you remove edges, press and hold Ctrl while executing a Remove operation, either by mouse or with the Backspace key. This option, called Clean Remove, ensures that the remaining polygons are planar.

Left: The original edge selection
Center: Standard Remove operation leaves extra vertices.

Right: Clean Remove with Ctrl-Remove deletes the extra vertices.

Edges with the same polygon on both sides usually can’t be removed.

**WARNING** Use of Remove can result in mesh shape changes and non-planar polygons.

**Split** Divides the mesh along the selected edges.
This does nothing when applied to a single edge in the middle of a mesh. The vertices at the end of affected edges must be separable in order for this option to work. For example, it would work on a single edge that intersects an existing border, since the border vertex can be split in two. Additionally, two adjacent edges could be split in the middle of a grid or sphere, since the shared vertex can be split.

**Extrude** Lets you extrude edges manually via direct manipulation in the viewport. Click this button, and then drag vertically on any edge to extrude it.

![Extrusion Example](http://example.com/extrusion.png)

*When extruding a vertex or edge interactively in the viewport, you set the extrusion height by moving the mouse vertically and the base width by moving the mouse horizontally.*

Extruding an edge moves it along a normal and creates new polygons that form the sides of the extrusion, connecting the edge to the object. The extrusion has either three or four sides; three if the edge was on a border, or four if it was shared by two polygons. As you increase the length of the extrusion, the base increases in size, to the extent of the vertices adjacent to the extruded edge’s endpoints.
Following are important aspects of edge extrusion:

- When over a selected edge, the mouse cursor changes to an Extrude cursor.
- Drag vertically to specify the extent of the extrusion, and horizontally to set the size of the base.
- With multiple edges selected, dragging on any one extrudes all selected edges equally.
- You can drag other edges in turn to extrude them while the Extrude button is active. Click Extrude again or right-click in the active viewport to end the operation.

Chamfer box showing extruded edge

Extrude Settings Opens the Extrude Edges dialog on page 2350, which lets you perform extrusion via interactive manipulation. If you click this button after performing a manual extrusion, the same extrusion is performed on the current selection as a preview and the dialog opens with Extrusion Height set to the amount of the last manual extrusion.

Weld Combines selected edges that fall within the threshold specified in Weld dialog on page 2359.
You can weld only edges that have one polygon attached; that is, edges on a border. Also, you cannot perform a weld operation that would result in illegal geometry (e.g., an edge shared by more than two polygons). For example, you cannot weld opposite edges on the border of a box that has a side removed.

**Weld Settings** Opens the Weld dialog on page 2359, which lets you specify the weld threshold.

**Chamfer** Click this button and then drag edges in the active object. To chamfer edges numerically, click the Chamfer Settings button and change the Chamfer Amount value.

If you chamfer multiple selected edges, all of them are chamfered identically. If you drag an unselected edge, any selected edges are first deselected.

An edge chamfer "chops off" the selected edges, creating a new polygon connecting new points on all visible edges leading to the original vertex. The new edges are exactly \(<\text{chamfer amount}\) distance from the original edge along each of these edges. New chamfer faces are created with the material ID of one of the neighboring faces (picked at random) and a smoothing group which is an intersection of all neighboring smoothing groups.

For example, if you chamfer one edge of a box, each corner vertex is replaced by two vertices moving along the visible edges that lead to the corner. Outside faces are rearranged and split to use these new vertices, and a new polygon is created at the corner.

![Using Chamfer at the Edge level](image)

Alternatively, you can create open space around the chamfered edges; for details, see Chamfer Edges dialog on page 2344.
Chamfer Settings Opens the Chamfer Edges dialog on page 2344, which lets you chamfer edges via interactive manipulation and toggle the Open option.

If you click this button after performing a manual chamfer, the same chamfer is performed on the current selection as a preview and the dialog opens with Chamfer Amount set to the amount of the last manual chamfer.

Target Weld Allows you to select an edge and weld it to a target edge. When positioned over an edge, the cursor changes to a + cursor. Click and move the mouse and a dashed line appears from the vertex with an arrow cursor at the other end of the line. Position the cursor over another edge and when the + cursor appears again, click the mouse. The first edge is moved to the position of the second, and the two are welded.

You can weld only edges that have one polygon attached; that is, edges on a border. Also, you cannot perform a weld operation that would result in illegal geometry (e.g., an edge shared by more than two polygons). For example, you cannot weld opposite edges on the border of a box that has a side removed.

Bridge Connects border edges on an object with a polygon “bridge.” Bridge connects only border edges; that is, edges that have a polygon on only one side. This tool is particularly useful when creating edge loops or profiles.

There are two ways to use Bridge in Direct Manipulation mode (that is, without opening the Bridge Edges settings dialog):

- Select two or more border edges on the object, and then click Bridge. This immediately creates the bridge between the pair of selected borders using the current Bridge settings, and then deactivates the Bridge button.

- If no qualifying selection exists (that is, two or more selected border edges), clicking Bridge activates the button and places you in Bridge mode. First click a border edge and then move the mouse; a rubber-band line connects the mouse cursor to the clicked edge. Click a second edge on a different border to bridge the two. This creates the bridge immediately using the current Bridge settings; the Bridge button remains active for connecting more edges. To exit Bridge mode, right-click the active viewport or click the Bridge button.

The new polygons that result from a Bridge operation are automatically selected; you can see this by accessing the Polygon sub-object level.
Using Bridge at the Edge level

**NOTE** Bridge always creates a straight-line connection between edges. To make the bridge connection follow a contour, apply modeling tools as appropriate after creating the bridge. For example, bridge two edges, and then use Bend on page 1165.

**Bridge Settings** Opens the Bridge Edges dialog on page 2341, which lets you add polygons between pairs of edges via interactive manipulation.

**Connect** Creates new edges between pairs of selected edges using the current Connect Edges dialog settings. Connect is particularly useful for creating or refining edge loops.

**NOTE** You can connect only edges on the same polygon. Also, Connect will not let the new edges cross. For example, if you select all four edges of a four-sided polygon and then click Connect, only neighboring edges are connected, resulting in a diamond pattern.
Connecting two or more edges using the Settings dialog creates equally spaced edges. The number of edges is set in the dialog. When you click the Connect button, the current dialog settings are applied to the selection.

- **Connect Settings** Opens the Connect Edges dialog on page 2345, which lets you preview the Connect results, specify the number of edge segments created by the operation, and set spacing and placement for the new edges.

- **Create Shape** After selecting one or more edges, click this button to create a spline shape or shapes from the selected edges, using the current settings from the Create Shape Settings dialog (see following).
  
  The new shape's pivot is placed at the same location as that of the Edit Poly object.

- **Create Shape Settings** Lets you name the Create Shape output and set it to Smooth or Linear.
An edge selection (top); a smooth shape (center); a linear shape (bottom)

**Edit Tri[angulation]** Lets you modify how polygons are subdivided into triangles by drawing internal edges, or **diagonals** on page 8551.

In **Edit Triangulation** mode, you can see the current triangulation in the viewport, and change it by clicking two vertices on the same polygon.
To edit triangulation manually, turn on this button. The hidden edges appear. Click a polygon vertex. A rubber-band line appears, attached to the cursor. Click a non-adjacent vertex to create a new triangulation for the polygon.

**TIP** For easier editing of triangulation, use the Turn command instead (see following).

**Turn** Lets you modify how polygons are subdivided into triangles by clicking diagonals. When you activate Turn, the diagonals on page 8551 become visible as dashed lines in wireframe and edged-faces views. In Turn mode, click a diagonal to change its position. To exit Turn mode, right-click in the viewport or click the Turn button again.

Each diagonal has only two available positions at any given time, so clicking a diagonal twice in succession simply returns it to its original position. But changing the position of a nearby diagonal can make a different alternate position available to a diagonal.

For more information on how to use Turn with the enhanced Cut tool, see this procedure on page 1368.
**Edit Geometry rollout**

For detailed descriptions of these controls, see Edit Geometry Rollout (Polymesh and Edit Poly) on page 1409.

**Paint Deformation rollout**

Paint Deformation lets you stroke elevated and indented areas directly onto object surfaces. For more information, see Paint Deformation Rollout (Polymesh) on page 2333.
Edit Poly (Border)

Select an Edit Poly object. > Modify panel > Selection rollout > Border

Select an Edit Poly object. > Modify panel > Modifier Stack display > Expand Edit Poly. > Border

Select an Edit Poly object. > Quad menu > Tools 1 quadrant > Border

A border is a linear section of a mesh that can generally be described as the edge of a hole. This is usually a sequence of edges with polygons on only one side. For example, a box doesn’t have a border, but the teapot object has several: on the lid, on the body, on the spout, and two on the handle. If you create a cylinder, and then delete an end polygon, the adjacent row of edges forms a border.

At the Edit Poly Border sub-object level, you can select single and multiple borders and transform them using standard methods. This topic covers the Edit Geometry and Edit Borders rollouts; for other controls, see Edit Poly Modifier on page 1332.

Procedures

To create a polygon that closes the surface at the selected border:

1. At the Border sub-object level, select any open edge.
   This selects the entire closed loop of continuous open edges that make up the border selection.

2. Click Cap.

Interface

Edit Poly Mode rollout

See Edit Poly Mode rollout on page 1342 for information on the Edit Poly Mode rollout settings.

Selection rollout

See Selection Rollout (Edit Poly Modifier) on page 1346 for information on the Selection rollout settings.

Soft Selection rollout

Soft Selection controls apply a smooth falloff between selected sub-objects and unselected ones. When Use Soft Selection is on, unselected sub-objects near your selection are given partial selection values. These values are shown in the viewports by means of a color gradient on the vertices, and optionally on the faces. They affect most types of sub-object deformations, such as the Move, Rotate, and Scale functions, as well as any deformation modifiers (such as Bend) applied to the object. This provides a magnet-like effect with a sphere of influence around the selection.

For more information, see Soft Selection Rollout on page 2014.

Edit Borders rollout

This rollout includes commands specific to editing borders.

**NOTE** To delete a border, select it and press the Delete key. This deletes the border and all attached polygons.

**Extrude** Lets you extrude a border manually via direct manipulation in the viewport. Click this button, and then drag vertically on any border to extrude it.

Extruding a border moves it along a normal and creates new polygons that form the sides of the extrusion, connecting the border to the object. The extrusion can form a varying number of additional sides, depending on the geometry near the border. As you increase the length of the extrusion, the base increases in size, to the extent of the vertices adjacent to the extruded border's endpoints.

Following are important aspects of border extrusion:

- When the mouse cursor is over a selected border, it changes to an Extrude cursor.
To specify the extent of the extrusion, drag vertically, and to set the size of the base, drag horizontally.

With multiple borders selected, dragging on any one extrudes all selected borders equally.

While the Extrude button is active, you can extrude other borders in turn by dragging them. Click Extrude again or right-click in the active viewport to end the operation.

**Extrude Settings** Opens the Extrude Edges dialog on page 2350, which lets you perform extrusion via interactive manipulation.

If you click this button after performing a manual extrusion, the same extrusion is performed on the current selection as a preview and the dialog opens with Extrusion Height set to the amount of the last manual extrusion.

**Insert Vertex** Lets you subdivide border edges manually.

After turning on Insert Vertex, click a border edge to add a vertex at that location. You can continue subdividing border edges as long as the command is active.

To stop inserting vertices, right-click in the viewport, or click Insert Vertex again to turn it off.

**Chamfer** Click this button and then drag a border in the active object. The border need not be selected first.

If you chamfer multiple selected borders, all of them are chamfered identically. If you drag an unselected border, any selected borders are first deselected.

A border chamfer essentially “frames” the border edges, creating a new set of edges paralleling the border edges, plus new diagonal edges at any corners. These new edges are exactly <chamfer amount> distance from the original edges. New chamfer faces are created with the material ID of one of the neighboring faces (picked at random) and a smoothing group which is an intersection of all neighboring smoothing groups.

Alternatively, you can create open space around the chamfered borders, essentially cutting away at the open edges; for details, see Chamfer Edges dialog on page 2344.

**Chamfer Settings** Opens the Chamfer Edges dialog on page 2344, which lets you chamfer borders via interactive manipulation and toggle the Open option.
If you click this button after performing a manual chamfer, the same chamfer is performed on the current selection as a preview and the dialog opens with Chamfer Amount set to the amount of the last manual chamfer.

**Cap** Caps an entire border loop with a single polygon. Select the border, and then click Cap.

**Bridge** Connects pairs of borders on an object with polygon “bridges.” There are two ways to use Bridge in Direct Manipulation mode (that is, without opening the Bridge Settings dialog):

- Select an even number of borders on the object, and then click Bridge. This immediately creates the bridge between each pair of selected borders using the current Bridge settings, and then deactivates the Bridge button.

- If no qualifying selection exists (that is, two or more selected borders), clicking Bridge activates the button and places you in Bridge mode. First click a border edge and then move the mouse; a rubber-band line connects the mouse cursor to the clicked edge. Click a second edge on a different border to bridge the two. This creates the bridge immediately using the current Bridge settings; the Bridge button remains active for connecting more pairs of borders. To exit Bridge mode, right-click the active viewport or click the Bridge button.

The new polygons that result from a Bridge operation are automatically selected; you can see this by accessing the Polygon sub-object level.

![Using Bridge at the Border level.](image)
**NOTE** Bridge always creates a straight-line connection between border pairs. To make the bridge connection follow a contour, apply modeling tools as appropriate after creating the bridge. For example, bridge two borders, and then use Bend on page 1165.

- **Bridge Settings** Opens the Bridge dialog on page 2339, which lets you connect pairs of borders via interactive manipulation.

- **Connect** Creates new edges between pairs of selected border edges. The edges are connected from their midpoints.
  
  You can connect only edges on the same polygon.
  
  Connect will not let the new edges cross. Thus, for example, if you select all four edges of a four-sided polygon and then click Connect, only neighboring edges are connected, resulting in a diamond pattern.

- **Connect Settings** Lets you preview the Connect and specify the number of edge segments created by the operation. To increase the mesh resolution around the new edge, increase the Connect Edge Segments setting.

- **Create Shape** After selecting one or more borders, click this button to create a spline shape or shapes from the selected edges, using the current settings from the Create Shape Settings dialog (see following).
  
  The new shape's pivot is placed at the same location as that of the Edit Poly object.

- **Create Shape Settings** Lets you preview the Create Shape function, name the shape, and set it to Smooth or Linear.

- **Edit Triangulation** Lets you modify how polygons are subdivided into triangles by drawing internal edges, or diagonals on page 8551.
  
  To edit triangulation manually, turn on this button. The hidden edges appear. Click a polygon vertex. A rubber-band line appears, attached to the cursor. Click a non-adjacent vertex to create a new triangulation for the polygon.

**TIP** For easier editing of triangulation, use the Turn command instead (see following).

- **Turn** Lets you modify how polygons are subdivided into triangles by clicking diagonals. When you activate Turn, the diagonals on page 8551 become visible as dashed lines in wireframe and edged-faces views. In Turn mode, click a
diagonal to change its position. To exit Turn mode, right-click in the viewport or click the Turn button again.

Each diagonal has only two available positions at any given time, so clicking a diagonal twice in succession simply returns it to its original position. But changing the position of a nearby diagonal can make a different alternate position available to a diagonal.

For more information on how to use Turn with the enhanced Cut tool, see this procedure on page 1368.

**Edit Geometry rollout**

For detailed descriptions of these controls, see Edit Geometry Rollout (Polymesh and Edit Poly) on page 1409.
Paint Deformation rollout

Paint Deformation lets you stroke elevated and indented areas directly onto object surfaces. For more information, see Paint Deformation Rollout (Polymesh) on page 2333.

Edit Poly (Polygon/Element)

Select an Edit Poly object. > Modify panel > Selection rollout > Polygon/Element

Select an Edit Poly object. > Modify panel > modifier stack display > Expand Edit Poly. > Polygon/Element

Select an Edit Poly object. > Quad menu > Tools 1 quadrant > Polygon/Element

A polygon is a closed sequence of three or more edges connected by a surface. Polygons provide the renderable surface of Edit Poly objects.

At the Edit Poly (Polygon) sub-object level, you can select single and multiple polygons and transform them using standard methods. This is similar for the Element sub-object level; for the distinctions between polygon and element, see Edit Poly > Selection rollout on page 1345. This topic covers the Edit Polygons/Elements rollout and Edit Geometry rollout functions for these sub-object types. For other controls, see Edit Poly Modifier on page 1332.

NOTE Workflow enhancements in the Edit Poly user interface give you a choice of editing methods. See Edit Poly Workflow on page 1339 for more information.

Interface

Edit Poly Mode rollout

See Edit Poly Mode rollout on page 1342 for information on the Edit Poly Mode rollout settings.

Selection rollout

See Selection Rollout (Edit Poly Modifier) on page 1346 for information on the Selection rollout settings.
**Soft Selection rollout**

Soft Selection controls apply a smooth falloff between selected sub-objects and unselected ones. When Use Soft Selection is on, unselected sub-objects near your selection are given partial selection values. These values are shown in the viewports by means of a color gradient on the vertices, and optionally on the faces. They affect most types of sub-object deformations, such as the Move, Rotate, and Scale functions, as well as any deformation modifiers (such as Bend) applied to the object. This provides a magnet-like effect with a sphere of influence around the selection.

For more information, see *Soft Selection Rollout* on page 2014.

**Edit Polygons/Elements rollout**

At the Element sub-object level, this rollout includes commands that are common to both polygons and elements. At the Polygon level, it contains those as well as a number more that are unique to polygons. The commands available at both levels are Insert Vertex, Flip, Edit Triangulation, Retriangulate, and Turn.

**NOTE** To delete polygons or elements, select them and press the Delete key. If *Delete Isolated Vertices* on page 1422 is off, this can result in isolated vertices; that is, vertices with no associated face geometry.

**Insert Vertex** Lets you subdivide polygons manually. Applies to polygons, even if at the element sub-object level.

After turning on Insert Vertex, click a polygon to add a vertex at that location. You can continue subdividing polygons as long as the command is active.
To stop inserting vertices, right-click in the viewport, or click Insert Vertex again to turn it off.

**Extrude** Lets you perform manual extrusion via direct manipulation in the viewport. Click this button, and then drag vertically on any polygon to extrude it.

Extruding polygons moves them along a normal and creates new polygons that form the sides of the extrusion, connecting the selection to the object.

Following are important aspects of polygon extrusion:

- When over a selected polygon, the mouse cursor changes to an Extrude cursor.
- Drag vertically to specify the extent of the extrusion, and horizontally to set the size of the base.
- With multiple polygons selected, dragging on any one extrudes all selected polygons equally.
- You can drag other polygons in turn to extrude them while the Extrude button is active. Click Extrude again or right-click in the active viewport to end the operation.
**Extrude Settings** Opens the *Extrude Polygons* dialog on page 2349, which lets you perform extrusion via interactive manipulation.

If you click this button after performing an extrusion, the same extrusion is performed on the current selection as a preview and the dialog opens with Extrusion Height set to the amount of the last manual extrusion.

**Outline** Lets you increase or decrease the outside edge of each contiguous group of selected polygons.

Outline is often used after an extrusion or bevel to adjust the size of the extruded faces. It doesn't scale the polygons; only changes the size of the outer edge. For example, in the following illustration, note that the sizes of the inner polygons remain constant.
Extruded polygons (top), outline expanded (middle), outline reduced (bottom)
Note that inner polygons do not change size.
Outline Settings Opens the Outline Polygons dialog, which lets you perform outlining by a numeric setting.

Bevel Lets you perform manual beveling via direct manipulation in the viewport. Click this button, and then drag vertically on any polygon to extrude it. Release the mouse button and then move the mouse vertically to outline the extrusion. Click to finish.

- When over a selected polygon, the mouse cursor changes to a Bevel cursor.
- With multiple polygons selected, dragging on any one bevels all selected polygons equally.
- You can drag other polygons in turn to bevel them while the Bevel button is active. Click Bevel again or right-click to end the operation.

Polygon beveled outward (left) and inward (right)

Bevel Settings Opens the Bevel Polygons dialog on page 2337, which lets you perform beveling via interactive manipulation.

If you click this button after performing a bevel, the same bevel is performed on the current selection as a preview and the dialog opens with the same settings used for the previous bevel.
**Inset** Performs a bevel with no height; that is, within the plane of the polygon selection. Click this button, and then drag vertically on any polygon to inset it.

- When over a selected polygon, the mouse cursor changes to an Inset cursor.
- With multiple polygons selected, dragging on any one insets all selected polygons equally.
- While the Inset button is active, you can drag other polygons in turn to inset them. To end the operation, click Inset again or right-click.

Inset works on a selection of one or more polygons. As with Outline, only the outer edges are affected.

**Inset Settings** Opens the Inset Polygons dialog on page 2353, which lets you inset polygons via interactive manipulation.

If you click this button after performing a manual inset, the same inset is performed on the current selection as a preview and the dialog opens with Inset Amount set to the amount of the last manual inset.

**Bridge** Connects two polygons or polygon selections on an object with a polygon “bridge.” There are two ways to use Bridge in Direct Manipulation mode (that is, without opening the Bridge Settings dialog):

- Make two separate polygon selections on the object, and then click Bridge. This creates the bridge immediately using the current Bridge settings, and then deactivates the Bridge button.
If no qualifying selection exists (that is, two or more discrete polygon selections), clicking Bridge activates the button and places you in Bridge mode. First click a polygon and move the mouse; a rubber-band line connects the mouse cursor to the clicked polygon. Click a second polygon to bridge the two. This creates the bridge immediately using the current Bridge settings; the Bridge button remains active for connecting more pairs of polygons. To exit Bridge mode, right-click the active viewport or click the Bridge button.

**Using Bridge at the Polygon level**

**NOTE** Bridge always creates a straight-line connection between polygon pairs. To make the bridge connection follow a contour, apply modeling tools as appropriate after creating the bridge. For example, bridge two polygons, and then use Bend on page 1165.

**Bridge Settings** Opens the Bridge dialog on page 2339, which lets you connect pairs of polygon selections via interactive manipulation.

**Flip** Reverses the directions of the normals of selected polygons, hence their facing.

**Hinge From Edge** Lets you perform a manual hinge operation via direct manipulation in the viewport. Make a polygon selection, click this button, and then drag vertically on any edge to hinge the selection. The mouse cursor changes to a cross when over an edge.
The hinge edge needn’t be part of the selection. It can be any edge of the mesh. Also, the selection needn’t be contiguous.

Hinging polygons rotates them about an edge and creates new polygons that form the sides of the hinge, connecting the selection to the object. It’s essentially an extrusion with rotation, with the exception that, if the hinge edge belongs to a selected polygon, that side is not extruded. The manual version of Hinge From Edge works only with an existing polygon selection.

**TIP** To avoid inadvertently hinging about a backfacing edge, turn on Ignore Backfacing.

**Hinge Settings** Opens the Hinge From Edge dialog on page 2352, which lets you hinge polygons via interactive manipulation. If you click this button after performing a manual hinge, the dialog opens with Angle set to the extent of the last manual hinge.

**Extrude Along Spline** Extrudes the current selection along a spline.
You can extrude a single polygon (1) or a selection of contiguous (2) or non-contiguous polygons (3). Extrusion 2 uses Taper Curve and Twist (available via Settings). Extrusion 3 uses Taper Amount; each extrusion has a different curve rotation.

Make a selection, click Extrude Along/On Spline, and then select a spline in the scene. The selection is extruded along the spline, using the spline’s current orientation, but as though the spline’s start point were moved to the center of each polygon or group.

**Extrude Along Spline Settings** Opens the **Extrude Polygons Along Spline dialog** on page 2347, which lets you extrude along splines via interactive manipulation.

**Edit Triangulation** Lets you modify how polygons are subdivided into triangles by drawing internal edges.
In Edit Triangulation mode, you can see the current triangulation in the viewport, and change it by clicking two vertices on the same polygon.

To manually edit triangulation, turn on this button. The hidden edges appear. Click a polygon vertex. A rubber-band line appears, attached to the cursor. Click a non-adjacent vertex to create a new triangulation for the polygon.

**Retriangulate** Lets 3ds Max automatically do its best triangulation on the polygon or polygons currently selected.

Retriangulate attempts to optimize how selected polygons are subdivided into triangles.
Turn Lets you modify how polygons are subdivided into triangles by clicking diagonals. When you activate Turn, the diagonals on page 8551 become visible as dashed lines in wireframe and edged-faces views. In Turn mode, click a diagonal to change its position. To exit Turn mode, right-click in the viewport or click the Turn button again.

Each diagonal has only two available positions at any given time, so clicking a diagonal twice in succession simply returns it to its original position. But changing the position of a nearby diagonal can make a different alternate position available to a diagonal.

For more information on how to use Turn with the enhanced Cut tool, see this procedure on page 1368.

**Edit Geometry rollout**

![Edit Geometry rollout](image)
For detailed descriptions of these controls, see Edit Geometry Rollout (Polymesh and Edit Poly) on page 1409.

**Polygon Properties rollout**

![Polygon Properties rollout](image)

These controls let you work with material IDs and smoothing groups.

**Material group**

**Set ID** Lets you assign a particular material ID to selected sub-objects for use with multi/sub-object materials on page 6120 and other applications. Use the spinner or enter the number from the keyboard. The total number of available IDs is 65,535.

**Select ID** Selects sub-objects corresponding to the Material ID specified in the adjacent ID field. Type or use the spinner to specify an ID, then click the Select ID button.

[Select By Name] This drop-down list shows the names of sub-materials if an object has a multi/sub-object material assigned to it. Click the drop arrow and choose a sub-material from the list. This selects any sub-objects assigned that material. If an object does not have a multi/sub-object material assigned, the
name list is unavailable. Likewise, if multiple selected objects have an Edit Patch, Edit Spline, or Edit Mesh modifier applied, the name list is inactive.

**NOTE** Sub-material names are those specified in the Name column on the material’s multi/sub-object Basic Parameters rollout. By default, 3ds Max assigns the material name “No Name” followed by a sequence number in parentheses. These names don't appear in the Material Editor, but they do show up in the drop-down list.

**Clear Selection** When on, choosing a new ID or material name unselects any previously selected sub-objects. When off, selections are cumulative, so new ID or sub-material name selections add to the existing selection set of patches or elements. Default=off.

**Smoothing Groups group**

Use these controls to assign selected polygons to different smoothing groups on page 8724, and to select polygons by smoothing group.

To assign polygons to one or more smoothing groups, select the polygons, and then click the number(s) of the smoothing group(s) to assign them to.

**Select By SG (Smoothing Group)** Displays a dialog that shows the current smoothing groups. Select a group by clicking the corresponding numbered button and clicking OK. If Clear Selection is on, any previously selected polygons are first unselected. If Clear Selection is off, the new selection is added to any previous selection set.

**Clear All** Removes any smoothing group assignments from selected polygons.

**Auto Smooth** Sets smoothing groups based on the angle between polygons. Any two adjacent polygons are put in the same smoothing group if the angle between their normals is less than the threshold angle, set by the spinner to the right of this button.

**[threshold]** This numeric setting (to the right of Auto Smooth) lets you specify the maximum angle between the normals of adjacent polygons that determines whether those polygons will be put in the same smoothing group.

**Paint Deformation rollout**

Paint Deformation lets you stroke elevated and indented areas directly onto object surfaces. For more information, see **Paint Deformation Rollout** on page 2333.
Edit Geometry Rollout (Polymesh and Edit Poly)

Create or select an editable poly or Edit Poly object. > Modify panel > Edit Geometry rollout

The Edit Geometry rollout provides global controls for changing the geometry of the poly object, at either the top (Object) level or the sub-object levels. The controls are the same at all levels, except as noted in the descriptions below.

Interface

- **Repeat Last**
  - Repeats the most recently used command.
  - For example, if you extrude a polygon, and want to apply the same extrusion to several others, select the others, and then click Repeat Last.
You can apply a spline extrusion of a single polygon (left) repeatedly to other single polygons (1) or to multiple polygon selections, contiguous (2) or not (3).

**NOTE** Repeat Last does not repeat all operations. For example, it does not repeat transforms. To determine which command will be repeated when you click the button, check the tooltip for the Repeat Last button on the command panel, which gives the name of the last operation that can be repeated. If no tooltip appears, nothing will happen when you click the button.

**Constraints** Lets you use existing geometry to constrain sub-object transformation. Choose the constraint type:

- **None**: No constraints. This is the default option.
- **Edge**: Constrains sub-object transformations to edge boundaries.
- **Face**: Constrains sub-object transformations to individual face surfaces.
- **Normal**: Constrains each sub-object's transformations to its normal, or the average of its normals. In most cases, this causes sub-objects to move perpendicular to the surface.

**NOTE** This constraint works like the Push modifier on page 1640, including the fact that it operates on unmodified base normals. Edited normals are unsupported.
When set to Edge, moving a vertex will slide it along one of the existing edges, depending on the direction of the transformation. If set to Face, the vertex moves only on the polygon’s surface.

**NOTE** You can set constraints at the Object level, but their use pertains primarily to sub-object levels. The Constraints setting persists at all sub-object levels.

**Preserve UVs** When on, you can edit sub-objects without affecting the object’s UV mapping. You can choose any of an object’s mapping channels to preserve or not; see Preserve UVs Settings, following. Default=off.

Without Preserve UVs, there is always a direct correspondence between an object’s geometry and its UV mapping. For example, if you map an object and then move vertices, the texture moves along with the sub-objects, whether you want it to or not. If you turn on Preserve UVs, you can perform minor editing tasks without changing the mapping.

**TIP** For best results with Preserve UVs at the vertex level, use it for limited vertex editing. For example, you’ll usually have no trouble moving a vertex within edge or face constraints. Also, it’s better to perform one big move than several smaller moves, as multiple small moves can begin to distort the mapping. If, however, you need to perform extensive geometry editing while preserving mapping, use the Channel Info utility on page 6486 instead.
Preserve UVs Settings Opens the Preserve Map Channels dialog on page 2355, which lets you specify which vertex color channels and/or texture channels (map channels) to preserve. By default, all vertex color channels are off (not preserved), and all texture channels are on (preserved).

Create Lets you create new geometry. How this button behaves depends on which level is active:

- **Object, Polygon, and Element levels**  
  Lets you add polygons in the active viewport. After you turn on Create, click three or more times in succession anywhere, including on existing vertices, to define the shape of the new polygon. To finish, right-click.
  
  While creating a polygon at the Polygon or Element level, you can delete the most recently added vertex by pressing Backspace. You can do this repeatedly to remove added vertices in reverse order of placement.
  
  You can start creating polygons in any viewport, but all subsequent clicks must take place in the same viewport.

  **TIP** For best results, click vertices in counterclockwise (preferred) or clockwise order. If you use clockwise order, the new polygon will face away from you.

- **Vertex level**  
  Lets you add vertices to a single selected poly object. After selecting the object and clicking Create, click anywhere in space to add free-floating (isolated) vertices to the object. The new vertices are placed on the active construction plane unless object snapping is on. For example, with face snapping on, you can create vertices on object faces.

- **Edge and Border levels**  
  Lets you create an edge between a pair of non-adjacent vertices on the same polygon. Click Create, click a vertex, and then move the mouse. A rubber-band line extends from the vertex to the mouse cursor. Click a second, non-adjacent vertex on the same polygon to connect them with an edge. Repeat, or, to exit, right-click in the viewport or click Create again.
  
  Edges you create separate the polygons. For example, by creating an edge inside a quadrilateral polygon, you turn it into two triangles.

Collapse (Vertex, Edge, Border, and Polygon levels only) Collapses groups of contiguous selected sub-objects by welding their vertices to a vertex at the selection center.
Using collapse on a vertex selection

Using collapse on a polygon selection

Attach lets you attach other objects in the scene to the selected poly object. After activating Attach, click an object to attach to the selected object. Attach remains active, so you can continue clicking objects to attach them. To exit, right-click in the active viewport or click the Attach button again.

You can attach any type of object, including splines, patch objects, and NURBS surfaces. Attaching a non-mesh object converts it to editable-poly format.

When you attach an object, the materials of the two objects are combined in the following way:

- If the object being attached does not have a material assigned, it inherits the material of the object it is being attached to.
Handle inherits material from the cup it is being attached to.

- Likewise, if the object you're attaching to doesn't have a material, it inherits the material of the object being attached.

- If both objects have materials, the resulting new material is a multi/sub-object material on page 6120 that includes the input materials. A dialog appears offering three methods of combining the objects' materials and material IDs. For more information, see Attach Options Dialog on page 2233.
  
  Attach remains active in all sub-object levels, but always applies to objects.

Attach List Lets you attach other objects in the scene to the selected mesh. Click to open the Attach List dialog, which works like Select From Scene on page 206 to let you choose multiple objects to attach.
Detach (sub-object levels only) Detaches the selected sub-objects and the polygons attached to them as a separate object or element(s).

With an Editable Poly object, when you click Detach, the software prompts you for the options specified on the Detach dialog. With an Edit Poly object, Detach on the Modify panel automatically uses those settings. To change them, click Detach Settings (see following).

Detach Settings Opens the Detach dialog on page 1423, which lets you set several options. Available only with Edit Poly objects; with Editable Poly, this dialog opens automatically when you click Detach.
Cut and Slice group

These knife-like tools let you subdivide the poly mesh along a plane (Slice) or in a specific area (Cut). Also see Full Interactivity on page 1422.

Slice Plane (sub-object levels only) Creates a gizmo for a slice plane that you can position and rotate to specify where to slice. Also enables the Slice and Reset Plane buttons; click Slice to create new edges where the plane intersects the geometry.

If you use Slice Plane from the modeling ribbon, the Slice, Split, and Reset Plane controls are available on the Slice Mode contextual panel on page 2098. If snapping is off, you see a preview of the slice as you transform the slice plane. To perform the slice, click the Slice button.

NOTE At the Polygon or Element sub-object level, Slice Plane affects only selected polygons. To slice the entire object, use Slice Plane at any other sub-object level, or at the object level.

Split When on, the QuickSlice and Cut operations create double sets of vertices at the points where the edges are divided. This lets you easily delete the new polygons to create holes, or animate the new polygons as separate elements.

Slice (sub-object levels only) Performs the slice operation at the location of the slice plane. Available only when Slice Plane is on. This tool slices the poly just like the “Operate On: Polygons” mode of the Slice modifier on page 1727.

Left: Using Slice; Right: After slicing and moving the pieces apart

Reset Plane (sub-object levels only) Returns the Slice plane to its default position and orientation. Available only when Slice Plane is on.
**QuickSlice** Lets you quickly slice the object without having to manipulate a gizmo. Make a selection, click QuickSlice, and then click once at the slice start point and again at its endpoint. You can continue slicing the selection while the command is active.

To stop slicing, right-click in the viewport, or click QuickSlice again to turn it off.

With Quickslice on, you can draw a line across your mesh in any viewport, including Perspective and Camera views. The mesh is sliced interactively as you move the line endpoint.

**NOTE** At the Object level, QuickSlice affects the entire object. To slice only specific polygons, use QuickSlice on a polygon selection at the Poly sub-object level.

**NOTE** At the Polygon or Element sub-object level, QuickSlice affects only selected polygons. To slice the entire object, use QuickSlice at any other sub-object level, or at the object level.

**Cut** Lets you create edges from one polygon to another or within polygons. Click at the start point, move the mouse and click again, and continue moving and clicking to create new connected edges. Right-click once to exit the current cut, whereupon you can start a new one, or right-click again to exit Cut mode.
While cutting, the mouse cursor icon changes to show the type of sub-object it’s over, to which the cut will be made when you click. The following illustration shows the three different cursor icons.

Top: Cutting to a vertex
Center: Cutting to an edge
Bottom: Cutting to a polygon

Cut is available at the object level and all sub-object levels.
NOTE You can use Cut with Turn for enhanced productivity. For more information, see this procedure on page 1368.

---

**MSmooth** Smoothes the object using the current settings. This command uses subdivision functionality similar to that of the MeshSmooth modifier on page 1505 with NURMS Subdivision, but unlike NURMS subdivision, it applies the smoothing instantly to the selected area of the control mesh.

![Smoothing a low-poly object with NURMS subdivision](image)

**MSmooth Settings** Opens the MeshSmooth Selection dialog on page 2354, which lets you specify how smoothing is applied.

**Tessellate** Subdivides all polygons in the object based on the Tessellation settings on page 2358.

Tessellation is useful for increasing local mesh density while modeling. You can subdivide any selection of polygons. Two tessellation methods are available: Edge and Face.

**Tessellate Settings** Opens the Tessellate Selection dialog on page 2358, which lets you specify how smoothing is applied.

**Make Planar** Forces all selected sub-objects to be coplanar. The plane's normal is the average surface normal of the selection.

At the Object level, forces all vertices in the object to become coplanar.
**TIP** One application for Make Planar is making a flat side on an object. Normally, you would use a contiguous selection set. If the selection includes vertices on various parts of the object, the vertices are still made planar, but with distorting effects on the rest of the geometry.

**X/Y/Z** Makes all selected sub-objects planar and aligns the plane with the corresponding plane in the object's local coordinate system. The plane used is the one to which the button axis is perpendicular; so, for example, clicking the X button aligns the object with the local YZ axis. At the Object level, makes all vertices in the object planar.

**View Align** Aligns all vertices in the object to the plane of the active viewport. At sub-object levels, this function affects only selected vertices or those belonging to selected sub-objects.

In orthographic viewports, aligning to the view has the same effect as aligning to the construction grid when the home grid is active. Aligning to a perspective viewport (including camera and light views), reorients the vertices to a plane that is parallel to the camera's viewing plane. This plane is perpendicular to the view direction that is closest to the vertices' average position.
Grid Align Aligns all vertices in the selected object to the plane of the current view. At sub-object levels, aligns only selected sub-objects.

This command aligns the selected vertices to the current construction plane. The current plane is specified by the active viewport in the case of the home grid. When using a grid object, the current plane is the active grid object.

Relax Applies the Relax function to the current selection, using the Relax dialog settings (see following). Relax normalizes mesh spacing by moving each vertex toward the average location of its neighbors. It works the same way as the Relax modifier on page 1643.

At the object level, Relax applies to the entire object. At sub-object levels, Relax applies only to the current selection.

Relax Settings Opens the Relax dialog on page 2357, which lets you specify how the Relax function is applied.

Hide Selected (Vertex, Polygon, and Element levels only) Hides selected sub-objects.

Unhide All (Vertex, Polygon, and Element levels only) Restores hidden sub-objects to visibility.

Hide Unselected (Vertex, Polygon, and Element levels only) Hides unselected sub-objects.
Named Selections (sub-object levels only)

Lets you copy and paste named selection sets of sub-objects between objects. Start by creating one or more named selection sets, copy one, select a different object, go to the same sub-object level, and then paste the set.

**NOTE** This function uses sub-object IDs, so if the target object’s geometry differs from that of the source object, the pasted selection will probably comprise a different set of sub-objects.

For more information, see Named Selection Sets on page 185.

**Copy** Opens a dialog that lets you specify a named selection set to place into the copy buffer.

**Paste** Pastes the named selection from the copy buffer.

________

Delete Isolated Vertices (Edge, Border, Polygon, and Element levels only) When on, deletes isolated vertices when you delete a selection of contiguous sub-objects. When off, deleting sub-objects leaves all vertices intact. Default=on.

**Full Interactivity (editable poly only)** Toggles the level of feedback for the QuickSlice and Cut tools, as well as all settings dialogs. Available with editable poly objects, but not the Edit Poly modifier.

When on (the default), the final result is always visible as you use the mouse to manipulate the tool or change a numeric setting. With Cut and QuickSlice, when Full Interactivity is turned off, only the rubber-band line is visible until you click. Similarly, with numeric settings in dialogs, the final result is visible only when you release the mouse button after changing the setting.

The state of Full Interactivity doesn't affect changing a numeric setting from the keyboard. Whether it's on or off, the setting takes effect only when you exit the field by pressing Tab or Enter, or by clicking a different control in the dialog.

**Align Geometry Dialog**

Select an Edit Poly object. > Modify panel > object level or any sub-object level > Animate mode > Edit Geometry rollout > Click View Align or Grid Align > Edit Poly Mode rollout > Settings button
This Edit Poly-specific dialog lets you change the alignment method after using the View Align or Grid Align function. Available only in Animate mode after using the View Align or Grid Align command.

Interface

Align to

- **View**  Aligns the selection with the view plane.
- **Construction Plane**  Aligns the selection with the active grid.

Update  Click this button to realign the selection with the designated entity after changing it. Typically you'd use this with the View option after rotating the view.

Detach Dialog

Select an Edit Poly object. > Modify panel > any sub-object level > Edit Geometry rollout > Detach Settings button

This dialog lets you specify how a sub-object selection is detached from an Edit Poly object.

By default, both Detach To Element and Detach As Clone are off. Thus, when you detach a sub-object selection, it's removed from the original object and becomes a new object. The dialog options let you keep the detached item as an element of the original object and/or detach it as a copy of the original selection.
NOTE When you detach a vertex or an edge, any adjacent polygons are detached as well. Also, a detached item remains in its original location.

NOTE Any Detach dialog settings you change are saved as program defaults automatically.

Interface

**Detach as** Lets you assign a name to the new object. By default, the name is "Object" followed by a sequence number.

This option is unavailable when Detach To Element is on.

**Detach To Element** The detached sub-object selection remains as part of the original object, but becomes a new element. It can then be manipulated independently at the Element sub-object level. Default=off.

**Detach As Clone** Detaches the selection as a copy of the original selection; the latter remains intact. Default=off.

**Edit Spline Modifier**

Create or select a spline > Modify panel > Object–Space Modifiers > Edit Spline

Create or select a spline > Modifiers menu > Patch/Spline Editing > Edit Spline

The Edit Spline modifier provides explicit editing tools for different levels of the selected shape: vertex, segment, or spline. The Edit Spline modifier matches all the capabilities of the base Editable Spline object, with the exceptions noted below. For a complete parameter reference, see *Editable Spline* on page 620.
The Rendering and Interpolation rollouts found in Editable Spline, which allow manipulation of the spline's creation parameters, are not available in the Edit Spline modifier. (The creation parameters are available in the modifier stack on page 8187 for a spline to which Edit Spline is applied.) In addition, the direct vertex animation capabilities of Editable Spline are not possible in Edit Spline.

When possible, it's far more efficient and reliable to perform explicit editing at the Editable Spline level rather than store those edits within the Edit Spline modifier. The Edit Spline modifier must copy the geometry passed to it, and this storage can lead to large file sizes. The Edit Spline modifier also establishes a topological dependency that can be adversely affected if earlier operations change the topology being sent to it.

There are, however, situations where using Edit Spline is the preferred method.

- You want to edit a parametric shape as a spline, but want to retain the ability to modify its creation parameters after the edit.
- You want to store your edits temporarily within Edit Spline until you are satisfied with the results, before committing them permanently to an editable spline object.
- You need to make edits across several shapes at once, but do not want to convert them to a single editable spline object.
- You have a modifier in the stack that must stay parametric, and the resulting spline must be edited after the modifier is applied.

**Extrude Modifier**

Select a shape. > Modify panel > Modifier List > Object-Space Modifiers > Extrude

Select a shape. > Modifiers menu > Mesh Editing > Extrude

The Extrude modifier adds depth to a shape and makes it a parametric object.
Above: Spline before extrusion
Below left: Extruded spline with Cap End off
Below right: Extruded spline with Cap End on
**Interface**

Amount Sets the depth of the extrusion.

Segments Specifies the number of segments that will be created in the extruded object.

**Capping group**

Cap Start Generates a flat surface over the start of the extruded object.

Cap End Generates a flat surface over the end of the extruded object.

Morph Arranges cap faces in a predictable, repeatable pattern, which is necessary for creating Morph targets on page 667. Morph capping can generate long, thin faces that don't render or deform as well as grid capping. Use morph capping primarily if you're extruding multiple morph targets.

Grid Arranges cap faces in a square grid trimmed at the shape boundaries. This method produces a surface of evenly sized faces that can be deformed easily by other modifiers. When you choose the Grid capping option, the grid lines are hidden edges rather than visible edges. This primarily affects any
objects assigned a material with the Wire option turned on, or any objects that use the Lattice modifier on page 1479.

**Output group**

**Patch** Produces an object that you can collapse to a patch object; see Editing the Stack on page 1049.

**Mesh** Produces an object that you can collapse to a mesh object; see Editing the Stack on page 1049.

**NURBS** Produces an object that you can collapse to a NURBS surface; see Editing the Stack on page 1049.

---

**Generate Mapping Coords** Applies mapping coordinates to the extruded object. Default=off.

When on, Generate Mapping Coordinates applies separate mapping coordinates to the end caps, placing a single 1 x 1 tile on each cap.

**Real-World Map Size** Controls the scaling method used for texture mapped materials that are applied to the object. The scaling values are controlled by the Use Real-World Scale settings found in the applied material’s Coordinates rollout on page 6201. Default=on.

**Generate Material IDs** Assigns different material IDs to the sides and the caps of the extruded object. Specifically, the sides receive ID 3, and the caps receive IDs 1 and 2.

This check box is turned on as a default when you create an extruded object, but if you load an extruded object from a MAX file, the check box is turned off, maintaining the same material ID assignment for that object as it had in R1.x.

**Use Shape IDs** Uses the material ID values assigned to segments in the spline on page 577 you extruded, or curve sub-objects in the NURBS on page 2416 curve you extruded.

**Smooth** Applies smoothing to the extruded shape.

---

**Face Extrude Modifier**

Modify panel > Select one or more faces of a mesh object. > Modifier List > Face Extrude
Modify panel > Select one or more faces of a mesh object. > Modifiers menu > Mesh Editing > Face Extrude

The Face Extrude modifier extrudes faces along their normals, creating new faces along the sides of the extrusion that connect the extruded faces to their object. As with most modifiers, this affects the current face selection passed up the stack. There are various differences between the Face Extrude modifier and the Face Extrude function in an editable mesh on page 2192, especially the fact that all parameters in the Face Extrude modifier are animatable.

Faces extruded on the top and along the edge of the object
Interface

Modifier Stack

**Extrude Center** At this sub-object level, you can select and move (or animate) the center point. This affects the geometry only if you turn on Extrude From Center.

For more information on the stack display, see Modifier Stack on page 8187.

**Parameters rollout**

**Amount** Determines the extent of the extrusion. You can adjust and readjust the Amount spinner as often as you choose. To extrude a second level, apply another Face Extrude modifier.

**Scale** Scales each cluster of selected faces independently about its center.

**NOTE** By using multiple extrude modifiers with Scale, you can achieve a bevel effect.

**Extrude From Center** Extrudes each vertex radially from the center point.
The direction in which the faces are extruded is slightly different than Face Extrude in the editable mesh. Each vertex is displaced in the direction of the average surface normal of selected faces that share that vertex. So each vertex may move in a slightly different direction. Put another way, each vertex is extruded in the direction of the surface normal at the point on the surface where that vertex lies.

**FFD (Free-Form Deformation) Modifiers**

Modify panel > Make a selection. > Modifier List > Object-Space Modifiers > FFD 2x2x2, FFD 3x3x3, or FFD 4x4x4

Make a selection. > Modifiers menu > Free Form Deformers > FFD 2x2x2, FFD 3x3x3, or FFD 4x4x4

FFD stands for Free-Form Deformation. Its effect is used in computer animation for things like dancing cars and gas tanks. You can use it as well for modeling rounded shapes such as chairs and sculptures.

The FFD modifier surrounds the selected geometry with a lattice. By adjusting the control points of the lattice, you deform the enclosed geometry.

FFD deformation creates a bulge in the snake.
There are three FFD modifiers, each providing a different lattice resolution: 2x2, 3x3, and 4x4. The 3x3 modifier, for example, provides a lattice with three control points across each of its dimensions or nine on each side of the lattice.

There are also two FFD-related modifiers that provide supersets of the original modifiers; see FFD (Box/Cyl) modifier on page 1436. With the FFD (Box/Cyl) modifiers, you can set any number of points in the lattice, which makes them more powerful than the basic FFD modifier.

**Animating FFD Control Points and the Master Point Controller**

Turn on the Auto Key button and move the lattice points to animate an FFD and any underlying geometry. When you animate FFD control points, a Master Point Controller is created automatically. In Track View the master controller allows you to move multiple animated control points in time by simply moving one master key (master keys display green in Track View).

**Procedures**

To use an FFD modifier:

1. Select the geometry. This can be the whole object, or you can use a Mesh Select modifier to select a portion of the object’s vertices.
2. Apply the FFD 2X2, FFD 3X3, or FFD 4X4 modifier, depending on the resolution of the lattice you want.
   An orange lattice gizmo surrounds the geometry.
3. In the modifier stack display, choose the Control Points sub-object level, and then move the control points of the lattice to deform the underlying geometry. To animate the deformation, turn on Auto Key.

The lattice volume defaults to the bounding box of the selected geometry. However, you can position, rotate, and/or scale the lattice box so that it modifies only a subset of vertices. Choose the Lattice sub-object level, and then use any of the transform tools to adjust the lattice volume relative to the geometry.
Interface

Modifier Stack

**Control Points** At this sub-object level, you can select and manipulate control points of the lattice, one at a time or as a group (select multiple points using standard techniques). Manipulating control points affects the shape of the underlying object. You can use standard transformation methods with the control points. If the Auto Key button is turned on when modifying the control points, the points become animated.

**Lattice** At this sub-object level, you can position, rotate, or scale the lattice box separately from the geometry. If the Auto Key button is turned on, the lattice becomes animated. When you first apply an FFD, its lattice defaults to a bounding box surrounding the geometry. Moving or scaling the lattice so that only a subset of vertices lies inside the volume makes it possible to apply a localized deformation.

**Set Volume** At this sub-object level, the deformation lattice control points turn green, and you can select and manipulate control points without affecting the modified object. This lets you fit the lattice more precisely to irregular-shaped objects, giving you finer control when deforming.

Set Volume essentially lets you set the initial state of the lattice. If you use it after you have animated a control point or when the Auto Key button is turned on, then it works the same as at the Control Points sub-object level, deforming the object as you manipulate points.

For more information on the stack display, see Modifier Stack on page 8187.

FFD (Free-Form Deformation) Modifiers | 1433
**Display group**

Affects the display of the FFD in the viewports.

**Lattice** Draws lines connecting the control points to make a grid. Although the viewports can sometimes become cluttered when these lines are drawn, it helps to visualize the lattice.

**Source Volume** Displays the control points and lattice in their unmodified state. When you're in the Lattice selection level, this helps to position the source volume.
To see which points lie in the source volume (and therefore will be deformed), temporarily deactivate the modifier by clicking to turn off the light bulb icon in the modifier stack display.

**Deform group**

**Only in Volume** Deforms vertices that lie inside the source volume. Default=on.

**All Vertices** Deforms all vertices, regardless of whether they lie inside or outside the source volume.

The deformation outside the volume is a continuous extrapolation of the deformation inside the volume. The deformation can be extreme for points far away from the source lattice.

**Control Points group**

**Reset** Returns all control points to their original positions.

**Animate All** Assigns Point3 controllers to all control points so that they're immediately visible in Track View.

By default the control points of an FFD lattice don't appear in Track View because they don't have controllers assigned to them. But when a control point is animated, a controller is assigned to it and becomes visible in Track View. With Animate All, you can add and delete keys and perform other key operations.

**Conform to Shape** Moves each FFD control point to the intersection of the modified object with a straight line extending between the object's center to the control point's original location, plus an offset distance specified by the Offset spinner.

**NOTE** Conform to Shape works best with regular shapes, such as primitives. It's less effective if the object has degenerate (long, narrow) faces or sharp corners. All the controls are unavailable with shapes, because there are no faces to intersect with.

**Inside Points** Only control points inside the object are affected by Conform to Shape.

**Outside Points** Only control points outside the object are affected by Conform to Shape.

**Offset** The distance by which control points affected by Conform to Shape are offset from the object surface.
About Displays a dialog with copyright and licensing information.

**FFD (Box/Cylinder) Modifiers**

Modify panel > Make a selection. > Modifier List > Object-Space Modifiers > FFD(box) or FFD(cyl)

Make a selection. > Modifiers menu > Free Form Deformers > FFD Box or FFD Cylinder

FFD stands for Free-Form Deformation. Its effect is used in computer animation for things like dancing cars and gas tanks. You can use it as well for modeling rounded shapes such as chairs and sculptures.

The FFD modifier surrounds the selected geometry with a lattice box. By adjusting the control points of the lattice, you deform the enclosed geometry. With the Auto Key button turned on, you can animate the lattice points, and thus the deformation of the geometry.

![FFD deformation creates a bulge in the snake.](image)

1436 | Chapter 9  Modifiers
With the FFD(box) and FFD(cyl) modifiers you can create box-shaped and cylinder-shaped lattice free-form deformation objects. Both are available as object modifiers and as space warps.

The source lattice of an FFD modifier is fitted to the geometry it's assigned in the stack. This can be a whole object, or a sub-object selection of faces or vertices.

**Interface**

**Modifier Stack**

![Modifier Stack](image)

**Control Points** At this sub-object level, you can select and manipulate control points of the lattice, one at a time or as a group (select multiple points using standard techniques). Manipulating control points affects the shape of the underlying object. You can use standard transformation methods with the control points. If the Auto Key button is turned on when modifying the control points, the points become animated.

**Lattice** At this sub-object level, you can position, rotate, or scale the lattice box separately from the geometry. If the Auto Key button is turned on, the lattice becomes animated. When you first apply an FFD, its lattice defaults to a bounding box surrounding the geometry. Moving or scaling the lattice so that only a subset of vertices lie inside the volume makes it possible to apply a localized deformation.

**Set Volume** At this sub-object level, the deformation lattice control points turn green, and you can select and manipulate control points without affecting the modified object. This lets you fit the lattice more precisely to irregular-shaped objects, giving you finer control when deforming.

Set Volume essentially lets you set the initial state of the lattice. If a control point is already animated or the Animate button is turned on, then Set Volume works the same as at the Control Points sub-object level, deforming the object as you manipulate points.

For more information on the stack display, see Modifier Stack on page 8187.
Dimensions group

Adjusts the unit dimensions of the source volume and specifies the number of control points in the lattice. Note that the point dimensions also show up beside the modifier name in the stack list.

Lattice dimensions The text displays the current number of control points in the lattice (for example 3x4x4).

Set Number of Points Displays a dialog containing three spinners labeled Length, Width, and Height, plus OK/Cancel buttons. Specify the number of control points you want in the lattice, and then click OK to make the change.

WARNING Make changes to the lattice dimensions before you adjust the positions of the lattice control points. When you change the number of control points with this dialog, you lose any adjustments you've already made to the control points. (You can undo this dialog.)

Display group

Affects the display of the FFD in the viewports.

Lattice Draws lines connecting the control points to make a grid. Although the viewports can sometimes become cluttered when these extra lines appear, they help to visualize the lattice.

Source Volume Displays the control points and lattice in their unmodified state. This is an important display when you're adjusting the source volume to affect specific vertices that lie inside or outside it.

TIP To see which points lie in the source volume (and therefore will be deformed), temporarily deactivate the modifier by clicking to turn off the light bulb icon in the modifier stack display.

Deform group

Provides controls that specify which vertices are affected by the FFD.

Only In Volume Deforms vertices that lie inside the source volume. Vertices outside the source volume are not affected.

All Vertices Deforms all vertices regardless of whether they lie inside or outside the source volume depending on the value in the Falloff spinner. The deformation outside the volume is a continuous extrapolation of the deformation inside the volume. Note that the deformation can be extreme for points far away from the source lattice.
Falloff Determines the distance from the lattice that the FFD effect will decrease to zero. Available only when you choose All Vertices. When set to 0, it's effectively turned off, and there is no falloff. All vertices are affected regardless of how far they are from the lattice. The units of the Falloff parameter are actually specified relative to the size of the lattice. A falloff of 1 means that the effect will go to 0 for points that are a lattice width/length/height away from the lattice (depending on which side they are).

Tension/Continuity Adjusts the tension and continuity of the deformation splines. Although you can't actually see the splines in an FFD, the lattice and control points represent the structure that controls the splines. As you adjust the control points, you alter the splines (which move through each of the points). The splines, in turn, deform the geometry of the object. By altering the tension and continuity of the splines, you alter their effect on the object.

Selection group

Provides additional methods of selecting the control points. You can toggle the state of any combination of the three buttons to select in one, two, or three dimensions at once.

All X, All Y, All Z Selects all control points along the specified local dimension when you select a control point. By turning on two buttons, you can select all control points in two dimensions.

Control Points group

Reset Returns all control points to their original positions.

Animate All By default, the control points of an FFD lattice don't appear in Track View because they don't have controllers assigned to them. But when you animate a control point, a controller is assigned and it becomes visible in Track View. You can also add and delete keys and perform other key operations. Animate All assigns Point3 controllers to all control points so that they're immediately visible in Track View.

Conform to Shape Moves each FFD control point to the intersection of the modified object with a straight line extending between the object's center to the control point's original location, plus an offset distance specified by the Offset spinner.
NOTE Conform to Shape works best with regular shapes, such as primitives. It’s less effective if the object has degenerate (long, narrow) faces or sharp corners. All the controls are unavailable with shapes, because there are no faces for the lattice to intersect with.

**Inside Points** Only control points inside the object are affected by Conform to Shape.

**Outside Points** Only control points outside the object are affected by Conform to Shape.

**Offset** The distance by which control points affected by Conform to Shape are offset from the object surface.

**About** Displays a dialog with copyright and licensing information.

### FFD (Free-Form Deformation) Select Modifier

Select an FFD space warp. > Modify panel > Modifier List > FFD Select

Select an FFD space warp. > Modifiers menu > Selection Modifiers > FFD Select

The FFD Select modifier works on an FFD (Box) Space Warp on page 2962 or FFD (Cyl) Space Warp on page 2969 to change the selection of its control points, and pass the selection up the stack.

The space-warp versions of the FFD modifiers provide sub-object geometry that you can manipulate in the stack. For example, you can apply a Bend modifier on page 1165 to an FFD space warp, bend its control points, and thus bend the object to which the space warp is bound. Using the FFD Select modifier, you can select a sub-object pattern of control points, and then use the subsequent modifier(s) to deform the selected points.

The FFD Select modifier is especially useful for assigning Linked XForm modifiers on page 1484 to portions of an FFD space warp.

#### Procedures

**Example: To use the Linked XForm modifier with an FFD space warp:**

1. Create an object, an FFD space warp (such as FFD (Box) on page 2962), and a couple of dummies on page 2840.
2. Bind the FFD space warp to the object you want to deform.
3. Select the FFD space warp and apply an FFD Select modifier.
4 At the Control Points sub-object level, select the control points you want to use to affect the object.

5 Apply a Linked XForm modifier, and then pick one of the dummies as a control object.

6 Apply another FFD Select modifier, and make a different selection of control points.

7 Apply another Linked XForm modifier and assign the other dummy as a control object.

8 You can now move either of the dummy objects to both translate the linked control points in the FFD space warp, and to deform the target object.

**Interface**

![FFD Select](image)

**All X/All Y/ All Z** Select the control points corresponding to the specified axis plane.
First click a selection button, and then select FFD control points in the viewports.

**Fillet/Chamfer Modifier**

Select a shape. > Modify panel > Modifier List > Object-Space Modifiers > Fillet/Chamfer
Select a shape. > Modifiers menu > Patch/Spline editing > Fillet/Chamfer
The Fillet/Chamfer modifier lets you fillet or chamfer the corners between linear segments of Shape objects on page 8720. Fillet rounds corners where segments meet, adding new control vertices. Chamfer bevels corners, adding another vertex and line segment. Note that this modifier works on the splines at the sub-object level of the shape. It does not work between two or more independent shape objects.
When you apply Fillet/Chamfer, you're placed in a Vertex sub-object selection level. You can select (and move) any vertex, but only Corner vertices and Bezier Corner vertices are valid for fillet and chamfer functions. In addition, both segments connected by a Bezier Corner vertex must be linear rather than curved.

There are two methods for applying either fillets or chamfers:

- Select one or more valid corner vertices, and then adjust either the Radius spinner to fillet the selected corners, or the Distance spinner to chamfer the corners.

- You can preset the Radius or Distance values, and then select one or more valid corner vertices, and click one of the Apply buttons to apply the specified value to the selected vertices.

**NOTE** As of version 3 of 3ds Max, Edit/Editable Spline on page 634 includes interactive fillet/chamfer functions. The only reason to use this modifier is to apply it at a specific location on the stack.

Star with selected vertices
Procedures

Example: To fillet/chamfer a star:

1. Create a Star shape on page 599.
2. Apply a Fillet/Chamfer modifier.
3. Select one or more of the star’s vertices.
4. Adjust the parameters to achieve different effects.
Interface

Fillet group

Radius Specifies the radius of the filleted corner.

Apply Applies the value specified in the Radius spinner to selected vertices. For example, before selecting any vertices, set the Radius to the desired value, then select your vertices and click Apply to fillet the selection with the specified radius.

Chamfer group

Distance Specifies the distance of the new vertices from the original corner vertex.

Apply Applies the value specified in the Distance spinner to selected vertices. For example, before selecting any vertices, set Distance to the desired value, then select your vertices and click Apply to chamfer the corners.

Flex Modifier

Select a Mesh, Patch, or NURBS object. > Modify panel > Modifier List > Object-Space Modifiers > Flex

Select a Mesh, Patch, or NURBS object. > Modifiers menu > Animation Modifiers > Flex Modifier

The Flex modifier simulates soft-body dynamics using virtual springs between an object's vertices. You can set the springs' stiffness, or how actively they
keep vertices from coming close to each other, as well as stretch, or how far apart they can move. At its simplest, this system causes vertices to lag behind an object as it moves. At a more advanced level, you can also control the sway, or how much the spring angle can change.

Flex causes the tongue to wag as the head rotates.

Flex works with NURBS, patches, meshes, shapes, FFD space warps, and any plug-in-based object types that can be deformed. You can combine Flex with space warps on page 2887 such as Gravity, Wind, Motor, Push, and PBomb to add realistic, physically based animation to an object. In addition, you can apply deflectors to soft-body objects to simulate collision.

NOTE The Flex modifier is aware of vertex/control-point motion in any animated modifier that deforms points below Flex in the modifier stack, such as the Morpher modifier on page 1518. Use this to simulate soft body motion on a morphed or otherwise deform-animated object.

TIP To change the center of the flex effect, after applying the Flex modifier to an object or sub-object selection, choose the Flex modifier's Center sub-object and use Move.
TIP  Using Flex’s advanced capabilities can significantly impede real-time playback. To improve performance in such cases, use the **Point Cache modifier** on page 1574 to record the vertex animation to disk, and then play it back using the cache.

The antennae, with the Flex modifier applied, move around like springs reacting to the motion of the character’s head.

**Surfaces Influenced by the Flex Modifier**

- On a mesh surface, the Flex modifier influences every vertex.
- On a patch surface, the Flex modifier influences both control points and tangent handles. Flex unlocks tangent handles and moves them independently.
- On a NURBS surface, Flex influences control vertices (CVs) or points.
- On a Spline (shape), the Flex modifier influences both control points and tangent handles.
- On an FFD Space Warp, the Flex modifier influences control points.
Effects

You can apply space warps to the Flex modifier. For example, you can add Wind on page 2926 to animate plants and trees, or a waving flag. In such cases, you don't need to create keyframes to see the effects; the space warp alone can animate the surface.

Character Animation

Use Flex above the Skin modifier on page 1667 to add secondary motion to a character animated with Bones, or above the Physique modifier to add secondary motion to a character animated with Biped.

Procedures

Example: To paint on weights:

1. Create a sphere on the left side of the Top viewport.
2. Turn on Auto Key and move the time slider to frame 50.
3. In the Top viewport, move the sphere to the right side of the viewport.
4. Turn off Auto Key.
5. On the Modify panel, click Modifier List, and then choose Flex. The Flex modifier is applied to the sphere.
6. Click Play. The sphere flexes around the Transform gizmo evenly.
7. Open the Flex modifier hierarchy in the stack display, and click Weights & Springs. This enables modification of the Weights & Springs sub-object settings.
8. In the Paint Weights group, turn on Paint.
9. In the Left viewport, paint on the lower part of the sphere. The vertex color changes as the vertex weight changes. Yellow vertices are more rigid, blue vertices are less rigid.
TIP  You can change Flex vertex colors through Customize menu > Customize User Interface > Colors > Elements=Geometry > Subselection Hard/Medium/Soft.

10 Click Play.
The sphere wobbles on one side more than the other.
If the Strength setting in the Paint Vertex group is a positive value, you paint rigidity. If the values are negative, you paint flexibility.
To reverse the effect, paint with negative Strength values.

Example: To use wind as a force:

1 In the Top viewport, create a sphere.

2 On the Create panel, click Space Warps, and then, if necessary, choose Forces from the drop-down list.

3 Click Wind, and then click and drag in the Front viewport to create a wind gizmo.

4 On the Wind Parameters rollout, set Strength and Turbulence to 4.

5 Select the Sphere.

6 Apply the Flex modifier.

7 On the Modify panel > Parameters rollout, set Samples to 1.

8 On Forces and Deflectors rollout > Forces group, click the Add button, and then select the Wind gizmo in the viewports.

9 Click Play.
The sphere undulates in the wind. The Advanced Parameters rollout > Reference Frame setting determines the frame where the force(s) in the list take effect.
You can also use this example to see how the Chase Springs option works.
10 Turn off Chase Springs and click Play again.

The sphere keeps moving in the direction the wind is blowing without "bouncing" back. That's because the chase springs, which attempt to return the object to its original shape, are no longer in effect.

To add custom springs:

1 Apply Flex to an object and go to the Weights & Springs sub-object level. The Flex vertices appear at object vertices in the viewports.

2 On the Advanced Springs rollout, turn on Show Springs.

3 Click the Options button and in the Spring Option dialog on page 1462, choose how you want to add springs. Exit the Spring Option dialog.

4 Select vertices according to the options. For instance, if you want to add one Hold Shape spring between two vertices, select both vertices.

5 Click Add Spring. The new spring or springs appear. Edge springs are blue and Hold Shape springs are red.

Example: To create a swinging rope:

1 Use Create menu > Space Warps to add a Drag and a Gravity space warp in the Top viewport.

2 Use Create menu > Shapes > Line to create a line with ten vertices spaced evenly in the top viewport.

3 In the Modify panel, turn on Vertex sub-object and select all the vertices except the first vertex.

4 Add the Flex modifier.

5 In the modifier stack view, open Weights and Springs sub-objects.

6 Turn off Use Chase Springs.

7 Turn off Use Weights.

8 Set the solver to Runge-Kutta4.

9 Set Samples to 5.
10 In a viewport, select all the points on the spline.
11 In the Advance Springs rollout, click the Option button.
12 In the dialog, turn on Hold Edge Length Springs and click OK.
13 Click Add Springs.
14 On the Forces and Deflectors rollout, add Gravity and Drag in the Forces group.
15 Click Play.
   The spline resembles a swinging rope.

Example: To create cloth draping on a sphere:

1 Use Create menu > Space Warps to add a Drag and a Gravity space warp in the Top viewport.
2 Use Create menu > Space Warps > Deflectors > SDeflector to create a spherical deflector. Set Bounce to 0 and Friction to 100. Place the deflector below Z=0.
3 Use Create menu > Geometry > Standard Primitives > Plane to create a 20 x 20 plane in the Top viewport. It should be above the spherical deflector.
4 Apply a Mesh Select modifier to the plane.
5 In the Top viewport, select all the vertices except for the leftmost column.
6 Apply the Flex modifier to the plane.
7 Turn off Use Chase Springs and Use Weights.
8 Set Samples to 3.
9 Click Create Simple Soft Body.
10 In the Forces and Deflectors rollout, add the Gravity and Drag forces.
11 In the Forces and Deflectors rollout, add the spherical deflector.
12 Click Play.
   The plane drapes over the spherical deflector like cloth.
Interface

Modifier Stack

These modifier sub-object levels are available in the stack display by opening the modifier hierarchy (click the + icon to the left of the modifier name).

Center Move the Transform gizmo in the viewports to set the center of the effect.

The flex effect increases as the distance between the center and a vertex increases.

Edge Vertices Select vertices in the viewports to control the falloff and direction of the flex effect.

Selected vertices flex less than unselected vertices.

Weights & Springs Use the Weights And Painting rollout controls to select and deselect vertices for subsequent operations on the Weights And Painting rollout and the Advanced Springs rollout.

You can paint weights at any sub-object level, and add and remove springs at any sub-object level (or even at the Flex modifier object level), but while a Weights & Springs selection is active, only the selected vertices are affected.
Parameters rollout

**Flex** Sets the amount of flex and bend. Range=0 to 1000; Default=1.
This value represents the amount of the flexed animation that is used; the flexed animation is determined by other factors such as motion and vertex weighting. The default setting of 1 causes the flexed animation to occur unmodified; higher settings cause unnaturally high amounts of stretching, and lower settings cause diminished stretching.

**Strength** Sets the overall spring strength of the chase springs.
A value of 100 is rigid. Range=0 to 100; Default=3.

**Sway** Sets the time for the object to come to rest for chase springs.
Lower values increase the time for the object to come to rest. Range=0 to 100; Default=7.

**Use Chase Springs** When on, enables chase springs, which force the object to return to its original shape. When off, no chase springs are used, and the amount by which vertices move depends only on their weights. Default=on.
Typically, for soft-body simulations when you want objects to be influenced by forces and deflectors, you would turn off Use Chase Springs.

**Use Weights** When on, Flex recognizes the different weights assigned to an object's vertices, applying different amounts of flexing accordingly. When off, the flex effect applies itself to the object as a monolithic whole. Default=on.
Typically, for soft-body simulations when you want objects to be influenced by forces and deflectors, you would turn off Use Weights.
**Solver Type** Choose a solver for the simulation from the drop-down list. The three choices are Euler, Midpoint, and Runge-Kutta4. Midpoint and Runge-Kutta4 require successively more computation than Euler, but are more stable and accurate. Default=Euler.

**TIP** In most cases, you can use Euler successfully, but if unexpected object deformations occur during a simulation, try using one of the more accurate solver types. Specifically, you might need to use Midpoint or Runge-Kutta4 with higher Stretch and Stiffness settings.

**Samples** The number of times per frame the Flex simulation is run at equal time intervals. The more samples you take, the more accurate and stable the simulation. When using the Midpoint or Runge-Kutta4 solver, you might not need as many samples as with Euler. Default=5.

**TIP** If your simulation produces unexpected results, such as object vertices moving to seemingly random locations, try increasing the Samples setting.

**Simple Soft Bodies rollout**

Let 3ds Max determine spring settings for the entire object automatically. Alternatively, you can use the Advanced Springs on page 1460 rollout settings to specify spring settings between each pair of vertices.

**Create Simple Soft Body** Generates spring settings for the object based on the Stretch and Stiffness settings.

**NOTE** After you use Create Simple Soft Body, you can change the Stretch and Stiffness settings without having to click the button again; the changes take effect immediately.
**Stretch** Determines how much object edges can elongate. When Advanced Springs rollout > Enable Advanced Springs is off, the Stretch setting is linked to the Advanced Springs rollout > Stretch Str. and Stretch Sway settings.

**Stiffness** Determines how rigid the object is. When Advanced Springs rollout > Enable Advanced Springs is off, the Stretch setting is linked to the Advanced Springs rollout > Shape Str. and Shape Sway settings.

The differences between Stretch and Stiffness are subtle, and understanding them is further complicated by the fact the two affect each other. In addition, how they work depends on object topology. For example, say you create a box, add a Flex modifier, apply Create Simple Soft Body, and then set a high Stretch value and a low Stiffness value. If you use the box in a Flex-based dynamics simulation, such as dropping it onto a surface (deflector) with gravity, you might expect the box to fall over and flatten out. But instead, because of the box’s topology, which causes Create Simple Soft Body to apply a relatively small number of shape springs, you’d actually get better results with a low Stretch value and a high Stiffness value. However, if you use a sphere of eight segments instead, you’ll get the collapsing behavior with the default Stretch and Stiffness settings, and as expected, increasing rigidity with higher Stiffness settings.

In soft-body simulations, such as the above-cited example of dropping an object onto a surface, particularly with dense meshes, you might get better results by applying the mesh to an FFD space warp that’s bound to the object. If the object’s shape isn’t suitable for use with the space warp, you might have to instead use the **Advanced Springs** on page 1460 rollout settings to apply springs manually. In such cases, you should create shape springs between opposite vertices rather than adjacent ones.

Cloth-like animation usually works best with a high Stretch setting and a low Stiffness setting. For soft bodies, you would usually use high settings for both Stretch and Stiffness, depending on how "squishy" you want the object to be.
Weights and Painting rollout

When you first apply Flex to an object, the modifier automatically sets a weight for each vertex based on its distance from the modifier’s center. The higher a vertex weight, the less prone it is to being affected by Flex effects. The modifier applies the highest weights to vertices closest to its center, and the lowest weights to vertices farthest from the center. So, for example, with a cylinder whose pivot point is at the base, you’ll get the greatest amount of flexing at the top. But with a sphere, all of whose vertices are equidistant from the pivot point (center), all vertices have, by default, equal weight values.

The Paint Weights controls let you use a spherical brush with adjustable radius and falloff to change vertex weights in the viewports, thus controlling the amount of lag. The Vertex Weights controls let you apply absolute or relative weighting to single vertices or groups of vertices.

Paint Weights group

Paint At any sub-object level, click Paint, and then drag the cursor over the mesh in the viewports to "paint" vertex weights using the current Strength and Feather settings. Vertex colors changes to reflect the new vertex weight. Painting changes vertex weights relative to their current values; it does not apply an absolute weight. Longer strokes over an area of the mesh will increase or decrease vertex weights more than short strokes, and repeated strokes over the same area will cause incremental changes in weight values unless they’re already at their extremes.
The vertex coloring shown at any Flex sub-object level provides an approximate indication of weighting. The colors are determined by the settings in Customize menu > Customize User Interface > Colors tab > Elements: Geometry. In this list are three color entries: Subselection Hard, used to display vertices with the highest Weight values; Subselection Medium, used to display vertices with medium Weight values; and Subselection Soft, used to display vertices with low Weight values.

**Strength** Sets the amount by which painting changes weight values. Higher values change weighting more quickly. At Strength=0, painting does not change weight values. Range=–1 to 1; Default=0.1. Negative values allow you to remove weight.

**TIP** When painting, you can use the Alt key to invert the strength.

**Radius** Sets the size of the brush in world units. Range=0.001 to 99999; Default=36.

**NOTE** If you position the mouse cursor over the object before painting, you can see a wireframe representation of the spherical “brush” that depicts the Radius setting.

**Feather** Sets the falloff in strength from the center of the brush to its edge. Default=0.7. Range=0.001 to 1. Vertices at the center of the brush are always changed by the full amount of the Strength setting, but the higher the Feather setting, the less vertices closer to the edge change. At the lowest setting, all vertices inside the radius are changed equally.

**Vertex Weights group**

Sets vertex weighting manually. At the Weights & Springs sub-object level, select vertices in the viewports, and then change the value of the Vertex Weight parameter. Alternatively, turn on Absolute Weight, set the desired Vertex Weight, and then select vertices to set; changes are immediate.

**Absolute Weight** Turn on to assign absolute weights to the selected vertices. Turn off to add or remove weight based on the Vertex Weight setting.

**Vertex Weight** Assigns weight to selected vertices.
Depending on the state of the Absolute Weight parameter, weight assignment is either absolute or relative.
NOTE  The Vertex Weight range is -100 to 100. With Absolute Weight on, the negative Vertex Weight settings have no effect; the effective range is 0 to 100. With Absolute Weight off, changing the Vertex Weight setting adds the amount to the current weights of selected vertices, and then the setting is reset to 0.

Forces and Deflectors rollout

Forces group

Use these controls to add space warps in the Forces category to the Flex modifier. Supported space warps are:

- Displace on page 2930
- Drag on page 2908
- Gravity on page 2923
- Motor on page 2898
List Window Displays particle space warps applied to the Flex modifier.

Add Click this, and then select a particle space warp in the viewports to add the effect to Flex. The added space warp displays in the list window.

Remove Select a space warp in the list and click Remove to remove the effect from Flex.

Deflectors group

Using deflectors with Flex lets object movement be impeded by surfaces. This lets you simulate collisions with soft-body objects. For best results with collisions, in the deflector settings use a low value for Bounce and a high value for Friction.

Supported deflectors are:
- POmniFlect on page 2935
- SOmniFlect on page 2946
- UOmniFlect on page 2948
- UDeflector on page 2956
- SDeflector on page 2953
- Deflector on page 2959

List Window Displays deflectors applied to the Flex modifier.

Add Click this, and then select a deflector in the viewports to add the effect to Flex. The added deflector displays in the list window.

Remove Select a deflector in the list and click Remove to remove the effect from Flex.
Advanced Parameters rollout

Reference Frame Sets the first frame at which Flex begins its simulation.

End Frame When on, sets the last frame at which Flex is to take effect. After this frame, the object snaps back to its shape as currently defined by the stack. For instance, if you animate a Bend modifier in the stack under Flex, then when Flex stops, the object’s shape is altered only by the Bend modifier settings as of that frame.

Affect All Points Forces Flex to ignore any sub-object selection in the stack and apply itself to the entire object.

Set Reference Updates the viewports.

After moving the effect center, click Set Reference to update the viewports.

Reset Resets vertex weighting to the defaults.

Advanced Springs rollout

Use these settings when you need a more precise springs setup than is provided by the Simple Soft Body feature. Flex uses two types of spring: edge springs, which create springs only along existing edges, and shape springs, which can exist between any two vertices in the object that are not connected by an edge. In general, add edge springs along existing edges and shape springs between vertices that don’t share an edge.

NOTE Before using these controls, go to the Weights & Springs sub-object level.

TIP Additional spring types are available using MAXScript. See the MAXScript Help for details.
Enable Advanced Springs  Makes the numeric controls available for editing, and disconnects the Strength and Sway settings from the Simple Soft Bodies controls. Default=off.

The four numeric Stretch and Sway settings in this rollout are available only when Enable Advanced Springs is on.

Add Spring  Adds one or more springs to the object based on the vertex selection at the Weights & Springs sub-object level and the Spring Option dialog on page 1462 settings.

NOTE  You cannot undo this action. To delete existing springs, select the endpoints and click Remove Spring.

Options  Opens the Spring Option dialog on page 1462 for determining how springs are added with the Add Spring function.

Remove Spring  Deletes any springs that have both vertices selected at the Weights & Springs sub-object level.

Stretch Str.  Determines the strength of the edge springs; the higher the strength, the less the distance between them can vary.
**Stretch Sway** Determines the sway of the edge springs; the higher the strength, the less the angle between them can vary.

**Shape Str.** Determines the strength of the shape springs; the higher the strength, the less the distance between them can vary.

**Shape Sway** Determines the sway of the shape springs; the higher the strength, the less the angle between them can vary.

**Spring Count** Displays the number of edge springs, followed by the number of shape springs in parentheses.

**Hold Length** Maintains the length of edge springs within the specified percentage.

**NOTE** This setting, which is applied after the Flex simulation, can affect the object shape, and thus cause collision detection to fail.

**Show Springs** Displays edge springs as blue lines and shape springs as red lines. Springs are visible only when a Flex sub-object mode is active.

You can change the spring colors using MAXScript.

### Spring Option Dialog

Select a Mesh, Patch, or NURBS object. > Modify panel > Modifier List > Animation Modifiers > Flex > Advanced Springs rollout > Options button

Use the Spring Option dialog to determine how springs are added in the Flex modifier when you click the Advanced Springs rollout > Add Spring button.
Interface

Single Edge Spring Creates one edge spring between two selected vertices. If any number of vertices is selected other than two, no springs are created.

Hold Edge Length Springs Creates edge springs along the edges of the objects between any vertex selection and neighboring vertices.

Hold Edge Length Springs Apply Only To Selected Creates edge springs along the edges of the objects between all selected vertices.

Hold Shape Springs Creates shape springs from the selected vertex or vertices to all other vertices within the Hold Shape Radius.

Hold Shape Springs Apply Only To Selected Creates shape springs between all selected vertices within the Hold Shape Radius.

Hold Shape Radius The radius within which shape springs are created. No shape springs are created between vertices farther apart than this distance.

At the bottom of the dialog is an informational display showing the object's average edge length, maximum edge length, and minimum edge length. This information can help in determining an appropriate Hold Shape Radius setting.
HSDS Modifier

Select an object. > Modify panel > Modifier List > Object-Space Modifiers > HSDS Modifier

Select an object. > Modifiers menu > Subdivision Surfaces > HSDS Modifier

The HSDS modifier implements Hierarchical SubDivision Surfaces. It is intended primarily as a *finishing* tool rather than as a modeling tool. For best results, perform most of your modeling using low-polygon methods, and then use HSDS to add detail and adaptively refine the model.

The modifier’s primary features are:

- Local refinement
- Hierarchical modeling
- Adaptive tessellation

With local refinement, you subdivide part of a polygon mesh and edit the mesh in the subdivided area. This is done indirectly by manipulating sub-objects in a *control grid*. Use this feature when you need to increase mesh resolution in specific areas of a model rather than uniformly over the entire object, as with the *Tessellate modifier* on page 1812. An example of usage would be a human hand. Once you’ve modeled the basic shape, you might use the HSDS modifier to add bumps for the knuckles.

The HSDS modifier supports multiple levels of detail, hence its hierarchical nature. The Subdivision Stack lets you visually navigate the levels of detail at any time while using the modifier. Thus, you can edit the same part of a mesh at different mesh resolutions. If you work at a level of detail lower than the highest available, the higher-detail areas are still in effect, but you control them indirectly by means of the more widespread sub-objects at the lower level.

Sub-object animation is supported only at the lowest level of detail: Base Level. This is accomplished by animating the mesh below the HSDS modifier. To apply deformation animation after HSDS modeling, first convert the object to an editable mesh by right-clicking the modifier stack and choosing Collapse All.

The adaptive tessellation automatically subdivides polygons as needed to maintain a smoothly curved surface when transforming mesh sub-objects. You can use a preset or provide custom settings.
IMPORTANT  HSDS models are not passed up the modifier stack. The HSDS modifier takes a polygon mesh as input, and outputs a triangle-based mesh.

Also, The HSDS modifier does not handle changes to the modified object's topology, such as altering a sphere's Segments setting. Topology changes to the input mesh results in the loss of all edits made in the HSDS modifier.

Procedures

To use the HSDS modifier:

1  Apply the HSDS modifier to an object.
   By default, the HSDS modifier doesn't convert non-quadrilateral polygons to quads. Because the modifier works best with four-sided polygons, it's recommended you perform the conversion if necessary.

2  If the object contains any non-quadrilateral polygons, in the HSDS Parameters dialog, turn on Force Quads. Click Yes in the Force Quads? dialog that appears.

   NOTE  Upon conversion to quads, the modifier automatically performs one level of subdivision with smoothing (like MeshSmooth on page 1505 with one iteration) on the object to which it's applied. Thus, for best results, use it with relatively low-polygon objects. For example, if you usually work with the Sphere object at the default 32 segments, use a 16-segment sphere with HSDS.

   If the object is made up of quads only, Force Quads isn't available because no conversion is necessary.

3  Choose a sub-object mode at which to subdivide.
   The object is covered with a gold control grid (or, in Vertex sub-object mode, a white grid with blue vertices), indicating that the entire mesh is available for subdivision and/or sub-object transformation at base level.

4  Select one or more sub-objects.

5  Click the Subdivide button.
   The modifier again subdivides and smooths the selected sub-objects as well as all surrounding polygons. The resultant sub-objects reside at a higher level of detail, as indicated by the addition of a level in the Subdivision Stack. Now the control grid shows only polygons at the new level.
level. With sub-objects other than Element, this typically covers only part of the object’s surface.

In wireframe views, you can still see polygons at lower levels of detail, but you can select only sub-objects resulting from the subdivision, as indicated by the control grid. You can subdivide sub-objects further, transform them, hide and delete them, and change material IDs.

**NOTE** When you transform an HSDS sub-object, the control grid tends to expand by adding segments at its edges, in order to maintain surface smoothness.

6 To subdivide a different part of the object, choose a lower level in the Subdivision Stack, and then repeat steps 2–4.

Each time you subdivide a sub-object that has been subdivided, a higher level in the Subdivision Stack is highlighted, indicating a finer mesh.
resolution. You can then work at that level, or any lower level by selecting the level.

**NOTE** If you transform a sub-object at a level lower than the highest level in which the subject exists, the mesh uses the resolution imparted by the detail in the higher levels.

Interface

**HSDS Parameters rollout**

The sub-objects available in the HSDS modifier belong to the control grid rather than the mesh object itself. Transforming the grid sub-objects also transforms the underlying mesh, but the mesh doesn’t always move to the full extent of the control grid. This is particularly true in cases where you transform a sub-object at a level lower than the highest level in which the sub-object resides.

For example, if you subdivide a vertex at the Base Level, it then resides in the Base Level and Level 1. If you then move the vertex in the base level, the mesh doesn’t, by default, move as far as the vertex. This is roughly analogous to the way free-form deformation works, but with HSDS, the control grid conforms much more closely to the shape of the mesh object.

With vertices, you can control the degree to which the mesh follows the control-grid vertex with the settings on the **Vertex Interpolation** on page 1470 group.
**Vertex**

Turns on Vertex sub-object mode, which lets you select a vertex beneath the cursor; region selection selects vertices within the region.
**Edge** Turns on Edge sub-object mode, which lets you select a face or polygon edge beneath the cursor; region selection selects multiple edges within the region.

**Polygon** Turns on Polygon sub-object mode, which lets you select a single face or polygon. A polygon is the area you see within the visible wire edges. Region selection selects multiple polygons within the region.

**Element** Turns on Element sub-object mode, which lets you select all contiguous polygons beneath the cursor in the current level of detail.

**Ignore Backfacing** When on, you can select only those sub-objects whose normals are visible in the viewport. When off (the default), selection includes all sub-objects, regardless of the direction of their normals. Default=off.

**Only Current Level** Displays only polygons at the current level of detail, with highlights, but without smoothing. Use this option to speed up the display when working with complex objects. Default=off.

**Subdivision Stack** Shows the current level of the subdivision hierarchy. Automatically increments when you subdivide a sub-object selection. To edit at a different level of detail, select the level in the stack. The current level is outlined in red.

Visibility is controlled by the box icon to the right of the level label. Turning on the visibility at one level activates the visibility from that level down to the base level. Visibility above that level will be turned off.
Subdivide

Performs subdivision and smoothing on the current selection, and adds a level to the Subdivision Stack. When the subdivision results in a control grid and other subdivisions have been performed at the same level of detail, the control grids may become interconnected.

**Vertex Interpolation group**

Determines how selected vertices are treated during subdivision. Available only in Vertex sub-object mode.

For best results, use when moving control grid vertices at a level of detail lower than the highest in which the vertex resides.

**Standard/Conic/Cusp/Corner** Determines how closely mesh vertices follow the movement of control grid vertices. Standard provides the least amount of relative movement, while Cusp and Corner provide the most. Corner also keeps edges adjacent to subdivided vertices from being rounded off during subdivision. Default=Standard.

**NOTE** Corner is available only when the selected vertex or vertices aren't surrounded by polygons, such as the vertices on the edge of a plane object.

**Edge Crease group**

Determines the extent to which selected edges are treated as creases during subdivision. Available only in Edge sub-object mode.
For best results, use with control grid edges at a level of detail lower than the highest in which the edge resides. Also, for creasing to be visible, the edge should be offset from the surrounding surface by a significant amount.

Left: Crease=1.0
Center: The eyebrow edges selected at LOD 0
Right: Crease=0.0

Crease Specifies how much creasing is performed on the selected edge or edges. At low settings, the edge is relatively smooth. At higher settings, the crease becomes increasingly visible. At 1.0, the highest setting, the edge is not smoothed at all. Default=0.0. Range=0.0 to 1.0.

Advanced Options rollout

Force Quads When on, the modifier converts all non-quadrilateral faces or polygons to four-sided polygons. When off, converts all polygons to triangles. Available only when the object contains any non-quadrilateral faces or polygons. Default=off.
When you change the status of Force Quads, any edits made in the HSDS modifier are lost. A message appears warning you of this, and asking you to confirm the change.
Because the modifier works best with four-sided polygons, it's recommended you confirm the conversion if an object contains non-quadrilateral faces or polygons. The sphere primitive is an example of such an object; the uppermost and lowermost faces are three-sided.

Smooth Result When turned on, all faces on the object will be in smoothing group 1, but if Smooth Result is turned off, each face will inherit smoothing groups from the input MNMesh.
Material ID  Displays the material ID assigned to the current selection. Available only in Polygon and Element sub-object modes. If multiple sub-objects are selected and they don't share an ID, this field is blank. You can change the material ID assigned to selected sub-objects at the current and higher levels of detail by changing this setting. Material IDs are used primarily with Multi/Sub-Object material on page 6120.

Hide  Hides the current polygon selection. Available only at the Polygon and Element sub-object levels. Use Unhide All to reveal hidden polygons.

TIP  Use Hide to isolate part of an object you want to work on. The Select Invert command on the Edit menu is useful in this case. Select the faces you want to focus on, choose Edit > Select Invert, then click the Hide button.

Unhide All  Reveals hidden polygons.

Delete Polygon  Deletes the current polygon selection, creating a hole or holes in the surface. Available only in Polygon sub-object mode.

NOTE  When the current level of detail does not encompass the entire object surface, you cannot delete polygons at the border of the control grid; that is, polygons that do not share all edges with other polygons in the grid.

Adaptive Subdivision  Opens the Adaptive Subdivision dialog on page 1472. This option is best used for smoothing subdivided and edited portions of the mesh when you're finished using the HSDS functionality.

Soft Selection rollout

These controls let you set a gradual falloff of influence between selected and unselected vertices. See Soft Selection Rollout (Edit/Editable Mesh) on page 2014.

Adaptive Subdivision Dialog

Select an object. > Modify panel > Modifier List > Object-Space Modifiers > HSDS Modifier > Advanced Options rollout > Adaptive Subdivision button

Select an object. > Modifiers menu > Subdivision Surfaces > HSDS Modifier > Advanced Options rollout > Adaptive Subdivision button

Use adaptive subdivision for smoothing subdivided and edited portions of the mesh when you're finished using the HSDS modifier on page 1464.
Alternatively, you can use adaptive subdivision to remove a level of detail from the object.

**Procedures**

**To use adaptive subdivision:**

1. Edit an object with the HSDS modifier.
2. Choose Add Detail or Remove Detail, depending which operation you want to perform.
3. Set the desired amount of detail with one of the presets or by specifying custom Length and Angle settings.
4. Click OK to perform the specified operation.
   The detail addition or removal is performed, and you're returned to the HSDS modifier. Depending on whether you removed or added detail, the highest level of detail is decremented or incremented by 1.

**Interface**

**Detail group**

*Add/Remove* Determines whether clicking the OK button increases or decreases detail.
**Parameters group**

These settings determine the extent to which detail is added or removed. The Length and Angle settings are available for editing only when the Custom option is chosen. However, they show the default settings for the Low, Medium, and High options.

**Low/Medium/High/Custom** Choose one of the presets, or choose Custom to set your own Length and Angle values.

**Max. LOD** Specifies the highest number of levels of detail that 3ds Max can add when increasing detail. Not available when removing detail.

**Length** The maximum permissible length of any edge after adding or removing detail. The smaller the length, the higher the amount of tessellation that is allowed.

**Angle** The maximum permissible angle between two opposite edges emanating from a vertex. The smaller the angle, the higher the amount of tessellation that is allowed.

**OK** Performs the subdivision or removal of detail and closes the dialog.

**Cancel** Closes the dialog without changing the mesh.

---

**Lathe Modifier**

Select a shape. > Modify panel > Modifier List > Lathe

Select a shape. > Modifiers menu > Patch/Spline Editing > Lathe

Lathe creates a 3D object by rotating a shape or NURBS curve about an axis.
Object resulting from 360-degree lathe

Interface

**Modifier Stack**

```
<table>
<thead>
<tr>
<th>Light Lathe</th>
<th>Axis</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ellipse</td>
<td></td>
</tr>
</tbody>
</table>
```

**Axis** At this sub-object level, you can transform and animate the axis of revolution.

For more information on the stack display, see [Modifier Stack](#) on page 8187.
Parameters rollout

Degrees  Determines the number of degrees that the object is spun around the axis of revolution (0 to 360, default=360). You can set keyframes for Degrees to animate the circular growth of a lathed object. The Lathe axis auto-sizes itself to the height of the shape being lathed.
Object resulting from 270-degree lathe

**Weld Core** Simplifies the mesh by welding together vertices that lie on the axis of revolution. Keep it turned off if you intend to create morph targets.

**Flip Normals** Depending on the direction of the vertices on your shape, and the direction of rotation, the lathed object might be inside out. Toggle the Flip Normals check box to fix this.

**Segments** Determines how many interpolated segments are created in the surface between the start and endpoint. This parameter is also animatable. Default=16

**NOTE** You can create up to 10,000 segments using the segments spinner. Try not to create geometry that is more complex than you need. Often you can get satisfactory results by using smoothing groups or smoothing modifiers, rather than increasing segmentation.

**Capping group**

Controls whether or not caps are created for the interior of the lathed object if Degrees is set to less than 360.
Cap Start Caps the start of the lathed object with Degrees set to less than 360 and a closed shape.

Cap End Caps the end of the lathed object with Degrees set to less than 360 and a closed shape.

Morph Arranges cap faces in a predictable, repeatable pattern necessary for creating morph targets. Morph capping can generate long, thin faces that don't render or deform as well as grid capping. Use morph capping primarily if you are lathing multiple morph targets.

Grid Arranges cap faces in a square grid trimmed at the shape boundaries. This method produces a surface of evenly sized faces that can easily be deformed by other modifiers.

**Direction group**

Sets up the direction of the axis of revolution, relative to the pivot point of the object.

X/Y/Z Set the direction of the axis of revolution relative to the pivot point of the object.

**Align group**

Min/Center/Max Align the axis of revolution to the minimum, center, or maximum extents of the shape.

**Output group**

Patch Produces an object that you can collapse to a patch object (see Editing the Stack on page 1049).

Mesh Produces an object that you can collapse to a mesh object (see Editing the Stack on page 1049).

NURBS Produces an object that can be collapsed to a NURBS surface (see Editing the Stack on page 1049).

Generate Mapping Coordinates Applies mapping coordinates to the lathed object. When Degrees is less than 360, and Generate Mapping Coordinates is turned on, additional mapping coordinates are applied to the end caps, placing a 1 x 1 tile on each cap.

Real-World Map Size Controls the scaling method used for texture mapped materials that are applied to the object. The scaling values are controlled by
the Use Real-World Scale settings found in the applied material's Coordinates rollout on page 6201. Default=on.

Generate Material IDs Assigns different material IDs to the sides and the caps of the lathed object. Specifically, the sides receive ID 3, and the caps (when Degrees is less than 360 and the lathed shape is closed) receive IDs 1 and 2. Default=on.

Use Shape IDs Uses the material ID values assigned to segments in the spline on page 577 you lathed, or curve sub-objects in the NURBS on page 2416 curve you lathed. Use Shape IDs is available only when Generate Material IDs is turned on.

Smooth Applies smoothing to the lathed shape.

### Lattice Modifier

Select an object or a shape. > Modify panel > Modifier List > Object-Space Modifiers > Lattice

Select an object or a shape. > Modifiers menu > Parametric Deformers > Lattice

The Lattice modifier converts the segments or edges of a shape or object into cylindrical struts with optional joint polyhedra at the vertices. Use this either to create renderable structural geometry based on the mesh topology, or as an alternate method to achieve a rendered wireframe effect.
Top: Joints only
Middle: Struts only
Bottom: Both (joints and struts)

**NOTE** This modifier can act on the whole object or on sub-object selections in the stack.
You can combine the Scatter compound object on page 674 with the Lattice modifier to place any object you want as a joint, rather than the provided polyhedra. To do this, create your mesh distribution object and your source object (for example, a box). Use Scatter to scatter the box at the vertices of the distribution object. (Be sure to use the Copy option rather than Instance.) In the Scatter Display parameters, hide the distribution object. Select the original object that was used as a distribution object, apply Lattice to it, and turn off the joints. You’ll have two coincident objects: one providing the lattice struts, and the other positioning the boxes.
Interface

Parameters

Geometry
- Apply to Entire Object
- Joints Only from Vertices
- Struts Only from Edges
- Both

Struts
- Radius: 2.0
- Segments: 1
- Sides: 4
- Material ID: 1

- Ignore Hidden Edges
- End Caps
- Smooth

Joints
- Geodesic Base Type
  - Tetra
  - Octa
  - Icosa
- Radius: 5.0
- Segments: 1
- Material ID: 2

- Smooth

Mapping Coordinates
- None
- Reuse Existing
- New
Geometry group

Specifies whether to use the whole object or selected sub-objects, and which of the two components (struts and joints) is displayed.

Apply To Entire Object Applies Lattice to all edges or segments in the object. When turned off, applies Lattice only to selected sub-objects passed up the stack. Default=on.

**NOTE** When Apply To Entire Object is turned off, unselected sub-objects render normally. For example, if you convert a box to an editable mesh, select one polygon, and then apply Lattice with Apply To Entire Object turned off, the face does not render, while the edges and vertices that form that face are converted to struts and joints, and the remaining faces render normally. However, if you select the four edges surrounding the polygon and turn off Ignore Hidden Edges, the struts and joints are added to the object while all faces render as normal. If you turn on Struts group > Ignore Hidden Edges, one of the polygon's faces renders, while the other doesn't.

Joints Only From Vertices Displays only the joints (polyhedra) generated by the vertices of the original mesh.

Struts Only From Edges Displays only the struts (cylinders) generated by the segments of the original mesh.

Both Displays both struts and joints.

Struts group

Provides controls that affect the geometry of the struts.

Radius Specifies the radius of the struts.

Segments Specifies the number of segments along the struts. Increase this value when you need to deform or distort the struts with subsequent modifiers.

Sides Specifies the number of sides around the perimeter of the struts.

Material ID Specifies the material ID to be used for the struts. The struts and the joints can have different material IDs, making it easy to assign them different materials. The struts default to ID #1.

Ignore Hidden Edges Generates struts only for visible edges. When turned off, generates struts for all edges, including the invisible edges. Default=on.

End Caps Applies end caps to the struts.

Smooth Applies smoothing to the struts.
Joints group

Provides controls that affect the geometry of the joints.

Geodesic Base Type Specifies the type of polyhedron used for the joints.

Tetra Uses a tetrahedron.

Octa Uses an octahedron.

Icosa Uses an icosahedron.

Radius Specifies the radius of the joints.

Segments Specifies the number of segments in the joints. The more segments, the more spherical the joints' shape.

Material ID Specifies the material ID to be used for the joints. Defaults to ID #2.

Smooth Applies smoothing to the joints.

Mapping Coordinates group

Determines the type of mapping assigned to the object.

None Assigns no mapping.

Reuse Existing Uses the mapping currently assigned to the object. This might be the mapping assigned by Generate Mapping Coords., in the creation parameters, or by a previously assigned mapping modifier. When using this option, each joint inherits the mapping of the vertex it surrounds.

New Uses mapping designed for the Lattice modifier. Applies cylindrical mapping to each strut, and spherical mapping to each joint.

Linked XForm Modifier

Modify panel > Select objects or sub-objects. > Modifier List > Object-Space Modifiers > Linked XForm

Select an object or sub-objects. > Modifiers menu > Animation Modifiers > Linked XForm

The Linked XForm modifier links the transforms for any object or sub-object selection to another object, called the control object. The control object’s
motion, rotation, and/or scale transforms are passed onto the object or
sub-object selection.

**Using Linked XForm**

Linked XForm connects any geometry it receives from the stack to another
object, which is called the control object. Its single control simply picks the
control object. To use this modifier, you must have at least two objects in
your scene.

**See also:**
- XForm Modifier on page 2010

**Procedures**

**To apply a Linked XForm modifier:**

1. Choose a location in an object's stack and apply a Linked XForm from
   the Modifier List.
2. On the Parameter's rollout, click Pick Control Object. When animating,
   do this at frame 0.
3. Select the object you want to be the control object.
   This completes the link. The name of the control object appears on the
   Parameters rollout.

**To apply a Linked XForm modifier at a Sub-Object level:**

1. Choose an Editable Mesh or an object to which a Mesh Select modifier
   has been applied.
2. Turn on the Vertex sub-object level and select some vertices on the object.
3. Apply a Linked XForm modifier.
4. On the Parameter's rollout, click Pick Control Object. When animating,
   do this at frame 0.
5. Select another object that you want to control the sub-object selection.
   This completes the link. The name of the control object appears on the
   Parameters rollout.
6. Move the control object and see how the vertices are affected.
Interface

Control Object  Object that the vertices are linked to. When transformed, the vertices follow.

Pick Control Object  Click this button, and then select the object that you want to be the control object.

Back Transform  Allows an object with a Linked XForm modifier to be linked to a Control Object. Normally, moving the Control Object causes the linked object to move twice as much as it should, once with the Control Object and once with the link. When the switch is turned on, any transforms to the Control Object are only applied to the linked object once. This switch is similar to the 'Back Transform Vertices' switch of the Skin on page 1667 modifier.

LS Mesh Modifier

Select a Lightscape mesh object. > Modify panel > Modifier List > LS Mesh

The LS Mesh modifier refines a Lightscape mesh object.

When you import a Lightscape scene into 3ds Max, the mesh produced by Lightscape doesn't contain the refinements that Lightscape introduced to improve the lighting. This information is kept and used by the Lightscape material while rendering. This modifier will add these refinements to the Lightscape mesh. In conjunction with the LS Colors modifier on page 1145, this modifier can be used to produce meshes suitable for game engines.

The refinement stored in a Lightscape mesh is hierarchical. When a polygon is refined, it is broken into four smaller polygons. These polygons can then be refined further. A polygon in the refinement has a depth from the original polygon, which is the number of refinements needed to get from the original polygon to the polygon in question.
The modifier allows you to reduce the number of polygons in the result by limiting the depth to which the modifier will descend, or by limiting the size of polygons that will be refined.

You can apply the LS Mesh modifier to a Face sub-object selection of a Lightscape mesh object. In this case, only the selected faces will be refined.

See also:
- Lightscape Files (LP, LS, and Other Formats) on page 7756

Interface

Limit subdivision depth When the toggle is on, the value sets the maximum depth of refinement. When the toggle is off, then the mesh modifier will descend to the bottom of the refinement. Default=on, 0.

Limit subdivision size When the toggle is on, the value limits the size of polygons that are refined. When the toggle is off, then the mesh modifier will refine polygons to any size. The size is a length in the current view units. Polygons smaller than that size squared will not be refined by the modifier. Default=off, 19.685 units or 0.5 meters.

MapScaler Modifier (Object Space)

Select an object. > Modify panel > Modifier List > Object-Space Modifiers > MapScaler

The MapScaler (OSM) modifier works in object space to maintain the scale of a map applied to an object. This lets you resize the object via its creation parameters without altering the scale of the map. Typically, you might use this to maintain the size of a map regardless of how the geometry is scaled, if you change the object size by adjusting its creation parameters. However, if
you use a Select And Scale tool to change the object size, the map scales along with the object.

To maintain the scale of the map regardless of how the object is resized, use the **MapScaler (WSM)** modifier on page 1147.

For example, if you scale a brick wall with the MapScaler (WSM) modifier applied, the bricks will all remain the same size as you increase the size of the wall. However, if you scale the same wall with the MapScaler (OSM) modifier applied, the size of the bricks will grow in proportion with the scale of the wall.

The MapScaler (OSM) modifier has two primary benefits compared to the WSM version:

- As an object-space modifier, it can reside anywhere in the stack and be collapsed with the stack, rather than being restricted to the top of the stack, as with world-space modifiers. This lets other object-space modifiers take effect after the map-scaling operation.

- When instanced among multiple objects, the object-space version appears in the modifier stack display when any number of objects is selected. This differs from the world-space version, which, when instanced among multiple objects, appears in the stack display only when a single object is selected.

**TIP** MapScaler also works at the sub-object level. If the object you’re working on requires different scaling of the texture map on each surface, you can do so by creating a modifier stack with multiple occurrences of the MapScaler modifier.

**Procedures**

**Example: To use the MapScaler at a sub-object level:**

1. Create a Box and apply a brick or other patterned material to the object.

2. Open the Modify panel and choose Mesh Select from the Modifier List.

3. On the Parameters rollout, click the Polygon button and select one of the sides of the box.

4. Open the Modifier List and apply either MapScaler modifier.
5  Change the Scale value.

Notice that the texture map only on the selected set of polygons is changed.

To change the scale of the texture on another part of the same object, add another Mesh Select modifier and make a new sub-object selection. Add the next MapScaler modifier to the new selection set and change the scale as you did in step 5.

Interface

Scale Represents the size of one repetition of the texture pattern. Size is measured in current scene units. Repetitions occur across the object in the U and V directions. Default=1.0.

NOTE When the Use Real-World Texture Coordinates switch is active in the General Preferences dialog on page 8299, the scale setting defaults to 1.0. If Use Real-World Texture Coordinates is turned off, scale defaults to 100.0.

U/V Offset Specify horizontal and vertical offsets respectively. Available only when Wrap Texture is off.

Wrap Texture When on, Map Scaler attempts to wrap the texture evenly around the object. This option requires more computing, but usually produces the most satisfactory results. Default=on.

Wrap Using Smoothing Groups When turned on, textures are wrapped around corners when they share the same smoothing groups. Curved walls
will map smoothly while sharp corners get a new texture origin. This switch is only available when the Wrap Textures switch is turned on. Default=off.

**Channel** Specifies the map channel on page 8627. Default=1.

---

**Material Modifier**

Select an object. > Modify panel > Modifier List > Object-Space Modifiers > Material  
Select an object. > Modifiers menu > Surface > Material  
Select an object. > Modifiers tab > Material Modifier

The Material modifier allows you to animate, or simply change, the assignment of material IDs on page 8633 on an object. If the material ID is animated, the change to a new material ID is abrupt, from one frame to the next.

Object mapped using a multi/sub-object material:

Material ID 1 for the housing of the monitor  
Material ID 2 for the image on the screen
TIP  If you want a gradual blend from one material to another, try animating the Mix parameter on a Blend on page 6107 material.

Use this modifier in conjunction with the multi/sub-object on page 6120 material type, to assign different materials to objects or faces at different frames of an animation, or to quickly change the material ID of an object.

See also:

■  Editable Mesh Surface on page 2192

Patches

This modifier does not convert a patch object below it in the modifier stack to a mesh. A patch object input to the Material modifier retains its patch identity.

Procedures

Example: To change the material ID of a sub-object selection:

1  In the Top viewport, create a sphere.

2  In the Material Editor, create a multi/sub-object material. Make the colors of material ID 1 and 2 different.

3  Assign the multi/sub-object material to the sphere.

4  On the Modify panel, choose Mesh Select from the Modifier List.

5  On the Mesh Select Parameters rollout, click Polygon.

6  In the Front viewport, region-select the lower half of the sphere. The selected polygons turn red.

7  While Polygon is still the active sub-object level (in the stack display, a square polygon icon appears to the right of Mesh Select), choose Material from the Modifier List.
On the Material modifier Parameters rollout, set the value of the Material ID to 1 and 2 to toggle the color on and off.

In the shaded viewport, the lower half of the sphere changes to the color of the selected material ID.

**Interface**

![Parameters](image)

**Material ID** Sets the material ID to be assigned; this can be animated. If the input object is in face sub-selection, then the ID is only applied to selected faces; otherwise, it is applied to the entire object. The ID number refers to one of the materials in a multi/sub-object material.

**MaterialByElement Modifier**

Modify panel > Make a selection. > Modifier List > Object-Space Modifiers > MaterialByElement

Make a selection. > Modifiers menu > Surface > Material By Element

The MaterialByElement modifier lets you apply different material IDs to objects containing multiple elements, at random or according to a formula. When animated, this effect is useful for such applications as an office building at night with window illumination turning on and off at random.
Various materials randomly applied to the leaves of the plant

Procedures

Example: To assign colors randomly in a group of spheres:

1. Create six spheres.

   **TIP** One method is to add a sphere on page 396 primitive, then use Shift+Move on page 914 with the Copy option, and enter 5 in the Number Of Copies field.

2. Combine the spheres into a single editable mesh object.
   
   Right-click a selected sphere and from the Transform (lower-right) quadrant of the quad menu, choose Convert To: > Convert to Editable Mesh. Then click Modify panel > Edit Geometry rollout > Attach List. In the Attach List dialog, click All, and then Attach.

3. Create a **multi/sub-object material** on page 6120 with six materials, and specify a different color for each material. Assign the material to the object with multiple spheres.
Because sphere primitives are assigned material ID 2 by default, all the spheres now have the color assigned to material number 2 in the multi/sub-object material.

4 Assign the MaterialByElement modifier to the object.

5 From the Parameters rollout, turn on Random Distribution.
   Because the default ID Count setting is 2, some of the spheres are assigned sub-material #1, and the rest are assigned #2.

6 Use the spinner to increase the ID Count setting to 3. Also change the Uniqueness group > Seed value.
   Now the first three materials are assigned to the spheres at random, although with some Seed settings, you may see only two different colors.

7 Keep increasing the ID Count setting until you see all six colors in the multi/sub-object material. As the assignments are random, it may take awhile.
Interface

Material ID By Element group

The two choices in this group let you either create a truly random distribution of material IDs or divide the assignments among up to eight materials according to percentages you set.

Random Distribution Assigns the materials at random to different elements in the object.
ID Count Determines the minimum number of material IDs to assign. Because material ID assignment is random, setting it to the number of materials in the multi/sub-object material or higher doesn’t guarantee that all materials get used.

List Frequency Determines an approximate relative weight (percentage) for each of up to eight material IDs, as set by the Mat'l ID #1-8 spinners. The modifier assigns material IDs until the weights total 100.

For example, if you set Mat'l ID #1 to 40, #2 to 35, and #3 to 60, approximately 40 percent of the elements will be assigned material ID 1, 30 percent will be assigned material ID 2, and 25 percent ($100 - [40 + 35]$) will be assigned material ID 3. Any remaining percentages (as set in Mat'l IDs 4-8) are ignored.

NOTE These percentages are approximate. The more elements the object contains, the closer the assigned percentage comes to the set percentage.

Uniqueness group

Seed Sets the seed value for the (pseudo-)randomization of material ID assignments. Not animatable.

Melt Modifier

Modify panel > Make a selection. > Modifier List > Melt

Make a selection. > Modifiers menu > Animation Modifiers > Melt

The Melt modifier lets you apply a realistic melting effect to all types of objects, including editable patches and NURBS objects, as well as to sub-object selections passed up the stack. Options include sagging of edges, spreading while melting, and a customizable set of substances ranging from a firm plastic surface to a jelly type that collapses in on itself.
Increasing the Melt amount progressively melts the cake

**Procedures**

**Example: To animate a jelly-like melting sphere:**

1. In the Top viewport, create a Sphere primitive with a radius of about 50 units.
2. Apply the Melt modifier.
3. Turn on the Auto Key button and go to frame 100.
4. In the Melt group box, set Amount to 70.
5. In the Solidity group box, choose Jelly.
6. Turn off the Auto Key button.
7. Drag the time slider to see the sphere melt.
Interface

Modifier Stack

Gizmo At this sub-object level, you can transform and animate the gizmo like any other object, altering the effect of the Melt modifier. Translating the gizmo translates its center an equal distance. Rotating and scaling the gizmo takes place with respect to its center.

Center At this sub-object level, you can translate and animate the center, altering the Melt gizmo’s shape, and thus the shape of the melted object.

For more information on the stack display, see Modifier Stack on page 8187.
Parameters rollout

Melt group

Amount  Specifies the extent of the "decay," or melting effect applied to the gizmo, thus affecting the object. Range=0.0 to 1000.0.

Spread group

% of Melt  Specifies how much the object and melt will spread as the Amount value increases. It's basically a "bulge" along a flat plane.

Solidity group

Determines the relative height of the center of the melted object. Less-solid substances like jelly tend to settle more in the center as they melt. This group provides several presets for different types of substances, as well as a Custom spinner for setting your own solidity.

Ice  The default Solidity setting.
Glass Uses a high Solidity setting to simulate glass.

Jelly Causes a significant drooping effect in the center.

Plastic Relatively solid, but droops slightly in the center as it melts.

Custom Sets any solidity between 0.2 and 30.0.

**Axis to Melt group**

X/Y/Z Choose the axis (local to the object) on which the melt will occur. Note that this axis is local to the Melt gizmo and not related to the selected entity. By default, the Melt gizmo's axes are lined up with the object's local coordinates, but you can change this by rotating the gizmo.

Flip Axis Normally, the melt occurs from the positive direction toward the negative along a given axis. Turn on Flip Axis to reverse this direction.

**Mesh Select Modifier**

Create or select and object > Modify panel > Modifier List > Mesh Select

Make a selection. > Modifiers menu > Selection Modifiers > Mesh Select

The Mesh Select modifier lets you pass a sub-object selection up the stack to subsequent modifiers. It provides a superset of the selection functions available in the Edit Mesh modifier on page 1321. You can select vertices, edges, faces, polygons or elements, and you can change the selection from sub-object level to object level.

Note the following:

- When you apply the Mesh Select modifier and then go to any sub-object level, the select-and-transform buttons in the toolbar are unavailable, and the Select Object button is automatically activated.

- The Mesh Select modifier automatically turns off the Show End Result button, which becomes "spring loaded" while you're in the modifier.

For more information on the stack display, see Modifier Stack on page 8187.
Using XForm Modifiers to Animate a Mesh Selection

When you apply a Mesh Select modifier, there are no animation controllers assigned to the sub-object selection. This means that the selection has no way to "carry" the transform information needed for animation.

To animate a sub-object selection using Mesh Select, apply either an XForm or Linked XForm modifier to the selection. These modifiers provide the necessary controllers for animating the effects of transforms. In a sense, they give "whole-object status" to the sub-object selection.

- **XForm** on page 2010
  Animates transforms directly on a sub-object selection. Creates a gizmo and center for the sub-object selection. You can animate both, with the center acting as a pivot point for the selection.

- **Linked XForm** on page 1484
  Lets you choose another object to control the animation. The sub-object selection is linked to the "control object." When you transform the control object, the sub-object selection follows accordingly.

Procedures

To use the Mesh Select modifier:

1. Create a mesh object.
2. Select a mesh object.
3. Apply a Mesh Select modifier.
4. Select vertices, edges, faces, polygons or elements.
5. Add another modifier to affect only the selection from step 3.

Interface

**Modifier Stack controls**

- **Show End Result** Normally, if you apply a modifier such as Twist to an editable-mesh object and then return to the Editable Mesh stack entry, you cannot see the effect of the modifier on the object's geometry. But if you turn on Show End Result, you can see the final object as a white mesh, and the original editable mesh as an orange mesh.
Mesh Select Parameters rollout

Provides buttons for turning different sub-object modes on and off, working with named selections and handles, display settings, and information about selected entities.

The icons at the top of the Selection rollout let you specify the method of sub-object selection.

Clicking a button here is the same as selecting a sub-object level in the modifier stack. Click the button again to turn it off and return to the object selection level.

Vertex Selects a vertex beneath the cursor; region selection selects vertices within the region.
**Edge** Selects a face or polygon edge beneath the cursor; region selection selects multiple edges within the region.

**Face** Selects a triangular face beneath the cursor; region selection selects multiple triangular faces within the region.

**Polygon** Selects all coplanar faces (defined by the value in the Planar Threshold spinner) beneath the cursor. Usually, a polygon is the area you see within the visible wire edges. Region selection selects multiple polygons within the region.

**Element** Selects all contiguous faces in an object. Region selection selects the same.

**By Vertex** Selects any sub-objects at the current level that use a vertex you click. Applies to all sub-object levels except Vertex. Also works with Region Select.

**Ignore Backfaces** Selects only those sub-objects whose normals make them visible in the viewport. When turned off (the default), selection includes all sub-objects, regardless of the direction of their normals.

**NOTE** The state of the Backface Cull setting in the Display panel doesn't affect sub-object selection. Thus, if Ignore Backfacing is turned off, you can select sub-objects even if you can't see them.

**NOTE** The state of the Ignore Backfaces check box also affects edge selection at the Edge sub-object selection level.

**Ignore Visible Edges** When turned off (the default), and you click a face, the selection won't go beyond the visible edges no matter what the setting of the Planar Thresh spinner. When turned on, face selection ignores the visible edges, using the Planar Thresh setting as a guide. Enabled when the Polygon face selection method is chosen.

Generally, if you want to select a "facet" (a coplanar collection of faces), you set the Planar Threshold to 1.0. On the other hand, if you're trying to select a curved surface, increase the value depending on the amount of curvature.
**Planar Thresh (Planar Threshold)** Specifies the threshold value that determines which faces are coplanar for Polygon face selection.

**Get from Other Levels group**

Applies selections from one sub-object level to another.

**Get Vertex Selection** Selects faces based on the last vertex selection. Selects all faces shared by any selected vertex. The selection is added to the current selection. Available only when Vertex is not the current sub-object level.

**Get Face Selection** Selects vertices based on the last face/polygon/element selection. This selection is added to the current selection. Available only when Face/Polygon/Element is not the current sub-object level.

**Get Edge Selection** Selects faces based on the last edge selection. Selects those faces that contain the edge. Available only when Edge is not the current sub-object level.

**Select by Material ID group**

Selects faces based on their material ID.

**ID** Set the spinner to the ID number you want to select, and then click the Select button. Press Ctrl while clicking to add to the current selection, or press Alt to remove from the current selection.

**Named Selection Sets group**

These functions are primarily for copying named selection sets on page 185 of sub-objects between similar objects, and between comparable modifiers and editable objects. For example, you can apply a mesh select modifier to a sphere, create a named selection set of edges, and then copy the selection to a different sphere that's been converted to an editable mesh object. You can even copy the selection set to a different type of object, because the selection is identified by the entities' ID numbers.

The standard procedure is to create a selection set, name it, and then use Copy to duplicate it into the copy buffer. Next, select a different object and/or modifier, go to the same sub-object level as you were in when you copied the set, and click Paste.

**NOTE** Because sub-object ID numbers vary from object to object, the results of copying named selection sets between different objects can be unexpected. For example, if the buffered set contains only entities numbered higher than any that exist in the target object, no entities will be selected when the set is pasted.
Copy Places a named selection into the copy buffer.

Paste Pastes a named selection from the copy buffer.

Select Open Edges Selects all edges with only one face. In most objects, this will show you where missing faces exist. Available only at the Edge sub-object level.

Selection Information

At the bottom of the Mesh Select Parameters rollout is a text display giving you information about the current selection. If 0 or more than one sub-object is selected, the text gives the number and type selected. If one sub-object is selected, the text gives the ID number and type of the selected item.

NOTE When the current sub-object type is Polygon or Element, selection information is given in faces.

Soft Selection rollout

These controls let you set a gradual falloff of influence between selected and unselected vertices. See Soft Selection Rollout (Edit/Editable Mesh) on page 2014.

MeshSmooth Modifier

Modify panel > Make a selection. > Modifier List > Object-Space Modifiers > MeshSmooth

Make a selection. > Modifiers menu > Subdivision Surfaces > MeshSmooth

The MeshSmooth modifier smoothes geometry in your scene by means of several different methods. It lets you subdivide the geometry while interpolating the angles of new faces at corners and edges, and apply a single smoothing group to all faces in the object. The effect of MeshSmooth is to round over corners and edges as if they had been filed or planed smooth. Use MeshSmooth parameters to control the size and number of new faces, and how they affect the surface of the object.
Angular model (shown on the right) changed to a smooth model with MeshSmooth

You can use MeshSmooth to produce a Non-Uniform Rational MeshSmooth object (NURMS for short). A NURMS object is similar to a NURBS object in that you can set different weights for each control vertex. You can further control the object's shape by changing edge weights.

MeshSmooth's effect is most dramatic on sharp corners and least visible on rounded surfaces. Use MeshSmooth on boxes and geometry with crisp angles. Avoid using it on spheres and similar objects.

**TIP** To better understand MeshSmooth, create a sphere and a cube and apply MeshSmooth to both. The cube's sharp corners become rounded, while the sphere's geometry becomes more complex without changing shape significantly.

**NOTE** Having an animated deformer placed before a meshsmoothed object that has had control level editing can result in the meshsmoothed object becoming distorted. It's recommended that deforming modifiers be placed after the MeshSmooth modifier in the stack if you're using the deformers for animation.

**See also:**
- Quadify Mesh Modifier on page 1641
Procedures

To apply MeshSmooth to an object:
1. Select an angular object.
2. Apply the MeshSmooth modifier.

To apply MeshSmooth to sub-objects:
1. Select an object.
2. Apply a Mesh Select modifier.
3. Select a group of vertices or faces.
4. Apply MeshSmooth.
5. In the Subdivision Method rollout, turn off Apply To Whole Mesh. This lets MeshSmooth work only on the sub-object selection.

Interface

Modifier Stack

- **Vertex** At this sub-object level you can transform or edit vertices in the smoothed mesh.
- **Edge** At this sub-object level you can transform or edit face edges in the smoothed mesh.

See Local Control rollout on page 1511.
For more information on the stack display, see Modifier Stack on page 8187.
Subdivision Method rollout

Subdivision Method list Choose one of the following to determine the output of the MeshSmooth operation:

- **NURMS**  Produces Non-Uniform Rational MeshSmooth object (NURMS for short). The Strength and Relax smoothing parameters are unavailable with the NURMS type.
  
  A NURMS object is similar to a NURBS object in that you can set different weights for each control vertex. You can further control the object’s shape by changing edge weights. See Display/Weighting group, following, for further information on changing weights.

- **Classic**  Produces three- and four-sided facets. (This is the same as applying MeshSmooth in version 2.x without turning on Quad Output.)

- **Quad Output**  Produces only four-sided facets (assuming you don’t look at the hidden edges, since the object is still made up of triangular faces). If you apply this with default parameters to a whole object, like a box, it’s topologically exactly the same as Tessellate on page 1812, edge-style. However, rather than using tension to project face and edge vertices out of the mesh, use the MeshSmooth Strength to relax the original vertices and the new edge vertices into the mesh.

**Apply To Whole Mesh** When turned on, any sub-object selection passed up the stack is ignored and MeshSmooth is applied to the entire object. Note that the sub-object selection is still passed up the stack to any subsequent modifiers.

**Old Style Mapping** Use the 3ds Max version 3 algorithm to apply MeshSmooth to the mapping coordinates. This technique tends to distort the underlying mapping coordinates as it creates new faces and as texture coordinates shift.
Effect of MeshSmooth with two iterations on a cube and different iteration method:

A. NURMS
B. Quad
C. Classic
D. Original object with no MeshSmooth

**Subdivision Amount rollout**

Sets how many times to apply MeshSmooth.
**Iterations** Sets the number of times the mesh is subdivided. When you increase this value, each new iteration subdivides the mesh by creating smoothly interpolated vertices for every vertex, edge, and face from the iteration before. The modifier then subdivides the faces to use these new vertices. Default=0. Range=0 to 10.

The default value of 0 iterations allows you to modify any setting or parameter, such as the type of MeshSmooth or the update options, before 3ds Max starts subdividing the mesh.

**NOTE** Be cautious when increasing the number of iterations. The number of vertices and faces in an object (and thus the calculation time) can increase as much as four times for each iteration. Applying four iterations to even a moderately complex object can take a long time to calculate. You can press Esc to stop calculation; this also automatically sets Update Options to Manually. Reduce the Iterations value before setting Update Options back to Always.

**Smoothness** Determines how sharp a corner must be before faces are added to smooth it. Smoothness is calculated as the average angle of all edges connected to a vertex. A value of 0.0 prevents the creation of any faces. A value of 1.0 adds faces to all vertices even if they lie on a plane.

**TIP** To subdivide only sharp edges and corners, use a Smoothness value of less than 1.0. To see the subdivisions in Wireframe/Edged Faces viewports, turn off Isoline Display on page 1512.

**Render Values** These let you apply a different number of smoothing iterations and a different Smoothness value to the object at render time. Typically you would use a low number of iterations and a lower Smoothness value for modeling, and higher values for rendering. This lets you work quickly with a low-resolution object in the viewports, while producing a smoother object for rendering.

**Iterations** Lets you choose a different number of smoothing iterations on page 1510 to be applied to the object at render time. Turn on Iterations, and then use the spinner to its right to set the number of iterations.

**Smoothness** Lets you choose a different Smoothness value to be applied to the object at render time. Turn on Smoothness, then use the spinner to its right to set the smoothness value.
From right to left, effect of increasing the number of iterations

Local Control rollout

MeshSmooth Modifier | 1511
Sub-object Level  Turns Edge or Vertex level on or off. When both levels are off, you're working at the object level. Information about the selected edges or vertices is displayed in the message area under the Ignore Backfacing check box.

Ignore Backfacing  When on, selection of sub-objects selects only those sub-objects whose normals make them visible in the viewport. When off (the default), selection includes all sub-objects, regardless of the direction of their normals.

Control Level  Allows you to see the control mesh after one or more iterations and to edit sub-object points and edges at that level. Transform controls and the Weight setting are available for all sub-objects at all levels. The Crease setting is available only at the Edge sub-object level.

Crease  Creates a discontinuity on a surface so you get a hard edge, such as a wrinkle or lip. You select one or more edge sub-objects and adjust the Crease setting; the crease appears in the surfaces associated with the selected edges. Available only at the Edge sub-object level.

Weight  Sets the weight of selected vertices or edges. Increasing a vertex weight "pulls" the smoothed result toward that vertex. Edge weights are more complex and behave in an opposite manner in some respects. They aren't really "weights" as such, but "knot intervals," in NURBS terminology. Consequently, increasing an edge weight tends to push the smoothed result away. Kinks will form in the result if weights of 0 are used.

Isoline Display  When on, 3ds Max displays only isolines: the object's original edges, before smoothing. The benefit of using this option is a less cluttered display. When off, 3ds Max displays all faces added by MeshSmooth; thus, higher Iterations settings (see Subdivision Amount Rollout on page 1509) result in a greater number of lines. Default=on.

Show Cage  Toggles the display of a two-color wireframe that shows the modified object before subdivision. The cage colors are shown as swatches to the right of the check box. The first color represents unselected edges at the Vertex sub-object level, and the second color represents unselected edges at the Edge sub-object level. Change a color by clicking its swatch.

Soft Selection rollout

Soft Selection controls affect the action of sub-object Move, Rotate, and Scale functions. When these are on, 3ds Max applies a spline curve deformation to unselected vertices surrounding the transformed selected sub-object. This provides a magnet-like effect with a sphere of influence around the transformation.
For more information, see Soft Selection Rollout on page 2014.

Parameters rollout

These settings are available only when MeshSmooth Type is set to Classic or Quad Output. Also, Project To Limit Surface is available only in Classic mode.

Strength

Sets the size of the added faces using a range from 0.0 to 1.0.

- Values near 0.0 create small faces that are very thin and close to the original vertices and edges.
- Values near 0.5 size faces evenly between edges.
- Values near 1.0 create large new faces and make the original faces very small.

Relax

Applies a positive relax effect to smooth all vertices.

Project to Limit Surface

Places all points on the "limit surface" of the MeshSmooth result, which is the surface that would be produced after an infinite number of iterations. The topology is still controlled by the number of iterations.

Parameters rollout > Surface Parameters group

Applies smoothing groups to the object and restrict the MeshSmooth effect by surface properties.
Smooth Result Applies the same smoothing group to all faces.

Separate by Materials Prevents the creation of new faces for edges between faces that do not share Material IDs.

Separate by Smoothing Groups Prevents the creation of new faces at edges between faces that don't share at least one smoothing group.

Settings rollout

Settings rollout > Input Conversion group

Operate On Faces/Polygons Operate On Faces treats every triangle as a face and smooths across all edges, even invisible edges. Operate On Polygons ignores invisible edges, treating polygons (like the quads making up a box or the cap on a cylinder) as a single face.

Keep Faces Convex (Available only with Operate On Polygons mode.) Keeps all input polygons convex. Selecting this option causes non-convex polygons to be handled as a minimum number of separate faces, each of which is convex. (Turn on Display/Weighting group > Display Control Mesh to see what's happening here.)

"Convex" means that you can connect any two points in the polygon with a line that doesn't go outside the polygon. Most letters aren't convex. In the capital letter "T," for example, you can't connect the upper-left corner to the bottom with a straight line without going outside the shape. Circles, rectangles, and regular polygons are all convex.

Problems that can occur with non-convex faces include the fact that changes in the geometry of the input object can result in a different topology for the MeshSmooth result. For instance, in a box, if you drag one of the top corners
across the middle of the top face, the box becomes non-convex. MeshSmooth would then see this as two triangles instead of one quad, and the number of points in the result would change.

If you need to make sure your output topology is stable, turn this off. If you have a lot of letters or other non-convex faces in your mesh, however, you'll probably want it on.

**Settings rollout > Update Options group**

Sets manual or render-time update options, for situations where the complexity of the smoothed object is too high for automatic updates. Note that you can also set a greater degree of smoothing to be applied only at render time, on the Subdivision Amount rollout.

**Always** Updates the object automatically whenever you change any MeshSmooth settings.

**When Rendering** Updates the viewport display of the object only at render time.

**Manually** Turns on manual updating. When manual updating is selected, any settings you change don't take effect until you click the Update button.

**Update** Updates the object in the viewport to match the current MeshSmooth settings. Works only when you choose When Rendering or Manually.

**Resets rollout**

This rollout allows you to go back to default or initial settings on any changes you made such as sub-object transforms (geometric edits), and changes to edge creases, vertex weights, and edge weights.

You can reset changes for all control levels or to the current control level. Turn on the reset option for the sub-object level you want, and then click the appropriate button.
Reset All Levels Returns to the default or initial settings for geometric edits, creases, and weights for all sub-object levels.

Reset This Level Returns to the default or initial settings for geometric edits, creases, and weights for the current sub-object level.

Reset Geometric Edits Returns to the default or initial settings for any transforms made to vertices or edges.

Reset Edge Creases Returns to the default or initial setting for edge creases.

Reset Vertex Weights Returns to the default or initial setting for vertex weights.

Reset Edge Weights Returns to the default or initial setting for edge weights.

Reset Everything Returns to the default or initial setting for everything.

**Mirror Modifier**

Modify panel > Make a selection. > Modifier List > Object-Space Modifiers > Mirror

Make a selection. > Modifiers menu > Parametric Deformers > Mirror

The Mirror modifier provides a parametric method of mirroring an object or a sub-object selection. You can apply the Mirror modifier to any type of geometry, and you can animate the mirror effect by animating the modifier's gizmo.
Mirroring a bench

Procedures

To apply the Mirror modifier:

1. Apply the Mirror modifier to a selection.
2. Set the axis or axis pair on which to mirror the object.
3. To create a mirrored pair, specify an Offset amount and turn on Copy.

Interface

Modifier Stack
Mirror Center Represents the axis of the mirror effect. You can move, rotate or scale the gizmo to affect the mirroring. You can animate the gizmo transforms, which you can't do with the toolbar Mirror on page 940 tool. For more information on the stack display, see Modifier Stack on page 8187.

Parameters rollout

![Parameters rollout]

Mirror Axis group

X, Y, Z, XY, YZ, ZX Specify the axis or axes about which the mirroring takes place. You can usually see the effect in the viewport as you select the option.

Options group

Offset Specifies the offset, in units, from the mirror axis. This is an animatable parameter.

Copy Copies the geometry rather than simply mirroring it.

NOTE The Copy option affects only geometry with triangular meshes.

Morpher Modifier

Select a mesh, patch, or NURBS object. > Modify panel > Modifier List > Morpher

Select a mesh, patch, or NURBS object. > Modifiers menu > Animation Modifiers > Morpher
Use the Morpher modifier to change the shape of a mesh, patch, or NURBS model. You can also morph shapes (splines), and World Space FFDs. As well as morphing from one shape to another, the Morpher modifier also supports material morphing.

On this patch model, morph targets are created by moving control vertices and tangent handles in an Editable Patch.

Morphing is commonly used for lip sync and facial expression on a 3D character, but can be used to change the shape of any 3D model. There are 100 channels available for morph targets and materials. Channel percentages can be mixed, and the result of the mix can be used to create a new target.

On a mesh object, vertex count on the base object and targets must be the same. On a patch or NURBS object, the Morpher modifier works on control points only. This means that the resolution of patches or NURBS surfaces can be increased on the base object to increase detail at render time.

A Flex modifier above the Morpher modifier is aware of vertex/control point motion in the Morpher modifier. If, for example, a jaw is morphed to slam shut, then the Flex modifier placed above the Morpher modifier in the modifier stack can be used to make the lips quiver to simulate soft tissue.
See also:
- Morpher Material on page 6116

Lip Sync and Facial Animation

For lip sync and facial animation, create a character's head in an "at rest" pose. The head can be a mesh, patch, or NURBS model. Copy and modify the original head to create the lip-sync and facial-expression targets. Select the original or "at rest" head and apply the Morpher modifier. Assign each lip-sync and facial-expression target to a channel in the Morpher modifier. Load an audio file in the Track View sound track, turn on the Auto Key button, scrub the time slider, and view the audio waveform in Track View to locate frames for lip sync. Then set the channel spinners on the Morpher modifier to create key frames for lip position and facial expression.

Teeth can either be a part of the model or animated separately. If the teeth and head are two different objects, model the teeth in an open position, and then apply the Morpher modifier, and create one target with the teeth closed. Eyes and head motion can be animated after the morph keys are created.

Morph Targets for Speech

Nine mouth shape targets are commonly used for speech. If your character speaks an alien dialect, don't hesitate to create extra morph targets to cover these mouth shapes.

Include cheek, nostril, and chin-jaw movement when creating mouth position targets. Examine your own face in a mirror or put a finger on your face while mouthing the phonemes, if necessary, to establish the direction and extent of cheek motion.

Set lip-sync keys by viewing the audio waveform as well as listening to the sound as you scrub the time slider. Many mouth-position keys benefit from being set a frame early. Often the mouth must assume a shape before the appropriate sound is uttered. For the word "kilo", the "K" mouth shape precedes the actual sound, for example.
A, I

E

E, V

C, D, G, J, K, N, S, T, Y, Z
Chapter 9  Modifiers
M,B,P (This target can be the same shape as the "at rest" base object)

**Morph Targets for Expression**

Create as many expression targets as necessary for the character. Joy, sadness, surprise, evil can all have their own targets. Depending on the personality of the character, certain targets, like a terror target, may not be necessary. Targets like nostril flare, jaw-muscle bunching, temple twitching can be effective to give a character an edge. Each morph channel can contain a material as well: as you morph the brows up, a bump map can crease the forehead, for example.

Save time and create targets as the need arises; if the audio file or scene you are working on requires a look of surprise, create the "surprise" target while the mood of the scene is with you.

If the character has teeth, copy the teeth and the base head to create a new target. The teeth act as a guide to shape and position the lips.
Procedures

Example: To add the morpher modifier to an object and assign a morph target to a channel:

1. On the Create panel, click Geometry.
2. On the drop-down list, choose Patch Grids.
3. On the Object Type rollout, click Quad Patch.
4. In the Top viewport, click and drag to create a patch grid.
5. On the Modify panel, on the modifier stack display, right-click Quad Patch and choose Convert To: Editable Patch from the right-click menu.
   The base object is now an Editable Patch.
6. In the Top viewport, use Shift+Move to create a copy of the patch object.
7 On the Modify panel, on the Selection rollout, click Vertex.

8 In the Front viewport, move patch vertices to deform the patch surface.

9 In the stack display, choose Editable Patch to go to the object (top) level. (The highlight should change from yellow to gray, and the Vertex sub-object icon is no longer displayed at the right of the stack.)

10 Select the first patch object.

11 On the Modify panel, choose Morpher from the Modifier List. The Morpher modifier is added to the modifier stack.

12 On the Morpher modifier, on the Channel List rollout, right-click the first channel (over the word "empty"). A right-click menu displays.

13 Choose Pick from Scene on the right-click menu, and click the deformed patch grid in the viewports. QuadPatch02 is listed in the channel as a morph target.

14 Drag the Channel spinner, to the right of QuadPatch02, up and down. The flat patch grid "morphs" to the shape of the target.

To use progressive morphing:

1 Create starting and ending morph targets, and one or more intermediate targets.

2 Apply the Morpher modifier to the starting morph target, and click Load Multiple Targets to load the starting and ending morph targets.

3 In the Channel List rollout, select the channel you want to be influenced by an intermediate target.

4 In the Channel Parameters rollout, click Pick Object from Scene, and select the intermediate target.
5 In the Progressive Morph group Target List, set the Target % to determine the degree to which each target affects the channel.

6 Use the down arrow button to move the original channel target to the bottom of the Target List.

**Interface**

Whatever is assigned as the default float controller in 3ds Max will be assigned as the float controller on the morph channels as well. Float controllers handle the interpolation between keys; Bezier is the default float controller. You can assign the TCB float controller to the morph channels in Track View, if you prefer.

For morphing, the Bezier controller allows you to use function curves with vector handles on the keys for smoothing and easing control of interpolation in Track View. Default parameters of the TCB controller, however, handles morph interpolation with less overshoot. Try using both controllers, to decide which one you prefer.

![Channel Color Legend]

**Gray** The channel is empty, and has not been edited.

**Orange** The channel has been changed in some way but contains no morph data.

An artist may wish to name a channel and set up its parameters before actually assigning a morph target.

**Green** The channel is live. The channel contains morph data and the target object still exists in scene (the target is available for refresh).
Blue The channel contains morph data but the target has been deleted from the scene.

Dark Gray The channel is disabled.

- There is a problem with the morph, the topology of the base object, or targets, have changed and are no longer valid; for example, the vertex count might have changed. The channel cannot be used.

- The channel is not active. This is controlled by the Channel is Active toggle in the Channel Parameters rollout.

- Disabled channels are not included in the morph result.

**Global Parameters rollout**

![Global Parameters rollout](image)

**Global Settings group**

**Use Limits** Use the minimum and maximum limits for all channels. You can turn off limits to double purpose a target. The target for a smile can be used to turn the corners of the mouth down using negative values for example.
Minimum Sets the minimum limit.

Maximum Sets the maximum limit.

Use Vertex Selection Turn on to limit morphing to vertices selected in a modifier below the Morpher modifier in the modifier stack.

If your are using Character Studio Physique, limit morph animation on the base object to just the head and exclude the neck, for example. Place the Physique modifier above the Morpher modifier and assign the head vertices as rigid (green) in the Physique modifier.

Channel Activation group

Set All Click to activate all channels.

Set None Click to deactivate all channels.

Morph Material group

Assign New Material Click to assign the Morpher material to the base object (the object to which the Morpher modifier is applied).

Open the Material Editor to view and edit the Morpher material. There is a direct correlation between the Channel Material Maps and the Channel list in the Morpher modifier (100 channels and 100 maps). For example, if channel 1 contains a brows up target and the Morpher material has a material assigned to map 1, then, as the brows are morphed so is the material.

In the Morpher material, if a material is assigned to a map or channel that has no morph target in the Morpher modifier, then the channel spinner in the Morpher modifier can be used to simply morph the material on a static object. See Morpher Material on page 6116.
Channel List rollout

The upper section of the Channel List rollout contains controls for managing markers, which designate different locations in the list of morph targets. For example, channels 15 through 24 might contain all the emotion targets. Rather than scrolling to display these tracks, you can choose a marker from the list to display those channels.

[marker drop-down list] Choose a previously saved marker in the list, or enter a new name in the text field and click Save Marker to create a new marker.
For example, channel 15 through 24 might contain all the emotion targets. Rather than scrolling to display these tracks, you can choose a marker from the list to display these channels in the list.

Save Marker Move the scroll bar to frame a particular set of 10 channels, enter a name in the text field, and then click Save Marker to store the channel selection.

Delete Marker Choose a marker name to delete from the drop-down list, and then click Delete Marker to delete it.

---

Channel List The Morpher modifier provides up to 100 morph channels. Scroll through the channels using the slider. Once you've assigned a morph target to a channel, the target's name appears in the channel list. Each channel has a percentage value field and a spinner to change the value.

You can change channel names and order in the Channel Parameters on page 1531 rollout.

Right-click a morph channel to display a right-click menu:

- **Pick from Scene** Choose this command and select an object in the viewports to assign a morph target to the channel.

- **Delete Channel** Deletes the morph data, name and parameters from the channel. Displays only if the channel has data.

- **Reload Target** Retrieves morph data from the target. Use this after editing a target.
List Range Displays the range of visible channels in the channel list.

Load Multiple Targets Load multiple morph targets into empty channels by selecting object names in the selection dialog and clicking Load.
If there are more targets than empty channels, a warning displays and the channels are not assigned.

Reload All Morph Targets Reloads all the morph targets.
If the targets have been edited, the channels are updated to reflect the changes.
If a morph target has been deleted from the scene, then the morpher updates using the stored data in the channel, functions using the last stored morph data.

Zero Active Channel Values Click to create keys with a value of 0 for all active morph channels, if the Auto Key is on.
This is handy to prevent key interpolation from distorting the model. First click Zero Active Channel Values, and then set a particular channel to the value you want; only the altered channel affect the model.

Automatically reload targets Turn this on to allow animated targets to be updated dynamically by the Morpher modifier. There is a performance penalty when using this option.

Channel Parameters rollout

The channel number button and channel name field at the top of this rollout reflect the current active channel in the channel list.
Click the number next to the channel name to display a menu. Use commands on the menu to group and organize channels, or to locate a channel.
Move To Displays the Channel Operations dialog. To move the current channel to the selected channel, choose a channel from the list, and click Move To.

Swap With Displays the Channel Operations dialog. To swap the current channel with the selected channel, choose a channel from the list, and click Swap With.

Used Channels Displays a list of active channels. Choose a channel to place it at the top of the channel list display in the Channel List rollout.

Channel Name Displays the name of the current target. Change the name of the target in the text field if necessary. Parameter changes in the Channel Parameters rollout affect the current target.

Channel is Active Toggles a channel on and off. Inactive channels do not affect the morph result. Use this control to turn off certain channels to focus on animating other channels.

Create Morph Target group

Pick Object from Scene Turn on and click an object in the viewports to assign a morph target to the current channel. Picking an object adds it to the Progressive Morph list.

Capture Current State Choose an empty channel to activate this function. Click to create a target using the current channel values. The captured channel is always blue because there is morph data but no specific geometry. Use Extract to create a mesh copy of the captured state.

Delete Deletes the target assignment for the current channel.

Extract Choose a blue channel and click this option to create an object from the morph data. If you have used Capture Current State to take a snapshot of a group of channel values, but then want to edit it, use Extract to make a new object, pick it as the channel's target, and then start editing.
Channel Settings group

Use Limits  Turn on to use limits on the current channel if Use Limits is turned off in the Global Parameters rollout.

Minimum  Sets the lower limit.

Maximum  Sets the upper limit.

Use Vertex Selection  Morphs only selected vertices on the current channel.

Progressive Morph group

Progressive morphing performs a tension-based interpolation, similar to the TCB animation controller, that creates smooth interpolation through each intermediary targets. This provides the artist with an unprecedented amount of control over the morph transformation.

Morphed object using multiple, intermediary targets
When morphing from one target to another, the object can sometimes pass through intermediary stages that are not desirable. For example, morphing a straight cylinder directly to a bent cylinder causes the cylinder to squash at intermediate stages.

You could get a better result by creating several intermediate morph targets for the object, and using them as channels. However, an easier solution is to create fewer intermediate targets, and use progressive morphing. With progressive morphing, you do not use the intermediate targets as channels; you use them to influence the end targets.

**Target List** Lists all intermediary morph targets associated with the current channel. To add morph targets to the list, click Pick Object from Scene.

**Move Up** Moves the selected intermediary morph target up in the list.

**Move Down** Moves the selected intermediary morph target down in the list.

**TIP** For best results, move the original morph target (the one in the channel) to the bottom of the list.
**Target %** Specifies how much the selected intermediate morph target contributes to the overall morph solution.

**Tension** Specifies the overall linearity of the vertex transformation between intermediary morph targets. A value of 1.0 creates a “loose” transition, causing the interpolation to overshoot each target slightly. A value of 0.0 creates a direct, linear transformation between each intermediary target.

**Delete Target** Deletes the selected intermediary morph target from the target list.

**Reload Morph Target** Reloads data from the current target into the channel. Reload a target if it has been adjusted or edited.

If the active morph target entry in the channel list is empty, this button is unavailable, and displays the text “No Target to Reload.”

**Advanced Parameters rollout**

**Spinner Increments** Specify fine or coarse spinner increments. 5.0 is coarse and 0.1 is fine. Default=1.0

**Compact Channel List** Compact the channel list by filling in any empty channels in between assigned channels. The status window displays how many channels were moved.

**Approximate Memory Usage** Displays an approximation of the current memory usage.
MultiRes Modifier

Select an object. > Modify panel > Modifiers List > Object-Space Modifiers > MultiRes

Make a selection. > Modifiers menu > Mesh Editing > MultiRes

The MultiRes modifier reduces the memory overhead needed to render models by decreasing the number of vertices and polygons. This is useful not only within 3ds Max, but for content creators who export models for use outside of 3ds Max, such as in Web-based 3D applications. MultiRes offers several advantages over the Optimize modifier, including faster operation and the ability to specify reduction as an exact percentage or vertex count.

NOTE

The MultiRes modifier supports the preservation of map channels when face count is increased or reduced.

Left: Original model
Center and right: Model progressively simplified by the MultiRes modifier
Modeling Tips for MultiRes

The MultiRes multi-resolution mesh algorithms are designed to be general-purpose, and yield high-quality meshes on a wide variety of model types. However, careful modeling can improve the results of the algorithm. The following are suggestions to yield high-quality multi-resolution meshes:

- Avoid using complex model hierarchies with MultiRes. For such models you should generate an individual multi-resolution mesh for each model component, or collapse the entire model into a single mesh. In general, single-skin meshes work best with animation engines like Physique in character studio. MultiRes works especially well with single-skin meshes.

- Avoid duplicating vertices. The presence of extra vertices is an often-overlooked artifact of some modeling techniques. The Weld function in the Edit Mesh modifier on page 1321 and Editable Poly on page 2240 is useful for cleaning these up.

- Be conservative with texture and normal discontinuities. For example, an artist might associate multiple texture coordinates with a single vertex. MultiRes will seek to preserve this discontinuity and the border between the two texture mappings, but it might do so at the expense of model shape.

- Create high-resolution models. High-resolution models provide MultiRes with more faces and vertices that describe the shape of the model. The more initial information MultiRes has about the shape of the model, the better the decisions it makes in generating a final multi-resolution mesh.

Procedures

To use the MultiRes modifier:

1. Select a model and apply the MultiRes modifier.

2. In the Generation Parameters group in the MultiRes Parameters rollout, click the Generate button to initialize the modifier.

3. In the Resolution group, use the keyboard or spinner controls to decrease the Vert Percent or Vert Count value.

As the vertex and polygon counts decrease, the mesh updates in real time in the viewports.
To maintain part of a mesh at full resolution while reducing the rest:

1. Select a model and apply the MultiRes modifier.
2. In the modifier stack display, click the + icon next to the MultiRes modifier to open the sub-object hierarchy.
3. Click the Vertex label to access the Vertex sub-object level.
4. Select the vertices in areas whose resolution you want to maintain.
5. In the Generation Parameters group, turn on Maintain Base Vertices.
6. Click the Generate button to initialize or re-initialize the mesh.
   Notice that the selected vertices look like asterisks instead of standard ticks.
7. Reduce the resolution as in the first procedure.
   The selected vertices are the last to be removed during vertex reduction.

**NOTE** You can change the base vertices at any time by selecting a different group of vertices and regenerating the mesh.

To merge vertices:

If there are gaps between vertices that you want to close as vertex resolution decreases, use the Vertex Merging feature of the MultiRes modifier. With vertex merging, vertices within a given threshold distance eventually collapse during vertex reduction.

You can estimate the gap length by activating the Select Object tool on page 172, moving the mouse cursor over the extents of the gap in the active viewport (it might help to access the Vertex sub-object level), and comparing the values displayed in the X/Y/Z readouts in the status bar, or use the Tape helper on page 2855 object to get an exact measurement. Enter the estimated gap length value in the Threshold field.

1. Select a model and apply the MultiRes modifier.
2. Turn on Vertex Merging. This makes the Merge Threshold and Within Mesh controls available.
3 Set the appropriate parameters:

- To define the maximum distance over which vertices are merged, enter a value in Merge Threshold.
- To merge boundaries of adjacent elements and vertices within elements, turn on Within Mesh.

4 Click the Generate button.
The effect of the change is displayed in the object.
After the Generate button is clicked, a busy cursor will display. If the merge threshold is too large relative to the dimensions of the model, the busy cursor may display for a long time. To cancel the generation process at any time, press the Esc key.

Interface
Resolution group

Use these controls to change the vertex count and overall topology of the modified object.

Vert Percent The modified object's vertex count as a percentage of the overall number of vertices in the original mesh. Adjusting this setting alters the Vert Count value as well.

NOTE After you enter a specific percentage, such as 30, you might find that 3ds Max changes the value to a slightly lower one, such as 29.971. This is due to the relationship between the overall number of vertices in the model and the percentage calculation. It is not a bug, but simply the closest solution to your request.

Vert Count The total number of vertices in the modified object. Use this control to set the maximum number of vertices in the output mesh. Adjusting this setting alters the Vert Percent value as well.

Max Vertex Displays the vertex count from the original mesh that you applied MultiRes to. You cannot enter values larger than this in the Vert Count field.

Face Count Displays the current face count. As you adjust the Vert Percent/Vert Count settings, the value for the face count will update on the fly.

Max Face Displays the maximum face count.

Generation Parameters group

Vertex Merging When on, lets MultiRes merge vertices between discrete elements on page 8559 in a model.

For example, if you apply MultiRes to a teapot, which comprises four separate elements, and turn on Vertex Merging, as you adjust the vertex resolution, the separate components will meld together into one contiguous lower-resolution object.

To control Vertex Merging, you can set a Merge Threshold. This value determines the unit distance within which vertices will merge at a higher rate.

Threshold Sets the maximum distance in 3ds Max units between vertices in order for those vertices to be considered for merging. Within this distance, the vertices between elements are welded together at a higher rate as the mesh is reduced in complexity. Available only when Vertex Merging is on.

NOTE To eliminate only coincident vertices, set Threshold to 0.0. This is similar to the Weld Vertex function.
**Within Mesh** When on, MultiRes merges the boundaries of adjacent elements and vertices within elements. Many objects can contain multiple groups of vertices that don't share connectivity. A simple example of this is the Teapot object on page 416. It comprises four different elements: the body, the handle, the spout, and the lid. Normally, MultiRes optimizes each discrete element in a mesh on its own.

The default behavior of the Vertex Merging option is to merge vertices between elements. Turning on Within Mesh causes vertices within elements to be merged as well.

**Boundary Metric** When on, MultiRes preserves materials assigned to the selected model. The material boundaries defined by Material IDs are retained as long as possible, and are the last to be eliminated at low vertex counts. Default=off.

**Maintain Base Vertices** When on, overrides the MultiRes optimization algorithms and preserves any vertices selected at the MultiRes Vertex sub-object level as “critical” ones. Use this feature to retain critical features of an object or character such as its fingers or claws, or other geometry that might become unrecognizable if reduced too severely.

To select vertices for use with this option, use the MultiRes Vertex sub-object level. To access this level, first go to the modifier stack display and click the plus-sign icon next to the MultiRes modifier. This opens its hierarchy, which consists of the single Vertex sub-object level. Next, click the Vertex entry. The MultiRes vertices appear on the mesh as blue dots. You can select these using any standard interactive method, but you cannot transform them.

**IMPORTANT** After selecting MultiRes sub-object vertices with Maintain Base Vertices turned on, regenerate the mesh before changing the vertex resolution.

In the following illustration, the clown started out as a high-resolution mesh. All of the MultiRes vertices in the right half were selected, Maintain Base Vertices was turned on, and then the vertices were reduced.
Clown model with left half reduced, right half at original resolution

**Multiple Vertex Normals** When on, lets MultiRes assign multiple normals for each vertex. By default, MultiRes generates a single normal per vertex. If multiple normals are generated, they are applied as the vertex resolution is decreased and increased.

When the Multiple Vertex Normals option is on, the MultiRes modifier generates normal updates when the geometry surrounding a vertex changes.
You must specify a *crease angle* in degrees (0.0 - 180.0). The crease angle is the angle between the face normals. It is used to decide when a normal should be shared across an edge between two faces.

For example, in a plane defined as a mesh grid of 10 x 10 faces, any two adjacent faces have a crease angle of zero. In a cube, adjacent faces have a crease angle of 90 degrees. In general, crease angles approaching 0 yield smoother shading. Crease angles approaching 180 yield more visible corners.

**Crease Angle** The value of the crease necessary in order to generate multiple normals. Available only when Multiple Normals Per Vertex is on.

The optimal crease angle depends on the model; set it interactively and check the viewport and rendered images for shading effects. While use of Multiple Vertex Normals enables more accurate shading, it can require more internal data.

**Generate** Applies the current MultiRes settings to the modified object. When you first apply MultiRes to an object, you must use Generate to initialize the mesh-optimizing algorithm before you can change the vertex count.

**Reset** Sets all Generation Parameters rollout settings to their values as of the last time you used Generate. Available only when one or more of these settings has changed.

Use Reset to review the generation parameters as of the last time you generated the mesh.

---

**Noise Modifier**

Modify panel > Make a selection. > Modifier List > Object-Space Modifiers > Noise

Make a selection. > Modifiers menu > Parametric Deformers > Noise

The Noise modifier modulates the position of an object's vertices along any combination of three axes. This important animation tool simulates random variations in an object's shape.

Using a fractal setting, you can achieve random, rippling patterns, like a flag in the wind. With fractal settings, you can also create mountainous terrain from flat geometry.

You can apply the Noise modifier to any kind of object. The Noise gizmo changes shape to help you visualize the effects of changing parameter settings. The results of the Noise modifier are most noticeable on objects that have greater numbers of faces.
Most of the Noise parameters have an animation controller. The only keys set by default are for Phase.
Adding texture to the plane creates a calm sea.
Plane with fractal noise applied
Procedures

To apply noise to an object:

1. Select an object and apply the Noise modifier. To animate, move to a nonzero frame and turn on the Auto Key button.

2. In the Parameters rollout > Strength group, increase Strength values along one or more of the three axes. You begin to see noise effects as the strength goes up.

3. In the Noise group, adjust Scale. Lower values increase the dynamics of the Strength settings, making the effect more obvious. See Noise group, below, for other options. If you’ve animated this procedure, you can change parameters as the animation runs to see the effects.

For another source of noise effects, go to the sub-object level of the Noise modifier and transform the gizmo and center of the modifier.
To create terrain effects:

When set for Fractal, the Noise modifier produces a random fractal noise that creates a variety of topological and terrain effects. You can animate these effects or use them to model static landscapes and other complex forms.

The following steps assume you begin with a broad object like a multi-segment box lying on the XY plane.

1. Apply the Noise modifier to the object.
2. In the Parameters rollout > Noise group, turn on Fractal.
   Roughness and Iterations settings are now available.
3. Increase Strength on the Z axis and adjust other parameters.
   Once you have a base terrain, you can select sub-objects with Edit Mesh and apply Noise to grow mountains in a smaller region. You can also apply a second Noise modifier to amplify the first one.

Interface

Modifier Stack

Gizmo/Center You can move, rotate, or scale the gizmo and center sub-objects to affect the noise. You can also animate the sub-object transforms.

For more information on the stack display, see Modifier Stack on page 8187.
Parameters rollout

`Noise group`

Controls the appearance of the noise, and thus its effect on the physical deformations of the object. By default, the controls are inactive until you change the settings.

- **Seed** Generates a random start point from the number you set. Especially useful in creating terrain, because each setting can produce a different configuration.

- **Scale** Sets the size of the noise effect (not strength). Larger values produce smoother noise, lower values more jagged noise. Default=100.

- **Fractal** Produces a fractal effect based on current settings. Default=off.

If you turn on Fractal, the following options are available:
Roughness Determines the extent of fractal variation. Lower values are less rough than higher values. Range=0 to 1.0. Default=0.

Iterations Controls the number of iterations (or octaves) used by the fractal function. Fewer iterations use less fractal energy and generate a smoother effect. An iteration of 1.0 is the same as turning Fractal off. Range=1.0 to 10.0. Default=6.0.

Strength group

Controls the magnitude of the noise effect. No noise effect occurs until some strength is applied.

X, Y, Z Set the strength of the noise effect along each of three axes. Enter a value for at least one of these axes to produce a noise effect. Default=0.0,0.0,0.0.

Animation group

Controls the shape of the noise effect by overlaying a sine wave for the noise pattern to follow. This keeps the noise within bounds, dampening random extremes. When Animate Noise is turned on, these parameters influence the overall noise effect. However, you can animate Noise and Strength parameters independently; these do not require Animate Noise to be on during animation or playback.

Animate Noise Regulates the combined effect of Noise and Strength parameters. The following parameters adjust the underlying wave.

Frequency Sets the periodicity of the sine wave. Regulates the speed of the noise effect. Higher frequencies make the noise quiver faster. Lower frequencies produce a smoother and more gentle noise.

Phase Shifts the start and end points of the underlying wave. By default, animation keys are set at either end of the active frame range. You can see the effect of Phase more clearly by editing these positions in Track View. Select Animate Noise to enable animation playback.

Normal Modifier

Select an object. > Modify panel > Modifier List > Normal
Select an object. > Modifiers menu > Mesh Editing > Normal Modifier
The Normal modifier allows you to unify or flip the normals of an object without applying an Edit Mesh modifier.
For example, if you wanted to fly inside of a procedural object, such as a sphere or a cylinder, and wanted to retain control over the radius and number of segments, you couldn’t collapse the object to an Editable Mesh and maintain the procedural nature of the primitive.

Flipping the normals of a sphere creates a sky dome over a city.

**TIP** If you are animating the creation of a complex object such as a nested Boolean or a loft, and you think the operation might result in inconsistent faces, apply Normal to the result and turn on Unify.

**TIP** The Lathe modifier sometimes creates an object with normals pointing inward. Use the Normal modifier with both Unify and Flip turned on to fix “inside-out” lathe objects. The Normal modifier allows whole-object manipulations of normals to be performed quickly without using an Edit Mesh modifier.
Patches

Patch objects coming up the modifier stack are not converted to a mesh by this modifier. A patch object input to the Material modifier retains its patch definition. Files that contain patch objects with the Material modifier from previous versions of 3ds Max will be converted to meshes to maintain backward compatibility.

Procedures

To use the normal modifier:

1. Select an object, then on the Modify panel, choose Object-Space Modifiers > Normal from the Modifier List. The object appears to turn inside-out, since Flip Normals is on by default.

2. If the object has some faces pointing inward and others outward, turn on Unify Normals to make all the faces point similarly.

   **TIP** To flip or unify normals on portions of objects, convert to Editable Mesh and select Faces or Polygons. On the Surface Properties rollout in the Normals group, use the Flip and Unify buttons.

Interface

![Parameters](image)

**Unify Normals** Unifies the normals of an object by flipping the normals so that they all point in the same direction, usually outward. This is useful for restoring an object's faces to their original orientations. Sometimes normals of scenes that have come into 3ds Max as part of a DWG or DXF file are irregular, depending on the methods used to create the scene. Use this option of the modifier to correct them.
**NOTE** Unify Normals does not work on *editable poly* on page 2240 objects; before applying the Normal modifier, convert the model to editable mesh format or apply a *Mesh Select* on page 1500 or *Turn To Mesh* on page 1825 modifier.

*Flip Normals* Reverses the direction of all the surface normals of the faces of the selected object or objects. Default=on.

**Normalize Spline Modifier**

Select a spline object. > Modify panel > Modifier List > Normalize Spl. Select a spline object. > Modifiers menu > Patch/Spline Editing > Normalize Spline

The Normalize Spline modifier adds new control points in the spline at regular intervals. Use Normalize Spline to produce splines for motion paths that require constant velocity.

The spline on the left has been normalized.

**NOTE** This feature is not animatable.
Interface

Seg Length  Sets the length of the spline's segments, in 3ds Max units. The positions of the original vertices are discarded, and vertices are set to regular intervals. Segment length determines how many control points are added: shorter segments result in more control points, longer segments result in fewer. Default=20.0 units.

NSurf Sel Modifier

Select a NURBS curve or surface object. > Modify panel > Modifier List > NSurf Sel
Select a NURBS curve or surface object. > Modifiers menu > Selection Modifiers > NURBS Surface Select
Select a NURBS curve or surface object. > Modifiers menu > NURBS Editing > Surface Select

The NSurf Sel (NURBS Surface Selection) modifier lets you place a NURBS on page 2416 sub-object selection on the modifier stack. This lets you modify only the selected sub-objects. Also, selected curve sub-objects are shape objects that you can use as paths and motion trajectories.

If a NURBS surface object is nonrelational on page 2484, NSurf Sel can't select the sub-object levels Curve, Curve CV, or Point. NURBS surfaces are nonrelational by default. You can make the surface relational by turning on Relational Stack on the object's General rollout.

NSurf Sel can select any kind of NURBS sub-objects except imports. Each sub-object selection is of one particular sub-object level only.

NOTE  The NSurf Sel modifier doesn't support copying and pasting selections as Mesh Select on page 1500 does. Copying and pasting mesh selections is based on vertex indexes. NURBS selections are based on object IDs, which are unique to each model.
Procedures

To use the NSurf Sel (NURBS Surface Selection) modifier:

1. With a NURBS object selected in the Modify command panel, apply NSurf Sel.
   This modifier has no controls at the top level.

2. In the stack display, choose a sub-object level from the list.

   NSurf Sel has the same selection controls you see for NURBS surfaces, except that selecting connected curves or surfaces is not available.

   For more information on the stack display, see Modifier Stack on page 8187.
While applying the modifier, you can also select NURBS sub-objects by name. Turn on the Keyboard Shortcut Override toggle on page 8420 and then press the **H** key. This displays a version of the Selection Floater on page 209 that lists only sub-objects at the current level. Choose one or more objects in the list, and then click Select.

3 Use the selection controls to create a selection set of the chosen sub-object type.

   With NSurf Sel, the selection can be of surface CV or surface sub-objects. If you turn on Relational Stack for the NURBS object, you can also select point, curve, and curve CV sub-objects.

4 At the Surface CV sub-object level, adjust Soft Selection controls as you wish. These controls are the same as those in the Soft Selection rollout on page 2541 for NURBS curves and surfaces, except that the Same Type Only toggle is absent.

Once you've used the modifier to create the selection, you can apply other modifiers to it.

**Optimize Modifier**

Select an object. > Modify panel > Modifier List > Optimize
Select an object. > Modifiers menu > Mesh Editing > Optimize

The Optimize modifier lets you reduce the number of faces and vertices in an object. This simplifies the geometry and speeds up rendering while maintaining an acceptable image. A Before/After readout gives you exact feedback on the reduction as you make each change.
Optimize simplifies a smooth model with a high number of faces without greatly changing the model’s appearance.

**TIP** Because Optimize makes decisions based on angles between faces, it's sometimes best to apply it to selected face sub-objects rather than to an entire object. Avoid applying Optimize to areas where you want to preserve geometric detail.

**Applying Optimize**

When you first apply Optimize, you might not see any change in the viewports. Adjust the Face Threshold setting to obtain the best optimization. In the Last Optimize Status group, you can see how the object or faces were optimized. Watch these values while you adjust the Optimize parameters, until you have the best possible result.

**Setting Level of Detail**

Optimize lets you maintain two levels of optimization detail. You might set a lower optimization level, with fewer faces, to speed up your viewport work, and a higher level for final output in the renderer. However, you can render
at either level. You can also switch to the higher level in a viewport to get an idea of what the rendered image will look like.

**Procedures**

**To optimize manually:**

1. Set up two viewports: one wireframe, one smooth shaded.
2. Select an object and apply the Optimize modifier. The Parameters rollout for this modifier appears.
3. Turn off Manual Update and then adjust the Face Thresh value. Observe the result in the viewports. You can also choose to view the results of the Optimize operation manually by leaving the Manual Update check box turned on and clicking the Update button every time you wish to view a result.
4. In the Parameters rollout > Last Optimize Status group, notice the Before/After count for vertices and faces.
5. In the Optimize group, vary parameters to continue reducing geometry. Compare the result in the two viewports against the Before/After count.

**To set the level of detail:**

1. In the Parameters rollout > Level of Detail group, choose Viewports L1.
2. Adjust parameters in the Optimize and Preserve groups. This sets the L1 level of optimization for both the viewport and the renderer.
3. Repeat steps 1 and 2 for Viewports L2, adjusting parameters for a different optimization.

**To use level of detail:**

- Switch between L1 and L2 for either Viewports or Renderer. You see the effect immediately in a smooth shaded viewport. Do a test rendering to see the effect on the renderer.

The following parameters are stored for each level: Face Threshold, Edge Threshold, Bias, Max Edge Len, Material Boundaries, and Smooth Boundaries.
Interface

Level of Detail group

**Renderer L1, L2** Set the level of display for the default scanline renderer. Use Viewports L1 and L2 to change the stored optimization level. Default=L1.

**Viewports L1, L2** Set the optimization level for both viewport and renderer. Also toggles the level of display for the viewport. Default=L1.
Optimize group

Adjusts the degree of optimization.

**Face Thresh** Sets the threshold angle used to determine which faces are collapsed. Low values produce less optimization but better approximations of the original shape. Higher values improve optimization, but are more likely to result in faces that render poorly (see Bias). Default=4.0.

**Edge Thresh** Sets a different threshold angle for open edges (those that bound only one face). A low value preserves open edges. At the same time you can apply a high face threshold to get good optimization. Default=1.0.

**Bias** Helps eliminate the skinny or degenerate triangles that occur during optimization, which can cause rendering artifacts. Higher values keep triangles from becoming degenerate. The default of 0.1 is enough to eliminate the skinniest triangles. Range=0.0 to 1.0 (a 0 value turns Bias off).

**Max Edge Len** Specifies the maximum length, beyond which an edge cannot be stretched when optimized. When Max Edge Len is 0, it has no effect. Any value greater than 0 specifies the maximum length of the edges. Default=0.0.

Along with Bias, this control helps you avoid creating long skinny faces while optimizing.

**Auto Edge** Turns edges on and off following optimization. Turns on any open edges. Turns off any edges between faces whose normals are within the face threshold; such edges beyond the threshold are not turned on. Default=off.

Preserve group

Maintains clean separation at the face level between material and smoothness boundaries.

**Material Boundaries** Prevents face collapse across material boundaries. Default=off.

**Smooth Boundaries** Optimizes an object and maintain its smoothing. When turned on, allows only faces that share at least one smoothing group to collapse. Default=off.

Update group

**Update** Updates the viewports with the current optimization settings. Available only when Manual Update is turned on.

**Manual Update** Enables the Update button. When turned off, Optimize works as it does by default, updating the viewport display dynamically.
NOTE When using Manual Update, if you make any changes that cause the reevaluation of the stack, the existing optimization display disappears. Click the Update button again to restore it.

The Renderer ignores the optimization display in the viewport, using the Optimize settings, regardless of the state of the Manual Update.

**Last Optimize Status group**

Displays numerical results of optimization with exact before-and-after counts for vertices and faces.

**Patch Select Modifier**

Make a selection. > Modify panel > Modifier List > Patch Select

Make a selection. > Modifiers menu > Selection Modifiers > Patch Select

The Patch Select modifier lets you pass a sub-object selection up the stack to subsequent modifiers. It provides a superset of the selection functions available in the Edit Patch modifier on page 1329. You can select vertices, edges, patches, and elements. You can also change the selection from sub-object level to object level.

NOTE When you apply the Patch Select modifier and then go to any sub-object level, the select-and-transform buttons in the toolbar are unavailable, and the Select Object button is automatically activated.

**Using XForm Modifiers to Animate a Patch Selection**

When you apply a Patch Select modifier, there are no animation controllers assigned to the sub-object selection. This means that the selection has no way to "carry" the transform information needed for animation.

To animate a sub-object selection using Patch Select, apply either an XForm or Linked XForm modifier to the selection. These modifiers provide the necessary controllers for animating the effects of transforms. In a sense, they give "whole-object status" to the sub-object selection.

■ XForm on page 2010

    Animates transforms directly on a sub-object selection. Creates a gizmo and center for the sub-object selection. You can animate both, with the center acting as a pivot point for the selection.
Linked XForm on page 1484

Lets you choose another object to control the animation. The sub-object selection is linked to the "control object." When you transform the control object, the sub-object selection follows accordingly.

Procedures

To use the patch select modifier:

1 Create or select a patch object.

2 Go to the Modify panel and choose Patch Select from the modifier list.

3 Select vertices, handles, edges, patches, or elements.

4 Add another modifier to affect only the selection from step 3.

Interface

Modifier Stack

- Vertex Selects vertices.
- Handle Selects handles.
- Edge Selects edges.
- Patch Selects patches.
- Element Selects elements.

For more information on the stack display, see Modifier Stack on page 8187.
Parameters rollout

Provides buttons for turning different sub-object modes on and off, working with named selections and handles, display settings, and information about selected entities.

The icons at the top of the Selection rollout let you specify the method of face selection. Clicking a button here is the same as selecting a sub-object type in the modifier stack. Click the button again to turn it off and return to the object selection level.

- **Vertex** Selects a vertex beneath the cursor; region selection selects vertices within the region.

- **Handle** Selects a handle beneath the cursor; region selection selects multiple handles within the region.
Edge Selects an edge beneath the cursor; region selection selects multiple edges within the region.

Patch Selects a patch beneath the cursor; region selection selects multiple patches within the region.

Element Selects all contiguous faces in an object; region selection selects the same.

Select By Vertex Selects any sub-objects at the current level that use a vertex you click. Applies to all sub-object levels except Vertex. Also works with Region Select.

Ignore Backfaces Selects only those edges, patches, or elements whose normals make them visible in the viewport. When turned off (the default), selection includes all sub-objects, regardless of the direction of their normals.

NOTE The state of the Backface Cull setting in the Display panel doesn't affect sub-object selection. Thus, if Ignore Backfacing is turned off, you can select sub-objects even if you can't see them.

NOTE The state of the Ignore Backfaces check box also affects edge selection at the Edge sub-object selection level.

Get from Other Levels group

Applies selections from one sub-object level to another.

Get Vertex Selection Selects edges, patches, or elements based on the last vertex selection. The selection is added to the current selection. Available only when Vertex is not the current sub-object level.

Get Edge Selection Selects vertices, patches, or elements based on the last edge selection. Selects those vertices, patches, or elements that contain the edge. Available only when Edge is not the current sub-object level.

Get Patch Selection Selects vertices, edges, or elements based on the last patch selection. This selection is added to the current selection. Available only when Patch is not the current sub-object level.
Select by Material ID group

Selects faces based on their material ID.

ID Set the spinner to the ID number you want to select, and then click the Select button. Press Ctrl while clicking to add to the current selection, or press Alt to remove from the current selection.

Named Selection Sets group

These functions are primarily for copying named selection sets on page 217 of sub-objects between similar objects, and between comparable modifiers and editable objects. For example, you can apply a patch select modifier to a sphere, create a named selection set of edges, and then copy the selection to a different sphere that's been converted to an editable patch object. You can even copy the selection set to a different type of object, because the selection is identified by the entities' ID numbers.

The standard procedure is to create a selection set, name it, and then use Copy to duplicate it into the copy buffer. Next, select a different object and/or modifier, go to the same sub-object level as you were in when you copied the set, and click Paste.

NOTE Because sub-object ID numbers vary from object to object, the results of copying named selection sets between different objects can be unexpected. For example, if the buffered set contains only entities numbered higher than any that exist in the target object, no entities will be selected when the set is pasted.

Copy Places a named selection into the copy buffer.

Paste Pastes a named selection from the copy buffer.

Select Open Edges Selects all edges with only one face. In most objects, this will show you where missing patches exist. Available only at the Edge sub-object level.

Selection Info

At the bottom of the Patch Select Parameters rollout is a text display giving you information about the current selection. If 0 or more than one sub-object is selected, the text gives the number and type selected. If one sub-object is selected, the text gives the ID number and type of the selected item.

NOTE When the current sub-object type is Patch or Element, selection information is given in Patches.
Soft Selection rollout


PatchDeform Modifier (Object Space)

Select an object. > Modify panel > Modifiers List > Object-Space Modifiers > PatchDeform
Select an object. > Modifiers menu > Animation Modifiers > Patch Deform

The PatchDeform modifier deforms an object based on the contours of a patch object. This modifier works similarly to the PathDeform modifier on page 1569, but uses a quad-based patch object instead of a spline shape or NURBS curve path.

To use the PatchDeform modifier, apply it to the object you want to deform, click the Pick Patch button, and then select a patch object. Deform the object by manipulating the patch object or adjusting the various controls in the Patch Deform panel.

Not all objects can be used with PatchDeform. Objects that are valid PatchDeform targets include: Plane, Cylinder, Cone and Torus.

This modifier is also similar to the SurfDeform modifier on page 1774, except that it uses a patch surface instead of a NURBS Point or CV surface.

There’s also a world-space version of the PatchDeform modifier. See PatchDeform (WSM) on page 1150. Generally, the PatchDeform object-space modifier leaves the object in place while moving the patch to the object, while the PatchDeform world-space modifier leaves the patch in place while moving the object to the patch. Also, the WSM version has a Move to Patch button, while the object-space version does not.

Procedures

To use the PatchDeform modifier:

1. Select an object.
2. Apply PatchDeform.
3. On the Parameters rollout, click Pick Patch.
4. Select a patch object.
Deform the object by adjusting the controls in the Patch Deform panel and by manipulating the patch object.

**Interface**

**Modifier Stack**

**Gizmo** At this sub-object level, you can transform and animate the gizmo like any other object, altering the effect of the modifier. The PatchDeform gizmo is a representation of the deforming patch object, so transforming it determines which part of the patch affects the modified object.

**Parameters rollout**

![Parameters rollout image]

**Patch Deform group**

Provides controls that let you pick the patch and adjust the object's position and deformation along the gizmo copy of the patch.

**Patch** Displays the name of the selected patch object.

**Pick Patch** Click this button, and then select the patch object you want to use for the deformation. A gizmo is created for the object that matches the
patch. Once you assign the patch gizmo, you can adjust the deformation using the remaining controls in this rollout.

NOTE Patch Deform can be used only with a rectangular quad patch form. 3ds Max makes no distinction between quad-style patches and certain primitive meshes. Examples of suitable patches are the primitive quad patch object on page 2410, the primitive cylinder on page 403, and the primitive torus on page 409. (The cylinder actually has tri-patches at each end, but since they are at the end of the list of patches, PatchDeform just ignores these extra faces.)

U Percent Moves the object along the U (horizontal) axis of the gizmo patch, based on a percentage of the U distance. This spinner defaults to a setting of 50 percent, which places the object at the center of the gizmo patch. A setting of 0 percent places the object at the left edge of the gizmo patch, as seen from the viewport where the patch was created.

U Stretch Scales the object along the U (horizontal) axis of the gizmo patch.

V Percent Moves the object along the V (vertical) axis of the gizmo patch, based on a percentage of the V distance. A setting of 0 percent places the object at the bottom of the gizmo patch.

V Stretch Scales the object along the V (vertical) axis of the gizmo patch.

Rotation Rotates the modified object with respect to the gizmo patch.

Move To Patch Clicking this button moves the object from its original position to the patch object you are using for deformation. This button is only available with the PatchDeform (WSM).

Patch Deform Plane group

XY/YZ/ZX Choose a two-axis plane of the object to make parallel with the XY plane of the gizmo patch.

Flip Reverses the gizmo direction.

PathDeform Modifier (Object Space)

Select an object. > Modify panel > Modifier List > Object–Space Modifiers > PathDeform

Select an object. > Modifiers menu > Animation Modifiers > Path Deform
The PathDeform modifier deforms an object using a spline or NURBS curve as a path. You can move and stretch the object along the path, and rotate and twist it about the path. There's also a world-space modifier version. See PathDeform (WSM) on page 1150.

PathDeform creates a wiggle for the snake.

**Using a Path to Deform an Object**

Generally, you use the PathDeform modifier when you want to keep an object in place while deforming to a path. Use the PathDeform world-space modifier when you want to move an object to a path while keeping the path in the same world space.

To use the PathDeform modifier, you apply it, then click the Pick Path button and select a shape or curve consisting of a single open or closed spline. Once the object is assigned to the path, you can adjust the parameters to deform or animate the object along a gizmo copy of the path.
Procedures

To use the PathDeform modifier:

1. Select an object.
2. Apply PathDeform.
3. On the Parameters rollout, click Pick Path.
4. Select a spline or NURBS curve.
   Deform the object by adjusting the various controls in the Path Deform
   panel and by editing the path object.

Example: To use the PathDeform modifier to curve text:

1. In the Top viewport, create a circle with a radius of 100 units.
2. In the Front viewport, create a text shape with six or seven letters, and a
   size of 25. (You can use the default "MAX Text").
3. Apply an Extrude modifier on page 1425 to the text shape and set Amount
   to -5.0.
4. On the main toolbar, set the Reference Coordinate System to Local.
   Looking at the axis tripod for the extruded text object, you can see that
   its Z axis runs from back to front, relative to world space.
5. Apply a PathDeform object-space modifier to the text object, click the
   Pick Path button, and then select the circle.
   A circular gizmo is displayed. The circle runs through the local Z axis of
   the text object. Because of its orientation, its effect is minimal, but you
   can see a slight wedge-shaped deformation from the top view.
6 In the Path Deform Axis group, choose the Y option, and then the X option. The circle gizmo rotates to run through the specified axes, deforming the text object differently with each change.

7 Adjust the Percent spinner to view its effect, and then set it to 0. Try the same with Stretch, Rotation, and Twist, and then restore them to their original values. (Tip: Use the Ctrl key with Twist to amplify the effect.)

8 Turn Flip on and off to switch the direction of the path.

9 In the stack display, choose the Gizmo sub-object level, and move the gizmo path around. The text object is further deformed by its relative position to the gizmo.

10 In the stack display, turn off sub-object selection by selecting the original circle shape.

11 Adjust the circle's radius. The deformation of the text object changes because its gizmo is an instance of the shape object.

**Interface**

**Modifier Stack**

**Gizmo** At this sub-object level, you can transform and animate the gizmo like any other object, altering the effect of the modifier. The PathDeform gizmo is a representation of the deforming path object, so transforming it determines which part of the path affects the modified object.
Parameters rollout

![Path Deform Modifier (Object Space)](image)

### Path Deform group

Provides controls that let you pick a path and adjust an object's position and deformation along the path.

**Path** Displays the name of the selected path object.

**Pick Path** Click this button and then select a spline or NURBS curve to use as the path. The gizmo that appears is shaped like the path and is aligned with the local Z axis of the object. Once you assign the path, you can adjust the deformation of the object using the remaining controls in this rollout. The path you pick should contain a single, open or closed curve. If you use a path object consisting of multiple curves, only the first one is used.

**Percent** Moves the object along the gizmo path based on a percentage of the path length.

**Stretch** Scales the object along the gizmo path, using the object's pivot point as the base of the scale.

**Rotation** Rotates the object about the gizmo path.

**Twist** Twists the object about the path. The twist angle is based on the rotation of one end of the overall length of the path. Typically, the deformed object takes up only a portion of the path, so the effect can be subtle.
Path Deform Axis group

X/Y/Z Choose one to rotate the gizmo path to align with a specified local axis of the object.

Flip Reverses the gizmo path 180 degrees about the specified axis.

Point Cache Modifier (Object Space)

Select an object. > Modify panel > Modifier List > Object-Space Modifiers > Point Cache
Select an object. > Modifiers menu > Cache Tools > Point Cache

The Point Cache modifier lets you store modifier and sub-object animation to a disk file that records only changes in vertex positions, and then play back the animation using the information in the disk file instead of the modifier keyframes.

Point Cache is useful when the computation required for vertex animation becomes so excessive that it causes animation playback to run slowly or drop frames. Another use for this modifier is to apply the same animation to a number of objects, varying the Start Time and Strength settings for each so they don't all move identically.

NOTE Point Cache can be useful with Cloth animations on page 1204. If your Cloth animation includes cloth that tears (see Tearing Cloth on page 1207), the Welder modifier on page 2004 can help smooth joins and seams before tearing occurs.

The Point Cache modifier is also available in a world-space version on page 1156, for which usage is the same.

Special Point Cache Features

Special features in the Point Cache modifier include:

■ You can save animation files in XML and MCB formats for greater compatibility with other applications, such as Autodesk Maya, as well as the legacy PC2 format.

■ When recording to XML, you can save each animation frame in a separate file. Cache files for large meshes and long animations can be very large. Saving as a file per frame lets you manage data more easily and replace single frames if you find errors.
Compatibility with Autodesk Maya

Following is a suggested workflow for using Point Cache for working on an animation project in both 3ds Max and Autodesk Maya:

1. Create a deforming mesh (Skin, Cloth, etc.).
2. Apply the Point Cache modifier.
3. Save the cache in XML format with referenced MC files.
4. Save the mesh in FBX format.
5. Bring the mesh into Maya.
6. In Maya, load the cache data onto the mesh using the XML file to load the referenced MC files.
7. Modify the animation in Maya and save it, overwriting the XML and MC files.
   In 3ds Max, use the Point Cache > Reload command; this updates the animation to that saved from Maya.

Special Features in Point Cache

Both versions of the Point Cache modifier provide enhanced animation capabilities, including:

- Adjustable playback ranges and a playback graph, to animate which cache frame is played back. This lets you load a cache and then animate it, slowing down, stopping, reversing, etc.
- Nth-frame sampling, so you can sample every few frames to save disk space if sampling every frame is unnecessary, or record multiple samples per frame for improved motion blurring.
- The "strength" is adjustable in Absolute mode, so you can easily blend the cache with what is below in the stack.
- Improved cache file management.
- Pre-loaded caches to speed up playback.
Procedures

To use the Point Cache modifier:

1. Use one or more modifiers to animate an object. For example, you might apply a Bend modifier on page 1165, and then set keyframes for the Angle parameter to make the object bend back and forth.

2. Click Play Animation.
   If the animation is a good candidate for caching, the playback will drop many frames with Real Time Playback turned on, and will run slowly with Real Time Playback turned off.

3. From the Modify panel > Modifier List, choose Object-Space Modifiers > Point Cache.

4. On the Parameters rollout > Record group, set values for Start Time and End Time.

5. If you plan to render the cached animation using motion blur, decrease the Sample Rate setting.

6. Click the Record button, and use the Save Cache dialog to specify a cache file. To export the animation to another program, such as Autodesk Maya, use the XML file format; otherwise, use the PC2 file format.
   3ds Max records the animation to the cache file. When finished, the cache file name appears in the Cache File group.

7. In the Record group, click Disable Modifiers Below.
   This turns off all the object's modifiers below Point Cache so that only the cached vertex animation will appear when you play back the animation.

8. Click Play Animation again.
   This time the animation plays back quickly and smoothly.
Interface

Parameters rollout
**Cache File group**

Contains settings for recording vertex animation.

[file name] After you specify or load a cache file, its name appears in this field.

**New** Creates a new, empty cache file. After setting a new file, use Record to create the cache data.

You can save the file in either of two formats:

- **XML**: Saves the basic cache information in an XML file, and the animation data in one or more MC files (The XML file includes references to the MC files). The modifier uses multiple MC files if you set the Record group option to One File Per Frame. When recording multiple MC files, the modifier gives them the name [file name]Frame[frame number].mc; for example, Cylinder01Frame10.mc. If you set a non-integer value for Sample Rate, the modifier appends the sub-frame cache file names with Tick[tick number].

- **PC2**: Saves all cache information and data in a single PC2 file. When you use this format, the One File Per Frame option is unavailable.

**Load** Loads a vertex animation from a cache file on disk into the Point Cache modifier. If the number of vertices in the cache does not match the number of vertices in the object, the Cache Info group reports an error, and the animation doesn’t take effect.

Load supports these file formats: XML, PC2, PTS.

**Unload** Temporarily frees the current cache file, so it can be edited or deleted externally.

**Reload** Reopens the current cache file, if previously unloaded.

**Cache Info group**

Displays cache statistics in read-only format, including the number of files, point count, evaluations (number of samples), sample rate, start and end frames, and errors, if any.

**Record group**

Contains settings for recording cached animation.
One File/One File Per Frame Choose whether to save the cache in a single file, or in a separate file for each frame of recorded animation. The latter option is available only when using the XML file format.

Start Frame Sets the first frame for recording the vertex animation. Default=first frame of the active time segment.

End Frame Sets the last frame for recording the vertex animation. Default=last frame of the active time segment.

Sample Rate Sets the number of frames between each recorded sample. When rendering with motion blur, which uses sub-frame sampling, decrease this value. Default=1.0.

At the default value of 1.0, Point Cache records one sample per frame. Increasing the value causes a sample to be recorded every Nth frame. For example, a value of 10.0 records every tenth frame. Decreasing the value causes multiple samples to be recorded for each frame. For example, if you set Sample Rate to 0.1, Point Cache records 10 samples per frame at evenly spaced intervals.

Record Stores the vertex animation to a disk file. If no cache file is specified, or the specified file doesn’t exist, activates the Save Points dialog, which lets you specify a path and file name for the cache file. Click Save to record the file, and then load it into the Point Cache modifier, ready for playback.

TIP To change the path or file name, use Cache File group > New and specify a different cache file.

Enable Modifiers Below Turns on all stack modifiers below the Point Cache modifier. Use this when you want to change modifier settings.

Disable Modifiers Below Turns off all the object’s stack modifiers below Point Cache so that only the cached vertex animation appears when you play back the animation.

Load Type group

These options apply only to PC2 and PTS files; when the cache file type is XML they are unavailable.
Local  The method the modifier uses to load the cache file. The options are:
■ Stream  Keeps the cache file open for fast access, but loads only a single frame at a time to conserve memory. This is the default mode.
■ Per-Sample  Opens the cache file, reads a single frame, and then immediately closes the file. This is slower than the Stream method, but is useful if many users are reading/writing the same set of cache files since the cache files won't be locked open as you read from them.
■ Pre-Load  Loads the entire cache file into memory for fast access, and then closes the file. This is particularly useful in networked situations, or when a few cache files are used by many objects in one scene. In the latter case, using this option prevents each object from thrashing the disk on playback.
Be conservative in using this, as it can consume a great deal of memory. However, if one cache file is used by several objects, the cache is loaded into memory only once.

Slave  These options apply if 3ds Max is running as a network-rendering client; see the preceding for details. In this situation, only Per-Sample and Pre-Load are available, and the default option is Per-Sample, so the clients don't lock files.

[label]  This read-only field displays the size of the pre-loaded data when Local is set to Pre-Load.

Playback Options group

Strength  Affects the motion relative to the original animation. Applies only when Relative Offset is on. Default=1.0. Range=-10.0 to 10.0.
At 1.0, the animation plays back the same as recorded. With strengths between 0.0 and 1.0, the animation is relatively restrained. At strengths greater than 1, the animation is exaggerated. With negative Strength settings, the motion is reversed.

Relative Offset  Enables offsetting the animated vertex positions relative to their positions as recorded, based on the Strength setting. Default=off.

NOTE  When you turn on Relative Offset and play back a cached animation with the modifiers turned on, the cached vertex positions are calculated relative to their positions as calculated by the modifiers. For example, if you record a Bend animation to a cache file, and then play it back with both Relative Offset and the Bend modifier on and Strength=1.0, all vertex positions are doubled, resulting in exaggerated motion.
Apply To Whole Object  When off, only the active vertex selection is animated. In this case, for the cache animation to be visible, the selection must include at least some of the originally animated vertices.

Playback Type group

Playback Type  Specifies how playback occurs:

- **Original Range**  Plays back the cache over the range it was originally recorded, so the animation will always be the same as the original.

- **Custom Start**  Plays back the cache from a custom start time, set by Start Frame, but the animation length and playback speed will be the same as the original animation.

- **Custom Range**  Lets you set start and end frames within which the current cache plays back. Using a range that is smaller than the original record range plays the cache back faster, while specifying a larger range plays the cache back slower.

- **Playback Graph**  Lets you animate which cache frame is played at any given time.
  For example, if you record a cache from frames 0 to 100 and then want it to play back twice as fast forward and then in reverse, choose this option, turn on Auto Key, set the Frame parameter to 0.0 at frame 0, 100.0 at frame 50, and then back to 0.0 at frame 100. The function curve of this parameter in Track View shows how the cache is played back. Animating the Frame value lets you achieve unusual effects such as slowing a cache down over time, creating a ping-pong effect during playback, etc.

Start Frame  The frame number at which the cached animation starts playing back. Using decimal fractions lets you start at a sub-frame setting when using a Frame:Ticks time display. Available only when Playback Type is set to Custom Start or Custom Range. Default=0.0.

End Frame  The frame number at which the cached animation starts playing back. Using decimal fractions lets you start at a sub-frame setting when using a Frame:Ticks time display. Available only when Playback Type is set to Custom Range. Default=0.0.

Frame  Lets you animate playback of the cache; for details, see Playback Graph, above.

Clamp Graph  Controls what gets loaded when the Playback Graph frame is out of the original recorded range.
Take an example in which the playback frame is set to 105, but the original cache was recorded over frames 0-100. With Clamp Graph on, the loaded frame will be 100. If it's off (the default), the cache will "wrap around" and load frame 5.

This lets you loop caches more easily. In the above example, you could simply have a two-key playback graph. The first key would be at frame 0 with a value of 0.0, and the second would be at frame 100 with a value of 100.0. You would then set the out-of-range type on page 3961 for the Frame parameter (Playback Frame in Track View) to Linear, and the cache would loop back smoothly to the beginning at frame 101.

### Poly Select Modifier

Make a selection. > Modify panel > Modifier List > Poly Select

Make a selection. > Modifiers menu > Selection Modifiers > Poly Select

The Poly Select modifier lets you pass a sub-object selection up the stack to subsequent modifiers. It provides a superset of the selection functions available in Editable Poly on page 2240. You can select vertices, edges, borders, polygons, and elements. You can change the selection from sub-object level to object level.

When you apply the Poly Select modifier and then go to any sub-object level, the select-and-transform buttons in the toolbar are unavailable, and the Select Object button is automatically activated.

#### Using XForm Modifiers to Animate a Poly Selection

When you apply a Poly Select modifier, there are no animation controllers assigned to the sub-object selection. This means that the selection has no way to "carry" the transform information needed for animation.

To animate a sub-object selection using Poly Select, apply either an XForm or Linked XForm modifier to the selection. These modifiers provide the necessary controllers for animating the effects of transforms. In a sense, they give "whole-object status" to the sub-object selection.

- **XForm on page 2010**
  Animates transforms directly on a sub-object selection. Creates a gizmo and center for the sub-object selection. You can animate both, with the center acting as a pivot point for the selection.

- **Linked XForm on page 1484**
Lets you choose another object to control the animation. The sub-object selection is linked to the "control object." When you transform the control object, the sub-object selection follows accordingly.

Procedures

To use the Poly Select modifier:

1 Create or select an object.

   NOTE Applying a Poly Select modifier to an object other than a polymesh type will convert the object to a polymesh object. If you want more control over the conversion, add a Turn To Poly modifier on page 1830 before applying the Poly Select modifier. The Turn To Poly modifier provides conversion options that aren't available with the Poly Select modifier.

2 Apply the Poly Select modifier.

3 Select vertices, faces, or polygons.

4 Add another modifier to affect only the selection from step 3.

Interface

Modifier Stack

Vertex Selects vertices.
**Edge** Selects edges.

**Border** Selects borders.

**Polygon** Selects polygons.

**Element** Selects elements.

For more information on the stack display, see *Modifier Stack* on page 8187.

**Parameters rollout**

![Parameters rollout diagram]

Provides buttons for accessing different sub-object levels, working with named selections and handles, display settings, and information about selected entities.

The icons at the top of the Selection rollout let you specify the method of face selection.
Clicking a button here is the same as choosing a sub-object type in the modifier stack. Click the button again to turn it off and return to the Object selection level.

**NOTE** You can convert sub-object selections in two different ways with the use of the Ctrl and Shift keys:

- Clicking a sub-object button in the Selection rollout with Ctrl held down converts the current selection to the new level, selecting all sub-objects in the new level that touch the previous selection. For example, if you select a vertex, and then Ctrl+click the Polygon button, all polygons that use that vertex are selected.

- To convert the selection to only sub-objects all of whose source components are originally selected, hold down both Ctrl and Shift as you change the level. For example, if you convert a vertex selection to a polygon selection with Ctrl+Shift+click, the resultant selection includes only those polygons all of whose vertices were originally selected.

**Vertex** Selects a vertex beneath the cursor; region selection selects vertices within the region.

**Edge** Selects a polygon edge beneath the cursor; region selection selects multiple edges within the region.

**Border** Turns on Border sub-object mode, which lets you select an area on a mesh that can generally be described as a hole. Areas like this are usually sequences of edges with faces on only one side. For example, a box doesn’t have a border, but the Teapot object has several of them: on the lid, on the body, on the spout, and two on the handle. If you create a cylinder, then delete the top face, the top row of edges forms a border.

When the Border sub-object level is active, you can’t select edges that aren’t on borders. Clicking a single edge on a border selects that whole border. Borders can be capped (either in editable poly or by applying the cap holes modifier). They can also be connected to another object (compound object connect).
**Polygon** Selects all coplanar polygons beneath the cursor. Usually, a polygon is the area you see within the visible wire edges. Region selection selects multiple polygons within the region.

**Element** Selects all contiguous polygons in an object; region selection selects the same.

**By Vertex** Selects any sub-objects at the current level that use a vertex you click. Applies to all sub-object levels except Vertex. Also works with Region Select.

**Ignore Backfaces** Selecting sub-objects selects only those whose normals make them visible in the viewport. When turned off (the default), selection includes all sub-objects, regardless of the direction of their normals.

**NOTE** The state of the Display properties on page 164 > Backface Cull setting doesn’t affect sub-object selection. Thus, if Ignore Backfacing is turned off, you can select sub-objects even if you can’t see them.

**NOTE** The state of the Ignore Backfaces check box also affects edge selection at the Edge sub-object selection level.

**Shrink** Reduces the sub-object selection area by deselecting the outermost sub-objects. If the selection size can no longer be reduced, the remaining sub-objects are deselected.

**Grow** Expands the selection area outward in all available directions. For this function, a border is considered to be an edge selection.
With Shrink and Grow, you can add or remove neighboring elements from the edges of your current selection. This works at any sub-object level.

**Ring** Expands an edge selection by selecting all edges parallel to the selected edges. Ring applies only to edge and border selections.

Ring selection adds to the selection all the edges that are parallel to the ones selected originally.
**Loop** Expands the selection as far as possible, in alignment with selected edges.

Loop applies only to edge and border selections, and propagates only through four-way junctions.

Loop selection extends your current edge selection by adding all the edges aligned to the ones selected originally.

**Get from Other Levels group**

Applies selections from one sub-object level to another.

**Get Vertex Selection** Selects faces based on the last vertex selection. Selects all faces shared by any selected vertex. The selection is added to the current selection. Available only when the current sub-object level is not Vertex.

**Get Poly Selection** Selects vertices based on the last polygon/element selection. This selection is added to the current selection. Available only when the current sub-object level is not Polygon or Element.
**Get Edge Selection** Selects faces based on the last edge selection. Selects those faces that contain the edge. Available only when the current sub-object level is not Edge or Border.

**Select by Material ID group**

Selects faces based on their material ID.

**ID** Set the spinner to the ID number you want to select, and then click the Select button. Press Ctrl while clicking to add to the current selection, or press Alt to remove from the current selection.

**Named Selection Sets group**

These functions are primarily for copying named selection sets on page 217 of sub-objects between similar objects, and between comparable modifiers and editable objects. For example, you can apply a Poly Select modifier to a sphere, create a named selection set of edges, and then copy the selection to a different sphere that's been converted to an editable mesh object. You can even copy the selection set to a different type of object, because the selection is identified by the entities' ID numbers.

The standard procedure is to create a selection set, name it, and then use Copy to duplicate it into the copy buffer. Next, select a different object and/or modifier, go to the same sub-object level as you were in when you copied the set, and click Paste.

**NOTE** Because sub-object ID numbers vary from object to object, the results of copying named selection sets between different objects can be unexpected. For example, if the buffered set contains only entities numbered higher than any that exist in the target object, no entities will be selected when the set is pasted.

**Copy** Places a named selection into the copy buffer.

**Paste** Pastes a named selection from the copy buffer.

**Select Open Edges** Selects all edges with only one face. In most objects, this will show you where missing faces exist. Available only at the Edge or Border sub-object level.

**Selection Info**

At the bottom of the Parameters rollout for Mesh Select is a text display giving you information about the current selection. If 0 or more than one sub-object
is selected, the text gives the number and type selected. If one sub-object is selected, the text gives the ID number and type of the selected item.

NOTE When the current sub-object type is Element, selection information is given in polygons When the current sub-object type is Border, selection information is given in edges.

Soft Selection rollout

Soft Selection controls affect the action of sub-object Move, Rotate, and Scale functions. When these are on, 3ds Max applies a spline curve deformation to unselected vertices surrounding the transformed selected sub-object. This provides a magnet-like effect with a sphere of influence around the transformation.

For more information, see Soft Selection Rollout on page 2014.

Preserve Modifier

Modify panel > Make a selection. > Modifier List > Object-Space Modifiers > Preserve

Make a selection. > Modifiers menu > Parametric Deformers > Preserve

The Preserve modifier lets you retain, as much as possible, the edge lengths, face angles, and volume of an edited and deformed mesh object using an unmodified copy of the object before it was deformed. When you push and pull vertices at the sub-object level, the process typically stretches the edges and often alters the face angles, resulting in irregular topology. You can use the Preserve modifier to generate more regular edge lengths, and a “cleaner” mesh.

Procedures

Using the Preserve modifier:

1. Create an object. Before you edit it, create a copy.
2. Edit the copy at the sub-object level, pushing and pulling vertices, faces, and so on.
3. Apply the Preserve modifier to the copy, click the Pick Original button, and then select the original, unmodified object.
4. Adjust controls in the Preserve modifier to fine-tune the mesh.
Example: Use the Preserve modifier on a geosphere:

1. Create a GeoSphere on page 401 and use Shift+Move to make a copy of it.

   **TIP** If you want to see the effect of Preserve on mapping, apply a checker-mapped material to the sphere and display it in the viewports before making the copy.

2. Convert the copy to an editable mesh on page 2192.

3. At the Vertex sub-object level, select a third of the vertices at the top of the sphere, and move them upward (as seen from the front) about one radius in distance. Notice the stretched edges between the moved vertices and the remaining vertices.

4. While still at the Vertex sub-object level, apply the Preserve modifier.

5. Click the Pick Original button, and then select the original (unedited) sphere. The selected vertices move back toward the sphere in an attempt to maintain the original volume and edge lengths.

6. Turn on Invert Selection. The selected vertices return to their moved position, and the unselected vertices (the inverted selection) move up toward the selected vertices.

7. Turn off Invert Selection and slowly reduce the Iterations to 0. The object now looks as it did before you applied Preserve.

8. Increase Iterations to the default 25, and then increase it to approximately 75. The object is now almost completely spherical again.

9. Set Iterations back to 25, and then try different Edge Lengths, Face Angles, and Volume settings. (You can restore the defaults by setting Edge Lengths to 1.0, and Face Angles and Volume to 0.3.)
Steps in applying the Preserve modifier to a geosphere

Example: Animating a preserved object:

You can animate the Preserve parameters, but the following procedure shows you how to use Morph and Preserve together.

1. Remove the Preserve modifier from the copied sphere, and go to object level (instead of sub-object level).

2. With the copied (and deformed) sphere still selected, choose Create panel > Compound Objects > Morph to make it into a Morph object.
3 Make sure Instance is chosen in the Pick Targets rollout.
4 At frame 0, click Pick Target, and then select the original sphere.
5 In the Modify panel, go to frame 100, select sphere02 in the Morph Targets list, and click Create Morph Key.
The object now morphs from a sphere to a deformed sphere.
6 Apply Preserve to the morph object.
7 Click Pick Original, and select the original sphere.
The object now morphs from the sphere to a preserved and deformed sphere. Note that because the object selection is passed up the stack, the Preserve effect is applied to the entire sphere.
8 Choose Selected Verts Only in the Selection group.
Now, only the selected vertices are affected by Preserve. The morph still works, however.

Example: Using the Selection check boxes:
1 Reset 3ds Max, create a box, and convert it to an editable mesh.
2 Use Shift+Move to make a copy.
3 Use the Modify panel to select the top four vertices in the second box. Move them upward in Z, making the copied box taller than the original.
4 Apply Preserve, and pick the first box as the original.
The selected vertices move down to match the original edge lengths.
5 Set Iterations to 0 to move the vertices back up, then turn on Invert Selection, and set iterations back up to 25.
The selected vertices stay in their original locations, but the unselected vertices move upward to restore the original edge lengths.
6 Turn Iterations back down to 0. Turn on Apply To Whole Mesh (Invert Selection becomes unavailable), and then turn Iterations back up to 25. Preserve is now applied to the whole mesh. Since all vertices are affected, the top and bottom of the box approach each other.
7 Turn off Apply To Whole Mesh.
All vertices are translated, but maintain the same positions relative to each other.

8  Turn off Invert Selection and turn on Selected Verts Only.
    You're back to the original effect. You can move the Iterations spinner up and down to see that you're affecting only the selected vertices.

Example: Simulating cloth:

1  Reset 3ds Max, create a Quad Patch Grid, and convert it to an editable mesh.

2  Make a copy, and then make a reference of the copy.
    You should have a total of three objects in the scene.

3  Apply Preserve to the third patch, using the first as the original.

4  Select Selected Verts Only and Invert Selection.

5  Set Iterations to 100.

6  Select the second patch and go to the Sub-Object > Vertex level.

7  Select a single vertex in the middle of the patch and move it upward in Z.
    The third patch becomes a floating handkerchief.

8  Undo the vertex move.

9  Select the far two corner vertices of the second patch, and drag them upward in Z.
    Now, you've got the beginnings of a sheet hanging on the line.
Interface

**Original** Displays the name of the selected original object. (Note that the so-called "original" object doesn't actually have to be the original. It's simply a copy of the object that represents its unmodified topology.)

**Pick Original** Click this, and then select an unmodified copy of the current object. You should pick an object with the same topology as the current object, which has the same number of vertices. While you can select a completely different object with equal vertices, the results are unpredictable.

**Iterations** Specifies the number of calculations toward the solution. The higher this number, the closer the object comes to matching the original object and the slower the process. When this is set to zero, the original object has no effect, as if the Preserve modifier were never applied.

**Preservation Weights group**

**Edge Lengths, Face Angles, Volumes** Adjusts the relative importance of the three components you're attempting to preserve: edge lengths, face angles, and volume. In most cases, you'd leave these at their default settings, but you can achieve some interesting effects by altering them. Higher face angles, for example, produce stiffer meshes.
Selection group

Provides options that let you specify which selection level to take from previous selection modifiers in the stack. The Preserve modifier acts on the specified selection.

Apply to Whole Mesh Applies Preserve to the entire object, regardless of the selection passed from previous levels of the stack. Disables the other two check boxes.

Selected Verts Only Uses previous sub-object vertex selections. Note that it doesn't matter if the Vertex sub-object level is active in a previous stack item. As long as vertices have been selected, Preserve will use that selection.

Invert Selection Inverts the selection passed up the stack.

NOTE If all of the check boxes are turned off, Preserve uses whatever active selection is passed up the stack. Thus, if a Mesh Select modifier is set to the Vertex level, then that vertex selection is used. If the same Mesh Select modifier is set to the top (object) level, then the entire object is affected.

Projection Modifier

Select an object. > Modify panel > Modifier List > Object-Space Modifiers > Projection

The Projection modifier is used primarily to manage objects for producing normal bump maps on page 6856. You apply it to the low-resolution object, and then pick a high-resolution object as the source for the projected normals. When you use the Render To Texture dialog on page 6869 to set up projection, Render To Texture applies the Projection modifier to the low-resolution object automatically. You can also explicitly apply the Projection modifier to set up the projection before you use Render To Texture.

NOTE The low-resolution object requires UV coordinates, but the high-resolution source object does not need to have them. When the normals map is rendered, you can choose to have Render To Texture apply an “Automatic Flatten UVs” (Unwrap UVW) modifier on page 1837 to the top of the low-res object's stack; or you can use existing mapping, if such exists.

You can apply more than one instance of the Projection modifier to the same object, and you can instance it across multiple objects.
The Projection modifier is a topology-dependent modifier on page 8744, so when you select an item in the stack that is lower than the Projection modifier, you see a warning dialog that asks if you want to proceed. (The same is true of the Automatic Flatten UVs modifier.)

**Projection and Sub-Object Selections**

You can match geometry to sub-object selections. There are two ways to do so: matching material IDs, or matching named selections of sub-object geometry.

**Matching Material IDs**

Here is a sample workflow for using material IDs to match portions of the low-res object to different high-res objects:

1. At the level of the low-res object itself, assign differing material IDs to different face selections.
   - To do so, the low-res object must be a surface model; that is, an editable mesh, editable poly, editable patch, or NURBS surface. Use the Surface Properties rollout to change the material ID of sub-object selections.

2. For the high-res target objects, assign corresponding material IDs. An easy way to do this is to apply the Material modifier on page 1490.

3. In the Resolve Hit group of the Projection Options dialog on page 6888, turn on Hit Only Matching Material ID.

4. Render to texture.
   - The texture for faces of the low-res object receive texture element information only from the source object that had the corresponding material ID.

**Matching Selected Geometry**

Here is a sample workflow for using sub-object selections to match portions of the low-res object to different high-res objects.

1. In the Projection modifier, go to the Face or Element sub-object level.
   - See Selection Rollout (Projection Modifier) on page 1598.

2. Make a sub-object selection, then on the Reference Geometry rollout on page 1601, enter a descriptive name in the Name field.
3 Click the Add button or press Enter.
   The name of the sub-object selection set is added to the list.

4 Click in the list to highlight the selection-set name, click Pick or Pick List, and then select the high-res source object to associate with the sub-object selection.

5 Repeat steps 2 through 4 to associate different sub-object selections with different source objects.

6 Choose Rendering > Render To Texture.
   The Render To Texture dialog appears.

7 In the Projection group of the Objects To Bake rollout on page 6872, turn off Object Level and turn on Sub-Object Levels.

8 Click Render.
   Render To Texture renders a separate texture for each of the named sub-object selections contained in the Projection modifier.

See also:
- Soft Selection Rollout on page 2014

**Selection Rollout (Projection Modifier)**

Select an object. > Modify panel > Modifier List > Object-Space Modifiers > Projection > Selection rollout

The Projection modifier's Selection rollout is for managing sub-object selections.
Interface

- **Cage** Click to turn on the Cage sub-object level.

The Cage is the surface from which normals are projected. At the Cage sub-object level, you can adjust the cage manually by transforming sub-object selections of cage vertices.

- **Face** Click to turn on the Face sub-object level.

The Face sub-object level lets you assign different source geometry to different portions of a surface.

- **Element** Click to turn on the Element sub-object level.

The element sub-object level lets you assign different source geometry to individual elements. (An element is a group of contiguous faces.)

**Shrink** Reduces the sub-object selection area by deselecting the outermost sub-objects. If the selection size can no longer be reduced, the remaining sub-objects are deselected.

**Grow** Expands the selection area outward in all available directions.
With Shrink and Grow, you can add or remove neighboring elements from the edges of your current selection. Shrink and Grow work at any sub-object level.

**Ignore Backfacing** When on, selection of sub-objects affects only those facing you. When off, you can select any sub-objects under the mouse cursor, regardless of visibility or facing. If multiple sub-objects lie under the cursor, repeated clicking cycles through them. Likewise, with Ignore Backfacing off, region selection includes all sub-objects, regardless of the direction they face. Default=off.

**Get Stack Selections** Click to collect sub-object selections from modifiers that are below the Projection modifier on the stack.

**Select SG** To select by smoothing group value, use the spinner to set the number of the smoothing group, and then click Select SG.

**Select MatID** To select by material ID, use the spinner to set the ID number, and then click Select MatID.

- **Sub-material drop-down list** When a multi/sub-object material is applied to the low-res object, this list shows the names and numbers of sub-materials that are assigned to faces or elements of the object. When you have selected by material ID, the corresponding sub-material appears in the field above the list.

**Clear Selection** When on, each stack, smoothing group, or material ID selection you make replaces the previous selection. When off, each new selection is added to the previous selection set. Default=on.
Reference Geometry Rollout (Projection Modifier)

Select an object. > Modify panel > Modifier List > Object-Space Modifiers > Projection > Reference Geometry rollout

On the Reference geometry rollout, you can create named sub-object selection sets, and associate them with high-resolution geometry.

Interface

Name Lets you enter a name for the current set of selected sub-objects.

Delete Click to delete the sub-object selection set whose name is highlighted in the list.

Add Click to add the named sub-object selection set to the list.
Keyboard shortcut: Enter.

Select Click to select the sub-objects in the selection set whose name is highlighted in the list.

Delete All Click to delete all named sub-object selection sets in the list.

Reference geometry window This window shows a list of named sub-object selection sets, and the high-resolution source geometry with which they’re associated. If you have picked a high-res object at the object level, it also shows “Object Level” followed by the name of the source object.

Proportion Multiplier When Proportional is chosen for sub-object normal bump mapping in the Projection Mapping group of the Objects To Bake rollout on page 6872 for Render To Texture, this value multiplies the default size of the normal bump map. Range=0.0 to 2.0. Default=1.0.

For example, if Proportional rendering of a sub-object were to render a sub-object selection at 16 x 16 pixels, changing Proportion Multiplier to 2.0 would change the size of the normal bump map to 32 x 32 pixels.

This control is unavailable unless a sub-object selection is active.

Pick To associate high-res geometry with the current selection, click Pick to turn it on, then click a source object in a viewport.

Pick List To associate high-res geometry with the current selection, click Pick List, then use the Add Objects dialog, which works like the Select From Scene dialog on page 206, to choose a source object.

Display Toggle group

The Display Toggle group is useful when you want to compare the hi—res to your low-res geometry. You can quickly toggle between your low-res geometry and your hi-res geometry to compare versions. You can show selected or all hi-res geometry.

Enable When on, makes it possible to show or hide reference geometries. Default=off.

Hide Reference Geometry/Hide Working Geometry When Enabled is on, click Hide Reference Geometry to hide your hi-res geometry. Conversely, click Hide Working Geometry to hide your low-res geometry. You can also selectively
show and hide high-res geometries in your Pick List. Click Off to hide a geometry. Click Hide to show a geometry.

**Cage Rollout (Projection Modifier)**

Select an object. > Modify panel > Modifier List > Object-Space Modifiers > Projection > Cage rollout

These settings adjust the cage and its display. The cage is the nonrenderable geometry that the Projection modifier uses as the surface from which it ray-traces normals.

---

**NOTE** Special export/import functionality available on this rollout lets you convert the cage into standard geometry of the same type and topology as the cage and modified object, which you can edit using standard methods and then use to define a new shape for the cage. This provides access to the full range of mesh-editing tools available in 3ds Max for shaping the cage to your precise requirements. For example, with editable poly, you can take advantage of tools such as Loop, Ring, Grow, and Shrink, and quickly switch among sub-object levels such as Face and Vertex.

---

**Procedures**

**To use Export and Import with a cage:**

1. Create a cage:
   1. Create low-resolution and high-resolution objects. In most cases, for best results they should be arranged concentrically.
   2. Apply the Projection modifier to the low-resolution object. This creates the cage with the same shape and position as the low-resolution object.
   3. Use the Reference Geometry rollout controls to specify one or more high-resolution objects.
   4. On the Cage rollout, click Update. This reshapes the cage, roughly enveloping the high-resolution object(s).

2. On the Cage rollout, click Export.
This creates a separate geometrical object in the same shape as the cage, with the same type and topology as the low-resolution object. We'll call this the cage object.

For example, if the low-resolution object is an editable poly, or has an Edit Poly modifier at the top of the modifier stack, the resultant cage object is of editable poly type.

3 Use standard object-editing tools to modify the cage object's shape. Do not alter its topology by adding or removing vertices, edges, etc., because that would invalidate its usage for reshaping the cage. Also, for best results, do not move the cage object. If you wish, you can temporarily hide any overlapping objects.

4 Select the low-resolution object.

5 On the Cage rollout, click Import and then select the cage object. If the cage object type and topology are the same as the low-resolution object, 3ds Max reshapes the cage to match the cage object's shape. Alternatively, if the cage object can be converted to the same type as the low-resolution object without a change in topology, it is also accepted. If not, a warning appears and no reshaping takes place.

**IMPORTANT** The resultant cage matches the imported cage object's shape, position, orientation, and size exactly.

If the import is successful, the cage object can be deleted, or retained for possible future cage modification.
## Interface

### Display group

**Cage** When on, the cage is displayed. When off, the cage is hidden except at the Cage sub-object level. Default=on.

The cage is always displayed at the Cage sub-object level, regardless of this toggle's setting. See [Selection Rollout (Projection Modifier)] on page 1598.

- **Shaded** When on, the cage is shaded with a transparent gray. When off, the cage is displayed as a blue lattice. Default=off.

  The Shaded option can be useful when you need to tell whether or not high-resolution source geometry is within the cage, and when you need to expand the cage to include more geometry.

- **Point to Point** When on, additional lines connect vertices in the cage to points on the target object, showing how the projection will be done. Default=off.
Push group

These controls let you adjust the size of the cage as a whole, or on a sub-object selection if one is currently chosen (see Reference Geometry Rollout (Projection Modifier) on page 1601).

Amount Change to adjust the size of the cage in 3ds Max units. Positive values increase the size of the cage; negative values decrease the size. Default=0.0.

Percent Change to adjust the size of the cage as a percentage. Positive values increase the size of the cage; negative values decrease the size. Default=0.0.

Auto-Wrap group

By default, the Projection modifier does not automatically create a cage that wraps around the geometry. To change the cage, use the settings in this group or the Push group, or adjust cage vertices manually at the Cage sub-object level.

Tolerance The distance in 3ds Max units, between the cage and the target geometry. Positive values are outside the high-res source geometry; negative values are inside the source geometry. Default=varies, depending on the geometry.

Always Update When on, the cage automatically expands around high-res geometry as it is added to the list (see Reference Geometry Rollout (Projection Modifier) on page 1601). When off, the initial cage is not updated automatically. Default=off.

Update Click to update the cage. Use this when Always Update is off.

Import Lets you specify a mesh object to define the cage shape. This is typically an object that was created with Export (see following) and then modified using standard mesh-editing methods. After clicking Import, select the object to import. After importing the object, the cage conforms to its shape. You can then delete the imported object if you wish.

IMPORTANT The imported object should be of the same type (for example, editable mesh) as the projection object (that is, the object with the Projection modifier), or be convertible to that type without topology change, and must have the identical topology. If it doesn't meet either or both of those criteria, an alert appears requesting that you select an object of the same type and identical topology.
Export  Creates a geometry object from the cage, with the same type and
topology as the modified object. Clicking Export causes the Export Cage dialog
to open. Accept the default “Export as” object name or enter a new one, and
then click OK.

For a detailed description of the export/import process, see To use Export and
Import with a cage: on page 1603.

Reset  Click to reset the cage to a wrapping that is the same size as the
low-resolution target geometry.

Selection Check Rollout (Projection Modifier)

Select an object. > Modify panel > Modifier List > Object-Space Modifiers >
Projection > Selection Check rollout

This rollout lets you check selections to see if any are overlapping; that is, if
a material ID or a face or element is assigned to more than one selection.

Interface

Check group

- Material IDs  Checks for material IDs being assigned to more than one
selection.
- **Geometry**  Checks for faces or elements being assigned to more than one selection.

- **Both** (The default.) Checks for both material ID and sub-object overlap.

---

**Check**  Click to run the check.

**Select Faces**  When on, if running the selection check detects “bad” selections, the “bad” faces are selected by the Projection modifier automatically. When off, “bad” selections are not selected automatically. Default=on.

**Results group**

After you click Check, the fields in this group display the results. The first field is for material IDs, and the second is for sub-object selections. If there is no conflict, the first field says “No conflicting Mat IDs detected,” and the second says “No conflicting face selections detected.” If there is a conflict, the results say something such as, “6 Mat IDs are assigned to more than one selection.”

**Projection Rollout (Projection Modifier)**

Select an object. > Modify panel > Modifier List > Object-Space Modifiers > Projection > Projection rollout

The Projection rollout has controls for projecting data from the object with the Projection modifier to a different object. This data flow is the reverse of what it is when you project normals from a high-resolution object to a low-resolution object.
Interface

**Projector list** Shows the active projector plug-ins.

**Projector plug-in drop-down list** Lets you choose a projector plug-in. Only one projector, Project Mapping, is provided with 3ds Max. See Project Mapping Rollout (Projection Modifier) on page 1610. Additional projectors might be available from third-party sources.

**NOTE** Multiple instances of the Project Mapping plug-in can be active.

**Add** Adds a projector of the type chosen in the drop-down list.

**Remove** Removes the projector that is currently highlighted in the projector list.

**Project to** Shows the name of the geometry to which you're projecting. To choose this geometry, use the Reference Geometry rollout on page 1601.

**Show Alignment** Click to display the faces of the geometry selection that will project to the selected faces of the object that has the Projection modifier. This shows which hi-res faces will be projected to the selected low-res faces. This works only for selected faces, not selected vertices: you can lock a face selection and then make adjustments to the cage, then click Show Alignment to see the effects of the cage modification. This button is unavailable if no selection has been made in the Reference Geometry rollout.
Clear Click to turn off the Show Alignment display.

Project Click to perform the projection.

Project All Click to perform all projections that are in the projector list.

**Project Mapping Rollout (Projection Modifier)**

Select an object. > Modify panel > Modifier List > Object-Space Modifiers > Projection > Projection rollout > Choose Project Mapping in the plug-in drop-down list (this is the only available choice unless third-party plug-ins have been installed). > Click Add > Project Mapping rollout.


The Project Mapping rollout contains controls for the Project Mapping projector plug-in. This rollout is visible when a Project Mapping instance is highlighted in the Projector list on the **Projection rollout** on page 1608. Use Project Mapping to project a map channel value, material IDs, or vertex attributes from the object that has the Projection modifier applied, onto other geometry.
Interface

- Project Mapping
  - Project Mapping 1
    - Projection Holder
      - Projection Holder 1
        - Create New Holder
        - Same Topology
        - Always Update
  - Source Channel
    - Map Channel
    - Vertex Color
    - Vertex Illum
    - Vertex Alpha
    - Vertex Position
  - Target Channel
    - Same as Source
    - Map Channel
    - Vertex Color
    - Vertex Illum
    - Vertex Alpha
    - Vertex Position
  - Project Material IDs
    - Projection Mapping Quality
      - Ignore Backfaces
      - Test Seams
      - Check Edge Ratios
        - Threshold: 0.1
      - Weld UVs
        - Threshold: 5.0
**Projector name field** Shows the name of the Project Mapping projector. If you edit this field, the change is reflected on the Projection rollout on page 1608.

**Projection Holder group**

**Projection Holder name field** Shows the name of the Projection Holder modifier. If you edit this field, the change is reflected in the target object’s stack, but not until you click Project on the Projection rollout.

**Create New Holder** When you click the Project button in the Project rollout, a Projection Holder modifier is added to the geometry selection. When Create New Holder is on, 3ds Max creates and adds a new modifier each time you click Project. When Create New Holder is off, clicking Project simply updates the data in the existing Projection Holder; it creates a new Projection Holder modifier only if none was present, before. Default=off.

**Same Topology** When on, the source object’s topology is transferred to the target object. Default=off.

**IMPORTANT** You need to turn on Same Topology when you project to the target object’s Vertex Position.

**Always Update** When on, changing the object with the Projection modifier automatically re-projects and updates the Projection Holder modifiers on the geometry selections. When off, projection is recalculated only when you click Project. Default=off.

This toggle is available only when Create New Holder is off and Same Topology is on.

When Always Update is on, changes to the geometry with the Projection modifier can manipulate UVW channels or animate vertex colors of the objects with the Projection Holder modifiers.

**Source Channel group**

- **Map Channel** (The default.) Projects a map channel on page 8627 value. Use the spinner to set the channel value.

- **Vertex Color** Projects vertex color values.

- **Vertex Illum** Projects vertex illumination (grayscale) values.

- **Vertex Alpha** Projects vertex alpha values.

- **Vertex Position** Projects vertex positions.
Target Channel group

**Same as Source** When on, the radio buttons in this group are disabled, and the Project Mapping projector projects to the same channel that is chosen in the Source Channel group. When off, the radio buttons in this group are enabled. Default=on.

The radio buttons are the same as the ones in the Source Channel group.

When Same As Source is off, the chosen map channel or vertex data of the target geometry derives its value from the channel or vertex data chosen in the Source Channel group.

The projection does not take place until you click Project or Project All on the Projection rollout.

---

**Project Material IDs** When on, projects values. Default=off.

The projection does not take place until you click Project or Project All on the Projection rollout.

Projection Mapping Quality group

Use these settings to improve the quality of the mapping when projecting texture mapping from one object to another.

**Ignore Backfaces** When on, does not take backfaces into account when calculating the projection. In the case of overlapping faces, this can prevent projection, resulting in undesirable erroneous faces. In almost all cases this should remain off.

**Test Seams** Tests for seams by walking around the neighboring faces and then will try to fix the faces.

**Check Edge Ratios** Attempts to correct UVW faces that look abnormal; that is, that are not similar to their geometry faces. This compares edge ratio lengths and angle ratio. It typically finds the sliver faces generated by projections across seams. The larger the Threshold value, the more likely a face is to be tagged as abnormal and fixed.

**Weld UVs** Welds all the UVs at the end of the projection and combines them into groups, based on the Threshold value. The Threshold value is based on edges, so it welds UVs based on the the closest N edges. In most cases this should be on.
Projection Holder Modifier

Select an object. > Modify panel > Modifier List > Object-Space Modifiers > Projection modifier > Geometry rollout > Choose target geometry > Projection rollout > Click Add. > Click Project. > Projection Holder is applied to the target geometry.

The Projection Holder modifier appears for objects being used by the Projection modifier's Project Mapping feature on page 1608. It contains the data generated by the Project Mapping operation, much as UVW Mapping Add or UVW Mapping Clear do for Channel Info manipulations.

Interface

The Projection Holder modifier has no parameters.

ProOptimizer Modifier

Create or import an object. > Modify panel > Modifier List > ProOptimizer modifier

Select an object or objects. > Modify panel > Modifier List > ProOptimizer modifier

The ProOptimizer modifier lets you select objects and interactively optimize them.

The ProOptimizer feature is an optimization tool that helps you reduce the number of vertices (and so the number of faces) in an object while preserving the object's appearance. Options let you maintain material, mapping, and vertex color information in the optimized model.

Optimizing objects can reduce a scene's memory requirements, simplify modeling because objects have fewer faces, and improve the speed of viewport display and rendering time.

There are two ways to use ProOptimizer:

- The ProOptimizer modifier, described here, lets you select objects and interactively optimize them.

- The Batch ProOptimizer utility on page 2768 lets you optimize multiple scene files (MAX or OBJ files) at the same time.
TIP With the Batch ProOptimizer, you can optimize meshes before you import them. This can save time. The Batch ProOptimizer is also a good choice if the original meshes are extremely dense.

Original model
Vertices: 47226
Faces: 93792

Optimized model, Vertex % = 10.0
Vertices: 4722
Faces: 9323
Optimized model, Vertex % = 5.0
Vertices: 2361
Faces: 4660

Optimization Level Rollout

Create or import an object. > Modify panel > Modifier List > ProOptimizer modifier > Optimization Level rollout

The main ProOptimizer modifier controls are on the Optimization Level rollout.

To initialize ProOptimizer, click Calculate. You can then adjust the optimization level interactively. You choose the level of optimization either by setting the percent of vertices to preserve (Vertex %), or by setting an explicit count of vertices to preserve (Vertex Count).
Additional rollouts contain options that let you control how the model is optimized, and what kind of information to retain or discard. These options are not interactive. If you adjust their settings after an initial optimization, you must click Calculate once again to see the effects.

**ProOptimizer Workflow**

To use the ProOptimizer modifier, follow these steps for most situations:

1. Select the object or objects you want to optimize.

2. Go to the Modify Panel and apply the ProOptimizer modifier.

   **NOTE** The ProOptimizer modifier is available for 3ds Max geometric objects, but not for nongeometric objects such as lights, cameras, or helpers.

3. In the Optimization Level rollout, click Calculate. This initializes ProOptimizer and lets you interactively adjust the optimization level.

4. Adjust the Vertex % or Vertex Count value until you have the level of optimization you want to achieve.

5. If you want to change the optional settings, do so now, and then click Calculate once again.

   **TIP** Once you are familiar with ProOptimizer, you can also change these settings before the first time you click Calculate.
When you have obtained the level of optimization and detail that you want, right-click the stack and choose Collapse All from the pop-up menu. This creates an Editable Mesh object with an optimized number of faces.

**Interface**

**Optimization Level rollout**

- **Vertex %** Sets the number of vertices in the optimized object as a percentage of the vertices in the original object. Default=100.0 percent.
  
  This control is unavailable before you click Calculate. After you click Calculate, you can adjust the Vertex % value interactively.

- **Vertex Count** Directly sets the number of vertices in the optimized object.
  
  This control is unavailable before you click Calculate. After you click Calculate, this value is set to the number of vertices in the original object (because Vertex % defaults to 100). Once this control is available, you can adjust the Vertex Count value interactively.

- **Calculate** Click to apply the optimization.
  
  If optimization takes some time, you can cancel the operation by pressing Esc.

**Status window** This text window shows the ProOptimizer status. Before you click Calculate, it displays “Modifier Ready.” After you click Calculate and adjust the optimization level, it displays statistics that describe the effect of the operation: “before” and “after” vertex and face counts.
If, after a calculation, you change a setting in the one of the Options rollouts, the text changes to “Optimization Invalid.” You must click Calculate again to see the results of changing the options.

The optimization can also become invalid if you move the ProOptimizer modifier location on the stack, or change topology on the stack below the ProOptimizer modifier.

If you press Esc to cancel an optimization, this window displays “Optimization Cancelled.”

**Options rollouts**

The options rollouts contain various settings that control ProOptimizer. They are described in the the topics that follow.

**Optimization Options Rollout**

Create or import an object. > Modify panel > Modifier List > ProOptimizer modifier > Optimization Options rollout

The Optimization Options rollout lets you control how ProOptimizer treats such features as object borders, materials and mapping, vertex colors, and sub-object selections.

**IMPORTANT** The controls on this rollout are *not* interactive. If you change a setting, the Status window on the Optimization Level rollout displays “Optimization Invalid,” and you must click Calculate once again to see the result of changing the option value.
**Optimization Mode Group**

Create or import an object. > Modify panel > Modifier List > ProOptimizer modifier > Optimization Options rollout > Optimization Mode group

Controls how ProOptimizer treats object borders.

An edge is considered to be on the “border” of an object, when it is shared by no other face. Preserving borders can be important to preserving the appearance of a model.

*Original model*

*Vertices: 557*
Interface

**Crunch Borders** ProOptimizer optimizes the object without considering whether edges and faces lie on borders or not.

Crunch Borders active

Vertex % = 50.0

Vertices = 278

Faces are reduced but object borders are not preserved
Protect Borders (The default.) ProOptimizer protects faces with edges that are on the border of the object. However, a high optimization level can still cause border faces to be removed. If you are optimizing multiple connected objects, gaps might appear between them.

Protect Borders active

Vertex % = 50.0

Vertices: 557

Borders are preserved
Protect Borders active

Vertex % = 1.0

Vertices: 5

Decreasing Vertex % or Vertex Count can cause borders to become distorted.

**Exclude Borders** ProOptimizer never removes faces with border edges. This reduces the number of faces you are able to remove from the model, but it ensures that gaps don’t appear when you optimize multiple connected objects.
Exclude Borders active
Vertex % = 10.0
Vertices: 65
At low Vertex % values, Exclude Borders can interfere with optimization.

**Materials and UVs Group**

Create or import an object. > Modify panel > Modifier List > ProOptimizer modifier > Optimization Options rollout > Materials and UVs group

Controls how ProOptimizer treats objects with materials or texture mapping.
Interface

Keep Material Boundaries When on, ProOptimizer preserves boundaries between materials. Points that belong to faces that have different materials are frozen, and not removed during optimization. Default=on.

When off, ProOptimizer can remove faces along the boundary between materials.
Original object with red points showing the boundaries between materials

Optimized object with Keep Material Boundaries active (red points show the boundaries)
Keep Textures When on, ProOptimizer preserves texture mapping coordinates. When off, ProOptimizer removes texture coordinates. Default=off. This option is disabled if the object doesn’t have texture coordinates.

NOTE If Keep Textures is off when you optimize a mapped object, 3ds Max will display a Missing Map Coordinates dialog when you attempt to render that object.

Keep UV Boundaries This control is available only when Keep Textures is turned on. When on, ProOptimizer preserves boundaries between UV mapping channels. When off, ProOptimizer disregards UV mapping boundaries. Default=off.

- Tolerance This is available only when Keep UV Boundaries is turned on. The Tolerance value controls how UV boundaries are treated. A value of 0.0 (the default), preserves all faces that have UV mapping channels that differ from neighboring faces. A value of 1.0 allows any face to be removed, even if its neighbor has a different UV channel.

TIP Setting Tolerance to 0.1 preserves most mapping boundaries, but also allows a reasonable amount of optimization.
**Vertex Colors Group**

Create or import an object. > Modify panel > Modifier List > ProOptimizer modifier > Optimization Options rollout > Vertex Colors group

Controls how ProOptimizer treats objects that have vertex colors assigned to them.

**Interface**

![Vertex Colors Group Interface](image)

**Keep Vertex Colors** When on, ProOptimizer preserves vertex color data. When off, ProOptimizer discards vertex colors. Default=Off

This control is unavailable if the object has no vertex color data.

**Keep VC Boundaries** This control is available only when Keep Vertex Colors is turned on. When on, ProOptimizer preserves boundaries between vertex colors. When off, ProOptimizer disregards vertex color boundaries. Default=off.

- **Tolerance** This is available only when Keep VC Boundaries is turned on.
The Tolerance value controls how vertex color boundaries are treated. A value of 0 (the default), preserves all vertices that have a color that differs from a neighboring vertex. A value of 255 allows any vertex to be removed, even if its neighbor has a different vertex color.

**TIP** A tolerance of 20 preserves most color boundaries, but also allows a reasonable amount of optimization.
Keep Vertex Colors turned off

ProOptimizer shows the object’s two materials, but vertex color is lost.
Keep Vertex Color turned on

Tolerance = 0

Frozen points are shown in red. Almost all faces are frozen and not optimized, because each point has a color that differs from its neighbor.

Keep Vertex Color turned on

Tolerance = 35
Frozen points are shown in red. Only the center, which has important color variations, is frozen.

Keep Vertex Color turned on

Tolerance = 90

Frozen points are shown in red. Only the frontier between the two materials is frozen.

**Normals Group**

Create or import an object. > Modify panel > Modifier List > Edit Normals modifier > Modifier List > ProOptimizer modifier > Optimization Options rollout > Normals group

The Normals group lets you manage the face normals on page 8654 of the geometry you are optimizing.

In general, turning on Keep Normals can improve the appearance of the optimized model, but also can reduce the number of faces that are removed during optimization.
Interface

Keep Normals When on, applies the normal controls to geometry. When off, normals are not taken into account during optimization, and all explicit normals are removed after optimization. Default=off.

This toggle is unavailable unless you have applied an Edit Normals modifier on page 1322 to the geometry. The ProOptimizer Keep Normals toggle is also available if you collapse the stack after applying Edit Normals.

- Crunch Normals When chosen, normals are ignored while optimizing, but explicit normals are kept after optimization.

- Protect Normals (The default) When chosen, ProOptimizer protects normals using the value of Threshold Angle: when the angle between the normals of two faces is greater than the Threshold Angle, the faces are preserved as long as possible. Explicit normals are kept after optimization.

- Exclude Normals Normals are excluded from the optimization using the value of Threshold Angle: when the angle between the normals of two faces is greater than the threshold angle, the faces are always preserved. Explicit normals are kept after optimization.

Threshold Angle Sets an angle value used in optimizing normals. Default=10.0.

When Crunch Normals is chosen, this value is ignored.

When Protect Normals is chosen, two faces are protected from optimization if the angle between their normals exceeds this value.

When Exclude Normals is chosen, two faces are excluded from the optimization if the angle between their normals exceeds this value.
Merge Tools Group

Create or import an object. > Modify panel > Modifier List > ProOptimizer modifier > Optimization Options rollout > Merge Tools group

Each of the Merge tools adds a preprocessing step to the optimization process. These can help correct specific problems in a model.

- **“Dirty” objects** If a model has faces that are disconnected, but should not be, the Merge Vertices tool can correct the discontinuities and improve the optimization.

- **Coplanar faces** If the model has surfaces that are subdivided into many coplanar (or nearly coplanar) faces, the Merge Faces tool can simplify these planes, leading to better optimization.

### Interface

![Merge Tools Interface](image)

**Merge Vertices** When on, merges vertices before performing the optimization. Default=off.

**Threshold** Sets the distance within which vertices are merged. This distance is based on a percentage of the size of the object’s bounding box. At the Threshold value of 0.0, the distance is about 0.0001 percent of the bounding-box size. At the Threshold value of 100.0, the distance is about 5 percent of the bounding-box size. Range=0.0 to 100.0. Default=0.0.

**Merge Faces** When on, merges coplanar (or nearly coplanar) faces before performing the optimization. Default=off.

**WARNING** If the planar surface has holes in it, Merge Faces might not give correct results. Also, if the planar surface has repeated (tiled) UV mapping, the tiling information will be lost.

**Threshold Angle** Sets the angle between face normals within which faces are merged. Range=0.0 to 10.0. Default=0.0.
Original model
Vertices: 557
Merge Faces turned off
Vertex % = 25.0
Vertices: 139
Faces: 214
Merge Faces turned on

Vertex % = 25.0

Vertices: 23

Faces: 21

When a model has coplanar faces, Merge Faces can greatly improve optimization.

Sub-Object Selection Group

Create or import an object. > Modify panel > Modifier List > ProOptimizer modifier > Optimization Options rollout > Sub-Object Selection group
These options control how ProOptimizer treats vertex sub-object selections. You can’t create a sub-object selection in ProOptimizer, but it can acquire a vertex selection from an object or modifier below it on the stack.

**Interface**

![Sub-Object Selection](image)

**Preserve Vertices** When on, ProOptimizer does not optimize vertex selections passed up from the stack. When off, ProOptimizer disregards vertex sub-object selections. Default=off.

**Invert** When on, ProOptimizer optimizes the vertex selection and disregards the rest of the object. Default=off. This control is unavailable unless Preserve Vertices is turned on.

**Symmetry Options Rollout**

Create or import an object. > Modify panel > Modifier List > ProOptimizer modifier > Symmetry Options rollout

The Symmetry options preserve an object’s symmetry around a plane that you specify.

When one of the Symmetry options is active, ProOptimizer looks for symmetrical pairs of edges. When it finds a symmetrical pair, it applies the same optimization on either side of the plane.

These options work best if the object is truly symmetrical; for example, if it was originally created by mirroring. If ProOptimizer cannot detect symmetry about the plane you specify, it optimizes the object as it normally does.

Points that lie on the plane itself are frozen (not optimized), because they are symmetrical by definition.

Some 3ds Max objects appear to be symmetrical but are not; for example, a surface of revolution created by the Lathe modifier. In this case, although the overall geometry is symmetrical, edges all have the same orientation in the direction of revolution, so when bisected by a plane, opposite edges face in
opposite directions. In this case, ProOptimizer cannot detect symmetry, and optimizes according to the usual method.

**IMPORTANT** The controls on this rollout are not interactive. If you change a setting, the Status window on the Optimization Level rollout displays “Optimization Invalid,” and you must click Calculate once again to see the result of changing the option value.

**Interface**

![Symmetry Options](image)

No Symmetry (The default.) ProOptimizer does not attempt to make symmetrical optimizations.

XY Symmetry ProOptimizer attempts to make optimizations symmetrical about the XY plane.

YZ Symmetry ProOptimizer attempts to make optimizations symmetrical about the YZ plane.

XZ Symmetry ProOptimizer attempts to make optimizations symmetrical about the XZ plane.

Tolerance Specifies a tolerance value for detecting symmetrical edges. In some models, the position of symmetrical edges might not be precise; for example, roundoff error might have caused small discrepancies in position values. Increasing the Tolerance value can correct this problem. Default=0.0.

**Advanced Options Rollout**

Create or import an object. > Modify panel > Modifier List > ProOptimizer modifier > Advanced Options rollout
This rollout provides two options: Favor Compact Faces, and Prevent Flipped Normals.

The options in this rollout are on by default, because in most cases they give the best optimization results.

**IMPORTANT** The controls on this rollout are *not interactive*. If you change a setting, the Status window on the Optimization Level rollout displays “Optimization Invalid,” and you must click Calculate once again to see the result of changing the option value.

**Interface**

<table>
<thead>
<tr>
<th>Advanced Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>□ Favor Compact Faces</td>
</tr>
<tr>
<td>□ Prevent Flipped Normals</td>
</tr>
</tbody>
</table>

**Favor Compact Faces** A face is “compact” when the triangle it forms is equilateral, or nearly so. When Favor Compact Faces is on, ProOptimizer verifies that removing a face does not create sharpened faces. The optimized model is more uniform than it would be without this test. Default=on.

**Prevent Flipped Normals** When on, ProOptimizer verifies that moving a vertex does not cause a face normal to flip. When off, ProOptimizer does not perform this test; the resulting mesh might appear to have holes when viewed with 1-sided viewport shading or rendered with a 1-sided material. Default=on.

**Push Modifier**

Modify panel > Make a selection. > Modifier List > Object-Space Modifiers > Push

Make a selection. > Modifiers menu > Parametric Deformers > Push

The Push modifier lets you "push" object vertices outward or inward along the average vertex normals. This produces an "inflation" effect that you can't otherwise obtain.
Positive and negative amounts of push applied to an object.

**Interface**

<table>
<thead>
<tr>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Push Value: 0.0</td>
</tr>
</tbody>
</table>

**Push Value** Sets the distance in world units by which vertices are moved with respect to the object center. Use a positive value to move vertices outward, or a negative value to move vertices inward.

**Quadify Mesh Modifier**

Modify panel > Make a selection. > Modifier List > Object-Space Modifiers > Quadify Mesh

Make a selection. > Modifiers menu > Mesh Editing > Quadify Mesh
The Quadify Mesh modifier converts the object structure to quadrilateral polygons whose relative size you specify. This capability helps to produce rounded edges when combined with MeshSmooth on page 1505.

Left: Original object; Right: After applying Quadify Mesh and MeshSmooth modifiers

See also:

- Quad Meshing and Smoothing on page 831

Interface

Quad Size % The approximate size of each quadrilateral relative to the size of the object. The smaller this value, the more quads will result.
Relax Modifier

Modify panel > Make a selection. > Modifier List > Object-Space Modifiers > Relax

Make a selection. > Modifiers menu > Parametric Deformers > Relax

The Relax modifier changes the apparent surface tension in a mesh by moving vertices closer to, or away from, their neighbors. The typical result is that the object gets smoother and a little smaller as the vertices move toward an averaged center point. You can see the most pronounced effects on objects with sharp corners and edges.
Relax moves the bowl away from its original contours.

When you apply Relax, each vertex is moved toward the average position of its neighboring vertices. A neighboring vertex is one that shares a visible edge with the current vertex.
Patches

As of version 4, a patch object coming up the modifier stack is not converted to a mesh by this modifier. A patch object input to the Relax modifier retains its patch definition. If a file created by a previous version of 3ds Max contains a patch object applied with the Relax modifier, it will be converted to a mesh to maintain backward compatibility.

Interface

Relax Value Controls how far a vertex moves for each iteration. The value specifies a percentage of the distance from the original location of a vertex to the average location of its neighbors. Range=-1.0 to 1.0. Default=0.5.

- Positive Relax values move each vertex in closer to its neighbors. The object becomes smoother and smaller.
- When the Relax value=0.0, vertices do not move and Relax has no affect on the object.
- Negative Relax values move each vertex away from its neighbors. The object becomes more irregular and larger.

Relax Values=1.0, 0.0, -1.0

Iterations=1 (default)
**Iterations** Sets how many times to repeat the Relax process. For each iteration, average locations are recalculated and the Relax Value is reapplied to every vertex. Default=1.

- For 0 iterations, no relaxation is applied.
- Increasing iterations for positive Relax Value settings smooths and shrinks an object. With very large iteration values, the object shrinks to a point.
- Increasing iterations for negative Relax Value settings exaggerates and expands an object. With relatively few iterations, the object becomes jumbled and almost unusable.

Iterations=0, 10, 50

Relax Value=0.5 (default)

Keep Boundary Pts Fixed Controls whether vertices at the edges of open meshes are moved. Default=on.

When Keep Boundary Pts Fixed is on, boundary vertices do not move while the rest of the object is relaxed. This option is particularly useful when working with multiple objects, or multiple elements within a single object, that share open edges.

When this check box is off, all vertices of the object are relaxed.
Keep Boundary Pts Fixed=on
Iterations=0, 10, 50

Keep Boundary Pts Fixed=off
Iterations=0, 10, 50

Save Outer Corners Preserves the original positions of vertices farthest away from the object center.

Renderable Spline Modifier

Select a shape. > Modify panel > Modifier List > Renderable Spline

The Renderable Spline modifier lets you set the renderable properties of a spline object, without collapsing the spline to an editable spline. This is particularly useful with splines you have linked to from AutoCAD. It also lets you apply the same rendering properties to multiple splines at once.

NOTE This modifier cannot be applied to NURBS curves.
Interface

Enable In Renderer
When on, the shape is rendered as a 3D mesh using the Radial or Rectangular parameters set for Renderer.

Enable In Viewport
When on, the shape is displayed in the viewport as a 3D mesh using the Radial or Rectangular parameters set for Renderer.

Use Viewport Settings
Lets you set different parameters for viewport display and rendering, and displays the mesh generated by the Viewport settings in the viewports. Available only when Enable in Viewport is turned on.

Generate Mapping Coords
Turn this on to apply mapping coordinates. Default=off.
3ds Max generates the mapping coordinates in the U and V dimensions. The U coordinate wraps once around the spline; the V coordinate is mapped once along its length. Tiling is achieved using the Tiling parameters in the applied material. For more information, see Mapping Coordinates on page 5636.
**Real-World Map Size** Controls the scaling method used for texture mapped materials that are applied to the object. The scaling values are controlled by the Use Real-World Scale settings found in the applied material's Coordinates rollout on page 6201. Default=on.

**Viewport** Choose this to specify Radial or Rectangular parameters for the shape as it will display in the viewport when Enable In Viewport is on. Available only when Use Viewport Settings is on

**Renderer** Choose this to specify Radial or Rectangular parameters for the shape as it will display when rendered or displayed in the viewport when Enable in Viewport is turned on.

**Radial** Displays the spline as a 3D object with a circular cross-section.

- **Thickness** Specifies the cross-section diameter. Default=1.0. Range=0.0 to 100,000,000.0.

- **Sides** Sets the number of sides for the spline mesh in the viewports or renderer. For example, a value of 4 produces a square cross-section.

- **Angle** Adjust the rotational position of the cross section in the viewports or renderer. For example, if you have a square cross section you can use Angle to position a “flat” side down.

**Rectangular** Displays the spline as a 3D object with a rectangular cross-section.

- **Length** Specifies the size of the cross-section along the local Y axis.

- **Width** Specifies the size of the cross-section along the local X axis.

- **Angle** Adjusts the rotational position of the cross-section in the viewport or renderer. For example, if you have a square cross-section you can use Angle to position a "flat" side down.

- **Aspect** Sets the aspect ratio for rectangular cross-sections. The Lock check box lets you lock the aspect ratio. When Lock is turned on, Width is locked to Depth that results in a constant ratio of Width to Depth.

**Auto Smooth** When on, the spline is auto-smoothed using the smoothing angle specified by the Threshold setting. Auto Smooth sets the smoothing based on the angle between spline segments. Any two adjacent segments are put in the same smoothing group if the angle between them is less than the threshold angle.
**NOTE** Turning Auto Smooth on for every situation does not always give you the best smoothing quality. Altering the Threshold angle may be necessary or turning Auto Smooth off may produce the best results.

**Threshold** Specifies the threshold angle in degrees. Any two adjacent spline segments are placed in the same smoothing group if the angle between them is less than the threshold angle.

## Ripple Modifier

Modify panel > Make a selection. > Modifier List > Object-Space Modifiers > Ripple

Make a selection. > Modifiers menu > Parametric Deformers > Ripple

The Ripple modifier lets you produce a concentric rippling effect in an object's geometry. You can set either of two ripples or a combination of both. Ripple uses a standard gizmo and center, which you can transform to increase the possible ripple effects.

The **Ripple** on page 2983 space warp has similar features. It is useful for applying effects to a large number of objects.
An object with the Ripple modifier applied.
Top (from left to right): Amplitude 1 only, Amplitude 2 only and both amplitudes.
Bottom: Both amplitudes with the Decay effect.

See also:
■ Wave Modifier on page 2000

Procedures

Example: To use the Ripple modifier:

1 Start with an empty scene, and add a Plane object on page 419 in the Perspective viewport. Set Length and Width both to 100.0, and set Length Segs and Width Segs both to 10.
   The Plane object is useful as the basis for the surface of a body of water in which ripples form.

2 Go to the Modify panel, click Modifier List, and, from the Object-Space Modifiers list, choose Ripple.
This applies the modifier to the Plane object.

3 On the Parameters rollout, set Amplitude 1 to 10.0. A large ripple forms in the Plane object.
   You can change the horizontal scale by adjusting the wave length.

4 Set Wave Length to 20.0. The waves become smaller, but now it's apparent that the Plane object needs greater geometric resolution to properly display the number of waves.

5 In the modifier stack, click the Plane item, and then set Length Segs and Width Segs both to 30.
   The smaller waves become more apparent. The Ripple modifier needs a relatively high number of subdivisions in the geometry it's applied to in order to work properly.
   You can use the Amplitude 2 parameter to add complexity to the wave forms created by Ripple.

6 Return to the Ripple level of the modifier stack, and then click and hold on the Amplitude 2 and drag downward.
   As you drag, a new set of wave forms are combined with the existing ones. The farther you drag, the more dominant the second set becomes.
   Using a negative value for Amplitude 2 (or a positive one if Amplitude 1 is negative) produces more of an interference effect between the two sets of waves.
   You can animate the waves with the Phase control.

7 Drag slowly upward or downward on the Phase spinner.
   Increasing the Phase value moves the waves inward, and decreasing it moves the outward. To animate the waves, create keyframes on page 8090 for the Phase value.
   To simulate an object dropping in liquid, use the Decay setting.

8 Drag slowly upward on the Decay spinner.
   The farther you drag, the more the wave sizes decrease with the distance from the center of the effect. This is the effect you get when an object perturbs the water surface, and the waves lose energy as they move away from the point of impact.
Interface

Modifier Stack

Gizmo At this sub-object level, you can transform and animate the gizmo like any other object, altering the effect of the Ripple modifier. Translating the gizmo translates its center an equal distance. Rotating and scaling the gizmo takes place with respect to its center.

Center At this sub-object level, you can translate and animate the center of the ripple effect, and thus the shape and positions of the ripples.

For more information on the stack display, see Modifier Stack on page 8187.

Parameters rollout

Amplitude 1/ Amplitude 2 Amplitude 1 produces a ripple across the object in one direction, while Amplitude 2 creates a similar ripple at right angles to the first (that is, rotated 90 degrees about the vertical axis).

Wave Length Specifies the distance between the peaks of the wave. The greater the length, the smoother and more shallow the ripple for a given amplitude. Default=50.0.
**Phase** Shifts the ripple pattern over the object. Positive numbers move the pattern inward, while negative numbers move it outward. This effect becomes especially clear when animated.

**Decay** Limits the effect of the wave generated from its center. The default value of 0.0 means that the wave will generate infinitely from its center. Increasing the Decay value causes the wave amplitudes to decrease with distance from the center, thus limiting the distance over which the waves are generated.

---

**Select By Channel Modifier**

Select an object. > Modify panel > Modifier List > Select By Channel

The Select By Channel modifier works in conjunction with the Channel Info utility on page 6486. After you store a vertex selection into a subcomponent with Channel Info, use Select By Channel to quickly access the selection.

**Procedures**

To use Select By Channel:

1. Use Channel Info to store one or more vertex selections in a map channel subcomponent.
2. Apply the Select By Channel modifier to the object with the stored vertex selection(s).
3. Choose the selection type.
4. Choose the selection channel.
5. To “bake” the new selection into the object, collapse the stack.
Interface

Selection Type Lets you choose how to combine the stored vertex selection with an existing vertex selection.
- **Replace** Replaces the existing selection with the stored selection.
- **Add** Adds the stored selection to the existing selection.
- **Subtract** Subtracts the stored selection from the existing selection. Has no effect if there's no overlap between the stored selection and the existing selection.

Selection Channel Lets you choose which stored, named vertex-selection channel to apply to the modified object. Click the arrow to the right of the name field to open the drop-down list, and then click a channel in the list.

Shell Modifier

Modify panel > Make a selection. > Modifier List > Object-Space Modifiers > Shell

Make a selection. > Modifiers menu > Parametric Deformers > Shell

The Shell modifier “solidifies” or gives thickness to an object by adding an extra set of faces facing the opposite direction of existing faces, plus edges connecting the inner and outer surfaces wherever faces are missing in the original object. You can specify offset distances for the inner and outer surfaces, characteristics for edges, material IDs, and mapping types for the edges.

Also, because the Shell modifier doesn’t have sub-objects, you can use the Select options on page 1663 to specify a face selection for passing up the stack to other modifiers. Please note that the Shell modifier doesn’t recognize existing sub-object selections, nor does it pass such selections up the stack.
You'd typically use Shell on an object with part of its surface removed, such as a sphere with several deleted vertices or faces, as illustrated above. For best results, the original polygons should face outward. If an object has no faces with at least one free edge, Shell will not create any edges.

Watch a movie about Shell Modifier.

Examples of Shell Usage

Following are some examples of modeling tasks for which the Shell modifier would be appropriate:

- An artist is modeling a vehicle such as a car, a tank, or, in this case, a helicopter. The artist builds a solid external shell as the body of the copter. When done, the modeler breaks up his model: he selects window areas and detaches them as new objects, followed by the area for the doors (also detached as new objects). The modeler now has open objects representing the body, windows, and doors. The modeler applies Shell to the body, and sets it to extrude both outward and inward, with the inward extrusion amount greater than the outward. Next, Shell is applied to the windows, with inward extrusion only. The modeler then copies the Shell modifier from the body to the doors, and reduces the doors' outward extrusion amount. The result is a solid body with an interior that can accept
additional modeling, inset windows, and doors that are slightly less thick than the shell of the helicopter.

A designer is modeling a manufactured object that will need to be shown in an exploded view. It might be a cell phone, an engine, a mouse, shaped glass, or something similar; this example will use part of a cell phone. When working on the phone keypad area, if the modeler builds with detail in mind, she might accurately model the shell with a moderately dense mesh, using ShapeMerge on page 709 to create the shapes for the holes where the keys will poke through, and then deleting those faces. When satisfied, the modeler applies the Shell modifier, sets Segments to 2, and then turns on the Bevel Edges option to use a curve for the profile of the holes' edges. She then applies a MeshSmooth modifier on top. The extra segment helps control the curve of the edges where the outer surface curves down to the keypad holes. The modeler then goes back to the cage portion of the stack and refines the base mesh details to her liking.

A modeler is creating a suit of futuristic armor for a character. The modeler copies a selection of polygons from the character mesh to a new object; for example, the polygons that make up the arm. The modeler deletes some faces from the copied arm, and perhaps cuts some holes from it. He then applies the Shell modifier, followed by a MeshSmooth modifier, resulting in form-fitting armor.

Procedures

To solidify an object:

1. Create an object to solidify. The object should have some holes in its surface. For example, start with a primitive sphere, convert it to Editable Poly, and delete some vertices or polygons.

2. Optionally create an open spline to serve as the profile for the edges connecting the inner and outer surfaces. For example, go to Create panel > Shapes and click Line. Then, in the Top viewport, draw the spline from top to bottom. Where the spline protrudes to the right, the edge surface will be convex, and where it protrudes to the left, the surface will be concave.

3. Apply the Shell modifier to the object from step 1.

4. To use custom edges, turn on Bevel Edges, click the Bevel Spline button, and then select the spline from step 2.
5 By default, Shell keeps the material IDs of the new surfaces consistent with those of the original object. To change these, turn on the different Override options, specify appropriate material IDs, and apply a Multi/Sub-Object material on page 6120.

6 Likewise, Shell keeps the texture coordinates of the new surfaces consistent with those of the original object. To change these on the new edges, change the Edge Mapping choice, and with the Strip and Interpolate choices, optionally change the TV Offset setting.
**Inner/Outer Amount** Distance in 3ds Max generic units by which the inner surface is moved inward and the outer surface is moved outward from their original positions. Defaults=0.0 / 1.0.

The sum of the two Amount settings determines the thickness of the object's shell, as well as the default width of the edges. If you set both to 0, the resultant shell has no thickness, and resembles an object set to display as 2-sided.

**Segments** The number of subdivisions across each edge. Default=1.
Change this setting if you need greater resolution on the edge for use by subsequent modeling or modifiers.

**NOTE** When you use a Bevel Spline, the spline's properties override this setting.

**Bevel Edges** When on, and you specify a Bevel Spline, 3ds Max uses the spline to define the edges' profile and resolution. Default=off.
After you define a Bevel Spline, use Bevel Edges to switch between a flat edge whose resolution is defined by the Segments setting and a custom profile defined by the Bevel Spline.

**Bevel Spline** Click this button and then select an open spline to define the edge shape and resolution. Closed shapes such as Circle or Star will not work.
The original spline is instanced to the Bevel Spline, so changing the spline's shape and properties are reflected in the Bevel Spline. With non-corner vertices, you can change the edge resolution with the spline's Interpolation rollout settings.
A bevel spline as viewed from the top (inset) and the resulting bevel

**TIP** For best results, create the spline in the Top viewport, and draw it from top to bottom. The top point on the spline is applied to the outside edge, and the bottom point to the inside edge. Displacements to the right will create outward protrusions on the edge profile, and displacements to the left create inward protrusions.

**Override Inner Mat ID** Turn on to specify a material ID for all of the inner surface polygons using the Inner Mat ID parameter. Default=off.
If you don't specify a material ID, the surface uses the same material ID or IDs as the original faces.

**Inner Mat ID** Specifies the material ID for inner faces. Available only when Override Inner Mat ID is on.

**Override Outer Mat ID** Turn on to specify a material ID for all of the outer surface polygons using the Outer Mat ID parameter. Default=off.
If you don't specify a material ID, the surface uses the same material ID or IDs as the original faces.

**Outer Mat ID** Specifies the material ID for outer faces. Available only when Override Outer Mat ID is on.
Override Edge Mat ID  Turn on to specify a material ID for all of the new edge polygons using the Edge Mat ID parameter. Default=off.
If you don’t specify a material ID, the surface uses the same material ID or IDs as the original faces from which the edges are derived.

Edge Mat ID Specifies the material ID for edge faces. Available only when Override Edge Mat ID is on.

Auto Smooth Edge Applies automatic, angle-based smoothing across the edge faces using the Angle parameter. When off, no smoothing is applied. Default=on.
This doesn’t apply smoothing across the junction between the edge faces and the outer/inner surface faces.

Angle Specifies the maximum angle between edge faces that will be smoothed by Auto Smooth Edge. Available only when Auto Smooth Edge is on. Default=45.0.
Faces that meet at an angle greater than this value will not be smoothed.

Override Smooth Group Lets you specify a smoothing group on page 8724 for the new edge polygons using the Smooth Grp setting. Available only when Auto Smooth Edge is off. Default=off.

Smooth Grp Sets the smoothing group for the edge polygons. Available only when Override Smooth Group is on. Default=0.
When Smooth Grp is set to the default value of 0, no smoothing group is assigned to the edge polygons. To specify a smoothing group, change the value to a number between 1 and 32.

NOTE When Auto Smooth Edge and Override Smooth Group are both off, 3ds Max assigns smoothing group 31 to the edge polygons.

Edge Mapping Specifies the type of texture mapping that is applied to the new edges. Choose a mapping type from the drop-down list:

- **Copy** Each edge face uses the same UVW coordinates as the original face from which it's derived.
- **None** Each edge face is assigned a U value of 0 and a V value of 1. Thus, if a map is assigned, the edges will take the color of the upper-left pixel.
- **Strip** The edges are mapped in a continuous strip.
- **Interpolate** The edge mapping is interpolated from the mapping of the adjacent inner and outer surface polygons.
**TV Offset** Determines the spacing of the texture vertices across the edges. Available only with the Edge Mapping choices Strip and Interpolate. Default=0.05.

Increasing this value increases the repetition of the texture map across the edge polygons.

**Select Edges** Selects the edge faces. This selection is passed up the stack to other modifiers. Default=off.

**Select Inner Faces** Selects the inner faces. This selection is passed up the stack to other modifiers. Default=off.

**Select Outer Faces** Selects the outer faces. This selection is passed up the stack to other modifiers. Default=off.

**Straighten Corners** Adjusts corner vertices to maintain straight-line edges.

If you apply Shell to a subdivided object with straight edges, such as a box set to 3x3x3 segments, you might find that the corner vertices don't stay in a straight line with the other edge vertices. This gives the edges a bulging look. To resolve this, turn on Straighten Corners.
Skew Modifier

Modify panel > Make a selection. > Modifier List > Object-Space Modifiers > Skew

Make a selection. > Modifiers menu > Parametric Deformers > Skew

The Skew modifier lets you produce a uniform offset in an object's geometry. You can control the amount and direction of the skew on any of three axes. You can also limit the skew to a section of the geometry.
Procedures

To skew an object:

1. Select an object, go to the Modify panel, and choose Skew from modifier list.

2. On the Parameters rollout, set the axis of the skew to X, Y, or Z. This is the axis of the Skew gizmo, not the axis of the selected object. You can change the axis at any time, but only one axis setting is carried with the modifier.

3. Set the amount of the skew. The amount is an offset in current units parallel with the axis. The object skews to this amount beginning at the lower limit, by default the location of the modifier's center.

4. Set the direction of the skew. The object swivels around the axis. You can reverse the amount and direction by changing a positive value to a negative value.

To limit the skew:

1. Turn on Limits group > Limit Effect.

2. Set values for the upper and lower limits. These are distances in current units above and below the modifier's center, which is at zero on the gizmo's Z axis. The upper limit can be zero or positive, the lower limit zero or negative. If the limits are equal, the result is the same as turning off Limit Effect. The skew offset is applied between these limits. The surrounding geometry, while unaffected by the skew itself, is moved to keep the object intact.

3. At the sub-object level, you can select and move the modifier's center. The limit settings remain on either side of the center as you move it. This lets you relocate the skew area to another part of the object.
Interface

Modifier Stack

Gizmo At this sub-object level, you can transform and animate the gizmo like any other object, altering the effect of the Skew modifier. Translating the gizmo translates its center an equal distance. Rotating and scaling the gizmo take place with respect to its center.

Center At this sub-object level, you can translate and animate the center of the Skew effect.

For more information on the stack display, see Modifier Stack on page 8187.

Parameters rollout

Skew group

Amount Sets the angle to skew from the vertical plane.
**Direction** Sets the direction of the skew relative to the horizontal plane.

**Skew Axis group**

X/Y/Z Specify the axis that will be skewed. Note that this axis is local to the Skew gizmo and not related to the selected entity. Default=Z.

**Limits group**

**Limit Effect** Applies limit constraints to the Skew modifier.

**Upper Limit** Sets the upper limit boundaries in world units from the skew center point, beyond which the skew no longer affects the geometry. Default=0.

**Lower Limit** Sets the lower limit boundaries in world units from the skew center point, beyond which the skew no longer affects the geometry. Default=0.

---

**Skin Modifier**

Select a mesh, patch, or NURBS object. > Modify panel > Modifier List > Object-Space Modifiers > Skin

Select a mesh, patch, or NURBS object. > Modifiers menu > Animation Modifiers > Skin

The Skin modifier is a skeletal deformation tool that lets you deform one object with another object. Mesh, patch, or NURBS objects can be deformed by bones, splines, and other objects.

Applying the Skin modifier and then assigning bones gives each bone a capsule-shaped "envelope." Vertices of the modified object within these envelopes move with the bones. Where envelopes overlap, vertex motion is a blend between the envelopes.

By default, each vertex that's affected by a single bone is given a weight value of 1.0, which means it's affected by that bone only. Vertices within the intersection of two bones' envelopes have two weight values: one for each bone. And you can use Skin modifier toolsets such as the Weight Tool dialog on page 1697 to arbitrarily assign vertices to any number of bones. The ratio of a vertex's weight values, which always total 1.0, determine the relative extent to which each bone's motion affects the vertex. For example, if a vertex's weight with respect to bone 1 is 0.8 and its weight with respect to bone 2 is 0.2, then the motion of bone 1 will have four times greater influence on the vertex than will the motion of bone 2.
The initial envelope shape and position depends on the type of bone object. Bones create a linear envelope that extends along the longest axis of the bone geometry. Spline objects create envelopes that follow the curve of the spline. Primitive objects create an envelope that follows the longest axis of the object.

You can also deform the mesh based on the angle of the bones. Three deformers let you shape the mesh based on bone angles:

- The Joint and Bulge Angle deformer use a lattice similar to an FFD lattice on page 1431 to shape the mesh at a specific angle.

- The Morph Angle Deformer morphs the mesh at specified angles. Morph targets are created by using modifiers above the Skin modifier in the stack, or by using the Snapshot tool on page 950 to create a copy of the mesh and deforming the mesh using standard tools.

You can apply the Skin modifier to several objects at the same time.

In 3ds Max you can mirror envelope and vertex assignments from one side of the mesh to the other with commands on the Mirror Parameters rollout.
Procedures

To use the Skin modifier:

1. Prepare the skin (mesh or patch object) and skeleton (bones or other objects). Carefully place the skeleton inside the mesh or patch object so that its elements are able to influence polygons or patches in their immediate vicinity.

2. Select the mesh or patch object and apply the Skin modifier.

3. In the Parameters rollout, click Add and choose the skeleton objects.

4. Click Edit Envelopes and select an envelope to modify the volume in which each bone can influence the surrounding geometry.

To weight vertices manually:

1. On the Parameters rollout, turn on Vertices.

2. On the mesh, select the vertices you would like to weight manually. Each selected vertex is surrounded by a small white rectangle.

3. Highlight the name of the bone for which you want to change the vertex weights.

4. In the Weight Properties group, change the Abs. Effect parameter to the new vertex weight.

To mirror envelope or vertex weight settings:

1. Adjust envelopes and vertex weights on one side of the mesh.

2. On the Mirror Parameters rollout, click Mirror Mode.

3. If the mirror plane is not at the center of the mesh, change the Mirror Offset parameter to move the plane to the center.

4. If some vertices in the left or right side of the mesh are red rather than blue or green, increase the Mirror Thresh value until all vertices are blue or green.

5. On the Mirror Parameters rollout, click the appropriate Paste button to paste green or blue envelopes or vertex weights to the other side of the mesh.
To adjust the skin and/or bones without affecting the envelopes:

1. Save the scene.
   This is a potentially destructive operation, so it's best not to take any chances with your data.

2. Select the object to which the Skin modifier is applied.

3. In the Advanced Parameters rollout, turn off Always Deform.

4. Apply any necessary transforms to the mesh/patch object or bones objects.

5. Turn Always Deform back on.
   To adjust the bones only, you can also use skin pose on page 280.

Example: To apply the Skin modifier to a cylinder with a bones skeleton:

1. On the Create panel, under Standard Primitives, click Cylinder.

2. In the middle of the Top viewport, click and drag 20 units to create the base of the cylinder.

3. Release the mouse button and drag up 130 units to establish the height of the cylinder.

4. On the parameters rollout, set Height Segments to 20.
   This provides mesh detail for a smooth surface deformation.

5. On the Create panel, under Systems, click Bones.
   Make sure an IK Solver is chosen in the IK Solver list. Turn on Assign To Children. (This should turn on Assign To Root as well.)

6. In the Front viewport, click successively three times: below the cylinder, in the middle of the cylinder, and above the top of the cylinder.

7. Right-click to end Bones creation.
   Three bones display. Two of them are within the middle of the cylinder.

8. Select the cylinder.
9  On the Modify panel, choose Skin from the Modifier List.

10 On the Skin modifier’s Parameters rollout, click Add, and use the Select Bones dialog to select the three bones.
   The names of the bones are now displayed in the list.

11 In the Front viewport, select the bone end effector (IK Chain01) and move it around.
   The cylinder deforms to follow the bones. To adjust envelopes to refine the surface deformation, choose the Skin modifier’s Envelope sub-object level, and use the Edit Envelopes controls to resize envelopes and change vertex weights.

**Example: To use a morph angle deformer:**

Create the cylinder and bones from the preceding procedure before you continue with this procedure.

1  At frame 50, animate bone 2 so that bones 1 and 2 represent a 90-degree angle.

2  At frame 0, the bones should be straight at about a 180-degree angle.

3  Move to frame 0.

4  Turn on Edit Envelopes in the Parameters rollout.

5  Select the child bone (bone 2) in the modifier’s list of bones.

6  In the Select group, turn on Vertices.
   This allows you to select vertices.

7  In the viewports, region-window select a good portion of the vertices that are controlled by both bones.

8  In the Gizmos rollout, select the Morph Angle Deformer in the drop-down list, and then click Add Gizmo.
   The Deformer Parameters rollout displays. A base morph target is the first and only target in the list.

   **TIP** if the Deformer doesn’t assign, make sure that bone 2 and not bone 1 is selected in the list.

9  Scrub the Time Slider to frame 50.
10 Add an Edit Mesh modifier above the Skin modifier in the modifier stack.

11 Turn on Vertex and Soft Selection in the Edit Mesh modifier.

12 Edit the mesh to the shape you want.

13 Go back down in the stack to the Skin modifier. If the topology warning dialog appears, click Yes.

14 In the Deformer Parameters rollout, click Add From Stack. A new morph target is added at about 90 degrees.

15 Delete the Edit Mesh modifier from the stack. There is a doubling effect of the morph if you don’t delete or deactivate the Edit Mesh modifier.

16 Scrub the time slider. The mesh morphs as the bone angle changes.

Interface

The Skin Modifier interface includes the following rollouts:

- Parameters rollout on page 1673
- Mirror Parameters rollout on page 1680
- Display rollout on page 1682
- Advanced Parameters rollout on page 1684
- Gizmos rollout on page 1687
- Deformer Parameters rollout on page 1690
- Joint Angle and Bulge Angle parameters on page 1692

Some of the Skin modifier commands are also available from the quad menu on page 8052.

Modifier Stack

Envelope Turn on this sub-object level to work on envelopes and vertex weights.

TIP You can use the quad menu to choose this sub-object level.
Parameters rollout
**Edit Envelopes** Use this sub-object level to work on envelopes and vertex weights.

**Select group**

The following filtering options are grouped together to help you work on a particular task, by preventing you from accidentally selecting the wrong item in the viewports.

**Vertices** Turn on for vertex selection.

You can rotate around selected vertices using Orbit SubObject on page 8152 from the Orbit flyout on page 8151. You can also rotate around a selected envelope as long as no vertices are selected, as they have precedence.

**NOTE** You must choose Use Selection Center on page 933 from the User Center flyout on page 930 to center on your selection. If you choose Use Pivot Point Center on page 931, Orbit centers on the selected bone/cross section.

You can zoom on selected vertices using Zoom Extents Selected on page 8144 from the Zoom Extents flyout. You can also zoom on an envelope if no vertices are selected.

- **Shrink** Modifies the current vertex selection by progressively subtracting the outermost vertices from the selected object. Has no effect if all the vertices from an object are selected.

- **Grow** Modifies the current vertex selection by progressively adding neighborhood vertices of the selected object. You must start with at least one vertex to be able to grow your selection.

- **Ring** Expands the current vertex selection to include all vertices part of parallel edges.

**NOTE** You must select at least two vertices to use the Ring selection.

- **Loop** Expands the current vertex selection to include all vertices part of continuing edges.

**NOTE** You must select at least two vertices to use the Ring selection.

- **Select Element** When on, selects all vertices of the element you select, as long as you select at least one vertex from that element.
TIP You can edit your selection by holding Ctrl or Alt, and then select vertices. This adds or removes, respectively, vertices to or from your selection.

- **Backface Cull Vertices** When on, you cannot select vertices pointing away from the current view (on the other side of the geometry).

**Envelopes** Turn on for envelope selection.

**Cross Sections** Turn on for cross-section selection.

The first step, after applying the Skin modifier to an object, is to determine which bones participate in the object’s weighting. Every bone you choose influences the weighted object with its envelope, which you can configure in the Envelope Properties group on page 1676.

**Add** Click to add one or more bones from the Select Bones dialog.

**Remove** Choose a bone in the list, and then click Remove to remove it.

**List window** Lists all bones in the system. Highlighting a bone in the list displays that bone's envelope and the vertices influenced by the envelope. An horizontal scroll bar appears if a bone's name is longer than the window's width.

**NOTE** If an older scene containing long bone names is loaded in 3ds Max, its name is truncated to fit in the window. You can overwrite this by setting the MAXScript `shortenBoneNames` property of your Skin modifier to false.

Example: `$'Sphere01'.modifiers[#Skin].shortenBoneNames = false`

For detailed information about the MAXScript utility, open the MAXScript Help, available from Help menu > MAXScript Help.

**Bone name type-in field** Enter a bone name to highlight it in the bone list above. The highlighting goes to the first matching bone.

Use these methods for finding bone names faster:

- Narrow the list by typing the first few characters in the name of the bone you want to highlight.

- Use the wildcard (*) key. For example, you can find *Robot R Index Finger* by typing * R In
Cross Sections group

By default, each envelope has two round, lateral cross sections, one at each end of the envelope. These options add and remove cross sections from envelopes.

Add Choose a bone in the list, click Add, and click a position on the bone in a viewport to add a cross section.

Remove Select an envelope cross section and click Remove to delete it.

Before you can select a cross section, the Cross Sections option in the Select group must be on.

You can delete only extra cross sections that you have added; not the default cross sections.

Envelope Properties group

Radius Select an envelope cross section, and use Radius to resize it. In order to select a cross section, the Cross Sections option in the Select group must be checked.

You can also click and drag a cross section control point in a viewport to resize it.

Squash A squash multiplier for bones that stretch. This is a single value that reduces or increases the amount of squash applied to a bone when it is stretched with Freeze Length off, and Squash on.

NOTE You can set Freeze Length and Squash in the Bone Tools dialog on page 877.

Absolute/Relative This toggle determines how vertex weights are calculated for vertices between inner and outer envelopes.

Absolute A vertex must merely fall inside the brown outer envelope to have 100% assignment weight to that particular bone. A vertex falling inside more than one outer envelope will be assigned multiple weights summing to 100% based on where it falls in the gradients of each envelope.
Relative  A vertex falling only within an outer envelope will not receive 100% weighting. A vertex must either fall inside two or more outer envelopes whose gradients sum to 100% or greater or the vertex must fall within a red inner envelope to have 100% weight. Any points within a red inner envelope will be 100% locked to that bone. Vertices falling within multiple inner envelopes will receive weighting distributed over those bones.

Envelope Visibility Determines the visibility of unselected envelopes. Choose a bone in the list and click Envelope Visibility, then choose another bone in the list. The first bone selected remains visible. Use this to work on two or three envelopes.

Falloff Flyouts Choose a falloff curve for the displayed envelopes.

Weight falls off in the area between the inner and outer envelope boundaries if envelopes overlap and Absolute is turned on. This setting lets you specify how the falloff is handled:

- **Falloff Fast Out**  Weight falls off quickly.
- **Falloff Slow Out**  Weight falls off slowly.
- **Falloff Linear**  Weight falls off in a linear way.
- **Falloff Sinual**  Weight falls off in a sinusoidal way.

Copy Copies the currently selected envelope size and shape to memory. Turn on sub-object Envelopes, choose one bone in the list, click Copy, then choose another bone in the list and click Paste to copy an envelope from one bone to another.
Paste commands are on a flyout with the following options:

- **Paste**  Pastes the copy buffer to the current selected bone.

- **Paste to All Bones**  Pastes the copy buffer to all bones in the modifier.

- **Paste to Multiple Bones**  Pastes the copy buffer to selected bones. A dialog allows you to choose the bones to paste to.

**Weight Properties group**

Abs. Effect  Enter an absolute weight for the selected bone to selected vertices. Choose the Envelope sub-object level, turn on Vertices in the Parameters rollout > Select group, select a vertex or vertices, and then use the Abs. Effect spinner to assign weight. Selected vertices move in the viewports as their weight changes.

Rigid  Causes selected vertices to be influenced only by one bone, the one with the most influence.

Rigid Handles  Causes the handles of selected patch vertices to be influenced by only one bone, the one with the most influence.

Normalize  Forces the total weights of each selected vertex to add up to 1.0.
Exclude Selected Verts Adds the currently selected vertices to the exclusion list for the current bone. Any vertices in this exclusion list will not be affected by this bone.

Include Selected Verts Takes the selected vertices out of the exclusion list for the selected bone. The bone can then affect these vertices.

Select Excluded Verts Selects all vertices excluded from the current bone (see Exclude Selected Verts, preceding).

Bake Selected Verts Click to bake the current vertex weights. Baked weights are not affected by envelope changes, only by changes to Abs. Effect on page 1678 or weights in the Weight Table on page 1704.

Weight Tool Displays the Weight Tool dialog on page 1697, which offers control tools to help you assign and blend weights on selected vertices.

Weight Table Displays a table for viewing and changing weights for all bones in the skeletal structure. See Weight Table on page 1704.

Paint Weights Click and drag the cursor over vertices in the viewports to brush on weights for the selected bone.

TIP Streamline the painting process by using the Brush Presets tools on page 8044.

Painter Options [ellipsis] Opens the Painter Options dialog on page 1989, where you can set parameters for weight painting.

Paint Blend Weights When on, blends painted values by averaging the weights of neighboring vertices and then applying the average weight based on the brush strength. Default=on.
Mirror Parameters rollout

**Mirror Mode** Activates Mirror mode, which lets you mirror the envelopes and vertex assignments from one side of the mesh to the other. This mode is available only at the Envelope sub-object level.

Mirror mode uses the Mirror Plane setting to determine the “left side” and “right side” of the mesh. When you turn on Mirror Mode, the vertices on the left side of the mirror plane turn blue, while the vertices on the right turn green. Vertices that are neither left nor right turn red, including vertices at the mirror plane. If vertices don’t change color appropriately, you might have to increase the Mirror Thresh value to expand the range used to determine the left and right sides.

If you select vertices or bones, the selected vertices or bones turn yellow, and the corresponding match on the other side of the mesh turns a brighter blue or green. This can help you check for matches.

**Mirror Paste** Pastes selected envelope and vertex assignments to the opposite side of the body.

**Paste Green to Blue Bones** Pastes the envelope settings from green bones to blue.
Paste Blue to Green Bones  Pastes the envelope settings from blue bones to green.

Paste Green to Blue Verts  Pastes the individual vertex assignments from all green vertices to the corresponding blue vertices.

Paste Blue to Green Verts  Pastes the individual vertex assignments from all blue vertices to the corresponding green vertices.

Mirror Plane  Determines the plane that will be used to determine the left and right sides. The plane appears in the viewport at the mesh’s pivot point when you turn on Mirror mode. The selected mesh’s local axes are used as the basis for the plane. If several objects are selected, one object’s local axes are used. Default=X.

TIP  For the easiest workflow with mirroring tools for the Skin modifier, set the pivot points for character meshes to align with the World before applying Skin.

Mirror Offset  Shifts the mirror plane along the Mirror Plane axis.

Mirror Thresh  Sets the relative distance the mirroring tools will look when setting vertices as left or right. If some vertices in the mesh (other than those at the mirror plane) are not colored blue or green when you turn on Mirror mode, increase the Mirror Thresh value to include a larger area of the character. You can also increase this value to compensate for lack of symmetry in asymmetrical models.

Display Projection  When Display Projection is set to Default Display, selecting vertices on one side of the mirror plane automatically projects the selection to the opposite side. The Positive and Negative options allow selection of vertices on one side of the character only. The None option does not project selected vertices to either side. Default=Default Display.

TIP  You can use the Positive and Negative options to temporarily project the display of one side’s vertices to the other side so you can see how the vertices align. This can be helpful when determining the correct Mirror Plane settings for an asymmetrical mesh.

Manual Update  When on, you can update the display manually rather than automatically after each mouse-up.

Update  When Manual Update is on, use this button to update the display with your new settings.
Display rollout

- **Show Colored Vertices** Colors vertices in viewports according to their weights.
- **Show Colored Faces** Colors faces in viewports according to their weights.
- **Color All Weights** Assigns a color to every bone in the envelope. The vertex weighting blends the colors together.

**TIP** You can toggle this feature to get a global view of all weight regions across your model at once.

**TIP** You can also assign a color to unweighted vertices: Open the Customize User Interface dialog and, on the Colors panel, choose Skin Colors from the Elements drop-down list.

- **Show All Envelopes** Displays all envelopes at the same time.
- **Show All Vertices** Draws a small tick at every vertex. On a patch surface, it will also draw all the handles.
- **Show All Gizmos** Displays all the gizmos in addition to the currently selected gizmo.
Show No Envelopes Causes no envelopes to be displayed even when an envelope is selected.

Show Hidden Vertices When on, hidden vertices are visible. Otherwise, they remain hidden until you enable the option or go into the object's modifier (Editable Mesh on page 2192 or Editable Poly on page 2258), and then click Unhide All on the Selection rollout or Edit Geometry rollout, respectively. Default=off.

Draw On Top group

These options determine which elements will be drawn on top of all other objects in viewports.

Cross Sections Forces cross sections to be drawn on top.

Envelopes Forces envelopes to be drawn on top.
Advanced Parameters rollout

Always Deform  A toggle useful for editing the transformation relationship between bones and the controlled points. This relationship is initially set when Skin is applied. To change the relationship the user can deactivate Always Deform, move the object or the bones and reactivate. The new transformation relationship is now used.

Ref. Frame  Sets the frame where the bones and the mesh are in a reference position.

Normally this is frame 0. Start your animation at frame 1 or later if frame 0 is the reference frame. If bones need to be adjusted relative to the mesh, move
the time slider to frame 0; turn off Always Deform, move the bones into the correct position and turn on Always Deform.

**Back Transform Vertices** Allows you to link the mesh to the bone structure. Ordinarily, when you do this, any movement of the bones causes the mesh to move twice as far as it should, because it moves once with the bones and once with the link. Checking this option prevents the mesh from moving twice under these circumstances.

**Rigid Vertices (All)** Causes vertices to have assignments to only one bone as if weighted 100% to the bone whose envelope has the most influence. Vertices will not have weight distributed over more than one bone and the deformation of the skinned object is rigid. This is mainly used for games that do not support weighted point transformation.

**Rigid Patch Handles (All)** On a patch model, forces patch handle weights to equal the knots weights.

**Bone Affect Limit** Limits the number of bones that can affect one vertex.

### Reset group

**Reset Selected Verts** Resets the weight of selected vertices to the envelope defaults. After manually changing vertex weight, use this to reset weights if necessary.

**Reset Selected Bone** Resets associated vertex weights back to the original weights calculated for the selected bone's envelope.

**Reset All Bones** Resets all vertex weights back to the original weights calculated for all bone's envelopes.

**Save/Load** Allows you to save and load the envelope position and shape, as well as the vertex weights. If you load a saved file onto a different system of
bones, you can use the Load Envelopes dialog on page 1693 to match the incoming bones to the current bones.

**Update on mouse up** When on and the mouse button is pressed down, no updates take place. When the mouse button is released, updates occur. This option helps keep workflow moving quickly by avoiding unnecessary updates.

**Fast Updates** Turns off viewport display of weighted deformation and gizmos and uses rigid deformation when not rendering.

**Ignore Bone Scale** Turn this option on to leave a skinned mesh unaffected by a scaled bone. Default=off.

**NOTE** To scale a bone’s length, you first need to turn off its Freeze Length option on the Object Properties rollout on page 877 of the Bone Tools floater dialog on page 871.

**Animatable Envelopes** Toggles the possibility of creating keys on all animatable envelope parameters while Auto Key is active. Default=off.

**NOTE** This does not affect keyable track settings.

**Weight All Vertices** When on, forces all vertices that are not under the control of an envelope to be weighted to the bone closest to them. Has no effect on vertices that are manually weighted. Default=on.

**TIP** If you want to revert vertices to their original weight value, click Reset Selected Verts (in the Reset group) or open the Weight Table on page 1704, and change the Modified weight status (M) of your selected vertices.

**Remove Zero Weights** Strips a vertex from its weight if it is less than the Remove Zero Limit value. This helps making your skinned model lighter (in games for instance) because less unnecessary data is stored in the geometry. Also accessible from the Weight Table.

**Remove Zero Limit** Sets the weight threshold that determines if a vertex is stripped of its weight when you click Remove Zero Weights. Default=0.0.
Gizmos rollout

Controls in the Gizmos rollout allow you to deform the mesh according to the angle of the joint, and to add gizmos to selected points on the object. The rollout consists of a list box containing all the gizmos for this modifier, a drop-down list of the current types of gizmos, and four buttons (Add, Remove, Copy and Paste).

The workflow for adding a gizmo is to select the vertices that you want to affect, select the bones that will drive the deformation, and then click the Add button.

There are three deformers available:

- The Joint Angle deformer has a lattice that can deform vertices on the parent and child bones.
- The Bulge Angle deformer has a lattice that only works on vertices on the parent bone.
- The Morph Angle deformer works on vertices of the parent and child bones. Keep these distinctions in mind when you select vertices to deform. For example, if you want to use the Joint Angle deformer, then select vertices close to the joint that will drive the deformation. If you want the parent bone vertices to deform like a biceps muscle, then select vertices that are only assigned to the parent bone before adding the Bulge Angle deformer. If all the vertices of the parent and child bone must deform, then select all of the vertices and add the Morph Angle deformer.
Bending the arm without the Morph Angle deformer causes the sleeve to crumple.
Using the Morph Angle deformer creates a smooth bend in the sleeve.

**Gizmo List Window** Lists the current Angle Deformers. The Deformer Parameters rollout changes depending on the type of gizmo selected.

**Deformer drop-down list** Lists the available deformers.

**Add Gizmo** Adds the current Gizmo to the selected vertices. To add a gizmo, you must first select the child bone for the joint you want to deform. Then you must select the vertices that you want to deform. You can then add a gizmo. After a gizmo is added, a Deformer Parameters rollout displays that contains gizmo parameters that you can adjust.

**Remove Gizmo** Remove the selected gizmo from the list.
Copy Gizmo Copy the selected gizmo.

Paste Gizmo Paste the gizmo.

The Paste button pastes the current copy buffer into the currently selected gizmo. You can only paste to like gizmos. For instance, you can't paste from a bulge gizmo to a joint gizmo.

Deformer Parameters rollout

The following parameters are for the Morph Angle deformer. One way to create morph targets, after the morph gizmo is added, is to add an Edit Mesh modifier to the stack above the Skin modifier. Use the vertex controls in the Edit Mesh
modifier to shape the geometry. Then go back in the stack to the Skin modifier and click Add From Stack. You can then delete the Edit Mesh modifier. Add From Stack looks at the last modifier in the stack to get the morph target. Note that when you go back down to the Skin modifier, the morph effect is doubled; you can rectify this by deleting or deactivating the Edit Mesh modifier.

**Joint Field** Displays the type of Deformer and the associated bone.

**List Window** Contains the current morph targets and associated bone angles.

**Naming Field** Select a morph target and rename it in this field.

**Add from stack** Uses the current state of the stack to get the morph target. Ideally, you have put an Edit Mesh modifier on top of the stack and done your edits before you click Add From Stack.

**Add from node** Uses another object as your morph target for this angle. This is like a regular morph target, but instead of being driven by a field, it is driven by the joint angle.

**TIP** You can use Snap Shot on the main toolbar to create a new target for morphing.

**Delete** Deletes the currently selected morph target from the list.

**Enable gizmo** Toggles the effect of the gizmo.
Joint Angle and Bulge Angle parameters

The following parameters are for the Joint Angle and Bulge Angle deformers. These two deformers are almost identical in the way they operate. The difference is that the Bulge Angle deformer only works on vertices of the parent bone, while the Joint Angle deformer works on vertices on both the child and parent bone.

To apply either of these deformers, first select the child link, then select vertices on the mesh, and then apply the deformer. Remember to turn on Vertices in the Parameters rollout > Select group before region-selecting vertices in the viewports.

Once the deformer is applied, turn on Edit Lattice and move the lattice control points in the viewports to deform the mesh at different bone angles.

**Name Field** Allows you to change the name of the deformer.

**Twist** Allows you to spin the gizmo around the mesh to place control points appropriately.

**Use Bounding Volume** Turn this on if you plan to change the geometry, like increasing segments on a cylinder. If the geometry changes, the mesh will still deform inside the lattice if this is turned on.
Enable Gizmo Toggles the effect of the gizmo on and off.

Edit Lattice Allows you to move the lattice control points in the viewports.

Edit Angle Keys Curves Brings up a curve editor that lets you manipulate the shape of the lattice at a particular angle. This curve is position vs. angle. It will show you the curves of the current selected points. The red curves are X, green curves are Y, and blue curves are Z.

Load Envelopes Dialog (Skin Modifier)

Select a mesh, patch, or NURBS object. > Apply Skin modifier. > Advance Parameters rollout > Load button

The Load Envelopes dialog associated with the Skin modifier on page 1667 allows you to load saved envelopes on page 1685 to specific bones. This resizable dialog shows the current envelopes in your scene and the incoming envelopes. Use the controls to manipulate the incoming envelopes so they align with the current envelopes.
Interface
<table>
<thead>
<tr>
<th>Current Envelopes</th>
<th>Incoming Envelopes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bone01</td>
<td>Bone01</td>
</tr>
<tr>
<td>Bone02</td>
<td>Bone02</td>
</tr>
<tr>
<td>Bone03</td>
<td>Bone03</td>
</tr>
<tr>
<td>Bone04</td>
<td>Bone04</td>
</tr>
<tr>
<td>Bone05</td>
<td>Bone05</td>
</tr>
<tr>
<td>Bone06</td>
<td>Bone06</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Current Vertex Set</th>
<th>Incoming Vertex Set</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sphere01</td>
<td>Sphere01</td>
</tr>
</tbody>
</table>

- Remove Incoming Prefix
- Remove Current Prefix
- Load End Points
- Load Cross Sections
- Load Vertex Data
- Load Exclusion Lists
- Load Vertices By Index
OK Accepts any changes and closes the dialog.

Cancel Discards any changes and closes the dialog.

**Move Up/Down** Move the current selection in the incoming list up or down.

**Create Blank** Creates space in the Incoming list.

Use this when loading data onto a skeleton that is not identical as the one from which the data was saved. For example, if your original skeleton had three fingers and the new one has only two fingers, you might need to add spaces in the list to line up the fingers correctly.

**Delete** Removes the current selected incoming envelopes.

**Match by Name** Resorts the Incoming list and matches any bones that have the same name in the list of current envelopes.

**Remove Incoming Prefix** Removes any prefixes on the names of the incoming envelopes.

**Remove Current Prefix** Removes any prefixes on the names of the current envelopes.

**Load End Points** Loads the envelope end point positions.

**Load Cross Sections** Loads the envelope cross sections.

**Load Vertex Data** When on, loads weights at the vertex level. Normally only the envelope data is loaded so any manual adjustments to the vertex data are lost. This option lets you load those manual edits.

**Load Exclusion Lists** Lets you also load user-generated exclusion-list data, which specifies that certain vertices should not be affected by certain bones. See **Exclude Selected Verts** on page 1679 and **Show Exclusions** on page 1705.

**Load Vertices By Index** Lets you load vertices by index rather than vertex position. You would typically use this option with identical meshes that have not undergone any type of topology change. This should be off if you’ve changed the topology, by, for instance, deleting or adding vertices or changing their order.

**Current Incoming Vertex Set**

When Load Vertex Data is on, use these controls to match vertex sets in cases where the Skin modifier is instanced. In such cases you might need to set up several vertex sets.
The Move Up/Create Blank/Move Down buttons have the same functions as in the Envelopes lists.

**Weight Tool Dialog (Skin Modifier)**

Select an object that has the Skin modifier applied to it. > Modify panel > Skin modifier > Parameters rollout > Weight Properties group > Weight Tool button

This dialog is launched from the Skin modifier on page 1667 and provides tools to select vertices and assign them weights. You can also copy, paste, and blend weights between vertices. Each vertex you select displays the objects contributing to its weighting in the dialog list.

To use these tools, Parameters rollout > Edit Envelopes must be on, Parameters rollout > Select group > Vertices must be on, and at least one vertex must be selected.

**IMPORTANT**  The controls on this dialog adjust vertex weighting with respect to the active bone; that is, the object highlighted in the Bones list on the Parameters rollout. When you select a vertex and then change its weighting, if the active bone does not already influence the vertex, the bone is added to the list of bones influencing the vertex. You can ensure that bone assignments don’t change by highlighting the bone in the Weight Tool dialog list after selecting the vertex and before changing weighting.

Also, the total weighting for all bones influencing a vertex is always 1.0, so if multiple bones influence a vertex and you change the weight value for one bone, the weight values for the others change as well.

**Procedures**

**Example: To Set and Blend Weights on Selected Vertices:**

1. Prepare a cylinder skinned to a bone chain.
2 On Parameters rollout of the Modify panel, turn on Edit Envelopes.

3 Turn on Vertices in the Select group.

4 In the Weight Properties group, click Weight Tool.
   The Weight Tool dialog opens.

5 Select a few vertices and then click the .25 weight button.
   The selected vertices are weighted at 0.250 for the active bone (highlighted in the Parameters rollout list), coloring them yellow.

**NOTE** The active bone is added to the list of bones influencing each of the selected vertices, if necessary.
NOTE

You might need to toggle the vertex weighting to Relative in the Envelope Properties group on page 1667.

6. Click the + button directly under the .9 weight button repeatedly until the vertices are red (that is, the weight is 1.0).
   As you increase the vertices' weight, they gradually change color.

7. Select a few other vertices, and assign them a weight of 0.250.
The left vertices are weighted 1.0 and the right vertices are weighted 0.25.

8 Select all weighted vertices and repeatedly click Blend. Every time you click Blend, each vertex’s weight is adjusted to blend with other selected neighborhood weights. This creates a smooth weighting transition among all selected vertices.
The two separate colors blend into a smooth gradient.
**Interface**

**Shrink**  Modifies the current vertex selection by progressively subtracting the outermost vertices from the selection. Has no effect if all vertices in an object are selected.

**Grow**  Modifies the current vertex selection by progressively adding neighborhood vertices of the selected object. You must start with at least one vertex to be able to grow your selection.

**Ring**  Expands the current vertex selection to include all vertices in parallel edges.

**NOTE**  You must select at least two vertices to use the Ring selection.

**Loop**  Expands the current vertex selection to include all vertices in continuing edges.
NOTE You must select at least two vertices to use the Loop selection.

<table>
<thead>
<tr>
<th>Weight Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
</tr>
</tbody>
</table>

**[specific weight values]** Assigns an absolute weight value between 0 and 1 for the active bone to the selected vertices.

NOTE When you click one of these buttons, the active bone is added to the list of bones influencing each of the selected vertices, if necessary.

**Set Weight** Sets an absolute weight based on the field value. Default=0.5.

NOTE The spinner increments the field value by steps of 0.05.

+/- Increases/decreases each selected vertex's weight by 0.05.

**Scale Weight** Multiplies each selected vertex's weight value by the field value, resulting in a relative weight change. Default=0.95.

NOTE The spinner increments the field value in steps of 0.05.

+/- Increases/decreases each selected vertex's weight by five percent.

**Copy** Stores the current weight value(s) in the copy buffer.

**Paste** Retrieves the weight values from the copy buffer and assigns them to the selected vertices.

**Paste-Pos** Assigns the weight values currently in the copy buffer to the selected vertices based on the distance between them and the copied vertices, which is determined by the Paste-Pos Tolerance value. This is useful when you need to match weights between two juxtaposed skinned meshes sharing the a common bone.

**Blend** Modifies the selected weight values to smooth out the transition between them and their surrounding vertices.

**Paste-Pos Tolerance** Determines the radius influence of the Paste-Pos. Default=0.1.

**Vertex information**

Below the Paste-Pos Tolerance field is a text display displaying information on the amount of copied and selected vertices.

**[First Vertex Weight list]** Displays the selected vertex weight along with the bone envelopes contributing to its weighting. You can select individual
envelopes in the current viewport by highlighting the respective bone in the list.

**NOTE** If you select multiple vertices, the list only displays the weighting of the first selected vertex.

### Weight Table (Skin Modifier)

Select an object that has the Skin modifier applied to it. > Modify panel > Skin modifier > Weight Properties group > Weight Table

The weight table for the Skin modifier is used to change vertex weights for several vertices and bones at a time. This table appears when you click the Weight Table button.

#### Interface

<table>
<thead>
<tr>
<th>Vertex ID</th>
<th>S</th>
<th>M</th>
<th>N</th>
<th>R</th>
<th>H</th>
<th>upperLegL</th>
<th>upperLegR</th>
<th>wristL</th>
<th>wristR</th>
<th>ankleL</th>
<th>ankleR</th>
<th>waistLR</th>
<th>waistRR</th>
<th>wristTwistL</th>
<th>wristTwistR</th>
</tr>
</thead>
<tbody>
<tr>
<td>#1462</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td>-</td>
<td>-</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>#1470</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>0.500</td>
<td></td>
<td>-</td>
<td>-</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>#1471</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>0.500</td>
<td></td>
<td>-</td>
<td>-</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>#1472</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>0.500</td>
<td></td>
<td>-</td>
<td>-</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>#1473</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>0.900</td>
<td></td>
<td>-</td>
<td>-</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>#1474</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>0.500</td>
<td></td>
<td>-</td>
<td>-</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>#1475</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>-</td>
<td>0.100</td>
<td>-</td>
<td>-</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>#1476</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>-</td>
<td>0.100</td>
<td>-</td>
<td>-</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>#1477</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>#1478</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>#1479</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>#1480</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>#2175</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>0.500</td>
<td>0.500</td>
<td>-</td>
<td>-</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>#2176</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>-</td>
<td>0.070</td>
<td>-</td>
<td>-</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Vertex numbers appear down the left column, while bone names appear across the top. Vertex weights for each bone are displayed in the chart. You can change vertex weights in a number of ways:

- Click and drag a vertex weight to the left or right.
- Highlight a weight and type in a new weight.
- Select vertices by dragging over vertex IDs, then click and drag one weight to change all selected weights for the bone.
- Right-click to enter a value of 0.
- Ctrl+right-click to enter a value of 1.0.

**Menu options:**

**Edit menu** Copy/paste vertex weights, and choose vertices to edit.
- **Copy:** Copies weights for highlighted vertices.
- **Paste:** Pastes the copied weights.
- **Remove Zero Weights:** All vertices with a weight less than the *Remove Zero Limit* on page 1686 field value are stripped from their weight. Also available on the *Advanced Parameters rollout* on page 1684.

- **Select All/None/Invert:** Changes the selection of vertices.

**Vertex Sets menu** Select vertices in the left column by holding down Ctrl while clicking vertices. Create a named selection set, which can then be picked from the drop-down menu at the lower left of the dialog.

**Options menu** Customizes the weight table display.
- **Flip UI:** Flips the UI to show vertex IDs across the top and bone names down the left side.
- **Update On Mouse Up:** When the mouse button is pressed down, no updates will take place. When the mouse button is released, updates will occur. This option helps keep workflow moving quickly by avoiding unnecessary updates.
- **Show Affected Bones:** Displays only bones that affect the displayed vertices.
- **Show Attributes:** Toggles display of the S/M/N/R/H attributes.
- **Show Exclusions:** Toggles display of small check box areas in each vertex weight field. Clicking the check box toggles exclusion of the vertex from the bone (a red X appears in the check box when the exclusion is in effect).
- **Show Global:** Shows values for all displayed vertices.
Show Set Sets UI: Displays info about vertex sets.

Dialog options

Vertex ID Vertices are displayed by number down the left column of the weight table. Double-click a vertex number to cause the vertex to display in pink in viewports. To display only selected vertices, choose Selected Vertices from the drop-down menu at the bottom left of the dialog.

S Indicates vertex is selected.

M Indicates vertex weight has been modified.

N Indicates vertex weights are normalized (total of all vertex weights is always 1.0).

R Indicates vertex is rigid (affected only by one bone, the one with the most influence).

H Indicates patch handles are rigid (affected only by one bone, the one with the most influence).

Vertex selection drop-down Choose to display all vertices, selected vertices or only vertices affected by the selected bone.

Copy Copies weights for highlighted vertices.

Paste Pastes copied weights.

Skin Morph Modifier

The Skin Morph modifier lets you use a bone's rotation to drive a morph; that is, a deformation of the object mesh. Skin Morph is intended for use with Skin or a comparable modifier such as Physique: add the Skin Morph modifier after the skin-type modifier. You create the morph at the frame in which the effect should be greatest, and then Skin Morph automatically animates the affected vertices into and out of the morph, based on the rotation of the bone that drives the morph.

Skin Morph lets you fine-tune mesh deformation at any frame, using a bone to drive the morph that is fixing a problem area. Often, when you animate a character with bones, you have to create extra bones to handle problem areas such as armpits and the groin. With Skin Morph, instead of adding extra bones, you can simply create a morph and then transform vertices into the
exact shape you want. Skin Morph provides an easy way to create muscle bulges and many other effects.

NOTE When working with Skin Morph, it’s important to be familiar with the concept of delta. The frame at which you apply the modifier determines the base position for each vertex that’s used in a morphing animation controlled by Skin Morph. After applying the modifier, go to a frame at which the bone driving the morph is rotated an amount that will cause the greatest deformation, and then transform vertices to produce the morph. The amount by which you transform the vertices is called the delta: the difference between the base pose and the morphed position.

Procedures

To use Skin Morph (basic usage):

1. Create an animated character with bones and a skinned body mesh, using a modifier such as Skin on page 1667 or Physique on page 4470.

2. Go to the “pose frame” and apply the Skin Morph modifier.
   The pose frame contains the initial pose; typically a standing character with arms outstretched and legs apart. This is often frame 0, but it can be any frame, even a negative-numbered one. This is the frame from which the modifier measures delta: the change in the vertex position between this pose and the morph.

3. Determine which bones are driving deformations that you want to modify with Skin Morph.
   For example, bending an arm might cause the inside of the elbow to indent too far, or you might want to add a bulging bicep. In this case, the forearm bone is driving the deformation.

4. Use Add to bind the deformation-driving bones to the modifier.
   The modifier overlays an orange line along the length of each bone you add.

5. Go to the frame where you wish to create the morph. Using the arm-bending example, this might be the frame where the forearm is at a 90-degree angle to the upper arm.

6. In the list box, click one of the bones.
   In the viewport, the orange line representing the bone becomes a thicker yellow line to indicate that this bone will drive the morph.
7 On the Local Properties rollout, click Create Morph. The modifier adds a morph to the highlighted bone and sets the morph to 100% at this frame, as reflected by the number next to the morph's name in the list.

8 On the Local Properties rollout, click Edit. This temporarily freezes the skin deformation at the current frame.

9 Move vertices to where they should be at the current frame.

10 Click Edit again to exit this mode, and then test the animation.

Interface

Skin Morph modifier stack

Points sub-object level At the Points sub-object level, you can view and select vertices on the skin mesh. However, you can transform these vertices only when Edit mode on page 1713 is on. The ability to select points when not in Edit mode lets you make the selection when the points are more easily accessible, and then go to the pose to transform them in Edit mode.
Parameters rollout

[list window] Lists all attached bones and their morphs in a hierarchical view. You can expand or contract a bone's morph listing by clicking the + or - box next to its name in the list. The number in parentheses next to the morph name shows its relative influence as a percentage at the current frame.

Highlighting a bone in the list highlights the bone in the viewports as a yellow line, and lets you create a morph for it. Alternatively, you can select the bone in the viewport while the modifier's Points sub-object level is active by clicking the orange line through its center.

Highlighting a morph in the list lets you edit the morph. To change the morph's name, edit the Local Properties rollout > Morph Name field.

**Add Bone** Click to add one or more bones from the Select Bones dialog.
**TIP** To keep things simple, add only bones that will drive morphs. There's no point in adding any other bones.

**Pick Bone** Lets you add bones by selecting them in a viewport.

Click Pick Bone, and then select bones in any viewport. While Pick Bone is active, the cursor resembles a cross with the words ADD BONE attached. To exit Pick Bone mode, right-click the active viewport or click Pick Bone again.

**Remove Bone** Removes a bone and its morphs from the list. Click a bone name in the list, and then click Remove.

If a morph name is highlighted when you click Remove, its bone is removed. To remove the morph only, highlight it and then click Local Properties rollout > Delete Morph.

**Selection rollout**

Use **Soft Selection** Enables soft selection for editing vertices.

Soft Selection in Skin Morph works much like **Soft Selection** on page 2014 in other parts of 3ds Max, except that instead of Pinch and Bubble settings you
can adjust the graph shape directly, and it uses a Radius setting instead of Falloff to determine the extent of the soft-selection area.

**Radius** Determines the extent of the soft-selection area in system units.

**Edge Limit** When on, Skin Morph uses the Edge Limit numeric setting to determine the extent of the soft-selection area in terms of the number of edges from the selected vertex or vertices.

**Reset Graph** Sets the soft-selection graph to default values. Use this if a vertex or handle is no longer visible and thus cannot be manipulated.

[graph] Skin Morph provides a small, full-functioned curve graph for editing soft-selection characteristics globally; it works much like other such graphs in 3ds Max, such as Curve Editor Introduction on page 3804. The toolbar above the graph offers functions for moving and scaling points on the graph, as well as inserting new ones. The same functions are available by right-clicking the graph: If you right-click a graph point, you can set it to Corner or one of two different Bezier types. If you select a Bezier point, you can reshape the curve by moving its handles.

**Ring** Expands a vertex selection by first converting the selection to an edge selection, selecting all edges parallel to the selected edges, and then converting the new edge selection back to a vertex selection. Use of Ring requires that a qualifying vertex selection exist; that is, at least two vertices on the same edge.

**Loop** Expands a vertex selection by first converting the selection to an edge selection, selecting all aligned edges, and then converting the new edge selection back to a vertex selection. Use of Loop requires that a qualifying vertex selection exist; that is, at least two vertices on the same edge.

**Shrink** Reduces the vertex selection area by deselecting the outermost vertices. If the selection size can no longer be reduced, the remaining vertices are deselected.

**Grow** Expands the vertex selection area outward in all available directions.
Local Properties rollout

This rollout contains functions for creating and editing individual morphs. The settings, such as Morph Name and Influence Angle, are specific to each morph.

Create Morph Sets a morph at the current frame for the highlighted bone. Also sets the “pose” for this morph, using the bone's current orientation, and sets the bone to 100%, as shown in the list window hierarchical view. When you edit the morph, the skinned object returns to and stays at this orientation. When you create a morph, the modifier displays, in orange, all vertices that are part of the current pose (that is, they're offset from the initial pose). Also, the modifier creates a default name for the morph and adds it as a child to the highlighted bone in the list window.
**TIP** By default, the Show Edges switch is on, which might make it difficult to see the vertices themselves. To see only the vertices, turn off Options rollout > Show Edges.

**TIP** To help keep track of morphs, use the Local Properties rollout to rename each morph as you create it.

**Delete Morph** Deletes the highlighted morph, removing it from its parent bone in the list window. Available only when a morph is highlighted.

**Edit** Lets you shape the current morph by transforming vertices. To exit Edit mode, click the Edit button again.

Transforming a vertex in Edit mode creates a morph target. Each transformed vertex moves into the morph target position (or orientation or scale) as the morph value increases to 100.0, and then out of it as the morph value decreases, based on the angle of the bone driving the morph.

Transforming a vertex in Edit mode also changes its color from orange to yellow. This lets you easily see which vertices are part of the current morph.

Choosing Edit places the skinned object at the 100% “pose” orientation for this morph (see Create Morph, above). It also activates the Points sub-object level so you can transform vertices using the standard 3ds Max transform tools.

**Clear Vents** Keeps selected vertices in the morph, but resets their deltas (changes from the initial pose) to 0.

**Reset Orientation** Sets the morph orientation to current orientation of the bone that controls the morph.

This lets you change the angle at which the morph has its greatest effect. For example, if you create a bulging bicep at frame 120, and later decide that the muscle should be largest at frame 150 instead, go to frame 150, choose the morph in the list box, and then click Reset Orientation.

**Remove Verts** Removes selected vertices from the current morph, which deletes any animation applied as part of the morph.

Use this command to save memory by removing vertices not part of the morph animation.

**Enabled** When on, the morph is active; when off, the morph doesn't appear in the animation, and is indicated in the list box with the text “Disabled.” Default=on.

The ability to enable and disable each morph individually lets you isolate the effect of each or test them in combination.
Morph Name Displays and lets you change the name of the current morph.

Influence Angle The angle around the bone's current orientation within which the morph takes place. Default=90.0.

This is an important parameter. Think of the influence angle as a cone around the bone at its orientation when you create the morph. Consider an example in which Influence Angle is set to the default value of 90.0 degrees. If the bone starts its rotation beyond 45 degrees away from the orientation at which the morph was created, the morph has no effect at that time. As the bone moves from 45 degrees away to the morph orientation, the morph increases to its full value. As the bone then rotates away, the morph gradually decreases until, at 45 degrees or more away from the morph orientation, the morph no longer appears.

Tips Influence Angle is useful for isolating morphs; that is, to prevent overlapping of different morphs on the same bone. Reduce the value until one morph's contribution percent value (shown in the list box) falls off to 0.0 before the next one begins.

Falloff Determines the rate of change of the morph as the bone moves within the influence angle. Use the drop-down list to choose one of four different falloff types: Linear, Sinual, Fast, or Slow. If you choose Custom Falloff, you can then click the G (for Graph) button and edit the falloff using standard curve-graph controls.

Tips The default graph, displayed when you first access the falloff graph, shows the Sinual falloff type.

Joint Type Determines how the modifier tracks the angular motion of the bone. This is a per-bone setting, not per-morph. Default=Ball Joint.

- Ball Joint Tracks all rotation of the bone. Use this setting in most cases.
- Planar Joint Tracks rotation of the bone only in the plane of its parent bone.

External Mesh Lets you use a different mesh as a morph target. Click the button (default label=-none-) and then select the target object. The target object should have the same mesh structure as the Skin Morph object. After specifying an external mesh, its name appears on the button.

Using an external mesh makes it easier to set up morph targets in a target mesh that uses a reference pose, rather than the skinned, animated mesh of which sections might be interpenetrating, making it difficult to select the
specific vertices to be morphed. In this situation, it's probably best to turn Reload Only Selected Verts.

**NOTE** The external-mesh connection is not live; if you edit vertices in the external mesh, Skin Morph doesn't automatically recognize the changes. To update the vertex positions after editing the external mesh, use Reload Target (see following).

**Reload Target** Updates the Skin Morph object with edited vertex positions from the external mesh.

**Reload only selected verts** When on, Reload Target copies only the positions of vertices selected in the Skin Morph mesh from the target mesh. When off, Reload Target copies the positions of all vertices. Default=off.

**Copy and Paste rollout**

These functions let you copy all morph targets for a specific bone from one side of the object to the other. Indicate the morphs to copy by highlighting the bone or any of its morphs in the Parameters rollout > list box.

**Paste Mirror** Copies the morphs from the highlighted bone to the target on the other side of the mirror gizmo. A qualified target bone must exist and be present in the list box.

**NOTE** This copies the morph data only; the rotation of the target bone must be comparable to that of the source bone for the morphing to appear in the animation.
**Show Mirror Plane** Displays the mirror plane as a red, rectangular gizmo in the viewports. The target bone must be on the opposite side of the mirror plane from the highlighted bone, and must be present in the Parameters rollout > list box.

**Preview Bone** Highlights the target bone in red in the viewports.

**Preview Vertices** Displays the morphing-qualified vertices in red in the viewports, as well as any animation present in the source vertices.

**Mirror Plane** The axis for the mirror plane. The plane is perpendicular to the indicated axis. Default=X.

**Mirror Offset** The position for the mirror plane on the Mirror Plane axis. Default=0.0.

**Mirror Threshold** The radius, in system units, within which Skin Morph looks for a qualifying target bone on the other side of the mirror plane. Default=1.0.

**Options rollout**

<table>
<thead>
<tr>
<th>- Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Beginner Mode</td>
</tr>
<tr>
<td>Show Driver Bone Matrix</td>
</tr>
<tr>
<td>Show Morph Bone Matrix</td>
</tr>
<tr>
<td>Show Current Angle</td>
</tr>
<tr>
<td>Show Edges</td>
</tr>
</tbody>
</table>

**Beginner Mode** When on, you must use the Create Morph button to create a morph and the Edit button to edit a morph.

When off, you can create and edit morphs on the fly. In this mode, when you select and move vertices at the Points sub-object level, 3ds Max first determines whether a morph exists for the selected bone at 100%; if so, all edits will go
to that morph. Otherwise, 3ds Max creates a new morph automatically and applies the edits to that morph.

**Show Driver Bone Matrix** Shows the matrix tripod of the current bone.

**Show Morph Bone Matrix** Shows the tripod of the orientation of the active morph.

**Show Current Angle** Shows pie wedges depicting the angles between the driver bone matrix and the morph bone matrix. These are color coded: red for the angle about the X axis; blue for the angle about the Y axis; and green for the angle about the Z axis.

**Show Edges** Highlights the edges connected to morphable vertices in orange. This is useful when a tessellating modifier such as MeshSmooth is applied to the skinned mesh above the Skin Morph modifier, to see the actual mesh being affected by Skin Morph.

**Matrix Size** The size of each tripod.

**Bone Size** The size of the bone display.

## Skin Wrap Modifier

Make a selection. > Modify panel > Modifier List > Object-Space Modifiers > Skin Wrap

The Skin Wrap modifier allows one or more objects to deform another. While Skin Wrap is flexible enough to serve a variety of needs, it's primarily intended for animating a high-resolution object, such as a character mesh, with a low-resolution one.

The low-resolution object doing the deforming is called a **control object**, and the high-resolution object it's affecting (that is, the one with the Skin Wrap modifier) is the **base object**. A base object can be any type of deformable object. Also, in this topic, **control vertex** refers to a vertex on the control object, and **point** refers to a vertex on the base object.

With Skin Wrap, you can modify the structure and topology of the high-resolution object after setting up the animation. The animation remains intact because it is actually contained in the control object.

In most cases, when using Skin Wrap, the control object is positioned near the modified base object, and then bound to the latter using the modifier's Add function. By default, moving a vertex in the control object affects nearby vertices in the base object. Additional options allow faces in the control object
to affect the nearest points in the base object instead (Blend To Base Object). Conversely, points in the control object can affect faces in the base object (Face Deformation).

Skin Wrap offers a great deal of control in that you can set a different strength value for each control vertex, as well as the shape of its volume of influence. You can also convert the Skin Wrap effect to a Skin modifier applied to the high-res model, suitable for use with game engines. And the ability to animate with multiple control objects lets a technical director assign animation of different parts of a complex character mesh to various artists.

**TIP** If you use a control object to which non-uniform scaling has been applied, its vertices will have non-spherical volumes of influence, which can lead to unexpected results. In such a case, before adding the control object to the modifier, apply Reset XForm on page 912 and then collapse the stack.

See also:
- Skin Wrap Patch Modifier on page 1726

**Procedures**

To use Skin Wrap (basic method):

1. Create a high-resolution base object and one or more low-resolution control objects, which will deform the base object. In general, each control object should have an overall shape similar to the part of the base object that it will deform, and be positioned near that part of the base object.

2. Apply Skin Wrap to the high-resolution base object. The modifier transfers animation or modeling from the control object to the base object.

3. On the Skin Wrap > Parameters rollout, use Add to assign the control object(s).

4. Choose a deformation engine: Vertex or Face.

5. Set global parameters as desired. These parameters affect all control vertices, and include Deformation Engine, Falloff, Distance Influence, and Face Limit.

6. To set local parameters, including strength and influence distances, access the Control Vertices sub-object level of the Skin Wrap. Select one or more control vertices, and then change the settings as necessary.
7 Edit or animate the control object with modifiers and/or sub-object transforms; the high-resolution (base) object deforms accordingly.

8 Repeat steps 5, 6, and 7 as necessary. Occasionally you might need to reset the modifier as well, by clicking the Reset button. Before doing so, always return to a non-deformed point (or “skin pose”) in the animation; typically, frame 0.

Interface

Skin Wrap modifier stack

Control Vertices sub-object level At the Control Vertices sub-object level, you can view and select vertices on the control object(s), and set local parameters on page 1722 for any selected vertices. By default, each selected vertex is surrounded by loops on page 1725 that depict its volume of influence. This sub-object level also uses color coding on affected points in the base object to show each selected vertex's relative effect on points within the volume of influence. Colors range from orange for the strongest influence to blue for the weakest influence. Red is for vertices that are within its range of influence but that it's not influencing.

By default, at this level, control vertices appear as small orange squares. To prevent this, turn off Display Parameters rollout > Display Control Vertices.
Parameters rollout

- low-poly hero

Deformation Engine
- Vertex Deformation

- Falloff: 1.0
- Distance Infl.: 1.2
- Face Limit: 3.0

- Blend To Base Mesh
- Blend Distance: 5.0

- Local Str.: 1.0
- Local Scale Mult.: 1.0
- Local X: 1.76
- Local Y: 1.76
- Local Z: 1.76

- Reset

- Threshold: 5.0

- Weight All Points
- Convert To Skin
[control object list] Lists object(s) that deform the modified object. Use the Add and Remove functions to edit the list contents.

Add Adds control objects to the list. Click Add, and then click each control object in turn. To stop adding, right-click in the viewport or click Add again. You can use as a control object anything that can be converted to a triangle mesh, such as a mesh, patch, or a NURBS object. However, avoid using objects that change topology, such as a deforming NURBS object with adaptive tessellation.

Remove Removes control objects from the list. Click an object in the list, and then click Remove.

Deformation Engine Determines which engine drives the deformation. Default=Vertex Deformation.

- The Vertex Deformation engine is a weighted engine; it uses vertex proximity to drive the deformation. That is, each vertex in the control object affects nearby points in the high-resolution (base) mesh.

- With the Face Deformation engine, each control vertex is tied to the closest face in the base object. Face deformation can use falloff, or be a rigid deformation by setting Falloff to 0.001, the lowest possible value.

Falloff Determines the extent to which the control vertices affect nearby points in the base object. This is a global setting. Default=1.0. Range=0.001 to 10.0.

Higher values pull nearby points closer to the control vertex. In Face Deformation mode, setting Falloff to the lowest value, 0.001, causes rigid deformation so that there’s no falloff; the control vertex either affects the base-object face or it doesn’t. For best results, use Falloff values between 1.0 and 2.0, or with Face Deformation, 0.001 for rigid mode.

Distance Influence Determines the distance of influence, in system units, of control vertices in the control object. This is a global setting, and is available only in Vertex Deformation mode. Default=1.2. Range=0.001 to 10.0.

Distance Influence is a multiplier. It looks at the length of each edge that touches each control vertex. For each vertex, it averages all the lengths and then multiplies the average by the Distance Influence value. This lets vertices that are touching only small faces to affect a small area, and vice-versa. The higher the influence value, the smoother the deformation, but the less individual control each vertex has. For best results, keep this value between 1.0 and 2.0.
**Face Limit** Determines the extent of influence, in control-object faces, of control vertices in the control object. This is a global setting, and is available only in Vertex Deformation mode. Default=3. Range=0 to 30.0. Beyond this limit, no base-object points can be influenced by the control vertex, even if they're within the Distance Influence radius. Face Limit is useful for preventing the control-object influence from bridging gaps in the mesh; for example, between fingers in a character mesh.

**Blend To Base Mesh** Causes the modifier to base deformation on the distance from each affected point to the closest face in the control object. Turning on this option makes the Blend Distance setting available.

**Blend Distance** Determines the relative distance between control-object faces and vertices in the base object for deformation to take effect. Available only when Blend To Base Mesh is on. Default=5.0. Increasing this setting effectively causes a stronger deformation effect and broadens the area on the control that affects the base object.

**[local parameters]**

The Local parameters are available only at the Control Vertices sub-object level (see Skin Wrap modifier stack on page 1719), and affect only selected points. If you select a single point, the numeric fields reflect its current parameter values. If you select multiple points, 3ds Max displays only those values common to all selected points; parameters with differing values are blank. With multiple points selected, changing a value sets all selected points to that value.

**Local Str(ength)** Determines the power and direction by which the control-object vertex affects points under its influence in the base object. A positive value pulls the points toward the vertex; a negative value pushes them away. Default=1.0.

**Local Scale Multiplier** Scales each selected control-object vertex's volume of influence uniformly. Default=1.0. Use the scale settings to increase or decrease the area of the base object that the selected control vertex affects.

**Local X/Y/Z** Scales each selected control-object vertex's volume of influence along the indicated axis. Default=1.0. Change these parameters to produce a non-spherical volume of influence.
**Reset** Resets all control-object vertices' local values to 1.0 and resamples the mesh. It recalculates the control vertices' influence on the base object using the current modifier settings.

Use Reset if you alter a parameter but don’t see any change in the deformation. For example, always use Reset after changing the Threshold value. Or, if you want the control object to affect a different part of the base object, move the former, and then use Reset so the modifier accounts for the change in positional relationship between the two. You might also need to reset after changing the topology of the base object or a control object.

**IMPORTANT** Use Reset at a point in the animation where no deformation is in effect; typically, frame 0.

**Threshold** Determines the distance in system units that 3ds Max uses to find the closest face to a control vertex. The greater the distances by which the control object's and base object's surfaces deviate, the higher the Threshold value needs to be. Default=5.0.

**NOTE** Threshold is recomputed only when you add a base mesh or click Reset.

**WARNING** Be careful about increasing this setting. High values can result in excessive computation times, especially with complex base objects.

**Weight All Points** Forces all base-object points to have weights. Each weight is calculated from a combination of three factors: control vertex scale, control vertex strength, and base-object point position.

By default, not all base-object points are necessarily influenced by the control object. Turning on Weight All Vertices causes all points to be influenced by one or more control vertices. If a large number of base-object points are unassigned, this can take a long time to calculate.

**Convert To Skin** Applies a new Skin modifier on page 1667 to the base object that replicates the animation in the Skin Wrap modifier. Using this function requires that a Skin modifier already be applied to each control object.

Basically, Convert To Skin intelligently “bakes” the animation from skinned low-res control objects to the high-res base object. The Skin modifier that it creates contains all the bone assignments from the original Skin modifier, but with completely rebuilt weight settings based on the base-object weights created by the Skin Wrap modifier.

This function is useful in game-development settings where the game engine recognizes the Skin modifier settings but not the Skin Wrap modifier.
Advanced Parameters rollout

The Mirror tools in Skin Wrap let you apply local settings (Strength and Scale) from control vertices on one side of a control object to the other, mirroring them across a plane aligned with the X, Y, or Z axis. This is useful for setting up character meshes.

**NOTE** Mirror copies only Skin Wrap settings from control vertices; it doesn't copy animation data. Thus, when using Skin Wrap with a character model, first make local settings for control vertices on one side of the control object, select the vertices to copy, mirror them, and then animate the control object.

The Bake/Retrieve Control Vertices functions let you store control-vertex settings into the base object and then retrieve them. This is useful for sharing data among artists working on the same project.

**Show Mirror Data** Turns on display of the mirror plane gizmo as well as a small circle showing the projected location for each selected control vertex. Move the gizmo and the projected locations with the Mirror Offset control (see following).

**NOTE** For mirror data to be visible, the Skin Wrap > Control Vertices sub-object level must be active.

**Mirror Plane** Choose the X, Y, or Z axis for mirroring.
**Mirror Offset** Moves the mirror plane as well as all mirrored vertices.

**Mirror Threshold** Sets the distance, in system units, that Skin Wrap uses to find a control vertex near a projected vertex. Increase this if vertex locations are not the same on either side of the mirror plane.

**Mirror Selected** Copies the local settings from each selected control vertex to any control vertices within the threshold distance of its projected location on the other side of the mirror plane.

**Bake Control Verts** Stores the Local Strength/Scale and the global Falloff, Distance Infl., and Face Limit settings on the control objects for later retrieval with Retrieve Control Vertices.

**NOTE** This data is static; any changes to the base-object topology invalidates it.

**Retrieve Control Verts** Takes any control-vertex data stored on the control objects with Bake Control Vertices and copies them into the modifier.

**Display Parameters rollout**

These settings determine whether or not 3ds Max displays different elements in the Skin Wrap modifier.

**Display Loops** Displays volumes of influence for selected control vertices as red loops. Default=on.

**Display Axis** Displays the axis tripods for selected control vertices. Default=on.

**Display Face Limit** Shows all base-object points that the selected control vertex or vertices can affect. This is a visualization of the Face Limit setting on page 1722. Default=on.
Display Unassigned Points  Draws a red circle around each base-object point that the system did not find a closest face for and draws a red box around each point that has a closest face but is not weighted by any control vertex. Default=off.

Unassigned points: The circled points (bottom) have no closest face, while the points with red boxes (center) have a closest face but aren't weighted by control vertices.

This is an important debugging tool because any vertex that is not assigned a closest face will never be weighted. To do so, you need to increase the Threshold value and click Reset, or turn on Weight All Points. Any points that are not weighted to a control vertex can be fixed by increasing the Local Scale of a control vertex near that point.

Display Control Verts  Toggles display of all control vertices. Default=on.

Skin Wrap Patch Modifier

Make a selection. > Modify panel > Modifier List > Object-Space Modifiers > Skin Wrap Patch
Skin Wrap Patch is a simple modifier that allows a patch object to deform a mesh object. It's very easy to use: just assign the modifier to a mesh object, and then use the modifier to specify a deforming patch object. Each point on the patch object influences a surrounding volume of points on the mesh object.

See also:

- Skin Wrap Modifier on page 1717

Interface

Pick Patch Click this button, labeled “None” by default, and then select a patch object to deform the mesh object. After picking the patch object, its name appears on the button.

Sample Rate Determines the accuracy with which the modifier samples the patch object. The higher the rate, the more accurate the resulting animation will be, but the longer it will take to calculate.

Resample Forces the system to resample the date. This should be done at a point in the animation at which no deformation takes place; typically, frame 0.

Slice Modifier

Select an object. > Modify panel > Modifier List > Object-Space Modifiers > Slice
Select an object. > Modifiers menu > Parametric Deformers > Slice
The Slice modifier lets you create a cutting plane that slices through a mesh, creating new vertices, edges and faces based on the location of the slice plane gizmo. The vertices can either refine or split the mesh according to the selected options.

The Slice modifier slices through groups, selected objects or sub-object selections of faces. It works similarly to the Editable mesh > Edge > Slice function but does not require the objects to be editable meshes.

The Slice cuts through the cake.

You can animate the cutting plane, changing its position and rotation over time. You can also use the Remove Top and Remove Bottom options to create the appearance and disappearance of objects by animating the Slice Plane gizmo.
Multiple Slices

To create multiple slices in an object you need to apply multiple Slice modifiers. If the geometry doesn't need to remain parametric, you can collapse it into an editable mesh and use the Slice tool available under Editable Mesh (Edge) on page 2209. This tool is easier to use when you need to make multiple slices in an object, but it does not stay parametric.

Warning: Slice and Sub-Object Selections

You can use Slice on sub-object selection sets by slicing or removing only the selected faces. However, because selected faces are sliced and unselected adjacent faces are not, there may be "holes" in the mesh on the edge where the slice occurs. These holes can be problematic, creating discontinuities in smoothing and rendering. Holes are created only when Operate On Faces is on.
Procedures

Example: To animate the appearance of a teapot using the Slice modifier:

1. Create a teapot on page 416 primitive. Set the viewport to wireframe.
2. Apply a Slice modifier.
   The Slice Plane gizmo appears at the base of the teapot.
3. On the stack display, choose the Slice Plane gizmo.
4. Turn on the Auto Key button, and move the time slider to frame 100.
5. Move the Slice Plane gizmo above the top of the teapot. Play the animation to verify that the slice plane is animated.
6. Change the Slice type from Refine Mesh (the default) to Remove Top. Play the animation again.
7. Make a copy of the teapot in the same position (choose Edit menu > Clone and click OK to accept the default settings).
8. Put a Wireframe material on the clone and change the Slice type on the clone to Remove Bottom.
9. Play the animation.
   The wireframe teapot magically becomes a fully shaded one.

Example: To slice vertically through an object:

1. Create a teapot on page 416 primitive.
2. Apply a Slice modifier.
The Slice Plane gizmo appears at the base of the teapot.

3 On the stack display, open the Slice modifier and choose the Slice Plane gizmo.

4 Move the Slice Plane gizmo so it intersects the middle of the teapot.

5 Rotate the Slice Plane gizmo so it is vertical.

6 Turn on Remove Top.
   The back of the teapot is sliced away.

7 Turn on Remove Bottom.
   The front half of the teapot is sliced away.

Interface

Modifier Stack

Slice Plane At this sub-object level, you can transform and animate the gizmo like any other object to determine where the slice occurs. Scaling the gizmo has no effect, because its extents are effectively infinite. If you need to limit the extent of the slice, use it on a sub-object selection set of faces, rather than on the entire object.

For more information on the stack display, see Modifier Stack on page 8187.
Slice Parameters rollout

Slice Type Defines how the slice plane will affect the geometry to which it has been applied.

- **Refine Mesh**  Adds new vertices and edges along the intersection of the geometry with the slicing plane. Faces cut by the plane are subdivided into new faces.

- **Split Mesh**  Adds a double set of vertices and edges along the plane boundary producing two separate meshes (one on either side of the slice plane), which you can modify differently if desired. Use this to break a mesh in two.

- **Remove Top**  Deletes all the faces and vertices above the Slice Plane.

- **Remove Bottom**  Deletes all the faces and vertices below the Slice Plane.

Operate On Choose one of these buttons to specify how the slice handles quads and other polygons.

- **Faces**  Treats the selection set as a set of triangular faces, slicing each one in turn. Outputs a mesh-type object on page 2192.

- **Polygons**  Converts the object to a polygon mesh based on visible edges, eliminating hidden edges. Outputs a polymesh-type object on page 2240.
Smooth Modifier

Select an object. > Modify panel > Modifier List > Object-Space Modifiers > Smooth

Select an object. > Modifiers menu > Mesh Editing > Smooth

The Smooth modifier provides auto-smoothing based on the angle of adjacent faces. You can apply new smoothing groups to objects.

Smoothing eliminates the facets on geometry by grouping faces into smoothing groups. At render time, faces in the same smoothing group appear as a smooth surface.
1. No smoothing applied
2. Smoothing threshold=15
3. Smoothing threshold=30

**Patches**

As of 3ds Max 4, patch objects coming up the modifier stack are not converted to a mesh by this modifier. A patch object input to the Material modifier retains its patch definition. Files that contain patch objects with the Material modifier from previous versions of 3ds Max will be converted to meshes to maintain backward compatibility.
Procedures

To smooth an object:

1. Select the object to be smoothed.

2. On the Modifiers menu, choose Mesh Editing > Smooth.

3. On the Modify panel, choose Object-Space Modifiers > Smooth from the Modifier List.

4. Turn on Auto Smooth and adjust the Threshold for the desired smoothing effect.

To apply smoothing groups manually:

1. Select an object.

2. Use a Mesh Select modifier on page 1500 to select the faces to be smoothed.

3. Click a numbered button to apply the corresponding smoothing group to the selected faces.

Interface

Parameters rollout

```
- Parameters

- Auto Smooth
- Prevent Indirect Smoothing

Threshold: 30.0

Smoothing Groups:

1  2  3  4  5  6  7  8
9 10 11 12 13 14 15 16
17 18 19 20 21 22 23 24
25 26 27 28 29 30 31 32
```
**Auto Smooth** If Auto Smooth is selected, the object is auto-smoothed using the (animatable) threshold specified by the Threshold setting below it. Auto Smooth sets the smoothing groups based on the angle between faces. Any two adjacent faces are put in the same smoothing group if the angle between their normals is less than the threshold angle.

**Prevent Indirect Smoothing** Turn on to prevent smoothing "leaks" when using Auto Smooth. If you apply Auto Smooth to an object, and portions of that object that should not be smoothed become smoothed, then turn on Prevent Indirect Smoothing to see if it corrects the problem.

**Threshold** Specifies the threshold angle in degrees. Any two adjacent faces are put in the same smoothing group if the angle between their normals is less than the threshold angle.

**Smoothing Groups group**

The grid of 32 buttons shows which smoothing groups are used by the selected faces, and are used to assign smoothing groups manually to selected faces.

**Spherify Modifier**

Select an object. > Modify panel > Modifier List > Object-Space Modifiers > Spherify

Select an object. > Modifiers menu > Parametric Deformers > Spherify

The Spherify modifier distorts an object into a spherical shape. This modifier has only one parameter: a Percent spinner that deforms the object, as much as possible, into a spherical shape.
Spherify shapes the dog inside the snake.

The success of the operation depends on the topology of the geometry to which it's applied. For example, a cylinder with no height segments will result in little change. Adding height segments will result in a barrel at 100 percent. Adding cap segments will produce a sphere.

Try this on a teapot on page 416.

**Procedures**

**Example: To use the spherify modifier to distort a teapot:**

1. Click Create > Geometry > Standard Primitives > Teapot.
2. Create a teapot in the viewports.
3. On the Modify panel, choose Spherify from the Modifier List. The teapot should now look like a sphere.
4. Adjust the Percent setting to less than 100%.
Example: To animate spherifying a teapot:

1. Click Create >Geometry > Standard Primitives > Teapot.
2. Create a teapot in the viewports.
3. On the Modify panel, choose Spherify from the Modifier List.
4. Turn the Auto Key button on.
5. Set the Spherify Percent to 0.
6. Move the time slider ahead to frame 30.
7. Set the Spherify Percent to 100.
8. Turn the Auto Key button off.
9. Drag the time slider to play the animation, or click Play.

Interface

<table>
<thead>
<tr>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Percent:</td>
</tr>
<tr>
<td>100.0</td>
</tr>
</tbody>
</table>

**Percent** Sets the percentage of spherical distortion to apply to an object.

**Spline IK Control Modifier**

Select a spline or NURBS curve > Modify panel > Modifier List > Spline IK Control

When the Spline IK Control modifier is applied to a spline, you can select and transform its vertices without having to access the vertex sub-object level. It can also place helpers at each vertex location to aid in moving vertices.

The Spline IK Control modifier works by placing knots (control points) at each vertex. The knots can then be used to control vertices, which in turn reshape the spline.
This modifier also works on NURBS curves, placing a knot at each control point or control vertex (CV).

Use the Spline IK Control modifier to prepare a spline or NURBS curve for use with the Spline IK Solver.

See also:

- Spline IK on page 3733

Interface

Control Objects When helpers are created, knot numbers and their corresponding names appear here. Knot #1 is placed at the first vertex on page 8578 on the spline, and additional knots are numbered in sequence.

Create Helpers Places a helper at each knot, and displays knot numbers and helper names in the Control Objects area. Helper display is based on selections in the Helper Display group. Helpers are linked upon creation if a linking option is selected in the Link Types group.
**Link Types group**

These options cause helpers to be linked upon creation.

**Link All in Hierarchy** Links each helper to its immediately previous helper. For example, the helper at knot #3 is linked to the helper at knot #2, while the helper at knot #2 is linked to the helper at knot #1.

**Link All to Root** Links each helper to the helper at knot #1.

**No Linking** Helpers are not linked.

**Helper Display**

When you click Create Helpers, 3ds Max can place one or more Point helper objects at each knot, making it easier to move and animate the knots. You can enable more than one type of helper.

**Center Marker** Places a small X-shaped Point helper at each knot.

**Axis Tripod** Places a small tripod-axis-shaped Point helper at each knot.

**Cross** Places a small cross-shaped Point helper at each knot.

**Box** Places a small box-shaped Point helper at each knot.

**Size** Sets the size for helpers.
**Constant Screen Size** Keeps the sizes of helpers constant regardless of the zoom extent of the viewports.

**Draw On Top** Displays the helpers on top of all other objects in the scene for improved visibility in busy scenes.

**TIP** To change the display of helpers after creation, select each helper and change selections on the Modify panel.

---

**Spline Select Modifier**

Select a shape. > Modify panel > Modifier List > Object-Space Modifiers > Spline Select

Select a shape. > Modifiers menu > Selection Modifiers > Spline Select

The Spline Select modifier passes a sub-object selection of shapes up the stack to subsequent modifiers. It provides much of the same set of selection functions available in the *Edit Spline modifier* on page 1424. You can select vertices, segments, or splines, and you can change the selection from sub-object level to object level.

This modifier is similar to the *Mesh Select* on page 1500 and *Poly Select modifiers* on page 1582, except for the type of sub-object components.

**Procedures**

**To use the Spline Select modifier:**

1. Create a multi-spline shape.
2. Apply a Spline Select modifier.
   By default, the Vertex sub-object level is active.
3. If you wish to work at a different sub-object level, use the modifier stack display to choose it.
4. In the viewports, select vertices, segments, or splines.

**TIP** You can transform the selection using an *XForm modifier* on page 2010 or *Linked XForm modifier* on page 1484.
Interface

Modifier Stack

The sub-object level you choose for the spline select modifier determines which rollout appears. (There are no parameters at the top, object level.)

**Vertex** Creates a sub-object selection of vertices.

**Segment** Creates a sub-object selection of segments.

**Spline** Creates a sub-object selection of splines.

For more information on the stack display, see Modifier Stack on page 8187.

Select Vertex rollout

**Get Segment Selection, Get Spline Selection** Select vertices based on the last Segment or Spline selection. This selection is added to the current selection. Available only when Vertex is not the current sub-object level.
Select Segment rollout

Get Vertex Selection, Get Spline Selection Select segments based on the last vertex or spline selection. The selection is added to the current selection. Available only when Segment is not the current sub-object level.

Select Spline rollout

Get Vertex Selection, Get Segment Selection Select splines based on the last vertex or segment selection. The selection is added to the current selection. Available only when Spline is not the current sub-object level.

Copy/Paste Selection controls (all rollouts)

Copy Places a named selection into the copy buffer.

Paste Pastes a named selection from the copy buffer.

You can copy a named selection from one object to another or one modifier to another. You must copy and paste in the same sub-object level.
Squeeze Modifier

Modify panel > Make a selection. > Modifier List > Object-Space Modifiers > Squeeze

Make a selection. > Modifiers menu > Parametric Deformers > Squeeze

The Squeeze modifier lets you apply a squeezing effect to objects, in which the vertices closest to the object's pivot point move inward. The squeeze is applied around the Squeeze gizmo's local Z axis. You can also use Squeeze to create a bulge on the vertical axis, to accentuate the squeeze effect.

Left: Original object
Middle and Right: Varying squeeze amounts

Interface

Modifier Stack

Gizmo At this sub-object level, you can transform and animate the gizmo like any other object, altering the effect of the Squeeze modifier. Translating the gizmo translates its center an equal distance. Rotating and scaling the gizmo takes place with respect to its center.

Center At this sub-object level, you can translate and animate the center, altering the Squeeze gizmo's shape, and thus the shape of the squeezed object.

For more information on the stack display, see Modifier Stack on page 8187.
Parameters rollout

Axial Bulge group

These controls let you apply a bulge effect along the Squeeze gizmo's local Z axis, which is aligned by default with the object's local Z axis.

Amount Controls the magnitude of the bulging effect. Higher values effectively elongate the object and cause the ends to curve outward.

Curve Sets the degree of curvature on the bulging ends. You can use this to control whether the bulge is smooth or pointy.

Radial Squeeze group

These controls let you apply a squeeze effect around the Squeeze gizmo's local Z axis, which is aligned by default with the object's local Z axis.

Amount Controls the magnitude of the squeezing action. Values larger than zero tend to constrict the “waist” of the object, and values less than zero tend to bulge the waistline out, as if the object had been stepped on.
Curve  Sets the degree of curvature into the squeeze. Low values cause a sharp squeezing effect, while high values create a gradual, less pronounced squeeze.

**Limits group**

These controls let you limit the squeeze effect's extents along the local Z axis.

**Limit Effect** Limits the extent of the squeeze effect as defined by the Lower and Upper Limit settings.

**Lower Limit** Sets the limit in the positive direction along the Z axis.

**Upper Limit** Sets the limit in the negative direction along the Z axis.

**Effect Balance group**

**Bias** Changes the relative amounts of bulge and squeeze while retaining a constant object volume.

**Volume** Increases or decreases the effects of both Squeeze and Bulge in parallel.

**STL Check Modifier**

Select an object. > Modify panel > Modifier List > STL Check

Select an object. > Modifiers menu > Mesh Editing > STL check

The STL Check modifier checks an object to see if it's correct for exporting to an STL (stereolithography) file format on page 7784. Stereolithography files are used by specialized machines to produce prototype physical models based on the data in the STL file.

To create a physical model, an STL file must have a complete and closed surface. Using STL Check to test your geometry before you export it can save time and money when the file is used to create the physical model.
STL Check errors.
1. Open edges
2. Double face
3. Spikes
4. Multiple edges

Procedures

To check an object for STL compatibility:

1. Select the object, then on the Modify panel, choose Mesh Editing > STL Check from the Modifier List.
2. Turn on Check.
   The message in the Status group shows if errors are found. STL Check indicates errors by selecting the problem geometry, assigning it a special material ID, or both.
Errors group

Choosing one of these options selects incorrect geometry specific to the choice, and selects it depending on the option chosen in the Selections group.
Open Edge  Checks for open edges (holes).

Double Faces  Checks for faces that share the same 3D space.

Spike  Checks for spikes, which are isolated faces that share only one edge with the object.

Multiple Edges  Checks for faces that share more than one edge.

Everything  Checks for all of the above.

**TIP** While checking Everything takes the longest amount of time, it is recommended if you plan to use the STL file for generating a physical model.

**Selections group**

These options specify the level of incorrect geometry that's selected, based on the settings in the Errors group.

**Don't Select**  When on, STL Check doesn't select any part of objects in error.

**Select Edges**  When on, STL Check marks the edges of faces in error by selecting them. The selection of erroneous edges is visible in viewports.

**Select Faces**  When on, STL Check marks the faces of any object in error by selecting them. The selection of erroneous faces is visible in viewports.

**Change Mat-ID**  When on (the default), STL Check also marks faces in error by assigning them a unique material ID. Use the spinner to choose the value of the material ID that STL Check uses.

**Check**  Turn on to perform the STL check. For complex models, expect a pause between the time you turn this on, and the time you see the reported errors in the Status group. Default=off.

**Status**  Displays the number of errors when Check is on.

**TIP** If Select Edges is turned off, you can see faces in error by applying an Edit Mesh modifier on page 1321 and selecting by material ID at the Face sub-object level. You can also assign a Multi/Sub-Object material on page 6120 to the object to help you see where the errors are.

---

**Stretch Modifier**

Select an object. > Modify panel > Modifiers List > Object–Space Modifiers > Stretch
Select an object. > Modifiers menu > Parametric Deformers > Stretch

The Stretch modifier simulates the traditional animation effect of "squash-and-stretch." Stretch applies a scale effect along a specified stretch axis and an opposite scale along the two remaining minor axes.

The amount of opposite scaling on the minor axes varies, based on distance from the center of the scale effect. The maximum amount of scaling occurs at the center and falls off toward the ends.

Applying a Stretch modifier to the object on the left creates the object on the right.

Procedures

To stretch an object:

1. Select an object.
2. Apply Stretch.
3. On the Parameters rollout > Stretch Axis group, choose X, Y, or Z.
4. On the Parameters rollout > Stretch group, enter a value in the Stretch field.
5 Adjust the Parameters rollout > Stretch group > Amplify setting to change the amount of scaling along the minor axes.

**To limit a stretch:**

1 Apply a Stretch modifier to an object and specify the stretch amounts and stretch axis.
2 On the Parameters rollout > Limits group, turn on Limit Effect.
3 Set values for the Upper and Lower Limits to define the Stretch boundaries on either side of the Stretch center.
4 In the stack display, choose the Center sub-object level, and move the center to locate the limited stretch effect.

**Interface**

**Modifier stack**

**Gizmo** At this sub-object level, you can transform and animate the gizmo like any other object, altering the effect of the Stretch modifier. Translating the gizmo translates its center an equal distance. Rotating and scaling the gizmo takes place with respect to its center.

**Center** At this sub-object level, you can translate and animate the center, altering the Stretch gizmo's shape, and thus the shape of the stretched object.
Use options in the Parameters rollout to set the following:

- Amount of stretch
- Major stretch axis
- Area affected by the stretch

**Stretch group**

The Stretch group of the Parameters rollout has two fields that control the amount of stretch scaling applied.

**Stretch** Sets the base scale factor for all three axes. The scale factor derived from the Stretch value varies according to the sign of the value.

- Positive stretch values define a scale factor equal to Stretch+1. For example, a stretch value of 1.5 yields a scale factor of 1.5+1=2.5, or 250 percent.
Negative stretch values define a scale factor equal to \(-1/(\text{Stretch}-1)\). For example, a stretch value of -1.5 yields a scale factor of \(-1/(-1.5-1)\)=0.4, or 40 percent. The calculated scale factor is applied to the selected stretch axis and the inverse scale is applied to the minor axes.

![Stretch values of 0.0, 0.5, and -0.5](image)

**Amplify** Changes the scale factor applied to the minor axes. Amplify generates a multiplier using the same technique as stretch. The multiplier is then applied to the Stretch value before the scale factor for the minor axes is calculated. Amplify values affect scaling along the minor axes in the following way:

- A value of 0 has no effect. It uses the default scale factor calculated from the Stretch amount.
- Positive values exaggerate the effect.
- Negative values reduce the effect.
Stretched objects with Amplify values of 0.0, 1.0, and -1.0.

**Stretch Axis group**

You select which of the object's local axes is the Stretch Axis using options in the Stretch Axis group of the Parameters rollout.

- The scale factor calculated from the Stretch Amount is applied to the Stretch Axis.
- The inverse scale factor is applied to the remaining minor axes.
**Limits group**

You can apply the stretch effect to the entire object, or limit it to a portion of the object, using controls in the Limits group of the Parameters rollout. The limits restrict the stretch effect along the positive and negative Stretch Axis as measured from the modifier's center.

**Limit Effect** Limits the stretch effect. When Limit Effect is turned off, values in the Upper and Lower Limit fields are ignored.

**Upper Limit** Sets the boundary of the stretch effect along the positive Stretch Axis. The Upper Limit can be 0 or any positive number.

**Lower Limit** Sets the boundary of the stretch effect along the negative Stretch Axis. The Lower Limit can be 0 or any negative number.

Limiting the effect of Stretch

Click Sub-Object and move the modifier's center to change the location of the limited stretch areas. The Upper and Lower Limit boundaries move with the modifier center to maintain their specified distances.
Effects of moving the Stretch center

**NOTE** You can also limit the stretch effect by using an Edit or Select modifier, defining a sub-object selection, and then applying Stretch. If the modifier’s Sub-Object button is active, only the selected sub-objects will be stretched.

### Subdivide Modifier (Object Space)

Select an object > Modify panel > Modifier List > Object-Space Modifiers > Subdivide

Make a selection. > Modifiers menu > Radiosity Modifiers > Subdivide

The Subdivide modifier provides an algorithm for creating meshes used for radiosity on page 6615 processing. Processing radiosity requires meshes that have elements shaped as close as possible to equilateral triangles. The density of the mesh also needs to be considered in determining the resolution of the lighting details that need to be captured. The denser the mesh is, the finer the lighting detail and accuracy will be. The trade-off is a larger memory requirement and slower rendering times. The Subdivide modifier works on a whole object and does not work on selected faces in a mesh.
Subdivide modifier breaks flat surfaces into meshes.

Although it is primarily developed for increasing the quality of radiosity solutions, the Subdivide modifier can also be used by any application that requires well-formed meshes. For example, irregular mesh elements generated for Terrain on page 730 compound objects can be improved.

The modifier has world space and object space variants. In the world space modifier the size limit is on the mesh after it is transformed into world space coordinates. The object space modifier limits the size in object space coordinates.

**NOTE** Typically, the Subdivide modifier is applied automatically to objects in the scene when a radiosity solution is processed. Meshing parameters can be set on a global basis in the radiosity control panel on page 6634 or for individual objects in the Object Properties dialog on page 283.

**TIP** When you are satisfied with the subdivision settings on one object, you can drag the modifier to other objects to propagate it.
Interface

Size Controls the size of triangles in the subdivided mesh. The length of the longest edge of any triangle will not exceed the square root of 2 times the size in the Subdivide modifier. The square root of 2 factor is used, so that a square whose edges are the size will not be subdivided.

Update group

The radio buttons in the Update group control when the meshing is done.

Automatic Updates immediately when changes are made to the controls or the mesh.

Render Updates only for rendering.

Manual Updates only when Update Now is pressed. Subdivision can be interrupted using the Esc key. If the subdivision is interrupted the Update mode is changed to Manual.

Update Now Updates the mesh when Manual is turned on.

Display Subdivision Controls whether all of the triangles are visible, or only the edges where face properties are changing. Allows you to reduce the visible triangles in the scene if it appears cluttered.
Substitute Modifier

Make a selection. > Modify panel > Modifier List > Object-Space Modifiers > Substitute

Typically, designers use two-dimensional shapes to represent objects, such as furniture, in their AutoCAD designs. However, when they link their DWG files on page 8556 into 3ds Max for visualization, they want to see how the objects will look in their design.

The Substitute modifier lets you quickly replace one or more objects with another in the viewports or at render time. The substitute object can be instanced from the current scene or can be referenced from an external file.
The Substitute modifier replaces the 2D objects with their 3D counterparts.

To get rid of the substitute object, simply remove the modifier from the stack. This frees up the memory required to store it.

**TIP** When you file link to a DWG file, the file is imported to 3ds Max as groups of VIZBlocks on page 8758. If the pivot points of the VIZBlock and the substituted geometry do not match, you may not obtain the desired results. Adjust the pivot point of the VIZBlock object using the Adjust Geometry button to align the substituted geometry correctly.

**See also:**
- XRef Objects on page 7450
- XRef Scene on page 7477

**Procedures**

To use an object from the current scene as a substitute:

1. Select an object, and then apply the Substitute modifier.
2 Click Pick Scene Object, and then in the viewport, select an object to substitute for the selection.
   Alternatively, click the ... button to the right of Pick Scene Object and select an object from the dialog that is displayed.
   The original object is replaced by an instance of the substitute object.

3 To see the original object in the viewport, turn off In Viewport. To see the original object in the final rendering, turn off In Render. To permanently disable the substitution, delete the modifier.

To use an externally referenced object as a substitute:

1 Select an object, and then apply the Substitute modifier.

2 Click Select XRef Object.

3 Use the Open File dialog to designate the file that contains the substitute object you want to use.

4 Use the XRef Merge dialog on page 7471 to designate the object to use as a substitute.
   The original object is replaced by an instance of the substitute object.
   To see the original object in the viewport, turn off Display group > In Viewport. To see the original object in the final rendering, turn off Display group > In Render. To permanently disable the substitution, delete the modifier.

Interface

Modifier Stack

Substitute Object  At this sub-object level, you can transform the substitute object without affecting the original, changing the offset distance between them. Otherwise, transforming the substitute object affects both equally.
Parameters rollout

- Display Parameters

  - Display
    - In Viewport
    - In Render

Object:

- Foliage01

Type:

Substitute Assignment

- Pick Scene Object
- Select XRef Object...

- Retain Local Rotation
- Retain Local Scale

Display group

In Viewport Replaces the original object with the substitute in the viewports.

In Render Replaces the original object with the substitute when you render the scene.

Object This editable text field displays the name of the substitute object and lets you rename it.

NOTE The name, if changed, appears only on the Modify panel at the current stack level. That is, the name is local to the current application of the Substitute modifier.

Type (label) Displays the type of object used as a substitute. If you use a scene object, the type is shown as Instance. If you use an XRef object, the type is shown as XRef Object. Appears only after you designate a substitute object.
Substitute Assignment group

Pick Scene Object Lets you choose an object from the current scene to be instanced as a substitute for the selected object. Click Pick Scene Object, and then select the object from a viewport to use as a substitute. If In Viewport is on and Retain Current Position is off (the default settings), an instance of the substitute object appears in the place of the original object. The mouse cursor changes to a plus sign (+) when over an object that can be used as a substitute. You cannot use an object to which the Substitute modifier is applied as a substitute object.

Use the button labeled "..." to the right of Pick Scene Object to choose a substitute object using the Select Substitute Object dialog, which works like the Select From Scene dialog on page 206. In the dialog’s list window, highlight the object to use as a substitute, and then click Select.

Select XRef Object Lets you specify an object to be instanced from an external scene file as the substitute. Click Select XRef Object, and then, in the Open File dialog, open the file containing the substitute object. On the XRef Merge dialog on page 7471, select the substitute object and then click OK. Objects to which the Substitute modifier is applied don't appear in the list.

NOTE Because the object used as a substitute is referenced from an external file, any changes to the object in that file apply to the substitute after reloading. For example, if you apply a Bend modifier to the substitute object in the external file, then the next time you load the file containing the object with the Substitute modifier, it appears bent.

Retain Local Rotation/Scale When on, rotates or scales the new object instance in the same place as the substitute object you select. In this case, the two objects coincide in space, and you must move one to see both. When off, 3ds Max positions the instanced substitute object in the same place as the object containing the Substitute modifier.

You must specify the Retain Local Rotation/Scale setting before designating the substitute object. Changing this setting afterward has no effect.

Surface Modifier

Select a spline object. > Modify panel > Modifier List > Object-Space Modifiers > Surface

Select a spline object. > Modifiers menu > Patch/Spline Editing > Surface

Procedures on page 1770 Interface on page 1773
The Surface modifier generates a patch surface based on the contours of a spline network. A patch is created wherever the segments of the interwoven splines form a three- or four-sided polygon. The Surface modifier and the CrossSection modifier, taken together, are referred to as Surface Tools. They allow you to create complex or organic surfaces, like the fuselage of a plane, or a three-dimensional character.

Applying the Surface modifier to create a patch surface.

The CrossSection modifier on page 1299 can be applied before the Surface modifier to connect splines representing cross-sections. Once the basic spline network is created and the Surface modifier is applied, the model can be adjusted by editing the splines using an Edit Spline modifier below the Surface modifier in the modifier stack. Since the Surface modifier creates a Patch surface, further refinements can be made to the patch model by adding an Edit Patch modifier above the Surface modifier.

The bulk of the work in using Surface tools to model lies in creating and editing splines in an Editable Spline or Edit Spline modifier. One of the benefits to modeling using splines and Surface Tools is the ease of editing the model. At almost any stage of modeling, you can add a nostril, ear, limb or body by simply adding splines. This lends itself to a free-form approach to organic modeling.
modeling: you have a mental image of what you want, then you create and edit the spline network until you are satisfied.

NOTE 3ds Max offers a simplified workflow for this modeling technique, using Edit/Editable Spline and the Edit Patch modifier. For details, see To create a patch object using the Cross Section and Spline Surface tools: on page 1330.

Surface Modifier Basics

1. Create a spline object.

2. Make sure that the Spline vertices form valid three-sided or four-sided, closed regions. Vertices on splines that cross one another should be coincident.
   
   To make spline vertices coincident, drag vertices over each other with 3D Snap turned on. 3D Snap must have the Vertex or End Point option turned on. With 3D Snap turned on, you can snap to vertices on existing splines as you create new splines. You can also select vertices and use the Fuse option in an Editable Spline to make vertices co-incident.

3. Use the CrossSection modifier to connect spline cross-sections, unless you plan on manually creating the splines that connect the model’s cross-sections.

4. Apply the Surface modifier, then adjust the weld threshold to generate a patch object. Ideally all spline vertices that will form a patch surface are coincident; the Threshold parameter allows patch creation even if vertices are not quite coincident.

5. Optionally, add an Edit Patch modifier to edit the patch surface.

TIP Make a reference copy of the spline object, then add the Surface modifier to the copy and edit the original. As you edit the original spline object, patches appear on the reference copy as splines form three-or four-sided shapes. This allows you to view a shaded surface as you model.

You can take this a step further and add a Mirror modifier to the reference copy. As you create splines for one side of a head or body, the reference copy displays an entire model.
Modeling with Surface Tools

There are two primary methods of using the Surface modifier to create patch models.

- Create splines that represent a model’s cross sections, add the CrossSection modifier to connect the cross sections, and apply the Surface modifier to create the patch surface. This approach works for models like the body of an airplane. Alternatively, use the editable spline Cross Section function on page 633 to connect the cross sections, and then use the editable patch Spline Surface tools on page 1331 to create the surface.

- Create a network of splines manually, and then apply the Surface modifier or editable patch Spline Surface tools to create the patch surface. This approach works for modeling a face or body of a character.

Modeling Examples
Scooter: Splines form cross sections of the body

One method of using Surface Tools is to create splines that represent a model's cross sections, then the CrossSection and Surface modifiers are applied to create the patch surface.
Two intersecting texture-mapped polygons are used as a reference to create a network of splines manually. Drawing lines on the physical sculpture is used as an added visual aid to position the splines in this case. The CrossSection modifier is not necessary if you create the spline network manually.

As the spline network is edited, the patch surface of the reference copy is updated dynamically. This allows you to view a shaded patch model as you manipulate the spline network, any surface anomalies can be spotted and corrected.
Sequence of images showing the spline network, the patches created by the Surface modifier, and a shaded view of an alien character.

**Additional Details**

- Splines are initially created using the tools in Create panel > Shapes > Splines > Object Type rollout, such as Line on page 584, Circle on page 590, Arc on page 592, and Section on page 607. Splines can also be created using the Create Line command in an Editable Spline or and Edit Spline modifier.
Splines are edited by applying an Edit Spline modifier to the selected spline object or editing parameters in an Editable Spline. Editing splines changes the patch surface created by the Surface modifier.

To add splines to a spline object, use the Attach command in the Edit Spline modifier.

Within a spline object, splines need not be continuous. A spline object may consist of ten splines, for example. As long as the spline vertices are coincident, or close enough for the Threshold parameter in the Surface modifier to weld them together, a surface will be generated.

**Procedures**

**Example: Understanding valid splines:**

1. In the Top viewport, use Create panel > Shape > NGon to create three NGons: a three-sided, four-sided, and five-sided NGon, each about 100 units wide.

2. Make sure that all the splines form one object. Do this by applying an Edit Spline modifier to one of the NGons and using Attach to add the remaining NGon objects.
3 Choose Modifiers menu > Patch/Spline Editing > Surface from the Modifier List.

Notice that the three- and four-sided splines formed patches but the five-sided NGon did not. The five-sided spline does not form a three- or four-sided closed region. To make it a valid spline, a line must bisect the NGon to form a three- and four-sided region.

4 In the stack display, choose the Edit Spline modifier again. Turn on Create Line on the Geometry rollout, and create a line that bisects the five-sided NGon.

The start and end points of the line should overlap the vertices on the NGon. Being exact is not critical; the Threshold parameter fuses spline vertices based on their proximity.
In the stack display, choose the Surface modifier again. Now the five-sided NGon is a patch object, consisting of a quad patch and a tri patch.

NOTE If the spline object did not turn into a patch, increase the Surface modifier's Threshold parameter until the patches appear.

Example continued: Adjusting the shape of the spline:

1. In the stack display, expand the Edit Spline modifier's hierarchy, and choose the Vertex sub-object level.

2. In the Top viewport, select the top vertex of the five-sided NGon. Two vector handles are displayed. These handles can be moved on any axis.

3. Turn on Select and Move on the toolbar, then drag the handles around in the Top viewport. The shape of the spline changes.

4. Below the stack display, turn on the Show End Result On/Off Toggle button. The patch changes shape to fit the spline.
Interface

Parameters

- Spline Options
  - Threshold: 1.0
  - Flip Normals
  - Remove interior patches
  - Use only selected segs.

- Patch Topology
  - Steps: 5
Spline Options group

**Threshold** Determines the overall distance that is used to weld the vertices of the spline object. All vertices/vectors within the threshold of each other are treated as one. Threshold uses units set in the [Units Setup dialog](page 8366) on page 8366.

**NOTE** Spline control handles are also treated as vertices, so setting high Threshold levels can produce unexpected results.

**Flip Normals** Flips the normal direction of the patch surface.

**Remove Interior Patches** Removes interior faces of an object that you would not normally see. These are the faces created within the caps or other interior patches of the same type of a closed polygon.

**Use only selected segs** Only segments selected in the Edit Spline modifier will be used by the Surface modifier to create patches.

**NOTE** Segment Sub-Object does not have to be left on in the Edit Spline modifier.

Patch Topology group

**Steps** The steps field spinner determines how many steps are used between each vertex. The higher the step count, the smoother the curve you will get between vertices.

SurfDeform Modifier (Object Space)

Select an object. > Modify panel > Modifiers List > Object–Space Modifiers > SurfDeform

Select an object. > Modify panel > Modifiers List > World–Space Modifiers > SurfDeform

Select an object. > Modifiers menu > Animation Modifiers > SurfDeform

Select an object. > Modifiers menu > Animation Modifiers > SurfDeform (WSM)

The SurfDeform modifier works the same way as the PatchDeform modifier on page 1567, except that it uses a NURBS Point or CV surface instead of a patch surface to apply surface deformation.
SurfDeform shapes how the snake rests.

Procedures

To use the SurfDeform modifier:

1. Select an object.

2. From the Modify panel > Modifier List, choose Object-Space Modifiers > SurfDeform.

3. On the Parameters rollout, click Pick Surface.

4. Select a NURBS Point or CV surface.

5. Deform the object by adjusting the controls in the Surface Deform group.
Interface

See PatchDeform modifier on page 1567 for a description of the user interface.

### Sweep Modifier

Modify panel > Select a 2D shape. > Modifier List > Sweep
Select a 2D shape. > Modifiers menu > Patch/Spline Editing > Sweep

The Sweep modifier is used to extrude a cross-section along an underlying spline or NURBS curve path. It is similar to the Loft compound object but is a more efficient method. The Sweep modifier allows you to work with a series of pre-made cross-sections such as angles, channels and wide flanges. You can also use your own splines or NURBS curves as custom sections that you create in 3ds Max or import from other MAX files.

**NOTE** This modifier is similar to the Extrude modifier in that once the Sweep is applied to a spline, the end result is a 3D mesh object. Both sections and paths can contain multiple splines or multiple NURBS curves.

This modifier is very useful for creating structural steel details, molding details, or in any situation where you need to extrude a section along a spline.
Examples of extrusions created with the Sweep modifier

Procedures

To apply the Sweep modifier to a line:

1. Create a line in the perspective viewport.
2. Apply the Sweep modifier to the line.
   The line takes on the shape of an angled extrusion.
3. Open the Built-In Section list and choose a different section.
   The line now has the new section swept along its length.

To use a custom section with the Sweep modifier:

1. Create a line and a six sided N-Gon in the perspective viewport.
2. Apply the Sweep modifier to the line.
   The line takes on the shape of an angled extrusion.
3. Click the Use Custom Section radio button.
The line displays as a line again.

4 Click the Pick button in the Custom Section Types group and choose the NGon in the viewport.
The hexagonal shape is swept along the line's length.

**NOTE** If you find that you need to rescale the Custom Section shape, the effects of using a transform like Select and Squash or Non-Uniform Scale will not be reflected when swept. You need to apply an XForm modifier on page 2010 to the section and then rescale the XForm modifier’s gizmo.

---

**Interface**

**Section Type rollout**

![Section Type rollout](image)

**Use Built-In Section** Choose this to use one of the included stock sections.
Built-In Section group

Built-In Section list Clicking the arrow button for this list displays common structural sections.

- **Angle section** Sweeps a structural angle section along the spline. Default section=Angle.
- **Bar section** Sweeps a 2D rectangular section along the spline.
- **Channel section** Sweeps a structural channel section along the spline.
- **Cylinder section** Sweeps a solid 2D circle section along the spline.
- **Half Round section** This section produces a half round extrusion along the spline.
- **Pipe section** Sweeps a circular hollow tube section along the spline.
- **Quarter Round section** Useful for molding details; this section produces a quarter round extrusion along the spline.
- **Tee section** Sweeps a structural tee section along the spline.
Tube section  Based on a square, this sweeps a hollow tube section along the spline. Similar to the Pipe section.

Wide Flange section  Sweeps a structural wide flange section along the spline.

Use Custom Section  Choose this if you've created your own section or there is another shape in the current scene or in another MAX file that you'd like to use as your section.

NOTE  Using a 2D shape as the Sweep modifier's custom section will yield the most predictable results. If using a 3D shape as the custom section, for the most predictable results the base object should be a straight line or smooth path like a circle or an arc. The same applies to custom sections made up of multiple splines. You'll get the best results attained by insuring that all vertices in all the shapes are coplanar.

Custom Section Types group

Section  Displays the name of the custom shape you've selected. This area is blank until you select a custom shape.

NOTE  You can switch from a custom section to a built-in section and back without having to pick the custom-section shape again from the viewports.

Pick  If the custom shape you want to use is visible in the viewport, click the Pick button and then pick the shape directly from the scene.

Pick Shape  Click the Pick Shape button to open the Pick Shape dialog on page 1796. This dialog shows only valid shapes that are currently in the scene.

Extract  Lets you create a new shape in the scene that is either a copy, instance, or reference of the current custom section. Opens the Extract Shape dialog on page 1798.

Merge From File  Lets you choose a section that is stored in another MAX file. Opens the Merge File dialog on page 1799.

NOTE  When you use the Merge from File option, you will not be able to Undo your work.

Move  Sweeps the custom section along the specified spline. Unlike the Instance, Copy and Reference switches, the selected section is moved to the
spline. Editing the original shape in the viewports has no effect on the Sweep mesh.

**Copy** Sweeps a copy of the selected section along the specified spline.

**Instance** Sweeps an instance on page 8611 of the selected section to the specified spline.

**Reference** Sweeps a reference on page 8699 of the selected section along the specified spline.

**NOTE** When using Instance or Reference, adding modifiers to or editing the original section in the viewports will change the Sweep mesh.

**Interpolation rollout (Sweep modifier)**

The controls in the Interpolation rollout of the Sweep modifier work exactly as they do for any other spline. However, the controls affect only the built-in section you've chosen, not the spline that the section is swept along.

**NOTE** If you want to change the interpolation settings of the underlying spline path, you need to select the path object in the modifier stack.

In general, all spline curves are divided into small straight lines that approximate a true curve. The number of divisions between each vertex on the spline are called steps. The more steps used, the smoother the curve appears.

**NOTE** The Interpolation rollout is only active when built-in sections are used.
Left: The quarter-round section is set to zero steps.
Right: The same section on the right is set to four steps.

**Steps** Sets the number of divisions, or steps, 3ds Max uses between each built-in section’s vertices. Splines with tight curves require many steps to look smooth while gentle curves require fewer steps. Range=0 to 100.

Splines steps can be either adaptive or manually specified. The method used is set by the state of the Adaptive switch. The main use for manual interpolation is to create splines for morphing or other operations where you must have exact control over the number of vertices created.

**Optimize** When on, removes unneeded steps from straight segments in the spline. Default=on.

**NOTE** Optimize is not available when Adaptive is on.

Left: Optimize is on for the left-hand sweep.
Right: Optimize is off for the right-hand sweep.
**Adaptive** When on, automatically sets the number of steps for each spline to produce a smooth curve. Straight segments always receive 0 steps. When off, enables manual interpolation control using Optimize and Steps. Default=off.

**Parameters rollout**

The Parameters rollout is context-sensitive and displays different settings depending upon the built-in section you've chosen to sweep along a spline. For example, more complex sections such as the Angle have seven settings that you can change whereas the Quarter-Round has only one setting.

**Parameters rollout: Angle**

![Parameters rollout: Angle](image)

**Length** Controls the height of the vertical leg of the angle section. Default=6.0.

**Width** Controls the width of the horizontal leg of the angle section. Default=4.0.

**Thickness** Controls the thickness of both legs of the angle. Default=0.5.

**Sync Corner Fillets** When turned on, Corner Radius 1 controls the radius of both the interior and exterior corners between the vertical and horizontal legs. It also maintains the thickness of the section. Default=off.

**Corner Radius 1** Controls the exterior radius between the vertical and horizontal legs of the angle section. Default=0.0.

**Corner Radius 2** Controls the interior radius between the vertical and horizontal legs of the angle section. Default=0.5.
**Edge Radii** Controls the interior radius at the outermost edges of the vertical and horizontal legs. Default=0.0.

**NOTE** Be cautious when adjusting these settings. There are no constraining relationships between them. Therefore, it's possible to set an inside radius (Corner Radius 2) that is greater than the length or width of the legs of the angle.

### Parameters rollout: Bar

![Bar parameters rollout]

**Length** Controls the height of the bar section. Default=6.0.

**Width** Controls the width of the bar section. Default=6.0.

**Corner Radius** Controls the radius of all four corners of the section. Default=0.0.

### Parameters rollout: Channel

![Channel parameters rollout]

**Length** Controls the height of the bar section. Default=12.0.

**Width** Controls the width of the bar section. Default=4.0.

**Thickness** Controls the thickness of the channel. Default=0.5.

**Sync Corner Fillets** Synchronizes the corner fillets.

**Corner Radius 1** Controls the radius of the first corner. Default=0.0.

**Corner Radius 2** Controls the radius of the second corner. Default=0.5.
**Length** Controls the height of the vertical web of the channel section. Default=12.0.

**Width** Controls the width of the top and bottom horizontal legs of the channel section. Default=4.0.

**Thickness** Controls the thickness of both legs of the channel. Default=0.5.

**Sync Corner Fillets** When on, Corner Radius 1 controls the radius of both the interior and exterior corners between the vertical web and horizontal legs. It also maintains the thickness of the section. Default=off.

**Corner Radius 1** Controls the exterior radius between the vertical web and horizontal legs of the channel. Default=0.0.

**Corner Radius 2** Controls the interior radius between the vertical web and horizontal legs of the channel. Default=0.5.

**NOTE** Be cautious when adjusting these settings. There are no constraining relationships between them. Therefore, it's possible to set an inside radius (Corner Radius 2) that is greater than the length of the web or width of the legs.

### Parameters rollout: Cylinder

![Parameters rollout: Cylinder]

**Radius** Controls the radius of the cylinder section. Default=3.0.

### Parameters rollout: Half-Round

![Parameters rollout: Half-Round]

**Radius** Controls the radius of the half round section. Default=3.0.
**Parameters rollout: Pipe**

Radius  Controls the exterior radius of the pipe section. Default=3.0.
Thickness  Controls the thickness of the wall of the pipe. Default=0.5.

**Parameters rollout: Quarter-Round**

Radius  Controls the radius of the quarter round section. Default=3.0.

**Parameters rollout: Tee**

Length  Controls the height of the vertical web of the tee section. Default=12.0.
Width  Controls the width of the flange crossing the tee section. Default=6.0.
Thickness  Controls the thickness of the web and flange. Default=0.5.
Corner Radius  Controls the radius of the two interior corners between the vertical web and horizontal flange of the section. Default=0.5.
NOTE Be cautious when adjusting these settings. There are no constraining relationships between them. Therefore, it's possible to set a radius (Corner Radius) that is greater than the length of the web or width of the flange.

Parameters rollout: Tube

**Length** Controls the height of the tube section. Default=6.0.

**Width** Controls the width of the tube section. Default=6.0.

**Thickness** Controls the thickness of the walls of the tube. Default=0.5.

**Sync Corner Fillets** When turned on, Corner Radius 1 controls the radius of both the interior and exterior corners of the tube. It also maintains the thickness of the section. Default=on.

**Corner Radius 1** Controls the radius of all four interior and exterior corners of the section. Default=0.8.

If Sync Corner Fillets is turned off, Corner Radius 1 controls the radius of the four exterior corners of the tube.

**Corner Radius 2** Controls the radius of the four interior corners of the tube. Default=0.0.

Corner Radius 2 is only available when Sync Corner Fillets is turned off.

NOTE Take care when adjusting these settings. There are no constraining relationships between them. Therefore, it's possible to set an inside radius (Corner Radius 2) that is greater than the length and width of the sides.
Parameters rollout: Wide Flange

**Length** Controls the height of the vertical web of the wide flange section. Default=14.0.

**Width** Controls the width of the horizontal flanges crossing the section. Default=8.0.

**Thickness** Controls the thickness of the web and flanges. Default=0.5.

**Corner Radius** Controls the radius of the four interior corners between the vertical web and horizontal flanges. Default=0.5.

**NOTE** Be cautious when adjusting these settings. There are no constraining relationships between them. Therefore, it's possible to set a radius (Corner Radius) that is greater than the length of the web or width of the flanges.
Mirror On XZ Plane When turned on, the section is flipped vertically in relation to the spline to which the Sweep modifier is applied. Default=off.
Mirror On XY Plane  When turned on, the section is flipped horizontally in relation to the spline to which the Sweep modifier is applied. Default=off.

X Offset  Lets you shift the horizontal position of the section relative to the underlying spline.
Left: The section is in the default position.

Right: The section is offset –10 relative to the underlying spline path (red).

**Y Offset** Lets you shift the vertical position of the section relative to the underlying spline.

---

**NOTE** The X and Y Offsets let you fine tune the section position while the Pivot Alignment settings allow for a quick initial adjustment.

**Angle** Allows you to rotate the section relative to the plane on which the underlying spline is located.
Left: The section is in the default position.

Right: The section is rotated 30 degrees.

**Smooth Section** Provides a smooth surface around the perimeter of the section that is swept along the underlying spline. Default=on.

**Smooth Path** Provides a smooth surface along the length of the underlying spline. This type of smoothing is useful when for curved paths. Default=off.
Left: Smoothing the path

Right: Smoothing the section

Rear: Smoothing both path and section

**Pivot Alignment** This is 2D grid that helps you align the section to the underlying spline path. Selecting one of the nine buttons shifts the section's pivot around the spline path.

**NOTE** When none of the Pivot Alignment buttons is depressed the pivot point of the section is used as the alignment point.

**Align Pivot** When turned on, a 3D representation of the Pivot Alignment grid appears in the viewport. You only see the 3x3 alignment grid, the section and the underlying spline path. Once you're satisfied with the alignment, turn off the Align Pivot button or right-click to see the sweep.
Align Pivot grid showing control points (in orange) superimposed over a duplicate sweep.

**Banking** When on, sections rotate about the spline path whenever the path bends and changes height in the path's local Z axis. Banking is ignored if the spline path is 2D. When off, shapes do not rotate about their Z axis as they traverse a 3D path. Default=on.

**Union Intersections** If working with multiple intersecting splines, like a grid, turn this switch on to produce cleaner intersections with fewer artifacts.

**NOTE** Union Intersections takes additional time to compute the intersections, so leave this switch off if you don’t have intersecting splines. Furthermore, this setting will only calculate intersections of separate splines contained in one shape object. So a figure X (separate, intersecting splines) will be properly intersected, but a figure 8 (a single, self-intersecting spline) will not.

**Gen. Mapping Coords** Applies mapping coordinates to the extruded object. Default=off.
**Real-World Map Size** Controls the scaling method used for texture mapped materials that are applied to the object. The scaling values are controlled by the Use Real-World Scale settings found in the applied material's Coordinates rollout on page 6201. Default=on.

**Generate Mapping IDs** Assigns different material IDs to the sides and the caps of the sweep. Specifically, if both Use Section IDs and Use Path IDs are both turned off the sides receive ID 3, the front cap receives ID 1, and the rear cap receives ID 2. Default=on.

**Use Section IDs** Uses the material ID values assigned to segments of the section that is swept along the underlying spline on page 577 or NURBS on page 2416 curve. Default=on.

By applying an Edit Spline modifier on page 1424 to a Custom Section, different material IDs can be assigned to each segment that makes up the section.

**NOTE** Built-in sections do not benefit from the Use Section IDs switch.

**Use Path IDs** Uses the material ID values assigned to segments of the underlying spline or curve sub-objects in the underlying curve.

By applying an Edit Spline modifier to the underlying spline, each segment can be assigned its own material ID.

**NOTE** Use Section IDs and Use Path IDs does not control the material IDs of the front and rear caps of the sweep.

![Image](image_url)

Left: Materials set by path IDs
Pick Shape Dialog (Sweep Modifier)

Select a shape that already has a Sweep modifier applied. > Modify Panel > Section Type rollout > Turn on Use Custom Section > Click Pick Shape.

The Pick Shape dialog is displayed when you select a custom shape in the scene. This shape can be any of the splines, extended splines or NURBS curves.

Procedures

To pick a custom section using the Pick Shape dialog:

1. In the viewport, pick a shape you want to use as the underlying path of the sweep.
2. From the Modifiers menu, open the Patch/Spline Editing menu and choose Sweep.
3. On the Modify panel, turn on Use Custom Section in the Section Types rollout.
4. Click the Pick Shape button.
   The Pick Shape dialog is displayed.
5. Select a shape in the list and click the Pick button.
If the scene contains multiple shapes, you can choose only one shape to be swept along the underlying spline in your scene.

**All/None/Invert** These buttons are unavailable in the Pick Shape dialog.

**Display Subtree** Displays the shapes in the list in an indented format. Turn this switch off to activate the Sort group options.

**Select Subtree** Unavailable in the Pick Shape dialog.

**Case Sensitive** When on, distinguishes between upper case and lower case for item names.
**Sort group**

Options allow you to sort the list on the left. When Display Subtree is on, these options are not available.

**Alphabetical** Sorts from A at the top to Z at the bottom.

**By Type** While this switch is available, it has no effect because only shapes are listed in the Pick Shape dialog.

**By Color** Sorts by object wireframe color. The sorting order is arbitrary; shapes of the same color are grouped together.

**By Size** This switch is available but has no effect on sorting.

**List Types group**

Because this dialog is specifically designed to work with the Sweep modifier, the List Type group is locked to only display Shapes. Shapes is the only switch in this group that affects what is displayed.

**All/None/Invert** These buttons alter the pattern of activation of the List Types options.

**Selection Sets group**

The Selection Sets group is unavailable in the Pick Shape dialog.

**Extract Shape Dialog (Sweep Modifier)**

Select a shape that already has a Sweep modifier using a Custom Section applied. > Modify Panel > Section Type rollout > Click Extract.

The Extract functionality allows you to recover custom cross-sections that may have been deleted from the scene. As long as you have a sweep in the scene that uses the deleted shape as a custom cross-section, Extract can be used to restore it to the scene.

In a large scene that has many objects and shapes, you can also use Extract if you want to quickly duplicate a section used by the sweep instead of searching for the original shape you used as the section.
Procedures

To extract a section from a sweep:

1. In the viewport, pick a swept shape.

2. Open the Modify panel and click the Extract button from the Custom Section Types group of the Section Types rollout. The Extract Shapes dialog is displayed.

3. Enter a new name for the extracted section if you want.

4. Specify the type of cloned shape you want extracted; a copy, an instance or a reference.

5. Click OK.

Interface

Name
This field shows the default name that will be given to the extracted section. By default, it always has the naming convention of Sweep_ShapeName01, Sweep_ShapeName02, etc.

For example, if your missing section was named Roman-Ogee, the extracted shape will be named Sweep_Roman-Ogee01.

Copy
Places a copy of the extracted section at the global origin (0,0,0).

Instance
Places an instance of the extracted section at the global origin.

Reference
Places a reference of the extracted section at the global origin.

Merge File (Sweep Modifier)

Select a shape that already has a Sweep modifier using a Custom Section applied. > Modify Panel > Section Type rollout > Click Merge From File.
The Merge File dialog for the Sweep modifier appears when you click the Merge From File button. Merge From File allows you to bring shapes or section profiles from other scene files into the current scene.

**Automatic Unit Conversion**

When Respect System Units in Files is turned on in the Units Setup dialog on page 8366 in the System Unit Scale group, merged objects from a file with a different scene-unit scale are scaled to maintain their correct size in the new scene.

**NOTE** If Respect System Units is off (which is not recommended), a 10-foot square tube that was created in a 1 unit = 1 foot scene becomes a 10-inch square tube in a 1 unit = 1 inch scene.

**Resolving Conflicts When Merged Shapes Have the Same Name**

When an incoming shape has the same name as a shape in the scene, an alert gives you the following options:

- **Merge** Merges the incoming shape using the name in the field at the right. To avoid having two shapes with the same name, type a new name before proceeding.

- **Skip** This button is unavailable when Merge From File is used in the Sweep modifier.

- **Delete Old** This button is unavailable when Merge From File is used in the Sweep modifier.

- **Auto Rename** The merged shape's name is left intact except it is given a numeric suffix that is one number higher than any duplicates found in the scene.

- **Cancel** Cancels the merge operation.

**Interface**

In the standard file selector dialog, select the scene file to merge. You can only merge MAX files.
This dialog has the same functionality as the Merge File dialog on page 7572 that appears when you choose Application menu on page 7989 > Import > Merge with one minor exception.

If you choose a MAX file that does not include a valid 2D shape that can be used as a custom section, you will receive a warning.

Once the scene file is selected, you can choose the shape or section profile that you want the Sweep modifier to use.
If the scene file you selected contains multiple shapes, keep in mind that you can only choose one shape to be swept along the spline in your current scene.

**All/None/Invert** These buttons are unavailable when Merge From File is used in the Sweep modifier.

**Display Subtree** Displays the shapes in the list in an indented format. Turn off this option to activate the Sort group options.

**Select Subtree** This switch is unavailable when Merge From File is used in the Sweep modifier.

**Case Sensitive** Distinguishes between uppercase and lowercase for item names.
Sort group

Options allow you to sort the list on the left. If the Display Subtree switch is on, these options are not available.

Alphabetical  Sorts from A at the top to Z at the bottom.

By Type  This switch is unavailable when Merge From File is used in the Sweep modifier.

By Color  Sorts by object wireframe color.

List Types group

Because this dialog is specifically designed to work with the Sweep modifier, the List Type group is locked to display only Shapes. None of the switches or buttons in this group can be activated.

Symmetry Modifier

Modify panel > Make a selection. > Modifier List > Symmetry

Make a selection. > Modifiers menu > Mesh Editing > Symmetry

The Symmetry modifier is especially useful when modeling characters or building ships or aircraft

This modifier is unique in that it allows you to perform three common modeling tasks:

- Mirror a mesh about the X, Y, or Z plane.
- Slice a mesh, removing parts if necessary.
- Automatically weld vertices along a common seam.
Examples of using Symmetry with different mirror axes or by moving the mirror gizmo

You can apply the Symmetry modifier to any geometry, and you can animate the mirror or slicing effect by animating the modifier’s gizmo.

When the Symmetry modifier is applied to a mesh, any edits you make to the original half of the mesh below the Symmetry modifier in the stack also occur interactively to the other half. For an example, see the second procedure, below.

NOTE The Symmetry modifier converts patch and NURBS objects to mesh format in the modifier stack; editable poly and editable mesh objects remain in their original format.

Procedures

Example: To apply the Symmetry modifier to an object:

1. Create a teapot in the Perspective viewport.
2. Apply the Symmetry modifier.
   The teapot appears to have two spouts.
3 In the modifier stack, click the + button to see the Mirror gizmo, and then select Mirror.
   The mirror gizmo acts as a slice plane when it is within the boundaries of the object.

4 With Mirror Axis set to X, click and drag the mirror gizmo along the X axis.
   Dragging right slices more of the teapot until there is nothing visible. Dragging left causes a second teapot to appear. When the mirror gizmo is moved beyond the boundaries of the original mesh, it acts as a mirror plane showing you two complete teapots.

Example: To perform box modeling with the Symmetry modifier:

1 Create a box primitive in the Perspective viewport, and then convert it to Editable Poly or apply the Edit Poly modifier.
2 If necessary, press F4 to activate Edged Faces display mode in the Perspective viewport.
3 Apply the Symmetry modifier.
   Other than the new edge loop created by the modifier, the box's appearance doesn't change, because it's already symmetrical.
4 In the modifier stack, click the + button to see the Mirror gizmo, and then click Mirror.
5 In the Front viewport, with Mirror Axis set to X, drag the Mirror gizmo in either direction on the X axis.
   Only the left-hand box moves; this is the copy created by the Symmetry modifier.
6 Position the Mirror near the left side of the original box, so the two copies are merged.
7 In the modifier stack, go to the Edit/Editable Poly level and access the Vertex sub-object level.
   If you no longer see the Symmetry copy of the box, turn on Show End Result.
   With Show End Result on, you might see an orange wireframe “cage” that shows the edges of original object. This is on by default for editable poly objects, but off by default for the Edit Poly modifier. The Show Cage
toggle for editable poly objects is on the Subdivision Surface rollout, and for Edit Poly it's on the Edit Poly Mode rollout.

You can also see that only the vertices of the original object are visible; the vertices of the symmetry object can't be transformed directly.

8 Move one of the visible vertices on the right side of the box.
As you do so, its counterpart on the symmetry object moves symmetrically in real time.
As you can see, the Symmetry modifier not only creates a mirror image of an object for you, but also lets you manipulate both sides in tandem in an intuitive way.

9 Now move one of the vertices on the left side of the box, where it overlaps the symmetry box.
Because you're also moving its counterpart vertex, which is invisible, the apparent result is motion of the corresponding point on the plane of symmetry. This isn't as intuitive as moving a non-overlapping point, so for best results, position the Mirror gizmo so as to cause as little overlap as possible; that way you can edit the center vertices directly on the plane of symmetry.

Interface

Modifier Stack

Mirror The placement of the mirror gizmo delegates how the object will be affected by symmetry. You can move or rotate, as well as animate the gizmo.
For more information on the stack display, see Modifier Stack on page 8187.
Parameters rollout

Mirror Axis group

X, Y, Z Specify the axis about which the symmetry takes place. You can see the effect in the viewport as you select the axis.

Flip Turn on Flip if you want to flip the direction of the symmetry effect. Default=off.

Slice Along Mirror Turning on Slice Along Mirror causes the mirror gizmo to act as a slice plane when it is located inside the boundaries of a mesh. When the gizmo is outside the boundaries of a mesh, the symmetrical reflection is still treated as part of the originating mesh. If Slice Along Mirror is turned off, the symmetrical reflection is treated as a separate element of the originating mesh. Default=on.

Weld Seam Turning on Weld Seam assures that the vertices along the mirror axis will be automatically welded if they are within the Threshold. Default=on.

Threshold The value of the Threshold setting delegates how close vertices can be before being automatically welded together. Default=0.1.

NOTE Setting the Threshold value too high may result in some distortion of the mesh, especially when the mirror gizmo is outside the boundaries of the originating mesh.

Taper Modifier

Modify panel > Make a selection. > Modifier List > Object-Space Modifiers > Taper
Make a selection. > Modifiers menu > Parametric Deformers > Taper

The Taper modifier produces a tapered contour by scaling both ends of an object’s geometry; one end is scaled up, and the other is scaled down. You can control the amount and curve of the taper on two sets of axes. You can also limit the taper to a section of the geometry.

Examples of default tapers

Interface

Modifier Stack

Gizmo At this sub-object level, you can transform and animate the gizmo like any other object, altering the effect of the Taper modifier. Translating the
gizmo translates its center an equal distance. Rotating and scaling the gizmo takes place with respect to its center.

**Center** At this sub-object level, you can translate and animate the center, altering the Taper gizmo's shape, and thus the shape of the tapered object. For more information on the stack display, see [Modifier Stack](#) on page 8187.

Moving the modifier's center changes the gizmo shape.
Parameters rollout

The Taper modifier provides two sets of axes and a symmetry setting in the Taper Axis group box of the Parameters rollout. As with other modifiers, these axes refer to the Taper gizmo, not the object itself.

**Taper group**

*Amount*  The extent to which the ends are scaled. Amount is a relative value with a maximum of 10.

*Curve*  Applies a curvature to the sides of the Taper gizmo, thus affecting the shape of the tapered object. Positive values produce an outward curve along the tapered sides, negative values an inward curve. At 0, the sides are unchanged. Default=0.

**Taper Axis group**

*Primary*  The central axis or spine of the taper: X, Y, or Z. Default=Z.

*Effect*  The axis, or pair of axes, indicating the direction of the taper from the primary axis. The available choices are determined by the choice of primary axis. The effect axis can be either of the two remaining axes, or their
combination. If the primary axis is X, the effect axis can be Y, Z, or YZ. Default=XY.

**Symmetry** Produces a symmetrical taper around the primary axis. A taper is always symmetrical around the effect axis. Default=off.

Changing the effect axis changes the effects of the modifier.

**Limits group**

The taper offset is applied between the upper and lower limits. The surrounding geometry, while unaffected by the taper itself, is moved to keep the object intact.

**Limit Effect** Enables upper and lower limits for the taper effect.

**Upper Limit** Sets the upper limit boundaries in world units from the taper center point, beyond which the taper no longer affects the geometry.

**Lower Limit** Sets the lower limit boundaries in world units from the taper center point, beyond which the taper no longer affects the geometry.
Left: Limiting the effect of the taper.
Right: Using symmetry.

**Tessellate Modifier**

Modify panel > Make a selection. > Modifier List > Object-Space Modifiers > Tessellate

Make a selection. > Modifiers menu > Mesh Editing > Tessellate

The Tessellate modifier subdivides faces in the current selection. It’s particularly useful for smoothing curved surfaces for rendering, and creating additional mesh resolution for other modifiers to act on. If no sub-object selection has been passed up the stack, then the entire object is tessellated.

This modifier lets you tessellate polygonal faces; the tessellation available in an editable mesh on page 2216 does not (it works on faces, even at the Polygon selection level).
Top: Original mesh object
Lower left: Tessellation applied to polygonal facets
Lower right: Tessellation applied to triangular faces

**WARNING** Tessellating an object retains any UVW mapping that exists in the stack before the Tessellate modifier. However, in some cases, the mapping might be altered, depending on the type of mapping and the tessellation settings. Typically, this happens when the applied mapping uses extreme compound angles.
Interface

Parameters rollout

Operate On: Specifies whether to perform the tessellation on the triangular faces or on the polygonal facets (the areas bound by visible edges).

Faces Treats the selection as a set of triangular faces.

Polygons Divides the polygonal facets. For example, using the polygonal method on the side of a box results in cross-shaped edges using the Edge method, and X-shaped edges using the Face-Center method.

Edge Divides the face or polygon from its center to the middle of each edge. When applied to a triangular face, it also divides unselected faces that share edges with the selected faces.

Face-Center Select this to divide the face from the center to the vertex corners.

Tension Determines if the new faces are flat, concave, or convex after Edge tessellation. A positive value rounds faces by pushing vertices outward. A negative value creates concave faces by pulling vertices inward. A setting of 0 keeps the faces flat. Also works with the Edge/Polygon method. Default=25.
**Iterations group**

**Iterations** Specifies how many times the tessellation is applied. For example, setting Iterations to 2 is similar to clicking the Tessellation button twice in an editable mesh, except that you can easily back out at any time while using the Tessellate modifier. If you want more than four iterations, apply another Tessellate modifier.

**Update Options group**

**Always** Tessellation is updated whenever the base geometry changes.

**When Rendering** Tessellation is updated only when the object is rendered.

**Manually** Tessellation is updated only when the user clicks Update.

**Update** Click to update tessellation. Has no effect unless Manually is the active update option.

---

**Trim/Extend Modifier**

Select a shape. > Modify panel > Modifier List > Object-Space Modifiers > Trim/Extend

Select a shape. > Modifiers menu > Patch/Spline Editing > Trim/Extend

The Trim/Extend modifier is used primarily to clean up overlapping or open splines in a multi-spline shape so that lines meet at a single point. As with the Fillet/Chamfer modifier, this modifier operates on the splines at the sub-object level in the shape. When applied to a selection of multiple splines, Trim/Extend works as it does on a single spline.

To trim, you need intersecting splines. Click the portion of the spline you want to remove. The spline is searched along its length until it hits an intersecting spline, and deleted up to the intersection. If the section intersects at both ends, the entire section is deleted up to the two intersections. If the section is open on one end and intersects at the other, the entire section is deleted up to the intersection and the open end. If the section is not intersected, nothing happens.

To extend, you need an open spline. The end of the spline nearest the picked point is extended until it reaches an intersecting spline. If there is no intersecting spline, nothing happens. Curved splines extend in a direction tangent to the end of the spline. If the end of a spline lies directly on a
boundary (an intersecting spline), then it looks for an intersection further along.

NOTE As of version 3 of 3ds Max, Edit/Editable Spline on page 620 includes interactive trim/extend functions. The only reason to use this modifier is to apply it at a specific location on the stack.

Before and after initial use of Trim

Before and after second use of Trim on above spline

Before and after using Extend
Procedures

To trim a shape using the Trim/Extend modifier:

1. Create an open Line shape on page 584 in the form of roughly concentric overlapping circles.
2. Apply the Trim/Extend modifier.
3. Click Pick Locations.
4. Click the inner spline sections of the concentric shape to trim them away, or click the open spline segment to extend the spline.

Interface

Pick Locations Click to turn on Pick mode. While in this mode, the mouse cursor changes in appearance when over part of the spline that can be affected by the Trim/Extend modifier. Click to either trim or extend the spline, based on the settings below. Default=Auto.

Operation group

Specifies the type of operation that’s performed on the selected spline.

Auto When this is chosen, a Trim is first looked for and, if not found, an Extend is attempted. In most cases, a Trim will occur when Auto is chosen.
An Extend can occur, however, in cases where an open spline exists without intersecting other splines.

**Trim Only** Performs only trims. Turn on Pick Locations, and then click the spline section you want to trim.

**Extend Only** Performs only extends. Click Pick Locations, and then select the open spline section you want to extend.

**Infinite Boundaries** For the purposes of calculating intersections, turn this on to treat open splines as infinite in length. For example, this lets you trim one linear spline against the extended length of another line that it doesn’t actually intersect.

**NOTE** As the number of open splines in the shape increases, the chance of finding an intersection, when using Infinite Boundaries, increases as well. This can produce results you might not have expected because of projected spline intersections you hadn’t considered, particularly if you’re in Auto mode. For predictable results, avoid using Auto mode when using Infinite Boundaries.

**Intersection Projection group**

These options specify how the Trim and Extend functions determine a valid intersection.

**View** Projects the lines onto the active viewport, and judges the intersections accordingly. These are the intersections as you see them in the active viewport.

**Construction Plane** Projects the lines onto the current construction plane.

**None (3D)** Considers only true intersections as the splines exist in 3D space. They must physically intersect to be considered.

**TurboSmooth Modifier**

Make a selection. > Modify panel > Modifier List > Object-Space Modifiers > TurboSmooth

The TurboSmooth modifier, like MeshSmooth on page 1505, smoothes geometry in your scene.
The differences between the two are as follows:

- TurboSmooth is considerably faster and more memory-efficient than MeshSmooth. TurboSmooth also has an option for Explicit Normals, unavailable in MeshSmooth. See Explicit Normals on page 1824.

- TurboSmooth provides a limited subset of MeshSmooth functionality. In particular, TurboSmooth uses a single smoothing method (NURMS), can be applied only to an entire object, has no sub-object levels, and outputs a triangle-mesh object.

TurboSmooth lets you subdivide the geometry while interpolating the angles of new faces at corners and edges, and apply a single smoothing group to all faces in the object. The effect of TurboSmooth is to round over corners and edges as if they had been filed or planed smooth. Use TurboSmooth parameters to control the size and number of new faces, and how they affect the surface of the object.

Angular model (shown on the right) changed to a smooth model with TurboSmooth
Smoothing an object modeled with extrusions

You use TurboSmooth to produce a Non-Uniform Rational MeshSmooth object (NURMS for short). A NURMS object is similar to a NURBS object in that you can set different weights for each control vertex.

TurboSmooth's effect is most dramatic on sharp corners and least visible on rounded surfaces. Use TurboSmooth on boxes and geometry with crisp angles. Avoid using it on spheres and similar objects.

**TIP** To better understand TurboSmooth, create a sphere and a cube and apply TurboSmooth to both. The cube's sharp corners become rounded, while the sphere's geometry becomes more complex without changing shape significantly.

**Procedures**

**To apply TurboSmooth to an object:**

1. Select an angular object.
2. Apply the TurboSmooth modifier.
3. Set TurboSmooth parameters.
Example: To compare the speeds of TurboSmooth and MeshSmooth:

1. Create a Box primitive with Length/Width/Height Segs=3. Convert the box to editable poly format.
2. Apply MeshSmooth.
3. Set Iterations=5. This creates a heavily subdivided mesh.
4. Go to the Editable Poly > Vertex sub-object level, and turn on Show End Result.
5. Move one of the corner vertices outward. There is a significant delay before you see the result of the Move operation.
6. Perform a few more Move operations on vertices, observe the delays, and then undo (Ctrl+Z) repeatedly until the MeshSmooth modifier goes away.
7. Apply TurboSmooth.
8. Set Iterations=5. This creates a heavily subdivided mesh.
9. Go to the Editable Poly > Vertex sub-object level, and turn on Show End Result.
10. Move one of the corner vertices outward. The response is much faster.
Interface

Main group

Lets you set the basic parameters for TurboSmooth.

**Iterations** Sets the number of times the mesh is subdivided. When you increase this value, each new iteration subdivides the mesh by creating smoothly interpolated vertices for every vertex, edge, and face from the iteration before. The modifier then subdivides the faces to use these new vertices. Default=1. Range=0 to 10.
NOTE Be cautious when increasing the number of iterations. The number of vertices and faces in an object (and thus the calculation time) can increase as much as four times for each iteration. Applying four iterations to even a moderately complex object can take a long time to calculate.

Render Iterations Lets you choose a different number of smoothing iterations on page 1822 to be applied to the object at render time. Turn on Render Iters, and then use the field to its right to set the number of render iterations.

Isoline Display When on, 3ds Max displays only isolines: the object's original edges, before smoothing. The benefit of using this option is a less cluttered display. When off, 3ds Max displays all faces added by TurboSmooth; thus, higher Iterations values result in a greater number of lines. Default=off.

WARNING If you’re going to collapse the model or apply further modifiers after the TurboSmooth, you should first turn off Isoline Display. Unlike in MeshSmooth, isoline display is achieved by making all the edges "invisible," joining large groups of faces together in single "polygons." This can be especially problematic if you apply a PolyObject-based modifier afterwards, because all vertices in the interior of these "polygons" will be lost.
Explicit Normals  Lets the TurboSmooth modifier compute normals for its output, which is faster than the standard method 3ds Max uses to compute normals from the mesh object’s smoothing groups. Default=off.

Consequently, if the TurboSmooth result is used directly for display or rendering, it will generally be faster with this option turned on. Also, the quality of the normals will be slightly higher. However, if you apply any topology-affecting modifiers, such as Edit Mesh, above the TurboSmooth modifier, these normals will be lost and new ones computed, potentially affecting performance adversely. So it’s important to remember to turn on Explicit Normals only if no modifiers change the object topology after TurboSmooth takes effect.

Surface Parameters group

Lets you apply smoothing groups to the object and restrict the smoothing effect by surface properties.

Smooth Result  Applies the same smoothing group to all faces.

Separate by Materials  Prevents the creation of new faces for edges between faces that do not share Material IDs.

Separate by Smoothing Groups  Prevents the creation of new faces at edges between faces that don’t share at least one smoothing group.

Update Options group

Sets manual or render-time update options, for situations where the complexity of the smoothed object is too high for automatic updates. Note that you can also set a greater degree of smoothing to be applied only at render time, in the Main group.

Always  Updates the object automatically whenever you change any TurboSmooth settings.

When Rendering  Updates the viewport display of the object only at render time.

Manually  Turns on manual updating. When manual updating is selected, any settings you change don’t take effect until you click the Update button.

Update  Updates the object in the viewport to match the current TurboSmooth settings. Works only when you choose When Rendering or Manually.
**Turn To Mesh Modifier**

Make a selection. > Modify panel > Modifier list > Object-Space Modifiers > Turn to Mesh

Make a selection. > Modifiers menu > Conversion > Turn to Mesh

The Turn To Mesh modifier lets you apply object conversions in the modifier stack. As another example, you could use this modifier on a sophisticated patch model to which you might want to apply a tool that applies only to meshes, or convert the object to a mesh. Also, when you apply general-purpose modifiers such as Normal, Material, or UVW Map, it can be helpful to explicitly control the type of object beforehand.

**NOTE** Converting from one object type to another causes a complete caching in the modifier stack. When you have large objects in your scene, this can take up a lot of space. For example, an object that starts as a mesh, converts to a patch, and then back to a mesh takes three times as much space as a mesh that just has ordinary modifiers like Bend or UVW Map applied.

**TIP** Turn To Mesh can be useful on meshes, allowing you to invert a selection or change the selection level in a modifier that doesn't depend on topology.

**Procedures**

**Example: To translate a patch sub-object selection to a polygon sub-object selection:**

1. Select a patch model and turn on wireframe mode.
2. In the stack display, choose the Patch sub-object level.
3. Select a patch on the model.
4. Apply the Turn To Mesh modifier from the Modifier list.
5. In the stack display, right-click the Turn To Mesh modifier and choose Collapse All.
6. Click Yes in the dialog that warns you about the possibility of undesirable topological effects.
7. In the stack display (or in the selection rollout), choose the Polygon sub-object mode. The original patch selection has been preserved.
Interface

Parameters rollout

Use Invisible Edges When on, uses invisible edges to represent polygons. When off, produces a completely triangulated mesh with all visible edges. Default=on.

Sub-object Selections group

These options control the selection of sub-objects.

Preserve Passes the sub-object selection up the stack. For example, if you have an object that you have converted to an editable mesh, and you've selected a polygon, then when you apply a Turn To Mesh modifier, the polygon remains selected. Default=on.

Clear Clears the sub-object selection so that nothing is selected. Default=off.

Invert Inverts the sub-object selection. All sub-objects not currently selected are selected, and all sub-objects currently selected are deselected. Default=off.

Include Soft Selection Affects the action of sub-object Move, Rotate, and Scale functions. When these are on, 3ds Max applies a spline curve deformation to unselected vertices surrounding the transformed selected sub-object. This provides a magnet-like effect, with a sphere of influence around the transformation. Use this when you want to preserve the soft selection from beneath. For example, if Use Soft Selection is on when you select vertices on
an editable poly, and you apply Turn To Mesh with Include Soft Selection on, then the same soft selection will apply to the mesh vertices. Default=on. For more information, see Soft Selection Rollout on page 2014.

**Selection Level group**

These options set the sub-object selection level for passing up the rest of the stack.

**From Pipeline** Uses the equivalent of whatever the input object uses (patch level becomes face level, and so on). For example, if you create a box, convert it to an editable patch in patch mode, and apply a Turn To Mesh modifier to it, 3ds Max passes a sub-object selection in patch mode up the stack. The Turn To Mesh modifier takes the sub-object patch selection into account and selects the mesh faces that derive from the patch selection.

**Object** Uses Object as the selection level for passing up the rest of the stack.

**Edge** Uses Edge as the sub-object selection level for passing up the rest of the stack.

**Vertex** Uses Vertex as the sub-object selection level for passing up the rest of the stack.

**Face** Uses Face as the sub-object selection level for passing up the rest of the stack.

### Turn To Patch Modifier

Make a selection. > Modify panel > Modifier List > Object-Space Modifiers > Turn to Patch

Make a selection. > Modifiers menu > Conversion > Turn to Patch

The Turn To Patch modifier lets you apply object conversions in the modifier stack. Using the Turn To Patch modifier, you can fine-tune the conversion process such as turning quads into quad patches.

**NOTE** Converting from one object type to another causes a complete caching in the modifier stack. When you have large objects in your scene, this can take up a lot of space. For example, an object that starts as a mesh, converts to a patch, and then back to a mesh takes 3 times as much space as a mesh which just has ordinary modifiers like Bend or UVW Map applied.
TIP  Turn To Patch can be useful on patches, allowing you to invert a selection or change the selection level in a modifier that doesn’t depend on topology.

Procedures

Example: To collapse to quad patches:

1  Create a chamfer box in wireframe: Create panel > Geometry > Extended Primitives > Object Type rollout > ChamferBox button.

2  Apply a Turn To Patch modifier: Modify panel > Modifier List > Turn To Patch.

3  Right-click the stack display and choose Collapse All.

Interface

Quads to Quad Patches  Turns quad faces in meshes or polymeshes into quad patches.

NOTE  When you turn this option off, 3ds Max triangulates quads when the Turn To Patch modifier is applied to a mesh or poly object.

Sub-object Selections group

These options control the selection of sub-objects.
Preserve  Passes the sub-object selection up the stack. For example, if you have an object that you have converted from an editable mesh, and you’ve selected a polygon, then when you apply a Turn To Patch modifier, the patch, which is derived from the selected polygon, remains selected. Default=on.

Clear  Clears the sub-object selection so that nothing is selected. Default=off.

Invert  Inverts the sub-object selection. All sub-objects not currently selected are selected, and all sub-objects currently selected are deselected. Default=off.

Include Soft Selection  When these are on, 3ds Max applies a spline curve deformation to unselected vertices surrounding the transformed selected sub-object. This provides a magnet-like effect, with a sphere of influence around the transformation. Use this when you want to preserve the soft selection from beneath. For example, if Use Soft Selection is on when you select vertices on an editable mesh, and you apply Turn To Patch with Include Soft Selection on, then the same soft selection will apply to the patch vertices. Default=on.

For more information, see Soft Selection Rollout on page 2014.

Selection Level group

These options set the sub-object selection level for passing up the rest of the stack.

From Pipeline  Uses the equivalent of whatever the input object uses (patch level becomes face level, and so on.). For example, if you create a box, convert it to an editable mesh in face mode, and apply a Turn To Patch modifier to it, 3ds Max passes a sub-object selection in patch mode up the stack. The Turn To Patch modifier takes the sub-object face selection into account and selects the patches that derive from the face selection.

Object  Uses object as the selection level for passing up the rest of the stack.

Edge  Uses edge as the sub-object selection level for passing up the rest of the stack.

Vertex  Uses vertex as the sub-object selection level for passing up the rest of the stack.

Patch  Uses patch as the sub-object selection level for passing up the rest of the stack.
Turn To Poly Modifier

Make a selection. > Modify panel > Modifier List > Object-Space Modifiers > Turn to Poly

Make a selection. > Modifiers menu > Conversion > Turn to Poly

The Turn To Poly modifier lets you apply object conversions in the modifier stack. Also, when you apply the general-purpose modifiers, such as Normal, Material, or UVW Map, it can be helpful to explicitly control the type of object beforehand.

When you use Turn To Poly, you're joining triangles into polygons, so you might need to have restrictions on polygon convexity, size, and planarity. All conversions from patches produce quads and triangles. Conversions from meshes can produce arbitrarily large polygons. Mesh polygons are controlled as usual by joining together faces that are separated by invisible edges.

**NOTE** Converting from one object type to another causes a complete caching in the modifier stack. When you have large objects in your scene, this can take up a lot of space. For example, an object that starts as a mesh, converts to a patch, and then back to a mesh takes three times as much space as a mesh that has only ordinary modifiers like Bend or UVW Map applied.

**TIP** Turn To Poly can be useful on polymeshes, allowing you to invert a selection or change the selection level in a modifier that doesn’t depend on topology.

**Procedures**

**Example: To prevent interior vertices from being passed up the stack:**

1. Create an NGon in wireframe mode: Create panel > Shapes > Splines > Object Type rollout > NGon.

2. Open the Modify panel and convert the NGon to an editable mesh by right-clicking the stack display and choosing Convert to > Editable Mesh.

3. In the stack display (or in the Selection rollout), choose the Polygon sub-object mode.

4. Choose Edit > Object Properties to display the Object Properties dialog.

5. In the Display Properties group, turn off By Layer.
6 Turn on Vertex Ticks. Choose OK to close the dialog.

7 Click Cut under the Edit Geometry rollout, and make a cut from one side of the NGon to the other. Notice that an interior vertex now exists.

**NOTE** Doing this on an NGon doesn't always generate an interior vertex.

8 Apply the Turn To Poly modifier: Modify panel > Modifier List > Turn To Poly. Notice the interior vertex clears.

**Interface**

**Parameters rollout**

![Parameters rollout](image)

**Keep Polygons Convex** Does not join across edges if the resulting polygon would not be convex. "Convex" means that you can connect any two points in the polygon with a line that doesn't go outside the polygon. A polygon is not convex if you can draw a line between vertices and that line lays outside of the polygon.
Problems that can occur with non-convex polygons include the fact that changes in the geometry of the input object can result in a different topology for the Turn To Poly result. For instance, in a box, if you drag one of the top corners across the middle of the top face, the box becomes non-convex. Turn To Poly would then see this as two triangles instead of one quad, and the number of points in the result would change.

**Limit Polygon Size** Limits the number of sides to a polygon so that the surface is better defined. For example, you might want to produce a polymesh of triangles and quads, or one composed of all triangles, rather than joining together more than two triangles into pentagons, hexagons, and so on.

**Max Size** The maximum number of sides to a polygon.

**Require Planar Polygons** Creates polygons composed of flat planes. Does not join faces together across an edge if the edge has a sharper angle than the threshold listed.

**Threshold** Controls the threshold of the angle between polygonal planes.

**Remove Mid-Edge Vertices** Eliminates divisions that result from intersections with invisible edges.

**Sub-object Selections group**

These options control the selection of sub-objects.

**Preserve** Passes the sub-object selection up the stack. For example, if you have an object that you have converted to an editable mesh, and you’ve selected a polygon, then when you apply a Turn To Poly modifier, the polygon remains selected. Default=on.

**Clear** Clears the sub-object selection so that nothing is selected. Default=off.

**Invert** Inverts the sub-object selection. All sub-objects not currently selected are selected, and all sub-objects currently selected are deselected. Default=off.

**Include Soft Selection** Affects the action of sub-object Move, Rotate, and Scale functions. When these are on, 3ds Max applies a spline curve deformation to unselected vertices surrounding the transformed selected sub-object. This provides a magnet-like effect, with a sphere of influence around the transformation. Use this when you want to preserve the soft selection from beneath. For example, if Use Soft Selection is on when you select vertices on an editable mesh, and you apply Turn To Poly with Include Soft Selection on, then the same soft selection will apply to the polymesh vertices. Default=on. For more information, see **Soft Selection Rollout** on page 2014.
Selection Level group

These options set the sub-object selection level for passing up the rest of the stack.

From Pipeline Uses the equivalent of whatever the input object uses (patch level becomes face level, and so on). For example, if you create a box, convert it to an editable mesh in face mode, and apply a Turn To Poly modifier to it, 3ds Max passes a sub-object selection in face mode up the stack. The Turn To Poly modifier takes the sub-object face selection into account and selects the polygons that derive from the face selection.

Object Uses object as the selection level for passing up the rest of the stack.

Edge Uses edge as the sub-object selection level for passing up the rest of the stack.

Vertex Uses vertex as the sub-object selection level for passing up the rest of the stack.

Face Uses face as the sub-object selection level for passing up the rest of the stack.

Twist Modifier

Modify panel > Make a selection. > Modifier List > Object-Space Modifiers > Twist

Make a selection. > Modifiers menu > Parametric Deformers > Twist

The Twist modifier produces a twirling effect (like wringing out a wet rag) in an object's geometry. You can control the angle of the twist on any of three axes, and set a bias that compresses the twist effect relative to the pivot point. You can also limit the twist to a section of the geometry.

NOTE When you apply the Twist modifier, the Twist gizmo's center is placed at the object's pivot point, and the gizmo lines up with the object's local axis.
Procedures

To twist an object:

1. Select an object and apply Twist.

2. On the Parameters rollout, set Twist Axis to X, Y, or Z. This refers to the axis of the Twist gizmo, not the axis of the selected object.
   You can switch between axes at any time, but only one axis setting is carried with the modifier.

3. Set the angle of the twist. Positive values produce a clockwise twist, negative values a counterclockwise twist. An angle of 360 produces a complete revolution.
   The object twists to this amount beginning at the lower limit (by default, the location of the modifier's center).

4. Set the bias of the twist.
A positive value compresses the twist at the end away from the pivot point, a negative value toward the pivot point.

**To limit the twist:**

1. Turn on Limits group > Limit Effect.

2. Set values for the upper and lower limits. These are distances in current units above and below the modifier's center, which is at zero on the gizmo's Z axis. The upper limit can be zero or positive, the lower limit zero or negative. If the limits are equal, the result is the same as turning off Limit Effect. The twist offset is applied between these limits. The surrounding geometry, while unaffected by the twist itself, is moved to keep the object intact.

3. At the sub-object level, you can select and move the modifier's center. The limit settings remain on either side of the center as you move it. This lets you relocate the twist area to another part of the object.

**Interface**

**Modifier Stack**

![Modifier Stack Diagram]

**Gizmo** You can transform and animate the gizmo like any other object at this sub-object level, altering the effect of the Twist modifier. Translating the gizmo translates its center an equal distance. Rotating and scaling the gizmo takes place with respect to its center.

**Center** You can translate and animate the center at this sub-object level, altering the Twist gizmo's shape, and thus the shape of the twisted object.

For more information on the stack display, see Modifier Stack on page 8187.
Twist Parameters rollout

Twist group

Angle Determines the amount of twist around the vertical axis. Default=0.0.

Bias Causes the twist rotation to bunch up at either end of the object. When the parameter is negative, the object twists closer to the gizmo center. When the value is positive, the object twists more away from the gizmo center. When the parameter is 0, the twisting is uniform. Range=100 to -100. Default=0.0.

Twist Axis group

X/Y/Z Specify the axis along which the twist will occur. This is the local axis of the Twist gizmo. Default=Z.

Limits group

Applies the twist effect only to vertices that lie between the lower and upper limits. The two spinners represent distance along the gizmo's Z axis (Z=0 is at the gizmo's center). When they are equal, it is the same as disabling the twist effect.

Limit Effect Applies limit constraints to the Twist modifier.

Upper Limit Sets the upper limit for the twist effect. Default=0.
**Lower Limit** Sets the lower limit for the twist effect. Default=0.

**UVW Mapping**

This group of modifiers provides various ways to manage UVW coordinates and mapping materials onto geometry.

**Unwrap UVW Modifier**

Select one or more objects. > Modify panel > Modifier List > Object-Space Modifiers > Unwrap UVW

Select one or more objects. > Modifiers menu > UV Coordinates > Unwrap UVW

The Unwrap UVW modifier lets you assign mapping coordinates to sub-object selections, and to edit the UVW coordinates of those selections. You can also use it to unwrap and edit existing UVW coordinates on an object. Maps can be adjusted to the proper fit on a Mesh, Patch, Polygon, HSDS, or NURBS model.

The Unwrap UVW modifier can be used as a self-contained UVW mapper and UVW coordinate editor, or in conjunction with the **UVW Map modifier** on page 1932. If you use Unwrap UVW in conjunction with the UVW Map modifier, it is usually so you can use a mapping method unavailable in Unwrap UVW, such as Shrink Wrap. You can animate UVW coordinates by turning on the Auto Key button and transforming the coordinates at different frames.

**NOTE** After applying the Unwrap UVW modifier, open mapping edges, or seams, appear on the modified object in the viewports. This helps you visualize the locations of mapping clusters on the object surface. You can toggle this feature and set the line thickness with the **Display setting** on page 1850.
Open UVW mapping edges (seams) shown on head model in viewport

**Self-Contained Mapper and UVW Coordinate Editor**

Rather than creating a large modifier stack by first making a sub-object selection of faces and then adding a UVW Map modifier to specify the type of mapping, you can use the Unwrap UVW modifier to do both. You can select sub-object vertices, edges, or faces/patches, store sub-object selections as named selections, map them using planar and other methods, and then edit the UVW coordinates for each sub-object selection, all from within the Unwrap UVW modifier. For example, to map a character's face using three planar maps, you could create three sub-object selections of the front and sides of the face, planar-map the selections individually, and then edit the UVW coordinates for each selection, all without leaving the Unwrap UVW modifier.
Support for Multiple Unwrap Objects

Instancing capabilities in Unwrap UVW make it easy to map a texture across several objects. You simply make your selection and then apply Unwrap UVW. When you open the editor, you’ll see the mapping coordinates for all selected objects containing the instanced modifier. The editor shows each object’s wireframe color on page 8182 so you can distinguish the different objects.

Left: Two objects’ UVW coordinates in the editor, showing wireframe colors.
Right (inset): The objects with a shared Unwrap UVW modifier in the viewport.
The UVWs of different objects typically start out in the same location in the editor, so it’s a good idea to separate them before editing. To save time, use the Pack UVs function on the Tools menu.

What Happens to Existing UVW Coordinates

When you apply the Unwrap UVW modifier, it stores the object’s current mapping coordinates in the modifier. If the object has no mapping coordinates, the modifier creates new ones by applying planar mapping. If the incoming data on the stack is a face-level or polygon-level sub-object selection, then only the UVWs for the selected faces are brought into the modifier, and the modifier’s sub-object levels are unavailable.

When the modifier is evaluated, its UVWs are reassigned to the object flowing down the pipeline. So if the UVWs upstream are changed, the changes won’t make it past the Unwrap UVW modifier. If the Unwrap modifier is operating on a selection of faces, then upstream changes to unselected faces will still be able to flow past the Unwrap modifier.

Native Support for HSDS, Polygon Object, and Patch mapping

Unwrap UVW supports polygon faces and Bezier quad and tri patch faces in addition to triangles and quads.

Below is a sample of what the various face types look like based on the incoming type. For HSDS and Poly surfaces, the basic interface remains the same, except that the maximum number of sides per polygon increases from 4 to over two billion. HSDS supports only one level of detail: the level at which the mapping was. Patches have handles on nonlinear vertices. These handles work just like regular patch handles.
Faces from HSDS and Poly surfaces; handles appear for nonlinear vertices

Pinning Textures

Although not its primary purpose, you can use the Unwrap UVW modifier to freeze UVWs. You can apply mapping after an animated deformation and have the mapping stick to the object. For example, you can apply Unwrap UVW above a Morpher modifier in the modifier stack, apply planar maps and edit the UVW coordinates. The mapping will follow the morphing geometry.

Procedures

To use Unwrap UVW with the standard mapping methods:

This procedure offers a general overview of using the basic Unwrap UVW tools available on the Modify panel and the Edit UVWs dialog on page 1856. Unwrap UVW provides many additional tools not described in this procedure, particularly in the editor.

For procedures detailing other mapping methods available with Unwrap UVW, see To use Pelt mapping on page 1900 and To use Spline mapping on page 1920.

1 Apply the modifier and a texture-mapped material to an object. Set the material to display in the viewports, set at least one viewport to be shaded (e.g., press F3 to toggle between Wireframe and Smooth+Highlights), and, if necessary, turn off Shade Selected Faces (press F2) for that viewport so the texture mapping is visible.
2 Go to the Face sub-object level of the Unwrap modifier and make a selection of contiguous faces. You'll use a single mapping type on this selection.

Within the single modifier, you can apply as many different mappings as you like to different face selections.

3 Name the face selection using the Named Selection Sets on page 217 function on the main toolbar. This makes it easy to return to the selection set in the viewports for subsequent mapping adjustments. For example, if you're working on a house, you could use names such as *roof*.

**IMPORTANT** Be sure to press Enter after typing the selection set name.

**NOTE** Naming each face selection set isn't strictly necessary, but it is highly recommended.

4 On the Map Parameters rollout, click the appropriate mapping type button (Planar, Box, etc.) and then adjust the gizmo using any combination of the transform tools (Move, Rotate, Scale) in the viewports and the Align buttons (Align X, etc.) on the Map Parameters rollout.

**TIP** You can often save time by starting with the Best Align command and then adjusting manually from there.

After each adjustment of the mapping gizmo, the texture display in the viewports updates to reflect the mapping changes, as do the green seam lines on the object that show where the open edges lie (depending on the object shape and mapping type; the seam lines don't change with Planar mapping). To cause the viewports to update in real time, turn on Edit UVWs dialog > Constant Update on page 1870.

You can also open the editor (Parameters rollout > Edit) to view the changes in the generated texture coordinates as you adjust the gizmo.

5 Click the mapping type button again to turn it off and exit mapping for this face selection.

6 Continue making and naming selections and applying mapping until the entire mesh is mapped. Use the green seam display lines as a guide. If you don't see them, make sure Parameters rollout > Display Group > Show Map Seam is on.

7 Open the Edit UVWs dialog on page 1856 (Parameters rollout > Edit). By default, the editor displays a checkered background. To view the map in the material on the object, you need to change a setting.
At the right end of the editor upper toolbar, click the drop-down list that currently reads CheckerPattern (Checker) and choose the map that's applied to the material.

The map appears as the background.

By default, all the UVW clusters display. To work on one cluster at a time, you need to filter the UVWs.

On the Edit UVWs dialog > lower toolbar, click Filter Selected Faces.

At this point, the editor shows only faces you select in the viewport, and hides the rest. You can select faces to show directly in the viewport, or choose a named selection set. In the next step, you'll use the latter method.

On the main toolbar, open the Named Selection Sets drop-down list, and choose one of your named selection sets.

The viewports show the selection as active, and the UVW coordinates for the selection appear in Edit UVWs window.

In the Edit UVWs window, select and move a UVW face.

In the viewports, the texture slides around the selected portion of the object mesh.

Choose a different selection set and edit its UVW coordinates.

Again, the viewport display reflects the editing changes.

In a viewport, drag to select a group of faces by region.

The faces' UVW coordinates display in the Edit UVWs window. This is another way of choosing what you want to work on.

As you can see, from within the Unwrap UVW modifier you can assign multiple mapping types to different, optionally named face selections, and then edit the UVW coordinates to fine-tune map placement on the geometry.

To perform quick planar mapping:

You'll find the Quick Planar Map controls on the Map Parameters rollout of the Unwrap UVW modifier.

Apply Unwrap UVW to an object.
2 Go to the Face sub-object level.

3 Select the faces to map.
   The Quick Map gizmo appears juxtaposed over the face selection, showing
   the default Averaged Normals mapping.

4 If you prefer a different orientation for the mapping, choose X, Y, or Z.

5 Click Quick Planar Map to apply the mapping. To map additional faces,
   proceed from step 3.

To export texture coordinates to a paint program:

1 Apply the Unwrap UVW modifier to your object and use the modifier
   tools to set up the mapping. Texture-coordinate clusters that will use the
   same texture area should overlap.

2 From the Edit UVWs dialog menu bar, choose Tools > Render UVW
   Template.
   This opens the Render UVs dialog:
3 Set the Width and Height values to the output resolution you want in the rendered template. You'll usually get good results by setting the desired width and then clicking Guess Aspect Ratio.

**TIP** When creating texture maps for gaming and other real-time 3D engines, be sure to set both dimensions to powers of 2: 256, 512, 1024, etc.

4 Change the remaining values as needed. By default, the template is rendered with the edges as white and opaque (alpha=1.0), and background is empty and transparent (background alpha=0.0), but you have a variety of choices here, as detailed in Render UVs Dialog on page 1910.

5 At the bottom of the dialog, click Render UV Template. This opens a new rendered frame window on page 6513 containing the rendered template as a bitmap. Inspect the output, and if changes are necessary, make them on the Render UVs dialog and re-render.
6 When you're satisfied with the results, click Save Bitmap on the rendered frame window toolbar, and then use the file dialog to specify the file type and name. Click Save to export the file.
If you want to use the rendered transparency information in the paint program, be sure to save in a format that supports the alpha channel, such as TIF or Targa.

7 Open the exported image in a paint program and use the rendered edges as a guide for painting the texture map. Save the image when done.
Be sure to paint over or erase all the edges so they don't appear in the final texture.

8 Back in 3ds Max, create a material, set the Diffuse map to Bitmap, and open the file from the previous step.

9 Apply the material to your mesh object.
The painted texture map follows the outlines set up by the exported UVs.

Interface

After applying the modifier, its panel appears, consisting of the modifier stack plus two rollouts:

**Modifier Stack display**

Normally, when you apply Unwrap UVW to an object, the modifier stack provides access to Vertex, Edge, and Face sub-object levels. These are synchronized with the corresponding selection modes on the Edit UVWs dialog on page 1856. The Vertex and Edge sub-object levels are useful for making
UVW vertex and edge selections in the viewports, where texture mapping on the object surface is more readily visible, and the Edge level is also useful for setting up edge selections that you can later convert to pelt seams.

If you apply Unwrap UVW to an active face selection of an Editable/Edit Mesh/Poly object, or to an active patch selection of an Editable/Edit Patch object, no sub-object levels are available in the Unwrap UVW modifier. You can use Unwrap UVW to edit only the selection that was active when you applied the modifier. Changing the sub-object selection in the object doesn't affect the Unwrap modifier contents, because the modifier obtains the face selection when you first apply it.

All three sub-object levels are synchronized between the modifier stack and the Selection Modes group on page 1864 on the Edit UVWs dialog. When you activate a sub-object level in one, it's also activated in the other. Similarly, selecting sub-objects in a viewport selects them in the editor and vice-versa.

**Selection Parameters rollout**

Use these settings to make or modify a sub-object selection for use by the modifier. If you've passed a face selection up the stack, for example from the Poly Select modifier, Unwrap UVW uses that instead, and makes these controls unavailable.

+ button Expands the selection by selecting all faces adjacent to selected faces.
- button Reduces the selection by deselecting all faces adjacent to non-selected faces.
**Ring** Expands an edge selection by selecting all edges parallel to the selected edges. Ring applies only to edge selections.

**Loop** Expands the selection as far as possible, in alignment with selected edges. Loop applies only to edge selections, and propagates only through junctions of even numbers of edges.

**Ignore Backfacing** When region selecting, prevents the selection of faces not visible in the viewport.

**Select By Element** Lets you select elements on page 8559.

**Planar Angle** Lets you select contiguous coplanar faces with one click. Turn this on, and then set the threshold angle value that determines which faces are coplanar. Then click a face to select it and all contiguous faces whose angles are less than the threshold value.

Planar Angle is available only at the Face sub-object level.

**Select MatID** Enables face selection by material ID on page 8633. Specify the material ID to select, and then click Select MatID.

Select MatID is available only at the Face sub-object level.

**Select SG** Enables face selection by smoothing group on page 8724. Specify the smoothing group to select, and then click Select SG.

Select SG is available only at the Face sub-object level.
Parameters rollout

Edit Displays the Edit UVWs dialog on page 1856.

Reset UVWs Resets the UVW coordinates in the Edit UVWs dialog. Clicking this is almost the same as removing and reapplying the modifier, except that a map assigned in the Edit UVWs dialog is not deleted. For example, if you forgot to turn on the Generate Mapping Coordinates check box for an object, and then applied the Unwrap UVW modifier, the modifier would have no UVW coordinates to use and its settings would be wrong. If you then go back in the Stack and turn on Generate Mapping Coordinates, you'd need to click the Reset UVWs button. When you click this button, an alert warns you that you're losing any edits you've made.

Save Saves the UVW coordinates to a UVW (.uvw) file.

Load Loads a previously saved UVW file.
Channel group

This option lets you choose a specific map channel by number, or the vertex color channel. For more information, see UVW Map modifier > Channel group on page 1950.

When you change channels, 3ds Max copies the current edits to the new channel without alerting you. If you already have edits in that channel from another modifier (Unwrap UVW or other), those edits could be overwritten. To ensure preservation of your edits, save them before changing channels and reload the saved edits as necessary.

Display group

This setting determines whether and how pelt seams and mapping cluster boundaries, also known as map seams, appear in the viewports:

Show Seam When on, pelt boundaries appear in the viewports as blue lines.

Show Map Seam When on, mapping cluster boundaries appear in the viewports as green lines. You can change this color by adjusting the Display seams color on page 1929.

Thin/Thick Seam Display The display thickness setting applies to both pelt seams and map seams:

■ Thin Seam Display Displays map seams and pelt seams on object surfaces in the viewports with relatively thin lines. The line thickness remains constant as you zoom the view in and out.

■ Thick Seam Display Displays map seams and pelt seams on object surfaces in the viewports with relatively thick lines. The line thickness increases when you zoom the view in and decreases when you zoom out. This is the default choice.

Prevent Reflattening This option is used mainly for texture baking. When turned on, the version of the Unwrap UVW modifier automatically applied by Render To Texture on page 6843, named, by default, Automatic Flatten UVs, will not reflatten the faces. Also, make sure that both Render To Texture and the modifier are using the same map channel.
Map Parameters rollout

You can apply any map type to selected faces, patches, or surfaces, and align the mapping gizmo in any of a variety of ways.

The mapping controls on the upper part of the rollout are available only at the Face sub-object level. Also, the Quick Map controls are available only when no mapping mode button (Planar, Pelt, etc.) is active. However, the seam controls on page 1854 are available at all sub-object levels.

NOTE When a mapping type button is active, you cannot change the selection without first exiting the mapping operation.
Preview Quick Map Gizmo When on, a rectangular planar mapping gizmo, applicable to the Quick Planar Map tool only, appears juxtaposed over the face selection in the viewports. This gizmo is not manually adjustable, but you can use the following control to reorient it.

X/Y/Z/Averaged Normals Choose the alignment for the quick map gizmo: perpendicular to the object's local X, Y, or Z axis, or based on the faces' average normals.

Quick Planar Map Applies planar mapping to the current face selection based on the orientation of the Quick Map gizmo.
Planar  Applies planar mapping to selected faces.
Make the selection, click Planar, adjust the mapping using the transform tools and Align buttons on the Map Parameters panel, and then click Planar again to exit.

Pelt  Applies pelt mapping to selected faces. Clicking this button activates Pelt mode, in which you can adjust the mapping and edit the pelt map on page 1898.

**NOTE** Pelt mapping always uses a single planar mapping for the entire pelt. If you’ve applied a different type of mapping, such as Box, and then switch to Pelt, the previous mapping is lost.

**TIP** For the basic method of using Pelt mapping, see this procedure on page 1900.

Cylindrical  Applies cylindrical mapping to the currently selected faces.
Make a face selection, click Cylindrical, adjust the cylinder gizmo using the transform tools and Align buttons on the Map Parameters panel, and then click Cylindrical again to exit.

**NOTE** When you apply Cylindrical mapping to a selection, 3ds Max maps each face to the side of the cylinder gizmo that most closely matches its orientation. For best results, use Cylindrical mapping with cylinder-shaped objects or object parts.

Spherical  Applies spherical mapping to currently selected faces.
Make the face selection, click Spherical, adjust the sphere gizmo using the transform tools and Align buttons on the Map Parameters panel, and then click Spherical again to exit.

Box  Applies box mapping to the currently selected faces.
Make the selection, click Box, adjust the box gizmo using the transform tools and Align buttons on the Map Parameters panel, and then click Box again to exit.

**NOTE** When you apply Box mapping to a selection, 3ds Max maps each face to the side of the box gizmo that most closely matches its orientation. For best results, use Box mapping with box-shaped objects or object parts.

Spline  Applies spline mapping to the currently selected faces. Clicking this button activates Spline mode, in which you can adjust the mapping and edit the spline map on page 1916.
Align X/Y/Z  Aligns the gizmo to the X, Y, or Z axis of the object's local coordinate system.

Best Align  Adjusts the mapping gizmo's position, orientation, and scale to fit that of the face selection, based on the selection's extents and average normals.

Fit  Scales the gizmo to the extents of the selection and centers it on the selection. Does not change the orientation.

Align To View  Reorients the mapping gizmo to face the active viewport and adjusts its size and position as necessary to fit the extents of the selection.

Center  Moves the mapping gizmo so that its pivot coincides with the center of the selection.

Reset  Scales the gizmo to fit the selection and aligns it with the object's local space.

Normalize Map  When on, scales the mapping coordinates to fit into the standard coordinate mapping space: 0 to 1. When off, the mapping coordinates are the same size as the object. The map is always tiled once in the 0-1 coordinate space; the part of the map based on its Offset and Tiling values on For example, if you take a sphere of 25 units that's planar mapped from the top, and then apply Unwrap UVW and turn off Normalize Map, then when you open the editor, the radius of the sphere's mapping coordinates is 25 units. As a result, the texture map is tiled onto the sphere surface many times. With Normalize Map on, both the sphere and the map fit into the 0-1 coordinate space, so they're the same size.

In general, for best results, leave Normalize Map on. One reason to turn it off would be to turn it off is if you want to map several elements of different proportions with a texture of a specific aspect ratio, such as brick, keeping the texture the same size on each object.

[Seam controls]

These tools, which give you different ways of specifying pelt seams, are available at all sub-object levels of the modifier. Pelt seams apply to pelt
mapping on page 1853, as well as to spline mapping on page 1853 when you use manual seams on page 1923.

**Edit Seams** Lets you specify a pelt seam by selecting edges with the mouse in the viewports.

This process is similar but not identical to standard edge selection:

- Click an edge to add it to the current selection.
- Alt+click an edge to remove it from the current selection.
- Drag to select a region.

**Point To Point Seam** Lets you specify pelt seams by selecting vertices with the mouse in the viewports. Pelt seams specified with this tool are always added to the current seam selection.

In this mode, after you click a vertex, a rubber-band line extends from the vertex you clicked to the mouse cursor. Click a different vertex to create a pelt seam, and then continue clicking vertices to create a seam from each vertex to the previous one. To start at a different point in this mode, right-click, and then click a different vertex. To stop drawing seams, click the button again to turn it off.

**NOTE** While Point To Point Seam is active, you can pan, rotate, and zoom the viewport at any time using contextual controls (middle-button drag, Alt+middle-button drag, turn mouse wheel, respectively) to access a different part of the mesh surface. You can also navigate using the ViewCube on page 86 and SteeringWheels on page 93. After doing so, 3ds Max still remembers the last vertex you clicked and draws an accurate seam at the next click. Similarly, you can adjust the viewport using the viewport control buttons on page 8113 and then return to selecting the seam. If the control requires more than a single click, such as Pan, exiting the control by right-clicking in the viewport restores the rubber-band line, extending from the last vertex you clicked.

**TIP** The algorithm Point To Point Seam uses to calculate a path might create a different seam than what you have in mind. If this happens, undo (Ctrl+Z) and specify the desired path by plotting points closer together.

**Edge Sel To Seams** Converts the current edge selection in the modifier to pelt seams. These seams are added to any existing seams.

**Exp(and) Face Sel to Seams** Expands the current face selection to meet the pelt seam border(s). If multiple seam outlines contain selected faces, the expansion takes place only for the last-selected face; all others are deselected.
Edit UVWs Dialog

Select an object. > Modify panel > Modifier List > Object-Space Modifiers > Unwrap UVW > Edit button (on Parameters rollout)

The heart of the Edit UVWs dialog is a window that displays a lattice made up of UVW faces and UVW vertices. Each UVW face, which has three or more vertices, corresponds to a face in the mesh.

The view window displays the UVWs in the 2D-image space of the map, superimposed over a grid. Thicker grid lines show the boundaries of a texture map as it would appear in image space; the lower-left corner of the rectangle has the coordinates (0,0) and the upper-right has the coordinates (1,1). Within this window, you manipulate the UVW coordinates relative to the map (or mesh) by selecting the lattice vertices, edges, or faces (collectively known as sub-objects), and transforming them.

The state of the Edit UVWs dialog, including buttons and selected options, is stored and recalled the next time you open the Edit dialog.

NOTE You can edit patch object texture coordinates as well as mesh coordinates in the Edit UVWs dialog. When editing a patch object, you can also edit the vertex handles. In addition, you can edit the manual interior handles. However, you must enable the manual interior handles before applying the Unwrap UVW modifier. To do so, at the Patch sub-object level, select one or more patches, right-click a selected patch, and then, from the quad menu > tools 1 quadrant, choose Manual Interior. The manual interior handles appear in the editor window as isolated vertices.

NOTE Certain modeling operations can leave unused (isolated) map vertices that show up in the editor window, but cannot be used for mapping. If the model is an Editable Poly or Edit Poly object, you can use the Remove Unused Map Verts button on page 1366 at the Vertex sub-object level to automatically delete these vertices.

TIP The editor can display the number of selected sub-objects. This option is available as an Unwrap UVW shortcut on page 1879 as Show Subobject Counter.

Interface

Besides the window, the editor interface consists of a menu bar, a toolbar, a lower toolbar, and, docked below the main dialog, the Options panel on page 1863.
Menu bar

The menu bar provides access to a wide range of Edit UVWs functions. See Edit UVWs Dialog Menu Bar on page 1871.

Toolbar

Contains all the controls for manipulating the texture sub-objects in the view window, navigating within the window, and setting other options. When transforming with Rotate and Scale, pressing Ctrl+Alt will allow you to
transform the selection from the point of the mouse click, instead of the selection center. The initial click specifies the center of the transform.

**Move** Lets you select and move sub-objects. Flyout options are Move, Move Horizontal, and Move Vertical. Press Shift to constrain the movement to a single axis.

**Rotate** Lets you select and rotate sub-objects.

**Scale** Lets you select and scale sub-objects. Flyout options are Scale, Scale Horizontal, and Scale Vertical. Pressing Shift as you scale constrains the transform to a single axis.

**Freeform Mode** Lets you select and move, rotate, or scale vertices, depending on where you drag. After you make a selection, the Freeform gizmo appears as a rectangular bounding box around the selected vertices. As you move the cursor over the gizmo’s various elements and inside the gizmo, the cursor’s appearance, and the result of starting to drag in this location, change:

- **Move** Position the cursor anywhere inside the gizmo and then drag to move the selection. To constrain movement to the vertical or horizontal axis, depending on how you begin dragging, press and hold Shift before dragging.

- **Rotate** Position the cursor over a gizmo edge center point, and then drag to rotate the selection about the pivot. As you drag, the amount of rotation is shown in the center of the gizmo. Ctrl+drag to rotate in five-degree increments; Alt+drag to rotate in one-degree increments. Freeform rotation respects the angle snap on page 2810 status.

- **Scale** Position the cursor over a gizmo corner and then drag to scale the selection. By default, scaling is non-uniform; if you press and hold Ctrl before dragging, scaling is uniform on the horizontal and vertical axes. Press and hold Shift before dragging to constrain scaling to the vertical or horizontal axis, depending on how you begin dragging.
By default, scaling takes place about the gizmo center. If you've moved the pivot (see following item), you can scale about the transform center instead by pressing and holding Alt before dragging.

- **Move pivot** Position the cursor over the pivot, a wireframe cross that appears by default at the center of the gizmo. When this cursor appears, drag to move the pivot. Rotation always occurs about the pivot; scaling takes place about the pivot if you press and hold Alt before dragging.

  **TIP** By default, the pivot always resets to the center of the gizmo when you make a new selection. If you prefer to retain the offset from selection to selection, you can toggle this feature with the Reset Pivot On Selection command. This command is not available in the editor interface by default; you must use the Customize User Interface dialog on page 8249 to add it.

If you Ctrl+select one or more vertices outside the gizmo, the gizmo expands to encompass the entire selection.

- **Mirror** Mirrors selected vertices and flips UVs. Flyout options are Mirror Vertical, Mirror Horizontal, Flip Horizontal, and Flip Vertical. Flip first detaches the selection along its boundary edges and then applies a Mirror Horizontal or Vertical depending on the mode.

- **Show Map** Toggles the display of the map in the editor window.

- **UV/VW/UW** By default, the UV portion of the UVW coordinates is displayed in the view window. However, you can switch the display to edit the UWs or the VWs.

  **[texture list drop-down]** Contains all the maps of the material assigned to the object.
The names of the maps assigned in the Material Editor and in the Edit UVWs dialog (via Pick Texture) appear in the list.

Below the map names are several commands:

- **Pick Texture**  Lets you use the Material/Map Browser to add and display textures that are not in the object's material.

- **Remove Texture**  Eliminates the currently displayed texture from the editor.

- **Reset Texture List**  Returns the texture list to the current state of the applied material, removing any added textures and restoring any removed textures that were part of the original material, if they still exist in the material. This command also adds any new maps in the material, so it essentially updates the UVW editor to the current state of the material.

Choose a map you want to use in the view window. For example, you might use a bump or texture map as a reference to move UVW vertices.

A checker texture named CheckerPattern (Checker), useful for checking for distorted areas of the texture mapping, is built in to the Edit UVWs dialog. By default, this texture appears as the background texture when you first open the editor after applying Unwrap UVW to an object. To cause the pattern to appear on the object in viewports set to display textures, choose it from the drop-down list, even if it's already active in the editor.

**Edit UVWs window**

The Edit UVWs window allows you to edit UVW sub-objects to adjust the mapping on a model. For example, a texture map might contain the side, top, and front views of a car. By first planar mapping the top, side, and front faces of the model at the Face sub-object level, you can adjust the texture coordinates for each selection to fit the different parts of texture map to the corresponding areas on the car.
To edit the UVW vertices, first choose a transform tool and sub-object mode, make a selection, and then click and drag in the window to transform the selection.

**Quad menu** Right-click in the window to display the quad menu, which provides access to all the transform tools, as well as a number of editor commands.

![Quad menu](image)

Commands to freeze and hide selected sub-objects and unfreeze/unhide all sub-objects are found only in the quad menu.

**Lower Toolbar**

**Absolute/Offset Mode** When this is off, 3ds Max treats values you enter into the U, V, and W fields (see following) as absolutes. When this is on, 3ds Max applies transform values you enter as relative to current values; that is, as offsets. Default=off.

**U, V, and W** These fields display the UVW coordinates for the current selection. Use the keyboard or the spinners to edit them.

These fields are active at all sub-object levels, but they always apply to vertices. With a single vertex selected, they display the current coordinates. With multiple vertices (or one or more edges or faces) selected, they display any coordinates the vertices belonging to the selection have in common; otherwise, they're blank.
**Lock Selection** Locks selection. You can move selected sub-objects without touching them.

**Filter Selected Faces** Displays UVW vertices of the object’s selected faces in the viewport, and hides the rest. When Filter Selected Faces is on, changing the viewport face selection automatically updates the display of visible faces in the editor.

**All ID’s (drop-down)** Filters the object’s material IDs. Displays texture faces that match the ID drop-down.

**Pan** Click Pan, and then drag in the window to change the visible portion.

**Tip** With a three-button mouse, you can also pan the window by dragging with the middle mouse button held down.

**Zoom** Click Zoom, and then click+drag to zoom the window.

**Tip** With a wheel mouse, you can also zoom by turning the wheel.

**Zoom Region** Click Zoom Region, and then region-select part of the window to zoom in.

**Zoom Extents** Zooms in or out to fit the texture coordinates in the window. The flyout buttons, from top to bottom, let you zoom to all texture coordinates, to the current selection, and to all clusters/elements containing any selected sub-objects.

**Grid Snap** When on, moving sub-objects tends to snap the vertex closest to the mouse cursor, which is highlighted by a square outline, to the nearest grid line or intersection.

This is the default tool on this flyout; Pixel Snap is also available.
You can set the snap strength in the Unwrap Options dialog on page 1931.

**Pixel Snap** Snaps to the nearest pixel corner when you have a bitmap in the background. Available from the Grid Snap flyout. Combine this with Center Pixel Snap on page 1871 to snap to the center of pixels rather than the corner.

**NOTE** With multiple vertices selected, all vertices snap to the nearest pixel, relatively; this can slightly alter the spatial relationships among them.

**Options panel**

By default, the Options panel, docked to the bottom of the Edit UVWs dialog, provides controls for using soft selection, specifying selection modes, and rotating the selection. The Options button lets you toggle the display of additional settings for bitmaps, viewports, and the editor.

**Soft Selection group**

The Soft Selection controls make a sub-object selection behave as if surrounded by a “magnetic field.” Unselected sub-objects within the field are drawn along smoothly while you transform the sub-object selection, the effect diminishing with distance. You can adjust this distance, or “falloff,” whether it applies to object space, texture space, or edge space, and the formula by which it diminishes.

First, set a value that encompasses sub-objects to be moved or scaled, and then transform sub-objects with a falloff effect.

**On** Activates or deactivates soft selection.

**XY/UV** Specifies object or texture space for the falloff distance. XY selects object space, UV selects texture space.

**Falloff** Sets the falloff distance. As values increase, unselected vertex colors change gradually from the selected vertex to reflect the area of influence.

**Edge Distance** Turn on to limit the falloff region by the specified number of edges between the selection and the affected vertices. The affected region is measured in terms of “edge-distance” space rather than absolute distance.
Falloff Type Transforming with soft selection affects non-selected vertices within the falloff area based on the falloff type.
The icons depict how their buttons affect falloff. The options are:

- Smooth
- Linear
- Slow Out
- Fast Out

Selection Modes group

[sub-object mode] Specifies the type of sub-object that you can select by clicking or dragging in the window. Default=Vertex.

One of the three sub-object modes can be active at a time:

- Vertex
- Edge
- Face

NOTE Selected sub-objects are colored red by default. Also, in Edge and Face sub-object modes, any shared edges are blue by default. A shared edge is one both of whose endpoints are shared by a selected edge or face; thus, it is, in effect, also selected. You can change these colors using Customize User Interface > Colors panel on page 8272.

The three sub-object levels are synchronized between the modifier stack on page 1846 of the Unwrap UVW modifier and the Selection Modes group. When you choose a sub-object level in one, it’s also activated in the other. Similarly, selecting sub-objects in a viewport selects them in the editor and vice-versa.
Select Element  When on, selecting a sub-object in a cluster causes the entire cluster to become selected. Works in all sub-object modes.

Expand Selection  Adds sub-objects to the selection.

Vertex and face expansion proceeds outwards in all available directions. Edge expansion proceeds along available UV paths. For example, to select a cluster outline, select one outer edge, and then click Expand Selection repeatedly.

Contract Selection  Shrinks the selection by deselecting the outermost sub-objects.

Paint Select Mode  Lets you “paint” a sub-object selection by dragging in the editor window. After activating this mode, move the cursor into the editor window, and then drag to select sub-objects. To exit Paint Select mode, right-click or choose a transform tool.

Paint mode selects only sub-objects that are fully inside the selection brush. The dotted circle attached to the mouse shows the size of the brush. Use the +/- buttons next to the paintbrush button to change its size.

+/- Increases and decreases the size of the Paint Select mode “brush”: the circle attached to the mouse cursor.

Loop [+/-]  Selects a loop of texture vertices, edges, or polygons. Usage is as follows:

- Vertices/Polygons  Select two or more adjacent vertices or polygons in one or more rows or columns, and then click Loop. This selects all sub-objects in line with the selection(s).

- Edges  Select one or more edges, and then click Loop. This selects all edges in line with the selected edge(s).

To extend a loop or loops at both ends, when possible, click +. To deselect the sub-objects at both ends of a loop or loops, click -. 
Ring [+/−] Selects a ring of texture vertices, edges, or polygons. Usage is as follows:

- **Vertices/Polygons** Select two or more adjacent vertices or polygons in one or more rows or columns, and then click Ring. This selects all sub-objects perpendicular to the line formed by the selection(s).

- **Edges** Select one or more edges, and then click Ring. This selects all edges in the row(s) or column(s) perpendicular to the selected edge(s).

To extend a ring or rings at both ends, when possible, click +. To deselect the sub-objects at both ends of a ring or rings, click −.

---

**Rot(ate) +90** Rotates the selection 90 degrees about its center.

**Rot(ate) -90** Rotates the selection -90 degrees about its center.

**Stitch** Rejoins a disconnected cluster of texture coordinates to its original neighbor by connecting selected vertices to their corresponding UV seam vertices. If a UV vertex has more than one corresponding UV vertex, it will be stitched to the closest one.

Stitch has three different modes, depending on which part of the button you click:

- **Stitch to Source [left arrow]** Moves the corresponding vertices to the selected vertices.

- **Stitch to Average [Stitch button]** Moves both sets of vertices to the average positions.

- **Stitch to Target [right arrow]** Moves the selected vertices to the corresponding vertices.
1. Texture vertices before stitching
2. Stitch to Source
3. Stitch
4. Stitch to Target

**Align Horizontal** Applies by default only to selected texture vertices and edges. At the Vertex level, this tool lines up the selected UV vertices horizontally in a straight line. At the Edge level, Align lines up the selected edges.

Initial vertex selection (left); after Align Horizontal (right)

At the Edge level, if you press Shift when clicking the button, Align loops through all selected edges and lines up all the edge loops of those edges horizontally. In that case it is enough to select one edge on each edge loop to line up. It will also line up UV seam edge loops.
**Align Vertical** Applies by default only to selected texture vertices and edges. At the Vertex level, this tool lines up the selected UV vertices vertically in a straight line. At the Edge level, Align lines up the selected edges.

At the Edge level, if you press Shift when clicking the button, Align loops through all selected edges and lines up all the edge loops of those edges vertically. In that case it is enough to select one edge on each edge loop to line up. It will also line up UV seam edge loops.

Aligning edges:

1. Initial edge ring selection
2. After using Align Vertical with **Shift** pressed
3. Initial edge ring selection
4. After using Align Horizontal with **Shift** pressed

**Space Horizontal** Applies by default only to selected texture vertices and edges. At the Vertex level, this tool adjusts the positions of selected UV vertices to make the horizontal distances between each pair the same. At the Edge level, Align evenly spaces selected edges horizontally.

At the Edge level, if you press Shift when clicking the button, Align loops through all selected edges and evenly spaces those edges horizontally. In that case it is enough to select one edge on each edge loop to space. It will also space UV seam edge loops.
Initial edge ring selection (left); after using Space Horizontal with Shift pressed to space each edge’s loop (right)

Space Vertical Applies by default only to selected texture vertices and edges. At the Vertex level, this tool adjusts the positions of selected UV vertices to make the vertical distances between each pair the same. At the Edge level, Align evenly spaces selected edges vertically.

At the Edge level, if you press Shift when clicking the button, Align loops through all selected edges and evenly spaces those edges vertically. In that case it is enough to select one edge on each edge loop to space. It will also space UV seam edge loops.

UV_SelectionFromBase/SelectionToBase These commands transfer sub-object selections from the base object (must be editable poly) to the texture coordinates and vice-versa. They are available only from the Customize User Interface dialog on page 8249:

- **UV_SelectionFromBase** Converts a sub-object selection from the base editable poly object to the texture coordinates in the Unwrap UVW modifier. It is available only when the Editable Poly level in the modifier stack is active. The CUI action is available from the PolyTools category.

- **SelectionToBase** Converts a sub-object selection from the texture coordinates in the Unwrap UVW modifier to base editable poly object. It is available only when the Unwrap UVW level in the modifier stack is active. The CUI action is available from the UVW Unwrap category.
Bitmap Options group

Click the Options button to toggle this group.

Use Custom Bitmap Size When on, scales the bitmap texture to the values specified by Width and Height values (see following). You can scale and re-proportion the bitmap texture in relation to the texture coordinates with these settings. This scaling affects the bitmap only as viewed in the editor; not in the material.

TIP For faster feedback when working with large textures, reduce the bitmap size. And when working with disproportionate textures, setting the dimensions closer to each other in the editor can make it easier to work.

Width Scales the bitmap along the horizontal axis.

Height Scales the bitmap along the vertical axis.

Tile Bitmap When turned on, you can repeat the bitmap in the editor, displaying tiling set in the material. You can use any part of the tiled image for setting texture coordinates. This is helpful when the sections of the texture image are packed tightly together and the mesh contains many different areas to map.

Tiles The number of times the texture image is repeated, counting outward in eight directions (the four corners and the four sides).

With Tiles=1, the result is a 3 x 3 grid. With Tiles=2, the result is a 5 x 5 grid, and so on.

Brightness Sets the brightness of the tiled bitmap. At 1.0, the brightness equals that of the original image; at 0.5 it's half the brightness; and at 0, it's black.

TIP Turning off Affect Center Tile, available in the Unwrap Options dialog on page 1927 > Display Preferences group, prevents the Brightness setting from affecting the center tile, so it's easier to find if you've turned down the brightness.

Viewport Options group

Click the Options button to toggle this group.

Constant Update When on, the viewports update in real-time, reflecting any changes to the texture coordinates as you make them. When off, the viewports update only after you finish transforming texture coordinates (that is, when you release the mouse button).
Unwrap Editor Options group

Click the Options button to toggle this group.

Show Hidden Edges Toggles the display of face edges. When turned off, only faces appear. When turned on, all mesh geometry appears.

Center Pixel Snap When Pixel Snap on page 1863 is turned on, snaps to the center of pixels of the background images instead of pixel edges.

Weld Threshold Sets the radius within which welding using Weld Selected takes effect. The setting is in UV-space distance. Default=0.01. Range=0 to 100.0.

Edit UVWs Dialog Menu Bar

Select an object. > Modify panel > Modifier List > Object-Space Modifiers > Unwrap UVW > Edit button (on Parameters rollout) > Menu bar

The Edit UVWs dialog on page 1856 menu bar provides access to a number of important editing commands. Some of these commands are replicated on the dialog toolbar and the Unwrap UVW command panel; others, such as the Mapping, Stitch, and Sketch tools, are available only from the menus.

Tip Several commands are not available in the editor interface by default; you can use the Customize User Interface dialog on page 8249 to add them.

Interface

File menu

Load UVs Loads a previously saved UVW (texture coordinates) file.

Save UVs Saves the UVW coordinates to a UVW file.

Reset All Restores the UVW coordinates to their original status.

Reset All has almost the same effect as removing and reapplying the modifier, except that a map assigned in the Edit UVWs dialog is not deleted. For example, if you forgot to turn on the Generate Mapping Coordinates check box for an object, and then applied the Unwrap UVW modifier, the modifier would have no UVW coordinates to use and its settings would be wrong. If you then go back in the modifier stack and turn on Generate Mapping Coordinates, you'd need to choose the Reset All command. When you do so, an alert warns you that you're losing any edits you've made.
**Edit menu**

These commands provide access to the different transform functions, and copy and paste selections.

**Copy** Copies the current selection (i.e., texture coordinates) into the paste buffer.

**Paste** Applies the texture mapping coordinates in the paste buffer to the current selection. Using Paste repeatedly with the same target coordinates causes the coordinates to rotate by 90 degrees each time.

Use Copy and Paste to apply the same mapping coordinates (i.e., image) to a number of different geometry faces. A typical example of usage would be in designing a game level, where you’re working with a multi-image texture map, part of which is a door image. You might want to apply the same door image to several different door polygons. First, you would select one of the door polys and position it over the door image. Next, use Copy to place its texture coordinates in the paste buffer. Then select another door poly and choose Paste or Paste Weld. The door’s texture coordinates move to the same location as the original poly. Continue selecting other door polys and pasting until all the doors are mapped.

**TIP** For best results, use comparable sets of texture coordinates for the source and destination. For example, copy a single four-sided face, and then paste another four-sided face.

**Paste Weld** Applies the contents of the paste buffer to the current selection and then welds coincident vertices, effectively fusing the source and destination selections together.

Use this function to end up with a single set of texture coordinates that’s applied to multiple geometry elements. Adjusting these texture coordinates changes the mapping for all geometry to which they’re applied.

**Move Mode** Lets you select and move sub-objects.

**Rotate Mode** Lets you select and rotate sub-objects.

**Scale Mode** Lets you select and scale sub-objects.

**Freeform Gizmo** Lets you select and transform vertices. See Freeform Mode on page 1858.

**Select menu**

These commands let you copy a viewport selection to the editor, and transfer selections among the three different sub-object modes.
**Convert Vertex to Edge** Converts the current vertex selection to an edge selection and places you in Edge sub-object mode. For an edge to be selected, both of its vertices must be selected.

**Convert Vertex to Face** Converts the current vertex selection to a face selection and places you in Face sub-object mode. For a face to be selected, all of its vertices must be selected.

**Convert Edge to Vertex** Converts the current edge selection to a vertex selection and places you in Vertex sub-object mode.

**Convert Edge to Face** Converts the current edge selection to a face selection and places you in Face sub-object mode. For a face to be selected, the current edge selection must include all of its vertices. For example, if two opposite edges of a four-sided face are selected, the edge selection includes all four of the face's vertices, so this command will select the face.

**Convert Face to Vertex** Converts the current face selection to a vertex selection and places you in Vertex sub-object mode.

**Convert Face to Edge** Converts the current face selection to an edge selection and places you in Edge sub-object mode.

**Select Inverted Faces** Selects any faces facing away from the current mapping. Available only in Face selection mode on page 1864.
This is useful in complex models for finding faces on a surface that folds in under itself, thus causing potential problems with bump mapping.
For example, add a sphere, turn off Generate Mapping Coords, and then apply Unwrap UVW. This causes the modifier to apply planar mapping from the top down, so that all faces on the bottom half of the sphere are “inverted”; that is, they face away from the mapping. In the modifier stack display, highlight the Select Face sub-object level, and then click the Edit button to open the UVW editor. Choose the Face selection mode, and then choose Select > Select Inverted Faces. In the viewports, the bottom half of the sphere turns red to indicate that the inverted faces are now selected.

**Select Overlapped Faces** Selects any faces that overlap other faces. If no face is selected, this selects all overlapping faces. If a face selection exists, this selects only overlapping faces within the selection. Available only in Face selection mode on page 1864.
When working with complex meshes, it's common for texture-coordinate faces to overlap one another, with the result that they use the same portion of the texture map. Use this command to find overlapping faces in order to separate them as needed.
**Tools menu**

Tools on this menu let you flip and mirror texture coordinates, weld vertices, combine and separate sets of texture coordinates, and sketch outlines for multiple selected vertices.

**Flip Horizontal/Vertical** Detaches the selected sub-objects along their boundary edges and then applies Mirror Horizontal or Vertical, depending on the mode.

**Mirror Horizontal/Vertical** Reverses the direction of selected sub-objects along the indicated axis and flips UVs accordingly.

**Weld Selected** Welds selected sub-objects to a single vertex, based on the Weld Threshold setting. You can set the threshold on the Options panel > Unwrap Editor Options group, as well as on the Unwrap Options dialog on page 1927 > Misc. Preferences group.

**Target Weld** Welds pairs of vertices or edges. Not available at the Face sub-object level.

Turn on Target Weld, and then drag one vertex to another vertex, or one edge to another edge. As you drag, the cursor changes in appearance to cross hairs when it’s over a valid sub-object. While this command is active, you can continue welding sub-objects, and change the sub-object level. To exit Target Weld mode, right-click in the editor window.

**Break** Applies to the current selection; works differently in the three sub-object modes. At the Vertex sub-object level, Break replaces each shared vertex with two vertices. With edges, Break requires at least two contiguous edges to be selected, and separates each edge into two. With faces, Break splits the selection off from the rest of the mesh into a new element, exactly as does Detach Edge Verts.

**Detach Edge Verts** Tries to split off the current selection into a new element. Any invalid vertices or edges are removed from the selection set before the detach.

**Stitch Selected** For the current selection, finds all the texture vertices that are assigned to the same geometric vertex, brings them all to the same spot, and welds them together. With this tool you can automatically connect faces that are contiguous in the object mesh but not in the editor.

To use Stitch Selected, first select sub-objects along an edge you want to connect (by default, this causes the shared edges to highlight), and then choose the command. In the Stitch Tool dialog on page 1924, adjust the settings, and then click OK to accept or Cancel to abort.
**Pack UVs** Distributes all texture-coordinate clusters through the texture space using one of two methods and spacing you specify. This is useful if you have several overlapping clusters and wish to separate them.

Choosing Pack UVs opens the Pack dialog on page 1897.

**Sketch Vertices** Lets you draw outlines for vertex selections with the mouse. This is useful for matching coordinate cluster outlines to sections of the texture map *en masse*, without having to move vertices one at a time.

Choosing Sketch Vertices opens the Sketch Tool dialog on page 1914. Sketch Vertices is available only in the Vertex sub-object mode.

**Relax Dialog** Opens the non-modal Relax Tool dialog on page 1906, which lets you change the apparent surface tension in a selection of texture vertices by moving vertices closer to, or away from, their neighbors. Relaxing texture vertices can make them more evenly spaced, resulting in easier texture mapping. Available at all sub-object levels.

**NOTE** This command, as well as a Relax command that lets you apply the default settings to the current selection without opening the dialog, are available as assignable keyboard shortcuts on page 1879.

**Render UVW Template** Opens the Render UVs dialog on page 1910, which lets you export texture mapping data as an image file that you can then import into 2D paint software.

**Mapping menu**

Lets you apply one of three different types of automatic, procedural mapping methods to a model. Each method provides settings so you can adjust the mapping to the geometry you’re using.

With each method, the mapping is applied to the current face selection; if there is no face selection it is applied to the entire mesh.

Here’s a quick overview of the three methods:

- Flatten mapping prevents overlap of mapping clusters, but can still cause texture distortion.
- Normal mapping is the most straightforward method, but can result in even greater texture distortion than with Flatten mapping.
- Unfold mapping eliminates texture distortion, but can result in overlapping coordinate clusters.
In many cases, one of the automatic mapping functions will provide useful results. But with certain custom or complex objects, you might get the best results with manual mapping; use a variation of the basic procedure on page 1841, or use a procedural method as a starting point for custom mapping.

**Flatten Mapping** Applies planar maps to groups of contiguous faces that fall within a specified angle threshold.
Choosing Flatten Mapping opens the Flatten Mapping dialog on page 1893.

**Normal Mapping** Applies planar maps based on different vector-projection methods.
Choosing Normal Mapping opens the Normal Mapping dialog on page 1895.

**Unfold Mapping** Unfolds the mesh so you get no face distortion, but does not guarantee that faces will not overlap.
Choosing Unfold Mapping opens the Unfold Mapping dialog on page 1926.

**Options menu**

**Load Defaults** Loads the editor settings from the file `unwrapuvw.ini` in the plugcfg directory.

**Save Current Settings as Default** Saves the editor settings to the file `unwrapuvw.ini` in the plugcfg directory. Settings saved in this way persist between sessions.

**Always Bring Up The Edit Window** When on, selecting an object with the Unwrap UVW modifier active automatically opens the Edit UVWs dialog. By default, this is off, so you must click the Parameters rollout > Edit button to open the dialog.

**Preferences** Opens the Unwrap Options dialog on page 1927.

**Display menu**

**Hide Selected** Hides all selected sub-objects and associated faces.

**Unhide All** Reveals any hidden sub-objects.

**Unfreeze All** Unfreezes any frozen sub-objects.

**NOTE** You can freeze a sub-object selection with Freeze Selected, available from the right-click menu > Display quadrant.
Filter Selected Faces When on, the editor displays UVW vertices of the viewport selection at the Face sub-object level of the modifier, and hides the rest.

This is a quick way to work on a limited selection of the texture coordinates of a complex mesh while ignoring the rest. You can turn this on, go to the Face sub-object level of the Unwrap UVW modifier, and select the portion of the object whose texture coordinates you want to edit; only those coordinates appear in the editor, and remain visible even when you change the sub-object level. To work on a different portion, return to the Face level and change the selection in the viewport; the editor window updates to the new selection automatically.

Show Hidden Edges Toggles the display of hidden face edges.

Show Edge Distortion Uses a green-to-red color range to depict distortion: how far in length texture edges are from their corresponding geometry edges. The greater the disparity in lengths (that is, the greater the distortion), the redder the edge appears in the Edit UVW dialog window. Also draws end segments of edges that are too long as white, showing the difference in length from that of the geometry edge.

Left: Texture edges the same as or very close to geometry edges in length are green.
Center: Texture edges slightly different from geometry edges in length are brown.
Right: Texture edges very different from geometry edges in length are red.

When texture edges are longer than geometry edges, white end segments depict length disparity.

Use this display as a way to view where the areas of greatest distortion are in your texture mesh. If an edge is brown or red but doesn’t have white end segments, it’s too short. If it’s brown or red and has white end segments, it’s too long, by the total length of the white segments.
**Show Vertex Connections** In Vertex sub-object mode, toggles the display of numeric labels for all selected vertices. Shared vertices are indicated by the appearance of multiple same-numbered labels.

**Show Shared Sub-objects** When turned on, for the current selection, highlights any shared vertices and/or edges. You can change the highlight color on the [Unwrap Options dialog](#) on page 1927.

### View menu

**Pan** Activates the Pan tool, which lets you move horizontally and vertically in the window by dragging the mouse.

As with the viewports, if you use a three-button mouse, you can also pan by middle-button dragging.

**Zoom** Choose Zoom, and then drag downward in the editor window to zoom out and upward to zoom in. Zooming is centered about the point you click before dragging.

If you have a wheel mouse, you can also turn the wheel to zoom. Zooming is centered about the mouse cursor location.

**Zoom Region** To zoom to a specific area, choose Zoom Region, and then drag a rectangle in the editor window.

**Zoom Extents** Zooms in or out to fit all UVW vertices in the editor window.

**Zoom Extents Selected** Zooms in or out to fit all selected UVW vertices in the editor window.

**Zoom To Gizmo** Zooms the active viewport to the current selection.

**Zoom Extents Selected** Zooms in or out to fit all selected UVW vertices in the window.

**Show Grid** Displays a grid in the background of the editor window.

Default=on.

**Show Map** Displays a texture map in the background of the editor window.

Set the image via the drop-down list at the right end of the editor toolbar.

**Update Map** Causes the displayed texture map to reflect any changes to the texture, such as tiling settings or a different bitmap.
**Unwrap UVW Shortcuts**

To use keyboard shortcuts for the Unwrap UVW modifier, the Keyboard Shortcut Override Toggle on page 8420 must be on.

See also:
- Unwrap UVW Modifier on page 1837
- Keyboard Shortcuts on page 8419
- Keyboard Panel on page 8250
- Customize User Interface Dialog on page 8249

In general, this table includes only functions that have default keyboard shortcuts and functions with descriptions that are not documented in the Unwrap UVW reference topics.

<table>
<thead>
<tr>
<th>Unwrap UVW Function</th>
<th>Keyboard Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow Selections Inside Transform Gizmo</td>
<td></td>
<td>Lets you select vertices inside the gizmo by CTRL+clicking or ALT+clicking a vertex. When turned on, you can move only by dragging over empty space.</td>
</tr>
<tr>
<td>Always Bring Up The Edit Window</td>
<td></td>
<td>When on, the Edit UVWs dialog automatically opens when you access the Unwrap UVW modifier.</td>
</tr>
<tr>
<td>Blend Tiles To Background</td>
<td></td>
<td>Lets you blend the image in the Edit UVWs dialog with the background color. At 0 the image will be hidden while at 1 it will be at full intensity.</td>
</tr>
<tr>
<td>Box Map</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unwrap UVW Function</td>
<td>Keyboard Shortcut</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>-------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Break Selected Vertices</td>
<td>Ctrl+B</td>
<td>Breaks selected vertices so no face shares them; the same as breaking a vertex in Edit Mesh.</td>
</tr>
<tr>
<td>Brightness Affects Center Tile</td>
<td></td>
<td>The brightness control for the tile of image at 0,0 of the Edit UVWs dialog.</td>
</tr>
<tr>
<td>Contract Geom. Faces</td>
<td></td>
<td>Shrinks the face selection in the viewport.</td>
</tr>
<tr>
<td>Copy</td>
<td></td>
<td>Copies the current face selection texture data into the paste buffer.</td>
</tr>
<tr>
<td>Cylindrical Map</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Detach Edge Vertices</td>
<td>D, CTRL+D</td>
<td>Detaches the selected vertices into a separate element.</td>
</tr>
<tr>
<td>Display Seams</td>
<td></td>
<td>Highlights edges that are seams in texture space in the Edit UVWs dialog. A seam is an edge that has only one face attached to it.</td>
</tr>
<tr>
<td>Edge Sel to Pelt Seam (Add)</td>
<td></td>
<td>Converts the edge selection to pelt seams, adding to the current pelt seams.</td>
</tr>
<tr>
<td>Edge Sel to Pelt Seam (Replace)</td>
<td></td>
<td>Converts the edge selection to pelt seams, replacing the current pelt seams.</td>
</tr>
<tr>
<td>Unwrap UVW Function</td>
<td>Keyboard Shortcut</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Edge Snap</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Edge to Face Select</td>
<td></td>
<td>Converts an edge selection into a face selection.</td>
</tr>
<tr>
<td>Edge to Vertex Select</td>
<td></td>
<td>Converts an edge selection into a vertex selection.</td>
</tr>
<tr>
<td>Edit UVWs</td>
<td>Ctrl+E</td>
<td>Opens the Edit UVWs dialog.</td>
</tr>
<tr>
<td>Expand Geom. Faces</td>
<td></td>
<td>Grows the face selection in the viewport.</td>
</tr>
<tr>
<td>Face to Edge Select</td>
<td></td>
<td>Converts a face selection into an edge selection.</td>
</tr>
<tr>
<td>Face to Vertex Select</td>
<td></td>
<td>Converts a face selection into a vertex selection.</td>
</tr>
<tr>
<td>Filter Selected Faces</td>
<td>Alt+F</td>
<td>When on, only faces that are selected in the viewport will be displayed in the Edit UVWs dialog.</td>
</tr>
<tr>
<td>Flatten Map</td>
<td></td>
<td>Lays out the UV space so that no texture faces overlap.</td>
</tr>
<tr>
<td>Flatten Map Dialog</td>
<td></td>
<td>Opens the dialog for Flatten Mapping settings.</td>
</tr>
<tr>
<td>Flip Horizontal</td>
<td></td>
<td>Detaches the current selection and then mirrors it in the U direction.</td>
</tr>
<tr>
<td>Unwrap UVW Function</td>
<td>Keyboard Shortcut</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Flip Vertical</td>
<td></td>
<td>Detaches the current selection and then mirrors it in the V direction.</td>
</tr>
<tr>
<td>Freeform Mode</td>
<td></td>
<td>Toggles freeform editing tool in the Edit UVWs dialog.</td>
</tr>
<tr>
<td>Freeze Selected</td>
<td>Ctrl+F</td>
<td>Locks the current selection so you cannot select it anymore.</td>
</tr>
<tr>
<td>Geom. Edge Loop Selection</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Geom. Edge Ring Selection</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Geom. Element Select Mode</td>
<td></td>
<td>Puts you in an element-select mode for selecting faces in the viewport.</td>
</tr>
<tr>
<td>Get Face Selection From Stack</td>
<td>Alt+Shift+Ctrl+F</td>
<td>Copies the face selection from the modifier stack into the face selection that Unwrap UVW uses.</td>
</tr>
<tr>
<td>Get Selection From Faces</td>
<td>Alt+Shift+Ctrl+P</td>
<td>Transfers the face selection in the viewport to the selection in the Edit UVWs dialog.</td>
</tr>
<tr>
<td>Grid Snap</td>
<td></td>
<td>Turns on grid snapping.</td>
</tr>
<tr>
<td>Grid Visible</td>
<td></td>
<td>Toggles grid visibility.</td>
</tr>
<tr>
<td>Hide Selected</td>
<td>Ctrl+H</td>
<td>Hides the current selection in the Edit UVWs dialog.</td>
</tr>
<tr>
<td>Unwrap UVW Function</td>
<td>Keyboard Shortcut</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Ignore Back Faces</td>
<td></td>
<td>When on you can select only faces in the viewport that are facing you.</td>
</tr>
<tr>
<td>Load Defaults</td>
<td></td>
<td>Loads the UI defaults from an <code>.ini</code> file.</td>
</tr>
<tr>
<td>Load UVW</td>
<td>Alt+Shift+Ctrl+L</td>
<td>Lets you load a <code>.uvw</code> file onto a mesh. The mesh must have similar topology as the source.</td>
</tr>
<tr>
<td>Lock Selected Vertices</td>
<td>Spacebar</td>
<td>Locks the selection so you cannot add to or remove from it.</td>
</tr>
<tr>
<td>Mapping Align Normals</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mapping Align To View</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mapping Align X</td>
<td></td>
<td>Aligns the mapping gizmo to the X axis of the object’s local coordinate system.</td>
</tr>
<tr>
<td>Mapping Align Y</td>
<td></td>
<td>Aligns the mapping gizmo to the Y axis of the object’s local coordinate system.</td>
</tr>
<tr>
<td>Mapping Align Z</td>
<td></td>
<td>Aligns the mapping gizmo to the Z axis of the object’s local coordinate system.</td>
</tr>
<tr>
<td>Mapping Center</td>
<td></td>
<td>Moves the mapping gizmo so that its pivot coincides with the center of the selection.</td>
</tr>
<tr>
<td>Unwrap UVW Function</td>
<td>Keyboard Shortcut</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-------------------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Mapping Fit</td>
<td></td>
<td>Scales the gizmo to the extents of the selection and centers it on the selection. Does not change the orientation.</td>
</tr>
<tr>
<td>Mapping Reset</td>
<td></td>
<td>Scales the gizmo to fit the selection and aligns it with the object's local space.</td>
</tr>
<tr>
<td>Mirror Horizontal</td>
<td>Alt+Shift+Ctrl+N</td>
<td>Mirrors the current selection along the U axis.</td>
</tr>
<tr>
<td>Mirror Vertical</td>
<td>Alt+Shift+Ctrl+M</td>
<td>Mirrors the current selection along the V axis.</td>
</tr>
<tr>
<td>Move Horizontal</td>
<td>Alt+Shift+Ctrl+J</td>
<td></td>
</tr>
<tr>
<td>Move Vertical</td>
<td>Alt+Shift+Ctrl+K</td>
<td></td>
</tr>
<tr>
<td>Normal Map</td>
<td></td>
<td>This creates a mapping based on the face normals.</td>
</tr>
<tr>
<td>Normal Map Dialog</td>
<td></td>
<td>Opens a dialog for making Normal Mapping settings.</td>
</tr>
<tr>
<td>Open Edge Mode</td>
<td></td>
<td>When turned on, selecting an open edge selects all attached open edges.</td>
</tr>
<tr>
<td>Open Edge Select</td>
<td></td>
<td>Selects all open edges connected to the current selection.</td>
</tr>
<tr>
<td>Pack</td>
<td></td>
<td>Lays out all selected elements so they don't overlap.</td>
</tr>
<tr>
<td>Unwrap UVW Function</td>
<td>Keyboard Shortcut</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Pack Dialog</td>
<td></td>
<td>Opens the Pack dialog.</td>
</tr>
<tr>
<td>Paint Select Decrement</td>
<td></td>
<td>Applies to the Sketch tool.</td>
</tr>
<tr>
<td>Cursor Size</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Paint Select Increment</td>
<td></td>
<td>Applies to the Sketch tool.</td>
</tr>
<tr>
<td>Cursor Size</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Paint Select Mode</td>
<td></td>
<td>Applies to the Sketch tool.</td>
</tr>
<tr>
<td>Pan</td>
<td>Ctrl+P</td>
<td></td>
</tr>
<tr>
<td>Paste</td>
<td></td>
<td>Pastes the contents of the paste buffer onto the selection. For best results the source and target should have similar topology.</td>
</tr>
<tr>
<td>Paste Instance</td>
<td></td>
<td>The pasted and source UVs will share the same vertices.</td>
</tr>
<tr>
<td>Pelt Always Show Seams</td>
<td></td>
<td>Toggles display of the pelt seams in the viewports.</td>
</tr>
<tr>
<td>Pelt Dialog</td>
<td></td>
<td>Opens the Pelt Map Parameters dialog</td>
</tr>
<tr>
<td>Pelt Dialog Mirror Stretcher</td>
<td></td>
<td>Mirrors the stretcher points from one side of the mirror axis to the other.</td>
</tr>
<tr>
<td>Pelt Dialog Relax Simulation</td>
<td></td>
<td>Causes a relatively strong normalization of the distances between mapping vertices.</td>
</tr>
</tbody>
</table>

UVW Mapping | 1885
<table>
<thead>
<tr>
<th>Unwrap UVW Function</th>
<th>Keyboard Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pelt Dialog Relax Simulation Light</td>
<td></td>
<td>Causes a relatively weak normalization of the distances between mapping vertices.</td>
</tr>
<tr>
<td>Pelt Dialog Reset Stretcher</td>
<td></td>
<td>Returns the stretcher and the pelt UVs to their default shape and orientation.</td>
</tr>
<tr>
<td>Pelt Dialog Run Simulation</td>
<td></td>
<td>Runs the simulation, pulling the pelt seam vertices towards the stretcher points.</td>
</tr>
<tr>
<td>Pelt Dialog Select Pelt UVs</td>
<td></td>
<td>Selects all pelt UVs.</td>
</tr>
<tr>
<td>Pelt Dialog Select Stretcher</td>
<td></td>
<td>Selects all stretcher UVs.</td>
</tr>
<tr>
<td>Pelt Dialog Snap Seams</td>
<td></td>
<td>Aligns all the stretcher points to the edge seams on the pelt UVs.</td>
</tr>
<tr>
<td>Pelt Dialog Straighten Stretcher</td>
<td></td>
<td>Lets you specify a polygonal outline for the stretcher by moving points.</td>
</tr>
<tr>
<td>Pelt Edit Seams</td>
<td></td>
<td>Lets you specify a pelt seam by selecting edges with the mouse in the viewports.</td>
</tr>
<tr>
<td>Pelt Expand Selection To Seams</td>
<td></td>
<td>Expands the current face selection to meet the pelt seam border(s).</td>
</tr>
<tr>
<td>Pelt Map</td>
<td></td>
<td>Activates pelt-mapping mode.</td>
</tr>
<tr>
<td>Unwrap UVW Function</td>
<td>Keyboard Shortcut</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Pelt Seam to Edge Sel (Add)</td>
<td></td>
<td>Converts the pelt seam to an edge selection, adding to the current edge selection.</td>
</tr>
<tr>
<td>Pelt Seam to Edge Sel (Replace)</td>
<td></td>
<td>Converts the pelt seam to an edge selection, replacing the current edge selection.</td>
</tr>
<tr>
<td>Pivot Snap ... (nine shortcuts)</td>
<td></td>
<td>Snaps the Freeform gizmo pivot to the specified gizmo edge.</td>
</tr>
<tr>
<td>Planar Map Faces/Patches Enter</td>
<td></td>
<td>Applies a planar map to the current selection.</td>
</tr>
<tr>
<td>Planar Threshold</td>
<td></td>
<td>Turns on the Modify panel &gt; Planar Angle check box.</td>
</tr>
<tr>
<td>Point to Point Edge Selection</td>
<td></td>
<td>Lets you specify pelt seams by selecting vertices with the mouse in the viewports.</td>
</tr>
<tr>
<td>Polygon Mode</td>
<td></td>
<td>Applies only to triangle meshes. When turned on (the default), if you select a triangular face, 3ds Max will select all faces that belong to the poly that owns that face.</td>
</tr>
<tr>
<td>Polygon Select</td>
<td></td>
<td>Expands the current face selection to the poly.</td>
</tr>
<tr>
<td>Unwrap UVW Function</td>
<td>Keyboard Shortcut</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Prevent Reflattening</td>
<td></td>
<td>When on, keeps Render To Texture from reflattening the mapping.</td>
</tr>
<tr>
<td>Relax</td>
<td></td>
<td>Applies the default Relax Tool settings to the current texture vertex selection.</td>
</tr>
<tr>
<td>Relax Dialog</td>
<td></td>
<td>Opens the Relax Tool dialog.</td>
</tr>
<tr>
<td>Render UVW Template</td>
<td></td>
<td>Renders the UVW coordinates to a bitmap.</td>
</tr>
<tr>
<td>Reset Pivot On Selection</td>
<td></td>
<td>When turned on (the default), the Freeform gizmo pivot is reset to the center every time the selection changes, otherwise the pivot maintains its offset.</td>
</tr>
<tr>
<td>Reset UVWs</td>
<td></td>
<td>Sets texture coordinates to the original values before Unwrap was applied.</td>
</tr>
<tr>
<td>Save Current Settings As Default</td>
<td></td>
<td>Saves current UI values to the default .ini file.</td>
</tr>
<tr>
<td>Save UVW</td>
<td></td>
<td>Lets you save the UVW data to disk as a .uvw file, which can be read in later or onto another mesh if they have similar topology.</td>
</tr>
<tr>
<td>Scale Horizontal</td>
<td></td>
<td>Scales the selection along the U axis.</td>
</tr>
<tr>
<td><strong>Unwrap UVW Function</strong></td>
<td><strong>Keyboard Shortcut</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>----------------------------</td>
<td>-----------------------</td>
<td>--------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Scale Vertical</td>
<td></td>
<td>Scales the selection along the V axis.</td>
</tr>
<tr>
<td>Select Inverted Faces</td>
<td></td>
<td>Selects any faces in the Edit UVWs dialog that are not facing you.</td>
</tr>
<tr>
<td>Select Overlapped Faces</td>
<td></td>
<td>Selects overlapping faces in the Edit UVWs dialog.</td>
</tr>
<tr>
<td>Show Edge Distortion</td>
<td></td>
<td>Uses a green-to-red color range to depict distortion.</td>
</tr>
<tr>
<td>Show Hidden Edges</td>
<td></td>
<td>Toggles display of all edges.</td>
</tr>
<tr>
<td>Show Map</td>
<td></td>
<td>Toggles display of the image map.</td>
</tr>
<tr>
<td>Show Seams in Viewport</td>
<td>Alt+E</td>
<td>Toggles display of cluster seams in the viewport. Works only when Edi UVWs dialog has focus.</td>
</tr>
<tr>
<td>Show Shared Sub-objects</td>
<td></td>
<td>Shows sub-objects that share edges/vertices.</td>
</tr>
<tr>
<td>Show Subobject Counter</td>
<td></td>
<td>Displays the number of selected objects in the editor window.</td>
</tr>
<tr>
<td>Show Vertex Connections</td>
<td></td>
<td>Tags all texture vertices that share the same geometry vertex with a unique ID.</td>
</tr>
<tr>
<td>Sketch</td>
<td></td>
<td>Activates Sketch Vertices.</td>
</tr>
</tbody>
</table>

UVW Mapping | 1889
<table>
<thead>
<tr>
<th>Unwrap UVW Function</th>
<th>Keyboard Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sketch Dialog</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sketch Reverse Vertex Order</td>
<td></td>
<td>Reverses the order of the selected vertices for Sketch mode. Applies to the Use Current Selection option for Sketch.</td>
</tr>
<tr>
<td>Snap</td>
<td>Ctrl+S</td>
<td>Toggles snapping.</td>
</tr>
<tr>
<td>Snap to Grid/Vertex/Edge</td>
<td></td>
<td>Sets the snap type.</td>
</tr>
<tr>
<td>Soft Selection Edge Distance</td>
<td></td>
<td>Equivalent to turning on Edge Distance.</td>
</tr>
<tr>
<td>Soft Selection Edge Distance Range 1</td>
<td></td>
<td>Set Edge Distance to the specified value.</td>
</tr>
<tr>
<td>Soft Selection Edge Distance Range 2</td>
<td></td>
<td>Set Edge Distance to the specified value.</td>
</tr>
<tr>
<td>Soft Selection Edge Distance Range 3</td>
<td></td>
<td>Set Edge Distance to the specified value.</td>
</tr>
<tr>
<td>Soft Selection Edge Distance Range 4</td>
<td></td>
<td>Set Edge Distance to the specified value.</td>
</tr>
<tr>
<td>Soft Selection Edge Distance Range 5</td>
<td></td>
<td>Set Edge Distance to the specified value.</td>
</tr>
<tr>
<td>Soft Selection Edge Distance Range 6</td>
<td></td>
<td>Set Edge Distance to the specified value.</td>
</tr>
<tr>
<td>Soft Selection Edge Distance Range 7</td>
<td></td>
<td>Set Edge Distance to the specified value.</td>
</tr>
<tr>
<td>Unwrap UVW Function</td>
<td>Keyboard Shortcut</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>------------------------------------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Soft Selection Edge Distance Range 8</td>
<td>- (minus sign), - (on numeric keypad)</td>
<td>Set Edge Distance to the specified value.</td>
</tr>
<tr>
<td>Spherical Map</td>
<td></td>
<td>Applies spherical mapping.</td>
</tr>
<tr>
<td>Stitch</td>
<td></td>
<td>Stitches together shared edges of a polygon.</td>
</tr>
<tr>
<td>Stitch Dialog</td>
<td></td>
<td>Opens the properties for the Stitch command.</td>
</tr>
<tr>
<td>Sync Selection Mode</td>
<td>Same as Sync to Viewport</td>
<td>Same as Sync to Viewport</td>
</tr>
<tr>
<td>Sync Texture Selection to Viewport</td>
<td></td>
<td>Synchronizes the selection in the Edit UVWs dialog to the selection in the viewport.</td>
</tr>
<tr>
<td>Sync Viewport Selection to Texture</td>
<td></td>
<td>Synchronizes the selection in the viewport to the selection in the Edit UVWs dialog.</td>
</tr>
<tr>
<td>Texture Vertex Contract Selection</td>
<td>- (minus sign), - (on numeric keypad)</td>
<td>Shrinks the selection in the Edit UVWs dialog.</td>
</tr>
<tr>
<td>Texture Vertex Expand Selection</td>
<td>= (equal sign), + (on numeric keypad)</td>
<td>Grows the selection in the Edit UVWs dialog.</td>
</tr>
<tr>
<td>Texture Vertex Move Mode</td>
<td>Q</td>
<td>Lets you move vertices in editor.</td>
</tr>
<tr>
<td>Texture Vertex Rotate Mode</td>
<td>Ctrl+R</td>
<td>Lets you rotate vertices in editor.</td>
</tr>
<tr>
<td>Texture Vertex Scale Mode</td>
<td></td>
<td>Lets you scale vertices in editor.</td>
</tr>
</tbody>
</table>

UVW Mapping | 1891
<table>
<thead>
<tr>
<th>Unwrap UVW Function</th>
<th>Keyboard Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Texture Vertex Weld Selected</td>
<td>Ctrl+W</td>
<td>Welds selected vertices in editor.</td>
</tr>
<tr>
<td>Texture Vertex Target Weld</td>
<td>Ctrl+T</td>
<td>Lets you target-weld selected vertices in editor.</td>
</tr>
<tr>
<td>TV Edge Sub-object Mode</td>
<td></td>
<td>TV=Texture Vertex</td>
</tr>
<tr>
<td>TV Element Mode</td>
<td></td>
<td>TV=Texture Vertex</td>
</tr>
<tr>
<td>TV Face Sub-object Mode</td>
<td></td>
<td>TV=Texture Vertex</td>
</tr>
<tr>
<td>TV Vertex Sub-object Mode</td>
<td></td>
<td>TV=Texture Vertex</td>
</tr>
<tr>
<td>Unfold Map</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unfold Map Dialog</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unfreeze All</td>
<td></td>
<td>Unfreezes all frozen elements.</td>
</tr>
<tr>
<td>Unhide All</td>
<td></td>
<td>Unhides all hidden elements.</td>
</tr>
<tr>
<td>Unwrap Options</td>
<td>Ctrl+O (letter “o”)</td>
<td></td>
</tr>
<tr>
<td>Update Map</td>
<td>Ctrl+U</td>
<td>Updates map in editor.</td>
</tr>
<tr>
<td>UV Edge Mode</td>
<td></td>
<td>When on, selecting an edge expands the selection to include all edges in its loop on page 1865.</td>
</tr>
<tr>
<td>UV Edge Select</td>
<td></td>
<td>Expands an existing edge selection to include all</td>
</tr>
<tr>
<td>Unwrap UVW Function</td>
<td>Keyboard Shortcut</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>edges in its loop on page 1865.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vertex Snap</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vertex To Edge Select</td>
<td></td>
<td>Converts vertex selection to an edge selection and puts you in Edge mode.</td>
</tr>
<tr>
<td>Vertex To Face Select</td>
<td></td>
<td>Converts vertex selection to a face selection and puts you in Face mode.</td>
</tr>
<tr>
<td>Zoom</td>
<td>Z</td>
<td></td>
</tr>
<tr>
<td>Zoom Extents</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Zoom Extents Selected</td>
<td>Alt+Ctrl+Z</td>
<td></td>
</tr>
<tr>
<td>Zoom Region</td>
<td>Ctrl+X</td>
<td></td>
</tr>
<tr>
<td>Zoom Selected Element</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Zoom to Gizmo</td>
<td>Shift+Spacebar</td>
<td></td>
</tr>
</tbody>
</table>

**UVW Editor Dialogs**

These topics describe support dialogs for the Unwrap UVW modifier.

**Flatten Mapping Dialog**

Select an object. > Modify panel > Modifier List > Object-Space Modifiers > Unwrap UVW > Edit button (on Parameters rollout) > Mapping menu > Flatten Mapping
The Flatten Mapping method of procedural mapping applies planar maps to groups of contiguous faces that fall within a specified angle threshold. It prevents overlap of mapping clusters, but can still cause texture distortion. The Flatten Mapping dialog lets you control how clusters are defined and mapped.

See also:

- Normal Mapping Dialog on page 1895
- Unfold Mapping Dialog on page 1926

Interface

![Flatten Mapping dialog](image)

**Face Angle Threshold** The angle used to determine the clusters to be mapped. As the Flatten Map gathers faces to be mapped, it uses this parameter to determine which faces get put in a cluster. This is the maximum angle that can exist between faces in a cluster.

The higher this number, the larger the clusters will be, with consequently greater distortion introduced as a result of texture faces' proportions deviating from their geometry-equivalent faces.

**Spacing** Controls the amount of space between clusters.

The higher this setting, the larger the gap that appears between clusters.

**Normalize Clusters** Controls whether the final layout will be scaled down to 1.0 unit to fit within the standard editor mapping area. If this is turned off, the final size of the clusters will be in object space, and they'll probably be much larger than the editor mapping area. For best results, leave this turned on.
Rotate Clusters Controls whether clusters are rotated to minimize the size of their bounding box. For instance, the bounding box of a rectangle rotated 45 degrees occupies more area than one rotated 90 degrees.

Fill Holes When turned on, smaller clusters will be placed in empty spaces within larger clusters to take the most advantage of the available mapping space.

By Material IDs When on, ensures that no cluster contains more than one material ID after flattening.

OK Accepts the settings, closes the dialog, and performs the mapping as specified.

Cancel Undoes any changes and closes the dialog.

Set As Default Makes the current settings the defaults for the current session.

Normal Mapping Dialog

Select an object. > Modify panel > Modifier List > Object-Space Modifiers > Unwrap UVW > Edit button (on Parameters rollout) > Mapping menu > Normal Mapping

The Normal Mapping method of procedural mapping applies planar maps based on different vector-projection methods. It is the most straightforward method, but can result in even greater texture distortion than with Flatten mapping on page 1893. The Normal Mapping dialog lets you control how clusters are defined and mapped.

See also:

- Flatten Mapping Dialog on page 1893
- Unfold Mapping Dialog on page 1926
Interface

![Normal Mapping Interface](image)

(drop-down) Sets the mapping method:
- Back/Front
- Left/Right
- Top/Bottom
- Box No Top
- Box
- Diamond

Spacing Controls the amount of space between clusters. The higher this setting, the larger the gap that appears between clusters.

Normalize Clusters Controls whether the final layout will be scaled down to 1.0 unit to fit within the standard editor mapping area. If this is turned off, the final size of the clusters will be in object space, and they'll probably be much larger than the editor mapping area. For best results, leave this turned on.

Rotate Clusters Controls whether clusters are rotated to minimize the size of their bounding box. For instance, the bounding box of a rectangle rotated 45 degrees occupies more area than one rotated 90 degrees.

Align By Width Controls whether the width or the height of the clusters is used to control the layout of the clusters.

OK Accepts the settings, closes the dialog, and performs the mapping as specified.
Cancel Undoes any changes and closes the dialog.

Set As Default Makes the current settings the defaults for the current session.

Pack UVs Dialog

Select an object. > Modify panel > Modifier List > Object-Space Modifiers > Unwrap UVW > Edit button (on Parameters rollout) > Tools menu > Pack UVs

The Pack UVs dialog contains controls for clusters.

Interface

(dropdown) Sets the packing method:

- **Linear Packing** Uses a linear method to lay out the faces. This method is fast but not very efficient, and tends to leave a lot of unused UV space.

- **Recursive Packing** Slower than the Linear method, but packs the faces more efficiently.

**Spacing** Controls the amount of space between clusters.

The higher this setting, the larger the gap that appears between clusters.

**Normalize Clusters** Controls whether the final layout will be scaled down to 1.0 unit to fit within the standard editor mapping area. If this is turned off, the final size of the clusters will be in object space, and they’ll probably be much larger than the editor mapping area. For best results, leave this turned on.
**Rotate Clusters** Controls whether clusters are rotated to minimize the size of their bounding box. For instance, the bounding box of a rectangle rotated 45 degrees occupies more area than one rotated 90 degrees.

**Fill Holes** When turned on, smaller clusters will be placed in empty spaces within larger clusters to take the most advantage of the available mapping space.

**OK** Accepts the settings, closes the dialog, and performs the packing as specified.

**Cancel** Undoes any changes and closes the dialog.

**Set As Default** Makes the current settings the defaults for the current session.

---

**Pelt Map Parameters Dialog**

Unwrap UVW Modifier > Face sub-object level > Map Parameters rollout > Pelt > Edit Pelt Map

*Pelt mapping* on page 1853 is useful for mapping organic models such as characters and creatures. This feature gives you a special editor with a virtual stretcher and springs that let you easily “pull” a complex UVW map flat. The result more closely approximates the actual shape of the object than other mapping methods, making it easier to create convincing texture maps.

The primary function of the Pelt Map Parameters dialog is to let you stretch out the UVW coordinates into a flat, unified map that you can then use for texturing. When the dialog is open, the *stretcher* appears in the Edit UVWs dialog window as a circle of points, each of which is attached to a vertex on a pelt seam. You can manipulate these vertices exactly as any other vertex in the editor, selecting, rotating, moving, etc. Other special functions available on the dialog let you straighten out stretcher vertices, snap them to the pelt seams, and so on.
The stretcher points surround the pelt UVs in the Edit UVWs dialog window.

The lines connecting the stretcher vertices to the pelt-seam vertices function as springs that pull the pelt seams outward in an animated simulation. After you set up the pelt UVs and the stretcher shape, you run the simulation by clicking the Simulate Pelt Pulling button. Depending on the results, further adjustment and simulation might be required.

While Pelt mode is active and the Edit UVWs dialog is open, most standard UVWs editing functions are also available. So, for example, instead of stretching the entire pelt, you could select a subset of UVs to stretch. To access any commands that are unavailable in Pelt mode, such as Mapping menu commands, simply close the Pelt Map Parameters dialog.
Procedure

To use Pelt mapping:

1. Apply Unwrap UVW to the object.

2. Make an edge selection that you can later convert to pelt seams. It's not absolutely necessary to do this at this point, but the Edge sub-object level of the modifier gives you handy Ring and Loop tools as well as buttons to expand and shrink the edge selection automatically.

   **TIP** Creating the pelt seams is more art than exact science. Visualize the way the mesh should lie flat, and then select edges so the UVs can split in a natural way.

3. Go to the Face sub-object level of the modifier and select the faces to pelt map. To select all faces, press Ctrl+A. If you're not pelt-mapping the entire mesh, you can skip this step.

4. If you made an edge selection in step 2, click Map Parameters rollout > Edge Sel To Seams. This copies the edge selection to pelt seams. If you didn't specify the pelt seams at the Edge sub-object level of the modifier, turn on Edit Seams or Point To Point Seam and then specify seams in the viewports.

   The pelt seams appear on the mesh as blue lines.

5. If you're not pelt-mapping the entire mesh, you probably want to map a region enclosed by a pelt seam. Click a face within the region to map and then click Exp. Face Sel to Pelt Seams.

   This expands the face selection to the full size of the region defined by the pelt seam.

   **NOTE** You can pelt map only one such region at a time.

6. On the Map Parameters rollout, click Pelt.

   This opens the Pelt Map Parameters dialog. It also opens the Edit UVWs dialog, if necessary, and displays the pelt UVWs and the stretcher in the editor window. By default, the stretcher appears as a circle of points centered on the pelt UVWs, with only the stretcher vertices selected. Also, springs, represented as dashed lines, connect the stretcher points and the pelt-seam vertices.
7 If necessary, rotate the Pelt UVs so that the mapping coordinates are oriented correctly, and rotate the stretcher so that the springs form a symmetrical pattern. Typically you're looking for left-right symmetry.

**TIP** Using Ctrl+click adds to the existing selection, as in the viewports.

8 On the Pelt Map Parameters dialog, click Start Pelt.

The springs contract, pulling the pelt seam vertices toward the stretcher points. The internal UV vertices are also affected by this action. You can adjust the extent to which they're affected with the Decay setting on the Pelt Options rollout.

9 The simulation runs continuously until you stop it by clicking the Stop Pelt button. Do so when you’re satisfied with the solution, or would like to adjust something.

10 Continue adjusting the stretcher points, mapping vertices, dialog settings, etc., and re-running the solution until you get the desired results. If things get out of hand, simply undo, or click Reset and start over.

**Interface**

The primary Pelt Map commands are activated via the buttons on the Quick Pelt rollout. Other functions on this dialog let you adjust various stretching parameters.
Quick Pelt rollout

These are the main controls for the simulation, in which the springs attached to the stretcher pull the pelt seam vertices out, flattening the UVs. For best
results, alternate between running the simulation (click Start Pelt) and relaxing the mesh.

**Pelt group**

**Start Pelt** Runs the simulation, pulling the pelt seam vertices towards the stretcher points. The simulation runs continuously until you stop it by pressing Esc or clicking Stop Pelt (the same button). You can also stop it by clicking Reset, or Commit or Cancel at the bottom of the dialog.

Pelt affects only selected texture vertices. However, if no texture vertices are selected, it affects all of them.

**Reset** Stops the simulation if it’s running, and returns the pelt and stretcher to their original condition.

You can also reset the pelt by exiting pelt mapping mode by clicking either Commit or Cancel, and then clicking the Pelt button again.

**Simulation Samples** The number of samples around each pelt-seam point used in the simulation. A higher value results in a greater pulling effect. Default=5. Range=1 to 50.

**Show Local Distortion** When on, depicts the differences between texture vertices and mesh vertices for visible faces; that is, faces selected in the viewport when Filter Selected Faces on page 1862 is on. For more information, see Show Edge Distortion on page 1877.

Normally, when showing edge distortion, 3ds Max takes the entire mesh into account. This can result in an unrealistic depiction of distortion when you use pelt mapping on only part of a mesh (for example, the head of a character). For a more accurate depiction of distorted edges with respect to the part of the mesh that you’re currently pelt-mapping, turn on this option, turn on Filter Selected Faces, and select in the viewport only the faces that you’re currently pelt-mapping.

**Relax group**

**Start Relax** Normalizes the distances between mapping vertices. The relaxation process runs continuously until you stop it by pressing Esc or clicking Stop Relax (the same button).

Relax affects only selected texture vertices. However, if no texture vertices are selected, it affects all of them.

**Settings** Opens the Relax Tool dialog on page 1906 for setting relax parameters. While this dialog is open, you can start the relax by clicking its buttons or the Start Relax button on the Pelt Map dialog.
Pelt Options rollout

Stretcher group

These tools help adjust the stretcher shape.

**Straighten Stretcher** Lets you specify a polygonal outline for the stretcher by moving points. When this mode is active, move one stretcher vertex, and then move a second, non-adjacent point to line up all intervening vertices in a straight line between the two. This process is fully interactive; as you move the second vertex, the intervening vertices continually change position to maintain the straight line. Continue moving vertices to create a polygonal outline; to quit, click Straighten Stretcher again.

**NOTE** While Straighten Stretcher is active, you can pan and zoom the editor window at any time using contextual controls (middle-button drag or turn mouse wheel, respectively) to access a different part of the window. After doing so, 3ds Max still remembers the last vertex you dragged and draws a straight line between it and the next one you drag. Similarly, you can adjust the window using the control buttons on page 1862 and then return to straightening the stretcher. If the control requires more than a single click, such as Pan, exit the control by right-clicking in the window and then return to straightening the stretcher.

**TIP** To create a symmetrical outline for the stretcher, create the outline on one side and then use Mirror Stretcher (see following).

**Snap To Seams** Aligns all the stretcher points to the edge seams on the pelt UVs. This causes the stretcher to take on the pelt outline.

**TIP** For best results, use this command only after stretching.

**Mirror Stretcher** Mirrors the stretcher points from one side of the mirror axis (see following) to the other. By default, Mirror Stretcher mirrors the points from the right side to the left.

**Mirror Axis** Lets you specify the orientation of the mirror axis. The axis takes the form of three yellow lines forming a T. The leg of the T indicates the side that will be mirrored when you use Mirror Stretcher (see preceding), and the crossbar indicates the axis across which the mirroring will occur. Default=0.0. Range=0.0 to 360.0.
Select group

These commands let you select all the stretcher points or the pelt UVs. As with other selection methods, you can press and hold Ctrl when you use either of these to add to the current selection. That is, to select all stretcher points and pelt UVs, click one button, press and hold Ctrl, and then click the other button.

Select Stretcher Selects all stretcher points.

Select Pelt UVs Selects all pelt texture vertices.

Springs group

These parameters control the springs that are used to stretch the pelt. In most cases you won’t need to change these values, except possibly for Pull Strength.

Pull Strength The magnitude of the stretching action when you click Simulate Pelt Pulling. Default=0.1. Range=0.0 to 0.5.

If the stretching is too gradual, increase Pull Strength for a more forceful stretching action.

Dampening Applies a dampening or inhibiting factor to the pulling action. The higher the Dampening value, the greater the inhibition of the stretcher. Default=0.16. Range=0.0 to 0.5.

Stiffness Sets the rate at which the springs pull. The higher the Stiffness value, the more abrupt the pulling action. Default=0.16. Range=0.0 to 0.5.

Decay The rate of falloff of the influence of each pelt-seam vertex on the other mapping vertices. Higher Decay values typically result in significantly greater stretching, or undesirable results. For best results, keep the Decay value low. Default=0.25. Range=0.0 to 0.5.

Lock Open Edges Locks the open edges in place. This typically applies to using the stretcher on a partial selection of mapping vertices in the pelt region. When Lock Open Edges is on, selected vertices next to unselected vertices tend to stay in place during stretching. When Lock Open Edges is off, the selected vertices tend to pull away from the unselected vertices.

Commit/Cancel

Commit Saves changes and closes the dialog.

Cancel Discards changes and closes the dialog.
Relax Tool Dialog

Select an object. > Modify panel > Modifier List > Object-Space Modifiers > Unwrap UVW > Edit button (on Parameters rollout) > Edit UVWs dialog > Make a selection. > Tools menu > Relax Dialog

The Relax Tool dialog offers an advanced toolset for modifying the spacing of selected texture coordinates parametrically, for the purpose of eliminating or minimizing distortion in texture maps.

The dialog provides three different methods for relaxing vertices, plus several numeric parameters and two check boxes. You can use Relax to separate texture vertices that are too close together to texture easily, and to resolve overlapping areas.

The dialog is non-modal, which means that you can work directly in the editor while keeping the dialog open. You can make a selection of texture vertices, apply relaxation, make a different selection, apply relaxation, and so on, without having to close the Relax Tool dialog.

**TIP** When using Relax with complex objects, you might find that vertices in interior sections of the texture mesh don’t relax properly because they have nowhere to go. In such cases, try making a seam: Select an edge loop or part of a loop, and then use the Break on page 1874 function to separate the mesh at the seam. Alternatively, you could make a face selection and then use Detach Edge Verts. For example, Select Overlapped Faces > Expand Selection > Detach Edge Verts will break the selection away from the mesh into a new UV element.

**TIP** Effective use of the Relax tools requires that the geometry and texture vertices be in the same order. If you get unexpected results using Relax, try mirroring the texture vertices to reverse their order.

Procedures

To relax texture coordinates:

1. Use the Edit UVWs dialog to select the texture-coordinate vertices to relax.
   
   You can make this selection at any sub-object level (Vertex, Edge, or Face), but Relax always works on vertices.

2. On the Tools menu, choose Relax Dialog.
This opens the Relax Tool dialog.

3 Choose the relax method. Three are available from the drop-down list:
   ■ Relax By Face Angles
   ■ Relax By Edge Angles
   ■ Relax By Centers

   The default method is Relax By Edge Angles; this usually gives the best results.

4 Do either of the following:
   ■ Set the other options and then click Apply. This applies the Amount and Stretch settings for the specified number of iterations. As the relaxing progresses, a message appears showing you which frame is being processed. A frame is equivalent to an iteration.

   ■ Click Start Relax. This ignores the Iterations setting and initiates a continuous relax process, during which you can change any of the other parameters to see the results in real time.

The appropriate relax method and other settings depend on a variety of conditions, including the complexity and topology of the mesh, so experimentation is usually required. Relaxing is undoable, so if one method doesn't work, undo and try another.
To use Relax to fix overlapping faces:

This procedure provides general guidelines for resolving overlapping texture faces. It might not work in every case, but it should give you a starting point for correcting most situations.

1. Open the Edit UVWs dialog and in the Selection Modes group, click Face Sub-object Mode.

2. From the Edit UVWs dialog > Select menu, choose Select Overlapping Faces.
   Only the overlapping faces are selected.

3. Click Expand Selection to select faces surrounding the overlapping faces.
   This gives the overlapping faces a larger area in which to spread out.

4. From the Tools menu, choose Relax Dialog.

5. On the Relax Tool dialog, set Stretch to an intermediate value. If the overlapping is considerable, use 0.5 or higher. If it's relatively small, try 0.1 to 0.3.

6. Click Apply.
   If this seems to help, continue clicking Apply, or just click Start Relax, and wait until the overlapping is resolved. If not, undo (Ctrl+Z) and try using Relax By Face Angles instead, or increase the Amount value, or change the Stretch value, or use combinations of the above.
Interface

[relax method] The method used to relax the texture vertices. Choose from the drop-down list:

- **Relax By Face Angles**  Relaxes the vertices based on the shape of the faces. It tries to align the geometric shape of the face to the UV face. This algorithm is mainly used to remove distortion and not so much to remove overlap, and is best suited for simpler shapes.

- **Relax By Edge Angles**  This default method is similar to Relax By Face Angles except that it uses the edges that are attached to the vertices as the shape to match. It typically works better than Relax By Face Angles but tends to take longer to reach a solution. This method is best suited for more complex shapes.

- **Relax By Centers**  The original Relax method from previous versions of 3ds Max. It relaxes vertices based off the centroids (centers of mass) of their faces. It does not take into account the face or edge shapes/angles so it is mainly useful for removing overlap or for faces that are mostly rectangular.

**Iterations** The number of times the Relax settings are applied when you click Apply. Each iteration is applied successively, to the results of the previous iteration. Range=0 to 100000, Default=100.

**Amount** The strength of the relaxation applied per iteration. Range=0.0 to 1.0. Default=0.1.

**Stretch** The amount of stretching that can occur. Stretching is useful mainly to resolve overlapping texture vertices, at the cost of reintroducing distortion into the texture mesh. Range=0.0 to 1.0. Default=0.0.
Keep Boundary Points Fixed Controls whether vertices at the outer edges of the texture coordinates are moved. Default=off.
When off, the outer edge of the texture mesh can float, allowing a wider range of the available texture-mapping space to be used. Typically you would keep this off when relaxing an entire element or cluster, so 3ds Max can minimize distortion by moving the edges.
When relaxing an interior subset of vertices, it is recommended you turn this on to prevent the selected vertices from overlapping unselected vertices. For Relax By Edge and Face Angles, turn this off until you get a good solution for the outer boundaries of the mesh and then turn it on to resolve the interior sections.

Save Outer Corners Preserves the original positions of texture vertices farthest away from the center. Available only with the Relax By Centers method.

Start Relax Initiates the relax process on a continuous basis, ignoring the Iterations setting. During this time, you can change the other dialog settings and see the results in real time.
To halt the relax process, click outside the dialog, press Esc, or click the same button (“Stop Relax”). To revert to the previous mapping, use Undo (Ctrl+Z).

Apply Begins the relaxation process using the current settings. As relaxation takes place, a textual progress indicator appears at the bottom of the dialog, showing the current iteration (Process frame) and the total number of iterations being processed.
To abort the relaxation process, press Esc. You can then use Undo (Ctrl+Z) to return to the prior state, if necessary.

Set As Default Saves all current settings as the Relax defaults, so they are recalled from session to session.

Render UVs Dialog

Unwrap UVW modifier > Edit button (on Parameters rollout) > Tools menu > Render UVW Template

The Render UVs dialog, part of the Unwrap UVW editor on page 1856, lets you export a model's texture mapping data as a template; a bitmapped image file. You can then import this template into a 2D paint program, apply color as needed, and then bring it back into 3ds Max as a texture map to apply to the model. The exported file looks like a screen shot of the editor window, but without any background texture, and has the added options of setting color and alpha options for both the edges and the area they cover.
For a procedure that covers usage of this dialog, see To export texture coordinates to a paint program: on page 1844.

**Interface**

**Width/Height** The horizontal and vertical dimensions of the output (rendered) template image in pixels.

**Guess Aspect Ratio** Adjusts the Height value to produce an output aspect ratio based on the Width value and the dimensions of the UV grid.

For instance, if a rectangular UV grid measures 20 x 100 units and you click Guess Aspect Ratio, it would try to keep the bitmap at the 1:5 aspect ratio. This makes painting on the bitmap easier because the bitmap is at the correct aspect ratio for the mesh.
WARNING Using this function can result in Height value that is not a power of 2. If your mesh is destined for a real-time renderer, adjust the resulting Height value to the nearest power of 2 after using Guess Aspect Ratio. For example, if it sets Height to 650, change it to 512 before rendering the template.

Force 2-Sided When on, all UV edges are rendered into the template. When off, only UV edges of faces facing the viewer are included; edges of back-facing faces are not rendered.

Fill group

Fill is the coloring applied to the rendered bitmap in the face areas between edges. By default, there's no fill; the bitmap color is black, and the alpha channel is fully transparent. You can change this to a solid color or to shading derived from the mesh and lighting in the scene, or from the normal directions.

NOTE The overlap color overrides the fill color. For example, if Show Overlap is on and all visible faces overlap other faces, all faces will show the overlap color, ignoring the fill color.

[color swatch] Shows the fill color used for faces when Mode is set to Solid. To change the color, click the swatch.

Alpha Sets the alpha-channel value for the fill areas when Mode=Solid, Normal, or Shaded. When Mode=None, the fill alpha is always 0.0 (transparent). Range=0.0 (transparent) to 1.0 (opaque). Default=1.0.

The alpha channel is included with the rendered image only when you save in a format that supports transparency, such as TIF or Targa.

Mode Specifies the method used for filling faces in the rendered template.

■ None: No fill is rendered. This setting ignores the Alpha value, and sets fill alpha to 0.0; that is, fully transparent.

■ Solid: Renders faces using the fill color specified by the swatch at the top of the Fill group.

■ Normal: Renders each vertex's normals into the bitmap. The result looks similar to a normal map.

■ Shaded: Uses a simple lighting setup to render shading across the UV surface.

Show Overlap When on, fills faces that overlap other faces with the overlap color, shown in the color swatch to the right. Default=on.
To change the overlap color, click the color swatch.

**Edges group**

[**color swatch**] Shows the color used for rendered edges. To change the color, click the swatch.

**Alpha** Sets the alpha-channel value for edges. Range=0.0 (transparent) to 1.0 (opaque). Default=1.0.

The alpha channel is included with the rendered image only when you save in a format that supports transparency, such as TIF or Targa.

**Visible Edges** When on, edges are rendered using the specified edge color. Default=on.

**Invisible Edges** When on, hidden edges are rendered using the specified edge color. Default=off.

Hidden edges are most often found dividing mesh polygons into triangles. They aren't present in polygon objects.

**Seam Edges** When on, seam (outside) edges are rendered using the specified seam color. Default=on.

To change the seam color, click the color swatch. The default color (green) is the same as that used for seam edges in the Edit UVWs dialog, but the two can be changed separately.

---

**Render UV Template** Renders the template bitmap in a new rendered frame window on page 6513.

To save the rendered frame, click the Save Bitmap button.

---

**NOTE** This command renders the normalized UV space, from (0,0) to (1,1), as depicted in the editor by a dark blue outline. For best results, make sure the texture UVs fill this space but don't exceed its bounds.

---

**TIP** To turn off the background texture, which tends to obscure the UV space outline, click the Show Map button on the upper toolbar.
Sketching Tool Dialog

Select an object. > Modify panel > Modifier List > Object-Space Modifiers > Unwrap UVW > Edit button (on Parameters rollout) > Tools menu > Sketch Vertices

If you need to match a contiguous selection of texture vertices to an outline in a bitmap, whether an irregular shape, a straight line, or a geometric shape, you can use the Sketch tool to perform the operation quickly, rather than dragging the vertices one at a time.

Procedures

Example: To sketch texture vertices free form:

You can start with the vertices already selected, or use the Sketch tool to select them. In this example, we’ll assume the latter.

1. Choose Sketch Vertices.
2. In the Sketch Tool dialog, next to Select By, choose Drag Selection, if necessary.
3. Next to Align To, choose Free Form, if necessary.
4. Make sure Show Vertex Order and Interactive Mode are turned on. Leave Drag Cursor Size at the default setting.
5. Click OK to close the dialog.
   The mouse cursor takes the form of a circle, which means you’re in “drag select” mode.
6. In the editor window, drag the cursor over the vertices to select, and then release the mouse button.
   As you drag, each vertex is assigned a consecutive number. When you release the mouse button, the cursor turns into a pencil, which means you’re in “sketch” mode.

   **NOTE** Before you start sketching, each successive mouse click alternates between drag and sketch modes.

7. In the editor window, drag a wavy line.
   The selected vertices follow the line in numeric order, spreading out evenly over its length. To start the sketch over, release the mouse button, and then drag again.
Alternatively, if you press and hold Alt, and then press and release the mouse button, you'll draw a straight line by moving the mouse. Click and move again to draw connected straight-line segments.

You can combine free-form and straight-line sketching freely:

- To append a free-form line to a straight-line segment, release the Alt key and then begin dragging.
- To append a straight-line segment to a free-form line, press and hold Alt as you drag, and then release the mouse button and move the mouse.

8 To exit the Sketch tool, right-click in the editor window.

Interface

Select by lets you choose how to select the vertices to sketch:

- **Pick Selection** lets you pick the vertices one by one. When you click OK, a Pick cursor appears comprising a + sign and the letter P; when the cursor is over a vertex, the + sign becomes larger. To finish picking, right-click, and then drag to sketch. After sketching, you return to Pick mode, and so on. To exit, right-click.

- **Drag Selection** lets you pick multiple vertices by dragging. When you click OK, the mouse cursor appears as a circle. After you drag to select vertices, release the mouse button, and then drag (or Alt+click) to sketch. As with Pick Selection, the mouse cursor continues to alternate between Select and Sketch modes until you right-click to exit.
Use Current Selection  Uses the current selection; you cannot change the selection while using the tool. If the current selection is edges or faces, Sketch uses all vertices attached to selected sub-objects.

Align To  Lets you choose how to sketch:
- Free Form  Drag to sketch free form (like drawing with a pencil), or Alt+click to sketch connected
- Line  Drag to sketch a single, straight line segment.
- Box  Drag diagonally to sketch a rectangle.
- Circle  Drag outward to sketch a circle, and then move the mouse in a circle to rotate the circle.

Show Vertex Order  Displays numbered labels that indicate the order in which vertices were selected and will spread out during sketching.

Interactive Mode  Shows vertex positioning as you sketch. Turn off for faster feedback.

Drag Cursor Size  Sets the size of the mouse cursor used while dragging a selection. Default=8. Range=1 to 15.

OK  Accepts the changes and closes the dialog.

Cancel  Undoes any changes and closes the dialog.

Set As Default  Makes the current settings the defaults for the current session.

Spline Map Parameters Dialog

Unwrap UVW Modifier > Face sub-object level > Map Parameters rollout > Spline

Spline mapping on page 1853 is useful for mapping curved objects with a cylindrical cross-section, such as a snake or tentacle, as well as curved flat surfaces such as a winding road. This feature lets you use any spline to specify mapping on a mesh surface, as well as manipulate the mapping gizmo via cross-sections for greater accuracy. The result more closely approximates the actual shape of such objects than other mapping methods, making it easier to create convincing texture maps.

The following illustration shows two objects that were created by extruding a circular polygon along an S-shaped spline. Such objects have no native
mapping coordinates. The object on the left uses simple planar mapping, with the plane parallel to its largest dimension. The object on the right uses spline mapping, with the spline (also used to extrude the polygon) inside the object.

Working with Cross-sections

You can adjust spline mapping in two ways:

- **By manipulating the assigned spline.** To use this method, you must exit the modifier, select the spline, and then transform it or its sub-objects (typically the vertices). To see the results of such manipulation, you must re-select the mapped object, go to the Face sub-object level, and then click the Spline button.

- **By manipulating the cross-sections in the Unwrap modifier.** This is the recommended method because it provides better feedback. Thus, it is important to make sure the spline fits the mapped object well before applying the spline mapping. If you have problems manipulating the cross-sections, sometimes the fastest way to recover is to delete the Unwrap UVW modifier and start fresh with a new one.
When manipulating cross-sections, keep the following points in mind:

- When Spline mode is active (that is, the Spline Map Parameters dialog is open), you can select and transform only cross-sections. To select cross-sections, use standard methods, such as clicking, Ctrl+clicking, region-selecting, and, to select all cross-sections, Ctrl+A. Selected cross-sections are yellow, and unselected ones are orange.

- All cross-section transforms take place in the Local coordinate system.

- Moving a cross-section on the Z axis always moves it along the length of the spline used for mapping. However, doing so does not change the mapping between the moved cross-section and the next one. For example, moving a cross-section closer to its neighbor does not compress the intervening texture coordinates. The main reason for having cross-sections close together is for finer control over mapping within complex areas of the model.

- With the Planar mapping method, it’s important to use well-formed mesh objects; that is, objects without narrow bends, with evenly spaced tessellating edges that cross the “track” perpendicular to its sides. In particular, avoid objects with the following two characteristics:
  - Narrow bends. In particular, this type of shape can cause tessellating edges that connect to the same side instead of crossing the “track,” as shown in the following illustration.
“Fan” edges, where several edges share a single endpoint. This can cause the type of mapping anomalies shown in the following illustration.
Procedure

To use Spline mapping:

1. Create a mesh object to map, and a spline with which to specify the mapping. Position the spline *inside* the mesh object. For best results, always center the spline inside the mesh.

   **TIP** To create the spline from a series of edges, use *Create Shape from Selection* on page 2285.

2. Apply Unwrap UVW to the mesh object.

3. Go to the Face sub-object level, and then select the faces to map. To map the entire object (that is, all faces), leave all faces unselected.


5. Click the Pick Spline button, and then select the spline to use for mapping. Either click the spline in the viewport or press H and select it by name. At this point, or if you already applied a spline, the mapping gizmo appears around the spline, showing the outlines and cross-sections.
If necessary, modify the mapping by transforming the cross-sections in the viewports and adjusting the Spline Map Parameters dialog settings. Keep in mind that changes affect only the mapping on selected faces, unless no faces are selected, in which case changes affect the mapping on all faces.

If you use the Planar mapping method, make sure the cross-sections are parallel to the flat surface. One way to do so is to select all the cross-sections (press Ctrl+A), then click the Align To: Face button, and then click a face on the surface.
Interface

**Spline group**

These settings are for overall mapping.

**Pick Spline** Lets you specify a spline to use for mapping. Click this button and then select the spline. After you specify the spline, its name appears in the space above the button.

If the spline contains several elements, the element used for mapping is the one you click.

**Mapping** Lets you specify how the modifier projects the map onto the mesh.

- **Circular** Use for objects with a circular cross-section, like a tube. With circular projection, the cross-sections are circular by default. You can change the mapping by transforming these cross-sections. For example, you can create a spiral mapping effect by rotating the cross-sections around their local Z axes by successively greater amounts.

- **Planar** Use for flat objects, like a road.
With planar projection, the cross-sections are lines. For best results, make sure the cross-sections are parallel to the mesh surface, and perpendicular to the spline used for mapping. In most cases, this happens by default.

**Use Manual Seams** When on, uses the pelt seam on page 1854 as the texture border. When off, uses the green seam line built in to the spline-mapping gizmo.

This option is available only with Circular mapping, and works best with relatively simple objects with open ends.

**Cross Section group**

After you assign a spline in the Spline group (see preceding), 3ds Max applies the spline mapping to the object, creating a cross-section for each vertex in the spline. The settings in this group let you manipulate the cross-sections. To select a cross-section, click it. To select all cross-sections, press Ctrl+A.

In Spline mode you can transform selected cross-sections in the local coordinate system, moving, rotating, and scaling them as you like to adjust the texture coordinates.

**NOTE** If you have two cross-sections close together with very different orientations or scaling values, the mapping might show visual anomalies (such as pinched UVs) as the Unwrap modifier interpolates quickly from one section to the next.

**Fit** Resizes selected cross-sections to match the adjacent geometry.

**NOTE** With asymmetrical geometry, Fit might give unexpected results because it adjusts the cross-section to the closest parts of the neighboring geometry along the cross section's local X and Y axes. In such cases, you might need to transform the cross-section manually to get the best fit.

**Add** Lets you add cross-sections for finer control over the interpolation of the mapping between cross-sections. Click this button and then click the spline where you want to add a cross-section. The mouse cursor changes to a crosshairs when over the spline. Continue adding cross-sections as necessary, and then click the button again to exit Add mode.

**Remove** Deletes any selected cross-sections. The end cross-sections cannot be deleted.

**Align To:**

- **Section** Aligns the selected cross-sections to another cross-section. Select the cross-sections to align, click Section, and then click the target.
cross-section. Aligned cross-sections pick up the orientation and scale of
the target.

- **Face**  Aligns the selected cross-sections to a mesh face on the modified
  object. Select the cross-sections to align, click Face, and then click the face
to align them to.
  This tool is most useful with Planar mapping.

**Reset Count to**  Lets you specify the number of evenly spaced cross-sections.
Set the numeric value and then click the Reset Count To button.
This tool is useful when the mapping spline has many vertices, and you want
to reduce the number of cross-sections to a manageable number.

**Commit/Cancel**

**Commit**  Applies changes and closes the dialog, exiting spline-mapping mode.
**Cancel**  Discards changes and closes the dialog, exiting spline-mapping mode.

**Stitch Tool Dialog**

Select an object. > Modify panel > Modifier List > Object-Space Modifiers >
Unwrap UVW > Edit button (on Parameters rollout) > Tools menu > Stitch
Selected

After you've separated your object's UVW coordinates into clusters, either
manually or using one of the automatic tools on the Mapping menu on page
1875, you can use the Stitch tool to recombine specific clusters by merging
对应 edges.

**NOTE** You can stitch together only two clusters at a time. If the current sub-object
selection is shared by more than one cluster, then “majority rules”: Stitch attaches
the cluster that shares the most sub-objects. If the number of sub-objects shared
by multiple other clusters is the same, 3ds Max attaches the cluster whose shared
sub-objects were chosen first.

**Procedures**

**To stitch two clusters together:**

1  In the “source” cluster, select sub-objects along an edge you want to
connect.
By default, this causes the shared edges to highlight in the “target” object(s).

2 Choose Stitch Selected.
The clusters are connected.

3 Adjust the settings on the Stitch Tool dialog.
Feedback takes place in real time.

4 Click OK to accept or Cancel to abort.

Interface

Align Clusters Moves the target cluster to the source cluster, and rotates the target cluster into place if necessary. When off, the target cluster remains in its original position and orientation. Default=on.

TIP If your clusters overlap after stitching with Align Clusters turned on, cancel the stitching, and then position and align them as you want them after stitching. Then use the Stitch tool with Align Clusters turned off.

Scale Clusters Resizes the target cluster to a size comparable to that of the source cluster. Takes effect only when Align Clusters is on. Default=on.
Bias When Scale Clusters is off, Bias sets the extent to which attached sub-objects are moved from their original positions. At Bias=0, the sub-objects remain in their original positions in the source cluster. At Bias=1, sub-objects remain in their original positions in the target cluster. At in-between settings, their positions are averaged between the two.

When Scale Clusters is on, Bias sets where 3ds Max derives the scaling of the target cluster(s). At Bias=0, the scale is fully derived from the stitched edges on the source. At Bias=1, the scale is fully derived from the stitched edges on the target. At in-between settings, the scaling is averaged between the two.

OK Accepts the changes and closes the dialog.

Cancel Undoes any changes and closes the dialog.

Set As Default Makes the current settings the defaults for the current session.

Unfold Mapping Dialog

Select an object. > Modify panel > Modifier List > Object-Space Modifiers > Unwrap UVW > Edit button (on Parameters rollout) > Mapping menu > Unfold Mapping

The Unfold Mapping method of procedural mapping eliminates texture distortion, but can result in overlapping coordinate clusters. The Unfold Mapping dialog lets you control how faces are unfolded.

See also:

■ Flatten Mapping Dialog on page 1893
Normal Mapping Dialog on page 1895

Interface

(\textit{drop-down}) Sets the unfold method by specifying whether 3ds Max will start unfolding with the closest or farthest face angle, with respect to distance. In almost all cases, you'll get better results with Walk To Closest Face.

\begin{itemize}
  \item **Walk To Closest Face**
  \item **Walk to Farthest Face**
\end{itemize}

\textbf{Normalize Clusters} Controls whether the final layout will be scaled down to 1.0 unit to fit within the standard editor mapping area. If this is turned off, the final size of the clusters will be in object space, and they'll probably be much larger than the editor mapping area. For best results, leave this turned on.

\textbf{OK} Accepts the settings, closes the dialog, and performs the mapping as specified.

\textbf{Cancel} Undoes any changes and closes the dialog.

\textbf{Set As Default} Makes the current settings the defaults for the current session.

Unwrap Options Dialog

Select an object. > Modify panel > Modifier List > Object-Space Modifiers > Unwrap UVW > Edit button (on Parameters rollout) > Edit UVWs dialog > Options menu > Preferences

Set preferences for the Unwrap UVW editor using controls in the Unwrap Options dialog.
Chapter 9  Modifiers
Colors group

Contains color swatches to customize the display of the UVW lattice. With certain maps, the default colors may become difficult to see. Use these swatches to choose colors that work better for your specific map.

To change a color, click its swatch, and then use the Color Selector on page 371 to choose a new one.

Line Color Specifies the color of the UVW lattice lines. Default=white.

Handle Color The color assigned to patch handles. Default=yellow.

Show Shared Subs When turned on, non-selected sub-objects shared by the current selection are highlighted in this color. In most cases, the shared sub-objects are edges. With a single vertex, the shared sub-objects are vertices. Defaults=on, blue.

Selection Color Specifies the color of selected UVW sub-objects. Default=red.

Gizmo Color The color assigned to the Freeform gizmo on page 1858. Default=orange.

Display Seams When on, lets you assign a distinctive color to coordinate clusters' boundaries that appears in the viewports. Defaults=on, green.

Show Grid When on, the grid lines are visible. Defaults=on, dark blue.
You can also set the grid size on page 1931.

Background Color The color assigned to the background where the texture map isn't displayed. Default=dark gray.

(drop-down) Lets you assign a fill pattern to selected faces. Default=Cross Hatch Horizontal/Vertical.

Display Preferences group

Contains controls affecting the map display in the view window.

Render Width Specifies the width resolution of the image displayed in the view window. This does not change the size of the image, but only the resolution.

Render Height Specifies the height resolution.

Use Custom Bitmap Size When turned on, scales the bitmap texture to the values specified by Width and Height. You can adjust these settings to scale and reproportion the bitmap texture in relation to the texture coordinates.
This scaling doesn't affect the bitmap in the material, but only as viewed in the editor.

**TIP** When working with large textures, reduce the bitmap size for faster feedback. And when working with disproportionate textures, setting the dimensions closer to each other in the editor can make it easier to work.

**Tiles** The number of times the texture image is repeated, counting outward in eight directions (the four corners and the four sides).

With Tiles=1, the result is a 3 x 3 grid. With Tiles=2, the result is a 5 x 5 grid, and so on.

You can toggle the tiling feature with the Tile Bitmap check box, described below.

**Tile Brightness** Sets the brightness of the tiled bitmap. At 1.0, the brightness equals that of the original image; at 0.5 it’s half the brightness; and at 0, it’s black.

This is the same setting as Brightness in the UVWs editor > Bitmap Options group (available with Show Options).

**Tile Bitmap** When turned on, you can repeat the bitmap in the editor, displaying tiling set in the material.

You can use any part of the tiled image for setting texture coordinates. This is helpful when the sections of the texture image are packed tightly together and the mesh contains many different areas to map.

**Affect Center Tile** When turned on, the Brightness setting affects all tiles equally. When off, the center, or “home,” tile always remains at full brightness, so you can easily distinguish the home tile from the copies.

**Constant Update in Viewports** Affects the adjusting of UVW vertices in the viewport while you move the mouse. Default=off (the effect of adjusting the UVW vertices does not appear in the viewport until you release the mouse).

**Show Image Alpha** Displays the alpha channel of the background image in the editor, if it exists.

**Show Hidden Edges** Toggles the display of face edges. When turned off, only faces appear. When turned on, all mesh geometry appears.

**Blend Tile to Background** Affects the color to which tiles set to Brightness less than 1.0 blend. When turned off, tiles blend to black. When turned on, tiles blend to the background color on page 1929.
Misc. Preferences

Center Pixel Snap When turned on, snaps to the center of pixels of the background images instead of pixel edges.

Grid Snap When on, snaps to grid edges and intersections.

Vertex Snap When on, snaps to texture-coordinate vertices.

Edge Snap When on, snaps to texture-coordinate edges.

Weld Threshold Sets the radius within which welding using Weld Selected on page 1874 takes effect. The setting is in UV-space distance. Default=0.01. Range=0 to 10.

Grid Size Sets the spacing of horizontal and vertical grid lines. Default=0.1. Setting Grid Size to 0 effectively turns off the grid. At the highest value, 1.0, the grid is the same size as the texture.

Snap Str(length) Sets the grid snap on page 1862 strength. Default=0.2. Range=0 to 0.5. Setting the strength to 0 effectively turns off snapping. At values less than 0.3, grid snapping tends to go to grid edges. At the highest value, 0.5, grid snapping goes only to grid intersections.

Selection Preferences

Soft Selection Edge Distance When Soft Selection on page 1863 is turned on, limits the falloff region by the specified number of edges between the selection and the affected vertices. The affected region is measured in terms of "edge-distance" space rather than absolute distance. Default=16.

Single Click Hit Size Sets how far away you can click from a sub-object to select it. Default=4. Range=1 to 10.

Selected Tick Size Sets the size of the square icon the editor window uses to indicate selected vertices. Default=2. Range=1 to 10.

OK/Cancel/Defaults Click OK to accept, or Cancel to cancel the changes in the dialog. Click Defaults to restore all settings in this dialog to default values.
UVW Map Modifier

Select an object. > Modify panel > Modifier List > UVW Map
Select an object. > Modifiers menu > UV Coordinates UVW Map

By applying mapping coordinates to an object, the UVW Map modifier controls how mapped and procedural materials appear on the surface of an object. Mapping coordinates specify how bitmaps are projected onto an object. The UVW coordinate system is similar to the XYZ coordinate system. The U and V axes of a bitmap correspond to the X and Y axes. The W axis, which corresponds to the Z axis, is generally only used for procedural maps. A bitmap's coordinate system can be switched in the Material Editor to VW or WU, in which case the bitmap is rotated and projected so that it is perpendicular to the surface.

Mapping a sphere and a box.
By default, primitive objects such as spheres and boxes have mapping coordinates, as do loft objects and NURBS surfaces. Scanned, imported, or hand-constructed polygonal or patch models do not have mapping coordinates until a UVW Map modifier is applied.

**NOTE** Drawings that are imported or linked from Autodesk Architectural Desktop and Autodesk Revit do retain the mapping coordinates that were assigned to objects by those products.

If you apply a UVW Map modifier to an object with built-in mapping coordinates, the applied coordinates take precedence if map channel on page 8627 1 in the UVW Map modifier is used. The Generate Mapping Coordinates option, available during the creation of primitives, uses map channel 1 by default.

You use the UVW Map modifier to:

- Apply one of the seven types of mapping coordinates to an object on a specified map channel. A diffuse map on map channel 1 and a bump map on map channel 2 can have different mapping coordinates and can be controlled separately by using two UVW Map modifiers in the modifier stack.

- Apply one of the seven types of mapping coordinates to an object.

- Transform the mapping gizmo to adjust map placement. Objects with built-in mapping coordinates lack a gizmo.

- Apply mapping coordinates to an object with no mapping coordinates, an imported mesh, for example.

- Apply mapping at the sub-object level.

**Map Channels**

You can control the type of mapping coordinates and the placement of the mapping gizmo for each bitmap in a material that uses multiple bitmaps by assigning explicit map channels to the bitmaps. In the Material Editor you assign each map a different channel number, then you add multiple UVW Map modifiers to the object's modifier stack, each UVW Map modifier is set to a different map channel. To change the type of mapping or gizmo placement for a particular bitmap, you select one of the UVW Map modifiers in the modifier stack and change the parameters. You can change the name of a UVW Map modifier in the Edit Modifier Stack dialog to correlate the modifier to the bitmap.
Transforming UVW Map Gizmos

Changing a map’s location by moving the gizmo.

The UVW Map gizmo projects mapping coordinates onto an object. You can position, rotate, or scale a gizmo to adjust map coordinates on an object; you can also animate the gizmo. Gizmo transformations remain in effect if you select a new map type. For example, if you scale a spherical mapping gizmo and then switch to planar mapping, then the planar mapping gizmo is also scaled.

Gizmo Display for Different Map Types

For planar, spherical, cylindrical and shrink wrap maps, a short yellow line indicates the top of the map. The green edge of the gizmo indicates the right side of the map. On a spherical or cylindrical map the green edge is the seam where the left and right edge meet. Gizmo must be selected in the modifier display hierarchy to display the gizmo.
Gizmos for different projection types
Left to right: planar, cylindrical, box, and spherical

Effects of Transforming the UVW Map Gizmo

Moving the gizmo changes the center of projection and affects all types of mapping. Rotating the gizmo changes the orientation of the map, which affects all types of mapping. Uniform scaling does not affect spherical or shrink-wrap mapping. Non-uniform scaling affects all types of mapping.

If you scale a gizmo smaller than the geometry, then a tiling effect is created, unless scaling has no effect on the map type in use. Tiling based on gizmo size is in addition to tiling values set in the Material Editor Coordinates rollout for the map or the UVW Map modifier tile controls.
The size of the gizmo affects how the mapping is applied to an object.

**Manipulators for UVW Map**

The UVW Map modifier has graphic manipulators to help you adjust the mapping dimensions and tiling when Real-World Map Size is off. When Real-World Map Size is on, you can adjust positioning only for the Planar and Box mapping types.

Manipulators are visible and usable while the Select And Manipulate button on page 2838 is active. This button is on the default toolbar on page 8034. When you move the mouse over a manipulator, the manipulator turns red to show that dragging or clicking it will have an effect. Also, a tooltip appears, showing the object name, the parameter, and its value.

For more information on using the UVW Map manipulators, see the Procedures section on page 1938.

**UV width/length manipulators** In a viewport, drag the edges of the UVW Map gizmo to change the width or height.
UV tiling manipulators In a viewport, drag the small circle next to the U edge or V edge to adjust the tiling in that dimension.

Tile Controls

Use the UVW Tile controls if you want a map to repeat. Tiled maps are useful for bricks on a wall, or tiles on a floor. Rather than creating one large map, seamless maps can be tiled to surface a large area without visible seams, to give the illusion of a large map.

Tiling in the UVW Map modifier affects only the objects that use this modifier. Tiling a map in the Material Editor affects tiling on all the objects that use the material.

Material and UVW Map tiling are multiplied. For example, if a map in the Material Editor has a tile value of 2 on one axis, and a UVW Map modifier has a tiling value of 3 on the same axis, then the result is a tiling value of 6.

Objects with No Mapping Coordinates

If you render an object that doesn't have mapping coordinates or a UVW Map modifier, and the object uses a material with 2D bitmaps or 3D procedural maps that use explicit map channels, then a Missing Map Coordinates on page 6198 alert is displayed. The alert lists both the name of the object and the UVW channels or Vertex Color channels that are missing the coordinates. For example: (UVW 2): Torus01.

Mapping Selection Sets or Grouped Objects

You can apply one UVW Map modifier to a selection of objects. One large mapping gizmo will encompass the entire selection unless the Use Pivot Points option is turned on in the modifiers rollout before applying the UVW Map modifier. If the Use Pivot Points option is used then each object is encompassed with its own mapping gizmo.

If any of the objects in the selection has had its pivot point shifted in the Hierarchy > Pivot panel, and you use the Use Pivot Points option with the UVW Map modifier, then the mapping gizmos are centered to the pivot points rather than the object center and the mapping may be tricky to position the way you want.

Real-World Mapping

The idea behind real-world mapping is to simplify the use of texture mapped materials which are scaled correctly with the geometry in the scene. This
feature gives you the ability to create a material and specify the actual width and height of a 2D texture map in the material editor. When you assign that material to an object in the scene, the texture map appears in the scene with the correct scaling.

There are two parts to the equation in order for real-world mapping to work. First, the correct style of UV texture coordinates must be assigned to the geometry. Basically, the size of the UV space needs to correspond to the size of the geometry. Therefore, a new switch, called Real-World Map Size, has been added to many of the dialogs and rollouts where you can generate texture coordinates. Any dialog or rollout in which you have the option to turn on Generate Mapping Coords, also has a switch where you can turn on Real-World Map Size.

**NOTE** There are a few primitive objects that do not have a Real-World Map Size switch. These are Torus Knot, Hedra, Prism and RingWave.

The other part of the equation is in the material editor. When you create a material and use a 2D texture map, you now see a new switch in the Coordinates rollout called Use Real-World Scale. When this switch is turned on, the default, the Width and Height spinners are enabled that let you specify the horizontal/vertical offsets and size of the texture map in current display units on page 8366.

**NOTE** Autodesk VIZ scenes with objects using real-world mapping coordinates will display differently when opened in 3ds Max. This is because real-world mapping coordinates is not the default method of generating mapping coordinates in 3ds Max.

### Procedures

**To apply the UVW Map modifier:**

1. Assign a mapped material to an object.

2. On the Modify panel, choose UVW Map from the Modifier List.

3. Adjust the mapping parameters.

By default, the UVW Map modifier uses planar mapping on map channel 1. You can change the type of mapping and the map channel to suit your needs. There are seven types of mapping coordinates, ninety-nine map channels, tiling controls, and controls to size and orient the mapping gizmo in the UVW Map modifier.
NOTE  If a UVW Map modifier is applied to multiple objects, the UVW Map gizmo is defined by the selection, and the mapping that results is applied to all the objects.

To use multiple UVW channels in the same object:

1  Assign Map channel 1 to an object. You can do this by either turning on Generate Mapping Coordinates in the Parameters rollout of any primitive, or by assigning a UVW Map modifier with channel 1 chosen. Generate Mapping Coordinates uses map channel 1 by default.

2  Assign a UVW Map modifier (or a second one, if you're using the first to assign channel 1). Choose channel 2 for this modifier. Both coordinate channels are now assigned to the geometry. The next step is to assign a mapped material that uses both channels.

3  Create a material with two maps. You can do this using a Composite map, or a Blend material with two maps, or you can have one map assigned to Diffuse and another assigned to Bump. Perhaps the easiest way to see the effect is to composite two maps, with the second map containing an alpha channel.

4  Go to the level of one of the maps and, in the Mapping list, choose Explicit Map Channel 2. The other map is already assigned channel 1 by default.

5  Assign the mapped material to the object. You can switch between viewing the maps in the viewport using the Show Map In Viewport control in the Material Editor. You can adjust the mapping of channel 2 without altering the mapping of channel 1 if you've assigned two UVW Map modifiers. Render the scene to see the effect.

To use the XYZ to UVW option:

The XYZ to UVW option is used to make a 3D procedural texture, like Cellular, follow the animated surface of an object. If the object stretches, so does the 3D procedural texture. Currently, it cannot be used with NURBS objects and is unavailable if a NURBS object is selected.

1  In the Top viewport, create a box.

2  Create a material with a Cellular diffuse map.
3 In the Material Editor, on the Coordinates rollout of the Cellular map, open the Source drop-down list, and choose Explicit Map Channel. On the Coordinates rollout, the Map Channel parameter activates, leave the value at 1.

4 Assign the material to the box.

5 On the Modify panel, choose UVW Map from the Modifier List.

6 On the UVW Map modifier, turn on XYZ to UVW. By default, the Map Channel value is 1.

7 Render the Front viewport. The cellular pattern renders normally on the surface of the box.

8 Right-click over the object and choose Convert To: > Convert to Editable Mesh from the Transform (lower-right) quadrant of the quad menu. The box is converted to an editable mesh.

9 On the Modify panel, click to turn on Vertex on the Selection rollout.

10 In the Front viewport, select the top vertices of the box, and move them up.

11 Render the Front viewport again. The cellular pattern stretches with the box. This effect is enabled by the XYZ to UVW option. To see the difference, we will change the Source option in the Coordinates rollout in the Material Editor.

12 In the Material Editor, locate the diffuse Cellular material.

13 On the Coordinates rollout of the Cellular diffuse map, open the Source drop-down list and choose Object XYZ.

14 Render the Front viewport. The cellular pattern is no longer stretched.
To transform the UVW Map gizmo:

1. On the Modify panel, choose the UVW Mapping modifier in the stack display.
2. In the stack display, choose the Gizmo sub-object level.
   The gizmo changes to a yellow color, with one green edge.
   The green edge indicates the right edge of the texture.
3. Move, scale, or rotate the gizmo in the viewports, or use the Length and Width controls in the UVW Map modifier.
   Transforming the map gizmo shifts the bitmap, allowing you to orient and move the map on the object's surface.

To use manipulators to control the width and length:

1. On the Modify panel, choose the UVW Map modifier in the stack display.
   You can also be at the Gizmo level of the modifier.
2. On the default main toolbar, click to turn on Select And Manipulate.
   The UVW Map modifier's gizmo turns green, showing it is now a manipulator. Also, two small circles appear next to two of the gizmo's edges.
3. Drag an edge of the gizmo to adjust the width or length.
   A tooltip shows the new width or length value.

To use manipulators to control tiling:

1. On the Modify panel, choose the UVW Map modifier in the stack display.
   You can also be at the Gizmo level of the modifier.
2 On the default main toolbar, click to turn on Select And Manipulate. The UVW Map modifier's gizmo turns green, showing it is now a manipulator. Also, two small circles appear next to two of the gizmo's edges.

3 Drag one of the circles to adjust tiling in the U or V dimension. A tooltip shows which dimension you are adjusting, and the new tiling value in that dimension.

Interface

Modifier Stack

Gizmo sub-object level Enables gizmo transformations. At this sub-object level you can move, scale, and rotate the gizmo in the viewports to position the mapping. In the Material Editor, you turn on the Show Map in Viewport option to make the map visible in a shaded viewport, the map moves on the surface of the object as you transform the gizmo.
Mapping group

Determines the type of mapping coordinates used. Different kinds of mapping are distinguished by how the map is geometrically projected onto the object and how the projection interacts with the object's surfaces.

**Planar** Projects the map from a single plane flat against the object, somewhat like projecting a slide.
Planar projection is useful when only one side of an object needs to be mapped. It is also useful for obliquely mapping multiple sides, and for mapping two sides of a symmetrical object.

![Planar map projection](image)

**Cylindrical** Projects the map from a cylinder, wrapping it around an object. Seams where the edges of the bitmap meet are visible unless a seamless map is used. Cylindrical projection is useful for objects that are roughly cylindrical in shape.
Cylindrical map projection

Cap Applies planar mapping coordinates to the caps of the cylinder.

NOTE If the ends of the object geometry are not at right angles to the sides, the Cap projection bleeds onto the sides of the object.

Spherical Surrounds the object by projecting the map from a sphere. You see a seam and mapping singularities at the top and bottom of the sphere where the bitmap edges meet at the sphere's poles. Spherical mapping is useful for objects that are roughly spherical in shape.
Spherical map projection

**Shrink Wrap** Uses spherical mapping, but truncates the corners of the map and joins them all at a single pole, creating only one singularity. Shrink-wrap mapping is useful when you want to hide the mapping singularity.
Shrink-wrap projection

Box  Projects the map from the six sides of a box. Each side projects as a planar map, and the effect on the surface depends on the surface normal. Each face is mapped from the closest box surface whose normal most closely parallels its own normal.
Box projection (shown on a box and on a sphere)

**Face** Applies a copy of the map to every face of an object. Pairs of faces sharing a hidden edge are mapped with the full rectangular map. Single faces with no hidden edge are mapped with a triangular portion of the map.
Face projection

**XYZ to UVW** Maps 3D procedural coordinates to UVW coordinates. This "sticks" the procedural texture to the surface. If the surface stretches, so does the 3D procedural map. Use this option with procedural textures, like *Cellular* on page 6279, on objects with animated topologies. Currently, XYZ to UVW cannot be used with NURBS objects and is disabled if a NURBS object is selected.

**NOTE** In the Material Editor's Coordinates rollout for the map, set Source to Explicit Map Channel. Use the same map channel in the material and UVW Map modifier.
A sphere with a 3D procedural texture is copied, and the copies are stretched.

Right: Using XYZ to UVW on the object enables the 3D procedural texture to stick and stretch with the surface.

**Length, Width, Height** Specify the dimensions of the UVW Map gizmo. The default scale of the mapping icon is defined by the largest dimension of the object when you apply the modifier. You can animate the projection at the gizmo level. Note the following facts about these spinners:

- The dimensions are based on a bounding box of the gizmo. The Height dimension is unavailable for the Planar gizmo: It does not have depth. Likewise, the dimensions for Cylindrical, Spherical, and Shrink Wrap mapping all display the dimensions of their bounding box and not their radiuses. No dimensions are available for the Face map: Each face on the geometry contains the entire map.

- The three dimensions are set to 1 or 2, depending on map type and dimensions, when you load files created in Autodesk VIZ or earlier versions of 3ds Max. (This maintains compatibility with files from previous releases, in which gizmos were scaled non-uniformly to adjust their dimensions.).
The dimensions essentially become scale factors rather than measurements. You can reset the values to dimensions by clicking the Fit or Reset buttons, which will lose the original non-uniform scaling.

**U Tile, V Tile, W Tile** Let you specify the dimensions of the UVW map, for tiling the image. These are floating-point values, which you can animate to displace the map's tiling over time.

**Flip** Reverses the image about the given axis.

**Real-World Map Size** Controls the scaling method used for texture mapped materials that are applied to the object. The scaling values are controlled by the Use Real-World Scale settings found on the applied material's Coordinates rollout on page 6201. Default=off.

When on, the Length, Width, Height and Tiling spinners are unavailable.

**Channel group**

Each object can have up to 99 UVW mapping coordinate channels. The default mapping (from the Generate Mapping Coordinates toggle) is always channel 1. The UVW Map modifier can send coordinates to any channel. This lets you have many different sets of coordinates on the same face simultaneously.

**Map Channel** Sets the map channel. The UVW Map modifier defaults to channel 1, so mapping behaves in the default fashion (and in the fashion of earlier software releases) unless you explicitly change to another channel. Default=1. Range=1 to 99

To use the additional channels, you must not only choose a channel in the UVW Map modifier, but also assign an explicit map channel at the map level of the material assigned to the object. You can use many UVW Map modifiers in the modifier stack, each one controlling the mapping coordinates of different maps in a material.

**Vertex Color Channel** Define the channel as a vertex color channel by choosing this option. Be sure to match any material mapping in the coordinates rollout to be Vertex Color as well, or by using the Assign Vertex Colors utility on page 6477.

The Map channels are accessed in various places in 3ds Max, as follows:

- **Generate Mapping Coords** This check box, in the creation parameters of most objects, assigns Map channel 1 when turned on.

- **UVW Map Modifier** Contains options for channels 1 through 99. This lets you specify which UVW coordinates are used by this UVW Map
modifier. The modifier stack can pass these channels simultaneously for any face.

- **UVW XForm and Unwrap UVWs**  These two modifiers also contain Channel option buttons.

- **Material Editor Channel Assignment**  You assign the channel to be used by a map in the Coordinates rollout at the map level in the Material Editor.

- The assignment varies depending on the type of map:

  - **2D Maps**
    In the Mapping list for the Texture option, you can choose Explicit Map channel, Vertex Color Channel, Planar from Object XYZ, or Planar from World XYZ.

  - **3D Maps**
    At the top of the Coordinates rollout, there is a Source list where you can choose an Explicit Map Channel, Vertex Color Channel, Object XYZ, or World XYZ. Use the Map Channel spinner to define the channel number.

- **NURBS Surface Objects and Sub-Objects**  Let you specify which Map channel the surface uses.

**Alignment group**

X/Y/Z  Select one of these to flip the alignment of the mapping gizmo. Each specifies which axis of the gizmo is aligned with the local Z axis of the object.

---

**NOTE**  These options aren't the same as the Flip check boxes beside the U/V/W Tile spinners. The Alignment option buttons actually flip the gizmo orientation, while the Flip check boxes flip an assigned map’s orientation.

**Manipulate**  When on, a gizmo appears on the object that lets you change parameters in the viewport. When Real-World Map Size is on, Manipulate is available only with the Planar and Box mapping types. For more information, see **Manipulators for UVW Map** on page 1936.
**TIP** Turn on snapping to adjust the mapping precisely.

**Fit** Fits the gizmo to the extents of the object and centers it so that it's locked to the object's extents. Unavailable when Real-World Map Size is on.

**Center** Moves the gizmo so that its center coincides with the center of the object.

**Bitmap Fit** Displays the standard bitmap file browser so that you can pick an image. Unavailable when Real-World Map Size is on.

For planar mappings, the map icon is set to the aspect ratio of the image. For cylindrical mapping, the height (rather than the radius of the gizmo) is scaled to match the bitmap. For best results, first use the Fit button to match the radius of the object and gizmo, and then use Bitmap Fit.

**Normal Align** Click and drag on the surface of the object to which the modifier is applied. The origin of the gizmo is placed at the point on the surface where the mouse is pointing; the XY plane of the gizmo is aligned to the face. The X axis of the gizmo lies in the object's XY plane.
Normal Align respects smoothing groups and uses the interpolated normal based on face smoothing. As a result, you can orient the mapping icon to any part of the surface, rather than having it "snap" to face normals.

**View Align** Reorients the mapping gizmo to face the active viewport. The size of the icon is unchanged.

**Region Fit** Activates a mode in which you can drag in the viewports to define the region of the mapping gizmo. The orientation of the gizmo is not affected. Unavailable when Real-World Map Size is on.

**Reset** Deletes the current controller controlling the gizmo and plugs in a new one initialized using the Fit function. Any animation to the gizmo is lost. As with all the alignment options, you can cancel the reset operation by clicking Undo.

**Acquire** Effectively copies the UVW coordinates from other objects. When you pick an object from which you want to acquire UVWs, a dialog prompts you whether the acquire should be done in an absolute or relative fashion. If you choose Absolute, the acquired mapping gizmo is positioned exactly on top of the mapping gizmo you pick. If you choose Relative, the acquired mapping gizmo is positioned over the selected object.

### Display group

![Display settings](image)

This setting determines whether and how mapping discontinuities, also known as seams, appear in the viewports. The seams appear only when the Gizmo sub-object level is active. The default seam color is green; to change it, go to Customize menu > Customize User Interface > Colors tab, and then from the Elements drop-down list, choose UVW Map.

The options are:

- **Show No Seams**  Mapping boundaries don't appear in the viewports. This is the default choice.
■ **Thin Seam Display**  Displays mapping boundaries on object surfaces in the viewports with relatively thin lines. The line thickness remains constant as you zoom the view in and out.

■ **Thick Seam Display**  Displays mapping boundaries on object surfaces in the viewports with relatively thick lines. The line thickness increases when you zoom the view in and decreases when you zoom out.

**UVW Mapping Add Modifier**

Select an object. > Modify panel > Modifier List > UVW Mapping Add

Select an object. > Channel Info on page 6486 > Add a channel.

The UVW Mapping Add modifier is added to an object's modifier stack when you add a channel in the Channel Info utility on page 6486. You can also add the modifier explicitly by choosing it from the Modifier List. It has no user interface.

To merge the results of the add operation into the object's geometry, collapse the modifier stack after adding.

**UVW Mapping Clear Modifier**

Select an object. > Modify panel > Modifier List > UVW Mapping Clear

Select an object. > Channel Info on page 6486 > Clear a channel.

The UVW Mapping Clear modifier is added to an object's modifier stack when you clear a channel with the Channel Info utility on page 6486. You can also add the modifier explicitly by choosing it from the Modifier List.

To merge the results of the deletion into the object's geometry, collapse the modifier stack after deleting.

**Interface**

**Map Channel**  Specifies the map channel to clear. This is equivalent to clearing a specific channel in the Channel Info utility. If the specified map channel doesn't exist, the modifier has no effect.
UVW Mapping Paste Modifier

Select an object. > Channel Info on page 6486 > Copy and then paste a channel.

The UVW Mapping Paste modifier is added to an object’s modifier stack when you paste a channel in the Channel Info utility on page 6486. It isn’t available from the modifier list, and has no user interface.

To merge the results of the paste operation (for example, a vertex selection) into the object’s geometry, collapse the modifier stack after pasting.

UVW XForm Modifier

Modify panel > Make a selection. > Modifier List > Object-Space Modifiers > UVW XForm

Select an object. > Modifiers menu > UV Coordinates > UVW XForm

Use the UVW XForm modifier to adjust tiling and offset in existing UVW coordinates on page 8754. If you have an object with complex UVW coordinates already applied (such as a Loft object, or a parametric object with generated coordinates), you can apply this modifier to adjust those coordinates further.

For example, if you create a torus and turn on Generate Mapping Coordinates, the UVW coordinates work perfectly with the torus, but if you want to tile or move the coordinates, you would previously have needed to do it at the material/map level. Now you can apply a UVW XForm modifier to alter the built-in coordinates. You can use a Mesh Select or Edit Mesh modifier to apply a UVW Adjust to sub-object selections, as well. This is handy if you want to rotate the mapping on a particular portion of an object.
**Interface**

![Interface Diagram](image)

**Mapping group**

*U Tile, V Tile, W Tile* Alter the tiling along any of the three coordinate axes.

*Flip* Reverses the direction of the map along the specified axis.

*U Offset, V Offset, W Offset* Move the map in the direction of the specified axis coordinate.

*Rotation* Rotates the map.

*Rotate About Center* When active, the map rotates about the center of the object. If this is applied to a sub-object selection, it uses the center of that selection.

When this is turned off, the map rotates about the corner of the U and V coordinate gizmo.
**Channel group**

Specifies whether to apply the transform to a mapping channel or a vertex color channel, and which channel to use. For more information on these channels, see *UVW Map Modifier* on page 1932.

**Map Channel** Specifies a UVW channel to use for the mapping, and use the spinner to its right to set the channel number.

**Vertex Color Channel** Uses the vertex color channel for the mapping.

---

**Apply To Entire Object** If the UVW Xform modifier is applied to an active sub-object selection, such as face or patch, this switch controls whether the settings of the UVW Xform modifier affect only the original sub-object selection or affect the entire object.

### Vertex Weld Modifier

Select a mesh, patch, or PolyMesh object. > Modify panel > Modifier List > Vertex Weld

Select a mesh, patch, or PolyMesh object. > Modifiers menu > Mesh Editing > Vertex Weld

The Vertex Weld modifier behaves like the Weld feature in Editable Mesh or Editable Patch and welds all vertices that fall within the threshold setting. Vertex Weld is very useful for cleaning up meshes that have vertices that are close or overlapping, but not welded.

The results of three Vertex Weld threshold settings

---

Vertex Weld Modifier | 1957
Procedures

Example: To apply the Vertex Weld modifier to a mesh:

1. Create a box with Length, Width, and Height set to 40.
2. Right-click the box and choose Convert to > Convert to Editable Poly.
3. Set the sub-object mode to polygon, and select Polygon 6.
   
   **TIP** Watch the listing at the bottom of the Selection rollout to see which polygon is selected.

   By deleting the polygon, you create an open mesh.
5. Apply a Turn To Poly modifier, and set the Selection Level to Object.
6. Apply a Mirror modifier, and set Mirror Axis to X.
7. Turn on Copy, and set Offset to –40.
   The reflection of the box shares a common seam but the vertices along the seam are not welded.
8. Apply a Vertex Weld modifier to cement the two boxes into one element.

**NOTE** This combination of steps can be streamlined by using the Symmetry modifier on page 1803, which will mirror the mesh and weld it in a single operation.

Interface

<table>
<thead>
<tr>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threshold: 0.1</td>
</tr>
</tbody>
</table>

**Threshold** The value of the Threshold setting delegates how close vertices can be before they are automatically welded together. Default=0.1
NOTE A higher threshold setting will result in welding more vertices, thus removing smaller faces and details. If the threshold is set too high, the mesh will begin to deform.

A threshold setting of 5.5 removes all detail, making the model unrecognizable.

**VertexPaint Modifier**

Select an object. > Modify panel > Modifier List > VertexPaint
Select an object. > Modifiers menu > Mesh Editing > Vertex Paint
Select an object. > Utilities panel > More > Assign Vertex Colors > Click Assign To Selected. > Modify panel

The VertexPaint modifier lets you paint vertex colors onto an object. You're not restricted to only vertex-level painting. Using sub-object selection, you can also control which vertices get painted, face-by-face. All faces sharing a vertex have the adjacent corner shaded as well. The resulting painted object receives a coarse gradient across each face.

The amount of color that 3ds Max applies to a vertex depends on the distance of the vertex from the position of the paint cursor on the face. The more you select a face, the more it changes to the new color. The Opacity button also controls the strength of the color. 3ds Max shades the color, so if you have one green vertex and two white vertices for one face, for example, you'll see a gradient on that face.

VertexPaint modifier also lets you paint values for the vertex alpha and illumination channels. These channels affect the transparency and shading of vertex colors, respectively.
Notes and Tips

For best results with VertexPaint, keep the following in mind:

- VertexPaint is automatically applied to the selected object when you click Assign Vertex Colors on page 6477 > Assign To Selected. It is not available directly from the Modify panel or Modifiers menu.
- To render vertex colors, assign a Vertex Color map on page 6355, as described in To render vertex colors on page 1963.
- If you select faces using the selection tools of the VertexPaint modifier, you restrict your painting to the selected faces, as opposed to all faces. This allows you to sharply define the edges of your painted selection.
- You can streamline the painting process by using the Brush Presets tools on page 8044.
- Each VertexPaint modifier works internally to itself, and cannot modify existing vertex coloring. To paint over existing coloring, use the Condense to single layer on page 1982 function.

About Map Channels and Vertex Color, Vertex Alpha, and Vertex Illum

When using vertex paint, it is helpful to understand how 3ds Max manages vertex color, alpha, illumination, and map channels. 3ds Max stores and manages all of these different pieces of information using the same underlying system.

The map channels are defined as triple-value channels (tuples) with a unique integer ID number ranging from \(-2\) to 99. The first five map channels have specific and familiar usages:

- **Channel (2):** UVW “second pass” texture mapping coordinates
- **Channel (1):** UVW standard texture mapping coordinates
- **Channel (0):** RGB vertex color
- **Channel (−1):** FLOAT vertex alpha (really only 1 value needed)
- **Channel (−2):** RGB vertex illumination

Every geometric vertex of a mesh or poly object can be assigned up to 102 channel values (99 + 3).
The reason for the negative numbering scheme for the vertex alpha and illumination channels is actually historic: It serves to preserve the meaning of existing map-channel data in older scene files before vertex alpha and illumination were added.

You can paint on any arbitrary channel, and to use one or more channels for any arbitrary meaning for a given vertex. It is useful in development of content for games to paint on arbitrary map channels numbered higher than those used for texture mapping (such as channels 3, 4, 5). These can be used to store logical information about a vertex: for example, whether it is “slippery” or “explosive.”

You can assign a single vertex a stack of map channels that carry different meanings. When you collapse the modifier stack, 3ds Max preserves these map channels.

The VertexPaint modifier takes this into consideration through its simple exposure of map channel IDs for display and painting.

About Painting in Layers

The layer system allows you to paint changes on a single layer, then make another layer on top of that, and paint additional changes. This can be used to store different versions or variations of your vertex color painting.

Every layer has a blending mode that it uses to determine how it combines with the other layers. You can assign vertex colors using the Assign Vertex Colors utility on page 6477, then add another layer, change the layer mode operator to Lighten, and paint with a white paintbrush to lighten up areas. Fifteen different modes are available, and many tasks can be accomplished using paint layers.

One of the primary advantages of VertexPaint is its use of the modifier stack as a kind of image-composite stack. Each VertexPaint modifier serves as a single layer in the composite. You can move layers up and down the stack, enable and disable them, and flatten the stack using Condense to single layer on page 1982.

Backward Compatibility

If you load an older file that uses a previous version of the VertexPaint modifier, then the legacy modifier will be loaded when the file is opened.

The legacy modifier has not been changed, and the two modifiers are not inherently compatible in terms of their data format during loading and saving.
If you have vertex color data in a legacy VertexPaint modifier, you can use the Condense to single layer tool on page 1982 of the new modifier to migrate the vertex colors into the new modifier.

**Procedures**

**To add scene lighting into an object's vertex color:**

1. Select the objects in the scene that you want to color.
2. On the Modify panel, choose VertexPaint from the modifier list. The floating Paintbox on page 1969 appears, docked to the left edge of the viewports.
3. Open the Assign Vertex Colors rollout.
   
   **NOTE** This rollout provides the same tools as found in the Assign Vertex Colors utility.

4. In the Light Model group, choose Lighting + Diffuse.
5. Click Assign.

6. On the Vertex Paintbox, turn on Vertex Color Display Shaded to see the vertex lighting in the vertex color map.

**To paint vertex colors on an object:**

1. Select the scene objects to paint.

2. On the Modify panel, choose VertexPaint from the Modifier List. The Vertex Paintbox appears.

3. Choose the color you want to paint with by clicking the large color swatch below the Paintbrush button. This opens the Color Selector.

5. Adjust the strength of the color by entering a percentage value in the Opacity field.
6 Click Vertex Color Display Unshaded to see the vertex colors without shading.

7 Click the Paint button and move the cursor over the selected object in the viewport.

8 When the cursor displays over the object, press and hold down the left mouse button and drag to paint the object.

**TIP** The cursor displays the size of the brush. Use the Size spinner to change to a larger or smaller brush.

To see vertex colors in a viewport:

1 Right-click the object with painted vertices, and choose Properties from the quad menu.

2 In the Display Properties group, turn on the toggle for Vertex Color. Vertex Color is one item on a drop-down list. The other items are Vertex Illumination, Vertex Alpha, Map Channel Color (which uses the spinner immediately below the list), and Soft Selection Color. Viewports can display only one of these vertex channels at a time.

3 Click OK.

To render vertex colors:

1 Open the Material Editor, and apply a Standard material to the object.

2 Click the map button for the Diffuse component.

3 In the Material/Map Browser, choose Vertex Color as the map, and then click OK. Now, when you render the scene, the rendering shows the painted vertices.
To animate the opacity of a vertex color layer

1. Choose the layer you wish to animate, by highlighting the Vertex Paint modifier in the stack that corresponds to that layer.
2. Turn on the Auto Key button.
3. On the floating vertex paintbox, in the Layer group move the Opacity slider. This sets a key for the opacity.
4. Move the time slider to another frame and again change the value using the Opacity slider.
5. Click Play to see the animated opacity in the viewport.

To animate vertex color using UVW XForm modifier:

You can use the UVW XForm modifier in conjunction with a specific vertex paint layer to modulate vertex color effects in the viewport.

1. Apply a UVW XForm modifier directly above the VertexPaint layer (modifier) you want to modulate.
2. Set the Channel type on the UVW XForm modifier to Vertex color.
3. Animate the U, V, and W spinners using identical values. For example, animate UVW from 1 to 0 over the length of the animation. This will attenuate the RGB values of the underlying vertex color results uniformly. It will effectively dim out the vertex color result directly below the UVW XForm modifier.

**NOTE** Any additional vertex paint layers applied above the UVW XForm modifier in the stack for the selected object(s) will be unaffected

**TIP** You can add multiple UVW XForm modifiers in your stack in this way, giving some progressive control over modulated vertex colors. The effect is always additive, however, and cannot be weight-blended.

To paint under an existing layer and view the result:

1. Select an object that has several VertexPaint modifiers displayed in the stack.
2. In the modifier stack, activate the VertexPaint modifier that is the layer you want to paint on.
Turn on the Show End Result toggle.
Now, when you paint on the layer, you will see the painting taking place under the top layer.

**Interface**

**Parameter rollout**

The controls in this group are identical to the selection controls found in the Selection group on page 1976 of the Paintbox rollout.
Channel group

These controls specify which channel type the vertex paint layer will affect, and which map channel number you'll paint on.

- **Vertex Color**  Choose this to paint on a vertex color layer.
- **Vertex Illum**  Choose this to paint on a vertex illumination layer.
- **Vertex Alpha**  Choose this to paint on a vertex transparency layer.
- **Map Channel**  Choose this to paint on a specifically named or numbered map channel.

  **Map channel spinner**
  Specifies the channel number. Available only when Map Channel is chosen.

**NOTE** If you have painted on a layer and then change the channel setting, the painted information will be moved to the new channel. For example if you select Vertex Color and paint, then turn on Vertex Illum, the painted information will be removed from the Vertex Color channel and applied to the Vertex Illum channel instead.

**Name** If a channel has a name defined it will appear here. Channels can be named using the **Channel Info Utility** on page 6486.

---

**Ignore underlying color** When turned on, VertexPaint ignores whatever vertex colors it receives from below it on the stack. As a result, you will see the layer's raw colors on an otherwise white object. The blend mode has no effect (it behaves like Normal mode) because the base color is considered transparent, so the layer is not blended with anything.

The purpose of this toggle is to isolate a layer from the colors below, to help the user visualize the layer's raw data. The layer is not completed isolated when this is on, because layers above it can still affect the result. The user needs to disable those layers or turn off Show End Result to see the current layer in complete isolation.

The Ignore Base Color toggle should *only* be needed when the object at the bottom of the stack already has some vertex colors baked in. In other cases, you can just disable the paint layers or whichever modifiers are adding vertex colors to the object. In that case, the active paint layer would not receive any vertex colors from below itself on the stack. As a result, it treats all base color as transparent and the layer colors are displayed in the raw (not blended with anything).
NOTE Per-vertex layer opacity is not passed up the stack. A paint layer modifier makes a yes/no decision about whether an object below it has vertex colors or not, and will subsequently treat all base colors as transparent or all as opaque. So if you paint even a single vertex using Edit Mesh, for example, the object is considered to have vertex colors, and a paint layer will blend its colors with the (predominantly white) mesh instead of treating the mesh as transparent.

Preserve Layer When on, the modifier will not be deleted by any Condense To Single Layer operation. Since Condense To Single Layer performs two independent actions (creating a new baked-color modifier and then deleting existing modifiers), this option allows access to only the first part of the functionality when necessary. That is, you can bake colors into a new paint layer, without being forced to have the old modifiers deleted.

Edit Displays the Vertex Paintbox floater on page 1969 if it has been closed.
Assign Vertex Color rollout

This rollout gives you access to the same controls found in the Assign Vertex Colors utility on page 6477. They let you take the scene lighting information and bake it into the vertex channel system.
VertexPaint Paintbox

Select an object. > Modify panel > Modifier List > VertexPaint > Paintbox dialog (Click Edit in the Parameters rollout if it isn’t displayed.)

Select an object. > Modifiers menu > Mesh Editing > Vertex Paint > Paintbox dialog (Click Edit in the Parameters rollout if it isn’t displayed.)

Select an object. > Utilities panel > More > Assign Vertex Colors > Click Assign To Selected > Modify panel > Modifier List > VertexPaint > Paintbox dialog (Click Edit in the Parameters rollout if it isn’t displayed.)

The VertexPaint modifier’s Paintbox is a floating toolbox with various vertex painting tools. The Paintbox is launched automatically after the VertexPaint modifier on page 1959 has been applied to one or more objects. You can close the Paintbox by clicking the X button in the upper-right corner of its window. To open it again, click the Edit button in the Parameters rollout of the VertexPaint Modifier.

NOTE If a VertexPaint modifier is assigned to the object, you can also display the Paintbox by clicking Edit in the Assign Vertex Color utility.
Vertex Color Display controls

Control the display of the vertex paint in the viewport by using the four icons at the top of the floating panel. You can easily switch between shaded and unshaded vertex color modes, or turn off the display of vertex color and or texture maps.

**NOTE** The first three of these buttons stay highlighted when you click them, to indicate which shading mode is active. Toggle Texture Display simply performs the action without becoming highlighted.

**NOTE** These controls have no effect on wireframe viewports, but work for all shaded viewports, including Lit Wireframe.

- **Vertex color display – unshaded** Displays the currently selected object in vertex color display mode. This mode is identical to the one offered by the Object Properties menu (right click on object, select Properties > Turn On Vertex Color in the Display Properties group, making sure that Shaded is off.)

  This has no effect on wireframe, but works on lit wireframe and all other shaded display modes.

- **Vertex color display – shaded** Displays the currently selected object in vertex color display mode, with viewport lighting (shading). This mode is identical to the one offered by the Object Properties menu (right click on object, select Properties > Turn On Vertex Color in the Display Properties group, making sure that Shaded is on.)

- **Disable vertex color display** Displays the currently selected object in its current shading mode without showing vertex colors.
**Toggle texture display**  Displays or hides texture maps on the currently selected object.

**Viewport Channel Display selector**

This menu allows you to select which one of the map channels to paint on:

- **Vertex colors**  Choosing this lets you display the vertex color channel in the viewport.

- **Vertex alpha**  Choosing this lets you display and paint the vertex transparency channel in the viewport.

- **Vertex Illum**  Choosing this lets you display and paint the vertex lighting channel in the viewport.

- **Map Channel**  Choosing this lets you define a numbered map channel to paint on. Define the channel ID number with the Map Channel Display spinner.

**Map channel display in viewport flyout**

What you see is what you paint, so whatever you select will both be displayed and activated for painting.
NOTE  You cannot paint on all channels simultaneously as you could in the previous version of the vertex paint modifier.

**Map Channel Display Spinner**  This control lets you to numerically select a channel other than the 3 conventional ones listed above, for display only. If the channel you select is currently used for mapping coordinates, you'll see red/yellow/green colors corresponding to the UVW values.

You might choose map channels above the standard channel 1, 2, 3 that do typically get used for texture mapping. But you will need to keep track of your own conventions, and/or use the Channel Info utility to track what has been allocated for each object.

The Map Channel Display Spinner is only available when the Map Channel display button. If you assign a new vertex paint modifier or create a new layer and choose a particular numeric map channel, then select Map Channel display, the spinner will become available.

**Lock button**  The Lock button makes the Display Channel setting unavailable, and automatically sets Display Channel to whatever channel you choose on the Modify panel > Channel rollout. Keep this turned on, to ensure that you're always displaying what you're painting.

If you want to glance at another channel without stopping your current paint session, turn off the lock and then switch the display channel. When you are finished, switch back and turn the lock back on.
Vertex Paintbrush group

Here are the controls that let you access the paintbrush and the paint. You can choose color to paint with, from a color selector or from the scene. Choose to adjust the brush size or envelope, or launch advanced paintbrush options such as pressure sensitivity.

**Paint All** Performs a traditional paint fill operation on the current object or sub-object selection. In the case of sub-object selections (vertices, faces, elements) the fill will honor those selections. In the case of soft-selection Paint all will do a “faded” fill, slowly tapering off the opacity based on the soft selection settings.

As with the Paint button, this will either paint on the current layer, if one is open in the Modify panel, or else it will create a new vertex paint layer instanced across the selected objects.

**Paint** Starts the painting process. Once it is turned on, you can start painting on the current selection, by moving the cursor into the viewport and over the object.

If there is a Vertex Paint modifier highlighted in the Modify panel, you will be painting into that layer. But if the selected objects do not currently have a vertex paint layer highlighted in the modify panel, then a dialog appears
letting you create a new modifier. This will be instanced across all the selected objects.

You will not see the results of your brush strokes, unless the proper display mode is set (above). Be sure your display mode and your paint target match. For example – if you are painting on the alpha channel, be sure you are displaying the alpha channel. If you are painting on the color channel, display the color channel. Brush strokes will use the color specified in the color swatch directly below the Paint button.

See Painter Options Dialog (VertexPaint Modifier) on page 1989 for more painting options.

**Erase all** Erases all painting applied to the currently selected objects via the current VertexPaint modifier. This allows you to see through the underlying color of the object’s vertices. This underlying color might come from the object’s original vertex color, or from another vertex paint layer directly below it in the modifier stack. This supports soft selection as well.

**Erase** Turns the brush into an eraser that will remove paint from the currently selected objects. Erase mode will actually erase any painting applied to the currently selected objects for the current layer of paint (allowing the true color of the original objects vertices to be seen, or the vertex paint layer immediately below the current one).

**Pick color from object** Allows you to choose a color from the currently selected objects. The color is taken from a single vertex; region selection is not supported. The choice must occur near a vertex, or no color will be chosen. You can drag across a vertex of interest to pick up its color. Because this button enters a mode, it must be clicked to leave the mode, or you can choose another mode to turn it off.

**Color swatch** The color swatch indicates the current color that will be used when painting begins. Clicking the swatch launches the standard color selector. Here you can change the color that will be used on the next brush stroke. It provides standard Hue, Saturation, and Brightness selection, along with Red, Green, and Blue selection and numerical entry.
**Opacity** Controls the opacity of paint being applied to the currently selected objects in a single paint stroke (actually, any time before mouse up). This value represents the percentage of new paint that will blend into the color already applied to the selected objects. Successive paint strokes will continue to add this color until it overpowers the underlying color completely. The maximum value is 100% and 0% is the minimum value. A value of 50 percent will blend equally with the underlying vertex color in a single stroke (before mouse up).

The brush opacity serves to clamp the effect of each brush stroke, taken as a whole. If you pick a low opacity amount, then a single brush stroke will have only a small effect, no matter how much you scrub. This allows improved control over the density of a glaze of color, with an even glazing across all the painted vertices.

**Size** Controls the diameter of the brush, as seen in the viewport. Size values range from zero to 9,999,999 and must be chosen appropriately for the size and resolution of geometry you are painting.

**Brush Options** Opens the Painter Options dialog on page 1989, where you can access advanced paintbrush controls. These are the standard set of Painter Interface options. The same options can be seen, for example in the Skin modifier, for painting weights.

Here you will find a rich selection of brush configuration tools that change the way your brush strokes apply color to the selection. Includes tools for mirror painting mode and using pressure sensitivity.

**Palette** Click to display the Color Palette on page 1984, which lets you create, edit, and manage custom palettes for use with VertexPaint.

**Selection group**
Tools in this group let you choose sub-object selection levels. You can select vertices, faces or elements. Includes the option to ignore backfacing so you can limit your selection to sub-objects that face toward you, and also provides access to standard soft selection options.

This creates a mask that will let you determine what is being affected by your paint strokes, and any other operations you might apply, such as blurring or color adjustment. Erase functionality will also honor this mode selection.

**NOTE** Soft Selection is supported on the various sub-object selection modes.

**Select vertex** Allows you to select vertices from the currently selected objects. Once selected, only these vertices will be available for painting.

**Select face** Allows you to select faces in the currently selected objects. Once selected, only these faces will be available for painting.

**Select element** Allows you to select elements in the currently selected objects. Once selected, only these elements will be available for painting.

**Ignore Backfacing** When this is on, prevents you from mistakenly selecting sub-objects facing away from the user.

**Soft Selection** The same soft-selection options on page 2014 found in Editable Mesh and Editable Poly are available by clicking this button.

**Image Adjustment group**

Tools in this group allow you to perform overall color adjustment or image blurring without using the paint brush in the viewport.
Adjust Color Displays the Adjust Color dialog on page 1982, where you can find sliders for adjusting HLS or RGB values, preview the adjustment effect, and apply it.

Blur Smoothes the pixels in the image so there is less contrast and color difference. Use this to get rid of harsh edges such as shadows created by the Assign Vertex Colors utility.

Blur Amount spinner Blurs currently selected channel values (for example, vertex color, alpha) for the currently selected objects. Also supports sub-object selection of vertices, faces, and elements. With soft selections, the final blurred value is computed, and then combined with the original color according the selection; a 50 percent soft selection means that a vertex will become a fifty-fifty combination of its original color and the blurred color. Successive clicks of the Blur button will successively blur the previous results, eventually washing out painting effects entirely.
Blur is useful for softening vertex color lighting information that is automatically generated by the Assign Vertex Color utility or rollout. Assign Vertex Color computes intensities per vertex. This is especially useful for low-resolution geometry and high-frequency lighting changes.

Blur Brush Lets you apply blurring by using the same brush techniques and settings that you use to apply color. The Blur Brush respects sub-object selection and the Blur Strength setting.

Layers group

Layer Mode: Normal
Opacity

1978 | Chapter 9  Modifiers
**Mode** The layer mode drop-down list allows you to select a specific operator for this paint layer. The operator selected affects base color, alpha, illumination, and other information coming up from layers below it, or from the base object itself. The chosen operator controls how the incoming color is combined with any newly painted colors for the current level.

This mode is changeable at any time, without destroying previously painted information in layers above, below, or in the current paint layer. The following modes are supported per paint layer:

- **Normal** The layer color completely overwrites the base color.

- **Overlay** The color cast is shifted towards the layer color and contrast might be increased.
  It's useful when you want to make an object appear a different color but in the same lighting conditions. A fully bright or dark channel is never affected however, so if Red=100% and Green=0% in the base color, then neither the red nor green channels can be affected by the layer color.

- **Screen** Each RGB channel is moved towards full brightness, depending on the layer color. The result is at least as bright (never darker) than the original. Black is transparent in this mode.

- **Multiply** Each RGB channel is moved towards zero, depending on the layer color. The result is at least as dark (never brighter) than the original. White is transparent in this mode.

- **Lighten** Whichever color is brighter, the layer or the base, is used as the output. It operates on the whole color, and *not* channel-by-channel.

- **Darken** Whichever color is darker, the layer or the base, is used as the output. It operates on the whole color, and *not* channel-by-channel.

- **Color dodge** Emulates the effect of "dodging" a color print in a darkroom; the result is at least as bright (never darker) than the original.
  For each RGB channel, if the layer is at full value in that channel, the output channel will be at full value. Even if the layer value is less than full value, the output is still strongly brightened in that channel. For example, a medium-red layer color will add a significant red brightness to the output.

- **Color burn** Emulates the effect of "burning" a color print in a darkroom; the result is at least as dark (never brighter) than the original. For each RGB channel, if the layer is zero in that channel, the output channel will be zero. Even if the layer value is above zero, the output is still strongly darkened in that channel. For example, a medium red layer color will significantly reduce blue and green brightness in the output.
The next four Light modes essentially offer compromises between the destructive effect of Normal Mode and the toning effect of Overlay mode. Try using medium-value desaturated layer colors, since the light modes can be too destructive with bright, vivid layer colors. A neutral grey layer color is transparent in any of the light modes.

- **Soft light**  Very similar to Overlay, but even more gentle, and it does not tend to increase contrast as much.

- **Hard light**  More like Normal mode than Overlay, it will change color cast somewhat. It is fairly destructive like Normal mode, especially with bright layer colors.

- **Vivid light**  Brighter layer colors produce a Color Dodge effect, while darker layer colors produce a Color Burn effect, although the effect is generally weaker than Dodge or Burn.

- **Linear light**  For each RGB channel, if the layer color is more than 50 percent bright in that channel, the output will be brightened, and if the layer is less then 50 percent bright, the output will be darkened. As an example, if you want the top of your image to be twice as bright, and the bottom to be half as bright, use a gradient from 75 percent gray to 25 percent gray, top to bottom.

The next four modes are used to control the HSV channel values of the image instead of using RGB channel value.

- **Hue**  The output color has the saturation and value of the base color, with the hue of the layer color.

- **Saturation**  The output has the hue and value of the base color, and the saturation of the layer color.

- **Color**  The output has the value of the base color, and the hue and saturation of the layer color.

- **Luminosity**  The output has the hue and saturation of the base color, and the brightness value of the layer color.

---

**NOTE** Using the show end result button in the modifier stack for the current paint layer will allow you to interactively paint under any over laying paint layers (vertex paint modifiers that are above the current one in the object’s modifier stack). This allows you to see the final results of your paint strokes for any paint layer in the stack.
Opacity Slider Allows you to set the opacity of the current vertex paint layer, from 0 to 100 percent. 100 percent Opacity means that the current layer is entirely opaque: you cannot see through it to the layer directly under it or to the base vertex colors of the objects being painted.

The opacity of a layer is animatable. Simply turn on Auto Key, move the time slider and adjust the spinner value. This will set a keyframe.

NOTE If you painted on the layer with a brush opacity less than 100 percent, then colors stored in the layer can already be less than full opacity, and the final opacity at any vertex is a product of the two values. If you vertex had only 50 percent opacity worth of paint applied to it, and the layer is 50 percent opaque, then the vertex will appear 25 percent opaque overall.

Be aware that the paint opacity is different from the vertex alpha channel. Values less than 100 percent incrementally reveal any vertex color, alpha information, and so on, coming from vertex paint layers beneath it, or the base object’s original information. Opacity values can be changed for the current layer at any time. Since vertex paint layers are preserved in the modifier stack you can return to a particular layer at any time and adjust its opacity to tune an object’s final appearance.

NOTE The opacity for a specific paint layer should not be confused with “alpha” information for a given vertex. Opacity controls the mixing of painted information in the modifier stack for the currently active map channel (whether it be color information, alpha, illumination, or any arbitrary map channel from 1 to 99). Alpha Channel information (by convention) is intended to be used specifically to indicate the transparency of all combined color information for a given vertex.

Another way to think about the opacity slider is that it is identical to the amount spinner. The difference between them is that opacity is for the entire layer, where as amount is for the current brush stroke (between a mouse down and mouse up period when painting). Changing the amount spinner after painting does not affect what is already displayed on the screen; where changing the opacity layer does. In the end, the current vertex paint layer being applied generates a final color that is the combine result of amount and opacity. The whole concept should be quite natural to any Adobe Photoshop user. However, Photoshop is able to display a light grey and dark grey quilt as a background to give a visual cue about layer opacity, whereas 3ds Max does not support this same display cue. So in 3ds Max, more attention is required of the artist to understand the opacity of each vertex on each layer.

Opacity numeric entry field Allows you to enter an opacity amount. Range=0 (completely transparent) to 100 (totally opaque).
New Layer Click to create a new VertexPaint layer. Clicking new layer displays a New Layer dialog.

Delete Layer Click to delete the current VertexPaint layer. This removes the modifier from the stack.

Condense to single layer Click to condense all vertex coloring into a single layer in the current VertexPaint modifier. Use this to modify existing vertex coloring within the current modifier.

Condensing layers is a two-part operation: First 3ds Max adds a new VertexPaint modifier to the stack, combining vertex coloring applied directly with Editable Mesh/Polygon and from previous VertexPaint layers according to the settings described above. Second, it deletes any prior VertexPaint modifiers.

If Preserve Layer has been turned on for a particular VertexPaint layer, then its colors are “baked” into the new VertexPaint modifier, but the preserved layer isn’t deleted from the stack.

Adjust Color Dialog (VertexPaint Modifier)

Select an object. > Modify panel > Modifier List > VertexPaint > VertexPaint Paintbox > Click the Adjust Color button.

Select an object. > Modifiers menu > Mesh Editing > Vertex Paint > VertexPaint Paintbox > Click the Adjust Color button.

Select an object. > Utilities panel > More > Assign Vertex Colors > Click Assign to Selected > Modify panel > Modifier List > VertexPaint > VertexPaint Paintbox > Click the Adjust Color button.

The Adjust Color dialog lets you adjust the color of currently selected vertices. If there is no active vertex sub-object selection, it affects all vertices equally.
Interface

HSV  (The default.) When chosen, the first three sliders are labeled HSV, and adjust the colors' hue, saturation, and value.

RGB  When chosen, the first three sliders are labeled RGB, and adjust the colors' red, blue, and green components.

See Red, Green, Blue / Hue, Saturation, Value on page 8698.

Preview When on, vertex color adjustments are previewed interactively in shaded viewports (provided that on the Paintbox, Vertex Color Display - Unshaded or Vertex Color Display - Shaded is active). Default=on.

Contrast slider Lets you adjust the contrast of the vertex colors.

Histogram and Input-Level Spinners

Histogram Graphically shows the distribution of colors in the vertex selection, as well as the current shadow, gamma, and highlight input levels.
The shadow, gamma, and highlight input levels can help you adjust 3ds Max viewport color to better match your target hardware display (such as a game engine).

**Shadow level** Adjusts the level of shadow display.

**Gamma level** Adjusts the gamma display. This value is a gamma correction.

**Highlight level** Adjusts the level of highlight display.

When you adjust a level, the corresponding arrow moves on the histogram, to indicate the current setting. (However, you can’t graphically drag the arrows.)

---

**Apply** Click to apply the current settings to vertex colors, without closing the dialog.

**Reset** Click to restore dialog settings to their defaults.

---

**Color Palette (VertexPaint Modifier)**

Select an object. > Modify panel > Modifier List > VertexPaint > VertexPaint Paintbox > Click the Palette button.

Select an object. > Modifiers menu > Mesh Editing > Vertex Paint > VertexPaint Paintbox > Click the Palette button.

Select an object. > Utilities panel > More > Assign Vertex Colors > Click Assign to Selected > Modify panel > Modifier List > VertexPaint > VertexPaint Paintbox > Click the Palette button.

The VertexPaint modifier’s Color Palette lets you create and maintain color palettes for use with vertex paints. You can save or load palettes as Color Clipboard (CCB) files, which are also used by the Color Clipboard utility on page 378.

**NOTE** The Palette remembers the last palette you used. This is not affected by File > Set. However, the active palette is saved in the file `3dsmax.ini` on page 60, so deleting the INI file causes the palette to revert to the default grayscale palette.
Procedures

To use the palette to choose a color:

- On the List or Swatch panel, click the color.
  The color appears as the active color on the VertexPaint Paintbox, in the swatch just below the Erase button.

To change the color of a color swatch:

1. Double-click the swatch.
   A Color Selector on page 371 appears.

2. Use the Color Selector to change the swatch’s color.
   This version of the Color Selector is modeless on page 8641, so after choosing a color you can either close it, or leave it open to change another swatch.

To use the color picker:

1. In the Palette’s List panel, highlight the name of a color.

2. Click the Color Picker button to turn it on.
   The cursor changes to an eyedropper icon.

3. Without depressing the mouse button, drag to an area where you want to pick a color.
   You can obtain colors from viewports, the 3ds Max user interface, or anywhere on the Windows desktop.

4. When you depress the mouse button, the picker obtains the color below the cursor. You can drag while the mouse button is depressed. While you do, the color swatch in the palette and the larger swatch on the Paintbox update.

5. Release the mouse to pick the color you want.
   The color in the Palette and the active color in the Paintbox are both updated.

To change a color’s name:

1. In the List panel, click the name twice (more slowly than a double-click).
   The name changes to an editable field.
2 Enter a new name or edit the existing one, and then press Enter. Press Esc to cancel the name change.

To save a palette to a file:

1 Right-click the List panel or the Swatch panel. The Palette's pop-up menu on page 1989 appears.
2 Choose Save As from the menu. A Save Color Clipboard File dialog appears.
3 Use the dialog to give the palette a name (and optionally, a directory location other than the default), and then click OK to save the CCB file.

To load a palette from a file:

1 Right-click the List panel or the Swatch panel. The Palette's pop-up menu on page 1989 appears.
2 Choose Load from the menu. A Load Color Clipboard File dialog appears.
3 Choose the CCB palette file you want to load, and then click OK.
Interface

New Click to add a new color to the palette.

The only limit to the number of colors a palette can have is a file size or memory limitation.
Delete Click to delete the active color.

Copy Click to copy the active color.

Paste Click to paste a copied color to the active swatch.

Color Picker Highlight a color in the palette, turn this button on to activate the picker, then drag anywhere on the Windows desktop. The color is picked when you release the mouse. (See the procedure “To use the color picker,” above.)

List panel Displays the colors in the palette, along with their names.

Swatch panel Displays the colors in the active palette. The swatch panel doesn’t list the names of colors, but each color’s name appear as a tooltip when the mouse is over the swatch.
List and Swatch Panel Right-Click Menu

When you right-click the List panel or the Swatch panel, a pop-up menu appears.

**Copy** Copies the active color.
This is the same as clicking Copy.

**Paste** Pastes a color to the active swatch.
This is the same as clicking Paste.

**New** Adds a color to the palette.
This is the same as clicking New.

**Delete** Deletes the active color.
This is the same as clicking Delete.

**Save As** Displays a *Save As* dialog on page 7441 that lets you enter a name for the CCB file, then save it.
By default, Color Clipboard files are saved in the `\images` directory below the 3ds Max root directory.

**Load** Displays a file open dialog that lets you choose a CCB palette file to load.

**View** Displays a text-editor window with the current CCB palette file. If no CCB file has been loaded or saved, choosing View has no effect.
The first 12 lines of a CCB file contain integer RGB values. This part of the file is used by the Color Clipboard utility on page 378 and ignored by the Color Palette dialog. The remaining lines of the file include floating-point RGB values and color names.

Painter Options Dialog (VertexPaint Modifier)

Modify panel > Skin modifier > Parameters rollout > Weight Properties group > Painter Options button

VertexPaint modifier > Floating Vertex Paintbox > Brush Options button

Edit/Editable Poly object or Poly Select modifier > Soft Selection rollout > Paint Soft Selection group > Brush Options button

Edit/Editable Poly object > Paint Deformation rollout > Brush Options button

VertexPaint Modifier | 1989
The Painter Options dialog for the Skin modifier appears when you click the Painter Options button.

This same dialog is used by the VertexPaint modifier to control the brush envelope, use pressure sensitivity, or enter mirror painting mode. The dialog is accessed through the Brush Options button on the floating Vertex Paintbox.

The dialog is also used by the Paint Soft Selection and Paint Deformation tools available for poly objects.

Interface

**Brush Properties group**

**Min. Strength** Sets the minimum vertex weight to paint.

**Max. Strength** Sets the maximum vertex weight to paint.
Min. Size  Sets the minimum size for the paint gizmo.

Max. Size  Sets the maximum size for the paint gizmo.

**Brush strength falloff curve**  This graph determines how the brush weight falls off as the distance increases from the center of the brush. The controls on this graph are similar to those on a loft deformation dialog on page 781.

Additive  When on, brush strokes add to existing vertex weights.

**Quick Brush Falloff Types**  Set the brush falloff to linear, smooth, slow, fast, or flat.

**Display Options group**

The options in this group determine the appearance of the paint gizmo.

**Draw Ring**  A ring appears as part of the paint gizmo.

**Draw Normal**  A normal arrow appears as part of the paint gizmo.

**Draw Trace**  Draws a trace (temporary mark) that shows the path of the brush stroke on the surface.

**Normal Scale**  Sets the scale of the normal arrow in the paint gizmo.

**Marker**  Displays a circular marker at the end of the normal arrow. The value next to Marker sets the height of the marker.

**Pressure Options group**

**Enable Pressure Sensitivity**  Turns on pressure sensitivity for the paint gizmo brush.

**Pressure Affects**  Selects the brush parameter to be affected by pressure sensitivity. Choose from four options: None, Strength, Size, or both size and strength (Size/Str).

**Predefined Str Pressure**  Turn this option on to use a predefined strength pressure. Click the button to view and edit the falloff curve for the strength.

**Predefined Size Pressure**  Turn this option on to use a predefined size pressure. Click the button to view and edit the falloff curve for the size.
Mirror group

Mirror Turn this option on to mirror the paint gizmo on the other side of the object. Choose an axis from the drop-down menu. The paint gizmo is mirrored about the selected axis in the world coordinate system.

Offset Offsets the mirror plane by the value you specify.

Gizmo Size Changes the mirror gizmo size to a value you specify.

Misc group

Tree Depth Determines the size of the quad tree used for hit testing. Tree Depth relates to the amount of memory set aside for weight painting. Larger values mean faster interaction but more memory use.

Update On Mouse Up Prevents the system from updating viewports when the mouse button is pressed. This can save time in your workflow.

Lag Rate Determines how often the stroke updates the painted surface. Higher values update the surface less often.

Volume Select Modifier

Modify panel > Make a selection. > Modifier List > Vol. Select

Make a selection. > Modifiers menu > Selection Modifiers > Volume Select

The Volume Select modifier lets you make a sub-object selection of vertices or faces for passing up the stack to another modifier or modifiers. The sub-object selection is completely separate from the underlying parametric geometry of the object. Like other selection methods, Volume Select works with single or multiple objects.
Faces and vertices selected using box volumes.

Volume Select lets you use one of three gizmos or another object to define a volume of space as the selection area, to which you can then apply modifiers. You can move the selection over an object and animate it.

When applied, Volume Select begins with the current geometry in the object’s stack, whether it’s a whole object or a sub-object selection (for example, from an Edit Mesh on page 1321 or another Volume Select modifier).
Top: Original mesh with select gizmo showing
Bottom: Modification made after applying Volume Select modifier

**Patches**

As of version 4, patch objects coming up the modifier stack are not converted to a mesh by this modifier. A patch object input to the Volume Select modifier retains its patch definition. Files that contain patch objects with the Volume Select modifier from previous versions of 3ds Max will be converted to meshes to maintain backward compatibility.

**Scaling Compatibility**

The Volume Select gizmo scales along with its object. Thus, if you apply a Volume Select modifier, and then change the scale of your object (with the toolbar Scale function on page 918) the selection doesn't change. In other words, all three transforms affect the Volume Select gizmo and its object identically.
**Volume Select Center**

The Volume Select modifier has a center as well as a gizmo. This lets you alter the center for non-animated transforms. However, if you animate a rotation about the offset center, you achieve animation of both rotation and translation.

**Procedures**

**To apply and use volume selection:**

1. Select an object and apply the Vol. Select modifier. The Parameters rollout appears.
2. In the Stack Selection Level group, choose Object, Vertex, or Face to specify the kind of geometry you want to work with.
3. In the Select By group, choose one of the four volume types: Box, Sphere, Cylinder, or Mesh Object.
   If you choose Mesh Object, you should then click the None button and select an object to use as the selection volume.
4. Choose a selection method and type (defined in the following Interface section). You can change these choices as you work, depending on the particular selection you're trying to make.
5. Once the selection is complete, you can do the following:
   - Apply modifiers to the selection.
   - Transform the Volume Select gizmo at the sub-object level, changing the selection in the process.
   - Combine these options. See the following example.

**Example: To animate a volume selection:**

1. Apply Volume Select to an object.
2. Make a sub-object selection of the object's geometry at Face or Vertex level, and apply a geometric modifier, such as Bend on page 1165, to the selection.
3. Move to a nonzero frame and begin animation. Adjust parameters on the geometric modifier, then move to another frame.
4 In the stack, return to the Volume Select modifier. Choose the Volume Select gizmo sub-object. Move the gizmo and its geometry selection to another part of the object.

5 Repeat this process on other frames. Optionally, you can return to the geometric modifier and change its parameters at any frame.

During playback, you see the effect of an animated geometric modifier moving over the object.

**Interface**

**Modifier Stack**

![Modifier Stack Interface](image)

**Gizmo sub-object** You can transform and animate the gizmo to change the selection. Translating the gizmo translates its center an equal distance. Rotating and scaling the gizmo takes place with respect to its center.

**Center sub-object** You can translate and animate the center, which affects rotation or scaling of the Volume Select modifier’s gizmo.

For more information on the Stack Display, see Modifier Stack on page 8187.
Parameters rollout

- Stack Selection Level:
  - Object
  - Vertex
  - Face

- Selection Method:
  - Replace
  - Add
  - Subtract
  - Invert

- Selection Type:
  - Window
  - Crossing

- Select By
  - Volume:
    - Box
    - Sphere
    - Cylinder
    - Mesh Object
    - None
  - Surface Features:
    - Material ID:
    - Sm Group:
    - Texture Map
      - None
    - Mapping Channel
      - Map
      - Vertex Color

- Alignment:
  - Fit
  - Center
  - Reset
  - Auto Fit
Stack Selection Level group

Object/Vertex/Face  Volume Select provides three selection levels. Vertex and Face levels put the modifier stack in sub-object selection. You can make one sub-object selection for each Volume Select modifier. You can then toggle the one selection between Face and Vertex level to send either up the stack. Object (top) level lets you modify the whole object while retaining any sub-object selection.

Selection Method group

Replace  Clears any selection passed up the stack to the Volume Select modifier, and then selects geometry within the volume.

Add  Selects all geometry within the volume, adding to any previous selection.

Subtract  Deselects all geometry within the volume.

Invert  Reverses the entire selection set. Geometry that was unselected becomes selected, and vice versa.

Selection Type group

Let's you determine whether selected faces are wholly or partially within the defined volume when you set Stack Selection Level to Face.

Window  Selects only faces with all three vertices within the selection volume.

Crossing  Selects faces with only one vertex within the selection volume.

Select By group

These controls let you define the selection with a primitive, a mesh object, or by surface characteristics.

Volume: Box/Sphere/Cylinder  To define the selection space using a standard primitive-shaped gizmo, choose one of these. You can then scale, rotate, or move the gizmo anywhere around the object.

Volume: Mesh Object  Choose this option to use another object to define the selection space. After choosing Mesh Object, click the button below it (labeled "None" by default), and then select an object to use as the volume.

Besides mesh objects, you can use patch objects and NURBS objects. In addition, if you turn on Soft Selection rollout > Use Soft Selection, you can use spline objects and particle systems to define the selection. This latter option is quite powerful because the selection changes as the particles move.
Mesh object button  Click this button, then select an object to define the selection space. You don't need to choose Mesh Object first, but you do need to choose Mesh Object to use the object as a volume. After you select an object, its name appears on the button. This button is labeled "None" if no object has been chosen.

NOTE  The selection depends on a volume intersecting the object. If a gizmo or object is scaled down and moved inside an object, no selection occurs because no geometry is within the volume of the gizmo.

Surface Features  Defines the selection by surface characteristics instead of a geometric volume. While this doesn't have much to do with volume, it was added because Volume Select is a procedural modifier, whereas Mesh Select on page 1500 is explicit. Now, even if your topology changes, Volume Select will consistently select the faces or vertices using a particular material or smoothing group.

Indicate which type of surface characteristic to base selection on by choosing one of the following:

Material ID  Specifies a material ID. All faces or vertices using the ID indicated by the spinner value are selected.

Sm Group  Specifies a smoothing group. All faces or vertices using the ID indicated by the spinner value are selected.

Texture Map  Specifies a texture map from the scene. Click the map button (labeled "None" by default) to choose a texture map to use for selection. All faces or vertices using that texture map will be selected. When using the Texture Map option, you can also specify a mapping channel or the vertex color channel using the Map/Vertex Color radio buttons and spinner.

NOTE  You must apply mapping to the object below Vol. Select in its stack for the Texture Map selection to work. That is, the Vol. Select modifier must have mapping coordinates passed up the stack so it can use a texture map for selection.

NOTE  If you set Selection Type to Window, vertices will be selected if all the faces they touch use the specified material or smoothing group. If you set Selection Type to Crossing, vertices will be selected if they touch any face using the specified material or smoothing group.

Alignment group

These controls are generally used when the gizmo has been transformed out of its original orientation to the object.
**Fit** Resizes the gizmo to fit around the object or previous selection in the stack. Maintains any previous rotation.

**Center** Recenters the gizmo on the object or previous selection in the stack. Maintains any previous scale or rotation.

**Reset** Returns the gizmo to its default size and orientation. Cancels the effect of all previous transforms.

**Auto Fit** When on, automatically adjusts the gizmo size and shape to fit the object as you change the underlying topology (for example, transforming vertices).

**Soft Selection rollout**

These controls, available only at the Vertex stack selection level, let you set a gradual falloff of influence between selected and unselected vertices. See [Soft Selection Rollout (Edit/Editable Mesh)](page 2014) on page 2014.

**NOTE** Soft Selection does not apply to materials or smoothing groups. However, if there was already a weighted selection passed up the stack, a Volume Select set to Material or Smoothing Group mode and *not* set to Replace will preserve the selection.

---

**Wave Modifier**

Modify panel > Make a selection. > Modifier List > Object-Space Modifiers > Wave

Make a selection. > Modifiers menu > Parametric Deformers > Wave

The Wave modifier produces a wave effect in an object's geometry. You can use either of two waves, or combine them. Wave uses a standard gizmo and center, which you can transform to increase the possible wave effects.

The [Wave](page 2979) space warp has similar features, and is useful for applying effects to a large number of objects.
An object with the Wave modifier applied. Amplitude 1 and 2 can be changed, creating different profiles.

See also:
■ Ripple Modifier on page 1650

Procedures
To make an object wavey:

1 Select an object and apply the Wave modifier.

TIP To see the effect clearly, apply Wave to a broad, flat object that has many segments.

2 Set one or both values for amplitude, or the vertical height of the wave in current units.
Amplitude 1 produces a sine wave from one edge to the other, while Amplitude 2 creates a wave between the opposite edges. Switching a value from positive to negative reverses the position of peaks and troughs.
Set the length of the wave and the distance in current units between crests of both waves. The greater the length, the smoother and more shallow the wave for a given amplitude.

To add a phase effect:
- Set a phase value to shift the wave pattern over the object. Positive numbers move the pattern in one direction, while negative numbers move them in the other. This effect is especially clear when animated.

To add a decay effect:
- Set a decay value to increase or decrease the amplitude. A decay value decreases the amplitude as the distance from the center increases. As the Decay value increases, the wave is concentrated at the center and flattens until it disappears (completely decays).
Interface

Modifier Stack

Gizmo  At this sub-object level, you can transform and animate the gizmo like any other object, altering the effect of the Wave modifier. Translating the gizmo translates its center an equal distance. Rotating and scaling the gizmo takes place with respect to its center.

Center  At this sub-object level, you can translate and animate the center, altering the Wave gizmo's shape, and thus the shape of the wavy object.

For more information on the stack display, see Modifier Stack on page 8187.

Parameters rollout

Amplitude 1/Amplitude 2  Amplitude 1 produces a sine wave along the gizmo's Y axis, while Amplitude 2 creates a wave along the X axis (although peaks and troughs appear in the same direction with both). Switching a value from positive to negative reverses the positions of peaks and troughs.

Wave Length  Specifies the distance in current units between the crests of both waves.
**Phase** Shifts the wave pattern over the object. Positive numbers move the pattern in one direction, while negative numbers move it in the other. This effect is especially clear when animated.

**Decay** Limits the effect of the wave generated from its origin. A decay value decreases the amplitude at increasing distance from the center. As this value increases, the wave is concentrated at the center and flattened until it disappears (completely decays).

---

**Welder Modifier**

Modify panel > Make a selection. > Modifier List > Object-Space Modifiers > Welder

Welder smooths a mesh that has a tear in it. Welder welds either the vertices or face normals on page 8654 of an Editable Mesh on page 2192. To “weld” normals means to make nearby vertices use the same normal.

Welder is meant for use with Cloth meshes on page 1204 that you have cached using a Point Cache modifier on page 1574. Add the Welder modifier to the stack above the Point Cache modifier. You don’t need to use Welder if the Cloth modifier is still active in the stack.

In the illustration, the cloth consists of two planes, and the edges of the front half of the join between the planes have been selected.
Two planes of cloth to weld
Welding normals with Don’t Weld Sel Edges on (the default)
At the rear half of the join, normals on either plane are matched within the Threshold distance.
Welding normals with Don’t Weld Sel Edges off
Normals are matched all along the join.
Welding vertices with Don’t Weld Sel Edges on (the default)

Welding vertices joins the plane geometry, but only at the rear half of the join are normals matched.
Welding normals with Don’t Weld Sel Edges off
Vertices are joined and normals are matched all along the join.

Interface

**Threshold**  Sets a threshold for welding vertices. When two vertices are within this distance, they are welded for smoothing purposes. Default=0.1.

**Verts/Normals**
- **Verts**  When chosen, smooths the mesh based on the proximity of vertices.
- **Normals** (The default.) When chosen, smooths the mesh based on face normals.

**Don’t Weld Sel Edges** When on, Welder does not weld selected edges. For example, you might not want to smooth the creases between the panels of a mesh created by Garment Maker on page 1266. You must select the edges at a lower level of the stack. Default=on.

---

**XForm Modifier**

Modify panel > Make a selection. > Modifier List > Object-Space Modifiers > XForm

Make a selection. > Modifiers menu > Parametric Deformers > XForm

Use the XForm (short for Transform) modifier to apply transformations (Move, Rotate, Scale) to objects. The XForm has two main functions:

- To animate transformations of a sub-object selection. You can also animate the position of the modifier's center.
- To transform an object at any point in the stack.

**NOTE** The Linked XForm modifier on page 1484 is a variant of XForm. Linked XForm has no gizmo or center of its own. Instead, a given selection is “linked” to another object, which supplies its gizmo and center. Using Linked XForm, you can link a sub-object selection directly to the coordinate system of another object.

---

**Using XForm**

XForm provides a gizmo and center for any geometry it receives from the stack whether it’s a sub-object selection or the whole object. XForm has no parameters. When you move the XForm modifier gizmo, the center moves with it, along with the geometry.

You can reposition the XForm center separately from the gizmo.

**Offsetting XForm Center**

At the XForm Center sub-object selection level, only the Move transform is available. This lets you reposition the center. When you return to the Gizmo
level, you can rotate or scale the selection around the offset center. The center position and gizmo transformations are all animatable.

**Scaling with XForm**

When you scale an object with a toolbar Scale tool, 3ds Max applies the effect to the object after all the modifiers in the stack. In some cases you might want to squash or stretch an object before applying geometric or edit modifiers. XForm makes this possible.

By applying XForm and scaling its gizmo, you can place the scaling operation anywhere in the stack.

**Using XForm with Volume Select**

You can combine the XForm and Volume Select modifiers on page 1992 to animate sub-object selections. This combination makes it possible to animate both the effect of a modifier on the selection (Volume Select) and a transformation of that selection (XForm).

**Procedures**

**To use the XForm modifier:**

1. Choose a location in an object's stack and apply the XForm modifier. The Gizmo sub-object level is automatically activated. All transform buttons are available on the toolbar.

2. Move to a nonzero frame and turn on Auto Key to animate the next step.

3. Transform the gizmo.
   As you transform the gizmo, the selected geometry is transformed with it.

**To use XForm as a scaling modifier:**

1. Apply XForm to an object or a sub-object selection.

2. Scale the gizmo.
   The rescaled geometry becomes "part of the stack" because the scale transform is carried with XForm, instead of being applied after the modifiers.
Interface

This modifier has no parameters, but you can transform the XForm gizmo and the XForm center. If you switch the selection level to the XForm center, only the Move transform is available. This lets you offset the center and transform the gizmo around it. Both offset and gizmo transformations are animatable.
Surface Modeling

Surface modeling is more free-form than geometric (parametric) modeling. Although you can create Patch and NURBS primitives from the Create panel, more often a surface model begins when you use the quad menu on page 8052 or the modifier stack on page 8187 to “collapse” a parametric model to some form of editable surface. Once you have done so, a variety of tools let you shape the surface. A lot of surface modeling work is done by editing sub-objects on page 8732 of the surface object.

![Three types of surface models: patch (left); mesh (center); NURBS (right)](image)

Subdivision Surfaces

A subdivision surface is a surface that has been divided into more faces while retaining the object's general shape. You perform subdivision to add detail to an object, or to smooth it out.

3ds Max supports two kinds of subdivision surfaces:

- The HSDS modifier on page 1464 provides hierarchical subdivision surfaces, which you can use to add fine detail to an object.
The MeshSmooth modifier on page 1505 and TurboSmooth modifier on page 1818 provide smoothing. Related closely to these are the Subdivision Surface rollout on page 2325 controls for editable poly on page 2240 objects, with which you can subdivide a surface without the need for a modifier.

**NOTE** These controls are not available with the Edit Poly modifier.

The latter type works best as a finishing tool for models.

## Soft Selection Rollout

Select an editable patch, editable mesh, editable poly, editable spline, an object that has an Edit Mesh, Edit Patch, or Edit Spline modifier applied to it, or an object that has a comparable Select modifier applied to it. > Modify panel > Choose a sub-object level. > Soft Selection rollout

The Soft Selection controls allow you to partially select sub-objects in the vicinity of an explicit selection. This causes the explicit selection to behave as if surrounded by a "magnetic field." Partially selected sub-objects within the field are drawn along smoothly as you transform the sub-object selection; the effect diminishes with distance or the "strength" of the partial selection.

This falloff is visible in the viewports as a color gradient surrounding the selection, conforming to the first part of the standard color spectrum: ROYGB (red, orange, yellow, green, blue). Red sub-objects are those you select explicitly. The highest-value soft-selected sub-objects are reddish-orange; they have the same selection value as red sub-objects, and respond the same way to manipulation. Orange sub-objects have a slightly lower selection value, and respond to manipulation a bit less strongly than do red and reddish-orange vertices. Yellow-orange sub-objects have an even lower selection value, and then yellow, green-yellow, and so on. Blue sub-objects are effectively unselected and don't respond to manipulation, except as required by neighboring soft-selected sub-objects.

Normally, you designate a soft selection procedurally, by setting parameters and then selecting sub-objects. You can also “paint” a soft selection explicitly on poly objects. See Paint Soft Selection group on page 2021.

By default, the soft-selection region is spherical without regard to geometric structure. Alternatively, you can use the Edge Distance option on page 2017 to limit the selection to vertices in contiguous faces.
If a sub-object selection is passed up the modifier stack, and Use Soft Selection is on, the results of modifiers that deform the object, such as Bend and XForm, are affected by the Soft Selection parameter values.

The controls in this dialog let you modify Soft Selection parameters. All sub-object levels share the same Soft Selection parameter values. Soft Selection is available for NURBS, mesh, poly, patch, and spline objects.

**Procedure**

To edit a soft selection in the viewport:

This procedure describes usage of the Customize User Interface > Edit Soft Selection Mode feature for editing the Falloff, Pinch, and Bubble values for soft selection.

For more information, including a list of feature sets with which Edit Soft Selection Mode is available, see Edit Soft Selection Mode on page 2019.

1. From the Customize menu, choose Customize User Interface; this opens the Customize User Interface dialog to the Keyboard panel. From the Group drop-down menu on the dialog, choose the feature set with which you wish to use Edit Soft Selection Mode, such as Editable Poly.

2. In the group’s Action list, check the action for Edit Soft Selection Mode (or Edit Soft Selection). If it’s not already assigned, or you wish to change the keyboard shortcut, highlight the action and use the standard method
to set a Hotkey. Alternatively, switch to one of the other panels and set, for example, a toolbar button for the action. When finished, close the dialog.

3 Select an object to edit and activate the feature set from step 1. On the Modify panel, go to the sub-object level you wish to edit, such as Vertex.

4 If necessary, expand the Soft Selection rollout and turn on Use Soft Selection.

5 Make a sub-object selection.
   The viewport shows your selection in red and the surrounding, soft-selected sub-objects in a color gradient.

6 Press the hotkey for Edit Soft Selection mode, or otherwise activate the action.
   The mouse cursor switches to the Falloff symbol.

7 Press and hold the mouse button, and drag vertically: upward to increase the Falloff value, or downward to decrease Falloff.
   As you drag, the color gradient changes to show the modified Falloff, as does the Falloff value on the Soft Selection rollout.

8 When you've finished editing the Falloff, release the mouse button and then click once.
   The mouse cursor switches to the Pinch symbol.

9 Drag to adjust the Pinch value.

10 When you've finished editing Pinch, release the mouse button and then click once.
   The mouse cursor switches to the Bubble symbol.
11 Drag to adjust the Bubble value.

12 You can continue cycling through the three editing modes by releasing the drag and then clicking once.

13 To finish using Edit Soft Selection Mode, right-click in the active viewport.

Interface

Use Soft Selection Affects the action of Move, Rotate, and Scale functions at sub-object levels of the editable object or Edit modifier, as well as the action of deformation modifiers applied to the object if they are operating on a sub-object selection (the latter also applies to the Select modifiers). When on, 3ds Max applies a spline curve deformation to the unselected sub-objects surrounding the selection you transform. To take effect, this check box must be on before transforming or modifying the selection.

Edge Distance When on, limits the soft-selection region to the specified number of edges between where you select and the maximum extent of the
soft selection. The affected region is measured in terms of "edge-distance" space, along the surface, rather than real space.

This option is useful in cases where you want to select only contiguous sections of geometry. For example, if a bird's wing is folded back against its body, selecting the wing tip with Soft Selection would affect body vertices as well. But if you turn on Edge Distance, set the numeric value to the distance (in edges) along the wing that you wish to affect, and then set Falloff to an appropriate value, selecting and then moving the wing tip would move only the wing geometry.

Affect Backfacing When on, deselected faces whose normals face in the opposite direction to the average normal of the selected sub-objects are affected by the soft-selection influence. In the case of vertices and edges, this applies to the normals of faces to which they're attached. Turn off Affect Backfacing when you want to manipulate faces of a thin object, such as a thin box, but don't want to affect faces on the other side of the object.

**NOTE** Affect Backfacing is not available when editing splines.

Falloff Distance in current units from the center to the edge of a sphere defining the affected region. Use higher falloff settings to achieve more gradual slopes, depending on the scale of your geometry. Default=20.

**NOTE** The region specified by the Falloff setting is depicted graphically in the viewports as a color gradient in vertices and/or edges (or, with editable polys and patches, optionally in faces). The gradient ranges from the selection color (normally red) to the non-selected sub-object color (normally blue). In addition, this gradient is updated in real time as you change the Falloff setting.

**NOTE** If Edge Distance on page 2017 is on, the Edge Distance setting limits the maximum falloff amount.

Pinch Raises and lowers the top point of the curve along the vertical axis. Sets the relative "pointedness" of the region. When negative, a crater is produced instead of a point. At a setting of 0, Pinch produces a smooth transition across this axis. Default=0.

Bubble Expands and contracts the curve along the vertical axis. Sets the relative "fullness" of the region. Limited by Pinch, which sets a fixed starting point for Bubble. A setting of 0 for Pinch and 1.0 for Bubble produces the smoothest bulge. Negative values for Bubble move the bottom of the curve below the surface, creating a "valley" around the base of the region. Default=0.
(soft selection curve) Graphically displays how Soft Selection will work. You can experiment with a curve setting, undo it, and try another setting with the same selection.

**Shaded Face Toggle** Displays a color gradient corresponding to the soft selection weights on faces within the soft selection range. Available only when editing patch and poly objects.

If the **Vertex Color display property** on page 291 of an editable poly or editable patch object is off, clicking the Shaded Face Toggle button will turn on Soft Selection Color shading. If the object already has an active Vertex Color setting, clicking the Shaded Face Toggle overrides the previous setting and changes it to Soft Selection Color.

**NOTE** Use the Undo command if you do not want to change your vertex color shading properties.

**Lock Soft Selection** Locks the soft selection in order to prevent changes to the procedural selection.

Using Paint Soft Selection (see following) turns on Lock Soft Selection automatically. If you turn it off after using Paint Soft Selection, the painted soft selection is lost and cannot be restored with Undo.

**Edit Soft Selection Mode**

In addition to the controls described in the preceding section, you can edit the soft selection in the viewports with interactive controls based on a Customize User Interface action named Edit Soft Selection Mode. This mode is available for the following feature sets:

- Editable Mesh surface
- Editable Poly surface
- Edit Mesh modifier
- Edit Patch modifier
- Edit Poly modifier
- Edit Spline modifier
- HSDS modifier
- Mesh Select modifier
- MeshSmooth
- Patch Select modifier
- Poly Select modifier
- Projection modifier
- Vol. Select modifier

For each feature set, open the Customize User Interface dialog from the Customize menu, and choose the feature from the Group drop-down list. For many feature sets, but not all, the Edit Soft Selection Mode keyboard shortcut is set to 7 by default. For the rest, such as Editable Poly, you must set the keyboard shortcut with the Customize User Interface controls.

For the basic method of using Edit Soft Selection Mode, follow this procedure on page 2015.

To enter Edit Soft Selection Mode, press the keyboard shortcut (or click the toolbar button, etc.) assigned in Customize User Interface. When active, drag to use the current mode and click to switch to the next mode. To exit, right-click in the active viewport.

The three Edit Soft Selection Mode modes, along with their mouse-cursor symbols, are:

- **Falloff**
- **Pinch**
- **Bubble**
Paint Soft Selection group

Paint Soft Selection lets you specify a soft selection explicitly by dragging the mouse over the selection. The Paint Soft Selection functionality is available at sub-object levels with Editable Poly objects, as well as with objects with the Edit Poly or Poly Select modifier applied. You can work in one of three painting modes: Paint, Revert, and Blur.

**TIP** You can streamline the painting process by using the Brush Presets tools on page 8044.

**Paint** Lets you paint a soft selection on the active object using the current settings. Drag the mouse cursor over the object surface to paint the selection.

**Blur** Lets you paint to soften the outlines of an existing painted soft selection.

**Revert** Lets you paint to reverse a soft selection on the active object using the current settings. Drag the mouse cursor over the object surface to reverse the selection.

**NOTE** Revert affects only a painted soft selection, not a soft selection made by normal means. Also, Revert uses only the Brush Size and Brush Strength settings, not the Selection Value setting.

**Selection Value** The maximum relative selection of the painted or reverted soft selection. The values of surrounding vertices within the brush radius fall off towards a value of 0. Default=1.0.

**Brush Size** The radius of the circular brush used for painting the selection.

**Brush Strength** The rate at which painting a soft selection sets the painted sub-objects to the maximum value. A high Strength value reaches the full value quickly, while a low value requires repeated applications to reach full value.
Brush Options Opens the Painter Options dialog on page 1989, with settings for brush-related properties.

Collapse Utility

Utilities panel > Utilities rollout > Collapse button

The Collapse utility lets you combine the stack operations of one or more selected objects into an Editable Mesh on page 2192 or the stack result, and, optionally, perform a Boolean on page 713 operation on them at the same time.

IMPORTANT You can't undo the results of using the Collapse utility. Before you use it, save a copy of your work file, or use Hold on page 242.

NOTE You can also collapse an object’s stack from the modifier stack right-click menu on page 8200, and convert a selection to editable surfaces on page 2013 with the transform quadrant of the quad menu on page 8052. These changes are undoable.

Procedures

To collapse the stack of an object into an editable mesh:

1 On the Utilities panel, click the Collapse button.
2 Select the object or objects that you want to collapse.
3 Click the Collapse Selected button.

   All modifiers are removed from the modifier stack and the object becomes an editable mesh.

To collapse the stack of an object into an editable surface other than mesh:

1 On the Utilities panel, click the Collapse button.
2 On the Collapse rollout, set Output Type to Modifier Stack Result.
3 Select the object or objects that you want to collapse.
4 Apply a modifier that outputs the desired ultimate surface type, such as Turn To Poly on page 1830 or Turn To Patch on page 1827.
5 Click the Collapse Selected button.
All modifiers are removed from the modifier stack and the object becomes an editable surface of the type indicated by the modifier.

To subtract multiple objects from another object:
The Boolean compound object restricts you to combining objects one at a time. With the Collapse utility, you can perform Boolean operations on several objects simultaneously.

1 For the purposes of this procedure, we'll call the object to have shapes subtracted from Main. Create and arrange Main and the objects to subtract from it. For example, you might have several boxes penetrating a sphere (Main) in different places; subtracting them will produce box-shaped cutouts in the sphere's surface.

2 Select Main, and then select the objects to be subtracted from it. The first object you select before collapsing is the one from which the others are subtracted.

3 On the Utilities panel, click the Collapse button.

4 On the Collapse rollout, set Output Type to Mesh, if necessary.

5 In the Collapse To group, choose Single Object.

6 Turn on Boolean, and then choose Subtraction.

7 Click the Collapse Selected button.

All objects you selected after Main, the first object, are subtracted from Main.
Selected Object group

Displays the name of the current selection. If more than one object is selected, "[Number] Objects Selected." displays.

Collapse Selected Collapses the selected objects. The method of collapse depends on the settings of the options below this button.

Output Type group

Specifies the type of object that results from the collapse.
Modifier Stack Result The resultant object will be the same as if you had collapsed its stack. In most cases, this results in a mesh object, as when using the Mesh option. However, if the object has an Edit Patch modifier so that its stack produces a patch, then the result will be a patch object rather than a mesh. Likewise, a shape with Edit Spline modifiers becomes an editable spline. When this option is used, the Collapse To options are unavailable, and all selected objects remain independent objects.

Mesh All selected objects become editable meshes regardless of their type before they were collapsed.

Collapse To group

Specifies how the selected objects are combined. These options are available only when you choose the Mesh option.

Multiple Objects Collapses each object in the selection but maintains each as an independent object. When this option is selected, the Boolean options are disabled.

Single Object Collapses all selected objects into a single, editable mesh object.

Boolean Performs Boolean operations on the selected objects. During the Boolean calculation, a progress bar appears along with a Cancel button. If any objects in the Boolean operation fail, that object is skipped, but the Collapse proceeds. The result is not a Boolean compound object, but a single editable mesh. The type of Boolean is specified by the following option.

Union Combines the several objects, removing intersecting geometry.

Intersection Removes all but the intersecting geometry.

Subtraction Maintains the first object selected while subtracting the subsequently selected objects. For example, to subtract several cylinders from a box, click to select the box, hold down Ctrl, and region-select the cylinders.

Close Exits the Collapse utility.

Graphite Modeling Tools

The Graphite Modeling Tools set, also known as the modeling ribbon, represents a new paradigm for editing mesh and polygonal objects. Its customizable, context-based interface provides all (and only) tools directly specific to the modeling task, and it minimizes onscreen clutter by giving you access to relevant parameters only as you need them. The Ribbon controls include all
existing Edit/Editable Poly tools as well as a plethora of new tools on page 2026 for creating and editing geometry.

NOTE Most tools on the modeling ribbon have two-part tooltips; the first part contains a brief description of the tool, and sometimes lists important options. The second part, when available, describes how to use the tool, and with certain tools lists secondary options.

NOTE The vertical modeling ribbon is available only as a Customize User Interface action that switches the ribbon orientation between horizontal and vertical. To access it, open the Customize User Interface dialog on page 8249, set Category to Modeling: Graphite Tools, and use the Toggle Modeling Ribbon Orientation action (see this procedure on page 2031). The vertical ribbon feature set is identical to that of the horizontal ribbon, except that it can be docked left and right, rather than top and bottom, and is always maximized.

New Tools

Many of the new modeling and texture-mapping features in Autodesk 3ds Max 2010 come from an existing plug-in known as PolyBoost. This topic lists and links to all of the PolyBoost tools now available in the modeling ribbon and elsewhere in 3ds Max.

NOTE In most cases, this list includes only major tools and toolsets, not variants or settings, which can be found nearby in the help.

Texture Mapping

Viewport Canvas on page 6455
Render Surface Map on page 6466
Loop [+-] on page 1865
Ring [+-] on page 1866
Stitch on page 1866
Align Horizontal on page 1867
Align Vertical on page 1868
Space Horizontal on page 1868
Space Vertical on page 1869
UV_SelectionFromBase/SelectionToBase on page 1869

**Polygon Modeling**

Transform Toolbox on page 936
Generate Topology on page 2053
Symmetry Tools on page 2053
Loop on page 2065
Grow Loop on page 2067
Shrink Loop on page 2067
Loop Mode on page 2067
Dot Loop on page 2068
Ring on page 2068
Grow Ring on page 2070
Shrink Ring on page 2070
Ring Mode on page 2070
Dot Ring on page 2071
Outline on page 2071
Similar on page 2071
Fill on page 2072
Fill Hole on page 2072
StepLoop on page 2074
Step Mode on page 2075
Tweak (UVs) on page 2077
SwiftLoop on page 2080
Paint Connect on page 2083
Cap Poly on page 2095
Quadrify ... on page 2097
Spin on page 2113
Insert Vertices on page 2113
GeoPoly on page 2124
Distance Connect on page 2133
Flow Connect on page 2135
Auto Ring (on Flow Connect drop-down) on page 2135
Insert Loop on page 2135
Remove Loop on page 2137
Set Flow on page 2139
Build End on page 2139
Build Corner on page 2140
Loop Tools on page 2142
Random Connect on page 2142
Hard/Smooth on page 2154

**PolyDraw**

Step Build on page 2158
Extend on page 2159
Drag on page 2159
Optimize on page 2160
Shapes on page 2161
Topology on page 2161
Splines on page 2162
Strips on page 2163
Surface on page 2163
Branches on page 2163
New Object on page 2164
Solve Surface on page 2164
**Paint Deform**

- Shift on page 2167
- Push/Pull on page 2167
- Relax/Soften on page 2168
- Smudge on page 2169
- Flatten on page 2170
- Pinch/Spread on page 2171
- Noise on page 2172
- Exaggerate on page 2173
- Revert on page 2174

**Selection**

- Tops on page 2181
- Open on page 2182
- Hard on page 2182
- Non-Quads on page 2182
- Patterns on page 2182
- Stored Selections on page 2184
- By Surface on page 2186
- By Normal on page 2187
- By Perspective on page 2187
- By Random on page 2188
- By Half on page 2189
- By Pivot Distance on page 2190
- By View on page 2190
- By Symmetry on page 2191
- By Numeric on page 2191
PolyBoost tools for modifying vertex selections in the Cloth modifier are available on the Group rollout on page 1249.

The Ribbon Interface

The modeling ribbon takes the form of a toolbar that can float or dock in a horizontal or vertical configuration. The toolbar contains three tabs: Graphite Modeling Tools, Freeform, and Selection.

Each tab contains a number of panels whose presence depends on the context, such as the active sub-object level. You can use a right-click menu to determine which panels appear, and you can also tear off panels so they float independently on the interface. You can adjust the panel size horizontally by dragging either end, and when you make it smaller, the panels adjust automatically to fit. The same controls that were previously available directly then become available from drop-down menus.

The main tab on the modeling ribbon is the Graphite Modeling Tools tab, and its first panel, Polygon Modeling, provides a subset of Modify panel tools: sub-object level (Vertex, Edge, Border, Polygon, Element); stack level, preview options for sub-object selection, and more. At any time you can show or hide any available panel with the right-click menu.

Using the Ribbon

The Graphite Modeling Tools interface takes the form of a highly customizable, context-sensitive toolbar containing three tabs: Graphite Modeling Tools, Freeform, and Selection. Each of these comprises a number of panels whose availability depends on the context.

The ribbon can assume a horizontal or vertical configuration and either configuration can float or be docked. The horizontal version can be maximized (Show Full Ribbon) or minimized to tabs or panel titles. By default, the ribbon is horizontal, minimized to panel titles, and is docked immediately above the viewports (below the main toolbar), as shown in the following illustration.
NOTE When the ribbon is horizontal, you can attach the Quick Access toolbar to its bottom edge. For details, see Quick Access Toolbar on page 7995.

The basic unit of ribbon organization is the panel; each panel contains a related set of tools. The most important panel, and the only one that appears by default on the ribbon when no qualifying object is selected, is the Polygon Modeling panel on page 2045. This panel contains global controls for making the other panels available, switching sub-object levels, toggling soft selection, and more.

Procedures

This section includes some basic procedures for getting started with the modeling ribbon. For more information about using and configuring the ribbon, be sure to read Modeling Ribbon Controls on page 2036.

To activate the modeling ribbon:

By default, 3ds Max starts with the horizontal configuration of the modeling ribbon open, minimized to panel titles, and docked to the top of the interface, just above the viewports. If you close it and quit the program, it does not automatically reopen when you restart.

Do either of the following:

- On the main toolbar, click the Graphite Modeling Tools (Open) button.
- At the bottom of the Tools menu, click Graphite Modeling Tools.

Each of these is a toggle: If the ribbon is closed, it opens it, and if open, it closes it.

To switch the ribbon orientation:

By default, the ribbon uses a horizontal configuration, but you can change it to vertical using Toggle Modeling Ribbon Orientation, an action available from the Customize User Interface dialog.

1. On the menu bar, choose Customize > Customize User Interface to open the Customize User Interface dialog on page 8249.
2 Choose whether to make the Toggle Modeling Ribbon Orientation command available from the keyboard, a toolbar, a quad menu or a regular menu, and click the corresponding tab on the dialog. This procedure shows how to add the command as a toolbar button. To use a different interface item, see the respective topic in the Customize User Interface Dialog help section.

3 Click the Toolbars tab and set Category to Modeling: Graphite Tools. This category contains only two actions: One to toggle the ribbon interface (already available on the main toolbar and Tools menu) and the other to toggle the orientation.

4 Drag the Toggle Modeling Ribbon Orientation from the list to a toolbar and then close the dialog.
   By default, the button text is “Toggle Modeling Ribbon Orientation,” of which only the central part is visible on the button.

5 To customize the button, right-click the button, choose Edit Button Appearance, and use the Edit Button Appearance dialog on page 8258 controls to change the button to your liking.

6 Click the new button.
   The first time, the ribbon switches to vertical orientation. Thereafter, clicking the button toggles the orientation.

   **NOTE** The vertical ribbon is always maximized.

To minimize or maximize the ribbon:

The ribbon in its horizontal orientation has three different minimize/maximize states. This procedure describes two ways to switch among them:

   **NOTE** The vertical ribbon is always maximized.

➢ Do either of the following:
   ■ Click the minimize/maximize button on the ribbon. If you hold the mouse over the button, a tooltip describes what happens when you click.
Right-click an empty portion of the ribbon, such as the area above the panels, to open the right-click menu, and then access the Minimize submenu on page 2044. The current state has a check mark next to it; choose a different one from the menu.

To convert an object to editable poly or Edit Poly format:

For most ribbon functions to be available, a single editable poly on page 2240 or Edit Poly on page 1332 object must be selected, and the corresponding stack level must be active. If the object you want to work with is not in the required format, you can use the ribbon to convert it.

1. Select an object.
2. If the ribbon is minimized, open the Polygon Modeling panel; otherwise, open the panel expansion.
3. Choose Convert To Poly or Apply Edit Poly Mod.
This converts the object or applies the modifier, respectively, and switches to Modify mode if necessary.

**NOTE** You could also use Collapse Stack if the stack collapses to an editable poly object. However, if you collapse a primitive object such as a Teapot with non-format-specific modifiers such as Bend, the result is an editable mesh object, which is not compatible with the modeling ribbon.

To start using the modeling ribbon with an editable poly or Edit Poly object:

You can use the modeling ribbon tools with a selected editable poly or Edit Poly object when the corresponding stack level is active and the software is in Modify mode.

Once you become familiar with the ribbon, you can accomplish just about any polygon-modeling task without resorting to the Modify panel. At that point, you can hide the command panel most of the time while working in 3ds Max, thus recovering valuable screen real estate.

1. Select an editable poly or Edit Poly object (to convert an object, see the preceding procedure).
To use the ribbon tools, Modify mode must be active; that is, the Modify panel must be the current command panel (whether or not the command panel is displayed).

2 Check the wide button on the Polygon Modeling panel:

![Modify Mode Button](image)

If it says Modify Mode, click the button to switch to Modify mode. If it says anything else, proceed to the next step without clicking.

3 If the Editable Poly or Edit Poly stack level is active, the applicable panels then become available. If the ribbon is maximized or minimized to panel titles, the panels are readily apparent. If the ribbon is minimized to tabs, you can see all available open panels on a tab by clicking the tab (see Minimize submenu on page 2044).

If the object is already in a required format but has modifiers other than Edit Poly applied, one of which is active, you need to switch to the Editable Poly or Edit Poly stack level. You can do so using the Next/Previous Modifier buttons on the Polygon Modeling panel.

For instance, consider an editable poly object with the Cloth modifier applied. When the Cloth modifier is active on the stack, the ribbon looks like this:

![Cloth Modifier](image)

Note that the wide button on the Polygon Modeling panel shows the modifier name.
The Next/Previous Modifier buttons enable navigation up and down the
stack, respectively. When navigation in only one direction is possible,
the other button is disabled.

In this example, you would use the Previous Modifier button,
thus accessing the Editable Poly level of the modifier stack.

4 Use the Next/Previous Modifier buttons to go to the Editable Poly or Edit
Poly stack level.

Modeling Ribbon Controls

Most ribbon-configuration controls are available from right-click menus. This
topic details these controls as well as others for customizing the ribbon setup.

NOTE When you reconfigure the ribbon and then exit 3ds Max, the changes are
automatically saved in the two files in the folder MaxModelingRibbon.Config.xml
and MaxManaged.cui. These files are saved in the system path on page 8293, in the
UI directory. By default, this is C:\Documents and Settings\[user name]\Local
Settings\Application Data\Autodesk\3dsmax\[3ds max version]\enu\UI. The next
time you start 3ds Max, it reads the previous ribbon status from these files and
restores it.

To return the ribbon to its default configuration, quit 3ds Max, delete both
MaxModelingRibbon.Config.xml and MaxManaged.cui from the system UI path
(be sure to make backup copies first), and restart.

Floating and Docking the Modeling Ribbon and its Panels

- To dock a floating horizontal ribbon to the top or bottom of the interface,
or the vertical ribbon left or right, drag it to the desired location and, when
the mouse cursor changes to a horizontal strip, release it. Alternatively,
right-click the title bar and choose the desired docking location from the
Dock submenu.

- To float the docked ribbon, drag it by the left end (horizontal) or top
(vertical) away from the docked location. The cursor changes from a
horizontal strip to a rectangle to let you know when releasing it will cause
it to float.
To float a panel by itself, drag it by the title bar (bottom edge or right side) away from the ribbon or panel group. If Show Panel Titles on page 2045 is off, there’s still a small bar at the bottom of docked panels on the horizontal ribbon by which you can drag the panel. However, this bar is not available on non-expanding panels on the vertical ribbon when Show Panel Titles is off.

To move a floating panel or group, drag it by the title or by the “thumbs”: the gray extensions on either side of a floating panel group. You can see the thumbs on the panels in the following illustration.

NOTE By default, panel thumbs are transparent and appear only when the mouse cursor is over the panel. However, on panels that contain spinners, the thumbs are always visible.

To dock a panel to a floating panel or panel group, drag the first to the others until a “landing zone” (rectangular outline, as shown in the illustration) appears on the target, and then release the mouse button.

Thereafter you can move the panel group as a unit.

To return a floating panel or panel group to the ribbon, drag it to the ribbon. If the panel’s “home” tab is active, a rectangular outline appears where it will dock when you release the mouse button. If the panel’s home tab is not active, the tab highlights. If a panel group contains a mix, a combination of the aforementioned conditions occur.
Similarly, to change a panel's position on the ribbon, drag it to the desired location.

**Resizing the Modeling Ribbon**

When the horizontal ribbon floats, you can resize it horizontally by dragging either end. When you reduce the size of the maximized ribbon, the panel contents automatically scale down to fit within the current width, first by dropping labels and ultimately by replacing the visible panel contents with the panel title. At that point, you need to click the panel to view its contents.
Center: ... at medium width, and ...

Bottom: ... fully reduced

NOTE Panels also sometimes scale down when the ribbon is more crowded. This happens when you access a sub-object level, which opens additional panels, or if you add optional panels.

- When the vertical ribbon floats, you can resize it both horizontally and vertically by dragging a vertical or horizontal edge, respectively. When you reduce the vertical ribbon height, the panel contents do not scale; rather, a scroll bar becomes available for scrolling through the panels.
Additional Controls

- To use a panel tool, click its button. To learn its function, hover the mouse cursor over it for a moment and read the tooltip.
NOTE  Certain tools, such as Use Soft Selection, open a contextual settings/options panel when active. The contextual panel always opens on all tabs of the ribbon, even if the panel with the tool floats. If you like, you can use the right-click menu to turn it off on other panels.

■ Contextual panels open at the right end of the ribbon. Like any other panel, you can drag them to another location on the ribbon if you wish.

The Soft Selection and Slice Mode contextual panels have been moved closer to the left end of the ribbon.

When the ribbon is minimized to panel titles, contextual panels are indicated with “---” on both sides of the panel title, as shown in the following illustration:

Interface

In addition to the modeling tools provided by the panel buttons and other controls, the modeling ribbon provides interface-management functions in the form of buttons and a context-sensitive right-click menu.

Buttons

Button-type ribbon controls let you expand panels, pin the expansions, and more; all are described in this section.

[open panel expansion] At the bottom or right side of every panel is the title bar; if Show Panel Titles on page 2045 is off, a thin bar takes its place. If the title bar contains a small arrowhead, that means it can be expanded to show additional controls. To expand the panel, click the title.
The panel expansion remains open as long the mouse cursor stays on it. To close it, simply move the mouse away.

![Panel Expansion Example](image)

**Left:** Click the panel title bar ...

**Right:** ... to open the panel expansion.

**NOTE** When the ribbon is minimized to panel titles, panels expand fully when opened, so further expansion is inapplicable.

**TIP** If you like, you can “pin” open a panel expansion (see following).

**[pin/unpin panel expansion]** At the left end of the title bar of an expanded panel is a small button with a pushpin icon (see preceding illustration). To “pin” the panel expansion, thus locking it open, click this button. To allow it to close, “unpin” it by clicking the button again.

**NOTE** When Show Panel Titles on page 2045 is off, the “pin” icon takes the form of a small circle.

**Return Panels to Ribbon** Restores all panels in the group to the modeling ribbon. Each panel returns to its previous tab and location on the ribbon, before it was floated. Available only on floating panels.
**Toggle Orientation** Switches the panel group layout between vertical and horizontal. Available only on floating panels.

Top: Floating panel group in vertical orientation  
Bottom: Floating panel group in horizontal orientation

**Minimize** Click this button, found on the horizontal ribbon to the right of the tab titles, to cycle through the three minimize/maximize options: Minimize to Panel Titles, Minimize to Tabs, Show Full Ribbon. For details, see Minimize submenu on page 2044.

**Right-click menu**

When you right-click the ribbon or a floating panel group, different commands and submenus appear, depending on where you click. Following is a comprehensive listing of available right-click-menu commands.

**Add to Quick Access Toolbar** Copies the button to the Quick Access toolbar on page 7995, leaving the original in place on the ribbon. Available only when right-clicking a modeling-ribbon button.
To remove the button from the Quick Access toolbar, right-click the button and choose Remove From Quick Access Toolbar.

**Minimize submenu** Choose one of the three Minimize settings, available only for the horizontal ribbon:
- **Minimize to Tabs** The ribbon shows only tab names. To access the panels, click a tab; this maximizes the ribbon temporarily. When you move the mouse cursor away from the ribbon, it minimizes again.

![Graphite Modeling Tools, Freeform, Selection]

In this mode, additional controls on some panels are available on the panel expansion, indicated by a small arrowhead next to the panel title when the panels are expanded. Click the title to open the expansion.

- **Minimize to Panel Titles** The ribbon shows tabs and panel titles. To access a panel, mouse over its title.

![Graphite Modeling Tools, Freeform, Selection]

In this mode, each panel expands to show all controls automatically; no further expansion is available.

- **Show Full Ribbon** Maximizes the ribbon so each panel always shows all or most of its controls.

![Graphite Modeling Tools, Freeform, Selection]

In this mode, additional controls on some panels are available on the panel expansion, indicated by a small arrowhead next to the panel title. Click the title to open the expansion.

**Tabs submenu** Toggles visibility of the three tabs: Graphite Modeling Tools on page 2045, Freeform on page 2155, and Selection on page 2180.

**Panels submenu** Lists all panels available for the active tab. Visible panels have check marks next to their names; hidden ones don’t. To toggle a panel, click its name in the list.

**NOTE** Floating panels do not appear in the list; to enable control over the visibility of a floating panel, return it to the ribbon.
Show Panel Titles When on, a panel title appears at the bottom or side of each panel (depending on orientation). When off, the panel titles are replaced by thin horizontal strips on the horizontal ribbon; you can drag these away from the ribbon to float the panels. However, on the vertical ribbon, turning of Show Panel Titles simply removes the title bars.

NOTE When Minimize to Panel Titles is active, panel titles always appear. Also, floating panels always have titles.

Graphite Modeling Tools Tab

Modeling ribbon > Graphite Modeling Tools tab

The Graphite Modeling Tools tab contains the tools you use most often for polygon modeling, organized into separate panels for easy, convenient access.

Polygon Modeling Panel

Modeling ribbon > Graphite Modeling Tools/Freeform/Selection tab > Polygon Modeling panel

NOTE The Polygon Modeling panel is visible by default only on the Graphite Modeling Tools tab but can be made visible on the Freeform tab and Selection tab via the right-click menu.

The Polygon Modeling panel includes tools for switching sub-object levels, navigating the modifier stack, converting objects to editable poly and Edit Poly, and more.

Because this is perhaps the most commonly used panel, we recommend that you float it separate from the modeling ribbon (“tear” it off by dragging the panel label), and use the rest of the ribbon minimized, to maximize screen real estate.
Recommended setup: The modeling ribbon is docked and minimized, while the Polygon Modeling panel floats.

See also:

- Editable Poly Surface on page 2240

**Interface**

Polygon Modeling panel on minimized ribbon
NOTE The sub-object level buttons on the Polygon Modeling panel provide the same selection-conversion features as their counterparts on the Modify panel. For details, see this note on page 1347.

**Vertex** Accesses the Vertex sub-object level, which lets you select a vertex beneath the cursor; region selection selects vertices within the region.
**Edge** Accesses the Edge sub-object level, which lets you select a polygon edge beneath the cursor; region selection selects multiple edges within the region.

**Border** Accesses the Border sub-object level, which lets you select a sequence of edges that borders a hole in the mesh. A border comprises only connected edges with faces on only one side of them, and is always a complete loop. For example, a default box primitive doesn't have a border, but the teapot object has a couple of them: one each on the lid, the body, and the spout, and two on the handle. If you create a cylinder and delete one end, the row of edges around that end forms a border.

When Border sub-object level is active, you can't select edges that aren't on borders. Clicking a single edge on a border selects that whole border.

You can cap a border, either with the [Cap function](#) on page 1392 or by applying the [Cap Holes modifier](#) on page 1185. You can also connect borders between objects with the [Connect compound object](#) on page 695.

**NOTE**

The Edge and Border sub-object levels are compatible, so if you go from one to the other, any existing selection is retained.

**Polygon** Accesses the Polygon sub-object level, which lets you select polygons beneath the cursor. Region selection selects multiple polygons within the region.

**Element** Accesses the Element sub-object level, which lets you select all contiguous polygons in an object. Region selection lets you select multiple elements.

**NOTE**

The Polygon and Element sub-object levels are compatible, so if you go from one to the other, any existing selection is retained.

**Modify Mode/[stack level]** Switches to the Modify panel, or if the Modify panel is active, shows the current modifier stack level.
Usage examples:

■ if any object is selected and any command panel other than the Modify panel is active, the button label reads “Modify Mode.”

■ For an object with no modifiers, if the Modify panel is active and the object type is anything other than editable poly or Edit Poly, the button is unavailable; otherwise the button shows the object type, such as “Editable Poly.”

■ If the Modify panel is active and the current stack level is a modifier, the button shows the name of the modifier.

**TIP** When the Modify panel is active, you can navigate the modifier stack with the Next/Previous Modifier controls.

**Toggle Command Panel** Toggles visibility of the command panel.

**NOTE** Clicking this button always makes the Modify panel active.

**Pin Stack** Locks the modifier stack and modeling ribbon controls to the currently selected object so they remain with that object regardless of subsequent changes in selection.

**TIP** Pin Stack is useful for transforming another object while keeping your place in the modified object’s stack.

**Show End Result (off/on)** Shows the selected object as it appears after all modifications in the stack have taken place, regardless of your current position in the stack.

When this toggle is off, the object appears as modified up to the current modifier in the stack.

**Next/Previous Modifier** Moves up or down the stack, respectively, making the next highest or lowest modifier current.
Equivalent to clicking the entry above or below the current one in the modifier stack.

**Preview** This option lets you preview a sub-object selection before committing to it. You can preview at the current sub-object level, or switch sub-object levels automatically based on the mouse position. The choices are:

- **Preview Off**  No preview is available.

- **Preview SubObject** Enables previewing at the current sub-object level only. As you move the mouse over the object, the sub-object under the cursor highlights in yellow. To select the highlighted object, click the mouse.
  
  To select multiple sub-objects at the current level, press and hold Ctrl, move the mouse to highlight more sub-objects, and then click to select all highlighted sub-objects.

![Polygon sub-object selection preview with Ctrl held down](image)
To deselect multiple sub-objects at the current level, press and hold Ctrl+Alt, move the mouse to highlight more sub-objects, and then click a selected sub-object. This deselects all highlighted sub-objects.

**Preview Multi**  Works like Preview SubObject, but also switches among the Vertex, Edge, and Polygon sub-object levels on the fly, based on the mouse position. For example, if you position the mouse over an edge, the edge highlights, and then clicking activates the Edge sub-object level and selects the edge. To select multiple sub-objects of the same type, press and hold Ctrl after highlighting a sub-object, move the mouse to highlight more sub-objects, and then click to activate that sub-object level and select all highlighted sub-objects. To deselect multiple sub-objects at the current sub-object level, press and hold Ctrl+Alt, move the mouse to highlight more sub-objects, and then click a selected sub-object. This deselects all highlighted sub-objects. Note that this method does not switch sub-object levels.

**NOTE** When Ignore Backfacing (see following) is off, you’ll see backfacing vertices and edges highlight while previewing a sub-object selection.

**Ignore Backfacing** Toggles selection of backfacing sub-objects. When on, selection of sub-objects affects only those facing you. When off (the default), you can select any sub-object(s) under the mouse cursor, regardless of their visibility or facing.

**Use Soft Selection** Toggles Soft Selection on page 2014 and the Soft Selection Panel on page 2053, with settings for controlling how Soft Selection works. Available only at sub-object levels. When off, transforming a sub-object selection affects only those sub-objects. When on, partially selects sub-objects near an explicit selection, depicted as a color gradient. Transforming then falls off with distance from explicitly selected sub-objects.
NOTE When the modeling ribbon is maximized or the Polygon Modeling panel floats, the following controls appear on the Polygon Modeling panel expansion.

**Collapse Stack** Same as *Collapse All* on page 1052: Collapses the selected object’s entire stack to an editable object that preserves the cumulative effect of the collapsed modifiers on the base object. See *Collapsing the Stack* on page 1051.

You can use the Graphite Modeling Tools with an object that results from collapsing the stack only if it’s an editable poly.

**Convert to Poly** Converts the object to editable poly format and switches to Modify mode.

This is the quickest way to start using the Graphite Modeling Tools on an object.

**Apply Edit Poly Mod** Applies the *Edit Poly modifier* on page 1332 to the object and switches to Modify mode.
Generate Topology Opens the Topology dialog on page 2057 with tools for adjusting the object’s geometric makeup.

Symmetry Tools Opens the Symmetry Tools dialog on page 2062 with controls for making models symmetrical.

Full Interactivity Toggles the level of feedback for the QuickSlice and Cut tools, as well as all settings dialogs. Available with editable poly objects, but not the Edit Poly modifier.

When on (the default), the final result is always visible as you use the mouse to manipulate the tool or change a numeric setting. With Cut and QuickSlice, when Full Interactivity is turned off, only the rubber-band line is visible until you click. Similarly, with numeric settings in dialogs, the final result is visible only when you release the mouse button after changing the setting.

The state of Full Interactivity doesn't affect changing a numeric setting from the keyboard. Whether it's on or off, the setting takes effect only when you exit the field by pressing Tab or Enter, or by clicking a different control in the dialog.

Soft Selection Panel

Modeling ribbon > Graphite Modeling Tools/Freeform/Selection tab > Polygon Modeling panel > Use Soft Selection

NOTE The Polygon Modeling panel is visible by default only on the Graphite Modeling Tools tab but can be made visible on the Freeform tab and Selection tab via the right-click menu.

The Soft Selection panel opens when Use Soft Selection is on, and provides controls for modifying how Soft Selection works. For details, see Soft Selection Rollout on page 2014
**Interface**

When on, you can change Soft Selection parameters interactively with the keyboard and mouse. For details, see [this procedure](#) on page 2015 and [this section](#) on page 2019.

**Paint**  Paint a soft selection on the active object using the current settings. When active, opens the [Paint Soft Selection panel](#) on page 2056 for controlling how painting works.

Drag the mouse cursor over the object surface to paint the selection.

**TIP** You can streamline the painting process by using the [Brush Presets tools](#) on page 8044.

**Lock**  Locks the soft selection in order to prevent changes to the procedural selection.

**NOTE** Painting the soft selection turns on Lock Soft Selection automatically. If you turn it off after using Paint Soft Selection, the painted soft selection is lost, and cannot be restored with Undo.

**Shaded**  When on, displays a color gradient corresponding to the soft selection weights on faces within the soft selection range.
Shaded makes it easier to see the soft-selection area, especially with complex models.

**Use Backfaces** When on, deselected faces whose normals face in the opposite direction to the average normal of the selected sub-objects are affected by the soft-selection influence. In the case of vertices and edges, this applies to the normals of faces to which they’re attached.

**TIP** Turn off Use Backfaces when you want to manipulate faces of a thin object, such as a thin box, but don’t want to affect faces on the other side of the object.

**NOTE** When the modeling ribbon is maximized or the Soft Selection panel floats, the following controls appear on the Soft Selection panel expansion.

**Use Edge Distance** When on, limits the soft-selection region to the specified number of edges (use the adjacent numeric setting) between where you select and the maximum extent of the soft selection. The affected region is measured in terms of "edge-distance" space, along the surface, rather than real space.

This option is useful in cases where you want to select only contiguous sections of geometry. For example, if a bird’s wing is folded back against its body, selecting the wing tip with Soft Selection would affect nearby body vertices as well. But if you turn on Use Edge Distance, set the numeric value to the distance (in edges) along the wing that you wish to affect, and then set Falloff to an appropriate value, selecting and then moving the wing tip would move only the wing geometry.

**Falloff** Distance in current units from the center to the edge of a sphere defining the affected region. If Edge Distance is on, Falloff is measured in edges and the Edge Distance setting limits the maximum falloff amount.

**NOTE** The region specified by the Falloff setting is depicted graphically in the viewports as a color gradient in vertices and/or edges (or, with editable polys and patches, optionally in faces). The gradient ranges from the selection color (red by default) to the non-selected sub-object color (blue by default). In addition, This gradient is updated in real time as you change the Falloff setting.

**Pinch** Adjusts the slope of the curves on either side of the top point of the soft-selection falloff curve (visible on the command panel). Default=0.
Pinch sets the relative "pointedness" of the region. When negative, a crater is produced instead of a point. At a setting of 0, Pinch produces a smooth transition across this axis.

**Bubble** Expands and contracts the soft-selection falloff curve (visible on the command panel) along the vertical axis. Sets the relative "fullness" of the region. Default=0. Bubble is limited by Pinch, which sets a fixed starting point for Bubble. A setting of 0 for Pinch and 1.0 for Bubble produces the smoothest bulge. Negative values for Bubble move the bottom of the curve below the surface, creating a "valley" around the base of the region.

**Paint Soft Selection Panel**

Modeling ribbon > Graphite Modeling Tools/Freeform/Selection tab > Polygon Modeling panel > Use Soft Selection > Soft Selection panel > Paint

**NOTE** The Polygon Modeling panel is visible by default only on the Graphite Modeling Tools tab but can be made visible on the Freeform tab and Selection tab via the right-click menu.

**Interface**

**Blur** Paint with Blur to soften the outlines of an existing painted soft selection.
**Revert** Paint with Revert to reverse a soft selection on the active object using the current settings.

**Options** Opens the Painter Options dialog on page 1989, with settings for brush-related properties.

**NOTE** When the modeling ribbon is maximized or the Paint Soft Selection panel floats, the following controls appear on the Paint Soft Selection panel expansion.

- **Value** The maximum relative selection of the painted or reverted soft selection. The values of surrounding vertices within the brush radius fall off towards a value of 0. Default=1.0.
- **Size** The radius of the circular brush used for painting the selection.
- **Strength** The rate at which painting a soft selection sets the painted sub-objects to the maximum value. A high Strength value reaches the full value quickly, while a low value requires repeated applications to reach full value.

---

**Topology dialog**

Modeling ribbon > Graphite Modeling Tools/Freeform/Selection tab > Polygon Modeling panel [expansion] > Generate Topology

**NOTE** The Polygon Modeling panel is visible by default only on the Graphite Modeling Tools tab but can be made visible on the Freeform tab and Selection tab via the right-click menu.

The topology tools rework an object’s mesh subdivision into procedurally generated patterns. You can apply a topology pattern over an entire surface or a selected section.

The various topology tools are described following. The descriptions for the tools are only suggestions of what the tools can be used for, and you can combine multiple tools to create new patterns. Try experimenting with applying a tool several times to generate a different pattern. A typical use of these tools could be to first generate a topology pattern of some sort, and then extrude or bevel different parts to form a structure.
**Interface**

**NOTE** The topology tools work at the object level and all sub-object levels. To confine a tool’s effect to the current sub-object selection, press and hold Shift before clicking.

Also, all tools have assignable CUI action items on page 8249 available in the PolyTools category, as noted in the descriptions.

---

Wall  Generates a wall-type topology with bricks of different sizes.  
CUI action: TopoWall

Tiles  Generates a tile type topology.  CUI action: TopoTiles
Bricks Generates brick topology.

**IMPORTANT** This tool requires one edge to be selected. The direction of the edge determines which way is "up" on the bricks. The tool works only if the selected edge is within quad topology.

CUI action: TopoBrick

Hive Generates hive-type topology.

**IMPORTANT** This tool requires one edge to be selected. The direction of the edge determines which way is "up." The tool works only if the selected edge is within quad topology.

CUI action: TopoHive

Tiles2 Works like Tiles (see preceding), but the resulting tiles are slightly more random.

CUI action: TopoTiles2

Mosaic Generates mosaic topology, with random bricks of different sizes.

CUI action: TopoMosaic

Floor Works like Tiles (see preceding), but generates the pattern in a crossing direction.

CUI action: TopoFloor

Floor2 Works like Wall (see preceding), but generates the pattern in a crossing direction.

CUI action: TopoFloor2
Skin Generates a skin-type topology, with rounded patches.
CUI action: TopoSkin

Holer Generates "holes" in the topology.
If you press Alt the result is more chaotic and less rounded, because it removes vertices with only two edges going from them.
CUI action: TopoHoler

Diamond Changes the direction of the edges to a regular diagonal pattern.
CUI action: TopoEdgedir

Simplify Simplifies the topology by removing random parts, but keeping certain areas of edges intact.
CUI action: TopoSimplify

Chaos Generates a chaotic topology, with randomly shaped patches.
CUI action: TopoChaos

Fours Generates a tile-type topology, which consists of mostly larger quads.
CUI action: TopoFours

Stars Generates a random smoothed-stars topology.
CUI action: TopoStars

Cross Generates a topology with crosses.
CUI action: TopoCross

![Planks](image)

**Planks** Generates a plank-type topology, with "planks" of different sizes.

CUI action: TopoPlanks

![Planks2](image)

**Planks2** Similar to Planks (see preceding) but with broader planks.

CUI action: TopoPlanks2

![Planks3](image)

**Planks3** Generates a topology with large crosses of "planks."

CUI action: TopoPlanks3

![Planks4](image)

**Planks4** Similar to Planks (see preceding) but with longer planks.

CUI action: TopoPlanks4

![Tatter](image)

**Tatter** Generates "holes" in the topology, separated by rows of polygons.

The three numeric settings apply to Tatter only, before applying the tool.

- **Size** Determines the overall size of the generated holes.
- **Iterations** Determines the number of different sizes for the generated holes.
- **Smooth** Determines how rounded the generated holes will be.

CUI action: TopoTatter

**ScrapVerts** Removes all vertices in the mesh with two edges going from them.

CUI action: TopoScrapV

**Plane** Creates a Plane object and converts it to editable poly format for quick testing of the different tools. The value of the "S" parameter determines the number of segments in the plane.
Symmetry Tools dialog

Modeling ribbon > Graphite Modeling Tools/Freeform/Selection tab > Polygon Modeling panel [expansion] > Symmetry Tools

NOTE The Polygon Modeling panel is visible by default only on the Graphite Modeling Tools tab but can be made visible on the Freeform tab and Selection tab via the right-click menu.

These are tools for making models symmetrical when using the Symmetry modifier on page 1803 is not an option, such as when working with morph targets. You can model one side of the model and apply these tools to make it symmetrical about an axis.

The symmetry is based on an object you pick that is symmetrical about the chosen axis. It then determines which vertices are symmetrical and enables you to use that information on any other model sharing the same vertex count. The Symmetry tool works in the object’s local coordinate system.

Interface

Pick Main Model Click this button and then select the object on which to base the symmetry. The software then calculates the symmetry based on the specified axis with the specified Tolerance value (see following).
After calculating the symmetry, the software selects all non-symmetrical vertices in the model, including vertices in the center seam.

**Axis** The axis on which to base the symmetry, in the object’s local coordinate system.

The center of the axis is determined by the pivot point of the picked object. Changing the axis recalculates the symmetry for the picked model.

**Tolerance** The distance in world units that the software uses to determine whether two vertices are symmetrical. If the picked model is not completely symmetrical, increase this value slightly.

**Make Symmetrical group**

+ To +/- To + Use these buttons to make the model symmetrical on the chosen axis. Click to make everything on the minus side of the axis symmetrical to the plus side. Click to make everything on the plus side of the axis symmetrical to the minus side.

**Flip Symmetry** Works like a mirror tool by switching the vertex positions on the chosen axis.

**Vertex positions group**

**Copy Selected** Use this tool to copy the currently selected vertices’ positions.

**Paste** Use this tool to paste the vertex positions that you copied with the Copy Selected tool.

For example, you can copy the closed eyes or a certain mouth shape from one model to another. You can also copy positions from an editable poly object and paste them into an Edit Poly modifier.

**Modify Selection Panel**

Modeling ribbon > Graphite Modeling Tools/Selection tab > Modify Selection panel

**NOTE** The Modify Selection panel is visible by default only on the Graphite Modeling Tools tab but can be made visible on the Selection tab via the right-click menu.
The Modify Selection panel provides tools for adding to and subtracting from sub-object selections, both in general and with respect to loops and rings.

**Interface**

Modify Selection panel on minimized ribbon

Modify Selection panel on maximized ribbon, with expansion
**Grow** Expands the selection area outward in all available directions. For this function, a border is considered to be an edge selection.

With **Shrink** and **Grow**, you can add or remove neighboring elements from the edges of your current selection. This works at any sub-object level.

**Shrink** Reduces the sub-object selection area by deselecting the outermost sub-objects. If the selection size can no longer be reduced, the remaining sub-objects are deselected.

**Loop** Selects a loop or loops based on the current sub-object selection. Loop on the modeling ribbon differs from Loop on the Modify panel in that the latter works only on edges, while the former works at all sub-object levels.
Usage:

- **Vertex** Select sets of neighboring vertices and apply to select loops. If you select a single vertex, Loop selects all vertices on loops passing through the vertex.

Using Loop at the Vertex level

- **Edge** Select one or more edges and apply to select loops.

Using Loop at the Edge level

- **Polygon** Select sets of neighboring polygons and apply to select loops. If you select a single polygon, Loop selects all polygon loops that pass through the poly.
Using Loop at the Polygon level

Loop Cylinder Ends (on Loop drop-down) Selects vertex and edge loops along the top and bottom edges of a cylinder. Select an edge or a pair of adjacent vertices along the top and/or bottom edge of a cylinder, and then apply to select a loop.

Grow Loop Grows a loop based on current sub-object selection. Select part of one or more loops (an edge, or two or more adjacent vertices or polygons), and then click Grow Loop to select sub-objects at the end(s) of the loops.

Shrink Loop Reduces the extent of selected loops by removing sub-objects from the ends. Does not apply to circular loops. Select one or more non-circular loops and then click Shrink Loop to deselect sub-objects at the end(s) of the loops.

Loop Mode When on, selecting sub-objects can also automatically select an associated loop. For sub-object specifics, see the expanded tooltip.
Usage:

- **Vertex/Polygon** Select two or more adjacent sub-objects to select the associated loop(s).

- **Edge** Select one or more edges to select the associated loop(s).

To deselect a loop with Loop Mode active, hold Alt while making a selection described preceding.

- **Dot Loop** Selects loops with gaps. Select an edge or sets of two or more adjacent vertices or polygons in a row or column (to indicate the loop direction) and apply. To change the spacing, use the Dot Gap setting.

- **Dot Loop Opposite (on Dot Loop drop-down)** Selects vertex/polygon loops with gaps. Select sets of two or more adjacent vertices or polygons in a row or column (to indicate the loop direction) and apply. Starts with a different sub-object from Dot Loop. To change the spacing, use the Dot Gap setting.

- **Dot Loop Cylinder (on Dot Loop drop-down)** Selects edges or vertices in a non-continuous loop around the top and bottom edges of a cylinder, with the selection pattern determined by the Dot Gap setting available on the panel expansion. To use with edges, first select an edge on the top or bottom edge of a cylinder. To use with vertices, first select two or more adjacent vertices on the top or bottom edge of a cylinder.

- **Ring** Selects a ring or rings based on the current sub-object selection.

Usage:

- **Vertex** Select sets of neighboring vertices and apply to select rings.
Using Ring at the Vertex level

- **Edge** Select one or more edges and apply to select rings.

Using Ring at the Edge level

- **Polygon** Select sets of neighboring polygons and apply to select rings. If you select a single polygon, selects both the loop and ring the poly belongs to.
**Grow Ring** Grows one or more edge rings in steps. Available only at the Edge and Border sub-object levels.
Select one or more edges and then apply to select any available rings at either end of the current ring(s).

**Shrink Ring** Reduces the extent of selected edge rings by removing edges from the ends. Does not apply to circular rings. Available only at the Edge and Border sub-object levels.
Usage: Select one or more non-circular rings and then click Shrink Ring to deselect edges from the ends of the rings.

**Ring Mode** When on, selecting enough sub-objects to indicate the ring direction automatically selects the ring.
Sub-object level:

- **Vertex/Polygon** Select two or more adjacent sub-objects to select the ring(s) they’re on.
- **Edge** Select one or more edges to select the ring(s) they’re on.

To deselect a ring with Ring Mode active, hold Alt while selecting an edge in a selected ring.
**Dot Ring** Selects edge rings with gaps, based on the current selection. To change the spacing, use the Dot Gap setting.

**NOTE** When the modeling ribbon is maximized or the Modify Selection panel floats, the following controls appear on the Modify Selection panel expansion.

**Outline** Selects the border (outside members) of the current sub-object selection and deselects the rest. At the Polygon level, to select an edge border, use Shift (switches to Edge sub-object level).

**Similar** Adds to the current sub-object selection based on the characteristics of selected sub-objects and the settings on the drop-down for this tool. The availability of options and results depend on the sub-object level and the current selection. The options are:

- **Edge Count** Selects vertices with the same number of edges going from them as the selected vertices, or polygons with the same number of sides as the selected polygons.

- **Edge Length** Selects vertices with roughly the same combined length of connected edges as the selected vertices, or edges with roughly the same lengths as selected edges.

- **Face Count** Selects vertices with the same number of surrounding faces as the selected vertices.

- **Face Areas** Selects vertices or edges with roughly the same combined areas of surrounding faces as the current selection.

- **Topology** Selects edges whose endpoint vertices have the same number of neighboring edges and faces as the selected edges, or polygons whose vertices have the same edge count as the selected faces.

- **Normal Direction** Selects vertices, edges, or polygons with roughly the same normal directions on page 8654 as the current selection.

Graphite Modeling Tools Tab | 2071
Also see: Select By Numeric on page 2191.

**Fill** Selects all sub-objects between two selected sub-objects.

Usage: Select two objects to designate diagonally opposite corners of the area to be filled, and then click Fill.

Using Fill at the Vertex level

Using Fill at the Polygon level

**Fill Hole** Selects all sub-objects within an enclosed area, as designated by an outline selection and a freestanding selection inside the outline.
Outline an area with a selection, select a sub-object within the area, and click Fill Hole. The selected part must stand free from the surrounding selection, so, for example, a selected polygon in the hole should not be adjacent to any selected polygons around the hole.

Using Fill Hole at the Vertex level

Using Fill Hole at the Edge level
Using Fill Hole at the Polygon level

**StepLoop** Selects a loop between two selected sub-objects on the same loop.
Select two sub-objects on the same loop and apply StepLoop to select all sub-objects between them using the shortest distance.

Using StepLoop at the Vertex level

**StepLoop Longest Distance** (on StepLoop drop-down) Selects a loop between two selected sub-objects on the same loop using the longest distance, if possible.
Select two sub-objects on the same loop and apply StepLoop to select all sub-objects between them using the longest distance, if the complete loop is closed.

Step Mode Use Step Mode to select a loop in steps, increasing the loop length by selecting individual sub-objects.

Access the desired sub-object level and turn on Step Mode. Select a sub-object and then Ctrl+click to select another sub-object on the same loop. This also selects all sub-objects between the two in the shortest distance.

To select an edge or vertex loop at a cylinder end, use Shift+Ctrl+click to select the second and subsequent sub-objects.

If you select a sub-object not on the current loop, you start a new loop, and can then use Step Mode for that loop.

Dot Gap Specifies the extent of gaps between sub-objects in a loop selected with Dot Loop, or between edges in a ring selected with Dot Ring.

Edit Panel

Modeling ribbon > Graphite Modeling Tools/Freeform tab > Edit panel

NOTE The Edit panel is visible by default only on the Graphite Modeling Tools tab but can be made visible on the Freeform tab via the right-click menu.

The Edit panel provides a variety of tools for modifying mesh objects, including transform constraints, edge and loop creation, and editing texture coordinates.
Interface

Edit panel on minimized ribbon

Edit panel at Object level

Edit panel at sub-object levels

Preserve UVs When on, you can edit sub-objects without affecting the object’s UV mapping. You can choose any of an object’s mapping channels to preserve or not; see Preserve UVs Settings, following. Default=off.
Without Preserve UVs, there is always a direct correspondence between an object's geometry and its UV mapping. For example, if you map an object and then move vertices, the texture moves along with the sub-objects, whether you want it to or not. If you turn on Preserve UVs, you can perform minor editing tasks without changing the mapping.

Original object with texture map (left); Scaled vertices with Preserve UVs off (center); Scaled vertices with Preserve UVs on (right)

**TIP** For best results with Preserve UVs at the vertex level, use it for limited vertex editing. For example, you'll usually have no trouble moving a vertex within edge or face constraints. Also, it's better to perform one big move than several smaller moves, as multiple small moves can begin to distort the mapping. If, however, you need to perform extensive geometry editing while preserving mapping, use the Channel Info utility on page 6486 instead.

**Preserve UVs Settings (on Preserve UVs drop-down)** Opens the Preserve Map Channels dialog on page 2355, which lets you specify which vertex color channels and/or texture channels (map channels) to preserve. By default, all vertex color channels are off (not preserved), and all texture channels are on (preserved).

**TIP** You can open the Preserve Map Channels dialog quickly by Shift+clicking the Preserve UVs button.

**Tweak (UVs)** When on, you can adjust the UVW mapping on your model directly in the viewport by dragging over the vertices of the model to pull the texture vertices around.

By tweaking UVs with this tool you can quickly adjust areas of stretching in the UVW mapping without the need to add any modifiers. Use the spinner to choose the desired mapping channel and then start the tool. When finished tweaking, right-click to exit the tool.
Drag a vertex to adjust the UVs

When working with Tweak, it’s useful to have a material applied to the model that enables you to easily spot stretching in the mapping. A checker map is suitable for this purpose.

**TIP** To see the modified texture coordinates that result from using the Tweak tool, apply an *Unwrap UVW modifier* on page 1837 and then click the Edit button on the modifier’s Parameters rollout.

**Repeat Last** Repeats the most recently used command.

For example, if you extrude a polygon, and want to apply the same extrusion to several others, select the others, and then click Repeat Last.

You can apply a spline extrusion of a single polygon (left) repeatedly to other single polygons (1) or to multiple polygon selections, contiguous (2) or not (3).
NOTE  Repeat Last does not repeat all operations. For example, it does not repeat transforms. To determine which command will be repeated when you click the button, check the tooltip for the Repeat Last button on the command panel, which gives the name of the last operation that can be repeated. If no tooltip appears, nothing will happen when you click the button.

**QuickSlice** Lets you quickly slice the object without having to manipulate a gizmo. Make a selection, click QuickSlice, and then click once at the slice start point and again at its endpoint. You can continue slicing the selection while the command is active.

To stop slicing, right-click in the viewport, or click QuickSlice again to turn it off.

With QuickSlice on, you can draw a line across your mesh in any viewport, including Perspective and Camera views. The mesh is sliced interactively as you move the line endpoint.

NOTE  At the Object level, QuickSlice affects the entire object. To slice only specific polygons, use QuickSlice on a polygon selection at the Poly sub-object level.
NOTE At the Polygon or Element sub-object level, QuickSlice affects only selected polygons. To slice the entire object, use QuickSlice at any other sub-object level, or at the object level.

SwiftLoop Place edge loops by clicking. Turn on, then click anywhere to insert an edge loop automatically, perpendicular to the edge closest to where you click. Continue clicking edges or right-click to exit.

NOTE As you move the mouse cursor over the object surface, a real-time preview shows where the loop will be created when you click.

Additional features include the ability to slide edges or edge loops in different ways. Following are the different functions of the tool, which depend on which keyboard keys are pressed:

■ Shift Click to insert an edge loop and adjust the new loop to the flow of the surrounding surface.

■ Ctrl Click to select an edge loop and automatically activate the Edge sub-object level.

■ Alt Drag a selected edge loop to slide the edge loop between its bounding loops.

■ Ctrl+Alt Same as Alt but also straightens out the loop (if necessary) when you start to drag.

■ Ctrl+Shift Click to remove an edge loop.

Use NURMS Applies smoothing via the NURMS method and opens the Use NURMS Panel on page 2084. As implemented in Edit/Editable Poly, NURMS is an easy-to-use, procedural mesh-smoothing method that gives you overall control over smoothing parameters.

You control the degree of smoothing with the main Iteration setting, and, optionally the Iteration setting in the Render group as well.
**Cut** Lets you create edges from one polygon to another or within polygons. Click at the start point, move the mouse and click again, and continue moving and clicking to create new connected edges. Right-click once to exit the current cut, whereupon you can start a new one, or right-click again to exit Cut mode.

While cutting, the mouse cursor icon changes to show the type of sub-object it’s over, to which the cut will be made when you click. The following illustration shows the three different cursor icons.
Top: Cutting to a vertex
Center: Cutting to an edge
Bottom: Cutting to a polygon
Cut is available at the object level and all sub-object levels.

**NOTE** You can use Cut with Turn for enhanced productivity. For more information, see this procedure on page 1368.
**Paint Connect** When on, you can paint connections interactively between edges and vertices.

Paint Connect offers a variety of operational modes, depending on which key or keys are pressed:

- **Normal** Drag to paint connections between edges.
- **Shift** Drag to paint connections between edges in the middle of the edges.
- **Ctrl** Drag to select and connect vertices.
- **Alt** Click to remove a vertex.
- **Ctrl+Shift** Click to remove an edge loop.
- **Ctrl+Alt** Click to remove an edge.
- **Shift+Alt** Drag to paint a double connection (two parallel edges) between edges.

**TIP** After using Paint Connect to create a loop that changes direction, you can “quadify” the corner polygons with Build Corner on page 2140.

**Set Flow (on Paint Connect drop-down)** When on, using Paint Connect automatically repositions new edges to fit the shape of the surrounding mesh.

**Constraints** Lets you use existing geometry to constrain sub-object transformation. Choose the constraint type:

- **None:** No constraints. This is the default option.
- **Edge:** Constrains sub-object transformations to edge boundaries.
- **Face:** Constrains sub-object transformations to individual face surfaces.
- **Normal:** Constrains each sub-object’s transformations to its normal, or the average of its normals. In most cases, this causes sub-objects to move perpendicular to the surface.
NOTE This constraint works like the Push modifier on page 1640, including the fact that it operates on unmodified base normals. Edited normals are unsupported.

When set to Edge, moving a vertex will slide it along one of the existing edges, depending on the direction of the transformation. If set to Face, the vertex moves only on the polygon’s surface.

NOTE You can set constraints at the Object level, but their use pertains primarily to sub-object levels. The Constraints setting persists at all sub-object levels.

Use NURMS Panel

Modeling ribbon > Edit panel > Use NURMS

The Use NURMS panel opens when the Use NURMS on page 2080 button on the modeling ribbon > Edit panel is active, and provides access to all controls for how NURMS smoothes object surfaces.
Interface

**Iterations** Sets the number of iterations used to smooth the poly object. Each iteration generates all polygons using the vertices created from the previous iteration. Range=0 to 10.

When the Iterations check box in the Render group (see following) is off, this setting controls iterations both in the viewports and at render time. When the check box is on, this setting controls iterations only in the viewports.

**WARNING** Use caution when increasing the number of iterations. The number of vertices and polygons in an object (and thus the calculation time) can increase as much as four times for each iteration. Applying four iterations to even a moderately complex object can take a long time to calculate. To stop calculation and revert to the previous iteration setting, press Esc.

**Smoothness** Determines how sharp a corner must be before polygons are added to smooth it. A value of 0.0 prevents the creation of any polygons. A value of 1.0 adds polygons to all vertices even if they lie on a plane.

When the Smoothness check box in the Render group (see following) is off, this setting controls smoothness both in the viewports and at render time. When the check box is on, this setting controls smoothness only in the viewports.

**Show Cage** Toggles the display of a two-color wireframe that shows the editable poly object before modification or subdivision. The cage colors are shown as swatches to the right of the check box. The first color represents
unselected sub-objects, and the second color represents selected sub-objects. Change a color by clicking its swatch.

The cage displays the original structure of the edited object.

Typically this feature is used in conjunction with the NURMS Subdivision feature, or with the MeshSmooth modifier on page 1505, because it lets you easily toggle visibility of the unsmoothed base object while simultaneously viewing the smoothed result, but it works with any modifier. When used with a modifier, turn on Show End Result to make Show Cage available.

**TIP** Show Cage is particularly helpful when used with the Symmetry modifier on page 1803.

**Isoline Display** When on, 3ds Max displays only isolines: the object's original edges, before smoothing. The benefit of using this option is a less cluttered display. When off, 3ds Max displays all faces added by NURMS Subdivision; thus, higher Iterations settings (see Display group on page 2328) result in a greater number of lines. Default=on.
NOTE Applying a modifier to an Editable Poly object cancels the effect of the Isoline Display option; the wireframe display reverts to showing all polygons in the object. This is not, however, always the case with the MeshSmooth modifier. Most deformation and mapping modifiers maintain the isoline display, but others, such as the selection modifiers (except Volume Select) and the Turn To ... modifiers, cause the interior edges to be displayed.

[cage display] Shows the colors used for the cage display (see preceding). To change a color, click its swatch.

Update Updates the object in the viewport to match the current MeshSmooth settings. Works only when you choose When Rendering or Manually.

Update: Choose how the software is to update the mesh:
- **Always** Updates the object automatically whenever you change any MeshSmooth settings.
- **When Rendering** Updates the viewport display of the object only at render time.
- **Manually** Any settings you change don’t take effect until you click the Update button.

Smooth Result Applies the same smoothing group to all polygons.
Separate By

**Smoothing Groups** Prevents the creation of new polygons at edges between faces that don't share at least one smoothing group.

**Material IDs** Prevents the creation of new polygons for edges between faces that do not share Material IDs.

Render group

Applies a different number of smoothing iterations and/or a different Smoothness value to the object at render time.

**TIP** Use a low number of iterations and/or a lower Sharpness value for modeling, and higher values for rendering. This lets you work quickly with a low-resolution object in the viewports, while producing a smoother object for rendering.

**Iterations** Lets you choose a different number of smoothing iterations on page 2328 to be applied to the object at render time. Turn on Iterations, and then use the spinner to its right to set the number of iterations.

**Smoothness** Lets you choose a different Smoothness value on page 2329 to be applied to the object at render time. Turn on Smoothness, and then use the spinner to its right to set the smoothness value.

Geometry (All) Panel

Modeling ribbon > Graphite Modeling Tools/Freeform tab > Geometry (All) panel

**NOTE** The Geometry (All) panel is visible by default only on the Graphite Modeling Tools tab but can be made visible on the Freeform tab via the right-click menu.

The Geometry (All) panel provides a subset of modeling tools from the *Edit Geometry rollout* on page 1409 and adds *Cap Poly* on page 2095 for creating a polygon from a vertex or edge selection and the *Quadrify* on page 2097 tools for converting polygons to quadrilaterals.
Interface

Geometry (All) panel on minimized ribbon

Geometry (All) panel on maximized ribbon, with expansion

Graphite Modeling Tools Tab | 2089
Relax. Applies the Relax function to the current selection, using the Relax dialog settings (see following). Relax normalizes mesh spacing by moving each vertex toward the average location of its neighbors. It works the same way as the Relax modifier on page 1643.

At the object level, Relax applies to the entire object. At sub-object levels, Relax applies only to the current selection.

NOTE To open the Relax Settings dialog, use the drop-down or Shift+click the Relax button.

Relax Settings (on Relax drop-down) Opens the Relax dialog on page 2357, which lets you specify how the Relax function is applied.

Create. Lets you create new geometry. How this button behaves depends on which level is active:

- **Object, Polygon, and Element levels**. Lets you add polygons in the active viewport. After you turn on Create, click three or more times in succession anywhere, including on existing vertices, to define the shape of the new polygon. To finish, right-click.

  While creating a polygon at the Polygon or Element level, you can delete the most recently added vertex by pressing Backspace. You can do this repeatedly to remove added vertices in reverse order of placement.

  You can start creating polygons in any viewport, but all subsequent clicks must take place in the same viewport.

  **TIP** For best results, click vertices in counterclockwise (preferred) or clockwise order. If you use clockwise order, the new polygon will face away from you.
■ **Vertex level**  Lets you add vertices to a single selected poly object. After selecting the object and clicking Create, click anywhere in space to add free-floating (isolated) vertices to the object. The new vertices are placed on the active construction plane unless object snapping is on. For example, with face snapping on, you can create vertices on object faces.

■ **Edge and Border levels**  Lets you create an edge between a pair of non-adjacent vertices on the same polygon. Click Create, click a vertex, and then move the mouse. A rubber-band line extends from the vertex to the mouse cursor. Click a second, non-adjacent vertex on the same polygon to connect them with an edge. Repeat, or, to exit, right-click in the viewport or click Create again. Edges you create separate the polygons. For example, by creating an edge inside a quadrilateral polygon, you turn it into two triangles.

[Attach](#)  Lets you attach other objects in the scene to the selected poly object. After activating Attach, click an object to attach to the selected object. Attach remains active, so you can continue clicking objects to attach them. To exit, right-click in the active viewport or click the Attach button again.

You can attach any type of object, including splines, patch objects, and NURBS surfaces. Attaching a non-mesh object converts it to editable-poly format. When you attach an object, the materials of the two objects are combined in the following way:

■ If the object being attached does not have a material assigned, it inherits the material of the object it is being attached to.
Handle inherits material from the cup it is being attached to.

- Likewise, if the object you're attaching to doesn't have a material, it inherits the material of the object being attached.
- If both objects have materials, the resulting new material is a multi/sub-object material on page 6120 that includes the input materials. A dialog appears offering three methods of combining the objects' materials and material IDs. For more information, see Attach Options Dialog on page 2233.
  
  Attach remains active in all sub-object levels, but always applies to objects.

**NOTE** To attach objects from a list, use the drop-down or Shift+click the Attach button.

**Attach from List (on Attach drop-down)** Lets you attach other objects in the scene to the selected mesh. Click to open the Attach List dialog, which works like Select From Scene on page 206 to let you choose multiple objects to attach.
Collapse (Sub-object levels only) Collapses groups of contiguous selected sub-objects by welding their vertices to a vertex at the selection center.
Using collapse on a vertex selection

Using collapse on a polygon selection

Detach (Sub-object levels only) Detaches the selected sub-objects and the polygons attached to them as a separate object or element(s).

With an Editable Poly object, when you click Detach, the software prompts you for the options specified on the Detach dialog. With an Edit Poly object, Detach on the Modify panel automatically uses those settings. To change them, click Detach Settings (see following).

On the modeling ribbon, with an Edit Poly object, click Detach to open the Detach dialog, or Shift+click Detach to detach using the current settings.
Cap Poly: Creates a single polygon from a vertex or edge selection and selects the polygon. Available at all sub-object levels except Polygon and Element.

Select vertices or edges and then click Cap Poly.

**TIP** To cap an entire border, for best results use Cap Poly at the Border sub-object level.

Using Cap Poly with a vertex selection

Using Cap Poly with an edge selection
Using Cap Poly with a border selection

When capping an edge selection, the software uses the edge vertices to determine the feasibility of creating a polygon. When using Cap Poly at the Vertex or Edge level, the software requires a non-overlapping counter-clockwise sequence of selected sub-objects. Consider the example shown in the following illustration, in which the goal is to cap all border edges or vertices:
The software first determines the geometric center of the selected sub-objects (the small green disc), and then shoots out “rays” in counter-clockwise order from that location to find the locations of vertices from which to form a polygon. In this case, it finds vertex 6 before it finds vertex 7, but vertex 7 actually precedes vertex 6 when going around the border in counter-clockwise order. As a result, Cap Poly cannot form the polygon because the vertices it finds are in the wrong order.

In such cases, apply Cap Poly at the Border sub-object level.

**Quadrify** ... A set of tools for converting triangles to quadrilaterals. Click the visible tool to apply it, or choose another tool from the drop-down list.

- **Quadrify All**  Removes edges from the entire object to convert triangles to four-sided polygons.

- **Quadrify Selection**  Removes edges from the current sub-object selection to convert triangles to four-sided polygons.
- **Select Edges from All**  Selects edges that would be removed in a Quadrify All operation.
  To see the selection, go to the Edge sub-object level.

- **Select Edges from Selection**  Selects edges that would be removed in a Quadrify All operation.
  To see the selection, go to the Edge sub-object level.

**TIP**  For best results, the geometry to quadrify should be fairly uniform.

**TIP**  Another way to convert a mesh to quads is with the Quadify Mesh modifier on page 1641.

**Slice Plane (sub-object levels only)**  Creates a gizmo for a slice plane that you can position and rotate to specify where to slice. Also enables the Slice and Reset Plane buttons; click Slice to create new edges where the plane intersects the geometry.

If you use Slice Plane from the modeling ribbon, the Slice, Split, and Reset Plane controls are available on the Slice Mode contextual panel on page 2098.

If snapping is off, you see a preview of the slice as you transform the slice plane. To perform the slice, click the Slice button.

**NOTE**  At the Polygon or Element sub-object level, Slice Plane affects only selected polygons. To slice the entire object, use Slice Plane at any other sub-object level, or at the object level.

**Slice Mode Panel**

Any sub-object level > Modeling ribbon > Graphite Modeling Tools/Freeform tab > Geometry (All) panel > Click Slice Plane.

The Slice Mode contextual panel is available on the modeling ribbon when the Slice Plane on page 2098 tool is active. It provides tools for performing the slice and resetting the slice plane position, as well as an option for splitting the mesh while slicing.
Interface

**Slice** Performs the slice operation at the location of the slice plane. Available only when Slice Plane is on. This tool slices the poly just like the “Operate On: Polygons” mode of the Slice modifier on page 1727.

**Split** When on, the QuickSlice and Cut operations create double sets of vertices at the points where the edges are divided. This lets you easily delete the new polygons to create holes, or animate the new polygons as separate elements.

**Reset** Returns the Slice plane to its default position and orientation. Available only when Slice Plane is on.

**[Sub-object] Panel**

Modeling ribbon > Graphite Modeling Tools tab > Polygon Modeling panel > Any sub-object level > [Sub-object] panel
The Polygon Modeling panel is visible by default only on the Graphite Modeling Tools tab but can be made visible on the other tabs via the right-click menu. The [sub-object] panel is available only on the Graphite Modeling Tools tab.

When you access a sub-object level on the Polygon Modeling panel, a corresponding contextual panel with controls for editing at that level opens on the ribbon. The sub-object panels are:

**Vertices Panel**

Modeling ribbon > Graphite Modeling Tools tab > Polygon Modeling panel > Access the Vertex sub-object level > Vertices panel

Vertices are points in space: They define the structure of other sub-objects (edges and polygons) that make up the poly object. When you move or edit vertices, the connected geometry is affected as well. Vertices can also exist independently; such isolated vertices can be used to construct other geometry but are otherwise invisible when rendering.

At the editable poly Vertex sub-object level, you can select single and multiple vertices and move them using standard methods.
Interface

Extrude

Extrude lets you extrude vertices manually via direct manipulation in the viewport. Click this button, and then drag vertically on any vertex to extrude it.

Extruding a vertex moves it along a normal and creates new polygons that form the sides of the extrusion, connecting the vertex to the object. The extrusion has the same number of sides as the number of polygons that originally used the extruded vertex.

Following are important aspects of vertex extrusion:

- When over a selected vertex, the mouse cursor changes to an Extrude cursor.
- Drag vertically to specify the extent of the extrusion, and horizontally to set the size of the base.
- With multiple vertices selected, dragging on any one extrudes all selected vertices equally.
- You can drag other vertices in turn to extrude them while the Extrude button is active. Click Extrude again or right-click in the active viewport to end the operation.
NOTE To open the Extrude Vertices dialog, choose Extrude Settings from the drop-down or Shift+click the Extrude button.

Extrude Settings (on Extrude drop-down) Opens the Extrude Vertices dialog on page 2350, which lets you perform extrusion via interactive manipulation. If you click this button after performing a manual extrusion, the same extrusion is performed on the current selection as a preview and the dialog opens with Extrusion Height set to the amount of the last manual extrusion.

Chamfer Click this button and then drag vertices in the active object. To chamfer vertices numerically, click the Chamfer Settings button and use the Chamfer Amount value.

If you chamfer multiple selected vertices, all of them are chamfered identically. If you drag an unselected vertex, any selected vertices are first deselected. Each chamfered vertex is effectively replaced by a new face that connects new points on all edges leading to the original vertex. These new points are exactly
<chamfer amount> distance from the original vertex along each of these edges. New chamfer faces are created with the material ID of one of the neighboring faces (picked at random) and a smoothing group which is an intersection of all neighboring smoothing groups.

For example, if you chamfer one corner of a box, the single corner vertex is replaced by a triangular face whose vertices move along the three edges that led to the corner. Outside faces are rearranged and split to use these three new vertices, and a new triangle is created at the corner.

Alternatively, you can create open space around the chamfered vertices; for details, see Chamfer Vertices dialog on page 2344.
NOTE To open the Chamfer Vertices dialog, choose Chamfer Settings from the drop-down or Shift+click the Chamfer button.

**Chamfer Settings (on Chamfer drop-down)** Opens the Chamfer Vertices dialog on page 2344, which lets you chamfer vertices via interactive manipulation and toggle the Open option.

If you click this button after performing a manual chamfer, the same chamfer is performed on the current selection as a preview and the dialog opens with Chamfer Amount set to the amount of the last manual extrusion.

**Weld** Combines contiguous, selected vertices that fall within the tolerance specified in Weld dialog on page 2359. All edges become connected to the resulting single vertex.

**Using Weld at the Vertex level**

Vertices farther apart than the Threshold distance are not welded.

Weld is best suited to automatically simplifying geometry that has areas with a number of vertices that are very close together. Before using Weld, set the Weld Threshold via the Weld dialog on page 2359. To weld vertices that are relatively far apart, use Target Weld on page 1366 instead.

NOTE To open the Weld Vertices dialog, choose Weld Settings from the drop-down or Shift+click the Chamfer button.

**Weld Settings (on Weld drop-down)** Opens the Weld dialog on page 2359, which lets you specify the weld threshold.
**Remove** Deletes selected vertices and combines the polygons that use them. The keyboard shortcut is Backspace.

Removing one or more vertices deletes them and retriangulates the mesh to keep the surface intact. If you use Delete instead, the polygons depending on those vertices are deleted as well, creating a hole in the mesh.

**WARNING** Use of Remove can result in mesh shape changes and non-planar polygons.

**Break** Creates a new vertex for each polygon attached to selected vertices, allowing the polygon corners to be moved away from each other where they were once joined at each original vertex. If a vertex is isolated or used by only one polygon, it is unaffected.

**Target Weld** Allows you to select a vertex and weld it to a neighboring target vertex. Target Weld works only with pairs of contiguous vertices; that is, vertices connected by a single edge.
In Target Weld mode, the mouse cursor, when positioned over a vertex, changes to a + cursor. Click and then move the mouse; a dashed, rubber-band line connects the vertex to the mouse cursor. Position the cursor over another, neighboring vertex and when the + cursor appears again, click the mouse. The first vertex moves to the position of the second and the two are welded. Target Weld remains active until you click the button again or right-click in the viewport.

NOTE When the modeling ribbon is maximized or the Vertices panel floats, the following controls appear on the Vertices panel expansion.

**Weight** Sets the weight of selected vertices. Used by the NURMS subdivision option on page 2326 and by the MeshSmooth modifier on page 1505. Increasing a vertex weight tends to pull the smoothed result toward the vertex.

**Remove Isolated Verts** Deletes all vertices that don’t belong to any polygons.

**Remove Unused Map Verts** Certain modeling operations can leave unused (isolated) map vertices that show up in the Unwrap UVW editor on page 1856, but cannot be used for mapping. You can use this button to automatically delete these map vertices.

**Edges Panel**

Modeling ribbon > Graphite Modeling Tools tab > Polygon Modeling panel > Access the Edge sub-object level > Edges panel

NOTE The Polygon Modeling panel is visible by default only on the Graphite Modeling Tools tab but can be made visible on the other tabs via the right-click menu. The Edges panel is available only on the Graphite Modeling Tools tab.

An edge is a line connecting two vertices that forms the side of a polygon. An edge can’t be shared by more than two polygons. Also, the normals of the two polygons should be adjacent. If they aren’t, you wind up with two edges that share vertices.

At the editable poly Edge sub-object level, you can select single and multiple edges and transform them using standard methods.
**Interface**

Extrude Lets you extrude edges manually via direct manipulation in the viewport. Click this button, and then drag vertically on any edge to extrude it.

When extruding a vertex or edge interactively in the viewport, you set the extrusion height by moving the mouse vertically and the base width by moving the mouse horizontally.
Extruding an edge moves it along a normal and creates new polygons that form the sides of the extrusion, connecting the edge to the object. The extrusion has either three or four sides; three if the edge was on a border, or four if it was shared by two polygons. As you increase the length of the extrusion, the base increases in size, to the extent of the vertices adjacent to the extruded edge’s endpoints.

Following are important aspects of edge extrusion:

■ When over a selected edge, the mouse cursor changes to an Extrude cursor.

■ Drag vertically to specify the extent of the extrusion, and horizontally to set the size of the base.

■ With multiple edges selected, dragging on any one extrudes all selected edges equally.

■ You can drag other edges in turn to extrude them while the Extrude button is active. Click Extrude again or right-click in the active viewport to end the operation.

NOTE To open the Extrude Edges dialog, choose Extrude Settings from the drop-down or Shift+click the Extrude button.
Extrude Settings (on Extrude drop-down) Opens the Extrude Edges dialog on page 2350, which lets you perform extrusion via interactive manipulation. If you click this button after performing a manual extrusion, the same extrusion is performed on the current selection as a preview and the dialog opens with Extrusion Height set to the amount of the last manual extrusion.

Chamfer Click this button and then drag edges in the active object. To chamfer edges numerically, click the Chamfer Settings button and change the Chamfer Amount value.

If you chamfer multiple selected edges, all of them are chamfered identically. If you drag an unselected edge, any selected edges are first deselected.

An edge chamfer "chops off" the selected edges, creating a new polygon connecting new points on all visible edges leading to the original vertex. The new edges are exactly <chamfer amount> distance from the original edge along each of these edges. New chamfer faces are created with the material ID of one of the neighboring faces (picked at random) and a smoothing group which is an intersection of all neighboring smoothing groups.

For example, if you chamfer one edge of a box, each corner vertex is replaced by two vertices moving along the visible edges that lead to the corner. Outside faces are rearranged and split to use these new vertices, and a new polygon is created at the corner.

Using Chamfer at the Edge level

Alternatively, you can create open space around the chamfered edges; for details, see Chamfer Edges dialog on page 2344.
NOTE To open the Chamfer Edges dialog, choose Chamfer Settings from the drop-down or Shift+click the Chamfer button.

Chamfer Settings (on Chamfer drop-down) Opens the Chamfer Edges dialog on page 2344, which lets you chamfer edges via interactive manipulation and toggle the Open option.

If you click this button after performing a manual chamfer, the same chamfer is performed on the current selection as a preview and the dialog opens with Chamfer Amount set to the amount of the last manual chamfer.

Weld Combines selected edges that fall within the threshold specified in Weld dialog on page 2359.

You can weld only edges that have one polygon attached; that is, edges on a border. Also, you cannot perform a weld operation that would result in illegal geometry (e.g., an edge shared by more than two polygons). For example, you cannot weld opposite edges on the border of a box that has a side removed.

NOTE To open the Weld dialog, choose Weld Settings from the drop-down or Shift+click the Weld button.

Weld Settings (on Weld drop-down) Opens the Weld dialog on page 2359, which lets you specify the weld threshold.

Bridge Connects border edges on an object with a polygon “bridge.” Bridge connects only border edges; that is, edges that have a polygon on only one side. This tool is particularly useful when creating edge loops or profiles.

There are two ways to use Bridge in Direct Manipulation mode (that is, without opening the Bridge Edges settings dialog):

- Select two or more border edges on the object, and then click Bridge. This immediately creates the bridge between the pair of selected borders using the current Bridge settings, and then deactivates the Bridge button.

- If no qualifying selection exists (that is, two or more selected border edges), clicking Bridge activates the button and places you in Bridge mode. First click a border edge and then move the mouse; a rubber-band line connects the mouse cursor to the clicked edge. Click a second edge on a different border to bridge the two. This creates the bridge immediately using the current Bridge settings; the Bridge button remains active for connecting
more edges. To exit Bridge mode, right-click the active viewport or click the Bridge button.

The new polygons that result from a Bridge operation are automatically selected; you can see this by accessing the Polygon sub-object level.

Using Bridge at the Edge level

**NOTE** Bridge always creates a straight-line connection between edges. To make the bridge connection follow a contour, apply modeling tools as appropriate after creating the bridge. For example, bridge two edges, and then use **Bend** on page 1165.

**NOTE** To open the Bridge Edges dialog, choose Bridge Settings from the drop-down or Shift+click the Bridge button.

**Bridge Settings (on Bridge drop-down)** Opens the Bridge Edges dialog on page 2341, which lets you add polygons between pairs of edges via interactive manipulation.

**Remove** Deletes selected edges and combines the polygons that use them.
Removing one edge is like making it invisible. The mesh is affected only when all or all but one of the edges depending on one vertex are removed. At that point, the vertex itself is deleted and the surface is retriangulated.

To delete the associated vertices when you remove edges, press and hold Ctrl while executing a Remove operation, either by mouse or with the Backspace key. This option, called Clean Remove, ensures that the remaining polygons are planar.

Left: The original edge selection  
Center: Standard Remove operation leaves extra vertices.  
Right: Clean Remove with Ctrl+Remove deletes the extra vertices.

Edges with the same polygon on both sides usually can’t be removed.
WARNING Use of Remove can result in mesh shape changes and non-planar polygons.

**Split** Divides the mesh along the selected edges. This does nothing when applied to a single edge in the middle of a mesh. The vertices at the end of affected edges must be separable in order for this option to work. For example, it would work on a single edge that intersects an existing border, since the border vertex can be split in two. Additionally, two adjacent edges could be split in the middle of a grid or sphere, since the shared vertex can be split.

**Target Weld** Allows you to select an edge and weld it to a target edge. When positioned over an edge, the cursor changes to a + cursor. Click and move the mouse and a dashed line appears from the vertex with an arrow cursor at the other end of the line. Position the cursor over another edge and when the + cursor appears again, click the mouse. The first edge is moved to the position of the second, and the two are welded. You can weld only edges that have one polygon attached; that is, edges on a border. Also, you cannot perform a weld operation that would result in illegal geometry (e.g., an edge shared by more than two polygons). For example, you cannot weld opposite edges on the border of a box that has a side removed.

**Spin** Spins the selected edge or edges in the polygon, changing the direction. Select one or more edges and then apply Spin to change how the edges subdivide the mesh. Normally the edge spins clockwise, but if you hold Shift, the edges spin counterclockwise.

**Insert Vertices** Inserts vertices in selected edges. Select edges, set the number of vertices to insert in each, and click Insert Vertices. The inserted vertices are spaced evenly along each selected edge. Also, the Vertex sub-object level is activated and the new vertices are selected.
NOTE When the modeling ribbon is maximized or the Edges panel floats, the following controls appear on the Edges panel expansion.

Create Shape From Selection After selecting one or more edges, click this button to create a spline shape from the selected edges. A Create Shape dialog appears, letting you name the shape and set it to Smooth or Linear. The new shape's pivot is placed at the center of the poly object.
An edge selection (top); a smooth shape (center); a linear shape (bottom)

**Weight** Sets the weight of selected edges. Used by the NURMS subdivision option on page 2326 and by the MeshSmooth modifier on page 1505. Increasing an edge weight tends to push the smoothed result away.

**Crease** Specifies how much creasing is performed on the selected edge or edges. Used by the NURMS subdivision option on page 2326 and by the MeshSmooth modifier on page 1505. At low settings, the edge is relatively smooth. At higher settings, the crease becomes increasingly visible. At 1.0, the highest setting, the edge becomes a hard crease.

**Border Edges Panel**

Modeling ribbon > Graphite Modeling Tools tab > Polygon Modeling panel > Access the Border sub-object level > Border Edges panel

**NOTE** The Polygon Modeling panel is visible by default only on the Graphite Modeling Tools tab but can be made visible on the other tabs via the right-click menu. The Border Edges panel is available only on the Graphite Modeling Tools tab.

A border is a linear section of a mesh that can generally be described as the edge of a hole. This is usually a sequence of edges with polygons on only one
side. For example, a box primitive on page 389 doesn’t have a border, but the teapot on page 416 object has several: on the lid, on the body, on the spout, and two on the handle. If you create a cylinder and then delete an end polygon, the adjacent row of edges forms a border.

At the editable poly Border sub-object level, you can select single and multiple borders and transform them using standard methods.

**Interface**

Extrude Lets you extrude a border manually via direct manipulation in the viewport. Click this button, and then drag vertically on any border to extrude it.

Extruding a border moves it along a normal and creates new polygons that form the sides of the extrusion, connecting the border to the object. The extrusion can form a varying number of additional sides, depending on the geometry near the border. As you increase the length of the extrusion, the base increases in size, to the extent of the vertices adjacent to the extruded border’s endpoints.

Following are important aspects of border extrusion:

■ When the mouse cursor is over a selected border, it changes to an Extrude cursor.
■ To specify the extent of the extrusion, drag vertically, and to set the size of the base, drag horizontally.

■ With multiple borders selected, dragging on any one extrudes all selected borders equally.

■ While the Extrude button is active, you can extrude other borders in turn by dragging them. Click Extrude again or right-click in the active viewport to end the operation.

**NOTE** To open the Extrude Edges dialog, choose Extrude Settings from the drop-down or Shift+click the Extrude button.

**Extrude Settings (on Extrude drop-down)** Opens the Extrude Edges dialog on page 2350, which lets you perform extrusion via interactive manipulation. If you click this button after performing a manual extrusion, the same extrusion is performed on the current selection as a preview and the dialog opens with Extrusion Height set to the amount of the last manual extrusion.

**Bridge** Connects pairs of borders on an object with polygon “bridges.” There are two ways to use Bridge in Direct Manipulation mode (that is, without opening the Bridge Settings dialog):

■ Select an even number of borders on the object, and then click Bridge. This immediately creates the bridge between each pair of selected borders using the current Bridge settings, and then deactivates the Bridge button.

■ If no qualifying selection exists (that is, two or more selected borders), clicking Bridge activates the button and places you in Bridge mode. First click a border edge and then move the mouse; a rubber-band line connects the mouse cursor to the clicked edge. Click a second edge on a different border to bridge the two. This creates the bridge immediately using the current Bridge settings; the Bridge button remains active for connecting more pairs of borders. To exit Bridge mode, right-click the active viewport or click the Bridge button.

The new polygons that result from a Bridge operation are automatically selected; you can see this by accessing the Polygon sub-object level.
Using Bridge at the Border level.

**NOTE** Bridge always creates a straight-line connection between border pairs. To make the bridge connection follow a contour, apply modeling tools as appropriate after creating the bridge. For example, bridge two borders, and then use **Bend** on page 1165.

**NOTE** To open the Bridge Borders dialog, choose Bridge Settings from the drop-down or Shift+click the Bridge button.

**Bridge Settings (on Bridge drop-down)** Opens the Bridge dialog on page 2339, which lets you connect pairs of borders via interactive manipulation.

**Chamfer** Click this button and then drag a border in the active object. The border need not be selected first.

If you chamfer multiple selected borders, all of them are chamfered identically. If you drag an unselected border, any selected borders are first deselected. A border chamfer essentially “frames” the border edges, creating a new set of edges paralleling the border edges, plus new diagonal edges at any corners. These new edges are exactly `<chamfer amount>` distance from the original edges. New chamfer faces are created with the material ID of one of the neighboring faces (picked at random) and a smoothing group which is an intersection of all neighboring smoothing groups. Alternatively, you can create open space around the chamfered borders, essentially cutting away at the open edges; for details, see **Chamfer Edges dialog** on page 2344.
NOTE To open the Chamfer Edges dialog, choose Chamfer Settings from the drop-down or Shift+click the Chamfer button.

**Chamfer Settings (on Chamfer drop-down)** Opens the Chamfer Edges dialog on page 2344, which lets you chamfer borders via interactive manipulation and toggle the Open option.

If you click this button after performing a manual chamfer, the same chamfer is performed on the current selection as a preview and the dialog opens with Chamfer Amount set to the amount of the last manual chamfer.

![Connect](image)

**Connect** Creates new edges between pairs of selected border edges. The edges are connected from their midpoints.

You can connect only edges on the same polygon.

Connect will not let the new edges cross. Thus, for example, if you select all four edges of a four-sided polygon and then click Connect, only neighboring edges are connected, resulting in a diamond pattern.

NOTE To open the Connect Edges dialog, choose Connect Settings from the drop-down or Shift+click the Connect button.

**Connect Settings (on Connect drop-down)** Lets you preview the Connect and specify the number of edge segments created by the operation. To increase the mesh resolution around the new edge, increase the Connect Edge Segments setting.

NOTE When the modeling ribbon is maximized or the Border Edges panel floats, the following controls appear on the Border Edges panel expansion.

![Create Shape From Selection](image)

**Create Shape From Selection** After selecting one or more borders, click this button to create a spline shape from the selected edges. A Create Shape dialog appears, letting you name the shape and set it to Smooth or Linear. The new shape's pivot is placed at the center of the poly object.

**Weight** Sets the weight of selected borders. Used by the NURMS subdivision option on page 2326.

Increasing an edge weight tends to push the smoothed result away.

**Crease** Specifies how much creasing is performed on the selected border or borders. Used by the NURMS subdivision option on page 2326.
At low settings, the border is relatively smooth. At higher settings, the crease becomes increasingly visible. At 1.0, the highest setting, the border is not smoothed at all.

Polygons/Elements Panel

Modeling ribbon > Graphite Modeling Tools tab > Polygon Modeling panel > Access the Polygon or Element sub-object level > Polygons/Elements panel

NOTE The Polygon Modeling panel is visible by default only on the Graphite Modeling Tools tab but can be made visible on the other tabs via the right-click menu. The Polygons or Elements panel is available only on the Graphite Modeling Tools tab.

A polygon is a closed sequence of three or more edges connected by a surface. Polygons provide the renderable surface of editable poly objects.

At the editable poly Polygon sub-object level you can select single and multiple polygons and transform them using standard methods. At the Element sub-object level you can select and edit groups of contiguous polygons. For further distinctions between polygon and element, see Editable Poly > Selection rollout on page 2248.

Interface

The Polygons panel includes all of the following controls, while the Elements panel includes only the Flip on page 2124 and Insert Vertex on page 2130 functions.
Extrude

Extrude lets you perform manual extrusion via direct manipulation in the viewport. Click this button, and then drag vertically on any polygon to extrude it.

Extruding polygons moves them along a normal and creates new polygons that form the sides of the extrusion, connecting the selection to the object. Following are important aspects of polygon extrusion:

■ When over a selected polygon, the mouse cursor changes to an Extrude cursor.

■ Drag vertically to specify the extent of the extrusion, and horizontally to set the size of the base.

■ With multiple polygons selected, dragging on any one extrudes all selected polygons equally.

■ You can drag other polygons in turn to extrude them while the Extrude button is active. Click Extrude again or right-click in the active viewport to end the operation.
Chamfer box showing extruded polygon

**NOTE** To open the Extrude Polygons dialog, choose Extrude Settings from the drop-down or Shift+click the Extrude button.

**Extrude Settings (on Extrude drop-down)** Opens the Extrude Polygons dialog on page 2349, which lets you perform extrusion via interactive manipulation. If you click this button after performing an extrusion, the same extrusion is performed on the current selection as a preview and the dialog opens with Extrusion Height set to the amount of the last manual extrusion.

**Bevel** Lets you perform manual beveling via direct manipulation in the viewport. Click this button, and then drag vertically on any polygon to extrude it. Release the mouse button and then move the mouse vertically to outline the extrusion. Click to finish.

- When over a selected polygon, the mouse cursor changes to a Bevel cursor.
- With multiple polygons selected, dragging on any one bevels all selected polygons equally.
- You can drag other polygons in turn to bevel them while the Bevel button is active. Click Bevel again or right-click to end the operation.
**Polygon beveled outward (left) and inward (right)**

**NOTE** To open the Bevel Polygons dialog, choose Bevel Settings from the drop-down or Shift+click the Bevel button.

**Bevel Settings (on Bevel drop-down)** Opens the Bevel Polygons dialog on page 2337, which lets you perform beveling via interactive manipulation. If you click this button after performing a bevel, the same bevel is performed on the current selection as a preview and the dialog opens with the same settings used for the previous bevel.

**Bridge** Connects two polygons or polygon selections on an object with a polygon “bridge.” There are two ways to use Bridge in Direct Manipulation mode (that is, without opening the Bridge Settings dialog):

- Make two separate polygon selections on the object, and then click Bridge. This creates the bridge immediately using the current Bridge settings, and then deactivates the Bridge button.

- If no qualifying selection exists (that is, two or more discrete polygon selections), clicking Bridge activates the button and places you in Bridge mode. First click a polygon and move the mouse; a rubber-band line connects the mouse cursor to the clicked polygon. Click a second polygon to bridge the two. This creates the bridge immediately using the current Bridge settings; the Bridge button remains active for connecting more pairs.
of polygons. To exit Bridge mode, right-click the active viewport or click the Bridge button.

Using Bridge at the Polygon level

**NOTE** Bridge always creates a straight-line connection between polygon pairs. To make the bridge connection follow a contour, apply modeling tools as appropriate after creating the bridge. For example, bridge two polygons, and then use **Bend** on page 1165.

**NOTE** To open the Bridge Polygons dialog, choose Bridge Settings from the drop-down or Shift+click the Bridge button.

**Bridge Settings (on Bridge drop-down)** Opens the Bridge dialog on page 2339, which lets you connect pairs of polygon selections via interactive manipulation.

**GeoPoly** Untangles a polygon and organizes the vertices to form a perfect geometric shape. Select polygons and apply to make a geometric shape. If several adjacent polygons are selected the result is averaged among the polygons.

**Flip** Reverses the directions of the normals of selected polygons, hence their facing.

2124 | Chapter 10  Surface Modeling
**Hinge** Lets you perform a manual hinge operation via direct manipulation in the viewport. Make a polygon selection, click this button, and then drag vertically on any edge to hinge the selection. The mouse cursor changes to a cross when over an edge.

The hinge edge needn't be part of the selection. It can be any edge of the mesh. Also, the selection needn't be contiguous.

Hinging polygons rotates them about an edge and creates new polygons that form the sides of the hinge, connecting the selection to the object. It's essentially an extrusion with rotation, with the exception that, if the hinge edge belongs to a selected polygon, that side is not extruded. The manual version of Hinge From Edge works only with an existing polygon selection.

**TIP** To avoid inadvertently hinging about a backfacing edge, turn on Ignore Backfacing.

**NOTE** To open the Hinge Polygons From Edge dialog, choose Hinge Settings from the drop-down or Shift+click the Hinge button.

**Hinge Settings (on Hinge drop-down)** Opens the Hinge From Edge dialog on page 2352, which lets you hinge polygons via interactive manipulation. If you click this button after performing a manual hinge, the dialog opens with Angle set to the extent of the last manual hinge.
Inset Performs a bevel with no height; that is, within the plane of the polygon selection. Click this button, and then drag vertically on any polygon to inset it.

- When over a selected polygon, the mouse cursor changes to an Inset cursor.
- With multiple polygons selected, dragging on any one insets all selected polygons equally.
- While the Inset button is active, you can drag other polygons in turn to inset them. To end the operation, click Inset again or right-click.

Inset works on a selection of one or more polygons. As with Outline, only the outer edges are affected.

NOTE To open the Inset Polygons dialog, choose Inset Settings from the drop-down or Shift+click the Inset button.

Inset Settings (on Inset drop-down) Opens the Inset Polygons dialog on page 2353, which lets you inset polygons via interactive manipulation.

If you click this button after performing a manual inset, the same inset is performed on the current selection as a preview and the dialog opens with Inset Amount set to the amount of the last manual inset.

NOTE When the modeling ribbon is maximized or the Polygons panel floats, the following controls appear on the Polygons panel expansion.
Outline lets you increase or decrease the outside edge of each contiguous group of selected polygons.

Outline is often used after an extrusion or bevel to adjust the size of the extruded faces. It doesn’t scale the polygons; only changes the size of the outer edge. For example, in the following illustration, note that the sizes of the inner polygons remain constant.
Extruded polygons (top), outline expanded (middle), outline reduced (bottom)

Note that inner polygons do not change size.
NOTE To open the Outline Polygons dialog, choose Outline Settings from the drop-down or Shift+click the Outline button.

Outline Settings (on Outline drop-down) Opens the Outline Polygons dialog, which lets you perform outlining by a numeric setting.

![Extrude on Spline](image)

Extrude on Spline Extrudes the current selection along a spline.

You can extrude a single polygon (1) or a selection of contiguous (2) or non-contiguous polygons (3). Extrusion 2 uses Taper Curve and Twist (available via Settings). Extrusion 3 uses Taper Amount; each extrusion has a different curve rotation.

Make a selection, click Extrude Along/On Spline, and then select a spline in the scene. The selection is extruded along the spline, using the spline's current orientation, but as though the spline's start point were moved to the center of each polygon or group.

NOTE To open the Extrude Polygons Along Spline dialog, choose Extrude On Spline Settings from the drop-down or Shift+click the Extrude On Spline button.

Extrude On Spline Settings (on Extrude On Spline drop-down) Opens the Extrude Polygons Along Spline dialog on page 2347, which lets you extrude along splines via interactive manipulation.
**Insert Vertex** Lets you subdivide polygons manually. Applies to polygons, even if at the element sub-object level. After turning on Insert Vertex, click a polygon to add a vertex at that location. You can continue subdividing polygons as long as the command is active. To stop inserting vertices, right-click in the viewport, or click Insert Vertex again to turn it off.

**Loops Panel**

Modeling ribbon > Graphite Modeling Tools tab > Polygon Modeling panel > Vertex, Edge, or Polygon sub-object level > Loops panel

**NOTE** The Polygon Modeling panel is visible by default only on the Graphite Modeling Tools tab but can be made visible on the other tabs via the right-click menu. The [sub-object] panel is available only on the Graphite Modeling Tools tab.

The Loops panel features are for working with edge loops, and include tools for creating loops within polygons and at a distance, automatically adjusting a new loop to an object’s shape, random paths, and more.

All of the Loops panel tools are available at the Edge level; other sub-object levels provide a subset or none. At the Polygon level, only Insert Loop and Remove Loop are available. The Vertex level provides Connect, Distance connect, Insert/Remove Loop, and Build End/Corners.
Interface

Loops panel at the Edge level on minimized ribbon

Loops panel on maximized ribbon, with expansion
Loops panel floating, with expansion

**Connect (Vertex level)** Creates new edges between pairs of selected vertices.

Connect does not let the new edges cross. Thus, for example, if you select all four vertices of a four-sided polygon and then click Connect, only two of the vertices will be connected. In this case, to connect all four vertices with new edges, use **Cut** on page 1417.

**Connect (Edge level)** Creates new edges between pairs of selected edges using the current Connect Edges dialog settings. Connect is particularly useful for creating or refining edge loops.

**NOTE** You can connect only edges on the same polygon. Also, Connect will not let the new edges cross. For example, if you select all four edges of a four-sided polygon and then click Connect, only neighboring edges are connected, resulting in a diamond pattern.
Connecting two or more edges using the Settings dialog creates equally spaced edges. The number of edges is set in the dialog. When you click the Connect button, the current dialog settings are applied to the selection.

**Connect Settings (on Connect drop-down)** Opens the Connect Edges dialog on page 2345, which lets you preview the Connect results, specify the number of edge segments created by the operation, and set spacing and placement for the new edges.

**TIP** You can open the Connect Edges dialog quickly by Shift+clicking the Connect button.

**Distance Connect** Creates edge loops between vertices and edges across distance and other topology.
Usage depends on the sub-object level:
- **Vertex** Select two end vertices and apply to connect them across the intervening mesh.
Edge  Select two parallel edges and apply to connect them across the intervening mesh.

NOTE  At the Edge level, if a complete (closed) loop is possible (for instance, around a sphere), Distance Connect automatically creates one.
**Flow Connect** Connects selected edges across one or more edge rings and adjusts the new loop position to fit the shape of the surrounding mesh.

Select an edge ring and apply Flow Connect. For each selected edge, Flow Connect creates a loop through the ring and adjusts the new edges to follow the physical outline of the mesh.

**Left top:** Selected edge ring; **Left bottom:** Selected edge with Auto Ring on

**Right:** After applying Flow Connect, showing the corrected shape after creating the loop

**TIP** To automatically select the ring before connecting, based on the edge selection, turn on Auto Ring first (see following).

**Auto Ring (on Flow Connect drop-down)** When on and you use Flow Connect, creates a full edge loop automatically.

Usage: Turn on Auto Loop, select one or more edges, and apply Flow Connect. For each selected edge, Flow Connect creates a loop through its entire ring and adjusts the new edges to follow the physical outline of the mesh.

**Insert Loop** Creates one or more edge loops based on the current sub-object selection and selects the results.
Usage depends on the sub-object level:

- **Vertex** Select one or more pairs of adjacent vertices and apply to insert edge loops between each pair of adjacent vertices.

- **Edge** Two options are available:
  - **Normal** Select one or more edges and apply to insert edge loops going through the edge ring that each selected edge is on.

---

Using Insert Loop at the Vertex level

Using Insert Loop at the Edge level
- **Shift** Opens the Connect Edges dialog on page 2345 so you can set the number of inserted edges and control Pinch and Slide settings interactively.

- **Polygon** Select one or more pairs of adjacent polygons and apply to insert edge loops going through the centers of each pair (parallel to the selection).

![Using Insert Loop at the Polygon level](image)

**Remove Loop** Removes loops at the current subobject level, and automatically deletes all leftover vertices.

Usage depends on the sub-object level:

- **Vertex** Select one or more pairs of adjacent vertices (to indicate the loop direction) and then click Remove Loop.
Using Remove Loop at the Vertex level

- **Edge** Select one or more edges, and then click Remove Loop. This removes all loops on which the edges reside.

Using Remove Loop at the Edge level

- **Polygon** Select one or more pairs of adjacent polygons (to indicate the loop direction) and then click Remove Loop. Alternatively, removing a single polygon removes all edge loops on which the polygon resides.
NOTE Removing a polygon loop is equivalent to removing the boundary edge loops.

Set Flow Adjusts selected edges to fit the shape of the surrounding mesh.
Usage: Select one or more edges and apply. To automatically adjust each edge's entire loop, first turn on Auto Loop.
Use the spinner to set the flow interactively.

Auto Loop (on Set Flow drop-down) When on, using Set Flow automatically selects loops for the selected edge(s).
Usage: Select one or more edges, turn on Auto Loop, and then apply Set Flow. Each selected edge's loop is automatically selected, and then Set Flow is applied to each loop.

NOTE When the modeling ribbon is maximized or the Loops panel floats, the following controls appear on the Loops panel expansion.

Build End Builds a quad ending to two parallel loops based on the vertex or edge selection.
Select two vertices at the ends of parallel loops ending at the same polygon or the edge connecting them and apply to build a quad ending to two parallel loops.

Using Build End at the Vertex level

Using Build End at the Edge level

**NOTE** Build End works only when exactly two parallel loops end at the same side of the same internal edge.

**Build Corner** Builds a quad corner based on the vertex or edge selection to make an edge-loop turn.
Usage depends on the sub-object level:

- **Vertex** Select vertices that terminate two loops that travel at right angles and end at adjacent sides of the same quad polygon and apply.

- **Edge** Select edges that connect two adjacent sides of a quad polygon and apply. Typically, these are edges where edge loops turn 90-degree corners.
Loop Tools Opens the Loop Tools dialog on page 2143, with features for adjusting loops.

Random Connect Connects selected edges, randomizing the positions of the created edges.
Select two or more contiguous edges to connect and then click Random Connect. This connects the edges, randomizing the positions of the created edges. The Jitter setting determines the extent of the randomization.

Using Random Connect at the Edge level

To make a full loop, first turn on Auto Loop (see following) or hold Shift as you click Random Connect. For this, only one selected edge is required.

Auto Loop (on Random Connect drop-down) When on, applying Random Connect makes as full a loop as possible.
Turn on Auto Loop and then apply Random Connect to one or more selected edges. The random-connection function is applied to all edges on the selected edges’ rings.

Set Flow Speed The speed by which adjusting the Set Flow on page 2139 spinner changes the flow of the selected edges.
Loop Tools dialog

Modeling ribbon > Graphite Modeling Tools tab > Polygon Modeling panel > Edge sub-object level > Loops panel [expansion] Loop Tools

**NOTE** The Polygon Modeling panel is visible by default only on the Graphite Modeling Tools tab but can be made visible on the other tabs via the right-click menu. The [sub-object] panel is available only on the Graphite Modeling Tools tab.

The Loop Tools dialog contains tools for adjusting inter-loop distance, curving loops, and more.

**Interface**

![Loop Tools dialog]

**AutoLoop** Automatically loops selected edges before applying a tool.

**[2Loops]** Select two or more parallel edges and adjust the spinner to change the distance between them. To change the rate at which the spinner works, use the Percent setting.
When AutoLoop is on, automatically selects the loops on which selected edges reside before adjusting the spacing.

[3Loops] Select one or more edges and adjust the spinner to change the positions of the edges on either side of the selected loop. To change the rate at which the spinner works, use the Percent setting.

Center Centers edges or edge loops on their edge rings and places the vertices in the middle of the edges. Select one or more edges and apply.

Space Spaces vertices evenly along the selected edges.

To space loops at the ends of cylinders, hold Shift and then click Space.
**Curve** Adjusts each set of selected edges or open edge loops into smooth curves. The curvature of each loop is determined by the positions of selected vertices along the loop. This is analogous to how splines work in that the resulting curve is smoothly interpolated among the selected vertices.

**NOTE** Curve supports open edge loops only; it does not work on closed (circular) edge loops.

To use, select vertices whose positions on the edge loops will determine the extents of the resulting curves, then select edges or edge loops to be adjusted, and then apply Curve.

If AutoLoop is on, loops on which selected edges reside are automatically selected before adjusting. And if Space Loops is on, all vertices are adjusted to be evenly spaced along their loops.

![Image](184x385 to 495x497)

Left: Initial selection of vertices  
Center: Initial selection of edges  
Right: After applying Curve with both AutoLoop and Space Loop on

**Straight** Straightens each set of selected edges or edge loops. Select edges or edge loops and apply.
To straighten loops at the ends of cylinders, hold Shift and then click Straight.

**Space loop**  Spaces all vertices evenly along the loop when using Curve and Straight.

**Circle** Adjusts each set of selected edges and edge loops into the form of a circle. To apply to loops at the top and bottom edges of a cylinder, hold Shift while clicking Circle.

For each loop or set of edges to apply Circle to, at the Vertex level, select a vertex on a closed loop whose position represents the radius of the desired circle, or on an open loop to designate the start of the circle. Then, at the Edge level, select a loop or an edge on the loop. If the latter, turn on AutoLoop on the Loop Tools dialog, and then click Circle.

**NOTE** After making the necessary vertex and edge selections, you can apply Circle at the object level or any sub-object level.

The following illustration shows using Circle with closed loops on a cylindrical object.
Center: The initial vertex selection, indicating the desired radii of the circles

Right: After clicking Circle while holding Shift, so the cylinder end loops are included.

The Space Loop check box has no influence on this tool.

Relax Smoothes the curvature of each set of selected edges or edge loops. To apply to loops at the top and bottom edges of a cylinder, hold Shift while clicking Relax. To increase the relax effect, apply several times.

The Space Loop check box has no influence on this tool. If AutoLoop is on, the software automatically loops the initial selection before applying the tool.

Additional Panels

Modeling ribbon > Graphite Modeling Tools tab

The panels described in this topic provide tools for subdividing meshes, changing triangulation, aligning objects and sub-objects, hiding and unhiding sub-objects, and setting properties such as smoothing. These panels are available only on the Graphite Modeling Tools tab of the modeling ribbon.

Subdivision Panel

The Subdivision panel provides tools for increasing mesh resolution parametrically for smoothing, displacement, and tessellation. It is available at the object level and at all sub-object levels.

MeshSmooth Smoothes the object using the current settings. This command uses subdivision functionality similar to that of the MeshSmooth modifier on page 1505 with NURMS Subdivision, but unlike NURMS subdivision, it applies the smoothing instantly to the selected area of the control mesh.
Smoothing a low-poly object with NURMS subdivision

MeshSmooth Settings (on MeshSmooth drop-down) Opens the MeshSmooth Selection dialog on page 2354, which lets you specify how smoothing is applied.

TIP You can open the MeshSmooth Selection dialog quickly by Shift+clicking the MeshSmooth button.

Tessellate Subdivides all polygons in the object based on the Tessellation settings on page 2358.

Tessellation is useful for increasing local mesh density while modeling. You can subdivide any selection of polygons. Two tessellation methods are available: Edge and Face.

Tessellate Settings (on Tessellate drop-down) Opens the Tessellate Selection dialog on page 2358, which lets you specify how smoothing is applied.

TIP You can open the Tessellate Selection dialog quickly by Shift+clicking the Tessellate button.

Use Displacement Opens the Displacement panel, with parameters for setting how to subdivide the mesh for displacement. For details, see Subdivision Displacement Rollout (Polymesh)subdivision displacement rollouteditable polyeditable polysubdivision displacement rollout on page 2330.
Triangulation (Tris) Panel

The Triangulation panel, also labeled “Tris” in some configurations, appears at all sub-object levels except Vertex, and provides tools for changing how polygons are subdivided into triangles for rendering purposes. The Retriangulate tool is available only at the Polygon and Element levels.

![Triangulation panel]

**Edit** lets you modify how polygons are subdivided into triangles by drawing internal edges, or **diagonals** on page 8551.

In **Edit Triangulation** mode, you can see the current triangulation in the viewport, and change it by clicking two vertices on the same polygon.

To edit triangulation manually, turn on this button. The hidden edges appear. Click a polygon vertex. A rubber-band line appears, attached to the cursor. Click a non-adjacent vertex to create a new triangulation for the polygon.
**TIP** For easier editing of triangulation, use the Turn command instead (see following).

**Turn** Lets you modify how polygons are subdivided into triangles by clicking diagonals. When you activate Turn, the diagonals on page 8551 become visible as dashed lines in wireframe and edged-faces views. In Turn mode, click a diagonal to change its position. To exit Turn mode, right-click in the viewport or click the Turn button again.

Each diagonal has only two available positions at any given time, so clicking a diagonal twice in succession simply returns it to its original position. But changing the position of a nearby diagonal can make a different alternate position available to a diagonal.

For more information on how to use Turn with the enhanced Cut tool, see this procedure on page 1368.

**Retriangulate** Lets 3ds Max automatically do its best triangulation on the polygon or polygons currently selected.

Retriangulate attempts to optimize how selected polygons are subdivided into triangles.
**Align Panel**

The Align panel provides tools for aligning objects and sub-object selections with the view or grid, or simply flattening a mesh. It is available at the object level and at all sub-object levels.

**Make Planar** Forces all selected sub-objects to be coplanar. The plane's normal is the average surface normal of the selection. At the Object level, forces all vertices in the object to become coplanar.

**TIP** One application for Make Planar is making a flat side on an object. Normally, you would use a contiguous selection set. If the selection includes vertices on various parts of the object, the vertices are still made planar, but with distorting effects on the rest of the geometry.

**To View** Aligns all vertices in the object to the plane of the active viewport. At sub-object levels, this function affects only selected vertices or those belonging to selected sub-objects.

In orthographic viewports, aligning to the view has the same effect as aligning to the construction grid when the home grid is active. Aligning to a perspective viewport (including camera and light views), reorients the vertices to a plane that is parallel to the camera's viewing plane. This plane is perpendicular to the view direction that is closest to the vertices' average position.
Above: Selected polygons in Perspective view

Below: Same polygons aligned to Front view

To Grid. Aligns all vertices in the selected object to the plane of the current view. At sub-object levels, aligns only selected sub-objects.

This command aligns the selected vertices to the current construction plane. The current plane is specified by the active viewport in the case of the home grid. When using a grid object, the current plane is the active grid object.

X/Y/Z Makes all selected sub-objects planar and aligns the plane with the corresponding plane in the object's local coordinate system. The plane used is the one to which the button axis is perpendicular; so, for example, clicking the X button aligns the object with the local YZ axis.

At the Object level, makes all vertices in the object planar.
Visibility Panel

Use the Visibility panel for hiding and unhiding sub-object selections. When working with complex geometry, hiding the parts you’re not modeling directly can help speed your work. It is available at all sub-object levels except Edge and Border.

- **Hide Selected** hides selected sub-objects.
- **Hide Unselected** hides unselected sub-objects.
- **Unhide All** restores hidden sub-objects to visibility.

Properties Panel

Use the Properties panel to adjust mesh smoothing, vertex colors, and material IDs. It is available at the object level and at all sub-object levels; the availability of commands depends on the level.
Hard

Turns off smoothing for the entire model. Removes all polygons in the model from any smoothing groups, resulting in a uniform faceted appearance.

Hard Selected

Turns off smoothing for selected polygons. Removes selected polygons in the model from any smoothing groups, resulting in a uniform faceted appearance for those polygons.

Smooth

Enables smoothing for the entire object. Sets Auto Smooth to 180.0 and applies it to all polygons in the model.

Smooth Selected

Enables smoothing for selected polygons. Sets Auto Smooth to 180.0 and applies it to selected polygons.

Smooth 30

Enables moderate smoothing for the entire object. Sets Auto Smooth to 30.0 and applies it to all polygons in the model, assigning smoothing groups as necessary.

Smooth 30 Selected

Enables moderate smoothing for selected polygons. Sets Auto Smooth to 30.0 and applies it to selected polygons.
Color  Click the color swatch to set the vertex color for selected vertices or polygons.
For more information on vertex color, see Assign Vertex Colors Utility on page 6477.

Illum  Click the color swatch to set the illumination color for selected vertices or polygons.
For more information on vertex illumination, see Assign Vertex Colors Utility on page 6477.

Alpha  Assign an alpha (transparency) value to selected vertices or polygons.
The spinner value is a percentage; zero is completely transparent and 100 is completely opaque.
For more information on vertex alpha, see Assign Vertex Colors Utility on page 6477.

Smoothing Groups  Opens a dialog for working with smoothing groups. For details, see Polygon: Smoothing Groups rollout on page 2310.

Opens the Material IDs dialog for setting material IDs and selecting by ID and sub-material name. For details, see Polygon: Material IDs rollout on page 2309.

Freeform Tab

Modeling ribbon > Freeform tab
The Freeform tab contains tools for freehand creation and modification of polygon geometry, available on the PolyDraw and Paint Deform panels. In
addition, the following panels are hidden but available on the Freeform tab from the right-click menu:

- Polygon Modeling Panel on page 2045
- Modify Selection Panel on page 2063
- Edit Panel on page 2075

**PolyDraw Panel**

Modeling ribbon > Graphite Modeling Tools/Freeform tab > PolyDraw panel

**NOTE** The PolyDraw panel is visible by default only on the Freeform tab but can be made visible on the Graphite Modeling Tools tab via the right-click menu.

PolyDraw provides tools for quickly sketching out and editing a mesh on the main grid, projected onto the surface of another object, or on the selected object itself, depending on the Draw On on page 2160 setting.

The tools have different effects depending on which combination of the Ctrl, Shift, and Alt keys you press, as described in the following definitions. PolyDraw does not require that a particular sub-object level be active, but we recommend that you use them at the Vertex level for improved visual feedback with certain tool effects. To exit a PolyDraw tool, click its button again or right-click in the active viewport.
Interface

PolyDraw panel on minimized ribbon

PolyDraw panel on maximized ribbon, with expansion

PolyDraw panel floating, with expansion

Freeform Tab | 2157
Step Build  With Step Build you can build and edit a surface vertex by vertex and polygon by polygon. Works at the object level and all sub-object levels. Right-click to exit the tool.

Following are the different functions of the tool, depending on which keyboard keys are pressed:

- **Normal** Click to place vertices on the grid or surface.
- **Shift** Drag over freestanding vertices to fill in the gaps with quad polygons. This always creates a polygon from the closest four vertices.
- **Ctrl** Click a polygon to delete it. The vertices remain so that if you accidently create a face in the wrong place it’s easy to delete the face and draw again closer to the vertices you want.
- **Alt** Click a vertex to remove it.
- **Ctrl+Alt** Click an edge to remove it.
- **Ctrl+Shift** Click to place and select vertices, or to select existing vertices. Each time you place and/or select four vertices, Step Build automatically creates a polygon. It includes the last two vertices from the previously created polygon in the new selection, so you need only click twice to create the next polygon. To clear the selection, release the keys.
- **Shift+Alt** Move the mouse cursor (without dragging) over vertices to select them, and then click to create a polygon from the selected vertices. Useful for creating non-quad polygons. To clear the selection, release the keys.
- **Ctrl+Shift+Alt** Drag to move a vertex around on the grid or surface. At the Vertex sub-object level, a vertex highlights when you move the mouse near enough to start dragging it.

**NOTE** While Step Build is active, vertex ticks on page 167 are always visible for the selected object. If you don’t see them at levels other than Vertex, make sure the object’s display properties on page 288 are set to By Object.
Extend

With the Extend tool you can work on the open edges of the object; those on the border of the surface that have only one polygon attached. Following are the different functions of the Extend tool:

- **Normal** Drag from border vertices to create polygons.
- **Shift** Drag from border edges to create polygons.
- **Shift+Ctrl** Drag between two edges to create a polygon.
- **Ctrl** Click to delete a polygon and its isolated vertices.
- **Ctrl+Shift+Alt** Drag to move a vertex around on the grid or surface.

You can also use Extend to edit the object in screen space, thus moving sub-objects perpendicular to the view direction. You do not need to change the active coordinate system to use this method.

- **Alt** Drag from border vertices to create polygons in screen space.
- **Alt+Shift** Drag from border edges to create polygons in screen space.
- **Alt+Ctrl** Drag to move a vertex around in screen space.

Drag

With the Drag tool you can move individual sub-objects around on the surface or grid. The options are:

- **Normal** Move vertices by dragging them.

**NOTE** With Drag on at the Vertex sub-object level, moving the mouse cursor around automatically selects the vertex that will be moved when you drag the mouse.

- **Shift** Move edges by dragging them.
- **Ctrl** Move polygons by dragging them.
- **Shift+Ctrl** Move edge loops by dragging them.
- **Shift+Ctrl+Alt** Move elements by dragging them.
You can also use Drag to move sub-objects in screen space; that is, perpendicular to the current view direction. You do not need to change the active coordinate system to use this method.

- Alt Drag vertices to move them in screen space.
- Alt+Shift Drag edges to move them in screen space.
- Alt+Ctrl Drag polygons to move them in screen space.

Optimize
Optimize meshes quickly by sketching away details. The tool options are:

- **Normal** Click edges to collapse them, combining two vertices into one.
- Shift Drag from one vertex to the next to target-weld the two, combining the first with the second. If you continue dragging to further vertices you can weld several vertices with a single stroke.
- Ctrl Drag between vertices to connect them with edges.
- Alt Remove a vertex by clicking it.
- Shift+Ctrl Remove an edge loop by clicking an edge on the loop.
- Shift+Alt Remove an edge ring by clicking an edge in the ring.
- Ctrl+Alt Remove an edge by clicking it.
- Shift+Ctrl+Alt Move a vertex by dragging it.

**Draw On:** Choose the entity type to draw on:

- **Grid** PolyDraw creates geometry on the grid of the active viewport. This drawing mode is particularly suited to orthographic viewports, but also works well in perspective viewports.

- **Surface** PolyDraw creates geometry on an object that you specify.
Click the Pick button and then select a different object to draw on. The button then contains the name of that object. Use any of the PolyDraw tools (Strips, etc.) to draw on the object. To change the surface, click the button again and choose a different object to draw on.

- Selection  PolyDraw creates geometry on the selected object.

- Pick  Designates an object to draw on for the Draw On: Surface option (see preceding).
After setting the Draw On option to Surface, click the Pick button, and then click an object to draw on. To remove the object, click the button again.

- Shapes  Draw polygon shapes on the grid or a surface.
Drag to set the polygon outline on the grid or an object surface. After drawing a polygon, optionally use Solve Surface to create a workable mesh from the shape.
While Draw Polygon is active, the following keyboard alternatives are available:
  ■ Ctrl Click to delete a polygon.
  ■ Ctrl+Shift+Alt Drag to move a polygon.

- Topology  Draw lines that form a grid of quads. As you draw eligible quads, Topology fills them in with polygons, creating a mesh from the grid. Right-click to exit the tool.
If Auto Weld (see following) is on, the software automatically attaches the created mesh to the selected object and welds border vertices that are close together. This way you can continue adding to the surface of the selected object.

When Auto Weld is off, drawing with Topology always creates a new object. The Minimum Distance on page 2165 value determines the resolution of the lines. If the value is too small some faces might be missed in the polygon creation. The default value, 10.0, with the unit type set to pixels should work well in most cases.

While Draw Topology Pattern is active, the following keyboard alternatives are available:

- Shift Drag to continue a line from the closest existing endpoint.
- Ctrl Click to delete a line.

Auto Weld When on, automatically attaches the mesh that you create with Topology to the selected object and welds border vertices that are close together.

When off, drawing with Topology always creates a new object.

Splines Draw splines on a surface or grid. You can then make these splines renderable or use them in a lofting operation to create quick details.
Set the Draw On option, click Splines, and then drag to draw the splines on the desired base. All splines are combined into a single, separate object. While Splines is active, the following keyboard alternatives are available:

- Ctrl Click to delete a spline.
- Ctrl+Shift+Alt Drag to move the closest spline.

**Strips** Paint strips of polygons that curve to follow the mouse direction.

The Strips tool lets you quickly lay out the topology foundation for a mesh object. While Strips is active, the following keyboard alternatives are available:

- Shift Starts painting from the closest existing edge.
- Alt While drawing, press and drag to an open edge in the current object (but not on the same strip) to add a polygon between where you press Alt and the edge you drag to. Alternatively, press Alt before drawing and then drag between two open edges to connect them with a new polygon.

**Surface** Drag to paint a surface onto an object or the grid.

To start the surface from an existing border edge, hold Shift before starting to draw. This prevents drawing overlapping polygons.

To delete a polygon and any resulting isolated vertices while Surface is active, Shift+click it.

**Branches** Paint multi-segmented extrusions from polygons with optional tapering to form "branches."

**NOTE** Drawing branches always starts from the selected object; it doesn’t use the Draw On: (Grid/Surface/Selection) setting.

The extrusions are aligned to the screen. The Branch Taper value (see following) determines the difference in size between the first and the last polygon in the
branch, while **Minimum Distance** on page 2165 lets you set the distance between segments in the extrusion.

Activate the tool and then drag from polygons on the selected object to draw branches.

- **Normal** Drag to draw extruded branches from the polygon closest to the mouse.
- **Shift** Drag to draw extruded branches from selected polygon(s).
- **Ctrl** Click to select a polygon (at the Polygon sub-object level only).
- **Ctrl+Alt** Click to select/deselect additional polygons (at the Polygon sub-object level only).

**NOTE** When the modeling ribbon is maximized or the Paint Deform panel floats, the following controls appear on the Paint Deform panel expansion.

**Branch Taper** The amount by which branches taper as you draw them. A negative value makes the branch dwindle in size; a positive value makes it get thicker, and 0 keeps it the same size as the starting polygon. A value of -1.0 makes the end of the branch as small as possible, while values lower than -1.0 cause the branch to shrink to the minimum partway through and then enlarge the rest of the way.

**New Object** Creates a new, “empty” editable poly object, accesses the Vertex sub-object level, and keeps the current PolyDraw tool active. Immediately after clicking New Obj you can use the PolyDraw tools to add geometry.

**Solve Surface** Takes a polygon shape such as one painted with the Shapes tool and tries to create a workable mesh, adding edges so that the result is a clean shape composed mainly of quadrilateral polygons. Or, if Solve To Quads (see following) is off, the result is mostly triangles.

**TIP** Solve Surface works best when the starting shape is mostly in the form of "strips," where the two sides of the polygon are fairly close together.
Angle Affects the way Solve Surface connects vertices. With flat shapes, the default value of 35 works best. With curved surfaces, however, Solve Surface might produce better results at higher values.

Solve to Quads When on, using Solve Surface (see preceding) results in mostly four-sided polygons. When off, Solve Surface produces mainly triangles.

Offset The distance that PolyDraw uses for creating geometry on (or moving it across) the grid or object surface (depending on the Draw On setting).

Minimum Distance The shortest distance you need to drag the mouse before the next step in the tool is taken.

For example, when using the Shapes on page 2161 tool, this value determines the minimum distance, in pixels or world units, between the vertices the software creates as you draw.

To determine how to measure Minimum Distance, choose one of the following:

- **in Pixels** Uses pixels to specify the minimum distance you need to drag the mouse before the next step in the tool is taken.

- **in Units** Uses world units to specify the minimum distance you need to drag the mouse before the next step in the tool is taken.

Paint Deform Panel

Modeling ribbon > Graphite Modeling Tools/Freeform tab > Paint Deform panel

**NOTE** The Paint Deform panel is visible by default only on the Freeform tab but can be made visible on the Graphite Modeling Tools tab via the right-click menu.
Paint Deform provides tools for deforming mesh geometry interactively and intuitively by dragging the mouse over an object surface. The primary tools are Shift, for moving vertices with falloff in the direction you drag the mouse, and Push/Pull, for moving vertices inward and outward. Additional tools include Smudge, Flatten, Noise, and more.

Paint Deform tools work the same way at the object level and at all sub-object levels, and are independent of any sub-object selection. To exit a Paint Deform tool, click its button again or right-click in the active viewport.

Interface
**Shift** Move sub-objects around in screen space (perpendicular to the viewing direction) with an adjustable falloff effect. The Shift tool is roughly equivalent to using the Move tool with Soft Selection, but no initial selection is necessary.

![Image of Shift tool](image_url)

**Using Shift on a mesh object**

Shift affects only vertices within the brush area when you start to drag; to affect other vertices, release and then drag again. When you activate the Shift tool, its Options panel on page 2175 opens with settings for adjusting the tool’s effect. These settings are also available via the following keyboard modifiers:

- **Ctrl** Drag vertically to change the radius of the **Falloff** on page 2176 (black) circle.
- **Shift** Drag vertically to change the radius of the **Full Strength** on page 2176 (white, inner) circle.
- **Shift+Alt** Drag vertically to change the **Strength %** on page 2176 value.

**NOTE** Revert on page 2174 works with the Shift tool only after you use another Paint Deform tool, such as Push/Pull.

![Image of Push/Pull tool](image_url)

**Push/Pull** Drag the brush to move vertices outward; Alt+drag to move them inward.
Using Pull (left) and Push (right) on a mesh object

Following is a list of other effects available with keyboard alternatives:

- Ctrl Reverts on page 2174 to the previous saved state.
- Shift Relaxes on page 2168 the mesh.
- Ctrl+Shift Resizes the brush.
- Shift+Alt Changes the brush strength.

Change brush size, strength, and other settings on the Paint Options Panel on page 2177.

Relax/Soften Drag the brush to smooth out the surface; for example, to round off corners.

NOTE With most other brushes, you can apply Relax/Soften by dragging with Shift held down.
Using Relax/Soften on a mesh object

Following is a list of effects available with keyboard alternatives:

- Alt Drag the brush to relax the mesh without shrinking.
- Ctrl Reverts on page 2174 to the previous saved state.
- Ctrl+Shift Resizes the brush.
- Shift+Alt Changes the brush strength.

Change brush size and strength on the Paint Options Panel on page 2177.

**Smudge** Drag to move vertices around. Smudge is roughly equivalent to the Shift tool, but updates the area of effect continually as you drag, and doesn’t use falloff.
Using Smudge on a mesh object

Following is a list of effects available with keyboard alternatives:

- Alt Drag the brush to move vertices horizontally only (prevents movement in normal direction).
- Ctrl Reverts on page 2174 to the previous saved state.
- Shift Relaxes on page 2168 the mesh.
- Ctrl+Shift Resizes the brush.
- Shift+Alt Changes the brush strength.

Change brush size and strength on the Paint Options Panel on page 2177.

Drag the brush to flatten convex and concave areas.
Using Flatten on a mesh object

Following is a list of effects available with keyboard alternatives:

- Ctrl Reverts on page 2174 to the previous saved state.
- Shift Relaxes on page 2168 the mesh.
- Ctrl+Shift Resizes the brush.
- Shift+Alt Changes the brush strength.

Change brush size and strength on the Paint Options Panel on page 2177.

**Pinch/Spread** Move vertices closer together by dragging, or spread them apart with Alt+drag.
Using Pinch (left) and Spread (right) on a mesh object

Following is a list of additional effects available with keyboard alternatives:

- **Ctrl Reverts** on page 2174 to the previous saved state.
- **Shift Relaxes** on page 2168 the mesh.
- **Ctrl+Shift** Resizes the brush.
- **Shift+Alt** Changes the brush strength.

Change brush size and strength on the [Paint Options Panel](on page 2177).

**Noise** Drag to add convex noise to the surface, or **Alt+drag** to add concave noise.
Using Noise on a mesh object

Following is a list of additional effects available with keyboard alternatives:

- **Ctrl** Reverts on page 2174 to the previous saved state.
- **Shift** Relaxes on page 2168 the mesh.
- **Ctrl+Shift** Resizes the brush.
- **Shift+Alt** Changes the brush strength.

Change brush size, strength, and other settings on the Paint Options Panel on page 2177.

**Exaggerate** Makes the features of the painted surface more pronounced by moving convex areas outward and concave areas inward.
Using Exaggerate on a mesh object

Following is a list of effects available with keyboard alternatives:

- Alt Inverts the exaggeration, making convex areas concave and vice-versa.
- Ctrl Reverts on page 2174 to the previous saved state.
- Shift Relaxes on page 2168 the mesh.
- Ctrl+Shift Resizes the brush.
- Shift+Alt Changes the brush strength.

Change brush size, strength, and other settings on the Paint Options Panel on page 2177.

Revert Paint to restore the mesh to its previous shape, before the last use of Commit (see following).

If you haven’t used Commit yet, Revert goes back to the object’s initial shape.

Following is a list of effects available with keyboard alternatives:

- Shift Relaxes on page 2168 the mesh.
- Ctrl+Shift Resizes the brush.
- Shift+Alt Changes the brush strength.

Change brush size and strength on the Paint Options Panel on page 2177.
NOTE  Revert works with Shift on page 2167 only after you use another Paint Deform tool, such as Push/Pull.

Commit  Sets the restore buffer to the current state of the object.
After using Commit, using Cancel or the Revert brush (see preceding) returns the model to its shape when you last used Commit.

Cancel  Removes any changes made with Paint Deform since the last Commit.
If you haven’t used Commit, returns the model to its initial shape.

Shift Options Panel

Modeling ribbon > Graphite Modeling Tools/Freeform tab > Paint Deform panel > Enable Shift tool.

NOTE  The Paint Deform panel is visible by default only on the Freeform tab but can be made visible on the Graphite Modeling Tools tab via the right-click menu.

This panel opens when the Shift tool is active, and provides settings for modifying its effects.

Interface

Shift Options panel on minimized ribbon
**Full Strength** The area of the Shift-tool painting brush within which sub-objects move at the same rate that you drag the brush. This area is depicted as a white circle inside a black one. Sub-objects outside the Full Strength circle but within the Falloff circle (see following) move at a gradually slower rate.

To adjust Full Strength interactively, use Shift+drag.

**Falloff** The area within which dragging the mouse with the Shift tool active gradually decrease the effect, going from full strength (within the white circle) to no effect (outside the black circle).

To adjust Falloff interactively, use Ctrl+drag.

---

**NOTE** When the modeling ribbon is maximized or the Shift Options panel floats, the following controls appear on the Shift Options panel expansion.

**Strength %** The overall rate at which the Shift tool deforms an object. For subtler effects, lower the Strength % value.

To adjust Strength % interactively, use Shift+Alt+drag.

---

**Use Selected Verts** When on, the Shift tool affects selected vertices only. Applies at the object level and all sub-object levels.

When off (the default), the Shift tool affects all vertices in the selected object.

**Ignore Backfacing** When on, the Shift tool affects only sub-objects facing you.

When off (the default), the Shift tool affects all sub-object(s) in the selected object within the Falloff range, regardless of their visibility or facing.

**Freeze Axis X/Y/Z** Click to activate any combination of X, Y, and Z. When an axis button is on, the Shift tool is prevented from moving sub-objects on the object’s corresponding local axis.

**TIP** To limit the Shift tool’s effect to a particular axis, turn on Freeze Axis for the other two axes.

**Freeze Selected Edges X/Y/Z** Click to activate any combination of X, Y, and Z. When an axis button is on, the Shift tool is prevented from moving selected edges on the object’s corresponding local axis. Unselected edges move freely.
Applies at all sub-object levels.

For example, to allow Shift to cause vertical deformation only on the upper half of an object, first access the Edge sub-object level and select the upper half of the object, turn on Freeze Selected Edges > X and Y, and activate the Shift tool. Then, at the object level or at any sub-object level, using Shift on the upper half of the object prevents horizontal deformation.

**Paint Options Panel**

Modeling ribbon > Graphite Modeling Tools/Freeform tab > Paint Deform panel > Enable a tool other than Shift (Push/Pull, etc.).

**NOTE** The Paint Deform panel is visible by default only on the Freeform tab but can be made visible on the Graphite Modeling Tools tab via the right-click menu.

This panel opens when Paint Deform on page 2165 tools other than Shift are active, and provides settings for modifying their effects.

**NOTE** Only Size and Strength settings are available for Relax/Soften, Flatten, Pinch/Spread, Smudge, and Revert; additional settings are available for the rest.
Interface

Size The radius of the circular deform brush.

NOTE With most brushes, you can change the size interactively by dragging with Ctrl+Shift held down.

Strength The overall rate at which the deform tool deforms an object. For subtler effects, lower the Strength value.

NOTE With most brushes, you can change the strength interactively by dragging with Shift+Alt held down.

Offset The maximum amount by which painting with a deform tool can change the mesh without lifting the mouse button. Applies only when Cap Offset is on (see following).

NOTE When the modeling ribbon is maximized or the Paint Options panel floats, the following controls appear on the Paint Options panel expansion.

Cap Offset When on, dragging the brush continuously stops deforming at the Offset amount (see preceding). To increase the offset, release the mouse button and then start again.
When off, dragging the brush continuously keeps applying the offset without limit.

**Normal Direction** Choose the direction in which mesh deformation occurs when painting:
- **Original** Uses the normals that the vertices had when you began using the tool. This way you can keep adding strokes without having the vertices go off in unexpected directions.
- **Deformed** The normals are updated after each stroke so the tool keeps pushing from the current state.
- **Brush** Uses the normal from the brush (gizmo) when you started the stroke.
- **View** Pushes towards or away from the view direction.
- **Transform X/Y/Z** Moves vertices along the corresponding world axis.

**Refresh Normals** Resets the brush to use each polygon’s current normal direction when deforming, rather than the original. Available only with Normal Direction=Original.

When off, painting always deforms in the original direction of the polygon’s normal.

**TIP** For automatic refreshing of the deform direction, set Normal Direction to Deformed (see preceding).

**Brush Options** Opens the Painter Options dialog on page 1989 for adjusting brush properties, display options, and more.

**Noise Options** These settings apply only to the Noise brush on page 2172:
- **Seed** Generates a random starting point for the noise deformation from the number you set. Affects only subsequent painting, not existing results.
- **Scale** Sets the size of the noise effect (not strength). Larger values produce smoother noise, lower values more jagged noise.
- **Turbulence** Determines the extent of noise variation. Lower values are less rough than higher values.

## Selection Tab

Modeling ribbon > Selection tab

The Selection tab of the modeling ribbon provides a variety of specialized tools for making sub-object selections. For example, you can select concave or convex areas, sub-objects that face the viewpoint, or point in a certain direction, and more.

**NOTE** The Selection tab panels appear only when a sub-object level is accessed. When no object is selected, or an object is selected but no sub-object level is active, the Selection tab is empty by default.

You can use the right-click menu > Panels submenu to make the Polygon Modeling panel available on the Selection tab, which you can then use to access and change sub-object levels.

## General Selection Panels

Access a sub-object level. > Modeling ribbon > Selection tab > Select/Stored Selections/Selection Sets panel

The general selection panels comprise the Select panel for selecting sub-objects based on certain topologies; the Stored Selections panel for saving, restoring, and combining sub-object selections; and the Selection Sets panel for copying and pasting named sub-object selection sets.

**Select panel**

The Select panel includes the Tops, Open, and Patterns tools for sub-object selection at all levels, plus the Hard tool for selecting edges at the borders of smoothing groups and additional selection tools for polygons.
Tops Selects the tops of extruded sections of the model. The actual results depend on the sub-object level:

- **Vertex** Selects the vertices of the tops of extruded polygons.
- **Edge** Selects the edge outlines of the tops of extruded polygons.
- **Polygon** Selects the tops of extruded polygons.
**Tops of Current Selection (on Tops drop-down)** Selects the tops of extruded sections of the model within the current selection, and deselects all remaining sub-objects. For details, see Tops (preceding).

**Open** Selects all “open” sub-objects.

The current sub-object level determines the actual results:

- **Vertex** Selects all border vertices; that is, vertices on edges with only one polygon.
- **Edges** Selects all border edges; that is, edges with only one polygon.
- **Polygon** Selects all border polygons; that is, polygons that have one or more edges with only one polygon.

**Hard** Selects all edges in a model whose faces do not share the same smoothing groups. Available only at the Edge sub-object level.

**Non-Quads** Selects all non-quadrilateral polygons; that is, polygons with more or fewer than four sides. Available only at the Polygon sub-object level.

**NOTE** When the modeling ribbon is maximized or the Select panel floats, the following controls appear on the Select panel expansion.

**Patterns** Grows the current selection and turns it into a pattern that depends on the initial selection. Make a selection and then choose a Patterns option from the drop-down list. All options work at all sub-object levels except for One Ring, which works only for polygons.

You can use the Pattern tools for a variety of purposes, such as making complex surface details or laying out building structures.
The options are as follows:

- **Pattern 1-8** Each numbered Pattern option provides a different way of forming a pattern. Some are fast-growing while others are slower; some tend to form cubic patterns while others are more broken up. The effect depends very much on the initial selection and thus can be somewhat unpredictable, so the best way to use the patterns is to experiment until you find a result you like.

- **Growlines** Grows the selection to lines with gaps of unselected lines. For example, if you select a whole polygon loop and apply Growlines, the selection grows by selecting alternating polygon loops starting with the initial selection.

- **Checker** Grows the selection and forms a checker pattern.

- **Dots** Grows the selection and forms a pattern where all selected sub-objects have gaps between them.

- **One Ring** Grows a single polygon ring around the initial selection. Available only at the Polygon level.

**By Vertex** When on, you can select sub-objects only by selecting a vertex that they use. When you click a vertex, all sub-objects that use the selected vertex are selected. Not available at the Vertex sub-object level.

**By Mat ID** Selects polygons corresponding to the Material ID specified in the adjacent ID field. Type or use the spinner to specify an ID, then click By Mat ID.

**By Angle** When on, selecting a polygon also selects neighboring polygons based on the angle setting to the right of the check box. This value determines the maximum angle between neighboring polygons to select. Available only at the Polygon sub-object level.

For example, if you click a side of a box and the angle value is less than 90.0, only that side is selected, because all sides are at 90-degree angles to each other. But if the angle value is 90.0 or greater, all sides of the box are selected. This function speeds up selection of contiguous areas made up of polygons that are at similar angles to one another. You can select coplanar polygons with a single click at any angle value.

**By Smoothing Group** Displays a dialog that shows the current smoothing groups. Select all polygons that belong to a group by clicking the corresponding numbered button and clicking OK.
If Clear Selection is on, any previously selected polygons are first deselected. If Clear Selection is off, the new selection is added to any existing selection.

**Stored Selections panel**

This panel provides tools for quickly and easily storing and retrieving selections as well as performing some basic operations between stored selections. You can also use the tools for transferring a selection from one model to another. This is especially useful when working with morph targets if you need to change the same area on multiple models.

![Image of stored selections panel]

**Copy Store 1** / **Copy Store 2** Places the current sub-object selection in the Store 1 or Store 2 buffer.

When a buffer contains a stored selection, its Copy button turns blue. When empty, the button background is white.

**Paste Store 1** / **Paste Store 2** Selects sub-objects at the current level based on the contents of the corresponding Store buffer, replacing the current selection. To retain the current selection, press Shift before clicking Paste Store.

Does not clear the buffer.

**Add 1+2** Combines the two stored selections and applies the selection at the current sub-object level, emptying both Store buffers.

TIP To use a third store, assign the Store and Paste CUI actions on page 8249 available in the PolyTools category. This store works only with the CUI versions of the commands.
Use Copy Store 1 and Copy Store 2 on different sub-object selections and then use Add 1 + 2 to select all sub-objects in both store buffers.

**Subtract 1-2** Selects Store 1 except for where it overlaps with Store 2. Clears both buffers.

**Intersect** Selects the overlap (if any) of the sub-object selections in Store 1 and Store 2.

**Clear** Clears the stored selections, emptying both buffers.

**Selection Sets panel**

This panel provides controls for copying and pasting sub-object selection sets. When the ribbon is maximized or the panel floats, the panel label is shortened to “Sets.”

The controls let you copy and paste named selection sets on page 185 of sub-objects between objects. Start by creating one or more named selection sets, copy one, select a different object, go to the same sub-object level, and then paste the set.

**NOTE** This function uses sub-object IDs, so if the target object’s geometry differs from that of the source object, the pasted selection will probably comprise a different set of sub-objects.

**Copy** Opens a dialog that lets you specify a named selection set to place into the copy buffer.
Select By Panels

Access a sub-object level. > Modeling ribbon > Selection tab > “By ...” panels

The Select By panels provide a variety of methods for making sub-object selections procedurally. For example, you can use By Surface to select concave or convex areas of a model, or By Pivot to select the outer areas of a model.

Following is a linked list of all the Select By panels:

- By Surface panel on page 2186
- By Normal panel on page 2187
- By Perspective panel on page 2187
- By Random panel on page 2188
- By Half panel on page 2189
- By Pivot Distance panel on page 2190
- By View panel on page 2190
- By Symmetry panel on page 2191
- By Numeric panel on page 2191
- By Color panel on page 2192

By Surface panel

Select sub-objects by the degree of concavity or convexity. Choose Concave or Convex and then specify the selection with the value spinner.

NOTE To see the resulting change in selection after switching between Concave and Convex, adjust the numeric setting.
Concave/Convex From the drop-down, choose to select sub-objects in concave or convex areas.

[value spinner] Adjust to change the number of selected sub-objects. Low values (including negative numbers) select sub-objects only in areas of extreme concavity or convexity, and increasing the value expands the selection from there.

By Normal panel

Selects sub-objects based on their normal directions on the World axes. Choose an axis, optionally turn on Invert, and then set an Angle value.

NOTE To see the resulting change in selection after switching the axis or toggling Invert, adjust the Angle setting.

Angle The amount by which a sub-object’s normal direction can deviate from the specified axis and still be selected. The higher this value, the more sub-objects are selected.

X/Y/Z The direction in which a sub-object’s normal must point in the World coordinate system to be selected.

Invert Reverses the direction of normal selection.

For example, using the Z option by itself selects upward-facing sub-objects, while turning on Invert instead selects downward-facing sub-objects.

NOTE Invert simply inverts the selection, so the Angle setting works in reverse when it’s on: Higher values select fewer sub-objects and vice-versa.

By Perspective panel

Selects sub-objects based on the extent to which they point toward the user in the active viewport. You can think of it as projecting a selection onto the model from the current view.
Set the Angle value, optionally toggle Outline, and then click Select.

**NOTE** The CUI on page 8249 action for this command, found in Group: Main UI > Category: PolyTools, is PerspectiveSelect. When you use the shortcut, the tool automatically uses an Angle value of 30.0, and when applied at the Edge sub-object level, it always uses Outline mode.

**Angle** The amount by which a sub-object’s normal direction can deviate from the view axis (an imaginary line between the viewpoint and the sub-object) and still be selected. The higher this value, the more sub-objects are selected.

**Outline** When on, By Perspective selects only the outermost sub-objects as defined by the Angle setting.

**Select** Makes the selection based on the current settings.

**By Random panel**

Use these tools to select sub-objects at random by number or percentage, and to expand or shrink the current selection, also at random.

Choose to select random sub-objects by number (#) or percent (%), set the respective numeric value, and then click Select. Or, to select random sub-objects within the current selection, click Select Within Current Selection on the Select drop-down. To expand or shrink the current selection at random, click Random Grow or Random Shrink.

**Number** Enables random selection by number.

Click #, set the desired number of sub-objects to select, and then click Select.
Percent Enables random selection by percentage. Click %, set the desired number of sub-objects to select, and then click Select.

Select Makes the selection based on the current settings.

Select Within Current Selection (on Select drop-down) Selects random sub-objects within the current selection based on the Random-panel settings.

Random Grow Grows the selection by selecting random unselected sub-objects near the current selection. This function has no parameters; it does not use the # or % setting.

Random Shrink Shrinks the selection by deselecting random sub-objects. This function has no parameters; it does not use the # or % setting.

By Half panel

Selects half of the mesh on the specified axis. The selection is based on area, not the number of sub-objects. Choose the axis on which to select half the mesh, then click Invert Axis or Select.

The center of the mesh is determined by the location of its pivot on page 3762. If you change the pivot position, apply Reset XForm Utility on page 912 and then collapse on page 2022 the mesh. If you use the Collapse utility, be sure to choose the Modifier Stack Result option.

X/Y/Z Choose the axis on which to select half the mesh.
Invert Axis  Toggles inverting the Select By Half selection, and makes the selection. Choose the axis on which to select half of the mesh, and then click Invert to make the selection. Click again to select the other half.

Select  Makes the selection based on the current settings.

By Pivot Distance panel
Selects sub-objects based on distance from the object’s pivot on page 3762. If you change the pivot position, apply Reset XForm Utility on page 912 and then collapse on page 2022 the mesh. If you use the Collapse utility, be sure to choose the Modifier Stack Result option.

% From Pivot  The distance beyond which to select sub-objects, expressed as a percentage of the object’s size. If the pivot is centered, a value of 100.0 means the whole object is unselected; values below that result in selection of the outer parts of the model, growing inward as the value decreases.

By View panel
Selects and grows sub-objects based on the current view and inwards into the view. The closest part of the model is selected first; higher values grow the selection farther into the view.

Grow From Perspective View  The distance to select sub-objects, starting with the closest part of the object to the view. At 0.0, no sub-objects are selected; low values select only the closest sub-objects, and higher values select increasingly farther sub-objects.
**By Symmetry panel**

In a symmetrical model, mirrors the current sub-object selection on the specified local axis. The center of the object is determined by the location of the object's pivot on page 3762.

X/Y/Z Choose the local axis on which to mirror the current sub-object selection.

**By Numeric panel**

Enables selecting vertices by the number of connected edges or polygons by the number of sides.

At the Vertex level, selects vertices with the same, less than, or more than the number of connected edges specified by the Edges setting. At the Polygon level, selects polygons with the same, less than, or more than the number of sides specified by the Sides setting. Available only at the Vertex and Polygon sub-object levels.

Click the =, <, or > button, set the desired number of connected edges (for vertices) or sides (for polygons) as the Edges value, and then click Select.

**By Numeric panel at the Vertex level**

**By Numeric panel at the Polygon level**

=/< Choose to base the selection on whether the qualifying sub-objects match the specified value (=) or are less than (<) or more than (>) the value.

**Edges** Selects vertices with (same as; less than; more than) the Edges number of edges connected to them. Available only at the Vertex sub-object level.
**Sides**  Selects polygons with (same as; less than; more than) the Sides number of sides. Available only at the Polygon sub-object level.

**Select**  Makes the selection based on the current settings.

**By Color panel**

Select vertices by color or illumination value. Available only at the Vertex sub-object level. For more information about vertex colors, see Assign Vertex Colors Utility on page 6477.

From the drop-down, choose Color or Illumination, use the color swatch and RGB settings to specify the color or illumination value and range to match, and then click Select.

**Color/ Illumination**  From the drop-down, choose to select vertices by Color or Illumination.

[**color swatch**]  Displays the Color Selector on page 371, where you can specify a color to match.

**RGB [Range]**  Specifies a range for the color match. All three RGB values in the vertex color or illumination must either match the color specified by the color swatch in Select By Vertex Color, or be within plus or minus the values in the Range spinners. Default=10.

**Select**  Makes the selection based on the current settings.

### Editable Mesh Surface

Create or select an object. > Quad menu > Transform quadrant > Convert To: submenu > Editable Mesh
Create or select an object. > Modify panel > Right-click the base object in the stack. > Convert to: Editable Mesh

Create or select an object. > Utilities panel > Collapse button > Collapse Selected button

Editable Mesh on page 8559, like the Edit Mesh modifier, provides controls for manipulating a mesh object made up of triangular faces as an object and at three sub-object levels: vertex, edge and face. You can convert most objects in 3ds Max to editable meshes, but for open spline objects, only vertices are available, because open splines have no faces or edges when converted to meshes.

To make a sub-object selection on a non-editable mesh object (for example, a primitive) for passing up the stack to a modifier, use the Mesh Select modifier on page 1500.

Once you make a selection with Editable Mesh, you have these options:

- Use the options supplied on the Edit Geometry rollout to modify the selection. Later topics discuss these options for each of the mesh components.
- Transform or Shift+clone the selection, as with any object.
- Pass the selection to a later modifier in the stack. You can apply one or more standard modifiers to the selection.
- Use the options on the Surface Properties rollout to alter the surface characteristics of selected mesh components.

**NOTE** Because Edit Mesh modifier functionality is almost identical to that of editable mesh objects, features described in the Editable Mesh topics also apply to objects with Edit Mesh applied, except as noted.

**TIP** Editable Poly on page 2240 is similar to Editable Mesh, but lets you work with polygons of four or more sides, and provides a greater range of functionality.

**TIP** You can exit most Editable Mesh command modes, such as Extrude, by right-clicking in the active viewport.

See also:

- Edit Modifiers and Editable Objects on page 1052
- Modifying at the Sub-Object Level on page 1054
Procedures

To produce an editable mesh object:
First select the object, and then do one of the following:
■ Right-click the object and choose Convert To Editable Mesh from the Transform quadrant.
■ Use the Collapse utility on page 2022.
■ Apply a modifier to a parametric object that turns the object into a mesh object in the stack, and then collapse the stack. (For example, you can apply a Mesh Select modifier.)
■ Apply an Edit Mesh or Mesh Select modifier to an object.
■ Import a non-parametric object, such as that found in a 3DS file.
■ Import a 3ds Max object using Application menu on page 7989 > Import > Merge.

Converting an object to an editable mesh removes all parametric controls, including the creation parameters. For example, you can no longer increase the number of segments in a box, slice a circular primitive, or change the number of sides on a cylinder. Any modifiers you apply to an object are collapsed as well. After conversion, the only entry left on the stack is "Editable Mesh."

Maintaining an object's creation parameters:
As described in the above procedure, you can convert an existing object to an editable mesh, which replaces the creation parameters in the stack with "Editable Mesh." The creation parameters are no longer accessible or animatable. If you want to maintain the creation parameters, you can use the following modifiers:
■ Edit Mesh Modifier on page 1321
■ Mesh Select Modifier on page 1500
Interface

**Modifier Stack display**

**Show End Result** Normally, if you apply a modifier such as Twist to an editable-mesh object and then return to the Editable Mesh stack entry, you cannot see the effect of the modifier on the object's geometry. But if you turn on Show End Result while in sub-object level, you can see the original sub-object selection as a yellow mesh, the final object as a white mesh, and the original editable mesh as an orange mesh.

**Selection rollout**

See Selection Rollout (Editable Mesh) on page 2198.

**Named Selections**

**Copy** Places a named selection into the copy buffer.

**Paste** Pastes a named selection from the copy buffer.

For more information, see Named Selection Sets on page 217.

**Selection Information**

At the bottom of the Selection rollout is a text display giving information about the current selection. If no objects or more than one sub-object are selected, the text gives the number of objects and the type selected. If a single sub-object is selected, the text gives its identification number and type.

*NOTE* When the current sub-object level is Polygon or Element, selection information is given in faces.

**Soft Selection rollout**

Soft Selection controls affect the action of sub-object Move, Rotate, and Scale functions. When these are on, 3ds Max applies a spline curve deformation to
unselected vertices surrounding the transformed selected sub-object. This provides a magnet-like effect with a sphere of influence around the transformation.

For more information, see Soft Selection Rollout on page 2014.

**Edit Geometry rollout**

The Edit Geometry rollout on page 2220 provides various controls for editing an editable mesh object and its sub-objects. For information specific to the different sub-object levels, see the topics in this section.

**Working with Mesh Sub-Objects**

This topic describes how to work with sub-object selections when you are editing an Editable Mesh on page 2192.

**See also:**
- Edit Modifiers and Editable Objects on page 1052
- Modifying at the Sub-Object Level on page 1054
- Modifier Stack Controls on page 8187
- Editable Mesh on page 8559
- Editable Poly on page 8559

**Selecting and Transforming**

In selecting and transforming sub-object geometry, you use standard techniques:

- Clicking any vertex, edge, or face/polygon/element selects it.
- Holding down Ctrl lets you add to or subtract from the selection with single clicks.
- Holding down Alt lets you a subtract from the selection with single clicks, or with Window/Crossing selections.
- Beginning a selection outside the object starts a region selection. Holding down Ctrl during region selection lets you add to the selection.
Once you’ve made a sub-object selection, you can use the Spacebar to lock the selection while you’re working with it.

**Using Sub-Object Selection**

With either an editable mesh (or Edit Mesh modifier) or a Mesh Select modifier, you can store three separate sub-object selections: one for each selection level (vertex, face, and edge). These selection sets are saved with the file. With sub-object selections, you have these options:

- Choose one of the selection sets to pass geometry up the stack to other modifiers. Only one selection set is active at a time.
- Change to one of the other selection sets at any time.
- Use named selection sets on page 217 for sub-object geometry you want to reuse.
  
  In modeling a character head, for example, you might have a number of different vertex selections for forehead, nose, and chin. Such selections can be difficult to re-create, so named sets give you easy access to the original selection when you want to rework a particular area.

**Cloning Sub-Object Geometry**

Using Shift+transform with a selection of vertices or faces displays the Clone Part Of Mesh dialog. This lets you determine whether you want to "Clone To Object" or "Clone To Element." Click the desired option, optionally giving the cloned object a new name, then click OK.

- If you choose Clone To Object, the cloned copy becomes a plain mesh object, entirely separate from the original object. The new object is given the name in the field to the right of the Clone To Object radio button.
- If you choose Clone To Element, the selection is cloned in its new position and remains part of the original object.

**Animating Sub-Object Geometry**

When you work with an editable mesh, you can directly transform and animate a sub-object selection. In effect, the selection works like any other object.
Selection Rollout (Editable Mesh)

The Selection rollout provides buttons for turning different sub-object levels on and off, working with named selections and handles, display settings, and information about selected entities.

When you first access the Modify panel with an editable mesh selected, you're at the Object level, with access to several functions available as described in Editable Mesh (Object) on page 2200. You can toggle the various sub-object levels, and access relevant functions by clicking the buttons at the top of the Selection rollout.

Clicking a button here is the same as selecting a sub-object type in the Modifier Stack display. Click the button again to turn it off and return to the Object selection level.

The Selection rollout also allows you to display and scale vertex or face normals on page 8654

Interface

<table>
<thead>
<tr>
<th>Selection</th>
</tr>
</thead>
<tbody>
<tr>
<td>✅ By Vertex</td>
</tr>
<tr>
<td>✅ Ignore Backfacing</td>
</tr>
<tr>
<td>✅ Ignore Visible Edges</td>
</tr>
<tr>
<td>Planar Threshold: 45.0</td>
</tr>
<tr>
<td>❌ Show Normals</td>
</tr>
<tr>
<td>Scale: 20.0</td>
</tr>
<tr>
<td>✅ Delete Isolated Vertices</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Hide</th>
<th>Unhide All</th>
</tr>
</thead>
</table>

| Named Selections: |
| --- | --- |
| Copy | Paste |

150 Faces Selected

Vertex: Turns on Vertex sub-object level, which lets you select a vertex beneath the cursor; region selection selects vertices within the region.
**Edge** Accesses the Edge sub-object level, which lets you select the edge of a face or polygon beneath the cursor; region selection selects multiple edges within the region. At the Edge sub-object level, selected hidden edges are displayed as dashed lines, allowing for more precise selection.

**Face** Accesses the Face sub-object level, which lets you select a triangular face beneath the cursor; region selection selects multiple triangular faces within the region. If a selected face has a hidden edge and Shade Selected Faces on page 8379 is off, the edge is displayed as a dashed line.

**Polygon** Accesses the Polygon sub-object level, which lets you select all coplanar faces (defined by the value in the Planar Threshold spinner) beneath the cursor. Usually, a polygon is the area you see within the visible wire edges. Region selection selects multiple polygons within the region.

**Element** Accesses the Element sub-object level, which lets you select all contiguous faces in an object. Region selection lets you select multiple elements.

**By Vertex** When on, and you click a vertex, any sub-objects (at the current level) that use that vertex are selected. Also works with Region Select.

**NOTE** When By Vertex is on, you can select sub-objects only by clicking a vertex, or by region.

**Ignore Backfacing** When on, selection of sub-objects selects only those sub-objects whose normals are visible in the viewport. When off (the default), selection includes all sub-objects, regardless of the direction of their normals.

**NOTE** The state of the Backface Cull setting in the Display panel does not affect sub-object selection. Thus, if Ignore Backfacing is off, you can still select sub-objects, even if you can't see them.

**Ignore Visible Edges** This is enabled when the Polygon face selection method is chosen. When Ignore Visible Edges is off (the default), and you click a face, the selection will not go beyond the visible edges no matter what the setting of the Planar Thresh spinner. When this is on, face selection ignores the visible edges, using the Planar Thresh setting as a guide.
Generally, if you want to select a “facet” (a coplanar collection of faces), you set the Planar Threshold to 1.0. On the other hand, if you’re trying to select a curved surface, increase the value depending on the amount of curvature.

■ **Planar Thresh**  (Planar Threshold) Specifies the threshold value that determines which faces are coplanar for Polygon face selection.

**Show Normals** When on, 3ds Max displays normals on page 8654 in the viewports. Normals are displayed as blue lines.
Show normals is not available in Edge mode.

■ **Scale**  Specifies the size of the normals displayed in the viewport when Show is on.

**Delete Isolated Vertices** When on, 3ds Max eliminates any isolated vertices when you delete a contiguous selection of sub-objects. When off, deleting a selection leaves all vertices intact. Not Available at the Vertex sub-object level. Default=on.
An isolated vertex is one that has no associated face geometry. For example, if Delete Isolated Vertices is off and you delete a rectangular selection of four polygons, all clustered about a single central point, the point remains, suspended in space.

**Hide** Hides any selected sub-objects. Edges cannot be hidden.

| Tip | The Select Invert command on the 3ds Max Edit menu is useful for selecting faces to hide. Select the faces you want to focus on, choose Edit > Select Invert, then click the Hide button. |

**Unhide All** Restores any hidden objects to visibility. Hidden vertices can be unhidden only when in Vertex sub-object level.

### Editable Mesh (Object)

Select an editable mesh object or object with the Edit Mesh modifier applied.
> Modify panel

Select an editable mesh object. > Quad menu > Tools 1 quadrant > Top-Level

Editable Mesh (Object) controls are available when no sub-object levels are active. These controls are also available at all sub-object levels, and work the same at each level, except as noted in **Edit Geometry Rollout (Mesh)** on page 2220.

---

2200 | Chapter 10  Surface Modeling
Interface

Edit Geometry rollout

See Edit Geometry Rollout (Mesh) on page 2220 for detailed descriptions of these controls.
Surface Properties rollout

Specifies surface approximation settings for subdividing the editable mesh. These controls work like the surface approximation settings for NURBS surfaces on page 2416. They are used when you apply a displacement map on page 6059 to the editable mesh.

**NOTE** The Surface Properties rollout is available only for editable mesh objects; it does not appear in the Modify panel for an object to which the Edit Mesh modifier is applied. With Edit Mesh-modified objects, you can use the Disp Approx modifier on page 1310 to the same effect.

**Subdivision Displacement** When on, faces are subdivided to accurately displace the mesh, using the method and settings you specify in the Subdivision Presets and Subdivision Method group boxes. When off, the mesh is displaced by moving existing vertices, the way the Displace modifier on page 1313 does. Default=off.

**Split Mesh** Affects the seams of displaced mesh objects; also affects texture mapping. When on, the mesh is split into individual faces before it is displaced;
this helps preserve texture mapping. When off, the mesh is not split and an internal method is used to assign texture mapping. Default=on.

**TIP** This parameter is required because of an architectural limitation in the way displacement mapping works. Turning Split Mesh on is usually the better technique, but it can cause problems for objects with clearly distinct faces, such as boxes, or even spheres. A box’s sides might separate as they displace outward, leaving gaps. And a sphere might split along its longitudinal edge (found in the rear for spheres created in the Top view) unless you turn off Split Mesh. However, texture mapping works unpredictably when Split Mesh is off, so you might need to add a Displace Mesh modifier on page 1068 and make a snapshot on page 950 of the mesh. You would then apply a UVW Map modifier on page 1932 and then reassign mapping coordinates to the displaced snapshot mesh.

**Subdivision Presets group & Subdivision Method group**

The controls in these two group boxes specify how the displacement map is applied when Subdivision Displacement is on. They are identical to the Surface Approximation controls on page 2737 used for NURBS surfaces.

**Editable Mesh (Vertex)**

Select an editable mesh object. > Modify panel > Selection rollout > Vertex

Select an editable mesh object. > Modify panel > Modifier Stack display > Expand Editable Mesh. > Vertex

Select an editable mesh object. > Quad menu > Tools 1 quadrant > Vertex

Vertices are points in space: they define the structure of faces. When vertices are moved or edited, the faces they form are affected as well. Vertices can also exist independently; such isolated vertices can be used to construct faces but are otherwise invisible when rendering.

At the Editable Mesh (Vertex) sub-object level, you can select single and multiple vertices and move them using standard methods.

**See also:**

- Editable Mesh Surface on page 2192
Procedures

To weld mesh vertices:

You can use either of two methods to combine several vertices into one, also known as welding. If the vertices are very close together, use the Weld function. You can also use Weld to combine a number of vertices to the average position of all of them.

Alternatively, to combine two vertices that are far apart, resulting in a single vertex that’s in the same position as one of them, use Target Weld.

TIP Welding vertices is considerably easier with poly objects. See this procedure: To weld polygon vertices: on page 1359

1  To use Weld:
   1  On the Selection rollout, turn on Ignore Backfacing, if necessary. This ensures that you’re welding only vertices you can see.
   2  Select the vertices to weld.
   3  If the vertices are very close together, go to the Edit Geometry rollout > Weld group and click Selected. If that doesn’t work (you get a “No vertices within weld threshold.” message), proceed to the next step.
   4  Increase the numeric value to the right of the Selected button. This is the threshold value; the minimum distance that vertices can be apart from each other to be welded.
   5  Click Selected again. At this point, one of three things happens: None, some, or all of the vertices are welded. If the latter, you’re done. If either of the others occurs, proceed to the next step.
   6  Continue increasing the threshold value and clicking Selected until all of the vertices are welded.

2  To use Target Weld:
   1  On the Selection rollout, turn on Ignore Backfacing, if necessary. This ensures that you’re welding only vertices you can see.
   2  Find two vertices you want to weld, and determine the ultimate location of the resulting vertex. You can weld any two vertices, but for best results the two should be contiguous; that is, they should be connected by a single edge.
For this example, we'll call the vertices A and B, and the resulting vertex will be at vertex B's location.

3 Click the Target button.
The button stays highlighted, to indicate that you're now in Target Weld mode.

4 Drag vertex A to Vertex B.
While you're dragging, the mouse cursor image is a four-headed, +-shaped arrow. When over an eligible target vertex, the cursor changes to a crosshairs.

**TIP** If you have trouble dragging in the proper direction, open the Axis Constraints toolbar on page 8039 and click the XY button.

5 Release the mouse button.
The pair is welded. The resulting vertex remains at vertex B's position, and you exit Target Weld mode.

**TIP** If you have trouble combining the two vertices, try increasing the Pixels value with the spinner to the right of the Target button.

You remain in Target Weld mode, and can continue to weld pairs of vertices.

6 Exit Target mode by right-clicking in the active viewport or clicking the Target button again.

**To select vertices by color:**

1 On the Surface Properties rollout, click the Existing Color swatch, and specify the color of vertex you want in the Color Selector.

2 Specify ranges in the RGB Range spinners. This lets you select vertices that are close to the specified color, but don't match exactly.

3 Click the Select button.
All vertices matching the color, or within the RGB range, are selected.
You can add to the selection by holding Ctrl as you click the Select button, and you can subtract from the selection by holding the Alt key.
**TIP** You can select all vertices of the same color by first selecting the vertex you want matched, dragging a copy of the Edit Color swatch to the Existing Color swatch, and then clicking the Select button. (If you want an exact match, be sure to set the RGB Range spinners to 0 first.)

**Interface**

**Selection rollout**

For information on the Selection rollout settings, see *Editable Mesh* on page 2195.

**Soft Selection rollout**

Soft Selection controls affect the action of sub-object Move, Rotate, and Scale functions. When these are on, 3ds Max applies a spline curve deformation to unselected vertices surrounding the transformed selected sub-object. This provides a magnet-like effect with a sphere of influence around the transformation.

For more information, see *Soft Selection Rollout* on page 2014.
Edit Geometry rollout

See Edit Geometry Rollout (Mesh) on page 2220 for detailed descriptions of these controls.
Surface Properties rollout

These controls let you set the weight and color for vertices.

**Weight** Displays and lets you change vertex weights for NURMS operations (see MeshSmooth Modifier on page 1505).

**Edit Vertex Colors group**

Use these controls to assign the color, illumination color (shading), and alpha (transparency) values of selected vertices.

- **Color** Click the color swatch to change the color of selected vertices.
- **Illumination** Click the color swatch to change the illumination color of selected vertices. This lets you change the illumination of a vertex without changing the vertex's color.
- **Alpha** Lets you assign an alpha (transparency) value to selected vertices. The spinner value is a percentage; zero is completely transparent and 100 is completely opaque.

**Select Vertices By group**

**Color/Illumination** These radio buttons let you choose to select vertices by vertex color value or vertex illumination value. Set the desired options and then click Select.
**Color Swatch** Displays the current color to match. Click to open the Color Selector, where you can specify a different color.

**Select** Depending on which radio button is selected, selects all vertices whose vertex color or illumination values either match the color swatch, or are within the range specified by the RGB spinners.

**Range** Specifies a range for the color match. All three RGB values in the vertex color or illumination color must either match the color specified by the Color swatch in Select By Vertex Color, or be within a range determined by adding and subtracting the Range values from the displayed color. Default=10.

For example, if you've chosen Color and set the color swatch to medium gray (R=G=B=128), and are using the default Range values of 10,10,10, then clicking the Select button selects only vertices set to RGB color values between 118,118,118 and 138,138,138.

---

**Editable Mesh (Edge)**

Select an editable mesh object. > Modify panel > Selection rollout > Edge

Select an editable mesh object. > Modify panel > Modifier Stack display > Editable Mesh rollout > Edge

Select an editable mesh object. > Quad menu > Tools 1 quadrant > Edge

An edge is a line, visible or invisible, forming the side of a face and connecting two vertices. Two faces can share a single edge.

At the Editable Mesh (Edge) sub-object level, you can select single and multiple edges and transform them using standard methods.

**See also:**

- [Editable Mesh Surface](#) on page 2192

**Procedures**

**To create a shape from one or more edges:**

1. Select the edges you want to make into shapes.
2. On the Edit Geometry rollout, click Create Shape From Edges.
3 Make changes, as needed, on the Create Shape dialog that appears.
   ■ Enter a curve name or keep the default.
   ■ Choose Smooth or Linear as the Shape Type.
   ■ Turn on Ignore Hidden Edges to exclude hidden edges from the calculation, or turn this feature off.

4 Click OK.
   The resulting shape consists of one or more splines whose vertices are coincident with the vertices in the selected edges. The Smooth option results in vertices using smooth values, while the Linear option results in linear splines with corner vertices.

   When you region-select edges, all edges are highlighted, including hidden edges, which are displayed as dashed lines. As a default, the Create Shape function ignores the hidden edges, even though they're selected. Turn off Ignore Hidden Edges if you want to include the hidden edges in the calculation.

   If the selected edges are not continuous, or if they branch, the resulting shape will consist of more than one spline. When the Create Shape function runs into a branching 'Y' in the edges, it makes an arbitrary decision as to which edge produces which spline. If you need to control this, select only those edges that will result in a single spline, and perform Create Shape repeatedly to make the correct number of shapes. Finally, use Attach in the Editable Spline to combine the shapes into one.
Top: Original object

Bottom: Object with edges selected
Top: Selected edges removed from original object

Bottom: Unwanted edges removed

**Interface**

**Selection rollout**

See *Editable Mesh* on page 2195 for information on the Selection rollout settings.
**Soft Selection rollout**

Soft Selection controls affect the action of sub-object Move, Rotate, and Scale functions. When these are on, 3ds Max applies a spline curve deformation to unselected vertices surrounding the transformed selected sub-object. This provides a magnet-like effect with a sphere of influence around the transformation.

For more information, see *Soft Selection Rollout* on page 2014.
**Edit Geometry rollout**

<table>
<thead>
<tr>
<th>Function</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create</td>
<td>Delete</td>
</tr>
<tr>
<td>Attach</td>
<td>Detach</td>
</tr>
<tr>
<td>Divide</td>
<td>Turn</td>
</tr>
<tr>
<td>Extrude</td>
<td>0.0</td>
</tr>
<tr>
<td>Chamfer</td>
<td>0.0</td>
</tr>
<tr>
<td>Normal</td>
<td>Group □ Local</td>
</tr>
<tr>
<td>Slice Plane</td>
<td>Slice</td>
</tr>
<tr>
<td>Cut</td>
<td>Split □</td>
</tr>
<tr>
<td>□ Refine Ends</td>
<td></td>
</tr>
<tr>
<td>Weld</td>
<td></td>
</tr>
<tr>
<td>Selected</td>
<td>0.1</td>
</tr>
<tr>
<td>Target</td>
<td>4 pixels</td>
</tr>
<tr>
<td>Tessellate</td>
<td>25.0</td>
</tr>
<tr>
<td>by □ Edge □ Face Center</td>
<td></td>
</tr>
<tr>
<td>Explode</td>
<td>24.0</td>
</tr>
<tr>
<td>to □ Objects □ Elements</td>
<td></td>
</tr>
<tr>
<td>Remove Isolated Vertices</td>
<td></td>
</tr>
<tr>
<td>Select Open Edges</td>
<td></td>
</tr>
<tr>
<td>Create Shape from Edges</td>
<td></td>
</tr>
<tr>
<td>View Align</td>
<td>Grid Align</td>
</tr>
<tr>
<td>Make Planar</td>
<td>Collapse</td>
</tr>
</tbody>
</table>

See *Edit Geometry Rollout (Mesh)* on page 2220 for detailed descriptions of these controls.
Surface Properties rollout

These controls affect the visibility of the edges. Invisible edges (also called construction lines) appear in the viewports when Edges Only is turned off in the Display command panel, or when you're editing at the Edge sub-object level. The visibility of edges is primarily of importance when an object is being rendered using a wireframe material.

Visible Makes selected edges visible.

Invisible Makes selected edges invisible, so they won't be displayed in Edges Only mode.

Auto Edge group

Auto Edge Automatically determines edge visibility based on the angle between the faces that share the edge, with the angle set by the Threshold spinner to its right.

Clicking Auto Edge can have one of three effects, depending on which radio button is active (Set means to make an invisible edge visible; Clear means to make a visible edge invisible):

- **Set and Clear Edge Vis** Can change the visibility of all selected edges depending on the Threshold setting.

- **Set** Makes previously invisible edges visible only if they exceed the Threshold setting; does not clear any edges.

- **Clear** Makes previously visible edges invisible only if they are less than the Threshold setting; does not make any edges visible.
Editable Mesh (Face/Polygon/Element)

Select an editable mesh object. > Modify panel > Selection rollout > Face/Polygon/Element

Select an editable mesh object. > Modify panel > Modifier Stack display > Editable Mesh rollout > Face/Polygon/Element

Select an editable mesh object. > Quad menu > Tools 1 quadrant > Face/Polygon/Element

A face is the smallest possible mesh object: a triangle formed by three vertices. Faces provide the renderable surface of an object. While a vertex can exist as an isolated point in space, a face cannot exist without vertices.

At the Editable Mesh (Face) level, you can select single and multiple faces and transform them using standard methods. This is also true for the Polygon and Element sub-object levels; for the distinctions between face, polygon, and element, see Editable Mesh > Selection rollout on page 2195.

See also:
- Editable Mesh Surface on page 2192

Interface

Selection rollout

For information on the Selection rollout settings, see Editable Mesh on page 2195.

Soft Selection rollout

Soft Selection controls affect the action of sub-object Move, Rotate, and Scale functions. When these are on, 3ds Max applies a spline curve deformation to unselected vertices surrounding the transformed selected sub-object. This provides a magnet-like effect with a sphere of influence around the transformation.

For more information, see Soft Selection Rollout on page 2014.
### Edit Geometry rollout

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create</td>
<td>Add new geometry elements</td>
</tr>
<tr>
<td>Delete</td>
<td>Remove selected geometry elements</td>
</tr>
<tr>
<td>Attach</td>
<td>Attach geometry elements to others</td>
</tr>
<tr>
<td>Detach</td>
<td>Detach geometry elements from others</td>
</tr>
<tr>
<td>Divide</td>
<td>Divide selected geometry elements</td>
</tr>
<tr>
<td>Turn</td>
<td>Rotate selected geometry elements</td>
</tr>
<tr>
<td>Extrude</td>
<td>Extrude geometry elements</td>
</tr>
<tr>
<td>Bevel</td>
<td>Bevel geometry elements</td>
</tr>
<tr>
<td>Normal</td>
<td>Set geometry elements to normal</td>
</tr>
<tr>
<td>Group</td>
<td>Group selected geometry elements</td>
</tr>
<tr>
<td>Local</td>
<td>Set geometry elements to local</td>
</tr>
<tr>
<td>Slice Plane</td>
<td>Slice selected geometry elements</td>
</tr>
<tr>
<td>Slice</td>
<td>Slice selected geometry elements</td>
</tr>
<tr>
<td>Cut</td>
<td>Cut selected geometry elements</td>
</tr>
<tr>
<td>Split</td>
<td>Split selected geometry elements</td>
</tr>
<tr>
<td>Refine Ends</td>
<td>Refine ends of selected geometry</td>
</tr>
<tr>
<td>Weld</td>
<td>Weld selected geometry elements</td>
</tr>
<tr>
<td>Selected</td>
<td>Selected weld tolerance</td>
</tr>
<tr>
<td>Target</td>
<td>Target weld tolerance</td>
</tr>
<tr>
<td>Tessellate</td>
<td>Tessellate selected geometry</td>
</tr>
<tr>
<td>by: Edge</td>
<td>Tessellate by edge</td>
</tr>
<tr>
<td>by: Face-Center</td>
<td>Tessellate by face-center</td>
</tr>
<tr>
<td>Explode</td>
<td>Explode selected geometry</td>
</tr>
<tr>
<td>to: Objects</td>
<td>Explode to objects</td>
</tr>
<tr>
<td>to: Elements</td>
<td>Explode to elements</td>
</tr>
<tr>
<td>Remove Isolated Vertices</td>
<td>Remove isolated vertices from selected geometry elements</td>
</tr>
<tr>
<td>Select Open Edges</td>
<td>Select open edges</td>
</tr>
<tr>
<td>Create Shape from Edges</td>
<td>Create shape from selected edges</td>
</tr>
<tr>
<td>View Align</td>
<td>View alignment options</td>
</tr>
<tr>
<td>Grid Align</td>
<td>Grid alignment options</td>
</tr>
<tr>
<td>Make Planar</td>
<td>Make selected geometry planar</td>
</tr>
<tr>
<td>Collapse</td>
<td>Collapse selected geometry elements</td>
</tr>
</tbody>
</table>

See [Edit Geometry Rollout (Mesh)](page2220) for detailed descriptions of these controls.
Surface Properties rollout

These controls let you work with face normals, material IDs, smoothing groups, and vertex colors.

Normals group

**Flip** Reverses the direction of the surface normals of the selected faces.

**Unify** Flips the normals of an object so that they all point in the same direction, usually outward. This is useful for restoring an object’s faces to their original orientations. Sometimes normals of objects that have come into 3ds Max as part of a DXF file are irregular, depending on the methods used to create the objects. Use this function to correct them.
**Flip Normal Mode** Flips the normal of any face you click. To exit, click this button again or right-click anywhere in 3ds Max interface.

**TIP** The best way to use Flip Normal mode is to set up your viewport to display with Smooth+Highlight and Edged Faces on. If you use Flip Normal mode with default settings, you’ll be able to flip a face away from you, but you won’t be able to flip it back. For best results, turn off Ignore Backfacing in the Selection rollout. This lets you click any face and flip the direction of its normal, regardless of its current direction.

**Material group**

**Set ID** Lets you assign a particular material ID to selected sub-objects for use with multi/sub-object materials and other applications. Use the spinner or enter the number from the keyboard. The total number of available IDs is 65,535.

**Select ID** Selects sub-objects corresponding to the Material ID specified in the adjacent ID field. Type or use the spinner to specify an ID, then click the Select ID button.

**[Select By Name]** This drop-down list shows the names of sub-materials if an object has a Multi/Sub-Object material assigned to it. Click the drop arrow and choose a sub-material from the list. The sub-objects that are assigned that material are selected. If an object does not have a Multi/Sub-Object material assigned, the name list is unavailable. Likewise, if multiple objects are selected that have an Edit Patch, Edit Spline, or Edit Mesh modifier applied, the name list is inactive.

**NOTE** Sub-material names are those specified in the Name column on the material's Multi/Sub-Object Basic Parameters rollout; these are not created by default, and must be specified separately from any material names.

**Clear Selection** When on, choosing a new ID or material name deselects any previously selected sub-objects. When off, selections are cumulative, so new ID or sub-material name selections add to the existing selection set of patches or elements. Default=on.

**Smoothing Groups group**

Use these controls to assign selected faces to different smoothing groups, and to select faces by smoothing group.

To assign faces to one or more smoothing groups, select the faces, and then click the number(s) of the smoothing group(s) to assign them to.
Select by SG (Smoothing Group) Displays a dialog that shows the current smoothing groups. Select a group by clicking the corresponding numbered button and clicking OK. If Clear Selection is on, any previously selected faces are first deselected. If Clear Selection is off, the new selection is added to any previous selection set.

Clear All Removes any smoothing group assignments from selected faces.

Auto Smooth Sets the smoothing groups based on the angle between faces. Any two adjacent faces will be put in the same smoothing group if the angle between their normals is less than the threshold angle, set by the spinner to the right of this button.

Threshold This spinner (to the right of Auto Smooth) lets you specify the maximum angle between the normals of adjacent faces that determines whether those faces will be put in the same smoothing group.

Edit Vertex Colors group

Use these controls to assign the color, illumination color (shading), and alpha (transparency) values of vertices on the selected face(s).

Color Click the color swatch to change the color of vertices on the selected face(s). Assigning vertex colors at the face level prevents blending across the face(s).

Illumination Click the color swatch to change the illumination color of vertices on the selected face(s). This lets you change the illumination without changing the vertex’s color.

Alpha Lets you assign an alpha (transparency) value to vertices on the selected face(s). The spinner value is a percentage; zero is completely transparent and 100 is completely opaque.

Edit Geometry Rollout (Mesh)

Select an editable mesh object. > Modify panel > Selection rollout > Choose any sub-object level.

Select an editable mesh object. > Modify panel > Modifier Stack display > Expand Editable Mesh. > Choose any sub-object level.

Select an editable mesh object. > Quad menu > Tools 1 quadrant > Choose any sub-object level.
The Edit Geometry rollout for Meshes contains most of the controls that let you alter the geometry of the mesh, at either the Object (top) level, or one of the sub-object levels. The controls that the rollout displays can vary, depending on which level is active; if a control is not available for the active level, it might be grayed out, or simply might not appear at all. The descriptions below indicate the levels at which controls are available.

### Interface

<table>
<thead>
<tr>
<th>-</th>
<th>Edit Geometry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create</td>
<td>Delete</td>
</tr>
<tr>
<td>Attach</td>
<td>Attach List</td>
</tr>
<tr>
<td>Break</td>
<td>Turn</td>
</tr>
<tr>
<td>Extrude</td>
<td>0.0</td>
</tr>
<tr>
<td>Bevel</td>
<td>0.0</td>
</tr>
<tr>
<td>Normal:</td>
<td>Group</td>
</tr>
<tr>
<td>Slice Plane</td>
<td>Slice</td>
</tr>
<tr>
<td>Out</td>
<td>Spit</td>
</tr>
<tr>
<td>Refine Ends</td>
<td></td>
</tr>
<tr>
<td>Weld</td>
<td></td>
</tr>
<tr>
<td>Selected</td>
<td>0.1</td>
</tr>
<tr>
<td>Target</td>
<td>4 pixels</td>
</tr>
<tr>
<td>Tessellate</td>
<td>25.0</td>
</tr>
<tr>
<td>by: Edge</td>
<td>Face Center</td>
</tr>
<tr>
<td>Explode</td>
<td>24.0</td>
</tr>
<tr>
<td>to: Objects</td>
<td>Elements</td>
</tr>
<tr>
<td>Remove Isolated Vertices</td>
<td></td>
</tr>
<tr>
<td>Select Open Edges</td>
<td></td>
</tr>
<tr>
<td>Create Shape from Edges</td>
<td></td>
</tr>
<tr>
<td>View Align</td>
<td>Grid Align</td>
</tr>
<tr>
<td>Make Planar</td>
<td>Collapse</td>
</tr>
</tbody>
</table>
**Editing buttons**

Create  Lets you add sub-objects to a single selected mesh object. Select an object, choose a sub-object level, click Create, and then click to add sub-objects. Available only at the Vertex, Face, Polygon, and Element levels only.

For example, at the Vertex sub-object level, Create lets you add free-floating vertices to the object. The new vertices are placed on the active construction plane.

To create faces at the Face, Polygon, or Element level, click Create. All vertices in the object are highlighted, including isolated vertices left after deleting faces. Click three existing vertices in succession to define the shape of the new face. (The cursor changes to a cross when it is over a vertex that can legally be part of the face.)

You can also create new faces at the Polygon and Element sub-object levels. At the Face and Element sub-object levels, a new face is created after every third click. At the Polygon sub-object level, you can continue clicking as many times as you like to add vertices to the new polygon. To finish drawing a new polygon, click twice, or click again on any existing vertex in the current polygon.

At the Face, Polygon, and Element levels, you can add vertices while Create is on by Shift+clicking in an empty space; these vertices are incorporated into the face or polygon you’re creating.

You can start creating faces or polygons in any viewport, but all subsequent clicks must take place in the same viewport.

---

**TIP** For best results, click vertices in counterclockwise (preferred) or clockwise order. If you use clockwise order, the new polygon will be facing away from you, and you won’t be able to see it unless you’ve turned on Force 2-Sided or are using a two-sided material.

---

Delete (sub-object levels only) Deletes selected sub-objects and any faces attached to them.

Attach  Lets you attach another object in the scene to the selected mesh. You can attach any type of object, including splines, patch objects, and NURBS surfaces. Attaching a non-mesh object converts it to a mesh. Click the object you want to attach to the currently selected mesh object.

When you attach an object, the materials of the two objects are combined in the following way:

- If the object being attached does not have a material assigned, it inherits the material of the object it is being attached to.
Handle inherits material from the cup it is being attached to.

- Likewise, if the object you're attaching to doesn't have a material, it inherits the material of the object being attached.

- If both objects have materials, the resulting new material is a multi/sub-object material on page 6120 that encompasses the input materials. A dialog appears offering three methods of combining the objects' materials and material IDs. For more information, see Attach Options Dialog on page 2233.
Attach remains active in all sub-object levels, but always applies to objects.

**Attach List (Object level only)** Lets you attach other objects in the scene to the selected mesh. Click to open the Attach List dialog, which works like Select From Scene on page 206 to let you choose multiple objects to attach.

**Detach (Vertex and Face/Polygon/Element levels only)** Detaches the selected sub-object as a separate object or element. All faces attached to the sub-object are detached as well.
A dialog appears, prompting you to enter a name for the new object. The dialog has a Detach As Clone option that copies the faces rather than moving them.

Detached faces leave a hole in the original object when you move them to a new position.

**Break (Vertex level only)** Creates a new vertex for each face attached to selected vertices, allowing the face corners to be moved away from each other where they were once joined at the original vertex. If a vertex is isolated or used by only one face, it is unaffected.

**Turn (Edge level only)** Rotates the edge within its bounding. All mesh objects in 3ds Max are composed of triangular faces, but by default, most polygons are depicted as quadrilaterals, with a hidden edge dividing each quad into two triangles. Turn lets you change the direction in which the hidden edge (or any other) runs, thus affecting how the shape changes when you transform sub-objects directly, or indirectly with a modifier.

**Divide (Face/Polygon/Element levels only)** Subdivides faces into three smaller faces. This function applies to faces even if you’re at the Polygon or Element sub-object level. Click Divide, and then select a face to be divided. Each face is subdivided where you click it. You can click as many faces as you want divided, in sequence. To stop dividing, click Divide again to turn it off, or right-click.

**Extrude, Chamfer, and Bevel group**

The Extrude controls let you extrude edges or faces. Edge extrusion works in a fashion similar to face extrusion. You can apply extrusion interactively (by dragging on sub-objects) or numerically (using spinners).
Extrude (Edge and Face/Polygon/Element levels only) Click this button and then either drag to extrude the selected edges or faces, or adjust the Extrude spinner to perform the extrusion. You can select different sub-objects to extrude while Extrude is active.

- **Extrude Amount** This spinner (to the right of the Extrude button) lets you specify the amount to extrude the edge. Select one or more edges, and then adjust the spinner.
The Chamfer controls are available only at the Vertex and Edge sub-object levels. They let you bevel object corners using a chamfer function. You can apply this effect interactively (by dragging vertices) or numerically (using the Chamfer spinner).

**Chamfer (Vertex and Edge levels only)**  Click this button, and then drag vertices or edges in the active object. The Chamfer Amount spinner updates to indicate the chamfer amount as you drag.

If you drag one or more selected vertices or edges, all selected sub-objects are chamfered identically. If you drag an unselected vertex or edge, any selected sub-objects are first deselected.

A chamfer "chops off" the selected sub-objects, creating a new face connecting new points on all visible edges leading to the original sub-object. Chamfer Amount specifies the exact distance from the original vertex along each of these edges. New chamfer faces are created with the material ID of one of the neighboring faces (picked at random) and a smoothing group that is an intersection of all neighboring smoothing groups.

For example, if you chamfer one corner of a box, the single corner vertex is replaced by three vertices moving along the three visible edges that lead to the corner. 3ds Max rearranges and splits the adjacent faces to use these three new vertices, and creates a new triangle at the corner.

- **Chamfer Amount**  Adjust this spinner (to the right of the Chamfer button) to apply a chamfer effect to selected vertices.

- **Normal (Edge and Face/Polygon/Element levels only)**  Determines how a selection of more than one edge is extruded. With Normal set to Group (the default), extrusion takes place along the averaged normal of each continuous group (line) of edges. If you extrude multiples of such groups, each group moves along its own averaged normal. If you set Normal to Local, extrusion takes place along each selected edge’s normal.

Beveling, available only at the Face/Polygon/Element levels, is a second step to extrusion: it lets you scale the faces you have just extruded.
TIP  A similar operation is Inset on page 1401, which Editable Poly has but Editable Mesh doesn’t. When you inset a polygon, you create another, smaller polygon of the same proportions inside the borders of an original polygon, in the plane of the original. Essentially, it’s a bevel with no height. You can achieve this in Editable Mesh with the following procedure:

1  Select the polygon to inset.

2  Right-click the spinner all the way to the right of the Extrude button. This performs an extrusion with no height, thus creating a new polygon plus connecting polygons in the same position as the original.

3  Set a negative Bevel value using the numeric field or the spinner. This insets the new polygon created by the extrusion without changing its height.
Extruded face beveled in two different directions

You can bevel faces by dragging or by using keyboard/spinner entry.

**Bevel (Face/Polygon/Element levels only)** Click this button, and then drag vertically on any face to extrude it. Release the mouse button and move the mouse vertically to bevel the extrusion. Click to finish.

- When over a selected face, the mouse cursor changes to a Bevel cursor.
With multiple faces selected, dragging on any one bevels all selected faces equally.

You can drag other faces in turn to bevel them while the Bevel button is active. Click Bevel again or right-click to end the operation.

**Outlining** This spinner (to the right of the Bevel button) lets you scale selected faces bigger or smaller, depending on whether the value is positive or negative. It is normally used after an extrusion for beveling the extruded faces.

**Cut and Slice group**

Lets you subdivide edges with either cut or slice tools to create new vertices, edges, and faces. For details, see Cut and Slice (Editable Mesh) on page 2235.

**NOTE** At the Vertex sub-object level, Slice is available but Cut is not.

**Weld group (Vertex level only)**

**Selected** Welds selected vertices that fall within the tolerance specified in the Weld Threshold spinner (to the button's right). All line segments become connected to the resulting single vertex.

**Target** Enters weld mode, which allows you to select vertices and move them around. While moving, the cursor changes to the Move cursor as usual, but when you position the cursor over an unselected vertex the cursor changes to a + cursor. Release the mouse at that point to weld all selected vertices to the target vertex they were dropped on.

The pixels spinner to the right of the Target button sets the maximum distance in screen pixels between the mouse cursor and the target vertex.

**Tessellate group (Face/Polygon/Element levels only)**

Use these controls to tessellate (subdivide) selected faces. Tessellation is useful for increasing local mesh density while modeling. You can subdivide any selection of faces. Two tessellation methods are available: Edge and Face-Center.

**Tessellate** Click to tessellate selected faces, based on the Edge, Face-Center, and Tension (spinner) settings.
Top: Original selection
Middle: Tessellated once
Bottom: Tessellated twice

**Tension** (Active only when Tessellate by Edge is active.) This spinner, to the right of the Tessellate button, lets you increase or decrease the Edge tension value. A negative value pulls vertices inward from their plane, resulting in a concave effect. A positive value pulls vertices outward from their plane, resulting in a rounding effect.

**By Edge/Face-Center** Edge inserts vertices in the middle of each edge and draws three lines connecting those vertices. As a result, four faces are created out of one face. (To see this at the Polygon or Element sub-object level, turn off Display panel > Display Properties rollout > Edges Only.)

Face-Center adds a vertex to the center of each face and draws three connecting lines from that vertex to the three original vertices. As a result, three faces are created out of one face.

Set of polygons showing Face-Center tessellation
Explode group (Object and Face/Polygon/Element levels only)

**Explode** Breaks up the current object into multiple elements or objects based on the angles of its edges. This function is available in Object mode as well as all sub-object levels except Vertex and Edge.

Exploded faces (white) removed from tessellated faces

The angle threshold spinner, to the right of the Explode button, lets you specify the angle between faces below which separation will not occur. For example, all sides of a box are at 90-degree angles to each other. If you set the spinner to 90 or above, exploding the box changes nothing. However, at any setting below 90, the sides all become separate objects or elements.

**To Objects/Elements** Specifies whether the exploded faces become the separate objects or elements of the current object.

---

**Remove Isolated Vertices** Deletes all isolated vertices in the object regardless of the current selection.
Select Open Edges (Edge level only) Selects all edges with only one face. In most objects, this shows you where missing faces exist.

Create Shape from Edges (Edge level only) After selecting one or more edges, click this button to create a spline shape from the selected edges. A Create Shape dialog appears, letting you name the shape, set it to Smooth or Linear, and ignore hidden edges. The new shape's pivot is placed at the center of the mesh object.

View Align Aligns all vertices in selected objects or sub-objects to the plane of the active viewport. If a sub-object level is active, this function affects only selected vertices or those belonging to selected sub-objects.

In the case of orthographic viewports on page 8668, using View Align has the same effect as aligning to the construction grid when the home grid is active. When aligning to a perspective viewport (including camera and light views), the vertices are reoriented to be aligned to a plane that is parallel to the camera's viewing plane. This plane is perpendicular to the view direction that is closest to the vertices’ average position.

Grid Align Aligns all vertices in selected objects or sub-objects to the plane of the current view. If a sub-object level is active, function aligns only selected sub-objects.

This function aligns the selected vertices to the current construction plane. The current plane is specified by the active viewport in the case of the home grid. When using a grid object, the current plane is the active grid object.

Make Planar (sub-object levels only) Forces all selected sub-objects to become coplanar. The plane's normal is the average surface normal of all faces attached to the selected sub-objects.

Collapse (sub-object levels only) Collapses selected sub-objects into an averaged vertex.

Attach Options Dialog (Editable Mesh)

Select an editable mesh object. > Modify panel > Attach button

The Attach Options dialog appears when you attach two or more objects to which materials have been assigned. It provides three different methods of combining the sub-materials and the material IDs in the two objects.
**Interface**

**Match Material IDs to Material** The number of material IDs in the attached objects are modified so they are no greater than the number of sub-materials assigned to those objects. For example, if you have a box with only two sub-materials assigned to it, and you attach it to another object, the box will have only two material IDs, instead of the six it was assigned on creation.

**Match Material to Material IDs** Maintains the original ID assignment in the attached objects by adjusting the number of sub-materials in the resulting multi/sub-object material. For example, if you attach two boxes, both assigned single materials, but with their default assignment of 6 material IDs, the result would be a multi/sub-object material with 12 sub-materials (six containing instances of one box's material, and six containing instances of the other box's material). Use this option when it's important to maintain the original material ID assignments in your geometry.

**NOTE** If you want to make the instanced sub-materials unique, select them in Track View, and click the Make Unique button on the Track View toolbar. You can also make them unique one at a time with the Make Unique button on page 5692 in the Material Editor.

**Do Not Modify Mat IDs or Material** Does not adjust the number of sub-materials in the resulting sub-object material. Note that, if the number of material IDs in an object is greater than the number of sub-materials in its multi/sub-object material, then the resulting face-material assignment might be different after the attach.

**Condense Material IDs** Affects the Match Material IDs To Material option. When this is on, duplicate sub-materials or sub-materials that aren't used in the objects are removed from the multi/sub-object material that results from the attach operation. Default=on.
Tips

- In most cases, use the first option (Match Material IDs to Material) while keeping Condense Material IDs selected. This maintains the appearance of the objects, and results in the fewest additional sub-materials or IDs.

- Use the second option (Match Material to Material IDs) when you need to maintain the original material ID assignments.

- Avoid using the third option, unless you need to repeat a 3ds Max version 1 attachment for compatibility with a previous project.

- Leave Condense Material IDs selected unless you have an unassigned sub-material that you want to keep for future assignment.

- Perform Edit menu > Hold before performing the attach.

Cut and Slice (Editable Mesh)

Select an editable mesh object. > Modify panel > Selection rollout > (Optional: Choose a sub-object level.) > Edit Geometry rollout > Cut and Slice group box

The tools available in the Cut and Slice group let you subdivide edges and faces to create new vertices, edges, and faces. You can slice an editable mesh object at any sub-object level; the Cut tool is available at every sub-object level except the Vertex sub-object level.

Procedures

To create a new face using Cut:

1. Convert the geometry to an editable mesh.

2. On the Modify panel, choose the object’s Edge (or Face, Polygon, or Element) sub-object level.

3. On the Selection rollout, turn on Ignore Backfacing.

4. On the Edit Geometry rollout, in the Cut and Slice group, click the Cut button.

5. Click the first edge you want to subdivide, and then move your cursor toward the second edge. The cursor changes to a plus sign when over an
edge, and a dotted line connects the initial point where the edge was clicked with the current cursor location.

6 Click the second edge. This edge can be anywhere, cutting across as many faces as you like. A new visible edge appears.

7 At this point, a new dotted line is connected to the mouse cursor, originating from the last point you clicked.

8 Continue clicking edges to cut. To start from a different point, right-click, and then select the new start point. To finish cutting, right-click twice. You can use Snaps on page 2807 with Cut. To divide an edge in half, set Snaps to midpoint. To start or end a cut at a vertex, set snap to vertex or endpoint.
To create multiple slices:

1. Select an editable mesh.

2. On the Modify panel, choose the object’s Edge (or Face, Polygon, or Element) sub-object level.

3. Select one or more sub-objects. Slice affects only selected sub-objects.

4. In the Cut And Slice group box, click the Slice Plane button.

5. Position and rotate the Slice Plane gizmo to where you want the first slice.

6. Click the Slice button. The object is sliced.

7. If you want, move the Slice Plane to a second position and click the Slice button again.
Click the Slice Plane button again to turn it off and see the results.

To better understand what has happened, turn off Edges Only in the Display panel.
Interface

NOTE The keyboard shortcuts listed here require that the Keyboard Shortcut Override Toggle on page 8420 be on.

Cut and Slice group

Slice Plane Creates a gizmo for a slice plane that can be positioned and rotated where you want to slice the edges. Also enables the Slice button.

Slice Performs the slice operation at the location of the slice plane. The Slice button is available only when the Slice Plane button is highlighted. This tool slices the mesh just like the Slice modifier on page 1727 in “Operate On: Face” mode.

NOTE Slice works only on a sub-object selection. Make the selection before activating Slice Plane.

Cut Lets you divide a edge at any point, then divide a second edge at any point, creating a new edge or edges between the two points. Clicking the first edge sets the first vertex. A dotted line tracks the cursor movement until you click a second edge. A new vertex is created at each edge division. Alternately, double-clicking an edge simply divides that edge at the point clicked, with invisible edges on either side.

You can use Cut to cut across any number of faces, even across an entire object. Click one edge to start the cut, and a second edge to end the cut. Use Snaps on page 2807 with Cut for precision. Cut supports Midpoint, Endpoint, and Vertex snaps.

You can also use the keyboard shortcut Alt+C to toggle Cut mode.

IMPORTANT When using the Cut tool to add new edges, you should work in a non-Perspective viewport, such as Front or User. If you use Cut while working in a Perspective viewport, you may find that the created edges appear to jump or aren't placed correctly. Using an orthographic viewport will allow the cuts to appear where you click.
**TIP** When performing a Cut, turn on Selection rollout > Ignore Backfacing to avoid accidentally selecting edges on the back side of the mesh.

**Split** When on, the Slice and Cut operations create double sets of vertices at the points where the edges are divided. This lets you easily delete the new faces to create holes, or animate the new faces as separate elements.

**Refine Ends** When on, adjacent faces at the ends of the cut are also divided by additional vertices, so that the surface stays contiguous. When Refine Ends is off, the surface will have a seam where the new vertex meets the adjacent face. For this reason, it's a good idea to keep Refine Ends turned on, unless you are sure that you don't want the extra vertices created.

Refine Ends affects only Cut. It does not affect Slice.

---

**Editable Poly Surface**

Create or select an object. > Quad menu > Transform quadrant > Convert to Editable Poly

Create or select an object. > Modify panel > Right-click the base object in the stack. > Choose Convert to: Editable Poly.

*Editable Poly* on page 8559 is an editable object with five sub-object levels: vertex, edge, border, polygon, and element. Its usage is similar to that of an *editable mesh object* on page 2192, with controls for manipulating an object as a polygon mesh at various sub-object levels. Rather than triangular faces, however, the poly object's faces are polygons with any number of vertices.

Editable Poly gives you these options:

- Transform or Shift+Clone the selection, as with any object.
- Use the options supplied on the Edit rollouts to modify the selection or object. Later topics discuss these options for each of the polymesh components.
- Pass a sub-object selection to a modifier higher in the stack. You can apply one or more standard modifiers to the selection.
- Use the options on the Subdivision Surface Rollout (Polymesh) in the *editable polysubdivision surface rollout* on page 2325 to alter surface characteristics.
You can exit most Editable Poly command modes, such as Extrude, by right-clicking in the active viewport.

**Overriding Actions with Press/Release Keyboard Shortcuts**

While working with poly objects, you can use a “press/release keyboard shortcut” to temporarily override the current operation and perform a different one. As soon as you release the keyboard shortcut, you return to the previous operation.

For example, you might be working at the Polygon sub-object level, moving polygons, and need to rotate the object to access a different part of it. Instead of having to exit the Polygon sub-object level, rotate the object and then re-enter the sub-object level, you could simply press and hold 6, rotate the object, release the key, and immediately return to moving polygons.

To see a list of press/release keyboard shortcuts, go to Customize > Customize User Interface > Keyboard panel, open the Group drop-down list, and choose Edit Poly or Editable Poly. The actions in boldface are the ones that you can assign as press/release shortcuts. Not all are assigned; for information about assigning keyboard shortcuts, see Keyboard Panel on page 8250.

The actions in boldface can function as press/release shortcuts.

**Editable Poly Workflow**

Sub-object-specific functions, such as Remove on page 1378 for edges, appear on their own rollouts in the Editable Poly user interface. This leaves the Edit...
Geometry rollout on page 1409 with functions that you can apply at most sub-object levels, as well as at the object level.

Also, many commands are accompanied by a Settings button, which gives you a second way to use the command:

- In Direct Manipulation mode, activated by clicking the command button, you apply the command by manipulating sub-objects directly in the viewport. An example of this is Extrude: You click the Extrude button, and then click and drag sub-objects in the viewports to extrude them.

  **NOTE** Some buttons, such as Tessellate, operate on the mesh immediately, with no viewport manipulation required.

- Interactive Manipulation mode is well suited to experimentation. You activate this mode by clicking the command's Settings button. This opens a non-modal settings dialog and places you in preview mode, where you can set parameters and see the results immediately in the viewport on the current sub-object selection. You can then accept the results by clicking OK, or reject them by clicking Cancel. You can also use this mode to apply the same or different settings to several different sub-object selections in a row. Make the selection, optionally change the settings, click Apply, and then repeat with a different selection.

  **IMPORTANT** When you click Apply, the settings are "baked into" the selection, and then applied again to the selection as a preview. If you then click OK to exit, you will have applied the settings twice. If your intention is to apply them only once, simply click OK the first time, or click Apply, and then Cancel.

  **NOTE** Changes implemented in Interactive Manipulation mode with editable poly objects cannot be animated. However, they can with Edit Poly objects.

See also:

- Edit Poly Modifier on page 1332
- Graphite Modeling Tools on page 2025
- Poly Select Modifier on page 1582
- Turn To Poly Modifier on page 1830
Procedures

To produce an editable poly object:

First select an object, and then do one of the following:

- If no modifiers are applied to the object, In the Modify panel, right-click in the modifier stack display and choose Editable Poly from the Convert To list on the pop-up menu.

- Right-click the object and choose Convert To Editable Poly from the Transform quadrant of the quad menu.

- Apply a modifier to a parametric object that turns the object into a poly object in the stack display, and then collapse the stack. For example, you can apply a Turn To Poly modifier on page 1830. To collapse the stack, use the Collapse utility on page 2022 and set Output Type to Modifier Stack Result, or right-click the object's modifier stack and then choose Collapse All.

Converting an object to Editable Poly format removes all parametric controls, including the creation parameters. For example, you can no longer increase the number of segments in a box, slice a circular primitive, or change the number of sides on a cylinder. Any modifiers you apply to an object are merged into the mesh as well. After conversion, the only entry left on the stack is "Editable Poly."

To maintain an object's creation parameters:

- As noted in the previous procedure, if you convert an existing object to editable poly format, 3ds Max replaces the creation parameters in the stack with "Editable Poly." The creation parameters are no longer accessible or animatable. If you want to maintain the creation parameters, you can use the Edit Poly modifier on page 1332 or the Turn To Poly modifier on page 1830.

Interface

Stack Display

For more information on the Stack Display, see Modifier Stack on page 8187.

Show End Result Normally, if you apply a modifier such as Symmetry on page 1803 to an editable poly object and then return to the Editable Poly stack entry, you cannot see the effect of the modifier on the object's geometry. But
if you turn on Show End Result while in sub-object level, you can see the final object as a white mesh, the original sub-object selection as a yellow mesh, and the original editable polymesh as an orange mesh.

**Selection rollout**

Lets you access the different sub-object levels. See Selection Rollout (Polymesh)selection rollouteditable polyeditable polyselection rolloutsub-objectselectionrolloutsselection on page 2245.

**Soft Selection rollout**

Soft Selection controls apply a smooth falloff between selected sub-objects and unselected ones. When Use Soft Selection is on, unselected sub-objects near your selection are given partial selection values. These values are shown in the viewports by means of a color gradient on the vertices, and optionally on the faces. They affect most types of sub-object deformations, such as the Move, Rotate, and Scale functions and any deformation modifiers (such as Bend) applied to the object. This provides a magnet-like effect with a sphere of influence around the selection.

For more information, see Soft Selection Rollout on page 2014.

**Edit (sub-object) rollout**

The Edit (sub-object) rollout provides sub-object-specific functions for editing an editable poly object and its sub-objects. For specific information, click any of the links below:

- Edit Vertices rollout on page 2261
- Edit Edges rollout on page 2278
- Edit Borders rollout on page 2290
- Edit Polygons/Elements rollout on page 1396

**Edit Geometry rollout**

The Edit Geometry Rollout (Polymesh and Edit Poly) on page 1409 provides global functions for editing an editable poly object and its sub-objects.

**Subdivision Surface rollout**

Controls on this rollout apply subdivision to the polymesh in the style of the MeshSmooth modifier. See Subdivision Surface Rollout (Polymesh)subdivision

---

2244 | Chapter 10  Surface Modeling
Surface rollout

The surface rollout is used to control the overall appearance of the polymesh. It includes controls for surface smoothness, lighting, and other visual effects.

Subdivision Displacement rollout

Specifies surface approximation for subdividing the polymesh. See Subdivision Displacement Rollout (Polymesh) on page 2330.

Subdivision Presets group & Subdivision Method group

The controls in these two group boxes specify how 3ds Max applies the displacement map when Subdivision Displacement is on. They are identical to the Surface Approximation controls on page 2737 used for NURBS surfaces.

Paint Deformation rollout

Paint Deformation lets you stroke elevated and indented areas directly onto object surfaces. For more information, see Paint Deformation Rollout (Polymesh) on page 2333.

Selection Rollout (Polymesh)

Create or select an editable poly object. > Modify panel > Selection rollout

The Selection rollout provides tools for accessing different sub-object levels and display settings and for creating and modifying selections, and displays information about selected entities.

When you first access the Modify panel with an editable poly selected, you're at the Object level, with access to several functions available as described in Editable Poly (Object) on page 2256. You can toggle the various sub-object levels, and access relevant functions, by clicking the buttons at the top of the Selection rollout.

Clicking a button here is the same as choosing a sub-object type in the modifier stack display. Click the button again to turn it off and return to the Object selection level.
NOTE You can convert sub-object selections in three different ways with the use of the Ctrl and Shift keys:

■ To convert the current selection to a different sub-object level, clicking a sub-object button on the Selection rollout with Ctrl held down. This selects all sub-objects at the new level that touch the previous selection. For example, if you select a vertex, and then Ctrl+click the Polygon button, all polygons that use that vertex are selected.

■ To convert the selection to only sub-objects all of whose source components are originally selected, hold down both Ctrl and Shift as you change the level. For example, if you convert a vertex selection to a polygon selection with Ctrl+Shift+click, the resultant selection includes only those polygons all of whose vertices were originally selected.

■ To convert the selection to only sub-objects that border the selection, hold down Shift as you change the level. The selection conversion is inclusive, meaning:

■ When you convert faces, the resulting selection of edges or vertices all belong to selected faces that bordered unselected faces. Only the edges or vertices that bordered unselected faces are selected.

■ When you convert vertices to faces, the resulting selection of faces had all of their vertices selected and bordered unselected faces. When you convert vertices to edges, the resulting selection contains only edges all of whose vertices were previously selected and only edges of faces that did not have all vertices selected; that is, of faces around the border of the vertex selection.
When you convert edges to faces, the resulting selection of faces had some but not all of their edges selected, and were next to faces with no edges selected. When you convert edges to vertices, the resulting vertices are on previously selected edges, but only at intersections where not all edges were selected.

Conversion commands are also available from the quad menu.
### Interface

<table>
<thead>
<tr>
<th>Selection</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>By Vertex</td>
<td></td>
</tr>
<tr>
<td>Ignore Backfaces</td>
<td></td>
</tr>
<tr>
<td>By Angle</td>
<td>12.0</td>
</tr>
<tr>
<td>Shrink</td>
<td>Grow</td>
</tr>
<tr>
<td>Find</td>
<td>Loop</td>
</tr>
<tr>
<td>Preview Selection</td>
<td>Off</td>
</tr>
<tr>
<td>Whole Object Selected</td>
<td></td>
</tr>
</tbody>
</table>

- **Vertex** Accesses the Vertex sub-object level, which lets you select a vertex beneath the cursor; region selection selects vertices within the region.

- **Edge** Accesses the Edge sub-object level, which lets you select a polygon edge beneath the cursor; region selection selects multiple edges within the region.

- **Border** Accesses the Border sub-object level, which lets you select a sequence of edges that borders a hole in the mesh. A border comprises only connected edges with faces on only one side of them, and is always a complete loop. For example, a default box primitive doesn't have a border, but the teapot object has a couple of them: one each on the lid, the body, and the spout, and two on the handle. If you create a cylinder and delete one end, the row of edges around that end forms a border.

  When Border sub-object level is active, you can't select edges that aren't on borders. Clicking a single edge on a border selects that whole border.

  You can cap a border, either with the Cap function on page 1392 or by applying the Cap Holes modifier on page 1185. You can also connect borders between objects with the Connect compound object on page 695.

**NOTE**

The Edge and Border sub-object levels are compatible, so if you go from one to the other, any existing selection is retained.
Polygon

Accesses the Polygon sub-object level, which lets you select polygons beneath the cursor. Region selection selects multiple polygons within the region.

Element

Accesses the Element sub-object level, which lets you select all contiguous polygons in an object. Region selection lets you select multiple elements.

NOTE

The Polygon and Element sub-object levels are compatible, so if you go from one to the other, any existing selection is retained.

By Vertex

When on, you can select sub-objects only by selecting a vertex that they use. When you click a vertex, all sub-objects that use the selected vertex are selected.

Not available at the Vertex sub-object level.

Ignore Backfacing

When on, selection of sub-objects affects only those facing you. When off (the default), you can select any sub-object(s) under the mouse cursor, regardless of their visibility or facing. If there are more than one sub-object under the cursor, repeated clicking cycles through them. Likewise, with Ignore Backfacing off, region selection includes all sub-objects, regardless of the direction they face.

NOTE  The state of the Backface Cull on page 166 setting on the Display panel does not affect sub-object selection. Thus, if Ignore Backfacing is off, you can still select sub-objects even if you can’t see them.

By Angle

When on, selecting a polygon also selects neighboring polygons based on the angle setting to the right of the check box. This value determines the maximum angle between neighboring polygons to select. Available only at the Polygon sub-object level.

For example, if you click a side of a box and the angle value is less than 90.0, only that side is selected, because all sides are at 90-degree angles to each other. But if the angle value is 90.0 or greater, all sides of the box are selected. This function speeds up selection of contiguous areas made up of polygons that are at similar angles to one another. You can select coplanar polygons with a single click at any angle value.
**Shrink** Reduces the sub-object selection area by deselecting the outermost sub-objects. If the selection size can no longer be reduced, the remaining sub-objects are deselected.

**Grow** Expands the selection area outward in all available directions. For this function, a border is considered to be an edge selection.

With Shrink and Grow, you can add or remove neighboring elements from the edges of your current selection. This works at any sub-object level.

**Ring** Expands an edge selection by selecting all edges parallel to the selected edges. Ring applies only to edge and border selections.
Ring selection adds to the selection all the edges that are parallel to the ones selected originally.

**TIP** After making a ring selection, you can use Connect on page 1383 to subdivide the associated polygons into new edge loops.

**[Ring Shift]** The spinner next to the Ring button lets you move the selection in either direction to other edges in the same ring; that is, to neighboring, parallel edges. If you have a loop selected, you can use this function to select a neighboring loop. Applies only to Edge and Border sub-object levels.
Left: Original loop selection

Upper right: Ring Shift up moves selection outward (from center of model).

Lower right: Ring Shift down moves selection inward (toward center of model).

To expand the selection in the chosen direction, Ctrl+click the up or down spinner button. To shrink the selection in the chosen direction, Alt+click the up or down spinner button.

**Loop** Expands the selection as far as possible, in alignment with selected edges.

Loop applies only to edge and border selections, and propagates only through four-way junctions.
Loop selection extends your current edge selection by adding all the edges aligned to the ones selected originally.

**[Loop Shift]** The spinner next to the Loop button lets you move the selection in either direction to other edges in the same loop; that is, to neighboring, aligned edges. If you have a ring selected, you can use this function to select a neighboring ring. Applies only to Edge and Border sub-object levels.
Left: Original ring selection

Upper right: Loop Shift up moves selection outward.

Lower right: Loop Shift down moves selection inward.

To expand the selection in the chosen direction, Ctrl+click the up or down spinner button. To shrink the selection in the chosen direction, Alt+click the up or down spinner button.

**Preview Selection**
This option lets you preview a sub-object selection before committing to it. You can preview at the current sub-object level, or switch sub-object levels automatically based on the mouse position. The choices are:

- **Off**  No preview is available.
- **SubObj**  Enables previewing at the current sub-object level only. As you move the mouse over the object, the sub-object under the cursor highlights in yellow. To select the highlighted object, click the mouse. To select multiple sub-objects at the current level, press and hold Ctrl, move the mouse to highlight more sub-objects, and then click to select all highlighted sub-objects.

![Polygon sub-object selection preview with Ctrl held down](image)

To deselect multiple sub-objects at the current level, press and hold Ctrl+Alt, move the mouse to highlight more sub-objects, and then click a selected sub-object. This deselects all highlighted sub-objects.

- **Multi**  Works like SubObj, but also switches among the Vertex, Edge, and Polygon sub-object levels on the fly, based on the mouse position. For example, if you position the mouse over an edge, the edge highlights, and then clicking activates the Edge sub-object level and selects the edge. To select multiple sub-objects of the same type, press and hold Ctrl after highlighting a sub-object, move the mouse to highlight more sub-objects,
and then click to activate that sub-object level and select all highlighted sub-objects.

To deselect multiple sub-objects at the current sub-object level, press and hold Ctrl+Alt, move the mouse to highlight more sub-objects, and then click a selected sub-object. This deselects all highlighted sub-objects. Note that this method does not switch sub-object levels.

**NOTE** When Ignore Backfacing on page 1350 is off, you’ll see backfacing vertices and edges highlight while previewing a sub-object selection.

**Selection Information**

At the bottom of the Selection rollout is a text display giving information about the current selection. If 0 or more than one sub-object is selected, the text gives the number and type selected; for example, “4 Polygons Selected.” If one sub-object is selected, the text gives the identification number and type of the selected item; for example, “Polygon 73 Selected.”

When using Preview Selection on page 1356, a second line gives additional information about the identity or number of highlighted sub-objects.

**Editable Poly (Object)**

Select an editable poly object. > Modify panel

Select an editable poly object. > Quad menu > Tools 1 quadrant > Top-level

Editable Poly (Object) functions are available when no sub-object levels are active. These functions are also available at all sub-object levels, and work the same in each mode, except as noted below.

Use the Selection rollout on page 2248 or modifier stack on page 8187 to access the different sub-object levels.
Interface

Edit Geometry rollout

For detailed descriptions of these controls, see Edit Geometry Rollout (Polymesh and Edit Poly) on page 1409.

Subdivision Surface rollout

For information about the Subdivision Surface rollout settings, see Subdivision Surface Rollout (Polymesh) on page 2325.
Subdivision Displacement rollout

For information about the Subdivision Displacement rollout settings, see Subdivision Displacement Rollout (Polymesh) subdivision displacement rollout editable poly editable polys subdivision displacement rollout on page 2330.

Paint Deformation rollout

Paint Deformation lets you stroke elevated and indented areas directly onto object surfaces. For more information, see Paint Deformation Rollout (Polymesh) editable polypaint deformation rollout edit polypaint deformation rollout spaint deformation paint deformation rollout on page 2333.

Editable Poly (Vertex)

Select an editable poly object. > Modify panel > Selection rollout > Vertex

Select an editable poly object. > Modify panel > Modifier Stack display > Expand Editable Poly. > Vertex

Select an editable poly object. > Quad menu > Tools 1 quadrant > Vertex

Vertices are points in space: They define the structure of other sub-objects (edges and polygons) that make up the poly object. When you move or edit vertices, the connected geometry is affected as well. Vertices can also exist independently; such isolated vertices can be used to construct other geometry but are otherwise invisible when rendering.

At the editable poly Vertex sub-object level, you can select single and multiple vertices and move them using standard methods. This topic covers the Edit Vertices and Vertex Properties rollouts and provides links to the rest.

Procedures

To weld polygon vertices:

You can use either of two methods to combine several vertices into one, also known as welding. If the vertices are very close together, use the Weld function. You can also use Weld to combine a number of vertices to the average position of all of them.
Alternatively, to combine two vertices that are far apart, resulting in a single vertex that’s in the same position as one of them, use Target Weld.

1 To use Weld:
   1 On the Selection rollout, turn on Ignore Backfacing, if necessary. This ensures that you're welding only vertices you can see.
   2 Select the vertices to weld.
   3 If the vertices are very close together, simply click Weld. If that doesn't work, proceed to the next step.

4 Click the Settings button to the right of the Weld button. This opens the Weld Vertices dialog on page 2359.

5 Increase the Weld Threshold value gradually using the spinner (click and hold on the up-down arrow buttons to the right of the numeric field and then drag upward). If you need the value to change more quickly, hold down the Ctrl key as you drag.
When the threshold equals or exceeds the distance between two or more of the vertices, the weld occurs automatically, and the resulting vertex moves to their average location.

6 If not all the vertices are welded, continue increasing the Weld Threshold value until they are.

7 Click OK to exit.

2 To use Target Weld:
   1 On the Selection rollout, turn on Ignore Backfacing, if necessary. This ensures that you're welding only vertices you can see.
   2 Find two vertices you want to weld, and determine the ultimate location of the resulting vertex. The two vertices must be contiguous; that is, they must be connected by a single edge.
For this example, we'll call the vertices A and B, and the resulting vertex will be at vertex B's location.
   3 Click the Target Weld button. The button stays highlighted, to indicate that you're now in Target Weld mode.
   4 Click vertex A and then move the mouse.
   A rubber-band line connects the vertex and the mouse cursor.
Position the cursor over vertex B, whereupon the cursor image changes from an arrow to a crosshairs. Reminder: Only vertices connected to the first vertex by a single edge qualify for target welding.

Click to weld the two.
The resulting vertex remains at vertex B's position.

Click Target Weld again to turn it off.

To select vertices by color:

1 In the Vertex Properties rollout > Select Vertices By group, click the color swatch, and specify the color of vertex you want in the Color Selector on page 371.

2 Specify ranges in the RGB Range spinners. This lets you select vertices that are close to the specified color, but don't match exactly.

3 Click the Select button.
All vertices matching the color, or within the RGB range, are selected.
You can add to the selection by holding Ctrl as you click the Select button, and subtract from the selection by holding the Alt key.

**TIP** You can select all vertices of the same color by first selecting the vertex you want matched, dragging a copy of the Edit Color swatch to the Existing Color swatch, and then clicking the Select button. (If you want an exact match, be sure to set the RGB Range spinners to 0 first.)

**Interface**

**Selection rollout**

See *Editable Poly* on page 2248 for information on the Selection rollout settings.

**Soft Selection rollout**

Soft Selection controls apply a smooth falloff between selected sub-objects and unselected ones. When Use Soft Selection is on, unselected sub-objects near your selection are given partial selection values. These values are shown in the viewports by means of a color gradient on the vertices, and optionally on the faces. They affect most types of sub-object deformations, such as the
Move, Rotate, and Scale functions, as well as any deformation modifiers (such as Bend) applied to the object. This provides a magnet-like effect with a sphere of influence around the selection.

For more information, see Soft Selection Rollout on page 2014.

**Edit Vertices rollout**

This rollout includes commands specific to vertex editing.

**NOTE** To delete vertices, select them and press the Delete key. This can create one or more holes in the mesh. To delete vertices without creating holes, use Remove (see following).

**Remove** Deletes selected vertices and combines the polygons that use them. The keyboard shortcut is Backspace.
Removing one or more vertices deletes them and retriangulates the mesh to keep the surface intact. If you use Delete instead, the polygons depending on those vertices are deleted as well, creating a hole in the mesh.

**WARNING** Use of Remove can result in mesh shape changes and non-planar polygons.

**Break** Creates a new vertex for each polygon attached to selected vertices, allowing the polygon corners to be moved away from each other where they were once joined at each original vertex. If a vertex is isolated or used by only one polygon, it is unaffected.

**Extrude** Lets you extrude vertices manually via direct manipulation in the viewport. Click this button, and then drag vertically on any vertex to extrude it.

Extruding a vertex moves it along a normal and creates new polygons that form the sides of the extrusion, connecting the vertex to the object. The extrusion has the same number of sides as the number of polygons that originally used the extruded vertex.

Following are important aspects of vertex extrusion:

- When over a selected vertex, the mouse cursor changes to an Extrude cursor.
- Drag vertically to specify the extent of the extrusion, and horizontally to set the size of the base.
- With multiple vertices selected, dragging on any one extrudes all selected vertices equally.

- You can drag other vertices in turn to extrude them while the Extrude button is active. Click Extrude again or right-click in the active viewport to end the operation.

Chamfer box showing extruded vertex

- **Extrude Settings** Opens the Extrude Vertices dialog on page 2350, which lets you perform extrusion via interactive manipulation. If you click this button after performing a manual extrusion, the same extrusion is performed on the current selection as a preview and the dialog opens with Extrusion Height set to the amount of the last manual extrusion.

- **Weld** Combines contiguous, selected vertices that fall within the tolerance specified in Weld dialog on page 2359. All edges become connected to the resulting single vertex.
Using Weld at the Vertex level

Vertices farther apart than the Threshold distance are not welded.

Weld is best suited to automatically simplifying geometry that has areas with a number of vertices that are very close together. Before using Weld, set the Weld Threshold via the Weld dialog on page 2359. To weld vertices that are relatively far apart, use Target Weld on page 1366 instead.

**Weld Settings** Opens the Weld dialog on page 2359, which lets you specify the weld threshold.

**Chamfer** Click this button and then drag vertices in the active object. To chamfer vertices numerically, click the Chamfer Settings button and use the Chamfer Amount value.

If you chamfer multiple selected vertices, all of them are chamfered identically. If you drag an unselected vertex, any selected vertices are first deselected.

Each chamfered vertex is effectively replaced by a new face that connects new points on all edges leading to the original vertex. These new points are exactly \(<\text{chamfer amount}\)> distance from the original vertex along each of these edges. New chamfer faces are created with the material ID of one of the neighboring faces (picked at random) and a smoothing group which is an intersection of all neighboring smoothing groups.

For example, if you chamfer one corner of a box, the single corner vertex is replaced by a triangular face whose vertices move along the three edges that led to the corner. Outside faces are rearranged and split to use these three new vertices, and a new triangle is created at the corner.

Alternatively, you can create open space around the chamfered vertices; for details, see Chamfer Vertices dialog on page 2344.
Top: The original vertex selection
Center: Vertices chamfered
Bottom: Vertices chamfered with Open on

Chamfer Settings Opens the Chamfer Vertices dialog on page 2344, which lets you chamfer vertices via interactive manipulation and toggle the Open option.

If you click this button after performing a manual chamfer, the same chamfer is performed on the current selection as a preview and the dialog opens with Chamfer Amount set to the amount of the last manual extrusion.

Target Weld Allows you to select a vertex and weld it to a neighboring target vertex. Target Weld works only with pairs of contiguous vertices; that is, vertices connected by a single edge.

In Target Weld mode, the mouse cursor, when positioned over a vertex, changes to a + cursor. Click and then move the mouse; a dashed, rubber-band
line connects the vertex to the mouse cursor. Position the cursor over another, neighboring vertex and when the + cursor appears again, click the mouse. The first vertex moves to the position of the second and the two are welded. Target Weld remains active until you click the button again or right-click in the viewport.

**Connect** Creates new edges between pairs of selected vertices.

Connect does not let the new edges cross. Thus, for example, if you select all four vertices of a four-sided polygon and then click Connect, only two of the vertices will be connected. In this case, to connect all four vertices with new edges, use **Cut** on page 1417.

**Remove Isolated Vertices** Deletes all vertices that don't belong to any polygons.

**Remove Unused Map Verts** Certain modeling operations can leave unused (isolated) map vertices that show up in the Unwrap UVW editor on page 1856, but cannot be used for mapping. You can use this button to automatically delete these map vertices.

**Weight** Sets the weight of selected vertices. Used by the **NURMS subdivision option** on page 2326 and by the **MeshSmooth modifier** on page 1505. Increasing a vertex weight tends to pull the smoothed result toward the vertex.
### Edit Geometry rollout

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Repeat Last</td>
<td></td>
</tr>
<tr>
<td>Constraints:</td>
<td>None</td>
</tr>
<tr>
<td>Preserve UVs</td>
<td></td>
</tr>
<tr>
<td>Create</td>
<td></td>
</tr>
<tr>
<td>Collapse</td>
<td></td>
</tr>
<tr>
<td>Attach</td>
<td>Detach</td>
</tr>
<tr>
<td>Slice Plane</td>
<td>Split</td>
</tr>
<tr>
<td>Slice</td>
<td>Reset Plane</td>
</tr>
<tr>
<td>QuickSlice</td>
<td>Cut</td>
</tr>
<tr>
<td>MSmooth</td>
<td></td>
</tr>
<tr>
<td>Tessellate</td>
<td></td>
</tr>
<tr>
<td>Make Planar</td>
<td>X, Y, Z</td>
</tr>
<tr>
<td>View Align</td>
<td>Grid Align</td>
</tr>
<tr>
<td>Relax</td>
<td></td>
</tr>
<tr>
<td>Hide Selected</td>
<td>Unhide All</td>
</tr>
<tr>
<td>Hide Unselected</td>
<td></td>
</tr>
<tr>
<td>Named Selections:</td>
<td></td>
</tr>
<tr>
<td>Copy</td>
<td>Paste</td>
</tr>
<tr>
<td>Delete Isolated Vertices</td>
<td></td>
</tr>
<tr>
<td>Full Interactivity</td>
<td></td>
</tr>
</tbody>
</table>

For detailed descriptions of these controls, see Edit Geometry Rollout (Polymesh and Edit Poly) [edit geometry rollout] on page 1409.
Vertex Properties rollout

Edit Vertex Colors group

Use these controls to assign the color, and illumination color (shading) of selected vertices.

**Color** Click the color swatch to change the color of selected vertices.

**Illumination** Click the color swatch to change the illumination color of selected vertices. This lets you change the illumination without changing the vertex's color.

**Alpha** Lets you set specific alpha values of selected vertices. These alpha values are maintained by the pipeline and can be used in conjunction with vertex color to provide full RGBA data for export.

Select Vertices By group

**Color/Illumination** Determines whether to select vertices by vertex color values or vertex illumination values.

**Color Swatch** Displays the Color Selector on page 371, where you can specify a color to match.

**Select** Depending on which radio button is chosen, selects all vertices whose vertex color or illumination values either match the color swatch, or are within the range specified by the RGB spinners.

**Range** Specifies a range for the color match. All three RGB values in the vertex color or illumination must either match the color specified by the color swatch.
in Select By Vertex Color, or be within plus or minus the values in the Range spinners. Default=10.

**Subdivision Surface rollout**

For information about the Subdivision Surface rollout settings, see Subdivision Surface Rollout (Polymesh) subdivsion surface rollout editable poly on page 2325.

**Subdivision Displacement rollout**

For information about the Subdivision Displacement rollout settings, see Subdivision Displacement Rollout (Polymesh) subdivsion displacement rollout editable poly on page 2330.

**Paint Deformation rollout**

Paint Deformation lets you stroke elevated and indented areas directly onto object surfaces. For more information, see Paint Deformation Rollout (Polymesh) paint deformation rollout editable poly on page 2333.

---

**Editable Poly (Edge)**

Select an editable poly object. > Modify panel > Selection rollout > Edge

Select an editable poly object. > Modify panel > Modifier Stack display > Expand Editable Poly. > Edge

Select an editable poly object. > Quad menu > Tools 1 quadrant > Edge

An edge is a line connecting two vertices that forms the side of a polygon. An edge can’t be shared by more than two polygons. Also, the normals of the two polygons should be adjacent. If they aren’t, you wind up with two edges that share vertices.

At the editable poly Edge sub-object level, you can select single and multiple edges and transform them using standard methods. This topic covers the Edit Geometry and Edit Edges rollouts; for other controls, see Editable Poly on page 2240.
NOTE Besides edges, each polygon has one or more internal diagonals that determine how the polygon is triangulated by 3ds Max. Diagonals can't be manipulated directly, but you can use the Turn on page 1387 and Edit Triangulation on page 1386 functions to change their positions.

Procedures

Example: To use the Cut and Turn features:

3ds Max provides a convenient function for turning edges, which, along with the Cut feature, streamlines the custom modeling process considerably. Specifically, cutting a new polygon into existing geometry minimizes the number of extra visible edges, typically adding none or one. And after using cut, the Turn function lets you adjust any diagonal with a single click.

1. In the Perspective viewport, add a Plane object. This object is available from the Create panel > Standard Primitives > Object Type rollout. By default, the Plane object is divided into 4 x 4 polygons. If you don't see the polygons in the Perspective viewport, press F4 to activate Edged Faces view mode.

2. Convert the Plane object to Editable Poly format. If you're not sure how, continue in this step; otherwise, skip to the next step after converting. To convert the object, right-click once in the Perspective viewport to exit create mode. This leaves the object selected. Right-click again in the Perspective viewport, and then at the bottom of the Transform quadrant,
choose Convert To > Convert To Editable Poly. Alternatively, apply the Edit Poly modifier.

The object is now an editable poly and the command panel switches to the Modify panel.

3 Cut is available at the object level as well as at every sub-object level. On the Edit Geometry rollout, find the Cut button, and then click it.

4 In the Perspective viewport, position the mouse cursor in the center of a corner polygon, such as the one closest to you, click once, and then move the mouse around the viewport.
Two or three lines appear and move as you move the mouse. One line connects the mouse cursor to the original click location, and indicates where the next cut will appear when you click the mouse button. Another connects to a corner of the polygon; this connection changes depending on the mouse position. And, if the cursor isn't over an edge or a vertex (it changes appearance if it is, depending on which), a third line connects the mouse cursor to another vertex.

This demonstrates one aspect of the new Cut functionality; in previous versions, the first click in a Cut operation connected to two corners of the polygon.

Continue cutting in a rectangular pattern, clicking once at the center of a different polygon, finish by clicking once more at the starting point, and then right-click to exit Cut mode.
The result is a rectangle across four polygons, without any connecting visible edges. In previous versions, you would have had eight connecting visible edges: two in each of the original polygons. Note that all the edges you created are selected, and ready for further transformation or editing.

6 Cut a rectangle into the center of a single polygon.
In this case you end up with a single, additional visible edge instead of seven, as in previous versions. The edge connects corner of the new polygon with a corner of the original one. This new edge is not selected, but the ones you created explicitly are.
Connecting the remaining corners are a number of diagonals on page 8551, which serve to fully triangulate the polygons. The new Turn function lets you manipulate each of these with a single click.

7 Go to the Edge sub-object level, and then, on the Edit Edges rollout, click Turn.
All diagonals, including those created from the Cut operations, appear as dashed lines.
Click a diagonal to turn it, and then click it again to return it to its original status.

In Turn mode, click a diagonal (dashed line) once to turn it.

Each diagonal has only two different available positions, given no changes in any other diagonals’ or edges’ positions.

Compare this with the Edit Triangulation tool, with which you must click two vertices to change a diagonal’s position.

This simple demonstration shows how, when manually subdividing a polygon mesh for modeling and animation purposes, you can save a good deal of time by using the Cut and Turn tools in 3ds Max.

To create a shape from one or more edges:

1. Select the edges you want to make into shapes.
2. On the Edit Edges rollout, click Create Shape From Selection.
3. Make changes, as needed, on the Create Shape dialog that appears.
   - Enter a curve name or keep the default.
   - Choose Smooth or Linear as the shape type.
4. Click OK.

The resulting shape consists of one or more splines whose vertices are coincident with the vertices in the selected edges. The Smooth option results in vertices using smooth values, while the Linear option results in linear splines with corner vertices.

If the selected edges are not continuous, or if they branch, the resulting shape will consist of more than one spline. When the Create Shape function runs into a branching 'Y' in the edges, it makes an arbitrary decision as to which edge produces which spline. If you need to control
this, select only those edges that will result in a single spline, and perform a Create Shape operation repeatedly to make the correct number of shapes. Finally, use Attach on page 655 in the Editable Spline to combine the shapes into one.

Above: Original object

Below: Object with edges selected
Above: Selected edges removed from original object

Below: Unwanted edges removed

Interface

Selection rollout

See Editable Poly on page 2248 for information on the Select rollout settings.
**Soft Selection rollout**

Soft Selection controls apply a smooth falloff between selected sub-objects and unselected ones. When Use Soft Selection is on, unselected sub-objects near your selection are given partial selection values. These values are shown in the viewports by means of a color gradient on the vertices, and optionally on the faces. They affect most types of sub-object deformations, such as the Move, Rotate, and Scale functions, as well as any deformation modifiers (such as Bend) applied to the object. This provides a magnet-like effect with a sphere of influence around the selection.

For more information, see Soft Selection Rollout on page 2014.

**Edit Edges rollout**

This rollout includes commands specific to edge editing.

**NOTE** To delete edges, select them and press the Delete key. This deletes all selected edges and attached polygons, which can create one or more holes in the mesh. To delete edges without creating holes, use Remove on page 1378.

**Insert Vertex** Lets you subdivide visible edges manually.

After turning on Insert Vertex, click an edge to add a vertex at that location. You can continue subdividing polygons as long as the command is active.

To stop inserting edges, right-click in the viewport, or click Insert Vertex again to turn it off.
**Remove** Deletes selected edges and combines the polygons that use them.

Removing one edge is like making it invisible. The mesh is affected only when all or all but one of the edges depending on one vertex are removed. At that point, the vertex itself is deleted and the surface is retriangulated.

To delete the associated vertices when you remove edges, press and hold Ctrl while executing a Remove operation, either by mouse or with the Backspace key. This option, called Clean Remove, ensures that the remaining polygons are planar.

Left: The original edge selection  
Center: Standard Remove operation leaves extra vertices.  
Right: Clean Remove with Ctrl+Remove deletes the extra vertices.
Edges with the same polygon on both sides usually can’t be removed.

**WARNING** Use of Remove can result in mesh shape changes and non-planar polygons.

**Split** Divides the mesh along the selected edges. This does nothing when applied to a single edge in the middle of a mesh. The vertices at the end of affected edges must be separable in order for this option to work. For example, it would work on a single edge that intersects an existing border, since the border vertex can be split in two. Additionally, two adjacent edges could be split in the middle of a grid or sphere, since the shared vertex can be split.

**Extrude** Lets you extrude edges manually via direct manipulation in the viewport. Click this button, and then drag vertically on any edge to extrude it.

![Extrusion Diagram]

When extruding a vertex or edge interactively in the viewport, you set the extrusion height by moving the mouse vertically and the base width by moving the mouse horizontally.

Extruding an edge moves it along a normal and creates new polygons that form the sides of the extrusion, connecting the edge to the object. The extrusion has either three or four sides; three if the edge was on a border, or four if it was shared by two polygons. As you increase the length of the extrusion, the base increases in size, to the extent of the vertices adjacent to the extruded edge’s endpoints.

Following are important aspects of edge extrusion:

- When over a selected edge, the mouse cursor changes to an Extrude cursor.
- Drag vertically to specify the extent of the extrusion, and horizontally to set the size of the base.
With multiple edges selected, dragging on any one extrudes all selected edges equally.

You can drag other edges in turn to extrude them while the Extrude button is active. Click Extrude again or right-click in the active viewport to end the operation.

Chamfer box showing extruded edge

Extrude Settings  Opens the Extrude Edges dialog on page 2350, which lets you perform extrusion via interactive manipulation.

If you click this button after performing a manual extrusion, the same extrusion is performed on the current selection as a preview and the dialog opens with Extrusion Height set to the amount of the last manual extrusion.

Weld Combines selected edges that fall within the threshold specified in Weld dialog on page 2359.

You can weld only edges that have one polygon attached; that is, edges on a border. Also, you cannot perform a weld operation that would result in illegal geometry (e.g., an edge shared by more than two polygons). For example, you cannot weld opposite edges on the border of a box that has a side removed.

Weld Settings  Opens the Weld dialog on page 2359, which lets you specify the weld threshold.
**Chamfer** Click this button and then drag edges in the active object. To chamfer edges numerically, click the Chamfer Settings button and change the Chamfer Amount value.

If you chamfer multiple selected edges, all of them are chamfered identically. If you drag an unselected edge, any selected edges are first deselected.

An edge chamfer “chops off” the selected edges, creating a new polygon connecting new points on all visible edges leading to the original vertex. The new edges are exactly <chamfer amount> distance from the original edge along each of these edges. New chamfer faces are created with the material ID of one of the neighboring faces (picked at random) and a smoothing group which is an intersection of all neighboring smoothing groups.

For example, if you chamfer one edge of a box, each corner vertex is replaced by two vertices moving along the visible edges that lead to the corner. Outside faces are rearranged and split to use these new vertices, and a new polygon is created at the corner.

![Using Chamfer at the Edge level](image)

Alternatively, you can create open space around the chamfered edges; for details, see Chamfer Edges dialog on page 2344.

**Chamfer Settings** Opens the Chamfer Edges dialog on page 2344, which lets you chamfer edges via interactive manipulation and toggle the Open option.

If you click this button after performing a manual chamfer, the same chamfer is performed on the current selection as a preview and the dialog opens with Chamfer Amount set to the amount of the last manual chamfer.
**Target Weld** Allows you to select an edge and weld it to a target edge. When positioned over an edge, the cursor changes to a + cursor. Click and move the mouse and a dashed line appears from the vertex with an arrow cursor at the other end of the line. Position the cursor over another edge and when the + cursor appears again, click the mouse. The first edge is moved to the position of the second, and the two are welded.

You can weld only edges that have one polygon attached; that is, edges on a border. Also, you cannot perform a weld operation that would result in illegal geometry (e.g., an edge shared by more than two polygons). For example, you cannot weld opposite edges on the border of a box that has a side removed.

**Bridge** Connects border edges on an object with a polygon “bridge.” Bridge connects only border edges; that is, edges that have a polygon on only one side. This tool is particularly useful when creating edge loops or profiles.

There are two ways to use Bridge in Direct Manipulation mode (that is, without opening the Bridge Edges settings dialog):

- Select two or more border edges on the object, and then click Bridge. This immediately creates the bridge between the pair of selected borders using the current Bridge settings, and then deactivates the Bridge button.

- If no qualifying selection exists (that is, two or more selected border edges), clicking Bridge activates the button and places you in Bridge mode. First click a border edge and then move the mouse; a rubber-band line connects the mouse cursor to the clicked edge. Click a second edge on a different border to bridge the two. This creates the bridge immediately using the current Bridge settings; the Bridge button remains active for connecting more edges. To exit Bridge mode, right-click the active viewport or click the Bridge button.

The new polygons that result from a Bridge operation are automatically selected; you can see this by accessing the Polygon sub-object level.
Using Bridge at the Edge level

**NOTE** Bridge always creates a straight-line connection between edges. To make the bridge connection follow a contour, apply modeling tools as appropriate after creating the bridge. For example, bridge two edges, and then use **Bend** on page 1165.

**Bridge Settings** Opens the Bridge Edges dialog on page 2341, which lets you add polygons between pairs of edges via interactive manipulation.

**Connect** Creates new edges between pairs of selected edges using the current Connect Edges dialog settings. Connect is particularly useful for creating or refining edge loops.

**NOTE** You can connect only edges on the same polygon. Also, Connect will not let the new edges cross. For example, if you select all four edges of a four-sided polygon and then click Connect, only neighboring edges are connected, resulting in a diamond pattern.
Connecting two or more edges using the Settings dialog creates equally spaced edges. The number of edges is set in the dialog. When you click the Connect button, the current dialog settings are applied to the selection.

Connect Settings Opens the Connect Edges dialog on page 2345, which lets you preview the Connect results, specify the number of edge segments created by the operation, and set spacing and placement for the new edges.

Create Shape From Selection After selecting one or more edges, click this button to create a spline shape from the selected edges. A Create Shape dialog appears, letting you name the shape and set it to Smooth or Linear. The new shape’s pivot is placed at the center of the poly object.
An edge selection (top); a smooth shape (center); a linear shape (bottom)

**Weight** Sets the weight of selected edges. Used by the NURMS subdivision option on page 2326 and by the MeshSmooth modifier on page 1505. Increasing an edge weight tends to push the smoothed result away.

**Crease** Specifies how much creasing is performed on the selected edge or edges. Used by the NURMS subdivision option on page 2326 and by the MeshSmooth modifier on page 1505.
At low settings, the edge is relatively smooth. At higher settings, the crease becomes increasingly visible. At 1.0, the highest setting, the edge becomes a hard crease.

**Edit Tri[angulation]** Lets you modify how polygons are subdivided into triangles by drawing internal edges, or diagonals on page 8551.

In **Edit Triangulation** mode, you can see the current triangulation in the viewport, and change it by clicking two vertices on the same polygon.

To edit triangulation manually, turn on this button. The hidden edges appear. Click a polygon vertex. A rubber-band line appears, attached to the cursor. Click a non-adjacent vertex to create a new triangulation for the polygon.

**TIP** For easier editing of triangulation, use the Turn command instead (see following).

**Turn** Lets you modify how polygons are subdivided into triangles by clicking diagonals. When you activate Turn, the diagonals on page 8551 become visible as dashed lines in wireframe and edged-faces views. In Turn mode, click a diagonal to change its position. To exit Turn mode, right-click in the viewport or click the Turn button again.

Each diagonal has only two available positions at any given time, so clicking a diagonal twice in succession simply returns it to its original position. But changing the position of a nearby diagonal can make a different alternate position available to a diagonal.
For more information on how to use Turn with the enhanced Cut tool, see this procedure on page 1368.

**Edit Geometry rollout**

- **Repeat Last**
- **Constraints:** None
- **Preserve UVs**
- **Create**
- **Collapse**
- **Attach**
- **Detach**
- **Slice Plane**
  - **Split**
  - **Slice**
  - **Reset Plane**
- **QuickSlice**
  - **Cut**
- **MSmooth**
- **Tessellate**
- **Make Planar**
  - X
  - Y
  - Z
- **View Align**
  - **Grid Align**
- **Relax**
- **Hide Selected**
- **Unhide All**
- **Hide Unselected**
- **Named Selections:**
  - **Copy**
  - **Paste**
  - **Delete Isolated Vertices**
  - **Full Interactivity**

For detailed descriptions of these controls, see *Edit Geometry Rollout (Polymesh and Edit Poly)* on page 1409.

**Subdivision Surface rollout**

For information about the Subdivision Surface rollout settings, see *Subdivision Surface Rollout (Polymesh)* on page 2325.
Subdivision Displacement rollout

For information about the Subdivision Displacement rollout settings, see Subdivision Displacement Rollout (Polymesh) on page 2330.

Paint Deformation rollout

Paint Deformation lets you stroke elevated and indented areas directly onto object surfaces. For more information, see Paint Deformation Rollout (Polymesh) on page 2333.

Editable Poly (Border)

Select an editable poly object. > Modify panel > Selection rollout > Border

Select an editable poly object. > Modify panel > Modifier Stack display > Expand Editable Poly. > Border

Select an editable poly object. > Quad menu > Tools 1 quadrant > Border

A border is a linear section of a mesh that can generally be described as the edge of a hole. This is usually a sequence of edges with polygons on only one side. For example, a box primitive on page 389 doesn't have a border, but the teapot on page 416 object has several: on the lid, on the body, on the spout, and two on the handle. If you create a cylinder and then delete an end polygon, the adjacent row of edges forms a border.

At the editable poly Border sub-object level, you can select single and multiple borders and transform them using standard methods. This topic covers the Edit Geometry and Edit Borders rollouts; for other controls, see Editable Poly on page 2240.

Procedures

To create a polygon that closes the surface at the selected border:

1. At the Border sub-object level, select any open edge.
   This selects the entire closed loop of continuous open edges that make up the border selection.

2. Click Cap.
Interface

Selection rollout

See Editable Poly on page 2248 for information on the Selection rollout settings.

Soft Selection rollout

Soft Selection controls apply a smooth falloff between selected sub-objects and unselected ones. When Use Soft Selection is on, unselected sub-objects near your selection are given partial selection values. These values are shown in the viewports by means of a color gradient on the vertices, and optionally on the faces. They affect most types of sub-object deformations, such as the Move, Rotate, and Scale functions, as well as any deformation modifiers (such as Bend) applied to the object. This provides a magnet-like effect with a sphere of influence around the selection.

For more information, see Soft Selection Rollout on page 2014.

Edit Borders rollout

This rollout includes commands specific to editing borders.

NOTE To delete a border, select it and press the Delete key. This deletes the border and all attached polygons.

Extrude Lets you extrude a border manually via direct manipulation in the viewport. Click this button, and then drag vertically on any border to extrude it.
Extruding a border moves it along a normal and creates new polygons that form the sides of the extrusion, connecting the border to the object. The extrusion can form a varying number of additional sides, depending on the geometry near the border. As you increase the length of the extrusion, the base increases in size, to the extent of the vertices adjacent to the extruded border's endpoints.

Following are important aspects of border extrusion:

- When the mouse cursor is over a selected border, it changes to an Extrude cursor.

- To specify the extent of the extrusion, drag vertically, and to set the size of the base, drag horizontally.

- With multiple borders selected, dragging on any one extrudes all selected borders equally.

- While the Extrude button is active, you can extrude other borders in turn by dragging them. Click Extrude again or right-click in the active viewport to end the operation.

**Extrude Settings** Opens the Extrude Edges dialog on page 2350, which lets you perform extrusion via interactive manipulation.

If you click this button after performing a manual extrusion, the same extrusion is performed on the current selection as a preview and the dialog opens with Extrusion Height set to the amount of the last manual extrusion.

**Insert Vertex** Lets you subdivide border edges manually.

After turning on Insert Vertex, click a border edge to add a vertex at that location. You can continue subdividing border edges as long as the command is active.

To stop inserting vertices, right-click in the viewport, or click Insert Vertex again to turn it off.

**Chamfer** Click this button and then drag a border in the active object. The border need not be selected first.

If you chamfer multiple selected borders, all of them are chamfered identically. If you drag an unselected border, any selected borders are first deselected.

A border chamfer essentially “frames” the border edges, creating a new set of edges paralleling the border edges, plus new diagonal edges at any corners. These new edges are exactly <chamfer amount> distance from the original edges. New chamfer faces are created with the material ID of one of the
neighboring faces (picked at random) and a smoothing group which is an
intersection of all neighboring smoothing groups.
Alternatively, you can create open space around the chamfered borders,
especially cutting away at the open edges; for details, see Chamfer Edges
dialog on page 2344.

Chamfer Settings Opens the Chamfer Edges dialog on page 2344, which
lets you chamfer borders via interactive manipulation and toggle the Open
option.
If you click this button after performing a manual chamfer, the same chamfer
is performed on the current selection as a preview and the dialog opens with
Chamfer Amount set to the amount of the last manual chamfer.

Cap Caps an entire border loop with a single polygon.
Select the border, and then click Cap.

Bridge Connects pairs of borders on an object with polygon “bridges.” There
are two ways to use Bridge in Direct Manipulation mode (that is, without
opening the Bridge Settings dialog):
■ Select an even number of borders on the object, and then click Bridge.
  This immediately creates the bridge between each pair of selected borders
  using the current Bridge settings, and then deactivates the Bridge button.
■ If no qualifying selection exists (that is, two or more selected borders),
clicking Bridge activates the button and places you in Bridge mode. First
  click a border edge and then move the mouse; a rubber-band line connects
  the mouse cursor to the clicked edge. Click a second edge on a different
  border to bridge the two. This creates the bridge immediately using the
  current Bridge settings; the Bridge button remains active for connecting
  more pairs of borders. To exit Bridge mode, right-click the active viewport
  or click the Bridge button.

The new polygons that result from a Bridge operation are automatically
selected; you can see this by accessing the Polygon sub-object level.
NOTE Bridge always creates a straight-line connection between border pairs. To make the bridge connection follow a contour, apply modeling tools as appropriate after creating the bridge. For example, bridge two borders, and then use Bend on page 1165.

Bridge Settings Opens the Bridge dialog on page 2339, which lets you connect pairs of borders via interactive manipulation.

Connect Creates new edges between pairs of selected border edges. The edges are connected from their midpoints.

You can connect only edges on the same polygon.

Connect will not let the new edges cross. Thus, for example, if you select all four edges of a four-sided polygon and then click Connect, only neighboring edges are connected, resulting in a diamond pattern.

Connect Settings Lets you preview the Connect and specify the number of edge segments created by the operation. To increase the mesh resolution around the new edge, increase the Connect Edge Segments setting.

Create Shape From Selection After selecting one or more borders, click this button to create a spline shape from the selected edges. A Create Shape dialog appears, letting you name the shape and set it to Smooth or Linear. The new shape's pivot is placed at the center of the poly object.

Weight Sets the weight of selected borders. Used by the NURMS subdivision option on page 2326.
Increasing an edge weight tends to push the smoothed result away.

**Crease** Specifies how much creasing is performed on the selected border or borders. Used by the NURMS subdivision option on page 2326. At low settings, the border is relatively smooth. At higher settings, the crease becomes increasingly visible. At 1.0, the highest setting, the border is not smoothed at all.

**Edit Tri[angulation]** Lets you modify how polygons are subdivided into triangles by drawing internal edges, or diagonals on page 8551. To edit triangulation manually, turn on this button. The hidden edges appear. Click a polygon vertex. A rubber-band line appears, attached to the cursor. Click a non-adjacent vertex to create a new triangulation for the polygon.

**TIP** For easier editing of triangulation, use the Turn command instead (see following).

**Turn** Lets you modify how polygons are subdivided into triangles by clicking diagonals. When you activate Turn, the diagonals on page 8551 become visible as dashed lines in wireframe and edged-faces views. In Turn mode, click a diagonal to change its position. To exit Turn mode, right-click in the viewport or click the Turn button again. Each diagonal has only two available positions at any given time, so clicking a diagonal twice in succession simply returns it to its original position. But changing the position of a nearby diagonal can make a different alternate position available to a diagonal.

For more information on how to use Turn with the enhanced Cut tool, see this procedure on page 1368.
Edit Geometry rollout

For detailed descriptions of these controls, see Edit Geometry Rollout (Polymesh and Edit Poly) on page 1409.

Subdivision Surface rollout

For information about the Subdivision Surface rollout settings, see Subdivision Surface Rollout (Polymesh) on page 2325.
Subdivision Displacement rollout

For information about the Subdivision Displacement rollout settings, see Subdivision Displacement Rollout (Polymesh) on page 2330.

Paint Deformation rollout

Paint Deformation lets you stroke elevated and indented areas directly onto object surfaces. For more information, see Paint Deformation Rollout (Polymesh) on page 2333.

Editable Poly (Polygon/Element)

Select an editable poly object. > Modify panel > Selection rollout > Polygon or Element

Select an editable poly object. > Modify panel > Modifier Stack display > Expand Editable Poly. > Polygon/Element

Select an editable poly object. > Quad menu > Tools 1 quadrant > Polygon or Element

A polygon is a closed sequence of three or more edges connected by a surface. Polygons provide the renderable surface of editable poly objects.

At the Editable Poly (Polygon) sub-object level, you can select single and multiple polygons and transform them using standard methods. At the Element sub-object level you can select and edit groups of contiguous polygons. For further distinctions between polygon and element, see Editable Poly > Selection rollout on page 2248. This topic covers the Edit Polygons/Elements rollout and Edit Geometry rollout functions for these sub-object types; for other controls, see Editable Poly on page 2240.

NOTE  Workflow enhancements in the Editable Poly user interface give you a choice of editing methods. See Editable Poly Workflow on page 2241 for more information.
Interface

Selection rollout

See Editable Poly > Selection rollout on page 2248 for information on the Selection rollout settings.

Soft Selection rollout

Soft Selection controls apply a smooth falloff between selected sub-objects and unselected ones. When Use Soft Selection is on, unselected sub-objects near your selection are given partial selection values. These values are shown in the viewports by means of a color gradient on the vertices, and optionally on the faces. They affect most types of sub-object deformations, such as the Move, Rotate, and Scale functions, as well as any deformation modifiers (such as Bend) applied to the object. This provides a magnet-like effect with a sphere of influence around the selection.

For more information, see Soft Selection Rollout on page 2014.

Edit Polygons/Elements rollout

At the Element sub-object level, this rollout includes commands that are common to both polygons and elements. At the Polygon level, it contains those as well as a number more that are unique to polygons. The commands available at both levels are Insert Vertex, Flip, Edit Triangulation, Retriangulate, and Turn.
NOTE To delete polygons or elements, select them and press the Delete key. If Delete Isolated Vertices on page 1422 is off, this can result in isolated vertices; that is, vertices with no associated face geometry.

**Insert Vertex** Lets you subdivide polygons manually. Applies to polygons, even if at the element sub-object level.

After turning on Insert Vertex, click a polygon to add a vertex at that location. You can continue subdividing polygons as long as the command is active. To stop inserting vertices, right-click in the viewport, or click Insert Vertex again to turn it off.

**Extrude** Lets you perform manual extrusion via direct manipulation in the viewport. Click this button, and then drag vertically on any polygon to extrude it.

Extruding polygons moves them along a normal and creates new polygons that form the sides of the extrusion, connecting the selection to the object. Following are important aspects of polygon extrusion:

- When over a selected polygon, the mouse cursor changes to an Extrude cursor.
- Drag vertically to specify the extent of the extrusion, and horizontally to set the size of the base.
- With multiple polygons selected, dragging on any one extrudes all selected polygons equally.
- You can drag other polygons in turn to extrude them while the Extrude button is active. Click Extrude again or right-click in the active viewport to end the operation.
Extrude Settings Opens the Extrude Polygons dialog on page 2349, which lets you perform extrusion via interactive manipulation.

If you click this button after performing an extrusion, the same extrusion is performed on the current selection as a preview and the dialog opens with Extrusion Height set to the amount of the last manual extrusion.

Outline Lets you increase or decrease the outside edge of each contiguous group of selected polygons.
Outline is often used after an extrusion or bevel to adjust the size of the extruded faces. It doesn’t scale the polygons; only changes the size of the outer edge. For example, in the following illustration, note that the sizes of the inner polygons remain constant.
Extruded polygons (top), outline expanded (middle), outline reduced (bottom)

Note that inner polygons do not change size.
**Outline Settings** Opens the Outline Polygons dialog, which lets you perform outlining by a numeric setting.

**Bevel** Lets you perform manual beveling via direct manipulation in the viewport. Click this button, and then drag vertically on any polygon to extrude it. Release the mouse button and then move the mouse vertically to outline the extrusion. Click to finish.

- When over a selected polygon, the mouse cursor changes to a Bevel cursor.
- With multiple polygons selected, dragging on any one bevels all selected polygons equally.
- You can drag other polygons in turn to bevel them while the Bevel button is active. Click Bevel again or right-click to end the operation.

**Bevel Settings** Opens the Bevel Polygons dialog on page 2337, which lets you perform beveling via interactive manipulation.

If you click this button after performing a bevel, the same bevel is performed on the current selection as a preview and the dialog opens with the same settings used for the previous bevel.
**Inset** Performs a bevel with no height; that is, within the plane of the polygon selection. Click this button, and then drag vertically on any polygon to inset it.

- When over a selected polygon, the mouse cursor changes to an Inset cursor.
- With multiple polygons selected, dragging on any one insets all selected polygons equally.
- While the Inset button is active, you can drag other polygons in turn to inset them. To end the operation, click Inset again or right-click.

Inset works on a selection of one or more polygons. As with Outline, only the outer edges are affected.

**Inset Settings** Opens the Inset Polygons dialog on page 2353, which lets you inset polygons via interactive manipulation.

If you click this button after performing a manual inset, the same inset is performed on the current selection as a preview and the dialog opens with Inset Amount set to the amount of the last manual inset.

**Bridge** Connects two polygons or polygon selections on an object with a polygon “bridge.” There are two ways to use Bridge in Direct Manipulation mode (that is, without opening the Bridge Settings dialog):

- Make two separate polygon selections on the object, and then click Bridge. This creates the bridge immediately using the current Bridge settings, and then deactivates the Bridge button.
If no qualifying selection exists (that is, two or more discrete polygon selections), clicking Bridge activates the button and places you in Bridge mode. First click a polygon and move the mouse; a rubber-band line connects the mouse cursor to the clicked polygon. Click a second polygon to bridge the two. This creates the bridge immediately using the current Bridge settings; the Bridge button remains active for connecting more pairs of polygons. To exit Bridge mode, right-click the active viewport or click the Bridge button.

Using Bridge at the Polygon level

NOTE Bridge always creates a straight-line connection between polygon pairs. To make the bridge connection follow a contour, apply modeling tools as appropriate after creating the bridge. For example, bridge two polygons, and then use Bend on page 1165.

Bridge Settings Opens the Bridge dialog on page 2339, which lets you connect pairs of polygon selections via interactive manipulation.

Flip Reverses the directions of the normals of selected polygons, hence their facing.

Hinge From Edge Lets you perform a manual hinge operation via direct manipulation in the viewport. Make a polygon selection, click this button, and then drag vertically on any edge to hinge the selection. The mouse cursor changes to a cross when over an edge.
The hinge edge needn't be part of the selection. It can be any edge of the mesh. Also, the selection needn't be contiguous.

Hinging polygons rotates them about an edge and creates new polygons that form the sides of the hinge, connecting the selection to the object. It's essentially an extrusion with rotation, with the exception that, if the hinge edge belongs to a selected polygon, that side is not extruded. The manual version of Hinge From Edge works only with an existing polygon selection.

**TIP** To avoid inadvertently hinging about a backfacing edge, turn on Ignore Backfacing.

- **Hinge Settings** Opens the Hinge From Edge dialog on page 2352, which lets you hinge polygons via interactive manipulation. If you click this button after performing a manual hinge, the dialog opens with Angle set to the extent of the last manual hinge.

- **Extrude Along Spline** Extrudes the current selection along a spline.
You can extrude a single polygon (1) or a selection of contiguous (2) or non-contiguous polygons (3). Extrusion 2 uses Taper Curve and Twist (available via Settings). Extrusion 3 uses Taper Amount; each extrusion has a different curve rotation.

Make a selection, click Extrude Along/On Spline, and then select a spline in the scene. The selection is extruded along the spline, using the spline's current orientation, but as though the spline's start point were moved to the center of each polygon or group.

- **Extrude Along Spline Settings** Opens the Extrude Polygons Along Spline dialog on page 2347, which lets you extrude along splines via interactive manipulation.

- **Edit Triangulation** Lets you modify how polygons are subdivided into triangles by drawing internal edges.
In Edit Triangulation mode, you can see the current triangulation in the viewport, and change it by clicking two vertices on the same polygon.

To manually edit triangulation, turn on this button. The hidden edges appear. Click a polygon vertex. A rubber-band line appears, attached to the cursor. Click a non-adjacent vertex to create a new triangulation for the polygon.

Retriangulate Lets 3ds Max automatically do its best triangulation on the polygon or polygons currently selected.

Retriangulate attempts to optimize how selected polygons are subdivided into triangles.
**Turn** Lets you modify how polygons are subdivided into triangles by clicking diagonals. When you activate Turn, the diagonals on page 8551 become visible as dashed lines in wireframe and edged-faces views. In Turn mode, click a diagonal to change its position. To exit Turn mode, right-click in the viewport or click the Turn button again.

Each diagonal has only two available positions at any given time, so clicking a diagonal twice in succession simply returns it to its original position. But changing the position of a nearby diagonal can make a different alternate position available to a diagonal.

For more information on how to use Turn with the enhanced Cut tool, see this procedure on page 1368.

**Edit Geometry rollout**
For detailed descriptions of these controls, see Edit Geometry Rollout (Polymesh and Edit Poly) on page 1409.

**Polygon: Material IDs rollout**

![Polygon: Material IDs rollout](image)

**Set ID** Lets you assign a particular material ID to selected polygons for use with multi/sub-object materials on page 6120 and other applications. Use the spinner or enter the number from the keyboard. The total number of available IDs is 65,535.

**Select ID** Selects polygons corresponding to the Material ID specified in the adjacent ID field. Type or use the spinner to specify an ID, then click the Select ID button.

**[Select By Name]** This drop-down list shows the names of sub-materials if an object has a Multi/Sub-Object material assigned to it. Click the drop arrow and choose a sub-material from the list. The sub-objects that are assigned that material are selected. If an object does not have a Multi/Sub-Object material assigned, the name list is unavailable. Likewise, if multiple objects are selected that have an Edit Patch, Edit Spline, or Edit Mesh modifier applied, the name list is inactive.

**NOTE** Sub-material names are those specified in the Name column on the material's Multi/Sub-Object Basic Parameters rollout; these are not created by default, and must be specified separately from any material names.

**Clear Selection** When on, choosing a new ID or material name deselects any previously selected sub-objects. When off, selections are cumulative, so new ID or sub-material name selections add to the existing selection set of patches or elements. Default=on.
Polygon: Smoothing Groups rollout

Use these controls to assign selected polygons to different smoothing groups on page 8724, and to select polygons by smoothing group.

To assign polygons to one or more smoothing groups, select the polygons, and then click the number(s) of the smoothing group(s) to assign them to.

Select By SG (Smoothing Group) Displays a dialog that shows the current smoothing groups. Select all polygons that belong to a group by clicking the corresponding numbered button and clicking OK.

If Clear Selection is on, any previously selected polygons are first deselected. If Clear Selection is off, the new selection is added to any existing selection.

Clear All Removes any smoothing group assignments from selected polygons.

Auto Smooth Sets the smoothing groups based on the angle between polygons. Any two adjacent polygons will be put in the same smoothing group if the angle between their normals is less than the threshold angle, set by the spinner to the right of this button.

Threshold This spinner (to the right of Auto Smooth) lets you specify the maximum angle between the normals of adjacent polygons that determines whether those polygons will be put in the same smoothing group.

Polygon: Vertex Colors rollout

Use these controls to assign selected polygons to different smoothing groups on page 8724, and to select polygons by smoothing group.

To assign polygons to one or more smoothing groups, select the polygons, and then click the number(s) of the smoothing group(s) to assign them to.

Select By SG (Smoothing Group) Displays a dialog that shows the current smoothing groups. Select all polygons that belong to a group by clicking the corresponding numbered button and clicking OK.

If Clear Selection is on, any previously selected polygons are first deselected. If Clear Selection is off, the new selection is added to any existing selection.

Clear All Removes any smoothing group assignments from selected polygons.

Auto Smooth Sets the smoothing groups based on the angle between polygons. Any two adjacent polygons will be put in the same smoothing group if the angle between their normals is less than the threshold angle, set by the spinner to the right of this button.

Threshold This spinner (to the right of Auto Smooth) lets you specify the maximum angle between the normals of adjacent polygons that determines whether those polygons will be put in the same smoothing group.

Polygon: Vertex Colors rollout

Use these controls to assign selected polygons to different smoothing groups on page 8724, and to select polygons by smoothing group.

To assign polygons to one or more smoothing groups, select the polygons, and then click the number(s) of the smoothing group(s) to assign them to.

Select By SG (Smoothing Group) Displays a dialog that shows the current smoothing groups. Select all polygons that belong to a group by clicking the corresponding numbered button and clicking OK.

If Clear Selection is on, any previously selected polygons are first deselected. If Clear Selection is off, the new selection is added to any existing selection.

Clear All Removes any smoothing group assignments from selected polygons.

Auto Smooth Sets the smoothing groups based on the angle between polygons. Any two adjacent polygons will be put in the same smoothing group if the angle between their normals is less than the threshold angle, set by the spinner to the right of this button.

Threshold This spinner (to the right of Auto Smooth) lets you specify the maximum angle between the normals of adjacent polygons that determines whether those polygons will be put in the same smoothing group.
Use these controls to assign the color, illumination color (shading), and alpha (transparency) values of vertices on selected polygons or elements.

**Color** Click the color swatch to change the color of vertices on selected polygons or elements.

**Illumination** Click the color swatch to change the illumination color of vertices on selected polygons or elements. This lets you change the illumination without changing the vertex's color.

**Alpha** Lets you assign an alpha (transparency) value to vertices on selected polygons or elements. The spinner value is a percentage; zero is completely transparent and 100 is completely opaque.

### Subdivision Surface rollout

For information about the Subdivision Surface rollout settings, see Subdivision Surface Rollout (Polymesh) on page 2325.

### Subdivision Displacement rollout

For information about the Subdivision Displacement rollout settings, see Subdivision Displacement Rollout (Polymesh) on page 2330.

### Paint Deformation rollout

Paint Deformation lets you stroke elevated and indented areas directly onto object surfaces. For more information, see Paint Deformation Rollout (Polymesh) on page 2333.

---

**Edit Geometry Rollout (Polymesh and Edit Poly)**

Create or select an editable poly or Edit Poly object. > Modify panel > Edit Geometry rollout

The Edit Geometry rollout provides global controls for changing the geometry of the poly object, at either the top (Object) level or the sub-object levels. The controls are the same at all levels, except as noted in the descriptions below.
Interface

Repeat Last

Repeats the most recently used command.

For example, if you extrude a polygon, and want to apply the same extrusion to several others, select the others, and then click Repeat Last.
You can apply a spline extrusion of a single polygon (left) repeatedly to other single polygons (1) or to multiple polygon selections, contiguous (2) or not (3).

**NOTE** Repeat Last does not repeat all operations. For example, it does not repeat transforms. To determine which command will be repeated when you click the button, check the tooltip for the Repeat Last button on the command panel, which gives the name of the last operation that can be repeated. If no tooltip appears, nothing will happen when you click the button.

**Constraints** Lets you use existing geometry to constrain sub-object transformation. Choose the constraint type:

- **None**: No constraints. This is the default option.
- **Edge**: Constrains sub-object transformations to edge boundaries.
- **Face**: Constrains sub-object transformations to individual face surfaces.
- **Normal**: Constrains each sub-object’s transformations to its normal, or the average of its normals. In most cases, this causes sub-objects to move perpendicular to the surface.

**NOTE** This constraint works like the Push modifier on page 1640, including the fact that it operates on unmodified base normals. Edited normals are unsupported.
When set to Edge, moving a vertex will slide it along one of the existing edges, depending on the direction of the transformation. If set to Face, the vertex moves only on the polygon's surface.

**NOTE** You can set constraints at the Object level, but their use pertains primarily to sub-object levels. The Constraints setting persists at all sub-object levels.

**Preserve UVs** When on, you can edit sub-objects without affecting the object’s UV mapping. You can choose any of an object’s mapping channels to preserve or not; see Preserve UVs Settings, following. Default=off.

Without Preserve UVs, there is always a direct correspondence between an object’s geometry and its UV mapping. For example, if you map an object and then move vertices, the texture moves along with the sub-objects, whether you want it to or not. If you turn on Preserve UVs, you can perform minor editing tasks without changing the mapping.

**TIP** For best results with Preserve UVs at the vertex level, use it for limited vertex editing. For example, you’ll usually have no trouble moving a vertex within edge or face constraints. Also, it’s better to perform one big move than several smaller moves, as multiple small moves can begin to distort the mapping. If, however, you need to perform extensive geometry editing while preserving mapping, use the Channel Info utility on page 6486 instead.
Preserve UVs Settings Opens the Preserve Map Channels dialog on page 2355, which lets you specify which vertex color channels and/or texture channels (map channels) to preserve. By default, all vertex color channels are off (not preserved), and all texture channels are on (preserved).

Create Lets you create new geometry. How this button behaves depends on which level is active:

- **Object, Polygon, and Element levels** Lets you add polygons in the active viewport. After you turn on Create, click three or more times in succession anywhere, including on existing vertices, to define the shape of the new polygon. To finish, right-click.

  While creating a polygon at the Polygon or Element level, you can delete the most recently added vertex by pressing Backspace. You can do this repeatedly to remove added vertices in reverse order of placement.

  You can start creating polygons in any viewport, but all subsequent clicks must take place in the same viewport.

  **TIP** For best results, click vertices in counterclockwise (preferred) or clockwise order. If you use clockwise order, the new polygon will face away from you.

- **Vertex level** Lets you add vertices to a single selected poly object. After selecting the object and clicking Create, click anywhere in space to add free-floating (isolated) vertices to the object. The new vertices are placed on the active construction plane unless object snapping is on. For example, with face snapping on, you can create vertices on object faces.

- **Edge and Border levels** Lets you create an edge between a pair of non-adjacent vertices on the same polygon. Click Create, click a vertex, and then move the mouse. A rubber-band line extends from the vertex to the mouse cursor. Click a second, non-adjacent vertex on the same polygon to connect them with an edge. Repeat, or, to exit, right-click in the viewport or click Create again.

  Edges you create separate the polygons. For example, by creating an edge inside a quadrilateral polygon, you turn it into two triangles.

Collapse (Vertex, Edge, Border, and Polygon levels only) Collapses groups of contiguous selected sub-objects by welding their vertices to a vertex at the selection center.
Using collapse on a vertex selection

Using collapse on a polygon selection

Attach  Lets you attach other objects in the scene to the selected poly object. After activating Attach, click an object to attach to the selected object. Attach remains active, so you can continue clicking objects to attach them. To exit, right-click in the active viewport or click the Attach button again.

You can attach any type of object, including splines, patch objects, and NURBS surfaces. Attaching a non-mesh object converts it to editable-poly format.

When you attach an object, the materials of the two objects are combined in the following way:

- If the object being attached does not have a material assigned, it inherits the material of the object it is being attached to.
Handle inherits material from the cup it is being attached to.

- Likewise, if the object you're attaching to doesn't have a material, it inherits the material of the object being attached.
- If both objects have materials, the resulting new material is a multi/sub-object material on page 6120 that includes the input materials. A dialog appears offering three methods of combining the objects' materials and material IDs. For more information, see Attach Options Dialog on page 2233.
  Attach remains active in all sub-object levels, but always applies to objects.

**Attach List** Lets you attach other objects in the scene to the selected mesh. Click to open the Attach List dialog, which works like Select From Scene on page 206 to let you choose multiple objects to attach.
Shaded view of model (upper left); wireframe view of model (upper right); model with objects attached (lower left); and subsequent multi/sub-object material (lower right)

**Detach (sub-object levels only)** Detaches the selected sub-objects and the polygons attached to them as a separate object or element(s).

With an Editable Poly object, when you click Detach, the software prompts you for the options specified on the Detach dialog. With an Edit Poly object, Detach on the Modify panel automatically uses those settings. To change them, click Detach Settings (see following).

**Detach Settings** Opens the Detach dialog on page 1423, which lets you set several options. Available only with Edit Poly objects; with Editable Poly, this dialog opens automatically when you click Detach.
Cut and Slice group

These knife-like tools let you subdivide the poly mesh along a plane (Slice) or in a specific area (Cut). Also see Full Interactivity on page 1422.

Slice Plane (sub-object levels only) Creates a gizmo for a slice plane that you can position and rotate to specify where to slice. Also enables the Slice and Reset Plane buttons; click Slice to create new edges where the plane intersects the geometry.

If you use Slice Plane from the modeling ribbon, the Slice, Split, and Reset Plane controls are available on the Slice Mode contextual panel on page 2098.

If snapping is off, you see a preview of the slice as you transform the slice plane. To perform the slice, click the Slice button.

NOTE At the Polygon or Element sub-object level, Slice Plane affects only selected polygons. To slice the entire object, use Slice Plane at any other sub-object level, or at the object level.

Split When on, the QuickSlice and Cut operations create double sets of vertices at the points where the edges are divided. This lets you easily delete the new polygons to create holes, or animate the new polygons as separate elements.

Slice (sub-object levels only) Performs the slice operation at the location of the slice plane. Available only when Slice Plane is on. This tool slices the poly just like the “Operate On: Polygons” mode of the Slice modifier on page 1727.

Left: Using Slice; Right: After slicing and moving the pieces apart

Reset Plane (sub-object levels only) Returns the Slice plane to its default position and orientation. Available only when Slice Plane is on.
QuickSlice Lets you quickly slice the object without having to manipulate a gizmo. Make a selection, click QuickSlice, and then click once at the slice start point and again at its endpoint. You can continue slicing the selection while the command is active.

To stop slicing, right-click in the viewport, or click QuickSlice again to turn it off.

With Quickslice on, you can draw a line across your mesh in any viewport, including Perspective and Camera views. The mesh is sliced interactively as you move the line endpoint.

**NOTE** At the Object level, QuickSlice affects the entire object. To slice only specific polygons, use QuickSlice on a polygon selection at the Poly sub-object level.

**NOTE** At the Polygon or Element sub-object level, QuickSlice affects only selected polygons. To slice the entire object, use QuickSlice at any other sub-object level, or at the object level.

Cut Lets you create edges from one polygon to another or within polygons. Click at the start point, move the mouse and click again, and continue moving and clicking to create new connected edges. Right-click once to exit the current cut, whereupon you can start a new one, or right-click again to exit Cut mode.
While cutting, the mouse cursor icon changes to show the type of sub-object it’s over, to which the cut will be made when you click. The following illustration shows the three different cursor icons.

Top: Cutting to a vertex
Center: Cutting to an edge
Bottom: Cutting to a polygon

Cut is available at the object level and all sub-object levels.
**NOTE** You can use Cut with Turn for enhanced productivity. For more information, see this procedure on page 1368.

---

**MSmooth** Smoothes the object using the current settings. This command uses subdivision functionality similar to that of the MeshSmooth modifier on page 1505 with NURMS Subdivision, but unlike NURMS subdivision, it applies the smoothing instantly to the selected area of the control mesh.

![Smoothing a low-poly object with NURMS subdivision](image)

**MSmooth Settings** Opens the MeshSmooth Selection dialog on page 2354, which lets you specify how smoothing is applied.

**Tessellate** Subdivides all polygons in the object based on the Tessellation settings on page 2358. Tessellation is useful for increasing local mesh density while modeling. You can subdivide any selection of polygons. Two tessellation methods are available: Edge and Face.

**Tessellate Settings** Opens the Tessellate Selection dialog on page 2358, which lets you specify how smoothing is applied.

**Make Planar** Forces all selected sub-objects to be coplanar. The plane's normal is the average surface normal of the selection. At the Object level, forces all vertices in the object to become coplanar.
**TIP** One application for Make Planar is making a flat side on an object. Normally, you would use a contiguous selection set. If the selection includes vertices on various parts of the object, the vertices are still made planar, but with distorting effects on the rest of the geometry.

X/Y/Z Makes all selected sub-objects planar and aligns the plane with the corresponding plane in the object’s local coordinate system. The plane used is the one to which the button axis is perpendicular; so, for example, clicking the X button aligns the object with the local YZ axis.

At the Object level, makes all vertices in the object planar.

**View Align** Aligns all vertices in the object to the plane of the active viewport. At sub-object levels, this function affects only selected vertices or those belonging to selected sub-objects.

In orthographic viewports, aligning to the view has the same effect as aligning to the construction grid when the home grid is active. Aligning to a perspective viewport (including camera and light views), reorients the vertices to a plane that is parallel to the camera’s viewing plane. This plane is perpendicular to the view direction that is closest to the vertices’ average position.
Grid Align Aligns all vertices in the selected object to the plane of the current view. At sub-object levels, aligns only selected sub-objects. This command aligns the selected vertices to the current construction plane. The current plane is specified by the active viewport in the case of the home grid. When using a grid object, the current plane is the active grid object.

Relax Applies the Relax function to the current selection, using the Relax dialog settings (see following). Relax normalizes mesh spacing by moving each vertex toward the average location of its neighbors. It works the same way as the Relax modifier on page 1643. At the object level, Relax applies to the entire object. At sub-object levels, Relax applies only to the current selection.

Relax Settings Opens the Relax dialog on page 2357, which lets you specify how the Relax function is applied.

Hide Selected (Vertex, Polygon, and Element levels only) Hides selected sub-objects.

Unhide All (Vertex, Polygon, and Element levels only) Restores hidden sub-objects to visibility.

Hide Unselected (Vertex, Polygon, and Element levels only) Hides unselected sub-objects.
Named Selections (sub-object levels only)

Lets you copy and paste named selection sets of sub-objects between objects. Start by creating one or more named selection sets, copy one, select a different object, go to the same sub-object level, and then paste the set.

**NOTE** This function uses sub-object IDs, so if the target object’s geometry differs from that of the source object, the pasted selection will probably comprise a different set of sub-objects.

For more information, see Named Selection Sets on page 185.

**Copy** Opens a dialog that lets you specify a named selection set to place into the copy buffer.

**Paste** Pastes the named selection from the copy buffer.

Delete Isolated Vertices (Edge, Border, Polygon, and Element levels only) When on, deletes isolated vertices when you delete a selection of contiguous sub-objects. When off, deleting sub-objects leaves all vertices intact. Default=on.

**Full Interactivity (editable poly only)** Toggles the level of feedback for the QuickSlice and Cut tools, as well as all settings dialogs. Available with editable poly objects, but not the Edit Poly modifier.

When on (the default), the final result is always visible as you use the mouse to manipulate the tool or change a numeric setting. With Cut and QuickSlice, when Full Interactivity is turned off, only the rubber-band line is visible until you click. Similarly, with numeric settings in dialogs, the final result is visible only when you release the mouse button after changing the setting.

The state of Full Interactivity doesn't affect changing a numeric setting from the keyboard. Whether it’s on or off, the setting takes effect only when you exit the field by pressing Tab or Enter, or by clicking a different control in the dialog.

Subdivision Surface Rollout (Polymesh)

Create or select an editable poly object. > Modify panel > Subdivision Surface rollout
Applies subdivision to the object in the style of MeshSmooth on page 1505, so you can work on a lower-resolution "cage" mesh and simultaneously see a smoother, subdivided result. This rollout is available at all sub-object levels, as well as at the object level, and always affects the entire object.

### Interface

#### Subdivision Surface

- **Smooth Result**
- **Use NURMS Subdivision**
- **Isoline Display**
- **Show Cage**

**Display**

- Iterations: 1
- Smoothness: 1.0

**Render**

- Iterations: 0
- Smoothness: 1.0

**Separate By**

- Smoothing Groups
- Materials

**Update Options**

- Always
- When Rendering
- Manually

**Update**

#### Smooth Result

Applies the same smoothing group to all polygons.

#### Use NURMS Subdivision

Applies smoothing via the NURMS method. See NURMS on page 1508. The difference between NURMS in Editable Poly and MeshSmooth is that the latter gives you access to control vertices, but the former does not.

You control the degree of smoothing with the Iterations controls in the Display and Render groups.
NOTE The remaining controls on this rollout take effect only when Use NURMS Subdivision is on.

Isoline Display When on, 3ds Max displays only isolines: the object's original edges, before smoothing. The benefit of using this option is a less cluttered display. When off, 3ds Max displays all faces added by NURMS Subdivision; thus, higher Iterations settings (see Display group on page 2328) result in a greater number of lines. Default=on.

Smoothed box with Isoline Display off (left) and Isoline Display on (right).

NOTE Applying a modifier to an Editable Poly object cancels the effect of the Isoline Display option; the wireframe display reverts to showing all polygons in the object. This is not, however, always the case with the MeshSmooth modifier. Most deformation and mapping modifiers maintain the isoline display, but others, such as the selection modifiers (except Volume Select) and the Turn To ... modifiers, cause the interior edges to be displayed.

Show Cage Toggles the display of a two-color wireframe that shows the editable poly object before modification or subdivision. The cage colors are shown as swatches to the right of the check box. The first color represents unselected sub-objects, and the second color represents selected sub-objects. Change a color by clicking its swatch.
The cage displays the original structure of the edited object.

Typically this feature is used in conjunction with the NURMS Subdivision feature, or with the MeshSmooth modifier on page 1505, because it lets you easily toggle visibility of the unsmoothed base object while simultaneously viewing the smoothed result, but it works with any modifier. When used with a modifier, turn on Show End Result to make Show Cage available.

**TIP** Show Cage is particularly helpful when used with the Symmetry modifier on page 1803.

**Display group**

**Iterations** Sets the number of iterations used to smooth the poly object. Each iteration generates all polygons using the vertices created from the previous iteration. Range=0 to 10.

When the Iterations check box in the Render group (see following) is off, this setting controls iterations both in the viewports and at render time. When the check box is on, this setting controls iterations only in the viewports.
WARNING Use caution when increasing the number of iterations. The number of vertices and polygons in an object (and thus the calculation time) can increase as much as four times for each iteration. Applying four iterations to even a moderately complex object can take a long time to calculate. To stop calculation and revert to the previous iteration setting, press Esc.

Smoothness Determines how sharp a corner must be before polygons are added to smooth it. A value of 0.0 prevents the creation of any polygons. A value of 1.0 adds polygons to all vertices even if they lie on a plane. When the Smoothness check box in the Render group (see following) is off, this setting controls smoothness both in the viewports and at render time. When the check box is on, this setting controls smoothness only in the viewports.

**Render group**

Applies a different number of smoothing iterations and/or a different Smoothness value to the object at render time.

**TIP** Use a low number of iterations and/or a lower Sharpness value for modeling, and higher values for rendering. This lets you work quickly with a low-resolution object in the viewports, while producing a smoother object for rendering.

**Iterations** Lets you choose a different number of smoothing iterations on page 2328 to be applied to the object at render time. Turn on Iterations, and then use the spinner to its right to set the number of iterations.

**Smoothness** Lets you choose a different Smoothness value to be applied to the object at render time. Turn on Smoothness, and then use the spinner to its right to set the smoothness value.

**Separate By group**

**Smoothing Groups** Prevents the creation of new polygons at edges between faces that don’t share at least one smoothing group.

**Materials** Prevents the creation of new polygons for edges between faces that do not share Material IDs.

**Update Options group**

Sets manual or render-time update options, for situations where the complexity of the smoothed object is too high for automatic updates.
You can also use the Iterations settings in the Render group to set a greater
degree of smoothing to be applied only at render time.

**Update Option** Choose how the software is to update the mesh:

- **Always** Updates the object automatically whenever you change any
  MeshSmooth settings.

- **When Rendering** Updates the viewport display of the object only at
  render time.

- **Manually** Any settings you change don't take effect until you click the
  Update button.

**Update** Updates the object in the viewport to match the current MeshSmooth
settings. Works only when you choose When Rendering or Manually.

---

### Subdivision Displacement Rollout (Polymesh)

Create or select an editable poly object. > Modify panel > Subdivision
Displacement rollout

Create or select an editable poly object. > modeling ribbon > Subdivision panel
> Activate Use Displacement. > Displacement panel

Specifies surface approximation settings for subdividing an editable poly object.
These controls work like the surface approximation settings for NURBS on
page 2416 surfaces. They are used when you apply a displacement map on page
6059 to the editable poly object.

**NOTE** These settings differ from the Subdivision Surface rollout on page 2325 settings
in that, while the latter are applied at the same modifier-stack level as the mesh,
subdivision displacement is always applied at the top of the stack, when the mesh
is used for rendering. So, for example, applying the Symmetry modifier to an
object that uses surface subdivision would affect the subdivided mesh, but would
not affect an object that uses subdivision displacement only.

**TIP** By default, subdivision displacement is visible only when the object is rendered.
To see the results of displacement in the viewports, apply the Displace Mesh
modifier on page 1068.
Interface

Subdivision Displacement Rollout (Polymesh)
Displacement panel on modeling ribbon

**Subdivision Displacement** When on, polygons are subdivided to accurately displace the poly object, using the method and settings you specify in the Subdivision Presets and Subdivision Method groups. When off, the poly is displaced by moving existing vertices, the way the Displace modifier on page 1313 does. Default=off.

**NOTE** On the modeling ribbon, this control is available as the Subdivision panel > Use Displacement on page 2148 button.

**Split Mesh** Affects the seams of displaced poly objects; also affects texture mapping. When on, the poly object is split into individual polygons before it is displaced; this helps preserve texture mapping. When off, the poly is not split and an internal method is used to assign texture mapping. Default=on.

**TIP** This parameter is required because of an architectural limitation in the way displacement mapping works. Turning Split Mesh on is usually the better technique, but it can cause problems for objects with clearly distinct faces, such as boxes, or even spheres. A box’s sides might separate as they displace outward, leaving gaps. And a sphere might split along its longitudinal edge (found in the rear for spheres created in the Top view) unless you turn off Split Mesh. However, texture mapping works unpredictably when Split Mesh is off, so you might need to add a Displace Mesh modifier on page 1068 and make a snapshot on page 950 of the poly. You would then apply a UVW Map modifier on page 1932 and then reassign mapping coordinates to the displaced snapshot poly.
Subdivision Presets group & Subdivision Method group

These settings determine how 3ds Max applies the displacement map when Subdivision Displacement is on. They are identical to the Tessellation settings on the Surface Approximation rollout on page 2737 used for NURBS surfaces.

Paint Deformation Rollout (Polymesh)

Paint Deformation lets you push, pull, or otherwise affect vertices by dragging the mouse cursor over the object surface. At the object level, Paint Deformation affects all vertices in the selected object. At sub-object levels, it affects only selected vertices (or vertices that belong to selected sub-objects), and recognizes soft selection.

By default, deformation occurs in the normal direction of each vertex. 3ds Max continues to use a vertex's original normal, but you can opt to use the altered normal direction for a more dynamic modeling process, or even deform along a specific axis.

NOTE Paint Deformation cannot be animated.

TIP You can streamline the painting process by using the Brush Presets tools on page 8044.

Procedures

To paint deformation onto a mesh object:

1. Apply an Edit Poly modifier on page 1332 to an object, or convert the object to Editable Poly on page 2240 format. Paint Deformation uses existing geometry, so the object should have enough mesh resolution for the desired deformation.

2. Do either of the following:
   - To deform anywhere on the object, remain at the object level, or work at a sub-object level with no sub-objects selected.
   - To deform only specific areas of an object, go to a sub-object level and then select the sub-objects in the area to deform.

3. On the Paint Deformation rollout, click Push/Pull.
4 Set Push/Pull value to a negative value to push into the object surface, or to a positive value to pull the surface outward. The higher the absolute value, the greater the effect.

5 Set Brush Size and Brush Strength.

6 Position the mouse cursor over the surface to be deformed. As you move the mouse, the “brush” reorients dynamically to show the normal direction of the portion of the mesh currently under the cursor. You can use the normal direction of deformed surfaces as the push/pull direction by choosing Deformed Normals.

7 Press the mouse button and drag to deform the surface. If you paint in the same spot repeatedly without lifting the mouse button, the effect is cumulative up to the maximum Push/Pull Value setting.

**Interface**

Paint Deformation has three modes of operation: Push/Pull, Relax, and Revert. Only one of these modes can be active at a time. The remaining settings control the effect of the active deformation mode.

For any mode, choose the mode, change settings as necessary, and then drag the cursor over the object to paint the deformation.
To paint deformation anywhere on the object, remain at the object level, or work at a sub-object level with no sub-objects selected. To deform only specific areas of an object, go to a sub-object level and select the sub-objects in the area to deform.

**Push/Pull** Moves vertices into the object surface (push) or out of the surface (pull). The direction and extent of pushing or pulling is determined by the Push/Pull Value setting.

**TIP** To reverse the Push/Pull direction while painting, press and hold Alt.

**NOTE** Push/Pull supports soft selection in that effective strength falls off with the selection value of soft-selected sub-objects.

**Relax** Normalizes the distances between vertices by moving each vertex to a position calculated from the average of its neighbors. Relax uses the same method as the Relax modifier on page 1643.

Use Relax to push apart vertices that are too close together, or to pull together vertices that are too far apart.

**Revert** Lets you gradually “erase” or reverse the effects of Push/Pull or Relax by painting. Affects only vertices deformed since the most recent Commit operation. If no vertices qualify for reversion, the Revert button is unavailable.

**TIP** You can switch to Revert mode temporarily by pressing and holding the Ctrl key while painting deformation in Push/Pull or Relax mode.

**Push/Pull Direction group**

This setting lets you specify whether pushing or pulling vertices occurs with respect to surface normals, original or deformed, or along a specific axis. Default=Original Normals.

Painting deformations with Original Normals typically moves vertices perpendicular to the original surface; using Deformed Normals tends to move vertices outward after their initial deformation, resulting in a “puffy” effect.

**Original Normals** When chosen, pushing or pulling a vertex moves it in the direction of its normal before deformation. Repeated applications of Paint Deformation always move each vertex in the same direction it moved originally.

**Deformed Normals** When chosen, pushing or pulling a vertex moves it in the current direction of the normal; that is, after deformation.
Transform axis X/Y/Z When chosen, pushing or pulling a vertex moves it along the specified axis, using the current reference coordinate system on page 922.

Push/Pull Value Determines the direction and maximum extent of a single application of the push/pull operation. Positive values “pull” vertices out of the object surface, and negative values “push” vertices into the surface. Default =10.0.

A single application is defined as painting (that is, dragging once or more over the same area) without lifting the mouse button.

TIP You can use Alt to switch between pushing and pulling with the same value while painting. For example, if you're pulling with a value of 8.5, press and hold Alt to start pushing with a value of -8.5.

Brush Size Sets the radius of the circular brush. Only vertices inside the brush circle are deformed. Default=20.0.

TIP To change the brush radius interactively, release the mouse button, press and hold Shift+Ctrl+left mouse button, and then drag the mouse. This also works with all other painter-interface features in 3ds Max such as Skin > Paint Weights and VertexPaint.

Brush Strength Sets the rate at which the brush applies the Push/Pull value. A low Strength value applies the effect more slowly than a high value. Range=0.0 to 1.0. Default=1.0.

TIP To change the brush strength interactively, release the mouse button, press and hold Shift+Alt+left mouse button, and then drag the mouse. This also works with all other painter-interface features in 3ds Max such as Skin > Paint Weights and VertexPaint.

Brush Options Click this button to open the Painter Options dialog on page 1989, where you can set various brush-related parameters.

Commit Makes any deformation changes permanent, “baking” them into the object geometry. After using Commit, you can no longer apply Revert to changes up to that point.

Cancel Eliminates all changes since the initial application of Paint Deformation or the most recent Commit operation.
Editable Poly Settings Dialogs

These topics describe support dialogs for tools for editing Editable Polymesh surfaces. The dialogs are used in Interactive Manipulation mode on page 1339, in which you can adjust settings parametrically and see the results immediately in the viewports.

**IMPORTANT** With the exception noted following, dialog settings persist throughout the current session and affect subsequent use of the related tool. For example, if you change the Segments value for the Bridge tool, and then use the tool subsequently in Direct Manipulation mode on page 1339, the altered Segments value is applied automatically.

The exception is where you apply a setting directly, typically by dragging on a sub-object. For example, changing the Chamfer Amount setting in a dialog doesn’t apply to chamfering a sub-object directly, because you set the amount by dragging.

**Bevel Polygons Dialog (Polymesh)**

Select an Edit Poly or editable poly object. > Modify panel > Polygon sub-object level > Edit Polygons rollout > Bevel Settings button

Select an Edit Poly or editable poly object. > Polygon sub-object level > Quad menu > tools 2 quadrant > Bevel Settings button

Select an Edit Poly or editable poly object. > Modeling ribbon > Graphite Modeling Tools tab > Polygon Modeling panel > Polygon sub-object level > Polygons panel > Shift+click Bevel button or choose Bevel Settings from drop-down.

Beveling involves first extruding and then scaling the extruded polygon(s). Use these settings for beveling polygons in Interactive Manipulation mode.
Interface

### Bevel Polygons

**Bevel Type group**

- **Group** Beveling takes place along the average normal of each contiguous group of polygons. If you bevel multiples of such groups, each group moves along its own averaged normal.

- **Local Normal** Beveling takes place along each selected polygon's normal.

- **By Polygon** Bevels each polygon individually.

**Height** Specifies the extent of the extrusion in scene units. You can extrude selected polygons outward or inward, depending on whether the value is positive or negative.

**Outline Amount** Makes the outer border of selected polygons bigger or smaller, depending on whether the value is positive or negative.

---

**Apply** Applies the settings to the current selection, retaining them if you then make another selection.

**OK** Applies the settings to the current selection and closes the dialog.

**Cancel** Closes the dialog without applying the settings to the current selection. Does not reverse previous uses of Apply.
Bridge Borders/Polygons Dialog (Polymesh)

Select an Edit Poly or editable poly object. > Modify panel > Polygon or Border sub-object level > Edit Polygons rollout > Bridge Settings button

Select an Edit Poly or editable poly object. > Polygon or Border sub-object level > Quad menu > tools 2 quadrant > Bridge Settings button

Select an Edit Poly or editable poly object. > Modeling ribbon > Graphite Modeling Tools tab > Polygon Modeling panel > Polygon or Border sub-object level > Polygons or Border Edges panel > Shift+click Bridge button or choose Bridge Settings from drop-down.

Use these settings for bridging pairs of polygons, polygon selections, or borders in Interactive Manipulation mode.

**NOTE** Bridge calculates which way the bridge polygons should face. If you bridge two sub-objects so that the bridge goes through the object, the bridge polygons face inward. But if you create a bridge that goes through empty space, such as when connecting sub-objects between two elements, the polygons face outward. To make the bridge polygons face differently, use the Flip function.

Examples of an internal bridge (left) and an external bridge (right), the latter connecting two elements
NOTE Bridging two elements makes them contiguous, combining them into a single element.

Interface

Bridge lets you use existing poly/border selections, or pick them from the dialog. Choose one of the following:

- **Use Specific Polygons/Borders** In this mode, use the Pick buttons to designate polygons or borders for bridging.

- **Use Polygon/Border Selection** If one or more qualifying selection pairs exist, choosing this option connects them immediately. If not, you can select pairs of sub-objects in a viewport to connect them. If you make more than two qualifying selections, Bridge connects them in increasing order of ID. For example, if you select polygon 12, 35, and 89, Bridge connects polygons 12 and 35. But if you then deselect polygon 35, Bridge then connects polygons 12 and 89.

**Polygon/Edge 1/2** Click each Pick button in turn, and then click a polygon or border edge in a viewport. At the Border sub-object level, clicking any edge on a border designates the entire border for bridging. Also, the edges you pick on each border are connected directly, and the remaining edges are connected in consecutive order. You can change the order of the edge correspondences with the Twist settings. Available only in Use Specific mode.
After clicking a sub-object, the Pick button shows its ID number. You can change the selection at any time by clicking a Pick button and picking a different sub-object.

**Twist 1/2** Rotates the order of connection between the edges of the two selections. The two controls let you set a different twist amount for each end of the bridge.

**Segments** Specifies the number of polygons along the length of the bridge connection. This setting also applies to manually bridged polygons.

**TIP** When using Taper, set Segments to a value greater than 1.

**Taper** Sets the extent to which the bridge width becomes smaller or larger toward its center. Negative settings taper the bridge center smaller; positive settings taper it larger.

**NOTE** To change the location of maximum taper, use the Bias setting.

**Bias** Determines the location of maximum taper amount. The range of the Bias value is -99.0 to 99.0. At the default value of 0.0, the taper amount is greatest at the center of the bridge. At -99.0, the taper amount is greatest near the first selected polygon or border; at 99.0, it's greatest near the second selected polygon or border.

**Smooth** Determines the maximum angle between columns across which smoothing can occur. A column is a string of polygons extending along the length of the bridge.

---

**Apply** Applies the settings to the current selection, retaining them if you then make another selection.

**OK** Applies the settings to the current selection and closes the dialog.

**Cancel** Closes the dialog without applying the settings to the current selection. Does not reverse previous uses of Apply.

### Bridge Edges Dialog (Polymesh)

Select an Edit Poly or editable poly object. > Modify panel > Polygon or Border sub-object level > Edit Polygons rollout > Bridge Settings button
Select an Edit Poly or editable poly object. > Polygon or Border sub-object level > Quad menu > tools 2 quadrant > Bridge Settings button

Select an Edit Poly or editable poly object. > Modeling ribbon > Graphite Modeling Tools tab > Polygon Modeling panel > Edge sub-object level > Edges panel > Shift+click Bridge button or choose Bridge Settings from drop-down.

Use these settings for bridging pairs of edges in Interactive Manipulation mode.

NOTE Bridge calculates which way the bridge polygons should face. If you bridge two edges so that the bridge goes through the object, the bridge polygons face inward. But if you create a bridge that goes through empty space, such as when connecting edges between two elements, the polygons face outward, in general. To make the bridge polygons face differently, use the Flip function.

NOTE Bridging edges of two elements makes them contiguous, combining them into a single element.

Interface

![Bridge Edges Interface](image)

Bridge lets you use existing edge selections, or pick them from the dialog. Choose one of the following:

- **Bridge Specific Edges** In this mode, use the Pick buttons to designate polygons or borders for bridging.

- **Use Edge Selection** If one or more qualifying selection pairs exist, choosing this option connects them immediately. If not, you can select pairs of sub-objects in a viewport to connect them.
**Edge 1/Edge 2** Click each Pick button in turn, and then click a border edge in a viewport. Available only in Bridge Specific Edges mode.

After clicking an edge, the Pick button shows its ID number. You can change the selection at any time by clicking a Pick button and picking a different sub-object.

**Segments** Specifies the number of polygons along the length of the bridge connection. This setting also applies to manually bridged edges.

**Smooth** Specifies the maximum angle between columns across which smoothing can occur. A column is a string of polygons extending along the length of the bridge.

**Reverse Triangulation** When bridging two edge selections each of which contains different numbers of edges, two ways of triangulating the bridge polygons are possible. This check box lets you toggle between them.

![Left: Reverse Triangulation on](image1)
![Right: Reverse Triangulation off](image2)

**Bridge Adjacent** Specifies the minimum angle between adjacent edges across which bridging can occur. Edges less than this angle will not be bridged, and instead will be skipped.
Top Left: Edge selections before bridging
Top Right: Segments=2, Bridge Adjacent<83.0
Bottom Left: Bridge Adjacent=83.0
Bottom Right: Bridge Adjacent=126.5

NOTE The above illustration shows, among other things, how setting Bridge Adjacent too high can cause overlapping polygons (left side of the two bottom images), which is undesirable.

---

Apply Applies the settings to the current selection, retaining them if you then make another selection.

OK Applies the settings to the current selection and closes the dialog.

Cancel Closes the dialog without applying the settings to the current selection. Does not reverse previous uses of Apply.

Chamfer Vertices/Edges/Borders Dialog (Polymesh)

Select an Edit Poly or editable poly object. > Modify panel > Vertex/Edge/Border sub-object level > Edit Vertices/Edges/Borders rollout > Chamfer Settings button
Select an Edit Poly or editable poly object. > Vertex/Edge/Border sub-object level > Quad menu > tools 2 quadrant > Chamfer Settings button

Select an Edit Poly or editable poly object. > Modeling ribbon > Graphite Modeling Tools tab > Polygon Modeling panel > Vertex/Edge/Border sub-object level > Vertices/Edges/Border Edges panel > Shift+click Chamfer button or choose Chamfer Settings from drop-down.

Chamfering creates new faces around the chamfered entity, along with connecting edges. Or, with the Open option, you can create an open (empty) area instead. For vertices, edges, and borders, you can use the dialog to set the chamfer amount numerically and to toggle the Open option. The Segments setting applies only to edges and borders.

**Interface**

![Chamfer Edges](image)

- **Chamfer Amount** The extent of the chamfer. Default=1.0.
- **Segments** (edges/borders only) Adds edges and polygons over the area of the chamfer, and, with single chamfered edges, rounds off the chamfer. By default, the chamfer uses a single segment, which covers the chamfered area with a new polygon positioned diagonally with respect to the original corner. The higher the Segments value you use, the more the chamfer is rounded off. If you chamfer two or more adjacent, open edges at a time, the rounding off takes place only at open ends of the edges. No rounding takes place where the edges meet.
- **Open** When on, the chamfered area is deleted, leaving open space. Default=off.

**Connect Edges Dialog (Polymesh)**

Select an Edit Poly or editable poly object. > Modify panel > Edge sub-object level > Edit Edges rollout > Connect Settings button

Select an Edit Poly or editable poly object. > Edge sub-object level > Quad menu > tools 2 quadrant > Connect Settings button
Select an Edit Poly or editable poly object. > Modeling ribbon > Graphite Modeling Tools tab > Polygon Modeling panel > Edge sub-object level > Loops panel > Shift+click Connect button or choose Connect Settings from drop-down.

Connecting edges creates new edges between adjacent pairs of selected edges. The Connect Edges dialog settings let you specify the number of new edges, the amount of separation from each other, and their general location.

**TIP** Connecting edges, and in particular the Slide function, work best with ring selections on page 1351.
Interface

**Segments** The number of new edges between each adjacent pair of selected edges. Default=1.

**Pinch** The relative spacing between the new, connecting edges. Negative values move the edges closer together; positive values move them farther apart. Default=0.
If Segments=1, the Pinch setting has no effect.

**Slide** The relative positioning of the new edges. Default=0.
By default, the new edges are centered. Positive values move them in one direction, while negative values move them in the opposite direction. The new edges cannot move beyond existing edges.

**Extrude Polygons Along Spline Dialog (Polymesh)**

Select an Edit Poly or editable poly object. > Modify panel > Polygon sub-object level > Edit Polygons rollout > Extrude Along Spline Settings button

Select an Edit Poly or editable poly object. > Polygon sub-object level > Quad menu > tools 2 quadrant > Extrude Along Spline Settings button

Select an Edit Poly or editable poly object. > Modeling ribbon > Graphite Modeling Tools tab > Polygon Modeling panel > Polygon sub-object level > Polygons panel > Shift+click Extrude On Spline button or choose Extrude On Spline Settings from drop-down.

Use these settings for extruding polygons along splines in Interactive Manipulation mode.
Interface

**Pick Spline** Click this button and then select a spline along which to extrude in the viewport. The spline object's name then appears on the button. If you open this dialog after performing a manual Extrude Along Spline, the name of the spline you used appears on the button.

**Align to face normal** Aligns the extrusion with the face normal, which, in most cases, makes it perpendicular to the extruded polygon(s). When turned off (the default), the extrusion is oriented the same as the spline.

With Align To Face Normal, the extrusion does not follow the original orientation of the spline (1); it's reoriented to match the face normals (2), or averaged normals for contiguous selections. The Rotation option is available only when Align To Face Normal is on.
**Rotation** Sets the rotation of the extrusion. Available only when Align To Face Normal is on. Default=0. Range=-360 to 360.

**Segments** Specifies the number of polygons into which each extruded side is subdivided. This setting also applies to manually extruded polygons.

**Taper Amount** Sets the extent to which the extrusion becomes smaller or larger along its length. Negative settings taper the extrusion smaller; positive settings taper it larger.

**Taper Curve** Sets the rate at which the tapering proceeds. Lower settings result in a more gradual taper; large settings result in a more abrupt taper. Taper Curve affects the thickness of the extrusion between its endpoints, but not the size of the ends.

**Twist** Applies a twist along the length of the extrusion. When using this option, increasing the number of segments will improve the smoothness of the extrusion.

---

**Apply** Applies the settings to the current selection, retaining them if you then make another selection.

**OK** Applies the settings to the current selection and closes the dialog.

**Cancel** Closes the dialog without applying the settings to the current selection. Does not reverse previous uses of Apply.

---

**Extrude Polygons Dialog (Polymesh)**

Select an Edit Poly or editable poly object. > Modify panel > Polygon sub-object level > Edit Polygons rollout > Extrude Settings button

Select an Edit Poly or editable poly object. > Polygon sub-object level > Quad menu > tools 2 quadrant > Extrude Settings button

Select an Edit Poly or editable poly object. > Modeling ribbon > Graphite Modeling Tools tab > Polygon Modeling panel > Polygon sub-object level > Polygons panel > Shift+click Extrude button or choose Extrude Settings from drop-down.

Use these settings for extruding polygons in Interactive Manipulation mode.
Interface

Extrude Polygons

Extrusion Type group

Group Extrusion takes place along the average normal of each contiguous group of polygons. If you extrude multiples of such groups, each group moves along its own averaged normal.

Local Normal Extrusion takes place along each selected polygon’s normal.

By Polygon Extrudes or bevels each polygon individually.

Extrusion Height Specifies the amount of the extrusion in scene units. You can extrude selected polygons outward or inward, depending on whether the value is positive or negative.

Apply Applies the settings to the current selection, retaining them if you then make another selection.

OK Applies the settings to the current selection and closes the dialog.

Cancel Closes the dialog without applying the settings to the current selection. Does not reverse previous uses of Apply.

Extrude Vertices/Edges Dialog (Polymesh)

Select an Edit Poly or editable poly object. > Modify panel > Vertex/Edge/Border sub-object level > Edit Vertices/Edges/Borders rollout > Extrude Settings button
Select an Edit Poly or editable poly object. > Vertex/Edge/Border sub-object level > Quad menu > tools 2 quadrant > Extrude Settings button

Select an Edit Poly or editable poly object. > Modeling ribbon > Graphite Modeling Tools tab > Polygon Modeling panel > Vertex/Edge sub-object level > Vertices/Edges panel > Shift+click Extrude button or choose Extrude Settings from drop-down.

Use this dialog for extruding vertices, edges, and borders in Interactive Manipulation mode.

NOTE At the Border sub-object level, this dialog is named Extrude Edges.

Interface

**Extrude Vertices**

- **Extrusion Height**: Specifies the amount of the extrusion in scene units. You can extrude sub-objects outward or inward, depending on whether the value is positive or negative.

- **Extrusion Base Width**: Specifies the size of the extrusion base in scene units. You can set this as high as you want, but the actual size cannot extend beyond the vertices adjacent to the extruded sub-object(s).

---

**Apply** Applies the settings to the current selection, retaining them if you then make another selection.

**OK** Applies the settings to the current selection and closes the dialog.

**Cancel** Closes the dialog without applying the settings to the current selection. Does not reverse previous uses of Apply.
Hinge Polygons From Edge Dialog (Polymesh)

Select an Edit Poly or editable poly object. > Modify panel > Polygon sub-object level > Edit Polygons rollout > Hinge From Edge Settings button

Select an Edit Poly or editable poly object. > Polygon sub-object level > Quad menu > tools 2 quadrant > Hinge From Edge Settings button

Select an Edit Poly or editable poly object. > Modeling ribbon > Graphite Modeling Tools tab > Polygon Modeling panel > Polygon sub-object level > Polygons panel > Shift+click Hinge button or choose Hinge Settings from drop-down.

Use these settings for hinging polygons in Interactive Manipulation mode.

Interface

**Angle** Quantifies the rotation about the hinge. You can hinge selected polygons outward or inward, depending on whether the value is positive or negative.

**Segments** Specifies the number of polygons into which each extruded side is subdivided. This setting also applies to manually hinged polygons.

**Current Hinge** Click Pick Hinge, and then click an edge to be the hinge. After you designate a hinge, the “Pick Hinge” button text is replaced with “Edge #” where # is the ID number of the hinge edge.

All subsequent hinge operations created via the dialog will use this hinge. To hinge multiple polygons, each from one of its own sides, you must reselect the hinge each time.
Apply Applies the settings to the current selection, retaining them if you then make another selection.

OK Applies the settings to the current selection and closes the dialog.

Cancel Closes the dialog without applying the settings to the current selection. Does not reverse previous uses of Apply.

**Inset Polygons Dialog (Polymesh)**

Select an Edit Poly or editable poly object. > Modify panel > Polygon sub-object level > Edit Polygons rollout > Inset Settings button

Select an Edit Poly or editable poly object. > Polygon sub-object level > Quad menu > tools 2 quadrant > Inset Settings button

Select an Edit Poly or editable poly object. > Modeling ribbon > Graphite Modeling Tools tab > Polygon Modeling panel > Polygon sub-object level > Polygons panel > Shift+click Inset button or choose Inset Settings from drop-down.

Use these settings for insetting polygons in Interactive Manipulation mode.

**Interface**

**Inset Type group**

This setting affects how Inset works with selections of more than one polygon.

**Group** The inset takes place across multiple, contiguous polygons.

**By Polygon** Insets each polygon individually.
Inset Amount Specifies the amount of the inset in scene units.

Apply Applies the settings to the current selection, retaining them if you then make another selection.

OK Applies the settings to the current selection and closes the dialog.

Cancel Closes the dialog without applying the settings to the current selection. Does not reverse previous uses of Apply.

MeshSmooth Selection Dialog (Polymesh)

Select an Edit Poly or editable poly object. > Modify panel > Polygon sub-object level > Edit Geometry rollout > MSmooth Settings button

Select an Edit Poly or editable poly object. > Modeling ribbon > Graphite Modeling Tools tab > Polygon Modeling panel > Polygon sub-object level > Subdivision panel > Shift+click MSmooth (MeshSmooth) button or choose MeshSmooth Settings from drop-down.

This dialog lets you specify how mesh smoothing affects editable poly and Edit Poly objects.

Interface

![MeshSmooth Selection Dialog](image)

Smoothness Determines how sharp a corner must be before polygons are added to smooth it. Smoothness is calculated as the average angle of all edges.
connected to a vertex. A value of 0.0 prevents the creation of any polygons. A value of 1.0 adds polygons to all vertices even if they lie on a plane.

**Separate by Smoothing Groups** Prevents the creation of new polygons at edges between polygons that don’t share at least one smoothing group.

**Separate by Materials** Prevents the creation of new polygons for edges between polygons that do not share Material IDs.

---

**Apply** Applies the settings to the current selection, retaining them if you then make another selection.

**OK** Applies the settings to the current selection and closes the dialog.

**Cancel** Closes the dialog without applying the settings to the current selection. Does not reverse previous uses of Apply.

### Preserve Map Channels Dialog (Polymesh)

Select an Edit Poly or editable poly object. > Modify panel > any sub-object level > Edit Geometry rollout > Preserve UVs button

Select an Edit Poly or editable poly object. > Modeling ribbon > Graphite Modeling Tools tab > Polygon Modeling panel > Polygon sub-object level > Edit panel > Shift+click Preserve UVs button or choose Preserve UVs Settings from drop-down.

Use these settings for specifying which map channels to preserve when editing sub-objects with the Preserve UVs option on. A preserved map channel doesn’t respond to minor editing that changes vertex locations, but a channel whose UVs aren’t preserved allows mapping to be changed by changes in vertex locations.

**Interface**

The dialog contains buttons for all available, data-containing vertex color channels and texture channels. The number and type of buttons displayed vary depending on the state of the object; they can be changed, for example, with the VertexPaint modifier on page 1959 and the Channel Info utility on page 6486.

Click a button to toggle its state. When off, a button is gray and appears higher than the dialog surface. When on, a button is orange and appears pressed in.
**Vertex Color Channels** Displays buttons for any vertex-color channels that contain data. These can be Vertex Colors, Vertex Illumination, and Vertex Alpha. By default, all vertex-color buttons are off, so that associated UVs are affected by sub-object editing. To prevent a channel from being affected by sub-object editing, click its button.

**Texture Channels** Displays buttons for any texture (mapping) channels that contain data. These are identified by number. By default these are on, so that associated UVs are not affected by sub-object editing. To allow a channel to be affected by sub-object editing, click its button.

**Reset All** Returns all channel buttons to their default states: all vertex color channels off, all texture channels on.

---

**Apply** Applies the settings to the current selection, retaining them if you then make another selection.

**OK** Applies the settings to the current selection and closes the dialog.

**Cancel** Closes the dialog without applying the settings to the current selection. Does not reverse previous uses of Apply.
Relax Dialog (Polymesh)

Select an Edit Poly or editable poly object. > Modify panel > object level or any sub-object level > Edit Geometry rollout > Relax Settings button

Select an Edit Poly or editable poly object. > Modeling ribbon > Graphite Modeling Tools tab > Polygon Modeling panel > Polygon sub-object level > Geometry (All) panel > Shift+click Relax button or choose Relax Settings from drop-down.

Use these settings for relaxing vertices in Interactive Manipulation mode. Relax in Edit/Editable Poly works much like the Relax modifier on page 1643: It normalizes the distance between each affected vertex and its neighbors by moving the vertex toward the average position of its neighbors.

NOTE At the object level, Relax applies to the entire object. At any sub-object level, Relax applies to selected sub-objects only.

Interface

Amount Controls how far a vertex moves for each iteration. The value specifies a percentage of the distance from the original location of a vertex to the average location of its neighbors. Range=-1.0 to 1.0. Default=0.5.

Iterations Sets how many times to repeat the Relax process. For each iteration, average locations are recalculated and the Relax Value is reapplied to every vertex. Default=1.

Hold Boundary Points Controls whether vertices at the edges of open meshes are moved. Default=on.

When on, boundary vertices do not move while the rest of the object is relaxed. This option is particularly useful when working with multiple elements within a single object that share open edges.

When this check box is off, all vertices of the object are relaxed.
**Hold Outer Points** When on, preserves the original positions of vertices farthest away from the object center.

---

**Apply** Applies the settings to the current selection, retaining them if you then make another selection.

**OK** Applies the settings to the current selection and closes the dialog.

**Cancel** Closes the dialog without applying the settings to the current selection. Cancel does not reverse previous uses of Apply.

---

**Tessellate Selection Dialog (Polymesh)**

Select an Edit Poly or editable poly object. > Modify panel > Polygon sub-object level > Edit Geometry rollout > Tessellate Settings button

Select an Edit Poly or editable poly object. > Modeling ribbon > Graphite Modeling Tools tab > Polygon Modeling panel > Polygon sub-object level > Subdivision panel > Shift+click Tessellate button or choose Tessellate Settings from drop-down.

Use this dialog to specify how Tessellate subdivides polygons.

**Interface**

![Tessellate Selection](image)

**Edge** Inserts vertices in the middle of each edge and draws lines connecting those vertices. The number of polygons created will equal the number of sides of the original polygon.

**Face** Adds a vertex to the center of each polygon and draws connecting lines from that vertex to the original vertices. The number of polygons created will equal the number of sides of the original polygon.
**Tension** Lets you increase or decrease the Edge tension value. Available only when Type: Edge is active.

A negative value pulls vertices inward from their plane, resulting in a concave effect. A positive value pulls vertices outward from their plane, resulting in a rounding effect.

---

**Apply** Applies the settings to the current selection, retaining them if you then make another selection.

**OK** Applies the settings to the current selection and closes the dialog.

**Cancel** Closes the dialog without applying the settings to the current selection. Does not reverse previous uses of Apply.

---

**Weld Vertices/Edges Dialog (Polymesh)**

Select an Edit Poly or editable poly object. > Modify panel > Vertex or Edge sub-object level > Edit Vertices/Edges rollout > Weld Settings button

Select an Edit Poly or editable poly object. > Vertex or Edge sub-object level > Quad menu > tools 2 quadrant > Weld Settings button

Select an Edit Poly or editable poly object. > Modeling ribbon > Graphite Modeling Tools tab > Polygon Modeling panel > Vertex/Edge sub-object level > Vertices/Edges panel > Shift+click Weld button or choose Weld Settings from drop-down.

Use this dialog for setting the weld threshold for vertices and edges.

**Interface**

![Weld Vertices Dialog](image)
**Weld Threshold** Specifies the maximum distance, in scene units, within which selected sub-objects will be welded. Any vertex or edge that lies outside this threshold (that is, it’s farther than this from the nearest vertex or edge) will not be welded.

**Number of Vertices** Shows the number of vertices before and after the weld. The After quantity updates dynamically as you change the setting with the spinner.

---

**Apply** Applies the settings to the current selection, retaining them if you then make another selection.

**OK** Applies the settings to the current selection and closes the dialog.

**Cancel** Closes the dialog without applying the settings to the current selection. Does not reverse previous uses of Apply.

---

### Patch Objects

With patch modeling, you can create objects that look mesh-like but whose surface curvature can be controlled with handles, like splines. You can create a patch model with built-in patch grids, and can convert most objects to patch format.

### Editable Patch Surface

Create or select an object > Modify panel > Right-click object’s entry in the stack display > Convert To: Editable Patch

Create or select an object > Right-click the object > Transform (lower-right) quadrant of the quad menu > Convert To: > Convert to Editable Patch

Editable Patch provides controls for manipulating an object as a patch object and at five sub-object levels: vertex, handle, edge, patch, and element.

Editable Patch objects provide the same basic functionality as the Edit Patch modifier on page 1329. Because working with them requires less processing and memory, we recommend you use Editable Patch objects rather than the Edit Patch modifier whenever possible.
When you convert an object to Editable Patch format or apply an Edit Patch modifier, 3ds Max converts the object’s geometry into a collection of separate Bezier patches, each patch made up of a framework of vertices and edges, plus a surface.

- The **framework** of control points and connecting tangents defines the surface. Transforming the components of this framework is the primary technique in patch modeling. The framework does not appear in scanline renderings.

- The **surface** is the Bezier patch surface, whose shape is controlled by the vertices and edges. The surface is the renderable geometry of the object.

Prior to version 3 of 3ds Max, some patch objects contained a lattice that appeared separate from the surface. This is no longer the case: The control framework conforms exactly to the surface, making it easier to visualize the results of patch modeling.

The output of the **Surface modifier** on page 1763 is a patch surface. If you are modeling with splines and are using the Surface modifier to generate a patch surface from the spline cage, you can use an **Edit Patch modifier** on page 1329 for further modeling.

**Show End Result**

- Turn on Show End Result on the Modify panel if you have modifiers above the Editable Patch modifier and want to see the result of all the modifiers in the modifier stack. This function will remain on until you turn it off.

**See also:**

- **Edit Modifiers and Editable Objects** on page 1052
- **Modifying at the Sub-Object Level** on page 1054
- **Modifier Stack Controls** on page 8187

**Procedures**

**To work at a sub-object level:**

1. In the modifier stack display, choose a selection level: Element, Patch, Edge, or Vertex.
To attach an object using Edit Patch:
1 Select an editable patch object, or an object with the Edit Patch modifier applied.
2 In the Modify panel > Geometry rollout > Topology group, click Attach.
3 Turn off Reorient, if necessary.
4 Select an object to attach.
The object takes on a patch structure and stays in its original location.
The attached object is now part of the editable patch object. The Tessellation settings for the original object affect attached objects as well.

To attach and reorient an object:
- Turn on Reorient before attaching the object.
The object is both attached and moved to align with the patch object. The pivot of the attached object matches the pivot of the Edit Patch object.

To detach a patch surface:
1 Make a selection at the Patch sub-object level.
2 If you want to reorient the detached surface, turn on Reorient.
3 Click Detach.
   A Detach dialog appears.
4 Name the detached surface.
The detached surface remains in place if you chose not to reorient it. It is deselected and assigned a different color.

To copy a patch surface:
1 Make a selection at the Patch sub-object level.
2 In the Geometry rollout > Topology group, turn on Copy.
3 If you want to reorient the copied surface, turn on Reorient.
4 Click Detach.
   A Detach dialog appears.
5 Name the patch copy.
The copied object remains in place if you chose not to reorient it.

To delete patches:
1 Make a selection at the Patch sub-object level.
2 Click Delete.
The patches disappear.

To subdivide a patch:
1 Make a selection at the Patch sub-object level.
2 Turn on Propagate to maintain surface continuity.
3 Click Subdivide.
The patch selection is subdivided, increasing the number of patches.
You can repeat this process, subdividing multiple times. Each subdivision
increases the number of patches, which become increasingly smaller. The
following figure is an example of modeling a highly subdivided surface.

To subdivide an edge:
1 At the Edge sub-object level, make an edge selection.
A single edge is indicated by its coordinate axis or transform gizmo at
the center of the edge. For multiple edges, the axis icon is at the center
of the selection set.
2 Optionally, turn on Propagate to maintain surface continuity.
3 Click Subdivide.
   The edge selection is subdivided. Each new edge is on the boundary of a
   new, smaller patch.

To add a patch:
1 At the Edge sub-object level, select an open edge (one that bounds a single
   patch, and therefore is not shared with another patch).
2 Click Add Tri or Add Quad.
   A new patch is added to the surface.

To unlock interior edges of selected patches:
1 At the Patch sub-object level, select one or more patches.
2 Right-click the selection and choose Manual Interior from the pop-up
   menu.
   The check mark moves from Auto Interior, the default, to Manual Interior.
   Interior edges and their vertices are now unlocked. If you now transform
   the patch, the interior edges remain static. To transform the interior
   vertices, see the following procedure.

To transform interior vertices:
1 At the Patch sub-object level, select one or more patches.
2 Right-click the selection and choose Manual Interior from the pop-up
   menu.
   The check mark moves from Auto Interior, the default, to Manual Interior.
3 Switch to Handle level.
   The interior vertices appear as yellow squares.
4 Transform the interior vertices of the selected patches.
To anchor a patch:

By default, the welding process shifts the geometry of both patches to a common center. You can anchor one patch so that the other patch moves to its location when the weld occurs.

1. At the Patch (Patch) level, before you begin the weld, select the patch you want anchored.

2. Return to Vertex level and weld the vertices.
   When the weld occurs, the anchor patch remains fixed while the other patch moves to make the weld.

To create a new element, do one of the following:

- Shift+drag one or more patches.
- Shift+extrude one or more patches.
- Shift+extrude one or more edges.
- Shift+drag an element.

Interface

Selection rollout

For information about these settings, see Selection Rollout (Editable Patch) on page 2366.

Soft Selection rollout

For information on the Soft Selection rollout settings, see Soft Selection Rollout on page 2014.

Geometry and Surface Properties rollouts

The Geometry rollout on page 2394 provides functions for editing a patch object and its sub-objects, and the Surface Properties controls let you modify the object's rendering characteristics. For detailed information on sub-object-specific controls, see the topics in this section.
Selection Rollout (Editable Patch)

Create or select an object > Modify panel > Right-click object's entry in the stack display > Convert To: Editable Patch > Selection rollout

Create or select an object > Right-click the object > Transform (lower-right) quadrant of the quad menu > Convert To: > Convert to Editable Patch > Selection rollout

The Selection rollout provides buttons for selecting the sub-object level, working with named selections, display and filter settings, and displays information about selected entities.

Editable Patch has five levels of sub-object editing: Vertex, Handle, Edge, Patch, and Element. The selection you make at each level appears in the viewport as a component of the patch object. Each level maintains its own sub-object selection. When you return to a level, the selection reappears.

Clicking a sub-object level button here is the same as clicking a sub-object level in the modifier stack. Click the button again to turn it off and return to the object selection level.
Vertex Lets you select vertex control points and their vector handles on a patch object. At this level, vertices can be welded and deleted. By default, a transform gizmo or axis tripod appears at the geometric center of the selected vertices. If you turn on Gizmo Preferences on page 8354 > Allow Multiple Gizmos, however, gizmos or tripods appear at all selected vertices. Vector handles appear as small green squares around selected vertices. Also, with certain objects you may see interior vertices represented as yellow squares.

Handle Lets you select vector handles associated with each vertex. This level lets you manipulate the handles without needing to deal with vertices. A Transform gizmo or axis tripod appears at the geometric center of the selected handles.
At this level, vector handles appear as small green squares around all vertices. Also, with certain objects you may see interior vertices represented as yellow squares.

**Edge** Selects a bounding edge of the patch object. At this level, edges can be subdivided, and new patches added to open edges. A Transform gizmo or axis tripod appears in the middle of a single selected edge. For multiple selected edges, the icon is at the selection center.

**Patch** Selects an entire patch. At this level, a patch can be detached, deleted, or its surface subdivided. When a patch is subdivided, the surface is broken into smaller patches, each with its own vertices and edges.

**Element** Select and edit an entire element. An element has contiguous faces.

**TIP** You can highlight selected patches in a shaded display by turning on Shade Selected Faces in the Viewport Properties dialog. Right-click over the viewport name and choose Configure in the menu to display the Viewport Properties dialog. You can also use the default keyboard shortcut, **F2**, to toggle this feature.

**Named Selections group**

These functions work with named sub-object selection sets. To create a named sub-object selection, make the selection, and then enter a name in the Named Selection Sets field on the toolbar. For more information, see Named Selection Sets on page 217.

**Copy** Places a named sub-object selection into the copy buffer. After clicking this button, choose the named sub-object selection from the Copy Named Selection dialog that appears.

**Paste** Pastes the named sub-object selection from the copy buffer.

You can use Copy and Paste to copy sub-object selections between different objects.

**Filter group**

These two check boxes, available only at the Vertex sub-object level, let you select and transform vertices, vectors (handles on the vertices), or both. When a check box is turned off, you can't select the corresponding element type.
Thus, for example, if you turn off Vertices, you can manipulate vectors without accidentally moving a vertex.

**TIP** For easier editing of vectors only, use the Handle sub-object level on page 2380.

You can't turn off both check boxes. When you turn off either check box, the other one becomes unavailable. At that point, you can manipulate the element corresponding to the check box that's on, but you can't turn it off.

**Vertices** When on, you can select and move vertices.

**Vectors** When on, you can select and move vectors.

---

**Lock Handles** Affects only Corner vertices. Locks the tangent vectors together so that when you move one, you move them all. Available only at the Vertex sub-object level.

**By Vertex** When you click a vertex, any handles, edges, or patches that use that vertex, depending on the current sub-object level, are selected. Available only at the Handle, Edge, and Patch sub-object levels.

This also works with Region Select.

**Ignore Backfacing** When on, selection of sub-objects selects only those sub-objects whose normals are visible in the viewport. When off (the default), selection includes all sub-objects, regardless of the direction of their normals. Use this on a complex patch model where you want to select only visible patches.

**NOTE** The state of the Backface Cull setting in the Display panel does not affect sub-object selection. Thus, if Ignore Backfacing is off, you can still select sub-objects, even if you can't see them.

**Shrink** Reduces the sub-object selection area by deselecting the outermost sub-objects. If the selection size can no longer be reduced, the remaining sub-objects are deselected. Unavailable at the Handle sub-object level.

**Grow** Expands the selection area outward in all available directions. Unavailable at the Handle sub-object level.

**Ring** Expands an edge selection by selecting all edges parallel to the selected edges. Available only at the Edge sub-object level.

**Loop** Expands the selection as far as possible, in alignment with selected edges. Available only at the Edge sub-object level.
Select Open Edges Selects all edges that are used by only one patch. Available only at the Edge sub-object level. You can use this to troubleshoot a surface; open edges will be highlighted.

Selection Information At the bottom of the Selection rollout is a text display giving information about the current selection. If multiple sub-objects are selected, or none is selected, the text gives the number and type selected. If one sub-object is selected, the text gives the identification number and type of the selected item.

Editable Patch (Object)

Select an editable patch > Modify panel > Editable patch (not a sub-object level) selected in the modifier stack
Select an editable patch > Right-click the patch > Tools 1 (upper-left) quadrant of the quad menu > Sub-objects > Top-level
The functions available at the editable patch object level (that is, when no sub-object level is chosen) are also available at all sub-object levels, and work exactly the same at each level.

Interface

Selection rollout

For information on these settings, see Editable Patch Surface on page 2360.
Geometry rollout

Editable Patch Surface | 2371
See Geometry Rollout (Patch) on page 2394 for detailed descriptions of these controls.

**Surface Properties rollout**

The Relax Mesh controls on the Surface Properties rollout change the apparent surface tension by moving vertices closer to, or away from, their neighbors. The typical result is that the object gets smoother and a little smaller as the vertices move toward an averaged center point. You can see the most pronounced effects on objects with sharp corners and edges.

- **Relax** Turns on the relax function for renderings.
- **Relax Viewports** Turns on the relax function for viewports.
- **Relax Value** Sets the distance a vertex moves as a percentage of the distance between a vertex and the average location of its neighbors. Range=-1.0 to 1.0. Default=0.5.
- **Iterations** Sets how many times Relax is repeated. Each iteration recalculates average vertex locations based on the result of the previous iteration. Default=1.
- **Keep Boundary Pts Fixed** Vertices at the edge of open patches do not relax. Default=on.
- **Save Outer Corners** Preserves the original positions of vertices farthest away from the object center.
A patch box with Relax off (left), and Relax Value=1.0, with 1, 2, and 3 iterations (left to right)

**Editable Patch (Vertex)**

Select an editable patch > Modify panel > Expand Editable Patch in the stack display > Vertex sub-object level
Select an editable patch > Modify panel > Selection rollout > Vertex button
Select an editable patch > Right-click the patch > Tools 1 (upper-left) quadrant of the quad menu > Sub-objects > Vertex

At the Editable Patch (Vertex) level, you can select single and multiple vertices and move them using standard methods. You can also move and rotate vector handles on page 8755, thus affecting the shapes of any patches connected to the vertex.

**Procedures**

To transform either vertices or vectors:

1. At Patch (Vertex) level, with Selection rollout > Filter group > Vertices turned on, select vertices in the patch object you want to transform. Vertices and their vectors both appear.

2. Turn off one of the filters, leaving the other on, and choose a transform.
A transform cursor appears when you move onto a vertex or vector in the selection set. You can toggle between filters to alternatively transform either component.

**To switch vertex types:**

1. Right-click a patch vertex.

2. Choose from commands on the quad menu. The Tools 1 (upper-left) quadrant includes two options specific to patch vertices:
   - **Coplanar:** If you set a patch control point's property to be coplanar, it's like locking the handle of the outgoing vector for that point. Moving a handle attached to a coplanar vertex causes the opposite vectors to adjust their positions to maintain a coplanar surface. This option is the default and gives smooth transitions between patches.
   - **Corner:** If you set a patch control point's property to be corner, it unlocks the handle of the outgoing vector, so you can create a discontinuous break in the patch surface.

**To switch vertex types from Coplanar to Corner, do one of the following:**

- Hold down Shift as you move a handle of a Coplanar vertex. This changes the vertex type to Corner.
  - If Lock Handles is off (the default), Shift+Move "breaks" the handle, allowing it to move independently.
  - If Lock Handles is on, the handles remain locked in their coplanar relationship. However, the vertex is still switched to Corner, and turning off Lock Handles lets you move the handles separately.

- Right-click the vertex and then choose Corner from the quad menu.

**To delete a vertex:**

1. At Patch (Vertex) level, select a vertex.

2. Click Delete.
   - The vertex and all patches sharing this control point are deleted.
To weld vertices:

1. At Patch (Vertex) level, select two valid vertices on different patches.
2. Set Weld Threshold to a value at least equal to the distance between the selected vertices.

3. Click Selected.
   The two vertices move together and join.
To transform interior vertices:

Using program defaults, you can select only vertices and vectors on the outer edge or boundary of a patch. This default is known as Auto Interior.

In some cases, you might want to move the interior vertices. For example, you might want to tweak a patch's curvature without having to subdivide the patch.

- At Patch level on page 2385, you can change the default on a patch-by-patch basis by right-clicking a patch and choosing Manual Interior from the shortcut menu. This lets you select and transform individual interior vertices. These vertices appear as yellow squares in the viewports.

  WARNING  If you return a patch to the default, changes due to Manual Interior are lost.

  NOTE  Certain objects are automatically set to Manual Interior when converted to patch objects. In such cases, you can see all interior vertices when you go to the Vertex sub-object level.

Interface

Selection rollout

For information on the controls in this rollout, see Selection Rollout (Editable Patch) on page 2366.

Soft Selection rollout

Geometry rollout

- Subdivision
  - Subdivide
  - Propagate
  - Bind
  - Unbind

- Topology
  - Add Tab
  - Add Quad
  - Create
  - Dotch
  - Frontend
  - Copy
  - Attach
  - Frontend
  - Copy
  - Delete
  - Break
  - Hide
  - Unhide All

- Weird
  - Selected
  - Target
  - [pixels]

- Extrude & Bevel
  - Extrude
  - Bevel
  - [pixels]
  - Normal: Group
  - Local
  - Bevel Smoothing:
    - Start
    - End
    - Smooth
    - Linear
    - None

- Tangent
  - [pixels]
  - Paste Length

- Surface
  - View Steps: [5]
  - Render Steps: [5]
  - Show Internal Edges
  - Use True Patch Normals

- Miscellaneous
  - [Create Shape]
  - Patch Smooth
See *Geometry Rollout (Patch)* on page 2394 for detailed descriptions of these controls.

**Surface Properties rollout**

![Surface Properties rollout](image)

**Edit Vertex Colors group**

Use these controls to assign the color, illumination color (shading), and alpha (transparency) values of selected vertices.

**Color** Click the color swatch to change the color of selected vertices.

**Illumination** Click the color swatch to change the illumination color of selected vertices. This lets you change the color of shadows without changing the vertex colors.

**Alpha** Lets you assign an alpha (transparency) value to selected vertices. The spinner value is a percentage; zero is completely transparent and 100 is completely opaque.

**Select Vertex By group**

**Color and Illumination radio buttons** These buttons determine whether to select vertices by vertex color values or vertex illumination values.

**Color Swatch** Displays the Color Selector, where you can specify a color to match.
Select Depending on which radio button is selected, selects all vertices whose vertex color or illumination values either match the color swatch, or are within the range specified by the RGB spinners.

Range Specifies a range for the color match. All three RGB values in the vertex color or illumination must either match the color specified by the Color swatch in Select By Vertex Color, or be within plus or minus the values in the Range spinners. Default=10.

Editable Patch (Handle)

Select an editable patch > Modify panel > Expand the editable patch in the stack display > Handle sub-object level

Select an editable patch > Modify panel > Selection rollout > Handle button

Select an editable patch > Right-click the patch > Tools 1 (upper-left) quadrant of the quad menu > Sub-objects > Handle

The Handle sub-object level in Editable Patch provides direct access to vertex handles, or vectors, without going through the Vertex sub-object level. Handles are still accessible at the Vertex sub-object level, but the Handle level provides enhanced functionality as follows:

- The ability to select multiple handles for transformation and application of operations such as Patch Smooth to them.
- Usage of the transform gizmo when manipulating handles.
- Elimination of the possibility of inadvertently transforming vertices.
- Support for named selection sets of handles.
- Copying and pasting handles.
- Use the Align tool on page 967 for aligning handles.
See Geometry Rollout (Patch) on page 2394 for detailed descriptions of these controls.

**Editable Patch (Edge)**

Select an editable patch > Modify panel > Expand the editable patch in the stack display > Edge sub-object level

Select an editable patch > Modify panel > Selection rollout > Edge button

Select an editable patch > Right-click the patch > Tools 1 (upper-left) quadrant of the quad menu > Sub-objects > Edge

An edge is the portion of a patch object between two adjacent vertices. When at the Editable Patch (Edge) level, you can select single and multiple segments and move, rotate, and scale them using standard methods. You can also hold down the Shift key and drag an edge to create a new patch. Holding down the Shift key during edge extrusion creates a new element.

**Procedures**

**To unlock interior edges:**

When you move an outer or boundary edge of a patch, the adjacent interior edges are normally “locked” so that they move in parallel with the boundary edge. This is often useful, because it provides a uniform transition across the patch. This default is known as Auto Interior.

- **At Patch level** on page 2385, you can change the default on a patch-by-patch basis by right-clicking a patch and choosing Manual Interior from the Tools 1 (upper-left) quadrant of the quad menu. Thereafter, when you move a boundary edge, interior edges are affected in a nonlinear way. The interior edges are no longer locked to the boundary edge.

**WARNING** If you return a patch to the default, changes caused by Manual Interior are lost.
Interface

Selection rollout

Select Open Edges Selects all edges that are used by only one patch. You can use this to troubleshoot a surface; open edges will be highlighted.

For information on the other controls in this rollout, see Selection Rollout (Editable Patch) on page 2366.

Soft Selection rollout

Geometry rollout

Subdivision
- Subdivide
- Propagate
- Bind
- Unbind

Topology
- Add Tilt
- Add Quad
- Create
- Detach
- Detach
- Propagate
- Copy
- Attach
- Delete
- Break
- Hide
- Unhide All

Weld
- Selected
- Target
- 4 pixels

Extrude & Bevel
- Extrude
- Bevel
- Extusion
- 0.0
- Beveling
- 0.0

Normal:
- Group
- Local

Bevel Smoothing:
- Start
- End
- Smooth
- Smooth
- Linear
- Linear
- None
- None

Target:
- Copy
- Paste
- Paste Length

Surface
- View Steps: 5
- Render Steps: 5
- Show Interior Edges
- Use True Patch Normals

Miscellaneous:
- Create Shape
- Patch Smooth
See Geometry Rollout (Patch) on page 2394 for detailed descriptions of these controls.

**Editable Patch (Patch)**

Select an editable patch > Modify panel > Expand the editable patch in the stack display > Patch sub-object level

Select an editable patch > Modify panel > Selection rollout > Patch button

Select an editable patch > Right-click the patch > Tools 1 (upper-left) quadrant of the quad menu > Sub-objects > Patch

A patch is an area of a patch object, defined by three or four surrounding edges and vertices. Controls described in this topic let you manipulate a patch object at the patch level. As well as moving and rotating patches, you can create a separate element by holding down the Shift key during a move operation. This creates a separate element of the selected patches.

**Texture Mapping Patches: Interpolation in Curved Space**

Patches can now be mapped in curved space; this means simplified texture mapping for patches. A planar map on a complex patch object will not be distorted. At the Patch sub-object level there is a parameter in the right-click quad menu (Tools 1 quadrant) called Linear Mapping. If you leave Linear Mapping off, then textures are interpolated in curved space and behave much like texture mapping a mesh object, predictably.

In the old method, patch mapping is interpolated between the knot points. This works well with procedural maps but not so well with bitmaps, since each patch is linear in UV space.
A complex patch (on right) no longer deforms a bitmap

The two leftmost patches show Linear patch mapping. The top left patch is a patch with planar mapping and the bottom left shows its UVW space representation. The patch on the right is a curved projection where the vectors are used in UVW space projection. Notice the bottom right represents the UVW space and notice how the handles and knots contribute to the shape of the UVW space.

In short, leave the Linear option off for predictable planar maps. Leave the linear mapping option on for backward compatibility.

**NOTE** The Unwrap UVW modifier now supports the new patch curve mapping. Spline handles can be manipulated in the Edit dialog in the Unwrap UVW modifier.
Interface

Selection rollout

For information on the controls in this rollout, see Selection Rollout (Editable Patch) on page 2366.

Soft Selection rollout

Geometry rollout

- Subdivision
  - Subdivide
  - Propagate
  - Blend
  - Unblend

- Topology
  - Add Tri
  - Add Quad
  - Create
  - Detach
  - Orient
  - Copy
  - Attach
  - Orient
  - Copy
  - Delete
  - Break
  - Hide
  - Unhide All

- Weld
  - Selected
  - Target

- Extrude & Bevel
  - Extrude
    - Amount: 0.0
  - Bevel
    - Amount: 0.0

- Normal
  - Group
  - Local

- Bevel Smoothing
  - Start
  - End
  - Smooth
  - Smooth
  - Linear
  - Linear
  - None
  - None

- Tangent
  - Copy
  - Paste

- Surface
  - View Steps: 5
  - Render Steps: 5
  - Show Interior Edges
  - Use True Patch Normals

- Miscellaneous
  - Update Shape
  - Patch Smooth
See Geometry Rollout (Patch) on page 2394 for detailed descriptions of these controls.

**Surface Properties rollout**

These controls let you work with patch normals, material IDs, smoothing groups and vertex colors.

**Normals group**

**Flip** Reverses the direction of the surface normals of the selected patches.
**Unify** Flips the normals of an object so that they all point in the same direction, usually outward. This is useful for setting an object’s patches to appropriate orientations, thus eliminating apparent holes in the object surface.

**Flip Normal Mode** Flips the normal of any patch you click. To exit, click this button again or right-click anywhere in the 3ds Max interface.

**TIP** The best way to use Flip Normal Mode is to set up your viewport to display with Smooth+Highlight and Edged Faces on. If you use Flip Normal Mode with default settings, you’ll be able to flip a patch away from you, but you won’t be able to flip it back. For best results, turn off Ignore Backfacing in the Selection rollout. This lets you click any patch and flip the direction of its normal, regardless of its current direction.

**Material group**

These controls let you use multi/sub-object materials with patches.

**Set ID** Lets you assign a particular material ID number to selected patches for use with multi/sub-object materials and other applications. Use the spinner or enter the number from the keyboard. The total number of available IDs is 65,535.

**Select ID** Selects patches or elements corresponding to the Material ID specified in the adjacent ID field. Type or use the spinner to specify an ID, then click the Select ID button.

[Select By Name] This drop-down list shows the names of sub-materials if an object has a Multi/Sub-Object material assigned to it. Click the drop arrow and choose a sub-material from the list. The patches or elements that are assigned that material are selected. If an object does not have a Multi/Sub-Object material assigned, the name list is unavailable. Likewise, if multiple objects are selected that have an Edit Patch, Edit Spline, or Edit Mesh modifier applied, the name list is inactive.

**NOTE** Sub-material names are those specified in the Name column on the material’s Multi/Sub-Object Basic Parameters rollout; these are not created by default, and must be specified separately from any material names.

**Clear Selection** When on, choosing a new ID or material name deselects any previously selected patches or elements. When off, selections are cumulative, so new ID or sub-material name selections add to the existing selection set of patches or elements. Default=on.
**Smoothing Groups group**

Use these controls to assign selected patches to different smoothing groups on page 8724, and to select patches by smoothing group.

To assign patches to one or more smoothing groups, select the patches, and then click the number(s) of the smoothing group(s) to assign them to.

**Select by SG (Smoothing Group)** Displays a dialog that shows the current smoothing groups. Select a group by clicking the corresponding numbered button and clicking OK.

**Clear All** Removes any smoothing group assignments from selected patches.

**Edit Vertex Colors group**

Use these controls to assign the color, illumination color (shading), and alpha (transparency) values of vertices on the selected patch(es).

**Color** Click the color swatch to change the color of vertices on the selected patch(es).

**Illumination** Click the color swatch to change the illumination color of vertices on the selected patch(es). This lets you change the color of shadows without changing the vertex colors.

**Alpha** Lets you assign an alpha (transparency) value to vertices on the selected patch(es).

The spinner value is a percentage; zero is completely transparent and 100 is completely opaque.

---

**Editable Patch (Element)**

Select an editable patch > Modify panel > Expand the editable patch in the stack display > Element sub-object level

Select an editable patch > Modify panel > Selection rollout > Element button

Select an editable patch > Right-click the patch > Tools 1 (upper-left) quadrant of the quad menu > Sub-objects > Element

Use the Element sub-object level when you want to select and work on all contiguous faces in an element. The Element sub-object level is essential when you are Shift+cloning and Shift+extruding patches, because doing so creates separate elements. For example, if you select a patch, hold down the Shift key,
and move the patch to a new location, a new element is created separate from
the original. This also applies to extrusion. If you hold the Shift key down
while you extrude, a new element is created.

**NOTE** In some cases, you might find that moving a patch element causes parts
of it to move by differing amounts. This typically occurs because the object is set
to Manual Interior. It happens, for instance, when you convert a sphere primitive
to an editable patch object. To remedy this, select the element, and then right-click
it to display the quad menu, and in the Tools1 quadrant, choose Auto Interior.

**Interface**

**Selection rollout**

For information on the controls in this rollout, see *Selection Rollout (Editable
Patch)* on page 2366.

**Soft Selection rollout**

See *Soft Selection Rollout* on page 2014 for information on the Soft Selection
rollout settings.
Geometry rollout

- Subdivision
  - Subdivide
  - Bind
  - Unbind

- Topology
  - Add Tile
  - Add Quad
  - Detach
  - Attach
  - Delete
  - Hide
  - Unhide All

- Weld
  - Selected
  - Target

- Extrude & Bevel
  - Extrude
  - Bevel
  - Extrusion
  - Outlining

- Normal
  - Group
  - Local

- Bevel Smoothing
  - Start
  - End
  - Smooth
  - Linear
  - None

- Length
  - Copy
  - Paste

- Surface
  - View Steps
  - Render Steps
  - Show Interior Edges
  - Use True Patch Normals

- Miscellaneous
  - Locate Shape
  - Patch Smooth
See Geometry Rollout (Patch) on page 2394 for detailed descriptions of these controls.

**Geometry Rollout (Patch)**

Select an editable patch > Modify panel > Geometry rollout

The Geometry rollout for Patches contains most of the controls that let you alter the geometry of the patch, at either the Object (top) level, or one of the sub-object levels. The controls that the rollout displays can vary, depending on which level is active; if a control is not available for the active level, it might be grayed out, or simply might not appear at all. The descriptions below indicate the levels at which controls are available.
Interface

- Geometry
  - Subdivision
    - Subdivide
    - Unsubdivide
  - Propagate
  - Bind
  - Unbind

- Topology
  - Add Tli
  - Add Quad
  - Detach
  - Recent Copy
  - Attach
  - Recent
  - Delete
  - Block
  - Hide
  - Unhide All

- Weld
  - Selected
  - Target

- Extrude & Bevel
  - Extrude
  - Bevel
  - Extrusion
  - Outlining

- Normal
  - Group
  - Local
  - Bevel Smoothing
    - Start
    - End
    - Smooth
    - Linear
    - None

- Target
  - Copy
  - Paste

- Scale Length

- Surface
  - View Steps
  - Render Steps
  - Show Interior Edges
  - Use True Patch Normals

- Miscellaneous
  - Locate Shape
  - Patch Smooth
Subdivision group (Vertex, Edge, Patch, and Element levels only)

Bind (Vertex level only) Lets you create a seamless, gapless connection between two patch edges that have unequal numbers of vertices. The two patches must belong to the same object, and the vertex need not be selected first. Click Bind, then drag a line from an edge-based vertex (not a corner vertex) to the edge you want to bind it to. The cursor turns into a white cross when over a legal edge.

Binding patch edges

To exit Bind mode, click the Bind button again, or right-click in the active viewport.

**TIP** When connecting two patches edge-to-edge, first line up as many pairs of vertices as possible, and use Weld to connect them. Then use Bind to connect the remaining vertices. Bound vertices cannot be manipulated directly, although their handles can.

**NOTE** Bind is useful for connecting patch objects with different patch resolutions, such as a head and a neck, without the need to create additional patches in the lower-resolution object.

Unbind (Vertex level only) Disconnects a vertex connected to a patch with Bind. Select the vertex, and then click Unbind.
Subdivide (Edge, Patch, and Element levels only) Subdivides the selected sub-objects.

- **Propagate** When on, extends the subdivision to neighboring patches. Propagating the subdivisions along all contiguous patches prevents patch cracks where you have attached patches together.

**Topology group**

**Add Tri / Add Quad (Edge level only)** You can add Tri and Quad patches to any open edge of an object. On closed objects such as spheres, you can delete one or more existing patches to create open edges, and then add new patches. The new patches adapt to the existing geometry. For example, when you add a patch to a curved edge, the new patch follows that curve and seamlessly extends it.
Add Tri adds a three-sided patch to each selected edge. Select one or more edges, then click Add Tri to add the patch or patches.

Add Quad adds a four-sided patch to each selected edge. Select one or more edges, and then click Add Quad to add the patch or patches.

Create (Vertex, Patch, and Element levels only) Lets you add geometry to the patch object. Available at Vertex, Patch, and Element sub-object levels only.
At the Vertex sub-object level, turn on Create and then click anywhere to add vertices to the object.

At the Patch and Element levels, you can add three- and four-sided patches. The cursor changes to white cross hairs when over an existing patch vertex. Select an existing vertex by clicking it. Click in free space to create a new vertex at that location; this vertex is included in the sequence of vertices for the new patch.

- **To create a Tri Patch**: Click three times in free space or on existing vertices. Right-click anywhere, or left-click one of the vertices in the current sequence to complete the creation of a Tri Patch.

- **To create a Quad Patch**: Click four times in free space or on existing vertices. The Quad Patch is automatically created at the fourth click.

No operation takes place if you right-click or select a vertex in the current sequence with only one or two vertices in the sequence.

**Detach** *(Patch and Element levels only)* Let you select one or more patches or elements within the current object and then detach them (or copy them) to form a separate patch object.

- **Reorient** When on, the detached patch or element copies the position and orientation of the source object’s Local coordinate system (when the source object was created). The new detached object is moved and rotated so that its Local coordinate system is positioned and aligned with the origin of the current active grid.

- **Copy** When on, the detached patches or elements are copied to a new patch object, leaving the originals intact.

**Attach** Lets you attach an object to the currently selected patch object. Click the object you want to attach to the currently selected patch object. If you attach a non-patch object, the object is converted to a patch object.

When you attach an object, the materials of the two objects are combined in the following way:

- If the object being attached does not have a material assigned, it inherits the material of the object it is being attached to.

- Likewise if the object you're attaching to doesn’t have a material, it inherits the material of the object being attached.

- If both objects have materials, the resulting new material is a [multi/sub-object material](#) on page 6120 that encompasses the input materials. A dialog appears offering three methods of combining the objects' materials.
and material IDs. For more information, see Attach Options Dialog on page 2233.

Attach remains active in all sub-object modes, but always applies to objects.

**Top: Original patch object with rendering**

**Bottom: Rendering with another patch attached**

**Reorient** When on, reorients the attached element so that each patch’s creation local coordinate system is aligned with the creation local coordinate system of the selected patch.

**Delete (Vertex, Edge, Patch, and Element levels only)** Deletes the selected sub-objects.
WARNING Delete vertices or edges with caution. Deleting a vertex or edge also deletes the patches that share them. For example, if you delete the single vertex at the top of a spherical patch, the top four patches are also deleted.

**Break** (Vertex and Edge levels only) For vertices, breaks a vertex into multiple vertices. Use this if you need to split open an edge to add another patch or for general modeling operations. Select a vertex, and then click Break. After the break, select the individual vertices and move them to separate the edges. For edges, splits an edge. Use this if you need to split open an edge for general modeling operations. Select one or more edges, and then click Break. After the break, move the handles of adjacent vertices to create a gap in the patch.

**Hide** (Vertex, Edge, Patch, and Element levels only) Hides the selected sub-objects. For vertices and edges, Hide also hides the patches that are attached to them.

**NOTE** At least one patch in the object must remain visible.

**Unhide All** Restores any hidden sub-objects to visibility.

**Weld group** (Vertex and Edge levels only)

**Selected** Welds selected vertices that fall within the tolerance specified in the Weld Threshold spinner (to the right of the Weld button). Select the vertices you want to weld between two different patches, set the spinner to a sufficient distance, and click Selected.

At the Edge sub-object level, clicking Selected welds two edges that share vertices. You can use this to eliminate gaps on a surface.

**Target** (Vertex level only) Turn on and drag from one vertex to another to weld the vertices together. The dragged vertex fuses to the target vertex. The pixels spinner to the right of the Target button sets the maximum distance in screen pixels between the mouse cursor and the target vertex.

**Extrude & Bevel group** (Edge, Patch, and Element levels only)

These controls let you extrude and bevel edges, patches, or elements. Extruding patches moves them along a normal and creates new patches that form the sides of the extrusion, connecting the selection to the object. Beveling adds a second step that lets you scale the extruded patches. You can extrude and bevel patches by dragging or by direct entry. You can also hold down the Shift key during extrusion, which creates a separate element.
**NOTE** Sides created by beveling or extrusion are assigned to smoothing group 1.

**Extrude** Click this button, and then drag any edge, patch, or element to extrude it interactively. Hold down the Shift key during this operation to create a new element.

When the mouse cursor is over a selected patch or element, it changes to an Extrude cursor.

**Bevel (Patch and Element levels only)** Click this button, and then drag any patch or element to extrude it interactively, then click and release the mouse button, and drag again to bevel the extrusion. Hold down the Shift key during this operation to create a new element.

When the mouse cursor is over a selected element, it changes to a Bevel cursor.
NOTE In some cases, particularly with closed objects (objects with no holes or open edges), the second bevel step might not produce visible results.

**Extrusion** This spinner sets whether the extrusion is outward or inward, depending on whether the value is positive or negative.

**Outlining (Patch and Element levels only)** This spinner lets you scale selected patches or elements bigger or smaller, depending on whether the value is positive or negative. It is normally used after an extrusion for beveling the extruded patches.
Normal If Normal is set to Local (the default), extrusion takes place along the normal of each selected edge, patch, or individual patch in an element. If normal is set to Group, extrusion takes place along the averaged normal of each contiguous group in a selection. If you extrude multiples of such groups, each group moves along its own averaged normal.

Bevel Smoothing (Patch and Element levels only) These settings let you set the shape of the intersection between the surface created by a beveling operation and the neighboring patches. The shapes are determined by the handle configurations of vertices at the intersections. Start refers to the intersection between the sides and the patches surrounding the beveled patch. Finish refers to the intersection between the sides and the beveled patch or patches. The following settings are available for each:

- **Smooth**  Vertex handles are set so the angles between the new patches and their neighbors are relatively small.
- **Linear**  Vertex handles are set to create linear transitions.
- **None**  Vertex handles are not modified.

**WARNING** Set Bevel Smoothing before the bevel is performed; changing the setting has no effect on existing beveled patches.

Tangent group (Vertex and Handle levels only)

These controls let you copy orientation, and optionally length, between handles on the same object, or on different objects applied with instances of the same Edit Patch modifier. The tool doesn't support copying handles from one patch object to another, or between spline and patch objects.

**Copy**  Copies a patch handle’s transform settings to a copy buffer. When you click Copy, 3ds Max displays all handles on the selected object. When the mouse cursor is over a handle end, the cursor image changes to the one shown below. Click a handle end to copy its direction and length to the paste buffer; this also exits Copy mode.

**Paste**  Pastes orientation information from the copy buffer to a vertex handle. If Paste Length is on, it also pastes the length of the copied handle. When you click Paste, 3ds Max displays all handles on the selected object. When the mouse cursor is over a handle end, the cursor image changes to the
one shown below. Click a handle end to paste the information from the buffer to the handle. You can continue clicking other handle ends to paste the information repeatedly. To exit Paste mode, right-click in the viewport or click the Paste button.

**Copy Length / Paste Length** When on and you use Copy, the length of the handle is also copied. When on and you use Paste, the length of the originally copied handle is pasted as well as its orientation. When off, only the orientation is copied or pasted.

**Surface group**

**View Steps** Controls the grid resolution of the patch model surface as depicted in the viewports. Range=0 to 100. Default=5.

**Render Steps** Controls the grid resolution of the patch model surface when rendered. Range=0 to 100. Default=5.
**Show Interior Edges** Enables the display of the patch object's interior edges in wireframe views. When off, only the object's outline is visible. Turn on to simplify the display for faster feedback.

**Use True Patch Normals** Determines how 3ds Max smooths the edges between patches. Default=off.

When the check box is off, 3ds Max computes the surface normals from the smoothing groups of the mesh object to which the patch object is converted before rendering. These normals are not accurate, especially with a low View/Render Steps setting. When the check box is on, 3ds Max computes true patch normals directly from the patch surfaces, which can generate more accurate shading.

In the illustration below, a sphere was converted to Editable Patch format, and then a vertex was moved toward the center and rotated. The sphere on
the left has Use True Patch Normals turned off, and the one on the right has it turned on. In both cases, View Steps was set to 8.

A patch sphere with Use True Patch Normals off (left) and on (right).

**Miscellaneous group**

**Create Shape (Edge level only)** Creates splines based on the selected edges. If no edges are selected, then splines are created for all the patch edges. 3ds Max prompts you for a name: Type in a name for the new shape object, and then click OK.

Each patch edge forms an individual spline. You can use this to create a spline cage based on patch edges. This is useful for spline modeling or working with surface tools.

**Patch Smooth** At the sub-object level, adjusts the tangent handles of the vertices of selected sub-objects to smooth the surface of the patch object. At the object level, adjusts all tangent handles to smooth the surface.

Patch Smooth sets the handles to absolute positions based on the patch object geometry; repeated applications have no effect.
Patch Grids

Create panel > Geometry > Patch Grids
Create menu > Patch Grids

You can create two kinds of patch surfaces in grid form: Quad Patch and Tri Patch. Patch grids begin as flat plane objects but can be modified into arbitrary 3D surfaces by either using an Edit Patch modifier or collapsing the grid’s modifier stack down to an Editable Patch in the Modify panel.

Patch grids provide convenient "building material" for custom surfaces and objects, or for adding patch surfaces to existing patch objects.

You can animate the surface of a Patch object using various modifiers such as the Flex and Morph modifiers. Control vertices and tangent handles of a patch surface can be animated with an Editable Patch modifier.

Surface Tools

The output of the Surface modifier on page 1763 is a Patch object. Patch objects offer a flexible alternative to mesh and NURBS modeling and animation.
Editable Patches

You can convert a basic patch grid to an editable patch object on page 2360. The editable patch has a variety of controls that let you directly manipulate it and its sub-objects. For example, at the Vertex sub-object level, you can move vertices or adjust their Bezier handles. Editable patches let you create surfaces that are less regular, more free-form than the basic, rectangular patches.

When you convert a patch to an editable patch, you lose the ability to adjust or animate its creation parameters.

See also:

- Edit Modifiers and Editable Objects on page 1052
- Modifying at the Sub-Object Level on page 1054
- Modifier Stack Controls on page 8187

Procedures

To create a patch grid:

1. On the Create panel > Geometry > Patch Grids > Object Type rollout, click either Quad Patch or Tri Patch.
2. Drag over any viewport to create a patch.
Interface

AutoGrid Uses surface normals as a plane to create patches. Click a patch type and then click and drag the cursor over a face in the viewports.

Quad Patch

Create panel > Geometry > Patch Grids > Quad Patch
Create menu > Patch Grids > Quad Patch
Quad Patch creates a flat grid with a default of 36 visible rectangular facets. A hidden line divides each facet into two triangular faces for a total of 72 faces.
Procedures

To create a patch grid:

1. On the Create panel > Geometry > Patch Grids > Object Type rollout, click either Quad Patch or Tri Patch.
2. Drag over any viewport to define a length and width for the patch.

To edit a Quad Patch:

1. Select a Quad Patch.
2. On the Modify panel, right-click Quad Patch in stack view and choose Editable Patch.
   The Quad Patch collapses to an Editable Patch.
4. In any viewport, select a vertex on the patch object, and move the vertex to change the surface topology.
   Vertices and vectors can be animated with an Editable Patch modifier.

At the sub-object Edge level, you can add patches along any edge. You can create complex patch models beginning from a single patch.

An ear is created by adding patches and editing patch vertices
Interface

Name and Color rollout

The Name and Color rollout on page 8182 lets you rename objects and change their wireframe color.

Keyboard Entry rollout

X/Y/Z Sets the patch center.
Length Sets the patch length.
Width Sets the patch width.
Create Creates a patch based on the XYZ, Length, and Width values.
Parameters rollout

Length, Width Sets the grid dimensions in current units.

Length, Width Segments Determines the number of facets along the length and width of the grid. Default=1.
The density of a Quad Patch rises sharply as you increase the segments. A Quad Patch of two segments on a side contains 288 faces. The maximum is 100 segments. High segment values can slow performance.

Generate Mapping Coordinates Creates map coordinates for applying mapped materials. Default=off.

Tri Patch

Create panel > Geometry > Patch Grids > Tri Patch
Create menu > Patch Grids > Tri Patch

Tri Patch creates a flat grid with 72 triangular faces. The face count remains at 72, regardless of its size. The faces become larger to fill the area as you increase the size of the grid.
Tri Patch

Procedures

To create a Tri Patch:

1. On the Create panel > Geometry > Patch Grids > Object Type rollout, click Tri Patch.
2. Drag over any viewport to create the patch.

To edit a Tri Patch:

1. Select a Tri Patch.
2. On the Modify panel, right-click TriPatch in stack view, and choose Editable Patch.
   The Tri Patch collapses to an Editable Patch.
3. In the Editable Patch Selection rollout, click Vertex.
4. In any viewport, select a vertex on the patch object and move the vertex to change the surface topology.
You can animate vertices and vectors with an Editable Patch modifier.

**Interface**

- **Name and Color rollout**
  The Name and Color rollout on page 8182 lets you rename objects and change their wireframe color.

- **Keyboard Entry rollout**
  X/Y/Z Sets the patch center.

  X: 0.0
  Y: 0.0
  Z: 0.0

  Length: 0.0
  Width: 0.0

  Create

- **Parameters**
  Length: 0.0
  Width: 0.0

  Generate Mapping Coords.
**Length** Sets the patch length.

**Width** Sets the patch width.

**Create** Creates a patch based on the XYZ, Length, and Width values.

**Parameters rollout**

**Length**, **Width** Sets dimensions of grid in current units.

**Generate Mapping Coordinates** Creates map coordinates for applying mapped materials. Default=off.

---

**NURBS Modeling**

3ds Max provides NURBS surfaces and curves. NURBS stands for *Non-Uniform Rational B-Splines*. NURBS have become an industry standard for designing and modeling surfaces. They are especially suited for modeling surfaces with complicated curves.

The tools for modeling with NURBS do not require an understanding of the mathematics that produces these objects. NURBS are popular because they are easy to manipulate interactively, and because the algorithms that create them are both efficient and numerically stable.
You can also model surfaces using polygonal meshes or patches. Compared to NURBS surfaces, meshes and patches have these shortcomings:

- Using polygons can make it more difficult to create complicated curved surfaces.
- Because meshes are faceted, facets appear at the edge of rendered objects. You must have a large number of small faces to render a smoothly curved edge.

NURBS surfaces, on the other hand, are analytically generated. They are more efficient to calculate, and you can render a NURBS surface that appears to be seamless. (A rendered NURBS surface is actually approximated by polygons, but the NURBS approximation can be very fine grained.)

**NURBS Models: Objects and Sub-Objects**

Like Shape on page 572 objects, a NURBS model can be an assemblage of multiple NURBS sub-objects. For example, a NURBS object might contain two
surfaces that are separate in space. NURBS curves and NURBS surfaces are controlled by either point or control vertex (CV) sub-objects. Points and CVs behave somewhat like the vertices of spline objects, but there are differences.

The parent object in a NURBS model is either a NURBS surface or a NURBS curve. Sub-objects can be any of the objects listed here. A NURBS curve remains a Shape object unless you add a surface sub-object to it when you convert it to a NURBS surface (without changing its name).

**Surfaces** There are two kinds of NURBS surfaces. A point surface is controlled by points, which always lie on the surface. A CV surface is controlled by control vertices (CVs). Instead of lying on the surface, CVs form a control lattice that surrounds the surface. (This is similar to the lattice used by the FFD [free-form deformation] modifiers.)

See Creating Surface Sub-Objects on page 2603 and Editing Surface Sub-Objects on page 2530.

**Curves** There are also two kinds of NURBS curves. These correspond exactly to the two kinds of surfaces. A point curve is controlled by points, which always lie on the curve. A CV curve is controlled by CVs, which don't necessarily lie on the curve.

See Creating Surface Sub-Objects on page 2603 and Editing Curve Sub-Objects on page 2518.

**Points** Point surfaces and point curves have point sub-objects. You can also create separate point sub-objects that are not part of a surface or a curve.

See Creating and Editing Point Sub-Objects on page 2694.

**CVs** CV surfaces and CV curves have CV sub-objects. Unlike points, CVs are always part of a surface or a curve.

See Editing Curve CV Sub-Objects on page 2503 and Editing Surface CV Sub-Objects on page 2509.

**Imports** Imports are 3ds Max objects, including other NURBS objects. Within the NURBS model, they render as NURBS; but they retain their original parameters and modifiers.

See Attaching and Importing 3ds Max Objects on page 2490.

Sub-objects can be dependent on page 2433 sub-objects whose geometry is related to the geometry of other sub-objects.
Creating NURBS Models

There is a variety of ways to create NURBS models. These are various ways you can create a top-level, parent NURBS object:

- You can create a NURBS curve on page 2464 on the Shape on page 572 panel of the Create panel.
- You can create a NURBS surface on page 2454 on the Geometry on page 357 panel of the Create panel. When you use this technique, the NURBS surface is initially a flat rectangle. You can alter it using the Modify panel.
- You can turn a standard geometry primitive on page 388 into a NURBS object.
- You can turn a torus knot on page 426 into a NURBS object.
- You can turn a prism on page 458 extended primitive into a NURBS object.
- You can turn a spline on page 577 object (Bezier spline) into a NURBS object.
- You can turn a patch grid on page 2408 object (Bezier patch) into a NURBS object.
- You can turn a loft on page 742 object into a NURBS object.

To turn objects other than NURBS curves and surfaces into NURBS objects, use the Modify panel. Right-click the object’s name in the stack display (see Modifier Stack on page 8187) and choose Convert To: NURBS.

In viewports, the quad menu on page 8052 also lets you convert objects to NURBS. Select and then right-click the object, and in the Transform (lower-right) quadrant, choose Convert To: > Convert to NURBS.

- In addition, the modifiers Extrude on page 1425 and Lathe on page 1474 let you choose NURBS output, which creates a NURBS object.

Working with NURBS Models

When you work with NURBS models, usually you create one NURBS object as the “starter” object, then edit the starter object or add additional sub-objects.
Here is the two-step process in more detail:

- Create one NURBS object as the "starter" object. This can be a surface object, a curve object, or a converted geometry primitive, as described in Creating NURBS Models on page 2419. Often modelers like to identify a single, master surface as the main component of the model. Converted geometry primitives are good if you want the starter surface to become the master surface. See Creating NURBS Surfaces from Geometric Primitives on page 2483. Point and CV surfaces are good as starters for rectangular surfaces.

- On the Modify panel, you can edit the original object, or you can create additional sub-objects. See Using the NURBS Toolbox to Create Sub-Objects on page 2426. You might even choose to delete the original, starter object once you have built a model from newer sub-objects.

Going immediately to the Modify panel avoids the problem of creating additional top-level NURBS objects, which you can't use to build relational, dependent sub-objects. (The exception is using curves for loft and sweep surfaces. See U Loft Surface on page 2646, UV Loft Surface on page 2656, 1-Rail Sweep Surface on page 2663, or 2-Rail Sweep Surface on page 2673.)


**NURBS Surface Trimming**

To trim a surface is to use a curve on the surface to cut away part of the surface, or to cut a hole in the surface.

Before you trim a surface, you must create a curve on that surface. These are the kinds of curves that can trim surfaces:

- U iso and V iso curves on page 2584
- Surface-surface intersection curve on page 2578
- Normal projected curve on page 2586
- Vector projected curve on page 2589
Once you've created the curve, you trim the surface by turning on Trim in the curve sub-object's parameters. A Flip Trim control inverts the trim direction. The direction of the curve determines the initial direction of the trim. For example, a closed curve on surface created in a clockwise direction trims inward, creating a hole in the surface; while a closed curve on surface created in a counterclockwise direction trims outward, creating a curve-shaped portion of the surface.

When a surface is trimmed, its untrimmed version is still present in the 3ds Max scene. You can select it for the purposes of editing it, or replacing it as a parent to a dependent sub-object on page 2433. For details, see Sub-Object Selection on page 2428.

**Procedures**

**Example: To cut a hole in a CV surface:**

1. Create a CV surface in the Top viewport.
2. Create a closed CV curve sub-object that lies on top of (or above) the surface.
3. In the toolbox, turn on Normal Projected Curve, then in the Top viewport select first the CV curve, then the surface.
   This creates a projection of the CV curve that lies on the surface, and can trim it.
4. In the normal projected curve's parameters, click to turn on Trim.
   A hole appears in the surface. Depending on the orientation of the Normal Projected curve, you might see everything but the hole.
5. Use the Flip Trim toggle to invert the trim.

**NOTE** Trims aren't displayed in viewports if the NURBS surface's Surface Trims toggle is turned off on the General rollout's Display group box.
To select an untrimmed surface:

1 Make sure the Keyboard Shortcut Override toggle on page 8420 is on.

2 At the appropriate sub-object level or during a replace parent operation, press H. This opens the Select Sub-Objects dialog, which is a subset of the Selection Floater on page 209 that you can use during sub-object creation as well as sub-object selection.

3 If the untrimmed version is selectable at this level, the trimmed version appears as a "tree," with a plus sign next to it. Click the plus sign to expand the tree. The child is the untrimmed version. Highlight its name to select it.
Modifying NURBS Models and Creating Sub-Objects

You can edit NURBS immediately when you enter the Modify panel. You don’t have to apply a modifier, as you do for most kinds of 3ds Max objects.

While you are editing a NURBS object on the Modify panel, you can create sub-objects "on the fly," without having to go back to the Create panel. This is an exception to the way you usually use 3ds Max. The Modify panel for NURBS curve and NURBS surface objects includes rollouts that let you create new NURBS sub-objects.

Example: Rollout for creating NURBS surface sub-objects

**TIP** Another way to create curve and surface sub-objects is to use the NURBS Creation Toolbox on page 2426.
This is a summary of how to create sub-objects:

- An individual point sub-object is either an independent point or a dependent point tied to other NURBS geometry.

- Curve sub-objects are either independent point curves or CV curves, or they are dependent on page 8550 curves whose geometry is based on other curves or surfaces already present in the model. For example, a blend curve is a dependent curve sub-object that connects the endpoints of two other curves.

- Surface sub-objects are either independent point surfaces or CV surfaces, or they are dependent on page 8550 surfaces whose geometry is based on other surfaces or curves already present in the model. For example, a blend surface is a dependent surface sub-object that connects the edges of two other surfaces.

- You can attach 3ds Max objects. If the attached object is not already a NURBS object, it is converted to NURBS geometry. You can attach a NURBS curve, another NURBS surface, or a convertible 3ds Max object. The attached object becomes one or more curve or surface sub-objects.

- You can import 3ds Max objects. The imported object retains its parameters. While it is part of the NURBS object it renders as a NURBS, but you can still edit it parametrically at the Imports sub-object level. At this sub-object level, viewports display its usual geometry, not its NURBS form. A NURBS curve can import NURBS curves or spline curves. A NURBS surface can import curves, surfaces, or convertible 3ds Max objects.

**NOTE** You can detach a NURBS sub-object to make it a new, top-level NURBS object, and you can extract an imported object to create an independent, top-level object once again.

### Quad Menu for NURBS Objects

While a NURBS object is selected and the Modify panel is active, the quad menu on page 8052 displays two quadrants that are specifically for NURBS editing.
Quad menu for modifying NURBS models

**Tools 1 (upper-left) Quadrant**

These options are general display and sub-object level shortcuts.

- **Transform Degrade** Toggles Degradation Override on page 123.

- **Display Shaded Lattice, Display Lattices, Display Surfaces, and Display Curves** See Display Controls for NURBS Models on page 2486.

- **Sub-objects** Displays the sub-object choices for the selected object, as well as a Top-level choice.
Tools 2 (lower-left) Quadrant

These options are creation and editing shortcuts.

Create CV Surface, Create CV Curve, Create Point Surface, Create Point Curve These create a new NURBS sub-object.

Insert CV Row, Insert CV Column, Refine CV Curve, Refine CV Row These add CVs to a CV Surface sub-object by inserting or refining. For the difference between inserting and refining, see Editing Surface CV Sub-Objects on page 2509. See NURBS Concepts on page 2440 for more information about refining.

Using the NURBS Toolbox to Create Sub-Objects

Modify panel > Select NURBS object. > General rollout > NURBS Creation Toolbox button

Keyboard > Ctrl+T (Keyboard Shortcut Override Toggle must be on.)

Besides using rollouts at the NURBS object level, you can use the NURBS toolbox to create sub-objects.
Interface

The toolbox contains buttons for creating NURBS sub-objects. In general, the toolbox behaves like this:

- While the button is on, the toolbox is visible whenever a NURBS object or sub-object is selected and you are on the Modify panel. It disappears whenever you deselect the NURBS object or make a different panel active. When you return to the Modify panel and select a NURBS object, it reappears.

- You can use the toolbox to create sub-objects from either the top, object level, or from any NURBS sub-object level.

- When you turn on a toolbox button, you go into creation mode, and the Modify panel changes to show the parameters (if there are any) for the kind of sub-object you are creating. Other NURBS rollouts aren't displayed while you create the new sub-object. This differs from using the NURBS object’s Create rollouts or the NURBS right-click menu on page 2424.

NURBS Models: Objects and Sub-Objects | 2427
If you are at the top, object level and use the toolbox to create a sub-object, you must then go to the sub-object level to edit the new sub-object. (This is the same as using the buttons on the rollouts.)

If you are at a sub-object level and use the toolbox to create an object of the same sub-object type, you can edit it immediately after you turn off the create button (or right-click to end object creation).

If you are at a sub-object level and use the toolbox to create an object of a different sub-object type, you must change to that sub-object level before you can edit the new sub-object.

The individual creation buttons are described in these topics:

- Creating and Editing Point Sub-Objects on page 2694
- Creating Curve Sub-Objects on page 2549
- Creating Surface Sub-Objects on page 2603

**NURBS Sub-Object Selection**

When you work with NURBS models, you often work with sub-objects. While you are at the sub-object level, you use the usual selection techniques, such as clicking, dragging a region, or holding down Ctrl, to choose one or more sub-objects.

You can also select NURBS point, curve, and surface sub-objects by name. Turn on the Keyboard Shortcut Override Toggle on page 8420, go to a NURBS sub-object level, and then press the H key. This opens the Select Sub-Objects dialog, which is a subset of the Selection Floater on page 209 that lists only sub-objects at the current level. Choose one or more objects in the list, and then click Select. You can assign your own names to NURBS sub-objects (aside from CVs) that you want to edit frequently.

**TIP**

Press Ctrl+H to have the Select Sub-Objects dialog list only sub-objects directly beneath the mouse cursor.

**TIP**

The H shortcut is also a convenient way to choose parent objects while you’re creating dependent sub-objects.
Workflow Tips

When you work with NURBS, you switch frequently between the object and sub-object levels, or from one sub-object level to another. Keyboard shortcuts and pop-up menus can help you do this.

- The Sub-Object Selection Toggle (default: Ctrl+B) switches between object and sub-object levels.
- The Cycle Sub-Object Level shortcut (default: Insert) switches from one sub-object level to another.
- When you right-click in a viewport while a NURBS object is selected and the Modify panel is active, the quad menu lets you switch between various levels of the NURBS model: Top Level, Surface CV Level, Surface Level, Curve CV Level, Point Level, Curve Level, and Imports Level.
- The command panel’s right-click popup menu (available whenever the mouse cursor becomes a pan hand) helps you navigate the rollouts on the current command panel. If you have a three-button or wheel mouse, rolling the wheel scrolls the command panel.
- Sub-object selection sets are persistent. If you go to a different sub-object level, when you return to the previous level, your selection is still available. However, refining or inserting points or CVs makes the sub-object selection sets invalid for that object.
- You can move a sub-object selection set among sub-objects at the active level of the NURBS model by holding down Ctrl while you press the arrow keys.
- When you select surface CV sub-objects that are "on top of" each other in a 3D view, sometimes all the selected CVs fail to highlight. To fix this, choose Customize > Viewport Configuration on page 8374, and turn on Z-buffer Wireframe Objects.

CV Sub-Objects and Point Sub-Objects

Independent curves and independent surfaces both come in two varieties: they are either CV sub-objects or point sub-objects. This topic describes the differences between the two.
CV Curves and CV Surfaces

CV curves and CV surfaces have control vertices (CVs) as do splines. The position of the CVs controls the shape of the curve or the surface. However, unlike spline vertices, CVs don’t necessarily lie on the curve or surface they define. The CVs define a control lattice that connects the CVs and surrounds the NURBS curve or surface. The control lattice displays in lines that are yellow by default.

Cone-shaped NURBS surface with its control lattice (CVs are displayed as green squares)

**TIP** When you use Zoom Extents, the entire extents of a NURBS object are displayed, including its control lattice. Because CVs can be located some distance from an object, the curve or surface itself (the object’s renderable geometry) is sometimes hard to see. If this happens, use Zoom Region or Field of View to zoom in.

You can move a CV at the Curve CV or Surface CV sub-object level on the Modify panel. Other transforms, rotate and scale, work as well. Rotate and scale are useful mainly when you have selected multiple CVs.
Moving and rotating CVs to change a surface (selected CVs are displayed in red)

Each CV also has a weight, which you can use to adjust the CV’s effect on the curve or surface. Increasing the weight pulls the surface toward the CV. Decreasing the weight relaxes the surface away from the CV.
Weights can be a useful way to "tune" the appearance of a NURBS curve or surface.

The weight value of a CV is rational (as in a "rational number"). That is, it is relative to other CVs in the curve or surface. Changing the weight of all CVs at once has no effect, because it doesn’t change the ratio between weights.

**Points, Point Curves, and Point Surfaces**

Point curves and point surfaces are similar to CV curves and surfaces, but the points that control them are required to lie on the curve or surface. Unlike CVs, points do not have a weight.

Point curves and point surfaces can be more intuitive to create and work with. However, working with point sub-objects is slower than working with CV sub-objects. You can think of a point curve or point surface as being dependent on the points to which it fits.

Points that you create individually are the same as the points on point curves and surfaces, except that initially they aren’t part of a curve or surface. You can create a point curve by fitting it to points that you select. When you fit the new point curve, you can use points that are part of curves or surfaces, and individual point sub-objects.
Dependent Sub-Objects (NURBS)

A NURBS sub-object is either independent or dependent. A dependent sub-object is based on the geometry of other sub-objects. For example, a blend surface smoothly connects two other surfaces. Transforming or animating either of the original, parent surfaces causes the shape of the blend to change as it maintains a connection between the parents.

The immediate, interactive relation between the parent and dependent sub-objects is known as relational modeling. Relational modeling is one of the reasons NURBS models can be particularly easy to change or to animate.

IMPORTANT Dependent sub-objects must have parents that are also sub-objects of the same NURBS model. Dependent relationships can’t exist between object-level NURBS curves or surfaces. If you want to use a top-level NURBS object to create a dependent object, first you must attach or import the top-level object. See Attaching and Importing 3ds Max Objects on page 2490.

You have the option of making a dependent sub-object independent. After you do so, the sub-object is no longer related to its parents. Changes to the former parents don’t affect it, but you can edit and transform it as an independent sub-object in its own right.
At the appropriate sub-object level, dependent NURBS are displayed in green in wireframe viewports. (You can change the display color using the Colors panel of the Customize User Interface dialog on page 8249.)

Relational modeling does add computation time to a model, so when you transform or edit dependent sub-objects in other ways, often you will notice a slowdown in performance. Once a dependent surface sub-object has the shape you want, you can improve performance by making it into a rigid surface on page 2436.

**Transforming Dependent Sub-Objects**

In general, you can select and transform dependent sub-objects, but the effect of the transform depends on the sub-object type. Some dependent objects have a gizmo, similar to the gizmo used with modifiers. Sub-objects that don’t have gizmos can’t change relative to their parent objects. For these kinds of sub-objects, transforms apply equally to the sub-object and its parents. For example, moving a blend sub-object moves its parents as well. Sub-objects that have gizmos can change relative to their parent objects. In this case, as with modifiers that use gizmos, you are really transforming the gizmo. For example, rotating a mirror sub-object changes the mirror axis, and therefore the mirror’s position relative to its parent curve or surface.

When you Shift+Clone on page 2734 a dependent NURBS sub-object, by default the parent objects are also cloned. For example, if you Shift+Clone a UV loft, all the lofting curves are copied as well. This means that the new object has the same type as the original object. The cloned object keeps its parents, so you can edit it just as you do the original. When you Shift+Clone a NURBS sub-object, you can also choose to remove dependencies in order to improve performance.

**Error Condition for Dependent Sub-Objects**

Sometimes changes you make to the parent objects make it no longer possible to correctly update the dependent object’s geometry. For example, a fillet between two curves requires the curves to be coplanar. If you move one curve (or its CVs or points) so that the curves are no longer coplanar, the fillet cannot update correctly. In this case, the dependent object’s geometry reverts to a default position, and it is displayed in orange to indicate an error condition. (You can change the error color using the Colors panel on page 8272 of the Customize User Interface dialog on page 8249.)
The arrow points to the segment indicating an error condition.

Seed Values

Some kinds of dependent sub-objects depend on geometry that might have more than one solution. For example, if you want to create a surface-curve intersection point, and the curve intersects the surface more than once, 3ds Max must decide which intersection is to be the location of the point.

For these kinds of objects, seed value on page 8713 parameters control the decision. The seed location is on a parent object, and 3ds Max chooses the location nearest to the seed value that satisfies the creation condition. You can alter the seed value when you edit these dependent sub-objects. The seed location is displayed as a yellow square.

For example, the seed location for a surface-curve intersection point is a U position along the length of the parent curve. The surface-curve intersection closest to the seed is chosen as the location of the dependent point.

The seed location for a surface is a pair of UV coordinates in the surface's parameter space on page 8674.
Replacing Parent Sub-Objects

Dependent sub-objects have controls that let you replace the object or objects on which they depend. For example, Offset Surface has a button called Replace Base Surface. You can click this button and then click a different surface to act as the base of the offset.

This capability lets you replace a trimmed surface with its untrimmed version, or vice versa. To do so, you need to use the Select Sub-Objects dialog, which is a subset of the Selection Floater on page 209 that you can use during sub-object creation as well as sub-object selection. For example, select the trimmed surface sub-object and turn on the Keyboard Shortcuts Override toggle on page 8420. Click the replacement button, press the H key, expand the surface's tree, and then highlight the name of the untrimmed version.

Rigid NURBS Surfaces

To improve performance, you can make any kind of surface sub-object into a rigid surface. The only editing allowed on a rigid surface is to transform it at the Surface sub-object level. You can't move a rigid surface's points or CVs, or change the number of points or CVs.

Rigid surfaces reduce the amount of memory used by the NURBS model. Making surfaces rigid improves performance, especially for large and complex models.

When a surface is rigid, you can't see its points or CVs when you are at the Point or Surface CV sub-object levels. If the model has only rigid surfaces and no point curves, the Point and Surface CV sub-object levels aren't available at all.

To make a rigid surface editable again, click Make Point, Make Independent, Make Loft, or Convert Surface.

NURBS and Modifiers

In general, you can apply modifiers to NURBS models as you do to other objects.

You can apply Edit Patch on page 1329 and Edit Mesh on page 1321 modifiers to NURBS surface objects.
**TIP** To improve performance while you animate your scene, make the surfaces in your NURBS model *nonrelational surfaces* on page 2484. Modifiers treat nonrelational surfaces as if they were independent CV surfaces: you can animate the scene more efficiently, and then turn relational modeling back on before you render.

---

### Deforming NURBS Objects

Deform modifiers such as *Bend* on page 1165 and *Twist* on page 1833 operate on CV and point sub-objects. They don't change the NURBS model into an editable mesh object. This means that you can use a deform modifier, collapse the stack, and still have a NURBS object that you can edit further. However, because the deform modifiers directly affect CVs and points (and not the mesh approximation of the NURBS model), they can produce unexpected results. For example, a *Ripple* on page 1650 modifier does not ripple the surface if the CVs are farther apart than the wavelength of the ripples. If you want the modifier to affect the mesh approximation instead of the CVs, you can apply a *Mesh Select* on page 1500 modifier first. Then when you collapse the stack, you get an editable mesh, not a NURBS object.

These are the deform modifiers that collapse to NURBS:

- Modifiers in the Parametric Deformers set, except for Lattice (which collapses to an editable mesh) and Slice (which collapses to an editable poly or an editable mesh).

- Modifiers in the Animation Modifiers set, except for the world-space modifier (WSM) versions of PatchDeform, PathDeform, and SurfDeform, which don't collapse.

**TIP** While the Morpher and Skin modifiers collapse to a NURBS object, they are meant to be used with their own controls, and lose their usefulness when you collapse them.

The modifiers with Soft Selection controls treat NURBS models the same way they treat editable meshes. As with editable mesh vertices, CVs are colored proportionally according to how much the region affects them.

If Relational Stack is turned off (see *Nonrelational NURBS Surfaces* on page 2484), the Affect Neighbors toggle can affect all surface CVs, curve CVs, and points in neighboring sub-objects. If Relational Stack is on, Soft Selection affects neighboring sub-objects only if they are at the same sub-object level. Soft Selection works with Scale and Rotate as well as with the Move transform.
NURBS Objects and the UVW Map Modifier

When you apply a UVW Map on page 1932 modifier, it affects the NURBS object the same way it affects a mesh. If you then collapse the stack, UVW mapping is still in effect. However, you can override the mapper for individual surface sub-objects. To do so, turn on the surface's Generate Mapping Coords check box, if necessary. When the check box is on, you get the natural mapping of the surface; when it is off, you get the mapping from the collapsed UVW modifier.

**TIP** Don't use UVW Map to assign a texture to an animated surface. The texture will shift as the surface animates.

NURBS Selection Modifier

The NURBS Surface Selection (NSurf Sel) on page 1555 lets you place a NURBS sub-object selection on the modifier stack. This lets you modify only the selected sub-objects. Also, selected curve sub-objects are Shape on page 572 objects that you can use as paths and motion trajectories.

NSurf Sel can select any kind of NURBS sub-object except imports. Each sub-object selection is of one sub-object level only.

Procedures

To use a NURBS select modifier:

1. With a NURBS object selected, go to the Modify panel and apply NSurf Sel.
   The selection modifier has no controls at the object level.

2. Click to open the modifier's hierarchy, and choose a sub-object level.
   The selection modifier has the same selection controls you see for the corresponding sub-object type.

   While applying the modifier, you can also select NURBS sub-objects by name. Turn on the Keyboard Shortcut Override Toggle button on the status bar, and then press the H key. This open the Select Sub-Objects dialog, which is a subset of the Selection Floater on page 209 that you can use during sub-object creation as well as sub-object selection. Choose one or more objects in the list, and then click Select. Press Ctrl+H to have the Select Sub-Objects dialog list only sub-objects (for example, points) directly under the mouse cursor.
3 Use the selection controls to create a selection set of the chosen sub-object type.

With the NSurf Sel modifier, you can select NURBS sub-objects at any level except imports.

**NOTE** To select point, curve, or curve CV sub-objects, you must go to the NURBS object and turn on Relational Stack.

Once you have used the modifier to create the selection, you can apply other modifiers to it. If the selected sub-object is a curve, you can also use it as a path or trajectory.

**NOTE** NSurf Sel doesn't support copy and paste of selections as Mesh Select does. Copying and pasting mesh selections is based on vertex indexes. NURBS selections are based on object IDs, which are unique to each model.

**NURBS and Animation**

In general, you animate NURBS curves and NURBS surfaces by turning on the Auto Key button and transforming sub-object attributes such as CV or point positions, by animating the parameters that control dependent NURBS objects, and so on.

You can't animate NURBS object creation or creation parameters, or fundamental changes to NURBS geometry such as adding or deleting CVs or points, attaching objects, and so on.

**TIP** To improve performance while you animate your scene, make the surfaces in your NURBS model nonrelational surfaces on page 2484. Modifiers treat nonrelational surfaces as if they were independent CV surfaces: you can animate the scene more efficiently, and then turn relational modeling back on before you render.

Some NURBS editing operations remove animation controllers.

**Operations that Remove Animation**

The following operations remove animation from a NURBS object or sub-object:

- Make Independent
  
  This operation removes the animation of anything directly dependent on the object.
Break, Extend, Join and Zip, Refine, Delete, Rebuild, Reparameterize, Close, Make Loft, Convert Curve, and Convert Surface
Any operation that changes the number of points or CVs in a curve or surface removes the animation of all points or CVs that are lost.

Fuse
The animation of the point or CV being fused to the other point or CV (the second one chosen) is lost. The first point or CV acquires the animation of the second.

NURBS Concepts

NURBS curves and surfaces did not exist in the traditional drafting world. They were created specifically for 3D modeling using computers. Curves and surfaces represent contours or shapes within a 3D modeling space. They are constructed mathematically.

NURBS mathematics is complex, and this section is simply an introduction to some NURBS concepts that might help you understand what you are creating, and why NURBS objects behave as they do. For a comprehensive description of the mathematics and algorithms involved in NURBS modeling, see *The NURBS Book* by Les Piegl and Wayne Tiller (New York: Springer, second edition 1997).

Definition and Parameter Space

The term NURBS stands for Non-Uniform Rational B-Splines. Specifically:

- **Non-Uniform** means that the extent of a control vertex's influence can vary. This is useful when modeling irregular surfaces.

- **Rational** means that the equation used to represent the curve or surface is expressed as a ratio of two polynomials, rather than a single summed polynomial. The rational equation provides a better model of some important curves and surfaces, especially conic sections, cones, spheres, and so on.

- A **B-spline** (for basis spline) is a way to construct a curve that is interpolated between three or more points. Shape curves such as the Line tool and other Shape tools are Bezier curves, which are a special case of B-splines.
The non-uniform property of NURBS brings up an important point. Because they are generated mathematically, NURBS objects have a parameter space on page 8674 in addition to the 3D geometric space in which they are displayed. Specifically, an array of values called knots on page 8617 specifies the extent of influence of each control vertex (CV) on the curve or surface. Knots are invisible in 3D space and you can't manipulate them directly, but occasionally their behavior affects the visible appearance of the NURBS object. This topic mentions those situations. Parameter space is one-dimensional for curves, which have only a single U dimension topologically, even though they exist geometrically in 3D space. Surfaces have two dimensions in parameter space, called U and V.

NURBS curves and surfaces have the important properties of not changing under the standard geometric affine transformations (Transforms), or under perspective projections. The CVs have local control of the object: moving a CV or changing its weight does not affect any part of the object beyond the neighboring CVs. (You can override this property by using the Soft Selection on page 2541 controls.) Also, the control lattice that connects CVs surrounds the surface. This is known as the convex hull on page 8540 property.

**Degree and Continuity**

All curves have a degree on page 8549. The degree of a curve is the highest exponent in the equation used to represent it. A linear equation is degree 1; a quadratic equation is degree 2. NURBS curves typically are represented by cubic equations and have a degree of 3. Higher degrees are possible, but usually unnecessary.

Curves also have continuity on page 8537. A continuous curve is unbroken. There are different levels of continuity on page 8537. A curve with an angle or cusp is C0 continuous: that is, the curve is continuous but has no derivative at the cusp. A curve with no such cusp but whose curvature changes is C1 continuous. Its derivative is also continuous, but its second derivative is not. A curve with uninterrupted, unchanging curvature is C2 continuous. Both its first and second derivatives are also continuous.
Levels of curve continuity:

Left: C0, because of the angle at the top

Middle: C1, at the top a semicircle joins a semicircle of smaller radius

Right: C2, the difference is subtle but the right side is not semicircular and blends with the left

A curve can have still higher levels of continuity, but for computer modeling these three are adequate. Usually the eye can't distinguish between a C2 continuous curve and one with higher continuity.

Continuity and degree are related. A degree 3 equation can generate a C2 continuous curve. This is why higher-degree curves aren't generally needed in NURBS modeling. Higher-degree curves are also less stable numerically, so using them isn't recommended.

Different segments of a NURBS curve can have different levels of continuity. In particular, by placing CVs at the same location or very close together, you reduce the continuity level. Two coincident CVs sharpen the curvature. Three coincident CVs create an angular cusp in the curve. This property of NURBS curves is known as multiplicity on page 8649. In effect, the additional one or two CVs combine their influence in that vicinity of the curve.

Effects of multiplicity: there are three CVs at the apex on the left, two CVs at the apex on the right.
By moving one CV away from the other, you increase the curve's continuity level again. Multiplicity also applies when you fuse CVs. Fused CVs create a sharper curvature or a cusp in the curve. Again, the effect goes away if you unfuse the CVs and move one away from the other.

Degree, continuity, and multiplicity apply to NURBS surfaces as well as to curves.

**Refining Curves and Surfaces**

*Refining* a NURBS curve means adding more CVs. Refining gives you finer control over the shape of the curve. When you refine a NURBS curve, 3ds Max preserves the original curvature. In other words, the shape of the curve doesn't change, but the neighboring CVs *move away from* the CV you add. This is because of multiplicity: if the neighboring CVs didn't move, the increased presence of CVs would sharpen the curve. To avoid this effect, first refine the curve, and then change it by transforming the newly added CVs, or adjusting their weights.

![Refining a NURBS curve.](image)

NURBS surfaces have essentially the same properties as NURBS curves, extended from a one-dimensional parameter space to two dimensions.

**Reparameterizing CV Curves and Surfaces**

When you refine a NURBS curve or surface, it is a good idea to reparameterize it. Reparameterizing adjusts the parameter space so the curve or surface will behave well when you edit it in viewports. There are two ways to reparameterize:

- Chord-length
  Chord-length reparameterization spaces knots in parameter space based on the square root of the length of each curve segment.

- Uniform
Uniform reparameterization spaces knots uniformly. A uniform knot vector has the advantage that the curve or surface changes only locally when you edit it.

CV curve and surface sub-objects give you the option of reparameterizing automatically whenever you edit the curve or surface.

**Point Curve and Surface Concepts**

You can work with point curves and point surfaces as well as with CV curves and surfaces. The points that control these objects are constrained to lie on the curve or surface. There is no control lattice, and no weight control. This is a simpler interface that you might find easier to work with. Also, point-based objects give you the ability to construct curves based on dependent (constrained) points, and then use these to construct dependent surfaces.

You can think of point curves and surfaces as an interface to CV curves and surfaces, which are the fully defined NURBS objects. The underlying representation of the curve or surface is still constructed using CVs.

You can also think of a point curve or surface as dependent on its points. You can use the Convert Curve button to convert a point curve or surface to the CV form, or vice versa.

**NURBS Tips and Techniques**

These topics contain suggestions on how to work with NURBS. They include tips collected from various NURBS modeling users.

**How to Make Objects with NURBS Modeling**

These are tips on using NURBS to create models.

**Objects and Sub-Objects**

- In 3ds Max, a NURBS model is a single, top-level NURBS object that can contain a variety of sub-objects. Get in the habit of creating a single object at the top level, then going immediately to the Modify panel and adding sub-objects by using rollouts or the NURBS Creation Toolbox on page 2426.
Sub-objects are either independent or dependent. Dependent sub-objects on page 2433 use relational modeling to build NURBS geometry that is related to other geometry. However, understand that the more dependencies a model has, the slower interactive performance becomes.

In general, point curves and surfaces are slower than CV curves and surfaces. Trims are the slowest kind of dependency, and texture surfaces are the slowest kind of dependent sub-object.

If a dependent sub-object doesn't change during animation, you can improve performance by making the sub-object independent after you finish creating it.

You can use NSurf Sel on page 1555 to apply modifiers to a sub-object selection. However, before you do so make sure that Relational Stack is on; Relational Stack on page 2484 is on the General rollout for NURBS models. Otherwise, NSurf Sel can select only the Surface and Surface CV sub-object levels.

Converting Other Objects to NURBS

Remember that you can collapse splines on page 577 to NURBS objects. A spline Shape or a NURBS curve can be a good starter object for a NURBS model.

Shapes with sharp angles collapse to multiple NURBS curves. You can control this before NURBS conversion by first converting the Shape to an editable spline on page 620. Modify the editable spline so that all its vertices are Bezier or Smooth vertices. Then when you collapse the spline to a NURBS curve, you obtain a single curve.

If you want a single NURBS curve, don't change vertices to Bezier Corner vertices. These always convert to a junction between two different NURBS curves.

Collapsing a primitive on page 388 into a NURBS object is one of the quickest ways to start building a NURBS model. After collapsing the primitive, you can select various CVs and transform them. Other objects you can convert to NURBS are prisms on page 458, torus knots on page 426, lofts on page 742, and patch grids on page 2408.

You can also change the NURBS surface by applying modifiers. The modifiers act on the points or CVs of the surface, and not on the surface itself. After applying the modifiers, collapse the modifier stack on page 8187.
This removes the modifiers from the stack without changing the position of the modified points or CVs, making for a simpler and quicker model.

- Another way to create a NURBS surface object is to apply a Lathe on page 1474 or Extrude on page 1425 modifier to a NURBS curve. Set the modifier's Output Type to NURBS, and then collapse when you're done adjusting the parameters. (There are also NURBS lathe and extrude surface sub-object types, which you can apply to curve sub-objects.)

### Shortcuts, Snaps, and User Interface Tips

- Remember to turn on the Plug-In Keyboard Shortcut Toggle on page 8420. While it is on, you can use all the NURBS keyboard shortcuts.

- One of the most useful NURBS keyboard shortcuts is H, which opens the Select Sub-Objects dialog. This is a subset of the Selection Floater on page 209 that you can use during sub-object creation as well as sub-object selection. This is handy when sub-objects are crowded or hard to see. A variant is Ctrl+H, which also displays the Select Sub-Objects dialog, but lists only those NURBS sub-objects beneath the mouse cursor position.

- There are special NURBS Snaps in the Grid and Snap Settings dialog on page 2819 (right-click the 3D Snap toggle to display this). When you use NURBS snaps, turn off Options/Axis Constraints; otherwise, snaps work only in the current axis. Also, remember that snaps work in a viewport only when you have made the viewport active. And choosing your snap settings does not turn on snaps. You must also turn on the 3D Snap Toggle button on page 2807 (on the status bar).

  Snaps are especially important when you create the curves for building 1-rail on page 2663 and 2-rail on page 2673 sweep surfaces.

- Remember that without leaving the viewport, you can right-click to display a quad menu on page 8052 with shortcuts for changing the sub-object level, creating some sub-objects, and using some other edit commands.

- When you work with NURBS, there are a lot of rollouts in the Modify panel. Minimize the rollouts you don't need. For example, minimizing the Modifiers rollout helps unless you're applying Modifiers, and minimizing the Surface Common rollout is useful when you're creating U loft, UV loft, and 1-rail or 2-rail sweep surfaces.

- Don't set viewports to display edged faces. Displaying edges is almost twice as slow as displaying a simple shaded viewport.
Creating Curves

■ When drawing a CV curve, click three times to get a sharp corner. Be aware, however, that multiple CVs increase the amount of calculation and therefore reduce the performance and stability of your model. However, if you want to use the curve to construct a U Loft, and so on, this is the best technique.

■ You can also create sharp corners by fusing the ends of two separate NURBS curve sub-objects. This is the recommended method if you aren't using the curves to construct a surface.

■ While creating curves, you can turn on the Draw in All Viewports toggle. This lets you draw curves in 3D. Begin drawing a curve in one viewport, go to another viewport, and continue drawing. If your mouse has a middle mouse button, Alt+middle mouse button lets you use Orbit on page 8152 to change a viewport's orientation while you are creating the curve.

■ To create a transform curve along a specific axis, turn on the appropriate axis constraints, and then Shift+move a copy of the transform curve.

Curves and Direction

■ NURBS curves show their direction in viewports. A small circle indicates the first vertex. If the curve is closed, a plus sign (+) indicates the direction of the curve. Be aware of curve direction when you use curves to construct blend surfaces on page 2614, U loft on page 2646 and UV loft on page 2656 surfaces, and 1-rail on page 2663 and 2-rail on page 2673 sweeps. If the curves don't have the same direction, you can get strange twisting. Make sure curves have the same direction before you construct the surface. On the Curve Common rollout, the controls Reverse and Make First let you control the direction of the curve, and where its starting point or CV is located. Another good way to make sure curves are aligned is to draw one curve and then use Shift+Clone to create the others. After creating the aligned curves, you can transform CVs to vary the curves on which the surface will be based.

Curves for Sweeps

■ Besides expecting cross-section curves to be all in the same direction, 1-rail on page 2663 and 2-rail on page 2663 sweep surfaces work best if the cross
sections intersect the rail or rails. To achieve this, draw the rails first, then draw the cross sections using the NURBS Snaps on page 2819 Curve End and Curve Edge turned on.

- 2-rail sweeps have the additional requirement that the endpoints of the first cross section intersect the endpoints of the rails. Again, NURBS Snaps help you do this. If the endpoints of the first cross-section don't coincide with the rail endpoints, the resulting surface might not follow the rails.

- While you're editing a sweep, the Edit Curve button lets you directly transform the CVs of a rail or cross section, without changing the sub-object level. Edit Curve also gives you access to all the rollouts that control the curve. You can use Refine or Make First, for example, without changing levels.

Curves on Surfaces and Projected Curves

- You can use a viewport to draw a curve on a surface on page 2593 (COS), but this works only for visible portions of the surface. To see the entire surface and the curve or curves on it projected into a flat plane, use Edit Curve. If your mouse has a middle mouse button, Alt+middle mouse button lets you use Orbit on page 8152 to change a viewport’s orientation while you draw the curve on surface.

- Neither curves on surfaces nor projected curves can cross the edge of a surface. This includes the seam on surfaces with fused CVs. If you try to project across the seam, only part of the curve’s projection is created.

Creating Blend Surfaces

- You can blend between curves or between surface edges. (You can't blend from a trimmed edge. In that situation, you are blending from the curve that trimmed the surface.)

- If you want a controllable tangent or tension, you must blend to a surface edge or a curve on a surface. Adjusting tension changes the flatness or "bulginess" of that end of the blend. When a curve and a surface (or two surfaces) are near each other, sometimes it can be hard to tell which edge you are selecting. To assist you, the currently selected surface turns yellow, and the edge that will be used for the blend turns blue. Make sure you have selected the right surface before you choose the edge.
- If the edges you are blending have different numbers of points (usually due to different surface approximation settings), then sometimes rendering shows gaps between the blend and the original surface. If this happens, go to the Surface Approximation rollout on page 2737 and increase the value of Merge until the gaps disappear when you render. The Merge setting affects only the production renderer. It has no effect on viewport display.

**Lofts**

- If you need a surface between only two curves, use a ruled surface on page 2640 instead of a U loft. This is faster.

- If loft creation seems slow, make sure the Display While Creating check box (in the U Loft Surface rollout on page 2646) is turned off.

- If the U loft doesn’t come out as you expected, try reparameterizing the curves. Click Reparam. at the Curve sub-object level. This button is on the CV Curve rollout. In the Reparameterize dialog on page 2733, choose Chord Length reparameterization. If a curve is dependent or a point curve, first you will have to make it independent (this also improves performance). Curves that are made of two joined curves have this problem more often than others. If you have a joined curve as one of the curves to construct the loft, reparameterize it before you create the loft, or set the curves to reparameterize automatically.

- The Edit Curve button lets you directly transform the CVs of a curve within a U loft or UV loft on page 2656, without changing the sub-object level. Edit Curve also gives you access to all the rollouts that control the curve. You can use Refine or Make First, for example, without changing levels.

- To close a UV loft, you can pick the first V curve again to make it the last curve in the loft. Sometimes a seam is visible at this location in the UV loft.

**Multisided Blend Surfaces**

- If 3ds Max doesn’t create the multisided blend on page 2683, fuse the CVs at the three or four corners. Snapping CVs to each other doesn’t always succeed, because of rounding off.
Multicurve Trimmed Surfaces

- Multicurve trimmed surfaces are the only way to create a trimmed hole that contains sharp angles.

Displacement Mapping

- In general, the default tessellation settings aren't suitable for displaced surfaces. With these default settings, displacement mapping can create an extremely high face count, which performs very slowly. Change the surface approximation to the lowest necessary resolution. A good rule of thumb is to start with Spatial approximation and an Edge value of 20. If that is too low, reduce the Edge value until the model looks as it should.

- Use the Displace NURBS world space modifier on page 1071 to convert the displacement map into an actual displaced mesh so you can see the effect of displacement in viewports. To make a displaced mesh copy of the NURBS model, use Snapshot on page 950.

Connecting an Arm to a Shoulder

- The easiest approach is to create a CV curve on surface on page 2593 or normal projected curve on page 2586 on the shoulder. Then create the arm as a U loft on page 2646. For the last curve of the U loft, select the CV curve on surface or the normal projected curve. Then turn on Use COS Tangents, which makes the loft surface tangent to the other surface where the arm joins the shoulder.

- If the blend appears twisted, use the Start Point spinner to change the location of the first point of the curves that make up the U loft surface.

- Another way to connect a U loft to another surface is to project the last curve in the U loft onto the other surface. Click Make COS to convert the projected curve into a curve on surface, and then on the U Loft Surface rollout click Insert to make the new curve on surface the last curve in the U loft. You can scale the curve on surface or move its CVs to get the curvature and blending you want.
How to Fix NURBS Objects

These are tips on fixing problems with NURBS models.

- If you create a surface but it isn't visible in viewports, click Flip Normals. Flip Normals is available on the surface's creation rollout, or at the Surface sub-object level on the Surface Common rollout.

- If you create a blend surface on page 2614 and it looks like a bow tie, use Flip End 1 or Flip End 2 to correct the twist.

- If a CV curve gives you unexpected or incorrect results, try reparameterizing it. Click Reparam. at the Curve sub-object level. This button is on the CV Curve rollout. In the Reparameterize dialog on page 2733, choose Chord Length reparameterization.
  If the curve still gives you trouble, try rebuilding it. The Rebuild button is on the same rollout.

- If a blend between a surface and a curve gives you unexpected or incorrect results, try reparameterizing the parent surface. Click Reparam. at the Surface sub-object level. This button is on the CV Surface rollout. In the Reparameterize dialog on page 2733, choose Chord Length reparameterization.

- If you see a seam in a shaded viewport, render the viewport first before you try to fix the seam. What you see in viewports might not be what you get in a render, and the viewport shader is less accurate than the production renderer. Seams in viewports can also result from different surface approximation settings on page 2737 for the viewport and the renderer, so check these as well.

- If you see gaps between faces in the rendered model, increase the Merge value for the renderer in the surface approximation settings.

- Sometimes gaps between faces appear after you convert a NURBS model into a mesh. (For example, by using Mesh Select on page 1500.) If this happens, increase the Merge value for the renderer in the surface approximation on page 2737 settings.

- If you see odd twists in a 1-rail on page 2663 or 2-rail on page 2673 sweep, add more cross sections at the areas of change in the surface. For example, if your rail looks like a box with rounded corners, placing cross sections at the corners helps to control the shape of the sweep. On the other hand, you don't need more cross sections for a rail shaped like an 'S', because the curvature is more constant.
If a U loft or UV loft doubles back on itself unexpectedly, make sure that all the curves are going in the same direction. Click Reverse to change a curve's direction. Use the Start Point spinner to align the curve's initial points.

How to Improve NURBS Performance

These are tips on improving the performance of your NURBS models.

- Avoid using point curves and point surfaces. These are slower than CV curves and CV surfaces. Use the point forms only when you need them for construction; for example, when you use Curve Fit to create a curve that interpolates specific points.

- Use the nonrelational stack on page 2484 feature in conjunction with the Shaded Lattice toggle to improve performance while you animate your NURBS model.

- Use Transform Degrade to hide surfaces while you are moving, rotating, and scaling NURBS sub-objects. The shortcut Ctrl+X toggles this option. You can use Ctrl+X in the middle of a transform, to turn on degradation if things are happening slowly.

- Turn off the display of dependent surfaces while you are creating new dependent surfaces or moving, rotating, or scaling NURBS sub-objects. The shortcut Ctrl+D toggles dependent surface display.

- Trim holes only when you need to. For example, when you connect an arm to a torso, you don't need to create a hole beneath the arm, as it won't be visible anyway. You can also speed up performance by turning off the Display Trims toggle. The shortcut Shift+Ctrl+T toggles trim display. The trims still appear in renderings.

- For symmetrical models, create only half the geometry, and then mirror it. You can then use a blend on page 2614 surface or ruled on page 2640 surface to connect the two halves.

- Restart 3ds Max when performance begins to slow down. If your NURBS model needs to page, then working with it for a long time causes performance to slow. If you notice this, save your work, close 3ds Max, and then restart.

- Convert point surfaces to CV surfaces whenever possible.
When you use texture surfaces, use the Edit Texture Surface dialog on page 2719 (click Edit Texture Surface on the Material Properties rollout on page 2544) to rebuild the texture surface with the minimum necessary number of UV rows and columns.

- U lofts are faster than UV lofts.
- Every type of surface is faster if you can make it independent.
- Set the surface approximation on page 2737 for viewports to use the lowest possible resolution. Set the renderer to use higher resolution, and turn on View Dependent for the renderer so objects far from the camera render more quickly.
- You can customize and save surface approximation on page 2737 presets by using the Surface Approximation utility on page 2748. This utility also lets you set surface approximation values for a selection set of multiple NURBS models.

**NURBS Animation, Textures, and Rendering**

These are tips about animating NURBS models and using textures with animated NURBS models.

- An easy way to animate a growing surface is to put a curve point on page 2698 with trimming on a curve, then animate the U position of the curve point, and then use this curve as the rail of a 1-rail sweep on page 2663. As the trimmed rail grows, so does the sweep surface. (You must trim the curve before you create the sweep surface.)

- If you see gaps between surfaces in rendered images, increase the value of Merge for the renderer in the surface approximation on page 2737 settings.

- If a texture slides around on the surface during animation, this is because you are using the default Chord-Length parameterization of the texture surface. Select the surface, then on the Material Properties rollout on page 2544 change the parameterization to User Defined. Now the texture should stick to the surface better.

- Don't use the UVW Map modifier on page 1932 to apply a texture to an animated NURBS surface.

- If a surface seems to glitter or jump around as you move toward it in an animation, this is because View Dependent tessellation is on (on the Surface
If a surface seems to glitter or jump around while it changes during animation, this is because the tessellation is changing as the surface animates. Changing surface approximation (on the Surface Approximation rollout) to Regular fixes this in all cases. Parametric tessellation also solves this problem for every kind of surface except U lofts on page 2646 and UV lofts on page 2656.

If the View Dependent setting doesn’t seem to be doing much, change the tessellation (on the Surface Approximation rollout) from Curvature to Spatial. You will then get a much more drastic change in face count.

To get a map to smoothly cover two or more surface without tiling, create another surface whose shape covers and roughly conforms to the original surfaces. Apply the texture to the larger surface. In the Material Properties rollout on page 2544 for the original surfaces, set Texture Surface to Projected, click Pick Source Surface, and pick the larger surface. Adjust the larger surface to fine-tune the map projection. Hide the larger surface before you render.

To have different maps on a surface sub-object, use different mapping coordinates on page 8628, and multiple map channels on page 8627. On the Material Properties rollout on page 2544, change the Map Channel value and then turn on Generate Mapping Coordinates. (Each map channel requires its own set of mapping coordinates.) NURBS surface sub-objects let you set the map channel directly, and don’t require you to apply UVW Map modifiers as other objects do.

If a map doesn’t align to a surface sub-object the way you want it to, on the Material Properties rollout on page 2544 choose User Defined as the Texture Surface, and then use Edit Texture Points or the Edit Texture Surface dialog to move the points of the texture surface.

To adjust how the map aligns to the edges of a surface sub-object, use the Texture Corner settings on the Material Properties rollout on page 2544.

**NURBS Surfaces**

Create panel > Geometry > NURBS Surfaces

Create menu > NURBS > CV Surface/Point Surface
NURBS on page 8655 surface objects are the basis of NURBS models. The initial surface you create using the Create panel is a planar segment with points or CVs. It is meant simply to be "raw material" for creating a NURBS model. Once you have created the initial surface, you can modify it on the Modify panel by moving CVs or NURBS points, attaching other objects, creating sub-objects, and so on.

There are two kinds of NURBS surfaces:

**Point Surface** on page 2456

**CV Surface** on page 2460

You can also create a NURBS surface from a geometric primitive on page 2483.

NURBS surfaces can contain multiple sub-objects, including NURBS points, NURBS curves, and other NURBS surfaces. These sub-objects are either dependent or independent.

**Creating Curve Sub-Objects** on page 2549

**Creating Surface Sub-Objects** on page 2603

**Creating and Editing Point Sub-Objects** on page 2694

**Common Sub-Object Controls** on page 2494

**Editing Point Sub-Objects** on page 2496

**Editing Curve CV Sub-Objects** on page 2503

**Editing Surface CV Sub-Objects** on page 2509

**Editing Curve Sub-Objects** on page 2518

**Editing Surface Sub-Objects** on page 2530

You can also create NURBS surface sub-objects by attaching or importing other 3ds Max objects on page 2490.

Both NURBS curves and NURBS surfaces have a Display area in the General rollout on the Modify panel. These controls affect which portions of the NURBS geometry are displayed. Next to the Display area is the button that turns on the toolbox for creating sub-objects.

**Display Controls for NURBS Models** on page 2486
WARNING When you move CV sub-objects, the effect must be calculated over a region of the surface. Although the calculations are optimized, this is a more involved process than simply moving vertices in an editable mesh. Because of this, if you manipulate large numbers of a NURBS surface’s CVs by transforming, animating, applying modifiers, and so on, you will notice a drop in interactive performance.

You can use MAXScript to control NURBS objects. See "Working with NURBS in MAXScript" in the MAXScript help file. Choose Help > Additional Help, and then choose MAXScript from the list of additional help files.

Point Surface

Create panel > Geometry > NURBS Surfaces > Point Surf
Create menu > NURBS > Point Surface
Point surfaces are NURBS surfaces on page 2454 whose points are constrained to lie on the surface.

Points shape the surface they lie on.
Because an initial NURBS surface is meant to be edited, the surface creation parameters do not appear on the Modify panel. In this respect, NURBS surface objects are different from other objects. The Modify panel provides other ways to change the values you set in the Create panel.

**Procedures**

**To create a point surface:**

1. Go to the Create panel.
2. Turn on Geometry, and choose NURBS Surfaces from the drop-down list.
3. Turn on Point Surf.
4. In a viewport, drag to specify the area of the planar segment.
5. Adjust the surface’s creation parameters.

**Interface**

The creation parameters are the same for both point surfaces and CV surfaces, except that the labels indicate which kind of basic NURBS surface you are creating.

**Keyboard Entry rollout**

The Keyboard Entry rollout lets you create a point surface by typing. Use the Tab key to move between the controls on this rollout. To click the Create button from the keyboard, press Enter while the button is active.
X, Y, and Z Let you enter the coordinates of the center of the surface.

Length and Width Let you enter the dimensions of the surface in current 3ds Max units.

Length Points Lets you enter the number of points along the length of the surface (this is the initial number of point columns).

Width Points Lets you enter the number of points along the width of the surface (this is the initial number of point rows).

Create Creates the surface object.
Create Parameters rollout

**Length** The length of the surface in current 3ds Max units.

**Width** The width of the surface in current 3ds Max units.

On the Modify panel, the Length and Width spinners are no longer available. You can change the length or width of the surface by scaling the surface at the Surface sub-object level. Moving point sub-objects also alters the length and width of the surface.

**Length Points** The number of points along the length of the surface. In other words, the initial number of point columns in the surface. Range=2 to 50. Default=4.

**Width Points** The number of points along the width of the surface. In other words, the initial number of point rows in the surface. Range=2 to 50. Default=4.

On the Modify panel, the point Length and Width spinners are no longer available. You can change the number of rows and columns by deleting existing rows and columns, or by adding new rows and columns using the Refine controls at the Point sub-object level.

**Generate Mapping Coordinates** Generates mapping coordinates so you can apply mapped materials to the surface.

The Generate Mapping Coordinates control is present on the Modify panel. It is at the Surface sub-object level.

**Flip Normals** Turn on to reverse the direction of the surface normals.
The Flip Normals control is present on the Modify panel. It is at the Surface sub-object level.

When you modify a point surface, a rollout lets you change its surface approximation settings on page 2737.

**CV Surface**

Create panel > Geometry > NURBS Surfaces > CV Surf

Create menu > NURBS > CV Surface

CV surfaces are NURBS surfaces on page 2454 controlled by control vertices (CVs on page 8543). The CVs don't lie on the surface. They define a control lattice on page 8538 that encloses the surface. Each CV has a weight that you can adjust to change the shape of the surface.

![CV Surface](image)

The CVs in a control lattice shape the surface it defines.

Because an initial NURBS surface is meant to be edited, the surface creation parameters do not appear on the Modify panel. In this respect, NURBS surface objects are different from other objects. The Modify panel provides other ways to change the values you set in the Create panel.
Procedures

To create a CV surface:

1. Go to the Create panel.
2. Turn on Geometry, and choose NURBS Surfaces from the drop-down list.
3. Turn on CV Surf.
4. In a viewport, drag to specify the area of the planar segment.
5. Adjust the surface’s creation parameters.

**NOTE** When you edit a CV surface you can add or move CVs so that more than one CV is at the same location (or close to it) to increase the influence of the CVs in that region of the surface. Two coincident CVs sharpen the curvature. Three coincident CVs create an angular peak in the surface. This technique can help you shape the surface. However, if you later move the CVs individually, you lose this effect. (You can also obtain the influence of multiple CVs by fusing on page 8588 CVs.)

Interface

The creation parameters are the same for both point surfaces and CV surfaces, except that the labels indicate which kind of basic NURBS surface you are creating.

**Keyboard Entry rollout**

The Keyboard Entry rollout lets you create a CV surface by typing. Use the Tab key to move between the controls on this rollout. To click the Create button from the keyboard, press Enter while the button is active.
X, Y, and Z Let you enter the coordinates of the center of the surface.

Length and Width Let you enter the dimensions of the surface, in current 3ds Max units.

Length CVs Lets you enter the number of CVs along the length of the surface (this is the initial number of CV columns).

Width CVs Lets you enter the number of CVs along the width of the surface (this is the initial number of CV rows).

Create Creates the surface object.
Create Parameters rollout

Length  The length of the surface in current 3ds Max units.

Width  The width of the surface in current 3ds Max units.

On the Modify panel, the Length and Width spinners are no longer available. You can change the length or width of the surface by scaling the surface at the Surface sub-object level. Moving CV sub-objects also alters the length and width of the surface.

Length CVs  The number of CVs along the length of the surface. In other words, the initial number of CV columns in the surface. Can range from 4 to 50.

Width CVs  The number of CVs along the width of the surface. In other words, the initial number of CV rows in the surface. Can range from 4 to 50.

On the Modify panel, the CV Length and Width spinners are no longer available. You can change the number of rows and columns by deleting existing rows and columns, or by adding new rows and columns using the Refine controls at the Surface CV sub-object level.
**Generate Mapping Coordinates** Generates mapping coordinates so you can apply mapped materials to the surface. The Generate Mapping Coordinates control is present on the Modify panel. It is at the Surface sub-object level.

**Flip Normals** Turn on to reverse the direction of the surface normals. The Flip Normals control is present on the Modify panel. It is at the Surface sub-object level. When you modify a CV surface, a rollout lets you change its surface approximation settings on page 2737.

**Automatic Reparameterization group**

The radio buttons in this group box let you choose automatic reparameterization. With reparameterization, the surface maintains its parameterization as you edit it. Without reparameterization, the surface's parameterization doesn't change as you edit it, and can become irregular.

**None** Do not reparameterize.

**Chord Length** Chooses the chord-length algorithm for reparameterization. Chord-length reparameterization spaces knots (in parameter space on page 8674) based on the square root of the length of each curve segment. Chord-length reparameterization is usually the best choice.

**Uniform** Spaces the knots uniformly. A uniform knot vector has the advantage that the surface will change only locally when you edit it. With the other two forms of parameterization, moving any CV can change the entire surface.

**NURBS Curves**

Create panel > Shapes button > NURBS Curves

NURBS on page 8655 curves are Shape objects on page 572, and you can use them as you do splines. You can use the Extrude or Lathe modifiers to generate a 3D surface based on a NURBS curve. You can use NURBS curves as the path or the shape of a loft. (Lofts created using NURBS curves are loft objects, not NURBS objects.)

You can also use NURBS curves as Path Constraint and Path Deform paths or as motion trajectories.
You can assign thickness to a NURBS curve so it renders as a cylindrical object. (The thickened curve renders as a polygonal mesh, not as a NURBS surface.)

A curve and the same curve rendered with thickness

There are two kinds of NURBS curve objects:
- Point Curve on page 2466
- CV Curve on page 2473

Like other Shape objects, NURBS curves can contain multiple sub-objects, which are either dependent or independent.
- Creating Curve Sub-Objects on page 2549
- Creating Surface Sub-Objects on page 2603
- Creating and Editing Point Sub-Objects on page 2694
- Common Sub-Object Controls on page 2494
- Editing Point Sub-Objects on page 2496
- Editing Curve CV Sub-Objects on page 2503
- Editing Surface CV Sub-Objects on page 2509
- Editing Curve Sub-Objects on page 2518
- Editing Surface Sub-Objects on page 2530

**NOTE** Like an object-level NURBS surface on page 2454, an object-level NURBS curve is a top-level NURBS model on page 8656 that can contain NURBS curve, NURBS surface, and NURBS point sub-objects. A NURBS curve remains a Shape object unless you add a surface sub-object to it; if you do, it converts to a NURBS surface (without changing its name).
Creating Independent Surfaces from NURBS Curve Objects on page 2480

You can also create NURBS curve sub-objects by attaching or importing other objects such as other NURBS curves or spline shapes.

Attaching and Importing 3ds Max Objects on page 2490

Display Controls for NURBS Models on page 2486

Both NURBS curves and NURBS surfaces have a Display area in the Modify panel. These controls affect which portions of the NURBS geometry are displayed. Next to the Display area is the button that turns on the toolbox for creating sub-objects.

**Point Curve**

Create panel > Shapes button > NURBS Curves > Point Curve button

Create menu > NURBS > Point Curve

Point curves are NURBS curves on page 2464 whose points are constrained to lie on the curve.

A point curve can be the basis of a full NURBS model on page 8656.
Points lie on the curve they define.

**Drawing Three-Dimensional Curves**

When you create a point curve, you can draw it in three dimensions. There are two ways to do this:

- **Draw In All Viewports:** This toggle lets you use any viewport to draw the curve, enabling you to draw three dimensionally.

- **Using Ctrl to drag points:** While you draw a curve, you can use the Ctrl key to drag a point off of the construction plane.

With the Ctrl-key method, further mouse movement lifts the latest point off the construction plane. There are two ways to use this:

- **Click-drag.** If you hold down Ctrl and also hold down the mouse button, you can drag to change the height of the point. The point's location is set when you release the mouse button. This method is probably more intuitive.
Click-click. If you Ctrl+click and then release the mouse button, the height changes as you drag the mouse. Clicking the mouse a second time sets the point's location. This method is less prone to repetitive stress injury.

While you are offsetting the point, a red dotted line is drawn between the original point on the construction plane and the actual point offset from the plane. You can move the mouse into an inactive viewport, in which case 3ds Max sets the height of the point using the point's Z axis in the inactive viewport. This lets you set the height of the point with accuracy.

Snaps on page 2819 also work when you change the height of a point. For example, if you turn on Point snapping, you can set a point to have the same height as another point by snapping to that other point in an inactive viewport.

Procedures

To create a NURBS point curve:

1. Go to the Create panel.
2. Turn on Shapes, and choose NURBS Curves from the drop-down list.
3. Turn on Point Curve.
4. In a viewport, click and drag to create the first point, as well as the first curve segment. Release the mouse button to add the second point. Each subsequent location you click adds a new point to the curve. Right-click to end curve creation.

**NOTE** If you begin the curve by clicking without dragging, this also creates the curve's first point. However, if you release the mouse button more than five pixels away from where you initially pressed it, this creates an additional point.

While you are creating a point curve, you can press Backspace to remove the last point you created, and then previous points in reverse order. If Draw In All Viewports is on, you can draw in any viewport, creating a 3D curve.
To lift a point off the construction plane, use the Ctrl key as described earlier in this topic under "Drawing Three-Dimensional Curves."

As with splines, if you click over the curve's initial point, a **Close Curve dialog** on page 2730 is displayed. This dialog asks whether you want the curve to be closed. Click No to keep the curve open or Yes to close the curve. (You can also close a curve when you edit it at the Curve sub-object level.) When a closed curve is displayed at the Curve sub-object level, the initial point is displayed as a green circle, and a green tick mark indicates the curve's direction.

5  Adjust the curve's creation parameters.

6  (Optional.) To add a new NURBS curve sub-object, you can turn off the Start New Shape check box, and then repeat the preceding steps.

**Interface**

The creation parameters are the same for both point curves and CV curves.
Rendering rollout

Lets you turn on and off the renderability of the curve, specify its thickness in the rendered scene, and apply mapping coordinates.

Render parameters can be animated. For example, you can animate the number of sides.

Enable In Renderer When on, the shape is rendered as a 3D mesh using the Radial or Rectangular parameters set for Renderer.

Enable In Viewport When on, the shape is displayed in the viewport as a 3D mesh using the Radial or Rectangular parameters set for Renderer.

Use Viewport settings Lets you set different rendering parameters, and displays the mesh generated by the Viewport settings. Available only when Enable in Viewport is turned on.

Generate Mapping Coords Turn this on to apply mapping coordinates. Default=off.
The U coordinate wraps once around the thickness of the spline; the V coordinate is mapped once along the length of the spline. Tiling is achieved using the Tiling parameters in the material itself.

**Real-World Map Size** Controls the scaling method used for texture mapped materials that are applied to the object. The scaling values are controlled by the Use Real-World Scale settings found in the applied material's Coordinates rollout on page 6201. Default=on.

**Viewport** Turn this on to specify Radial or Rectangular parameters for the shape as it will display in the viewport when Enable in Viewport is turned on.

**Renderer** Turn this on to specify Radial or Rectangular parameters for the shape as it will display when rendered or viewed in the viewport when Enable in Viewport is turned on.

**Radial** Displays the 3D mesh as a cylindrical object.

**Thickness** Specifies the diameter of the viewport or rendered spline mesh. Default=1.0. Range=0.0 to 100,000,000.0.

Splines rendered at thickness of 1.0 and 5.0, respectively

**Sides** Sets the number of sides (or facets) for the spline mesh in the viewport or renderer. For example, a value of 4 results in a square cross section.

**Angle** Adjusts the rotational position of the cross-section in the viewport or renderer. For example, if the spline mesh has a square cross section you can use Angle to position a "flat" side down.

**Rectangular** Displays the spline's mesh shape as rectangular.

**Aspect** Sets the aspect ratio for rectangular cross-sections. The Lock check box lets you lock the aspect ratio. When Lock is turned on, Width is locked to Depth that results in a constant ratio of Width to Depth.
Length Specifies the size of the cross-section along the local \( Y \) axis.

Width Specifies the size of the cross-section along the local \( X \) axis.

Angle Adjusts the rotational position of the cross-section in the viewport or renderer. For example, if you have a square cross-section you can use Angle to position a "flat" side down.

Auto Smooth If Auto Smooth is turned on, the spline is auto-smoothed using the threshold specified by the Threshold setting below it. Auto Smooth sets the smoothing based on the angle between spline segments. Any two adjacent segments are put in the same smoothing group if the angle between them is less than the threshold angle.

Threshold Specifies the threshold angle in degrees. Any two adjacent spline segments are put in the same smoothing group if the angle between them is less than the threshold angle.

Keyboard Entry rollout

The Keyboard Entry rollout lets you create a NURBS curve by typing. Use the Tab key to move between the controls in this rollout. To click a button from the keyboard, press Enter while the button is active.

<table>
<thead>
<tr>
<th>X</th>
<th>Y</th>
<th>Z</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.1</td>
<td>0.3</td>
<td>0.3</td>
</tr>
</tbody>
</table>

Add Point Adds the point to the curve.

Close Ends creation of the curve and creates a segment between the last point and the initial point to close the curve.

Finish Ends creation of the curve, leaving it open.
Create Point Curve rollout

This rollout contains the controls for curve approximation.

Interpolation group

The controls in this group box change the accuracy and type of curve approximation on page 2736 used to generate and display the curve.

Draw In All Viewports  Lets you use any viewport while you are drawing the curve. This is one way to create a 3D curve. When off, you must finish drawing the curve in the viewport where you began it. Default=on.

While Draw In All Viewports is on, you can also use snaps on page 2819 in any viewport.

CV Curve

Create panel > Shapes button > NURBS Curves > CV Curve button
Create menu > NURBS > CV Curve

CV curves are NURBS curves on page 2464 controlled by control vertices (CVs on page 8543). The CVs don't lie on the curve. They define a control lattice on page 8538 that encloses the curve. Each CV has a weight that you can adjust to change the curve.

While you're creating a CV curve you can click to create more than one CV at the same location (or close to it), increasing the influence of the CVs in that region of the curve. Creating two coincident CVs sharpens the curvature. Creating three coincident CVs creates an angular corner in the curve. This technique can help you shape the curve; however, if you later move the CVs individually, you lose this effect. (You can also obtain the influence of multiple CVs by fusing on page 8588 CVs.)

A CV curve can be the basis of a full NURBS model on page 8656.
CVs shape the control lattice that defines the curve.

**Drawing Three-Dimensional Curves**

When you create a CV curve, you can draw it in three dimensions. There are two ways to do this:

- **Draw In All Viewports:** This toggle lets you use any viewport to draw the curve, enabling you to draw three dimensionally.

- **Using Ctrl to drag CVs:** While you draw a curve, you can use the Ctrl key to drag a CV off of the construction plane.

With the Ctrl–key method, further mouse movement lifts the latest CV off the construction plane. There are two ways to use this:

- **Click-drag:** If you hold down Ctrl and also hold down the mouse button, you can drag to change the height of the CV. The CV’s location is set when you release the mouse button. This method is probably more intuitive.
Click-click. If you Ctrl+click and then release the mouse button, the height changes as you drag the mouse. Clicking the mouse a second time sets the CV's location. This method is less prone to repetitive stress injury.

While you are offsetting the CV, a red dotted line is drawn between the original CV on the construction plane and the actual CV offset from the plane. You can move the mouse into an inactive viewport, in which case 3ds Max sets the height of the CV using the CV's Z axis in the inactive viewport. This lets you set the height of the CV with accuracy.

Snaps on page 2819 also work when you change the height of a CV. For example, if you turn on CV snapping, you can set a CV to have the same height as another CV by snapping to that other CV in an inactive viewport.

Procedures

To create a NURBS CV curve:

1. Go to the Create panel.
2. Turn on Shapes, and choose NURBS Curves from the drop-down list.
3. Turn on CV Curve.
4. In a viewport, click and drag to create the first CV, as well as the first curve segment. Release the mouse to add the second CV. Each subsequent location you click adds a new CV to the curve. Right-click to end curve creation.

**NOTE** If you begin the curve by clicking without dragging, this also creates the curve's first CV. However, if you release the mouse more than five pixels away from where you initially pressed it, this creates an additional CV.

While you are creating a CV curve, you can press Backspace to remove the last CV you created, and then previous CVs in reverse order.

If Draw In All Viewports is on, you can draw in any viewport, creating a 3D curve.

To lift a CV off the construction plane, use the Ctrl key as described earlier in this topic under "Drawing Three-Dimensional Curves."
As with splines, if you click over the curve's initial CV, a Close Curve dialog on page 2714 is displayed. This dialog asks whether you want the curve to be closed. Click No to keep the curve open or Yes to close the curve. (You can also close a curve when you edit it at the Curve sub-object level.) When a closed curve is displayed at the Curve sub-object level, the initial CV is displayed as a green circle, and a green tick mark indicates the curve's direction.

5 Adjust the curve's creation parameters.

6 (Optional) To add a new NURBS curve sub-object, you can turn off the Start New Shape check box, and then repeat the preceding steps.

Interface

The creation parameters are the same for both point curves and CV curves.

Rendering rollout
Enable In Renderer When on, the shape is rendered as a 3D mesh using the Radial or Rectangular parameters set for Renderer.

Enable In Viewport When on, the shape is displayed in the viewport as a 3D mesh using the Radial or Rectangular parameters set for Renderer.

Use Viewport settings Lets you set different rendering parameters, and displays the mesh generated by the Viewport settings. Available only when Enable in Viewport is turned on.

Generate Mapping Coords Turn this on to apply mapping coordinates. Default=off.

The U coordinate wraps once around the thickness of the spline; the V coordinate is mapped once along the length of the spline. Tiling is achieved using the Tiling parameters in the material itself.

Real-World Map Size Controls the scaling method used for texture mapped materials that are applied to the object. The scaling values are controlled by the Use Real-World Scale settings found in the applied material's Coordinates rollout on page 6201. Default=on.

Viewport Turn this on to specify Radial or Rectangular parameters for the shape as it will display in the viewport when Enable in Viewport is turned on.

Renderer Turn this on to specify Radial or Rectangular parameters for the shape as it will display when rendered or viewed in the viewport when Enable in Viewport is turned on.

Radial Displays the 3D mesh as a cylindrical object.

Thickness Specifies the diameter of the viewport or rendered spline mesh. Default=1.0. Range=0.0 to 100,000,000.0.

Splines rendered at thickness of 1.0 and 5.0, respectively
**Sides** Sets the number of sides (or facets) for the spline mesh in the viewport or renderer. For example, a value of 4 results in a square cross section.

**Angle** Adjusts the rotational position of the cross-section in the viewport or renderer. For example, if the spline mesh has a square cross section you can use Angle to position a "flat" side down.

**Rectangular** Displays the spline's mesh shape as rectangular.

**Aspect** Sets the aspect ratio for rectangular cross-sections. The Lock check box lets you lock the aspect ratio. When Lock is turned on, Width is locked to Depth that results in a constant ratio of Width to Depth.

**Length** Specifies the size of the cross-section along the local Y axis.

**Width** Specifies the size of the cross-section along the local X axis.

**Angle** Adjusts the rotational position of the cross-section in the viewport or renderer. For example, if you have a square cross-section you can use Angle to position a "flat" side down.

**Auto Smooth** If Auto Smooth is turned on, the spline is auto-smoothed using the threshold specified by the Threshold setting below it. Auto Smooth sets the smoothing based on the angle between spline segments. Any two adjacent segments are put in the same smoothing group if the angle between them is less than the threshold angle.

**Threshold** Specifies the threshold angle in degrees. Any two adjacent spline segments are put in the same smoothing group if the angle between them is less than the threshold angle.

---

A curve and the same curve rendered with thickness
Keyboard Entry rollout

The Keyboard Entry rollout lets you create a NURBS curve by typing. Use the Tab key to move between the controls in this rollout. To click a button from the keyboard, press Enter while the button is active.

<table>
<thead>
<tr>
<th>Keyboard Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>X: 0.0</td>
</tr>
<tr>
<td>Y: 0.0</td>
</tr>
<tr>
<td>Z: 0.0</td>
</tr>
<tr>
<td>Weight: 1.0</td>
</tr>
</tbody>
</table>

**Add Point** Adds the CV to the curve.

**Weight** Enter a weight for the CV.

**Close** Ends creation of the curve and creates a segment between the last CV and the initial CV, to make the curve a closed curve.

**Finish** Ends creation of the curve, leaving it open ended.

Create CV Curve rollout

This rollout contains the controls for curve approximation.
Interpolation group

The controls in this group box change the accuracy and kind of curve approximation on page 2736 used to generate and display the curve.

Draw In All Viewports Lets you use any viewport while you are drawing the curve. This is one way to create a 3D curve. When off, you must finish drawing the curve in the viewport where you began it. Default=On.
While Draw In All Viewports is on, you can also use snaps on page 2819 in any viewport.

Automatic Reparameterization group

The controls in this group box let you specify automatic reparameterization. They are similar to the controls in the Reparameterize dialog on page 2733, with one addition: all choices except for None tell 3ds Max to reparameterize the curve automatically; that is, whenever you edit it by moving CVs, refining, and so on.

None Do not reparameterize automatically.

Chord Length Chooses the chord-length algorithm for reparameterization.
Chord-length reparameterization spaces knots (in parameter space on page 8674) based on the square root of the length of each curve segment.
Chord-length reparameterization is usually the best choice.

Uniform Spaces the knots uniformly.
A uniform knot vector has the advantage that the curve or surface changes only locally when you edit it. With the other two forms of parameterization, moving any CV can change the entire sub-object.

Creating NURBS Curve and Surface Objects

These topics describe how to create top-level, “starter” NURBS objects.

Creating Independent Surfaces from NURBS Curve Objects

To create independent surfaces from top-level NURBS curve objects, use the Extrude on page 1425 and Lathe on page 1474 modifiers. Extrude adds height to
the curve, creating a shape by sweeping it along the curve's local Z axis. Lathe
creates a surface of rotation, revolving the shape along a specified axis. You
can also use the Bevel on page 1169 and Bevel Profile on page 1176 modifiers on
NURBS curves.

These modifiers treat NURBS curves the same way they treat shapes on page
572. The advantage of using NURBS curves instead of shapes is in the different
possible shapes that NURBS geometry and editing provide.

**TIP** When you create a complicated surface, especially with the Lathe modifier,
you often want to render both sides of the surface. To see both sides of the
extruded or lathed surface in rendered output, turn on Force 2-Sided on the Render
Setup dialog. To see both sides in viewports, turn on Force 2-Sided on the Viewport
Configuration dialog.

By default, an object with Extrude or Lathe collapses to an editable mesh on
page 2192 object. To have Extrude or Lathe output collapse to a NURBS object,
change the setting to NURBS in the Output group box of the Extrude or Lathe
rollout, and then collapse the modifier stack on page 8187.

**Creating NURBS Curves from Splines**

Select Spline object. > Modify panel > Right-click the spline name. > Convert
To: NURBS

You can turn a spline on page 577 into a NURBS object formed of CV curves
on page 2464. Once converted, you can no longer edit the spline shape
parametrically, but you can edit it as a NURBS object, moving CVs and so on.
Splines become NURBS curves that then become NURBS surfaces.

When you convert a spline circle on page 590 to a NURBS curve, the direction of the curve is reversed. This facilitates using the curve to trim a surface: if the direction weren't reversed, usually the circle would trim outward instead of inward.

Procedures

To turn a spline into NURBS curves:

1. Create the spline.

2. Go to the Modify panel.

3. In the stack display, right-click the name of the spline.

4. On the pop-up menu, choose Convert To: NURBS.
   The spline is converted to one or more CV curves.
   Smoothly curved splines, such as circles and arcs, convert to a single CV curve.
Splines with sharp angles, such as rectangles and stars, convert to multiple CV curves whose endpoints are at the angles in the original spline. These endpoints are fused except for the initial CV in the spline (for a star, the initial segment is unfused at both ends).

"Sharp angles" doesn't apply to smooth splines to which you have given angles by changing vertex tangents using the Edit Spline on page 1424 modifier. These still convert to a single NURBS curve.

Creating NURBS Surfaces from Geometric Primitives

You can turn a standard primitive on page 388 into a NURBS object formed of CV surfaces on page 2606. Once converted, you can no longer edit the object parametrically, but you can edit it as a NURBS object, moving CVs and so on.

Primitive objects become NURBS surfaces that you can then edit in various ways.

You can't convert most extended primitive objects in this way, but you can convert the torus knot on page 426 and prism on page 458 extended primitives to NURBS objects.
You can also convert patch on page 2408 objects and loft on page 742 compound objects.

**Tips**

- Geospheres are good for creating rounded models with no sharp edges.
- Boxes are good for creating models that have sharp edges.
- Flattened cones work well for models whose contours are roughly triangular.

If the primitive is closed, the converted surface is a closed CV surface, which has no visible seams. Also, relational cap surfaces on page 2643 are used to cap surfaces that aren’t closed.

**Procedures**

To turn a primitive into a NURBS object:

1. Create the primitive object.
2. Go to the Modify panel.
3. In the stack display, right-click the name of the object.
4. On the pop-up menu, choose Convert To: NURBS.
   The object is converted to one or more CV surfaces. The surfaces can be independent surface sub-objects, or dependent surface sub-objects such as Lathe.

**Nonrelational NURBS Surfaces**

Select NURBS object. > Modify panel > General rollout > Relational Stack toggle
Nonrelational NURBS surfaces provide a way to improve the performance of NURBS with modifiers. These are controlled by the Relational Stack toggle on the General rollout for NURBS objects.
When Relational Stack is on, NURBS maintain full relational modeling on the modifier stack on page 8187. When this toggle is off (the default), then using the modifier stack converts surfaces into independent CV surfaces before applying modifiers. Surfaces on the stack behave in a nonrelational way. If your NURBS model contains no dependent surfaces, then it behaves the same on the stack regardless of the Relational Stack setting. However, the results are still faster if Relational Stack is turned off.

When Relational Stack is off, there is no overhead of copying the data from the relational model, and no need to compute the relational surfaces, so performance is faster.

**TIP** To improve performance still further, display surfaces as shaded lattices (see Display Controls for NURBS Models on page 2486). With Relational Stack off and Shaded Lattice chosen, NURBS objects perform on the stack about as well as mesh objects do.
Procedures

To use nonrelational NURBS surfaces:

1. Make sure Relational Stack is off and Shaded Lattice is chosen.

2. Set up your modifiers and animation.

3. If your model has only independent CV surfaces, you can render it now. If it has relational surfaces such as blends or lofts, then before you render, choose the NURBS model at the bottom of the stack, and turn on Relational Stack.

   When you return to the top of the modifier stack, performance is slower but dependent surfaces are accurate. The modified NURBS model looks different than it did with the nonrelational stack. Usually the difference in appearance isn't great, but the nonrelational stack can show anomalies such as cracks between Blend surfaces.

Display Controls for NURBS Models

Modify panel > Select NURBS object. > General rollout > Display group, Surface Display group, and NURBS Creation Toolbox button

Modify panel > Select NURBS object. > Right-click in viewport. > Display commands on the Tools 1 (upper-left) quadrant of the quad menu

The check boxes on the General rollout for a NURBS curve or surface control how the object is displayed in viewports. If all check boxes are turned off, the NURBS object is invisible (except for the white bounding-box indicators displayed in shaded viewports when the object is selected).

An additional rollout, Display Line Parameters on page 2489, contains controls for how surfaces display in viewports.
### Interface

![Interface Display Group](image)

#### Display group

**Lattices** When on, displays control lattices in yellow lines. (You can change the lattice color using the Colors panel on page 8272 of the Customize User Interface dialog.) The Curve CV and Surface CV sub-object levels also have a local Display Lattice toggle, which overrides this global setting at the sub-object level. The Curve CV and Surface CV settings are independent. In other words, at the sub-object level you can turn on the lattice for an object’s curves but not its surfaces, or vice versa.

Keyboard shortcut (while Keyboard Shortcut Override Toggle is on): Ctrl+L

At the object level, this shortcut is equivalent to turning Lattice on or off. At the sub-object level, Ctrl+L overrides the setting of Lattice, toggling the local Display Lattice setting.

**Curves** When on, displays curves.

Keyboard shortcut (while Keyboard Shortcut Override Toggle is on): Ctrl+Shift+C

**Surfaces** When on, displays surfaces.

Keyboard shortcut (while Keyboard Shortcut Override Toggle is on): Ctrl+Shift+S

**Dependents** When on, displays dependent sub-objects.

Keyboard shortcut (while Keyboard Shortcut Override Toggle is on): Ctrl+D

**Surface Trims** When on, displays surface trimming on page 2420. When turned off, displays the entire surface, even if it’s trimmed.

Keyboard shortcut (while Keyboard Shortcut Override Toggle is on): Ctrl+Shift+T

**Transform Degrade** When on, transforming a NURBS surface can degrade its display in shaded viewports, to save time. This is similar to the Degradation Override on page 123 button for playing animations. You can turn off this...
toggle so surfaces are always shaded while you transform them, but transforms can take longer.
Keyboard shortcut (while Keyboard Shortcut Override Toggle is on): Ctrl+X

**TIP** You can toggle Ctrl+X during a transform, as well as before you begin the transform.

NURBS Creation Toolbox
Turn on to display the NURBS sub-object creation toolbox. See Using the NURBS Toolbox to Create Sub-Objects on page 2426.
Keyboard shortcut (while Keyboard Shortcut Override Toggle is on): Ctrl+T

**Surface Display group**

![Surface Display]

This group box, for surfaces only, lets you choose how to display surfaces in viewports.

**Tessellated Mesh** When chosen, NURBS surfaces display as fairly accurate tessellated meshes in shaded viewports. In wireframe viewports, they appear as either iso curves or wire meshes, depending on the settings you've chosen on the Display Line Parameters rollout on page 2489.

**Shaded Lattice** When chosen, NURBS surfaces appear as shaded lattices in shaded viewports. Wireframe viewports display the surface's lattice without shading. A shaded lattice shades the CV control lattice on page 8538 of the NURBS surface. This displays more quickly than a tessellated mesh. The shading is not accurate. It gives you a fairly good idea of loft's, but is less accurate for free-form surfaces. The shading is always as large or larger than the actual surface, because of the convex hull property on page 8540.

Shaded lattice display doesn't show surface trimming on page 2420 or texture mapping.

**TIP** Shaded Lattice is a good option to choose when you use the modifier stack with nonrelational NURBS surfaces on page 2484.

Keyboard shortcut: Alt+L
(You can use this keyboard shortcut without having to turn on the Keyboard Shortcut Override Toggle.)

**Display Line Parameters for NURBS Surfaces**

Select NURBS object. > Modify panel > Display Line Parameters rollout
These parameters are contained on a single rollout at the top level of a NURBS object.

**Interface**

![Display Line Parameters Rollout]

**U Lines and V Lines** The number of lines used to approximate the NURBS surface in viewports, along the surface's local U and V dimensions, respectively. Reducing these values can speed up the display of the surface, but reduce accuracy of the display. Increasing these values increases accuracy at the expense of time. Setting one of these values to 0 displays only the edge of the object in the corresponding dimension.
Iso and mesh displays of a NURBS teapot

**Iso Only** When chosen, all viewports display iso line representations of the surface. Iso(parametric) lines are similar to contour lines. The lines show where the NURBS surface has a constant U value or V value or both. Iso line representations can be less crowded and easier to visualize than wire mesh representations.

**Iso and Mesh** (The default.) When chosen, wireframe viewports display iso line representations of the surface, and shaded viewports display the shaded surface.

**Mesh Only** When chosen, wireframe viewports display the surface as a wire mesh, and shaded viewports display the shaded surface. In wireframe viewports, this option lets you see the surface approximation on page 2737 used for viewports.

### Creating and Editing NURBS Sub-Objects

These topics describe how to create and edit lower-level, sub-object NURBS.

#### Attaching and Importing 3ds Max Objects

Modify panel > Select NURBS object > General rollout > Attach button, Import button, and related controls
You can bring other 3ds Max objects into a NURBS model.

There are two ways to bring other 3ds Max objects into a NURBS object:

- **Attach**, which works like Attach for meshes and splines. It converts the attached object to NURBS format. Once the object is attached, you can edit it as a NURBS surface or curve. However, the attached object's history is lost.

  **NOTE** For NURBS surfaces, you can attach other NURBS objects, standard primitive on page 388 objects, or quad patch on page 2410 and tri patch on page 2413 surfaces. The patch is converted to a NURBS surface. Quad patches convert more successfully than Tri Patches. A converted Tri Patch has a collapsed internal edge, which gives irregular results when you manipulate its mesh.

  When you convert a spline circle on page 590 to a NURBS curve, the direction of the curve is reversed. This facilitates using the curve to trim a surface: if the direction weren't reversed, usually the circle would trim outward instead of inward.

- **Import**, which works somewhat like the operand of a Boolean on page 713. The object is brought into the NURBS object without losing its history. You can select the imported object as a sub-object.

**Using Imports**

Here are reasons to use Import instead of Attach:

- To maintain parametric control over primitives. For example, if you import a sphere, you can change its radius directly, which you can't do after using Attach.

- To use Bezier splines as NURBS curves. For example, if you want to use a Bezier spline as a curve in a NURBS model, import it. This allows you to edit it as a Bezier spline, and not as a NURBS curve.

Surfaces and curves created by an import are available in the NURBS model. For example, if you import a box, you can create a blend surface between one of its polygons and another surface in your NURBS object.

Once you have imported an object, the NURBS object has an Imports sub-object level. When you select an import, it is highlighted in red.

It is an error to apply a modifier to an import when the modifier converts the import into something that can't be converted to a NURBS object. For example,
if you import a sphere and apply a Bend on page 1165 to it, the sphere converts to an editable mesh, which can't automatically convert to a NURBS surface. In this case, the import sub-object is in an error state, and it is displayed in the error color (orange by default).

Imports are displayed in two different ways. While you work at the NURBS object level or at a sub-object level other than Imports, imports are displayed as NURBS curves or surfaces, and use the NURBS object's mesh tessellation (see Surface Approximation on page 2737). However, at the Imports sub-object level, the selected import is displayed using its native display format. In other words, it displays as it would if it were a top-level object. This is because the display must let you edit the imported object. For example, an imported Bezier spline needs to display its tangent handles. This wouldn't be possible if it were displayed as a converted NURBS curve. Leaving the Imports sub-object level returns to NURBS-style display.

You can extract an imported object. This creates an independent, top-level object again.

![Extract](image)

**Procedures**

**To attach or import an object to a NURBS object:**

1. Select the NURBS object and go to the Modify panel.

2. (Optional.) Turn on Reorient if you want to reorient and align the import with the center of the NURBS object.

3. Turn on Attach or Import.

   **NOTE** At this step, you can click Attach Multiple or Import Multiple instead. These buttons open a Select From Scene dialog on page 206 so you can choose multiple objects to attach or import.

4. Click the object to attach or import.

   The mouse cursor changes shape to indicate a valid object. You can attach curves, NURBS surfaces, or objects convertible to NURBS.
To extract an imported object:

1. Go to the Imports sub-object level and select the object to extract.
2. Click Extract Import on the Import sub-object rollout.

If Copy is set (the default), the extracted object is a top-level copy of the imported object. If Instance is set, the extracted object is an instance of the imported object. Initially the extracted object occupies the same space as the imported object; you must move either the extracted object, the import sub-object, or the whole NURBS model before you can see the extracted object.

**Interface**

![Attach, Attach Multiple, Reorient, Import, Import Multiple buttons]

**Attach and Import controls**

**Attach** Lets you attach another object to the NURBS object. Click to turn on Attach, and then click the object to attach. If the object you're attaching isn't already a NURBS object, it is converted to one or more NURBS curves or surfaces that are sub-objects of the object you're modifying.

**Attach Multiple** Lets you attach multiple objects to the NURBS surface. Opens a version of the Select From Scene dialog on page 206, listing the objects that can be attached. Use the dialog controls to select one or more objects by name, and then click Attach.

**Reorient** Moves and reorients the object you are attaching or importing so its creation local coordinate system is aligned with the creation local coordinate system of the NURBS object.

**Import** Lets you import another object to the NURBS object. Works the same way Attach does, but the imported object retains its parameters and modifiers.

**Import Multiple** Lets you import multiple objects. Works the same way Attach Multiple does, but the imported objects retain their parameters and modifiers.
Common Sub-Object Controls

Many controls are common to the various kinds of sub-objects in NURBS models (with the exception of Imports on page 2490). This topic introduces the controls that are common to most NURBS sub-objects.

See also:
- Editing Point Sub-Objects on page 2496
- Editing Curve CV Sub-Objects on page 2503
- Editing Surface CV Sub-Objects on page 2509
- Editing Curve Sub-Objects on page 2518
- Editing Surface Sub-Objects on page 2530

Transforming Sub-Objects

One way to alter a NURBS model is to transform its sub-objects. Transforming lets you interactively change the model's curvature and shape. Transforming points or CVs is especially useful for adjusting the shape of a NURBS curve or surface.

You can also Shift+Clone most kinds of sub-objects, except CVs. For curves and surfaces, Shift+Cloning displays a Sub-Object Clone Options dialog on page 2734, which lets you reduce relational dependencies to improve performance.

Selection Controls

There is a Selection group box on the rollout for all NURBS sub-objects except Imports. The buttons in this group let you control which sub-objects to select. The selection buttons let you select sub-objects individually, or multiple sub-objects at once. For example, Surface CV selection buttons give you the option of selecting individual CVs, or selecting a row of CVs on the surface, and so on.

NOTE There is no delete modifier for NURBS curves as there is for splines. There is a NURBS selection modifier, NSurf Sel on page 1555. See NURBS and Modifiers on page 2436.
Selection controls also include a Name field that lets you customize the name of individual NURBS sub-objects other than CVs. (The Name field is the only selection control for Import sub-objects.)

**Visibility**

You can hide or unhide NURBS sub-objects as you do other objects. Hidden sub-objects are invisible in viewports, but remain renderable. (At the sub-object level, hiding doesn’t affect the renderer.) You can’t select hidden sub-objects. Hide and unhide by name is available for curve and surface sub-objects.

**Make Independent**

You can make a dependent point, curve, or surface sub-object independent.

**WARNING** When you make an object independent, you lose the animation controllers for all objects that depend on it in turn. When you make point objects independent, you lose the animation controllers for all points on the curve or surface. Also, if you make a curve that trims a surface independent, you lose the trimming of the surface.

**Remove Animation**

All sub-object rollouts have a Remove Animation button. This removes animation controllers from the selected sub-objects.

**Detach and Copy**

You can create a new curve or surface object by detaching a curve or surface sub-object from a NURBS model. To do so, select the curve or surface and then click Detach. A dialog is displayed, which lets you enter a name for the new NURBS object. The new object is no longer part of the original NURBS object.

You can also use the Detach button to create a new NURBS object that is a copy of a curve or surface sub-object. To do so, select the curve or surface, and click to turn on Copy before you click Detach. A dialog is displayed, which lets you enter a name for the new object. The original curve or surface sub-object remains part of the NURBS object you were editing, but the copied curve or surface is now a NURBS object of its own.

**Relational** This toggle affects dependent objects. When off, detaching a dependent sub-object makes it an independent object. For example, detaching a U loft converts it to a CV surface. When on, detaching a dependent sub-object
also detaches the objects it depends on, so the object remains dependent. For example, detaching a U loft also detaches the curves that define it.

**Editing Point Sub-Objects**

Modify panel > Select NURBS object or sub-object > Point sub-object level > Select point sub-objects.

Modify panel > Select NURBS object or sub-object > Right-click > Tools 1 (upper-left) quadrant > Sub-objects > Point > Select point sub-objects.

This topic describes the controls for point sub-objects. A rollout labeled Point contains the point sub-object controls for NURBS models. In addition to the Point rollout described here, the Point sub-object level displays the Soft Selection rollout on page 2541.

**Procedures**

To transform point sub-objects:

1. At the Point sub-object level, select one or more points.
   The sub-object selection tools are the same as for other kinds of sub-objects. You can also use the H key while the Keyboard Shortcut Override toggle on page 8420 is on. See Sub-Object Selection on page 2428.
   The Selection group box, described under "Interface" later in this topic, provides some additional options for selecting Point sub-objects.

2. Turn on Move or another transform and then drag in a viewport to transform the selection.
   The shape of the model changes as you interactively transform the points. Rotate and Scale are useful only when you've selected multiple points.

**Tips**

- The Lock Selection Set button is useful when you transform NURBS point sub-objects. You can make a selection in one viewport, click Lock Selection Set (or press the Spacebar), and then transform the selection in a different viewport.

- When you move point sub-objects, move them as systematically as possible to avoid "getting lost."
On surfaces, avoid moving points so they cross over or under adjacent points. This can create odd-looking warps or overlaps in the surface.

**To Shift+Clone a point sub-object:**
- Hold down Shift while you transform the point.
  This works only for points that lie on curves or surfaces, independent point on page 2695 sub-objects, and curve point on page 2698 or surface point on page 2701 sub-objects that lie on the curve or surface (that is, that aren't displaced).

**To use the keyboard to select point sub-objects:**
You can select point sub-objects using the Ctrl key and the arrow keys. The arrows traverse the sub-objects in the order they were created. To do so, follow these steps:

1. Turn on the Keyboard Shortcut Override Toggle.
2. Click or drag to select points.
3. Hold down Ctrl and use the arrow keys to move among the point sub-objects.
   For points on curves, the arrow keys traverse the point selection along the length of the curve. The arrow keys don’t move between curve sub-objects.
   For points on surfaces, the left and right arrow keys traverse the U dimension of a surface, while the up and down arrow keys traverse the V dimension of the surface. The arrow keys don’t move between surface sub-objects.
   The arrow keys don’t traverse individually created points that aren’t part of a curve or surface.

You can also use the H keyboard shortcut (while the Keyboard Shortcut Override Toggle is on) to display a dialog and select points by name. Ctrl+H displays only the names of points directly beneath the mouse cursor.

**To remove a point from a curve:**
1. Select a point.
2 In the Delete group box, click Point.
   Keyboard shortcut: Delete
   The point is deleted and the shape of the curve is updated.

   **NOTE** An open point curve must have at least two endpoints.

**To remove points from a surface:**
1 Select a point, row, or column.
   The appropriate Delete buttons are enabled.
2 In the Delete group box, click Point, Row, or Col.
   The point, row, or column is deleted. Deleting a "single" point actually
   deletes both the row and column to which the point belongs.

**To add a point to a curve:**
1 In the Refine group box, turn on Curve.
2 Click the curve where you want to add the point.
   A point is added at the location you clicked. The curvature can change.

**To add a point and extend the length of a curve:**
1 Click to turn on Extend.
2 Move the mouse over a point curve. The curve is highlighted in blue,
   and one of the curve's ends displays a box to show where the curve will
   be extended.
3 Drag from the highlighted end point, and then release the mouse button.
   A new point is added beyond the original length of the curve.

**To add points to a point surface:**
1 In the Refine group box, click Surf Row, Surf Col., or Surf Row & Col.
2 Click the surface.
   A row, a column, or both are added close to the point where you clicked
   the surface. The new points are placed on the surface so they preserve
   the surface's curvature. The curvature can change, but only slightly.
To fuse two points:

1. Turn on Fuse.
2. Click a point without releasing the mouse button. Drag to another point, and then release the mouse button.

   The first point you choose acquires the position of the second point, and becomes dependent to it. If the first point has an animation controller, the controller is discarded. If the second point has an animation controller, the first point acquires it too.

   Fused points display in purple by default.

To unfuse fused points:

1. Select the fused point.
2. Click Unfuse.
   - Now you can move and edit the two points independently.

To transform a region:

1. Using sub-object selection, select one or more points for the center of transformation.
2. Turn on Soft Selection.
3. Transform the point.
   - A region around the selected point is transformed accordingly.

Move is the most common transform to use. Rotate and Scale can be used with a non-local transform center.

**TIP** If Soft Selection appears not to be working, the Falloff value might be too small for the size of your surface. On the Soft Selection rollout on page 2541, increase the value of Falloff so it encompasses other points.

**Interface**

In addition to the Point rollout described here, the Point sub-object level also displays the Soft Selection rollout on page 2541.
Selection group

Point sub-object selection controls

- **Single Point** (The default.) When on, you can select individual points by clicking, or groups of points by dragging a region.

- **Row of Points** When on, clicking a point selects the entire row the point belongs to. Dragging selects all rows in the region.
  If the point is on a curve, Row of Points selects all points in the curve.

- **Column of Points** When on, clicking a point selects the entire column the point belongs to. Dragging selects all columns in the region.
  If the point is on a curve, Column of Points selects only a single point.

- **Row and Column of Points** When on, clicking a point selects both the row and column the point belongs to. Dragging selects all rows and columns in the region.

- **All Points** When on, clicking or dragging selects all the points in the curve or surface.

**TIP** Rows and columns are easily visible when the NURBS surface is planar, or nearly so. When the surface has a complicated curvature, rows and columns can be more difficult to see. The Row, Column, and Row/Column buttons can be especially useful in this situation.

**Name** Shows the name of the currently selected point. It is disabled if you have selected multiple points.
By default, the name is "Point" followed by a sequence number. You can use this field to give the point a name that you choose.

**Hide** Click to hide the currently selected points.

**Unhide All** Click to unhide all hidden points.

**Fuse** Fuses a point to another point. (You can't fuse a CV to a point, or vice versa.) This is one way to connect two curves or surfaces. It is also a way to change the shape of curves and surfaces.

Fusing points does **not** combine the two point sub-objects. They are connected but remain distinct sub-objects that you can unFuse later.

Fused points behave as a single point until you unFuse them.

Fused points are displayed in a distinct color. The default is purple. (You can change this color using the Colors panel on page 8272 of the Customize User Interface dialog on page 8249.)

**Unfuse** Unfuses the fused points.

**Extend** Extends a point curve. Drag from the end of a curve to add a new point and extend the curve.

**WARNING** When you add points with Extend, you lose the animation controllers for all points on the curve or surface.

**Make Independent** Disabled if the point is independent. If the point is dependent, clicking this button makes it independent.

**WARNING** When you make a point independent, you lose the animation controllers for all objects that depend on it in turn.

**Remove Animation** Removes animation controllers from the selected points.

**Delete group**

The buttons in this group box delete one or more points.

**Point** Deletes a single point (on a curve) or a row and column of points (on a surface).

**Row** Deletes a row from a surface.

**Col.** Deletes a column from a surface.

**WARNING** When you delete points, you lose the animation controllers for all points on the curve or surface.
Refine group

The buttons in this box refine point curves or surfaces by adding points to them.

**Curve** Adds points to a point curve.

**Surf Row** Adds a row of points to a point surface.

**Surf Col.** Adds a column of points to a point surface.

**Surf Row & Col.** Adds both a row and a column to a point surface; their intersection is where you click the surface.

---

**WARNING** When you add points, you lose the animation controllers for all points on the curve or surface.

---

**Points Selected** This text field shows how many points are currently selected.

---

Editing Curve CV Sub-Objects

Modify panel > Select NURBS object or sub-object. > Stack display > Curve CV sub-object level > Select CV sub-objects.

Modify panel > Select NURBS object or sub-object. > Right-click. > Tools 1 (upper-left) quadrant > Sub-objects > Curve CV > Select CV sub-objects.

This topic describes the controls for CV sub-objects that lie on curves. A rollout labeled CV contains the CV sub-object controls for NURBS models. In addition to the CV rollout described here, the Curve CV sub-object level displays the Soft Selection rollout on page 2541.

In you can edit the CVs in **CV curves on surfaces** on page 2593 as you edit other kinds of curve CVs. You can transform CVs in CV curves on surfaces, but you can't move the CVs off the surface. Using the Curve CV sub-object level is an alternative to editing these CVs by using the **Edit Curve on Surface** on page 2716 dialog.

---

Procedures

**To transform curve CV sub-objects:**

1. At the Curve CV sub-object level, select one or more CVs.
The sub-object selection tools are the same as for other kinds of sub-objects. You can also use the H key while the Keyboard Shortcut Override toggle on page 8420 is on. See Sub-Object Selection on page 2428.

The Selection group box, described under "Interface" later in this topic, provides some additional options for selecting CV sub-objects.

2 Turn on Move or another transform and then drag in a viewport to transform the selection.

The shape of the model changes as you interactively transform the CVs. Rotate and Scale are useful only when you've selected multiple CVs.

**Tips**

- When you transform NURBS CV sub-objects, the Lock Selection Set button can be useful. You can make a selection in one viewport, click Lock Selection Set (or press the Spacebar), and then transform the selection in a different viewport.

- When you move CV sub-objects, move them as systematically as possible to avoid "getting lost."

**To use the keyboard to select curve CV sub-objects:**

You can select curve CV sub-objects using the Ctrl key and the arrow keys. The arrows traverse the sub-objects in the order they were created. To do so, follow these steps:

1. Turn on the Keyboard Shortcut Override Toggle.

2. Click or drag to select CVs.

3. Hold down Ctrl and use the arrow keys to move among the CV sub-objects. For CVs on curves, the arrow keys traverse the CV selection along the length of the curve. The arrow keys don't move between curve sub-objects.

You can also use the H keyboard shortcut (while the Keyboard Shortcut Override Toggle button is on) to display a dialog and select CVs by name. Ctrl+H displays only the names of CVs directly beneath the mouse cursor.
To remove a CV from a curve:

1 Select a CV.

2 Click Delete.
   - Keyboard shortcut: Delete
   - The CV is deleted and the shape of the curve is updated.

   **NOTE** A CV curve must have at least one more CV than the degree on page 8549 of the curve.

To add a CV to a curve:

1 Turn on Refine.

2 Click the curve where you want to add the CV.
   - A CV is added at the location you clicked. Neighboring CVs move away from the new CV in order to preserve the original curvature.

To add CVs and extend the length of a curve:

1 Click to turn on Extend.

2 Move the mouse over a CV curve. The curve is highlighted in blue, and one of the curve's ends displays a box to show where the curve will be extended.

3 Drag from the highlighted end CV, and then release the mouse button.
   - New CVs are added beyond the original length of the curve.

To fuse two CVs:

1 Turn on Fuse.

2 Click a CV without releasing the mouse button. Drag to another CV, and then release the mouse button.
   - The first CV you choose acquires the position of the second CV, and becomes dependent to it. If the first CV has an animation controller, the controller is discarded. If the second CV has an animation controller, the first CV acquires it too.
   - Fused CVs display in purple by default.
To unfuse fused CVs:

1. Select the fused CV.
2. Click Unfuse.
   Now you can move and edit the two CVs independently.

To transform a region:

1. Using sub-object selection, select one or more CVs for the center of transformation.
2. Turn on Soft Selection.
3. Transform the CV.
   A region around the selected CV is transformed accordingly.

Move is the most common transform to use. Rotate and Scale can be used with a non-local transform center.

**TIP** If Soft Selection appears not to be working, the Falloff value might be too small for the size of your surface. On the Soft Selection rollout on page 2541, increase the value of Falloff so it encompasses other points or CVs.

**Interface**

In addition to the CV rollout described here, the Curve CV sub-object level also displays the Soft Selection rollout on page 2541.
Selection group

Curve sub-object selection controls

- **Single CV** (The default.) When on, you can select individual CVs by clicking, or groups of CVs by dragging a region.

- **All CVs** When on, clicking or dragging selects all the CVs in the curve.
Name  Shows either "No CVs selected", "Multiple CVs selected", or "CurveName(index)", where "CurveName" is the name of the CV's parent curve, and "index" is the CV's U location along the length of the curve. You can't edit the Name field to customize the names of CVs. If CVs are fused, the Name field shows the name of the first CV.

Weight  Adjusts the weight of the selected CVs. You can use a CV's weight to adjust the CV's effect on the curve. Increasing the weight pulls the curve toward the CV. Decreasing the weight relaxes the curve away from the CV. Increasing weight is a way to harden a curve; that is, to sharpen its curvature at a particular location.

By default, the weight is 1.0 for the CVs of NURBS objects that you create on the Create panel or the NURBS sub-object creation rollouts. The weight of CVs in geometry that you convert to NURBS can vary, depending on the object's original shape.

You can change the weight when multiple CVs are selected. Using the Weight field or spinner while multiple CVs are selected assigns all of them the value you choose. Because weights are relative to each other (rational), using the Weight control when all CVs are selected has no visible effect.

Hide  Click to hide the currently selected CVs.

Unhide All  Click to unhide all hidden CVs.

Fuse  Fuses a CV to another CV. (You can't fuse a CV to a point, or vice versa.) This is one way to connect two curves. It is also a way to change the shape of curves.

Fusing CVs does not combine the two CV sub-objects. They are connected but remain distinct sub-objects that you can unfuse later.

Fused CVs behave as a single CV until you unfuse them. Fused CVs behave similar to a single point, but the property of multiplicity for coincident CVs also applies. (See NURBS Concepts on page 2440 and CV Curve on page 2473.) The fused CVs have proportionally more influence on the curve. The curve can become sharper in the fused CVs' vicinity, or even angular if more than two CVs are fused together.

Fused CVs are displayed in a distinct color. The default is purple. (You can change this color using the Colors panel on page 8272 of the Customize User Interface dialog on page 8249.)

Unfuse  Unfuses the fused CVs.

Refine  Refines the curve by adding CVs.
WARNING  When you add CVs with Refine, you lose the animation controllers for all CVs on the curve.

As you move the mouse over the CV curve, a preview of the CVs that will be added, and their locations, is displayed in blue.

TIP  It is a good idea to reparameterize after you have added CVs to a curve by refining. See Editing Curve Sub-Objects on page 2518.

Delete  Deletes the selected CVs.

Insert  Inserts CVs into the curve. Click Insert and then click the curve where you want to insert the new CV. Inserting CVs is similar to refining with CVs, except that other CVs in the curve do not move. This means that the shape of the curve changes when you insert.

Inserting CVs does not remove animation from the curve, as refining does.

TIP  It is a good idea to reparameterize after you have added CVs to a curve by inserting. See Editing Curve Sub-Objects on page 2518.

Extend  Extends a CV curve. Drag from the end of a curve to add a new CV and extend the curve.

WARNING  When you add points with Extend, you lose the animation controllers for all points on the curve.

Remove Animation  Removes animation controllers from the selected CVs.

Display Lattice  When on, displays the control lattice on page 8538 that surrounds CV curves. When off, the control lattice isn’t shown in viewports. Default=on.

CVs Selected  This text field shows how many CVs are currently selected.

Editing Surface CV Sub-Objects

Modify panel > Select NURBS object or sub-object. > Stack display > Surface CV sub-object level > Select CV sub-objects.

Modify panel > Select NURBS object or sub-object. > Right-click a viewport. > Tools 1 (upper-left) quadrant > Sub-objects > Surface CV > Select CV sub-objects.

Procedures  on page 2510
This topic describes the controls for CV sub-objects that lie on surfaces. A rollout labeled CV contains the CV sub-object controls for NURBS models. In addition to the CV rollout described here, the Curve CV sub-object level displays the Soft Selection rollout on page 2541.

Transforming CVs changes the shape of the surface.

Procedures

To transform surface CV sub-objects:

1. At the Surface CV sub-object level, select one or more CVs.
   The sub-object selection tools are the same as for other kinds of sub-objects. You can also use the H key while the Keyboard Shortcut Override Toggle on page 8420 button is on. See Sub-Object Selection on page 2428.
   The Selection group box, described under "Interface" later in this topic, provides additional options for selecting CV sub-objects.

2. Turn on Move or another transform and then drag in a viewport to transform the selection.
The shape of the model changes as you interactively transform the CVs. Rotate and Scale are useful only when you've selected multiple CVs.

**Tips**

- The Lock Selection Set button is useful when you transform NURBS CV sub-objects. You can make a selection in one viewport, click Lock Selection Set (or press the Spacebar), and then transform the selection in a different viewport.
- When you move CV sub-objects, move them as systematically as possible to avoid "getting lost."
- On surfaces, avoid moving CVs so they cross over or under adjacent points. This can create odd-looking warps or overlaps in the surface.

To **Shift+clone surface sub-objects:**

- Hold down Shift while you transform the surface selection. The Sub-Object Clone Options on page 2734 dialog appears. This dialog provides various ways to clone the surfaces, some of which reduce relational dependencies to improve performance.

To **use the keyboard to select surface CV sub-objects:**

You can select surface CV sub-objects using the Ctrl key and the arrow keys. The arrows traverse the sub-objects in the order they were created. To do so, follow these steps:

1. Turn on the Keyboard Shortcut Override Toggle.
2. Click or drag to select CVs.
3. Hold down Ctrl and use the arrow keys to move among the CV sub-objects. For CVs on surfaces, the left and right arrow keys traverse the U dimension of a surface, while the up and down arrow keys traverse the V dimension of the surface. The arrow keys don’t move between surface sub-objects.
You can also use the H keyboard shortcut (while the Keyboard Shortcut Override Toggle button is on) to display a dialog and select CVs by name. Ctrl+H displays only the names of CVs directly beneath the mouse cursor.

To remove CVs from a surface:

1. Select a row, column, or a row and column.
   The appropriate Delete buttons are enabled.
2. In the Delete group box, click Row, Col., or Both.
   The row, the column, or both are deleted.

   **NOTE** You can't delete a single CV from a CV surface. Nor can you delete a row or column if that would make the surface have fewer than four rows or columns.

To add CVs to a CV Surface:

1. In the Refine group box, click Row, Col., or Both.
2. Click the surface.
   A row, a column, or both are added close to the point where you clicked the surface. Neighboring CVs move away from the new CVs in order to preserve the surface's original curvature.

To fuse two CVs:

1. Turn on Fuse.
2. Click a CV without releasing the mouse button. Drag to another CV, and then release the mouse button.
   The first CV you choose acquires the position of the second CV, and becomes dependent to it. If the first CV has an animation controller, the controller is discarded. If the second CV has an animation controller, the first CV acquires it too.

   **NOTE** Fused CVs display in purple by default.

To unfuse fused CVs

1. Select the fused CV.
2. Click Unfuse.
Now you can move and edit the two CVs independently.

**To transform a region:**

1. Using sub-object selection, select one or more CVs for the center of transformation.
2. Turn on Soft Selection.
3. Transform the CV.
   A region around the selected CV is transformed accordingly.

Move is the most common transform to use. Rotate and Scale can be used with a non-local transform center.

**TIP** If Soft Selection appears not to be working, the Falloff value might be too small for the size of your surface. On the Soft Selection on page 2541 rollout, increase the value of Falloff so it encompasses other CVs.

**Interface**

In addition to the CV rollout described here, the Surface CV sub-object level also displays the Soft Selection rollout on page 2541.
CV rollout

Surface CV sub-object rollout
Selection group

Surface CV sub-object selection controls

- **Single CV** (The default.) When on, you can select individual CVs by clicking, or groups of CVs by dragging a region.

- **Row of CVs** When on, clicking a CV selects the entire row the CV belongs to. Dragging selects all rows in the region.

- **Column of CVs** When on, clicking a CV selects the entire column the CV belongs to. Dragging selects all columns in the region.

- **Row and Column of CVs** When on, clicking a CV selects both the row and column the CV belongs to. Dragging selects all rows and columns in the region.

- **All CVs** When on, clicking or dragging selects all the CVs in the surface.

**Name** Shows either "No CVs selected", "Multiple CVs selected", or "SurfaceName(uIndex,vIndex)", where "SurfaceName" is the name of the CV's parent surface, and "uIndex,vIndex" is the CV's UV location on the surface. You can't edit the Name field to customize the names of CVs. If CVs are fused, the Name field shows the name of the first CV.

**Weight** Adjusts the weight of the selected CVs. You can use a CV's weight to adjust the CV's effect on the surface. Increasing the weight pulls the surface toward the CV. Decreasing the weight relaxes the surface away from the CV. Increasing weight is a way to harden a surface: that is, to sharpen its curvature at a particular location.
By default, the weight is 1.0 for the CVs of NURBS objects that you create on the Create panel or the NURBS sub-object creation rollouts. The weight of CVs in geometry that you convert to NURBS can vary, depending on the object's original shape.

You can change the weight when multiple CVs are selected. Using the Weight field or spinner while multiple CVs are selected assigns all of them the value you choose. Because weights are relative to each other (rational), using the Weight control when all CVs are selected has no visible effect.

**TIP** You can increase the curvature of an indentation in a surface by increasing the weight of the CVs surrounding the indented area. This is easier and often more effective than moving the indented area's CVs.

**Hide** Click to hide the currently selected CVs.

**Unhide All** Click to unhide all hidden CVs.

**Fuse** Fuses a CV to another CV. (You can't fuse a CV to a point, or vice versa.) This is one way to connect two surfaces. It is also a way to change the shape of surfaces.

Fusing CVs does not combine the two CV sub-objects. They are connected but remain distinct sub-objects that you can unfuse later.

Fused CVs behave as a single CV until you unfuse them. Fused CVs behave similar to a single point, but the property of multiplicity for coincident CVs also applies. (See NURBS Concepts on page 2440 and CV Curve on page 2473.) The fused CVs have proportionally more influence on the curve, which can become sharper in the fused CVs' vicinity, or even angular if more than two CVs are fused together.

Fused CVs are displayed in a distinct color. The default is purple. (You can change this color using the Colors panel on page 8272 of the Customize User Interface dialog on page 8249.)

**Unfuse** Unfuses the fused CVs.

**Remove Animation** Removes animation controllers from the selected CVs.

**Constrained Motion group**

These buttons constrain CV motion. They are enabled when you select one or more CVs. When you finish dragging the CV selection, the active constraint button turns off.

**U** Constrains the CV selection to move in the surface's U dimension.

Keyboard shortcut (Keyboard Shortcut Override Toggle must be on): Alt+U
V Constrains the CV selection to move in the surface's V dimension.  
Keyboard shortcut (Keyboard Shortcut Override Toggle must be on): Alt+V

**Normal** Constrains the CV selection to move normal to the original surface.  
Keyboard shortcut (Keyboard Shortcut Override Toggle must be on): Alt+N

**Delete group**

These buttons delete CVs from the surface. Select one or more CVs, and then click Row, Col., or Both.

You can't delete surface CVs if the deletion would give the surface fewer than four rows or fewer than four columns. Aside from that restriction, these buttons delete all rows, columns, or rows and columns that contain selected CVs. This means that you can't delete after you make a selection using the Row and Column or All selection buttons: that would imply deleting the entire CV surface.

These buttons are unavailable unless the deletion is possible.

---

**WARNING** When you delete CVs, you lose the animation controllers for all CVs on the surface.

**Row** Deletes rows of CVs from the surface.

**Col.** Deletes columns of CVs from the surface.

**Both** Deletes both rows and columns of CVs from the surface.

**Refine group**

These buttons refine the surface by adding CVs. As you move the mouse over the surface, a preview of the CVs that will be added, and their locations, is displayed in blue.

---

**WARNING** When you add CVs with Refine, you lose the animation controllers for all CVs on the surface.

**Row** Adds a row of CVs to the surface.

**Col.** Adds a column of CVs to the surface.

**Both** Adds both a row and a column of CVs to the surface.

---

**TIP** It is a good idea to reparameterize after you have added CVs to a surface by refining. See Editing Surface Sub-Objects on page 2530.
**Insert group**

These buttons insert CVs into the curve. Click to turn on one of these buttons and then click the surface where you want to insert the new CVs. Inserting CVs is similar to refining with CVs, except that other CVs in the surface do not move. This means that the shape of the surface can change when you insert.

Inserting CVs does not remove animation from the surface the way refining does.

- **Row** Inserts a row of CVs into the surface.
- **Col.** Inserts a column of CVs into the surface.
- **Both** Inserts both a row and a column of CVs into the surface.

**TIP** It is a good idea to reparameterize after you have added CVs to a surface by inserting. See *Editing Surface Sub-Objects* on page 2530.

**Display Lattice** When on, displays the control lattice that surrounds CV surfaces. When off, the control lattice isn't shown in viewports. Default=on.

**CVs Selected** This text field shows how many CVs are currently selected.

---

**Editing Curve Sub-Objects**

Modify panel > Stack display > Open the NURBS object's hierarchy. > Curve sub-object level > Select curve sub-objects.

This topic describes the controls that are common to point and CV curves. A rollout labeled Curve Common contains the curve sub-object controls for NURBS models.

**Procedures**

To transform curves:

1. At the Curve sub-object level, select one or more curves.

   The sub-object selection tools are the same as for other kinds of sub-objects. You can also press the H key when the Keyboard Shortcut Override toggle on page 8420 is on. See *Sub-Object Selection* on page 2428.
The Selection group box, described under "Interface" later in this topic, provides additional options for selecting curves.

2 Turn on Move or another transform and then drag in a viewport to transform the selection.
   The shape of the model changes as you interactively transform the curves.

   **TIP** The Lock Selection Set button is useful when you transform NURBS curve sub-objects. You can make a selection in one viewport, click Lock Selection Set (or press the Spacebar), and then transform the selection in a different viewport.

**To Shift+Clone curve sub-objects:**

- Hold down Shift while you transform the curve selection.
  The Sub-Object Clone Options on page 2734 dialog is displayed. This dialog provides various ways to clone the curves, some of which reduce relational dependencies to improve performance.

**To use the keyboard to select curve sub-objects:**

You can select curve sub-objects using the Ctrl key and the arrow keys. The arrows traverse the sub-objects in the order they were created. To do so, follow these steps:

1 Turn on the Keyboard Shortcut Override Toggle.

2 At the Curve sub-object level, set the selection controls to select curves individually.

3 Click or drag to select curves.

4 Hold down Ctrl and use the arrow keys to move among the curves in the current model.
   At the Curve sub-object level, the left and right arrow keys move forward and backward through individual curves in the order they were created. The up and down arrows are equivalent to left and right.
You can also use the H keyboard shortcut (while the Keyboard Shortcut Override Toggle is on) to display a dialog and select curves by name. Ctrl+H displays only the names of curves directly beneath the mouse cursor.

To delete a curve:

- Select the curve and then click Delete.
  Keyboard shortcut: Delete

To turn a CV curve into a point curve:

1 Select the curve sub-object, and then click Make Fit.
   The Make Point Curve on page 2730 dialog is displayed. This dialog asks how many points the new point curve should have.

2 Change the number of points, and then click OK.
   Reducing the number of points can change the shape of the curve.

If the selected curve is already a point curve, you can use Make Fit to change the number of points it has.

To select a first vertex on the curve:

- Select the curve sub-object, turn on Make First, and then click a location on the curve.
  If the curve is closed and there is a vertex where you click, this vertex becomes the first vertex. If the curve is closed and there is no vertex where you click, a new vertex is created at the location you click. It becomes the new first vertex, and the curve's points or CVs adapt to maintain the curvature.
  If the curve is open, clicking it has no effect.

**WARNING** Using Make First discards any animation controllers for the points or CVs in the curve.

If the curve is open, the first vertex must be one of the endpoints (by default, it is the first you created). The Make First button has no effect, but you can use Reverse to change the curve's direction.
The small circle indicates the first vertex.

To turn a curve that lies on a surface into a Point Curve on Surface:

1. Select the curve sub-object, and then click Make COS. Make COS is unavailable unless the curve already lies on a surface; for example, it is a U Iso curve.

2. The Convert Curve on Surface dialog on page 2710 is displayed.
Choose CV Curve on Surface to create a CV curve, or Point Curve on Surface to create a point curve. The Number of CVs or Number of Points values let you specify the complexity and accuracy of the new curve on surface. If Preview is on, the new curve is previewed in viewports. This can help you choose the number.

**To reverse a curve:**

- Select a curve sub-object and then click Reverse.
Reversing a curve affects the blend surface that depends on it.

**To join two curves:**

1. In a NURBS object that contains two curve sub-objects, turn on Join.

2. Click one curve near the end that you want to connect. Drag to near the end of the other curve, and then release the mouse.
   
   The Join Curve dialog on page 2723 is displayed. This dialog gives you a choice of methods for joining the curves. Whichever method you choose, the two original curves are replaced by a single curve.

3. If the gap between the curves is small (less than about 30 units), use the Join Curve dialog to set the Tolerance value greater than the distance of the gap.

**To break a curve:**

- Turn on Break and then click a curve.
The curve is split into two independent curve sub-objects. Two coincident (but independent) points or CVs are created at the location you clicked: each is the endpoint of one part of the original curve.

If the curve is a closed curve, Break creates a single curve object, with its new start and end points at the location you clicked. The new start and end points are coincident but independent.

**To close a curve:**

- Select the curve and then click Close.
  3ds Max closes the curve by adding a segment between the curve's endpoints. The curvature of the new segment blends the curvature of the previous end segments.

Closing a curve does not add points or CVs. The curve retains its original number of points or CVs, and increases its number of segments by one.
Interface

Curve Common rollout
The controls on this rollout apply to all curve types. Depending on the type of curve, an additional rollout is displayed with controls specific to that type of curve.

**Selection group**

The selection buttons for curve sub-objects let you select either individual curves, or curves that are connected in space.

**Curve sub-object selection controls**

**Single Curve** Clicking or transforming a curve selects only a single independent curve sub-object.

**All Connected Curves** Clicking or transforming a curve selects all curve sub-objects that are connected within the NURBS object. To be connected, two curves must have fused points, or one curve must be a connected dependent (a blend, fillet, or chamfer) of the other.

**Name** Shows the name of the currently selected curve. It is disabled if you have selected multiple curves.

By default, the name is the name of the curve type ("CV Curve" or "Point Curve") followed by a sequence number. You can use this field to give the curve a name that you choose.

**Hide** Click to hide the currently selected curves.

**Unhide All** Click to unhide all hidden curves.

**Hide by Name** Click to display a Select Sub-Objects dialog that lists curves by name. Select the curves to hide, then click Hide.

**Unhide by Name** Disabled unless there are hidden curves. Click to display a Select Sub-Objects dialog that lists curves by name. Select the curves to make visible, then click Unhide.

**Delete** Deletes the selected curve sub-objects.
Make Fit  Turns a CV curve into a point curve. This displays the Make Point Curve dialog on page 2730, which lets you set the number of points. For a point curve, this button lets you change the number of points in the curve.

Reverse  Reverses the order of the CVs or points in a curve, so that the first vertex becomes the last, and the last becomes the first.

The first point or CV is significant when you use the NURBS curve like a spline: as a loft on page 742 path or shape, as a path constraint on page 3596 path, or as a motion trajectory on page 3411. For these purposes, the first vertex of the curve is significant. If the curve is a closed curve, you can use Make First to set the curve's first vertex.

The direction of the curve also determines the initial direction of normals on surfaces based on this curve.

Make COS  This button is enabled only for the following kinds of curves:

- U iso curves on page 2584
- V iso curves on page 2584
- Normal projected curves on page 2586
- Vector projected curves on page 2589
- Surface-surface intersection curves on page 2578
- Surface edge curves on page 2601
- CV curves on surfaces on page 2593
- Point curves on surfaces on page 2597

This displays a Make Curve on Surface dialog on page 2710, which turns the selected curve into a CV or point curve on surface. Once converted, you can edit the new curve on surface using the curve on surface controls, including the Edit Curve on Surface dialog on page 2716.

If the curve is already a curve on surface, this button lets you change it from a point to CV curve on surface, or vice versa.

The new Curve on Surface preserves the trimming of the original curve.

Convert Curve  Click to display the Convert Curve dialog on page 2708. This dialog provides a more general way to convert a CV curve to a point curve, or a point curve to a CV curve. It also lets you adjust a number of other curve parameters.
**Make Independent** Disabled if the curve is independent. If the curve is dependent, clicking this button makes it independent.

**WARNING** When you make a curve independent, you lose the animation controllers for all objects that depend on it in turn. If you make a curve that trims a surface independent, you lose the trimming of the surface.

**Remove Animation** Removes animation controllers from the selected curves.

**Detach** Detaches the selected curve sub-object from the NURBS model, making it a new top-level NURBS curve on page 2464 object. The Detach dialog on page 2715 is displayed, which lets you name the new curve. The new object is no longer part of the original NURBS model.
To create a new top-level NURBS curve that is a copy of the selected curve, turn on Copy before you click Detach.

**Copy** When on, clicking Detach creates a copy of the selected curve instead of detaching it from the NURBS model. Default=off.

**Make First** For a closed curve, lets you choose a position that becomes the first vertex of the curve.
The first point or CV is significant when you use the NURBS curve like a spline: as a loft on page 742 path or shape, as a path constraint on page 3596 path, or as a motion trajectory on page 3411. For these purposes, the first vertex of the curve is significant. If the curve is a closed curve, you can use Make First to set the curve’s first vertex.

**Break** Breaks a single curve into two curves. Click in a viewport to choose the location to break the curve.

**WARNING** When you break a curve sub-object, you lose the animation controllers for all points or CVs on the curve.

**Join** Joins two curve sub-objects together. After you have joined the curves in a viewport, the Join Curves dialog on page 2723 is displayed. This dialog lets you choose the method for joining the two curves.

**WARNING** When you join two curve sub-objects, you lose the animation controllers for all points or CVs on both curves.

**Material ID** Lets you assign a material ID value to the curve. If the curve is renderable, material IDs let you assign a material to the curve using a Multi/Sub-Object on page 6120 material. In addition, the Select by ID button lets you select a curve or multiple curves by specifying a material ID number. Can range from 1 to 100. Default=1.
Select by ID Displays a Select by Material ID on page 2736 dialog.

**CV Curve rollout**

This additional rollout is displayed when a CV curve is selected.

![CV Curve rollout](image)

**Degree** Sets the degree of the curve. The higher the degree value, the greater the continuity. The lower the degree, the more discontinuous the curve segments become. The degree can't be less than one or greater than the number allowed by the number of CVs in the curve. Degree 3 curves are adequate to represent continuous curves, and are stable and well behaved. Default=3.

Setting the degree greater than 3 isn't recommended because higher-degree curves are slower to calculate and less stable numerically. Higher-degree curves are supported primarily to be compatible with models created using other surface modeling programs.

The number of CVs in a CV curve must be at least one greater than the curve's degree.

**Automatic Reparameterization group**

The controls in this group box let you specify automatic reparameterization. They are similar to the controls in the Reparameterize dialog on page 2733, with the addition that all choices except for None tell 3ds Max to reparameterize the curve automatically; that is, whenever you edit it by moving CVs, refining, and so on.

**None** Do not reparameterize automatically.
Chord Length  Chooses the chord-length algorithm for reparameterization. Chord-length reparameterization spaces knots (in parameter space on page 8674) based on the square root of the length of each curve segment. Chord-length reparameterization is usually the best choice.

Uniform  Spacing the knots uniformly. A uniform knot vector has the advantage that the curve or surface changes only locally when you edit it. With chord-length parameterization, moving any CV can potentially change the entire curve.

Close  Closes the curve. Disabled if the curve is already closed.

Rebuild  Displays the Rebuild CV Curve dialog on page 2731, which lets you specify how to rebuild the curve. Rebuilding the curve can change its appearance.

Reparam.  Displays the Reparameterize dialog on page 2733. Reparameterizing a curve changes the curve’s parameter space on page 8674 to provide a better relation between control point locations and the shape of the curve.

TIP  It is a good idea to reparameterize after you have added CVs to the curve by refining or inserting.

**Point Curve rollout**

This additional rollout appears when a point curve is selected.

![Point Curve](image)

Close  Closes the curve. Disabled if the curve is already closed.

**Editing Surface Sub-Objects**

Modify panel > Stack display > Open the NURBS object’s hierarchy. > Surface sub-object level > Select surface sub-objects.

This topic describes controls that are common to point surfaces, CV surfaces, and the various dependent surface types. A rollout labeled Surface Common contains the surface sub-object controls for NURBS surfaces. Another rollout,
Material Properties on page 2544, controls mapping on surface sub-objects, and is described in its own topic. See Surface Approximation on page 2737 for a description of that rollout. The final rollout for surface sub-objects depends on the type of surface selected.

Procedures

To transform surface sub-objects:

1. At the Surface sub-object level, select one or more surface sub-objects. The sub-object selection tools are the same as for other kinds of sub-objects. In addition, you can use the H key when the Keyboard Shortcut Override toggle on page 8420 is on. See Sub-Object Selection on page 2428.

   The Selection group box, described under "Interface" later in this topic, provides additional options for selecting surfaces.

2. Turn on Move or another transform and then drag in a viewport to transform the selection.

   The shape of the model changes as you interactively transform the surfaces.

   TIP The Lock Selection Set button is useful when you transform NURBS sub-objects. You can make a selection in one viewport, click Lock Selection Set (or press the Spacebar), and then transform the selection in a different viewport.

To use the keyboard to select surface sub-objects:

You can select surface sub-objects using the Ctrl key and the arrow keys. The arrows traverse the sub-objects in the order they were created. To do so, follow these steps:

1. Turn on the Keyboard Shortcut Override Toggle.

2. At the Surface sub-object level, set the selection controls to select surfaces individually.
3 Click or drag to select surfaces.

4 Hold down Ctrl and use the arrow keys to move among surfaces in the current model.

At the Surface sub-object level, the left and right arrow keys move forward and backward through individual surfaces in the order they were created. The up and down arrows are equivalent to left and right.

You can also use the H keyboard shortcut (while the Keyboard Shortcut Override Toggle is on) to display a dialog and select surfaces by name. Ctrl+H displays only the names of surfaces directly beneath the mouse cursor.

To delete a surface:

- Select the surface and then click Delete.
  Keyboard shortcut: Delete

To make a surface a loft:

1 Select the surface and then click Make Loft. A Make Loft dialog on page 2727 is displayed.
2 Use the Make Loft dialog controls to choose the settings for the new surface, and then click OK.

To break a surface:

1 Turn on Break Row, Break Col., or Break Both, and then drag over the surface.
   One or two blue curves appear on the surface to indicate where the break will occur.

2 When you have dragged to the location you want to break, click the surface.

   **NOTE** If you break a dependent surface, the new "broken" surfaces are made independent.

You cannot break a trimmed surface.
To extend a surface:

1. Turn on Extend.
2. Move the mouse over the surface without depressing the mouse button. The edge that will be extended is highlighted in blue.
3. When the edge you want to extend is highlighted, press the mouse button, and then drag vertically to increase the length of the surface.

The surface extension is invalid and disappears if it would cause the surface to intersect itself or if the edge of the surface touches itself but is not closed. For example, you can’t extend the top of a cylinder.

To join two surfaces:

1. In a NURBS object that contains two surface sub-objects, turn on Join.
2. If the gap between the surfaces is small (less than about 30 units), set the Tolerance value greater than the distance of the gap.
3. Click one surface near the edge that you want to connect. The edge that will be connected is highlighted in blue. Drag to choose the edge you want to connect. Without releasing the mouse button, drag to the other surface. The edge of the other surface is also highlighted in blue. Drag on the other surface to choose the edge to connect, and then release the mouse button.

The surface that owns the highlighted edge is highlighted in yellow, to help you distinguish which edge you are choosing when two surfaces have coincident edges.

The Join Surfaces dialog on page 2725 is displayed, which gives you a choice of methods for how to join the surfaces. Whichever method you choose, 3ds Max creates a single surface that replaces the two original surfaces.

To close a surface:

- Select the surface sub-object and then click Close Rows or Close Cols.
Interface

Surface Common rollout

<table>
<thead>
<tr>
<th>Selection</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name:</td>
</tr>
<tr>
<td>Hide</td>
</tr>
<tr>
<td>Hide By Name</td>
</tr>
<tr>
<td>Unhide By Name</td>
</tr>
<tr>
<td>Delete</td>
</tr>
<tr>
<td>Make Loft</td>
</tr>
<tr>
<td>Convert Surface</td>
</tr>
<tr>
<td>Make Independent</td>
</tr>
<tr>
<td>Remove Animation</td>
</tr>
<tr>
<td>Detach</td>
</tr>
<tr>
<td>✔ Renderable</td>
</tr>
<tr>
<td>☐ Display Normals</td>
</tr>
<tr>
<td>☐ Flip Normals</td>
</tr>
<tr>
<td>Break Row</td>
</tr>
<tr>
<td>Break Both</td>
</tr>
<tr>
<td>Join</td>
</tr>
<tr>
<td>Surfaces Selected:</td>
</tr>
</tbody>
</table>

Surface sub-object rollout

The controls on this rollout apply to all surface types. Depending on the type of surface, an additional rollout is displayed with controls specific to that type of surface.

Selection group

The selection buttons for surface sub-objects let you select either individual surfaces, or surfaces that are connected in space.
Surface sub-object selection controls

Single Surface Clicking or transforming a surface selects only a single surface sub-object.

All Connected Surfaces Clicking or transforming a surface selects all surface sub-objects that are connected within the NURBS object. To be connected, two surfaces must have all the CVs on a shared edge fused between them, or one surface must be a connected dependent of the other (for example, a blend or a cap).

Name Shows the name of the currently selected surface. It is disabled if you have selected multiple surfaces.

By default, the name is the name of the surface type ("CV Surface," "Point Surface," "Blend Surface," and so on) followed by a sequence number. You can use this field to give the surface a name that you choose.

Hide Click to hide the currently selected surface.

Unhide All Click to unhide all hidden surfaces.

Hide by Name Click to display a Select Sub-Objects dialog that lists surfaces by name. Select the surfaces to hide, then click Hide.

Unhide by Name Disabled unless there are hidden surfaces. Click to display a Select Sub-Objects dialog that lists surfaces by name. Select the surfaces to make visible, then click Unhide.

Delete Deletes the selected surface sub-objects.

Make Rigid Makes the surface rigid. The only editing allowed on a rigid surface is to transform it at the Surface sub-object level. You can't move a rigid surface's points or CVs, or change the number of points or CVs.

Rigid surfaces reduce the amount of memory used by the NURBS model. Making surfaces rigid improves performance, especially for large and complex models.

When a surface is rigid, you can't see its points or CVs when you are at the Point or Surface CV sub-object levels. If the model has no nonrigid surfaces...
and no point curves, the Point and Surface CV sub-object levels aren't available at all.

To make a surface no longer rigid, click Make Point or Make Independent. Editing the surface with Break, Join, and so on also makes it no longer rigid.

**Make Loft** Displays a Make Loft dialog on page 2727 to convert the surface sub-object to a (dependent) U loft or UV loft surface. Can also change the dimension used to construct a U loft surface.

You can't use Make Loft if the surface sub-object is in an error condition.

**TIP** Make Loft creates a loft with uniformly spaced curves. To make a loft with adaptively spaced iso curves, manually create the curves and then loft them with U Iso Lines, V Iso Lines, or U and V Iso Lines.

**Make Point** Displays a Make Point dialog on page 2729 to convert any kind of surface to a point surface. You can also use Make Point to change the number of rows and columns if the surface is already a point surface.

**Convert Surface** Click to display the Convert Surface dialog on page 2711. This dialog provides a general way to convert a surface to a different type of surface. You can convert between lofts, point ("fit") surfaces, and CV surfaces. The dialog also lets you adjust a number of other surface parameters.

**Make Independent** Disabled if the surface is independent. If the surface is dependent, clicking this button makes it independent.

**WARNING** When you make a surface independent, you lose the animation controllers for all objects that depend on it in turn.

**Remove Animation** Removes animation controllers from the selected surfaces.

**Detach** Detaches the selected surface sub-object from the NURBS model, making it a new top-level NURBS surface object on page 2454. The Detach dialog on page 2715 is displayed, which lets you name the new surface. The new object is no longer part of the original NURBS model.

To create a new top-level NURBS surface that is a copy of the selected surface, turn on Copy before you click Detach.

**Copy** When on, clicking Detach creates a copy of the selected surface instead of detaching it from the NURBS model. Default=off.

**Renderable** When on, the surface renders. Turn off to make the surface invisible in renderings. Default=on.

**Display Normals** When on, the normal for each selected surface is displayed. There is one normal per surface sub-object. The normal is displayed at the
surface's UV origin, so displaying normals can help you see how materials will be mapped. On the other hand, the normal can be hard to see if you are zoomed out. Default=off.

**Flip Normals** Turn on to reverse the direction of the surface normals. Default=off.

---

**TIP** The Flip Normals control is useful for viewing a surface that is mostly concave or mostly convex. With more complicated NURBS surfaces, you often want to render both sides of the surface. To see both sides of the surface, turn on Force 2-Sided on the Render Setup dialog on page 6506. To see both sides of the surfaces in viewports, turn on Force 2-Sided on the Rendering Method panel of the Viewport Configuration dialog on page 8374, or assign a Double-Sided Material on page 6113.

**Break Row** Breaks the surface into two surfaces in the direction of a row (the surface's U axis).

**Break Col.** Breaks the surface into two surfaces in the direction of a column (the surface's V axis).

**Break Both** Breaks the surface into four surfaces in both directions. You cannot break a trimmed surface.

**Extend** Extends the surface by changing its length.

---

**WARNING** Extending a surface loses all animation controllers for the surface and its points or CVs.

**Join** Joins two surface sub-objects together. After you have joined the surfaces in a viewport, the Join Surfaces dialog on page 2725 is displayed. This dialog lets you choose the method for joining the two surfaces. You can join only original edges of surfaces; you cannot join edges created by trimming.

---

**WARNING** When you join two surface sub-objects, you lose the animation controllers for all point or CVs on both surfaces.

**CV Surface rollout**

This additional rollout is displayed when a CV surface is selected.
U Degree and V Degree  Let you set the degree of the surface in either the U or V dimension. The higher the degree value, the greater the continuity. The lower the degree, the more discontinuous the surface segments become. The degree can't be less than one or greater than the number allowed by the number of CVs in the specified dimension. Degree 3 is adequate to represent continuous surfaces, and is stable and well behaved. Default=3.

Setting the degree greater than 3 isn't recommended because higher-degrees are slower to calculate and less stable numerically. Higher-degrees are supported primarily to be compatible with models created using other surface modeling programs.

The number of CVs in a given dimension must be at least one greater than that dimension's degree.

Automatic Reparameterization group

The controls in this group box let you specify automatic reparameterization. They are similar to the controls in the Reparameterize dialog on page 2733, with the addition that all choices except for None tell 3ds Max to reparameterize the curve automatically; that is, whenever you edit it by moving CVs, refining, and so on.

None  Do not reparameterize automatically.

Chord Length  Chooses the chord-length algorithm for reparameterization. Chord-length reparameterization spaces knots (in parameter space on page 8674) based on the square root of the length of each curve segment. Chord-length reparameterization is usually the best choice.

Uniform  Spaces the knots uniformly.
A uniform knot vector has the advantage that the curve or surface changes only locally when you edit it. With chord-length parameterization, moving any CV can potentially change the entire surface.

The close controls let you close a surface. They are displayed on the CV Surface rollout while an independent CV surface sub-object is selected. They are disabled if the surface is already closed in that direction.

**Close Rows** Closes the surface by joining the ends of its rows.

**Close Cols.** Closes the surface by joining the ends of its columns.

**Rebuild** Displays the Rebuild CV Surface dialog on page 2732, which lets you specify how to rebuild the surface. Rebuilding the surface can change its appearance.

**WARNING** When you rebuild a surface, you lose the animation controllers for all CVs on the surface.

**Reparam.** Displays the Reparameterize dialog on page 2733. Reparameterizing a surface changes the surface's parameter space on page 8674 to provide a better relation between control point locations and the shape of the surface.

**TIP** It is a good idea to reparameterize after you have added CVs to the surface by refining or inserting.

**WARNING** When you reparameterize a surface, you lose the animation controllers for all CVs on the surface.

**Point Surface rollout**

This additional rollout appears when a point surface is selected.

The close controls let you close a surface. They appear on the Point Surface rollout while an independent point surface sub-object is selected. They have no effect if the surface is already closed in that direction.

**Close Rows** Closes the surface by joining the ends of its rows.

**Close Cols.** Closes the surface by joining the ends of its columns.
Soft Selection Rollout (NURBS)

Modify panel > Select NURBS point or CV sub-objects. > Soft Selection rollout

The soft selection controls for NURBS models are like the soft selection controls for editable mesh on page 2192 objects. Soft selection controls make a point or CV behave as if surrounded by a "magnetic field." Unselected points or CVs within the field are drawn along smoothly while you move the selected one.

With this feature, you can sculpt the points or CVs of a curve or surface. For example, you can draw a sphere into an egg, or gently curve a flat surface into hills and valleys.

The Soft Selection rollout for point and CV sub-objects contains the controls for this feature. The Soft Selection check box is turned off by default.

Before you begin, you might need to increase the number of CVs or points on the surface. This allows smoother and more complex reshaping effects.

A single point or CV works well for many purposes. Moving a point or CV along a single axis is the most useful for smoothly raising and lowering surfaces. For multiple points or CVs, you can also use Rotate or Scale.
**Interface**

**Soft Selection** When on, point or CV transforms affect a region of the curve or surface.

**Affect Neighbors** When on, the transform affects points or CVs not only on this curve or surface but within the entire Falloff region of the NURBS object.

**Same Type Only** (for point curves and surfaces only) When on, the transform affects only neighboring points of the same type; that is, either curve points, surface points, or independent points.

**Soft Selection Curve** This curve display shows how Soft Selection will work. You can experiment with a curve setting, undo it, and try another setting with the same selection.

**Falloff** Distance in current units from the center to the edge of a sphere defining the region. Use higher falloff settings to achieve more gradual slopes, depending on the scale of your geometry. Default=20.
Falloff=20 (the default)  
Right: Falloff=40

Pinch Raises and lowers the top point of the curve along the vertical axis. Sets the relative "pointedness" of the region. When negative, a crater is produced instead of a point. At a setting of 0, Pinch produces a smooth transition across this axis. Default=0.

Left: Pinch=.5  
Right: Pinch=2  
Falloff and Bubble have their default values.

Bubble Expands and contracts the curve along the vertical axis. Sets the relative "fullness" of the region. Limited by Pinch, which sets a fixed starting point for Bubble. A setting of 0 for Pinch and 1.0 for Bubble produces a maximum smooth bulge. Negative values for Bubble move the bottom of the curve below the surface, creating a "valley" around the base of the region. Default=0.
Material Properties Rollout (NURBS)

Modify panel > Select NURBS object. > Stack display > Surface sub-object level > Material Properties rollout

This rollout controls material mapping onto a NURBS surface sub-object.

Procedures

To apply a mapped material to a surface sub-object:
2. Use the Material Editor on page 5641 to assign a mapped material to the surface.

To use multiple map channels on a single surface sub-object (example):
2. Change the Map Channel value to 2, and turn on Gen. Mapping Coordinates.
3. Change the U and V tiling values for map channel 2.
Now when you assign a mapped material, maps on map channel 1 use the default UV tiling, while maps on map channel 2 use the channel 2 tiling. An easy way to see this is to create a checker on page 6227 map on channel 1, and make one checker color another checker map on channel 2.
Interface

Material Properties rollout

- Material ID: [1]
- Select By ID

Texture Channels
- Map Channel: [1]
- Gen. Mapping Coords.
  - Offset: U: 0.0, V: 0.0
  - Tiling: U: 1.0, V: 1.0
- Rotation Angle: 0.0

Texture Corners
- U: 0.0, V: 0.0

Texture Surface
- Default
- User Defined
  - Edit Texture Surface
  - Edit Texture Points
- Projected
  - Pick Source Surface
- Source: None
**Material ID** Use this to change the surface's material ID number. Multiple material IDs in a single NURBS object let you assign a multi/sub-object material on page 6120 to the NURBS object.

**Select by ID** Displays a Select by Material ID dialog on page 2736.

**Texture Channels group**

The controls in this group box support materials, including tiling and positioning mapping coordinates on the surface.

**Map Channel** Chooses a UV coordinates map channel on page 8627. Range=1 to 99. A single surface can use up to 99 texture channels. Default=1.

**Gen. Mapping Coordinates** Generates mapping coordinates so you can apply mapped materials to the surface. Each surface in a NURBS object has its own set of mapping coordinates. Default=off.

**U and V Offset** Offset mapping coordinates along the surface's local U axis or V axis. That is, at 0.0 (the default), the map begins at the U or V origin. Increasing an Offset value moves the map forward along that axis, and decreasing it moves it backward. These parameters are animatable.

**U and V Tiling** Control the tiling of UV mapping coordinates; that is, the number of times a mapped material's map is repeated in the surface's local U axis or V axis. Default=1.0 for both axes (no tiling). These parameters are animatable.

**Rotation Angle** Lets you specify a rotation angle for the texture. This parameter is animatable.

**Texture Corners group**

The controls in this group box let you explicitly set which texture surface UV values to use at the corners of a surface. These controls are especially useful when you are matching the textures of adjacent surfaces.

These controls are disabled unless Generate Mapping Coordinates is on.

**Corners radio buttons** The four buttons correspond to the four corners of the currently selected surface. When you choose a button, the corresponding corner is highlighted with a blue box in 3D viewports, and the U and V spinners are enabled.

**U and V** Unavailable unless you've chosen one of the Corners radio buttons. When available, you use these spinners to set the U and V texture values for the chosen corner.
By default, the U and V values for most surfaces range from 0.0 to 1.0. For some kinds of geometry converted to a NURBS surface, these ranges can vary.

**Texture Surface group**

The controls in this group box let you choose a method for mapping texture to the currently selected NURBS surface sub-object, and to adjust the parameters for some of the chosen methods.

These controls are available when Generate Mapping Coordinates is on.

A texture surface is a surface associated with the surface sub-object. The texture surface controls how materials are mapped. In effect, changing the texture surface stretches or otherwise changes the UV coordinates for the surface, altering the mapping.

Maps can shift with certain surface approximation methods. This effect is especially noticeable when the surface has animated CVs. You can reduce or eliminate map shifting by changing the mapping method to User Defined.

**TIP** Don’t use the UVW Map modifier to apply a texture to an animated NURBS surface.

**Default** Automatically generates a texture surface. This method evenly distributes the texture and attempts to compensate for stretching of the surface. The default texture surface method has no additional controls.

**User Defined** Generates a texture surface that you can edit. You edit the user-defined texture surface either by using an Edit Texture Surface dialog (as you did in 3ds Max prior to v3), or by editing texture points directly in viewports.

**Edit Texture Surface** Click to display the Edit Texture Surface dialog on page 2719, which lets you control UV mapping on this surface. This button is available when you’ve chosen User Defined as the texture surface method.

**Edit Texture Points** Click to edit texture surface points directly in viewports. This button available when you’ve chosen User Defined as the texture surface method.

While Edit Texture Points is on, the points of the texture surface are displayed in viewports, where you can adjust their positions by using the selection and transform tools.

**Projected** Generates the texture surface by projecting the texture of another NURBS surface sub-object in the NURBS model. The projection travels along the direction of the normals of the source surface.
Projected texture surfaces are relational: if you update the source surface, the texture updates on all the surfaces it projects onto.
If you use the same source surface to project a texture onto several other connected surfaces, the textures will match along the boundaries where the mapped surfaces touch.

**Pick Source Surface** This button is available when you've chosen Projected as the texture surface method. To choose a source (projector) surface, choose Projected, click to turn on this button, and then click in a viewport to select another surface sub-object in the same NURBS model.

**Source text field** If Projected is the chosen texture surface method and you have picked a surface to project, this field displays the name of the projector (source) surface. Otherwise, this field says "None."

### Creating Curve Sub-Objects

Select NURBS object. > Modify panel > Create Curves rollout
Select NURBS object. > Modify panel > NURBS toolbox
Keyboard > Ctrl+T to toggle NURBS toolbox display (Keyboard Shortcut Override Toggle must be on)

Curve sub-objects are either independent point and CV curves (similar to the top-level point and CV curves described in Point Curve on page 2466 and CV Curve on page 2473), or they are dependent curves. Dependent curves are curve sub-objects whose geometry depends on other curves, points, or surfaces in the NURBS object. When you change the geometry of the original, parent sub-objects, the dependent curve changes as well.

You create curve sub-objects using the Create Curves rollout on the Modify command panel for a NURBS curve.
Tip: Lathe and extrude surface sub-objects can be based on only a single curve; see Creating Dependent Surfaces on page 2603. If you create dependent curves and then want to use the set of curves (for example, two parents and a fillet between them) as the basis of an extrude or loft surface, first go to the Curve sub-object level and use Join to connect the curves.

Creation operations for dependent sub-objects require you to select one or more parent objects. In general, you can click and drag, or click and then click again. You can also use the H keyboard shortcut to display the Select Sub-Objects dialog. This is a subset of the Selection Floater on page 209 for choosing the parent. (The Keyboard Shortcut Override Toggle on page 8420 must be on for H to work this way.)

Toolbox Buttons for Creating Curves

These are the toolbox on page 2426 buttons for creating curve sub-objects:

Create an independent CV curve sub-object on page 2552.
Create an independent point curve sub-object on page 2556.

Create a dependent fit curve (as with the Curve Fit on page 2558 button).

Create a dependent transform curve on page 2560.

Create a dependent blend curve on page 2562.

Create a dependent offset curve on page 2564.

Create a dependent mirror curve on page 2566.

Create a dependent chamfer curve on page 2569.

Create a dependent fillet curve on page 2574.

Create a dependent surface-surface intersection curve on page 2578.

Create a dependent U iso curve on page 2584.

Create a dependent V iso curve on page 2584.

Create a dependent normal projected curve on page 2586.

Create a dependent vector projected curve on page 2589.

Create a dependent CV curve on surface on page 2593.

Create a dependent point curve on surface on page 2597.

Create a dependent surface offset curve on page 2582.
Create a dependent surface edge curve on page 2601.

**CV Curve Sub-Object**

Select NURBS object. > Modify panel > Create Curves rollout > CV Curve button

Select NURBS object. > Modify panel > NURBS toolbox > Create CV Curve button

CV curve sub-objects are similar to object-level CV curves on page 2473. The main difference is that you can't give CV curves a renderable thickness at the sub-object level.

**Drawing Three-Dimensional Curves**

When you create a CV curve, you can draw it in three dimensions. There are two ways to do this:

- **Draw In All Viewports:** This toggle lets you use any viewport to draw the curve, enabling you to draw three dimensionally.
- **Using Ctrl to drag CVs:** While you draw a curve, you can use the Ctrl key to drag a CV off of the construction plane.

With the Ctrl-key method, further mouse movement lifts the latest point off the construction plane. There are two ways to use this:

- **Click-drag:** If you hold down Ctrl and also hold down the mouse button, you can drag to change the height of the CV. The CV’s location is set when you release the mouse button. This method is probably more intuitive.
- **Click-click:** If you Ctrl+click and then release the mouse button, the height changes as you drag the mouse. Clicking the mouse a second time sets the CV's location. This method is less prone to repetitive stress injury.

While you are offsetting the CV, a red dotted line is drawn between the original CV on the construction plane and the actual CV offset from the plane. You can move the mouse into an inactive viewport, in which case 3ds Max sets
the height of the CV using the CV's Z axis in the inactive viewport. This lets you set the height of the CV with accuracy.

**Snaps** on page 2819 also work when you change the height of a CV. For example, if you turn on CV snapping, you can set a CV to have the same height as another CV by snapping to that other CV in an inactive viewport.

**Procedures**

**To create a CV curve sub-object:**

1. Turn on CV Curve.
2. In a viewport, click and drag to create the first CV, as well as the first curve segment. Release the mouse button to add the second CV. Each subsequent location you click adds a new CV to the curve. Right-click to end curve creation.

**NOTE** If you begin the curve by clicking without dragging, this also creates the curve's first CV. However, if you release the mouse button more than five pixels away from where you initially pressed it, this creates an additional CV.

While you are creating a CV curve, you can press Backspace to remove the last CV you created, and then previous CVs in reverse order.

If Draw In All Viewports is on, you can draw in any viewport, creating a 3D curve.

To lift a CV off the construction plane, use the Ctrl key as described earlier in this topic under "Drawing Three-Dimensional Curves."

As with splines, if you click over the curve's initial CV, a Close Curve dialog on page 2714 is displayed. This dialog asks whether you want the curve to be closed. Click No to keep the curve open or Yes to close the curve. (You can also close a curve when you edit it at the Curve sub-object level.) When a closed curve is displayed at the Curve sub-object level, the initial CV is displayed as a green circle, and a green tick mark indicates the curve's direction.
Interface

CV Curve rollout (creation time)

Draw In All Viewports Lets you use any viewport while you are drawing the curve. This is one way to create a 3D curve. When off, you must finish drawing the curve in the viewport where you began it. Default=on. While Draw In All Viewports is on, you can also use snaps on page 2819 in any viewport.

Automatic Reparameterization group

The controls in this group box let you specify automatic reparameterization. They are similar to the controls in the Reparameterize dialog on page 2733, with one addition: all choices except for None tell 3ds Max to reparameterize the curve automatically; that is, whenever you edit it by moving CVs, refining, and so on.

None Do not reparameterize automatically.

Chord Length Chooses the chord-length algorithm for reparameterization. Chord-length reparameterization spaces knots (in parameter space on page 8674) based on the square root of the length of each curve segment. Chord-length reparameterization is usually the best choice.

Uniform Spaces the knots uniformly.
A uniform knot vector has the advantage that the curve or surface changes only locally when you edit it. With the other two forms of parameterization, moving any CV can change the entire sub-object.
CV Curve rollout (modification time)

**Degree** Sets the degree of the curve. The higher the degree value, the greater the continuity. The lower the degree, the more discontinuous the curve segments become. The degree can't be less than one or greater than the number allowed by the number of CVs in the curve. Degree 3 curves are adequate to represent continuous curves, and are stable and well behaved. Default=3.

Setting the degree greater than 3 isn’t recommended, because higher-degree curves are slower to calculate and less stable numerically. Higher-degree curves are supported primarily to be compatible with models created using other surface modeling programs.

The number of CVs in a CV curve must be at least one greater than the curve's degree.

**Automatic Reparameterization group**

The controls in this group box let you specify automatic reparameterization. They are similar to the controls in the Reparameterize dialog on page 2733, with one addition: all choices except for None tell 3ds Max to reparameterize the curve automatically; that is, whenever you edit it by moving CVs, refining, and so on.

**None** Do not reparameterize automatically.

**Chord Length** Chooses the chord-length algorithm for reparameterization. Chord-length reparameterization spaces knots (in parameter space on page 8674) based on the square root of the length of each curve segment.
Chord-length reparameterization is usually the best choice.

**Uniform** Spaces the knots uniformly. A uniform knot vector has the advantage that the curve or surface changes only locally when you edit it. With the other two forms of parameterization, moving any CV can change the entire sub-object.

**Close** Closes the curve. Disabled if the curve is already closed.

**Rebuild** Displays the Rebuild CV Curve dialog on page 2731 to let you rebuild the CV curve.

**Reparam** Displays the Reparameterize dialog on page 2733 to let you reparameterize the CV.

### Point Curve Sub-Object

Select NURBS object. > Modify panel > Create Curves rollout > Point Curve button

Select NURBS object. > Modify panel > NURBS toolbox > Create Point Curve button

Point curve sub-objects are similar to object-level point curves on page 2466. Points are constrained to lie on the curve. The main difference is that you can’t give point curves a renderable thickness at the sub-object level.

### Drawing Three-Dimensional Curves

When you create a point curve, you can draw it in three dimensions. There are two ways to do this:

- **Draw In All Viewports:** This toggle lets you use any viewport to draw the curve, enabling you to draw three dimensionally.

- **Using Ctrl to drag points:** While you draw a curve, you can use the Ctrl key to drag a point off of the construction plane.

With the Ctrl key method, further mouse movement lifts the latest point off the construction plane. There are two ways to use this:

- **Click-drag:** If you hold down Ctrl and also hold down the mouse button, you can drag to change the height of the point. The point’s location is set when you release the mouse button.
This method is probably more intuitive.

- Click-click. If you Ctrl+click and then release the mouse button, the height changes as you drag the mouse. Clicking the mouse a second time sets the point’s location.
  This method is less prone to repetitive stress injury.

While you are offsetting the point, a red dotted line is drawn between the original point on the construction plane and the actual point offset from the plane. You can move the mouse into an inactive viewport, in which case 3ds Max sets the height of the point using the point’s Z axis in the inactive viewport. This lets you set the height of the point with accuracy.

**Snaps** on page 2819 also work when you change the height of a point. For example, if you turn on Point snapping, you can set a point to have the same height as another point by snapping to that other point in an inactive viewport.

**Procedures**

**To create a point curve sub-object:**

1. Turn on Point Curve.

2. In a viewport, click and drag to create the first point, as well as the first curve segment. Release the mouse button to add the second point. Each subsequent location you click adds a new point to the curve. Right-click to end curve creation.

**NOTE** If you begin the curve by clicking without dragging, this also creates the curve’s first point. However, if you release the mouse button more than five pixels away from where you initially pressed it, this creates an additional point.

While you are creating a point curve, you can press Backspace to remove the last point you created, and then previous points in reverse order.

If Draw In All Viewports is on, you can draw in any viewport, creating a 3D curve.

To lift a point off the construction plane, use the Ctrl key as described earlier in this topic under **Drawing Three-Dimensional Curves** on page 2556.
As with splines, if you click over the curve's initial point, a Close Curve dialog on page 2730 is displayed. This dialog asks whether you want the curve to be closed. Click No to keep the curve open or Yes to close the curve. (You can also close a curve when you edit it at the Curve sub-object level.) When a closed curve is displayed at the Curve sub-object level, the initial point is displayed as a green circle, and a green tick mark indicates the curve's direction.

**Interface**

**Point Curve rollout (creation time)**

![Point Curve rollout (creation time)](image)

**Draw In All Viewports** Lets you use any viewport while you are drawing the curve. This is one way to create a 3D curve. When off, you must finish drawing the curve in the viewport where you began it. Default=on.

While Draw In All Viewports is on, you can also use snaps on page 2819 in any viewport.

**Point Curve rollout (modification time)**

![Point Curve rollout (modification time)](image)

**Close** Closes the curve. Disabled if the curve is already closed.

**Curve Fit**

Select NURBS object. > Modify panel > Create Curves rollout > Dependent Curves group box > Curve Fit button

---

**Chapter 10   Surface Modeling**
Select NURBS object. > Modify panel > NURBS toolbox > Create Fit Curve button

This command creates a point curve fitted to points you select. The points can be part of previously created point curve and point surface objects, or they can be point sub-objects you created explicitly. They can't be CVs.

Fitting a curve to selected points

Procedures

To create a point curve with Curve Fit:

1. Turn on Curve Fit.
2. Click to select two or more points.
   A point curve is created. It runs through the points you select, in the order you select them.
   You can use Backspace to undo point selection in reverse order.
3. Right-click to end creation.
Interface

There are no parameters for a point curve created with Curve Fit.

Transform Curve

Select NURBS object. > Modify panel > Create Curves rollout > Dependent Curves group box > Transform button

Select NURBS object. > Modify panel > NURBS toolbox > Create Transform Curve button

A transform curve is a copy of the original curve with a different position, rotation, or scale.

Curve used to create a transform curve
Procedures

To create a transform curve:

- In a NURBS object that contains at least one curve, turn on Transform.
  To move the transform curve, click and drag the curve you want to duplicate. To rotate or scale the transform curve, click the parent curve, go to the Curve sub-object level in the modifier stack, and then rotate or scale the transform curve.

  When you use Move to create the transform curve, it simply copies the parent. (It doesn't exaggerate curvature as an offset curve does.)

  Axis constraints don't apply to the creation of transform curves. You can click to create the curve in place; then once it is created, transform it using constraints.

  **TIP** You can also use axis constraints by using Shift+Clone at the Curve sub-object level.

Interface

Creation time

At creation time, transform curves have no parameters.

Transform Curve rollout (modification time)

At modification time, you can transform the transform curve as a curve sub-object, and you can animate curve sub-object transforms. Transform curves also have one control in the Modify panel.

Replace Base Curve Lets you replace the parent curve. Click the button, then click the curve to replace the original curve.
Blend Curve

Select NURBS object. > Modify panel > Create Curves rollout > Dependent Curves group box > Blend button

Select NURBS object. > Modify panel > NURBS toolbox > Create Blend Curve button

A blend curve connects the end of one curve to the end of another, blending the curvature of the parents to create a smooth curve between them. You can blend curves of the same type, a point curve with a CV curve (and vice versa), an independent curve with a dependent curve, and so on.

Blend curves connecting original curves

Procedures

To create a blend curve:

1. In a NURBS object that contains two curves, turn on Blend.
2 Click one curve near the end that you want to connect. The end that will be connected is highlighted. Without releasing the mouse button, drag to the end of the other curve that you want to connect. The other end is highlighted as well. When the end that you want to connect is highlighted, release the mouse button.

After the blend curve is created, changing the position or the curvature of either parent curve changes the blend curve as well.

3 Adjust the blend parameters.

Interface

Blend Curve rollout (creation time)

"Tension" affects the tangent between a parent curve and the blend curve. The greater the tension value, the more closely the tangent parallels the parent curve, and the smoother the transition. The lower the tension, the greater the tangent angle and the sharper the transition between parent and blend.

Tension 1 Controls tension at the edge of the first curve you clicked.

Tension 2 Controls tension at the edge of the second curve you clicked.
Blend Curve rollout (modification time)

"Tension" affects the tangent between a parent curve and the blend curve. The greater the tension value, the more closely the tangent parallels the parent curve, and the smoother the transition. The lower the tension, the greater the tangent angle and the sharper the transition between parent and blend.

**Tension 1** Controls tension at the edge of the first curve you clicked.

**Tension 2** Controls tension at the edge of the second curve you clicked.

**Replace First Curve and Replace Second Curve** Let you replace the parent curves. Click the button, then click the curve to replace the original first or second curve.

**Offset Curve**

Select NURBS object. > Modify panel > Create Curves rollout > Dependent Curves group box > Offset button

Select NURBS object. > Modify panel > NURBS toolbox > Create Offset Curve button

An Offset curve is offset from the original, parent curve. It is normal to the original. You can offset both planar and 3D curves.
Curve used to create an offset curve

Procedures

To create an offset curve:

1. In a NURBS object that contains at least one curve, turn on Offset.
2. Click the curve you want to offset, and drag to set the initial distance. An offset curve is created.
3. Adjust the Offset parameter.
   If the parent curve is not linear, increasing the distance increasingly exaggerates the curvature of the offset curve.
**Interface**

**Offset Curve rollout (creation time)**

![Offset Curve rollout](image)

**Offset** The distance between the parent curve and the offset curve, in 3ds Max units.

This parameter is animatable.

**Offset Curve rollout (modification time)**

![Offset Curve rollout](image)

**Offset** The distance between the parent curve and the offset curve, in 3ds Max units.

**Replace Base Curve** Lets you replace the parent curve. Click the button, then click the curve to replace the original curve.

**Mirror Curve**

Select NURBS object. > Modify panel > Create Curves rollout > Dependent Curves group box > Mirror button

Select NURBS object. > Modify panel > NURBS toolbox > Create Mirror Curve button

A mirror curve is a mirror image of the original curve.
Curve used to create a mirror curve

Procedures

To create a mirror curve:

1. In a NURBS object that contains at least one curve, turn on Mirror.
2. On the Mirror Curve rollout, choose the axis or plane you want to use.
3. Click the curve you want to mirror, and drag to set the initial distance. A mirror curve is created. A gizmo (yellow by default) indicates the direction of mirroring. Transforming the mirror curve’s gizmo changes the orientation of the mirror, letting you mirror along an axis that isn’t aligned with a local coordinate axis.
4. Adjust the mirror parameters.

Interface

In viewports a gizmo (yellow by default) indicates the mirror axis.
Mirror Curve rollout (creation time)

Mirror Axis group

The Mirror Axis buttons control the direction in which the original curve is mirrored.

You can't transform the mirror curve directly (that would simply transform the mirror curve and its parent curve at the same time). You transform it by transforming its gizmo. By using transforms you can mirror about an arbitrary axis, rather than using one of the Mirror Axis presets. When you transform a mirror curve, you are actually transforming the mirror plane, so Rotate has the effect of rotating the plane about which the curve is mirrored. (This is like rotating the mirror gizmo in the Mirror modifier.)

Offset Controls the mirror's distance from the original curve. This parameter is animatable.
**Mirror Curve rollout (modification time)**

![Mirror Curve rollout](image)

**Mirror Axis group**

The Mirror Axis buttons control the direction in which the original curve is mirrored.

You can't transform the mirror curve directly (that would simply transform the mirror curve and its parent curve at the same time). You transform it by transforming its gizmo. By using transforms you can mirror about an arbitrary axis, rather than using one of the Mirror Axis presets. When you transform a mirror curve, you are actually transforming the mirror plane, so Rotate has the effect of rotating the plane about which the curve is mirrored. (This is like rotating the mirror gizmo in the Mirror modifier.)

**Offset** Controls the mirror's distance from the original curve. This parameter is animatable.

**Replace Base Curve** Lets you replace the parent curve. Click the button, then click the curve to replace the original curve.

**Chamfer Curve**

Select NURBS object. > Modify panel > Create Curves rollout > Dependent Curves group box > Chamfer button
Select NURBS object. > Modify panel > NURBS toolbox > Create Chamfer Curve button

Chamfer creates a curve that is a straight bevel between two parent curves.

Creating chamfers between two original curves

Procedures

To create a chamfer curve:

1. In a NURBS object that contains at least two curves, turn on Chamfer.

   **TIP** Make sure the curves intersect before you begin to create the chamfer.

2. Click one curve near the end that you want to connect. The end that will be connected is highlighted. Without releasing the mouse button, drag to the end of the other curve that you want to connect. When the end that will be connected is highlighted, release the mouse button.
A chamfer curve is created. Changing the position or the curvature of either parent curve can change the chamfer as well.

The parent curves must be coplanar. The chamfer is not necessarily connected at the endpoints of the parent curves: you can adjust its position with the chamfer’s Length parameters.

3 Adjust the chamfer parameters.

Interface

Chamfer Curve rollout (creation time)

![Chamfer Curve rollout](image)

The lengths are the distances from the intersection (or apparent intersection) at which the chamfer segment is drawn.

**Length 1** The distance along the first curve you click.

This parameter is animatable.

**Length 2** The distance along the second curve you click.
This parameter is animatable.
Some length values make it impossible to construct the chamfer. If you set
the length to an invalid value, the chamfer returns to a default position and
is displayed in the error color (orange by default).

**Trim First Curve and Trim Second Curve groups**

These two group boxes let you control how the parent curves are trimmed.
The controls are the same in each. "First" and "second" refer to the order in
which you picked the parent curves.

Flipping the direction of a trim

**Trim Curve** When on (the default), trims the parent curve against the fillet
curve. When off, the parent isn't trimmed.

**Flip Trim** When on, trims in the opposite direction.

**Seed 1 and Seed 2** Change the U location of the seed value on the first and
second curves. If there is a choice of directions, the direction indicated by the
seed points is the one used to create the chamfer.
Chamfer Curve rollout (modification time)

The lengths are the distances from the intersection (or apparent intersection) at which the chamfer segment is drawn.

**Length 1** The distance along the first curve you click.

**Length 2** The distance along the second curve you click.

Some length values make it impossible to construct the chamfer. If you set the length to an invalid value, the chamfer returns to a default position and is displayed in the error color (orange by default).
**Trim First Curve and Trim Second Curve groups**

These two group boxes let you control how the parent curves are trimmed. The controls are the same in each. "First" and "second" refer to the order in which you picked the parent curves.

**Flipping the direction of a trim**

**Trim Curve** When on (the default), trims the parent curve against the fillet curve. When off, the parent isn’t trimmed.

**Flip Trim** When on, trims in the opposite direction.

**Seed 1 and Seed 2** Change the U location of the seed value on the first and second curves. If there is a choice of directions, the direction indicated by the seed points is the one used to create the chamfer.

**Replace First Curve and Replace Second Curve** Let you replace the parent curves. Click the button, then click the curve to replace the original first or second curve.

**Fillet Curve**

Select NURBS object. > Modify panel > Create Curves rollout > Dependent Curves group box > Fillet button

Select NURBS object. > Modify panel > NURBS toolbox > Create Fillet Curve button

Fillet creates a curve that is a rounded corner between two parent curves.
Above: Two simple fillets
Below: Flip Trim changes the direction of trimming and the shape the fillet.

Procedures

To create a fillet curve:

1. In a NURBS object that contains at least two curves, turn on Fillet.
2. Click one curve near the end that you want to connect. The end that will be connected is highlighted. Without releasing the mouse button, drag to the end of the other curve that you want to connect. When the end that you want to connect is highlighted, release the mouse button.

A fillet curve is created. It trims the ends of the parent curve to match the fillet. The fillet is not necessarily placed at the endpoints of the parent curves: placement depends on the value of the Radius parameter.

Changing the position or the curvature of either parent curve can change the fillet as well.

The parent curves must be coplanar.

3. Adjust the fillet parameters.
Interface

Fillet Curve rollout (creation time)

Radius The radius of the fillet arc in the current 3ds Max units. Default=10.0. This parameter is animatable.

TIP If the fillet you initially create is in an error state, often this is because the radius is not large enough to bridge the distance between the two curves. Increasing the Radius value gives you a correct fillet. The fillet becomes an arc displayed in the dependent object color (green by default). When the fillet is in an error state it is displayed as a straight line in the error color (orange by default).

Trim First Curve and Trim Second Curve groups

These two group boxes let you control how the parent curves are trimmed. The controls are the same in each. "First" and "second" refer to the order in which you picked the parent curves.

Trim Curve When on (the default), trims the parent curve against the fillet curve. When off, the parent isn't trimmed.
Flip Trim When on, trims in the opposite direction.

Seed 1 and Seed 2 Change the U location of the seed value on the first and second curves. If there is a choice of directions, the direction indicated by the seed points is the one used to create the fillet.

Fillet Curve rollout (modification time)

Radius
The radius of the fillet arc in the current 3ds Max units. Default=10.0.

TIP If the fillet you initially create is in an error state, often this is because the radius is not large enough to bridge the distance between the two curves. Increasing the Radius value gives you a correct fillet. The fillet becomes an arc displayed in the dependent object color (green by default). When the fillet is in an error state it is displayed as a straight line in the error color (orange by default).
**Trim First Curve and Trim Second Curve groups**

These two group boxes let you control how the parent curves are trimmed. The controls are the same in each. "First" and "second" refer to the order in which you picked the parent curves.

**Trim Curve** When on (the default), trims the parent curve against the fillet curve. When off, the parent isn't trimmed.

**Flip Trim** When on, trims in the opposite direction.

**Seed 1 and Seed 2** Change the U location of the seed value on the first and second curves. If there is a choice of directions, the direction indicated by the seed points is the one used to create the fillet.

**Replace First Curve and Replace Second Curve** Let you replace the parent curves. Click the button, then click the curve to replace the original first or second curve.

---

**Surface-Surface Intersection Curve**

Select NURBS object. > Modify panel > Create Curves rollout > Dependent Curves group box > Surf x Surf button

Select NURBS object. > Modify panel > NURBS toolbox > Create Surface-Surface Intersection Curve button

This command creates a curve that is defined by the intersection of two surfaces. You can use surface-surface intersection curves for trimming on page 2420.
If the surfaces intersect at two or more locations, the intersection closest to the seed point is the one that creates the curve.

Procedures

To create a surface-surface intersection curve:

1. Turn on Create Surface-Surface Intersection Curve in the NURBS toolbox, or Surf x Surf on the Create Curves rollout.
2. Click the first surface, then the second. If the two surfaces intersect, a curve that lies along their intersection is created.
Interface

Surf-Surf Intersection Curve rollout (creation time)

Trim Controls group

Trim 1 and Trim 2 When on, trim a surface against the intersection curve. When off, the surface isn’t trimmed. Trim 1 trims the first parent surface you clicked, and Trim 2 trims the second parent surface.

If the intersection curve does not pass completely across a surface, trimming is impossible, and the affected surface is displayed in the error color (orange by default).

Flip Trim 1 and Flip Trim 2 When on, trim the associated surface in the opposite direction.

U Seed and V Seed Change the UV location of the seed value on surface 1, the first surface you clicked. If there is a choice of intersections, the intersection closest to the seed point is the one used to create the curve.
**Trim Controls group**

**Trim 1 and Trim 2** When on, trim a surface against the intersection curve. When off, the surface isn’t trimmed. Trim 1 trims the first parent surface you clicked, and Trim 2 trims the second parent surface.

If the intersection curve does not pass completely across a surface, trimming is impossible, and the affected surface is displayed in the error color (orange by default).

**Flip Trim 1 and Flip Trim 2** When on, trim the associated surface in the opposite direction.

**U Seed and V Seed** Change the UV location of the seed value on surface 1, the first surface you clicked. If there is a choice of intersections, the intersection closest to the seed point is the one used to create the curve.

**Replace First Surface and Replace Second Surface** Let you replace the parent surfaces. Click a button, then click the surface to replace the original first or second surface.
Surface Offset Curve

Select NURBS object. > Modify panel > Create Curves rollout > Dependent Curves group box > Surf Offset button

Select NURBS object. > Modify panel > NURBS toolbox > Create Surface Offset Curve button

This command creates a curve that is offset from a curve that lies on a surface. In other words, the parent curve must have one of the following types: surface-surface intersection, U iso, V iso, normal projected, vector projected, CV curve on surface, or point curve on surface. The offset is normal to the surface. That is, the new curve is either above or below the surface by the offset amount.
Procedures

To create a surface offset curve:

1. In a NURBS object that contains at least one NURBS surface with a curve on it, turn on Create Surface Offset Curve in the NURBS toolbox, or Surf Offset on the Create Curves rollout.

2. Put the cursor over a curve that lies on a surface, and drag to set the offset amount. Release the mouse button to end curve creation.

Interface

Surface Offset Curve rollout (creation time)

- Offset: The amount by which the curve is offset from the surface on which the parent curve lies.

Surface Offset Curve rollout (modification time)

- Offset: The amount by which the curve is offset from the surface on which the parent curve lies.
  This parameter is animatable.

- Replace Curve: Lets you replace the parent curve. Click the button, then click the curve to replace the original parent curve.
U and V Iso Curves

Select NURBS object. > Modify panel > Create Curves rollout > Dependent Curves group box > U Iso Curve button or V Iso Curve button

Select NURBS object. > Modify panel > NURBS toolbox > Create U Iso Curve button or Create V Iso Curve button

U and V iso curves are dependent curves created from the iso (isoparametric) lines of a NURBS surface. You can use U and V iso curves to trim surfaces on page 2420.

Iso curves in the U and V dimensions

Procedures

To create an iso curve:

- Turn on U Iso Curve or V Iso Curve, then drag over the surface. The iso lines are highlighted in blue as you drag.
Click to create the curve from the highlighted iso line.

**Interface**

**Iso Curve rollout (creation time)**

- **Position** Sets the iso curve's position along the U or V axis of the surface. This parameter is animatable.

**Trim Controls group**

- **Trim** When on, trims the surface against the iso curve.
- **Flip Trim** When on, flips the direction of the trim.
**Iso Curve rollout (modification time)**

![Iso Curve rollout](image)

**Position**
Sets the iso curve's position along the U or V axis of the surface. This parameter is animatable.

**Trim Controls group**

**Trim**
When on, trims the surface against the iso curve.

**Flip Trim**
When on, flips the direction of the trim.

**Replace Base Surface**
Lets you replace the parent surface. Click the button, then click the new surface on which to base the iso curve.

**Normal Projected Curve**

Select NURBS object. > Modify panel > Create Curves rollout > Dependent Curves group box > Normal Proj. button

Select NURBS object. > Modify panel > NURBS toolbox > Create Normal Projected Curve button

A normal projected curve lies on a surface. It is based on an original curve, which is projected onto the surface in the direction of the surface's normals.

You can use normal projected curves for **trimming** on page 2420.
Trimming a surface with a normal projected curve

If the projection intersects the surface in two or more locations, the intersection closest to the seed point is the one that creates the curve.

Procedures

To create a normal projected curve:

1. In a NURBS object that contains at least one surface and one curve sub-object, turn on NormalProjected Curve in the NURBS toolbox or Normal Proj. on the Create Curves rollout.

2. Click the curve, then click the surface where you want the normal projected curve to lie.
   If the curve can be projected onto the surface in the surface's normal direction, the projected curve is created. The original, parent curve can go "off the edge of the surface." The projected curve is created only where the projection and the surface intersect.
Interface

Normal Projected Curve rollout (creation time)

Trim Controls group

Trim When on, trims the surface against the curve. When off, the surface isn’t trimmed.
If it’s impossible to trim with this curve, the surface is displayed in the error color (orange by default). For example, the curve is unusable for trimming if it neither crosses the edge of the surface nor forms a closed loop.

Flip Trim When on, trims the surface in the opposite direction.

U Seed and V Seed Change the UV location of the seed value on the surface. If there is a choice of projections, the projection closest to the seed point is the one used to create the curve.
Normal Projected Curve rollout (modification time)

Trim Controls group

Trim When on, trims the surface against the curve. When off, the surface isn’t trimmed.

If it’s impossible to trim with this curve, the surface is displayed in the error color (orange by default). For example, the curve is unusable for trimming if it neither crosses the edge of the surface nor forms a closed loop.

Flip Trim When on, trims the surface in the opposite direction.

U Seed and V Seed Change the UV location of the seed value on the surface. If there is a choice of projections, the projection closest to the seed point is the one used to create the curve.

Replace Curve and Replace Surface Let you replace the parent sub-objects. Click a button, then click a curve or surface to replace the original parent object.

Vector Projected Curve

Select NURBS object. > Modify panel > Create Curves rollout > Dependent Curves group box > Vector Proj. button
Select NURBS object. > Modify panel > NURBS toolbox > Create Vector Projected Curve button

A Vector Projected curve lies on a surface. This is almost the same as a Normal Projected curve, except that the projection from the original curve to the surface is in the direction of a vector that you can control.

You can use vector projected curves for trimming on page 2420.

![Trimming a surface with a vector projected curve](image)

**Trimming a surface with a vector projected curve**

If the projection intersects the surface in two or more locations, the intersection closest to the seed point is the one that creates the curve.

**Procedures**

**To create a vector projected curve:**

1. In a NURBS object that contains at least one surface and one curve sub-object, click to turn on Vector Projected Curve in the NURBS toolbox or Vector Proj. in the Create Curves rollout.
2 Click the curve, then the surface where you want the vector projection curve to lie.

The initial vector direction is in the view direction. That is, the vector points away from you as you look at the viewport. If the curve can be projected onto the surface in this direction, the projection curve is created. The original, parent curve can go "off the edge of the surface." The projection curve is created only where the projection and the surface intersect.

Interface

In viewports a gizmo (yellow by default) indicates the projection axis. Transforming the gizmo changes the projection onto the surface. Rotating the gizmo is the most useful transform. You can use rotation to adjust the distortion caused by projection.

Vector Projected Curve rollout (creation time)

Trim Controls group

Trim When on, trims the surface against the curve. When off, the surface isn't trimmed.

If it's impossible to trim with this curve, the surface is displayed in the error color (orange by default). For example, the curve is unusable for trimming if it neither crosses the edge of the surface nor forms a closed loop.

Flip Trim When on, trims the surface in the opposite direction.
U Seed and V Seed Change the UV location of the seed value on the surface. If there is a choice of projections, the projection closest to the seed point is the one used to create the curve.

Vector Projected Curve rollout (modification time)

Trim Controls group

Trim When on, trims the surface against the curve. When off, the surface isn’t trimmed.

If it’s impossible to trim with this curve, the surface is displayed in the error color (orange by default). For example, the curve is unusable for trimming if it neither crosses the edge of the surface nor forms a closed loop.

Flip Trim When on, trims the surface in the opposite direction.

U Seed and V Seed Change the UV location of the seed value on the surface. If there is a choice of projections, the projection closest to the seed point is the one used to create the curve.

Replace Curve and Replace Surface Let you replace the parent sub-objects. Click a button, then click a curve or surface to replace the original parent object.
CV Curve on Surface

Select NURBS object. > Modify panel > Create Curves rollout > Dependent Curves group box > CV on Surf button

Select NURBS object. > Modify panel > NURBS toolbox > Create CV Curve on Surface button

A CV curve on surface is similar to a plain CV curve, but it lies on a surface. You create it by drawing rather than projecting from a different curve. You can use this curve type for trimming on page 2420 the surface on which it lies.

Trimming a surface with a CV curve on surface

There are two methods for drawing and editing curves on surfaces: drawing in a viewport, or using the Edit Curve on Surface dialog. The choice is useful because you draw in two dimensions, with a mouse or other pointing device, while the curve on a surface can exist in three dimensions. The more complex the 3D surface, the more effort it can require to create and edit a curve on a surface.

Visual feedback can help you draw the curve. The point whose surface you first click is shown as a blue square, and the surface's minimum UV point is shown as a plus sign (+). As you draw the curve, it is displayed interactively in viewports.
**Drawing in a Viewport**

When you click to position a CV, the click is projected in the viewport's Z dimension. That is, your click is projected "through the screen" and onto the surface. This is a straightforward way to create a curve on a surface if the portion of the surface where the curve will lie is clearly visible in the viewport. However, this method doesn't let you place CVs on surface locations that are not visible in the viewport (they are on back faces, lie behind other geometry, and so on).

**Using the Edit Curve on Surface Dialog**

The Edit Curve on Surface dialog on page 2716 lets you edit curves on surfaces as you edit regular curves in a viewport. The main part of the dialog is a two-dimensional view of the surface. The controls provide typical curve editing functions. While you are creating a CV curve on surface, the 2D View toggle controls display of the Edit Curve on Surface dialog.

You can edit the CVs in CV curves on surfaces at the Curve CV sub-object level on page 2503, as you edit other kinds of curve CVs. You can transform CVs in CV curves on surfaces, but you can't move the CVs off the surface. Using the Curve CV sub-object level is an alternative to editing these CVs by using the Edit Curve on Surface dialog.

**Procedures**

To create a CV curve on surface:

1. In a NURBS object that contains at least one surface, turn on Create CV Curve on Surface in the NURBS toolbox, or CV on Surf on the Create Curves rollout.

2. Do one of the following:
   - Draw the curve in the viewport, using the mouse above the surface.
   - Turn on 2D View. This displays an Edit Curve on Surface dialog, which lets you create the curve in a two-dimensional (UV) representation of the surface.

3. Right-click to end curve creation.
Interface

CV Curve on Surface rollout (creation time)

Trim Controls group

Trim When on, trims the surface against the curve. When off, the surface isn't trimmed.

If it's impossible to trim with this curve, the surface is displayed in the error color (orange by default). For example, the curve is unusable for trimming if it doesn't form a closed loop.

Flip Trim When on, trims the surface in the opposite direction.

Automatic Reparameterization group

The radio buttons in this group box let you choose automatic reparameterization. With reparameterization, the curve maintains its parameterization as you edit it. Without reparameterization, the curve's parameterization doesn't change as you edit it, and can become irregular.

None Do not reparameterize.

Chord Length Chooses the chord-length algorithm for reparameterization. Chord-length reparameterization spaces knots (in parameter space on page 8674) based on the square root of the length of each curve segment. Chord-length reparameterization is usually the best choice.
Uniform  Spaces the knots uniformly. A uniform knot vector has the advantage that the curve will change only locally when you edit it. With the other two forms of parameterization, moving any CV can change the entire curve.

2D View  When on, displays the Edit Curve on Surface dialog on page 2716, which lets you create the curve in a two-dimensional (UV) representation of the surface.

CV Curve on Surface rollout (modification time)

Trim Controls group

Trim  When on, trims the surface against the curve. When off, the surface isn’t trimmed.

If it's impossible to trim with this curve, the surface is displayed in the error color (orange by default). For example, the curve is unusable for trimming if it doesn't form a closed loop.

Flip Trim  When on, trims the surface in the opposite direction.
**Automatic Reparameterization group**

The radio buttons in this group box let you choose automatic reparameterization. With reparameterization, the curve maintains its parameterization as you edit it. Without reparameterization, the curve's parameterization doesn't change as you edit it, and can become irregular.

**None** Do not reparameterize.

**Chord Length** Chooses the chord-length algorithm for reparameterization. Chord-length reparameterization spaces knots (in parameter space on page 8674) based on the square root of the length of each curve segment. Chord-length reparameterization is usually the best choice.

**Uniform** Spaces the knots uniformly. A uniform knot vector has the advantage that the curve will change only locally when you edit it. With the other two forms of parameterization, moving any CV can change the entire curve.

**Replace Surface** Lets you replace the parent surface. Click a button, then click a surface to replace the original parent surface.

**Edit** Click to display the *Edit Curve on Surface dialog* on page 2716, which lets you edit the curve in a two-dimensional (UV) representation of the surface. To edit multiple curves on a surface, select more than one CV curve sub-object on the same surface, then click Edit.

**Rebuild** Displays the *Rebuild CV Curve dialog* on page 2731 to let you rebuild the CV curve on surface.

**Reparam** Displays the *Reparameterize dialog* on page 2733 to let you reparameterize the CV curve on surface.

**Point Curve on Surface**

Select NURBS object. > Modify panel > Create Curves rollout > Dependent Curves group box > Point on Surf button

Select NURBS object. > Modify panel > NURBS toolbox > Create Point Curve on Surface button

A point curve on surface is similar to a plain point curve, but it lies on a surface. You create it by drawing rather than projecting from a different curve. You can use this curve type for *trimming* on page 2420 the surface on which it lies.
Trimming a surface with a point curve on surface

There are two methods for drawing and editing curves on surfaces: drawing in a viewport, or using the Edit Curve on Surface dialog. The choice is useful because you draw in two dimensions, with a mouse or other pointing device, while the curve on a surface can exist in three dimensions. The more complex the 3D surface, the more effort it can require to create and edit a curve on a surface.
Visual feedback can help you draw the curve. The point whose surface you first click is shown as a blue square, and the surface's minimum UV point is shown as a plus sign (+). As you draw the curve, it is displayed interactively in viewports.

**Drawing in a Viewport**

When you click to position a point, the click is projected in the viewport's Z dimension. That is, your click is projected "through the screen" and onto the surface. This is a straightforward way to create a curve on a surface if the portion of the surface where the curve will lie is clearly visible in the viewport. However, this method doesn't let you place points on surface locations that are not visible in the viewport (they are on back faces, lie behind other geometry, and so on).

**Using the Edit Curve on Surface Dialog**

The *Edit Curve on Surface dialog* on page 2716 lets you edit curves on surfaces as you edit regular curves in a viewport. The main part of the dialog is a two-dimensional view of the surface. The controls provide typical curve editing functions. While you are creating a point curve on surface, the 2D View toggle controls display of the Edit Curve on Surface dialog.

You can edit the points in point curves on surfaces at the *Point sub-object level* on page 2496, as you edit other kinds of points. You can transform points in point curves on surfaces, but you can't move the points off the surface. Using the Point sub-object level is an alternative to editing these points by using the Edit Curve on Surface dialog.

**Procedures**

**To create a point curve on surface:**

1. In a NURBS object that contains at least one surface, turn on Create Point Curve on Surface in the NURBS toolbox, or Point on Surf on the Create Curves rollout.

2. Do one of the following:
   - Draw the curve in the viewport, using the mouse above the surface.
   - Turn on 2D View. This displays an Edit Curve on Surface dialog, which lets you create the curve in a two-dimensional (UV) representation of the surface.
Right-click to end curve creation.

**Interface**

Point curves on surfaces have point sub-objects that you can transform and edit in viewports as you do with plain point curves.

**Point Curve on Surface rollout (creation time)**

![Point Curve On Surface Rollout](image)

**Trim Controls group**

*Trim* When on, trims the surface against the curve. When off, the surface isn’t trimmed.

If it’s impossible to trim with this curve, the surface is displayed in the error color (orange by default). For example, the curve is unusable for trimming if it doesn’t form a closed loop.

*Flip Trim* When on, trims the surface in the opposite direction.

*2D View* When on, displays the Edit Curve on Surface dialog on page 2716, which lets you create the curve in a two-dimensional (UV) representation of the surface.
Point Curve on Surface rollout (modification time)

Trim Controls group

Trim When on, trims the surface against the curve. When off, the surface isn’t trimmed.

If it’s impossible to trim with this curve, the surface is displayed in the error color (orange by default). For example, the curve is unusable for trimming if it doesn’t form a closed loop.

Flip Trim When on, trims the surface in the opposite direction.

Replace Surface Lets you replace the parent surface. Click a button, then click a surface to replace the original parent surface.

Edit Click to display the Edit Curve on Surface dialog on page 2716, which lets you edit the curve in a two-dimensional (UV) representation of the surface. To edit multiple curves on a surface, select more than one point curve sub-object on the same surface, then click Edit.

Surface Edge Curve

Select NURBS object. > Modify panel > Create Curves rollout > Dependent Curves group box > Surf Edge button

Select NURBS object. > Modify panel > NURBS toolbox > Create Surface Edge Curve button

A surface edge curve is a dependent curve type that lies on the boundary of the surface. It can be the original boundary of the surface, or a trim edge.
Creating a curve from a surface edge

**Procedures**

To create a surface edge curve:

1. Turn on Surf Edge.
2. As you move the mouse in the scene, NURBS surface edges are highlighted in blue. Click the edge where you want to create the curve.
Interface

Surface Edge Curve rollout (creation time)

Seed 1 and Seed 2 The curve resides on the edge closest to the two seed values. Adjust the seed values to change the edge on which the curve resides.

Surface Edge Curve rollout (modification time)

Seed 1 and Seed 2 The curve resides on the edge closest to the two seed values. Adjust the seed values to change the edge on which the curve resides.

Replace Surface This lets you replace the parent surface. Click a button, then click a surface to replace the original parent surface.

Creating Surface Sub-Objects

Select NURBS object. > Modify panel > Create Surfaces rollout
Select NURBS object. > NURBS toolbox
Keyboard > Ctrl+T to toggle NURBS toolbox display (Keyboard Shortcut Override Toggle must be on.)
Surface sub-objects are either independent point and CV surfaces (like the top-level point and CV surfaces described in Point Surface and CV Surface), or they are dependent surfaces. Dependent surfaces are surface sub-objects whose geometry depends on other surfaces or curves in the NURBS model. When you change the geometry of the original, parent surface or curve, the dependent surface changes as well.

You create surface sub-objects using the Create Surfaces rollout on the Modify panel for a NURBS surface, or using the NURBS toolbox on page 2426.
**TIP** Lathe and extrude surface sub-objects can be based on only a single curve. If you have dependent curves and want to use the set of curves (for example, two parents and a fillet between them) as the basis of an extrude or lathe surface, first go to the Curve sub-object level and use Join to connect the curves.

Creation operations for dependent sub-objects require that you select one or more parent objects. In general, you can click and drag, or click and then click again. You can also use the H keyboard shortcut to open a Pick Object version of the Selection Floater on page 209 for choosing the parent. (The Keyboard Shortcut Override Toggle on page 8420 must be on for H to work this way.)

**Toolbox Buttons for Creating Surfaces**

These are the toolbox buttons for creating surface sub-objects:

- ![Create an independent CV surface sub-object on page 2606.](image)
- Create an independent point surface sub-object on page 2610.
- ![Create a dependent transform surface on page 2612.](image)
- Create a dependent blend surface on page 2614.
- ![Create a dependent offset surface on page 2621.](image)
- Create a dependent mirror surface on page 2624.
- ![Create a dependent extrude surface on page 2628.](image)
- Create a dependent lathe surface on page 2631.
- ![Create a dependent ruled surface on page 2640.](image)
- Create a dependent cap surface on page 2643.
- ![Create a dependent U loft surface on page 2646.](image)
Create a dependent UV loft surface on page 2656.

Create a dependent 1-rail sweep surface on page 2663.

Create a dependent 2-rail sweep surface on page 2673.

Create a dependent multisided blend surface on page 2683.

Create a dependent multicurve trimmed surface on page 2684.

Create a dependent fillet surface on page 2689.

CV Surface Sub-Object

Select NURBS object. > Modify panel > Create Surfaces rollout > CV Surf
Select NURBS object. > Modify panel > NURBS toolbox > Create CV Surface button
Select NURBS object. > Modify panel > Right-click a viewport. > Tools 2 (lower-left) quadrant > Create CV Surface
CV surface sub-objects are similar to object-level CV surfaces on page 2460.

See also:
- Editing Surface Sub-Objects on page 2530
- NURBS Surface Approximation on page 2737

Procedures

To create a CV surface sub-object:

1. In a NURBS object, turn on CV Surf on the Create Surfaces rollout or Create CV Surface in the toolbox.

2. In a viewport, drag to specify the initial area of the CV surface.
3. Adjust the CV surface's creation parameters.

**Interface**

The parameters that appear when you create a CV surface sub-object differ from those you see when you modify it as a sub-object.

**CV Surface rollout (creation time)**

![Image of CV Surface rollout]

- **Length** The length of the surface in current 3ds Max units.
- **Width** The width of the surface in current 3ds Max units.
- **Length Points** The number of points along the length of the surface. In other words, the initial number of point columns in the surface. Range=2 to 50. Default=4.
- **Width Points** The number of points along the width of the surface. In other words, the initial number of point rows in the surface. Range=2 to 50. Default=4.
Generate Mapping Coordinates Generates mapping coordinates so you can apply mapped materials to the surface.

Flip Normals Turn on to reverse the direction of the surface normals.

**Automatic Reparameterization group**

The radio buttons in this group box let you choose automatic reparameterization. With reparameterization, the surface maintains its parameterization as you edit it. Without reparameterization, the surface's parameterization doesn't change as you edit it, and can become irregular.

None Do not reparameterize.

Chord Length Chooses the chord-length algorithm for reparameterization. Chord-length reparameterization spaces knots (in parameter space on page 8674) based on the square root of the length of each curve segment. Chord-length reparameterization is usually the best choice.

Uniform Spaces the knots uniformly.
A uniform knot vector has the advantage that the surface will change only locally when you edit it. With the other two forms of parameterization, moving any CV can change the entire surface.

**CV Surface rollout (modification time)**
U Degree and V Degree

Let you set the degree of the surface in either the U or V dimension. The higher the degree value, the greater the continuity. The lower the degree, the more discontinuous the surface segments become. The degree can’t be less than one or greater than the number allowed by the number of CVs in the specified dimension. Degree 3 is adequate to represent continuous surfaces, and is stable and well behaved. Default=3.

Setting the degree greater than 3 isn’t recommended, because higher degrees are slower to calculate and less stable numerically. Higher degrees are supported primarily to be compatible with models created using other surface modeling programs.

The number of CVs in a given dimension must be at least one greater than that dimension’s degree.

Automatic Reparameterization group

The radio buttons in this group box let you choose automatic reparameterization. With reparameterization, the surface maintains its parameterization as you edit it. Without reparameterization, the surface’s parameterization doesn’t change as you edit it, and can become irregular.

None

Do not reparameterize.

Chord Length

Chooses the chord-length algorithm for reparameterization. Chord-length reparameterization spaces knots (in parameter space on page 8674) based on the square root of the length of each curve segment. Chord-length reparameterization is usually the best choice.

Uniform

Spaces the knots uniformly.

A uniform knot vector has the advantage that the surface will change only locally when you edit it. With the other two forms of parameterization, moving any CV can change the entire surface.

The close controls let you close a surface. They appear on the Point Surface rollout while an independent point surface sub-object is selected. They have no effect if the surface is already closed in that direction.

Close Rows

Closes the surface by joining the ends of its rows.

Close Cols.

Closes the surface by joining the ends of its columns.

Rebuild

Displays the Rebuild CV Surface dialog on page 2732, which lets you specify how to rebuild the surface. Rebuilding the surface can change its appearance.

Reparameterize

Displays the Reparameterize dialog on page 2733. Reparameterizing a surface changes the surface’s parameter space on page 8674.
to provide a better relation between control point locations and the shape of the surface.

**TIP** It is a good idea to reparameterize after you have added CVs to the surface by refining or inserting.

---

**Point Surface Sub-Object**

Select NURBS object. > Modify panel > Create Surfaces rollout > Point Surf
Select NURBS object. > Modify panel > NURBS toolbox > Create Point Surface button
Select NURBS object. > Modify panel > Right-click a viewport. > Tools 2 (lower-left) quadrant > Create Point Surface

Point surface sub-objects are similar to object-level point surfaces on page 2456. The points are constrained to lie on the surface.

**See also:**
- Editing Surface Sub-Objects on page 2530
- NURBS Surface Approximation on page 2737

**Procedures**

**To create a point surface sub-object:**

1. In a NURBS object, turn on Point Surf on the Create Surfaces rollout or Create Point Surface in the toolbox.
2. In a viewport, drag to specify the initial area of the point surface.
3. Adjust the point surface’s creation parameters.

**Interface**

The parameters that appear when you create a point surface sub-object differ from those you see when you modify it as a sub-object.
Point Surface rollout (creation time)

Length The length of the surface in current 3ds Max units.

Width The width of the surface in current 3ds Max units.

Length Points The number of points along the length of the surface. In other words, the initial number of point columns in the surface. Range=2 to 50. Default=4.

Width Points The number of points along the width of the surface. In other words, the initial number of point rows in the surface. Range=2 to 50. Default=4.

Generate Mapping Coordinates Generates mapping coordinates so you can apply mapped materials to the surface.

Flip Normals Turn on to reverse the direction of the surface normals.

Point Surface rollout (modification time)
The close controls let you close a surface. They appear on the Point Surface rollout while an independent point surface sub-object is selected. They have no effect if the surface is already closed in that direction.

**Close Rows** Closes the surface by joining the ends of its rows.

**Close Cols.** Closes the surface by joining the ends of its columns.

## Transform Surface

Select NURBS object. > Modify panel > Create Surfaces rollout Dependent Surfaces group box > Transform

Select NURBS object. > Modify panel > NURBS toolbox > Create Transform Surface button

A transform surface is a copy of the original surface with a different position, rotation, or scale.

![Surface created as a transform](image)
Procedures

To create a transform surface:

- In a NURBS object that contains at least one surface, turn on Transform.
  To move the transform surface, click and drag the surface you want to duplicate. To rotate or scale the transform surface, click the parent surface, go to the Surface sub-object level in the modifier stack, and then rotate or scale the transform surface.
  When you use Move to create the transform surface, it simply copies the parent. (It doesn’t exaggerate curvature as an offset surface does.) Axis constraints don’t apply to the creation of transform surfaces. You can click to create the surface in place; then once it is created, transform it using constraints.

You can later transform the transform surface as a surface sub-object, and you can animate surface sub-object transforms.

Interface

Creation time

At creation time, there is only one parameter.

Flip Normals Flips the surface normals
After creation, you can flip normals using controls on the Surface Common rollout.
**Transform Surface rollout (modification time)**

[Image]

**Replace Base Surface** Lets you replace the parent surface. Click the button, then click the surface to replace the original surface.

**Blend Surface**

Select NURBS object. > Modify panel > Create Surfaces rollout > Dependent Surfaces group box > Blend

Select NURBS object. > Modify panel > NURBS toolbox > Create Blend Surface button

A blend surface connects one surface to another, blending the curvature of the parent surfaces to create a smooth surface between them. You can also blend from a surface to a curve, or from a curve to a curve.
Blend surface connecting two other surfaces

Procedures

To create a blend surface:

1. In a NURBS object that contains two surfaces, two curves, or a surface and a curve, turn on Blend.

2. Click one surface near the edge that you want to connect. The edge that will be connected is highlighted in blue. Drag to choose the other edge you want to connect. When the edge you want is highlighted, click and then drag to the other surface. The edge of the other surface is also highlighted in blue. Drag on the other surface to choose the edge to connect, and then release the mouse button to create the blend surface. The surface that owns the highlighted edge is highlighted in yellow, to help you distinguish which edge you are choosing when two surfaces have coincident edges.

The blend surface is created. Changing the position or the curvature of either parent surface will change the blend surface as well.
3. Adjust the blend parameters.

**Interface**

While a blend surface sub-object is selected, a rollout with the blend parameters is displayed at the bottom of the Modify panel.

**Blend Surface rollout (creation time)**

![Blend Surface rollout](image)

"Tension" affects the tangent between a parent surface and the blend surface. The greater the tension value, the more closely the tangent parallels the parent surface, and the smoother the transition. The lower the tension, the greater the tangent angle and the sharper the transition between parent and blend.

**Tension 1** Controls tension at the edge of the first surface you clicked. This value has no effect if the edge is a curve.

**Tension 2** Controls tension at the edge of the second surface you clicked. This value has no effect if the edge is a curve.
A. Tension 1=0, Tension 2=10
B. Tension 1=1, Tension 2=1
C. Tension 1=10, Tension 2=0
D. Tension 1=0, Tension 2=0

Flip End 1 and Flip End 2 Flip one of the normals used to construct the blend. A blend surface is created using the normals of the parent surfaces. If the two parents have opposing normals, or if a curve has the opposite direction, the blend surface can be shaped like a bow tie. To correct the situation, use Flip End 1 or Flip End 2 to construct the blend using a normal opposite the corresponding parent surface’s normal.
A. No flipping
B. End 2 is flipped.

**Flip Tangent 1 and Flip Tangent 2** Flip the tangent at the edge of the first or second curve or surface. Flipping the tangent reverses the direction in which the blend surface approaches the parent sub-object at that edge.
Flipping the tangent has no effect if the edge is a curve, unless the curve is a curve on surface.
When you blend to a CV or point curve on surface, the new blend surface is tangent to the surface on which the curve on surface lies. The Flip Tangent controls are especially useful in this situation.
A. Tangent 1 flipped
B. Tangent 2 flipped

**Start Point 1 and Start Point 2** Adjust the position of the start point at the two edges of the blend. Adjusting the start points can help eliminate unwanted twists or "buckles" in the surface.

These spinners are unavailable if the edges or curves are not closed.

While you're adjusting start points, a dotted blue line is displayed between them, to show the alignment. The surface is not displayed, so it doesn't slow down adjustment. When you release the mouse button, the surface reappears.

**Flip Normals** Turn on to reverse the direction of the blend surface normals.
Blend Surface rollout (modification time)

"Tension" affects the tangent between a parent surface and the blend surface. The greater the tension value, the more closely the tangent parallels the parent surface, and the smoother the transition. The lower the tension, the greater the tangent angle and the sharper the transition between parent and blend.

**Tension 1** Controls tension at the edge of the first surface you clicked. This value has no effect if the edge is a curve.

**Tension 2** Controls tension at the edge of the second surface you clicked. This value has no effect if the edge is a curve.

**Flip End 1 and Flip End 2** Flip one of the normals used to construct the blend. A blend surface is created using the normals of the parent surfaces. If the two parents have opposing normals, or if a curve has the opposite direction, the blend surface can be shaped like a bow tie. To correct the situation, use Flip End 1 or Flip End 2 to construct the blend using a normal opposite the corresponding parent surface's normal.

**Flip Tangent 1 and Flip Tangent 2** Flip the tangent at the edge of the first or second curve or surface. Flipping the tangent reverses the direction in which the blend surface approaches the parent sub-object at that edge.
Flipping the tangent has no effect if the edge is a curve, unless the curve is a curve on surface.

When you blend to a CV or point curve on surface, the new blend surface is tangent to the surface on which the curve on surface lies. The Flip Tangent controls are especially useful in this situation.

**Start Point 1 and Start Point 2** Adjust the position of the start point at the two edges of the blend. Adjusting the start points can help eliminate unwanted twists or "buckles" in the surface.

These spinners are unavailable if the edges or curves are not closed.

While you're adjusting start points, a dotted blue line is displayed between them, to show the alignment. The surface is not displayed, so it doesn't slow down adjustment. When you release the mouse button, the surface reappears.

**Replace First Edge and Replace Second Edge** Let you replace the parent edges or curves. Click a button, then click the edge to replace the original first or second edge. The edge can be on the same surface as the original edge, or on a different surface.

---

### Offset Surface

Select NURBS object. > Modify panel > Create Surfaces rollout > Dependent Surfaces group box > Offset

Select NURBS object. > Modify panel > NURBS toolbox > Create Offset Surface button

An Offset surface is offset a specified distance from the original along the parent surface's normals.
Surface created as an offset

Procedures

To create an offset surface:

1. In a NURBS object that contains at least one surface, turn on Offset.

2. Click the surface you want to offset, and drag to set the initial distance of the offset surface.
   The offset surface is created.

3. Adjust the Offset parameter.

Interface

While an offset surface sub-object is selected, a rollout with the offset Distance parameter is displayed at the bottom of the Modify panel.
**Offset Surface rollout (creation time)**

**Offset** The distance between the parent surface and the offset surface, in 3ds Max units.

If the parent surface is planar, the appearance of the offset surface doesn't change with distance. If the parent surface is curved, increasing the offset value increasingly exaggerates the curvature of the offset surface.

**Flip Normals** Lets you flip the surface normals at creation time. (After creation, you can flip normals using controls on the Surface Common rollout.)

**Cap** When on, eight boundary curves are generated (four at the four edges of each surface), and then generates four ruled surfaces to connect the two original surfaces. While they are present, cap surfaces are maintained so they match the dimensions of the offset and its parent.

The Cap check box appears only on the creation rollout. If you want to remove the caps later, simply select them as surface sub-objects and delete them. Think of offset capping as a workflow shortcut rather than a property (or parameter) of offset surfaces.

To flip the normal of an offset cap, select it as a surface sub-object and use the Flip Normals toggle on the Surface Common rollout.

**NOTE** If you trim the original surface, or make the offset surface independent and then trim it, the capping surfaces will look strange.
Offset Surface rollout (modification time)

**Offset** The distance between the parent surface and the offset surface in 3ds Max units.
If the parent surface is planar, the appearance of the offset surface doesn't change with distance. If the parent surface is curved, increasing the offset value increasingly exaggerates the curvature of the offset surface.

**Replace Base Surface** Lets you replace the parent surface. Click the button, then click the new surface on which to base the offset.

Mirror Surface

Select NURBS object. > Modify panel > Create Surfaces rollout > Dependent Surfaces group box > Mirror

Select NURBS object. > Modify panel > NURBS toolbox > Create Mirror Surface button

A mirror surface is a mirror image of the original surface.
Surface created as a mirror

Procedures

To create a mirror surface:

1. In a NURBS object that contains at least one surface, turn on Mirror.
2. On the Mirror Surface rollout, choose the axis or plane you want to use.
3. Click the surface you want to mirror, and drag to set the initial distance of the mirror surface.
   The mirror surface is created. A gizmo (yellow by default) indicates the direction of mirroring. Transforming the mirror surface's gizmo changes the orientation of the mirror, letting you mirror along an axis that isn't aligned with a local coordinate axis.
   The Flip Normals control lets you flip the surface normals at creation time. (After creation, you can flip normals using controls on the Surface Common rollout.)
4. Adjust the Offset parameter.
Interface

While a mirror surface sub-object is selected, the Mirror Surface rollout appears at the bottom of the Modify panel. Also, a gizmo (yellow by default) indicates the mirror axis.

Mirror Surface rollout (creation time)

Mirror Axis group

The Mirror Axis buttons control the direction in which the original surface is mirrored.

You can't transform the mirror surface directly (that would simply transform the mirror surface and its parent surface at the same time). You transform it by transforming its gizmo. By using transforms you can mirror about an arbitrary axis, rather than using one of the Mirror Axis presets. When you transform a mirror surface, you are actually transforming the mirror plane, so Rotate has the effect of rotating the plane about which the surface is mirrored. (This is like rotating the mirror gizmo in the Mirror modifier.)

**TIP** A convenient way to guarantee that a surface is symmetrical is to create one side of the surface, mirror that surface, and then create a blend between the two sides.

Offset Controls the mirror's distance from the original surface. This parameter is animatable.

Flip Normals Lets you flip the surface normals.
Mirror Surface rollout (modification time)

Mirror Axis group

The Mirror Axis buttons control the direction in which the original surface is mirrored.

You can't transform the mirror surface directly (that would simply transform the mirror surface and its parent surface at the same time). You transform it by transforming its gizmo. By using transforms you can mirror about an arbitrary axis, rather than using one of the Mirror Axis presets. When you transform a mirror surface, you are actually transforming the mirror plane, so Rotate has the effect of rotating the plane about which the surface is mirrored. (This is like rotating the mirror gizmo in the Mirror modifier.)

TIP A convenient way to guarantee that a surface is symmetrical is to create one side of the surface, mirror that surface, and then create a blend between the two sides.

Offset Controls the mirror’s distance from the original surface. This parameter is animatable.

Replace Base Surface Lets you replace the parent surface. Click the button, then click the new surface on which to base the mirror.
Extrude Surface

Select NURBS object. > Modify panel > Create Surfaces rollout > Dependent Surfaces group box > Extrude

Select NURBS object. > Modify panel > NURBS toolbox > Create Extrude Surface button

An extrude surface is extruded from a curve sub-object. It is similar to a surface created with the Extrude modifier. The advantage is that an extrude sub-object is part of the NURBS model, so you can use it to construct other curve and surface sub-objects.

Procedures

To create an extrude surface:

1. In a NURBS object that contains at least one curve, turn on Extrude.
2 Move the cursor over the curve to extrude, and drag to set the initial amount.

By default, the surface extrudes along the NURBS model's local Z axis. A gizmo (yellow by default) indicates the direction of extrusion. Transforming the extrude surface's gizmo changes the direction of the extrude, letting you extrude along an axis that isn't aligned with a local coordinate axis.

The Flip Normals control lets you flip the surface normals at creation time. (After creation, you can flip normals using controls on the Surface Common rollout.)

3 Adjust the extrusion parameters.

**Interface**

While an extrude sub-object is selected, a rollout with the extrusion parameters is displayed at the bottom of the Modify panel.

**Extrude Surface rollout (creation time)**

```
- Extrude Surface

Amount: 0.0

Direction

X, Y and Z

Start Point: 0.0

Flip Normals

Cap
```

**Amount** The distance the surface is extruded from the parent curve in current 3ds Max units.

This parameter is animatable.

**Direction group**

X, Y and Z Choose the axis of extrusion. Default=Z.
**Start Point** Adjusts the position of the curve's start point. This can help eliminate unwanted twists or "buckles" in the surface. This control is disabled if the curve is not a closed curve. The start point is displayed as a blue circle.

**Flip Normals** Lets you flip the surface normals at creation time. (After creation, you can flip normals using controls in the Surface Common rollout.)

**Cap** When on, two surfaces are generated to close the ends of the extrusion. While they are present, the cap surfaces are maintained so they match the dimensions of the extrude surface. The parent curve must be a closed curve. The Cap check box appears only on the creation rollout. If you want to remove the caps later, simply select them as surface sub-objects and delete them. Think of extrude capping as a workflow shortcut rather than a property (or parameter) of extrude surfaces.

To flip the normal of an extrude cap, select it as a Surface sub-object and use the Flip Normals toggle on the Surface Common rollout.

**Extrude Surface rollout (modification time)**

![Extrude Surface Rollout](image)

**Amount** The distance the surface is extruded from the parent curve in current 3ds Max units.

**Direction group**

**X, Y and Z** Choose the axis of extrusion. Default=Z.
Start Point Adjusts the position of the curve's start point. This can help eliminate unwanted twists or "buckles" in the surface. This control is disabled if the curve is not a closed curve. The start point is displayed as a blue circle.

Replace Base Curve Lets you replace the parent curve. Click the button, then click the new curve on which to base the extruded surface.

Lathe Surface

Select NURBS object. > Modify panel > Create Surfaces rollout > Dependent Surfaces group box > Lathe
Select NURBS object. > Modify panel > NURBS toolbox > Create Lathe Surface button

A lathe surface is generated from a curve sub-object. It is similar to a surface created with the Lathe modifier. The advantage is that a lathe sub-object is part of the NURBS model, so you can use it to construct other curve and surface sub-objects.
To create a lathe surface:

1. In a NURBS object that contains at least one curve, turn on Lathe.

2. Click the curve to lathe.
   The lathe surface rotates about the NURBS model's local Y axis. The initial lathe amount is 360 degrees. A gizmo (yellow by default) indicates the axis of the lathe. Transforming the lathe surface's gizmo changes the shape of the lathe, and lets you lathe around an axis that isn't aligned with a local coordinate axis.
The Flip Normals control lets you flip the surface normals at creation time. (After creation, you can flip normals using controls on the Surface Common rollout.)

3 Adjust the lathe parameters.

**Interface**

While a lathe sub-object is selected, a rollout with the lathe parameters is displayed at the bottom of the Modify panel.
Lathe Surface rollout (creation time)

**Degrees** Sets the angle of rotation. At 360 degrees (the default), the surface completely surrounds the axis. At lower values, the surface is a partial rotation.
A partial lathe (degrees=225)

Direction group

X, Y, and Z Choose the axis of rotation. Default=Y.
X, Y, and Z rotations of the same curve

**Align group**

These buttons position the axis of rotation relative to the curve.

**Min** (The default.) Locates the lathe axis at the curve's negative local X-axis boundary.

**Center** Locates the lathe axis at the curve's center.

**Max** Locates the lathe axis at the curve's positive local X-axis boundary.
Min, Center, and Max lathes of the same curve

**Start Point** Adjusts the position of the curve's start point. This can help eliminate unwanted twists or "buckles" in the surface. This control is disabled if the curve is not a closed curve. The start point is displayed as a blue circle.

**Flip Normals** Lets you flip the surface normals at creation time. (After creation, you can flip normals using controls on the Surface Common rollout.)

**Cap** When on, two surfaces are generated to close the ends of the lathe. While they are present, the cap surfaces are maintained so they match the dimensions of the lathe surface. The lathe must be a 360-degree lathe. The Cap check box appears *only* on the creation rollout. If you want to remove the caps later, simply select them as surface sub-objects and delete them. Think of lathe capping as a workflow shortcut rather than a property (or parameter) of lathe surfaces.

To flip the normal of a lathe cap, select it as a Surface sub-object and use the Flip Normals toggle on the Surface Common rollout.
Adding a cap to a partial lathe
Lathe Surface rollout (modification time)

 Degrees  Sets the angle of rotation. At 360 degrees (the default), the surface completely surrounds the axis. At lower values, the surface is a partial rotation.

**Direction group**

 X  Y  Z  Choose the axis of rotation. Default=Y.

**Align group**

 These buttons position the axis of rotation relative to the curve.

 Min  (The default.) Locates the lathe axis at the curve's negative local X-axis boundary.

 Center  Locates the lathe axis at the curve's center.

 Max  Locates the lathe axis at the curve's positive local X-axis boundary.

 Start Point  Adjusts the position of the curve's start point. This can help eliminate unwanted twists or "buckles" in the surface.

 This control is disabled if the curve is not a closed curve.

 The start point is displayed as a blue circle.
Replace Base Curve  Lets you replace the parent curve. Click the button, then click the new surface on which to base the lathed surface.

Ruled Surface

Select NURBS object. > Modify panel > Create Surfaces rollout > Dependent Surfaces group box > Ruled

Select NURBS object. > Modify panel > NURBS toolbox > Create Ruled Surface button

A ruled surface is generated from two curve sub-objects. It lets you use curves to design the two opposite borders of a surface.

Using two curves to create a ruled surface

You can animate the parent curves or their CVs to change the ruled surface.
Automatic Curve Attachment

When you create a ruled surface, you can select curves that are not already sub-objects of the active NURBS model. You can select another curve or spline Splines object in the scene. When you select that curve, it attaches to the current object as if you had used the Attach button on page 2490.

**WARNING** If the curve you attach is a sub-object of another NURBS model, the entire model (that is, the curve's parent NURBS object) is attached as well.

As you move the mouse over a curve that is not part of the active NURBS object, the cursor changes shape to indicate that you can pick the curve, but the curve is not highlighted in blue.

Procedures

**To create a ruled surface:**

1. In a NURBS object that contains at least two curves, turn on Ruled.
2. Drag from one curve to the other.
   You can also click first one curve, then the other.
   A dependent surface is generated, using the two curves as the surface's opposite edges. The perpendicular edges are generated automatically.

The Flip Normals control lets you flip the surface normals at creation time. (After creation, you can flip normals using controls on the Surface Common rollout.)
Interface

When you turn on the Ruled button, and while a ruled surface sub-object is selected, a rollout with the ruled surface parameters is displayed at the bottom of the Modify panel.

Ruled Surf rollout (creation time)

![Ruled Surf rollout](image)

**Flip Beginning and Flip End** Flip one of the curve directions used to construct the ruled surface. A ruled surface is created using the directions of the parent curves. If the two parents have opposing directions, the ruled surface can be shaped like a bow tie. To correct the situation, use Flip Beginning or Flip End to construct the ruled surface using a direction opposite the corresponding parent curve’s direction. These controls eliminate the need to reverse the curve.

**Start Point 1 and Start Point 2** Adjust the position of the start point at the two curves that specify the ruled surface. Adjusting the start points can help eliminate unwanted twists or “buckles” in the surface.

These spinners are disabled if the edges or curves are not closed.

While you’re adjusting start points, a dotted blue line is displayed between them, to show the alignment. The surface is not displayed, so it doesn’t slow down adjustment. When you release the mouse button, the surface reappears.

**Flip Normals** Turn on to reverse the direction of the ruled surface’s normals.
Ruled Surf rollout (modification time)

Flip Beginning and Flip End  Flip one of the curve directions used to construct the ruled surface. A ruled surface is created using the directions of the parent curves. If the two parents have opposing directions, the ruled surface can be shaped like a bow tie. To correct the situation, use Flip Beginning or Flip End to construct the ruled surface using a direction opposite the corresponding parent curve's direction. These controls eliminate the need to reverse the curve.

Start Point 1 and Start Point 2  Adjust the position of the start point at the two curves that specify the ruled surface. Adjusting the start points can help eliminate unwanted twists or "buckles" in the surface.

These spinners are disabled if the edges or curves are not closed.

While you're adjusting start points, a dotted blue line is displayed between them, to show the alignment. The surface is not displayed, so it doesn't slow down adjustment. When you release the mouse button, the surface reappears.

Replace First Curve and Replace Second Curve  Let you replace the parent curves. Click a button, then click the curve to replace the original first or second curve.

Cap Surface

Select NURBS object. > Modify panel > Create Surfaces rollout > Dependent Surfaces group box > Cap
Select NURBS object. > Modify panel > NURBS toolbox > Create Cap Surface button

This command creates a surface that caps a closed curve or the edge of a closed surface. Caps are especially useful with extruded surfaces.

Capping an extrude surface

Procedures

To create a cap surface:

1. In a NURBS object, turn on Cap.

2. Move the mouse over the closed curve or the closed edge of a closed surface.
   If the cap can be created, the curve or edge is highlighted in blue.

3. Click the highlighted curve or edge.
The Flip Normals control lets you flip the surface normals at creation time. (After creation, you can flip normals using controls on the Surface Common rollout.)

**Interface**

While a cap surface sub-object is selected, a rollout with cap surface controls is displayed at the bottom of the Modify panel.

**Cap Surface rollout (creation time)**

- **Flip Normals** Turn on to reverse the direction of the cap surface's normals.
- **Start Point** Adjusts the position of the edge or curve's start point. The start point is displayed as a blue circle.

**Cap Surface rollout (modification time)**
**Replace Curve** Lets you replace the parent curve or edge. Click the button, then click the new curve or edge on which to base the cap.

**Start Point** Adjusts the position of the edge or curve's start point. The start point is displayed as a blue circle.

**U Loft Surface**

Select NURBS object. > Modify panel > Create Surfaces rollout > Dependent Surfaces group box > U Loft

Select NURBS object. > Modify panel > NURBS toolbox > Create U Loft Surface button

A U loft surface interpolates a surface across multiple curve sub-objects. The curves become U-axis contours of the surface.

*Using multiple curves to create a U Loft surface*
Tips

- A U loft can be an extremely dense surface. To improve performance while working with viewports, set the surface approximation on page 2737 for viewports to Curvature Dependent.

- You can speed up U loft creation by making sure that the curves you loft have the same number of CVs in the same order (that is, the curves point in the same direction). Also, CV curves have a performance advantage over point curves.

- Turning off display of dependent sub-objects, including the U loft itself, also speeds up interactive performance when you create a U loft. The default keyboard toggle for dependent sub-object display is Ctrl+D (the Keyboard Shortcut Override Toggle on page 8420 button must be on.)

Closed U lofts

Automatic Curve Attachment

When you create a U loft, you can select curves that are not already sub-objects of the active NURBS model. You can select another curve or spline on page
577 object in the scene. When you select that curve, it is automatically attached to the current object as if you had used the Attach button.

**WARNING** If the curve you attach is a sub-object of another NURBS model, the entire model (that is, the curve's parent NURBS object) is attached as well.

As you move the mouse over a curve that is not part of the active NURBS object, the cursor changes shape to indicate you can pick the curve, but the curve is not highlighted in blue.

**Procedures**

To **create a U loft surface**:

1. In a NURBS object that contains at least two curves, turn on U Loft.
2. Click the first curve.
3. Click additional curves in succession.
The U loft is created. It is "stretched" across the curves you click. The order in which you click the curves can affect the shape of the U loft surface. The names of the curves appear in the U Loft Surface creation rollout.

While creating a U loft, you can press Backspace to remove the last curve you clicked from the list of U loft curves.
The Flip Normals control lets you flip the surface normals at creation time. (After creation, you can flip normals using controls on the Surface Common rollout.)

4 Right-click to end U loft creation.

To create a U loft with automatic attach (example):

1 From the Create panel, create three or more independent CV or Point NURBS curves.

2 Go to the Modify panel, and click to turn on U Loft in the NURBS toolbox.

3 Select the curves in the appropriate order for the loft.
   
   The U loft is created. You don't have to collapse the curves to a NURBS surface, or attach them to an existing NURBS model on page 2490.

   As you move the mouse over a curve that is not part of the active NURBS object, the cursor changes shape to indicate you can pick the curve, but the curve is not highlighted in blue.

Interface

While a U loft sub-object is selected, a rollout with the U loft parameters is displayed at the bottom of the Modify panel. This rollout appears only when one U loft sub-object is selected. It isn't possible to edit more than one U loft at a time, so unlike some other NURBS sub-objects, the rollout doesn't appear when multiple U loft sub-objects are selected.

When you create lofted and swept surfaces, you have access to all the parameters, and some of the editing operations, of the surface. You can reverse and set start points on curves while you create the surface. You can also use the arrow buttons to change the order of the curves, and you can remove a curve with the Remove button.

TIP When you edit a U loft sub-object, close the Surface Common rollout to see the U Loft Surface rollout more easily.
U Loft Surface rollout (creation time)

**U Curves** This list shows the name of the curves you click in the order you click them. You can select curves by clicking their names. Viewports display the selected curve in blue. Initially the first curve is the one selected. You can also select more than one curve at a time. This is useful when you use the Edit Curves button.
Arrow Buttons Use these to change the order of curves used to construct the U loft. Select a curve in the list, and then use the arrows to move the selection up or down.
These buttons are available at creation time.

Curve Properties group

These controls affect individual curves you select in the U Curves list, as opposed to properties of the loft surface in general. They are enabled only when you have selected a curve in the U Curves list.

Reverse When set, reverses the direction of the selected curve.

Start Point Adjusts the position of the curve's start point.
This control is disabled if the curve is not a closed curve.
While you’re adjusting start points, a dotted blue line is displayed between them, to show the alignment. The surface is not displayed, so it doesn’t slow down adjustment. When you release the mouse button, the surface reappears.

Tension Adjusts the tension of the loft where it intersects that curve.

Use COS Tangents If the curve is a curve on surface, turning on this toggle causes the U loft to use the tangency of the surface. This can help you blend a loft smoothly onto a surface. Default=off.
This toggle is disabled unless the curve is a point or CV curve on surface.

Flip Tangents Reverses the direction of the tangents for that curve.
This toggle is disabled unless the curve is a point or CV curve on surface and Use COS Tangents is on.

Auto Align Curve Starts (Disabled.)

Close Loft (Disabled.)

Insert (Disabled.)

Remove Removes a curve from the U loft surface. Select the curve in the list, and then click Remove.
This button is available at creation time.

Refine (Disabled.)

Replace (Disabled.)

Display While Creating When on, the U loft surface is displayed while you create it. When off, the loft is created more quickly. Default=off.
**Flip Normals** Reverses the direction of the U loft's normals.

**U Loft Surface rollout (modification time)**

**U Curves** This list shows the name of the curves you click, in the order you click them. You can select curves by clicking their names in this list. Viewports display the selected curve in blue. Initially the first curve is the one selected.
You can also select more than one curve at a time. This is useful when you use the Edit Curves button.

**Arrow Buttons** Use these to change the order of curves used to construct the U loft. Select a curve in the list, and then use the arrows to move the selection up or down.

These buttons are available at creation time.

**Curve Properties group**

These controls affect individual curves you select in the U Curves list, as opposed to properties of the loft surface in general. They are enabled only when you have selected a curve in the U Curves list.

**Reverse** When set, reverses the direction of the selected curve.

**Start Point** Adjusts the position of the curve's start point.

This control is disabled if the curve is not a closed curve.

While you're adjusting start points, a dotted blue line is displayed between them, to show the alignment. The surface is not displayed, so it doesn't slow down adjustment. When you release the mouse button, the surface reappears.

**Tension** Adjusts the tension of the loft where it intersects that curve.

**Use COS Tangents** If the curve is a curve on surface, turning on this toggle causes the U loft to use the tangency of the surface. This can help you blend a loft smoothly onto a surface. Default=off.

This toggle is disabled unless the curve is a point or CV curve on surface.

**Flip Tangents** Reverses the direction of the tangents for that curve.

This toggle is disabled unless the curve is a point or CV curve on surface and Use COS Tangents is on.

**Auto Align Curve Starts** When on, aligns the start points of all curves in the U loft. 3ds Max chooses the location of the start points. Using automatic alignment minimizes the amount of twisting in the loft surface. Default=off.

**Close Loft** If the loft was initially an open surface, turning on this toggle closes it by adding a new segment to connect the first curve and the last curve. Default=off.

**Insert** Adds a curve to the U loft surface. Click to turn on Insert, then click the curve. The curve is inserted before the selected curve. To insert a curve at the end, first highlight the "----End-----" marker in the list.
**Remove** Removes a curve from the U loft surface. Select the curve in the list, and then click Remove.

This button is available at creation time.

**Refine** Refines the U loft surface. Click to turn on Refine, then click a U-axis iso curve on the surface. (As you drag the mouse over the surface, the available curves are highlighted.) The curve you click is converted to a CV curve and inserted into the loft and the U Curves list. As when you refine a point curve, refining a U loft can change the curvature of the surface slightly. Once you've refined the surface by adding a U curve, you can use Edit Curve to change the curve.

**Replace** Replaces a U curve with a different curve. Select a U curve, click to turn on Replace, then click the new curve in a viewport. Available curves are highlighted as you drag the mouse.

This button is enabled only when you've selected a single curve in the U Curves list.

**Display Iso Curves** When set, the U loft's V-axis iso curves are displayed as well as the U-axis curves used to construct the loft. The V-axis curves are only for display. You can't use them for surface construction.

**Edit Curve** Lets you edit the currently selected curve without switching to another sub-object level. Click to turn on Edit Curve. The points or CVs of the curve are displayed, as well as the control lattice if the curve is a CV curve. You can now transform or otherwise change the points or CVs as if you were at the Point or Curve CV sub-object level. To finish editing the curve, click to turn off Edit Curve.

When you turn on Edit Curves, all applicable rollouts for the selected curves are displayed, including the Curve Common rollout, the CV or Point rollout (depending on the curve type), and the CV Curve or Point Curve rollout. These rollouts appear beneath the U Loft rollout. They let you edit the loft curves and their points or CVs without having to switch sub-object levels.

**TIP** When you edit curves in a U loft, turning off display of the U loft itself can make the curves easier to see and improve performance. Use Ctrl+D (while the Keyboard Shortcut Override Toggle button on page 8420 is on) to toggle display of dependent sub-objects, including U Lofts.
UV Loft Surface

Select NURBS object. > Modify panel > Create Surfaces rollout > Dependent Surfaces group box > UV Loft

Select NURBS object. > Modify panel > NURBS toolbox > Create UV Loft Surface button

A UV loft surface is similar to a U loft surface, but has a set of curves in the V dimension as well as in the U dimension. This can give you finer control over the lofted shape, and require fewer curves to achieve the result you want.

Using perpendicular curves to create a UV loft surface

If the U and V curves intersect, the UV loft surface interpolates all the curves. If the curves don't intersect, the lofted surface lies somewhere between the U and V curves. In general, UV loft works best if the ends of all the curves in one direction lie on the two end curves in the other direction, as in the illustration. UV loft does not work well if the curves in both directions are closed.
**NOTE** The Make Loft on page 2727 dialog (displayed by the Make Loft button on the Surface Common rollout for surface sub-objects) now lets you convert a surface to a UV loft as well as a U loft. In addition, you can use point curves instead of CV curves for the new loft lattice. If you use point curves for a UV loft, turning on the Fuse Points option guarantees that the U and V curves intersect.

**Automatic Curve Attachment**

When you create a UV loft, you can select curves that are not already sub-objects of the active NURBS model. You can select another curve or spline on page 577 object in the scene. When you select that curve, it attaches to the current object as if you had used the Attach button on page 2490.

**WARNING** If the curve you attach is a sub-object of another NURBS model, the entire model (that is, the curve’s parent NURBS object) is attached as well.

As you move the mouse over a curve that is not part of the active NURBS object, the cursor changes shape to indicate that you can pick the curve, but the curve is not highlighted in blue.

**Procedures**

**To create a UV loft:**

1. Create the curves that outline the surface you want to create.
2. Click to turn on UV Loft in the toolbox or on the Create Surfaces rollout.
3. Click each of the curves in the U dimension, then right-click. Click each of the curves in the V dimension, then right-click again to end creation. As you click curves, their names appear in the lists on the UV Loft Surface creation rollout. The order in which you click the curves can affect the shape of the UV loft surface. In either dimension, you can click the same curve more than once. This can help you create a closed UV loft.

**To create a UV loft with automatic attach (example):**

1. From the Create panel, create three or more independent CV or point NURBS curves.
2. Go to the Modify panel, and click to turn on UV Loft in the NURBS toolbox.
3 Select the curves in the appropriate order for the loft.

The UV loft is created. You don’t need to collapse the curves to a NURBS surface or Attach them to an existing NURBS model.

As you move the mouse over a curve that is not part of the active NURBS object, the cursor changes shape to indicate that you can pick the curve, but the curve is not highlighted in blue.

**Interface**

While a UV Loft sub-object is selected, a rollout with the UV loft parameters appears. This rollout appears only when one UV loft sub-object is selected. It isn’t possible to edit more than one UV loft at a time, so unlike some other NURBS sub-objects, the rollout doesn’t appear when multiple UV loft sub-objects are selected.

**TIP** When you edit a UV loft sub-object, close the Surface Common rollout to see the U Loft Surface rollout more easily.
UV Loft Surface rollout (creation time)

![UV Loft Surface rollout](image)

Creating and Editing NURBS Sub-Objects | 2659
U Curves and V Curves These lists show the names of the curves you click, in the order you click them. You can select a curve by clicking its name in a list. Viewports display the selected curve in blue.

The two buttons above and the four below each list are identical for both lists. While you create the loft, in either dimension you can click the same curve more than once. This can help you create a closed UV loft.

Arrow Buttons Use these to change the order of curves in the U Curve or V Curve list. Select a curve in the list, and then use the arrows to move the selection up or down.

Insert (Disabled.)

Remove Removes a curve from the U list or V list. Select the curve in the list, and then click Remove.

Refine (Disabled.)

Replace (Disabled.)

Display While Creating When on, the UV loft surface is displayed while you create it. When off, the loft can be created more quickly. Default=off.

Flip Normals Reverses the direction of the UV loft's normals.
UV Loft Surface rollout (modification time)

Creating and Editing NURBS Sub-Objects | 2661
**U Curves and V Curves** These lists show the names of the curves you click, in the order you click them. You can select a curve by clicking its name in a list. Viewports display the selected curve in blue.

The two buttons above and the four below each list are identical for both lists.

**Arrow Buttons** Use these to change the order of curves in the U Curve or V Curve list. Select a curve in the list, and then use the arrows to move the selection up or down.

**Insert** Adds a curve to the U list or V list. Click to turn on Insert, then click the curve. The curve is inserted *before* the selected curve. To insert a curve at the end, first highlight the "----End-----" marker in the list.

**Remove** Removes a curve from the U list or V list. Select the curve in the list, and then click Remove.

**Refine** Refines the UV loft surface. Click to turn on Refine, then click an iso curve on the surface. (As you drag the mouse over the surface, the available curves are highlighted.) The curve you click is converted to a CV curve and inserted into the loft and the U Curves or V Curves list. As when you refine a point curve, refining a UV loft can change the curvature of the surface slightly. Once you’ve refined the surface by adding a U curve or V curve, you can use Edit Curves to change the curve.

**Replace** Lets you replace the selected curve. Select a curve in the list, click this button, then select the new curve.

**Display Iso Curves** When set, the UV loft’s iso curves are displayed as well as the U-axis and V-axis curves used to construct the loft. The iso curves are only for display. You can’t use them for surface construction.

**Edit Curves** Lets you edit the currently selected curve without switching to another sub-object level. Click to turn on Edit Curve. The points or CVs of the curve are displayed, as well as the control lattice if the curve is a CV curve. You can now transform or otherwise change the points or CVs as if you were at the Point or Curve CV sub-object level. To finish editing the curve, click to turn off Edit Curves.

When you turn on Edit Curves, all applicable rollouts for the selected curves are displayed, including the Curve Common rollout, the CV or Point rollout (depending on the curve type), and the CV Curve or Point Curve rollout. These rollouts appear beneath the U Loft rollout. They let you edit the loft curves and their points or CVs without having to switch sub-object levels.
TIP When you edit curves in a UV loft, turning off display of the UV loft itself can make the curves easier to see and improve performance. Use Ctrl+D (while the Keyboard Shortcut Override Toggle button on page 8420 is on) to toggle display of dependent sub-objects, including UV lofts.

The UV loft surface can deviate from the curve if you edit a curve in a UV loft by increasing the weight of the curve CVs. You can work around this by refining the curve at the point where the surface deviates.

1-Rail Sweep Surface

Select NURBS object. > Modify panel > Create Surfaces rollout > Dependent Surfaces group box > 1-Rail

Select NURBS object. > Modify panel > NURBS toolbox > Create 1-Rail Sweep button

Sweep surfaces are constructed from curves. A 1-rail sweep surface uses at least two curves. One curve, the "rail," defines one edge of the surface. The other curves define the surface's cross sections.
1-rail sweep surface

Changing the position of the rail can change the shape of the surface.

The cross-section curves should intersect the rail curve. If the cross-sections don't intersect the rail, the resulting surface is unpredictable. In addition, the initial point of the rail and the initial point of the first cross-section curve must be coincident. Use NURBS Snaps on page 2819 to accomplish this.

Automatic Curve Attachment

When you create a 1-rail sweep, you can select curves that are not already sub-objects of the active NURBS model. You can select another curve or spline on page 577 object in the scene. When you select that curve, it attaches to the current object as if you had used the Attach button on page 2490.

WARNING If the curve you attach is a sub-object of another NURBS model, the entire model (that is, the curve's parent NURBS object) is attached as well.

As you move the mouse over a curve that is not part of the active NURBS object, the cursor changes shape to indicate that you can pick the curve, but the curve is not highlighted in blue.
Procedures

To create a 1-rail sweep:

1. Create the curves that define the surface you want to create.

2. Click to turn on 1 Rail Sweep in the toolbox or on the Create Surfaces rollout.

3. Click the curve to use as the rail, then click each of the cross-section curves. Right-click to end creation. The sweep is interpolated smoothly between the cross sections, following the outline defined by the rail.
As you click curves, their names appear in the lists on the 1 Rail Sweep Surface creation rollout. The order in which you click the curves can affect the shape of the sweep surface.
Example: To create a 1-rail sweep with automatic attach:

1 From the Create panel, create two independent CV or Point NURBS curves.

2 Go to the Modify panel, and click to turn on 1-Rail Sweep in the NURBS toolbox.

3 Select the curves in the appropriate order for the sweep.
   The sweep is created. You don’t need to collapse the curves to a NURBS surface or Attach them to an existing NURBS model.
   As you move the mouse over a curve that is not part of the active NURBS object, the cursor changes shape to indicate that you can pick the curve, but the curve is not highlighted in blue.

Interface

While a 1-rail sweep sub-object is selected, a rollout with the 1-rail sweep parameters appears. This rollout appears only when one 1-rail sweep sub-object is selected. It isn’t possible to edit more than one 1-rail sweep at a time, so unlike some other NURBS sub-objects, the rollout doesn’t appear when multiple 1-rail sweep sub-objects are selected.

TIP When you edit a 1-rail sweep sub-object, close the Surface Common rollout to see the 1-rail sweep Surface rollout more easily.
1-Rail Sweep Surface rollout (creation time)

Rail Curve Shows the name of the curve you chose to be the rail.

Replace Rail (Disabled.)
Section Curves  This list shows the names of the cross-section curves, in the order you click them. You can select a curve by clicking its name in the list. Viewports display the selected curve in blue.

Arrow Buttons  Use these to change the order of section curves in the list. Select a curve in the list, and then use the arrows to move the selection up or down.

Curve Properties group

These controls affect individual curves you select in the Section Curves list, as opposed to properties of the sweep surface in general. They are enabled only when you have selected a curve in the Section Curves list.

Reverse  When set, reverses the direction of the selected curve.

Start Point  Adjusts the position of the curve's start point. This can help eliminate unwanted twists or "buckles" in the surface.

This control is disabled if the curve is not a closed curve.

While you're adjusting start points, a dotted blue line is displayed between them, to show the alignment. The surface is not displayed, so it doesn't slow down adjustment. When you release the mouse button, the surface reappears.

Insert  (Disabled.)

Remove  Removes a curve from the list. Select the curve in the list, and then click Remove.

Refine  (Disabled.)

Replace  (Disabled.)

Sweep Parallel  When on, ensures that the sweep surface's normal is parallel to the rail.

Snap Cross-Sections  When on, cross-section curves are translated so they intersect the rail. The first cross section is translated to the start of the rail, and the last to the end of the rail. The cross sections in the middle are translated to touch the rail at the closest point to the end of the cross-section curves.

When Snap Cross-Sections is on, the sweep follows the rail curve exactly. This makes it easier to construct 1-rail sweep surfaces.

Road-Like  When on, the sweep uses a constant up-vector so the cross sections twist uniformly as they travel along the rail. In other words, the cross sections bank like a car following a road, or a camera following a path constraint on page 3596. Default=off.
When you edit the surface, you can control the angle of banking. The up-vector is displayed as a yellow gizmo (similar to the gizmo that lathe surfaces on page 2631 use for the center of rotation). To change the up-vector angle, use Rotate on page 915 to change the gizmo's angle.

**Display While Creating** When on, the sweep surface is displayed while you create it. When off, the sweep can be created more quickly. Default=off.

**Flip Normals** Reverses the direction of the sweep's normals.
**1-Rail Sweep Surface rollout (modification time)**

![1-Rail Sweep Surface rollout](image)

**Rail Curve** Shows the name of the curve you chose to be the rail.

Creating and Editing NURBS Sub-Objects | 2671
**Replace Rail** Lets you replace the rail curve. Click this button, then in a viewport click the curve to use as the new rail.

**Section Curves** This list shows the names of the cross-section curves, in the order you click them. You can select a curve by clicking its name in the list. Viewports display the selected curve in blue.

**Arrow Buttons** Use these to change the order of section curves in the list. Select a curve in the list, and then use the arrows to move the selection up or down.

**Curve Properties group**

These controls affect individual curves you select in the Section Curves list, as opposed to properties of the sweep surface in general. They are enabled only when you have selected a curve in the Section Curves list.

- **Reverse** When set, reverses the direction of the selected curve.
- **Start Point** Adjusts the position of the curve's start point. This can help eliminate unwanted twists or "buckles" in the surface.
  This control is disabled if the curve is not a closed curve.
  While you're adjusting start points, a dotted blue line is displayed between them, to show the alignment. The surface is not displayed, so it doesn't slow down adjustment. When you release the mouse button, the surface reappears.

- **Insert** Adds a curve to the section list. Click to turn on Insert, then click the curve. The curve is inserted before the selected curve. To insert a curve at the end, first highlight the "----End-----" marker in the list.

- **Remove** Removes a curve from the list. Select the curve in the list, and then click Remove.

- **Refine** Refines the 1-rail sweep surface. Click to turn on Refine, then click an iso curve on the surface. (As you drag the mouse over the surface, the available section curves are highlighted.) The curve you click is converted to a CV curve and inserted into the sweep and the section list. As when you refine a point curve, refining a sweep can change the curvature of the surface slightly. Once you've refined the surface by adding a cross-section curve, you can use Edit Curves to change the curve.

- **Replace** Lets you replace the selected curve. Select a curve in the list, click this button, and then select the new curve.

- **Sweep Parallel** When on, ensures that the sweep surface's normal is parallel to the rail.
**Snap Cross-Sections** When on, cross-section curves are translated so they intersect the rail. The first cross section is translated to the start of the rail, and the last to the end of the rail. The cross sections in the middle are translated to touch the rail at the closest point to the end of the cross-section curves.

When Snap Cross-Sections is on, the sweep follows the rail curve exactly. This makes it easier to construct 1-rail sweep surfaces.

**Road-Like** When on, the sweep uses a constant up-vector so the cross sections twist uniformly as they travel along the rail. In other words, the cross sections bank like a car following a road, or a camera following a path constraint on page 3596. Default=off.

When you edit the surface, you can control the angle of banking. The up-vector is displayed as a yellow gizmo (similar to the gizmo that lathe surfaces on page 2631 use for the center of rotation). To change the up-vector angle, use Rotate on page 915 to change the gizmo's angle.

**Display Iso Curves** When set, the 1-rail sweep's V-axis iso curves are displayed as well as the U-axis curves used to construct the loft. The V-axis curves are only for display. You can’t use them for surface construction.

**Edit Curves** Lets you edit the currently selected curve without switching to another sub-object level. Click to turn on Edit Curve. The points or CVs of the curve are displayed, as well as the control lattice if the curve is a CV curve. You can now transform or otherwise change the points or CVs as if you were at the Point or Curve CV sub-object level. To finish editing the curve, click to turn off Edit Curves.

**TIP** When you edit curves in a 1-rail sweep, turning off display of the sweep itself can make the curves easier to see and improve performance. Use Ctrl+D (while the Keyboard Shortcut Override Toggle on page 8420 is on) to toggle display of dependent sub-objects, including sweeps.

The sweep surface can deviate from the curve if you edit a curve in a sweep by increasing the weight of the curve CVs. You can work around this by refining the curve at the point where the surface deviates.

### 2-Rail Sweep Surface

Select NURBS object. > Modify panel > Create Surfaces rollout > Dependent Surfaces group box > 2-Rail
Select NURBS object. > Modify panel > NURBS toolbox > Create 2-Rail Sweep button

Sweep surfaces are constructed from curves. A 2-rail sweep surface uses at least three curves. Two curves, the "rails," define the two edges of the surface. The other curves define the surface's cross sections. A 2-rail sweep surface is similar to a 1-rail sweep. The additional rail gives you more control over the shape of the surface.

The cross-section curves should intersect the rail curves. If the cross sections don't intersect the rails, the resulting surface is unpredictable. In addition, the initial points of the rails and the endpoints of the first cross-section curve must be coincident. Use NURBS Snaps to accomplish this.

**Automatic Curve Attachment**

When you create a 2-rail sweep, you can select curves that are not already sub-objects of the active NURBS model. You can select another curve or spline object on page 577 in the scene. When you select that curve, it attaches to the current object as if you had used the Attach button on page 2490.
WARNING If the curve you attach is a sub-object of another NURBS model, the entire model (that is, the curve’s parent NURBS object) is attached as well.

As you move the mouse over a curve that is not part of the active NURBS object, the cursor changes shape to indicate that you can pick the curve, but the curve is not highlighted in blue.

Procedures

To create a 2-rail sweep:

1  Create the curves that define the surface you want to create.

2  Click to turn on 2 Rail Sweep in the toolbox or on the Create Surfaces rollout.

3  Click the curve to use as the first rail, then click the curve to use as the second rail. Click each of the cross-section curves, and then right-click to end creation.

   The sweep is interpolated smoothly between the cross sections, following the outlines defined by the two rails.

   As you click curves, their names appear in the lists on the 2 Rail Sweep Surface creation rollout. The order in which you click the curves can affect the shape of the sweep surface.

Example: To create a 2-rail sweep with automatic attach:

1  From the Create panel, create three independent CV or Point NURBS curves.

2  Go to the Modify panel, and click to turn on 2-Rail Sweep in the NURBS toolbox.

3  Select the curves in the appropriate order for the sweep.

   The sweep is created. You don’t need to collapse the curves to a NURBS surface or Attach them to an existing NURBS model.

   As you move the mouse over a curve that is not part of the active NURBS object, the cursor changes shape to indicate that you can pick the curve, but the curve is not highlighted in blue.
Interface

While a 2-rail sweep sub-object is selected, a rollout with the 2-rail sweep parameters appears. This rollout appears only and when one 2-rail sweep sub-object is selected. It isn’t possible to edit more than one 2-rail sweep at a time, so unlike some other NURBS sub-objects, the rollout doesn’t appear when multiple 2-rail sweep sub-objects are selected.

**TIP** When you edit a 2-rail sweep sub-object, close the Surface Common rollout to see the 2-rail sweep surface rollout more easily.
2-Rail Sweep Surface rollout (creation time)

Rail Curves
- Shows the names of the two curves you chose to be the rails.

Rail Curves
- Point Curve 01
- Point Curve 02

Section Curves:
- Point Curve 03
- End

Curve Properties
- Reverse
- Start Point: 0.0

Buttons:
- Insert
- Remove
- Refine
- Replace

Options:
- Sweep Parallel
- Sweep Scale
- Snap Cross-Sections
- Display While Creating
- Flip Normals
Section Curves This list shows the names of the cross-section curves, in the order you click them. You can select a curve by clicking its name in the list. Viewports display the selected curve in blue.

Arrow Buttons Use these to change the order of section curves in the list. Select a curve in the list, and then use the arrows to move the selection up or down.

Curve Properties group

These controls affect individual curves you select in the Section Curves list, as opposed to properties of the sweep surface in general. They are enabled only when you have selected a curve in the Section Curves list.

Reverse When set, reverses the direction of the selected curve.

Start Point Adjusts the position of the curve's start point. This can help eliminate unwanted twists or 'buckles' in the surface.

This control is disabled if the curve is not a closed curve.

While you're adjusting start points, a dotted blue line is displayed between them, to show the alignment. The surface is not displayed, so it doesn't slow down adjustment. When you release the mouse button, the surface reappears.

Insert (Disabled.)

Remove Removes a curve from the list. Select the curve in the list, and then click Remove.

Refine (Disabled.)

Replace (Disabled.)

Sweep Parallel When off, the rail curves define a ruled surface, and the cross sections describe lofting from this base ruled surface. When on, each cross section is associated with its best fitting plane. This plane moves along the rails and parallel to them. If the rails are curved, the plane can rotate. If the spacing between the rails changes, the section scales or stretches. In either case, the surface is blended from section to section along its entire length. Default=off.

Sweep Scale When off, the size of the plane is scaled only in the direction across the rails. When on, the plane is scaled uniformly in all directions. Default=off.

Snap Cross-Sections When on, cross-section curves are translated and scaled so they intersect both rails. The first cross section is translated to the start of the rails, and the last to the end of the rails. The cross sections in the middle
are translated to touch the rails at the closest point to the ends of the cross-section curves. Default=off.
When Snap Cross-Sections is on, the sweep follows the rail curves exactly. This makes it easier to construct 2-rail sweep surfaces.

**Display While Creating** When on, the sweep surface is displayed while you create it. When off, the sweep can be created more quickly. Default=off.

**Flip Normals** Reverses the direction of the sweep's normals.
2-Rail Sweep Surface rollout (Modification time)

![2-Rail Sweep Surface rollout](image)
Rail Curves Shows the names of the two curves you chose to be the rails.

Replace Rail 1 and Replace Rail 2 Let you replace the rail curves. Click one of these buttons, then in a viewport click the curve to use as the new rail.

Section Curves This list shows the names of the cross-section curves, in the order you click them. You can select a curve by clicking its name in the list. Viewports display the selected curve in blue.

Arrow Buttons Use these to change the order of section curves in the list. Select a curve in the list, and then use the arrows to move the selection up or down.

Curve Properties group

These controls affect individual curves you select in the Section Curves list, as opposed to properties of the sweep surface in general. They are enabled only when you have selected a curve in the Section Curves list.

Reverse When set, reverses the direction of the selected curve.

Start Point Adjusts the position of the curve's start point. This can help eliminate unwanted twists or "buckles" in the surface. This control is disabled if the curve is not a closed curve.

While you're adjusting start points, a dotted blue line is displayed between them, to show the alignment. The surface is not displayed, so it doesn't slow down adjustment. When you release the mouse button, the surface reappears.

Insert Adds a curve to the section list. Click to turn on Insert, then click the curve. The curve is inserted before the selected curve. To insert a curve at the end, first highlight the "----End-----" marker in the list.

Remove Removes a curve from the list. Select the curve in the list, and then click Remove.

Refine Refines the 2-rail sweep surface. Click to turn on Refine, then click an iso curve on the surface. (As you drag the mouse over the surface, the available section curves are highlighted.) The curve you click is converted to a CV curve and inserted into the sweep and the section list. As when you refine a point curve, refining a sweep can change the curvature of the surface slightly. Once you've refined the surface by adding a cross-section curve, you can use Edit Curves to change the curve.

Replace Lets you replace the selected curve. Select a curve in the list, click this button, then select the new curve.
Sweep Parallel  When off, the rail curves define a ruled surface, and the cross sections describe lofting from this base ruled surface. When on, each cross section is associated with its best fitting plane. This plane moves along the rails and parallel to them. If the rails are curved, the plane can rotate. If the spacing between the rails changes, the section scales or stretches. In either case, the surface is blended from section to section along its entire length. Default=off.

Sweep Scale  When off, the size of the plane is scaled only in the direction across the rails. When on, the plane is scaled uniformly in all directions. Default=off.

Snap Cross-Sections  When on, cross-section curves are translated and scaled so they intersect both rails. The first cross section is translated to the start of the rails, and the last to the end of the rails. The cross sections in the middle are translated to touch the rails at the closest point to the ends of the cross-section curves. Default=off.

When Snap Cross-Sections is on, the sweep follows the rail curves exactly. This makes it easier to construct 2-rail sweep surfaces.

Display Iso Curves  When set, the 2-Rail Sweep's V-axis iso curves are displayed as well as the U-axis curves used to construct the sweep. The V-axis curves are only for display. You can’t use them for surface construction.

Edit Curves  Lets you edit the currently selected curve without switching to another sub-object level. Click to turn on Edit Curve. The points or CVs of the curve are displayed, as well as the control lattice if the curve is a CV curve. You can now transform or otherwise change the points or CVs as if you were at the Point or Curve CV sub-object level. To finish editing the curve, click to turn off Edit Curves.

TIP  When you edit curves in a 2-rail sweep, turning off display of the sweep itself can make the curves easier to see and improve performance as well. Use Ctrl+D (while the Keyboard Shortcut Override Toggle on page 8420 is on) to toggle display of dependent sub-objects, including sweeps.

The sweep surface can deviate from the curve if you edit a curve in a sweep by increasing the weight of the curve CVs. You can work around this by refining the curve at the point where the surface deviates.
Multisided Blend Surface

Select NURBS object. > Modify panel > Create Surfaces rollout > Dependent Surfaces group box > N Blend

Select NURBS object. > Modify panel > NURBS toolbox > Create a Multisided Blend Surface button

A multisided blend surface "fills in" the edges defined by three or four other curve or surface sub-objects. Unlike a regular, two-sided blend surface, the curves’ or surfaces’ edges must form a closed loop; that is, they must completely surround the opening that the multisided blend will cover.

Multisided blend between three other surfaces

TIP If the multisided blend surface can't be created, fuse the points or CVs at the corners where the surfaces meet. Sometimes snapping the corners doesn't work, because of round-off error.
Procedures

To create a multisided blend:

1. Click to turn on Multisided Blend in the toolbox or N Blend on the Create Surfaces rollout.

2. In turn, click the three or four surface sides or curves that surround the opening.

3. Right-click to end creation.

A new surface is created. It covers the opening.

You can flip normals on the multisided blend while creating it.

Interface

Multisided Blend surfaces have no parameters other than those on the Surface Common rollout on page 2530.

Multicurve Trimmed Surface

Select NURBS object. > Modify panel > Create Surfaces rollout > Dependent Surfaces group box > Multi-Trim
Select NURBS object. > Modify panel > NURBS toolbox > Create a Multicurve Trimmed Surface button
A multicurve trimmed surface is an existing surface trimmed by multiple curves that form a loop.
Creating a multicurve trimmed surface

When you create a multicurve trimmed surface, you create only one trimmed hole. If you want to create multiple holes, first create holes in the surface using other techniques, and as the final step create the multicurve trim.

You can't trim across the edge between two surfaces, or across a "seam" where a surface touches itself, as at the back of a spherical surface created by converting a Sphere primitive.

Procedures

To create a multicurve trim:

1. Create a loop out of multiple curve sub-objects.
2. At the Curve CV or Point sub-object level, use Fuse to connect the ends of the curves.
   The curves must form a single closed loop, or completely traverse the surface.
3. Project the curves onto the surface by creating a normal or vector projected curve for each curve in the loop.
4 Turn on Multicurve Trimmed Surface in the toolbox or Multi-Trim on the Create Surfaces rollout.

5 Click the surface to trim, then click each of the curves in the loop. Right-click to end creation.

The Trim list shows the names of the curves you select. Flip Trim inverts the direction of trimming. Flip Normals lets you flip the surface normals at creation time. (After you have created the surface, you can flip normals using controls on the Surface Common rollout.)

**Interface**

While a multicurve trimmed sub-object is selected, a rollout with the multicurve trim parameters appears. This rollout appears only when one multicurve trimmed sub-object is selected. It isn’t possible to edit more than one multicurve trimmed object at a time, so unlike some other NURBS sub-objects, the rollout doesn’t appear when multiple multicurve trimmed sub-objects are selected.

**TIP** When you edit a multicurve trimmed sub-object, close the Surface Common rollout to see the Multicurve Trim Surface rollout more easily.
**Multicurve Trimmed Surface rollout (creation time)**

**Trim Curves** This list shows the names of the curves used to trim the surface. You can select a curve by clicking its name. Viewports display the selected curve in blue.

**Insert** (Disabled.)

**Remove** Removes a curve from the list. Select the curve in the list, and then click Remove.

**Replace** (Disabled.)

**Flip Trim** Reverses the direction of the trim.

**Flip Normals** Turn on to reverse the direction of the trimmed surface's normals.
Multicurve Trimmed Surface rollout (modification time)

**Trim Curves** This list shows the names of the curves used to trim the surface. You can select a curve by clicking its name. Viewports display the selected curve in blue.

**Insert** Adds a curve to the Trim Curves list. Click to turn on Insert, then click the curve. The curve is inserted before the selected curve. To insert a curve at the end, first highlight the "----End-----" marker in the list.

**Remove** Removes a curve from the list. Select the curve in the list, and then click Remove.

**Edit Curves** Lets you edit the currently selected curve without switching to another sub-object level. Click to turn on Edit Curve. The points or CVs of the curve are displayed, as well as the control lattice if the curve is a CV curve. You can now transform or otherwise change the points or CVs as if you were at the Point or Curve CV sub-object level. To finish editing the curve, click to turn off Edit Curves.

Don’t edit the curve so you break the loop. If you do, the surface goes into an error condition.
**Replace** Lets you replace the selected curve. Select a curve in the list, click this button, and then select the new curve.

**Flip Trim** Reverses the direction of the trim. Along with Edit Curves, the Insert, Remove, and Replace buttons let you alter the curves that trim the surface. While you are making changes, the surface will go into an error condition (orange display by default) until the curves you are working on once again form a closed loop.

**Fillet Surface**

Select NURBS object. > Modify panel > Create Surfaces rollout > Dependent Surfaces group box > Fillet Surf

Select NURBS object. > Modify panel > NURBS toolbox > Create Fillet Surface button

A fillet surface is a rounded corner connecting the edges of two other surfaces.

_Fillet surface created from two parent surfaces_
Usually you use both edges of the fillet surface to trim the parent surfaces, creating a transition between the fillet and its parents.

**Procedures**

To create a fillet surface:

1. In a NURBS object, turn on Fillet on the Create Surfaces rollout or Create Fillet Surface in the toolbox.
2. Click to choose the first parent surface, then click to choose the second parent surface. Potential parent surfaces are highlighted in blue as you move the mouse in a viewport.
   
The fillet surface is created. If the fillet surface can't be created, a default error surface is displayed (by default, the error surface displays as orange).
Interface

Fillet Surface rollout (creation time)

Start Radius and End Radius Set the radius used to define the fillet at the first surface you chose and the second surface you chose, respectively. The radiuses control the size of the fillet surface. Default=1.0.

Lock Locks the Start and End radius values so they are identical. When on, the End Radius setting is unavailable. Default=on.
**Radius Interpolation group**

This group box controls the radius of the fillet. The Radius Interpolation setting has no effect unless one or both surfaces that define the fillet have curvature to them.

**Linear** When chosen (the default), the radius is linear.

**Cubic** When chosen, the radius is treated as a cubic function, allowing it to change based on the parent surface's geometry.

**Seeds group**

These spinners adjust the seed values for the fillet surface. If there is more than one way to construct the fillet, 3ds Max uses the seed values to choose the nearest edge for that surface.

**Surface 1 X** Sets the local X coordinate of the seed on the first surface you chose.

**Surface 1 Y** Sets the local Y coordinate of the seed on the first surface you chose.

**Surface 2 X** Sets the local X coordinate of the seed on the second surface you chose.

**Surface 2 Y** Sets the local Y coordinate of the seed on the second surface you chose.

**Trim First Surface and Trim Second Surface groups**

For each of the parent surfaces, these controls affect trimming.

**Trim Surface** Trims the parent surface at the edge of the fillet.

**Flip Trim** Reverses the direction of the trim.

**Flip Normals** Turn on to reverse the direction of the fillet surface's normals.
Fillet Surface rollout (modification time)

Start Radius and End Radius Set the radius used to define the fillet at the first surface you chose and the second surface you chose, respectively. The radiiuses control the size of the fillet surface. Default=10.0.

Lock Locks the Start and End radius values so they are identical. When on, the End Radius setting is unavailable. Default=on.
**Radius Interpolation group**

This group box controls the radius of the fillet. The Radius Interpolation setting has no effect unless one or both surfaces that define the fillet have curvature to them.

**Linear** When chosen (the default), the radius is always linear.

**Cubic** When chosen, the radius is treated as a cubic function, allowing it to change based on the parent surface's geometry.

**Seeds group**

These spinners adjust the seed values for the fillet surface. If there is more than one way to construct the fillet, 3ds Max uses the seed values to choose the nearest edge for that surface.

**Surface 1 X** Sets the local X coordinate of the seed on the first surface you chose.

**Surface 1 Y** Sets the local Y coordinate of the seed on the first surface you chose.

**Surface 2 X** Sets the local X coordinate of the seed on the second surface you chose.

**Surface 2 Y** Sets the local Y coordinate of the seed on the second surface you chose.

**Trim First Surface and Trim Second Surface groups**

For each of the parent surfaces, these controls affect trimming.

**Trim Surface** Trims the parent surface at the edge of the fillet.

**Flip Trim** Reverses the direction of the trim.

**Replace First Surface and Replace Second Surface** Let you replace the parent surfaces. Click a button, then click the surface to replace the original first or second surface.

**Creating and Editing Point Sub-Objects**

Select NURBS object. > Modify panel > Create Points rollout

Select NURBS object. > Modify panel > NURBS toolbox
Keyboard > Ctrl+T to toggle NURBS toolbox display (Keyboard Shortcut Override Toggle must be on.)

In addition to the points that are an integral part of point curve on page 2466 and point surface on page 2456 objects, you can create "freestanding" points. Such points can help you construct point curves by using the Curve Fit on page 2558 button. You also use dependent points to trim curves.

You create individual points as NURBS sub-objects while you are modifying NURBS. To create points individually, use the Create Points rollout or the NURBS toolbox on page 2426.

**Toolbox Buttons for Creating Points**

These are the toolbox buttons for creating point sub-objects:

- Create an independent point on page 2695.
- Create a dependent offset point on page 2696.
- Create a dependent curve point on page 2698.
- Create a dependent curve-curve intersection point on page 2704.
- Create a dependent surface point on page 2701.
- Create a dependent surface-curve intersection point on page 2707.

**Point (NURBS)**

Select NURBS object. > Modify panel > Create Points rollout > Point button
Select NURBS object. > Modify panel > NURBS toolbox > Create Point button
This command creates an independent, freestanding point.
Procedures

To create a freestanding point:

1. Select a NURBS object.
2. In the Modify > Create Points rollout, turn on Point.
3. Click a viewport to position the point.

Independent point sub-objects have no additional parameters. You can use Curve Fit in the Create Curves rollout to create a curve from multiple freestanding points.

Interface

There are no additional controls for independent points.

Offset Point

Select NURBS object. > Modify panel > Create Points rollout > Dependent Points group box > Offset Point button
Select NURBS object. > Modify panel > NURBS toolbox > Create Offset Point button

This command creates a dependent point that is coincident to an existing point or at a relative distance from an existing point.

Procedures

To create a dependent offset point:

1. Select a NURBS object
2. On the Modify > Create Points rollout, turn on Offset Point.
3. In a viewport, click an existing point.
4. In the Modify > Offset Points rollout, use the Offset spinners to adjust the point’s position relative to the original point.
Interface

While an offset point sub-object is selected, the Offset Point rollout appears.

**At Point** When chosen, the dependent point has the same location as the original, parent point.

**Offset** Enables point offset. Use the X,Y,Z Offset spinners to set offset values (in object space coordinates).

**Replace Base Point** (Only at modification time.) Lets you replace the parent point. Click the button, then click the new point on which to base the offset point.
Curve Point

Select NURBS object. > Modify panel > Create Points rollout > Dependent Points group box > Curve Point button

Select NURBS object. > Modify panel > NURBS toolbox > Create Curve Point button

This command creates a dependent point that lies on a curve or relative to it. The point can be either on the curve or off the curve. If it is on the curve, the U Position is the only control of its location. The U Position specifies a location along the curve (based on the curve’s local U axis). There are three ways to displace the point’s location relative to the U position.

Procedures

To create a dependent curve point:

1. Turn on Curve Point and then click along a curve to position the point.
2. The curve and cursor position are highlighted during this operation.
3. At the Point sub-object level, adjust the point’s position relative to the curve by adjusting the curve point parameters on the Curve Point rollout.
4 Right-click to end operation.

**Interface**

While a curve point sub-object is selected, the Curve Point rollout appears.
**U Position** Specifies the point's location on the curve or relative to the curve.

**On Curve** When on, the point lies on the curve at the U Position.

**Offset** Moves the point according to a relative (object space) X,Y,Z location. This is relative to the U Position.

**X Offset, Y Offset, and Z Offset** Specify the object space location of the offset curve point.

**Normal** Moves the point along the direction of the curve's normal at the U Position.

**Distance** Specifies the distance along the curve's normal. Negative values move the point opposite to the normal.
**Tangent** Moves the point along the tangent at the U Position.

**U Tangent** Specifies the distance from the curve along the tangent.

---

**Trimming group box**

Controls in this group box let you trim the parent curve.

**Trim Curve** When on, trims the parent curve against the curve point's U position. When off (the default), the parent isn't trimmed.

**Flip Trim** When on, trims in the opposite direction.

**Replace Base Curve** (Only at modification time.) Lets you replace the parent curve. Click the button, then click the new curve on which to base the curve point.

---

**Surface Point**

Select NURBS object. > Modify panel > Create Points rollout > Dependent Points group box > Surface Point button

Select NURBS object. > Modify panel > NURBS toolbox > Create Surf Point button

This command creates a dependent point that lies on a surface or relative to it. This is enabled with a NURBS object that contains a surface.
Procedures

To create a dependent surface point:

1. Turn on Surf Point and then click over a NURBS surface to position the point.
2. The surface cross-section and cursor are highlighted during this operation.
3. Right-click to end the create operation.
4. At the Point sub-object level, adjust the point’s position relative to the surface by adjusting the surface point parameters in the Surface Point rollout.

Interface

While a surface point sub-object is selected, the Surface Point rollout appears. These controls are similar to the curve point controls.
U Position and V Position If the point is on the surface, these coordinates specify the point's location, based on the surface's local UV coordinates.

On Surface Specifies that the point lies on the surface, at the location specified by U Position and V Position.

If the point lies on the surface, you can move it using the Move transform. You can also move it using the Move Surface Point button. See Editing Point Sub-Objects on page 2496. Either way, this updates the U Position and V Position values.

Offset Moves the point according to a relative (object space) X,Y,Z location.

X Offset, Y Offset, and Z Offset Specify the object space location of the offset surface point.

Normal Moves the point along the direction of the surface's normal.
**Distance** Specifies the distance from the surface, along the normal. Negative values move the point opposite to the normal.

**Tangent** Moves the point along the tangent of the UV position.

**U Tangent and V Tangent** Specify the distance from the surface along the tangents at U and V.

**Replace Base Surface** (Only at modification time.) Lets you replace the parent surface. Click the button, then click the new surface on which to base the surface point.

---

**Curve-Curve Intersection Point**

Select NURBS object. > Modify panel > Create Points rollout Dependent Points group box > Curve-Curve button

Select NURBS object. > Modify panel > NURBS toolbox > Create Curve-Curve Point button

This command creates a dependent point at the intersection of two curves.

**Procedures**

**To create a dependent curve-curve point:**

1. Turn on Curve-Curve, then drag from the first curve to the second.

   If the curves do not intersect, the point is orange, an invalid dependent point.

   The point is created at the nearest intersection between the two curves. You can use the curve-curve parameters to trim the parent curves.

2. Right-click to end the create operation.
Interface

While a curve-curve point sub-object is selected, the Curve-Curve Intersection rollout appears.
Trim First Curve and Trim Second Curve groups

These two groups let you control how the parent curves are trimmed. The controls are the same in each. "First" and "second" refer to the order in which you picked the parent curves.

Trim Curve When on, the parent curve is trimmed against the curve-curve point. When off (the default), the parent isn't trimmed.

Flip Trim When on, trims in the opposite direction.

Seed 1 and Seed 2 Change the U location of the seed value on the first and second curves. If there is a choice of intersections, the intersection closest to the seed points is the one used to create the point.

Replace First Curve and Replace Second Curve (Only at modification time.) Let you replace the parent curves. Click a button, then click the curve to replace the original first or second curve.
Surface-Curve Intersection Point

Select NURBS object. > Modify panel > Create Points rollout > Dependent Points group box > Surf-Curve button

Select NURBS object. > Modify panel > NURBS toolbox > Create Surface-Curve Point button

This command creates a dependent point at the intersection of a surface and a curve.

Procedures

To create a dependent surface-curve point:

1. In a NURBS object that has a curve that passes through a surface, click to turn on Create Surface Curve Point in the NURBS toolbox or Surf-Curve on the Create Points rollout.

2. Click the curve, then click the surface.

The point is created at the intersection between the curve and the surface that is nearest the seed point. You can use the surface-curve parameters to trim the parent curve.

Interface

While a surface-curve intersection point sub-object is selected, a rollout with its parameters appears.
Trim Curve group

Trim When on, trims the curve from the surface. When off, the curve isn’t trimmed.

Flip Trim When on, trims the curve in the opposite direction.

Seed Changes the U location of the seed value on the curve. If there is a choice of intersections, the intersection closest to the seed point is the one used to create the point.

Replace Curve and Replace Surface (Only at modification time.) Let you replace the parent sub-objects. Click a button, then click a curve or surface to replace the original parent object.

NURBS Editing Dialogs

This section describes dialogs that support creating and editing NURBS models.

Convert Curve Dialog (NURBS)

Modify panel > Select NURBS curve sub-object. > Curve Common rollout > Convert Curve button

This dialog is a general way to convert one kind of a curve to another or to adjust a curve’s parameters.
Interface

Point Curve and CV Curve Choose whether to convert to a point curve or a CV curve. If the curve is already of the type you chose, the settings in this dialog don’t convert it, but do change its properties. Default=CV Curve.

CV Curve options

These are the options when you choose CV Curve.

Number When chosen, the spinner sets the number of CVs in the CV curve.

Tolerance When chosen, 3ds Max calculates the number of CVs. This option rebuilds the curve according to accuracy. The lower the Tolerance value, the more accurate the rebuild. Increasing Tolerance enables the curve to be rebuilt using fewer CVs.

Reparameterization group

These controls let you reparameterize the CV curve and turn on automatic reparameterization.

Chord Length Chooses the chord-length algorithm for reparameterization.
Chord-length reparameterization spaces knots (in parameter space on page 8674) based on the square root of the length of each curve segment. Chord-length reparameterization is usually the best choice.

**Uniform** Spacing the knots uniformly.

A uniform knot vector has the advantage that the curve changes only locally when you edit it. With chord-length parameterization, moving any CV can potentially change the entire sub-object.

**Maintain Parameterization** When on, the curve is automatically reparameterized as you edit it, using the currently active method of reparameterization. When off, no reparameterization happens unless you use a dialog to specifically request it. Default=on.

**Point Curve options:**

These are the options when you choose Point Curve.

**Number** Sets the number of points in the point curve.

**Tolerance** When chosen, 3ds Max calculates the number of points. This option rebuilds the curve according to accuracy. The lower the Tolerance value, the more accurate the rebuild. Increasing Tolerance enables the curve to be rebuilt using fewer points.

**Preview** When on, the effect of the conversion is previewed in viewports. Default=on.

---

**Convert Curve On Surface Dialog (NURBS)**

Modify panel > Select NURBS object. > Stack display > Curve sub-object level > Select curve sub-object. > Curve Common rollout > Make COS button

This dialog converts a curve to a point curve on surface on page 2597 or CV curve on surface on page 2593.

The Make COS button that displays it is enabled only for the following types of curves:

- **U iso curves** on page 2584
- **V iso curves** on page 2584
- **Normal projected curves** on page 2586
- **Vector projected curves** on page 2589
If the curve is already a curve on surface, this dialog lets you change its type.

Interface

**Convert Curve On Surface**

- **CV Curve On Surface** Converts the curve to a CV curve on surface.
- **Point Curve On Surface** Converts the curve to a point curve on surface.

**Number of CVs/Points** Specifies the number of CVs/points in the new curve.

**Preview** When on, previews the effect of the conversion in viewports. Default=on.

**Convert Surface Dialog (NURBS)**

Modify panel > Select NURBS surface sub-object. > Surface Common rollout > Convert Surface button
This dialog provides a general way to convert one kind of a surface to another or to adjust a surface's parameters.

**Interface**

![Convert Surface dialog]

**Loft tab**

If the surface isn't already a loft, this tab converts it to the kind of loft you indicate.

The controls are comparable to those in the [Make Loft dialog](#) on page 2727.

**From U Iso Lines** Uses curves along the surface's U dimension to construct a U loft.

**From V Iso Lines** Uses curves along the surface's V dimension to construct a U loft. If the surface was already a U loft, set this to change the lofting dimension.

**From U and V Iso Lines** Uses curves from both the U and V dimensions to construct a UV loft.
U Curves Sets the number of curves in U.

V Curves Sets the number of curves in V.

Use Point Curves When on, constructs the loft from point curves instead of the default CV curves. Default=off.

Extra Points per Segment This control is available only for UV lofts (From U and V Iso Lines). Lets you increase the number of points in each segment.

Fuse Points This control is available only for UV lofts (From U and V Iso Lines). When on, fuses points at curve intersections to ensure that the U and V curves continue to intersect when you edit the surface, and that the surface remains coincident with its parent curves. UV lofts constructed from intersecting curves behave more predictably. Default=on.

Fit Point tab
If the surface isn't already a point surface, this tab converts it to a point surface.

In U Sets the number of point rows (in the surface’s U axis).

In V Sets the number of point columns (in the surface’s V axis).

Tolerance When chosen, 3ds Max calculates the number of points. This option rebuilds the surface according to accuracy. The lower the Tolerance value, the more accurate the rebuild. Increasing Tolerance enables the surface to be rebuilt using fewer points.

CV Surface tab
If the surface isn't already a CV surface, this tab converts it to a CV surface. This tab is the default.

Number When chosen, the spinners set the number of CVs in the CV surface.

In U Sets the number of CV rows (in the surface’s U axis).

In V Sets the number of CV columns (in the surface’s V axis).

Tolerance When chosen, 3ds Max calculates the number of CVs. This option rebuilds the surface according to accuracy. The lower the Tolerance value, the more accurate the rebuild. Increasing Tolerance enables the surface to be rebuilt using fewer CVs.
Reparameterization group

These controls let you reparameterize the CV surface and turn on automatic reparameterization.

Chord Length Chooses the chord-length algorithm for reparameterization. Chord-length reparameterization spaces knots (in parameter space on page 8674) based on the square root of the length of each segment. Chord-length reparameterization is usually the best choice.

Uniform Spaces the knots uniformly. A uniform knot vector has the advantage that the surface changes only locally when you edit it. With chord-length parameterization, moving any CV can potentially change the entire surface.

Maintain Parameterization When on, the surface is automatically reparameterized as you edit it, using the currently active method of reparameterization. When off, no reparameterization happens unless you use a dialog to specifically request it. Default=on.

Preview When on, viewports display a preview of the conversion. Turning off this toggle can speed up conversion, especially to lofts.

Delete Original Curves This is available only if the surface was already a U loft or UV loft. When on, Convert Surface deletes the original loft curves when you click OK. When off, the original curves remain where they are. Default=off.

CV Curve: Close Curve Dialog (NURBS)

Create panel > Shapes button > CV Curve button > In viewports, draw a CV curve and click to create a CV in the same location as the first CV in the curve.

Modify panel > Select NURBS object. > NURBS toolbox > Create CV Curve > In viewports, draw a CV curve sub-object and click to create a CV in the same location as the first CV in the curve.

This dialog lets you create a closed CV curve when you click to create a CV in the same location as the curve’s first CV.
Interface

Yes Closes the curve and ends curve creation.

No Keeps the curve open and does not end curve creation.

Detach Dialog (NURBS)

Modify panel > Select a NURBS sub-object. > Curve Common or Surface Common rollout > (optional) Copy toggle > Detach button

This dialog appears when you use Detach to create a new top-level NURBS curve or surface sub-object.

Interface

Detach as Lets you assign a name to the new object. By default, the name is "Curve" or "Surface" followed by a sequence number.

This option is unavailable when Detach To Element is on.
Relational  This toggle affects dependent objects. When off, detaching a dependent sub-object makes it an independent object. For example, detaching a U loft converts it to a CV surface. When on, detaching a dependent sub-object also detaches the objects on which it depends, so the object remains dependent. For example, detaching a U loft also detaches the curves that define it. Default=on.

Edit Curve On Surface Dialog (NURBS)

Select NURBS object. > Modify panel > Stack display > Curve sub-object level > Select NURBS curve on surface sub-object. > CV Curve On Surface or Point Curve On Surface rollout > Edit button

This dialog lets you edit curves on surfaces as you edit regular curves in a viewport. The main part of the dialog is a two-dimensional view of the surface. The controls provide typical curve editing functions.

This is a modeless dialog. You can use the main 3ds Max window while Edit Curve On Surface remains open. However, if you select a different kind of curve or a sub-object that isn’t a curve, the dialog closes.

You can edit multiple CV on surface on page 2593 or Point on surface on page 2597 curves, but you can’t edit both types of curves at the same time.

The point whose surface you first click is shown as a blue square in the dialog as well as in viewports. As you draw the curve, it appears interactively in viewports and a blue asterisk (*) shows the current mouse location on the surface.

While you are creating a curve, you can press Backspace to remove the last point or CV you created, and then previous points or CVs in reverse order.
Interface

The toolbar above the surface image provides selection, transform and viewing controls. These controls work the way their analogs do in the main 3ds Max viewports. The toolbar is disabled while you create a new curve on surface.

**Toolbar**

The toolbar above the surface image provides selection, transform and viewing controls. These controls work the way their analogs do in the main 3ds Max viewports. The toolbar is disabled while you create a new curve on surface.

**Select** Selects one or more points. Drag a window to select multiple points.
Move Moves the selected points.
Move is a flyout. The alternative buttons constrain texture points to move either vertically or horizontally.

Rotate Rotates the selected points.

Scale Scales the selected points. This is a flyout that lets you choose between uniform scale, nonuniform scale in the surface's U dimension, or nonuniform scale in the surface's V dimension.

Pan Pans the surface view.

Zoom Zooms in or out on the surface view.

Zoom Window Zooms to a window you drag on the surface view.

Zoom Extents Zooms to the extents of the surface.

Lock Selection Locks the active selection set. You can turn this on to keep from accidentally selecting other points or CVs while you’re transforming a selection set.

Preview When on (the default), edits you make in the dialog are also shown in viewports.

Curve on Surface Image

Below the toolbar is a 2D image of the curve. This image shows the points or CVs of the curve, allowing you to edit it as you edit sub-objects in viewports.
If you right-click while in the image, a pop-up menu lets you switch between Select, Move, Rotate, and Scale. This is an alternative to using the toolbar. If your mouse has a middle button, you can use it to pan in this window.

**Buttons and Weight**

These controls are comparable to editing controls on the rollouts for point sub-objects. (The Open button works differently.) These controls are disabled while you create a new curve on surface.

**Refine** Adds points to the curve. This does not change curvature. For point curves, the curvature can change, but only slightly.

**Insert** (Not available for point curves on surfaces.)

**Close** Closes the curve.

**Fuse** Fuses two points.

**Weight** (Not available for point curves on surfaces.)

**Delete** Deletes the selected points.

**Open** Opens the curve by unfusing the points where the curve was originally closed.

**Unfuse** Unfuses the selected points.

**Remove Animation** Removes animation controllers from the selected points or CVs.

**Edit Texture Surface Dialog (NURBS)**

Modify panel > Select NURBS surface sub-object. > Material Properties rollout > Texture Channels group box > Turn on Gen. Mapping Coords. > Texture Surface group box > Choose User-Defined. > Edit Texture Surface button

This dialog lets you edit the texture surface for a surface sub-object. It is available when you have chosen User Defined as the sub-object’s texture surface method.

A texture surface is associated with the surface sub-object. The texture surface is used to control how materials are mapped. In effect, changing the texture surface stretches or otherwise changes the UV coordinates for the surface, altering the mapping.
The Edit Texture Surface dialog shows a 2D view of the texture surface. You can also edit user-defined texture surfaces directly in 3D viewports, using the Edit Texture Points button. See Material Properties Rollout on page 2544.

Maps can shift with certain surface approximation methods. This effect is especially noticeable when the surface has animated CVs. You can reduce or eliminate map shifting by changing the mapping method to User Defined.

**TIP** Don't use the UVW Map modifier to apply a texture to an animated NURBS surface.
Interface

The toolbar above the surface image provides selection, transform and viewing controls. These controls work the way their analogs do in viewports.

NOTE You can animate transforms to the texture surface points.

Toolbar

The toolbar above the surface image provides selection, transform and viewing controls. These controls work the way their analogs do in viewports.

NOTE You can animate transforms to the texture surface points.
Select  Selects one or more points. Drag a window to select multiple points or CVs.

Move  Moves the selected points. Move is a flyout. The alternative buttons constrain texture points to move either vertically or horizontally.

Rotate  Rotates the selected points.

Scale  Scales the selected points. This is a flyout that lets you choose between uniform scale, nonuniform scale in the surface's U dimension, or nonuniform scale in the surface's V dimension.

Pan  Pans the surface view.

Zoom  Zooms in or out on the surface view.

Zoom Window  Zooms to a window you drag on the surface view.

Zoom Extents  Zooms to the extents of the surface.

Lock Selection  Locks the active selection set. You can turn this on so you don't accidentally select other points while you're transforming a selection set.

Preview  When on (the default), your edits are also shown in viewports. In viewports, selected texture points are displayed in red, and the others are displayed in green.
Texture Surface Image

Below the toolbar is a 2D image showing the points of the texture surface. You can edit the texture surface as you edit sub-objects in viewports.

If you right-click while in the image, the popup menu lets you switch between Select, Move, Rotate, and Scale. This is an alternative to using the toolbar.

If your mouse has a middle button, you can use it to pan in this window.

Texture Surface Controls

The controls below the surface image edit the texture surface.

Remove Animation Removes animation controllers from the selected texture points.

Reset to Defaults Resets user-defined mapping to the default.

Rebuild Displays the Rebuild Texture Surface dialog on page 2733, which rebuilds the texture surface and lets you change the number of CV rows or columns.

Insert Row, Insert Col., Insert Both Click one of these buttons to insert a row or column of points, or both at once, into the surface. Insertion adds points without moving other rows and columns.

While you refine the surface, the operation is previewed the same way Insert is previewed in 3D viewports.

Delete Row, Delete Col., Delete Both Click one of these buttons to delete a row or column of points, or both at once.

Join Curves Dialog (NURBS)

Modify panel > Select NURBS curve sub-object. > Curve Common rollout > Join button > Join two curves in a viewport.

This dialog lets you choose the way to join two curves.
Interface

ZIP tab

This tab chooses the zip algorithm. Zipping concatenates the CV lattices of the two original curves. Zipping can change the shape of the original curves, but usually it produces a better result than joining.

By default, the ZIP tab is active.

If both curves are untrimmed point curves, the result of zipping is a point curve. In all other cases, the result is a CV curve.

Tolerance A distance in 3ds Max units. If the ends of the two original curves are closer than this distance, zipping deletes one of the points or CVs in order to avoid creating coincident points or CVs in the new zipped curve.

Tension 1 (Disabled.)

Tension 2 (Disabled.)

Join tab

This tab chooses the join algorithm. Joining first creates a blend curve between the two original curves, and then makes all three into a single curve. Joining does not change the shape of the two original curves.
If both curves are point curves, the result is a point curve. If one or both curves are CV curves, the result is a CV curve.

**Tolerance** A distance in 3ds Max units. If the gap between the curves you are joining is greater than this value, the join is created by first creating a blend curve and then joining the three parts. If the gap is less than this value, or if the curves are overlapping or coincident, 3ds Max doesn’t create the blend. Creating a blend and then joining the three curves into a single curve is the better technique. The result matches the parent curves well. Without the blend step, the resulting curve can deviate from the parent curves, in order to maintain smoothness. (The amount of deviation depends on how far from tangent the two input curves were at the join.)

A problem arises when the gap is too small. In this case, 3ds Max generates the blend but because there isn’t enough room for it, the resulting curve has a loop. To avoid having this loop, set the Tolerance higher than the gap distance.

If you set the tolerance to 0.0, 3ds Max chooses a value to use for the Tolerance.

**Tension 1** Adjusts the tension of the new curve at the end of the first curve you picked.

**Tension 2** Adjusts the tension of the new curve at the end of the second curve you picked.

**Preview** When on, the effect of the zip or join is previewed in viewports. Default=on.

---

**Join Surfaces Dialog (NURBS)**

Modify panel > Select NURBS surface sub-object. > Surface Common rollout > Join button > Join two surfaces in a viewport.

This dialog lets you choose the way to join two surfaces.
Interface

ZIP tab

This tab chooses the zip algorithm. Zipping concatenates the CV lattices of the two original surfaces. Zipping can change the shape of the original surfaces, but compared to joining it usually produces a simpler surface that is easier to edit.

By default, the ZIP tab is active.

If both curves are untrimmed point surfaces, the result of zipping is a point surface. In all other cases, the result is a CV surface.

Tolerance A distance in 3ds Max units. If the edges of the two original surfaces are closer than this distance, zipping deletes one row (or column) of the points or CVs in order to avoid creating a coincident point or CV row (or column) in the new zipped surface.

Tension 1 (Disabled.)
Tension 2 (Disabled.)

Join tab

This tabChoose the join algorithm. Joining first creates a blend surface between the two original surfaces, and then makes all three into a single surface. Joining does not change the shape of the two original surfaces.
If both surfaces are point surfaces, the result is a point surface. If one or both surfaces are CV surfaces, the result is a CV surface.

**Tolerance** A distance in 3ds Max units. If the gap between the surfaces you are joining is greater than this value, the join is created by first creating a blend surface and then joining the three parts. If the gap is less than this value, or if the surfaces are overlapping or coincident, 3ds Max doesn’t create the blend. Creating a blend and then joining the three surfaces into a single surface is the better technique. The result matches the parent surfaces well. Without the blend step, the resulting surface can deviate from the parent surfaces, in order to maintain smoothness. (The amount of deviation depends on how far from tangent the two input surfaces were at the join.)

A problem arises when the gap is too small. In this case, 3ds Max generates the blend but because there isn’t enough room for it, the resulting surface has a loop. To avoid having this loop, set the Tolerance higher than the gap distance.

If you set the tolerance to 0.0, 3ds Max chooses a value to use for the Tolerance.

**Tension 1** Adjusts the tension of the new surface at the edge of the first surface you picked.

**Tension 2** Adjusts the tension of the new surface at the end of the second surface you picked.

**Preview** When on, the effect of the zip or join is previewed in viewports.

**Make Loft Dialog (NURBS)**

Modify panel > Select NURBS surface sub-object. > Surface Common rollout > Make Loft button

This dialog converts a surface sub-object to a (dependent) U loft or UV loft surface. You can also change the dimension used to construct a U loft surface.
**Interface**

From **U Iso Lines** uses curves along the surface's U dimension to construct a U loft.

From **V Iso Lines** uses curves along the surface's V dimension to construct a U loft. If the surface was already a U loft, set this to change the lofting dimension.

From **U and V Iso Lines** uses curves from both the U and V dimensions to construct a UV loft.

**U Curves** sets the number of curves in U.

**V Curves** sets the number of curves in V.

**Use Point Curves** when on, constructs the loft from point curves instead of the default CV curves. Default=off.

**Extra Points per Segment** this control is enabled only for UV lofts (From U and V Iso Lines). Lets you increase the number of points in each segment.
**Fuse Points** This control is enabled only for UV lofts (From U and V Iso Lines). When on, fuses points at curve intersections to ensure that the U and V curves continue to intersect when you edit the surface, and that the surface remains coincident with its parent curves. UV lofts constructed from intersecting curves behave more predictably. Default=on.

**Delete Original Loft Curves** This is available only if the surface was already a U loft or UV loft. When on, Make Loft deletes the original loft curves when you click OK. When off, the original curves remain where they are. Default=off.

**Preview** When on, displays a preview of the new loft surface. Loft creation is faster when Preview is off. Default=off.

### Make Point Dialog (NURBS)

Modify panel > Select NURBS surface sub-object. > Surface Common rollout > Make Point button

This dialog converts a CV surface sub-object to a point surface sub-object.

**Interface**

![Make Point Surface Dialog](image)

**Number in U** Sets the number of columns.

**Number in V** Sets the number of rows.

**Preview** When on, your changes are previewed in viewports. Point surface conversion is faster when Preview is off. Default=off.
Make Point Curve Dialog (NURBS)

Modify panel > Select NURBS curve sub-object. > Curve Common rollout > Make Fit button

The Make Fit button for a NURBS curve sub-object turns a CV curve into a point curve. For point curves, it lets you change the number of points. It displays this dialog.

Interface

![Make Point Curve Dialog]

Number of Points  Sets the number of points in the point curve.

Point Curve: Close Curve Dialog (NURBS)

Create panel > Shapes button > Point Curve button > In viewports, draw a point curve and click to create a point in the same location as the first point in the curve.

Modify panel > Select NURBS object. > NURBS toolbox > Create Point Curve > In viewports, draw a point curve sub-object and click to create a point in the same location as the first point in the curve.

This dialog lets you create a closed point curve when you click to create a point in the same location as the curve's first point.
Interface

Yes Closes the curve and ends curve creation.

No Keeps the curve open and does not end curve creation.

Rebuild CV Curve Dialog (NURBS)

Modify panel > Select NURBS object. > Stack display > Curve sub-object level > Select an independent CV curve sub-object. > CV Curve rollout > Rebuild button

The Rebuild button for CV curves displays this dialog. It lets you specify how to rebuild the curve. Rebuilding the curve can change its appearance.

Interface

Tolerance Rebuilds the curve according to accuracy. The lower the Tolerance value, the more accurate the rebuild. Increasing Tolerance enables the curve to be rebuilt using fewer CVs.

Number (The default.) Lets you alter the number of CVs in the curve.
Preview When on (the default), your changes are previewed in viewports.

Rebuild CV Surface Dialog (NURBS)

Modify panel > Select NURBS object. > Stack display > Surface sub-object level > Select an independent CV surface sub-object. > CV Surface rollout > Rebuild button

The Rebuild button for CV surfaces displays this dialog. It lets you specify how to rebuild the surface. Rebuilding the surface can change its appearance.

Interface

![Rebuild CV Surface Dialog](image)

Tolerance Rebuilds the surface according to accuracy. The lower the Tolerance value, the more accurate the rebuild. Increasing Tolerance enables the surface to be rebuilt using fewer CVs.

Number (The default.) Lets you alter the number of CVs in the surface. Number in U specifies the number in the U dimension, and Number in V specifies the number in the V dimension. These values default to the numbers that already exist in the surface.

Preview When on (the default), your changes are previewed in viewports.
Rebuild Texture Surface Dialog (NURBS)

Modify panel > Select NURBS surface sub-object. > Surface sub-object level > Material Properties rollout > Texture Channels group box > Turn on Gen. Mapping Coords. > Texture Surface group box > Choose User-Defined. > Edit Texture Surface button > Edit Texture Surface dialog > Rebuild button

This dialog rebuilds the texture surface and lets you change the number of CV rows or columns.

**Interface**

![Rebuild Texture Surface Dialog](image)

**Number in U** Sets the number of CV columns.

**Number in V** Sets the number of CV rows.

Reparameterize Dialog (NURBS)

Modify panel > Select NURBS object. > Stack display > Curve sub-object level > Select an independent CV curve sub-object. > CV Curve rollout > Reparam. button

Modify panel > Select NURBS object. > Stack display > Curve sub-object level > Select an independent CV surface sub-object. > CV Surface rollout > Reparam. button

The Reparam. button for CV curves and surfaces displays this dialog. Reparameterizing a CV sub-object changes its parameter space on page 8674 to provide a better relation between control point locations and the shape of the sub-object.

**TIP** It is a good idea to reparameterize after you have added CVs to a curve or surface by refining or inserting.
Interface

Chord Length Chooses the chord-length algorithm for reparameterization. Chord-length reparameterization spaces knots (in parameter space on page 8674) based on the square root of the length of each curve segment. Chord-length reparameterization is usually the best choice.

Uniform Spaces the knots uniformly. A uniform knot vector has the advantage that the curve or surface changes only locally when you edit it. With chord-length parameterization, moving any CV can potentially change the entire sub-object.

Maintain Parameterization When on, the curve is automatically reparameterized as you edit it, using the currently active method of reparameterization. When off, no reparameterization happens unless you use this dialog. Default=off.

Preview If on (the default), displays the effects of reparameterizing in viewports.

Sub-Object Clone Options Dialog (NURBS)

Modify panel > Select NURBS surface or curve sub-object. > Shift+Clone. > Clone Options dialog

When you Shift+Clone on page 996 a surface or curve sub-object, the Clone Options dialog appears. This dialog asks whether you want the clone to be a relational copy, an independent copy, or a transform.
Interface

**Relational Copy** The cloned object is the same type as the original. If the original object was a dependent object, the clone includes copies of the parents. For example, when you clone a Blend surface, the clone remains a Blend surface and its two parent surfaces are copied along with it. Because all related sub-objects are copied, Relational Copy can be time-consuming.

**Independent Copy** The cloned object is an independent CV curve or CV surface. It has the same shape as the original, but its relational dependencies aren't copied. This method of cloning uses less time and memory, although you lose the relational properties. For example, when you clone a Blend surface, the clone is an independent CV surface.

**Copy as Transform Object(s)** The "clone" is actually a transform curve or transform surface, based on the original object and still dependent on it. This lets you create transform curves and surfaces based on a rotation and scale as well as on translation.

**Include Parent(s)** (Available only for Independent Copy or Copy as Transform Object(s).) Tells the system whether or not to include the parents of the dependent object. For example, if Include Parent(s) is on when you clone a blend surface, the two parent surfaces are also cloned as independent CV surfaces. If Include Parent(s) is off, only the one curve or surface is cloned. Cloning is slower when Include Parent(s) is on, although quicker than Relational Copy.
Select By Material ID Dialog (NURBS)

Modify panel > Select NURBS object. > Stack display > Curve sub-object level > Select By ID button.

This dialog lets you select curve sub-objects by the material ID number assigned to them.

**Interface**

![Select By Material ID Dialog](image)

**ID** Specifies the material ID you want to select.

**Clear Selection** When on, replaces the current selection (if any) by the material ID selection. When off, adds the material ID selection to the current selection set.

**NURBS Curve and Surface Approximation**

Topics in this section describe how you can control the way 3ds Max generates NURBS curves and surfaces.

**NURBS Curve Approximation**

Modify panel > Select top-level NURBS object. > Curve Approximation rollout

Although NURBS curves are analytically generated, in order to generate and display them they must be approximated by line segments.

Curve approximation controls are displayed in the creation parameters for curve objects, and on a Curve Approximation rollout for NURBS models (top-level NURBS objects). At the model level, approximation controls affect all curve sub-objects in the model.
Curve approximation is accomplished by *segments*. One or more line segments, or *steps*, are used to approximate each segment of the curve. For point curves, a segment of a curve is the portion between one point and the next. For CV curves, the segment is determined by the CV’s parametric *knot* on page 8617. The transition from one CV curve segment to another isn't visible in viewports.

Curve approximation parameters aren't animatable.

**Interface**

**Steps** The maximum number of line segments used to approximate each curve segment. If the curve displays or renders with angles, increase this value. This control is unavailable when Adaptive is on. Range=1 to 100.

**Optimize** Turn on this check box to optimize the curve. When on, interpolation uses the specified *Steps* value unless two segments are collinear, in which case they are converted to a single segment. This control is unavailable when Adaptive is on.

**Adaptive** (The default.) Segments the curve adaptively, based on its curvature. In other words, the curve is assigned more segments where its curvature is greatest, and fewer segments where its curvature is less.

**NURBS Surface Approximation**

Modify panel > Select top-level NURBS object. > Surface Approximation rollout

Modify panel > Select NURBS surface sub-object. > Surface Approximation rollout

Although NURBS surfaces are analytically generated, in order to generate and display them they must be approximated by faces. You use the controls described in this section to set the type of approximation used and its parameters.

The Surface Approximation rollout controls how surface sub-objects in the NURBS model are approximated for purposes of rendering and viewport
display. NURBS can be approximated differently in viewports and in the renderer. Typically you want viewport display to be clear and quick, while you want rendered display to be smooth, accurate, and "realistic." However, the approximation you choose for viewports creates a mesh, and the kind of mesh you choose can affect the behavior of modifiers that you later apply to the NURBS model.

The first two controls on this rollout are radio buttons for selecting the kind of display output, viewport or renderer, these parameters control.

Surface approximation parameters are not animatable.

**NOTE** If the size or shape of a surface changes over time, the tessellation used to approximate it can change (automatically) as well. This has the advantage of improving render time in animations. It has the disadvantage that you can't apply image motion blur on page 8606 to NURBS objects whose tessellation changes during animation. The Regular method of tessellation is the exception: it doesn't change when animated, so you can use image motion blur with Regular tessellation.

**Surface Approximation Per Surface**

By default, surface sub-objects use the same approximation settings as the top-level NURBS model. You can override these settings. Each surface sub-object now has a Surface Approximation rollout of its own. The controls on this rollout are disabled unless you turn off the Lock to Top Level toggle. With this toggle turned off, you can choose approximation settings specific to this surface sub-object.
Tessellation group

Viewports When chosen, the rollout affects how surfaces in the NURBS object are displayed interactively in viewports, including shaded viewports, and by the preview renderer.

The Viewports surface settings are also used when you apply a mesh modifier such as Mesh Select to the NURBS object. This is important because the modifier can affect the scene's geometry.

Renderer When chosen, the rollout affects how surfaces in the NURBS object are displayed by the renderer.

The next cluster of buttons lets you choose which portions of the geometry are affected by the surface approximation settings.

Base Surface Settings affect the entire surface. This is the default.

Surface Edge Turn on to set approximation values for tessellating surface edges that are defined by trim curves. With Lock turned off, the surface and edge tessellation values are independent of each other.

For object-level surfaces, this is unavailable unless Lock (described below) is turned off.

Displaced Surface Turn on to set a third, independent approximation setting for surfaces that have a displacement map on page 6059 applied to them. Available only when Renderer is chosen.

Using a preset approximation setting (in the Presets group box) should give you faster results for displaced surfaces.

Lock (for object-level surfaces only) Locks the Base Surface settings to the Surface Edge settings. In other words, surfaces and surface edges have a relational tessellation setting unless Lock is turned off. Default=on.

Tessellation Presets group

Lets you choose a preset low, medium, or high quality surface approximation. While a preset is chosen, the values it uses are displayed on the Tessellation Method rollout.

Preset values are saved in the 3dsmax.ini on page 60 file. You can customize the preset values by using the Surface Approximation utility on page 2748.

Low Selects a (comparatively) low-quality surface approximation. These are the default values:

Viewports, Base Surface:
Method=Spatial and Curvature Edge=50.0 Distance=50.0 Angle=50.0 Merge=0.0
Advanced Parameters > Minimum=0, Maximum=3
Renderer, Base Surface:
Method=Spatial and Curvature Edge=20.0 Distance=20.0 Angle=15.0 Merge=0.01 Advanced Parameters > Minimum=0, Maximum=3
Renderer, Displaced Surface:
Method=Spatial and Curvature Edge=20.0 Distance=20.0 Angle=10.0 Merge=(Unavailable) Advanced Parameters > Minimum=0, Maximum=2
Keyboard shortcut: Alt+1

**Medium**(The default for both viewports and rendering.) Selects a medium-quality surface approximation. These are the default values:
Viewports, Base Surface:
Method=Spatial and Curvature Edge=20.0 Distance=20.0 Angle=15.0 Merge=0.0
Advanced Parameters > Minimum=0, Maximum=3
Renderer, Base Surface:
Method=Spatial and Curvature Edge=10.0 Distance=15.0 Angle=10.0 Merge=0.01 Advanced Parameters > Minimum=0, Maximum=4
Renderer, Displaced Surface:
Method=Spatial and Curvature Edge=10.0 Distance=10.0 Angle=4.0 Merge=(Unavailable) Advanced Parameters > Minimum=0, Maximum=3
Keyboard shortcut: Alt+2

**High** Selects a high-quality surface approximation. These are the default values:
Viewports, Base Surface:
Method=Spatial and Curvature Edge=5.0 Distance=15.0 Angle=10.0 Merge=0.0
Advanced Parameters > Minimum=0, Maximum=3
Renderer, Base Surface:
Method=Spatial and Curvature Edge=5.0 Distance=5.0 Angle=3.0 Merge=0.01 Advanced Parameters > Minimum=0, Maximum=4
Renderer, Displaced Surface:
Method=Spatial and Curvature Edge=5.0 Distance=5.0 Angle=2.0 Merge=(Unavailable) Advanced Parameters > Minimum=0, Maximum=4
Keyboard shortcut: Alt+3
NOTE  The keyboard shortcuts for surface approximation presets don't require that the Keyboard Shortcut Override Toggle be on. You can change the surface approximation of NURBS objects by selecting them in a viewport, and then using Alt+1, Alt+2, or Alt+3. This works for sub-objects as well, but the surface sub-object's Lock to Top Level toggle must be turned off.

Tessellation Method group

The controls in this group affect the display of the NURBS surface in viewports if you have chosen Viewports above, or by the renderer if you have chosen Renderer above. You can choose between five algorithms. Each approximates NURBS surfaces by tessellating them in a different way.

Generally speaking, if the preset values you have chosen give good results, you don't need to adjust the controls on this rollout. Adjust them if you encounter problems with the preset alternative.

Tips

- **Viewport Tessellation:** The tessellation method creates the mesh. If you modify the NURBS object with Mesh Select on page 1500, choose the method that gives the result you need. If you use modifiers heavily, Spatial or Parametric might be better than Curvature, because of their regular tessellation. Curvature-dependent tessellation can cause problems with some modifiers.

- **Renderer Tessellation:** Spatial and Curvature usually obtains the most accurate rendering. Curvature can be the more efficient choice when you render animated surfaces.

**Lock to Top Level** (for sub-object surfaces only) When on, the surface sub-object uses the same surface approximation settings as the top-level NURBS model, and other controls on this rollout are disabled. When turned off, you can set the sub-object approximation to differ from the top-level model. Default=on.

**Regular** Generates a fixed tessellation across the surface based on U Steps by V Steps. Increasing these parameters increases accuracy at a cost of speed, and vice versa, but in general this can be the quickest and least accurate way to approximate a NURBS surface. Very low values for U and V Steps using the Regular method usually doesn't provide good results. Model complexity increases slowly as U and V Steps values increase.
Regular mesh of the NURBS teapot

**Parametric** Generates an adaptive tessellation based on U Steps by V Steps. Low values for U and V Steps using the Parametric method often provide good results. Model complexity increases rapidly as U and V Steps values increase, so take care when you switch from Regular, which generally requires higher U and V values, to Parametric, where lower U and V values generally suffice. For example, if you convert a teapot to NURBS and set the U and V steps to 15, the Regular method generates 4470 faces but the Parametric method generates 204960 faces.

Parametric mesh of the NURBS teapot

**Spatial** Generates a uniform tessellation made of triangular faces. The Edge parameter specifies the maximum length of a triangular face in the tessellation. The value is a percentage of the object’s bounding box. Decreasing this value increases accuracy but increases rendering time.
Spatial mesh of the NURBS teapot

Curvature (The default.) Generates a variable tessellation based on the curvature of the surface. The tessellation has a finer grain where the surface is more curved. Changing surface curvature dynamically changes the curvature tessellation.

The Distance parameter specifies how far the approximation can deviate from the actual NURBS surface. Distance is a percentage of the diagonal of each surface's bounding box. Each surface in an object is tessellated based on its size, independently of other surfaces. Scaling a surface doesn't change its tessellation. Decreasing this value increases accuracy but increases rendering time. When you set Distance to 0.0, 3ds Max ignores this parameter and uses the Angle to control accuracy.

The Angle parameter specifies the maximum angle between faces in the approximation. Decreasing this value increases accuracy but increases rendering time. When you set Angle to 0.0, 3ds Max ignores this parameter and uses Distance to control accuracy.

When both Distance and Angle are 0.0, the surfaces degenerate and can become flat surfaces.
Curvature mesh of the NURBS teapot

**Spatial and Curvature** Combines the spatial (edge-length) method and the curvature (distance and angle) methods, using all three values.

The Edge parameter specifies the maximum length of a triangular face in the tessellation. The value is a percentage of the object's bounding box. Decreasing this value increases accuracy but increases rendering time. When you set Edge to 0.0, the effect is equivalent to the Curvature method.

The Distance parameter specifies how far the approximation can deviate from the actual NURBS surface. Distance is a percentage of the diagonal of each surface's bounding box. Each surface in an object is tessellated based on its size, independently of other surfaces. Scaling a surface doesn't change its tessellation. Decreasing this value increases accuracy but increases rendering time. When you set Distance to 0.0, 3ds Max ignores this parameter and uses the Edge and Angle values to control accuracy.

The Angle parameter specifies the maximum angle between faces in the approximation. Decreasing this value increases accuracy but increases rendering time. When you set Angle to 0.0, 3ds Max ignores this parameter and uses the Edge and Distance values to control accuracy.

When Distance, Angle, and Edge are all 0.0, the surfaces degenerate and can become flat surfaces.
View-Dependent (for the Renderer only) When on, takes the object's distance from the camera into account while calculating tessellation. This can improve rendering time by not generating fine-grained tessellations for objects in the distance of the rendered scene. The view-dependent effect works only when you render camera or perspective views. It doesn't work in orthographic views. This control is disabled while Viewports is active.

For the Spatial, Curvature, and Spatial and Curvature methods, the Distance and Edge values specify pixels instead of 3ds Max units when View-Dependent is on.

NOTE When View-Dependent is on, tessellation quickly reaches the maximum subdivision limit. You might want to increase this value to 7 (the greatest value allowed). See the description of Advanced Parameters, below.

Merge (sub-object surfaces only) Controls the tessellation of surface sub-objects whose edges are joined or very nearly joined. When input to a modifier (such as Mesh Select) requires a mesh, and when NURBS surfaces are tessellated for production rendering, by default 3ds Max adjusts the tessellation of adjoining surfaces to match each other, in terms of the number of faces along the edges. The Merge parameter controls how this is done. If Merge is zero, adjoining faces are unchanged. Increasing the value of Merge increases the distance 3ds Max uses to calculate how edges should match, guaranteeing no gaps between the surfaces when they are rendered. Default=0.0.

In most cases, you don't need to adjust Merge. If rendering shows gaps between nearly adjoining faces, increase Merge to eliminate them.

Technically, the Merge value is 0.1 percent of the diagonal of the object's bounding box. In other words, a Merge value of 1.0 (higher than necessary for most purposes) is 0.1 percent of the length of the diagonal. Because Merge
is based on the object’s dimensions, you can scale the NURBS model without affecting the Merge setting.

**Advanced Parameters** Click to display the Advanced Surface Approximation dialog on page 2747. The parameters in this dialog apply to the Spatial, Curvature, and Spatial and Curvature approximation methods.

**Clear Surface Level** (Appears only for top-level surfaces.) Clears all surface approximation settings assigned to individual surface sub-objects. When you click this button, all surface-specific approximations are lost, and Lock to Top Level is on for surface sub-objects.

### Advanced Surface Approximation Dialog (NURBS)

Modify panel > Select a NURBS surface object or surface sub-object. > Surface Approximation rollout > Tessellation Method group box > Turn off Lock to Top Level > Advanced Parameters button

Select an editable mesh object. > Modify panel > Surface Properties rollout > Advanced Parameters button

This dialog sets parameters that control the tessellation used in the Spatial, Curvature, and Spatial and Curvature approximation methods.

#### Interface

![Advanced Surface Approx. dialog](image)

**Subdivision Style**

Chooses the method used to subdivide the surface:
**Grid** Subdivides the surface using a regular grid.

**Tree** (The default.) Subdivides the surface using a binary tree.

**Delaunay** Subdivides the surface using nearly equilateral triangles.

---

**Delauney surface subdivision style**

**Subdivision Limits**

For Grid or Tree subdivisions, the limits control the number of recursive decompositions that are performed during tessellation.

**Minimum Subdivision Levels** Sets the minimum number of recursions. Default=0.

**Maximum Subdivision Levels** Sets the maximum number of recursions. The maximum can be no greater than 7. Be careful: setting the maximum greater than 5 can result in massive face counts and poor performance. Default=3.

**Maximum Number of Triangles**

For Delaunay subdivision, the Maximum Number of Triangles lets you specify the maximum number of triangles into which the surface will be divided. Default=20000.

---

**Surface Approximation Utility (NURBS)**

Utilities panel > Utilities rollout > More button > Utilities dialog > Surface Approximation
The Surface Approximation utility lets you change approximation and display settings without going into the NURBS model, and is especially useful for changing settings on multiple NURBS objects at once.

It has two rollouts, one for surface approximation and the other for surface display controls:

- **Surface Approximation Rollout** on page 2749
- **Surface Display Rollout** on page 2759

**Procedures**

To use the Surface Approximation utility:

1. On the Utilities panel, click the More button, and choose Surface Approximation from the list.
2. Set the desired options on the Surface Approximation and Surface Display rollouts.
3. Select the NURBS objects to apply the settings to.
4. On the Surface Display rollout, click Set Selected to apply the settings.

**Surface Approximation Rollout**

Utilities panel > Utilities rollout > More button > Utilities dialog > Surface Approximation > Surface Approximation rollout

The controls in the Surface Approximation rollout are the same as the surface approximation on page 2737 controls for NURBS on page 2416 surface objects, with two additional buttons: Set Selected and Reset.
**Iso Parametric Lines group**

The controls in this group box affect the display of the NURBS surfaces in viewports.

**U Lines and V Lines** The number of lines used to approximate the NURBS surfaces in viewports, along the surface's local U and V dimensions, respectively. Reducing these values can speed up the display of the surface, but reduce accuracy of the display. Increasing these values increases accuracy at the expense of time. Setting one of these values to 0 displays only the edge of the object in the corresponding dimension.

**Iso Only** When chosen, all viewports display iso line representations of the surface. Iso (parametric) lines are similar to contour lines. The lines show where the NURBS surface has a constant U value or V value or both. Iso line representations can be less crowded and easier to visualize than wire mesh representations.

**Iso and Mesh** (The default.) When chosen, wireframe viewports display iso line representations of the surface, and shaded viewports display the shaded surface.

**Mesh Only** When chosen, wireframe viewports display the surface as a wire mesh, and shaded viewports display the shaded surface.

In wireframe viewports, this option lets you see the surface approximation used for viewports.

![Iso and mesh displays of a NURBS teapot](image)
Viewports When chosen, the utility affects how surfaces in the NURBS objects are displayed interactively in viewports, including shaded viewports, and by the preview renderer.

The Viewports surface settings are also used when you apply a mesh modifier such as Mesh Select to the NURBS objects. This is important because it can affect the scene’s geometry.

Renderer When chosen, the utility affects how surfaces in the NURBS objects are displayed by the renderer.

Base Surface When on, settings affect entire surfaces in the selection set. Default=on.

Surface Edge When on, settings affect the tessellation of surface edges that are defined by trim curves.

Displaced Surface Enabled only when Renderer is chosen. Turn on to set a third, independent approximation setting for surfaces that have a displacement map on page 6059 or Displace on page 1313 modifier applied to them.

Load Tessellation Preset group

Lets you choose a preset low, medium, or high-quality level of surface approximation. While a preset is chosen, the values it uses are displayed in the Tessellation Method group box.

Preset values are saved in the 3dsmax.ini file. You can customize the preset values by using the buttons in the following group box, Save Tessellation Preset.

Low Selects a (comparatively) low-quality level of surface approximation. These are the default values:

**Viewports, Base Surface:**
Method=Spatial and Curvature
Edge=50.0
Distance=50.0
Angle=50.0
Merge=0.0
Advanced Parameters > Minimum=0, Maximum=3

**Renderer, Base Surface:**
Method=Spatial and Curvature
Edge=20.0
Distance=20.0
Angle=15.0
Merge=0.01
Advanced Parameters > Minimum=0, Maximum=3

**Renderer, Displaced Surface:**
Method=Spatial and Curvature
Edge=20.0 Distance=20.0
Angle=10.0 Merge=(Unavailable)
Advanced Parameters > Minimum=0, Maximum=2

**Medium** (The default for both viewports and rendering.) Selects a medium-quality level of surface approximation. These are the default values:

**Viewports, Base Surface:**
Method=Spatial and Curvature
Edge=20.0
Distance=20.0
Angle=15.0
Merge=0.0
Advanced Parameters > Minimum=0, Maximum=3

**Renderer, Base Surface:**
Method=Spatial and Curvature
Edge=10.0
Distance=15.0
Angle=10.0
Merge=0.01
Advanced Parameters > Minimum=0, Maximum=4

**Renderer, Displaced Surface:**
Method=Spatial and Curvature
Edge=10.0
Distance=10.0
Angle=4.0
Merge=(Unavailable)
Advanced Parameters > Minimum=0, Maximum=3

**High** Selects a high-quality level of surface approximation. These are the default values:

**Viewports, Base Surface:**
Method = Spatial and Curvature  
Edge = 5.0  
Distance = 5.0  
Angle = 3.0  
Merge = 0.01  
Advanced Parameters > Minimum = 0, Maximum = 4

Renderer, Base Surface:
Method = Spatial and Curvature  
Edge = 5.0  
Distance = 5.0  
Angle = 3.0  
Merge = 0.01  
Advanced Parameters > Minimum = 0, Maximum = 4

Renderer, Displaced Surface:
Method = Spatial and Curvature  
Edge = 5.0  
Distance = 5.0  
Angle = 2.0  
Merge = (Unavailable)  
Advanced Parameters > Minimum = 0, Maximum = 4

Save Tessellation Preset group

Click a button to save the current Tessellation Method settings as a new Low, Medium, or High preset. These values are saved in the 3dsmax.ini file.

NOTE  There is a separate Low, Medium, and High preset for Base Surface and Displaced Surface approximation. Check whether Base Surface or Displaced Surface is on before you use the buttons in this group box to save a custom preset.

Customizing preset values overwrites the default presets. To restore the defaults, you can re-enter the default preset values shown above, and then save them with the corresponding button. You can also restore defaults by editing the 3dsmax.ini file to delete the custom preset values.

When you customize the preset values, there is no necessary correlation between the button names and the quality of surface approximation. 3ds Max has no way of knowing how "good" a tessellation is, and you can save a very high-quality surface approximation in the Low preset, for example.

Tessellation Method group

The controls in this group box affect the display of the NURBS surfaces in either viewports, if Viewports is chosen, or by the renderer, if Renderer is
chosen. You can choose between five algorithms. Each approximates NURBS surfaces by tessellating them in a different way.

**NOTE** When Viewports is chosen, you must also choose Mesh Only in order to see the effect of the Mesh Parameter settings in wireframe viewports.

Generally speaking, if the preset values you have chosen give good results, you don’t need to adjust the controls in this rollout further. Use them if you encounter problems with the preset alternative.

**Tips**

- **Viewport Tessellation:** The tessellation method creates the mesh, so if you modify the NURBS object with Mesh Select, choose the method that gives the result you need. If you use modifiers heavily, Spatial or Parametric might be better than Curvature, because of their regular tessellation. Curvature-dependent tessellation can cause problems with some modifiers.

- **Renderer Tessellation:** Spatial and Curvature usually obtains the most accurate rendering. Curvature can be the more efficient choice when you render animated surfaces.

**Regular** Generates a fixed tessellation across the surface based on U Steps by V Steps. Increasing these parameters increases accuracy at a cost of speed, and vice versa, but in general this can be the quickest and least accurate way to approximate a NURBS surface. Very low values for U and V Steps using the Regular method usually doesn’t provide good results. Model complexity increases slowly as U and V Steps values increase.

**Parametric** Generates an adaptive tessellation based on U Steps by V Steps. Low values for U and V Steps using the Parametric method often provide good results. Model complexity increases rapidly as U and V Steps values increase, so take care when you switch from Regular, which generally requires higher U and V values, to Parametric, where lower U and V values generally suffice. For example, if you convert a teapot to NURBS and set the U and V steps to 15, the Regular method generates 4470 faces but the Parametric method generates 204960 faces.
Spatial mesh of the NURBS teapot

Spatial Generates a uniform tessellation made of triangular faces. The Edge parameter specifies the maximum length of a triangular face in the tessellation. The value is a percentage of the object’s bounding box. Decreasing this value increases accuracy but increases rendering time.

Curvature Generates a variable tessellation based on the curvature of the surface. The tessellation has a finer grain where the surface is more curved. Changing surface curvature dynamically changes the curvature tessellation. The Distance parameter specifies how far the approximation can deviate from the actual NURBS surface. Distance is a percentage of the diagonal of each surface’s bounding box. Each surface in an object is tessellated based on its size, independently of other surfaces, and scaling a surface doesn’t change its tessellation. Decreasing this value increases accuracy but increases rendering time. When you set Distance to 0.0, 3ds Max ignores this parameter and uses the Angle to control accuracy.
The Angle parameter specifies the maximum angle between faces in the approximation. Decreasing this value increases accuracy but increases rendering time. When you set Angle to 0.0, 3ds Max ignores this parameter and uses the Distance to control accuracy.

When both Distance and Angle are 0.0, the surfaces degenerate and can become flat surfaces.

Curvature mesh of the NURBS teapot

**Spatial and Curvature** (The default.) Combines the spatial (edge-length) method and the curvature (distance and angle) methods, using all three values. The Edge parameter specifies the maximum length of a triangular face in the tessellation. The value is a percentage of the object's bounding box. Decreasing this value increases accuracy but increases rendering time. When you set Edge to 0.0, the effect is equivalent to the Curvature method.

The Distance parameter specifies how far the approximation can deviate from the actual NURBS surface. Distance is a percentage of the diagonal of each surface's bounding box. Each surface in an object is tessellated based on its size, independently of other surfaces, and scaling a surface doesn't change its tessellation. Decreasing this value increases accuracy but increases rendering time. When you set Distance to 0.0, 3ds Max ignores this parameter and uses the Edge and Angle values to control accuracy.

The Angle parameter specifies the maximum angle between faces in the approximation. Decreasing this value increases accuracy but increases rendering time. When you set Angle to 0.0, 3ds Max ignores this parameter and uses the Edge and Distance values to control accuracy.

When Distance, Angle, and Edge are all 0.0, the surfaces degenerate and can become flat surfaces.

**View-Dependent** (for the Renderer only): When on, takes the object's distance from the camera into account while calculating its tessellation. This can
improve rendering time by not generating fine-grained tessellations for objects that are in the distance of the rendered scene. The view-dependent effect only works when you render camera or perspective views. It doesn't work in orthographic views. This control is disabled while Viewports is active.

For the Spatial, Curvature, and Spatial and Curvature methods, when View-Dependent is on, the Distance and Edge values specify pixels instead of the default 3ds Max units.

**NOTE** When View-Dependent is on, tessellation very quickly reaches the maximum subdivision limit. You might want to increase this value to 7 (the greatest value allowed). See the description of Advanced Parameters, below.

**Merge** Controls the tessellation of surface sub-objects whose edges are joined or very nearly joined. When input to a modifier (such as Mesh Select) that requires a mesh, and when NURBS surfaces are tessellated for production rendering, by default 3ds Max adjusts the tessellation of adjoining surfaces to match each other, in terms of the number of faces along the edges. The Merge parameter controls how this is done. If Merge is zero, adjoining faces are unchanged. Increasing the value of Merge increases the distance 3ds Max uses to calculate how edges should match, guaranteeing no gaps between the surfaces when they are rendered. Default=0.01.

In most cases, you don't need to adjust Merge. If rendering shows gaps between nearly adjoining faces, increase Merge to eliminate them.

Technically, the Merge value is one tenth of one percent of the diagonal of the object's bounding box. In other words, a Merge value of 1.0 (higher than necessary for most purposes) is 0.1 percent of the length of the diagonal. Because Merge is based on the object's dimensions, you can scale the NURBS model without affecting the Merge setting.

**Advanced Parameters** Click to display the Advanced Surface Approximation dialog on page 2747. The parameters in this dialog apply to the Spatial, Curvature, and Spatial and Curvature approximation methods.

**Clear Surfaces** When on, the settings you choose in this utility override all sub-object specific surface approximation settings in the selected NURBS models. When off, the utility affects top-level NURBS models but settings local to individual surface sub-objects remain unaffected. Default=Off.

**Set Selected** Applies the surface approximation values active in the utility to all selected NURBS objects.

**Reset** Resets the values in the utility to the default settings for a NURBS surface.
Surface Display Rollout

Utilities panel > Utilities rollout > More button > Utilities dialog > Surface Approximation > Surface Display rollout

The controls in the Surface Display rollout are the same as the display controls for NURBS surface objects, with two additional buttons: Set Selected and Reset.

Interface

Display group

Lattices When on, displays control lattices, in yellow lines. (You can change the lattice color by using the Colors panel on page 8272 of the Customize User Interface dialog. The Curve CV and Surface CV sub-object levels also have a local Display Lattice toggle, which overrides this global setting at the sub-object level. The Curve CV and Surface CV settings are independent. In other words, at the sub-object level, you can turn on the lattice for an object’s curves but not its surfaces, or vice versa.

Curves When on, displays curves.

Surfaces When on, displays surfaces.

Dependents When on, displays dependent sub-objects.
Surface Trims  When on, displays surface trimming. When turned off, displays all of a surface even if it’s trimmed.

Transform Degrade  When on, transforming a NURBS surface can degrade its display in shaded viewports, to save time. This is similar to using the Adaptive Degradation toggle for playing animations. You can turn off this toggle so surfaces are always shaded while you transform them, but transforms can take longer to create.

Button set

Set Selected  Applies the display settings active in the utility to all selected NURBS objects.

Reset  Resets the values in the utility to the default settings for a NURBS surface.

Tools for Low-Polygon Modeling

A few features help you manage the polygon count for scenes and animations that must not become too complex.

Show Statistics, available from the General viewport label menu on page 8117, lets you monitor the number of polygons, vertices, and so on, in the scene, as well as the frames per second displayed.

The Level of Detail utility, available from the Utilities panel on page 8223, lets you manage the complexity of an object in the scene. For example, Level of Detail enables you to display a complex object as simple geometry when the object is at a distance from the camera.

ProOptimizer is a modifier that helps you reduce the vertex and polygon count of high-resolution models. This feature is also available as a utility, which lets you run it as a batch process on one or more scene files.

Show Statistics

Click or right-click the General viewport label (“[ + ]”). > General viewport label menu on page 8117 > Show Statistics

Keyboard > 7

You can quickly access various statistics related to your current selection and entire scene.
NOTE These statistics are relevant primarily to mesh and poly objects. Some statistics information might be unavailable with certain other types of object.

Procedures

To use the viewport statistics display:

1. Customize the statistics display on the Customize menu > Viewport Configuration dialog > Statistics panel.
2. Activate the viewport in which to display statistics.
3. Toggle the statistics display by pressing 7 or right-clicking the viewport label and choosing Show Statistics.

Interface

You can customize the viewport statistics by turning on and off options on the Statistics on page 8390 panel of the Viewport Configuration dialog. The following statistics reflect all options turned on.

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Polys</td>
<td>Displays the number of polygons in the scene and selection.</td>
</tr>
<tr>
<td>Tris</td>
<td>Displays the number of triangle faces in the scene and selection.</td>
</tr>
<tr>
<td>Edges</td>
<td>Displays the number of edges in the scene and selection.</td>
</tr>
<tr>
<td>Verts</td>
<td>Displays the number of vertices in the scene and selection.</td>
</tr>
<tr>
<td>FPS</td>
<td>The frames per second displayed in the viewport.</td>
</tr>
</tbody>
</table>

NOTE This is valid only for poly objects.

NOTE If you select a polygon in a poly object, this option shows two or more triangles.
Level of Detail Utility

Utilities panel > Utilities rollout > More button > Utilities dialog > Level of Detail

The Level Of Detail utility lets you construct an object that alters its geometric complexity or level of detail based on its size in the rendered image. You create several versions of the same object each with different levels of detail, group them as one, and then run the Level Of Detail utility, which automatically creates a special LOD controller as a Visibility track. The LOD controller then hides and unhides the objects in the group, depending on their size in the rendered scene.

The main purpose of this utility is to save time in rendering complex objects and in manipulating objects in the viewports. Since a portion of rendering speed is directly related to the number of faces that must be rendered in a scene, using the Level Of Detail utility lets you reduce the number of rendered faces as an object reduces its apparent size. In addition, you can use this utility to display a simple stand-in for a more complex object in the viewports. Since the stack is not calculated for objects hidden in the viewports, you can speed up viewport manipulation by using this utility to substitute complex stack objects with simple stand-ins.

Procedures

To set up an object for the Level Of Detail utility:

1 Create two or more objects that are identical except for their complexity.

   NOTE It's best to assign materials and mapping coordinates, as well as all modifiers while the objects are still separate.

2 Select all of the objects, and use the Align tool to center all of them about a common center.

3 Group the objects.

4 Choose the Level Of Detail utility.

5 While the grouped object is selected, click the Create New Set button. The name of the objects within the group appear in the Level Of Detail list, in order of complexity; only the least complex object in the group is displayed in the viewports, while all other objects are made invisible.
Use the controls in the Level Of Detail rollout to adjust when the objects will switch their display in the rendered scene.

To access an object's stack:

1. Select the Level Of Detail object, and then choose Group menu > Open.
2. In the Level Of Detail utility, choose the object you want to access from the list window, and then turn on Display In Viewports (or double-click the object's name in the list window).
3. Select the object in the viewport.
4. Open the Modify panel to access that object's parameters.
5. When finished, choose Group menu > Close.

To assign materials within the group:

1. Select the grouped object.
2. Use Display In Viewports in the Level Of Detail utility to display the grouped object you want to assign the material to.
3. Drag the material from the Material Editor (or the Browser) over to the object in the viewport.
4. Choose Assign To Object in the Assign Material alert, and then click OK.

**NOTE** Be sure and choose Assign To Object. If you choose the default Assign To Selection, all objects in the group will be assigned the same material.

To dismantle a Level Of Detail object:

If you look at a Level Of Detail object in Track View, you'll see only the tracks for the sub-object that's currently displayed in the viewports. To see all sub-objects in Track View, you need to turn off Visible Objects.

If you need to dismantle a grouped Level Of Detail object, and restore its sub-objects to their independent states, follow these steps:

1. Open the Filters dialog in Track View, and turn off Visible Objects in the Show Only group box.
2. The tracks for all of the sub-objects in the Level Of Detail object are now visible.
3 Open the hierarchy of each of the sub-objects, and then select each of their Visibility tracks.

4 On the Track View toolbar, click the Delete Controller button.

5 If you also want to remove the grouping, select the grouped objects, and then choose Explode in the Group menu.
Interface

Level of Detail Set group

Lets you create a new set, and add or remove objects from the current set.
Create New Set  Creates a new Level of Detail set based on a currently selected group object.

Add To Set  Adds an object to the Level of Detail set. You must first attach the object you want to add to the group object. To add an object to the set, use Align to center the object with the group object. Select the object you want to add, and then choose Attach from the Group menu, and then click the group object. Finally, click the Add to Set button, and then click the object you want added.

Remove from Set  Removes the object highlighted in the list window from the current set. Note that the object then becomes visible in the viewports, but is still part of the group. To remove the object from the group, choose Group menu > Open, select the object you want removed, and choose Group menu > Detach. Select the group object again, and choose Group menu > Close.

Image Output Size group

Width/Height  The Width and Height spinners in this area are set to the current rendering output size each time you enter the Level of Detail utility. Using the spinners, you can change this to any resolution. If the percent of Target Image option is selected, as you change the Target Image Size, the threshold values change as well.

Reset to Current  Resets both spinners to the current rendering output size.

List window  Lists all of the objects in the group by complexity, with the least complex at the top of the list. The numbers at the left of each object name are the threshold values that indicate at what size the object will be displayed in the rendered scene. The numbers can be one of two types of units, pixels, or percentage of the target image. You set the type of unit in the Threshold Units group.

Display in Viewports  Displays in the viewport the object highlighted in the list window. Only one object in the group is displayed in the viewports at any time. As a default, the least complex object is displayed, but you can look at the other objects by highlighting them in the list and selecting this item. Double-clicking the object name in the list performs the same function.

Threshold Units group

The options in this group box let you choose between two types of threshold units. Switching between these two options does not alter the effect; it alters the method by which you set the thresholds.
**Pixels** The thresholds are determined by specifying the maximum pixel size of the image (measured diagonally). Use when you want to set the transfer thresholds using absolute rather than relative values.

**% of Target Image** Sets the thresholds based on the percentage of the size of the image (measured diagonally) relative to the size of the rendered output.

**Thresholds group**

**Min Size/Max Size** Sets the minimum size of the object before it's replaced by the less complex object, and the maximum size of the object before it's replaced by the more complex object. The values vary depending on the current type of Threshold Unit. The default threshold values are initialized so that the most complex object is 100 percent of the image output size. The remaining thresholds are set using an algorithm based on a ratio of the number of faces between each object. It assumes that all faces are the same size, and then picks thresholds so that the faces would remain a constant size as displayed on the screen. Usually, this will provide the type of smooth transition you need, but you can customize the threshold values. The threshold values are interrelated between the objects, so altering the minimum size of one object, for example, will also alter the maximum size of the next object.

**Reset All** Resets all thresholds for all objects in the list, using the previously described algorithm.

**TIP** You can use the Level of Detail utility to create objects that display very simple geometry in the viewports, while displaying complex geometry in the rendered scene. Create a grouped Level of Detail object consisting of only two objects, the complex object and the simple object. Select the simple object in the list window and, in the Thresholds are, set its Min Size and its Max Size to 0. This will display the simple object in the viewports, but the complex object will always appear in the rendered scene, regardless of its apparent size.

**Close button**

**Close** Closes the utility.

**Optimization Modifiers**

A few 3ds Max modifiers can help you lower the polygon count of your models.

- **MultiRes** on page 1537
The MultiRes modifier reduces the memory overhead needed to render models by decreasing the number of vertices and polygons. This is useful not only within 3ds Max, but for content creators who export models for use outside of 3ds Max, such as in Web-based 3D applications. MultiRes offers several advantages over the Optimize modifier, including faster operation and the ability to specify reduction as an exact percentage or vertex count.

- **Optimize on page 1557**
The Optimize modifier lets you reduce the number of faces and vertices in an object. This simplifies the geometry and speeds up rendering while maintaining an acceptable image. A Before/After readout gives you exact feedback on the reduction as you make each change.

- **ProOptimizer on page 1614**
The ProOptimizer modifier lets you select objects and interactively optimize them.

ProOptimizer is also available as a Batch ProOptimizer utility on page 2768, described in this chapter. This utility lets you optimize multiple scene files at the same time.

### Batch ProOptimizer Utility

Utilities panel > Utilities rollout > More button > Utilities dialog > Batch ProOptimizer

The Batch ProOptimizer utility lets you optimize multiple scene files at the same time. You can optimize 3ds Max (MAX) or Wavefront (OBJ) files.

The ProOptimizer feature is an optimization tool that helps you reduce the number of vertices (and so the number of faces) in an object while preserving the object’s appearance. Options let you maintain material, mapping, and vertex color information in the optimized model.

Optimizing objects can reduce a scene’s memory requirements, simplify modeling because objects have fewer faces, and improve the speed of viewport display and rendering time.

There are two ways to use ProOptimizer:

- **The ProOptimizer modifier on page 1614** lets you select objects and interactively optimize them.
The Batch ProOptimizer utility, described here, lets you optimize multiple scene files (MAX or OBJ files) at the same time.

**TIP** With the Batch ProOptimizer, you can optimize meshes before you import them. This can save time. The Batch ProOptimizer is also a good choice if the original meshes are extremely dense.

Original model
Vertices: 47226
Faces: 93792

Optimized model, Vertex % = 10.0
Batch ProOptimizer Rollout

Utilities panel > Utilities rollout > More button > Utilities dialog > Batch ProOptimizer > Batch ProOptimizer rollout

The Batch ProOptimizer rollout contains a couple of options, and also lets you open the Batch Optimization dialog, which contains the main controls for this utility.
Interface

**Batch Optimization** Click to open the **Batch Optimization dialog** on page 2771.

**Options group**

**Apply Modifier** When on, applies modifiers to objects before optimizing them. After optimization, ProOptimizer collapses the stack. Default=on.

When off, ProOptimizer optimizes base objects only, and does not collapse the stack.

**Validate 3ds Max dialogs automatically during batch processing** Opening and saving files can cause 3ds Max to display dialogs; for example, warnings about missing bitmaps or MAX files that were saved with an earlier version.

When on, ProOptimizer confirms these dialogs. This option prevents the dialog appearing interactively, interrupting the batch process and forcing you to intervene. Default=on.

When off, ProOptimizer does not confirm dialogs. If a 3ds Max dialog appears during batch processing, you must click to confirm it before the batch process continues.

**Batch Optimization Dialog**

Utilities panel > Utilities rollout > More button > Utilities dialog > Batch ProOptimizer > Click Batch Optimization. > Batch Optimization dialog
The Batch Optimization dialog lets you set up and launch a batch optimization task.

The first time you click Batch Optimization, ProOptimizer displays a dialog warning you to close any modeless 3ds Max dialogs and windows that might be open. The batch process runs more quickly if all such dialogs are closed before you begin.

If your current scene has unsaved changes, the ProOptimizer utility also prompts you to save the scene.
Interface

The Batch Optimization dialog has three panels, described in the topics that follow.

**Batch Optimization: Source Files Panel**

Utilities panel > Utilities rollout > More button > Utilities dialog > Batch ProOptimizer > Click Batch Optimization. > Batch Optimization dialog > Source Files panel

On the Source Files panel, you choose which files to optimize.

For options on how to save the optimized files, see Batch Optimization: Optimized Files Panel on page 2777.
Interface

- **Source Directory**
  - File Selection (no file selected)
  - Current Directory (C:\Program Files\Autodesk\3ds Max 2009\)
  - Selected Directory

- **Include Subdirectories**

**File Selection** Lets you choose an one or more files to optimize.

- **Select** Click to open a file selector that lets you choose the file or files to optimize.

**Current Directory** (The default.) Batch optimizes all the eligible files (MAX or OBJ files) in the current directory.

**Selected Directory** Batch optimizes all the eligible files (MAX or OBJ files) in the selected directory.

- **Browse** Click to display a directory browser that lets you choose the directory to process.

**Include Subdirectories** When on, ProOptimizer scans subdirectories and batch processes the eligible files in them. When off, it processes only files in the specified directory (the root). Default=on.

This option is disabled when File Selection is active.

**Batch Optimization: Optimization Panel**

Utilities panel > Utilities rollout > More button > Utilities dialog > Batch ProOptimizer > Click Batch Optimization. > Batch Optimization dialog > Optimization panel

On the Optimization panel, you choose the optimization levels to generate, and the options that will be active.

These settings are comparable to those for the ProOptimizer modifier on page 1614. The main difference is that you can choose to generate multiple files, each of which has a different level of optimization.
This panel is inaccessible if you haven’t used the Source Files panel to choose at least one file or directory to optimize. If you haven’t done so, this alert appears when you click the tab:

![Batch ProOptimizer Alert](image)

**Interface**

![Batch ProOptimizer Interface](image)

**Optimization Level group**

The controls in this group are comparable to the Vertex % control for the modifier (see ProOptimizer Modifier on page 1614), but allow you to generate multiple optimized scenes during batch processing.
**Predefined Vertex %** When Predefined Vertex % is active, you can generate up to five optimized files, using Vertex % values that you enter yourself. Defaults = 25, 50, 65, 75, 90.

If you enter fewer than five values, ProOptimizer generates only as many optimized files as Vertex % values you specify.

**Automatic Vertex %** When Automatic Vertex % is active, ProOptimizer generates multiple optimized files at regular Vertex % intervals. Each interval is greater than zero and less than 100 percent (zero percent would leave no geometry at all, and 100 percent is just the original model).

The number you choose is the number of optimized files that ProOptimizer generates. Default=9.

For example, at the default count of 9, the optimized files use Vertex % values of 10, 20, 30, through 90. If you change the count to 3, the Vertex % values used are 25, 50, and 75. A count of 50 (too large to be practical) would use Vertex % values of 2, 4, 6, through 98.

For options on how to save the optimized files, see Batch Optimization: Optimized Files Panel on page 2777.

**Optimization Options group**

**Crunch Borders / Protect Borders / Exclude Borders** See Optimization Mode Group on page 1621.

**Optimize Hidden Objects** When on, ProOptimizer optimizes hidden objects as well as visible ones. When off, ProOptimizer optimizes visible objects only. Default=on.

**Merge Vertices** When on, applies the Merge Vertices tool before optimizing. Default=off.

**TIP** Use this tool if a model has faces that are disconnected, but should not be.

- **Threshold** The Threshold setting for the Merge Vertices tool. See Merge Tools Group on page 1634.

**Merge Faces** When on, applies the Merge Faces tool before optimizing. Default=off.

**TIP** Use this tool if the model has surfaces that are subdivided into coplanar faces.

- **Threshold Angle** The Threshold Angle setting for the Merge Faces tool. See Merge Tools Group on page 1634.
**Materials and UVs group**

These are equivalent to the modifier options. See Materials and UVs Group on page 1625.

**Vertex Color group**

These are equivalent to the modifier options. See Vertex Colors Group on page 1629.

**Symmetry Options group**

These are equivalent to the modifier options. See Symmetry Options Rollout on page 1638.

**Normals group**

These are equivalent to the modifier options. See Normals Group on page 1632.

**Advanced Options group**

These are equivalent to the modifier options. See Advanced Options Rollout on page 1639.

---

**Batch Optimization: Optimized Files Panel**

Utilities panel > Utilities rollout > More button > Utilities dialog > Batch ProOptimizer > Click Batch Optimization. > Batch Optimization dialog > Optimized Files panel

On the Optimized Files panel, you choose the location of the generated files, their file name format, and file format.

This panel is inaccessible if you haven’t used the Source Files panel to choose at least one file or directory to optimize. If you haven’t done so, this alert appears when you click the tab:
Interface

File Names group

These options tell ProOptimizer how to name the files it generates.

Number by order of creation (The default.) When this option is active, ProOptimizer gives the files it generates the name of the original file, followed by a value that shows the order in which the file was created.
Number by optimization level When this option is active, ProOptimizer gives the files it generates the name of the original file, followed by a value that shows the optimization level (Vertex % value) used to create the file.

Auto rename duplicate files When on, ProOptimizer renames each file it generates if there is a conflict with the name of an existing file. When off, ProOptimizer overwrites existing files that have the same name. Default=on.

Prefix to add to the name Lets you specify a prefix to add to the name of all files generated by ProOptimizer.

Suffix to add to the name Lets you specify a suffix to add to the name of all files generated by ProOptimizer.

Optimized Files Directory group

These options tell ProOptimizer where to save the files it generates.

In the same directory as the source files When active, ProOptimizer saves optimized files in the same directory as the source files.

In a subdirectory of the source files (The default.) When active, ProOptimizer saves optimized files in the directory whose name is shown in the Directory Name field.

In the selected directory When active, you can click the Browse button to choose a particular directory in which to save the optimized files.

Directory Name field When you choose either a subdirectory or specify a particular directory, this field shows the name of the directory used. Default="\Results".

NOTE The combination of defaults means that by default, optimized files are saved in a folder named Result, which is a subdirectory of the directory where the source files are located.

- Browse When “In the selected directory” is active, click Browse to display a directory browser that lets you choose the folder in which to save the optimized files.

Re-create directory tree When on, and “In the selected directory” is active, ProOptimizer creates subdirectories that match the original source tree. When “In a subdirectory of the source files” is active, this option is always on. Default=on.

This option is disabled if you turn off Include Subdirectories on the Source Files panel on page 2773.
**Optimized Files Format group**

With these options, you can choose the format of the generated files.

**Keep source file format if possible, otherwise convert to selected format** (The default.) When active, optimized files are saved in the same format as the source file, unless this is impossible for some reason, in which case they are saved in the format specified by the drop-down list.

**Convert to the selected format** When active, optimized files are saved in the format specified by the drop-down list.

**File Format drop-down list** Lets you choose between MAX (3ds Max) or OBJ (Wavefront) file formats.
Precision and Drawing Aids

3ds Max provides tools that give you control over the positioning and alignment of objects in 3D space. With these tools, you can do the following:

- Choose display units from the most common real-world measuring systems or define your own.
- Use the home grid as a construction plane, or use grid objects to position custom construction planes.
- Select different options to align objects with grids, points, and normals.
- Use 3D object snaps on a modeless dialog as you build and move geometry in your scene. Grid points and lines are among the many snap options.
- Use "helper objects" in your work. This category includes grid objects as well as objects used for positioning and measurement.
Tools for Precision

A set of interrelated tools in 3ds Max gives you precise control of the scale, placement, and movement of objects in your scene. These are especially important tools for those who build precise models in real-world units of measurement.

Basic Tools

The tools for precision are grouped as follows:

Units Define different measurement systems. Besides the generic unit, you have your choice of feet and inches in both decimals and fractions. Metric units range from millimeters to kilometers. You can also define other units.
See Using Units on page 2784.

**Grids** Include the home grid and special grid objects. Both types of grid can act as construction planes. 3ds Max constructs objects using the orientation and position of the active grid. While the home grid is fixed in world space, you can rotate grid objects and place them anywhere in a scene, and align them to other objects and surfaces. You can also give each grid object its own spacing, and display any grid as a dedicated viewport.

See Using Grids on page 2785.

**Object alignment** Matches an object with the position, orientation, or normal of another object, or to a point in space.

See Alignment on page 2799.

**Object snaps** Ensure precise placement when creating and rearranging objects. Keyboard shortcuts let you change object snaps as you work. You can also set snaps to find grid lines and intersections. An angle snap sets the increment for rotation, and a percent snap sets the increment for scaling.

See Using Snaps on page 2804.

**Helpers** These are specialized tools in the same category as grid objects. For example, the Tape object measures distances in current units, and the Protractor object measures angles. The Dummy helper is useful in constructing hierarchies, and the Manipulator helpers let you use custom controls in the program interface.

See Helpers on page 2837.

**Additional Tools** Rounding out the set of precision aids are tools and utilities for checking geometry, measurement, and rescaling units.

See Drawing Assistants on page 2873.

**How the Tools Work Together**

The tools themselves establish a general order of use and interaction, although you can always change settings as needed without following this sequence.

- Choose a measuring unit. The default is generic units, sufficient for many purposes.
- Set grid spacing (the size of the smallest square), based on the measuring unit. The home grid and grid objects can have their own spacing, separate from the grid spacing.
- Move and align grid objects to a useful orientation.
Set or vary snap settings as needed in your work.

Use other helper objects like Point and Tape as part of the precision process.

As you work, you can change your settings (including the measuring unit) without losing any precision.

### Using Units

Units are the key to connecting the three-dimensional world of 3ds Max with the physical world. You define the units you want to use from the Units Setup dialog on page 8366.

#### Changing Display Units

When you change display units, 3ds Max displays measurements in the new unit for your convenience. All dimensions are displayed in the new unit. Essentially, you’re using a new “measuring stick.” No object is changed in this process. As in the physical world, objects in the scene maintain their absolute size, regardless of how you measure them.

#### Type-In Entry

When you enter any dimension, 3ds Max always assumes the number you enter is expressed in the current units. You can also enter a series of numbers: 3ds Max then converts their sum into the current unit. Here are some examples that assume the current units are in centimeters:

- When you enter a dimension of 1’ (one US foot), it converts to 30.48cm.
- If you enter a series of numbers such as 14 286 175 (separated by spaces), the series is totaled to 475.0cm.
- If you enter 1’ 1 (one US foot and 1 centimeter), this is converted and summed into 31.48cm.

When you use US Standard as the display unit scale, you can select either feet or inches as the default for type-in entry. If you select feet and enter 12, the result is 12’ 0”. However, if you enter 1’ 2, 3ds Max identifies the second digit as inches, producing 1’ 2” as the result.
In any unit system, you can enter fractional amounts. For example, assume you’re working in US Standard with feet as the default:

- If you enter 18/3, the result is 6'0".
- If you enter 18/3", the result is 0'6".
- You can specify units in a different system, and they are converted on the fly. For example, if you enter 18/3cm, the result is 0'2.362".

**Understanding the System Unit**

3ds Max keeps track of all measurements in its own internal system unit. No matter what kind of display units you use, measurements are stored in this absolute unit for storage and computation. The default system unit is defined as 1.000 inch. As long as the system unit is left at one inch, you can freely share models and change units on the fly with no effect on the underlying geometry. Except in rare circumstances, you never need to change this default scale. This means you can merge a model created with any standard unit into your scene at true scale.

You can change the system unit setting on the System Unit Setup dialog, available from the Units Setup dialog on page 8366. Changing the system unit is recommended only if your scene has very small (less than one inch) or very large dimensions. See System Unit Setup Dialog on page 8370 for more information.

If you do need to change the system unit, change it before you create or import geometry. Do not change the system unit in an existing scene.

**Using Grids**

Grids are two-dimensional arrays of lines similar to graph paper, except that you can adjust the spacing and other features of the grid to the needs of your work.
One grid establishes the pitch of the boat, another the pitch of the ship

Grids have these primary uses:

- As an aid in visualizing space, scale, and distance.
- As construction planes where you create and align objects in your scene.
- As a reference system for using the Snap feature to align objects.

Home Grid and Grid Objects

3ds Max provides two kinds of grids: the home grid and grid objects. In addition, it includes the AutoGrid feature, an automated way of creating grid objects.

Home grid The home grid is defined by three planes along the world X, Y, and Z axes. Each of these axes passes through the world coordinate system’s origin point (0,0,0). The home grid is fixed; it cannot be moved or rotated.
- The home grid is visible by default when you start 3ds Max, but its display can be turned off.
You can use any view of the home grid as a construction plane by drawing in the viewport in which the grid's view appears.

See Viewing and Navigating 3D Space on page 65 for a complete introduction to the home grid.

Grid objects A grid object is a helper object you can create whenever you need a local reference grid or construction plane somewhere other than the home grid.

- You can have any number of grid objects in your scene, but only one can be active at a time.
- When active, a grid object replaces the home grid in all viewports.
- Each grid object has its own set of XY, YZ, and ZX planes. You can freely move and rotate grid objects, placing them at any angle in space, or attach them to objects and surfaces.
- You can change a viewport to display a plan (top) view of any active grid object.
- Grid objects can be named and saved like other objects, or used once and deleted.

AutoGrid This feature lets you create new objects and grid objects off the surfaces of other objects on the fly. See AutoGrid on page 2792.

Using the Home Grid

The home grid provides ready-to-use construction planes, much like a leveled building site marked with stakes and strings. When you create an object in a viewport, the new object is placed on the home grid plane of that viewport.

To use the home grid effectively for construction, you often need to change the defaults to the job at hand, analogous to moving the stakes and strings to match your own site plan.
Using the home grid to position houses

Changing Home Grid Settings

The home grid is a single system; its three planes use the same settings for grid spacing and major line divisions. You change these settings from a single panel of the Grid and Snap Settings dialog.

To access the Home Grid panel, do one of the following:

1. Choose Tools menu > Grids And Snaps > Grid And Snap Settings, then click the Home Grid tab.
2. Right-click any snap button on page 2807, then click the Home Grid tab.

Setting Grid Spacing

Grid spacing is the size, in current units, of the grid's smallest square. The basic idea is to choose a grid spacing that corresponds to your unit of measurement, then choose a larger spacing for multiple units.

For example, if you have units set to centimeters, you might make one grid space equal to 1.000 (one unit, or one centimeter in this case).
Setting Major Grid Divisions

The home grid displays heavier or “major” lines to mark groups of grid squares. You can use these to represent larger units of measurement.

For example, if you use a grid spacing of one centimeter, you might use a value of 10 so the major grid divisions represent one decimeter.

Setting Color and Intensity

To improve grid visibility, you can change the intensity or color of the home grid. Choose Customize menu > Customize User Interface > Colors panel on page 8272.

Using Grid Objects

Grid objects let you bypass the home grid and work on separately defined grids to create and position objects. You can use as many grid objects as you like, each serving as a custom construction plane with its own grid settings.
Grid objects are 2D parametric objects, with adjustments for overall size and grid spacing. You can adjust their orientation in world space, and match them to a particular surface or object.

**To activate a grid object:**
1. Create or select a grid object.
2. Choose Views > Grids > Activate Grid Object.

**To deactivate a grid object, do one of the following:**
- Select and activate another grid object.
Choose Views > Grids > Activate Home Grid.

Delete the grid object.

Creating and Modifying Grid Objects

You find Grid objects in the Create panel > Helpers category.

When creating an object, you can also create a temporary "AutoGrid" grid object that's tangent to an existing object surface at the point you click. To do this, turn on the AutoGrid on page 2792 check box in the Object Type rollout. You can save this grid by holding the Alt key before you click.

Grid objects are named when you create them and are saved with the scene. You can delete them at any time.

Like other objects created in 3ds Max, standard grid objects are placed on the grid of the current viewport. By default, this is a plane of the home grid, but can also be another activated grid object.

For more information on grid object settings, see Grid on page 2847.

Viewing Grid Objects

An activated grid helper object on page 2847 creates a true plane in 3D space. No matter how small an activated grid object appears on the screen, its plane is effectively infinite, just as if it were a plane of the home grid. However, you can view a given grid object in different ways.

Setting the Display Plane

You can adjust the visible plane of a selected or activated grid object on the Modify panel.

To set the display plane:

1. Open the Modify panel to display the Parameters rollout for the selected grid.

2. In the Display group, choose any of the three planes: XY, YZ, or ZX. The grid rotates in world space to display the corresponding plane, always based on the grid's local axis.

You can move or rotate a grid, either before or after setting its display plane.
Setting Grid Views

You can set the view in any viewport to an orthographic view as well as the display view.

To set grid view:

1. Activate the grid object. on page 2850
2. Click or right-click the Point-Of-View (POV) viewport label and from the
   POV viewport label menu on page 8122 choose Grid to display a submenu
   of possible views.
3. Choose Front, Back, Top, Bottom, Right, Left, or Display Planes. Display
   Planes corresponds to the current setting on the Parameters rollout (XY,
   YZ, or ZX).
   The viewport now shows this view of the grid.

You can set different viewports to different views of the grid. Objects are always
created on a view's orthographic grid, even if you rotate the angle of view. In
other words, you can set up a convenient view and still construct on the
chosen plane.

Deactivating Grid Objects

You can deactivate a grid object in any of the following ways:

- Select and activate another grid object.
- Choose Views > Grids > Activate Home Grid.
- Delete the grid object.

When you deactivate a grid object, any viewports based on that grid switch
to the corresponding orthographic view. For example, a Grid (Front) viewport
becomes a Front viewport. A Grid (Display Planes) viewport always switches
to Top view, regardless of the currently displayed plane.

AutoGrid

Create panel > Any object category > Object Type rollout
Extras toolbar > AutoGrid

AutoGrid lets you automatically create, merge, or import objects on the surface of other objects by generating and activating a temporary construction plane based on normals of the face that you click. This serves as a more efficient way of stacking objects as you create them, rather than building objects and then aligning them as a separate step.
AutoGrid used to position the second block on top of the first

You can use objects within an XRef scene as reference when AutoGrid is on.

**NOTE** If the Smooth check box is turned on in the Parameters rollout of a parametric object, the construction plane is placed tangent to the face of the surface implied by any smoothing present on the surface, not the actual face of the surface.

**Procedures**

Example: To create a box aligned to another object using a temporary construction grid:

1. Create or load a scene containing an object to which you want to align a new box.

2. On the Create panel > Standard Primitives > Object Type rollout, click Box.

3. Turn on AutoGrid.
4 Merge the object you want aligned.

5 Move your cursor over the object to which you want to orient the box you are about to create.
The cursor includes an X,Y,Z tripod to help you orient the position of the new object. As you move over the object, the cursor aligns the Z axis to the surface normal.

6 When the orientation is as you want it, click and use the standard drag-release-move-click method to create the box. The box will be created on the designated surface.

When you click, a temporary, automatic grid is created, and the newly created object is aligned to that grid.

Interface

Object Type rollout

AutoGrid AutoGrid is available only after you select an object button (such as Box). When you turn AutoGrid on, the cursor includes an axis tripod to help you orient the grid. Before clicking and as you position the cursor over a visible mesh object, the cursor jumps to the nearest point on that surface. The tripod's X and Y axes form a plane tangent to the object surface (forming an implied construction grid), and the Z axis is perpendicular to the plane. After creating the object, 3ds Max places it on the temporary construction grid. When creating an object, if the cursor isn't over another object, 3ds Max places the object on the current active grid.

TIP When you create an object that requires multiple clicks, AutoGrid applies only to the first click. So, for instance, if you want to create a Line spline on page 584 that snaps to the faces of a sphere, turn on Snaps on page 2807 (press the S key), and then open the Grid And Snap Settings dialog on page 2819 and turn on Face.
**NOTE** To make the grid permanent, hold down the Alt key before you click. The grid becomes active and 3ds Max turns AutoGrid off.

**Grid Commands**

Tools menu > Grids and Snaps

The Grids commands on the Tools menu > Grids And Snaps submenu provide functions to manipulate the home grid on page 8600 and grid objects on page 8597.

The Snaps system uses grids both as visual references and as physical snap references. In addition, grids serve as construction planes, because the objects you create are built on the active grid in the active viewport.

As a default, 3ds Max uses a construction grid called the home grid. The home grid is the basic reference system, and is defined by three fixed planes on the world coordinate axes. It provides ready-to-use construction planes, intersecting at right angles through the origin. When the home grid is displayed, each orthographic viewport on page 8668 is coplanar (parallel) with one of the grid faces.

A custom grid, or grid object, is a helper object that you can use in place of the home grid. While the home grid is three intersecting planes whose orientation is fixed in world space, a grid object is a free-floating, 2D grid that you can position anywhere and rotate freely, letting you construct objects at any angle in world space. You can also generate grids automatically on existing geometry when creating objects by using AutoGrid on page 2792.

**Show Home Grid**

Views menu > Grid > Show Home Grid

Click or right-click the General viewport label (“+”). > General viewport label menu on page 8117 > Show Grids

Keyboard > G

Show Home Grid toggles the display of the home grid on page 8600 in the active viewport.

Grids are used both as visual references and as physical snap references by the Snap system. In addition, grids are construction planes, since the objects you create are built on the active grid in the active viewport.
As a default, there is a home construction grid called home grid. The home grid is the basic reference system, and is defined by three fixed planes on the world coordinate axes. It provides ready-to-use construction planes, intersecting at right angles through the origin. When the home grid is displayed, each orthographic viewport on page 8668 is coplanar (parallel) with one of the grid faces.

**Procedures**

To toggle the display of the home grid, do one of the following:

1. Choose Views menu > Grids, and click Show Home Grid.
2. Click or right-click the General viewport label (“[ + ]”) and choose Show Grids on the General viewport label menu on page 8117.
3. Press G on the keyboard.

**Activate Home Grid**

Activate a grid other than the Home grid. > Views menu > Grids > Activate Home Grid

This command activates the home grid on page 8600 as the construction grid, and deactivates the active grid object on page 8597.

**Procedures**

To return to the home grid, do one of the following:

- Choose Views menu > Grids > Activate Home Grid.
- Right-click the selected grid object, and choose Activate Home Grid from the quad menu.
  
  This deactivates the grid object and activates the home grid in all views.

**Activate Grid Object**

Select a grid object. > Views menu > Grids > Activate Grid Object
This command activates the selected grid object on page 8597 as the construction grid and deactivates the home grid on page 8600. This menu item is available only when a grid object is selected.

Procedures

To activate a grid object:

1. Select a grid object.
2. Do one of the following:
   - Choose Views menu > Grids > Activate Grid Object.
   - Right-click the selected grid object and choose Activate Grid from the quad menu.
     The grid object changes to show its internal grid structure. Except for its main axes, the home grid disappears in all viewports.
3. Right-click the selected grid object and choose Activate Grid from the quad menu.
   The grid object changes to show its internal grid structure. Except for its main axes, the home grid disappears in all viewports.

Align Grid to View

Activate a grid object. > Views menu > Grids > Align Grid to View

This command aligns a grid object on page 8597 with the current view. The grid object is aligned so that it's coplanar with the view and oriented with the top of the grid at the top of the view.

Procedures

To align a grid object with a viewport:

1. Activate a grid object.
2. Click or right-click in a viewport.
3. Right-click to open the quad menu.
4. In the Tools 1 quadrant, choose Align Grid to View.
   The grid object rotates to align itself with the selected view. The grid object is now planar, or parallel, with the viewport.
Choose Views menu > Grids > Align Grid to View. The grid object rotates to align itself with the selected view. The grid object is now planar, or parallel, with the viewport.

Alignment

3ds Max provides a range of tools for aligning objects. This section includes a couple of brief introductory topics to alignment in 3ds Max; for specific information on the available alignment functions, see Align Flyout on page 966 and Clone and Align Tool on page 961.

Aligning Objects

You can align a selection consisting of one or more objects, called the source, with a target object. There are many uses for this feature. For precision, an important use is grid alignment. You can create a new grid object and align it to an existing object, either manually after creation or automatically during creation using the AutoGrid on page 2792 feature. Conversely, you can move an object onto a grid anywhere in your scene.
Aligning objects by the centers, bottoms, or tops of their bounding boxes

**Source and Target Objects**

Alignment involves two entities: one is the source object or selection set, where the process begins; the other is the target object, where the selection process ends.

**Source object** Object or objects you want to move into alignment with another object. You select one or more source objects to begin the alignment process.

**Target object** Object used to define the alignment. You select the target object during the alignment process. It cannot be selected beforehand.

After selecting the source, choose Tools menu > Align or click the Align button on the Main toolbar, and then select the target object.

Next, the Align dialog appears. For discussion of the Align options, see Align on page 967.
Setting a Coordinate System

The effects of alignment depend on the current reference coordinate system, such as View, World, or Local. You should decide which system you want to use before beginning alignment.

Reference Coordinate System Determines the axes used for positional alignment and the size of the bounding box for maximum and minimum positions.

To align objects using active grid axes:

■ Choose Grid as the reference coordinate system from the list on the toolbar.

To align two objects using their own axes:

■ Choose Local as the reference coordinate system. Alignment is then strictly between the two objects. Object bounding boxes determine maximum and minimum positions.

As a reminder to you during the alignment process, the current reference coordinate system appears in parentheses following the Align Position label in the Align Selection dialog.

Basics of Aligning Objects

Alignment controls are on a single dialog. As you make a setting, the object being aligned moves immediately to the new position. This lets you experiment with alignment until you get what you want. Settings can be made in any order.

You can also work step-by-step, by applying position choices, for example, before deciding on final orientation. You can cancel at any time, returning the scene to its original state. You can also undo any alignment and start over.
Aligning Multiple Objects

Aligning multiple objects to the arrow object (each photo is adjusted in a different correction)

When you select multiple objects for alignment, the same settings apply to all of them. However, the effect on each source object can be different. In practice, you're aligning separate objects at the same time with the same settings.

To align a collection of objects as a single unit, select the objects and group on page 243 them. The alignment now takes place relative to the pivot and bounding box of the entire group.

Sub-Object Alignment

You can use Align with any selection that can be transformed. The tripod axis becomes the source for alignment. You do this by accessing the sub-object level of the object before clicking Align.
Aligning Normals

3ds Max lets you align the normals between any two objects. In the case of mesh objects, the alignment is between individual faces, because each face has its own normal. See Normal Align on page 973.

Normal on the front of the bolt is aligned with the normal of a face on the assembly.

Basics of Aligning Normals

Before you begin, select a view that lets you see both objects you want to align. If necessary, you can navigate the view after selecting the first normal. To see face normals clearly, work in a wireframe viewport.

For details on the procedure and dialog settings, see Normal Align on page 973.

Other Align Options

The Align flyout on the main toolbar has other buttons that provide specialized alignments.
**Align Camera** Orients a camera viewport to a selected face normal, with the normal in the center of the viewport and on the axis of the camera. See Align Camera on page 978.

**Align to View** Orients a local axis of an object or sub-object selection with the current viewport. Options on the dialog are interactive, as they are on the Normal Align dialog. See Align to View on page 979.

**Place Highlight** Orients a face normal to a light. See Place Highlight on page 976 and Lighting in 3ds Max on page 5328.

### Using Snaps

Standard snaps give you control in creating, moving, rotating, and scaling objects. You access the 3ds Max snap features from buttons on the main toolbar.
Snapping to: endpoints, midpoints, edges

You make most snap settings on Grid And Snap Settings, a modeless dialog with four panels. You can move this dialog to any convenient location on your screen and turn options on and off as you work. Panels are reset to defaults for each new session.

You can also make commonly used snap settings on the Snaps toolbar on page 2821. In addition, a Snaps quad menu on page 8062 gives you quick access to some snap options.

Snap settings are stored in the 3dsmax.ini file rather than in the MAX file. This means that the state of the snap settings persists from session to session without your having to modify the maxstart.max file.

**Grid And Snap Settings Dialog and Snaps Toolbar**

The most commonly used grid and object snaps appear on the Grid and Snap Settings dialog on page 2819. This is the general sequence for using these snaps:
1 Turn on snapping by clicking the Snaps Toggle button on the main toolbar, and then right-click this button to display the Grid And Snap Settings dialog.

Two sets of snap types are available: Standard (the default) and NURBS. Both are discussed in Snap Settings on page 2819.

You can also make commonly used snap settings on the Snaps toolbar on page 2821.

2 Turn on OSNAPS on the status bar, then right-click this button to display the Grid and Snap Settings dialog.

3 By default, only the Grid Points snap type is active. Turn on other snap types to activate them. When you create or move objects, these snaps are now in effect anywhere in 3D space, and unaffected by the current transform coordinate system.

As you move the cursor, each snap type is marked by a distinctive icon shown on the Snap panel. The current icon indicates the type and position of the next snap.

Grid points and grid lines are secondary to the other snap types. For example, if both Grid Point and Vertex are active, 3ds Max snaps to a vertex in preference to an equally close grid point.

4 Turn snaps on and off as needed; the easiest way is by pressing the $ key.

For more information on snaps, see 2D Snap, 2.5D Snap, 3D Snap on page 2807 and Snap Settings on page 2819.

Snap Override

Snap Override bypasses currently selected snaps. You use a keyboard-mouse combination or a keyboard shortcut to define a new snap for the next click. You can override on the fly, one snap at a time.

For example, while creating a spline between grid points, you might need to snap to a vertex or midpoint of an object. This is the general procedure:

1 As you use preset snaps to create or move an object, hold down Shift and right-click. This pops up a three-quadrant right-click menu, which you can use to override the current snap setting(s).
NOTE You can begin the creation or transformation process before accessing the override menu. This typically means that you'll be holding down the left button as you Shift+right-click.

2 From the Snap Override quadrant, choose the snap type you want to use. The cursor switches to this type.

3 Make the snap. After the snap, currently set snaps are back in effect.

In addition, the Snap Override quadrant lets you reuse the last override you used (listed by name), and gives you an option for None. None turns off snapping entirely on the next click. The Snap quad menu also contains an Options quadrant, with toggles for snapping within current transform constraints (default=off) and snapping to frozen objects (default=off).

Snap Commands

main toolbar > Snap buttons
Menu bar > Tools menu > Grids and Snaps submenu

Snaps help you precisely control the dimensions and placement of objects when you create them or transform them. There is also a Spinner snap for controlling the entry of values.

You can use objects within an XRef scene as snap references.

The snap commands listed below and described in this section are found on the main toolbar (except for Ortho and Polar; see their topics for details). They’re also available from the Grids And Snaps submenu of the Tools menu.

2D Snap, 2.5D Snap, 3D Snap

Main toolbar > 2D Snap, 2.5D Snap, or 3D Snap on the Snaps Toggle flyout
Tools menu > Grids and Snaps > Snaps Toggle
Keyboard > $ S

The buttons on the Snaps Toggle flyout on page 8582 provide control over the range of 3D space where snaps are active. A wide variety of snap types is available from the Snaps dialog on page 2819, which you can use to activate different snap types as you work.
Object Snapping

Object snapping lets you snap to specific portions of existing geometry during creation and transforms of objects or sub-objects. You can also snap to the grid, and you can snap to tangents, midpoints, pivot points, face centers and other options.

The mode you choose maintains its state when you switch levels.

Transforming Around Snap Points

When snapping is on and Auto Key on page 8090 is off, rotations and scales occur about the snap point. For example, if you're using Vertex snapping and you're rotating a box, you can rotate it about any of its corner vertices. See To use snaps to move an absolute distance: on page 2809 below.

When Auto Key is on and either Select And Rotate or Select And Scale is active, the Snaps Toggle button is disabled, and rotation and scaling take place about the pivot point of the object.

Procedures

To turn snap off during a transform:

Press S to toggle snapping off when it gets in the way. Press S again to turn it back on.

To use snaps to move a relative distance:

1. Turn on Snaps with the S key, or by clicking the Snaps Toggle button.

2. Lock your selection set with the spacebar, or by clicking Lock Selection on the status bar.

3. Wherever you click in the viewport, the snap will stay relative to the distance of your cursor to the object.
To use snaps to move an absolute distance:

1. Turn on Snaps Toggle.
2. Click the selection. Snap uses the point you click for the snap source.
3. Move to whatever target snap you desire. The object will snap to an absolute distance.

To rotate a box around a vertex using snaps:

1. Make sure the Auto Key button is off.
2. Select the box.
3. On the Main toolbar, click Select And Rotate.
4. Turn Snaps on by pressing $S$ on the keyboard.
5. On the Tools menu, choose Grids And Snaps > Grid And Snap Settings. Turn on Vertex and turn off Grid Points.
7. On the toolbar, choose Use Transform Coordinate Center (hold the mouse down on Use Pivot Point Center to expose the flyout).
8. Move your cursor over any vertex in the box. The blue snap cursor will appear, and then you can rotate the box around that vertex.

Interface

There are three snap modes:

- **2D Snap** The cursor snaps only to the active construction grid, including any geometry on the plane of that grid. The $Z$ axis, or vertical dimension, is ignored.

- **2.5D Snap** The cursor snaps only to the vertices or edges of the projection of an object onto the active grid.

Suppose you create a grid object on page 8597 and make it active. You then position the grid object so you can see through the grid to a cube further off...
in 3D space. Now with 2.5D set, you can snap a line from vertex to vertex on
the distant cube, but the line is drawn on the active grid. The effect is like
holding up a sheet of glass and drawing the outline of a distant object on it.

3D Snap  This is the default tool. The cursor snaps directly to any
gometry in 3D space. 3D snapping lets you create and move geometry in all
dimensions, ignoring the construction plane.
Right-click this button to display the Grid and Snap Settings dialog on page
2819, which lets you change snap categories and set other options.

Angle Snap Toggle

Main toolbar > Angle Snap Toggle
Tools menu > Grids and Snaps > Angle Snap Toggle
Keyboard > A
Angle Snap Toggle determines the incremental rotation for a number of
features, including the standard Rotate transform. As you rotate an object (or
group of objects), the object moves around a given axis in the increment you
set.

Angle Snap Toggle also affects Pan/Orbit camera controls, FOV on page 8569
and Roll camera settings, and Hotspot/Falloff on page 8604 spotlight angles.

Procedures

To turn angle snap on:
- Click Angle Snap Toggle on the Main toolbar. When on, angle snap affects
  all rotational transforms.

To rotate an object an even number of degrees:
- Turn on Angle Snap Toggle and rotate the object.
  The rotations take place in 5-degree increments as a default.

To rotate an object a precise degree of rotation, do one of the following:

1  Click Select And Rotate, then right-click it to display the Transform
Type-In dialog on page 899. Enter the exact rotation you want.
2 Choose Select And Rotate from the quad menu, then right-click it to use the Transform Type-In dialog on page 899. Enter the exact rotation you want.

3 Right-click Angle Snap Toggle and click the Options tab on the dialog that is displayed. Set the Angle value in the General group to the precise degree of rotation you need, then rotate the object. Rotation snaps to the angle increment you specified.

**Interface**

The angle increment is set on the Options panel of the Grid and Snap Settings dialog on page 2819. Right-click the Angle Snap Toggle button to display the Options panel of the Grid and Snap Settings dialog. The default is 5 degrees.

### Percent Snap Toggle

Main toolbar > Percent Snap Toggle

Tools menu > Grids and Snaps > Percent Snap Toggle

Keyboard > Shift+Ctrl+P

Percent Snap Toggle increments scaling of objects by the specified percentage.

**Interface**

The snap percent increment is set in the Grid And Snap Settings dialog. The default is 10 percent. Right-click the Percent Snap Toggle button to display the Grid and Snap Settings dialog on page 2819.

This is a general-purpose snap system that applies to any operation involving a percentage, such as scaling or squashing.

### Spinner Snap Toggle

Main toolbar > Spinner Snap Toggle

Spinner Snap Toggle sets the single-click increment or the decrement value for all of the spinners in 3ds Max.
Procedures

To set and toggle spinner snap:

1. Do one of the following:
   - Choose Customize menu > Preferences.
   - Right-click the Spinner Snap Toggle button on the main toolbar.
     Either method opens the Preference Settings dialog > General panel.
     The two controls for spinner snap are in the Spinners group on this panel.

2. Set a value in the Snap field.

3. Turn on Use Snap.
   When you exit the dialog, the Spinner Snap Toggle button is turned on.

4. As you work, use the Spinner Snap Toggle button to toggle the alternate setting.

Interface

The amounts for Spinner Snap are controlled by settings on the General panel on page 8299 of the Preferences dialog. Default=1.0.

Ortho Snapping Mode

When drawing a Line spline on page 584 or Wall object on page 491, Ortho Snapping Mode constrains line creation to the horizontal or vertical directions relative to the active grid. That is, with Ortho on, you can draw only lines that are parallel to lines of the active grid.

Ortho is particularly useful for drawing plans where all lines must be at 90 degrees to each other, such as a house plan. To constrain line-drawing to other angle increments, use Polar Snapping Mode on page 2814 instead.

IMPORTANT By default, Ortho Snapping Mode is not directly accessible in the 3ds Max user interface. To add it as a button on the Snaps toolbar, follow this procedure on page 2813.
The following provisions apply to using Ortho:

- Use of Ortho is mutually exclusive of use of the Polar Snapping Mode toggle on page 2814; only one can be active at a time.

- Ortho Snapping applies primarily to the creation of line splines and wall objects. It can be used while creating other objects, but results are likely to be unsatisfactory.

Ortho mode displays a compass which gives a readout of the current angle of the input relative to the positive direction of the local X axis.

**NOTE** If you hold down the Alt key in Ortho mode, the next point becomes doubly constrained by both the previous point and the first point of the current object. This allows you to close splines precisely. In this mode, two compasses are displayed; one each at the first *and* previous points.

### Procedures

**To add Ortho Snapping Mode to the Snaps toolbar:**

1. Open the Snaps toolbar, if necessary. To do so, right-click an empty part of the main toolbar, such as the area directly below one of the drop-down lists, and choose Snaps.

2. Drag the right end of the toolbar to the right to make room for a new button.

3. Choose Customize menu > Customize User Interface. This opens the Customize User Interface dialog.

4. On the dialog, click the Toolbars tab.

5. Scroll down the Action list on the dialog to the Ortho Snapping Mode item. You can jump to the O section by clicking any item in the list and then pressing O on the keyboard.

6. Drag the Ortho Snapping Mode item from the list to the empty section of the Snaps toolbar. This adds the button to the toolbar.

7. Close the Customize User Interface dialog. 3ds Max automatically saves the toolbar in its revised state and makes the new button a permanent part of the user interface.
To use Ortho:

1  Turn on the Ortho Snapping Mode button.
   The button appears depressed.
2  Begin to draw a Line spline.
   An orange compass appears where you place the first point, along with
   a red number indicating the angle of the current line segment with the
   positive direction of the local X axis.
3  Move the mouse cursor around in the viewport.
   The line jumps to 90-degree angle increments on the local X axis, while
   the compass reading updates to show the current angle.
4  Click to place the next vertex.
5  Repeat steps 3 and 4 until you're ready to complete the shape.
6  Do either of the following:
   ■ To finish the shape at the most recent vertex without closing it,
     right-click anywhere.
   ■ To finish the shape by closing it, position the mouse cursor close to
     the first point and then click. A small dialog opens asking if you want
     to close the spline; click Yes.

Polar Snapping Mode

When drawing a Line spline on page 584 or Wall object on page 491, Polar
Snapping Mode constrains line creation to angle increments determined by
the Angle Snap setting relative to the active grid. To change the Angle Snap
setting, right-click the Angle Snap Toggle button on the main toolbar and in
the Options panel > General group, edit the Angle setting.

IMPORTANT  By default, Polar Snapping mode is not directly accessible in the
3ds Max user interface. To add it as a button on the Snaps toolbar, follow this
procedure on page 2815.

Polar is particularly useful for drawing plans where angles between all lines
must conform to specific angle increments, such as 45 degrees. If all lines must
be at 90-degree angles to each other, use the Ortho Snapping Mode toggle on
page 2812 instead.
The following provisions apply to using Polar:

- Use of Polar is mutually exclusive of use of the Ortho toggle; only one can be active at a time.
- Polar applies primarily to the creation of line splines and wall objects. It can be used while creating other objects, but results are likely to be unsatisfactory.

Polar mode displays a compass that provides a readout of the current angle of the input relative to the positive direction of the local X axis.

**NOTE** If you hold down Alt in Polar mode, the next point becomes doubly constrained by both the previous point and the first point of the current object. This allows you to close splines precisely. In this mode, two compasses are displayed; one each at the first and previous points.

**Procedures**

**To add Polar Snapping Mode to the Snaps toolbar:**

1. Open the Snaps toolbar, if necessary. To do so, right-click an empty part of the main toolbar, such as the area directly below one of the drop-down lists, and choose Snaps.
2. Drag the right end of the toolbar to the right to make room for a new button.
3. Choose Customize menu > Customize User Interface. This opens the Customize User Interface dialog.
4. On the dialog, click the Toolbars tab.
5. Scroll down the Actions list on the dialog to the Polar Snapping Mode item. You can jump to the P section by clicking any item in the list and then pressing P on the keyboard.
6. Drag the Polar Snapping Mode item from the list to the empty section of the Snaps toolbar. This adds the button to the toolbar.
7. Close the Customize User Interface dialog.
   3ds Max automatically saves the toolbar in its revised state and makes the new button a permanent part of the user interface.
To use Polar:

1. Turn on the Polar Snapping Mode button. The button appears depressed.

2. Begin to draw a line spline. An orange compass appears where you place the first point, along with a red number indicating the angle of the current line segment with the positive direction of the local X axis.

3. Move the mouse cursor around in the viewport. The line jumps to specific angle increments from the X-axis, while the compass reading updates to show the current angle. You set the angle increment in the Grid And Snap Settings dialog > Options panel on page 2828 > General group, which you can access by right-clicking the Angle Snap Toggle button on the main toolbar.

4. Click to place the next vertex.

5. Repeat steps 3 and 4 until you're ready to complete the shape.

6. Do any of the following:
   - To finish the shape at the most recent vertex without closing it, right-click anywhere.
   - To finish the shape by closing it, position the mouse cursor close to the first point and then click. A small dialog opens asking if you want to close the spline; click Yes.
   - To finish the shape by closing it while constraining the line to the polar snap, first position the mouse cursor close to the first point, press and hold Alt to constrain the mouse by both the previous point and the first point, and then click. This vertex is automatically placed at the current angle increment from the first point, so that you need only click the first point to close the shape.

Setting Snap Options

You can access a number of snap features from the Options tab of the Grid and Snap Settings dialog. Right-click any of the snap buttons on the main toolbar to display the Grid And Snap Settings dialog or choose Tools menu > Grids And Snaps > Grid And Snap Settings, then click the Options tab.
### Display and General Settings

**Marker settings** Determine the color and size of the snap cursor. To prevent the snap cursor from appearing, turn off Display.

**Snap Radius settings** Determines how close the cursor needs to approach a snap point before the snap preview or actual snap takes place. These are global settings, affecting all snap interactions, and are measured in terms of the pixels in a "search region" around the active point of the cursor.

**Snap to Frozen Objects** Normally, if an object is frozen you can't snap to it; this option lets you snap to frozen objects.

### Settings for Angle and Percent Snap

The following Options settings are for two snap buttons that operate independently of standard snaps.

**Angle (deg)** A global setting, in degrees, that determines the angle of rotation for a number of features in 3ds Max, including the standard Rotate transform.
As you rotate an object (or group of objects), the object moves around a given axis in the increment you set. Angle snap also affects the following:

- Pan/Orbit camera controls
- FOV and Roll camera settings
- Hotspot and Falloff light angles

For more information, see Angle Snap on page 2810.

**Percent** Sets a percentage increment during a scaling operation.
For more information, see Percent Snap on page 2811.

### Rotating and Scaling with Snaps

The effect of rotating and scaling with snaps depends on whether Auto Key on page 8090 is on or off:

- With Auto Key **on**, snap toggles are disabled, while Angle and Percent snaps remain active. Rotation and scaling occur around the pivot point of the object.
- With Auto Key **off**, rotations and scales occur around the snap point. For example, using Vertex snap, you can rotate a box about any of its corners.

### Translation Options

By default, the Use Axis Constraints on page 910 option is off. The current setting on the Axis Constraints toolbar (XY, for example) has no effect. Turning on this option lets you use snaps in conjunction with axis constraints.

The Translation group also lets you toggle display of a rubber band line between the start and end points during a snap operation.

### Settings for Spinner Snap

You set the spinner snap on the General panel on page 8299 of the Preferences dialog. Right-click the Spinner Snap button on the main toolbar to display this panel.

**Spinner snap** Sets a numerical increment for spinner fields. If you're using generic units of 1 inch, a setting of 12 would let you resize objects by one foot with every click, or add 12 segments to a sphere.
The same setting applies to all spinner fields. Since spinner snap is a toggle, you can easily turn it on when needed and use the default at other times. Spinner snap has no effect on dragging a spinner, only on single clicks. For more information, see Spinner Snap on page 2811.

**Grid and Snap Settings**

Tools menu > Grids and Snaps > Grid and Snap Settings

Right-click any snap button

Shift+right-click a viewport. > Snaps shortcut (quad) menu on page 8062 > Snap Options quadrant > Grid and Snap Settings

This command displays the Grid and Snap Settings dialog. This modeless dialog establishes settings and options for snaps, the home grid on page 8600, and user-defined grids.

Controls on the Grid And Snap Settings dialog determine which snap settings are used when you activate snaps by clicking 3D Snap Toggle. Adjusting any of these snap settings does not automatically turn on snaps.

You can use objects within an XRef scene as snap references.

**Procedures**

To change grid and snap settings:

1. Choose Tools menu > Grids And Snaps > Grid And Snap Settings and click the appropriate tab.
2. Choose the type of snap you want (Standard or NURBS).
3. Select the snap settings.

**Snap Settings**

Tools menu > Grids and Snaps > Grid And Snap Settings > Grid And Snap Settings dialog > Grid And Snap Settings tab

Main toolbar > Right-click a snap button

Keyboard > Hold Shift+right-click > Snaps quadrant

Keyboard > S (toggles snaps on and off)
Snapping gives you additional control when creating, moving, rotating, and scaling objects by causing the cursor to “jump” to specific portions of existing geometry and other scene elements during creation and transformation of objects or sub-objects. The controls in this dialog set the snap strength and other characteristics such as the snap target.

NOTE Snapping functionality includes several features that enhance ease of use. For details, see the General Group section of the Snap Options topic on page 2831.

You can specify the portion of the geometry where you will snap. For example, when Vertex is the active snap type, creating and transforming objects snaps to the vertices of existing geometry. You can specify any combination of active snap types to provide multiple snapping points. For example, if Vertex and Midpoint are active, snapping occurs at both vertices and edge midpoints.

The default snap type is Grid Points.

NOTE Snapping is not on by default. You can toggle snapping by pressing the S key at any time, even in the middle of a transform. In this way you can combine snapping with free positioning.

Snapping works at sub-object levels. For example, you can use snaps to position a gizmo to the object on which you’re working, or snap it to other objects in the scene.

You must activate a viewport in order to use snaps. Also, the Z-axis constraints don’t apply to the home grid or grid objects, since grids don’t have a Z axis.

Settings are stored in the 3dsmax.ini on page 60 file. The state of the snap settings persists from session to session.

**Snaps and Axis Constraints**

Snaps take precedence over axis constraints on page 910. If you activate an axis constraint, such as Restrict to X, you can move the object only in X. But if you then turn on snaps, Restrict to X is suspended and not used.

You can override this by turning on Snaps Use Axis Constraint Toggle on the Axis Constraints toolbar on page 8039, or by turning on Use Axis Constraints in Snap Options on page 2828.
The Snaps Toolbar

The most common Snaps settings are available from an optional toolbar. To toggle display of the Snaps toolbar, right-click an empty area of the main toolbar, such as the section under the Reference Coordinate System drop-down, and choose Snaps. The toolbar buttons are shown next to the relevant commands, below and in the Snap Options topic on page 2828.

The same settings are also available from the snap quad menu, available with Shift+right-click.

Procedures

To set grid and snap settings:

1. Turn on the 3D Snap Toggle button to activate snaps.
2. Choose Tools menu > Grids And Snaps > Grid And Snap Settings to display the Grid and Snap Settings dialog.
3. In the Snaps tab, select one or more of the types of snaps you want active.
4. Create an object or transform an object.
   Snap markers appear when the mouse cursor is over existing geometry or on a grid, depending on the active snap types. Each snap type has a different display; clicking when the snap-specific display is visible snaps to that spot.

To display the Snaps shortcut menu:

- Hold Shift and right-click anywhere in any viewport. The quad menu that opens gives you access to various snap settings including Snaps Use Axis Constraints and Snap To Frozen Objects.

To use both constraint and snaps, do one of the following:

1. In the Grid and Snap Settings dialog > Options tab > Translation group, turn on Use Axis Constraints.
2 Hold Shift and right-click in the viewport, and then choose Options > Transform Constraints from the Snap quadrant.

Example: To use 3D snaps and rotation transformations together:
1 Create a box.
2 Select the box and choose Lock Selection.
3 Turn on 3D Snaps and click Rotate on the toolbar.
4 From the Use Center flyout on the main toolbar, choose Use Transform Coordinate Center on page 934.
5 Activate the Perspective viewport and move the cursor over the grid. A blue icon displays when the cursor passes over a grid point.
6 When the blue icon displays, click and drag to rotate the box around the selected grid point.
   You can rotate around anything you can snap to.

To turn snaps on and off during an operation:
■ Use the S keyboard shortcut to turn snap on and off.

TIP You can select something with snap off, and then turn snap on to snap it to a snap target. Alternately you might want to snap to something, then position it freely wherever you want.

Interface

Use these check boxes on the Snaps tab to turn on any combination of snap settings.

After setting snaps, close the dialog using the Close button in the dialog’s upper-right corner. Do not click the Clear All button, or you’ll turn off all the snaps.

Override This label changes to display the temporary snap type used by the Override system. For more information, see Snap Override on page 2826.

Clear All Turns off all of the Snaps check boxes.
NOTE The layout of the Grid And Snap Settings dialog is generated at runtime. Because of this, it might appear slightly different than the illustrations shown here.

Standard snaps

These are the standard snap types used for grids, mesh, and shape objects. Non-grid snap types, when active, take priority over Grid Points and Grid Lines snaps: if the mouse is equally near a grid point and some other snap type, it will choose the other snap type.

NOTE The button images shown below are from the Snaps toolbar on page 2821.

Grid Points Snaps to grid intersections. This snap type is on by default. Keyboard shortcut=Alt+F5.

Grid Lines Snaps to any point on a grid line.
**Pivot** Snaps to pivot points of objects. Keyboard shortcut=Alt+F6.

**Bounding Box** Snaps to one of the eight corners of an object's bounding box.

**Perpendicular** Snaps to the perpendicular point on a spline, relative to the previous point.

**Tangent** Snaps to a tangent point on a spline, relative to the previous point.

**Vertex** Snaps to vertices of mesh objects or objects that can be converted to editable meshes. Snaps to segments on splines. Keyboard shortcut=Alt+F7.

**Endpoint** Snaps to the end points of edges on meshes or spline vertices. Keyboard shortcut=Alt+F8.

**Edge/Segment** Snaps anywhere along edges (visible or invisible) or spline segments. Keyboard shortcut=Alt+F10.

**Midpoint** Snaps to the middle of edges on meshes and spline segments. Keyboard shortcut=Alt+F9.

**Face** Snaps anywhere on the surface of a face. Back faces are culled, so they have no effect. Keyboard shortcut=Alt+F11.

**Center Face** Snaps to the center of triangular faces.
NURBS snaps

These options snap to objects or sub-objects in a NURBS model on page 8656. The NURBS snaps settings are aids for creating and transforming objects, and are not constraints. 3ds Max does not maintain the relationship between the NURBS object and other objects you create or transform.

CV Snaps to a CV sub-object on page 8543 in a NURBS curve on page 8655 or NURBS surface on page 8656.

Point Snaps to a point sub-object on page 8688 in a NURBS model.

Curve Center Snaps to the center of a NURBS curve.
The center of a NURBS curve is calculated parametrically, and might not be the same as the curve's apparent visual center.

Curve Normal Snaps to a point normal to a NURBS curve.
This snap operates only while you are creating a new object that requires two or more clicks to create.

Curve Tangent Snaps to a point tangent to a NURBS curve.
This snap operates only while you are creating a new object that requires two or more clicks to create.

Curve Edge Snaps to the edge of a NURBS curve (the current object moves or is created to lie along the curve).

Curve End Snaps to the end of a NURBS curve.

Surf Center Snaps to the center of a NURBS surface.
The center of a NURBS curve is calculated parametrically, and might not be the same as the curve's apparent visual center.
Surf Normal Snaps to a point on a NURBS surface normal to previous point. This snap operates only while you are creating a new object.

Surf Edge Snaps to the edge of a NURBS surface.

Snap Override

Any viewport > Hold Shift and right-click. > Snaps shortcut (quad) menu on page 8062 > Snap Override > Standard > Choose snaps type.

Any viewport > Hold Shift and right-click. > Snaps shortcut (quad) menu on page 8062 > Snap Override > NURBS > Choose snaps type.

Tools menu > Grids and Snaps > Grid and Snap Settings > Snaps tab

Snap Override lets you supersede all the currently selected snap types and temporarily use only one, or none, of the snap types currently selected on the Grid And Snap Settings dialog. For example, you might be creating a spline while snapping to grid points, but then need to snap one of its vertices to the midpoint of an object.

TIP You can choose the override by cycling through active snap types via a keyboard shortcut instead of using the quad menu. Press Alt+S repeatedly to choose the override snap type. If the Grid and Snap dialog is displayed, the "Override OFF" label changes to display the selected snap type.

Procedures

To use Snap Override (keyboard shortcut method):

1. Activate all the snap types you want to use or override with.
2. Make sure the Grid And Snap Settings dialog is open to the Snaps panel, so you can easily track the override type. Alternatively, if you're using only snap types available on the Snaps toolbar on page 2821, you can keep the toolbar open instead.
3. While creating or moving an object with Snap on, press Alt+S repeatedly. The Grid And Snap Settings dialog > "Override OFF" label changes to display the first available override snap type, chosen from the active snap types. If the Snaps toolbar is open, and the override snap type is available on the toolbar, the override snap type is visible there as well.
4. Press Alt+S repeatedly.
3ds Max cycles through all the active snap types for the override type. The benefit of this method is that it's fast and easy; you don't have to use the quad menu. But if you want to override with a snap type that isn't currently active, it's necessary to use the standard override method, which is described in the next procedure.

To use Snap Override (standard method):

1. While creating or moving an object with Snap on, hold down Shift and right-click in a viewport.
2. Select one of the snap types from the sub-menus in the Snap Override quadrant to make it the only active snap type.
   If the Grid And Snap Settings dialog is open to the Snaps panel, the "Override OFF" label changes to display the active snap override type. When you complete the mouse action, "Override OFF" is again displayed in the dialog, and the previously active snap types are active again.

To use Snap Override during a drag operation:

1. Left-click, press Shift, and then right-click to display the menu.
2. Release the left mouse button, and then left-click to select the snap you want.
3. Release the Shift key, right-click, and continue the drag operation (the geometry remains locked to the mouse).
4. Left-click to complete the operation.

Interface

In addition to the available snap types, the snap quad menu contains these items:

Snap Options quadrant Lets you set the following options:

- Grid and Snap Settings: Toggles display of the Grid And Snap Settings dialog.
- Snaps To Frozen Objects: Turn this on to enable snapping to frozen objects. Default=off.
- Snaps Use Axis Constraints: Turn this on to use the current transform constraints. For example, if you're moving a vertex with Restrict To XY
Plane on and want to snap the vertex to a point removed on the Z axis, turn this off, if necessary. Default=off.

Snap Override quadrant Lets you set the following options:

NURBS/Standard Let you choose a snap type for one-time use. This applies to the next snap only.

None Turns off all snap types for the next mouse action. (This item is unavailable if the Snap Toggle is off.)

[last] Displays the last snap override type you chose from the NURBS or Standard submenu, letting you easily reuse that type.

Snap Toggles quadrant Lets you set six of the most common snap types on an ongoing basis. These remain in effect until you turn them off; it's the same as setting them on the Grid And Snap Settings dialog.

Snap Options

Tools menu > Grids and Snaps > Grid and Snap Settings > Grid and Snap Settings dialog > Options panel
Main toolbar > Right-click 3D Snap Toggle > Grid and Snap Settings dialog > Options panel

The Options panel of the Grid And Snap Settings dialog lets you set options related to snapping.

Procedures

To set snap options:

1. Choose Tools menu > Grids And Snaps > Grid And Snap Settings.
2. Click the Options tab.
3. Set the options as desired.

Example: To use Snap Preview:

The Snap Preview Radius setting lets you preview a snap before it actually happens. The Snap Radius setting determines when actual snapping occurs, providing the same functionality as Snap Strength in previous versions.
This procedure also demonstrates how to cycle through available snap/preview points with the keyboard shortcut.

1. Reset 3ds Max, and then maximize the Perspective viewport.
   
   To maximize the Perspective viewport, make sure it's active (yellow border), and then press Alt+W.

2. Zoom in a bit so the grid squares are relatively large.
   
   Snap and Snap Preview measure in pixels, so if the grid points are relatively far apart, it's easy to see the difference between Snap Preview and Snap.

3. On the main toolbar, click the Snaps Toggle button to turn on snapping, and then right-click the button to open the Grid And Snap Settings dialog to the Snaps panel.
   
   The default Snaps setting is Grid Points only; if this is not the case, make it so. A grid point is the intersection of two grid lines.

4. On the dialog, click the Options tab.
   
   In the General group, Snap Preview Radius is set to 30 pixels and Snap Radius is set to 20 pixels. You can leave this dialog open while you use snaps.

5. On the Create panel, click Shapes, and then click Object Type rollout > Line.
   
   You're now in line-creation mode.

6. Click anywhere in the viewport to start creating a line-type spline object.

7. Move the cursor around the viewport.
   
   As you do so, a rubber-band line connects the mouse cursor to the start point.

8. Position the mouse cursor near a grid point, but not too close, so that the snap cursor (cyan box + crosshairs) appears at the grid point, but the line endpoint remains attached to the mouse cursor.
   
   This shows the snap preview; you'll see its purpose in the next step.

9. Click the left mouse button.
The second line vertex is created not where you clicked but at the grid point indicated by the snap preview. Snap preview lets you see where a snap will occur before it actually happens.

10 Move the cursor toward another grid point.
   At the Snap Preview Radius distance (30 pixels), the snap cursor appears at the grid point.

11 Continue moving the cursor toward the grid point.
   After you move it 10 pixels closer (the difference between Snap Preview Radius and Snap Radius), the line endpoint jumps from the mouse cursor to the grid point. This is the legacy snap functionality.

12 Click to accept the snap.

13 Complete the line, and then zoom out so the grid points are closer together. Start another line, and then position the mouse cursor in the center of a grid square, so the preview snap point appears at one of the grid points.

14 On the keyboard, press and hold Alt+Shift and then press S repeatedly to cycle through the remaining nearby grid points. If nothing happens, try zooming out more or increasing the Snap Preview Radius value.
   By default, 3ds Max uses the closest snap point as the preview location. This keyboard shortcut lets you choose other qualifying snap points.

Interface

NOTE The layout of the Grid And Snap Settings dialog is generated at runtime. Because of this, it might appear slightly different than the illustration shown here.
Marker group

Provides settings that affect the visual display of the snap points.

**Display** Toggles the display of the snap guides. When off, the snaps still function, but there's no display.

**Size** Sets the size, in pixels, of the snap "hit" point. This is the small icon that indicates either the source or target snap point.

**Color** Click the color swatch to display the Color Selector, where you can set the color of the snap display.

General group

Snap functionality includes several features that enhance ease of use. When using Snap, if the cursor comes within distance of a potential snap point that's less than the *Snap Preview Radius* distance but greater than the *Snap Radius* distance, the snap cursor jumps to that point as a preview of where the snap will occur, but no actual snapping occurs.

To use the preview point as the snap point, click or release the mouse button, depending on the context. If, instead, you then continue to move the cursor toward the potential snap point so that it comes within a distance equal to or less than the Snap Radius value, the snap takes place.
**TIP** For best results, keep the Snap Preview Radius value 10 pixels or more higher than the Snap Radius value. This lets you preview any snap before it actually occurs.

**Snap Preview Radius** When the cursor is a distance from a potential snap-to point between the Snap Preview Radius value and the Snap Radius value, the snap marker jumps to the closest potential snap-to point, but no snap occurs. Default=30.

When a snap-to preview point is highlighted, release or click the mouse button (depending on the context) to snap the current selection to that location. Alternatively, before using the displayed snap point, you can cycle through any other available preview and snap points by pressing and holding Alt+Shift and then press S repeatedly.

**NOTE** The Snap Preview Radius value should generally be set higher than the Snap Radius value, so that previewing occurs before snapping. If you attempt to set the Snap Preview Radius value lower than the Snap Radius value, 3ds Max lowers the latter so that the two are equal. This effectively turns off previewing, so that only snapping is in effect.

**Snap Radius** Sets the size of the area around the cursor, in pixels, within which snapping occurs automatically. Default=20.

**NOTE** The Snap Radius value should generally be set lower than the Snap Preview Radius value, so that previewing occurs before snapping. If you attempt to set the Snap Radius value higher than the Snap Preview Radius value, 3ds Max raises the latter so that the two are equal. This effectively turns off previewing, so that only snapping is in effect.

**Angle** Sets the increment at which objects are rotated about a given axis (degrees).

**Percent** Sets the percentage increment for scale transforms.

**Snap to Frozen Objects** When on, snapping to frozen objects is enabled. Default=off. This option is also available from the Snaps shortcut menu, accessed when you hold Shift and right-click in any viewport, as well as from the Snaps toolbar on page 2821. Keyboard shortcut=Alt+F2.
Translation group

**Use Axis Constraints** Constrains the selected object to move only along the axes specified on the [Axis Constraints toolbar](#) on page 8039. When off (the default), the constraints are ignored, and snapped objects can be translated in any dimension (assuming 3D snapping is used). This is also available from the Snaps shortcut menu, accessed when you hold Shift and right-click in any viewport, as well as from the [Snaps toolbar](#) on page 2821 and the Tools menu > Grids And Snaps submenu. Keyboard shortcut=Alt+F3 or Alt+D.

**Display rubber band** When on and you move an selection, a rubber-band line appears between the original location and the mouse position. Use this visual aid for greater accuracy when fine-tuning Default=on.

**Use Axis Center As Start Snap Point** Sets the center of the transform axis of the current selection set to be the initial snap point if there's no other start snap point detected by the snap system. This option works both at the object and sub-object levels.

This lets you, for example, snap the geometric center of a multi-object selection to a grid point.

**Home Grid Settings**

Tools menu > Grids and Snaps > Grid And Snap Settings > Home Grid panel

Main toolbar > Right-click 3D Snaps Toggle. > Grid And Snap Settings > Home Grid panel

The Home Grid panel of the Grid And Snap Settings dialog sets the spacing and other characteristics of the [home grid](#) on page 8600. Choosing useful home grid settings can simplify the construction process. The home grid provides a visual reference for creating objects in a scene.

In 3ds Max, grids have these primary uses:

- An aid in visualizing space, scale, and distance.
- Construction planes where you create and align objects in your scene.
- A reference system for using grid snaps.
Procedures

To set grid spacing for unit measure:

1. From the menu bar, choose Tools menu > Grids And Snaps > Grid And Snap Settings.
2. Click the Home Grid tab.
3. Adjust the value for Grid Spacing, which is in current units.
   For example, if you have units set to centimeters, you might make one grid space equal to 1.000 (one unit, or one centimeter in this case).

To set major grid divisions for multiple units:

1. From the menu bar, choose Tools menu > Grids And Snaps > Grid And Snap Settings.
2. Click the Home Grid tab.
3. Adjust the Major Lines Every Nth Grid Line value, which is the number of grid squares between major lines. The minimum is 2.
   For example, if you use a grid spacing of one centimeter, you might use a value of 10 so the major grid divisions represent one decimeter.
   In perspective viewports, you can set a fixed size for the displayed home grid. If Inhibit Perspective View Grid Resize is turned off however, the grid size adjusts as you zoom in or out.

To set view update options:

1. From the menu bar, choose Tools menu > Grids And Snaps > Grid And Snap Settings.
2. Click the Home Grid tab.
3. Under Dynamic Update, choose either Active Viewport (the default) or All Viewports.

To allow subdivision below grid spacing:

1. From the menu bar, choose Tools menu > Grids And Snaps > Grid And Snap Settings.
2. Click the Home Grid tab.
3. Turn off Inhibit Grid Subdivision Below Grid Spacing.
When you turn off this box, you can zoom indefinitely "deep" into any plane of the home grid. Each grid square subdivides into the same number of smaller grid spaces.

**Interface**

**NOTE** The layout of the Grid And Snap Settings dialog is generated at runtime. Because of this, it might appear slightly different than the illustration shown here.

**Grid Dimensions group**

**Grid spacing** Grid spacing is the size of the grid's smallest square. Use this spinner to adjust the spacing (which is in current units), or enter the value directly.

For example, if you have units set to centimeters, you might make one grid space equal to 1.000 (one unit, or one centimeter in this case).

**Major Lines every Nth Grid Line** The home grid displays heavier or "major" lines to mark groups of grid squares. Use spinners to adjust the value, which is the number of grid squares between major lines, or you can enter the value directly, the minimum is 2.
For example, if you use a grid spacing of one centimeter, you might use a value of 10 so the major grid divisions represent one decimeter.

**Perspective View Grid Extent** Sets the size of the home grid in the Perspective viewport.

This value is specified in terms of the Grid Spacing value, and represents the length of half the grid along an axis. This means that if Grid Spacing=10.0 and Perspective View Grid Extent=7, you will have a grid that is 140 x 140 units in size.

---

**Inhibit Grid Subdivision Below Grid Spacing** Causes 3ds Max to treat the grid as a fixed set of lines when you zoom in on the home grid. In effect, the grid stops at the grid space setting. If you keep zooming, the fixed grid is lost from view. Zooming out is not affected. When you zoom out, the home grid expands indefinitely to maintain the major grid divisions. Default=on.

When this is turned off, you can zoom indefinitely into any plane of the home grid. Each grid square subdivides into the same number of smaller grid spaces.

For a grid spacing of one centimeter and a major division of 10, the next level down subdivides into millimeter spaces, and so on.

**Inhibit Perspective View Grid Resize** Causes 3ds Max to treat the grid in the Perspective viewport as a fixed set of lines when you zoom in or out. In effect, the grid maintains one size, no matter how much you zoom. Default=on.

When this is turned off, the grid in the Perspective viewport will subdivide to adjust its size when you zoom in or out.

**Dynamic Update group**

**Dynamic Update** By default, only the active viewport updates as you change values for Grid Spacing and Major Lines every Nth. The other viewports update after you have completed changing the values. Choose All Viewports to have all viewports update as you change the values.

**User Grid Settings**

Tools menu > Grids and Snaps > Grid And Snap Settings > Grid And Snap Settings dialog > User Grids tab

The User Grids panel controls automatic activation of grid objects on page 2847 and settings for AutoGrid on page 2792.
Interface

NOTE The layout of the Grid And Snap Settings dialog is generated at runtime. Because of this, it might appear slightly different than the illustration shown here.

Grid object automation group

Determines if 3ds Max automatically makes grids active upon creation.

Activate grids when creating  
Turn on to automatically activate the grid you created.

TIP If not turned on, you can activate the grid by selecting the grid, then right-clicking and choosing Activate Grid.

AutoGrid group

AutoGrid allows you to automatically create grids on the surface of objects. The task of creating objects that are aligned to other object surfaces has been simplified. Turn on AutoGrid in the Object Type rollout of a command panel. When you turn on AutoGrid, 3ds Max uses the setting in the User Grids dialog for world or object space.

World space Aligns grids to world space.

Object space Aligns grids to object space.

Helpers

Create panel & Helpers
Create menu > Helpers

Helper objects play a supporting role, like stagehands or construction assistants.

Several categories of helpers are available from the drop-down list on the Create panel:

- **Standard helpers** on page 2839
- **Atmospheric Apparatuses** on page 7236
- **Camera match** on page 5615
- **Assembly Head Helper Object** on page 271
  - **Character Assembly** on page 254
  - **Luminaire Helper Object** on page 271
- **Manipulator Helper Objects** on page 2861
- **Particle Flow helpers** on page 3044
- **VRML97 Helper Objects** on page 7809
- **reactor** on page 4219

Other helper objects might be available, depending on your configuration.

---

**Select And Manipulate**

Main Toolbar > Select And Manipulate button

The Select And Manipulate tool lets you edit the parameters of certain objects, modifiers, and controllers by dragging "manipulators" in viewports.

**NOTE** Unlike Select And Move and the other transforms, this button's state is non-exclusive. As long as Select mode or one of the transform modes is active, and Select And Manipulate is turned on, you can manipulate objects. However, you must turn off Select And Manipulate before you can select a manipulator helper.

You can add these custom manipulators to your scene:

- **Cone Angle Manipulator** on page 2861
- **Plane Angle Manipulator** on page 2865
These features have manipulators built in, which you can use to change parameters on these objects:

- **Slider Manipulator** on page 2868
- **IK Solver Properties Rollout (HI Solver)** on page 3700
- **Reaction Controllers** on page 3527
- **Target Spotlight** on page 5399
- **Target Directional Light** on page 5405
- **mr Area Spotlight** on page 5421
- **Free Spotlight** on page 5402
- **Spotlight Parameters** on page 5439
- **UVW Map Modifier** on page 1932

**Primitives** on page 385 with a Radius parameter have a built-in manipulator for the radius.

### Standard Helper Objects

Create panel > Helpers > Standard > Object Type rollout

Create menu > Helpers

Helper objects play a supporting role, like stage hands or construction assistants.

The helpers in this section serve mainly as precision and drawing aids, while you can find links to other kinds of helpers in the See Also list, following.

<table>
<thead>
<tr>
<th>Object Type</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>AutoGrid</td>
<td>Dummy</td>
</tr>
<tr>
<td>Crowd</td>
<td>Container</td>
</tr>
<tr>
<td>ExposeTin</td>
<td>Delegate</td>
</tr>
<tr>
<td>Point</td>
<td>Grid</td>
</tr>
<tr>
<td>Protractor</td>
<td>Tape</td>
</tr>
<tr>
<td></td>
<td>Compass</td>
</tr>
</tbody>
</table>
See also:

- Container on page 7395
- Crowd Helper on page 5162
- Delegate Helper on page 5154
- Atmospheric Apparatuses on page 7236
- CamPoint Helper on page 5615
- Assembly Heads Helper on page 271
- Manipulator Helper Objects on page 2861
- Particle Flow helpers on page 3044
- VRML97 Helper Objects on page 7809
- reactor Helpers on page 4246

**Dummy Helper**

Create panel > Helpers > Standard > Object Type rollout > Dummy
Create menu > Helpers > Dummy

A Dummy helper object is a wireframe cube with a pivot point at its geometric center. It has a name but no parameters, you can't modify it, and it doesn't render. Its only real feature is its pivot, used as a center for transforms. The wireframe acts as a reference for transform effects.

The dummy object is used primarily in hierarchical linkages. For example, you can use a dummy object as a center of rotation by linking a number of different objects to it. When you rotate the dummy, all of its linked children rotate with it. A dummy is often used this way to animate linked motion.

Another common usage of a dummy object is in the animation of target cameras. You can create a dummy and position a target camera within the dummy object. Then you can link both the camera and its target to the dummy, and animate the dummy with a path constraint. The target camera will follow the dummy along the path.

Dummy objects are always created as cubes. You can change the proportions of dummies by using non-uniform scaling, but avoid this on dummies that are within a hierarchical linkage; this can introduce unexpected results.
Procedures

To create a dummy object:

■ Click Dummy and drag a cube to any convenient size.

Interface

Dummy objects don't have any parameter rollouts or settings.

Expose Transform Helper

Create panel > Helpers > Standard > Object Type rollout > ExposeTm
Create menu > Helpers > Standard > ExposeTm

The Expose Transform helper exposes values of non-keyed objects for use in expressions and scripts. This lets riggers and animators access a select set of transforms for an object, and between an object and its parent, such as a bone in an IK chain. For example, using the Expose Transform helper, you could write a script or use parameter wiring that tests the angle of an character's arm bone that's controlled by IK (thus, has no keys), and once it exceeds a specific value, rotate the corresponding clavicle bone to deform the shoulder area.

In the viewports, the Expose Transform helper object looks just like a Point helper on page 2853.

Procedures

To use the Transform helper:

1  Click ExposeTm and choose the appearance characteristics from the Display rollout.

2  Adjust the size of the helper object by using the Size spinner on the Display rollout. Default=20.0

3  Click anywhere in your scene to add the helper object.
   The helper object's position has no bearing on its functionality.

4  On the Modify panel > Parameters rollout, click the Expose Node button (default label: None) and select the object whose transform values you want to expose.
The object's name appears on the button, and its transform values appear in the fields on the Expose Values rollout.

5 Optionally, turn off Parent and choose a Local Reference Node object. This option is used by the Local Euler Angles, Distance To Reference, and Angle parameters. If the object has no parent and you don't specify a Local Reference Node object, these fields use the world center (0,0,0) as the reference node.

6 To use a transform value in a script or expression, first click the M button next to the parameter value. This copies the transform name, using MAXScript notation, to the copy buffer.

7 Paste the contents of the buffer to your script or expression. A sample result of this is "$ExposureTransform01.localPositionX". 3ds Max interprets this as the local position, on the X axis, of the Expose Node object.
### Interface

#### Parameters rollout

These settings let you specify the exposed node, a reference object other than the parent, and rotation and timing parameters.

**Expose Node** The object from which the values are generated. Click the button, and then select the object. Thereafter, the object name appears on the button.

**Local Reference Node** The object whose relationship with the Expose Node object is used to generate local data for rotation, distance, and angle. Click the button, and then select the object. Available only when Parent is off. By default, this is the parent object, but you can turn off Parent and then specify a different object.

**Parent** When on, the Local Reference Node is set automatically to the parent of the Expose Node. When off, you can pick an object to refer to for local data. Default=on.
This is used by the Local Euler Angles, Distance To Reference, and Angle parameters. If the object has no parent and you don't specify a Local Reference Node object, these fields use the world center (0,0,0) as the reference node.

**Rotation Order** These three settings determine the order in which the Expose Transform helper will look for an Euler rotation.

This parameter corrects for anomalies that can be introduced when a local rotation value is generated in relation to other rotation values. For example, when Z Order is set to XYZ, the Z value is generated in reference to X and then Y. Or when X Order is set to ZXY, the Z value is generated directly in reference to the parent, regardless of X and Y rotations.

**Strip NU Scale** When on, removes any non-uniform scaling that could influence the rotation data. It does not strip non-uniform scaling from the object; only from the values generated.

**Use Time Offset** When on, lets you specify a frame other than the current one from which to gather data. The Offset value is added to the current frame to derive the frame from which data is gathered.

For example, if the current frame is 20 and you wish to gather data from frame 15, turn on Use Time Offset and set Offset to -5.

**Display rollout**

- **Center Marker** Displays a small X marker at the center of the helper object.

*2844* | Chapter 11 Precision and Drawing Aids
**Axis Tripod** Displays a tripod axis indicating the position and orientation of the helper object.

**Cross** Displays an axis-aligned cross.

**Box** Displays a small axis-aligned box at the center of the helper object.

**Size** Sets the size for the helper object. Use this setting to minimize the helper object, or increase its size to aid in locating it. Default=20.0.

**Constant Screen Size** Keeps the size of the helper object constant, regardless of how much you zoom in or out.

**Draw On Top** Displays the helper object on top (or in front) of all other objects in the scene.
This rollout provides readouts of values for all transform values of the Expose Node object. Each value has a button labeled “M” next to it; click this button to copy the MAXScript associated with the value to the clipboard, which you can then paste into a script.

**Display Exposed Values** When on, transform values for the Expose Node object appear on this rollout, and update as the values change. When off, values don’t appear, but the M buttons still function normally.

**Local Euler Angles** Rotation values with respect to the parent or Local Reference Node object.

**World Euler Angles** Rotation values in the world coordinate system.

**Local Position** Position values with respect to the Expose Node object’s local coordinate system.

**World Position** Position values in the world coordinate system.

**Bounding Box** The maximum dimensions of the object.

**Distance to Reference** The distance between the Expose Node object and its parent or the designated Local Reference Node object. If neither exists, this shows the distance to the world center (0,0,0).

**Angle** The angle between the Expose Node object and its parent or the designated Local Reference Node object.

**Grid Helper**

Create panel > Helpers > Standard > Object Type rollout > Grid
Create menu > Helpers > Grid

The grid, also called User Grid or Custom Grid, is a 2D parametric object with adjustments for overall size and grid spacing. You can move and orient user grids anywhere in world space.

You can create any number of grid objects in your scene. You name them when you create them and save them with the scene. You can delete them at any time.

Like other objects you create in 3ds Max, grid objects are placed on the grid of the current viewport. By default, this is a plane of the home grid, but it can also be another activated grid object.
NOTE You can use AutoGrid on page 2792 to create a temporary or permanent user grid off the surface of any object.

Using the Grid Object

You can use the grid object as a construction plane on all three orthographic planes in both directions. Here's how it works:

In the Parameters rollout of each grid object is a Display group with three options: XY Plane, YZ Plane, and ZX Plane. These determine which of the three planes of the grid object is displayed in the viewport.

When you activate a grid object, the displayed plane is the construction plane for all viewports. When you create a grid viewport, you can choose from one of six orthographic views (Front, Top, Left, and so on), or you can choose a special Display Planes grid viewport. (When you press the G key to create a grid viewport, the Display Planes type becomes the default.) The Display Planes type of grid viewport always displays the plane chosen by the three option buttons under Display. Thus, as you switch between XY Plane, YZ Plane, and ZX Plane, the view through the grid viewport switches accordingly, and objects created in that viewport are created on the displayed plane.

When you use the Point-Of-View (POV) viewport label menu on page 8122 (or go to the Layout tab of the Viewport Configuration dialog), you can choose six additional types of grid viewports, based on the six orthographic views. These are available by a cascading Grid menu that provides Left, Right, Front, Back, Top, Bottom, and Display Planes. Each of the orthographic directions is local to the grid object, regardless of its orientation in the scene.

When you choose a specific orthographic grid viewport (as opposed to the Display Planes viewport), the construction of objects in that viewport is on the plane specified in the viewport title regardless of the displayed plane of the grid object.

You can create more than one viewport based on the same grid object, with each using a different plane. For example, you can have a Grid (Front) viewport and a Grid (Top) viewport, as well as a Grid (Display Planes) viewport.

When you deactivate a grid object, its remaining viewports show the assigned orthographic view. Thus, a Grid (Front) viewport becomes a Front viewport, for example. A Grid (Display Planes) viewport always reverts to a Top view, regardless of the currently displayed plane.
Scaling Not Advised

As a rule, don’t use scaling to resize a grid object. Scaling enlarges or reduces the apparent size of the grid object but has no effect on grid spacing. A sphere 20 units in radius created on a grid object appears smaller than another 20-unit sphere created on a scaled-up version of the same grid.

If you want to change the actual size of the grid object, select it and go to the Modify panel > Parameters rollout > Grid Size group, and change the Length and Width settings.

Locating Grid Tools

Grid tools are spread throughout the 3ds Max interface.

- In the Views menu, under Grids, are the commands to activate home and user grids. The same tools are available with a right-click anywhere in the viewport when a grid helper is selected.
- Right-click anywhere in the viewport while a grid object is selected and the Tools1 quadrant of the quad menu provides commands to activate the home and user grids.
- Choose Tools menu > Grids And Snaps > Grid And Snap Settings to display the Grid and Snap Settings dialog on page 2819. Two tabs are devoted to Grid tools, one for home, another for user grids. You can change parameters of any active grid using the Modify panel.

See also:

- Viewing Grid Objects on page 2791

Procedures

To create a grid object:

1. Do one of the following:
   - Click Create panel > Helpers > Standard > Object Type rollout > Grid.
   - Choose Create menu > Helpers > Grid.

The Parameters rollout appears on the Create panel.
In a viewport, drag out a rectangle and release the mouse button. This creates and selects a grid object, which appears in white wireframe, divided into four quadrants with coordinate axes at the center.

While the newly created grid object is still selected, you can change its settings on the Parameters rollout.

You can also create a grid object during object creation. Turn on AutoGrid, then press Alt during object creation. A grid is created at the same time as the object and remains displayed and active. See AutoGrid on page 2792 for more information.

To activate a grid object:

A grid object requires activation before use. Standard selection doesn't activate it unless you turn on the option to do so (see User Grids on page 2836).

Only one grid can be active for construction at a time, whether it's the home grid or a grid object. Activating a user grid “deactivates” the home grid.

Activating a grid object enables options to reactivate the home grid on the Views menu > Grids submenu and the Quad menu.

If you have more than one grid object in your scene, you have to activate each one separately. Select the grid object you want to make active and follow the same procedure. Activating another grid object deactivates the current one.

1. Select a grid object.
2. Do one of the following:
   - From the Views menu, choose Grids > Activate Grid Object.
   - Right-click the selected grid object and choose Activate Grid from the quad menu.

   The grid object changes to show its internal grid structure. Except for its main axes, the home grid disappears in all viewports.

To reactivate the home grid, do one of the following:

1. From the Views menu, choose Grids > Activate Home Grid.
2. Right-click the selected grid object and choose Activate Home Grid from the quad menu.

   This deactivates the grid object and returns the home grid in all views.
   If you delete an activated grid object, the home grid also reactivates.
You can assign a keyboard shortcut to Activate Home Grid in the Keyboard panel on page 8250 of the Customize User Interface dialog. This is useful if you need to move back and forth between different grids.

**To use a grid object as construction plane:**

When activated, a grid object replaces the home grid as the frame of reference for creating objects.

An activated grid object creates a true plane in 3D space. No matter how small an activated grid object appears on screen, its XY plane is effectively infinite, just as if it were the XY plane of the home grid.

1. Activate the grid object.
2. Create any category of object.
   3ds Max creates the object directly on the plane of the grid object, with the object’s Z axis perpendicular to the plane.
3. Use Application menu on page 7989 > Import > Merge to import an object.
   3ds Max creates the object directly on the plane of the grid object, with the object’s Z axis perpendicular to the plane.

See Align on page 967 for details on aligning objects and grids.

Like other objects in 3ds Max, you can move and rotate grid objects freely using standard transformation methods. These transforms, along with alignment, are essential in positioning a construction plane in 3D space.

**To nudge a grid object up or down:**

1. Activate the grid object.
2. Use Customize User Interface on page 8249 to specify controls for the Nudge Grid Down and Nudge Grid Up actions. For example, you could set the + and – keys on the numeric keypad to move the grid object up and down.
   Adjust the nudge strength with the Grid Nudge Distance on page 8312 setting on the Viewports panel of the Preferences dialog.
Interface

Grid Size group

Sets the overall size of the grid object. This size determines the extents of a viewport set to the grid object. It doesn't affect the useful limits of the grid, which extend infinitely.

Length/Width  Specifies the length and width of the grid.

Grid Spacing group

Grid  Specifies the size of the smallest square in the visible grid. This setting appears on the status line when the grid is activated.
**NOTE** You can set Grid Spacing when a grid is selected, but you won’t see the grid spacing until the grid is activated.

**Active Color group**

Determines the color used to draw the grid in viewports when it's not selected.

- **Gray** The active grid object is two shades of gray.

- **Object Color** The main grid lines use the assigned object color, while the secondary lines use a lighter intensity.

- **Home Color** The grid object uses the home grid color assigned via the Customize User Interface dialog on page 8249.

- **Home Intensity** The grid object uses the grid intensity settings assigned to the home grid in the Customize User Interface dialog on page 8249.

**Display group**

**XY Plane, YZ Plane, ZX Plane** Determines which of the three planes of the grid object are displayed in the viewport.

**Point Helper**

Create panel > Helpers > Standard > Object Type rollout > Point

Create menu > Helpers > Point

Point provides a specific location in 3D space that can be used as a reference or by other program functions.

**Procedures**

**To create a point in space:**

1. Click `Point` and check the type of display from the Parameters rollout.

2. Adjust the size of the point object by using the Size spinner in the Parameters rollout. Default=20.0

3. Left-click and drag anywhere in your scene.

   The point follows the cursor until you release the mouse button, indicating the current location of the point object.
4 Move the cursor to where you want the point object and release the mouse button.

The point object appears using the display setting you chose.
You can move and rotate the point as needed using standard transformation methods.

**Interface**

![Parameters window](image)

**Center Marker** Displays a small X marker at the center of the point object.

**Axis Tripod** Displays a tripod axis indicating the position and orientation of the point object. The axis remains visible when the point object is no longer selected.

**Cross** Displays an axis-aligned cross.

**Box** Displays a small axis-aligned box at the center of the point object.

**Size** Sets the size for the point object. Use this to minimize the point object, or increase its size to aid in locating it. Default=20.

**Constant Screen Size** Keeps the size of the point object constant, regardless of how much you zoom in or out.

**Draw On Top** Displays the point object on top of all other objects in the scene.
NOTE You can also choose to activate multiple display settings.

Tape Helper

Create panel > Helpers > Standard > Object Type rollout > Tape
Create menu > Helpers > Tape Measure

Tape provides an on-screen "tape measure" for determining and setting distances. The tape is composed of two named objects, in the same way targeted lights and cameras are. By default, these are named Tape## and Tape##.Target. The tape and target icons are connected by a line representing the current distance between them.

Using a tape helper to measure the distance from floor to window frame.

You can drag a length (the default), or enter a specific length by turning on Specify Length. You can snap or align either end of the tape or link to objects in your scene. Deleting either end deletes the tape.
When you add a Tape helper object, 3ds Max automatically assigns a Look At controller to it, with the tape's target object assigned as the Look At target. You can use the controller settings on the Motion panel to assign any other object in the scene as the Look At target.

**Selection**

You can select a tape-measure object from either end, or from the middle. When you click the connecting line, both ends of the tape object become selected so you can move them as one. Note that the same is true of target cameras and lights.

**NOTE** Line selection is available only when clicking with the mouse. Region selection doesn't work for this.

**TIP** The Length readout of the tape object is displayed in the Modify panel only when you select the tape end of the object (as opposed to the target or link line). You can lock the Length display by activating the Pin Stack button while the tape end is selected, and then proceed to adjust any part of the tape object or any other object in your scene.

See also:

- Measure Distance Tool on page 2881

**Procedures**

To measure a distance:

1. Click Tape and drag from one point to create the tape, and then drag to a second point and release the mouse button to create the target. The distance between tape and target appears in the Length field. The number in the Length field is gray to indicate that this is a read-only measurement.

   **NOTE** To snap the tape ends to object vertices, edges and so on, turn on Snap on page 2807 with the appropriate snap settings activated.

2. Move either end to a new location. The line between stretches to the new distance, shown in the Length field.
NOTE For accurate results when moving a tape endpoint with Snap, you must turn on Pivot in the Snap Settings panel as well as the types of sub-object you want to snap to; see Snaps on page 2819. This is because the endpoints are actually pivots.

To set a distance:

- Turn on Specify Length in the Parameters rollout, enter a length, and then create the tape. The connector line is the length you specified, although you can still set the target to any offset by dragging. You can reorient this line as required.

NOTE Clearing Specify Length will adjust the connector line length to meet the target and the new length appears in the Length field.

Interface

![Parameters rollout]

**Parameters rollout**

**Length** Specifies the length of the tape object. You must select the Specify Length check box to enable this option.
Specify Length  Activates the Length parameter setting. Otherwise the tape object’s length will be specified by clicking and dragging in the viewport.

World Space Angles group

To X/Y/Z Axis  Displays the angle of the tape object relative to each axis in world space.

To XY/YZ/ZX Plane  Displays the angle of the tape object relative to each of these home planes.

Protractor Helper

Create panel > Helpers > Standard > Object Type rollout > Protractor
Create menu > Helpers > Protractor

Protractor measures the angle between a point and any two objects in your scene.

The names of the two objects appear above their respective buttons, and the angle formed at the protractor object between the pivot points of the two objects is displayed in the Angle field. Lines are drawn between the protractor and the two selected objects.

NOTE  The line to the first selected object uses the Target Line color, and the line for the second selected object uses the color of the protractor. The Target Line color is set with Customize User Interface dialog > Colors panel on page 8272 > Elements drop-down list > Gizmos group. The Protractor color is set by choosing the Tape Object in Customize User Interface dialog > Colors panel on page 8272 > Elements drop-down list > Objects group.

You can reselect the protractor at any time, enter the Modify panel on page 8184, and pick new objects to measure. You can move either of the two objects or the protractor itself to change the angle.

NOTE  If you need to watch the Angle readout while moving either of the objects, first select the protractor, then click the Pin Stack button on the Modify panel. You can now select and move the other objects while the stack remains pinned to display the protractor angle.
**Procedures**

**To use the protractor:**

1. After selecting Protractor in the Create panel > Helpers section, click in the viewport to place and create the protractor icon. You can also drag to move it before releasing the mouse button.

2. Click the Pick Object 1 button, and then select one of the objects in the scene.
   The name of the selected object appears above the button.

3. Click Pick Object 2, and then select a second object in the scene.
   The Angle parameter shows the angle formed by lines from the protractor object to the two picked objects.

**Interface**

**Parameters rollout**

**Pick Object 1** Click this and select the first of the two objects whose angle you want to measure.

**Pick Object 2** Click this and select the second of the two objects whose angle you want to measure.

**Angle** Displays the angle formed by the lines from the protractor to the two objects.
**Compass Helper**

Create panel > Helpers > Standard > Object Type rollout > Compass

Create menu > Helpers > Compass

Compass displays as a non-rendering compass rose, with indicators for North, South, East, and West. A compass is part of a Daylight or Sunlight system on page 5491; you create a compass automatically when you create sunlight. In a Sunlight system, the orientation of the compass indicates the orientation of the scene, relative to the path of the sun (the ecliptic).

Use the Compass helper object if you want to create an orientation symbol in your scene, but don’t need to create a sunlight system.

**Procedures**

**To create a compass object:**

1. Choose Compass in the Create panel > Helpers section.
2. Click and drag to define the radius of the compass.
3. Select and rotate the compass object to orient it.

**Interface**

**Parameters rollout**

Show Compass Rose Displays the non-rendering compass rose in the viewport.

Radius Specifies the radius of the compass object.
Manipulator Helper Objects

Create panel > Helpers > Manipulators > Object Type rollout
Create menu > Helpers > Manipulators

Manipulator helpers are objects you can create to manipulate other objects. They let you add customized controls to your scene that provide visual feedback in viewports. To control other objects, manipulators use the parameter wiring feature on page 3610.

Manipulators can be especially useful when you create a scene that will be used by more than one animator.

There are three kinds of manipulator helpers: Cone Angle, Plane Angle, and Slider.

See also:
- Wire Parameters on page 3610
- Parameter Wiring Dialog on page 3612
- Select And Manipulate on page 2838

Cone Angle Manipulator

Create panel > Helpers > Manipulators > Object Type rollout > Cone Angle button
Create menu > Helpers > Manipulators > Cone Angle

The Cone Angle manipulator is a cone whose base you can adjust. By wiring its Angle value to a parameter of another object, you can create a custom control, with visual feedback, within a scene.
Cone angle manipulators are used by a spotlight's Hotspot and Falloff controls.

**Procedures**

**To create a cone angle manipulator:**

1. In the Create panel, go to Helpers and choose Manipulators from the drop-down list.
2. Click to turn on Cone Angle.
3. Drag in a viewport, and then release the mouse.
   The cone angle manipulator is created along the negative Z axis of the viewport in which you drag. In other words, its initial position points away from you.

**To change the angle of a cone angle manipulator:**

1. Turn on Select And Manipulate.

   **TIP** If you are still in the Create panel, turn on Select Object before using the manipulator. Otherwise, it is too easy to create a new one.

2. In a viewport, move the mouse over the manipulator.
The manipulator turns red when the mouse is over it and it is available to be manipulated. Also, a tooltip appears, showing the name of the manipulator and its current value.

3 Drag the base of the cone angle manipulator's cone. The Angle value changes as you drag the manipulator. This value can range between 0.0 and 180.0.

To select a cone angle manipulator:

1 Turn on Select Object. You can also use Select And Move, Select And Rotate, and the scale options on a cone angle manipulator.

2 Turn off Select And Manipulate. If you don't turn off Select And Manipulate, you adjust the manipulator's Angle value without affecting its properties.

3 Adjust the properties of the selected manipulator.

To connect a cone angle manipulator so it controls another object:

1 Select the cone angle manipulator.

NOTE Select And Manipulate must be off before you can select the manipulator.

2 Choose Animation > Wire Parameters > Wire Parameters. You can also right-click the manipulator and choose Wire Parameters from the Transform (lower-right) quadrant of the quad menu. A pop-up menu appears over the manipulator.

3 In the pop-up menu, choose Object (Cone Angle Manipulator) > Angle.

4 Click the object you want to manipulate.
A pop-up menu appears over the object.

5 In the pop-up menu, choose Object, then the name of the parameter you want to manipulate.

The Parameter Wiring dialog on page 3612 appears.

6 On the Parameter Wiring dialog, click the “control direction” arrow between the two upper lists that goes from the manipulator to the object (or both directions), and then click Connect.

7 Close the Parameter Wiring dialog.

Now when you turn on Select And Manipulate and use the manipulator, the object updates under the manipulator’s control.

**Interface**

![Parameter Wiring Interface](image)

- **Angle** The initial angle of the manipulator.
- **Distance** The length of the manipulator, in 3ds Max units. Default=the distance of mouse drag when the manipulator was created.
- **Use Square** When on, the base of the cone is square or rectangular, rather than circular. Default=off.
- **Aspect** When Use Square is on, adjusts the aspect ratio of the rectangular cone base. Default=1.0.
Plane Angle Manipulator

Create panel > Helpers > Manipulators > Object Type rollout > Plane Angle button

Create menu > Helpers > Manipulators > Plane Angle

The Plane Angle manipulator looks like a lever or joystick. By wiring its Angle value to a parameter of another object, you can create a custom control, with visual feedback, within a scene.

Plane angle manipulator at different angles
Procedures

To create a plane angle manipulator:

1. In the Create panel, go to Helpers and choose Manipulators from the drop-down list.
2. Click to turn on Plane Angle.
3. Drag in a viewport, and then release the mouse.
   The plane angle manipulator is always created vertically, along the Y axis of the viewport in which you drag.

To change the angle of a plane angle manipulator:

1. Turn on Select And Manipulate.

   TIP: If you are still in the Create panel, turn on Select Object before using the manipulator. Otherwise, it is too easy to create a new one.

2. In a viewport, move the mouse over the manipulator.
   The manipulator turns red when the mouse is over it and it is available to be manipulated. Also, a tooltip appears, showing the name of the manipulator and its current value.
3. Drag the handle of the plane angle manipulator.
   The Angle value changes as you drag the manipulator. This value can range between –100000.0 and 100000.0.

To select a plane angle manipulator:

1. Turn on Select Object.

   You can also use Select And Move, Select And Rotate, and the scale options on a plane angle manipulator.
2 Turn off Select And Manipulate.
   If you don't turn off Select And Manipulate, you adjust the manipulator's
   Angle value without affecting its properties.

3 Adjust the properties of the selected manipulator.

To connect a plane angle manipulator so it controls another object:

1 Select the plane angle manipulator.

   **NOTE** Select And Manipulate must be off before you can select the
   manipulator.

2 Choose Animation > Wire Parameters > Wire Parameters.
   You can also right-click the manipulator and choose Wire Parameters
   from the Transform (lower-right) quadrant of the quad menu.
   A pop-up menu appears over the manipulator.

3 In the pop-up menu, choose Object (Plane Angle Manipulator) > Angle.

4 Click the object you want to manipulate.
   A pop-up menu appears over the object.

5 In the pop-up menu, choose Object, then the name of the parameter you
   want to manipulate.
   The **Parameter Wiring dialog** on page 3612 appears.

6 On the Parameter Wiring dialog, click the “control direction” arrow
   between the two upper lists that goes from the manipulator to the object
   (or both directions), and then click Connect.

7 Close the Parameter Wiring dialog.
   Now when you turn on Select And Manipulate and use the manipulator,
   the object updates under the manipulator's control.
Interface

![Parameters Interface]

**Angle** The angle of the manipulator, from 0.0 to 360.0 (both values are perpendicular in the Y axis of the viewport where you created the manipulator, unless you have rotated the manipulator object). Default=0.0.

**Distance** The length of the manipulator, in 3ds Max units. Default=the distance of mouse drag when the manipulator was created.

**Size** The size of the manipulator's handle, in 3ds Max units. Default=1.0.

**Slider Manipulator**

Create panel > Helpers > Manipulators > Object Type rollout > Slider button

Create menu > Helpers > Manipulators > Slider

The Slider manipulator is a graphic control that appears in the active viewport. By wiring its Value to a parameter of another object, you can create a custom control, with visual feedback, within a scene.

![Slider manipulator]

**NOTE** Because the slider manipulator is a custom control, its Value has no inherent unit. It takes on the unit of the parameter to which it is wired. When the minimum is 0.0 and the maximum is 100.0, the slider Value can represent a percentage.
Using a Slider Manipulator

Slider manipulator components:
1. Label
2. Value
3. Move
4. Show/hide
5. Slider bar
6. Adjust value
7. Change width

The slider appears in the same location in whichever viewport is active.

You can adjust the slider’s value by dragging the triangle below the slider bar. The triangle turns red when you move the mouse over it. It represents the slider’s value, and the value changes as the triangle is dragged. You can also make the following changes without going into the Modify panel:

- Dragging the small square at the left moves the slider.
- Dragging the diamond at the right changes the width of the slider.
- Clicking the plus sign (next to the move icon at the left) hides all of the slider except for the label and the move icon.

Like the Value triangle, these components also turn red when you move the mouse over them.
Procedures

To create a slider manipulator:

1. In the Create panel, go to Helpers and choose Manipulators from the drop-down list.
2. Click to turn on Slider.
3. Click a viewport.
   The slider manipulator is created with its default width of 100 units. It will appear at the same viewport location in whichever viewport is active.

To change the value of a slider manipulator:

1. Turn on Select And Manipulate.
   The slider turns green.

   TIP
   If you are still in the Create panel, turn on Select Object before using the manipulator. Otherwise, it is too easy to create a new one.

2. In a viewport, move the mouse over the triangle below the slider bar.
   The triangle turns red when the mouse is over it and it is available to be dragged.
3. Drag the value triangle of the slider manipulator.
   The slider's value display changes as you drag the triangle.

To move a slider manipulator:

1. Turn on Select And Manipulate.

2. In the active viewport, move the mouse over the move icon, which is the small square at the left of the slider, below the sliders label (if there is one) and value display.
   The square turns red when the mouse is over it and it is able to be dragged.
3. Drag the box to move the slider.
Unlike angle manipulators, transforms have no effect on sliders.

To connect a slider manipulator so it controls another object:

1. Select the slider.

   **NOTE** Select And Manipulate must be off before you can select the slider.

2. Choose Animation > Wire Parameters > Wire Parameters.
   You can also right-click the manipulator and choose Wire Parameters from the Transform (lower-right) quadrant of the quad menu.
   A pop-up menu appears over the manipulator.

3. In the pop-up menu, choose Object > Value.

4. Drag to the object you want to manipulate, and click it.
   A pop-up menu appears over the object.

5. In the pop-up menu, choose Object, then the name of the parameter you want to manipulate.
   The **Parameter Wiring dialog** on page 3612 appears.

6. In the Parameter Wiring dialog, make sure the direction goes from the slider to the object (or both directions), and then click Connect.

7. Close the Parameter Wiring dialog.
   Now when you turn on Select And Manipulate and use the slider, the object updates under the slider's control.
**Interface**

![Parameters Interface](image)

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label: Percentage</td>
<td></td>
</tr>
<tr>
<td>Value: 0.0</td>
<td></td>
</tr>
<tr>
<td>Minimum: 0.0</td>
<td></td>
</tr>
<tr>
<td>Maximum: 100.0</td>
<td></td>
</tr>
<tr>
<td>X Position: 0.703</td>
<td></td>
</tr>
<tr>
<td>Y Position: 0.185</td>
<td></td>
</tr>
<tr>
<td>Width: 100.0</td>
<td></td>
</tr>
<tr>
<td>Snap:</td>
<td></td>
</tr>
<tr>
<td>Snap Value: 0.01</td>
<td></td>
</tr>
<tr>
<td>Hide:</td>
<td></td>
</tr>
</tbody>
</table>

**Label** The slider name that appears in viewports. Default=none.

**Value** The value of the slider, based on the position of the slidable triangle. Default=0.0.

**Minimum** The minimum possible value of the slider. Default=0.0.

**Maximum** The maximum possible value of the slider. Default=100.0.

When the minimum is 0.0 and the maximum is 100.0, the slider Value can represent a percentage.

**X Position** The slider's X location in the active viewport. Default=Viewport X location you clicked when you created the slider.

**Y Position** The slider's Y location in the active viewport. Default=Viewport Y location you clicked when you created the slider.

**Width** The slider's width, in 3ds Max units. Default=100.0.

**Snap** When on, the slider "snaps" to incremental values determined by the Snap Value setting. Default=on.

**Snap Value** The increment used by the slider when Snap is on. Default=0.01.

**Hide** When on, hides all of the slider except for the label and the move and show/hide components. Default=off.
Drawing Assistants

The tools and utilities described in this section can help with drawing and precision. The xView toolset gives you visual feedback for a variety of mesh-object metrics. The Measure Distance tool lets you quickly calculate the distance between two points. The Measure utility returns the measurements of a selected shape or 3D object. And the Rescale World Units utility rescales either a selection or an entire scene.

Access xView from the Views menu and the Shading viewport label menu. Measure Distance is available from the Tools menu. Access the Measure utility and Rescale World Units from the Utilities panel on page 823.

xView

Views menu > xView
Shading Viewport Label menu on page 8130 > xView > Choose a command.
Activate xView. > Active viewport > Click xView message (test name/result).
xView analyzes mesh models, flags various potential problems and errors, and displays the results in the viewports both graphically and as text. Tests include isolated and overlapping vertices, open edges, various UVW statistics, and more.

In addition, xView can convert its graphical display, such as highlighted vertices or edges, to a sub-object selection. And you can change the tolerance setting (distance) for relevant checks such as overlapping edges.

While a test is active, its name appears at the top or bottom of the active viewport; you determine the position by toggling the Display On Top command on the xView menu. You can open the xView menu by clicking this text.

The xView viewport display

Next to the test name is a status message. If the test has been successful, the message indicates the results, such as “14 Vertices.” Otherwise, the message
indicates a possible reason for the failure of the test, such as “No selection” (xView works only on selected objects) or “Unsupported object type” (xView works only on editable mesh and poly objects).

If the active test is configurable, the message “Click Here To Configure” appears on a second line after the test name. Typically the configurable parameter is a Tolerance setting that determines the maximum distance for the test, such as between vertices. To change the value, click the message or use the xView menu > Configure command.

Customizing xView

Every command on the xView submenu is available from the Customize User Interface (CUI) on page 8249, so you can define keyboard shortcuts or a custom toolbar for frequently used functions. Also available in the CUI xView category are additional actions to cycle through the command list, toggle the viewport display, and more.

Procedure

To use xView:

1. Select the geometry to check; typically an Edit/Editable Mesh/Poly object. There is no need to access a sub-object level.

2. Choose the type of test to perform from the xView menu. By default, you can find this menu on the Shading Viewport Label menu on page 8130 (the rightmost viewport label menu) and the Views menu.

   The test is performed immediately and the results, if any, display in the viewports as green-highlighted sub-objects: vertices, edges, or faces. At the same time, the name of the test and its numerical results display at the bottom or top of the viewport.

   **NOTE** If any of the flagged sub-objects are already selected, they remain selected and display normally at the relevant sub-object level. Thus they are not highlighted in green when the relevant sub-object level is active. However, they’re still flagged and, if you deselect the sub-objects, retain the green highlighting.
3 To convert the highlighted sub-objects to a sub-object selection, reopen the xView menu and choose Select Results. To use the selection, access the relevant sub-object level.

**Interface**

The xView functions work on editable/edit poly and mesh objects; most other object types (including primitives) are unsupported.

All of the modes relate to sub-objects: vertices, edges, and faces (whether geometry or UVW). However, you need not be at a sub-object level for a checker to display its results. The checker results appear at the object level and at all sub-object levels.
Face Orientation  Highlights the back side (see 2-Sided (Double Sided) on page 8493) of each face in the selection. This is useful for checking for inadvertently flipped faces.

Overlapping Faces  Highlights interpenetrating, coplanar faces. This should be avoided when possible to prevent rendering anomalies. Technically, this test checks for at least one vertex of one face lying in the plane of another, so if only edges of two faces overlap, the test won't find them. The Tolerance value specifies the distance from the vertex to the plane of the overlapping face.

Open Edges  Edges that are not shared with any other polygons; that is, at the outer edge of a surface.

Multiple Edges  Checks for edges that are common to more than two faces. This doesn't happen in Edit/Editable Poly objects, but is possible in Edit/Editable Mesh objects. However, if you have any flipped polys in an Edit/Editable Poly, xView flags edges where they adjoin non-flipped polys as multiple edges.
NOTE Because of the underlying nature of Edit/Editable Mesh objects, an internal edge can show two different IDs on the Selection panel when selected twice in succession. However, this does not necessarily indicate a multiple edge, and the Multiple Edges test does not indicate such edges.

**Isolated Vertices** Flags vertices that are not associated with any edges or faces.

**Overlapping Vertices** Flags vertices that lie within a certain distance of each other. The configurable Tolerance parameter indicates the maximum distance in world units within which the test is performed.

**T-Vertices** Flags vertices that lie at the intersection of three edges or faces. Applies to poly objects only.

The T-Vertex is highlighted in green

**Missing UVW Coordinates** Highlights faces that lack texture-mapping coordinates. 3ds Max has internal safeguards against this, but it might happen with certain imported geometry.

**Flipped UVW Faces** Highlights texture-mapping faces whose normals point opposite the usual direction.

**Overlapped UVW Faces** Highlights any texture-mapping faces that coincide with other texture-mapping faces.

**Select Results** Selects sub-objects flagged and highlighted by the active test. To see the selection, go to the relevant sub-object level.

**See-Through** Shows all highlighted sub-objects regardless of any intervening geometry.
Auto Update When on, xView automatically redraws the screen to show the result of parameter changes.

Display On Top When on, the text display appears at the top of the active viewport. When off (the default), the text displays at the bottom of the viewport.

Configure Opens a small dialog for setting the current test’s parameters, if there are any. If there are not, this option is unavailable.

Measuring Distances

3ds Max provides several options for measuring various aspects of your scene. The tape, protractor and compass helpers measure distance, angles and direction respectively. The Measure utility has a floater to display various measurements of any selected object.

You can quickly measure the distance between two points with the Measure Distance tool on page 2881.

Helper Objects for Measurement

Tape Helper

You can create a Tape helper on page 2855 by dragging between any two points in 3D space, much like using a physical tape measure. You then read the length on the Parameters rollout.

If you turn on Specify Length, the length field lets you enter a value in current units. This is like locking a tape measure to a set length. You can position the tape object and snap to its ends.
To display length and angle settings, select only the tape helper object (the pyramid icon).

To move the entire tape including its target (the cube icon), select the connecting line.

Two sets of World Space Angles give you current readouts to the three world axes (X, Y, Z) and the three world planes (XY, YZ, ZX).

**TIP** When measuring with precision, it is helpful to use snaps to force the ends of the tape object to exact locations. If there are no specific points to snap to, you can use dummy or point helpers to set points.

### To measure with a tape helper using snaps:

1. Locate points in the scene to which you can snap to accurately make a measurement. If no points like this exist, create point objects on page 2853 at measurement extremes.

2. Choose 3D from the Snap Toggle flyout.

3. Right-click the Snap Toggle button to display the Grid And Snap Settings dialog. On the Snaps tab, set the snap type to the type you will use for measurement. For example, if you are going to use point objects for measurement, check the Pivot option so you can snap to the point objects' pivot points. Close the dialog.

4. On the Create panel, click the Helpers button, then click Tape. Move the cursor over the first measurement point until the snap cursor appears, then click and drag to the other measurement point.
5  Read the length of the tape on the Parameters rollout.

**Protractor**

The **Protractor helper** on page 2858 measures the angle between pivot points of two objects and the protractor object. As with the tape helper, point objects and snap tools can be used to aid in precise measurement of angles.

**To measure an angle with a protractor:**

1. **On the Create panel, click the Helpers button, then click Protractor. Click in a viewport to place the protractor object.**
2. **On the Parameters rollout, click Pick Object 1 and select an object in your scene. The name of the selected object appears above the pick button. A line connects the protractor to the center of the object.**
3. **Click Pick Object 2 and pick a second object. The angle between the protractor and the two objects appears on the rollout.**
4. **To move either object while watching the Angle readout, turn on Pin Stack below the modifier stack. This locks the stack to the Protractor’s Parameters rollout.**

**Compass**

The **Compass helper** on page 2860 establishes an orientation for your scene. You create this object with a single click and drag to define the radius, usually in a Perspective or Top view. On its parameters rollout, you can adjust the apparent radius of the compass rose. Like all helper objects, this object is for reference only and does not render.

**Measure Utility**

The **Measure Utility** on page 2882 provides measurements of a selected object or shape.
To use the Measure utility:

1. On the Utilities panel, click Measure to display the Measure rollout.
2. Select any shape or object and read out the measurements. If you select multiple objects, the sum of the measurements is displayed.
3. Click New Floater to display a modeless Measure dialog with all the same information.
4. Use the Measure dialog to display the length of a spline, like a line or circle, as you create it.

Measure Distance Tool

The Measure Distance tool quickly calculates the distance between two points.

To measure the distance between two points:

1. Choose Tools menu > Measure Distance.
2. Click in the viewport where you want to start measuring from.
3. Click again in the viewport where you want to measure to.

A distance is returned in the Mini Listener. Additional information, detailing the distance along the X, Y, and Z coordinates is displayed in the status bar.
A distance is returned in the status bar. Additional information, detailing the distance along the X, Y, and Z coordinates is displayed as well.

**Measure Utility**

Utilities panel > Utilities rollout > Measure button

The Measure utility provides measurements of a selected object or shape.

**See also:**

- Measure Distance Tool on page 2881

**Procedures**

To measure an object:

1. On the Utilities panel, click the Measure button.
2. Select the object you want to measure.

   If both an object and a shape are in the selection, information is displayed for both types. If several objects are in a selection, the sum of their measurements is displayed.
**Interface**

- **Text display** Displays the name of the object in the current selection. If more than one object is in the selection, Multiple Objects Selected is displayed.

- **Lock Selected** Prevents the displayed data from changing when you change selection. For example, you might need to select and manipulate another object that affects the currently selected object.

**Objects group**

Displays information about renderable mesh objects.

- **Surface Area** Displays the total surface area of all objects in the selection, in units squared.
Volume Displays the total volume of all objects in the selection, in units cubed. Note that objects with "holes" caused by missing faces can result in inaccurate volume values. When an object has one or more holes, an asterisk appears beside the Volume number.

Center Of Mass Displays the world coordinates of the location of the center of mass for the object or the center of mass of the selected objects.

Create Center Point Creates a point helper object on page 2853 at the center of mass.

Shapes group
Displays information about shape objects.

Length Displays the sum of the length of all splines in all selected shapes.

Dimensions group
Displays the dimensions of the object, as they appear in world space. For example, if it were a box with the created dimensions of 15 x 10 x 25, and that box were scaled 200 percent, then this group would report dimensions of 30 x 20 x 50.

Button set

New Floater Launches a modeless Measure dialog that displays the same information found under the Objects, Shapes, and Dimensions groups on the Utilities panel. In addition, you can expand the dialog horizontally, in case the values are too long to be viewed in the default dialog size.

TIP While the Measure floater is displayed, you can view the length of a spline while you're creating it.

Close Closes the utility.

Rescale World Units Utility

Utilities panel > Utilities rollout > More button > Utilities dialog > Rescale World Units

This utility rescales the world units of either the entire scene or selected objects in the scene. The Rescale World Units dialog controls scale factor and whether it is applied to the entire scene or the current selection.
Procedures

To rescale an object:

1. Select an object in the viewport.
2. On the Utilities panel, click the More button, and on the Utilities dialog, choose Rescale World Units from the list.
3. On the Utilities panel, click the Rescale World Units button.
4. On the Rescale World Units rollout, click the Rescale button.
5. Set the Scale Factor to the desired scale. For example, setting the scale to a value of 2.0 doubles the size of the object that it’s applied to.
6. In the Affect group, choose the Selection option.
7. Click OK to apply the scale.

Interface

Rescale World Units rollout

Rescale After selecting the objects you want to rescale, click this to display the Rescale World Units dialog.
Rescale World Units dialog

Scale Factor Specifies the scaling factor.

Affect
- **Scene** Applies the scale to the entire scene.
- **Selection** Applies the scale only to the current selection.

OK Applies the scale.

Cancel Cancels the operation.
Space Warps and Particle Systems

Space warps and particle systems are additional modeling tools. Space warps are “force fields” that deform other objects, creating the effect of ripples, waves, blowing wind, and so on. Particle systems generate particle sub-objects for the purpose of simulating snow, rain, dust, and so on. (You use particle systems primarily in animations.)

Left: Fountain spray created as a particle system
Insets on right: Wind space warp changes the direction of fountain spray

Space Warp Objects

Create panel > Space Warps
Space warps are nonrenderable objects that affect the appearance of other objects. Space warps create force fields that deform other objects, creating the effect of ripples, waves, blowing wind, and so on.

Space warps behave somewhat like modifiers, except that space warps influence world space, rather than object space, as geometric modifiers do.

When you create a space warp object, viewports show a wireframe representation of it. You can transform the space warp as you do other 3ds Max objects. The position, rotation, and scale of the space warp affect its operation.

Surfaces deformed by space warps
Left: Bomb
Right: Ripple
Rear: Wave

A space warp affects objects only when the objects are bound to it on page 2893. The warp binding appears at the top of the object's modifier stack. A space warp is always applied after any transforms or modifiers.

When you bind multiple objects to a space warp, the space warp's parameters affect all the objects equally. However, each object's distance from the space
warp or spatial orientation to the warp can change the warp's effect. Because of this spatial effect, simply moving an object through warped space can change the warp's effect.

You can also use multiple space warps on one or more objects. Multiple space warps appear in an object's stack in the order you apply them.

**NOTE** You can take advantage of the AutoGrid feature to orient and position new space warps with respect to existing objects. See AutoGrid on page 2792 for details.

**Space Warps and Supported Objects**

Some types of space warps are designed to work on deformable objects, such as geometric primitives, meshes, patches, and splines. Other types of warps work on particle systems such as Spray and Snow.

Five space warps (Gravity, PBomb, Wind, Motor, and Push) can work on particle systems and also serve special purposes in a dynamics simulation. In the latter case, you do not bind the warps to objects, but rather assign them as effects in the simulation.

On the Create panel, each space warp has a rollout labeled Supports Objects Of Type. This rollout lists the kind of objects you can bind to the warp.

**Basics of Using Space Warps**

Follow these general steps to use space warps:

1. Create the space warp.
2. Bind objects to the space warp.

   ![Click Bind To Space Warp](click_bind_to_space_warp.png)

   Click Bind To Space Warp on the main toolbar (available from the Select And Link flyout), and then drag between the space warp and the object.

   The space warp has no visible effect on your scene until you bind an object, system, or selection set to it.
3. Adjust the space warp's parameters.
4. Transform the space warp with Move, Rotate, or Scale. The transforms often directly affect the bound object.

You can animate space warp parameters and transforms. You can also animate space warp effects by animating transforms of an object bound to the warp.
Particle Leakage and Deflector Space Warps

A deflector is a space warp that acts as a barrier to particles in particle systems. Occasionally stray particles can leak through a deflector under the following circumstances:

- When a particle happens to hit the deflector too near the end or beginning of a time interval, and numerical error in the solution doesn't report a hit
- When a particle hits too near the edge of a face referenced by a UDeflector, and neither face finds it
- When a particle is moving quickly and first appears too close to the deflector, so the very first update cycle within the particle system takes it past the deflector without the deflector ever seeing it

Often this isn't a problem because the particles bounce off solid objects, so you don't see the errant particles. When it does cause problems, you can use a planar deflector instead of a UDeflector, a collection of planars to approximate the mesh, or a simple mesh to replace the planar. The solutions vary, so where one has a glitch the other might work just fine.

If particles are moving fast and the deflector is in a particular position (for example, it might be too close to the emitter) many particles can leak through deflectors. Sometimes you can fix this leakage by changing the particle system's Subframe Sampling setting or the particle speed. Other times you must reposition the deflector farther away from the emitter.

In addition, particles imbued with bubble motion on page 3356 can leak through deflectors, particularly when set to high amplitudes. To avoid this, use alternative methods of implementing bubble-like motion, such as varying speed (see Particle Generation Rollout (PArray) on page 3338), setting a higher angle for the stream spread with spray systems (see Spray Particle System on page 3306, Super Spray Particle System on page 3315), or using larger particles with an animated texture map.

Space Warp Categories

There are four categories of space warps, available via the list on the Create panel's Space Warps category.

Forces

These space warps are used to affect particle systems and dynamics systems. All of them can be used with particles, and some can be used with dynamics.
The Supports Objects of Type rollout indications which systems each space warp supports.

**Motor Space Warp** on page 2898

**Push Space Warp** on page 2894

**Vortex Space Warp** on page 2903

**Drag Space Warp** on page 2908

**Path Follow Space Warp** on page 2919

**PBomb Space Warp** on page 2914

**Displace Space Warp** on page 2930

**Gravity Space Warp** on page 2923

**Wind Space Warp** on page 2926

**Deflectors**

These space warps are used to deflect particles or to affect dynamics systems. All of them can be used with particles and with dynamics. The Supports Objects of Type rollout indicates which systems each space warp supports.

**PDynaFlect Space Warp** on page 2941

**POmniFlect Space Warp** on page 2935

**SDynaFlect Space Warp** on page 2948

**SOmniFlect Space Warp** on page 2946

**UDynaFlect Space Warp** on page 2951
**Geometric/Deformable**

These space warps are used to deform geometry.

- **FFD(Box) Space Warp** on page 2962
- **FFD(Cyl) Space Warp** on page 2969
- **Wave Space Warp** on page 2979
- **Ripple Space Warp** on page 2983
- **Displace Space Warp** on page 2930
- **Conform Space Warp** on page 2987
- **Bomb Space Warp** on page 2991

**Modifier-Based**

These are space-warp versions of object modifiers (see **Modify Panel** on page 8184). Read more about these in **Modifier-Based Space Warps** on page 2995.

- **Bend Modifier** on page 1165
- **Noise Modifier** on page 1544
- **Skew Modifier** on page 1664
- **Taper Modifier** on page 1807
- **Twist Modifier** on page 1833
- **Stretch Modifier** on page 1749

**Procedures**

**To create a space warp:**

1. On the Create panel, click Space Warps.
   The Space Warps panel is displayed.
2 Choose a category of space warp from the list.
3 On the Object Type rollout, click a space warp button.

**TIP** You can take advantage of the AutoGrid feature to orient and position new space warps with respect to existing objects. For details, see AutoGrid on page 2792.

4 Drag in a viewport to create the space warp.
See the topics for the various space warps for further details.

---

**Bind to Space Warp**

Main toolbar > Bind to Space Warp

Use the Bind to Space Warp button to attach the current selection to a space warp on page 8727 or vice versa.

**Procedures**

To bind the current selection to a space warp:

1 Select an object

2 Click Bind to Space Warp.

3 Drag a line from the selected object to the space warp object. You can also press H to select the space warp by name.
The space warp object flashes for a moment to show that the bind was successful.

**Forces**

Forces affect particle systems and dynamics systems.
Push Space Warp

Create panel > Space Warps > Forces > Object Type rollout > Push
Create menu > Space Warps > Forces > Push

For particle systems, Push applies a uniform, unidirectional force. For dynamics systems, it provides a point force: like pushing something with your finger.

Push disperses a cloud of particles

The Push space warp applies a force to either particle systems on page 2997 or dynamics systems on page 4190. The effect is different, depending on the system:

- **Particles**: Applies a uniform, unidirectional force in a positive or negative direction. A positive force moves in the direction of the pad on the
hydraulic jack. The breadth of the force is infinite, perpendicular to the direction; you can limit it using the Range option.

- **Dynamics**: Provides a point force (also called a point load) away from the pad of the hydraulic jack icon. A negative force pulls in the opposite direction. In dynamics, applying a force is the same as pushing something with your finger.

Procedures

To create a Push space warp:

1. On the Create panel, click Space Warps. Choose Forces from the list, and then on the Object Type rollout, click Push.
2. Drag in a viewport to define the size.
   The Push warp appears as a hydraulic jack icon.
Interface

- Parameters
  - Timing
    - On Time: 0
    - Off Time: 30
  - Strength Control
    - Basic Force: 1.0
    - Newtons
    - Feedback On
    - Reversible
    - Target Speed: 100.0
    - Gain: 50.0
  - Periodic Variation
    - Enable
    - Period 1: 0
    - Amplitude 1: 100.0
    - Phase 1: 0.0
    - Period 2: 0
    - Amplitude 2: 100.0
    - Phase 2: 0.0
  - Particle Effect Range
    - Enable
    - Range: 1000.0
  - Display Icon
    - Icon Size: 10x388
Timing group

On Time/Off Time The numbers of the frames in which the space warp begins and ends its effect. Because Push moves the particles to which it’s applied over time, no keyframes are created.

Strength Control group

Basic Force The amount of force exerted by the space warp.

Newtons/Pounds This option specifies the units of force used by the Basic Force spinner.

A pound is about 4.5 Newtons, and one newton is one kilogram-per-second-squared. When Push is applied to particle systems, these values have only subjective meaning because they depend on the built-in weighting factors and time scaling used by the particle system. However, when used in a dynamics system, the value listed is precisely the value used.

Feedback On When on, the force varies depending on the speed of the affected particles relative to the specified Target Speed. When off, the force remains constant, regardless of the speed of the affected particles.

Reversible When on, if the particle's speed exceeds the Target Speed setting, the force is reversed. Available only if you turn on Feedback On.

Target Speed Specifies the maximum speed in units per frame before the Feedback takes effect. Available only if you turn on Feedback On.

Gain Specifies how quickly the force adjusts to approaching the target speed. If set to 100 percent, the correction is immediate. If set lower, a slower and "looser" response occurs. Available only if you turn on Feedback On.

NOTE Setting Gain above 100 percent can result in over-correction, but is sometimes necessary to overcome damping from other system settings, such as IK damping.

Periodic Variation group

These settings introduce variations into the force by affecting the Basic Force value randomly. You can set two waveforms to produce a noise effect.

Enable Turns on the variations.

Period 1 The time over which the noise variation makes a full cycle. For example, a setting of 20 means one cycle per 20 frames.
Amplitude 1 The strength of the variation (in percent). This option uses the same types of units as the Basic Force spinner.

Phase 1 Offsets the variation pattern.

Period 2 Provides an additional variation pattern (a second wave) to increase the noise.

Amplitude 2 The strength of the variation of the second wave (in percent). This option uses the same types of units as the Basic Force spinner.

Phase 2 Offsets the variation pattern of the second wave.

Particle Effect Range group

Lets you restrict the Push effect's range to a specific volume. This affects particle systems only; it has no effect on dynamics.

Enable When on, limits the range of the effect to a sphere, displayed as a tri-hooped sphere. The effect falls off increasingly as the particles near the boundary of the sphere.

Range Specifies the radius of the range of the effect, in units.

Display Icon group

Icon Size Sets the size of the Push icon. This is for display purposes only, and does not alter the Push effect.

Motor Space Warp

Create panel > Space Warps > Forces > Object Type rollout > Motor
Create menu > Space Warps > Forces > Motor

The Motor space warp works like Push on page 2894, but applies rotational torque to the affected particles or objects rather than a directional force. Both the position and orientation of the Motor icon affect particles, which swirl around the Motor icon.
Motor disperses a cloud of particles

When used in dynamics, the position of the icon relative to the affected object has no effect, but the orientation of the icon does.

Motor viewport icon (with particle system on the left)
Procedures

To create a motor space warp:

1 On the Create panel, click Space Warps > Forces > Motor. Choose Forces from the list, then on the Object Type rollout, click Motor.

2 Click and drag in a viewport to define the size.

The Motor warp appears as a box-shaped icon with an arrow indicating the direction of the torque.

Interface

Timing group

On Time/Off Time The numbers of the frames in which the space warp begins and ends its effect. Because Motor moves the objects to which it’s applied over time, no keyframes are created.

Strength Control group

Basic Torque The amount of force exerted by the space warp.
N·m/Lb-ft/Lb-in Specify the unit of measure for the Basic Torque setting, using common world measurements of torque. N-m stands for Newton meters, Lb-ft stands for pound-force feet, and Lb-in stands for pound-force inches.

Feedback On When on, the force varies depending on the speed of the affected objects relative to the specified Target Speed. When off, the force remains constant, regardless of the speed of the affected objects.

Reversible When on, if the object’s speed exceeds the Target Speed setting, the force is reversed. Available only if you turn on Feedback On.

Target Revs Specifies the maximum revolutions before the feedback takes effect. Speed is specified in units traveled per frame. Available only if you turn on Feedback On.

RPH/RPM/RPS Specifies the units of measure for Target Revs in revolutions per hour, minute, or second. Available only if you turn on Feedback On.

Gain Specifies how quickly the force adjusts to approaching the target speed. If set to 100%, the correction is immediate. If set lower, a slower and "looser" response occurs. Available only if you turn on Feedback On.

NOTE Setting Gain above 100% can result in over-correction, but is sometimes necessary to overcome damping from other system settings, such as IK damping.
**Periodic Variation group**

These settings introduce variations into the force by affecting the Basic Torque value randomly. You can set two waveforms to produce a noise effect.

**Enable** Turn on to enable the variations.

**Period 1** The time over which the noise variation makes a full cycle. For example, a setting of 20 means one cycle per 20 frames.

**Amplitude 1** The strength of the variation (in percent). This option uses the same types of units as the Basic Torque spinner.

**Phase 1** Offsets the variation pattern.

**Period 2** The next two spinners provide an additional variation pattern to increase the noise.
Amplitude 2 The strength of the variation of the second wave in (percent). This option uses the same types of units as the Basic Torque spinner.

Phase 2 Offsets the variation pattern of the second wave.

Particle Effect Range group

Lets you restrict the Motor effect’s range to a specific spherical volume. This affects particles systems only; it has no effect on dynamics.

Enable When on, limits the range of the effect to a sphere, displayed as a tri-hooped sphere. The effect falls off increasingly as the particles near the boundary of the sphere.

Range Specifies the radius of the range of the effect, in units.

Display Icon group

Icon Size Sets the size of the Motor icon. This is for display purposes only, and does not alter the Motor effect.

Vortex Space Warp

Create panel > Space Warps > Forces > Object Type rollout > Vortex

Create menu > Space Warps > Forces > Vortex

The Vortex space warp applies a force to particle systems on page 2997, spinning them through a whirling vortex, and then moving them down a long, thin spout or vortex well. Vortex is useful for creating black holes, whirlpools, tornadoes, and other funnel-like objects.

The space warp settings let you control the vortex shape, the well characteristics, and rate and range of particle capture. The shape of the vortex is also affected by particle system settings, such as speed.
Particle stream caught in a vortex

**Procedures**

To create a Vortex space warp:

1. On the Create panel, click Space Warps. Choose Forces from the list, and then click Vortex.

2. Determine which world axis you want the vortex to spiral around, and then drag in the appropriate viewport to create the space warp. For example, if you want the vortex to spin around the vertical world axis, create the space warp in the Top viewport. You can rotate the warp later to change the vortex direction, and animate the warp orientation.
The Vortex warp appears as a curved-arrow icon in the plane you drag in, with a second, perpendicular arrow indicating the axis of rotation as well as the direction of the well. This second axis is called the drop axis.

**NOTE** The position of the space warp plays an important role in the results. The vertical position affects the shape of the vortex, and the horizontal position determines its location. If you want the particles to spiral around the particle emitter, place both at the same location.
**Interface**

**Timing group**

*Time On/Time Off* The frame numbers at which the space warp becomes active and becomes inactive.
**Vortex Shape group**

**Taper Length** Controls the length of the vortex, as well as its shape. Lower settings give you a "tighter" vortex, while higher settings give you a "looser" vortex. Default=100.0.

**Taper Curve** Controls the shape of the vortex. Low values create a vortex with a wide, flared mouth, while high values create a vortex with nearly vertical sides. Default=1.0. Range=1.0 to 4.0.

**Capture and Motion group**

This group contains basic settings for Axial Drop, Orbital Speed, and Radial Pull, with Range, Falloff, and Damping modifiers for each.

**Unlimited Range** When on, Vortex exerts full damping strength over an unlimited range. When off, the Range and Falloff settings take effect.

**Axial Drop** Specifies how quickly particles move in the direction of the drop axis.

**Range** The distance from the center of the Vortex icon, in system units, at which Axial Damping has its full effect. Takes effect only when Unlimited Range is turned off.

**Falloff** Specifies the distance beyond the Axial Range within which Axial Damping is applied. Axial Damping is strongest at the Range distance, decreases linearly out to the limit of the Axial Falloff, and has no effect beyond that. Takes effect only when Unlimited Range is turned off.

**Damping** Controls the degree to which particle motion parallel to the drop axis is restrained per frame. Default=5.0. Range=0 to 100.

For subtle effects, use values of less than 10%. For more overt effects, try using higher values that increase to 100% over the course of a few frames.

**Orbital Speed** Specifies how quickly the particles rotate.

**Range** The distance from the center of the Vortex icon, in system units, at which Orbital Damping has its full effect. Takes effect only when Unlimited Range is turned off.

**Falloff** Specifies the distance beyond the Orbital Range within which Orbital Damping is applied. Orbital Damping is strongest at the Range distance, decreases linearly out to the limit of the Orbital Falloff, and has no effect beyond that. Takes effect only when Unlimited Range is turned off.
**Damping** Controls the degree to which orbital particle motion is restrained per frame. Smaller values produce a wide spiral, while larger values produce a thin spiral. Default=5.0. Range=0 to 100.

**Radial Pull** Specifies the distance from the drop axis at which the particles rotate.

**Range** The distance from the center of the Vortex icon, in system units, at which Radial Damping has its full effect. Takes effect only when Unlimited Range is turned off.

**Falloff** Specifies the distance beyond the Radial Range within which Radial Damping is applied. Radial Damping is strongest at the Range distance, decreases linearly out to the limit of the Radial Falloff, and has no effect beyond that. Takes effect only when Unlimited Range is turned off.

**Damping** Controls the degree to which Radial Pull is restrained per frame. Default=5.0. Range=0 to 100.

**CW/CCW** Determines whether particles rotate clockwise or counterclockwise.

**Display group**

**Icon Size** Specifies the size of the icon.

---

**Drag Space Warp**

Create panel > Space Warps > Forces > Object Type rollout > Drag

Create menu > Space Warps > Forces > Drag

The Drag space warp is a particle motion damper that reduces particle velocity by a specified amount within a specified range. The damping can be applied linearly, spherically, or cylindrically. Drag is useful for simulating wind resistance, transfers into dense media (like water), impacts with force fields, and other, similar situations.

With each damping type, you can control the damping effect along several vectors. The damping is also affected by particle system settings, such as speed.

---

**NOTE** To create a uniform drag effect, the default value for all directional parameters is 5.0%.
Drag slows down a stream of particles.

Procedures

To create a Drag space warp:

1. On the Create panel, click Space Warps. Choose Forces from the list, and then click Drag.

2. Drag in a viewport to create the space warp.
   The space warp appears initially as a box within a box, indicating that it’s using the default Linear Damping mode.

3. To apply the damping spherically or cylindrically, choose Spherical Damping or Cylindrical Damping in the command panel.
NOTE The position and orientation of the space warp plays an important role for all three damping types.

4 Change the settings for the current damping type as necessary.
## Interface

### Parameters

<table>
<thead>
<tr>
<th>Timing</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Time On:</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Time Off:</td>
<td>100</td>
<td></td>
</tr>
</tbody>
</table>

### Damping Characteristics

#### Unlimited Range

- **Linear Damping**
  - X Axis: 5.0
  - Range: 100.0
  - Fault: 1000.0
- Y Axis: 5.0
  - Range: 100.0
  - Fault: 1000.0
- Z Axis: 5.0
  - Range: 100.0
  - Fault: 1000.0

#### Spherical Damping

- Floccal: 5.0
  - Range: 100.0
  - Fault: 1000.0
- Tangential: 5.0
  - Range: 100.0
  - Fault: 1000.0

#### Cylindrical Damping

- Floccal: 5.0
  - Range: 100.0
  - Fault: 1000.0
- Tangential: 5.0
  - Range: 100.0
  - Fault: 1000.0

### Display

- Icon Size: 25.5

---

Forces | 2911
Timing group

Time On/Time Off  The frame numbers at which the space warp becomes active and becomes inactive.

Damping Characteristics group

This group lets you choose Linear Damping, Spherical Damping, or Cylindrical Damping, plus a set of parameters for each.

Unlimited Range  When on, Drag exerts full damping strength over an unlimited range. When off, the Range and Falloff settings for the current damping type take effect.

- **Linear Damping**  Motion for each particle is separated into vectors for the space warp's local X, Y, and Z axes. The area over which damping is exerted for each vector is an infinite plane whose thickness is determined by the corresponding Range setting.

  X Axis/Y Axis/Z Axis  Specifies the percentage of particle motion along the local Drag space warp axis that's affected by the damping.

  Range  Sets the thickness of the "range plane," or the infinite plane perpendicular to the specified axis. Takes effect only when Unlimited Range is turned off.

  Falloff  Specifies the distance beyond the X, Y, or Z Range within which Linear Damping is applied. Damping is strongest at the Range distance, decreases linearly out to the limit of the Falloff, and has no effect beyond that. While Falloff takes effect only beyond the Range, it is measured from the center of the icon, and always has a minimum value equal to the Range value. Takes effect only when Unlimited Range is turned off.

- **Spherical Damping**  When Drag operates in Spherical Damping mode, its icon is a sphere within a sphere. Particle motion is broken up into radial and tangential vectors. Damping is applied for each vector within a spherical volume whose radius is set by the Range setting, when Unlimited Range is off.

  Radial/Tangential  Radial specifies the percentage of particle motion toward or away from the center of the Drag icon that's affected by the damping. Tangential specifies the percentage of particle motion across the body of the Drag icon that's affected by the damping.
Range
Specifies the distance from the center of the Drag icon, in system units, within which damping is in full effect. Takes effect only when Unlimited Range is turned off.

Falloff
Specifies the distance beyond the Radial/Tangential Range within which Linear Damping is applied. Damping is strongest at the Range distance, decreases linearly out to the limit of the Falloff, and has no effect beyond that. While Falloff takes effect only beyond the Range, it is measured from the center of the icon, and always has a minimum value equal to the Range value. Takes effect only when Unlimited Range is turned off.

Cylindrical Damping
When Drag operates in Spherical Cylindrical mode, its icon is a cylinder within a cylinder. Particle motion is broken up into radial, tangential, and axial vectors. Damping is applied within a spherical volume for the radial and tangential vectors and on a planar basis for the axial vector.

Radial/Tangential/Axial
Damping controls the percentage of particle motion toward or away from the center of the circular portion of the icon (Radial), across the radial vector (Tangential), or along the length of the icon's long axis (Axial) that's affected by the damping, on a per-frame basis.

Range
Specifies the distance from the center of the Drag icon, in system units, within which Radial and Axial damping are in full effect. Range also specifies the thickness of the infinite plane that governs the range of Axial damping. Takes effect only when Unlimited Range is turned off.

Falloff
Specifies the distance beyond the Radial/Tangential/Axial Range within which Linear Damping is applied. Damping is strongest at the Range distance, decreases linearly out to the limit of the Falloff, and has no effect beyond that. While Falloff takes effect only beyond the Range, it is measured from the center of the icon, and always has a minimum value equal to the Range value. Takes effect only when Unlimited Range is turned off.

Display group
Icon Size  Specifies the size of the icon.

Forces | 2913
PBomb Space Warp

Create panel > Space Warps > Forces > Object Type rollout > PBomb
Create menu > Space Warps > Forces > PBomb

The PBomb space warp creates an impulse wave to blow up a particle system, as distinguished from the Bomb space warp on page 2991, which blows up geometry. The PBomb is particularly well suited to the Particle Array (PArray) system with Particle Types set to Object Fragments. This space warp also applies an impulse as a dynamics effect.

The general usage is as follows:

- Create a particle system (recommended: a PArray system on page 3331 set to Object Fragments).

- Create a PBomb and use Bind to Space Warp on page 2893 to bind it to a non-event-driven particle system. Be sure to bind the PBomb to the particle system and not to the distribution object. Or, if using Particle Flow, use a Force operator on page 3189 to apply the space warp to the particle system.

- Adjust the parameters of both the PBomb and the particle system.

Right: PBomb viewport icon
Above: PArray particle system

Below: Torus knot used as the PArray's distribution object

Effect of blowing up the torus knot

**Procedures**

**Example: To use PBomb with PArray:**

You can use the Particle Bomb bound to a Particle Array to blow an object into fragments. The following steps demonstrate the basic setup.

Begin by binding a particle array to an object, and setting parameters.

1. Create the object you want to blow up.
2. Create a PArray and use Pick Object to assign the object to blow up as the PArray object-based emitter.
3. In the Basic Parameters rollout > Viewport Display group, choose Mesh to display the fragments as mesh objects in the viewports.
4 On the Particle Generation rollout of PArray, set Speed and Divergence to 0.0. This prevents PArray from moving the particles, letting PBomb do the work.

5 On the Particle Generation rollout, set Life to the length of the active time segment, so that the fragments appear during the entire animation.

6 In the Particle Type rollout > Particle Types group, choose Object Fragments. In the Object Fragment Controls group, choose Number of Chunks, and set the Minimum to about 50, depending on your distribution object and the effect you want.

Now create a particle bomb, and bind it to the particle array.

1 In the Space Warps panel > Particles & Dynamics category, click the PBomb button and drag in a viewport to create the PBomb icon.

2 Use Bind to Space Warp to bind the PArray icon to the PBomb icon. (Don’t bind the distribution object by mistake.)

3 Select the PBomb icon and move to the Modify panel.

4 In the Explosion Parameters group, set Blast Symmetry to Spherical, Start Time to 10, Duration to 1, and Strength to 1.0. Choose Linear, if it’s not already chosen.

5 Drag the time slider between frames 9 and 20 to see the effect.

6 Go to frame 12 and try out various settings. Notice that increasing Strength expands the explosion effect at the current frame. If you decrease Range enough, the bomb no longer affects all or part of the object (depending on the placement of the PBomb icon). Test the three Blast Symmetry settings by placing the bomb in the center of the object and then seeing the different blast patterns.

Once you get an explosive effect you like, you can return to the PArray settings, add spin or thickness to the fragments, and so on.
Interface

Blast Symmetry group

These options specify the shape, or pattern of the blast effect.

**Spherical** The blast force radiates outward from the PBomb icon in all directions. The icon looks like a spherical anarchist's bomb.

**Cylindrical** The blast force radiates outward from and normal to the central axis, or core of the cylindrical icon. The icon looks like a stick of dynamite with a fuse.

**Planar** The blast force radiates both up and down, perpendicular to the plane of the planar icon. The icon looks like a plane with arrows pointing up and down along the direction of the blast force.

**Chaos** The blast forces vary for each particle or each frame, an effect similar to Brownian motion, with a rate of change in the direction of force equal to
the rendering interval rate. Note: This setting is effective only when the
Duration spinner is set to 0.

**Explosion Parameters group**

**Start Time** The frame number at which the impulse forces are first applied to
the particles.

**Duration** The number of frames, beyond the first, over which the forces are
applied. This value should typically be a small number, such as between 0 and
3.

**Strength** The change in velocity along the blast vector, in units per frame.
Increasing Strength increases the speed with which the particles are blown
away from the bomb icon.

**Unlimited Range** The effects of the bomb icon reach all bound particles
throughout the scene. This option ignores the Range setting (which specifies
the distance of the PBomb effect).

**Linear** The impulse forces decay linearly between the full Strength setting to
a value of 0 at the specified Range setting.

**Exponential** The impulse forces decay exponentially between the full Strength
setting to a value of 0 at the specified Range setting.

**Range** The maximum distance, in units, over which the PBomb icon affects
the bound particle system. If the Range is large enough to reach only a portion
of the particle system, only that part of the system is affected.

If you turn on Range Indicator (see following), the extent of the range is
indicated by a tri-ahooped sphere. If you choose Unlimited Range, this
parameter has no effect.

**Display Icon group**

These options affect the visual display of the PBomb icon.

**Icon Size** Alters the overall size of the PBomb icon.

**Range Indicator** Displays a wireframe sphere that indicates the volume of
the particle bomb's influence. If you choose Unlimited Range, turning this
on has no effect.
Path Follow Space Warp

Create panel > Space Warps > Forces > Object Type rollout > Path Follow
Create menu > Space Warps > Forces > Path Follow
The Path Follow space warp forces particles to follow a spline path.

Particles following a spiral path

Procedures

To create a Path Follow space warp:

1. On the Create panel, click Space Warps. Choose Forces from the list, then on the Object Type rollout, click Path Follow.

2. Click and drag in a viewport to define the size.
   The Path Follow warp appears as a box-shaped icon containing curved lines that indicate hypothetical paths.

To set up and use Path Follow:

1. Create a shape consisting of a single spline. (You can use shapes with multiple splines, but 3ds Max uses only one spline for the path.)

2. Create a particle system and set its parameters to emit particles over a range of frames.
3 On the Create panel, click Path Follow, and drag in a viewport to create the Path Follow icon (a cube with wavy lines). The display and position of this icon don’t affect the particles.

4 On the Basic Parameters rollout, click Pick Shape Object and select the spline you created earlier.

5 Bind the Path Follow icon to the particle system.

6 Adjust the Path Follow parameters to create the particle movement you want.

**NOTE** You can further animate the particle effect by animating the spline vertices.

**TIP** To adjust the position of the path or particle system while maintaining access to the Path Follow parameters, select the Path Follow space warp and then turn on Pin Stack, below the modifier stack.

If the particles don't follow the emitter after it's moved, then change any PathFollow parameter, and the motion will be corrected.
Interface

- Basic Parameters
  - PARTICLE PATH FOLLOW
    - Current Path: <None>
    - Pick Shape Object
      - Unlimited Range
        - Range: 100.0
  - Motion Timing:
    - Start Frame: 0
    - Travel Time: 30
    - Variation: 0.0
    - Last Frame: 100
  - Particle Motion:
    - Along Offset Splines
    - Along Parallel Splines
    - Constant Speed
      - Stream Taper: 1.0
      - Variation: 0.0
      - Converge
      - Diverge
      - Both
      - Stream Swift: 1.0
      - Variation: 0.0
      - Clockwise
      - Counterclockwise
      - Bidirectional
  - Uniqueness:
    - Seed: 12345
  - Display Icon
    - Icon Size: 36.218
Current Path group

Lets you choose the path for the particles, and specify the range of influence of the Space Warp.

Object Displays the name of the currently assigned path.

Pick Shape Object Click this, and then click a shape in the scene to select it as a path. You can use any shape object as a path; if you select a multiple-spline shape, only one the lowest-number spline is used. You can also use NURBS curves as paths.

Unlimited Range When off, the range of influence of the space warp is limited to the value set in the Distance spinner. When on, the space warp influences all bound particles in the scene, regardless of their distance from the path object.

Range Specifies the range of influence when Unlimited Range is off. This is the distance between the path object and the particle system. The position of the Path Follow space warp's icon is ignored.

Motion Timing group

These controls affect how long particles are influenced by Path Follow.

Start Frame The frame at which Path Follow begins to influence the particles.

Travel Time The time each particle takes to traverse the path.

Variation The amount by which each particle's travel time can vary.

Last Frame The frame at which Path Follow releases the particles and no longer influences them.

Particle Motion group

The controls in this area determine the motion of particles.

Along Offset Splines The distance between the particle system and the path alter the effect of the particle motion. If the first vertex of the spline is at the birthplace of the particle, the particle follows the spline path. If you move the path away from the particle system, the particles are affected by the offset.

Along Parallel Splines Particles follow a copy of the selected path, parallel to the particle system. In this mode, the position of the path relative to the particle system does not matter. The orientation of the path, however, affects the particle stream.
**Constant Speed** When on, all particles travel at the same speed.

**Stream Taper** Causes particles to converge or diverge toward the path over time, or to simultaneously converge and diverge. You specify the effect by choosing Converge, Diverge, or Both (see following). This provides a tapering effect over the length of the path.

**Variation** The amount by which Stream Taper can vary for each particle.

**Converge** When Stream Taper is greater than 0, the particles move in toward the path as they follow the path. The effect is that the stream tapers from larger to smaller over time.

**Diverge** Provides the opposite effect of Converge. The particles diverge from the path over time.

**Both** Splits the particle stream, causing some particles to converge and others to diverge.

**Stream Swirl** Specifies the number of turns by which particles spiral about the path. In conjunction with Stream Taper, alters the diameter of the spiral. Stream Swirl is generally more effective when you choose Along Offset Splines.

**Variation** The amount by which each particle can vary from the Spiral value.

**Clockwise** Particles spiral in a clockwise direction.

**Counterclockwise** Particles spiral in a counterclockwise direction.

**Bidirectional** The stream is split so that particles spiral in both directions.

**Uniqueness group**

Provides a seed number for unique generation of the particle pattern.

**Seed** Specifies the seed number for the current Path Follow.

**Display Icon group**

Affects the display of the Path Follow icon.

**Icon Size** Specifies the size of the Path Follow icon. Does not alter the Path Follow effect.

**Gravity Space Warp**

Create panel > Space Warps > Forces > Object Type rollout > Gravity
Create menu > Space Warps > Forces > Gravity

The Gravity space warp simulates the effect of natural gravity on particles generated by a particle system. Gravity is directional. Particles moving in the direction of the gravity arrow accelerate. Particles moving against the arrow decelerate.

Particles falling because of gravity

In the case of spherical gravity, motion is toward the icon. Gravity can also be used as an effect in dynamics simulations. See Dynamics Utility on page 4190.

Gravity effect on snow

Procedures

To create gravity:

1. On the Create panel, click Space Warps. Choose Forces from the list, then on the Object Type rollout, click Gravity.
2 Drag in a viewport.

The Gravity icon appears. For planar gravity (the default), the icon is a wireframe square with a direction arrow on one side. For spherical gravity, the icon is a wireframe sphere.

The initial direction of planar gravity is along the negative Z axis of the construction grid that is active in the viewport where you drag. You can rotate the gravity object to change the direction.

**Interface**

![Parameters interface](image)

**Force group**

**Strength** Increasing Strength increases the effect of gravity; that is, how objects move in relation to the Gravity icon's direction arrow. Strength less than 0.0 creates negative gravity, which repels particles moving in the same direction and attracts particles moving in the opposite direction. When Strength is set to 0.0, the Gravity space warp has no effect.

**Decay** When Decay is set to 0.0, the Gravity space warp has the same strength throughout world space. Increasing the Decay value causes gravity strength to diminish as distance increases from the position of the gravity warp object. Default=0.0.
**Planar** Gravity effect is perpendicular to the plane of the Gravity warp object throughout the scene.

**Spherical** Gravity effect is spherical, centered on the Gravity warp object. This choice is effective for creating water fountain or planetary effects.

**Display group**

**Range Indicators** When on, and when the Decay value is greater than 0.0, icons in the viewports indicate the range at which the force of gravity is half the maximum value. For the Planar option, the indicators are two planes; for use the Spherical option, the indicator is a double-hooped sphere.

**Icon Size** Size of the Gravity warp object icon, in active units. You set the initial size when you drag to create the Gravity object. This value does not change the gravity effect.

**Wind Space Warp**

Create panel > Space Warps > Forces > Object Type rollout > Wind
Create menu > Space Warps > Forces > Wind

The Wind space warp simulates the effect of wind blowing particles generated by a particle system. Wind is directional. Particles moving in the direction of the wind arrow accelerate. Particles moving against the arrow decelerate. In the case of spherical wind, motion is toward or away from the icon.
Wind changing the direction of the spray of a fountain

Wind is similar in effect to the Gravity space warp, but has added parameters for turbulence and other features characteristic of wind in the natural world. Wind can also be used as an effect in dynamics simulations. See Dynamics Utility on page 4190.
Procedures

To create wind:

1. On the Create panel, click Space Warps. Choose Forces from the list, then on the Object Type rollout, click Wind.

2. Drag in a viewport.
   The wind icon appears. For planar wind (the default), the icon is a wireframe square with a direction arrow coming out of one side. For spherical wind, the icon is a wireframe sphere.
   The initial direction of planar wind is along the negative Z axis of the construction grid that is active in the viewport where you drag. You can rotate the wind object to change the direction.
Interface

Force group

These settings are comparable to the Gravity parameters.

**Strength** Increasing Strength increases the wind effect. Strength less than 0.0 creates a suction. It repels particles moving in the same direction and attracts particles moving in the opposite direction. When Strength is 0.0, the Wind warp has no effect.

**Decay** When Decay is set to 0.0, the Wind warp has the same strength throughout world space. Increasing the Decay value causes wind strength to diminish as distance increases from the position of the Wind warp object. Default=0.0.

**Planar** Wind effect is perpendicular to the plane of the Wind warp object, throughout the scene.
Spherical Wind effect is spherical, centered on the Wind warp object.

Wind group

These settings are specific to the Wind space warp.

Turbulence Causes particles to change course randomly as the wind blows them. The greater the value, the greater the turbulence effect.

Frequency When set greater than 0.0, causes turbulence to vary periodically over time. This subtle effect is probably not visible unless your bound particle system generates a large number of particles.

Scale Scales the turbulence effect. When Scale is small, turbulence is smoother and more regular. As Scale increases, turbulence grows more irregular and wild.

Display group

Range Indicators When the Decay value is greater than zero, icons appear in the viewports that represent the range at which the force of wind is half the maximum value. When you use the Planar option, the indicators are two planes; when you use the Spherical option, the indicator is a double-hooped sphere.

Icon Size Size of the Wind warp object icon, in active units. You set the initial Icon Size value when you drag to create the wind object. This value does not change the wind effect.

Displace Space Warp

Create panel > Space Warps > Geometric/Deformable > Object Type rollout > Displace
Create menu > Space Warps > Geometric/Deformable > Displace

The Displace space warp acts as a force field to push and reshape an object’s geometry. Displace affects both geometry (deformable objects) and particle systems.
There are two basic ways to use the Displace space warp:

- Apply the gray scale of a bitmap to generate the displacement amount. Black areas of the 2D image are not displaced. Whiter areas push outward, causing a 3D displacement of geometry.

- Apply displacement directly by setting displacement Strength and Decay values.

The Displace space warp works similarly to the Displace modifier, except that, like all space warps, it affects world space rather than object space. Use the Displace modifier when you need to create detailed displacement of a small number of objects. Use the Displace space warp to displace particle systems, a large number of geometric objects at once, or an object relative to its position in world space.

For geometry, the detail of the displacement depends on the number of vertices. Use the Tessellate modifier to tessellate faces you want to show in greater detail.
Procedures

To create a Displace space warp:

1. On the Create panel, click Space Warps. Choose Geometric/Deformable from the list, and then on the Object Type rollout, click Displace.

2. Drag in a viewport to create the Displace warp object, which appears as a wireframe. Its shape depends on the active mapping parameter settings. Regardless of the mapping, a single drag creates the space warp.

3. Bind the space warp to an appropriate object.

To assign a bitmap to a displace space warp:

1. Select the Displace warp object.

2. In the Parameters rollout > Displacement group, click the Bitmap button (labeled "None" by default). Use the selection dialog to choose a bitmap.

3. Set the Strength value. Vary the strength of the field to see how the bitmap displaces the object's geometry.
Interface

Displacement group

These are the basic controls for Displace space warps.
**Strength** When set to 0.0, the Displace warp has no effect. Values greater than 0.0 displace object geometry or particles away from the position of the Displace space warp object. Values less than 0.0 displace geometry toward the warp. Default=0.0

**Decay** By default, the Displace warp has the same strength throughout world space. Increasing Decay causes displacement strength to diminish as distance increases from the position of the Displace warp object. Default=0.0

**Luminance Center** By default, the Displace space warp centers the luminance by using medium (50%) gray as the zero displacement value. Gray values greater than 128 displace in the outward direction (away from the Displace warp object) and gray values less than 128 displace in the inward direction (toward the Displace warp object). You can adjust the default using the Center spinner. With a Planar projection, the displaced geometry is repositioned above or below the Planar gizmo. Default=0.5. Range=0 to 1.0.

**Image group**

These options let you choose a bitmap and map to use for displacement.

**Bitmap** (Labeled "None" by default.) Click to assign a bitmap or map from a selection dialog. After you choose a bitmap or map, this button displays the bitmap's name.

**Remove Bitmap** Click to remove the bitmap or map assignment.

**Blur** Increase this value to blur or soften the effect of the bitmapped displacement.

**Map group**

This area contains mapping parameters for a bitmapped Displace warp. The mapping options are comparable to those options used with mapped materials. The four mapping modes control how the Displace warp object projects its displacement. The warp object's orientation controls where in the scene the displacement effect will appear on bound objects.

**Planar** Projects the map from a single plane.

**Cylindrical** Projects the map as if it were wrapped around the cylinder.

**Spherical** Projects the map from a sphere, with singularities at the top and bottom of the sphere, where the bitmap edges meet at the sphere's poles.

**Shrink Wrap** Truncates the corners of the map and joins them all at a single pole, creating one singularity.
**Length, Width, Height** Specify the dimensions of the bounding box of the space warp gizmo. Height has no effect on planar mapping.

**U/V/W Tile** The number of times the bitmap repeats along the specified dimension. The default value of 1.0 maps the bitmap once; a value of 2.0 maps the bitmap twice, and so on. Fractional values map a fractional portion of the bitmap in addition to copies of the whole map. For example, a value of 2.5 maps the bitmap two and one-half times.

**Flip** Reverses the orientation of the map along the corresponding U, V, or W axis.

---

**Deflectors**

Deflectors are used to deflect particles or to affect dynamics systems.

**POmniFlect Space Warp**

Create panel > Space Warps > Deflectors > Object Type rollout > POmniFlect

POmniFlect is a planar version of the omniflector on page 8663 type of space warp. It provides enhanced functionality over that found in the original Deflector space warp, including refraction and spawning capabilities.
**Procedures**

To create a POmniFlect space warp:

1. On the Create panel, click Space Warps. Choose Deflectors from the list, then on the Object Type rollout, click POmniFlect.

2. Drag in a viewport to create the planar icon.

   **NOTE** Because particles bounce off the icon, the size of the icon affects particle deflection.

3. Apply the deflector to the particle system using the appropriate method:
   - If using Particle Flow on page 2997, specify the deflector in the Collision test on page 3236 or Collision Spawn test on page 3241 parameters.
   - If using a non-event-driven particle system on page 3292, bind on page 2893 the particle system to the deflector icon.
4 Position the POmniFlect icon to interrupt the particle stream.
5 Adjust the POmniFlect parameters as necessary.
### Interface

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Timing</strong></td>
<td></td>
</tr>
<tr>
<td>Time On</td>
<td>0</td>
</tr>
<tr>
<td>Time Off</td>
<td>100</td>
</tr>
<tr>
<td><strong>Reflection</strong></td>
<td></td>
</tr>
<tr>
<td>Reflects</td>
<td>100.0</td>
</tr>
<tr>
<td>Bounce</td>
<td>1.0</td>
</tr>
<tr>
<td>Variation</td>
<td>0.0</td>
</tr>
<tr>
<td>Chaos</td>
<td>0.0</td>
</tr>
<tr>
<td><strong>Refraction</strong></td>
<td></td>
</tr>
<tr>
<td>Refracts</td>
<td>100.0</td>
</tr>
<tr>
<td>Pass Vel</td>
<td>1.0</td>
</tr>
<tr>
<td>Variation</td>
<td>0.0</td>
</tr>
<tr>
<td>Distortion</td>
<td>50.0</td>
</tr>
<tr>
<td>Variation</td>
<td>0.0</td>
</tr>
<tr>
<td>Diffusion</td>
<td>0.0</td>
</tr>
<tr>
<td>Variation</td>
<td>0.0</td>
</tr>
<tr>
<td><strong>Common</strong></td>
<td></td>
</tr>
<tr>
<td>Inherit Vel</td>
<td>1.0</td>
</tr>
<tr>
<td>Friction</td>
<td>0.0</td>
</tr>
<tr>
<td><strong>Spawn Effects Only</strong></td>
<td></td>
</tr>
<tr>
<td>Spawns</td>
<td>100.0</td>
</tr>
<tr>
<td>Pass Vel</td>
<td>1.0</td>
</tr>
<tr>
<td>Variation</td>
<td>0.0</td>
</tr>
<tr>
<td><strong>Display Icon</strong></td>
<td></td>
</tr>
<tr>
<td>Width</td>
<td>0.0</td>
</tr>
<tr>
<td>Height</td>
<td>0.0</td>
</tr>
</tbody>
</table>
**Timing group**

The two spinners specify the start frame and end frame of the deflection effect.

**Time On/Off** Time On specifies the frame at which the deflection begins, and Time Off specifies the frame at which the deflection ends.

**Reflection group**

These options affect the reflection of particles from the space warp. The POmniFlect can reflect or refract particles, or perform a combination of the two.

**Reflects** Specifies the percentage of particles to be reflected by the POmniFlect. See also Refracts, later in this topic, for methods of combining the two effects.

**Bounce** This is a multiplier that specifies how much of the initial speed of the particle is maintained after collision with the POmniFlect. Using the default setting of 1.0 causes the particle to rebound with the same speed as it collides. A real-world effect would usually be less than 1.0. For a “flubber” effect, set greater than 1.0.

**Variation** Specifies the variation of Bounce applied to the range of particles. For example, a Variation of 50% applied to a Bounce setting of 1.0 would result in randomly applied Bounce values ranging from 0.5 to 1.5.

**Chaos** Applies a random variation to the bounce angle. When set to 0.0 (no chaos), all particles bounce off the POmniFlect surface perfectly (like banking pool balls). A nonzero setting causes the deflected particles to scatter.

**Refraction group**

These settings are similar to those in the Reflection group, but these affect the refraction of particles as they pass through the POmniFlect, causing the direction of the particles to change.

**Refracts** Specifies the percentage of particles not already reflected that will be refracted by the POmniFlect.

**NOTE** The Refracts value affects only those particles not already reflected because the reflected particles are processed before the refracted particles. Thus, if you set Reflects to 50% and Refracts to 50%, you would not get a 50/50 split of particles. Rather, half the particles would be reflected, and then half the remainder (25% of the total) would be refracted. The remaining particles either pass through without being refracted or are passed on to Spawn Effects.
To get a 50/50 split of reflection and refraction, set Reflects to 50% and Refracts to 100%.

**Pass Vel** Specifies how much of a particle’s initial speed is maintained after passing through the POmniFlect. The default setting of 1 retains the initial speed is retained, so there's no change. A setting of 0.5 reduces the speed by half.

**Variation** Specifies the variation of Pass Velocity applied to the range of particles.

**Distortion** Controls the angle of refraction. A value of 0 means there's no refraction. A value of 100% sets the angle of the particles to be parallel with the POmniFlect surface. A value of −100% sets the angle perpendicular to the surface. The Distortion effect is reversed when particles strike the POmniFlect from the back side.

**NOTE** Distortion and Refraction do not work properly when particles strike the POmniFlect surface at exactly 90 degrees. In this case, any positive Distortion settings cause a scattering of particles, while negative values have no effect.

**Variation** Specifies a range of variation of the Distortion effect.

**Diffusion** Applies a diffusion effect to the refraction by randomly modifying each particle's Distortion angle by the Diffusion angle. This effectively scatters the particles into a hollow cone.

**Variation** Specifies a range of variation of the Diffusion value.

**Common group**

**Friction** The amount by which particles are slowed as they move along the deflector surface. A value of 0% means they’re not slowed at all. A value of 50% means they’re slowed to half their original speed. A value of 100% means they stop moving when they strike the surface. Default=0%. Range=0% to 100%.

**TIP** To have particles slide along a deflector surface, set Bounce to 0. Also, unless influenced by a force such as Wind or Gravity, particles meant to slide should strike the surface at an angle other than 90 degrees.

**Inherit Vel** (Velocity Inheritance) Determines how much of a moving POmniFlect’s speed is applied to reflected or refracted particles.
For example, if Inherit Vel is 1.0, particles with no motion that are hit by a moving PomniFlect inherit the speed of the POmniFlect at the point of collision.

**Spawn Effects Only group**

These settings affect only particles set to Spawn On Collision that do not either reflect or refract from the omniflector. See Particle Spawn Rollout (PArray) on page 3358. The Spawns percentage spinner works like the Reflects and Refracts percentage spinners, but is the third in line to be processed. Thus, if either Reflects or Refracts are set to 100%, no particles are affected by these settings. Note also that reflective or refractive particles spawn upon collision, regardless of the settings in this group.

**Spawns** Specifies the percentage of particles that can use spawn effects.

**Pass Vel** Specifies how much of the particle’s initial speed is maintained after passing through the POmniFlect.

**Variation** Specifies the variation of the Pass Velocity setting applied to the range of particles.

**Display Icon group**

**Width/Height** Specify the width and height of the POmniFlect icon. This is for display purposes only and does not influence the deflector effect.

**PDynaFlect Space Warp**

Create panel > Space Warps > Deflectors > Object Type rollout > PDynaFlect

PDynaFlect (planar dynamics deflector) is a planar version of the dynaflector on page 8557, a special class of space warp that lets particles affect objects in a dynamics situation. For example, if you want a stream of particles to strike an object and knock it over, like the stream from a firehose striking a stack of boxes, use a dynaflector.

**NOTE** You use dynaflectors in the same way as omniflectors; that is, you can use them as deflectors alone, with no dynamics simulation. Because they take physics into account, dynaflectors are slower than omniflectors. Therefore, it is recommended that you use dynaflectors only when a dynamics simulation is involved.
Procedures

Many dynaflector parameters are the same as those for omniflectors. However, the procedure of associating the dynaflector with both the particle system and the object to be affected is more complex than the simple binding used by omniflector.

To create a particle/dynamics system:

1. Create or load a scene containing a non-event-driven particle system on page 3292 and an object to be affected by the particles (hereafter called "the object"). Position and orient the two as desired so that the particles strike the object.
   - The icon for the particle system must be visible in at least one non-disabled viewport.
   - On the Basic Parameters rollout of the particle system, set Percentage of Particles to 100%. Otherwise, only those particles displayed in the viewport will be calculated.
2 On the Create panel, click Space Warps. Choose Deflectors from the drop-down list, and then click one of the dynaflector buttons (PDynaFlect, SDynaFlect, or UDynaFlect). Drag in a viewport to create the deflector.

3 Do either of the following:
   ■ If using a PDynaFlect or SDynaFlect, position the space warp icon where the particles strike (or will strike) the object. Resize and orient it as needed.
   Also, link the PDynaFlect or SDynaFlect as a child of the object. This step isn't absolutely necessary, but allows the deflector to follow the object as it moves.
   ■ If using a UDynaFlect, go to the Modify panel > Parameters rollout, click the Pick Object button, and then select the object. The position of the space warp icon doesn't matter, and it's not necessary to link the two.

4 Bind the particle system to the dynaflector using the toolbar Bind to Space Warp button on page 2893.

5 Go to the Utilities panel and open the Dynamics utility.

6 On the Dynamics rollout, click New to create a new simulation.

7 Click Edit Object List, and add the object to the dynamics simulation.

8 Click Edit Object. On the Edit Object dialog, click Assign Object Effects and assign the dynaflector to the object.

9 On the Dynamics rollout, turn on the Update Display w/Solve check box above the Solve button.

10 Solve the simulation.
Interface

Timing group

The two spinners specify the start frame and end frame of the deflection effect.
Time On/Off Time On specifies the frame at which the deflection begins, and Time Off specifies the frame at which the deflection ends.

**Particle Bounce group**

These settings affect the reflection of particles from the space warp.

**Reflects** Specifies the percentage of particles to be reflected by the PDynaFlect. This affects both the particles and the dynamics reaction of the object struck by the particles. The more particles that strike the affected object, the more force applied to that object. If set to 0.0, the particles have no effect on the object.

**Bounce** This is a multiplier that specifies how much of the initial speed of the particle is maintained after collision with the PDynaFlect. Using the default setting of 1.0 causes the particle to rebound with the same speed as it collides. A real-world effect would usually be less than 1.0. For a "flubber" effect, set greater than 1.0.

**Variation** Specifies the variation of Bounce applied to the range of particles. For example, a Variation setting of 50% applied to a Bounce setting of 1.0 would result in randomly applied Bounce values ranging from 0.5 to 1.5.

**Chaos** Applies a random variation to the bounce angle. When you set Chaos to 0.0 (no chaos), all particles bounce off the PDynaFlect surface perfectly (like banking pool balls). A nonzero setting causes the deflected particles to scatter.

**Friction** The amount by which particles are slowed as they move along the deflector surface. A value of 0% means they're not slowed at all. A value of 50% means they're slowed to half their original speed. A value of 100% means they stop moving when they strike the surface. Default=0%. Range=0% to 100%.

**TIP** To have particles slide along a deflector surface, set Bounce to 0. Also, unless influenced by a force such as Wind or Gravity, particles meant to slide should strike the surface at an angle other than 90 degrees.

**Inherit Vel** (Velocity Inheritance) Determines how much of a moving PDynaFlect's speed is applied to reflected or refracted particles. For example, if Inherit Vel is 1.0, particles with no motion that are hit by a moving PDynaFlect inherit the speed of the PDynaFlect at the point of collision.
Physical Properties group

These options let you set the mass of each particle.

**Mass** Specifies the mass based on the chosen unit.

- **gram** One gram equals 1/1000 kg or 22/1000 Lbm at a gravity of 1.0.
- **Kg** One kg (kilogram) equals 1000 grams or 2.2 Lbm at a gravity of 1.0.
- **Lbm** One Lbm (pounds-mass) equals 5/11 kg or 454 5/11 grams at a gravity of 1.0. (Pounds-mass, the amount of mass in one pound of weight, is dependent on gravity. For pounds-mass values at a gravity other than 1.0, multiply the pounds-mass value by the gravity factor.)

Display Icon group

**Width/Height** Specify the width and height of the PDynaFlect icon. This is for display purposes only and does not influence the deflector effect.

SOmniFlect Space Warp

Create panel > Space Warps > Deflectors > Object Type rollout > SOmniFlect

SOmniFlect is the spherical version of the omniflector on page 8663 type of space warp. It provides more options than the original SDeflector. Most settings are the same as those in POmniFlect on page 2935. The difference is that this space warp provides a spherical deflection surface rather than the planar surface. The only settings that are different are in the Display Icon area, in which you set the Radius, instead of the Width and Height.

**NOTE** Opposite sides of the deflectors reverse the distortion effect. Thus, a refracted particle passing through the SOmniFlect hits its outside surface first, and then its inside surface. A positive Distortion value warps the particles toward the perpendicular; then, as the particles pass through the inside surface, the same positive Distortion value warps them toward the parallel.
Procedures

To create an SOmiFlect space warp:

1. On the Create panel, click Space Warps. Choose Deflectors from the list, then on the Object Type rollout, click SOmiFlect.

2. Drag in a viewport to create the spherical icon.

   **NOTE** Because particles bounce off the icon, the size of the icon affects particle deflection.

3. Apply the deflector to the particle system using the appropriate method:
   - If using *Particle Flow* on page 2997, specify the deflector in the *Collision test* on page 3236 or *Collision Spawn test* on page 3241 parameters.
   - If using a *non-event-driven particle system* on page 3292, bind on page 2893 the particle system to the deflector icon.
Position the SOmniFlect icon to interrupt the particle stream.
Adjust the SOmniFlect parameters as necessary.

**SDynaFlect Space Warp**

Create panel > Space Warps > Deflectors > Object Type rollout > SDynaFlect

The SDynaFlect space warp is a spherical dynaflector on page 8557. It’s like the PDynaFlect on page 2941 warp, except that it’s spherical, and its Display Icon spinner specifies the icon’s Radius value.

---

**UOmniFlect Space Warp**

Create panel > Space Warps > Deflectors > Object Type rollout > UOmniFlect

UOmniFlect, the universal omniflector on page 8663, provides more options than the original UDeflector. This space warp lets you use any other geometric
object as a particle deflector. The deflections are face accurate, so the geometry can be static, animated, or even morphing or otherwise deforming over time.

**NOTE** Some particle “leakage” can occur with this deflector, particularly when you use many particles and a complex deflector object. To avoid this, perform a test render to check for leaking particles, and then add POmniFlects to catch the strays.

![UOmniFlect viewport icon](image)

**Procedures**

To use the UOmniFlect space warp:

To use a universal omniflector, you need a minimum of three objects in the scene:

1. The particle system
2. The UOmniFlect space warp
3. The object used as the deflector
4. Add or select an object used as the deflector.
5 Create a particle system whose particles intersect the deflector object.

6 On the Create panel, click Space Warps. Choose Deflectors from the list, and then click UOmniFlect.

7 Click and drag in a viewport to place the space warp icon.

**NOTE** The size and position of the UOmniFlect icon do not alter the effect.

8 Apply the deflector to the particle system using the appropriate method:
   - If using Particle Flow on page 2997, specify the deflector in the Collision test on page 3236 or Collision Spawn test on page 3241 parameters.
   - If using a non-event-driven particle system on page 3292, bind on page 2893 the particle system to the deflector icon.

9 On the Modify panel > Parameters rollout > Object-Based OmniFlector group, click Pick Object, and then select the object to use as a deflector.

10 Adjust the particle system and UOmniFlect parameters as necessary.

**Interface**

**Parameters rollout**

The settings for the UOmniFlect are the same as those for POmniFlect on page 2935, with the following additions:

**Object-Based OmniFlector group**

Lets you choose the object to use as a deflector.

**Item** Displays the name of the selected object.

**Pick Object** Click this, and then select any renderable object to use as a deflector.

**Display Icon group**

**Icon Size** Specifies the size of one side of the square UOmniFlect icon.
UDynaFlect Space Warp

Create panel > Space Warps > Deflectors > Object Type rollout > UDynaFlect

The UDynaFlect space warp is a universal dynaflector on page 8557 that lets you use the surface of any object as both the particles deflector and the surface that reacts dynamically to the particle impact.

The procedures and options for using UDynaFlect are the same as for PDynaFlect on page 2941, with the following changes and additions.

NOTE When you use UDynaFlect, you must indicate the object to be affected with the Pick Object button. Linking is not necessary.
Interface

Parameter
Object-Based DynaFlector
Item: <None>
Pick Object

Timing
Time On: 0
Time Off: 10000

Particle Bounce
Reflects: 100.0
Bounce: 1.0
Variation: 0.0
Chaos: 0.0
Friction: 0.0
Inherit Vel: 1.0

Physical Properties
Mass: 1.0

Units of Mass
- gram
- Kg
- Lbm

Display Icon
Icon Size: 8.088
Object-Based DynaFlector group

Lets you choose the object to use as a deflector.

**Item** Displays the name of the selected object.

**Pick Object** Click this, and then select any renderable object to use as a deflector.

Display Icon group

**Icon Size** Specifies the size of the UDynaFlect icon.

SDeflector Space Warp

Create panel > Space Warps > Deflectors > Object Type rollout > SDeflector

Create menu > Space Warps > Deflectors > SDeflector

The SDeflector space warp serves as a spherical deflector of particles.
Procedures

To create an SDeflector:

1. On the Create panel, click Space Warps. Choose Deflectors from the list, then on the Object Type rollout, click SDeflector.

2. Drag in a viewport to create the spherical icon.

   **NOTE** Because particles bounce off the perimeter of the spherical icon, the size of the icon affects particle deflection.

3. Apply the deflector to the particle system using the appropriate method:
   - If using Particle Flow on page 2997, specify the deflector in the Collision test on page 3236 or Collision Spawn test on page 3241 parameters.
   - If using a non-event-driven particle system on page 3292, bind on page 2893 the particle system to the deflector icon.

4. Position the SDeflector icon to interrupt the particle stream.
5 Adjust the SDeflector parameters as necessary.

### Interface

![Particle Bounce group]

#### Particle Bounce group

These settings determine how the deflector affects the bound particles.

**Bounce** Determines the speed with which particles bounce off the deflector. At 1.0, the particles bounce at the same speed as they approach. At 0, they don't deflect at all.

**Variation** The amount by which each particle can vary from the Bounce setting.

**Chaos** The amount of variation from the perfect angle of reflection (found when Chaos is set to 0.0). 100% induces a variation in reflection angle of up to 90 degrees.

**Friction** The amount by which particles are slowed as they move along the deflector surface. A value of 0% means they're not slowed at all. A value of 50% means they're slowed to half their original speed. A value of 100% means they stop moving when they strike the surface. Default=0%. Range=0% to 100%.
TIP To have particles slide along a deflector surface, set Bounce to 0. Also, unless influenced by a force such as Wind or Gravity, particles meant to slide should strike the surface at an angle other than 90 degrees.

Inherit Vel (Velocity Inheritance) When the value is greater than 0, the motion of the deflector affects particles as well as the other settings. For example, to animate the SDeflector passing through a passive array of particles, turn up this value to affect the particles.

Display Icon group
This option affects the display of the icon.
Diameter Specifies the diameter of the SDeflector icon. This setting also alters the effect of the deflection, because particles bounce off the perimeter of the icon. The scale of the icon also affects the particles.

UDeflector Space Warp
Create panel > Space Warps > Deflectors > Object Type rollout > UDeflector
Create menu > Space Warps > Deflectors > UDeflector
The UDeflector is a universal deflector that lets you use any object as a particle deflector.
Particles scatter when they strike a UDeflector object

Procedures

To create a UDeflector:

1. On the Create panel, click Space Warps. Choose Deflectors from the list, then on the Object Type rollout, click UDeflector.

2. In a viewport, drag out a rectangle to add a UDeflector warp to the scene.

3. On the command panel, click the Pick Object button and select an object to be a particle deflector.

4. Apply the deflector to the particle system using the appropriate method:
   - If using Particle Flow on page 2997, specify the deflector in the Collision test on page 3236 or Collision Spawn test on page 3241 parameters.
   - If using a non-event-driven particle system on page 3292, bind on page 2893 the particle system to the deflector icon.
5 Position the UDeflector icon to interrupt the particle stream.
6 Adjust the UDeflector parameters as necessary.

**Interface**

**Object-Based Deflector group**

Specifies the object to use as a deflector.

**Item** Displays the name of the selected object.

**Pick Object** Click this, and then click any renderable mesh object to be used as a deflector.
Particle Bounce group

**Bounce** Determines the speed with which particles bounce off the deflector. At 1.0, the particles bounce at the same speed as they approach. At 0, they don't deflect at all.

**Variation** The amount by which each particle can vary from the Bounce setting.

**Chaos** The amount of variation from the perfect angle of reflection (found when Chaos is set to 0.0). 100% induces a variation in reflection angle of up to 90 degrees.

**Friction** The amount by which particles are slowed as they move along the deflector surface. A value of 0% means they're not slowed at all. A value of 50% means they're slowed to half their original speed. A value of 100% means they stop moving when they strike the surface. Default=0%. Range=0% to 100%.

**TIP** To have particles slide along a deflector surface, set Bounce to 0. Also, unless influenced by a force such as Wind or Gravity, particles meant to slide should strike the surface at an angle other than 90 degrees.

Inherit Vel (Velocity Inheritance) When greater than 0, the motion of the deflector affects particles as well as the other settings. For example, to animate the SDeflector passing through a passive array of particles, turn up this value to affect the particles.

Display Icon group

**Icon Size** This spinner displays and lets you change the size of the icon.

Deflector Space Warp

Create panel > Space Warps > Deflectors > Object Type rollout > Deflector
Create menu > Space Warps > Deflectors > Deflector

The Deflector space warp acts as a planar shield to repel the particles generated by a particle system. For example, you can use Deflector to simulate pavement being struck by rain. You can combine a Deflector space warp with a Gravity space warp to produce waterfall and fountain effects.
Two streams of particles striking two deflectors

See also:
- SDeflector Space Warp on page 2953
- UDeflector Space Warp on page 2956

Procedures

To create a deflector:

1. On the Create panel, click Space Warps. Choose Deflectors from the list, then on the Object Type rollout, click Deflector.

2. Drag in a viewport to define the deflection area. The deflector appears as a wireframe rectangle.
3 Apply the deflector to the particle system using the appropriate method:

- If using Particle Flow on page 2997, specify the deflector in the Collision test on page 3236 or Collision Spawn test on page 3241 parameters.

- If using a non-event-driven particle system on page 3292, bind on page 2893 the particle system to the deflector icon.

Interface

The deflector's effect is controlled mainly by its size and orientation in the scene, relative to the particle system that is bound to it. You can also adjust how strongly the deflector deflects particles.

**Bounce** Controls the speed at which particles bounce off the deflector. At a setting of 1.0, particles bounce off the deflector at the same speed they struck it. At 0.0, particles do not bounce at all. At values between 0.0 and 1.0, particles bounce off the deflector at a speed reduced from their initial speed. At values greater than 1.0, particles bounce off the deflector at a speed greater than their initial speed. Default=1.0.

**Variation** The amount by which each particle can vary from the Bounce setting.
**Chaos** The amount of variation from the perfect angle of reflection (found when Chaos is set to 0.0). 100% induces a variation in reflection angle of up to 90 degrees.

**Friction** The amount by which particles are slowed as they move along the deflector surface. A value of 0% means they're not slowed at all. A value of 50% means they're slowed to half their original speed. A value of 100% means they stop moving when they strike the surface. Default=0%. Range=0% to 100%.

**TIP** To have particles slide along a deflector surface, set Bounce to 0. Also, unless influenced by a force such as Wind or Gravity, particles meant to slide should strike the surface at an angle other than 90 degrees.

**Inherit Vel** (Velocity Inheritance) When the value is greater than 0, the motion of the deflector affects particles as well as the other settings. For example, if you want an animated SDeflector passing through an array of particles to affect the particles, turn up this value.

**Width** Sets the deflector's width.

**Length** Sets the deflector's length.

**Geometric/Deformable**

These space warps are used to deform geometry.

**FFD(Box) Space Warp**

Create panel > Space Warps > Geometric/Deformable > Object Type rollout > FFD(Box)

Create menu > Space Warps > Geometric/Deformable > FFD(Box)

Free-form deformations (FFDs) provide a method of deforming an object by adjusting the control points of a lattice. The offset position of the control points to the original lattice source volume causes the distortion of the affected object. The FFD(Box) space warp is a box-shaped lattice FFD object similar to the original FFD modifiers. This FFD is available as both an object modifier and a space warp. For information on the object-modifier version, see FFD (Box/Cylinder) Modifiers on page 1436.
You create FFD space warps as separate objects similarly to the way you create standard primitives: by dragging the mouse in the viewport. The result is a lattice of control points. The source lattice of an FFD modifier is fitted to the geometry it's assigned to in the stack. This might be a whole object or a sub-object selection of faces or vertices.

Because FFD space warps are separate objects, they carry their own adjustable dimension parameters among the creation parameters.

You can apply object modifiers to space warp objects. For example, you can use the Linked XForm modifier with a space-warp FFD.
Object and object surrounded by an FFD lattice
Moving control points in the lattice deforms the object.

Procedures

To use the FFD(box) space warp:

1. On the Create panel, click Space Warps. Choose Geometric/Deformable from the list, then on the Object Type rollout, click FFD(Box).

2. Drag in a viewport to create the base. Release the mouse button, and then move the mouse to define the height of the FFD lattice. Click to finish the lattice.

3. Bind the lattice to the object you want to deform.

4. Determine the relative placement of the lattice to the object. If the lattice is to be outside of the object, turn on All Vertices. To affect only those vertices inside the lattice, choose Only In Volume, and position the lattice accordingly.
5 In the modifier stack display, choose Control Points as the sub-object level for FFD(box).

6 Adjust the control points.

**NOTE** The distortion effect of an FFD modifier is based on the positional offset of the control points from their original positions in the source volume. If you don't move control points, there is no effect on the target object. Keep this in mind when using space-warp version of the FFD.

If you're using the Deform group > All Vertices option, once you've distorted the object you can set the Falloff value to adjust how much the lattice affects the object, based on distance. This is particularly useful if the lattice is animated to approach or move away from the target object. When Falloff is set to 0, all the vertices are affected, regardless of distance.

**NOTE** When you're at the base-parameters level of an FFD modifier in the Stack, the Show End Result button is turned off and spring-loaded, as it is in an Edit Mesh modifier.
This rollout lets you set the size and resolution of the lattice, and how it displays and deforms.

**Dimensions group**

These options let you adjust the unit dimensions of the source volume, and specify the number of control points in the lattice. Note that the point dimensions are displayed beside the modifier name in the Stack list.

**Length, Width, Height** These three spinners display and let you adjust the length, width, and height of the lattice. To create the space warp, you drag the mouse in the same way that you would to create a standard Box primitive. Note that these spinners don't exist in the object-modifier version of the FFD.

**Label** Displays the current number of controls points in the lattice (for example: 4x4x4).

**Set Number of Points** Displays a dialog containing three spinners labeled Length, Width, and Height, plus OK/Cancel buttons. Specify the number of control points you want in the lattice, and then click OK to make the change.

**NOTE** Make changes to the dimensions before you adjust the positions of the lattice control points. When you change the number of control points with this dialog, any adjustments you've already made to the control points are lost; however, you can undo this use of the dialog.

**Display group**

These options affect the display of the FFD in the viewports.

**Lattice** When turned on, lines are drawn connecting the control points to make a grid. Although viewports can become cluttered when these extra lines are drawn, they help to visualize the lattice.

**Source Volume** When on, the control points and lattice are displayed in their unmodified state. This display is helpful when you're adjusting the source volume to affect specific vertices that lie within or without it. See the All Vertices and Only in Volume options, later in this topic.

**Deform group**

These options provide controls that specify which vertices are affected by the FFD.

**Only In Volume** Only vertices that lie inside the source volume are deformed. Vertices outside the source volume are not affected.
All Vertices All vertices are deformed regardless of whether they lie inside or outside the source volume, depending on the value in the Falloff spinner. The deformation outside the volume is a continuous extrapolation of the deformation inside the volume. The deformation can be extreme for points far away from the source lattice.

Falloff This spinner, enabled only when you choose All Vertices, determines the distance from the lattice that the FFD effect will decrease to zero. When this spinner is set to 0, it’s effectively turned off, and there is no falloff; that is, all vertices are affected regardless of their distance from the lattice. The units of the Falloff parameter are specified relative to the size of the lattice: A falloff of 1 means that the effect will go to 0 for points that are a lattice width/length/height away from the lattice (depending on which side they are on).

Tension/Continuity Lets you adjust the tension and continuity of the deformation splines. Although you can’t see the splines in an FFD, the lattice and control points represent the structure that controls the splines. As you adjust the control points, you alter the splines (which move through each point). The splines, in turn, deform the geometry of the object. By altering the tension and continuity of the splines, you alter their effect on the object.

Selection group

These options provide additional methods of selecting the control points. You can toggle the state of any combination of the three buttons to select in one, two, or three dimensions at once.

All X, All Y, All Z When one of these buttons is on and you select a control point, all control points along the local dimension specified by the button are selected as well. By turning on two buttons, you can select all control points in two dimensions.

About Displays a dialog with copyright and licensing information.

FFD(Cyl) Space Warp

Create panel > Space Warps > Geometric/Deformable > Object Type rollout > FFD(Cyl)

Create menu > Space Warps > Geometric/Deformable > FFD(Cyl)

Free-form deformations (FFDs) provide a method of deforming an object by adjusting the control points of a lattice. The offset position of the control
points to the original lattice source volume causes the distortion of the affected object. The FFD(Cyl) space warp uses a cylindrical array of control points in its lattice. This FFD is available as both an object modifier and a space warp. For information on the object modifier version, see FFD (Box/Cylinder) Modifiers on page 1436.

You create FFD space warps as separate objects similarly to the way you create standard primitives: by dragging the mouse in the viewport. The result is a lattice of control points. The source lattice of an FFD modifier is fitted to the geometry it's assigned to in the stack. This might be a whole object or a sub-object selection of faces or vertices.

Because FFD space warps are separate objects, they carry their own adjustable dimension parameters among the creation parameters.

You can apply object modifiers to space warp objects. For example, you can use the Linked XForm modifier with a space-warp FFD.

**Procedures**

**Example: Create an animated tablecloth:**

![Finished tablecloth using FFD (Cyl) space warp](image)

This example shows how to use the FFD(Cyl) space warp to create a tablecloth that flies in and drapes itself over a table.
Begin by creating the table and tablecloth.

1. Create a table from two cylinders. Make the table top with a radius of 30 units, and a height of 2 units. Make the “table stand” cylinder with a radius of 3 and a height of 60.

2. Make a tablecloth from a box 100 units square and 0.5 units in height. Increase Length and Width Segments to 30, and keep Height Segments at 1.

3. Position the tablecloth so it’s level with or slightly above the table top, and a little less than 100 units to the left of the table edge, as seen from the Top view.

4. Apply a nice wood grain to the table, and a checker to the tablecloth. (Set the checker tiling to about 15x15, and choose any color for the checkers.)

Now, set up a cylindrical FFD space warp that will form the drape of the tablecloth over the table.

1. From the Create panel > Space Warps > Geometric/Deformable, choose FFD(Cyl).

2. In the Top viewport, create a cylindrical FFD space warp, centered on the table top, with a radius of 45 and a height of 5.

3. Click the Set Number of Points button and, in the Set FFD Dimensions dialog, set Side points to 12, Radial points to 5, and Height points to 2.

4. Move the entire FFD lattice up until it’s just over the surface of the table, as seen from the Front viewport.
Next, adjust the control points of the lattice to drape over the table.

1. **Zoom Extents All Selected.**

2. On the Modify panel, in the stack display (below "Modifier List"), click the FFD(cyl) item so it turns yellow. This means you've enabled direct access to the FFD space warps control point sub-objects.

3. In the FFD Parameters rollout > Selection group, turn on All X. This lets you select control points around the perimeter of the FFD cylinder.

4. In the Top viewport, use the **Select and Move tool** on page 914 and region-select the two visible control points of the two outer rings of control points at the nine-o’clock position. (This is easier shown than described. You can actually region-select any number of vertices in the two outer concentric rings of vertices. Because All X is on, all control points for the two rings will be selected.)

5. **On the status bar, click the Selection Lock Toggle button to lock the selection. In the Front viewport, drag the selected points halfway down the height of the table.**

6. Unlock the selection, and then region-select any control point in the outer ring to select all points in the outer ring.
7 Lock the selection and, in the Front viewport, drag the outer ring of points down to the floor.

![Diagram]

You now have a truncated cone shape over the table.

8 Unlock the selection. In the Top viewport, again select all the control points in the two outer rings.

9 Scale the selected control points in, until the radius of the inner ring of points is slightly larger than the table top.

10 Select only the outer ring of points, and scale them so their radius is slightly larger than the inner ring.
   If necessary, move the points, as seen from the Front viewport, down to touch the floor again.
   You now have a lattice of control points draped over the table.

In this next series of steps, you'll bind the tablecloth to the FFD lattice, and then animate it to move over the table.

1 In the stack display, click the FFD(cyl) entry again to exit the sub-object level. It turns gray.

2 In the main toolbar, click the Bind to Space Warp button, and drag between the FFD and the tablecloth.
3 Select the FFD lattice.

4 Choose Deform group > All Vertices.
   The tablecloth is immediately deformed because all vertices are now
   affected, including those outside the lattice volume, and Falloff is set to
   0. A falloff value of 0 means that the distance of the vertices from the
   lattice doesn't matter. Any number greater than 0, however, limits the
   effect.

5 Set the Falloff spinner to 0.4.
   No longer influenced by the FFD space warp, the tablecloth returns to
   its square shape.

6 Turn on Auto Key, and go to frame 100.

7 In the Top viewport, select the tablecloth, and move it until it's centered
   over the table.

8 As the tablecloth nears the table, it droops down to the floor, sweeps up
   and over the table, and finally drapes itself over the table.

9 As you move the time slider back and forth and examine the animation,
   you might find that the bottom of the tablecloth is deformed to the point
   where it's hanging below the floor. To fix this, turn off Auto Key, go to
   frame 100, select the lower ring of control points, and move them up
until the tablecloth is at the height you want it. You can also adjust the position of the other control points to create drapes, and so on.

10 On the Display command panel > Hide by Category rollout, turn on Space Warps to hide the FFD space warp.

11 Set up appropriate lights and a camera, and play your animation.
Chapter 12  Space Warps and Particle Systems
This rollout lets you set the size and resolution of the lattice, and how it displays and deforms.

**Dimensions group**

These options let you adjust the unit dimensions of the source volume, and specify the number of control points in the lattice. Note that the point dimensions are displayed beside the modifier name in the Stack list.

**Radius, Height** These two spinners display and let you adjust the length, width, and height of the lattice. To create the space warp, drag the mouse in the same way that you would to create a standard Cylinder primitive. Note that these spinners don’t exist in the object-modifier version of the FFD.

**Label** Displays the current number of controls points in the lattice (for example: 4x8x4).

**Set Number of Points** Displays a dialog containing three spinners labeled Side, Radial, and Height, plus OK/Cancel buttons. Specify the number of control points you want in the lattice, and then click OK to make the change.

**Side** The number of control points around the perimeter of the lattice.

**Radial** The number of control points, radially, from the center to the outer perimeter of the lattice.

**Height** The number of control points along the height of the lattice.

**NOTE** Make changes to the dimensions before you adjust the positions of the lattice control points. When you change the number of control points with this dialog, any adjustments you’ve already made to the control points are lost; however, you can undo this use of the dialog.

**Display group**

These options affect the display of the FFD in viewports.

**Lattice** When on, lines are drawn connecting the control points to make a grid. Although viewports can become cluttered when these extra lines are drawn, they help to visualize the lattice.

**Source Volume** When on, the control points and lattice are displayed in their unmodified state. This display is helpful when you’re adjusting the source volume to affect specific vertices that lie within or without it. See the All Vertices and Only in Volume options, later in this topic.
Deform group

These options provide controls that specify which vertices are affected by the FFD.

Only In Volume When on, only vertices that lie inside the source volume are deformed. Vertices outside the source volume are not affected. This is the default choice.

All Vertices When on, all vertices are deformed regardless of whether they lie inside or outside the source volume, depending on the value in the Falloff spinner. The deformation outside the volume is a continuous extrapolation of the deformation inside the volume. Note that the deformation can be extreme for points far away from the source lattice.

Falloff This spinner, enabled only when you choose All Vertices, determines the distance from the lattice that the FFD effect will decrease to zero. When this spinner is set to 0, it’s effectively turned off, and there is no falloff; that is, all vertices are affected regardless of their distance from the lattice. The units of the Falloff parameter are specified relative to the size of the lattice: A falloff of 1 means that the effect will go to 0 for points that are a lattice width/length/height away from the lattice (depending on which side they are on).

Tension/Continuity Lets you adjust the tension and continuity of the deformation splines. Although you can’t see the splines in an FFD, the lattice and control points represent the structure that controls the splines. As you adjust the control points, you alter the splines (which move through each point). The splines, in turn, deform the geometry of the object. By altering the tension and continuity of the splines, you alter their effect on the object.

Selection group

These options provide additional methods of selecting control points. You can toggle any combination of the three buttons to select in one, two, or three dimensions at once.

All X, All Y, All Z When one of these buttons is on and you select a control point, all control points along the local dimension specified by the button are selected as well. By turning on two buttons, you can select all control points in two dimensions.

About Displays a dialog with copyright and licensing information.
**Wave Space Warp**

Create panel > Space Warps > Geometric/Deformable > Object Type rollout > Wave

Create menu > Space Warps > Geometric/Deformable > Wave

The Wave space warp creates a linear wave through world space. It affects geometry and behaves the same as the Wave modifier on page 2000. Use the Wave space warp when you want the wave to affect a large number of objects, or to affect an object relative to its position in world space.
Using a wave to deform a box

See also:
- Ripple Space Warp on page 2983

Procedures

To create a Wave space warp:

1. On the Create panel, click Space Warps. Choose Geometric/Deformable from the list, then on the Object Type rollout, click Wave.

2. Drag in a viewport to define the initial size of the wave object icon. The icon is displayed as a flat mesh wireframe.

3. Release the mouse button to set the icon size; then move the mouse to define the initial amplitude of the wave.

4. Click to set the wave amplitude.
The initial amplitude sets both Amplitude 1 and Amplitude 2. Set these parameters to unequal values to create a cross wave.

**Wave group**

These options control the wave effect.

**Amplitude 1** Sets wave amplitude along the wave warp object's local X axis. Amplitude is expressed in units. The wave is a sine wave along its Y axis and parabolic along its X axis. Another way to think of the difference between the amplitudes is that Amplitude 1 is at the center of the wave gizmo and Amplitude 2 is at the edge of the gizmo.

**Wave Length** Sets the length of each wave along the wave's local Y axis, in active units.
Phase  Offsets the phase of the wave from its origin at the wave object's center. Whole values have no effect; only fractional values do. Animating this parameter makes the wave appear to travel through space.

Decay  When set to 0.0, the wave has the same amplitude or amplitudes throughout world space. Increasing the Decay value causes amplitude to diminish as distance increases from the position of the wave warp object. Default=0.0.

Display group

These options control the geometry of the Wave warp gizmo. In some cases, such as when the two Amplitude values differ, they change the effect of the wave.

Sides  Sets the number of side segments along the wave object's local X dimension.

Segments  Sets the number of segments along the wave object's local Y dimension.

Divisions  Adjusts the size of the wave icon without altering the wave effect as scaling would.

Flexibility parameter (Modify panel)

The Wave space warp also has a Flexibility parameter that you can adjust individually in each bound object's stack, at the Wave Binding level. The parameter belongs to each binding; it doesn't appear with the Wave warp parameters.
Flexibility Makes the bound object more or less responsive to the wave by multiplying the amplitude by this value.

**Ripple Space Warp**

Create panel > Space Warps > Geometric/Deformable > Object Type rollout > Ripple

Create menu > Space Warps > Geometric/Deformable > Ripple

The Ripple space warp creates a concentric ripple through world space. It affects geometry and behaves the same as the Ripple modifier on page 1650. Use the Ripple space warp when you want the ripple to affect a large number of objects, or to affect an object relative to its position in world space.
Using a ripple to deform a surface

See also:

- Wave Space Warp on page 2979

Procedures

To create a Ripple space warp:

1. On the Create panel, click Space Warps. Choose Geometric/Deformable from the list, then on the Object Type rollout, click Ripple.

2. Drag in a viewport to define the initial size of the ripple object icon. The icon is displayed as a wireframe spider web.

3. Release the mouse button to set the icon size, and then move the mouse to define the initial amplitude of the ripple wave.

4. Click to set the wave amplitude.
The amplitude value set by dragging applies equally in all directions. The ripple’s Amplitude 1 and Amplitude 2 parameters are initially equal. Set these parameters to unequal values to create a ripple whose amplitude varies relative to the local X and Y axes of the space warp.

**Ripple group**

**Amplitude 1** Sets ripple amplitude along the ripple warp object’s local X axis. Amplitude is expressed in active units.

**Amplitude 2** Sets ripple amplitude along the ripple warp object’s local Y axis. Amplitude is expressed in active units.

**Wave Length** Sets the length of each wave, in active units.

**Phase** Offsets the phase of the wave from its origin at the ripple object’s center. Whole values have no effect; only fractional values do. Animating this parameter makes the ripple appear to travel through space.
Decay When set to 0.0, the ripple has the same amplitude or amplitudes throughout world space. Increasing the Decay value causes amplitude to diminish as distance increases from the position of the ripple warp object. Default=0.0.

Display group

The options control display of the Ripple warp object's icon. They don't change the effect of the ripple.

Circles Sets the number of circles in the ripple icon.

Segments Sets the number of segments (pie slices) in the ripple icon.

Divisions Adjusts the size of the ripple icon without altering the ripple effect as scaling would.

Flexibility parameter (Modify panel)

The Ripple space warp also has a Flexibility parameter that you can adjust individually in each bound object's stack, at the Ripple Binding level. The parameter belongs to each binding; it doesn't appear with the Ripple warp parameters.
Flexibility Makes the bound object more or less responsive to the wave by multiplying the amplitude by this value.

**Conform Space Warp**

Create panel > Space Warps > Geometric/Deformable > Object Type rollout > Conform

Create menu > Space Warps > Geometric/Deformable > Conform

The Conform space warp modifies its bound object by pushing its vertices in the direction indicated by the space warp icon, until they hit a specified target object, or until the vertices move a specified distance from their original position.

After creating a Conform space warp, you specify a target object in the Conform parameters, and then bind the Conform to the object you want to deform. You rotate the Conform icon to specify the travel direction (toward the target object). The vertices of the deformed object move until they hit the target object.
There is also a Conform compound object on page 688 that provides additional methods of conforming one object to another.

Conform viewport icon (a surface is below it)

**Procedures**

**Example: Using the Conform space warp:**

Begin by making two objects.

1. Create a terrain by making a wide, flat box with plenty of Length and Width segments (or a quad patch). Apply a Noise modifier and adjust its parameters to result in a bumpy terrain (not mountainous, but low and irregular).

2. Create a short, wide cylinder whose radius is about one-eighth the area of the box (like a coin). You'll animate the cylinder to float diagonally over the surface of the terrain.

3. Set Cap Segments in the cylinder to 4, and position the cylinder to float over the terrain.

4. Set the object color of the cylinder to contrast with the color of the terrain.

5. Move the cylinder inside one corner of the terrain as seen from the Top viewport. Turn on Animate, move to frame 100, and move the cylinder to the opposite corner of the terrain.
The coin/disk moves from one corner of the terrain to the other.

The terrain will become the target object, and the cylinder the deformed object. The next step is to create the Conform space warp and bind it to the cylinder.

1. On the Create panel, choose Space Warps, and then, from the drop-down list, choose Geometric/Deformable. Click the Conform button.
2. In the Top viewport, in the center of the terrain, drag outward to create the Conform space warp.
3. Click the Pick Object button, and then click the terrain box.
4. In the Front viewport, drag the space warp up until it’s above the cylinder. As seen in the Front viewport, the terrain is at the bottom, the cylinder is between the terrain and the space warp, and the space warp is at the top.
5. Bind the space warp to the cylinder. The cylinder becomes a disk that seems to be painted on the surface of the terrain.
6. Drag the time slider to see the cylinder/disk move across the box, following the terrain.

Because the vertices are pushed almost to the level of the terrain, the faces of the two object might intersect. In the following steps, you'll fix this by adjusting the standoff distance between the target surface and the pushed vertices. Then you'll go on to affect only selected vertices in the cylinder.

1. Select the Conform space warp, and open the Modify panel.
2. Set Standoff Distance to 3. You can now clearly see the surface of the disk above the terrain.
3. Set the Standoff Distance to 20. The disk floats 20 units above the terrain. Next, change the affected vertices.
4. Select the disk/cylinder.
5. In the modifier stack display, click the Cylinder item so it’s highlighted in gray.
6. Apply a Mesh Select modifier.
7  At the Vertex sub-object level, in the Front viewport, region-select the bottom cap vertices of the cylinder.

8  Remain at the sub-object level, and in the stack display click the Conform Binding item.

9  In the viewport, select the Conform icon.

10  In the Modify panel, turn on Use Selected Vertices.
    Now that only the bottom cap vertices are selected, the rest of the cylinder is restored. If you adjust the viewing angle and play the animation, you’ll see that the bottom face of the cylinder follows the terrain, while the rest of the cylinder retains its shape.

Interface
Wrap To Object group

These options provide controls to select the target object.

Pick Object  Click this, and then select an object in the scene. The object you select becomes the barrier against which the bound object's vertices will be pushed.

Object  Displays the name of the picked object.

Move Vertices group

These options affect how the vertices are moved.

Default Projection Distance  The distance a vertex in the bound object moves from its original location if it does not intersect the target object.

Standoff Distance  The distance maintained between the vertex and the surface of the target object. For example, if set to 5, the vertices can be pushed no closer than 5 units from the surface of the target object.

Use Selected Vertices  When on, only the sub-object selection of vertices on the Stack are pushed. When off, all vertices in the object are pushed regardless of the Stack selection.

Display group

Icon Size  Specifies the size of the icon.

Bomb Space Warp

Create panel > Space Warps > Geometric/Deformable > Object Type rollout > Bomb

Create menu > Space Warps > Geometric/Deformable > Bomb

The Bomb space warp explodes objects into their individual faces.
Procedures

To create a Bomb space warp:

1. On the Create panel, click Space Warps. Choose Geometric/Deformable from the list, and then on the Object Type rollout, click Bomb.

2. Create mesh objects to be exploded.
3 On the toolbar, click the Bind to Space Warp button.

4 Drag the mouse between each object and the Bomb space warp.

5 Adjust Bomb parameters to achieve different effects.

**Interface**

**Explosion group**

**Strength** Sets the power of the bomb. Larger values make the particles fly farther. The closer an object is to the bomb, the greater the effect of the bomb.
Spin The rate at which fragments rotate, in revolutions per second. This is also affected by the Chaos parameter (which causes different fragments to rotate at different speeds), and by the Falloff parameter (which causes the force of the explosion to be weaker the farther the fragment is from the bomb).

Falloff The distance from the bomb, in world units, of the effect of the bomb. Fragments past this distance are not affected by the Strength and Spin settings, but are affected by the Gravity setting.

For example, this is useful for blowing up the base of a building, and having the top of the building topple. To see the effect, place a bomb at the base of a tall cylinder with many height segments, and adjust Falloff to be less than the height of the cylinder.

Falloff On Turn on to use the Falloff setting. The falloff range appears as a yellow, tri-hooped sphere.

Fragment Size group

These two parameters define the number of faces per fragment. Any given fragment will have a number of faces, randomly determined, between the Min and Max values.

Min Specifies the minimum number of faces per fragment to be randomly generated by the "explosion."

Max Specifies the maximum number of faces per fragment to be randomly generated by the "explosion."

General group

Gravity Specifies the acceleration due to gravity. Note that gravity is always in the direction of the world Z axis. You can have negative gravity.

Chaos Adds random variation to the explosion to make it less uniform. A setting of 0.0 is totally uniform; 1.0 is a realistic setting. A value greater than 1.0 makes the explosion extra chaotic. Range=0.0 to 10.0.

Detonation Specifies the frame at which the bomb goes off. Bound objects are unaffected before this time.

Seed Change to alter randomly generated numbers in the bomb. You can achieve a different bomb effect by changing Seed while maintaining the other settings.

Although you can animate strength and gravity, the equations used for projectile motion assume they are constant. Therefore, the motion will not
be physically correct, but it might look interesting. Also, if the bomb object is in motion during the blast, the result is not physically correct.

**Modifier-Based Space Warps**

Create panel > Space Warps > Modifier-Based

Create menu > Space Warps > Modifier-Based

Modifier-based space warps duplicate the effects of standard object modifiers. Like other space warps, they must be bound to objects, and they work in world space. They are useful when you want to apply effects such as Twist or Bend to a widely scattered group of objects.

Creating Modifier-Based Space Warps

You create modifier-based space warps the same way that you create other space warps. Modifier-based space warps are listed on the Create panel as a separate category under Space Warps.

All the modifier-based space warps use a box-shaped (nonrenderable) object. When you create one, you use the mouse in the viewport as you do when creating a Box primitive.

Unlike their modifier versions, these space warps do not have sub-object levels.
Interface

Gizmo Parameters rollout

![Gizmo Parameters rollout]

Gizmo Size group

Length/Width/Height Let you adjust the warp object's dimensions.

Deformation group

Decay When is set to 0, there is no decay, and the space warp affects its bound object regardless of its distance from the object. When you increase the decay, the effect on the bound object falls off exponentially. See the topics on the individual modifiers for more information.

Parameter rollout

The parameters for a modifier-based space warp are identical to those of the modifier on which the space warp is based:

- Bend Modifier on page 1165
- Taper Modifier on page 1807
- Noise Modifier on page 1544
- Twist Modifier on page 1833
- Skew Modifier on page 1664
- Stretch Modifier on page 1749
Particle Systems

Particle systems are useful for a variety of animation tasks. Primarily, they're employed when animating a large number of small objects using procedural methods; for instance, creating a snowstorm, a stream of water, or an explosion. 3ds Max provides two different types of particle systems: event-driven and non-event-driven. The event-driven particle system, Particle Flow on page 2997, tests particle properties, and, based on the test results, sends them to different events. Each event assigns various attributes and behaviors to the particles while they're in the event. In the non-event-driven systems on page 3292, particles typically exhibit consistent properties throughout the animation.

**IMPORTANT** Particle systems can involve a great many entities, each of which is potentially subject to any number of complex calculations. For this reason, when using them for advanced simulations, you should have a very fast computer and as much memory as possible. Also, a powerful graphics card helps speed the display of particle geometry in the viewports. Even so, it's still easy to overburden the system; if you encounter loss of responsiveness, wait for the particle system to finish its calculations, and then reduce the number of particles in the system, implement a cache, or use other methods to optimize performance.

Which Particle System to Use?

Having access to a wealth of particle systems in 3ds Max leads to the need to decide which system to use for a particular application. In general, for a simple animation, such as falling snow or a water fountain, setup is faster and easier with a non-event-driven particle system. With more complex animations, such as an explosion that generates different types of particles over time (for example: fragments, fire, and smoke), use Particle Flow for greatest flexibility and control.

Particle Flow

Particle Flow is a versatile, powerful particle system for 3ds Max. It employs an event-driven model, using a special dialog called Particle View on page 3015. In Particle View, you combine individual operators on page 8665 that describe particle properties such as shape, speed, direction, and rotation over a period of time into groups called events on page 8564. Each operator provides a set of parameters, many of which you can animate to change particle behavior during the event. As the event transpires, Particle Flow continually evaluates each operator in the list and updates the particle system accordingly.
To achieve more substantial changes in particle properties and behavior, you can create a flow on page 8581. The flow sends particles from event to event using tests on page 8741, which let you wire on page 8763 events together in series. A test can check, for example, whether a particle has passed a certain age, how fast it's moving, or whether it has collided with a deflector. Particles that pass the test move on to the next event, while those that don't meet the test criteria remain in the current event, possibly to undergo other tests.

**NOTE** Operators and tests are known collectively as actions on page 8495.

See also:
- Non-Event-Driven Particle Systems on page 3292

---

**What's New in Particle Flow**

New in Autodesk 3ds Max 2010 is a set of operators and other tools that extend the capabilities of Particle Flow.

Before using PflowAdvanced, you should be familiar with Particle Flow in 3ds Max. If you have never used Particle Flow, do some of the Particle Flow tutorials that come with 3ds Max before working with PflowAdvanced.

**Operators and Tests**

The new operators appear in the Particle View depot alongside the original Particle Flow operators, sorted by category and then by name. They are highlighted in the following illustration.
If you have used other particle-related plug-ins, you will recognize some of the new operators and tests as improved versions of those found in other particle system extensions. However, many operators and tests are completely new with Autodesk 3ds Max 2010.

**Birth Paint operator on page 3222** Generates particles by using the data from a Particle Paint helper on page 3197.

**Birth Texture operator on page 3057** Generates particles by using animated color data from emitter objects. The operator can translate mapping from emitters to particles, and control particle scale by texture color.

**Group operator on page 3076** Uses operators from an external event to modify a subset of particles defined by a Group Selection operator.

**Group Selection operator on page 3078** Defines a subset of particles based on particle properties and other means.

**Initial State operator on page 3069** Makes a snapshot of a particle system or Particle Flow events at Start Time, and uses it to generate clone particles at Emit Time.

**Lock/Bond test on page 3264** A test for attaching particles to animated objects.

**Mapping Object operator on page 3158** Assigns mapping from reference objects to particles.

**Placement Paint operator on page 3224** Initializes position, rotation, and script data from a Particle Paint helper.
Preset Flow on page 3230 Lets you create initial custom particle systems, or add predefined sets of events, operators, and objects to the scene.

Shape operator on page 3137 Replaces the original Shape operator with an extended set of 2D and 3D particle shapes.

Split Group test on page 3084 Checks whether a particle belongs to a selection group as defined by a Group Selection operator.

Additional Tools

Painting Particles on page 3197 The Particle Paint system starts with the Particle Paint Helper on page 3197, which lets you spray particle seeds onto the surface of one or more objects. The seeds can then be used with the Birth Paint and Placement Paint operators to generate particles.

Tools menu on page 3025 The Tools menu in Particle View provides several useful functions to Particle Flow.

How Particle Flow Works

Particle View on page 3015 is the primary interface for building and modifying Particle Flow systems. The first event in the system is always a global event, whose contents affect all particles in the system. It has the same name as the Particle Flow source icon.

By default, the global event contains a single Render operator that specifies rendering properties for all particles in the system. You can add other operators here to have them act globally, such as Material, Display, and Speed. When you use an operator globally, be sure not to use the same operator locally (that is, in any other events in the system) to avoid potential conflicts.

The global event also serves as the Particle View representation of the particle system. You can create a new system by duplicating this event, or by adding an Empty Flow or Standard Flow. Conversely, if you clone the Particle Flow icon in a viewport, or add a new PF Source, the new system appears in Particle View as well.

The second event is called the birth event, because it must contain a Birth operator. The Birth operator should exist at the top of the birth event, and in no other place. The default birth event also contains a number of operators that act locally to specify properties of particles while in that event. The default particle system provides a basic global event and birth event that serve as a
useful starting point for creating your own system. If you like, you can instead start with an empty system that lets you build a particle system from scratch.

1. Event display
2. Particle diagram
3. Global event
4. Birth event
5. Depot
To add an action to the particle diagram, you drag it to the event display from the depot (the area at the bottom of the Particle View dialog). If you drag an action to an event, you can add it to the event or replace an existing action, depending on where you drop it. If you drop it in an empty area, it creates a new event. Then, to customize the action, you click its event entry, and then edit its settings in the parameters panel at the side of Particle View.

To add complexity to the particle system, you can add a test to an event, and then wire the test to another event. You can adjust the test parameters to affect particle behavior, as well as determine whether specific conditions exist. When particles meet these conditions, they become eligible for redirection to the next event.

Particle Flow provides a number of tools for determining where in the system particles currently reside, including the ability to change particle color and shape on an event-by-event basis. You can also easily enable and disable actions and events, and determine the number of particles in each event. To speed up checking particle activity at different times during the animation, you can cache particle motion in memory. Using these tools, plus the ability to create custom actions with scripting, you can create particle systems of a level of sophistication previously unachievable.

The Life of a Particle

Another way of looking at Particle Flow is from the perspective of an individual particle. Each particle first comes into existence, or is born, via the Birth operator on page 3052, which lets you specify when to start and stop creating particles, and how many to create.

The particles first appear at an object called an emitter. By default, the emitter is the Particle Flow source icon using the Position Icon operator on page 3086, but you can alternatively use the Position Object operator on page 3089 to specify that particles should be born on the surface of or within any mesh object in the scene.

After being born, particles can remain stationary at the emission point, or start moving in two different ways. First, they can move, physically, within the scene at a speed and in a direction specified by various actions. These are typically Speed operators, but other actions can also affect particle motion, including Spin on page 3099 and Find Target on page 3247. In addition, you can use the Force operator on page 3189 to affect their motion with outside forces.
1. Particle immediately after creation, with no speed.
2. The Speed operator sets the particle in motion.
3. The particle continues moving until acted upon by another action.

The second way that particles move is logically, from event to event through the particle diagram, as constructed in Particle View on page 3015. Each event can contain any number of operators that can affect, in addition to motion, a particle's surface appearance, its shape and size, and others.

The particles start out in the birth event, which typically is the first event after the global event. During a particle's residence in an event, Particle Flow evaluates each of the event's actions from top to bottom, once per integration step, and makes any applicable changes to the particle. If the event contains a test, Particle Flow determines whether the particle tests True for the test's parameters, such as whether it has collided with an object in the scene. If it does, and if the test is wired to another event, Particle Flow sends the particle to the next event. If it doesn't, the particle remains in the current event, and may be further acted upon by its operators and tests. Thus, each particle exists in only one event at a time.

An action in an event can change the particle shape (1), or the particle spin (2), or spawn new particles (3).
Actions can also apply forces to particles (1), specify collision effects (2), and alter surface properties (3).

In this way, the particle continues to travel through the system. Due to the flexible nature of schematic construction in Particle Flow, a particle may be redirected to the same event several times. But at some point, you might want the particle's life to end. For this purpose, you'd use the Delete operator on page 3067 or the Collision Spawn test on page 3241 or Spawn test on page 3281. Otherwise, the particle lives throughout the entire animation.

Particle age can be used to kill a particle.

As a particle moves through the system, it's accompanied by a number of channels. For example, each particle has a speed channel that defines how fast it moves, and a material ID channel that lets Particle Flow know which sub-material to apply to it. However, the material itself is not defined by a channel, but by a Material operator that acts locally or globally. Properties that are defined by channels persist, unless altered by an action. For example, the Material Dynamic operator on page 3168 can change a particle's material ID. In effect, by setting up a particle diagram and modifying how particles look and act during the animation, you're deciding how channel values change based on events and animation keyframes.
Particle Flow FAQ

This topic offers answers to a number of questions users commonly ask when first learning to use Particle Flow. The first section contains links to all the questions, and the subsequent sections contain the questions and answers organized by category.

Question List

How does Particle Flow handle time? on page 3006
When I go to a different frame, 3ds Max sometimes seems to freeze for a while. What's going on? on page 3007
Is there a way to pre-calculate portions of a particle simulation, as in "baking" the animation? on page 3007
What else can I do to optimize performance? on page 3008
How do I use Particle Flow to make an object explode? on page 3008
How can I control the accuracy of the Particle Flow simulation? on page 3008
Can I use MAXScript to affect particles? on page 3008
Can I use more than one object as instanced geometry? on page 3009
How can I exclude particles from certain light sources? on page 3009
How do I open Particle View without clicking Particle View button on the command panel? on page 3009
Do I need multiple Particle Views to manage more than one particle system? on page 3009
Can I selectively disable or "turn off" portions of a particle system? on page 3009
I sometimes see events named “Action Recovery” in Particle View. Where did they come from? on page 3010
How do I animate action parameters? on page 3010
How can I synchronize an animated bitmap texture to particle age? on page 3010
Do I still need to bind my Particle Flow particles to space warps? on page 3010
How do I make particles follow a path? on page 3010
Can I use Snapshot or dynamics with Particle Flow? on page 3011
How do I use motion blur with Particle Flow? on page 3011

How do I use the Particle Age and Particle MBlur maps with Particle Flow? on page 3011

I’m trying to apply Particle Flow to an animation created with a dynamics system. Why am I getting strange results such as unexpected spawning of particles? on page 3012

How can I make all particles appear in the first frame while giving them different ages? on page 3012

How can I specify the time frame in which animated parameters are applied to particles? on page 3012

How can I apply bubble motion to particles? on page 3012

How can I branch an event to several other events? on page 3013

Does it matter which order I put actions in an event? on page 3013

How can I tell which particles are in a certain event? on page 3014

Why do my particles lose their material when they move to another event? on page 3014

Can I have an event receive input from multiple events? on page 3014

I changed an operator setting, but it doesn’t seem to have any effect on the particle system. on page 3014

Can an event be isolated in Particle View and not connected to anything? on page 3015

General

How does Particle Flow handle time?

Parameters that measure time in Particle Flow, such as Birth on page 3052 > Emit Start/Stop and Age Test on page 3235 > Test Value, are specified in frames. However, Particle Flow is always aware of the current system frame rate (fps), and if you change this rate, it adjusts all time-related parameters to keep the same timing. For instance, if you set Test Value to 60 when you’re using the NTSC frame rate (30 fps), and then switch to PAL (25 fps), Particle Flow automatically changes the value to 50, so the age that’s tested for is still two seconds.

On the other hand, rate parameters, such as Speed, are measured in units per second, so they don’t change when you go to a different frame rate.
When I go to a different frame, 3ds Max sometimes seems to freeze for a while. What's going on?

Most of the animation in Particle Flow is history dependent; that is, to be able to draw the particles in a particular frame, Particle Flow needs to know what happened in all previous frames. Normally, when you change a parameter value, Particle Flow needs to recalculate all frames between the start and the current frames. Or, if you go to a different frame, Particle Flow must recalculate one or more animation frames. If you go forward, it must calculate the frames between the current frame and the one you go to. So, for example, if you just go to the next frame, relatively little calculation is needed. But if you go backward, even only by one frame, it must calculate all frames from the start of the animation to the frame you go to.

If a lot of calculation is needed, there is a delay. Meanwhile, 3ds Max displays a message like “PF Source 01 Update xx% (Press Esc to cancel)” in the status bar, so you can get an idea of how the recalculation is progressing. If, when you see this message, you press the Esc key, Particle Flow displays an alert with the message “Click OK to turn off PF Source 01.” If you click OK, the recalculation stops, giving you the opportunity to optimize the animation. For example, you could reduce the number of particles for testing purposes. You must turn the source back on to continue. If you click Cancel, the calculation continues.

**TIP** An easy way to speed up recalculation and rendering of particles is by adjusting the total number of particles. To do this, select the Particle Flow source icon, and then go to the Modify panel > Emission rollout > Quantity Multiplier group. Here you can increase or decrease by percentage the total number of particles, separately for viewport display and rendering.

**TIP** To speed up animation playback when you’re not adjusting parameters, use the Cache operator (see the following item).

Is there a way to pre-calculate portions of a particle simulation, as in "baking" the animation?

Yes. Particle Flow's [Cache operator](#) on page 3178 lets you store all or part of a particle animation in memory, and then play back the animation from memory rather than having to recalculate particle motion. This makes it much faster to jump between different parts of the animation. You can even save the cached animation to disk as part of the scene file.
**What else can I do to optimize performance?**

Particle Flow can place heavy processing and resource demands on your computer. For optimal performance, the most important thing you can do is to use the fastest available CPU. Also, when using particle systems with many particles, install as much memory as possible in your computer, especially if you're using caching.

Other ways to improve performance include reducing the percentage of viewport particles with the Quantity Multiplier setting, and temporarily disabling flows and actions that you're not currently working with. When making parameter changes, return to the first frame and play forward, or set Particle View > Options menu > Update Type to “Forward”. That way, if you change a setting, the particle system is not forced to recalculate its state from the very beginning. The change will affect only animation from the current frame forward. On the other hand, the result could be misleading, because you won't be able to see the difference right away.

Also, be cautious when using spawning; it can quickly create very large numbers of particles, especially when you use the By Travel Distance option in the Spawn test on page 3281.

**How do I use Particle Flow to make an object explode?**

Particle Flow doesn't have a fragmentation operator, but by utilizing the **PArray particle system** on page 3331 in a Birth Script operator, you can implement fragmentation in Particle Flow. You can find example scenes, with commented Birth Script operators, in the files on the second disc in the directory **Samples\Scenes\Particle Flow\Fragments\**.

**How can I control the accuracy of the Particle Flow simulation?**

On the command panel > System Management rollout on page 3041 of the PF Source icon, you can adjust the integration step independently for viewport playback and rendering. The smaller the integration step, the more times Particle Flow calculates particle motion per frame, resulting in greater accuracy at the cost of calculation time.

**Can I use MAXScript to affect particles?**

Yes. Particle Flow includes a **Script operator** on page 3196 and a **test** on page 3280, as well as a **Birth Script operator** on page 3056, that let you fully customize the particle system. Each scriptable action includes a sample script, which also lists all relevant scriptable functions. You can also control parameters of the
Force operator on page 3189 and Keep Apart operator on page 3131 with script wiring, described in the respective topics.

In addition, you can execute a script at each integration step, and another just before each frame is viewed or rendered; see Script rollout on page 3042.

Can I use more than one object as instanced geometry?

Yes. With the Shape Instance operator on page 3142, you can use groups, hierarchies, and objects consisting of multiple elements, with each member of the combined object constituting a separate particle. These objects can be emitted in a specific order, or in a random order. For example, you can use a text object, with the letters emitted in the order in which they appear in the text.

How can I exclude particles from certain light sources?

To prevent particles from being affected by a light source, use the light’s Exclude function, found on the General Parameters rollout (Modify panel), to specify any events containing particles to be excluded. Specifying the PF Source XX object (default name) has no effect; you must specify all objects listed as PF Source XX->Event XX.

Particle View

How do I open Particle View without clicking Particle View button on the command panel?

Press the 6 key. It might be necessary to first turn on the Keyboard Shortcut Override Toggle.

Do I need multiple Particle Views to manage more than one particle system?

No: All particle systems appear in Particle View. You can scroll and zoom the event display to see the different systems.

Can I selectively disable or “turn off” portions of a particle system?

Yes. Particle View gives you a number of different ways of doing this. You can click an action's icon or an event's light-bulb icon to turn it off, or use the right-click menu, or use Edit menu's Turn On and Turn Off commands. Also, if you press Esc while Particle Flow is calculating, 3ds Max gives you the
opportunity of turning off the entire particle system, thus immediately returning control of 3ds Max to you. You can then analyze the system to determine the area of slowdown, optimize or simplify the particle flow, and then recalculate the animation.

I sometimes see events named “Action Recovery” in Particle View. Where did they come from?

When you merge a scene containing Particle Flow data, you can import entire events and isolated actions. If you merge an action without its events, Particle Flow places it in an event named “Action Recovery.”

Animation

How do I animate action parameters?

Use the same Auto Key on page 3373 method as with animating any other parameter in 3ds Max.

NOTE Avoid animating Particle Flow parameters with Set Key mode or with Shift+right-click. Also, to see animation keys for actions in the track bar, make sure the Particle Flow source icon is selected.

How can I synchronize an animated bitmap texture to particle age?

Use the Material Dynamic operator on page 3168 in conjunction with the Bitmap 2D map on page 6213. You'll find a procedure that describes the method in detail here on page 3169.

Do I still need to bind my Particle Flow particles to space warps?

No; you use the Collision test on page 3236, Collision Spawn test on page 3241, or Force operator on page 3189 to affect particle motion with 3ds Max space warps. The ability to do this on a global and local (per-event) basis gives you much greater control over how space warps affect the particles than with previous systems.

How do I make particles follow a path?

You can use the Speed By Icon operator on page 3112 or the Find Target test on page 3247, assigning the icon or target to a spline path. You'll find illustrative procedures in both topics.
Can I use Snapshot or dynamics with Particle Flow?

No. The Snapshot tool is not currently compatible with Particle Flow, nor is reactor or the legacy dynamics system.

How do I use motion blur with Particle Flow?

You can apply motion blur on a per-event basis by editing the event’s object properties on page 283 with the right-click menu in Particle View, or on a global basis by editing the global event’s object properties. In the Particle View dialog, highlight the event to edit and then right-click and choose Properties. On the Object Properties dialog, edit the Motion Blur group settings.

Alternatively, you can apply motion blur to an entire Particle Flow system without the need to set properties by using the multi-pass motion blur effect on page 5594 with a camera.

NOTE You can also use Object Properties to set other properties for events and the particle system, as with any object in 3ds Max. Do this only within Particle View, not using the source icon in the viewports (right-click menu > Properties or Edit menu > Object Properties).

NOTE When using Object Motion Blur, if an event contains a Material Dynamic operator that uses a material with a Particle Age, Particle MBlur, or Bitmap map, the event should not also contain a Delete operator, or a Spawn or Collision Spawn test. Also, the event should not contain any tests that are wired to another event. The only exception to this is the Age Test operator when set to Absolute Time without any variation; that is, all particles leave the event at the same time. This applies to the use of Object Motion Blur only; there are no restrictions with Image Motion Blur.

How do I use the Particle Age and Particle MBlur maps with Particle Flow?

To use the Particle Age map with Particle Flow, you must use the Delete operator to give the particles a finite life span. For further information, see Delete Operator on page 3067.

Also note the following:

- Particle Age, Particle MBlur and a Bitmap map containing an animated bitmap can be used only with Material Dynamic operator on page 3168, with Same As Particle ID turned on. You’ll find procedures for using Bitmap and Particle Age at this topic.
- The particle material cannot be a submaterial; it must be the main material.
In the non-event-driven particle systems in 3ds Max, Particle MBlur is used with a control named Direction Of Travel\MBlur and an accompanying Stretch parameter. In Particle Flow, you can replicate the stretching effect by using a Scale operator, turning off Scale Factor > Constrain Properties, and scaling the particle along one axis.

I'm trying to apply Particle Flow to an animation created with a dynamics system. Why am I getting strange results such as unexpected spawning of particles?

The dynamics system probably generates rotation keys using the Euler XYZ controller. To avoid interpolation discontinuities, change the rotation controller for such objects to TCB Rotation.

How can I make all particles appear in the first frame while giving them different ages?

Use a negative frame range in the Birth operator on page 3052. For example, to get a particle-age spread of 30 frames, set Emit Start to -29 and Emit Stop to 0.

How can I specify the time frame in which animated parameters are applied to particles?

You can animate many of the Particle Flow parameter values with keyframing. In most actions, you can choose the time frame by which to apply this animation to the particles from a drop-down list labeled Sync By. You can apply this animation to particles in the time frame of the entire animation, or at a specific time of each particle's life (particle age), or based on the length of time the particle has been in the current event. See the individual operator and test topics for details.

How can I apply bubble motion to particles?

Although Particle Flow doesn't have the bubble motion option on page 3356 found in PArray, you can simulate the effect by following this procedure:

1. Add an object to serve as particle geometry and a dummy helper object on page 2840.
2. Position the dummy away from the center of the particle geometry object and link on page 3630 your particle geometry to the dummy so that the dummy is the parent object (that is, drag from the geometry object to

3012 | Chapter 12  Space Warps and Particle Systems
the dummy). The distance between the pivots on page 3762 of the two objects determines the radius of the bubble motion.

3  In Particle View, add a Shape Instance operator on page 3142 and a Spin operator on page 3099 to the event in which the bubble motion is to occur.

4  Click the Shape Instance operator and specify the dummy object as the particle geometry object.

5  Click the Spin operator and set appropriate values for Spin Rate and Variation. For Spin Axis, keep the default setting of Random 3D.

The result is particle motion in which the particles bob about while moving along their paths, similar to bubble motion.

Events

How can I branch an event to several other events?

Particle Flow includes several Split tests, which let you send some particles to another event based on quantity, selection, or source. You can use any number of these in a single event to send parts of the particle stream to different events, and then use a Send Out test on page 3280 to redirect the remaining particles to another event. Keep in mind that any tests subsequent to the first can work only with particles remaining in the event, not necessarily all particles that begin in the event.

Does it matter which order I put actions in an event?

It depends. If an event contains two or more operators of the same type, such as Shape, the last one overrides the rest. If an event contains two or more tests, they are evaluated and particles redirected in the order in which the tests appear.

However, if two actions in an event control the same properties, the interaction is more complex. An action that works on a continuous basis will typically prevail over one that affects particles only when they first enter the event. For example, both the Find Target test on page 3247 and Speed operator on page 3108 can control particle speed and direction, but the test works continuously, while the operator takes effect only once. If an event contains both, particle speed and direction will be primarily controlled by the test, in general, even if the operator comes after the test. However, the operator's settings will still have some influence over particle behavior, particularly if its Speed value is significantly higher than that of the test. For a list of actions' effective time frames, see Action Time Frames on page 3046.
Also, if you're testing for a specific condition that can be affected by other actions in an event, be sure to place the test after the actions. For example, in an event with a Force operator on page 3189 and a Collision test on page 3236, place the Collision test after the Force operator. This avoids the possibility of the force pushing particles past the deflector before Particle Flow can test for the collision, which would allow the particles to penetrate the deflector. In general, place tests at the end of the event.

**How can I tell which particles are in a certain event?**

One way is to set the Type option for the Display operator on page 3186 in each event to a different choice. For example, the first event could use Ticks, the second Circles, and the third Lines. This way the particles change appearance in the viewports as they move from event to event. You can also use the Display operator to change particle colors, to further distinguish them.

Another way is to select all particles in a certain event. Select the Particle Flow source icon, and then go to the Modify panel > Selection rollout and click the Event icon. You can then click an event in the Select By Event list to highlight all of its particles in the viewports.

**Why do my particles lose their material when they move to another event?**

A material is a static property of an event. It does not travel along with the particles from event to event. A particle's material ID does, but its material does not. If you want particles always to use the same material, define the material in the global event on page 8594 with a Material operator on page 3156 or a Shape Instance operator on page 3142. Otherwise, you need to define it in each local event.

**Can I have an event receive input from multiple events?**

Particle Flow lets you wire any number of tests to a single event.

**I changed an operator setting, but it doesn't seem to have any effect on the particle system.**

A similar operator in the global event might be overriding your local operator. By default, Particle Flow evaluates local operators first, and then global operators. If a global operator affects the same property, such as speed, as a local one, the particle system will use the value set by the global operator. You can set local operators to override global ones by choosing Particle View > Options menu > Action Order > Globals First.
Can an event be isolated in Particle View and not connected to anything?  

Yes, but it won’t affect the particle system at all.

Particle Flow User Interface

This section describes the interface to Particle Flow.

Particle View

Select a Particle Flow source icon > Modify panel > Setup rollout > Click Particle View (or press 6).

Create panel > Geometry > Particle Systems > Object Type rollout > Click PF Source. > Setup rollout > Click Particle View (or press 6).

Particle View provides the main user interface for creating and modifying particle systems in Particle Flow. The main window, known as the event display, contains the particle diagram, which describes the particle system. A particle system consists of one or more events wired together, each of which contains a list of one or more operators on page 3050 and tests on page 3233. Operators and tests are known collectively as actions.

The first event is called the global event, because any operators it contains can affect the entire particle system. The global event always has the same name as the Particle Flow icon; by default, this is PF Source ## (starting with 01 and counting upward). Following this is the birth event, which must contain a Birth operator on page 3052 if the system is to generate particles. By default, the birth event contains this operator as well as several others that define the system’s initial properties. You can add any number of subsequent events to a particle system; collectively, the birth event and additional events are called local events. They’re called this because a local event’s actions typically affect only particles currently in the event.

You use tests to determine when particles are eligible to leave the current event and enter a different one. To indicate where they should go next, you wire the test to another event. This wiring defines the schematic, or flow, of the particle system.

By default, the name of each operator and test in an event is followed by its most important setting or settings in parentheses. Above the event display is a menu bar, and below is the depot, containing all actions available for use in the particle system, as well as a selection of default particle systems.
The easiest way to open Particle View is by pressing the 6 key. It’s not necessary to first select a Particle Flow icon.

1. Menu bar
2. Event display
3. Parameters panel
4. Depot
5. Description panel
6. Display tools

Particle View comprises the following elements:

- The menu bar on page 3017 provides functions for editing, selection, adjusting the view, and analyzing the particle system.
The event display on page 3027 contains the particle diagram, and provides functions for modifying the particle system.

The parameters panel contains rollouts for viewing and editing parameters of any selected actions. Basic functionality is identical to that of rollouts on the 3ds Max command panels, including usage of the right-click menu. To toggle display of the parameters panel, choose Display menu > Parameters.

The depot contains all Particle Flow actions, as well as several default particle systems. To see an item's description, click its entry in the depot. To use an item, drag it into the event display on page 3027. The contents of the depot fall into three categories: operators on page 3050, tests on page 3233, and flows on page 3229.

To toggle display of the depot, choose Display menu > Depot.

The Description panel displays a brief description of the highlighted depot item.

To toggle display of the description panel, choose Display menu > Description.

The icon-based display tools in the bottom-right corner of the Particle View dialog let you pan and zoom the event display window. For descriptions, see Display menu on page 3022.

Particle View Menu Bar

Select a Particle Flow source icon. > Modify panel > Setup rollout > Click Particle View (or press 6).

Create panel > Geometry > Particle Systems > Object Type rollout > Click PF Source. > Setup rollout > Click Particle View (or press 6).

The menu bar provides access to a number of important Particle View functions.

Procedures

To render only particles in specific events:

1. In Particle View, highlight the events containing the particles you want to render.

2. Choose Select menu > Assign Selection To Viewport.
3 Render using one of the Render Type on page 6542 > Selected options.

To bring a Particle Flow setup into a different scene:

1 In Particle View, highlight the events containing the particles you want to merge with a different scene. For example, to designate only a particular flow, you might highlight its global event, and then choose Select menu > Select Downstreams.

2 Choose Select menu > Save Selected, and use the file dialog to specify a file to save.

**NOTE** Any scene objects on which Particle Flow depends are also saved. For instance, if a Shape Instance operator on page 3142 in one of the highlighted events refers to a certain object, that object is saved along with the designated events.

3 Open or create the scene with which the saved Particle Flow setup will be combined, and then use Merge on page 7572 to merge the file from step 2.

**Interface**

**Edit menu**

<table>
<thead>
<tr>
<th>New</th>
<th>Insert Before</th>
<th>Append To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Turn On All</td>
<td>Turn Off All</td>
<td>Turn On Selected</td>
</tr>
<tr>
<td>Turn Off Selected</td>
<td>Make Unique</td>
<td>Wire Selected</td>
</tr>
<tr>
<td>Copy</td>
<td>Paste</td>
<td>Paste Instanced</td>
</tr>
<tr>
<td>Delete</td>
<td>Rename</td>
<td></td>
</tr>
</tbody>
</table>
Each of the first three commands on this menu presents a submenu containing all actions. Choose the command, and then choose an action from the submenu.

**NOTE** The Undo and Redo commands are available from the main 3ds Max Edit menu, and their default keyboard shortcuts are the same: Ctrl+Z and Ctrl+Y, respectively.

**New** Adds a new event containing the chosen action to the event display.

**Insert Before** Inserts the chosen item above each highlighted action. Available only when one or more actions are highlighted.

**Append To** Inserts the chosen item at the end of each highlighted event. Available only when one or more events are highlighted.

**Turn On All** Turns on all actions and events.

**Turn Off All** Turns off all actions and events.

**Turn On Selected** Turns on any highlighted, turned-off actions or events. Available only when one or more highlighted items are turned off.

**Turn Off Selected** Turns off any highlighted, turned-on actions or events. Available only when one or more highlighted items are turned on.

**Make Unique** Converts an instanced action to a copy that's unique to its event. Available only when one or more instanced actions are highlighted.

**Wire Selected** Wires one or more highlighted tests to a highlighted event, or one or more highlighted global events to a highlighted birth event. Available only when one or more tests and a single event are highlighted, or when one or more global events and a single birth event are highlighted.

**Copy** Copies any highlighted events, actions, and wires to the paste buffer. Keyboard equivalent: Ctrl+C.

**Paste** Pastes the contents of the paste buffer to the event display. Keyboard equivalent: Ctrl+V.

The result of copying and then pasting multiple items depends on what you copied:

- If you copied multiple actions, pasting adds them all to a single new event, even if they originally came from different events.
- Copying multiple events or wires pastes them exactly as copied.
If you copied a combination of actions and events, pasting creates a new event for each group of actions from a single event. For example, if you highlight event A, some actions from event B, and some actions from event C, copying and then pasting would add three events: a copy of event A, a second event with the actions from event B, and a third event with the actions from event C.

**Paste Instanced** Pastes the contents of the paste buffer to the event display, making instances of any pasted actions and their originals.

For the results of pasting multiple copied items, see Paste, above.

**Delete** Deletes any highlighted items. Keyboard equivalent: Delete.

Deleting an event also deletes all of its actions.

**Rename** Lets you enter a new name for any single highlighted item in the event display. Available only when one action or test is highlighted

---

**Select menu**

- Select Tool
  - Select All
  - Select None
- Select Actions
  - Select Operators
  - Select Tests
  - Select Sources
  - Select Events
  - Select Wires
  - Select Downstreams
- Save Selected
- Get Selection From Viewport
  - Assign Selection To Viewport
  - Sync Source/Events Selection In Viewport
By default, the Select tool is active when Particle View is open, as indicated by the arrow-shaped mouse cursor. You can use this tool to highlight, move, and copy events, actions, tools, and wires. You can also use the commands on this menu to highlight all elements, no elements, or elements by category.

**NOTE** When you render using any of the Selected options, 3ds Max renders only events that are selected in the viewports. You can use the last three commands on this menu to manage and coordinate selection of events and flows between Particle View and the viewports. This also applies to use of the Views menu > Shade Selected command.

**Select Tool** Activates the Select tool. Choose this to return to the Select tool after using interactive tools for panning and zooming the event display. Alternatively, simply right-click anywhere in the event display to activate the Select tool.

**Select All** Highlights all items in the event display.

**Select None** Deselects all items in the event display. Alternatively, click an empty area in the event display.

**Select Actions** Highlights all operators and tests in the event display.

**Select Operators** Highlights all operators in the event display.

**Select Tests** Highlights all tests in the event display.

**Select Events** Highlights all events in the event display.

**Select Wires** Highlights all wires in the event display.

**Select Downstreams** Highlights all events after currently highlighted events. Available only when one or more events are highlighted.

**Save Selected** Saves only highlighted elements in the event display to a MAX file. You can then open this file, or combine it with an existing scene with Application menu on page 7989 > Import > Merge.

**NOTE** The Particle View > Save Selected command saves all items selected in Particle View and in the scene. So if a PF Source icon is selected in the scene, then this command will save its global event as well as any birth events associated with it, if you want to save only parts of a Particle Flow setup, first unselect everything in the scene.

Also, if an action references an object (for example, a Shape Instance operator on page 3142 uses a geometry object), and the action or its parent event is
highlighted when you use Save Selected, then the reference object is saved as well.

**Get Selection From Viewport** Highlights global events whose source icons are selected in the viewports.

**Assign Selection To Viewport** Transfers an event selection to the viewports. Use this to render only particles in specific events. First, in Particle View, highlight the events to render. Next, choose this command, and finally, render using one of the **Render Type** on page 6542 > Selected options.

**Sync Source/Events Selection In Viewport** Selects all events of any source icons selected in the viewports. You can then propagate this selection to Particle View with the Get Selection From Viewport command.

Use this function to render a specific particle flow using one of the **Render > Selected options**.

**Display menu**

<table>
<thead>
<tr>
<th>Pan Tool</th>
<th>Zoom Tool</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom Region Tool</td>
<td>Zoom Extents</td>
</tr>
<tr>
<td>No Zoom</td>
<td></td>
</tr>
</tbody>
</table>

The first five commands on this menu are also available as icons, in the Display tools section on the right side of the bottom border of the Particle View dialog. Each command’s Display tools icon is shown below.

**Pan Tool** Drag in the event display to move the view. The mouse cursor changes to a hand icon. You can also pan the view by dragging with the middle mouse button or wheel button held down.

To exit this mode, right-click in the event view or choose the command again.
Zoom Tool Drag in the event display to zoom the view. The mouse cursor changes to a magnifying-glass icon. Drag upward to zoom in, or downward to zoom out. To exit this mode, right-click in the event view or choose the command again.

Zoom Region Tool Drag in the event display to define a zoom rectangle. The mouse cursor changes to the image of a magnifying glass inside a zoom region. When you release the mouse button, the display zooms to show only the area defined by the region. To exit this mode, right-click in the event view or choose the command again.

Zoom Extents Sets the zoom to show the entire particle diagram in the event display.

No Zoom Sets the zoom to the default level. This is the level displayed when you first open Particle View in a given session.

Parameters Toggles display of the parameters panel, on the right side of the Particle View dialog. Default=on.

Depot Toggles display of the depot, below the Particle View dialog. Default=on.

Description Toggles the Description panel, to the right of the depot. Default=on. The Description panel displays a brief description of any action highlighted in the depot.

Options menu

This menu contains a number of options useful in analyzing and debugging particle systems.
Default Display Determines whether the Display operator is applied locally or globally to new particle systems and events. Default=Local.

- **Global**  When you create a new particle system, Particle Flow adds a single Display operator to the global event. It does not add a Display operator to each new event.

- **Local**  Particle Flow adds a Display operator to each new event. This lets you easily distinguish particles in different events in the viewports.

Action Order For predictable results, don’t use similar actions in the global and local events. However, if comparable actions do exist in both the global event and other events, Particle Flow applies them to the system in the order specified here. Typically, the effect that’s applied last is the one that’s visible in the particle system. Default=Locals First.

For example, consider a situation in which the global event contains a Shape operator set to Cube, and the other events in the same system contain Shape operators set to Tetra or Sphere. By default, Particle Flow applies the global Shape operator last at each integration step, overwriting any local shapes, so all particles would be cubes. But if you set Action Order to Globals First, the local shapes are applied last, and particles appear as tetrahedrons or spheres, depending on which event they’re in.

- **Globals First**  At each integration step, Particle Flow first applies actions in the global event, and then actions in the other (local) events. Typically, the result is that actions in the local events override comparable actions in the global event.

- **Locals First**  At each integration step, Particle Flow first applies actions in the local events, and then actions in the global event. Typically, the result is that actions in the global event override comparable actions in the local events.

Update Type This setting determines how Particle Flow updates the system when you change a parameter during playback. Because the state of the particle system at any given frame can depend on events in previous frames, using the Complete option can provide a more accurate depiction of the result of the change, at a cost in speed; it takes more time to recalculate the entire system starting at the first frame. Default=Complete.

- **Complete**  When you change a setting during playback, Particle Flow updates the entire system, starting at the first frame.

- **Forward**  When you change a setting during playback, Particle Flow updates the system starting at the current frame.
**Track Update** Provides options for visualizing the particle system status in Particle View.

- **Particle Count**  Adds a tab above each event that shows the number of particles in the event. The global event's count shows the total number of particles in the particle system. Use this, in addition to the ability to display particles differently in each event, to trace particle progress through the system.

- **Update Progress**  Highlights each action in color whenever Particle Flow evaluates it. The highlighting is very fast, but this option can add significant computational overhead to the particle system, with the result that real-time playback might skip a greater number of frames. To see all frames, turn off Time Configuration > Real Time.

**Use Dynamic Names** When on, action names in events are followed by their most important setting or settings, in parentheses. When off, only the names appear. Default=on.

---

**Tools menu**

The Tools menu in Particle View provides several utilities for managing Particle Flow.

- **Synchronize Layers** Synchronizes Particle Flow geometry with source objects. Use this option after you move PF Source objects to different layers. The Synchronize Layers option does not change objects' layers, but rather synchronizes Particle Flow geometry with source objects so they will function correctly.
  - **MAXScript** particleFlowUtility.synchronizeLayers()

- **Repair Cache System** Repairs the cache system if it stops working. If a Cache operator ends up in a different event from the one it was originally placed in, whether through direct manipulation or from being merged into another Particle Flow system, the operator might stop functioning because of ID conflicts. In such cases, use this function to restore the cache to working condition.
  - **MAXScript** particleFlow.repairCacheSystem(bool doReport)
**Preset Manager** Opens the Particle Flow Preset Manager dialog (see following).

- **MAXScript** `particleFlow.presetManager()`

**Particle Flow Preset Manager dialog**

You can use the Preset Manager to save a scene as a preset for later retrieval via **Preset Flow** on page 3230 in Particle View. Keep in mind that all objects in the scene are saved as a part of the preset, regardless of whether they are part of the Particle Flow. This ensures that any Particle Flow reference objects are included in the preset.

To save a new preset, enter a Preset Name and Preset Description, and then click **Save Scene As Preset Flow**.
**Preset Name** Enter an identifying name for the new preset.

**Preset Description** Enter a description for the new preset.

**Presets** A list of the current presets in the system. Click a preset to see its description.

**Save Scene as Preset Flow** Saves the current scene as a preset. The preset is saved as a pair of files: *preset_name.txt* with the description of the preset; and *preset_name.max* file with the scene itself. Both files are saved in \plugcfg\ParticleFlow\Presets\ within the install folder. Since presets are saved as files, it is possible to exchange or modify the presets by manipulating the files.

**Particle View Event Display**

Select a Particle Flow source icon. > Modify panel > Setup rollout > Click Particle View (or press 6).

Create panel > Geometry > Particle Systems > Object Type rollout > Click PF Source. > Setup rollout > Click Particle View (or press 6).

The event display on page 8566 in Particle View contains the particle diagram, and provides a complete range of intuitive functions for editing the particle system.

**NOTE** A number of these functions are also available from the event display right-click menu on page 3031, as well as the menu bar on page 3017.

**Editing the Particle Diagram and Particle System**

Interactive functionality in event display includes the following:

**General**

- To add an action to the particle system, drag it from the depot to the event display. If you drop it in an empty area of the event display, it creates a new event. If you drag it to an existing event, the result depends on whether a red line or a blue line appears when you drop it. If a red line, the new action replaces the underlying action. If a blue line, the action is inserted in the list.

- To edit an action's parameters, click its name in an event. The parameters appear on the right side of Particle View. If not, it means the parameters panel is hidden; to display it, choose Display menu > Parameters.
To wire a test to an event, drag from its test output, the blue dot that by default sticks out to the left of the test, to the event’s event input, which sticks out from the top, or vice-versa. Similarly, you can wire a global event to a birth event by dragging between the source output on the bottom of the global event and the event input. The mouse cursor changes to the first depicted image when you can begin this operation, and to the second image when you can complete it.

To pan or zoom the event display, use the controls available from the Display menu on page 3022, the right-click menu on page 3031, or as icons at the bottom-right of the dialog.

**Modifying Actions and Events in the Event Display**

- To change the color used by a Display operator, click its color swatch to the right of its name.

- To toggle an operator (that is, turn it off and on), click its icon in the event. The mouse cursor changes to the depicted image when this action is possible.

  A turned-off operator does not affect the particle system, and appears as gray in the event list; however, its parameters are still available for editing.

  Toggling an instanced operator doesn’t affect its other instances.

- To toggle an event (that is, turn it off and on), click the light-bulb icon next to its name in the title bar. Turning off an event is equivalent to turning off all of its operators and tests, although you cannot turn the operators and tests back on individually. The event’s items do not affect the particle system, and appear as gray in the event list. All particles entering a turned-off event are immediately passed on to the next event, if any.
To make a test result always True or False, click its icon’s left or right side, respectively. The mouse cursor changes to the first image at the left (with the left-pointing arrow) when you can click for always True, and to the second image at the left (without the left-pointing arrow) when you can click for always False.

The test icon changes to a green or red light bulb to indicate current functionality: green for always True, and red for always False.

To return to the original functionality, click the icon again. The mouse cursor changes to the depicted image when this action is possible.

## Selecting, Moving, and Copying

To copy an action or event, first press and hold the Shift key and position the mouse cursor over the item to copy. When the plus sign (+) appears next to the mouse cursor arrow, drag the item to a new location. When you release the mouse button, the Clone Options dialog appears; choose Copy or Instance and click OK. In the Clone Options dialog, the Event And Particle System group is unavailable, as a reminder that you cannot instance these elements. Reference is not an option when cloning Particle System elements. Cloning an event or particle system simply creates a new event or particle system containing clones of the original’s actions. Any instanced actions have identical properties. Changing one instance’s values changes them all. On the other hand, copied actions can have different values.

To clone multiple items, highlight them all before Shift+dragging. If you attempt to clone a combination of actions and events, or actions from different events, the result depends on where you start dragging from. If you drag a highlighted action, you’ll clone only actions from that event. If you drag an event, only highlighted events are cloned.

**NOTE** When you highlight an instanced action, Particle View indicates all of its other instances by changing their background color to a lighter shade of gray.
To move an event, drag its title bar, or the icon of any of its actions. If you drag the event to an edge of the display, and scrolling is possible, the display window will automatically scroll in that direction.

To resize an event, drag its right edge.

To highlight multiple items, drag a rectangle around them, or Ctrl+click them individually.

To delete an event, action, or wire, highlight it and then press Delete. Be sure the Particle Dialog is active, or you might inadvertently delete a selection in the scene instead.

To move an action, drag its name (not its icon) to the new location. If you drag the event to an edge of the display, and scrolling is possible, the display window will automatically scroll in that direction.

If you drag an action to an event, you can insert the action or replace an existing action, depending on where you position the mouse cursor before releasing the button. A blue line (before releasing) indicates that it will be inserted at that location, and a red line indicates that it will replace the underlying action. If you drag the action to an empty space in the event display, it will form a new event, and, by default, the system will add a new Display operator.

NOTE Particle Flow doesn't let you perform illegal operations. For instance, a Birth operator must always be the first item in a birth event on page 8521; the system doesn't let you position it elsewhere. You can place a Birth operator in an isolated event, but you can't then wire that event into a particle system, except in parallel with another birth event. For more information, see the Birth operator topic on page 3052.

To move a test output or switch it to the opposite side of the event, drag from just inside the test output to the desired new location. The mouse cursor changes to the depicted image when this operation is possible.

Getting Information

To see a renamed action's original type, position the mouse cursor over its event list entry until the tooltip appears.

To see a brief description of an action, click it in the depot. The description appears on the Description panel, to the right of the depot.
Event Display Right-Click Menu

Select a Particle Flow source icon. > Modify panel > Setup rollout > Click Particle View (or press 6). > Right-click in event display.

Create panel > Geometry > Particle Systems > Object Type rollout > Click PF Source. > Setup rollout > Click Particle View (or press 6). > Right-click in event display.

The event display right-click menu provides handy access to a number of contextual commands. The contents of the menu, as well as the results of its commands, depend in some cases on where you click, in other cases on what’s highlighted, and in still other cases, on both.

In the following descriptions, “item” means an action or event, or, in some cases, a wire.

Interface

**Insert** Displays a submenu of all actions, and when you choose a new action, inserts it where you originally right-clicked. Available only when you right-click over an event or action.

If you right-click over an action, and then insert an action, the inserted action replaces the old one. If you right-click above or below an action (no tooltip appears), the new action is added to the event at that location. If you right-click over an event, the action is inserted at the first available position.

**Append** Displays a submenu of all actions, and when you choose a new action, inserts it at the end of the event. Available only when you right-click over an event or action.

**Turn On** Turns on the event or action under the mouse cursor. Available only when the item under the mouse cursor is turned on.

To affect an event, the mouse cursor must be over its title bar. Turning on a highlighted item affects all highlighted items.

**Turn Off** Turns off the event or action under the mouse cursor. Available only when the item under the mouse cursor is turned off.

To affect an event, the mouse cursor must be over its title bar. Turning off a highlighted item affects all highlighted items.

**Make Unique** Converts an instanced action to a copy that’s unique to its event. Available only when the mouse cursor is over an instanced action.
If you right-click over a highlighted, instanced action, Make Unique affects all such actions.

**Wire** Wires one or more highlighted tests to a highlighted event, or one or more highlighted global events to a highlighted birth event. Available only when one or more tests and a single event are highlighted, or when one or more global events and a single birth event are highlighted, and when you right-click over an eligible, highlighted item.

**Copy** Copies any highlighted events, actions, and wires to the paste buffer. Available only when the mouse cursor is over an highlighted action, but affects all highlighted items.

**Paste** Pastes the contents of the paste buffer to the event display at the mouse cursor.

If the cursor is over a list, and you copied actions, the actions are added to the event. If the cursor is over an empty area of the event display, Particle Flow creates a new event containing the pasted actions. A copied event can be pasted only in an empty area of the event display.

The result of copying and then pasting multiple items depend on what you copied and the position of the mouse cursor:

- If you copied multiple actions, pasting adds them all to the event under the mouse cursor, or, if the cursor is over an empty area, to a new event, even if they originally came from different events.

- Copying multiple events and/or wires pastes them exactly as copied, but in this case Paste is available only when the mouse cursor is over an empty area.

- If you copied a combination of actions and events, you can paste them only when the mouse cursor is over an empty area. Pasting creates a new event for each group of actions from a single event. For example, if you highlight event A, some actions from event B, and some actions from event C, copying and then pasting would add three events: a copy of event A, a second event with the actions from event B, and a third event with the actions from event C.

**Paste Instanced** Pastes the contents of the paste buffer to the event display, making instances of any pasted actions and their originals.

For the results of pasting multiple copied items, and the limitations based on mouse position, see Paste, above.
New  Add a new item to the event display from the submenu. The submenu contents are identical to that of the depot. Available only when the mouse cursor is over an empty area.

Delete  Deletes the item under the mouse cursor. Available only when the mouse cursor is over an item.
If the mouse cursor is over a highlighted item, choosing Delete deletes all highlighted items.

Rename  Lets you rename the item under the mouse cursor. Enter a new name from the keyboard.

Properties  Opens the Object Properties dialog for the event under the mouse cursor. Available only when the mouse cursor is over the title bar of a highlighted event.
Particle Flow lets you set object properties on a per-event basis. This lets you set attributes such as Hide, Renderable, and Motion Blur separately for each event. Alternatively, you can set properties for the entire particle system from the global event.
For more information, see Object Properties on page 283.

NOTE Set properties for events and the particle system only within Particle View, not via the source icon in the viewports (using the right-click menu > Properties or Edit menu > Object Properties).

Use Script Wiring  Lets you use a script to specify certain parameters in the Force operator on page 3189 and Keep Apart operator on page 3131. This command appears only when you right-click either of the specified, highlighted operators in an event.

Comments  Lets you add comments to each action and event, and view existing comments. Available only when the mouse cursor is over an action or the title bar of an event.
Choosing Comments opens a window for entering text from the keyboard. Begin typing, and click OK to finish. A commented event or action has a red triangle near its name to indicate the presence of the comment. You can click this triangle to open the comment.
Commented actions; click the triangle to view a comment.

**NOTE** A comment is specific to the action or event to which it's applied. If you copy a commented event or action, the comment is not included in the copy, because it's probably not applicable to the copy.

**Pan** Switches to the Pan tool. Drag in the event display to change the view; right-click to exit. Available only when you click over an empty area of the event display.

**Zoom** Switches to the Zoom tool. Drag upward in the event display to zoom in, and downward to zoom out; right-click to exit. Available only when you click over an empty area of the event display.

**Zoom Region** Switches to the Zoom Region tool. Drag a rectangle in the event display to specify the area to zoom into; right-click to exit. Available only when you click over an empty area of the event display.

**Particle Flow Source**

Add a Particle Flow system to the scene. > Create panel
Select a PF Source icon. > Modify panel

**Particle View** on page 3015 > Click a global event (title bar). > Parameters panel

The Particle Flow source is the viewport icon for each flow on page 8581, and also serves as the default emitter. By default, it appears as a rectangle with a central logo (see illustration), but you can change its shape and appearance using the controls described in this topic.
When you select a source icon in the viewport, the Particle Flow emitter-level rollouts appear on the Modify panel. Alternatively, click the title bar of a global event in Particle View to highlight it, and to access the emitter-level rollouts from the parameters panel on the right side of the Particle View dialog. Use these controls for setting global attributes, such as icon properties and the maximum amount of particles in the flow.

The particle source icon is roughly equivalent to the corresponding global event on page 8594 in Particle View. They have the same name, but selecting one does not select the other. If you delete a particle source icon from the scene, Particle Flow converts the global event to an isolated local event in Particle View, retaining its operators with their settings intact. Any other events in the system remain in Particle View, along with their wiring. However, if you delete a global event, Particle Flow also removes any local events used exclusively by that system, as well as the corresponding particle source icon. To retain the local events, first delete the wire from the global event, and then delete the global event.

If you clone a particle source in a viewport with Shift+transform or Edit menu > Clone, an equal number of copies of the global event appear in Particle View, each wired to the original birth event on page 8521. The Clone Options dialog offers only the Copy option. However, if you clone a global event in Particle View, the Clone Options dialog also lets you create instances of the cloned operators and tests. It's not possible to create instances of global and local events, so these options are unavailable in the Clone Options dialog, as a reminder. Also, global events cloned in Particle View are not automatically wired to the original birth event.
Interface

Modifier stack

In the modifier stack, expanding the hierarchy of a Particle Flow source object provides access to two sub-object levels: Particle and Event. For further information, see Selection rollout on page 3039.

Setup rollout

Use these controls to turn the particle system on and off, and to open Particle View.

NOTE This rollout appears only on the Create and Modify panels, not on the Particle View dialog > parameters panel.

Enable Particle Emission Turns the particle system on and off. Default=on. You can also turn off all particle flows in Particle View with Edit menu > Turn Off All, or a specific particle flow by right-clicking its global event's title bar and choosing Turn Off.

Particle View Click to open the Particle View dialog on page 3015.
Emission rollout

Sets the physical characteristics of the emitter (particle source) icon, and the percentage of particles produced in the viewports and when rendering.

Emitter Icon group

Logo Size  Sets the size of the Particle Flow logo, which appears at the center of the source icon, as well as the arrow that indicates the default direction of particle motion.
By default, the logo size is proportional to that of the source icon; with this control, you can make it larger or smaller.
This setting affects only the viewport display of the logo; changing it has no effect on the particle system.

Icon Type  Choose the basic geometry of the source icon: Rectangle, Box, Circle, or Sphere. Default=Rectangle.
This choice matters only if you use the source icon as the particle emitter. The available size settings depend on which icon type you choose, and, again, are important only if you use the source icon as an emitter.
The default icon type is Rectangle. If you add a particle system, and then change the icon type to Box, the icon continues to resemble a rectangle. To make it look like a box, increase the Height setting.

Length/Diameter  Sets the length of the Rectangle and Box icon types, and the diameter of the Circle and Sphere icon types.
Width  Sets the width of the Rectangle and Box icon types. Unavailable with
the Circle and Sphere icon types.

Height   Sets the height of the Box icon type. Available only with the Box icon
type.

Show Logo/Icon   Turns display of the logo (with arrow) and icon on and off,
respectively.

These settings affect only the viewport display of these items; they have no
effect on the particle system.

Quantity Multiplier group

These settings determine the percentage of the total number of particles in
each flow on page 8581 that are actually produced in the viewports and at render
time. They don’t affect the percentage of particles that are visible; those are
determined by the Display operator on page 3186 and Render operator on page
3194. You can use them to quickly decrease or increase the number of particles
consistently throughout all events in the particle system. The maximum
setting, 10,000%, lets you multiply the number of particles generated by the
flow by 100.

The total number of particles is determined by the combined effects of the
following operators and tests: Birth on page 3052, Birth Script on page 3056, Delete
on page 3067, Collision Spawn on page 3241, and Spawn on page 3281. Scripted
operators and tests can also affect this number.

Viewport   Sets the percentage of the total number of particles in the system
produced in the viewports. Default=50.0. Range=0.0 to 10000.0.

Render   Sets the percentage of the total number of particles in the system
produced at render time. Default=100.0. Range=0.0 to 10000.0.
Selection rollout

Use these controls for selecting particles on a per-particle or event basis. Selection of particles at the Event level is for debugging and tracking purposes. Particles selected at the Particle level can be acted upon by the Delete operator on page 3067, the Group Selection operator on page 3078, and the Split Selected test on page 3290. You cannot directly manipulate selected particles with standard 3ds Max tools such as Move and Rotate.

**NOTE** This rollout appears only on the Modify panel, not on the Create panel or Particle View dialog > parameters panel.

**Particle** Lets you select particles by clicking them or dragging a region.

**Event** Lets you select particles by event. At this level, you can select all particles in one or more events by highlighting the event(s) in the Select By Event list on page 3040, or in the viewports with standard selection methods. To convert a selection from the Event level to the Particle level for use with the Delete operator or Split Selected test, use Get From Event Level on page 3040.
Selected particles appear in the viewports in red (if not geometry), in the form designated by the Display operator > Selected setting on page 3189.

**Select by Particle ID group**

Each particle has a unique ID number, starting with 1 for the first particle and counting up. Use these controls to select and deselect particles by their ID numbers. Available only at the Particle selection level.

**TIP** You can display particle IDs in the viewports by turning on Display operator > Show Particle IDs.

**ID** Use this to set the ID number of the particle you want to select. You can set only one number at a time.

**Add** After setting the ID number of a particle to select, click Add to add it to the selection. By default, selecting a particle doesn't deselect any others.

**Remove** After setting the ID number of a particle to deselect, click Remove to remove it from the selection.

**Clear Selection** When on, clicking Add to select a particle deselects all other particles.

---

**Get From Event Level** Click to convert an Event-level selection to the Particle level. Available only at the Particle level.

---

**Select By Event** This list shows all events in Particle Flow, and highlights selected events. To select all of an event's particles, click its list entry, or use standard viewport-selection methods.

**# Particles Selected** Shows the number of selected particles.
System Management rollout

Use these settings to limit the number of particles in the system, and to specify the frequency of updating the system.

Particle Amount group

Upper Limit The maximum number of particles the system may have. Default=100000. Range=1 to 10000000.

TIP You can have more than 10,000,000 particles in a single system by using multiple particle sources and wiring them to the same birth event. Note, however, that Particle Flow is limited to sending a maximum of 5,000,000 particles per event to the renderer.

Integration Step group

At each integration step, Particle Flow updates the particle system, applying each active action to particles in its event. A smaller integration step can improve accuracy, at the cost of calculation time. These settings let you apply different integration steps to the particle animation in the viewports and at render time.

In most cases, the default Integration Step settings work fine. One instance in which increasing the integration-step frequency might help is when fast-moving particles that should collide with a deflector penetrate it instead.

Viewport Set the integration step for animation playback in the viewports. Default=Frame (once per animation frame). Range=1/8 Frame to Frame.

Render Set the integration step at render time. Default=Half Frame (twice per animation frame). Range=1 Tick to Frame.

There are 4,800 ticks in a second; thus, at the NTSC video rate of 30 frames per second, there are 160 ticks per frame.
Script rollout

This rollout lets you apply a script to the particle system at each integration step, as well as after the last integration step of each frame you view. Use an Every Step Update script to set up history-dependent properties, and a Final Step Update script to set up history-independent properties.

Every Step Update group

The Every Step Update script is evaluated at the end of each integration step, after all actions in the particle system are evaluated, and all particles are finally in their respective events. When, for example, you are setting up Material ID according to a particle index, it is important to be sure that particles are not about to jump to another event.

When you set up history-dependent properties, such as speed, it is important to do that at every integration step, because otherwise the final position would be quite different.

Enable Script Turn on to cause a script in memory to be executed at each integration step. You can modify this script by clicking the Edit button, or load and use a script file with the remaining controls in this group.

The default script modifies particle speed and direction, causing particles to follow a wavy path.

Edit Click this button to open a text-editor window with the current script. When Use Script File is on, this is the default Every Step Update script (3dsmax\scripts\particleflow\example-everystepupdate.ms). When Use Script File is on, this is the loaded script, if you've loaded one. If you haven't, clicking Edit displays the Open dialog.
Use Script File When on, you can load a script file by clicking the button below.

[button] Click this button to display an Open dialog that lets you specify a script file to load from disk. After you load a script, the name of script file appears on the button.

**Final Step Update group**

The Final Step Update script is executed after the last integration step has been completed for each frame that you view (or render). For example, if you play the animation in the viewport with Real Time turned off, Particle Flow runs this script at each frame, immediately before the particle system is rendered to the viewport. However, if you simply jump to a different frame, the script is run once only, so if the script assumes a certain history, you might get unexpected results.

For this reason, it's best to use the Final Step Update script to modify history-independent properties. For example, if no operators in the system depend on the material indices, you could use it to modify the material index. In this case there's no need to set those indices in every intermediate integration step. Also, you can set up a position channel in the Final Step Update script if you know the analytical expression for the position.

Enable Script Turn on to cause a script in memory to be executed after the final integration step. You can modify this script by clicking the Edit button, or load and use a script file with the remaining controls in this group.

The default script modifies particle speed and direction, causing particles to follow a bulb-shaped path.

Edit Click this button to open a text-editor window with the current script.

When Use Script File is off, this is the default Final Step Update script (3dsmax\scripts\particleflow\example-finalstepupdate.ms). When Use Script File is on, this is the loaded script, if you've loaded one. If you haven't, clicking Edit displays the Open dialog.

Use Script File When on, you can load a script file by clicking the button below.

[button] Click this button to display an Open dialog that lets you specify a script file to load from disk. After you load a script, the name of script file appears on the button.
Particle Flow Helpers

Create panel > Helpers > Particle Flow > Object Type rollout
Create menu > Helpers > Particle Flow

In general, Particle Flow helpers take the form of icons that are automatically created in the scene when you add the associated test or operator. A special case is the Particle Paint helper, which must be added explicitly.

With the exception of Particle Paint, when you add a Particle Flow helper to the scene, Particle Flow creates the associated action in Particle View.

Interface

![Object Type rollout]

SpeedByIcon on page 3112
Find Target on page 3247
Particle Paint on page 3197
Birth Texture on page 3057
Initial State on page 3069
Group Select on page 3078

Particle Flow Keyboard Shortcuts

To use Particle Flow keyboard shortcuts, the Keyboard Shortcut Override Toggle on the main toolbar must be turned on.

To view and customize these shortcuts, open the Customize User Interface dialog from the Customize menu, and then, from the Group drop-down menu, choose Particle Flow.

<table>
<thead>
<tr>
<th>Particle Flow Function</th>
<th>Keyboard Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clean Up Particle View</td>
<td>Alt+Ctrl+P</td>
<td></td>
</tr>
<tr>
<td>Particle Flow Function</td>
<td>Keyboard Shortcut</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>-------------------</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td>Copy Selected In Particle View*</td>
<td>Ctrl+C</td>
<td></td>
</tr>
<tr>
<td>Open Preset Manager</td>
<td>Alt+Ctrl+M</td>
<td></td>
</tr>
<tr>
<td>Particle Emission Toggle</td>
<td>;</td>
<td>Toggles active status of all particle systems.</td>
</tr>
<tr>
<td>Particle View Toggle</td>
<td>6</td>
<td>Toggles Particle View dialog.</td>
</tr>
<tr>
<td>Paste In Particle View*</td>
<td>Ctrl+V</td>
<td></td>
</tr>
<tr>
<td>Repair Cache System</td>
<td>Alt+Ctrl+C</td>
<td></td>
</tr>
<tr>
<td>Reset Particle View*</td>
<td>Alt+Ctrl+R</td>
<td></td>
</tr>
<tr>
<td>Select All In Particle View*</td>
<td>Ctrl+A</td>
<td>Selects all events, actions, and wires.</td>
</tr>
<tr>
<td>Selected Particle Emission Toggle</td>
<td>Shift+;</td>
<td>Toggles active status only of particle systems whose icons are selected in the viewports.</td>
</tr>
<tr>
<td>Synchronize Particle Flow Layers</td>
<td>Alt+Ctrl+L</td>
<td></td>
</tr>
</tbody>
</table>

* These functions are specific to Particle View. It is recommended that you use Customize User Interface to change their keyboard shortcuts only, and not assign them to toolbars, quads, or menus.

**MAXScript/CUI-Only Tools**

New in Particle flow are two commands for resetting Particle View and for cleaning up Particle Flow that are available from Customize User Interface and MAXScript.
Interface

Reset Particle View Moves the Particle View dialog to its default position. If a scene is opened and saved on different computer systems with different resolutions, you might find that the Particle View dialog has been placed off-screen with regard to your system. Reset Particle View option restores the default position and makes the dialog visible on any computer system.

- Customize User Interface (CUI) action  Reset Particle View
- Shortcut  Alt+Ctrl+R
- MAXScript  particleFlowUtility.resetParticleView()

Clean Up Particle Flow Removes items that can slow down rendering and editing. When a you create or modify a Particle Flow system, invisible items are sometimes created in the flow network. If you change the PF system during playback, these items allow the PF system to display changes immediately in viewports. However, the items might slow down rendering or editing. Clean Up Particle Flow deletes the invisible items safely, improving render speed and interactivity during Particle View editing.

It is recommended that you use this option after editing Particle View wiring and before rendering or saving the scene.

- Shortcut  Alt+Ctrl+P
- MAXScript  particleFlow.cleanUpParticleFlow(bool doReport)
  Returns number of items removed (cleaned up) from Particle Flow. The bool doReport parameter specifies whether or not to show a message box with the report.

Actions

The Particle Flow components for creating particle systems are known collectively as actions. These are subdivided into three main categories: Operators, Flows, and Tests.

Action Time Frames

Most actions in Particle Flow operate on particles in either of two time frames: once, when the particle first enters the event, or on a continuous basis, potentially changing particle behavior at each integration step (that is, the
whole time the particle is in the action’s event). Some actions can work only in one time frame, while others can work on an instantaneous or continuous basis, depending on their settings. The tables in this topic list each action with its time frame.

**Operators**

<table>
<thead>
<tr>
<th>Operator</th>
<th>Time Frame</th>
</tr>
</thead>
<tbody>
<tr>
<td>Birth</td>
<td>n/a</td>
</tr>
<tr>
<td>Birth Paint</td>
<td>Once, except continuous when Lock At Painted Objects &gt; Position or Rotation is on</td>
</tr>
<tr>
<td>Birth Script</td>
<td>n/a</td>
</tr>
<tr>
<td>Birth Texture</td>
<td>Once</td>
</tr>
<tr>
<td>Delete</td>
<td>n/a</td>
</tr>
<tr>
<td>Force</td>
<td>Continuous</td>
</tr>
<tr>
<td>Group</td>
<td>Once</td>
</tr>
<tr>
<td>Group Selection</td>
<td>Depends on Selection Update setting</td>
</tr>
<tr>
<td>Initial State</td>
<td>Once, except continuous when Lock To Icon TM &gt; Position or Speed is on</td>
</tr>
<tr>
<td>Keep Apart</td>
<td>Continuous</td>
</tr>
<tr>
<td>Mapping</td>
<td>Continuous</td>
</tr>
<tr>
<td>Mapping Object</td>
<td>Depends on Type setting</td>
</tr>
<tr>
<td>Material Dynamic</td>
<td>Continuous</td>
</tr>
<tr>
<td>Operator</td>
<td>Time Frame</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Material Frequency</td>
<td>Once</td>
</tr>
<tr>
<td>Material Static</td>
<td>Once</td>
</tr>
<tr>
<td>Placement Paint</td>
<td>Depends on Data Update setting</td>
</tr>
<tr>
<td>Position Icon</td>
<td>Once, except continuous with Lock On Emitter</td>
</tr>
<tr>
<td>Position Object</td>
<td>Once, except continuous with Lock On Emitter</td>
</tr>
<tr>
<td>Preset Flow</td>
<td>n/a</td>
</tr>
<tr>
<td>Rotation</td>
<td>Once, except continuous with Speed Space Follow</td>
</tr>
<tr>
<td>Scale</td>
<td>Once, except continuous with Absolute and Relative options</td>
</tr>
<tr>
<td>Script Operator</td>
<td>Depends on script</td>
</tr>
<tr>
<td>Shape</td>
<td>Once, except continuous when Scale % or Variation % parameters are animated</td>
</tr>
<tr>
<td>Shape Facing</td>
<td>Continuous</td>
</tr>
<tr>
<td>Shape Instance</td>
<td>Once, except continuous with Animated Shape</td>
</tr>
<tr>
<td>Shape Mark</td>
<td>Once, except continuous with Align To Surface Animation</td>
</tr>
<tr>
<td>Speed</td>
<td>Once</td>
</tr>
<tr>
<td>Speed By Icon</td>
<td>Continuous</td>
</tr>
</tbody>
</table>
Time Frame | Operator | Time Frame
---|---|---
Depends on setting | Speed By Surface | Depends on setting
Once, except continuous with Speed Space Follow | Spin |
Continuous | Split Group |
n/a=not applicable

Tests

Most tests in Particle Flow function only as tests. At each integration step, they check each particle for the specified conditions, and then return the test result: True or False. So, as tests, they work on a continuous basis. For example, Age Test checks each particle's age at every integration step, because particles might not reach the specified age until remaining in the event for a while, and also because another action in the event might change or reset particle age.

The principal exceptions to this are the Split tests, which test each particle only when it first enters the event. That is, a Split test splits the particle stream only once for each particle that enters the event. Any particles that remain in the event are not subject again to being split off from the stream by the same test. Also, the Send Out test performs no test, but simply moves particles along to the next event.

Some tests also function as operators, in that they directly affect particle behavior. These are the ones listed here, and the specified time frame is related to the operator functionality, not the test.

Test | Time Frame
---|---
Continuous | Collision Spawn
Continuous | Find Target
Continuous | Go To Rotation
Depends on script | Script Test
<table>
<thead>
<tr>
<th>Test</th>
<th>Time Frame</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spawn</td>
<td>Continuous, except once with Once</td>
</tr>
</tbody>
</table>

**Operators**

The operator is the basic element of the particle system: you combine operators into events to specify the particles' characteristics over a given period of time. Operators let you describe particle speed and direction, shape, appearance, and more.

The operators reside in two groups in the Particle View depot, and within each group appear in alphabetical order. Each operator's icon has a blue background, except for the Birth operators, which have a green background. The first group contains operators that directly affect particle behavior, such as transformation.

The second group, found at the end of the depot listing, contains four operators that serve more of a utility function: Cache, for optimizing particle-system playback; Display, for determining how particles appear in the viewports; Notes, for adding comments; and Render, for specifying render-time characteristics.

The primary operators in Particle Flow are:

- **Birth Operator** on page 3052
- **Birth Paint Operator** on page 3222
- **Birth Script Operator** on page 3056
Birth Texture Operator on page 3057
Delete Operator on page 3067
Force Operator on page 3189
Group operator on page 3076
Group Selection Operator on page 3078
Initial State operator on page 3069
Keep Apart Operator on page 3131
Mapping Object operator on page 3158
Mapping Operator on page 3175
Material Dynamic Operator on page 3168
Material Frequency Operator on page 3166
Material Static Operator on page 3163
Placement Paint operator on page 3224
Position Icon Operator on page 3086
Position Object Operator on page 3089
Preset Flow on page 3230
Rotation Operator on page 3097
Scale Operator on page 3102
Script Operator on page 3196
Shape Operator on page 3137
Shape Facing Operator on page 3139
Shape Instance Operator on page 3142
Shape Mark Operator on page 3149
Speed Operator on page 3108
Speed By Icon Operator on page 3112
Speed By Surface Operator on page 3122
Spin Operator on page 3099

The utility operators are:
Birth and Death

These operators control the creation of new particles and the elimination of particles that are no longer needed.

See also:
- Birth Paint Operator on page 3222

Birth Operator

Particle View on page 3015 > Click Birth in an event or add a Birth operator to the particle system and then select it.

The Birth operator enables creation of particles within the Particle Flow system using a set of simple parameters. In general, use Birth as the first operator in any event connected directly to a global event on page 8594; this is called the birth event on page 8521.

You can specify a total number of particles, or a rate of particles born per second. You can also tell the system when to begin emitting particles, and when to stop.
NOTE  The Birth operator must always come at the beginning of a particle stream; the system doesn't let you position it elsewhere. You can place a Birth operator in an isolated event, but you can't then wire that event in series with a stream that already uses a Birth operator. However, you can wire multiple Birth operators, each in its own event, into a particle stream with an existing Birth operator, in parallel. The following procedure illustrates this. If you need to create particles midstream, use the Spawn Test on page 3281 or Collision Spawn Test on page 3241 test.

See also:
■ Birth Script Operator on page 3056

Procedures

To use the Birth operator:

This procedure demonstrates the impossibility of using multiple Birth operators in series, and shows how to use multiple Birth operators in parallel.

1  Start or reset 3ds Max, and add a new PF Source object to the scene.
2  Press 6 to open Particle View.
   The default particle system contains a Birth operator as the first action in the birth event.
3  Try to drag the Birth operator elsewhere in Event 01.
   You can't. As you drag over the different actions in Event 01, a red line appears at the top of the event, showing that the Birth operator will be placed here, no matter where you release the mouse button.
4  Try to drag a new Birth operator from the depot to Event 01.
   As in the previous step, the only place you can drop the Birth operator is at the top of the event, replacing the existing Birth operator.
5  From the depot, drag the Birth operator to an empty area in the event display.
   Particle Flow creates a new birth event, Event 02, containing the Birth operator and a Display operator.
6  Wire the output of the global event, PF Source 01, to the event input of Event 02.
   Each birth event must be associated with a global event to be able to generate particles.
From the depot, add a Send Out test at the end of both Event 01 and Event 02.

Try to wire the test output of Event 02 to the event input of Event 01. Particle Flow doesn’t let you, because this would result in two Birth operators in series.

Try to wire the test output of Event 01 to the event input of Event 02. Again, Particle Flow doesn’t let you, because this would result in two Birth operators in series.

Drag a Speed operator to an empty area of the event display. Particle Flow creates a new event, Event 03.

Wire the test output of Event 01 to the event input of Event 03.

Wire the test output of Event 02 to the event input of Event 03. There’s no problem wiring the two birth events to a single, third event. The birth events exist in the particle stream in parallel, each generating particles independently and then feeding its particle stream into a common event, where the two streams are combined.

If the second birth event had its own global event, you could, at any point further downstream, separate the streams back out according to their origin using the Split Source test on page 3291. To do this, delete the wire from PF Source 01 to Event 02, add an Empty Flow on page 3232 to the system, and then wire it to Event 02.

### Interface

The user interface appears in the parameters panel, on the right side of the Particle View dialog.
**Emit Start** The frame number at which the operator begins emitting particles.

**Emit Stop** The frame number at which the operator stops emitting particles.

**NOTE** The Emit Start and Emit Stop values are tied to the system frame rate. If you change the frame rate, Particle Flow automatically adjusts the Emit values accordingly. For example, if you set Emit Start to 120 and Emit Stop to 300 using the default NTSC frame rate (30 fps), and then switch to PAL (25 fps) using the Time Configuration dialog, you've reduced the frame rate to 5/6 of the original value. Thus, Particle Flow automatically uses the same ratio to adjust the Emit settings, resulting in an Emit Start value of 100 and an Emit Stop value of 250. This allows the particle system to retain the timing you specify, no matter which frame rate you use.

**NOTE** With Subframe Sampling off, such adjustments are rounded off to the nearest integer frame number. With Subframe Sampling on, fractional frame values that result from such adjustments will be used, but not displayed.

**Amount** To specify the total number of particles emitted by the operator, choose Amount, and then set the quantity of particles. Using the Amount option, the first particle is always emitted at the Emit Start frame, and the last particle is always emitted at the Emit Stop frame. Particles emitted between these endpoints appear at equal intervals within the emission period. For example, if you set Amount to 3, the second particle is emitted halfway through the emission period.

To determine the number of particles emitted per frame when using Amount, divide the Amount value by the number of emission frames (Emit Stop-Emit Start+1).

**Rate** To specify the number of particles emitted per second, choose Rate, and then set the value. The operator emits this number of particles per second starting at the Emit Start frame and ending at the Emit Stop frame.

If you specify a birth rate value that isn’t an integer multiple of the system frames-per-second value (set in the Time Configuration dialog), Particle Flow uses interpolation to determine when to emit particles. For example, if you use the system default rate of 30 frames per second, and set the birth rate to 4, the system would emit each particle at intervals of seven or eight frames if Subframe Sampling is off, or at intervals of 7.5 frames if Subframe Sampling is on.

**Total** The calculated total number of particles emitted by the operator.
Subframe Sampling  Turning this on helps avoid particle "puffing" by emitting particles at a much higher subframe resolution (that is, throughout each frame), rather than using the relatively coarse frame resolution. Default=on. "Puffing" is the effect of emitting separate "puffs" or clusters of particles, rather than a continuous stream. This effect is especially noticeable when the emitter is animated.

Turn off Subframe Sampling to cause particles to be emitted exactly at frame times. This makes it easier to sort particles by their age later.

TIP  If, when using the Collision on page 3236 or Collision Spawn test on page 3241, you experience an irregular particle stream, try turning off Subframe Sampling.

Birth Script Operator

Particle View on page 3015  >  Click Birth Script in an event or add a Birth Script operator to the particle system and then select it.

The Birth Script operator enables creation of particles within the Particle Flow system using a MAXScript script. The script can use any program functionality available to MAXScript.

The default script (3dsmax\scripts\particleflow\example-scriptbirth.ms) emits particles for 100 frames in a wavy, circular path. To see this, turn off or delete any Speed and Position operators in the event.

See also:

- Birth Operator on page 3052

Interface

The user interface appears in the parameters panel, on the right side of the Particle View dialog.
**Edit Script** Click this button to open the current script in a MAXScript Editor window.

For detailed information about the MAXScript utility, open the MAXScript Help, available from Help menu > MAXScript Help.

**Emit Start** The frame number at which the operator begins emitting particles.

**Uniqueness group**

The Uniqueness setting provides a randomization seed that the script can use or ignore.

**Seed** Specifies a randomization value.

**New** Calculates a new seed using a randomization formula.

---

**Birth Texture Operator**

[Particle View](#) on page 3015 > Click Birth Texture in an event or add a Birth Texture operator to the particle system and then click it.

The Birth Texture operator uses an animated texture to calculate the timing, location, and scale of particles. In general, Birth Texture causes particles to emit from the object where the texture is white or a bright color.

The Birth Texture operator controls are available in two areas of 3ds Max. First, the **Birth Texture rollout** on page 3059, which appears in Particle View, regulates the overall timing of particles.

Second, adding a Birth Texture operator to a Particle Flow system creates a 3D icon, or helper, that you can select in viewports. The icon is placed at the world origin (0,0,0). When you select this icon, the **Parameters rollout** on page 3060 opens on the Modify panel. These controls let you specify the timing, placement, and scaling of particles. You can also access the Birth Texture operator’s parameters via the operator in Particle View, by clicking Initialization Parameters.
Birth Texture icon

Procedure

To use the Birth Texture operator:

1. Create an object, and apply a material to it that includes an animated map with variations of light and dark colors. For example, you could apply a Checker map as the Diffuse map with an animated Offset parameter.

2. Create a PF Source.

3. In Particle View, replace the Birth operator with a Birth Texture operator. This creates the Birth Texture icon at the world center: 0,0,0.

4. On the Birth Texture rollout in Particle View, set Emit Stop to 100 (or any other value you prefer) and turn off Lock To Emitters.

5. Click Initialization Parameters. This selects the Birth Texture icon and opens the Modify panel.

6. On the Modify panel, in the Timing group of controls, set Stop to the value you used in step 4.

7. In the Emitter Objects group, select the object with the material as the emitter.

8. At the top of the Parameters rollout, click Initialize Particle Emission. This process runs through the animation, and places particle seeds (white) on the object’s surface where white or light areas appear.
TIP If no particles appear, try turning down the Whiteness setting in the Emission By group. This lowers the threshold of texture brightness required to emit particles.

9 In Particle View, remove or disable the Position Icon operator and then play the animation.

The seeds turn into particles whenever the area under the seeds turns white; the particles then move away from the object.

Interface

Birth Texture rollout

This rollout appears in Particle View when the Birth Texture operator is selected.

 Emit Start The frame at which the operator begins emitting particles.

 Emit Stop The frame at which the operator stops emitting particles. The exact timing of start and stop may vary due to the timing of individual particles, which depends on the emitter’s animated texture.

 Reset To Original Timing Sets the Emit Start and Emit Stop values to the current values of Timing > Start and Stop on page 3063 as initialized (that is, when you last clicked Initialize Particle Emission on page 3061). If Emit Start and Emit Stop differ from the original timing, the particle timing is scaled to fit into the emission interval. This lets you change the overall timing of the emission without the long process of pre-calculation.

 Lock On Emitters Causes all particle pivot points to be “glued” to the emitter objects. This control is similar to the Lock On Emitter option of the Position
Icon operator. It tells the Birth Texture operator to continue controlling particle position even after the particles are born.

**Total Particles** This read-only value shows the total number of pre-calculated particles. The amount of particles actually generated depends on the Quantity Multiplier of the master PF Source object. If the multiplier value is less than 100%, the operator samples the pre-calculated particles. If the multiplier is greater than 100%, some particle seeds are able to generate multiple particles.

**Initialization Parameters** Selects the Birth Texture icon and switches to the Modify panel to show controls related to the particle timing and placement pre-calculation (see following).

**Parameters rollout**

This rollout is available on the Modify panel when you select the Birth Texture icon or click Initialization Parameters (see preceding).
The color of this icon indicates the calculation status of particle seeds. When blue-green, the operator has generated particle seeds according to the current set of parameters, and is up to date. When red, parameters have been changed since the last initialization, and you must update the particle seeds by clicking Initialize Particle Emission.

Initialize Particle Emission

Click to calculate particle seed timing, placement and scaling according to the current set of parameters. If the emitters geometry or textures are complex, the initialization process can be lengthy. The overall progress of calculation is indicated as a percentage in the status bar. When calculation is complete, the Green/Red concentric color box turns green.

This option is available only after you have picked at least one emitter in the Emitter Objects group.

Quantity group

The Birth Texture operator offers several methods for determining the quantity and placement of particle seeds. In general, each of these methods covers the emitter with the maximum number of particle seeds allowed for the chosen method, then the texture's coloring or brightness defines if and when a seed is converted to a particle.

NOTE These parameters control particle seeds, not the particles themselves. A particle seed is converted to a particle based on the parameters in other rollouts, and on the color and brightness of the texture itself.

Choose one option in this group:

- **Amount**  Randomly covers the emitter surface with the specified number of particle seeds. Then the animated texture is used to define if and when a seed generates a particle. This option can be used when you don’t want particles to be generated in the same place multiple times when the texture is animated.

- **Max. Rate**  Sets the maximum number of particles that can be generated per frame over the entire surface, when the texture color exceeds the Whiteness value. The rate is expressed in particles per frame. First, the emitter surface is randomly covered with seeds at the Max. Rate, starting with the Start frame. Then the texture for the current frame defines at that frame whether each seed generates a particle. The unused seeds are not used. At the next frame, a new set of particle seeds is generated. This option generates particle seeds in this manner from the Start frame to the Stop frame. This option can be used when it doesn’t matter whether particles are generated in the same place multiple times.
Separate  Sets the distance by which particle seeds are separated, in units. The emitters surface is evenly covered with particle seeds, and the seeds are placed in such a way that they are separated by the Separate value. Then the animated texture is used to define if and when a seed generates a particle. The Separate option guarantees the absence of dense clusters and overlapping particles. This option guarantees that particles will not be generated in the same place multiple times.

When you choose Separate, two additional options become available:

- **Adjust By Scale Factor**  When the Separate option is chosen and you've specified a Scale Factor option on page 3066 other than None, this option adjusts the separation distance according to particle scale. In other words, when Adjust By Scale Factor is on, Particle Flow can place smaller particles closer together, while increasing the distance between larger particles.

- **Fast Approx. Separation**

**Vertices/Edges**  Places particle seeds on surface vertices. The total amount of particle seeds is defined by the number of vertices.

**Subdivide**  Places particle seeds on visible edges as well as vertices. The seeds are distributed evenly along edges, spaced by a distance approximately equal to the Subdivide value. Then the animated texture is used to define if and when a seed generates a particle. The total amount of particle seeds is defined by the number of vertices, and the lengths of visible edges.

**Faces**  Places particle seeds at face centers. If the Subdivide option is on then each face is subdivided to a point when every faces edge is less than the Subdivide value, and a particle seed is placed at the center of the sub-faces. Then the animated texture is used to define if a seed generates a particle, and when. The total amount of particle seeds is defined by the number of faces and their size (if Subdivide is on). The Faces option with Subdivide on generates the most evenly distributed particles over the emitter surface, with some regular properties. If the Subdivide value is less than a particle size then the particles are able to cover the entire emitter surface without any holes.

**Subdivide**  The option is available for the Vertices/Edges and Faces amount types only. When On, edges and faces are subdivided to generate the greater amount of particles.
**Amount Limit** This control is available if you choose Vertices/Edges or Faces and also turn on Subdivide. Small values of Subdivide can generate so many particle seeds that they exceed available memory: this value limits the number of seeds, so 3ds Max doesn’t hang. Range = 10 to 50000000 (fifty million). Default=1000000 (one million).

**Total Amount** This read-only value shows the total number of particles pre-calculated for the emission. Because the animated texture might not reach required whiteness level over the emitter surface, this value is usually smaller then Amount or Max. Rate*(Stop-Start) values.

**Timing group**

These parameters determine the time interval over which particles are generated. The operator analyzes the emitter texture over the time interval, using the data to define the precise birth moment for each particle. The timing for each particle is stored as a floating-point value ranging from 0.0 to 1.0. This indicates its timing relative to the start (0.0) or end (1.0) of the interval and makes it possible to adjust the overall timing of the particle emission without recalculation.

You can also adjust particle timing in Particle View by changing the Emit Start and Emit Stop values.

**Start** The first frame of the interval over which particles are generated.

**Stop** The last frame of the interval over which particles are generated.

**Delay Var** Variation in particle emission, in frames.

**Latency** Causes particle seeds to accumulate brightness over time, and to be converted to particles only if they accumulate a certain brightness value. The Latency value is multiplied by the Whiteness % on page 3065 value to determine the whiteness that needs to be achieved. Then particle seeds accumulate Luminance values for the texture at each frame, and are converted to particles when they achieve the multiplied whiteness value. Latency can be used to cause a sweep of particles to be generated over a gradient map without having to animate the map.

For example, if Latency is off, Whiteness is 100%, and the texture where a particle seed resides is white [256,256,256], a particle will be generated. But if Latency is on and set to 3, the multiplied whiteness required to convert to a particle is 300%, which the particle seed accumulates after 3 frames.
Following are more examples of how adjusting Latency affects how particles are generated:

- Texture color=[128,128,128] (50% brightness); Whiteness=100%; Latency=7:
  The particle seed requires 700% brightness to emit a particle, which would be achieved after 14 frames.

- Texture color=[32,32,32] (12.5% brightness); Whiteness=50%; Latency=2:
  The particle seed requires 100% brightness to emit a particle, which would be achieved after eight frames.

**Precision**
The level of accuracy for particle timing calculation. If the texture has more than a single image per frame, to include the sub-frame images choose a sub-frame sampling method. The available choices are Frame, Half Frame, 1/4 Frame, 1/8 Frame.

**Emission By group**

Particle seeds are converted to particles when the particle seeds are located on an area of the texture that exceeds the Whiteness value. The parameters in this group define how Particle Flow interprets the texture information to see if it exceeds the Whiteness value.

The Emission By choices are as follows:

- **Material**
  Gathers colors from the emitter’s material.

- **Sub-Material**
  Gathers colors from a single sub-material, and generates particles only on faces with the specified sub-material ID (Material ID). The sub-material ID is set by the Sub-Mtl ID parameter (see following).

- **Sub-Mtl Global**
  Gathers colors from a single sub-material, and generates particles over the entire emitter surface regardless of the faces’ Material IDs. The sub-material ID is set by the Sub-Mtl ID parameter (see following).

- **Vertex Color**
  Gathers colors from the Vertex Color channel.

- **Vertex Alpha**
  Gathers colors from the Vertex Alpha channel.

- **Vertex Illum**
  Gathers colors from the Vertex Illum channel.

- **Mapping**
  Gathers colors from a mapping channel. A mapping channel can be used by the Vertex Paint modifier to color vertices. The mapping channel index is defined by the Channel parameter.
TIP  For information about these channels, see the VertexPaint Modifier topic in the 3ds Max Help.

R/G/B  These buttons let you define the set of color channels to be considered for particle generation. For example, if only the R (red) button is active, then only the red color data is used to determine whether particles are generated. If more than one button is active, the average of the chosen channels is used.

Sub-Mtl ID  Specifies the sub-material ID when Emission By (see preceding) is set to Sub-Material or Sub-Material Global. Typically the sub-material is a component of a Multi/Sub-Object material, and you can find the IDs on the material’s Basic Parameters rollout.

Whiteness %  Sets the color trigger level. If a color at a particle seed location exceeds this threshold, then a particle is generated. A 0% Whiteness corresponds to RGB value (0,0,0), while a 100% Whiteness corresponds to the RGB value (255,255,255).

Emitter Objects group

Use these controls to assign objects to be used as particle emitters.

Add  Adds an object to the list.

By List  Opens the Select Emitter Geometry dialog where you can add multiple objects to the list.

Remove  Removes a highlighted object from the list.

Animated Emitters  Indicates that the emitter objects are animated, either with transforms or surface animation. This option affects the display of particle seeds, but doesn’t affect particle generation, because all particles are generated on the surface regardless of whether it is animated. Toggling this option does not affect calculation status.

Surface Normal Offset  When on, lets you specify an offset range from the emitter surface for particle placement. Negative values place particle seeds below the surface.

Offset Min/Max  When Surface Normal Offset is on, you can specify the range of offset distance from the object surface. The Min value cannot exceed the Max value, and the Max value cannot go below the Min value.

Scale Factor group

The operator can initialize particle scaling according to the characteristics of the texture the particles are generated from. So, for example, you can vary the
sizes of particles emitted from different parts of the surface with a gradient map. The scale value calculation uses the texture's state at the current frame, disregarding any animation the texture has. Since a color has three floating-point values, each value defines a different component of the scale vector. To have a uniform scale factor, use textures with no hue (black/gray/white gradients).

**Scale By** Defines the source of color to calculate particle scaling. The available choices are:

- **None** No particle scaling is set.
- **Sub-Material** Uses a single sub-material to set the scale, and uses this scale over the entire emitter surface regardless of the faces' Material IDs. The sub-material ID is set by the Sub-Mtl ID parameter.
- **Vertex Color** Uses the Vertex Color channel to define particle scale.
- **Vertex Alpha** Uses the Vertex Alpha channel to define particle scale.
- **Vertex Illum** Uses the Vertex Illum channel to define particle scale.
- **Mapping** Defines particle scale with a mapping channel that is used for vertex coloring by the Vertex Paint modifier. The mapping channel index is defined by the Channel parameter.

**TIP** For information about these channels, see the VertexPaint Modifier topic in the 3ds Max Help.

**Sub-Mtl ID** When Scale By (see preceding) is set to Sub-Material, specifies the sub-material ID. Typically the sub-material is a component of a Multi/Sub-Object material, and you can find the IDs on the material’s Basic Parameters rollout.

**Black Scale %** Defines the scale value for particles that fall on pure black areas of the texture. This value should be used to set the scale percentage for the smallest particles in the range. The Black Scale % must be lower than or equal to the White Scale %.

**White Scale %** Defines the scale value for particles that fall on pure white areas of the texture. For intermediate gray colors, the scale value is linearly interpolated between the Black Scale % and White Scale %.

The Black Scale % and White Scale % can influence the particle distribution if the Separate option in the Quantity group is chosen, and Adjust By Scale Factor is on.
Display group

The operator is able to show the particles in interactive, non-history-dependent mode. Usually, if you want to see particle animation, you have to place the operator into an event that is wired to an active PF Source event. However, this might require heavy calculation for history-dependent particle animation. The parameters in the Display group give you the ability to see how particles will be created without the overhead of generating a particle system.

Show Particles Displays calculated particle seeds as ticks.

All / By Timing Defines the mode for showing particles:
- All All pre-calculated particles are shown.
- By Timing Each particle is displayed at the frame at which it will be born. The timing shown with the By Timing method might differ from the actual particle emission because the Emit Start and Emit Stop values in the Birth Texture operator can adjust the overall particle timing.

Only When Selected When on, particle seeds appear in the viewports only when the Birth Texture icon is selected. When off, particle seeds always appear.

Icon Size Sets the size of the 3D icon of the operator. The size of the icon has no effect on particle size or emission.

Color Coordinated When on, the color of the 3D icon is synchronized with the color set by the Display operator in the same event as the corresponding Birth Texture operator. When off, the icon uses the standard Particle Flow operator color: blue.

Uniqueness group

The Uniqueness settings enable you to change the randomization of the particle generation where appropriate.

Seed Specifies a randomization value.

New Calculates a new seed using a randomization formula.

Delete Operator

Particle View on page 3015 > Click Delete in an event or add a Delete operator to the particle system and then select it.
Use the Delete operator to remove particles from the particle system. By default, particles live “forever,” that is, for the duration of the animation. The Delete operator lets you give them a finite life span. This is useful for eliminating particles once they’ve served their purpose in the animation.

The Delete operator is also necessary when using the Particle Age map, which, when incorporated into the Material Dynamic operator, applies different materials to particles depending on their age. Because the map works on the basis of a percentage of the particle’s life span, you need to use a Delete operator to define the particles' maximum age. For an example of usage, see Material Dynamic operator on page 3168.

**Interface**

![Delete Operator Interface](image)

The user interface appears in the Parameters panel, on the right side of the Particle View dialog.

**Remove group**

Choose whether to delete all particles, selected particles, or particles past a specific age.

The Uniqueness setting enables randomization of maximum particle age using the By Particle Age > Variation setting.

**All Particles** Deletes all particles in the event immediately.

**Selected Particles Only** Deletes particles selected at the Particle sub-object level in the event immediately. See Selection rollout on page 3039.
By Particle Age Deletes particles in the event after they've existed for a specific length of time, with an optional random variation. Choosing this makes the Life Span and Variation settings available.

**Life Span** The number of frames of life allowed to the particles. After this period, they're deleted. Default=60.

**Variation** The maximum amount by which Life Span may vary. To get each particle's actual life span, this value is multiplied by a random number between -1.0 and 1.0, and then added to Life Span. Default=10.

**Uniqueness group**

The Uniqueness setting enables randomization of maximum particle age using the By Particle Age > Variation setting.

**Seed** Specifies a randomization value.

**New** Calculates a new seed using a randomization formula.

---

**Initial State Operator**

Particle View on page 3015 > Click Initial State in an event or add an Initial State operator to the particle system and then click it.

The Initial State operator is a birth operator that uses a snapshot of another particle system or other events as a starting point for a new event. The particle system or events from which the Initial State operator gets its snapshot must be different from those of the Initial State operator itself.

The Initial State operator can make use of an icon in the scene, whose default size is 0.0. The icon is visible only if the Icon Size parameter is greater than 0.

You can also use the Initial State helper object (in the Particle Flow category) to create an Initial State icon and a corresponding Initial State event at the same time.

---

**NOTE** To avoid looping dependencies, create the Initial State operator *after* you create the particle system or events from which it obtains its initial state.


**Initial State Usage**

The Initial State operator is particularly useful when a large number of particles are generated before frame 0, and you want to use the state of particles at frame 0.

In the following example, the left side of the image shows the original wiring without the Initial State operator. Because 1,000,000 particles are born starting at frame -750, a great deal of calculation is required to calculate the particles at frame 0.

In a particle system like this, you can save time by using the Initial State operator. In this case, you could set the Viewport Quantity Multiplier in the original system to 100%, and then let the system calculate the particles at frame 0, which could take 15 minutes or more. Then you would use the Calculate Initial State function in the Initial State operator to acquire the starting state of particles at frame 0. The first time you perform this operation, it will take as long as particle calculation without the Initial State operator. The advantage is that the initial particle state at frame 0 does not have to be calculated again unless you change parameters that affect the initial state.

The original system generates particles from frame -750 to 144, but the Initial State operator captures the state at frame 0. Therefore, you would need an additional Birth operator to generate particles from frames 0 to 144. To determine how many particles to generate from frames 0 to 144, look at the Initial State operator to get the number of particles generated, and subtract
this number from the original total; the result is the number of particles should be generated with the new Birth operator. In the example shown above, the amount is $1,000,000 - 834,000 = 166,000$.

If the original particle system has Position and Speed operators, be sure to instance them in the new event with the Birth operator. There is no need to instance these operators in the event that contains the Initial State operator, as this information is already included in the referenced event. All other operators can go into a common event where the Birth and Initial State events merge.

**Procedure**

**To use Initial State:**

1. Create a particle system.
2. Go to the frame where the particle system is in the desired initial state.
3. Drag the Initial State operator to a blank area of Particle View to create a new, separate event. Alternatively, you can use the Initial State helper to create an Initial State icon and a new event at the same time.
4. Decide if you want the whole particle system, or distinctive events for the initial state, and choose the appropriate option in the Initial State From group.
5. Select the particle system or events.
6. Click Calculate Initial State. The Initial State UI makes a snapshot at the current frame, and also reports the number of the particles in the initial state and the amount of memory used.
7. At this point, you can disable the original particle system if you like.
8. Drag an Empty Flow to a blank area of Particle View to create a new global event.
9. Wire the new global event to the event that includes the Initial State operator.
Interface
**Calculate Initial State** Creates a snapshot of a particle system or selected events at the current frame. The snapshot uses only particles visible in the viewport, and is reflected by the Amount and the Memory Used statistics. This button becomes available after you specify a particle system or events.

Initial State uses the Viewport % and Render % in the PF Source's Quantity Multiplier group. If Viewport % is set to 100, all particles in the snapshot are used. If Viewport % is less than 100, then only some particles of the original initial state are used. If Viewport % is greater than 100, the operator spawns particles from the original state to meet the percentage. The Initial State operator moves the particles apart in order to separate the spawns visually, and can modify the speed of the spawns.

**Emit Time** All particles in the initial state are generated at the Emit Time.

**Auto Sync Emit Time** Sets the Emit Time value to the current frame automatically when you click Calculate Initial State button. This action synchronizes the referenced particle system's timing with the operator.

**Amount** Read-only field shows the number of particles in the initial state, which is the number of visible particles in the original particle system during the snapshot. Keep in mind that the operator grabs the viewport state of a particle system. What you have in the viewport at the snapshot frame is what you get for the initial state.

**Memory Used** Read-only field shows the amount of system memory used to keep the initial-state data when the scene is saved into a file, in kilobytes.

**Initial State From** Choose a source option for the initial state and then make settings as appropriate.

- **Particle System** Lets you derive the initial state from an entire particle system. Click the button to choose the particle system. You cannot use the particle system that contains the Initial State operator.

- **Selected Events** Lets you choose any number of events to use for the initial state. To add events to the list, click Add. You cannot add the event the Initial State operator is in. To remove an event from the list, highlight the event and click Remove.

**Initial State Data group**

The options in this group serve two purposes:

- Before you click Calculate Initial State, the settings define the types of data to get from the particle system or events for the initial state.
After you click Calculate Initial State, the settings define the data to be used during particle generation.

When you click Calculate Initial State, the operator reads the status of the check boxes in this group and acquires the indicated data from the particle system or events. If a check box is on and the data corresponding to that checkbox is available from the particle system or events, the checkbox text is black. Otherwise, it is gray. You can toggle a check box whether its text is black or gray.

If the data is available (the checkbox text is black) and you turn off the check box, the data is not used when particles are generated.

**Age** When off, all particles are born with age 0. When on, each particle retains its age as of the moment of the snapshot.

**Speed/Scale/Rotation/Spin/Shape** When on, these options derive the corresponding type of data from the snapshot.

**Mapping** Takes data from a Mapping operator. To make this option work properly, turn on Show Map in Viewport for the original Mapping operator.

**Material ID** Takes the sub-material index assignment, To make this option work properly, turn on Assign Material ID and Show in Viewport for all Material operators.

**Script Data** Takes the Script Float, Integer, Vector and Matrix data created by Script operators. This data can be used later by Script operators as well as by the Script Vector option of the Find Target test > Point setting.

**Selection** Takes particle selection data. Any selections in the Initial State operator's particle system is overwritten by the snapshot selection.

**For Quantity Multiplier > 100% group**

The options in this group have an effect on particles only if the Viewport % (or Render %) in the PF Source's Quantity Multiplier group is greater than 100%. To meet the requirement of the Quantity Multiplier, the operator has to spawn the acquired particles.

**Position Variation Max. Spread** The maximum offset of spawned particles’ placement from the original location.

**Speed Variation Magnitude** % Variation in the speed magnitude for spawned particles. The variation is defined as the maximum percentage change from the original speed. For example, if the original speed is 100 units per second
and Magnitude is 20%, then the spawned particle may have any speed from 80 to 120.

**Speed Variation Divergence** Directional variation of the speed for the spawned particles, in degrees, with a range from 0 to 180.

**Lock To Icon TM group**

The options in this group are used to link initial particle placement and speed to the operators 3D icon.

- **Position** When on, you can modify the particles’ initial placement by moving, rotating, and scaling the operator icon.
- **Speed** Causes the particles’ initial speed after the snapshot to be affected by transform animation of the operators icon.
- **Icon Size** Sets the icon size. If you create the operator in Particle View, the default size is 0, and the icon is not visible in viewport. If you create the operator as a Particle Flow helper object, then the size is set when you drag in a viewport during the icon-creation process.
- **Color Coordinated** When this option is turned on, the color of the 3D icon is synchronized with the color of the Display operator in the same event. When this option is off, the icon has a standard Particle Flow operators color (blue).

**Uniqueness Group of Controls**

The Uniqueness setting enables changing the randomization of the position and speed variation when Quantity Multiplier is greater than 100% (see the For Quantity Multiplier > 100% group).

- **Seed** Specifies a randomization value.
- **New** Calculates a new seed using a randomization formula.

**Groups**

The group actions in Particle Flow let you identify and act on subsets of particles, specified either explicitly or procedurally according to any of a number of different conditions. You can create as many groups as you like, and apply any event’s actions to any group.
**Group Operator**

**Particle View** on page 3015 > Click Group Operator in an event or add a Group Operator operator to the particle system and then click it.

The Group Operator applies an entire event to the particles specified by one or more Group Selection operators on page 3078. The Group Operator is useful when you want to apply an event to a subset of particles, but you don't want to split the particles from the current event. It affects the selected particles only while they remain in the current event.

This operator is useful when you want to apply a complex event to a subset of particles. It is also useful when you want to apply the same series of operators to different subsets of particles in different events.

The Group Operator does not wire the external event to the current event, but rather, it refers the current event to the external event.

---

Group operator is not wired to the event that it calls.
In the Particle Flow network shown above, all particles in Event 01 that pass the Age test are directed to Event 02, but only those that were selected by the Group Selection operator in Event 02 will use the operators in the Rotation event. Then all particles that flowed to Event 02 (including both the particles selected with the Group Selection operator, and those not selected) are directed to Event 03 via the Spawn test.

**Interface**

**Group Selection Operators** Lists one or more Group Selection operators that specify the particle selection(s) to which the event should be applied.

To add one or more groups, click the Add button and use the Select Group Selection Operator dialog to specify the groups to add. To remove a group from the list, highlight its name and then click Remove.

**Selection Condition** When the Group Selection Operators list (see preceding) contains multiple entries, use this option to specify how to qualify particles in overlapping groups:

- **Selected In All Groups** A particle qualifies only if it belongs to all listed groups.
- **Selected In Any Group** A particle qualifies if it belongs to any listed group.
- **Selected In Single Group** A particle qualifies only if it belongs to only one of the listed groups.
**Modify Particles By Event**  Specifies the event with operators/tests to be used on the selected particles. Click the button and then choose the event from the selection dialog.

If the referred-to event has tests, the particles are not redirected to another event. All other operators in the event are performed on the specified particles.

---

**Group Selection Operator**

[Particle View on page 3015 > Click Group Selection in an event or add a Group Selection operator to the particle system and then click it.]

The Group Selection operator extends Particle Flow's ability to select particles. Originally in Particle Flow, you select a single group of particles explicitly that remains selected throughout the entire flow. With Group Selection, however, you can specify any number of groups according to various criteria: location, particle properties, at random, and more.

You can divert selected particle groups to another event with the Split Group test on page 3084, or indicate an outside event to affect particles with the Group Operator on page 3076. The Group Selection icon can be scaled and transformed to change the particle selection dynamically over the course of the particle flow.

You can instance the Group Selection operator in different events to define the same selection subset. If the particles converge into another event, the selection subsets are united, and a Group Operator works with the combined selection subset.

The Group Selection operator doesn't change particle properties. It adds a data channel that indicates the selection status of a particle corresponding to the selection operator. To modify particles based on their selection status, use a Group Operator or Split Group test.

**Group Selection icon**

Adding a Group Selection operator to a Particle Flow system creates a 3D icon, or helper, that you can select in viewports. The icon is placed at the world origin (0,0,0). When you select this icon, the Parameters rollout opens on the Modify panel that provides the controls described in the following section. The position of the icon is used by Particle Flow when you choose the Inside Icon Volume on page 3081 option.
Group Selection icon
Interface
Selection Update Choose how to calculate the selection status:

- **Once** The operator determines the selection status only once, at the time a particle enters the event.

- **Continuous** Calculates the selection status anew at every frame.

Depending on other options, the Group Selection operator may detect the selection status change in between frames, on sub-frame sampling basis.

Reverse Selection Inverts the particle selection.

Selection Condition Determines the method the operator uses to select particles. The choices are as follows:

- **Entire Particle Stream** Selects all particles in the event. Use this option if particle selections are merging in the current event, and in a later event you plan to separate particles with an instanced Group Selection operator.

- **By Snapshot** Selects particles based on those currently selected in the PF Source sub-object level, or all particles present in the event at the current frame. The number of selected particles appears next to By Snapshot. To select the particles, choose one of the following sources from the dropdown menu and then click Generate Snapshot:

  - **Selected in PF Source** Selects the particles currently selected at the Particle sub-object level of the PF Source. Before using this option, make sure both of the PF Source object’s Quantity Multiplier settings (Viewport % and Render %) are the same.

  - **All in Current Event** Selects all particles in the event at the current frame.

- **Generate Snapshot** Click to select the particles as specified by the choice in the drop-down list. The number of selected particles appears next to By Snapshot.

  Once you have generated a snapshot, you can change the frame or sub-object particle selection without affecting the selection in this Group Selection operator. Keep in mind that the selection is based on the particle IDs. Therefore, if the number of particles in the viewport and the rendering are different, the overall effect can differ drastically. To use this type of selection effectively, synchronize the percentage of particles in the viewport and renderer.

- **Inside Icon Volume** Displays the Group Selection icon in the viewports, and selects all particles within the icon. If Selection Update (see preceding) is set to Once, only particles that are inside the icon at the start of the
event are selected. If Selection Update is set to Continuous, particles are members of the group only when present inside the icon volume; thus, the selection can change throughout the animation.

- **Icon Type**  Sets the overall shape of the icon: Box, Cylinder, or Sphere. The initial size of the icon is set by the Icon Size parameter, near the bottom of the rollout. To change the icon size and shape, change this parameter or use either uniform and non-uniform scaling. You can also move, rotate, and animate the icon to change the selection area.

- **Subframe Sampling**  When off, the motion of the icon or the reference object is considered to be linear between frames. If the icon or the object has fast, complex motion, turn on this option for greater precision in the calculation of the icon/object location.

  **NOTE**  This setting also applies to the Inside Object option (see following).

- **Inside Object**  Lets you designate an arbitrary object as the volume for selecting particles for the group. After choosing this option, click the “None” button and then select a reference object to use as a selection bounding area. All particles inside the reference object are selected. If the object doesn’t define a closed space, the resulting selection might not be consistent.

  **NOTE**  The Subframe Sampling option (see preceding) applies to Inside Object as well as Inside Icon Volume.

- **Animated Shape**  If the reference object is animated in a way that changes its shape or volume, turn on this option.

- **Select By Particle Property**  Uses particle properties to define the selection set. This choice appears in parentheses in the event, after the operator name. From the Property list, choose one of the following:
  - **Age**  Uses particle age to define the subset. All particles with ages in the From/To range become selected. Use the Variation parameter to vary the selection status.
  - **Birth ID**  Uses a unique particle ID is used to define the subset. All particles with IDs in the From/To range become selected. Use the Variation parameter to vary the selection status.
NOTE. The Birth ID property is not scalable in reference to the Quantity Multiplier parameters of the PF Source object.

- **Direction** Uses the particle speed vector and the icon direction vector to determine the selection subset. Particles are selected if their speed vectors are close in direction to the icon vector. When this option is selected, the icon shows an arrow with a surrounding cone to show the effects of the Divergence parameter. All particles with a speed vector within the cone become selected. The Divergence and Variation parameters are expressed in degrees.

- **Scale** Uses particle scale value to define the selection subset. Since the scale value is a vector, and From and To values are scalar, the maximum value of the scale components is used to define the range inclusion.

- **Script Float** Uses a particle float data channel to define the selection subset. The Float data channel is usually controlled by a Script operator.

- **Size** Uses particle size to define the selection subset. Particle size is controlled by Shape and Scale operator parameters. As with the Scale option, the operator uses the maximum value of the size vectors components to define the range inclusion.

- **Speed** Uses particle speed to define the selection subset. The From, To, and Variation parameters are defined in units per second.

- **Uniform Index** A scalable particle ID parameter. If the Quantity Multiplier is set to 100%, then the Uniform Index is the same as the Birth ID index. If the Uniform Index parameter is used, then the area with selected particles is consistent regardless of the Quantity Multiplier parameters.

- **Randomly Selected** Selects particles at random. The Chance % parameter defines how many particles will be selected. 100% means that all particles are selected; 50% means that roughly half of the particles are selected.

- **Combine Groups** Selects particles using a combination of the selection subsets defined by other Group Selection operators. Buttons A and B define the other Group Selection operators. The available combinations are:
  - **A and B** A particle is selected if it is selected by both operators A and B.
- **A or B** A particle is selected if it is selected by operator A or operator B.

- **A or B not both** A particle is selected if it is selected by operator A but not by operator B, or vice-versa.

- **A and not B** A particle is selected if it is selected by operator A but not by operator B.

**Icon Size** Sets the size of the 3D icon. Available only for the selection conditions Inside Icon Volume and Select By Particle Property: Direction.

**Logo Size** Sets the logo size, which has no effect on particles.

**Color Coordinated** When on, the color of the 3D icon is synchronized with the Display operator in the current event. When off, the icon has a standard Particle Flow operator color (blue).

**Uniqueness Group**

These controls set randomization for the Randomly Selected and Select By Particle Property selection conditions.

- **Seed** Specifies a randomization value.

- **New** Calculates a new seed using a randomization formula.

### Split Group Test

**Particle View** on page 3015 > Click Split Group in an event or add a Split Group test to the particle system and then click it.

The Split Group test splits the particle stream based on the particles’ selection status, as defined by a **Group Selection operator** on page 3078.
Interface

**Group Selection Operators**  Lists the Group Selection operators holding the particle selection to split. If a single Group Selection operator exists in the event, that operator will be added to the list automatically.

**Use Proxy Particles**  When on, you can split the particles based on their selection status in a particle system other than the one that contains the Split Group test.

**Proxy Particle System**  To specify a proxy particle system, click this button and then select the proxy’s icon. If the current event contains particles that meet the “Test True if Particle” condition (see following) as specified by a Group Selection operator on page 3078 in the proxy system, Particle Flow will send those particles to the next event.

**Proxy Index --> Particle Index**

- **Multiplier**  Applies a multiplier for index values of particles in the proxy system. So, for example, if Multiplier is set to 2.0 and the particles that test
true in the proxy system have index values 4, 5, and 8, then the particles that actually get split off will be those with index values 8, 10, and 16.

- **Index Offset**  Adds the specified value to index values of particles in the proxy system. So, for example, if Index Offset is set to 5 and the particles that test true in the proxy system have index values 4, 5, and 8, then the particles that actually get split off will be those with index values 9, 10, and 13.

**Test True if Particle** Lets you specify how to determine whether particles should pass the test and move on to the next event. The choices are:

- **Selected In All Groups**  Only particles that belong to all listed groups can pass the test.
- **Selected In Any Group**  Particles that belong to any listed group can pass the test.
- **Selected In Single Group**  Only particles that belong to only one listed group can pass the test.
- **Not Selected In Any Group**  Only particles that belong to none of the listed groups can pass the test.

### Transforms

Transform operators control particle position, rotation, scale, and angular velocity.

**See also:**

- **Lock/Bond Test** on page 3264
- **Placement Paint Operator** on page 3224

### Position Icon Operator

**Particle View** on page 3015 > Click Position in an event or add a Position operator to the particle system and then select it.

By default, particles are born, or *emitted*, from the Particle Flow icon. This topic uses the term *emitter* to refer to this icon. Use the Position Icon operator to control the initial placement of particles on the emitter. You can set the
emitter to emit particles from its surface, volume, edges, vertices, or center. And, if you animate the emitter, you can cause its motion to be imparted to the particles it emits.

Alternatively, you can use Position Object on page 3089 to emit particles from any other object.

**Interface**

The user interface appears in the parameters panel, on the right side of the Particle View dialog.

**Lock On Emitter** When on, causes all particles to remain at their initial positions on the emitter. In effect, they’re “glued” to the emitter. When off, each particle's birth position is determined by the emitter's current location. Default=off.

**Inherit Emitter Movement** When on, Particle Flow sets each particle's rate and direction of motion to that of the emitter at the time of birth. When off, the emitter movement doesn’t affect that of the particles. Available only when Lock On Emitter is off. Default=off.

**NOTE** If a Speed operator exists later in the event, it overrides any motion imparted by Inherit Emitter Movement.
Multiplier Determines, as a percentage, the extent to which particles inherit the emitter's motion. Available only when Inherit Emitter Movement is on. Default=100.

To have the particles move half as fast as the emitter, set Multiplier to 50. To have them move the same speed, use the default setting of 100. To make the particles move twice as fast as the emitter, set Multiplier to 200.

Location group

The Location drop-down list lets you specify where on the emitter the particles appear. You can create a variety of emission behaviors by varying the icon type on page 3037, Location setting, and direction of emission. Default=Volume.

- **Pivot** Emits particles from the center of the icon.
- **Vertices** For the Box and Rectangle icon types, emits particles from the corners of the icon. For the Sphere icon type, emits particles from the six intersections of the three circles that define the sphere. For the Circle icon type, emits particles from the center.
- **Edges** Emits particles from random points along the edges of the icon.
- **Surface** Emits particles from random points on the surface of the icon.
- **Volume** Emits particles from random points within the volume of the icon.

Distinct Points Only Limits emission to a specific number of points (see Total, below) on the specified Location type.

Emission points are still randomized; change the Uniqueness setting to alter these.

**Total** Sets the number of emission points. Available only when Distinct Points Only is on. Default=10.

Subframe Sampling When on, the operator acquires animation of the emitter icon on a tick basis (every 1/4800th of a second) rather than a frame basis. This provides greater precision in allowing the particle positions to follow animation of the emitter icon. Default=off.

Uniqueness group

The Uniqueness setting lets you alter the randomization of emission points.
Seed Specifies a randomization value.

New Calculates a new seed using a randomization formula.

**Position Object Operator**

*Particle View* on page 3015 > Click Position Object in an event or add a Position Object operator to the particle system and then select it.

By default, particles are born, or *emitted*, from the Particle Flow icon. The Position Object operator lets you emit particles from any other object or objects in the scene instead. This topic uses the term *emitter* to refer to an object or objects used to emit particles with this operator. For example, use it to create a meteor’s fiery trail.

Use the Position Object settings to control the initial placement of particles on the emitter. You can set the emitter to emit particles from its surface, volume, edges, vertices, or pivot, or from a sub-object selection. You can also control particle emission with a material applied to the object.

Alternatively, you can use the Position Icon operator on page 3086 to emit particles from the Particle Flow icon.

**NOTE** Typically, you would use Position Object in a birth event, so the particles appear initially at the emitter object(s). If you use it in a non-birth event, the particles jump to the designated emitter(s) upon entering the event. This could be useful for a teleportation effect.

**TIP** The default speed operator, Speed on page 3108, typically uses the Particle Flow icon to control the direction of the particle flow, so if the emitter object(s) and the icon aren’t coincident and aligned, you might get unexpected results. For better control over the direction of particle movement when using Position Object, use the Speed By Surface operator on page 3122 instead and designate as Surface Geometry the same object(s) as with Position Object.

**Procedures**

To use Position Object:

1. Create a Particle Flow system and one or more mesh objects to use as emitters. Animate the emitter objects and set particle system parameters as necessary.
2 In Particle View, add a Position Object operator to the birth event, replacing the Position Icon operator if one exists. Click the operator to display its parameters.

3 In the Emitter Objects group, click Add, and then select an object to serve as the emitter. Alternatively, click By List and then use the Select Emitter Objects dialog to designate one or more objects as emitters.

4 Use the Location drop-down list to choose where the particles should appear on the emitter: surface, vertices, and so forth.

5 Set other options as necessary. For example, if you want the particles to use the same motion as the emitter at the time of emission, turn on Inherit Emitter Movement. Or if you’re using an emitter object whose shape is animated, turn on Animated Shape.
The user interface appears in the parameters panel, on the right side of the Particle View dialog.

**Lock On Emitter** When on, causes all particles to remain at their initial positions on the emitter. In effect, they’re “glued” to the emitter. When off, each particle’s birth position is determined by the emitter’s current location. Default=off.

**Inherit Emitter Movement** When on, Particle Flow sets each particle's speed and direction of motion to those of the emitter at the time of birth. When off, the emitter movement doesn't affect that of the particles. Available only when Lock On Emitter is off. Default=off.

**NOTE** If a Speed operator exists later in the event, it overrides any motion imparted by Inherit Emitter Movement.

**Multiplier** Determines, as a percentage, the extent to which particles inherit the emitter's motion. Available only when Inherit Emitter Movement is on. Default=100.

To have the particles move half as fast as the emitter, set Multiplier to 50. To have them move the same speed, use the default setting of 100. To make the particles move twice as fast as the emitter, set Multiplier to 200.

**Variation** Determines, as a percentage, the extent to which inherited emitter motion can vary per particle. To determine the final multiplier for each particle, the Variation value is multiplied by a random number between -1.0 and 1.0, and then added to the Multiplier value. Default=0.

**Emitter Objects group**

Use these controls to assign objects to be used as particle emitters. The list in this group shows the objects, or reference geometry, that the operator uses as emitters.

If you don’t assign any objects, Particle Flow uses the world origin (0,0,0) as the emitter source.

With more than one emitter object, the division of particles among the objects depends on which option you choose for Location. If you set Location to Pivot, then each object has one emission point and each object emits the same number of particles (total number of particles/number of objects). But if you set Location to any other option, each object emits a number of particles proportionate to the number of available emission points per object. For instance, if you set Location to Volume, then a larger object will emit more particles than a smaller one. Similarly, with Location set to Vertices, an object with 100 vertices will emit twice as many particles as an object with 50.
If you delete from the scene an object designated as an emitter, its entry in the list is replaced with “<deleted>”.

Use the Add and Remove buttons to edit this list.

**Add** Adds an object to the list. Click Add, and then click an object in the viewport.

**By List** Adds multiple objects to the list. Click By List to open the Select Emitter Objects dialog. This works just like Select From Scene on page 206: Highlight the objects to use as emitters, and then click the Select button.

**Remove** Removes an object from the list. Highlight the object in the list, and then click Remove.

**Animated Shape** Turn on to allow particles to emit from the surface of an object whose form is animated by morphing or with modifiers.

**Subframe Sampling** When on, the operator acquires animation of the emitter shape on a tick basis (every 1/4800th of a second) rather than a frame basis. This provides greater precision in allowing the particle positions to follow animation of the emitter object’s form.

### Location group

The Location drop-down list lets you specify where on each emitter the particles appear. This choice applies to all emitter objects. Default=Surface.

The Selected Vertices/Edges/Faces options in this list let you emit particles from a specific part of the emitter object by using an existing sub-object selection. To create this selection, first convert the object to an editable mesh or poly, or apply a Mesh Select or Poly Select modifier (or equivalent), select the sub-objects that are to emit particles, and then choose the corresponding Location option. If Particle Flow doesn't find a sub-object selection, it uses all sub-objects of the indicated type.

**Pivot** Emits particles from the original position of the emitter object's pivot. Moving the pivot does not affect this option.

**Vertices** Emits particles from randomly selected vertices of the emitter objects.

**Edges** Emits particles from random points along the edge sub-objects of the emitter objects.

**Surface** Emits particles from random points on the surface of the icon.

**Volume** Emits particles from random points within the volume of the icon.

**Selected Vertices** Emits particles from the current vertex sub-object selection.
**Selected Edges** Emits particles from the current edge sub-object selection.

**Selected Faces** Emits particles from the current face or polygon sub-object selection.

---

You can modify the Location choice with any combination of the following:

**Surface Offset** Lets you specify a range of distances from the object surface for particle placement.

Surface Offset is unavailable when Location is set to Pivot or Volume. Use the Min and Max parameters to set the range.

**NOTE** Negative values offset the particles below the surface.

**Min/Max** When Surface Offset is on, these let you specify the range of offset distances from the object surface. The Min value cannot exceed the Max value, and vice-versa. If you try to raise Min above Max, or lower Max below Min, both values change equally.

**Density by Material** Varies emission over the emitter surface based on properties of the material applied to the emitter. For example, if the object is assigned a black-and-white checkered diffuse map and you choose the Grayscale option, particles are emitted only from the white checks.

**IMPORTANT** For material-influenced emission to appear properly in the viewports, two conditions are required:

- At least one viewport must be set to a shaded display mode.
- The material or map must have Show Map In Viewport turned on in the Material Editor.

The options are as follows:

- **Grayscale** Particle Flow internally converts the material-based coloring (diffuse) to grayscale, and then emits more particles in lighter areas and fewer in darker areas.
The box emitter is mapped with a gradient. With Position Object set to Density By Material > Grayscale, the particles appear with greater frequency in the lighter areas of the box.

- **Opacity**  
  Particles are more likely to appear on opaque areas than on transparent areas.

- **Grayscale & Opacity**  
  Combines the two: More particles appear on light, opaque areas than on dark, transparent areas.

- **Red/Green/Blue**  
  Considers only the specified color channel. The higher its value at any given pixel, the more likely particles are to appear there.

**Use Sub-Material**  
When on, uses a sub-material from the Multi/Sub-Object material assigned to the emitter to define density values. This option allows usage of “invisible” materials for particle placement. If the emitter uses a Multi/Sub-Object material but its geometry doesn't use the ID
that corresponds to one of the sub-materials, the sub-material doesn’t appear. However, the operator can use it to calculate the density of particle placement. Particle Flow assumes the material to be applied to the entire object surface.

**Mtl ID** Specifies the material ID of the sub-material to be used for particle emission.

**Separation** When on, Particle Flow attempts to keep the particles apart by the amount specified in Distance. The likelihood of successfully separating particles depends on the number of particles, the specified distance, and the Attempts Max value.

**Distance** Specifies the distance, in system units, by which Particle Flow should try to keep the particles separate. Default=1.0.

**Distinct Points Only** Limits emission to a specific number of points (see Total, below) on the specified Location type. Emission points are still randomized; change the Uniqueness setting to alter these.

**Total** Sets the number of emission points. Available only when Distinct Points Only is on. Default=10.

**If Location Is Invalid group**

**Delete Particles** When on, if Particle Flow cannot place a particle according to the current option, it deletes the particle. When off, particle placement is undefined; that is, it depends on other variables. Default=off.

If the number of particles is more important than the position on the object, leave this off. However, if exact placement is of higher priority than the number of particles, turn Delete Particles on.

**Uniqueness group**

The Uniqueness setting enables randomization of placement on the emitters.

**Seed** Specifies a randomization value.

**New** Calculates a new seed using a randomization formula.

**Attempts Max** When using the Separation option, this specifies the maximum number of times Particle Flow will try to set particle positions that maintain the requested distance. If unsuccessful within this number of attempts, particles might be closer together than the requested distance. Also affects placement with Density By Material using either of the Grayscale options.
Rotation Operator

Particle View on page 3015 > Click a Rotation operator in an event or add a Rotation operator to the particle system and then select it.

The Rotation operator lets you set and animate particle orientation during an event, with optional random variation. You can apply orientation in any of five different matrices: two random and three explicit. For some options you can set a degree of random variation or divergence from the specified orientation.

To cause particles to spin, use the Spin operator on page 3099.

Interface

The user interface appears in the parameters panel, on the right side of the Particle View dialog.
**Orientation Matrix group**

**Orientation drop-down list** The Orientation Matrix drop-down list includes options that give particles random orientations, or let you specify orientation in any of three different ways. Default=Random 3D.

- **Random 3D**  
  Gives each particle an arbitrary, random 3D orientation.

- **Random Horizontal**  
  Gives each particle an arbitrary, random 3D orientation about the Z axis only. Rotation about the X and Y axes doesn't change (unless Divergence is used), so the particles remain vertical.

- **World Space**  
  Orientation is specified in the world coordinate space. Use the X/Y/Z settings to specify the orientation for all particles.

- **Speed Space**  
  The coordinate space for particle orientation is determined by the particles' direction upon entering the event. By default, using the Speed operator on page 3108 > Along Icon Arrow option, particles are aimed straight down when born. Use the X/Y/Z settings to specify the orientation for all particles.

- **Speed Space Follow**  
  The coordinate space for particle orientation is determined continually while the particles are in the event. Thus, by default, particles constantly reorient themselves to "aim" in the direction they're traveling. For example, if you add a Find Target test on page 3247 to the end of the default Event 01, move the target sideways, and set Rotation to Speed Space Follow, the particles start out pointing straight down, as oriented by the Speed operator, and then gradually reorient themselves to point in the direction they're traveling: toward the target. Use the X/Y/Z settings to specify the orientation for all particles. The Divergence setting is unavailable when using Speed Space Follow.

- **X/Y/Z**  
  Set the basic orientation about the particles' local axes. Unavailable with the Random 3D and Random Horizontal options.

- **Divergence**  
  Defines the range of variation (in degrees) for particle orientation. The actual deviation is calculated at random within this range. Unavailable with the Random 3D or Speed Space Follow option. Default=0.0.

- **Restrict Divergence To Axis**  
  When on, lets you use the Divergence Axis controls to set the axis to which divergence will be applied. When off, Particle Flow uses a random axis for each particle. Unavailable with the Random 3D or Speed Space Follow option. Default=off.
Divergence Axis Use the X/Y/Z settings to set the axis to which divergence will be applied. Default=1,0,0. Range=-1.0 to 1.0.

To specify one of the world axes, set the corresponding parameter to any nonzero value, and the others to 0. A negative value flips the axis. The numeric values come into play when you want to use an axis that’s not aligned with the X, Y, or Z axis. In that case, you specify multiple nonzero values whose effect is relative to one another. For example, if you want the axis to be oriented halfway between the positive X and Y axes, you would set X and Y to the same positive amount. The actual value doesn’t matter. Similarly, to set the axis to 30 degrees (1/3 of the angle) from the X axis to the Y axis, you’d set the Y value to twice that of the X value. For example, X=0.2 and Y=0.4, or X=0.5 and Y=1.0.

Uniqueness group

The Uniqueness setting affects the randomization of orientation with the Random 3D and Random Horizontal options, and also Divergence.

Seed Specifies a randomization value.

New Calculates a new seed using a randomization formula.

Spin Operator

Particle View on page 3015 > Click a Spin operator in an event or add a Spin operator to the particle system and then select it.

The Spin operator gives an angular velocity to particles in an event, with optional random variation. Spin is applied once per event per particle, except when using the Speed Space Follow option; however, the settings can be animated.

To simply specify particle orientation, use the Rotation operator on page 3097.
Interface

The user interface appears in the parameters panel, on the right side of the Particle View dialog.

**Spin Rate** The rate of revolution in degrees per second.

**Variation** The maximum amount, in degrees per second, by which the spin rate can vary. The actual variation is calculated once, at random, for each particle.

**Spin Axis group**

**Spin Axis drop-down list** The Spin Axis setting includes options that let you apply the spin on a random or specific axis, with optional random variation of the spin axis. Default=Random 3D.

- **Random 3D** Spins each particle about an arbitrary, random 3D axis.
- **World Space** The spin axis is specified in the world coordinate space. Use the X/Y/Z settings to specify the spin axis.
- **Particle Space** The spin axis is specified in the local coordinate space of each particle. Use the X/Y/Z settings to specify the spin axis.
- **Speed Space** The coordinate space for particle orientation is determined by the particles' direction upon entering the event.
The X axis is aligned with the particle direction, while the Z axis is perpendicular to the X axis and is pointed upward with respect to world space as much as possible.

Use the X/Y/Z settings to specify the orientation for all particles.

- **Speed Space Follow**  The coordinate space for particle orientation is determined by the particles' direction throughout the event. Use this option to allow particles that change direction during the event to keep the spin axis aligned with their direction.
  The X axis is aligned with the particle direction, while the Z axis is perpendicular to the X axis and is pointed upward with respect to world space as much as possible.
  Use the X/Y/Z settings to specify the orientation for all particles.

**X/Y/Z** Use these to set the spin axis. Unavailable for the Random 3D option. Default=0,0,1. Range=–1.0 to 1.0.

To specify a single axis, set the corresponding parameter to any nonzero value, and the others to 0. A negative value flips the axis, and reverses the direction of rotation. The numeric values come into play when you give more than one axis a nonzero value, in which case their effect is relative to one another. For example, if you want the spin axis to be oriented halfway between the positive X and Y axes, you would set X and Y to the same positive amount. The actual value doesn't matter. Similarly, to set the spin axis to 30 degrees (1/3 of the angle) from the X axis to the Y axis, you'd set the Y value to twice that of the X value. For example, X=0.2 and Y=0.4, or X=0.5 and Y=1.0.

- **Divergence** Defines the range of variation (in degrees) for spin-axis orientation. The actual deviation is calculated at random within this range. Unavailable for the Random 3D option. Default=0. Range=0 to 180.

**Uniqueness group**

The Uniqueness setting affects the randomization of spin rate variation, spin axis with the Random 3D option, and Divergence with the other options.

- **Seed** Specifies a randomization value.
- **New** Calculates a new seed using a randomization formula.
Scale Operator

Particle View on page 3015 > Click a Scale operator in an event or add a Scale operator to the particle system and then select it.

The Scale operator lets you set and animate particle size during an event, with optional random variation. Options for how scaling and animation are applied give this operator a great deal of flexibility.

Procedures

Example: To animate particle scale:

This procedure gives an overview of animating particles to grow for 30 frames, remain at full size for the next 30 frames, and then shrink for 30 frames. It also gives an option for having the particles pulsate in size during the middle period. To follow this procedure, you should be familiar with the basic usage of Particle Flow and Track View.

1. Set up a default Particle Flow system. Set the Shape operator to Sphere, and set the Display operator to Geometry.

2. Add a Send Out test to Event 01.

3. Add a new Scale operator to the event display, creating a new event. Set the new event's Display operator to Geometry, and make sure it's a different color than the one in Event 01.

4. Wire the Send Out test in Event 01 to Event 02.

5. In the Event 02 > Scale operator, set Type to Absolute, and animate the Scale Factor values from 10 to 100 over frames 0 to 30. In the Animation Offset Keying group, set Sync By to Event Duration.

6. Add an Age Test to Event 02. Set it to Event Age, set Test Value to 30, and Variation to 0.

   In this event, particles grow from 10 percent of their original size to full size over the first 30 frames of their existence, which is the same as their duration in the event. At that point, they'll be eligible to move to the next event.

7. Use a new Scale operator to create a new event, Event 03. Set the new event's Display operator to Geometry, and make sure it's a different color than the others.

8. Wire the Age Test in Event 02 to Event 03.
9 In the Event 03 > Scale operator, Set Type to Absolute, and in the Animation Offset Keying group, set Sync By to Event Duration.

10 Copy and paste the Age Test as an instance from Event 02 to Event 03. Particles in Event 03 remain at full scale for 30 frames, and then move on to the next event.

11 Use a new Scale operator to create a new event: Event 04. Set the new event's Display operator to Geometry, and make sure it's a different color than the others.

12 Wire the Age Test in Event 03 to Event 04.

13 In the Event 04 > Scale operator, set Type to Absolute, and animate the Scale Factor values from 100 to 10 over frames 0 to 30. In the Animation Offset Keying group, set Sync By to Event Duration.

14 Copy and paste the Age Test as an instance from Event 03 to Event 04. In this event, particles shrink from full size to 10 percent of their original size over 30 frames.

15 Play the animation.
   Next, you'll use a Noise controller to cause the particles in Event 03 to pulsate in size.

16 Add a second Scale operator to Event 03, below the existing Scale operator. Set it to Relative Successive, and set Sync By to Event Duration. The name of this operator should be Scale 04.

17 In Particle view, right-click the Scale Factor X % parameter field on the Scale 04 rollout, and choose Show In Track View. The Curve Editor opens with the X Scale Factor parameter highlighted.

18 Right-click the X Scale Factor item and choose Assign Controller from the menu.

19 In the Assign Float Controller dialog, double-click Noise Float. The Noise Controller dialog opens.

20 Set Strength to 200, and to the right of Strength, turn on the >0 check box.

21 Copy this controller, and then paste it as instances to Y Scale Factor and Z Scale Factor.
Although the Scale operator defaults to constraining all scale factors to the same value, thus scaling particles uniformly, changing controllers in Track View works on a per-parameter basis.

22 Play the animation.
This time, the particles grow in size for 30 frames, then pulsate in size for the next 30 frames, and then shrink from the size at the end of Event 03 to 10 percent of that over the next 30 frames.

Interface

The user interface appears in the parameters panel, on the right side of the Particle View dialog.
Type

The scaling Type setting includes options that let you scale particles once in an event or repeatedly, and apply scaling as an absolute or relative factor. Default=Overwrite Once.

**Overwrite Once** Sets the scale *one time only* as an absolute percentage value, disregarding any previous scaling.

To produce a range of different birth sizes, and specify the scaling explicitly, use Overwrite Once with animated scale factors.

**Inherit Once** Sets the scale *one time only* as a percentage of existing scaling. The existing scaling should be specified with a previous Scale operator, the Scale setting in the Shape operator on page 3137, or a Shape Instance operator on page 3142.

For instance, if you previously used Scale with Overwrite Once to scale particles' birth size within a range, and then want to scale them to half their previous size, use Inherit Once and set Scale Factor to 50%.

**Absolute** Sets the scale *continuously*, while the particle is in the event, as an absolute percentage value, disregarding any previous scaling.

Use Absolute if you want to animate the particles' scale explicitly.

**Relative First** Sets the scale *continuously*, while the particle is in the event, as a percentage of existing scaling. The existing scaling should be specified with a previous Scale operator, or a Shape Instance.

Use Relative First when you want to scale the particles relative to the scaling at which they enter the event, and optionally animate the scaling, or before a Relative Successive operator.

**Relative Successive** Scales the particles *continuously*, relative to scaling set earlier in the same event.

**NOTE** Always precede Relative Successive *in the same event* with an operator that modifies the scale channel all the time, such as a Scale operator set to Absolute or Relative First, or a Shape Instance operator with the Scale check box turned on (it's on by default).

Scale Factor group

The operator performs scaling on each particle's local axes. It can scale particles on a single axis or on any combination of axes.
X/Y/Z Sets the scaling as a percentage of the particle's current size. To scale uniformly, turn on Constrain Proportions, and then change any axis setting. Range=0 to 10000000. Default=100.

Constrain Proportions When on, retains the current ratio of scale factor settings, so that changing any axis setting changes all of them. Default=on.

Scale Variation group

X/Y/Z Sets the scaling variation as a percentage of the particle's previous size. To scale uniformly, turn on Constrain Proportions, and then change any axis setting. Range=0 to 100. Default=0.

Constrain Proportions When on, retains the current ratio of scale variation settings, so that changing any axis setting changes all of them. Default=on.

Bias Lets you choose how to distribute the scaling variation within the specified range or ranges. Default=None.

- **None**  No bias; scaling variation is distributed equally through the range.

- **Centered**  Scaling variation is concentrated near the middle of the range; that is, at 0.0%.
  With this choice, scaling will occur more frequently with low percentage values than with ones near the values you set. In other words, most scaling variants will be close to the specified scaling value.

- **Towards Minimum**  Scaling variation is concentrated near the lower end of the range (base-variation); that is, most scaling variants will be smaller than the scaling value.

- **Towards Maximum**  Scaling variation is concentrated near the upper end of the range (base+variation); that is, most scaling variants will be larger than the scaling value.

Animation Offset Keying group

If you animate the Scale Factor or the Scale Variation settings or both, Particle Flow can begin applying this animation to all particles as of the start frame of the animation or the first frame of the current event, or to each particle based on its age. For instance, if you set Sync By to Particle Age, and set Scale Factor keys at frames 0 and 30, then Particle Flow will animate the scaling factor for each particle between its birth and its 30th frame of existence, if the particle is in the scaling event or a prior event. Following this example, any particle that has already reached its 30th frame of existence before reaching the event will enter the event fully scaled. That is, Particle Flow will apply the
Scale Factor value that you set at frame 30 to each particle aged 30 or above at the moment it enters the scaling event. However, any particle that leaves the scaling event before reaching age 30 will stop scaling as of its exit frame. In other words, with respect to particles in other events, animation of action parameters is retroactive, but not post-active.

Alternatively, if you set Sync By to Absolute Time, the scaling is animated from frame 0 to frame 30 of the animation, regardless of particle age, and even if no particles are in the event at that time. Or, if you set Sync By to Event Duration, the scaling animation is applied to each particle as of the time that it enters the event.

NOTE With the Overwrite Once and Inherit Once scaling types, scaling always occurs with respect to the entire animation; that is, in Absolute Time mode. Thus, when either of those scaling types is in effect, the Sync By setting is unavailable. Also, if you animate Scale Factor or Scale Variation when using Overwrite Once or Inherit Once, it doesn't cause scaling animation in the particles, but rather applies one-time scaling to particles born during that period. For instance, if you animate Scale Factor on all three axes from 100% to 200% over frames 0 to 30, particles born at frame 0 are normal size, particles born at frame 15 are one-and-one-half times normal size, and particles born at frame 30 (and thereafter) are twice normal size.

Sync By Choose the time frame for applying animated parameters:

- **Absolute Time** Any keys set for parameters are applied at the actual frames for which they're set.

- **Particle Age** Any keys set for parameters are applied at the corresponding frames of each particle's existence.

- **Event Duration** Any keys set for parameters are applied to each particle starting when it first enters the event.

Uniqueness group

The Uniqueness setting affects the randomization of scale variation.

Seed Specifies a randomization value.

New Calculates a new seed using a randomization formula.
**Speed**

Speed operators control particle speed, direction, and some other aspects of particle movement.

**Speed Operator**

[Particle View on page 3015 > Click Speed in an event or add a Speed operator to the particle system and then select it.]

This is the default Speed operator, which appears in the first event when you create a new Particle Flow icon. It provides basic controls over particle speed and direction.

Directional controls provided by the Speed operator are based on the position and orientation of the Particle Flow icon. For best results when using other objects as emitters, use the Speed By Surface Operator on page 3122 operator instead.

**See also:**
- Speed By Icon Operator on page 3112
- Keep Apart Operator on page 3131

**Procedures**

**Example: To change particles' speed:**

The Speed operator works on an instantaneous basis: It sets each particle's speed once only, when it enters the event. Even if you animate the Speed value, each particle moves at a constant rate of speed, defined by the value at the time it enters the event. This procedure demonstrates a trick you can use to change particle speed with an animated Speed value, thanks to Particle Flow's looping ability.

1. Create a default particle system, and position it at the top of the Perspective viewport.

2. Play the animation.
   - The particles fall downward at the default rate: 300 units per second.

3. Add a Send Out test at the bottom of Event 01.
4 Add a Speed operator to an empty area of the event display. This creates a new event.

5 Turn on Auto Key, and move the time slider to frame 30.

6 In Particle View, click the new Speed 02 operator, and then in the Particle View parameters panel, set Speed to 0. This animates the Speed value from 300 at frame 0 to 0 at frame 30.

7 Turn off Auto Key.

8 Wire the Send Out test in Event 01 to Event 02.

9 Play the animation. The particles born later move slower, but all still move at a constant rate of speed.

10 Add a Send Out test at the end of Event 02.

11 Create a new event using an Age Test. Click the Age Test to display its parameters, and then set the following:
   ■ Event Age
   ■ Test Value=1
   ■ Variation=0

12 Wire the Send Out test in Event 02 to Event 03.

13 Wire the Age Test in Event 03 to Event 02.

14 Play the animation. All the particles slow down simultaneously and eventually come to a stop.

   Here's how it works: As each particle enters Event 02, its speed is set to the current Speed value in the Speed operator. Particle Flow then sends the particle immediately to Event 03, where it sits for one frame. Event 03 then returns the particle to Event 02, whose Speed value is now lower. Particle Flow perceives the returned particle as newly entering the event, so it changes its speed to the current Speed value. Thus, the particles continually return to Event 02 one frame later than before, and are assigned a progressively lower speed.
If you wanted the particles to do something else after they stop, you could add a Speed Test to Event 02, above the Send Out test, set Test True If Particle Value to Is Less Than Test Value, and set Test Value to a very low value, such as 0.01. Then wire the Speed Test to a different event.

Interface

The user interface appears in the parameters panel, on the right side of the Particle View dialog.

**Speed** The particle speed in system units per second. Default=300.
A positive Speed value moves the particles in the direction determined by the Direction setting; a negative Speed value moves the particles in the opposite direction.

**NOTE** Speed sets each particle’s speed once only: when the particle enters the event (or is born, in the case of a birth event). If you animate the Speed value, particle speed does not vary: rather, each particle is given a constant speed equal to the current Speed value when it enters the event.

**Variation** The amount by which particle speed can vary, in system units per second. Default=0.0.
To obtain each particle’s speed, the system multiplies the Variation value by a random number between -1.0 and 1.0, and then adds the result to the Speed value. For example, if Speed=300 and Variation=100, then each particle’s speed would be between 200 and 400.
Direction group

The Direction drop-down list lets you specify which way the particles go after they're born. Default=Along Icon Arrow. In most cases, the actual direction also depends on the icon orientation. The primary exception is when Position > Location is set to Pivot.

Particle movement is always in a straight line unless influenced by other factors.

Along Icon Arrow Particles move parallel to the icon arrow. Rotate the icon to change the direction.

Icon Center Out Each particle moves along an imaginary line drawn between the particle's location and the icon center.

With the flat icon types (Rectangle and Circle), this results in all the particles moving in one plane, unless you increase Divergence above 0.0. With icons that have height (Box and Sphere), the particles move outward in three dimensions.

Particles at the center, as is the case when the Position operator's Location parameter is set to Pivot, arbitrarily move along the world X axis.

Icon Arrow Out Each particle moves along an imaginary line drawn between the particle's location and the icon arrow. The line is perpendicular to the icon arrow, which is considered an infinite line for this purpose.

With the flat icon types (Rectangle and Circle), this results in all the particles moving in one plane, unless you increase Divergence above 0.0. With icons that have height (Box and Sphere), the particles move outward in a cylindrical formation.

Random 3D Particles move in all directions. This option is affected by the Uniqueness setting.

Random Horizontal Each particle moves in a random horizontal direction; that is, parallel to the world XY plane. This option is affected by the Uniqueness setting.

Inherit Previous Uses the current direction of motion.

If you choose Inherit Previous but no direction was previously specified, the speed and direction are undefined; the particles don't move.

Reverse When on, the direction is reversed. Default=off.

Using Reverse is the equivalent of multiplying the Speed value by -1. This option is unavailable if Random 3D or Random Horizontal is chosen.
**Divergence** When on, spreads out the particle stream. Use the numeric setting to define the extent of the divergence, in degrees. Range=0 to 180. Default=0. The value can be animated.

This option is unavailable if Random 3D is chosen.

**TIP** For a fountain-like spray, set Position > Location to Pivot, set Direction to Along Icon Arrow, set Divergence to the desired angle, and rotate the icon so its arrow points upward.

**Uniqueness group**

The Uniqueness setting enables randomization of speed variation, and randomization of direction with the Random 3D and Random Horizontal options.

**Seed** Specifies a randomization value.

**New** Calculates a new seed using a randomization formula.

**Speed By Icon Operator**

**Particle View** on page 3015 > Click Speed By Icon in an event or add a Speed By Icon operator to the particle system and then select it.

Click a Speed By Icon operator icon in the viewport > Modify panel > Create panel > Helpers > Particle Flow > SpeedByIcon

The Speed By Icon operator lets you use a special, non-rendering icon to control particle speed and direction.
When you add a Speed By Icon operator to the particle system in Particle View on page 3015, the Speed By Icon operator icon, or helper, appears in the scene at the world origin (0,0,0). When animated, the operator icon's motion is imparted to the particles. If you delete the icon, Particle Flow also deletes the operator.

**NOTE** If you add Speed By Icon from the Create panel, Particle Flow creates a separate event for the operator in the particle diagram.

**WARNING** If you delete a Speed By Icon operator icon in the viewport, you also delete the corresponding operator in the Particle Flow system.

See also:
- Speed Operator on page 3108
- Speed By Surface Operator on page 3122
- Keep Apart Operator on page 3131

**Procedures**

**To use the Speed By Icon operator:**

1. Add a Speed By Icon operator to an event. Be sure to add it after any existing Speed operators in the event. Alternatively, delete or turn off any existing Speed operators.

   The Speed By Icon operator icon appears at the world origin (0,0,0).
2 Animate the icon as you would any object. You can do this manually, or with a controller such as Path Constraint. See the following procedure for an example of this.

The particles' motion is now under the influence of the animated icon.

3 Set the Speed By Icon parameters. With the icon selected, you can do this in the Modify panel.

In general, the default Icon Animation > Sync By setting, Event Duration, works best. It causes the icon animation to be applied to the particles within the time frame of the event containing the Speed By Icon operator.

Example: To send particles along a path:

1 Reset 3ds Max, and then add a Particle Flow system in the Perspective viewport.

2 On the Create panel, choose Shapes > Splines > Helix, and then, in the Perspective viewport, at the center of the grid, create a helix shape. Then, on the Parameters rollout, set the following:

   ■ Radius 1=100
   ■ Radius 2=20
   ■ Height=20
   ■ Turns=3
   ■ Bias=0

   This will serve as the particle path.

3 Move and rotate the Particle Flow source icon so that it's at the start of the helical path, and aimed along the path, as shown. Get the base of the arrow as close as possible to the start of the path.
4 Open Particle View (press 6).

5 In Event 01, click the Position Icon operator and set Location to Pivot. This causes the particles to be emitted in a thin stream.

6 Insert a Speed By Icon operator at the end of Event 01. The operator icon appears at the world origin.

7 Select the operator icon, and then, from the Animation menu, choose Position Controllers > Path Constraint on page 3596. When you move the mouse cursor into the viewport, a rubber-band line joins the cursor to the icon.

8 Select the Helix object. The command panel switches to the Motion tab, and the controls indicate that 3ds Max has applied a Position List controller to the icon, with the listed controllers being a Position XYZ and a Path Constraint. You can
delete the former if you like, but it doesn’t make any difference for the purposes of this procedure.

9 Close Particle View, and then drag the time slider back and forth between its extents a few times.

**TIP** The best way to view the results is from the Top viewport.

The particles follow the path fairly closely, but diverge noticeably at the end of the path, where the turns are tightest. Correcting divergence in tight turns typically requires an increase in the acceleration limit.

10 Stop at frame 100.

This will let you see the results of changing the Speed By Icon parameters as you make the changes.

11 Open the Modify panel, and, if necessary, select the Speed By Icon operator icon.

The operator parameters appear on the Modify panel. This is the case with any action that uses a unique icon, and lets you adjust the parameters without using Particle View.
12 On the Parameters rollout, use the Accel Limit spinner to slowly increase the value as you observe the changes to the particle path.

As you approach a value of 150, the end of the particle path comes closer and closer to the Helix. You shouldn’t see much change above 150.

The endpoints now coincide.

13 Drag the time slider again.

The particle path remains similar to that of the Helix for the entire duration of the animation. With other setups, you might need to use different values for Influence %, and for paths with tight twists and turns, you might need to increase Accel Limit as well.

You might be wondering why you didn’t simply replace the default Speed operator with the Speed By Icon operator. To see why not, try this:

14 Go to frame 100, open Particle View, and click the Speed 01 operator’s icon to turn it off. Play the animation.

The entire particle path is offset from the Helix, so it’s difficult to tell how closely it follows the latter’s curves.

15 Try adjusting the Speed By Icon’s Accel Limit and Influence % setting to get the particles to follow the helical path more closely.
It's not easy. You get more reliable results using the Speed operator to set the initial speed, and then Speed By Icon to set the particle path.

To use the Use Icon Orientation option:
The Use Icon Orientation option applies arc-like motion to the particles based on rotation animation of the icon. To best understand how it works, it's necessary to isolate its influence by eliminating any potentially conflicting factors.

1. Reset 3ds Max, and then add a Particle Flow system in the Perspective viewport. Set its position to the world origin: (0,0,0).

2. Open Particle View and click the Birth operator. Set Emit Stop=0. This causes all particles to appear at frame 0.

3. Click the Speed operator and press the Delete key to delete it.

4. Drag a Speed By Icon operator from the Depot to the end of Event 01. The Speed By Icon operator icon appears at the world origin.

5. Select the Speed By Icon operator icon, and then right-click the icon and choose Rotate from the menu. Go to frame 20, turn on Auto Key, and rotate the icon 180 degrees about the X axis.

6. Turn off Auto Key.

7. Drag the time slider.
The particles aren't affected by the icon animation.
Because the Speed By Icon operator icon is selected, the operator's parameters appear on the Modify panel.

8. On the Modify panel, turn on Use Icon Orientation. Drag the time slider again.
This time, the particles move in unison with the icon rotation, as if they were glued to an infinite plane coincident with the icon.

9. Go to frame 10, select the Particle Flow source icon (not the Speed By Icon operator icon), and then right-click the icon and choose Move from the menu. Move the icon straight up, on the Z axis, about 100 units.
As you drag upward, the particles move away from the icon.
10 Drag the time slider again. This time the particles move in an arc around the icon.

11 Try moving and rotating the two icons, playing the animation each time you make a change. Also set Emit Stop back to 30.

As you can see, the possibilities with just this simple setup are myriad. In combination with the many other variables and options in Particle Flow, they're endless.

Interface

The user interface appears in the parameters panel, on the right side of the Particle View dialog. When the icon is selected, the parameters also appear on the Modify panel.

**Accel(eration) Limit** The maximum amount, in system units per second per second, by which the particles' speed can change in order to match the speed of the operator icon. Default=100.0.
If the operator icon changes speed or direction rapidly, increase this value to let the particles follow it more closely.

**TIP** Use a lower Accel Limit value for smooth motion, and a higher value when greater accuracy is needed, such as when the particles should hit a small target. You can animate this setting (use Sync By > Event Duration) to specify different appropriate values, depending on the required results.

**Influence %** Determines the mix of the previous speed with the speed of the operator icon. Default=100.0. Range=0.0 to 100.0.

At the default value of 100, the speed is controlled only by that of the icon. At 0, the icon speed doesn't affect particle speed at all. At in-between values, the mix proportion is determined by the Influence % value.

**Speed Variation** Enables random variation of the particles' speed, so they don't all move at exactly the same rate as the icon. Turn this on, and then set the minimum and maximum percentages of variation. Default=off.

Using Speed Variation can help keep the particles from bunching up as they travel along the animation path. Note, however, that each individual particle's speed doesn't vary; it travels at a constant speed.

**Min %/Max %** Set the minimum and maximum percentages, respectively, of particle speed variation. Default=50.0 (Min %), 100.0 (Max %).

For example, if you set Min % to 50 and Max % to 200, the particles will vary in speed between half and two times the speed of the icon.

**Use Icon Orientation** Applies animation of the icon's orientation to the particles.

By default, Speed By Icon controls particle motion only by animation of the icon's position. If you turn on Use Icon Orientation, Particle Flow also applies rotation of the icon to the particle motion. In essence, this motion is circular, and its extent depends on the distance between each particle and the icon. Default=off.

The best way to understand how this works is by using it. To try out Use Icon Orientation, see this procedure on page 3118.

**Steer Towards Trajectory** Particles farther away than the Distance value from the icon are moved directly toward the icon. Default=off.

**Distance** Sets the distance between the particles and the operator icon beyond which Steer Towards Trajectory takes effect. Default=10.0.
Parameters Animation group

If you animate the operator settings, Particle Flow can begin applying this animation to all particles as of the start frame of the animation or the first frame of the current event, or to each particle based on its age. For instance, if you set Sync By to Particle Age, and set Speed Variation keys at frames 0 and 30, then Particle Flow will animate the speed variation for each particle born while the event is active between its birth and its 30th frame of existence. Alternatively, if you set Sync By to Absolute Time, the speed variation is animated from frame 0 to frame 30 of the animation, even if no particles are in the event at that time. Or, if you set Sync By to Event Duration, the speed variation animation is applied to each particle as of the time that it enters the event. For further information, see Animation Offset Keying group on page 3106.

Sync By Choose the time frame for applying animated parameters:

- **Absolute Time** Any keys set for parameters are applied at the actual frames for which they’re set.
- **Particle Age** Any keys set for parameters are applied at the corresponding frames of each particle’s existence.
- **Event Duration** Any keys set for parameters are applied to each particle relative to the frame at which it first enters the event.

Icon Animation group

Particle Flow can begin applying animation of the Speed By Icon operator icon to all particles as of the start frame of the animation or the first frame of the current event, or to each particle based on its age. For an explanation, see Animation Offset Keying group on page 3106.

Sync By Choose the time frame for applying animation of the icon to the particles:

- **Absolute Time** Any keys set for icon motion are applied at the actual frames for which they’re set.
- **Particle Age** Any keys set for icon motion are applied at the corresponding frames of each particle’s existence.
- **Event Duration** Any keys set for icon motion are applied to each particle relative to the frame at which it first enters the event.
Icon Size  Sets the size of the operator icon. This setting is for visibility only; it doesn't affect particle behavior.

Uniqueness group

The Uniqueness setting enables randomization of the speed variation range.

Seed  Specifies a randomization value.

New  Calculates a new seed using a randomization formula.

**Speed By Surface Operator**

[Particle View](#) on page 3015 > Click Speed By Surface in an event or add a Speed By Surface operator to the particle system and then select it.

The Speed By Surface operator lets you control particle speed and direction with any object or objects in the scene. This is in contrast to the default Speed operator on page 3108, which uses the Particle Flow icon to control particle speed and direction. Speed By Surface also provides options for controlling speed by materials in the scene, and continuous speed control.

Typically, you use Speed By Surface to assign speed and direction characteristics based on the objects used as emitters with the Position Object operator on page 3089. That is, you assign the same objects as emitters with Position Object and as Surface Geometry objects with Speed By Surface.

**TIP**  For greater control over particle motion on the surface, apply a Speed operator on page 3108 before the Speed By Surface operator in the same event. Use the Speed operator to specify particle direction on the surface, and the Speed By Surface operator to adjust the vertical component of the speed vector to follow the contour of the surface.

See also:

- Speed By Icon Operator on page 3112
- Keep Apart Operator on page 3131
Procedures

Example: To use Speed By Surface:

The Speed By Surface operator offers a wealth of possibilities for usage. This procedure will lead you through several examples, but you're encouraged to explore the operator further on your own to learn more about it.

1. Start or reset 3ds Max, and add a Particle Flow system. Position the source icon at the world origin (X/Y/Z=0), and set the icon's Length and Width values both to 30.

2. Add a Cylinder primitive to the scene. Position it above the source icon: X/Y=0 and Z=30. Set Radius=20 and Height=40.

3. Play the animation, and then stop.
   The particles move downward, using the default starting setup.

4. Open Particle View and add a Speed By Surface operator to the end of Event 01. Click the operator in the event to display its parameters panel in Particle View.

5. In the Surface Geometry group, click Add, and then select the cylinder.

6. Play the animation again, and then stop.
   The particles still move downward.

7. Go to frame 15, so you can see the particles, and then slowly move the cylinder downward along the Z axis, while watching the particles in the Perspective and Front viewports. Stop when the emitter is above the cylinder.
   As the bottom of the cylinder passes below the emitter, more and more particles start moving on the XY plane rather than perpendicular to it. That's because they eventually become closer to one of the vertical sides of the cylinder, rather than the bottom, at which point they move perpendicular to the vertical sides. When the top becomes the closest side, the particles again move vertically, but upward instead of downward.

8. Move the cylinder back up until the emitter is at its vertical center. Then, on the Modify panel, click the lower part of the Sides spinner to decrease the number of sides, one at a time.
   Each time you click, the particle streams traveling outward change, to move perpendicular to the vertical sides as they change position. You might also try rotating the cylinder, and note that the particle streams also rotate, like the spokes of a wheel.
9 In the Speed By Surface parameters, change Direction to Out Of Surface, and then move the cylinder up and down. The overall behavior doesn't change much. Out Of Surface becomes more useful when you use the Control Speed Continuously option, as you'll observe shortly.

10 In the Speed By Surface parameters, change Direction to Parallel To Surface, and then move the cylinder up and down. Now the particle behavior is effectively opposite of that with the other two options. When the particles are closer to the top or bottom, they move along the XY plane, and when they're closer to the vertical sides, they move downward. If you want them to move upward instead, set Speed to a negative value. Next, you'll discover how the Control Speed Continuously option alters particle behavior.

11 In the Speed By Surface parameters, choose Control Speed Continuously, and then drag the time slider. The particles spread out from the emitter, and then start orbiting the cylinder in a roughly cylindrical overall formation. Particle Flow continually checks to see which side of the cylinder a particle is closest to, and, if necessary, changes its direction to make it travel parallel to that side. You can affect the size of the particles' orbits by changing their speed.

Lastly, you'll see how to contain particle motion within the cylinder.

12 Make the cylinder considerably larger: Radius=60 and Height=90. Activate the Perspective viewport, if necessary, and then press F3 to set it to Wireframe view.

13 In Particle View, click the Speed 01 operator and set Direction to Random 3D.

14 Click the Speed By Surface operator. Set Speed to 300 if necessary. In the Direction group, choose Out Of Surface, and then drag the time slider. After exiting the emitter, the particles always move away from the nearest surface, with the result that they end up milling about in the center of the cylinder.

15 Gradually increase the Speed value, up to 1,000 or so. The particles start to spread out vertically, and eventually start moving so fast that they escape the cylinder. You can make them stay inside the
cylinder by letting them accelerate more quickly, so they can turn before moving past the nearest surface.

16 Increase the Accel Limit setting until the particles no longer exit the cylinder.

17 Try giving the particles more room to move about in by increasing the size of the emitter. Also try changing other settings throughout the particle system to see their effects. The possibilities don’t end here, and the more you experiment, the more you’ll learn about how this powerful operator works.
Chapter 12  Space Warps and Particle Systems
The user interface appears in the parameters panel, on the right side of the Particle View dialog.

The first setting lets you choose whether the operator controls speed once or continuously.

**Set Speed Once** The operator sets the speed for each particle once: when the particle enters the event.

**Control Speed Continuously** The operator sets particle speed throughout the event. When you choose this option, the Continuous Speed Control group on page 3130 becomes available.

**Speed** The particle speed in system units per second. Default=300.

With the Control Speed Continuously option, you can turn off Speed. This causes Particle Flow to use the current particle speed.

Using a negative Speed value causes particles to move in the opposite direction of that effected by a positive speed.

**Variation** The amount by which particle speed can vary, in system units per second. Default=0.0.

To obtain each particle's speed, the system multiplies the Variation value by a random number between -1.0 and 1.0, and then adds the result to the Speed value. For example, if Speed=300 and Variation=100, then each particle's speed would be between 200 and 400.

**Surface Geometry group**

Use these controls to assign objects to affect particle speed and direction. The list in this group shows the objects, or reference geometry, that the operator uses to control speed and direction.

If you don't assign any objects, the current particle speed and direction are not affected.

You can assign multiple Surface Geometry objects, but if they're not all emitters as well, the results can be difficult to interpret. In general, assign the same objects as Surface Geometry that your system uses as emitters.

**TIP** For optimal performance, when moving particles with respect to high-polygon objects, create a low-poly proxy version to use as surface geometry, link it as a child of the high-poly object if necessary, and then hide the low-poly proxy.

Use the Add and Remove buttons to edit this list.
Add Adds an object to the list. Click Add, and then click an object in the viewport.

By List Adds multiple objects to the list. Click By List to open the Select Surface Objects dialog. This works just like Select From Scene on page 206: Highlight the objects to use to control speed and direction, and then click the Select button.

Remove Removes an object from the list. Highlight the object in the list, and then click Remove.

Animated Shape Turn on to allow particles to follow the surface of an object whose form is animated by morphing or with modifiers.

Subframe Sampling When on, the operator acquires animation of the Surface Geometry shape on a tick basis (every 1/4,800th of a second) rather than a frame basis. This provides greater precision in allowing the particle positions to follow animation of the Surface Geometry object's form.

Speed by Material Varies particles' existing speed and direction based on properties of the material applied to each Surface Geometry object. For example, if an object is assigned a black-and-white checkered diffuse map and you choose the Grayscale Multiplier option, particles near the white-checked areas move faster than those from the black-checked areas.

NOTE For material-influenced speed to appear properly in the viewports, two conditions are required: at least one viewport must be set to a shaded display mode, and the material or map must have Show Map In Viewport turned on in the Material Editor.

The options are as follows:

- **Grayscale Multiplier**  Lets material luminance control speed, with darker areas producing slower particles and lighter areas producing faster ones. Particle Flow multiplies the luminance of the material near each particle, converted to a percentage, by the particle's current speed. A luminance of 0 converts to 0%, of 128 converts to 50%, and of 255 converts to 100%. For example, if the speed of a particle traveling at 50 units per second is influenced by a pixel whose luminance is 90, the resulting speed is 90/255*50, or about 17.6 units per second.

- **Signed Grayscale**  Works like Grayscale Multiplier, but the multiplier can be negative as well, causing reversal of motion. Signed Grayscale uses a material luminance value of 128 as the midpoint, and assigns it a multiplier of 0%. Luminance values from 0 to 127 result in multipliers of -100% to 100%. Luminance values above 127 produce negative multipliers.
about -1%, respectively, and values of 129 to 255 result in multipliers of about 1% to 100%, respectively.

- **RGB as World XYZ Mult.** Works like Grayscale Multiplier, but uses the intensity of the material’s red, green, and blue channels to affect particle speed on the world X, Y, and Z axes, respectively. So, for example, if the material pixel is pure red, that is, its RGB value is (255,0,0), then the particle will retain its current speed on the world X axis, but its speed on the Y and Z axes will be reduced to 0. Similarly, a medium-yellow pixel (128,128,0) will cause speed on the world X and Y axes to be reduced by half, and will cut speed on the Z axis to 0.

- **RGB as Local XYZ Mult.** Works like RGB as World XYZ Mult., but uses the object’s local coordinates rather than world coordinates.

**Use Sub-Material** When on, uses a sub-material from the Multi/Sub-Object material assigned to the Surface Geometry object to define speed. This option allows usage of “invisible” materials for controlling particle speed. If the emitter uses a Multi/Sub-Object material but its geometry doesn’t use the ID that corresponds one of the sub-materials, the sub-material doesn’t appear. However, the operator can use it to calculate the density of particle placement. Particle Flow assumes the material to be applied to the entire object surface.

**Mtl ID** Specifies the material ID of the sub-material to be used for particle speed control.

**Direction group**

The Direction drop-down list lets you specify which way the particles go after they’re born. Default=Surface Normals. In most cases, the actual direction also depends on the icon orientation. The primary exception is when Position > Location is set to Pivot.

Particle movement is always in a straight line unless influenced by other factors.

**Surface Normals** Each particle moves along a line perpendicular to the nearest face. The direction the surface faces doesn’t matter.

**Out Of Surface** Particles move away from the closest face.
**TIP** You can use this option to confine particles to the interior of an object. Position the emitter inside the object, designate the object as the Surface Geometry, choose Control Speed Continuously, and choose Out Of Surface. Each time a particle comes close to a surface, it turns to travel directly away from the surface. Control the particles' travel range with the Speed setting, but keep in mind that particles moving very fast might “escape” their container. If this happens, increase the Accel Limit setting; this lets the particles turn more quickly.

**Parallel To Surface** Each particle travels parallel to the nearest face.

To make particles orbit an object, use this with Control Speed Continuously, and set appropriate Continuous Speed Control values (see the following section).

---

**Divergence** When on, spreads out the particle stream. Use the numeric setting to define the extent of the divergence. Range=0 to 180. Default=0. The value can be animated.

This option is unavailable if Control Speed Continuously is chosen.

**TIP** For a fountain-like spray, set Position > Location to Pivot, set Direction to Along Icon Arrow, set Divergence to the desired angle, and rotate the icon so its arrow points upward.

---

**Continuous Speed Control group**

When you choose the Control Speed Continuously option, these controls become available. Basically, these controls let the particles move about within the region of the Surface Geometry object rather than in a straight line away from the emitter.

**Accel Limit** Sets the maximum acceleration. The higher this value, the more quickly particles can turn and change speed.

**TIP** Use a lower Accel Limit value for smooth motion, and a higher value when greater accuracy is needed, such as when the particles should hit a small target. You can animate this setting (use Sync By > Event Duration) to specify different appropriate values, depending on the required results.

**Unlimited Range** When on, the surface controls speed and direction of particles at any distance. When off, particles must be within a specified range. Default=on.
**Range** The maximum distance, in system units, between the particles and controlling surface. The Surface Geometry will not control particles beyond this distance.

**Falloff Zone** The distance, in system units, beyond the Range value within which the Surface Geometry exerts partial control over particles. The degree of control diminishes from 100% at the Range distance to 0% at the Range+Falloff Zone distance.

**Animation Offset Keying group**

Choose the time frame for applying animated parameters. For an explanation, see Animation Offset Keying group on page 3106.

**Absolute Time** Any keys set for parameters are applied at the actual frames for which they're set.

**Particle Age** Any keys set for parameters are applied at the corresponding frames of each particle's existence.

**Event Duration** Any keys set for parameters are applied to each particle starting when it first enters the event.

**Uniqueness group**

The Uniqueness setting enables randomization of speed variation, and randomization of direction with the Random 3D and Random Horizontal options.

**Seed** Specifies a randomization value.

**New** Calculates a new seed using a randomization formula.

**Keep Apart Operator**

**Particle View** on page 3015 > Click Keep Apart in an event or add a Keep Apart operator to the particle system and then select it.

The Keep Apart operator, a member of the Speed operator family, lets you apply forces to particles to cause them to separate, in order to prevent or minimize collisions among particles. Alternatively, you can use a negative force to keep particles from separating too much. The operator works by controlling particle speed and acceleration.
NOTE Keep Apart doesn't use particle geometry; rather, it creates a spherical force field centered on the pivot of each particle. You can adjust the size of the force field by changing the particle size.

TIP In certain cases, the default settings might not be sufficient to keep particles from interpenetrating. For increased separation, use higher values for Force and Accel Limit, choose Relative To Particle Size, and increase the Core % value.

See also:
- Speed Operator on page 3108
- Speed By Surface Operator on page 3122
- Speed By Icon Operator on page 3112

Script Wiring rollout

This rollout appears in the parameters panel below the main operator rollout after you highlight the operator, right-click it, and then choose Use Script Wiring. Thereafter, a check mark appears next to the Use Script Wiring in the right-click menu, and the rollout appears whenever you highlight the operator. To turn off script wiring, choose Use Script Wiring again from the right-click menu.

Script wiring lets you use a script to control the Force and Range parameters, which you normally specify in the operator's parameters. Place a Script operator on page 3196 before the Keep Apart operator in the event, and then use it to define values in the particleFloat and particleVector channels. For an example of a script that sets particleFloat values, see particleFloat Sample Script on page 3190.

On the Script Wiring rollout, choose either of the following:

Use Script Float As Choose either of the following:
- Not Used Particle Flow uses the Force setting on page 3135 specified in the Parameters rollout.
- Influence Particle Flow applies the script particleFloat value to the Force value.
Use **Script Vector As** Choose one of the following. Choosing Absolute Size Range or Relative Size Range makes the Range settings on the Parameters rollout unavailable.

- **Not Used** Particle Flow uses the Range on page 3135 settings specified in the Parameters rollout.

- **Absolute Size Range** Particle Flow applies the script particleVector values to the Absolute Size Range values. The X component of the vector value is used for the core radius, and the Y component for the falloff radius.

- **Relative Size Range** Particle Flow applies the script particleVector values to the Relative Size Range values. The X component of the vector value is used for the core percent, and the Y component for the falloff percent.
The user interface appears in the parameters panel, on the right side of the Particle View dialog.
**Force** The amount of force applied to the particles. Use positive values to separate particles, or negative values to move them closer together. Default=100.0

**Accel(eration) Limit** When on, lets you set a maximum acceleration value that can be applied to particles' motion. When off, Particle Flow uses any necessary acceleration. Default=on, 1000.0.

**Tip** Use a lower Accel Limit value for smooth motion, and a higher value when greater accuracy is needed, such as when the particles should hit a small target. You can animate this setting (use Sync By > Event Duration) to specify different appropriate values, depending on the required results.

**Speed Limit** When on, lets you set a maximum speed value that can be applied to particles' motion. When off, Particle Flow uses any necessary speed. Default=off, 600.0.

**Range group**

You can set a volume and falloff within which the force takes effect, either as absolute distances or relative to particle size. Default=Absolute Size.

**Absolute Size** Choose this to set the core radius and falloff zone as absolute distances, in system units.

**Core Radius** The distance from each particle's pivot point, in system units, within which the force is applied at full strength. Default=10.0

**Falloff Zone** The distance beyond the core radius, in system units, over which the force diminishes from full strength to 0. Default=10.0

**Relative to Particle Size** Choose this to set the core radius and falloff zone as percentages, relative to the radius of each particle. The particle radius is determined by measuring the distance from the pivot point to the farthest corner of its bounding box.

**Core %** The distance from each particle, as a percentage of the particle radius, within which the force is applied at full strength. Default=200.0

**Falloff %** The distance beyond the core radius, as a percentage of the radius, over which the force diminishes from full strength to 0. Default=100.0

**Variation %** The amount by which range values can vary randomly, as a percentage of the specified values. Particle Flow uses the same random variation value for both Core and Falloff values, whether absolute or relative. Default=0.0

For example, if you choose Absolute Size, set Core Radius to 40 and Falloff Zone to 20, and set Variation % to 50, then each particle's actual core radius...
will be a random number in the range 20 to 60, and the falloff zone a random number in the range 10 to 30. For each particle, Particle Flow uses the same Variation % value, so if Core Radius is determined to be 20, then Falloff Zone would be 10.

**Scope group**

By default, the Keep Apart force keeps particles only in the current event (that is, the event that contains the Keep Apart operator) apart from each other when used locally, or particles in each event in the current flow on page 8581 apart when used globally. These settings let you alternatively keep particles away from particles in other events or flows without affecting the behavior of latter. Default=Current Event.

**Current Event** Keeps particles in the current event only away from each other. When used globally, keeps particles in each event in the current flow apart from each other, but not apart from particles in other events in the flow.

**Current Particle System** Keeps particles in the current event away from each other, and away from all other particles in the current flow on page 8581. The particles not in the current event are not influenced by the Keep Apart operator. When used globally, keeps apart and influences all particles in the current flow.

**Selected Events** Keeps particles in the current event away from all particles in the events highlighted in the list below this choice. Particles not in the current event are not influenced by the Keep Apart operator. When used globally, keeps all particles in the current flow apart from all particles in the events highlighted in the list below this choice, but influences only particles in the current flow. After choosing this option, click items in the list to highlight them.

**Selected Particle Systems** Keeps particles in the current event away from all particles in the flows on page 8581 highlighted in the list below this choice. The particles not in the current event are not influenced by the Keep Apart operator. When used globally, keeps all particles in the current flow apart from all particles in the flows highlighted in the list below this choice, but influences only particles in the current flow. After choosing this option, click items in the list to highlight them.

**Uniqueness group**

The Uniqueness setting enables randomization of the Range on page 3135 > Variation % calculations.
Seed Specifies a randomization value.

New Calculates a new seed using a randomization formula.

Shape

Shape operators control the geometry of particles.

Shape Operator

Particle View on page 3015 > Click Shape in an event or add a Shape operator to the particle system and then select it.

The new Shape operator, which replaces the original version, expands the choices of ready-made geometry for use in the particle system. You can specify particles in a number of different predefined 2D and 3D shapes, such as geometric primitives, alphanumeric characters, and musical notes, as well as particle size and scale.

Primitive particles created with Shape have pivot points at their geometric centers. They also have UVW mapping assigned according to the vertex position in the local 3D particle space.

2D particles have zero thickness, and are invisible when the back of the particle faces the camera unless a double-sided material is assigned to the particles or emitter.

See also:

- Shape Instance Operator on page 3142
- Shape Facing Operator on page 3139
- Shape Mark Operator on page 3149
Interface

2D/3D Makes available a drop-down list of pre-built 2D or 3D objects for use as a particle shape. The thumbnail image is color-coded to indicate its relative complexity to other pre-built objects. Simpler shapes are blue or green, while more complex shapes are purple or red. There are 20 shapes of each type. For sequential shapes, such as digits, letters, and notes, you can turn on Multi-Shape Random Order to produce a random sequence.

Size Sets the overall size of the particles in system units. Default=10.0.

Scale Turn on to set the size of the particles as a percentage of the Size value. Use the numeric field to set the Scale percentage value. Default=100.0. Scale is animatable, while Size is not. Turning on Scale creates scale data that Scale operators later in the flow can work with.

Variation Available only if Scale is turned on. Adds variation to the overall particle scale. The resulting scale factor is set only once, when a particle enters the event. To control the scale factor continuously, use the Scale operator.

Multi-Shape Random Order When on, assigns shapes to particles in random order. This option is available only for multi-shape forms. When off, the shapes are assigned in their natural order, such as A, B, C for letters, and 1, 2, 3 for digits.
Uniqueness Group of Controls

The options in the Uniqueness group are available only when Multi-Shape Random Order is turned on.

Seed  Specifies a randomization seed.

New  Calculates a new seed using a randomization formula.

Shape Facing Operator

Particle View on page 3015 > Click Shape Facing in an event or add a Shape Facing operator to the particle system and then select it.

The Shape Facing operator creates each particle as a rectangle that always faces a particular object, camera, or direction. For effects like smoke, fire, water, bubbles, or snowflakes, use Shape Facing with a material containing appropriate opacity and diffuse maps.

By default, the particles' top and bottom sides are parallel to the horizontal plane. The Orientation setting lets you change this default alignment.

**NOTE** For the Shape Facing operator to be able to calculate the particle orientation, it must know the current particle position. For this reason, always place the Shape Facing operator *below* a Position operator in an event.

See also:

- Shape Operator on page 3137
- Shape Instance Operator on page 3142
- Shape Mark Operator on page 3149
**Interface**

![Interface Diagram]

**Look At Camera/Object group**

Use this control for defining the camera or object toward which the particle will face. This object is known as the *Look At object*. For the technically minded, the facing is maintained by keeping each particle's local Z axis pointed at the Look At object, or when Use Parallel Direction is on, aligned with the vector between the Particle Source icon and the Look At object.

**Name** After picking a Look At object, its name appears here.

**Pick Camera or Object** Click this button, and then select a camera or object in the scene to use as the Look At object. The mouse cursor changes to a cross shape when positioned over a valid object.
Use **Parallel Direction** When off, all particles continuously rotate to stay facing toward the Look At object. Each particle's orientation varies because its location differs from those of the others. When on, all particles face in the same direction, defined by an imaginary line between the Particle Source gizmo center and the Look At object. Default=off.

**Size/Width group**

Use these settings to specify the coordinate system for setting the size, as well as the size parameters. The numeric settings in this group are not animatable.

**In World Space** Sets the absolute size in system units, using the World coordinate system.

**Units** With the In World Space option, sets the particle size in system units. Range=0 to 1000000000. Default=1.

**In Local Space** Sets particle size relative to the existing size, in local space. Particle Flow uses the dimensions of the existing shape to determine the size of the “facing rectangle.”

**Inherited %** Sets the facing particles' size as a percentage of the existing size. Range=0 to 100. Default=100.

**In Screen Space** Sets the facing particles' size as a percentage of the screen width. The actual size of each particle changes as necessary throughout the animation, depending its distance from the camera, to maintain a constant size from the camera’s point of view.

This option is available only when the Look At object is a camera, and Use Parallel Direction is off.

**Proportion %** Sets the particle size as a percentage of the screen width. Default=1.

**Variation %** Sets the percentage by which particle size can vary. Default=0.

**Pivot At** Specifies the part of the particle around which rotation is performed when maintaining the facing direction. The choices, available from the drop-down list, are Top, Center, and Bottom. Default=Center.

With Top and Bottom, the center of the corresponding side is used as the particle center for rotation.
This option is useful, for example, when particles are lying on a surface, and each particle is an explosion. In this situation, you'd probably want the entire particle rectangle to appear above the surface, so you'd set Pivot At to Bottom.

**W/H Ratio** Defines the aspect (width-to-height) ratio of the shape rectangle. Adjust this ratio to that of the particle-map imagery. For the commonly used TV aspect ratio of 4:3, set W/H Ratio=1.33. The parameter is not animatable. Range=0.001 to 1000. Default=1 (square particles).

This value is not animatable.

**Orientation**

Use this drop-down list to choose how particles rotate on the axes not specified by the Look At direction. Default=Align to Horizon.

**Align to Horizon** Keeps the top edge aligned with the horizon (the world XY plane).

**Align to Speed Follow** Uses the right side of each particle as the leading edge, so the top and bottom edges are aligned with the direction of particle motion.

**Random** Orient the top edge at random.

**Allow Spinning** To spin the particles, choose this option, and in the same event use a Spin operator on page 3099. In the latter, set Rotation Axis to Particle Space and use the default axis values: X=0, Y=0, Z=1.

**Uniqueness group**

The Uniqueness setting enables changing the randomization of the size/width variation.

**Seed** Specifies a randomization value.

**New** Calculates a new seed using a randomization formula.

**Shape Instance Operator**

**Particle View** on page 3015 > Click Shape Instance in an event or add a Shape Instance operator to the particle system and then select it.

Shape Instance lets you use any reference object on page 8700 in the scene as particles. You can effectively define only one reference object per event, but the object can comprise any number of sub-objects, each of which Particle Flow can treat as a separate particle. Also, using tests, you can divide the
particle stream into multiple branches and define a different particle shape for each.

As the name of the operator indicates, reference geometry is instanced into the particle system. Thus, any physical changes you make to the original geometry are reflected instantly in the particle system. If you hide the original geometry, the particles still appear. However, if you delete the original geometry, the particles are deleted as well.

**Using Transform-Animated Reference Objects**

You can create animated particle shapes by animating the reference object with modifiers, and then turning on **Animated Shape** on page 3148. However, **Shape Instance** ignores any rotational and positional transformations applied directly to the reference object; it uses only the pure scale component. For example, if you scale an object non-uniformly using the View reference coordinate system, the result might skew the object's shape. Because the skewing is the by-product of a rotational transform, it wouldn't be reflected in the particles' shape. However, modifiers and comparable functions that contain transformations applied to the reference object are reflected in the instanced particles. For example, if you want particles to use rotational transforms applied to the reference object, use the **Reset XForm** function on the reference object. **Reset XForm** is available from the **Utilities** panel.

**TIP** Particle Flow can, however, use rotational and positional animation applied to descendant objects in a hierarchy, when you use the entire hierarchy as a single particle. To do this, create a hierarchy, animate the descendant objects, and then designate the parent as the reference object. Do not turn on **Separate Particles For > Object And Children**. You'll find a procedure illustrating this, below.

When using an animated reference object, it is recommended that you hide the reference object after instancing it in the particle system.

**See also:**
- **Shape Operator** on page 3137
- **Shape Facing Operator** on page 3139
- **Shape Mark Operator** on page 3149
Procedures

Example: To use the reference object’s rotational and positional animation in the particle system:

1. Create an object you want to use as the particle shape, such as a teapot, and a Dummy helper object.

2. Animate the teapot using the Move and Rotate tools.

3. Use the Align tool to center the teapot to the dummy.
   This step isn’t necessary, but it can help to obtain more consistent results.

4. Link the teapot as a child of the dummy (drag from the teapot to the dummy).
   You can use any object as the parent, but using a dummy, which doesn’t render, lets you animate all instanced particles visible in the final animation.

5. Create a default Particle Flow system.

6. In Particle View, delete the Rotation operator.

7. Replace the Shape operator with a Shape Instance operator.

8. In the Shape operator parameters, designate the dummy as the Particle Geometry Object.

9. Turn on Animated Shape.

10. For sequential animation, which can be more interesting visually, in Animation Offset Keying, set Sync By to Particle Age or Event Duration.
Interface

Particle Geometry group

Use this control for defining the object to be used as the particle geometry. This object is known as the reference object.

[button] Click this button, and then select a geometry object in the scene to be used as the particle shape. The mouse cursor changes to a cross shape when positioned over an object that’s valid for use as a reference object. Valid objects
include *multi-shape* objects such as groups and hierarchies; see Separate Particles For group on page 3146.

After picking a reference object, its name appears on the button.

You can use almost any geometry object as a reference object. By default, the operator automatically converts closed splines to rendering geometry by “filling in” the area defined by the shape outline. To use the shape outline instead, select the original shape and, on the Modify panel > Rendering rollout, turn on Display Render Mesh. You needn’t turn on Renderable, but changes to all other Rendering rollout settings, such Thickness and Sides, are reflected in the rendered particles.

Particle Flow does not automatically “fill in” open shapes such as Line (non-closed) and Arc. To render these shapes when using them as particles, turn on Modify panel > Rendering rollout > Display Render Mesh.

If a Shape Instance operator is in effect for which the geometry object is not defined, and the viewport display type is set to Geometry, then the particles appear in the viewports as X characters.

**NOTE** If a multi-shape object used as a reference object comprises objects both with and without materials applied, and Acquire Material is on, Particle Flow will apply the first available material to any objects without materials applied.

**NOTE** You can use a NURBS surface as a reference object, but not a NURBS curve. To use a NURBS curve as particle geometry, first convert it to a surface using a method such as the Cap function.

**TIP** For best results, when using an animated reference object, it’s highly recommended that you hide the original object before rendering, or use Object Properties to turn off its Renderable check box.

**NOTE** If using a group as a reference object, make sure the group is closed before selecting it. Selecting an open group will add only the group member you click, not the entire group.

**Separate Particles For group**

3ds Max provides a number of methods for combining disparate objects into single entities, including grouping, building hierarchies with linking, and attaching. By default, when using such a *multi-shape* object as particle geometry, each particle comprises all member objects. Alternatively, you can instruct Particle Flow to treat each member object as a separate particle with these options. When on, Particle Flow uses each member object as a single particle, in left-to-right order according to its X-axis position, by default. So, for
example, if you create text in the Front viewport, assign it as reference geometry, and turn on Object Elements, the letters come out in the proper order.

You can vary the order randomly by turning on Multi-Shape Random Order on page 3148.

You can turn on any combination of Separate Particles items. All are off by default.

**Group Members** When on, group members are treated as separate particles.

**Object and Children** When on, linked objects are treated as separate particles.

**Object Elements** When on, element sub-objects of a single mesh object are treated as separate particles.

**Vertices/Faces** Show the number of vertices and triangles per particle. If the reference geometry is multi-shape and the appropriate check boxes in the Separate Particles are on, then these displays show an average vertex/face count.

**Number of Shapes** Shows number of different particle shapes. This number is always 1 unless the reference geometry is multi-shape and the appropriate check boxes in the Separate Particles For group are on, in which case this displays the number of resulting different shapes.

**Scale (%)** Specifies a uniform scaling factor for all particles. Range=0 to 100000. Default=on, 100.

The center of scaling for multi-shape object members treated individually depends on how the objects are combined. For grouped and linked objects, the scaling is done about the objects' pivot points. For object elements, the scaling center is the geometric center of each object; that is, the averaged location of all the vertices.

This value cannot be animated. To animate particle size, use the Scale operator on page 918.

**Variation (%)** Specifies a randomized percentage of scaling variation. Use the Uniqueness setting to change the randomization. Range=0 to 100. Default=0.

This value cannot be animated. To animate scaling variation, use the Scale operator on page 3102 operator.

**Acquire Mapping** When on, all mapping data from the reference object is transferred to particles. Default=on.
**Acquire Material** When on, material data from the reference object is transferred to particles. Default=on.

If the reference object is a group, with different materials applied to the group members, Particle Flow creates a new Multi/Sub-Object material containing all of the materials and uses it as the particle material.

**TIP** Because materials are “sticky” in Particle Flow, if you turn off Acquire Material after specifying a reference object with an attached material, the material remains applied to the particles. To avoid applying the instanced shape’s material to the particles, turn off Acquire Material before specifying the reference object.

**Multi-Shape Random Order** When on, assigns shapes to particles in random order. When off, Particle Flow emits each shape in the multi-shape object as a single particle, in the order of the shape’s X coordinate. In other words, the shape with the lowest X-axis coordinate is emitted first, then the one with the next highest, and so on. The option is available only if at least one of Separate Particles For group check boxes is on. Default=off.

For example, if you want the particles to spell out a word or phrase, use extruded text created in the Front viewport as the reference object, turn on Separate Particles For > Group Elements, but leave Multi-Shape Random Order off.

**Animated Shape** When on, particles use any animation in the reference object, including cyclic animation applied with the Parameter Curve Out-of-Range Types controls. When off, the particles are not animated.

With this option, you can use the Animation Offset Keying controls to specify how to synchronize the reference-object animation with the particles. See the next section.

**NOTE** A particle that uses this option is animated only while in the event containing the Shape Instance operator. If it moves to another event that doesn’t contain a shape operator, it keeps the same shape, but the animation stops. The easiest way to keep the animation going from event to event is to place the Shape Instance operator in the global event on page 8594. Otherwise, you need to place the operator in each event in which the particle should be animated.

**Acquire Current Shape** When on, Particle Flow acquires the particle shape from the reference object as each particle enters the event. Thus, if the reference object is animated, particles that enter at different times get different shapes. However, these shapes are not animated. When the option is off, the shape is acquired from frame 0. Default=off.

This option is available only when Animated Shape is off.
Animation Offset Keying group

These controls are available only when Animated Shape is on.

Sync By Lets you choose how to synchronize reference-object animation with the particles.

- **Absolute Time**  All particles have the same shape at any given moment.
- **Particle Age**  Animation of the reference object is synchronized with particle age: Frame 0 of the reference-object animation corresponds to the frame of each particle's birth.
- **Event Duration**  Frame 0 of the reference-object animation corresponds to the moment the particle enters the event.

Rand Offset When on, randomly varies the start of each particle's animation. Use the numeric setting to specify the number of frames by which the animation start can vary.

Update Particle Shape Refreshes instanced particle shapes from the reference object. Use this after changing an object in a hierarchical reference object. In most cases, Particle Flow automatically updates instanced particles when changes are made to the reference object. However, in some cases, when you change an object deep in a hierarchy, the particle instances might not be updated. In such a case, click Update Particle Shape to refresh the instances.

Uniqueness group

The Uniqueness setting enables changing the randomization of the scale variation, animation offset, and the multi-shape random order.

Seed Specifies a randomization value.

New Calculates a new seed using a randomization formula.

Shape Mark Operator

Particle View on page 3015 > Click Shape Mark in an event or add a Shape Mark operator to the particle system and then select it.

Use the Shape Mark operator to replace each particle with either a rectangle or a box cut out from the particle geometry with an image mapped onto it.
The image can be animated and the animation can be synchronized with particle events.

A typical application of Shape Mark would be to leave marks after particles impact objects in the scene. For example, when a torpedo hits a boat and explodes, you could use Shape Mark to leave scorch marks on the boat surface.

**TIP** By default, the mark left by Shape Mark is always rectangular, no matter what shape the particles are. To leave a differently shaped mark, choose the Shape group > Rectangle option, and use a [material](#) on page 3156 in the same event with transparent areas to define the mark's outline. For example, apply a Mask map to the material's Opacity channel, and to the map's Mask channel, apply a bitmap containing an alpha channel. On the Bitmap Parameters rollout, set Mono Channel Output to Alpha.

**NOTE** With its default settings, the Shape Mark operator can generate coplanar faces, which the mental ray renderer cannot render well. If you want to use mental ray rendering with Shape Mark, adjust the operator's settings as follows:

- In the Shape group, choose Box Intersection.
- Set Surface Offset to 0.01.
- Set Offset Variation to 0.005.
- Set Vertex Jitter to 0.002.

With these settings, faces are no longer coplanar, and the mental ray renderer gives better results.

**See also:**
- [Shape Operator](#)
- [Shape Instance Operator](#)
- [Shape Facing Operator](#)

**Procedures**

**Example: To use Shape Mark:**

1. Determine which object is to receive the marks; this will be the contact object. Apply a deflector to this object.
2 Set up your particle system with an event that causes particles to collide with the contact object deflector.

3 At the end of this event, add a Collision test on page 3236.

4 In the Collision test, designate the deflector from step 1.

5 Create a new event with the Shape Mark operator, and wire the Collision test to this event.

6 In the Shape Mark operator > Contact Object group, designate the object from step 1. Change the other Shape Mark settings as necessary.

   Now, when the particles strike the contact object, they disappear, leaving marks on the object.

   If you want the particles to bounce after leaving marks, rather than disappearing, use a Collision Spawn test on page 3241 instead, and turn off its Delete Parent check box. The spawned particles become the marks, and the original particles remain in the first event.

7 Optionally, add a Material operator to define the surface characteristics of the marks.
Contact Object group

Use this control for defining the object on which marks are to be left.

[button] Click this button, and then select an object in the scene to use as the contact object. The mouse cursor changes to a cross shape when positioned over a valid object.

After picking a contact object, its name appears on the button.

Align to Surface Animation When on, Shape Mark takes into account surface changes due to vertex animation of the contact object. If Shape on page 3154 is set to Rectangle, then the mark changes its orientation and position to appear be stuck to the surface of the contact object. If Shape is set to Box Intersection, then the mark changes shape along with that of the contact object. When off, only transformation of the contact object is taken into consideration. Default=off.

Turn this on only if there is significant vertex animation at the contact point, such as with an animated water surface.

**WARNING** This option requires significant CPU and memory resources.

Orientation group

Align To Depending on the setting for Shape on page 3154, Shape Mark creates either a rectangle or a box cutout on the contact geometry. The Orientation setting specifies how the shape is oriented. In the mark’s local coordinate system, the X axis is Length, the Y axis is Width, and with the box cutout, Z is height. The Z axis is perpendicular to the surface of the object at the contact point.

The alignment choices are as follows:

- **Speed**  The Length direction is parallel to the projection of the particles' speed vector onto the contact plane.

- **Particle X/Y/Z**  The Length direction is parallel to the projection of the particle’s local coordinate axis X, Y, or Z, respectively, as the particle moves toward the contact object.

- **Random**  Uses a random Length direction in the contact plane.

**Divergence** Applies a range of random variation, in degrees, to the orientation of the Length direction. Unavailable when using the Random option.
Size group

Use these settings to specify the coordinate system for setting the size of the mark, as well as the size parameters. The numeric settings in this group are not animatable.

In World Space Sets the absolute size of the mark in system units, using the World coordinate system.

Width/Length With the In World Space option, sets the particle dimensions in system units. Range=0 to 1000000000. Default=1.0.

In Local Space Sets the mark size relative to the existing particle size, in local space. Particle Flow uses the dimensions of the existing shape to determine the size of the “facing rectangle.”

Inherited % Sets the percentage of the mark size, relative to the existing particle size. Range=0 to 100. Default=100.0.

Variation % Sets the percentage by which particle size can vary. Default=0.0.

Impact Angle Distortion When on, increases the Length value of the mark according to the particle's angle of approach. This effectively stretches the mark shape if particle approaches the contact geometry at a low angle. Available only when Align To is set to Speed. Default=off.

For example, if a drop of paint hits a surface perpendicularly, it creates a circular mark, but if it hits the surface at a lower angle, the resulting shape is an ellipse.

Distortion Max % Sets the maximum percentage by which Particle Flow may stretch the mark. Available only when Impact Angle Distortion is on. Default=1000.

With very low angles of approach, the stretching factor can become very high. For example, value 500% means that the stretching factor cannot exceed 5.

Shape group

These settings let you specify the mark-making object as a rectangle or a box. Default=Rectangle.

Rectangle The mark shape is a two-faced rectangle.

When using a material with Shape Mark, always choose this option.

Box Intersection With this option, Particle Flow creates a box for each particle that leaves a mark, and derives the mark shape from a Boolean intersection between the contact object and the box.
**Box Height** Sets the height of the box used with the Box Intersection method. Available only with Box Intersection. Default=10.0.

**Allow Multiple Elements** When on, particles can leave marks on all parts of contact objects that contain multiple elements. When off, a particle marks only the first element it collides with. Available only with Box Intersection. Default=off.

Particles falling onto a two-element cylinder
Left: Allow Multiple Elements is off; Right: Allow Multiple Elements is on.

**Continuous Update** When on, the shape of the mark is recalculated at each frame, according to the current positions of the particle and the contact surface. This option can consume a great deal of CPU time. Available only with Box Intersection.

**Generate Mapping Coords.** Allows correct application of the shape mark when using a mapped material. Default=on.

If you're not using a mapped material, you can save memory by turning this off.

**Pivot Offset %** Shifts the position of the shape mark along its length dimension with respect to the pivot of the impacting particle. Default=0.0. Range=-50.0 to 50.0.

By default, the center of the mark's length dimension coincides with the point where the particle's pivot strikes the contact object. This setting lets you offset the mark's position to anywhere along its length.

**NOTE** The width dimension and the Box Intersection's height dimension are always centered at the intersection of the particle pivot and the contact object's surface.
**Surface Offset**  Specifies the distance of the shape mark above the contact object's surface. Default=0.001.

The mark is slightly elevated above the contact geometry to achieve the visual effect of the mark spot overlapping the contact geometry. This parameter is not animatable.

**Offset Variation**  Specifies the maximum extent of a random variation in the actual surface offset among particles. Default=0.0.

Adjusting this value can help to alleviate rendering artifacts with overlapping marks.

**Vertex Jitter**  Specifies the maximum extent of a random variation in the positions of vertices of marks created using the Box Intersection method. Available only with the Box Intersection method. Default=0.0.

Adjusting this value can help to alleviate rendering artifacts with overlapping marks.

**Uniqueness group**

The Uniqueness setting enables changing the randomization of the size/width variation.

**Seed**  Specifies a randomization value.

**New**  Calculates a new seed using a randomization formula.

**Materials and Mapping in Particle View**

Particle Flow provides three operators for applying materials to particles. To give the same appearance to all particles throughout an event, use **Material Static Operator** on page 3163. If you're using a compound material such as **Multi/Sub-Object** on page 6120, you can assign different sub-materials to different particles with the **Material Frequency operator** on page 3166. And to assign materials that change in appearance over time, use the **Material Dynamic operator** on page 3168.

Related to this is the **Mapping operator** on page 3175, which lets you give the same mapping coordinates to the entire surface of each particle in an event, thus using a single pixel from a material to color the particles. By animating the mapping coordinates, you can cause the particles to change color over time. This is particularly effective with a gradient material.
The Bitmap map on page 6213, used in conjunction with Material Dynamic, lets you assign different frames from an image sequence to particles based on the particle age, among other effects.

Following are some items to keep in mind when using materials with Particle Flow:

- A material is a static property of an event. It does not travel along with the particles from one event to the next. A particle's material ID does, but its material does not. If you want particles always to use the same material, define the material in the global event on page 8594 with a Material operator or a Shape Instance operator on page 3142. Otherwise, you need to define it in each local event.

- The primitive particle shapes available with the Shape operator on page 3137 do not have mapping coordinates. The Mapping operator on page 3175 applies the same mapping coordinates to each particle's entire surface, so it's not suitable in this situation. If you want to apply image-based materials to particles, use Shape Instance on page 3142 instead.

- If you use a Material operator with Shape Instance on page 3142, be sure to apply mapping coordinates to the reference object(s) on page 8700. You can do this by making sure the object's Generate Mapping Coords option is on (if available), or applying a UVW Map modifier on page 1932 or Unwrap UVW modifier on page 1837. If you don't apply mapping coordinates, the system generates a Missing Map Coordinates warning when you render the scene.

- If you use an object with a material already applied as a reference object on page 8700 for instanced particles, you don't need a Material operator in the same event. However, the material appears only in the event containing the Shape Instance operator on page 3142; it does not persist from event to event.

- If you use the Cache operator on page 3178 with Update set to Always, toggling the Material Editor > Show Map In Viewport switch causes Particle Flow to recalculate the cache.

- You can drag a material from the Material Editor to a Particle Flow source icon, but the material will not have any effect on the system. You must use a Material operator or Shape Instance to apply materials to particles in Particle Flow.

- Once you've assigned a material to a Material operator, the material shows up in the Material Editor as “hot”; that is, triangles appear in the corners of its sample slot. However, because of the nature of the Particle Flow data
structure, the Material Editor functions Select By Material and Get Material > Browse From Selected do not work correctly with Particle Flow systems. You can, however, use Get Material > Browse From Scene.

**Mapping Object Operator**

*Particle View* on page 3015 > Click Mapping Object in an event or add a Mapping Object operator to the particle system and then click it.

The Mapping Object operator assigns mapping to particles by taking mapping values from one or more reference objects. For every particle, the Mapping Object operator finds the closest point on reference geometry, takes the mapping values and material ID from this point, and then assigns these values to the particle.

If a particle enters the event with mapping already assigned, you can blend the mapping values to avoid a jump in color. Blending can occur either by time or by distance from the reference geometry.
**Type** Defines the timing used to acquire and apply the mapping. The options are:

- **Once on Event Entry**  Acquires the mapping once, from the closest point on the reference object geometry when the particle enters the event. Use this option if particles are locked to the reference surface.

- **Continuous**  Acquires the mapping continuously during the time a particle is in the current event. If a particle changes location with regard to the reference object, mapping values change according to the closest point at any given time because, in this case, the closest point on the surface is not constant. This option takes significantly longer to calculate, as the closest point has to be computed for every particle on every frame. Use this option only when necessary.

**Acquire Sub-Material Index** When on, the Mapping Object operator assigns the material ID from the nearest face to each particle. If the current event or a previous event has a material operator that uses the reference surface material, this option matches particle coloring to the reference surface. This allows you to blend particles to the reference surface for Multi/Sub-Object materials.

**TIP** Place the Mapping Object operator below a Material operator in the same event. This way, Mapping Object has the final word in assigning the sub-material index to a particle.

**Uniform Color Per Particle** When on, the whole particle gets the same mapping coordinates. As a result, the whole particle is of the same color since the mapping coords are the same across the particle shape. The mapping coordinates are taken from the surface point on the reference geometry nearest the particle pivot point.

When off, a mapping for a particle is a linear approximation of the mapping at the nearest surface point. It's as though mapping from the reference geometry is projected onto the particle. As a result, vertices of a particle have different mapping coordinates, and a texture on a particle represents a patch of texture from the reference geometry. This method is slower because it requires more complex analysis of the reference geometry.

**Mapping From Objects group**

These controls let you assign reference objects, from which particles acquire mapping or material IDs.

[List] Lists reference objects.
Add Adds an object to the list.

By List Displays a dialog where you can select multiple objects from a list.

Remove Removes a highlighted object from the list.

Static Objects Indicates that reference geometry is not animated in any way. In this case, the Mapping Object operator acquires mapping and material IDs only once.

Animated Surface When on, the Mapping Object operator updates the surface data at every frame, which is necessary if the reference geometry has surface animation that causes it to change shape. If the object has transform animation only (move, rotate, scale), leave this option off. This option is available only when Static Objects is off.

Mapping Channels Choose mapping channels to acquire from the reference surface and assign to particles. You can choose up to 32 channels.

Vertex Color Channel Acquires the Vertex Color channel from reference geometry and assigns it to particles.

Mapping Variation group

U/V/W Var % Enables variation of the mapping values assigned. The variation value is a percentage of the standard 0.0-1.0 mapping space. For example, if the U Var % value is 20.0, then the U mapping assigned to a particle can vary by up to 0.2 from the reference geometry mapping U value.

Exclude Tiling Clamps mapping values to the 0.0-1.0 range. Variations set by U/V/W Var % can cause mapping values to go below 0.0 or above 1.0. With non-tiling textures, this can cause a visual jump in coloring. When this option is on, if the original mapping value is below 1.0, then adding the variation won’t make it larger than 1.0. If the original mapping is above 0.0, adding the variation won’t make it smaller than 0.0.

By default, the acquired mapping values are assigned to a particle as soon as it enters the event. If particles have been assigned mapping values in a previous event, a visual color jump can result. Use Blend Mapping By Time or Blend Mapping By Distance to cause particles to smoothly blend between previous mapping and mapping assigned by the Mapping Object operator in the current event.

Blend Mapping By Time Causes particles to blend smoothly between previous and current mapping by time.
NOTE When Blend Mapping By Time is on, Blend Mapping By Distance is unavailable.

Type This option defines the timing used for map blending. It is available only when Blend Mapping By Time is on.

The types are:

- **Absolute Time**  Particles finish the blending process by the time they reach the frame specified by the Finish At Time parameter.

- **Particle Age**  Particles finish the blending process by the time they reach the age specified by the Finish At Age parameter.

- **Event Duration**  Particles will finish the blending process after they spend a specific period of time in the current event, as specified by the Finish At Time parameter.

- **Limited Change Rate**  Limits the rate at which a particle can change its mapping. The Turnaround Time parameter defines the time interval required to change the mapping value from its previous value to the current value. The greater the Turnaround Time value, the longer it takes for a particle to change to the current mapping.

**Blend Mapping By Distance** Causes particles to blend smoothly between previous and current mapping based on the distance from the reference geometry. At every frame, the operator calculates the distance to the closest surface point. As a particle approaches the reference surface, the blending process occurs. The blending is finished when a particle reaches the Finish Distance in relation to the reference surface. Use this option if particles are directed toward the surface upon entry into the event, as with a Find Target operator.

NOTE When Blend Mapping By Distance is on, Blend Mapping By Time is unavailable.

**Show Map In Viewport** Displays map coloring in viewports.

**Uniqueness Group of Controls**

The settings in this group change the randomization of the U Var, V Var, and W Var parameters in the Mapping Variation group.

**Seed** Specifies a randomization value.

**New** Generates a new seed using a randomization formula.
Material Static Operator

Particle View on page 3015 > Click Material Static in an event or add a Material Static operator to the particle system and then select it.

The Material Static operator lets you give particles material IDs that remain constant throughout the event. It also lets you assign a material to each particle based on its material ID. The operator can assign the same material ID to all particles, or different IDs to successive particles on a cyclical or random basis. The most common usage of this latter capability is with a Multi/Sub-Object material, for applying a different material to each particle.

See also:

■ Materials and Mapping in Particle View on page 3156
■ Material Frequency Operator on page 3166
■ Material Dynamic Operator on page 3168

Interface

![Material Static Operator Interface](image-url)
The user interface appears in the parameters panel, on the right side of the Particle View dialog.

**Assign Material** When on, the operator assigns a material to the particles. Default=on.

**button** Use this button to assign a material to the operator. Click the button and then use the Material/Map Browser to choose the material. Alternatively, drag the material from a Material Editor sample slot to the button. After you assign a material to the operator, its name appears on the button.

**Assign Material ID** When on, the operator defines a material ID number for each particle. Default=off.

**Show In Viewport** When on, the material is shown applied to the particles in the viewports.

**Assignment Method**

The Material Static operator gives you a choice of three different methods for assigning Material IDs to particles:

**Material ID** Assigns the same material ID to all particles. Use the numeric field to set the ID value.

**Cycle** Assigns each particle a material ID in the range 1 to N, where N=# Sub-Materials, in increasing sequential order. The first ID assigned is 1, then 2, then ..., then N, then 1 again, and so on.

**Random** Assigns each particle a random material ID in the range 1 to N, where N=# Sub-Materials.

# Sub-Materials The highest ID number assigned to particles using the Cycle or Random option.

In general, set this to the same number of sub-materials in the Multi/Sub-Object material. If you set it to a smaller number, the operator will use only that many sub-materials, starting with the first and counting upward.

**NOTE** Particle Flow automatically sets this value to the number of sub-materials in the material, once only, the first time you apply the material to the operator. Any subsequent changes in the material itself, or applying a different material to the operator, will not change or update the setting.
Rate group

These settings let you choose the basis on which the operator changes material ID assignments, and specify the rate of change.

Per Second Sets the number of times per second that the assigned material ID is incremented. If this value is the same as the rate at which particles enter the event, then one ID is assigned per particle. If it's lower, then multiple particles are given the same ID, or if it's higher, then Particle Flow increments the assigned ID faster than 1 per particle.

For instance, if particles enter the event at intervals of 1/60 of a second, and Per Second=30, then each pair of particles will be assigned the same ID. Or if particles enter the event at intervals of 1/15 of a second, and Per Second=30, then the ID is incremented (or changed randomly) twice per particle.

Per Particle Sets the number of particles that must appear before material ID assignment changes. For example, If you set Per Particle=3, the material ID changes every three particles.

If you set Per Particle to a number less than 1.0, Particle Flow then moves through the sub-material list more rapidly than one (or more) particle per ID. That is, Particle Flow divides this value into 1.0, and adds the result to the current material ID to obtain the next one. For example, with eight sub-materials, if you set Per Particle=0.33, and use the Cycle option, the following series of IDs will result: 1, 4, 7, 2, 5, 8, 3, 6, 1, ... In general, this option is useful only with the Cycle option.

Loop When on, and the last ID has been assigned, Particle Flow loops back around to the first ID and continues the cycle. When off, Particle Flow assigns the last cycle ID to all subsequent particles. Available only with the Cycle assignment method. Default=on.

For example, say you want the first eight particles that enter the event to use different materials, and all subsequent particles to use a ninth material. To do so, you would create a nine-sub-material Multi/Sub-Object material and assign it to the Material Static operator. Turn on Assign Material ID, choose the Cycle assignment method, and set # Sub-Materials=9. For Rate, use the default settings of Per Particle and 1.0. Lastly, turn off Loop.

Uniqueness group

The Uniqueness setting varies the sequence of assigned IDs with the Random option.
**Seed** Specifies a randomization value.

**New** Calculates a new seed using a randomization formula.

---

**Material Frequency Operator**

[Particle View](#) on page 3015 > Click Material Frequency in an event or add a Material Frequency operator to the particle system and then select it.

The Material Frequency operator lets you assign a material to an event, and specify the relative frequency with which each sub-material appears on the particles. Typically, the material is a Multi/Sub-Object or other compound material, and you specify the frequency by setting a percentage for each of up to 10 different sub-materials (or material ID). Particle Flow assigns IDs to particles in a random sequence, based on these percentages. You can also use other materials that use sub-materials, such as Double Sided and Top/Bottom.

See also:

- [Materials and Mapping in Particle View](#) on page 3156
- [Material Static Operator](#) on page 3163
- [Material Dynamic Operator](#) on page 3168
Interface

The user interface appears in the parameters panel, on the right side of the Particle View dialog.

**Assign Material** When on, the operator assigns a material to the particles. Default=on.

[button] Use this button to assign a material to the operator. Click the button and then use the Material/Map Browser to choose the material. Alternatively, drag the material from a Material Editor sample slot to the button. After you assign a material to the operator, its name appears on the button.

**Assign Material ID** When on, the operator defines a material ID number for each particle, and enables the remaining parameters. Default=on.

In general, this should remain on. Particle Flow uses the material ID with compound materials to know which sub-material to assign to a particle.
Show In Viewport  When on, the material is shown applied to the particles in the viewports.

# Sub-Materials  Displays the number of sub-materials in the assigned material.

Material ID #1–10  Specifies the relative likelihood of particles to be assigned the corresponding material ID. Assign values for all IDs, or sub-materials, in the material that you want to have applied to the particles. So, for example, with a Multi/Sub-Object material containing five sub-materials, you'd set values for Material IDs #1-5.

This value is not absolute, but relative to the other settings. To follow the previous example, if you wanted all five materials to appear with equal frequency, you'd set the same nonzero value for Material IDs #1-5; the actual value wouldn't matter. On the other hand, if you wanted the materials to appear with decreasing frequency, you'd set the lower Material ID settings to relatively higher values; say 100, 80, 50, 33, and 10. In this case, each particle would twice as likely to be assigned material ID 1 as it would material ID 3, and one-tenth as likely to be assigned ID 5 as it would ID 1.

The actual sequence of material ID assignments is random, and can be varied by changing the Uniqueness Seed setting.

Uniqueness group

The Uniqueness setting varies the random sequence of assigned IDs.

Seed  Specifies a randomization value.

New  Calculates a new seed using a randomization formula.

Material Dynamic Operator

Particle View  on page 3015 > Click Material Dynamic in an event or add a Material Dynamic operator to the particle system and then select it.

The Material Dynamic operator lets you give particles material IDs that can vary during the event. It also lets you assign a different material to each particle based on its material ID. When used with an animated texture  on page 8505, this lets you assign a different frame or map to each particle based on its total age or the amount of time it has spent in the current event. In this context, one example of an animated texture is a material that uses a multi-frame bitmap, such as an AVI file, as the Diffuse Bitmap map  on page 6213. Other examples of animated textures are materials that use the Particle Age map on
page 6306 or the Particle MBlur map on page 6308. Alternatively, you can use different sub-materials from a compound material such as Multi/Sub-Object.

**NOTE** When using Object Motion Blur, if an event contains a Material Dynamic operator that uses a material with a Particle Age/MBlur/Bitmap map, the event should not also contain a Delete operator, or a Spawn or Collision Spawn test. Also, the event should not contain any tests that are wired to another event. The only exception to this is the Age Test operator when set to Absolute Time without any variation; that is, all particles leave the event at the same time. This applies to the use of Object Motion Blur only; there are no restrictions with Image Motion Blur.

See also:
- Materials and Mapping in Particle View on page 3156
- Material Static Operator on page 3163
- Material Frequency Operator on page 3166

**Procedures**

**Example: To assign animation frames to particles based on age:**

1. Prepare a file to be used as the animated bitmap. This can be a multiple-frame format such as AVI, or an image file list (IFL file) that points to a sequence of still images. With the latter, you can use images in a format such as Targa that contain predefined alpha channels to specify particle opacity selectively.

2. Open the Material Editor, and assign a Bitmap map as the Diffuse map.

3. Use the Select Bitmap Image File dialog to assign the file from step 1 as the bitmap. This dialog appears automatically when you first assign a Bitmap map; alternatively, click the Bitmap button on the map's Bitmap Parameters rollout.

4. On the map's Time rollout, turn on Sync Frames To Particle Age.

5. If you want to use the image background or alpha channel to define transparency, on the Maps rollout, copy this map to the Opacity slot, and set the parameters accordingly.
At the material level, turn on Show Standard Map In Viewport.

Add a camera to the scene and set it up as desired. Activate the Perspective viewport and press the C key to set the viewport to show the camera view.

Create a default Particle Flow system.

Open Particle View.

Replace the Shape operator with a Shape Facing operator. Using this operator makes it easier to see the animation.

Click the Shape Facing operator, and in its rollout, click the Look At Camera/Object button, and then select the camera.

In the Size/Width group, increase In World Space > Units to about 15.

Add a Material Dynamic operator to Event 01, and assign it the material from the beginning of this procedure.

Turn on Show In Viewport.

In the Animated Texture group, make sure Same As Particle ID is chosen, and turn on Reset Particle Age.

Always choose Same As Particle ID with an animated texture, and one of the Sub-Material Rotoscoping options when using a compound material. Turning on Reset Particle Age causes Particle Flow to set particles to age 0 as they enter the event. In this example, the particles are born in the event, so technically it's not necessary to turn on Reset Particle Age. However, it's a good habit to get into to ensure that the animation always plays from the first frame.

Play the animation.

In the viewport, the bitmap animation advances as the particles move, but all the particles show the same frame, regardless of age. This is anomalous behavior related to the limitations of viewport interactivity. The particles render correctly, however.

Render the animation.

As each particle is born, it begins displaying the animation from the first frame. At each frame, each particle's age is incremented, and it displays the next frame from the applied map.
Example: To use the Particle Age map:

The Particle Age map on page 6306 applies up to three different colors or maps to particles throughout their life span, gradually changing from one to the next as the particles age. This effect can be used, for example for sparks flying from a fire: At first they're yellow; then, as they cool down, they turn red, and finally they become gray ashes. In order for Particle Age to know how far a particle has progressed through its life span, the particle has to be given a finite life. You do this using the Delete operator on page 3067.

1. Start or reset 3ds Max, and add a Particle Flow system.
2. Open Particle View and the Material Editor. Position them side by side.
3. In Particle View, add a Material Dynamic operator and a Delete operator to Event 01.
   For Particle Age to work, the Delete operator must be in the same event as the Material Dynamic operator. Alternatively, you can add the Delete operator to the global event on page 8594 so that it affects every event.
4. Click the Delete operator, and in the parameters panel, choose By Particle Age, and set Life Span=100 and Variation=0.
   This gives each particle a life span of 3 1/3 seconds.
5. Click the Material Dynamic operator.
6. In the Material Editor, assign a Particle Age map as the Diffuse map. On the Particle Age Parameters rollout, set three different colors, such as red, green, and blue. Also change the Age percentage values as necessary. For example, if you want each particle to show the second color a third of the way through its life instead of halfway, change Age #2 to 33.
7. Drag the active material from its sample slot to the material button on the Material Dynamic parameters rollout in Particle View. When the Instance (Copy) dialog appears, click OK to accept the default choice: Instance.
8. In the Material Dynamic parameters, make sure Assign Material ID is on.
   If it isn’t, the particles all change color at the same time.
   There’s no need to turn on Show In Viewport; the Particle Age map doesn’t appear in the viewports.
9. Render the animation, or a few representative frames.
   As each particle falls, it gradually changes color, with the oldest particles changing first.
TIP You needn't actually delete the particles to use this method. There are several ways to avoid this. You could set Life Span to a higher number than the length of the animation, and then, in the Particle Age map parameters, lower the Age #2 and Age #3 settings. Or, if you're using a local Delete operator, you could use an Age test on page 3235 to move the particles into another event just before they're scheduled to be deleted. In that case, to avoid an abrupt color change, you might want to add to subsequent events a Material Static operator on page 3163 with a material that uses the same final color or map as the Particle Age map.

Interface

![Interface illustration](image-url)
The user interface appears in the parameters panel, on the right side of the Particle View dialog.

**Assign Material** When on, the operator assigns the specified material (see next parameter) to the particles. Default=on.

[button] Use this button to assign a material to the operator. Click the button and then use the Material/Map Browser to choose the material. Alternatively, drag the material from a Material Editor sample slot to the button. After you assign a material to the operator, its name appears on the button.

**Assign Material ID** When on, the operator defines a material ID number for each particle. Default=on.

In general, this should remain on. Particle Flow uses the material ID with the Particle Age map to find the particle's other properties, including its life span and current age. And it uses the material ID with compound materials to know which sub-material to assign to a particle.

**Show In Viewport** When on, the material is shown applied to the particles in the viewports when the particles are displayed as geometry.

**Assignment Method**

The Material Dynamic operator lets you assign Material IDs to particles in several different ways, depending on whether you're using an animated texture or a compound material. Default=Same As Particle ID.

**Animated Texture group**

**Same As Particle ID** Assigns the same material ID to a particle as its particle ID. Choose this when using a material containing an animated texture, such as a Bitmap, Particle Age, or Particle MBlur map.

**NOTE** Particle Flow assigns Particle IDs consecutively to particles at birth, starting with 0. Although the highest possible Particle ID is over 2,000,000,000, the highest possible material ID is 65535. Thereafter, the numbering sequence starts again at 0. Thus, when using a Particle Age map in a material assigned to the Material Dynamic operator, for best results, use a total of 65,536 particles or fewer.

**Reset Particle Age** When on, sets each particle's age to 0 when it enters the event.

When using an animated material with a Bitmap map, turn this on to ensure that the animation always plays from the first frame.
Randomize Age Offset When on, Particle Flow varies the difference between the particle age and the starting material ID at random. The maximum difference is determined by the Max Offset parameter.

Max Offset The maximum number of frames by which Particle Flow can randomly vary particle age.

Sub-Material Rotoscoping group

These settings let you choose the basis on which the operator changes material ID assignments when using a compound material such as Multi/Sub-Object, and specify the rate of change.

Material ID Assigns the same material ID to all particles. Use the numeric field to set the ID value.

Cycle Assigns each particle a material ID in the range 1 to N, where N=# Sub-Materials, in increasing sequential order. The first ID assigned is 1, then 2, continuing to increment each by 1 until N; then 1 again, and so on.

Random Assigns each particle a random material ID in the range 1 to N, where N=# Sub-Materials.

# Sub-Materials The highest ID number assigned to particles using the Cycle or Random option.
In general, set this to the same number of sub-materials in the Multi/Sub-Object material. If you set it to a smaller number, the operator will use only that many sub-materials, starting with the first and counting upward.

NOTE 3ds Max automatically sets this value to the number of sub-materials in the material, once only, the first time you apply the material to the operator. Any subsequent changes in the material itself, or applying a different material to the operator, will not change or update the setting.

Rate Per Sec(ond) Sets the number of times per second that the assigned material ID is incremented. If this value is the same as the rate at which particles enter the event, then one ID is assigned per particle. If it's lower, then multiple particles are given the same ID, or if it's higher, then Particle Flow increments the assigned ID faster than 1 per particle.
For instance, if particles enter the event at intervals of 1/60 of a second, and Per Second=30, then each pair of particles will be assigned the same ID. Or if particles enter the event at intervals of 1/15 of a second, and Per Second=30, then the ID is incremented (or changed randomly) twice per particle.
Loop When on, and the last ID has been assigned, Particle Flow loops back around to the first ID and continues the cycle. When off, Particle Flow assigns the last cycle ID to all subsequent particles. Available only with the Cycle assignment method. Default=off.

For example, say you want the first eight particles that enter the event to use different materials, and all subsequent particles to use a ninth material. To do so, you would create a nine-sub-material Multi/Sub-Object material and assign it to the Material Dynamic operator. Choose the Cycle assignment method, and set # Sub-Materials=9. Set the Rate Per Sec value to the rate at which particles enter the event. Lastly, turn off Loop.

Sync By Choose the time frame for applying animated parameters. Available only with the Material ID and Cycle options.
- Absolute Time Any keys set for parameters are applied at the actual frames for which they're set.
- Particle Age Any keys set for parameters are applied at the corresponding frames of each particle's existence.
- Event Duration Any keys set for parameters are applied to each particle starting when it first enters the event.

Rand Offset When on, Particle Flow varies the difference between the particle age and the assigned material ID at random. The maximum difference is determined by the numeric parameter. Available only with the Material ID and Cycle options.

Uniqueness group
The Uniqueness setting varies the sequence of assigned IDs with the Random option, and the offset with the Randomize Age Offset option.
Seed Specifies a randomization value.
New Calculates a new seed using a randomization formula.

Mapping Operator
Particle View on page 3015 > Click Mapping in an event or add a Mapping operator to the particle system and then select it.

The Mapping operator lets you assign a constant UVW mapping to the entire surface of the particles. It works in conjunction with a map specified in a material operator in the current event. By animating the mapping coordinates,
you can vary the location on the material map from which the particle color is taken, thus changing the particle color in a predictable way over time.

The Mapping operator was designed primarily to be used with gradient maps, although you can use it with any map you like. The procedure below describes a recommended method for using the Mapping operator.

See also:

- Material Static Operator on page 3163
- Material Frequency Operator on page 3166
- Material Dynamic Operator on page 3168

Procedures

Example: To animate particle coloring using the Mapping operator:

1. Open the Material Editor, and create a material that uses Gradient Ramp as the Diffuse map.
2. On the map’s Gradient Ramp Parameters rollout, make sure Gradient Type is set to Linear.
3. Create a colorful gradient. The Mapping operator uses the colors in left-to-right order as the U value increases from 0.0 to 1.0.
4. Add a Particle Flow Source object to the scene.
5. Open Particle View.
6. In Event 01, click the Speed operator and set Speed to 100.
7. In Event 01, click Display and set Type to Geometry.
8. Add a Material Static operator to Event 01, and then click the operator in the event.
9. Drag the material you created from its Material Editor sample slot to the button (labeled “None”) on the Material Static parameters rollout in Particle View.
10. Add a Mapping operator to Event 01, and then click the operator in the event.
11. On the Mapping rollout in Particle View, turn on Show Map In Viewport.

12. Go to frame 100 and turn on Auto Key.

13. On the Mapping rollout in Particle View, set Map Values > U=1.0.

14. For Sync By, choose Particle Age.

15. Turn off Auto Key, and click Play Animation.

As each particle is born and falls, its U mapping coordinate gradually changes from 0.0 to 1.0, while its color changes to match the corresponding position across the Gradient Ramp map.

To vary the effect, try changing the Gradient Type setting, and animate the V and W values as well. Or, for more sophisticated effects, assign animation controllers such as Noise Float to the Mapping coordinate values, or wire them to other changing parameters in the scene (Animation menu > Wire Parameters > Parameter Wire Dialog).

**TIP** In the Material Editor, it’s easier to see the result of the Gradient Type choice if you set Sample Type to Cube.

**Interface**

The user interface appears in the parameters panel, on the right side of the Particle View dialog.
Map Values group

U/V/W Set the coordinates on the map from which the particle color is taken. One pixel from this location is used to color the entire particle.
In general, U and V represent the horizontal and vertical dimensions, respectively, beginning at the upper-left corner of the map, and W is useful only with three-dimensional maps, in which context it specifies depth.

Sync By Choose the time frame for applying animated parameters. For further information, see Animation Offset Keying group on page 3106.
- Absolute Time Any keys set for parameters are applied at the actual frames for which they’re set.
- Particle Age Any keys set for parameters are applied at the corresponding frames of each particle’s existence.
- Event Duration Any keys set for parameters are applied to each particle starting when it first enters the event.

Channel group

The Channel setting determines whether the mapping is applied to a map channel or to a vertex color channel.

Map Channel The mapping is applied to the specified map channel.

Vertex Color Channel The mapping is applied to the particles’ vertex color channel.

Show Map In Viewport The map coloring is visible in the viewports.

Additional Operators

The operators described in this section are utilities to help you manage Particle Flow systems.

Cache Operator

Particle View on page 3015 > Click Cache in an event or add a Cache operator to the particle system and then select it.
The Cache operator records and stores particle states to memory. This is particularly useful with large or complex particle systems, where playback, and particularly backtracking, are slow because of the large amount of processing required.

When Cache is in effect, the first time you play or go to a frame, the particle motion up to and including the frame is calculated and recorded in the cache. Thereafter, playing the frame or any previous frames uses the data in the cache, rather than recalculating the particle action. With caching on, the particle system needs to be calculated only once for each frame, and thereafter playback and moving among frames is significantly faster.

To cache an entire flow, add a Cache operator to the global event. To cache an individual local event, add a Cache operator to it.

To determine how best to implement caching in your particle system, turn on Particle View > Track Update > Update Progress, and then play the animation or go to a frame relatively distant from the current frame. Observe the particle diagram, and watch for events with actions that highlight longer than a fraction of a second, or events with more activity than the rest. Any such events could benefit from caching.

**NOTE** Use no more than one Cache operator per event, unless you’re using two: one set up for viewports, and the other for rendering. Similarly, don’t use global and local Cache operators in the same flow, unless one is set up for viewports, and the other for rendering.

**TIP** When using real-time playback, if playback isn’t fast enough, you can use the Cache operator to speed it up. For best results, set the Viewport integration step to the same value as the real-time playback speed, and set cache sampling to Integration Step. For example, if the real-time playback speed is set to 1/4x, then the Viewport Integration Step for viewport should be also set to 1/4 Frame, and the Cache operator Sampling parameter should be set to Integration step. Thus, because real-time playback is showing four times as many frames per second, and the Cache operator has stored four times as many frames per second, the two are synchronized. If the real-time playback speed is set to 2x or 4x, set the Viewport Integration Step to Frame.

**Procedures**

**Example: To use the Cache operator:**

1. Start or reset 3ds Max, and then add a Particle Flow system.
2. Open Particle View.
3 In Particle View, go to Options menu > Track Update and turn on Update Progress.
This lets you monitor calculation of the particle system by highlighting actions in Particle View as the system executes them.

4 In Particle View, Add a Keep Apart operator on page 3131 to Event 01. Keep Apart is a fairly calculation-intensive operator.

5 Go to frame 100 by clicking the right end of the time slider track. There is a delay as the system calculates all particle motion between frames 0 and 100. This is necessary because Particle Flow is a history-dependent system. At the same time, the actions in the system highlight briefly in Particle View as they're executed at each frame.

6 Go to frame 50 by clicking the center of the time slider track. There is another delay as the system calculates all particle motion between frames 0 and 50.

7 In Particle View, drag a Cache operator from the depot to Event 01. Insert it anywhere in the event. When you release the mouse button, there is a delay as the Cache operator automatically caches particle motion from the start of the animation to the current frame. Meanwhile, each action highlights briefly at each frame.

8 Go to frame 20 or so. The only operators that highlight are Cache (very fast) and Display; there is no delay for calculation. All frames between 0 and 50 have been cached.

9 Go to frame 100. The delay this time is a result of caching particle motion for frames 50 to 100.

10 Jump to different frames, and drag the time slider. All particle motion is now cached, so no delays occur. But if you change a setting's value, the Cache operator automatically recalculates and stores the particle motion.

11 Go to frame 100, and then, in Particle View, click the Keep Apart operator and use the keyboard to change the Falloff Zone value to 8.0. By default, the Cache operator automatically updates the cache when you change any parameters it stores. Thus, when you change the Falloff Zone value at frame 100, it recalculates and recaches the entire animation.
Next, you'll briefly explore how manual caching works.

12 Click the Cache operator and set Update to Manually.
   The Cache operator no longer updates the stored data automatically when you change a parameter.

13 Click the Keep Apart operator, change the Falloff Zone value to 9.0, and then drag the time slider.
   There is no delay, because the animation is still playing back from the cached data. However, the cached data is now invalid, because you changed a parameter in the particle system.

14 Click the Cache operator, and in the Manual Update group, click Update.
   3ds Max closes Particle View, updates the cache for the active segment, and then reopens Particle View. The cached data is now accurate.
   Other manual update options let you update the cache for the entire animation or a custom frame range.
   As you can see, the Cache operator is quite powerful. When present and active, by default it overrides recalculation of the particle system, except when you change any action parameters, whereupon it automatically updates the cached data. Used appropriately, it can save a good deal of time in setting up and testing particle systems.
The user interface appears in the parameters panel, on the right side of the Particle View dialog.

**Use At** Caches particle motion when playing back in the viewports, or at render time, or both. Default = Viewport.

**IMPORTANT** Choose the Viewport/Render option only when using the same number of particles in the viewports and for rendering (see Quantity Multiplier group on page 3038). Otherwise, unpredictable results can occur.
Update If you change a parameter in the particle system, the cached data might become invalid. This setting determines whether Particle Flow should update the cache automatically, or let you do it manually. Default=Always.

- **Always** Changing any parameter under the Cache operator's purview causes it automatically to update stored data from the start of the current range (see next parameter) to the current frame.

- **Manually** Updating occurs only when you click the Update button, or clear the cache and then move to a different frame.

**Range** Sets the frame range within which the Cache operator operates. Default=Active Segment.

- **Complete** Particle Flow caches the entire animation.

- **Active Segment** Particle Flow caches only frames in the active segment, as defined by the Start Time and End Time settings on the Time Configuration dialog. This is the frame range shown on the track bar. You can also change the active segment by holding down Alt and Ctrl and dragging the track bar with the left, middle, or right mouse button.

- **Custom** Particle Flow caches only frames in the custom range, as defined by the Cache operator's Start Time and End Time settings (see following).

**NOTE** If you cache only part of the animation, Particle Flow calculates particle behavior in subsequent, non-cached frames using the cached data. For example, if you cache frames 0 to 50, and then jump to frame 60, Particle flow will calculate frame 51 based on the cached data, and frames 52 to 60 based on each previous frame.

**Start/End Time** The first and last frames of the range considered for caching when Range=Custom (see above). Default=0, 30.

**NOTE** The frame range time frame is in absolute time; that is, in terms of the entire animation. If you use a Cache operator locally, and specify a frame range during which no particles are present in the event, Particle Flow won’t use the cache.

**Sampling** Determines how often the Cache operator samples and caches the animation. Default=Every Frame.

- **Every Frame** Particle Flow caches animation data once per frame.

- **Integration Step** Particle Flow caches animation data at each integration step, using the Integration Step setting as specified in the Use At setting.
(see above). If Use At is set to Viewport/Render, it uses lower of the two Integration Step values. For example, if Viewport is set to Half Frame, and Render to 1/8 Frame, the sampling rate would be eight per frame.

■ **Every Nth Frame**  Particle Flow caches animation data at frame intervals specified by the N value, below.

N Determines the frame interval for caching when Sampling (above) is set to Every Nth Frame. Default=5.
For example, with N set to the default value of 5, the cache stores animation data for every fifth frame.

**Cache Test Results**  When caching particle data, this caches the results of test actions as well. Default=on.
This is important if Cache is used as a local operator, and the next event doesn’t have a Cache operator. For the next event to work properly, it should receive particles from the current event. Those particles result from the activity of a test action. The Cache operator can record the test activity to play it back later.
If the Cache operator is used as a global operator, there is no need to cache the test results. This is because the system has cache data for every event, and is able to jump to an arbitrary frame without the need for test results.

**Save Cache with File**  When on, Particle Flow Includes the cached data with scenes that you save to disk. This can significantly increase the size of saved files, but saves the time of recalculating the particle motion upon reloading the file. Default=off.
Normally, the cached data is saved only in disk files that you create with the Save or Save As commands. You can also instruct 3ds Max to include cached data with other types of files using the two following options.

**Save Cache with Hold**  Saves cached data in the Hold file, created with Edit menu > Hold. Default=off.

**Manual Update group**

These controls let you update or clear the cache manually within a frame range, or clear the entire cache.

**Update**  Calculates particle motion within the current range (defined below) and stores it in the cache, replacing any existing cached data. Available only when Range is set to Active Segment or Custom.
During the update, 3ds Max temporarily closes Particle View and displays a Cache Update Progress bar, while moving the time slider through the cached
range. At the same time, by default, the animation plays in the viewports. To prevent this, and speed calculation, turn off Update Viewports.

If the cache runs out of memory during a manual update, Particle Flow halts the update operation and displays an alert. Click OK to continue, and then, if possible, increase the Limit value before updating the cache again.

**Clear** Deletes any cached data.

After you clear the cache buffer, if you go to a different frame or change any action parameters, Particle Flow automatically caches particle motion even if Update is set to Manually.

**Range** Sets the frame range within which the Cache operator recalculates data when you click Update. Default=Active Segment.

- **Complete** Particle Flow clears the cache for the entire animation. Choosing Complete makes the Update button unavailable; this option is for clearing the cache only.
  
  To update the entire animation, set the active segment or the custom range to encompass all frames, and then use the corresponding choice and click Update.

- **Active Segment** Particle Flow updates the cache only for frames in the active segment, as defined by the Start Time and End Time settings on the Time Configuration dialog. This is the frame range shown on the track bar. You can also change the active segment by holding down Alt+Ctrl and dragging the track bar with the left, middle, or right mouse button.

- **Custom** Particle Flow updates the cache only for only frames in the custom range, as defined by the Start Time and End Time settings (see following).

**Start/End Time** The first and last frames of the range that’s updated when Range=Custom (see above). Defaults=0, 30.

**Update Viewports** When on, the animation plays in the viewports during manual updating of the cache. Turn this off to disable playing the animation in the viewports during manual caching; this can speed up the caching process, especially with large or complex particle systems. Default=on.

**Memory Used (K) group**

The Cache operator stores data in system memory; you can specify an upper limit for the amount of memory it uses. If the Limit setting and the amount of cached data exceeds the available free memory, the computer system might
use virtual (hard disk-based) memory instead, which slows down the caching. If Particle Flow fills the cache, any remaining frames are calculated on the fly. This group also lets you monitor the amount of memory used for caching data.

**Limit** The maximum amount of system memory used to cache particle data, in kilobytes. Default=100,000, or 97.6 MB.

**Total** The amount of memory currently used by the cached data, in kilobytes. Read-only.

**NOTE** Even animation frames with no particles will probably consume a certain amount of cache memory. The reason for this is that the cache also stores states for randomly calculated values such as Variation, to ensure that particle activity is consistent across a rendering network, and with machines that might not have regular access to all frames.

**Current Frame** The amount of memory used by the data cached for the current frame, in kilobytes. Read-only.

### Display Operator

**Particle View** on page 3015 > Click Display in an event or add a Display operator to the particle system and then select it.

The Display operator lets you specify how particles appear in the viewports. The default display mode is Ticks, which is the simplest, and thus the fastest to display. It’s useful for animations that use a large number of particles. At the opposite end of the complexity spectrum is the Geometry option, which lets 3ds Max depict particles as their actual shapes. In addition, the Display operator provides a variety of simple shapes that provide fast feedback in testing animation, as well as the ability to easily distinguish among particles in different events. It also lets you set the percentage of visible particles.

By default, Particle Flow automatically inserts a new Display operator in each local event you add to the system. Alternatively, you can choose Particle View > Options menu > Default Display > Global. With this option, Particle Flow automatically inserts a Display operator in new global events, but does not add one to new local events.

Particles in any local event that doesn’t contain a Display operator don’t appear in the viewports, unless an associated global event contains a Display operator (that is, a global Display operator). If a particle is affected by multiple Display
operators (for example, both global and local operators) simultaneously, 3ds Max generates all viewport particle representations at the same time.

See also:

- Render Operator on page 3194

Interface

The user interface appears in the parameters panel, on the right side of the Particle View dialog.

Type Choose how particles appear in the viewports. The two-dimensional particle markers depict position only. Geometry shows how particles will actually render, in three dimensions; Lines shows speed and direction of motion; and Bounding Boxes reflects scale and orientation.

In the following list, each choice's description is preceded by the number of dimensions used by each particle representation:

- **None**  
  Particles do not appear in the viewports.

- **Dots** (0D)  
  Each particle appears as a single pixel.

- **Ticks** (2D)  
  Each particle appears as a + sign.

- **Circles** (2D)  
  Each particle appears as a small circle.

- **Lines** (1D)  
  Each particle appears as a line, one pixel thick. The line's length indicates particle speed, and its orientation reflects the direction of motion. Use this option for fast, accurate feedback when experimenting with the Speed operators.
TIP When using the Lines display type with the OpenGL display driver, slow-moving particles might not appear properly in the viewports. In such cases, to see all particles, add a second Display operator in the same event and set its Type to Dots.

- **Bounding Boxes** (3D) Each particle appears as a bounding box. Use this option for a good representation of the final animation, at a slight cost in computational speed.
- **Geometry** (3D) Each particle appears as its actual geometry. Use this option for the best representation of the final animation, at the greatest cost in computational speed.
- **Diamonds** (2D) Each particle appears as a diamond.
- **Boxes** (2D) Each particle appears as a small square.
- **Asterisks** (2D) Each particle appears as an asterisk (*).
- **Triangles** (2D) Each particle appears as a small triangle.

**Visible %** Specifies the percentage of particles visible in the viewports. This option lets you speed up viewport redrawing by reducing the number of visible particles.

**Show Particle IDs** When on, each particle's unique index number is visible in the viewports. Particles are numbered in the order of their birth, starting with 1 for the first particle born.

[**[color swatch]**] Shows the color for particles displayed using options other than Geometry, as well as for the particle IDs. Particle Flow chooses a different color at random for each Display operator added to the system. In addition to the Type options, using different colors helps to distinguish among particles in different events.

To change the color, click the color swatch and use the Color Selector dialog to choose a new color.

If a system has a global Display operator, and you select its Source icon in a viewport, then you can change the color of the global Display operator from the color swatch on the Modify panel. However, changing the global Display operator's color in Particle View does not change the color of the swatch on the Modify panel.
NOTE When a Particle Flow source icon is selected, all of its non-selected particles, other than those shown as geometry, are colored white in the viewports. To see all assigned particle colors, deselect the particle system.

Selected Choose how selected particles appear in the viewports. The choices are the same as for Type, above.

**Force Operator**

**Particle View** > Click a Force operator in an event or add a Force operator to the particle system and then select it.

The Force operator lets you influence particle motion with one or more space warps from the Forces category. Use this operator along with different forces to simulate the effects of wind, gravity, and so on.

The following force space warps work with the Force operator:

- **Displace** on page 2930
- **Drag** on page 2908
- **Gravity** on page 2923
- **Motor** on page 2898
- **PBomb** on page 2914
- **Push** on page 2894
- **Vortex** on page 2903
- **Wind** on page 2926

**NOTE** By default, the influence of these space warps on Particle Flow particles is equivalent to their influence on the 3ds Max 2 particle systems: PArray, Super Spray, Blizzard, and PCloud. To obtain an influence on Particle Flow particles equivalent to that of the 3ds Max 1 particle systems Snow and Spray, set **Influence** on page 3192 to **100.0**.

**TIP** To make the particles follow a path, use the **Speed By Icon operator** on page 3112 and use Path Constraint to assign its icon to the path. For a procedure, see **Example: To send particles along a path** on page 3114.
To employ deflectors for particle dynamics, with or without the Force operator, use the Collision test on page 3236 and Collision Spawn test on page 3241.

**Script Wiring rollout**

This rollout appears in the parameters panel below the main operator rollout after you highlight the operator, right-click it, and then choose Use Script Wiring. Thereafter, a check mark appears next to the Use Script Wiring in the right-click menu, and the rollout appears whenever you highlight the operator. To turn off script wiring, choose Use Script Wiring again from the right-click menu.

Script wiring lets you use a script to control parameters that you normally specify in the operator's parameters. Place a Script operator on page 3196 before the Force operator in the event, and then use it to define values in the particleFloat channel. You'll find an example script below.

**Use Script Float As** Choose either of the following:

- **Not Used**  Particle Flow uses the Influence setting on page 3192 specified in the Parameters rollout.

- **Influence**  Particle Flow applies the script to the Influence setting.

**particleFloat Sample Script**

**NOTE**  See this topic in the online User Reference for the particleFloat sample MAXScript code.

**Procedures**

**To affect particle motion with force space warps:**

1. Add one or more force space warps to the scene, and set them up as necessary.

2. In Particle View, add a Force operator to any events in which particles are to be affected by the forces. To affect particles in all events, add the Force operator to the PF Source instead.

3. Highlight the Force operator, and then use the Add or By List button to apply the force space warps to the operator.
Interface

The user interface appears in the parameters panel, on the right side of the Particle View dialog.

**Force Space Warps group**

This group displays the forces currently in effect, and let you add and remove forces.

[List] Shows the forces that apply to this operator. If more than three forces apply, a scroll bar appears at the right side of the list.

If you delete a listed space warp from the scene, its name is replaced in the list by the entry “<deleted>”.

**NOTE** Particle Flow applies the forces to particle motion in the order in which the space warps appear in the list; the effect is cumulative in top-to-bottom order. First, the topmost space warp is applied to particle motion, then the second space warp is applied to the result of the first space warp, and so on. Changing the order can alter the final result.

Add Click this button, and then select a force space warp in the scene to add it to the end of the list.
By List  Click this button, and then use the Select Force Space Warps dialog to add one or more space warps to the list. The space warps must already exist in the scene.

Particle Flow adds space warps to the list in same order in which they appear in the dialog. To effect a different order, use the Add button to add them one at a time.

Remove  Highlight a space warp in the list, and then click this button to remove it from the list. Any removed space warps remain in the scene.

Force Field Overlapping  Determines how multiple forces that occupy the same volume of space affect the particles. With Additive, the forces are combined according to their relative strengths. With Maximum, only the force with the greatest strength affects the particles.

For example, you might apply Wind and Gravity space warps to particles, and set their Strength parameters to 1.5 and 1.0, respectively. If you choose Additive, the Wind space warp will have approximately 50 percent more influence over the particles than the Gravity space warp. But if you choose Maximum, only the Wind space warp will affect the particles.

Influence  Specifies the strength with which the force or forces are applied to the particles as a percentage. Default=1000.0.

A negative Influence value reverses the force effects.

NOTE  By default, the influence of the Force space warps on Particle Flow particles is equivalent to their influence on the 3ds Max 2 particle systems PArray, Super Spray, Blizzard, and PCloud. To obtain an influence on Particle Flow particles equivalent to that of the 3ds Max 1 particle systems Snow and Spray, set Influence=100.0.

Offset Influence group

Choose the time frame for applying animated parameters. For an explanation, see Animation Offset Keying group on page 3106.

Sync By  Choose the time frame for applying animated parameters:

■ Absolute Time  Any keys set for parameters are applied at the actual frames for which they’re set.

■ Particle Age  Any keys set for parameters are applied at the corresponding frames of each particle’s existence.

■ Event Duration  Any keys set for parameters are applied to each particle starting when it first enters the event.
Notes Operator

Particle View on page 3015 > Click Notes in an event or add a Notes operator to the particle system and then select it.

The Notes operator lets you add a textual comment to any event. It doesn’t have any direct effect on the particle system, but it helps you keep track of the overall function of each event.

NOTE You can also add a comment directly to an event or action by right-clicking it and choosing Comments.

Interface

The user interface appears in the parameters panel, on the right side of the Particle View dialog.

The interface is a simple text box. Click in the box and enter your text.
Render Operator

Particle View on page 3015 > Click a Render operator in an event or add a Render operator to the particle system and then select it.

The Render operator provides controls related to rendering particles. You can specify the form that rendered particles are to take, and how to convert the particles to individual mesh objects for rendering purposes.

**Interface**

![Render Operator Interface](image)

The user interface appears in the parameters panel, on the right side of the Particle View dialog.

**Type** Lets you render particles as bounding boxes or geometry, or disable the particle system at render time, or enable the particle system but prevent it from sending renderable particles to the 3ds Max renderer. Default=Geometry.

- **None**  The particle system (or event, if used locally) is considered non-renderable, and therefore is never evaluated during render.

- **BoundingBox**  Particles render as boxes whose sizes represent the particle geometry extents. Use this option with complex particle systems to speed up test renders.

- **Geometry**  Particles render with their actual geometry. Use this option with simpler particle systems, and for the final render.

- **Phantom**  Use this option when you want Particle Flow to function normally, calculating the animation at each frame, but not to render geometry directly. An example would be when you're using a Final Step...
Update script on page 3043 to pass data from the particle system to other objects in the scene.

Visible % The percentage of particles that render. Range=0 to 100. Default=100. Lower this value for faster rendering of complex particle systems. You can also reduce the number of particles in the system at render time with the Quantity Multiplier > Render setting on page 3038.

**Render Result group**

These settings determine how the system converts particles to mesh format for rendering. By default, 3ds Max renders all particles as a single mesh per event, which provides for the most efficient operation under most conditions. However, in some situations each particle should be converted to an individual mesh object by turning on Mesh Per Particle. For example, with particles each of whose face count exceeds 10,000, it’s most efficient to render a mesh per particle. Alternatively, you can opt to combine particles into multiple meshes by specifying a face count and number of particles per mesh.

Certain renderers might require a non-default setting for Render Result. Consult the renderer documentation for further information.

---

**NOTE** The number of particles Particle Flow can handle per frame is limited only by system resources, but each single mesh is allowed a maximum of 5,000,000 faces or vertices. If the total number of faces or vertices in a mesh exceeds 5,000,000, Particle Flow ignores particles beyond this limit.

**Single Mesh** Sends the renderer one mesh object comprising all particles in the system.

**Multiple Meshes** Sends the renderer the specified number of mesh objects, each containing the specified number of particles. If the result of dividing the total number of particles by the Particles p/Mesh value is less than the specified Mesh Count value, some of the meshes might contain few or no faces. This is a compromise method of operation, and can be used with renderers that cannot handle all particles in a single mesh, but can deal with groups of particles of a certain size.

**Mesh Count** The maximum number of mesh objects that Particle Flow will send to the renderer.

**Particles p/Mesh** The number of particles that each mesh object will comprise.

**Mesh Per Particle** Sends the renderer a separate mesh for each particle.
This is the least efficient method of operation, but might be required by certain renderers.

NOTE With the default scanline and mental ray renderers, this method does not support rendering of particles born after the start of the rendered frame sequence. In general, use Mesh Per Particle only with renderers that require it.

**Script Operator**

*Particle View* on page 3015 > Click Script Operator in an event or add a Script Operator to the particle system and then select it.

The Script operator enables control of particles within the Particle Flow system using a MAXScript script. The script can use any program functionality available to MAXScript.

When you add a new Script operator, it contains a default script that slows particles, and then, when they are slow enough, splits off the first 50 particles into a stream traveling in a negative direction on the world X axis, and the remainder traveling in the opposite direction.

**TIP** You can use MAXScript to align particle scale with the underlying bitmap, thus providing a “scale bitmap” function. This requires a sandwich with three operators: two Script operators, and a Speed By Surface operator in between. The first Script operator reads the current speed vector into the MXVector channel, thus caching the current speed. The Speed By Surface operator changes the speed according to the underlying bitmap. And the second Script operator reads the speed channel into a temporary variable, restores the speed from the MXVector channel (the cached value), and uses the temporary variable to define the scale. This way, the original speed is restored, and the scale value is defined by the bitmap.

**Interface**

![Script Operator Interface](image)
The user interface appears in the parameters panel, on the right side of the Particle View dialog.

**Edit Script** Click this button to open the current script in a MAXScript Editor window.

For detailed information about the MAXScript utility, open the MAXScript Help, available from Help menu > MAXScript Help.

**Uniqueness group**

The Uniqueness setting provides a randomization seed that the script can use or ignore.

**Seed** Specifies a randomization value.

**New** Calculates a new seed using a randomization formula.

**Painting Particles**

New in Particle Flow is the ability to generate particles from specific locations by “painting” particle generators, or seeds, on object surfaces. The toolset for doing so includes the Particle Paint helper and the Placement Paint operator.

**Particle Paint**

The Particle Paint toolset lets you use a spray-paint metaphor to specify arbitrary areas of object surfaces for emitting particles. To paint particles, you first apply particle “seeds” to one or more objects with the Particle Paint helper, and then use other controls to specify how the seeds should generate particles.

**Particle Paint Helper**

Create panel > Helpers > Particle Flow > Particle Paint

The Particle Paint helper enables you to apply particle seeds with a specific pattern and timing onto the surface of one or more objects.
Particle seeds painted with the Particle Paint helper are not particles, but are seeds that can be turned into particles with the Birth Paint or Placement Paint operators in Particle Flow.

You can spray particle seeds with a freehand painting tool, or by using 3ds Max splines to define the pattern. Particle Paint works in any orthogonal viewport such as a Front or Top view. It sprays directly into the viewport (that is, perpendicular to the plane of view), and plants particle seeds on the surface of first object that it hits.

**Particle Paint Icon**

To create the Particle Paint icon, click Create panel > Helpers > Particle Flow > Particle Paint, and then drag in a viewport.

The Particle Paint icon is composed of two parts: a circle and a spray can icon.

The Particle Paint helper uses the metaphor of a real-world airbrush to spray-paint particle seeds onto a surface. When you use the Freehand paint tool, particle seeds are sprayed through a virtual nozzle, as with an airbrush. The circle in the Particle Paint icon represents the size of the nozzle. If, on the other hand, you use stroke splines, the particle seeds are sprayed along the spline.

The Particle Paint icon does not have to sit in front of or on the objects on which you plan to paint particle seeds, nor does it have to be created in the viewport in which you plan to paint.

Deleting the Particle Paint icon deletes all particle seeds and strokes associated with it.
Strokes

The Particle Paint helper works with particle groupings called *strokes*. With a real-world airbrush, each time you depress the nozzle, spray, then release the nozzle, you create a stroke. With the freehand tool, you can drag across objects several times to create strokes. With the spline method, you can pick several splines to create different strokes.

Each set of strokes stored with the Particle Paint helper can be used as a series of birth instructions with the “Birth Paint” on page 3222 and “Placement Paint” on page 3224 operators in Particle Flow. You can work with each stroke separately to adjust its timing, delete some of its particles, and perform other operations. To edit particle seeds and strokes after creating them, select the Particle Paint helper and then access the Editing rollout on the Modify panel.

You can undo the creation of strokes, and you can also delete particle seeds or change particle seed timing with the options on the Editing rollout. You can also restart by deleting the Particle Paint helper and creating a new one.

Procedures

**Example: To create strokes with freehand painting:**

1. Create a sphere in the Top viewport.
2. Click Create panel > Helpers > Particle Flow > Particle Paint, and drag in any viewport to create the Particle Paint helper.
3. With the Particle Paint helper selected, go to the Modify panel.
4. On the Setup rollout, click Freehand Paint.
5. In the Front viewport, position the mouse cursor over the sphere. A set of nozzle crosshairs appear, indicating that Particle Paint is ready to paint.

   **NOTE** You can create freehand strokes only in orthographic viewports.

6. Drag the nozzle crosshairs over the sphere for a few seconds, then release. After you release, the particle seeds appear as +-shaped tick marks on the object surface.
   
   You have just created one stroke.
7. Move the time slider to a later frame.
8. Drag the nozzle over a different part of the sphere to create another stroke.
9. Click the Freehand Paint button to turn it off.
10  On the Editing rollout, turn on Show Particle Timing.
11  Drag the time slider to see the particle timing.

   As you drag the time slider, the particle seeds change color as they become eligible for birth. You will see the second stroke begin at the frame to which you moved the time slider before making the stroke.

To create strokes with splines:

1  Create a 3D object in any viewport.
2  In the Front viewport, create two splines, such as a line and a circle. Place the splines so they overlap the 3D object when viewed in the Front viewport.

   The splines don’t have to actually be in front of the 3D object in 3D space. But because Particle Paint will project the splines onto the object to create particle seeds, the splines must overlap the 3D object when viewed in the viewport.
3  Click Create panel > Helpers > Particle Flow > Particle Paint, and create the Particle Paint helper in any viewport.
4  With the Particle Paint helper selected, go to the Modify panel.
5  On the Setup rollout, click Pick Stroke Spline.
6  Activate the Front viewport.
7  With the time slider at frame 0, click one of the splines in the Front viewport.

   This creates the first stroke.
8  Move the time slider to a later frame, and click another spline.

   This creates a second stroke, starting at the current frame.
9  Click Pick Stroke Spline again to turn it off.
10  On the Editing rollout, turn on Show Particle Timing.
11  Drag the time slider to see the particle timing.

   As you drag the time slider, the particle seeds change color as they become eligible for birth. You will see the second stroke begin at the frame to which you moved the time slider before picking the second spline.
Interface

The controls on the Setup, Orientation, and Mapping rollouts set parameters for particle seeds upon creation. These settings go into effect when you create the particle seeds with the freehand or spline tool. Changing the parameter values after you create particle seeds has no effect on the seeds. After particle seed creation, you can change some aspects of seeds and strokes with the Editing rollout settings.

The Particle Paint rollouts are as follows:

Setup Rollout (Particle Paint) on page 3201
Layout Rollout (Particle Paint) on page 3208
Orientation Rollout (Particle Paint) on page 3212
Mapping Rollout (Particle Paint) on page 3213
Editing Rollout (Particle Paint) on page 3215

Setup Rollout (Particle Paint)

Select a Particle Paint helper. > Modify panel > Setup rollout

The parameters on the Setup rollout determine the density and placement of particle seeds as well as stroke timing.

**IMPORTANT** For these parameters to affect the strokes or seeds, you must set them before you create particle seeds. Changing values after creating particle seeds has no effect on the existing strokes or seeds.
**Freehand Paint** Activates a freehand paint tool, allowing you to drag anywhere in an orthographic viewport to set particle seeds. The timing of the drag across an object determines the base timing for particle birth when used with the Birth Paint or Particle Paint operators. This option is available only on the Modify panel.

**IMPORTANT** To use the freehand paint tool, you must work from one of the orthographic viewports such as Top or Front. You cannot use this tool in Perspective, Camera, or Spotlight viewports.

Each time you release the mouse while using this tool, you create an individual stroke. You can create as many strokes as you like for each Particle Paint helper. Particle timing and other options for each stroke are governed by the other settings on the Setup rollout.

To stop creating strokes, right-click in the active viewport or click the Freehand Paint button again.

**Pick Stroke Spline** Allows you to pick one or more standard splines as paths for the particle seeds. Particles are then placed along this spline, but are projected on to 3D surfaces into the orthogonal viewport. The splines do not have to be in front of the surfaces in the orthographic viewport; Particle Paint will project from splines to surfaces as if the splines were in front of the objects regardless of their actual positions in 3D space.

The picked splines can be either open or closed splines. NURBS curves cannot be used as spray splines.

You can pick as many splines as you like, and each spline picked is considered to be a separate stroke. The stroke starts from the spline's first vertex, and continues along the spline until it reaches the end of the spline (or the first vertex, in the case of closed splines).

**Total Particle Seeds** The total number of particle seeds that have been generated.

**Strokes** The number of strokes created by the Particle Paint helper.

**Brush Radius** Adjusts the spray emitter's nozzle size. The change in size is reflected in the Particle Paint icon. This value determines the distance around the center of the nozzle by which particle seeds spread when using either method to generate particle seeds. This value can be animated over time.

**Paint Density group**

These controls set the particle seeds’ area of distribution within the emitter nozzle.
Center (%) Percentage of particle seeds that spray at the center of the nozzle.

Sides (%) Percentage of particle seeds that spray at the edges of the nozzle. Higher percentages result in wider bands of particles.

**Paint Flow Rate group**

These controls determine how many particle seeds are emitted and how fast they are emitted over the course of a single stroke. For the freehand paint method, a stroke is defined by the time you press the mouse button to start the stroke, until you release the mouse button. For a spline, one stroke is distributed over each spline picked.

**Stroke Limit** Sets the overall number of particle seeds that can be emitted per stroke when using the freehand or spline methods. So if Seeds p/sec is 25.0 and Stroke Limit is 100.0, you can spray for four seconds before running out of particle seeds with that one stroke. This parameter is overridden by the Stroke spray rate type, selected under Type (see following).

**Type** Sets the spray rate type. The available choices are Time, Length, and Stroke. Each one works with one of the later parameters to set the spray rate.

- **Time** Sets the spray rate by particle seeds per second.
- **Length** Sets the spray rate by spatial movement of the nozzle.
- **Stroke** Sets the spray rate with a specific number of particle seeds per stroke, regardless of stroke length. This option overrides the Stroke Limit parameter (see preceding).

[rate value] Depending on the Type setting (see preceding), one of these is available to set the number of seeds created when painting.

- **Seeds p/sec** The number of particle seeds emitted per second as you draw in viewports. Higher values cause more seeds to be emitted. This option is available only for the Time spray rate type (see preceding).
- **Paint Step** The distance the nozzle center must move between emitting individual particle seeds. Higher values cause fewer seeds to be emitted during a stroke. This option is available only for the Length spray rate type.
- **Total Amount** Determines the total number of particle seeds per stroke, regardless of the stroke length in units or time. Seeds are evenly distributed over the stroke time. This option is available only for the Stroke spray rate type.
Brush Adjustment group

These controls are used for fine-tuning the Brush Radius and Flow Rate with regard to stroke timing.

**Radius** Provides for varying the seed-painting radius over the course of each stroke. Alternatively, you can animate the Brush Radius parameter to vary the brush size, but that animation occurs in absolute time (that is, within a specific frame range). Use this option to adjust the brush radius within a single stroke regardless of its start and end times.

Clicking Radius opens the “Brush Radius Graph (Particle Paint)” on page 3218. The settings on the graph are in effect when the Radius option is on.

**Rate** Provides for varying the seed-painting rate over the course of each stroke. Alternatively, you can animate the Seeds p/sec parameter to vary the rate, but this animates the rate in absolute time (that is, within a specific frame range). Use the Rate option to adjust the seed painting rate within a single stroke regardless of its start and end times.

Clicking Rate displays the “Paint Flow Rate Graph (Particle Paint)” on page 3220. The settings on the graph are in effect when the Rate option is on.

Display Type

This drop-down list gives you the choice of how to display the particles in the viewports. You can choose Ticks or Flags as the display type. The Flags type gives more information about each seed's rotational data. The pole of a flag marker is aligned with its seed's local Z axis, while the banner points in the direction of the local X axis.

**Particle Size** Sets the size of the flag markers. Available for the Flags type only.

Stroke Start group

The settings in this group determine the start frame for particle seeds generated by a stroke. These timing values can be used later by the Birth Paint on page 3222 and Placement Paint on page 3224 operators for precise timing of every particle emitted.

**Stroke Start** Choose either of the following:

- **Current Frame** Starts the stroke timing at the current frame.
- **Fixed** Starts the stroke timing at the indicated frame.
Stroke Stop group

These settings specify the method for determining the duration or stop frame of the stroke.

Stroke Stop Choose one of the following:

- **Real-Time Offset**  Defines stroke time by the actual time taken for drawing the stroke. If you created a stroke by picking a spline, then the default time for the stroke is one second.
  Use the Time Scale % parameter to define the correspondence between the animation time (frames of animation) and the real-world time when a stroke is drawn. For example, a value of 100.0 means that one second of actual time corresponds to 30 frames of animation (for NTSC), while a value of 50.0 means that one second of stroke drawing corresponds to 15 frames of animation.

  **NOTE** Adjusting the Time Scale % value changes the effective flow rate of the painting, since the Seeds p/sec on page 3205 parameter uses animation time, not drawing time.

- **Fixed**  Stops the stroke at the specified frame, in absolute time.

- **Duration**  Sets the stroke length in frames.

Auto Adjust Current Frame Aligns the start of each successive stroke automatically with the stop time of the previous one. If you turn on this option for an existing stroke, the time slider is adjusted to the stop moment of the stroke. This option is available only if Stroke Start is set to Current Frame and Stroke Stop is set to either Real-Time Offset or Duration.

Auto Adjust Global Timing Adjusts emission timing of the related Birth Paint operator automatically.

The Birth Paint operator has its own parameters that define when particles start and stop emission. When this switch is off, Particle Flow fits the timing of the strokes into the Birth Paint operator’s Start/Stop interval. However, when this option is on, Particle Paint allows the related Birth Paint operator to adjust its emission timing to the timing of the strokes.

Icon Size Adjusts the overall size of the helper icon, but does not affect the nozzle radius.
**Paint Spread Uniqueness group**

These settings randomize particle-seed distribution over a stroke. If you pick the same spline for a stroke, the helper generates the same placement for seeds. To generate varied particle placement for the same spline, change the Seed value.

**Seed** Specifies a randomization value. Not otherwise related to particle seeds.

**New** Generates a new Seed value.

**Layout Rollout (Particle Paint)**

Select a Particle Paint helper. > Modify panel > Layout rollout

The settings on this rollout determine how the particles are placed on objects in the scene. The Layout settings affect all particle seeds associated with the Particle Paint helper, either before or after they are created.
Interface

Layout

- Paint on All Objects
- Paint on Objects Listed

Add | By List | Remove

- Animated Objects
- Include Children
- Include Group Members

- Use Mask Objects

Add | By List | Remove

- Include Children
- Include Group Members

Selection Filter:

None

Particle Location:

- At Surface

  Distance: 10.0
  Variation %: 0.0

- Separation: 1.0

- Max Attempts: 100
- Stack Up For Separation
Choose a painting option:

- **Paint on All Objects**  Allows particle painting on any object in your scene.
- **Paint on Objects Listed**  Allows particle painting only on listed objects. Click Add to pick objects from viewports, or By List to choose from a dialog. The names of paintable objects appear in the list. To delete an object from the list, highlight it and then click Remove.

**Animated Objects**  If the object on which particle seeds are placed is animated, the original stroke placement might not be at the same place as the animated surface at the time particles are born. If you want particles painted on animated objects to be born from the animated surface regardless of the surface's position, orientation, or shape by the time the particles are born, turn on this option. The Particle Paint helper works with any animated object, whether animated by transforms or another method, such as sub-object animation, morphing, or skinning operations. If the surface animation involves a change in the number of faces (as with the Optimize modifier), Particle Paint might fail because the seeds are linked to specific faces by face indices.

**Include Children**  Allows painting on linked children of listed objects.

**Include Group Members**  For groups in the list, allows painting on all group members.

**Use Mask Objects**  Lets you use a mesh or patch object as a mask or frisket to block particles from being sprayed in that area. Click Add to pick objects from viewports, or By List to choose from a dialog. The names of selected objects appear in the list. To delete an object from the list, highlight it and then click Remove.

**NOTE**  Mask objects block painting only where their geometry is above (or closer to the viewpoint than) the painted surface in the viewport in which the painting occurs. Also, mask objects cannot receive particle seeds.

**Include Children**  Linked children of listed objects also mask the painting.

**Include Group Members**  For groups in the list, all group members mask the painting.

**Selection Filter**  Restricts painting to selected areas of geometry. Choose one of the following:

- **None**  No restriction.
- **Selected Faces Only**  Paints particle seeds only at the geometry's selected faces.
■ **Soft Selection**  Uses Soft Selection on a selection of the geometry's vertices or faces. Fewer particle seeds will be placed areas where the selection falls off.

**Particle Location group**

These controls determine how to distribute particle seeds on the geometry.

**Particle Location**  This drop-down list lets you choose where particle seeds will be deposited. The choices are:

■ **At Surface**  Particle seeds will reside on the surface of any objects on which they are painted.

■ **Above Surface**  Particle seeds will be placed above the surface of objects on which they are painted. Set the distance above the surface with the Distance parameter.

■ **Below Surface**  Particle seeds will be placed below the surface of any objects on which they are painted. Set the distance below the surface with the Distance parameter.

■ **Above And Below Surface**  Particle seeds will be placed both above and below the surface of any objects on which they are painted. Set the distance from the surface with the Distance parameter.

**Distance**  The distance above or below the surface that particles seeds are placed. This value is expressed in units.

**Variation**  Adds variation to the distance from the surface that particle seeds are placed.

**Separation**  When on, Particle Paint attempts to keep particle seeds apart by the specified distance, expressed in 3ds Max units.

**Max Attempts**  When Separation is on, Particle Paint attempts to separate particles by generating seeds repetitively until the desired separation is achieved. The Max Attempts parameter sets the number of times Particle Paint will generate seeds to attempt separation. If the Distance value is low and Separation is high, the desired separation might not be achieved even after many attempts. In this case, turn on Stack Up For Separation (see following).

**Stack Up For Separation**  When on, instead of using repetitive seed generation to attempt to separate particles, the separation conflict is resolved by moving the conflicting seed away in the direction of the surface normal.
Orientation Rollout (Particle Paint)

Select a Particle Paint helper. > Modify panel > Orientation rollout

The Orientation rollout controls the way particle seeds are oriented on surfaces. The orientation information can be used by the Birth Paint and Placement Paint operators to rotate particles in space. These options are useful when you plan to use instanced shapes with a visible orientation as particles.

**IMPORTANT** To have these settings affect the particle seeds, set these parameters before you create the seeds. Changing these parameter values after creating particle seeds has no effect on the existing seeds’ orientation.

**Interface**

Generate Rotational Comp. Enables control over the orientation of particle seeds. The remaining settings on this rollout are available only when this check box is on.

X-Axis and Z-Axis groups

Priority Axis Sets the axis as the primary axis. When the X axis is chosen as the Priority Axis, each particle first aligned by its local X axis in the manner specified in the drop-down list, and then the local Z axis is used. If the Z axis is chosen as the Priority Axis, each particle is aligned first by its local Z axis, and then its X axis.
Reverse Reverses the direction of the Priority Axis. This has the effect of rotating particles by 180 degrees so they point in the opposite direction.

[orientation list] Use this drop-down list to specify how Particle Flow orients particles with respect to the surface of the painted object.

- Random Orients the particles on the surface at random, according to the chosen axis.
- Align to Surface Normal Aligns particles to the surface normal of the object upon which they were painted. For example, if X is selected as the Priority Axis, the local X-axis for a particle is aligned with the surface normal. This option is suitable for placing instanced grass or hair objects on a surface.
- Align to World X/Y/Z-Axis Aligns the particles along the respective world axis.
- Look at Viewport Forces all particles to align with the active viewport.
- Look at Particle Paint Icon Forces all particles to face the Particle Paint Icon.
- Follow Stroke Aligns particles along the spray path in the direction in which the stroke was drawn.
- Align to U/V/W Map Vector Aligns particles along the U/V/W mapping direction on the surface of the painted object.

Divergence Sets the maximum degree of variation off the chosen Priority Axis, expressed in degrees.

Mapping Rollout (Particle Paint)

Select a Particle Paint helper. > Modify panel > Mapping rollout

The Mapping rollout determines how particles are mapped. To use mapping with particle seeds, add a Material operator to the event, and assign a material that has mapping.

IMPORTANT To have these settings affect the particle seeds, set these parameters before you create the seeds. Changing the parameter values after creating particle seeds has no effect on existing seeds’ mapping.
**Interface**

[Image: A small diagram illustrating the interface with checkboxes for "Acquire Sub-Material Index," "Generate Mapping Coords," and a dropdown menu for "Assign To Mapping Channels." Below this, there are options for "Type" and two input fields for "Start Value" and "End Value".]

**Acquire Sub-Material Index** Causes each particle seed to acquire the sub-material index (Material ID) of the nearest point of the surface painted.

**Generate Mapping Coords.** Creates mapping coordinates for each particle seed according to the Type selection. If you use this option, do not use a Mapping operator with the Birth Paint or Placement Paint operator, because doing so will override the mapping generated by the Particle Paint helper.

**Assign To Mapping Channels** Defines the mapping channels to which mapping values are assigned. You can choose more than one channel for assignment. Available only when Generate Mapping Coords. is on.

**Type** Lets you specify how Particle Paint assigns mapping to particles. These mapping types work with numeric parameters to set mapping on particle seeds. For example, with a planar map the bottom-left corner has UVW values of 0,0,0, while the top-right corner has UVW values of 1,1,0. These mapping types correlate these values to the stroke.

- **Stroke Dependent** Spreads mapping values from the Start Value to the End Value over the course of the stroke. The first particle in the stroke receives the Start Value, the last particle of the stroke receives the End Value, and intervening particles receive values interpolated between the two. The same value is assigned to U, V, and W.

- **Time Dependent** Assigns mapping values according to time. The first particle in the stroke is given the Start Value, and the timing of each successive particle (in relation to the first particle) receives an incremented value according to the Offset p/Sec parameter and the number of seconds elapsed. For example, if Offset p/Sec is 0.25 (the default value), then a four-second stroke covers the 0-1 range of UV mapping values.
Index Dependent  Assigns mapping values incrementally regardless of the stroke time. The first particle in the stroke is given the Start Value, and each successive mapping value increments by the Offset p/Particle value. For example, if Offset p/Particle is 0.01 (the default value) and a stroke has 101 particles, then particles in the stroke receive the incremental mapping values 0.0, 0.01, 0.02, 0.03, ... 0.98, 0.99, 1.0.

From Object Painted  Particle seeds take their mapping from their placement on the painted object. A particle acquires the mapping values at the nearest point of the object surface. To acquire mapping values from several mapping channels of the object, activate multiple buttons in the Assign To Mapping Channels group.

Editing Rollout (Particle Paint)

Select a Particle Paint helper. > Modify panel > Editing rollout

The Editing rollout lets you delete unwanted particle seeds or whole strokes, adjust stroke/particle timing, and select particles/strokes and pass the selection data to the Birth Paint and Placement Paint operators. You cannot directly manipulate selected particle seeds with standard 3ds Max tools such as Move and Rotate.

This rollout appears only on the Modify panel.
Two levels of sub-objects are available for selection: Particles and Strokes. As with other sub-object types in 3ds Max, each level remembers its selection. Selected particles are red.

- **Particle** Lets you select particle seeds by clicking them or dragging a region.

- **Event** Lets you select entire strokes. At this level, you can select all particle seeds in one or more strokes with standard selection methods.

**Show Particle Timing** When on you can scrub the time slider to see particle timing in the viewports. Particles start out with the color specified by the
Show Particle Timing color swatch. As you scrub the time slider, each particle turns white when it reaches its emission time.

The particle timing displayed with this option is taken from the current stroke timing settings stored in the Particle Paint helper. This timing might differ from the timing set by a Birth Paint operator.

Available only when not at a sub-object level (Particles or Strokes).

**Delete Selected Items** Deletes selected particles or strokes. You can also use the Delete key.

**Combine Into Single Stroke** Combines selected strokes into a single stroke. The particle seeds are intermixed according to their relative timing. You can use this tool to combine short or single-particle strokes into a larger stroke.

Available only at the Stroke sub-object level when multiple strokes are selected.

**Equalize Particle Timing** Evens out the distribution of particle timing within a stroke. This tool is useful for evening out strokes where some particles have been deleted.

Available only at the Stroke sub-object level.

**Auto Sync Timing by Sel.** When on, sets Start At, Stop At, and Duration (see following) to the current start frame, stop frame, and duration of the currently selected stroke. This option takes effect only if a single stroke is selected.

**Current Start** Shows the start frame of the currently selected stroke(s). If multiple strokes with different start times are selected, then the value shown is <multiple>.

**Start At** The start time for selected strokes. If you change this value, the new time goes into effect when you click Adjust Stroke Timing.

**Current Stop** Shows the end frame of the currently selected stroke(s). If multiple strokes with different end times are selected, then the value shown is <multiple>.

**Stop At** The end time for selected strokes. If you change this value, the new time goes into effect when you click Adjust Stroke Timing. You can choose either this method or the Duration method for changing the length of the stroke.

**Cur. Duration** Shows the duration of the currently selected stroke(s). If multiple strokes with different durations are selected, then the value shown is <multiple>.
**Duration** The duration of selected strokes. A change to this value goes into effect when you click Adjust Stroke Timing. You can choose either this method or the Stop At method for changing the length of the stroke.

**Auto-Adjust Global Timing** When on, changing the stroke timing automatically changes the timing in any related Birth Paint operators on page 3222 in Particle Flow. This option has an effect only if a Birth Paint operator that references the Particle Paint helper is present in the scene.

**Adjust Stroke Timing** Adjusts the timing of selected strokes to match the values for Start At, and Stop At or Duration.

**Total Particles** Displays the total number of particle seeds associated with the Particle Paint helper.

**Total Strokes** Shows the total number of strokes in the Particle Paint helper.

**Selected Particles** Shows the number of selected particles. At the Particles sub-object level, it shows the number of selected particles. At the Strokes sub-object level, it show the total number of particles in the selected strokes. At the object level, it displays the number of selected particles at the Particles sub-object level.

**Selected Strokes** Shows the number of selected strokes. The value changes for different sub-object levels. At the Particles level it shows the number of strokes that have selected particles. At the Strokes level it shows the number of directly selected strokes. At the Object level it shows the same amount as in the Strokes level.

**Selected Stroke #** Shows the sequence number of the currently selected stroke. Strokes are stored in the order in which they are made.

---

**Brush Radius Graph (Particle Paint)**

Select a Particle Paint helper. > Modify panel > Setup rollout > Brush Adjustment group > Turn on Radius. > Click Radius.

The Brush Radius Graph appears when you click the Radius button on the Setup rollout of a “Particle Paint helper” on page 3197. It allows you to animate the brush radius over the time of a single stroke.
The left end of the graph represent the start of the stroke, while the right end represents the end of the stroke. The values in the left column represent the brush radius in units.

Move the existing control points, or add and move more control points, to change the curve over the length of the stroke.

The controls on this dialog are similar to those on the loft deformation dialogs in 3ds Max.

Moves control points in any direction. The exceptions are the start and end control points, which can be moved only vertically.

Moves control points horizontally only. This button is available from the main Move button flyout.

Moves control points vertically only. This button is available from the main Move button flyout.

Scales selected control points with respect to the 0 value.

Inserts a Corner point on the graph.
Inserts a Bezier point on the graph. This type of point has handles that you can adjust for a smooth curve. This button is available from the Corner point button flyout.

Deletes a control point.

Pans the graph.

Zoom Extents, Zoom Horizontal Extents, and Zoom Vertical Extents zoom the graph in or out to fit in the window.

Interactive zoom controls zoom horizontally or vertically, zoom the entire window, or zoom to a selected region.

**Paint Flow Rate Graph (Particle Paint)**

Select a Particle Paint helper. > Modify panel > Setup rollout > Brush Adjustment group > Turn on Rate. > Click Rate.

The Paint Flow Rate Graph appears when you click the Rate button on the Setup rollout of a “Particle Paint helper” on page 3197. It allows you to animate the particle paint rate over the time of a single stroke.
The left end of the graph represents the start of the stroke, while the right end represents the end of the stroke. The values in the left column represent particles per second.

To change the curve over the length of the stroke, move control points, or add and move control points.

The controls on this dialog are similar to those on the loft deformation dialogs in 3ds Max.

- Moves control points in any direction. The exceptions are the start and end control points, which can be moved only vertically.
- Moves control points horizontally only. This button is available from the main Move button flyout.
- Moves control points vertically only. This button is available from the main Move button flyout.
- Scales selected control points with respect to the 0 value.
- Inserts a Corner point on the graph.
- Inserts a Bezier point on the graph. This type of point has handles that you can adjust for a smooth curve. This button is available from the Corner point button flyout.
- Deletes a control point.
- Pans the graph.

Zoom Extents, Zoom Horizontal Extents, and Zoom Vertical Extents zoom the graph in or out to fit in the window.

Interactive zoom controls zoom horizontally or vertically, zoom the entire window, or zoom to a selected region.
Birth Paint Operator

Particle View on page 3015 > Click Birth Paint in an event or add a Birth Paint operator to the particle system and then click it.

The Birth Paint operator uses a Particle Paint helper on page 3197 as a reference for creating particles. With the Particle Paint helper, you place particle seeds on an object with a specific pattern and timing. The Birth Paint operator creates particles from these seeds, initializing particle position, rotation, mapping and selection status.

**TIP** If the Particle Paint helper does not generate a sufficient number of particles, but you want to use the overall particle birth pattern and rate set by the Particle Paint helper, use the Spawn test on page 3281 after Birth Paint in the event to spawn additional particles at each particle seed's location.

See also:

- Placement Paint Operator on page 3224
Interface

Particle Paint Helper group

[button] Choose a Particle Paint helper as the source for particle seeds by clicking the button, labeled “None” by default, and then selecting a helper. After doing so, the helper name appears as the button label.

Total Particles Shows the total number of particles in the Particle Paint helper. The amount of particles actually generated depends on the Quantity Multiplier of the master PF Source object. If the multiplier value is less than 100%, the Birth Paint operator samples the particles from the helper. If the multiplier is greater than 100%, some particle seeds from the helper generate multiple particles.

Total Strokes The total number of strokes in the Particle Paint helper.

Emit Start The frame number at which particles start to emit, beginning with particle seeds at the start of the first stroke.
**Emit Stop/Duration** Choose either of two methods of setting the length of time particles are emitted:

- **Emit Stop** Sets the frame number at which particles stop emitting. The time to emit all strokes in the Particle Paint helper is scaled to fit the time between Emit Start and Emit Stop.

- **Duration** Sets the duration of the emission in frames. If the Duration value is not the same as the stroke time, particle emission timing is scaled to fit the Duration value.

**Reset To Stroke Time** Adjusts the Emit Start, Emit Stop, and Duration values to the timing of the Particle Paint helper's strokes. The Emit Start value is set to the earliest start time of the strokes, and the Emit Stop time is set to the latest stop time of the strokes.

**Subframe Sampling** When on, particles are emitted on the sub-frame timing as defined by the strokes timing and the Emit Start and Emit Stop values. This can help avoid particle clumps. When off, the particle creation time is clamped to the nearest whole frame value.

**Lock At Painted Objects group**

This group of controls tells the Birth Paint operator how to continue controlling particle position/rotation after particles are born. These options apply only if objects painted with the Particle Paint helper are animated, and the Animated Objects on page 3210 option on the Particle Paint helper's Layout rollout is on.

- **Position** Causes all particle pivot points to stick firmly to the painted objects.

- **Rotation** Causes all particles to retain their original orientations. Even if the painted object has surface animation, particles retain the same normal orientation they had at the moment of generation.

- **Acquire Selection** Uses the Particle Paint helper selection. This selection overwrites the PF Source particle selection, if any. Choose the sub-object selection Particles or Strokes (see Editing Rollout (Particle Paint) on page 3215).

**Placement Paint Operator**

Particle View on page 3015 > Click Placement Paint in an event or add a Placement Paint operator to the particle system and then click it.
The Placement Paint operator uses a **Particle Paint helper** on page 3197 to acquire particle seeds from which to generate particles. Placement Paint sets particle positions, rotation, and mapping.

For more information about painting particles, see **Particle Paint** on page 3197.

**Using Placement Paint**

Both Placement Paint and Birth Paint allow placing particles as painted with the Particle Paint helper. Birth Paint combines Birth operator functionality with limited placement options. If you prefer to use birth options not provided in Birth Paint, you can use a different Birth operator with Placement Paint placed immediately after the Birth operator in the event.

Another case for using Placement Paint would be a situation in which you would like to paint particle positions to which particles should be sent by the Find Target operator. In that case the event would look something like this:

- Birth (any)
- Placement Paint
- Script operator (to copy particle positions to Script Vector)
- Position operator (any)
- Find Target (set to use Script Vector)

This the way particles are directed to the positions defined by the painted particle seeds.

**See also:**

- **Birth Paint Operator** on page 3222
Particle Paint Helper Click the button to specify a Particle Paint helper on page 3197 as the reference for particle seeds.

Total Particles The total number of particles in the Particle Paint helper. How the particles seeds correspond to the particles in the current event depends
on the Quantity Multiplier of the PF Source object and the option Obey Quantity Multiplier.

Total Strokes The total number of strokes in the Particle Paint helper.

Data Update Lets you choose how the operator controls positions and rotation:
- Once Sets the positions and rotation for each particle once, when the particle enters the event.
- Continuous Sets particle positions and rotation throughout the event.

Acquire Paint Data group

These controls tell the Placement Paint operator which data to get from the Particle Paint helper, how to interpret the data, and how to use it for particle control.

Paint Position To When on, Particle Flow uses position data from the Particle Paint helper to control particle position or speed. Choose either of the following:
- Position The particle seeds’ position data is translated into particle position. If Data Update is set to Continuous, particle speed is controlled to ensure that particles are locked to the particle seeds location. This is similar to the Lock On Emitter option of the Position Icon operator.
- Script Vector The particle seeds’ position data is translated into the particle script vector channel (as used by the Script operators and Find Target test). If Data Update is set to Continuous, the script vector channel is updated continuously while the particles are in the event. Most commonly, the Find Target test uses the Script Vector data to direct particles at the target defined by the script vector. However, Find Target controls particles only until they reach the target. To overcome this and keep particles on target, you can use the following option.

Snap If Close Available for the Script Vector option only. If a particle is directed close to the target point as defined by the Paint Position value (written to the Script Vector channel), then the operator starts controlling the particle position directly, as with the option Position. With this technique you can use the Find Target test to direct particles to the Paint seeds’ location, and then switch back to direct control of particle position (similar to Lock On Emitter operation). Keep in mind that the operator continues to write the data into the script vector channel even after the snap moment.
Snap Distance Defines distance in 3ds Max units when control shifts from
directing particles toward a target to snapping to the target, as defined in the
Snap If Close description.

Rotation When turned on, Particle Flow uses rotation data from the Particle
Paint helper to control particle rotation or spin.

- Blend-in Rotation Available when Data Update is set to Continuous,
  Paint Position To is set to Script Vector, and Rotation is on. In this case,
  particles move toward the position as defined by the Particle Paint helper.
  When on, the operator modifies particle rotation to allow smooth blending
  from the current particle rotation to the rotation by Particle Paint while
  particles are approaching their target position.

- Near/Far Distance Available when Blend-in Rotation is On. The Far
  Distance value indicates the distance from the target point to the current
  particle position when the blend-in rotation process starts. The Near
  Distance value indicates the distance when the blend-in process should
  be finished, meaning a particle eventually assumes the rotation value as
  defined by the Particle Paint helper.

Mapping When on, uses the mapping data from the Particle Paint helper for
particle mapping.

Material ID When on, defines a material ID for each particle. The ID is defined
by the Particle Paint operator as sub-material index at the closest face of the
painted object to the particle seed.

Selection When on, uses the Particle Paint helper selection to set up the
selection qualities of particles. Any selection made at a PF Source sub-object
level is overwritten by the selection from the helper. Since selection in the
helper can be done at two different sub-object levels, you must choose the
selection level: Particles or Strokes.

Index Order group

These controls associate particle quantity and timing in the event with particle
seeds in the Particle Paint helper.

Type Indicates the method the operator uses to select particle seeds from the
Particle Paint helper for conversion to particles. The choices are:

- Random Selects particle seeds for conversion to particles at random,
  without regard to stroke timing. If the number of particles exceeds the
  number of particle seeds and Stop If Count Overflow is off, all particle
  seeds are used each time Placement Paint cycles through the seeds.
- **Paint Timing**  Uses the timing of particles and strokes in the Particle Paint helper to define the order of emission.

**Stop If Count Overflow**  Causes Placement Paint to stop controlling particles when the number of particles in the event reaches the number of particle seeds in the Particle Paint helper. When this option is turned off, Placement Paint cycles through the particle seeds as many times as necessary to create the required quantity of particles.

**Obey Quantity Multiplier**  Uses the Quantity Multiplier parameter from the PF Source object to adjust the correspondence between particles in the event and particle seeds in the helper. For example, if Quantity Multiplier is set to 50%, then only half the particle seeds in the Particle Paint helper are used. If Quantity Multiplier is greater than 100%, then some or all particle seeds will be used to generate more than one particle.

**Separate Streams Indexing**  Causes particles from different events to be treated as separate streams with regard to particle seed correspondence. When on, particles retain their correspondence to their original seeds. When off, particles coming into the event can be associated with any seed from the entire pool of seeds.

**Uniqueness group**

These parameters initialize randomness for particle sequence when Random is selected as the Type in the Index Order group.

- **Seed**  Specifies a randomization value.
- **New**  Generates a new randomization value.

**Flows**

The flows category contains operators for creating three different kinds of initial particle-system setups. These are: Preset, Empty Flow, and Standard Flow.

**See also:**

- **Operators** on page 3050
- **Tests** on page 3233
Preset Flow

Particle View on page 3015 > depot > Preset Flow

Particle View > Edit menu > New > Particle System > Preset Flow

Preset Flow merges a previously saved Particle Flow setup into the current scene. It allows you to use the flow as an event within your current flow, or as a starting point for a new particle system.

Before you can merge a scene with Preset Flow, you must save it with the Preset Manager on page 3026. A preset can include Particle Flow elements as well as standard 3ds Max objects.

To add a Preset Flow, drag Preset Flow into the event map of Particle View. The Select Preset Flow dialog opens. Highlight a preset and then click OK, or simply double-click a preset name.

When you drag a Preset Flow in Particle View, the global event appears where you drop the flow, and additional events appear in the same spatial relationship as when they were saved in the preset (if you add the Preset Flow from the Edit menu, it appears where it was saved from). All items that were added by Preset Flow are selected in the scene and in Particle View.

To revert the merge, activate the 3ds Max window (by clicking outside a viewport, right-clicking a viewport, or closing Particle View) and then press the Delete key.

If the Preset Flow contains geometry, operators, or other items with names identical to those in your current scene, the standard 3ds Max Duplicate Name dialog appears and prompts you to change the names or skip the items. If you skip the PF source item, the preset will not merge.

NOTE Preset Flow flushes the Undo/Redo buffer.

See also:

- Empty Flow on page 3232
- Standard Flow on page 3232
Interface

**Presets** Lists the current presets in the system. Add a preset either by double-clicking its name or by highlighting it and then clicking OK.

**Preset Description** Displays the description for the highlighted preset. To scroll a description that is too long to fit into the visible space, place the cursor in the description area and use the Down Arrow and Up Arrow keys.
OK Adds the selected preset.
Cancel Cancels the merging of presets.

Empty Flow

Particle View on page 3015 > depot

Empty Flow provides a starting point for a particle system consisting of a single global event containing a Render operator. This lets you build a system completely from scratch, without having first to delete the default operators provided by the Standard Flow system.

To use Empty Flow, drag it from the depot to the event display. In Particle View, this creates a global event containing a single Render operator. If the Global default display option is active in the Particle View > Options menu, the global event will also contain a Display operator. Adding an Empty Flow also creates a Particle Flow Source icon in the viewports, at the world origin (0,0,0).

NOTE If an orthographic viewport is active when you add an Empty Flow to the system, 3ds Max orients the new source icon parallel to the plane of the active viewport, with the default emission direction pointing forward. For example, if the Front viewport is active, the icon is oriented parallel to the XZ plane in the world coordinate system, with the default emission direction along the positive Y axis. If a Camera or Perspective viewport is active, Particle Flow uses the default orientation: parallel to the XY plane, pointing in the negative Z direction.

See also:
- Preset Flow on page 3230
- Standard Flow on page 3232

Standard Flow

Particle View on page 3015 > depot

Standard Flow provides a starting point for a particle system consisting of a global event containing a Render operator, wired to a birth event containing a Birth, a Position, a Speed, a Rotation, a Shape, and a Display operator, with
all parameters set to default values. This is the same system that 3ds Max creates automatically when you add a Particle Flow icon to the viewport.

To use Standard Flow, drag it from the depot to the event display. In Particle View, this creates the particle system described above. If the Global default display option is active in the Particle View > Options menu, the global event will also contain a Display operator. Adding a Standard Flow also creates a Particle Flow Source icon in the viewports, at the world origin (0,0,0).

**NOTE** If an orthographic viewport is active when you add a Standard Flow to the system, 3ds Max orients the new source icon parallel to the plane of the active viewport, with the default emission direction pointing forward. For example, if the Front viewport is active, the icon is oriented parallel to the XZ plane in the world coordinate system, with the default emission direction along the positive Y axis. If a Camera or Perspective viewport is active, Particle Flow uses the default orientation: parallel to the XY plane, pointing in the negative Z direction.

See also:

- Empty Flow on page 3232
- Preset Flow on page 3230

**Tests**

The basic function of a test in Particle Flow is to determine whether particles satisfy one or more conditions, and if so, make them available for sending to another event.

When a particle passes a test, it is said to “test True.” To send eligible particles to another event, you must wire the test to that event. Particles that don’t pass the test (“test False”) remain in the event and are repeatedly subjected to its operators and tests. Or, if the test isn’t wired to another event, all particles remain in the event. You can use several tests in an event; the first test checks all particles in the event, and each test after the first checks only particles that remain in the event.

One test, Spawn, doesn’t actually perform a test, but simply creates new particles from existing ones, and sets the new particles’ test result to True so they’re automatically eligible for redirection to another event. And the Send Out test simply sends all particles to the next event by default.
Some tests can also serve as operators, in that they contain parameters that modify particle behavior. If you don’t wire a test to another event, it functions only as an operator; the test aspect doesn’t affect particle flow.

**TIP** Always place a test at the end of its event, unless you have specific reasons for placing it elsewhere. That way, all preceding actions can take effect during each integration step before the test is evaluated.

All the tests are grouped together in the Particle View depot, and are listed in alphabetical order. The icon for all tests is a yellow diamond, usually containing a simplified diagram of an electrical switch.

---

**See also:**

- **Split Group Test** on page 3084
- **Operators** on page 3050
- **Flows** on page 3229
Age Test

Particle View on page 3015 > Click Age Test in an event or add Age Test to the particle system and then select it.

Age Test lets the particle system check whether a specific amount of time has passed since the start of the animation, or how long a particle has existed, or how long a particle has been in the current event, and branch accordingly.

Interface

The user interface appears in the parameters panel, on the right side of the Particle View dialog.

The first interface element is a drop-down list that lets you choose the type of age to test. Default=Particle Age.

- **Absolute Age** Tests the current frame number in the animation.
- **Particle Age** Tests the current age of each particle in frames. This is the default test type.
- **Event Age** Tests the current duration of the current event in frames.

**Test True if Particle Value** Lets you specify whether the test passes particles on to the next event if the age test succeeds or fails. Default=Is Greater Than Test Value
By default, Age Test returns True if the value tested for exceeds the Test Value quantity, but you can alternatively choose Is Less Than Test Value. For example, if you use the Absolute Age test type and set Test Value=60 and Variation=0, and choose Is Less Than Test Value, then particles will move to the next event only until frame 60. After frame 60, any remaining particles stay in the current event unless another test returns True.

**Test Value** The specific frame number, particle age (in frames), or event duration (in frames) to test for. Default=30.
This value cannot be animated.

**Variation** The number of frames by which the value tested for can vary randomly. Default=5.
This value cannot be animated.
To obtain the actual test value for each particle, the system multiplies the Variation value by a random number between -1.0 and 1.0, and then adds the result to the Test Value setting. For example, if Test Value=300 and Variation=10, then tested value for each particle would be between 290 and 310.

**Subframe Sampling** Turning this on helps avoid particle "puffing" when passing particles to the next event by testing the time at a much higher subframe resolution (that is, throughout each frame), rather than using the relatively coarse frame resolution. Default=on.
"Puffing" is the effect of creating separate "puffs" or clusters of particles, rather than a continuous stream.
Turn off Subframe Sampling to cause the test to be executed exactly at frame times.

**Uniqueness group**
The Uniqueness setting enables randomization of the test value variation.

**Seed** Specifies a randomization value.

**New** Calculates a new seed using a randomization formula.

**Collision Test**

Particle View on page 3015 > Click Collision in an event or add Collision to the particle system and then select it.
Collision tests for particles that collide with one or more specified Deflector space warps. It can also test whether a particle has slowed down or sped up after one or more collisions, has collided more than once, and even whether it will collide with a deflector in a specified number of frames.

The Collision test supports all deflector space warps except the DynaFlect defectors:

- POmniFlect on page 2935
- SOmniFlect on page 2946
- UOmniFlect on page 2948
- SDeflector on page 2953
- UDeflector on page 2956
- Deflector on page 2959

**TIP** When testing for collisions with multiple deflectors, for best results, place all the deflectors in a single Collision test. This tests for collisions with all the deflectors simultaneously, and helps avoid possible missed collisions.

See also:

- Collision Spawn Test on page 3241

**Procedures**

**Example: To test for particles slowing down after one or more collisions:**

In the real world, particles bouncing repeatedly against a surface lose kinetic energy at each collision, and slow down gradually. Rather than testing for a specific number of bounces, you can use the Is Slow After Collision(s) to test whether particle speed has sunk below a specific level.

1. Start or reset 3ds Max. Set the animation length to 500 frames.
2. Add a Gravity space warp and a Deflector space warp. Decrease the deflector’s Bounce setting below 1.0, and increase the Variation and Chaos values above 0.0. Set the deflector’s Width and Length to 500.
3. Create a default Particle Flow system. Position the emitter directly above the deflector.
4 Add a **Force operator** on page 3189 to the end of Event 01 and add the Gravity space warp to the Force operator.

5 Create a new event with a **Display operator** on page 3186, and change the display type to a different choice than is used in Event 01.

6 Add a Collision test to Event 01, below the Force operator, and wire it to the new event.

7 In the Collision test settings, add the deflector. Choose **Is Slow After Collision(s)**, and set **Speed Min=100** (assuming you're using the default initial speed of 300).

8 Play the animation. You might need to adjust one or more settings before seeing the expected behavior.

   After several bounces, the particles change in appearance and move steadily away from the deflector, indicating that they've entered the second event. Of course, you can set any behavior you like in this event. In the next step, you'll see what happens when actions in an event are not in the right order.

9 In Event 01, move the Collision test above the Force operator, and then play the animation.

   Quite a few particles leak through the deflector. This happens because Particle Flow first tests the particles for a collision, and then applies the Gravity force. The particles that are approaching the deflector and are very close to it are being tested for a collision, which tests False because they haven't actually struck the deflector yet. Particle Flow then applies the gravity, which pushes them past the deflector, making them no longer eligible for testing for collision. Generally speaking, it is best to keep Force operators above Collision tests in each event to ensure that particles don't leak through the deflector.
Interface

The user interface appears in the parameters panel, on the right side of the Particle View dialog.

Deflectors group

This group displays the deflectors currently in effect, and let you add and remove deflectors.

[list] Shows the deflectors that apply to this operator. If more than three deflectors apply, a scroll bar appears at the right side of the list.

If you delete a listed space warp from the scene, its name is replaced in the list by the entry “<deleted>”.

Particle Flow | 3239
Add Click this button, and then select a Deflector space warp in the scene to add it to the list.

By List Click this button, and then use the Select Deflectors dialog to add one or more space warps to the list. The space warps must already exist in the scene.

Remove Highlight a deflector in the list, and then click this button to remove it from the list. Any removed space warps remain in the scene.

Test True If Particle group

Choose the condition under which the test will pass particles on to the next event, and then adjust the associated setting or settings. Default=Collides.

Collides Choose this option, and then set Speed according to how particle speed should be affected by the collision.

Speed Choose one of the following. Default=Bounce.

■ Bounce The speed and direction after collision is determined by the deflector properties.

■ Continue Particle speed and direction are unaffected by the collision.

■ Stop Particle speed is set to 0 after the collision.

■ Random Particles bounce off the deflector in random directions.

Is Slow After Collision(s) The test succeeds if, after collision, particle speed is less than the Speed Min value.

With this choice, particle behavior with respect to the deflector(s) is the same as with the Collides > Bounce option.

Speed Min Particles traveling at less than this speed, in system units per second, test True and become eligible for moving to the next event. Default=1.0.

Is Fast After Collision(s) The test succeeds if, after collision, particle speed is greater than the Speed Max value.

With this choice, particle behavior with respect to the deflector(s) is the same as with the Collides > Bounce option.

Speed Max Particles traveling faster than this speed, in system units per second, test True and become eligible for moving to the next event. Default=1000.0.
Collided Multiple Times  The test becomes True after a particle collides a specific number of times. The particle is moved to the point of the last collision and then redirected to the next event.

# Times  The number of times a particle must collide in order to test True.

Speed  Determines speed and direction after the specified number of collisions. See above for explanations of the choices.

Will Collide  Particle Flow extrapolates particle motion in a linear fashion, based on the current direction and speed, and the test becomes True if the results suggest that the particle will collide with the deflector during a specified time interval. The particle is redirected to the next event without updating its speed or position.

# Frames  The number of frames ahead during which Particle Flow looks for an impending collision.

Uniqueness group

The Uniqueness setting enables randomization of the Random options in the Speed drop-down lists.

Seed  Specifies a randomization value.

New  Calculates a new seed using a randomization formula.

Collision Spawn Test

Particle View on page 3015 > Click Collision Spawn in an event or add Collision Spawn to the particle system and then select it.

Collision Spawn creates new particles from existing ones that collide with one or more Deflector space warps.

You can specify different post-collision behavior for the colliding particles and their offspring. Each spawned particle is born at the same location as its parent, and has the same orientation and shape. Collision Spawn can give the spawned particles a different speed and scaling factor. If you wire the Collision Spawn test to another event, spawned particles are sent to that event, where you can specify different properties for the new particles.

Examples of Collision Spawn usage include marks or explosions resulting from collisions between particles and objects. To achieve these effects, you can use Collision Spawn in conjunction with the Shape Mark on page 3149 and Shape Facing on page 3139 operators.
The Collision Spawn test supports all deflector space warps except the DynaFlect deflectors:

- **POmniFlect** on page 2935
- **SOmniFlect** on page 2946
- **UOmniFlect** on page 2948
- **SDeflector** on page 2953
- **UDeflector** on page 2956
- **Deflector** on page 2959

**TIP** When testing for collisions with multiple deflectors, for best results, place all the deflectors in a single Collision Spawn test. This tests for collisions with all the deflectors simultaneously, and helps avoid possible missed collisions.

**See also:**

- **Collision Test** on page 3236
- **Spawn Test** on page 3281
The user interface appears in the parameters panel, on the right side of the Particle View dialog.

In the context of Collision Spawn, a parent is the original particle from which new particles are spawned.

**Test True for group**

These check boxes let you specify which particles, if any, should become eligible for redirection to the next event upon satisfaction of the test conditions.

**NOTE** After a particle tests True, the Collision Spawn test no longer tests the particle for collision. If you simply want particles to spawn every time they collide, turn either or both of these off and use a different test for redirection.

**Parent Particles** When on, parent particles qualify for redirection when the test conditions are met. Default=on.

When using the Spawn On First Collision option on page 3245, Parent Particles is available only when Delete Parent is off.

This option is also available when using the Spawn On Each Collision option on page 3245. In this case, parent particles test True only after colliding the number of times specified by the Until # value.

**Spawn Particles** When on, spawned particles qualify for redirection when the test conditions are met. Default=on.

**Deflectors group**

This group displays the deflectors currently in effect, and let you add and remove deflectors.

**[list]** Shows the deflectors that apply to this operator. If more than three deflectors apply, a scroll bar appears at the right side of the list.

If you delete a listed space warp from the scene, its name is replaced in the list by the entry “<deleted>”.

**Add** Click this button, and then select a Deflector space warp in the scene to add it to the list.

**By List** Click this button, and then use the Select Deflectors dialog to add one or more space warps to the list. The space warps must already exist in the scene.
Remove Highlight a deflector in the list, and then click this button to remove it from the list. Any removed space warps remain in the scene.

**Spawn Rate And Amount group**

Use these settings to specify when particles are to spawn and other values related to how many particles are spawned.

**Spawn On First Collision** Particles spawn only the first time they collide with a deflector.

**Delete Parent** When on, deletes each original particle from which a new one is spawned. Available only with the Spawn On First Collision option.

**Spawn On Each Collision** Particles spawn on each of multiple collisions, up to a limit specified with the Until # parameter.

**Until #** The maximum number of collisions by the parent particles that produce spawned particles. Available only with the Spawn On Each Collision option. Default=3.

When Test True For > Parent Particles is on, parent particles test True only after colliding the number of times specified by the Until # value.

**Spawnable** The percentage of particles in the current event that will spawn new particles. This is determined once for each particle, when it enters the event. However, the parameter is animatable. Default=100.0.

For values other than 100.0, Spawnable uses a randomized selection process, which is affected by the Uniqueness Seed value. For example, with five parent particles, Offspring #=1, and Spawnable=80.0, you might get any number of spawned particles between two and five for each collision. The average per spawning would be four, however.

**Offspring #** The number of new particles the system creates from each parent particle for each spawning event. Default=1.

**Variation** The amount by which the Offspring # value can vary randomly. Default=0.0.

To obtain the actual test value for each particle, the system multiplies the Variation value by a random number between -1.0 and 1.0, and then applies the result as a percentage of the Offspring # setting. For example, if Offspring#=20 and Variation=10, then the actual number of offspring for each particle would be between 18 and 22.
Sync By Choose the time frame to use when animating Offspring # and Variation:

- **Absolute Time**  Any keys set for parameters are applied at the actual frames for which they're set.
- **Particle Age**  Any keys set for parameters are applied at the corresponding frames of each particle's existence.
- **Event Duration**  Any keys set for parameters are applied to each particle starting when it first enters the event.

---

**Restart Particle Age** When on, sets the age of each newly spawned particle at 0. When off, each spawned particle inherits its parent's age. Default=on.

**Speed group**

Lets you specify the behavior of spawned particles, as well as their speed in absolute terms or relative to the parents' speed, with optional random variation. The direction of a spawned particle is always in relation to that of its parent, but you can set a Divergence so they eventually spread out. Default=Inherited.

**Parent** Specify the parent's behavior. Available only when Delete Parent is off.
- **Bounce**  The speed and direction after collision is determined by the deflector properties.
- **Continue**  Particle speed and direction are unaffected by the collision.

**Offspring** Specify the behavior of the newly spawned particles.
- **Bounce**  The speed and direction of offspring after collision is determined by the deflector properties.
- **Continue**  Speed and direction of offspring are unaffected by the collision.

**In Units** Choose this to specify the speed of spawned particles in system units per second. Default=100.0.

A positive value inherits the parent's direction; a negative value reverses it.

**Inherited** Choose this to specify each spawned particle's speed as a percentage of its parent's speed. Default=100.0

A positive value inherits the parent's direction; a negative value reverses it.
Variation The amount by which a spawned particle's speed can vary randomly. Default=0.0.
To obtain the actual speed for each spawned particle, the system multiplies the Variation value by a random number between -1.0 and 1.0, and then adds the result to the particle's speed as specified or inherited. For example, if a particle's speed is 100 units/second and Variation=20, then the tested value for each particle would be between 80 and 120 units/second.

Divergence When on, spreads out the stream of spawned particles. Use the numeric setting to define the extent of the divergence in degrees. Range=0 to 180. Default=12.0.

Size group

Scale Factor The amount of uniform scaling to apply to each spawned particle, as a percentage of its parent's size. Default=100.0.
Variation The amount by which a spawned particle's scale can vary randomly. Default=0.0.
To obtain the actual scaling for each spawned particle, the system multiplies the Variation value by a random number between -1.0 and 1.0, and then adds the result to the Scale Factor value. For example, if Scale Factor=100 and Variation=20, then each spawned particle would be between 80 and 120 percent of its parent's size.

Uniqueness group

The Uniqueness setting enables randomization of the Spawnable result, when less than 100.0, as well as of the Variation values.
Seed Specifies a randomization value.
New Calculates a new seed using a randomization formula.

Find Target Test

Particle View on page 3015 > Click Find Target in an event or add Find Target to the particle system and then select it.
Select a Find Target icon in the viewport. > Modify panel > Parameters rollout Create panel > Helpers > Particle Flow > Find Target
By default, Find Target sends particles to a specified target or targets. Upon reaching a target, the particles become eligible for redirection to another event. You can specify that the particles should use a particular speed or time frame in moving toward the target. You can also specify where on the target the particles should go.

Alternatively, you can use Find Target as a simple proximity test: If a particle comes within a certain distance of its target, it becomes eligible for redirection to the next event.

When you add a Find Target test to the particle system in Particle View on page 3015, a spherical Find Target icon, or helper, appears in the scene at the world origin (0,0,0). You can use this icon as a target, or you can use one or more mesh objects in the scene as targets. To display the Find Target parameters on the Modify panel, select the icon. If you delete the icon, Particle Flow also deletes the test.

**NOTE** If you add Find Target from the Create panel, Particle Flow creates a separate event for the test in the particle diagram.

**TIP** In a particle loop, all particles end up at their respective starting positions, enabling seamless repetition of the resulting animation. You can make particle loops with Particle Flow using a Script operator and a Find Target operator. At the start of the loop, the Script operator should read all particle positions and write them into the MXS Vector channel. Then, at the end of the loop, set the Find Target operator to Control by Time, set Timing to Absolute Time, set Time to the end of the loop, and in the Target group, set Point to By Script Vector. Particle Flow will direct particles to the previously cached position at the specified frame.
Script Operator Example

NOTE See this topic in the online User Reference to view the script operator sample MAXScript code.
Interface

- Find Target 01
  - Control By Speed
    - Use Cruise Speed
      - Speed: 300.0
      - Variation: 0.0
      - Accel Limit: 1000.0
      - Ease In %: 0.0
    - Sync By: Absolute Time
  - Target
    - Icon: On
    - Mesh Objects:
      - Sphere02
      - Spheres01
    - Sync By: Absolute Time
    - Animate Shape
    - Follow Target Animation
    - Point: Random
    - Object: Random
    - Lock On Target Object
  - Docking Direction
    - Type: None Specified
    - Distance: 10.0
    - Icon Size: 30.0
    - Color Coordinated
    - Uniqueness:
      - Seed: 12345

3250 | Chapter 12  Space Warps and Particle Systems
The user interface appears in the parameters panel, on the right side of the Particle View dialog.

**Control By ...** The drop-down list at the top of the parameters panel lets you choose whether to send particles to a target by specifying the speed and acceleration, or by specifying the amount of time they should take. Alternatively, by choosing No Control, you can test particles' distance from a target.

- **Control By Speed** Specify speed and acceleration settings for the particles to follow while traveling to the target. Use the Control By Speed group to set the parameters.

- **Control By Time** Specify time-based settings for the particles to follow while traveling to the target. Use the Control By Time group to set the parameters.

- **No Control** With this option, Find Target functions only as a proximity test. When a particle comes within the specified distance of the target, the particles become eligible for redirection to the next event.

**NOTE** When you choose No Control, the Find Target test does not affect particle speed or direction.

**Test True If Distance To group**

These settings let you choose which distance the Find Target test measures and specify the measured distance. You can choose Target Pivot or Target Point, and specify a distance with the Is Less Than setting.

- **Target Pivot** Measures the distance between the particle and the target pivot. If the particles are directed to the outside of the target and the Is Less Than value is small, this condition might never be satisfied.

- **Target Point** Measures the distance between the particle and the target point on page 3255.

- **Is Less Than** When particles are closer than this distance from target pivot or point, they test True and become eligible for redirection to the next event. Measured in scene units.

**NOTE** If you set Is Less Than to 0, the particles might never test True. This might be desirable for an animation of, for example, bees buzzing around a flower but not landing on it. In this case, you might want to use a low value for Accel Limit so the bees don’t circle too close to the flower.
Control By Speed group

Use these settings to specify speed and acceleration parameters when using Control By Speed or Speed Then Time. This group is available only when using Control By Speed.

Use Cruise Speed When on, Particle Flow gives you explicit control over particle speed and speed variation. When off, Particle Flow calculates particle speed automatically using the Accel Limit value. Default=on.

Speed Particle speed in scene units per second. Default=300.0.

Variation The amount by which the actual Speed value can vary randomly. Default=0.0.

To obtain the actual speed for each particle, the system multiplies the Variation value by a random number between –1.0 and 1.0, and then applies the result as a percentage of the Speed setting. For example, if Speed=200 and Variation=10, then the actual speed for each particle would vary randomly between 190 and 210.

Accel Limit Sets the acceleration limit. This value impacts the inertia and speed of the particles. Default=1000.0.

The default acceleration limit value is based on the default Speed value of 300.0. If you change the Speed value, it is recommended that you also change the Accel Limit value proportionately.

TIP Use a lower Accel Limit value for smooth motion, and a higher value when greater accuracy is needed, such as when the particles should hit a small target. You can animate this setting (use Sync By > Event Duration) to specify different appropriate values, depending on the required results.

Ease In % Controls the rate by which particles slow down when it approaches the target point.

Particle Flow calculates the final speed with this formula: (100% – Ease In) * Speed. Therefore, if the Ease In value is 100%, a particle should approach the target with a speed of 0, and if Ease In is 0%, the particle doesn't slow down at all when approaching the target. At intermediate values, the speed is calculated according to the distance to the target point, as linear interpolation between the initial (cruise) speed, and the final speed. When a particle enters the event, the distance to the target point is calculated and later used for the interpolation. Default=0.0.
Sync By  Choose the time frame to use when animating Speed, Variation, and Accel Limit:

- **Absolute Time**  Any keys set for parameters are applied at the actual frames for which they're set.

- **Particle Age**  Any keys set for parameters are applied at the corresponding frames of each particle's existence.

- **Event Duration**  Any keys set for parameters are applied to each particle starting when it first enters the event.

**Control By Time group**

```
Control By Time:

Timing: [Event Duration]

Time: 48
Variation: 4

Subframe Sampling
Use Docking Speed

Speed: 100.0
Variation: 0.0
```

Lets you specify the amount of time particles should take to reach the target. This group is unavailable when using Control By Speed.

**Timing** Determines how Particle Flow applies the specified timing, defined by the Time and Variation values. The possible options are:

- **Absolute Time**  Time refers to the overall time of the system. Each particle will reach its target at the frame number specified by Time.

- **Particle Age**  Time refers to the time elapsed since the birth of the particle. Each particle will reach its target when its age reaches the value specified by Time.

- **Event Duration**  Time refers to the time elapsed since the particle entered the current event. Each particle will reach its target when it has been in the current for the number of frames specified by Time.

**Time** The number of frames particles should take to reach the target. Default=60.
Variation. The number of frames by which Time can vary randomly. Default=5.
To obtain the actual time to the target for each spawned particle, the system multiplies the Variation value by a random number between –1.0 and 1.0, and then adds the result to the Time value. For example, if Time=60 and Variation=20, then the time to target for each particle would be between 40 and 80 frames.

Subframe Sampling. Turning this on helps avoid particle "puffing" by timing particles at a much higher subframe resolution (that is, throughout each frame), rather than using the relatively coarse frame resolution. Default=on. "Puffing" is the effect of clustering particles, rather than producing a continuous stream. This effect is especially noticeable when the emitter is animated.

Use Docking Speed. Lets you specify particles' speed when they reach the target.
A particle might be required to reach the target from a specific direction at a specific speed. When Use Docking Speed is off, Particle Flow calculates a path for particles to reach the target in the shortest distance with the least acceleration along the path. When Use Docking Speed is on, Particle Flow calculates particles' final speed when they reach the target using the Speed and Variation parameters. Therefore if you want a "smooth landing," set Speed to 0.0. Default=off.

Speed. The speed of particles when they reach the target in scene units per second. Default=100.0.

Variation. The amount by which the actual Speed value can vary randomly. Default=0.0.

Target group
By default, Find Target uses its own target icon, but you can use these controls to designate other scene objects as targets instead.

Icon. Use the Find Target icon as the target.
Each Find Target test has its own target icon. Even if you don't use it as a target, it still influences particle behavior if you set the docking type to Parallel, Spherical, or Cylindrical.

Mesh Objects. Use one or more scene mesh objects as targets. Choose this to make the list and list-management buttons available.
If you designate more than one target, the target used by each particle is determined by the choice in the Object drop-down list on page 3256 in this group.
[list] Shows the mesh objects used as targets. If more than three target objects apply, a scroll bar appears at the right side of the list.

**Add** Click this button, and then select a mesh object in the scene to add it to the list as a target.

**By List** Click this button, and then use the Select Target Objects dialog to add one or more mesh objects to the list. The objects must already exist in the scene, and the dialog shows only eligible objects.

**Remove** To remove a target object from the list, first highlight it and then click this button. Any removed objects remain in the scene.

**Sync By** Choose the time frame to use when sending particles toward animated objects when using Animated Shape or Follow Target Animation:

- **Absolute Time** Animation derived from the target is applied to particles immediately.
- **Particle Age** Animation derived from the target is applied to particles at the corresponding frames of each particle’s existence.
- **Event Duration** Animation derived from the target is applied to particles is applied to each particle starting when it first enters the event.

**Animated Shape** Turn on to allow particles to target the surface of an object whose form is animated by scaling, by morphing, or with modifiers. This requires more computation, because the destination must be updated at every integration step.

**Follow Target Animation** Turn on to allow particles to follow a moving target; that is, a target whose location is animated. This requires more computation, because the destination must be updated at every integration step.

**Point** Lets you specify where on its target a particle should land.

- **Random** Each particle targets a random point on the target.
- **Closest Surface** Each particle targets the nearest point of the target’s surface.
- **By Script Vector** The target point or points are defined using a Script operator that defines values in the particleVector channel. The Script operator can be anywhere upstream of the Find Target test.
NOTE When using By Script Vector to target absolute positions, such as vertex locations, be sure to set Target to Icon. If you set it to Mesh, the positions specified by the script will be relative to the position of the mesh object. This latter option is useful for placing scripted targets on the surface of a moving object.

Object With multiple mesh targets, lets you specify how Particle Flow should choose among them. Available only when targeting more than one object.

- **Random** For each particle, Particle Flow chooses a target object at random.
- **Closest Pivot** For each particle, Particle Flow chooses as its target the object whose pivot is nearest to the particle.
- **Closest Surface** For each particle, Particle Flow chooses as its target the object whose surface is nearest to the particle.
- **Least Deviation** For each particle, Particle Flow chooses as its target the object that requires the least change in its current direction (or resteering) to reach.
- **By Script Integer** For each particle, the choice of a targeted object is defined by a script operator that sets an index. This index corresponds to a target-object entry position in the target list. See Script Operator Example on page 3249.

Lock On Target Object When on, Particle Flow calculates each particle's target object once: when the particle enters the event. Thereafter, the particle is "locked on" to its target object. When off, Particle Flow can continually recalculate the target object for each particle. Available only when multiple target objects are designated.

For example, if you set particles to target the closest surface, due to the target animation and particle movement, the definition of the closest surface is constantly changing. Thus the particle may change the target object due to the circumstances.

NOTE Each time Find Target sets a target object, it "locks on" to a specific point on that object. This point can change only if the target object changes. Thus, with a single target object, the target point always remains constant relative to the target object. That is, if the target object or its surface is animated, and Follow Target Animation or Animated Shape is on, the absolute coordinates of the target point may change.
NOTE When Lock On Target Object is off, more calculation is required because the system might have to recalculate each particle’s optimal target point in each frame.

Docking Direction group

Docking type Lets you specify from which direction particles should approach targets.

- **None Specified**  No docking constraints. Particles reach their targets in the most efficient way, based on their assigned parameters and their current attributes.

- **Along Icon Arrow**  The final direction is the same as the Find Target icon arrow.

  NOTE When using this option, arrows appear on the Find Target icon to indicate the direction particles will use for docking. You can change the docking direction by reorienting the icon. This applies even when using mesh objects as targets.

- **Icon Spherical**  The final direction points toward the center of the operator icon.

  NOTE When using this option, arrows appear on the Find Target icon to indicate the directions particles will use for docking. You can change the docking directions by reorienting the icon. This applies even when using mesh objects as targets.

- **Icon Cylindrical**  The final direction points toward the icon arrow as a line, thus forming a cylindrical field with the arrow as the cylinder's main axis.

  NOTE When using this option, arrows appear on the Find Target icon to indicate the directions particles will use for docking. You can change the docking directions by reorienting the icon. This applies even when using mesh objects as targets.

- **Surface Normals**  Each particle reaches its target point from a direction perpendicular to the surface at that point.
NOTE When using this option, arrows appear on the Find Target icon to indicate that particles will use surface normals for docking; the actual directions they will use depends on the target surface. This applies even when using mesh objects as targets.

**Distance** The distance from the target at which particles begin docking behavior. This includes the docking direction, and, when using Control By Time, the docking speed.

**Icon Size** Set the size of the Find Target icon. This affects particle behavior when using the icon as the target.

**Color Coordinated** When on, the Find Target icon uses the color of the event containing the test as defined by its local Display operator, if one exists. This applies even if the Display operator is turned off. When off, the Find Target icon uses the default Test Gizmos color as defined in Customize User Interface > Colors > Particle Flow. Default=on.

Turn on Color Coordinated to make it easier to spot the Find Target icon, because the particles in the event use the same color as the icon.

**Uniqueness group**

The Uniqueness setting enables randomization of the Random options and the Variation options.

**Seed** Specifies a randomization value.

**New** Calculates a new seed using a randomization formula.

### Go To Rotation Test

**Particle View** on page 3015 > Click Go To Rotation in an event or add Go To Rotation to the particle system and then select it.

The Go To Rotation test enables a smooth transition in the rotational component of a particle, so that the particle can gradually rotate to a specific orientation over a specific period. An example of its usage would be with falling leaves, which spin chaotically as they fall, but land on a flat side rather than an edge. The test aspect lets you direct the particle to a new event when the transition period ends.
To set a target orientation, place the Go To Rotation test *before* an orientation-type operator (*Rotation* on page 3097 or a *Script operator* on page 3196 if it defines the rotation channel) in the same event. In this situation, the Go To Rotation test can grab the particle rotational component before the orientation-type operator overwrites it. The Go To Rotation operator modifies the particle orientation and spinning in the post-evaluation cycle. For an example, see the procedure below.

**WARNING** The Go To Rotation test is not compatible with the Spin, Shape Facing, and Shape Mark operators. Do not use any of these operators in the same event with a Go To Rotation test.

**NOTE** You can define the transition period only in terms of time. You cannot set the test to come to a specific rotation by the time of another test, such as a collision test. Also, limited control is provided over the axis of spinning when a particle comes to the final rotation.

**Procedures**

**Example: To make falling particles land smoothly, face up:**

This procedure assumes a basic knowledge of Particle Flow usage.

1. In the Perspective viewport, add a Particle Flow system and raise its icon about 80 units on the Z axis.

2. In Event 01, make the following changes:
   - Birth > Amount=50
   - Speed=100
   - Shape=Cube (or use Shape Instance with a custom object, such as a coin-shaped cylinder)
   - Display > Type=Geometry

   This reduces the number of particles and slows them down, making it easier to see what's going on.

3. Add a Spin operator on page 3099 to Event 01, and set both Spin Rate and Variation to **150**.
   - This gives the particles random spinning behavior as they fall.

4. Add an Age test to the end of Event 01, and set Test Value=15.
This allows each particle to fall and tumble for 15 frames before Go To Rotation takes effect.

5 From the Depot, drag a Go To Rotation test to an empty area in Event Display. Set Duration=15 and keep all other default settings.

6 Insert a Rotation operator immediately after the Go To Rotation test. Choose Random Horizontal as the orientation matrix. Keep the other default settings.
   The Go To Rotation test will use this as the final orientation for the particles.

7 Use a Speed event to create a third event. Set Speed=0.0. This stops the particles at the end of the animation.

8 In both new events, set Display > Type=Geometry.

9 Wire the Age Test in Event 01 to Event 02, and then wire the Go To Rotation test in Event 02 to Event 03.

10 Play the animation.
   The particles tumble chaotically as they fall for about 30 frames, and then come to a smooth stop, facing up.
The user interface appears in the parameters panel, on the right side of the Particle View dialog.

**Test True When group**

**Transition Period Ends** When on, the particles test True at the end of the specified transition period, and become eligible for redirection to the next event. When off, particles will not go to the next event, even if wired. Turn off to disable the test aspect of Go To Rotation. Default=on.

**Transition By group**

Determines how Particle Flow applies the specified timing, defined by the Time and Variation values. Default=Event Duration.
The possible options are:

- **Absolute Time**  Time refers to the overall time of the system. Each particle will reach its target orientation at the frame number specified by Time.

- **Particle Age**  Time refers to the time elapsed since the birth of the particle. Each particle will reach its target orientation when its age reaches the value specified by Time.

- **Event Duration**  Time refers to the time elapsed since the particle entered the current event. Each particle will reach its target orientation when it has been in the current for the number of frames specified by Time.

**Duration**  The number of frames particles should take to reach the target orientation. Default=30.

**Variation**  The number of frames by which Duration can vary randomly. Default=0.

To obtain the actual time to the target orientation for each particle, the system multiplies the Variation value by a random number between -1.0 and 1.0, and then adds the result to the Duration value. For example, if Duration=60 and Variation=20, then the time to target orientation for each particle would be between 40 and 80 frames.

**Target Rotation group**

When you use an orientation-type operator with Go To Rotation, this setting lets you determine whether the test sets the target orientation on a one-time or ongoing basis. Default=Constant.

**Constant**  Defines that the orientation-type operator sets a constant orientation for a particle. For example, when using a Rotation operator set to an orientation matrix other than Speed Space Follow, the Go To Rotation operator would acquire the target orientation only once, and then use it as its goal.

**Changing**  Defines that the orientation-type operator sets a changing rotation for a particle. At each frame the desirable final rotation may be different. For example, if you use the test with a Rotation operator set to Speed Space Follow, the test will adjust the particle rotation constantly to aim at the changing final rotation.
**Target Rotation Spin group**

Defines the angular velocity for each particle when it reaches the target orientation.

**Match Initial Spin** Sets the angular velocity at the end of the transition period to the same as the angular velocity when particle enters the event.

**NOTE** The axis of rotation might still be different, because it is calculated on the fly to let the particle come to the target orientation.

**Spin Rate** Defines each particle's angular velocity, in degrees per second, when it reaches the target orientation. Available only when Match Initial Spin is off. Default=0.0.

For a smooth transition to the target orientation, set to **0.0**.

**Variation** Defines a random variation in the Spin Rate value when a particle reaches the target orientation. Default=0.0.

To obtain the final angular velocity for each particle, the system multiplies the Variation value by a random number between -1.0 and 1.0, and then adds the result to the Spin Rate value. For example, if Spin Rate=6.0 and Variation=1.0, then the final angular velocity for each particle would be between 5.0 and 7.0 degrees per second.

**Ease In %** Defines a curve in achieving the final spin rate. Default=0.0

When set to 0.0, the test produces a linear interpolation between the initial and final spin rate, and when set to 100.0, the final spin rate is achieved earlier. For the smoothest approach to the target orientation, set Spin Rate and Variation to 0.0, and Ease In to 100.0.

**Transition End group**

**Stop Spinning** When on, halts particle rotation when it reaches the target orientation. Default=on.

Even with Spin Rate spinner set to 0.0, we recommend that you keep this check box on to avoid slow spinning at the end, due to computational averaging and marginal errors.

**Uniqueness group**

The Uniqueness setting enables randomization of the Variation options.

**Seed** Specifies a randomization value.

**New** Calculates a new seed using a randomization formula.
Lock/Bond Test

Particle View on page 3015 > Click Lock/Bond in an event or add a Lock/Bond test to the particle system and then click it.

The Lock/Bond test attaches particles to objects, and can keep them attached even as the object animates. Particles can move over an object’s surface and the bond can be broken, causing particles to fly or break off from the object.

The standard Position Object operator is also able to lock particles to an object, but because it chooses particle positions at random on the object’s surface, particles can drift when the object is animated. The Position Object operator’s main limitation is that it cannot be applied to particles that have already established their positions. Because the Position Object operator generates new particle positions regardless of the old ones, it can create the illusion that each particle shifts to a new location instantaneously. With Lock/Bond, you can force particles to maintain their original positions with respect to an animated surface.

Lock/Bond can also fix particle orientation. This means that particles with a perceivable orientation, such as darts or arrows, can maintain their orientation to the object even as it rotates. You can also limit particles’ rotation from their original orientations for fine control over wind and gravity effects.

You can also dampen particle motion to simulate air, fluid, or friction as particles move across a surface or through the air.

While Lock/Bond functions mainly as an operator, applying various attributes to particles while they’re in the same event, it also serves as a test for particles breaking off from the object. For information on the test performed, see the parameter Break Off When Exceeds on page 3270.

For more information on Lock/Bond, see Using the Lock/Bond Test on page 3271.
Interface
Lock On Objects group

The controls in this group set the starting point for the Lock/Bond test. Here you specify the objects to which to attach the particles, and choose the method for placing particles as they enter the event.

When the Lock/Bond test starts, each particle is locked to a specific point in the scene, usually on the object's surface. This point is referred to as the particle's lock point. If the object is animated, the lock points animate along with the object. When Snap to Surface is turned on, the lock point is on the surface. When Snap to Surface is off, the lock point is exactly at the point where the particle is located at the moment when it enters the event. This location is translated to the local coordinates of the reference object, and maintained throughout the animation of the reference object.

[list] Shows all objects referenced by the test.

Add  Adds an object to the list.

By List  Allows you to add multiple objects to the list.

Remove  Removes highlighted objects from the list.

[locking method] Choose a method for locking particles to objects in the list:

■ **Lock To Object**  Locks particles to the object's local coordinate space. This option takes less processing time than Lock To Surface.

■ **Lock To Surface**  Locks particles to the closest point of the object's surface at the moment when the particle enters the event. By default, this option maintains the distance each particle had from the surface upon entering the event. When used in conjunction with Snap To Surface, this option locks particles to the actual object surface.

Lock to Surface takes more processing time than Lock to Object because the software has to find the closest point on the surface for each particle.

**Animated Surface**  Locks particles to a changing surface. Use this option when the object's surface changes shape or detail over time, such as with animated sub-objects or parameters, morphing, or a skinning modifier. If the object is animated through transforms only (position/rotation/scale), you can save processing time by leaving this option off.

When on, the operator acquires the surface data at every frame. When off, the operator acquires the surface data only once, and uses transformation data as needed to calculate the surface location at every frame.

Available only when Lock To Surface is on.
Snap To Surface  Causes particles to jump to the object's surface as they enter the event. This option differs from Lock To Surface, which locks particles to the surface but maintains each particle's distance from the surface upon entering the event. Snap To Surface forces particles to lie on the object's surface.

If you turn on Snap To Surface but not Restrict To Surface (see following), particles jump to the surface upon entering the event, but don't stay on the surface if Force in the Position Lock/Bond group is less than 100% and other forces such as the Speed operator or Force operator are applied.

Available only when Lock To Surface is on.

Position Lock/Bond group

These options control the movement of particles from their lock points after they enter the event.

Restrict To Surface  Forces particles to stay on the object's surface as they move. When the Force parameter is less than 100%, particles can move from their original positions based on Speed and Force operators within the event. In this case, turning on Restrict to Surface forces the particles to move only to other parts of the surface without leaving the surface itself.

For more information on how Restrict to Surface works with the Force parameter, see Force, following.

Offset Limit  The maximum distance a particle can move from its lock point, in units. When off, particles are not limited in their movement.

If the object or surface is animated, particles might need to move quickly to keep up with the lock point's animation and stay within the Offset Limit distance. If Offset Limit is on and particles cannot keep up with the lock point's movement, particles will be limited to be within the Offset Limit distance to the lock point (to the Offset Limit) even if Force is less than 100%. In addition, if Speed Limit is on, particles can exceed the speed limit to maintain the specified offset. In other words, the Offset Limit parameter, when on, overrides the Speed Limit parameter.

Speed Limit  The maximum speed a particle can travel, in units per frame. If Speed Limit is on and particles cannot keep up with lock points on an animated object, particles are limited to the Speed Limit even if Force is 100%. In other words, the Speed Limit parameter, when on, overrides the Force % parameter.

Force %  Sets the amount of force holding the particle to its lock point. A Force % value of 100.0 attempts to keep particles stuck to their lock points. If the Force % value is less than 100.0, particles can move off their lock points based on Speed and Force operators in the event. The lower the Force % value, the more influence Speed and Force operators have on the particles.
If Force % is less than 100.0 and Restrict To Surface is on, particles move along the object’s surface. If Force % is less than 100.0 and Restrict To Surface is off, particles move off the surface but retain their relationships to lock points. In either case, particle movement is based on Speed and Force operators, and is restricted by Offset Limit and Speed Limit if those parameters are on.

When Force % = 100.0 and Restrict To Surface is on, particles are locked strictly to the object or surface, and do not move. If Force % = 100.0 and Restrict To Surface is off, particles are locked to the object unless Break Off When Exceeds is on and the object is animated at a sufficient speed to break off particles.

**NOTE** Offset Limit and Speed Limit, when enabled, can override a 100% Force setting.

**Dampening** Defines how particles are slowed down, whether moving on the object’s surface or off it. Dampening simulates the effect of various resistance forces.

- **None**
  No dampening is applied, other than the default dampening on oscillating forces from Speed and Force operators.

- **Friction**
  Simulates a surface friction effect, which gradually slows particles until they stop moving. The total slowdown is proportional to the travel distance of a particle. The number of seconds in which a particle loses its speed is equal to initial speed divided by the Friction value. For example, if the initial speed of a particle is 300.0 and the Friction value is 100.0, then the particle gradually comes to a halt over three seconds.

- **Air/Fluid**
  Simulates the resistance of a medium such as air or water, which slows particles but never stops them completely. The resistance is proportional to the speed squared, making the resistance very high for fast-moving particles, but quite low for slow-moving particles. For example, if one particle is moving at a speed of 100.0 and another at 200.0, the resistance for the faster particle will be four times larger than for the slower particle. The Resistance value defines the resistance force for a particle with speed equal to the Speed Unit value.

- **Both**
  Combines both forces: Friction and Air/Water. If you want the overall effect of air resistance, but you want particles to stop moving eventually, use this option. In this case, a small Friction value stops slow-moving particles.

**No Force In Central Zone group**

The central zone is a volume around a lock point. Each particle has its own central zone defined by the Radius parameter in this group.
When Force % is less than 100.0, particle movement is influenced by Force and Speed operators, where forces are oscillated and particles gradually slow down until they come to rest. If you want particles to wander around the lock point rather than coming to rest, you can use these settings to disable forces in each particle's central zone. This will keep a particle wandering indefinitely if its location is within the Radius of its lock point.

**Acceleration** When on, turns off acceleration forces in each particle's central zone. This prevents the particle from slowing down to a stop.

**Dampening** When on, turns off dampening in each particle's central zone. This prevents particles from being slowed by friction and coming to a stop.

**Rotation Lock/Bond group**

Use these options to control the rotation of particles. In this section, mentions of the Force % parameter refer specifically to the one in this group.

**Offset Limit** The maximum number of degrees by which a particle can deviate from its lock point's rotation. For example, the maximum number of degrees a particle can lean or bend when affected by Wind or Gravity.

If the object or surface is animated, particles might need to rotate quickly to keep up with the lock point's rotation and still remain within the Offset Limit. If Offset Limit is on and particles cannot keep up with the lock point's rotation, particles will be limited to the Offset Limit even if Force % is less than 100.0. In addition, if a Spin Limit is set (see following), particles can exceed the Spin Limit to maintain the specified offset. In other words, the Offset Limit, when on, overrides the Spin Limit.

**Spin Limit** The maximum number of degrees per frame that a particle can rotate. If Spin Limit is on and particles cannot keep up with lock points that are rotating, particles will be limited to the Spin Limit even if Force %=100. In other words, the Spin Limit, when on, overrides the Force % setting.

**Force %** The amount by which the particle's rotation is forced to match its lock point's rotation. When Force % = 100.0, particles maintain their original orientations, unless limited to rotate by Spin Limit settings. When Force % is less than 100.0, particles can be rotated with Force operators. The lower the Force value, the more a particle can be influenced by Force operators and inertial properties of a particle.

**Dampening %** The amount of resistance that prevents a particle from catching up with the lock point's rotation. A value of 0.0 creates no dampening, while 100.0 keeps the particle from rotating at all. If Offset Limit is on, Dampening cannot cause the particle rotation to deviate from the lock point's rotation by
more than the Offset Limit amount, even if Dampening % is set to 100.0. In other words, the Offset Limit setting overrides the Dampening value.

**Induced By Speed Change** Causes particle rotation to occur even when particles' positions are locked to their lock points. For example, a field of grass particles would not move, but could rotate when wind is applied to them. This option also works with particles locked to animated surfaces, such as hair or fur particles on an animal's body. Usually particles are rotating because the underlying surface is rotating, and particles are trying to catch up with the "lock" orientation. This option lets you simulate the effect of a particle with a springy attachment to a surface. Since the center of gravity of a particle doesn't coincide with the lock point, any movement of the underlying surface initiates a rotational movement of a particle.

**Inertial Size** The distance between the pivot point of a particle and the particle's center of gravity. For example, the inertial size of a blade of grass is half the length of the strand. Smaller values induce a stronger rotation. Available only when Induced By Speed Change is turned on.

**Break Off When Exceeds** Causes particles to be released from an object's surface when they achieve a specific speed or acceleration. This option works only when particles are glued to the object's surface and have no speed of their own, and any speed or acceleration comes from animation of the object itself. Particles that break off from the object become available to the Lock/Bond test output, which you can wire to another event.

You can use either of the following settings with this option:

- **Speed** The particle speed at which a particle breaks off the object.
- **Accel.** The particle acceleration at which a particle breaks off the object.

**Break If Outwards Only** Causes particles to break off only when the particle's motion is directed away from the object's surface, in the direction of the nearest surface normal. Particles that would penetrate the object when breaking off are not released from the object. Available only when Lock to Surface is chosen and Break Off When Exceeds is on.

**Parameters Animation group**

You can animate Lock/Bond parameters. When you do, Particle Flow can begin applying the animation to particles at different times, depending on the settings in this group.
Sync By
Choose the time frame for applying animated parameters:

- **Absolute Time** Any keys set for parameters are applied at the actual frames for which they're set.

- **Particle Age** Any keys set for parameters are applied at the corresponding frames of each particle's existence. For example, suppose you set keys for the Offset Limit parameter at frames 0 and 30. With the Particle Age option, the settings for the first key would be applied to particles at birth, and the second key would be applied 30 frames later.

- **Event Duration** Any keys set for parameters are applied to each particle relative to the frame at which it first enters the event. Use this option when particles are entering from another event. If particles are born in the current event, this option has the same effect as the Particle Age option.

**Uniqueness Group**

These controls set randomization for the Randomly Selected and Select By Particle Property selection conditions.

- **Seed** Specifies a randomization value.

- **New** Calculates a new seed using a randomization formula.

**Using the Lock/Bond Test**

The Lock/Bond test is a versatile tool for locking particles to objects. By combining its controls in different ways, as described in this topic, you can create a variety of effects.

**How Lock/Bond Works**

Lock/Bond has three main functions:

- Attaching particles firmly to an object, either at the start of an animation or as a result of a collision

- Moving particles along or near an object's surface with a flexible attachment

- Ejecting particles from an animated object

In setting up these effects, you will find that the four most important parameters are Lock To Surface, Snap To Surface, Restrict To Surface, and Force.
Different settings for these parameters, along with a few other parameters and operators, can create a variety of effects with Lock/Bond.

**Attaching Particles to an Object**

When particles enter an event containing a Lock/Bond test with the Snap To Surface option enabled, each particle is locked to a specific point on the selected object's surface. This point is referred to as the particle's lock point. If the object is animated, the lock points animate along with the object.

With Lock/Bond, particle attachment is controlled largely by the Force % parameter in the Position Lock/Bond group. In general, when Force %=100.0, particles stay firmly stuck to their lock points, even on an animated object. For firm attachment, the Lock/Bond test should be the last action in the event. If there are other operators below Lock/Bond that modify speed, then the overall attachment might not be as firm as desired.

All parameters in the Lock/Bond test are animatable. Therefore, you can animate Force % to lock down particles gradually or loosen them from their locked positions.

**Position Object vs. Lock/Bond**

The standard Position Object operator can generate particles randomly on the surface of an object. Position Object is useful for some types of animation, but is limited in its functionality. The Lock/Bond test overcomes many of these limitations, as described in the following points:

- When an object to which particles are attached is rotated, the Position Object operator does not rotate the particles along with it. The effects of this limitation are not necessarily visible with tiny or round particles, but it becomes obvious when using directional-type particle instances such as arrows or darts. Lock/Bond rotates the particles along with the object to which they are locked.

- When particles are passed to a new event that has a Position Object operator and the particles are meant to land on the object's surface, particles do not necessarily lock to the exact spot on which they land. This is because Position Object generates particles randomly on the surface, and they are not "glued down" to a specific spot on a specific face or vertex. Lock/Bond attaches each particle to a specific location on the object's surface so particles don't drift in relation to the surface.
The Position Object operator can be useful in conjunction with the Lock/Bond test. For example, you can use Position Object to cover an object with particles before locking them down with Lock/Bond, as described in the following section.

Covering an Object in Particles

To cover an object in particles, add a Position Object operator to the same event as the Lock/Bond test. The Position Object operator places particles randomly on the surface, while the Lock/Bond test locks or animates them with Lock/Bond forces and parameters.

To cover the object with particles, make sure the Amount setting in the Birth operator is high enough to create the necessary quantity of particles. The Birth Texture operator generates complete, even coverage when using Face subdivision.

After the object is covered in particles, you can lock them to the surface as the object animates, make them drift over the surface, or fling them off the object.

Locking Particles to an Animated Surface

An animated surface is one that deforms, or changes shape, over time. Examples of animated surfaces are objects with:

- Parameter animation
- Sub-object animation (animated vertices or faces)
- Morphed objects
- Surfaces animated with skinning modifiers such as Skin and Physique

Transform animation (position, rotation, scale) at the object level is not considered an animated surface.

Use these parameters to lock particles to an animated surface:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lock To Surface</td>
<td>On</td>
</tr>
<tr>
<td>Animated Surface</td>
<td>On</td>
</tr>
</tbody>
</table>
When Force % = 100.0, particles stay firmly stuck to their lock points. The exception is when Speed Limit is on and the object is animated. In that case, particles stick to their lock points only if they can keep up with them without exceeding the specified velocity (Speed Limit). If this parameter is off, there is no distance or speed limit, and particles stay firmly stuck to their lock points.

A Force % value of 100.0, coupled with Offset Limit and Speed Limit off, forces the particles to stay on the surface.

**Moving Particles Along or Near an Object’s Surface**

To allow particles to move along an object’s surface, Restrict To Surface must be on and the Force % parameter in the Position Lock/Bond group must be set to a value lower than 100.0.

Any Speed or Force operators in the event will then act on the particles to move them along the surface. These forces are applied in such a way that they cause the particles to oscillate with and against the force, gradually slowing down (damping). You can control the amount of damping in the particles’ motion with the Dampening parameters in the Position Lock/Bond group.

When Restrict To Surface is on, all Force and Speed operators should be above the Lock/Bond test, while Collision and Spawn tests should be below the Lock/Bond test.

**Moving Particles Along a Surface**

If you want particles to drift along the surface of an object, use the following settings:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lock To Surface</td>
<td>On</td>
</tr>
</tbody>
</table>

---

3274 | Chapter 12  Space Warps and Particle Systems
Add Speed and Force operators to the event to make the particles move in a particular direction. For example, you can use a Wind space warp with a Force operator to push all the particles onto one end of the object.

**Drifting Particles**

Lock/Bond can also cause particles to drift slightly but always stay a short distance from their lock points. The area around each particle's lock point is called the central zone. Each particle has its own central zone, which extends to a specified radius around the lock point.

**Ejecting Particles from an Animated Object**

Lock/Bond can also cause particles to be ejected, released, or flung from an object's surface when they achieve a specific speed or acceleration.
**Ejecting Particles from a Fast-Moving Object**

Use this technique when particles are glued to the object's surface and have no speed of their own, and any speed or acceleration comes from animation of the object itself. Examples include a fast-spinning or fast-moving object, or one with sub-object animation that moves one part of the object at a fast speed.

Use these parameters to cause particles to break off a fast-moving object:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lock To Surface</td>
<td>On</td>
</tr>
<tr>
<td>Snap To Surface</td>
<td>On</td>
</tr>
<tr>
<td>Restrict To Surface</td>
<td>Off</td>
</tr>
<tr>
<td>Force %</td>
<td>100.0</td>
</tr>
<tr>
<td>Break Off When Exceeds</td>
<td>On</td>
</tr>
</tbody>
</table>

Under Break Off When Exceeds, choose either Speed or Acceleration, and set the speed or acceleration where particles should break off. Use the Acceleration method to simulate an object shaking off particles. When the object suddenly stops shaking the particles will fly off the object.

Particles that break off pass the Lock/Bond test and can be passed to another event. Use a Force operator in the next event to specify how the particles will behave after they are released from the object.

**Ejecting Particles When They Reach a Specific Speed**

To cause particles to break off an object as they move along the surface and achieve a specific speed of their own, use the settings described in the preceding section Moving Particles Along a Surface, and use a Speed Test operator to test particle speed and break to a new event.
Scale Test

*Particle View* on page 3015 > Click Scale Test in an event or add Scale Test to the particle system and then select it.

Scale Test lets the particle system check particle scaling, or particle size before or after scaling, and branch accordingly. The test provides a variety of axis options for measuring scale or size.

You can use this test to cause a change in behavior based on size. For example, a bubble could grow to a certain size, and then pop. Or an object could shrink in size until it falls under the influence of a force, like wind.

**Interface**

The user interface appears in the parameters panel, on the right side of the Particle View dialog.
Type Choose the type of measurement to test. You can test actual scaling, or the size before or after scaling. Default=Scale.
For example, if the X-axis size of a particle's bounding box starts out at 10 system units, and you then use the Scale operator to scale it by 150% on the X axis, the pre-scale size is 10, and the post-scale size is 15. And, of course, the scale is 150.

NOTE Particle Flow measures particle size based on each particle’s bounding-box dimensions in the particle’s local coordinate space. With the low-polygon Shape options Tetra and Sphere, the result of this measurement might not be the same as the Shape operator’s Size value.

- **PreScale Size** Tests the size before scaling.
- **PostScale Size** Tests the size after scaling.
- **Scale** Tests the scaling percentage.

Axis Choose the axis to measure. Default=Average.
- **Average** Obtains an average measurement by adding the sizes on all three axes and then dividing by three.
- **Minimum** Uses the smallest dimension.
- **Median** Uses the middle dimension in order of size. For example, if the particle dimensions are X=5, Y=6, Z=12, then the number compared to Test Value would be 6.
- **Maximum** Uses the largest dimension.
- **X/Y/Z** Uses the specified dimension.

Test True if Particle Value Lets you specify whether the test passes particles on to the next event if the speed test succeeds or fails. Available for all tests except True When Accelerates/Decelerates. Default=Is Greater Than Test Value. By default, Scale Test returns True if the value tested for exceeds the Test Value quantity, but you can alternatively choose Is Less Than Test Value. For example, if you set Type to Scale and set Test Value=150 and Variation=0, and choose Is Less Than Test Value, a particle will move to the next event only when its scaling factor is less than 150%.

Size group

These settings are available when Type is set to PreScale Size or PostScale Size.
**Test Value** The specific size to test for. Default=10.0.

**Variation** The amount by which the value tested for can vary randomly. Default=0.0.

To obtain the actual test value for each particle, the system multiplies the Variation value by a random number between -1.0 and 1.0, and then adds the result to the Test Value setting. For example, if Test Value=10 and Variation=5, then the tested value for each particle would be between 5 and 15.

**Scale group**

These settings are available when Type is set to Scale.

**Test Value** The specific scaling factor to test for. Default=100%.

**Variation** The amount by which the value tested for can vary randomly. Default=0.0%.

To obtain the actual test value for each particle, the system multiplies the Variation value by a random number between -1.0 and 1.0, and then adds the result to the Test Value setting. For example, if Test Value=100% and Variation=10%, then the tested value for each particle would be between 90% and 110%.

**Test Value Offset Keying group**

**Sync By** Choose the time frame to use when animating Test Value and Variation:

- **Absolute Time** Any keys set for parameters are applied at the actual frames for which they’re set.

- **Particle Age** Any keys set for parameters are applied at the corresponding frames of each particle's existence.

- **Event Duration** Any keys set for parameters are applied to each particle starting when it first enters the event.

**Uniqueness group**

The Uniqueness setting enables randomization of the test value variation. Available only when either Variation value exceeds 0.0.

**Seed** Specifies a randomization value.

**New** Calculates a new seed using a randomization formula.
Script Test

Particle View on page 3015 > Click Script Test in an event or add a Script Test operator to the particle system and then select it.

Script Test lets you test particle conditions using a MAXScript script. The script can use any program functionality available to MAXScript.

The default test script tests for the presence of all particles within a spherical volume of radius 20.

Interface

The user interface appears in the parameters panel, on the right side of the Particle View dialog.

Edit Script Click this button to open the current script in a MAXScript Editor window. For detailed information about the MAXScript utility, open the MAXScript Help, available from Help menu > MAXScript Help.

Uniqueness group

The Uniqueness setting provides a randomization seed that the script can use or ignore.

Seed Specifies a randomization value.

New Calculates a new seed using a randomization formula.

Send Out Test

Particle View on page 3015 > Click Send Out in an event or add Send Out to the particle system and then select it.
The Send Out test simply sends all particles to the next event, or, conversely, keeps all particles in the current event. Use Send Out when you simply want to send particles to another event without any conditions.

**TIP** You can temporarily convert any test to Send Out. To specify that a test should send all particles out without any conditions, click the left side of its icon in Particle view; the icon changes to a green light bulb to indicate that all particles automatically test True. Or, if you click the right side of the icon, it changes to a red light bulb, indicating that all particles test False and thus will stay in the current event. To revert to the test's original function, click its icon again.

### Interface

The user interface appears in the parameters panel, on the right side of the Particle View dialog.

**Test True For** Lets you specify whether the test passes all particles on to the next event or keeps them in the current event. Default=All Particles.

- **All Particles** All particles are passed on to the next event.
- **No Particles** All particles are retained in the current event.

**Spawn Test**

Particle View on page 3015 > Click Spawn in an event or add Spawn to the particle system and then select it.

Spawn creates new particles from existing ones. Each spawned particle is born at the same location as its parent, and has the same orientation and shape. Spawn can give the spawned particles a different speed and scaling factor. If you wire the Spawn test to another event, spawned particles are sent to that event, where you can specify different properties for the new particles.

Spawn is a test only in that it sends the spawned particles to another event (if wired); it doesn't actually test any properties. All particles that encounter Spawn are immediately affected by it. Thus, if you want particles to spawn based on the results of a test, use a different test that branches to an event.
containing the Spawn. In such a case, you might want to then send the spawned particles to yet another event, or the particles will continually respawn. Alternatively, to spawn particles after a collision, use Collision Spawn Test on page 3241.

See also:

- Collision Spawn Test on page 3241

Interface

![Particle System Interface Diagram](image)
The user interface appears in the parameters panel, on the right side of the Particle View dialog.

In the context of Spawn, a *parent* is the original particle from which new particles are spawned.

**Spawn Rate And Amount group**

Use these settings to specify how often particles are to spawn, the measurement system to use, and other values related to how many particles are spawned.

**Once** Particles spawn one time only. For each existing particle, one new one is born.

**Delete Parent** When on, deletes each original particle from which a new one is spawned. Available only with the Once option.

**Per Second** Lets you specify a number of particles to spawn every second. For example, if you use the default Rate setting of 10.0, at 30 fps a new particle is born every three frames.

**Rate** The number of particles to spawn per second. Available only with the Per Second option.

**By Travel Distance** Lets you spawn new particles at regular intervals over the path of a moving parent particle.

**Step Size** The system spawns a new particle every time the parent moves this distance, in system units.

**Spawnable** The percentage of particles in the current event that will spawn new particles. This is determined once for each particle, when it enters the event. However, the parameter is animatable. Default=100.0. For values other than 100.0, Spawnable uses a randomized selection process, which is affected by the Uniqueness Seed value. For example, with five parent particles, Offspring #=1, and Spawnable=80.0, you might get any number of spawned particles between two and five. The average per spawning would be four, however.

**Offspring #** The number of new particles the system creates from each parent particle for each spawning event. Default=1.

**Variation** The amount by which the Offspring # value can vary randomly. Default=0.0.

To obtain the actual test value for each particle, the system multiplies the Variation value by a random number between -1.0 and 1.0, and then applies the result as a percentage of the Offspring # setting. For example, if Offspring
#=20 and Variation=10, then the actual number of offspring for each particle would be between 18 and 22.

**Sync By** Choose the time frame to use when animating Rate, Step Size, Offspring #, and Variation:

- **Absolute Time** Any keys set for parameters are applied at the actual frames for which they're set.

- **Particle Age** Any keys set for parameters are applied at the corresponding frames of each particle's existence.

- **Event Duration** Any keys set for parameters are applied to each particle starting when it first enters the event.

**Restart Particle Age** When on, sets the age of each newly spawned particle at 0. When off, each spawned particle inherits its parent's age. Default=on.

**Speed group**

Lets you specify the speed of spawned particles in absolute terms or relative to the parents' speed, with optional random variation. The direction of a spawned particle is always in relation to that of its parent, but you can set a Divergence so they eventually spread out. Default=Inherited.

**In Units** Choose this to specify the speed of spawned particles in system units per second. Default=100.0.

A positive value inherits the parent's direction; a negative value reverses it.

**Inherited** Choose this to specify each spawned particle's speed as a percentage of its parent's speed. Default=100.0

A positive value inherits the parent's direction; a negative value reverses it.

**Variation** The amount by which a spawned particle's speed can vary randomly. Default=0.0.

To obtain the actual speed for each spawned particle, the system multiplies the Variation value by a random number between -1.0 and 1.0, and then adds the result to the particle's speed as specified or inherited. For example, if a particle's speed is 100 units/second and Variation=20, then the tested value for each particle would be between 80 and 120 units/second.

**Divergence** When on, spreads out the stream of spawned particles. Use the numeric setting to define the extent of the divergence in degrees. Range=0 to 180. Default=20.0.
Size group

Scale Factor The amount of uniform scaling to apply to each spawned particle, as a percentage of its parent's size. Default=100.0.

Variation The amount by which a spawned particle's scale can vary randomly. Default=0.0.

To obtain the actual scaling for each spawned particle, the system multiplies the Variation value by a random number between -1.0 and 1.0, and then adds the result to the Scale Factor value. For example, if Scale Factor=100 and Variation=20, then each spawned particle would be between 80 and 120 percent of its parent's size.

Uniqueness group

The Uniqueness setting enables randomization of the Spawnable result, when less than 100.0, as well as of the Variation values.

Seed Specifies a randomization value.

New Calculates a new seed using a randomization formula.

Speed Test

Particle View on page 3015 > Click Speed Test in an event or add Speed Test to the particle system and then select it.

Speed Test lets the particle system check particle speed, acceleration, or the rate of circular travel, and branch accordingly. The test provides a number of variants that let you test speed or acceleration on specific axes, or simply whether the particle is accelerating or decelerating.
The user interface appears in the parameters panel, on the right side of the Particle View dialog.

The first interface element is a drop-down list that lets you choose the type of measurement to test:

- **Velocity Magnitude** Tests the particle velocity, in system units per second, without consideration of direction. This is the default test type.

- **Velocity X/Y/Z** Tests the particle velocity on the specified axis, in system units per second, using the world coordinate system.
  An example of this option would be with fireworks: As the particles move upward, their velocity on the world Z axis is positive. When the reach the top of their trajectory and begin to move downward, their velocity on the world Z axis slows to 0, and then becomes negative. If you choose Velocity Z and Is Less Than Test Value, and set Test Value to 0.0, you can send particles to another event at the moment they begin to move downward.

- **Acceleration Magnitude** Tests the particle acceleration (change in velocity), in system units per second per second, without respect to direction.

- **Acceleration X/Y/Z** Tests the particle acceleration (change in velocity) on the specified axis, in system units per second per second, using the world coordinate system.

- **Steering Rate** Tests the circular component of particle travel in degrees per second, without consideration of rotation or spinning.
For example, if a particle travels along a parabolic path, its motion has both linear and circular components. The circular component is greatest at the top of the parabola. If a particle travels in a full circle in one second, the rate is 360; if it travels in a half circle, the rate is 180.

Potential usage: When a particle is forced to turn too sharply, it might explode or change its type of movement. For example, missiles chase a jet fighter, which maneuvers to elude the missiles. The missiles are forced to change their course rapidly, but the missile construction cannot stand the fast change in steering, so the missiles blow up or disintegrate.

**TIP** You can test steering rate by setting the particle speed with Speed By Icon on page 3112, and linking the Speed By Icon operator icon to a circular path.

- **True When Accelerates** Returns a True value when the particle velocity is increasing in value.
- **True When Decelerates** Returns a True value when the particle velocity is decreasing in value.

**Test True if Particle Value** Lets you specify whether the test passes particles on to the next event if the speed test succeeds or fails. Available for all tests except True When Accelerates/Decelerates. Default=Is Greater Than Test Value.

By default, Speed Test returns True if the value tested for exceeds the Test Value quantity, but you can choose Is Less Than Test Value as well. For example, if you use the Velocity Magnitude test type and set Test Value=200 and Variation=0, and choose Is Less Than Test Value, then particles will move to the next event only when they travel faster than 200 units per second. Any particles traveling 200 units per second or slower stay in the current event unless they later exceed that speed or another test returns True.

**Test Value** The specific speed or acceleration to test for. The unit of measurement depends on the type of test; see above. Default=300.0.

**Variation** The amount by which value tested for can vary randomly. Default=0.0.

To obtain the actual test value for each particle, the system multiplies the Variation value by a random number between -1.0 and 1.0, and then adds the result to the Test Value setting. For example, if Test Value=300 and Variation=10, then tested value for each particle would be between 290 and 310.
Sync By Choose the time frame to use when animating Test Value and Variation. For further information, see Animation Offset Keying group on page 3106.

- **Absolute Time** Any keys set for parameters are applied at the actual frames for which they’re set.

- **Particle Age** Any keys set for parameters are applied at the corresponding frames of each particle’s existence.

- **Event Duration** Any keys set for parameters are applied to each particle starting when it first enters the event.

**Uniqueness group**

The Uniqueness setting enables randomization of the test value variation.

**Seed** Specifies a randomization value.

**New** Calculates a new seed using a randomization formula.

**Split Amount Test**

**Particle View** on page 3015 > Click Split Amount in an event or add Split Amount to the particle system and then select it.

The Split Amount test lets you send a specific number of particles to the next event, keeping all remaining particles in the current event. You can split the particle stream by a specific number or percentage, or by every Nth particle. With a specific number of particles, the splitting takes place once per event, but you can animate the percentage and “every Nth” values to vary the amount of split-off particles over time.
Interface

The user interface appears in the parameters panel, on the right side of the Particle View dialog.

**Test True For group**

Lets you choose how to split the particle stream. Default=Fraction Of Particles, 50%.

**Fraction Of Particles** Split the particle stream on a percentage basis, specified with the Ratio value. With Ratio greater than 0.0, whether a particular particle is split off depends on a randomization factor; change this with the Uniqueness Seed value.

**Ratio** Specify the percentage of particles that will test True. Animatable. Default=50.0.

Available only with the Fraction Of Particles option.

**Every Nth Particle** Splits off a regular sample of particles.

**N** Specify how often to split off a particle. Animatable. Default=3.

For example, enter 8 to split off every eighth particle.

Available only with the Every Nth Particle option.

**First N Particles** Splits off the number of particles specified as the N value (below), starting with the first particle to enter the event, and retains the rest.
**Particles After N First** Splits off all particles starting with the first one after N particles, as specified with the N parameter (below). All particles starting with the first to enter the event up to N are retained in the event.

N Specify the number of particles to split off, with First N Particles, or to retain in the event, with Particles After N First.
Available only with the First N Particles or the Particles After N First option.

**Per Emission Source** When on, Particle Flow applies the N value for the options First N Particles and Particles After N First separately for each emission source.
Use this option with multiple Particle Flow sources converging into a single Split Amount test.

**Uniqueness group**

The Uniqueness setting enables randomization of particle retention with the Fraction Of Particles option.

**Seed** Specifies a randomization value.

**New** Calculates a new seed using a randomization formula.

**Split Selected Test**

**Particle View** on page 3015 > Click Split Selected in an event or add Split Selected to the particle system and then select it.

The Split Selected test lets you split the particle stream based on particles' selection status. For information about selecting particles, see **Selection rollout** on page 3039.

**NOTE** This test considers only particles selected at the Particle sub-object level. To use all particles in an event at a specific frame, go to that frame, go to the Event sub-object level, and highlight the event. Then go to the Particle sub-object level, and on the Selection rollout, click Get From Event Level.
Interface

The user interface appears in the parameters panel, on the right side of the Particle View dialog.

Test True If Particle group

Lets you choose how to split the particle stream. Default=Is Selected.

Is Selected All selected particles are eligible for redirection to another event.

Is Not Selected All non-selected particles are eligible for redirection to another event.

Split Source Test

Particle View on page 3015 > Click Split Source in an event or add Split Source to the particle system and then select it.

The Split Source test lets you split the particle stream based on particles' origin. You can specify that particles from one or more specific Particle Flow sources should or should not be eligible for redirection to the next event.
Interface

The user interface appears in the parameters panel, on the right side of the Particle View dialog.

**Test True If Particle group**

Lets you choose how to split the particle stream. Default=Is From Selected Source.

- **Is From Selected Source** All particles from sources highlighted in the Selected Emission Sources list are eligible for redirection to another event.

- **Is Not From Selected Source** All particles from sources not highlighted in the Selected Emission Sources list are eligible for redirection to another event.

---

**Selected Emission Sources** Lists all emission sources in the system. Highlight the sources to be considered by the test.

**Non-Event-Driven Particle Systems**

Create panel > Geometry > Particle Systems

Create menu > Particles

Non-event-driven particle systems provide relatively simple, straightforward methods for generating particle sub-objects over time for the purpose of simulating snow, rain, dust, and so on. You use particle systems primarily in
animations. 3ds Max provides six built-in, non-event-driven particle systems: Spray, Snow, Super Spray, Blizzard, PArray, and PCloud.

**Fountain spray created as a particle system**

**TIP** You can take advantage of the AutoGrid feature to orient and position new particle systems with respect to existing objects. For details, see AutoGrid on page 2792.

See also:
- Particle System Usage on page 3295
- Creating a Particle Emitter on page 3297
- Particle Flow on page 2997
Interface

Snowstorm created as a particle system

This topic describes only the general properties of particle systems. Other plug-in particle systems might be available in your configuration.

The built-in particle systems share these controls:

**Emitter** Specifies where in the scene the particles are generated. The emitter is the particle system's main sub-object. It doesn't render. Particles appear on the surface of the emitter and fall (or drift, drop, flurry, spray) from the emitter in a particular direction.

**Timing** The timing parameters control the dynamics of particles in the system. They specify how quickly particles appear, how quickly they disappear, whether the emission rate is constant, and so on.

**Particle-specific parameters** These parameters are specific to the kind of particle system. Examples are particle size and speed.

**Rendering properties** These parameters are also specific to the kind of particle system. There are options for displaying particles in viewports and rendering them in scenes and animations. Particles do not necessarily appear the same in renderings as they do in viewports.

You can modify and animate particle system parameters. You can also affect particle system behavior with space warps on page 2887. In addition, you can deform particle systems with the Mesher compound object on page 794.

**NOTE** Particles can participate in dynamics simulations.
Particle System Usage

You create particle systems when you want to model an object or effect that can best be described as a large collection of similar objects behaving in a similar fashion. Obvious examples of such effects include rain and snow, but other equally valid examples include water, smoke, ants, and even crowds of people.

On the Create panel, click Spray, Snow, Super Spray, Blizzard, PArray, or PCloud to create a particle system. Spray and Snow exist primarily for compatibility with earlier releases of 3ds Max, and are superseded by Super Spray and Blizzard.

To create a particle system, first choose Create menu > Particles > Spray or Snow.

These are the basic steps for creating a particle system:

1. Create a particle emitter. All particle systems require an emitter. Some particle systems use the particle system icon as the emitter while others use an object you select from the scene as the emitter.

2. Determine the number of particles. You set parameters such as birth rate and life span to control how many particles can exist at any given time.

3. Set particle shape and size. You can select from many standard particle types (including metaballs) or you can select an object to be emitted as a particle.

4. Set initial particle motion. You can set the speed, direction, rotation, and randomness of particles as they leave the emitter. Particles can also be affected by animation of the emitter.

5. Modify particle motion. You can further modify the motion of particles after they leave the emitter by binding the particle system to a space warp in the Forces group, such as Path Follow, or make them bounce off a deflector in the Deflectors space warp group, such as UDeflector.

**IMPORTANT** When you use forces and deflectors together, always bind the forces before the deflectors.

**TIP** If the particles don't follow the emitter after it's moved, then change any Path Follow parameter on page 2919. The motion will be applied to the particles.
Rain and Snow

Create rain and snow using Super Spray on page 3315 and Blizzard on page 3319. These particle systems are optimized for droplet (Super Spray) and tumbling flake (Blizzard) effects. Add space warps such as Wind on page 2926 to create spring rains or winter storms.

Bubbles

Create bubbles by using the Bubble Motion options of Super Spray on page 3315. If you require good rendering speed, consider using constant or tetra particles. If you require bubble detail, consider using opacity-mapped facing particles, instanced spheres, or metaparticles.

Flowing Water

You generate flowing liquid effects by setting Super Spray on page 3315 to generate closely packed metaparticles. The metaparticles blob together forming a stream. Add a Path Follow on page 2919 space warp to send the stream down a trough.

Explosions

Particle Array (PArray) on page 3331 uses another object as its particle emitter. You can set the particle type to use fragments of the emitter object to simulate the object exploding.

Volume Effects

Particle Cloud (PCloud) on page 3324 constrains its particles within a specified volume. You can use Particle Cloud to generate bubbles in a glass of soda, or bees buzzing inside a jar.

Crowds

Super Spray on page 3315, Blizzard on page 3319, Particle Array on page 3331, and Particle Cloud on page 3324 can use instanced geometry as their particle type. You can create a stream of ants, a flock of birds, or a cloud of dandelion seeds using instanced geometry particles.
Creating a Particle Emitter

After you choose a particle system type to add, you create the particle system icon in the scene. The icon serves different purposes depending on the type of particle system.

As an emitter: The icon defines the starting location and direction of the particles. Spray, Snow, Super Spray, Blizzard, and Particle Cloud use the icon as the particle emitter.

As a placeholder: The icon serves only to hold the parameters for the particle system. The particles are emitted from another selected object. Particle Array and Particle Cloud use the icon as a placeholder.

You can choose whether Particle Cloud uses its icon or another selected object as the emitter.

Procedures

To create emitter icons:

- Drag in a viewport to set the size and orientation of the particle emitter icon for Spray, Snow, Super Spray, Blizzard, and Particle Cloud. Spray, Snow, Blizzard, and Particle Cloud use the icon size as the area of particle emission. Super Spray emits particles from its center regardless of its icon size.
  
  All particle systems align the particle direction with the Z axis of the creation grid.

To create placeholder icons:

1. Drag in a viewport to set the size of the placeholder icon for Particle Array and Particle Cloud. The size and location of the particle system icon has no effect on the particles.

2. After placing the particle system icon, click Pick Object on the Basic Parameters rollout to select the object to use as the particle emitter.

Using Materials with Particle Array

There are a few different options for applying a material to a particle system.
The material that appears on the particles comes from one of three places:

- The particle system itself
- The material assigned to the distribution object (PArray only)
- The material assigned to the instanced objects
Particles with various materials assigned to them

You make this choice in the Material Mapping and Source group near the bottom of the Particle Type rollout. Choose Icon to use the material assigned to the particle system, choose Picked Emitter to use the material assigned to the distribution object, or choose Instanced Geometry to use the material assigned to the instanced objects. Note that this third option is available only when Instanced Geometry is the current particle type (selected in the Particle Types group at the top of the Particle Type rollout).

**NOTE** SuperSpray and Blizzard don’t have distribution objects. PCloud has a distribution object but you can’t get the material from it. In these cases, a radio button lets you use the material from the instanced geometry. Only PArray lets you get the material from the distribution object.

**IMPORTANT** A particle-system object, like any other object, can carry only a single material at any time. Thus, if you choose either Picked Emitter or Instanced Geometry, an instance of the chosen material is actually copied to the particle system, overwriting the material assigned to the emitter. If you want to restore the emitter material, choose Icon, and then reassign the material from the Material Editor or the Browser.

No matter what choice you make, if the material used is not mapped, then all particles take on the surface properties of the material, regardless of which object is used as the source of the material.
Achieving Particle Motion Blur

Particle motion blur is actually the result of varying the opacity and the length of particles based on their speed. To accomplish this requires coordination between material assignment and the settings in the particle systems.

Follow these instructions:

■ Use the Particle MBlur map on page 6308 in the material that you assigned to the particles. For best results, assign it as an opacity map.

■ Make sure that the particle system, PArray, PCloud, and Super Spray, or Spray, supports the Particle MBlur map.

■ Choose Rotation and Collision rollout > Spin Axis Controls group > Direction of Travel/Mblur option.

■ In this same group, set the Stretch spinner greater than 0 to stretch the particles as a percent of their length based on the particle Speed setting.

■ Use the correct type of particle. MBlur works on all particle types except Constant and Facing.

NOTE Instanced objects with multi/sub-object materials cannot be image motion blurred.

Using Mapped Materials with Particle Systems

Mapped materials affect particles differently, depending on the source of the material.
When you choose Icon, the mapping coordinates of the material are applied across the V (vertical) axis, from \( V=0 \) (the bottom edge of the map) to \( V=1 \) (the top edge of the map). The bottom edge of the map is applied at the birth of the particle, and the top edge at either the death of the particle (if Time is on) or the distance of the particle at its death (if Distance is on).

The Time spinner specifies the number of frames from birth that it takes to complete one mapping of a particle. Thus, if set to 15, the particle uses the bottom edge of the map at its birth, and moves through to the top edge of the map at frame 15.

The Distance spinner specifies the distance, in units, from birth that it takes to complete one mapping of a particle. Thus, if set to 50, as the particle moves along the normal vector, it displays the bottom edge of the map at birth, and the top edge at 50 units along the normal vector.

The one exception to this is when you use the Tetra particle type. In this case, each particle is always constantly mapped with \( V=0 \) at the head and \( V=1 \) at the tail.

When you choose Picked Emitter, the particles take on the color of the object at the point at which they're created. If the mapped surface is yellow where the particle emerges, then the particle is yellow.

Again, Tetra particles are an exception and the distribution-object material is mapped from head to tail.
Fragment particles use the same technique, with additional options when the Thickness setting is greater than 0.

When Thickness is 0, all faces in the fragment are mapped the same as the portion of the object surface from which they're derived.

When Thickness is greater than 0, the outer faces of the fragment copy the surface of the distribution object, and are assigned the material ID specified in the Outside ID spinner in the Particle Type rollout > Fragment Materials group. The thickness edges use the Edge ID number, and the inner faces use Backside ID. Thus, by assigning a multi/sub-object material to the object-based emitter, you can specify a different material for the outer fragment surfaces, the edges, and the inner surfaces. Note that the Outside ID spinner defaults to a value of 0, which means “use whatever material is currently assigned.” Change this to a specific sub-material number to assign a sub-material to the outside edges of the fragments.

**Using Multi/Sub-Object Materials with Particle Systems**

If the assigned material is a Multi/Sub-Object material, the source of the material affects how particles are rendered.

- **Icon:** In most cases, each particle, at its birth, is assigned a different sub-material, cycling through each available sub-material. For example, if there are only three sub-materials, the first particle receives sub-material #1, the second #2, the third #3, the fourth #1, and so on. The exceptions to this are as follows:
  - MetaParticles use only the first sub-material.
  - Object fragments are born at once, so all of them use only the first sub-material.
  - **Picked Emitter:** When used with object fragments as particles, each particle uses the three ID numbers in the Fragment Materials group. If this source is used with the other particle types, the particles are assigned sub-materials in the same way as when Icon is chosen.
  - **Instanced Geometry:** When used with Instanced Geometry particles, each particle is assigned a sub-material in exactly the same way as the source object, so each particle looks just like the source object. When used with other particle types, the particles are assigned sub-materials in the same way as when Icon is chosen.
NOTE: Instanced objects with Multi/Sub-Object materials cannot be image motion blurred.

Particles with a Multi/Sub-Object material

Using Spawned Particles

The examples in this topic demonstrate a very simple spawning using the Super Spray particle system.

Example: Setting up the particle system:

1. In the Perspective viewport, create a pyramid that's 5 units in all dimensions.
2. Create a cylinder with a radius and height of 3, and 6 sides.
3. In the center of the Perspective viewport, create a Super Spray emitter.
4. Set Speed in the Particle Motion group (Particle Generation rollout) to 3.0.
5. On the Particle Type rollout, choose Instanced Geometry, then in the Instancing Parameters group click Pick Object, and select the pyramid.
In the Viewport Display group of the Basic Parameters rollout, choose Mesh and set the Percentage of Particles to 100.

On the Particle Generation rollout, choose Use Rate, and set the spinner to 1.

Set Emit Start and Emit Stop to 0, set Display Until to 100, set Life to 10, and leave Variation at 0.

Under Particle Size, set Grow For and Fade For to 0.

Drag the time slider between frames 0 and 15.

A single pyramid particle emerges from the emitter, moves up, and then dies and disappears at frame 10.

**Example: Adding spawning effects:**

1. On the Particle Spawn rollout, choose Spawn on Death.
2. Leave Spawns spinner at 1, and set the Multiplier to 2.
3. Set the Direction Chaos spinner to 50.
4. Drag the time slider slowly over frames 8 to 25 (approximately).
   At frame 10, two pyramids appear at the death of the original particle (because of the Multiplier setting), and move off in different directions (because of the Direction Chaos setting). All particles die after frame 20 because only one generation of spawned particles is specified.
5. Set Spawns to 4, and the Multiplier to 4.
6. Drag the time slider over frames 8 to 50.
   With each spawned generation the particles increase exponentially.

**Example: To mutate the objects:**

1. In the Object Mutation Queue group, click Pick Object, and then select the cylinder.
   The name of the cylinder appears in the list window.
2. Click Pick Object and select the pyramid. Then click Pick Object again, and select the cylinder. Your list now reads: Cylinder01, Pyramid01, Cylinder01.
3. Drag the time slider over frames 0 to 50.
The pyramid appears over frames 0 to 10, then changes to four cylinders at frame 11, then 16 pyramids at the next spawning, and so on.

**Using Interparticle Collision**

You can set up particles to detect collisions with each other. This can be useful when the particles are meant to model solid objects such as marbles.

![Particles colliding and then rebounding](image)

**Procedures**

**Example: To create particles that collide with each other:**

1. Create a Super Spray particle emitter, and place a Deflector space warp on page 2959 a short distance from it with the surface of the deflector perpendicular to the stream of the particles. Bind the deflector to the Super Spray.
2 Set the Super Spray values as follows:
   ■ Off Axis: 1, Spread: 1, Off Plane: 180, Spread: 180
   ■ Mesh: chosen, Percent of Particles: 100
   ■ Particle Quantity: Use Rate chosen and set to: 1
   ■ Speed: 3, Variation: 100%
   ■ Emit Start: 0, Emit Stop: 5, Display Until: 100, Life: 100
   ■ Size: 4.0, Grow For: 0, Fade For: 0
   ■ Particle Type: Sphere

3 Drag the time slider so you can see the particle spheres bounce off the deflector. Note that the rebounding particles move through each other.

4 On the Rotation & Collision rollout, turn on Enable in the Interparticle Collisions group. View the animation again. This time, the particles bounce off each other.

**TIP** InterParticle Collisions, Deflector Binding, and Bubble Noise do not get along well together. Particles may leak through the deflector when these three are used together. Instead of bubble motion use animated mapping. Use facing particles with an animated map of a bubble, where the bubble is smaller than the map size. The bubble is animated moving around the map. This simulates bubble motion at the map level.

**Spray Particle System**

Create panel > Geometry button > Choose Particle Systems from the drop-down list. > Object Type rollout > Spray

Create menu > Particles > Spray

Spray simulates water drops such as rain, a fountain, the spray from a garden hose, and so on.
Kinds of Spray

NOTE SuperSpray on page 3315 is a more powerful and advanced version of Spray. It provides all the functionality of Spray, plus additional features.

TIP To animate particles following a path through space, use the Path Follow space warp on page 2919.

Procedures

To create spray:

1. On the Create panel, make sure the Geometry button is active and Particle Systems is chosen in the object category list, then click Spray.

2. Drag in a viewport to create the Spray emitter; see Creating a Particle Emitter on page 3297.

The emitter's direction vector points in the negative Z direction of the active construction plane. For example, if you create the emitter in the Top viewport, the particles will move downward in the Front and Left viewports.
Interface

Particles group

Viewport Count  Maximum number of particles displayed in viewports at any given frame.

TIP  Setting the viewport count less than the render count can improve viewport performance.
**Render Count** Maximum number of particles that can appear in a single frame when you render it. Works in combination with the particle system's timing parameters.

- When the number of particles reaches the Render Count value, particle creation is suspended until some particles die.
- When enough particles die, particle creation resumes until Render Count is reached again.

**Drop Size** Size of a particle in the active units.

**Speed** Initial velocity of each particle as it leaves the emitter. Particles travel at this speed unless they are affected by a particle system space warp.

**Variation** Varies the initial speed and direction of particles. The greater the Variation, the stronger and broader the spray.

**Drops, Dots, or Ticks** Choose how particles are displayed in viewports. The display setting does not affect how particles are rendered. Drops are streaks that appear like raindrops, dots are points, ticks are small plus signs.

**Render group**

**Tetrahedron** Particles are rendered as long tetrahedrons, with the length you specify in the Drop Size parameter. Tetrahedron is the default setting for rendering. It provides a basic simulation of water drops.

**Facing** Particles are rendered as square faces whose width and height equals the Drop Size. Facing particles always face the camera (or the user's perspective). They are provided especially for use with material maps. Use with an appropriate opacity map for bubbles or snowflakes.

**NOTE** Facing works correctly only in a perspective or camera view.

**Timing group**

Timing parameters control the "birth and death" rates of emitted particles.

At the bottom of the Timing group is a line that displays the maximum sustainable rate. This value is based on the Render Count and the lifetime of each particle. To be precise:

maximum sustainable rate=Render Count/Life

Because the number of particles in a frame never exceeds Render Count, if the Birth Rate exceeds the maximum rate, the system will run out of particles,
pause until some die off, and then start again, generating particles in bursts or spurts.

**Start** Number of the first frame where particles appear.

**Life** The lifetime of each particle, in number of frames.

**Birth Rate** The number of new particles born per frame. If this is less than or equal to the maximum sustainable rate, the particle system generates an even flow of particles. If it is greater than the maximum rate, the particle system generates particles in bursts.

You can animate the Birth Rate parameter.

**Constant** When on, Birth Rate is unavailable and the birth rate used equals the maximum sustainable rate. When off, Birth Rate is available. Default=on. Turning Constant off does not mean that the birth rate varies automatically; the birth rate remains constant unless you animate the Birth Rate parameter.

**Emitter group**

The emitter specifies the area where particles appear in the scene. It has a geometry you can display in viewports, but it isn’t renderable.

The emitter is displayed as a rectangle with a vector pointing out of one side. The vector shows the direction in which the system emits particles.

**Width and Length** You implicitly set the initial value of these parameters when you drag in a viewport to create the emitter. You can adjust the values in the rollout.

The space occupied by the particle system at any given time is the result of a combination of its initial parameters (such as size of the emitter, and speed and variation of emission) and any space warps that have been applied.

**Hide** Turn on to hide the emitter in viewports. When Hide is off, the emitter is displayed in viewports. The emitter is never rendered. Default=off.

**Snow Particle System**

Create panel > Geometry button > Choose Particle Systems from the drop-down list. > Object Type rollout > Snow

Create menu > Particles > Snow
Snow simulates falling snow or confetti. The snow system is similar to Spray, but it has additional parameters to generate tumbling snowflakes, and its rendering options are different.

Kinds of Snow

NOTE Blizzard on page 3319 is a more powerful and advanced version of Snow. It provides all the functionality of Snow, plus additional features.

TIP To animate particles following a path through space, use the Path Follow space warp on page 2919.

Procedures

To create snow:

1. In the Create panel, make sure the Geometry button is active and Particle Systems is selected from the object category drop-down list, then click Snow.

2. Drag in a viewport to create the Snow emitter; see Creating a Particle Emitter on page 3297.

   The emitter's direction vector points in the negative Z direction of the active construction plane.
Interface

Particles group

**Viewport Count** Maximum number of particles displayed in viewports at any given frame.
TIP Setting the viewport count less than the render count can improve viewport performance.

**Render Count** Maximum number of particles that can appear in a single frame when you render it. Works in combination with the particle system’s timing parameters.

- When the number of particles reaches the Render Count value, particle creation is suspended until some particles die.
- When enough particles die, particle creation resumes until Render Count is reached again.

**Flake Size** Size of a particle in the active units.

**Speed** Initial velocity of each particle as it leaves the emitter. Particles travel at this speed unless they are affected by a particle system space warp.

**Variation** Varies the initial speed and direction of particles. The greater the Variation, the broader the area of snowfall.

**Tumble** Amount of random rotation for snowflake particles. This parameter can range from 0 to 1. At 0, flakes do not rotate; at 1, they rotate the most. The axis of rotation is generated randomly for each particle.

**Tumble Rate** Speed at which snowflakes rotate. The greater the Tumble Rate, the faster the rotation.

**Flakes, Dots, or Ticks** Select how particles are displayed in viewports. The display setting does not affect how particles are rendered. Flakes are star-shaped snowflakes, dots are points, ticks are small plus signs.

**Render group**

**Six Point** Each particle is rendered as a six-pointed star. Each side of the star is a face to which you can assign a material. This is the default setting for rendering.

**Triangle** Each particle is rendered as a triangle. Only one side of the triangle is a face to which you can assign a material.

**Facing** Particles are rendered as square faces whose width and height equals the Drop Size. Facing particles always face the camera (or the user’s perspective). They are provided especially for use with material maps. Use with an appropriate opacity map for bubbles or snowflakes.

**NOTE** Facing works correctly only in a perspective or camera view.
Timing group

Timing parameters control the "birth and death" rates of emitted particles.

At the bottom of the Timing group is a line that displays the maximum sustainable rate. This value is based on the Render Count and the lifetime of each particle. To be precise:

maximum sustainable rate=Render Count/Life

Because the number of particles in a frame never exceeds Render Count, if the Birth Rate exceeds the maximum rate, the system will run out of particles, pause until some die off, and then start again, generating bursts or spurts of particles.

Start Number of the first frame where particles appear.

Life The lifetime of a particle, in number of frames.

Birth Rate The number of new particles born per frame.

If this is less than or equal to the maximum sustainable rate, the particle system generates an even flow of particles. If it is greater than the maximum rate, the particle system generates particles in bursts.

You can animate the Birth Rate parameter.

Constant When on, Birth Rate is unavailable and the birth rate used equals the maximum sustainable rate. When off, Birth Rate is available. Default=on.

 Turning Constant off does not mean that the birth rate varies automatically; the birth rate remains constant unless you animate the Birth Rate parameter.

Emitter Group

The emitter specifies the area where particles appear in the scene. It has a geometry you can display in viewports, but it isn't renderable.

The emitter is displayed as a rectangle with a vector pointing out of one side. The vector shows the direction in which the system emits particles.

You set emitter parameters in the Emitter group of the particle system's Parameters rollout.

Width and Length You implicitly set the initial value of these parameters when you drag in a viewport to create the emitter. You can adjust the values in the rollout.

The space occupied by the particle system at any given time is the result of a combination of its initial parameters (size of the emitter, and speed and variation of emission) and any space warps that have been applied.
**Hide** Turn on to hide the emitter in viewports. When off, the emitter is displayed in viewports. The emitter is never rendered. Default=off.

**Super Spray Particle System**

Create panel > Geometry button > Choose Particle Systems from the drop-down list. > Object Type rollout > Super Spray

Create menu > Particles > Super Spray

Super Spray emits a controlled spray of particles. This particle system is like the simple Spray particle system with the added power provided by all the newer particle systems.
To animate particles following a path through space, use the Path Follow space warp on page 2919.
Procedures

To create a super spray particle system:

1. On the Create panel, make sure the Geometry button is active and Particle Systems is chosen in the object category list, then click Super Spray.

2. Drag in any viewport to create the Super Spray emitter icon; see Creating a Particle Emitter on page 3297. The icon appears as an intersecting plane and circle with an arrow. The initial direction of the spray (based on the orientation of the emitter icon and indicated by the icon arrow) depends on the viewport in which you create the icon. Generally, the particles spray toward you when created in an orthographic viewport, or spray upward when created in a Perspective viewport.

3. Adjust the various parameters to alter the spray effect.

Interface

NOTE This section describes the Particle Formation group in the Basic Parameters rollout, and the Particle Motion group in the Particle Generation rollout. These are the only controls unique to Super Spray. The other Super Spray rollouts and their contents are identical with those in Particle Array, except that Object Fragments and associated settings are not available on the Particle Type rollout. See PArray Particle System on page 3331 for details or choose from the following list for rollout information.

- Particle Generation Rollout (PArray) on page 3338
- Particle Type Rollout (PArray) on page 3342
- Rotation and Collision Rollout (PArray) on page 3352
- Object Motion Inheritance Rollout (PArray) on page 3355
- Bubble Motion Rollout (PArray) on page 3356
- Particle Spawn Rollout (PArray) on page 3358
- Load/Save Presets Rollout (PArray) on page 3364
These items control the direction and spread of particles.

**Off Axis** Affects the angle of the particle stream off the Z axis (along the plane of the X axis).

**Spread** Affects the spread of the particles away from the emission vector (along the plane of the X axis).

**Off Plane** Affects the angle of emission about the Z axis. This has no effect if Off Axis is set to 0.
**Spread** Affects the spread of the particles about the Off Plane axis. This has no effect if Off Axis is set to 0.

**Particle Generation rollout > Particle Motion group**

**Speed** The speed of the particle at birth, in units per frame.

**Variation** Applies a percentage of variation to the speed of emission for each particle.

**Blizzard Particle System**

Create panel > Geometry button > Choose Particle Systems from the drop-down list. > Object Type rollout > Blizzard

Create menu > Particles > Blizzard

This is an advanced version of the original Snow particle system.
To animate particles following a path through space, use the **Path Follow space warp** on page 2919.

Blizzard viewport icon (emitter)

Snowflake particles in a blizzard
Procedures

To create a blizzard particle system:

1. On the Create panel, make sure the Geometry button is active and Particle Systems is chosen in the object category list, then click Blizzard.

2. Drag in a viewport to create the Blizzard emitter; see Creating a Particle Emitter on page 3297.
   The icon appears as a plane with a perpendicular line pointing in the direction of emission.

3. Adjust the various parameters on the command panel.

Interface

This section describes the Display Icon group in the Basic Parameters rollout, the Particle Motion group in the Particle Generation rollout, and the Material Mapping and Source group in the Particle Type rollout. These are the only controls unique to Blizzard. The other Blizzard rollouts and their contents are identical with those in Particle Array, except that Object Fragments and associated settings are not available on the Particle Type rollout. See PArray on page 3331 for details or choose from the following list for rollout information.

- Particle Generation Rollout (PArray) on page 3338
- Particle Type Rollout (PArray) on page 3342
- Rotation and Collision Rollout (PArray) on page 3352
- Object Motion Inheritance Rollout (PArray) on page 3355
- Particle Spawn Rollout (PArray) on page 3358
- Load/Save Presets Rollout (PArray) on page 3364
The emitter specifies the location where particles are generated in the scene. It has a geometry you can display in viewports, but it isn’t renderable.

The emitter is displayed as a rectangle with a vector pointing out of one side. The vector shows the direction in which the system emits particles.

You set emitter parameters on the particle system’s Basic Parameters rollout, in the Display Icon group.

**Width and Length** You implicitly set the initial value of these parameters when you drag in a viewport to create the emitter. You can adjust the values on the rollout.

The space occupied by the particle system at any given time is the result of a combination of its initial parameters (such as size of the emitter, and speed and variation of emission) and any space warps that have been applied.

**Emitter Hidden** Hides the emitter in viewports. When off, the emitter is displayed in viewports. The emitter is never rendered. Default=off.
Particle Generation rollout > Particle Motion group

Specifies the number, size, and motion of particles.

**Speed** The speed of the particle at birth, in units per frame.
Variation Applies a percentage of variation to the speed of emission for each particle.

Tumble Amount of random rotation of the particles.

Tumble Rate Speed at which the particles rotate.

Particle Type rollout > Mat'l Mapping and Source group

Emitter Fit Planar Maps particles at birth, based on their point of emission from the rectangular Blizzard emitter icon. The UV range of the mapped material runs from 0 to 1 over the width and length of the emitter.

PCloud Particle System

Create panel > Geometry button > Choose Particle Systems from the drop-down list. > Object Type rollout > PCloud
Create menu > Particles > PCloud

Use the PCloud (or Particle Cloud) particle system when you want a "cloud" of particles that fill a specific volume. PCloud can provide a flock of birds, a starfield, or a troupe of soldiers marching over terrain.

You can confine the particles using basic supplied volumes of a box, sphere, or cylinder, or you can use any renderable object in the scene as a volume as long as that object has depth. Two-dimensional objects do not work with PCloud.

**TIP** There is no automatic way to hide the object chosen as the object-based emitter. Hide it by using Hide Selected on the Display panel, or by applying a Hide key in Track View.
PCloud viewport icon (object-based emitter)

PCloud used to form a school of fish (each fish is a particle)
Procedures

To create a particle cloud:

1 On the Create panel, make sure the Geometry button is active and Particle Systems is chosen in the object category list, then click PCloud.

2 Drag in a viewport to create the PCloud emitter; see Creating a Particle Emitter on page 3297. Adding a PCloud emitter works the same way as creating a box primitive: First drag out the length and width, then release the mouse button and move the mouse vertically to set the height, and then click to finish.

3 The emitter appears with a letter "C" representing the particle cloud.

3 Adjust the various parameters on the command panel.

Interface

This section describes the Object-Based Emitter, Particle Formation, and Display Icon groups in the Basic Parameters rollout, and the Particle Motion group in the Particle Generation rollout. These are the only controls unique to PCloud. The other PCloud rollouts and their contents are identical with those in Particle Array, except that Object Fragments and associated settings are not available on the Particle Type rollout. See PArray on page 3331 for details or choose from the following list for rollout information.

Particle Generation Rollout (PArray) on page 3338
Particle Type Rollout (PArray) on page 3342
Rotation and Collision Rollout (PArray) on page 3352
Object Motion Inheritance Rollout (PArray) on page 3355
Bubble Motion Rollout (PArray) on page 3356
Particle Spawn Rollout (PArray) on page 3358
Load/Save Presets Rollout (PArray) on page 3364
Basic Parameters rollout

Object-Based Emitter group

This button lets you select a renderable mesh object to use as a particle emitter. This object is used only when the Object-Based Emitter option is chosen in the Particle Formation group.

Pick Object Click this, and then select a renderable mesh object to be used as a custom emitter.

Object Displays the name of the picked object.
Particle Formation group

These options let you specify the shape of the emitter.

**Box Emitter** Chooses a box-shaped emitter.

**Sphere Emitter** Chooses a sphere-shaped emitter.

**Cylinder Emitter** Chooses a cylindrical emitter.

**Object-Based Emitter** Chooses the object selected in the Object-Based Emitter group.

**NOTE** With regard to animation of the object-based emitter, the particles will properly fill a deformed object at frame 0, but they can't stay with the emitter while it's moving. If the emitter moves in a straight line, this can give the appearance of the cloud moving with the emitter.

Display Icon group

These options let you adjust the dimensions of the emitter icon when a custom object is not used as an emitter. When a custom object is used you can still resize the "Fill" icon using these options.

**Rad/Len** Adjusts the radius of a spherical or cylindrical icon, and the length of a box icon.

**Width** Sets the width of a box emitter.

**Height** Sets the height of a box or cylindrical emitter.

**Emitter Hidden** Hides the emitter.
Particle Generation rollout > Particle Motion group

Speed The speed of the particle at birth along the normal, in units per frame.

NOTE For the correct volume effect, Speed should be set to 0.

Variation Applies a percentage of variation to the speed of emission for each particle.

Random Direction One of three options that affect the direction of the particles. This option emits particles in random directions.

Direction Vector Specifies the direction of the particles by a vector defined by the three X, Y, and Z spinners.

X/Y/Z Displays the particle direction vectors.

Reference Object Emits particles in the direction of the local Z axis of a specified object.

Object Displays the name of the picked object.
**Pick Object** Click this, and then select an object in the scene to use as a reference object. This button is available only when you choose Reference Object.

**Variation** Applies a percentage of variation to the direction when you choose either the Direction Vector or Reference Object option. This spinner is unavailable and has no effect when you choose Random Direction.

---

**PArray Particle System**

Create panel > Geometry button > Choose Particle Systems from the drop-down list. > Object Type rollout > PArray

Create menu > Particles > PArray

The PArray (Particle Array) particle system can distribute particles on a geometric object. You can also use it to create sophisticated object explosions.

**TIP** A good way to create explosions with PArray is to set the particle type to Object Fragments and then apply a PBomb space warp on page 2914.

When you use PArray to emit particles using a selected geometric object as the emitter template (or pattern) for the emission, the object is referred to as the *distribution object.*
Basket used as a distribution object for random particles over its surface

How particles can be distributed on an object:
Left: Edges
Center: Vertices
Right: Faces

See also:
- Particle System Usage on page 3295
- Using Materials with Particle Array on page 3297
- Achieving Particle Motion Blur on page 3300
- Using Mapped Materials with Particle Systems on page 3300
- Using Multi/Sub-Object Materials with Particle Systems on page 3302
- Using Spawned Particles on page 3303
- Using Interparticle Collision on page 3305

Procedures

To set up a particle array:

1. Create an object that will become the distribution object, providing the emitter pattern (or exploded object) for the particle array.

2. On the Create panel, make sure the Geometry button is active and Particle Systems is chosen in the object category list, then click PArray.

3. Drag anywhere in a viewport to create the particle-system object; see Creating a Particle Emitter on page 3297.

4. On the Basic Parameters rollout, click Pick Object, and then click the object to use as the distribution object.

5. Adjust the various options in the Particle Array rollouts to achieve the effect you want. The distribution object can be any object containing renderable faces. The particle-system object does not appear in the rendered scene. Its placement, orientation or size in the scene has no influence on the particle effect. To access the Particle Array parameters after creation, open the Modify panel and select the particle-system object (or click any visible...
particles in the viewport). To transform or otherwise modify the distribution object, select the distribution object itself.

Also, you can share a single distribution object among more than one particle-system object. The distribution object merely provides the template for the particles, which are actually generated by the particle system.

Example: To assign three different mapped materials to fragments:

1. Apply mapping coordinates to the distribution object, either by turning on Generate Mapping Coords, if necessary, or by applying a UVW Map modifier on page 1932.

2. Assign a Multi/Sub-Object material on page 6120 to the distribution object.

3. Set up the first three sub-materials to be mapped materials.

4. Select the PArray icon.

5. On the Particle Type rollout in the Mat'l Mapping And Source group, choose Picked Emitter.

6. In the Particle Type rollout > Particle Types group, turn on Object Fragments.

7. Make sure the three spinners in the Fragment Materials group are set to 1, 2, and 3, respectively (or match the numbers with the sub-materials you've assigned in your multi/sub-object material).

TIP Using a complex distribution object for object-fragment particles can really slow down viewport interaction. You can use a simple stand-in object as the distribution object, and then later use the File/Replace command to replace the distribution object with a more complex object of the same name.

Basic Parameters Rollout (PArray)

Create panel > Geometry button > Choose Particle Systems from the drop-down list. > Object Type rollout > PArray > Basic Parameters rollout

The items on the Basic Parameters rollout let you create and adjust the size of the particle system, and pick the distribution object. In addition, they let you specify the initial distribution of the particles in relation to the geometry of the distribution object, and the initial velocity of the particles from the
distribution object. From here, you can also specify how the particles appear in the viewport.

**Interface**

**Object-Based Emitter group**

**Pick Object** After you create the particle-system object, the Pick Object button becomes available. Click this button, and then click to select an object in your scene. The selected object becomes the object-based emitter, and is used either
as the source geometry over which particles form, or the source geometry used to create particles that appear to be fragments of the object.

**Object text field** Displays the name of the picked object.

**Particle Formation group**

These options determine how standard particles are initially distributed over the surface of the object-based emitter. These controls are available only when the picked object is used as a distribution grid for standard particles, MetaParticles, or instanced geometry; see Particle Type rollout on page 3342. When Object Fragments is chosen in the Particle Type rollout, these controls are unavailable.

**Over Entire Surface** Emits particles randomly over the entire surface of the object-based emitter. This is the default choice.

**Along Visible Edges** Emits particles randomly from the visible edges of the object.

**At All Vertices** Emits particles from the vertices of the object.

**At Distinct Points** Places a specified number of emitter points randomly over the surface of the object.

**Total** Specifies the number of emitter points used when At Distinct Points is chosen.

**At Face Centers** Emits particles from the center of each triangular face.

**Use Selected SubObjects** With mesh-based emitters, and to a limited extent with patch-based emitters, limits the source of the particle stream to the sub-object selection passed up the modifier stack in the object-based emitter. For example, if your emitter object is a cylinder converted to an editable mesh, and the top cap of that cylinder is selected at the Face or Polygon sub-object level, if Use Selected SubObjects is on and Particle Formation group > At Face Centers is on, the particles will stream only from the top cap of the cylinder. Default=off.

The type of particle formation you specify determines the type of sub-object geometry used, as follows:

- **Over Entire Surface** Faces
- **Along Visible Edges** Edges
- **At All Vertices** Vertices
- **At Distinct Points** Faces
At Face Centers
Faces
If you've converted your object to an editable mesh, and selected different sub-object sections of it with vertex, edge, and face selection, as you switch particle formation options, you'll see the particles emit from different areas of the object.

NOTE Use Selected SubObjects is applicable to patch object emitters only at the patch and element sub-object levels, and is not applicable NURBS objects used as emitters.

TIP You can best see the emission patterns by first setting Speed on the Particle Generation rollout > Particle Motion group to 0. Move to a frame in which the particles appear, and then choose the various particle formation options.

Display Icon group

Adjusts the display of the particle-system icon in the viewports. (The particle-system icon is usually called the "emitter." In this case, however, it doesn't actually emit particles, so we're avoiding the term.)

Icon Size Sets the overall size of the icon, in units.

Icon Hidden When on, the PArray icon is hidden in the viewports. Note that the icon does not render, in any case. Default=off.

Viewport Display group

Specifies how the particles are displayed in the viewports.

Dots Displays the particles as dots.

Ticks Displays the particles as crosses.

Mesh Displays the particles as mesh objects. This results in slower viewport redraws.

BBox For instanced geometry only, this displays each instanced particle, whether a single object, a hierarchy, or a group, as a bounding box.

Percentage of Particles This spinner specifies the number particles displayed in the viewports as a percentage of the number of rendered particles. Default=10 percent.

Set the display percentage to 100 percent if you want to see the same number of particles as will be rendered in your scene. However, this can considerably slow viewport display.
Particle Generation Rollout (PArray)

Create panel > Geometry button > Choose Particle Systems from the drop-down list. > Object Type rollout > SuperSpray/Blizzard/Parray/PCloud > Particle Generation rollout

Select a SuperSpray/Blizzard/Parray/PCloud emitter. > Modify panel > Particle Generation rollout

Items on this rollout control when and how quickly particles form, how particles move, and the size of the particles over time.
Interface

Particle Quantity group

In this group, you can choose one of two methods by which the number of particles is determined over time. These settings are unavailable if you set Particle Type (in the Particle Type rollout on page 3342) to Object Fragments.
Use Rate Specifies a fixed number of particles emitted per frame. Use the spinner to set the number of particles formed per frame.

Use Total Specifies a total number of particles formed over the life of the system. Use the spinner to set the number of particles formed per frame.
The life of the system, in frames, is specified by the Life spinner in the Particle Timing group, described later in this topic.

**TIP** Generally, Use Rate is best for a continuous flow of particles, like a trail of pixie dust, while Use Total is better for bursts of particles over a short period of time.

**Particle Motion group**

These spinners control the initial particle velocity, which is directed along the surface, edge, or vertex normals (interpolated for each emitter point).

**Speed** The velocity of the particle at birth, along the normal, in units traveled per frame.

**Variation** Applies a percentage of variation to the speed of emission for each particle.

**Divergence** Applies an angular degree of variation by which each particle's velocity can vary from the emitter normal.

**NOTE** The initial direction for a fragment cluster is the normal of the cluster's seed face. Clusters are created by choosing a single face (the seed face), and then creating a cluster outward from that face, depending on the method chosen in the Object Fragment Controls group on the Particle Type rollout.

**Particle Timing group**

These options specify when particle emission starts and stops, and the lifespan of the individual particles.

**Emit Start** Sets the frame at which particles begin to exist in the scene.

**Emit Stop** Sets the last frame at which particles are emitted. This setting has no effect if you choose the Object Fragments particle type.

**Display Until** Specifies the frame at which all particles will disappear, regardless of other settings.

**Life** Sets the lifespan in number of frames of each particle from the frame of creation.
Variation Specifies the number of frames by which the life of each particle can vary from the norm.

Subframe Sampling Turning on any of the three check boxes below helps avoid particle "puffing" by sampling particles at a much higher subframe resolution, instead of the relatively coarse frame resolution. Depending on your needs, you can do this over time, over motion, or over rotation. "Puffing" is the effect of emitting separate "puffs" or clusters of particles, rather than a continuous stream. This effect is especially noticeable when the emitter is animated.

- **Creation Time** Enables the addition of a time offset to the equations of motion that prevents puffing in time. This setting has no effect with the Object Fragments particle type. Default=on.

- **Emitter Translation** If the object-based emitter is moving in space, particles are created at integral times at positions along the geometry's path between renderable positions. This prevents puffing in space. This setting has no effect if Object Fragment particle type is on. Default=on.

- **Emitter Rotation** If the emitter is rotating, turn this on to avoid puffing and produce smooth spiral effects. Default=off.

**IMPORTANT** Each additional subframe sampling check box that you turn on progressively increases the necessary computation. In addition, the methods are listed in order of least amount of computation to most. Thus, Emitter Rotation is more costly than Emitter Translation, which is more costly than Creation Time.

---

**Particle Size group**

These spinners specify the size of the particles.

**Size** This animatable parameter specifies the target size for all particles in the system, depending on the type of particle:

- **Standard Particles** The major dimension of the particle.

- **Constant** The dimension, in rendered pixels, of a Constant type of particle.

- **Object Fragments** No effect.

**Variation** The percentage by which the size of each particle may vary from the norm. This is applied to the Size value. Use this parameter to get a realistic mix of large and small particles.
Grow For  The number of frames over which the particle grows from being very small to the Size value. The result is subject to the Size/Variation value, since Grow For is applied after Variation. Use this parameter to simulate natural effects such as bubbles growing as they reach the surface.

Fade For  The number of frames over which the particle will shrink to 1/10th its Size setting prior to its death. This is also applied after Variation. Use this parameter to simulate natural effects such as sparks fading to ash.

Uniqueness group

By changing the Seed value in this spinner, you achieve different results using otherwise identical particle settings.

New  Randomly generates a new seed value.

Seed  Sets a specific seed value.

Particle Type Rollout (PArray)

Create panel > Geometry button > Choose Particle Systems from the drop-down list. > Object Type rollout > SuperSpray/Blizzard/Parray/PCloud > Particle Type rollout

Select a SuperSpray/Blizzard/Parray/PCloud emitter. > Modify panel > Particle Type rollout

The controls on this rollout let you specify the type of particle used and the type of mapping performed on the particles.
Left: A stream from a fountain
Right: The same stream with various types of particles
Chapter 12  Space Warps and Particle Systems
Particle Types group

These options specify one of four categories of particle type. Depending on which option you choose, different controls become available in the lower portion of the Particle Type rollout.

**Standard Particles** Uses one of several standard particle types, such as triangle, cube, tetra, and so on.

**MetaParticles** Uses Metaball particles. These are particle systems in which the individual particles blend together in blobs or streams.

**Object Fragments** Creates particles out of fragments of an object. Object Fragments is available only with Particle Array. Choose it when you want to fracture the particle emitter object and use the pieces as particles. This option is useful for animating explosions and shattering collisions. The fragments are created at the Emit Start frame. The Use Rate, Use Total, Emit Stop, and Particle Size parameters are unavailable.

**Instanced Geometry** Generates particles that are instances of either an object, a linked hierarchy of objects, or a group. The object is selected in the Instancing Parameters group on the Particle Type rollout. Choose Instanced Geometry when you want particles to be identical instances of another object in your scene. Instanced geometry particles are extremely effective for creating crowds, flocks, or flows of very detailed objects. Here are a few examples:

- Instance a red blood cell and use Super Spray to animate blood flowing in an artery.
- Instance a bird and use Particle Cloud to animate a flock of birds flying.
- Instance a rock and use Particle Cloud to animate an asteroid field.

**NOTE** Only one type of particle can be used for the particle system. However, you can have more than one particle array bound to a single object, and each particle array can emit a different type of particle.

**TIP** Image motion blur, described in Object Properties on page 283 > Motion Blur group, is known not to work properly with instanced particles. Use object motion blur with instanced particles, or use image motion blur with standard particles.
Standard Particles group

When you choose Standard Particles in the Particle Types group, the options in this group become available. Choose one of the following options to specify the particle type:

Triangle Renders each particle as a triangle. Use Triangle particles with noise opacity for steam or smoke.

Cube Renders each particle as a cube.

Special Each particle consists of three intersecting 2D squares. These are effective when you use a face-map material, described in Shader Basic Parameters Rollout on page 5969, optionally along with an opacity map, to create the effect of a three-dimensional particle.

Facing Renders each particle as a square that always faces the view. Use with an appropriate opacity map for bubbles or snowflakes.

Constant Provides a particle that remains the same size, in pixels, specified in the Size spinner. This size never changes, regardless of its distance from the camera.

**IMPORTANT** You must render either a camera or a perspective view for Constant particles to render correctly.

Tetra Renders each particle as a mapped tetrahedron. Use Tetra particles for raindrops or sparks.

The default alignment of the tetra particles depends on the particle system type and emitter setup. To specify an alignment, use controls in the Rotation and Collision rollout on page 3352.

SixPoint Renders each particle as a six-pointed, two-dimensional star.

Sphere Renders each particle as a sphere.

MetaParticle Parameters group

When you choose the MetaParticles option in the Particle Types group, the options in this group become available, and metaballs are used as particles. Metaparticles take extra time to render but are very effective for spraying and flowing liquid effects.

Tension Determines the tightness of the particles, with regard to their tendency to blend with other particles. The higher the Tension, the harder the blobs, and the harder it is for them to merge.
Variation Specifies the percent of variation of the Tension effect.

Evaluation Coarseness Specifies how accurately the metaparticle solution is calculated. The higher the coarseness values, the less calculation. However, if the coarseness is too high, there may be little or no metaparticle effect at all. Conversely, if the coarseness is set too low, the time for calculation can become extremely long.

Render Sets the coarseness for metaparticles in the rendered scene. This option is unavailable when Automatic Coarseness is on.

Viewport Sets the coarseness for the viewport display. This option is unavailable when Automatic Coarseness is on.

Automatic Coarseness A general rule is to set the Coarseness value between 1/4 and 1/2 the size of the particles. When this item is on, the rendering coarseness is automatically set, based on the size of the particles, and the viewport coarseness is set to about twice that of the rendering coarseness.

One Connected Blob When off (the default), all particles are calculated; when on, a shortcut algorithm is used that calculates and displays only those particles that are adjoining or contiguous to each other.

NOTE One Connected Blob mode speeds particle calculations, but you should use it only when your metaparticles form one connected blob, as the label indicates. That is, all particles’ blobs must be touching. For example, if you were to use One Connected Blob on a stream of particles containing a mass of 10 contiguous particles followed by a space, then 12 contiguous particles followed by another space, and finally 20 contiguous particles, one of the particles will be chosen, and only the mass connected to that particle will be displayed and rendered.

TIP When in doubt, leave this option off. If you think all your particles are contiguous and want to save time, turn on One Connected Blob, and then display various frames to see if everything appears.

Object Fragment Controls group

With a particle array, when you choose the Object Fragments particle type, the items in this group become available, and the object-based emitter is exploded into fragments, rather than being used to distribute particles.

NOTE To see the fragments in the viewports, choose Mesh in the Viewport Display group near the bottom of the Basic Parameters rollout on page 3334.
The items in this group include a Thickness spinner, along with three option buttons that determine how the fragments are formed.

**TIP** There is no automatic way to hide the distribution object that explodes into fragments. To create the illusion that an object is exploding, you must either set the original object to be invisible at the start of the explosion, as described in Add Visibility Track on page 3910, or move or scale the original object so it doesn't remain in view.

**Thickness** Sets the thickness of the fragments. At 0, the fragments are single-sided with no thickness. When greater than 0, the fragments are extruded, at fragmentation time, by the amount specified. The outer and inner surfaces of the fragment use identical smoothing, which is picked up from the object-based emitter. The edges of the fragments are not smoothed.

The three options that follow specify how the object fragments.

**All Faces** Each face of the object becomes a particle. This results in triangular particles.

**Number of Chunks** The object breaks into irregular fragments. The Minimum spinner, below, specifies the minimum number of fragments that will appear. The method of calculating the chunks may result in more fragments than specified.

**Minimum** Determines a number of "seed" faces in the geometry. Each seed face collects connecting faces surrounding it until all available faces are exhausted. Any leftover faces become unique particles, thus increasing the minimum number of fragments.

**Smoothing Angle** The fragments are broken based on the angles between face normals, as specified in the Angle spinner. Generally, the higher the Angle value, the fewer the number of fragments.

**Angle** Sets the amount of smoothing angle.
Instancing Parameters group

Object: <None>

Pick Object

Use Subtree Also

Animation Offset Keying

- None
- Birth
- Random

Frame Offset: 0

Material Mapping and Source

- Time
- Distance

30
100.0

Get Material From:

- Icon
- Picked Emitter
- Instanced Geometry

Fragment Materials

Outside ID: 0
Edge ID: 2
Backside ID: 3
These options are used when you specify Instanced Geometry in the Particle Types group. They let you generate each particle as an instance of either an object, a linked hierarchy of objects, or a group.

**NOTE** Instanced objects can be animated, providing the animation incorporates one or more of the following types:

- Animation of object geometry parameters, such as a sphere's Radius setting.
- Animation of object-space modifiers, such as the Angle setting of a Bend modifier on page 1165.
- Transform animation of a hierarchical object's children. Transform animation of the top-level parent and non-hierarchical objects is not supported. For example, if you use the toolbar Select and Rotate function on page 915 to animate a box rotating, and then use the box as instanced geometry with a particle system, the system will not use instanced box's keyframed animation.

**Object** Displays the name of the picked object.

**Pick Object** Click this, and then select an object in the viewport to be used as a particle. If you select an object that's part of a hierarchy and Use Subtree Also is on, then the picked object and its children become a particle. If you pick a group, all objects in the group are used as a particle.

**Use Subtree Also** Turn this on when you want to include the linked children of the picked object in the particle. If the picked object is a group, all children of the group are included. Note that you can turn this on or off at any time to alter the particles.

**Animation Offset Keying** Because the instanced objects can be animated, the options here let you specify the timing of the animations for the particles.

**None** Each particle duplicates the timing of the original object. As a result, the animation of all particles will be identically timed.

**Birth** The firstborn particle is an instance of the current animation of the source object at the moment of that particle's birth. Each subsequent particle then uses the same start time for the animation. For example, if the animation of the source object is a bend from 0 to 180 degrees, and the first particle is born at frame 30, when the object is at 45 degrees, then that particle, and all subsequent particles will be born starting at a bend of 45 degrees.

**Random** This option is the same as None when Frame Offset is set to 0. Otherwise, each particle is born using the same animation as the source object.
at the time of birth, but with a random offset of frames, based on the value in the Frame Offset spinner.

**Frame Offset** Specifies an offset value from the current timing of the source object.

**Mat'l Mapping and Source group**

Specifies how a mapped material affects the particles, and lets you specify the source of the material assigned to the particles. A detailed description of how materials affect particles is in the topic Using Mapped Materials with Particle Systems on page 3300.

**Time** Specifies the number of frames from the birth of the particle that it takes to complete one mapping of the particle.

**Distance** Specifies the distance, in units, from the birth of the particle that it takes to complete one mapping of the particle.

**NOTE** Tetra particles are an exception. They always have their own local mapping from head to tail, as described in the following section.

**Get Material From** Updates the material carried by the particle system, using the source specified by the option buttons below this button.

**IMPORTANT** Remember to click Get Material From whenever you choose a different source option button, or whenever you assign a new material to the specified source. Only a single material (or multi/sub-object material) is carried by the particle-system object at any time. Thus, when you change sources, you actually overwrite the currently assigned material with an instance of the source material.

**Icon** The particles use the material currently assigned to the particle system icon.

**NOTE** The Time and Distance options are available only when you choose this option.

**Picked Emitter** The particles use the material assigned to the distribution object.

**Instanced Geometry** The particles use the material assigned to the instanced geometry. This option is available only when you choose Instanced Geometry in the Particle Types group.
IMPORTANT When you turn on either Picked Emitter or Instanced Geometry, an instance of the material from the chosen source is copied to the emitter icon, overwriting the material originally assigned to the icon. Thus, if you've assigned a material to the particle emitter, and then switch to Picked Emitter, the material originally assigned to the icon is replaced by an instance of the material carried by the picked object. If you then return to the Icon option, the particle system does not revert to the material that was assigned the icon, but retains the material taken from the picked object.

Fragment Materials group

These spinners let you assign different material ID numbers to outside surfaces, the edges and the back sides of fragment particles. You can then assign different materials to the front, edge and back of the fragments by using a multi/sub-object material.

Outside ID Specifies which face ID number is assigned to the outside faces of the fragments. This spinner defaults to 0, which is not a valid ID number, forcing the outside of the particle fragments to use whatever material is currently assigned to the associated faces. Thus, if your distribution object already has several submaterials assigned to its outer faces, these materials are retained by using ID 0. If you want a single, specific submaterial, you can assign it by changing the Outside ID number.

Edge ID Specifies which submaterial ID number is assigned to the edges of the fragments.

Backside ID Specifies which submaterial ID number is assigned to the back sides of the fragments.

Rotation and Collision Rollout (PArray)

Create panel > Geometry button > Choose Particle Systems from the drop-down list. > Object Type rollout > SuperSpray/Blizzard/Parray/PCloud > Rotation and Collision rollout

Select a SuperSpray/Blizzard/Parray/PCloud emitter. > Modify panel > Rotation and Collision rollout

Particles often move at high rates of speed. In such cases, you might want to add motion blur to the particles to enhance their motion. Also, real-world particles typically rotate as they move, and collide with each other.
The options on this rollout affect the rotation of the particles, provide motion blur effects, and control inter-particle collisions.

**Interface**

<table>
<thead>
<tr>
<th>Rotation and Collision</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spin Speed Controls</td>
</tr>
<tr>
<td>Spin Time: 0</td>
</tr>
<tr>
<td>Variation: 0.0 %</td>
</tr>
<tr>
<td>Phase: 0.0 deg</td>
</tr>
<tr>
<td>Variation: 0.0 %</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Spin Axis Controls</th>
</tr>
</thead>
<tbody>
<tr>
<td>Random</td>
</tr>
<tr>
<td>Stretch: 0</td>
</tr>
<tr>
<td>User Defined</td>
</tr>
<tr>
<td>X Axis: 1.0</td>
</tr>
<tr>
<td>Y Axis: 0.0</td>
</tr>
<tr>
<td>Z Axis: 0.0</td>
</tr>
<tr>
<td>Variation: 0.0 % deg</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Interparticle Collisions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
</tr>
<tr>
<td>Calc Intervals Per Frame:</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>Bounce: 100.0 %</td>
</tr>
<tr>
<td>Variation: 0.0 %</td>
</tr>
</tbody>
</table>

**Spin Speed Controls group**

**Spin Time** The number of frames for one rotation of a particle. If set to 0, no rotation takes place.

**Variation** The percent of variation of the Spin Time.
Phase Sets the initial particle rotation, in degrees. This has no meaning for fragments, which always begin with zero rotation.

Variation The percent of variation of the Phase.

Spin Axis Controls group

These options determine the spin axis for the particles, and provide a partial method of applying motion blur to the particles.

Random The spin axis for each of the particles is random.

Direction of Travel/Mblur (Not available with the Blizzard particle system.) Rotates the particles about a vector formed by the direction in which they're moving. This option also lets you apply a form of motion blur to the particles by using the Stretch spinner. For further information, see Achieving Particle Motion Blur on page 3300.

Stretch When greater than 0, the particles stretch along the travel axis, depending on their speed. Specifically, the Stretch value specifies the percent of their length per each unit of the Speed setting (in the Particle Motion group). Thus, if you set Stretch to 2 while Speed is set at 10, the particles are stretched 20 percent longer than their original size along the axis of their travel. This spinner is available only when you choose Direction of Travel/Mblur.

NOTE For best results when using Stretch, you should also assign the Particle MBlur map as an opacity map of the material assigned to the particle system.

User Defined Uses a vector defined in the three X, Y, and Z axis spinners.

X/Y/Z Axis Specifies the spin vector of the X, Y, or Z axis, respectively. These spinners are available only when User Defined is chosen.

Variation The amount, in degrees, by which the spin axis of each particle may vary from the specified X Axis, Y Axis, and Z Axis settings. This spinner is available only when you choose User Defined.

Interparticle Collisions group

These options enable collisions between particles, and control how the collisions occur. Note that this involves intensive calculation, particularly when large numbers of particles are involved.

Enable Enables inter-particle collisions in the calculation of the particle movements.
Calc Intervals Per Frame The number of intervals per rendering interval, during which an inter-particle collision test is conducted. The higher the value, the more accurate the simulation, but the slower the simulation will run.

Bounce The degree to which speed is recovered after a collision.

Variation The percentage of random variation of the Bounce value, applied to the particles.

Object Motion Inheritance Rollout (PArray)

Create panel > Geometry button > Choose Particle Systems from the drop-down list. > Object Type rollout > SuperSpray/Blizzard/PArray/PCloud > Object Motion Inheritance rollout

Select a SuperSpray/Blizzard/PArray/PCloud emitter. > Modify panel > Object Motion Inheritance rollout

Each particle's position and direction of movement are determined by the position and orientation of the emitter at the time the particle is created. If the emitter is moving through the scene, particles are scattered along the emitter's path.

Use these options to affect the motion of the particles by the motion of the emitter.

Procedures

Example: To observe object motion inheritance:

1. Create a Super Spray particle system.

2. Animate the emitter moving sideways (perpendicular to the direction of the particle stream) between frames 1 and 15.

3. Play the animation while observing it from the Top viewport.
   The emitter stops at frame 15, while the particles it has emitted up to that point continue moving along the diagonal between the emitter's path and that of the particles. The remaining particles move straight out from the emitter.

4. On the Object Motion Inheritance rollout, set Influence to 50.

5. Play the animation again.
This time, only some of the particles inherit the emitter’s motion, while the rest move straight out from the emitter. Note that the latter form a diagonal stream because each particle emerges at a subsequent point on the emitter path.

**Interface**

<table>
<thead>
<tr>
<th>- Object Motion Inheritance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Influence: 100.0%</td>
</tr>
<tr>
<td>Multiplier: 1.0</td>
</tr>
<tr>
<td>Variation: 0.0%</td>
</tr>
</tbody>
</table>

**Influence** The percent of particles that inherit the motion of the object-based emitter at the moment of particle formation. For example, when this is set at 100 (the default), all particles travel along with a moving object; when it’s set at 0, none of the particles are affected by the translation of the object and fall behind its movement.

**Multiplier** Modifies the amount by which the emitter motion affects the particle motion. This can be a positive or negative number.

**Variation** Provides a percentage of variation of the Multiplier value.

**Bubble Motion Rollout (PArray)**

Create panel > Geometry button > Choose Particle Systems from the drop-down list. > Object Type rollout > SuperSpray/Parray/PCloud > Bubble Motion rollout

Select a SuperSpray/Parray/PCloud emitter. > Modify panel > Bubble Motion rollout

Bubble motion provides the wobbling effect you see in bubbles rising underwater. Typically, it’s used when the particles are set to rise in thin streams. Bubble motion is similar to a waveform, and the Bubble Motion parameters let you adjust the amplitude, period, and phase of the bubble “wave.”

**NOTE** The bubble motion is not affected by space warps, so you can use a space warp to control the direction of the particle flow without altering the local, wobbling bubble effect.
TIP InterParticle Collisions, Deflector Binding, and Bubble Noise do not get along well together. Particles may leak through the deflector when these three are used together. Instead of bubble motion, use animated mapping. Use facing particles with an animated map of a bubble, where the bubble is smaller than the map size. The bubble is animated moving around the map. This simulates bubble motion at the map level.

Interface

<table>
<thead>
<tr>
<th>Bubble Motion</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amplitude: 0.0</td>
</tr>
<tr>
<td>Variation: 0.0 %</td>
</tr>
<tr>
<td>Period: 100000</td>
</tr>
<tr>
<td>Variation: 0.0 %</td>
</tr>
<tr>
<td>Phase: 0.0 deg</td>
</tr>
<tr>
<td>Variation: 0.0 %</td>
</tr>
</tbody>
</table>

Amplitude The distance the particle moves off its usual velocity vector as it travels.

Variation The percent of Amplitude variation applied to each particle.

Period The cycle time for one complete oscillation of a particle through the bubble "wave." A recommended value might be 20 to 30 intervals.

NOTE Bubble motion is measured in time, not in rate, so a very large Period value means the motion takes a long time to complete. Thus, there is no motion, effectively. Period is therefore set to a very large default value so that the default motion of this type is none.

Variation The percent of Period variation for each particle.

Phase The initial displacement of the bubble pattern along the vector.

Variation The percent of Phase variation for each particle.
Particle Spawn Rollout (PArray)

Create panel > Geometry button > Choose Particle Systems from the drop-down list. > Object Type rollout > SuperSpray/Blizzard/Parray/PCloud > Particle Spawn rollout

Select a SuperSpray/Blizzard/Parray/PCloud emitter. > Modify panel > Particle Spawn rollout

The options on the Particle Spawn rollout let you specify what happens to particles when they die, or when they collide with a particle deflector. Using the options on this rollout, you can have particles generate additional generations of particles upon collision or death.
### Interface

#### Particle Spawning Effects group

Choose one of these options to determine what happens to the particles at either collision or death.

<table>
<thead>
<tr>
<th>Option</th>
<th>Persist</th>
<th>Variation</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Die After Collision</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Spawn on Collision</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Spawn on Death</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Spawn Trails</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- **Spawns:**
  - Value: 1

- **Affects:**
  - Value: 100

- **Multiplier:**
  - Value: 1

- **Variation:**
  - Value: 0.0

#### Direction Chaos

- **Chaos:**
  - Value: 0.0

#### Speed Chaos

- **Factor:**
  - Value: 0.0

- **Sbw:**
  - Value: Fast

- **Inherit Parent Velocity:**
  - Value: Yes

- **Use Fixed Value:**
  - Value: No

#### Scale Chaos

- **Factor:**
  - Value: 0.0

- **Down:**
  - Value: Yes

- **Up:**
  - Value: Yes

- **Both:**
  - Value: Yes

- **Use Fixed Value:**
  - Value: No
None Uses none of the spawning controls, and the particles act as they normally would. That is, upon collision, they either bounce or stick, depending on Particle Bounce settings in the deflector, and on death they disappear.

Die After Collision Particles disappear when they strike a deflector to which they're bound, such as the SDeflector.

Persist The life, in frames, that the particle will persist after the collision. Setting this to 0 (the default) causes particles to vanish immediately after the collision.

Variation Varies the Persist value of each particle, when Persist is greater than 0. This lets you "feather" the dying off of particle density.

Spawn on Collision Spawn effects take place upon collision with a bound deflector.

Spawn on Death Spawn effects take place at the end of each particle's life.

Spawn Trails Particles are spawned from existing particles at each frame of that particle's life. The Multiplier spinner specifies the number of particles that are spawned from each particle. The base direction of the spawned particles is opposite that of the parent's velocity. The Scale, Direction, and Speed Chaos factors are applied to that base direction.

NOTE If the Multiplier is greater than 1, at least one of the three Chaos factors must be greater than 0 in order to see the additional spawned particles. Otherwise, the multiples will occupy the same space.

WARNING This option can produce many particles. For best results, begin by setting Particle Quantity on the Particle Generation rollout to Use Rate and to 1.

Spawns The number of spawns beyond the original particle generation. For example, if this is set to 1, and you're spawning at death, one spawning will occur beyond the original lifespan of each particle.

Affects Specifies the percentage of particles that will spawn. Reducing this reduces the number of particles that produce spawned particles.

Multiplier Multiplies the number of particles spawned at each spawning event.

Variation Specifies a percentage range by which the Multiplier value will vary, frame by frame.
Direction Chaos group

Chaos Specifies the amount by which the direction of the spawned particle can vary from the direction of the parent particle. A setting of 0 means no variance. A setting of 100 causes the spawned particle to travel in any random direction. A setting of 50 causes the spawned particle to deviate from its parent's path by up to 90 degrees.

Speed Chaos group

These options let you vary the spawned particles' speed randomly in relation to their parents' speed.

Factor This is the range of a percentage of change in the speed of the spawned particle relative to its parent. A value of 0 means no change.

Slow Applies the speed factor randomly to slow the speed of the spawned particles.

Fast Randomly speeds up particles based on the speed factor.

Both Some particles speed up, while others slow down, based on the speed factor.

Inherit Parent Velocity Spawned particles inherit the speed of their parents, in addition to the effect of the speed factor.

Use Fixed Value Uses the Factor value as a set value, rather than as a range applied randomly to each particle.
Scale Chaos group

These options apply random scaling to the particles.

**Factor** Determines a random percentage range of scaling of the spawned particles relative to their parents, and dependent on the options below.

**Down** Randomly scales down spawned particles to be smaller than their parents, based on the Factor value.

**Up** Randomly scales up spawned particles to be larger than their parents.

**Both** Scales spawned particles both larger and smaller than their parents.

**Use Fixed Value** Uses the Factor value as a fixed value, rather than a range of values.

Lifespan Value Queue group

These options let you specify a list of alternative lifespan values for each spawned generation of particles. The spawned particles use these lifespans.
rather than the lifespan specified for the original particles in the Life spinner on the \textit{Particle Generation rollout} on page 3338.

\textbf{List window} Displays a list of lifespan values. The first value on the list is used for the first generation of spawned particles, the next value is used for the next generation, and so on. If there are fewer values on the list than there are spawnings, then the last value is used repeatedly for all remaining spawnings.

\textbf{Add} Adds the value in the Lifespan spinner to the list window.

\textbf{Delete} Deletes the currently highlighted value in the list window.

\textbf{Replace} Lets you replace a value in the queue with a value in the Lifespan spinner. To use, first place a new value in the Lifespan spinner, then select the value in the queue you want to replace, and click the Replace button.

\textbf{Lifespan} Use this to set a value, and then click the Add button to add the value to the list window.

\textbf{Object Mutation Queue group}

The options in this group let you switch between instanced-object particles with each spawning (as set with the Spawns spinner). These options are available only if Instanced Geometry is the current particle type.

\textbf{List window} Displays a list of objects to be instanced as particles. The first object on the list is used for the first spawning, the second for the second spawning, and so on. If there are fewer objects on the list than there are spawnings, then the last object on the list is used for all remaining spawnings.

\textbf{Pick} Click this, and then select an object in the viewport to add to the list. Note that the type of object you use is based on the settings in the Instancing Parameters group of the Particle Type rollout. For example, if you've turned on Subtree in that group, you can pick object hierarchies. Likewise, if you've picked a group, you can use groups as your spawned particles.

\textbf{Delete} Deletes the currently highlighted object in the list window.

\textbf{Replace} Replaces an object in the queue with a different object. Select an object in the queue to enable the Replace button. Click Replace, and then pick an object in the scene to replace the highlighted item in the queue.
Load/Save Presets Rollout (PArray)

Create panel > Geometry button > Choose Particle Systems from the drop-down list. > Object Type rollout > SuperSpray/Blizzard/Parray/PCloud > Load/Save Presets rollout

Select a SuperSpray/Blizzard/Parray/PCloud emitter. > Modify panel > Load/Save Presets rollout

These options let you store preset values that can be used in other, related particle systems. For example, after setting parameters for a PArray and saving it under a specific name, you can then select another PArray system, and load the preset values into the new system.

Interface

| Preset Name | An editable field in which you can define a name for your settings. Click the Save button to save the preset name.
| Saved Presets | Contains all the saved preset names. A number of presets are included with 3ds Max; to see what they do, create a particle system, load a preset, and play back the animation. Some of the presets, such as Particle Array's Shimmer Trail, are most effective with moving particle systems.

- Load | Loads the preset currently highlighted in the Saved Presets list. Alternatively, double-click the preset name in the list to load it.

- Save |
Save Saves the current name in the Preset Name field and places it in the Saved Presets window.

Delete Deletes the selected items in the Save Presets window.

NOTE Animated parameter values subsequent to frame 0 are not stored.
3ds Max gives you a variety of different ways to create animation, and a wealth of tools for managing and editing animation.

A spacefighter model is animated by following a path.

See also:
- Saving and Loading Animation on page 4103
- Animation Layers (Layer Controller) on page 3467
- Animation and Time Controls on page 8089
Animation Concepts and Methods

With 3ds Max, you can create 3D computer animation for a variety of applications. You can animate characters or vehicles for computer games, or you can animate special effects for film or broadcast. You can create animation for serious purposes such as medical illustration or forensic presentation in the courtroom. Whatever reason you have to animate, you'll find 3ds Max a capable environment for achieving your goals.

The basic way to animate is quite simple. You animate the transform parameters of any object to change its position, rotation, and scale over time. Turning on the Auto Key button, then moving the time slider places you in a state in which any changes you make will create animation for the selected objects in the viewport.

Animation is used throughout 3ds Max. You can animate the position, rotation, and scale of an object, and almost any parameter setting that affects an object's shape and surface. You can link objects for hierarchical animation, using both forward and inverse kinematics, and you can edit your animation in Track View.

This section discusses the basics of creating animation. It looks briefly at a comparison between computer animation and classic hand-drawn animation, and then describes the creation of keyframed animation.

Animation Concepts

Animation is based on a principle of human vision. If you view a series of related still images in quick succession, you perceive them as continuous motion. Each individual image is referred to as a frame.
A frame is a single image in an animated film.

**Traditional Animation Method**

Historically, the main difficulty in creating animation has been the effort required of the animator to produce a large number of frames. One minute of animation might require between 720 and 1800 separate images, depending on the quality of the animation. Creating images by hand is a big job. That’s where the technique of keyframing comes in.

Most of the frames in an animation are routine, incremental changes from the previous frame directed toward some goal. Traditional animation studios realized they could increase the productivity of their master artists by having them draw only the important frames, called keyframes. Assistants could then figure out what belonged on the frames in between the keyframes. The in-between frames were called tweens.

Once all of the keyframes and tweens were drawn, the images had to be inked or rendered to produce the final images. Even today, production of a traditional animation usually requires hundreds of artists to generate the thousands of images needed.
The frames marked 1, 2, and 3 are key frames. The other frames are tweens.

**The 3ds Max Method**

This program is your animation assistant. As the master animator, you create the keyframes that record the beginning and end of each animated sequence. The values at these keyframes are called keys. 3ds Max calculates the interpolated values between each key to produce the completed animation. 3ds Max can animate just about any parameter in your scene. You can animate modifier parameters, such as a Bend angle or a Taper amount, material parameters, such as the color or transparency of an object, and much more.

Once you have specified your animation parameters, the renderer takes over the job of shading and rendering each frame. The result is a high-quality animation.
The object’s position at 1 and 2 are the keyframed models at different times. The computer generates the in-between frames.

Comparing Frames and Time

Traditional animation methods, and early computer animation programs, are rigidly locked to the concept of producing animation frame by frame. This is okay if you always work in a single format or do not need to specify an animated effect at a precise time. Unfortunately, animation comes in many formats. Two of the more common formats are film at 24 frames per second (FPS) and NTSC video on page 8654 at 30 FPS. Also, the need for accurate time-based animation versus frame-based animation is critical as animation becomes more common for scientific and legal presentation.
Different animation formats have differing frame rates.

3ds Max is a time-based animation program. It measures time, and stores your animation values, with an internal precision of 1/4800 of a second. You can configure 3ds Max to display time in a format best suited for your work, including traditional frames format. See Time Configuration on page 8106.

Many of the examples in the following sections describe time using the frames method for the sake of tradition and familiarity. Keep in mind that you are really animating using a very precise time-based method, and frames aren’t created until you instruct 3ds Max to render your animation.

**Identifying Animation Tools**

You can locate the basic animation tools in the following areas of the interface:
Track View Provides detailed animation editing capabilities in several floating or dockable windows. See Track View on page 3790.

Track Bar Provides quick access to keyframes and interpolation controls. Can be expanded for function curve editing. See Track Bar on page 8071.

Motion Panel Use this panel to adjust transform controllers that affect all position, rotation, and scale animation. See Working with Controllers on page 3391.

Hierarchy Panel Use this panel to adjust all parameters governing the linkage of two or more objects. These include inverse kinematics parameters and pivot point adjustments. See Hierarchy Panel on page 8213.

Time Controls Use these controls to move through time in the viewport displays. You can move to any point in time, and play animations in the viewports. The time controls, documented in Animation and Time Controls on page 8089, include:

- Time slider on page 8068
- Auto Key button on page 8090
- Set Key buttons on page 8093
- Animation playback buttons on page 8102
- Current frame field on page 8104
- Key Mode toggle on page 8105
- Time Configuration button on page 8106

To get started with animation, see Using Auto Key Mode on page 3373.

Using Auto Key Mode

Start creating an animation by turning on the Auto Key button, setting a current time, and then changing something in your scene. You can change the position, rotation, or scale of an object, or change almost any setting or parameter.

When you make a change, a key storing the new value for the changed parameter is created at the current time. If that key was the first animation key created for the parameter, a second animation key is also created at time 0 to hold the parameter's original value.
Keys are not created at time 0 until you create at least one key at another time. After that, you can move, delete, and re-create keys at time 0.

Turning Auto Key on has the following effects:

- The Auto Key button, the time slider, and the border of the active viewport turn red to indicate you are in animation mode.
- Whenever you transform an object or change an animatable parameter, 3ds Max creates keys at the current frame, as indicated by the time slider position.

To begin animating an object:

1. Click Auto Key to turn it on.
2. Drag the time slider to a time other than 0.
3. Do one of the following:
   - Transform an object.
   - Change an animatable parameter.

For example, if you have a cylinder that has not been animated yet, it has no keys. If you turn on Auto Key, and at frame 20 you rotate the cylinder 90 degrees about its Y axis, rotation keys are created at frames 0 and 20. The key at frame 0 stores the original orientation of the cylinder, while the key at frame 20 stores the animated orientation of 90 degrees. When you play the animation, the cylinder rotates 90 degrees about its Y axis over 20 frames.

**TIP** To change the default start frame to 1, or to disable automatic start-frame recording, use the Animation Preferences > Auto Key Default Frame controls on page 8350.

**Modeling Without Animating**

Just as you can animate at any time by turning Auto Key on, you can also model at any time in your animation without creating animation keys.
The results of changing an object or any other parameters with Auto Key off varies according to whether or not the object or parameters have been animated yet.

■ If you create a new object, or change an object parameter that has not been animated yet, you can work at any time with Auto Key off. The changes you make are constant through the entire animation. For example, you might animate an object bouncing around your scene and then decide to create pads for the object to land on. To do that, you drag the time slider to a time when the bouncing object hits the ground, and make sure Auto Key is off before you proceed. You can then create a pad under the bouncing object and repeat the process at the next time where it hits the ground. Because Auto Key is off, the frame at which you create the pad objects does not matter. They remain present and inanimate through the entire animation.

■ If you change an object or parameter that is already animated, while Auto Key is off, the amount of change is applied equally across all the animation keys. For example, you might animate a sphere’s radius to be 15 at frame 0, 30 at frame 10, and 50 at frame 20. If you drag the time slider to frame 10, turn Auto Key off, and increase the sphere’s radius from 30 to 40, the change in the radius is applied to the other two keys as well. Because you increased the radius by 10 units with Auto Key off, all radius keys are increased by 10 units. The sphere’s radius is now 25 at frame 0, 40 at frame 10, and 60 at frame 20.

If Auto Key had been on when you changed the radius, it would have been an animated change applied only to the key at frame 10.

Identifying What Can Be Animated

Because most parameters in 3ds Max can be animated, the easiest way to find out if something can be animated is just to try it. Usually, if you want to animate a parameter, it can be animated.

Sometimes you need to know in advance if you can animate a parameter. If so, you can use Track View on page 3790. The Track View Hierarchy list displays every parameter that can be animated. You might also need to add a controller on page 3424 to a track before it can be animated.
Using Set Key Mode

The Set Key animation method is designed for the professional character animator who wants to be able to try out poses and then commit those poses to keyframes intentionally. It can also be used by any animator to set keys on specific tracks of objects.

The Set Key method allows more control than the Auto Key method, because it gives you the chance to try out ideas and discard them quickly without having to undo work. It lets you transform objects and selectively key certain tracks on certain objects through the use of Key Filters and Keyable tracks in Track View.

NOTE Although the following information uses the example of animating a character, it also applies to animating a complex mechanical assembly.

Straight-Ahead and Pose-to-Pose

Traditional animation is created one of two ways, either straight-ahead animation or pose-to-pose animation. Straight-ahead animation is drawn starting from the beginning and then additional frames are drawn sequentially thereafter, moving straight ahead in time. Pose-to-pose animation is created by drawing the important frames first (extremes and breakdowns), and then the intervening frames are filled in later.

Once a character has been correctly drawn for a specific frame, pose-to-pose animation requires that all the keyable tracks needs to be keyframed. This creates a pose of the character that will not be affected if animation for the character is edited at other points in time. If all the animatable tracks are keyed in the extremes, the in-betweening work will not destroy any of those poses.

Set Key and Pose-to-Pose Animation

The number of objects and tracks that require keying for a character, even a simple character, is not something that can be easily handled manually. Set Key makes this process easier by listing all the tracks that are parts of the character that have to be keyed when you want to fix a pose and create a snapshot in time. Keyable tracks let you determine which tracks can be keyed, then Key filters let you work on them selectively, placing keys on only the tracks you want.
Differences Between Set Key and Auto Key Modes

Set Key mode differs from Auto Key in a number of ways.

**Auto Key**
In Auto Key mode, the workflow is to turn on Auto Key, move to a point in time, then transform objects or change their parameters. All changes register as keyframes. When you turn off Auto Key mode, you no longer are creating keys. Changes made to objects when Auto Key mode is off are applied globally to the animation. This is referred to as *Layout mode*.

**Set Key**
In Set Key mode, the workflow is similar, but the behavior is fundamentally different. Turn on Set Key mode, then move to a point in time. Before you transform or change object parameters, you determine the tracks you want to set keys on using Keyable icons in Track View and Filters. Once you know what you plan to key, you try out poses in the viewport (transform the objects, change parameters, and so forth).

When you like what you see, click the large Set Keys button or press K on the keyboard to set a key. If you don't do this, no keys are set.

If you move to another point in time, your changes are lost and have no effect on your animation. For example, if you find that you have a posed character, but *at the wrong frame* in time, you can hold down Shift and the right-mouse button and drag the time slider to the correct frame without losing your pose.

**Using Set Key with Inverse Kinematics**

Choosing IK Parameters in Key Filters allows you to use Set Key to keyframe inverse kinematics. This lets you set keys for IK goals and end effectors using Set Key as well as other IK parameters such as Swivel Angle or Twist.

As always, when using Set Key, you can selectively keyframe tracks by combining Keyable icons in Track View with Key Filters.

Set Key doesn't currently support IK/FK Enabling, so don't try to keyframe the Enable button using the Set Key button or the keyboard shortcut. Use the Auto Key method when you want to work with IK/FK blending.

**Using Set Key with Materials**

If you select Materials in Key Filters, you can use Set Key to create keys for materials. Be forewarned that you need to use Keyable Icons to limit the tracks
which get keyed. If you simply turn on Materials and set a key, you will place keys on every Material track, something you probably don't want to have happen.

**Using Set Key with Modifiers and Object Parameters**

When you want to set a key on an object's parameters, and you have the Object Parameters Key Filter selected, every parameter will receive a key, unless you have turned off the parameter track in the Controller window of Track View using Keyable icons. It might be easier to simply Shift+right-click the parameter spinner to set the key.

Also make sure both Modifiers and Object Parameters are turned on in the Filters dialog on page 3889 when you are keyframing a modifier gizmo.

**Additional Set Key Tools**

Additional Set Key Tools are found in the Customize User Interface dialog on page 8249. On the Keyboard panel, choose Set Key Tools from the Category field. Here, you can set keyboard shortcuts to clear the Set Key buffer, as well as create keys on just a single axis for a transform.

**Using Set Key with Sub-Object Animation**

When using Set Key with sub-object animation, you must first assign a controller before creating a key. Sub-objects do not have a default controller assigned upon creation. The controller is assigned by animating at the sub-object level.

**Other Methods to Set Keys**

You can also set position, rotation, and scale keys by right-clicking the Frame Indicator of the time slider. To set keys on parameters that have spinners, hold down the Shift key and right-click to set a key using the existing parameter value.

**Procedures**

**To use Set Key animation:**

1. Turn on the Set Key button.

   When the button is red you are now in Set Key mode.
This is a mode where you can try out ideas before you commit to them.

2. Open Track View (either Curve Editor or Dope Sheet).

3. Click the Show Keyable button on the Track View toolbar.

4. Turn off all the other tracks you don’t want to keyframe.
   - The red key means the track will be keyed. If you click the red key, it turns to a gray key, which means that track will not be keyed.

   **TIP** You can toggle multiple tracks as keyable by using the Controller menu > Keyable command.

   When you are finished, minimize or close Track View.

5. Click the Key Filters button, and turn on the Filters to choose the tracks you want keyframed.
   - Position, Rotation, and Scale are on by default. So is IK Parameters.
   - You can use the Key Filters button to work on individual tracks selectively. For example, if you are in Track View and the Rotation and Position tracks of a character’s arm are keyable, you can use the key filters to turn off the Position filter and only work on the Rotation tracks.

6. Move the time slider to another point in time, transform your objects or adjust parameters in the command panels to create animation.
   - This does not yet create keyframes.

7. Click the Set Keys button or press K on the keyboard to set a key.
   - When the button turns red, it sets a key which appears on the time ruler. The keys are color coded to reflect which tracks are being keyed.

   If you don’t click Set Keys and you move to another point in time, the pose is lost.
**TIP** To move the pose to another point in time, use the right mouse button to press and drag the time slider. This lets you move to another frame number without losing the pose.

To animate a vertex using Set Key:

1. Create an editable spline.
2. Select a vertex.
3. Turn on Set Key mode.
4. Move the selected vertex.
5. Click the Set Keys button.

Now a controller has been assigned to the vertex. From this point forward, you can animate.

To set a key on every keyable track of an object:

1. Select the object for which you need to set keys.
2. On the Key Filters dialog, click All.
3. Click the Set Keys button or press **K** on the keyboard.

**Spinner Right-Click Menu**

To open the spinner right-click menu, right-click the editable field of an animatable parameter. This menu provides options for cutting, copying, and pasting values, wires, and animation tracks between various object parameters. It also allows you to show the parameter in Track View on page 3790 or in the Parameter Wiring dialog on page 3612.

**Interface**

With the exceptions of Undo and Select All, each of the following commands takes effect on the parameter you right-click. It's not necessary to first click in the value field.
**Undo** Reverses the effect of the last action.

**Cut** Removes highlighted text to be pasted elsewhere.

**Copy** Copies highlighted text to be pasted elsewhere.

**Paste** Inserts cut or copied text into the editable field.

**Delete** Removes highlighted text.

**Select All** Highlights all text within the active editable field.

**NOTE** In order for Select All to work, the text cursor must be active in the field that you right-click to open the menu. For best results, first click in the field, and then right-click the field and choose Select All.

**Copy Animation** Copies the animation controller, including all animation keys, to a buffer, which you can then assign elsewhere by pasting.

**Paste Animation - Copy** Assigns a copy of animation controller in the buffer to the right-clicked field.

**Paste Animation - Instance** Assigns an instance on page 8611 of the copied animation controller to the right-clicked field.

**Paste Animation - Wire** Opens a Parameter Wiring dialog on page 3612 with the copied parameter and the paste destination parameter selected. This is
equivalent to creating a **wire parameter** on page 3610 in the viewport between two parameters.

**Edit Wire** Opens the **Parameter Wiring dialog** on page 3612 expanded and positioned to show the wire controller assigned to the selected parameter.

**NOTE** Edit Wire is available only if a **two-way connection** on page ?is currently applied on the right-clicked parameter.

**Show in Track View** Opens a Track View - Curve Editor window, titled “Selected,” expanded and positioned to show the selected parameter. This is very useful for fast access to a particular curve or track.

**Show in Parameter Wire dialog** Opens a Parameter Wiring dialog expanded and positioned to show the selected parameter.

### Viewing and Copying Transform Keys

The viewports display white brackets around objects that have transform keys at the current time. These key brackets only appear in viewports using the wireframe shading method.

Use the Track View to view all key types. You can also see all keys for the current selection in the **track bar** on page 8071.

For example, suppose you animate a sphere by moving it at frame 20, and scale and rotate it at frame 50. When you drag the time slider, white brackets appear around the sphere at frames 50, 20, and 0, and keys appear at the same frames in the track bar.

If you then apply a modifier such as Bend, and animate its Angle setting at frame 40, you won't see a white bracket around the sphere at frame 40, but track bar displays a key for the Bend animation.
Controlling Key Bracket Display

You can control the display of key brackets using options in the Preference Settings dialog > Animation panel on page 8346.

Creating Transform Keys with the Time Slider

You can use the time slider on page 8068 to create transform keys by copying transform values from one time to another. To specify the type of key to create and the source and destination time for the key values, right-click the time slider to display the Create Key dialog.
You set parameters in the Create Key dialog:

**Source Time** Specifies the time from which transform values will be copied.

**Destination Time** Specifies the time where the key will be created.

**Position, Rotation, Scale** Determine which transform key values will be copied to the destination time.

When you click OK, new keys for the specified transforms are created at the destination time, using values from the source time. Keys do not have to exist at the source frame, because the interpolated values at the frame are used. You might find it easier to create and manipulate keys with the track bar on page 8071.

When Auto Key mode is on, you can right-click and drag the time slider at the same time. When you do this, the Source time uses the frame number that you were on when you pressed the mouse button, and the Destination time accepts the frame number that you move the time slider to.

When Set Key mode is on, you can right-click and drag the time slider to move to another frame in time, without losing your character pose. If you find you have posed your character on the wrong frame, simply right-click and drag the time slider, and the pose will be copied to the new frame. Click Set keys to set keys for the pose on the new frame.

**Creating Position Lock Keys and Rotation Lock Keys**

Creating a lock key creates a key with Linear interpolation. If you create the lock key while an existing key is selected, it changes that key’s interpolation from Smooth to Linear. (Different types of interpolation are described in Bezier Controllers on page 3432.)

You can create a lock key for position or for rotation.
Lock keys are useful when you want an object to be stationary, but smooth interpolation is causing it to “wobble” on its stationary spot.

To create a lock key:

1. From the Customize menu, choose Customize User Interface.

2. On the Customize User Interface dialog, click the Quads tab, and then, from the drop-down list at the upper right of the dialog, choose Animation.

3. Click the top-left quadrant of the four gray squares that comprise the quad menus.
   The quad turns yellow.

4. In the Action list to the left, find Create Position Lock Key. Drag it to the window on the right below any menu item. Choose Save and click OK to apply this and close the dialog.

5. (Optional.) Select a key.

6. Alt+right-click the object you're animating.

   **NOTE** The Auto Key button need not be on.

7. From the quad menu that appears, choose Create Position Lock Key.
   You can also create keyboard shortcuts for these two commands. Create Position Lock Key and Create Rotation Lock Key are main user interface shortcuts. See Keyboard Shortcuts on page 8419.

**Controlling Time**

You create animation by changing your scene over time. You can exercise great control over time, including: how time is measured and displayed; the length of the active time segment (the part of the animation in which you’re currently working); and how much time is covered by each rendered frame of your animation.

Other time issues described in the topics that follow include how to move through time, and how to view animation in the viewports.
Choosing the Time Display Format

When you start 3ds Max, the default time display is in frames, but you can use alternative time-display formats. For example, you might want to see time in seconds and minutes.

You can specify different time-display formats using the Time Configuration dialog on page 8106 > Time Display group settings. When you change the time display format, you not only change the way that time is shown in all parts of 3ds Max, but you also change the method with which you access time.

You can use these time display formats:
Frames Displays time in whole frames.
This is the default display mode. The amount of time covered by a single frame depends on your choice for the current frame rate. For example, in NTSC video each frame represents 1/30th of a second.

SMPTE Displays time using the Society of Motion Picture and Television Engineers format.
This is the standard time-display format for most professional animation work. From left to right, the SMPTE format displays minutes, seconds, and frames, delineated by colons. For example, 2:16:14 represents 2 minutes, 16 seconds, and 14 frames.

FRAME:TICKS Displays time using frames and the 3ds Max internal time increment, called "ticks."
There are 4,800 ticks per second, so you can actually access time intervals as small as 1/4800 of a second.

MM:SS:TICKS Displays time in minutes (MM), seconds (SS), and ticks, delineated by colons. For example, 2:16:2240 represents 2 minutes, 16 seconds, and 2,240 ticks.

Setting Time Segments
The active time segment specifies a block of working time. You might think of it as a window in time that you use to focus on a specific part of your animation.

Specifying an Active Time Segment
You specify the active time segment by setting the Start Time and End Time for the segment on the Time Configuration dialog on page 8106.
You can change the active time segment whenever you want without affecting the keys you've already created. For example, if you have keys scattered over a range of 1000 frames, you can narrow your active time segment to work only on frames 150-300.
Changing the active time segment has the following effect:

- Restricts the range of time you can access using the time slider on page 8068.
- Restricts the range of time displayed when using the animation playback buttons.
The default setting for the active time segment runs from frames 0 to 100, but you can set it to any range.

You can also increase the active time segment using the track bar on page 8071.

**Rescaling the Active Time Segment**

You use the Re-scale Time button on the Time Configuration dialog on page 8106 to change your entire animation based on the active time segment.

Use Re-scale Time as follows:

- Scale all animation in the active time segment to fit within a new time range.
- Move the entire animation to a new time.

Click Re-scale Time and then enter new Start Time and End Time values on the Re-scale Time dialog. When you click OK all the animation in the active time segment is moved and scaled to fit the new Start Time and End Time settings. Any animation outside the active time segment is moved to match the new active time segment boundaries.

For example, say you have an animation from frame 0 to frame 300 and an active time segment starting at frame 100 and ending at frame 200. Use Re-scale Time to set the new Start Time to frame 200 and the new End Time to frame 250. Clicking OK gives you the following result:

- Animation in the active time segment moves forward 100 frames and shrinks to a length of 50 frames. The new active time segment is from frames 200 to 250.
- Animation in the frames preceding the original active time segment moves forward 100 frames to connect to the start of the new active time segment.
- Animation in the 100 frames after the original active time segment moves forward 50 frames to connect to the end of the new active time segment.

You can also rescale the active time segment using the track bar on page 8071.

**Moving Through Time**

You can move to any time in your active time segment by using either the time slider on page 8068, or the Current Frame field on page 8104 in the time...
controls area. You can also move through time using the playback control buttons.

**Using the Time Slider**

The time slider shows you the current time, and lets you move to any time in your active time segment.

**To change the current time using the time slider, do one of the following:**

1. Drag the time slider.
2. Click in the empty track to either side of the time slider.
3. Click the increment arrows at either end of the time slider.

When you click in the slider track, the time slider jumps to the time where you clicked. This is a faster method of moving through time than dragging the time slider.

The time slider displays the current time, followed by a slash (/), followed by the total time in the active time segment. For example 25/100 means frame 25 of 100 frames. The current time also appears in the current time field. If your scene has been animated, it's played back in all viewports as you drag the time slider.

You can use the < and > keys on the keyboard to advance the time slider a frame at a time. When Key mode is on, this will advance to the next keyframe.

**Moving to an Exact Time**

The Current Time field always displays the current time. You can also enter a time value and press Enter to move to that time.

**Using the Time Control Buttons**

You use the Time Control buttons to move forward and backward in time and to play your animation in one or more viewports. They work like VCR controls that you use to move through frames and to start and stop animation playback. The Time Control buttons include four buttons for moving through time and a center flyout for controlling animation playback:

- **Go To Start** on page 8101
- **Previous Frame/Key** on page 8101
- **Play/Stop** on page 8102
They work like VCR controls that you use to move through frames and to start and stop animation playback.

Choosing a Frame Rate and Playback Speed

The frame rate of an animation is expressed in frames per second (FPS). This is the number of frames 3ds Max displays and renders for every second of real time. Because 3ds Max stores your animation keys using real time using an internal precision of 1/4800 of a second, you can change the frame rate for your animation at any time without affecting your animation timing.

For example, if you create three seconds of animation using the NTSC video frame rate of 30 FPS, you will have a 90-frame animation. If you later discover you need to output to PAL video, at 25 frames per second, you can switch to that frame rate, and your animation is now set to 75 frames of output. No change in the timing of your animation has occurred. Only the number of frames that 3ds Max will display and render has changed.

Setting the Frame Rate

You use the settings in the Time Configuration dialog on page 8106 > Frame Rate group to switch back and forth between frame rates at any time.

NTSC: U.S. and Japanese video standard of about 30 frames per second.

PAL: European video standard of 25 frames per second.

Film: Movie standard of 24 frames per second.

Custom: Frame rate set in the FPS parameter.

Configuring Animation Playback

You use settings in the Time Configuration dialog on page 8106 > Playback group to specify the playback speed, and the number of viewports that play the animation.

Real Time: Animation plays at the selected playback speed, skipping frames, if necessary, to maintain the correct speed. Turn this off and the animation will play every frame without trying to maintain the correct speed. The different playback speeds are also useful when using the Motion Capture utility on page 4137.
Active Viewport Only: Animation plays only in the active viewport. Turn this off and the animation will play in all four viewports at once.

Speed: Choose one of these options to multiply the frame rate by the selected speed.

Direction: When Real Time is off you have the option to change the direction of the animation playback. Choosing Reverse will play the animation from end to start. Choosing Pingpong will play the animation from start to end, and then end to start.

Loop: When Loop is turned off, the animation will play once and stop.

Viewport Playback Speed

The ability of 3ds Max to play your animation at a specified rate depends on many things, including the complexity of the scene, the number of objects moving in the scene, the geometry display mode, and so on. The worst case is a camera move in shaded mode, in which the viewport is filled with detailed geometry. In such cases, it's best to simplify the viewport display, using either wireframe display or, in extreme cases, box display mode.

Naturally, it takes more computing power to display your animation in four viewports, and playback smoothness is reduced. When Active Viewport Only is on, you can switch active viewports during playback either by clicking the label of an inactive viewport, or by right-clicking in an inactive viewport.

Working with Controllers

Everything you animate in 3ds Max is handled by a controller. A controller is a plug-in that handles the storage and interpolation of all animated values.

The default controllers are:

- **Position**: Position XYZ
- **Rotation**: Euler XYZ
- **Scale**: Bezier Scale

**TIP** For fast access to key info or controller parameters, double-click a controller track name on the Motion panel or Track View hierarchy window. This productivity enhancement can help speed your work when fine-tuning animation.
Although 3ds Max has many different types of controllers, much of the animation is handled by the Bezier controller on page 3432. Bezier controllers interpolate between keyframes in a smooth curve. You can adjust the key interpolation of these interpolations through the keys on the track bar or in Track View. This is how you can control acceleration, hesitation and other types of motion.

The default controller for Rotation is Euler XYZ, which breaks the rotation down into three individual Bezier Float tracks. The default controller for Position is Position X,Y,Z. The Scale controller default is Bezier.

**NOTE** If you load files made in earlier versions of 3ds Max, their existing controllers will be maintained.

**WARNING** Be aware that Euler rotations behave differently than TCB rotations. If you are used to using TCB controllers, you can reassign TCB Rotation as the controller and you will get the same behavior you are used to.

3ds Max has a specialized type of controller, called a *constraint*, that is commonly used to help automate the animation process. A constraint can be used to control an object’s position, rotation, or scale through a binding relationship with another object.

You apply constraints and controllers using commands on the Animation menu. When you assign a controller from this menu, a weighted list controller is automatically applied, with the controller you've selected appearing first in the list. The weighted list controller gives you the ability to blend controllers, similar to a nonlinear animation system. If you assign a controller through the Motion panel or Track View, it replaces the existing controller, rather than creating a list controller. You can do that manually if you are working in the Motion panel or Track View.

This section explains techniques for working with controllers. For details about the parameters and use of each individual controller type, see Animation Controllers on page 3424.

### Understanding Controllers

Controllers are plug-ins that handle the animation tasks in 3ds Max.

Specifically, a controller can:

- Store animation key values.
- Store procedural animation settings.
- Interpolate between animation key values.

Most animatable parameters don't receive a controller until you animate them. As soon as you change an animatable parameter at any frame other than 0 with the Auto Key button on, or click the parameter track to choose Curve Editor > Add Keys, 3ds Max assigns a default controller to the parameter.

**Accessing Controllers**

You can work directly with controllers in two different places:

- **Track View**: Controllers are indicated in the Hierarchy list by the various controller icons. Each controller has its own individual icon. Using Track View, in either Curve Editor or Dope Sheet mode, you can view and work with the controllers for all objects and all parameters. See Track View on page 3790.

- **Motion panel**: Contains special tools for working with transform controllers. The Motion panel contains many of the same controller functions as the Curve Editor, plus controls necessary for working with special controllers such as IK Solvers. Using the Motion panel you can view and work with the transform controllers of a single selected object. See Motion Panel on page 8215.

**Categories of Controllers**

There are two main categories of controllers. These categories are easy to identify when looking at the Track View - Curve Editor Hierarchy list.

**Single-Parameter Controllers**: Control animation values of a single parameter. Regardless of whether the parameter has a single component, such as the number of sides of a cylinder, or multiple components, such as the RGB values of a color, the controller is handling a single parameter.

**Compound Controllers**: Combine or manage multiple controllers. Compound controllers include high-level Transform controllers, such as PRS on page 3526, the Euler XYZ Rotation controller on page 3453, the Transform Script controller on page 3553, and the List controller on page 3497.
A compound controller appears in the Hierarchy list as a controller icon with subordinate-level branches of other controllers.

**Controllers and Constraints**

In addition to controllers, 3ds Max can animate using constraints. These items are located in the Animation > Constraints menu. The constraints include the following: Attachment, Surface, Path, Link, Position, Orientation, and LookAt.

When you assign a controller in the Motion panel or in Track View, you will see these constraints appearing in the list of available controllers. You can assign them the same as the other controllers, but they are also assignable from the Animation > Constraints submenu. For more information, see *Animation Constraints* on page 3574.

**NOTE** If you assign a controller using the Animation > Controller submenu, a list controller is automatically applied to the object, with the selected controller applied beneath the list controller. This is different than controllers that are applied via the Motion panel.

**Viewing Controller Types**

You can view the controller type assigned to a parameter in both the Curve Editor and in the Motion panel. Before you can view the controller types in Track View, you must do the following:

1. On the Curve Editor toolbar, click the Filters icon. Then in the Filters dialog > Show group, turn on Controller Types.
   
   You can then see the name of the Controller type in the Hierarchy view.

2. Assign controllers to parameters. You can do this on the Assign Controller rollout of the Motion panel, or through the right-click menu in the Hierarchy list in Track View.

   The Parameters mode of the Motion panel always displays the transform controller types for the selected object.
Reading Controller Types

You can tell a lot about how a parameter is animated by looking at the controller type.

**Parameter Name:** Is always visible and is always to the right of the controller icon. It tells you what is animated.

**Interpolation Type:** Usually follows the parameter name. It tells how animation values are calculated. The label Diffuse: Bezier Color indicates a Diffuse color parameter using Bezier interpolation with Color data.

**Data Type:** Usually follows the interpolation type. It tells what type of data is used. The label Height: Linear Float indicates a Height parameter using Linear interpolation with a floating point value.

Changing Controller Properties

Certain controllers, including procedural ones like Noise on page 3519, do not use keyframes. For this type of controller, you can analyze and change your animation by editing controller parameters by means of a Properties dialog. The controller type determines whether or not the controller displays a properties dialog and the type of information displayed.

Using Curve Editor you can view controller properties dialogs for multiple tracks simultaneously. The following rules govern viewing multiple controller properties dialogs:

- Each track displays only one properties dialog in each Track View window.
- When properties dialogs for multiple tracks are visible, only one dialog can be active.
- Properties dialogs for tracks that use keys are disabled unless keys are selected.

Changing Controller Properties

Some controllers do not use keys, using instead a properties dialog that affects the entire animation. Such controllers are usually parametric controllers like Noise, or compound controllers like List.
To view controller properties in Curve Editor:

Do one of the following:

■ Highlight the label for a parametric or compound controller, right-click the label, and then choose Properties from the shortcut menu to display the properties dialog.
   The dialog title identifies the controller type, the item or object name, and the parameter. For example: Noise Controller:-Box01\Position

■ Double-click the label.

You can also view global properties for some transform controllers in the Motion panel. The same controls described above apply.

Controller properties can also be viewed from the track bar on page 8071. Right-click any key and choose Controller Properties.

Changing Controller Key Information

Some controllers interpolate between keys that you set on specific frames. Such controllers are always single parameter controllers such as a Bezier Float controller for Height or TCB for Rotation. These controllers use a Key Info dialog that contains settings for one of more selected keys.

To view key information in the Curve Editor:

■ Right-click a key to display the Key Info dialog.
   If more than one key is highlighted, Key Info displays common information for all of the selected keys. Settings that contain values indicate values common to all of the selected keys. Settings that are blank indicate values that change from key to key.

Viewing key information in the Motion panel always displays the settings for a single transform key.

To view key information for transform controllers in the Motion panel:

1 Select an object.

2 On the Motion panel, click Parameters, if it's not already active.

3 Click Position, Rotation, or Scale on the Parameters rollout.
   If the transform controller uses keys, Key Info rollouts appear below the Parameters rollout.
To view key information for transform controllers in the track bar:

1. Select an animated object.
2. Right-click any key in the track bar.
3. From the right-click menu, choose the property to inspect (e.g., Sphere01: X Position), or, if available, choose Controller Properties.

Changing Controllers That Do Not Display Properties

Some controller types do not display any properties in Track View or the Motion panel. You change the animation values of these controllers using the Auto Key button in the viewports and using the tools in the Curve Editor Keys and Curves menus, and in the track bar.

Assigning Controllers

Every parameter has a default controller type that gets assigned the moment the parameter is animated. You can choose from multiple controller types for any parameter and change controllers after the parameter is animated.

Assigning Controllers in Track View

You can assign controllers to any animatable parameter in the Curve Editor by selecting controller items and then choosing Assign Controller on the Controller menu.

You can also assign controllers to any animatable parameter in the Track View — Curve Editor by selecting the parameter in the Hierarchy List then right-clicking and choose Assign Controller from the quad menu.

You can also assign the same controller type to a selection of multiple parameters as long as all the selected parameters can use the same type of controller. For example, you could select the Length, Width, and Height parameters for multiple Box objects and assign the same controller type to all of them. This is because they all use controllers that work on floating point data.
If a parameter has already been animated, then assigning a new controller has one of the following effects:

- The existing animation values are recalculated to produce a similar animation with the new controller. For example, replacing TCB Position with Bezier Position closely preserves the animation.

- The existing animation values are discarded. For example, replacing Smooth Rotation with Noise Rotation discards the Smooth Rotation animation values.

**Assigning Controllers in the Motion Panel**

You can assign controllers on the Motion panel by selecting an object and then, on the Assign Controller rollout, choosing a controller and clicking the Assign Controller button. You can change the controllers of only one selected object.

**Assigning Controllers Using the Animation Menu**

You can assign controllers using the Animation menu. All the controllers and constraints are available by going to the menu bar and choosing Animation, and then selecting the type of Controller you want and picking the controller from the submenu that displays.

When you assign a controller in this method, a list controller is automatically assigned, and the controller you have selected appears as the first entry in the list. This automatic list controller assignment does not occur if you assign controllers using the Motion panel or Track View. Weighted list controllers allow you to blend between various tracks by animating the weights.

**TIP** You can use the Animation menu to assign the same type of controller or constraint to several different objects at once. Just select the objects and then choose the controller or constraint from the Animation menu.

**NOTE** If an assigned constraint requires designating an additional subject, such as a Path constraint, a rubber-band line extends from the first selected object to the mouse cursor after choosing the constraint. To complete the assignment, position the cursor over a qualifying target object and click.
Copying and Pasting Controllers

Right-click any blank area on the Track View toolbars, then choose Show Toolbars > Controllers: Track View. This displays the Controller toolbar with buttons for quick access to controller tools.

Click Copy and Paste on the Track View toolbar to copy and paste controllers. For a general discussion of using Copy and Paste, see Copying and Pasting Items on page 3946.

To copy and paste controllers in the Curve Editor, select the controller track to copy, then right-click and choose Copy from the Track View quad menu. Navigate the Hierarchy list to the target object, select the track, right-click and choose Paste.

Rules for using Copy and Paste are as follows:

- You can copy only single controllers. Compound controllers like List or PRS Transform controllers are considered single controllers for Copy and Paste operations.
- You can paste a copied controller into one or more controllers using the same data type.
- You can choose to make an instance or a copy of the pasted controller.
- You can choose to convert other controller instances in the scene automatically.

Clicking Paste displays the Paste dialog, with three controls for determining how the Paste operation is carried out.

**Copy** Pastes the controller as a copy.

**Instance** Pastes the controller as an instance of the source controller. Any change you make to either controller will affect the other.

For example, you can paste a box’s Length controller as an instance into its Height and Width parameters. This makes the box a cube. Changing either of the Length, Width, or Height parameters changes the other two.

**Paste Target: Replace All Instances** When selected, all instances of the target controller receive the paste controller, whether or not they are selected. This keeps all instances of the target controller as instances. When off, the target controller is made unique and the remaining instances are unchanged.
Specifying Default Controllers

You can specify the permanent defaults for controller types and controller settings to match the way you prefer to work.

The following defaults are written to the 3dsmax.ini file:

■ The default controller used for each data type
■ The default controller settings

Specifying Default Controllers

You specify default controllers by choosing Controller > Assign from on the Track View menu (see Assigning Controllers on page 3397). When you choose a controller in the Assign Controller dialog you have the option to click Make Default before clicking OK.

Clicking Make Default assigns the chosen controller as the default for all parameters using that data type. It has the following effects:

■ The default controller is listed at the bottom of the Assign Controller dialog.
■ Many different parameters might share the same data type. For example, selecting the Length parameter of a Box and specifying Linear Float as the default sets the default controller for all parameters that use the Float data type. This includes, Width, Camera FOV, and Scale Deformation Curves.
■ Default controller choices are written to the 3dsmax.ini file and become the default for all new scenes.
■ Previously assigned controllers are not affected.

Specifying Default Controller Values

You can specify the default settings for many controller types, or reset controllers to their factory settings on the Preferences dialog.

To specify default controller settings:

1. Choose Customize menu > Preferences.
2. In the Preferences dialog > Animation panel > Controller Defaults group, click Set Defaults to display the Set Controller Defaults dialog.
From the list of available controllers, choose a controller type and click the Set button to display the default settings supported by the selected controller. For example, with a Bezier controller you can set the In and Out tangents.

**NOTE** The default Rotation controller is Euler XYZ, not TCB (Quaternion) as in earlier versions of 3ds Max. The default Position controller is now Position XYZ, instead of TCB Position. Only Scale is still Bezier as a default.

Euler XYZ Rotation behaves quite differently from TCB. It gives you three function curves to manipulate, but does not allow rotations of greater than 180 degrees between keys. If you are used to working with TCB controllers, you can change the default rotation controller back to TCB.

Once you click OK, the controller defaults are changed. Changes to the controller default settings are written to your `3dsmax.ini` file and become the defaults for all newly assigned controllers and all new scenes.

You can also revert to the original program defaults for all controllers by clicking Preference Settings dialog > Animation panel > Controller Defaults group > Restore To Factory Settings.

### General-Purpose Controllers

The controllers described in this topic are general purpose in that you can apply them to parameters of different data types, yet they behave in essentially the same way for those different parameters.

Within certain general-purpose controllers there might be variations according to the data type used by a parameter.

See Animation Controllers on page 3424 for detailed descriptions of controller properties.

**Bezier Controllers**

**Bezier controllers** on page 3432 interpolate between keys using an adjustable spline curve; they are the default controller for most parameters.

Use Bezier controllers to provide fully adjustable interpolation between keys. Bezier controllers support the following options:

- Adjustable tangent handles.
- Step tangents for abrupt changes from one key to the next.
- Constant velocity control.

You can adjust the key interpolation by choosing among different tangent types in the Key Info dialog.

**TCB Controllers**

The TCB controller on page 3563 produces curve-based animation like Bezier controllers. However, TCB controllers use fields to adjust the Tension, Continuity, and Bias of the animation.

Use TCB controllers when you want adjustable, curved interpolation between keys, and you want to use TCB style controls.

**Linear Controllers**

The Linear on page 3496 controller interpolates between animation keys by evenly dividing the change from one key value to the next by the amount of time between the keys.

For a rigid, mechanical motion, use Linear controllers.

**Noise Controllers**

The Noise on page 3519 controller produces random, fractal-based animation over a range of frames. Noise controllers are parametric; they do not use keys.

Noise controllers have many possible uses, as in the following examples:

- Use Noise whenever you need completely random animation around a given value. For example, use a Noise Rotation controller when you want an object to wobble in place. A common use for a noise controller is the creation of camera shake.

- Use Noise in a List controller to apply variations to the result of another controller. For example, use a List controller to combine Noise Position with Bezier Position. The Bezier controller moves the object while the Noise controller makes the object shake and stray a little from the trajectory.
XYZ Controllers

The XYZ controllers such as Euler XYZ on page 3453 and Position XYZ on page 3524 are specifically designed so that you have three separate curves, one for each axis. This allows you to independently view and control the curves individually. This has advantages over rotation controllers like TCB that do not display function curves at all. XYZ controllers are now the default for rotation animation.

You can adjust the interpolation between keys using the Key Info dialog.

Audio Controllers

The Audio controller on page 3425 converts the amplitude of a recorded sound file or real-time sound wave into values that can be used by an animated parameter.

Use the Audio controller to synchronize parameter values with a sound file. For example, use an Audio controller for a Multiplier Curve to scale a parameter in sync with a sound.

Special-Purpose Controllers

The controllers described in this topic are applied to parameters of different data types, like general-purpose controllers, but they are used for special purposes.

List Controllers

The List controller on page 3497 combines multiple controllers into a single effect. It is a compound controller with tools for managing the order in which its internal controllers are calculated. List controllers are weighted, by animating the weights of the different layers you can create an effective non-linear animation system.

Use List controllers to combine controllers as in the following examples:

- Combine Noise Rotation and TCB Rotation controllers to introduce random orbital motion as an object rotates.
- Combine Bezier Position and Path Constraint to make an object follow a path with manually keyframed variation away from the path.
When you apply any controller from the Animation menu, a list controller is automatically placed on the object and the selected controller placed first in the list.

**Expression/Script Controllers**

You write custom code for Expression controllers on page 3456 and Script controllers on page 3552 in an Expression or Script controller dialog. You specify parameters using mathematical expressions, functions, and variables. The code can include values based on the controllers of other objects in the animation.

**NOTE** You can replicate some functions of Expression and Script controllers without having to write code by using parameter wiring or Reaction controllers. See Parameter Wiring Dialog on page 3612 and Reaction Controllers on page 3527.

See also

Expression Controller Techniques on page 3463

Trigonometric Functions on page 349

Vectors on page 352

**Motion Capture Controllers**

A Motion Capture controller controls parameters in real time from the input of external devices. Currently supported devices are mouse, keyboard, MIDI device and joystick. Each device has specific properties that must be set:

- After assigning the motion-capture controller, open the controller Properties dialog and bind the type of peripheral device and set device parameters.
- Use the Motion Capture utility on page 4137 to test and record captured motion.

**Explicit Axis Keys**

The XYZ controllers assign an individual track to the X, Y, and Z components of the position, rotation, or scale of an object. However, the controllers always assign three keys (one for each axis), by default.
In previous versions of 3ds Max, you had to manually edit the keys in order
to create explicit axis keys. However, there are now actions available from the
Customize User Interface dialog on page 8249 that let you create explicit keys
with the touch of a button.

When an explicit key is created on an axis, any keys on the two remaining
axes (at the selected time) will be deleted.

An explicit axis key can only be assigned to objects that already have an XYZ
controller assigned to their position, scale, or rotation tracks.

You can also use Keyable Icons to turn on or off tracks for editing. This allows
you to set keys on only specified PRS X, Y or Z axes as well. See Keyable Icons
on page 3864.

See also:

■ Position XYZ Controller on page 3524
■ General-Purpose Controllers on page 3401
■ Euler XYZ Rotation Controller on page 3453
■ Scale XYZ Controller on page 3550

Interface

NOTE These commands are not available in the default user interface. You can
use the Customize User Interface dialog to assign a keyboard shortcut to them or
add them to your toolbars or menus if you want to use them.

Key Position X, Y, or Z Creates an explicit key on the designated position
axis.

Key Rotation X, Y, or Z Creates an explicit key on the designated rotation
axis.

Key Scale X, Y, or Z Creates an explicit key on the designated scale axis.

Float Controllers

The controllers described in this topic are available only for parameters that
use the Float data type.
**On/Off Controller**

An On/Off controller on page 3522 controls parameters using binary on and off values. The On/Off track displays a solid blue color in frames that are on, and the background in frames that are off. The on/off state of the parameter switches every time you add a key.

Use for binary parameters such as the Smooth object parameter, or for Visibility tracks.

**Boolean Controller**

The Boolean Controller is a variation on the On/Off controller. It provides a similar functionality, but with one significant difference. The on/off state of the parameter does not switch automatically every time you add a key. This allows you to effectively add keys in the middle of a sequence without creating unintended drastic changes.

**Waveform Controller**

A Waveform controller on page 3566 generates values by combining periodic waveforms. You can specify different types of waveforms and add waveforms together to create complex animation.

Waveform was originally created to control blinking lights. Use it for any value that you want to vary in a regular, oscillating pattern.

**Controlling Transforms**

Transform controllers are compound controllers. They set the type and behavior of the controllers used for Position, Rotation, and Scale.

You assign Transform controllers using either Track View — Curve Editor or the Motion panel. Compound Transform controllers do not display properties in Track View. You can access the parameters of Transform controllers only in the Motion panel.

**Position/Rotation/Scale Controller**

The Position/Rotation/Scale (PRS) controller on page 3526 is a simple Transform controller applicable for most objects. When applied the PRS Transform controller sets up default Bezier Position, TCB Rotation, and Bezier Scale controllers.
Use a PRS controller whenever you want a standard transform set up or when you want single function curve control over the Position, Rotation, and Scale controllers.

**NOTE** PRS controller is no longer the default controller applied to all objects. The latest version of 3ds Max uses Position XYZ and Euler XYZ as the new default controllers for position and rotation transforms.

### Transform Script Controller

The **Transform Script controller** on page 3553 contains all of the information contained in a PRS Controller in one scripted matrix value. Instead of having three separate tracks for position, rotation, and scale, all three values can be simultaneously accessed from one script controller dialog. Because the transform values are defined by a script, they are easier to animate.

The value of the controller script must be a matrix3 value. A matrix3 value is a 4x3 3D transformation matrix. For more information, see the Matrix3 Values topic in the MAXScript Help.

### XRef Controller

The **XRef controller** on page 3570 lets you externally reference any type of Transform controller from another scene file. When you assign this controller to your object, it nests the source controller, making it only accessible for playback. You can use the XRef controller either on its own, or combine it with an **XRef Object** on page 7450.

## Controlling Position

The Position controller is a component of the Transform controller. Position is a data type that can use most of the standard controllers such as Bezier, TCB, and Noise.

The controllers described in this topic can be used only as position controllers.

### XYZ Controller

The XYZ controller breaks a Position controller into three separate Bezier Float controllers. Each of the X, Y, and Z components of position receives its own track.
Use the XYZ controller when you want to have separate key patterns or controller types for each position component.

See Euler XYZ Rotation Controller on page 3453, Position XYZ Controller on page 3524, and Scale XYZ Controller on page 3550.

Controlling Rotation

The Rotation controller is a component of the Transform controller. Rotation is a data type that can use most of the standard controllers such as TCB, Linear, and Noise.

Rotations in 3D are very complex. Even the standard controller types behave differently when used for rotation. The most common way of calculating rotations in 3D animation uses four components to define rotation about an arbitrary axis. This is the quaternion method.

The benefits of using quaternion rotation include:

- It produces a direct one-to-one relationship between the quaternion values and how objects interactively rotate in the scene.
- It produces smoother rotation than other methods.

The drawbacks of using quaternion rotation include:

- Rotation values in key information can be difficult to understand.
- Quaternion rotation controllers do not display function curves in Track View — Curve Editor. For this reason Euler XYZ is now the default rotation controller assigned to all objects.

You can use the following controllers only as rotation controllers.

Smooth Rotation

Use Smooth Rotation on page 3558 when you want rotation to have a smooth and natural look. Smooth rotation uses nonadjustable curved interpolation, and has the following characteristics:

- You can move keys in Track View to change timing.
- You can directly rotate objects in the viewports to change rotation values.
- You cannot display controller or key properties, or function curves.
Euler XYZ Rotation

Use the Euler XYZ Rotation controller on page 3453 when you want individual function curve control for each axis of rotation. Euler XYZ is a compound controller that combines separate, single-value float controllers to specify an angle of rotation about each of the X, Y, and Z axes. Euler XYZ Rotation is the default controller applied to all objects.

Euler XYZ is not as smooth as quaternion rotation, but it is the only rotation type that you can use to edit rotation function curves.

Euler angles are well suited for animating mechanical rotations. They can also be a good choice for an object in an inverse kinematics chain because IK Rotational joints are defined as Euler angles. X, Y, and Z function curves displayed by this controller in Track View represent rotations in "world" or "parent" space which is the rotation system used by most 3D animation packages.

Customers upgrading from earlier versions of 3ds Max might find some difficulty in adapting to using Euler XYZ rotation controllers. If you find yourself experiencing unexpected rotation behavior, this might be the reason. Reassign TCB rotation as the default rotation controller and you will be able to regain your customary workflow.

Controlling Colors

You can animate colors in 3ds Max just as you can animate most other parameters.

Two data types are available for controlling colors:

- **Point3**: A general-purpose, three-component data type that works with RGB color values. It uses most of the standard controllers.

- **Color**: A special data type designed specifically for working with RGB and HSV color values. Color uses the Bezier and RGB controllers.

Color Point3 Controller

You can assign any of a variety of Point3 controllers to a material's color channels, including Point3 Expression, Point3 List, Color RGB (described later in this topic), and so on. When using Point3 controllers for color parameters,
an important issue is behavior of the Key Value fields, labeled X, Y, Z. They store color values using only the RGB color model.

- The X value field stores Red color values.
- The Y value field stores Green color values.
- The Z value field stores Blue color values.

The Point3 Key Value fields do not clamp at the valid color range of 0 to 255. Values that drop below 0 or exceed 255 are ignored by the color parameter but are still displayed in Track View.

**Bezier Color Controller**

The Bezier Color controller (see Bezier Controllers on page 3432) is a data type that uses Bezier key interpolation. You can use RGB or HSV color models with the Bezier Color controller.

The choice of color model is global for all keys used by the controller. You can switch between color models anytime and color key values are correctly converted.

The Color Value fields are limited to a range of 0 to 255. You can drag the color keys above 255 in Track View Curve Editor, but the values are clamped at 255.

**Color RGB Controller**

Assign a Color RGB controller on page 3451 to break a Color controller into three separate Bezier Float controllers. Each of the R, G, and B components of color uses its own track.

Use the Color RGB controller when you want to have separate key patterns or controller types for each color component.

**Morph Controllers**

You can choose from two morph controllers: Cubic and Barycentric; they manage how morph targets blend from one target to another. Morphing can also be achieved by applying a Morpher modifier on page 1518 to an object.


**Cubic Morph Controller**

A Cubic Morph controller is a TCB-style controller. It uses Tension, Continuity, and Bias controls much like the generic TCB controller.

The Cubic Morph controller manages only the interpolation from one morph target to the next. If you want to add Morph keys or change the morph target, you must use the Pick Targets and Current Targets rollouts on page 667 in the Modify panel.

**Barycentric Morph Controller**

The Barycentric Morph controller on page 3429 is also a TCB controller like the Cubic Morph controller, except that instead of each key representing a single target, each key represents a series of weights for all targets. A Barycentric Morph key represents a new object which is a blending of all targets.

You can adjust each morph key to percentages of the available morph targets, creating subtle adjustments in the animation.

You can also click Add Keys in Track View to create new Barycentric Morph keys. The added keys contain interpolated values for all targets.

**Motion Panel Commands**

Controls for assigning and adjusting controllers appear on the Motion panel.

**NOTE** You can also work with controllers in Track View on page 3790.

**Trajectories**

Select an object > Motion panel > Trajectories

The Trajectories rollout displays the path an object travels over time. Controls to convert splines into trajectories, trajectories into splines, and to collapse any transform controller into editable keys are also available by choosing Motion panel > Trajectories.
NOTE The state of the Trajectory check box under Display in the Object Properties dialog on page 283 (and on the Display panel > Display Properties rollout) controls whether trajectories will be visible for an object.

Using trajectories, you can do the following:

- Display the 3D path for selected object’s position tracks.
- Insert and delete keys from the path.
- Move, rotate, and scale keys on the path.
- Convert the path to a spline object.
- Derive a new path from a spline object.
- Collapse transforms.

Values under Sample Range are used in the Spline Conversion and Collapse Transform functions.
NOTE You can assign the four principal Trajectories functions to keyboard shortcuts and other custom UI items. The following actions are available via Customize User Interface on page 8249:

- **Trajectory Add Key Mode Toggle**: Enters and exits Add Key mode on page 3415.
- **Trajectory Delete Key**: Activates the Delete Key on page 3415 function on a one-time basis.
- **Trajectory Key Mode Toggle**: Enters and exits the Keys sub-object level for direct editing of animation keys via transformation of the trajectory keys.
- **Trajectory Toggle**: If one or more objects are selected, this enters and exits Trajectories mode on the Motion panel.

**Procedures**

**To display an object's trajectory:**

1. Select an animated object that moves over time.
2. Right-click the object and choose Properties. Trajectory is not available.
3. In the Display Properties group, click By Layer to change this button to By Object. Skip this step if By Object is already displayed. Trajectory becomes available.
4. Turn on Trajectory, then click OK. The Trajectory is displayed as a red line with white squares and dots. The white squares are keys, the white dots are in-betweens.

**To add a key to a trajectory:**

1. Select an object.
2. Display the trajectory by following the previous steps.
3. In the Motion panel, click Trajectories.
4. Click Sub-Object to activate Keys and enable editing.
5. Click Add Key.
6 Click the trajectory. Wherever you click the trajectory a key will be added.

7 Right-click the key and select Key Info from the right-click menu. In the Key Info dialog, you can change the In and Out values for the in-betweens on either side of the key. This allows you to use the trajectory key to create the illusion of hesitation or acceleration. You can click repeatedly to add many keys in this mode.

**To delete a key from a trajectory:**

1 Select a key on a trajectory. You can click it, or use window selection.

2 Be sure Add Key is turned off in the Trajectories rollout of the Motion panel.

3 Click Delete Key in the Trajectories rollout of the Motion panel. The key is deleted.

**To transform keys on a trajectory:**

1 Select one or more objects.

2 On the Motion panel, click Trajectories.

3 Click Sub-Object to activate Keys and enable editing.

4 Select one or more keys and use the transform tools on the Main toolbar to move, rotate, or scale the selected keys.
**Interface**

![Interface Image]

**Sub-Object** Enables key editing. Use the Move, Rotate, and Scale transforms to change the location of a key(s) displayed on a trajectory.

**Trajectories rollout**

**Delete Key** Deletes the selected key(s) from the trajectory.

**Add Key** Adds key(s) to the trajectory. This is a modeless tool. When you click this button once, you can then add any number of keys by clicking the trajectory line in the viewport one or more times in succession. To exit Add Key mode, click the button again.

**Sample Range group**

**Start Time/End Time** Specifies the interval for the conversion. If you're converting from position keyframes to a spline object, this is the time interval for which the trajectory will be sampled. If you're converting from a spline object to position keys, this is the interval over which the new keys will be placed.

**Samples** Sets the number of samples for the conversion. When converting in either direction, the source is sampled at regular intervals, and keys or control points are created on the target object.
Spline Conversion group

Convert To/Convert From Converts keyframe position tracks to and from spline objects. This enables you to create a spline trajectory for an object and then convert that spline to keyframes for that object’s position track in order to do various keyframe-specific functions (such as applying constant velocity to the keys and normalizing the time). Or, you can convert an object’s position keyframes into a spline object.

TIP Convert To and Convert From can be used to move an object along a path without using a path constraint.

Collapse Transform group

Generates keys based on the current transformation of the selected object. You can apply this for any type of transform controller assigned to an object, but the main purpose of this function is to "collapse" a parametric transform effect, such as one generated by a Path constraint, into standard, editable keys.

Collapse Collapses the transform of the selected object.

Position, Rotation, Scale Specifies which transforms you want to collapse. You must choose at least one check box to activate the Collapse button.

PRS Parameters Rollout

Select an object > Motion panel > Parameters > PRS Parameters rollout
The PRS Parameters rollout provides tools for creating and deleting keys. PRS stands for the three basic transform controllers: Position, Rotation, and Scale.

**Procedures**

**To create a PRS transform key:**

1. Select an object in the viewports.
2. Drag the time slider to the frame where you want to place a key.
3. On the Motion panel, choose Parameters > PRS Parameters rollout.
4. Click one of the following buttons under Create Key PRS Parameters rollout:
   - Click Position to create a Position key.
   - Click Rotation to create a Rotation key.
   - Click Scale to create a Scale key.

If a particular Position, Rotation, or Scale controller doesn’t use keys, then that button is not available under Create Key. For example, you can’t create Position keys if you’re using a Noise Position controller.

**Interface**

**Create Key/Delete Key** Creates or deletes a move, rotate, or scale key at the current frame. These buttons become active or inactive depending on the existence of a key type at the current frame.

For example, if you’re on a frame containing a Scale key, the Scale button is inactive in the Create column because a key already exists. At the same time,
the Position and Rotation buttons are inactive in the Delete column because there are no keys of that type to delete.

**Position/Rotation/Scale** Determines the contents of the Key Info rollouts that appear below the PRS Parameters rollout on the Motion panel.

### Key Info (Basic) Rollout/Dialog

Select an animated object > Motion panel > Parameters > Key Info (Basic) rollout

Select an animated object. > Right-click a key on the track bar. > Choose a controller track.

Make a selection. > Hierarchy panel > IK button > Key Info (Basic) rollout

Curve Editor > Right-click a key.

Parameter Collector on page 325 > Click a Properties button.

The Key Info (Basic) rollout or dialog changes the animation value, time, and interpolation methods of one or more selected keys.

The following parameters are available with the Bezier controller, which is the default position controller. The Key Info controls for a TCB position controller are different.

**See also:**

- Key Info (Advanced) Rollout/Dialog on page 3422

**Procedures**

**To set the tangent type for a key:**

1. Select an object and open the Key Info (Basic) rollout.
2. Use the arrows in the upper-left corner of the dialog to select a key.
3. Choose a tangent type from the In or Out tangent flyouts.
Interface

![Key Info dialog](image)

**Key number** Shows the current key number. Click the right or left arrows to go to the next or previous key.

**Time** Specifies at what time the key occurs.

**Time Lock** Prevents horizontal key movement in Track View Edit modes.

**Value** Adjusts the position of the selected object at the current key.

NOTE In the Key Info dialog for the Bezier Scale controller, a Lock button is displayed beside the X Scale spinner. If you click Lock X, only the X value affects all three axes of scale. The Y and Z values are ignored and their function curves are not displayed. When X is locked, the Y and Z values aren’t affected by changes in the X value. If you click Lock X when all three axes are at identical values, alter the X value, and then unlock X. The Y and Z values remain where they were while X retains its new value.

**Key Tangent Flyouts** With Bezier controller types, sets the interpolation properties of the In tangent and Out tangent of the key. For details, see [Tangent Types](#) on page 3420.

**Tangent Copy buttons** Use the arrow buttons at either side of the Key Tangent flyouts to copy the tangent type between the tangents of the current key or between the tangents of the previous and next key.

- The left arrow of the In tangent copies to the Out tangent of the previous key.
The right arrow of the In tangent copies to the Out tangent of the current key.

The left arrow of the Out tangent copies to the In tangent of the current key.

The right arrow of the Out tangent copies to the In tangent of the next key.

**Tangent Types**

Key Info (Basic) dialog/rollout on page 3418 > In/Out Tangent Type flyouts

Status bar > Animation controls > Default In/Out Tangents For New Keys flyout

Select an animated object > Motion panel > Parameters > Key Info (Basic) rollout

You can adjust the tangent type of the Bezier transforms. This means you can adjust the interpolation between keyframes to create particular motion effects. By manipulating tangent types, you can make something hesitate, speed up, slow down, or even stand still.

Each key has two tangents: one to define the interpolation before the key, and a second to define interpolation following the key.

**TIP** You can also set the default tangent type through the Default In-Out Tangents For New Keys on page 8098 flyout. By doing so, each new key created with Set Key Mode or Auto Key Mode follows the curve interpolation set by the default tangent type.

Smooth Creates smooth interpolation through the key.

Linear Creates linear interpolation at the key.

A linear tangent affects the curve near the key only. Full linear interpolation between two keys occurs only when the Out tangent of the first key and the In tangent of the next key both use a linear tangent.
Step  Creates binary interpolation from one key to the next. Step
tangents require a matched set between the Out tangent of one key and the
In tangent of the next key.

Choosing Step for the In tangent of the current key also sets the Out tangent
of the previous key to Step. Likewise, choosing Step for the Out tangent of
the current key also changes the In tangent of the next key to Step.

Using Step tangents, the outgoing value of a key is held constant until the
time of the next key is reached. The value then abruptly jumps to the value
of the next key. Use this tangent when you want to animate On/Off switching
or instantaneous changes from one value to the next.

Slow  Causes the interpolated rate of change to slow down around
the key. A slow In tangent decelerates as it approaches the key. A slow Out
tangent begins slow and accelerates as it leaves the key.

Fast  Causes the interpolated rate of change to speed up around
the key. The effect is the opposite of using slow. A fast In tangent accelerates
as it approaches the key. A fast Out tangent begins fast and decelerates as it
leaves the key.

Custom  Displays adjustable tangent handles at the key in Function
Curves mode in 3ds Max.

Flat Tangent  Displays a smooth interpolation type designed to
eliminate overshoot with no editable handles. Tangent slopes automatically
take the most direct route to the next key value.

See also:

- Default In/Out Tangents For New Keys on page 8098

Motion Panel Commands | 3421
Key Info (Advanced) Rollout/Dialog

Select an animated object. > Motion panel > Parameters > Key Info (Advanced) rollout

Make a selection. > Hierarchy panel > IK button > Key Info (Advanced) rollout

Select an animated object in the viewport. > Right-click a key in track bar. > Choose the name of the controller track such as Sphere01: Z Position. > Key Info dialog > Click Advanced.

Parameter Collector on page 325 > Click a Properties button. > Key Info dialog > Click Advanced.

The Key Info (Advanced) rollout or dialog contains additional key settings.

With the Key Info (Advanced) settings, you can control velocity in three ways:

■ You can specify the absolute velocity at a key using the In/Out fields.

■ You can average velocity over a time period using Normalize Time.

■ With certain controller types, you can force constant velocity from one component key to the next using Constant Velocity.

If you are creating Path animation, you can force constant velocity by placing a Normalize Spline modifier on page 1554 on the spline used as a path.

See also:

■ Key Info (Basic) Rollout/Dialog on page 3418

Procedures

To set normalize time for a key:

1. Select an object and choose a key to Normalize.

   You can use the arrows in the Key Info (Basic) rollout to step through Keyframes.

2. In the Key Info (Advanced) rollout, click Normalize Time.

   The key is moved in time to average the velocity through the key.
Interface

**In/Out** The In field is the rate of change as the parameter approaches the key. The Out field is the rate of change as the parameter leaves the key.

- These fields are active only for keys using the Custom tangent type on page 3420.
- The number in the field is the rate of change expressed as parameter units per tick. By changing the two values for X, Y, and Z you are changing the length and angle of the tangent handle.

**Lock button** Changes one Custom tangent by changing the other an equal but opposite amount. For example, if you click the Lock button and the In value is 0.85, then the Out value is -0.85.

**Normalize Time** Averages the position of the keys in time and applies them to any consecutive blocks of selected keys. Useful if you have an object that speeds up and slows down repeatedly, and you want to smooth out the motion.

**Constant Velocity** When on, interpolates values between the key and the next one so that the object moves at a constant velocity across that curve segment. Available only with certain controller types, such as Bezier.

**Free Handle** Used for automatically updating the length of the tangent handle. When this is turned off, the length of the tangent is at a fixed percentage from its neighboring key. As you move a key, the handles adjust to stay the same percentage away from the neighboring keys. When this is turned on, the handle lengths are based on time lengths.
Animation Controllers

Track View > Select a track in the Track View hierarchy. > Track View menu bar > Controller menu > Assign > Choose a controller in the dialog.

Animation menu > Constraints/Transform Controllers/Position Controllers/Rotation Controllers/Scale Controllers> Choose a controller.

Select an object. > Motion panel > Assign Controller rollout > Select a track. > Assign Controller > Choose a controller in the dialog.

Controllers, like constraints on page 3574, handle the animation tasks in a scene. They store animation key values and procedural animation settings, and they interpolate between animation key values.

An object or parameter doesn't receive a controller until you animate it. As soon as you change an animatable parameter with Auto Key on, or add a key on page 3917 in Track View - Dope Sheet on page 3790, 3ds Max assigns a controller to the parameter. 3ds Max chooses a default type for the controller, depending on the animation. You can change the default controller to another type.

The animation controllers are organized in the following categories:

- **Float controllers**: for animating floating-point values
- **Point3 controllers**: for animating three-component values such as colors or 3D points
- **Position controllers**: for animating positions of objects and selection sets
- **Rotation controllers**: for animating rotation of objects and selection sets
- **Scale controllers**: for animating the scale of objects and selection sets
- **Transform controllers**: for animating general transforms (position, rotation, and scale) of objects and selection sets

To change an assigned controller, use Controller > Assign on page 3897 in Track View or in the Motion panel on page 8215.

See also:

- Working with Controllers on page 3391
- Animation Constraints on page 3574
- Inverse Kinematics (IK) on page 3661
Audio Controller

Main toolbar > Curve Editor (Open) > Select a track in the Track View hierarchy. > Track View menu bar > Controller menu > Assign > Audio

Graph Editors > Track View – Curve Editor > Select a track in the Track View hierarchy. > Track View menu bar > Controller menu > Assign > Audio

Use the Audio controller to drive the animation of almost any parameter in 3ds Max. The Audio controller converts the amplitude of a recorded sound file or real-time sound wave into values that can animate an object or parameter.

With the Audio controller, you have full control over sound channel selection, base threshold, oversampling, and parameter range.

The Audio controller works with most parameters in Track View, including:

- Transforms
- Float values
- Point3 values (color)

![Audio controller assigned to the scale track of this object](image)

Procedures

To animate the Z axis scale of a box using a sound file:

1. Create a box.
2. In the Track View hierarchy, select the Scale track.
3. On the Track View menu, click Controller > Assign, and choose the AudioScale controller.
   The Audio Controller dialog appears.
5. In the Base Scale group, set the Z field to 0.
6 In the Target Scale group, set the Z field to 600.

7 Close the Audio Controller dialog and play the animation.
   The box scale is animated along the Z axis.

   **TIP** If you want to hear the sound as the animation plays, include the same audio file in the **Sound Track** on page 3833. (Sound Track in the Track View hierarchy)

   In the Time Configuration dialog, turn on Real Time.

Interface

See **Audio Controller Dialog** on page 3426

**Audio Controller Dialog**

Track View or Motion panel > Highlight a track using the Audio controller in the Track View hierarchy. > Right-click the track. > Properties

Track View or Motion panel > Double-click a track using the Audio controller in the Track View hierarchy. > Properties

Adding a sound track to your animation allows you to synchronize animation to sound. Add a sound track to lip-sync a character speaking, for example.
Interface

Audio File group

Use this group to add and remove sound files from the controller, and to adjust amplitude.

Choose Sound Displays a standard file selector dialog. You can choose WAV and AVI files.

Remove Sound Removes any sound file associated with a controller.

Absolute Value Controls the interpretation of sound amplitude. The value returned by the Audio controller is sample amplitude divided by maximum amplitude.

Value = (sample amp.)/(maximum amp.)

When Absolute Value is turned on, the maximum amplitude equals the maximum sampled amplitude from the waveform. This ensures that potential for the output value reaches the target value.
When off, the maximum amplitude equals the maximum potential amplitude of the waveform. Output reaches the target value only if the waveform reaches its maximum potential amplitude.

The maximum potential amplitude for an 8-bit file is 128; for a 16-bit file, it's 32768.

**Real Time Control group**

Use this group to create interactive animation that's driven by sound captured from an external audio source, such as a microphone. Use these options only for interactive presentations. You can't save the real-time sound or save the animation produced by the controller.

**Enable Real Time Device** Sets whether sound is captured from an external audio source. This option is inactive if a sound capture device is not installed in your system.

When on, any selected audio file is ignored, and the controller uses sound captured by the selected device.

When off, the controller uses the selected audio file.

**Real Time device list** Displays all available real-time sound devices installed in your system. Select the device you want to use for real time sound capture.

**Sample group**

This group contains controls to filter out background noise, smooth out the waveform, and control display in Track View.

**Threshold** Sets the bottom cut-out level as a percentage of total amplitude. Any amplitude below the threshold drops to 0.0.

Threshold range is from 0.0 to 1.0.

A Threshold of 0.0 has no effect on amplitude output values.

A Threshold of 1.0 drops all amplitude output values to 0.0.

You can use low threshold values to filter out background noise from the controller.

**Oversampling** Smooths the waveform. Multiple samples are averaged to remove peaks and valleys. Enter a number in the Oversampling field to calculate the average.

**Fast Track View** Controls the display of oversampling.

When turned on, oversampling is ignored for the Track View display.
When turned off, oversampling is applied to the Track View display. High oversampling values can slow the display of the waveform.

**Base & Target Scale groups**

Here you enter minimum and maximum parameter values returned by the controller. The fields you see vary by the type of parameter using the Audio controller.

Float parameters are displayed in the Controller Range group with Min. and Max. fields.

Vector parameters (3 components), such as Transforms, display Base and Target groups with fields for X, Y, and Z values.

**Base Scale** Defines the float value or X, Y, and Z values returned for an amplitude of 0.0.

**Target Scale** Defines the float value or X, Y, and Z values returned for maximum amplitude.

**Channel group**

With this group you select which channel drives the controller output value. These options are only available if you have chosen a stereo sound file.

**Left** Uses the left channel amplitude.

**Right** Uses the right channel amplitude.

**Mix** Combines the two channels so that the returned amplitude is the greater value of either channel.

**Barycentric Morph Controller**

Select an object. > Create panel > Geometry > Compound Objects > Morph

The **Barycentric** on page 8517 Morph controller is automatically applied when a morph object is created in Create > Geometry > Compound Objects > Morph. Morph targets are selected and keys are created at different times to morph the original object into the shape of the Morph Targets.
The Morpher modifier provides an alternative to the Morph controller to morph objects.

The Barycentric Morph controller represents each key as a series of weights for all targets. One barycentric key represents a new object which is a blending of all targets.

You can adjust each morph key to various percentages of the available morph targets. This lets you create subtle adjustments in the animation.

You can add keys between existing morph keys. The added keys contain interpolated values for all targets.

To access the key properties dialog, select the Morph track, select one of its keys, and click Properties to display the Key Info dialog.

See also:
- Morph Compound Object on page 667
- Morpher Modifier on page 1518

Procedures

See Morph Compound Object on page 667 and Barycentric Morph Controller Key Info Dialog on page 3431

Interface

After assigning the Barycentric Morph controller in Create panel > Compound Objects > Morph, then morph parameters for the controller display in the Modify panel and in the Barycentric Controller Key Info dialog, which is displayed by right-clicking over a morph key in Track View — Dope Sheet or the track bar.
See Morph Compound Object on page 667 for Morph parameters.

**Barycentric Morph Controller Key Info Dialog**

Select a Morph object > Track View - Dope Sheet > Right-click a morph key. > Barycentric Morph Controller Key Info dialog

You can change morph target weighting using controls in the Barycentric Morph Controller Key Info dialog.

**Interface**

![Key Info window]

**Current Key** Specifies the current key that you're adjusting.

**Time** Specifies where, in time, the current key is placed.

**Tension/Continuity/Bias** Adjusts the TCB parameters of the key spline interpolation.
**TCB Spline** Displays the key interpolation spline.

**Targets** Lists all morph targets for the object, along with the percentage of their influence at the current key. The total percentage of all targets is displayed below the window. You can select any target in this window, and then adjust its percentage of influence using the spinner at right.

**Percentage** Sets the percentage of influence for the target selected in the list window. Percentage values can be negative as well as greater than 100 percent.

**Constrain to 100%** Limits total weight of all targets to 100 percent. As you increase or decrease the percentage of a selected target, the other targets adjust accordingly. The adjustment takes the form of balancing all of the target percentages so that their relative weights remain the same.

When this check box is turned off, you can adjust the weight of each target without affecting the others, and create a total that's greater or less than 100 percent. Totals greater than 100 percent cause the morph object to scale up in size, while totals less than 100 percent cause the morph object to scale down. Note that this check box is global, and not confined to a single key or track.

---

**Bezier Controllers**

Main toolbar > Curve Editor (Open) > Select a track in the Track View hierarchy. > Track View menu bar > Controller menu > Assign > Bezier

Graph Editors > Track View > Curve Editor > Select a track in the Track View hierarchy. > Track View menu bar > Controller menu > Assign > Bezier

The Bezier controller is the most versatile controller available in 3ds Max. Bezier controllers interpolate between keys using an adjustable spline curve. They are the default controller for most parameters.

<table>
<thead>
<tr>
<th>Transform</th>
<th>Position/Rotation/Scale</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position</td>
<td>Bezier Position</td>
</tr>
<tr>
<td>Rotation</td>
<td>Euler XYZ</td>
</tr>
<tr>
<td>Scale</td>
<td>Bezier Scale</td>
</tr>
</tbody>
</table>

Use Bezier controllers whenever you want fully adjustable interpolation between keys. Bezier is the only controller that supports the following:

- Dragging tangent handles
- Step tangents for abrupt changes from one key to the next
Constant velocity controls

Procedures

To set the tangent type for a key:

1. Select an object that has some animation keys and open the Key Info (Basic) rollout in the Motion panel.
2. Use the arrows to select a key.
3. Choose a tangent type from the In or Out tangent flyouts.

To normalize time for a key:

1. Select an object, and then choose a key to normalize. You can use the arrows in the Key Info (Basic) rollout to step through keyframes.
2. On the Motion panel, in the Key Info (Advanced) rollout, click Normalize Time. The key is moved in time to average the velocity through the key.

Interface

Motion panel > Parameters > Key Info (Basic) rollout

A Key Info dialog with identical parameters to this rollout is available by right-clicking a key in Track View or the track bar.
**Key number** Shows the current key number. Click the right or left arrows to go to the next or previous key.

**Time** Specifies when in time the key occurs.

**Time Lock** Controls dragging the key horizontally in Track View edit modes.

**X/Y/Z** Adjusts the position of the selected object at the current key.

**Key Tangent** Two flyouts set the interpolation properties of the in tangent and out tangent of the key.

**ChoosingBezier Tangent Types** Sets the tangent types for one or more keys in the same track using the In and Out tangent flyouts.

See [Tangent Types](#) on page 3420 for detailed information on each of the available tangent choices.

**Tangent Copy** Copies the tangent type between the tangents of the current key or between the tangents of the previous and next key. Use the arrow buttons on either side of the Key Tangent flyouts.

The left arrow of the In tangent copies to the Out tangent of the previous key.

The right arrow of the In tangent copies to the Out tangent of the current key.

The left arrow of the Out tangent copies to the In tangent of the current key.

The right arrow of the Out tangent copies to the In tangent of the next key.

**ChoosingBezier Tangent Types** Sets the tangent types for one or more keys in the same track using the In and Out tangent flyouts.
**Bezier Scale Controller (Lock X)** Causes the X value to affect all three axes of scale. The Y and Z values are ignored and their function curves are not displayed.

When X is locked, the Y and Z values are not affected by changes in the X value. If you lock X when all three axes are at identical values, alter the X value, and then unlock X, the Y and Z values remain where they were while X retains its new value.

**Motion panel > Parameters > Key Info (Advanced) rollout**

Controls in the rollout affect velocity in three ways:

- Control the absolute velocity at a key using the In/Out values
- Average velocity over a specified amount of time using Normalize Time
- Force constant velocity from one component key to the next using Constant Velocity

**In/Out** The In field displays the rate of change as the parameter approaches the key. The Out field displays the rate of change as the parameter leaves the key.

These fields are active only for keys using the Custom tangent type.
The number in the field is the rate of change expressed as parameter units per Tick. By changing the two values for X, Y, and Z you are changing the length and angle of the tangent handle.

**Lock button** When on, changing one Custom tangent changes the other by equal but opposite amount. For example, if the Lock button is on and the In value is 0.85, then the Out value is -0.85.

**Normalize Time** Averages the position of the keys in time and is applicable to any consecutive blocks of selected keys. Useful if you want to smooth out the motion and have an object that speeds up, slows down, speeds up, and slows down.

**Constant Velocity** Interpolates values between a key and the next one in a way that makes the object move at a constant velocity across that curve segment.

**Free Handle** Used for automatically updating the length of the tangent handle. When this is turned off, the length of the tangent is at a fixed percentage from its neighboring key. As you move a key, the handles adjust to stay the same percentage away from the neighboring keys. When this is turned on, the handle lengths are based on time lengths.

**Create Position Lock Key / Create Rotation Lock Key** Makes the incoming handle of the current key linear, and the outgoing handle of the previous key linear. This is to prevent overshoot from the spline interpolation.

To use these two features, you must first create a keyboard shortcut in Customize > Customize User Interface. Look for Create Position Lock Key and Create Rotation Lock Key in the keyboard shortcut list and assign a key. Or you can also add these commands to the quad menu.

---

**Block Controller**

Main toolbar > Curve Editor (Open) > Expand Global Tracks in the Track View hierarchy. > Block Control

Graph Editors > Track View – Curve Editor > Expand Global Tracks in the Track View hierarchy. > Block Control

A Block controller is a global List controller on page 3497 that allows you to combine several tracks from multiple objects over a range of time, and group them as "Blocks." These Blocks are then used to re-create the animation anywhere in time. Blocks can be added, removed, scaled, moved graphically
in Track View, and saved. Blocks can represent either absolute or relative animation.

For example to animate a hand forming a guitar chord, all the rotations of the fingers and hand can be saved as a block. This block can then be used to recreate the hand and finger position, rotation, and animation whenever the chord is played in an animation.

Essentially, block controllers allow you to build up libraries of animations and apply them to objects as you choose.

**TIP** Euler Rotations will give you better results than TCB Rotation controllers when you are working with blocks. Block controllers blend clips in a relative repeat manner. If your motions do not loop exactly, your rotations start to drift. Also note that block controllers only work with Keyframe controllers (non-procedural).

**Master Block Parameters Dialog**

After assigning a Master Block, right-click the MasterBlock track to display the Master Block Parameters dialog on page 3444. This is the first step in creating a block.

With this dialog, you can save blocks and then load them later. Blocks are saved as BLK files.

**Track View Pick Dialog**

The Track View Pick dialog on page 3448 is displayed when track selection is necessary; for example, when you click Add in the Master Block Parameters dialog. Select tracks in the dialog to include in a block. Valid tracks are shown as darker.
**Block Parameters Dialog**

After you create a block by clicking Add in the Master Block Parameters dialog and then selecting tracks in the Track View Pick dialog, clicking OK in the Track View Pick dialog displays the Block Parameters dialog on page 3444.

**Attach Controls Dialog (Loading Blocks)**

The Attach Controls dialog on page 3442 is displayed when you click Load in the Master Block Parameters dialog. Tracks in blocks saved previously can be mapped to tracks in the current scene.

**Slave Parameters Dialog (Slave Controller)**

Every time a block is created, all tracks within the block are assigned a slave controller, which allows the MasterBlock to transfer key data. The slave controller tracks appear with the original tracks you used to create the block. See Slave Parameters dialog on page 3446.

**MasterBlock Subtracks**

Below the main MasterBlock track are subtracks. The first of these is always Blend. The remaining subtracks are initially copies of the tracks used to create the block.

**Blend track** Lets you animate the influence of the block. You can reduce the block’s influence by creating Blend keys with values less than 1.0. Default=1.0.

**Block-specific subtracks** Display the block name and its associated tracks. Initially these are copies of the tracks used to create the block. You can edit keys on these tracks to change the block's behavior.
Block Key Properties Dialog

**Relative Motion** Toggles between relative and absolute motion.

**Start, End** Set the first and last frames for this instance of the block (this scales the block instance).

**Procedures**

**Example: To create a block:**

1. Animate two objects moving in the viewports. Make the final keyframe for the objects frame 10.

2. Open Track View — Dope Sheet.

3. On the Track View hierarchy, expand Global Tracks, expand Block Control, and then select Available. Available is the track below the Block Control track.

4. From the Track View toolbar, choose Controller menu > Assign, select Master Block in the dialog, and then click OK. The Master Block Parameters dialog automatically displays.

5. Click Add on the Master Block Parameters dialog.

6. On the Track View Pick dialog, expand the tracks for the two animated objects.

7. While holding down Ctrl, click the X,Y,Z Position tracks for both objects, and then click OK.

8. On the Block Parameters dialog, type a name in the name field.
Choose a name that will remind you of the animation in this block.

9  Set the End value to 10, and then click OK.
The Block will contain animation between frame 0 and frame 10.

10 Click OK to close the Master Block Parameters dialog.
The block has been created, and you can now use it.

- Once a block is added, a slave controller is added to the controllers on the original tracks. This enables communication between the track and the Block controller.

- With the Blend track (below the MasterBlock track in the Track View hierarchy) you can animate how much of the block animation will be in effect. Negative values reverse the animation.

- Controllers that each block uses are listed under the block name. This allows you to adjust the data for a particular block.

Example continued: To use a block:

1  In the Dope Sheet Key window, right-click the MasterBlock track.
   A pop-up menu displays the name of blocks already created.

2  Select the name of the block you created earlier.
The Block is displayed in the Key window.

3  Drag the Block to start at frame 20, and click Play.
The animation repeats at frame 20.

   You can create a number of blocks for different periods of an object's animation, and use them at different locations in the MasterBlock track.

To move an inserted block:

- In the Key window, select the block and then drag it left or right.

To scale (resize) an inserted block:

- Select the key at the lower left or right corner of the block, and then drag left or right.

To create a copy of a block:

- Hold down Shift, and draft the block.
This creates a new instance of the block, which you can place at a different time.

**To remove an inserted block:**
- Click to select the block, then press Delete.

**Interface**

Inserted blocks appear in the Key window to the right of the MasterBlock controller in the hierarchy under Global Tracks.

**Block Control track** Displays in Track View under Global Tracks.

To create a MasterBlock Control, expand Block Control, select Available, and choose Controller > Assign.

**MasterBlock Track** Displays in Track View after you assign a Master Block controller to an available track.

You can right-click the track in the Key window. This displays a pop-up menu that shows the name of blocks that have been created. Choosing a block inserts the block into the MasterBlock track. The dialog also has an entry, Properties, that displays the Master Block Parameters dialog.

In the MasterBlock track, inserted blocks display as colored rectangles. The name of the block appears at the center. In the lower left and right corners are keys that indicate the beginning and end of the block's animation. Below the name of the block is the letter “R” for relative, or “A” for absolute. Click and drag the center of a block to move it in time. Select a key in the corner of a Block to move one edge of the block (scale time).
Right-click an inserted lock to display the Block Key Properties dialog (described below).

**Attach Controls Dialog (Block Controller)**

Track View > Global Tracks > Block Control > Click and then right-click MasterBlock track. > Properties > Load > Choose a file. > OK > Attach Controls dialog

Track View > Global Tracks > Block Control > Double-click MasterBlock track. > Properties > Load > Choose a file. > OK > Attach Controls dialog

3ds Max opens this dialog when you click Load in the *Master Block Parameters dialog* on page 3444. Tracks in blocks previously saved can be mapped to tracks in the current scene.

The Incoming Controls list on the left contains all the incoming tracks. The Copy To list on the right contains all the tracks in the current scene that you will attach to.
**Interface**

**Attach Controls**

<table>
<thead>
<tr>
<th>Incoming Controls</th>
<th>Copy to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sphere01 X Position</td>
<td>Add</td>
</tr>
<tr>
<td>Sphere01 Y Position</td>
<td>Add</td>
</tr>
<tr>
<td>Sphere01 Z Position</td>
<td>Add</td>
</tr>
<tr>
<td>Tours01 X Position</td>
<td>Add Null</td>
</tr>
<tr>
<td>Tours01 Y Position</td>
<td>Add Null</td>
</tr>
<tr>
<td>Tours01 Z Position</td>
<td>Add Null</td>
</tr>
<tr>
<td>Tours01 X Rotation</td>
<td>Match by Node</td>
</tr>
<tr>
<td>Tours01 Y Rotation</td>
<td>Delete</td>
</tr>
<tr>
<td>Tours01 Z Rotation</td>
<td>Delete</td>
</tr>
<tr>
<td></td>
<td>Move Up</td>
</tr>
<tr>
<td></td>
<td>Move Down</td>
</tr>
<tr>
<td></td>
<td>OK</td>
</tr>
<tr>
<td></td>
<td>Cancel</td>
</tr>
</tbody>
</table>

**Add** Selects tracks in the current scene in the Track View Pick dialog on page 3448.

**Add Null** Allows a space to be taken if you don’t want to use a particular track.

**Match by Node** Select tracks on the left that you want to match. Click Match By Node. Then select a group of tracks that you want to match to. The system attempts to match the controls based on their names.

**Delete** Deletes a track from the list.

**Move Up, Move Down** Move tracks up and down to align them before attaching them.

**OK** Imports the tracks and closes the dialog.

**Cancel** Cancels the Load operation.
Block Parameters Dialog (Block Controller)

Track View > Global Tracks > Block Control > Click and then right-click MasterBlock track. > Properties > Master Block Parameters dialog > Add > Choose tracks in Track View Pick dialog > Click OK. > Block Parameters dialog

Track View > Global Tracks > Block Control > Double-click MasterBlock track. > Properties > Master Block Parameters dialog > Add > Choose tracks in Track View Pick dialog > Click OK. > Block Parameters dialog

After clicking Add in the Master Block Parameter dialog and selecting tracks in the Track View Pick dialog to create a Block, clicking OK in the Track View Pick dialog opens the Block Parameters dialog.

Interface

| Name Field | Names the block. |
| Start, End | Set the range of the block in frames. |
| Color | Selects a color for the Block. Displays a color selection dialog. |
| OK | Saves the parameters and closes the dialog. |
| Cancel | Closes the dialog without saving the parameters. |

Master Block Parameters Dialog (Block Controller)

Track View > Global Tracks > Block Control > Master Block > Click and then right-click the Master Block track. > Master Block Parameters dialog

Track View > Global Tracks > Block Control > Master Block > Double-click the Master Block track. > Master Block Parameters dialog
After assigning a Master Block, right-click the Master Block track to open the Master Block Parameters dialog. This is the first step in creating a block.

**Interface**

![Master Block Parameters Interface]

**Add** Opens the Track View Pick dialog. Use the dialog to choose tracks to include in a Block. Valid tracks are displayed in darker text.

**Add Selected** Creates a block using the tracks already selected in the Track View hierarchy. Any invalid tracks are ignored.
Select the tracks (include the Master Block track), and then right-click Master Block in the Track View hierarchy.

**Replace** Replaces the currently selected block.

**Remove** Remove the selected block from the list.

**Load** Loads a block from disk. Displays the Attach Controls dialog.
Map incoming tracks to tracks in your scene using controls in the Attach Controls dialog.

**Save** Saves the current block to disk.
**Slave Parameters Dialog (Block Controller)**

Track View > Click and then right-click a slave track in the Track View hierarchy. > Properties > Slave Parameters dialog

Track View > Double-click a slave track in the Track View hierarchy. > Properties > Slave Parameters dialog

Every time you create a block, all tracks within the block are assigned a Slave controller, which allows the Master Block to transfer key data.

The Slave controller can be assigned without being connected to a Master Block controller. Controls in the Slave Parameters dialog allow you to attach the slave to a master. If the slave is not attached to a master, a dialog is displayed listing the available master controls you can attach to. The Track View Pick dialog on page 3448 is displayed, listing the tracks you can add.

Right-click a Slave controller in the Track View hierarchy to display the Slave Parameters dialog. The list window displays any assigned tracks.
Interface

Add New Link Adds a link. Displays the Add New Link dialog with available tracks. Click a track and then click OK.

Remove Link Removes the highlighted link.

Collapse Control Collapses the Slave controller to a standard controller. Existing keys are copied to the new controller.

OK Closes the dialog.
**Track View Pick Dialog (Block Controller)**

Track View > Global Tracks > Block Control > Click and then right-click MasterBlock track. > Properties > Master Block Parameters dialog > Add > Track View Pick dialog

Track View > Global Tracks > Block Control > Double-click MasterBlock track. > Properties > Master Block Parameters dialog > Add > Track View Pick dialog

3ds Max opens this dialog when track selection is necessary; for example, when you click Add in the Master Block Parameters dialog on page 3444. Select tracks in the dialog that you want to include in a Block. Valid tracks are darker.

**Interface**

3448 | Chapter 13  Animation
Boolean Controller

Main toolbar > Curve Editor (Open) > Select a track containing a float value in the Track View hierarchy > Track View menu bar > Controller menu > Assign > Boolean controller

Graph Editors > Track View – Dope Sheet > Select a track containing a float value in the Track View hierarchy > Track View menu bar > Controller menu > Assign > Boolean controller

The Boolean controller is similar to the On/Off controller on page 3522. By default, it is assigned to tracks (such as an object’s Visibility track) that provide only binary on and off control.

NOTE The Boolean controller is useful for controlling the Enabled state in the History Independent (HI) IK system on page 3695.

It differs from the On/Off controller in two ways: first, each key has its own float value, either 1.0 or 0.0, signifying its on or off state. This enhancement leads to the second component that differentiates the Boolean controller from its On/Off cousin: the ability to lay down sequential keys without inadvertently changing the on/off state of any keys downstream.

The Boolean controller can be assigned to any parameter that would normally be controlled by a float or boolean class controller, such as a sphere’s Hemisphere or Smooth track.
Boolean controller key values can be changed in one of two ways: through Track View's Dope Sheet editor or through MAXScript.

**NOTE** Although the Boolean controller displays a function curve in Track View's Curve Editor, it does not display keys. Key time and value must be changed in the Dope Sheet editor.

### Procedures

**To assign a Boolean controller and add keys:**

1. Open Track View's Dope Sheet editor and select any track that would normally be assigned a float or boolean class controller.

2. Right-click and select Assign Controller. Pick the Boolean controller from the Assign Controller dialog, and click OK.

3. From the main Track View toolbar, select the Add Keys button and click anywhere on the selected track. New keys with a value of 0.0 are added.

**To change Boolean controller key values in Track View:**

1. Open the Track View Dope Sheet editor and select a track that contains a Boolean controller.

2. Select any key and type **1.0 or 0.0** into the key value field at the bottom of the Track View dialog.

**NOTE** Values greater than 0.0 will automatically be clamped to 1.0.

**To change Boolean controller key values via MAXScript:**

- Enter the following into either the MAXScript Listener or Mini Listener:

  ```maxscript
  <node>.<animatable_property>.keys[<index_integer>].value = <float>
  ```

  where `<node>` is the object containing the Boolean-controlled
parameter (for example, $Sphere01$, <animatable_property> is the parameter itself (for example, Smooth, <index_integer> is the actual sequential number of the key in the key array, and <float> is either 1.0 or 0.0.

Color RGB Controller (Point3 XYZ Controller)

Main toolbar > Curve Editor (Open) > Select a material color track in the Track View hierarchy. > Track View menu bar > Controller menu > Assign > Color RGB

Graph Editors > Track View – Curve Editor > Select a material color track in the Track View hierarchy. > Track View menu bar > Controller menu > Assign > Color RGB

The Color RGB controller splits the R, G, and B components into three separate tracks. You can use this controller with color tracks. By default, each track is assigned a Bezier Float controller. The Bezier Float controller is a single parameter controller.

NOTE The Color RGB and the Point3 XYZ controllers are identical in function, except that the labels of their tracks are RGB and XYZ respectively. Point3 XYZ controllers can be used for functions such as Noise Strength, and the FFD modifier.

Procedures

Example: To animate the background color of a rendered animation:

1. Open Track View – Curve Editor.
2. In the Track View hierarchy, expand the Environment track and then select Background Color.

3. On the Track View menu, click Controller > Assign and select the Color RGB controller.

4. Expand the Background Color track.

5. On the Track View toolbar, click Add Keys.

6. Add three keys along the red track at frames 0, 50, 100.

7. Right-click one of the keys to display the Bezier Float dialog. Change the key values to 0, 400, and 0, respectively.

To see the background color change, move the time slider to the same frame as the key that is being adjusted and render the scene. To see the color change in an animated fashion, you must render the animation.

Although you can set values over 255 in the value field, the actual color value stops at 255.

**Interface**

Bezier Float controller properties.

![Bezier Float controller](image)

See [Bezier Controller](#) on page 3432 for a description of these parameters.
The Euler XYZ Rotation controller is a compound controller that combines separate, single-value float controllers to specify an angle of rotation about each of the X, Y, and Z axes. Euler XYZ is not as smooth as quaternion rotation (used by the TCB Rotation controller), but it is the only rotation type that you can use to edit rotation function curves.

The Euler XYZ Rotation controller assigns individual tracks to the X, Y, and Z components of position, rotation, and scale transforms. However, the controller assigns three keys (one for each axis), by default. To avoid this, you can use Customize User Interface on page 8249 actions to create explicit axis keys. These are available in the Main UI group > Set Key Tools category.

The Gimbal reference coordinate system on page 928 is intended for use with this controller. With other coordinate systems, rotating about one axis always changes at least two tracks. With Gimbal rotation, rotating about one axis changes only one track, making it easier to edit function curves.

**Euler versus TCB Rotation**

Euler rotation offers several advantages over the TCB Rotation controller, which was the default rotation controller prior to 3ds Max 5. Euler rotation provides function curves, while TCB does not. Euler rotation allows for three separate curves that can be manipulated in the Curve Editor. TCB rotations can be controlled only with tension, continuity, and bias settings, making it difficult to keyframe and manipulate X, Y, and Z rotation independently.
On the other hand, TCB rotation allows for rotation greater than 180 degrees on a given keyframe. If you turn on the Rotation Windup on page 3566 option, you can get rotation values greater than 360 degrees.

**TIP** If you’re used to working with TCB rotation, you might find it difficult to adapt to the Euler workflow. In that case, you might want to assign TCB as the default rotation controller. See Specifying Default Controllers on page 3400.

**Euler Rotation and the Waveform Float Controller**

Because the Euler Rotation controller uses radians, unit adjustments should be made when other controllers are applied to Euler axes. For example, the Waveform Float controller has a default amplitude of 100 in the Characteristic Graph. When the Waveform Float controller is applied to an Euler axis, the default amplitude is 100 radians. This sets the Amplitude setting to 5729.598 (the number of degrees in 100 radians).

**Euler Rotation and the Noise Float Controller**

When a Noise Float controller is applied to an Euler axis, the default Strength setting is 286.479 or 50 percent of 10 radians in degrees (maximum deflection).

**Euler Rotation and the MIDI Motion Capture Controller**

When a MIDI Motion Capture controller is applied, the Parameter Scaling is taken in radians so that the Max. default setting of 1.0 results in an upper boundary of 57.2958 degrees.

**Procedures**

**Example: To use Euler XYZ Rotation:**

1. Create a box.

2. Go to the Motion panel and make sure the assigned rotation controller is Euler XYZ. If not, highlight the Rotation track in the Assign Controller rollout list, click Assign Controller, and then choose Euler XYZ in the Assign Controller dialog list. Click OK.

3. Turn on Auto Key.

4. At the bottom of the PRS Parameters rollout, click Rotation.
5 On the Euler Parameters rollout, click the X rotation axis button, if
necessary.

6 In the Create Key group of the PRS Parameters rollout, click Rotation.
   3ds Max creates a rotational key.

7 Move the time slider to frame 50.

8 Again, in the Create Key group of the PRS Parameters rollout, click
   Rotation.

9 On the Key Info (Basic) rollout, enter 500 in the Value field.

10 On the Euler Parameters rollout, click the Z rotation axis button and then
    enter 90 in the Value field of the Key Info (Basic) rollout.
    Play the animation. The box rotates 500 degrees around the X axis and
    90 degrees around the Z axis. In this case the X-axis rotation takes place
    first, and then Z-axis rotation.

To use Euler XYZ with List controllers for local rotation control:

You can mimic the local Euler rotation controller (available in earlier versions
of 3ds Max) by combining a list controller with an Euler XYZ rotation
controller.

1 Select the object for which you want to have local rotational control. For
   example, create a teapot and a dummy.

2 Animate the dummy.

3 Open the Motion Panel.

4 In the Assign Controller rollout, select the Rotation transform, then assign
   a LookAt controller to teapot, with the dummy assigned as the LookAt
   Target.
   You now have an object with rotation controlled through the dummy.

5 With the Rotation: LookAt controller selected in the window, again
   choose Assign Controller and pick Rotation List.
   Now there is a list controller, with the LookAt Constraint applied as the
   first rotation controller in the list.

6 Scroll down in the window and select the entry labelled Available, then
   again click Assign Controller.
7 Choose Euler XYZ.
You now have a list controller with a LookAt Rotation as the first controller and an Euler XYZ as the second controller.

8 In the Rotation List rollout, highlight Euler XYZ in the Layers window, then click Set Active.

9 In the Euler Parameters rollout, change the Axis Order to ZYX.
Now you can animate the rotation independent of the LookAt rotation control. It should now behave the same as the Local Euler controller that was available in versions 4 and earlier.

**Interface**

Euler parameters are displayed in the Motion panel.
The Euler parameters rollout is displayed when Rotation is selected in the PRS Parameters rollout on page 3526.

![Euler Parameters](image)

**Axis Order** Selects the order that rotations are calculated. The default is X,Y,Z order, where the X axis is rotated first.

X Displays controller properties for X axis rotation angle.

Y Displays controller properties for Y axis rotation angle.

Z Displays controller properties for Z axis rotation angle.

Each axis uses its own independent controller using the float data type. For example, the X and Y Rotation axes could use Bezier Float controllers, while the Z rotation axis uses a Noise Float controller.

**Expression Controller**

Main toolbar > Curve Editor (Open) > Select a track in the Track View hierarchy. > Track View menu bar > Controller menu > Assign > Expression

Graph Editors > Track View – Curve Editor > Select a track in the Track View hierarchy. > Track View menu bar > Controller menu > Assign > Expression

3456 | Chapter 13  Animation
The Expression controller lets you use mathematical expressions to control these animation aspects: object parameters such as length, width, and height; and transform and modifier values such as an object's position coordinates.

An expression is a mathematical function that returns a value. 3ds Max evaluates the expression once for each frame of an animation, generating values that can change from frame to frame.

You can constrain values by basing them on the controller values of other objects in the scene.

You can create and manage Expression controllers in Track View and on the Motion panel. You can assign expressions to the following kinds of scene elements:

<table>
<thead>
<tr>
<th>Scene element</th>
<th>Controller</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creation parameters</td>
<td>Any numeric creation parameter</td>
</tr>
</tbody>
</table>
| Transforms | Position [X, Y, Z]  
X Rotation  
Y Rotation  
Z Rotation  
Scale [X%, Y%, Z%] |
| Modifiers | Any numeric modifier parameter (including creation parameters) |
| Materials | Colors [R, G, B]  
Any numeric material parameter |
NOTE Expression controllers can work only with the individual XYZ components of Euler rotation. You can't assign an expression to TCB Rotation or other kinds of rotation controllers.

See also:
- Expression Techniques on page 339
- Expression Controller Techniques on page 3463
- Trigonometric Functions on page 349
- Vectors on page 352

Procedures

To assign a constant value to a variable:
1. Highlight the variable name in the Scalars or Vectors list.
2. Click Assign To Constant.
   A new dialog opens.
3. On the dialog, enter the new value (or, in the case of a vector, values) for the constant, and then click OK.

To assign a controller to a variable:
1. Highlight the variable name in the Scalars or Vectors list.
2. Click Assign To Controller.
   The Track View Pick subdialog is displayed, showing the track hierarchy. The dialog display is similar to the Track View hierarchy.
3. Highlight the track for the variable to use, and then click OK.

Example: To create an expression that moves a sphere in a precise circle:
1. Create a sphere with Radius=15.0.
   You'll use Track View to create the Expression controller.
2. In the active viewport, right-click the sphere and click Curve Editor.
3 In the Hierarchy list, scroll down to the Objects branch and, if necessary, expand Sphere01 the branch so the sphere's Position track is visible. Click the Position label to highlight it.

4 In the Hierarchy list, right-click the Position label and then choose Assign Controller
   The Assign Controller dialog opens.

5 Choose Position Expression from the list of controller types, and then click OK.
   The Expression Controller dialog opens.

   **NOTE** You can also open the Expression Controller dialog with Track View > Controller menu > Properties.

6 Replace the default expression by typing the following position expression in the Expression field:

   `[100*cos(360*NT), 100*sin(360*NT), 0]`

   The expression specifies a circular path for the sphere. NT is a variable that means normalized time. Movement based on NT happens exactly once per the active time segment, regardless of how many frames are in the animation.

7 Click Evaluate.

8 Play the animation. The sphere moves in a circle about the world origin (0,0,0). The radius of the circular path is 100 units.

**Example continued: To change the radius of the circle:**

The two 100s in the position expression from the previous procedure specify the radius. To adjust the radius of the circle's path, create a symbolic variable to represent the radius. The variable has a constant value that is easy to edit.

1 Reopen Track View and the Expression Controller dialog if necessary.

2 In the Name field of the Expression Controller dialog, type `radius` Make sure Scalar is chosen, and then click Create.
   The variable name "radius" appears in the Scalars list of the dialog.

3 Click Assign To Constant.
   A dialog titled "radius" opens.

4 Enter 150 in the Value field, and then click OK.
The radius variable is now 150.
Next you’ll use the new variable in the expression.

Example continued: To replace the literal value with the variable name:

1 In the Expression field, change 100 to radius in both places. The expression should now look like this:
   \[ \text{radius} \cos(360\times NT), \text{radius} \sin(360\times NT), 0 \]

2 Click Evaluate.

3 Play the animation. The sphere moves in a circle about the world origin (0,0,0). The radius of the circular path is 150 units.

Example continued: To make the sphere rotate about a box:

1 Create a box about 40 units square, and animate its position over three or four keyframes.

2 Select the sphere.

3 In the Name field of the Expression Controller dialog, enter boxposn. Choose Vector, and then click Create.
The name "boxposn" is displayed in the Vectors list in the lower-left area of the dialog.
Variable names are case sensitive; the variable name should be lower case.

4 Click Assign to Controller.
The Track View Pick dialog is displayed. It shows the object hierarchy as it appears in the left side of Track View-Dope Sheet.

5 In the Hierarchy list, highlight the Position controller for Box01 and then click OK.

6 In the Expression field, add boxposn as an offset:
   \[ \text{radius} \times \cos(360\times NT), \text{radius} \times \sin(360\times NT), 0] + \text{boxposn} \]

7 Click Evaluate, and then click Close.
Play the animation again. The sphere moves in a circle around the box and follows the box wherever it moves.
Interface

TIP You can resize the dialog by dragging an edge or a corner.

Create Variables group

Name The variable name.

Scalar/Vector Choose the type of variable to create.

Create Creates the variable and adds it to the appropriate list.
You must enter a name and specify a type before clicking Create.

Delete Deletes the highlighted variable in the Scalar or Vector list.

Rename Renames the highlighted variable in the Scalar or Vector list.
First highlight the variable in the list; this places the name in the Name field.
Edit the name in the Name field, and then click Rename; the new name
replaces the previous one in the list.

Variable Parameters group

Tick Offset Contains an offset value.
A tick is 1/4800 of a second. If a variable has a non-zero tick offset, that value
is added to the current time.
Expression window

Type an expression in the Expression box.

The expression must be a valid mathematical expression. The result is either a three-value vector for a vector expression (position, scale, or point3) or a scalar value for a float expression.

Description window

Type text in this window to document an expression. For example, you can describe user-defined variables.

Function List Displays a list of Expression controller functions.

In the list, p, q, and r represent scalar values or scalar expressions; V and W represent vector values or vector expressions.

Save Saves an expression. Expressions are saved as files with a .xpr file name extension.

Load Loads an expression.

A saved expression does not include variable definitions or values. After loading the expression, you need to redefine them.

Debug Displays the Expression Debug window.

This window shows the values of all variables, and the value of the expression. When you change the variables or move the time slider, the Debug window automatically updates so you can interactively view what's happening with the expression. The values for frames (F), normalized time (NT), secs (S), and ticks (T) are also displayed.

Evaluate Evaluate the expression for each frame in the animation.

There is no explicit assignment (= or := operator) as in a conventional programming language; the assignment is implicit and takes place over time.

If the expression has a syntax error, an error message is displayed. The error message is the first part of the expression itself. The last character in the error message is the point of the error. This is usually where the error actually is, unless the problem is that opening and closing parentheses (or the braces for vectors) don't match. In this case, evaluation can proceed further before the error is detected.

Close Closes the Expression Controller dialog.
Expression Controller Techniques

This topic summarizes some useful expression techniques.

See also:
- Trigonometric Functions on page 349
- Vectors on page 352

Commonly Used Expressions

This topic lists some expressions that you might find useful in situations when you animate.

Circular Path

\[
\begin{align*}
\text{[ Radius } \times \cos(360\times\text{Time}), \\
\text{Radius } \times \sin(360\times\text{Time}), 0 ]
\end{align*}
\]

where \text{Time} is one of the predefined time variables such as NT or S.

If you make the two \text{Radius} values unequal, you get an elliptical path.

If you specify a nonzero Z component, the path is no longer planar.

Following Another Object

\[
\begin{align*}
\text{[X, Y, Z] + Position}
\end{align*}
\]

where \text{Position} is the Position controller of the second object.

The vector [X, Y, Z] can be an offset from the second object. (If it’s [0,0,0], the two objects occupy the same position.) It can also be a vector expression that specifies some movement in itself.

Keeping an Object Between Two Objects

\[
\begin{align*}
\text{(Position1 + Position2) / 2}
\end{align*}
\]

where \text{Position1} and \text{Position2} are the Position controllers of two objects.

The divisor 2 constrains the object to be halfway between the two other objects. Other values constrain the object to other locations.
**Bouncing Between Other Objects**

\[(1+\sin(360\cdot Time))/2 \cdot (Pos1-Pos2) + Pos2\]

where *Time* is one of the predefined time variables such as NT or $S$; *Pos1* and *Pos2* are the Position controllers of two other objects.

The subexpression \((1+\sin(360\cdot Time))/2\) is a value that oscillates between 0 and 1 over time. \((Pos1-Pos2)\) is the vector between the two other objects. Multiplying the two and then adding *Pos2* as an offset locates the object along this vector.

**Changing the Number of an Object's Segments Based on Camera Distance**

This expression varies the number of segments in a cylinder based on the distance of a camera. It is assigned to the cylinder's Segments creation parameter.

\[
\text{if } (\text{length}(\text{Camera-Myself}) > 35), \\
3 + (50\cdot\text{Height}) / \text{length}(\text{Camera-Myself}), \\
\text{MaxSegs})
\]

where *Camera* is the position controller of the camera; *Myself* is the cylinder's position controller; *Height* (= 70) is the cylinder's height; *MaxSegs* (=100) is the maximum number of segments.

When the camera is closer, more segments make the cylinder smoother; when the camera is distant, the smoothing is less important and fewer segments render more quickly.

The if() function returns its second argument if the first argument is true; otherwise, it returns its third argument. In this example, if the camera is more than 35 units away from the cylinder, the expression calculates the number of segments; if the camera is 35 units away or closer, the number of segments is the MaxSegs constant.

The values in the second argument are chosen so that as the distance decreases toward the threshold of 35, the number of segments increases toward MaxSegs. The addition "3+" ensures that the cylinder always has at least three segments, even when the division rounds to zero (Segments is an integer).

**NOTE** To the expression, it doesn’t matter whether the camera is moving, or the cylinder, or both.
Layer Controller

Main toolbar > Curve Editor (open) > Highlight a Layer controller track and right-click > Properties

Select layer-enabled object. > Motion Panel > Parameters > Position/Rotation/Scale

The Layer Controller dialog provides commands and options related to the Layer controllers in your scene, which the system automatically assigns for you when you enable animation layers on page 3467 on an object.

Unlike other controllers, you cannot assign a Layer controller explicitly to a track; you first need to enable layers via the Animation Layers toolbar on page 8044 or the Controller menu of the Curve Editor.

The Layer controller dialog has similarities to the List controller on page 3497 dialog. You can refer to it for complementary information on some of the options.

NOTE This section concerns itself with using layers in general animation; for information about using layers with biped animation, see Layers Rollout on page 4741.

Animation Layers and Autodesk VIZ

Although the Animation Layers feature is not available in Autodesk VIZ, VIZ can load and save objects that use this feature without any data loss. The Layer controllers continue to exist in VIZ, and can even be viewed and edited in Track View, although editing of the animation-layer data is not recommended if the objects are to be returned to 3ds Max.

TIP For best results with objects that are to be brought into Autodesk VIZ, collapse on page 3481 any animation layers before saving the objects.
Interface

The dialog for a Layer controller depends on whether you’re using it with a position or scale track (left, following), or with a rotation track (right, following).

<table>
<thead>
<tr>
<th>Layer Controller dialog with position and scale tracks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Layer Controller dialog with Rotation tracks</td>
</tr>
</tbody>
</table>

**TIP** In general, for ease of use we recommend you use the work with layers using the Animation Layers toolbar on page 3467 rather than this dialog.

**List Window** Displays all Layer controllers for the selected object, along with their respective weight value.

**Set Active** Determines on which layer your animation keys are set. The active controller is marked with an arrow in the list.

**TIP** You can also switch between active layers from the drop-down list on the Animation Layers toolbar on page 3467.

**Delete** Deletes the highlighted controller. A confirmation dialog prompts you before.

**Copy** Copies the highlighted controller's data and enables Paste.

**Paste** Puts the copied content onto the highlighted controller.

**Weight** Sets the effects of the highlighted Layer controller
**Average Weights** When on, the weight values of all the controllers in the list. Available only when you assign a Layer controller to a position track. Default=off.

**Pose to Pose** Enables blending among controllers in the list. Available only when you assign a Layer controller to a rotation track. Default=off.

Refer to the List controller on page 3497 for more information on this option.

**Blend Euler As Quat** When on, exposes the rotation axis order for blending the Euler controllers, which can prove useful for controlling gimbal on page 922. Available only when you assign a Layer controller to a rotation track. Default=off.

**X/Y/Z Order** Sets the order in which the system calculates each rotation axis. Available only when Blend Euler As Quat is on.

**Disable** Removes the Layer controller from the select object and reverts the animation keys on the Base Layer to the original controller.

**NOTE** You have to delete or collapse (available on the Animation Layers on page 3467 toolbar) all layers above the Base Layer before you can disable it.

---

### Animation Layers (Layer Controller)

Right-click unused area of any toolbar. > Animation Layers

Animation menu > Animation Layers

Animation layers let you combine multiple animation tracks on the same object. You can use layers to store your animation experiments as you try them out, turning them on or off to your liking. To enable, add, and control layers, use commands from the Animation Layers toolbar.

Using animation layers is comparable to using both the List Controller on page 3497 and biped layer system on page 4741, while it is more flexible and simpler for the animators to use.

**Enabling Animation Layers**

When you enable animation layers on page 3479 for a selected object by turning them on in the Enable Anim Layers dialog, 3ds Max assigns a Layer controller on page 3465 to the animation tracks.
When 3ds Max adds a Layer controller, it copies the original controller into its first layer (called *Base Layer*), preserving any animation data it may already contain.

**NOTE** The *Base Layer* is not a new layer; it is on the same level as any other controller track.

**NOTE** If you layer-enable a controller but do not see a Layer controller appear in the Track View hierarchy window, open and close the Enable Anim Layers dialog again.

To revert from a Layer controller to the original controller, click *Disable Anim Layer* on page 3481 on the Animation Layers toolbar. However, if your object contains more than one animation layer, you first need to either delete or collapse them before you can disable the *Base Layer*. 
**TIP** You can also disable a Layer controller through the Layer Controller dialog on page 3465.

**NOTE** Turning off a track in the Enable Anim Layers dialog does not disable it.

You can assign a Layer controller either at the leaf level of a controller track (such as a material's Diffuse Color track), or at a branch level (such as a Position track).

The Layer controller affects a leaf track.

If the selected object already has a list controller track when you enable layers, that list controller is preserved within the Base Layer of the new Layer controller.

The new Layer controller nests the List Controller.

**NOTE** You cannot nest a Layer controller within a List controller or another Layer controller.
Working with Animation Layers

The animation layers list works as follows (Refer to the procedure section below on page 3473 for common workflow examples):

■ The list displays all existing layers for the selected object. If the object isn't layer-enabled, “(Enable Layers)” appears instead.

■ By default, the Base Layer is the active layer when you first layer-enable an object. This means that it stores all future animation keys.

■ Every subsequent layer you create becomes the new active layer and appears after the previous one in the list.

■ When you select an object, its active layer is automatically chosen. When expanded, the drop-down list highlights the active layer.

■ When you select multiple objects that have different active layers, “(Multiple Active Layers)” appears. The drop-down list displays all common layers (that is, with the same name); layers not common to all are unavailable.

■ You can turn on or off any layer in the expanded list by clicking its light bulb icon. Turning off a layer hides its animation without deleting it.
To toggle a layer, click its light bulb icon.

- You can include or exclude any layer from the output track by clicking its plus/minus sign icon. The output track contains the sum of all included layers. You can use this track to control other objects' tracks via MAXScript and parameter wiring.

To toggle a layer's inclusion in the output track, click the plus/minus sign icon.

**TIP** For a procedure that demonstrates how to use this option, see Example: To link two objects with wire parameters using the Layer Controller's output track: on page 3476.

- You can lock and unlock a layer by clicking its lock icon. If a layer is locked, you cannot manipulate any object properties that the layer controls (such as motion) when the layer is active.

To toggle the ability to change animation in a layer, click the lock icon for the layer.
Each animation layer has a global weight value which, when changed, impacts every controller within that active layer. Similar to the List controller on page 3497, you can animate a layer’s weight and toggle the visibility of the resulting keys in the Track Bar using the Track Bar Filter menu on page 8078.

When you add a new animation layer on page 3483, you can pick a name already in use by an existing layer; this links both layers' weight track, which is now instanced.

### Using Merged or XRef Scenes Containing Layers

When you merge on page 7572 or externally reference on page 7477 a source scene (or object) containing layers into your master scene, the system adds the incoming layers to the master scene's layer list.

**NOTE** All animations within an incoming XRef object or scene is preserved within an XRef controller on page 3570. You cannot edit them unless you merge the XRef object or XRef controller into your master scene.

If a layer name from the merged or XRef scene matches one from the master scene, both layers become synchronized; that is, the weight track is instanced to both of them.

### Collapsing Layers

Collapsing a layer merges keys if any of these conditions are met:

- the two controllers are of similar types (Bezier, Float, TCB, etc.).
- they have the same tangent type.
- the Blend Euler As Quat option of the Layer Controller dialog on page 3465 is turned off.
However, many factors can cause a collapse per frame (that is, setting a key on every frame):

- If one controller type is TCB (Quaternion) and the other is Bezier (Euler).
- If the Blend Euler As Quat option of the Layer Controller dialog on page 3465 is turned on, and both rotation controllers are Euler-driven.
- If the Blend Euler As Quat option of the Layer controller is turned off, and both rotation controllers are Euler-driven, but both have different tangent types.
- If either controller is non-keyable.

**Procedures: Integrating Animation Layers in a Workflow**

The following sequence of procedures illustrate how you can use animation layers in your workflow to quickly create and combine different animation tracks together for the same object. You should be familiar with the basics of animation and key creation before going through the following steps.

**Example: To enable layers:**

1. Create a teapot, and then turn on Auto Key and move the teapot at frames 15 and 30 to create a short animation.
   By default, this also creates a key at frame 1. Your start key might be at frame 0 instead; for the purposes of this example, it's immaterial.

2. On the main toolbar, choose Animation > Animation Layers.
   This opens the Animation Layers toolbar.

3. Make sure the teapot is selected, then click Enable Anim Layers.

4. On the Enable Anim Layers dialog, turn on only the Position track, and click OK.
   The new Layer controller now nests your teapot's animation.

**Example: To add a layer and change its controller type:**

This continues from the previous procedure, in which you enabled layers for an animated object.

1. On the Animation Layers toolbar, click Add Anim Layer.
On the Create New Animation Layer dialog, enter “Noise Layer” as name, and click OK.

The teapot now has two animation layers, each of which can contain a separate animation that you can control independently of the other.

Right-click the teapot, and from the context menu choose Curve Editor on page 3804. In the hierarchy list on the left, scroll down to the Teapot01 object. Expand the hierarchy as follows: Teapot01 > Transform > Position. Under Position you’ll see Base Layer, Noise Layer, two Weight Tracks, and Output

Highlight Noise Layer and right-click it.

From the context menu, choose Assign Controller and pick a Noise Position controller.

This opens the Noise Controller dialog. Leave the options as they are and close the dialog.

Two different controllers are now driving the teapot’s position.

Play the animation to see the teapot jitter as it moves along the original animation path.

Example: To turn a layer on and off:

This procedure discusses turning existing layers on and off. It continues from the previous procedure.

On the Animation Layers toolbar, expand the drop-down list.

The list currently contains both the original base layer and Noise Layer from the previous procedure.

Move your cursor across the list and click the light bulb icon next to Noise Layer.

This turns off the layer and hides the Noise controller track from the rest of the tracks.
3 Drag the time slider and notice how the teapot does not shake anymore.

4 Try turning on and off both layers in the list to see the results. When finished, turn both layers on.

Example: To lock and unlock a layer:

This procedure discusses locking and unlocking layers. It continues from the previous procedure.

1 If the Base Layer isn’t already active, on the Animation Layers toolbar, expand the drop-down list and choose the Base Layer.

2 Make sure Auto Key is on, then go to frame 20 and move the teapot to set a new animation key.
   Now, when you play the animation, the new key is included.

3 On the Animation Layers toolbar, expand the drop-down list. On the list entry for the Base Layer, click the lock icon so it appears to be locked.

4 With the Base Layer still active, try to move the teapot.
   You can’t, because the layer is locked. This protects the animation on that layer from inadvertent changes.

5 Open Track View and find the Position > Base Layer track for the teapot and expand it. Highlight the X Position track (or Y Position or Z Position), then right-click the highlighted track and from the top-left quadrant of the quad menu, choose Unlock.
   The “(Locked)” text no longer appears after the Base Layer tracks.

6 Go back to the Animation Layers dialog and check the Base Layer lock icon.
It is no longer locked. This shows that locking and unlocking a track in an animation layer affects all tracks controlled by that layer.

Example: To link two objects with wire parameters using the Layer Controller's output track:

This procedure refers to a simple way to use the output track to control a cube's position through wire parameters. It continues from the previous procedure.

1. Make sure both layers listed on the Animation Layers toolbar are on, as indicated by the light bulb icons.

2. Create a box next to the teapot.

3. Right-click it and choose Wire Parameters from the quad menu.

4. Navigate through the pop-up menu and choose Z Position.

5. A dashed line appears. Click the teapot and choose the X Output Track from the pop-up menu.
6 The Parameter Wiring dialog on page 3612 opens, with the two highlighted parameters. Click the left directional arrow button to control the cube's position using the teapot's animation.

7 Click Connect and close the window. Drag the time slider and notice how the cube's position in Z matches the teapot's layered animation in X.

8 Select the teapot and expand the layer list from the Animation Layers toolbar.

9 Click the plus sign icon next to the Noise Layer. This excludes the layer from the output track.
Drag the time slider again. The cube doesn't move erratically like the teapot.
Try including and excluding both layers in the list to see the results.

**Example: To copy and paste a layer and update an active layer:**
This procedure continues from the previous procedure and focuses solely on the teapot.

1. Make sure the teapot is selected and choose Base Layer from the animation layers list to make it active.

2. Click Copy Anim Layer on the Animation Layers toolbar to buffer this layer and the data it contains.

3. Click Paste New Layer. On the Rename Anim Layer dialog, enter “Changes on Z axis” as name and click OK.
   This new layer becomes the active layer.

4. While Auto Key is on, move the teapot on the Z axis at frames 5 and 20.
   This animation update only affects the position tracks of the active layer.
Example: To collapse a layer:

This procedure continues from the previous procedure.

1. In the animation layers list, turn off Noise Layer. Then, choose Changes on Z axis to make it active.

2. Click Collapse Anim Layer on the Animation Layers toolbar.

   This merges the layer onto the next available one (Base Layer), skipping Noise Layer, which is off.

3. Turn Noise Layer back on in the list.

Interface

Enable Anim Layers Assigns a Layer controller to tracks you specify.

NOTE  Enabling animation layers does not create a new layer, but rather transfers all chosen controller tracks to the Base Layer.

This opens the Enable Anim Layers dialog, which, similar to the Set Key Filters dialog on page 3376, lets you turn on tracks you want to assign a Layer controller to.

The Position, Rotation, and Scale tracks are on by default. You can still animate attributes other than those enabled on this dialog, but they are not subject to control by the Layer controller.
NOTE Once you turn on a track, you can turn it off only by disabling the respective Layer controller.

If you enable animation layers for an object that has animation loaded in the Motion Mixer on page 4001, the following dialog opens:

Remapping is necessary in this case because enabling Animation Layers causes the full controller names to change. For example, if a sphere’s X position track before enabling Animation Layers is Sphere01\Transform\Position\X Position, then after enabling animation layers it might change to Sphere01\Transform\Position\Base Layer\X Position (the layer name is inserted into the controller name).

If you accept the default dialog option, to create the new map files automatically, 3ds Max automatically generates any necessary XMM files on page 4110 with the same names as the XAF files and places them in the same directory as the original map files, or if no map files exist, in the same directory as the XAF files. Thereafter, when you open this scene file the map file is loaded automatically and no additional mapping is required.

However, if you turn off Automatically Create The New Map Files? before clicking OK, no map files are generated, and the next time you open the scene file you’re prompted to create map files. Without map files, the animation doesn’t appear correctly.

Select Active Layer Objects Selects all objects in your scene containing the active layer.

[animation layer list] Displays all existing layers for the selected object. Each layer in the list contains toggle icons to turn it on or off, as well as include or exclude it from the controller’s output track. See Working with Animation Layers on page 3470 for more details.
[weight] Sets a global weight for the active layer, which affects If the active layer is shared by several objects (ex. Base Layer), changing its weight affects them all.

Anim Layer Properties Opens the Layer Properties dialog on page 7966, which lets you set global options for layers.

Add Anim Layer Opens the Create New Animation Layer dialog on page 3483, which lets you specify settings related to the new layer. This adds a new layer to every track that has a Layer controller.

Delete Anim Layer Removes the active layer, along with the data it contains. A confirmation dialog prompts you before deletion.

NOTE You cannot delete the Base Layer. Alternatively, Click Disable Anim Layer on page 3481 to removes the Layer controller entirely.

Copy Anim Layer Copies the active layer's data and enables Paste Active Anim Layer and Paste New Layer.

Paste Active Anim Layer Overwrites the active layer's controller type and animation keys with the copied data.

NOTE You cannot paste a copied layer from one object onto another.

Paste New Layer Creates a new layer with the copied layer's controller type and animation keys. Opens the Rename Anim Layer dialog, in which you can use the default layer name or enter your own.

Collapse Anim Layer Collapses the active layer to the one below it, as long as it is not turned off. If it is, the collapsed layer cycles through the list until it finds an available layer.

NOTE Collapsing a layer does not remove the Layer controller. Click Disable Anim Layer to remove it.

Disable Anim Layer Removes the Layer controller from the selected object. The animation keys on the Base Layer revert to the original controller. A dialog prompts for confirmation.
NOTE Before you can disable the Base Layer, you have to delete or collapse all layers above.

Layer Properties Dialog (Layer Controller)

Right-click unused area of any toolbar. > Animation Layers > Create New Animation Layer

This dialog provides global options in regards to collapsing animation layers on page 3467 and isolating the active layer from the rest.

Interface

Collapse To  Sets the controller type for when you collapse a controller track onto a non-keyable controller track, such as a Noise controller.

- **Bezier or Euler**  On collapse, the resulting track is assigned either a Position XYZ controller (for a Position track), a Bezier Scale controller (for a Scale track), or an Euler XYZ controller (for a Rotation track).

- **Linear or TCB**  On collapse, the resulting track is assigned either a Linear controller (for Position and Scale tracks) or a TCB controller (for a Rotation track).

- **Default**  On collapse, the resulting track is assigned a default controller based on the original controller track. Refer to Specifying Default Controllers on page 3400 for more details.

Per Frame Collapse Range  Sets the range to cover when you collapse a layer.
NOTE For best results, turn off Collapse to Keys Only, When Possible; otherwise, based on the collapsed layer’s controller and tangent type, the system might collapse to keys instead.

■ **Current** When chosen, a key is set on every frame of your scene’s animation range when you collapse a layer.

■ **Range** When chosen, a key is set on every frame of the animation range you specify.
  
  **Start/End**

  Sets the collapse range boundaries.

**Collapse To Keys Only, When Possible** When you collapse a layer, the keys are merged only when the respective controllers are of the same type, same tangent types, and Blend Eulers As Quats is on. Default=on.

**Mute Layers Above Active Layer** When on, you see the effects of the layers only up to the active layer, inclusively. This is similar to the Visible Before/After options of the **biped Layers rollout** on page 4741.

### Create New Animation Layer Dialog (Layer Controller)

Right-click unused area of any toolbar. > Animation Layers > Create New Animation Layer

This dialog lets you choose both the name and controller type of the new layer.

**Interface**

Layer Name Lists all available layers in your scene. You can use the default name, enter a custom name, or pick one from the list. If you choose an existing
layer from the list, it inherits that layer’s name and weight properties. Refer to Working with Animation Layers on page 3470 for more details.

TIP You can rename a layer after it is added from the Layer Controller dialog on page 3465.

NOTE All animation layer names persist in the Layer Name list even after you delete their host object. Resetting the scene clears the list.

[controller type] Determines the controller type to assign to each track within the animation layer.

- **Duplicate the Active Controller Type** The new layer’s controller type becomes the same as the one from the active layer, on a per-track basis. For example, if a track in the active layer has a Noise controller, adding a new layer copies that controller type.

- **Use Default Controller Type** When chosen, the new layer’s controller does not take into account the active layer’s controller type and instead uses the original track’s type.

**Limit Controller**

Main toolbar > Curve Editor (Open) > Highlight a track in the Track View hierarchy. > Track View menu bar > Controller menu > Assign > Float Limit

Graph Editors > Track View - Curve Editor > Highlight a track in the Track View hierarchy. > Track View menu bar > Controller menu > Assign > Float Limit

The Limit controller lets you specify upper and lower limits to available controller values, thus restricting the potential value range of the controlled track. For example, in a character rig you could use this to restrict rotation on finger joints so the fingers can’t bend backward. Basically, once a track is limited, and the limit is active, you can’t set a value for the track beyond the limit.

You can apply a Limit controller to any other type of controller; the limited controller (that is, the original controller) then appears as a child of the Limit controller in the Track View hierarchy.

The Limit controller lets you specify upper and lower limits to available controller values, thus restricting the potential value range of the controlled track. For example, in a mechanical assembly you could use this to restrict
rotation on a part so that it doesn't rotate beyond its standard range of motion. Basically, once a track is limited, and the limit is active, you can't set a value for the track beyond the limit. You can apply a Limit controller to any other type of controller; the limited controller (that is, the original controller) then appears as a child of the Limit controller in the Track View hierarchy.

Because the Limit controller doesn't change the original controller, you can easily switch back and forth between the original and the limited animation by toggling the limits. But if you collapse the Limit controller, the result is the limited animation, and the original animation is no longer available.

Use of the Limit controller makes it faster to set up and create animation. It eliminates the need for expressions or scripts to do the same thing, thus improving the ease with which you can set up automation in hierarchies and rigs, creating effects such as avoiding collision, FK joint limits, etc.

For example, a Technical Director might want to assign limits to float values that animators will adjust to make posing easier, enforce standards, or prevent inconsistencies and mistakes. A TD could use limits for:

- light intensity
- finger rotation
- position extents for sliding drawers
- camera field-of-view
- limiting patch resolution to that supported by the game engine

Character riggers can use limits to create complex relationships or shortcuts in rigs. Examples include:

- Wire wrist-twist bones to the rotation of the hand, but limit the rotation of the wrist-twist or hand to stop short of any flipping that might occur.
- Prevent unnatural translation of a spline IK helper by causing limit values for its local position tracks to react to the angle or distance of the helper from surrounding helpers.
- React to when IK is disabled, and match the limits of the solver in FK.
- Limit the position of the IK chain swivel-angle target for the knee so that it can never go behind the character. That is, the target is linked to character's root.
Use Cases

Following is a brief list of examples of specific uses for the Limit controller:

- Select the Y Rotation tracks of all finger bones in a character’s hands and assign a Limit controller. Use Set Key mode to pose the fingers at the extremes of their ranges of motion and then use the right-click menu on page 3495 > Set Upper/Lower Limit commands to limit the fingers’ motion.

  **NOTE** Limits are included for Set Key via the Other category.

- You apply a Noise controller to the X Rotation track of a window shutter object to make it rattle, but the object intersects the building at the lower end of its motion range. Apply a Limit controller to the track and set the Lower Limit value to prevent the intersection.

- Following from the previous example, say the wind tears the window shutter from the building at frame 100. If the Noise controller is in a Float List with a Bezier Float, you can weight the noise to 0 at frame 100, when the shutter is torn from the building by the wind, at which point the animator will key the animation. Limits are unnecessary after frame 100. At frame 99, you’d use Set Lower Limit. Then, at frame 100, you’d edit the Lower Limit value to set the limit to much lower, essentially removing the limit. Finally, you would set keyframes to animate its movement past frame 100.

Limitations of the Limit Controller

It’s important to be aware of the following limitations of Limit controllers:

- Limit controllers do not limit IK joints. All IK solvers use their own limits, and ignore Limit controllers. Interactive IK uses the current controllers, but it also has its own limits, so using Limit controllers with interactive IK will produce unpredictable results.

- The Limit controller currently supports only Float controllers. Thus, the Limit controller is currently available only under the name Float Limit.

- Upper and lower limits values are expressed in the same units or coordinates as those used by the limited controller. Thus, for example, Float limits on an X Position track are in local coordinates, not in global coordinates.
Procedures

Example: To use the Limit controller:

1. Start with an animated object, and open Curve Editor.
   In this example, the teapot position was animated on the X axis between extents of about –45 to 40, and on the Y axis between extents of about –80 and 54.

2. Assign the Float Limit controller to a track. In this example, we'll assign it to the X Position track.
   This opens the Float Limit Controller dialog, where you can set limits and other values, but you might find it easier to do this interactively, so for now just accept the defaults by closing the dialog.
   The track retains its original name (X Position, in this example), but the icon has changed to indicate that it's now a Limit controller, and is expandable (see illustration in following step).

3. Expand the track.
The hierarchy contains a child track, named Limited Controller, and a new, expandable child branch named Limits.

4 Click the X Position track and then the Limited Controller track to compare them.

Because the original X-axis movement falls within the default limits, the two tracks are identical.

5 Scrub the animation until the X-axis position is where you want to set a limit. In this example, the position is about -20, where we'll set a lower limit.

6 Highlight the X Position track, and then right-click and from the right-click menu choose Limit Controller > Set Lower Limit.
The graph curve is now clipped below the lower limit. When you scrub the animation, the object doesn't move beyond that position.

7 Again scrub the animation, stop where you want to set the upper limit, right-click the X Position track, and choose Limit Controller > Set Upper Limit.
In this example, we've set it at about 13. The graph curve is now clipped above the upper limit and below the lower limit. The resulting motion is likewise constrained.

8  Scrub the animation.
   The motion on the X axis is limited at both extremes; wherever the object originally moved beyond the limits, it now behaves as though it's hitting a wall.

9  Again compare the two tracks.
   The Limit Controller (X Position) track clearly shows the upper and lower clipping, while the Limited Controller track shows the original motion.
   The original motion still exists as the Limited Controller track; you can restore it temporarily by toggling the Limit controller.

10 Highlight the X Position track, and then right-click and choose Limit Controller > Toggle Limit.
   Now, when you scrub the animation, the object moves as before.

11 Choose Limit Controller > Toggle Limit again to restore the limits
   You can copy the Limit controller in two ways: the limits only, or the limits and motion combined. First, you'll copy the limits only.

12 Highlight the Y Position track and note how its curve differs from that of the X Position track.

13 Highlight the X Position track, and then right-click and choose Limit Controller > Copy Limit Only.
14 Highlight the Y Position track, and then right-click and choose Limit Controller > Paste Limit Only. When the Paste dialog opens, click OK to confirm the paste as a copy.

Now the Y Position track is also limited, using the same extents as the X Position track, but retaining its original underlying motion. To verify this, compare the Y Position track with its child Limited Controller track.

Next, you'll copy the entire limited X Position track to the Z Position track, including motion and limits. The Z Position track currently is not animated.

15 Highlight the X Position track, and then right-click and choose Copy.

16 Highlight the Z Position track, and then right-click and choose Paste. Compare the X and Z Position tracks and both their child Limited Controller tracks. Each corresponding pair of curves is identical. The motion appears as though the object is hitting the inside edge of a box.

Finally, we'll cover the Smoothing Buffer settings. By default, sharp corners are created wherever a curve is limited, causing abrupt changes in motion. You can smooth off these corners with the Smoothing Buffer parameters, resulting in more natural-looking motion.

17 Highlight the X Position track, and then right-click it and choose Properties. This reopens the Float Limit Controller dialog.

18 Use the Upper Limit group > Smoothing Buffer spinner to increase the Smoothing Buffer value as far as it can go. As you increase the value, the corners of the upper limit on the graph become smoother.
Note that there's an upper limit to this value; in this case, it's 34.973. This limit is determined by the values of the other three settings on the dialog.

19 Try increasing the Lower Limit group > Smoothing Buffer. It's not possible with the upper smoothing value at its maximum.

20 Decrease the upper smoothing value, and then increase the lower smoothing value.

Now you get smoothing at both the upper and lower limits.

**Interface**

The Limit Controller interface comprises the Float Limit Controller dialog and several-right-click menu items.
Float Limit Controller dialog

The Float Limit Controller dialog opens when you first assign the Limit controller, or when you right-click a highlighted Limit-controller track and choose Properties.

**Enable** Toggles the Limit controller. When off, the original values of the limited track are in effect. When on, the original values are limited by the Upper Limit and Lower Limit values.

**NOTE** You can enable and disable all Limit controllers in the scene simultaneously with the Toggle Limits command, available from the 3ds Max Animation menu. If some Limit controllers are on and the rest are off, Toggle Limits turns them all on.

**Upper Limit Group**

**Enable** Toggles the upper limit set by the controller. When off, no upper limit is imposed. Default=on.

**[Upper Limit value]** The highest value permitted by the Limit controller. Any values above this value in the original controller are clipped; that is, they're set to this value, unless smoothing is in effect. Default=1000.0.

You can animate this value via keyframing and other standard methods, and manipulate this animation in Track View via the Upper Limit track in the controller's Limits branch.
**Smoothing Buffer** Specifies a smoothing value, so that clipped values at the beginning and end of a clipped range gradually increase and decrease instead of leveling off abruptly.

The maximum total smoothing is determined by the Upper and Lower Limit values. (Upper Limit > Smoothing Buffer value) + (Lower Limit > Smoothing Buffer value) cannot exceed this total. For the smoothest possible results at the upper and lower extents of the clipping, set either Smoothing Buffer value to the maximum amount, and then back it off to half that value and set the other Smoothing Buffer to the same amount.

You can animate the Smoothing Buffer value via keyframing and other standard methods, and manipulate this animation in Track View via the Upper Smoothing track in the controller's Limits branch.

**Lower Limit Group**

**Enable** Toggles the lower limit set by the controller. When off, no lower limit is imposed. Default=on.

**[Lower Limit value]** The lowest value permitted by the Limit controller. Any values below this value in the original controller are clipped; that is, they're set to this value, unless smoothing is in effect. Default= -1000.0.

You can animate this value via keyframing and other standard methods, and manipulate this animation in Track View via the Lower Limit track in the controller's Limits branch.

**Smoothing Buffer** Specifies a smoothing value, so that clipped values at the beginning and end of a clipped range gradually decrease and increase instead of leveling off abruptly.

The maximum total smoothing is determined by the Upper and Lower Limit values. (Upper Limit > Smoothing Buffer value) + (Lower Limit > Smoothing Buffer value) cannot exceed this total. For the smoothest possible results at the upper and lower extents of the clipping, set either Smoothing Buffer value to the maximum amount, and then back it off to half that value and set the other Smoothing Buffer to the same amount.

You can animate the Smoothing Buffer value via keyframing and other standard methods, and manipulate this animation in Track View via the Lower Smoothing track in the controller's Limits branch.
Limit Controller right-click menu

To access the Limit Controller right-click menu, highlight a Limit Controller track in the Track View hierarchy, and then right-click the track and move the cursor to the Controllers quadrant > Limit Controller menu item.

**NOTE** After using Copy Limit Only on a Limit controller track, you can apply a new Limit controller with the same limits to any track by invoking Paste Limit Only.

---

**Toggle Limit** Turns the Limit controller on and off. This is the same as the *Enable check box* on page 3493 on the Float Limit Controller dialog.

**Set Upper Limit** Sets a value/key in the Upper Limit track at the current frame equal to the value at the current frame of the limited track. If there is only one key, the value of the limit is constant over time.
Set Lower Limit  Sets a value/key in the Lower Limit track at the current frame equal to the value at the current frame of the limited track. If there is only one key, the value of the limit is constant over time.

Remove Limit  Deletes the Limit controller, restoring the original controller without limits.

Copy Limit Only  Copies only the Limit values and ignores the limited controller of the highlighted track.

Paste Limit Only  Applies only the copied Limit values, or adds a Limit controller with the copied values if one doesn't exist, while retaining the values of the original limited track.

As with pasting copied controller tracks, you can paste the Limit values as a copy or an instance of the copied Limit controller, with the option to replace all instances of the paste target.

**Linear Controller**

Main toolbar > Curve Editor (Open) > Select a track in the Track View hierarchy. > Track View menu bar > Controller menu > Assign > Linear

Graph Editors > Track View – Curve Editor > Select a track in the Track View hierarchy. > Track View toolbar > Controller menu > Assign > Linear

Animation menu > Position, Rotation or Scale controllers > Linear

The Linear controller interpolates between animation keys by evenly dividing the change from one key value to the next by the amount of time between the keys.

Linear controllers do not display a properties dialog. The only information stored in a linear key are the time and animation values.

Use Linear controllers whenever you want a very regular, even transition from one key to the next. For example, use a Linear controller for:

- A color parameter to change from one color to another at a constant rate of change.
- Transforms to produce mechanical, robot-like motion.
Procedures

**To assign a Linear controller:**

1. Select an animated object.

2. In the Motion panel > Parameters > Assign Controller rollout, select the Position track in the list window.

3. Click Assign Controller, and then select Linear Position in the Assign Controller dialog.
   The animated object has a mechanical motion.
   You can also assign this controller in Track View.

Interface

No Properties dialog is available for Linear controllers. You can, however, move keys in Track View to change the animation.

**Time** Change linear key time. Move keys horizontally in Track View Edit Keys or Function Curves mode.

**Value** Change linear animation values by moving keys vertically in Track View Function Curves mode, change the parameter value in the viewport with Auto Key on.

List Controller

Main toolbar > Curve Editor (Open) > Select a track in the Track View hierarchy. > Track View menu bar > Controller menu > Assign > List

Graph Editors > Track View – Curve Editor > Select a track in the Track View hierarchy. > Track View toolbar > Controller menu > Assign > List

Select an object in the viewport > Motion panel > Assign Controller rollout > Highlight either Position, Rotation or Scale controller > Assign Controller button > choose Position List, Rotation List or Scale List.

The List controller combines multiple controllers into a single effect. It is a compound controller with tools for managing how its component controllers are calculated. Controllers are evaluated in top-to-bottom order. In addition,
you can specify a Weight setting for each controller in the list to determine its relative influence.

When you assign a List controller to a parameter, the current controller is moved one level below the List controller; it becomes the first controller in the list. A second parameter, named Available, is added below the List controller. This is an empty placeholder for the next controller you add to the list.

By default, each listed controller's Weight setting is set to 100.0. This setting can be changed to increase or decrease the effect the controller has on an object.

When you assign a controller using the Animation menu, a list controller is automatically assigned as a default, with the chosen controller placed first in the list. This behavior differs from when you assign a controller in the Motion Panel or Track View, where only the specified controller is assigned.

You can animate List controller weights to achieve the equivalent of a non-linear animation system. Each list controller track can hold different values from frame to frame that you can turn on or off, or blend between by animating the weights.

**Wired and Expression-based Animation**

The List controller is particularly useful when employing parameter wiring or expressions to animate members of a hierarchy. If an object has only one controller, animating it (or the first controller in a list) via wiring or an expression always uses the parent object’s coordinate system, which, if the object has no parent, is the World coordinate system. However, most such situations call for animation in the object’s Local coordinate system. The latter requires wiring to (or using an Expression controller as) the second controller in a controller list.
TIP You can use the Freeze Transform on page 8060 command to apply a List controller to multiple objects simultaneously, which is not possible with the standard Assign Controller feature. “Freezing” an object’s transform creates a two-controller list of which the second controller is the default for its transform, so it then becomes easy to wire to the second controller.

Procedures

Example: To use the List controller to combine two controllers:

1. Create a box, and then turn on Auto Key on page 8090.
2. Create a simple animation containing three position keys.
3. On the Motion panel > Parameters > Assign Controller rollout, click the position track to highlight it.
4. Click Assign Controller.
5. Click Position List on the Assign Position Controller dialog. Click OK.
6. Click the plus sign in the Position track to expand the track.
   A Position XYZ track and a track labeled Available are now visible.
7. Click the track named Available and then click the Assign Controller button.
8. Choose Noise Position in the Assign Controller dialog, and then click OK.
   The Noise Controller dialog opens.
9. Play the animation.
   The box follows the original animated path while vibrating randomly.
   Experiment with different Weight settings for each controller and see the results.
Interface

Motion panel > Parameters > List rollout

List Window Displays all the controllers in a list, with evaluation order from top to bottom. The controller at the top of the list is evaluated first; lower controllers are layered onto the result of higher controllers.

Set Active Determines which controller is affected by interactive changes in the viewport. The current active controller is marked with an arrow in the list.

For example, you have an object using a Position List, with Noise Position and Bezier Position in the list. The Bezier Position controller handles the general motion path of the object, while the Noise Position controller adds a random shake to the motion.

- If Bezier Position is the active controller, you can freely move the object in the scene.
- If Noise Position is the active controller, you cannot move the object because Noise is not an interactive controller.

Delete Deletes the selected controller.

Cut Removes the selected controller and stores it in a temporary clipboard. The clipboard contents are only held until you paste the controller, close the List Controller dialog, or exit the Motion panel.
**Paste** Puts the contents of the controller clipboard in the position above the selected controller. The clipboard is empty after pasting.

**Weight** Exaggerate or minimize the effects of a controller by increasing or decreasing its weight value. Default=100.0.

**Average Weights** When on, the weight values of all the controllers in the list are averaged. Available only for the Position List and Scale List controllers. Default=off.

**Pose to Pose** Enables blending among controllers in the list. Available only for the Rotation List controller. Default=off.

When off, the List controller weights each rotation individually and adds up the weighted rotations for the final effect. You animate by stacking layers on top of layers, and then weighting in and out their effect. This is the default behavior.

When on, each pose is blended with the results from the previous controllers in the list. This method is not additive, but is instead true pose-to-pose blending. Adjusting the weight of a controller in the list will blend to and from that pose (controller in list). If the last weight is 100.0, then adjusting the weights of the previous poses in the list won’t have any effect because the last pose has full effect. This is a stack-based approach that is best used for nonlinear animation (NLA) effects. You can paste motion clips or even single-frame poses onto new layers and use the weights to blend the poses together.

**Editable Name Field** Select one of the controllers in the list window of the Controller list, and then enter a descriptive name in this field. This field lets you rename the controller so it's easier to identify.

### Local Euler XYZ Rotation Controller

**This controller is no longer available. You can, however, still edit objects that were assigned this controller in previous versions.**

The Local Euler Rotation controller is similar to the Euler XYZ Rotation controller on page 3453, but the angles are with respect to the rotated object’s local coordinate system. With the standard Euler Rotation controller, angles are with respect to parent coordinates. Parameters for this controller are displayed in the Motion panel.

The Local Euler XYZ Rotation controller has three rotation tracks to control rotation on the X, Y, and Z axes. Setting an X axis rotation key will not create
keys in the Y and Z tracks on the same frame; each track can be keyed independently. The rotation order of the axes is set in the Motion panel.

**Interface**

The Local Euler parameters are displayed in the Motion panel.

**Euler Parameters rollout**

This rollout is displayed when you select Rotation in the PRS Parameters rollout on page 3526.

```
- Euler Parameters:
  - Axis Order: XYZ
  - Rotation Axis: X Y Z
```

**Axis Order** Sets the order that rotations are calculated in the list. The default is X,Y,Z order, where the X axis is rotated first.

**X** Displays controller properties for X axis rotation angle.

**Y** Displays controller properties for Y axis rotation angle.

**Z** Displays controller properties for Z axis rotation angle.

Each axis uses its own independent controller using the float data type. For example, the X and Y rotation axes could use Bezier Float controllers, while the Z Rotation axis uses a Noise Float controller.

**Look At Controller**

Create or select an object that contains a Target component, such as a target spotlight or camera. > Motion panel > Look At Parameters rollout

The Look At controller is automatically assigned as a transform animation controller upon creation of objects that contain targets, including Target Camera, targeted lights (including IES Sun/Sky) and the Tape helper. It cannot be assigned by the user. To assign the equivalent of a Look At controller to an object, use a LookAt constraint on page 3585.

**NOTE** A targeted object’s pitch and heading are adjusted by moving the target, so the only orientation setting that can be controlled directly by the user is Roll, or bank.
Example: To prevent flipping of targeted objects during rotation:

1. Add a **Target Camera object** on page 5556.
2. Activate the Move tool and use the **coordinate display** on page 8081 to position the camera and target at **0,0,0** and **80,0,0**, respectively.
3. Add a **Dummy object** on page 2840 and position it at **0,0,0**.
4. Use Select And Link to link the camera to the dummy, and then link the camera target to the dummy. At this point, the dummy is parent to both the camera and its target.
5. Rotate the dummy about its Y axis, and watch the camera. As the target passes through the zenith and nadir of its orbit, the camera flips.
6. Select the camera and go to the Motion panel. On the Look At Parameters rollout, turn on **Use Target As Up Node**.
7. Again rotate the dummy about its Y axis. The camera no longer flips.
Interface

After you create or select an object that contains a Target component, you can access the object’s Look At properties on the Motion panel. In this rollout you can change the target, create and delete animation keys, set the axis, and adjust other, related parameters.

Create Key Sets a position, roll (orientation), or scale key at the current frame, depending on which button you click.

Delete Key Deletes a position, roll (orientation), or scale key at the current frame, depending on which button you click.

Pick Target Lets you set a target other than the default Target object. Click this button, and then select the new object to use as a target.

Thereafter, the new target controls the object’s orientation. The original target remains in the scene, and can be deleted or used as a Dummy helper.
Axis Specifies the local axis that looks at the target. The Flip check box is used to flip the directions of the axis.

Use Target as Up Node When turned on, the controller forces the object on which it acts (source node) to keep one of its local axes aligned with the look-at direction (the vector between the source node and the target node). It also prevents the source node from rotating around the look-at direction, to avoid flipping about the object's local Z axis.

The flipping behavior is most commonly seen when the line between a targeted object and its target is close to vertical; that is, their positions on the World Z axis are nearly the same.

The option works by aligning one of the source node's local axes with one of the target node's local axes. These axes are picked automatically by 3ds Max.

NOTE This feature lets you properly manipulate Luminaire assemblies. It also provides for trouble-free operation when you i-drop on page 7644 manufacturer luminaire assemblies.

TIP In some cases, the object will flip 90 or 180 degrees even when the Use Target As Up Node option is turned on. This behavior occurs due to the fact that the axis alignment is automatic. To resolve this, apply a roll angle to the object with the coordinate display.

Position/Roll/Scale These three buttons let you specify the other rollouts that appear for this controller. In all three cases, the Key Info (Basic) on page 3418 and Key Info (Advanced) on page 3422 rollouts appear. When Position is active, an additional Position XYZ Parameters rollout lets you specify the position axis.

Master Point Controller

Main toolbar > Curve Editor (Open) > Expand tracks on an object with animated vertices or vectors in the Track View hierarchy. > Master Point Controller

Graph Editors > Track View – Curve Editor > Open Track View > Expand tracks on an object with animated vertices or vectors in the Track View hierarchy. > Master Point Controller

The Master Point controller controls point sub-objects within editable splines, editable surfaces, and FFD (free-form deformation) modifiers.
The Master Point controller is assigned automatically whenever control points, vertices, or vectors (tangent handles) are animated in the sub-object mode of an Editable Spline, Editable Patch, Editable Mesh, Editable Poly, NURBS surface, or FFD (Free-Form Deformation). By allowing you to select and move all the sub keys, visually correlate keys to points in the viewports, and change key properties quickly, this controller helps to manage the numerous tracks created when animating vertices, control points, and vectors.

The Master Point controller is displayed as a track with green keys in Track View. Sub tracks below the Master track contain all the animated vertices, control points, and vectors.

**Procedures**

**Example: To animate vertices, viewing the Master Point controller track:**

1. In the Front viewport, create a sphere.
2. Right-click the sphere and select Convert to Editable Mesh in the dialog.
3. On the Editable Mesh > Selection rollout, click Vertex.
5. Turn on Auto Key, and move the time slider to frame 10.
6. In the viewports, select and move some vertices on the sphere. A key appears on the track bar at frame 10.
7. Right-click the sphere, and select Curve Editor in the dialog. Track View — Curve Editor is displayed with the sphere at the top of the Controller window.
8. Change modes to Dope Sheet and expand all the sphere tracks in the Track View hierarchy. The Master Point Controller track is displayed, with tracks for the animated vertices below it.
Interface

Master Track Keys

While in the Track View – Dope Sheet, selecting a master key (green) selects all the sub keys at that frame.

If hundreds of vertices are animated, collapse the master track so that only the master track is visible. Moving the green keys will move all the sub keys.

Master Track Key Info dialog

Right-click a green master key in Track View to display the Master Track Key Info dialog on page 3507.

Master Track Key Info Dialog (Master Point Controller)

Track View - Dope Sheet > Right-click a master track key in the Dope Sheet Key window. > Master Track Key Info dialog

With Track View in Dope Sheet mode, right-click a green master key of a Master Point controller on page 3505 to open the Master Track Key Info dialog.
Interface

[key arrows] Moves to the next or previous key.

Time Moves the master key to a different frame or time.

Sub Keys list window Displays all the animated sub-object keys at a particular frame or time.

Select Point Select a node in the List Window and the corresponding node in the viewports is selected, if the corresponding sub-object level is active.
Key Frame Properties Displays and lets you adjust interpolation and position. See Bezier Controller on page 3432.

Motion Capture Controller

Main toolbar > Curve Editor (Open) > Select a track in the Track View hierarchy. > Track View toolbar > Controller menu > Assign > Motion Capture

Graph Editors > Track View – Curve Editor > Select a track in the Track View hierarchy. > Track View menu bar > Controller menu > Assign > Motion Capture

You can control an object’s position, rotation, or other parameters using an external device with the Motion Capture controller.

NOTE Rotation Motion Capture uses Euler rotations with an X, Y, Z axis order and is subject to the limitations of Euler rotations. See Euler XYZ Rotation Controller on page 3453.

The Motion Capture System

To use motion capture in 3ds Max, you follow these steps:

1. In Track View — Dope Sheet or the Motion panel, you assign motion capture animation controllers to the specific tracks you want controlled by external devices.

2. After assigning the motion capture controller, you open the Properties dialog for the track and bind the type of peripheral device(s) that you want. Currently supported devices are mouse, keyboard, MIDI device, and joystick. Each device has specific properties.
3 After binding the devices, adjust their settings and parameters in the lower portion of the Track Properties dialog. These controls vary depending on the type of device.

4 In the Utilities panel, access the Motion Capture utility. You can test and record your motion for any combination of tracks over any range of frames.

5 When you assign a Motion Capture controller, the previously assigned controller is maintained as a child of the Rotation controller. You can continue to adjust the rotation of the object using standard transform controls, while still making motion-capture control available.

Procedures

To use your mouse as an input device to animate the position of a box:

1 Create a box.

2 In Motion panel > Assign Controller, select the position track for the box in the list window, and then click the Assign Controller.

3 Select Position Motion Capture in the Assign Position Controller dialog, and then click OK.

4 Select X Position in the Motion Capture dialog, select mouse input device, and then click OK.

NOTE You can open the Motion Capture dialog by selecting the Position track in the Assign Controller list window, and then right-click and select Properties.

5 In the Mouse Input Device rollout, make sure that horizontal is turned on and Scale is set to 1.

6 In Utilities panel > Motion Capture, click Box01 > Position in the Track list window. Click Start in the Record Controls group. Real-time recording is in effect; move the mouse horizontally back and forth. The box moves back and forth along the X axis. Play the animation to view the recorded movement. By default, a key is generated at every frame.
Interface

Right-click the transform track in the Track View - Dope Sheet hierarchy to display the Motion Capture Properties dialog.

Position Motion Capture rollout

X, Y, Z Position Click an axis’s button to display a Choose Device dialog, which lets you pick a motion-capture device from a list of alternatives: keyboard, joystick, mouse, or MIDI.

Choose Device dialog Select a device from a list of devices.

Edit Bindings XYZ Displays device controls in the device rollout in the lower part of the Motion Capture dialog. If no device has been assigned to an axis, this option is not available.

Track Name Names the Motion Capture Data track. This overrides the default naming convention.

Mouse Input Device rollout

This rollout controls animation using the horizontal or vertical motion of the mouse. The available settings include:

Horizontal/Vertical Specifies which mouse motion drives the animation.
Scale Scales the relative effect of the mouse movement to the animation response. Spinner Value=float, 0 to 999,999

Flip Flips the direction of the response relative to the mouse movement. For example, if moving the mouse horizontally to the right produces a clockwise effect on a Rotation controller, activating Flip will reverse the rotation to counterclockwise.

Keyboard Input Device rollout

This rollout lets you assign most keyboard keys to drive the animation.

Assign Click and then press any key. The assigned key is displayed in the list window at right.

List Open the list to select a key.

Envelope Graph group

The Envelope Graph group displays a representation of the amplitude curve over time.
**Envelope Parameters group**

These options specify the time the envelope of the action takes effect. This relates to the duration of pressing and releasing the key.

**Attack** Specifies the time, after pressing the key, for the value to reach its maximum level.

**Decay** Specifies the time, after having reached maximum, for the value to fall to that specified by the Sustain spinner.

**Sustain** After the Attack and Decay, specifies the value sustained until you release the key.

**Release** After releasing the key, specifies the time for the value to fade out to zero.

**Parameter Scaling group**

Provides controls for setting the scale of the envelope and the range of the output value.

**Time** Specifies the scale of the Attack, Decay, and Release parameters. The value represents the number of seconds for 1 unit. For example, if this value is 1.0, then an Attack value of 1.0 equals 1 second.

**Range** Sets the maximum output value of the controller.

**NOTE** This controller ignores the state of the Ctrl, Alt, and Shift keys.

**Joystick Input Device rollout**

The Joystick Input Device driver was designed for the Microsoft Sidewinder joystick, which contains more controls than the standard joystick. You can use this device driver for standard joysticks as well.

![Joystick Input Device](image)

X, Y, Z Specifies which joystick direction drives the animation. (Standard joysticks provide X and Y axes only. The Sidewinder provides the Z axis when you twist the joystick.)
Throttle On the Sidewinder, this is a slider next to the stick.

Scale Scales the relative effect of the joystick action to the animation response. Spinner Value=float, 0 to 999,999

Flip Flips the direction of the response.

Accumulate When off, the joystick position represents an absolute position, and you’re limited to the "rectangle" defined by the limits of the joystick. When the joystick returns to its rest position, the value generated returns to zero. When on, the joystick represents a change in the current position. Moving the joystick forward, for example, can cause an object to start moving, and it will continue to move until you return the joystick to its rest position.

Joystick Buttons group

Point-of-View Hat (Left-Right, Up-Down) A mini joystick on the tip of the main joystick that specifies the direction of the animation.

1, 2, 3, 4 Specifies one of four buttons in the Sidewinder joystick. They work similarly to the Point-of-View Hat, except that each button increases a direction value only while pressed. When you release the button, the value returns to zero (centered).

Inc./Dec One of three options that are only available when one of the numbered joystick button options is turned on. This option (Increment/Decrement) means that the value is incremented when the button is down, and decremented when the button is up.

Inc When on, the value increments when the button is down, and stays at that value when the button is released.

Absolute When on, the assigned parameters jumps to the value set in the Speed spinner when the button is down, and then jumps back to zero when the button is released. Use this for on/off animations, such as blinking lights.
Speed  Controls the rate at which the value changes when using either the Point-of-View Hat or the four buttons. When using a button option and the Absolute option, this specifies the value that's output when the button is pressed. Spinner Value=float, -999,999 to 999,999

Increment Based On Direction group

This group provides controls that let you derive the direction of movement from a Rotation controller. These options are used primarily when you're animating a first-person flythrough such as when you're controlling a camera.

NOTE  The items in this group are only available when Accumulate is selected in the Joystick Axis group.

Controller  Assigns a Rotation Motion Capture controller where the direction will be derived. Typically, this would be the Rotation controller of the camera you're moving.

NOTE  You can only use a Rotation Motion Capture controller here.

Clear  Removes the assigned controller.

Direction X/Y/Z  Specifies the local axis that will be used as the direction. For a Free Camera, for example, this would be Z, because the camera points in the Z direction. However, if you had a car that pointed along its Y axis, you'd use Y.

Component X/Y/Z  Specifies which edit binding to use. Match this to the Edit Binding button in the Device Bindings group. For example, if the Y Edit Binding button is selected, choose the Y Component option.
MIDI Device rollout

MIDI Channel group

This group contains 16 buttons. You can assign a channel to your MIDI device.

MIDI Trigger group

Here, you define the type of MIDI event (message) that will drive the motion. There are four options; Note, Velocity, Pitch Bend and MIDI controller.
NOTE Turn on to let the note number or pitch define the output value. The value is derived from where the note falls within the Note Range, specified in the group below. When the note is at the bottom of the range, the value takes on the Min value specified in the Parameter Scaling group. When the note is at the top of the range, the value takes on the Max value from the same group. Anything in between is interpolated between the Min and Max values. (Note that Min doesn't have to be less than Max.) The generated value will slide around as different keys are pressed. The harder a key is pressed, the faster the value changes.

**Speed** Defines how fast the value changes as keys are pressed.

**Velocity** Determines the output value based on the velocity that the note pressed. The notes set in the Note Range group specify which notes are valid to press. The value takes on the Min value until a key within the Note Range is pressed. When the key is pressed, the value approaches the Max value based on how hard the key was pressed. (The value actually travels along a parabola toward the Max value.)

**Sustain** Defines how long it takes the value to move through the parabola.

**Variable** Sustain duration is scaled by how hard the key is pressed.

**Pitch Bend** Value is defined by the MIDI instrument's pitch bend knob. The Note Range doesn't apply in this case and is not available.

**MIDI Controller** Specifies a note event when you're hooked up to a different type of MIDI controller than the typical keyboard. For example, if you're using a MIDI slider box, you would select the MIDI Controller option, and then use the # spinner to specify the note event for the specify slider.

**Note Range group**

Turn on Note or Velocity, and then set the note range here. A value is derived from where the note falls within the Note Range.

**Low Note** Set a note and octave for the lower range.

**High Note** Set a note and octave for the higher range.

See **Note** parameter in the MIDI Trigger group, above.

**Parameter Scaling group**

Contains the Min and Max spinners, which specify the range of generated values. See Note and Velocity above.
**MIDI Channel Viewer** Displays a dialog that lets you test your MIDI device to see which MIDI channel is receiving events and which notes are being triggered.

**Midi Viewer Dialog**

![MIDI Viewer Dialog](image)

**MIDI Channel group**

Provides a column of 16 buttons and progress bars representing the 16 MIDI channels. Select the channel where you want to view note activity. The channel progress bars light up when any channel has an event.
**MIDI Note group**

The 11 Octave buttons let you select which octave you want to view. When a note is played in that octave, a corresponding progress bar lights up in the Note column.

**MIDI Controller** When using a different type of MIDI controller, such as a slider box, you can specify a note event, and then watch the corresponding progress bar light up when you activate that event. (You can find the correct note number by activating the event while watching the Note Number field in the group below.)

**Channel** Displays the currently selected channel. This is one of four text fields that display all of the values being generated by the MIDI device as you activate an event.

**Event** Displays the type of MIDI event being sent. For example:
- Note On: 9
- Note Off: 8
- Pitch Bend: 14
- MIDI Controller: 11

**Velocity** Displays the velocity, which has a different meaning depending on the event. For the most common event, a note being pressed, this value represents the velocity at which the key was struck. Other events, however, might generate a continuous value. For example, a pitch bend event transmits the position of the pitch bend.

**Note Number** Displays the corresponding note number for the event. When you're using a non keyboard MIDI device, such as a slider box, you can use this to identify the note number of a specific slider.

---

**Noise Controller**

Main toolbar > Curve Editor (Open) > Select a track in the Track View hierarchy. > Track View menu bar > Controller menu > Assign > Noise

Graph Editors > Track View – Curve Editor > Select a track in the Track View hierarchy. > Track View menu bar > Controller menu > Assign > Noise

The Noise controller produces random, fractal-based animation over a range of frames. Noise controllers are parametric: they work on a range of frames, but do not use keys.
When you assign a Noise controller in Track View or the Motion panel, it is initially applied to all frames in the current time segment. You can change the range of frames by dragging the Noise range bar in Track View.

- Use Noise whenever you need completely random animation around a given value. For example, use a Noise Rotation controller when you want an object to wobble in place.

- Use Noise as part of a compound List controller to apply noise variations to the result of another controller. For example, use a List controller to combine Noise Position with Bezier Position. The Bezier controller moves the object through your scene while the Noise controller makes the object shake and stray a little from the path.

**Procedures**

**Example: To apply a Noise controller to a rotation track:**

1. Create a box in any viewport.
2. In the Motion panel > Parameters > Assign Controller rollout, select the rotation track in the list window.
3. Click Assign Controller.
4. Select Noise rotation from the list of controllers. The Noise Controller dialog automatically opens.
5. Play the animation. The box rotates randomly around all three axes. Because the non-modal Noise Controller dialog is still open, you can adjust parameters and see the results in real time.
Interface

Characteristic Graph

Shows a stylized graph of how changing Noise properties affects the Noise curve.

Seed

Starts the noise calculations. Changing the seed creates a new curve.

Frequency

Controls the peaks and valleys of the noise curve. The useful range is from 0.01 to 1.0. High values create jagged, heavily oscillating noise curves. Low values create soft, gentle noise curves.

Strength fields

Sets the value range for noise output. These values can be animated.

The number and meaning of the fields vary with different parameter data types. Some typical field arrangements are:

- XYZ fields for Position and Point3 keys
- XYZ percentage fields for Scale keys
- A single value field for Float keys

>0 Value constraint

Forces Noise values to stay positive. Each strength field has its own >0 constraint.

When on, the application of the Strength field is changed. Noise values will range from 0 to the value of Strength; most values will hover around Strength/2.
Ramp In Sets the amount of time Noise takes to build to its full strength. A value of 0 causes Noise to start immediately at full strength at the start of its range. Any other value causes Noise to start at 0 strength and then build to full strength by the elapsed time set in the Ramp In field.

Ramp Out Sets the amount of time Noise takes to fall to 0 strength. A value of 0 causes Noise to stop immediately at the end of its range. Any other value causes Noise to fall off to 0 strength by the end of its range. The value in the Ramp Out field sets the amount of time before the end of the range that Noise begins to fall off.

Fractal Noise Generates noise using a fractal Brownian motion. The main value of using Fractal Noise is that it activates the Roughness field.

Roughness Changes the roughness of the Noise curve (when Fractal Noise is turned on). Where Frequency sets the smoothness of the overall Noise effect, Roughness changes the smoothness of the Noise curve itself.

On/Off Controller

Main toolbar > Curve Editor (Open) > Select a track in the Track View hierarchy. > Track View menu bar > Controller menu > Assign > On/Off

Graph Editors > Track View > Curve Editor > Select a track in the Track View hierarchy. > Track View menu bar > Controller menu > Assign > On/Off

The On/Off controller provides binary on and off control. It is similar to the Boolean controller on page 3449. For example, you can apply an On/Off controller to the Visibility track of an object.
You can view the curve for this controller in the Function Curve display, but it's not editable. In addition, there's no Properties dialog for this controller.

**NOTE** When you load a scene from version 1.x of 3ds Max that contains a Visibility controller, the controller is automatically converted to an On/Off controller.

**See also:**
- **Boolean Controller** on page 3449

**Procedures**

**Example: To use the On/Off controller to control an object's visibility:**

1. Create a cylinder, and open Track View.
2. In Track View, select the Cylinder track and click Tracks > Visibility Track > Add.
   A Visibility and Transform track are now added.
3. Select the track named Visibility.
4. From the Track View toolbar > Controller menu > Assign and select On/Off in the Assign Controller dialog. Click OK.
   If you change modes to Dope Sheet, note that the entire track region is filled by a blue bar.
5. Click the Add Keys button in Track View — Dope Sheet and add a key at frame 20.
   The blue bar stops at frame 20.
6. Add another key at frame 60.
   The track is now blue again following frame 60.
7. Add some additional keys in the Visibility Track. Each added key reverses the on/off blue pattern following the added key.

**TIP** You can select two or more keys and copy them to different positions. This allows you to create even intervals for the On/Off effect.

**Interface**

You assign the On/Off Controller in Track View.
The On/Off track displays a solid blue color in frames that are On, and no blue in frames that are Off. When you add a key to an On section of the track, the section following that key is turned off. When you add a key to an Off section, the following section is turned on and colored blue.

**Position XYZ Controller**

Main toolbar > Curve Editor (Open) > Select a position track in the Track View hierarchy. > Track View menu bar > Controller menu > Assign > Position XYZ

The Position XYZ controller splits the X, Y, and Z components into three separate tracks (similarly to the Euler XYZ Rotation controller on page 3453). This provides separate control of the three tracks when referenced from Expression controllers.

The Position XYZ controller assigns three keys (one for each axis), by default. In earlier versions of 3ds Max, you had to edit the keys manually in order to create explicit axis keys. However, there are now actions available from the Customize User Interface dialog on page 8249 that let you create explicit axis keys using Set Key Mode on page 3376.

**Procedures**

**Example: To use the Position XYZ and Noise controller together:**

1. Create a sphere.

2. In the Motion panel > Parameters > Assign Controller rollout, select the Position track of the sphere.
3 Click Assign Controller and choose Position XYZ.

4 Turn on Auto Key and create three keys that move the sphere on the XY plane.

5 In the Assign Controller rollout, expand the position track and select Z Position.

6 Click Assign Controller, and then select Noise Float.

7 Play the animation. The sphere moves around the keys that were created earlier. The random up and down movement in the Z axis is generated by the noise controller on the Z track.

This effect can also be created using the List Controller to combine controllers.

Interface

Motion panel > Parameters > Position XYZ Parameters rollout

<table>
<thead>
<tr>
<th>Position XYZ Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position Axis: X, Y, Z</td>
</tr>
</tbody>
</table>

X Displays controller properties for X axis transformation.

Y Displays controller properties for Y axis transformation.

Z Displays controller properties for Z axis transformation.

When you select an axis, a Key Info (Basic) and Key Info (Advanced) rollout is available to change values.

A Bezier Float Controller is assigned to each track by default. Use Key Info (Basic) and Key Info (Advanced) to control how the keys behave. See Bezier Controller on page 3432.
PRS Controller

Main toolbar > Curve Editor (Open) > Select a transform track in the Track View hierarchy. > Track View menu bar > Controller menu > Assign > Position/Rotation/Scale

Graph Editors > Track View – Curve Editor > Select a transform track in the Track View hierarchy. > Track View menu bar > Controller menu > Assign > Position/Rotation/Scale

The Position/Rotation/Scale (PRS) controller is the default Transform controller for most objects. Use it for all general-purpose transforms.

Procedures

To create PRS Transform keys:

1. Select an object.

2. Click Motion panel > Parameters.

3. Drag the time slider to the frame where you want to place a key.

4. On the PRS Parameters rollout, in the Create Key group, click one of the following:
   - Click Position to create a Position key.
   - Click Rotation to create a Rotation key.
   - Click Scale to create a Scale key.

If a particular Position, Rotation, or Scale controller does not use keys, then that button is not available in the Create Key group. For example, you cannot create Position Keys if a Noise Position controller is being used.
Interface

Motion panel > PRS Parameters rollout

Create Key/Delete Key The six buttons in the PRS Parameters rollout let you create or delete a transform key at the current frame. These buttons become active or inactive depending on the existence of a key type at the current frame.

For example, if you're on a frame containing a Scale key, the Scale button is inactive in the Create column, because a key already exists. At the same time, the Position and Rotation buttons are inactive in the Delete column because there are no keys of that type to delete.

Position/Rotation/Scale Determines the contents of the Key Info rollouts that appear below the PRS Parameters rollout in the Motion panel.

Reaction Controllers

Track View > Highlight a track in the Track View hierarchy. > Assign a Reaction-type controller (e.g., Position Reaction).

Select an object. > Motion panel > Assign Controller rollout > Highlight a track. > Click Assign Controller > Choose a Reaction-type controller (e.g., Position Reaction).

The Reaction controller is a procedural controller that lets a parameter react to changes in any other parameter in 3ds Max. Typically, most of the setup involving Reaction controllers is done with the Reaction Manager dialog on page 3533. You use the dialog to define a master, which is an object that controls other objects, and, for each master, any number of slaves, which are objects the master controls. Alternatively, you can assign a Reaction controller directly.
to a slave object using Track View or the Motion panel (as you would any other controller), and then use Reaction Manager to specify its master and other parameters.

Reaction controllers come in five different types: Position Reaction, Rotation Reaction, Point3 Reaction, Scale Reaction, and Float Reaction. You can assign a Reaction controller to any animatable track in the scene. Reaction is not based on time, but rather on other variables in your scene such as position or rotation.

You can use a Reaction controller to turn on a light as an object nears a given point. Muscles can bulge as an arm bone rotates. A ball can squash automatically as the ball's Z position nears the ground plane. Feet can rotate as their heels are lifted from the floor.

A particle system can be triggered by any given event. Morph target percentages can be controlled by events.

NOTE The Reaction controllers replace the Reactor controllers found in previous versions of 3ds Max. If you load a file containing a Reactor controller into this version of 3ds Max, the Reactor controller is converted to a Reaction controller, with all settings and reactions fully intact.

See also:

- Using Manipulators with Reaction Controllers on page 3548

Procedures

Example: To make the position of a sphere react to the position of a box:

This procedure shows an alternate way to use a Reaction controller. The recommended workflow is to do most of the setup in the Reaction Manager dialog: See Example: To use the Reaction Manager dialog: on page 3533.
NOTE  Objects don’t need to be animated to use Reaction controllers. This procedure starts with animation to make the reaction easier to see.

1. On the left side of the Top viewport, create a box about 30 units on a side.

2. Animate the box from position (-100,0,0) at frame 0 to position (100,0,0) frame 100.

3. In the Front viewport, create a sphere slightly above the box. Position the sphere at (-100,0,50).

4. Go to the Motion panel, and on the Assign Controller rollout, click the Position track to highlight it.

5. On the Assign Controller rollout, click the Assign Controller button.

6. On the Assign Position Controller dialog, click Position Reaction to highlight it, and then click OK.

This opens the Reaction Manager dialog on page 3533. The Reactions list shows that the sphere is assigned as a slave, but no master is assigned. A Reaction controller uses a master’s motion to control any number of slaves.

7. Right-click the “Unassigned” line at the top of the Reactions list. From the menu, choose Replace Master.

   This places you in a Pick mode where you can choose a motion track from any object in the scene to act as master.

8. In any viewport, click the box (Box01).

   A pop-up menu appears.
From the pop-up menu, choose Transform > Position > X Position. The “Unassigned” text is replaced by a master track labeled “Box01 / X Position”.

Also, a new state, State01, appears in the States list.

This is an example of the basis of the control mechanism used by the Reaction controller: For each master/slave combination, you can specify any number of states defined by values for the master and slave tracks. The first state, created automatically when you added the master, specifies that when the box is at –100 on the X axis, the sphere should be at (–100,0,50). In this case, you’re controlling three parameters (the sphere position on all three axes) with one (the box position on the X axis). More typically you’d use one-to-one master/slave-parameter ratios.

**NOTE** Reaction Manager also defines a state automatically when you assign a new slave to a master.

Next you’ll create a second state that tells the sphere how to move on multiple axes as the box moves on one.

Move the time slider to frame 50.
The box moves to the midpoint of its animated trajectory. The sphere remains where it is.

11 On the Reaction Manager dialog, click the Create State button.
   This creates a new state (State02) using the current positions of the box and sphere.

12 Try moving the sphere in the Front viewport.
   You can't move the sphere because it's under the full control of its master, the box. Similarly, you can't change its position using the Coordinate Display fields on the status bar. However, you can change the sphere's position using the Reaction Manager's editing tools.

13 On the Reaction Manager dialog, click the Sphere01 / Position entry to highlight it, if necessary, and then click the Edit Mode button.

14 Position the sphere at (0,0,100).

![Reaction Manager dialog](image)

The position updates in the Sphere01 / Position line under State02. Also, the Reaction Manager graph shows the change in values of the slave's (sphere) X and Z position values as the master box's X position changes. On the graph, as in Track View, red=X, green=Y, and blue=Z.

15 Click the Edit Mode button again to turn it off, and then scrub the time slider.
   As the box moves between frames 0 and 50, the sphere rises to the position specified in the second state.
For the third and final state, you'll have the slave move in a different direction over the second half of the master's motion.

16  Go to frame 100, and then create a new state.
17  In the States list, click the new state or its slave track to highlight it.
18  Turn on Edit Mode. Position the sphere at \((0, -100, 100)\), and then turn off Edit Mode.
19  Scrub the time slider between frames 0 and 100.

Over the first 50 frames, the sphere moves between the first two states, and over the second half of the animation, the sphere moves between the second and third states.

To conclude the procedure, you'll demonstrate that the sphere is responding only to the box's X position, regardless of animation.

20  Go to frame 0. Select the box, and then press and hold the Alt key and right-click the box.
    This opens the Animation quad menu.
21  From the Set (lower-right) quadrant, choose Delete Selected Animation.
    This command deletes all animation keys for the current selection.
22  Now move the box in all three dimensions.
Any change in the Y or Z position has no effect on the sphere. However, moving the box between -100 and 100 on the X axis, no matter what the Y or Z position, results in changing the sphere's position as specified in the Reaction controller.

This procedure gives you a hint of the Reaction controller's power. You can find another procedure showing additional aspects of the Reaction Manager in: Example: To use the Reaction Manager dialog: on page 3533.

**Interface**

After assigning a Reaction controller, right-click the track and then choose Properties, or choose Animation > Reaction Manager, to open the Reaction Manager dialog on page 3533.

**Reaction Manager Dialog**

Animation menu > Reaction Manager

Track View > Highlight a track in the Track View hierarchy. > Assign a Reaction-type controller (e.g., Position Reaction).

Select an object. > Motion panel > Assign Controller rollout > Highlight a track. > Click Assign Controller > Choose a Reaction-type controller (e.g., Position Reaction).

Use the Reaction Manager dialog for setting up and modifying Reaction controllers on page 3527. Reaction Manager lets you add and delete masters and slaves, define states for reactions, use a graph to view and modify reactions with curves, and more.

**NOTE** If you assign a Reaction controller while Reaction Manager is open, the dialog closes. To reopen it, choose Animation menu > Reaction Manager. If you use Reaction Manager often, it's recommended that you assign a keyboard shortcut to the command.

**Procedures**

**Example: To use the Reaction Manager dialog:**

The purpose of this procedure is to show you different ways to use Reaction Manager. Before trying it, we suggest that you first follow the introductory
procedure in the Reaction Controllers topic: Example: To make the position of a sphere react to the position of a box: on page 3528.

1. Start or reset 3ds Max.

2. In the Perspective viewport, add a box and a sphere object. Also add a Slider manipulator on page 2868, and give it the label Slider.
   The viewport should resemble the following illustration:

You'll use the slider to control two slaves separately: Negative values for the box X position, and positive values for the sphere's Hemisphere parameter.

3. On the Create panel > Parameters rollout, set Minimum to -100.0.
   The slider's current value is 0.

4. Open the Reaction Manager dialog from the Animation menu and position it so you can see the Perspective viewport.
   At this point, the dialog is empty.

5. On the upper toolbar, click Add Master, and then click the Slider manipulator in the Perspective viewport.
6 On the pop-up menu that appears, choose Object (Slider) > value.
In the Reactions list, the master entry Slider01 / value appears.

7 On the upper toolbar, click Add Slave, and then click the box in
the Perspective viewport.

8 On the pop-up menu that appears, choose Transform > Position > X
Position.
In the Reactions list, the slave entry Box01 / X Position appears under
the master entry. Also, a new state appears in the States list for the newly
added slave track. This simply says that, when the slider value is 0, the
box's X position should be what it is currently. However, a reaction needs
at least two states to be meaningful. You'll learn how to accomplish this
shortly.

Next, you'll discover a different way to add a slave track.

9 In the Perspective viewport, select the sphere.

10 On the upper toolbar, click Add Selected.
This causes the pop-up menu to appear at the mouse cursor.

11 From the pop-up menu, choose Object (Sphere) > Hemisphere.
The sphere's Hemisphere track is added as a slave of the slider, and a new
state for the two is added to the States list.
You now have two states in the States list, but in both cases the state
value (that is, the slider value) is the same, so you really need only one.
You can resolve this by adding the Hemisphere slave track to the first
state and then eliminating the second state.

12 In the Reactions list, click the Sphere01 / Hemisphere entry, and in the
States list, click the State01 entry.
13 On the center toolbar, above the States list, click the Append
Selected button.
This adds the Hemisphere track to State01.
Now you can delete the second, superfluous state.

14 In the States list, click the State02 entry, and then on the toolbar
above the States list, click the Delete State button.
State02 goes away.
Currently, the box is where you created it, but you might want it to start
out at a different location. However, because the box is a slave of the
slider, you can't move it freely on the X axis. You'll use Reaction Manager
to set the X position of the box to a specific value.

15 In the States list, position the click and hold the mouse cursor over the
Box01 / X Position > Value entry.
16 Drag upward to increase the value, or downward to decrease the value. Change the value to about -50.0.
You might find it difficult to set an exact value by dragging, which changes only the tenths (and higher) value. You can use the keyboard to specify a more exact value.

17 Double-click the value.
The value highlights and becomes an keyboard-editable field.

18 Enter -50 and press Enter or Tab.
The value now displays as -50.000.
You can use the same mouse and keyboard methods to change state (master) values as well.
Next you'll learn how to use Create Mode to create new states freely.
First you'll set a new state to move the box leftward for negative slider values.

19 Try moving the box on the X axis.
You can't do it, because it's slaved to the slider value.

20 Above the States list, click the Create Mode button.
When Create Mode is on, you can change master and slave properties and use the current properties to create new states.
On the main toolbar, click Select And Manipulate, and then drag the slider pointer all the way to the left, so the slider value reads –100.0.

In the Reactions (upper) list, click the Box01 / X Position entry to highlight it, and then move the box about –50 units on the X axis, to about X=–100.

Highlighting the slave entry lets you manipulate the slaved value interactively in the viewport while Create Mode is on. Then, when you click Create State, a new state is created for that slave only. If you highlight the master instead, you can manipulate all slaves freely, but then clicking Create State creates a new state for all slaves. Reaction Manager is a complex tool, so in general it’s best to keep the data as simple as possible.

Click Create State.

Reaction Manager adds a new state, State02, with the state (slider) value at –100.0 and the box at its new X position.

Turn off Create Mode and move the slider left and right to see how it affects the box position.

Next you’ll set a new state so the right half of the slider range affects the sphere’s Hemisphere value.

Select the sphere and go to the Modify panel.

The Hemisphere parameter is unavailable, because it’s slaved to the slider value.

Turn on Create Mode, and then and in the Reactions list, click the Sphere01 / Hemisphere entry.

The Hemisphere parameter is now available.

On the Modify panel, set Hemisphere to 0.75.

In the Perspective viewport, drag the slider all the way to the right.
Click Create State.

Reaction Manager adds a new state with the state (slider) value at 100.0 and the Sphere01 / Hemisphere value at 0.750.

<table>
<thead>
<tr>
<th>States</th>
<th>Value</th>
<th>Strength</th>
<th>Influence</th>
<th>Falloff</th>
</tr>
</thead>
<tbody>
<tr>
<td>State01</td>
<td>0.000</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Box01 / X Position</td>
<td>-50.000</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sphere01 / Hemisphere</td>
<td>0.000</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>State03</td>
<td>-100.000</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Box01 / X Position</td>
<td>-100.000</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>State05</td>
<td>100.000</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sphere01 / Hemisphere</td>
<td>0.750</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Also, if you click Slide01 / value in the Reactions list, you can see in the graph showing the slider value on the horizontal axis and the two reactions on the vertical axis. The scale between the two differs greatly, so the Hemisphere reaction on the right side of the graph looks like a straight line, but if you click the Sphere01 / Hemisphere slave entry in the Reactions list, the graph shows a steady rise from 0.0 to 0.75.

Turn off Create Mode and then drag the slider in both directions.

Over the left half of the slider range, the box moves along the X axis, and over the right half of the range, the sphere's Hemisphere value changes.

To finish the procedure, you'll experiment with using the graph to change a reaction.

If you haven't already, click the Sphere01 / Hemisphere slave entry in the Reactions list, and then click Zoom Extents button below the graph.

Click the Add Point button, and then click the middle of the graph curve (it's the red, diagonal line).

This adds a new point to the curve and a new state in the States list.

Click the Move button, and then drag the new point upward so it's above the right-hand endpoint.

Drag the slider again.

As the slider moves from 0 to 100, the Hemisphere value increases so much that the sphere disappears, and then decreases so you can see the upper fourth of the sphere.
This has been a brief tour of some of the capabilities of the Reaction Manager dialog. For further information, consult the reference, below.

**Interface**

The Reaction Manager dialog interface consists of three parts: the Reactions list, the States list, and the graph. Each has its own toolbar or toolbars. Each list contains rows and columns; the column headings employ standard Windows functionality. To resize a column, drag the divider to the right of
its heading, or auto-size a column to fit its widest entry by double-clicking the right-side heading divider. To change the vertical size of a list section, drag the horizontal divider at the bottom of the list, and to scale all three sections proportionally, drag the bottom of the dialog. You can also resize the dialog by dragging a corner or a side.

You can use standard methods to highlight list items for further actions. Highlight a single item by clicking it. Highlight multiple consecutive items by clicking the first item and then Shift+clicking the last. Use Ctrl+click to highlight non-contiguous items and to toggle highlighting of a single item.

In most cases, if a cell in the Reactions list or the States list contains a single numeric value, you can change the value by dragging vertically on the cell. Click and hold on the number in the cell, and then move the mouse upward to increase the value or downward to decrease it. The exception to this are the Start and End values for master objects; you can change these values only by modifying a slave’s Start or End value. You can also modify a one-value field by double-clicking it and then editing it with the keyboard. If a field contains multiple numeric values, you must manipulate the object directly in the viewports or the appropriate dialog.

The dialog also has a right-click menu on page 3547 for managing reactions and states, available by right-clicking anywhere on the dialog except in the graph section.

NOTE A master is an object that you can use to control other objects via Reaction controllers, and a slave is an object controlled by a master.

Reactions list

The Reactions list displays a hierarchical view of the master-slave relationships of objects with Reaction controllers in the scene. You can use its controls to add and delete masters and slaves, change start and end frames, and toggle usage of the graph curve. These controls are available both on the toolbar above the list and in the list itself.
Add Master

Places you in Add Master mode. Click an object in a viewport, and then use the pop-up menu to choose an animation track to use as master. Alternatively, choose a track in Track View or from the Motion panel > Assign Controller rollout list.

Using the pop-up menu, you can choose only a track at the end of the menu hierarchy; for example, Transform > Position > X Position. If you choose the object name from the top of the menu, Reaction Manager lists it as World Space Position, so that you can use its three-dimensional position in the World coordinate system to control its slaves.

To use a Position or Rotation track for the master, click Add Master and then click the track in Track View or the Motion panel > Assign Controller rollout list. In the latter case, the object must already be selected in the viewports before clicking Add Master in order for it to show up on the Assign Controller rollout list. If using Track View, you can open the Track View dialog before or after clicking Add Master.

**TIP** If you use Track View or Motion panel to assign a Reaction controller to an animation track, the object shows up in Reaction Manager without a master ("Unassigned"). To assign a master, right-click the highlighted "Unassigned" label, and then choose Replace Master from the context menu. Finally, choose the master track.

Add Slave

Places you in Add Slave mode, letting you assign a slave track to the currently highlighted master in the Reactions list. Highlight a master and then click Add Slave. Click an object in a viewport, and then use the pop-up menu to choose an animation track to use as slave. Alternatively, choose a track in Track View or from the Motion panel > Assign Controller rollout list. Available only when a master is highlighted in the Reactions list.

To add multiple slaves, click Add Slave and then press H to open the Pick Object dialog. Highlight the objects to add, and then click Pick. The pop-up menu then appears, prompting you to choose an animation track to use as slave. The same track is used from each object. Alternatively, select the objects and then use Add Selected (see following).

If multiple masters are highlighted when you add a slave or slaves, the slave is added to the first master in the list.

If any states are highlighted in the States list, the new slave or slaves are added to the highlighted states. If no states are highlighted in the States list, Reaction Manager creates a new state with the added slave or slaves.
**Add Selected** Lets you add slave tracks to the current master for any selected objects in the viewports. Opens a pop-up menu from which you can choose a track. If multiple objects are selected, this track is added as a slave for each selected object. Available only when a master is highlighted in the Reactions list and at least one object is selected in the viewports. If multiple masters are highlighted, the slaves are added to the first master in the list.

If any states are highlighted in the States list, the new slave or slaves are added to the highlighted states. If no states are highlighted in the States list, Reaction Manager creates a new state with the added slave or slaves.

**Delete Selected** Deletes any items highlighted in the Reactions list. If you delete a slave, any related state definitions are deleted from the States list, although the states themselves remain. If you delete a master, all of its slaves and any related states are also deleted.

**Show Selected** When on, displays data in the Reactions list only for objects selected in the viewports. This lets you restrict display reaction setups to objects of immediate interest, without having to scroll through long lists of parameters. When off, shows all objects and states, regardless of viewport selection status. If the master is selected in the viewport, Show Selected shows all slaves in the Reaction list whether or not they're selected.

**Update Selection** Refreshes the list contents based on the current selection. Available only when Show Selected is on and the viewport selection has changed.

**Start/End** These columns show the first and last animation frames for which the master-slave relationship is in effect. These default to the active time segment on page 8496. Use standard methods on page 3541 to change these values. If multiple slaves assigned to the same master have different Start or End values, the master's Start and End fields are blank.

**Curve** This column shows an X when the graph curve on page 3546 is used to modify Strength, Influence, and Falloff. To specify these numerically in the States list, click the field to toggle the X. Available for slaves only.
States list

A state describes interaction between a master and its slaves. In each state, you specify a value or values for the master track, and corresponding values for each slave. Then, as a master-track value changes in the scene, the slaved values follow along according to the states' specifications.

The States list shows all states for the highlighted reaction in the Reactions list. Any member of a reaction (master and/or slaves) can be highlighted in the Reactions list for its states to appear in the States list. If members of multiple reactions are highlighted, the States list reflects values for the first highlighted reaction only.

You can use tools in the States list to add and modify states and their names. To change a state name, click the text twice, slowly (don’t double-click). Or, if the state name already highlighted, just click it once. The text highlights and a box appears around it to show that you can now edit it. You can rename only state names, not the indented slave tracks.

You can change values for single-numeric-value slaves in this list by dragging vertically on the value.

The following reference describes changing values interactively in the viewports using the States list controls. Other controls are described in the introduction to this topic.

Create Mode Use primarily to create new states interactively. To use it, turn on Create Mode, adjust values for the current reaction (master and slaves) in the viewports, and then click Create State. You can repeat this to create any number of new states quickly and efficiently.

The difference between creating a state in or out of Create mode is that, in Create mode you can manipulate the reaction tracks for all objects, whereas with it off you can manipulate the reaction track only for the master.
Create State Adds a new state to the States list for the current reaction, using the current values for the master and slave parameters.
When you create a state, 3ds Max gives it a default name (State##) and lists its slave tracks, indented, under the state name.
The contents of the new state depend on what's highlighted in the Reactions list. If the master is highlighted, a new state specifies values for the state (i.e., master track) and all of its slaves. If one or more slaves are highlighted in the Reactions list, the new state specifies values for the master and only the highlighted slaves.

Append Selected Adds a slave or slaves to a state in which they don't currently participate. To use, highlight one or more slave tracks in the Reactions list, highlight a state in the States list, and then click Append Selected.

Edit Mode When on, you can change slave values interactively in the current state by manipulating slave objects in the viewports or by editing their values on a rollout. Available only when at least one item in the States list is highlighted.
If you highlight a slave name, you can edit its value for the current state. If you highlight a state name and then click Edit Mode, you can edit any of its slave tracks. To exit this mode and test the new values, click Edit Mode again.
As you manipulate the object, the value is updated immediately and the new value is displayed in the States list. If slaves in multiple states are highlighted, values are updated for those in the first state only.

Set State Updates the highlighted state (master track) to its current value. To use this option, highlight the master track in the Reactions list and the state in the States list. Manipulate the master object in the viewports, and then click Set State to update the state value. Available only when a state is highlighted in the States list.

Delete State Deletes any items highlighted in the States list.

Value This column shows the current value or values for the state: the master parameter(s) on the State## line and the slave parameter(s) on each slave line
within a state. You can edit a single value (not groups of three in parentheses) by dragging vertically on the value in the table.

The following three parameters, which appear as columns in the States list, apply to slaves and are normally controlled via the graph curve. They're available only if the slave has Curve turned off in the Reactions list.

These parameters are based on the fact that states can influence one another, so that you get a blending between them.

Strength This is a biasing factor that affects a state's relative influence when one or more states overlap. A greater Strength value influences a value towards a state and a smaller one influences the value away from it.

Influence The distance from the master state's value to the maximum extent of its range of influence.

Falloff The rate of change in the slave state (its speed) as the master goes from a state to the maximum extent of its range of influence.

Graph

Reaction Manager's graph displays curves that graph the master values on the horizontal axis and slave values on the vertical axis. It shows data of all states for items highlighted in the Reactions list. If a master is highlighted, the graph shows states curves for all its slaves. If one or more slaves are highlighted, but the master isn't, the graph shows data for those slaves only. You can edit data using the graph by dragging points.

The graph controls are similar to those found in other graphs in 3ds Max, such as the Material Editor Output rollout on page 6192. The toolbar above the graph offers functions for moving and scaling points on the graph, as well as
inserting new ones (that is, new states). The same functions are available by right-clicking the graph, and if you right-click a graph point, you can set it to Corner and two different Bezier types. If you select a Bezier point, you can reshape the curve by moving its handles. You can drag a region to select multiple points, and then edit them together. Use the toolbar under the graph for panning and zooming the graph.

**Right-click menu**

Reaction Manager’s right-click menu provides quick access to a number of commonly used functions. It also contains the Replace Master function, which is unavailable elsewhere in the dialog interface. To open the right-click menu, right-click anywhere on the Reaction Manager dialog except in the graph section.

**Add Master** Places you in Add Master mode. Click an object in a viewport, and then use the pop-up menu to choose an animation track to use as master. Alternatively, choose a track in Track View or from the Motion panel > Assign Controller rollout list.

For more information, see [Add Master](#) on page 3542.

**Replace Master** Lets you replace the current master. Use the standard method to choose another master as described in [Add Master](#) on page 3542. Use this function to specify a master when you open Reaction Manager by assigning a Reaction controller to a slave.

**NOTE** If you replace a master with multiple states, Reaction Manager deletes all existing states except the default one. In essence, replacing a master is like starting over.

**Add Slave** Lets you add a slave to the current master. For details, see [Add Slave](#) on page 3542.

**Add Selected** Lets you add selected objects as slaves to the current master. For details, see [Add Selected](#) on page 3543.

**Delete Selected** Deletes any items highlighted in the Reactions list. For details, see [Delete Selected](#) on page 3543.

**Create States Mode** Lets you create states on the fly by manipulating objects in the viewports. For details, see [Create Mode](#) on page 3544.

**Create State** Adds a new state to the States list for the current reaction. For details, see [Create State](#) on page 3545.
Append Selected Adds a slave to a state in which the slave doesn’t currently participate. To use, highlight a slave in the Reactions list, highlight a state in the States list, and then choose Append Selected.

Set State Updates the highlighted state (master track) to its current value. For details, see Set State on page 3545.

Delete State Deletes any highlighted items in the States list.

Edit Slave State Mode Lets you change slaves’ values in the current state. For details, see Edit Mode on page 3545.

Show in Track View Opens Track View, displaying reaction tracks for highlighted slaves and masters only.

Show in Schematic View Opens Schematic View, with reaction tracks expanded for highlighted slaves and masters.

Using Manipulators with Reaction Controllers

The Position Reaction and Rotation Reaction controllers on page 3527 let you perform certain functions via manipulators in the viewports.

Manipulators for Reactor Controllers

Reaction controllers for position and rotation tracks have graphic manipulators to help you adjust their settings.

Other Reaction controllers, such as point3, scale, and float, do not have manipulators.

Manipulators are visible and usable while the Select and Manipulate button on page 2838 is turned on. This button is on the default main toolbar on page 8035. When you move the mouse over a manipulator, the manipulator turns red to show that dragging or clicking it will have an effect.

TIP Use the Reaction controller manipulators in a wireframe viewport. (See Shading Viewport Label Menu on page 8130.) Also, for the Position Reaction controller, you might have to change viewports to see a particular manipulator clearly.
**Position Reaction controller**

The Position Reaction controller has a set of manipulators to control (or simply display) different reaction values.

**Reaction cycle manipulator**: Click this to cycle among the various reactions in the Reactions list. The display of the manipulators and indicators changes to show their settings for the active reaction.

This manipulator is a small yellow circle that appears in the lower-left corner of the active viewport, near the icon for coordinate axes.

**Influence manipulator**: Drag in a viewport to change the manipulator's size, which changes the reaction's range of influence.

This manipulator is a yellow sphere that turns red when you can drag it. At the center of the Influence manipulator is the Reaction Value manipulator.

**Reaction Value manipulator**: Drag in a viewport to change the reaction value, which for a position track is an XYZ location.

This manipulator is a light blue sphere that appears at the center of the Influence manipulator.

**Object Pivot indicator**: Shows the pivot point location of the master object.

This indicator is a dark blue sphere. You can't manipulate it.

**Reaction State manipulator**: Drag to adjust the reaction state. For position reactions, the reaction state is an XYZ location that the slave object approaches, depending on the animation of the master object and the Influence value.

This manipulator is a small green square.

**Reaction State indicator**: Shows the reaction state value. This indicator is independent of the square green Reaction State manipulator, which you can drag in viewports. As you drag the green square, the indicator follows it.

This indicator is a small dark-blue dot.

**Rotation Reactors**

The Rotation Reaction controller has a single manipulator, which controls the reaction's Influence parameter.

**Influence manipulator**: Drag in a viewport to change the manipulator angle, which changes the reaction's range of influence.
Procedures

To use manipulators for a position or rotation Reaction controller:

(Point3, scale, and float Reaction controllers don't have manipulators.)

1. Select the object that has the Reaction controller assigned to it.

2. On the default Main toolbar, click Select And Manipulate.
   The manipulators appear in viewports.

3. In the active viewport, drag or click manipulators to adjust the reaction parameters.
   When you move the mouse over a manipulator, the manipulator turns red to show that dragging or clicking it will have an effect.

   **Tip:** Use the reactor manipulators in a wireframe viewport. (See Shading Viewport Label Menu on page 8130.) Also, for the Position Reaction controller, you might have to change viewports to see a particular manipulator clearly.

The specific manipulators and their use are described below.

**Scale XYZ Controller**

Main toolbar > Curve Editor (Open) > Select a scale track in the Track View hierarchy > Track View menu bar > Controller menu > Assign > Scale XYZ

Graph Editors > Track View – Curve Editor > Select a scale track in the Track View hierarchy > Track View menu bar > Controller menu > Assign > Scale XYZ

The Scale XYZ controller has independent float controllers for each scale axis of an object's transform. With three separate tracks for scale, you can create scale keys for each axis independently, change interpolation settings for a single axis, or assign a controller on an axis. For example, after applying a Scale XYZ controller, you could apply a Noise or Waveform controller to an axis to animate that axis independently.
The Scale XYZ controller assigns three keys (one for each axis), by default. In previous versions of 3ds Max, you had to edit the keys manually in order to create explicit axis keys. However, there are now actions available from the Customize User Interface dialog on page 8249 that let you create explicit axis keys on page 3404.

**TIP** Open Track View to view and edit the three scale tracks.

### Procedures

**Example: To assign the Scale XYZ controller to an object:**

1. In the Top viewport, create a sphere.
2. Right-click over the sphere and choose Curve Editor from the quad menu. Track View - Curve Editor opens with the sphere as the first item in the hierarchy.
3. In the Track View hierarchy, click the Scale track.
4. From the Track View menus, choose Controller > Assign and select Scale XYZ from the Assign Controller dialog. Three tracks are displayed and are available to control the object's scale.
5. In the Track View hierarchy, click the Z Scale track, click Controller > Assign from the Track View menus, and then choose Noise Float from the dialog. The Noise Controller dialog automatically displays.
6. Click Play. The sphere changes scale along the Z axis, controlled by the Noise controller.

### Interface

After applying the Scale XYZ controller to an object, Scale XYZ parameters appear in a rollout on the Motion panel.
Scale Axis Adjusts an axis using controls in the Motion panel > Key Info rollout.
An axis should already have a key to adjust. To create keys, either turn on Auto Key and scale the object, or click Scale in the Create Key group on the PRS Parameters rollout.

Script Controller

Track View > Highlight a track in the Track View hierarchy. > Track View menu bar > Controller menu > Assign > Script

The Script controllers work similarly to Expression controllers on page 3456. They provide a Script Controller dialog where a you can enter a script for computing the controller value.

The following Script controllers are available in 3ds Max:

- Float Script: float controller
- Point3 Script: Point3 controller
- Transform Script on page 3553: matrix3 PRS controller
- Position Script: position Point3 controller
- Rotation Script: rotation Quaternion controller
- Scale Script: scale Point3 controller

The differences among the various types of Script controllers are mainly in the type of animation track you can assign them to. For example, you assign a Transform Script controller to a Transform Track; a Position Script controller to a Position track; and, if the Position controller is Position XYZ, you could assign a Float Script controller to any or all of the individual Position tracks (Position X/Y/Z).
The primary advantages of Script controllers are:

- They can use all the features of the MAXScript on page 21 language, including loops, scripted functions, and path names.
- Almost any property of any object in a scene can be used to help compute controller values, including mesh vertices, values of properties at arbitrary frame times, and other non-animatable properties that are not accessible in Expression controllers.
- They can use MAXScript global variables to communicate and coordinate with other controllers and scripts in 3ds Max.

Refer to the MAXScript Help for a complete explanation of this scripting language.

**Transform Script Controller**

A Transform Script controller contains all of the information contained in a Position/Rotation/Scale (PRS) controller on page 3526 in one scripted matrix value. Instead of having three separate tracks for position, rotation, and scale, you can access all three values simultaneously from a single script controller dialog. Because a script defines the transform values, they are easier to animate.

The value of the controller script must be a matrix3 value. A matrix3 value is a 4x3 3D transformation matrix. For more information, see the Matrix3 Values topic in the MAXScript Help.

**Writing Controller Scripts**

3ds Max interprets the text you type into the Script text box as the body of a MAXScript block expression. You can type as many expressions as you want on as many lines as you want, and they are evaluated in turn. The value of the last expression is taken as the controller value. This value must yield the right type for the controller: float for Float, point3 for Position, quat for Rotation, matrix3 for Transform, and so on.

Because the text is inside a block expression, you can declare local variables that are visible only within the script and are temporary for one evaluation. You can also declare or access global variables that are shared with all other scripts in MAXScript and hold their values from one evaluation to the next.

A controller is always evaluated by 3ds Max with respect to a specific animation time. This might be the current time slider or incrementing frame time if an animation is playing, or a rendering is under way. In the case of Script controllers, the time being evaluated is used to establish an automatic "at
time" context around the controller script, so any properties you access (outside of other explicit “at time” expressions) yield the correct values for the current controller evaluation time. This means you don’t have to do anything special in your scripts to work at the correct time. You can access the evaluation time with the standard MAXScript variable, currentTime. You can also reference scene property values at other times by using "at time" expressions in your scripts, as in regular MAXScript programming.

Assign Nodes and Tracks to Variables

When you need to refer to nodes in your scene or to animation tracks, it is recommended that you use the Script controller variable toolset to create variables to assign to any particular node or controller track. This way, if you decide to later on rename your scene objects, the script controllers using these objects are preserved because the variables maintain the link to the nodes. Otherwise, if you assign, for example, a node to a variable manually in the dialog's Expression window, that link becomes broken as soon as you rename that particular node.

NOTE It is especially important to assign nodes and tracks to variables with the corresponding buttons when using XRef scenes and objects.

Procedures

Example: To keep an object centered relative to other objects in the scene during an animation:

1 Name the object that should remain centered foo and assign a Script controller to its Position track.

2 Enter foo in the Name field and click Create.
   The new variable is automatically added to the Variables list.

3 With the variable highlighted, click Assign Node.
   The Track View Pick dialog opens, listing the contents of your scene.

4 Expand the Objects hierarchy until you locate foo. Highlight it and click OK.
   The foo node is assigned to your variable.

5 Enter the following script in the Script Controller dialog's Expression window:
   local pos=[0,0,0]
for o in objects where o != foo do
    pos += o.pos
    pos / (objects.count - 1)

This script computes the average position of all objects, except the current one (written as foo here) by setting up a local, iterating over all objects except foo, accumulating a total position vector, and computing the average in the last line, which is the final result of the script.

To use a Transform Script controller:

1. Select an object.
2. Right-click to open the quad menu.
3. In Transform quadrant, click Curve Editor.
4. Select the Transform track of the selected object in Track View.
5. Select Transform Script from the Assign Transform Controller dialog and click OK.
   The Script Controller dialog opens.
6. Edit the matrix3 value in the Script Controller dialog, and click Evaluate when you are finished.

Interface

Assigning a Script controller automatically opens a Script Controller dialog where you can enter a script. You can open the dialog subsequently by
right-clicking the track on the Motion panel or in the Track View hierarchy and choosing Properties, or clicking the Properties button on the Track View toolbar.

**TIP** You can resize the dialog by dragging an edge or a corner.

**Create Variable group**

*Name* Lets you enter and edit the name of user variables.

*Create* Creates a variable and adds it to the Variables list.

*Delete* Removes the highlighted variable from the Variables list. You can also delete a variable by tying its name into the Name field and click Delete.

*Rename* Renames the highlighted variable.

**Variable Parameters group**

*Tick Offset* Specifies a time offset in ticks for the current variable. When the script is evaluated, the variable's value is set from the current time plus the Tick Offset value.

**NOTE** The Time Offset has no effect on variables that are assigned a constant.

**Variables list**

Lists all available variables in the controller. The following pre-defined constant variables are available in every script Controller and cannot be deleted or renamed:

- **F** the current time in frames
- **NT** the normalized time
- **S** the current time in seconds
- **T** the current time in ticks

**Assign Constant** Opens a dialog which lets you assign a constant to the highlighted variable.
■ Value expression  Enter any MAXScript value or expression (such as an integer, a float, an array, and so on).

■ Value expression result  Displays the results of the expression above.

■ Evaluate  Analyzes the expression at the current time.

■ OK  Assigns the value expression result to the current variable.

■ Cancel  Disregards the current value expression result and closes the dialog.

Assign Track  Lets you assign a controller to the highlighted variable. The controller’s value is taken at the current time plus the variable’s Tick Offset.

Assign Controller  Lets you assign a track to the highlighted variable.

Assign Node  Lets you assign a node to the highlighted variable.

Expression window
Displays the expression to evaluate. You can edit the text in this window.

Description window
In this text window, you can enter comments about how the controller works, how to use it, and so on.

_____

Save  Click to save the script to a MAXScript (.ms) text file.

Load  Click to load a script from a MAXScript (.ms) text file.

Debug  Opens the Script Controller Debug Window, which displays the value of all variables used in your script.
**Evaluate** Evaluates the script expression. The evaluation is computed for the current position of the time slider.

**Close** Compiles and checks the controller script for errors. If no errors are found, the dialog is closed. Any problems result in a query box asking whether you want to revert the expression to the original value of the current track and close the dialog (OK), or to return to editing the expression (Cancel).

## Smooth Rotation Controller

Main toolbar > Curve Editor (Open) > Select a rotation track in the Track View hierarchy. > Track View menu bar > Controller menu > Assign > Smooth Rotation

Graph Editors > Track View – Curve Editor > Select a rotation track in the Track View hierarchy. > Track View menu bar > Controller menu > Assign > Smooth Rotation

Animation menu > Rotation controllers > Smooth

Use Smooth Rotation when you want rotation to have a smooth and natural look.

Smooth rotation functions the same as Linear Rotation, but uses non-adjustable curved interpolation, and has the following characteristics:

- Displays no controllers, key properties, or function curves
- Move keys in Track View to change timing
- Directly rotate objects in the viewports to change rotation values

## Spring Controller

Main toolbar > Curve Editor (Open) > Select a track in the Track View hierarchy: > Track View menu bar > Controller menu > Assign > Spring

Graph Editors > Track View – Curve Editor > Select a track in the Track View hierarchy. > Track View toolbar > Controller menu > Assign > Spring

---

3558 | Chapter 13  Animation
Animation menu > Position controllers > Spring

The Spring controller adds secondary dynamics effects to any point or object position. The end result is secondary mass/spring dynamics similar to Flex. This constraint adds realism to generally static animations.

When you apply Spring to an animated object, its original motion is preserved and secondary, velocity-based dynamics are applied. You can control the object's mass and drag. When you first apply the controller, it constructs a virtual spring between the object's original position and where it would end up after forces are applied to it.

You can adjust spring tension and dampening. Increasing the tension creates a tighter spring, while increasing the dampening smooths out jitters in the motion. You can add external forces like Gravity on page 2923 and Wind on page 2926 to affect the motion, and also add additional objects whose motions act as springs.

NOTE You can also assign the Spring controller to animated vertices in Track View: Open the object's Master Point Controller hierarchy, select the vertices, and assign the Spring controller.

Interface

When you assign a Spring controller to an object, its rollouts automatically appear in the Motion panel. In addition, the rollouts open in a floating dialog. If you close the dialog, you can reopen it by right-clicking the track in the Motion panel Assign Controller rollout or in the Track View hierarchy and choosing Properties, or clicking the Properties button on the Track View toolbar.
Spring Dynamics rollout

Point group

Mass  The mass of the object to which the Spring controller is applied. Increasing the mass causes the "bouncing" spring motion to become more exaggerated.

Drag  Acts as air friction on the spring motion. A low Drag setting results in a greater "bouncing" effect, while a high Drag results in subdued bouncing. Default=1. Range=0 to 10.

Springs group

Add springs to an object using the Spring controller when you want the object to be affected by the motion of other objects in your scene. This effectively creates virtual springs between objects.

Add  Click this button, and then select one or more objects whose motion relative to the spring-controlled object will act as springs on that object. To finish adding springs, click Add again, right-click in a viewport, or press Esc.

Remove  Removes highlighted spring objects from the list.

NOTE  You cannot remove the Self Influence list entry, which is the spring-controlled object's influence on itself.
(List) Lists all spring objects by name, and displays each object's Tension and Dampening settings separated by a slash (/). The spring-controlled object’s influence on itself appears as Self Influence, and cannot be deleted. However, you can effectively remove the object's influence on itself by setting Tension and Dampening to 0, resulting in no motion.

To set Tension and Dampening for one or more objects in the list, highlight them in the list and then adjust the settings.

**Tension** The "stiffness" of the virtual spring between the controlled object and the highlighted spring object(s).

**Dampening** Acts as a multiplier of an internal factor that determines how quickly the object comes to rest.

With the Self Influence spring, changing Dampening has the same effect as changing Drag. With other springs, Dampening affects only the movement caused by that spring.

Internally, the dampening value is proportional to the tension, so as you increase the tension and make the solution more stiff, the dampening is increased to maintain system stability.

**Relative/Absolute** With Relative chosen, changing the Tension and Dampening settings causes the new settings to be added to the existing values. With Absolute chosen, the new settings replace the existing values.
Forces Limits and Precision rollout

Add Click this button, and then select one or more space warps in the Forces category that are to affect the object's motion. To finish adding space warps, click Add again, right-click in a viewport, or press Esc.

Remove Removes highlighted space warps from the list.

(List) Lists all spring space warps by name.

Calculation Parameters group

Start Frame The frame at which the Spring controller first takes effect. Default=0.

Iterations The accuracy of the controller application. If you get unexpected results, try increasing this setting. Default=2. Range=0 to 4.

X/Y/Z Effect These settings let you control the percentage of the effect on the individual world axes. Default=100.0. Range=0 to 1000.0.
TCB Controllers

Main toolbar > Curve Editor (Open) > Select a track in the Track View hierarchy. > Track View menu bar > Controller menu > Assign > TCB

Graph Editors > Track View - Curve Editor > Select a track in the Track View hierarchy. > Track View toolbar > Controller menu > Assign > TCB

Animation menu > Position, Rotation, or Scale > Quaternion (TCB)

TCB Controllers produce curve-based animation much like Bezier controllers. However, TCB controllers do not use tangent types or adjustable tangent handles. They use fields to adjust the Tension, Continuity, and Bias of the animation.

This controller works well as a Position controller in conjunction with the Motion panel > Trajectories display of an object. With sub-object keys turned on and the Key Info dialog for a key displayed (right-click and select Key Info on the selected key to display Key Info properties), you can change the parameters in the Key Info dialog and see the trajectory path change. This allows for very precise control of an object's trajectory with visual feedback.

Euler XYZ is now the default rotation controller in 3ds Max. The TCB Rotation controller was the default rotation controller for files created in versions 4 and earlier.

**TIP** Euler XYZ behaves very differently than TCB rotations. Users upgrading from versions 4 or earlier might have difficulty adapting to the differences between these controllers. If you are used to working with TCB rotations, you can reassign it to be the default rotation controller.
Procedures

To change an Euler XYZ Rotation controller into a TCB Rotation controller:

1. Select an object animated with an Euler XYZ rotation controller.

2. In Motion panel > Parameters > Assign Controller rollout, select the Rotation track in the list window.

3. Click Assign Controller, and then select Quaternion (TCB).
   You can also assign this controller in Track View or from the Animation menu.

Interface

TCB controllers display their properties in a Key Info dialog in Track View and a single Key Info rollout in the Motion panel.

Time field Specifies when in time the key occurs.

Time Lock Prevents horizontal key motion in Track View edit modes.

Key Value fields Stores the animation values for the key. The number and meaning of the fields vary with different parameter data types. Some typical field arrangements are:

- XYZ fields for Position and Point3 keys
- XYZ percentage fields for Scale keys
- A single value field for Float keys

**TCB Graph** Charts the effect that changing the controller properties will have on the animation. The red mark at the top of the curve represents the key. The marks to the left and right of the curve represent an even division of time to either side of the key.

The TCB graph is a stylized representation of the animation around a single key. If you want to view the effect of changing TCB properties on the true animation curve, use the Function Curves mode of Track View (works only with position and scale).

The following descriptions refer to both the TCB graph and the function curve as the animation curve.

**NOTE** When you are changing the properties of a selection of multiple keys, the TCB graph is blank unless all properties are equal.

- **Ease To** Slows the velocity of the animation curve as it approaches the key. Default=0.
  - High Ease To causes the animation to decelerate as it approaches the key.
  - The default setting causes no extra deceleration.

- **Ease From** Slows the velocity of the animation curve as it leaves the key. Default=0.
  - High Ease From causes the animation to start slow and accelerate as it leaves the key.
  - The default setting causes no change of the animation curve.

- **Tension** Controls the amount of curvature in the animation curve.
  - High Tension produces a linear curve. It also has a slight Ease To and Ease From effect.
  - Low Tension produces a very wide, rounded, curve. It also has a slight negative Ease To and Ease From effect.
  - The default value of 25 produces an even amount of curvature through the key.

- **Continuity** Controls the tangential property of the curve at the key. The default setting is the only value that produces a smooth animation curve through the key. All other values produce a discontinuity in the animation curve causing an abrupt change in the animation. Default=25.
  - High Continuity values create curved overshoot on both sides of the key.
Low Continuity values create a linear animation curve. Low continuity creates a linear curve similar to high tension except without the Ease To and Ease From side effect.

The default setting creates a smooth continuous curve at the key.

**Bias** Controls where the animation curve occurs with respect to the key. Default=25.

High Bias pushes the curve beyond the key. This produces a linear curve coming into the key and an exaggerated curve leaving the key.

Low Bias pulls the curve before the key. This produces an exaggerated curve coming into the key and a linear curve leaving the key.

The default setting distributes the curve evenly to both sides of the key.

**Rotation Windup (TCB rotation only)** When on, rotation keys can be greater than 180 degrees. When off, rotation keys are always less than 180 degrees. This is useful if you want to set a single rotation key to create multiple revolutions of an object. Default=off.

**WARNING** If you have Rotation Windup on and you insert a rotation key between two previously created rotation keys, you might get unexpected directional shifts. Rotation Windup works best if you set keys using a straight-ahead workflow.

---

**Waveform Controller**

Main toolbar > Curve Editor (Open) > Select a track in the Track View hierarchy. > Track View menu bar > Controller menu > Assign > Waveform Float

Graph Editors > Track View – Curve Editor > Select a track in the Track View hierarchy. > Track View toolbar > Controller menu > Assign > Waveform Float

The Waveform controller is a float controller that provides regular, periodic waveforms. Created originally to control blinking lights, you can use it on any float value.
To view how the trajectory of an object is being affected by the Waveform controller, turn on Motion panel > Trajectories.

**Procedures**

**To use the Waveform controller to animate the visibility of a sphere:**

1. Create a sphere.
2. Open Track View, and select the Sphere track.
3. On the Tracks menu choose Visibility Track > Add.
4. Select the Visibility track, click Controller > Assign, and select Waveform Float.
5. Play the animation to see the effect.

**To use the Waveform controller to animate the radius of a sphere:**

1. Create a sphere.
2. Open Track View — Dope Sheet, and expand the Object (Sphere) track.
3. Select the Radius track, click Controller > Assign, and choose Waveform Float from the Assign Controller dialog.
4. Play the animation to see the effect.

**Interface**

After assigning the Waveform controller, in Track View, right-click its track to display its properties in the Waveform Controller dialog.
List Window Displays waveforms in a list.

Add Adds a new waveform to the end of the list. The default waveform is a sine wave with a period of 10 frames and with an amplitude of 100.

Insert Inserts a new waveform before the selected waveform slot.

Remove Deletes the selected waveform. This is not available when only one waveform remains.

Move Up and Move Down Shifts the selected waveform up and down in the list, allowing the waveform order to be altered.

Disable Disables the selected waveform.

Waveform group

This group provides control parameters for the currently selected waveform.

TIP Using the Sphere example, you can observe the waveform in the Function Curve displays of the Track View, and watch changes in the waveform while testing the parameters described below.

Name Contains the name of the waveform.

Waveform Icons Specifies five waveform types: Sine, Square, Triangle, Sawtooth, and Half Sine.

Inverted Flips the waveform vertically.
**Flipped** Flips the waveform horizontally.

**Period** Sets the number of frames to complete one waveform pattern. Spinner Value=float, 0.01 to 9,999,999

**Duty Cycle** For square waves only, specifies the percentage of time the square wave is "on." Default=50, Spinner Value=float, 0 to 100

**Amplitude** Sets the height of the wave. Spinner Value=float, 0 to 9,999,999

**Phase** Sets the offset of the wave. Spinner Value=float, 0 to 1

**Vertical Bias group**

A waveform's output value can be altered by adjusting the Vertical Bias parameter. Spinner Value=float, -9,999,999 to 9,999,999

**Centered** Centers the waveforms vertical bias about zero. For example, a 100 unit amplitude waveform would range from -100 to 100.

**Auto > 0** Shifts the waveform above the zero line.

**Auto < 0** Shifts the waveform below the zero line.

**Manual** Lets you set the waveform manually by adjusting the spinner.

**Effect group**

Each waveform has an Effect parameter, which can be one of the following:

**Add** Causes the current waveform's value to be added to the previous waveform's output. This is the default.

**Multiply** Multiplies the previous waveform's output by this waveform's value.

**Clamp Above** Limits the previous waveform's output to be above this waveform's value.

**Clamp Below** Limits the previous waveform's output to be below this waveform's value.

**Characteristic Graph**

Characteristic Graph shows one of three displays, controlled by the radio buttons below the display.

**This Wave** Shows the current waveform only, independent of all other waveforms.
This Output Shows the output of the current waveform, including all previous waveforms.

Final Output Shows the output of all the waveforms in the list. You can also see the final output by turning on the Track View — Curve Editor display for the track which has the waveform controller assigned.

All displays show the output graph of the controller waveforms in a solid dark line, with the zero line drawn in a dotted gray line. Two numeric displays to the right show the high and low range of the waveform curve. The graph automatically scales vertically to fit the waveform output curve, and scales horizontally to two times the period of the longest-period waveform.

**XRef Controller**

Main toolbar > Curve Editor (Open) > Select a transform track in the Track View hierarchy. > Track View menu bar > Controller menu > Assign > XRef Controller

Graph Editors > Track View - Curve Editor > Select a transform track in the Track View hierarchy. > Track View menu bar > Controller menu > Assign > XRef Controller

This controller lets you externally reference any type of Transform controller on page 3406 from another scene file. The XRef controller follows the same concepts and principles as the XRef objects on page 7450 and XRef material on page 6183; it can improve upon the collaborative synergy within a production environment by letting you access animation data currently in another scene while someone else updates it.

For example, while an animator works locally on a character’s walk cycle, a scene integrator can externally reference it into his master scene comprised of several characters. The integrator can now regularly update his master scene with the latest changes from the source scene; if he notices a problem, the animator can make the appropriate modifications, which reflect in the master scene.
You can create an XRef controller with or without an XRef object:

- You can externally reference a source object's animation without the object itself by assigning an XRef controller to your current selection on page 3571.
- You can create an XRef object, which automatically nests the source object's Transform controller in an XRef controller. The XRef Objects dialog's XRef Entities list on page 7465 lists both XRefs as separate entries.

**NOTE** The Merge Transforms option must be off to externally reference a controller; otherwise, the controller merges with the current scene.

To remove an XRef controller, you can either right-click the entry in the XRef Entities list and choose Merge in Scene from the contextual menu, or assign a new Transform controller to your object.

**NOTE** Replacing the XRef controller with another type removes any animation it contains.

Although XRef controllers are read-only in your master scene, you can add a local offset to the object's animation on page 3572.

**Procedures**

**To assign an XRef controller using the Motion Panel:**

1. Select an object in the current screen.

2. On the Motion Panel, click Parameters, and open the Assign Controller rollout.

3. Highlight the Transform track in the Assign Controller list.

4. Click the Assign Controller button, and then select XRef Controller from the Assign Transform Controller dialog.
In the Open File dialog, navigate to the file from which to externally reference the transform controller and then click Open.

Use the XRef Merge dialog to designate the object whole transform controller you want to XReference.

3ds Max references the scene object’s transform controllers from the external object’s controllers.

**TIP** You can also XReference a different controller from either another file or another object via the Parameters rollout of the XRef controller.

---

**To add and reset a Transform offset to an XRef Object’s Animation**

1. Create a sphere at [0,0,0] and animate it from [0,0,0] to [5,5,5]
2. Save your scene, then choose File > Reset.
3. Choose File > XRef Objects.
4. In the XRef Objects dialog, make sure Merge Transforms is off, then click the Create XRef Record From File and select the scene you just saved.
The sphere appears in your master scene at \([0,0,0]\).

5 Move the sphere to \([10,10,10]\).
   The sphere now translates from \([10,10,10]\) to \([15,15,15]\).

6 Right-click the XRef Controller entry in the XRef Entities list of the XRef Objects dialog.

7 From the contextual menu, choose Reset PRS Offset.
   This removes the sphere's local offset, which now returns to its original \([0,0,0]\) position.

**Interface**

These controls, similar to those on the XRef Object rollout on page 7474, let you change the file path, file name, and object name of the source of the XRef controller.

- **Highlight corresponding XRef Record in the XRef Object dialog** Opens the XRef Objects dialog on page 7456 and highlights the corresponding XRef record within.

**File Name controls**

- **File Name field** Displays the path and file name of the scene containing the source controller. You can edit this to point to a different path and file.
  
- **File Name display** Displays the file name only, without the path.
Path button Opens a file dialog from which you select a new file (either .max or .chr).

Object controls

Object Name field Displays the name of the source object pointed to in the source file which holds the source controller.

Object Name display Displays the file name of the source object.

Path button Opens an XRef Merge dialog on page 7471 pointing to the scene in the XRef File Name field. Here, you can specify a different object to be used as the XRef object.

status line Displays status information regarding the XRef controller:
- “Unresolved XRef, File Not Found”: Cannot find the scene file containing the specified object name.
- “Unresolved XRef, Object Not Found”: Cannot find the object in the specified scene.
- “XRef Resolved”: Both scene and object match.

Animation Constraints

An animation constraint is a special type of controller that can help you automate the animation process. You can use constraints to control an object’s position, rotation, or scale through a binding relationship with another object.

A constraint requires an animated object and at least one target object. The target imposes specific animation limits on the constrained object.

For example, to quickly animate an airplane flying along a predefined path, you can use a Path constraint on page 3596 to restrict the airplane’s motion to a spline.

You can use keyframe animation to toggle the constraint’s binding relationship with its targets over a period of time.
Common uses for constraints include:

- Linking one object to another over a period of time, such as a character’s hand picking up a baseball bat
- Linking an object’s position or rotation to one or several objects
- Keeping an object’s position between two or more objects
- Constraining an object along a path or between multiple paths
- Constraining an object to a surface
- Making an object point toward another object
- Keeping an object’s orientation in relation to another

**TIP** You can use Schematic View to see all the Constraint relationships in a scene.

**Using Constraints with Bones**

Constraints can be applied to bones as long as an IK controller is not controlling the bones. If the bones have an assigned IK controller, you can only constrain the root of the hierarchy or chain.

**Attachment Constraint**

Animation menu > Constraints > Attachment Constraint

The Attachment constraint is a position constraint that attaches an object’s position to a face on another object (the target object doesn’t have to be a mesh, but must be convertible to a mesh).
Attachment constraints keep the cylinders on the surface.

By keying different attachments over time, you can animate the position of an object over the irregular surface of another object, even if that surface is changing over time.

Procedures

Example: To attach a cone to a bending cylinder:

1. In the Perspective viewport, create a cylinder with a radius of 20, a height of 30, and 10 height segments.

2. In the Perspective viewport, create a cone with a radius 1 of 15, a radius 2 of 5, and a height of 30.
3 Select the cylinder, apply a Bend modifier, and set the bend angle to –70 degrees.

4 Turn on Auto Key, move to frame 100, and set the bend angle to 70 degrees.
   The cylinder bends from one direction to the other over 100 frames.

5 Turn off Auto Key.

Example continued: To assign the Attachment constraint and adjust the cone:

1 Select the cone.

2 On the Motion panel, open the Assign Controller rollout, click the Position track, click Assign Controller, and choose Attachment.
   The cone moves to the origin of the scene, and the Attachment Parameters rollout is displayed.

3 Click the Pick object, and then click the cylinder.
   The name of the cylinder is displayed above the Pick Object button.

4 Go to frame 0. Orbit the Perspective viewport so you can see the top surface of the cylinder.

5 Click Set Position, and click and drag over the faces on the top surface of the cylinder.
   The cone jumps to the top of the cylinder. As you drag the mouse, it jumps to whichever face you drag over.

6 Release the mouse when the cone is on the top surface of the cylinder.

Example continued: To adjust the position of the cone relative to the face:

1 Drag in the face display window to position the red x relative to the triangle representing the face. (Because of the radial arrangement of cap faces in a cylinder, the upper-left corner of the displayed triangle is the center of the cylinder cap. You can turn off Edges Only for the cylinder to see this.)

2 Adjust the A and B spinners to move the cone across the surface of the face.

3 Drag the time slider to various frames.
As the cylinder bends back and forth, the cone remains attached to its upper surface. Continue adjusting the A and B spinners and dragging in the face display window to adjust the cone's position.

4 Remember the number in the Face spinner, and then lower the spinner value until the cone leaves the cylinder cap and begins jumping around various areas of the cylinder.

The Face spinner specifies which face the cone is attached to. As you change its values, the cone moves to different faces on the cylinder.

5 Re-enter the original value in the Face spinner to return the cone to the top of the cylinder.

6 Play the animation.

The cylinder bends back and forth with a cone attached to its upper cap.

Interface

Parameters for this constraint are available on the Motion panel after the controller has been assigned.

**Attach To group**

<table>
<thead>
<tr>
<th>Attach To:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cylinder02</td>
</tr>
<tr>
<td>Pick Object</td>
</tr>
<tr>
<td>Align To Surface</td>
</tr>
</tbody>
</table>

**Object Name text** Specifies the target object to which the source object is attached.

**Pick Object** Selects and picks the target object in the viewports for the attachment.

**Align to Surface** Fixes the orientation of the attached object to the face where it's assigned. When this is turned off, the orientation of the attached object is not affected by the orientation of the face on the target object.
**Update group**

- **Update**: Updates the display.
- **Manual Update**: Enables Update.

**Key Info group**

- **Current Key**: Displays the current key number and lets you move to another key.
- **Time**: Displays the current frame, and lets you move the current key to a different frame.

**Position group**

- **Face**: Provides the index of the face to which the object is attached. Range=0 to 268435455.
- **A/B**: Contains the barycentric coordinates defining the position of the attached object on the face. Range=-999,999 to 999,999.
(display window) Shows the position of the source object within the attachment face. You can drag within this window to adjust the position of the object relative to the face.

**Set Position** Adjusts the placement of the source object on the target object. Drag over the target object to specify a face and a position within the face. The source object moves accordingly over the target object.

**TCB group**

![TCB group](image)

All of the items in this group are the same as in other TCB controllers on page 3563. The orientation of the source object is also interpolated and affected by these settings.

- **Tension** Range=0 to 50
- **Continuity** Range=0 to 50
- **Bias** Range=0 to 50
- **Ease To** Range=0 to 50
- **Ease From** Range=0 to 50

**Link Constraint**

Animation menu > Constraints > Link Constraint

A Link constraint is used to animate an object linking from one target object to another.
A link constraint enables the robot arms to pass a ball.

The Link constraint causes an object to inherit the position, rotation, and scale of its target object. In effect, it allows you to animate a hierarchical relationship, so that the motion of an object to which the Link constraint is applied can be controlled by different objects in the scene throughout an animation.

An example of using a link constraint is to pass a ball from one hand to another. Assume that at frame 0 the ball is in a character’s right hand. The hands are animated to meet at frame 50, when the ball is passed to the left hand, and then spread apart until frame 100. This is achieved by assigning the Link constraint to the ball, with the right hand as its target at frame 0, changing to the left hand as target at frame 50.
Procedures

Example: To assign the Link constraint and animate links:

1. Move the time slider to frame 0.
2. In the Top viewport, create a sphere, a cylinder and a box.
3. Select the sphere.
4. Open the Motion panel.
5. Expand the Assign Controller rollout.
7. Click Assign Controller.
8. Choose Link Constraint.
   This changes the Transform entry to Transform: Link Constraint and adds a child controller named Link Params: Position/Rotation/Scale, which becomes the immediate parent of the individual transform tracks. It also adds a controller track named Link Times: LinkTimeControl.
   The purpose of the LinkTimeControl controller is to expose the Link constraint keys in the track bar so they can be manipulated there.
   You can also assign the Link constraint from the Animation menu > Constraints submenu.
   It is recommended that you apply Link To World on page 3585 before linking to any target objects. This allows you to animate the object on its own, before the first link to a target object takes place.
9. On the Link Params rollout, click Link To World.
   This adds a World entry at frame 0 in the link list on the Link Params rollout.
10. Move the time slider to frame 1.
11. Click Add Link and select the cylinder.
    The cylinder becomes a target and is added to the link list. The Link constraint relationship is now active between the sphere and the cylinder.
12. Click Add Link again to turn it off.
13. Move the time slider to frame 50.
14. Turn on Auto Key and move the cylinder a good distance away from where it is.
15. Play back the animation.
   The sphere follows the cylinder as it moves. The sphere is link-constrained.
16. Select the sphere.
17. Move the time slider to frame 25.
18. On the Motion panel > Link Param rollout, click Add Link, select the box, and turn off Add Link.
   You have now added another target that becomes active at frame 25.
19. Turn off the Auto Key button and play back the animation. The sphere is linked to the cylinder from frame 0 to 24, so it follows the cylinder until frame 25, at which point it links to the box.
20. With the sphere selected, right-click one of the keys on the track bar and open the Delete Key submenu.
   Note the “Sphere01: Link Times” item. This is a special key made accessible on the track bar by the LinkTimes: LinkTimeControl controller. You can use these keys to modify link animation directly on the track bar, like regular animation keys, by dragging them on the time line or deleting them. However, unlike other animation keys, they cannot be cloned by Shift+dragging them.

To access the Link constraint’s parameters through the Motion panel:

1. Select the Link-constrained object.
2. On the Motion panel, expand the Link Params rollout, if necessary.
Once you assign a Link constraint, you can access its properties on the Link Params rollout in the Motion panel. In this rollout you can add and delete targets and animate the time at which each target becomes the active parent of the constrained object.

You can also modify the animation of link frames by manipulating the keys on the track bar and in Track View. However, standard methods for deleting keys in those contexts do not apply to link keys; you must use the Delete Link function on the Link Params rollout instead.

**Add Link** Adds a new link target.

After clicking Add Link, set the time slider to the frame at which to activate the link, and then select the object to link to. You can continue adding links
as long as Add Link is on; to exit this mode, right-click in the active viewport or click Add Link again.

**Link to World** Links the object to the world (the scene as a whole).
We recommend this be the first target in the list. This prevents the object from reverting to its independent creation or animation transforms if other targets are deleted from the list.

**Delete Link** Removes the highlighted link target. Once a link target is removed, it will no longer influence the constrained object.

**Start Time** Assign or edit the frame value of a target.
When you highlight a target entry in the list, Start Time shows the frame at which the object becomes a parent. To change when the link transfer takes place, adjust the value.

---

**TIP** You can also modify the animation of link frames by manipulating the keys on the track bar and in Track View.

---

**Key Mode group**

**NOTE** The options Key Nodes and Key Entire Hierarchy have no effect unless the object you are constraining is already part of a hierarchy. If you add objects to the hierarchy after you apply the Link constraint, you have to reapply the Link constraint using the key options you desire.

**No Key** When used, no keyframes are written to the constrained object or its targets. The link control happens without inserting any keys.

**Key Nodes** When used, keyframes are written to the specified option. There are two options: Child and Parents. Child sets a keyframe only on the constrained object. Parents sets keyframes for the constrained object and all of its targets.

**Key Entire Hierarchy** Sets keyframes up the hierarchy for the specified option. There are two options: Child and Parents. Child sets a keyframe only on the constrained object and its parents. Parents sets keyframes for the constrained object, its targets, and their upper hierarchy.

---

**LookAt Constraint**

Animation menu > Constraints > LookAt Constraint

---

LookAt Constraint | 3585
The LookAt constraint controls an object’s orientation so that it’s always looking at another object. It locks an object’s rotation so that one of its axes points toward the target object. The LookAt axis points toward the target, while the Upnode axis defines which axis points upward. If the two coincide, a flipping behavior may result. This is similar to pointing a target camera straight up.

LookAt constraints enable the antenna dishes to track the satellite.

An example of a LookAt constraint’s use would be to constrain the eyeballs of a character to a point helper. The eyes will then always be aimed at the point helper. Animate the point helper, and the eyes follow. Even if you rotate the character’s head, the eyes maintain their lock on the point helper.

**Multiple Targets and Weighting**

A constrained object can be influenced by several target objects. When using multiple targets, each target has a weight value that defines the degree by which it influences the constrained object, relative to other targets.

Using Weight is meaningful (and available) only with multiple targets. A value of 0 means the target has no influence. Any value greater than 0 causes the target to influence the constrained object relative to other targets' Weight.
settings. For example, a target with a Weight value of 80 will have twice the influence of a target with a Weight value of 40.

**Procedures**

**To assign a LookAt constraint:**

1. Select the object you want to constrain. This is the object that will be always looking at its target.
2. Choose Animation menu > Constraints > LookAt Constraint.
3. Select the target object.

**To access the LookAt constraint’s parameters through the Motion panel:**

1. Select the LookAt Constrained object.
2. On the Motion panel > Rotation list, double-click LookAt Constraint.
   The LookAt constraint parameters are located under the LookAt Constraint rollout.

**To edit weight values:**

1. Select the constrained object.
2. On the Motion panel > Rotation list, double-click LookAt Constraint.
   The LookAt constraint parameters are located under the LookAt Constraint rollout.
3. Click a target from the list.
4. Use the Weight spinner or enter a numerical value to adjust the weight value.

**To animate weight values:**

1. Select the constrained object.
2 On the Motion panel > Rotation list, double-click LookAt Constraint.
The LookAt constraint parameters are located under the LookAt Constraint rollout.

3 Click a target from the list.

4 Turn on the Auto Key button.

5 Use the Weight spinner or enter a numerical value to adjust the weight value.
Once you assign a LookAt constraint, you can access its properties on the LookAt Constraint rollout on the Motion panel. On this rollout, you can add or delete targets, assign weighting, assign and animate target weight values, and adjust other related parameters.

**NOTE** When you assign a LookAt constraint via the Animation menu, 3ds Max assigns a Rotation List controller to your object. In the list on the Rotation List rollout, you will find LookAt Constraint, which is the constraint you assigned. To view the LookAt Constraint rollout, double-click the LookAt Constraint entry in the list.

- **Add LookAt Target** Use to add new targets that influence the constrained object.
- **Delete LookAt Target** Use to remove target objects that influence the constrained object.
- **Weight** Use to assign and animate weight values for each target. Available only when multiple targets are used.
- **Keep Initial Offset** Maintains the constrained object’s original orientation as an offset to its constrained orientation.
- **Viewline Length** Defines the length of the main viewline drawn from the pivot of the constrained object to the pivot of its target (or the average, in case of multiple targets). A negative value draws the line from the constrained object in the opposite direction of the target or targets.
  
  With a single target, the length of the viewline is determined by the distance between the constrained object and the target, as well as the Viewline Length setting. However, if Viewline Length Absolute is on, the distance between the two has no effect on the length.
  
  The color of the viewline is defined by the Target Line element in the Gizmos category of the Colors panel on page 8272 in the Customize > Customize User Interface dialog on page 8249.

**NOTE** When multiple targets are assigned, additional viewlines drawn from the constrained object to each target object inherit the color of the respective targets. If Viewline Length Absolute is on, the length of each target-specific line is determined by its target’s Weight setting and the Viewline Length value. If Viewline Length Absolute is off, the length of each line is determined by the distance between the constrained object and the respective target, as well as the Viewline Length value. An additional (main) viewline, whose length and color are determined as specified above, indicates the actual, calculated orientation.
Viewline Length Absolute  When on, 3ds Max uses only the Viewline Length setting for the length of the main viewline; the distance between the constrained object and the target(s) has no effect.

Set Orientation  Lets you define the offset orientation of the constrained object manually. When on, you can use the Rotation tool to set the constrained object’s orientation. This orientation is then maintained as the constrained object looks at its target.

Reset Orientation  Sets the orientation of the constrained object back to the default. This is useful if you want to reset the constrained object’s orientation after having set the orientation manually.

Select LookAt Axis  Use to define the axis that looks at the target. The X,Y,Z check boxes reflect the constrained object’s local coordinate system. The Flip check box reverses the directions of the local axes.

Select Upnode  The default Upnode is the World. Turn off World to manually select an object that defines the Upnode plane. This plane is drawn from the constrained object to the Upnode object. If the LookAt Axis and the Upnode axis coincide, the constrained object will flip. Animating the position of the upnode object will move the upnode plane.

Upnode Control group:

Lets you quickly flip between LookAt Upnode Control and Axis Alignment.

LookAt  When selected the Upnode matches the LookAt target.

Axis Alignment  When this is selected the Upnode Aligns to the object axis. Choose which axis (X, Y or Z) in the Source Upnode Alignment group directly below Upnode Control.

Source/Upnode Alignment group

Source Axis  Chooses the constrained object’s axis that is to be aligned to the Upnode Axis. The Source Axis reflects the constrained object’s Local Axis. The Source Axis and LookAt Axis work together therefore the Axis used to define the LookAt Axis will be unavailable.

Aligned to Upnode Axis  Chooses the Upnode axis that the selected Source Axis aligns to. Note that the selected Source axis may or may not be able to completely align to the Upnode Axis.
Orientation Constraint

Animation menu > Constraints > Orientation Constraint

An Orientation constraint causes an object's orientation to follow the orientation of an object or averaged orientation of several objects.

Orientation constraints align the awning vanes to the supporting rod.

An Orientation Constrained object can be any rotatable object. When constrained it will inherit its rotation from a target object. Once constrained you can not rotate the object manually. You may move or scale the object as long as its not constrained in a manner that effects the object’s position or scale controller.

The target object can be any type of object. The rotation of a target object drives the constrained object. Targets can be animated using any of the standard translation, rotation, and scale tools.
Multiple Targets and Weighting

A constrained object can be influenced by several target objects. When using multiple targets, each target has a weight value that defines the degree by which it influences the constrained object, relative to other targets.

Using Weight is meaningful (and available) only with multiple targets. A value of 0 means the target has no influence. Any value greater than 0 causes the target to influence the constrained object relative to other targets’ Weight settings. For example, a target with a Weight value of 80 will have twice the influence of a target with a Weight value of 40.

 Procedures

To assign an Orientation constraint:

1. Select the object you want to constrain.
2. Choose Animation menu > Constraints > Orientation Constraint.

To access the Orientation constraint’s parameters through the Motion panel:

1. Select the Orientation-constrained object.
2. On the Motion panel > Rotation list, double-click Orientation Controller.
   The Orientation constraint parameters are located on the Orientation Constraint rollout.

To edit weight values:

1. Select the constrained object.
2. Open the Motion panel > Orientation Constraint rollout.
3. Click a target from the list.
4. Use the Weight spinner or enter a numerical value to set the weight value.
To animate weight values:

1. Select the constrained object.

2. Open the Motion panel > Orientation Constraint rollout, and choose a target from the list.

3. Turn on the Auto Key button.

4. Use the Weight spinner or enter a numerical value to set the weight value.
Once you assign an Orientation constraint, you can access its properties on the Position Constraint rollout in the Motion panel. In this rollout you can add or delete targets, assign weighting, assign and animate target weight values, and adjust other, related parameters.

**NOTE** When you assign an Orientation constraint via the Animation menu, 3ds Max assigns a Rotation List controller to your object. In the Rotation List rollout list you will find Orientation Constraint, which is the constraint you assigned. To view the Orientation Constraint rollout, double-click Orientation Constraint entry in the list.
Add Orientation Target Adds new target objects that influence the constrained object.

Add World as Target Aligns the constrained object to the world axis. You can weight the amount of influence that the world target has on the constrained object as you would any other target object.

Delete Orientation Target Remove targets. Once removing the target, it will no longer influence the constrained object.

Weight Assigns and animates weight values for each target.

Keep Initial Offset Preserves the original orientation of the constrained object. When you turn off Keep Initial Offset, the object adjusts itself to match the orientation of its target or targets. Default=off.

Transform Rule When an orientation constraint is applied to an object that is part of a hierarchy, this determines whether the local node transform or the parent transform will be used for the orientation constraint.

Local -> Local When selected, the local node transform is used for the orientation constraint.

World -> World When selected, the parent or world transform will be applied, rather than the local node transform.

Path Constraint

Animation menu > Constraints > Path Constraint

A path constraint restricts an object's movement along a spline or at an averaged distance between multiple splines.
A path target can be any type of spline. The spline curve (target) defines a path of motion for the constrained object. Targets can be animated using any of the standard translation, rotation, scale tools. Setting keys at a sub-object level of the path, such as vertex or segment, animates the path while affecting the constrained object.

**Multiple Targets and Weighting**

A constrained object can be influenced by several target objects. When using multiple targets, each target has a weight value that defines the degree by which it influences the constrained object, relative to other targets.

Using Weight is meaningful (and available) only with multiple targets. A value of 0 means the target has no influence. Any value greater than 0 causes the target to influence the constrained object relative to other targets' Weight settings. For example, a target with a Weight value of 80 will have twice the influence of a target with a Weight value of 40.
Procedures

To assign a Path constraint:
1. Create a Sphere with a radius of 10 and a Circle with a radius of 60.
2. With the Sphere selected, choose Animation menu > Constraints > Path Constraint.
   You are now in select target mode.
3. In the viewport, select the Circle shape.

To access the Path constraint’s parameters through the Motion panel:
1. Select the Sphere.
2. Open the Motion panel.
3. In the PRS Parameters rollout, click the Position button.
   The Path constraint’s settings are located in the Path Parameters rollout.

To assign a Path constraint through the Motion panel:
1. Create a Sphere with a radius of 10 and a Circle with a radius of 60.
2. Select the Sphere.
3. On the Motion panel and click Parameters.
4. Open the Assign Controller rollout and select the Position controller.
5. Click the Assign Controller button.
6. Choose Path Constraint from the Assign Position Controller dialog.
7. On the Motion panel, click Parameters.
8. In the Path Parameters rollout, click Add Path.
9. In the viewport, select the Circle.
To edit weight values:

1. Open the Create > Shapes panel and create a Line that is about 120 units long.

   **TIP** Use the diameter of the Circle to gauge the length of the Line.

2. Select the Sphere.

3. On the Motion panel, open the Path Parameters rollout.

4. Click the Add Path button and select the line.

   The Sphere is now affected equally by both paths since the path weighting defaults to 50

5. Adjust the Weight spinner or enter a numerical value for the weight value.

To animate weight values:

1. Select the Sphere.

2. On the Motion panel, open the Path Parameters rollout.

3. Turn on the Auto Key button.

4. Select the Line01 from the Path list.

5. Place the time slider at frame 50 and change the Weight of Line01 to 75.

6. Move the time slider at frame 100 and change the Weight of Line01 to 10.

7. Select the Circle01 path and change its Weighting to 25.

8. Turn off Auto Key and play the animation.

To correct path constrained object flipping:

When an object is assigned a path constraint and the follow box is turned on, the object will rotate as it moves along the path. Sometimes the object is subject to unwanted flipping.

1. Select the object that is flipping.
2 On the Animation menu choose Constraints > Orientation constraint, then constrain the object to another object’s orientation.

3 Use the control object to adjust the flipping. Animate the orientation of the control object, while watching the flipped object at the problematic frames.

Interface

Once you assign a Path constraint, you can access its properties on the Path Parameters rollout in the Motion panel. In this rollout you can add or delete targets, assign weighting, and animate each target’s weight value.
When you assign a Path constraint via the Animation menu, 3ds Max assigns a Position List controller to your object. In the Position List rollout list you will find Path Constraint. This is the actual path constraint controller. To view the Path Parameters rollout with the constraint settings, double-click Path Constraint in the list.

**Add Path** Adds a new spline path that influences the constrained object.

**Delete path** Removes a path from the target list. Once removing the path target, it will no longer influence the constrained object.

**Weight** Assigns and animates weight values for each target.

**% Along Path** Sets the percent that the object is positioned along the path. This duplicates the Value spinner in the track Properties dialog for the Percent track in Track View. If you want to set keys to place an object at a certain percent along the path, turn on Auto Key, move to the frame where you want the key set, and adjust the % Along Path spinner to move the object.

The % Along Path value is based on the parameterization of the spline path’s U value. A NURBS curve might not have an evenly spaced U value, so a value of 50 % Along Path might not translate visually to 50 per cent of the NURBS curve’s length.

**Follow** Aligns the object to the trajectory as it follows the contour.

**Bank** Allows the object to bank (roll) as it negotiates the curves of the spline.

**Bank Amount** Adjusts the amount of the banking to one side or the other, depending on whether the value is positive or negative.

**Smoothness** Controls how rapidly the roll angle changes as the object moves through bends in the trajectory. Smaller values will make the object more responsive to subtle changes in the curve, while larger values smooth out jerking. The default value is a good value for general damping along the curve. Values below 2 tend to make the action jerky, but values around 3 can be very useful for simulating a certain degree of realistic instability.

**Allow Upside Down** Turn on to avoid the situation in which an object flips when going around a vertically oriented path.

**Constant Velocity** Provides a constant velocity along the path. When off, the velocity of the object along the path varies depending on the distance between the vertices on the path.

**Loop** By default, when the constrained object reaches the end of a path it can no longer move past the end point. The loop option changes this behavior.
so that when the constrained object reaches the end of the path it loops back to the starting point.

**Relative** Turn on to maintain the original position of the constrained object. The object will follow the path with an offset distance based on its original world space position.

**Axis** Defines which axis of the object is aligned to the trajectory of the path.

**Flip** Turn on to flip the direction of the axis.

The following controls are located on the Hierarchy panel while the IK button is active:

- **Active** Activates an axis (X/Y/Z). Allows the selected object to animate along the activated path.
- **Limited** Limits the range of motion allowed on an active path. Use in conjunction with the From and To spinners.
- **Ease** Causes a joint to resist motion as it approaches its From and To limits. Simulates an organic joint, or worn mechanical joint, moving or rotating freely in the middle of its range of motion but moving less freely at the extremes of its range.
- **From and To Spinners** Determine for path limits. Use in conjunction with the Limited function.
- **Damping** Applies resistance over a joint’s motion along the path. Simulates the natural effect of joint friction or inertia.

**Position Constraint**

Animation menu > Constraints > Position Constraint
A position constraint causes an object to follow the position of an object or the weighted average position of several objects.

Position constraints align the elements of the robot assembly.

In order to activate, a position constraint requires an object and a target object. Once assigned the object becomes constrained to the target object’s position. Animating the target’s position causes the constrained object to follow.

Each target has a weight value defining its influence. A value of 0 is equal to off. Any value greater than 0 will cause the target to influence the constrained object. Weight values can be animated to create effects such as a ball being picked up from a table.

**Multiple Targets and Weighting**

A constrained object can be influenced by several target objects. When using multiple targets, each target has a weight value that defines the degree by which it influences the constrained object, relative to other targets.

Using Weight is meaningful (and available) only with multiple targets. A value of 0 means the target has no influence. Any value greater than 0 causes the target to influence the constrained object relative to other targets’ Weight
settings. For example, a target with a Weight value of 80 will have twice the influence of a target with a Weight value of 40.

For example, if a sphere is Position-constrained between two targets and each target’s weight value is 100, the sphere will maintain an equal distance between both targets even when they are in motion. If one of the weight values is 0 and the other is 50, then the sphere is influenced only by the target with the higher value.

**Procedures**

**To assign a Position constraint:**

1. Select the object you want to constrain.
2. Choose Animation menu > Constraints > Position Constraint.
3. Select the target object.

**To access the Position constraint’s parameters through the Motion panel:**

1. Select the Position-constrained object.
2. On the Motion panel, on the Position list, double-click Position Constraint.
   The Position constraint parameters are located under the Position Constraint rollout.

**To edit weight values:**

1. Select the constrained object.
2. On the Motion panel, on the Position list, double-click Position Constraint.
   The Position constraint parameters are located under the Position Constraint rollout.
3. Click a target from the list.
4. Adjust the Weight spinner or enter a numerical value for the weight value.
To animate weight values:

1. Select the constrained object.

2. On the Motion panel, on the Position list, double-click Position Constraint.
   The Position constraint parameters are located under the Position Constraint rollout.

3. Click a target from the list.

4. Turn on the Auto Key button.

5. Adjust the Weight spinner or enter a numerical value for the weight value.

Example: To assign a Position constraint with two targets and editing weights:

1. In the Top viewport, create a sphere, a box, and a cylinder so that the box is between the sphere and the cylinder.

2. Click to select the box, assign a Position constraint, and select the sphere as the target.

3. Click to select the box, assign a Position constraint, and select the cylinder as the target.
   The box is now position-constrained between the two targets.

4. In the Top viewport, move the sphere around.
   As the sphere moves, the box maintains an equal distance between the sphere and the cylinder. This is because the weight values for both targets are equal. By default the values are 1.00. If the sphere had a higher weight value than the cylinder, the sphere would influence the box more than the cylinder.

5. To edit the weight values, select the box.

6. Open the Motion panel and view the Position Constraint rollout.

7. Click the Cylinder's name in list of targets.

8. Using the Weight spinner, change the value from 50 to 20.
   As the value decreases, the box moves closer to the sphere.
In the Top viewport, select the cylinder and move it around.

In the Top viewport, select the sphere and move it around.

The sphere has more influence over the box's movement than the cylinder.

### Interface

![Position Constraint Interface]

Once you assign a Position constraint, you can access its properties on the Position Constraint rollout in the Motion panel. In this rollout you can add or delete targets, assign weighting, and animate each target's weight value.

**NOTE** When you assign a Position constraint via the Animation menu, 3ds Max assigns a Position List controller to your object. In the Position List rollout list you will find Position Constraint. This is the actual Position Constraint controller. To view the Position Constraint rollout, double-click Position Constraint in the list.

**Add position target** Adds new target objects that influence the position constrained object.
**Delete position target** Removes targets. Once a target is removed, it will no longer influence the constrained object.

**Weight** Assigns and animates weight values for each target.

**Keep Initial Offset** Use Keep Initial Offset to preserve the original distance between the constrained object and the target object. This prevents the constrained object from snapping to the target object’s pivot. The default is Off.

---

**Surface Constraint**

Animation menu > Constraints > Surface Constraint

Animation menu > Track View > New/Open Track View > Select a position track in Track View Hierarchy. > Track View toolbar > Assign Controller > Surface

The Surface constraint positions an object along the surface of another object.

![Surface constraints position the weather symbols on the globe.](image)
The type of object that can be used as the surface object is limited to those whose surfaces can be represented parametrically. Use the Surface constraint with the following types of objects:

- Sphere
- Cone
- Cylinder
- Torus
- Quad Patches (single quad patches)
- Loft object
- NURBS object

The surface used is a "virtual" parametric surface, and not the actual mesh surface. Objects with a low number of segments might have a mesh surface quite different than the parametric surface.

The parametric surface ignores Slice and Hemisphere options. So if the object is sliced, for example, the controlled object will position itself as if the missing portion were still there.

Since the Surface constraint only works on parametric surfaces, if you apply a modifier that converts the object to a mesh, the constraint will no longer work. For example, you can’t use it with a cylinder with a bend modifier applied.

**Procedures**

**Example: To animate a sphere over the surface of a cylinder:**

1. In the Top viewport, create a cylinder and a sphere.

2. Select the sphere, open the Motion panel, expand the Assign Controller rollout, and then expand the Transform heading in the list.

3. In the list window, click the Position item and then click Assign Controller.
4 In the Assign Position Controller dialog, choose Surface and then click OK.
The Surface Controller Parameters rollout replaces the Key Info rollout.

5 Click Pick Surface, and then select the cylinder.

6 Turn on Auto Key, and place the time slider at frame 0.

7 Use the V Position spinner to move the sphere to a starting position at the bottom of the cylinder.

8 Place the time slider at frame 100.

9 Use the V Position spinner to place the sphere at the top of the cylinder.

10 Set U Position to 300.
   Turn off Auto Key and play the animation. The sphere moves over the surface of the cylinder in a helical path.

Interface

The Surface Constraint Parameters rollout is on the Motion panel.

Current Surface Object group

This group provides a method for selecting and then displaying the selected surface object.
Text Displays the name of the selected object.

Pick Surface Selects the object you want used as a surface.

Surface Options group

This group provides controls for adjusting the position and orientation of the object along the surface.

U Position Adjusts the position of the controlled object along the U coordinates of the surface object.

V Position Adjusts the position of the controlled object along the V coordinates of the surface object.

No Alignment When on, the controlled object is not reoriented, regardless of its position on the surface object.

Align to U Aligns the local Z axis of the controlled object with the surface normal of the surface object, and the X axis with the U axis of the surface object.

Align to V Aligns the local Z axis of the controlled object with the surface normal of the surface object, and the X axis is aligned with the V axis of the surface object.

Flip Flips the alignment of the local Z axis of the controlled object. This check box is not available if No Alignment is turned on.

Wire Parameters

Select an object. > Animation menu > Wire Parameters > Wire Parameters

Select an object. > Right-click quad menu > Transform (lower-right) quadrant > Wire Parameters

Wire Parameters lets you link parameters from one object to another in the viewport, so that adjusting one parameter changes the other automatically. This enables you to set up one- and two-way connections between specified object parameters, or to control one or more objects with a dummy object containing the desired parameters. By wiring parameters, you can set up custom constraints directly without having to go to Track View and assign controllers.

Parameter wiring is accessible from the Animation menu and the quad menus on page 8052. The Wire Parameters command is available only if a single node
is selected. Choosing the Wire Parameters command displays a hierarchical pop-up menu with levels and items corresponding to the animatable tracks that would be visible for that object in Track View.

When you make a parameter selection, a dashed line, similar to that displayed in the Select and Link mode on page 3631, is drawn from the selected object to the mouse cursor. The cursor changes from an arrow to a cross whenever it is over a valid destination object. You can right-click at any time to cancel the parameter wiring.

While the dashed line is displayed, you can click a destination node or on empty space in the viewport to customize the relationship between two wired parameters. If you click empty space, the Parameter Wiring dialog on page 3612 opens showing the first parameter in the left Tree View and the full scene in the right tree. Clicking a destination node (which can be the same as the originating node) displays a hierarchical pop-up menu for the destination object so you can choose the destination parameter. After you choose a second parameter, the Parameter Wiring dialog opens.

You can wire one-way and two-way connections between parameters. For one-way wires, one parameter is effectively slaved to the other and its value changes as the controlling parameter changes, according to a user-defined transfer expression. The controlling parameter can be animated and adjusted as needed using all the animation tools in 3ds Max. This includes making it a controlled parameter in another parameter-wiring setup, so that you could potentially set up a chain of controlled parameters.

For two-way wiring, 3ds Max assigns Wire controllers of the appropriate kinds to each of the parameters and they are cross-linked so that changing either parameter cause linked changes in the other.

**NOTE** You should establish all object hierarchies before wiring parameters in a scene. If you change the hierarchy of an object that has a wired parameter, it will take on new parameters, which could introduce undesired results in your wired parameters.

**TIP** Use Schematic View on page 7926 to see all the wired parameter relationships in a scene. You can also use Schematic view to wire parameters.

**Procedures**

**To attach wire parameters:**

1. Select the first object you want to use.
2 Choose Animation menu > Wire Parameters > Wire Parameters, or right-click the object and choose Wire Parameters.
A pop-up menu displays the parameters you can link.

**NOTE** Wire Parameters works only with parameters that can be animated. The menu options displayed depend upon the selected object and are the same options you would see for the selected object in Track View.

3 Choose the parameter you want to link to another object from the displayed menu.
A dashed line appears.

4 Move the cursor to the second object you want to use. When the cursor changes from an arrow to a selection cross, you are over a valid destination object. Click to select the destination object.
A pop-up menu displays the parameters to which you can link.

5 Choose the parameter you want to link from the displayed menu.
The **Parameter Wiring dialog** on page 3612 opens, with the two parameters you selected highlighted in yellow.

6 If you like, change the parameter highlighting in the dialog, and then click the direction buttons between the two panels to determine the control direction: one way either way, or both directions (changes to either object’s selected parameters affect the other object).

7 Click Connect to complete the wiring.

**Parameter Wiring Dialog**

Animation menu > Wire Parameters > Choose parameters to wire.

Select an object. > Right-click quad menu > Transform (lower-right) quadrant > Wire Parameters > Choose parameters to wire.

Select an object. > Modify panel > Right-click text box portion of animatable parameter spinner. > Choose Show In Parameter Wire dialog.

Select an object with a wired parameter. > Modify panel > Right-click text box portion of a two-way-wired on page 3616 parameter > Edit Wire

The Parameter Wiring dialog allows you to define the relationships for Wire Parameters on page 3610. In this dialog, you can create new one and two-way
control relationships between object parameters, edit existing relationships, and create or edit expressions which define the parameter relationships.

Only parameters that can be animated can be wired. Sub-objects, such as vertices, must be animated before they can be wired.

Parameter wires can be used to establish connections from Manipulators on page 2861 and Custom Attributes on page 307 to objects, materials, and modifiers.

**NOTE** Parameter Wiring is a [modeless dialog](#) on page 8641, and you can have several dialogs open at the same time.

### Procedures

**Example: To use an expression with wire parameters:**

1. Create a box and a sphere in your scene.
2. Right-click the box, and from the quad menu choose Transform quadrant > Wire Parameters.
3. From the pop-up menu, choose Object (Box) > Length. A rubber-band dashed line now connects the box and the mouse cursor.
4. Click the sphere and choose Transform > Position > Z Position from the pop-up menu. The position of the sphere and the length of the box are now wired.
5. In the Parameter Wiring dialog, create a one-way wire by clicking the arrow pointing toward the box’s tree view.
6. Type `abs(Z_Position)` in the expression text box for Box01, so that the entire expressions is `abs(Z_Position)`.
7. Click Connect.
8. Move the sphere upward along the Z axis in the viewport. Note that as the sphere moves in the viewport, the length of the box changes. Using `abs()` ensures that the box never has a negative length.

**To control several slave parameters from one master parameter:**

1. Open the Parameter Wiring dialog.
2. Choose the master parameter in the tree view.
Choose the first slave parameter in the other tree view.

Click the arrow pointing toward the slave parameter.

Enter the desired relationship expression in the expression text box.

Click Connect.

Keeping the master parameter selected, choose another slave parameter from the tree view.

Click the arrow pointing toward the slave parameter.

Enter the desired relationship expression in the expression text box.

Click Connect.

You can repeat this cycle to set up as many slaves as you want. The result is a “fan” of parameter wires, so that you can control all of the slave parameters at once as you change the master parameter.

To create a chain of wired parameters:

Open the Parameter Wiring dialog.

Choose the first controlling parameter in one tree view.

Choose the first slave parameter in the other tree view.

Click the arrow pointing toward the slave parameter.

Enter the desired relationship expression in the expression text box.

Click Connect.

Keeping the original slave parameter selected, choose the next slave parameter from the tree view.

Click the arrow pointing toward the new slave parameter.

Enter the desired relationship expression in the expression text box.

Click Connect.

You can repeat this cycle, continuing to alternate slaves to masters as many times as you like. The result is a “daisy chain” of parameter wires, so that as you modify the original master parameter, each slave parameter maintains a constant relationship with the next in a line of parameters.
Interface

Tree Views

The dialog presents two tree views that display the animatable parameters of all of the visible objects in the scene. The names of the currently selected objects appear at the top. The tree views display the objects in the scene and allow you to select and wire all of the animatable parameters of the objects in the scene and the scene itself.

The tree views are color-coded to show existing wiring. A parameter with a wire controller assigned to it (either as the member of a two-way pair or as the slave in a one-way wire) displays in red. When a wire-controlled parameter is selected, all of the parameters wired directly to it are displayed in green text in the other Tree View. In either case, if the parameter is inside a track that is not expanded, the enclosing track will display in red or green, so you can expand the tracks to find the wires.

NOTE If you open the Parameter Wiring dialog by wiring two parameters, the tree views initially display only the selected objects, highlighting the parameters that you chose from the pop-up menus during the wiring procedure. If you want to expand the trees, to include all other animatable parameters in the scene, click Show All Tracks.

The buttons above the tree views are:

Show All Tracks Brings you to the top of the scene object list.
**Find Next Parameter** Finds the next wired parameter in the scene, expanding the tree if necessary to show and select it. You can browse through all existing wires by clicking this button repeatedly.

**NOTE** If you click a wired parameter, its connections are shown in green on the other tree view. While the wired parameter is highlighted, the Show Next Wire button on the other tree cycles through the green connections only, so you can quickly find the selected wire’s connections.

**Refresh Tree View Content to Selected Node** Shows only the node or nodes that are selected in the scene in the tree view. The nodes are shown as currently expanded.

**Control Direction** The Parameter Wiring dialog provides three direction-control buttons between the tree views. You can choose only one of these at a time. These buttons determine the direction of control, either one-way or two-way:

- **Two-way connection** [two-headed arrow] Click this to link both parameters to each other, so that changing either parameter affects the other.

- **One-way connection: right parameter controls left parameter** [left arrow] The right parameter controls the left parameter.

- **One-way connection: left parameter controls right parameter** [right arrow] The left parameter controls the right parameter.

**NOTE** You can change the direction of a wire at any time by clicking the desired direction button and then clicking Connect or Update.

**Connect/Update** The Connect/Update button changes its label depending on whether clicking it would add a new wire to previously unwired parameters (Connect) or change an existing wire’s expressions or direction (Update). Changes to existing wires are only applied when you click Update.
**Disconnect**  

**Disconnect** The Disconnect button is enabled when you’ve selected parameters with an existing wire between them. It will remove the wire controller(s) and replace them with the Master parameter’s animation track (if two-way) or with default controllers (if one-way).

**Master parameters**

The Parameter Wire system provides a way for the pair of wired parameters to be animated as a single system. It does this by setting up a subcontroller on one of the parameters; any animation on this controller drives the Wire Controller pair. The animation subcontroller is always assigned to the master parameter of the wired pair. By default, this is the parameter that is clicked first in the wiring interaction. The master parameter can also be designated with the Master radio buttons beneath the tree views.

The animation subcontroller appears as a nested track inside the master parameter’s track in Track View and its values directly drive and match the master parameter values. If the subcontroller is keyframable (which is the default when a two-way wiring is first established) it can be keyframed by adjustments of either of the wired parameters. This means that if you keyframe the wired pair by adjusting the non-master parameter, the values keyframed into the animation subcontroller are derived from the master parameter transfer expression. Since the wired pair can be animated through either parameter, the choice of master parameter is essentially just a convention.

**Transfer Expression boxes**

Underneath the parameter trees are the transfer expression text boxes. These expressions determine how changes to each parameter affect the other and are usually inverses of one another.

For more information on expression syntax, see the topic “Script Controllers” in the MAXScript Help.

When the parameters are first wired, the default expressions are simple 1-to-1 links between the parameters. These expressions can be edited into any valid script fragment that will yield a result of the correct type for its parameter. For example, if you link a parameter such as height (which contains a float value) to a parameter such as position (which contains a point3 value), your expressions must include conversions that produce the same output value type.

For one-way wires, the Expression box for the controlling parameter is unavailable, since there is no Wire controller assigned to it.
For two-way wiring, both transfer expression text boxes will be enabled. It is possible for the user to supply transfer expressions for the two parameters that are not inverses of one another, but this is of course discouraged, since the relationship of the parameters will be different depending on which one is changed first.

Hierarchies and Kinematics

When you animate characters (whether humanoid or otherwise), mechanical assemblies, or complex motion, you can simplify the process by linking objects together to form a hierarchy or chain. In a linked chain, the animation of one member can affect some or all of the others, making it possible to animate a number of objects or bones at once.

The term kinematics describes the movement or animation of the chain. There are two types of kinematics:

- With forward kinematics, you transform a parent object to move its descendants (its children, their children, etc.).
- With inverse kinematics, you transform a child object to move its ancestors (its parent and so on up the chain). You can also use IK to make an object “stick” to the ground or another surface, while allowing the chain to rotate off the pivot of that object.

Forward kinematics is the most straightforward method for animating hierarchies. Inverse kinematics requires more setup than forward kinematics, but is more intuitive for complex tasks such as character animation or intricate mechanical animation.

Hierarchies

One of the most useful tools in producing computer animation is the ability to link objects together to form a chain. By linking one object to another, you create a parent-child relationship. Transforms applied to the parent are also transmitted to child objects. A chain is also referred to as a hierarchy.
You can find the commands to build and manipulate hierarchies in the following places in the interface:

- The **Select and Link** on page 3631 and **Unlink Selection** on page 3632 buttons let you make and break links between objects in your scene.

- The **Bones system** on page 857 in the Create panel > Systems category lets you create a hierarchy of bones. You can also create bones by choosing **Bone Tools** on page 871 from the **Animation menu** on page 8023. You can turn any hierarchy of objects into bones by selecting the hierarchy and turning on Bone Tools dialog > Object Properties rollout > Bone On.

- The **Hierarchy panel** on page 8213 contains commands to control how links behave.

- The **Motion panel** on page 3714 contains commands to control how links behave when using an History Dependent (HD) Solver.
Common Uses for Hierarchies

- Link a large collection of objects to a single parent so they can be easily animated and transformed by moving, rotating, or scaling the parent.
- Link the target of a camera or light to another object so it tracks the object through the scene.
- Link objects to dummy objects to create complex motions by combining multiple simple motions.
- Link objects to simulate jointed structures to animate characters or mechanical assemblies.

Parts of a Hierarchy

The relationship between objects linked together in a hierarchy is analogous to a family tree.

**Parent** Object that controls one or more children. A parent object is often controlled by another superior parent object. In the following figure, objects 1 and 2 are parent objects.

**Child** Object controlled by its parent. A child object can also be a parent to other children. In the following figure, objects 2 and 3 (the support and hub) are children of object 1. Objects 5 (the seats) are children of object 4, the Ferris wheel.

**Ancestors** Parent and all of the parent's parents of a child object. In the following figure, objects 1 and 2 are ancestors of object 3.
The seats of the Ferris wheel are children of the wheel, which is in turn a child of the base and support objects, as shown in the following hierarchy.

**Descendants** Children and all of the children’s children of a parent object. In the figures, all the objects are descendants of object 1.

**Hierarchy** Collection of all parents and children linked together in a single structure.

**Root** Single parent object that is superior to all other objects in the hierarchy. All other objects are descendants of the root object. In the figures, Object 1 is the root.

**Subtree** All the descendants of a selected parent. In the figure below, the Rotational Hub, Ferris Wheel, and Seats represent the subtree under the Support object.
1. Root
2. Leaves
3. Subtree

Example of a hierarchical structure

**Branch** Path through the hierarchy from a parent to a single descendant. In the figure above, the Support, Rotational Hub, and Ferris Wheel objects comprise a branch from the root to the leaf objects (the seats).

**Leaf** Child object that has no children. The lowest object in a branch. In the figure above, the Seat objects are leaf objects.

**Link** Connection between a parent and its child. A link transmits position, rotation, and scale information from parent to child.

**Pivot** Defines the local center and coordinate system for each object. You can think of a link as the connection between the pivot of a child object and the pivot of its parent.
Linking Strategy

Before you begin linking any but the simplest hierarchy you should take a few minutes to plan your linking strategy. Your choices for the root of the hierarchy and how the branches grow out to the leaf objects will have important effects on the usability of your model.

The strategy behind linking objects into a hierarchy can be reduced to two main principles:

- The hierarchy follows a logical progression from parent to child.
- Parent objects move less than their descendants.

Within these two principles you have almost unlimited flexibility as to how you link your objects. If you think about how you intend to use the hierarchy, and link it with that use in mind, you will rarely have a problem.

Progression from Parent to Child

Progression from parent to child means the links do not erratically jump from object to object. If two objects touch each other they should probably be linked as parent and child. There is nothing to prevent you from linking a body in the order of: Thigh->Foot->Shin->Waist. You would probably regret such a linking strategy later. The effort to figure out how to transform objects linked in such a strange way would be quite difficult. A more logical progression would be Foot->Shin->Thigh->Waist.

Using Multiple Hierarchies

Rather than build a single bone chain from a hip to a toe, you can make one chain from the hip to the ankle, and then a second independent chain from the heel to the toe. You would then link the chains together to form a complete leg assembly.

Because they are linked together, the leg and foot chains could be considered one chain. However, the way you animate them treats each chain separately, allowing fine control over the parts.

With this type of arrangement on leg and foot chains, the foot could be made to stay on the ground while the leg bends. It also allows for independent control of the foot’s rotation, pivoting on the heel or toe, which would then cause the knee to bend.
Parents Move Less Than Descendants

Because of the way transforms are inherited from parent to child, small adjustments to a parent object might require you to adjust all of its descendants. The typical approach to linking is to choose as your root object the object that moves the least. Objects close to the root should move very little, and leaf objects should move the most.

This is especially true when you are linking jointed structures like robots or machinery, or intend to use the hierarchy with inverse kinematics on page 3661.

An exception to this rule occurs when you are using the root object as a handle. All of the descendants of the root are just along for the ride. Consider a tray full of objects traveling on a conveyor belt. All the objects should be children of the tray even though the tray moves much more than any of the other objects.

Choosing the Root of a Hierarchy

You can find the best candidate for the root of your hierarchy by asking the following question:

If I move this object, should all of the other objects in the hierarchy move with it?

- If the answer is almost always, then you are looking at a likely candidate for the root object. Examples of this type of object are a torso, a lamp base, and a tree trunk.
- If the answer is not often, then you are probably looking at a child object. Examples of this type of object are hands, lamp shades, and tree leaves. If you move a character's hand, for example, its torso should not move.

Once you have a few candidates for the root object, you can examine them in greater detail. Use these criteria to determine a good root object for your hierarchy:

- Moving the root object usually has a great effect on all other objects in the hierarchy.
- Conversely, the root object is mostly unaffected by movement of other objects in the hierarchy.
- The root object is rarely animated, and is moved or rotated primarily to place the hierarchy at the correct place in the scene.
The root object is at or near the hierarchy’s virtual center of mass.

The object that best satisfies these criteria is your root object. You then create your hierarchy with all of the other objects as descendants of that root object.

**Linking Objects for Inverse Kinematics**

Inverse kinematics (IK) uses the child object as the driving force for the animation. IK is less forgiving and is highly dependent on the linking strategy for performing calculations.

You need to consider two additional principles when linking hierarchies for use with inverse kinematics:

- Links and pivot placement simulate real-world joint locations.
- Choose an object near the structure’s center of mass, or center of gravity, as the root of the hierarchy. The center of mass in the real world is the point on an object about which reactions to external forces are applied.
1 and 2 each represent the root of the characters.

Both structures are suitable for forward kinematics.

The structure on the right is best for most inverse kinematics.

The figure above shows two approaches to linking a skeletal structure. Either structure is suitable for working with forward kinematics. The structure on the right, however, is a better choice for working with inverse kinematics.

- The root object is located near the body’s center of mass.
- The link order more closely simulates the connections of a real body.
The structure on the left has the arms and torso linked to the neck. The structure on the right links the arms and neck to the torso, a more realistic approach.

**WARNING** Be sure to avoid using non-uniform scaling on objects in a hierarchy that will be animated using IK. You will see stretching and skewing if you do. Instead do all non-uniform scaling at the sub-object level, to avoid this problem. Use Reset XForm if you have objects that exhibit this behavior.

**Linking Objects After Animation**

When you link an object to another, the link relationship between the child and its parent is determined by the position, rotation and scale of the parent and child objects when the link is made.

Imagine linking a stationary sphere to an animated box.

- At frame 0 the box is beside the sphere.
- At frame 50 the box is 20 units away.

![Original animation, with ball unlinked and stationary while the box moves.](image)
Linking the sphere to the box causes the sphere to move with the box. The distance between the sphere and the box depends on the frame when the link is made. Linking the sphere on different frames has the following effects:

- Link on frame 0, and the sphere stays next to the box as it moves.
- Link on frame 50, and the sphere stays a distance 20 units away from the box as it moves.

Unlinking Objects After Animation

When you unlink a child, its frame 0 transforms are taken from the transforms of its parent at the frame when the link is removed.

Imagine a sphere linked to a box moving around the face of a clock. The box starts at 12 o’clock and travels all the way around the face over 100 frames. The figure shows a box moving in a circle with a sphere linked above it.
Original animation, with ball linked to follow the animated box.

If you unlink the sphere, it stops following the box. The position of the sphere depends on its position, rotation or scale at the frame on which the link is removed. Unlinking the sphere on different frames has the following effects:

- Unlink on frame 0, and the sphere stays at 12 o'clock.
- Unlink on frame 25, and the sphere stops at 3 o'clock.
- Unlink on frame 75, and the sphere stops at 9 o'clock.
Clockwise from top, position of the sphere unlinked at frame 0, 25 and 75, respectively.

**Linking and Unlinking Objects**

Use Select and Link on page 3631 and Unlink Selection on page 3632 on the toolbar to make and remove links between objects.

**Linking Objects**

The general process of creating links is to build the hierarchy from child to parent. You click Select And Link on the toolbar, select one or more objects as children, and then drag the link cursor from the selection to a single parent object. The selected objects become children of the parent object.
Once objects are linked, any transformations applied to the parent are also applied to its children. For example, if you scale the parent to 150%, the size of its children and the distance between the children and the parent are also scaled by 150%.

**Unlinking Objects**

Click Unlink Selection to remove the link from selected objects to their parents. Any children of the selected object are unaffected.

You can quickly unlink an entire hierarchy by double-clicking the root object to select the object and all of its children. Then click Unlink Selection.

**Linking Animated Objects**

You should establish links before you begin animating objects. The linkage of objects with Select and Link cannot be animated; the link remains in force throughout the entire animation.

If you want your objects to be linked during one part of the animation but not another, you can a Link constraint on page 3580 to change the linkage at specific frames.

**Displaying Links**

A complex mesh hierarchy can be displayed with the links visible, or even with the links replacing the mesh objects. To display links, first select the linked objects. On the Display panel > Link Display rollout on page 169, turn on Display Links to see the links. You can also turn on Link Replaces Object to see only the links and not the objects.

**Select and Link**

Main toolbar > Select and Link

Use the Select and Link button to define the hierarchical relationship on page 8599 between two objects by linking them as child and parent.

You link from the currently selected object (child) to any other object (parent).
You can link an object to a closed group. When you do, the object becomes a child of the group parent rather than any member of the group. The entire group flashes to show that you’ve linked to the group.

A child inherits the transformations (move, rotate, scale) applied to the parent, but the child’s transformations have no effect on the parent. If you want the child not to inherit the transforms, use the Link Inheritance (Selected) Utility on page 3660 or use the controls found in Link Info on page 3787 in the Hierarchy panel.

You can also create hierarchical linkages using Schematic View on page 7922. Use the Connect button on the Schematic View toolbar to create hierarchical linkages between nodes.

**Procedures**

To link two objects:

1. Click Select and Link.
2. Drag a line from an object (the child) to any other object (the parent).

   **NOTE** You do not need to select the child object first.

**Unlink Selection**

Main toolbar > Unlink Selection

Use the Unlink Selection button to remove the hierarchical relationship on page 8599 between two objects.

Unlink Selection detaches a child object from its parent object.

**TIP** You can also link and unlink hierarchies in Schematic View on page 7926.

**Procedures**

To unlink a child object from a parent object:

1. Select the child object you want to unlink.
Click Unlink Selection.

**Adjusting Pivots**

You can think of an object's pivot point as representing its local center and local coordinate system.

The pivot point of an object is used for a number of purposes:

- As the center for rotation and scaling when the Pivot Point transform center is selected.
- As the default location of a modifier center.
- As the transform offset for linked children.
- As the joint location for IK.

You can adjust pivot points by clicking Pivot on the Hierarchy panel, and then using the Adjust Pivot rollout on page 3763 tools.

The functions on the Adjust Pivot rollout cannot be animated. Adjusting an object's pivot on any frame changes it for the entire animation.

**See also:**

- [Working Pivot Rollout on page 3766](#)

**Affecting Pivot Only**

When Affect Pivot Only is on, move and rotate transforms are applied only to the pivot of a selected object.

- Moving or rotating the pivot does not affect the object or its children.
- Scaling the pivot scales the object from the pivot center, but its children are unaffected.
Affect Pivot Only transforms the pivot without moving the object.

Affecting Object Only

When Affect Object Only is on, transforms are applied only to selected objects. Pivots are not affected.

Moving, rotating, or scaling the object does not affect the pivot or its children.
Affect Object Only transforms the object without moving the pivot.

**Affecting Hierarchy Only**

When Affect Hierarchy Only is on, rotate and scale transforms are applied only to the links between objects and their children.

- Scaling or rotating an object affects the link offsets of all its descendents without affecting the geometry of the object or its descendents. The descendents shift position because of the scaled or rotated links.

Use this technique to adjust the offset relationship between linked objects. Use this technique to adjust the offset relationship between linked objects and for adjusting bones to match geometry.
After a hierarchy is created, you can scale the position of the children without changing the individual objects’ dimensions.
Rotating the hierarchy does not affect the individual objects' orientation.

Aligning Pivots

Buttons on the Alignment group box of the Adjust Pivot rollout change names based on the state of Affect Object Only and Affect Pivot Only. Alignment is disabled when Affect Hierarchy Only is active.

Center to Object/Pivot Moves the object, or pivot, so the pivot is at the center of the object.

Align to Object/Pivot Rotates the object, or pivot, to align the pivot with the object's original local coordinate system.

Align to World Rotates the object, or pivot, to align with the world coordinate system.

Resetting the Pivot

Click Reset Pivot to return the pivot point of a selected object to the position and orientation it held when the object was first created.

Reset Pivot has no effect on the object or its children. The state of the Affect Pivot Only and Affect Object Only is ignored.
Viewing and Selecting Hierarchies

There are a number of ways to view a hierarchy structure and select objects in it.

Viewing a Hierarchy

You can use these methods to view the relationships between parents and children in a linked hierarchy.

- The Select Objects dialog on page 210 appears whenever you use a by-name selection method, such as choosing Edit menu > Select By > Name, by clicking Select By Name on the main toolbar, or by pressing the H key. To list objects hierarchically, turn on Display Subtree on the dialog. This indents children below their parent.

- The Hierarchy list on page 3817 at the left side of the Track View window on page 3790 displays all objects using indentation to express hierarchy. Child objects are displayed indented and below their parent. An added advantage of Track View is that you can control the view by collapsing and expanding branches of the hierarchy.
A square icon with a plus indicates a collapsed branch under that object, while a minus indicates an expanded branch. Click a plus icon to expand a branch, or a minus icon to collapse it.

**TIP** In complex scenes, use Curve Editor to navigate quickly through the Track View. Simply select the object in the viewport, then right-click and choose Curve Editor. The Track View — Curve Editor will appear with the selected object at the top of the window.

- You can also use Schematic View on page 7926 to view hierarchies. In addition to showing you the structure, Schematic View contains tools for manipulating hierarchies.
Selecting Hierarchy Members: Ancestors and Descendants

Once you have selected one or more objects in a hierarchy, you can select its direct ancestor or descendant with the Page Up and Page Down keys.

- Page Up deselects the object and selects the object’s parent.
- Page Down deselects the object and selects all its immediate children, but not all descendants down the chain.

**TIP** These navigation commands are particularly useful when setting joint parameters for inverse kinematics.

To select an object and all of its descendants, you can:

- Double-click the object in a viewport.
- Double-click the object icon in the Track View Hierarchy list on page 3817.

Selecting Hierarchy Members: Siblings

Available in Customize User Interface on page 8249 are the actions Select Sibling - Next and Select Sibling - Previous, which appear in the Main UI group and All Commands category. You can assign them as hotkeys, toolbar buttons, etc. We recommend assigning them to the cursor keys Right Arrow and Left Arrow, respectively; by default, those keys are not assigned keyboard shortcuts.

Using one of these commands replaces the current selection with one object only at the same hierarchical level. More precisely, a sibling is defined in this context as an object of equal generational distance from the selected object’s nearest parent. All objects that fit this definition are siblings, so that in asymmetrical hierarchies, object A can be a sibling of object B, but the reverse is not necessarily the case.
Take, for example, the asymmetrical hierarchy of dummy helper objects shown below:

From the viewport image, it might appear that Dummy objects 06, 08 and 02 are siblings of each other. However, the setup is actually more complicated, because Dummy objects 02 and 08 are direct children of Dummy03, while Dummy06 is a direct child of Dummy05, which has the same hierarchical level as Dummy03:

- Selecting Dummy06 and activating Select Sibling - Next results in Dummy08 being selected.
- Selecting Dummy06 and activating Select Sibling - Previous results in Dummy02 being selected.
- With Dummy02 selected, activating either Select Sibling command results in Dummy08 being selected, and the selection continues alternating for each subsequent invocation of either command. This is because 3ds Max looks only as far as the next branch above the selected object, resulting in Dummies 02 and 08 being siblings of Dummy06, but not vice versa.
Defining a sibling in this way has the practical advantage of letting you, for example, cycle through the selection of all finger links on one side of a character without the selection jumping to the other hand. But cycling through siblings with an arm object selected usually results in selecting the opposite arm object.

When using these commands, hidden objects on page 8599 and frozen objects on page 8587 can't be selected, but are considered part of the hierarchy when deciding what is and is not a sibling. Also, if a selection filter on page 187 is active, siblings that don't meet the filter's criteria cannot be selected. In all such cases, ineligible siblings are skipped in favour of a further sibling, if any exists.

**Customizing the Quad Menu**

You can customize the quad menu so it displays commands to select children, or ancestors, or both. From the Customize menu, choose Customize User Interface on page 8249. On the Quads tab, drag Select Ancestor or Select Children from the list of all commands to the quad menu. Then you can easily select children or parents with a right-click and then a click.

**Animating with Forward Kinematics**

The default method of manipulating a hierarchy uses a technique called forward kinematics on page 8585.

The basic principles employed by this technique are:

- Hierarchical linking from parent to child
- Placement of pivot points to define the connecting joint between linked objects
- Inheritance of position, rotation, and scale transforms from parent to child

You animate the objects of a hierarchy in much the same way you animate anything else. Turn on the Auto Key button and transform members of the hierarchy at different frames. However, you need to be aware of a few special issues for animating hierarchies.
How Links and Pivots Work

Once two objects are linked together, the child object maintains its position, rotation, and scale transforms relative to its parent object. These transforms are measured from the pivot of the parent to the pivot of the child.

For example, consider the two boxes in the following figure. The larger box is the parent of the smaller. The pivots and link between the boxes are indicated to show how the link works. The link extends from the pivot of the parent and connects to the pivot of the child. You can think of the child’s pivot as being the joint between the parent and child.
Rotating the parent affects the position and orientation of the child object.
Rotating the child does not affect the parent.

Links act as a one-way conduit to transmit the transforms of a parent object to its child object. If you move, rotate, or scale the parent, the child is moved, rotated, or scaled by the same amount. Because hierarchical links are one-way, moving, rotating, or scaling the child has no effect on its parent.

The end result is that transforms applied to a child object are applied in addition to any transforms inherited from the child's parent.

**Animating a Parent Object**

Only transforms are passed from parent to child. Animating a parent object using move, rotate, or scale animates the parent and the subtree attached to the parent.

Animating a parent's modifiers or creation parameters has no effect on its descendants.
Moving the root parent moves the whole hierarchy.
Rotation of a parent object is passed to all the child objects.

**Animating a Child Object**

With forward kinematics, a child is not constrained by its link to a parent. You can move, rotate, and scale children independent of their parents.
Moving the last child object does not affect any of the previous objects in the hierarchy.
Rotating a child object in the middle of the hierarchy affects all the descendants but none of the parents.

If you want to manipulate parent objects by moving the last child in the chain, use inverse kinematics on page 3661.

**Manipulating the Hierarchy**

A child object inherits the transforms of its parent, and the parent inherits the transforms of its ancestors all the way up the hierarchy to the root object. Because forward kinematics employs this method of inheritance, you must position and animate your hierarchies using a top-down method.
Manipulating the hierarchy of a leg.

Consider the linked mannequin in the figure. If you want to position the mannequin’s right foot to rest on top of the soccer ball beside it, you perform the following steps:

1. Rotate the right thigh so the entire leg is above the soccer ball.
2. Rotate the right shin so the foot is near the top of the soccer ball.
3. Rotate the right foot so it is parallel with the top.
4. Repeat steps 1 through 3 until the foot is properly placed.
You always start transforming objects at the highest-level parent affected by the motion and work your way down the hierarchy to the last child.

You have considerable control over the exact placement of every object in the hierarchy using forward kinematics. However, the process can become tedious with large and complex hierarchies. In such situations, you might want to use inverse kinematics on page 3661.

**Using Dummy Objects**

The primary use of *dummy helper objects* on page 2840 is to assist in creating complex motions and building complex hierarchies. Because dummies are invisible when rendered, they are an excellent choice for offset joints, connectors between objects, and handles for complex hierarchies. Dummies and *Points* on page 2853 can act as null objects that function as controls for transforming parts of an IK chain.

**Using a Dummy to Control Motion**

Breaking complex motions into simple components often makes it easier to go back and edit your animations.

Consider a bouncing ball that moves along a path. You could animate the ball by positioning it on many frames, but it would be very difficult for you to go back and adjust the height of the bounce or the path of the ball. You have to edit the motion of the ball on many frames to make even a simple change.

Using a dummy object solves this problem by breaking the motion into simple components. One component is the up and down bounce of the ball. The other is movement on the path.
Combining the bouncing motion of a ball with the forward motion of a dummy results in a moving bouncing ball.

**Using a Dummy as a Handle**

You might want to move and animate a selection of objects individually but also have the ability to transform them as a single object.

A good example of this is a camera on a tripod. You want to adjust both the camera and its target individually but also want to move them together as a single unit.

**Procedures**

To create a complex bounce motion using a dummy object:

1. Start with a sphere, then create a dummy object below the sphere, and link the sphere as a child of the dummy.
2. Animate the sphere bouncing up and down above the dummy.
3. Animate the dummy moving.
The sphere bounces on top of the dummy object as the dummy moves around the scene. You can easily change the height and speed of the bounce by changing the sphere animation. You can change the path through the scene by changing the dummy animation.

To create a camera tripod:

- Create a dummy object below a target camera and link the camera and target as children of the dummy object.
  The camera and the target follow the dummy object. You can quickly position the camera by placing the dummy object and compose your view by adjusting the camera and its target.

**Animating Links**

You assign a Link constraint on page 3580 to an object to animate links from one parent to another. You use a link constraint instead of using the regular Select and Link and Unlink Selection buttons on the toolbar. (See Animation Constraints on page 3574.)

An example of using a link constraint is to pass a ball from one hand to another. Assume that at frame 0 the ball is in the first hand. The hands are animated to meet at frame 50 and then spread apart until frame 100.

To animate the links for the ball:

1. On the Motion panel, assign a Link constraint as the ball's Transform controller. You can also put a Link constraint on the ball from the Animation menu by choosing Constraints > Link Constraint.

2. Move the time slider to frame 0, then on the Motion panel click Add Link, and click the hand holding the ball. The ball will now move along with the hand, as if it were linked to it.

3. Move the time slider to frame 50, where you want the second hand to pick up the ball, click Add Link, then click the second hand. From this frame on, it's as if the ball were linked to the second hand.

When you play back the animation, the ball travels with the first hand until frame 50, where you added the second link, then the ball is passed to the second hand for the rest of the animation.
Robot arms pass a ball from one hand to the other.

**Adding and Deleting Links**

You add and delete links on the Motion panel. Expand the Link Parameters rollout and click Add Link or Delete Link.

- Click Add Link then click the object that you want to link to as a parent. The frame at which you add the link is the frame at which control is passed. You can change the link frame with the Start Time parameter.
- Click the name of a parent object in the list, and then click Delete Link to remove the link.
Properties of the Link constraint include:

- The Link constraint respects the link inheritance settings applied to the child object.
- The object using a Link constraint is not a true child object. It does not appear in the subtree of any linked parent objects.
- Objects with Link constraint do not participate in IK solutions.

**Link to World**

You can also link an object to the world using the Link to World button. This will keep the object stationary without the use of a dummy object. Just click Link to World and the world is automatically entered as a Target.

**Key Modes**

You can choose between three different key modes, which determine how keyframes are written on the linked objects as part of the link constraint. These options provide the following:

- **No Key Mode** No keys are created any of the objects involved. No keys will be visible in the track bar.
- **Key Nodes** Sets keys for some of the objects. **Child** applies keys to the child object only. **Parents** applies keys to both parents and the child object.
- **Key Entire Hierarchy** This applies keyframes to the chosen nodes and their entire hierarchies. **Child** keys the chosen object and the nodes in its hierarchy up to the world. **Parents** keys both parents and the child and all three hierarchies up to the world.

**Side Effects of the Link Constraint**

The Link constraint works to keep a child object from jumping position at the time when the link changes from one parent to another parent.

Considering the previous example, the following should hold true:

- During frames 0 to 50 the ball remains constant relative to the first hand.
- During frames 50 to 100 the ball remains constant relative to the second hand.
- At frame 50, the time when link control changes, the ball does not jump.
If you change the animation of the second hand at frame 75, it affects the position of the hand relative to the ball at the time of the link (frame 50). This change in relative position affects the ball over all frames where it is linked to the second hand. Therefore, as you change the position of the hand at frame 75, the child’s position will also change, possibly in a counter-intuitive way. However, when playing back the animation the above three rules will hold true.

**Adjusting Object Transforms**

You use the features on the Adjust Transform on page 3770 rollout to transform objects after they have been linked without transforming descendents, and to reset an object’s transform.

**Transforming Parent Objects**

You might discover, after linking a number of objects, that you need to move, rotate, or scale a parent object but you do not want to affect the object’s descendents. You can transform a parent object without affecting its descendents by clicking Don’t Affect Children on the Adjust Transform rollout of the Hierarchy panel.

**Resetting an Object’s Orientation and Scale**

Click the Transform button in the Reset group to rotate an object’s pivot to match its parent’s local coordinate system. Descendents of the object are not affected.

**Resetting an Object’s Scale Only**

Click the Scale button in the Reset group to set the current scale value as the selected object’s base scale value. All following scale transforms are then applied using the base scale value as an absolute local scale of 100%.

Consider a sphere with a radius of 20 units and a linked child object:

1. Use Uniform Scale to scale the sphere to 200%. The sphere and its child become twice as big. Scale Transform Type-In reports an Absolute Local Scale of 200% and the object’s creation parameters report a radius of 20 units. The true radius of the sphere is 200% of 20 units, or 40 units.

2. Select the sphere and click Reset Scale. The sphere and its child remain the same size. Here’s what has happened:
The 200% scale has been absorbed by the sphere as its original state. The sphere has a true radius of 40 units, Creation Parameters report a radius of 20 units, and absolute local scale is 100%.

The sphere's child object accepts a local scale of 200% so it does not change in size.

Resetting the scale of an object can lead to confusion because the object’s true size, absolute local scale, and creation parameters no longer match up.

**Using the Reset Transform Utility**

You can also reset the orientation and scale of an object by clicking Reset XForm on page 912 on the Utilities panel on page 8223. Reset XForm takes the rotation and scale transforms of an object and places them in an XForm modifier on the modifier stack.

Consider the same sphere as before with a radius of 20 units and a linked child object:

1. Use Uniform Scale to scale the sphere to 200%. The sphere and its child become twice as big. The Scale Transform Type-In reports an Absolute Local scale of 200% and Creation Parameters report a radius of 20 units. The true radius of the sphere is 200% of 20 units, or 40 units.

2. Select the sphere and click Reset XForm. The sphere remains the same size but its child reverts to its original size and position. Here's what has happened:
   - The 200% scale has been placed in an XForm modifier on the sphere's modifier stack. The sphere has a true radius of 40 units, Creation Parameters report a radius of 20 units, and absolute local scale is 100%.
   - The sphere's child object now sees only the 100% local scale so it reverts to its original size and position.

**Locking Object Transforms**

You can lock an object’s ability to move, rotate, or scale about any of its local axes by selecting objects and then setting options on the Locks on page 3788 rollout of the Hierarchy panel.

Enabling and disabling Local transform axes is also referred to as setting degrees of freedom (DoF) for an object. If an axis is enabled, an object is free to transform about that Local axis.
The Locks rollout contains three groups: one each for Move, Rotate, and Scale. Each group contains three options, one each for the X, Y, and Z Local axes of the selected objects.

- When turned on, the objects cannot be transformed about the selected Local axes when you directly use one of the transform tools. Objects can still be transformed by other means such as being a child of a transformed parent object or being part of an inverse kinematics chain.
- When turned off, objects can be freely transformed about the unlocked Local axes.

### Animating Attachment

You assign an Attachment constraint on page 3575 to cause an object to hold a position on the surface of another object.

The Attachment constraint is not a hierarchical link, but it has the effect of "linking" an object to the surface of another object as follows:

- Attach a "source" object to the face of a "target" object so that the source object acts as if it's glued to the target object, no matter how the surface of the target object is deformed.
- Animate the Attachment parameters so that the source object moves over the surface of the target object.

Unlike hierarchical linking, which considers only object transforms, an object using an Attachment constraint follows the deformations of another object based on that object's modifiers and space warp bindings.

See Animation Constraints. on page 3574

### Setting Attachment Parameters

You use features on the Attachment Parameters rollout on the Motion panel, to pick a target object and position the source object.

- Click Pick Object, then click the target object to perform the attachment.
- Click Set Position and click or drag on the surface of the target object to place the source object onto the surface.
If you want to move the source object along the normal of the face (move it below or above the face) click Affect Object Only on the Hierarchy panel and move the object, using Local transform coordinates.

- Turn on Align to Surface if you want to align the world Z axis of the source object with the surface normal of the target object. Even with Align to Surface selected, you can always rotate the source object to orient it the way you want in relation to the target object.
  If you were to align trees on an uneven terrain, you would turn off Align to Surface so that all of the trees grew upright, regardless of the angle of the terrain surface.

**Animating Attachment Position**

You can move to any frame and click Set Position to animate the source object moving across the surface of the target object. It is not necessary to turn on the Auto Key button, because you are working with an animation constraint.

When you set positions for the source target on multiple frames, its attachment to the target object is only fixed at each keyframe. Frames between keys are interpolated and might not match the target surface. If you need the object to remain on the target surface, try using a Surface Constraint, rather than attachment.

Test your animation, and either adjust the values of the keys, or add intermediate keys to better match the target surface. Too many keys can result in jittery movement of the source object, while too few keys might result in the source object missing the surface of the target object over some frames.

**Changing Link Inheritance**

Links can transmit transform information from a parent to a child. By default, a child inherits all of the transforms of its parent. To set an object's ability to inherit the move, rotate, and scale transforms of its parent, you use the Inherit rollout of the Hierarchy panel. Use its settings to limit which transforms a child inherits.

The Inherit rollout is available only when you have selected a single object. When multiple objects are selected, the rollout is disabled.
Setting Link Inheritance Options

Set the Inherit options to release the link components between a selected object and its parent for any world axis of Move, Rotate, or Scale.

The options that appear when you expand the Inherit rollout are determined by the transform controllers assigned to the selected object.

The Inherit rollout for objects using standard position, rotation, and scale controllers contains three groups: one each for Move, Rotate, and Scale. Each group contains three options, one each for the X, Y, and Z world axes.

- When turned on, transform information from the parent is passed on to the child for the selected World axes.
- When turned off, transform information for the selected axes is ignored by the child.

Imagine you are animating a Ferris wheel that rotates on the world Y axis. The wheel is the parent and the cars are its children. You want the cars to ignore the Y axis rotation of the wheel. Otherwise, the passengers would all fall out. You use Link Info to turn off the Y axis option on the Rotation group of the Inherit rollout for each car.

Using the Link Inheritance Utility

The Link Inheritance on page 3660 utility works exactly the same as the Inherit rollout in the Link Info group on the Hierarchy panel, except that you can set link inheritance for multiple objects in a selection set.

For example, on a Ferris wheel, you could select all of the cars and use the Link Inheritance utility to turn off Y axis rotation for all the cars at once.

Link Inheritance (Selected) Utility

Utilities panel > Utilities rollout > More button > Utilities dialog > Link Inheritance (Selected)

The Link Inheritance (Selected) utility constrains the links between multiple objects in a selection set for any axis of position, rotation, or scale.

This utility works exactly the same as the Inherit rollout on page 3789 in the Link Info group box in the Hierarchy panel on page 8213, except that it lets you adjust link inheritance for multiple objects in a selection set, while the functions in the Hierarchy panel work only on single objects.
Procedures

To prevent the inheritance of X rotation in a hierarchy:

- Select one or more objects, and then turn off X in the Rotate group of the Inherit rollout.

Interface

XYZ

Turn off any axis in the Move, Rotate, or Scale groups to prevent inheritance.

When a box is turned on, transform information from the parent is passed on to the selected objects for the selected axis. When a box is turned off, transform information on that axis is ignored by the selected objects.

Inverse Kinematics (IK)

Inverse kinematics (IK on page 8612) is a method of animating that reverses the direction of the chain manipulation. Rather than work from the root of the tree, it works from the leaves.
Using IK to animate a leg

Let's take the example of an arm. To animate an arm using forward kinematics, you rotate the upper arm away from the shoulder, then rotate the forearm, the hand from the wrist and so, on adding rotation keys for each child object.

To animate the arm using inverse kinematics, you move a goal that positions the wrist. The upper and lower arms are rotated by the IK solution which moves the pivot point of the wrist, called an end effector on page 8560, toward the goal.

In the case of a leg, for example, the foot is constrained to the floor by the goal. If you move the pelvis, the foot stays put since the goal has not moved, and this causes the knees to bend. The entire animation is contained in keyframes for the goal and the root, without keys being applied to the individual chain objects.
With inverse kinematics you can quickly set up and animate complex motions. The basic procedure involves these tasks:

- Build a model. It could be a jointed structure or many pieces or a single continuous surface.

- Link the jointed model together and defining pivot points, as described in Hierarchies on page 3618. For a continuous-surface model, create a Bones on page 857 structure or use a biped to animate the skin of the character.

- Apply IK solvers on page 3669 to the jointed hierarchy. You will probably create several IK chains throughout the hierarchy, rather than just one. You might also create several independent hierarchies, rather than link everything together in one large hierarchy. For simple inverse kinematic animation you can use interactive IK, without applying any IK Solver.

- Define joint behavior on page 3754 at the pivot points, setting limits or preferred angles, depending on the type of IK solvers you are using. Here you can set up sliding joints or rotating joints. You might also need to move the root of the hierarchy, and you might want to add control objects such as dummies or points at this point.

- Animate the goal (in the case of an HI Solver on page 3680 or IK Limb solver on page 3732) or the end effector (in the case of the HD Solver on page 3710). This animates all the components of the IK chain. You can apply constraints on page 3574 to the goals or control objects or to the root of a chain.

You can externally reference IK chains in your scene. An XRef IK chain behaves the same as a non-XRef chain, except that you cannot retarget its XRef controller on page 3570 once it is in your master scene. For more information, see XRef Objects on page 7450.

**Control Objects to Assist IK**

You can link a goal or an end effector to points, splines, or dummy objects that serve as quick controls to translate or rotate the end of the chain. These control objects can be linked together as well, or they can be controlled with constraints. You can also use parameter wiring to build relationships between these control objects.

You can wire control objects to manipulator helpers on page 2861 or to custom attributes on page 307, creating an easily accessible interface for your animatable model.
You can add further controls to manipulate the elements in the middle of the chain.

**NOTE** In the **HI Solver** on page 3680, the **swivel angle** on page 3685 has its own manipulator, which can be animated or linked to another target object.

### Differences Between Forward and Inverse Kinematics

Forward kinematics uses a top-down method, where you begin by positioning and rotating parent objects and work down the hierarchy positioning and rotating each child object.

Basic principles of forward kinematics include:

- Hierarchical linking from parent to child.
- Pivot points defining joints between objects.
- Children inheriting the transforms of their parents.

These principles are fairly forgiving. As long as everything is linked together and the pivots are located at joint locations, you can successfully animate the structure.

Inverse kinematics (IK) uses a goal-directed method, where you position a goal object and 3ds Max calculates the position and orientation of the end of the chain. The final position of the hierarchy, after all of the calculations have been solved, is called the IK solution. There are a variety of IK solvers that can be applied to a hierarchy.

Inverse kinematics starts with linking and pivot placement as its foundation and then adds the following principles:

- Joints can be limited with specific positional and rotational properties.
- Position and orientation of parent objects are determined by the position and orientation of child objects.

Because of these additions, IK requires greater thought about how you link your objects and place pivots. Where many different solutions for linking objects may be suitable for forward kinematics, there are usually just a few good solutions for any given IK approach.

Inverse kinematics is often easier to use than forward kinematics, and you can quickly create complex motions. If you need to edit those motions later, it can be simpler to revise the animation if you are using IK. It also is the best way to simulate weight in an animation.
See also:

- **IK Solvers** on page 3669
- **Linking Strategy** on page 3623
- **Bones System** on page 857
- **Using Objects as Bones** on page 870

## IK Terminology

Using inverse kinematics requires that you set parameters for a number of IK components. Brief definitions of these components follow; details are provided in other topics.

**NOTE** 3ds Max offers a variety of inverse kinematics systems. There are four kinds of IK solvers, plus applied IK and interactive IK systems that don’t use IK solvers. Not all of the following parameters are used by all the systems.

**IK Solvers** An IK solver applies an IK solution to a kinematic chain. The kinematic chain is composed of a bones system, or a set of linked objects.

**Joints** An IK joint controls how an object transforms with respect to its parent. You specify joint behavior with settings in three categories:

- **Object Pivot Point** The location of an object’s pivot point defines where joint motion is applied.

- **Joint Parameters** Changing the IK settings in the Hierarchy command panel determines the direction, constraints, and order of how the joint operates.

- **Parent Pivot Point** The location of an object’s parent pivot point defines the origin from which the joint constraints are measured.

The commands you use to place the pivot points for both the object and its parent are described in *Adjusting Pivots* on page 3633.

**Start and End Joints** The start and end joints define the beginning and end of an IK chain managed by the IK solver. The hierarchy of the chain determines the direction of the chain. The pivot point of the end joint is displayed as the end effector, when end effector display is enabled.
Kinematic Chain Inverse kinematics calculates the position and orientation of objects in a kinematic chain. The kinematic chain is defined as any part of a hierarchy under IK control. The IK chain starts with a selected node and consists of a start joint and an end joint. The base of the chain is either the root of the entire hierarchy, or an object that you specify as a terminator for the chain. The kinematic chain is defined when you apply an IK solver to a chain, or when you create a bone chain with an IK solver automatically applied.

Goal The goal is used by the HI Solver to manipulate the end of the chain. When the goal is animated, the IK solution attempts to match the end effector (pivot point of the last child in the chain) to the goal position. When using an HD Solver, the end effector fulfills the same function as the goal.

End Effector For any IK solution, you explicitly move a control object. IK calculations then move and rotate all other objects in the kinematic chain to react to the object you move. The object that you move is the goal, in an HI Solver or IK Limb Solver, or in the case of an HD Solver, an end effector on page 8560.

Preferred Angle Determines which direction a joint will bend. The preferred angle establishes a base angle between chain elements when an HI Solver is applied. The IK Solution seeks this angle in calculations.

Solver Plane and Swivel Angle Manipulator A plane can be defined between the start and end joints, which aids in controlling the IK solution. Adjust or animate the solver plane by changing the swivel angle manipulator when in manipulate mode. This determines an up-vector handle for the chain, which can also be animated over time. You can also define a target for the swivel angle manipulator to follow. For more information, see White Paper: Swivel Angle of the HI IK Solver on page 3685.

Terminators You can explicitly set the base of an HD (History-Dependent) IK chain by defining one or more objects as terminators. A terminator object stops the IK calculations so that objects higher up the hierarchy are unaffected by the IK solution. Terminator objects are also used to define hierarchies that use multiple HD IK chains.

Terminator objects are not used in HI Solvers or IK Limb Solvers. In these cases the termination is determined by the end joint of the chain.

Bound Objects Objects in your hierarchy can be bound to the world, or they can be bound to other objects called follow objects on page 8583.

Binding allows objects in your hierarchy to be influenced by objects that are not part of the hierarchy.

- An object bound to the world will attempt to maintain its current position and orientation.
An object bound to a follow object will attempt to match the position and orientation of the follow object.

You can bind to a follow object when you use an HD Solver, or when Applied IK is used. If you want to bind to a follow object when using an HI or IK Limb Solver, apply a position constraint between the goal and any follow object of your choice (usually a point, dummy, spline, or bone).

**Enabled IK** (HI Solver) When using the HI Solver, you can animate with either inverse kinematics or forward kinematics (FK). When Enabled is turned on, inverse kinematics controls the chain, and keyframes are placed only on the goal. When Enabled is turned off, forward kinematic rotational keys are placed on all the bones.

**IK/FK Snap** (HI Solver) When using the HI Solver, if you animate using both IK and FK, you might create a situation where the goal has moved away from the end of the chain, causing a jump in the animation. Pressing IK/FK Snap will result in the goal being moved back to match the position of the end effector, eliminating the jump in the animation.

**IK for FK pose** (HI Solver) When this button is turned on, moving the goal automatically sets rotation keys for the bones. In effect, this lets you use IK manipulation to create your pose, setting FK keys.

### Inverse Kinematics Methods

Inverse kinematics builds on the concepts of hierarchical linking. To understand how IK works, you must first understand the principles of hierarchical linking and forward kinematics. See Animating with Forward Kinematics on page 3642 and Inverse Kinematics (IK) on page 3661.

### IK Solvers

IK solvers on page 3669 are specialized controllers that apply IK solutions procedurally across a range of frames.

Four different IK solvers ship with 3ds Max:

- HD (History-Dependent) Solver
- HI (History-Independent) Solver
- IK Limb Solver
Spline IK Solver

**TIP** In order to put an IK solver on a two-bone chain, a third bone is needed. Choose the first bone, then from the Create menu click IK solver, then click the third bone in the viewport.

In general, all IK solvers:

- Work on any hierarchy.
- Work on any hierarchy or bone structure.
- Calculate IK solutions for all frames in real-time as you make changes.
- Allow you to create multiple IK chains within a single hierarchy.
- Display active joint axes and joint limits graphically.
- Use a node, goal or an end effector to animate the end of a chain.
- Use an end effector to animate the end of a chain.

An IK solver places keyframes only on the IK goal or end effector, as opposed to forward kinematics (or the non-solver IK methods), which place rotation keyframes on the bones or hierarchical objects themselves.

**Other IK Methods**

In addition to the IK solvers, 3ds Max provides two non-solver methods of inverse kinematic animation: Interactive IK and Applied IK. These IK methods do not apply an IK solver.

**NOTE** These are older IK methods carried over from the earliest versions of 3ds Max. It is generally recommended that IK Solvers be used in most cases rather than Interactive or Applied IK.

- **Interactive IK** on page 3747
  Interactive IK gives you the ability to use IK manipulation on hierarchies without applying an IK solver. You animate your IK structure by activating Interactive IK (found in the IK panel of the Hierarchy panel and on the Hierarchy toolbar) and manually animating the position of end effectors. IK solutions are calculated only for the keyframes you set. All other motion...
is interpolated as set by the object’s controllers. Moving the end of the chain simply adds rotational keys to the objects in the chain. The objects can have joint limits assigned, for additional control. The chain can also be terminated using the tools in the Auto Termination rollout on page 3786.

- **Applied IK** on page 3750
  With Applied IK, you animate follow objects and 3ds Max calculates the solution on every frame of a specified range. The IK solution is applied as standard transform animation keys. Applied IK works with any linked hierarchy of objects except for bones that use the HI Solver or the IK Limb Solver. It can combine forward kinematics with inverse kinematics on the same objects. You can apply it automatically to a range of frames, or interactively to single frames.
  
  Applied IK is fast and accurate, but it creates keys for every object in the kinematic chain, on every frame. The large number of keys can make it difficult to adjust the animation later. Use Applied IK repeatedly to adjust the animation.

**IK Solvers**

Select an object in a hierarchy where you want IK to start. > Animation menu > IK Solver > Apply an IK solver. > Click the object in the hierarchy where you want the IK chain to end.

An IK solver creates an inverse kinematic solution to rotate and position links in a chain. It applies an IK Controller to govern the transforms of the children in a linkage. You can apply an IK solver to any hierarchy of objects. You apply an IK solver to a hierarchy or part of a hierarchy using commands on the Animation menu. Select an object in the hierarchy, choose an IK solver, and then click another object in the hierarchy to define the end of the IK chain.
Each type of IK solver has its own behavior and workflow, as well as its own specialized controls and tools that display in the Hierarchy and Motion panels. IK solvers are plug-ins, so programmers can expand IK capabilities of 3ds Max by customizing or writing their own IK solvers.

3ds Max ships with four different IK solvers.

**How Does an IK Solver Work?**

An IK solver generally operates in this way: an inverse kinematic chain is defined on part of the hierarchy, say from the hip to the heel, or the shoulder to the wrist of a character. At the end of the IK chain is a gizmo, called the goal. The goal can be repositioned or animated over time in a variety of ways, often using linkage, parameter wiring or constraints on page 3574. No matter how the goal is moved, the IK solver attempts to move the pivot of the last joint in the chain (also called the end effector) to meet the goal. The IK solver
rotates the parts of the chain to stretch out and reposition the end effector to coincide with the goal.

Using an IK solver to animate an arm

Frequently, the end effector is constrained to the ground plane. For example, you might "pin" the toes as the heels lift in a character walk cycle. Then the movement of the root of the chain poses the legs up from the toes.

Four plug-in IK solvers ship with 3ds Max:

- **HI (History-Independent) Solver** on page 3680

  The HI Solver is the preferred method for character animation, and for any IK animation in long sequences. With HI Solvers, you can set up multiple chains in a hierarchy. For example, a character’s leg might have one chain from hip to ankle, and another from heel to toe.

  Because this solver’s algorithm is history-independent, it is fast to use regardless of how many frames of animation are involved. Its speed is the same on frame 2000 as it is on frame 10. It is stable and jitter-free in viewports. This solver creates a goal and an end effector (although the display of end effector is off by default). It uses a swivel angle on page 3685 to adjust the solver plane to position the elbow or the knee. You can display the swivel angle manipulator as a handle in the viewport, and adjust it.
HI IK also uses a preferred angle to define a direction for rotation, so the elbow or knees bend correctly.

**HD (History-Dependent) Solver** on page 3710
The HD Solver is a solver well-suited to use for animating machines, especially ones with sliding parts that require IK animation. It lets you set up joint limits and precedence. It has performance problems on long sequences, so ideally use it on short animation sequences. It is good for animating machines, especially ones with sliding parts.

Because this solver's algorithm is history dependent, it works best for short animation sequences. The later in the sequence it is solving, the longer it takes to calculate a solution. It allows you to bind the end effector to a follow object, and it uses a system of precedence and damping to define the joint parameters. It allows for sliding joint limits combined with IK animation, unlike the HI IK solver, which only allows for sliding joint limits when using FK movement.

**IK Limb Solver** on page 3732
The IK Limb solver operates on only two bones in a chain. It is an analytical solver that is fast in viewports, and can animate the arms and legs of a character.

The IK Limb solver can be used for export to game engines.

Because this solver's algorithm is history-independent, it is fast to use regardless of how many frames of animation are involved. Its speed is the same on frame 2000 as it is on frame 10. It is stable and jitter-free in viewports. This solver creates a goal and an end effector (although the display of end effector is off by default). It uses a **swivel angle** on page 3685 to adjust the solver plane to position the elbow or the knee. You can target the swivel angle to an another object to animate it. IK Limb Solver also uses a preferred angle to define a direction for rotation, so the elbow or knees bend correctly. It also allows you to switch between IK and FK by keyframing IK Enabling, and it has a special IK for FK pose function so you can use IK to set FK keys.

**Spline IK Solver** on page 3733
The Spline IK solver uses a spline to determine the curvature of a series of bones or other linked objects.

Vertices on a Spline IK spline are called **nodes**. Like vertices, the nodes can be moved and animated to change the curvature of the spline.

The number of spline nodes can be fewer than the number of bones. This provides the ease of posing or animating a long multiple-bone structure with just a few nodes, as opposed to animating each bone individually.
Spline IK provides a more flexible animation system than other IK solvers. Nodes can be moved anywhere in 3D space, so the linked structure can be intricately shaped.

A helper object is automatically placed at each node when Spline IK is assigned. Each node is linked to its corresponding helper, so a node can be moved by moving the helper. Unlike the HI Solver, the Spline IK system does not use a goal. The positions of nodes in 3D space is the only factor that determines the shape of the linked structure. Rotating or scaling nodes has no effect on the spline or structure.

NOTE 3ds Max also provides two other methods of inverse kinematic manipulation of hierarchies, which don't depend on a solver: Interactive IK on page 3747 and Applied IK on page 3750.

IK with Bones

While you can apply an IK solver to any hierarchy of objects, a system of Bones on page 857 combined with an IK solver is a good way to animate a character.

A bones system is a jointed, hierarchical linkage of bone objects. Bones are used as an armature on to which objects are linked. If you use the skin modifier on page 1667, you can "skin" an object to the bones, so the animation of the bones deforms the mesh that models a character. If you have a jointed character, you can use linkage or constraints so the bones animate the mesh.

Animating bones with skin causes the skin to stretch or shrink.
Animating bones with skin causes the skin to stretch or shrink.

**Turning Other Objects into Bones**

Any object can be turned into a bone object. Select the object, choose Animation > Bone Tools on page 871. On the Object Properties rollout, turn on Bone On. You can then choose Show Links Only to replace the display of the objects with the bones. This can be useful if you have a geometrically intensive hierarchy to animate. The interactive viewport response will be much quicker when the geometry is hidden and displayed only at links.

You can display any object as a bone object. Select the object, then choose Animation > Bone Tools. This opens the Bone Tools floater. On the Object Properties rollout, turn on Bone On. Then go to the Display panel, and on the Link Display rollout turn on Display Links and Link Replaces Object, which displays the bones instead of the object. This can be useful if you have a geometrically intensive hierarchy to animate. The interactive viewport response is faster when the geometry is hidden and displayed as links only.
Any object hierarchy can be displayed as bones.
Any object hierarchy can be displayed as bones.

Bones can scale, squash and stretch over time. See Using Objects as Bones on page 870.

**Link Display**

You can use Display Links and Link Replaces Object to display the links instead of the object. These settings are found on the Link Display rollout on the Display panel. This can be useful if you have a geometrically intensive hierarchy to animate. The interactive viewport response is faster when the geometry is hidden and displayed only at links.

**Advantages of Animating Bones with IK**

It is possible to animate a character’s motion through forward kinematics, rotating each limb into position from the shoulder to the fingers, and the hips to the toes. But it’s a lot quicker and more realistic to use inverse kinematics to simulate the foot interacting with the ground. And it is a lot easier to control when you need to make changes to the animation. Rather than having keyframes on every bone in the chain, you have to make changes to only one node, to change the animation of the entire chain.

On the other hand, it is common for animators to use IK for the legs and FK for the torso and the arms. FK offers a bit more control for posing the upper body. It is not necessary to use IK for every character animation task. Using the HI IK solver allows you to jump back and forth easily between FK and IK.
How to Apply an IK Solver

You can apply an IK solver when you create a Bones system, or from the Animation menu:

- **Bones creation** on page 857
  When you create bones, turning on the Assign to Children option lets you apply an IK solver immediately. Default=Off.

- You can apply the IK solver to a part of the skeleton using Animation menu > IK Solver. You must select the node where you want the IK chain to start, then choose Animation menu > IK Solvers and select the solver. Then click the node where you want the chain to end. The chain will be created between the pivot points of the two nodes. If you are using an IK Limb Solver, the IK goal will be placed two bones down from the highest node you've selected in the chain.

Where to Adjust the IK Solver

You adjust IK solver settings in the Motion and Hierarchy panels:

- **Motion panel** on page 8215
  When the goal of an IK chain is selected, the motion panel displays the rollouts for the individual IK solver.

  **HI Solver**
  Motion panel parameters adjust the swivel angle on page 3685 of the solver plane, to point the knees and elbows. Also, the controls in the IK Solver rollout let you mix periods of IK with FK (forward kinematics) through the Enabled button and the IK button.

  **HD Solver**
  Motion panel parameters assign, remove, and edit the end effector for the currently selected joint. You can parent the end effector to another object, and return the skeleton to an initial pose. Changing IK controller parameters in the Motion panel affects the entire HD IK chain, even when you've selected only a single bone.

  **IK Limb Solver**
  Motion panel parameters for the IK Limb solver are the same as for the HI Solver.

  **Spline IK Solver**
  Motion panel parameters allow you to activate/deactivate the solver, adjust the bones assigned to the start and end joints, adjust start and end twist angles and make twist handle display settings.
To add an IK solver to a hierarchy or bones system:

1. Create a bones system or any other linked hierarchy of objects.
2. Select a bone or an object where you’d like the IK chain to start.
3. Choose Animation menu > IK Solver, and then choose the IK solver:
   - HI Solver for character animation
   - HD Solver for mechanical assemblages with sliding joints
   - IK Limb Solver for two-bone chains
   - Spline IK Solver for improved control of intricate, multiple-bone structures
Click where you want the IK chain to end.
If you are using the IK Limb Solver, you must apply the IK Solver to control only two bones.
The IK solver appears in the viewport.

To create a bones hierarchy that uses an IK solver:

1 Go to the Create panel, choose Systems, and click Bones.
2 On the IK Chain Assignment rollout, choose an IK solver from the list.
3 Turn on Assign To Children.
4 Click and drag in a viewport to create the bones. Right-click to stop bone creation.
The bones are created with the IK solver already applied.

NOTE If you use the Spline IK Solver, a Spline IK Solver dialog will open where you can make special settings for the spline and helpers used by the Spline IK solver.

To display a hierarchy of objects as bones:

1 Select the hierarchy of objects in the viewport.
2 From the Animation menu, choose Bone Tools. This Opens the Bone Tools dialog.
3 Expand the Object Properties rollout.
4 In the Bone Properties group, turn on Bone On.
5 On the Display panel, scroll down to Link Display and expand it.
6 On the Link Display rollout, turn on Display Links, and Link Replaces Object.
The objects disappear and the links are displayed as bones.
History-Independent (HI) IK Solver

The HI (History-Independent) Solver does not rely on IK solutions calculated in previous keyframes in the timeline, so it is just as fast to use at frame 2000 as it is at frame 20.

The HI Solver uses a goal to animate a chain. You animate the goal and the IK solver attempts to move the end effector (the pivot point of the last joint of the chain) to match the position of the goal. Often the goal is parented to other control objects such as points or dummies, splines or bones, and these control objects in turn are wired to viewport or rollout sliders.

The IK solution takes place in a plane, known as the solver plane. The angle of the solver plane in world space is controlled by a parameter called the swivel angle on page 3685. The swivel angle is animatable. You can adjust it directly, or with a manipulator.

The HI Solver allows for the creation of multiple or overlapping chains. This allows you to create multiple goals for additional controls. By linking the goals to points, splines, bones or dummies, you can create simple controls to animate complex chains or hierarchies. You can also use constraints on these goals or control objects, as another animation tool.

Applying an HI Solver

To apply an HI Solver to any part of a hierarchy select the bone or object where you want to the solver to start. Then choose Animation menu > IK Solvers > HI Solver. In the active viewport move your cursor to the bone where you want the chain to end. When you click to select that bone, the goal is drawn at the pivot point of that bone. If you want a goal at the far end of the bone, refine the bone where you want to goal to be placed. An extra bone will be added, and then choosing that bone allows you place the goal at the end.

When you create bones, a small "nub" bone is automatically created at the end of the chain to assist in this process.

Setting Up Multiple Chains

To rig a skeleton for a human leg you could use three chains in one leg, as follows:

- The first chain is created from the hip to the ankle. This chain controls the overall leg motion including bending of the knee.
The second chain is created from the ankle to the ball of the foot. This chain controls the heel's up and down motion.

The third chain is created from the ball of the foot to the toe.

When the three chains work together they help to maintain the foot’s position in space. This means it will keep the foot planted on the ground as the character’s body moves. All three IK chains in this hip-to-toe setup place goals at key positions in the foot that mimic natural foot behavior. In real life, the toe, ball of the foot, and heel can be planted on the ground or raised.

Each chain has an goal that drives motion on the heel, ball of foot, and toe. Use the IK goals to raise the heel, bend the toe, move and rotate the entire foot, and maintain the foot's position in space.

**Overlapping Chains**

The IK solver system allows you to create overlapping IK chains in a single hierarchy. In a human leg, for example, you could create a chain running from the hip to the ankle, then a second chain from the knee to the ball of the foot, and a third from the ankle to the toes. Use overlapping chains, when you want to apply goals to sequential bones, but you don't want to refine the bones.

Another good use for overlapping HI IK chains is to keep the goals at the bottom of the hierarchy firmly rooted in place. In the case of the leg example, the ankle, ball and toe of the foot would not move until the upper portion of the hierarchy had reached its full stretch.
Overlapping chains make the toe stick to the ground
Overlapping chains make the toe stick to the ground

Don’t try to overlap chains with different kinds of IK solvers or you might get unpredictable results.

Creating Control Objects

To create control objects to animate the goals, create dummies, points, splines or other objects near the goal, then link the goal to the control object. For example in a human leg, you might have a goal at the ankle, ball of the foot, and the toe. You then create three splines under the foot, one for the heel, one for the ball and one for the toe. Link each goal to each spline, then you can animate the goals using these splines. You could also link the splines together, so that the rotation of the toe is controlled by the movement of the heel.

Besides hierarchical linkage, you can now use the new Constraint system in conjunction with IK solvers. You could apply any of the constraints to create a relationship between the goals or bones and other objects. The goal could be position constrained to a dummy which is moved. Or you could create
three bone chains that are all in the same place, and constrain one bone chain to another, then weight the constraints.

Bone chains constrained together

Using control objects gives you something bigger to select in the viewport. You can also use control objects to separate chains, for example in a human arm one chain could end at the wrist and another separate chain be created for the hand and fingers. The control object at the wrist serves as the root node for the hand chain, yet that chain would remain disconnected (hierarchically speaking) from the arm chain.

You can create viewport sliders using the manipulator helper, and then use the viewport sliders to control the transforms of the control objects. Use wire parameters on page 3610 to hook up the sliders with the control objects. You can also create Custom Attributes to add these sliders to the object rollouts.

**Mixing Forward Kinematics with Inverse Kinematics**

The HI IK solver provides a tool for mixing FK and IK in a single animation track. There is an FK subcontroller beneath the IK controller assigned by this solver.
When the Enabled button is on, the FK subcontroller values are preserved but ignored. When Enabled is turned off, the FK subcontroller values apply. To access the Enabled button, select the goal and go to the Motion panel, then turn off the Enabled button. This will allow you to animate using FK rotations of the bones or hierarchy objects.

IK for FK pose allows one to turn on IK in middle of FK manipulation. When the Enabled button is turned off, and IK for FK Pose is on, then selecting and moving the goal lets you use IK to create the forward kinematic keyframes. Moving the goal poses the skeleton and add rotation keys to all the objects in the chain when the Auto Key button is on.

When working with IK and FK together it is possible to create a situation where the goal has moved away from the end of the chain. Use the IK/FK snap button to reposition the goal, snapping it back to the end of the chain. When AutoSnap is on, the snap happens automatically; when you touch the goal, you don't have to click the IK/FK snap button.

Controlling HI IK Precision

When you are animating with HI Solvers, if you find the animation of the limbs is not smooth, you should try doubling the Iterations in the Solutions group of the HI Solver Properties rollout on page 3700. You can also try reduce the Thresholds value to smooth the animation.

See also:

- IK Solver Rollout (HI Solver) on page 3695

White Paper: Swivel Angle of the HI IK Solver

The fundamental requirement of HI Solver is that the solution be history-independent: the solution has to be based on the goal and other incidental parameters solely at their current states.

Swivel Angle Degree of Freedom

When the positional goal is given for a single chain, there remains an obvious degree of freedom: the rotation about the End Effector Axis (EE Axis). The swivel angle is used to describe this degree of freedom quantitatively.
1. Start joint
2. End effector
3. EE axis

**Solver Plane**

Let's call the plane passing all the joints the Solver Plane. When joints do not lie on a plane, we will define it to be the plane that (A) passes the Start Joint and End Joint and (B) is closest to the remaining joint in a certain sense.

The Swivel Angle describes the degree of freedom of the Solver Plane and it constrains only the Start Joint.

**Zero Plane Map**

In order to describe the solver plane in terms of a numerical quantity, we have to agree to what 0 means. Given the end-effector position, where is the Zero (Solver) Plane? The Zero Plane Map takes as the argument EE Axis and produces the normal to the zero plane.

The IK system allows individual solver plug-ins to define their own Zero Plane Maps. When not defined, the IK system provides a default one.
The argument to the Zero Plane Map is a unit vector to give the direction of the EE axis. Equivalently, when the EE slides along the EE axis, the solver plane should be fixed. Therefore, the Zero Plane Map defines a vector field on a sphere. Given a point on the sphere, it produces a tangential unit vector to be interpreted as the normal to the zero plane.

1. Normal to the zero plane

**Solver Plane Flipping**

It is a mathematical fact that there does not exist a continuous vector field on a sphere. No matter how hard you try, there will always be a point on the sphere where neighboring vectors change dramatically. This is where the solver plane will flip when the end effector axis approaches to it.

This is because, on one hand, the history independent requirement demands us to assign a fixed vector to the singular point. On the other hand, no matter what vector is assigned, it will be dramatically different from some vectors assigned to the neighboring points.
Intrinsic Reference Frame for the Sphere

In order to define the Zero Plane Map, we need to define a reference frame for the sphere. This reference frame is intrinsic to the joint chain itself.

A sphere can be defined by the center, the horizontal plane, and the meridian (zero longitude). The center is assigned to the start joint.

The pose when all the joint angles assume preferred angles is particularly important. Let’s call it the preferred pose.

We use the solver plane at the preferred pose as the horizontal plane. Since the swivel angle is used to control the start joint, the preferred angles at the start joint are not so intrinsic. It is also reasonable to define the horizontal plane with the solver plane that is derived by assigning zeroes to the start joint and preferred angles to the other joints.

The EE axis defines the meridian. The sphere is now defined as shown in the following figure:

1. EE axis

All the joints assume preferred angles. The Zero Plane Map is to be defined on this sphere.
The API for the plug-in solver to define its own Zero Plane Map in fact takes the EE axis and the normal to the solver plane at the preferred pose:

```cpp
virtual const IKSys::ZeroPlaneMap*
GetZeroPlaneMap(const Point3& a0,
                const Point3& n0) const
```

where \(a0\) and \(n0\) are the EE axis and solver plane at the preferred pose, respectively. Object of ZeroPlaneMap is a function that assigns a plane normal to each point on the sphere.

**Default Zero Plane Map**

When not provided by plug-in solvers, (the IK Solver itself is implemented as a plug-in solver) the IK system will provide a default one. This map is defined by the following rules:

- **A:** For each point on the equator, the intersection of the horizontal plane and the sphere, the normal vector is defined as the vertical vector, pointing to the same direction as the normal of the solver plane at the preferred pose.

- **B:** For any point on the sphere other than the north or south poles, there is a great circle that passes the point and the north, south poles. This circle hits the equator at two points. One point is closer to the given point. The normal vector at the given point is defined as derived from moving tangentially the normal at the closer point on the equator along the great circle to the point.
Obviously, this method won’t extend to the north or south poles. They are the singular points. When the EE axis moves across the poles, the normal will suddenly change direction: it flips from the users’ viewpoint.

Normally, the preferred pose is the one when the solver is first assigned. So, the plane on which one lays the joints corresponds to the horizontal plane here. Rule A makes sure that the chain will stay on the plane if one moves the goal on the plane.

Rule B means that, when you move the goal along the great circle vertical to the equator, the chain will stay vertical, except when it passes through the poles, which are the singular points of this map.

**Parent Space**

So far, we have described things as if the whole world comprises only IK elements. In practice, the IK chain and goal might sit at points of separate transformation hierarchies. Ultimately, we need to map the position of the end effector that is described in the world to a point on the sphere. Depending how the sphere is mounted relative to the end effector position, the readings
of latitude and longitude are different. The parent transformation space that this sphere is to be placed in is called the Swivel Angle Parent Space, or Parent Space when the context is clear.

The parent space has to be invariant with regard to the IK parameters. Right now, we provide two choices:

- **Start Joint** The Swivel Angle Parent Space is the same as the parent space of the Start Joint.
- **IK Goal** The Swivel Angle Parent Space is the parent space of the IK Goal.

**Example 1**

If both the start joint and the goal are rooted directly at the world, the choice of Parent Space does not give rise to any difference. In the following example, the start joint is parented to object A.
Assume this is the pose when the IK solver is assigned. So, this is the preferred pose. The plane on that the joints are laid out is the horizontal plane of the (Zero Plane Map) sphere.

- **A:** Parent Space is Start Joint. In this case, the sphere is parented to A. If A is rotated about the drawn axis, the sphere is rotated together with it. The goal is in a separate transformation hierarchy. It stays in place, and the end effector sticks to it because of the IK solution. Since the (plane) normal is fixed to the sphere, it rotates with A, too. Therefore, the whole chain appears to be rotated together with the parent object.

- **B:** Parent Space is IK Goal. Suppose that the goal is parented to the world. In this case, the sphere is parented to the world and, hence, stays fixed. Since the normal is fixed to the sphere, the chain will appear stationary when A is rotated.

**Example 2**

In the following example, we look at a case where there exists a rotation in the parent space when the IK solver is assigned.

![Diagram](image.png)

The parent space of the IK chain contains a rotation when the IK solver is assigned.

Parent A contains a rotation of 90 degrees. This is an abstraction of the case when a user creates four bones without an IK solver and later assigns an IK
solver from Bone2 to Bone4. If we parent the chain directly to world, it would appear as shown in the right figure: the solver plane becomes horizontal.

■ **A:** Parent Space is Start Joint. The sphere is mounted after the rotation of A and therefore the “horizontal plane” coincides with the chain plane as shown in the viewport. The singular points are perpendicular to the Start Joint with regard to the plane. When the goal/end effector is moved on the plane, it will never hit the singular points and flip.

■ **B:** Parent Space is IK Goal. Again, we assume that the parent space of the goal is the world. The “horizontal plane” of the sphere becomes horizontal, as shown in the right figure. The singular points, the poles, are on the plane that joints are laid out. Therefore, when users move the goal/end effector left to right, or the other around, the end effector will move across the singular point and flip.

A problem of B is that the figure on the right is never shown to the user. They have to envision it in order to understand the flipping.

**Example 3**

This example describes what happened when Start Joint is reassigned. Suppose we have an IK chain of four bone nodes.
The Start and End Joints are Bone01 and Bone04, respectively. Suppose the pose shown in the figure is the preferred pose and Bone01 contains a rotation. If we parent Bone02 directly to the world, the hierarchy from Bone02 will appear as in the right figure.

When we reassign Start Joint to Bone02, the Zero Plane Map sphere will be based on the configuration on the right.

- **A**: Parent Space is Start Joint. In this case, the sphere that is fixed to the right configuration is to be parented to Bone01 together. This will be the same as the one based on Bone01 to Bone04. Therefore, we get the same normal and chain stays stationary.

- **B**: Parent Space is IK Goal. In this case, the sphere stays in the world while Bone02 is parented to Bone01. When Bone04 is moved to where it is shown on the left due to the transformation of Bone01, the observer who is fixed to the sphere that is fixed to the world will see that Bone04 moves away from the neutral position defined by the preferred pose. The algorithm then applies the Zero Plane Map to find the normal at the displaced
position. It generally is not perpendicular to the viewport. Therefore, we will see a flip once it takes a new Start Joint.

If you delete the solver/goal and assigned a new one from Bone02 to Bone04, you will find that the chain won’t flip. Why? Assignment of Start Joint is different from creating a new IK chain/goal. Start Joint is one of many IK parameters. Reassigning it is simply the same as modifying any parameter. The rest parameters are intact. In particular, the Swivel Angle is not changed as a result of this reassignment.

Creating a new IK chain/goal is different. Effort is made to ensure that the joint chain stay fixed by adjusting parameters appropriately. In particular, the Swivel Angle will be set to a value so that the solver plane keeps stationary in the viewport.

**HI IK Solver Rollouts (Motion Panel)**

These topics describe controls for the HI IK Solver, which appear on the Motion panel.

**IK Solver Rollout (HI Solver)**

Select an HI or IK Limb Solver IK Chain control (the blue cross at the end of the chain.) > Motion panel > Parameters button > IK Solver rollout

The HI Solver is a history-independent solver that doesn’t rely on the calculations from previous frames for the IK solution, so it is fast to use no matter the length of your animation. The history-independent solver uses a goal to manipulate the end of the chain. It uses a preferred angle that specifies a preference regarding which direction the link will rotate: positive or negative. The preferred angle can also be considered as the initial angle; that is, the angle at which the link was rotated at the time the solver was applied.

The IK solution takes place in a plane, known as the *solver plane*. The angle of the solver plane is controlled by a parameter called the *swivel angle*. 
Changing the swivel angle

The angle of the solver plane is actually calculated in one of two coordinate systems: the Start Joint Parent space or the IK Goal Parent space. World space is not an explicit option; however, you can easily configure the IK chain to work in world space by choosing the IK Goal Parent option and making sure that the IK goal is unlinked (i.e., has no hierarchical parent). In this case, the IK goal’s parent is the world, and therefore, the solver plane will be computed in world space.

The swivel angle is animatable. You can adjust it directly, or with a manipulator. Or you can target the swivel angle to a object and animate that to affect the swivel angle. These parameters are on the IK Solver Properties rollout on page 3700.

The HI Solver is designed to let the animator jump back and forth between forward and inverse kinematics quickly and conveniently, with tools to automatically enable IK and snap the goal to the end effector.
Procedures

To turn off IK on a chain:

1. Select the goal of a chain with an HI Solver.
2. In the Motion panel IK Solver rollout, turn off Enabled.
   IK is now off, so you can select and rotate any of the objects in the chain.
   Turning IK on and off is animatable using the Auto Key button.

To mix IK and forward kinematics (FK) in a single animation track:

1. Apply an HI IK Solver to a hierarchy or bone system.
2. Turn on the Auto Key button and move the time slider ahead in time.
3. Select the goal of the IK Chain, and open the Motion panel.
4. Select and move the goal to animate the IK chain with Inverse Kinematics.
5. Advance the time slider again.
6. In the IK Solver Rollout, turn off Enabled and IK for FK Pose.
7. Select and rotate the root. The entire hierarchy rotates freely. You are
   now adding keyframes using forward kinematics.

To match the goal and the end effector positions:

1. If the goal and end effector become separated, click IK/FK Snap and the
   goal will move to match the end link of the chain.
2. If AutoSnap is turned on, clicking the goal will automatically perform
   the snap action, matching the goal and end effector positions.
**Interface**

![IK Solver interface diagram]

**IK Solver group**

The items in this group provide the ability to set the start and end points of the selected HI IK solver chain. There are also controls in this rollout that allow you to use IK manipulation to create forward kinematic rotational keyframes on the hierarchy objects, and there are buttons to align the goal and the end effector.
Solver field

Allows selection of IK Solver. Choose between the HI IK Solver and the IK Limb Solver here. Any HI IK plug-in solver present at startup will appear in this list, as well.

Enabled

Turns IK control of the chain on and off.

The HI IK Controller has an FK subcontroller. When Enabled is selected, the FK subcontroller values are overwritten by the IK controller. When Enabled is turned off, the FK values are used. You can animate Enabled On and Off. Use this to turn off the chain control by the goal, when you want to do forward rotations.

IK for FK Pose

Lets you turn on IK in middle of FK manipulation. When Enabled is off and IK for FK Pose is on, moving the goal will turn on IK automatically in the middle of an FK manipulation. The result of this is that all the FK subcontrollers receive values from the IK solution. Keys are placed on the hierarchy objects or the bones, not on the goal. When both Enabled and IK for FK Pose are turned off, moving the goal does not affect the chain at all.

IK/FK Snap

Performs an IK snap when in FK mode, and an FK snap in IK mode.

IK Snap

If the goal has moved away from the end of the chain, clicking IK/FK Snap moves the goal to coincide with the end link position.

FK Snap

The values of FK subcontrollers are suppressed by the solution of IK when IK is on (Enabled is on). Their values don't always correspond to the current pose of the chain. If you turn off Enabled, the values of FK subcontrollers will suddenly take over. This can cause the chain to jump. FK Snap, before Enabled is turned on, forces the FK subcontrollers to assume values from the current pose (which is determined by the IK.) This eliminates the jump in the chain's animation.

Auto Snap

When Auto Snap is on, 3ds Max automatically applies an IK/FK snap before you turn Enabled on or off. If Auto Snap is not on, you need to click IK/FK Snap before toggling Enabled, otherwise the chain will jump.

Preferred Angles group

Set As Pref Angles

Sets the preferred angle for each bone in the HI IK chain. The current parent-space rotation of each bone is placed into its X, Y, and Z Preferred Angle rotation channels as seen in the Rotational Joint rollout of the Hierarchy|IK panel. This is useful for establishing a perfect match frame on page 8632 when transitioning between forward and inverse kinematics.
Assume Pref Angles  Copies the X, Y, and Z preferred angle channels of each bone and places them into its FK rotation subcontroller. This essentially performs the inverse operation of the Set As Pref Angles function.

Bone Joints group

Allows you to change the ends of the IK chain.

Pick Start Joint  Defines one end of the IK chain. Select from the viewport or by name (press H).

Pick End Joint  Defines the other end of the IK chain. The direction of the chain is defined by the hierarchy, not by Start and End Joint. Select from the viewport or by name (press H).

WARNING  If you change the Start or End Joints so the IK Limb Solver so there are more than two bones between the start and end, the solver will not work. Moving the IK goal does not affect the bones.

TIP  The order of the hierarchy determines the direction of the chain. You cannot reverse the direction of the chain by picking Bone 10 as the start and Bone 1 as the end.

IK Solver Properties Rollout (HI Solver)

Select end effector of an HI IK chain. > Motion panel > Parameters button > IK Solver Properties rollout

Here are the additional controls for the HI IK solver. The IK Solver Plane is controlled here through the Swivel Angle, which can be animated directly or using a target object.

In the Parent Space group you can choose to whether the IK goal or the start joint will be used as the parent space for the swivel angle. If IK Goal is selected (which is the default), then the Swivel Angle of the chain is defined in the parent space of its goal. If Start Joint is chosen, then the Swivel Angle will be relative to the parent space of the start joint. These two options allow a much better control of the swivel angle on a chain with two HI IK solvers. For example, the first solver on the upper part of a chain can use a Swivel Angle in the Parent Space of the Start Joint, while the second IK solver on the lower part of the chain uses the Parent Space of the IK Goal. In this case, the change of the Swivel Angle for one chain won’t change the orientation of the other one.
In the Thresholds and Solutions group you can refine the IK solution. The Position Threshold sets a limit in units of how far the goal can be moved from the end effector, the Rotation does the same in angle degrees.

The Solutions group Iterations is the maximum number of attempts the IK solution will perform before giving up.

If your IK animation seems to jitter, try increasing the Iterations to 200. Increasing the Iterations will slow down the computational time, but should produce better results.

**Manipulator for the Swivel Angle**

You can adjust the swivel angle with the spinner in this rollout, or you can adjust it with a manipulator. To do so, turn on Select and Manipulate on page 2838. The swivel angle manipulator is displayed as a handle in the viewports.

Swivel angle manipulator.
Swivel angle manipulator.

When you move the mouse over the manipulator, it turns red. At this point, you can drag the manipulator to change the swivel angle. The Auto Key button can be active while you do this.

You can also animate the swivel angle by using a target object. Pick an object for the target, then animating the object will animate the swivel angle.

The swivel angle manipulator is a standard plane angle manipulator on page 2865. The HI Solver has its own controls for displaying this manipulator. These are on the IK Display Options rollout on page 3704.

**Procedures**

**To increase the precision of an IK solution:**

1. Select the goal in an HI IK chain.
2. In the IK Solver Properties rollout increase the Iterations to 200 in the solutions group.
3. Play or render the animation.
4. You can also adjust the Position and Rotation Thresholds to a smaller value.
Interface

IK Solver Plane group

Swivel Angle Controls the Solver Plane which determines the direction of the knee or elbow in a human limb. The Swivel Angle can be manipulated in the viewport by turning on Swivel Angle Display in the Display Options rollout, and then turning on Manipulate Mode. When the swivel angle manipulator is displayed in the viewport, you can interactively animate the handle to animate the solver plane.

Pick Target Lets you select another object to use to animate the Swivel Angle.

Use Turns the use of the Target on and off.

Parent Space Defines what space the Swivel Angle is relative to. Use this on chains with multiple solvers, so the swivel angle manipulations on one chain will not affect the second. For more information, see White Paper: Swivel Angle of the HI IK Solver on page 3685.

IK Goal Defines the Swivel Angle parent space relative to the IK Goal.

Start Joint Defines the Swivel Angle Parent Space relative to the Start Joint.

Thresholds group

Use to define the tolerances the system uses for its calculations.
**Position** Sets a limit in units of how far the goal can be moved from the end effector. Keep these numbers low.

**Rotation** Sets a limit in degrees of how far the goal can be rotated away from the end effector rotation. Keep these numbers low for best results.

Note that adjusting the Rotation threshold on the HI Solver and IK Limb Solver has no effect. It is up to the plug-in solver’s discretion as to whether or not they will support a rotation component in the IK solution.

**Solutions group**

Use to control the precision of the animation. Increase the iterations when the IK solution produces an animation that appears rough or jittered.

**Iterations** The number of attempts an IK solution will make to find the best match between the goal and the end effector positions. Increase this number if you are seeing jumpy animation.

**IK Display Options Rollout (HI Solver)**

Create a bone chain > Add an HI Solver. > Motion panel

Here are the controls to turn on and off a variety of gizmos in the viewport. The Goal and End effectors, the vector handle of the swivel angle manipulator, and the IK solver display itself, are all located in this rollout.

**Procedures**

To see multiple IK solvers in a single chain:

1. In a chain with multiple IK solvers, select a goal in the viewport.
2. In the IK Display Options rollout, turn on IK Solver Display Enabled.
3. Select a second goal and repeat the process.
   Each goal’s display remains on whether it is selected or not.
Interface

### End Effector Display group

Controls the appearance of the end effectors in the IK chain. Off by default.

- **Enabled** Turns the end effectors display on or off.
- **Size** Controls the size of the end effector gizmo in the viewport.

### Goal Display group

Controls the appearance of the goals in the IK chain. On by default.

- **Enabled** Turns the goals display on or off.
- **Size** Controls the size of the goal gizmo in the viewport.

### Swivel Angle Manipulator group

Controls the display of the swivel angle manipulator in the IK chain. Default = on. Turn this on, then turn on Manipulate mode to see the swivel angle manipulator.

- **Enabled** Turns the swivel angle manipulators on or off.
Size Controls the size of the manipulator's handle in viewports.

Length Controls the length of the manipulator in viewports.

IK Solver Display group

Controls the appearance of the IK Solver display, the line drawn between the start and end joints. Turn this on when you have multiple chains that you want to see at the same time.

Enabled Turns on or off the IK Solver display.

Sliding and Rotational Joints (HI Solver)

Create a bone chain. > Apply an HI Solver > Select any bone in the chain. > Open the Hierarchy panel. > IK button

Here are the controls for setting the joint limits when using the HI Solver. You can turn X, Y, or Z axes on or off, limit them, and set those limits here. This is also where the preferred angle is defined, and adjusted. The preferred angle defines the direction a chain will bend, which angle a chain will tend to rotate toward.

NOTE Sliding joints are implemented in the HI Solver, but they do not take part in an IK solution. They do, however, take part during FK interactive manipulation.

Use the HD Solver if you need to animate sliding joints with inverse kinematics.

Procedures

Example: To set the direction an IK chain will bend (preferred angle):

To understand setting the preferred angle it helps to use a simple example.

1. Go to Create panel > Systems and turn on Bones.

2. Turn on Assign to Children and make sure the HI Solver is displayed in the Solver name field.

3. In the Top viewport, create a bone chain of four bones in a straight line.

4. Turn on the Auto Key button, and move the time slider to frame 50.

5. Select and move the goal so it is close to the root node.
6 Select any bone in the chain.
7 On the Hierarchy panel > IK panel, open the Rotational Joint rollout.
8 There are three axes. Find the one with the preferred angle that is not zero.
9 Change the preferred angle. If it is negative make it a positive one.
10 Play the animation, see how changing the preferred angle can redefine the direction of the rotation.

To set rotational joint limits on a hierarchy of objects or a bone chain:
1 Create a bone chain or a hierarchy of objects.
2 Select any object in the chain.
3 On the Hierarchy panel > IK panel, open the Rotational Joint rollout.
4 If you want to limit an axis, turn on Active and Limited, and set the values of From and To. The hierarchy will rotate in the viewport.

**TIP** Pressing the From and To labels instantly rotates the bone to those angles.
Interface

Sliding Joints rollout

X, Y, Z Axis groups

**Active** Activates an axis (X/Y/Z). Allows the selected object to slide on the activated axis.

**Limited** Limits the range of motion allowed on an active axis. Use in conjunction with the From and To spinners. Most joints are limited in their range of motion along an active axis. For example, a piston slides only within the length of its cylinder.

**From and To spinners** Determine for position limits. Use in conjunction with the Limited function. Clicking the labels From and To moves the object to its limit position. Use this to check the sliding limits on an object.
Rotational Joints rollout

Active
Activates an axis (X/Y/Z). Allows the selected object to rotate about the activated axis.

Limited
Limits the range of rotation allowed on an active axis. Use in conjunction with the From and To spinners. Most joints are limited in their range of rotation along an active axis. For example, a wheel rotating around an axle could be limited to rotate around only one axis.

From and To Spinners
Determine for rotation limits. Use in conjunction with the Limited function. Clicking the labels From and To rotates the object to its limit rotation. Use this to check the rotation limits on an object.

Preferred Angle
Used by the HI Solver to set the initial pose for internal calculations. Determines the direction of rotation preferred by a bone.

X, Y, Z Axis groups

Active
Activates an axis (X/Y/Z). Allows the selected object to rotate about the activated axis.

Limited
Limits the range of rotation allowed on an active axis. Use in conjunction with the From and To spinners. Most joints are limited in their range of rotation along an active axis. For example, a wheel rotating around an axle could be limited to rotate around only one axis.

From and To Spinners
Determine for rotation limits. Use in conjunction with the Limited function. Clicking the labels From and To rotates the object to its limit rotation. Use this to check the rotation limits on an object.

Preferred Angle
Used by the HI Solver to set the initial pose for internal calculations. Determines the direction of rotation preferred by a bone.
History-Dependent (HD) IK Solver

Select a node of hierarchy or bone chain. > Animation menu > IK Solvers > HD Solver > Click a second node of chain.

Animating with the HD Solver lets you use sliding joints combined with inverse kinematics. It has controls for spring back, damping, and precedence not found in the HI Solver. It also has quick tools for viewing the initial state of the IK chain. Use it for animations of machines and other assemblies. Since this is history dependent, performance is slower at the end of long animations. For lengthy scenes, use HI Solvers, if possible.

Animating the End Effectors

You animate a hierarchy of objects or bone structure using HD Solvers by animating special end effectors located at the bone joints. There are two types of end effectors: Position and Rotation. They are displayed as three intersecting blue lines at the joint.

When you select and transform a joint that carries either end effector, only the end effector itself is transformed. The objects or bones in the chain then use IK to calculate the IK solution.

Animating these end effectors is much like animating with Interactive IK except interpolation between keyframes uses correct IK solutions.

Linking End Effectors to a Parent

You can link HD IK end effectors to a parent to achieve results similar to using bound follow objects with Interactive and Applied IK. To link a HD IK end effector, you click Link on the Motion panel.

There are two reasons to link an end effector to a parent:

■ You can rescale your entire hierarchy. If you animate a robot, and then later decide you want to scale the entire robot and its animation, link the robot’s root object to a dummy, link all of the robot’s end effectors to the same dummy, and then scale the dummy to scale all of the hierarchical objects as well as the animation of the end effectors.

■ You can use linked end effectors for things like feet or hands. End-effectors are automatically bound to the world, so when you move a root object in your hierarchy, the end effectors remain behind. This is good for keeping feet on the ground, but not very good for hands, where you want them to
move along with the character. To have hands follow the root object, link the end effectors of the hands to the root object.

**Linking Bones to Follow Objects**

You can also use follow objects instead of end effectors and bind bones to any number of follow objects using Interactive IK.

If you use follow objects with HD IK, you do not need to click Apply IK. The IK solver takes care of everything automatically.

See also:

- Inverse Kinematics Rollout on page 3784

**Binding Objects (HD Solver)**

Use the binding functions on page 3774 in the HD Solver to cause an object to attempt to maintain its position and orientation relative to the world or to another object. A bound object will resist motion in the kinematic chain until the chain is stretched near its limits and the bound object must move to complete the IK solution.

In the top row, the ball is independent of the lamp. In the bottom row, the lamp head is bound to the ball’s position.

**Setting Binding Options**

You can bind an object by position, orientation, or both. Once an object is bound you can set binding axes, weight, and whether the binding is absolute or relative.
Bind Position  Causes an object to attempt to maintain its location or to match the location of a follow object.

Bind Orientation  Causes an object to attempt to maintain its rotational orientation or to match the orientation of a follow object.

Relative  Changes how an object reacts to a bound follow object. See the following discussion about binding an object to a follow object.

Axis and Weight  Set these options to control which axes are affected by the binding and the binding’s influence over other bindings in the kinematic chain.

Binding an Object to the World

You can bind an object to the world if you want the object to hold its position and orientation as long as possible during IK operations.

If you are animating a walking figure you want one foot to remain in place while you position the other foot. Without binding, the whole hierarchy would have a tendency to slide around when you attempt to position a foot. Binding both feet to the world ensures that the unselected foot stays in place while you position the other foot.

Binding an Object to a Follow Object

You can bind a selected object in your hierarchy to any other object that is not a descendant of the selected object. This other object is called the follow object.

The behavior of the bound object varies depending on the state of the Relative buttons next to the bind options.

■ When Relative is inactive, the bound object tries to match the exact position and orientation of its pivot point to the position and orientation of the follow object’s pivot point.

■ When Relative is active, the bound object mimics any changes in position or rotation of the follow object but does not try to match it exactly.

You might want to animate a figure that always points to another object. Bind the hand of the figure to the other object with Relative active. Turn IK on, and as you move the object, the hand and arm of the figure move to point at it.
Unbinding Objects

If you decide that you do not want an object to be bound you can either turn off the Bind Orientation and Bind Position boxes, or unbind the object from its follow object.

- If you turn off the binding options, you disable the effect of binding without removing the binding to a follow object. This method is handy if you decide to reposition a follow object after you have bound an object to it.
- If you unbind an object, it permanently removes the binding to a follow object.

Controlling IK Precision (HD Solver)

Even with carefully defined joint precedence and joint parameters there are many valid IK solutions for any placement of an end effector. You set position and rotation thresholds to control IK precision and solution speed.

- The threshold and iteration settings are found on the Motion panel on the IK Controller Parameters Rollout, when the end effector is selected.
- The threshold and iteration settings for the HD solver are also found on the Inverse Kinematics tab of the Customize > Preferences dialog.

Position Threshold Sets how close the end effector has to get to the follow object or cursor position to be considered a valid solution. The value expresses a distance in the current unit system. Small values increase accuracy but take longer to solve.

Rotation Threshold Sets how accurately the end effector has to match the orientation of the follow object to be considered a valid solution. The value expresses a rotation angle in degrees. Small values increase accuracy but take longer to solve.

Iterations Sets the maximum number of times 3ds Max repeats the IK calculations to find a valid solution. A high Iterations value increases the chance that 3ds Max can calculate a valid solution, but takes longer to complete. The following rules apply:

- Calculations stop as soon as a valid solution is found, even if the maximum number of iterations have not been performed.
The last solution calculated is used if the maximum number of iterations is reached, regardless of whether the solution satisfies the position and rotation thresholds.

**Setting Applied and Interactive Thresholds**

You set the threshold and iterations settings as a trade-off between accuracy and speed. You have two groups of settings so you can individually tune the behavior of applied IK and interactive IK.

- Use interactive IK if you want fast, real-time response. Your interactive IK preferences should be set for speed.
- Use applied IK if you want the solution to match the follow objects very closely. Your Applied IK preferences should be set for accuracy.

The default applied IK and interactive IK settings are shown in the following table:

<table>
<thead>
<tr>
<th>Thresholds</th>
<th>Applied IK</th>
<th>Interactive IK</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position</td>
<td>0.100</td>
<td>1.000</td>
</tr>
<tr>
<td>Rotation</td>
<td>0.100</td>
<td>1.000</td>
</tr>
<tr>
<td>Iterations</td>
<td>50</td>
<td>10</td>
</tr>
</tbody>
</table>

**See also:**

- HD Solver Motion Panel Rollouts on page 3714

**HD Solver Motion Panel Rollouts**

Select end effector of an HD chain > Motion panel > Parameters button > IK Controller Parameters rollout

To adjust the parameters for all bones or hierarchically linked objects in the chain, you select a single bone or object, and then adjust the parameters in Motion panel > Parameters to affect all the bones or objects in the hierarchy.
Procedures

See History-Dependent (HD) IK Solver on page 3710.

Interface

Thresholds group

These settings are the same as those in Customize menu > Preferences > Inverse Kinematics. They set the threshold for the changes in position and rotation between the end effector and the last link of the chain.

**Position** Specifies, in units, the "slop" factor between the end effector and its associate object. This is the allowable distance between the end effector and its object, given the current IK solution.

**Rotation** Specifies the allowable number of degrees of rotational error between a rotational end effector and its associate object.

Solution group

**Iterations** Specifies the maximum number of iterations allowed to solve the IK solution. The actual number of iterations used depends on the difficulty of the problem. This value simply puts a cap on it.

**Start Time and End Time** Specifies the range of frames in which IK is solved. If the Start Time is set to 20 and the End Time is set to 80 in a 100-frame animation, and then the end effector is animated, the animation of the chain will only be correctly solved within the Start and End range.
Initial State group

When you first create a hierarchical chain, the initial position of the bones or objects is the initial state. The options here let you display, alter, or lock the initial state. When both of the options here are turned off (the default), transforming the end effector is different from transforming the other joints in the chain. When you select and transform a joint assigned an end effector, you are actually transforming the end effector, and an IK solution transforms the joints. This alters the position of the bones or objects in the viewport, but will not alter their initial state. On the other hand, when you select and transform any of the joints without end effectors, you alter their initial state.

Show Initial State Shuts off the real-time IK solution. All objects in the chain are moved to their initial positions and orientations prior to any changes caused by IK calculations. The positions of the end effectors, however, are not affected.

Turn on Show Initial State to view the initial state, or adjust the initial state of bones or objects using end effectors. This is useful when you set joint limits using the IK controls in the Hierarchy panel: the joints jump to their limits while you set them. When Show Initial State is off (the default), you can select and alter the initial state of bones or objects without end effectors, but when you select a bone or object with an end effector, the end effector is transformed, leading to an IK solution; the initial state of the associate object is not changed. By selecting this, you can transform the initial state of the associated object.

Lock Initial State Locks all bones or objects in the chain from direct transformations. You can, however, transform the end effector of any joint to generate the IK solution without altering the initial state. Activate this when you want to avoid accidentally selecting and transforming joints that are not assigned end effectors. When Show Initial State is selected, Lock Initial State is ignored.
Update group

The options in this group determine how the IK calculation is solved during the transformation of the end effector.

**Precise** Solves the entire chain precisely for all frames from the Start time to the current time. When you release the mouse button, the chain will not move. Since all frames must be solved from Start to current time, the solution takes longer if the current frame is 1000 rather than 100.

**Fast** Solves the chain only for the current frame while the mouse is moved. Releasing the mouse button solves for all frames. Although this is faster than Precise, sometimes the current-frame solution differs slightly from the all-frame solution. As a result, when you release the mouse, the objects in the chain might shift a bit.

**Manual** With this option, the IK problem is not solved until you click Update.

**Update** With Manual on, click to solve the IK solution.

Display Joints group

The options here affect the display of the joint axes and limits. When a rotational or sliding joint is active (Active is selected in the Sliding or Rotational Joints rollouts in Hierarchy > IK panels), an orange "rod" appears representing the active axis. When the joint is also limited, a pair of small orange squares appears, representing the From and To limits of the joint. If it's a sliding joint, the squares are positioned on the axis rod. If it's a rotational joint, the squares are at the ends of an orange arc.

**Always** Displays the axis rod and joint limits for all joints in the chain at all times.
**When Selected** Displays the axis rod and joint limits only on selected joints.

**TIP** The joint icons can be difficult to see when the bones are linked to mesh objects. When animating a bone-based hierarchy, you can hide all of the objects and display and animate only the bones, which makes the joint icons more visible. This is easily done by hiding geometry by category in the Display branch.

---

**End Effectors group**

With the options in this group, you can add or delete Position or Rotation end effectors for any joint. Options affect only the currently selected joint. An end effector is the object that the IK chain follows to come to a solution. There are two types of end effectors: Position and Rotation. Both are displayed as three intersecting blue lines at the joint. When you select a joint that carries either or both end effectors and perform a transformation matching the type of end effector, only the end effector itself is transformed. The objects in the chain then use IK to follow and create the IK solution.

When you transform a joint that does not have an end effector (or perform a type of transform that doesn’t match the assigned end effector), you transform the joint itself and alter its initial state.

**Position** Creates or deletes Position end effectors. If the node already has an end effector, only the Delete button is available.

**Create** Creates a Position end effector for the selected node.

**Delete** Removes the Position end effector from the selected node.

**Rotation** Works like the Position buttons, except Rotation end effectors are created rather than Position end effectors. When you want to solve for IK rotation, add a Rotation end effector, and then use the Rotate tool to rotate the end effector.
End Effector Parent Links an end effector to another object in the scene. Since end effectors are not, in themselves, objects, you won't see this linkage in Track View, but the linked end effector will inherit the transformations of its parent.

NOTE Apart from the root object, you can't link an end effector to an object in the hierarchy because it would create an endless loop. The position of all objects in the hierarchy depends on the position of the end effector, so the end effector can't depend on the position of an object in the hierarchy.

End Effector (Display) Displays the name of the selected parent object.

Link Makes a selected object a parent of the currently selected link.

Unlink Unlinks the currently selected end effector from its parent.

Remove IK group

Delete Joint Deletes any selection of bones or hierarchical objects. Doesn't delete the IK; only the selected hierarchical members.

NOTE Using the DELETE key will delete the entire hierarchy.

Remove IK Chain Deletes the IK Solver from the hierarchy. Doesn't delete the objects or bones, only the IK controls.

Position Displays the Key Info parameter rollouts specific for a Position end effector. This option is not active if no Position end effector is assigned. (The Key Info parameters are the same as those used for any Position controller.)

Rotation Displays the parameters for an assigned Rotation end effector. This option is not active if no Rotation effector is assigned. (The Key Info parameters are the same as those used for any Rotation controller.)
HD Joint Settings

You control a joint's resistance to motion, and its tendency to return to its original position, by setting Ease, Damping, and Spring Back options.

Moving telescopes with and without damping

Easing a Joint at Its Limits

An organic joint, or a worn mechanical joint, moves freely in the middle of its range of motion but moves less freely at the extremes of its range. Use Ease to cause a joint to resist motion as it approaches its From and To limits.

For example, your forearm might move freely in the middle of its range of motion, but it resists movement when you try to squeeze it against your upper arm or extend it all the way out. Ease simulates this effect.

Damping Joint Action

As a joint corrodes, dries out, or is put under a heavy load, it resists motion along its active axes. Damping simulates the natural effect of joint friction or inertia. Enter a value greater than zero in the Damping field to apply resistance over a joint's full range of motion.

As damping increases a joint resists motion and other joints are required to move more. A damping value of 1.0 means there is extreme resistance and a joint will not move on that axis.
For example, a telescope with no damping at all allows each cylinder to move to its maximum limit before the next cylinder moves. If the cylinders have damping values assigned, then each cylinder causes its parent to begin moving before it reaches full extension.

Setting a Joint to Spring Back

When a joint resists motion, it also has a tendency to return toward its at-rest position. You simulate this by setting Spring Back tension in the joints. As the joint moves further from its rest position, an increasingly larger force pulls the joint back, like a spring.

When you set Spring Tension higher, the spring pulls harder as the joint moves farther away from its rest position. Very high settings can turn the joint into a limit, because you can reach the point where the spring is too strong to allow the joint to move any farther.

Setting Joint Precedence (HD Solver)

You set Joint Precedence to control the order in which joint calculations are applied to the kinematic chain. When an IK solution is calculated, the result is dependent on the order of calculation for each joint.

The hoof (a child) has precedence over the leg (its parent).
The hoof (a child) has precedence over the leg (its parent).

For any given position of an end effector, there are many possible IK solutions. The three joint precedence controls in the Object Parameters rollout are:

- **Precedence** Sets joint precedence manually.
- **Child->Parent** Automatically sets joint precedence to decrease in value from child to parent.
- **Parent->Child** Automatically sets joint precedence to decrease in value from parent to child.

**Determining Order of Calculations**

You control the HD IK solution by setting joint precedence to determine which joints contribute the most to the HD IK solution and which joints contribute the least.

- Joints with high precedence values are calculated first, and contribute more motion to the HD IK solution.
Joints with low precedence values are calculated last and contribute the least motion to the HD IK solution.

Joints with equal precedence values are calculated by order in the hierarchy. Joints closer to the end effector are calculated first and joints closer to the root are calculated last.

Of all of the joint parameters, Joint Precedence is the most subtle.

See also:
- Using Default Joint Precedence (HD Solver) on page 3723
- Choosing Child-to-Parent Precedence (HD Solver) on page 3724
- Choosing Parent-to-Child Precedence (HD Solver) on page 3726
- Setting Precedence Manually (HD Solver) on page 3727

**Using Default Joint Precedence (HD Solver)**

The default joint precedence is suitable for many HD IK solutions. It assumes that joints closest to where a force is applied (the end effector) will move more than joints farther from the force.

The default joint precedence is a value of 0 for every joint: *all joints have the same precedence value*. This default starts calculations with the end effector and progresses up the IK chain until the base object is reached.

Using methods described in the following topics you can change the default precedence values. You can also set your kinematic chain back to its default precedence.

**To reset the default joint precedence:**

1. Select all objects in the kinematic chain.
2. On the Hierarchy panel, expand the Object Parameters rollout.
3. Set Precedence to 0.

**NOTE** Default joint precedence occurs whenever all joints in the kinematic chain have the same precedence value. Assigning a value of 100 to all objects in the kinematic chain is exactly the same as assigning a value of 0.
Choosing Child-to-Parent Precedence (HD Solver)

Child→Parent precedence causes joints closest to where a force is applied (the end effector) to move more than joints that are farther away from the force. Like the default precedence, Child→Parent precedence produces a natural result that is suitable for many IK solutions.

The difference is that Child→Parent precedence assigns unique values to each object in the kinematic chain (default precedence uses the value of 0 for every object). Child→Parent precedence is more flexible if you want to go back and manually change precedence values.

The first figure shows values for child-to-parent precedence.
The first figure shows values for child-to-parent precedence.

**Assigning Child->Parent Precedence**

Clicking Child->Parent sets joint precedence based on a child having a higher precedence than its parent. The values are calculated by setting the root of the entire hierarchy to a precedence value of 0 and each child to a value equal to 10 times its depth from the root.

You almost always assign Child->Parent precedence to an entire kinematic chain. The chain for the structure in the figure uses the body as the root object and the duck as the end effector.

Each object receives a value equal to its depth from the root of the hierarchy times 10. Note that precedence value calculation is based on the root of the hierarchy whether or not the root is selected as part of the kinematic chain.

You might want to assign Child->Parent precedence to just a single object in the kinematic chain. For example, if you have been manually changing precedence values, you might want to set an object to its original Child->Parent value. The value assigned to the object is equal to its depth from the root of the hierarchy times 10.
Choosing Parent-to-Child Precedence (HD Solver)

Parent->Child precedence causes joints closest to where a force is applied (the end effector) to move less than joints farther away from the force. This is the opposite of Child->Parent precedence. Parent->Child precedence assigns the highest precedence to the base object and the lowest precedence to the end effector.

You might use this type of precedence for a number of special cases. For example:

- When joints near the end effector are less flexible than joints near the base. You use Parent->Child precedence in conjunction with limits and damping. For more information about the latter two, see Setting Joint Resistance and Spring Back on page 3720.

- When animating a kinematic chain where the real-world object is moved by applying force to the base of the chain. Imagine an animal’s tail. Using IK you animate the tail by moving the tip of the tail. However, a real animal moves its tail using muscles at the tail’s base. The real-world motion is applied from the base to the tip in a Parent->Child order.

The figure shows values for parent-to-child precedence.
The figure shows values for parent-to-child precedence.

**Assigning Parent->Child Precedence**

Clicking Parent->Child sets joint precedence based on a child having a lower precedence than its parent. The values are calculated by setting the root of the entire hierarchy to a precedence of 0 and each child to a value equal to -10 times its depth from the root.

You almost always assign Parent->Child precedence to an entire kinematic chain. The chain for the structure in the above figure uses the body as the root object and the duck as the end effector. Using Parent->Child precedence, the feet are assigned a precedence of -50 and the duck is assigned a precedence of -140.

You might want to assign Parent->Child precedence to a single object in the kinematic chain. The value assigned to the object is equal to its depth from the root of the hierarchy times -10.

**Setting Precedence Manually (HD Solver)**

Some models and animated motions don't fit neatly into a Child->Parent or Parent->Child precedence. In such situations you can manually assign precedence values to any object in the IK chain on a joint-by-joint basis.
For example:

- Animating models with a combination of light, flexible joints and heavy, resisting joints. Imagine a model of heavy iron balls linked together with lengths of chain. Setting the precedence values of the chains higher than the precedence values of the iron balls simulates the balls' inertial resistance to motion.

- Animating a motion where certain joints must move before other joints. Imagine a golfer's arm where the elbow should remain locked while swinging a golf club. You could accomplish this by setting the precedence of the elbow lower than the precedence of the wrist and shoulder.

High precedence values are calculated before low precedence values. Precedence values that are equal are calculated in Child->Parent order.

The precedence calculations only consider the relative IK values. This means that an IK chain of three objects with precedence values of 0, 30, and 200 would have the same solution if the precedence were changed to 1, 2, and 3.

The figures show precedence values that were assigned manually: the chain for the structure uses the body as the root object and the duck as the end effector.
The figures show precedence values that were assigned manually: the chain for the structure uses the body as the root object and the duck as the end effector.

**Terminating Chains (HD Solver)**

The kinematic chain is automatically defined using the object you select as the end effector and working up the hierarchical tree to use the root object as the base of the kinematic chain. Sometimes you might not want the kinematic chain to go all the way to the root of the hierarchy. This is especially true when you are animating multi-limbed or branching structures, such as an octopus or a tree.
You use the Terminator option in the Object Parameters rollout to stop calculation of the kinematic chain before it reaches the root object of the hierarchy. A terminator object stops calculation at the terminator's child object; the terminator itself is not affected by the IK solution. This gives you very precise control over the behavior of the kinematic chain.

For example, look at the bird in the figure. The bird is linked with its body as the root of the hierarchy. If you use inverse kinematics to move the duck, all objects from the duck to the body will be affected by the IK solution. However, if you define a neck bone as a terminator object, then only the objects from the duck to the neck vertebrae are affected.
With a terminator in the neck, the body of the bird is not affected.

With a terminator in the neck, the body of the bird is not affected.
IK Limb Solver

The IK Limb solver is specifically meant for animating the limbs of human characters; for example, the hip to the ankle, or the shoulder to the wrist. Each IK Limb solver affects only two bones in a chain, but multiple solvers can be applied to different parts of the same chain. It is an analytical solver that is very fast and accurate in viewports.

To use the IK Limb solver, a bones system must have at least three bones in the chain. The goal is placed at the pivot point of the bone that is two bones away from the first selected bone.

The IK Limb solver works not only with bone hierarchies, but with any linked hierarchy that has at least three elements, and is set up to model a human limb. The additional requirements are:

- The first joint is "spherical." That is, it has three degrees of freedom.
- The second joint is "revolute," a robotics term that means it is based on a pin and has one degree of freedom.

The IK Limb solver uses the same controls as the HI Solver, so it allows for mixing periods of forward and inverse kinematics in the same animation period. It does not use the HD Solver methods of damping, precedence, and setting joint limits, instead it has a preferred angle parameter, swivel plane and IK/FK Enabling.

The IK Limb solver can be exported directly to a game engine.

See also:
- IK Solver Rollout (HI Solver) on page 3695
- IK Solver Properties Rollout (HI Solver) on page 3700
- IK Display Options Rollout (HI Solver) on page 3704
- Sliding and Rotational Joints (HI Solver) on page 3706

Procedures

To apply a IK limb solver:

1. Create a chain that has three bones.
2. Select the root of the chain.
3 From the Animation menu, choose IK Solvers > IK Limb Solver.

4 In the viewport, move the mouse. You will see a dotted line attached to the cursor as you move the mouse.

5 Click the third bone in the chain, or any bone after the third bone. The IK Limb solver displays on the bone chain. The IK Limb solver only affects two bones in the chain, but you need to select the third bone to put it on the other two bones.

To animate an IK limb solver chain:

1 Apply the IK Limb solver to a two bone chain, with joint limits as described above.

2 Select the goal.

3 Move or rotate the goal.

Interface

The Interface for the IK Limb solver is identical to that of the HI Solver.

Select the goal at the end of the chain, and open the Motion panel. Here you will see the controls for the IK Limb solver. (The fourth is available from the Hierarchy > IK panel when a bone is selected.)

Spline IK

Animation menu > IK Solvers > Spline IK Solver

Create panel > Systems > Bones > Choose SplineIKSolver from the IK Solver list.

The Spline IK solver uses a spline to determine the curvature of a series of bones or other linked objects.
You can move and animate the spline vertices to change the curvature of the spline. Usually, a helper is placed at each vertex to assist in animating the spline. The spline curvature is then passed on to the entire linked structure. The bones themselves do not change shape.

Normally the number of spline vertices and bones are the same, but you can use fewer vertices for easier posing and animating a long multiple-bone structure with just a few nodes, as opposed to animating each bone individually.

Spline IK provides a more flexible animation system than other IK solvers. You can position vertices/helpers anywhere in 3D space, so the linked structure can assume any shape you want to give it.

A helper object is automatically placed at each vertex when Spline IK is assigned. Each vertex is linked to its corresponding helper, so a vertex can be moved by moving the helper.

Unlike the HI Solver, the Spline IK system does not use a goal. The positions of helpers/vertices in 3D space is the only factor that determines the shape of the linked structure.
NOTE Moving the Spline IK helpers to curl the spline can sometimes cause bones to rotate or flip unexpectedly. If this happens, you can try choosing a different upnode object with the IK chain's Pick Upnode option in the IK Solver Properties rollout (see Spline IK Solver Rollouts on page 3743), or use a different IK method for your hierarchy.

Applying a Spline IK Solver

The Spline IK solver can be applied at the time bones are created, or after the bone structure has already been made.

To apply a spline IK solver when bones are created:

1. Choose Create panel ➤ Systems ➤ Bones.

2. On the IK Chain Assignment rollout, set IK Solver to SplineIKSolver, and turn on both check boxes: Assign To Children and Assign To Root. By default, Assign To Root is on automatically when you turn on Assign To Children.

3. Draw the bone structure as usual. When you right-click to end the bone creation process, the Spline IK Solver dialog on page 3740 appears. Set parameters and click OK.
Chapter 13  Animation
This procedure automatically draws the spline based on your dialog selections and sets up the Spline IK system to work with the spline. 3ds Max automatically assigns a Path constraint to the root bone to constrain it to the helper/vertex at that end of the spline.

To apply a Spline IK solver to an existing bone structure:

1 Create a bone structure without an IK chain.

2 Draw a spline or NURBS curve to be used by the bones. The curve can have any length and shape, and does not have to match the length or shape of the bone structure.

3 Select the bone or object where you want the solver to start.

4 Choose Animation menu > IK Solvers > Spline IK Solver. In the viewport, move the cursor to the bone or object where you want the chain to end and click that bone. Then move the cursor to the spline and click it.
The bone structure jumps to the spline and takes its shape, and a helper is created on the spline at each vertex. A Path constraint is automatically assigned to the root bone to constrain it to the helper/vertex at that end of the spline.
To specify a spline after the spline IK solver is applied:

You can also apply a Spline IK solver to an existing bone structure without selecting a spline, then choose the spline later.

1. Create a bone structure without an IK chain.
2. Select the bone or object where you want the solver to start.
3. Choose Animation menu > IK Solvers > Spline IK Solver. In the viewport, move the cursor to the bone or object where you want the chain to end and click that bone. Then right-click in the viewport to end the IK solver creation without choosing a spline.
4. Create a spline or NURBS curve to be used with the Spline IK system. It is recommended that you apply the Spline IK Control modifier on page 1738 to it and then click Create Helpers to place helpers at each vertex, making the spline easier to control.
5. Select the IK chain cross hairs and access the Motion panel. On the Spline IK Solver rollout, click Pick Shape and click the spline.
With this method, the position constraint is not automatically assigned to the root bone, so it must be assigned manually.

6 Select the root bone. Choose Animation menu > Constraints > Path Constraint, and then click the spline.
This moves the bone structure to the spline, if they're apart, and creates a Position List controller for the bone with the Path Constraint as the second (active) constraint.

NOTE This also animates the bones along the path. If you don't want this, delete the second animation key.

Working with the Spline IK Solver

To use the Spline IK Solver, move the helpers to shape the spline. Do not move the spline. The shape of the spline is determined by the positions of the vertices, so moving the spline itself has no effect on the bone structure. If the spline is moved, it will snap back to the helpers the next time a helper is moved. However, it is recommended that you not move the spline at all.

Once you have finished setting up the spline IK solver, it can be helpful to freeze the spline to avoid accidentally moving it.

Moving helpers changes the shape of the spline. To twist the spline, select the spline IK chain object and go to the Motion panel to change twist angles in the IK Solver Properties rollout.

Spline IK Solver Dialog

Create menu > Systems > Bones > Choose SplineIKSolver as IK Solver and turn on Assign To Children. > Create bone structure.

The Spline IK Solver dialog appears after bone creation if the Spline IK Solver has been selected as the IK solver and Assign To Children is turned on.
This dialog sets parameters for the spline that will be created to control the bone structure. The spline, in turn, is shaped by the positions of helper objects at each knot (control point).

See also:

- Spline IK on page 3733
Interface

Spline Options group

**IK Name** Sets the name of the IK chain object. This object appears as a set of blue cross hairs at the end of the chain after you click OK.

**Auto Create Spline** Automatically creates the spline used for the Spline IK solver based on the parameters on this dialog. When off, no spline is created and a spline must be manually created and assigned to the spline IK solver in order to use the solver. See Animating with the Spline IK Solver on page 3733 for a description of this procedure. Default=on.

**Curve Type** Choose the type of curve to serve as the Spline IK control:

- **Bezier** Creates a Bezier spline, similar to a spline created with the Create > Shapes > Line tool. This is the default curve type.

- **NURBS Point** Creates a NURBS Point Curve, where all knots (control nodes) lie on the curve.

- **NURBS CV** Creates a NURBS CV Curve, where knots (control nodes) do not necessarily lie on the curve.
Number of Spline Knots Vertices on the spline, or control points and CVs on the NURBS curve. You alter the spline or curve by moving and animating the knots. The number of knots sets the degree of refinement on the curve as well as the number of points that can be selected and moved to change the shape of the curve.

The default value is the number of bones in the Spline IK chain. Because one purpose of a Spline IK solver is to reduce the number of objects that require animation, you might want to use a lower value, such as half the number of bones.

Helper Options group

Create Helpers When on, 3ds Max places one or more Point helper on page 2853 objects at each knot in the spline or curve, making it easier to move and animate the knots.

You can enable more than one type of helper. When you move one helper, the others at the same location also move, as does the curve knot.

Center Marker Places a small X-shaped Point helper at each knot.

Axis Tripod Places a small tripod-axis-shaped Point helper at each knot.

Cross Places a small cross-shaped Point helper at each knot.

Box Places a small box-shaped Point helper at each knot.

Size Sets the size for helpers.

Constant Screen Size Keeps the sizes of helpers constant regardless of the zoom extent of the viewports.

Draw On Top Displays the helpers on top of all other objects in the scene for improved visibility in busy scenes.

TIP To change the display of helpers after creation, select each helper and change selections on the Modify panel.

Spline IK Solver Rollouts

Select a Spline IK Solver control (the blue cross at the end of the chain) > Motion panel > Parameters button
When a Spline IK chain is selected, the options on the Motion panel can be used to change the starting and ending bones, and twist angles for the entire linked structure.

To create a Spline IK Solver, see Spline IK on page 3733.

**Interface**

**Spline IK Solver rollout**

The options on this rollout allow you to pick a new spline for the spline IK chain, or pick new start and end joints for the chain.

**Spline IK Solver group**

**Spline IK Solver** Displays the name of the solver. The only available solver is Spline IK Solver.

**Enabled** Turns control of the solver on and off.

**Bone Joints group**

**Pick Start Joint** Picks the start joint for the Spline IK Solver and displays the object name.

**Pick End Joint** Picks the end joint for the Spline IK Solver and displays the object name.
IK Solver Properties rollout

The options on this rollout set the start and end twist angles for the spline IK chain. The twist manipulators on each end of the chain show the degree of twist.

**Twist Start Angle** Sets the twist angle for the entire chain, rotating all bones in the chain.

**Twist End Angle** Sets the twist angle for the end joint relative to the start joint, creating a gradual twist over the entire chain.

**Pick Upnode** When Spline IK is assigned to a bone chain, the IK system attempts to determine the “up” direction for bones, which is the direction in which the bones’ back fins should point. The Spline IK Solver might interpret this direction incorrectly, causing bones to flip to one side or the other. Picking an upnode causes the “up” direction to point along the picked object’s local Z axis. By default, the upnode is set to the first helper/knot on the spline, which usually causes the “up” direction to be interpreted correctly.

**Use** Use the picked node to specify the “up” direction for the root bone.

IK Display Options rollout

The options on this rollout set the display of twist manipulators and the IK chain object.

**TIP** To see and adjust the twist manipulators, turn on Select And Manipulate on page 2838.
Twist Start group

Enabled Turns on the display of the start twist manipulator. Default=on.
Size Sets the size of the start twist manipulator. Default=1.0.
Length Sets the length of the start twist manipulator. Default=75.0

Twist End group

Enabled Turns on the display of the end twist manipulator. Default=on.
Size Sets the size of the end twist manipulator. Default=1.0.
Length Sets the length of the end twist manipulator. Default=75.0.

Goal Display group

Enabled Turns on the display of the IK goal. Default=on.
Size Sets the size of the IK goal. Default=30.0.
IK Solver Display group

Enabled Turns on the display of the IK chain object. Default=off.

Interactive and Applied IK

Interactive IK and Applied IK are alternative methods to the IK Solver methods.

**TIP** Interactive IK and Applied IK are features carried over from the earliest version of 3ds Max. We recommend that you explore the IK Solver methods first, and use Interactive IK or Applied IK only if you find the IK Solvers will not satisfy your needs.

Animating with Interactive IK

Select the end of a hierarchy > Hierarchy panel > IK > Interactive IK.

With Interactive IK and the Auto Key button turned on, you position your model on keyframes, and the IK solution is interpolated between those keyframes. Because the IK solution accounts for multiple objects and the joints between objects, the interpolated animation of an IK object is usually different from the animation of objects without IK.

**TIP** Interactive IK is a feature carried over from the earliest version of 3ds Max. We recommend that you explore the IK Solver methods first, and use Interactive IK only if you find the IK Solvers will not satisfy your needs.

Example of Interactive IK

The following example demonstrates how an interactive IK animation works and how it might differ from what you expect. The figure shows an IK structure with its end effector resting on top of a box. The box moves in a straight line over 100 frames.

Turn the Auto Key button on and then in the Hierarchy panel > IK tab, turn on Interactive IK. Move the end effector of the IK structure to rest on top of the box at frame 100. The interpolated animation of the end effector follows a natural looking curved path.

You might have expected the IK bone structure to follow the same path as the box. However, the IK solution is only calculated at the keyframes. The positions and rotations of all the objects in the kinematic chain are interpolated between the keyframes to produce the curved result.
To make the end effector closely follow the path of the box, you would have to add more keyframes. You can also use binding and standard applied IK. For information about making the end effector precisely follow the motion of the box, see Animating with Applied IK on page 3750.
Behavior of Objects in IK Mode

As you move and rotate objects using interactive IK you notice that some objects might not be able to move or rotate about all axes. This is because the objects are constrained by the joint parameters you have set. If the joint parameters specify that motion cannot occur in a certain axis, the end of the chain will not move.

Behavior of Root Objects in IK Mode

An option on the Inverse Kinematics panel on page 8352 of the Preference Settings dialog enables the special case of moving and rotating root objects when IK mode is on. The name of this control is Always Transform Children Of The World.

While you are transforming an end effector using IK mode, the settings for the root object’s joint parameters are used and the root object does not move with respect to the World. If you select the root object, its joint parameters are released and you can transform the root object.
If you decide you want root objects to always use their joint parameters, you can turn off the Always Transform Children Of The World option.

Single, unlinked objects are hierarchies of one. An unlinked object is its own root and is also a child of the World. Turning Always Transform Children of the World will prevent you from transforming single objects in IK mode.

**Animating with Applied IK**

Select the end of a hierarchy > Hierarchy panel > IK > Set object parameters such as Bind to Follow Object > Apply IK.

Applied IK requires you bind one or more parts of your IK structure to animated follow objects. Once bound, you can select any object in your kinematic chain and click Apply IK. This calculates the IK solution for each frame of the animation and places transform keys for every object in the IK chain.

The Apply IK method of animation works best when you want objects in the kinematic chain to match the motions of other objects exactly.

**TIP** Applied IK is a feature carried over from the earliest version of 3ds Max. We recommend that you explore the IK Solver methods first, and use Applied IK only if you find the IK Solvers won't satisfy your needs.
Example of Applied IK

IK structure
The illustration demonstrates how an applied IK animation works. Just as in the example in Animating with Interactive IK on page 3747, the figure shows an IK lamp structure with its head positioned over a spider. To maintain the offset distance between the lamp head and spider, the actual end effector is an invisible Dummy helper object, placed within the spider and linked to the lamp head as a child. The spider moves in a straight line over 100 frames.

To bind the end effector to the spider, click Bind, and then drag a line between the two. Once the end effector is bound to the spider, it will try to match the location of its pivot point with the pivot point of the spider.

Select the end effector and click Apply IK. 3ds Max matches the end effector with the box and calculates the IK solution for every frame. Playback of the animation shows that the end effector perfectly follows the box.

**NOTE** In the above example, the end effector is an invisible Dummy helper object, which is used to maintain the offset distance between the lamp head and the spider.
Clearing Keys from Previous Animation

If you have animated any members of the IK chain interactively, or run Apply IK previously, the existing animation keys will affect the new IK solution. Sometimes that is exactly what you want. You can use manual animation to subtly nudge the IK solution toward a particular result. However, it is more likely that you want to remove old keys in order to begin the IK calculations with a clean slate.

The Clear Keys option in the Inverse Kinematics rollout controls whether or not old move and rotate animation keys are removed.

Constraining the IK Solution to Specific Frames

You use the Start and End fields in the Inverse Kinematics rollout to set the range of frames used to calculate the applied IK solution. Using these fields, you can restrict IK solutions to specific frames and solve for different solutions in different time segments.

You can set the Start and End fields to include frames outside of the active time segment.

You can also constrain an IK solution to frames where a key exists for an end effector. This is useful if you want to animate a hierarchy using end effectors but do not want keys generated on every frame.

Turn on Apply Only To Keys to constrain the IK solution to frames with end effector keys.

Watching Progress of the IK Solution

Normally, Apply IK calculates all frames before updating the viewports. To watch the progress of Apply IK frame by frame, turn on Update Viewports on the Inverse Kinematics rollout.

Updating the viewports greatly slows down the Apply IK process but it can help you troubleshoot complex animations.

Joint Controls

Joints control the rotation and position of an object with respect to its parent.
Setting Joint Parameters

You set whether a joint behaves as a hinge, a drawer slide, or another type of joint by setting joint parameters on page 3706 for each object in the kinematic chain. Joints control the rotation and position of an object with respect to its parent.

Any object has a maximum of two joint-type rollouts: One rollout contains settings to control the object's position, and the other controls the object's rotation. There can be many different types of positional and rotational joints. Which joint parameters are available is determined by the type of IK solver assigned to an object. HI Solvers, for instance, are controlled with a preferred angle setting found in the Rotational Joint parameters. HD Solvers have additional parameters for spring back, precedence, and damping, not found in the HI Solver.

Any hierarchy of object or bone systems can have its joint limits defined. Select all the objects, and turn on their bone or link display. Select the bone or link and open the Hierarchy panel > IK tab. Scroll down to the Sliding and Rotational Joints. There, you can activate axes and set their individual limits.

**NOTE** Different IK solvers use different joint limits. When using a bone system, add the IK solvers first, then set the joint limits second.

Common Joint Types

The most common joint types are Rotational and Sliding joints. Other common joint types are Path and Surface joints. Each joint type displays its own set of joint parameters.

**Rotational joints** Control rotation of objects using many of the standard rotation controllers. The parameters for rotational joints set an object's ability to rotate about a given axis.

For many IK structures, consider using an Euler XYZ controller on page 3453. Quaternion-based controllers tend to freeze if an object is moved beyond rotational joint limits before turning on IK.

**Sliding joints** Control the position of objects using many of the standard position controllers. The parameters for sliding joints control whether an object can move along a given axis.

**Surface joints** Control the position of objects using Surface constraint on page 3607. The parameters control how the object travels along its assigned surface.
Path joints Control the positional motion of objects using Path constraint on page 3596. The parameters for path joints control how far an object can travel along its assigned path.

Using Joint Parameters

The way the children behave toward one another is governed by the inheritance of the transforms down the chain. Setting joint limits on individual child objects can influence this inheritance. If three children in a row all have their rotational axes made inactive, they will not be able to rotate, and so a piece of the chain will appear stiff. Or if only one axis is made active as a sliding joint, the component can separate in space from the chain.

When you are using an object with a path constraint in an IK chain you might want the path to appear as if it is part of the IK chain. You achieve this effect by linking the object using the path constraint and the path to the same parent. The path object should have no children, and other objects in the IK chain should be linked to the object using the path constraint.
4. Ring  
5. Holder  
6. Handle

In the figure, the bead uses a path constraint to hold it to the ring. The IK chain from parent to child is Post->Cap->Bead->Handle. The ring is a child of the Cap but is not part of the IK chain.

**Copying and Pasting Joint Parameters**

You can copy and paste at the bottom of the Object Parameters rollout in the Hierarchy panel to copy and paste a complete set of joint parameters from one object to another.
There are separate copy and paste functions for sliding joints and rotational joints. Each joint type saves copied parameters in separate clipboards.

**TIP** Choose one of the Mirror Paste options if you want to mirror the joint parameter settings as you paste them. This is very useful when pasting from one side of an object to another, such as left arm joints to a right arm.

You can also copy joint settings from a non-IK controller to an IK controller, but you can't copy from an IK controller to a non-IK controller.

## Activating Joint Axes

You set whether an object can move or rotate about a given axis by using the Active check box in the joint rollouts. Joints have a maximum of six possible axes: three for rotation and three for position. You constrain the motion of a joint by setting which axes are active.

- A joint with all axes active can move and rotate freely, independent of its parent.
- A joint with all axes inactive is locked to its parent and cannot move independently.
- The setting of IK joint axes overrides Inherit and Lock settings on the Link Info rollout.

### Understanding Joint Axis Orientation

IK joint axes for an object are defined by the Local axes of the object's parent. That means if you activate the X axis of an object's rotational joint parameters, the object rotates about its parent's X axis, not its own X axis.

You might have a problem when you set joint parameters for an object whose local coordinate system is oriented 90 degrees from its parent's coordinate system. In such a case, the rotation angle about one axis becomes indeterminate. The result is that one axis will often cause rotation about one of the other two axes.

The following techniques will make setting joint parameters easier and more successful:

- Assemble IK hierarchies with objects aligned along the World axes.
Consider using the Adjust Pivot on page 3763 functions to align your object pivots with either the World axes or the root object of the hierarchy.

Set the transform managers to Parent coordinate system and Use Pivot Point Center, while setting joint parameters. This helps you see the orientation of the joint axes by displaying the parent axis icon at the selected object’s pivot point.

When activating joint axes, drag the From spinner up and down. This causes the object to move or rotate about the active axis and is a quick check that you chose the right axis.

Activating Rotational Joints

1. Rotational links

When you turn on Active for one of the X, Y, Z axes of a rotational joint, the object can rotate about that axis of its parent’s coordinate system.

Joints that rotate about multiple axes are very common. A ball joint, like your shoulder, is a rotational joint active about all three axes. A pin joint, like your elbow, is a rotational joint active on a single axis.
Activating Sliding Joints

1. Sliding axis

When you turn on Active for one of the X, Y, Z axes of a sliding joint the object can move along that axis of its parent’s coordinate system.

Most sliding joints are active only along a single axis. A telescope is an example of a sliding joint active on a single axis. You rarely see a sliding joint active along all three axes.

If a sliding joint is active along all three axes, it moves independently from its parent. It’s almost as if there is no joint connection at all.

**TIP** Use the HD IK Solver when you need to use sliding joints with IK.
Path and Surface Joints

Circular path

When you turn on Active for Path or Surface joints you are setting whether the object can move along the assigned path or surface.

A house key on a ring is an example of an active path joint.

See Path Constraint on page 3596.

Limiting Joint Action

Most joints are limited in their range of motion along an active axis. For example: a hinge might open only to 120 degrees; a piston slides only within the length of its cylinder. To limit the range of motion allowed on an active axis, you turn on Limited and set values for the From and To fields on the joint rollouts.

You can also view joint limits in the viewport by pressing and holding the mouse button on the From or To label of a limit field. The object will move or rotate to the limit value until you release the mouse button.
**Limiting Rotational Joints**

Limits for a rotational joint define how far the object can rotate about its parent's axes. The values in the From and To fields represent the rotation angle about the active axis measured from 0 degrees on the parent object.

For example, an elbow joint rotates the forearm with respect to the upper arm. In the figure the limits on X axis rotation are from 0 to 135 degrees. The Y, Z axes are inactive because an elbow joint rotates about a single axis.

**Limiting Sliding Joints**

Limits for a sliding joint define how far a joint can move along its parent's axes. The values in the From and To fields represent a distance for movement along the active axis measured from the pivot point of the parent to the pivot point of the selected object.

For example, a sliding joint on a piston moves the piston in and out of the cylinder. In the figure, the limits on Z axis movement are from 10 to 90. This prevents the piston from hitting the bottom or moving past the end of the cylinder.

**Limiting Path and Surface Joints**

Limits for path and surface joints define how far along the path or surface an object can move. The values in the From and To fields represent a percentage of the total distance measured along the path or surface.

For example, a path joint for a house key moves the key along a key ring. Setting the limits on the path joint at 5% to 95% prevents the key from traveling along the ring where the fob is attached.

*See also:*

■ Sliding and Rotational Joints (HI Solver) on page 3706

**Hierarchy Panel Commands**

Once you have set up a hierarchy using the Select and Link command on page 3631 or a system such as Bones on page 857, you can manage it using the Hierarchy panel.

The Hierarchy panel has three tabs:
You use the Pivot tab to adjust the pivot points of objects in the hierarchy.
You use the IK tab to manage the behavior of inverse kinematics (IK). You use
the Link Info tab to apply locks or inheritance to movement within the
hierarchy.

See also:
- Hierarchies and Kinematics on page 3618
- Inverse Kinematics (IK) on page 3661
- IK Terminology on page 3665
- Animating with Interactive IK on page 3747
- Animating with Applied IK on page 3750
- History-Dependent (HD) IK Solver on page 3710
- History-Independent (HI) IK Solver on page 3680
- IK Limb Solver on page 3732
- Spline IK on page 3733

Pivot

Make a selection in the viewport. > Hierarchy panel > Pivot button
Every object has a pivot point that represents its local center and local
coorinate system.
The pivot point of an object is used for the following:

- Functions as the center of rotation and scaling when you use the Pivot Point transform center on page 931.
- Sets the default location of a modifier center.
- Defines the transform relationship for the object's linked children.
- Defines the joint location for inverse kinematics (IK) on page 3661.

You can adjust the position and orientation of an object's pivot point at any time using the buttons in the Adjust Pivot rollout in the Hierarchy panel. Adjusting an object's pivot has no effect on any children linked to that object.

**NOTE** You cannot animate the functions under the Adjust Pivot rollout. Adjusting an object's pivot on any frame changes it for the entire animation. Use caution when adjusting the pivot of an animated object. Adjusting the pivot on one frame might produce unexpected results in another part of the animation. You should adjust the pivot point to the location you want, before you start to animate, if possible.

**TIP** Use the Link constraint on page 3580 to simulate the effect of an animated pivot.

### Adjust Pivot Rollout

Make a selection in the viewport. > Hierarchy panel > Pivot button > Adjust Pivot rollout

You can adjust the position and orientation of an object's pivot point on page 8686 at any time using the buttons in the Adjust Pivot rollout. Adjusting an object's pivot has no effect on any children linked to that object.

You cannot animate the functions under the Adjust Pivot rollout. Adjusting an object's pivot on any frame changes it for the entire animation.
Pivot point sets hand to the center of the clock face.

Procedures

To reposition an object’s pivot point:

1. Select an object and then turn on Adjust Pivot rollout > Affect Pivot Only.
2. Move or rotate the pivot.
   You can also use Align on page 967, Quick Align on page 972, and Align to View on page 979 on the toolbar to align the pivot.
   See Adjust Transform Rollout on page 3770 for related information.

Interface

Move/Rotate/Scale group

Each of the buttons in the Move/Rotate/Scale group box highlights when active. This determines which part of the object is affected by the three buttons in the Alignment area, as well as the Transform and Align commands on the main toolbar.
Affect Pivot Only Affects only the pivot point of the selected objects.

NOTE A Scale transform has no effect on the pivot.

Affect Object Only Affects only the selected objects (and not the pivot point).

Affect Hierarchy Only Applies only to the Rotation and Scale tools. It applies the rotation or scale to the hierarchy by rotating or scaling the position of the pivot point without rotating or scaling the pivot point itself.

NOTE You can use this on hierarchies of 3ds Max objects, but don’t use it on Bones systems. To reposition, rotate or change the size of bones in a chain, see Bones on page 857.

NOTE It’s important to remember that the Align, Normal Align, and Align to View functions are all affected by the state of Affect Pivot Only, Affect Object Only, and Affect Hierarchy Only. Snap mode allows you to snap the pivot to its own object, or to any other object in the scene.

Alignment group

The effect of these buttons depends on whether you chose Affect Pivot Only or Affect Object Only. They don’t apply to Affect Hierarchy Only.

If you chose Affect Pivot Only, the buttons work as follows:

Center to Object Moves the pivot to the center of its object.
Align to Object  Rotates the pivot to align with the object’s transformation matrix axes.

Align to World  Rotates the pivot to align with the world coordinate axes. If you chose Affect Object Only, the buttons work as follows:

Center to Pivot  Moves the center of the object to its pivot location.

Align to Pivot  Rotates the object to align its transformation matrix axes with the pivot.

Align to World  Rotates the object to align its transformation matrix axes with the world coordinate axes.

Pivot group

Reset Pivot  Resets the pivot point to the position and orientation it held when the object was first created. This is not affected by the state of the Affect Pivot Only and Affect Object Only buttons.

Working Pivot Rollout

Make a selection. > Hierarchy panel > Pivot button > Working Pivot rollout

As an alternative to the object’s own pivot, you can use the working pivot for applying transforms to any object in the scene. This allows you, for example, to rotate an object about an arbitrary, persistent point in the scene without interfering with the object’s own pivot.

You position and orient the working pivot using standard transform tools as well as some special options available on this rollout, and can activate it at any time. You can use it for editing geometry at the object and sub-object levels. Keep in mind, however, that the working pivot cannot be used as a transform center when creating animation (see Animation and the Transform Center on page 909).

NOTE  The scene contains only one working pivot, which is independent of other scene elements such as geometry.
Moving an object along the working pivot Z axis

**IMPORTANT** Most Working Pivot tools are best used in working contexts other than the Hierarchy panel. For example, you can use it in the Modify panel context while editing mesh sub-objects. For this reason, it’s highly recommended that you use Customize User Interface on page 8249 > Main UI group > Working Pivot category actions to create a set of controls that you can use anywhere in the 3ds Max interface. For example, you could create a custom Working Pivot toolbar on page 8252 with buttons that give you access to the Working Pivot commands while editing meshes.

**Procedure**

**To use Working Pivot:**

1. Turn on Edit Working Pivot and use standard transform tools and/or the Place Pivot To group on page 3769 commands to place and orient the working pivot. Turn off Edit Working Pivot when done.

2. You can use the working pivot in either of two ways:
   - Turn on Use Working Pivot from either the Hierarchy panel or your custom UI control on page 3767.
By default, this sets the geometric center for rotate and scale transforms to Use Transform Coordinate Center on page 934; that is, the working pivot position. To specify a different transform center, use the Use Center flyout on page 930.

- From the main toolbar > Reference Coordinate System list on page 922, choose Working.
  This keeps the current Use Center on page 930 setting.

**Interface**

When any of the modular tools on this rollout is active, a message to that effect appears in each viewport below the viewport name. For example, when you activate Use Working Pivot, the viewport legend reads “USE WP,” as shown in the above illustration.

![Diagram](image)

**Edit Working Pivot** When on, makes the working pivot visible in the scene and lets you transform it.

When you first enter Edit Working Pivot mode, all transform tools use the Local reference coordinate system on page 922 by default. You can change the coordinate system while working in this mode, and the tool remembers the reference coordinate system for each transform. Changing the transform, for example from Move to Rotate, recalls the last coordinate system for that transform during the current Edit Working Pivot session.

Exiting Edit Working Pivot restores the last active transform tool. For example, if you’re rotating an object, and you move the working pivot and then exit Edit Working Pivot mode, the Rotate tool will again be active.
NOTE While Edit Working Pivot is active, the current selection is locked to the working pivot and cannot be changed without exiting this mode.

**Use Working Pivot** When on, lets you transform the current selection (objects or sub-objects) with respect to the working pivot. The transform gizmo, when visible, moves to the working pivot location. In this mode you typically transform the selection by manipulating the gizmo rather than the selection.

This mode overrides the current transform space for all transforms. Exiting this mode restores the individual coordinate system for each transform tool.

By default, this sets the geometric center for rotate and scale transforms to **Use Transform Coordinate Center** on page 934; that is, the working pivot position. To specify a different transform center, use the **Use Center flyout** on page 930.

You can activate Edit Working Pivot while using the working pivot; when you exit Edit Working Pivot, Use Working Pivot mode is restored.

**Align To View** Reorients the working pivot so that its XY plane is parallel to the active view plane and the X and Y axes are parallel to the viewport edges. Available only in Edit Working Pivot and Use Working Pivot modes.

**Reset** Moves the working pivot to the pivot location of the selected object. With multiple selected objects, the working pivot moves to the pivot position of the last-selected object. With a sub-object selection, the working pivot moves to the geometric center of the selection (the averaged position of the selected sub-objects).

If the working pivot doesn’t appear onscreen, use Reset to move it to a known location.

**Place Pivot To group**

These controls let you position the working pivot by clicking the mouse instead of with transform tools. To use, click the View or Surface button, and then click in a viewport to position the working pivot there. To exit, right-click the active viewport or click the button again. You’re then returned to the previous transform tool and working pivot mode if you were using one.

**View** Places the working pivot in screen space without changing its depth in the screen. Thus the placement is on a grid that is parallel to the screen, intersecting the original position of the pivot.

**Surface** Places the working pivot on a surface you click on, or, if no surface is present where you click, the construction plane. This works like **AutoGrid** on page 2792, and you can see the gizmo previewing the alignment to the normal
of the surface as you move the cursor over it. Clicking places the pivot to the
surface and aligns it to the normal (unless Align To View is on; see following).

**Align To View** When on, automatically aligns the working pivot to the current
view when you place it with View or Surface. This is useful to prepare for
transforms in the screen plane.

### Adjust Transform Rollout

Make a selection. > Hierarchy panel > Pivot button > Adjust Transform rollout

You can transform an object and its pivot without affecting its children using
the buttons in Adjust Transform rollout. Adjusting an object's transforms has
no effect on any children linked to that object.

**See also:**

- Adjust Pivot rollout on page 3763

### Procedures

**To scale a parent without scaling the children:**

1. Select the parent object in a hierarchy.
2. On the Hierarchy panel click the Pivot button if it's not already on, then
   on the Adjust Transform rollout, click Don't Affect Children.
3. Scale the parent object.
   The children will remain unaffected.

**TIP** Never use non-uniform scale at the object level for objects in a hierarchical
chain. Always go to the sub-object level when you do a non-uniform scale
on hierarchically linked objects.

**To reinitialize the scale of an object:**

1. Select an object.
2. In the Adjust Transform rollout > Reset group, click Scale.
   The XYZ values are re-initialized to 100%. This operation prevents
   Non-uniform Scale inheritance if a child object is linked to this object.
Interface

Move/Rotate/Scale group

**Don't Affect Children** Limits transforms to the selected object and its axis, not to its children. This is very useful when working with bones and other hierarchies. If you need to make a particular bone or object longer or shorter, select the object and then turn on Don't Affect Children. You can readjust it and any parent objects in the hierarchy will stretch or shrink to compensate to the new dimension of the selected bone.

Reset group

**Transform** Resets the orientation of an objects local axis coordinates to align with the world coordinate system, regardless of the current orientation of the object.

This does not affect descendants.

When applied to closed groups, it aligns the dummy node of the parent, but keeps the children in the same place. It reorients and resizes the dummy node to correctly bind the children of the group.

**Scale** Resets the scale values in the transformation matrix to reflect the new scale of the object. There is no visual change in the object.

You can use the Scale to correct Non Uniform Scale inheritance problems. If Non Uniform Scale is inherited by a child object in a hierarchy, it can result in an undesirable deformation in the child object. To correct for this, use Reset: Scale in the Adjust Transform rollout on an object before linking.

You can view the scale values of the transformation matrix of a selected object. On the toolbar, turn on Scale, then right-click any of the three toolbar Transform buttons (Move, Rotate, or Scale).
There is also a Reset XForm utility on page 912 to do the same tasks.

**Skin Pose Rollout**

Make a selection in the viewport. > Hierarchy panel > Pivot button > Skin Pose rollout

These controls function as a copy/paste system for setting up character animation. For more information, see Skin Pose Commands on page 280.

**Interface**

![Skin Pose Rollout Interface]

**Skin Pose Mode** Poses the character in its skin pose and allows the skin pose to be refined. Changes to the objects when Skin Pose Mode is on affect only the skin pose, not the animation. When Skin Pose Mode is off, the structure returns to its pose at the current frame.

Available only after you’ve used Set As Skin Pose on page 280 on an object.

**Enabled group** Toggle the Position, Rotation, and Scale check boxes to enable and disable recording of the corresponding transforms when Skin Pose Mode is active.

**IK**

Make a selection. > Hierarchy panel > IK button

The IK rollouts contain controls for interactive IK and the HD IK solver.
The rollouts on this panel are:

- **Inverse Kinematics Rollout (Interactive, Applied, and HD IK)** on page 3784
- **Object Parameters Rollout (HD Solver)** on page 3773
- **Auto Termination Rollout (Interactive IK)** on page 3786
- **Position XYZ Parameters** on page 3524
- **Key Info (Basic)** on page 3418
- **Key Info (Advanced)** on page 3422
- **Rotational Joints (HD Solver)** on page 3782

**NOTE** The rollouts for the HI IK and IK Limb solvers are not available while IK is chosen in the Hierarchy panel. Most controls for these solvers are found on the Motion panel.

## HD IK Solver Rollouts

The HD IK Solver rollouts appear on the Hierarchy panel.

### Object Parameters Rollout (HD Solver)

Make a selection. > Hierarchy panel > IK > Object Parameters rollout

The Object Parameters rollout lets you set IK parameters for an entire hierarchical chain.
This topic covers the Terminator check box; other parameters on the Object Parameters rollout are covered in the following topics:

- Position / Orientation / Bind to Follow Object (HD Solver) on page 3774
- Precedence (HD Solver) on page 3778
- Copying, Pasting, and Mirroring Joint Parameters (HD Solver) on page 3780
- Sliding and Rotational Joints Rollouts (HD Solver) on page 3782

**Procedures**

**To create a terminator in any hierarchy or HD IK chain:**

1. Select an object in any hierarchy or HD IK chain that you want to be the terminator.
2. In the Object Parameters rollout, turn on Terminator.
   - The terminated objects will not move when you use Interactive, Applied, or HD IK animation.

**Interface**

Terminator

Sets the base of an IK chain by defining one or more selected objects as terminators.

Turn on Terminator to stop calculation of the kinematic chain before it reaches the root object of the hierarchy. A terminator object stops calculation at the terminator's child object; the terminator itself is not affected by the IK solution. This gives you very precise control over the behavior of the kinematic chain.

**Position / Orientation / Bind to Follow Object (HD Solver)**

Make a selection with an HD Solver applied. > Hierarchy panel > IK > Object Parameters rollout > Position/Orientation/Bind to Follow Object groups

Use the controls in these group boxes to bind objects in a HD IK chain to the world or to follow objects. Use the various options to modify the behavior of the bindings.
Use weighted and axis-specific binding controls to create different weights for each binding, and to specify which axes the bound follow object influences. Use the R (Relative) buttons to establish a relative offset with Bind Position and Bind Orientation.

**Binding an Object to the World**

Binds an object to the world if you want the object to hold its position and orientation as long as possible during IK operations.

**Binding an Object to a Follow Object**

Binds a selected object in your IK chain to any other object that is not a descendant of the selected object. This other object is called the follow object.

**Procedures**

**To bind an object to the world:**

1. Select the object to be bound.
2. Click IK in the Hierarchy panel and expand the Object Parameters rollout.
3. Select one or both of the Bind boxes.
   - Turn on Bind Position to cause the object to attempt to maintain its current location.
   - Turn on Bind Orientation to cause the object to attempt to maintain its current orientation.

**To bind an object to a follow object:**

1. Turn on Bind and select the object in a kinematic chain to be bound. Moving your mouse over an acceptable target will change the cursor to a push-pin icon.
2. Drag to the follow object and release.
3. Turn on Bind Orientation if you want the bound object to match the rotation of the follow object. Bind Position is automatically selected. Turn off an axis (Axis: XYZ). The specified axis is no longer influenced by the follow object or the New IK Position end effector.
Use Weight to set the relative influence of multiple follow objects or end effectors, and thus their priority in solving the IK solution. The higher the relative Weight value, the higher the priority.

**NOTE** As you drag, a dotted line is drawn from the pivot point of the selected object to the cursor. When the cursor is over a valid follow object, it changes to a push-pin cursor. Release to set the follow object. The name of the follow object will appear in the text area.

To unbind an object:

- Select the object to unbind, and then click Unbind.

In the text area, the name of the follow object is replaced with the word "None."

**Interface**

**Position group**

- **Bind Position** Binds the selected object in the IK chain to the world (attempts to maintain its location), or to a follow object, if one has been assigned. If a follow object has been assigned, then the translation of the follow object affects the IK solution.

**NOTE** This check box has no effect on the HD IK Solver Position end effectors, which are always bound to their assigned joints.

**Orientation group**
Bind Orientation Binds the selected object in the hierarchy to the world (attempts to maintain its orientation), or to a follow object, if one has been assigned. If a follow object has been assigned, then the rotation of the follow object affects the IK solution.

**NOTE** This check box has no effect on the HD IK Solver Rotation end effectors, which are always bound to their assigned joints.

R Establishes a relative position offset or rotation offset between follow object and end effector. This button has no effect on the HD IK Solver Position end effectors. They are created on top of the joint to which they're assigned, and are automatically absolute. If you move the joint away from the end effector, and want to reset the end effector to an absolute position, you can delete and then recreate the end effector.

Axis X/Y/Z If one of the axes is turned off, the specified axis is no longer influenced by the follow object or the HD IK Solver Position end effector. For example, if you turn off the X axis in the Position group, movement of the follow object (or end effector) along the X axis has no effect on the IK solution, but movement along the Y or Z axis has.

**NOTE** These do not constrain the movement of the follow object or end effector.

Weight Sets the influence of the follow object (or end effector) on its assigned object, and on the rest of the chain. A setting of 0 turns off the binding. Using this value you can set the relative influence of multiple follow objects or end effectors and their priority in solving the IK solution. The higher the relative Weight value, the higher the priority. The Weight settings are relative; there's no point in using them if there's only one follow object or end effector in your IK hierarchy. However, if you have a single HD IK chain with both Position and Rotation end effectors on a single joint, you can give them different weights to give priority to either the position or rotation solution. You can adjust the Weight for multiple joints. Select two or more objects in the hierarchy, and the Weight value represents the commonality of the selection set.

**NOTE** Differences in the Weight values only have an effect when there is no solution that satisfies two or more opposing end effectors in the chain. In this case, the end effector with the greatest weight "wins."
Bind To Follow Object group

Controls to bind and unbind an object in an inverse kinematic chain to a follow object.

**Label** Displays the name of the selected follow object. Displays the word "None" if no follow object is set.

**Bind** Binds an object in an inverse kinematic chain to a follow object.

**Unbind** Unbinds the selected object in a HD IK chain from its follow object.

**Precedence (HD Solver)**

Make a selection with an HD IK Solver applied. > Hierarchy panel > IK > Object Parameters rollout > Precedence

You can use the three joint precedence controls to alter how the IK Solution is calculated.

The default joint precedence is 0. This is suitable for many IK solutions. It assumes that joints closest to where a force is applied (the end effector) will move more than joints farther from the force.

**Child->Parent** values are calculated by assuming the root of the entire hierarchy has a precedence value of 0 and each child has a value equal to 10 times its depth from the root. In a four-object hierarchy starting with the root, the values would be 0, 10, 20, and 30.

**Parent->Child** values are calculated by assuming the root of the entire hierarchy has a precedence value of 0 and each child has a value equal to 10 times its depth from the root. In a four-object hierarchy starting with the root, the values would be 0, -10, -20, and -30.

- Default joint precedence occurs whenever all joints in the kinematic chain have the same precedence value. Assigning a value of 100 to all objects in the kinematic chain is exactly the same as assigning a value of 0.

- An IK chain of three objects with precedence values of 0, 30, and 200 would have the same solution if the precedence were changed to be 1, 2, and 3.
Procedures

To assign a precedence value to an object manually:
1 Select an object in an HD IK Chain.
2 Open the Object Parameters rollout in the Hierarchy panel.
3 Enter a value in the Precedence field.

To assign Child->Parent precedence to all objects in a kinematic chain:
1 Select all objects in an HD IK chain.
2 Open the Object Parameters rollout in the Hierarchy panel.
3 Click Child->Parent.

To assign Parent->Child precedence to all objects in a kinematic chain:
1 Select all objects in the kinematic chain.
2 Open the Object Parameters rollout in the Hierarchy panel.
3 Click Parent->Child.

To reset the default joint precedence:
1 Select all objects in the kinematic chain.
2 Open the Object Parameters rollout in the Hierarchy panel.
3 Set the value in the Precedence field to 0.

Interface

Three controls set precedence:

- **Precedence** Manually assigns precedence values to any object in the IK chain. High precedence values are calculated before low precedence values. Precedence values that are equal are calculated in Child->Parent order.
**Child->Parent** Automatically sets joint precedence to decrease in value from child to parent. Causes joints closest to where a force is applied (the end effector) to move more than joints farther away from the force.

You almost always assign Child->Parent precedence to an entire kinematic chain.

Child->Parent behaves like the default precedence settings but is more flexible if you want to go back and manually change the settings.

**Parent->Child** Automatically sets joint precedence to decrease in value from parent to child. Causes joints closest to where a force is applied (the end effector) to move less than joints farther away from the force.

You almost always assign Child->Parent precedence to an entire kinematic chain.

### Copying, Pasting, and Mirroring Joint Parameters (HD Solver)

Make a selection. > Hierarchy panel > IK > Object Parameters rollout > Copying, Pasting, and Mirroring joint parameters

Use the Copy and Paste buttons in the Object Parameters rollout to copy and paste the joint settings between IK controllers. You can also copy joint settings from a non-IK controller to an IK controller, but you can't copy from an IK controller to a non-IK controller. With an HD IK solver hierarchy, you can paste to a multiple selection of joints.

Use Mirror Paste to mirror the IK joint settings about the X, Y, or Z axis during a Paste operation. It consists of four buttons: one each for the X, Y, and Z axes, and a None option that prevents mirroring altogether.

You can also mirror the IK joints using the Mirror tool on the main toolbar.

See also:
- [Sliding and Rotational Joints](#) on page 3782

#### Procedures

**To copy and paste joint parameters:**

1. Select an object in an inverse kinematic chain.
2. Set sliding or rotational joint parameters.
3 Click Copy in either the Sliding Joints or Rotational Joints group on the Object Parameters rollout.

4 Select a different object in the inverse kinematic chain.

5 Select an axis to mirror in the Mirror Paste group.

6 Click paste in either the Sliding Joints or Rotational Joints group on the Object Parameters rollout.

Both Sliding Joints and Rotational Joints maintain separate clipboards. The copied joint parameters are saved in the clipboard until you replace them with new copied parameters.

Interface

Sliding Joints group

Use these buttons to copy sliding joint parameters from one object to another. These buttons are not available for Path joints.

Rotational Joints group

Use these buttons for copying rotational joint parameters from one object to another.

Mirror Paste group

Use to mirror the IK joint settings about the X, Y, or Z axis during a Paste operation.
Sliding and Rotational Joints Rollouts (HD Solver)

Make a selection. > Hierarchy panel > IK > Sliding and Rotational Joints rollouts

In inverse kinematics, joints operate by allowing motion on one or more axes and restricting motion on the remaining axes. You set whether an object can move (slide) on or rotate about a given axis with the Active check box in the joint rollouts. Joints have a maximum of six possible axes: three for position and three for rotation. You constrain the motion of a joint by setting which axes are active.

The setting of IK joint axes overrides any Inherit and Lock settings in Link Info on page 3787.

Procedures

To activate or deactivate an axis:

1. Select an object.
2. On the Hierarchy panel, click IK.
3. Expand the rollout for a joint type.
4. Turn on Active for any available axis.

- When on, the axis is active and the object can move or rotate about that axis.
- When off, the axis is inactive and the object cannot move or rotate about that axis.

To limit a joint:

1. Select an object.
2. Click IK in the Hierarchy panel.
3. Turn on Limited for any active axis. If an axis is inactive the limits settings are ignored.

- When on, the axis is limited and the object can move or rotate within the range set by the From and To fields.
- When off, the axis is not limited and the object moves or rotates freely about that axis. If you turn on Limited, specify limit values in the From and To fields. When setting limits, the object transforms to the position or rotation defined by the From or To field. When you exit
the field or release the spinner, the object returns to its original position. You can also view joint limits in the viewport by pressing and holding the mouse button on the From or To label of a limit field. The object will move or rotate to the limit value until you release the mouse button.

**Interface**

**Sliding/Rotational Joints rollouts**

<table>
<thead>
<tr>
<th>Sliding/Rotational Joints rollout</th>
<th>X/Y/Z Axis groups</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Active</td>
</tr>
<tr>
<td></td>
<td>Limited</td>
</tr>
<tr>
<td></td>
<td>Ease</td>
</tr>
<tr>
<td>From:</td>
<td>To:</td>
</tr>
<tr>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td>Spring Back:</td>
<td>0.0</td>
</tr>
<tr>
<td>Spring Tension:</td>
<td>1.0</td>
</tr>
<tr>
<td>Damping:</td>
<td>0.0</td>
</tr>
</tbody>
</table>

The Sliding Joints rollout and Rotational Joints rollout contain similar controls for position and rotation, respectively. Also, each rollout contains identical group boxes for control of the X, Y, and Z axes.

**X/Y/Z Axis groups**

- **Active** Activates an axis (X/Y/Z). Allows the selected object to slide on or rotate about the activated axis.

- **Limited** Limits the range of motion or rotation allowed on an active axis. Use in conjunction with the From and To spinners. Most joints are limited in their range of motion along an active axis. For example, a piston slides only within the length of its cylinder.

- **Ease** Causes a joint to resist motion as it approaches its From and To limits. Simulates an organic joint, or worn mechanical joint, moving or rotating freely in the middle of its range of motion but moving less freely at the extremes of its range.

- **From and To Spinners** Determine for position and rotation limits. Use in conjunction with the Limited function.
**Spring Back** Activates Spring Back. Each joint has a rest position. As the joint moves further from the rest position, an increasingly larger force pulls the joint back to its rest position, like a spring.

**Spring Back (spinner)** Sets the rest position for the joint. For rotational joints, this is the orientation of the joint in degrees; for sliding joints, it's the position in units. Adjusting this is similar to adjusting the From/To spinners. You see the orientation/position while performing the adjustment, but when you release the spinner the object returns to its previous state.

If you're using the HD Solver, you must turn on Show Initial State (Motion panel > IK Controller Parameters rollout) to see the effect on the geometry during the adjustment.

**Spring Tension** Sets the strength of the "spring." Higher values cause the spring to pull harder as the joint moves further from its rest position. A setting of 0 turns off the spring; very high settings can turn the joint into a limit because you can reach the point where the spring is too strong to allow the joint to move past a certain point.

**Damping** Applies resistance over a joint's full range of motion or rotation. Simulates the natural effect of joint friction or inertia. As a joint corrodes, dries out, or is put under a heavy load, it resists motion along its active axes.

### Interactive and Applied IK Rollouts

The Interactive and Applied IK rollouts appear on the Hierarchy panel.

### Inverse Kinematics Rollout

Make a selection. > Hierarchy panel > IK > Inverse Kinematics rollout

The Inverse Kinematics rollout displays different controls based on IK Solvers applied to the selected hierarchy. IK Solvers are applied to the hierarchies using the Animation menu.

When an HD IK Solver is applied to an IK chain the Inverse Kinematics rollout displays the controls described below.

The Inverse Kinematics rollout provides controls for interactive and applied IK, as well as the controls for the HD Solver (history dependent). Use Apply IK to calculate an IK solution and generate Transform keys (move, rotate) for
all objects in an IK chain (the IK chain must include a follow object). By default, keys are created at every frame.

- Applied IK requires that one or more parts of your IK structure be bound to animated follow objects. Once bound, you can select any object in your kinematic chain and click the Apply IK button.
- The Apply IK method of animation works best when you want objects in the kinematic chain to match the motions of other objects exactly. An example of this would be a mechanical connection that should always appear to be attached to the follow object.

**Procedures**

**To use interactive IK:**

1. Build a hierarchy of objects.
   - If you want to use Bones, be sure Assign to Children is not active when you create the Bones.
2. Select the end of the chain.
3. Go to the Hierarchy panel > IK button.
4. Scroll up to the Inverse Kinematics Rollout
5. Click Interactive IK.
6. Advance the time slider and move the end of the chain.
7. Turn off Interactive IK when you want to do forward kinematics.

**To use applied IK:**

1. Add an HD Solver to your hierarchy.
2. Bind objects in your IK structure to follow objects.
3. Animate the follow objects.
4. Select any object in the IK structure.
5. Click IK in the Hierarchy panel and expand the Inverse Kinematics rollout.
6. Click Apply IK.

**TIP** Be sure your Start Frame and End frames match the length of your animation.
**Interface**

**Interactive IK**  Allows for IK manipulation of hierarchies without applying an IK Solver or using a follow object.

**Apply IK** Calculates the IK solution for each frame of the animation and creates transform keys for every object in the IK chain. A bar graph appears on the prompt line to indicate progress of the calculations.

**Apply Only To Keys** Solves the IK solution for keyframes that already exist for one of the end effectors.

**Update Viewports** Views the progress of Apply IK frame by frame in the viewports.

**Clear Keys** Removes all move and rotate keys from the selected IK chain before applying IK.

**Start/End** Sets the range of frames to calculate the applied IK solution. The default settings for Apply IK calculates the IK solution for every frame of the active time segment.

---

**Auto Termination Rollout (Interactive IK)**

Make a selection. > Hierarchy panel > IK button > Auto Termination rollout
The Auto Termination controls temporarily assign terminators a specific number of links up the hierarchical chain from the selected object. This only works with Interactive IK; it does not work with applied IK or with IK solvers.

**Procedures**

To use auto termination:

1. In the Auto Termination rollout, turn on Auto Termination.
2. Enter a value in the # of Links Up field.
   - Turn on the IK button on the toolbar.
3. Select any object in an IK chain to move or rotate.

**Interface**

- **Interactive IK Auto Termination** Turns on the auto termination feature.
- **# of Links Up** Specifies how far up the chain the termination is applied.

For example, if you set this to 5, when you move any object in the hierarchy, the object that’s five links up the chain from the object you’re adjusting acts as a terminator. If you select a different object in the hierarchy, termination is switched to whichever object is five links up the chain from the newly selected object.

A setting of 1 simply locks the hierarchy, since it terminates the joint just beyond the currently selected object.

**Link Info**

Make a selection. > Hierarchy panel > Link Info button

This part of the Hierarchy panel contains two rollouts. The Locks rollout has controls to restrict the movement of objects in a particular axis. The Inherit rollout has controls to limit the transforms that a child inherits from its parent object.
Interface

<table>
<thead>
<tr>
<th>Pivot</th>
<th>IK</th>
<th>Link Info</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td></td>
<td>Locks</td>
</tr>
<tr>
<td>+</td>
<td></td>
<td>Inherit</td>
</tr>
</tbody>
</table>

Locks Rollout

Make a selection. > Hierarchy panel > Link Info button > Locks rollout

The Locks rollout locks an object’s ability to transform along particular local axes.

See also:
- Inherit Rollout on page 3789

Procedures

To lock all move transforms:

1. Select an object in the viewports.
2. In the Locks rollout, turn on Move group > X, Y, and Z.
   Only rotate and scale transforms will work.
   The object does not need to be part of a hierarchy.
Interface

X, Y, Z Turn on any axis in the Move, Rotate, or Scale group box to lock the axis. For example, if Rotate > X and Y are turned on, you'll be able to rotate the object only around the Z axis. All locks are relative to an object's local coordinate system.

Inherit Rollout

Make a selection. > Hierarchy panel > Link Info button > Inherit rollout

The Inherit rollout limits which transforms a child inherits. It constrains the links between a selected object and its parent for any axis of position, rotation, or scale.

See also:

- Locks Rollout on page 3788

Procedures

To prevent inheritance of X rotation in a hierarchy:

- Select an object, then turn off X in the Rotate group on the Inherit rollout.
Interface

X, Y, Z Turn off any axis in the Move, Rotate, or Scale group boxes to prevent inheritance.

When you turn on an axis, transform information passes from the parent to the child for that axis. When you turn off an axis, transform information on that axis is ignored by the child.

Track View

Main toolbar > Curve Editor (Open) button
Graph Editors menu > New Track View
Graph Editors menu > Track View - Curve Editor
Graph Editors menu > Track View - Dope Sheet
Graph Editors menu > Saved Track View > Choose a saved Track View.
Right-click the active viewport. > Transform quadrant > Curve Editor or Dope Sheet
Click or right-click the Point-Of-View (POV) viewport label. > POV viewport label menu on page 8122 > Track > Choose New or a saved Track View.
With Track View, you can view and edit all the keys that you create. You can also assign animation controllers to interpolate or control all the keys and parameters for the objects in your scene.

Track View uses two different modes, Curve Editor and Dope Sheet. Curve Editor mode lets you display the animation as function curves. Dope Sheet mode displays the animation as a spreadsheet of keys and ranges. Keys are color-coded for easy identification. Some of the functions in Track View, such as moving and deleting keys, are also available on the track bar near the time slider, which can be expanded to show curves as well. You can dock the Curve Editor and Dope Sheet windows beneath the viewports at the bottom of the interface, or use them as floating windows. Track View layouts can be named and stored in the Track View buffer and reused. Track View layouts are stored with the MAX file.
Typical Uses for Track View

Track View can perform a variety of scene management and animation control tasks. Use Track View to:

- Display a list of objects in your scene and their parameters.
- Change key values.
- Change key timing.
- Change controller ranges (see procedure).
- Change interpolation between keys.
- Edit ranges of multiple keys.
- Edit blocks of time.
- Add sound to your scene.
- Create and manage notes about the scene.
- Change the behavior of the animation outside the range of keys.
- Change controllers for animated parameters
- Select objects, vertices, and hierarchies.
- Navigate the modifier stack in the Modify panel by clicking the modifier items in the Track View Hierarchy.

NOTE Tracks are created for animated vertices in Track View. A Bezier Point3 controller is the default vertex interpolation controller.

See also:

- Animation Controllers on page 3424

Procedures

To change the frames in which a controller takes effect:

When you apply a controller or constraint to an object's motion, the frame range over which controller takes effect is determined by the current active time segment on page 8496. If you then change the active time segment or the animation length, the duration of the controller's influence doesn't change. Sometimes applying a controller (such as Path Constraint) automatically sets...
keys that you can use to change this range. But others, such as Noise controllers, don’t set keys. In such cases, follow this procedure:

1. Select the object, and then right-click it and choose Curve Editor from the menu.
2. Expand the object hierarchy to find the track or tracks to adjust.
3. From the Modes menu, choose Dope Sheet.

4. On the Dope Sheet, click the Edit Ranges button.
5. Adjust the range duration by dragging its endpoints, or its position in the animation by dragging between endpoints.

For more information, see Dope Sheet on page 3805.

To select keys in Track View (either mode), do any of the following:

1. Click the key to select an individual key.
2. Drag a selection rectangle around keys to select multiple keys.
3. Hold down the Ctrl key and click to create discontinuous multiple key selections.

NOTE If you are in Dope Sheet – Edit Ranges mode, you can use Select Time to select multiple keys.

To delete keys in Track View (either mode):

1. Select keys on the curve, or on the dope sheet.
2. Press the Delete key on the keyboard to delete the selected keys.

To force Track View to always display on a second monitor:

If you are running a dual-monitor setup, you can force Track View to display on the right-hand monitor by editing a script.

1. Right-click the Curve Editor (Open) icon in the main toolbar, and then choose Edit Macro Script.
   The MAXScript script that opens the Track View – Function Curve Editor appears.
Locate the line that reads:
if (trackviews.open "Track View - Curve Editor" layoutName:"Function Curve Layout") == true then

Replace that line with this one:
max_window = getMaxWindowSize() --get Desktop size if (trackviews.open "Track View - Curve Editor" layoutName:"Function Curve Layout" pos:[max_window.x/2,0] height:max_window.y width:(max_window.x/2) ) == true then

Save the script and restart 3ds Max.

This should open the Track View in a new session over the right half of the desktop. Assuming that a dual-monitor setup reports twice the width, this will force the Track View on the second monitor. On a single monitor, it opens it over the right half of the monitor. Of course, you could enter your own numbers like pos:[1024,0] height:768 width:1024 in case you are running two monitors at 1024x768.

To open Track View in a viewport:
- Click or right-click the Point-Of-View (POV) viewport label, and then from the POV viewport label menu on page 8122 choose Views > Track > New, or choose the name of a saved Track View.

Working with Track View

Track View is the tool that you use to see a data-driven view of your scene and animation.

The standard views, such as Top, Front, User, and Camera, are geometry-driven views. These views display the surfaces of your objects and show them changing over time.

Track View displays the values and timing that produce the geometry and motion you see in standard views. Using Track View, you have very precise control over every aspect of your scene.

Track View has two modes: Curve Editor and Dope Sheet. The Curve Editor displays your animation as keys on function curves; editing the tangency of the keys allows control of the in-betweens. Dope Sheet displays your animation as keys and ranges on a box grid and allows you to adjust the timing of your motions.
Track View keys and curves can also be displayed in the track bar. The same Key properties dialogs available on Track View can also be found on the Motion panel as well.

For details about using Track View and editing animation, see the following:

- Track View Edit Window on page 3795
- Track View Menu Bar on page 3849
- Curve Editor Toolbars on page 3873
- Dope Sheet on page 3805
- Dope Sheet Toolbars on page 3879

Understanding Track View Concepts

The left side of Track View, called the Controller Window, presents a Hierarchy list of everything in your scene. Every object and environment effect appears in the list, along with its associated animatable parameters. Choose items from this list to apply changes to the animation values. Expand or collapse the list using manual navigation, or allow the Auto expand to determine the display in this window.

The right side of Track View, called the Key window, charts the changes applied to parameters over time. Any change you make to one of these parameters when the Auto Key button is on, appears as a key in the right side of Track View. Select keys to apply changes to one or more specific keys.

This section covers some of the editing functions you can use with Track View:

- Copying and Pasting Items on page 3946
- Copying and Pasting Objects on page 3948
- Making Instance and Reference Controllers and Objects Unique on page 3950

Track View Workspace

The Track View Key window displays function curves and keys when in Curve Editor mode. When in Dope Sheet mode, the tracks can be displayed as keys or ranges. You select and change animation values and timing in these windows. The Key window also indicates the active time segment. Time within
The active time segment is highlighted with a light gray background. The Track View Key window is sometimes referred to as the Key window.

Components of the Key window include a time slider, a time ruler, and a scale origin slider. The Track View time slider indicates the current frame and is synchronized with the viewport time slider. A time ruler at the bottom of the window can be raised to measure keys against time. A scale origin indicator (a horizontal orange line at 0) can be moved during scale value operations as a reference point for scaling.

**Interface**

The two main sections of the Track View workspace consist of the Key window and the Controller window.

**Controller Window**

The Controller window displays object names and controller tracks, and determines which curves and tracks are available for display and editing. Hierarchy items in the Controller window can be expanded and rearranged as necessary using the Hierarchy list right-click menu. The navigation tools can also be found in the Track View Options menu. Default behavior is to only show selected object tracks. Use Manual Navigation mode to collapse or expand tracks individually, or press Alt+right-click to display an alternate menu to collapse and expand tracks.
Controller window

Key window

The Key window displays the keys as either curves or tracks. The tracks can be displayed as a box graph of keys or range bars.
Key Creation

Keys are created using a variety of methods. Keys can be created by turning on Auto Key, moving the time slider, and then transforming the object or adjusting its parameters. Keys can also be created by right-clicking the viewport time slider to access the Create Key dialog. Keys can be created directly in Track View using Add Keys. Finally, keys can be created by turning on Set Key mode, moving to a desired frame, posing the object, then clicking Set Key.

Key Display

Keys are displayed as points on the function curves, or as boxes on the Dope Sheet. Keys on the Dope Sheet are color-coded for easy identification. When there are multiple tracks keyed at one frame, the boxes appear with bands of color to indicate the shared key types. Key coloration is also used to show soft selection of keys. Subframe keys (keyframes that fall between frames) are indicated as narrow rectangles within the boxes.
Colored keys with subframe display

Keys are also displayed on the track bar below the viewport.

Keys displayed on the function curves have tangency types. The tangency buttons found on the Key Tangents toolbar can be used to change the function curve keys. Use Custom tangency to show editable curve handles. Use Step tangency to freeze motion or create classic storyboard pose-to-pose blocking.

Function curves can also be displayed below the track bar.
Custom Tangency handles

Range Bars

In the Dope Sheet - Edit Ranges mode (when animation keys have been created), range bars display to indicate the range of time the animation occurs. Tools specific to working with ranges (position ranges and recouple ranges) can be found on the Ranges toolbar (off by default). Right-click the toolbar, choose Show Toolbars, and then select Range-Track View to access these tools.
Function Curves

Function Curves display the values of keys, and the interpolated values between keys, as a curve. These curves express how a parameter varies over time. Only animation tracks can display function curves. You can edit the curves using tangency handles on the keys to change the shape of the curve.
Multiple curves can be viewed simultaneously by selecting tracks in the Controller window. This is especially useful when using Multiplier or Ease Curves. You can adjust the multiplier or ease curve point tangencies and watch the final result in the controller curve at the same time.

**Time Ruler**

The time ruler measures time. Markings on the ruler reflect the settings in the Time Configuration dialog. Move the time ruler up to the keys for more accurate key placement.

**Track View Time Slider**

The current time is indicated by the Track View time slider. This is displayed as a set of blue vertical lines synchronized with the position of the viewport time slider. You can move the Track View time slider by dragging it in the Key window. Moving either time slider updates the animation in the viewports. The blue time slider also serves as a scale origin point when scaling keys in time.
Scale Values Origin Line

When you scale key values on page 3955 (that is, scaling in space rather than time), a horizontal orange line appears at the 0 value on the vertical graph axis. This orange line is a scale values origin indicator, which you can move vertically to vary the reference point for scaling values.
TIP The easiest way to return the scale origin line to the 0 position is to close and reopen Track View.

**Curve Editor Introduction**

Main toolbar > Curve Editor (Open) button

*Track View* on page 3790 > Modes menu > Curve Editor

Main menu > Graph Editors > Track View - Curve Editor

Right-click an object selected in a viewport. > Curve Editor

The Track View - Curve Editor is a Track View mode that allows you to work with motion expressed as function curves on a graph. It lets you visualize the interpolation of the motion, the object transformations that 3ds Max creates between the keyframes. You can easily see and control the motion and animation of the objects in the scene using tangent handles on the keys found on the curves.

The Curve Editor interface consists of a menu bar, a toolbar, a Controller window, and a Key window. There is also a time ruler, and navigation and status tools at the bottom of the interface.

You can loop or cycle your animation beyond its range by adding Parameter Curve Out-Of-Range Types from the Curve Editor, as well as by adding Multiplier or Ease Curve onto other animated tracks for added control.
Dope Sheet

Track View on page 3790 > Modes menu > Dope Sheet
Main menu > Graph Editors menu > Track View - Dope Sheet
Right-click an object selected in a viewport > Dope Sheet

The Track View - Dope Sheet editor displays keyframes over time on a horizontal graph. This graphical display simplifies the process of adjusting animation timing because you can see all keys at once in a spreadsheet-like format.

Classical animation technique included the use of an exposure sheet, called an “X” sheet or a Dope Sheet. The Dope Sheet was a vertical chart that served as instructions to the camera operator. Dialogue and camera actions were indicated over a numbered list that represented each shot, which became a
single photographed frame of the animated movie. The classical exposure sheet also included instructions for compositing the cel drawings of animated characters over backgrounds. This device serves as inspiration for the Dope Sheet tool in 3ds Max.

The 3ds Max Dope Sheet editor is similar to the classic X sheet. It displays keyframes over time, only using a horizontal graph (rather than vertical). This provides tools for adjusting the timing of your animation. Here, you can see all the keys in a spreadsheet-type interface. You can select any or all of the keys in a scene, scale them, move them, copy and paste them, or otherwise work directly here, rather than in the viewport. You can choose to select the keys for children, or subtree, or both, so you can make simple changes that affect many objects and their keys at once.

A common use of Dope Sheet is to stagger the movement of a character’s limbs so they don’t all move simultaneously. If you have a crowd of characters, you could use Dope Sheet to shift movements so they don’t all move in unison.

**Dope Sheet Menus and Tools**

In the Dope Sheet, you can select any or all of the keys in a scene, scale them, move them, copy and paste them, or otherwise work directly, rather than working with objects in viewports. You can choose to select the keys for children, or subtree or both, so you can make simple changes that affect many objects and their keys at once.

Dope Sheet allows for soft-selection of keys which is very useful when working with motion capture data that has keys on every frame.

Dope Sheet provides tools for working directly with time. You can select, cut, copy, paste, and insert and reverse time using the tools on the Time menu.

Like the Curve Editor on page 3804, Dope Sheet has both a menu bar and toolbars to provide you quick access to tools.

<table>
<thead>
<tr>
<th>Modes</th>
<th>Settings</th>
<th>Controller</th>
<th>Tracks</th>
<th>Keys</th>
<th>Time</th>
<th>Utilities</th>
</tr>
</thead>
</table>

**Dope Sheet menu bar**

Unlike Curve Editor, Dope Sheet has two modes: Edit Keys and Edit Ranges. These modes affect the display in the Key window.
Edit Keys Mode

When Edit Keys is active, the keyframes are displayed as boxes within rectangles on a grid. The keys are color-coded to show what has been keyframed (position is red, scale is yellow, rotation is green, and so on.)

Colored keys

Dope Sheet keys are now displayed as rectangles within boxes so you can easily spot sub-frame keys, keys that fall in-between frames. Keys that fill the boxes are on the frame, keys that are small rectangles are sub-frame.
Dope Sheet, just like the Curve Editor, allows you to use soft selection on keys. This is extremely useful when you are dealing with massive quantities of keys, such as in motion-capture data files. Combine this with scaling keys for a means to manipulate motion data.

When Edit Ranges is active, the animation tracks are displayed as range bars; no individual keys are visible. Use this mode when you want to change only how long an action takes, or when it starts and ends, rather than particular keys within an animation range.
Edit Ranges mode

Modify Subtree and Modify Child Keys

When working in Dope Sheet mode, you can toggle Modify Subtree on page 3860 and Modify Child Keys on page 3861. These let you automatically move the tracks for the subtree and the keys for the children, respectively. If you experience a slowdown while working with Dope Sheet, try turning these off and moving the keys manually instead. Modify Subtree is on by default in Dope Sheet, but Modify Child Keys is off.

Time Editing

Dope Sheet offers you a variety of tools for working directly with time. You can select a period of time, which includes all the keys within that period, and then perform different operations on that time segment. You can copy and paste time to loop animations, or reverse time so the animation plays backward. You can insert time to add a space to an animation, or delete time to shorten a motion.

NOTE For Dope Sheet procedures, see the individual tools and menu choices within the links below.
Dope Sheet Display Optimization

Only tracks displayed in the current field of view are computed, optimizing the responsiveness of the Dope Sheet editor.

Dope Sheet temporarily retains the key caches so tracks that have already been computed as a result of the parent being computed needn't be recomputed. The cache is used instead.

The default auto-navigation settings for the Dope Sheet editor auto-expand only to the node track for the currently selected object. This reduces the number of tracks whose keys need to be displayed and also helps enforce the top-down workflow for which the Dope Sheet editor is designed.

See also:

- Track View Menu Bar on page 3849
- Dope Sheet Toolbars on page 3879
- Select Time on page 3930
- Edit Ranges on page 3943
- Edit Keys on page 3906

Time Ruler

Track View on page 3790 > Time Ruler (below right-hand pane)

The time ruler at the bottom of the Track View Key window measures time. Markings on the time ruler reflect the settings in the Time Configuration dialog on page 8106. You can drag the time ruler vertically in the Key window to align it with any track.

```
0 ....... 20 .... 40 ......... 60 .... 80 .... 100
```

Track View Shortcuts

This topic lists Track View functions for which keyboard shortcuts can be set. Where there is no default keyboard shortcut listed and no button shown in the action list, a brief description appears in the right column.
To use Track View keyboard shortcuts, the Keyboard Shortcut Override toggle on page 8420 must be on.

**See also:**
- Track View on page 3790
- Keyboard Shortcuts on page 8419
- Keyboard Panel on page 8250
- Customize User Interface Dialog on page 8249

<table>
<thead>
<tr>
<th>Track View Function</th>
<th>Default Keyboard Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access Hierarchy Select Name Field</td>
<td></td>
<td>Accesses the track selection field at the lower left of Track View window</td>
</tr>
<tr>
<td>Access Time Field</td>
<td></td>
<td>Accesses the time field at the lower left of Track View window</td>
</tr>
<tr>
<td>Access Track Name Field</td>
<td></td>
<td>Accesses the name of the Track View window at upper right</td>
</tr>
<tr>
<td>Access Value Field</td>
<td></td>
<td>Accesses the value field at the lower left of Track View window</td>
</tr>
<tr>
<td>Add Keys</td>
<td>A</td>
<td></td>
</tr>
<tr>
<td>Add Note Track</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Add Visibility Track</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Align Keys</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Apply Ease Curve</td>
<td>Ctrl+E</td>
<td></td>
</tr>
</tbody>
</table>

Track View Shortcuts | 3811
<table>
<thead>
<tr>
<th>Track View Function</th>
<th>Default Keyboard Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apply Multiplier Curve</td>
<td>Ctrl+M</td>
<td></td>
</tr>
<tr>
<td>Assign Controller</td>
<td>C</td>
<td></td>
</tr>
<tr>
<td>Auto Expand Animated</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Auto Expand Keyable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Auto Expand Limits</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Collapse All</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Collapse Objects</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Collapse Tracks</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Copy Controller</td>
<td>Ctrl+C</td>
<td></td>
</tr>
<tr>
<td>Copy Time</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cut Time</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delete Controller</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delete Ease/Multiplier Curve</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delete Note Track</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delete Visibility Track</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Draw Curves</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Track View Function</td>
<td>Default Keyboard Shortcut</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>---------------------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td>Ease Curve Out-of-Range Types</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ease/Multiplier Curve Enable Toggle</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Edit Keys Mode</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Edit Ranges Mode</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Edit Time Mode</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Edit Track Set</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Exclude Left End Point Toggle</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Exclude Right End Point Toggle</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Expand Object Toggle</td>
<td>O (letter ‘o’)</td>
<td></td>
</tr>
<tr>
<td>Expand Objects</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Expand Track Toggle</td>
<td>ENTER, T</td>
<td></td>
</tr>
<tr>
<td>Expand Tracks</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Filters</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>Freeze Nonselected Curves</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Function Curves Mode</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ignore Animation Range</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Track View Function</td>
<td>Default Keyboard Shortcut</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Insert Time</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Keyable Properties Toggle</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lock Selection</td>
<td>Spacebar</td>
<td></td>
</tr>
<tr>
<td>Lock Tangents Toggle</td>
<td>L</td>
<td></td>
</tr>
<tr>
<td>Make Controller Unique</td>
<td>U</td>
<td></td>
</tr>
<tr>
<td>Modify Subtree Toggle</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Move Highlight Down</td>
<td>Down Arrow</td>
<td></td>
</tr>
<tr>
<td>Move Highlight Up</td>
<td>Up Arrow</td>
<td></td>
</tr>
<tr>
<td>Move Keys</td>
<td>M</td>
<td></td>
</tr>
<tr>
<td>Move Keys Horizontal</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Move Keys Vertical</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Move Object Down</td>
<td></td>
<td>Moves an object down in the hierarchy display</td>
</tr>
<tr>
<td>Move Object Up</td>
<td></td>
<td>Moves an object up in the hierarchy display</td>
</tr>
<tr>
<td>Multiplier Curve Out-of-Range Types</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Nudge Keys Left</td>
<td>Left Arrow</td>
<td></td>
</tr>
<tr>
<td>Nudge Keys Right</td>
<td>Right Arrow</td>
<td></td>
</tr>
<tr>
<td>Track View Function</td>
<td>Default Keyboard Shortcut</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>---------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Pan</td>
<td>P</td>
<td></td>
</tr>
<tr>
<td>Parameter Curve Out-of-Range Types</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Paste Controller</td>
<td>Ctrl+V</td>
<td></td>
</tr>
<tr>
<td>Paste Limit Only</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Paste Time</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Position Ranges Mode</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Properties</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reduce Keys</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remove Limit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Respect Animation Range</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reverse Time</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Scale Keys</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Scale Time</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Scale Values</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Scroll Down</td>
<td>Ctrl+Down Arrow</td>
<td></td>
</tr>
<tr>
<td>Scroll Up</td>
<td>Ctrl+Up Arrow</td>
<td></td>
</tr>
<tr>
<td>Select All</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Track View Shortcuts | 3815
<table>
<thead>
<tr>
<th>Track View Function</th>
<th>Default Keyboard Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Children</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Select Invert</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Select None</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Select Time</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Select Lower Limit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Set Tangents to Auto</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Set Tangents to Custom</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Set Tangents to Fast</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Set Tangents to Linear</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Set Tangents to Slow</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Set Tangents to Smooth</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Set Tangents to Step</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Set Upper Limit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Show All Tangents</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Show Keys on Frozen Curves</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Show Selected Key Stats</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Show Tangents Toggle</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Track View Function</td>
<td>Default Keyboard Shortcut</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Slide Keys</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Snap Frames</td>
<td>S</td>
<td></td>
</tr>
<tr>
<td>Toggle Limit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Track View Utilities</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Zoom</td>
<td>Z</td>
<td></td>
</tr>
<tr>
<td>Zoom Horizontal Extents</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Zoom Horizontal Extents</td>
<td>Alt+X</td>
<td></td>
</tr>
<tr>
<td>Zoom Region</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Zoom Selected Object</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Zoom Time</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Zoom Value Extents</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Zoom Values</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Track View Hierarchy**

*Track View* on page 3790 > Controller Window

The Track View Controller window displays all elements in your scene in a hierarchical fashion.

You highlight items in the Hierarchy list to:

- Designate object and track labels for Track View operations.
- Select objects in the scene.
- Designate materials and maps when working in the Material Editor.
- Navigate the modifier stack in the Modify panel.

**See also:**
- **Hierarchy Right-Click Menu** on page 3825
- **Properties (Track View Hierarchy)** on page 3832
- **Modify Subtree** on page 3860
- **Sound** on page 3833

**Procedures**

**To select objects in the scene using the Track View Controller window:**

1. Do one of the following to select the first object:
   - Click an object's icon to select a single object.
   - Double-click a parent object's icon to select an object and its descendants.

2. Do one of the following to select additional objects:
   - Press Shift and click an object icon to select all objects between the object and the previously selected object.
   - Press Ctrl and click an object icon to add (or remove) the object to the selection.

When objects are selected in the scene, their icons are also highlighted in Track View.

All objects in your scene are always displayed in Track View. However, selecting object icons in Track View follows the same rules as selecting objects in the scene:

- You can't select the icon of a hidden object.
- You can't select the icon of a frozen object.
- If you select the icon of an object that is part of a closed group, the group icon and all the objects in the group are selected.
To select and deselect item labels by clicking:

1. Select the first item by clicking its label.

2. Do one of the following to add or subtract from the selection:
   - Press Shift and click an item label to select all items between the item and the previously selected item.
   - Press Ctrl and click an item label to add (or remove) that item to the selection.
   - Press Alt and click an item label to select all item labels in the column.

Right-clicking an item displays a right-click menu for globally selecting items in the Hierarchy list.

To select items in the Controller window with the right-click menu:

- Right-click an item in the Controller window, then do any of the following:
  - Choose Select All to select all items visible in the Hierarchy list. Collapsed items are not selected. Press Ctrl and choose Select All to select only visible transform items.
  - Choose Select Invert to reverse the selection pattern.
  - Choose Select None to clear all items from the selection.
  - Choose Selected Children to select the linked descendants of a parent object.

When working with function curves, you can also select a controller icon (instead of the label) to select that function curve for vertex editing.

To select a material or map as the active material in the Material Editor:

1. Open the Material Editor.

2. Open the Medit Materials branch in the Hierarchy list of the Controller window and select a material.
   The selected material becomes the active item in the Material Editor. This is one way to navigate and select a material for editing.
Example: To navigate the modifier stack in the Modify panel:

1. Create a cylinder.
2. In the Modify panel, add a Bend and a Twist modifier to the cylinder.
3. In the Track View controller window, expand the Cylinder branch.
4. Expand the Modified Object branch.
5. Click the icon of the Twist modifier.
   The Twist modifier is displayed on the Modify panel.
6. Click the icon of the Bend modifier in the Hierarchy list.
   The Bend modifier is displayed on the Modify panel.

Example: To highlight all tracks containing animation:

1. Create a box and a sphere.
2. Click Auto Key, go to frame 10, and move the sphere in X.
3. Go to frame 20 and move the sphere in Y.
4. Go to frame 30 and move the sphere in Z.
5. Deselect the sphere by clicking in a blank area of the viewport.
6. Open the Track View — Curve Editor and press Ctrl+A (Select All).
   Locate in the Track View Controller window the box and sphere objects.
   Notice that both their icons are highlighted as well as the sphere's XYZ position tracks. The box's tracks aren't highlighted because they don't contain any animation.
Interface

Scene Hierarchy

World  World is the root of the scene hierarchy. This track collects all keys in your scene as a single range for quick global operations.

By default, the World track shows the range of the Sound, Environment, Medit Materials, and Scene Materials branches. Modify Subtree in Edit Ranges mode causes the World track to include the range of all tracks in the Objects branch as well.
NOTE The default location of the time ruler covers the World animation track. Move the time ruler to see the World track.

**Sound** You can accompany your animations with audio tracks via either of two plug-ins: Default Sound and ProSound. For details, see Sound on page 3833.

**Global Tracks** Allows you to store controllers for global use. Using expression controllers, for example, you could point to a controller in the Global Tracks from several other tracks. By altering the expression in the Global Tracks, all of the other tracks are changed.

By pasting an instance of a controller in Global Tracks to a number of other tracks, you can change many tracks by altering the controller in Global Tracks.

By default, Global Tracks contains List tracks of the different controller types. To assign a controller, open one of the List tracks, highlight the available track, and then click Assign Controller. Once the controller is assigned, you can point to it from an expression controller assigned to any other track, or you can copy and paste it to any number of matching controller types.

**Video Post** Allows you to manage animated parameters for Video Post plug-ins.

**Environment** Contains items that control the background and scene environment effects. Examples include Ambient Light, Background definition, Fogs, and Volumetric Lighting.

**Render Effects** Contains tracks for the effects added in Rendering menu > Effects. After adding rendering effects, use the tracks here to animate effects parameters such as glow size and color.

**Render Elements** Shows you what elements you've chosen to render separately via the Render Setup dialog > Render Elements rollout.

**Renderer** Allows you to animate parameters in the renderer. After selecting a type of antialiasing in the Render dialog, you can animate various antialiasing parameters using these tracks.

**Global Shadow Parameters** Use these tracks to change or animate shadow parameters for any light that has the Use Global Settings parameter turned on in the Shadow Parameters rollout. (Select a light, then open the Modify panel > Shadow Parameters rollout to toggle the Use Global Settings parameter). You can change shadow parameters for multiple lights simultaneously. Tracks include Map Size, Map Range, Map Bias, and Absolute Bias on page 5448.

**Scene Materials** Contains the definitions for all materials in the scene. It is empty until you begin assigning materials to objects. When you select materials
in this branch, you are working with instances of materials assigned to objects in your scene. These materials might not be in any of the Material Editor samples.

**Medit Materials** Contains global material definitions. The Medit Materials branch contains the 24 material definitions in the Material Editor on page 5641. When you select materials from this branch, you are working with global material definitions that might not yet be assigned to objects in your scene.

**Objects** Contains a hierarchy for all the objects in your scene. When Manual Navigation on page 3862 is on, many of these categories display a small plus or minus button to expand/collapse the contents.

**Item Categories**

Each type of item in the Hierarchy list is represented by an icon. You can use these icons to quickly identify what each item represents.

**Objects** Branches contain linked descendants of the object. Branches below contain transforms, materials, and modifiers applied to the object, as well as the object’s creation parameters.

**Controllers** They contain the animation values for parameters and are the only item in the Hierarchy list that can have a track containing keys. Every controller has an individual icon

![Diagram of Object hierarchy with icons for Length, Width, Height, Width Segments, and Length Segments.]

**Examples of controller icons**

Certain types of controllers can contain other controllers. Examples of these are Transform Controllers and List Controllers.
NOTE Controllers that have been applied to objects via the Animation menu > Controllers or Constraints submenus automatically have list controllers assigned. Controllers assigned using the Track View Controller menu or right-click Assign Controller choice on the quad menu do not apply list controllers automatically.

Maps Indicates map definitions. All branches below a map definition are part of that map. This includes values used by parametric maps and other map definitions that are part of a map tree.

Modifier This icon indicates modifiers and space warp bindings. Branches below a modifier contain the modifier’s sub-objects and parameters.

Controller Window Right-Click menu

Right-click any item in the Controller window to display the right-click menu on page 3825. Use Alt + right-click to display an alternate navigation menu.

Track View Hierarchy Icons

The Track View hierarchy, as displayed in the Controller window, follows the traditional example of organizational headings in an outline. The highest levels of the hierarchy represent the main groupings in 3ds Max of Sound, Environment, Materials, Render Effects, and Objects. Lower levels of the hierarchy progress through the details of your scene, such as individual materials, material maps, and map parameters.

Each type of item in the Track View Hierarchy List is represented by an icon. You can use these icons to quickly identify what each item represents.

Sound Indicate sound parameters. 3ds Max provides only one sound source in Track View.

Material Indicates material definitions. All branches below a material definition are part of that material. Because a material can be composed of multiple materials it is possible to have nested material definitions in Track View. Icons also appear in an object’s modifier branch when a material is assigned to an object.

Map Indicates map definitions. All branches below a map definition are part of that map. This includes values used by parametric maps and other map definition that are part of a map tree.
**Object** Indicates objects in the scene. Branches below the square icon contain linked descendents of the object. Branches below the circle icon beside a yellow cube contain transforms and modifications applied to the object.

**Modifier** Indicate modified objects and Space Warp bindings. Branches below a modifier contain the modifier’s sub-objects and parameters.

**Controller** Indicate animation controllers. Controllers are the animation workhorses of Track View. They contain the animated values for all parameters and are the only item in the Hierarchy list that can have a track containing keys. Every controller has its own individual icon. Some examples:

- Position controller
- Rotation controller
- Scale controller

Certain types of controllers can contain other controllers. Examples of these are Transform Controllers and List Controllers.

**Hierarchy Right-Click Menu**

*Track View* on page 3790 > Select an item in the Track View controller window and right-click > Hierarchy right-click menu

The Hierarchy right-click menu contains quick-access commands for assigning, copying and pasting controllers, accessing controller properties, as well as tools for navigating, expanding and collapsing the Hierarchy list of the Controller window.
The Hierarchy right-click menu contains quick-access commands for expanding and collapsing the hierarchy.

**TIP** Use Alt+right-click with quad menu tools to expand and collapse selected tracks individually.

**TIP** The Hierarchy right-click menu displays commands related to the highlighted item while the Alt+right-click menu displays commands related to the item currently located under your mouse cursor.

**Interface**

- **Lock** Locks highlighted animation tracks, thus preventing any change in the property or properties the tracks control, or controllers for those tracks. For example, if you lock an object’s X Position track, you can then move it in the YZ plane, but not on the X axis. If a track is locked, the text “(Locked)” appears after its name in the track view hierarchy.
Locking a parent track also locks all of its child tracks. For instance, if you lock an object’s Transform/Rotation track, its X/Y/Z Rotation tracks are locked as well (assuming the default Euler XYZ rotation controller), thus preventing the object from being rotated at all.

**NOTE** If a track is part of an animation layer, toggling its locked status affects all tracks in that particular Layer controller. For details, see [Animation Layers (Layer Controller)](page) on page 3467.

**TIP** To toggle the display of locked tracks, use the Filter - Unlocked Attributes Toggle on the Track Selection toolbar (see [Track Filters](page) on page 3980). Also, if you turn on [Lock Toggle Icons](page) on page 3863 on the Display menu, you can toggle a track’s locked status simply by clicking its lock icon.

![Unlock](image) Unlocks highlighted locked tracks.

**NOTE** Unlocking a child track unlocks any locked parent tracks, all the way to the top of the hierarchy. For example, if you lock an object’s Transform track, and then unlock its X Position track, this also unlocks the Position and Transform tracks.

However, unlocking the parent in a locked hierarchy does not automatically unlock any locked children. For example, locking an object’s Position track also locks the X/Y/Z Position tracks (assuming the default Position XYZ controller). But if you then unlock the same Position track, its children, the X/Y/Z Position tracks, remain locked.

![Override All Locks](image) Temporarily disables locking of all tracks in the Hierarchy list. When Override All Locks is on, the “(Locked)” text in the Hierarchy list changes to “(Overridden)” and you can change properties in locked tracks (for example, animate rotation) as if they were not locked. But after you turn Override All Locks back off, locked tracks can no longer be manipulated.

**Select All** Selects all tracks that are visible in the Hierarchy list. Collapsed items are not selected.

**Select Invert** Inverts the current Hierarchy list selection.

**TIP** Inverting an empty selection is the same as selecting all.
**Select None** Deselects all visible object tracks in the Hierarchy list. Does not apply to selected objects in the scene (object icons remain highlighted).

**Select Children** Selects all objects descending from the selection by highlighting their icon in the Hierarchy list. Collapsed children are also selected.

**TIP** You can also select an object’s children by double-clicking its icon.

**Expand Objects** Expands only the object branch for all descendants of the selected object. The expanded branches are not selected.
NOTE  If you are using Auto Expand on page 3858 with the Children option turned on, all objects branches are automatically expanded.

Expand Tracks Expands all branches of the selected item.

Expand All Expands all branches for all descendants of the selected object.

Collapse Objects Collapses only the object branch for all descendants of the selected object.

Collapse Tracks Collapses all branches of the selected item.

 Collapse All Collapses all branches for all descendants of the selected object.
**Auto Expand** Expands the Hierarchy list automatically based on submenu selection choices. Submenu choices are: Selected Objects Only, Transforms, XYZ Components, Limits, Keyable, Animated, Base Objects, Modifiers, Materials, and Children.

**Manual Navigation** Turns off Auto Expand. Allows you to manually decide when you will collapse and what you will expand. A small minus button in a circle to the left of an item lets you collapse it. This button disappears when Auto Expand is on and Manual Navigation is off.

**TIP** To expand or collapse individual tracks, use Alt+right-click.

**Load Animation** Loads XML animation data from files to the highlighted track or tracks. For more information, see Saving and Loading Animation on page 4103.

If any of the highlighted tracks has child tracks, animation is loaded to those tracks as well.

**Save Animation** Saves XML animation data from the highlighted track or tracks to disk files. For more information, see Saving and Loading Animation on page 4103.

If any of the highlighted tracks has child tracks, animation is saved from those tracks as well.

**Properties** Displays the property dialog of a controller, if available. Not all controller use this dialog, and it is unavailable in these cases.

**Assign Controller** Displays the Assign Controller dialog, which offers a list of the available controller for that selection.
Copy Makes a copy of the controller held in the Track View clipboard.

Paste Pastes the copied controller to another object or track. Copies can be pasted as instances or as unique copies.

Make Unique Changes an instanced controller into a unique one. Changes made to instanced controller are reflected in all versions of the controller, unique controllers can be individually edited without affecting anything else.

**Alt + Right-click Menu**

These commands can also be found on the right-click quad menu described above.

Expand Objects Expands only the object branch for all descendants of the selected object. The expanded branches are not selected.

**NOTE** If you are using Auto Expand on page 3858 with the Children option turned on, all objects branches are automatically expanded.

Expand Tracks Expands all branches of the selected item.

Expand All Expands all branches for all descendants of the selected object.

Collapse Objects Collapses only the object branch for all descendants of the selected object.

Collapse Tracks Collapses all branches of the selected item.

Collapse All Collapses all branches for all descendants of the selected object.

Select All Selects all tracks that are visible in the Hierarchy list. Collapsed items are not selected.

Select Invert Inverts the current Hierarchy list selection.

**TIP** Inverting an empty selection is the same as selecting all.

Select Children Selects all objects descending from the selection by highlighting their icon in the Hierarchy list. Collapsed children are also selected.

**TIP** You can also select an object's children by double-clicking its icon.

Select None Deselects all visible object tracks in the Hierarchy list. Does not apply to selected objects in the scene (object icons remain highlighted).

Properties See Properties on page 3832.
Properties (Track View Hierarchy)

Track View on page 3790 > Select an item in the Controller window > Right-click. > Properties

Right-click an animated object in the viewport. > Curve Editor > Right-click the Key window. > Properties

Motion panel > Assign Controller rollout > Right-click a controller track. > Properties

Properties displays the Properties dialog for the selected item in the Track View. For example, this option displays the Key Info dialog for selected keys, or the Sound Options dialog on page 3833 if you select an item in the Sound Track.

Some controllers, such as Noise, use the Properties dialog as their primary interface for animating parameters. Other controllers do not use the Properties dialog at all, and in those cases it is unavailable.

Procedures

To display properties for animation controllers:

1 Select the controller track in the Controller Window.
2 On the Controller menu choose Properties.
   Or you can right-click and select Properties from the Track View quad menu.

To display the properties dialog for a Bezier key:

The Bezier Controller is the default position controller when an object is animated.

1 In the Track View Key window, select an object's position key.
2 Right-click the key.
   The controller dialog is displayed. The Key Tangency choices are available from the dialog.

TIP You can also change tangency handles using the tools in the Key Tangents: Track View toolbar.
To display the Sound Options dialog for adding a sound track:

1. In the Track View Hierarchy, select the Sound item.

2. Right-click and choose Properties.
   The Sound Options dialog is displayed.
   You can use this dialog to assign a sound file to the animation, which can be displayed in Track View or the track bar.

To display the Sound Options dialog for adding a sound track:

1. In the Track View Hierarchy, select the Sound item.

2. On the Tools toolbar, click Properties, or right-click the Sound label and choose Properties.
   The Sound Options dialog is displayed.

Sound

The Sound track lets you add audio to your animations by either of two options: Default Sound (Sound Options dialog) and ProSound. To assign the sound option, use Preferences > Animation > Sound Plug-In. To access the sound settings, open Track View, click and then right-click the Sound track, and choose Properties.

While Default Sound is easier to use, ProSound is far more powerful and offers more options.

Sound Options Dialog

Track View on page 3790 > Right-click a Sound track in the Controller window. > Properties > Sound Options dialog

When using Default Sound, the Sound track in the Track View Controller window contains two sound options. Use the Metronome to generate a series of beeps, or load a sound file to play back.

Default Sound allows you to synchronize your animation to a sound file or to a metronome. If you use a sound file, a Wave Form track is displayed in the Hierarchy list, and a waveform is displayed in the Edit window. A sound
file plays on your installed sound card. You set the Metronome and the Wave Form parameters in the Sound Options dialog on page 3833.

Sound is one way to provide the timing for your animation. You can scrub the time slider to locate a particular sound, and coordinate your visuals around it.

You can display this dialog by right-clicking the Sound item in the Track View controller window, or by right-clicking a sound track in the Key window.

**Procedures**

**To add a sound track:**

1. In the Track View Controller window, right-click a sound item and choose Properties.
   The Sound Options dialog is displayed.
2. Click Choose Sound, select a sound file, and then click OK.
   A Wave Form branch appears in the Track View Hierarchy. A waveform appears in the Track View Key window.
3. Turn on Real Time in the Time Configuration dialog to hear the sound track when you play your animation.

**Interface**
Audio group

Choose Sound Displays a file selector where you choose a sound file.

Remove Sound Deletes the waveform from Track View.

Reload Sound Reloads the last loaded file. This allows the sound file to be reloaded when it has been changed by another program.

Active Plays the waveform during animation play back.

Metronome group

The Metronome track produces a regular beat using two tones. You specify three settings in the Sound Options dialog to control the Metronome:

Beats per minute Sets the frequency of beats. The beats display in the Metronome tracks as black vertical bars. Default=60.

Beats per measure Sets which beat is emphasized with a higher pitch tone. Emphasized beats display in the Metronome track as black pluses. For example, a setting of 4 generates a higher pitched tone every fourth beat. Default=4.

Active Plays the beats during animation playback.

ProSound

Customize menu > Preferences > Animation panel > Sound Plug-In group > Click Assign > Choose Sound Plug-In dialog > Double-click ProSound. > Click OK. > Track View > Highlight Sound track > Right-click > Properties

MAXScript Listener (or Mini Listener) > Enter “prosound.init(true)” (without quotes) > Enter “prosound.open()” (without quotes)

Initialize ProSound (see either of the preceding) > Track View or Mini Curve Editor (on track bar) > Highlight Sound track (or any child track). > Right-click > Properties

ProSound is a real-time, multitrack audio solution for 3ds Max that includes full support for and integration with Track View. For best results, use Track View in Dope Sheet mode.

With ProSound, you can:

- Add up to 100 independent audio tracks.
Animate the volume of each track.

- Normalize the output audio volume to handle soft or transient tracks.

- Manipulate sound tracks and audio samples independently in Track View or with the ProSound controls.

- Use PCM audio in both AVI and WAV files with up to six output channels: front left, front right, back left, back right, center, and low frequency. (Note: Multichannel audio must pre-exist in sound files.)

- Export audio to a WAV file, or add it to an existing AVI.

- Play back the audio accurately at 1/4, 1/2, 1, 2, and 4 times recorded speed to match viewport settings.

- Render audio to match playback speed.

- Manage multiple sound-effects directories.

- Access all features from MAXScript with 46 audio-related functions.

### Editing ProSound Tracks in Track View

When working with ProSound tracks in Dope Sheet mode on page 3805, use Edit Ranges on page 3943 to drag an audio clip and its endpoints. Dragging a range changes its start and stop times by the same amount, while dragging an endpoint makes it shorter (by truncating the clip) or longer (by repeating the clip). You can change the length of individual clips (must be set to End Frame on page 3844, not Loops) but not of the Master Waveform track, which serves as a composite of all the individual clips. Dragging an endpoint of the Master Waveform track is the same as dragging the range.
Truncating a clip always takes place from the ending, not the beginning, no matter which end you drag.

To open the ProSound interface with a specific track highlighted, showing its parameters, simply right-click the track (either the waveform or the range bar) in the graph area of Track View - Dope Sheet.

**Procedure**

**To assign and access ProSound:**

1. From the Customize menu choose Preferences and then click the Animation tab.

2. In the Sound Plug-In group click Assign; this opens the Choose Sound Plug-In dialog. In the dialog list double-click ProSound and then click OK to close Preferences.

3. Open Track View and click the Sound track (under World) to highlight it. Then right-click and choose Properties.

   The ProSound dialog opens.

NOTE An alternative method of opening the ProSound dialog is included in the path annotation at the start of this topic.

**Interface**

The ProSound dialog is modeless, so you can keep it open while using other parts of the program.
Input Files group

Controls in this group let you manage the audio samples available in the scene. The number of loaded samples appears next to the group box title; in the preceding illustration, it's 2.

[file list] Shows all loaded samples with file paths. All of these are automatically loaded into the scene, play back when the animation is played, and are saved with rendered animations. You can control each track's playback with the controls in the File Details group (see following).

**Add** Imports samples into ProSound. Each sample creates a track in the Track View with start and end keys that you can manipulate, as with the default sound track in 3ds Max. You can add multiple files in one action with standard Windows methods: Use the Shift key to select a range of files or the Ctrl key to toggle individual files.

**Delete** Removes highlighted samples from ProSound. You can highlight multiple files for deletion.

**Replace** Lets you replace a single highlighted sample with another, from an external file.
**Reload** Loads the highlighted sample from its file. If the file contents have changed, the new sound replaces the previous one.

**Convert Path** Use this function when opening a 3ds Max scene file that points to samples in a different location from your system and ProSound has loaded the sample from a directory you added with Path Manager (see following). Convert Path adjusts the file's path in the file list to match that of your system. If you use Convert Path, save the scene, and then reopen it on the original machine, the location of the file on the original system must be added with Path Manager or ProSound will not find the sample.

Example: On another computer, a scene is saved with samples located in D:\Sound\Samples. These same samples are located in E:\Samples on your machine and you have added this directory with Path Manager. When you load the scene, your machine will find the samples and no changes will be made to the path in the Input Files section of ProSound. If you highlight these samples and use Convert Path, the paths as listed change from D:\Sound\Samples to match their location on your system: E:\Samples. If you then save the scene and open it on the original system, the original location of the samples (D:\Sounds\Samples) must be added with Path Manager so ProSound can find the samples.

**Path Manager** Lets you manage disk locations where ProSound looks for samples. This is useful when loading MAX scenes created on another system where samples might be in different directories. Adding directories in the Path Manager gives ProSound more places to look for samples. For example, if one person saves a scene with a sample located in D:\Sounds\Samples, but your copy of the sample is in E:\Samples, adding E:\Samples to the Path Manager means ProSound will find the sample on your system without additional input from you.
Clicking Path Manager opens a dialog, shown in the preceding illustration, comprising a list and the following controls:

- **Add** Opens a file dialog named Add Sound Path that lets you navigate to a file path and use it. If you highlight a path before clicking Add, the Add Sound Path dialog opens to that path, and the added path appears in the Path Manager list after the highlighted path. If no path is highlighted when you click Add, the Add Sound Path dialog opens to the last-used path, and the added path appears at the end of the Path Manager list.

- **Delete** Removes the highlighted item from the Path Manager list.

- **Modify** Opens a dialog that lets you replace the highlighted item with a different path.

- **Move Up/Move Down** Repositions the highlighted item in the list. Path Manager searches paths in the order listed.

- **OK** Accepts changes and closes the dialog.

- **Cancel** Ignores changes and closes the dialog.

**Move Up** Raises the highlighted track above the preceding one. Rearranging tracks also affects their order in Track View.

**Move Down** Lowers the highlighted track below the following one. Rearranging tracks also affects their order in Track View.
Arrange Opens a dialog that lets you sort the highlighted tracks by filename, full path name, or start frame. Choose the sort order and then click OK. Applies to highlighted tracks only.

Rearranging tracks also affects their order in Track View.

Sequence Alters the Start Frame and End Frame times to play each clip one time, in the order listed. The first clip plays to its end, then the next clip plays, and so on.

**WARNING** Clicking this button once instantly resets the start and end frame settings for all highlighted clips, and is not undoable.

Diagnostics Click to open a dialog with diagnostic information.
■ **Soft Reset**  Sometimes, after repeated playback, the sound tracks stop playing in 3ds Max. When this happens, click Soft Reset to reset the playback buffers and hear sound tracks once again.

**File Details group**

Displays information about the currently selected sample in the Input Files list.
[Play/Pause] Plays the current sample as loaded from the external source; that is, without any modification from ProSound settings. Clicking the button again during playback pauses the preview.

To the right of the Play button is the position indicator, which displays the current position of playback. You can move the slider to change the position of playback; this stops the audio output. To begin playback from the new position, click Play again.

[file name] To the right of the Preview controls (above Format), ProSound displays the file name of the highlighted sample.

Length Indicates the total length of the current sample in time and frames; for example, 3.48 s (104.5 f) indicates 3.48 seconds or 104.5 frames. The number of frames is rounded off; for example, a length of 318.688 frames would be rounded up to 318.7.

Format Indicates the audio file format of the current sample. ProSound supports two formats: WAV and AVI.

Statistics Indicates the sample rate and bit depth of the highlighted sample and whether the audio is mono or stereo.

Mapped When on, indicates that ProSound has had to load a sample from a directory other than the one used in the scene. For example, this would be on if you loaded a scene that contains a sample originally located in D:\Sound\Samples, but ProSound had to load it instead from E:\Samples as mapped with Path Manager on the current machine.

Active Indicates whether the current sample is to be included in playback as well as rendering of the output audio. For example, you could turn off Active for three of five samples so that only the other two are heard during playback of the animation, or included in the rendered animation.

Front/Center When on, places samples in the front-center channel when using five- or six-channel audio. Applicable only to one-channel (Mono) samples.

Replaceable When on, the software is permitted to replace a sample if necessary. This is used when loading samples via MAXScript and tells ProSound which samples may be replaced. The first sample with this option enabled will be replaced. If no samples have this option enabled, any samples loaded via MAXScript are appended to the Input Files list.

Start Frame The frame at which the sample is to start playing. Samples start at frame 0.0 by default.
End Frame/Loops Choose either of the following to determine the length of the sample:

- **End Frame**  The frame at which playback is to stop. By default, this is frame 0.0+(sample length in frames). For example, a sample 50 frames in length will have a Start Frame of 0.0 and End Frame of 50.0 by default. If you manipulate tracks or keys for the sample in Track View (move, slide, etc), these numbers will adjust automatically.

- **Loops**  The number of times the sample repeats. If Loops is active for a sample, you cannot change its length in Track View.

**Duration**  The true length of the current sample in frames. This value is not rounded, as in Length (preceding).

**Playback group**

These settings are global for all audio output, not individual samples (to control playback of individual samples, use the Active option in the File Details group). Also, these options do not affect how the audio is rendered for export.

![Playback interface](image)

**Permit Playback**  Toggles preview of the audio within 3ds Max. When off, the audio will not play when you play the animation or scrub the time slider.

**Channels**  The number of channels for the audio file.

**Sample Rate**  The sample rate to use when previewing audio output in 3ds Max. If set to Auto, ProSound examines the source files and determines the best setting.
**Audio Quality** Affects how ProSound alters sample rates. If, for example, Sample Rate is set to 44Khz and you are using source files of 22Khz, changing Audio Quality affects the quality of the upsampling.

**Normalize** adjusts the output of the audio so the peak amplitude is optimal - it's loudest point is the loudest possible peak for a sound clip. This insures that the audio file doesn't clip and distort if the volume is overdriven. Normalization can be set to work in four different modes:

- **Only on overflow** ProSound normalizes only when the amplitude of the output is too great.

- **Before master volume** ProSound normalizes the audio before any volume adjustments by you. In other words, this option normalizes the audio from ProSound before any adjustments are made in the Master Volume track in Track View.

- **After master volume** The audio output is normalized after volume adjustments made in the Master Volume track in Track View.

- **Never** Tells ProSound not to normalize the output.

**Track within # seconds when scrubbing** Adjusts the amount of time between when a frame is reached and the corresponding point in the audio is triggered. For example, if you move the time slider forward and this parameter is set to 0.05, as you reach each frame there is 0.05-second delay before the audio at that point is triggered.

Practically speaking, this means more accurate tracking because the lower the number, the faster you can scrub and have the audio keep up. If this option is disabled, when you scrub quickly, the audio simply plays back in real time until it reaches the current frame. For instance, if you start at frame 0 and scrub very fast to frame 75, audio plays back in real time until it reaches frame 75, and then stops, thus lagging the animation by a significant amount.

**Permit Backwards Scrubbing** When on and you scrub backward (that is, drag the time slider to the left), the audio plays in reverse.

**Play Once** When on and you play the animation in 3ds Max, playback stops after the last frame instead of repeating, as it normally does.

**Specify Play Range**

Toggles a limited playback range, as specified by the two numeric fields separated by “to,” within the full length of the time slider. This "focus area" is highlighted in the time slider area. This mode can be helpful for fine-tuning lip sync of a single word or phrase.
NOTE To see the focus area in the time slider area, it’s necessary to display the sound track: Right-click the track bar to display the context menu, and then turn on Configure > Show Sound Track.

Toggles automatic forward-then-reverse playback when you play the animation. If a Specify Play Range is active, the ping pong mode will play back and forth within this range. If Play Once is active, playback will play to the animation or play range end, then reverse play to the beginning or play range start.

**Render group**

These options adjust various parameters of the rendered audio for export. These are not heard within 3ds Max unless you export the audio and reload it as a sample. Most of the options in this section have identical functionality to the same options in the Playback group. The other options in this section are as follows.

- **Permit Save on Render** Indicates that audio output should be included when you render the scene. To set options for the exported audio, click Export Audio.

  **NOTE** This option applies only when you render to a single animation file, such as AVI or MOV.

- **Channels** The number of channels for the audio file.
Sample Rate  The sample rate to use when previewing audio output in 3ds Max. If set to Auto, ProSound examines the source files and determines the best setting.

Audio Quality  Affects how ProSound alters sample rates. If, for example, Sample Rate is set to 44Khz and you are using source files of 22Khz, changing Audio Quality affects the quality of the upsampling.

Normalize  adjusts the output of the audio so the peak amplitude is optimal - it’s loudest point is the loudest possible peak for a sound clip. This insures that the audio file doesn't clip and distort if the volume is overdriven. Normalization can be set to work in four different modes:

- Only on overflow  ProSound normalizes only when the amplitude of the output is too great.

- Before master volume  ProSound normalizes the audio before any volume adjustments by you. In other words, this option normalizes the audio from ProSound before any adjustments are made in the Master Volume track in Track View.

- After master volume  The audio output is normalized after volume adjustments made in the Master Volume track in Track View.

- Never  Tells ProSound not to normalize the output.

Export Audio  Click to open a dialog where you can set options (Range, Codec, etc.) for the exported audio. You can also export the audio separately directly from this dialog.
■ **Output Range**  Sets the length of the exported audio in frames.

■ **File**  Sets the name of the exported file.

■ **Codec**  Choose the codec (if available) and relevant attributes for the file.

■ **Export**  Click to export the audio separately from the video file.

### Metronome group

These controls work the same as the Metronome function for the standard audio functionality in 3ds Max (see the Sound Options Dialog topic) with the addition of two Tone parameters.

![Metronome Controls](image)

**Beats Per Minute > Tone**  The beep pitch indicating each beat.

**Beats Per Measure > Tone**  The beep pitch indicating each measure.
Track View Menu Bar

Track View on page 3790 > Menu bar

A menu bar appears at the top of Track View in both Curve Editor and Dope Sheet modes and the expanded track bar layout. The Track View menu bar is contextual; it changes slightly between Curve Editor and Dope Sheet modes.

The commands available on the Track View menus can also be accessed on the Curve Editor and Dope Sheet toolbars. Certain tools, however, appear only on the toolbars, and do not appear in the menus.

Modes Menu

Track View on page 3790 > Modes menu

The Modes menu lets you switch between the Curve Editor and Dope Sheet when working in Track View.

Curve Editor Displays and allows for editing of animation function curves.

Dope Sheet Displays animation as a spreadsheet of keys available for editing.

Controller Menu

Track View on page 3790 > Controller menu

The Controller menu gives you tools for working with controllers that are assigned to objects or tracks when in the Curve Editor or Dope Sheet.

Assign Lets you select tracks and then assign a controller to that selection. See Assign Controller on page 3897.

Delete ControllerLets you delete certain controllers, that can't otherwise be replaced (Visibility tracks, Image Motion Blur Multiplier, Object Motion Blur, On/Off). See Delete Controller on page 3899.

Keyable Toggles the ability to be keyed of selected controller tracks. Use this with the Show Keyable button on the toolbar to see whether a track is keyable.

Copy Puts a copy of the selected controller track into the Track View buffer. See Copy Controller on page 3894.
**Paste** Copies the controller track in the Track View buffer onto the selected track of another object or objects. You have the option of pasting as a copy or as an instance. See *Paste Controller* on page 3895.

**Collapse Controller** Converts procedural animation tracks to Bezier, Euler, Linear, or TCB keyframe controller tracks. Can also be used to convert any controller to these type of controllers. Allows for key reduction by using a Samples parameter. See *Collapse Controller* on page 3850

**Enable Anim Layer** Assigns a Layer controller to each highlighted track in the controller window. See *Animation Layers (Layer Controller)* on page 3467.

**NOTE** You must first set keys on the desired tracks before they can be layer-enabled.

**Ignore Animation Range** Ignores the animation range for the selected controller track. When set, the track plays independently of its range and its background changes color. See *Ignore Animation Range* on page 3900.

**Respect Animation Range** Respects the animation range for the selected controller track. When set, the track plays only within its range. See *Respect Animation Range* on page 3901.

**Make Unique** Lets you turn an instanced controller into a unique controller. If a controller is instanced, making changes to it will affect where ever it is copied. If the controller is unique, then changes to it will not affect anything else. See *Make Controller Unique* on page 3902.

**Out of Range Types** Lets you extend the animation beyond the existing keyframes. Used primarily to loop and otherwise cycle your animation without having to copy keys. See *Parameter Curve Out-of-Range Types* on page 3961.

**Properties** Displays the Properties dialog, which gives access to the key interpolation types. Different controller types will offer individual options here. For example a Position XYZ controller will offer Fast, Slow, Linear, Smooth, Step, Bezier and Auto Tangent as key options, while a TCB controller will not show any of those controls. For some controllers this is the primary gateway to the animation parameters. See *Properties (Track View Key Window)* on page 3918.

---

**Collapse Controller**

*Track View* on page 3790 > Controller menu > Collapse Controller
The Collapse Controller tool allows you to convert procedural animation tracks into tracks with keyframes. A procedural track is an expression track, wired parameter, noise controller, or even something like a list controller.

You can also use this tool to convert any controller track to a simple keyframed track. You can convert rotation tracks to either Euler or TCB, and collapse Position and Scale tracks to either Bezier or Linear controllers.

You can collapse an entire track, or collapse a range of frames within a track by setting the Start and End frames. A Samples parameter lets you define how many frames will be placed between keys.

Collapse Controller can be used to collapse any number of selected tracks at once.

This functionality is similar to the Collapse button found in the Collapse Transform group of the Motion panel > Trajectories rollout on page 3411.

WARNING If you are using a Path constraint with the Follow option, using Collapse Controller to collapse the position and rotation tracks will not preserve rotation properly, because additional rotation is applied by the Path constraint. If you want to collapse this kind of track, use Collapse in the Collapse Transform group of the Motion panel > Trajectories rollout instead.

Procedures

To collapse a procedural controller track:

1 In a viewport, select an object with a procedural controller, then right-click and choose Curve Editor from the quad menu.
   The Track View – Curve Editor is displayed.

2 In the Curve Editor's Controllers window, select the track you want to collapse. Then choose Controller > Collapse Controller from the Track View menu.
   The Collapse Controller dialog appears.

3 Change the Samples to specify the number of frames between keys.
   The default value of 1.0 creates a key for every other frame, which might be more than you want to work with.

4 Select the type of controller that you want the keys to use after collapsing. Position and Scale tracks collapse to either Bezier or Linear. Rotation tracks collapse to either Euler or TCB.
NOTE TCB controllers will not display function curves.

5 Click OK.

The Key window displays the curves for the collapsed animation. The track bar displays the keys, as does the Track View – Dope Sheet.

TIP If you want to collapse the controller into a weighted list controller, turn on Add To New Layer. The original controller will be stored on a layer with a weight of 0.0. It will have no effect, but will be available for future use, if need be.

Interface

<table>
<thead>
<tr>
<th>Start Frame</th>
<th>Sets the first frame of the range of animation to be collapsed. Default=The first frame of the original controller’s active range.</th>
</tr>
</thead>
<tbody>
<tr>
<td>End Frame</td>
<td>Sets the last frame of the range of animation to be collapsed. Default=The last frame of the original controller’s active range.</td>
</tr>
<tr>
<td>Samples</td>
<td>Sets the granularity of the collapse operation. This value defines the number of frames between keys. Default=1.0.</td>
</tr>
</tbody>
</table>

WARNING If you choose a range of frames smaller than the original range, the animation within the range will be collapsed, and the remaining motion will be discarded unless Add to New Layer is on.
Collapse to  Sets the type of controller the procedural track will become:

- **Bezier or Euler Controller**  When this is chosen, Position, Scale, and scalar parameter tracks will be assigned Bezier controllers. Rotation tracks will be assigned Euler controllers.

- **Linear or TCB Controller**  When this is chosen, Position, Scale, and scalar parameter tracks will be assigned Linear controllers. Rotation tracks will be assigned TCB controllers.

**NOTE**  TCB controllers will not display function curves.

Add to New Layer  When this is turned on, the collapsed controller is added as a new layer in a weighted list controller on page 3497. Default=off.

This option is useful because it keeps the old controller on another layer with a weight of 0.0. This lets you restore the original animation easily if you need to.

**Tracks Menu**

Track View on page 3790 > Tracks menu

There are two types of special tracks that can be accessed from the Tracks menu: Note tracks and Visibility tracks.

**Note Track**  Lets you add or remove note tracks to your scene. Note tracks can be used for variety of purposes to add information to any track in Track View. See Add Note Track on page 3903.

**Visibility Track**  Lets you add or remove visibility tracks to objects your scene. You can also keyframe visibility by changing the visibility parameter in the Object Properties dialog when Auto Key is on. See Add Visibility Track on page 3910.

**Keys Menu**

Track View on page 3790 > Keys menu

The commands on the Keys menu let you add, remove, slide, or scale keys while you work in either the Curve Editor or the Dope Sheet.

**Add Keys**  Adds keys in the Curve Editor or Dope Sheet. See Add Keys (Dope Sheet) on page 3917.
Reduce Keys Reduces the amount of keys on curves, or in edit keys mode in Dope Sheet. See Reduce Keys on page 3941.

Move Moves keys either vertically (in value) or horizontally (in time). See Move Keys (Dope Sheet) on page 3913 or Move Keys (Curve Editor) on page 3953.

Slide Moves keys, and adjacent keys slide away to make room for the move. See Slide Keys on page 3914.

Scale Values Proportionally increase or decrease the key values (in space, not time). Use in combination with the Scale Value Origin Slider. See Scale Values on page 3955.

Scale Keys - Time Proportionally increase or decrease the key values (in space, not time). Use in combination with the Scale Value Origin Slider. See Scale Keys - Time on page 3916.

Use Soft Select When turned on, affects keys adjacent to a selection set of keys according to a falloff threshold. Works on Curves and Dope Sheet edit keys mode. See Use Soft Select on page 3854.

Soft Select Settings Use Soft Select Settings to display the dialog that lets you control the falloff range of the soft selection. Select some keys, then watch the Track View Key window while you adjust the range value. See Soft Selection Settings on page 3927.

NOTE By default, the Soft Selection dialog appears as a toolbar on the bottom of the Track View dialog.

Align to Cursor Proportionally increases or decreases the key values (in space, not time). Use in combination with the Scale Value Origin Slider. See Align to Cursor on page 3909.

Snap Frames When this is on, keys always snap to frames. When off, you can move keys to sub-frame positions. See Snap Frames on page 3907.

Use Soft Select

Track View on page 3790 > Keys menu > Use Soft Select

When on, Use Soft Select affects keys adjacent to a selection set of keys according to a falloff threshold. This applies to both Curve Editor keys and Dope Sheet Edit Keys modes.

To adjust the Soft Selection range and falloff, choose Soft Select Settings on the Keys menu.
TIP Keys are “soft-selected” across time only (horizontally).

See also:
- Soft Selection Settings on page 3927

Procedures

To soft select keys in Track View:

1. In either Dope Sheet > Edit Keys mode or in the Curve Editor, select a single key in the middle of the animation curve or graph.
2. From the Keys menu, choose Use Soft Select.
3. From the Keys menu, choose Soft Select Settings
   The Soft Selection Settings dialog appears.
4. Change the Range and observe the soft selection display in the key window.

Curves Menu

Track View on page 3790 > Curve Editor on page 3951 > Curves menu

The Curves menu is only available when working in Track View’s Curve Editor mode. The tools on this menu facilitate curve adjustments.

Apply – Ease Curve Applies curves to selected tracks that allow you to effect the timing of the animation. See Apply Ease Curve / Apply Multiplier Curve on page 3964.

Apply – Multiplier Curve Applies curves to selected tracks that allow you to effect the strength of the animation. See Apply Ease Curve / Apply Multiplier Curve on page 3964.

Remove Removes Ease and Multiplier Curves. See Remove Ease/Multiplier Curve on page 3965.

On/Off Turns Ease and Multiplier Curves on or off. See On/Off (Curves) on page 3966.

**Multiplier Curve Out-of-Range Types** Applies multiplier curves to Parameter Out of Range keys. See **Multiplier Curve Out-of-Range Types** on page 3968.

**Time Menu**

**Track View on page 3790 > Dope Sheet on page 3805 > Time menu**

Use tools on the Time menu to edit, adjust, or reverse time. The Time menu is available only when Track View is in Dope Sheet mode.

The commands on the Time menu are available only when Edit Keys is on. If you are using Edit Ranges, these commands will not be accessible. If you are using Edit Keys, then once you select a time range, the remainder of the time menu commands will become available for use.

**Select** Select a time range.

**Insert** Add blank periods of time into a selected range.

**Cut** Remove a time selection.

**Copy** Copy a time selection. Includes any keys within the time selection.

**Paste** Duplicates a copied or cut selection.

**Reverse** Rearranges the order of keys within a time range, flips time from back to start.

**Options Menu**

**Track View on page 3790 > Options menu**

The Options menu contains a series of toggles and switches that control how items are handled in the Controller window.

**Interactive Update**

**Track View on page 3790 > Options menu > Interactive Update**

Interactive Update controls whether editing keys in Track View updates the Viewports in real time. Also, turning off Interactive Update allows faster animation playback in some cases.
Interactive Update When on, editing keys in Track View updates the viewports with any changes that affect the current frame while your mouse button is down. When off, the viewports are updated only after you release the mouse button. Default=Off.

For example, if you're at frame 10 and there are position keys at frame 0, 20, 30, and 50, then editing either a key at frame 0 or 20 with Interactive Update on potentially lets you see the changes in the viewport as you drag the key. However, editing a key at frame 50 is unlikely to cause a position change at the current frame, so you won't see any difference with Interactive Update on or off.

To view the results of editing keys anywhere in Track View in real time, use Sync Cursor Time on page 3857 instead. Turning on Sync Cursor Time automatically turns on Interactive Update as well, so you can see all changes interactively.

Keep this turned off when you are working in big files and moving large numbers of keys. Default=Off.

In some circumstances, simply playing back an animation or dragging the time slider with Track View open, without editing keys, can cause performance issues. If you experience this, and Interactive Update is on, turn it off to improve playback performance.

Sync Cursor Time

Track View on page 3790 > Options menu > Sync Cursor Time

Snaps the time slider to the cursor position.

Sync Cursor Time Snaps the time slider to the cursor position. When on, clicking the cursor in the Track View window moves the time slider to that spot in time. When you release the mouse button, the time slider jumps back to its previous position.

When off, the time slider does not jump to the cursor position; you need to click the time slider and move it by hand. Default=Off.

Turning on Sync Cursor Time also turns on Interactive Update on page 3856 so you can edit keys anywhere in Track View by dragging them and see your results right away. The time slider jumps to the frame at which the key resides and the viewport displays your changes in real time.
**Auto Expand**

**Track View** on page 3790 > Options menu > Auto Expand submenu

Auto Expand determines the behavior of the controller window display based on choices made from a submenu. To turn Auto Expand off with a single click, choose Manual Navigation from the Options menu: The Auto Expand settings are then disregarded.

When you are working on a specific animation task, turn off the unnecessary options to focus the controller window on what you need to see.

**NOTE** The default auto-navigation setting for the Dope Sheet editor auto-expands only to the node track for the currently selected object. This reduces the number of tracks whose keys need to be displayed and also helps enforce the top-down workflow for which the Dope Sheet editor is designed.

**Interface**

**Selected Objects Only** When this is on, the controller window displays the tracks for highlighted objects only. Default=On.

**Transforms** Expands the Hierarchy list to display the highlighted object’s Transform track. Default=On.

**XYZ Components** Expands the highlighted object’s Transform track to display individual XYZ components contained in each Transform controller (such as Position and Scale).

**Limits** Expands the highlighted object’s Limits track to display its parameters (such as Upper Limit and Lower Smoothing). To be used in conjunction with the Limit Controller on page 3484. Default=On.

**Keyable** Expands the highlighted object’s Hierarchy list to display keyable tracks. You must also enable Transform or XYZ Components to see results. Also expands the Environment and Global Shadow Parameters Hierarchy lists.

**Animated** Expands the highlighted object’s Hierarchy list to display animated tracks.

**Base Objects** Expands the highlighted object’s base object track to display its parameters (such as Height/Width/Length).

**Modifiers** Expands the highlighted object’s modifier track to display modifiers applied to that object.
**Materials** Expands the highlighted object's material track to display materials parameters.

**Children** Expands the Hierarchy list to display all children starting from the highlighted object.

---

**Auto Select**

*Track View* on page 3790 > Options menu > Auto Select

Provides options to determine which types of tracks are selected when a Track View window is opened, or node selection changes. Options include Animated, with submenu choices of Position, Rotation and Scale.

When this is turned on, animated curves are automatically selected when opening the controller window, using the submenu choices as well.

Additional filtering of the controller window can be accomplished by using Filters, such as combining only selected tracks with only animated tracks.

---

**Auto Scroll**

*Track View* on page 3790 > Options menu > Auto Scroll submenu

Provides options to control the automatic scrolling of the controller window in Dope Sheet and Curve Editor. When these are chosen, the choice is displayed at the top of the controller window.

Options include Selected and Objects.

---

**Interface**

**Selected** When this is on, the controller window automatically scrolls to move the viewport selection to the top of the controller window.

**Objects** When this is turned on, the controller window automatically scrolls to show all the objects in the scene in the controller window.
Modify Subtree

Track View on page 3790 > Dope Sheet on page 3805 > Display toolbar > Modify Subtree button

Modify Subtree lets you move and scale on all sub-tracks for any/all tracks on a node. It has two modes: Edit Keys and Edit Ranges.

**NOTE** Modify Child Keys on page 3861 works similarly, but for child nodes of the current object. Modify Subtree lets you edit timing for a subset of tracks for an object, while Modify Child Keys lets you edit the timing of an entire linked structure, group, or character.

**Procedures**

To drag the ranges and linked descendants of an object:

1. In the Dope Sheet Editor, click Edit Ranges.
   
   Modify Subtree is on by default.

2. Drag the World range bar or the Objects range bar.
   
   With Modify Subtree on, a range bar is displayed in the Objects branch. The Objects branch is the default parent of all named objects in the scene. Dragging a parent Objects range bar with Modify Subtree on affects all tracks subordinate to the object and all tracks of its linked descendants. Dragging the World range bar with Modify Subtree on affects all tracks in the scene, including Sounds, Materials, and all tracks of all objects.

3. Turn Modify Subtree off.
   
   The World range bar and the Objects range bar are no longer available. In this mode you can affect the range of an individual object or track without affecting its descendants.
Interface

Modify Subtree (Edit Keys) Edits (cuts, pastes, or moves) keys in the parent track. Anything you do to the keys in the parental track affects the child keys as well.

NOTE Adding keys only affects the current track.

Modify Subtree (Edit Range) Affects the tracks of an object and all of its descendent objects. When you edit the range of a parent object, the child objects are also affected.

Modify Child Keys

Track View on page 3790 > Dope Sheet on page 3805 > Display toolbar > Modify Child Keys button

Track View on page 3790 > Dope Sheet on page 3805 > Options menu > Modify Child Keys

Provides the ability to turn changes on and off down the hierarchy when working in Dope Sheet mode. Changes that you have made to a parent object can be added to the children by clicking this toolbar button. Similarly, if you have made changes with Modify Subtree on, and you want to remove the changes from the children, clicking Modify Child Keys will remove those changes from the children that you previously made to the parent.

This tool is primarily designed for use in Dope Sheet Edit Ranges mode.

Modify Subtree allows you to move, scale, edit time, and so on, on all sub-tracks for any or all tracks on a node. Modify Child Keys does the same thing, but also extends to child nodes as well. Modify Subtree lets you edit timing for an object of subset of tracks on an object, while modify child keys lets you edit the timing of an entire linked structure, group, or character.
Manual Navigation

Track View on page 3790 > Options menu > Manual Navigation

Graph Editor > Track View - Curve Editor > Right-click the Controller window. > Manual Navigation.

Manual Navigation turns off the Auto Scroll features of the controller window and allows you to select which tracks will display on an individual basis.

The default behavior of the Controller window is to automatically display the selected object animated tracks, and to hide them when the object is not selected in the viewport. Turning on Manual Navigation changes this behavior so that deselecting the object will not make the curves disappear from view.

When Manual Navigation is engaged, buttons appear in the Controller window next to the tracks, that allow you to expand or collapse individual containers such as objects or materials.

**TIP** Use Alt+right-click to quickly access tools for expanding and collapsing selected tracks.

**To collapse individual components in the Controller window:**

1. On the Graph Editors menu, choose Track View - Curve Editor.
2. Right-click the controller window and turn on Manual Navigation.
3. Click any item label in the controller window.
   - An small minus sign within a circle appears to the left of the entry.
4. Click the minus sign in the circle.
   - The tracks collapse. A plus sign within a circle appears.
   - When Manual Navigation is turned off, tracks expand based on Auto-Expand choices made on the Settings > Auto Expand menu.

Display Menu

Track View on page 3790 > Curve Editor on page 3951 > Display menu

Display is only available when Track View is in Curve Editor mode. The toggles in the Display menu let you adjust and customize how the items in the Curve Editor appear.
**Selected Key Stats** Toggles display of statistics for the selected keys in the function curve window. The statistics for a key generally include frame number and value

This is useful because you see statistics for the keys you are working on only. For details, see Show Selected Key Statistics on page 3983.

**All Tangents** Toggles display of all tangent handles for all keys in the Curve Editor. When off, handles are displayed for selected keys only.

**Show Custom Icons** Changes the display of the icons in the Hierarchy list from 2D to 3D shaded.

**Keyable Icons** Toggles a key icon for each track that indicates and lets you define whether the track is keyable.

A red key icon indicates a keyable track, while a black key icon indicates the track is not keyable. To toggle between these, click the icon or use Keyable on the Controller menu. For details, see Keyable Icons on page 3864.

**Lock Toggle Icons** Toggles a lock icon for each track that indicates and lets you define whether the track is locked on page 3826. Locking a track prevents manipulation of the data (such as position animation) controlled by that track.

**NOTE** Locked tracks also show the text “(Locked)” after the track name. This text appears whenever the track is locked, and is not affected by the Lock Toggle Icons setting.

The X Position track is locked; Y and Z Position are unlocked

**Hide Non-Selected Curves** When on, if you deselect the object in the viewport, its function curve also disappears from view in the Curve Editor. Default is on.

For details, see Hide/Show Non-Selected Curves on page 3866.

**Show Non-Selected Curves** When on, the Curve editor shows data for unselected objects as well as selected ones. Default is off.

For details, see Hide/Show Non-Selected Curves on page 3866.
**Freeze Non-Selected Curves** Displays nonselected curves, but doesn't allow you to edit them. Available only when Show Non-Selected Curves is on. Default is on.
For details, see Freeze Non-Selected Curves on page 3970.

**Filters** Provides controls to filter the display in Curve Editor. A wide range of options to show, hide and display data is available.
For details, see Filtering Track View Display on page 3888.

**Show All Tangents**

*Track View* on page 3790 > *Curve Editor* on page 3951 > Curves toolbar > Show All Tangents button

*Track View* on page 3790 > *Curve Editor* on page 3951 > Display menu > All Tangents

This feature shows all tangent handles on any displayed curves.
You can make changes to multiple tangent handles simultaneously by using Show All Tangents in combination with Lock Tangents.

See also:
- Show Tangents on page 3958

**Keyable Icons**

*Track View* on page 3790 > *Curve Editor* on page 3951 > Curves toolbar > Show Keyable Icons button

*Track View* on page 3790 > *Curve Editor* on page 3951 > Display menu > Keyable Icons

Keyable icons provide a method to tag a track so that it can receive keyframes or be exempted from keyframes. An icon is displayed in the Controller window next to the name of track to indicate whether or not the track is keyable. You can toggle the state of the icon to define the keyable property.
You can also use the Track View Controller menu > Keyable command to make tracks keyable in a single operation.

You can define keyboard shortcuts for making tracks keyable. By combining the use of keyable icons with key filters, you can use Set Key animation mode to add keyframes to just the tracks you want to work with, and avoid keyframing other tracks.

![Red key icon]

Red key icon means a track is keyable.

When the keyable icons are visible, click the red icon to turn off the track.

![Black key in a circle]

Black key in a circle indicates a track is not keyable.

**WARNING** When you are working with Set Key animation and you have used key filters to select object parameters or materials, all of the parameters will be keyed unless you turn off the track’s keyable property.

**TIP** You can assign a keyboard shortcut for making tracks keyable, by choosing Keyable Property Toggle in the Track View group, on the Keyboard panel of the Customize User Interface dialog.

**Procedures**

**To make an individual track keyable:**

1. Select the object in the viewport.
2. Right-click and choose Curve Editor.
   
   The Function Curve Editor opens, with the selected object tracks visible.
3. On the Curves toolbar, click Show Keyable Icons.
4. Click the red keyable icons for the tracks for which you want to prevent animation.
   
   The tracks are changed, now marked with a black key in a circle. These tracks will not receive keyframes. Only the tracks marked with red keyable icons will.
NOTE Keyable tracks work with both Auto Key and Set Key animation modes.

To make multiple tracks keyable:

1. In Track View, with the object selected, hold down the Ctrl key and click each track to create a selection set of tracks for which you want to prevent animation. This can be for one or multiple objects.

   **TIP** You can hold down the Shift key to select a group of sequential tracks at once. Alternately you can hold down the Alt key to select all tracks at the same level as a given track at once.

   **NOTE** If you select just a parent track such as Position, Controller > Keyable will toggle all of its sub-tracks, even if they’re not selected.

2. From the Controller menu, choose Keyable. The selected tracks are now defined as keyable.

3. From the Display menu, choose Keyable Icons. The keyable icon appears next to the tracks. The icon appears red for the tracks that are keyable, and black for the ones that are not.

   **TIP** Use the same procedure to make multiple tracks not keyable. The Controller > Keyable command toggles the keyability of the tracks.

   **NOTE** If you have a mixed keyable situation it will toggle the state of the first track and then set all remaining tracks to match the value of the first track.

### Hide/Show Non-Selected Curves

*Track View* on page 3790 > *Curve Editor* on page 3951 > Display menu > Hide Non-Selected Curves or Show Non-Selected Curves

These commands either hide or show function curves that are not selected in the controller window.

When Hide Non-Selected Curves is on (the default), the curve will disappear when another track is chosen.

When Show Non-Selected Curves is on, the curve will still be visible in the Key window when another track is chosen.
If you turn on Show Non-Selected Curves, then you can also use Freeze Non-Selected Curves. This allows you to see the other curve but not edit it inadvertently.

**View Menu**

*Track View* on page 3790 > View menu

These commands replicate those found on the Navigation toolbar in Track View.

**Pan** Lets you move the window. See *Pan (Track View)* on page 3984.

**Zoom** Lets you zoom in and out. See *Zoom Track View Key Window* on page 3987.

**Zoom Region** Lets you zoom in to a rectangular area. See *Zoom Region (Track View)* on page 3988.

**Zoom Horizontal Extents** Zooms to the active time segment. See *Zoom Horizontal Extents* on page 3985.

**Zoom Horizontal Extents Keys** Zooms to show all keys. See *Zoom Horizontal Extents* on page 3985.

**Zoom Value Extents** (Curve Editor only) Zooms vertically so that you can see the full height of the curve.

**Zoom Values** (Curve Editor only) Zooms the contents of the key window vertically. Drag upward to increase magnification, or downward to decrease magnification.

**Utilities Menu**

*Track View* on page 3790 > Utilities menu

The *Utilities menu* on page 3919 gives you access to the Track View Utilities dialog. The dialog shows a list of tools you can use when working with keys. This menu is available in both Curve Editor and Dope Sheet modes.

**Randomize Keys** Changes the values of selected keys randomly based on range thresholds. Use this on either values or time. For details, see *Randomize Keys Utility* on page 3921.
Create Out of Range Keys Creates new keys for selected tracks based on Out-of-Range Parameters. Adjust the samples value to change the granularity of the key creation. For details, see Create Out of Range Keys Utility on page 3923.

Select Keys by Time Allows you to select the keys within a time range. Turn off Clear Previous Selection to create discontinuous selection sets. For details, see Select Keys By Time Utility on page 3925.
Soft Selection Settings Manager Displays a soft selection dialog at the bottom of the Track View window. For details, see Soft Selection Settings on page 3927.

Euler Filter Corrects rotation anomalies by filtering Euler rotation tracks. For details, see Euler Filter on page 3926.

Current Value Editor Provides transform type-in capability from within the Track View modes. Allows you to choose between absolute and relative value editing. The name of the controller appears above the axis choices. For details, see Current Value Editor on page 3928.
This utility starts a floating Current Value window that works for either Dope Sheet – Edit keys mode or Curve Editor. It doesn't work for Edit Ranges. Not for use with object parameters, the current value editor is intended for use primarily with Transform controllers.

**Track View Quad Menus**

*Track View* on page 3790 > Right-click the Controller window or the Key window. Right-clicking the Key window or Hierarchy list brings up a quad menu that offers instant access to tools. The menu is context-sensitive, so its contents vary, depending on what is highlighted. For example, when the Hierarchy list is active, you can assign copy and paste controllers, and open properties which you can animate. You can set the Auto Expand and Manual Navigation controls to change the behavior of the Controller window display.

The commands from the alternative quad menu (Alt+right-click) are integrated in the right-click quad menu on page 3825. The Select, Expand, and Collapse commands are therefore accessible along with the existing quad menu commands, improving workflow efficiency.
When the key window is active you can draw curves, add keys, move keys and scale values. You can also reduce keys.
In the Controller window, if you hold down Alt+right-click you can display an alternate quad menu, which is also integrated with the main quad menu. You can add additional commands to these quad menus. You can customize the Track View quad menu the same as any other quad menu.

Procedures

To customize the Track view quad menu:

1. On the Customize menu choose Customize User Interface.
2. On the Customize User Interface dialog, click the Quad tab.
3. From the Quad pull-down menu, choose Track View Quad, or Track View Key Quad.
Change the Group to Track View, and then drag items from the table of actions on the left to the window in the lower right.

**Track View Toolbars**

Track View has a number of toolbars for managing controllers and animation. The toolbars can be floated, docked, and rearranged as you like. (Most toolbar commands are also available from the Track View menu bar.)

Not all toolbars are visible by default. To see the hidden toolbars, right-click an empty area between toolbars, choose Show Toolbars, and then pick the toolbar you want to display.

**Curve Editor Toolbars**

These toolbars are visible by default when you open the Curve Editor. For the most part, they contain controls that are active only in the Curve Editor.

See also:

- Status Bar and View Controls on page 3971

**Keys Toolbar (Curve Editor)**

The Keys toolbar for the Curve Editor contains the Filter button, and buttons for transforming keys or editing them in other ways.

**Interface**
**Filter** Use this to determine what is displayed in the Controller window and the Key window. See Filtering Track View Display on page 3888.

**Move Keys** Moves keys freely both horizontally and vertically on the function curve graph. See Move Keys on page 3913.

**Move Keys—Horizontal** Moves keys only horizontally on the function curve graph. See Move Keys on page 3913.

**Move Keys—Vertical** Moves keys constrained vertically on the function curve graph. See Move Keys on page 3913.

**Slide Keys** Use Slide Keys in the Curve Editor to move a group of keys and slide adjacent keys away as you move. See Slide Keys on page 3914.

**Scale Keys** Use Scale Keys to compress or expand the amount of time between keyframes. Works both in Curve Editor and Dope Sheet modes. See Scale Keys - Time on page 3916.

**Scale Values** Proportionally increases or decreases the values of the keys, rather than moving the keys in time. See Scale Values on page 3955.

**Add Keys** Creates keys on existing curves on the function curve graph or Dope Sheet. See Add Keys (Dope Sheet) on page 3917.

**Draw Curves** Use this to draw new curves, or revise existing ones by sketching directly on the function curve graph. See Draw Curves on page 3957.
Reduce Keys Use this to reduce the amount of keys in a track. See Reduce Keys on page 3941.

Key Tangents Toolbar

Track View on page 3790 > Curve Editor on page 3951 > Key Tangents toolbar

The Key Tangents toolbar lets you assign tangency to keys. Tangency controls the smoothness and the speed of motion at the key.

Each of these buttons is also a flyout: you can apply tangents uniformly to both in and out motion (the default), or to in and out motion individually.

Select the keys you want to adjust before you use these buttons.

Interface

- **Set Tangents to Auto** Sets keys to automatic tangents.

  Use the In button to affect only the incoming tangent.

  Use the Out button to affect only the outgoing tangent.

  **NOTE** Selecting the handles of an Auto tangent changes them to custom, and makes them available for editing.

- **Set Tangents to Custom** Sets keys to custom tangents. Custom tangents have key handles that you can edit by dragging in the Curve window. Hold down the Shift key to break continuity when you edit handles.
Use the In button to affect only the incoming tangent.

Use the Out button to affect only the outgoing tangent.

**Set Tangents to Fast** Sets key tangency to fast.

Use the In button to affect only the incoming tangent.

Use the Out button to affect only the outgoing tangent.

**Set Tangents to Slow** Sets key tangency to slow.

Use the In button to affect only the incoming tangent.

Use the Out button to affect only the outgoing tangent.

**Set Tangents to Step** Sets key tangency to step. Use step to freeze motion from one key to the next.

Use the In button to affect only the incoming tangent.

Use the Out button to affect only the outgoing tangent.
Set Tangents to Linear Sets key tangency to linear.

Use the In button to affect only the incoming tangent.

Use the Out button to affect only the outgoing tangent.

Set Tangents to Smooth Sets key tangency to smooth. Use this to even up discontinuous motion.

Use the In button to affect only the incoming tangent.

Use the Out button to affect only the outgoing tangent.

Curves Toolbar

Track View on page 3790 > Curve Editor on page 3951 > Curves toolbar
The Curves toolbar contains controls for managing key selection and editing.

Interface

Lock Selection Locks the key selection. Once you have created a selection, turn this on and you can’t inadvertently select something else. See Lock Selection on page 3909.
**Snap Frames** Resticts key movement to frames. Keys that are moved will always snap to frames when this is on. When this is off, you can move a key so it falls between frames and becomes a sub-frame key. Default=on. See Snap Frames on page 3907.

**Parameter Out-of-Range Curves** Use this to repeat keyframed motion beyond the range of the keys. Includes options for Loop, Ping Pong, Cycle, or Repeat relatively, as well as constant and linear. If you use Parameter Out-of-Range types, you can later create keys using Track View > Utilities > Create Out-of-Range Keys. See Parameter Curve Out-of-Range Types on page 3961 and Create Out of Range Keys Utility on page 3923.

**Show Keyable Icons** Displays an icon that defines a track as keyable or not. Use this to set keys only on the tracks you want to keyframe. Turning off a track in Track View also restricts the movement in the viewport. Red keys indicate keyable tracks, black keys are not keyable. See Keyable Icons on page 3864.

**Show All Tangents** Hides or displays all tangent handles on the curves. Use this to hide the handles quickly when many keys are selected. See Show All Tangents on page 3864.

**Show Tangents** Hides or displays tangent handles on the curves. Use this to hide the handles on individual curves. See Show Tangents on page 3958.

**Lock Tangents** Locks the selection of multiple tangent handles, so you can then manipulate several handles at once. When Lock Tangents is off, you can only manipulate one key tangency at a time. See Lock Tangents on page 3960.

**Biped Toolbar**

Track View on page 3790 > Curve Editor on page 3951 > Biped toolbar
Tools on the Biped toolbar let you choose which animation curves to display in the Curve Editor. You can toggle between the position and rotation curves, as well as toggle the separate curves representing the X, Y, and Z axes of the current biped selection.

These controls are inactive if you haven’t selected a biped.

**Interface**

**Show Biped Position Curves** Displays the position curves for the animated biped selection. Also chooses *Pos Curve* from the Curve Type drop-down list of the Animation Workbench Toolbar on page 4827.

**Show Biped Rotation Curves** Displays the rotation curves for the animated biped selection. Also chooses *Rot Curve* from the Curve Type drop-down list of the Animation Workbench Toolbar on page 4827. Default=on.

**Show Biped X Curves** Toggles the X axis of the current animation or position curves. Also toggles the X button of the Animation Workbench Toolbar on page 4827. Default=on.

**Show Biped Y Curves** Toggles the Y axis of the current animation or position curves. Also toggles the Y button of the Animation Workbench Toolbar on page 4827. Default=on.

**Show Biped Z Curves** Toggles the Z axis of the current animation or position curves. Also toggles the Z button of the Animation Workbench Toolbar on page 4827. Default=on.

**Dope Sheet Toolbars**

Track View on page 3790 > Dope Sheet on page 3805 > toolbars

These toolbars are visible by default when you open the Dope Sheet. For the most part, they contain controls that are active only in the Dope Sheet.
See also:
- Status Bar and View Controls on page 3971

Keys Toolbar (Dope Sheet)

Track View on page 3790 > Dope Sheet on page 3805 > Keys toolbar

The Keys toolbar for the Dope Sheet contains the Filter button and other display controls, as well as buttons for transforming keys and editing them in other ways.

Interface

![Keys Toolbar](image)

**Edit Keys** Displays a Dope Sheet Editor mode that shows the keys as boxes on a graph. Use this to mode to insert, cut, and paste time. See Edit Keys on page 3906.

**Edit Ranges** Displays a Dope Sheet Editor mode that shows the keyed tracks as range bars. See Edit Ranges on page 3943.

**Filter** Use this to determine what is displayed in the Controller window and the Dope Sheet - Key window. See Filtering Track View Display on page 3888.

**Slide Keys** Use Slide Keys in the Dope Sheet to move a group of keys and slide adjacent keys away as you move. Only slides keys on the same controller track. See Slide Keys on page 3914.
Add Keys  Creates keys on existing tracks on the Dope Sheet grid. Combine this tool with Current Value editor to adjust the key values numerically. See Add Keys (Dope Sheet) on page 3917.

Scale Keys  Use Scale Keys to compress or expand the amount of time between keyframes. Works both in Curve Editor and Dope Sheet modes. Uses the time slider as an origin point to or from which to scale. See Scale Keys - Time on page 3916.

Time Toolbar

Track View on page 3790 > Dope Sheet on page 3805 > Time toolbar

Controls on the Time toolbar let you select time ranges, remove time, scale it, insert it, or reverse its flow.

Interface

Select Time  Lets you select a time range. Time selections include any keys that might be included within the time range. Use Insert Time, then Select Time to choose the time range. See Select Time on page 3930.

Delete Time  Removes selected time from the selected tracks. Cannot be applied globally to shorten the time segment. This removes keys but leaves “blank” frames behind. See Delete Time on page 3932.

Reverse Time  Reverses the keys on selected tracks within a selected time segment. See Reverse Time on page 3936.
Scale Time  Scales the keys within a selected time segment for selected tracks. See Scale Time on page 3937.

Insert Time  Allows you to insert a range of frames as a time insertion. Existing keys slide out of the way to make room for inserted time. Once you have made a time selection with Insert Time, you can then use all the other time tools. See Insert Time on page 3937.

Cut Time  Deletes time selections from the selected tracks. See Cut Time on page 3932.

Copy Time  Duplicates the selected time selection so it will be available for pasting. See Copy Time on page 3933.

Paste Time  Adds cut or copied time selections into the selected tracks. See Paste Time on page 3934.

Display Toolbar

Track View on page 3790 > Dope Sheet on page 3805 > Display toolbar

The Display toolbar contains controls for managing key selection and editing, including how to edit tracks in a hierarchy.

Interface

Lock Selection  Locks the key selection. Once you have created a selection, turn this on so that you cannot inadvertently select something else. See Lock Selection on page 3909.
**Snap Frames** Restricts key movement to frames. Keys that are moved will always snap to frames when this is on. When this is off you can move a key so it falls between frames and become a sub-frame key. Default=on. See Snap Frames on page 3907.

**Show Keyable Icons** Shows an icon that defines a track as keyable or not. Use this to set keys only on the tracks you desire to keyframe. Turning off a track in Track View will also restrict the movement in the viewport. Red keys show keyable tracks, black keys are not keyable. See Keyable Icons on page 3864.

**Modify Subtree** When this is on, allows key manipulations to parent tracks to affect the tracks down the hierarchy. On by default in Dope Sheet mode. See Modify Subtree on page 3860.

**Modify Child Keys** If you modify the parent without Modify Subtree on, click Modify Child Keys to apply the change to the child keys. Similarly, if you modify the parent with Modify Subtree on, Modify Child Keys toggles those changes off. See Modify Child Keys on page 3861.

**Name Toolbar**

Track View on page 3790 > Name toolbar

The Name toolbar lets you name the Track View.

**Interface**

![Name : Track View](image)

**Name** By entering a name in this field, you create a named Track View window that you can later recall using the Graph Editors menu > Saved Track View submenu.

This toolbar appears by default for both the Curve Editor and the Dope Sheet.
Controllers Toolbar

Track View on page 3790 > Right-click the starting area of a toolbar (containing two vertical bars). > Show Toolbars > Controllers toolbar

This toolbar contains the basic tools you need to work with controllers in Track View. This toolbar is hidden as a default. Right-click the Track View toolbar and choose Show Toolbars > Controllers: Track View to display these tools.

All of these commands are always available via the Track View Controller menu.

Interface

Filters Click to display the Filters dialog on page 3889, which you can use to control what Track View displays in the Controller and Key windows.

Copy Controller Use this to copy a controller and its animated tracks from a selected object. See Copy Controller on page 3894.

Paste Controller Pasts the copied or cut controller onto a new object or selection of object tracks. See Paste Controller on page 3895.

Assign Controller Use this to assign a new controller to an object. All objects have a default controller assigned; use this to change the default controller to a different one. Select the controller track in the Controller window, then use Assign Controller to select a new one. See Assign Controller on page 3897.
Delete Controller  Delete a controller from an object. The controller will be replaced with a default controller. See Delete Controller on page 3899.

Make Controller Unique  Changes an instanced controller to a unique controller. This lets you make changes to the controller without affecting any other object tracks. See Make Controller Unique on page 3902.

Procedures

To display the Controllers toolbar:

1  Right-click the blank area on the Track View toolbar, to the right of the Modify Child Keys button.

2  From the right-click menu, choose Show Toolbars.

3  Choose Controllers: Track View from the list.

Tools Toolbar

Track View on page 3790 > Right-click the starting area of a toolbar (containing two vertical bars). > Show Toolbars > Tools : Track View

The Tools toolbar has buttons for managing Note tracks, Visibility tracks, controller properties, starting utilities, and some buttons also available from other toolbars.

Interface

Add Note Track  Click to add a note track on page 3903.
Delete Note Track Click to remove a note track on page 3906.

Add Visibility Track Click to add a visibility track on page 3910.

Snap Frames Restricts key movement to frames. Keys that are moved will always snap to frames when this is on. When this is off, you can move a key so it falls between frames and becomes a sub-frame key. Default=on. See Snap Frames on page 3907.

Lock Selection Locks the key selection. Once you have created a selection, turn this on so that you cannot inadvertently select something else. See Lock Selection on page 3909.

Properties Click to open a dialog for editing a track or selected key. See Properties (Track View Key Window) on page 3918.

Track View Utilities Click to open a dialog that lets you choose one of the Track View utilities on page 3919.

Ranges Toolbar (Dope Sheet)

Track View on page 3790 > Dope Sheet on page 3805 > Right-click the starting area of a toolbar (containing two vertical bars). > Show Toolbars > Ranges : Dope Sheet

This toolbar, hidden by default, provides tools you use when working with ranges.
Interface

**Edit Ranges** Changes Dope Sheet to display range bars rather than tracks of keys. See Edit Ranges on page 3943.

**Position Ranges** Adjusts the relationship between a range bar and its keys. Turning this on will allow you to see the keys while moving the range bar.

**Recouple Ranges** Resizes the range bar to fit the first and last key of the selected track.

**Extras Toolbar (Dope Sheet)**

Track View on page 3790 > Dope Sheet on page 3805 > Right-click the blank area of the toolbar to the right of Modify Child Keys. > Show Toolbars > Extras : Dope Sheet

Provides extra tools for use in Dope Sheet mode.

Interface

**Exclude Left End Point** Prevents a key at the first frame of a selected block of time from being copied to the clipboard.
Exclude Right End Point Prevents a key at the last frame of a selected block of time from being copied to the clipboard.

**Filtering Track View Display**

Track View on page 3790 > Keys Toolbar > Filters button

Track View on page 3790 > Controllers Toolbar > Filters button

Track View on page 3790 > Display menu > Filters

Filters lets you determine which categories of items appear in Track View. When you click the Filters button, Track View opens the Filters dialog on page 3889.

You can also right-click the Filters button for quick selection of items.

**TIP** You can set up a default filter configuration. Open a single Track View, set the filters the way you want them to come up, and close the Track View. Save the (empty) scene as maxstart.max. This scene file is automatically loaded when you start 3ds Max.

**Procedures**

To position a selected object at the top of the Track View Hierarchy:

1. In a viewport, right-click a selected object.
2. From the right-click menu, choose Curve Editor or Dope Sheet.
   Track View opens with the selected object at the top of the Track View Hierarchy.

To display the animated transform tracks for an object in Track View:

1. Select an object, then open a Track View window.
2. Right-click Filters.
3. From the right-click menu, choose Animated Tracks Only.
4. Right-click Filters again.
5 From the right-click menu, choose Selected Objects Only.

**Interface**

See Filters Dialog on page 3889.

**Filters Dialog (Track View)**

Track View on page 3790 > Keys Toolbar > Filters button
Track View on page 3790 > Controllers Toolbar > Filters button
Track View on page 3790 > Display menu > Filters

You use the Filters dialog to choose what to display in Track View. For example, you can limit the view to animated tracks only, or tracks for selected objects. This dialog also controls function curve display and transform display for Position, Rotation, Scale, and X, Y, and Z axes individually.

**Procedures**

**To choose filter options:**

1 On the Keys Toolbar, click Filters.
2 Choose any of the filter options from the dialog.
Interface

Show group

The Show group has options to display any of the following in the Hierarchy list window:

- Hierarchy
- Objects
- Space Warp Bindings
- Transforms (Position, Rotation, Scale, X/Y/Z/W axes in any combination)
- Modified Objects
- Base Objects
- Controller Types (off by default)
- Note Tracks
- Visibility Tracks
- Sound
- Materials/Maps
- Material/Parameters
- Static Values
- Global Tracks: non-object tracks

| All | None | Invert |

**All** Sets all Show check boxes to on.

**None** Sets all Show check boxes to off.

**Invert** Reverses the state of all Show check boxes.

**Hide by Controller Type group**

Hide By Controller Type contains a window displaying a list of all controller types in 3ds Max. Choose one or more controller types to prevent them from appearing in the Hierarchy list. You can use the standard multiple-selection methods of Ctrl+click, Shift+click, or drag.

**All/None/Invert** Selects either all items in the list, none of the items in the list, or inverts the current selection.

**NOTE** When you hide a controller, its subcontrollers (if any) are hidden as well. For example, if you hide a PRS Transform controller, its Position, Rotation, and Scale controllers are also hidden.
Show Only group

Animated Tracks Displays only tracks that contain animation. Only the animated tracks are shown, each with its full hierarchy, whether or not the Hierarchy switch on page 3890 is on.

Selected Objects Displays only items for objects selected in the scene. As you select objects in the scene, the display in the Hierarchy list changes to show the current selection. The display of sound and materials branches are not affected by this filter.

Selected Tracks Displays only items that you select prior to setting this filter. All of the displayed items are left-justified in the Hierarchy list regardless of their level in the hierarchy.

Visible Objects Determines whether objects that are hidden in the viewports will appear in the Track View Hierarchy. This does not consider objects with tracks, but only objects that have been hidden. Default=on.

Keyable Tracks Displays only tracks that can receive keys. This property is toggled using the Keyable property available on the Track View Controller menu, or by clicking the keyable icon displayed using Show Keyable Icon. Default=off.

Unlocked Attributes Displays only tracks that are not locked. This property is controlled with the Lock and Unlock on page 3826 commands on the Hierarchy right-click menu. Default=off.

Active Layer For each object listed in the controller window with animation layers on page 3467 enabled, displays only the active layer, along with all nested controllers.
**TIP** Available in *Customize User Interface* on page 8249 are actions and icons for all Show Only options. Find them in the Track View group; their names all start with “Filter”.

**Hide by Category group**

Contains a list of check boxes that let you hide tracks based on categories similar to those found in the Display panel. Turning on one of these hides the entire category type and any subcomponents.

**Function Curve Display group**

Check boxes in this group, when active, specify which transforms are suppressed, for which axis, and which RGB color values are suppressed. This is only used for controllers such as the Bezier Position controller that displays all three axis with one track selected.
NOTE The “W” and “A” Filters are for use with the Point4 controller. The W is simply a fourth filter for position, and the A is for use with the floating-point RGBA controller, which is based on the Point4 controller.

Managing Controllers

In Track View, you can manage controllers from either the Curve Editor or the Dope Sheet.

Copy Controller

Track View on page 3790 > Controllers toolbar on page 3884 > Copy Controller button

Track View on page 3790 > Highlight a controller track in the Controller window. > Controller menu > Copy

Copy Controller copies the selected item to the Track View clipboard.

You can use Copy and Paste to copy object and modifier tracks, controllers, objects, and containers, depending on what you are working on.

The Controller tools are also available as buttons on the Controllers: Track View toolbar. This toolbar is hidden by default; to unhide right-click the toolbar and choose Show Toolbars > Controllers: Track View.

Not all tracks can be copied and pasted. The basic restrictions for using Copy and Paste in Track View are:

- Only a single selected item can be copied.
- A copied item can only be pasted into another item of the same type.
- A copied item can be pasted into a selection of multiple items only if all of the items are of the same type.

Procedures

To copy and paste a modifier:

1. In the Track View Hierarchy, highlight a modifier track.
2 From the Controller menu, choose Copy.
3 Click the object track for an object in the Track View Hierarchy.
4 From the Controllers menu, choose Paste.
   The Paste dialog is displayed.
5 Set the options in the Paste dialog, and click OK.
   The pasted modifier is inserted above the object track you selected. Note
   that it does not replace any of the tracks in the target object.

To copy and paste a controller:
1 In the Track View Hierarchy, highlight a controller track.
2 On the Track View Controllers menu, click Copy Controller.
3 Highlight the controller track for an object in the Track View Hierarchy.
   Make sure you choose the same type of transform that you copied.
4 From the Controllers menu, choose Paste.
   The Paste dialog is displayed.
5 Set the options in the Paste dialog, and click OK.
   The controller is pasted onto the selected object.

**Paste Controller**

*Track View* on page 3790 > *Controllers toolbar* on page 3884 > Paste Controller button

*Track View* on page 3790 > Highlight a controller track in the Controller window.
   > Controller menu > Copy

Keyboard > Ctrl+V

Paste Controller pastes the contents of the Copy Controller buffer. You can use
the Copy and Paste buttons to copy tracks, controllers, objects, and containers.

All the Controller tools can also be found on the Controllers: Track View toolbar, which is hidden by default. Right-click the toolbar, then choose Show
Toolbars > Controllers: Track View to display the icons for Assign, Copy, Paste. Delete Controller and Make Controller Unique.

**TIP** If you need a gizmo to follow a dummy object, use Copy Controller and Paste Controller to copy the animation from the dummy to the gizmo.

**Procedures**

See Copy Controller on page 3894.

**Interface**

**Paste Controller** Pastes an item from the Track View clipboard. The Paste dialog contains the following options:

- **Copy/Instance** Determines whether the cloned item is a simple copy or an instance on page 8611 of the original.

- **Replace All Instances** When you paste to any track that contains an instanced object, replaces all instances of the object with the object on the clipboard. If off, only the object in the selected track will be replaced. Any instanced objects will remain as they are.
Assign Controller

Track View on page 3790 > Controllers toolbar on page 3884 > Assign Controller button

Track View on page 3790 > Highlight a controller track in the Controller window. > Controller menu > Assign

Motion panel > Assign Controller rollout > Highlight a track in the list. > Assign Controller button

Keyboard > C

Use Assign Controller to assign animation controllers to any animatable parameter or track in Track View.

Animation controllers and constraints provide powerful tools for animating all the objects and materials in a scene. For example, rather than keyframing the position of an object in your scene, the object can follow a spline using the Path constraint, react to any animated parameter using a Reaction controller, or move to the beat of music using the Audio controller. You can combine controllers with a List Controller. You can drive a single vertex or control point on a complex object by a variety of controllers.

You can also assign controllers using the right-click menu in the Track View Controller window. Or you can assign controllers on the Motion panel, with Schematic View, and from the Animation menu.

To view lists of available controllers and constraints, see Animation Controllers on page 3424 and Animation Constraints on page 3574.

Constraints and Controllers

Technically, there is no difference between a controller and a constraint. A constraint is simply a controller that requires the use of a second object. For example, a Path constraint is a controller that requires a spline object for a path.

Special-Case Controllers

Special-case controllers are not assigned manually with the Assign Controller command. They are applied automatically during certain procedures.
Barycentric Morph Controller is applied by selecting an object and clicking Command panel > Geometry > Compound Objects > Morph.

A Master Point Controller is assigned when animating vertices, control points, or vectors in the sub-object mode of an Editable Mesh, Editable Spline, Editable Patch, NURBS surface, or FFD modifier.

Slave Controllers can be assigned manually, but is also automatically applied to selected tracks when a Block controller is created in Track View Global Tracks. A Slave controller transfers key data to a Block controller. Slave controllers are described in the Block controller topic.

Procedures

To assign an animation controller in Track View:

1. In the Track View Hierarchy, select one or more parameter items of the same type.
2. From the Controller menu, choose Assign.
3. Choose a controller type from the Assign Controller dialog.

If a parameter has already been animated, then assigning a new controller has one of the following effects:

- The existing animation values are recalculated to produce a similar animation with the new controller. For example, replacing Position XYZ with Bezier Position closely preserves the animation.
- The existing animation values are discarded. For example, replacing Smooth Rotation with Noise Rotation discards the Smooth Rotation animation values.
Interface

Assign Controller Choose a controller type from the Assign ... Controller dialog. Depending on the type of track currently highlighted, the dialog lists a subset of the different types of controllers.

Delete Controller

Track View on page 3790 > Controllers toolbar on page 3884 > Delete Controller button

Track View on page 3790 > Highlight a controller track in the Controller window. > Controller menu > Delete Controller

Some node subcontrollers can be deleted. Visibility tracks, Image Motion Blur Multiplier, Object Motion Blur, and On/Off are examples of controllers that can be deleted. Most controllers, however, are not deletable.

You can also delete a Visibility track by using Tracks > Visibility Tracks > Remove.
Procedures

To delete a deletable controller:

1. In the Controller window, select a deletable controller.
2. On the Track View Controllers menu, choose Delete Controller.
   The controller is deleted.

   NOTE  Most controllers cannot be deleted, only replaced. The Delete Controller menu item is available only if the controller track selected is an applicable type.

Ignore Animation Range

Track View on page 3790 > Select a controller track > Controller menu > Ignore Animation Range

Ignore Animation Range allows a parametric, non-keyable controller track to be active throughout the entire length of the animation, independent of the track's current animation range. Choosing this option changes the track's background color to purple.

This setting is active by default on all new controller tracks (turn off the Override Parametric Controller Range By Default option in the Animation Preferences on page 8346 to change it). However, controller tracks from older scenes are set to Respect Animation Range on page 3901 to maintain their original behavior.

Procedures

Example: To set a controller track to ignore the animation range:

1. Create a sphere.

2. On the Motion Panel > Assign Controller rollout, highlight the sphere's Position track.

3. Click the Assign Controller button, and then choose Noise Position from the Assign Controller dialog.
4 The Noise Controller dialog opens. Keep the current settings and close the dialog.

5 Select the sphere, and then right-click it. From the quad menu, choose Dope Sheet.

6 Expand the hierarchy items in the Controller window until you find the sphere's Position track.

7 Drag the track's range bar until it starts at frame 10.

8 Play the animation.
   Because Ignore Animation Range is on by default, the sphere moves randomly even before entering the track's animation range.

**Respect Animation Range**

*Track View* on page 3790 > Select a Controller track > Controller menu > Respect Animation Range

Respect Animation Range constrains a parametric, non-keyable controller track to be active only within the track's current animation range. Choosing this option changes the track's background color to gray.

**NOTE** While Ignore Animation Range on page 3900 is the default setting (turn off the Override Parametric Controller Range By Default option in the Animation Preferences on page 8346 to change it), controller tracks from older scenes are set to this setting to maintain their original behavior.

**Procedures**

**Example: To set a controller track to respect the animation range:**

1 Create a sphere.

2 On the Motion Panel > Assign Controller rollout, highlight the sphere's Position track.
Click the Assign Controller button, and then choose Noise Position from the Assign Controller dialog.

The Noise Controller dialog opens. Keep the current settings and close the dialog.

Select the sphere, and then right-click it. From the quad menu, choose Dope Sheet.

Expand the hierarchy items in the Controller window until you find the sphere's Position track.

On the Controllers menu, choose Respect Animation Range. The background color of the track changes to gray.

Drag the track's range bar so it starts at frame 10.

Play the animation.

Because Respect Animation Range is on, the sphere starts moving only when it is within the track's animation range.

**Make Controller Unique**

*Track View* on page 3790 > Select an instanced controller track. > Controller menu > Make Controller Unique button

Keyboard: U

Make Controller Unique converts an instanced clone of a controller to a copy that's unique to the current object. Objects and modifiers can also be made unique.

The result depends on whether or not the data flow branches at the selected container:

- If the data flow does not branch anywhere below the selected container, nothing happens.
If the data flow does branch at or below the selected container, the data flow above the branch is split from the current data flow as a unique object. The data flow from the selected container to the master object is copied and attached to the new unique object.

All the Controller tools can also be found on the Controllers: Track View toolbar which is hidden by default. Right-click any blank area of the Track View toolbar, then choose Show Toolbars > Controllers: Track View to display the buttons for Assign, Copy, Paste. Delete Controller and Make Controller Unique.

**Procedures**

**To convert an instanced controller to a unique one:**

1. Select an instanced controller.
2. On the Controllers menu choose Make Unique, or press `U` on the keyboard.

**TIP** If you have instanced modifiers you can make them unique by choosing the modifier in the Modifier Stack, right-clicking and choosing Make Controller Unique.

**Note Tracks**

Note tracks let you annotate keys with information such as what the key is doing or how you plan to edit it.

**Add Note Track**

*Track View* on page 3790 > Tracks menu > Note Tracks > Add

*Track View* on page 3790 > *Tools toolbar* on page 3885 > Add Note Track button

With Add Note Track, you can insert a note track below a highlighted track in the Track View Hierarchy. You can make note keys and associated notes at specific time locations to keep track of what keys do. Do this by adding keys in *Dope Sheet* > Add Keys mode, then right-click a note key to see the Notes.
dialog. The information you enter will appear in the Key window under the keys.

Any item in the Hierarchy list can have a note track added as a branch below it. You can add a note track to an item in any of the Track View modes.

![Note track for animation of door opening](image)

Once you have created a note track for an item, use Add Keys to insert note keys. Use the Notes dialog to edit the notes.

You can have toolbar access to the Note Tracks by unhiding the Tools: Track View toolbar.

**Procedures**

**To add a note track:**

1. On the Track View Dope Sheet toolbar, click Edit Keys.
2. Highlight one or more item labels in the Hierarchy list.
3. From the Tracks menu, choose Note Tracks > Add.
   A note track is inserted as a branch directly below each highlighted item.

**To add a note key to a note track:**

1. Select the Note track (in Dope Sheet Edit Keys mode).
2. Click Add Keys.
3. Click a note track in the Key Window to place a note at that particular frame.

**To edit notes:**

1. Right-click a note key to display the Notes dialog.
2 Click inside the edit box, and then start typing. The first line of your note appears as a label to the right of the note key. Type a one- or two-word description as the first line of your note. Close the dialog using the X button at the top right corner to enter the body of the note.

Interface

Add Note Track Inserts a note track directly below the highlighted items in the Hierarchy list. This is available from the Tracks menu or from the Tools: Track View toolbar.

Notes dialog

Adds or edits notes on the animation in Track View. The first line of your note appears as a label to the right of the note key. You should type a short one- or two-word description as the first line of your note. Press Enter to start the body of the note. Press Enter or click within the text field to start the body of the note. Close the Notes dialog by clicking the X button at the top-right corner of the dialog.

Note Number Indicates which note key you are working with. Click the left arrow to move back to the previous note or the right arrow to move forward to the next note.

Time Sets the time position for the note key. Change the value to move the note to a new time.
Lock Key  Locks the key to the Time field. When set, the key ignores all operations performed with Move, Slide, and Scale. The only way to change the key’s time is to use the Time field in the Notes dialog.

Remove Note Track

Track View on page 3790 > Highlight a note track. > Tracks menu > Note Tracks > Remove

Track View on page 3790 > Highlight a note track. > Tools toolbar on page 3885 > Delete Note Track button

Use Remove Note Track to delete a note track and its associated keys.

You can have toolbar access to Remove Note Track by unhiding the Tools: Track View toolbar. This toolbar is available only in the Curve Editor, however. The tooltip is labeled Delete Note Track.

Procedures

To delete a note track from items:

1. Highlight one or more note tracks in the Hierarchy list.
2. From the Tracks menu, choose Note Track > Remove.

Editing Keys

Topics in this section relate to editing animation keys in Track View.

Edit Keys

Track View on page 3790 > Dope Sheet on page 3805 > Keys Toolbar > Edit Keys button

Edit Keys displays your animation as a series of keys as boxes on a grid in the Key window. Dope Sheet Editor turns on Edit Keys by default.
Edit Keys is useful for getting a global view of your animation because it displays animation timing for all tracks. Use this mode for key and range editing when you want to view your changes in the context of the total animation.

Use Edit Keys mode to:

- Select and change one or more keys
- Drag range bars to change all animation in multiple tracks

**Procedures**

**To turn on Edit Keys mode, do one of the following:**

1. If you are in Curve Editor, choose Modes > Dope Sheet.
2. If you are in Dope Sheet > Ranges, click Edit Keys on the Keys Toolbar.

**To delete keys in Edit Keys mode:**

1. Highlight the keys in the Key window.
2. Press DELETE on the keyboard to delete the selected keys.

**Snap Frames**

- **Track View** on page 3790 > **Curve editor** on page 3951 > Curves toolbar > Snap Frames button
- **Track View** on page 3790 > **Dope Sheet** on page 3805 > Display toolbar > Snap Frames button
- **Track View** on page 3790 > **Tools toolbar** on page 3885 > Snap Frames button
- **Track View** on page 3790 > Keys menu > Snap Frames

With Snap Frames, all key and range bar positions that are changed are forced to absolute frame increments. This includes selection sets of multiple keys. When Snap Frames is on, each key in a selection set will snap to the nearest frame when the selection is moved or scaled. Default=on.
When you use the Time Display format MM:SS:Ticks, which doesn't use frames, Snap Frames snaps to time values that match frame boundaries.

In Dope Sheet > Edit Keys mode, keys are displayed as a box grid. Keys that are snapped to frames are displayed as filled boxes. Keys that have been moved with snap frames off are displayed as narrow rectangles within the grid. When using the Curve Editor, a similar display is available in the track bar.

![Subframe keys moved with snap frame off](image)

**WARNING** Don't turn off Snap Frames unless you have a reason to, such as the need for more precise animation timing. If you do turn off Snap Frames and move keys in Curve Editor you will create sub-frame keys, but they won't be noticeably different in Curve Editor. In some cases, sub-frame keys can lead to animation “popping,” or overly fast changes due to keys being too close together.

**Procedures**

**To use Snap Frames:**

Snap Frames is on by default, so the following procedure only applies if you have turned off snap frames previously.

1. On the Track View Dope Sheet toolbar, click Edit Keys.

   **NOTE** This isn't an absolute necessity, but it makes it easier to see the snapping action. You can also view the snapping in the track bar in either Dope Sheet or Curve Editor mode.

2. On the Track View toolbar, turn on Snap Frames.

3. In the Track View Key window, select one or more keys.

4. Use Move Keys or Scale Keys to move keys.
With Snap Frames on, each key in a selection set snaps to the nearest frame when the selection is moved or scaled.

**Lock Selection**

[Image: lock_icon.png]

**Track View** on page 3790 > **Curve editor** on page 3951 > Curves toolbar > Lock Selection button

**Track View** on page 3790 > **Dope Sheet** on page 3805 > Display toolbar > Lock Selection button

**Track View** on page 3790 > **Tools toolbar** on page 3885 > Lock Selection button

Keyboard > Spacebar

Lock Selection toggles selection locking on and off. When a selection is locked you can't inadvertently deselect or select anything else. When a selection is locked you don't have to click it to move the keys, you can click anywhere in the window to move or scale the keys.

**NOTE** To use the Spacebar keyboard shortcut, the Keyboard Shortcut Override Toggle on page 8420 must be on.

**Procedures**

**To use Lock Selection in Track View:**

1. In either Dope Sheet or Curve Editor Key window, highlight one or more keys.

2. On the Track View toolbar, turn on Lock Selection, and then click and drag inside the Track View Key window. All the selected keys move regardless of where inside the Track View Key window you click and drag.

**Align to Cursor**

**Track View** on page 3790 > In the Key window, select keys to align to the current frame. > Keys menu > Align to Cursor
Use Align to Cursor to move selected keys to the current time. Select the keys to align using Move, Slide, or Scale.

Align to Cursor is useful for taking a group of scattered keys and moving them to the same time location.

Align to Cursor is available in Dope Sheet and Curve Editor modes.

Align Keys to Cursor ignores the state of Snap Frames, and always uses the exact time set by the time slider.

**Procedures**

**To move all selected keys to the current frame:**

1. Open either Curve Editor or Dope Sheet - Edit Keys mode.
2. Drag the time slider to the time where you want the keys aligned.
3. Highlight one or more keys using Move Keys, Slide Keys, or Scale Keys.
4. From the Keys menu choose Align To Cursor.
   The leftmost selected key in each track is moved to the current time.
   Multiple selected keys on the same track maintain their relative distance from the leftmost key.

**Add Visibility Track**

Right-click an object in the viewport. > Choose Curve Editor or Dope Sheet. > Track View on page 3790 > Tracks menu > Visibility Track > Add

Track View on page 3790 > In the Controller window, select the object whose visibility you want to key. > Tracks menu > Visibility Track > Add

Track View on page 3790 > In the Controller window, select the object whose visibility you want to key. > Tools toolbar on page 3885 > Add Visibility Track button

Add Visibility Track controls when you can see an object. Visibility tracks can only be added to objects.
You can create a visibility track by either animating the Visibility parameter in the Object Properties dialog or by selecting an object in the Track View Hierarchy and clicking Tracks menu > Visibility Tracks > Add. In both cases a visibility track, using a Bezier float controller, is created in Track View. The visibility track displays as a child of the object in the Track View Hierarchy.

**NOTE** In the Object Properties dialog, Rendering Control must be set to By Object in order to keyframe the Visibility using the spinner.

**NOTE** Right-click over an object in the viewports and select Properties to display the Object Properties dialog.

**WARNING** An object without mapping coordinates that is invisible at frame 0 will not ask for UVW Map coordinates at render time. The warning will display at the frame that the object becomes visible. This can stop a render midway, so make sure invisible objects at the beginning of your animation have mapping coordinates if necessary.

**On and Off Visibility**

When you first assign a visibility track to an object, a Bezier float controller is automatically assigned; this allows gradual visibility. You can make an object appear or disappear suddenly by changing the interpolation of the visibility keys to Step tangency.

Variable opacity is supported in the shaded viewports. For ease of use, the object never completely disappears from the viewports.

**Visibility Inheritance**

An object can inherit the visibility of its parent (as determined by the parent’s Visibility track in the Track View). Use the Object Properties > Inherit Visibility check box to specify the visibility inheritance of an object.

**Groups and Visibility**

All members of a Group inherit the visibility of the parent when a visibility controller is assigned to the parent. Transparent materials and hidden objects have no effect on this function.

**Level of Detail Utility and Visibility**

The Level of Detail utility on page 2762 lets you construct an object that alters its geometric complexity or level of detail based on its size in the rendered view.
image. You create several versions of the same object each with different levels of detail; you group them as one, and then assign the Level of Detail utility. This automatically creates a special LOD controller as a Visibility track.

**Procedures**

**To add a visibility track to objects:**

1. In Track View Curve Editor or Dope Sheet Edit Keys mode, highlight the object you want to affect in the Hierarchy list on the controller window.
2. From the Track View > Tracks menu, choose Visibility Tracks > Add.
3. Select the keys then use Controller > Properties to adjust the key values and interpolation.
   A value of 0 creates an invisible object, a value of 1.0 creates a fully visible object. Change the interpolation to step for sudden visibility, rather than gradual fades.

A visibility track appears below the selected object(s). Add and edit keys in the visibility track to control the object’s visibility.

**To add visibility keys:**

1. Once you have a visibility track assigned to the object, highlight the track.
2. On the toolbar, click Add Keys.
3. On the Track View Key window, click in a visibility track to add a key at that time location.

**Example: To create and animate a visibility track using the Object Properties dialog:**

1. Create a box.
2. Turn on Auto Key.
3. Move the time slider to frame 10.
   This is the frame at which you'll set the box to disappear.
4. Right-click the object and choose Properties from the shortcut menu.
5 In the General tab, set Visibility to 0, and then click OK.

6 Scrub the time slider.

The box fades. This creates a visibility track in Track View and adds a key with a value of 0 to the track.

**Move Keys (Dope Sheet)**

*Track View* on page 3790 > Keys Toolbar > Move Keys button

Move Keys lets you reposition keys horizontally, within their own track(s), thus changing the times at which they take effect. If no keys are highlighted, you can move any key by dragging it. If multiple keys are highlighted, you can move them all the same distance by dragging one of them.

This button is a flyout. You can choose Move Keys Horizontal or Move Keys Vertical, but in the Dope Sheet, all three buttons have the same effect.

You can clone highlighted keys by moving them while holding down the Shift key.

**NOTE** You can use any button on the Move Keys flyout to move keys in Dope Sheet mode, but you can move keys horizontally only.

**Procedures**

To move a selection of keys:

1 On the Keys Toolbar, click Move Keys if it isn’t already highlighted. It should be on by default.

2 Highlight the keys you want to move in the Key window by dragging a selection rectangle around the keys. You can also use Ctrl+click to highlight non-contiguous keys.

3 Position the mouse cursor over one of the highlighted keys, and then drag horizontally to move the keys in time.
TIP Press Spacebar to lock the key selection. Then you don’t have to drag over the selected key, but anywhere in the viewport. This is useful when you have a complex selection set of keys.

### Slide Keys

**Track View** on page 3790 > Highlight keys in the Key window. > Keys Toolbar > Slide Keys button

Use Slide Keys to move a group of keys (the highlighted keys plus all the keys to one end of the animation).

The direction that you drag determines which group of keys moves:

- Dragging to the right moves the highlighted keys, plus all keys to the last key of the animation, forward in time.
- Dragging to the left moves the highlighted keys, plus all keys to the first key of the animation, backward in time.

Slide Keys is a way to split the animation at the highlighted keys and spread the ends apart. Slide Keys is available in Edit Keys mode.

You can clone keys and insert them elsewhere in your animation curve while offsetting existing keys by the length of time occupied by the cloned keys by dragging while holding down Shift. Based on the length of your selection, the existing keys to the right of the selection move forward in time (that is, to the right) to allow the new key insertion, whether you drag to the right or the left.

**Procedures**

To slide a selection of keys:

1. Click Slide Keys on the Track View toolbar.
2. Highlight one or more keys.
3 Drag to slide the keys to the right.
The keys following your selection move to account for the offset produced by sliding the keys.

4 Highlight another group of keys.

5 Hold Shift while dragging to slide the keys to the right.
The keys following your selection move to the right by the length of time occupied by the cloned keys.
Scale Keys - Time

Track View on page 3790 > Keys Toolbar > Scale Keys button

Track View on page 3790 > Keys menu > Scale Keys - Time

Scale Keys - Time moves all selected keys proportionally toward or away from the current frame. Use the Scale Keys button in either mode to change the location and amount of time covered by one or more selected keys.

The scale center is defined by the current time set by the time slider. You can scale keys about any moment in time by dragging the time slider before you use Scale Keys.

Procedures

To use Scale Keys:

1. Select an animated object in the viewport, then right-click and choose Curve Editor.
   The following steps work in either Curve Editor or Dope Sheet modes.

2. Drag the time slider to the time you want to use as the scale center.

3. Click Scale Keys or from the Keys menu choose Scale Keys - Time.

4. Highlight one or more keys.

5. Drag to scale the selected keys or press and hold Shift and drag to add scaled copies of the selected keys.

Drag away from or toward the current time line for the following results:

- Dragging away expands the keys from the current time. Expanding the selection increases time between the selected keys and slows that part of the animation.

- Dragging toward shrinks the keys toward the current time. Shrinking the selection reduces time between the selected keys and accelerates that part of the animation.

- Dragging through the current time reverses the keys and expands the keys away from the current time.
You can type-in the Scale Value using the first field in the Key Stats: Track View toolbar.

The scale percentage is displayed in the Show Selected Key Stats field as you drag the selection.

Add Keys (Dope Sheet)

Add Keys inserts a key on page 8616 at the point where you click a curve or a track.

Add Keys is a mode that remains active until you activate another mode. While Add Keys is on, you click in any animation track to add a key at that location in time.

Procedures

To add keys in Track View:

1. On the Track View toolbar, click Add Keys.
2. Click an animation track to add a key.
   The location where you click sets the time of the key as measured on the time ruler.
   The value of the new key is set by one of the following conditions:
   - Keys added before the first key of a track receive the same value as the former first key.
   - Keys added between two keys receive an interpolated value based on the values of the original keys.
   - Keys added after the last key in the track receive the same value as the former last key.
If you are unable to add keys to a track, check the following conditions:

- Only animated tracks can accept keys. If you want to add a key to a track, such as an object parameter, you need to animate it first.

- The animation controller must be a type that uses keys. Not all controllers use keys. Examples of controllers that do not use keys include procedural controllers such as Noise.

- The animation controller must be a type that uses keys. Not all controllers use keys. Examples of controllers that do not use keys include Expression controllers, List controllers, and Parametric controllers.

**Properties (Track View Key Window)**

Track View on page 3790 > Highlight a single track that uses Properties. > Right-click the track. > Choose Properties on the Controllers pop-up quad menu.

Track View on page 3790 > Highlight a single track that uses Properties. > Controller menu > Properties

Track View on page 3790 > Highlight a single track or select a key in the Key window. > Tools toolbar on page 3885 > Properties button.

Properties displays a dialog to change animation values. The type of dialog displayed depends on the type of animation controller the selected track is using. The Properties function is unavailable if the selected track controller does not use properties, or the track selection set is incorrect.

- A track with animation keys display a Key Info dialog on page 3418. You can change the values in the Key Info fields to change the animation value, time, and interpolation methods of one or more selected keys.

- A track with a parametric controller, such as Noise on page 3519, displays a Properties dialog. You change the values in the Properties dialog to modify the behavior of the controller over its entire range. Access the Properties dialog through the controllers quad of the right-click menu, or on the Controller menu > Properties. The same dialog is also accessible through the Motion panel.
You can also display the Key Info dialog by right-clicking a key in the Key window. Parametric controller dialogs can also be displayed by right-clicking their range bars.

The Properties button is unavailable in ambiguous cases, for example, when a key and a Parametric controller item are both selected.

Procedures

To display properties for a controller, do one of the following:

1. Highlight the track and then choose Controller menu > Properties.
2. Right-click the track, and then on the Controllers quad choose Properties.

To display the Key Info dialog for a key:

1. Right-click the key in the Curve Editor Key Window. The Key Info dialog is displayed.
2. Change key properties in the dialog.

Track View Utilities

Track View on page 3790 > Utilities menu > Track View Utilities
Track View on page 3790 > Tools toolbar > Track View Utilities button

Track View Utilities displays a dialog listing plug-in Track View utilities. A typical Track View utility displays a modeless dialog (though utilities can be modal) and provides functions that can be applied across multiple selected keys and tracks. You can launch more than one utility by choosing Track View Utilities again.

Available Utilities

- Randomize Keys on page 3921: Applies random offset values to Time or Value of selected keys or selected time.
- Create Out of Range Keys on page 3923: Creates keys in the out-of-range time of a track, when the Out of Range type is something other than Constant. Thus, it converts the specified out-of-range area to a keyed area.
that you can edit and adjust. Select one or more tracks, set the parameters of the utility, and click Apply. In Function Curve display mode, you must select the curve as well as the track.

- **Select Keys by Time** on page 3925: Selects keys within a specified start and end range of time. Lets you select a large range of time when using the mouse might be awkward—for example, if keys are not visible in the Track View Key window.

- **Euler Filter** on page 3926: Displays a dialog with controls to remove gimbal flipping from animated tracks using Euler rotation.

- **Soft Selection Settings Manager** on page 3927: Displays a dialog with controls to adjust the range and falloff of the soft selection of keys in the Dope Sheet and Curve Editor.

- **Current Value Editor** on page 3928: Provides transform type-in capability from within the Track View modes. Allows you to choose between absolute and relative value editing. The name of the controller appears above the axis choices. This utility launches a floating Current Value window that works for either Dope Sheet — Edit keys mode or Curve Editor. It doesn’t work for Edit Ranges.

**Procedures**

**To select a Track View utility:**

1. Open the Curve Editor, and then from the Utilities menu, choose Track View Utilities.

2. In the Track View Utilities dialog, choose from the available utilities, and click OK.
Interface

The dialog displays a list of the available utilities. Click to highlight the name of the utility you want to use, and then click OK; or simply double-click the name of the utility.

Randomize Keys Utility

Track View on page 3790 > Utilities menu > Track View Utilities > Track View Utilities dialog > Randomize Keys

Randomize Keys applies random offset values to the times and/or values of selected keys.

Procedures

To use Randomize Keys:

1. Highlight one or more keys, or a block of time, in one or more tracks.
   In Dope Sheet > Edit Keys mode, all selected keys are affected. In Edit Ranges mode, the keys in the selected tracks that are within the selected
range of time are affected. In Curve Editor mode, the selected keys on selected curves are affected.

2 From the Utilities menu, choose Track View Utilities, and then choose Randomize Keys. The Randomize Keys utility is displayed.

3 By default, both Randomize Time and Randomize Value are on. Turn off either if you wish.

4 Set the +/- spinners to specify the desired range of randomized offset.

5 Click Apply.

**Interface**

![Randomize Keys dialog box]

**Randomize Time** Randomly shifts values in time, based on the spinner settings. For example, if the + spinner is set to 20, and the - spinner is set to 10, the values could shift up as much as 20, and down as much as 10.

+ The amount of random shift in a positive direction.

- The amount of random shift in a negative direction.

**Randomize Value** Randomly shifts values, based on the spinner settings.

+ The amount of random shift in a positive direction.

- The amount of random shift in a negative direction.

**Randomize group box** You can apply randomization either with selected keys or with selected time. When applying to selected keys, this displays the message: "All selected keys." However, when you select a block of time in Edit.
Time mode on page 3929, this message is displayed: "Keys in selected tracks that are in the range: n to n."

Apply Applies the specified random offset values to the selection. You can click this repeatedly for more randomization.

Create Out of Range Keys Utility

Track View on page 3790 > Utilities menu > Track View Utilities > Track View Utilities dialog > Create Out of Range Keys

Create Out of Range Keys creates keys in the out-of-range time of a track when the out of range type is something other than Constant. It converts the specified out-of-range area to a keyed area that you can edit and adjust. This utility works both in Curve Editor and Dope Sheet modes.

In Curve Editor mode, you must select the curve as well as the track.

Procedures

To use Create Out of Range Keys:

1. In the Track View Controller window, select the Position track of an animated object.

2. On the Track View toolbar, click Parameter Curve Out-of-Range Types button to apply an out-of-range type curve to the selected track. Use any curve type except Constant (the default).

3. Click Utilities menu > Track View Utilities. In the dialog box that appears choose Create Out of Range Keys.

4. Set the desired parameters in the Create Out of Range Keys dialog.

5. Click Apply.

Keys are created in the out-of-range areas of the position track. The track bar expands to the boundaries of the newly created keys.
Interface

Time Range group

Sets the time after the range for generating keys. For example, if your range of keyed animation is from frame 31 to 54, the out-of-range animation might be from 0 to 30 and from 55 to 100.

**Before** Specifies the number of frames before the range for generating keys. In the previous example, if you set this option to 20, it would generate keys over frames 10 to 30. When you set this option to 0, no keys are generated before the range.

**After** Specifies the number of frames after the range for generating keys. In the first example, if you set this option to 40, it would generate keys over frames 55 to 95. When you set this option to 0, no keys are generated after the range.

**Samples** Specifies the number of keys to be generated for both the before and after time range, based on the settings in Before and After. In the example above, if Samples is set to 20, 20 new keys would be generated over frames 10 to 30, and another 20 new keys would be generated over frames 55 to 95.

**Apply** Generates the keys.

**NOTE** Keys are generated only for non-constant out-of-range types. If the area before or after the range is the default, Constant type, no keys are generated in that area.
Select Keys By Time Utility

Track View on page 3790 > Utilities menu > Track View Utilities > Track View Utilities dialog > Select Keys by Time

The Select Keys By Time utility lets you select keys within a specified start and end range of time. You can select a large range of time, which might be difficult to select using the mouse in the Track View Key window for example.

This utility works in Curve Editor and Dope Sheet Edit Keys modes.

Procedures

To use Select Keys By Time:

1. In the Controller window, highlight the tracks you want to work with.

2. On the Utilities menu choose >Track View Utilities, then choose the Select Keys By Time utility from the Track View Utilities dialog.

3. Set a range and click OK.
   - Keys within the range in the highlighted tracks are selected.
   - If you select Clear Previous Selection, all keys are cleared before the keys within the time range are selected.
   - In Dope Sheet, highlight a single track to select all keys in the descendants of the track.

Interface

![Select Keys by Time dialog]

Start Time Specifies the start range for selecting keys.

End Time Specifies the end range for selecting keys.
The Start Time and End Time spinners are activated to match the current time selection.

Clear Previous Selection  Clears all keys before keys within the specified time range are selected.

In Dope Sheet mode, highlight a single track to select all keys in the descendants of the track. Modify Subtree must be on for this to work.

Euler Filter

Track View on page 3790 > Utilities menu > Track View Utilities > Track View Utilities dialog > Euler Filter

This Track View utility corrects for gimbal flipping (anomalous rotation animation) in objects animated using Euler rotation on page 3453 by processing existing animation keys in selected animated tracks. It's particularly useful for cleaning up rotation artifacts when importing raw motion-capture data. This process does not break any keyed orientations.

By default, the utility modifies only frames with keys on all three tracks (X, Y, and Z). By turning on Add Keys If Needed, you can perform the correction on frames with X, Y, and Z keys and also add keys at frames that contain only one or two keyed axes but require correction, resulting in X, Y, and Z keys at those frames.

The default range for filtering is the current active range for the scene, which automatically appears in the utility. To isolate the operation to a specific subset of the animation, change the Start Time and End Time settings. Any changes made to the utility remain active during the current 3ds Max session.

TIP The utility works in Dope Sheet mode, but it’s much easier to see what it’s doing if you use Curve Editor mode.

Procedures

To use Euler Filter:

1  Select an object animated with Euler rotation on page 3453.

2  Right-click the object, and from the quad menu choose Curve Editor. Track View opens in Curve Editor mode, with the animated tracks highlighted.

3  Make sure the rotation tracks to be filtered are highlighted in Track View.
4 From the Utilities menu in Track View, choose Track View Utilities. This opens the Track View Utilities dialog.

5 In the list of utilities, click Euler Filter and then click OK, or just double-click Euler Filter. This opens the Filter Selected Euler Tracks dialog.

6 Change the parameters as necessary, and then click OK. The utility adjusts the rotation keys to removed gimbal flipping.

**Interface**

**Start/End Time** The range over which the filtering should occur. Default=current animation range.

**Add Keys If Needed** When on, the utility performs the correction on frames with X, Y, and Z keys and also adds keys at frames that contain only one or two keyed axes but require correction, resulting in X, Y, and Z keys at those frames.

**OK** Performs the filtering using the current settings.

**Cancel** Closes the dialog without performing the filtering.

**Soft Selection Settings**

*Track View* on page 3790 > Utilities menu > Track View Utilities > Track View Utilities dialog > Choose Soft Selection Settings Manager, then click OK.

*Track View* on page 3790 > Tools toolbar on page 3885> Track View Utilities button > Track View Utilities dialog > Choose Soft Selection Settings Manager, then click OK.

Displays a toolbar with controls to adjust the range and falloff of the soft selection of keys in the Dope Sheet and Curve Editor.
NOTE When the Soft Selection Settings toolbar first appears, it is docked at the bottom of the Track View window beneath the status bar controls on page 3971.

**Interface**

![Soft Selection Settings](image)

- **Soft** Toggles usage of the soft selection. When this is off, only the selected keys are used, the soft selection is not.
- **Range** Determines the range of keys affected by the soft selection.
- **Falloff** Determines the distribution of the strength of the soft selection over the range of keys.

**Current Value Editor**

*Track View* on page 3790 > Utilities menu > Track View Utilities > Track View Utilities dialog > Current Value Editor

The Current Value Editor gives you a way to use numeric input to affect the values of the keys inside the Track View windows.

Absolute and relative value editing let you increment changes, or apply exact values. The name of the controller whose values are being changed appears above the axis choices.

This utility opens a dockable Current Value window that works for either Dope Sheet - Edit keys mode or Curve Editor. It doesn’t work for Edit Ranges.

**Procedures**

To use the Current Value Editor to apply an incremental change:

1. Select the position track of an animated object.
2. Choose Utilities > Track View Utilities > Current Value Editor.
3. Turn on Relative.
4. Change the values for X, Y, or Z.
The numbers you enter add a relative increment to the existing values.

**Interface**

![Current Value Interface](image)

**Absolute** Applies world space values to the keys. The numbers you enter are the numbers that are applied.

**Relative** Increments the values relative to their existing value. The numbers you enter are added to the existing value.

**Controller type** Displays the name of the controller about the X, Y, and Z fields.

**X, Y, Z** Use these fields to input numbers for relative or absolute value editing.

**Edit Time**

Use the Edit Time tools to work directly with selected blocks of time in the Dope Sheet Editor, as opposed to working with keys and range bars. A block of time is any contiguous time segment, across one or more tracks, and is independent of key locations.

Enter Edit Time mode by selecting a time segment in the Dope Sheet Editor. Once a time segment has been selected you can insert, cut, copy, paste, or reverse the time segment, including its keys. The time tools are available from the Time menu and the Time Toolbar. Time tools are unavailable from the Time menu in Edit Ranges mode.
In Edit Time mode, keys and range bars of your animation are there only for reference. You select blocks of time and then apply time-editing functions to your selection.

**Procedures**

**To edit time:**

1. Select the animated object in the viewport, then right-click and choose Curve Editor.
   This opens Track View navigated to the animated object.

2. On the Modes menu choose Dope Sheet mode.
   The Key window changes from curves to a key spreadsheet.

3. If Edit Keys isn't highlighted on the Keys Toolbar, click it to turn it on.
   The next steps won't work if you have Edit Ranges on instead of Edit Keys.

4. From the Time menu, choose Select Time.

5. Expand and activate the tracks you wish to alter. For example you could select the Z Position transform track of a bouncing Box object.

6. Drag a time segment out in the Key window. A tooltip displays the selected Start and End frame numbers interactively as you drag.
   This selects the time segment including any keys within it.

7. Perform any of the time tool operations available from the Time Menu or the Time Toolbar.

**Select Time**

Track View on page 3790 > Dope Sheet on page 3805 > Time toolbar > Select Time button

Track View on page 3790 > Dope Sheet on page 3805 > Time menu > Select Time

With Select Time you can specify a block of time by dragging in the Key window.
When you have selected a block of time, then you can apply any of the following operations to the highlighted block (and any keys contained therein):

- **Delete Time** on page 3932
- **Cut Time** on page 3932
- **Copy Time** on page 3933
- **Paste Time** on page 3934
- **Reverse Time** on page 3936
- **Insert Time** on page 3937
- **Scale Time** on page 3937
- **Exclude Left End Point** on page 3938
- **Exclude Right End Point** on page 3940
- **Reduce Keys** on page 3941

**Procedures**

**To select time:**

1. In Dope Sheet mode, highlight one or more item labels in the Controller window to specify tracks for time editing.

2. On the toolbar, click the Select Time button.

3. Drag in the key window to specify time in the selected tracks.
   - A beige bar between two yellow lines appears as you drag across the box grid of the Dope Sheet Key window.
   - If a highlighted track does not support time operations, time selection in that track is ignored.
   - After specifying a time range, you can perform other time- and key-related operations.
Delete Time

Track View on page 3790 > Dope Sheet on page 3805 > Specify a time block. > Time toolbar > Delete Time button

Use Delete Time to delete a selected block of time and any keys inside the selected block. Keys to the right of the deleted time move to the left.

**NOTE** The deleted block is not copied to the clipboard.

**Procedures**

**To delete a block of time:**

1. In Dope Sheet mode, highlight one or more item labels in the Controller window to specify tracks for time editing.

2. Use Select Time on page 3930 to specify a block of time.

3. Click Delete Time.
   
   Keys in the specified time block are deleted, and any keys to the right of the block move leftward.

Cut Time

Track View on page 3790 > Dope Sheet on page 3805 > Specify a time block. > Time toolbar > Cut Time button

Track View on page 3790 > Dope Sheet on page 3805 > Specify a time block. > Time menu > Cut

Use Cut Time to delete a block of time from one or more tracks and place it in the clipboard. Before you can paste time in a track, you must have time in the clipboard. After specifying a block of time, place it in the clipboard with Cut Time or Copy Time on page 3933.
Procedures

To cut time from tracks:

1. In Dope Sheet mode, highlight one or more item labels in the Controller window to specify tracks for time editing.

2. Use Select Time on page 3930 to specify a block of time.

3. Click Cut Time, or, from the Time menu, choose Cut Time.
   The block of time is deleted from the selected tracks and stored in the time clipboard. Keys to the right of the deleted time move left.

Copy Time

Track View on page 3790 > Dope Sheet on page 3805 > Specify a time block. > Time toolbar > Copy Time button

Track View on page 3790 > Dope Sheet on page 3805 > Specify a time block. > Time menu > Copy

Use Copy Time to copy a block of time from one or more tracks to the clipboard, after which you can paste it to other tracks.

You can use the clipboard to copy time, with keys, to different places in the same track or from one track to another. For example, you can copy position keys from one object to another.

Procedures

To copy time from tracks:

1. In Dope Sheet mode, highlight one or more item labels in the Controller window to specify tracks for time editing.

2. Use Select Time on page 3930 to specify a block of time.
Click Copy Time, or choose Time menu > Copy.
The block of time is copied to the time clipboard. The original block remains unchanged.

Paste Time

Track View on page 3790 > Dope Sheet on page 3805 > Specify a time block. > Cut or Copy Time > Specify a different time block. > Time toolbar > Paste Time button

Track View on page 3790 > Dope Sheet on page 3805 > Specify a time block. > Cut or Copy Time > Specify a different time block. > Time menu > Paste

Use Paste Time to paste a block of time from the clipboard into one or more tracks.

The conditions for pasting time into a track are:

■ If the block of time on the clipboard is from a single track, you can paste it into any track using the same type of controller.

■ If the block of time on the clipboard is from multiple tracks, you can paste it into a selection of multiple tracks as long as the controllers for the selected tracks include valid track types. For example, position tracks in the clipboard are pasted to position tracks in the selection.

If the above conditions are not met, the Paste Time function has no effect.

Time editing is available only in Dope Sheet mode; it is not available in the Function Curve Editor.

In Edit Time mode, you can copy and paste controller tracks that have no animation keys. When a track has no key, its value at frame 0 is used. You must select a block of time before cutting or pasting; otherwise the time is ignored.

Relative and Absolute Pasting

The values of all the pasted keys are adjusted so that the first pasted key has a value equal to the value at the time of the insertion point. For example, the value of the controller at frame 50 is 10. The clipboard holds three keys
spanning 50 frames with values 20, 30, and 40. When you paste the three keys at frame 50, the first key has a value of 20, but the insertion point has a value of 10. 3ds Max subtracts 10 from the pasted key to maintain the value at the insertion point. 3ds Max then subtracts 10 from the remaining pasted keys, resulting in three pasted keys valued at 10, 20, and 30. In addition, any keys after the insertion range are also adjusted by the net change over the range being pasted. The net change is the value of the last key pasted minus the value of the first key pasted. In this case 40-20=20. Every key after the insertion point is increased by 20.

**Procedures**

**To paste time into tracks:**

1. In Dope Sheet mode, after using Cut Time on page 3932 or Copy Time on page 3933, highlight one or more item labels in the Controller window to specify tracks for pasting.

2. Use Select Time on page 3930 to specify a block of time.

3. Click the Paste Time button on the Time: Track View toolbar. The Paste Track dialog opens.

4. In the Paste Track dialog, choose Paste Absolute or Paste Relative, and then click OK.

**Interface**

Options on the Paste Track dialog are as follows:
**Paste Absolute** Replaces the current animation values with the values in the clipboard. Use this method when you want to replace one animated effect with another.

**Paste Relative** Adds the animation values in the clipboard to the current animation values. Use this method when you want to layer animation onto an existing effect.

## Reverse Time

*Track View* on page 3790 > *Dope Sheet* on page 3805 > Specify a time block. > Time toolbar > Reverse Time button

*Track View* on page 3790 > *Dope Sheet* on page 3805 > Specify a time block. > Time menu > Reverse

Reverse Time flips the order of keys within the selected time. You can reverse time by scaling a selection past its left edge, but this also changes the position of the selection and the remaining keys around it. Use Reverse Time to reverse keys within a designated block of time.

### Procedures

**To reverse time:**

1. In Dope Sheet mode, highlight one or more item labels in the Controller window to specify tracks for time editing.

2. Use *Select Time* on page 3930 to specify a block of time.

3. Click the Reverse Time button, or choose Time menu > Reverse.
   The position of the selected block of time does not change, but order of keys within the block is reversed.
Insert Time

Track View on page 3790 > Dope Sheet on page 3805 > Time toolbar > Insert Time button

Use Insert Time to interpose time into highlighted tracks. Inserting time adds time at a selected point in your animation, making existing keys slide out of the way.

Procedures

To insert time into tracks

1. In Dope Sheet mode, highlight one or more item labels in the Controller window to specify tracks for time editing.

2. On the Dope Sheet toolbar, click the Insert Time button.

3. Drag in the Key window to insert time into the tracks.

TIP To insert time globally, highlight the World track, turn on the Modify Child Keys button, then insert time into the World track.

Scale Time

Track View on page 3790 > Dope Sheet on page 3805 > Time toolbar > Scale Time button

Scale Time scales a block of time. You can scale down to fit into less time, or expand it to fill more time. Scale Time doesn't use the Track View time slider as the scale origin reference; it always scales from the first frame of the key selection.
Procedures

To scale time:

1. In the Dope Sheet Editor, on the Time Toolbar, click Scale Time.

2. In the controller window, click item labels to highlight tracks for time editing.

3. Drag out a time block in the Key window, or use an existing block.

4. Move your cursor over the active time block in the Key window. The cursor changes to show you when you can scale.

5. Do one of the following:
   - Drag to the right within the selection to expand time from the left edge of the selection. All keys to the right of the selection slide right as the selection expands.
   - Drag to the left within the selection to reduce time towards the left edge of the selection. All keys to the right of the selection slide left as the selection shrinks.
   - Drag past the left edge of the selection to reverse time and expand it with a negative scale factor. Keys inside the selection, and keys to the right of the selection, can overlap keys to the left of the selection.

Exclude Left End Point

Track View on page 3790 > Dope Sheet on page 3805 > Extras toolbar > Exclude Left End Point button

Use Exclude Left End Point to exclude the beginning key in a selected block of time.

If you paste the same block of time repeatedly, one block following the other, you can create a looping segment in your animation. To create a smooth looping animation, you need to exclude either the first or last key of the copied block to prevent keys from doubling up at the ends.

The key to be excluded must be at the exact start time of the copied block of time.
NOTE By default, the Extras: Dope Sheet toolbar doesn’t appear in the Dope Sheet Editor. You’ll find a method for displaying it in the following procedure.

Procedures

To animate a loop by copying and pasting keys:

1. In Dope Sheet mode, highlight one or more item labels in the Controller window to specify tracks for time editing.

2. Use Select Time on page 3930 to specify a block of time. At least one track in the block should start with a keyframe. Also, for a smooth loop, the first and last frame of the selection should be the same.

3. Right-click an empty section of the toolbar area and choose Show Toolbars > Extras: Dope Sheet. The Exclude Left End Point and Exclude Right End Point buttons appear.

4. On the Track View toolbar, click Exclude Left End Point.

5. On the Track View toolbar, click Copy Time. The selection is copied to the clipboard, minus the first frame.

6. Click to define an insertion point in the key window. The last position key should be your insert point.

7. Click Paste Time. The Paste Time dialog appears.

8. In the dialog choose Paste Absolute or Paste Relative. For an animated loop choose Paste Absolute, then click OK. The time, including keys, is pasted.

9. Play your animation to observe the effect.
Exclude Right End Point

Track View on page 3790 > Dope Sheet on page 3805 > Extras toolbar > Exclude Right End Point button

If you paste the same block of time repeatedly, one block following the other, you can create a looping segment in your animation. To create a smooth looping animation, you need to exclude either the first or last key of the copied block to prevent keys from doubling up at the ends.

The key to be excluded must be at the exact end time of the copied block of time.

**NOTE** By default, the Extras: Dope Sheet toolbar doesn't appear in the Dope Sheet Editor. You'll find a method for displaying it in the following procedure.

**Procedures**

To animate a loop by copying and pasting keys:

1. In Dope Sheet mode, highlight one or more item labels in the Controller window to specify tracks for time editing.

2. Use Select Time on page 3930 to specify a block of time.
   At least one track in the block should end with a keyframe. Also, for a smooth loop, the first and last frame of the selection should be the same.

3. Right-click an empty section of the toolbar area and choose Show Toolbars > Extras: Dope Sheet.
   The Exclude Left End Point and Exclude Right End Point buttons appear.

4. On the Track View toolbar, click Exclude Right End Point.

5. On the Track View toolbar, click Copy Time.
   The selection is copied to the clipboard, minus the first frame.

6. Click to define an insertion point in the key window.
   The last position key should be your insert point.
7 Click Paste Time.

The Paste Time dialog appears.

8 In the dialog choose Paste Absolute or Paste Relative. For an animated loop choose Paste Absolute, then click OK.

The time, including keys, is pasted.

9 Play your animation to observe the effect.

Reduce Keys

Track View on page 3790 > Curve Editor on page 3951 > In the Key window, highlight the keys to reduce. > Keys Toolbar > Reduce Keys button

Track View on page 3790 > In the Key window, highlight the keys to reduce. > Keys menu > Reduce Keys

Use Reduce Keys to decrease key density. Animating with inverse kinematics, or creating any complex animation, can result in many keys, which can make editing the animation difficult. In the case of applied inverse kinematics, 3ds Max generates a key on nearly every frame. Often, the same animation can be produced with fewer keys. Having fewer keys in a track makes it easier to change your animation.

Reduce Keys analyzes the pattern of keys in a block of time and creates a new pattern of fewer keys that produces nearly the same animation. You specify how closely the new animation matches the original.

NOTE The Reduce Keys button, depicted above, appears on the Keys Toolbar only in Curve Editor, but you can add it to a Dope Sheet toolbar with Customize User Interface on page 8249.

Procedures

To reduce keys:

1 Select an animated object in the viewport.

2 Right-click the object and choose Curve Editor or Dope Sheet from the quad menu.
3 In the Hierarchy list, highlight the tracks whose keys you want to reduce. Reduce Keys works only on highlighted tracks.

4 Optionally, in the Key window, specify a time range within which to reduce keys. Highlight a key at either end of the range to reduce, or drag a selection rectangle around the keys you want to reduce. Alternatively, in Dope Sheet mode, highlight specific tracks and then use Select Time on page 3930 to designate a block of time within which to reduce keys. If no keys are highlighted in a highlighted track, Reduce Keys works on all keys in that track.

You can use any of the above methods to specify different ranges for different highlighted tracks.

5 From the Keys menu, choose Reduce Keys.

The Reduce Keys dialog appears. This dialog has a single Threshold parameter.

Raising the Threshold setting will increase the number of keys that are reduced. The higher the threshold, the greater the reduction.

6 Click OK to reduce the keys.

Observe the results. If you are left with too few keys, press Ctrl+Z to undo, then lower the threshold and reduce the keys again. If too many keys remain, increase the threshold and reduce keys again.

TIP It will take repeated experimentation to find exactly the right threshold for your particular animation.

Interface

Reduce Keys Displays the Reduce Keys dialog.

Threshold Sets a threshold value. Higher values will result in fewer keys.
OK Accepts the Threshold setting and reduces keys as follows:
■ Keys are reduced only in highlighted tracks.
■ If any of a track's keys are highlighted, reduction is performed only within the indicated range (that is, between the leftmost and rightmost highlighted key for each track). If no key is highlighted, reduction is performed on all keys in the track.

Edit Ranges

Track View on page 3790 > Dope Sheet on page 3805 > Keys Toolbar > Edit Ranges button

Edit Ranges displays all tracks as range bars. This mode is useful for quickly scaling and sliding complete animation tracks.
■ Drag the range bar of an animation track to change all animation in that track.
■ Drag range bars in higher-level tracks to change all animation in multiple tracks.

NOTE You cannot access individual key values in this mode.

The Ranges: Dope Sheet toolbar contains tools for working with Ranges. Right-click an empty area adjacent to the Dope Sheet toolbar and choose Show Toolbars > Ranges: Dope Sheet to display the toolbar. Save your layout after you do.

Procedures

To drag the ranges of an object and all of its linked descendants:

1 On the Track View toolbar, click Edit Ranges.

2 On the Track View toolbar, click Modify Subtree.
In the Track View Key window, drag an Object range bar or the World range bar.

With Modify Subtree on, a range bar displays in the Objects track. The Objects branch is the default parent of all objects in the scene.

Dragging a parent-object range bar with Modify Subtree on affects all tracks subordinate to the object and all tracks of all of its linked descendants.

Position Ranges

Track View on page 3790 > Dope Sheet on page 3805 > Ranges toolbar > Position Ranges button

Position Ranges mode allows you to position range bars independently from their associated keys and produce special effects.

The process of adjusting a range bar independent of its keys is called **decoupling the range**. Positioning a range bar so it matches the first to last keys of a track is called **recoupling the range**.

NOTE The Ranges: Dope Sheet toolbar doesn’t appear in Track View by default. To open it, right-click an empty area adjacent to the Dope Sheet toolbar and choose Show Toolbars > Ranges: Dope Sheet. Save your layout after you do.

Decouple a Range Bar

You decouple a range bar for two reasons:

- You want some keys at the start or end of an animation range not to take effect.
  Keys outside of the range bar are ignored during animation playback. The keys outside the range still affect interpolated values inside the range, but the applied Out-of-Range type is used to animate time outside the range bar.

- You want to add extra time before the first key or after the last key that is not affected by the applied Out-of-Range type.
  Time beyond the first or last key of the track, but still within the range, uses the constant value of the nearest key within the range.
Procedures

To decouple a range bar from its keys:

1. Right-click an empty area adjacent to the Dope Sheet toolbar and choose Show Toolbars > Ranges: Dope Sheet.

2. On the Track View toolbar, click Position Ranges.

3. In the Track View Key window, drag the entire range bar left or right of the keys, or drag either end of the range bar to make it longer or shorter than the keys.

   Using Out-of-Range types on page 3961 in conjunction with this procedure allows you to change the behavior of an animated loop. Positioning either end of a range bar changes the loop.

Recouple Ranges

Track View on page 3790 > Dope Sheet on page 3805 > Ranges toolbar > Recouple Ranges button

Recouple Ranges resizes the range bar so that the beginning and end of the range matches the first and last keys in the track. This is useful to quickly realign the range and the keys after editing.

NOTE The Ranges: Dope Sheet toolbar doesn't appear in Track View by default. To open it, right-click an empty area adjacent to the Dope Sheet toolbar and choose Show Toolbars > Ranges: Dope Sheet. Save your layout after you do.

Procedures

To recouple a range:

1. Right-click an empty area adjacent to the Dope Sheet toolbar and choose Show Toolbars > Ranges: Dope Sheet.

2. On the Track View toolbar, click Position Ranges.
3 Select one or more item labels in the Hierarchy list to select tracks to be recoupled.

4 On the Track View toolbar, click Recouple Ranges.
   
   The range bars for the selected tracks are positioned to match up with the first and last keys in their track.
   
   Position Ranges mode allows you to decouple the range bar from the animation keys. Recouple Ranges is a quick way to realign the range bars.

**Editing Tracks: Copying, Pasting, and Handling Instances and References**

These topics describe how to copy and paste within Track View.

**Copying and Pasting Items**

You can copy and paste geometry, lights, materials, and animation controllers between items in the Track View Hierarchy list of the controller window.

You can copy these categories of items in Track View:

**Containers**

Items with multiple branches that completely define something in your scene. Container items that can be copied include:

- Material Parameters containing the Basic Parameters for a material definition.
- Material Maps containing the entire set of maps and map parameters assigned to a material.
- Map definitions containing a single map type with its associated parameters and coordinates.
- Map Coordinates containing the map XYZ and UVW coordinate offset, tiling, and angle settings.
- Map Parameters containing the parameters for a specific map type.
- Objects, on levels below the transforms, containing creation parameters for an unmodified object.
■ Modified Object, containing modifiers applied to an object and the object-creation parameters.

■ Modifiers containing modifier parameters.

Controllers These control actual animated values for each parameter. Keep in mind that when you copy containers, you are actually copying and pasting groups of related controllers. Details about copying and pasting single controllers are presented in Assigning Controllers on page 3397. Whether you copy objects, materials, or controllers, the same basic principles apply. Here are restrictions for using Copy and Paste:

■ You can copy only a single highlighted item.

■ You can paste a copied item only into another item of the same type. An exception to this restriction involves pasting Object and Modified Object containers.

■ You can paste a copied item into a selection of multiple items only if all the items are of the same type.

■ When pasting items, you can choose to make an instance or a copy of the pasted item.

■ You cannot copy/paste actively linked objects.

Copying Items

You copy an item by highlighting it in the Controller window Hierarchy list, and then right-clicking and choosing Copy from the quad menu. If Copy is not available the selected item is not a valid copy source. 3ds Max disables Copy when the selected item is not a valid copy source or if multiple items are selected.

Pasting Items

Pasting items involves a few more choices than copying. You select one or more items from the Hierarchy list. If Paste is available the selected items are valid paste targets. 3ds Max disables Paste if the selected targets are not all the same type or if they do not match the type of item in the clipboard.

You can use Paste as follows:

■ Paste into a single target item.

■ Paste into multiple target items.
■ Paste copies or instances.
■ Choose to convert other instances in the scene automatically.

Clicking Paste on the quad menu displays the Paste dialog, with controls for determining how the Paste operation will be carried out.

**Copy** Pastes the item in the clipboard as an *independent copy*. The target item will have no connection to the copied source item.

**Instance** Pastes the item in the clipboard as an *instance of the copied source item*. The target item will be an instance of the source item. Any change you make to either item affects the other.

**Replace All Instances** Controls whether existing instances of the target item are also converted to the paste source or left as they are.

### Making Instances Unique

You can convert instanced items to unique items by clicking [Make Unique](#) on page 3902 on the Controller menu. If the selected item is not an instance, or if a selection of multiple items does not contain similar instances, Make Unique is disabled.

### Copying and Pasting Objects

In the Track View controller window you can use the Hierarchy list to copy and paste objects. This allows you to replace the geometry of one animated object with the geometry of another object. This is similar to the functionality provided by XRef objects and scenes where you have to option of defining *proxy* or stand-in objects.

Copying and pasting objects is achieved by highlighting the Object track for the source object, copying it, then pasting it to the Object track of the target object. The Object track is found beneath the Transforms and Modified objects entries, and appears with parentheses that define the geometry type. For example, Object (Box) or Object (Editable Mesh) are two label names that might appear on the correct track for object cut and paste.

Using these two container types, you can copy geometry between objects.
To copy one object to other objects:

1. In the Curve Editor controller window, find the object that you want to copy from.

2. Navigate to the Object track that is beneath the Transform or Modified Object entries. The name will be something like Object (PivotDoor) or Object (Editable Mesh), for example.

   **NOTE** If the object is modified, the order of the name of its Object track in the Hierarchy list is reversed; for example, Object (Sphere) becomes Sphere (Object).

3. Highlight the object track you wish to copy, then right-click and choose Copy from the quad menu.

4. Navigate to the object track for the target object, highlight it, and then right-click and choose Paste. Set options in the Paste dialog, then click OK.

   The object is replaced with the new one in the viewport as well as in the Hierarchy list of the controller window.

   **WARNING** The original target has been completely replaced by the pasted object. Use *Save Selected* on page 7444 on the target object to save a copy of that object, if you think you'll need to use it again sometime.

Here are some examples of how you might use object copy and paste:

- Paste an Object to another Object to replace one simple object with another. For example, you animate the transforms of a box object and want to replace the box with a torus.

- Paste an Object into a Modified Object to replace a complex, modified object with a simple stand-in object. For example, you model a complicated vehicle and you want to replace it with a box while you animate its transforms. Be sure to save the Modified Object to a file (using *Save Selected* on page 7444).

- Paste a Modified Object into another Modified Object to replace one complex modified object with another. For example, you animated a flight of jets and want to replace them with helicopters.

- Paste a Modified Object into an Object to replace simple stand-in objects with complex modified objects. For example, you have animated a box and now want to replace it with a complex model of a jet.
Copying and Pasting Object Modifiers

You can also copy and paste modifiers below the Modified Object container. Copy and paste modifiers to do the following:

■ Copy modifiers within the modifier stack of a single object.
■ Copy modifiers between objects.

Unlike pasting other items, modifiers do not replace the highlighted item when you click Paste. Instead, the pasted modifier is inserted above the selected item.

Making Instance and Reference Controllers and Objects Unique

You can convert instanced and referenced objects into unique objects by clicking Make Controller Unique on the Track View toolbar or by choosing Make Unique on the Controller menu. The result of clicking Make Unique depends on how the object was instanced or referenced, and which object container you select in the Hierarchy list.

When you make an instance or reference object, you cause the data flow to branch on its way from the master object to two or more named objects.

■ In Track View, these branches usually occur at Modified Object containers and sometimes at the base Object container.
■ In Track View, instances and references are displayed in bold face.
■ In the modifier stack, these branches display as a horizontal line, called a derived object line.

For descriptions of object data flow and instance objects, see Understanding Object Data Flow on page 1034.

You can make an object unique by selecting a Modified Object or an Object container and clicking Make Unique on the Track View toolbar. Your result depends on whether or not the data flow branches at the selected container.

■ If the data flow does not branch anywhere below the selected container, nothing happens.
If the data flow does branch at or below the selected container, the data flow above the branch is split from the current data flow as a unique object. The data flow from the selected container to the master object is copied and attached to the new unique object.

Making a Selection of Multiple Instances Unique

If you select multiple objects that are instances of each other, or share instanced modifiers, you can choose how to make them unique. After you click Make Unique, the Make Unique dialog appears, with the question, “Do you want to make the selected items unique with respect to each other?”

- Click Yes to make each object in the selection completely unique.
- Click No to leave the objects in the selection as instances, but to make them unique from other objects not in the selection.

Curve Editor

Main toolbar > Curve Editor (Open) button > Highlight animated tracks. > Curves are displayed in Key Window.

Graph Editors > Track View - Curve Editor > Highlight animated tracks. > Curves appear in Key window.

Right-click any animated object. > Curve Editor > Curves appear in the Key window.

The Curve Editor displays animation as function curves, charting the controllers' changes of value over time.

Highlighting a controller label displays keys for that item as vertices on the function curve. You can then highlight keys and change their values.

You can add keys to function curves for tracks that are not yet animated. The curves appear as straight lines. When you add a key to a function curve, a controller is created for that track.

Not all controller types display function curves. For example, a TCB Rotation controller doesn't display a function curve, while an Euler XYZ rotation controller shows individual curves for X, Y and Z. Some controllers display individual tracks for each axis, while other controllers combine the three axis values into a single curve.
See also:
- Slide Keys on page 3914
- Show All Tangents on page 3864

Bezier Tangent Handles

![Bezier Tangent Handles](image)

Custom tangents

You can use Bezier handles in the Curve Editor to change the shape of the trajectory through a key. To display handles on a key, right-click a key in the Track View Key Window and choose the Custom Tangents option. You can assign the Custom Tangent type only to items using a Bezier controller. This will display tangent handles on the keys that you can manipulate horizontally and vertically.

![Beziers Tangent Handles](image)

Procedures

To display function curves:

1. Select an animated object in a viewport.
2. Right-click the active viewport and choose Curve Editor.
   The function curves for the object’s animation are displayed in the Key window of the Function Curve Editor.
To display additional curves at the same time, from the Track View menu choose Settings > Manual Navigation.

Navigate the controller window until you see the additional tracks, and then hold down the Ctrl key and click them.

The curves for all highlighted tracks are displayed together in the Key window.

**Move Keys (Curve Editor)**

**Track View** on page 3790 > **Curve Editor** on page 3951 > Keys Toolbar > Move Keys flyout > Move Keys, Move Keys Horizontal, or Move Keys Vertical

With the Move Keys flyout buttons in the Curve Editor, you can move one or more highlighted keys to change keys' timing, values, or both.

You can clone keys by holding down Shift while dragging. The new keys are added to the existing keys on the curve.

You can also clone keys to replace existing keys by holding down Shift+Alt while dragging.

**TIP** When you select keys to clone and replace others, you can include the key before the first selected key to preserve the tangent of your first copied key.

**Procedures**

**To move a selection of keys:**

1. In the Hierarchy list, highlight one or more tracks.
   Only keys in highlighted tracks appear in the Key window.
   By default, the Move Keys button is yellow, showing it is already on.

2. In the Track View Key window, highlight one or more keys.

3. Drag the highlighted keys to a new location, or press Shift and drag the highlighted keys to add copies at the new location.

4. Highlight another group of keys.

5. Press Shift+Alt, and drag the highlighted keys towards existing keys to replace them with copies.
Interface

- **Move Keys** Moves keys in both horizontal and vertical axes, to change both timing and values.

- **Move Keys Horizontal** Constrains movement to the horizontal axis, to change timing.

- **Move Keys Vertical** Constrains movement to the vertical axis, to change values.

Scale Keys

Track View on page 3790 > Keys Toolbar > Scale Keys button

Track View on page 3790 > Keys menu > Scale Keys - Time

Use Scale Keys to scale keys horizontally, changing the horizontal location and amount of time covered by selected keys. The horizontal location of the keys represents the frame in time at which the key action takes place.

The scale center for scale time is the current time set by the time slider. You can scale keys about any point in time by dragging the time slider before you use Scale Keys.

Procedures

To scale a selection of keys horizontally:

1. Right-click an animated object and choose Curve Editor.
2. In the Hierarchy list, highlight a track.
3. Scrub the time slider on page 8068 to the frame to use as the scale center.
4. On the Track View toolbar, click Scale Keys.
5 Highlight one or more keys.

6 In the Track View Key window, drag any of the highlighted keys horizontally to scale, or press Shift and drag to add scaled copies of selected keys.

7 The scaling effect depends on the direction you drag with respect to the time slider location:
   ■ Drag away from the time slider location to expand keys' scaling.
   ■ Drag toward the time slider location to reduce keys' scaling.
   ■ Drag past the time slider location to reverse the keys' order and expand the keys away from the current time.

Scale Values

Scale Values is used to proportionally increase or decrease the vertical distance between selected keys on the function curves in Curve Editor. It uses the Scale Origin Line on page 3803 as a movable reference point for the scale operation. Practically speaking, scaling values always creates spatial adjustments, rather than temporal. To scale in time, use Scale Time on page 3937 instead.

NOTE Scale Values is not available in Dope Sheet mode.

Procedures

To scale key values:

1 Select an object in the viewport, then right-click and choose Curve Editor.

2 Highlight one or more tracks, if necessary, and then highlight the keys you want to scale.

3 On the Curve Editor toolbar, click Scale Values.
The orange Scale Values Origin line appears at the 0 position on the vertical scale.

4 Drag the Scale Values Origin line to where you want to scale values from or to.

**TIP** An easy way to return the scale origin line to the 0 position is to close and reopen Track View.

5 Drag any highlighted key vertically to scale all of them.

**TIP** If you use Lock Selection on page 3909 after highlighting the keys, you can drag anywhere in the Key window to create the scale operation.

---

**Add Keys (Curve Editor)**

*Track View* on page 3790 > *Curve Editor* on page 3951 > Keys toolbar > Add Keys button

*Track View* on page 3790 > *Curve Editor* on page 3951 > Keys menu > Add Keys

When Add Keys is active, you can click anywhere on a function curve to add a key at that location on the curve. Add Keys stays active until you click another mode.

If the curve is part of a multicurve controller, vertices are added to each curve at the time location where you clicked. For example, adding a key to the red X curve of a TCB Position track simultaneously adds keys to the green Y curve and the blue Z curve.

**TIP** You can move an existing key while in Add Keys mode simply by dragging it.

---

**Adding Keys to a Multicurve Controller**

The value of each key is set by one of the following conditions:

- Keys added between keys receive the interpolated value shown by the function curve at that location.
- Keys added before the first or after the last key on the curve receive the same value as the nearest key.
You can change a key value and/or time while adding it by dragging after clicking the curve.

**Procedures**

**To add keys to a function curve:**

1. In the Hierarchy list, highlight a track.

2. On the Track View toolbar, click Add Keys.

3. Click the function curve (Curve Editor) where you want to add the key. If the highlighted curve is part of a multicurve controller, vertices are added to each curve at the time location where you clicked. For example, if you are using a Bezier Position controller, adding a key to the red X curve of a Position track simultaneously adds keys to the green Y curve and the blue Z curve.

**Draw Curves**

*Track View* on page 3790 > *Curve Editor* on page 3951 > Keys Toolbar > Draw Curves button

Use this tool to draw new curves, or revise existing ones by sketching directly on the function curve in the Curve Editor Key window.
The speed with which you draw determines how many keys are added to the curve. If there are too many keys, use Reduce Keys to make fewer keys on the curve.

**Procedures**

**To draw a curve:**

1. On the Curve Editor toolbar, click Draw Curves.
2. Select the track of the curve you want to draw on.
3. Move your cursor onto the curve and draw.

   If there are too many points after drawing curves, delete or reduce on page 3941 keys.

**Show Tangents**

*Track View* on page 3790 > *Curve Editor* on page 3951 > Curves Toolbar > Show Tangents button

Show Tangents lets you view adjust the tangents of highlighted vertices in Curve Editor.

**Custom Tangent**

You can assign the Custom Tangent type to any controller that displays keys on a curve. Highlight the key on the curve and then click the Set Tangents To Custom icon on the Key Tangents: Track View toolbar to display the handle controls.

The tangent handles can be either continuous or discontinuous. To make a handle discontinuous, hold down the Shift key when you move it.

- Continuous handles behave like a single lever with its pivot point at the key location. Moving either end of the handle also moves the opposite end, maintaining the continuity of the tangent. The function curve, and the animation it represents, moves smoothly through a key with continuous tangent handles.
Discontinuous handles behave like leaves on a hinge, with the hinge pin at the key location. Each end moves independently of the other.

To convert a discontinuous tangent to a continuous tangent, change the tangent type from Custom to Smooth and then back to Custom again. This technique is performed at the key level and can affect unselected vertices if they belong to the same key as one of the selected vertices.

**Horizontal Bezier Handle Control**

When using the Custom Tangent type, a tangent handle can be moved horizontally in length away from its keyframe to affect the shape of the function curve. This affects the amount of influence the keyframe has over the interpolation between keyframes.

This feature can be used to aid in the slow-in and slow-out workflow of traditional animation. For example, suppose you're animating a ball bouncing up and down on the world's Z axis. On frame 1, the ball is on the ground; on frame 8, the ball is in the air; on frame 16 the ball is back on the ground. You could adjust the tangents for frame 8 so that their length pulls more of the curve towards its keyframe and away from the keyframes on frame 1 and 16. When rendered, the ball will be more visible on screen near the top of its bounce and blurrier near the points where it touches the ground.

**Procedures**

To assign a Custom tangent type:

1. Open the Curve Editor.
2. In the Hierarchy list, highlight a track that uses any controller that displays keys on the curve.
3. Highlight one or more keys on the curve.
4. On the Key Tangents: Track View toolbar, click Set Tangents to Custom.

The handles are now all Custom and available for editing.

**TIP** If a highlighted key has Auto Tangency set, you can just move its handle to instantly convert the key to Custom. For selections of multiple keys, choose Lock Tangents, then move any handle to convert all the keys to Custom tangency.
To edit the horizontal length of a Bezier handle:

1. Assign a Custom Tangent type to the key you want to edit on the function curve, or highlight a key that already has one.

2. Make sure Show Tangents is on. The toggle is located on the Track View toolbar.

3. Highlight the key on the function curve. Tangent handles appear on the highlighted keyframe.

4. Move one of the handles horizontally away from its key.

**Interface**

Show Tangents Displays the tangents of highlighted vertices, whereupon you can adjust the tangents by dragging the handle endpoints. By holding down the Shift key, you can edit the tangents handles separately.

**Lock Tangents**

Track View on page 3790 > Curve Editor on page 3951 > Select keys on curves. > Curves toolbar > Lock Tangents button

Lock Tangents lets you manipulate handles of multiple vertices simultaneously. When Lock Tangents is active, dragging a tangent handle affects the handles of all highlighted keys. When Lock Tangents is inactive, dragging a tangent handle affects only that handle's key.

**Procedures**

To drag discontinuous tangent handles:

1. Highlight one or more keys in the Curve Editor. Hold down the Ctrl key to add to the selection set.
Click Lock Tangents to set one of the following modes:

- **Off**: Dragging a tangent handle affects only the single key displaying the handle.
- **On**: Dragging a tangent handle affects both handles of all selected keys.

**Parameter Curve Out-of-Range Types**

Track View on page 3790 > Curve Editor on page 3951 > Curves toolbar > Parameter Curve Out-of-Range Types button

Track View on page 3790 > Curve Editor on page 3951 > Controller menu > Out-of-Range Types

With Parameter Curve Out-of-Range Types you can specify how an object is to behave outside the range of the keys you've defined.

Use Parameters Curve Out-of-Range Types to create loops and cycles. The idea is to create a short pattern of keys that produce an animated effect, and then loop or cycle through those keys throughout the animation.

Using the Parameter Curve Out-of-Range Types dialog, you select from four ways for repeating your animation and two ways for applying a linear value.

**TIP** Use the Create Out of Range Keys utility on page 3923, found in Track View Utilities, to turn the parameter out-of-range animation into editable keyframes.

**Typical Steps for Using Parameter Out-of-Range Types**

1. Animate an object to loop or cycle.
2. In the Curve Editor select the track you want to loop.
3. Click Parameter Out-of-Range Types to select how your animation behaves outside the time covered by the range bar.
Choose the type of out of range type you want in the dialog, then close it and play the animation. The Curve editor will display the loop or cycle with a dotted line.

**TIP** You can create keys from the out of range type by using the Track View Utilities > Create Out of Range Keys.

### Procedures

**To use Parameter Out-of-Range Types to create a loop:**

1. Create a Box primitive on the left side of the Front viewport.
2. Turn on Auto Key and move the time slider to frame 10.
3. Move the box to the right side of the Front viewport.
4. Open Track View, right-click Filters, and then select Animated Tracks Only.
5. Choose the Position track for the box in the Track View Hierarchy, and then click Parameter Curve Out-of-Range types.
6. In the Parameter Curve Out-of-Range Types dialog, select Ping Pong for both the in and out types and then click OK.
7. Click Play in the Viewport Controls.
   - The box moves back and forth repeatedly.
   - While the animation is playing, experiment by adjusting the keys in the Curve Editor, or in the Dope Sheet.
Interface

Select from the options for repeating your animation and options for applying a linear value.

**Constant** Holds the value of the end key of the range for all frames. Use constant when you want no animated effect before the first key of the range or after the last key. Constant is the default out-of-range type.

**Cycle** Repeats the same animation as within the range. If the first and last keys in the range have different values, the animation will show an abrupt "jump" from the last key to the first. Use Cycle when you want an animation to repeat, but do not need the ends to match.

**Loop** Repeats the same animation as within the range, but interpolates between the last key and first key in the range to create a smooth loop. If the first and last key are both at the extreme ends of the range, Loop will behave exactly like Cycle. If you use Position Ranges to extend the range bar beyond the keys, the added length determines the amount of time used to interpolate between the last key and the first key. Use loop with an extended range bar to produce smoothly repeating animation.

**Ping Pong** Alternates between a forward and backward repeat of the animation within the range. Use Ping Pong when you want your animation to alternate back and forth.
Linear Projects the animation value along a line tangent to the function curve at the end of the range. Use Linear when you want the animation to enter and leave the range at a constant velocity.

Relative Repeat Repeats the same animation as within the range but offsets each repetition by the value at the end of the range. Use Relative Repeat to create animations that build on each other as they repeat.

Apply Ease Curve / Apply Multiplier Curve

Track View on page 3790 > Curve Editor on page 3951 > Curves menu > Apply Ease Curve or Apply Multiplier Curve

Apply - Ease Curve and Apply - Multiplier Curve (available from the Curves menu in the Curve Editor) create an ease curve or multiplier curve track. These tracks let you modify or intensify an existing animation track without changing the original track.

- A multiplier curve shifts the value of the original track up or down. Adjusting the multiplier curve increases or decreases the “intensity” of the original track.

- An ease curve shifts the time of the original track left or right. Adjusting the ease curve changes time. The value of the ease curve at a particular frame is a frame value from the original track. For example, if the ease curve is 0 at frame 0 and 10 at frame 10, the original track plays at its original speed. If the ease curve value at frame 10 increases to 20, the original track plays to frame 20 by frame 10: it has been sped up by a factor of two.

Once you apply an ease or multiplier curve, you can edit its keys, ranges, and properties just like any other animation track.

One use of ease and multiplier curves is to blend between the effects of different controllers. This can be an aid to nonlinear editing.

Procedures

To apply an ease curve or a multiplier curve:

1. In the Curve Editor Hierarchy list, highlight the tracks you wish to ease or intensify.

   Not all controller items can receive ease or multiplier curves. For example, the Path Constraint position controller cannot receive an ease or
multiplier curve, but its subordinate Percent controller can. If the highlighted controller is incapable of receiving ease or multiplier curves, nothing happens when you apply the curve.

2 From the Curves menu, choose Apply - Ease Curve or Apply - Multiplier Curve.

3 In the Controller window expand the highlighted tracks to view the ease curve.

4 Hold down the Ctrl key and click the ease curve and controller tracks.

5 Adjust the keys on the ease curve and watch the result in the controller curve.
Use a Multiplier curve to intensify an effect, or an ease curve to make less of an effect.

**TIP** Use Step interpolation to use the ease curve to turn tracks on and off.

**Interface**

**Apply - Ease Curve** Applies a curve to alter the timing of the selected function curve. Ease curves vary the timing of a superior function curve. A normal function curve charts an animated parameter value over time. An ease curve charts changes to the timing of a function curve over time.

**Apply - Multiplier Curve** Applies a curve to scale the value of the selected function curve. The value of a multiplier curve is a scale factor applied to the value of its superior function curve.

You apply ease and multiplier curves in Curve Editor mode. Once you apply an ease or multiplier curve, you can edit its keys, ranges, and properties, as with any other animation track.

**Remove Ease/Multiplier Curve**

**Track View** on page 3790 > **Curve Editor** on page 3951 > Select one or more ease or multiplier curve tracks. > Curves menu > Remove

Remove (Ease/Multiplier Curve) lets you delete an ease or multiplier curve at any time.
Procedures

To delete an ease or multiplier curve:

1. In the Hierarchy list, select one or more ease or multiplier curve tracks.
2. On the Track View menu bar, choose Curves > Remove. The selected Ease or Multiplier curve is removed.

**TIP** You can use On/Off (Curves) on page 3966 to turn off the ease or multiplier affect without removing the curve.

On/Off (Curves)

*Track View on page 3790 > Curve Editor on page 3951 > Curves menu > On/Off*

Use On/Off when you want to work with the original function curve rather than a curve altered by ease and multiplier curves. A disabled curve has no effect on its assigned track, but can be enabled to restore the effect.

Procedures

To toggle the active state of an ease or multiplier curve:

1. In the Hierarchy list, highlight one or more ease or multiplier curves.
2. From the Curves menu choose On/Off. If you also have the parent track selected (the transform that has the ease applied), you will see the difference in the curve when you turn the ease or multiplier off.

Ease Curve Out-of-Range Types

*Track View on page 3790 > Curve Editor on page 3951 > Curves menu > Ease Curve Out-of-Range Types*

Ease Curve Out-of-Range Types displays a dialog that lets you assign out-of-range types for the current ease curve on page 8558.

Ease and multiplier curves use the same out-of-range types as other controller tracks. See Parameter Curve Out-of-Range Types on page 3961.
You will usually want to use the same out-of-range type for an ease curve that you use for its superior function curve.

**Procedures**

**To set the out-of-range type for an ease curve:**

1. Highlight one or more ease curve items in the Hierarchy list.
2. From the Curves menu choose Ease Curve Out-of-Range Types.
3. Do one of the following.
   - Click an out-of-range type image to apply that type to both the incoming and outgoing curves of the ease curve.
   - Click the left arrow button below an out-of-range type image to apply it to only the incoming curve of the ease curve.
   - Click the right arrow button below an out-of-range type to apply it to only the outgoing curve of the ease curve.

**Interface**

![Ease Curve Out-of-Range Types](image)

**Constant**  Holds the values at the ends of the range for all frames. Use Constant when you want no animated effect before or after the range. The time value at start of the range is held for all frames before the range, and the time value at the end of the range is held for all frames after the range. Constant is the default out-of-range type for multiplier curves.
Cycle Repeats the same animation as within the range. Use Cycle when you want an animation to repeat exactly.

Loop Repeats the same animation as within the range but interpolates between the last key and the first key of the range to create a smooth loop. Use Loop with an extended range bar to produce smoothly repeating animation.

Ping Pong Alternates between a forward and backward repeat of the animation within the range. Use Ping Pong when you want your animation to alternate back and forth.

Linear Projects the animation value along a line tangent to the ease or multiplier curve at the end of the range. Use Linear when you want the animation to enter and leave the range at a constant velocity.

Relative Repeat Repeats the same animation as within the range but offsets each repetition by the value at the end of the range. Use Relative Repeat to create animations that build on each other as they repeat.

Identity Projects the ease curve along a line with a slope of 1.0 from either end of the range. This causes time to flow at a normal, constant rate outside the range of the ease curve. Use Identity when you want the ease curve to be a localized, non-repeating effect.

Identity for an ease curve produces an effect similar to constant for other types of curves. Identity is not available for multiplier curves; it is the default Out-of-Range type for ease curves.

Multiplier Curve Out-of-Range Types

Track View on page 3790 > Curve Editor on page 3951 > Curves menu > Multiplier Curve Out-of-Range Types

Multiplier Curve Out-of-Range Types displays a dialog that lets you assign out-of-range types for the current multiplier curve on page 8651.

Ease and multiplier curves use the same out-of-range types as other function curves.

You will usually want to use the same out-of-range type for a multiplier curve that you use for its superior function curve.
Procedures

To set the out-of-range type for a multiplier curve:

1  Highlight one or more multiplier curve items in the Hierarchy list.
2  From the Curves menu choose Multiplier Curve Out-of-Range Types.
3  Do one of the following.
   ■ Click an out-of-range type image to apply that type to both the incoming and outgoing curves of the multiplier curve.
   ■ Click the left arrow button below an out-of-range type image to apply it to only the incoming curve of the multiplier curve.
   ■ Click the right arrow button below an out-of-range type to apply it to only the outgoing curve of the multiplier curve.

Interface

Constant  Holds the values at the ends of the range for all frames. Use Constant when you want no animated effect before or after the range. The time value at start of the range is held for all frames before the range, and the time value at the end of the range is held for all frames after the range. Constant is the default out-of-range type for multiplier curves.
Cycle  Repeats the same animation as within the range. Use Cycle when you want an animation to repeat exactly.

Loop  Repeats the same animation as within the range but interpolates between the last key and the first key of the range to create a smooth loop. Use Loop with an extended range bar to produce smoothly repeating animation.

Ping Pong  Alternates between forward and backward repetition of the animation within the range. Use Ping Pong when you want your animation to alternate back and forth.

Linear  Projects the animation value along lines tangent to the ease or multiplier curve at the limits of the range. Use Linear when you want the animation to enter and leave the range at a constant velocity.

Relative Repeat  Repeats the same animation as within the range but offsets each repetition by the value at the end of the range. Use Relative Repeat to create animations that build on each other as they repeat.

**Freeze Non-Selected Curves**

Track View on page 3790 > Curve Editor on page 3951 > Display menu > Show Non-Selected Curves > Freeze Non-Selected Curves

Freeze Non-Selected Curves is a selection modifier that makes all non-highlighted curves uneditable. Default=On.

Freeze Non-Selected Curves has the following properties:

- Non-highlighted curves display as dashed lines.
- You can manipulate vertices on highlighted curves only in the Edit window.
- You highlight other curves by clicking their icons in the Hierarchy list. Turn Freeze Non-Selected Curves off when you want to be able to edit multiple curves without having to select them all. Turn Freeze Non-Selected Curves On when you have multiple vertices on multiple curves all in the same place.

**Procedures**

**Example: To freeze non-selected curves:**

1. Animate an object's position.
2 From the Graph Editors menu, choose Track View - Curve Editor. On the Options menu, make sure Auto Expand > Selected Objects Only/Transforms/XYZ Components are all on.
   The X/Y/Z position tracks are all highlighted, and their curves appear in the Key window. You can drag keys on any curve.

3 On the Display menu, make sure Hide Non-Selected Curves is on. This is the default setting.

4 In the Hierarchy list, click the X Position track icon.
   Now only the red X Position curve is visible.

5 From the Display menu, choose Show Non-Selected Curves.
   The other two curves reappear, and are editable.

6 From the Display menu, choose Freeze Non-Selected Curves.
   The Y Position and Z Position curves remain visible, but display as dashed lines.

7 Position the mouse cursor over a vertex on the Y Position or Z Position curve.
   The cursor doesn't change to a crosshair, indicating that you can't modify the vertex.

8 In the Hierarchy list, click the Y Position track icon and then Z Position track icon.
   All three remain visible, but in each case the two non-highlighted tracks display as dashed lines, and are not editable.

Status Bar and View Controls

Track View on page 3790 > Status bar

These toolbars appear on the status bar, at the bottom of the Track View window. They control the Track View display, and also let you enter frame and key values.

Track Selection Toolbar

Track View on page 3790 > Status bar > Track Selection toolbar
The Track Selection toolbar has controls for particular object or track selections.

![Track Selection toolbar](image)

**Zoom Selected Object**

With Track View on page 3790 already open to navigate to a particular object, select the object in the viewport. > Track Selection toolbar > Zoom Selected Object button

Use Zoom Selected Object to place the currently selected object at the top of the Hierarchy list in the controller window.

In Dope Sheet mode, Zoom Selected Object affects the Hierarchy list as well as the Edit window, but in the Curve Editor, it affects only the Hierarchy list. This function scrolls the hierarchy to place the track of the currently selected object at the top of the list. If the object is a child of a closed hierarchy, the hierarchy is opened to display the selected object. If more than one object is selected in the scene, the uppermost selected object in the Hierarchy list is placed at the top of the list. If no objects are selected, nothing happens. This function works only on object tracks.

**Procedures**

**To place the selected object at the top of the Hierarchy list:**

1. Select an object in the viewports.

2. Open Track View, and then click Zoom Selected Object.
   The object is placed at the top of the Hierarchy list.
   This option is handy to quickly find an object in a hierarchy, such as a character’s finger, and place it at the top of the Hierarchy list.
Select By Name (Track View)

Track View on page 3790 > Track Selection toolbar > Select By Name field

With Select By Name you can highlight tracks in the Controller window by entering the track names (including optional wildcards) in the editable field. If the Controller Type display is active in the Filters options, you can specify by controller type as well.

Select By Name using wildcard

Notes

- The name selection is not case-sensitive, except for text within parentheses.
- Only those tracks that are open and displayed can be selected.
- You can use wildcard characters. For example:
  - Seat selects all objects with Seat in the beginning of the name.
  - (Cone01)Position selects only the Position track under Cone01.
  - (Cone*)Position selects the Position track under all objects that begin with "Cone"
- You can include multiple names in your selection if you separate them with commas; for example: Cone,Box,Sphere.
**Procedures**

**To highlight all the tracks in a scene:**

- Enter * in the Select by Name field in the Track Selection toolbar. All the tracks are selected at once.

**Example: To highlight and display Position tracks for three objects:**

1. Create three boxes.
   By default, the boxes are named Box01, Box02, and Box03.
2. On the main toolbar, click Curve Editor (Open).
3. In the Track View Hierarchy list, expand the hierarchies for the three box objects.
4. In the Select By Name field, type `(Box*)p`.
   All the Position tracks are highlighted.
5. On the Track View toolbar, right-click Filters and choose Selected Tracks Only in the dialog.
   The Position tracks for the three boxes are displayed at the top of the Hierarchy list.

**Example: To highlight multiple tracks using comma-separated name selections:**

1. Create a box.
2. On the main toolbar, click Curve Editor (Open).
3. In the Track View Hierarchy list, expand box01's hierarchy to see all Transform children tracks.
4. In the Select By Name field, type `x pos,y rot, scale`.
   The box's X Position, Y Rotation, and Scale tracks are highlighted. The commas placed between each name act as Boolean addition (“OR”) operators, allowing multiple names in one selection.

**Track Set Controls**

Track View on page 3790 > Track Selection toolbar
You can assign a name to the current track selection, and then later reselect those tracks by choosing the name of the respective track set from the list.

**Using Key Filters with Track Sets**

If you are animating track sets using Key Filters in Set Key mode on page 8093, the filters dictate which track set members are keyable, because they take precedence over track sets.

![Set Key Filters](image)

Only the track set members specified in the Key Filters list are keyable.

**Procedures**

To assign a name to a track set:

1. Highlight one or more tracks in the Track View Controller window.
2. Click in the Track Set List field on the Track View toolbar on page 3873.
3. Enter a name for your track set. The name can contain any standard ASCII characters, including letters, numerals, symbols, punctuation, and spaces.

   **NOTE** Names are case-sensitive.

4. Press Enter to complete the track set.
You can now highlight another combination of tracks and repeat the process to create another track set.

To retrieve a track set:

1. In the Track Sets List, click the arrow.
2. On the list, click a name.

The respective tracks are highlighted in the Track View Controller window.

To edit a track selection:

You can change a track selection using track sets and the Ctrl and Alt keys.

1. Highlight one or more tracks in the Track View Controller window.
2. Open the Track Set List by clicking the arrow.
3. Press and hold Ctrl, and then click a name in the list.
   The track set members are added to the current track selection.
4. Press and hold Alt, and then click a name (either the same or another) in the list.
   The track set members are subtracted from the current track selection.

To edit track sets:

- On the Track View toolbar, click Edit Track Set to display the Track Sets Editor dialog on page 3977.

Interface

![Edit Track Set](image)

Edit Track Set Click to display the Track Sets Editor dialog on page 3977.

Track Set List If you have created named track sets, you can activate them by choosing them from this list.
Track Sets Editor Dialog

Track View on page 3790 > Track Selection toolbar > Edit Track Set button

The Track Sets Editor dialog is a modeless dialog on page 8641 that lets you create and edit animation track groups called track sets. This feature facilitates working on multiple tracks at a time, because you can recall your tracks without the need to select them individually.

TIP As your projects grow in size, you can also use track sets to help organize your animations by regrouping them under reference dates or versions such as Walk_Animation_v5.0 or Baseball_Hit_2005/07/01.

Within the Track Sets Editor dialog, you can browse track set listings, add or remove tracks to/from a track set, highlight track set members based on selections from the Hierarchy list, and vice-versa.

See also:
- Track Set Controls on page 3974

Procedures

To create a track set from selected tracks:

1. In the Track View Controller window, highlight tracks to group as a track set.

2. Click Edit Track Set.

3. In the Track Sets Editor dialog, click Create A New Track Set.

4. Expand the new track set.
   A new track set appears containing your selected tracks.
To edit the contents of a track set:

This procedure follows from the previous procedure, and focuses on adding and removing tracks to/from your track set.

1. In the Track View Controller window, highlight a few tracks to add to your track set. Make sure the tracks are not already part of it.

2. In the Track Sets Editor dialog, highlight your track set or any of its members, and then click Add The Track View Selection To The Current Track Set. The highlighted tracks are now members of your track set.

3. Click Remove The Track View Selection From The Current Track Set. The highlighted tracks are now removed from the track set.

To locate tracks in the Track View or the Track Sets Editor:

This procedure is a continuation of the previous procedures and explains how you can use the Track Sets Editor to quickly locate your tracks in the Hierarchy list and vice-versa. This is useful for managing scenes comprised of many tracks that span across multiple track sets.

1. Create two track sets each containing tracks. Make sure one track is common to both track sets.

2. In the Track View Controller window, highlight the common track.

3. Highlight another track set member and click Select The Current Track Or Track Set In The Track View. The respective track in the Controller window is highlighted.
Interface

The Track Sets Editor dialog window displays all current track sets. To expand or collapse the track list for a set, click the plus (+) or minus (−), button next to the track set name.

**Create A New Track Set** Adds a new track set comprising any highlighted tracks in the Hierarchy list.

Only leaf on page 8599 tracks can be part of a track set. If you highlight a non-leaf parent track when the track set is created, all its children leaf tracks are added instead.

A track set created from a non-leaf parent track contains all children leaf tracks.

**NOTE** If no tracks are highlighted, an empty set is created.
Delete Track Sets Or Tracks Removes a highlighted track set or track set member.

**NOTE** Deleting a track set member does not delete it in the Track View.

Add The Track View Selection To The Current Track Set Combines a highlighted track from the Controller window to the current track set. Only leaf tracks can be added to a track set. If you highlight a non-leaf parent track to be added to the track set, all its children leaf tracks are added instead.

Remove The Track View Selection From The Current Track Set Deletes a track set member from the current track set. The track itself must be highlighted in the Controller window.

Highlight Tracks Selected In The Track View Highlights a track set member based on the current Track View selection. If a track is shared between track sets, all track set members are highlighted.

Select The Current Track Or Track Set In The Track View Highlights a track in the Controller window based on the current track set member selection.

**Track Filters**

*Track View* on page 3790 > Track Selection toolbar > Filter buttons

The filter buttons on the Track Selection toolbar help you control which tracks are displayed in the Controller (Hierarchy) window.

You can use any combination of these filters to control what you see in Track View.
Interface

Filter - Selected Tracks Toggle When on, the Controller window shows only selected tracks.

Filter - Selected Objects Toggle When on, the Controller window shows only tracks for selected objects.

Filter - Animated Tracks Toggle When on, the Controller window shows only tracks with animation.

Filter - Unlocked Attributes Toggle When on, the Controller window shows only tracks whose attributes are not locked on page 3826.

Key Stats Toolbar

Track View on page 3790 > Status bar > Key Stats: Track View toolbar

The Key Stats toolbar controls key display.

Key Stats toolbar
Key Time Display

Track View on page 3790 > Key Stats toolbar > Key Time Display (field on left)

The Key Time editable field (the field on the left) displays the frame number (position in time) of the selected key. You can enter a new frame number or enter an expression to move the key to a frame.

Key Stats toolbar

Using Expressions in the Time and Value Fields

You can enter any expression in the time and value fields. The variable $n$ stands for the key time or value. An expression can be as complex as you want, and can involve any function the expression controller on page 3456 uses. For example, you could enter an expression such as: $n/2+\sin(n)*40^n$.

The expression parsing in the time field works only when Time Configuration on page 8106 > Time Display is set to Frames. The expression parser doesn't understand SMPTE or Frame:Ticks.

Procedures

To move a key to a specific frame:

1 In Track View, highlight a key.
2 In the Key Time Display, enter the frame number you want to move the key to.
3 Press Enter.
   The key (and, in Dope Sheet mode, any associated keys) moves to the new time.

To move keys ahead 10 frames:

1 In the Track View Key window, highlight keys.
2 In the Key Time field, type $n+10$.
   Selected keys are incremented by 10 frames.
Value Display

Track View on page 3790 > Key Stats toolbar > Value Display (field on right)

Value Display (the field on the right) displays the value, or position in space, of a highlighted key. This is an editable field. You can enter a new number or expression to change the value of selected keys.

![Key Stats toolbar]

Procedures

Example: To move an object in space using Value Display:

1. In the Track View (either mode) Hierarchy list, expand the Position track of an animated object. In Curve Editor mode, if Show Non-Selected Tracks is not active, highlight a track, if necessary, so the keys are visible.

2. Highlight an X, Y, or Z Position key.
   The Value Display shows the X, Y, or Z position key spatial value.

3. Enter the value you want in the Value Display and press Enter.
   The new value takes effect. If the time slider is at or near the same frame as the key, the change is visible in the viewports.

Example: To add 10 to the values of specific keys:

1. In Track View, either mode, highlight the keys to edit.

2. In the Value Display field, enter \texttt{n+10}.
   Each key's value is incremented by 10. Simply entering 10 would give each key a value of 10.

Show Selected Key Statistics

Track View on page 3790 > Key Stats toolbar > Show Selected Key Stats button
Show Selected Key Statistics displays the statistics represented by the currently selected keys in the Key window of the Curve Editor.

The frame number and value are displayed to the right of the key in the Key window. For example, 68, 40.620 (frame=68, value=40.620).

**Procedures**

To show selected key statistics:

1. On the Key window of the Curve Editor, select any key or set of keys.
2. On the Key Stats: Track View toolbar, click Show Selected Key Stats. The key statistics are displayed next to each key.

**Navigation Toolbar**

*Track View* on page 3790 > Status bar > Navigation toolbar

The Navigation toolbar has controls for navigating the key window or curve window.

**Pan (Track View)**

*Track View* on page 3790 > Navigation toolbar > Pan button

With Pan you can click and drag the Key window to move it left, right, up or down. Pan remains active until you right-click to cancel or click another option. The Pan button is yellow while active.
If you have a middle mouse button, pressing it will instantly give you the Pan capability in Track View, as in the rest of 3ds Max.

Drag horizontally in all modes to slide the view forward and backward in time. Drag vertically to slide the view up and down in value.

**Zooming and Panning with a wheel mouse**

You can use the wheel on a wheel mouse to zoom and pan the Track View Key window. Drag with the wheel to pan, and roll the wheel to zoom. (If you have a standard three-button mouse, use Ctrl+Alt+middle mouse button to zoom.)

**Procedures**

**To pan in the Key window:**

2. Position the mouse cursor over the Key window, and then press and drag to pan.

**Zoom Horizontal Extents**

Track View on page 3790 > Navigation toolbar > Zoom Horizontal Extents flyout

Zoom Horizontal Extents is a flyout containing the Zoom Horizontal Extents and Zoom Horizontal Extents Keys buttons.

Use Zoom Horizontal Extents to show only the active time segment on page 8496, and use Zoom Horizontal Extents Keys to show all keys, including those outside the active time segment.

**Procedures**

**To display the active time segment in the Key window:**

- On the Track View status bar, select Zoom Horizontal Extents.
  The active time segment (lighter background color) is centered in the Key window.
Interface

*Zoom Horizontal Extents* Adjusts the magnification of the Track View Key window horizontally so that all of the active time segment is visible at once.

*Zoom Horizontal Extents Keys* Scales the Track View Key window horizontally to display the full range of all animation keys. Depending on your animation, this view could be larger or smaller than the active time segment.

**Zoom Value Extents**

Track View on page 3790 > Navigation toolbar > Zoom Value Extents flyout

Zoom Value Extents is a flyout containing the Zoom Value Extents and Zoom Value Extents Range buttons.

In Function Curves mode, Zoom Value Extents adjusts the size of the Track View Key window vertically so that you can see the full height of the curve. Zoom Value Extents Range also adjusts the window vertically but it zooms only to the height of the keyframes that are currently in view.

**NOTE** In Dope Sheet mode, Zoom Value Extents and Zoom Value Extents Range serve no function.

**Procedures**

To zoom to the height of the curves:

1. In the Hierarchy list, highlight the tracks to display.

2. On the Track View status bar, click Zoom Value Extents.
   The Key window scales vertically to display the function curves.
   This is particularly useful if you are zoomed in and need to see all the keys again. There is no undo for view changes that occur in the Key
window, so the Zoom Extents button can serve the function of resetting your view.

**To zoom to the height of the keyframes that are currently visible:**

1. In the Hierarchy list, highlight the tracks to display.

2. On the Track View status bar, click Zoom Value Extents Range.
   The Key window scales vertically to the height of the keyframes in view.
   This is useful if you want to focus on working with one section of your animation curve.

**Zoom Track View Key Window**

In Track View, the Zoom controls are available from a three-button flyout. You can zoom your view of time horizontally (Zoom Time), vertically (Zoom Values), or in both directions simultaneously (Zoom). Drag to the right or upward (Zoom Values) to increase magnification, or to the left or downward (Zoom Values) to decrease magnification.

Zooming occurs around the cursor location.

**NOTE** All three zoom modes work in Curve Editor, but only Zoom and Zoom Time work in Dope Sheet.

**TIP** If you use a three-button or wheel mouse, you can also zoom uniformly by using Ctrl+Alt+middle mouse button or by scrolling with your mouse wheel in the Curve Editor.

**TIP** You can also zoom exclusively in time (left and right) or in value (up and down) by holding down Ctrl or Shift respectively while scrolling with your mouse wheel in the Curve Editor.
Procedures

To zoom in on time:

1. On the Navigation: Track View toolbar, choose Zoom Time from the flyout.

2. Click and drag to the right in the Track View Key window. 
   Your view of time expands horizontally in the Key window.

Interface

Zoom
Zooms your view of time and values simultaneously. Zoom remains active until you right-click to cancel or click another option. The Zoom button is yellow while active.

Zoom Values
In Curve Editor, zooms the contents of the key window vertically. Drag upward to increase magnification, or downward to decrease magnification.

Zoom Time
Zooms the contents of the Key window horizontally.

Zoom Region (Track View)

Track View on page 3790 > Navigation toolbar > Zoom Region button
Zoom Region lets you drag a region in the Key window to scale that region to fill the window. Zoom Region remains active until you right-click to cancel or click another option. The Zoom Region button is yellow while active.

In Curve Editor mode, both time and value are scaled to fit the Key window.
In Dope Sheet mode, only time is scaled to fit the Key window.
Procedures

To zoom a region of the Key window:

1. On the Navigation: Track View toolbar, click Zoom Region.
2. Drag a window in the Key window.
   The region zooms to fill the Key window.

TIP There is no undo for view changes in the Track View windows. Use the Zoom, Zoom Region, and Zoom Extents tools to navigate the Key window.

Managing Track View Windows

Controls for managing Track View windows are on the 3ds Max Graph Editors menu. This section also contains topic on how to customize the Track View interface.

New Track View

Graph Editors menu > New Track View

New Track View opens a new, untitled Track View on page 3790 window. A scene in 3ds Max can have up to 13 Track View windows. You can choose these by name from the Graph Editors > Saved Track Views on page 3991 submenu. New Track View is disabled if the scene already has 13 Track View windows.

You can name a Track View window by typing in the editable field at the right end of the Track View toolbar.

Procedures

To create a new Track View window:

- Click Track View > New Track View.
  3ds Max opens a new, untitled Track View window, regardless of whether you have closed other Track View windows.
To name a Track View window:

- Type the name in the edit box at the right end of the Track View toolbar. As soon as you type the name in, it is stored in the Saved Track Views list.

Delete Track View

Graph Editors menu > Delete Track View

Delete Track View displays the Delete Track View dialog, which lets you delete one or more stored Track View windows on page 3790.

Procedures

To delete a Track View window:

1. From the Graph Editors menu, choose Delete Track View. The Delete Track View dialog opens.
2. In the Delete Track View dialog, highlight the name of one or more Track View windows.
3. Click OK to delete the Track View windows you chose.
Interface

Drag a selection, use Shift+click to select additional adjacent Track View windows, or Ctrl+click to toggle a selection.

Saved Track Views

Graph Editors menu > Saved Track Views > Choose the named Track View from the list.

Saved Track View lets you recall various Track View windows that you save by naming them.
It is different from saved Track View layouts, which are recalled by right-clicking the toolbar and choosing Load layout.

Saved Track View windows are saved with the MAX file.

**Procedures**

**To save a Track View window:**

1. In either Dope Sheet or Curve Editor, enter a name in the Name: Track View field at the upper right.

   **TIP** If the Name field is not visible, right-click the toolbar and choose Show Toolbars, then choose Name: Track View from the list. This toolbar can float or dock, as you like.

2. Close Track View.

3. To recall the saved Track View window, from the Graph Editors menu, choose Saved Track Views, and then the desired window name.

**Customizing the Track View Window**

The Track View user interface is fully customizable. There are many ways you can change the UI to suit your needs.

![A customized Track View user interface:](image)

- Controllers toolbar docked left
- Controller window (Hierarchy) hidden
• **Tools toolbar floating**
• **Navigation toolbar docked right**

You can hide or display UI elements as you need to use them. Customization tools are available from the Track View menu bar or from several Track View toolbars. You can float or dock the toolbars to the top, bottom, left, or right of the application window, for example, floating a toolbar so it is closer to where you are working.

To customize the Track View UI, right-click the menu bar or the blank space to the right of the Track View toolbars. A right-click menu is displayed, with commands for the tools you need to perform your customization.

**Track View Toolbar Right-Click Menu**

You can use commands on the [toolbar right-click menu](page 3999) to perform most Track View UI customization tasks. Move your cursor over the blank space to the right of the Track View toolbars and right-click to display this menu.

**Show UI Elements**

Toggles on and off the display of Track View user interface elements. For example, you can hide or show the menu bar, scroll bars, the controller and key windows, and the time ruler.

**Menu Bar**

The menu bar gives access to most of the tools also found on the toolbars. The menu bar can be displayed or hidden in the Curve Editor, Dope Sheet, or track bar. The menu bar is context-sensitive, so it changes its display depending on which Track View mode is active.

**Scroll Bar**

Standard Windows scroll bars can be displayed or hidden for the Track View window. These are useful for navigating complex or lengthy windows.

![Hand icon] Use the Pan hand button to scroll when these are not visible. The middle mouse button can also be used to activate the pan hand to scroll this window.
Windows

There are two side-by-side display areas in Track View. They are the Controller window and the Key window. The Controller window contains the Hierarchy list with labeled tracks. The Key window displays the keys either as curves in the Curve Editor, or as boxes or ranges on a grid in Dope Sheet mode. Use Show UI Elements, available from the toolbar right-click menu, to hide either window.

Time Ruler

A movable time ruler is provided. To measure time, you can move the time ruler close to the keys or curves when working zoomed in. Default=on.

Track View - Curve Editor Toolbars

You can display Curve Editor toolbars on page 3873 for quick access to tools. The Curve Editor toolbars that you can display or hide, dock or float, from the right-click menu include the following:

- Name toolbar
  Enter a name in this field to create a named Track View window. You can recall the saved Track View window by choosing Graph Editors menu > Saved Track View on page 3991 submenu. This option is also available in Dope Sheet mode.

- Navigation toolbar
  Use these tools to pan on page 3984 and zoom the Key window on page 3987, or zoom to the extents of the time on page 3985 or the values on page 3986. This option is available in both Track View modes.
Key Stats toolbar  Track View provides tools for the display and type-in transform of key values on page 3982. This option is also available in Dope Sheet mode.

Key Tangents toolbar  Track View gives you quick access to different tangency types of keys on page 3875. This toolbar is most useful when floating near the curves. This option is also available in Dope Sheet mode.

Controllers toolbar  Track View has tools to copy, paste, assign, delete, and make controllers unique on page 3884. This option is also available in Dope Sheet mode.

Track Selection toolbar  Track View gives you tools to select tracks by typing in the name of an object on page 3971. This option is also available in Dope Sheet mode.

Keys toolbar  Track View provides the tools to move on page 3953, scale on page 3954, and slide keys on page 3914, scale values on page 3955, add keys on page 3956, draw curves on page 3957, and reduce keys on page 3941. This toolbar also has the Filter button, which lets you limit the display in the Controller.
window. A similar option is available in Dope Sheet mode on page 3879 with different and fewer controls.

**Curves**  
Track View provides tools to select and lock keys and curve handles on page 3877, as well as to make tracks keyable on page 3864, and to apply parameter curve out-of-range types on page 3961.

**Tools**  
Track View gives you tools to create or remove Note and visibility tracks, snap frames, lock selection, properties, and Track View utilities. This toolbar is hidden by default.

**Dope Sheet Toolbars**  
There are 11 toolbars that can be displayed when in Dope Sheet mode. In addition to the ones listed above for the Curve Editor, you can also choose to display the following:

**Keys**  
DopeSheet displays the tools to move, add, and scale keys on page 3880, the Filters button on page 3888, and the buttons that let you choose between Edit Keys on page 3906 and Edit Ranges on page 3943 options for Dope Sheet.

**Time**  
Track View provides tools to select and work with time on page 3881. Time can be
selected, inserted, cut, copied, pasted, scaled, reversed, or removed. This toolbar works only in Dope Sheet mode.

Ranges  Here are the tools to edit on page 3943, position on page 3944, and recouple ranges on page 3945.

Display  Dope Sheet holds tools to modify subtree on page 3860 and modify child keys on page 3861, lock selection on page 3909, snap frames on page 3907, and display keyable icons on page 3864.

Soft Selection Toolbar

Both the Curve Editor and Dope Sheet Edit Keys mode take advantage of soft selection of keys. If you choose Keys menu > Use Soft Select, then choose Soft Selection Settings on page 3927, the Soft Selection Settings toolbar is displayed. This toolbar is accessible only from the Keys menu, not from the right-click menu. If you want this menu to stay visible, save a Track View layout on page 3998.

Track Bar

You can dock the Track View windows below the time slider and track bar by choosing Dock > Bottom from the toolbar right-click menu. You can dock multiple Track View windows using this technique.

You can also display a Track View window below the viewports by clicking the Open Mini-Curve Editor button at the upper left corner of the track bar. Using this method, the time slider and track bar are replaced with
the Track View window. As with Dope Sheet and Curve Editor modes, you use the toolbar right-click menu to display or hide all Track View UI elements.

Procedures

To save a Track View layout:

1. Customize the Track View layout as you want.
2. When you want to save it, right-click the Track View menu bar or the blank area at the right of the Track View toolbar, and choose Save Layout As.
3. Enter a name you will remember.

To reload a saved Track View layout:

1. Right-click the Track View menu bar or the blank area at the right of the Track View toolbar and click Load Layout.
2. Choose the layout you want to display in Track View.

To save a Track View window:

You can save a particular Track View window, displaying to a particular set of tracks, by using the Name: Track View toolbar.

Enter the name for the window in the Name field. When you close the window, you can reload it by choosing Graph Editors > Saved Track Views. Then choose the named window from the list.

**Tip** Named Track View windows are saved with a file. Named layouts are independent of the file.

To restore the default Track View user interface:

If you have customized your Track View user interface and want to return to the original installed version, do the following:

1. In the \plugcfg folder within the 3ds Max install directory, locate the file trackview.bak.
2. Copy the file and rename the copy trackview.ini.
3. In Windows Explorer or My Computer, right-click and choose Properties. Make sure the Attributes is not set to Read-only.
TIP You can also right-click the Track View title bar and choose Load Layout > Default to return to the default layout. This works only if you have not saved over the default.

To add a new menu bar name to a custom Track View layout:

1. From the Customize menu, choose Customize User Interface.
2. On the Menus panel, click New to create a new menu. Enter the name of the menu in the New Menu field and click OK.
3. Using Notepad, open \plugcfg\trackview.ini, and navigate to the layout section. To affect the Curve Editor toolbar, choose the section named [default], or to affect the Dope Sheet toolbar, choose the section called [Dope Sheet layout].
4. Change the value of the "Menu Name" entry to the name of the menu you created in step 2.
   Save the layout after you are done and the changes will be persistent.

TIP You can also make the Dope Sheet Editor point at a renamed menu bar by using MAXScript:

In the MAXScript Listener, type trackviews.current.ui.menubar = "Dope Sheet - Menu Bar", substituting your menu bar name, and then press the Enter key.

NOTE There is also a script that lets you choose menus from a list. Choose Customize menu > Customize User Interface, then on the Menus panel, set Group to Main UI and Category to Track View, and choose Load Menu Bar from the Action list. Select the Track View menu bar you want to customize from the drop-down list on the right. Drag the action to the right window and the menu bar will be customized.

Track View Toolbar Right-Click Menu

You can use commands on the right-click toolbar menu to perform most Track View UI customization tasks. Move your cursor over the blank space to the
right of the Track View toolbars and right-click. This shortcut menu's customization tools are as follows:

- **Dock**  Snaps the toolbars into position horizontally above or below the window, or vertically along the left or right window edge. Once toolbars are horizontally docked, they can be reordered by dragging and dropping them as you like. Also used to dock the window beneath the viewports.

- **Float**  Floats the selected toolbar. You can float toolbars anywhere you like. You can also drag the double bars at the left of the toolbar to float the toolbar over the viewport.

- **Hide**  Turns off the display of the selected user interface element. Once something is hidden, you can redisplay it using Show UI Element or Show Toolbar on this menu.

- **Load Layout**  Loads a saved default, named, Function Curve, Dope Sheet, or track bar layout.

- **Save Layout**  Saves your customized layout, creating a new default layout. When you open a new Track View, this saved layout will be displayed.

  **NOTE**  To restore the default 3ds Max layout, see To save a Track View layout: on page 3998.

- **Save Layout As**  Saves your customized layout with a name you choose. When you've customized your layout, save it with an easily recognizable name, then you can return to it whenever you choose. Use Load layout to retrieve a saved layout.

- **Show UI Elements**  Toggles the display of Track View user interface elements. For example, you can hide or show the menu bar, scroll bars, the controller and Key windows, and the time ruler.

- **Add Toolbar**  Lets you display additional toolbars that you can create using commands the Customize User Interface pull down from the main menu bar.

- **Delete Toolbar**  Deletes the selected toolbar.

- **Show Toolbars**  Lets you choose which toolbars you want to display or hide.

  **NOTE**  Some toolbars are hidden by default.
The Motion Mixer allows you to combine motion data for biped and non-biped objects.

The Motion Mixer takes its design from the world of audio. When a song is recorded in a studio, each instrument is played and recorded separately. Each recording is called a track. The tracks are then put together in a sound mixer so they play simultaneously, or overlap one another. During the mixing process, the mixer operator can change the length or speed of a track, increase or reduce volume, move a track to another place in the song, or cause a track to fade in or out.

The Motion Mixer works in a similar way. For any object, you can add multiple tracks on page 8744 to the mixer, each holding a separate series of motion clips (BIP files on page 8520, XAF files). You can trim clips to use only part of a motion,
make the clips play slower or faster, or create transitions from one clip or set of clips to another.

You can also use the Motion Mixer to animate some body parts with one set of clips, and other body parts with other motions. For example, suppose you have two clips, one where the biped runs with its arms pumping by its sides, and another where the biped stands and cheers with its arms in the air. You can mix the leg and hip motions from the running motion with the arms from the cheering motion to make an animation of a biped cheering as he runs across a finish line.

**Using the Motion Mixer**

The Motion Mixer allows you to mix motion files (BIP on page 8520 and XAF on page 4122 files) for any biped or non-biped objects. These motion files are also called *clips*. 
The Motion Mixer is comparable to an audio mixer. Motion clips can be cross-faded, stretched, layered, and finally, mixed down to a single clip.

The Motion Mixer works by placing motion files on tracks on page 8744. With the Motion Mixer, you can:

■ Transition or fade between motions.
■ Move motions in time.
■ Trim a motion so only part of it is used.
■ Vary the speed of a motion over time.
■ Use animation from selected biped or non-biped body parts within a motion clip.
■ Keep planted feet from sliding during foot-based transitions.

To see a biped motion in the Mixer applied to the biped in the scene, you must turn on Mixer Mode from the Biped rollout on page 4669.

In the Motion Mixer, motions are imported and mixed for any objects in the scene. Once motions are mixed, you can pass the mix on to other biped (if it contains BIP files) and non-biped objects (if it contains XAF files), or save the mix to a MIX file.
Blending Motions in the Mixer

The Motion Mixer provides these types of motion blending.

- You can blend motion from one clip to another with a transition on page 8750. Transitions in the Mixer are similar to those used in the motion flow system on page 4848. The optimization feature can automatically find the best timing for a transition between two clips. When you make a transition between foot-based clips (clips where IK constraints keep the feet planted at certain times), you can cause the transition to focus on one foot or the other. See Working with Transitions on page 4026.

- In biped animation, if a transition between foot-based clips causes the foot to slide or pop slightly during the transition, you can fix this problem with a mixdown on page 8640 (flattening all tracks into one track). See Exporting Animation to the Biped on page 4043.

- You can change the weight on page 4032 of clips or tracks so they affect the animation more at some times than others. See Adjusting Track Weight on page 4032.

- You can use only the part of a clip's motion that affects specified body parts. See Filtering Mixer Tracks on page 4018.

- When motions applied to a biped's upper body vary greatly from motions on its lower body, the Mixer automatically compensates for discrepancies in balance. See Adjusting Biped Balance in the Mixer on page 4038.

**NOTE** Balance parameters are available only when mixing biped objects.

Transitions Between Foot-Based Clips

The Motion Mixer excels in its ability to maintain smoothness of motion over transitions between foot-based clips. Foot-based clips use IK constraints to keep one or both feet locked down over the course of the motion.

For bipeds, the Mixer provides tools for maintaining foot positions during transitions:

- Computing the influence of balance from the upper to the lower body. Without this, layered motion tracks will appear to be artificially combined since out since the resulting motion will be plagued by the isolation of dynamics and improper balance.
Mixdowns allow for precise elimination of the foot sliding with the aid of knee limit filtering to unnatural knee popping artifacts. In short, the goal of the mixer is to assemble seamless, coherent character motion using building blocks composed from other motion fragments.

For non-biped rigs and other 3ds Max objects, the Mixer provides velocity blends and sub-blends to maintain smooth and coordinated motion.

Comparing the Motion Mixer and Motion Flow

Both the Motion Mixer and Motion Flow on page 48 can be used to create transitions between a consecutive series of BIP files. However, there are a few significant differences between the two features:

- With the Motion Mixer, several BIP files can be used at the same time to affect biped motion. Compare with Motion Flow, where only one BIP file, or a transition between two consecutive BIP files, affects the biped at any given time.

- With the Motion Mixer, you can specify that a BIP file will affect only one part of the body. This feature is not available in Motion Flow.

- In the Motion Mixer, you can use a mixdown to automatically lock feet during transitions between biped foot-based motions. Motion Flow does not perform this function.

- A Motion Flow network can be used in conjunction with the Crowd feature, giving the bipeds a choice of motions over the course of the simulation. The Motion Mixer does not generate motion for biped crowds.

- A Motion Flow network can be used to randomly generate different motion scripts for one or more bipeds. This feature is not available in the Motion Mixer.

Use the Motion Mixer when you want to create a specific animation for an object from several clips, or you want to specify that some motions be applied only to specific body parts. If you want to work with biped crowds or create random motion, use Motion Flow.

If you're creating a straight series of transitions between motions, you can use either one. However, the Motion Mixer has additional tools for improving foot-based transitions.
Opening the Motion Mixer

You open the Mixer by either clicking the Mixer button on the Motion panel > Biped Apps rollout on page 4668 or choosing Motion Mixer from the Graph Editors menu on page 8027.

When you open the Mixer while a biped is selected, a trackgroup on page 8745, a clip track, and a balance track on page 8517 are assigned to that biped. If a non-biped object is selected, the Mixer opens empty.

These items are discussed in detail in the sections that follow.

Procedures

To access the Motion Mixer from the Motion panel:

1. Select a biped.

2. Access the Motion panel.

3. On the Biped Apps rollout on page 4668, click the Mixer button.

   The Motion Mixer opens, and displays the selected biped and two tracks. To learn about these tracks, see Adding Tracks to the Mixer on page 4007.

   Accessing the Mixer also turns on Mixer mode for the biped. Mixer mode must be on for the biped in order to see the mixed motion on the biped.
To display the Motion Mixer in a viewport:

1. Activate the viewport in which you want to display the Motion Mixer.

2. Click or right-click the Point-Of-View (POV) viewport label, and from the Point-Of-View (POV) Viewport Label Menu on page 8122, choose Extended > Motion Mixer.

**NOTE** When the Motion Mixer is displayed in a viewport, its menu bar is not accessible. However, you can access each menu by right-clicking the corresponding element in the Mixer.

To remove the Motion Mixer from a viewport:

- Right-click a blank area of the Motion Mixer toolbar, and choose another POV from the menu that pops up.

**Adding Tracks to the Mixer**

In the Motion Mixer, you begin the mixing process by opening the Mixer, then adding objects to mix, and then loading motion clips to clip tracks on page 8744. One clip track is created automatically if a biped is selected while you open the Mixer, but you'll probably need more to hold all the motions you want to use with your mixed objects.

When you open the Mixer while a biped is selected, a trackgroup on page 8745, a clip track, and a balance track on page 8517 are assigned to that biped. If a non-biped object is selected, the Mixer opens empty.

1. Trackgroup
2. Clip track
3. Balance track
This section discusses clip tracks. To learn about trackgroups, see Filtering Mixer Tracks on page 4018. For information on the balance track, see Adjusting Track Weight on page 4032.

Adding and Merging Non-Biped Object to a Mix

When you add a non-biped object to a mix, its keyable controllers are replaced by mixer controllers, which store the object's original animation as well as the Mixer animation.

If you merge a non-biped object containing Mixer controllers into a new scene, it comes in with its mix name preserved from the original file, but without any mixed animation.

Types of Clip Tracks

There are two types of tracks to which you can add clips:

Layer A track for a series of motions that do not need transitions between them. By default, a Layer track is created for a biped when you open the Mixer.

Transition A tall track with room for two rows of clips. You can put one motion file on the top tier and another on the bottom, and place a transition in the area where the two clips overlap. Transitions on these tracks are similar to Motion Flow transitions on page 4865 between clips.
Each biped in the Mixer is automatically given a balance track on page 8517, used for adjusting balance between clips in Layer and Transition tracks. Clips cannot be added to the balance track.

**NOTE** Balance tracks are only available for mixed biped objects.

**Procedures**

To add a Transition or Layer track to a trackgroup:

- Right-click an existing track and choose one of the options for adding tracks from the pop-up menu.
To convert a clip track from one type to another:

- Right-click an existing track, and choose one of the options from the pop-up menu for converting tracks.
To add a biped to the Motion Mixer:

1. On the Motion Mixer toolbar, click Add Biped.
2. From the Bipeds dialog, choose the biped(s) you want to add to the Motion Mixer.
   Several bipeds can be added to the mixer at once. When you click OK, highlighted bipeds are added to the mixer. Each is automatically assigned a trackgroup, a clip track, and a balance track.

To add a non-biped object to the Motion Mixer:

1. On the Motion Mixer toolbar, click Add Max Objects.
2. From the Max Objects To Mix dialog, choose the object(s) you want to add to the Motion Mixer.
   TIP You can save time if you first select your objects, and then open the dialog. This way, the objects are automatically highlighted.
3. Enter a mix name or leave the default one.
   When you click OK, the highlighted objects are added to the mixer under a single object mix. A track is automatically assigned to the object.

Importing Clips to the Mixer

You can import motion clips (BIP and XAF files) into the mixer
To import a clip, use any of these methods:

- Choose a file directly from the folder in which it resides.
- Choose a file from those you have placed in the Reservoir on page 4047, a storage area for BIP and XAF files.
- Import motion from another biped in the scene. See Working with Clips in the Mixer on page 4015.
- Import a motion flow script.
All clips imported for a single object are assigned a random, unique color. For example, all clips for one biped might be red, while those for another biped are blue. The color distinction makes it easier to work with multiple bipeds and non-biped objects in the Motion Mixer.

Biped rollout > Mixer Mode must be turned on in order to see the motion on the biped in viewports. This option is turned on by default when you open the Mixer from the Biped rollout on page 4669.

The Motion Mixer might not display the entire active segment when it is first opened. To set the Mixer display to the extent of clips in the Mixer, click Set Range on the Motion Mixer toolbar.

Preparing BIP and XAF Files

To use a motion file with the Motion Mixer, it must first be saved as either a BIP or XAF file. Many BIP files come with 3ds Max; you can use these, or you can make your own. To find out how to create your own BIP files, see Loading and Saving BIP Animation on page 4638. For more information of XAF files, see Saving and Loading Animation on page 4103.

Importing XAF Files

Non-biped object assets are loaded into the Mixer using the Load XML Animation File dialog on page 4107, from which you pick the desired XAF motion file to import. If the motion file needs an XMM mapping file, you can either choose an existing one or open the Map Animation dialog on page 4110 to create a new file.

TIP If you load multiple motion clips at the same time, you can pick a mapping file only once if all clips use the same.

NOTE The Relative/Absolute and Replace/Insert options are unavailable when you import XAF files.

NOTE Loading XAF clips from the Reservoir on page 4095 follows the same workflow.

Interpreting Clip Names

When you load a clip into the Mixer, the clip appears on the track as a solid bar, with its name displayed on the clip.
Other information can appear on the clip, such as the start and end frames, and the clip scale on page 4023. You can change the information that displays on the clip by clicking Preferences on the Motion Mixer toolbar, and changing the Clips options on the Mixer Preferences dialog on page 4099.

You can use the same clip numerous times in the Mixer. Each version of the clip displays the name of the BIP file, followed by a number, such as 1 or 2. The name might also have the letter Z between the name and number. These suffixes tell you how the clip is interpreted by the Mixer.

When you load a biped clip from a file, you have the option of setting the lowest starting foot height to Z=0 (the construction plane). If you leave this option turned on, the clip's motion will be moved in space so the biped's feet fall on the construction plane on the first frame of the clip. The letter Z appears after the clip name to indicate this setting.

When you load a clip into the Mixer for the first time, the clip name is followed by the number 1. If you clone or load the same clip to another part of the Mixer, the clip will display the same number or a different number depending on whether the new clip is an instance on page 8611 or an adaptation on page 8498 of the original clip. Instances are versions of the same clip used with the same object, or different objects of the same size. Adaptations are versions of the clip used with objects of different sizes.

The Mixer displays instanced clips with the same numbers, while adaptations receive sequential numbers. For example, if you clone a clip with the number 1 to a track for the same object, the new clip's name is also followed by the
number 1. If you clone the clip to a different object, the new clip is an adaptation, and the displayed name is followed by an incremental number: in this case, the number 2. If you then clone the adaptation to another track for the same object, the new clip is an instance of that clip, and will be displayed with the number 2. These numbers can help you determine which clips are instances of one another, and which are adaptations.

The ability to tell instances from adaptations becomes important when you replace a clip in the Mixer with another clip. During this operation, you have the option of replacing only the selected clip, only the instances of the clip, or all instances and adaptations of the clip.

**NOTE** Operations in the Mixer, such as cloning clips and editing clip timing, do not affect the clip sources (BIP files).

### Procedures

**To import BIP clips from a file:**

1. Select a biped, and open the Motion Mixer. See *Adding Tracks to the Mixer* on page 4007.

2. In the Motion Mixer, highlight the track into which you want to bring the motion file. Be sure to highlight a blank area of the track and not any existing clips on the track.

3. From the Motion Mixer menu, choose Tracks > New Clips > From Files. You can also right-click the track and choose New Clips > From Files from the pop-up menu.

4. Navigate to the folder where your BIP files are stored, and select one or more BIP files.
   - You can select as many BIP files as you like. These motions will be placed consecutively on the selected track.
   - Files imported into the Mixer in this way are automatically placed in the Reservoir.

**To import clips from the Reservoir:**

In order to import clips from the Reservoir, you must first place them in the Reservoir. See *Using the Reservoir* on page 4047.

1. Highlight a blank area of the track into which you want to bring the motion(s).
2 From the Motion Mixer menu, choose Tracks > New Clips > From Reservoir. You can also right-click the track and choose New Clips > From Reservoir from the pop-up menu.

3 Select one or more BIP or XAF files.

**To import clips from a motion flow script:**

Motion flow scripts can be imported to a track in the Mixer. Both clips and transitions from the script are imported to the track.

Before you can import motion flow to a track, the biped must have at least one motion flow script assigned to it in Motion Flow mode. See [Creating a Motion Flow Script](#) on page 4858.

1 Highlight a blank area of the track into which you want to bring the Motion Flow clips and transitions. You can choose either a transition or layer track.

2 From the Motion Mixer menu, choose Tracks > Import Motion Flow. You can also right-click the track and choose Motion Flow from the pop-up menu.

3 Choose a script from which to import motion.

The clips and transitions from the script are imported to the Mixer and displayed the track. If the track was a layer track, it is converted to a transition track to accommodate the transitions imported from the script.

**To see the motions in the Motion Mixer on the biped in the scene:**

1 Select the biped for which you want to see the current motion from the Motion Mixer.

2 Click Mixer Mode on the Biped rollout.

3 Play the animation or drag the time slider to see the motion in viewports.

**Working with Clips in the Mixer**

Once you have created tracks and imported clips to the Motion Mixer, you can adjust your animation mix by moving, cloning, and replacing clips.
Within the Motion Mixer, you can:

- Move clips in time within the same track.
- Move clips to other tracks.
- Clone clips.
- Slide all clips in time on a track.
- Replace a clip with motion from a biped, a motion flow script, or another clip.

To move a clip in time within a track:

1. Click Move Clips on the Motion Mixer toolbar.
2. Drag the clip and move it to another location on the track.
   A clip cannot be moved in such a way that it overlaps another clip. If you move a clip on top of another clip, it will return to its original location when you release the mouse.

Procedures

To move all clips horizontally on one track:

1. Select one or more clips. You can select multiple clips on different tracks for this operation.
2. Click Slide Clips on the Motion Mixer toolbar.
3. Move the selected clips to slide clips to the left or right.
   When you slide a selected clip to the right, all unselected clips to the right of the clip move to the right. When you slide a clip to the left, all unselected clips to the left move to the left.

To move a clip to another track:

1. Click Slide Clips on the Motion Mixer toolbar.
2 Move one clip on a track to slide all clips on the track.

To replace one clip with another:
After a clip is placed on a track, you can replace the clip with another clip. The new clip is scaled to fit the time of the original clip.

1 Select the clip(s) you want to replace.

2 Right-click a selected clip and choose Load Source > From Files from the pop-up menu. Select a BIP file to replace selected clips.

3 On the Mixer Clip Source Options dialog, choose whether to replace only the selected clips, or to also replace instances on page 8611 (versions of the clip on same-sized bipeds) or adaptations on page 8498 (versions of the clip on all bipeds).

To clone a clip:
Clips can be cloned within the same track, across tracks, and even across bipeds in the Mixer. A cloned clip retains the Z=0 status of the original clip (if this option was selected for the original clip), and any changes made to the original clip’s timing. Cloning a clip to a different-sized biped creates an adaptation on page 8498 of the original clip.

1 Make sure there’s enough space on the track where you want to place the cloned clips. Move clips as necessary to make room.

2 Select the clip(s) you want to clone.

3 Hold down the Shift key on your keyboard, and drag the selected clips to the new location.
   If there isn’t enough room where you attempted to place the cloned clips, the operations is cancelled and clips are not cloned.

To replace a clip with motion from a biped in the scene:
All motions used in the Motion Mixer must be saved as BIP files. When you copy animation from a biped in the scene, you must save this motion as a BIP file.

1 Place a clip in the track using any method.

2 Select the clips you want to replace with biped motion from the scene.

3 From the Motion Mixer menu, choose Clips > Load Source > From Biped. The Copy Biped Animation to Clip dialog on page 4052 appears.
Highlight the biped from which you want to copy the animation.

Enter a filename for the new clip.

Click Copy to replace clips with the biped motion.

The name of the clip in the track is replaced with the new filename.

**Filtering Mixer Tracks**

Each track in the Motion Mixer is part of a trackgroup on page 8745. Each trackgroup can be filtered so it uses motions from one set of body parts and not another. For example, you might want to use the arm motions from one motion file with the legs from another. For this purpose, you would need two separate trackgroups.

There are two steps involved in filtering with trackgroups:

- Create additional trackgroups as needed in the Mixer.

  - Filter each trackgroup (set it to use some body parts but not all), and name the trackgroup appropriately. This is accomplished with the Trackgroup Filter dialogs (biped and non-biped objects).
The Trackgroup Filter dialog for biped objects.

The Trackgroup Filter dialog for non-biped objects.
When a trackgroup is created, it is given one Layer track by default. However, you can add more tracks to each trackgroup, making it possible to mix motions for each set of body parts. For example, you could create a trackgroup for the arms, and have two tracks within this trackgroup. Then you could put two completely different sets of motions on each track, and use weighting to use one track or the other at different times during the motion. See Adjusting Track Weight on page 4032.

Trackgroups for Spine, Legs and Arms. The Arms trackgroup has two tracks.

**NOTE** Create only one trackgroup for each filtered set of body parts. For example, don’t use two trackgroups that both filter the spine. If you do so, the trackgroup highest in the Motion Mixer is used, and the other trackgroup is ignored. Instead, use multiple tracks within the trackgroup to achieve the animation you want.

**Procedures**

**To add a new trackgroup for the biped:**

1. Highlight the name of an existing trackgroup.
2. Right-click the trackgroup name and choose Add Trackgroup Above or Add Trackgroup Below.
A new trackgroup and Layer track are added above or below the existing trackgroups. You can add more tracks to the trackgroup by right-clicking the existing track and choosing one of the options from the pop-up menu.

To filter and name a trackgroup:

1. Highlight the trackgroup label at the upper left corner of the trackgroup you want to filter. By default, the trackgroup label is All, denoting that the trackgroup currently affects all biped parts.

2. From the Motion Mixer menu, choose Trackgroups > Filter. The Trackgroup Filter dialog appears. By default, all body parts are selected.
3 Click on body parts in the diagram to select or deselect them. You can also use the buttons below the diagram to help make the selection. For example, if the trackgroup will affect only the arms, click None to deselect all biped parts, then click the four arm boxes to select the arms.

4 Enter an appropriate name for the trackgroup at the bottom of the Trackgroup Filter dialog, such as **Arms**.
5 Click OK to close the dialog.
The new trackgroup name appears at the upper left of the track display.

**Adjusting Clip Timing**

In the Motion Mixer, you can shorten clips or change their timing interactively within the track display.
You can change the timing of motion clips in a number of ways:

- Change the length of a clip without changing its speed by trimming the clip at the start or end.
- Change the speed of an entire clip by stretching it out or shrinking it.
- Cause varying changes in speed throughout the clip with time warps. See Adding Time Warps on page 4034.

**TIP** When changing clip timing, it can be helpful to display start and end frame numbers and the clip time scale. To do this, click Preferences on the Motion Mixer and choose the appropriate options in the Mixer Preferences dialog on page 4099. As you choose options, the Motion Mixer display is changed interactively.

**Procedures**

To change the length of a clip without changing its speed:

1. On the Motion Mixer toolbar, click Trim Clips.
2. Drag either end of a clip to trim its length.
A gray bar appears on a trimmed end of a motion clip.

3 Turn off Trim Clips.
The gray area disappears.

TIP At any time, you can view original clip lengths in gray by turning on Trim Clips.

To remove scaling or trimming from a clip in the Motion Mixer, select the clip, right-click and choose Remove Scale/Trim.

To change the speed of an entire clip:

You can cause a motion to slow down or speed up by changing the length of the clip in the Mixer. Lengthening a clip will slow down the motion, while shortening the clip will speed it up.

1 On the Motion Mixer, click Move Clips.

2 Drag either end of the clip to extend or shorten it in time.

TIP To see the ratio of the original motion time to the new time, click Preferences. In the Mixer Preferences dialog, turn on Scales. This displays the ratio on the clip next to its name.
Working with Transitions

When two or more clips are placed on a transition track on page 8751, you can create transitions between any two clips. A transition creates a constant, gradual change from one clip to another.

To learn how to create a transition track, see Adding Tracks to the Mixer on page 4007.

If you want to make a less linear blend between clips than the blend created by a transition, see Adjusting Track Weight on page 4032.
Adjusting Transitions

Transitions are automatically created between clips when you load the clips into a Transition track. You can adjust the start or end point of a transition by dragging either end of the transition in the Mixer.

When a transition appears with hatchmarks, this indicates that the transition is invalid. This can occur when a clip’s brackets are reversed, with the out-bracket before the in-bracket. You can correct this problem by dragging each end of the transition to reverse the ends.

A useful transition can occur anywhere where two clips overlap. The unused part of the clip on either side of the transition appears with hatchmarks to indicate that that part of the clip will not be used in the mix. This type of transition is often used for foot-based clips, when the best place for a transition is not always at the edge of a clip.

Hatched parts of the clips are not used in the mix.

The Motion Mixer will allow you to extend a transition into an area where two clips do not overlap. However, this transition will most likely result in undesirable motion in the mix.
Transitions extending into areas where clips don’t overlap can create unpredictable results.

For the best results, make sure all your transitions cover only areas where two clips overlap completely.

To aid in making your transitions as smooth as possible, you can select transitions and use the Transitions menu > Optimize option. This feature searches the two clips to find the start and end time that will result in the smoothest transition, and adjusts the transition accordingly.

If you want to snap the ends of a transition to the ends of clips, turn on Snap Clips on the Motion Mixer toolbar before dragging the transition edges.

When you move or scale a clip on a transition track, by default its transitions are also moved or scaled. To prevent transitions from changing when you move or scale a clip, turn on Lock Transitions on the Motion Mixer toolbar.

**Using Transition Brackets**

On a transition track, transition brackets appear around each transition, and at the start or end of each clip that is not surrounded by a transition.
When you load a clip onto a transition track where clips already exist, the clip creates a transition between the last clip on the track and the new clip. The transition is created at the location of the last clip's transition bracket.

You can move a transition bracket to create the transition automatically exactly where you want it before loading the next clip. This feature can make it very quick and easy to load a long series of clips into a transition track with correct transitions.

**Working with Foot-Based Transitions**

Much like Motion Flow, transitions in the Mixer between foot-based motion clips (clips where IK constraints keep the feet planted at various times) must be carefully placed and adjusted to make the animation look as natural as possible. The workflow depends on whether you are animating a biped, or 3ds Max objects such as a rigged character.

**Foot-Based Transitions with Biped**

For the most natural transitions between foot-based motions, follow this workflow:

1. Find a good place to start and end the transition.
2. Create the transition with this timing. You can also optimize the transition to fine-tune it.
3 Change the transition focus.
4 Perform a mixdown.

Study both clips to find a start time and range for the transition that will result in smooth motion. Look for times when each foot has the same planting or free status in both clips. For example, a time period when both clips have the left foot planted and the right foot free is a good time range for a transition.

You can fine-tune your choice of transition time by optimizing the transition. This features searches each clip, either in its entirety or near an existing transition, to find the best timing for the transition.

You can improve a transition between foot-based clips by changing the transition focus on the Transition Editor dialog (Biped Object) on page 4066. In the example described above, the left foot would be chosen as the transition focus, because this would keep the left foot planted while the animation moves around it.

When transitions cause a planted foot to slide or pop slightly, or force a leg to straighten unnaturally, you can use a mixdown on page 8640 to correct these problems. See Exporting Animation to the Biped on page 4043.

Foot-Based Transitions with 3ds Max Objects

For foot-based motions, follow this overall workflow:

1 Find a good place to start and end the transition.
2 Create the transition with this timing.
3 Choose the parent object to be a velocity blend object.
4 Choose the model’s feet to be sub-blend objects.
5 Optimize the transition.

Procedures

To create a transition between two clips:

1 Right-click an existing track to insert a Transition track or convert the current track to a Transition track.
2 Right-click the track and choose New Clips > From Files from the pop-up menu. Choose at least two clips to load.
The clips are placed on the transition track with transitions between them.

3 Drag the transition to move it, or drag its ends to resize it.

4 Before adding the next clip, move the last clip’s transition bracket to the next desired transition location, and then load the clip.

To optimize a transition:

With foot-based clips, you can use the Optimize command on page 4060 to help you find the best timing for a transition. The Optimize command exhaustively searches the specified time period for times when the foot positions match most closely.

**TIP** A good workflow is to look at the clips individually to find the best approximate time for a transition, then use Optimize to fine-tune the timing.

1 Create a transition between clips at approximately the right location on the track.

2 Right-click the transition and choose Optimize from the pop-up menu. The Transition Optimization dialog on page 4079 appears.

3 Choose Search Near Existing Transition and click OK. The best transition is calculated, and the transition changes position and/or length in the Mixer to reflect the change.

**TIP** If you aren’t sure where you want the transition to take place, you can choose Search Entire Clip. This option can place the transition anywhere in the two clips. Check the motion afterward to ensure the transition takes place at an appropriate time.

To change the focus on a foot-based transition with Biped animation:

1 Scrub the time slider to the middle of the transition.

2 Zoom in on the feet in any viewport.

3 Right-click the transition and choose Edit from the pop-up menu. Alternately, you can select the transition and choose Transitions > Edit from the Motion Mixer menu. The transition editor appears. In addition, two stick figures appear in viewports to show the bipeds’ positions in the two clips. The yellow stick
figure shows the biped's position in the first clip, while the red figure shows the second.

4 On the dialog that appears, choose a different Transition Focus from the list.

As you change the Transition Focus, you will see the foot positions change. The Transition Focus sets a center or focal point for the transition, changing the biped's position slightly depending on the setting. On foot-based transitions, try different settings to bring the yellow and red skeletons closer together on a planted foot.

**NOTE** Transitions involving planted feet often result in one or both feet sliding when they should stay planted. After setting up the transition, you can correct this problem with a mixdown. See *Exporting Animation to the Biped* on page 4043.

### Adjusting Track Weight

Each track has one or more **weight curves** on page 8762 that you can use to mix motion from several tracks to varying degrees. The weight curve determines how much a specific track contributes to the motion within the trackgroup.

With weight curves, you can create several full or partial transitions between all the tracks in a trackgroup. Compare with transitions on a transition track on page 8751, which can only create a full transition between two clips.

Weight curves are useful for:

- Creating transitions between two tracks in a trackgroup.
- Creating random motion.
Experimenting with transitions quickly and easily.

Each track's weight curve appears as a thin black line across the top of the track.

**TIP** If you can't see the weight curve, click Preferences to display the Mixer Preferences dialog on page 4099. Turn Weight Curves off and on and watch the display to see the weight curve appear.

You access the weight curve by clicking the Weight Mode button at the right end of the track. Clicking Weight Mode on the Motion Mixer toolbar enables weight curve editing for all tracks. When Weight mode is on, you can work only with the weight curve, and not with clips.

You edit a weight curve using nodes (points) on the curve. Clips on layer tracks automatically have a node at each end of each clip. A transition track has no nodes by default.

**Weight Curve Evaluation**

By default, each track's weight curve is set to a value of 1.0 across the entire track, which uses 100% of the track's motion in the mix. When you change the curve to dip to a value below 1.0, the motion on the track is mixed with the motion on the track below it. For example, if you set the weight curve for two tracks in a trackgroup to 0.5, the two clips will be mixed equally.

Several tracks can be stacked in a trackgroup with varying weight curves on each one. For each frame in the animation, the Motion Mixer evaluates the curve on the topmost track. If its weight curve is less than 1.0 at that frame, the Mixer evaluates the next track down, and so forth. The Motion Mixer adds up the weight curve values until the sum reaches 1.0, and disregards tracks below that point.

For Transition tracks, one weight curve is used for the entire track. On Layer tracks, weight curves are set individually for each clip.

**Procedures**

To adjust a weight curve:

1. Open the Mixer, add a biped to the Mixer, and create two tracks for a trackgroup. See Filtering Mixer Tracks on page 4018.

2. Place different motion clips on the tracks.
For the topmost track in the trackgroup, click Weight Mode to the right of the track display. The weight curve turns red to indicate it can be edited. You have to do the next two steps only if the weight curve has no nodes, or would like to create more nodes.

Move the cursor over the line until a small arrow appears. Click to set a node.

Move the cursor and click to set more nodes on the weight curve.

**Tip** On a transition track, you would ordinarily set a node at each end of the track, and at intervals in between. The number of nodes you set depends on the type of curve you want to make. Make as few nodes as possible to get the curve required for your animation.

Move the cursor over an existing node until a cross cursor appears.

Click and drag to move the selected node downward.

The Motion Mixer mixes the motions from the topmost track with the track below it on that frame. The motions are mixed to a greater or lesser degree depending on how low you set the weight curve value for the topmost track.

### Adding Time Warps

Select a biped. > Motion panel > Biped Apps rollout > Mixer > Motion Mixer menu bar > Clips > Add Time Warp

Graph Editors menu > Motion Mixer... > Clips > Add Time Warp

You can cause varying changes in speed throughout a clip with a time warp. Adding a time warp to a clip allows you visually to squash and stretch time over different parts of the clip.

You can use a time warp to:

- Cause the object to do some parts of the motion quickly and others slowly.
- Cause a particular motion within the clip to occur at a specific time.
You use a time warp by picking a time within the motion clip and dragging that time's motion to another time in the same clip. The overall time of the clip is unchanged, so the object takes the same amount of time to do the entire motion, but does some parts quickly and others slowly.

Dashed lines appear on a time-warped clip in the Mixer to indicate the motion speed at different points in the clip.

![Time warp added to topmost clip.](image)

Warping a clip's time requires two steps. First a time warp must be added to the clip with the Clips > Add Time Warp menu option. Then you turn on Editable Time Warps to see the dashed lines and adjust the clip's timing.

**Procedures**

**To prepare to warp a clip's time:**

1. Open the Motion Mixer, add a biped to the Mixer, and load a clip on a track. See Adding Tracks to the Mixer on page 4007.

2. Scrub the time slider to find a motion you would like to occur earlier or later in the clip. Note the frame number. This frame number is the original time.

3. Scrub the time slider to find the frame on which you would like the motion to occur, and note the frame number. This frame number is the warped time.

With a time warp, you will cause the motion to occur at the desired frame by moving the original time to the warped time within the clip.
To warp a clip's time:

1. In the Motion Mixer, zoom in on the original time for the time warp. This is the frame number you noted in step 2 of the previous procedure.

2. In the Motion Mixer, select the clip.

3. From the Motion Mixer menu, choose Clips > Add Time Warp. The appearance of the clip does not change when a time warp is added.

4. On the Motion Mixer toolbar, click Editable Time Warps.

A series of evenly spaced dashes appears on the clip. The lengths of the dashes indicate the relative speed of the clip at various points. Right now, all dashes are evenly spaced to indicate the clip is playing at its original speed from beginning to end.

5. Move the cursor over the clip's horizontal center line until an arrow cursor appears.
6 At the approximate original time, click the clip to set a time warp bar.

A time warp bar actually consists of two parts, a top and a bottom.

7 Click the top half the bar. The top half turns white to indicate it is selected.

8 Drag the top half of the bar to the left or right to set it to the warped time noted in step 3 of the previous procedure. This will cause the motion at the original time to occur at the warped time.

TIP As you drag the top bar, watch the Frame value at the top of the Motion Mixer window to see the top bar’s new frame number.

9 Select and move the bottom bar to change the original time.
Either bar can be moved to change the effect of the time warp. The length of separation between the two bars sets the degree of time-warping that will occur. When both bars are aligned, no warping occurs.

To add multiple time warps to a clip:

1. You can time-warp other parts of the clip by adding more time-warp bars with the arrow cursor, then moving the new top bars. When you add a second time warp bar after editing the first, the top bar appears where you click, but the bottom bar appears in a different location. The bottom bar's location corresponds to the original time of the top bar before the clip was time-warped.

   ![Image](image.png)

   **NOTE** You cannot move one time warp's top bar past another on the clip.

2. When you have finished warping the clip’s time, turn off Editable Time Warps. When Editable Time Warps is turned off, the bars and the dashed line between them remain displayed on a clip to indicate it has been time-warped.

**Adjusting Biped Balance in the Mixer**

When you use different motions on the upper and lower parts of the biped, you can create a situation where the balance in the two clips do not match one another. For example, if the arms are waving wildly in the motion used for the upper body, the hip motion should compensate to some degree to
keep the biped in balance. A straight mix of this arm motion with another hip/leg motion will most likely not match up in terms of balance.

Bipeds with same set of upper and lower body motions. Biped on the left has balance compensation, biped on the right does not.

By default, the Mixer compensates for differences in upper and lower body motion by making slight alterations to the spine and pelvis motions. If the biped bends over at the waist, for example, the pelvis will be moved to compensate for the weight shift, and the spine rotation will be lessened to help the biped keep its balance. Balance compensation is intended to make the biped's motion look as natural as possible.

In the Mixer, you can control the degree of automatic balance compensation using the balance track. One balance track is automatically created for each biped as it is added to the Mixer.
If the balance track for a biped is not displayed, click Preferences on the Motion Mixer toolbar, and turn on Balance Curves on the Mixer Preferences dialog on page 4099.

The balance track has a weight curve for adjusting the degree of automatic balance compensation between upper and lower body trackgroups. By default, the weight value of 1.0 across the balance track provides the maximum degree of compensation. You can reduce the weight curve at various points to lessen the degree of automatic balancing performed by the Mixer.

Each biped can have only one balance track, and the balance track cannot be deleted.

For fine adjustments to balance compensation, you can also change the parameters on the Balance Parameters dialog on page 4053, available from the Mix menu.

Balance Curves and related parameters are not available for non-biped mixes.

Procedures

To adjust balance using the balance track:

1. Add a biped to the Mixer, and create at least two trackgroups for the biped. See Filtering Mixer Tracks on page 4018.

2. Filter one trackgroup to use motion only from the spine, arms and head. See Filtering Mixer Tracks on page 4018. This trackgroup will hold the upper body motion.
3 Filter a different trackgroup to apply only to the legs, pelvis and COM tracks. This trackgroup will hold the lower body motion.

4 Add a clip with a great deal of upper body motion to the upper body track. See Importing Clips to the Mixer on page 4011.

5 Add a clip with very different lower body motion to the lower body track.

6 Click the Balance Weight Mode button at the far right of the balance track.

The weight curve becomes visible at the top of the balance track.

**TIP** If you can't see the weight curve, click Preferences to display the Mixer Preferences dialog, and turn on Weight Curves.

7 Add nodes to the weight curve, and adjust the nodes. For information on how to add nodes and edit weight curves, see Adjusting Track Weight on page 4032.
When the weight is set to 0.0, the Mixer will not adjust the spine and pelvis motion to compensate for differences in the upper and lower body motion. Values between 0.0 and 1.0 will adjust the balance to some degree.

To fine-tune balance compensation on the pelvis and spine:

The values on the Balance Parameters dialog can be used to make subtle adjustments to the biped’s balance.

1. In the Motion Mixer, select the biped by clicking its name at the upper left corner of its trackgroups.

2. From the Motion Mixer menu, choose Mix > Balance Parameters. The Balance Parameters dialog appears.

3. To adjust the degree of horizontal balance compensation on the pelvis, change the Lateral Ratio parameter. Lower values make more forward/backward motion on the pelvis, while higher values use more side-to-side motion to compensate.

4. To adjust the degree to which spine rotation from the lower body motion is propagated on the upper body, change the Propagation parameter. Higher values rotate the spine links to better follow the COM and pelvis motion.
Exporting Animation to the Biped

Once you've worked with the Motion Mixer to create an animated sequence for the biped, there are several ways to work with the finished mix.

If you want to work with the mix on the current biped (rather than another biped in the scene), you have several options:

- If you're satisfied with the animation as it is, you can turn on Mixer Mode on the Biped rollout on page 4669 to display the mix on the biped, and simply render the scene.
If transitions between different foot/leg motions have created small pops or jerks near the transition area, you will want to create a mixdown on page 8640 for the biped and check the mixdown before copying it to the biped. A mixdown can correct many continuity problems with feet and legs. You can correct transitions and recomPUTE the mixdown as many times as you like. When the mixdown is satisfactory, you can copy it to the biped.

If you want to use the motion with a different biped, you can copy the mixdown to the current biped, save the motion as a BIP file, and load the new BIP file onto the other biped.

The mix can also be saved as a MIX (.mix) file. A MIX file on page 8640 can be loaded onto other bipeds and edited as needed in the Motion Mixer.

**Fixing Foot-Based Transitions with a Mixdown**

When you create a transition between two motions with planted feet (feet with IK constraints), the motion might not match perfectly between clips. When this occurs, a planted foot might slide or pop, or a leg might stretch unnaturally during or near the transition period.

A mixdown can correct two types of problems during transitions between foot-based motions:

- A foot sliding as it transitions from one planted motion to another.
- A leg extending completely straight (hyper-extending) unnaturally to reach a planted position.

The mixdown options on the **Mixer Preferences dialog** on page 4099 can help correct these problems. To access this dialog, click Preferences on the Motion Mixer toolbar.
To have an effect on a mixdown, these options must be set before the mixdown is computed. If Prompt for options at each Mixdown is turned on, you will be prompted to set these options each time you compute a mixdown. Otherwise, the mixdown uses the settings on the Mixer Preferences dialog.

The options in the Mixdown Options group determine if and how the mixdown affects transitions between clips with planted feet. Enforce IK Constraints affects planted feet, while Filter Hyper-Extended Legs affects unnaturally straight legs. Turn on Prompt for options at each Mixdown if you want to be asked for these settings each time you do a mixdown. For more information on these options, see Mixer Preferences Dialog on page 4099.

**TIP** You should not rely on the mixdown process to correct extreme problems with clips or transitions. For the best results, adjust transitions before a mixdown to minimize sliding feet and hyper-extending legs. See Working with Transitions on page 4026.

**Procedures**

**To perform a mixdown and copy it to the biped:**

1. Select the biped in the Motion Mixer by clicking the biped name at the upper left of the trackgroup set.
2 From the Motion Mixer menu, choose Bipeds > Compute Mixdown. If Prompt for options at each Mixdown is turned on in the Mixer Preferences dialog, you will be prompted for mixdown options. Click OK to start the mixdown.

A progress bar at the bottom of the Mixer shows the progress of the mixdown process. After a few moments, a new track called Mixdown is created as the last track in the biped’s mix.

You can turn the track on and off by clicking the track. When the track is solid, the Mixdown track is on (active), and the biped performs the animation in the mixdown. When the track appears with hatchmarks, the track is off (inactive), and the biped performs the animation in the raw mix.

3 Click the Mixdown track to make it active.

4 Scrub the time slider or play the animation to check the transitions. If they need correction, turn off the Mixdown track, correct the transitions, and compute the Mixdown again. Repeat until the transitions are correct.

5 With the Mixdown track active, choose Bipeds menu > Copy Mixdown to Biped.

6 Turn off Mixer Mode if it is on.

The mix from the Motion Mixer is visible on the biped in viewports even though the biped is no longer in Mixer mode.

7 To save the animation as a BIP file, click Save File on the Biped rollout.

**To save Motion Mixer data to a MIX file:**

A MIX file saves the current state of the Motion Mixer data for a selected biped, including all clips, transitions, trims, scaling and time warps. It is not necessary to collapse clips before saving a MIX file.

1 Select the biped in the Motion Mixer by clicking the biped name at the upper left of the track set.

2 From the Motion Mixer menu, choose Bipeds menu > Save Mix File. Enter a filename for the .mix file, and click Save.
Using the Reservoir

The Reservoir serves as a storage facility for motion clips on page 8646 (BIP and XAF files) that you use with the Motion Mixer. You can load clips directly into the Reservoir, and all clips that you load directly in the Motion Mixer also show up in the Reservoir.

For each motion file used in the Motion Mixer, the Reservoir list shows the source (disk path and name of the file), and, under the source, shows the name of each clip or set of clips derived from that file.
The Motion Mixer can apply multiple adaptations on page 8498 (occurrences of the clip for different-sized bipeds) to different bipeds. In the Reservoir, the various clip adaptations are listed under the clip name.

If you click a clip in the list, the window under the list displays information about the clip, including structural differences between the figure it's applied to and the figure from which the file was originally saved. A second window displays a graphical view of the biped animation; drag the slider below the window to move through the animation.
NOTE  The preview window is available only for BIP files.

TIP  For best results when loading animation clips that might require remapping into the Motion Mixer, load the clips directly into Mixer tracks, rather than going through the Reservoir. This always gives you the opportunity to remap the animation data.

Saving Clip Adaptations

The Reservoir lets you save a unique version of an adapted clip to a new BIP file. This new file will contain the new biped's size data, so will not have to be adapted when it is loaded into the Mixer.

If you are mixing long BIP files on a biped of a size other than the size used to create the BIP file, when you reload the MAX file or load a MIX file, you might have to wait while the Mixer recalculates the adaptation for the biped. You can save loading time by saving adapted clips to new BIP files and replacing the original clip in the Mixer.

If you save an instanced clip from the Reservoir under a new file name, all clips in the Reservoir are renamed likewise.

Procedures

To access the Reservoir:

1. On the Motion Mixer toolbar, click the Reservoir button. The Reservoir opens.

To add clips to the Reservoir:

1. Choose between Max Clips and Biped Clips.

2. On the Reservoir toolbar, click the New Entry button. The Open dialog appears.

3. Find the directory containing the clip files to load, highlight the desired file or files, and then click the Open button.
The file loads and appears as a Source in the Reservoir list. You can then add it to a track in the Motion Mixer using the latter's New Clips > From Reservoir command.

**To replace a clip in the Reservoir:**

Use the Load File command to replace a highlighted source or clip.

1. In the Reservoir list, click a single item.
   
   The Motion Mixer permits replacing only one source or clip at a time.

2. On the toolbar, click Load File.
   
   The Open dialog appears.

3. Find the directory containing the clip files to load, highlight the desired file, and then click the Open button.
   
   The file loads and replaces the highlighted item in the Reservoir list and the Motion Mixer. If you replace a source item, all of its clips are replaced as well. If you replace a clip, all of its references are replaced.

**To save an instanced clip to a new clip:**

Once you apply a clip instance to a different biped in Motion Mixer, 3ds Max automatically fits the motion to the biped. You can then save the modified motion from the Reservoir.

1. In the Reservoir list, highlight the clip whose motion you want to save.

2. On the Reservoir toolbar, click the Save File button. Use the Save As dialog to specify a name and location for the motion file, and then click the Save button.

   The motion file is saved as fitted to the biped to which the clip is applied.

**NOTE** The motion file is saved at its original length, whether or not you changed the length of any instances of the clip in the Motion Mixer.
To save multiple instanced clips from the Reservoir:

1. On the Reservoir toolbar, click Batch Save.
   This operation does not depend on which items are highlighted in the Reservoir list.

2. In the Save Reservoir Items dialog, turn on items you want to save. For each source/clips group, you can save the source or any combination of clips, but not both.
   Optionally turn on Reset Names After Saving.

3. Click Save to save the specified items.

To remove clips not used in the Motion Mixer from the Reservoir:

If you delete all instances of a clip from the Motion Mixer, it appears in the Reservoir with a Refs value of 0.

- On the Reservoir toolbar, click Clean to remove these clips from the Reservoir.
  The motion file is saved under the new name.

**Motion Mixer Interface**

Select a biped. > Motion panel > Biped Apps rollout > Mixer

Graph Editors menu > Motion Mixer...

The Motion Mixer is used to mix motion clips that are assigned to bipeds and non-biped objects. The concept of the Motion Mixer is based on audio mixing done in the music and sound industries. Like an audio mixer, Motion Mixer lets you add a series of tracks on page 8744 for each object in a scene. To each track you add clips on page 8646 in the form of BIP or XAF files. You can also add transitions on page 8750 to smoothly link clips together. Clips and transitions can be filtered on page 8574 so their motion affects only specified biped parts.

The entirety of the clips, transitions and other clip settings for a single object in the Motion Mixer is called a mix on page 8639. As each object has its own mix, there can be several mixes in the Motion Mixer at any given time. You can save a mix as a MIX file on page 8640.
For more information and procedures describing how to use the Motion Mixer, see Using the Motion Mixer on page 4002 and the topics that follow it.

The Motion Mixer is normally opened as a floating window. It can also be opened in a viewport, like the Asset Browser and MAXScript Listener.

**Motion Mixer Menus**

Select a biped. > Motion panel > Biped Apps rollout > Mixer

Graph Editors menu > Motion Mixer...

The Motion Mixer interface contains five menus located at the top of Motion Mixer window.

**Interface**

**Mix menu**

The Mix menu provides tools for managing your bipeds and non-biped objects when they are selected. If an object is already added to the Motion Mixer, right-clicking its name displays the menu. Use commands on this menu to
load and save MIX files, adjust track colors and balance parameters, and activate and deactivate the Mixer mode.

**Edit Max Mix Object** Opens the Edit Max Mix Object dialog, which lets you modify the content of the highlighted non-biped object mix. This dialog is comparable to the Max Objects To Mix dialog on page 4080 with the exception of the Bake Removed Nodes option.

**NOTE** This dialog is only available for non-biped object mixes.

**Bake Removed Nodes** When on, animation keys from removed objects are baked to the main timeline. Default=off.

**Add Trackgroup** Adds a trackgroup on page 8745 to the top of the selected object's mixes.

**Track Color...** Allows you to change the color of the clips in the selected object's mixes. Choosing this command displays a Color Selector, where you can specify the clip color.

**Balance Parameters...** Opens the Balance Parameters dialog. These values influence the effects of balance compensation on the biped's pelvis and spine when you use different motions on the upper and lower parts of the biped. See Adjusting Biped Balance in the Mixer on page 4038.

**NOTE** This dialog is available only for biped object mixes.
Lateral Ratio  Decreasing the Lateral Ratio to 0.0 will cause balance compensation to use only forward/backward motion on the pelvis. Increasing Lateral Ratio to 1.0 will adjust the pelvis with only side-to-side motion. Range=0.0 to 1.0; Default=0.5.

Propagation  Affects the degree to which spine links are rotated to follow COM and pelvis rotation. When set to 0.0 (the default), spine rotation is not influenced by lower body motion. When set to 1.0, all spine links except the topmost one use the lower body motion's spine animation to some degree to better follow the COM and pelvis motion. The lowest spine link is rotated the most, and each subsequent spine link is rotated less and less. The topmost spine link is not rotated at all so arm motion will be preserved.
In order for this setting to affect spine rotation, the lower body motion must have some spine animation as part of the motion clip.
A Propagation setting above 0.0 is appropriate when the upper body motion causes the spine to bend over a great deal during a large part of the animation. Range=0.0 to 1.0; Default=0.0.

Delete  Clears the selected object(s) from the Mixer.

Load Mix File  Opens a dialog where you can select a MIX file on page 8640 to load into the Mixer.

Save Mix File  Opens a dialog where you can save the current object's mix on page 8639 to a MIX file.

The following Mixdown-related tools are available only for biped object mixes.

Compute Mixdown  Performs a mixdown on page 8640 on the selected biped(s). A Mixdown track appears at the bottom of each biped's mix. Clicking the Mixdown track deactivates or activates it. When the Mixdown track is active, each biped inherits this single track's animation rather than the transition and layer tracks in the mix. When the Mixdown track is inactive, the biped uses the raw mix on page 8639 instead.
A mixdown can make automatic adjustments to transitions between planted foot motions. Creating a Mixdown track makes it possible to copy the mixdown to the biped so it can be saved as a BIP file. See Exporting Animation to the Biped on page 4043.

Delete Mixdown  Removes the mixdown from the mix of the selected biped(s).

The next three menu options are mutually exclusive; only one can be turned on at a time.

Copy Mixdown to Biped  Copies animation from the Mixdown track to the biped. The animation remains on the biped even after Mixer mode is turned off, and the animation can be saved as a BIP file.

Effect Raw Mix  When this option is turned on, Mixer mode is turned on for the biped. Default=active.

Effect Mixdown  When this option is turned on, the mixdown track is activated. This option is available only if a mixdown has been computed.

Effect Biped  When this option is turned on, Mixer mode is turned off for the biped. Click Effect Raw Mix to turn Mixer Mode on again.

Trackgroups menu

When a trackgroup is selected, you can access the commands in the Trackgroup menu. Alternately, you can right-click a trackgroup label to open the menu.

The Trackgroups menu lets you administer the bipeds in the mixer. Each biped you add to the Motion Mixer gets its own trackgroup, a selection of biped parts.

Filter...  Opens the Trackgroup Filter dialog where you can customize the object body parts that are included in a trackgroup mix. This command is only available when a single trackgroup is selected. For more information, see
The Trackgroup Filter dialog for biped object mixes.

Trackgroup Filter Dialog (Non-Biped Object) on page 4088, Trackgroup Filter Dialog (Biped Object) on page 4086, or Filtering Mixer Tracks on page 4018.
The Trackgroup Filter dialog for non-biped object mixes.

Add Trackgroup Above Adds new trackgroups above the currently selected ones.

Add Trackgroup Below Adds new trackgroups below the currently selected ones.

Add Layer Track Adds a Layer track at the top of the selected trackgroups. Layer tracks hold clips to be mixed without transitions.

Add Transition Track Adds a Transition track at the top of the selected trackgroups. Transition tracks hold clips that are mixed with transitions. Clips in Transition tracks will automatically spawn transitions when they overlap.

Delete All Clips Clears the selected trackgroups of all clips and transitions.

Delete Clears the selected trackgroups from the Motion Mixer.

Tracks menu

The commands in the Tracks menu are only active when you have a track, or tracks, selected in the Mixer. These menu commands are also available when you right-click a track in the Mixer window.
Add Layer Track Above Adds a new Layer track above the currently selected tracks.
Add Layer Track Below Adds a new Layer track below the currently selected tracks.
Add Transition Track Above Adds a new Transition track above the currently selected tracks.
Add Transition Track Below Adds a new Transition track below the currently selected tracks.
Convert to Layer Track Converts the selected Transition tracks to Layer tracks.
Convert to Transition Track Converts the selected Layer tracks to Transition tracks.
Optimize All Transitions All transitions on the track are optimized.
New Clips > From Files Opens a dialog where you can choose one or more BIP or XAF files to add to the selected track. If a selected BIP file has been saved for this release of 3ds Max, a thumbnail is displayed in the Motion Preview where you can move the slider and get an idea of what the motion looks like.
Any clip you add to a track using this method is automatically added to the Reservoir on page 4095.

NOTE If you choose a BIP file that is older, you will receive a warning that the file is obsolete and should be resaved. Until the BIP file is resaved, it will not display in the Motion Preview.

New Clips > From Reservoir Opens a Reservoir Files dialog where you can choose one or more BIP or XAF files listed in the Reservoir.
Import Motion Flow Allows you to import clips and transitions from a motion flow script to the selected track. You can import a script only if it is active on the currently selected biped, and if it has been loaded or saved as part of an MFE file on page 8639. If scripts are available for import, the Motion Flow Scripts dialog displays a list of available scripts. The imported script replaces the currently selected track with a transition track on page 8751 containing all the clips and transitions in the script.

NOTE This dialog is available only for biped object mixes.
NOTE If the selected track contains clips and transitions when you choose this option, these clips are removed from the track when the motion flow script is imported.

Delete All Clips Deletes all the clips residing on the selected track.

Delete Deletes a selected track or tracks.

Clips menu

The Clips menu is active when a clip is selected or when you right-click a clip in the Mixer. Some menu commands are not available when multiple clips are selected.

Add Time Warp Applies the ability to be time warped to the selected clips. A time warp allows you to alter clip speeds. It gives you the ability to stretch or squeeze time for parts of selected clips. For more details and procedures, see Adding Time Warps on page 4034.

Remove Time Warp Removes the ability for clips to be Time Warped and removes any existing Time Warping from selected clips.

Tile View Tiles the selected clip along the width of the Motion Mixer. The number of duplicated clips depends upon the clip’s length and the number of frames displayed across the Motion Mixer. For example, if a clip is 100 frames long and the number of frames across the Motion Mixer is 500, the clip will tile five times.

Tile Range Tiles the selected clip along the range of the active time segment. The number of duplicated clips depends upon the clip’s length and the number of frames in the active time segment. For example, if a clip is 100 frames long and the number of frames in the active time segment is 500, then the clip will tile five times.

Remove Trim/Scale Removes the trim/scale from the selected clip or clips.

Delete Deletes a selected clip or clips from a track.

Load Source > From File Opens a dialog where you can choose a new BIP or XAF file to replace selected clips. After selecting the new clip, the Mixer Clip Source Options dialog on page 4061 is displayed.

Load Source > From Biped Opens the Copy Biped Animation To Clip dialog on page 4063, where you can choose a biped from which to copy animation to selected clips.

NOTE This tool is available only for biped object mixes.
Load Source > From Reservoir  Opens the Reservoir File Groups dialog on page 4065, where you can choose a clip from the Reservoir to replace selected clips.

Copy to Biped  Puts the clip's animation onto the base state of the selected biped, evident when not in Mixer or any other mode. This option is available only when a single clip is selected.

NOTE  This dialog is available only for biped object mixes.

Collapse  Saves a collapsed version of the selected clip to a new BIP file. Collapsing removes all scaling, trims, and time warps from the clip, and prompts for a new BIP file name for the collapsed version of the clip. The original selected clip is replaced by the new clip. Collapsing a clip does not affect the selected clip itself.

NOTE  This dialog is available only for biped object mixes.

Transitions menu

Select a transition track to make commands on this menu active. Right-clicking a transition also opens this menu.

Edit  Opens either the Mixer Transition Editor dialog (Biped Object) on page 4066 or the Mixer Transition Editor dialog (Non-Biped Object) on page 4072, based on the kind of mix the transition is applied to. The dialogs are similar to the Transition Editor on page 4900 accessed from the Motion Flow rollout.

Optimize  Optimizes the selected transitions. This uses optimization algorithms similar to those in Motion Flow.

Convert To Loopable Clip  Allows you to create a loopable clip from a transition between two clips that are clones of one another. The two clips must share the same source file, meaning they must point to the same clip in the reservoir and they must have identical time warps and scales. Although the two clips don't have to be created via cloning, it is probably the best way to create them.

The loopable clip will replace the two original clips and their transition and will begin exactly one frame before the transition starts, so at that frame, the animation will appear the same as it did before you created the loopable clip. If you tile the loopable clip after you create it, it should loop perfectly.

NOTE  This dialog is available only for biped object mixes.
Motion Mixer Dialogs

The topics in this section describe support dialogs for the Motion Mixer.

Mixer Clip Source Options Dialog

Select a biped. > Motion panel > Biped Apps rollout > Mixer > Select clip(s). > Motion Mixer menu bar > Clips > Load Source > From File

Select non-biped clip(s). > Motion Mixer menu bar > Clips > Load Source > From File

The Mixer Clip Source Options dialog opens when you select one or more clips on a track and choose Load Source > From File Clips menu on page 4059. The new clip you choose replaces the selected clips. You also have the option of replacing instances on page 8611 and adaptations on page 8498 of selected clips.
Load Animation Into:

- **The selected clips only** Replaces only the selected clip with the newly specified clip.

- **All instances of the selected clip** Replaces instances of the clip (any occurrence of the selected clip within tracks for the same biped, or other bipeds of the same size).

- **All instances and adaptations of the selected clip** Replaces adaptations (any occurrence of the selected clip on all bipeds' tracks).
Method to Fit Animation to Clip:

- **Scale animation to fit clip**  Scales the length of the loaded clip to match the length of the clip it replaces in the track.

- **Trim animation to fit clip**  Trims the length of the loaded clip to match the length of the clip it replaces in the track.

- **Set clip length to animation length, shifting remaining clips in time**  For selected clips, changes the animation length to the loaded clip length. All clips on the track after the selected clip are shifted depending on the length of the newly loaded clip.

**Remove Weights** Removes any existing weight curves from clips selected to be replaced.

**Remove Warps** Removes any existing time warps from clips selected to be replaced.

**Copy Biped Animation to Clip Dialog**

Select a biped. > Motion panel > Biped Apps rollout > Mixer > Motion Mixer menu bar > Clips > Load Source > From Biped

The Copy Biped Animation To Clip dialog opens when you select one or more clips on a track and choose Load Source > From Biped on the Clips menu on page 4059 The animation from the biped replaces the selected clips.

**NOTE** This dialog is available only for biped object mixes.
Interface

Copy Animation Into:
- **The selected clips only**  Only the selected clip in the track is replaced by a new clip chosen from the reservoir.
- **All instances**  Replaces instances on page 8611 of the clip (any occurrence of the selected clip within tracks for the same biped, or other bipeds of the same size) with the clip selected from the Reservoir.
- **All instances and adaptations**  Replaces any occurrence (adaptation on page 8498) of the selected clip on all bipeds' tracks in the Mixer, with the clip selected from the Reservoir.

Method to Fit Animation to Clip:
- **Scale animation to fit clip**  Scales the length of the loaded clip to match the length of the clip it replaces in the track.
- **Trim animation to fit clip**  Trims the length of the loaded clip to match the length of the clip it replaces in the track.
Set clip length to animation length, shifting remaining clips in time  For selected clips, changes the animation length to the loaded clip length. All clips on the track after the selected clip are shifted depending on the length of the newly loaded clip.

Remove Weights  Removes any existing weight curves from clips selected to be replaced.

Remove Warps  Removes any existing time warps on page 4034 from clips selected to be replaced.

Reservoir File Groups Dialog

Select a biped. > Motion panel > Biped Apps rollout > Mixer > Motion Mixer menu bar > Clips > Load Source > From Reservoir...

Graph Editors menu > Motion Mixer... > Select a non-biped object track > Motion Mixer menu bar > Clips > Load Source > From Reservoir...

The Reservoir File Groups dialog opens when you select clips and choose Load Source > From Reservoir on the Clips menu on page 4059. This action replaces selected clips with the clip you choose from the Reservoir. This dialog shows a list of all the clips in the Reservoir on page 4095.

Interface
Copy Animation Into:

- **The selected clips only**  Only the selected clip in the track is replaced by a new clip chosen from the reservoir.

- **All instances**  Replaces instances on page 8611 of the clip (any occurrence of the selected clip within tracks for the same object, or other objects of the same size) with the clip selected from the Reservoir.

- **All instances and adaptations**  Replaces any occurrence (adaptation on page 8498) of the selected clip on all objects' tracks in the Mixer, with the clip selected from the Reservoir.

Method to Fit Animation to Clip:

- **Scale animation to fit clip**  Scales the length of the loaded clip to match the length of the clip it replaces in the track.

- **Trim animation to fit clip**  Trims the length of the loaded clip to match the length of the clip it replaces in the track.

- **Set clip length to animation length, shifting remaining clips in time**  For selected clips, changes the animation length to the loaded clip length. All clips on the track after the selected clip are shifted depending on the length of the newly loaded clip.

Remove Weights  Removes any existing weight curves from clips selected to be replaced.

Remove Warps  Removes any existing time warps from clips selected to be replaced.

**Mixer Transition Editor Dialog (Biped Object)**

Select a biped. > Motion panel > Biped Apps rollout > Mixer > Motion Mixer dialog > Add clips to the Mixer. > Select a transition in the Mixer. > Motion Mixer menu bar > Transitions > Edit > Transition Editor

The Mixer Transition Editor controls transitions on page 8750 on transition tracks on page 8751. When it is active, you view transitionary stick figures to aid in placing your transitions. You can use this dialog to change the start and end times of transitions, change the transition focus, and perform other functions.

This dialog is very similar to the Motion Flow Transition Editor on page 4900.
**Interface**

**Length** Sets the number of frames for the duration of the transition. Transitions are calculated by matching velocities in both clips. Smooth out abrupt velocity changes using longer transitions.

**Ease In** Ease-in value for the source clip.

**Ease Out** Ease-out value for the destination clip.

**Transition Focus** Lets you specify a focus point on the biped where the transition takes place. The Mixer will attempt to match movement based on this selection. For example, if Left Foot is selected, the transition will use the left foot as a focal point during the transition, aligning the motion of the left foot in both clips as much as possible during the transition. Default=Auto.

- **Auto** The transition focus is calculated by averaging the overall position of the biped as it transitions from one clip to the next.
■ **Center Of Mass**   The transition focus is based on the center of mass position of the biped as it transitions from one clip to the next.

■ **Left Foot**   The transition focus is based on the left foot position of the biped as it transitions from one clip to the next.

■ **Right Foot**   The transition focus is based on the right foot position of the biped as it transitions from one clip to the next.

■ **Both Feet**   The transition focus is based on an averaged foot position of both of the biped’s feet as it transitions from one clip to the next.

**NOTE**   The best way to see the differences between the transition foci is by watching the yellow and red ghosts.

**Angle**   Sets the direction of the destination clip.

The angle of the destination clip is automatically set for best body fit between the two clips when the Start Frame values change. Use Angle to change the direction of the destination clip.

**Preserve Height**   When turned on, Preserve Height will allow gradual vertical motion to accumulate from the source to the destination clip. For example, climbing stairs will loop upward. If it is turned off, the next clip is always set so that its lowest point is at z=0. This default insures that motion does not gradually float up (or down) with each additional clip.

**Previous/Next Transition buttons, Start Frame controls, and Optimize button**

**Previous Transition**   Go to the previous transition in the transition track.

Displays the previous transition in the Transition Editor, moves the time slider to the start frame of the previous transition and highlights the previous clip in the transition track.
Next Transition Go to the next transition in the transition track. Displays the next transition in the Transition Editor, moves the time slider to the start frame of the next transition and highlights the next clip in the Scripts list.

Start Frame This text field displays the number of the first frame of the transition.

Go To Start Frame Moves the time slider to the first frame of the transition.

Optimize Transition Displays the Transition Optimization dialog on page 4079. Options in the Transition Optimization dialog allow you to search for the range over which the optimizer searches for the transition.

Source Clip and Destination Clip groups

Clip range This text field displays the range of the source or destination clip. The ranges are relative to the clip itself, not to the frame range of the full animation.

Start Frame Sets the transition start frame for the source or destination clip. The start frame is relative to the clip itself, not to the frame range of the full animation.

Transition options These choices control how the transition is interpolated.

- Rolling Retains the clip motion during the transition.

- Fixed For the source clip, this option freezes the biped at the Start Frame position during the transition. For the destination clip, this option freezes the biped at the End Frame position. If Fixed is chosen for both the source and destination clips, the transition is a gradual interpolation from one frozen pose to another.
Ghost subgroups (Source and Destination clips)

The Ghost group Frame spinners allow you to view and scrub the source and destination clips by displaying stick figures (ghosts); yellow and red stick figures represent the source and destination clips. The source and destination bipeds might not be near each other during this scrubbing process; the destination clip will be repositioned when you click Set Start Frame is clicked. When you locate a suitable start frame, click Set Start Frame to copy the values in the Frame field to the Start Frame field. Monitor foot position status in the field provided.

Footstep key display This text field shows the state of footstep keys for the current frame.

Set Start Frame Copies the value in the Frame field of the Ghost area to the Start Frame field in the Clip area. The position of the destination clip
changes to match the biped body in the destination clip to the biped body in the source clip.
Locate an appropriate start frame for the source and destination clips by using the Frame spinner and viewing the positions of both stick figures, then click Set Start Frame.
The destination clip is rotated and positioned to match both bipeds. Use the Angle spinner to reorient the destination clip.

Frame Shows the current frame in the clip. The frame value is relative to the clip itself, not to the frame range of the full animation.
You can use the Frame spinner to scrub a stick figure back and forth, which can help you choose a start frame for the source and destination clips. Visual feedback of the stick figures is a good way to judge which start frames are needed for the source and destination clips.

Playback group

These controls let you play back the transition from the Transition Editor dialog.

Play Transition Click to play the transition. Click again to stop playback.

Speed Chooses the playback speed.
- 1/4 x Plays at one-quarter of real time.
- 1/2 x Plays at half real time.
- 1 x (The default.) Plays at real time (full speed).

Frames Before/Frames After Set the number of frames to play before and after the transition period.

Selected Only When on, plays back only the selected biped. Default=off.
Play Ghosts  When on, shows transition ghosts during playback. Default=off.

**Mixer Transition Editor Dialog (Non-Biped Object)**

Graph Editors menu > Motion Mixer... > Select a non-biped object clip transition. > Motion Mixer menu bar > Transitions > Edit

The Mixer Transition Editor controls transitions on page 8750 on transition tracks on page 8751. You can use this dialog to change the start and end times of transitions, change the transition focus, and perform other functions. Mix transition blend objects are changeable from clip to clip, and any new transition that results from cloning or adding clips initially uses the blend options from the last clip in time.

The options on this dialog are much the same as for Bipeds, except that:

- Mix transitions for 3ds Max objects do not have ghosting or playback controls.
- You can explicitly pick blend objects from any object being mixed in the track.
- The sub-blend capability provides further tuning of the transition.

**Blending and Sub-Blending**

Consider a character walking around a corner. The trajectory of the character's root describes an arc, while the IK feet cycle along the ground. This clip contains a few footsteps, and is used to make a mixer cycle that should take the character around in a circle. If you set the root and the feet all to be velocity blends, the transition will result in the root continuing around the corner while the feet continue in whatever direction they were moving at transition time! That is, if the right foot was just about to hit the ground with its heel, thus pointing up a bit, it would transition upward into the next clip instead of blending in the direction that the root's arc is taking. If you set the root to be a velocity blend and then set the feet to be sub-blends of the root, the transition results in the root continuing on its arc around the corner but with the feet blending in relation to it. That is, the upward-pointing right foot motion will blend with the foot motion in the new clip but in the direction of the arc, not in its own upward direction.
Interface

**Length** Sets the number of frames for the duration of the transition. Transitions are calculated by matching velocities in both clips. Smooth out abrupt velocity changes using longer transitions.

**Ease In** Ease-in value for the source clip.

**Ease Out** Ease-out value for the destination clip.

**Source Clip and Destination Clip groups**

The following options let you set different parameters proper to both source and destination clips involved in the transition.
Start Frame Set the transition start frame for the source and destination clips in their respective fields. Duration for the source and destination clips displays above the Start Frame fields.

- **Rolling** Keeps the clip in motion during the transition.
- **Fixed** For the source clip, this option freezes motion at the Start Frame position during the transition. For the destination clip, this option freezes motion at the End Frame position. If Fixed is chosen for both the source and destination clips, the transition is a gradual interpolation from one frozen pose to another.

**Velocity Blends group**

A Velocity Blend object is one that has its positions blended based on velocity (like a biped's COM). Objects used for Velocity Blending are most commonly the roots of the mix hierarchy. When you pick an object for velocity blending, its animation will accumulate based on its trajectory in the scene; for example, choosing the root of a character as the blend object will ensure that the character's animation is transitioned relatively from clip to clip, so the character keeps moving through world space instead of repeating each clip as absolute. All children of the root will follow in the transition.

In some cases, you might want to use velocity blending for a child object. By default, the Transition Editor uses no velocity blend objects.

**IMPORTANT** If you use velocity blending, pick your blend objects before you optimize the transition.

**Velocity Nodes list** Lists the objects you have chosen for velocity blending.

- **Select Velocity Nodes** Click to display a Pick Nodes dialog on page 4077 and choose the objects to velocity blend.

- **Delete Velocity Nodes** Click to delete the highlighted objects from the list.

- **Set Other Transition Velocity Nodes** Copies the set of velocity blend objects to all other transitions in the current track.
**Roll**  When on, accumulates the roll (X) angle during the transition. When off, the angle is simply blended with the next clip. Default=on.
The spinner value lets you specify an additional angle to add to the roll.

**Pitch**  When on, accumulates the pitch (Y) angle during the transition. When off, the angle is simply blended with the next clip. Default=on.
The spinner value lets you specify an additional angle to add to the pitch.

**Yaw**  When on, accumulates the yaw (Z) angle during the transition. When off, the angle is simply blended with the next clip. Default=on.
The spinner value lets you specify an additional angle to add to the yaw.

**X/Y/Z**  When on, accumulates position in the specified axis during the transition. When off, the position is simply blended with the next clip. Default=on.

**Sub-Blends group**

In order for other world-space objects to transition within the space of the velocity blend or a child of the velocity blend, you need to specify a sub-blend. For example, think of a rig that has a root moving through world space, and also has world-space IK foot controls. In this case, you would pick the root as the velocity blend, then select the root in the list and add the foot controls as its sub-blends. The result of this will be that the root makes a smooth transition and the feet make as smooth a transition as possible in the direction that the legs are going (within the root’s space) at transition time, not in the direction that the feet themselves are going at transition time.

**Sub-Blend Nodes list**  Displays the objects chosen for sub-blending.

![Select Sub-blend Nodes](image)  Click to display a Pick Nodes dialog on page 4077 and choose the objects to sub-blend.

Before you pick sub-blend nodes, you must first choose a velocity blend node in the upper list. Typically this is the parent of the nodes that will be sub-blends.

![Delete Sub-blend Nodes](image)  Click to delete the highlighted objects from the list.
**Set Other Transition Sub-blend Nodes** Copies the set of velocity sub-blend objects to all other transitions in the current track.

---

**Previous Transition** Goes to the previous transition in the transition track. Displays the previous transition in the Transition Editor, moves the time slider to the start frame of the previous transition and highlights the previous clip in the transition track.

**Next Transition** Goes to the next transition in the transition track. Displays the next transition in the Transition Editor, moves the time slider to the start frame of the next transition and highlights the next clip in the Scripts list.

**Current Frame** Displays the current frame number.

**Go To Start Frame** Moves the time slider to the first frame of the transition.

**Optimize Transition** Displays the Transition Optimization dialog on page 4079. Options in the Transition Optimization dialog allow you to search for the location for the transition.

**IMPORTANT** If you use velocity blending, pick your blend objects *before* you optimize the transition.

**OK** Confirms the current settings and closes the dialog.
Pick Nodes Dialog (Motion Mixer)

Graph Editors menu > Motion Mixer... > Select a non-biped object clip transition. > Motion Mixer menu bar > Transitions > Edit > Mixer Transition Editor > Click the Select Velocity Nodes or Select Sub-blend Nodes button.

This dialog opens when you pick nodes for velocity blending or sub-blending. If you click the Select Velocity Nodes button, the list displays only the objects being mixed in the current transition track. If you click the Select Sub-blend Nodes button, the list displays only the objects being mixed in the current transition track, except those objects that are already velocity blends.
Interface

Search field: To find an object in the list, enter the object’s name and then press Enter.

Node list: Lists all the available objects.

All: Selects all objects in the list.

None: Selects no objects in the list.

Invert: Inverts the current list selection.
Subtree group

**Display** When on, the object hierarchy is shown by indenting. When off, all objects appear at the same level. Default=on.

**Select** When on, selecting an object selects that object's children. When off, only one object at a time is selected. Default=off.

---

**Named selection sets drop-down list** This list shows the scene's named selection sets on page 217. Choosing a set from this list selects its members in the Node list.

---

**Transition Optimization Dialog**

Motion Mixer > Create a transition track. > Place clips on the track. > Right-click the transition. > Optimize > Transition Optimization dialog

Motion Mixer > Create a transition track. > Place clips on the track. > Select the transition. > Transitions menu > Optimize > Transition Optimization dialog

Options in the Transition Optimization dialog allow you to select the range over which the optimize algorithm will search for a transition. It can search either the whole clip, or it can search near the existing transition. You must specify the preferred length of the optimized transition. 3ds Max will try to get as close to that length as possible, still opting to give you the best length.

If it searches about the existing transition, you must specify the number of frames about which it will search before and after the existing transition.

Optimized transitions compute for minimum foot sliding over the range of the transition. This method of determining transitions yields very high quality results.
Interface

**Preferred Transition Length** Specify the preferred length of the optimized transition.

**Search Entire Clip** Search the entire clip for an optimized transition start frame.

**Search Near Existing Transition** Allows animators to find good transitions that "are in the ballpark" of their existing transitions. Transitions can be fine tuned without drastically changing the animation's timing. In general, there may be several "good transitions", so this feature narrows the range of search to the ones that are near to the current settings.

**Search Range about Existing Transition** Allows animators to set a “before” and “after” range of frames to perform a search for other transitions that are close to the selected transition. Both ranges default to 20 frames around the selected transition.

**Before** Set a frame value to search before the existing transition.

**After** Set a frame value to search after the existing transition.

**Motion Mixer Toolbar**

Select a biped. > Motion panel > Biped Apps rollout > Mixer
Graph Editors menu > Motion Mixer...

Like an audio mixer where you add music tracks and use fades and blends to transition between tracks, the Motion Mixer allows you to mix motion clips. The Motion Mixer toolbar offers commands that you use to add and delete biped and non-biped objects to and from the mixer, modify clips, and change the way tracks in the mixer are displayed.

See also:

- Adding Tracks to the Mixer on page 4007
- Using the Reservoir on page 4047

Interface

Add Max Objects

Opens the Max Objects To Mix dialog, which lists all non-biped objects in the scene. This dialog lets you add objects to be driven by your mixed animation, as well as name the mix in which they are contained.

This dialog is comparable to the Select Objects dialog on page 210.

NOTE The default mix name is the root node with the most children in the list.

NOTE Objects can be added to only one mix at a time. Once an object is part of a mix, it is removed from the list.
Add Bipeds Opens the Bipeds dialog listing all the bipeds in the scene. Highlight one or several bipeds to load them into the Motion Mixer window.

TIP You can click-drag over all, or several adjacent bipeds in the list if you want to add multiple bipeds to the Motion Mixer. If the bipeds you want to add are not next to one another, hold down the Ctrl key while choosing the bipeds you want to add.
Delete Deletes a selected biped from the Motion Mixer window.

Select Lets you select bipeds, trackgroups, tracks, and clips.

Move Clips Allows selection and movement (including Shift+Clone) of bipeds and trackgroups, keeping clips and transitions intact. It also allows independent horizontal movement of clips on the same track or vertical movement of clips from one biped's track to another biped's track.

Slide Clips Allows horizontal movement of clips on the same track or vertical movement of clips from one biped's track to another biped's track. Sliding a clip to the right will move unselected clips which are situated to the right of the selected clip; sliding to the left will move unselected clips which sit to the left of the clip.

Offset Records how many frames have been displaced. This value appears in the status area next to Slide Clips only during interactive translations, such as moving a clip or editing a time warp. The Offset value resets to zero when the translation is complete.

Frame Displays the frame number under the cursor during interactive translations, such as stretching a clip or editing a time warp. When stretching a clip, you can use both the Frame and Offset fields to tell you how many more or fewer frames the clip will have.

Trim Clips Clips can be trimmed from their original lengths interactively. When using this mode, you can grab the edge of a clip and drag it to a new frame within the clip's original length. This mode will display all trimmed portions of clips in the Motion Mixer as gray. See Adjusting Clip Timing on page 4023.

Editable Time Warps Clips can be interactively time warped, given that they have had a time warp applied. When in this mode, you can place
seams in a clip and then drag them within the clip's original length. See Adding Time Warps on page 4034.

**Draggable Tracks** Enables vertical movement of tracks with clips. Holding down the Shift key while moving a track creates a clone of the original track.

**Lock Transitions** When Lock Transitions is turned off (the default), moving a clip or changing its length on a transition track affect the lengths of transitions around the clip. When Lock Transitions is turned on, transition lengths do not change when you move a clip or drag clip edges not touching the transition. You can still change a transition's length by dragging the edges of the transition itself.

**Set Range** Matches the active segment’s start and end times to the extents of the mix.

**Pan** Pans the Motion Mixer display horizontally and vertically.

**Zoom Extents** Stretches or shrinks the mix to fit in the current Motion Mixer display.

**Zoom** Allows horizontal stretching and shrinking of the display of the mix.

**Zoom Region** Zoom into a portion of a track by dragging a region selection around that part of a track.

**Snap Frames** An on/off toggle that sets the Motion Mixer to snap all adjustments to single frames.
**Snap Clips** An on/off toggle that causes clips residing on the same track to snap together. The end frame of one clip will match the start frame of the next clip. If the first clip ends at frame 100, the start frame of the next clip will snap to frame 100.

When Snap Clips is on, transition edges snap to clip edges when dragged.

**Preferences** Opens the Mixer Preferences dialog on page 4099, where you can change display settings for clips, transitions, and frames.

**Reservoir** Opens the Reservoir dialog on page 4095.

**Named selection** Lets you enter a name for the current selection. This field is similar to named selections for 3ds Max objects (on the main toolbar), but unlike named object selections, you can rename an existing set.

To create a named selection, select the clips for the set, enter a name in the named selection field, and then press Enter. You can reselect an existing selection set by choosing its name from the drop-down list.

Named sets of clips in the mixer are saved with the MAX file but not with MIX files.

**Horizontal** This button is available when the Weighting button on the motion mixer toolbar or on a trackgroup is active. It locks all movement of weight nodes to the horizontal.

**Vertical** This button is available when the Weighting button on the motion mixer toolbar or on a trackgroup is active. It locks all movement of weight nodes to the vertical.

**Horizontal Vertical** This button is available when the Weighting button on the motion mixer toolbar or on a trackgroup is active. It allows free horizontal and vertical movements of weight nodes.
**Weight Mode** An on/off toggle that allows you to work with weight curves. Weight curves are useful for making smooth blends between tracks. The Weight Mode button on the Motion Mixer toolbar acts as a global switch that toggles the Weight Mode buttons on every track in the Mixer. The Weight Mode button at the right end of each track toggles weighting only for that track. For more information on how weight curves work, see Motion Mixer Editor on page 4090. To find out how to use weight curves, see Adjusting Track Weight on page 4032.

**Trackgroup Filter Dialog (Biped Object)**

Select a biped. > Motion panel > Biped Apps rollout > Mixer > Click a biped track name to highlight it (by default, the name is “All”). > Trackgroups menu > Filter

By default, the Motion Mixer expects that a mix you create will affect the entire biped. If you like, you can filter on page 4018 a trackgroup so clips in the mix affect only selected body parts. This functionality makes it easy for you to assign one set of BIP files to control the motion of a biped’s upper body, while another set controls the lower body.

For more information and procedures on the use of trackgroup filters, see Filtering Mixer Tracks on page 4018.
The Trackgroup Filter dialog consists of a rough diagram of a biped. Selectable components display in the color specified for the trackgroup by the Track Color command on the Mix menu on page 4052. If the biped does not include parts like ponytails or props, they are unselectable. Body parts can be individually activated or deactivated by clicking them, or you can use the buttons across the bottom of the Trackgroup Filter diagram to expedite selections.

**Center** Activates all central body parts, comprised of the spine, pelvis and horizontal movement, rotation and vertical movement icons.

**Arms** Activates the biped's arms, comprised of the right arm, left arm, and both hand icons.

**Legs** Activates the biped's legs, comprised of the right leg, left leg, and both foot icons.

**Xtras** Activates the biped's extra tails. See Xtras group on page 4772.

**All** Activates all selectable body parts.

**None** Deactivates all body parts.

**Invert** Inverts the current body part selection. If everything is active, this deactivates everything, as if you clicked the None button.
**Trackgroup Label Field** Use this field to specify a more descriptive label for a trackgroup. When you first create a trackgroup, it is labelled All. The new label entered here will appear in place of All to the left of the trackgroup. Use a unique, descriptive name to help you keep track of what body parts were filtered for the trackgroup. For example, if you selected only the pelvis and legs, you could enter **Lower Body** as the trackgroup label.

**Xtras group**

Lists the names of any Xtra tails the biped might have. See **Xtras group** on page 4772. Click the name of an extra tail to select it. Extra tails don’t appear in the biped diagram, only in this list.

**Trackgroup Filter Dialog (Non-Biped Object)**

Graph Editors menu > Motion Mixer > Click a non-biped track name to highlight it (by default, the name is “All.”) > Trackgroups menu > Filter

By default, the Motion Mixer expects that a mix you create will affect the entire non-biped object. If you like, you can filter on page 4018 a trackgroup so clips in the mix affect only selected body parts. This functionality makes it easy for you to assign one set of XAF files to control the motion of an object’s upper body, while another set controls the lower body.

For more information and procedures on the use of trackgroup filters, see **Filtering Mixer Tracks** on page 4018.
Interface

Search field To find an object in the list, enter the object’s name and then press Enter.

Object list The Trackgroup Filter dialog displays a list of objects, with the hierarchy indicated by indenting (if Subtree > Display is on, which it is by default). Objects can be individually activated or deactivated by clicking them, or you can use the buttons across the bottom of the Trackgroup Filter diagram to expedite selections.

All Activates all selectable

None Deactivates all body parts.

Invert Inverts the current body part selection. If everything is active, this deactivates everything, as if you clicked the None button.

Subtree group

Display When on, all body parts are listed following a hierarchy structure. Otherwise, body parts are listed on the same level. Default=on.

Select When on, highlighting a body part automatically select all its children.
Named selection sets drop-down list This list shows the scene's named selection sets on page 217. Choosing a set from this list selects its members in the Object list.

OK Confirms selection and closes the dialog.
Cancel Disregards current selection and closes the dialog.

Motion Mixer Editor

Select a biped. > Motion panel > Biped Apps rollout > Mixer

The Motion Mixer window contains an editor where you manage everything that is added to the mix: bipeds, trackgroups, tracks, clips, and transitions.

Interface

The editor contains three sections:
- Biped/Trackgroup/Track Controls on page 4091
- Interactive Clip Controls on page 4091
- Weighting Controls on page 4093
**Biped/Trackgroup/Track Controls**

The left-most section of the editor is the Biped/Trackgroup/Track Controls section. The Biped/Trackgroup/Track Controls set the number, order, display, and characteristics of those features in the mix. Bipeds and trackgroups can be selected, added, removed and repositioned.

The “−” and “+” buttons collapse and expand the display of bipeds and trackgroups. The “m” button mutes a track, taking its influence out of the mix. The “s” button sets a track to solo mode, making it the only active track in the mix.

**Interactive Clip Controls**

The center section of the editor, Interactive Clip Controls, lets you manipulate the scale, time, timing, and trimming of clips and transitions.
The overall length of all clips and transitions in a track can be stretched or squeezed by dragging the white ends of the gray range bars along the top of each trackgroup. Drag from the middle of the range bar if the entire mix of a trackgroup needs to be moved. Likewise, clips can be moved by dragging from the middle of a clip. Clips and transitions can be shortened or lengthened by dragging either end.

The range bar for each biped can also be moved or scaled to move or scale the entire mix for the biped.

Transition brackets appear in Transition tracks. Where a transition exists, the brackets indicate the start and end point of the transition. If there is no transition at the end of the clip, the bracket indicates where the transition will be placed when a new clip is loaded into the track.

The current time in the scene can be changed by dragging the vertical, purple timeline, a change which is reflected on the 3ds Max time slider.
If a clip has a time warp applied, time can be distorted interactively in Time Warp mode: first create seams in the clip, then drag the seams to stretch or squeeze time.

Note the corresponding changes in the frequency of the time ticks down the center of the clip. Time warps are used to speed up or slow down a motion.

**Weighting Controls**

The weighting controls at the rightmost end of the editor let you set the weight with which a clip or track will be blended with other tracks within the same trackgroup.
When Weight Mode is turned on, weights can be adjusted with a red weight curve on a clip or track.

On a Layer track, each clip has its own weight curve. Each Transition track has one weight curve for the entire track. By default, each weight curve has a node at each end that can be moved to change the weight at that point. Click on the weight curve to add more nodes, and drag a node to move it.

Weights can range from 0.0 (no weight) to 1.0 (full weight). The weight for the currently selected node appears to the left of the Weight Mode button. You can change the weight by moving the node or by changing the spinner value.

When you have multiple weight nodes selected, and you use the spinner to set a new value, weight node values are changed relative to their original values. In this case, you cannot spin the spinner lower than 0 or higher than
1 on any one spin. If you have more than one weight node selected and you type in a weight, the weights of all nodes are changed to the new value.

Weighting is evaluated across tracks in a single trackgroup. If a trackgroup has two or more tracks, the topmost track’s weight is evaluated at each frame. If the weight at any frame is less than 1.0, the motion on the track is only partially used, and next track down is evaluated for its weight. If the total weight is still less than 1.0, the next track down is evaluated, and so on. In this way, motion from multiple tracks can be mixed at the same frame for the same set of body parts.

The Weight Mode button at the right end of the main toolbar turns on this mode for all tracks in the Motion Mixer. For more information, see Motion Mixer Toolbar on page 4080.

On a balance track, the Balance Weight Mode button appears rather than the Weight Mode button. When in Balance Weight mode, you can adjust the weight curve for the balance track on page 8517. To find out how to use Balance Weight mode, see Adjusting Biped Balance in the Mixer on page 4038.

**Reservoir**

Select a biped. > Motion panel > Biped Apps rollout > Mixer > Reservoir

Graph Editors menu > Motion Mixer... > Reservoir

The Motion Mixer Reservoir on page 8701 is similar to the Motion Flow Graph on page 4891, in that it acts as a holding area where clips can be listed, giving you a palette of motions to choose from. As you add clips on page 8646 to objects in the Motion Mixer window, you see them appear on a track on page 8744 and they are automatically added to the Reservoir. If you add new clips directly to the Reservoir, they are available and held for future use.

**See also:**

- Using the Reservoir on page 4047
The Reservoir comprises four parts:

- The **Reservoir toolbar** on page 4097, where all the commands are located. You can choose between listing biped clips and non-biped clips.

- The **Source/Clipname list** on page 4098, where motion clips (BIP and XAF files) are listed. **Instances** on page 8611 are grouped together in one listing, while adaptations on page 8498 are listed separately.
- The **Clip Status field** on page 4099, where you can gather information about the clips used in the Motion Mixer.
- The **Motion Preview** on page 4099, where you can see what a motion looks like before you use it.

**NOTE** The Motion Preview is available only when you choose the Biped Clips option.

**Reservoir toolbar**

The commands on the main Reservoir toolbar allow you to manage the clips you have in the Motion Mixer and also build up a collection of clips that you may want to use in the future.

- **Max Clips/Biped Clips** Choose to switch between a list of biped and non-biped motion assets. The Max Clips option displays XAF files while Biped Clips displays BIP files.
- **New Entry** Opens a dialog where you can choose BIP or XAF files to load into the Reservoir. You can highlight multiple files to load by holding down the Ctrl key while you click.
- **Reload Files** Reloads selected BIP or XAF files listed in the Reservoir.
- **Load File** Opens a dialog where you can choose a new BIP or XAF file to replace the selected entry.
- **Save File** Allows you to save a highlighted clip from the Reservoir. The Save As dialog is displayed and you can specify a name and location for the clip you are saving.
**Batch Save** Opens the Save Reservoir Items dialog, where you can choose the clip or clips to save.

**Delete** Removes a highlighted clip from the Reservoir. All instances of the clip are also removed from the Motion Mixer.

**Clean** Similar to Delete, but only removes clips from the Reservoir that are *not* used in the Motion Mixer.

**Auto Clip Names** Names the clip based on the name of the motion file. Turn off to name a clip yourself.

**Source / Clipname list**

The Source / Clipname List displays all the clips you have in the Motion Mixer Reservoir. Four pieces of important information can be gathered from this list:

- Drive location where the clips are stored.
- Which clips are currently being used in a mix.
- How many times each instance of a clip appears in the Mixer (*Refs*).
- Which clips are simply being held in the reservoir, as opposed to being used in the Mixer.

As you add clips to a track, from the Tracks menu on page 4057 or by right-clicking a track, they are automatically added to the Reservoir. If the clip is a new adaptation on page 8498, the name of the clip is assigned an incremental suffix, such as 1 or 2.

The Refs (Reference) column tells you how many times a clip instance on page 8611 has been used in the Motion Mixer, or if it has not been used at all. If an instance shows a Refs value of 1 or more, it means the instance has been used that many times. If an instance shows a Refs value of zero, it means the clip was once used by one or more bipeds, but is not currently used on any tracks.

If a clip has been added to the reservoir, but has never been placed in the Motion Mixer, only the source path will be listed and no Refs value is displayed.
Clip Status field

The Clip Status field appears at the lower left of the Reservoir and gives you information about how a particular clip has been used. You can get file information, such as the source location of the BIP or XAF file. Clip information is also displayed, like the name of the clip reference as it appears in the Motion Mixer. Information about the biped structure is also listed along with the bipeds to which the clip has been adapted.

Motion Preview

The Motion Preview at the lower right side of the Reservoir shows a thumbnail of the selected clip. Moving the slider across the bottom gives you an idea of what the motion looks like before you add it to a track.

NOTE In order for a clip to show in the Motion Preview, it must be a BIP file that has been saved for this version of 3ds Max. If you choose a BIP file that is from an older version of 3ds Max, you will see a warning that the file is obsolete and should be resaved. Until the BIP file is resaved, it will not display in the Motion Preview.

NOTE The Motion Preview is available only when you choose the Biped Clips option.

Mixer Preferences Dialog

Select a biped. > Motion panel > Biped Apps rollout > Mixer > Preferences

Graph Editors menu > Motion Mixer... > Preferences

The Motion Mixer Preferences dialog lets you make changes to display settings for clips, transitions and frames. It is similar to the way you can Hide By Category on the Display panel. You can also specify mixdown options from this dialog.

The settings on the Motion Mixer Preference dialog are saved in the biped.ini file, as well as with the MAX file.
Interface

Show / Hide group

These settings affect how clips appear in the Motion Mixer tracks.

- **Names**  When turned off, clip names do not appear on the colored clip bars in the Motion Mixer. Default=On.

- **Scales**  Displays the clip scale. Since clips can be resized by using tools like Move Clips, displaying the scales quickly lets you know if a clip is two times its original length or half its length. Default=Off.

- **Boundaries**  Turns on and off the frame numbers at the start and end of the colored clip bars. Default=On.

- **Weight Curves**  Toggles the display of the weighting line. It doesn’t matter if the Weight button is active or not. Default=On.

- **Time Warps**  If a time warp has been added to a clip, this switch toggles the display of the warp on the colored clip bar. Default=On.
Show / Hide Transitions group

The two settings affect how transitions appear in the Motion Mixer tracks.

- **Inpoints**  Toggles the beginning transition frame on the transition clip bar. Default=On.
- **Outpoints**  Displays the end transition frame on the transition clip bar. Default=Off.

Show / Hide Other group

These settings indicate if range bars and balance curves appear in the Motion Mixer tracks.

- **Trackgroup Rangebars**  Hides the gray range bar that appears along the top of each trackgroup. Default=On.
- **Balance Curves**  Displays the Balance Curves track. Default=On.

Frame Display group

These settings affect how clip boundaries and transition in/outpoints appear in the Motion Mixer.

- **Global** Displays clip start and end frames as frame numbers. Inpoints and outpoints of transitions display the frame at which transitions start and end. Default=On.
- **Local** Clip boundary values are displayed as actual lengths in frames. Along with the start and end frame number of the transition, additional values tell you by how much the transition overlaps each motion clip.

Mixdown Options group

These settings affect how transitions between biped object clips appear in the Motion Mixer tracks.

- **Prompt For Options At Each Mixdown**  When turned on, the Mixdown Options dialog is displayed when you choose Compute Mixdown from the Mix menu in the Motion Mixer. Default=On.
- **A Keyframe Per Frame**  When turned on, a keyframe is generated for each frame of animation when the mixdown is computed. Default=Off.
- **Enforce IK Constraints**  When a transition occurs between two clips where the same foot or feet are planted with footsteps or planted keys, this option forces the foot/feet to stay planted during the transition. Default=On.

- **Continuity Range**  Sets an additional transition time after the actual transition, giving the foot time to get from its planted position to its keyframed location in the next clip. Range=0 to 100; Default=6.

- **Filter Hyper–Extended Legs**  Prevents a leg from straightening during a transition. This can occur when the COM moves in such a way that the foot can't reach its planted position unless the leg goes completely straight. This option corrects the problem by raising the biped's heel off the ground so the knee can bend. Default=On.

- **Max Knee Angle**  Sets the maximum angle that can be reached between the thigh and calf before the heel comes off the ground. An angle of 180 indicates a perfectly straight leg. A value of 160 or 170 indicates a slightly bent leg.

### Mixer Rollout

Select a biped. > Motion panel > Biped rollout > Mixer Mode

On this rollout, you can load and save MIX files (Motion Mixer files) on page 8640. A saved MIX file can be loaded onto any biped in the scene, and motions in the mix will be automatically adapted to the biped's size.

The Mixer rollout appears when Mixer Mode is turned on from the Biped rollout.

**Interface**
Load File Loads a Motion Mixer file (.mix). These files include the following, which display in the Motion Mixer window when a MIX file is loaded:

- **Trackgroups** Groups of tracks on page 8744 for selected parts of the biped.
- **Tracks** Layer tracks on page 8617 and transition tracks on page 8751 where clips and transitions reside.
- **Clips** References to BIP animation files used in the mix.
- **Transitions** Connections between clips on transition tracks.

**NOTE** Loading a MIX file does not automatically open the Motion Mixer. Click Mixer on the Biped Apps rollout to open the Motion Mixer and see the loaded mix.

Save File Saves the currently selected biped's mix in the Motion Mixer to a MIX file.

**Saving and Loading Animation**

You can save and load animation data for any number of objects separately from the actual scene via Load Animation and Save Animation commands available on the Animation menu.

These commands use two file types:

- **XAF (XML Animation File)** contains the animation data.
- **XMM (XML Animation Map File)** contains mapping information: how the incoming animation data is assigned to objects in the current scene.

Mapping is quite flexible: as long as data is comparable, it can be assigned. For example, each key for both position and rotation animation contains three numbers, so you could, if you wanted, assign incoming position data to a current object’s rotation track, or vice versa.

**See also:**

- **Save Animation** on page 4122
Procedures

To use the Save Animation and Load Animation commands:

You start by saving animation data from the current scene.

1. Select any number of objects in your scene that contain animation. The animation can be of any type: procedural, manually keyframed, IK, and so on.

   The frame range from which the animation is saved is the same for all objects, so make sure you select only objects from which you want to save the same frame range.

   **NOTE** Using this method, you can save animation only from selected objects. Alternatively, you can save animation from specific tracks in Track View; see Hierarchy Right-Click Menu on page 3825.

2. From the Animation menu, choose Save Animation on page 4122.

3. Set the save parameters.

   By default, the command saves all keys from animated tracks for selected objects, including motion derived from constraints. For example, if an object rotates because a LookAt constraint is applied to its Rotation track, then when you save its animation with Include Constraints on page 4124 on, 3ds Max generates rotation keys based on the constrained motion. It does not save the actual constraint.

   You can save just a part of the animation by turning on Segment on page 4125 and setting a frame range.

4. Specify a file name and then click Save, or click the + button next to Save to increment the file name and save under the new file name.

   If the selected objects contain no savable animation, the message “No animation tracks to save” appears. If this happens, create animation to save or change the Save Animation parameters as needed.

   Next, you load the animation data.

5. Set up or load a new scene and then select any objects that are to receive the loaded animation.
NOTE Using this method, you can load animation only to selected objects. Alternatively, you can load animation to specific tracks in Track View; see Hierarchy Right-Click Menu on page 3825.

6 From the Animation menu, choose Load Animation on page 4107.

7 Find and highlight the XAF file from which to load animation.

8 Click Load Motion. If the objects you're loading animation to are the same as those you saved the animation from, the animation loads and is mapped automatically. If mapping is required, you're given the opportunity to set it up. Or, if you've already set up mapping for the scene and incoming animation data, choose a mapping (XMM) file from the Motion Mapping/Retargeting drop-down list and then click Get Mapping. Otherwise, click Edit Mapping.

Clicking Edit Mapping opens the Map Animation dialog on page 4110, which contains three lists: from left to right, Current, Mapped, and Incoming. The Current list shows selected objects in the scene and their animation tracks; the Incoming list shows animation tracks in the XAF file, and the Mapped list shows, for each track in the Current list, the animation track in the Incoming list that will map to it. In certain cases, such as with objects that have the same name, some tracks are mapped automatically and appear in the Mapped column as soon as you open the dialog. The tracks that are already mapped are shown in gray in the Current and Incoming columns.

9 To map a pair of tracks manually, click a track in the Current list and another in the Incoming list, and then click the left-arrow (<-) button to the left of the Incoming list.

This places the name of the incoming track in the Mapped list, opposite the Current-list track to which it is assigned.

10 To remove a mapping assignment, click its entry in the Mapped list, and then click the -> button.

11 Continue setting up the mapping assignments as needed. When you're finished, click Save Mapping or Save Mapping As, and then specify a file name to save.

After you save the mapping file, the Load Motion button becomes available, and you can proceed with loading the animation.

12 Click Load Motion.

The animation data is loaded and assigned to the selected objects, and any animation keys appear on the track bar.
To retarget an incoming animation:

This is a continuation of the previous procedure, and explains the basic workflow of node retargeting. *Retargeting* means to scale the animation so it matches the objects onto which you are mapping the motion. You can use this feature any time you need to transfer an animation between two objects or rigs of different sizes and proportions. For example, an animation of a cat stretching could be retargeted to a bigger dog model, resulting in a scaled animation to fit the dog’s skeleton.

Once your track-mapping assignments are complete, the Retargetable Nodes list on the Retargeting rollout displays the mappings available for retargeting.

For steps that describe retargeting a character rig, see *To retarget one character onto another* on page 4118.

1 First, in the Scale Origin group, choose the Incoming and Current objects to use as the origin and basis for scaling.
   For example, when retargeting a rig, you would use each rig’s root object.

2 Next, in the Derive Scale Between Chains group, chose comparable IK or FK chains from the Incoming and Current models to obtain a Scale Factor that proportionally retargets the incoming animation onto the current model.

3 Click Set to apply the retargeting.

4 If different portions of the model are differently proportioned, you might need to repeat steps 2 and 3 for different selections of mapped tracks. You might also need to use the FK Retargeting Extent group to account for the different proportions. See *Retargeting Rollout* on page 4117 for more details.

5 When you're finished, save your mapping to preserve the retargeted data, and then click Load Motion to apply the animation to the currently selected objects.
   Retargeting is essentially a “by hand” process. You might need to try different settings to get the result you need. You can remove retargeting by highlighting a mapped track in the Retargetable Nodes list, and then clicking Clear.

6 Close the Map Animation dialog.
Load Animation

Select one or more objects. > Animation menu > Load Animation

Track View > Hierarchy/Controller window > Highlight one or more tracks > Right-click. > Load Animation

Load Animation lets you load animation from an XAF (XML Animation File) file to objects in your scene. Part of the animation-loading process is mapping the animation; that is, specifying which objects in the scene are to receive the loaded animation tracks.

For a procedure that outlines the basic method of saving and loading animation, see To use the Save Animation and Load Animation commands on page 4104.

See also:

- Saving and Loading Animation on page 4103
- Save Animation on page 4122
- Map Animation Dialog on page 4110
**Interface**

The controls in the upper-left corner of the dialog are standard file-browsing controls.

**Load Into Active Layer** Loads the animation file into the active layer. Default=off.

This option makes it easier to load an animation file to an object that has had Animation Layers on page 3467 enabled (or disabled) subsequent to saving the animation files. Remapping is necessary in this case because enabling or disabling Animation Layers causes the full controller names to change. For example, if a sphere's X position track before enabling Animation Layers is Sphere01\Transform\Position\X Position, then after enabling Animation Layers it might change to Sphere01\Transform\Position\Base Layer\X Position (the layer name is inserted into the controller name).

Whether Load Into Active Layer is on or off, when you load animation to an object after changing its Animation Layers status, 3ds Max prompts you to create a map file. If Load Into Active Layer is on, when you click Yes to create the map file, the Map Animation dialog opens showing only the active layer's...
tracks in the Current list, and the tracks are already mapped correctly in the Mapped list. All you need to do is save the mapping, and then load the motion. If Load Into Active Layer is off, clicking Yes to create the map file opens the Map Animation dialog showing all animation tracks in all layers, and you need to use the Map Animation controls to map the tracks before saving the mapping and loading the motion.

**Relative/Absolute** Determines how incoming animation affects existing values. Relative starts the loaded motion at the current values of the selected objects in the scene. Absolute sets the values of objects in the scene to those of the motion; so, for example, it would move a character to a new location and start the animation there. Default=Relative.

**Replace/Insert** Determines how existing keys are treated when the animation is loaded. Replace overwrites the keys in the scene with the incoming motion, starting at the chosen frame. Insert inserts the motion at the chosen frame and moves any subsequent, existing keys to the end of the incoming motion. Default=Insert.

**At Frame** The frame at which the incoming animation is applied. Default=0.

**Load Motion** If mapping information is available, loads the animation from the file specified in the File Name field and applies it to current objects according to the mapping information. If no mapping has been specified, you're given the opportunity to create a map file. If you then click Yes, the Map Animation dialog on page 4110 opens, but if you click No, no animation is loaded.

**Cancel** Closes the dialog without loading any animation.

**Motion Mapping/Retargeting group**

**File** Shows the current mapping file, or “Default” if no mapping file has been chosen. Choose a mapping file from the drop-down list. The list contains the most recently loaded mapping files. If the file you want to use isn't available in the list, use the Get Mapping button.

**TIP** If the paths in the drop-down list are too long to see the file name itself, you can resize the dialog to make the dialog and the list wider.

**Get Mapping** Lets you browse to load a mapping file. Use this if the file doesn't appear in the Use Mapping drop-down list. The file then appears in the list for easy reloading.
Edit Mapping Opens the Map Animation dialog on page 4110 for setting up animation assignments between incoming tracks and existing tracks. Available only after an animation (XAF) file has been chosen.

User Data group

The User Data list shows any user data present in the XAF file specified in the File Name field. User data can be created via the Save Animation dialog, or by editing the XAF file directly.

Map Animation Dialog

Animation menu > Load Animation > Open dialog > Edit Mapping
Animation menu > Load Animation > Open dialog > Load Motion > XML Animation dialog > Click Yes.

The Map Animation dialog lets you assign incoming animation tracks when using the Load Animation on page 4107 command. The dialog is resizable and contains three rollouts: for setting up basic parameters, doing the actual mapping, and doing retargeting.

For a procedure that outlines the basic method of saving and loading animation, see To use the Save Animation and Load Animation commands on page 4104.

See also:

- Saving and Loading Animation on page 4103
- Save Animation on page 4122
- Load Animation on page 4107
Interface

Most controls on this dialog are contained in three rollouts:

- **Motion Mapping Parameters rollout** on page 4112
- **Map Track to Track rollout** on page 4115
- **Retargeting rollout** on page 4117

**Motion File** Shows the path and name of the current animation (XAF) file.
- **New** Click to display a file dialog and specify a new animation file to load.
  
  With this option, you don’t need to return to the Load Animation dialog.

**Map File** Shows the path and name of the current map (XMM) file.
- **New** Click to display a file dialog and specify a new map file to load.
  
  With this option, you don’t need to return to the Load Animation dialog.

**Save Mapping** Click to save the current mapping assignments to an XMM file. If a file name is already displayed in the Map File field, it is overwritten; otherwise, 3ds Max displays a file dialog so you can enter a name for the new file.
Save Mapping As  Click to save the current mapping assignments to an XMM file using a different file name. This displays the Save XML Animation map file dialog.

Load Motion  Click to load the animation from the XAF file, and maps the animation tracks as specified.
This button is available only when the Map File field contains a valid map file name.

Replace / Insert  These options determine how existing keys are treated when you load an animation. Replace overwrites the current scene's keys (if any) with the incoming motion, starting at the chosen frame. Insert inserts the motion at the chosen frame and moves any existing keys to the end of the incoming motion. Default=Insert.

- At Frame  The frame at which the incoming animation is written (Replace) or inserted. Default=0.

Relative/Absolute  These options determine how incoming animation affects existing values. Relative starts the loaded motion at the current values of the selected objects in the scene. Absolute sets the values of objects in the scene to those of the incoming motion. For example, when you load a character animation, Relative starts the animation from the character's current position, while Absolute first moves the character to the position of the character in the scene from which the animation was saved. Default=Relative.

Motion Mapping Parameters Rollout

Animation menu > Load Animation > Open dialog > Edit Mapping
Animation menu > Load Animation > Open dialog > Load Motion > XML Animation dialog > Click Yes.
This rollout provides controls for automatically mapping animation tracks and for filtering tracks to reduce clutter.

Interface
Map Nodes group

These controls let you perform automatic mapping by name or hierarchical order. Mapping is done first by node (object) name, and then within each node's hierarchy by controller (track) name.

The default method of automatic mapping is Exact Name for both nodes and controller. When you first open the Map Animation dialog, any node/controller pairs whose names match exactly are automatically mapped. To change the mapping, remove any existing assignments in the Mapped list (highlight them and then click the -> button), and then choose an alternate method.

Exact Name This maps node to node, by name. If the names do not match exactly, the tracks will not map, and the status line will report how many nodes did not map.

Closest Name Finds a match in the object names, and uses the Controller options (described below) to confirm the match.

For example, if the incoming is R Toe 01 and the choice in the Current list is between Right Index Toe and R Toe Helper, it will look at the controller structure and compare by name, or type or order, and try to determine which node is the closest to the incoming. When the choice is close like this, the status line reports that there was another close match, and highlight the close, but unmapped, nodes in the incoming list in red.

Hierarchy This option turns off the above options. It matches by node order; for example, Bone01>Bone02>Bone03 would map to Leg>Calf>Foot, if Controller is set to Order and the leg is mapped to Bone01. The Hierarchy option ignores the names.

Controller Determines how automatic mapping is performed within nodes:

- Exact Name (The default.) Matches controllers by name, regardless of order. This applies specifically to lists, morph channels, maps, custom attributes, and any other tracks that are listed by a user-defined name that might be reordered for some reason.

- Order This maps by controller order only, regardless of name or type, and it turns the other options off. For example, it will map the first controller in a list to the first controller in a list. If necessary, it “bakes” the animation by creating per-frame keys. If any controllers are not mappable (for example, a Bezier controller getting mapped into a script), the status line will report the error and highlight the node that couldn’t map in the incoming list.
**Type** When on, allows mapping only between controllers of the same type. It prevents mapping between two controllers of different types. For example, a controller such as Noise and its parameters will map only to another Noise controller. Default=off.

**Filters group**

The Filters options are similar to those available in Track View: they enable viewing only certain types of tracks. Filtering is can be a help with large, complex animation setups, because it lets you focus on tracks of specific interest and ignore the rest.

The following information describes the action of filters that are on. Unless otherwise specified, when a filter is off, the track type it applies to is hidden. In some cases, a track will not be hidden because a different filter that is on permits display of that track.

**NOTE** The Incoming list contains only animation tracks that were saved in the XAF file, so it cannot display unavailable tracks. For example, if you don't animate an object’s creation parameters, toggling the Base Objects switch won't change the Incoming list contents.

**Current/Incoming** Determines whether the filters are applied to the Current list or the Incoming list.

- **Lock** When the Lock button is on, the filters are applied to both lists. Default=locked.

When the Lock button is off, only one of these is active at a time, and 3ds Max remembers different sets of on/off values for the filtering parameters.

- **Animated Tracks** Displays tracks that contain animation keys.
- **Include Constraints** Displays constraint tracks, even if they are not animated.
- **Keyable Tracks** Displays tracks that are set to keyable, regardless of whether they contain animation.
- **Unmapped Tracks** When on, hides mapped tracks. When off, all tracks are displayed.
- **Visibility Tracks** Displays visibility tracks.
- **Note Tracks** Displays note tracks. When a note track is mapped, the notes are added to an existing note track in the current scene.
Custom Attributes Displays custom attribute tracks.

Controller Types Displays controller types (names) in the list. For example, the Position X track reads “Position X: Bezier Float.”

IK Controllers Displays any IK controllers.

Modifiers Displays animatable modifier tracks.

NOTE In order for modifier tracks to display in the Current column, the Base Objects filter must also be on.

Base Objects Displays creation-parameter tracks for parametric objects such as Box and Sphere.

Map Parameters Shows map tracks, such as Tiling for Bitmaps and Mix Amount for Mix maps.

Material Parameters Shows tracks for materials; for example, animated Diffuse color values, Opacity, and so on.

Expose World Transforms Displays tracks for world transforms. These let you map all transform animation between two objects using a single track, named Exposed World Transform.

Transforms Enables or disables display of all transforms other than the exposed world transforms. The toggles that follow control display of individual transforms:

- **Position/X/Y/Z** The Position check box lets you toggle display of all Position tracks, while the X/Y/Z check boxes let you toggle display of the track for each axis.

- **Rotation/X/Y/Z** The Rotation check box lets you toggle display of all Rotation tracks, while the X/Y/Z check boxes let you toggle display of the track for each axis.

- **Scale/X/Y/Z** The Scale check box lets you toggle display of all Scale tracks, while the X/Y/Z check boxes let you toggle display of the track for each axis.

Map Track to Track Rollout

Animation menu > Load Animation > Open dialog > Edit Mapping
Animation menu > Load Animation > Open dialog > Load Motion > XML
Animation dialog > Click Yes.

This rollout comprises three list windows. The left (Current) and right (Incoming) show node/controller hierarchies, as in Track View.

Because the Map Nodes group functions apply to highlighted tracks, you can use standard highlighting methods. Click to highlight an entry, Ctrl+click to highlight multiple entries, and Shift+click to highlight a range. Also, in the Current and Incoming windows, you can right-click to open a menu that lets you highlight all tracks (Select All), invert the current highlighting (Select Invert), and turn off highlighting for all tracks (Select None).

In addition, you can use the right-click menu to expand and collapse any track with a - or + icon next to its name.

Interface

Current list Shows animation tracks for selected objects in the scene, using the same hierarchical display as Track View. Unassigned tracks use black characters, while assigned tracks use gray characters.

Status This read-only field shows the number of controllers and the number of nodes mapped.

Mapped list Shows tracks that have been mapped.

< Assigns the highlighted animation track in the Incoming list to the highlighted animation track in the Current list. The assignment then appears in the Mapped list, opposite the corresponding Current list entry.

If the two tracks don’t contain comparable data, nothing happens when you click the button.
-> Removes the highlighted Mapped list entry.

**Incoming list** Shows animation tracks in the loaded XAF file, using the same hierarchical display as Track View. Unassigned tracks use black characters, while assigned tracks use gray characters.

## Retargeting Rollout

Animation menu > Load Animation > Open dialog > Edit Mapping

Animation menu > Load Animation > Open dialog > Load Motion > XML

Animation dialog > Click Yes.

When you map an animation from one rig or object onto another, use this rollout to establish *retarget* references between the incoming nodes in regards to their scale dependency. *Retargeting* means to scale the animation so it matches the objects onto which you are mapping the motion.

You need to retarget only when the size or proportions of the incoming model differ from the size or proportions of the current model.

Retargeting applies to *any kind of animation*, from matching fight choreographies, to changing a weather balloon’s fly-through trajectory over hills and valleys. The down side of this is that essentially you have to set up the scaling relationships by hand; the good news is that the steps are fairly straightforward, and that once you have retargeted, the settings are reusable for all animation mapped between the same two sets of objects.

While retargeting is a general-purpose feature, it is especially useful for transferring animation from one character to another, when the characters are of different sizes, and possibly of different proportions (for example, a human model to a gorilla, or vice versa). You can transfer IK animation onto an FK rig, or vice versa. There are some rules of thumb when you work with mapping character animation:

- In a walk cycle, the root of a character moves, and all other movement is typically rotation. Because of this, usually you want to map the root motion and the rotation tracks, and leave the others alone. The exception to this is when arms or other parts (tentacles?) are animated by IK. When IK is present, you need to take the additional step of mapping and retargeting the IK goals.

- The legs need to reach the “ground,” and feet should not slide.
Because of this, use the legs as the basis of recalculating the scale for the target character.

- Characters are usually symmetrical.
  Because of this, usually retargeting one limb does the trick for both.
  If a character's limbs are not symmetrical, retarget each of them individually.
  If the current model uses forward kinematics, then use the FK Retargeting Extent controls as well.

**Procedures**

**To retarget one character onto another:**

This procedure is not a detailed procedure, but an overall workflow. It assumes you have already saved the incoming character's animation, then loaded it onto the current character, as described in To use the Save Animation and Load Animation commands on page 4104.

**NOTE** If the animation you are saving is unkeyed world-space animation (as opposed to IK or FK), turn off Animated Tracks when you save.

1. On the Map Track To Track rollout on page 4115, map the motion tracks of the incoming character's root to the current character's root. For example, if you are retargeting a Biped on page 4487 onto another, you would map the incoming Biped object's position and rotation tracks onto the current Biped.

2. Map the rotation tracks of the incoming character's limbs onto the current character's limbs.
   There is one exception here: if a hand (for example) is going to use IK in the current scene, either don't map it at all, so you can animate it later, or if you are mapping from an FK model to an IK model, map the Exposed World Transform to transfer the incoming FK trajectories to current IK controls.

3. Go to the Retargeting rollout.

4. In the Scale Origin group, choose both the Incoming and Current root objects.
   If the characters are symmetrical and have the same proportions, you can now choose all the mapped tracks in the Retargetable Nodes list. If the characters are not symmetrical, or their proportions are different, then you need to take further steps.
5 In the Derive Scale Between Chains group, choose the Start and End nodes of both Incoming and Current chains to correspond to either the left or right leg of the character: for example, Thigh to Toe.

Read the Scale Factor that is set on the basis of the two chains.

6 Click Set to retarget the highlighted mapped tracks.

If the two current legs are not the same length, repeat step 5 for the other leg, then choose that leg's Foot (or Toe) node, turn on Enabled in the FK Retargeting Extent group, and choose the top of the leg (for example, Thigh) as the parent to use. Click Set.

7 Save the retargeted mapping file.

8 Click Load Motion to animate the current character, and then close the Map Animation dialog.

Interface

Retargetable Nodes list This list shows the tracks that have been mapped using the Map Track To Track rollout on page 4115. Each of these mappings can be retargeted.

The fields in this list are as follows:

- **Current Mapped Node** Shows the node-to-node mapping, as in “CurrentObject->IncomingObject.”

- **R** When a mapping has been retargeted, this field shows an “X.”
- **Scale (X,Y,Z)**  Shows the current scaling factor for each dimension of the current node.

- **Absolute**  When a mapping uses absolute scaling, this field shows an “X.”

- **Scale Origin (Incoming,Current)**  Shows the incoming and current scale origins for this mapping. If the mapping hasn't been retargetted, this field shows “Scene Root , Scene Root.”

- **Incoming Chain (Start,End)**  If the mapping has been retargeted, shows the incoming chain used to calculate scale.

- **Current Chain (Start,End)**  If the mapping has been retargeted, shows the current chain used to calculate scale.

- **FK Extent**  If a mapped track’s FK extents have been recalculated, shows the parent node used in the recalculation.

**Find**  Enter a name to search for a particular object, then press Enter. 3ds Max highlights matching entries in the list.

**Filter Retargeted Nodes**  When on, the list shows only those mappings that have been retargeted. When off, all mappings are listed. Default=off.

**Mapped Node**  Shows the currently highlighted mapped node. If more than one list entry is highlighted, shows “—Multiple—.”

**Scale group**

- **Absolute**  When chosen, scaling for the currently highlighted mappings is absolute, and based on the XYZ settings in this group alone.

- **Multiply Derived Scale**  (The default.) When chosen, scaling for the selected mappings is based on both the XYZ settings in this group, and calculations from the Derive Scale Between Chains group and the FK Retargeting Extent group (if that is used).

**X/Y/Z**  You can use these fields to explicitly set the scaling factor for the currently highlighted mappings.

**Scale Origin group**

**Incoming**  Choose the incoming object from which to derive the scaling origin. This is a drop-down list obtained from the list of incoming nodes.
Current Click to display a Select dialog and chose the current object from which to derive the scaling origin. The dialog shows all currently selected objects.

Typically, you set these two to be the incoming root node and current root node, whose motion tracks are already mapped.

Derive Scale Between Chains group

Resulting Scale Factor Displays the scale factor derived from the Scale Origin and Incoming/Current Chain settings. Check this value to see that it matches the apparent difference in proportion between the objects or characters you are retargeting.

Incoming Chain These controls set the incoming IK or FK chain to use in calculating the Scale Factor.

- Start Choose the start of the incoming chain. This is a drop-down list obtained from the list of incoming nodes.
  When retargeting character animation, typically you choose the top of the incoming character's leg; for example, the thigh.

- End Choose the end of the incoming chain. This is a drop-down list that is restricted to children of the incoming Start object.
  When retargeting character animation, typically you choose the end of the incoming character's leg; for example, the toe.

Current Chain These controls set the incoming IK or FK chain to use in calculating the Scale Factor.

- Start Click to display a Select dialog and choose the start of the current chain. The dialog shows all currently selected objects.
  When retargeting character animation, typically you choose the top of the current character's leg (using the same side as you used for the incoming chain).

- End Choose the end of the current chain. This is a drop-down list that is restricted to children of the current Start object.
  When retargeting character animation, typically you choose the end of the current character's leg.

If a character's legs are symmetrical, which is usually the case, you only need to calculate the retargeting scale for one leg, and then Set that value to both. If the character's legs are not symmetrical, you need to calculate values for both legs, and also use the FK Extents controls (described below).
**FK Retargeting Extent group**

When the current model uses IK, 3ds Max knows the extent to retarget because it is defined by the IK solution. But if the current model uses FK, you should specify the extent of retargeting. For example, mapping rotation animation from a long leg to a short leg with different link lengths requires that the short leg’s foot be chosen to retarget so it ends up meeting the floor in the same way the long leg does. In order for 3ds Max to know how far up the chain from the foot to do the retargeting, the parent of the desired chain (for example, the thigh) must be specified. By defining the two chains to compare, 3ds Max can adjust the resulting rotations such that the feet don't slide.

When a character’s limbs are not symmetrical, you can also use these controls to keep rotations proportional. First, highlight the current child (for example, a foot or toe) in the Retargetable Nodes list. Turn on Enabled, and then use the drop-down list to choose the upper parent (for example, the thigh) of the limb you are retargeting. Finally, click Set.

**Enabled** Turn on to enable retargeting extents. Default=off.

**Parent Node** Choose the current upper parent of the limb you are retargeting. This drop-down list is restricted to parents of the currently highlighted current object.

---

**Get** Click to set controls in the Scale, Derive Scale Between Chains, and FK Retargeting Extents groups based on the currently highlighted mapping in the list.

If multiple mappings are selected, Get fetches the first highlighted mapping in the list.

**Set** Click to apply the current Scale Factor to the mappings that are currently highlighted in the list.

**Clear** Click to clear retargeting values from the mappings that are currently highlighted in the list.

---

**Save Animation**

Select one or more animated objects. > Animation menu > Save Animation

Track View > Hierarchy/Controller window > Highlight one or more tracks > Right-click. > Save Animation
Save Animation lets you store animation from your scene to disk in the XML Animation File (XAF) format. The XAF file format lets you save and load animation for any number of objects separately from the actual scene.

For a procedure that outlines the basic method of saving and loading animation, see To use the Save Animation and Load Animation commands on page 4104.

See also:

- Saving and Loading Animation on page 4103
- Load Animation on page 4107
- Map Animation Dialog on page 4110

Interface

To use Save Animation, select the objects from which to save animation data, and then choose Save Animation from the Animation menu. Settings in the Save XML Animation dialog apply only to objects that are selected when you save the animation.
File controls  The controls in the upper-left corner of the dialog are standard file-browsing controls.

Animated Tracks  Saves only animated tracks. This is on by default, and should generally be left on.

Include Constraints  When on, includes motion derived from constraints. Available only when Animated Tracks is on. Default=on.

For example, if an object rotates because a LookAt constraint is applied to its Rotation track, then when you save its animation with Include Constraints on, 3ds Max generates rotation keys based on the constrained motion. It does not save the actual constraint. When off, animation accomplished only by constraints, such as the Link constraint, is not saved.

NOTE  This doesn't apply to constraints such as the Path constraint on page 3596. Because this constraint assigns the animation directly to the constrained object, rather than deriving it from the constraining object, Save Animation saves path-constrained animation even if Include Constraints is off.
Keyable Tracks  When on, saves only keyable on page 3864 tracks with controllers, as defined in Track View. Turning this on allows keyless animation tracks to be saved. Default=off.

If both Animated Tracks and Keyable Tracks are on, any tracks that contain animation but are not keyable won’t be saved. You can use this option to avoid saving tracks that aren’t relevant to the scene into which you’re loading the animation. For example, if you want to save constraint data, but not data from a LookAt constraint (because LookAt tends to be specific to the scene), you can turn off Keyable for the LookAt track, and then save with Keyable Tracks on.

NOTE  Animated Tracks overrides Keyable Tracks. If a track is keyable but doesn’t contain any animation data, and Animated Tracks is on, the track won’t be saved even if Keyable Tracks is on.

NOTE  Tracks without controllers, such as nonanimated creation-parameter tracks, won’t be saved even if Keyable Tracks is on. To save a nonanimated creation-parameter track, add a controller, turn off Animated Tracks, and turn on Keyable Tracks.

Segment  Lets you save a specific frame range, as opposed to the entire animation. Default=off.

■ Active Time Range  Click to set the From and To fields to the currently active time range. Available only when Segment is on.

■ Objects Time Range  Click to set the From and To fields to the time range that corresponds to the keys of the currently selected objects. Available only when Segment is on.

■ From  Sets the starting frame for the range to save. Available only when Segment is on.

■ From/To  Sets the ending frame for the range to save. Available only when Segment is on.

Key Per Frame  Saves an animation key per frame, thus “baking” the animation to keyframes.

This can be useful if you are applying a procedural animation, such as a dynamics simulation, to an object that won’t be participating in a dynamics simulation in the target scene.
Increments the number at the end of the file name and saves the animation file with the new name. If the file name doesn't currently end with a number of two or more digits, clicking + appends “01” to the file name (before the extension), and then saves the file.

**Save** Saves the animation using the current file name.

**Cancel** Closes the dialog without saving any animation.

**User Data group**

These controls let you enter user attributes and names. This could simply be notes about the animation file, or they could be actual data for use by custom plug-ins and utilities.

To enter user data, type a value in the Attribute field, press Tab and type a value in the Value field, and then press Enter to add the attribute and value to the list below. These values are saved with the XAF file and can be viewed with the Load Animation dialog.

**Attribute** Enter an attribute name.

**Value** Enter an attribute value. This can be any combination of alphanumeric characters. To add the attribute and value to the file, press Enter while the cursor is in this field.

**Delete User Data** Deletes the highlighted attribute from the list along with its corresponding value.

**Attribute list** Shows all attributes and values in the file. To change a value, click the corresponding attribute in the list to highlight it and place it in the Attribute and Value fields, edit the Value field, and then press Enter. You can also edit the Attribute field, but this creates a new entry.

To remove an attribute, highlight its name in the list and then click Delete User Data.

**Merge Animation**

[Available only as a CUI action]

Merge Animation merges (transfers) animation data from one object to another. Animation data can be transferred from one scene to another, or between
objects in the same scene. Animation data from several objects can be merged at the same time.

**IMPORTANT** The Merge Animation command is available only as a Customize User Interface on page 8249 action; to use it you must first add it explicitly to the user interface. For transferring animation data between scenes, we highly recommend that you use, instead of Merge Animation, the Save Animation and Load Animation functions. See Saving and Loading Animation on page 4103.

Within the Merge Animation dialog, objects eligible for transferring or receiving animation data are called *nodes*. *Source nodes* refer to objects from which animation data can be transferred, while *current nodes* can receive animation data. *Merge nodes* are source nodes that have been mapped to (matched up with) current nodes in the Merge Animation dialog in preparation for merging.

In order for a particular attribute's animation data to be transferred from a merge node, the corresponding current node must have the same attribute. For example, if a merge node has an animated Bend modifier applied to it, the current node must also have a Bend modifier applied to it for the animation data to transfer successfully.

The Merge Animation feature is ideal for transferring animation data between similar hierarchies, such as character structures. In character creation, it is a common practice to name bones for different characters with the character name plus a suffix or prefix that describes the bone. For example, you might have one character called Alien with bones named Alien_Pelvis, Alien_LeftHand, etc. Another character called Chef would have bones named Chef_Pelvis, Chef_LeftHand, etc. The Merge Animation dialog can automatically filter prefixes and suffixes so you can quickly map the merge nodes for complex hierarchies.

**NOTE** If you plan to merge animation data to and from characters, the process will be much easier if you use the same bone-name prefixes or suffixes for each character.

See also:
- Merge on page 7572
- Merging Effects on page 7060
- Replace on page 7578
**Procedures**

To replace the animation in the current scene with the animation from another scene:

1. Load the scene that will receive the merged animation data.
2. Launch the Merge Animation dialog.
3. In the Merge Animation dialog, click Source File to choose the file from which to merge animation data. The objects appear under Source Nodes in the Object Mapping rollout.
4. On the Object Mapping rollout, drag and drop the source nodes to the Merge Nodes column, matching them with the appropriate current nodes.
5. In the Source Time Range group, choose Replace Animation.
6. Specify the source node attributes that will be merged.
7. Click Merge Animation to merge the animation data from the merge nodes to the current nodes.

To insert animation data from one character to another:

The Source Objects and Current Objects entry fields allow you to enter wildcard expressions to filter prefixes and suffixes of node names. The filtered text is ignored by the Auto Name Mapping tool, so complex structures of similarly-named nodes can be mapped quickly. This feature is handy for transferring an animation between character structures, providing the source and current nodes have been named with the same conventions.

1. Load the file with the character to which animation data will be merged.
2. Launch the Merge Animation dialog.
3. Click Source File and choose the animation source file.
4. In the Merge Animation dialog, under Source Objects, use a wildcard expression to specify multiple items that share a set of characters in their names. For example, if the character bones are named `Skater_Head`, `Skater_RFoot`, and so on, enter `Skater*` under Source Objects.
5. Click Refresh for Source Objects.
6. Under Current Objects, use a wildcard expression to filter the current nodes' prefix or suffix. Click Refresh.
7. Click Auto Name Mapping.
Source nodes are placed in the Merge Nodes column, corresponding with current nodes with the same prefix or suffix.

8 Specify whether to replace or paste animation data from the source file. If pasting animation data, the frame times for the merge nodes are added to the current nodes.

9 Specify the source node attributes that will be merged.

10 Click Merge Animation to merge animation data from merge nodes to corresponding current nodes.

To insert animation from one character assembly to another:
For character assemblies on page 254, the Insert Animation feature can be used to merge animation data.

1 Load the file into which the animation data will be merged.

2 Select the character assembly node.

3 On the Modify panel, click Insert Animation. Select the source file from which animation data will be merged.

4 Follow the previous procedure from step 4.

To merge animation data from objects in the same scene:

1 Launch the Merge Animation dialog.

2 Click Source Object, and choose the object from which animation data will be transferred. This object and its hierarchy appear under Source Nodes in the Object Mapping rollout.

3 On the Object Mapping rollout, drag and drop source nodes to the Merge Nodes column, matching them with the appropriate current nodes.

4 Specify whether to replace or paste animation data from the source file. If pasting animation data, the frame times for the merge nodes are added to the current nodes.

5 Specify the source node attributes that will be merged.

6 Click Merge Animation to merge the animation data from the merge nodes to the current nodes.
Interface

The Merge Animation dialog has the following controls.

Source Objects group

Source File  Click to select a source file containing the animation data. Animation data from this file will be merged into the current scene. All objects in the scene are displayed under Source Nodes in the Object Mapping rollout.

Source Object  Selects a source object from within the current scene. If a source object is selected, the Source File selection is ignored.

Merge Animation  Merges the animation data based on settings on this dialog. Before animation data can be merged, Merge Nodes must be listed for their corresponding Current Nodes on the Object Mapping rollout. The progress bar at the bottom of the dialog shows the progress of the merge operation. After merging, this dialog remains on-screen so you can check whether the merge was performed properly before closing the dialog.

Undo Last Merge  Undoes the last merge. If the merge was not performed properly, you can change settings and try again.

Source Time Range group

Replace Animation  Completely replaces existing animation data in the current scene with the animation data from the source file.

Paste to Existing Animation  Appends the source file animation data to the existing animation data based on the following time parameters.

Match Source File Time  Sets the source time range to match the active time segment in the source file.
**Start Time** Start Time and End Time set the frame range to merge from the source file. Start Time sets the first frame in the range.

**End Time** Sets the end frame number to merge from the source file.

**Insert Animation to Frame** Sets the start time in the current scene. Animation data will be pasted into the current scene starting at this frame. Any existing animation data in the current scene prior to this frame will remain the same.

**Relative** Animation data pasted into the scene will change the current scene objects relative to their current status. For example, if an object in the source file is animated to move from the XYZ position 0,0,0 to 12,0,0, the object receiving the animation data in the current scene will start at its current position and move 12 units along the X axis.

**Absolute** Animation data pasted into the scene will replace the current animation data. For example, if an object in the source file is animated to move from the XYZ position 0,0,0 to 12,0,0, the object receiving the animation data in the current scene will start at exactly 0,0,0 and animate to 12,0,0.

**Main Attributes group**

Specify the source file attributes whose animation data will be merged. Current nodes must have the same attributes as merge nodes for the attribute animation data to be merged.

**Transform** Enables selection of Position, Rotation and Scale animation data for merging.

**IK** Merges animation data of IK chains created with IK solvers.

**Position** Merges Position transform animation data.

**Rotation** Merges Rotation transform animation data.

**Scale** Merges Scale transform animation data.

**Modifiers** Merges animation data of modifiers. In order for animation data of a modifier to be transferred, the current object must already have the same modifier applied to it.

**More Attributes group**

Selects additional attributes to be merged from the source file.

**Custom Attributes** Merges animation data of any custom attributes on source objects.
Add NewDefs Adds custom attribute definitions to the current object if it doesn’t have the same definitions as the source object.

Base Objects Merges animation data of parameters at the object base level. For example, if a sphere’s Radius parameter is animated, checking this option will merge the Radius animation data. This option will also merge animation data at an object’s sub-object level, such as the animation of vertices on a spline or Editable Mesh object.

Materials/Maps Merges animation data of materials and/or maps.

Visibility Tracks Merges animation data of visibility tracks.

Object Mapping rollout

Sets up a one-to-one correspondence (mapping) between source objects and current objects. Animation data on objects in the Merge Nodes column will be merged to the corresponding object in the Current Nodes column.

To move objects to the Merge Nodes column, drag them from the Source Nodes column, or use Auto Name Mapping to automatically map objects with the same names or partial names.

Source Objects Allows you to specify wildcard expressions for filtering source objects. Click Refresh to view objects specified by the wildcard expression.
Refresh Refreshes the display based on wildcard expressions entered in the Source Objects field.

Source Nodes Displays the object selected with the Source Object option, and all its children. Objects with keyframed animation are listed in red, and objects with procedural controllers (such as a Noise or Expression controller) are listed in green. The display can be limited with wildcard expressions entered in the Source Objects field.

Current Objects Allows you to specify wildcard expressions for filtering current objects. Click Refresh to view objects selected by the wildcard expression.

Refresh Refreshes the display based on wildcard expressions entered in the Current Objects field.

Current Nodes Displays objects in the current scene. Animated objects are listed in red. Display can be limited by wildcard expressions in the Current Objects field.

Merge Nodes Lists the current objects that will receive animation data from the corresponding object under Current Nodes. To place an object in the Merge Nodes column, drag and drop the item from Source Nodes, or use Auto Name Mapping to automatically map objects with the same or similar names.

Move Up Moves the selected Merge Node up one row.

Clear Selected Clears selected entries under Merge Nodes.

Move Down Moves the selected Merge Node down one row.

Auto Name Mapping Automatically maps source objects to the Merge Nodes column, matching names with current objects. The mapping process filters any wildcard expressions entered in the Source Objects and Current Objects fields. If no wildcard expressions are entered, source objects are mapped only to current objects with identical names.

Display Options group

Show Animated Only Displays animated objects only.
**Indent** Sets the number of characters by which child objects are indented in the display.

**Load Mapping** Loads a previously saved .mnm file. This type of file can be loaded and saved only on the Merge Animation dialog.

**Save Mapping** Saves the current mapping in an .mnm file. The name of the source file and the mapping of source and current objects are saved. This type of file can be loaded only with the Load Mapping option on the Merge Animation dialog.

---

**Animation Utilities**

3ds Max provides a number of utilities, available from the Utilities panel on page 8223, to assist in animating scenes.

---

**Follow/Bank Utility**

Utilities panel > Utilities rollout > More button > Utilities dialog > Follow/Bank

The Follow/Bank utility applies rotation keys to an object that already has a motion trajectory. The settings are similar to those found in the Path constraint. Use this when you have an object for which you've already assigned motion and want it to follow or bank along its trajectory, but don't want to use a Path constraint.

![Follow/Bank utility](image)

*Follow/Bank utility changes the roll of a camera as it follows a path.*

The utility aligns the object's X axis to the direction of motion. To change the orientation, change the pivot orientation in the Hierarchy > Pivot panel before using this utility.

Although many of the settings are the same as in the Path constraint, this utility is not dynamic; you have to click the Apply Follow button each time
you change an object’s animation or the utility settings. When adjusting banking settings, move to the point at which the object is at the sharpest turn, then alternately click Apply Follow and adjust the banking settings to get the right affect at the extreme corner.

**TIP** You can also use an Orientation Constraint to manually control the rotation of the object as it moves through space. While this is not automatic, it allows more fine control on individual frames than other methods.

**Procedures**

**To apply the Follow/Bank utility:**

1. On the Utilities panel, click the More button, and choose Follow/Bank from the list.
2. Adjust the options in the Follow/Bank Parameters rollout.
3. Select the objects you want to follow/bank.
4. Click the Apply Follow button.
   - The objects orient themselves at the start frame, and follow or bank along their trajectories.
Interface

Selected Object group
Displays the name of the current selection. If more than one object is selected, "Multiple Selected" displays.

Apply Follow button
Apply Follow Applies the settings and generates rotation keys. Each time you click this button, rotation keys in the specified range of frames (set in the Samples group) are deleted and regenerated.
Follow Options group

Contains the parameters that specify whether or not to use banking, and the banking settings.

Bank Turn on to cause the objects to bank as well as follow the trajectory.

Bank Amount Adjusts the amount of the banking to one side or the other, depending on whether the value is positive or negative.

Smoothness Controls how rapidly the roll angle changes as an object moves through bends in the trajectory. Smaller values make an object more responsive to subtle changes in the curve while larger values minimize jerkiness.

Allow Upside Down Avoids the situation where an object flips when going around a vertically oriented path.

Samples group

Specifies the range of frames over which rotation keys are generated, and the number of keys to be generated.

Start Specifies the first frame rotation keys are generated.

End Specifies the last frame rotation keys are generated.

Samples Specifies the number of rotation keys to be generated in the specified range.

Close button

Close Exits the Follow/Bank utility.

Motion Capture Utility

Utilities panel > Utilities rollout > Motion Capture button

The Motion Capture utility drives your animation using peripheral devices, such as MIDI keyboards, joysticks, and the mouse. While driving the animation, you can record it in real time.

The motion capture system in 3ds Max is handled in the following way:

1 In Track View, assign motion capture animation controllers to the specific tracks you want controlled by external devices.
2 After assigning the Motion Capture controller, open the Properties dialog for the track and bind the type of peripheral device(s). As an example, the Rotation Motion Capture controller has three rotational axes to which you can bind one device each.

3 After binding devices, adjust their settings and parameters in the lower portion of the Track Properties dialog. These controls vary depending on the type of device.

4 On the Utilities panel, open the Motion Capture utility. You can test and record your motion for any combination of tracks over any range of frames.

The following motion-capture devices are included with 3ds Max:

Mouse Input Device rollout on page 4148
Keyboard Input Device rollout on page 4149
Joystick Input Device rollout on page 4150
MIDI Device rollout on page 4153

Procedures

To assign a Motion Capture controller to tracks:

The first step in using motion capture is to assign motion-capture controllers to the tracks you want.

1 In the Track View hierarchy, highlight the Transform track you want.

2 Choose Controller > Assign.
   The Assign Controller dialog is displayed.

3 Choose Motion Capture (might start with “Position,” “Float,” “Scale,” or other), and then click OK.
   A Motion Capture dialog is displayed. Its title bar includes the name of the object and the track to which the controller is assigned.
   If a Data dialog opens instead, close it, right-click the track name, and choose Properties.
When you assign a Motion Capture controller, the previously assigned controller is maintained as a child of the Motion Capture controller. This lets you continue to adjust the object using standard transform controls, while still making motion-capture control available.

**To bind and adjust devices:**

1. After assigning a Motion Capture controller, determine the type of device that will drive the motion.
   Depending on the type of controller, you might be able to bind one or more devices. For example, a Rotation Motion Capture controller can
have three devices, one for each axis of rotation. On the other hand, a controller for the radius of a cylinder would have only one device to control the radius value.

2 Bind the devices in the Properties dialog for the track.

**To specify a device:**

1 Click the Properties button while the Rotation track is selected. The Properties dialog for rotation motion capture includes three binding buttons (one for each axis.)

2 Click the Y Rotation button. In the resulting dialog, choose Mouse Input Device, and click OK. The lower half of the Properties dialog display controls specific to the new device. Assuming this is a segment that isn’t attached to another object, you want the horizontal mouse movement.

3 Under Mouse Input, choose Horizontal. The Scale spinner lets you adjust the relative effect of the mouse movement to the rotation. Flip reverses the rotational direction with respect to the mouse movement.

**Example: To set up the Joystick controller to move a Free camera:**

You set up the Joystick controller to move a Free Camera around on the XY plane. The Y movement of the joystick will affect the camera’s forward and backward movement, and the X movement of the joystick will rotate the camera. You’ll use Increment Based On Direction to allow the Y movement to be local to the camera rather than to the world.

1 Create a Free camera in the Front viewport.

2 In Track View, assign a Rotation Motion Capture controller to the Rotation track of the camera.

3 Right-click in the Rotation track to display the Motion Capture properties dialog.

4 Click the button beside Z Rotation, and assign a Joystick Input Device.

5 Under Joystick Axis, choose the X option (if it’s not already chosen).

6 Check Accumulate so that the rotation won’t return to zero each time you release the joystick.
Example: To set up the Position controllers of a camera for moving with a joystick:

The rotation of the camera about its world Z axis will be controlled by the X motion of the joystick. You’ll set up the Position controllers of the camera to move the camera forward and back with the Y motion of the joystick.

1. Assign a Position Motion Capture controller to the camera's Position track, and access its Properties dialog.
2. Assign a Joystick Input Device to both the X Position and Y Position buttons.
3. Click the Edit Binding X button, and then choose the Y option under Joystick Axis.
4. Check Accumulate.
5. Click the Edit Binding Y button, and also choose Y under Joystick Axis.
6. Check Accumulate.

The Y motion of the joystick will now affect both the X and Y positions of the camera.

Example continued: To add the increment based on direction options:

If you tested the camera motion at this point, moving the joystick forward or backward along the Y would produce a diagonal motion because the Position tracks would receive equal amounts of X and Y values. Adding the Increment Based On Direction options will change this.

1. Click the X Edit Binding button.
2. Under Increment Based On Direction, click the button beside Controller. A dialog appears with a list of controllers.
3. Find and select the Rotation Motion Capture controller for the camera.
4. Set the Direction option to Z (the local axis along which the direction points).
5. Set the Component option to X (matching the Edit Binding button).
6. Click the Y Edit Binding button.
7. Click the button beside Controller, and assign the Rotation Motion Capture controller.
8. Set the Direction option to Z, then set the Component option to Y.
Open the Motion Capture utility, turn on both tracks in the list, click the Test button, and move the camera while observing it in the Top viewport.

As you move the joystick in the Y direction, the camera moves forward or backward. Moving the joystick in the X direction rotates the camera, but then, as you continue moving the joystick in the Y direction, the camera moves forward and back along its local axis.
Record Controls group

Tests and records your animation. The first three buttons let you control the recording directly, while the Start/Stop button lets you use a MIDI device to control the recording.

**Start** Starts a recording using the values set under Record Range below the Track list.

**Stop** Stops the recording before the Out frame is reached. You can also stop a recording by pressing Esc, or by pressing the right mouse button.

**Test** Tests your motion. No recording takes place. Exit by clicking Test again, pressing Esc, or clicking the right mouse button.

**Play During Test** When turned on, and you click Test, the animation in the scene plays in a loop while you test your motion. Note that tracks in the Motion Capture list that are selected (marked red) won’t play back because they’re waiting for input from the assigned peripheral device.

**Start/Stop** Displays the Start/Stop Trigger Setup dialog on page 4145. You can choose the type of MIDI device that will control the recording.

**Enable** Uses the assigned MIDI device for recording instead of the Start, Stop, and Test buttons.

**TIP** In the Time Configuration dialog, you can reduce the viewport playback speed, test or record at the lower speed, and then reset the speed to normal to view the results.
Start/Stop Trigger Setup dialog

Presets Choose the type of MIDI device. If you choose Media Control Station 2, you can use its buttons to Stop, Play, and Record. (The Media Control Station is a MIDI device containing standard VCR-style playback buttons along with a jog wheel.) By choosing Custom, you enable the remaining spinners in the dialog, where you can set specific channels and note numbers. You can also use Custom to customize the controls used by the Media Control Station.

Channel Specifies the channel to which your MIDI device is assigned.

Note Number The Stop, Play, and Record spinners that follow this label let you specify which note event triggers which function.

■ Stop This note event stops the playback or the recording. On the Media Control Station, this would be the square button. This is the equivalent of clicking the Stop button under the Record Controls group.

■ Play Plays the animation. This is the arrow button on the Media Control Station.

■ Record When this note is sent by itself, it's the equivalent of clicking the Test button under Record Controls. To record the motion capture, you must press both Play and Record at the same time (the equivalent of clicking the Start button under Record Controls). You can press the Play button before or after the Record button and release the Play button before or after the Record button. The recording starts when the button is released.
Tracks group

The Tracks area displays all tracks that have been assigned Motion Capture controllers. You select the tracks that will be affected by the three buttons in the Record Controls group. Click a track to toggle its selection box on or off. Only the selected tracks displaying the red box are affected by the Record Controls group.

You can select the tracks either by clicking them, or by using the All, Invert, None buttons. In addition, you can create named selection sets of tracks. To create a named selection, click the tracks you want, and then enter a name in the Edit field above the track list. To select a previously named set, open the Edit window, and select it from the list. To delete a named set, select it from the list, and then click the Delete button at the right.

**NOTE** A specific track can be in only one named selection at a time.

**All** Assigns all tracks to the Record Controls group.

**Invert** When tracks are selected, assigns the unselected tracks to the Record Controls Area.

**None** Assigns none of the tracks to the Record Controls group.

By default, each track is provided a name consisting of the name of the object followed by a backslash and the name of the parameter. For example,
Sphere01\Angle is an Angle parameter applied to one of the modifiers assigned to a sphere. You can rename the tracks in the Properties dialog, which you can access in Track View, or by double-clicking the track name in the Motion Capture utility. The upper rollout of each Properties dialog includes a Track Name field. Any name entered in the Track Name field appears in the Track list in the command panel, in the title bar of the Properties dialog, and beside the Data track in the Hierarchy list in Track View.

**Record Range group**

<table>
<thead>
<tr>
<th>Record Range:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preroll: 0</td>
</tr>
<tr>
<td>In: 0</td>
</tr>
<tr>
<td>Out: 100</td>
</tr>
</tbody>
</table>

**Live During Preroll**

Specifies the frame range affected by the recording. You can also set a *preroll* range of frames (see below).

**Preroll** Specifies the frame number where the animation begins playing when you press the Start button. If this number is the same or greater than the In number, the Preroll number is ignored. For example, if In: 0 and Out: 200, then a Preroll of -100 would give you 100 frames before the recording started, while a Preroll of 50 would be meaningless. If the range defined by Preroll and Out is larger than the current segment, the segment is temporarily enlarged during the recording.

**In** Specifies the frame number where the recording begins after you click Start.

**Out** Specifies the frame number where the recording ends after you click Start. You can stop the recording before this by clicking Stop.

**Live During Preroll** When this is active, the motion capture is live through the preroll frames. The motion occurs, but isn't recorded. This can cause sudden motion shifts at the In frame because your live motion might not match the animation when you reach the In frame. When this option is inactive, the motion is disabled or frozen until you reach the In frame.
**Samples group**

When the motion data is captured, it’s sampled at a rate relative to the current frame rate, which defaults to 30 frames per second. Increasing the frame rate increases the sample rate. The two radio buttons in this section allow you to choose one or two samples per frame. This is a shortcut that lets you sample at a field rate. If you’re rendering to fields, you don’t need to capture at 60 frames per second. Controllers will interpolate between the samples.

**Reduce Keys** Reduces the keys generated by the motion capture.

**Threshold** The value you enter in the Threshold field constrains how 3ds Max changes the selected track. The difference between the new animation and the original animation, at any frame, will be less than the threshold value. Low threshold values closely match the original animation but may not greatly reduce the number of keys. High threshold values produce the fewest keys but may not match the original animation with much accuracy.

**NOTE** When Reduce Keys is active, there is additional calculation time after each completed recording.

**Mouse Input Device rollout**

Controls animation using the horizontal or vertical motion of the mouse. The available settings include the following:

**Horizontal/Vertical** Specifies which mouse motion drives the animation.
**Scale** Scales the relative effect of the mouse movement to the animation response (Spinner Value: float, 0 to 999,999)

**Flip** Flips the direction of the response relative to the mouse movement. For example, if moving the mouse horizontally to the right produces a clockwise effect on a Rotation controller. Activating Flip will reverse the rotation to counterclockwise.

**Keyboard Input Device rollout**

Lets you assign most keyboard keys to drive the animation.

**Key Assignment group**

Click the Assign button, and then press any key. The assigned key appears in the list at right. Alternatively, you can open the list and select a key from it.

**Assign** Click the Assign button, and then press any key. The assigned key appears in the lower list at right.

**Drop-Down List** You can open the list and select a key from it.
**Envelope Graph group**

Displays a representation of the amplitude curve over time.

**Envelope Parameters group**

Specifies the time over which the envelope of the action takes effect, relative to the key pressing and release.

**Attack** Displays the time it takes after pressing the key for the value to reach its maximum level.

**Decay** Displays the time it takes after having reached maximum for the value to fall to that specified by the Sustain spinner.

**Sustain** After the Attack and Decay, the value specified here is sustained until you release the key.

**Release** After releasing the key, this is the time it takes for the value to fade out to zero.

**Parameter Scaling Area** Sets the scale of the envelope and the range of the output value.

**Time** Specifies the scale of the Attack, Decay, and Release parameters. The value represents the number of seconds contained in 1 unit. For example, if this value is 1.0, then an Attack value of 1.0 equals 1 second.

**Range** Sets the maximum output value of the controller.

**NOTE** This controller ignores the state of the Ctrl, Alt, and Shift keys.

**TIP** Because a single keyboard key can only generate either a positive or negative value, if you want to control both directions of a Bend Angle, for example, use a List controller. First, make sure there’s a standard controller (such as a Bezier controller) assigned first in the list to maintain the center position. Then add two Keyboard Motion Capture controllers to the list (one assigned to one key, and the other assigned to a different key.) Set the range of one to the positive extent and the range of the other to the negative extent.

**Joystick Input Device rollout**

The Joystick Input Device driver was designed for the Microsoft Sidewinder joystick, which contains more controls than the standard joystick. You can use this device driver for standard joysticks as well.
Joystick Axis group

X, Y, Z Specifies which joystick direction drives the animation. (Standard joysticks provide X and Y axes only. The Sidewinder provides the Z axis when you twist the joystick.)

Throttle On the Sidewinder, this is a slider next to the stick.

Scale Scales the relative effect of the joystick action to the animation response (Spinner Value: float, 0 to 999,999)

Flip Flips the direction of the response.

Accumulate When turned off, the joystick position represents an absolute position, and you're limited to the "rectangle" defined by the limits of the
joystick. When the joystick returns to its rest position, the value generated returns to zero. When this is turned on, the joystick represents a change in the current position. Moving the joystick forward, for example, can cause an object to start moving, and it will continue to move until you return the joystick to its rest position.

**Joystick Buttons group**

**Point-of-View Hat (Left-Right, Up-Down)** The Sidewinder includes a mini-joystick on the tip of the main joystick. Specify the direction this joystick controls in the animation.

**1, 2, 3, 4** Specifies one of four buttons in the Sidewinder joystick. They work similarly to the Point-of-View Hat, except that each button increases a direction value only while pressed. When you release the button, the value returns to zero (centered).

**Inc./Dec.** One of three options available only when you choose one of the numbered joystick button options. This option (Increment/Decrement) means that the value is incremented when the button is down, and decremented when the button is up.

**Inc.** When turned on, the value increments when the button is down, and stays at that value when you release the button.

**Absolute** When turned on, the assigned parameters jumps to the value set in the Speed spinner when the button is down, and then jumps back to zero when you release the button. Use this for on/off animations, such as blinking lights.

**Speed** Controls the rate at which the value changes when using either the Point-of-View Hat or the four buttons. When using a button option and the Absolute option, this specifies the value output when you press the button (Spinner Value: float, -999,999 to 999,999).

**Increment Based On Direction group**

Provides controls that let you derive the direction of movement from a Rotation controller. These options are used primarily when you're animating a first-person flythrough (such as when controlling a camera).

**NOTE** The items in this area are only available when you select Accumulate in Joystick Axis.

**Controller** Assigns a Rotation controller from which the direction will be derived.
Clear Removes the assigned controller.

Direction X/Y/Z Specifies the local axis that will be used as the direction. For a Free Camera, for example, this would be Z because the camera points in the Z direction. However, if you had a car that pointed along its Y axis, you'd use Y.

Component X/Y/Z Specifies the edit binding to use. Match this to the Edit Binding button under Device Bindings. For example, if the Y Edit Binding button is selected, choose the Y Component option.

MIDI Device rollout

Controls animation using a MIDI device.
**MIDI Channel group**

Contains 16 buttons. Click to specify the channel to which your MIDI device is assigned.

**MIDI Trigger group**

Defines the type of MIDI event (message) that will drive the motion. There are four options.

**NOTE** When you choose this option, the note number or pitch defines the output value. The value is derived from where the note falls within the Note Range, specified in the Note Range group. When the note is at the bottom of the range, the value takes on the Min value specified under Parameter Scaling. When the note is at the top of the range, the value takes on the Max value from the same area. Anything in between is interpolated between the Min and Max values. (Note that Min doesn’t have to be less than Max.) The generated value will slide around as different keys are pressed. The harder a key is pressed, the faster the value changes. The Speed setting defines how fast, overall, the value changes as keys are pressed.

**Velocity** When you choose this option, the velocity of the note pressed determines the output value. The notes set under Note Range merely specify which notes are valid to press. The value takes on the Min value until a key within the Note Range is pressed. When the key is pressed, the value approaches the Max value based on how hard the key was pressed. (The value actually travels along a parabola toward the Max value.) The Sustain setting defines how long it takes the value to move through the parabola. When you choose Variable, the sustain length is also scaled by how hard the key was pressed.

**Pitch Bend** The MIDI instrument’s pitch bend knob defines the value. The Note Range doesn’t apply in this case and is disabled.

**MIDI Controller** Specifies a note event when you’re hooked up to a different type of MIDI controller than the typical keyboard. For example, if you’re using a MIDI slider box, you would select the MIDI Controller option, and then use the # spinner to specify the note event for the specify slider.

**Note Range group**

**Low Note/High Note** Set these to specify the low and high ends of the note range when the Note option under MIDI Trigger is turned on.
**Parameter Scaling group**

Contains the Min and Max spinners, which specify the range of generated values. See Note and Velocity.

**MIDI Channel Viewer**

Clicking MIDI Channel Viewer at the bottom of the MIDI Device rollout displays a dialog that lets you test your MIDI device to see which MIDI channel is receiving events, and which notes are being triggered.

**MIDI Channel group**

Provides a column of 16 buttons and progress bars representing the 16 MIDI channels. Select the channel from which you want to view note activity. The channel progress bars light up when any channel has an event.

**MIDI Note group**

The 11 Octave buttons let you select which octave you want to view. When a note is played in that octave, a corresponding progress bar lights up in the Note column.

**MIDI Controller #** When using a different type of MIDI controller, such as a slider box, you can specify a note event, and then watch the corresponding progress bar light up when you activate that event. You can find the correct note number by activating the event while watching the Note Number field at the bottom of the dialog.

**Channel** This is one of four text fields that display all of the values being generated by the MIDI device as you activate an event. The Channel field displays the currently selected channel.

**Event** Displays the type of MIDI event being sent. This can be:

- Note On: 9
- Note Off: 8
- Pitch Bend: 14
- MIDI Controller: 11

**Velocity** Displays the velocity, which has a different meaning, depending on the event. For the most common event, a note being pressed, this value represents the velocity at which the key was struck. Other events, however, might generate a continuous value. For example, a pitch bend event transmits the position of the pitch bend.
**Note Number** Displays the corresponding note number for the event. When you're using a non-keyboard MIDI device, such as a slider box, you can use this to identify the note number of a specific slider, for example.

### MACUtilities Utility

Utilities panel > More button > MACUtilities

You can use the Motion Analysis Corporation utility to convert motion data originally recorded in TRC format on page 7765 into character studio marker (CSM) format on page 8543. This allows you to easily map the motion onto a biped.

A MNM (Marker Name) file is needed to determine how to convert the marker names from the incoming data into the CSM naming convention. You can either load an existing MNM file or create a new one using the MNM Creator/Marker Selection dialog.

### Procedures

**To convert a TRC file into CSM:**

1. Click the Browse... button next to Create.
2. Highlight a MNM file in the Select Mapping File... dialog. Click Open to confirm your selection.
   - The MNM file serves as a naming convention reference for the TRC conversion.
3. Click the Browse... button over Convert TRC To CSM.
4. Highlight a folder in the Choose CSM Files Destination Folder... dialog. Click Use Path to confirm your selection.
   - After the conversion, the resulting CSM file is saved in this folder.
5. Turn on Use MNM Filter File.
6. Turn off Use TRC Filename.
7. Click Convert TRC to CSM.
   - A Select Source TRC Files... dialog opens.
8. Highlight a TRC file and click Open to confirm your selection.
   - A Selected Target CSM File... dialog opens.
9 Either highlight an existing CSM file to overwrite or enter a new filename. Click OK to confirm your selection.

Your file is converted into CSM format. You can now load it onto a biped.

Interface

MNM Mapping File Displays the path and name of the chosen MNM file.

Create Launches the MNM Creator/Marker Selection dialog, which creates a MNM file to use in the conversion process.

Browse... Lets you pick a custom mapping file to use in the conversion process.

CSM Output Folder Displays the folder path where the CSM file is generated.

Browse... Lets you pick a folder in which 3ds Max saves the generated CSM file.

Convert TRC To CSM Lets you first pick the TRC file to convert. The resulting CSM file is named after the original TRC file.
NOTE If Use TRC Filename is turned off, a second dialog opens so you can pick an existing CSM file to overwrite or create a new one.

**Options group**

Use MNM Filter File When on, the MNM file is used in the conversion process. Default=on.

NOTE Turn off if the TRC marker names already follow the CSM standard naming convention.

Batch File Conversion Enables you to pick multiple TRC files to convert.

TIP Use this option to save time when you need to convert multiple TRC files.

Use TRC Filename When off, you can customize the resulting CSM filename. When on, the CSM file is named after the TRC file. Available only when Batch File Conversion is off. Default=on.

**Translation Offset group**

Enable Turn on to add an offset to the resulting data's position.

TRC Space/3ds max Space Choose between an offset space relative to the TRC data's root or to your scene.

XYZ Sets the offset value for each position axis.

---

**Camera Tracker Utility**

Utilities panel > Utilities rollout > More button > Utilities dialog > Camera Tracker

The Camera Tracker utility synchronizes a background by animating the movement of a camera inside 3ds Max to match the movement of a real camera that was used to shoot a movie.

**Procedures**

To generate a camera match-move:

1. Open the working scene in 3ds Max.
The scene should have a Free camera to be match-moving, as the tracker does not create one. The scene also should have a set of Point or CamPoint helper objects positioned in 3D to correspond to the tracking features. Optionally install the movie as an environment map-based background image in the match camera viewport. This is needed if you want to render a composite using the match-move or checking match accuracy. This doesn’t automatically display the background image in the viewport. Use Views > Background Image to select the background movie and display it in the viewport.

![Real-world camera films a scene (the white dots will be tracking points).](image)

2. Open the movie file in the Camera Tracker utility and create a set of feature tracking gizmos for each of the tracking features in the scene.
Resulting footage to be tracked and used as a background.

3 Position the Feature Selection box and Motion Search box for each gizmo so that they’re centered on the features and have motion search bounds large enough to accommodate the biggest frame-to-frame move of the features throughout the frames that will be tracked.

4 Associate each tracker with its corresponding scene point object.
The associated scene point objects are set up in 3D space based on real-world dimensions.

5 (Optional) Use the Movie Stepper rollout to set the start and stop frames for each tracker if it’s out-of-view for any of the frames that will be matched. These specify the frame range during which the tracker is visible in the scene and will be tracked as part of the matching process. This mechanism allows you to match a move in which the view passes through a field of features with only some of them (at least six) visible at any time.

6 (Optional) Set up manual keyframes for each tracker at frames in which the feature radically changes motion or shape or is briefly occluded and so might be difficult for the computer to track. If you want, you can do this after a tracking attempt indicates where tracking errors occurred.

7 Perform the feature track using the Batch Track rollout. This is often an iterative process: correcting for tracking errors by tuning start and stop frames or manually repositioning the gizmo and motion search boxes at error frames. When you reposition a gizmo at some frame, you establish a new target feature image and subsequent frames up to the next keyframe will be retracked. You can use the error detecting features in the tracker to step through possible tracking errors. When complete, this process
builds a table of 2D motion positions for each feature. You can save this
to disk using the Save button on the Movie rollout.

8 Choose the camera that will be matched in the Match-Move rollout,
select which camera parameters you want to estimate, set the movie and
scene animation frame ranges and perform the match. This generates a
keyframed animation of the selected camera parameters.

9 Check the match for obvious errors and review the tracker gizmo positions
at these frames. You can manually adjust gizmos at these frames and the
matcher interactively recomputes the camera position.

10 (Optional) Apply smoothing to selected camera parameters and recompute
a compensating match for the other parameters.

The Camera Tracker also has the ability to animate 3ds Max geometry to follow
or match the video by following the movement of a tracker in a 2D plane. For
this type of animation scene measurements aren’t required. Use the Object
Pinning rollout of the Camera Tracker to create this type of tracking.
Requirements for Camera Tracking

Using the Camera Tracker requires some setup, as this topic describes.

To use the camera tracker, you need the following:

■ Movie footage in one of the file formats that 3ds Max supports, such as AVI or MOV. If you have sequential still images, you can use an IFL (Image File List). The file selector can automatically generate an IFL file by selecting the file name and turning on the sequence button. Or use the IFL Manager Utility on page 7845 to create an IFL file.

■ A set of trackable features in the movie, such as wall markers, balls, corner points and so on, for which position measurements are known. The tracker will track most small features with good contrast to their surroundings, have a well-defined position in space, and are unique within their frame-to-frame areas of movement. There must be six or more tracking features in the scene at any one time, at least two of which must be non-coplanar with the others, for example four on the ground and two elevated or three on one wall and three on another. For maximum match accuracy, you should use as many features as you can and select the features that are distributed as widely as possible over the scene. The features don’t have to be in any particular planes.

■ A 3ds Max scene file in which a set of point objects have been created and positioned in 3D corresponding to all the tracking features in the scene. The objects should be point or CamPoint helper objects. The tracker will match-move a selected Free camera in the scene, so you need to have at least one Free camera. You can place and orient it anywhere in the scene.

Camera Tracker: Movie Rollout

Utilities panel > Utilities rollout > More button > Utilities dialog > Camera Tracker > Movie rollout

Opens the movie for tracking. Also provides controls for the display of the movie, including fade display to improve the visibility of the trackers. Provides controls for loading and saving MOT files in which tracker information is stored.
Interface

Movie file

Selects and opens the movie that will be tracked. You can open any image file format that 3ds Max supports. If you use sequential still-image files, you will use an .ifl (image file list) file. You can create the .ifl file using the IFL Manager or using any bitmap selector dialog by choosing Sequence. When you open the movie file, it's displayed in a Movie window.

Display Movie

Reopens a closed or minimized Movie window. You use the Movie window to setup and adjust feature tracking gizmos and to browse through the movie. For more details on working with the Movie window, see Motion Tracker rollout on page 4168.

Show frame

Allows you to step through the movie displayed in the Movie window. Alternatively, use the Movie Stepper rollout, which provides additional browsing controls.

Deinterlace

Causes the tracker to apply a video deinterlacing filter to the movie frames. If the movie comes from a video source and the features you're tracking show marked interlacing, you should deinterlace the video to improve tracking accuracy. If the movie was digitized from film, you should not perform deinterlacing because the results will be less accurate. The deinterlacing is performed temporarily on loaded frames and doesn't affect the original movie file.

Off

Disables deinterlacing. When no filtering is required click this.
Odd Interpolates using the odd lines.

Even Interpolates using the even lines.

Fade Display Fades the movie in a Movie window by 50 percent. Use this to see the tracker gizmos more clearly.

Auto Load/Save Saves the state of a tracking setup and any position data you’ve produced to a special file associated with each movie. Selecting Auto Load/Save Settings causes the tracker to keep this settings file up-to-date automatically as you work in the tracker. You can force a save at any time by clicking the Save button. Whenever you open a movie file in the Camera Tracker with Auto Load/Save on, the tracker reloads the state of the tracking session from this settings file.

With Auto Load/Save Settings on, the tracker constructs the setting file automatically and places it in the same folder as the movie, named with the same prefix as the movie but with file type MOT. If you move the movie file to a new folder, move the MOT file with it so the tracker can find it. You can delete this file if you want to clear the settings or if the file becomes corrupted for any reason.

When Auto Load/Save is turned off, you can open a different movie file either with an empty tracker state or into the existing tracker state or save the current tracker state into a new file. The name of the current tracker file is displayed at the bottom of the Movie rollout.

Save Saves the state of the tracking setup, and any position data produced to the current MOT file.

Save As Saves the current setup into a new MOT file. This file becomes the destination for subsequent Save operations.

Load Load the tracker setup and position data from another file.

Camera Tracker: Movie Window

The tracker gizmo displayed in the Movie window consists of two enclosed boxes, a central pair of cross hairs, and a tracker number.

The inner box surrounds the feature that will be tracked and is called the feature bounds box. The outer box defines the frame-to-frame search and is called the motion search bounds box. You should place the central cross-hair over the feature as close as possible to the point corresponding to the placement of its scene point object. It’s this center coordinate that’s used in
the camera match-move correlation between image feature and scene Point coordinates.

You should make the feature bounds box large enough to enclose the feature and some of the surrounding images enough to give the feature a contrasting background of several pixels.

The motion search bounds defines the area in which the feature will be searched for from frame-to-frame. This bounds box moves with the feature box, so the area is relative to the current feature at each frame. It’s important to estimate this search area well. If it’s too large, the matching process will be unnecessarily slow and there’s more chance of other features in the search area making the search ambiguous; if it’s too small, tracking errors will occur. It might be useful to review the movie that will tracked on a real-time playback device like a video deck and estimate feature moves beforehand. If you set the Max Move/Frame spinner to the maximum move before creating the tracker, its motion search bounds box will be set to accommodate this move for you. You can also adjust this box at any time in the Movie window.

**NOTE** It’s possible to change the search bounds box for different frame ranges in the movie, so you can optimize your search capabilities. See *Keyframes and Position Data* on page 4179.

**Working with the Movie Window**

Displays the current frame of the movie being tracked and any active tracker gizmos for that frame. You can open and close the window using the Display Movie check box in the Movie rollout or minimize it using the standard window title bar controls.

When you first open a movie, 3ds Max sizes the window so it will fit on the screen and this might result in an automatic zoom out if the image is too big.

You can resize the window by dragging its sides or corners. You can zoom around in and out of the window using the tracker gizmo controls.
Working with the Tracker Gizmos

There are several ways to work with gizmos in the Movie window.

- **Selecting:** You need to select a gizmo to work on it. You do this by clicking anywhere inside its bounds in the Movie window or by clicking its entry in the tracker list box in the Motion trackers rollout. The selected gizmo displays positioning handles at the corners of both its bounds boxes. You can also select a gizmo by typing its number on the keyboard. A selected gizmo has click-selection priority in the Movie window. If several gizmos overlap, they make it hard to select and adjust the gizmo you want. You can select it first in the Motion Trackers rollout list; it remains selected for adjustment when you click it in the Movie window.

- **Zooming:** You can zoom in and out on the selected gizmo by pressing the I and O keys, for “in” and “out,” respectively. Each time you press I or O, the window zooms in or out by a factor of 2 and centers the selected gizmo in the window. Pressing R resets the zoom factor to 100 percent whether you have a gizmo selected or not. The Movie window has to be the active window for any keyboard commands to work. You can make it active by clicking it.

- **Tabbing:** You can move among successively numbered gizmos by pressing the Tab key. If the gizmo you’re searching for is out of view, because you’re zoomed in, the image will be repositioned in the window to bring the newly selected gizmo into view. Tabbing while you’re zoomed in provides a quick way to step through the gizmos to check their fine positioning.

- **Positioning:** You can reposition a gizmo by dragging anywhere within its bounding boxes, providing you don’t click one of the eight box-corner handles. You can nudge a gizmo in single increments by pressing one of the arrow keys on the keyboard. The minimum increment that a gizmo will move depends on the zoom factor and the subpixel-tracking level. The increment is the smaller of either a single screen pixel in the current window or the subpixel increment selected. So, if you’re zoomed out two times and the subpixel increment is 1/16 of a pixel, the nudge increment is four image pixels, due to the zoom. However, if you’re zoomed in five times, the nudge increment is 1/16 of an image pixel, due to the subpixel level.

- **Bounds:** You adjust the bounding boxes by pressing and dragging the handles of the box you want to adjust in the selected gizmo. Dragging the handles of the inner feature bounds box adjusts the opposite corner symmetrically to keep the gizmo center fixed.
Typically when setting up tracker gizmos you should create and position them all roughly in a zoomed-out view, then zoom in on one of them, fine-tune its position and bounds, then tab to the next gizmo and repeat.

**Movie Window Keyboard Shortcuts**

You can use the following keyboard shortcuts in the Movie window:

- **I, i**: Zooms in on a selected gizmo.
- **O,o**: Zooms out on a selected gizmo.
- **R, r**: Resets zoom level to 100 percent.
- **Tab**: Selects next numbered gizmo, cycles back to first gizmo after the last.
- **[digit]**: Selects the numbered gizmo, only works for gizmos 1 to 10 (0=10).
- **Arrow Keys**: Nudges the gizmo in the direction of the arrow.

**Camera Tracker: Motion Trackers Rollout**

Utilities panel > Utilities rollout > More button > Utilities dialog > Camera Tracker > Motion Trackers rollout

The Camera Tracker utility's Motion Trackers rollout sets up and controls the image feature trackers. All the trackers created are listed here: showing enable check mark, tracker number, associated scene point object name, and active frame range. To select a tracker, click in the list. Provides controls for subpixel tracking as well.
Interface

On When turned on, the feature will be tracked in the image when the movie is stepped through in the Movie Stepper, or when a full track is performed. An X appears in the tracker list when turned on.

Off When turned off, the tracker will sit at the closest known position prior to the current frame. Because feature tracking is computationally intensive, sometimes it’s useful to disable the trackers you’re not working on to speed up movie stepping.

All Enables all the trackers.

None Disables all the trackers.

New Tracker Creates a new movie feature tracker. This places a feature tracker gizmo in the center of the Movie window and a new entry in the tracker list. The new tracker takes on the parameters currently displayed under Tracker Setup. You can change these parameters after you create the tracker, but it’s often useful to set the Max Move Per Frame parameter prior to creating the new tracker as this automatically establishes an initial search bound for the tracker gizmo.

Delete Tracker Deletes the selected tracker from the list and the Movie window.

Tracker Setup group

Sets up the parameters for the currently selected tracker. Any tracker you create will take its initial parameters from the current values in this group.
Scene object Associates a tracker with a scene point object that corresponds to the image feature in the Movie window. Pressing this button puts 3ds Max into standard object picking mode. When you've selected the object, the entry in the tracker list and the text in the button change to the name of the selected object. You can change the connected object at any time by pressing this button.

It’s recommended that you use point or CamPoint helper objects, although you can use any 3ds Max object. The tracker uses the pivot point of the selected object as the correlation reference point during the match computation.

When you set up a tracking project, you can make the tracker save the setup in a .mot settings file. The association between tracker and scene point object that you set up here is saved as a scene object name. If you reload the movie in the tracker, the object association is reestablished using the object’s name. This means you must be careful to name the point objects uniquely, otherwise you might establish incorrect associations. Further, you must load the working scene in 3ds Max before opening the movie in the camera tracker utility, so the named objects can be found. If you happen to open the movie first, the object names in the Tracker list will all read "<none>". Simply reopen the movie in the tracker and it will establish the connections correctly.

Match weight Sets the camera matching priority separately for each tracker. Use this to improve the match accuracy for features close to where a computer graphics generated element will be inserted. It helps to minimize sliding and jitter in that part of the scene.

The match-move algorithm works by adjusting the camera to minimize the error between the feature objects seen through the camera and their associated feature points in the movie plate. With all weights set to 1, the algorithm randomly distributes the error between all the object projections and their tracking features. If you bump the Match Weight of a tracker, it redistributes
the error in favor of that tracker, reducing the distance between that tracker's feature and object projection, while possibly increasing the error in other trackers. If you bump weights on two or more features, the locking may progressively lessen, since the algorithm distributes the improvements between the high-weight trackers. Use weights of two to six to get a good lock.

**Max Move/Frame** Sets the maximum number of pixels that the tracked feature moves from frame-to-frame over the entire tracking range and establishes an initial motion search bounds box for newly created trackers. You can also set this dynamically by adjusting the motion search bounds box directly in the Movie window.

**Resample on error** You can make the tracker identify possible tracking errors and you can use this during a manual tracking review and during actual tracking to correct errors. Typical sources of error include frame-to-frame jumps greater than the search bounds, image contrast changes, or a feature changing shape over a sequence of frames, such as a corner might if the camera moves by it. The error detector is controlled by measurement thresholds set in the Error Thresholds rollout.

When you place a gizmo on some frame, a keyframe is created and a new target feature image is sampled at that frame for searching in subsequent frames. Turning on Resample On Error causes the tracker to detect errors during tracking. If one is found, it backs up to the last good frame and places a new keyframe there causing a new target feature image to be sampled at that frame and continues tracking from that frame.

**Subpixel Tracking** Usually, an image feature won’t move an integral number of pixels from frame-to-frame. With pixel-level tracking, however, the nearest estimate for a feature center is always at a pixel boundary. This can lead to camera match errors. With subpixel tracking you can zoom in on a feature and position its gizmo within a pixel. This makes the tracker attempt to track at that resolution by up-sampling the target image and search bounds, thereby improving match accuracy.

You can turn on subpixel tracking selectively for each tracker by choosing a level in the Subpixel Tracking drop-down menu on the Motion Trackers rollout. This defines the resolution at which feature tracking is performed in the tracker up to 1/32 of a pixel.

Two things happen when you select a subpixel level:

- The grid over which you can position a tracker gizmo in the image window is adjusted to the new subpixel level. You can position the gizmo can be positioned inside pixels in zoomed views. You can zoom in on a tracker gizmo by selecting it and pressing the I or O key to zoom in or out, respectively.
Feature searching is performed on internally scaled-up versions of the target image feature and portions of the search window. These versions are scaled up in inverse proportion to the subpixel level using bicubic interpolation, which allows the feature tracker to search at this scaled pixel level.

When manually positioning gizmos at keyframes, it’s crucial that you zoom in enough so you can place the gizmo in the center of the feature to the degree of accuracy allowed by the selected subpixel level. If you don’t do this, the tracker won’t be able to track the correct center at the selected resolution.

**TIP** Even though the feature is first tracked to the nearest pixel at whole pixel increments and then tracked at the subpixel level within that one pixel range, the tracking time can increase significantly in proportion to the inverse square of the subpixel level. For this reason it’s suggested that you set the subpixel level to as low as possible. Usually 1/8 of a pixel is adequate for features well distributed around the scene. Use greater levels if the features are fairly close together, or move very slowly within the frame.

You can also reduce feature tracking times by making the inner feature bounds box in the gizmo as tight as you can while still retaining a couple of pixels worth of surrounding contrast. Search times are proportional to the feature bounds box size.

**Track Range**

Use these when a feature moves off-screen or is not visible in the Movie window.

**Set Start** Sets the start of the active frame range for a tracker.

**Set Stop** Sets the end of the active frame range for a tracker.

You use the Set Start and Set Stop buttons in the Setup box together with the Movie Stepper rollout to set the active range. Pressing the buttons will set the start or stop point at the frame currently shown in the Movie Stepper.

**Tracker Keyframes and Position Data**

Any time you manually position a tracker gizmo, such as at the first frame or at some tracking error, you create a special keyframe position. The tracker never attempts to reposition these keyframes, but uses them as start points for the frames that follow them up to the next keyframe. At keyframes, you can adjust the position and the feature or search bounds.
During tracking, the selected feature at a keyframe is sampled and that feature becomes the search target for subsequent frames. Using any adjusted search bounds up until the next keyframe, provides the start point, target feature, and search bounds box for the frames that follow.

The position data for each frame in each gizmo can be one of three possibilities:

- A keyframe defining a new start position, target feature image, and search bounds box.
- A tracked position.
- Unknown.

All frame positions except the first are initially unknown and will be named as tracking proceeds or gizmos are positioned. When you manually set a keyframe, any previously tracked positions following that keyframe up until the next keyframe are deleted and so become unknown. The Complete Tracking button in the Batch Track rollout searches for unknown positions in the currently enabled trackers and tracks those frames. The Check Status button in the same rollout checks for any currently unknown positions as well as tracking errors. See Batch Track Rollout on page 4176.

**Camera Tracker: Movie Stepper Rollout**

Utilities panel > Utilities rollout > More button > Utilities dialog > Camera Tracker > Movie Stepper rollout

The Camera Tracker utility’s Movie Stepper rollout browses through the movie during the tracking phase either to set start and stop frames, to review tracking results or to manually perform a track over a sequence of frames. The Movie Stepper rollout consists of a frame counter, a set of stepper buttons, and some option check boxes.
**Interface**

<table>
<thead>
<tr>
<th>Movie Stepper</th>
</tr>
</thead>
<tbody>
<tr>
<td>Movie frame: 0</td>
</tr>
<tr>
<td>&lt;&lt;</td>
</tr>
<tr>
<td>Off</td>
</tr>
<tr>
<td>Clear tracking to end</td>
</tr>
<tr>
<td>Step key-frames</td>
</tr>
<tr>
<td>Show track</td>
</tr>
<tr>
<td>Live camera match</td>
</tr>
<tr>
<td>Sync animation</td>
</tr>
</tbody>
</table>

**Movie Frame Counter** Advances the Movie window to the designated frame.

**VCR controls** Navigates through the movie in the Movie window:

- **<<** Steps to the start frame of the selected tracker.
- **<10** Steps back 10 frames.
- **<** Steps back one frame or keyframe if Step Keyframes is turned on.
- **>** Steps forward one frame or keyframe if Step Keyframes is turned on.
- **>10** Steps forward 10 frames, either directly or one frame at a time if the Master Track Enable check box is turned on.
- **>>** Steps forward to the end frame of the selected tracker, either directly or one frame at a time if the Master Track Enable check box is turned on.

**Feature Tracking** If turned on, any forward steps will cause frame-by-frame feature tracking to be performed for all enabled trackers with unknown position data at the frames you previously stepped through. You can use this to perform a tracking check while testing bounds settings or to review tracked positions one frame at a time. The tracker also moves the gizmos to previously tracked positions, so you can review tracking results a few frames at a time. If you want, you can force a retrack by nudging a keyframe gizmo back-and-forth which causes the gizmos to drop all subsequent tracked positions up to the next keyframe.
NOTE Make sure this button is turned off if you just want to step through the movie without tracking, such as when browsing through the movie to find and place Start and Stop frames for trackers that come on screen or go off screen during the tracking range.

**Clear Tracking to End** Removes all tracked positions and keyframes from the current stepper frame onward for the currently selected tracker. This is often helpful if you have too many errors and error correcting keyframes at the end of a track and you want to clear them and track to the end again.

**Step Keyframes** Modifies the operations of the single-step buttons in the Movie Stepper. If turned on, the single step buttons step immediately to the next or previous keyframes, allowing you to browse through them quickly. In this mode, feature tracking is disabled.

**Show Track** Displays a visible tracking line in the Movie window for the currently selected tracker. This button shows where the tracker has currently tracked. A red line is displayed for tracked segments, a white dashed line for segments still to be tracked. White dots are centered on each frame position with a green box around each frame position at which you or the tracker create keyframes.

**Live Camera Match** Enabled after you set up the match parameters and select a match camera in the Match rollout. If turned on, the match camera position is recomputed and adjusted as you move gizmos in the Movie window. This can be useful for making corrections to bad match frames by adjusting the trackers or to check the effect of tracker placement on the match computations. This is best done with the nudge arrows. Turn on the 3ds Max Auto Key button to record adjusted match camera positions.

**Sync Animation** Controls whether the scene time slider is advanced in step with the movie frames during stepping. This is sometimes useful if you have the movie set up as an animated background image in the match camera window. Check camera positioning at the same time you check feature positioning. This can slow stepping substantially, so it’s turned off by default.

---

**Camera Tracker: Error Thresholds Rollout**

Utilities panel > Utilities rollout > More button > Utilities dialog > Camera Tracker > Error Thresholds rollout

The Camera Tracker utility’s Error Thresholds rollout attempts to identify feature tracking errors by taking measurements and comparing them to the thresholds that you set up in this rollout. You can use this detection can be
used both during a manual tracking review (see Batch Track Rollout on page 4176) or during actual tracking to correct errors using the Resample On Error control in the Motion Trackers setup rollout on page 4168.

**Interface**

<table>
<thead>
<tr>
<th>Error Thresholds</th>
</tr>
</thead>
<tbody>
<tr>
<td>Match error</td>
</tr>
<tr>
<td>Variance delta</td>
</tr>
<tr>
<td>Jump delta</td>
</tr>
</tbody>
</table>

**Match Error** A sum-of-differences-squared measure in RGB space of the best match in the current frame to the feature target from the previous keyframe. The error shown is a percentage of the maximum possible image difference. Good matches are usually below 0.05 percent.

**Variance Delta** The difference in RGB color variance between the feature target image and the current best match. This measures whether the target and match have similar color ranges and can compensate for mistakes made by the sum-of-differences measure.

**Jump Delta** The tracker computes a moving average for the preceding five frames and measures the difference between that average and the jump in the current frame. If this difference exceeds the current Jump delta threshold, a potential error is flagged. If the threshold is set to five, any jump in the current frame that's five pixels more than the average jump in the last five frames is flagged. This picks up sudden accelerations rather than just large jumps.

You can adjust the thresholds as needed and enable or disabled individual measures in the detector using the check boxes to the left of each measure.

**Camera Tracker: Batch Track Rollout**

Utilities panel > Utilities rollout > More button > Utilities dialog > Camera Tracker > Batch Track rollout

The Camera Tracker utility's Batch Track rollout performs feature hands-off tracking once the trackers have been set up. You can set up a set of trackers, start a batch tracking of them all, and then use the other tools in this panel to check for and review detected tracking errors. This panel also checks for tracking completion.
Procedures

To review and correct tracking errors:

1  Select an error in the list.

2  Browse through the errors in sequence by repeatedly clicking Next, under the list.

3  When you’ve selected an error, the associated tracker gizmo is selected and brought into view and the movie is set to the frame at which the potential error was detected.

4  If there is indeed an error, adjust the gizmo in the Movie window to correct it, and place a new keyframe.

5  If inspection shows that there isn't an error, the thresholds may be set too finely, so try adjusting the associated threshold and running Check Status again. This is often a good way to calibrate the thresholds for your scene, but be careful not to increase them too much and miss a real error.

6  To clear an entry out of the list, click the Clear button. This is basically a cosmetic action that removes items from the list that you've either fixed or determined are not errors while working through the potential errors. If you perform a Check Status again, some of the errors may show up as well.
Interface

**Complete Tracking** Searches for unknown positions in enabled trackers and undertakes tracking for those frames. It performs this optimally, and only tracks the frames for which enabled trackers have no position data.

**Tracking Status group**

**Check Status** Scans for tracking errors and untracked frames. It displays two lines of information underneath it in the Status box:

- **Incomplete** Lists the tracker numbers with untracked frames in their active frame ranges.
- **Errors** Lists the tracker numbers containing one or more tracking errors as determined by the current error threshold settings.

**Tracking Error Review group**

Displays all the potential errors in a list. For each error the list shows a tracker number, error frame and details about the error. The details include a code identifying the thresholds and the error measure.

**Error Codes**

- **Me** Match error threshold exceeded.
Vd  Color variance delta threshold exceeded.

Jd  Jump delta threshold exceeded.

In each case, the number following the code is the actual error measure. You can see how the error measure compares to the current thresholds in the Error Thresholds rollout. If you adjust the thresholds in this rollout and then rerun the Check Status again, the list is refilled with those points in the tracking that exceed the newly adjusted thresholds.

Next  Moves to the next error in the list.

Clear  Clears an entry out of the list.

**Camera Tracker: Position Data Rollout**

Utilities panel > Utilities rollout > More button > Utilities dialog > Camera Tracker > Position Data rollout

This rollout lets you manage position data.

**Interface**

Apply to group

Contains three radio buttons that control which trackers will be operated on by the action buttons below it.

Selected Tracker  Operates on the currently selected tracker.

Enabled Trackers  Operates on all the enabled trackers in the Motion Trackers rollout.

All  Operates on all the trackers.
Clear to End  Clears the position data in the trackers specified in the Apply To group from the current Movie Stepper frame onward. This is useful for clearing out and redoing a portion of the tracking.

Clear All  Clears all the position data in the trackers specified in the Apply To group.

Show Data  Opens a text window that displays the position data for the trackers specified in the Apply To box. The display includes some title lines showing the tracker number and associated tracking object followed by comma separated columns of numbers for the position data one row per frame. All rows contain at least three columns: frame number, X position, Y position. Keyframe frames also contain another eight columns: feature bounds left, top, right, and bottom, and Search bounds left, top, right, and bottom. The coordinates in decimal pixels show any subpixel tracking as decimal fractions. The text window is a standard MAXScript source editor and you can copy, edit or save the contents to file.

Export  Creates a text file containing position data for the trackers specified in the Apply To group. Pressing this button displays a standard Save File dialog asking for the location and name of the file you’re creating. The file type defaults to .csv, the comma-separated value format readable by Excel and other data processing applications. The format of the data is exactly as for the Show Data command described previously.

Camera Tracker: Match Move Rollout

Utilities panel > Utilities rollout > More button > Utilities dialog > Camera Tracker > Match Move rollout

The Camera Tracker utility's Match Move rollout automatically generates a camera animation by correlating the 2D position data of the movie features gathered during the tracking phase with the associated 3D feature points in the 3ds Max scene.
**Interface**

<table>
<thead>
<tr>
<th>Match Move</th>
</tr>
</thead>
<tbody>
<tr>
<td>Camera: none</td>
</tr>
</tbody>
</table>

**Match**

- **FOV**
- **Roll**
- **Pan**
- **Tilt**
- **Track H**
- **Track V**
- **Dolly**

**Match Range**

- **Movie start:** 0
- **Animation start:** 0
- **Frame count:** 101

**Reset Ranges**

**Animate Displays**

- **Generate Keyframes**

**Max pixel error:**

- **Show errors**

**Camera** Enters an object-picking mode for you to select the camera that you will match-move. You can either select the camera directly in the scene or press H to open the Select Objects dialog on page 210. Once selected, the camera name is placed in the picker button, and other buttons and controls are enabled in the utility. The selected camera is remembered in the MOT settings file and restored on reopening the movie in the camera tracker. As with the tracker point scene objects, the camera name is stored and used when reloading, so make sure it’s unique. The camera selected must be a Free camera. It can be at any position and orientation in the scene.

**Match group**

Lets you choose which camera parameters will be estimated during the match-move. Those parameters turned off will be derived from the current Camera animation or position, so it’s possible to pre-position or pre-animate.
the match camera with known moves or parameter settings and have the matcher estimate just the missing parameters. The accuracy of the estimation process increases substantially as the number of parameters that need estimation decreases.

**FOV** Camera FOV (field-of-view).

**Pan** Rotation about the local camera Z axis.

**Tilt** Rotation about the local camera X axis.

**Roll** Rotation about the local camera Y axis.

**Dolly** Movement along the local camera Y axis.

**Truck-H** Movement along the local camera X axis.

**Truck-V** Movement along the local camera Z axis.

### Match Range group

Let’s you set the range of frames that will be matched to set up the relationship between the movie frames and the 3ds Max scene animation frames. By default, the start frames are both set to zero and the frame count is set to the smaller of the number of frames in the movie or the scene animation. Setting a different Movie Start or Animation Start frame lets you position the movie frame range relative to the animation frame range. The position data for a match will be taken from the tracker frames starting at the Movie Start spinner value and the camera will be matched and animated starting from those frames.

**Movie Start** Sets the start of the range to be matched in the movie.

**Animation Start** Sets the start of the range in the animation. Use this if the animation range is different from the movie range.

**Frame Count** Sets the number of frames to be matched.

**Reset Ranges** Reloads the maximum frame number and count ranges into the match range spinners from the current movie and 3ds Max scene settings. This is useful if you change the animation frame range in the scene while the tracker is open.

**Animate Displays** Controls whether the 3ds Max viewport appears and if the Movie window updates frame-by-frame to show the match results. This display update can be very time-consuming, so it’s often best to leave this turned off and review the match results by looking at the Camera function curves in
Track View or by stepping through the 3ds Max animation a frame at a time after the match.

**Generate Keyframes** Generates keyframes for the estimated parameters on each frame.

**Match-Move** Starts the match process.

**Max. Pixel Error** Displays the running maximum tracking error and frame. The error is shown in pixel fractions, and gives the largest distance between any feature and the viewed position of its associated tracking object over all the frames matched. You can use this to give a general estimate of how good the match is and the frame to investigate if errors are problematic. The pixel error display also interactively updates as you nudge tracker gizmos in Live Camera Match mode, showing the current maximum match distance for the camera; see Movie Stepper Rollout on page 4173.

Note that this error might be exaggerated when you employ match point weighting, as this tends to distribute the errors toward the nonweight points.

**Show Errors** Opens a text window containing a list of the maximum errors for each of the matched frames, so you can look over the whole set of match frames and identify which frames to check.

**Camera Tracker: Move Smoothing Rollout**

Utilities panel > Utilities rollout > More button > Utilities dialog > Camera Tracker > Move Smoothing rollout

Because the match-move algorithm is not always exact and is highly susceptible to field measurement error or feature tracking errors, and because the match for each frame is computed independently, the results can be “noisy”, particularly if field of view is estimated. In match-move situations where the real camera performs smooth moves, it might be useful to filter the match results to eliminate this noise.

You use the Move Smoothing rollout to control and perform these smoothing operations after a match has been created.
**Interface**

**Channel To Smooth group**

Lets you choose which parameter or set of parameters to smooth. You can choose to smooth the entire Rotation or all the Position tracks at once, or you can smooth individual parameters or axes.

**Rotation** Pan, Tilt, and Roll.

**Position** Dolly, Truck-H, and Truck-V.

**FOV** Camera FOV (field-of-view).

**Pan** Rotation about the local camera Z axis.

**Tilt** Rotation about the local camera X axis.

**Roll** Rotation about the local camera Y axis.

**Dolly** Movement along the local camera Y axis.

**Truck-H** Movement along the local camera X axis.

**Truck-V** Movement along the local camera Z axis.
Smooth Type group

**Straight line average** Causes Move smoothing to generate a straight line average for each of the selected parameters. This is useful when you know a parameter is fixed, but don’t know its actual value. Examples might include field-of-view or vertical position. Use the camera matcher to initially estimate the parameter, then construct a straight line average fit and rematch the remaining parameters.

**Low pass filter** Causes Move smoothing to apply a low-pass filter to the selected parameters, eliminating high-frequency noise.

**Smooth amount** Implements smoothing using a Gaussian low-pass filter whose width and variance are controlled by the Smooth Amount spinner. Increase this value to increase the smoothing.

Smooth Range group

Controls the range of frames over which the smoothing will be performed.

**Match-Move Range** Applies the smoothing to the range of animation frames specified in the Match Move rollout. This allows you to break up a match-moving job into several frame ranges. Use this to isolate and experiment on a troublesome range of frames, without disturbing other satisfactory frames.

**All Frames** Applies the smoothing to all the keyframes in the selected parameters.

**Rematch After Smooth** Controls whether a compensating match-move is performed after the filtering. If this is turned on, the parameters that were smoothed are disabled in the Match rollout and another match-move is performed. Performing this rematch again is advised because it adjusts the other camera parameters to compensate for the smoothing and often results in a smoother estimation for the unsmoothed parameters.

**Smooth** Performs the move smoothing based on the smooth type, range, and amount settings. If this button is disabled, no current match camera is assigned.

Camera Tracker: Object Pinning Rollout

Utilities panel > Utilities rollout > More button > Utilities dialog > Camera Tracker > Object Pinning rollout

Object Pinning lets you use the 2D image feature tracking data to directly animate objects in the 3ds Max scene. This is useful for replacing moving
features in the scene with 3D objects when the movement is approximately planar.

After the tracking data is created, you can use this function to do such things as synchronizing the movement of 3D objects with feature movements in the background movie. If the 3D objects directly cover the background features, they will appear to replace them. For example, you could take the video of a juggler juggling balls and replace the balls with 3D balls of fire or synchronize the movement of an animal’s head with a 3D jaw to create talking animal animations.

**Procedures**

**Example: To create a juggler juggling 3D balls of fire:**

This assumes you already have a video of a juggler. Otherwise, find a juggler and a video camera.

1. Load a video of a juggler.
2. Create tracker gizmos to associate with the juggling balls.
3. Use the Movie Stepper to track the gizmos.
4. Go to Object Pinning and choose the tracker.
5. Under Object To Pin, associate an object with a tracker. In this case, create a 3D ball of fire using fire or an animated map to generate the fire.
6. Adjust the Pin Range, and then click the Pin button to move the object to follow the tracker.
Choose Tracker Shows all the current trackers as set up in the Motion Trackers rollout. Use this to select the tracker whose feature movements you will use to control the pinned 3ds Max object. The feature must have been tracked already over the frames you want to use, with the Track and/or Movie Stepper rollouts. Note that the accuracy of the pinning is determined by the accuracy of the match, so subpixel tracking is highly recommended.

Object To Pin Lets you choose the object in 3ds Max scene for pinning and animating. By default the tracking object associated with the selected tracker is preloaded into this button. You can use this picker if you wish to pin a different object.

Pin Range group

Movie Start The movie frame from which to start using tracked feature positions.

Animation Start The frame in the 3ds Max animation at which to start keyframing the move of the pinned object.

Frame Count The number of frames to animate. There must be enough tracked positions in the selected tracker to cover this number of frames.
**Reset Ranges** Reloads the maximum frame number and count ranges into the above spinners from the current movie and 3ds Max scene settings.

**Pin Space group**

Lets you select the plane of motion in which the keyframed pinning will occur.

**Screen** Moves and animates the pinned object in the plane of the screen at its current depth in the scene. This is equivalent to dragging an object around in the Screen reference coordinate system in 3ds Max.

**Grid** Moves and animates the pinned object in the plane of the currently active grid. This lets you set up an arbitrary plane of motion for the pinning by constructing a grid helper object in the desired place and making it the active grid. If you don't have a grid helper set up and active, the pinning will occur on the 3ds Max Home Grid.

**Pin Mode Group**

Lets you choose between two different pinning modes: absolute and relative.

**Absolute** Places and moves the pinned object exactly over the tracked feature. If combined with grid space, the object is also placed and moved directly on the active grid plane.

**Relative** Leaves the pinned object at its current position in space and moves it so that its projected position relative to the tracked feature remains the same throughout the pinning frame range. This makes it possible to animate an object that you don't want placed exactly over a feature, or to animate an object using several features in successive frame ranges. (For example, a computer generated jaw can track an ear for some frames, then a nose for others in a talking animal shot). If combined with grid space, the object is not moved onto the grid plane, but keeps its height above the grid and is moved parallel to it.

**Pin** Performs the actual pinning, moves the object to follow the selected feature and places a keyframe at each frame in the pin frame range. As with the other keyframing operations in the tracker, you can undo a pin using the 3ds Max Undo function. You might also find it useful to perform keyframe reduction afterwards in Track View.
Camera Tracker: Troubleshooting

This topic describes some common problems you might encounter when using the Camera Tracker, and gives suggestions about how to fix them.

Feature Tracking Halts Immediately

If the feature tracker attempts to match the first couple of frames but halts immediately, check these steps:

1. One of the enabled error thresholds might be set too low. Perform a Check Status in the Batch Track rollout and look at the reports in the Tracking Error Review list. Also try disabling the thresholds in the Error Thresholds rollout one at a time and see if this fixes the problem. Adjust the problematic threshold as needed. You can also disable error threshold checking altogether by turning off the Resample On Error check box in each of the trackers.

2. Make sure the search bounds box for each tracker is big enough to accommodate the frame-to-frame motion of the feature. This needs to be at least big enough to enclose the moved feature and the surrounding contrast area you’ve selected in the feature bounds box.

3. Make sure the scene objects are associated correctly with their trackers. You can verify this by checking the entries in the list at the top of the Motion Trackers rollout. If there is an object associated, you will see its name in the list entry, if not you will see “<no object>”. If you open a movie file for which you have previously set up trackers in the camera tracker before you open the associated 3ds Max scene, the objects won’t be associated with their trackers. You should make sure the correct 3ds Max scene is open then close and reopen the movie file in the Camera Tracker so that it can now find the scene objects.

4. If you have inadvertently swapped the scene objects for one or more pairs of trackers, the match-move can’t find a solution.

Repeated Match-Move Errors

If you get repeated camera match-move errors, here’s a list of things to check:

1. Make sure there are at least six features actively being tracked at the error frame and that at least two of them are a good distance out the plane of the others.
2 Check the tracker gizmos in the Movie window around the frame on which the error occurs to ensure that no obvious feature tracking errors exist.

3 If you’ve disabled any parameters in the Match section of the Match-Move rollout prior to a match-move, the camera being matched must be already set correctly in the scene for those parameters. For example, if you disable roll and FOV, you must already have set the camera to the correct FOV and roll orientation, either directly in 3ds Max, or as a result of a previous match-move. The matching algorithm uses all the “fixed” camera parameters to compute the ones being estimated and simply won’t work if they’re fixed at incorrect values.

4 You may know that some of the camera parameters don’t vary during a match sequence, but you aren’t sure of their values. One approach to this situation is to enable all parameters for an initial match and then apply a straight-line average filter to them in the Move Smoothing rollout. This automatically disables them in the Match section and with luck sets them at a good estimate of the fixed position.

**Dynamics Utility**

Utilities panel > Utilities rollout > More button > Utilities dialog > Choose Dynamics.

The term *dynamics* refers to a system of controls that generate keys to produce animation that simulates real-world physics. For example, using standard keyframing techniques to animate a bouncing ball, you create keys that move the ball down to the floor, squash the ball, move the ball back up, and so on.

Using a dynamics system, you assign physical properties to the ball and the floor (such as friction or amount of bounce), specify which object will collide against another object (for example, the ball with the floor), place an effect (such as gravity), in the scene, and then calculate a solution over a range of frames. The result is a number of keys that produce an animation in which the ball drops due to the gravity effect, collides with the floor and reacts naturally based on its surface characteristics.

**NOTE** As of 3ds Max 5, the preferred tool for dynamics simulation is reactor on page 4219, available from the Utilities panel. The reactor feature lets you control and simulate complex physical scenes with ease. reactor supports fully integrated rigid and soft-body dynamics, cloth simulation, and fluid simulation.
Objects and Space Warps Used to Create Dynamics Simulations

A very basic simulation would involve creating a sphere and a gravity space warp, adding the sphere to a new simulation, assigning gravity as an effect on the sphere and solving the simulation. The result is that the sphere falls under the force of gravity.

You can use dynamics objects on page 841, dynamics space warp deflectors (PDynaFlect on page 2941, SDynaFlect on page 2948, and UDynaFlect on page 2951), and space warp forces such as Gravity on page 2923 and Wind on page 2926 to add complexity to a simulation. You can use a particle stream from a particle emitter as a force on an object: the particles can collide with and be deflected by the object, as well as move it. You can attach special dynamics objects to objects, such as Spring on page 849 to simulate the effects of a spring.

You can combine effects: Wind, gravity, a spring object, collision, particle deflection and collision, as well as surface properties such as friction, can all work on an object in a simulation. For a full understanding of what dynamics can do, explore this topic and areas of 3ds Max that pertain to dynamics.

Dynamics-Specific Areas in 3ds Max

The Dynamics Utility (this topic)

The Dynamics Utility is the main control center for dynamics simulations. You specify which objects are used in the simulation, what their interactivity is with each other and with the effects in the scene. The simulation is then "solved," generating the keyframes.

The effects of collisions between objects depend on the velocity of the objects and their properties. For collision to work between two objects, each object must have the other object assigned for collision. For example, when bouncing a ball, both the floor and the ball are assigned collisions.

The Material Editor: The Dynamics Properties rollout on page 6062 in the Material Editor lets you assign the dynamics properties to the surface of an object, like friction and bounce. Using a multi/sub-object material, you can have different surface properties at the face level of any object.

NOTE You can override material surface dynamic properties with controls on the Edit Object dialog on page 4205 in the Dynamics utility.

Dynamics Objects, Particles and Dynamics, Dynamics Interface: Special objects like Spring and Damper, Space Warp forces like Gravity and Wind, as well as Space Warp deflectors like PDynaFlect can all influence a dynamics simulation.
You must create these objects and space warps first in other areas of 3ds Max before you can use them in a dynamics simulation. See the following topics for details on their creation and use:

- Create panel > Geometry > Dynamics Objects on page 841
  You can use the Spring and Damper objects for dynamics effects.

- Create panel > Space Warps on page 2887 > Particles and Dynamics.
  Effects (forces) are special space-warp objects that emulate natural phenomena, such as wind or gravity. In a dynamics simulation, you must place gravity in the scene if you want the objects in your simulation to fall.

- Create panel > Space Warps on page 2887 > Dynamics Interface.
  The Dynamics Interface space warps can cause particles to deflect from and affect an object in a simulation.

**Combine Keyframed Objects in a Simulation:** Keyframe an object and have it interact with other objects in a dynamics simulation by turning on the This Object is Unyielding check box in the Edit Object dialog for the keyframed object. Objects can bounce off of a keyframed sphere for example.

**Dynamics Controller:** When a Dynamics simulation is solved, a new list controller is created that holds both the generated dynamics keys and the original keys. This allows you to restore your original keys, if necessary. Undo is not supported by Dynamics.

For example, if a sphere is bouncing in a Dynamics simulation, and the sphere already contains position keys from a previous animation, the following tracks display in Track View:

- Transform
- Position
- Dynamic Position Controller
- Old Position
- Rotation
- Dynamic Rotation Controller
- Old Rotation

**Procedures**

**Example: To create a basic simulation of bouncing boxes:**

1. Create a thin box in the Top viewport.
   Have the box almost the same height and width as the viewport. This will act as the ground plane.
In the Front viewport, create six small boxes above the "ground" box. Position some of them to collide with each other when they fall.

On the Create panel > Space Warps > Forces > Object Type rollout, click Gravity.

Drag in the Top viewport to create a Gravity gizmo.

On the Utilities panel, click Dynamics.

On the Dynamics rollout, click New. Dynamics00 appears in the Simulation Name field.

Click Edit Object List. The Edit Object List dialog displays.

Select all the boxes in the dialog and click the > button, then click OK. All the objects are moved to the Objects in Simulation list on the right side of the dialog.

On the Dynamics rollout, click Edit Object. The Edit Object dialog displays.

In the list under Object, choose Box01.

Turn on Dynamics Controls group > This Object is Unyielding.

Click Ok to close the Edit Object dialog. The "ground" box won't move when the other objects collide with it.

On the Dynamics rollout, in the Effects group, turn on Global Effects.

Click Assign Global Effects, select Gravity in the dialog and click > (right arrow), then click Ok. This assigns gravity to all objects in the simulation.

On the Dynamics rollout, in the Collisions group, turn on Global Collisions.

Click Assign Global Collisions, select all the boxes in the dialog and click > (right arrow), then click OK. Collisions are active for all the boxes.

Turn on Update Display with Solve, and then click Solve. In the viewports the objects fall and collide with each other and the ground plane.
18 Turn on the Auto Key button, move the time slider to frame 15, and then select and move the “ground” box upward along the Z axis. The ground will "move" during the simulation.

19 Click Solve.

The keyframed "ground" box moves up and collides with the boxes. The ability of a keyframed object to be part of a simulation is one of the useful features in 3ds Max. You could use this capability to strike a ball with a bat, for example.

For further experimentation, create a spring object in Create panel > Geometry > Dynamics Objects and attach the ends of the spring object to two of the boxes and then solve the simulation. The spring will stretch and follow the bouncing boxes.

You can use the space warps in Create panel > Space Warps > Dynamics Interface, such as SDynaFlect (Spherical Dynamics Deflector) to cause a particle stream to "push" an object in a dynamics simulation.

To remove the dynamics tracks and restore the original animation tracks in Track View:

When you solve a dynamics simulation, 3ds Max creates a list controller that holds both the generated dynamics keys and the original keys. This lets you easily restore the original keys. Undo is not supported by Dynamics.

To layer simulations, reverse this method. In other words, after you’ve solved the first simulation, copy its controllers to the old tracks, and then set up the next level of the simulation. The new simulation will base its actions on the previous one instead of overwriting it, as it normally does. You can repeat this as many times as you like to layer simulations *ad infinitum*.

Since Undo is not supported by Dynamics, you can also use Hold and Fetch in its place.

1 In Track View, open the Position track for an object animated by a dynamics simulation.
2 Select the Old Position track, and click Copy Controller on the Track View toolbar (the second button from the left).
3 Select the Position track (the parent), and click Paste Controller (to the right of Copy Controller).
4 Click OK in the Paste dialog.
The two sub-tracks and the Position parent track are replaced by a single Position track containing the original keys that were in the Old Position track.

Repeat the above steps with the Rotation track.

To set up dynamics:

1. Assign materials to the objects included in the simulation and adjust the surface characteristics in the Dynamics Properties rollout of the Material Editor. (For a bouncing ball, you'd use this to create a rubber-like surface.)

2. If you're using a linked hierarchy, set the Move and Rotate locks in the Hierarchy/Link Info panel to limit the motion and rotation of the linked objects.

3. Create space warp effects in the scene where needed. (For a bouncing ball, you'd need a Gravity space warp.)

4. Use the Dynamics utility to create a new simulation. Specify which objects are included in the simulation, which effects influence which objects, and which objects should collide with which. (For the bouncing ball, the ball and the floor are in the simulation because one collides with the other. You assign the ball the floor to collide with each other, and assign the gravity effect to the ball.)

5. Use the Dynamics utility to specify the range of frames to which keys will be generated, and to calculate the animation and generate the keys. (In the case of a bouncing ball, a number of position and rotation keys are generated for the ball.)

6. Play the animation to see if the effect is what you were looking for. If one or more objects fly off into space, or move through objects they should have bounced off, it's likely that you need to increase the Calc Intervals Per Frame value.

To reduce the number of keys generated by the Dynamics utility:

When you solve a dynamics simulation, Position and Rotation keys are generated at every frame of the specified range for every object affected in the simulation. Not only does this result in an excess of keys for later editing, but it can increase the size of the .max file tremendously. The following steps show how to reduce the number of keys using Track View.

1. After solving the simulation, check the animation to make sure it's what you want, and then save that version of the scene.
2 Deselect every object in the scene.

3 In the Dynamics panel > Objects in Simulation group, click the Select Objects In Sim button.
   All objects included in the simulation are selected.

4 Open a Track View window, and then set its filter to show Animated Tracks Only and Selected Objects Only.

5 Right-click the top object in the Hierarchy list (Objects), and choose Expand All.
   Track View now shows all tracks in the simulation that have keys.

6 Go to Edit Time display mode and select all of the tracks containing keys
   (or right-click over the hierarchy, and choose Select All).

7 Double-click any key to select all keys in all tracks.

8 Click the Reduce Keys button, set the Threshold to what you want, and
   then click OK.
   All selected keys are reduced.

9 Save the reduced version of the scene either under a new name, or by
   replacing the original file.

To use linked hierarchies in a simulation:

When linked hierarchies are included in your simulation, you must set locks
for the children in the simulation to confine the dynamics results to specific
axes. Do this on the Hierarchy panel > Link Info > Locks rollout on page 3788.

The Locks rollout contains three rows of check boxes affecting the XYZ axes
of the three possible transforms: Move, Rotate, and Scale. The Scale transforms
are ignored, and only the Move and Rotate locks are used. When a check box
is turned on, that axis of the specific transform is locked.

When you manipulate a forward-kinematics hierarchy directly using the Move
or Rotate tools, you might not bother with the Link Info locks, because you
can specify axis constraints using the X, Y, Z, and XY buttons in the toolbar.
However, when you use that same hierarchy in a dynamics simulation, where
there are several forces at work (gravity, wind, collisions), the only thing that
maintains the linkage between the objects is the locks you set in the Link Info
> Locks rollout. As a result, no matter what combination of Move and Rotate
locks you use, you’ll always want at least one Move lock in place, or your
objects won’t really be linked.
The following lists all of the combinations of Move and Rotate locks that make sense within a dynamics simulation, and the effect on the link of such combinations. An asterisk (*) indicates those combinations that are more typically useful.

The format of this list is as follows:

X=check box on.
O=check box off.

One group of settings is made up of the three Move check boxes over the three Rotate check boxes. Here's an example:

XXO=X and Y Move check boxes on, and Z off.
OXO=Y Rotate check box on, and X and Z off.

1 1 Move Lock: Turn on any single Move. (This is like a long pin sliding in a loose, long slot.) The joint can transmit force in one direction only. The objects can slide with respect to each other in two directions and rotate freely.

2 2 Move Locks: Turn on any two Moves. (This is like a sliding ball joint; a freely rotating joint at the end of a sliding shaft, which can slide and rotate in a hole.)

3 * 3 Move Locks: Turn on three Moves. (This is like a ball joint, or the theoretical "pin joint" of the statics and dynamics texts, in that it transmits any force but never transmits any torque.)

4 1 Move + 1 Rotate (unique): Turn on any one Move and any one Rotate, but not in the same column. (This is like two long pins, parallel, sliding in a single long slot.) The joint can transmit force in one direction only and restrain rotation about the axis of the "pins." This combination is of limited application.

5 2 Moves + 1 Rotate (matching): Turn on two Moves, plus one Rotate turned on that's in the same column as one of the selected Moves. (This is the same as 1 Move + 1 Rotate, above, except that the pins can no longer slide vertically in their slot.) If the assembly rotates so that one pin travels further into the slot, the other must ride higher in the slot. This is of limited application. The possible check box combinations are:

XXO XOX XOX OXX OXX OXX OXX OXX OXX OXX OXX OXX OXX OXX

6 * 2 Moves + 1 Rotate (complementary): Turn on two Moves, plus one Rotate that's not in the same column as any of the selected Moves. (This is a sliding universal joint like the splined output shaft between the
automatic transmission of a rear-drive car and the drive shaft.) It can transmit torque and constrain translation in two directions, both orthogonal to the axis of rotation. The possible check box combinations are: \textit{XOX XXO OXX OXO OOX XOO}

7 \textbf{3 Moves + 1 Rotate}: Turn on three Moves plus one Rotate. (This is a universal joint without the sliding.) It’s typical of automotive applications where the rear axle is located with the trailing drive shaft. This is an uncommon application.

8 \textbf{* 1 Move (complementary) + 2 Rotates}: Turn on one Move that’s complementary to two Rotates. (This is like a hockey puck on ice.) The joint can slide anywhere on a plane, but cannot fall or tip, and it cannot leave the surface of the plane. The possible check box combinations are: \textit{XOO OXO OXX OXO XXO}

9 \textbf{2 Moves (one complementary) + 2 Rotates}: Turn on two Moves, one of which is complementary to one of the two Rotates that are selected. (This is like a hockey puck with a nail through it, and the nail is sliding along a groove in the ice.) It’s free to travel in one direction, and to rotate about an orthogonal axis. One possible check box combination is: \textit{XXO XOX}

10 \textbf{* 2 Moves + 2 Rotates (matching)}: Turn on two Moves and two matching Rotates. This results in a sliding axle (a shaft that can both slide in and out of a hole, and rotate with the hole). The clear Move and Rotate axis specifies the axis along which the joint can slide and rotate. The possible check box combinations are: \textit{XXO XOX OXX OXX OXX}

11 \textbf{* 2 Moves + 3 Rotates}: Turn on two Moves and all three Rotates. (This is a prismatic or sliding joint.) The joint transmits no torque, and force in only one direction. You can use this in conjunction with the Push effect to make a hydraulic cylinder. The one clear Move specifies the axis of movement.

12 \textbf{* 3 Moves + 2 Rotates}: Turn on all three Moves, and any two Rotates. This is an axle (the most common type of joint.) The one clear Rotate specifies the axis of rotation.

13 \textbf{All Locked}: All six check boxes are on. This is a completely rigid joint.

\textbf{Interface}

\textbf{Dynamics rollout}

Contains all of the surface dynamics controls.
Simulation Name Displays the name of the current simulation. You can edit the name to rename any existing simulation.

You can create any number of simulations in your scene. Each must have a unique name and is stored in the .max file. For example, you might have a simulation named Bouncing Ball that bounces a ball down a flight of stairs, while another simulation named Paper Airplane flies a paper airplane across the room.

List Displays the name of the current dynamics simulation, and lists all simulations in the scene. If the list contains two or more simulations, choose
one from the list to make it current. All remaining panel settings are specific to the current simulation.

**New** Creates a new simulation. Its name consists of the word "Dynamics" appended by a number, starting with 00. This number is incremented by one for each new simulation.

**Remove** Deletes the current simulation. Dynamic simulations can use a lot of memory. Removing old or unused simulations reduces the size of your .max files. When you remove a simulation, all timings and other settings are deleted. However, any keys generated by the simulation remain.

**Copy** Creates a duplicate of the current dynamics simulation. All of the settings are identical to the original simulation, with the addition of “01” appended to the name.

**Objects in Simulation group**

Lets you add and remove objects from the simulation, and edit the properties of objects in the simulation.

**Edit Object List** Displays the Edit Object List dialog on page 4211, which lets you specify which scene objects are to be included in the simulation.

**Edit Object** Displays the Edit Object dialog on page 4205. The Edit Object dialog is the main interface for object dynamics attributes. Use this dialog to set collisions, effects, surface properties and mass for each object in the simulation.

**Select Objects in Sim** Adds all objects in the simulation to the current selection set. One use for this function is to bring selected objects into Track View for further manipulation, keyframe reduction, and so on.

**Effects group**

Specifies which effects are included in the dynamics calculation.

**Effects by Object** Only effects assigned to specific objects with the Edit Object dialog > Assign Object Effects button are considered in the calculation.

**Global Effects** Only effects included in the Assign Global Effects dialog (accessed by clicking the button of the same name) are included in the calculation.

**Assign Global Effects** Displays the Assign Global Effects dialog.
Select effects (space warps) in the list on the left and use the > button to move them to the list on the right. Effects thus chosen affect all objects in the simulation except unyielding ones.

The Assign Global Effects dialog functions similarly to the Edit Object List dialog on page 4211.

**Collisions group**

Specifies which collisions are included in the dynamics calculation.

**Collisions by Object** Collisions assigned to specific objects through the Edit Object dialog > Assign Object Collisions button are included in the calculation.

**Global Collisions** Collisions assigned in the Assign Global Collisions dialog (accessed by clicking the button of the same name) are included in the calculation.

**Assign Global Collisions** Displays the Assign Global Collisions dialog. Select the objects in the list on the left and use the > button to move them to the list on the right. All objects thus chosen collide with each other in the simulation.

The Assign Global Collisions dialog functions similarly to the Edit Object List dialog on page 4211.

**Solve group**

**Update Display w/ Solve** Displays each frame of the solution in the wireframe viewports during the calculations. This slows down the calculation process.

**Solve** Calculates the dynamics solution, generating keys over the range of frames specified in the Timing area. A progress bar appears in the status/prompt line. Press ESC to cancel the calculation.

**NOTE** You cannot undo the generation of a dynamics simulation solution. If there's a chance you might want to restore the scene to its state prior to the solution, either save on page 7440 the scene or use Hold on page 242 before solving it.

**Timing and Simulation rollout**

Lets you specify the range included in the calculation, how IK is included in the simulation, and what the air density is for the simulation.
Timing group

Controls how keys are generated over time.

**Start Time** Specifies the first frame to generate keys, which is the first frame to be considered for the solution. Default=0.

**Tip** If you set a start time that's later than a keyframe-animated object's last animation frame, you may get unexpected motion during the interim frames. For example, if you animate a box's position from frames 0 to 10, and then use the box in a dynamics simulation that starts at frame 20, the box will move between frames 10 and 20 because of the Bezier controller's default interpolation. To avoid this, before solving the simulation, set the last animation keyframe's Out tangent type to Linear or Step; see Bezier Controllers on page 3432. Alternatively, set the last key of the keyframed "input motion" after the start time of the simulation, or set a start time before the last key.

**End Time** Specifies the last key considered for the solution. This spinner is set to the last frame of the active segment on page 8496 when you create a new
simulation. For example, if your active segment ends at frame 200, when you click New to create a new simulation, End Time is set to 200.

**Calc Intervals Per Frame** Specifies how many calculations are performed for each frame of the simulation time range. Range=1 to 160.

Finding the right number for this spinner is a matter of experimentation. As a general rule, the faster things are moving in the simulation, the higher you should set this value.

**NOTE** If you find that some objects aren't colliding properly with others (they're going through them), increase the Calc Intervals Per Frame value.

**Keys Every N Frames** Specifies the frequency with which keys are generated, per object. If this were set to 2, keys would be generated in every other frame.

**WARNING** When you reduce the key count by increasing this setting, important information can be lost. For example, if a collision occurs on frame n, the Dynamics utility normally sets keys at frames n, n+1, and n-1. But if you've set Keys Every N Frames to 2, a keyframe for the impact itself might not be generated, while keys for the sudden reversal of motion would be generated on either side of the (missing) impact. Thus, the motion controller is left to interpolate motion in a region where the motion should be sharply defined. When this happens, motion can be incorrect and the remainder of the solve is affected. In the aforementioned example, a key describing the impact is lost and the motion controller interpolates motion so that objects that should collide actually intersect, ruining the simulation.

**Time Scale** Slows down or speeds up the overall effect of the simulation. It applies a linear scale factor to the outside forces affecting each object (gravity, wind, and so on).

The default value of 1 results in normal speed. You can scale down the simulation (make it slower) by using values below 1 (from 0.1 to 1), and you can scale up the simulation (make it faster) by using values greater than 1 (from 1 to 100). If you speed up your simulation and objects begin to behave incorrectly (going through objects, for example), increase the Calc Intervals Per Frame value to compensate.

**Simulation Controls group**

Relates to IK settings and the transfer of momentum.

**Use IK Joint Limits** Uses the current IK joint limit settings as constraints for hierarchies in the simulation.
Use IK Joint Damping Uses the IK damping settings as constraints for hierarchies in the simulation.

**Air Resistance group**

**Density percent** Sets the air density in the simulation. A setting of 100 is the air at sea level. A setting of 0 is a total vacuum.

When anything moves, it hits air resistance (except in space). The faster it moves, the higher the relative air resistance with the square of the speed. Thus, air resistance imposes an upper limit on the speed of things that are falling with gravity, and also makes objects tumble due to the effect of air resistance on each face of the object.

**Close** Closes the Dynamics utility.

**Dynamics Properties Material Editor rollout**

<table>
<thead>
<tr>
<th>Dynamics Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bounce Coefficient: 1.0</td>
</tr>
<tr>
<td>Static Friction: 0.0</td>
</tr>
<tr>
<td>Sliding Friction: 0.0</td>
</tr>
</tbody>
</table>

The three spinners in the Dynamics Properties rollout in the Material Editor let you specify surface properties that affect the animation of an object upon collision with another object. If there are no collisions in your simulation, these settings have no effect.

Because the Dynamics Properties rollout is available at the top level of any material (including sub-materials), you can specify different surface dynamic properties for each face in an object. There are also controls in the Dynamics utility that let you adjust the surface properties at the object level, but only the Material Editor lets you alter the surface properties at the sub-object level (through use of a Multi/Sub-Object material).

As a default, the values in the Dynamics Properties rollout provide a surface that’s similar to Teflon-coated hardened steel. This is with values of Bounce Coefficient equal to 1; with both Static Friction and Dynamic Friction set to 0.

**Bounce Coefficient** Determines how far an object bounces after striking a surface (the higher the value, the greater the bounce.) A value of 1 represents a bounce in which no kinetic energy is lost.
**Static Friction** Determines how difficult it is for an object to start moving along a surface (the higher this value, the more difficult the movement). If something weighs 10 pounds and sits on Teflon (a static friction of near zero), it takes almost no force to make it move sideways. On the other hand, if it sits on sandpaper, then the static friction might be very high, around .5 to .8.

**Sliding Friction** Determines how difficult it is for an object to keep moving over a surface (the higher this value, the more difficult for the object to keep moving). Once two objects begin to slide over one another, static friction disappears and sliding friction takes over. Generally, sliding friction is lower than static friction due to surface tension effects. For example, once steel starts sliding over brass (a value of static friction that might run from .05 to .2), the sliding friction drops to a significantly lower value: .01 to .1.

### Edit Object Dialog (Dynamics Utility)

Utilities panel > Utilities rollout > More button > Dynamics > Dynamics rollout > Edit Object button > Edit Object dialog

The Edit Object dialog is the main interface for setting dynamic properties for any object in the simulation. You assign dynamics properties one object at a time. Select an object in the list under Object, and then set that object’s parameters. For example, you can cause the object to be affected by gravity or wind, and specify collisions with other objects.
**Interface**

![Interface Diagram](image)

**Object** Displays the name of the object for which you're setting the dynamic properties. All settings in the Edit Object dialog affect the object listed here. To change the object you're affecting, open the list, and choose from a list of all objects assigned to the simulation.

**Dynamic Controls group**

**Use Initial State** When turned on, the simulation solves for the motion, energy, and momentum of the object at the simulation's starting frame (specified in the Start Time spinner in the Time and Simulation rollout > Timing group.) If Use Initial State is turned off, the object is assumed to be sitting motionless at the starting frame. The Dynamics utility overwrites keys. Either the object's keys are clocked with the simulation, or it's not moving (or both). If you don't solve for the initial state, the object's keys are interpolated at the instant the simulation starts and all subsequent motion comes from the interaction of the simulation itself.
This Object is Unyielding  Lets you use keyframe-animated objects in dynamics simulations. Objects with this option turned on are immovable relative to other objects that collide with them, but can be animated (keyframed).

You can animate objects with this option turned on by themselves or as part of a keyframed hierarchy. For collisions, objects with Use Initial State turned on cannot move objects with This Object is Unyielding turned on.

Move Pivot to Centroid  When this button is on (green) and you exit the Edit Object dialog by clicking OK, the object’s pivot point is moved to its center of mass. Having the pivot aligned with the center of mass speeds up the dynamics calculation and makes manual keyframing of the objects appear more natural. However, if the pivot point is already positioned as part of a linked hierarchy, turning on Move Pivot to Centroid will alter the positioning of your hierarchical linkage.

Load/Save Parameters Sets group

Saves the current Edit Object parameter settings, or loads previously saved parameter settings. You can use these controls to save the settings for one object, and then apply them to another object.

Set Name  Accepts a new name for a parameter set. Click Save to save the parameter set with this name.

Available Parameters Sets  Lists previously saved parameter sets.

Load  Loads the selected parameter set.

Save  Saves the named parameter set. The saved parameter sets appear in the list.

Delete  Deletes the selected parameter set.

Assign Effects/Collisions group

Let you specify which effects in the scene will affect the current object, or which objects in the scene can collide with the current object.

Assign Object Effects  Displays a subdialog that lets you specify which effects in the scene will affect the current object. The dialog consists of two list windows. All effects (typically space warps) in the scene are listed in the window on the left. Select effects in the list, and then click the > button to transfer the highlighted effects to the window at right.

The Assign Object Effects dialog functions similarly to the Edit Object List dialog on page 4211.
**Assign Object Collisions** Displays a subdialog that lets you choose which objects in the scene are considered for collision with the current object. This dialog works the same as the Assign Object Effects dialog, except that it lists only objects in the simulation. Objects included for collision in this dialog can collide with the current object.

**NOTE** For every potential collision, you should explicitly specify both colliding objects. For example, if you specify that Box01 is to collide with Box02, you should also specify that Box02 is to collide with Box01. This is primarily for keeping track of your simulation; if you specify the collision for only one object, it works for the other as well. While it is not necessary to specify that Box02 collides with Box01, this is the only way to update the Assign Object Collision list for Box02.

The Assign Object Effects dialog functions similarly to the [Edit Object List dialog](#) on page 4211.

**Collision Test group**

Specifies the type of boundary used for collision testing.

- **Box** A bounding box is used to test collision. This is the fastest method. If your object is a box or close to a box shape, this option is both fast and accurate.

- **Cylinder** A cylindrical form is used to test collision. The "height" axis of the cylinder is aligned with the local Z axis of the object.

- **Sphere** A spherical form is used to test collision.

- **Mesh** Uses the surface of the object to calculate the collision. This option is the most accurate, but also takes far longer to calculate than the previous three methods. Use this only when your object is too complex to work properly with the first three options.

**Recalculate Properties group**

Specifies when to recalculate the properties of an object that changes over the course of the animation. Specifically, the properties refer to the mass moment of the object. The mass moment of an object can be defined as the measure of how the mass in an object is distributed with respect to the center of mass of that object. Altering the mass moment changes the way an object responds to torque. If your object is changing shape over time, and you want to take this into account for the simulation, you should recalculate the properties.

- **Never** No calculation is performed beyond the first calculation for the dynamics solution.
**Every Frame** The object's properties are recalculated for every frame.

**Every Calc Interval** The object's properties are recalculated at each "Calc Interval." You set the Calc Interval (interval of calculation) in the Time Parameters rollout; it specifies how many calculations are performed for each frame of the simulation time range.

**Material Editor Physical Properties group**

Three of an object's physical properties are taken by default from its material: bounce, static friction, and sliding friction; see Dynamics Properties Rollout on page 6062. Use these settings in this group to accept or override the material's dynamics properties.

**Bounce** Specifies how far the object bounces after collision. Available only if Override Material Bounce is on.

**Override Material Bounce** Enables the Bounce spinner when you want to use a specific value that's different than that assigned by the object's material. When using a multi/sub-object material, you can assign different Bounce values to the sub-materials, and thus to different faces of an object. But if you use an override value, it affects the whole object only.

**Copy to Object's Material** Copies the value in the Bounce spinner to the material assigned to the object.

**Static Friction** Specifies how hard it is to start moving on a surface. Available only if Override Material Static Friction is on.

**Override Material Static Friction** Enables the Static Friction spinner when you want to use a specific value that's different than that assigned by the object's material. When using a multi/sub-object material, you can assign different Static Friction values to the sub-materials, and thus to different faces of an object. But if you use an override value, it affects the whole object only.

**Copy to Object's Material** Copies the value in the Static Friction spinner to the material assigned to the object.

**Sliding Friction** Sliding friction determines how hard it's for an object to keep moving over a surface. Available only if Override Material Bounce is on.

**Override Material Sliding Friction** Enables the Sliding Friction spinner when you want to use a specific value that's different than that assigned by the object's material. When using a multi/sub-object material, you can assign different Sliding Friction values to the sub-materials, and thus to different faces of an object. But if you use an override value, it affects the whole object only.
Copy to Object's Material  Copies the value in the Sliding Friction spinner to the material assigned to the object.

**Physical Properties group**

Provides controls that specify the physical properties of the current object.

**Density** Specifies the density of the object in grams per cc. A setting of 1 is the equivalent of water, and useful for anything wooden, plastic, or organic. The more dense an object, the slower it will react to forces. There is a direct relationship between density and mass, so when you alter the Density setting, the Mass value changes (when its automatic value is not overridden).

**Mass** Technically, mass is the measure of how many subatomic particles are in an object. In 3ds Max, it's calculated as a result of density times volume. Mass can is the resistance to acceleration given a constant force. The greater the mass, the more resistance. The Mass value, when not overridden, is derived from the density and volume, and the volume, when automatically calculated, is affected by the Calculate Properties Using option.

**Override Automatic Mass** Enables the Mass spinner so you can specify the object's mass. When you override the automatic value, the Mass value is no longer affected by the Density or Volume values. Mass is affected by the Calculate Properties Using options.

**Volume** The volume of the object, measured in cubic centimeters. When automatically calculated, this value depends on the option chosen under Calculate Properties Using.

**Override Automatic Volume** Enables the Volume spinner so you can specify the object's volume. When you override the automatic Volume value, it's no longer affected by the Calculate Properties Using options, and it no longer affects the Mass value.

**Calculate Properties Using options**

Specifies the type of geometry the simulation will use to calculate the mass, the volume, and the mass moment. When the Mass and Volume values are automatically calculated (their overrides are turned off), changing these options affects the volume, and thus the mass.

**Vertices** Treats an object as a "point cloud," or a collection of vertices without segments. Each vertex is given a mass of 1 gram, but the object itself has no volume.
**Surface** Treats the object as a hollow shell whose thickness is 1 centimeter. The mass is derived from the surface area and the 1-centimeter thickness, but the object has no volume.

**Bounding Box** A bounding box surrounding the extents of the object is used to calculate both the volume (of a solid bounding box) and the mass (based on the volume).

**Bounding Cylinder** Similar to the Bounding Box option, except that a bounding cylinder is used, whose Z height axis is aligned with the local Z axis of the object.

**Bounding Sphere** Similar to Bounding Box, except that a bounding sphere is used.

**Mesh Solid** The geometry of the object is used to calculate both the volume and the mass, according.

**Property Estimate Resolution options**

Available only when the Mesh Solid option is chosen. The Property Estimate Resolution settings affect the accuracy with which the mass moment is calculated. This determines how accurately the rotation of the object responds to torque.

**Grid** A sample grid is used to calculate the mass moment. The smaller the cells in the grid, the more accurate the calculation. The grid cells are measured in centimeters, regardless of the current display unit.

**Override Automatic Resolution** Lets the Dynamics utility automatically set the grid size based on the complexity and size of the object. In addition, the lowest value that will be automatically calculated is plugged into the Grid spinner (which is also unavailable). If you want to specify your own grid value using the Grid spinner, but want some idea of where to start, turn off Automatic Resolution and then turn it back on again.

**Edit Object List Dialog (Dynamics Utility)**

Utilities panel > Utilities rollout > More button > Dynamics > Dynamics rollout > Edit Object List button > Edit Object List dialog

The Edit Object List dialog lets you select the objects to include in a dynamics simulation. Highlight objects from the Objects in the Scene list on the left, and then click the > button to place them in the Objects in the Simulation list on the right side of the dialog.
The Exclude and Include option buttons above the right window determine whether the items listed are excluded from or included in the simulation.

**NOTE** All the selection and inclusion dialogs in the Dynamics Utility are displayed and function similarly.

**Interface**

**Objects in the Scene** To add scene objects to the simulation (assuming Include is chosen), select objects from the list on the left, then use the > button to move them to the list on the right.

**Search Field** The edit box above the Scene Objects list lets you search for object names by entering names that use wildcards. For example, searching for "sphere*" finds all objects whose names start with "sphere".
**Objects in the Simulation**  To exclude objects from the simulation (assuming Include is chosen), select objects from the list on the right, then use the < button to move them to the list on the left.

**Exclude/Include** Choose whether the simulation will exclude or include the objects named in the list on the right. If you choose Exclude, only objects in the list on the left are included in the simulation.

**All/None/Invert** Affect the list on the left. All selects all objects, None deselects all objects, and Invert selects unselected objects and deselects selected objects.

**Display Subtree** Turn on to indent the list according to the object hierarchy.

**Case Sensitive** Turn on to use case sensitivity when searching for object names.

**Select Subtree** Selects all objects in a hierarchy at the level you click and below.

**Selection Sets** Displays a list of named selection sets. Choosing a selection set from this list selects those objects in the Scene Objects list.

**Clear** Clears all entries from the Exclude/Include list on the right.

**Skin Utilities**

Utilities panel > More button > SkinUtilities

Skin Utilities provide a method for copying skin data (envelopes and vertex weights) from one model to another. Skin Utilities work by embedding the skin data in a copy of the source mesh, then using the object copy to map the data onto the target mesh.

To use Skin Utilities, you must have two meshes to which the Skin modifier on page 1667 has been applied, both in the current scene. You must have already assigned bones to the Skin modifier for both meshes.

**NOTE** Skin Utilities work by matching bones from one character to another, so the task of copying the skin data will be greatly simplified if you name the bones in each mesh with similar naming conventions.
Procedures

To use Skin Utilities:

1. Load a scene that contains two skinned meshes, one from which you want to extract the skin data, the other to which you want to paste it.

2. Select the source mesh, the mesh with the correct envelopes and vertex weights.

3. Choose Utilities panel > More button > Skin Utilities.

4. Click Extract Skin Data to Mesh.
   A new object is created, identical to the selected object. This is a new mesh with all envelope-assigned and manually-assigned vertex weights “baked” into the mesh. The object is named with the prefix SkinData_ followed by the same name as the original object.

5. Move the skin data mesh on top of the mesh to which you would like to paste the skin data, so the two meshes are coincident.

6. If necessary, adjust the skin data object at the Vertex sub-object level to make it fit the other mesh as closely as possible.

7. Select both the skin data object, and the object to which you want to paste the data.

8. Click Import Skin Data From Mesh.
   The Paste Skin Data dialog appears.

9. Match up the bones by highlighting one on each side of the dialog, and clicking the left arrow to move the target bone to its match on the left side.
   You can also highlight several bones on each side at once, and click the left arrow to move them all over at the same time. Only bone pairs on the left side of the dialog will be pasted.

10. If the meshes' vertices do not match exactly, set the Interpolation method to Match by Face, and increase the Threshold to a unit value that will allow the meshes' faces to match up.

11. Click OK to paste the vertex weights and close the dialog.

12. Delete the skin data mesh.
Interface

Extract Skin Data To Mesh

Extracts the skin data from the selected mesh and embeds it in a new mesh named SkinData_ followed by the original object name.

NOTE The skin data is stored in channels. To see the data, select the SkinData_ mesh and use the Channel Info Utility on page 6486.

Import Skin Data From Mesh

Opens the Paste Skin Data dialog. Before clicking this option, you must select the SkinData_ mesh and the mesh to which you want to paste the data.
Paste Skin Data dialog

To use the Paste Skin Data dialog, highlight matching Target Bones and Source Bones, and click the left arrow to match them. Only matched sets of bones listed under Target Bones will be mapped when you click OK.

Target Bones
Lists target bones available for matching, and lists matches moved from the Source Bones listing with the left arrow.

Source Bones
Lists source bones available for matching.

Add
Adds removed bones back to the source or target list.

Remove
Removes highlighted bones from the source or target list.

4216 | Chapter 13 Animation
Remove Suffix If bone names end with an underscore followed by text, this removes the suffix from the displayed bone names from the underscore to the end of the name. Use this option to remove suffixes and make source and target bone names match, which will allow you to use the Match by Name option.

Remove Prefix If bone names start with text followed by an underscore, this removes all characters from the displayed bone names up to and including the underscore. Use this option to remove prefixes and make source and target bone names match, which will allow you to use the Match by Name option.

Left Arrow Matches highlighted target bones to highlighted source bones. The source bone name is moved to the left side of the dialog, where it follows the target bone name. You can also match more than one source bone to a single target bone by highlighting the target bone and the source bones and clicking the left arrow. When you click OK, only the matches listed on the left side of the dialog will be mapped.

Right Arrow On a highlighted match on the left side of the dialog, removes the match and moves the source bone to the right side of the dialog.

Match by Name Matches the source and target bones by name. You can use this option only if you have removed prefixes or suffixes to make the displayed source and target bone names match exactly.

Threshold Sets the unit distance that the utility will search for vertex or face matches. Default=1.0.

Interpolation Sets the method by which pasting will take place. Use the Match by Vertex option only if the meshes are identical. Otherwise, use Match by Face. Default=Match by Vertex.
reactor

reactor is a toolset that allows animators and artists to control and simulate complex physical scenes in 3ds Max. reactor supports integrated rigid and soft body dynamics, cloth simulation, and fluid simulation. It can simulate constraints and joints for articulated bodies. It can also simulate physical behaviors such as wind and motors. You can use all of these features to create rich dynamic environments.

In a reactor simulation, a rag-doll figure crashes through a window.

Once you have created an object in 3ds Max, you can assign physical properties such as mass, friction, and elasticity to it with reactor. Objects can be fixed, free, attached to springs, or attached together using a variety of constraints. By assigning physical characteristics to objects
like this, you can model real-world scenarios and then simulate them to produce physically accurate, keyframed animations.

After you set up your reactor scene, you can preview it quickly using the real-time simulation display window. This allows you to test and play with a scene interactively. You can alter positions of all physical objects in the scene, dramatically reducing the design time. You can then transfer the scene back into 3ds Max with a single mouse click while retaining all the properties needed for the animation.

reactor frees you from having to hand-animate time-consuming secondary effects, like exploding buildings or draping curtains. reactor also supports all standard 3ds Max functionality such as keyframes and skinning, so you can use both conventional and physical animation in the same scene. Convenient utilities, such as automatic keyframe reduction, let you tweak and alter the physically generated parts of an animation after it has been created.

The remainder of this chapter describes each of reactor's features in detail. Also, the included tutorials step you through creating some typical reactor scenes. Together, we hope these will help you to get the most from reactor.

If you would like to find out more about dynamics simulation, see Introducing Dynamics Simulation on page 4227.

Getting Started

This section shows you where to find the various reactor options in 3ds Max, as well as introducing you to reactor's helper icons. You'll see how to use each of the options in the relevant section of this guide.

Command Panel

You can use the reactor options on the Create panel to create various reactor elements. To find most reactor objects, go to the Helpers sub-panel, and then, from the drop-down list, choose reactor.
You can also find a space warp, used for water on page 4411, in Space Warps > reactor.

Once you've created a reactor object, selecting the object and opening the Modify panel allows you to configure its properties.
There are also three reactor modifiers, used to simulate **deformable bodies** on page 4363:

---

4222 | Chapter 14  reactor
You'll find most of the remaining reactor functions on the Utilities panel. This provides access to functionality such as previewing the simulation, changing world and display parameters, and analyzing the convexity of objects. It also lets you see and edit the rigid body properties associated with objects in the scene.
The reactor menus and toolbar provide shortcuts for many of the reactor functions provided in the command panel.
The reactor Toolbar

The reactor toolbar is a handy way to access much of reactor's functionality. It has buttons that let you quickly create constraints and other helpers, display physical properties, generate animations, and run the real-time preview.

To display the reactor toolbar:

1. Right-click an empty area of the main toolbar to display a list of available toolbars.
2. Click reactor.

The reactor Submenu
The main reactor submenu, available from the Animation menu, is another way to access reactor functionality.

**The reactor Quad Menu**

![Reactor Quad Menu Diagram]

A further quick way to access reactor options is the reactor quad menu. To open this menu, press Shift+Alt and right-click in the active viewport.

**Helper Icons**

Many reactor elements, such as constraints and the Rigid Body Collection, have their own special helper icon that appears in the viewport when you add them to the scene. For instance, the following illustration shows the Hinge constraint icon:
Although the helper icon doesn't appear in your rendered scene, the icon's appearance (and in some cases, its position and orientation) will help you to set up your reactor scene correctly.

When selected, reactor icons are white and are also larger than when not selected. When not selected, the icon for a valid element is blue, and for an invalid element is red. What constitutes validity depends on the particular reactor element. For instance, a hinge on page 4307 is valid if it has the correct number of objects attached to it; a Rigid Body Collection on page 4261 is valid if it's not empty. Invalid elements are excluded from the simulation, and reported as errors.

Certain icons provide additional information about how the element behaves in the simulation. For example, the display for a valid hinge indicates the hinge position, and, when selected, the hinge axis and any limits you've specified for the movement of the hinged bodies.

Introducing Dynamics Simulation

This section gives a broad overview of physical simulation, and introduces some concepts you might find useful when working with reactor.

Physical Simulation

Havok’s physics technology, used in reactor, relies on a process known as physical simulation in order to provide a dynamic environment for the objects in a scene. So what exactly does physical simulation mean?

It is a process that automatically determines the motion of objects according to their physical properties. It achieves this by encapsulating some physical laws, like Newton’s laws of motion, within a robust, efficient engine, which calculates the position of each object as time passes. In much the same way
that a motion picture is composed of many individual images or frames, physical simulation splits time into small discrete steps and predicts the motion of each object during each step. The cumulative effect of all these steps is fluid, continuous, believable motion.

Unlike traditional keyframe-based animation, where the animator needs to specify a set of keyframed configurations, physical simulation determines how objects move based on their properties. This takes the burden from the animator, who no longer needs to manually animate every piece in an explosion, every bone in a character stunt animation, or every vertex in a piece of cloth.

In a physical simulation, physical properties such as mass and elasticity are assigned to all objects in a scene. This is then complemented with a set of external forces like gravity or wind and/or constraints, like a spring force or a ball-socket configuration. From all this information, the physics engine calculates a continuous set of states that can then be displayed in real-time, if the calculations are fast enough, or converted into keyframes to be played back later.

**What Does A Physics Engine Do?**

A physics engine like Havok has three basic tasks to perform:

1. **Collision Detection**
   Track the movement of all the objects in the scene and detect when any of them have collided.

2. **Update System**
   Determine an appropriate response for objects that have collided by resolving the collision according to the object properties and for all other (non-colliding) objects update them according to the forces acting on them.

3. **Interface with Application**
   Once reactor determines the new positions and state of all objects, it can display the objects in a 3D window or store their states in the form of keyframes.

**NOTE** A physics engine knows nothing about how the objects it is simulating are displayed. It simulates the motion and interaction of these objects based on a physical (not graphical) description of the objects, and this information can be used to generate a display that “tracks” the simulation.
Given that we are talking about simulating a continuously evolving state (in other words, objects are moving and colliding and reacting all the time in general), we need to map this to a series of snapshots in order to generate an animation. In a computer game, for example, we typically want to display the world 60 times per second, because this is how frequently many graphics systems can redraw the screen. When creating an animation, we may want to store the state (that is, create a keyframe) for every frame. At 60 FPS, for example, this would also create 60 keyframes every second. What this really means is that the physics engine must be capable of evolving the world by 1/60th of a second knowing the state of all the objects at the start of this time interval and knowing the external forces acting on these objects. As an example we'll look at the simple case of a cannon ball and we'll assume we're interested in animation at 60Hz (Hz = cycles or frames per second).

**Simulating a Cannon Ball**

Let's forget about collisions for now, and consider only the simulation of a cannon ball immediately after it has been fired from the cannon. We know the ball's position (and orientation, but we'll ignore this for now), speed, acceleration, and weight, and we assume we know the state of the environment (air resistance, wind force, gravity). Armed with this knowledge we can start to make predictions using a physics engine.

A cannon ball follows a parabolic trajectory.

This figure illustrates what we would like to achieve. Over a period of time the cannon ball's rate of ascent should slow due to gravity, and it should eventually fall to the ground having traveled through a classic parabolic arc (assuming no air resistance).

At a given point in time we can examine the state of the ball (its speed $v$ and acceleration $a$) and knowing the external forces acting on it we can make a
guess as to its change in position after a period of time has elapsed (call this period $h$ seconds). This guess is a combination of a number of factors:

- We assume that Newton’s laws of motion govern the motion of the ball
- We assume that in the time period $h$ all the external forces acting on the ball are constant, so air resistance and wind and gravity do not change during this time.
- We assume that the math we use to calculate the new position is accurate

In general, the first assumption is usually valid, except at relativistic or quantum scales, which we can assume should be handled by other systems. The remaining two, however, cause problems and are closely linked to the time period $h$ over which we’re performing the calculations. We’ll now examine the effect of the size of this time period on the accuracy of the simulation.

**Time Steps**

In general, the forces acting on an object are rarely truly constant; gravity is close to being constant, but most other forces like wind and air resistance are not. So, taking the cannon ball example, imagine a windy layer in the atmosphere that the cannon ball passes through, as shown in the next figure.

In the simulation on the left we assume we’re taking steps of one second; this is actually a relatively large interval for a physics simulation, but is used here...
to illustrate the point. We know all the forces acting on the ball at time \( t_1 \) so we use some math to predict the new position and velocity at time \( t_2 \), after one second has elapsed. During this period, we assume that the wind force acting on the ball is constant. In this example, we’ll calculate the new position above the region of high wind, so we’ll effectively have missed the windy bit by taking too great a jump. In the second example on the right, we’re using time steps of \( \frac{1}{2} \) second. In this case, after determining the new position at time \( t_2 \) we find the ball in the middle of the windy region. This region causes a large wind force to act on the ball which is taken into account during the next time step. At that point we reevaluate the math and determine a new position for the ball at time \( t_3 \). This is different from the position determined in the simulation on the left, even though the same amount of time has been simulated in each case. In other words, the wind has blown the ball to the left a bit and has reduced the velocity of the ball.

In general, the smaller the time step taken, the more accurate the result at the end of the time step. Thus, to step forward in time by a large time step \( t \) it is better to split this into \( n \) steps of a smaller time interval \( t/n \).

This is also true of the math. As the simulation becomes more complex, the math required to calculate the new positions and velocities of objects in a simulation also becomes more complex, and as a result the guesses produced by the math give progressively less-accurate results.

So the principle is to take small time steps, evaluate all the forces acting on the objects, determine the new positions and velocities (and other parameters) of the objects at the end of the time steps, and then start over. We end up with a series of snapshots of the state of the system as it evolves, as shown in the following illustration.
Snapshots of a system state taken at regular time intervals

**Substeps**

In the previous section, we said that the physics engine passes on the necessary information to update the display after it determines the new positions for all its objects. However, what if you don’t want to update the display in each simulation time step?

Let’s say we absolutely need to update the application once every 1/60th of a second, either because we’re playing a real-time game that refreshes the screen at 60Hz or we’re creating a keyframe every frame for a 60FPS movie. This effectively means that we want to step the physics engine at intervals of 1/60th of a second. In many cases this does not present a problem, but if, hypothetically, the accuracy of the simulation was not sufficient (remember: smaller time steps mean better accuracy), then we’d like to decrease the time step even further, say to 1/120th of a second. But this would mean we generate twice the number of images/keyframes we are interested in, which is wasteful. To get around this, the Havok engine allows you to specify the number of substeps to take per key.

The Substeps/Key parameter specifies the number of steps the physics engine takes before updating the application. This gives control over the granularity of the physics simulation independent of the display update or keyframe-creation frequency. So with Substeps/Key=1, reactor uses a single
simulation step for each update to the 3D display. With Substeps/Key=2, reactor takes two physics steps each time before updating the application, and so on.

In this figure, we have specified that the physics simulation should step at intervals of 1/240th of a second, but that we create a keyframe only once every 1/60th of a second. The red spots indicate a keyframe and simulation step, the yellow spots are simulation steps only. This was achieved by instructing the physics engine to employ four substeps per key. Thus, for each four simulation steps we create only keyframe. By setting the number of substeps we can control the accuracy of the physical simulation independent of the number of keyframes created.
Rigid Bodies and Deformable Bodies

Rigid Bodies

Havok simulates most objects in a simulation as rigid bodies. A rigid body is an object whose geometry doesn't change over the course of the simulation. You can simulate any real-world object that doesn't noticeably change its shape, from a pen to a boulder hurtling down a mountainside, as a rigid body. Simulating objects in this way facilitates rapid physical simulation in real time; the physics engine can make certain assumptions when detecting collisions based on the fact that the objects' shapes don't vary from simulation step to simulation step.

Both the Havok 1 and Havok 3 engines can simulate rigid bodies, but Havok 3 simulations are faster and more accurate.

Deformable Bodies

To simulate cloth, rope, or other material whose shape changes over time, you need to use a different type of body: a deformable body. With deformable objects, collision detection becomes much more difficult, given that the object can change shape dramatically between time steps and can also attempt to collide with itself. For this reason, deformable bodies are more expensive to simulate.

NOTE Only the Havok 1 engine can simulate with deformable bodies.

Scale

Our scientific knowledge of physics is extensive. What we are concerned with here would more accurately be described as a mechanical simulation of the interactions of objects at real-world scales. We are dealing with Newtonian mechanics; that is, the well-understood laws of motion, popularized by Sir Isaac Newton, that describe the behavior of objects under the influences of other objects and external forces. Since then we've discovered that these laws break down at very small (i.e. subatomic) and very large (i.e. planetary) scales.

New physics systems have been devised to work with these scales (for example, relativistic and quantum), but these are beyond the scope of the reactor physics engine. The Havok physics simulation technology works at the scale of objects we interact with on a daily basis, such as chairs, cars, buildings, and footballs. By default, the engine works in units of meters and kilograms.

It's important to keep in mind the scale in which you're working. For example, a common mistake people make is to start by creating a cube 100 meters on
a side, and then they wonder why it takes so long to fall. A box of this size when viewed at a distance sufficient to be able to see the entire box (say 1km away) will appear to fall at the same speed as an aircraft hangar dropped from a height and viewed from a kilometer away: slowly.

**Changing Scale**

The Havok physics engine does not care what units of measurement you use when specifying the size of objects or the strength of gravity; it cares only about the numbers. So you could, for instance, work in inches. However, for realistic (or at least predictable) results, it's important to be consistent. So, for instance, if you're working in meters, make sure gravity is set to an appropriate value in meters. To produce Earth-like gravity, use 9.8 m/s². Otherwise objects might appear to fall faster or slower than you expect.

**NOTE** Due to CPU floating-point precision, a physics engine is most accurate when dealing with numbers as close in magnitude to 1 as possible. In other words, values like 10,000,000 work poorly, as do values like 0.0000001. Therefore, for real-world scenes, when creating objects of 1*1*1 size it is most useful to be working in meters or feet, rather than centimeters/inches or kilometers/miles, in that you most often simulate objects larger than sugar cubes and smaller than football fields. It is for this reason that the default values in many physics engines are usually specified in meters.

---

**Special Features in reactor**

A number of reactor features enhance speed and usability. reactor lets you create new and better animations that were virtually impossible without reactor, and you can set up those animations in an efficient, intuitive way. Here we present some of the main features in reactor.

**Two Simulation Engines**

From the reactor utility interface, you can choose to run your simulation with either of two engines: Havok 1 or Havok 3.
If your reaction involves cloth, rope, or soft bodies, you'll need to stick with Havok 1, the version included with previous releases of 3ds Max. However, if you're using rigid bodies only, you can take advantage of the enhanced accuracy available in Havok 3. For more information, see The reactor Utility on page 4420 and Havok 1 World / Havok 3 World Rollout on page 4424.

Integrated User Interface

The reactor interface is fully integrated in 3ds Max. You can access functionality in reactor through menus, quad menus and toolbars. All 2D and 3D icons follow a consistent look and feel. The reactor utility on page 4420 parameters are arranged for easy access.
You can find more details in:

- reactor on page 4219
- The reactor Utility on page 4420

**Vertex Selection Inside reactor Modifiers**

The reactor modifiers for deformable bodies on page 4363: Cloth, Soft, and Rope, let you select vertices and apply constraints (fix points, keyframe points, attach to rigid body, attach to deforming mesh) to those vertices without leaving the modifier or having to apply extra modifiers. You can create and manipulate deformable constraints on page 4398 inside the modifier.
**Cooperative Constraints**

reactor includes a number of cooperative constraints on page 4281 that facilitate the simulation of articulated bodies and machinery.
Mannequins constrained to touch hands

The **Rag Doll constraint** on page 4286 allows the simulation of constrained bodies with relative rotation and twist angles limits similar to those found in human and animal joints.

The **Hinge constraint** on page 4307 allows the simulation of hinges (limited or not) and hinge-like joints where movement is limited around a specified axis, like elbows and knees.

The **Prismatic constraint** on page 4320 allows the simulation of translation-only joints (limited or not) like those found in robots and machinery.

The **Car-Wheel constraint** on page 4326 is particularly suited to the simulation of wheels attached to a chassis. The wheels rotate (and can be powered) about a given axis. Limited linear motion relative to the chassis is allowed along a user-defined suspension axis.

Using **Point-Point constraint** on page 4313 with the Limited option lets you limit the relative rotation of the attached objects by a given degree around each axis.

Using **Point-Point** on page 4313 with the Stiff Spring option constrains both objects as though attached by a fixed-length bar (a very stiff spring).
Fracture Object

The Fracture on page 4349 object in reactor offers excellent usability and behavior. Objects inside Fracture are standard Rigid Bodies and, as such, you can add them to constraints, assigned initial velocities, etc. You can tell pieces to break at a specific time.

A fractured glass

Constraint Manipulation and Constraint Spaces

Constraints on page 4264 in general restrict the relative movement between two bodies (parent and child) or between a body (child) and the world, and use consistent, intuitive nomenclature and setup methods. Springs, linear dashpots and angular dashpots are referred as Simple Constraints on page 4268, while the other constraints (those that are grouped with a Constraints Solver on page 4283) are referred to as Cooperative Constraints on page 4281.
In reactor, you define the effect of constraints by specifying and manipulating two constraint spaces on page 4266. Limits, such as minimum and maximum rotation angles, are defined and displayed around those spaces, which you can modify using sub-object manipulation. reactor provides tools for automatically aligning and manipulating those spaces.

**Storage and Access of Collision Information**

reactor can store information of all rigid body collisions occurred during the simulation. The information includes the objects involved, the point of collision, and the relative velocity during collision, and can be used by animators to generate particles or other effects, trigger sounds, etc. You can access the information via MAXScript and save it to a text file.
For more information, see Storing and Accessing Collisions on page 4358.

**Support for Global Collisions**

In reactor, you can enable or disable collisions globally instead of inside the Rigid Body Collection on page 4261. 3ds Max stores disabled collisions inside the reactor Utility on page 4420. You can disable collisions not only for rigid bodies, but also for cloth, soft and rope. And you can access disabled collisions through MAXScript.
Animatable Wind

You can animate most parameters in the reactor Wind on page 4416 object, including wind speed and direction. Range and Falloff parameters let you set up the range of action for the wind.

An array of planes shifted by wind

Cloth/Soft/Rope Attachments to Deforming Meshes (Skin)

The Attach to DefMesh on page 4406 deformable constraint allows vertices in cloth, soft bodies, and rope to follow a non-rigid mesh such as skin.
One mesh deforms another

**Soft Selection for Cloth/Soft/Rope**

The deformable on page 4363 (cloth/soft/rope) modifiers in reactor can now use the soft selection flowing to that modifier and blend the current vertex animation with the reactor animation, facilitating the transition between skin-driven and reactor-driven animation.
Soft selection dampens the deformation

Floating Rigid Body Property Editor

In reactor you can change the rigid body properties on page 4248, like mass, elasticity or friction without having to use the reactor Utility on page 4420. You can open a floating MAXScript window to modify rigid body properties from the reactor menus, quad menus, and toolbars at any time.
MAXScript Access

Virtually all parameters and functionality in reactor are accessible through MAXScript.

Animation Features

reactor can automatically create list controllers (or character studio layers) to store the animation of rigid bodies. For more information, see Preview & Animation Rollout on page 4422.

Also, the ragdoll script on page 4441 is aware of being applied to character studio bipeds, and, in such cases, sets up the constraints so that, when you create an animation, the biped is physically animated.

reactor Helpers

Create panel > Helpers > reactor
Animation menu > reactor > Create Object

This topic simply provides links to the various helper objects that are part of the reactor system.

Interface

<table>
<thead>
<tr>
<th>Object Type</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>RBCollection</td>
<td>CSolver</td>
</tr>
<tr>
<td>Point-Point</td>
<td>Point-Path</td>
</tr>
<tr>
<td>Hinge</td>
<td>Ragdoll</td>
</tr>
<tr>
<td>Carwheel</td>
<td>Prismatic</td>
</tr>
<tr>
<td>L Dashpot</td>
<td>A Dashpot</td>
</tr>
<tr>
<td>CLCollection</td>
<td>DMCollection</td>
</tr>
<tr>
<td>RPCollection</td>
<td>SBCollection</td>
</tr>
<tr>
<td>Fracture</td>
<td>Motor</td>
</tr>
<tr>
<td>Plane</td>
<td>Spring</td>
</tr>
<tr>
<td>Toy Car</td>
<td>Wind</td>
</tr>
</tbody>
</table>

Rigid Body Collection on page 4261
Constraint Solver on page 4283
Point-Point Constraint on page 4313
Point-Path Constraint on page 4333
Hinge Constraint on page 4307
Rag Doll Constraint on page 4286
Car-Wheel Constraint on page 4326
Prismatic Constraint on page 4320
Linear Dashpot on page 4273
Angular Dashpot on page 4277
Cloth Collection on page 4372
Deforming Mesh Collection on page 4396
Rope Collection on page 4392
Rigid Bodies

The rigid body is the basic building block of reactor simulations. You can use a rigid body in reactor to simulate any real-world object that doesn’t change its shape, from a pen to a boulder hurtling down a mountainside.

A rigid mannequin collides with a rigid window, which fractures.

You can create a rigid body using any geometry in a 3ds Max scene. reactor then lets you assign the properties the object should have in the simulation,
such as mass, friction, and whether the body can collide with other rigid bodies. You can also restrict the possible movement of your rigid bodies in the simulation using constraints such as hinges and springs.

This section shows you how to create and work with rigid bodies in reactor. To find out how to simulate objects that change their shape over time, see Deformable Bodies on page 4363.

**Rigid Body Basics**

You can make a rigid body from any geometry in your scene. A rigid body can be a single object, or it can comprise several objects grouped together, known as a compound rigid body on page 4259. If you designate an object whose geometry changes over time as a rigid body, the simulation uses its geometry at the start frame.

reactor lets you assign the physical properties that each body will have in the simulation, such as mass, friction, and whether the body can collide with other rigid bodies. You can specify a proxy geometry for a rigid body, which allows reactor to treat the rigid body as an easier-to-simulate shape for the purpose of the simulation. You can also specify how your rigid body should be displayed when previewing the simulation.

An object is simulated as a rigid body after you have added it to a Rigid Body Collection on page 4261; you can edit its rigid body properties before or after you do this.

This section tells you how to:

- Edit rigid body properties on page 4249, including
  - physical properties on page 4250
  - simulation geometry on page 4252
  - display properties on page 4259

**Rigid Body Properties**

Utility panel > reactor > Properties

Animation menu > reactor > Open Property Editor
reactor toolbar > Open Property Editor button

You assign physical properties, simulation geometry, and display properties to a rigid body using the Rigid Body Properties rollout or dialog. The interface consists of three rollouts or sections, each of which is described in detail in this topic.

Procedures

To edit the properties of a rigid body:

1. Select the appropriate object in the scene.
2. Open the Properties rollout or dialog. If the item you have selected cannot become a rigid body (for example, if it is a helper object such as a Rigid Body Collection), or if you have no object selected, the dialog still displays when you choose this option, but its controls are unavailable until you select a valid object.
3. Use the settings to specify the required properties, as described in the following sections.

Interface

Physical Properties
Mass  A rigid body's mass governs how the object interacts with other objects. When its mass is set to 0.0 (the default value), the object remains fixed in space during the simulation, although other objects will be able to collide with it. For example, you could use a fixed rigid body to create a slope for other objects to roll down. Other values allow the object to move during the simulation, depending on other circumstances. A valid value for Mass is greater than or equal to 0.0.

Friction  The coefficient of friction for the object's surface. This affects how smoothly the rigid body moves relative to surfaces it's in contact with. The friction values for both objects combine to produce a coefficient for the interaction. To achieve realistic results, use values between 0.0 and 1.0. However, values up to 5.0 are accepted.

Elasticity  This value governs the effect collisions have on the velocities of the rigid body; in other words, how "bouncy" the object is. Like Friction, this is a pair-wise coefficient: When two objects collide, their elasticity values combine to produce a coefficient for the interaction. To achieve realistic results, use values between 0.0 and 1.0. However, values up to 5.0 are accepted.

Inactive  When on, the rigid body starts the simulation in an inactive state. This means it requires interaction with another object or system, or the mouse, before it becomes active in the simulation. For example, if you place an object in midair, give it a mass and set it to Inactive, when the simulation starts it sits in midair until something interacts with it. Inactive objects require less computation during simulation.

Disable All Collisions  When on, the object doesn’t collide with other objects in the scene; it simply passes through them.

Unyielding  When on, the rigid body takes its motion from the animation it already has in 3ds Max, rather than the physical simulation. Other objects in the simulation can collide with it and react to its motion, but its motion is governed solely by the current animation in 3ds Max, and reactor will not create keyframes for it.

Phantom  A phantom object has no physical presence in the simulation. Like an object with Disable All Collisions on, it simply passes through other objects. Unlike an object with disabled collisions, however, a phantom maintains collision information about any objects that it passes through during the simulation. You can then use this collision information, for instance, to trigger sounds or other effects. You can find out how to access collision data in the Storing and Accessing Collisions on page 4358.

Shell  The radius of an extra "shell" around convex shapes, which reactor uses as the shape's surface for collision-detection purposes. The simulation tries to
ensure that the distance between this shell and other objects is always more than zero; in other words, that the distance between the original convex shape and other objects is always more than the combined radii of the objects. Default=0.05.

**IMPORTANT** Applies to Havok 3 only.

Adding a shell to an object can improve performance. The core convex-convex collision-detection algorithm is fast when objects are not interpenetrating, and slower when they are. Adding a shell makes it less likely that the shapes themselves will interpenetrate, thus reducing the likelihood of using the slower algorithm. Using a shell is thus faster in situations that involve the risk of shapes interpenetrating; for instance, when an object is settling or sliding on a surface, when there is a stack of objects, or when many objects are jostling together.

**Penet.** (Penetration) The amount of penetration reactor permits. To avoid trying to solve insoluble physical problems, the Havok 3 engine allows penetration between objects even if continuous physics on page ?is enabled. Default=0.05.

**IMPORTANT** Applies to Havok 3 only.

**Quality** Lets you set individual settings for each object based on the desired level of interaction. Default=Moving.

**IMPORTANT** Applies to Havok 3 only.

The available Quality settings are:
- **Debris** Low-importance objects used for adding visual quality.
- **Moving** Regular objects that populate the world, such as furniture, etc.
- **Critical** Essential objects that are never allowed to interpenetrate.
- **Bullet** Fast-moving projectiles.

**Simulation Geometry**

Lets you specify the physical representation of your object that will be used in the Havok simulation.
Proxies

reactor supports substituting one object for another in two different ways: geometry proxies and display proxies.

Geometry proxies allow you to specify a different body's geometry as the simulation geometry for an object. For example, you can have a complex object displayed on-screen, but replaced for simulation purposes by a box, which is much easier and faster for reactor to simulate. The box governs the movement of the object, and dictates how it collides, its position, and orientation. However, on-screen you can see the complex object in full detail. Geometry proxies are applied per object.

Display proxies replace a rigid body's display body with that of another object. Therefore, they affect display only during the real-time preview on page 4436 and do not affect animation. They are applied per rigid body, rather than per object. This means that you can create a compound rigid body of several objects and simulate these, but display an alternative mesh for the body during the preview. You can find out how to specify a display proxy in the Display on page 4259 section.

Convex and Concave Objects

A rigid body primitive is defined as convex if, given any two points inside the object, you can always go in a straight line from one to the other without leaving the object. Convex objects include spheres, cylinders, and boxes. For example, a sphere is convex but a golf ball is concave because of the concavities (dimples) in its surface. Also, by definition, non-closed meshes (planes, hollow hemispheres) are always concave.

Convex objects are faster to simulate than concave objects. Because of this, you should aim to use convex objects as often as possible for simulation. Treating concave objects as convex for simulation purposes allows you to take advantage of their faster processing time. This is the default setting for an object's simulation geometry (Mesh Convex Hull). If you are unsure whether an object is convex or concave, you can perform a convexity test on it. With the object selected, open the reactor - Utilities menu and select Convexity Test.

You can specify one of the following simulation geometry options to define how your object will be represented in the physical simulation. To view the simulation geometry for your objects in the preview, as in the following examples, select Sim Edges from the Display menu in the Preview Window.
Bounding Box  The object is simulated as a box whose extents are determined by the object’s dimensions.
Bounding Sphere The object is simulated as an implicit sphere. The sphere is centered on the object’s pivot point and then minimally encloses the object’s geometry.

Mesh Convex Hull This is the default option. The object’s geometry is passed through an algorithm that creates a convex geometry using the geometry’s vertices, completely enclosing the geometry’s vertices. To visualize this, imagine shrink-wrapping a teapot: The teapot is concave but its shrink-wrap forms a convex hull.
Convex hull

**Proxy Convex Hull** The convex hull of another object is used as the physical representation of the object in the simulation. For instance, you could use the convex hull of a low-poly teapot to simulate a high-poly teapot. The proxy object’s pivot point is aligned with that of the rigid body.
**Proxy convex hull**

**Concave Mesh** The actual mesh of the object is used for simulation. Although the convex hull of an object and the object’s actual mesh may be exactly the same shape, using the convex hull simulates much more quickly, as reactor can make certain assumptions for convex objects. If you try to use Concave Mesh for a convex object you will get a warning. Not heeding such warnings could dramatically reduce the speed of your simulation. In some cases, though, you might want to ignore that warning. If, for example, you want to place objects inside a convex object, and make them collide with the internal faces of that object, you should simulate it as concave instead of convex.

**NOTE** If you are using a standard 3ds Max plane as a rigid body (as opposed to the special reactor Plane on page 4338 object), you must set its simulation geometry to Concave Mesh.
Proxy Concave Mesh Another object’s concave mesh is used as the physical representation of the object. For example, you can use a low-poly teapot to animate a highly tessellated teapot. The proxy object’s pivot point is aligned with that of the rigid body.
To specify the proxy object, click the Proxy button at the bottom of the rollout.
Proxy concave mesh

Not Shared This option is active when multiple objects with different Simulation Geometry settings are selected.

Display

Proxy When on and you specify a proxy object by clicking the button (default label: None), reactor displays the specified proxy in the Preview Window in place of the object.

Compound Rigid Bodies

Rigid bodies can be made of one or more objects, or primitives. For instance, if you assign physical properties to an object in a scene and add it to a Rigid
Body Collection, we say that the rigid body has one primitive. However, reactor can also simulate a rigid body made up of more than one primitive. To do this, you need to group objects together using the 3ds Max Group menu. You can then add the group to the collection, and the objects in the group then become the primitives that make up the rigid body.

Creating such compound rigid bodies can be useful, as it is much faster to simulate a rigid body made up of convex pieces than to simulate a more complex concave shape. In addition, the primitives that make up a compound rigid body can have different masses, so you can create rigid bodies that have nonuniform mass distribution. For example, you can create a hand axe where the head is heavier than the handle, so that if you toss the axe it spins around its head.

You can do this because the Mass property on the Rigid Body Properties dialog is assigned to a specific primitive rather than an entire rigid body, unlike most of the other properties in this dialog. For single-primitive rigid bodies, this distinction is unimportant. However, in the case of a compound rigid body, the group parent is the rigid body and cannot have a Mass value assigned: Mass can be assigned only to its children, the primitives.

Simulation geometry is also defined at a primitive level, so you can combine concave and convex hull geometries in a single rigid body.

Procedures

To create a compound rigid body:

1. Arrange the objects to use to make up your compound rigid body.
2. Select all of the objects.
3 From the Group menu, choose Group.
Your objects are now all child objects of a new group parent. You can add this parent object to a Rigid Body Collection.

To edit compound rigid body properties:

1 With the compound rigid body selected, choose Group > Open.

2 To edit the compound rigid body’s properties, select the parent (dummy) and go to the properties rollout of the utility or open the Rigid Body Properties dialog. You cannot edit the Mass or Simulation Geometry values for a group parent because they are primitive properties.

TIP It's easier to select a group parent using the Select Objects dialog on page 210 with Display Subtree enabled: The group parent is displayed above its members.

3 To edit one of the rigid body’s primitive’s properties, select the appropriate child and go to the Properties rollout of the utility or open the Rigid Body Properties dialog. You can give this object a Mass value and, if you wish, change its Simulation Geometry setting. Specifying any other rigid body properties for a child object has no effect unless you remove the object from the group.

Rigid Body Collection

Create panel > Helpers > reactor > RBCollection
Animation menu > reactor > Create Object > Rigid Body Collection
reactor toolbar > create Rigid Body Collection button

The Rigid Body Collection is a reactor helper object that acts as a container for rigid bodies. Once you have added a Rigid Body Collection to your scene, you can add any valid rigid bodies in the scene to the collection. You can find out more about rigid bodies in the Rigid Body Basics on page 4249 section.

When you run the simulation, reactor examines the Rigid Body Collections in the scene and, provided the collections are not disabled, adds the rigid bodies they contain to the simulation.

At a lower level, a collection also allows you to choose the mathematical method to be used for solving the rigid body behaviors for its member bodies.
Procedures

To create and use a Rigid Body Collection:

1. Choose any of the above commands, and then click in any viewport to add the Rigid Body Collection.

   **NOTE** The icon's position has no effect on the collection's behavior.

   The collection icon is added to the scene. You can add rigid bodies to the collection in two ways: by picking or by using a selection list.

2. Add objects to the collection using either (or both) of these methods:
   - On the RB Collection Properties rollout, click the Pick button, and then in the viewport click an object to add.
   - On the RB Collection Properties rollout, click the Add button, and then use the Select Rigid Bodies dialog to specify one or more objects to add.

To create a collection and add bodies in a single step:

1. Create and select the object(s) to add to the collection.

2. Create the collection using the reactor toolbar, reactor menu, or quad menu. reactor instantly places the collection in the scene and adds the selected objects to the collection.
Interface

RB Collection Properties rollout

**Highlight** Cause the objects in the Rigid Bodies list to display momentarily in the viewports as if selected.

**Rigid Bodies** Lists the names of the objects in the Rigid Body Collection.

**Pick** Lets you add an object to the Rigid Body Collection. Click this button, then in the viewport move the cursor over the object you would like to add to the collection. If the object can be used as a rigid body the cursor will change from an arrow to a cross and you can select the object to add it to the collection.

**Add** Lets you add one or more objects from the scene to the collection. Click the button to open the Select Rigid Bodies dialog. Make a selection in the provided list, and then click the Select button to add the objects to the collection.

**Delete** Lets you remove objects from the collection. In the rigid bodies list, select the bodies you would like to remove from the collection and click this button.
Disabled When on, the collection and the bodies it contains are not added to the simulation.

**Advanced rollout**

**ODE Solver** Lets you choose the method by which reactor simulates the collection:

- **Euler** The collection calculates the behavior for its rigid bodies using an Euler ODE (Ordinary Differential Equation) solver. Euler is a fast method that provides good results in most cases.

- **Runge-Kutta** This method is more accurate in some cases but requires more computation. Use Runge-Kutta if you have many object connected using simple constraints on page 4268 like springs or dashpots, because those kind of systems can easily become unstable.

**Reset Default Values** Sets values for the collection to their defaults. In this instance, it sets the ODE Solver back to its default value.

**Constraints**

With reactor, you can easily create a simple physical simulation by simply assigning rigid body properties to objects and adding them to a Rigid Body Collection. When you run the simulation, objects can fall from the sky, slide across each other, bounce off each other, and so on. However, let’s say you want to simulate a real-world scene such as a person pushing open a door. How, for instance, do you make sure that the door rigid body doesn’t just fall onto the ground, or that it swings out in the proper direction when pushed?

To accomplish this you use constraints. These let you restrict the possible movement of objects in the physical simulation. Depending on the type of
constraint you use, you can hinge objects together, attach them together with springs that will snap back if the objects are pulled apart, or even simulate the movement of a human body joint. You can constrain objects to each other or to points in space.

This section shows you how to work with constraints in reactor.

Simple Constraints include:

- **Spring** on page 4269
- **Linear Dashpot** on page 4273
- **Angular Dashpot** on page 4277

Cooperative Constraints include:

- **Constraint Solver** on page 4283
- **Rag Doll Constraint** on page 4286
- **Hinge** on page 4307
- **Point to Point** on page 4313
- **Prismatic** on page 4320
- **Car-Wheel** on page 4326
- **Point to Path** on page 4333

**Constraint Concepts**

This topic introduces some common concepts that you'll need to understand to work with any of the reactor constraint types.

**Constraints, Simple Constraints, and Cooperative Constraints**

You use constraints in reactor to specify limitations in the movements of objects. Without constraints, the movement of objects could be limited only by collisions and deformations. This is the case in the real world: For example, a door's movement is limited by a set of pieces that form a hinge; the collisions between those objects limit the movement of the door. The motion of two objects attached by a spring is limited by the deformation of the spring. A train can move only along the path defined by a rail due to the collisions of its wheels with the rail. In many cases, though, it is preferable to specify
explicitly the effect of those objects (hinge, spring, rail) rather than model them and simulate them. This is what constraints are for.

A constraint lets you limit the way an object can move. Once you specify a constraint, reactor tries to enforce it during the simulation. For example, you can use a *Hinge* on page 4307 constraint to simulate the effect of an actual hinge on an object: No translation is allowed, and rotation is allowed around only one axis. Similarly, you can use a *Spring* on page 4269 constraint to simulate the effect of a spring (translation is limited to a certain length); or a *Point-Path* on page 4333 constraint to simulate the effect of a rail (translation and orientation are limited to follow a path).

Sometimes you will have a system of many objects constrained together. For example, if you want to simulate a character falling down the stairs, you might constrain the different bones of the character using many constraints (like *Rag Doll* on page 4286 or *Hinge* on page 4307). Because all the bodies are connected, maintaining one constraint may affect the other constraints, so it is better if they are simulated together, so they are aware of each other. Thus, some constraints require you group them so they can be solved as a system. Those constraints are called *Cooperative Constraints* on page 4281 and are usually more stable, although they can be slightly slower to simulate. The other constraints, *Simple Constrains* on page 4268, cannot be grouped and therefore are more prone to instability in complex scenes, but are faster to simulate.

**Constraint Spaces**

In rigid body dynamics, each body has six degrees of freedom to move:

- three translational degrees of freedom
- three rotational degrees of freedom

Each type of reactor constraint can remove or limit one or more of these degrees of freedom for its constrained bodies.

Depending on the number and type of these limitations, we get different types of constraint, from the simple *Point-Point* on page 4313 constraint to the much more complicated *Rag Doll* on page 4286 constraint. For example, with a Point-Point constraint, the constrained objects are completely free to rotate around the constraint pivot point, but have no linear freedom relative to each other in any direction; they are attached together at the point. However, with a Rag Doll constraint, the objects not only have no linear freedom, but their possible relative orientation is also restricted.

In each constraint, these angular and linear limits are defined in terms of the constraint's coordinate system or *constraint space*. Because a constraint restricts
the movement of its objects relative to each other, a constraint also needs to maintain a mapping from each object's local space to the constraint space. reactor lets you manipulate the constraint space in each object's local space separately, as you'll see in the Working With Constraint Spaces on page 4267 section.

Parents and Children

Each reactor constraint can have two objects: a parent object and a child object. Although two-bodied constraints actually restrict the possible movement of both bodies, it is often simpler to specify how one object is allowed to move relative to the other one, particularly when you are using limits. With reactor, you specify how the child object can move relative to the parent.

For some constraints, it makes no difference which object is the parent and which is the child. For instance, if you use a Point-Point constraint to attach two objects together at a common point, it works in exactly the same way regardless of how you specify the attached objects.

However, with the more complex Rag Doll constraint, which you typically use to model body joints, it's important to specify which object is the parent. This is because this constraint lets you specify a number of limits on how the child can move relative to the parent object. For example, when you move your torso, your arm always moves with it. So when modeling a shoulder joint, you would specify that the torso object is the parent, making the arm object the child. You can then specify limits on the arm's movement relative to the torso.

When you constrain an object to a point in world space rather than another object, the constrained object is the child object and there is no parent object.

Working With Constraint Spaces

For most constraints, by default the constraint space is aligned with the child body. This means that the constraint pivot/attachment point is positioned at the child object's pivot point, and the constraint space takes its orientation from the child body's local space. The exceptions to this are the constraints with two attachment points, Springs and Stiff Springs, and the Point-Path constraint, each of which has its own default alignment.

You can move the constraint space relative to each of the bodies by going to the constraint's Parent Space or Child Space sub-object level in the modifier stack, and then using the Move and/or Rotate tools. The space will then
maintain its position and/or orientation relative to the corresponding object during the simulation.

reactor also provides some quick shortcuts for aligning constraint spaces, available with each constraint. These are:

- **Align Spaces To Child Body**  This is the default alignment for all constraints except Spring, the Stiff Spring variant of Point-Point, and Point-Path.

- **Align Spaces To Parent Body**  The constraint space is aligned with the parent body: The pivot point is positioned at the parent body's pivot point, and the constraint space takes its orientation from the parent object's local space.

- **Align Spaces To Child Space**  Aligns the parent and child constraint spaces with the child's constraint space. So, for instance, if you move the constraint space relative to the child, you can use this option to move the parent's constraint space into alignment with it.

- **Align Spaces To Parent Space**  Aligns the parent and child constraint spaces with the parent's constraint space. So, for instance, if you move the constraint space relative to the parent, you can use this option to move the child's constraint space into alignment with it.

Certain constraints have additional alignment options:

- **Align Spaces To Each Body**  (Spring and Point-Point > Stiff Spring only) This option aligns each local constraint space (and hence the spring attachment point) with the relevant body, so each body's attachment point is at its pivot. It also sets the spring length to the current distance between the nodes. This is the default alignment for springs and stiff springs.

- **Align Parent Space To Path**  (Point-Path constraint only) This option aligns the parent space with the local space of the shape used for the constraint's path. This is the default parent space alignment for the Point-Path constraint.

**Simple Constraints**

The simple constraints provided with reactor are Spring, Linear Dashpot, and Angular Dashpot. Unlike cooperative constraints, the simple constraint does not require you to add it to a Constraint Solver on page 4283 helper. Instead, reactor adds all valid simple constraints in a scene to the simulation by default.
A two-bodied simple constraint is valid if it has two rigid bodies attached, while a single-bodied simple constraint is valid if it has one rigid body attached.

**Spring**

Create panel > Helpers > reactor > Spring
Animation menu > reactor > Create Object > Spring
reactor toolbar > Create Spring button

The Spring helper lets you create a spring-like effect between two rigid bodies in the simulation, or between a rigid body and a point in space. During the simulation, the spring exerts forces on the attached bodies in an attempt to maintain its rest length. So, for instance, if the objects are pulled apart so that the spring attachment points are further apart than the rest length, the spring works to bring them back together again.

You can configure a spring's behavior by specifying its stiffness, damping, and rest length. reactor also lets you choose whether the spring acts under extension (when the attachment points are pulled further apart) or compression (when the attachment points are pushed closer together) or both (the default). A spring that acts only on extension behaves as if the objects were joined with a rubber band.

You do not have to add a Spring constraint explicitly to a simulation, as all valid springs in a scene are added to the simulation by default. A two-bodied spring is valid if it has two rigid bodies attached, while a single-bodied spring is valid if it has one rigid body attached. When not selected, invalid springs will be colored red in the viewport.

**Procedures**

**To create a spring:**

- Choose one of the above options, and then click in any viewport to add the Spring.

  **NOTE** The icon's position has no effect on the constraint's behavior.

**To attach objects to the spring:**

1. Create the Spring and the object(s) to connect using it.
2 If you do not want to assign a second body to the spring, turn off the Parent check box on the spring’s Properties rollout if necessary.

3 Click the Child pick button and then select the object to use as the child object in one of the viewports. This attaches the Spring to the body at the body’s pivot point.

4 If the spring is two bodied, repeat step 2, using the Parent pick button to set the parent object for the spring.

To create the spring and attach the objects in a single step:

■ See the Scripts and Tools on page 4440 topic.

To change the attachment positions for the bodies:

1 With the Spring constraint selected, open the Modify panel.

2 In the modifier stack, open the Spring’s sub-object list.

3 Highlight the option corresponding to the object whose attachment point you want to move: Parent Space or Child Space. If the Spring is single-bodied, Parent Space allows you to move the world attachment position.

4 The appropriate space becomes active in the viewport and can be moved using the Move tool. The attachment point maintains its position relative to its corresponding object; for example, if you move the child object, its space, and hence its attachment point, moves with it. The attachment point doesn't actually have to be on the object.

If you move the attachment points so that they’re inside or beyond the Spring rest length, you will see the attachment points represented by large box markers and the rest length denoted by small box markers. The difference between the two is displayed in red.

5 To reset the attachment point to the object’s pivot, reattach the object to the Spring. Alternatively, if you click the Align Spaces To Each Body button, both attachment points will be reset to their respective body’s pivot.

To align the parent and child constraint spaces:

1 Ensure that the constraint is selected in one of the viewports.
2 In the Align Spaces To group, click the button for your chosen alignment. You can find out more about the alignment options in the Working With Constraint Spaces on page 4267 section.

**Interface**

**Modifier Stack**

![Modifier Stack Diagram]

**Child Space** At this sub-object level, you can select and move the constraint space for the child object, including the point relative to the child where the Spring is attached to it. When you assign a child body to the Spring, the Child Space attachment point is set to the child's pivot point. If you alter the position of the attachment point, it maintains its new position relative to the child during the simulation.

**Parent Space** At this sub-object level, you can select and move the constraint's second attachment point. If the spring is two-bodied, then this is the point relative to the parent where the spring is attached to it. When you assign a parent object to the Spring, the Parent Space attachment point is set to the parent object's pivot point. If you alter the position of the attachment point, it maintains its new position relative to the parent. If the spring is single-bodied, then the Parent Space's attachment point represents the point in the world where the spring is attached.
**Properties rollout**

**Parent** When on, the Spring has two bodies and you can designate an object to be the parent body. When off, the Spring is single-bodied and the point occupied by the Parent Space sub-object is the parent.

You assign the parent object by clicking this button and then selecting a rigid body from any viewport. Thereafter the button displays the name of the parent body.

**Child** Displays the name of the second rigid body attached to the Spring. You assign the child object by clicking this button and then selecting a rigid body from any viewport.

**Align Spaces To** Use these options to align the bodies' local constraint spaces. You can find out more about each option in the Working With Constraint Spaces on page 4267 section.
Lock Relative Transform When on, the relative transform between the child and parent constraint spaces is locked: If you move either space in the viewport, the other space moves along with it.

Stiffness The strength of the spring; governs the force the spring applies to each attached body for each unit difference between its current length and its rest length. Values greater than or equal to 0.0 are valid. Default=10.0.

Rest Length The spring applies forces to the attached objects in an attempt to reach this length. You can specify a figure in world units for this value, or you can use the Set button. The spring’s rest length is displayed in the viewports as the length of the displayed line between the two small box markers. The large box markers are the objects’ attachment points.

Set Click this button to set the spring’s rest length to the current distance between the two objects’ attachment points.

Damping Determines how quickly the oscillation of the spring settles down. It governs the forces applied to the connected bodies due to the relative velocities of their connection points. Valid damping values are those greater than or equal to 0.0. The default damping value is 1.0.

TIP Typically, a Damping value of 1/10th of the stiffness yields good results.

Act on compression When on, the spring applies forces to the attached objects when its length is less than its Rest Length. Default=on.

Act on extension When on, the spring applies forces to the attached objects when its length is greater than its Rest Length.

Disabled When on, the spring is not used in the simulation.

Reset Default Values Click this to set Stiffness, Rest Length, Damping, Act On Extension, and Act On Compression to their respective default values.

Linear Dashpot

Create panel > Helpers > reactor > L Dashpot

Animation menu > reactor > Create Object > Linear Dashpot

reactor toolbar > Create Linear Dashpot button

Dashpots typically server to cushion impact. An example of a real-world linear dashpot is the hydraulic cylinder in an automobile shock absorber. The Linear
Dashpot constraint lets you constrain two rigid bodies together in the simulation, or to constrain one body to a position in world space. It behaves like a heavily damped spring with zero rest length. You can specify the strength and damping, and whether collisions between the attached bodies are disabled.

reactor lets you specify a dashpot attachment point in each body's local space. During the simulation, the dashpot exerts impulses on the attached bodies in an attempt to make these points match up in world space, thus keeping the bodies in the same positions relative to each other. The bodies are still free to rotate around the attachment point.

You do not need to add a Linear Dashpot explicitly to a simulation, as all valid constraints in a scene are added to the simulation by default. A two-bodied dashpot is valid if it has two rigid bodies attached, while a single-bodied dashpot is valid if it has one rigid body attached. When not selected, invalid dashpots are colored red in the viewport.

Procedures

To create a Linear Dashpot:

■ Choose one of the above options, and then click in any viewport to add the dashpot.

NOTE The icon’s position has no effect on the constraint’s behavior.

To attach objects to the Linear Dashpot:

1 Create the Linear Dashpot and the objects to connect using it.

2 On the linear dashpot’s Properties rollout, click the Child pick button, and then select the object to use as the child object in one of the viewports. By default, this attaches the linear dashpot to the body at the body’s pivot point.

3 If you do not want to assign a second body to the dashpot, turn off the Parent check box, if necessary.

4 If the dashpot is two-bodied, repeat step 2, using the Parent pick button to set Parent for the Linear Dashpot.

To create the constraint and attach objects in a single step:

■ See the Scripts and Tools on page 4440 topic.
To change the attachment positions for the bodies:

1. With the dashpot selected, open the Modify panel.
2. In the modifier stack open the dashpot's sub-object list.
3. Highlight the sub-object corresponding to the object in whose space you want to move the attachment point: Parent Space or Child Space. If the dashpot is single-bodied, Parent Space allows you to move the world attachment position.
4. The appropriate point becomes active in the viewport and can be moved using the Move tool. The attachment point maintains its position relative to its corresponding object; for example, if you move the child object, its space, and hence its attachment point, moves with it. The attachment point doesn't have to actually be on either object.
5. To reset the attachment point to the child object’s pivot, reattach the objects to the dashpot, or use the Align Spaces To Child Body option.

To align the parent and child constraint spaces:

1. Ensure that the constraint is selected in one of the viewports.
2. In the Align Spaces To group, click the button for your chosen alignment. You can find out more about the alignment options in the Working With Constraint Spaces on page 4267 section.

Interface

Modifier Stack

Child Space At this sub-object level, you can select and move the dashpot attachment point for the child body. When you assign a child body to the
dashpot, the Child Space attachment point is set to the child object’s pivot point. If you alter the position of the Child Space attachment point, it maintains its new position relative to the child during the simulation.

Parent Space At this sub object level, you can select and move the dashpot attachment point for the parent body. When you assign a parent object to the dashpot, the Parent Space attachment point is set to the parent object’s pivot point. If you alter the position of the Parent Space attachment point, it maintains its new position relative to the parent during the simulation. If the dashpot is single-bodied, then the Parent Space’s attachment point represents the point in the world where the dashpot will be attached.

Properties rollout

Parent When on, the dashpot has two bodies and you can designate an object to be the parent body. When off, the dashpot is single-bodied and the point occupied by the Parent Space sub-object is the parent.

You assign the parent object by clicking this button and then selecting a rigid body from any viewport. Thereafter the button displays the name of the parent body.
**Child** Displays the name of the second rigid body attached to the dashpot. You assign the child object by clicking this button and then selecting a rigid body from any viewport.

**Align Spaces To** Use these options to align the bodies' local constraint spaces. You can find out more about each option in the Working With Constraint Spaces on page 4267 section.

**Lock Relative Transform** When on, the relative transform between the child and parent constraint spaces is locked: If you move either space in the viewport, the other space moves along with it.

**Strength** Governs the size of the impulse the dashpot applies to each attached body, taking into account the distance between the attachment points. The strength value is mass-dependent. For example, a Strength value of 10 generates a different behavior when connecting two 5 kg bodies than when connecting two 50 kg bodies. Values greater than or equal to 0 are valid for this property. Default=1.

**Damping** Determines how quickly the oscillation of the linear dashpot settles down. Damping governs the impulse applied to the connected bodies due to the relative velocities of their dashpot connection points. Valid damping values are those greater than or equal to 0 and less than or equal to 100000. Default=0.1.

**TIP** Typically, a damping value of 1/10th of the stiffness yields good results.

**Allow Interpenetration** When on, collisions are disabled between the dashpot's objects, so that they can pass through each other during the simulation. Defaults=off.

**Disabled** When on, the dashpot is not added to the simulation.

**Reset Default Values** Click this to set Strength, Damping, and Disabled to their respective default values.

---

**Angular Dashpot**

Create panel > Helpers > reactor > A Dashpot
Animation menu > reactor > Create Object > Angular Dashpot
reactor toolbar > Create Angular Dashpot button
Dashpots typically serve to cushion impact. An example of a real-world angular dashpot is a device connected to a door to keep it from slamming shut. You can use the Angular Dashpot constraint to constrain the relative orientation of two rigid bodies, or the absolute orientation of a rigid body in world space. When simulating, the dashpot exerts angular impulses on the bodies to which it is attached in an attempt to maintain the specified rotation between the objects. You can specify the dashpot’s strength and damping, and whether collisions between the system’s bodies are disabled.

An angular dashpot has two sets of axes as sub-objects. For two-bodied dashpots, these are specified as offset rotations from the dashpot’s bodies. For single-bodied dashpots, one sub-object is an offset rotation and the other is a world rotation. In a simulation, the dashpot tries to maintain a common rotation for these axes.

You do not need to add angular dashpots explicitly to a simulation, as all valid dashpots in a scene are added to the simulation by default. A dashpot is valid if it has the correct number of rigid bodies attached and is enabled. When not selected, invalid dashpots are colored red in the viewport.

Procedures

To create an Angular Dashpot:

■ Choose one of the above options, and then click in any viewport to add the dashpot.

NOTE The icon’s position has no effect on the constraint’s behavior.

To attach objects to the Angular Dashpot:

1 Create the dashpot and the objects to connect using it.

2 In the dashpot’s Properties rollout, click the Child pick button and then select the object to use as the child object in one of the viewports. By default, this aligns the Angular Dashpot’s target orientation with the child body’s local space.

3 If you do not want to assign a second body to the dashpot, turn off the Parent check box if necessary.

4 If the dashpot is two-bodied, repeat Step 2, using the Parent pick button to set Parent for the angular dashpot.
To create the constraint and attach objects in a single step:

▪ See the Scripts and Tools on page 4440 topic.

To change the offset rotations for the bodies:

1. With the Angular Dashpot selected, open the Modify panel.
2. In the modifier stack, open the dashpot’s sub-object list.
3. Highlight the sub-object that corresponds to the offset rotation you want to change: Child Space or Parent Space. If the dashpot is single-bodied, Parent Space represents the world rotation that the dashpot works to align the Child Space with.
4. The selected axis sub-object becomes active in the viewports and can be rotated using the Rotate tool. The axis maintains its offset rotation so that if you rotate the object it’s linked to, it also rotates.
5. To realign the rotation to the child body’s local space, reattach the object to the dashpot. Alternatively, click the Align Spaces To Child Body button.

To align the parent and child constraint spaces:

1. Ensure that the constraint is selected in one of the viewports.
2. In the Align Spaces To group, click the button for your chosen alignment. You can find out more about the alignment options in the Working With Constraint Spaces on page 4267 section.

Interface

Modifier Stack

[Diagram of Modifier Stack]

Constraints | 4279
**Child Space** At this sub-object level, you can select and rotate the offset rotation for the child object. This is the rotation that the angular dashpot tries to maintain for the child body relative to the parent. When you assign a child object to the dashpot, reactor aligns Child Space to the child body's local space. If you alter the rotation of this sub-object, it maintains its new rotation relative to the child body.

**Parent Space** At this sub-object level, you can select and rotate the offset rotation for the parent body. This is the rotation that the dashpot tries to maintain for the parent body relative to the child. When you assign the parent body to the dashpot, this rotation is aligned with the child body's local space. If you alter the rotation of this sub-object, it maintains its new rotation relative to the parent. If the dashpot is single-bodied, this rotation represents the world rotation to which the dashpot tries to align the Child Space axis.

**Properties rollout**

<table>
<thead>
<tr>
<th>-</th>
<th>Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Parent</td>
</tr>
<tr>
<td></td>
<td>Child</td>
</tr>
<tr>
<td>Align Spaces To</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Child Body</td>
</tr>
<tr>
<td></td>
<td>Child Space</td>
</tr>
<tr>
<td>Lock Relative Transform</td>
<td></td>
</tr>
</tbody>
</table>

**Strength** 1.0

**Damping** 0.1

**Allow Interpenetration** Disabled

**Reset Default Values**

**Parent** When on, the dashpot has two bodies and you can designate an object to be the parent body. When off, the dashpot is single-bodied and the point occupied by the Parent Space sub-object is the parent.
You assign the parent object by clicking this button and then selecting a rigid body from any viewport. Thereafter the button displays the name of the parent body.

**Child** Displays the name of the second rigid body attached to the dashpot. You assign the child object by clicking this button and then selecting a rigid body from any viewport.

**Align Spaces To** Use these options to align the bodies' local constraint spaces. You can find out more about each option in the Working With Constraint Spaces on page 4267 section.

**Lock Relative Transform** When on, the relative transform between the child and parent constraint spaces is locked: If you move either space in the viewport, the other space moves along with it.

**Strength** Governs the size of the impulse the dashpot will apply to each attached body, taking into account the difference in their relative offset rotations (Child Space and Parent Space). The strength value is mass dependent – for example, a strength value of 10 will generate a different behavior when connecting two 5 kg bodies than when connecting two 50 kg bodies. Values greater than or equal to 0.0 are valid for this property. Default=1.0.

**Damping** This value affects how quickly the oscillation of the angular dashpot settles down. It governs the impulse applied to the connected bodies due to their relative angular velocities. Valid damping values are those greater than or equal to 0. Default=0.1.

**TIP** Typically, a damping value of 1/10th of the stiffness yields good results.

**Allow Interpenetration** When on, collisions are disabled between the dashpot's objects: During the simulation, they can pass through each other. Default=off

**Disabled** When on, the dashpot is not added to the simulation.

**Reset Default Values** Click this to set Strength, Damping, and Disabled to their respective default values.

### Cooperative Constraints

Cooperative constraints are more stable than simple constraints on page 4268, but can be more computationally expensive to simulate. For a cooperative constraint to take part in the simulation, you first need to add it to a Constraint Solver on page 4283. The solver acts as a container for the cooperative constraint
in a particular Rigid Body Collection, and performs all the calculations necessary for the constraints to work together.

The following constraint types are cooperative constraints:

- **Hinge** on page 4307
- **Point-Point constraint** on page 4313
- **Point-Path constraint** on page 4333
- **Car-Wheel constraint** on page 4326
- **Prismatic constraint** on page 4320
- **Rag Doll constraint** on page 4286

**Common Properties**

The following properties are shared by all cooperative constraints:

**Strength and Tau**

These properties govern the impulses applied to the constraint's bodies in order to maintain the constraint, and so how strongly the constraint works to restrict their movement.

**Strength** The constraint applies an impulse to each attached body in order to maintain the constraint, based on the relative velocities of the attached bodies. The Strength parameter governs the percentage of this impulse the constraint will apply to each object. If this is sufficient, then the constraint is maintained.

**Tau** If the constraint drifts; that is, if the attached objects reach a state where the constraint isn't satisfied, then reactor applies a corrective force to rectify this drift. An impulse is calculated to rectify the drift in a constraint system; the Tau parameter governs the percentage of the corrective impulse the constraint applies to each object.

**NOTE** Tau is unavailable in the Havok 3 engine.

**Breakable Constraints**

A breakable constraint stops working when a specified threshold is exceeded. For example, you could use a breakable constraint to make a door that flies off its hinges when kicked hard enough. You make a constraint breakable by
turning on its Breakable check box. It then ceases to exert impulses on its constrained bodies if its limits are exceeded during the simulation.

<table>
<thead>
<tr>
<th>Breakable</th>
<th>Linear 1.0</th>
<th>Angular 1.0</th>
<th>Threshold 1.0</th>
</tr>
</thead>
</table>

**Breakable** Turn on to make the constraint breakable.

The Linear and Angular parameters apply only to Havok 1, and the Theshold parameter applies only to Havok 3.

**Linear** The maximum linear impulse the breakable constraint can apply before it breaks. Available in Havok 1 only.

**Angular** The maximum angular impulse the breakable constraint can apply before it breaks. Available in Havok 1 only.

**Threshold** A generic impulse parameter that governs the overall breakability of the constraint. Larger values make the constraint harder to break. Available in Havok 3 only.

**Constraint Solver**

Create panel > Helpers > reactor > CSolver

Animation menu > reactor > Create Object > Constraint Solver

reactor toolbar > Create Constraint Solver button

The Constraint Solver acts as a container for the cooperative constraints on page 4281 in a particular Rigid Body Collection on page 4261, and performs all the calculations necessary for the constraints to work together.

For a cooperative constraint to be simulated in a scene, it must be included in a valid Constraint Solver and any of the rigid bodies it contains should be in the Rigid Body Collection associated with the solver. For a Constraint Solver to be valid it should be associated with a valid Rigid Body Collection. When not selected, an invalid Constraint Solver is red in the viewport.
You can disable an entire Constraint Solver, thus disabling all of its constraints. You can also set a deactivation threshold for all the constraints in the solver, which lets you specify when you would like all the relevant rigid bodies to be deactivated.

**Procedures**

**To create a Constraint Solver:**

- Choose one of the above options, and then click in any viewport to add the Constraint Solver.

**NOTE** The icon’s position has no effect on the constraint’s behavior.

**To assign a Rigid Body Collection to the solver:**

1. On the Properties rollout click the RB Collection button. This enters a pick mode in which you can choose only a Rigid Body Collection.
2. In one of the viewports click the collection to assign to the Constraint Solver. The collection should contain the rigid bodies for the constraints in the solver.

**To add constraints to a solver:**

1. Create a Constraint Solver and some cooperative constraints to add to the solver.
2. Add constraints to the solver using either (or both) of these methods:
   - On the Constraint Solver > Properties rollout, click the Pick button, and then in the viewport click a constraint helper to add.
   - On the Properties rollout, click the Add button, and then use the dialog to specify one or more constraints to add.
Interface

Properties rollout

**RB Collection button** Displays the name of the Rigid Body Collection assigned to the solver, if any. To assign a Rigid Body Collection to the solver, click this button and then selecting a collection in any viewport.

**Highlight** Click this button to cause the constraints in the Constraints list to momentarily display in the viewports as if selected.

**Constraints** Lists the names of the constraints currently in the solver.

**Pick** Lets you add a constraint to the solver. Click this button, then in the viewport move the cursor over the constraint you would like to add to the solver. If the object can be used as a constraint, the cursor changes from an arrow to a cross and you can select the object to add it to the solver.
Add Lets you add one or more constraints from the scene to the solver. Click the button to open up the Select New Constraints To Add dialog. Make a selection in the provided list, and then add the constraints to the solver by pressing the Select button.

Delete Lets you remove constraints from the solver. Highlight the constraints to remove from the solver in the Constraints list and then click this button.

Deactivation Threshold Lets you specify a special deactivation threshold for all the rigid bodies constrained by the solver's constraints. Objects in a Constraint Solver are activated and deactivated together; this parameter specifies how aggressive the deactivation is. A value of 0.0 disables deactivation. For more information about deactivation, see Havok 1 World / Havok 3 World Rollout on page 4424.

Disabled When on, disables all the constraints in this solver.

Reset Default Values Sets Deactivation Threshold and Disabled to their respective default values.

Rag Doll Constraint

Create panel > Helpers > reactor > Ragdoll

Animation menu > reactor > Create Object > Rag Doll Constraint

reactor toolbar > Create Rag Doll Constraint button

The Rag Doll constraint lets you realistically simulate the behavior of body joints, such as hips, shoulders, and ankles. Once you decide the degree of movement a joint should have, you can model it by specifying limiting values for the Rag Doll constraint.
The Rag Doll constraint uses the parent body as a reference when defining the limits for the motion of the child body. For example, when your torso moves, your arm always moves with it. So when modeling a shoulder joint, you would usually designate the torso as the parent body and the upper arm as the child body. You can then specify limits on the arm’s movement relative to the torso, as in the above illustration: The arm is allowed to rotate relative to the torso within the grey limited cone. You can also limit the child body’s ability to twist.

You restrict how a Rag Doll constraint’s child can move relative to the parent using the constraint’s Twist, Cone, and Plane limits on page 4295. As with the other constraints, the constraint space for the Rag Doll joint is defined in each body’s local space; you use this constraint space to define your limits. The constraint space is defined as follows:

- The origin as the attachment point of the constraint between the child and parent bodies.
A twist axis, which is the axis around which the child body can twist relative to the parent body. You use this axis to specify twist limits and the child body's permitted cone of movement.

A plane and plane normal centered on the attachment point; the plane serves to define further limits that restrict the child body's movement within the cone.

reactor provides special limit visualizations to help you choose appropriate values for the Rag Doll.

For a detailed explanation of how to define those limits, see Defining Rag Doll Limits on page 4297.

reactor simulates a Rag Doll constraint if it has the correct number of rigid bodies attached and is included in a valid Constraint Solver on page 4283. When not selected, invalid rag dolls are red in the viewport.

To find out how to create an example character quickly using the Rag Doll constraint, see Scripts and Tools on page 4440.

Procedures

To create a Rag Doll constraint:

Choose one of the above options, and then click in any viewport to add the Rag Doll.

**NOTE** For a two-bodied Rag Doll, the icon’s initial position has no effect on the Rag Doll's behavior. For a single-bodied Rag Doll, it defines the initial position of the world attachment point. You can change this afterwards.

To attach objects to the Rag Doll:

1. Create the rag doll and the objects to connect using it.

2. In the rag doll’s Properties rollout, click the Child pick button. Now, in one of the viewports, select the object to use as the child object. This attaches the constraint to the selected body at the body’s pivot point. The twist axis for the constraint in the child’s space is aligned to the x-axis of the child object and initially, the plane normal will be aligned to the y-axis.

This constraint is more intuitive to use if the child and parent bodies are attached correctly. For example, if connecting an upper arm to a shoulder, the shoulder should be the parent and the upper arm the child.
3 If you do not want to assign a parent to the constraint, turn off the Parent check box.

4 If the constraint is two bodied, repeat Step 2, using the Parent pick button to set the parent body for the constraint. By default, the constraint space in the parent’s local space is also aligned with the child body.

To create the constraint and attach objects in a single step:

- See the Scripts and Tools on page 4440 topic.

To change the Rag Doll positions and orientations for the bodies:

1 With the Rag Doll selected, open the Modify panel.

2 In the modifier stack open the sub-object list.

3 Access the sub-object level corresponding to the object whose constraint representation is to be altered: Parent Space or Child Space. If the rag doll is single-bodied, Parent Space represents the world attachment position and rotation of the rag doll’s axes.

4 The space, represented by just the twist axis for the child and by the twist axis, plane normal and limit visualization for the parent, becomes active.
in the viewport and can be moved and rotated using the Move and Rotate tools respectively. The space maintains its position and rotation relative to its corresponding object. For example, if you move or rotate the child, Child Space moves relative to it.

5 To reset the space for an object to its default, reattach the object to the rag doll or use the Align To Child Body button.

6 You can also rotate the plane normal independent of the twist axis. To do this, set the sub-object level to Plane Rotation and you will be able to rotate the plane normal with respect to the parent’s twist axis.

To change the Cone and Plane limits:

1 Ensure that you can see the limit visualization for the Rag Doll; this helps you to choose appropriate limits for your desired behavior. Visual representation of the limits is displayed at the location of the parent’s sub-object. This provides you with a graphical representation of the limited area of movement for the child relative to the parent.

2 With the rag doll selected, open the Properties rollout.

NOTE You can use this rollout to specify how the limits are represented in the visualization, as well as changing the limits.

3 Change the Cone > Min and Max settings.
When displayed, the cone remains symmetrical and is rotated about the plane normal by the average offset of Min and Max. For example, if Min=-10.0 and Max=20.0, the average offset is (-10+20)*0.5=5 with a cone angle of 15. In effect, we have a 15-degree symmetrical cone [-15, 15] rotated by 5 degrees, resulting in limits of [-10, 20]. If the plane normal
is not at 90 degrees to the twist axis, non-intuitive cone rotations can result. The rotation of the twist axis for the attached object is limited to the volume of this cone. You can view the cone on its own by ensuring that only the Show Cone option in the Properties rollout > Display group is on.

4 You can also try changing the Plane > Min and Max settings. These are limited between [-90, 0] and [0,90] respectively. Taking the Min and Max limits and sweeping those angles around the plane normal creates cones. The rotation of the attached object is then limited to within the region between the plane and these cones.

You can also rotate the plane independent of the twist axis. To display the plane limits, turn on Display rollout Show Plane Limits.

5 By combining Cone and Plane limits you generate valid rotational regions for the child object relative to the parent object. This is the region represented by the Show Volume option.
NOTE  Cone and plane limits limit the movement independently. As a result, it is possible to have ineffective plane limits, where the cones generated by the plane limits do not intersect the cone generated by the cone limits. Use the plane limits to reduce the level of movement provided by the cone.

To change the Twist limits:

1. Select the Rag Doll helper object and open the Properties rollout.

2. The Twist settings limit the rotation of the child object about the twist axis relative to the parent object. To fix the twist of one object relative to the other, set the twist limits to [0,0].

3. Display the Twist limits by turning on Display rollout > Show Twist.

For a detailed explanation of how to define these limits, see Defining Rag Doll Limits on page 4297.
Interface

Modifier Stack

<table>
<thead>
<tr>
<th>Parent Space</th>
<th>Child Space</th>
<th>Plane Rotation</th>
</tr>
</thead>
</table>

**Parent Space** At this sub-object level, you can move and rotate the representation of the Rag Doll for the parent body. The constraint axes are defined in the parent body's space, which means that if you alter the position or rotation of the parent, the space moves as well and maintain its offset rotation and translation with respect to the parent. When you assign a parent body to the Rag Doll, Parent Space is also aligned with the child body's local space, with the attachment point at the child body's pivot point, the twist axis aligned with the child’s X axis, and the plane normal aligned to the child’s Y axis. If the Rag Doll is single-bodied, then Parent Space represents the world orientation and position of the constraint.

**Child Space** At this sub-object level, you can move and rotate the representation of the Rag Doll for the child body. The constraint axes are defined in the child body's space, which means that if you alter the position or rotation of the child, the space moves as well and maintain its offset rotation and translation with respect to the child. When you assign a child body to the Rag Doll, the Child Space is positioned so that the attachment point coincides with the child body pivot point, and the twist axis is aligned with the child's X axis.

**NOTE** While the Child Space sub-object has its own representation of the plane and plane normal, these are not displayed at this sub-object level, as the plane normal can be edited only in the parent body's space.

**Plane Rotation** This sub-object level allows independent rotation of the plane normal with respect to the Parent Space. This means that your plane normal doesn’t have to be perpendicular to your twist axis, allowing for a greater range of constraint setups. However, it should be noted that non-orthogonal systems affect the way reactor handles non-symmetrical cone limits.
## Properties rollout

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parent</td>
<td>None</td>
</tr>
<tr>
<td>Child</td>
<td>None</td>
</tr>
<tr>
<td>Align Spaces To</td>
<td></td>
</tr>
<tr>
<td>Child Body</td>
<td></td>
</tr>
<tr>
<td>Parent Space</td>
<td></td>
</tr>
<tr>
<td>Lock Relative Transform</td>
<td></td>
</tr>
<tr>
<td>Strength</td>
<td></td>
</tr>
<tr>
<td>Strength</td>
<td>100.0</td>
</tr>
<tr>
<td>Tau</td>
<td>100.0</td>
</tr>
<tr>
<td>Limits</td>
<td></td>
</tr>
<tr>
<td>Min</td>
<td></td>
</tr>
<tr>
<td>Max</td>
<td></td>
</tr>
<tr>
<td>Twist</td>
<td>360.0</td>
</tr>
<tr>
<td>Cone</td>
<td>45.0</td>
</tr>
<tr>
<td>Plane</td>
<td>28.0</td>
</tr>
<tr>
<td>Breakable</td>
<td></td>
</tr>
<tr>
<td>Linear</td>
<td>10.0</td>
</tr>
<tr>
<td>Angular</td>
<td>10.0</td>
</tr>
<tr>
<td>Threshold</td>
<td>10.0</td>
</tr>
<tr>
<td>Display</td>
<td></td>
</tr>
<tr>
<td>Show Twist</td>
<td></td>
</tr>
<tr>
<td>Show Cone</td>
<td></td>
</tr>
<tr>
<td>Show Plane</td>
<td></td>
</tr>
<tr>
<td>Show Plane Limits</td>
<td></td>
</tr>
<tr>
<td>Show Volume</td>
<td></td>
</tr>
<tr>
<td>Size</td>
<td>1.0</td>
</tr>
</tbody>
</table>

4294 | Chapter 14  reactor
**Parent** When on, the Rag Doll has two bodies and you can designate an object to be the parent body. When off, the Spring is single-bodied and the point occupied by the Parent Space sub-object is the parent.

You assign the parent object by clicking this button and then selecting a rigid body from any viewport. Thereafter the button displays the name of the parent body.

**Child** Displays the name of the second rigid body attached to the Rag Doll. You assign the child object by clicking this button and then selecting a rigid body from any viewport.

**Align Spaces To** Use these options to align the bodies’ local constraint spaces. You can find out more about each option in Working With Constraint Spaces on page 4267.

**Lock Relative Transform** When on, the relative transform between the child and parent constraint spaces is locked: If you move either space in the viewport, the other space moves along with it.

**Strength group**

**Strength/Tau** Govern the impulses applied to the constraint’s bodies in order to maintain the constraint, and so how strongly the constraint works to restrict their movement. You can find out more about these parameters in Strength and Tau on page 4282.

**Limits group**

**Twist Min** The minimum rotation about the twist axis the constraint allows between the reference and attached objects' constraint spaces. For example, if Min=–5 then, with respect to the constraint spaces, the child cannot rotate more than 5 degrees counterclockwise about the twist axis.

**Twist Max** The maximum rotation about the twist axis the constraint allows between the reference and attached objects' constraint spaces. For example, if Max=5 then, with respect to the constraint spaces, the child cannot rotate more than 5 degrees clockwise about the twist axis.

**Cone Min** The minimum value, in degrees, used to specify the limit cone. This value combines with the Cone Max value to generate a symmetrical cone. This cone is rotated about the plane normal by an offset calculated by combining these limits. The rotation of the child’s twist axis is then limited to the volume of this cone with respect to the parent. For example, if the Min=–10 and Max=20, the range is 30 degrees. A 30-degree cone [–15,15] is created about the twist axis and is then rotated by the offset...
between the limits \((-10+20)\times0.5=5\). This results in the effective limits being 
\([-15,15]\) rotated by 5 degrees, thus final limits of \([-10,20]\).

**Cone Max** The maximum value, in degrees, used to specify the limit cone. 
This is combined with the Cone Min value to generate a symmetrical cone. 
This cone is rotated about the plane normal by an offset calculated by 
combining these limits. The rotation of the child’s twist axis is then limited 
to being within this cone with respect to the parent.

**Plane Min** The angle between the plane and a reference line in the range 
\([-90,0]\). This line is swept about the plane normal to create a cone. The child’s 
twist axis is then restricted from entering this cone. If this cone intersects the 
cone produced by the cone limits, it further inhibits the motion of the child 
with respect to the parent.

**Plane Max** The angle between the plane and a reference line in the range 
\([0,90]\). This line is swept about the plane normal to create a cone. The child’s 
twist axis is then restricted from entering this cone. If this cone intersects the 
cone produced by the cone limits, it further inhibits the motion of the child 
with respect to the parent.

**Breakable group**

**Breakable** When on, the constraint is breakable. If its breakable limits are 
exceeded during simulation it will cease to exert impulses on the attached 
objects. You can find out more about breakable constraints in **Breakable Constraints** on page 4282.

**Display group**

**Show Twist** When on, Twist limits display as part of the Parent Space 
visualization. The representation is a cylinder section showing the restricted 
motion of the attached object with respect to rotation about the twist axis.

**Show Cone** When on, the entire symmetrical cone produced by the Cone > 
Min and Max limits displays as part of the Parent Space visualization.

**Show Plane** When on, representations of the plane and plane normal display 
as part of the Parent Space visualization.

**Show Plane Limits** When on, the cones formed by the plane limits display 
as part of the Parent Space visualization.

**Show Volume** If true, a representation of the allowed region of movement 
based on a combination of the plane and cone values will be calculated and 
displayed as part of the Parent Space visualization.
Size Allows you to change the size of the limit visualization in the viewport.

Reset Default Values Resets the parameters for this constraint to their default values.

**Defining Rag Doll Limits**

The Rag Doll constraint on page 4286 is useful for simulating complex joints, like those found in some human and animal joints (shoulders, hips), that cannot be properly simulated by simpler constraints like Hinge on page 4307 or Point-Point on page 4313 constraints.

Because they represent complex joints, the rotational limits use a complex parameterization that can benefit from some explanation. This section covers the different axes, planes, and cones used for that parameterization. We’ll begin with a simple picture of two objects connected by a rag doll constraint; you can think of a shoulder joint, where the parent body is the torso and the child body the upper arm:

![Diagram of Rag Doll Limits](image)

A. Twist Axis
B. Plane Axis
C. Twist X Plane Axis (outward)
1. Parent Body
2. Child Body

The illustration shows three axes of importance: the **Twist Axis**, the **Plane Axis** and the **Twist X Plane Axis**. The twist axis is probably the easiest to visualize and you can do so by simply stretching out your arm and rotating it so that your thumb changes from pointing upwards to downwards. Your movement is just a series of rotations along the twist axis of the shoulder and elbow. In general, the twist axis should follow the length of the child body in a joint. In reactor you can specify the extent to either side of the neutral position the constraint can twist; this need not be symmetrical.

A. Twist Axis (outward)
B. Plane Axis
C. Twist X Plane Axis
1. Twist Min.
2. Twist Max.
3. Twist Range
A. Twist Axis
B. Plane Axis
C. Twist X Plane Axis
1. Twist Range

The other two axes are interlinked and together control the volume the child body may occupy. So first we'll look at the cone angles that allow you to specify the volume that the child may move through:
A. Twist Axis
B. Plane Axis (inward)
C. Twist X Plane Axis
1. Cone Min.
2. Cone Max.
If you imagine the constraint representing your shoulder, then the green volume is the range of allowed positions your upper arm may occupy. However, we can refine the allowed volume further by using the plane axis to enforce plane limits. These limits are used to generate two further cones:

A. Twist Axis
B. Plane Axis
C. Twist X Plane Axis
A. Twist Axis
B. Plane Axis
C. Twist X Plane Axis (outward)
1. Plane
2. Plane Min. Cone
3. Plane Max. Cone
4. Plane Min.
5. Plane Max.
A. Twist Axis
B. Plane Axis
C. Twist X Plane Axis
1. Plane
2. Plane Min. Cone
3. Plane Max. Cone

This allows us to create two different scenarios: one where the cones generated by the plane limits intersect with cone produced by the cone angles, and another where they do not:
A. Twist Axis
C. Twist X Plane Axis
1. Plane Min. Cone
2. Plane Max. Cone
A. Twist Axis
C. Twist x Plane Axis (outward)
1. Plane Min. Cone
2. Plane Max. Cone

If the volumes do not intersect, the plane limits have no effect in the constraint. However, by allowing the cones to intersect, and deeming the overlapping volume as invalid body positions, we can limit the allowed positions for the child body even further:
A. Twist Axis
B. Plane Axis
C. Twist X Plane Axis

Back to Rag Doll Constraint on page 4286.
Hinge Constraint

Create panel > Helpers > reactor > Hinge
Animation menu > reactor > Create Object > Hinge Constraint
reactor toolbar > Create Hinge Constraint button

The Hinge constraint allows you to simulate a hinge-like action between two bodies. reactor lets you specify an axis in local space for each body, with a position and a direction. During the simulation, the two axes attempt to match position and direction, thereby creating an axis around which the two bodies can rotate. Alternatively, you can hinge a single body to an axis in world space.

You can also limit the rotation between the attached objects relative to the hinge axis, allowing you, for instance, to create a door that can open only to a specified extent. You define this limitation with respect to an axis perpendicular to the hinge axis for each body.

A Hinge constraint is simulated only if it has the correct number of rigid bodies attached and is included in a valid Constraint Solver on page 4283. When not selected, an invalid Hinge is red in the viewport.

Procedures

To create a Hinge constraint:

■ Choose one of the above options, and then click in any viewport to add the Hinge constraint.

NOTE: The icon's position has no effect on the constraint's behavior.

To attach objects to the Hinge:

1 Create the Hinge and the objects to connect using it.

2 On the Hinge's Properties rollout, click the Child pick button, and then select the object to use as the child object in one of the viewports. By default, this attaches the constraint so that its axis goes through the child body pivot point and the axes are aligned with the child body's local space. The constraint axis is aligned with the child's Z axis, and the perpendicular axis used for rotation limits is aligned to the child's X axis.
3 If you do not want to assign a second body to the Hinge, turn off the Parent check box if necessary.

4 If the Hinge is to be two-bodied, repeat step 2, using the Parent pick button to set Parent for the Hinge.

To create a Hinge and attach objects in a single step:

- See the Scripts and Tools on page 4440 topic.

To change the Hinge positions and rotations for the bodies:

1 With the Hinge helper object selected, open the Modify panel.

2 In the modifier stack open the sub-object list for the Hinge.

3 Access the sub-object level corresponding to the object whose hinge axes you want to move: Child Space or Parent Space. If the Hinge is single-bodied, Parent Space represents the world attachment position and rotation of the axes.

4 The space, represented by a pair of axes, the larger of which represents the hinge axis, the smaller of which is used to specify limits, becomes active in the viewport. It can be moved and rotated using the Move and Rotate tool respectively. The space maintains its position and rotation relative to its corresponding object. For example, if you move or rotate the child body, the Child Space moves with it.

5 To reset the axes to their default alignment, reattach the objects to the Hinge or click the Align Spaces To > Child Body button.
To limit the rotation between the attached objects:

1. With the Hinge selected, open the Properties rollout.

2. Turn on the Limited check box.
   
   The Hinge limits display around the Parent Space axis.
   
   The default angle limits are \(-90.0\) and \(90.0\). This means that in a situation where the sub-objects are fully aligned for the objects, the objects will be able to rotate 90 degrees in either direction about the shared hinge axis.
   
   The child object is free to rotate within the indicated limits relative to the parent during the simulation.

3. Change the minimum and maximum rotations the constraint maintains between the objects by adjusting the Min Angle and Max Angle values.
   
   The limit display updates to reflect your changes, to help you choose appropriate values. Upon simulation you can see that the rotation between the objects has been limited.
Interface

Modifier Stack

Parent Space At this sub-object level, you can move and rotate the representation of the Hinge for the parent body. The Hinge axes are defined in the parent body's space, which means that if you alter the position or rotation of the parent, the space moves as well and maintains its offset rotation and translation with respect to the parent. When you assign a parent body to the Hinge, Parent Space is also aligned with the child body's local space, with the Hinge axis going through the child body's pivot point. If the Hinge is single-bodied, then Parent Space represents the world orientation and position of the Hinge.

Child Space At this sub-object level, you can move and rotate the representation of the Hinge for the child body. The Hinge axes are defined in the child body's space, which means that if you alter the position or rotation of the child, the space moves as well and maintains its offset rotation and translation with respect to the child. When you assign a child body to the Hinge, the Child Space hinge axis is positioned so that it goes through the child body pivot point, and the axes are aligned with the child body's local space: The Hinge axis is aligned with the child's Z axis, and the perpendicular axis used for rotation limits is aligned to the child's X axis.
**Properties rollout**

- **Parent** When on, the Hinge has two bodies and you can designate an object to be the parent body. When off, the Hinge is single-bodied and the point occupied by the Parent Space sub-object is the parent.

Constraints | 4311
You assign the parent object by clicking this button and then selecting a rigid body from any viewport. Thereafter the button displays the name of the parent body.

**Child** Displays the name of the second rigid body attached to the Hinge. You assign the child object by clicking this button and then selecting a rigid body from any viewport.

**Align Spaces To** Use these options to align the bodies' local constraint spaces. You can find out more about each option in *Working With Constraint Spaces* on page 4267.

**Lock Relative Transform** When on, the relative transform between the child and parent constraint spaces is locked: If you move either space in the viewport, the other space moves and rotates along with it, and vice-versa.

**Strength group**

**Strength/Tau** Govern the impulses applied to the constraint's bodies in order to maintain the constraint, and so how strongly the constraint works to restrict their movement. You can find out more about these parameters in *Strength and Tau* on page 4282.

**Limited group**

**Limited** When on, limits the rotation about the hinge axis between the attached objects. When this value is true, the child object will only be free to rotate relative to the parent within the range specified by the Min Angle and Max Angle values. You can also specify a friction value for a limited Hinge.

**Min Angle** The minimum rotation the constraint allows between the two hinge spaces. For example, if Min Angle is \(-5.0\) then the child body cannot rotate more than 5 degrees counter clockwise about the hinge axis relative to the parent body.

**Max Angle** The maximum rotation the constraint allows between the two hinge spaces. For example, if Max Angle is \(5.0\) then the child body cannot rotate more than 5 degrees clockwise about the hinge axis relative to the parent body.

**Friction** The level of friction applied to the objects as they try to rotate about the hinge axis. It is only applied to limited Hinges.
**Breakable group**

**Breakable** When on, the constraint is breakable. If its breakable limits are exceeded during simulation, it ceases to exert impulses on the attached objects. You can find out more about breakable constraints in Breakable Constraints on page 4282.

**Display group**

Size Lets you change the size of the Hinge limit display in the viewport.

**Reset Default Values** Returns the Strength, Tau, Min Angle, Max Angle, Friction, Linear, Angular, Threshold, and Display settings to their default values.

---

**Point-Point Constraint**

Create panel > Helpers > reactor > Point-Point

Animation menu > reactor > Create Object > Point-Point Constraint

reactor toolbar > Create Point-Point Constraint button

The Point-Point (point-to-point) constraint lets you attach two objects together, or an object to a point in world space. It forces its objects to try to share a common point in space. The objects can rotate freely relative to each other, but always have the attachment point in common. When you set up the constraint, the point is defined in the object space of each object involved. During the simulation the constraint tries to apply forces to the objects so that the two pivot points defined by the two objects match.

reactor also provides two variations on the Point-Point constraint: Limited and Stiff Spring. With a Limited Point-Point constraint, you can specify limits for how much the child object can rotate relative to the parent. A Stiff Spring constraint is similar to a standard Point-Point constraint with one important exception: It holds the constrained bodies apart at a specified distance, as if they were attached at each end of an invisible rod. The Stiff Spring variant requires a point in the body space of each of two bodies, and a constant distance by which reactor must keep these two points separated. Each body is free to rotate around its point.
The constraint is simulated when it has the correct number of rigid bodies attached and is included in a valid Constraint Solver on page 4283. When not selected, an invalid Point-Point constraint is red in the viewport.

**Procedures**

To create a Point-Point constraint:

- Choose one of the above options, and then click in any viewport to add the Point-Point constraint.

**NOTE** The icon’s position has no effect on the constraint’s behavior.

To attach objects to the Point-Point constraint:

1. Create the constraint and the objects to connect with it.
2. On the constraint’s Properties rollout, click the Child pick button, and then select the object to use as the child object in one of the viewports. By default, this attaches the constraint to the body at the body’s pivot point.
3. If you do not want to assign a second body to the constraint, turn off the Parent check box if necessary.
4. If the constraint is to be two-bodied, make sure Parent is on and then use the Parent pick button to set the parent for the constraint. By default, the attachment point for the parent is also aligned with the child body’s pivot point, which means that the bodies will maintain their current positions relative to each other in the simulation.

To create the constraint and attach objects in a single step:

- See the Scripts and Tools on page 4440 topic.

To change the attachment positions for the bodies:

1. With the constraint selected, open the Modify panel.
2. In the modifier stack open the constraint’s sub-object list.
3. Access the sub-object level corresponding to the object in whose space you want to move the attachment point: Parent Space or Child Space. If the constraint is single-bodied, Parent Space allows you to move the world attachment position.
4 The corresponding point becomes active in the viewports and can be moved using the Move tool.

The attachment point maintains its position relative to its corresponding object. For example, if you move the child object, its space, and hence its attachment point, moves with it. The attachment point doesn’t have to actually be on either object.

5 To reset the attachment point to the child object’s pivot, reattach the objects to the constraint, or click the Align Spaces To > Child Body button.

**To limit the rotation between the attached objects:**

1 With the constraint selected, open the Properties rollout.

2 In the Constraint Type group, choose Limited.

   By default, the child body can rotate a total of 90 degrees around each axis relative to the parent during the simulation: 45 degrees clockwise and 45 degrees counterclockwise.

3 You can then choose which limits to display around the Parent Space constraint axis by turning on each one’s check box.

4 If you then change the limits, the limit display updates to reflect your changes to help you choose appropriate values. Upon simulation you can see that the rotation between the objects has been limited.
You can also change the orientation of the axis to be limited by rotating the Child Space and Parent Space sub-objects.

To create a Stiff Spring constraint:

1. With a Point-Point constraint selected, open the Properties rollout.
2. In the Constraint Type group, choose Stiff Spring.
3. You can now specify a Length value for the stiff spring. The default is 0.0: the same as a Point-Point constraint.
   During the simulation, reactor works to maintain this distance between the constrained objects' attachment points. To use the current distance between the attachment points as the length, click the Set button.
Interface

Modifier Stack

<table>
<thead>
<tr>
<th>Point-Point</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Parent Space</td>
<td></td>
</tr>
<tr>
<td>Child Space</td>
<td></td>
</tr>
</tbody>
</table>

**Parent Space** At this sub-object level, you can select and move the constraint attachment point in the parent body’s local space. When you assign a parent object to the constraint, the Parent Space attachment point is set to the child object’s pivot point. If you alter the position of the Parent Space attachment point, it maintains its new position relative to the parent during the simulation. If the constraint is single-bodied, the Parent Space’s position represents the point in the world where the constraint is attached.

**Child Space** At this sub-object level, you can select and move the constraint attachment point in the child body’s local space. When you assign a child body to the constraint, the Child Space attachment point is set to the child object’s pivot point. If you alter the position of the Child Space attachment point, it maintains its new position relative to the child during the simulation.
Properties rollout

- **Parent**: None
- **Child**: None
- **Align Spacing To**: 
  - **Child Body**: Parent Body
  - **Child Space**: Parent Space
  - **Each Body**: None
- **Lock Relative Transform**: None
- **Strength**: 
  - **Strength**: 100.0
  - **Tate**: 100.0
- **Constraint Type**: 
  - **Standard**: None
  - **Limited**: None
  - **Stiff Spring**: None
- **Limited**: 
  - **Max**: 
    - **X Axis**: 25.0
    - **Y Axis**: 25.0
    - **Z Axis**: 25.0
- **Stiff Spring**: 
  - **Length**: 0.0
- **Breakable**: 
  - **Linear**: 10.0
  - **Angular**: 10.0
  - **Threshold**: 10.0
- **Display**: 
  - **Size**: 1.0
- **Reset Default Values**: None
Parent When on, the constraint has two bodies and you can designate an object to be the parent body. When off, the constraint is single-bodied and the point occupied by the Parent Space sub-object is the parent.

You assign the parent object by clicking this button and then selecting a rigid body from any viewport. Thereafter the button displays the name of the parent body.

Child Displays the name of the second rigid body attached to the constraint. You assign the child object by clicking this button and then selecting a rigid body from any viewport.

Align Spaces To Use these options to align the bodies' local constraint spaces. You can find out more about each option in Working With Constraint Spaces on page 4267.

Lock Relative Transform When on, the relative transform between the child and parent constraint spaces is locked: If you move either space in the viewport, the other space moves and rotates along with it, and vice-versa.

Strength group

Strength/Tau Govern the impulses applied to the constraint's bodies in order to maintain the constraint, and so how strongly the constraint works to restrict their movement. You can find out more about these parameters in Strength and Tau on page 4282.

Constraint Type group

These options let you choose the type of Point-Point constraint to add to your scene.

- **Standard** The default option.
- **Limited** This type allows you to limit how the child object can rotate relative to the parent.
- **Stiff Spring** This type allows you to specify a distance for reactor to maintain between the constraint attachment points.

Limited (Limited constraints only) Lets you specify how much the child object can rotate relative to the parent around the x, y, and z axes - for each axis there is a minimum (counterclockwise) and maximum (clockwise) limit. You can use the check boxes to switch on or off the limit displays in the viewport.
Length (Stiff Springs only) The distance that reactor should maintain between the constraint attachment points.

Set Sets Length to the current distance between the attachment points.

Breakable group

Breakable When on, the constraint is breakable. If its breakable limits are exceeded during simulation, it ceases to exert impulses on the attached objects. You can find out more about breakable constraints in Breakable Constraints on page 4282.

Display group

Size Lets you change the size of the constraint limit display in the viewport.

Reset Default Values Returns the constraint's parameters to their default values.

Prismatic Constraint

Create panel > Helpers > reactor > Prismatic Animation menu > reactor > Create Object > Prismatic Constraint reactor toolbar > Create Prismatic Constraint button

The Prismatic constraint serves as a constraint between two rigid bodies, or a rigid body and the world, that allows its bodies to move relative to each other along one axis only. Rotations, as well as the remaining two translation axes, are fixed. For example, you could use a Prismatic constraint when creating a forklift truck.

A Prismatic constraint is simulated if it has the correct number of rigid bodies attached and is included in a valid Constraint Solver on page 4283. When not selected, an invalid prismatic constraint is red in the viewport.

Procedures

To create a Prismatic constraint:

- Choose one of the above options, and then click in any viewport to add the Prismatic constraint.
To attach objects to the prismatic constraint:

1. Create the Prismatic constraint and the objects to connect using it.

2. On the constraint’s Properties rollout, click the Child pick button and then, in one of the viewports, select the object to use as the child. This attaches the constraint to the body at the body's pivot point. The constraint's sliding axis is aligned to the Z axis of the object.

3. If you do not want to assign a second body to the prismatic constraint, turn off the Parent check box, if necessary.

4. If the constraint is to be two-bodied, make sure Parent is on and then use the Parent pick button to set the parent for the constraint.

To create the constraint and attach objects in a single step:

- See the Scripts and Tools on page 4440 topic.

To change the Prismatic constraint positions and rotations for the bodies:

1. With the constraint selected, open the Modify panel.

2. In the modifier stack open the constraint's sub-object list.

3. Access the sub-object level corresponding to the object whose attachment point you want to move: Child Space or Parent Space. If the constraint is single-bodied, Parent Space represents the world attachment position and rotation of the constraint axes.

4. The space, represented by a pair of axes, the larger of which represents the sliding axis, becomes active in the viewport and can be moved or rotated using the Move or Rotate tool, respectively. The space maintains its position and rotation relative to its corresponding object. For example, if you move or rotate the child body, Child Space moves with it.

5. To realign the constraint space to the child body, reattach the object to the Prismatic constraint, or choose the Align To Child Body option.

To limit the movement of the child body along the sliding axis:

1. With the constraint selected, open the Properties rollout.
2 Turn on the Limited check box. Both Limit parameters (Min and Max) are set by default to 0.0. This means that from a situation where the sub-objects are fully aligned for the objects, the child can move 0 units in either direction along the shared sliding axis relative to the parent. The limits are displayed as a line in Parent Space.

3 Change the Min Limit and Max Limit settings as necessary.

**Interface**

**Modifier Stack**

<table>
<thead>
<tr>
<th>Prismatic</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parent Space</td>
</tr>
<tr>
<td>Child Space</td>
</tr>
</tbody>
</table>
**Parent Space** At this sub-object level, you can move and rotate the representation of the Prismatic constraint for the parent body. The constraint axes are defined in the parent body's space, which means that if you alter the position or rotation of the parent, the space moves as well and maintains its offset rotation and translation with respect to the parent. When you assign a parent body to the constraint, Parent Space is also aligned with the child body's local space, with the constraint axis going through the child body's pivot point. If the constraint is single-bodied, then Parent Space represents the world orientation and position of the constraint.

**Child Space** At this sub-object level, you can move and rotate the representation of the Prismatic constraint for the child body. The constraint axes are defined in the child body's space, which means that if you alter the position or rotation of the child, the space moves as well and maintains its offset rotation and translation with respect to the child. When you assign a child body to the constraint, the Child Space axis is positioned so that it goes through the child body pivot point, and the axes are aligned with the child body's local space: The prismatic sliding axis is aligned with the child's Z axis.
Properties rollout

**Parent** When on, the constraint has two bodies and you can designate an object to be the parent body. When off, the constraint is single-bodied and the point occupied by the Parent Space sub-object is the parent.
You assign the parent object by clicking this button and then selecting a rigid body from any viewport. Thereafter the button displays the name of the parent body.

**Child** Displays the name of the second rigid body attached to the constraint. You assign the child object by clicking this button and then selecting a rigid body from any viewport.

**Align Spaces To** Use these options to align the bodies' local constraint spaces. You can find out more about each option in *Working With Constraint Spaces* on page 4267.

**Lock Relative Transform** When on, the relative transform between the child and parent constraint spaces is locked: If you move either space in the viewport, the other space moves and rotates along with it, and vice-versa.

**Strength group**

**Strength/Tau** Govern the impulses applied to the constraint's bodies in order to maintain the constraint, and so how strongly the constraint works to restrict their movement. You can find out more about these parameters in *Strength and Tau* on page 4282.

**Limited group**

**Limited** When on, limits the movement of the child object along the sliding axis; the child object can move relative to the parent only within the range specified by the Min Limit and Max Limit values. You can also specify a Friction value for a limited prismatic constraint.

**Min Limit** The minimum distance the constraint allows between the two spaces. For example, if Min Limit is –5.0 then the child body then the child object cannot move more than 5 units backwards relative to the parent along the sliding axis.

**Max Limit** The maximum distance the constraint allows between the two spaces. For example, if Max Limit is 5, then the child object will not be able to move more than 5 units forward relative to the parent along the sliding axis.

**Friction** The level of friction applied to the objects as they try to move along the sliding axis. It is applied only to limited Prismatic constraints.
Breakable group

**Breakable** When on, the constraint is breakable. If its breakable limits are exceeded during simulation, it ceases to exert impulses on the attached objects. You can find out more about breakable constraints in Breakable Constraints on page 4282.

Display group

**Size** Lets you change the size of the constraint space display in the viewport.

**Reset Default Values** Returns the constraint's parameters to their default values.

**Car-Wheel Constraint**

Create panel > Helpers > reactor > Carwheel

Animation menu > reactor > Create Object > Car-Wheel Constraint

reactor toolbar > Create Car-Wheel Constraint button

You can use this constraint to attach a wheel to another object; for instance, a car chassis. You can also constrain a wheel to a position in world space. During the simulation, the wheel object is free to rotate around a spin axis defined in each object's space. Linear motion is allowed for the wheel along a suspension axis. You can also add limits to the wheel's movement along this axis. The constraint's child body always acts as the wheel, while the parent acts as the chassis.

The Car-Wheel constraint also has spin parameters. If these are nonzero, the constraint turns the wheel during the simulation. You can specify a target velocity and a target gain: the maximum angular impulse that the motor can apply to the rigid body in order to achieve the target velocity.

A Car-Wheel constraint is simulated if it has the correct number of rigid bodies attached and is included in a valid Constraint Solver on page 4283. When not selected, an invalid Car-Wheel constraint is red in the viewport.
Procedures

To create a Car-Wheel constraint:

- Choose one of the above options, and then click in any viewport to add the Car-Wheel constraint.

NOTE The icon’s position has no effect on the constraint’s behavior.

To attach objects to the Car-Wheel constraint:

1. Create the constraint and the objects to connect using it.
2. On the constraint’s Properties rollout, click the Child pick button, and then, in one of the viewports, select the object you want to use as the wheel.
   This attaches the constraint to the wheel at the wheel’s pivot point. The spin axis is aligned to the X axis of the wheel object and the suspension axis is aligned to the Z axis.
3. If you do not want to assign a chassis to the Car-Wheel constraint, turn off the Parent check box if necessary.
4. If the Car-Wheel constraint is to be two-bodied, repeat step 2, using the Parent pick button to specify the chassis object for the constraint.

To create the constraint and attach objects in a single step:

- See the Scripts and Tools on page 4440 topic.

To change the positions and rotations for the bodies:

1. With the constraint selected, open the Modify panel.
2. In the modifier stack open the constraint’s sub-object list.
3. Access the sub-object level corresponding to the object whose constraint space you want to move: Parent Space for the chassis or Child Space for the wheel. If the constraint is single-bodied, Parent Space represents the world attachment position and rotation of the constraint axes.
4. The space, represented by just a spin axis for the wheel and by the spin and suspension axes for the chassis, becomes active in the viewport and can be moved or rotated using the Move or Rotate tool, respectively. The space maintains its position and rotation relative to its corresponding
object. For example, if you move or rotate the wheel, Child Space moves with it.

5. To reset the attachment point to the child's pivot, reattach the objects to the car-wheel constraint or choose the Align Spaces To Child Body option.

6. You can also rotate the suspension axis independent of the spin axis. To do this, highlight the Suspension Rotation sub-object level; this lets you rotate the suspension axis with respect to the chassis's spin axis.

To change the suspension limits:

1. With the car-wheel constraint selected, open the Properties rollout. The default limit settings in the Suspension Parameters group are Min Limit=0.0 and Max Limit=0.0. This means that in a situation where the constraint spaces are fully aligned for the objects, the wheel cannot move along the suspension axis.

   The limits define the allowed motion of the wheel along the suspension axis with respect to the chassis, and are displayed as a line with respect to the chassis. This means that from a stable position where the sub-objects are aligned, if the limits are –5 and 10, the wheel will be able...
to move 10 units away from chassis along the suspension axis in the direction of the icon’s arrow and 5 units in the opposite direction.

2 Change the limits and observe the difference in the simulation.

3 You can also change Friction for the Car-Wheel constraint; this inhibits the wheel’s motion along the suspension axis.

To spin the wheel:

These controls are found in the Spin Parameters group.

1 Set the Velocity value to the required value. This is specified in radians per second.

2 Set the Gain. This is the maximum angular impulse the constraint can apply to maintain this angular velocity.
Interface

Modifier Stack

Parent Space At this sub-object level, you can move and rotate the representations of spin and suspension axes for the chassis. This describes where on the chassis the wheel is attached and also the directions of the spin and suspension axes for the chassis. This is defined in chassis space, which means that if you alter the position or rotation of the chassis the axes will move as well and maintain their offset rotation and translation with respect to the chassis. When you assign a chassis to the car-wheel constraint, Chassis Space’s translation is set to the wheel’s pivot point, the spin axis is aligned to the wheel’s X axis, and the suspension axis is aligned to its Z axis. If the car-wheel constraint is single-bodied, then Chassis Space represents the world orientation and position of the constraint.

Child Space At this sub-object level, you can move and rotate the representation of the constraint for the wheel. This describes both the location on the wheel that the constraint considers as its attachment point and the rotation of the spin axis for the wheel. This is defined in wheel space, which means that if you alter the position or rotation of the wheel the space moves as well and maintains its offset rotation and translation with respect to the wheel. When you assign a wheel body to the Car-Wheel constraint, Wheel Space’s translation is set to the wheel’s pivot point and the wheel’s spin axis is aligned to its X axis.

Suspension Rotation This level allows independent rotation of the suspension axis with respect to the Chassis Space. This means that your suspension axis doesn’t have to be perpendicular to your spin axis, allowing for a greater range of constraint setups.
`Parent` When on, the constraint has two bodies and you can designate an object to be the optional chassis rigid body attached to the Car-Wheel.
constraint. When off, the constraint is single-bodied and the point occupied by the Parent Space sub-object is the parent.

You assign the chassis by clicking this button and then selecting a rigid body from any viewport. Thereafter the button displays the name of the chassis object.

Child Displays the name of the second rigid body attached to the constraint. You assign the child object by clicking this button and then selecting a rigid body from any viewport.

Align Spaces To Use these options to align the bodies' local constraint spaces. You can find out more about each option in Working With Constraint Spaces on page 4267.

Lock Relative Transform When on, the relative transform between the child and parent constraint spaces is locked: If you move either space in the viewport, the other space moves and rotates along with it, and vice-versa.

Strength group

Strength/Tau Govern the impulses applied to the constraint's bodies in order to maintain the constraint, and so how strongly the constraint works to restrict their movement. You can find out more about these parameters in Strength and Tau on page 4282.

Suspension Parameters group

Min Limit The distance the constraint allows the wheel to move along the suspension axis relative to the chassis, in the direction opposite that indicated by the icon's suspension arrow. For example, if Min Limit=–5, then the wheel cannot move more than five units backwards along the suspension axis with respect to the constraint's spaces.

Max Limit The distance the constraint allows the wheel to move along the suspension axis relative to the chassis, in the direction indicated by the icon's suspension arrow. For example, if Max Limit=10 then with respect to the constraint's spaces the wheel cannot move more than 10 units forward along the suspension axis.

Friction The level of friction applied to the objects as they try to move relative to each other along the suspension axis. Available with Havok 1 only.

Strength The strength value of the suspension spring. Higher values cause less vertical movement. Available with Havok 3 only.
Damping The damping value of the suspension spring. Higher values suppress vertical oscillation. Available with Havok 3 only.

Spin Parameters group

Velocity This value indicates the angular velocity in radians per second that the constraint will seek to achieve for the wheel.

Gain This value indicates the maximum angular impulse the constraint can apply to attain the specified angular velocity.

Breakable group

Breakable When on, the constraint is breakable. If its breakable limits are exceeded during simulation, it ceases to exert impulses on the attached objects. For more information, see Breakable Constraints on page 4282.

Display group

Size Lets you change the size of the constraint space display in the viewport.

Reset Default Values Returns the constraint's parameters to their default values.

Point-Path Constraint

Create panel > Helpers > reactor > Point-Path

Animation menu > reactor > Create Object > Point-Path Constraint

reactor toolbar > Create Point-Path Constraint button

The Point-Path constraint allows you to constrain two bodies so that the child is free to move along a specified path relative to the parent. Alternatively, you can create a single-bodied version of the constraint, where the constrained body can move along a path in world space. The child body's orientation is not restricted by the constraint.

You could, for example, use a Point-Path constraint to simulate a bead on a wire. In most cases, you don't need to specify a parent rigid body for a Point-Path constraint, unless the motion of the path itself should follow another rigid body.
The constraint is simulated if it has the correct number of rigid bodies attached, a specified path shape, and is included in a valid Constraint Solver on page 4283. When not selected, invalid constraints are red in the viewport.

**Procedures**

**To create a Point-Path constraint:**

- Choose one of the above options, and then click in any viewport to add the Point-Path constraint.

**NOTE** The icon’s position has no effect on the constraint’s behavior.

**To specify objects and a path for the constraint:**

1. Create the constraint and the bodies to constrain.
2. Create a line or curve in the viewport using one of the Shapes tools on the Create panel.
3. In the constraint’s Properties rollout, click the Child pick button, and then select the object you want to use as the child object in one of the viewports.
4. If you do not want to assign a second body to the constraint, turn off the Parent check box if necessary.
5. If the constraint is to be two-bodied, repeat step 2, using the Parent pick button to set the parent for the constraint.
6. Use the Path pick button to designate the path.
   The constraint icon moves to the designated path. By default, this constraint type is aligned so that the parent constraint space is aligned with the path shape's local space, while the child space is aligned with the child body's local space.

**To change the path position and orientation for the bodies:**

1. With the constraint selected, open the Modify panel.
2. In the modifier stack open the constraint’s sub-object list.
3. Access the sub-object level corresponding to the object whose constraint space you want to move: Child Space or Parent Space. If the Point-Path constraint is single-bodied, Parent Space represents the world position and rotation of the path.
The space, represented by a set of axes and the path, becomes active in the viewport and can be moved or rotated using the Move or Rotate tool, respectively. The space maintains its position and rotation relative to its corresponding object. For example, if you move or rotate the child body, Child Space moves with it.

**Interface**

**Modifier Stack**

<table>
<thead>
<tr>
<th>Point-Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parent Space</td>
</tr>
<tr>
<td>Child Space</td>
</tr>
</tbody>
</table>

**Parent Space** At this sub-object level, you can move and rotate the representation of the constraint for the parent body. The axes and path are defined in the parent body's space, which means that if you alter the position or rotation of the parent, the space moves as well and maintains its offset rotation and translation with respect to the parent. When you assign a parent body to the constraint, Parent Space is aligned with the path's local space. If the constraint is single-bodied, then Parent Space represents the world orientation and position of the path.

**Child Space** At this sub-object level, you can move and rotate the representation of the constraint for the child body. The axes and path are defined in the child body's space, which means that if you alter the position or rotation of the child, the space moves as well and maintains its offset rotation and translation with respect to the child. When you assign a child body to the constraint, the Child Space is aligned with the child body's local space.
Properties rollout

- **Parent** When on, the constraint has two bodies and you can designate an object to be the parent body. When off, the constraint is single-bodied and the point occupied by the Parent Space sub-object is the parent.

You assign the parent object by clicking this button and then selecting a rigid body from any viewport. Thereafter the button displays the name of the parent body.
**Child** Displays the name of the second rigid body attached to the constraint. You assign the child object by clicking this button and then selecting a rigid body from any viewport.

**Align Spaces To** Use these options to align the bodies' local constraint spaces. You can find out more about each option in Working With Constraint Spaces on page 4267.

**Lock Relative Transform** When on, the relative transform between the child and parent constraint spaces is locked: If you move either space in the viewport, the other space moves and rotates along with it, and vice-versa.

**Strength group**

**Strength/Tau** Govern the impulses applied to the constraint’s bodies in order to maintain the constraint, and so how strongly the constraint works to restrict their movement. You can find out more about these parameters in Strength and Tau on page 4282.

**Breakable group**

**Breakable** When on, the constraint is breakable. If its breakable limits are exceeded during simulation, it ceases to exert impulses on the attached objects. You can find out more about breakable constraints in Breakable Constraints on page 4282.

**Display group**

**Size** Lets you change the size of the constraint space display in the viewport.

**Reset Default Values** Returns the constraint’s parameters to their default values.

**reactor Objects**

These topics describe helper objects that reactor provides specifically for use in dynamic reactor simulations.
Plane

Create panel > Helpers > reactor > Plane

Animation menu > reactor > Create Object > Plane

reactor toolbar > Create Plane button

The reactor Plane object is a type of rigid body that acts as a fixed, infinite plane in the simulation. It shouldn’t be confused with the standard 3ds Max plane, which can also be used as a rigid body provided its simulation geometry property on page 4252 is set to Concave Mesh.

Like other rigid bodies, the Plane can have display proxies assigned to it and can be contained in a compound rigid body. You can also assign friction and elasticity values to it. However, it is always fixed in the simulation (the Mass on page 4250 and Unyielding on page 4250 properties are ignored).

The reactor Plane acts in only one direction, as shown in the viewport by an arrow pointing away from its solid surface. This means that rigid bodies approaching the plane from the “wrong” direction pass through it. You can, of course, also use two opposing planes.

![The reactor Plane as rendered in a viewport](image)
Procedures

To create a Plane:

1. Choose one of the above options, and then click in any viewport. The plane’s normal is aligned with the viewport’s Z axis.
2. Use the Move and Rotate tools to adjust its position and orientation, as necessary.

Interface

Properties rollout

Show Normal When on, the Plane normal is displayed as an arrow in the viewport.

Motor

Create panel > Helpers > reactor > Motor
Animation menu > reactor > Create Object > Motor
reactor toolbar > Create Motor button

The Motor helper lets you apply a turning force to any non-fixed rigid body in the scene. You can specify the angular velocity for the target and the maximum angular impulse the Motor can apply to achieve this velocity.

You do not need to add a Motor explicitly to a simulation, as all valid motors in a scene are added to the simulation by default. A Motor is valid if its Rigid Body property has been set to a valid rigid body in the scene. When not selected, invalid motors are colored red in the viewport.
Procedures

To create a motor:

- Choose one of the above options, and then click in any viewport to add the motor.

**NOTE** The icon's position has no effect on the motor's behavior.

To set the rigid body for the motor:

1. Create the motor and the rigid body to attach the motor to.
2. On the Properties rollout, click the Rigid Body pick button and then, in one of the viewports, select the object you would like to motor to act on. The motor can apply rotational forces about one of the object's axes. The default rotation axis is the object's Z axis. The rotation axis and rotation direction are displayed in the viewport.
Interface

Motor Properties rollout

![Motor Properties rollout](image)

**Rigid Body** Displays the name of the rigid body that the motor applies forces to. You assign a motor's rigid body by clicking this button and then selecting a rigid body from any viewport.

**Ang Speed** The target angular velocity that the motor attempts to achieve for the rigid body. It is specified in radians per second, so the default value of 3.14 (pi) results in 180 degrees of rotation per second or half a revolution per second.

**Gain** The maximum angular impulse that the motor can apply to the rigid body in order to achieve the target velocity.

**Rotation Axis** The local axis for the rigid body about which the motor applies impulses. This axis has a visual representation when the motor helper is selected.
**Disabled** When on, the motor is not added to the simulation.

**Size** The size of the rotation axis in the viewport.

**Reset Default Values** Returns Ang Speed, Gain, and Rotation Axis to their default values.

---

**Toy Car**

Create panel > Helpers > reactor > Toy Car

Animation menu > reactor > Create Object > Toy Car

reactor toolbar > Create Toy Car button

The reactor Toy Car is a quick way to create and simulate a simple car without having to set up each constraint separately.

The Toy Car helper lets you choose a chassis and wheels for your car, tweak various properties such as the strength of its suspension, and specify whether you would like reactor to turn its wheels during the simulation. reactor then sets up all the necessary constraints to simulate the car.

A Toy Car is simulated if it has a rigid body assigned as a chassis and at least one rigid body assigned as a wheel. When not selected, an invalid Toy Car helper is red in the viewport.

**Procedures**

To set up a toy car, follow these procedures in order, and make sure the car has a surface to travel on, such as a level plane. For getting started, we suggest you use Icon Orientation and ignore the procedure about Common Local Orientation.
To create a Toy Car helper:

- Choose one of the above menu options, and then click in any viewport to add the Toy Car.

**NOTE** The icon’s initial position has no effect on the car’s behavior.

To set up the rigid bodies for a Toy Car:

1. Create and position the rigid bodies you want to connect using the Toy Car helper.
   
   A toy car must have a chassis and at least one wheel.

2. Use the Rigid Body Properties dialog to assign a mass value to each car element.
   
   The Mass values you specify affect how the toy car behaves. Ideally, the mass of the chassis should not be much greater than the total wheel mass, and the density of the bodies should be such that the Analyze World utility on page 4434 generates no warnings.

To assign rigid bodies to a Toy Car:

1. Create the Toy Car helper and the objects to connect using it, as described above.
2 On the Properties rollout, click the Chassis pick button, and then, in one of the viewports, select the object to use as the chassis.

The Toy Car icon moves to the chosen rigid body. By default, the icon is aligned with the chassis's local space. reactor can use this orientation as a guide for the directions of the suspension and wheel axes.

3 Add your car’s wheels to the helper. You can add wheels to the toy car either by picking or using a selection list:
   ■ Click the Pick button and then select the object to use as a wheel.
   ■ Click the Add button and then use the dialog to select one or more objects to use as wheels.

By default, reactor uses the icon orientation (taken from the chassis) to provide the directions of the wheels' spin and suspension axes. Each spin axis is aligned with the icon’s X axis and passes through the relevant wheel's pivot point. The suspension axes are aligned with the icon's Z axis, and also pass through each wheel's pivot point.

**NOTE** For this to work, make sure that the wheels are oriented correctly relative to the icon before simulating.

**To change the wheel axis orientation (Icon Orientation):**

1 Use the Rotate tool to change the toy car icon’s orientation so that it matches that of the actual car model.

2 Ensure that Toy Car Properties rollout > Toy Car Orientation is set to Icon Orientation (the default).
   The wheel axes are aligned with the icon’s new orientation during the simulation.

**To change the wheel axis orientation (Common Local Orientation):**

1 Ensure that the wheel and chassis local spaces are correctly aligned in world space.
   The initial world space orientation of the wheels relative to the chassis/icon is unimportant when using this option, as reactor reorients the bodies so that their local spaces continue to match during the simulation.

2 On the Toy Car Properties rollout, set Toy Car Orientation to Common Local Orientation.
3 Use the radio buttons to change the Suspension and Spin directions relative to the bodies' local spaces. By default, the Spin axes are aligned with the wheel and chassis's local X axes, and the suspension axes with their Z axes.

To spin the Toy Car wheels:

1 On the Toy Car Properties rollout, turn on the Spin Wheels check box.

2 Change the default Ang (Angular) Speed and Gain values as necessary. Angular Speed is the target angular velocity that reactor attempts to achieve for the wheels. The Gain is the maximum angular impulse that can be applied to the wheels in order to achieve the target velocity.
Interface

Toy Car Properties rollout

Chassis Displays the name of the rigid body that serves as the chassis. You assign the chassis object by clicking this button and then selecting a rigid body from any viewport.
Wheels Lists the names of the toy car’s wheels.

Pick Lets you add a wheel to the car. Click this button, and then in the viewport position the cursor over the object you would like to use as a wheel. If the object can be used as a rigid body, the cursor changes from an arrow to a cross and you can select the object to add it to the toy car.

Add Lets you add one or more rigid bodies from the scene to act as wheels for the toy car. Click the button to open the Select Car Wheels dialog. Make a selection in the provided list, then add the wheels to the car by clicking the Select button.

Delete Lets you remove wheels from the car. Highlight the wheels to remove from the car in the Wheels list and then click this button.

NOTE The following four parameters are available with Havok 1 only. With Havok 3, use the Havok 3 Wheel Params rollout on page 4348 settings instead.

Angular Strength The strength of the corrective forces applied to keep the wheels upright and pointing forward.

Linear Strength The strength of the forces applied to keep the wheels in position relative to the chassis.

Suspension The suspension strength for the car. The lower the value, the more the chassis bounces when forces are applied to it.

Internal Substeps Allows the car to be simulated using more substeps per keyframe than the rest of the simulation.

Increasing the Internal Substeps value can be useful if you are simulating a car with unusual parameters, which might require more substeps for stability.

Toy Car Orientation group

Choose how reactor orients the bodies in relation to the spin and suspension axes.

Icon Orientation The Toy Car icon’s initial orientation provides the directions of the wheels’ spin and suspension axes. Each spin axis is aligned with the icon’s X axis and pass through the relevant wheel’s pivot point. The suspension axes are aligned with the icon’s Z axis, and also pass through each wheel’s pivot point. The wheels’ own local orientations are unimportant.

NOTE Animating the orientation of the Toy Car icon has no effect on the direction of motion during the simulation; reactor uses only the orientation at the start of the simulation.
Common Local Orientation With this option, you align the bodies' local spaces in world space, and specify the Spin and Suspension axes relative to this common orientation. The orientation of the rigid bodies in world space before simulating is unimportant.

This means, for instance, that you can set up your car with its wheels turned sideways and they still spin around the correct axes when simulating. This option allows you to change the spin and suspension axes separately. By default, the spin axes are aligned with the wheel and chassis' local X axes, and the suspension axes with their Z axes.

Allow Wheel Penetration When on, reactor disables collision detection between the chassis and the wheels.

Spin Wheels When on, the car's wheels to spin during the simulation and an arrow appears on the Toy Car viewport icon showing the direction of motion.

■ Ang Speed The target angular velocity that reactor attempts to achieve for the wheels when Spin Wheels is on. It is specified in radians per second, so the default value of 3.14 (pi) results in 180 degrees of rotation per second or half a revolution per second.

■ Gain The maximum angular impulse that reactor can to the wheels in order to achieve the target velocity.

Disabled When on, reactor removes the Toy Car helper from the simulation.

Display Size The size of the Toy Car helper icon as displayed in the viewport.

Reset Default Values Returns the Toy Car parameters to their default values.

Havok 3 Wheel Params rollout

These parameters apply only when the simulation engine is Havok 3, and reflect the implementation of a subset of Car-Wheel constraint parameters in the Toy Car object in Havok 3.
These parameters replicate the Car-Wheel constraint parameters of the same names on page 4332.

**Fracture**

Create panel > Helpers > reactor > Fracture
Animation menu > reactor > Create Object > Fracture
reactor toolbar > Create Fracture button

The Fracture helper object simulates the breaking of a rigid body into a number of smaller pieces as the result of an impact. To do this, you need to supply the pieces that are glued together to create the whole object. This is known as "pre-fracturing," reactor does not break the pieces you supply into smaller pieces.
Asteroid fractures after a collision

**TIP** An excellent tool for pre-fracturing your objects is the ProCutter compound object on page 823.

Rigid bodies that are part of a Fracture helper move together as a single body. When a rigid body that belongs to a Fracture helper collides with another body, the collision information is analyzed and if a threshold is exceeded, the rigid body is removed from the fracture helper. Once the rigid body has been removed, it moves independently of the fracture object and is free to collide with the rigid bodies that are still part of the fracture object. This can often result in a chain reaction of pieces breaking off.

You can optionally enable the use of connectivity. Connectivity analyzes the bodies belonging to the Fracture helper to find bodies that are in contact with each other before simulation occurs. This builds up an internal graph of which bodies are connected to which other bodies. Thus groups of rigid bodies that are connected to each other, but disconnected with other bodies in the fracture helper, can move independently as separate fracturable objects. As a result, you can get the effect of multiple fracturable objects in a single Fracture helper.

After a fracture event occurs, reactor once again analyzes this connectivity graph to create new chunks if they exist. If you see floating disconnected
bodies moving strangely because they are invisibly still part of a larger fracture object, be sure to turn on connectivity. A body is considered to be in contact with another body if the closest distance between them is less than the collision tolerance.

To allow the fracture feature to work reasonably well, reactor uses a special collision detection technique: penetration depth calculation. Unlike normal rigid bodies in reactor, bodies that are part of a fracture helper are allowed to continue to collide with each other, even when they are in a interpenetrating state. To see how the non-fracture bodies are treated during collision detection, see the Fracture Tips on page 4356 topic. Penetration depth calculation, especially in the context of the simulation paradigm used in reactor, is computationally expensive, so you might notice slower performance when the fracture bodies are penetrating each other. Stability in these cases can also become an issue.

reactor provides a number of techniques for getting your fracture simulation to behave more realistically. If you find that it is unstable. For instance, the fractured object might appear to explode after a single piece breaks loose. You can find these in the Fracture Tips on page 4356 topic.

Procedures

To create a Fracture helper:

- Choose one of the above menu options, and then click in any viewport to add the Fracture helper.

  **NOTE** The icon’s position has no effect on the fracture object’s behavior.

To add rigid bodies to a Fracture helper:

1. Create a Fracture helper in the scene and some objects to use as rigid bodies.
   
   You can add rigid bodies to the helper in two ways: by picking or by using a selection list.

2. With the Fracture helper selected, use either (or both) of the following methods:
   - Click the Pick button on the Properties rollout and then select the rigid body to add to the helper.
   - Click the Add button and then use the dialog to select one or more objects to use as fracture elements.
The names of rigid bodies you add appear in the helper’s Pieces list.

**To create the Fracture helper and add objects in a single step:**
- See the [Scripts and Tools](#) on page 4440 topic.

**To prevent the Fracture object from exploding:**
- See the [Fracture Tips](#) on page 4356 topic.
Interface

Properties rollout

Highlight Click this button to cause the objects in the Pieces list to momentarily display as if selected.
**Pieces** Lists the names of the objects currently part of the Fracture object. To highlight multiple contiguous list items, click and then Shift+click. To highlight multiple non-contiguous list items or remove highlighting, use Ctrl+click.

**Pick** Lets you add an object to the Fracture helper. Click this button, and then in the viewport position the cursor over the object to add to the helper. If the object can be used as a fracture piece, the cursor changes from an arrow to a cross and you can select the object to add it to the helper.

**Add** Lets you add one or more objects from the scene to the helper. Click the button to open the Select Rigid Bodies For Fracture dialog. Make a selection in the provided list, and then press the Select button to add the objects to the helper.

**Delete** Lets you remove objects from the helper. In the Pieces list, highlight the bodies to remove from the helper and then click this button.

**Selected piece**

You can assign these properties to pieces highlighted in the Pieces list.

**Broken** This read-only check box shows whether any of the highlighted pieces have broken off at the current frame. For example, say you've created an animation from frame 0 to frame 50 using Fracture, where piece A broke off at frame 10. Highlighting piece A and moving the time slider to frame 10 or after automatically turns on Broken. Moving the time slider to frame 9 or before turns off Broken. This is because reactor keeps track of the times pieces break off. That way, if you continue the animation at frame 50, reactor knows it shouldn't add piece A to the fracture object, so it keeps moving independently. You can restore a highlighted piece to its "unbroken" state with the Reset button (see following).

**Reset** This button is available if any of the pieces broke off during a previous animation (reactor stores the times when pieces broke off). Clicking this button tells reactor to ignore the times they broke off in the previous animation.

Choose the behavior for highlighted pieces:

- **Normal** The default behavior option for a fracture piece.
- **Unbreakable** The highlighted piece never breaks away from the Fracture object, even if it experiences an intense collision.
- **Keystone** If this piece breaks, then all pieces break.
- **Break At Time** The selected piece breaks at the time you specify. For this kind of piece the Broken check box reflects the state of the piece at the
current frame. Thus, if you set a piece to break at frame 5, the Broken check box is on at frame 5 and later, and off at frames before 5.

**Use Connectivity**  When on, groups of pieces that are connected to each other move independently of pieces that they are not connected to. This is like having multiple fracture objects contained in one fracture helper. The collision detector determines that two pieces are connected to each other if their distance from each other is less than the world’s Collision Tolerance on page 4425.

**Break on**

Choose the method by which reactor determines whether fracturing should occur:

- **Impulse**  When a piece of the fracture object experiences a collision where the impulse is greater than the threshold specified, it breaks off from the fracture object. The impulse of the collision is proportional to both the relative velocity of the collision and the mass of the objects involved in the collision. The higher the mass of the object that hit the piece, the larger the impulse.

- **Velocity**  When a piece of the fracture object experiences a collision where the relative velocity is greater than the threshold specified, it breaks off from the fracture object. The size or mass of the object is not be taken into account.

**Energy Loss** The amount of extra kinetic energy is lost in the collision due to the breaking of the fracture bonds. This has the effect of dampening the collision somewhat and also transferring energy to the remaining, unbroken pieces of the fracture object. To simulate a brittle object, with maximum shatter effect, keep this value low. To simulate breakage of a material more like wood or concrete, use a high Energy Loss value.

**TIP** Increasing this value can improve the performance and stability of the simulation.

**Display: Show Bounding Box**  When on, the viewports display a box that contains all the pieces of the fracture object.

**Disabled**  When on, the Fracture helper has no influence on the rigid bodies that are part of it.

**Reset Default Values** Returns the settings to their default values.
World rollout > Fracture Penetrations group

Several additional values govern fracture behavior. These are global in that they apply to every rigid body added to a Fracture object, and are found in the Utility panel > reactor > World rollout.

These values control the behavior of penetration depth collision detection and response, and apply only to objects that are included in a Fracture helper.

Separation Time  Forces are applied to penetrating bodies that are strong enough so the bodies become separated within the time specified. To simulate an explosion effect, make this value very small and reduce the Velocity Cap value.

Velocity Cap  reactor won’t apply penetration recovery forces if they cause the relative velocity between two penetrating bodies to exceed the specified value.

Scale Tolerance  The collision tolerance for bodies that use the penetration depth algorithm is determined by multiplying the Collision Tolerance value on page 4425 by the value specified. If this value is negative, the collision tolerance will extend inside the bodies, effectively shrinking the collision geometry.

For more information about using these values, see the Fracture Tips on page 4356 topic.

Fracture Tips

This topic provides some tips on how to control fractures.

After you procedurally slice up an object for fracture, the new pieces fit snugly among each other. When one piece breaks loose after a fracture event, it might be in contact with other pieces that are still part of the non-fractured body. This can throw the broken piece into unstable oscillations against two or more opposing pieces. The result is a chain-reaction throughout the fracture body, with all the pieces flying off into space. It might appear as though some of
the pieces simply wink out of existence. Unlike normal rigid bodies in reactor, Fracture pieces are allowed to exist in a state of interpenetration, where restoring forces are applied to separate them. Many objects sitting in penetrating states next to each other can result in an unstable system.

To make the system more stable and less prone to exploding:

Try one or more of the following:

■ Reduce the Scale Tolerance value on page 4356 in the Fracture Penetrations group of the reactor utility World rollout. This value can be as low as $-1.0$, but $-0.1$ should suffice in most cases. This scales the Collision Tolerance on page 4424 for pieces of a fracture object. A negative Scale Tolerance value effectively shrinks the object as it is perceived by the collision-detection system. Pieces that were snug against each other now have a comfortable safety zone where no collisions take place. This is tied to the Collision Tolerance value, so changing Collision Tolerance changes the effective tolerance used when fracture pieces collide with other fracture pieces. It dramatically reduces unstable oscillations. This is the most effective thing to try when you wish to avoid explosions.

■ Manually offset the pieces from each other, leaving a physical gap between all pieces. The gap should be as big as Collision Tolerance * Scale Tolerance.

■ Increase the Energy Loss value on the Fracture object's Properties rollout. This is the percent of energy that can be "lost" in the fracture event by transferring momentum from the broken piece to the unbroken Fracture object. Increasing it increases the relative velocity between the newly fractured piece and the remaining unfractured pieces. Ultimately this reduces the chances of a chain-reaction of unstable oscillations.

■ Increase the Separation Time value and/or decrease the Velocity Cap in the Fracture Penetrations on page 4356 group of the World rollout. This controls how aggressively reactor pushes the pieces out of a state of interpenetration. After doing this you may notice visible interpenetrations.

■ Slice up your object in a different configuration. Avoid creating very small pieces, especially if they are right next to very large pieces.

■ Turn on the Use Connectivity check box on the Properties rollout of the Fracture helper. When connectivity is enabled, clumps of pieces that are disconnected from other clumps but still internally glued to each other are set free to move independent of the other clumps. This serves to create gaps between fractured pieces earlier, so unstable oscillations won't happen.
Storing and Accessing Collisions

Utility panel > reactor > Collisions rollout

reactor lets you store information about all rigid body collisions that occur during the simulation. You can access this information via MAXScript or save it to a text file. The information includes the objects involved, the point of collision, and the relative velocity during collision. You can then use it to generate particles or other effects in your animation when objects collide, trigger sounds, and so on.

You can activate and configure collision storing using the reactor utility’s Collisions rollout on page 4427.

Interface

Store Collisions group

Store Collisions Use these options to store collision information when creating an animation. For each collision that occurs during the simulation, reactor
can record the simulation time at which the collision occurred, the objects involved, the point of collision, and the relative velocity during the collision.

- **Do not store** reactor stores no collision data.
- **Store once** reactor stores collision data next time an animation is created.
- **Always store** reactor always stores collision data when creating an animation.

**# collisions stored** This read-only field reports how many collisions were stored in reactor last time an animation was created.

**View** Opens the Stored Collisions dialog on page 4360, which shows all the currently stored collision information.

**Clear** Deletes all stored collision information.

**Filter Before Storing**

These options let you provide more specific details about the collision information you want to record.

**Objects** When on, lets you store only collisions involving particular objects. Use the Objects button to designate those objects.
Click this button to open the Filter Bodies In Collisions dialog on page 4362. This allows you to select the pairs of objects whose collisions interest you. Only collisions involving those pairs of objects are stored.

**Velocity** When on, reactor stores only collisions that occur above a certain velocity. You can specify the threshold velocity using the provided field. reactor ignores this filter for phantom collisions on page 4251.

**Define Collision Pairs** Allows you to enable or disable collision detection between specified pairs of objects. You can find out more about this in the Collisions Rollout on page 4427 topic.
Stored Collisions Dialog

Collisions List Box This list box shows all the information stored about the collisions occurred during the last animation. The information is organized in different columns:

- **Ticks** The time, in ticks (1/4800th of a second) when the collision happened.
- **Frame / SMPTE / MM:SS:Ticks** The time, in the current time units (which can be frames, ticks, SMPTE, etc.), when the collision happened.
- **Object A** The first rigid body involved in the collision.
- **Object B** The second rigid body involved in the collision.
- **Point** The location of the collision, in world coordinates.
- **Normal** The unit normal of the collision, specified from B to A.
- **Speed** The relative velocity of the two objects along the specified normal direction.
**Phantom** Specific information generated by phantom rigid bodies on page 4251. There are three possible values:

- **Not Phantom** This collision wasn't generated by a phantom rigid body.

- **Entering** The time the phantom rigid body started penetrating (entered) the other rigid body.

- **Leaving** The time the phantom rigid body finished penetrating (exited) the other rigid body.

**Close** Closes the dialog.

**Save** Allows you to save the stored information in a text file. This is an example of the format:

```plaintext
....
Time : 4175
A : Box01
B : Teapot01
Point : ( 3.25862 -56.7632 10.0549 )
Normal : ( 1.28512e-007 3.18186e-007 -1 )
NRV : 53.4184
Phantom : Not Phantom
Time : 4415
A : Phantom
B : Box01
Point : ( 0 0 0 )
Normal : ( 0 0 0 )
NRV : 0
Phantom : Entering
Time : 4495
A : GeoSphere01
B : Box01
Point : ( -6.02472 18.1558 10.1478 )
Normal : ( -2.48431e-006 1.51463e-006 1 )
NRV : 21.6887
Phantom : Not Phantom
```
Bodies Lists the names of the reactor bodies in the scene. Highlighting an object populates the Store Collisions and Do Not Store Collisions lists for that object with respect to the other bodies in the scene. If you highlight more than one object in this list, how the lists are populated depends on the value of Common Collisions.

Common Collisions When on, if more than one rigid body is highlighted in the Bodies list, the Store and Do Not Store lists are populated from the list of possible pairs that can be made using only your selected objects. When off, the lists contain all possible pairs from the scene that contain at least one of your selected objects.

For example, take a scene containing four rigid bodies: Box01, Box02, Box03 and Box04. If Common Collisions is on, and you highlight Box01 and Box02 in the Bodies list, then the only possible pair that includes only your selected objects is Box01<->Box02.

If you highlight Box01, Box02, and Box03, then the possible pairs using these objects are Box01<->Box02, Box02<->Box03, and Box01<->Box03. If highlight the same objects with Common Collisions off, then the lists also include the highlighted objects paired with the remaining objects in the collection. This means that the available pairs would also now include Box01<->Box04, Box02<->Box04 and Box03<->Box04.

This option is selected by default.

Store Collisions Collision data is stored for any pairs of objects in this list.
Deformable Bodies

You can use rigid bodies on page 4248 in reactor to model any real-world object whose shape doesn't change over time. However, what if you want to simulate an object whose geometry does change over the course of the simulation, such as a cloak, hair, foam bricks, or perhaps a slithering tentacle? reactor allows you to model these with a second category of objects, called deformable bodies. The geometry (vertices) of deformable bodies can change over time, driven either by reactor during the simulation or by existing animation in 3ds Max, allowing the objects to bend, flex, and stretch while affecting and being affected by the rest of objects in the world simulation.

IMPORTANT The Havok 3 engine does not support deformable bodies in reactor; you can use these only with the Havok 1 engine.

In addition to creating entirely deformable objects, you can combine deformable bodies with rigid bodies, for instance to add secondary motion to a simulated character. Secondary motion could include swirling clothing, wobbling flesh, or a swinging tail. Deformable objects are also useful for environmental effects such as swinging ropes and chains, curtains, and flags with dynamic wind.

Generally, you create a deformable body in reactor by first creating a mesh or spline that models the object's basic shape, and then applying a special modifier. You can then specify additional physical properties for the object. reactor includes four main types of deformable bodies, each of which is dealt with in its own section:

- Cloth on page 4364, a deformable two-dimensional triangular mesh
- **Soft Body** on page 4374, a deformable three-dimensional closed triangular mesh.
- **Rope** on page 4386, a deformable one-dimensional chain of vertices.
- **Deforming Mesh** on page 4394, a deformable mesh whose vertices have already been animated, for instance the skin on a character rig.

As with rigid bodies, you must add deformable bodies to a collection in order to be added to the simulation. Each deformable body type has its own corresponding collection type.

Also like rigid bodies, you can constrain the possible movement of deformable bodies: see **Constraining Deformable Bodies** on page 4398.

---

### NOTE
Deformable bodies are more complex than **rigid bodies** on page 4248, so reactor requires more time to simulate them.

---

### Working with Deformable-Body Vertices

reactor includes several tools for working with individual vertices in deformable bodies. The topics covering these are:

- **Fixing Vertices in World Space** on page 4401
- **Keyframing Vertices** on page 4402
- **Attaching Vertices to a Rigid Body** on page 4404
- **Attaching Vertices to Deforming Meshes (Skin)** on page 4406
- **Soft Selection** on page 4408

---

### Cloth

Cloth objects in reactor are two-dimensional deformable bodies. Using cloth objects you can simulate flags, curtains, clothing (skirts, capes, shirts), banners and even materials like paper and sheet metal.
A character's cape and kilt are modeled as cloth.

**Cloth Modifier**

Animation menu > reactor > Apply Modifier > Cloth Modifier
reactor toolbar > Apply Cloth Modifier button

The Cloth modifier lets you to turn any geometry into a deformable mesh, allowing you to simulate the behavior of objects such as curtains, clothes, metal sheets, and flags. You can specify a number of special properties for cloth objects, including stiffness and how the object folds.

To add a cloth object to the simulation, you need to add it to a Cloth Collection on page 4372.

**Procedures**

To create a Cloth object:

1. Create the mesh object that you would like to simulate as cloth.
**NOTE** In reactor the underlying topology of this object can influence the cloth’s behavior. For instance, cloth tends to fold along contiguous edges; highly tessellated meshes also stretch more, etc. Irregular triangulations (for example, a Delaunay triangulation of a 3ds Max NURBS surface) results in isotropic behavior (same behavior across all directions), avoiding artificial creases and folds around specific directions; it can therefore produce more realistic-looking results for pieces of clothing. Regular triangulations (like that of a standard 3ds Max plane) lead to anisotropic behavior (tendency to folding and creasing is different depending on the direction), this of course might be irrelevant or even desirable in some situations.

**TIP** A quick, easy way to create a Delaunay mesh for reactor Cloth is to apply the *Garment Maker modifier* on page 1266 to a shape.

![Different tessellation produces different cloth behavior.](image)
2 With the object selected, choose one of the above options.
   The Cloth modifier appears in the object's modifier stack.

To edit a cloth object's physical properties:

1 Select the appropriate object in the scene.

2 On the Modify panel, ensure that the reactor Cloth modifier is highlighted in the modifier stack.

3 Use the Properties rollout to edit the properties, which are described in the Interface section, following.

Interface

Modifier Stack

![Modifier Stack Diagram]

**Vertex** Allows you to select individual vertices of the cloth object to apply and modify deformable constraints on page 4398.
Cloth Properties rollout

<table>
<thead>
<tr>
<th>Properties</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mass</td>
<td>1.0 kg</td>
</tr>
<tr>
<td>Friction</td>
<td>0.5</td>
</tr>
<tr>
<td>Rel Density</td>
<td>1.0</td>
</tr>
<tr>
<td>Air Resistance</td>
<td>0.01</td>
</tr>
</tbody>
</table>

- Force Model
  - Simple Force Model
    - Stiffness: 0.2
    - Damping: 0.2
  - Complex Force Model
    - Stiffness: 0.2
    - Bend: 0.02
    - Shear: 0.2
    - Damping: 0.01

- Fold Stiffness
  - None

- Avoid Self Interactions
- Constrain Deformation
- Max. (%): 10.0
- Start With Current State
- 101 keyframes stored
- Clear Keyframes
- Use Soft Selection

**Mass** The Cloth object’s mass in kilograms. This affects the behavior during collisions with other objects, and also the stretching caused by attached rigid parts.
bodies on page 4404: the higher the mass of the cloth, the less stretching induced by the rigid body.

**Friction** The coefficient of friction for the cloth's surface. As with rigid bodies, this affects how smoothly the cloth moves relative to surfaces it contacts. The Friction values for both objects in contact combine to produce a coefficient for the interaction.

**Rel Density** Cloth has no volume, so reactor cannot calculate its density. Instead, reactor provides a buoyancy property for Cloth objects, which reflects its relative density. The default value is 1.0, the density of water. This value is important only if you are going to float or immerse the cloth in water.

**Air Resistance** The extent to which the cloth loses energy as it moves.

**Force Model** Choose the way forces in the simulation affect your cloth object:
- **Simple Force Model** This default method is suitable for most situations.
  - **Stiffness** The stiffness of the cloth.
  - **Damping** How quickly the cloth dissipates energy as it changes shape.
- **Complex Force Model** This more-accurate model of cloth dynamics is more computationally expensive to simulate. It provides parameters to specify the shear and stretch stiffness separately, as well as a physically accurate out-of-plane bend property.
  - **Stretch** The cloth resistance to stretching.
  - **Bend** The cloth resistance to bending.
  - **Shear** The cloth resistance to shearing.
  - **Damping** How quickly the cloth dissipates energy as it changes shape.

**Fold Stiffness** Fold stiffness governs the cloth resistance to folding.
- **None** By default, Cloth objects have no fold stiffness, and behave like a loose material such as silk.
- **Uniform Model** This model adds fold stiffness uniformly across the surface of the cloth, regardless of its topology.
  - **Stiffness** The fold stiffness value.
Spatial Model  This more-complex model of fold stiffness can be useful if you are simulating a complicated piece of cloth, such as a dress. It allows you, for instance, to add fold stiffness only to sections of the cloth that are flat.

Stiffness  The fold stiffness value.

Distance  The degree of fold stiffness per unit area. A Distance value of 2 refers to twice the average triangle edge length in the cloth, so a large Distance value results in a large concentration of fold stiffness per unit area.

Spread Angle  Controls the degree to which fold stiffness is added to cloth when it has a non-flat shape. The angle relates to the threshold angle between two parts of the cloth, below which stiffness is added. If this value is 0.0, fold stiffness is added only to flat parts of the cloth.

Split Angle  The degree to which fold stiffness is added; specifically, how fold stiffness is concentrated along the grid lines of the cloth's original mesh.

Avoid Self-Intersections  When on, the cloth will not intersect with itself during the simulation. This results in a more realistic-looking simulation, but can increase simulation time.

Constrain Deformation  When on, limits the extent to which the cloth can stretch.

Max  A percentage value that indicates how stretchy the cloth is: The lower the value, the less stretching reactor allows.

Start With Current State  When on, the Cloth object starts the simulation using the current state stored in the modifier. This can be useful if you have, for example, draped the cloth around something in the Preview Window and then updated the viewport using Update MAX. When off, the cloth starts with the state it had originally, below the modifier. Available only when keyframes are stored.

# Keyframes Stored  This read-only shows the number of keyframes, if any, stored for the Cloth object. reactor stores keyframes for the object if you create a reactor animation, or if you use Update MAX in the Preview Window.

Clear Keyframes  Deletes any stored keyframes for the Cloth object.
Use Soft Selection Allows you to use soft selection to smooth the transition between keyframed and simulated vertices for this deformable object. For more information, see Soft Selection on page 4408.

Reset Default Values Resets the values for the Cloth object to their defaults.

Constraints rollout

These options allow you to create different types of deformable constraints for the body. For more information, see Constraining Deformable Bodies on page 4398.
Cloth Collection

Create panel > Helpers > reactor > CLCollection

Animation menu > reactor > Create Object > Cloth Collection

reactor toolbar > Create Cloth Collection button

The Cloth Collection is a reactor helper object that acts as a container for Cloth objects. Once you have added a Cloth Collection to your scene, you can add Cloth objects (object with a Cloth modifier on page 4365) in the scene to the collection.

When you run the simulation, reactor examines the cloth collections in the scene, and, provided that the collections are not disabled, adds the cloth objects they contain to the simulation.

**Procedures**

**To create and use a Cloth Collection:**

1. Create some Cloth objects by applying the reactor Cloth modifier to standard objects.
2. Choose one of the above commands, and then click in any viewport to add the Cloth Collection.

**NOTE** The icon’s position has no effect on the collection’s behavior.

The collection icon is added to the scene. You can add Cloth objects to the collection in two ways: by picking or by using a selection list.

3. Add objects to the collection using either (or both) of these methods:
   - On the Properties rollout, click the Pick button, and then in the viewport click an object to add.
   - On the Properties rollout, click the Add button, and then use the Select Cloths dialog to specify one or more objects to add.

**To create the collection and add objects in a single step:**

- See the Scripts and Tools on page 4440 topic.
Highlight Causes the objects in the collection to flash momentarily in the viewports.

Cloth Entities Lists the names of the objects currently in the Cloth Collection.

Pick Adds an object to the cloth collection. Click this button, then in the viewport move the cursor over an object to add to the collection. If it is a Cloth object, the cursor changes from an arrow to a cross and you can select the object to add it to the collection.

Add Adds one or more objects from the scene to the collection. Click the button to open the Select Cloths dialog. Highlight one or more entries in the list, and then click the Select button to add the objects to the collection.

Delete Removes objects from the collection. In the Cloth Entities list, highlight the bodies to remove from the collection and click this button.

Disabled When on, the collection and the bodies it contains are not added to the simulation.
Advanced rollout

Internal Steps  Because deformable objects are more complex to simulate, it is usually necessary to perform more simulation steps on page 4230 to increase stability. This parameter specifies the number of steps reactor performs internally to simulate objects in this collection for each simulation substep taken globally during the simulation. For example, at 60 fps, simulating at one keyframe (step) per frame, 10 substeps, at three internal substeps for this collection, reactor simulates the objects in this collection using $60 \times 10 \times 3 = 1,800$ steps per second, while the simulation in general uses $60 \times 10 = 600$ steps every second. This allows the objects in this collection to be simulated more accurately without slowing down the rest of the simulation. In general terms, you can think of it in this way:

- Precision (stability) of overall simulation = Number of Substeps (as specified on the Preview and Animation rollout on page 4422)

- Precision (stability) of objects in this collection = (Precision of overall simulation) x (Internal Substeps)

Reset Default Values  Restores Internal Steps to its default value.

Soft Bodies

Soft bodies are three-dimensional deformable bodies on page 4363. Like Cloth on page 4364 objects, they modify meshes. The main difference between cloth as soft bodies is that soft bodies have a notion of shape: a soft body tries, to some extent, to keep its original shape.
You can use soft bodies to simulate squishy objects like a partially deflated beach ball, a water bottle, jelly, or fruit. They are also useful for adding realistic secondary motion to your objects and characters: floppy ears, noses, tails, etc.

reactor provides two methods for simulating soft bodies:

- The mesh-based method uses the vertices in the mesh to operate (as with cloth and rope).
- FFD soft bodies on page 4381 manipulate the control points in an FFD grid instead.

Depending on the complexity of your objects and the desired effect, you can use either method.

Soft Body Modifier

Modify panel > Modifier List > reactor SoftBody
Animation menu > reactor > Apply Modifier > Soft Body Modifier
reactor toolbar > Apply Soft Body Modifier button

The Soft Body modifier lets you turn a rigid body into a closed, deformable, 3D triangular mesh, thus creating objects that can be flexed, bent, and squashed during the simulation. You can specify physical properties for soft bodies, including stiffness, mass, and friction.

reactor provides two types of soft body: mesh-based soft bodies, where reactor deforms the underlying mesh directly; and Freeform Deformation (FFD) bodies, in which reactor encases the original mesh in a simpler lattice that it uses to update the mesh. For more information about creating FFD bodies, see FFD Soft Bodies on page 4381.

To add a soft body to the simulation, you need to add it to a Soft Body Collection on page 4384.

Procedures

To create a soft body:

1. Create the mesh to use as the basic, non-deformed state of your soft body. You can turn any mesh with a fixed number of vertices into a soft body.
2. With the object selected, choose one of the above commands. The reactor SoftBody modifier appears in the object’s modifier stack.

To edit a soft body's physical properties:

1. Select an appropriate object in the scene.
2. On the Modify panel, ensure that the reactor SoftBody modifier is highlighted in the modifier stack.
3. Use the Properties rollout to edit the properties, which are described in the Interface section, following.
Interface

Modifier Stack

**Vertex** Allows you to select individual vertices of the soft body to which to apply and modify deformable constraints on page 4398.
**Soft Body Properties rollout**

- Mass: The mass of the soft body in kilograms. This affects the soft body behavior upon colliding with other objects, its buoyancy when interacting with water, and the stretching caused by attached rigid bodies on page 4404.

---

Mass: The mass of the soft body in kilograms. This affects the soft body behavior upon colliding with other objects, its buoyancy when interacting with water, and the stretching caused by attached rigid bodies on page 4404.
the higher the mass of the soft body, the less stretch induced by the rigid body.

**Stiffness** The stiffness of the soft body: the stiffer it is, the harder it is to deform.

**Damping** The damping coefficient for the oscillation of the soft body's compression and expansion.

**Friction** The coefficient of friction for the soft body's surface. As with rigid bodies, this affects how smoothly the soft body will move relative to surfaces it's in contact with. The friction values for both objects are combined to produce a coefficient for the interaction.

**Avoid Self-Intersections** When on, the soft body does not intersect with itself during the simulation. This results in a more realistic simulation, but can increase simulation time.

### [soft body type]

- **Mesh-Based** By default, soft bodies are mesh-based - the modifier directly modifies the underlying mesh. This option is suitable for most simple objects, such as balls and bricks. For more complex meshes (greater than 200 triangles), however, this approach can be time-consuming and may slow down the simulation. A good alternative is to use FFD soft bodies.

- # keyframes stored This indicates the number of keyframes stored for the soft body, if any. reactor stores keyframes for the object if you create a reactor animation, or use Update MAX in the Preview Window.

- **Clear Keyframes** Clears any stored keyframes for this soft body.

- **Start With Current State** The soft body starts the simulation using the current state stored in the modifier. This can be useful if you have, for example, deformed the soft body in the Preview Window and then updated the viewport using Update MAX. When off, the soft body will start with the state it had originally (below the modifier).

- **Use Soft Selection** Allows you to use soft selection to smooth the transition between keyframed and simulated vertices for this deformable object. For more information, see Soft Selection on page 4408.
- **FFD-Based**  Uses the FFD version of the Soft Body modifier. For more information about FFD bodies, including descriptions of these parameters, see FFD Soft Bodies on page 4381.

**Reset Default Values** Restores the default values for parameters in the modifier.

**Constraints rollout**

These options let you create different types of deformable constraint for the body. For more information, see Constraining Deformable Bodies on page 4398.
**FFD Soft Bodies**

reactor provides two different types of soft body: mesh-based soft bodies, where the underlying mesh is directly deformed, and Freeform Deformation (FFD) bodies. With an FFD body, reactor encases the original shape in a simpler FFD lattice. Then the simulation uses the lattice, rather than the object itself, as the soft body's shape. As the lattice deforms, it updates the original shape so that it, too, appears to deform.

![FFD soft body deformation applied to a character's nose](image)

FFD bodies are less accurately modeled than mesh-based soft bodies, but also less computationally expensive to simulate. Because of this, it's generally advisable to use an FFD-based soft body when deforming a complex mesh. As a general rule of thumb, if a mesh has more than 200 triangles, it's probably a good idea to use an FFD-based soft body.
NOTE When you view an FFD soft body in the Preview Window, you will see the FFD rather than the underlying shape. This should still give you some idea as to how the body will behave in your final animation.

Procedures

To create an FFD soft body:

1. Create the mesh to use as the basic, non-deformed state of your soft body.
2. Apply an FFD modifier: the FFD 2x2x2, 3x3x3, 4x4x4 on page 1431 or FFD(box) on page 1436 modifier.
   Different FFD dimensions produce different behavior. When using FFD(box), set the dimensions to a number that leaves the FFD vertices evenly distributed over the lattice. You can also use the Conform To Shape command to make the FFD lattice better represent the underlying geometry.
3. Apply the reactor Soft Body modifier on page 4375 on top of the FFD modifier.
4. In the Properties rollout of the Soft Body modifier, choose FFD-Based. You can now add the body to a soft body collection on page 4384 and simulate it as an FFD soft body.

Interface

FFD Options

![FFD Options](image)

**FFD-based** Specifies that you want to simulate this body as an FFD soft body.
Stable Configuration  Here you can specify which configuration (position of vertices) reactor considers to be the stable (non-deformed) configuration. The FFD soft body will tend to maintain that configuration.

- **Original Box**  The stable configuration for an FFD soft body is the original, non-deformed FFD box; any animation or modification of the lattice is ignored. This is the default option.

- **Frame**  Lets you specify the state of the FFD state at a particular keyframe as the stable configuration for the object.

Animate Transform  When on, reactor animates both the FFD lattice and the transformation of the object. In some situations, the deformation calculated by the FFD modifier is more consistent if the object transformation follows the FFD lattice.

**IMPORTANT**  Use this option only when the FFD encloses the entire mesh of the object, as the transformation applies to the whole mesh; that is, the whole object will be transformed.

Not animating the object transform can cause the FFD modifier to apply strange deformations.
Animating the object transform (turning on Animate Transform) fixes the problem.

**Soft Body Collection**

Create panel > Helpers > reactor > SBCollection

Animation menu > reactor > Create Object > Soft Body Collection

reactor toolbar > create Soft Body Collection button

The Soft Body Collection is a reactor helper object that acts as a container for soft bodies. Once you have created a Soft Body Collection, you can add any soft bodies in the scene to the collection. For more information about soft bodies, see Soft Body Modifier on page 4375.

When you run the simulation, the soft body collections in the scene are examined, and, provided the collections are not disabled, reactor adds the soft bodies they contain to the simulation.

**Procedures**

To create and use a Soft Body Collection:

1. Create some soft bodies by applying the reactor SoftBody modifier to standard objects.

2. Choose any of the above commands, and then click in any viewport to add the Soft Body Collection.

   **NOTE** The icon’s position has no effect on the collection’s behavior.
The collection icon is added to the scene. You can add soft bodies to the collection in two ways: by picking or by using a selection list.

3 Add objects to the collection using either (or both) of these methods:
   - On the Properties rollout, click the Pick button, and then in the viewport click an object to add.
   - On the Properties rollout, click the Add button, and then use the Select Soft Bodies dialog to specify one or more objects to add.

To create the collection and add objects in a single step:
   - See the Scripts and Tools on page 4440 topic.

**Interface**

**Soft Body Collection Properties rollout**

**Highlight** Click this button to cause the objects in the Soft Bodies list to momentarily display as if selected.

**Soft Bodies** Lists the names of the objects currently in the Soft Body Collection.
**Pick** Adds an object to the Soft Body Collection. Click this button, and then in the viewport move the cursor over the object to add to the collection. If it is a soft body, the cursor will change from an arrow to a cross and you can select the object to add it to the collection.

**Add** Adds one or more objects from the scene to the collection. Click the button to open the Select Soft Bodies dialog. Highlight one or more items in the list, and then click the Select button to add the objects to the collection.

**Delete** Removes objects from the collection. In the Soft Bodies list, highlight the bodies to remove from the collection and click this button.

**Disabled** When on, the collection and in turn the bodies it contains are not added to the simulation.

**Advanced rollout**

![Advanced rollout]

**Internal Steps** Specifies how many substeps per keyframe are used to simulate the collection. Deformable bodies often require a higher level of simulation accuracy than rigid bodies, so you might need to tweak this value to get realistic results.

**Reset Default Values** Resets Internal Steps to its default value.

**Rope**

The reactor Rope is a one-dimensional deformable body on page 4363. You can use it to simulate rope, string, hair, and so on. Only shapes on page 572 can be simulated as ropes.
Weighted ball at the end of a rope

Rope Modifier

Modify panel > Modifier List > reactor Rope
Animation menu > reactor > Apply Modifier > Rope Modifier
reactor toolbar > Apply Rope Modifier button

You can create a reactor Rope using any spline object in 3ds Max. The Rope modifier turns the object into a deforming, one-dimensional chain of vertices. You can use rope objects to simulate ropes, as well as hair, chains, fringing, and other rope-like objects.

A rope must be added to a rope collection on page 4392 in order to be simulated.
Procedures

To create a rope:

1. Create the spline-based shape to use to create the rope. As with all deformable bodies on page 4363, the underlying topology of this object will influence the rope's behavior. If the spline contains only two vertices, then the rope simulation geometry will have only a single section and will behave in a particularly un-rope-like fashion as a result. More vertices will allow the rope to bend easily and behave more realistically.

2. With the object selected, choose one of the commands listed above. The Rope modifier appears in the object's modifier stack.

To edit a Rope's physical properties:

1. Select the Rope object.

2. On the Modify panel, ensure that the reactor Rope modifier is selected in the modifier stack.

3. Use the Properties rollout to edit the properties, which are described in the Interface section, following.

Interface

Modifier Stack

<table>
<thead>
<tr>
<th>Modifier Stack</th>
</tr>
</thead>
<tbody>
<tr>
<td>reactor Rope</td>
</tr>
<tr>
<td>Vertex</td>
</tr>
<tr>
<td>Arc</td>
</tr>
</tbody>
</table>

**Vertex** Allows you to select individual vertices of the rope to apply and modify deformable constraints on page 4398.
Rope Properties rollout

**Mass** The rope's mass in kilograms. This affects the rope behavior on collisions against other objects, its buoyancy when interacting with water, and the stretching caused by attached rigid bodies on page 4404: the higher the mass of the rope, the less stretching induced by the rigid body.
Thickness  Lets you specify a thickness for the simulated rope, as the shape used to create the rope has no inherent thickness. A rope with a thickness of 0.0 will not be visible in the simulation.

Friction  The coefficient of friction for the rope's surface. As with rigid bodies, this affects how smoothly the rope will move relative to surfaces it's in contact with. The Friction values for both objects are combined to produce a coefficient for the interaction.

Air Resistance  The extent to which the rope loses energy as it moves.

Rope Type

- **Spring**  The default rope type.
- **Stiffness**  How much the rope can stretch.
- **Damping**  How quickly oscillations settle down when the rope is compressed or expands.
- **Num Weaves**  The extent to which the rope's inflexibility extends across vertices. For example, a value of 3 ensures that all vertices separated by three or fewer sections are subject to extra forces to stop bending. Large Num Weaves values produce an inflexible rope, whereas small values mean that only sections very close to each other will have restricted relative movement.
- **Keep Shape**  When on, the rope tries to keep its original shape, such as a spiral, rather than returning to a straight line. The effectiveness of this depends on the number of weaves (the higher the number of weaves, the stronger the shape-keeping forces).
- **Constraint**  Uses a simpler, and hence less computationally expensive, model to simulate the rope. Ropes of this type are quite stiff, and cannot be configured in the same way as ropes with a Spring type.

Avoid Self-Intersections  When on, the rope will not intersect with itself during the simulation. This results in a more realistic simulation, but can increase simulation time.

Start With Current State  The rope starts the simulation using the current state stored in the modifier. This can be useful if you have, for example, draped the rope around something in the Preview Window and then updated the viewport using Update MAX. When off, the rope starts with the state it had originally, below the modifier in the stack.
# Stored Keyframes
The number of keyframes, if any, stored for the rope. reactor stores keyframes for the rope if you create an animation, or if you use Update MAX in the Preview Window.

Clear Keyframes
Clears any stored keyframes for this rope.

Use Soft Selection
Allows you to use Soft Selection to smooth the transition between keyframed and simulated vertices for this deformable object. For more information, see Soft Selection on page 4408.

Reset Default Values
Resets the values for this rope to their defaults.

Constraints rollout
These options let you create a different types of deformable constraint for the body. For more information, see Constrain Deformable Bodies on page 4398.

**Rope Collection**

Create panel > Helpers > reactor > RPCollection  
Animation menu > reactor > Create Object > Rope Collection  
reactor toolbar > create Rope Collection button

The Rope Collection is a reactor helper object that serves as a container for ropes. Once you have placed a Rope Collection in your scene, you can add any ropes in the scene to the collection. You can find out more about ropes in the Rope Modifier on page 4387 topic.

When you run the simulation, the rope collections in the scene are examined, and, provided that the collections are not disabled, the ropes they contain are added to the simulation.

**Procedures**

**To create and use a Rope Collection:**

1. Choose any of the above commands, and then click in any viewport to add the Rigid Body Collection.

   **NOTE** The icon’s position has no effect on the collection’s behavior.

   The collection icon is added to the scene. You can add rigid bodies to the collection in two ways: by picking or by using a selection list.

2. Add objects to the collection using either (or both) of these methods:
   - On the Properties rollout, click the Pick button, and then in the viewport click an object to add.
   - On the Properties rollout, click the Add button, and then use the Select Rigid Bodies dialog to specify one or more objects to add.

**To create the collection and add objects in a single step:**

- See the Scripts and Tools on page 4440 topic.
Interface

Rope Collection Properties rollout

Highlight Causes the objects in the collection to flash momentarily in the viewports.

Rope Entities Lists the names of the objects currently in the Rope Collection.

Pick Adds an object to the Rope Collection. Click this button, and then in the viewport move the cursor over an object. If it is a Rope object, the cursor changes from an arrow to a cross and you can select the object to add it to the collection.

Add Adds one or more objects from the scene to the collection. Click the button to open the Select Ropes dialog. Highlight one or more objects in the list, then click the Select button to add the objects to the collection.

Delete Removes objects from the collection. In the Rope Entities list, highlight the bodies to remove from the collection and click this button.

Disabled When on, the collection and the bodies it contains are not added to the simulation.
Advanced rollout

Internal Steps Because deformable objects are more complex to simulate, it is usually necessary to perform more simulation steps on page 4230 to increase stability. This parameter specifies how many steps will be taken internally to simulate objects in this collection for each simulation substep taken globally during the simulation. For example, at 60 fps, simulating at one keyframe (step) per frame, 10 substeps, at three internal substeps for this collection, the objects in this collection will be simulated using 60x10x3=1,800 steps every second, while the simulation in general uses 60x10=600 steps per second. This allows the objects in this collection to be simulated more accurately without slowing down the rest of the simulation. In general terms, you can think of it this way:

- Precision (stability) of overall simulation=Number of Substeps (as specified in the Preview and Animation rollout on page 4422)
- Precision (stability) of objects in this collection=Precision of overall simulation x (multiplied by) Internal Substeps

Reset Default Values Resets Internal Steps to its default value.

Deforming Meshes (Skin)

A deforming mesh is a mesh whose vertices' behavior has been keyframed. The skin of a skinned character, where any deformation comes from the underlying animated character rig, could be used as a deforming mesh in reactor.
Deforming mesh provides a gorilla's skin.

Why use deforming meshes? Firstly, rigid bodies on page 4248 and deformable bodies on page 4363 can collide with a deforming mesh as if it was another reactor body. The deforming mesh won't be affected by the collision, but the rigid body/deformable body will. So, for instance, you can create deformable clothes for a deforming mesh that you can drape realistically around his body, or you can cause environmental objects to react to the deforming mesh.

You can also attach deformable bodies to deforming meshes. This allows you, for example, to attach physically-simulated hair, garments, or tentacles to a keyframed character. When the character moves, its simulated elements swirl, swing, or slither (as appropriate) along with it. This is known as secondary motion, and is an easy way to add realism to your characters without having to animate the behavior by hand.

Unlike the other reactor deformable body types, you do not need to apply a special modifier to a deforming mesh or set physical properties for it. You just have to add the shape to a Deforming Mesh Collection on page 4396. This is because reactor itself does not deform the mesh's vertices during the simulation: The deforming mesh is simply controlled by its current animation.
For information about how to attach objects to deforming meshes, see *Constraining Deformable Bodies* on page 4398.

**Deforming Mesh Collection**

Create panel > Helpers > reactor > DMCollection  
Animation menu > reactor > Create Object > Deforming Mesh Collection  
reactor toolbar > create Deforming Mesh Collection button

The Deforming Mesh Collection is a reactor helper object that acts as a container for *deforming meshes* on page 4394. Once you have placed a Deforming Mesh Collection in your scene, you can add any deforming meshes in the scene to the collection. For more information about deforming meshes, see *Deforming Meshes (Skin)* on page 4394.

When you run the simulation, reactor examines the deforming mesh collections in the scene, and, provided the collections are not disabled, adds the deforming meshes they contain to the simulation.

**Procedures**

To create and use a Deforming Mesh Collection:

1. Create some objects to use as deforming meshes.
2. Choose any of the above commands, and then click in any viewport to add the Deforming Mesh Collection.

**NOTE** The icon's position has no effect on the collection's behavior.

The collection icon is added to the scene. You can add deforming meshes to the collection in two ways: by picking or by using a selection list.

3. Add objects to the collection using either (or both) of these methods:
   - On the Properties rollout, click the Pick button, and then in the viewport click an object to add.
   - On the Properties rollout, click the Add button, and then use the dialog to specify one or more objects to add.
To create the collection and add objects in a single step:

- See the Scripts and Tools on page 4440 topic.

Interface

**Deforming Mesh Collection Properties rollout**

![Deforming Mesh Collection Properties rollout](image)

**Highlight** Click this button to cause the objects in the collection to flash momentarily in the viewports.

**Deforming Meshes** Lists the names of the objects in the deforming mesh collection.

**Pick** Adds an object to the deforming mesh collection. Click this button, and then in the viewport move the cursor over an object to add to the collection. If it can be used as a deforming mesh, the cursor will change from an arrow to a cross and you can select the object to add it to the collection.

**Add** Adds one or more objects from the scene to the collection. Click the button to open the Select Deforming Meshes dialog. Highlight one or more objects in the list, and then click the Select button to add the objects to the collection.
Delete: Removes objects from the collection. In the Deforming Meshes list, select the bodies to remove from the collection and then click this button.

Disabled: When on, the collection and the bodies it contains are not added to the simulation.

Advanced rollout

Freeze: When on, the deforming meshes in this collection do not follow their animation during the simulation but instead remain static. This is useful, for instance, if you want to drape clothes around a deforming-mesh-skinned character in the Preview window on page 4436 before using Update MAX - it's much easier to dress a character that isn't still walking around!

Reset Default Values: Resets the Freeze value to its default.

Constraining Deformable Bodies

As with rigid bodies, you might want to constrain the possible movement of your deformable bodies. For instance, you might want to fix cloth draperies to a position in world space, or attach deformable clothing and hair to a moveable character. However, because deformable bodies can change their shape over the course of the simulation, you can't just specify attachment points in the object's local space as you do with rigid bodies.

Instead, when you work with deformable bodies, you need to specify the vertices to constrain in the deformable mesh. You can then constrain the vertices using one of four deformable constraint types, which you can choose from the deformable body's deformable Constraints rollout.
This section has separate topics for each of the following deformable constraint types:

- **Fixing Vertices in World Space** on page 4401
- **Keyframing Vertices** on page 4402
- **Attaching Vertices to a Rigid Body** on page 4404
- **Attaching Vertices to Deforming Meshes (Skin)** on page 4406

For information about using the Soft Selection option to smooth the transition between simulated and keyframed vertices for deformable bodies, see **Soft Selection** on page 4408.

**NOTE**  You can constrain deformable bodies only to points in world space, rigid bodies, or deforming meshes. You can't attach deformable bodies to "live" deformable bodies. You can, however, attach deformable bodies to other deformable bodies once they have been simulated. For example, after simulating a piece of cloth, you can remove it from the Cloth Collection and add it to a **Deforming Mesh Collection** on page 4396. You can then attach any deformable body (cloth, soft or rope) to it using the **Attach to Deforming Mesh constraint** on page 4406.

**Procedures**

The procedure for each deformable constraint type is described in its own topic.
**Interface**

**Constraints rollout**

- **Fix Vertices** Creates a Fix Vertices to World constraint on page 4401 that fixes the chosen vertices to their current position in world space.

- **Keyframe Vertices** Creates a Keyframe constraint on page 4402 that makes the chosen vertices follow their current animation in 3ds Max.

- **Attach to Rigid Body** Creates an Attach to Rigid Body constraint on page 4404 between the chosen vertices and a rigid body. The vertices follow the animation (changes in position and rotation) of the rigid body on page 4248.
Attach to DefMesh Creates an Attach to Deforming Mesh constraint on page 4406 between the chosen vertices and a deforming mesh. The vertices will follow the animation (deformations) of the deforming mesh on page 4394.

[constraints list] Displays a list of the deformable constraints for the deformable body. To highlight a constraint for changing its parameters or deleting it, click its name in the list.

Delete Constraint Deletes the highlighted constraint in the list.

Fixing Vertices in World Space

reactor modifier (Cloth/Soft Body/Rope) > Constraints rollout

The Fix Vertices constraint lets you fix vertices in a deformable body to their current positions in world space.

A row of vertices fixes the curtain to the wall.
Procedures

To fix points in a deformable body in world space:

1. On the Modify panel, click Vertex in the deformable body modifier's sub-object list.
   This lets you select individual vertices in the deformable body.

2. On the Constraints rollout, click Fix Vertices.
   A new Constrain To World constraint appears in the constraints list.

3. Ensure the constraint is highlighted in the constraints list.

4. Select the vertices to constrain.
   These vertices remain fixed in place during the simulation, while the rest of the mesh is subject to physical forces and deformation as usual.

5. When you are finished choosing vertices, it's advisable to exit the Vertex sub-object level. This prevents you accidentally deselecting some of the constrained vertices before simulating.

6. To change the set of fixed vertices, select the object, access the modifier's Vertex sub-object level, highlight its Constrain To World constraint in the list, and then select a different set of vertices.

Keyframing Vertices

reactor modifier (Cloth/Soft Body/Rope) > Constraints rollout

This constraint allows you to make the deformable body's chosen vertices follow their current animation.
Vertices keyframed to pull a curtain across a projection screen

Procedures

To keyframe points for a deformable body:

1. On the Modify panel, click Vertex in the deformable body modifier’s sub-object list. This lets you select individual vertices in the deformable body.


3. Ensure the constraint is highlighted in the constraints list; this makes the Keyframe rollout available.

4. Select the vertices to constrain in the deformable body. During the simulation, these vertices follow the deformable body’s current animation, while the rest of the body is affected by the physical simulation as usual.

5. When finished, it’s advisable to exit the Vertex sub-object level. This prevents you accidentally deselecting some of the constrained vertices before simulating.
Interface

Keyframe rollout

![Keyframe rollout image]

Use Current Stored Keys When on, the animation used for these vertices is that after the reactor modifier is applied. In other words, if the modifier contains any keyframes, reactor uses those for the animation. When off, reactor evaluates the animation before the reactor modifier is applied, thus ignoring any stored keyframes.

Attaching Vertices to a Rigid Body

reactor modifier (Cloth/Soft Body/Rope) > Constraints rollout

The Attach To Rigid Body constraint allows you to fix vertices in a deformable body to a particular rigid body.
Vertices attach the sails to the mast and booms.

Procedures

To fix vertices in a deformable body to a rigid body:

1. On the Modify panel, click Vertex in the deformable body modifier's sub-object list.
   This lets you select individual vertices in the deformable body.

2. On the Constraints rollout, click Attach To Rigid Body.
   The new constraint appears in the Constraints list.

3. Ensure the constraint is selected in the Constraints list; this makes the Attach To RigidBody rollout available.

4. On the Attach To RigidBody rollout, click the Rigid Body pick button and then select the body to which to constrain the vertices.

5. Select the vertices to constrain in the deformable body.
   During the simulation, these vertices maintain their positions relative to the rigid body.
When finished, it's advisable to exit the Vertex sub-object level, to keep from accidentally deselecting some of the constrained vertices before simulating.

**Interface**

**Attach To Rigid Body rollout**

![Attach To Rigid Body rollout](image)

**Rigid Body** Displays the name of the rigid body to which the vertices are constrained. Choose a rigid body by clicking this button and then selecting a rigid body in one of the viewports.

**Do not affect rigid body** When on, the attached deformable body does not affect the behavior of the rigid body in the simulation. In other words, the points in the deformable body will follow the rigid body, but no force is applied to the rigid body from the deformable.

**Ignore Collisions** When on, disables collision detection between the rigid body and the deformable body.

**Attaching Vertices to Deforming Meshes (Skin)**

reactor modifier (Cloth/Soft Body/Rope) > Constraints rollout

The Attach To Deforming Mesh constraint allows you to fix vertices in a deformable body to a particular deforming mesh on page 4394. This option is useful for adding physically simulated elements such as hair and clothing to an skinned character.
Vertices attach a skirt (or kilt) to the waist of a character mesh.

**Procedures**

To fix vertices in a deformable body to a deforming mesh:

1. On the Modify panel, access the Vertex sub-object level of the deformable body's modifier. This lets you select individual vertices in the deformable body.

2. On the Constraints rollout, click Attach To DefMesh. The new constraint appears in the Constraints list.

3. Ensure the constraint is selected in the Constraints list; this makes the Attach To DefMesh rollout available.

4. On the Attach To DefMesh rollout, click the Deformable Mesh pick button and then select the body to which to constrain the vertices.

5. Select the vertices to constrain in the deformable body. During the simulation, these vertices will maintain their position relative to the deforming mesh.
When finished, it's advisable to exit the Vertex sub-object level, to keep from accidentally deselecting some of the constrained vertices before simulating.

Interface

Attach To DefMesh rollout

Deformable Mesh Displays the name of the deforming mesh to which the vertices are constrained. Choose a deforming mesh by clicking this button and then selecting the object in one of the viewports.

Ignore Collisions When on, disables collision detection between the deforming mesh and the deformable body.

Soft Selection

You can use deformable constraints to specify that you want certain vertices of a deformable object to follow a user-specified animation, such as skinning, while the rest of the object is fully physically simulated. However, sometimes this can result in a visible "join" between the animated and simulated parts of a piece of cloth, soft body or rope.

To deal with this, the Cloth on page 4365, Soft Body on page 4375, and Rope on page 4387 modifiers have a Use Soft Selection option. The option can help smooth transitions between the keyframed and simulated vertices.

The following illustration shows the effect of using this option. The cloth tube on the left has a keyframed top and a simulated bottom, with a visible join. The cloth on the right uses soft selection to blur the line between the two.
To use soft selection when animating a deformable body:

1. Before you apply the reactor modifier to a deformable body, apply a modifier that has a Soft Selection option to your object, such as Edit Mesh on page 1321 or Mesh Select on page 1500. You can also apply this modifier to the body later, but it’s important that it be below the reactor modifier in the object’s modifier stack.

2. Follow the instructions in Keyframing Vertices on page 4402 to keyframe selected points for the deformable body, then create your reactor animation.

3. With the body selected, open the selection modifier in the modifier stack, and access the Vertex sub-object level.

4. Select the vertices that should appear fully physically simulated. For instance, for a piece of cloth where the top section is keyframed, you might want only the bottom vertices to appear to be fully affected by the physical simulation.
5 On the Soft Selection rollout, turn on Use Soft Selection.

6 Set the Falloff value to specify a smooth falloff from the selected vertices to the unselected ones. This is represented visually in the viewport.

7 Now open the reactor modifier and turn on Use Soft Selection. When you run the animation, your specified falloff will be used to blend smoothly between the keyframed and simulated vertices.
Water Simulation

The reactor Water object allows you to simulate the behavior of a water surface. Objects can interact with the water in physically realistic ways, creating waves and ripples. Reactor calculates a buoyancy value for any objects that fall into the water using their mass and size, so that some objects sink and others float. You can even change the density of a water object, which affects how objects float in it.

A rag-doll mannequin floats on simulated water.

Water in reactor is a space warp on page 8727 that is simulated as water. Space warps don't render, so you need to provide reactor with a geometrical representation of the water if you want it to appear in your final animation. You do this by binding a plane or other geometry to the space warp. Note that a representation of the water still appears in the Preview Window even if you haven't done this.
Water Space Warp

Create panel > Space Warps > reactor > Water

Animation menu > reactor > Create Object > Water

reactor toolbar > Create Water button

You can use the Water space warp to simulate the behavior of a liquid surface in your reactor scene. You can specify a size for the water, and physical properties such as density, wave speed, and viscosity.

You don't need to add the water to a collection for it to take part in the simulation. However, while it will appear in the Preview Window, it will not appear in a rendered animation unless you bind the space warp to a plane or other geometry. You can find out how to do this in Rendering Water on page 4415.

Procedures

To create a Water space warp:

1 Choose one of the above commands, and then in any viewport drag out a Water object.

| TIP  For horizontal water, create the space warp in a Perspective or Top viewport.

2 Move and rotate the object as necessary using standard commands. For changing other properties, see the next procedure.

To edit the properties of a Water object:

1 Select the object in the scene.

2 On the Modify panel, open the Properties rollout.

3 Use the rollout to specify properties, as described in the Interface section.
Interface

Water Properties rollout

[Image of the Water Properties rollout with various input fields and options]

Size X: 31.947
Size Y: 98.771
Subdivisions X: 20
Subdivisions Y: 20
Landscape: <none>
Wave Speed: 39.37
Min Ripple: 3.0
Max Ripple: 39.37
Density: 1.0
Viscosity: 1.0
Depth: 10.0

Use current state
Disabled
No keyframes stored
Clear Keyframes
Show Text
Reset Default Values
Size X/Y The dimensions for the water object.

Subdivisions X/Y The tessellation for the water's mesh.

Landscape button Although water is defined using a rectangular area, you can simulate non-rectangular surfaces and obstacles inside the water by defining a landscape geometry. Once you designate landscape geometry, any vertex in the Water space warp that are contained in the landscape are fixed during the simulation and waves and ripples will be reflected at those points.

Wave Speed The speed at which wave crests propagate across the surface of the water.

Min/Max Ripple Limits on the size of the waves generated in the water.

Density The relative density of the liquid. This determines which objects will sink into the water, and at what height objects of a lesser density will float. The density is specified relative to the density of water (1.0=1,000 kg/m3).

Viscosity Resistance to flow: how difficult it is for objects to move through the liquid. A high value means that the motion of objects through the water is highly damped.

Depth The depth of the water. Buoyancy is applied only to objects inside the water.

Use Current State When on, the simulation uses the current animation to calculate the starting state. So if you have, for example, updated the water during the preview on page 4436 using the Update MAX command, the stored state is used as the initial state.

Disabled Removes the water from the simulation.

# Stored Keyframes This indicates if there are any keyframes stored for the water. Keyframes are stored for the water if you create a reactor animation in 3ds Max, or if you use Update MAX in the Preview Window.

Clear Keyframes Clears any stored keyframes for this water.

Show Text When off, the label "Water" doesn't appear next to the space warp in the viewports.

Reset Default Values Restores the default values for the object.
Rendering Water

Water in reactor is defined using a space warp. Space warps don't render, so if you want the water to appear in your final animation, you need to provide reactor with a geometrical representation of the water. To do this, you need to bind a plane or any other planar geometry to the water. The plane will deform according to the Water space warp on page 4412, and you can then render it as part of your scene.

Binding an object to the water applies a modifier to that object, which lets you set a scale strength for the deformation. For example, if you set this scale value to 2.0, any water deformation is doubled for the vertices in the object.

Procedures

To bind a plane to reactor Water:

1. Draw a plane the same size as your water in the viewport. Put it in a different place so you can easily link the two.

2. Click the Bind To Space Warp button on the main toolbar.

3. In the viewport, drag from the plane to the water space warp, or vice-versa. The reactor Water (WSM) modifier appears in the plane's modifier stack.

4. Move the plane to the same position and orientation as the space warp (or vice-versa).

Interface

Water WS Modifier Properties rollout
**Scale Strength** Acts as a multiplier for the geometry’s deformation by the water. Increases or decreases the deformation applied by the Water space warp on page 4412.

**Reset Default Values** Returns Scale Strength to its default value: 1.0.

---

**Wind**

Create panel > Helpers > reactor > Wind

Animation menu > reactor > Create Object > Wind

reactor toolbar > Create Wind button

The Wind helper object lets you add wind effects to reactor scenes, allowing you, for instance, to make curtains flap in the breeze.

After adding the Wind helper to your scene, you can configure various properties for the effect such as its speed, gusts, and whether objects in your scene can be sheltered from the wind. You can animate most of these parameters. The orientation of the helper icon indicates the direction of the wind: It blows in the direction of the weathervane arrow. You can also animate this direction by animating the icon’s orientation.
Procedures

To add wind to a scene:

1. Choose one of the above commands, and then click in any viewport to add the Wind helper.

   **NOTE** The icon’s position has no effect on the wind’s behavior unless you activate the Use Range option.

2. Use the Rotate tool to rotate the icon and set the wind direction. The wind blows in the direction indicated by the weathervane arrow.
Interface

Wind Properties rollout

- Properties

  - Wind On
  - Wind Speed: 11.25m
  - Random Speed
    - Variance: 2.0
    - Time Scale: 1.5
  - Ripple
    - Left / Right
    - Up / Down
    - Back / Forward
    - Magnitude: 0.62
    - Frequency: 1.062
  - Perturb Time
    - Magnitude: 5.203
    - Frequency: 1.062
  - Use Range
    - Range: 1.015m
    - Fall Off: None
      - Inv
      - Inv Sq
  - Enable Sheltering
  - Applies To
    - Rigid Bodies
    - Cloth
    - Soft Bodies
    - Ropes
  - Display
    - Size: 1.0

Reset Default Values
Wind On [Animatable] Defines whether the wind forces are applied or not.

Wind Speed [Animatable] The strength of the wind force. The direction is specified by the icon's orientation, which is also animatable.

Perturb Speed When on, the strength of the wind varies over time, using the following parameters.
- **Variance** The maximum amount of change in the speed.
- **Time Scale** How quickly speed change occurs, with small values producing slow changes, and large values producing rapid changes.

Ripple [Animatable] When on, the wind direction becomes a function of space and time, allowing you to add rippling effects to cloth objects affected by the wind. This effect can occur in the Left/Right, Up/Down, or Back/Forward directions, where Forward is the wind direction and Up is the up-axis of the wind icon.
- **Magnitude** The directional variance for the ripples.
- **Frequency** The regularity of ripple formation.
- **Perturb Time** When in, the spatial perturbation is itself perturbed over time, meaning that the ripples move back and forth. The Perturb Time feature has its own Magnitude and Frequency parameters. When off, the rippling cloth should eventually come to rest, unless Perturb Speed is on.

Use Range [Animatable] When on, the wind effect has the specified range of action, starting from the icon. The range limit is displayed in the viewport, as depicted in the following illustration.
Fall Off  The extent to which the wind effect falls off towards its range limit. You can choose from None, Inv (strength decreases proportionally to distance), and Inv Sq (strength decreases proportionally to the square of the distance).

Enable Sheltering  [Animatable] When on, objects can be sheltered from the wind by other objects.

Applies To  These check boxes allow you to specify the types of objects that are affected by the wind. You can choose from Rigid Bodies, Cloth, Soft Bodies, and Ropes.

Disabled  Removes the wind from the simulation.

Display  The size of the wind icon in the viewports.

Reset Default Values  Resets the default property values for this Wind helper.

---

The reactor Utility

Utility panel > reactor

You can access much of reactor's functionality through the reactor utility. It lets you preview the simulation, change world and display parameters, and analyze the convexity of objects. It also lets you see and edit the rigid body properties associated with objects in the scene. Perhaps most important, it lets you switch between the Havok 1 and Havok 3 engines.
The utility is divided into a number of rollouts. For more information, follow the links. More information about the two different Havok versions is available later in this topic, in Differences between Havok 1 and Havok 3 on page 4421.

- About: Choose Havok 1 or Havok 3 solver
- Preview and Animation on page 4422
- Havok 1 World/Havok 3 World on page 4424
- Collisions on page 4427
- Display on page 4430
- Utils on page 4432
- Properties on page 4435

Differences between Havok 1 and Havok 3

You can use either of two different dynamics solvers in reactor: Havok 1 or Havok 3. To switch between them, choose the desired solver from the drop-down list on the About rollout. The active solver is saved with the scene file.

The difference between the two, in a nutshell, is that Havok 1 provides a broader range of functionality, but Havok 3 is faster and more accurate. If your simulation requires only rigid bodies, you'll generally get better results with Havok 3.
Following is a more detailed list of differences:

<table>
<thead>
<tr>
<th>Feature</th>
<th>Havok 1</th>
<th>Havok 3</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Simulation</strong></td>
<td>Discrete only</td>
<td>Discrete or Continuous on page 4427 with extra parameters</td>
</tr>
<tr>
<td><strong>Supported bodies</strong></td>
<td>Rigid/Cloth/Soft/Rope/Deforming Mesh/Water</td>
<td>Rigid only</td>
</tr>
<tr>
<td><strong>Rigid Body Properties</strong> on page 4249</td>
<td>Standard</td>
<td>Standard + Shell/Penetration/Quality on page 4251</td>
</tr>
<tr>
<td><strong>Cooperative Constraints &gt; Breakable Constraints</strong> on page 4282</td>
<td>Linear, Angular</td>
<td>Threshold</td>
</tr>
<tr>
<td><strong>Cooperative Constraints &gt; Strength settings</strong> on page 4282</td>
<td>Strength, Tau</td>
<td>Strength only</td>
</tr>
<tr>
<td><strong>Preview Window: display</strong></td>
<td>Textures, smoothing, actual geometry</td>
<td>Simulation geometry only</td>
</tr>
<tr>
<td><strong>Preview Window: interaction during preview</strong></td>
<td>right-button drag</td>
<td>hold Spacebar and move mouse</td>
</tr>
<tr>
<td><strong>Toy Car</strong> on page 4342</td>
<td>Standard</td>
<td>Additional parameters</td>
</tr>
</tbody>
</table>

**NOTE** If you preview a simulation or create an animation using Havok 3 and the scene contains non-supported entities such as soft bodies, reactor simply ignores these entities and excludes them from the simulation.

**Preview & Animation Rollout**

Utility panel > reactor > Preview & Animation rollout

This rollout lets you run and preview your reactor simulation, as well as specifying timing parameters for the simulation.
Interface

**Start Frame**  When creating a world to be simulated or previewed, reactor needs to access the objects in 3ds Max at a fixed point in time. This parameter defines this point in time (in 3ds Max frames). Initial shapes, positions and velocities are taken from the actual shapes, positions and velocities of the objects in the scene at this particular frame. When creating an animation, keyframes are created starting from this frame to the End Frame time.

**End Frame**  The last frame to simulate. When reactor creates an animation, it generates keyframes from the Start Frame time to this frame.

**Frames/Key**  The number of frames for every keyframe that reactor creates (time step). For example, a value of 2 will create a keyframe every other frame. Increasing this value forces reactor to take bigger time steps, potentially reducing the accuracy of the simulation; you might need to then update the Substeps/Key setting accordingly (see following).
Substeps/Key The number of reactor simulation substeps per keyframe (that is, per time step). The higher this value, the more accurate the simulation will be, although it will also require more computation to simulate. For information about time steps and substeps, see Time Steps on page 4230.

Time Scale This parameter maps between time in the simulation and time in 3ds Max. Changing the value lets you slow down or speed up the animation. Values less than 1.0 produce slow-motion animations, while values greater than 1.0 produce sped-up animations.

Create Animation Runs the simulation and creates keyframes, starting at Start Frame and ending at End Frame.

Update Viewports When on, updates the scene in the viewports as the animation is created.

Create List/Layer When on, creates a List controller on page 3497 (unless one is already present) for the position and rotation tracks of those rigid bodies using Position/Rotation/Scale transform controllers. A new subcontroller is added to the List controller to hold the keys created by reactor. This new controller is weighted to 100, while the previous controllers are weighted to 0. In the special case of rigid bodies belonging to a character studio Biped on page 4487, a new biped layer is created every time a reactor animation is generated.

Preview Animation Previews the simulated scene in the Preview Window on page 4436.

**Havok 1 World / Havok 3 World Rollout**

Utility panel > reactor > Havok 1 World/Havok 3 World rollout

This rollout lets you set some general parameters for your simulated world, such as the strength and direction of gravity, the scale of the world, and how easily objects can collide with each other. When Choose Solver is set to Havok 1, the rollout name is Havok 1 World, and when Choose Solver is set to Havok 3, the name is Havok 3 World.

**Interface**

The only difference between the two different versions of the Havok World rollout is that the Havok 3 World rollout contains an extra group of parameters at the end, named Simulation. The following illustration shows the Havok 3 version of the rollout.
Gravity

The acceleration, in world units, the objects in a scene have due to gravity. It is an important value because it affects the overall feeling of scale in a dynamics simulation.

reactor will generate a warning if you specify a non-standard Gravity value compared to World Scale (see following); that is, if you set the value much higher or lower than \(-9.8 \, \text{m/s}^2\), where m is World Scale’s representation of one meter. The warnings are provided for guidance and can be safely ignored if you are happy with the behavior of your animation. The default Gravity value reflects “real-world” gravity: \(-9.8 \, \text{m/s}^2\) (-386.22 inches/s\(^2\)) on the Z axis. For more information, see Scale on page 4234.

World Scale

The distance in 3ds Max world units, that represents one meter in the reactor world, and hence determines the size of every object in your simulation.

NOTE Changing the World Scale value can drastically alter simulated objects’ behavior. For more information, see Scale on page 4234.

Col. Tolerance (Collision Tolerance) One of the tasks that reactor performs at each simulation step is detection of whether any objects in the scene are
colliding, and then updating the scene accordingly. If objects are closer
together than the Collision Tolerance value, reactor considers them to be
colliding. A high Collision Tolerance value results in a stable simulation, but
it can also cause gaps between "colliding" objects.

The default value is 1/10th of World Scale (10 cm if you are modeling using
real-world sizes), and it is a good rule of thumb to always keep it above 1/40th
(4 mm), due to floating point precision limits in the processor. For standard
scenes and object sizes, the default parameters for world scale and tolerance
should be adequate. If you are simulating very small objects where the
tolerance is still to visible, try reducing the World Scale value and the Collision
Tolerance and Gravity accordingly. For more information, see Scale on page
4234.

Add Deactivator When on, reactor adds a deactivator to the simulation.
The deactivator keeps track of the objects in the simulation and deactivates
(stops simulating) objects that it determines are at rest. This keeps reactor
from wasting system resources simulating objects that aren't doing anything.

When Add Deactivator is on, you have access to two distance parameters for
determining whether an object is moving or not. The reason that there are
two properties rather than just one is for bodies that vibrate. It's possible that
a body can end up vibrating after a collision or some other occurrence. A
vibrating body might vibrate a few millimeters in distance, which would keep
it active for a typical Short Frequency test. However, the object is not really
moving anywhere, so keeping it active wastes CPU time. However, if it vibrates
in place, it fails the Long Frequency test and is deactivated.

- **Short Frequency**  The minimum distance, usually in millimeters, that an
  object must move during each step of a simulation. If an object in a
  simulation does not move the specified distance in each step, reactor
deactivates it.

- **Long Frequency**  Also sets a distance, usually larger than the Short
  Frequency value. Long Frequency checks every few steps simulation rather
  than at every step. Any object that does not move the required Long
  Frequency distance is deactivated.

Add Drag Action When on, ensures that rigid bodies are subject to constant
drag. This damps their linear and angular velocities, so they come to rest
sooner. This is useful, for example, where rigid bodies are joined with
constraints on page 4264, as it helps the constrained bodies to come to rest
despite the forces applied by the constraints.

- **Lin**  The linear damping applied by Add Drag Action.
- **Ang**  The angular damping applied by Add Drag Action.
Do Not Simulate Friction  When on, reactor ignores all Friction values during the simulation, and objects slide easily across each other.

Fracture Penetrations  These parameters let you adjust how reactor simulates Fracture objects. For details, see World rollout > Fracture Penetrations group on page 4356.

Simulation group

These controls are available only with the Havok 3 engine.

The first lets you choose how reactor computes the simulation:

- **Discrete**  reactor checks for collisions only at the beginning and end of each simulation step. This is faster but less accurate.

- **Continuous**  reactor checks for collisions constantly, throughout each step. This is the default choice, and results in slower but highly accurate simulations. This option significantly reduces the chances of missed collisions.

**Max Linear Vel.**  The assumed maximum linear velocity for all bodies.

This does not set objects' linear velocity. If, later on, a rigid body's velocity significantly exceeds this value, it might tunnel through other objects even if its Quality property is set to Critical.

The default value is 200 meters/second. This value is used during continuous simulations by the collision solver to optimize the simulation, so if it can assume a maximum linear velocity it can discard several cases and get a solution faster.

**Stiffness**  The hardness of the constraints in the scene.

Use this parameter to configure the dynamics solver. When constraints used in the scene are very hard or stiff, set this to Hard; the Soft or Medium setting works most other cases. Setting Stiffness to Soft can lead to unstable solutions if the constraints are too stiff.

**TIP**  Another way to reduce the stiffness of the simulation is by lowering the Strength value of constraints, thus relaxing the constraints.

Collisions Rollout

Utility panel > reactor > Collisions rollout
These settings let you store collision details from your scene, and enable and disable collision detection for specific pairs of objects. Pairs of objects with collisions disabled pass through each other during the simulation.

Disabling collisions can be useful when you have objects that are attached together, such as the wheels of a car and its chassis. This means reactor doesn't check for every small collision between the objects, which can slow down the simulation.

**Interface**

**Collisions rollout**

- **Store Collisions** See *Storing and Accessing Collisions* on page 4358.
- **Filter Before Storing** See *Storing and Accessing Collisions* on page 4358.
- **Define Collision Pairs** Opens the *Define Collisions dialog* on page 4429. This allows you to toggle collision detection between specified pairs of objects. Pairs of objects with disabled collisions pass through each other during the simulation.
- **Selected Pair: Enable** Lets you quickly enable collisions between the selected pair of objects. This button is available only when both objects are part of a collection (not necessarily the same collection) and their collisions are currently disabled.
- **Selected Pair: Disable** Click this button to quickly disable collisions between the selected pair of objects. This button is available only when both objects
are part of a collection (not necessarily the same collection) and their collisions are currently enabled (the default condition).

**Define Collisions Dialog**

**Entities** Lists the names of the reactor bodies in the scene (any object added to a collection). Highlighting one object populates the Enabled Collisions and Disabled Collisions lists for that object with respect to the other bodies in the scene. If you select more than one object in this list, how the Enabled/Disabled lists are populated depends on the value of Common Collisions.

**Common Collisions** When on, if more than one object is highlighted in the Entities list, the Enabled and Disabled lists are populated from the list of possible pairs that can be made using only the highlighted objects. When off, the lists contain all possible pairs from the scene that contain at least one of your selected objects.

For example, take a scene containing four bodies: Box01, Box02, Box03, and Box04. If Common Collisions is on, and you then highlight Box01 and Box02 in the Entities list, then the only possible pair that just includes your selected objects is Box01<->Box02.

If you highlight Box01, Box02, and Box03, the possible pairs using these objects are Box01<->Box02, Box02<->Box03 and Box01<->Box03. If you highlight the same objects with Common Collisions off, then the lists also include the highlighted objects paired with the remaining objects in the collection. This means that the available pairs would now include Box01<->Box04, Box02<->Box04 and Box03<->Box04.

This option is on by default.
**Enabled Collisions** Lists pairs with collisions enabled.

**Disabled Collisions** Lists pairs with collisions disabled.

**Disable Selection (Right Arrow)** Moves pairs highlighted in the Enabled list to the Disabled list.

**Disable All (Double Right Arrow)** Moves all pairs in the Enabled list to the Disabled list.

**Enable Selection (Left Arrow)** Moves the pairs highlighted in the Disabled list to the Enabled list.

**Enable All (Double Left Arrow)** Moves all pairs in the Disabled list to the Enabled list.

**OK** Closes the dialog, saving any changes carried out while the dialog was open.

**Cancel** Closes the dialog without saving changes.

### Display Rollout

Utility panel > reactor > Display rollout

This rollout lets you specify display options for previewing your simulation, including cameras and lighting. These options have no effect on the actual behavior of the final animation; they affect only the appearance of the preview window.
**Interface**

Camera Click this button and then pick a camera from the viewports to use as the initial view for the display. Your chosen camera's name appears on the
button. If you don’t assign a camera, the settings on the current Perspective viewport (if any) are used initially in the Preview Window.

**Camera Clipping Planes** If a camera is assigned, the display tries to use the camera to generate clipping planes. If no camera is assigned, reactor uses default values for the clipping planes in the display.

**Use Defaults** It is possible that the clipping planes for your specified camera are not sufficient to display everything in the scene. Rather than having to change these values in the window every time the simulation is run, you can turn off Use Defaults and then specify your own clipping planes using the Near Plane and Far Plane values.

- **Near Plane** The near plane to be used when Use Defaults is off.
- **Far Plane** The far plane to be used when Use Defaults is off.

**Lights** Lists the scene lights reactor uses for the preview. When the list is empty, reactor creates and uses a flashlight at the camera position; you can toggle this light from the Preview Window > Display menu. You can combine up to six omni lights or spotlights to create the preview lighting. Choose lights from the scene one at a time with the Pick button, or add from a list of the available lights in the scene using the Add button. To remove a light from this list, highlight it in the list and then click Delete.

**Texture Quality** The size (NxN pixels) of the textures generated for use in the display. A smaller value uses less memory.

**Mouse Spring** These options allow you to configure the spring used when you select objects with the right mouse button (Havok 1) or Spacebar (Havok 3) in the preview window on page 4436.

- **Stiffness** The stiffness of the mouse spring. If the mouse spring is too strong you might be able to pull objects through each other; this won’t cause errors, but it can create an undesirable state. Default=30.0.
- **Rest Length** The rest length of the mouse spring. Default=0.0.
- **Damping** The damping value for the mouse spring. Default=1.0.

**Use DirectX** When on, the 3D rendering in the preview window uses the DirectX system. When off, the window uses OpenGL.

---

**reactor Utilities**

Utility panel > reactor > Utils rollout
reactor provides a number of helpful utilities that you can use to analyze and optimize your simulation. For instance, you can check your reactor world for the presence of any unusual physical states that might cause problems with the simulation, such as excessive gravity, and you can remove redundant keyframes from a generated animation.

You can also access these utilities from the reactor menu.

**Interface**

- **World Analysis**
  - Analyze World
  - Analyze Before Simulation
  - Stop Simulation on Warnings
  - Report Problems After Simulation
  - Analyze on Solver Switch

- **Key Management**
  - Reduction Threshold
  - Reduce After Simulation
    - Reduce Now
    - Delete All Keys

- **Selection**
  - Test Convexity
  - Delete Keys
  - Reduce Keys
Analyze World

This utility begins by creating a simulation. If it finds any errors while constructing the simulation, such as invalid numbers of objects in systems or invalid meshes that would stop the simulation from running, it reports these in a dialog. These error checks are always carried out when creating a simulation, and if any of the tests fail the simulation cannot continue.

If your simulation passes the initial error checks, the world analysis begins. This checks for unusual physical states that could cause issues in simulation, such as interpenetrating objects or extreme values for gravity or object density. If any such states are found, the utility reports them in a window. Options include the ability to show errors and warnings, and to clear the window automatically before generating another analysis report.

Analyze Before Simulation

When on, reactor always calls Analyze World before previewing or running the simulation. Default=on.

Stop Simulation on Warnings

When on, prevents reactor from creating an animation if any warnings occur during analysis. For example, if the analysis finds that a body's property such as Friction exceeds the bounds of real-world values, it halts generation of the animation. Has no effect on the Preview process. Default=off.

Report Problems After Simulation

When on, reactor reports problems detected during the simulation after it’s finished. Default=on.

Analyze on Solver Switch

When on, reactor automatically calls Analyze World when you change the solver from the About rollout. Default=on.

Save Before Simulation

When on, reactor saves your scene before simulating.
Suppress Animation Warning  When off, and you click Create Animation, reactor opens an alert warning you that animation creation cannot be undone, and asking you to confirm. When off, reactor simply creates the animation without warning you. Default=off.

Key Management group

After generating an animation with reactor, you often end up with a number of redundant keyframes. For instance, in a scene with a rolling rigid body, creating the initial animation might result in a keyframe for every frame. However, you can actually specify the body's animation with keys at just a few frames (perhaps frames 0, 25, and 90), allowing 3ds Max to interpolate frames between them. This utility allows you to remove any redundant keyframes for specified objects, thus saving memory. This functionality applies only to rigid bodies.

Reduction Threshold  Specifies how aggressive the key reduction is. Increasing this value causes more keys to be deleted, but the animation might lose fidelity. Lowering it retains more keys with greater accuracy, at the cost of memory. Default=0.5.

Reduce After Simulation  When on, reactor automatically applies keyframe reduction each time you simulate.

Reduce Now  Reduces keyframes for all the rigid bodies in the simulation.

Delete All Keys  Deletes all keyframes for all the rigid bodies in the simulation.

Selection group

Test Convexity  Performs a convexity test on the object currently selected in the viewport, allowing you to check whether the object is convex or concave before choosing a simulation geometry on page 4252.

Delete Keys  Deletes all keyframes for the objects currently selected in the viewport.

Reduce Keys  Reduces keyframes for the objects currently selected in the viewport.

Properties Rollout

Utility panel > reactor > Properties rollout
reactor toolbar > Open Property Editor
The Real-Time Preview

Utility panel > reactor > Preview and Animation rollout > Preview In Window button

Animation menu > reactor > Preview Animation

reactor toolbar > Preview Animation button

It's useful to be able to preview reactor simulations from within 3ds Max. The Preview Window lets you view and interact with a simulation in real time. You can run the simulation, interact with the objects in the scene using the mouse, and even update your objects in 3ds Max with their current state in the preview.

Procedures

To preview a simulation in the Preview Window:

1. Choose one of the above commands.
2. If no errors are found in your current scene setup, the Preview Window opens with your scene.
3. Press P to start the simulation.

   At any time during the simulation, you can orbit around the scene by left-button dragging the mouse within the Preview Window. With Havok 1 and Havok 3, you can pan the window by middle-button dragging; with Havok 3, you can also pan the window by right-button dragging.

To interact with objects in the Preview Window:

1. Position the mouse cursor over the object you want to interact with, and then press and hold the right mouse button (Havok 1) or the Spacebar (Havok 3).

   This creates a reactor spring between the mouse cursor and your chosen object.

2. While holding the right mouse button (Havok 1) or the Spacebar (Havok 3), move the mouse.
This drags the object, letting you pull it around, unless it’s a fixed object, or attached to one, and interact with other objects in the scene.

3 To release the object, release the right mouse button (Havok 1) or the Spacebar (Havok 3).

To update 3ds Max from the Preview Window:

1 Preview the simulation as described above.

2 When the scene is in your chosen state (for instance, you might want to drape some clothing over a figure, or let some objects fall and roll on the ground), open the MAX menu and choose Update MAX.

NOTE The scene in 3ds Max will not be refreshed until you close the Preview Window.

Interface

Preview Window Menus
**Timing**

At the bottom of the window, profiling and timing information is shown:

- The current time step (simulation step) on page 4230 used for the simulation. This value is initially taken from the Preview & Animation rollout on page 4422 but can also be changed by using the Performance menu on page 4439.
- The number of substeps on page 4230 used for the simulation. Again, this value is initially taken from the Preview & Animation rollout on page 4422 but can also be changed by using the Performance menu on page 4439.
- The current simulation time; that is, the time that the current image in the preview represents in the final animation.

During the preview, reactor tries to run the simulation in real time. In other words, if a simulation step of one second takes only 0.7 second of CPU to simulate, reactor "waits" 0.3 second before simulating the next step. That way, the animation is presented in the window at the same speed as the final animation in 3ds Max.

However, for complex scenes or slow CPUs, simulating a particular period of time can take actually more CPU time than the specified period. For example, a simulation step of one second might actually take two seconds to calculate. In that case, it is not possible to present the animation in real time, and the animation is therefore presented during the preview at a slower speed that the final animation will have once it has been created. When this happens, the preview reports it by appending an asterisk (*) to the current time:

**Simulation menu**

**Play/Pause** (P) Starts and pauses the simulation. If the simulation is paused, the display remains active and you can still pan, rotate, and zoom the camera, but the physics world remains still.

**Reset** (R) Resets the simulation, returning objects to their initial positions.
Display menu

**IMPORTANT** When About rollout > Choose Solver is set to Havok 3, only Camera Settings is available from this menu.

**Camera Settings** Opens a dialog that allows you to specify the near and far clipping planes for the camera, and to change the camera’s field of view (F.O.V.). The clipping planes can also be set externally from the reactor utility Display rollout.

**Faces** When on, the faces (and not the edges) of the display bodies are rendered.

**Wireframe** When on, the edges (and not the faces) of the display bodies are rendered.

**Sim Edges** When on, the edges of the physically simulated geometry (the simulation geometry for each body) are rendered in the preview window. This is useful for seeing what’s physically happening in a simulation.

**Grid** When on, three 2D grids are displayed in the XY, YZ and ZX planes.

**Origin** When on, the X (in red), Y (in green) and Z (in blue) axis are displayed at the origin (0,0,0).

**Flashlight On/Off** When on, a flashlight located behind the camera lights the scene. When off, lights defined on the Display rollout of the utility are used. If no lights are defined, the preview uses a single fixed light.

**Performance menu**

**Fixed Step** (60,50,40,30 fps) Choosing one of these options changes the frequency of the simulation to the given value; a frequency of 30 fps yields a time step of 1/30 (0.0666) second, 50 fps means a time step of 1/50 (0.02) second, etc.

**Substeps** (1-100 substeps) Choosing of these options sets the number of substeps taken in every simulation step.

**Mouse menu**

This menu is available only when using the Havok 1 engine.

**Pick at C.O.M.** During the preview, you can pick and drag objects (see To interact with objects in the Preview Window: on page 4436. A spring is the attached between the mouse cursor in the screen and the object. When this option is on, the spring is attached to the center of mass of the object.
Otherwise the spring is attached to the point on the object where you first right-clicked.

**Mouse Help** This option shows some help regarding the use of the mouse to control the camera and mouse picking.

**MAX**

**Update MAX** Takes the position and rotation of the objects in the simulation and uses them to update the objects in 3ds Max.

**Use MAX parameters** Resets the substeps and time step (FPS) values to the values set in the reactor utility's *Preview and Animation* on page 4422 rollout.

**Display rollout**

The Display rollout of the reactor utility lets you configure various display options for the Preview Window, including cameras and lighting. For more information, see *Display Rollout* on page 4430.

---

**Scripts and Tools**

This topic describes some useful scripts and tools that you can use to speed up your creation of reactor scenes.

If you are interested in creating your own scripts, see the MAXScript Help, available from the 3ds Max Help menu.

**Setup Scripts**

These scripts allow you to quickly set up constraints and collections. They are run automatically when you follow the specified procedures.

**Constraint Creation**

This applies to all the reactor constraint on page 4264 types, except the *Point-to-path constraint* on page 4333.

**To create a constraint and attach objects in a single step:**

This method works with two or more objects only; it doesn’t work with a single-body constraint setup such as Spring with a child only.

1. Create the object(s) to constrain, and then ensure they are both selected.

---

4440 | Chapter 14  reactor
If you select more than two objects, reactor will create constraints between them. If you link the objects together hierarchically in 3ds Max before creating the constraints, reactor will create constraints between link parents and children. Otherwise, reactor will examine the scene and try to choose appropriate pairs of objects.

Create the constraint(s) by using the reactor toolbar, menu or quad menu. The constraint automatically appears in the viewport, and as you will see in the constraint’s Properties rollout, your objects are now attached to the constraint.

If the objects are linked in 3ds Max, reactor will automatically make the link's child object the constraint child and the link parent the constraint parent. Otherwise, reactor will examine the scene and try to choose an appropriate parent and child.

In addition, if the constrained objects are already added to a collection, reactor will disable collisions between them (except in the case of springs on page 4269).

Collection Creation

This applies to all the reactor collection types: rigid body collections on page 4261, soft body collections on page 4384, cloth collections on page 4372, and rope collections on page 4392. It also applies to the Fracture on page 4349 and Constraint Solver on page 4283 helpers.

To create a collection and add bodies in a single step:

1. Create the object(s) to add to the collection, then ensure that they are all selected.

2. Create the collection by using the reactor toolbar, menu or quad menu. The collection automatically appears in the viewport, and as you will see in the collection’s Properties rollout, your objects are now added to the collection.

The Rag Doll Utility

This utility lets you quickly set up a simple humanoid character, using a mixture of Rag Doll on page 4286 and Hinge on page 4307 constraints to limit the movement of the character’s limbs. You can use the sample humanoid, or create your own character using the provided naming conventions and the script will set up its constraints. Alternatively, you can use the script as a basis for creating your own custom rag doll script.
Procedures

To create the sample rag doll:

1. From the Customize menu, choose Customize User Interface. Click the Toolbars tab, and from the Category list, choose reactor. Scroll the list to the Rag Doll Utility action, and then drag the action to a toolbar. This creates a “Rag Doll” button. Alternatively, you can use a similar method to create a custom keyboard shortcut or menu/quad entry for the same action.

2. Click the Rag Doll button or otherwise activate the utility, depending on the CUI method you’ve chosen.

   The Ragdoll dialog opens, with two rollouts: Create Humanoid and Constrain Humanoid.

3. On the Create Humanoid rollout, ensure that your chosen creation options are on, and then click Create Humanoid. A humanoid figure appears in the viewport.

4. To set up the humanoid’s constraints, ensure that your new humanoid is highlighted in the Humans list on the Constrain Humanoid rollout (by default, it’s called Ragdoll) and that your chosen options are active on the rollout.
5 Click Constrain Humanoid.

The script creates Rag Doll constraints and Hinge joints with appropriate limits for the humanoid. In addition, if Create RBCollection and Create CSolver are on, the script creates these helpers and adds the bodies and constraints to them.

To turn your own humanoid figure into a constrained rag doll:

1 Create your figure using the naming conventions described in How It Works on page 4446.

2 Run the script as described above.

   The script searches the scene for geometry that follows the naming conventions and adds your figure to the Humanoids list.

3 Ensure your figure is highlighted in the list and then click Constrain Humanoid.

Interface

Create Humanoid rollout

![Create Humanoid Rollout](image)

Name Root This text box stores the root name for the objects to be created. For example, the Name Root "RagDoll" generates objects with names such as RagDoll Pelvis and RagDoll R UpperArm.
**Height** The height of humanoid to be created.

**Vertebra** The number of vertebra to be created in the character's spine.

**Add Hands** When on, reactor creates boxes for the character's hands.

**Add Feet** When on, reactor creates boxes for the character's feet.

**Link Parts** When on, reactor links the created parts as a 3ds Max hierarchy.

**Create Humanoid** Click to create the humanoid objects and add them to the scene.
Constrain Humanoid rollout

Humanoids Displays a list of potential humanoids found in the current scene that could be used for creating rag dolls. In generating this list only the root node is examined so it is, in effect, a list of valid root nodes in the scene. If the rest of the hierarchy does not exist for a given root, when you use the root to create a rag doll 3ds Max writes errors to the MAXScript listener.
Vertebra The maximum number of Rag Doll constraints that the script creates for the character's spine. If this value exceeds the number of valid vertebrae in the selected humanoid, the script won't create the excess constraints.

Create RBCollection When on, the tool creates a Rigid Body Collection on page 4261 and places all the parts of the newly created rag doll character into it.

Create CSolver When on, the script adds a Constraint Solver on page 4283 to the scene, which is then associated with the freshly created Rigid Body Collection. All the hinges and rag doll constraints that are created for the selected humanoid are added to this. This option is available only if you have chosen to create a Rigid Body Collection.

Add Hands When on, if the selected humanoid has hands, the script creates constraints to connect the humanoid's hands to the rest of the body.

Add Feet When on, if the selected humanoid has feet, the script creates constraints to connect the humanoid's feet to the rest of the body.

Snapshot Parts When on, the script creates a separate geometry object for each object to be attached to a constraint. It is the newly created snapshot that is then used in the constraint and added to the collection (if a collection is being created).

Link To Original When on, the newly created snapshot geometries are linked to the original geometries. Available only when Snapshot Parts is on.

Change Name When on, each geometric component of the new rag doll is prefixed with the text in the New Name field. Available only when Snapshot Parts is on.

New Name When on, each geometric component of the new rag doll is prefixed with the text in the New Name field.

Constrain Humanoid Click to create the Rag Doll constraints and, depending on the active options, also create a copy of the source objects, a Rigid Body Collection, and a Constraint Solver.

How It Works

The script works by assuming that you've used the following naming conventions for the rag doll parts. This naming convention follows that used by the character studio Biped object to name the limbs. However, as long as they are named as following, you can use any geometry created in 3ds Max.
The script scans the selection for geometry with names that include one of the following:

- _R_UpperArm
- _R_ForeArm
- _L_UpperArm
- _L_ForeArm
- _R_Thigh
- _R_Calf
- _L_Thigh
- _L_Calf
- _Pelvis
- _Spine
- _Head

The script assumes that there is only one of each type of part, except in the case of the spine, which can have up to five parts.

At this point the adjoining parts are connected, using mostly Rag Doll constraints on page 4286. However, the script also uses Hinges on page 4307 for the elbow and knee joints, as using Rag Doll constraints would be overkill to achieve the simple constrained motion found in an elbow joint. The script also sets suitable limits for each constraint.

In addition, the script sets the mass of each rigid body in the character to 10.0 kilograms, and the simulation geometry to be a bounding box. It also disables collisions between constrained pairs of bodies.

**Frequently Asked Questions**

This topic answers some frequently asked questions about reactor.
A figure floats on water.

See also: Troubleshooting on page 4452

**Can I assign initial velocities to objects? How?**

Yes. At the start of the simulation, reactor assigns to each object the velocity it currently has in 3ds Max. In other words, if an object is moving during the frame range A to B, and you start the reactor animation setting Start Frame on page 4422 in between A and B, the object will start with the velocity it had in your animation.

**WARNING** Make sure the object has the desired velocity at the exact frame where reactor starts the simulation (Start Frame). Since 3ds Max usually decelerates an object when animating its movement using keys at time A and B, starting the reactor animation at time B won’t add any velocity to the reactor simulation. In order to have initial velocity in the reactor animation, start at a frame between A and B.
Is it possible to modify the animation in Cloth/Soft/Rope/Water?

The animation for Cloth, Soft (mesh), and Rope is internally stored in the respective modifier using a memory-optimized format. Unfortunately, there is no direct access to those keyframes. However, you can use the Point Cache modifier on page 1574 to do some manipulations.

There is some MAXScript access to Water keyframes. For details on MAXScript, choose Help > MAXScript Help.

What happened to Point-Nail constraint?

The Point-Nail constraint from reactor 1 has been superseded by generalizing the Point-Point constraint on page 4313. The old Point-Nail constraint is equivalent to a-single bodied Point-Point constraint.

Can I apply the Cloth/Soft/Rope modifier to part of a mesh?

While the Soft, Cloth, and Rope on page 4363 modifiers apply to all the vertices, you can fix or keyframe vertices of the mesh or spline by using deformable constraints on page 4398. Fixed or keyframed vertices will not be simulated physically.

Can I apply the Cloth/Soft/Rope modifier to more than one object?

In general, no, because the animation is stored explicitly in a single modifier. The only exception is the FFD soft body on page 4381: If you have an FFD modifier applied to more than one object, you can apply a reactor Soft Body modifier on page 4375 to any (or many) of the bodies. You should still add only one of the objects to the Soft Body Collection on page 4384.

Which parameters can I animate?

Only Wind on page 4416 parameters are animatable.

Can a keyframed object participate in the simulation?

Yes. For objects that don't change shape, and for which reactor should not create keyframes, use unyielding on page 4251 rigid bodies. For objects that change shape (deform), use deforming meshes on page 4394. Unyielding rigid bodies are much faster and simpler to simulate than deforming meshes.
Can reactor store collisions for deformable bodies (Soft, Cloth, Rope)?

No. The storing collisions on page 4358 functionality applies only to rigid bodies.

What are the limitations of Water on page 4411 in reactor?

Water in reactor is simulated as a height field (points are displaced vertically only). This can produce effects like ripples and waves, but it cannot reproduce certain other effects:

- Wakes
- Splashes. You can, though, use the information exposed through MAXScript to generate particles or other effects.
- Flowing fluids (like water flowing through a pipe or pouring from a tap).

Can I move the center of mass of my objects? How?

You can’t explicitly set the center of mass of an object. However, you can use compound rigid bodies where different pieces have different masses to simulate uneven mass distribution. For example, you can simulate an object with a low center of gravity by dividing the object into two pieces (primitives), top and bottom, where the bottom piece is heavy and the top piece is light; alternatively, you leave the original piece intact, with low mass, and add a small, heavy primitive at the point of the desired center of mass. For more information, see Compound Rigid Bodies on page 4259.
Rocking toy with center of mass at the bottom of the globe

Can I attach Cloth/Rope/Soft Bodies to other Cloth/Rope/Soft Bodies?

No. However, once a piece of, say, cloth has been simulated, you can take it out of its Cloth Collection and add it to a Deforming Mesh Collection on page 4396. By doing so, the cloth will still be part of the simulation the next time, but reactor won’t recalculate its animation. You can then attach other pieces of Cloth/Soft/Rope to it by using the Attach To Deforming Mesh on page 4406 constraint.

How can I make a rigid body not move until a collision happens?

You can use the Inactive on page 4251 property for the rigid body.

How can I animate a floating object, like a balloon?

There are many alternatives you can try:

- Use water on page 4411. The buoyancy of a balloon in the air follows the same rules as the buoyancy of a light object inside a fluid. You will need
to place the water surface well above the scene so the objects are not visible when they reach it.

- Use very low mass for the objects, and add wind on page 4416 blowing in the up direction. You might want to also decrease the strength of gravity.

**Troubleshooting**

This topic provides solutions to some problems with reactor simulations that you might encounter.

A character collides with a fracturing window.

Check also: Frequently Asked Questions on page 4447

**General Troubleshooting**

**Analyzing the World**

Whenever you get unexpected behavior from reactor, it is advisable to perform a world analysis on page 4434 to get a report of anything detected by reactor as
suspicious, unexpected, or prone to error in your scene. For more information, see reactor Utilities on page 4432.

Discussion Forums

The Area provides you with a moderated community to discuss, learn, and share techniques and ideas with other 3D professionals. Need to know how to do something? Having a problem? Just want to show off your work? Post your questions to the appropriate forums.

Simulation takes too long.

General tip:

- Before performing a CPU-intensive operation such as Create Animation or Reduce Keys, make sure you don't have any object selected in the scene. Having an object selected during some calculations can force 3ds Max to evaluate the selected object many times in order to update its UI, slowing down the calculations.
- If the scene is complex but contains independent parts that don't interact with each other, try adding the objects involved to different collections and solvers and create the animations independently for each subset, enabling and disabling the collections and solvers accordingly.

If you are using Soft Bodies, Cloth, or Rope on page 4363:

- Try to reduce the complexity of the mesh that flows to the reactor modifier. For example, you can apply a MeshSmooth modifier on top of the reactor modifier to render a smooth surface while simulating a simpler one.
- For soft bodies with complex meshes, using FFD soft bodies on page 4381 can offer better results and decrease the computation time.
- Unless necessary, do not use the Avoid Self-Intersections option, because it increases computation time and memory usage significantly.
- Try to reduce the number of substeps on page 4422 used in the simulation. Also try to decrease the number of Internal Steps used by the Cloth/Soft/Rope collection.

NOTE These steps also reduce the accuracy of the simulation, and can therefore cause instability.
If you are using rigid bodies on page 4248:

- For best results when using rigid bodies only, set Utilities panel > reactor > About rollout > Choose Solver to Havok 3.

- Reduce the complexity of the geometry used for the rigid bodies. Try using bounding boxes or sphere, and avoid using non-fixed concave objects. Use simpler geometry as a geometry proxy on page 4253 for the object.

- If you are using Fracture, slowdowns can be caused by reactor trying to avoid instability. Follow some of these tips on page 4356 to help reduce the chances of instability happening.

- Try decreasing the number of substeps on page 4422 used in the simulation. Be aware that this will reduce the accuracy of the solution and therefore may cause instability.

**Water doesn’t render.**

The reactor Water on page 4411 is a world-space modifier and therefore it is not a renderable object. You can bind renderable object (like planes) to the water WSM in order to render a water animation. See Rendering Water on page 4415.

**Cloth/Soft/Rope becomes unstable and explodes.**

- Check whether any unyielding rigid body or DefMesh on page 4394 is forcing the Cloth/Soft/Rope into a penetration.

- If you are attaching to a rigid body on page 4404, make sure that the points of attachment are outside the rigid body; otherwise, make sure Ignore Collision is on.

- If your Cloth/Soft/Rope is attached to a rigid body on page 4404, use Runge-Kutta as the ODE Solver for the Rigid Body Collection on page 4261 of the attached rigid body.

- Try increasing the amount of internal steps in the Cloth/Soft/Rope collection (Advanced rollout).

**Rigid bodies become unstable/explode/fly to infinity.**

In rare situations, simulation can become unstable and objects can "explode.” This typically happens only when using complex systems of objects, like...
**Fracture** on page 4349, or using **simple constraints** on page 4268 like springs or dashpots.

- For best results when using rigid bodies only, set Utilities panel > reactor > About rollout > Choose Solver to Havok 3.
- If you are using many **simple constraints** on page 4268 (spring, dashpots) working together, switching the ODE Solver in the **Rigid Body Collection** on page 4261 to Runge-Kutta can improve the results.
- Usually, increasing the number of **substeps** on page 4422 in the simulation improves the stability of the simulation.
- Also for springs and dashpots, avoid attaching objects with very different masses. Using a Strength value similar to the mass of the objects attached, and a Damping value of 1/10th of that Strength usually give good results.
- If you are using **constraints** on page 4264, make sure you have aligned the **constraint spaces** on page 4265 properly.
- If many objects start the simulation too close too each other (inside **collision tolerance** on page 4425), reactor will try to push them apart at the beginning of the simulation. Try increasing the space between them, or reducing the collision tolerance.
- If you have constrained two rigid bodies so they are in continuous contact/penetration (like an upper arm and a forearm), be sure to **disable collisions** on page 4427 between those bodies.
- Adding **drag action** on page 4426 can help damp the overall simulation. Try increasing the linear drag in the scene.
- If you are working with Fracture, the **Fracture Tips** on page 4356 section provides information on how to avoid instability.

**Cloth/Soft/Rope object stretches too much**

If you have attached (using the **Attach to RB Constraint** on page 4404) it to a falling object, be sure to turn off Do Not Affect Rigid Body. If the problem remains, increase the mass of the Cloth/Soft/Rope, or decrease the mass of the attached rigid body. Increasing the strength and damping of the Cloth/Soft/Rope should also improve the situation.
Objects seem to move very slowly

Make sure you are using the proper World Scale on page 4424 in the scene. A 10cm box falling from a 1m height doesn’t behave the same as a 1km box falling from a height of 10km: The second one will reach the ground much later. Use real-world units or have a proper mapping between 3ds Max units and simulation units (World Scale on page 4424).

Why, after simulation, do I get warnings regarding "topology changes"?

The term “topology” refers to the internal connections of the vertices, edges and faces of a mesh. If you change the number of vertices in a mesh, you are changing its topology. While 3ds Max lets you animate the topology of objects (e.g., change the number of vertices or faces over time), reactor can simulate only objects with fixed numbers of vertices. If, during a simulation, reactor detects a topology change, it ignores the object in question and reports the problem as a warning.

Objects interpenetrate.

There can be different reasons for this:

- Check that you haven’t disabled collisions for those bodies. You can disable collisions either globally on page 4427 for pairs of objects, or for the object in particular (Rigid Body Properties on page 4249).
- If the objects are attached using deformable constraints on page 4398, make sure you haven’t disabled collisions in the constraint parameters.
- Make sure Collision Tolerance on page 4425 is set to a value that makes sense for the sizes of the objects.
- Try increasing the number of substeps on page 4422 in the simulation.

Cloth/Soft/Rope intersects itself.

Make sure you have turned on the Avoid Self-Intersections option in the modifier on page 4363.

I can't add an object to a Cloth/Soft/Rope Collection.

Only an object that has the proper reactor modifier applied can be added to one of these collections. Make sure you have applied a reactor Cloth on page 4365, Soft Body on page 4375, or Rope on page 4386 modifier to the object.
I can’t add an object to a Rigid Body Collection.

If you are using compound bodies on page 4259, make sure the group is open, as only the group parent can be added to a Rigid Body Collection on page 4261.

Mass and other properties are disabled.

Make sure you have selected only one object, and that this object is geometrical. The most common cause for this is the use of groups. You can use groups to create compound rigid bodies on page 4259, but in order to change the properties of the primitives inside the group, you’ll need to open it and selected the individual primitives inside it.

Rigid bodies don’t bounce enough.

Increase the Elasticity property on page 4249 of the object. Try also increasing the Elasticity of the other object involved in the collisions, as the elasticity of a collisions is a function of the elasticity property on page 4249 of the two objects involved.

Objects stop moving unexpectedly in the middle of a simulation.

This can be caused by objects being deactivated. There are two ways objects can be deactivated: through the world on page 4424 deactivation or, if the object belongs to a constrained system, through the Constraint Solver on page 4283 deactivation parameters.

In both cases, try modifying the deactivation parameters for a less-aggressive deactivation, or disable deactivation in general.

An object doesn’t move during the simulation.

Make sure that you’ve added the object to a RBCollection on page 4261 and that it has a mass on page 4249 other than 0.0 (objects with mass 0.0 are fixed). If you are using Fracture on page 4349, make sure none of the pieces is fixed (has mass 0.0).

A keyframed object doesn’t move during the simulation.

Make sure that you enabled the unyielding on page 4249 property for that rigid body.
My old scripts don't work.

reactor exposes parameters and functionality to MAXScript in a much more consistent and complete way than previously. For the update, some reactor MAXScript interfaces had to be renamed, but all functionality exposed in previous versions is still available, and a lot more functionality has been exposed. While this means that some reactor-specific scripts need to be updated, it also means that a great deal more flexibility and power is now achievable using MAXScript with reactor. For more information, see the MAXScript Help, available from the Help menu.

I can't disable collisions between two bodies.

If your objects don't appear in the Define Collisions dialog on page 4429, make sure you've added the two bodies to a collection; only objects in collections are shown in that dialog.

Rigid bodies don't sink/don't float in the water.

Objects sink or float depending on their density and the density of the water. You define water density explicitly in the Water space warp on page 4411. The density of a rigid body is defined as its mass divided by its volume.

- Check that your objects have real-world sizes (or adjust the world scale on page 4424) and masses on page 4249.

If your bodies still don't sink enough for your liking, try the following:

- Increase the mass of the bodies.
- Decrease the density of the water.
- Decrease the viscosity of the water, this can slow down the sinking.

Follow the opposite steps if you're trying to make your objects float more.

Water doesn't ripple enough

You can either increase the Max Ripple value in the Water space warp on page 4412, or you can scale the effect of the space warp on a particular object that you've bound to the space warp by modifying the Scale Strength value in the Water world-space modifier on page 4415. The first option (increasing the Max Ripple value) is preferable, but you need to re-create the animation in order to see the effect. The second option (increase the Scale Strength parameter in the modifier) affects only the object bound to the Water space warp. It can
thus produce inconsistent results if you have objects floating in the water, because they won’t be affected by the change.

**I can’t see any stored collisions.**

Make sure you’ve set reactor to store collisions on page 4358 during the simulation. Collisions are stored only for rigid bodies; not for Cloth, Soft Bodies, or Rope.

**Constrained objects snap at the beginning of the simulation.**

During a simulation, reactor tries to match the two constraint spaces (sub-objects) defined in the constraint (see Constraint Concepts on page 4265 for more info). When you create a constraint those spaces are aligned by default. After setup, each space moves with the corresponding attached object. If you have moved the objects and wish to realign the constraint spaces, there are tools in the helper to do so (see Working With Constraint Spaces on page 4267 for more info).

**File size increases dramatically.**

- If you are using rigid bodies, try the Reduce Keys on page 4432 utility to reduce the number of keyframes created for each rigid body.

- **FFD-based soft bodies** on page 4381 can also create a large number of keys in the FFD modifier (one for each vertex for each frame). Although the Reduce Keys on page 4432 functionality in reactor applies only to rigid bodies, you can reduce keys in the FFD modifier using the 3ds Max Reduce Keys tool, available from Track View on page 3790.

**reactor runs out of memory during simulation.**

Reduce the complexity of the objects simulated:

- For rigid bodies, use a simpler geometry or proxy on page 4252 to simulate the object.

- For Cloth and Soft Bodies, try to use a coarse mesh for the simulation, then apply a MeshSmooth modifier on top of the reactor modifier to smooth the final result.

- For Soft Bodies, try to use FFD-based Soft Bodies on page 4381 instead of mesh-based soft bodies.
For any deformable body, the Avoid Self-Intersection option is particularly memory-intensive. Avoid using this option if you are having problems regarding memory.

**Using FFD-Based Soft Bodies to animate a part of a mesh, the whole object seems to be rotated by the simulation.**

If you are using FFD Soft Bodies on page 4381 to animate just a subpart of a mesh, make sure the Animate Transform on page 4383 check box is off, as this option works only for FFD animating the whole mesh.

**Using FFD-Based Soft Bodies to animate a whole mesh, some weird squashing happens on occasion.**

If you are using FFD Soft Bodies on page 4381 to animate the whole mesh, sometimes the FFD modifier deformation can show artifacts when the lattice points are rotated. Try switching on the Animate Transform on page 4383 check box in the modifier to avoid those artifacts.

**Picking objects during preview makes them go unstable.**

Try reducing the strength and damping of the mouse spring on the Display rollout on page 4430.

**Objects barely move when picking during preview.**

Try increasing the strength and damping of the mouse spring on the Display rollout on page 4430.

**I can’t see anything in the Preview Window.**

It might be caused by the lack of a proper camera; create a camera and select it in the Display rollout on page 4430. If still doesn’t work, try changing the far and near clipping planes.

**The preview shows everything in black.**

If the scene uses texture maps but 3ds Max can't find the map files, they’re shown as black. Disable textures by pressing X during the preview on page 4436.
After the simulation I get a warning reporting that objects moved to infinity.

When instability occurs, rigid bodies can reach extreme velocities and therefore move to infinity. If reactor detects this condition when creating an animation, it does not create keyframes, but instead reports the problem once the animation is finished.

Check also the Rigid bodies become unstable on page 4454 section above.

There is a visible gap between rigid bodies in the simulation.

Try reducing the Collision Tolerance on page 4425 of the simulation.

reactor complains about a no longer existing node.

This can happen if you rename an object that is used as geometry or display proxy on page 4253 for a rigid body; proxies are stored by name, so if you change the name of the proxy you’ll have to manually update the rigid bodies that use it.

Error : All vertices are coplanar, use concave mesh.

By default, geometries in reactor are simulated by using their convex hull. reactor can't create a convex hull from geometry in which all the vertices lie in the same plane, such as a standard 3ds Max plane. Those geometries need to be simulated as concave. Check the Rigid Body Properties on page 4249 section for more information.

Rope simulation modifies the smoothness of the spline.

Although reactor simulates cloth as a series of linked vertices, the Rope modifier on page 4387 tries to produce a smooth curve going through the vertices. In most cases the curve generated by the modifier is suitable, but in some cases (for example, if the vertices in the spline are far apart) you might find that the generated curve is not optimal. In those cases you can:

- Modify (refine) the spline below the Rope modifier so there is a uniform distance, not too great, between vertices. You will need to re-create the animation in order to see the final results.

- Modify the spline after the Rope modifier using an Edit Spline modifier on page 1424. This is the most flexible option.
Animation works in the preview, but not in 3ds Max after creating the animation.

reactor creates the animation for rigid bodies on page 4248 by sending transforms (new rotation and new position) to the controllers assigned to those bodies. Some controllers, like procedural controllers (Noise) and some system controllers (Biped) do not handle these explicit transform updates. To overcome this, assign a regular keyframable controller such as Euler XYZ or Bezier to the objects or, if that's not possible or desirable, create a copy or snapshot of the bodies and make sure that a suitable controller is assigned to the snapshot copies. Use these copies for the reactor simulation instead.

Rigid bodies in animation flicker and jump when playing the animation but not when moving the time slider.

This is usually a problem with the subframe interpolation of the Euler (XYZ) rotation controller. While reactor sends valid transformation keys to the controller, the conversion from an arbitrary rotation to X,Y and Z Euler angles may cause non-smooth animations between keyframes (the controller produces noncontinuous X,Y and Z values). This problem can be solved by using a quaternion-based rotation controller, such as the TCB controller, for the rigid bodies.

Preview Animation fails

While the Preview Window on page 4436 should work with most OpenGL and DirectX compliant hardware, some specific hardware and driver configurations might cause problems:

- Update to the latest drivers for your graphics card. Refer to the manufacturer's Web site for details.

- Try to use DirectX instead of OpenGL (or vice versa) for the preview. This setting, independent of what is used for the 3ds Max viewports, can be changed on the Display rollout on page 4430. If you discover that your card works only with a particular configuration, you may want to create startup script (a script in the scripts/startup folder) that calls reactor.displayUsingDirectX = true/false.

- Some problems can be caused by lack of display memory. Avoid having multiple sessions of 3ds Max open at the same time, and reduce the size of the windows and the display resolution.

- Try changing the 3ds Max to different drivers: OpenGL, Direct3D or Software.
**Wind doesn’t seem to work**

- Make sure the Wind Helper icon is pointing towards the right direction.
- If the wind should act upon cloth, rigid bodies, etc., make sure the correct check box is on in the Wind Helper parameters.
- Try to increase the strength of the wind, or decrease the weight of the objects it should affect.
The character studio functionality in 3ds Max provides professional tools for animating 3D characters. It is an environment in which you can quickly and easily build skeletons and then animate them, thus creating motion sequences. You use the animated skeletons to drive the movement of geometry, thus creating virtual characters. And you can generate crowds of these characters using character studio, and animate crowd movement using a system of delegates and procedural behaviors.
**character studio** comprises three components: Biped, Physique, and Crowd.

- **Biped** on page 8521 builds and animates skeletal armatures, ready for character animation. You can combine different animations into sequential or overlapping motion scripts, or layer them together. You can also use Biped to edit motion capture files.

  **NOTE** Biped does not create character mesh objects. Create your character mesh before using Biped to create a skeleton for it.

- **Physique** on page 8685 uses the biped armatures to animate the actual character mesh, simulating how the mesh flexes and bulges with the movement of the underlying skeleton.

  **NOTE** You can use Physique with other hierarchies beside the biped skeleton. And, as an alternative to Physique, you can use the **Skin modifier** on page 1667 to animate a character mesh with any hierarchy, including a biped.

- **Crowd** on page 8543 animates groups of 3D objects and characters using a system of delegates and behaviors. You can create crowds with highly complex behaviors.

  If you are new to 3ds Max, read **What You Should Know to Use character studio** on page 4467 and **Understanding character studio Workflow** on page 4480.

  If you are already use 3ds Max, proceed to **Understanding Biped** on page 4468 to continue.

  To find out about Physique, read **Understanding Physique** on page 4470.

  To learn about the Crowd system, read **Crowd Animation** on page 5104.

---

**What Is character studio?**

**character studio** is a set of components that provides a full set of tools for animating characters.

**character studio** lets you create skeletal hierarchies for two-legged characters (called *bipeds*) that can be animated quickly using a wide variety of methods. If your character walks on two legs, **character studio** provides unique **footstep animation** on page 4515 that automatically creates movement based on gravity, balance, and other factors.

If you want to animate motions manually, you can use **freeform animation** on page 4571. This type of animation is also suitable for characters with more
than two legs, or characters that fly or swim. With freeform animation, you can animate the skeleton with traditional inverse kinematic techniques.

You can also animate a biped skeleton by loading motion capture files on page 4647. You can convert back and forth between these methods to take advantage of their several benefits.

**character studio** also provides tools for skinning a character using the biped skeleton, or any other type of linked hierarchy.

**character studio** provides a unique ability to separate the motion of the animation from the structure of the character. Thus you can animate a giant walking and apply that motion to a tiny elf. Or you could animate a fat character and retarget the same motion to thin one. Using a library of motions, you can animate a character doing hundreds of different actions as easily as loading a file.

**character studio** provides a comprehensive range of tools for motion editing. You use motion scripting to sequence animations with transitions. You can overlay different animations with layers, or blend them with the nonlinear Motion Mixer on page 4002.

Function curve editing, available on the track bar and in Track View, as well as in the Animation Workbench on page 4816, lets you alter animations. The workbench also provides specialized tools for analyzing and correcting motion errors. Finally, **character studio** provides options for creating crowds of bipeds on page 5104 or other objects with a procedural-animation system that uses forces and behaviors to drive character motion.

**character studio** consists of three basic components:

- **Biped** provides tools to create and animate skeletons.
- The **Physique** on page 4944 modifier associates a skeleton with the character-mesh objects, so you can control the mesh with the skeleton.
- **Crowd** provides tools to create and animate crowds of animated objects, including bipeds.

### What You Should Know to Use **character studio**

**character studio** provides you with a broad range of tools for animating virtually any type of character.
A biped being pensive

To expedite your introduction to the product, be familiar with the following 3ds Max concepts:

- Creation, transformation, and modification of objects
- Selection of objects through clicking or dragging in viewports, and by using the Select From Scene dialog on page 206
- Navigation in viewports and changing your viewport configuration
- Use of the Track View - Dope Sheet and Track View - Curve Editor, and the trackbar to view and edit animation tracks and keys

For information on these areas, consult the remainder of this reference. If you are not familiar with 3ds Max, do some of the introductory tutorials found online in Help > Tutorials.

**Understanding Biped**

Biped on page 4487 is a 3ds Max component that you access from the Create panel. Once you create a biped, you animate it using the Biped controls on the Motion panel. Biped provides tools to let you design and animate the figures and motion of characters.
The Biped

The biped skeleton created with the Biped module is a two-legged figure created as a linked hierarchy, and designed for animation. The biped skeleton has special properties that make it instantly ready to animate.

Figure and Keyframe Modes

character studio is designed to interchange motion and characters. In Figure mode on page 4758, you pose the biped to fit your character model. In Keyframe mode on page 8615, you animate the skeleton. Motions created for the biped can be saved and loaded onto other biped skeletons with different physical characteristics. For example, you could animate a giant ogre, save the animation, and load it onto a small child. Motion files are saved in the proprietary character studio BIP format on page 8520.

You can use these files in a variety of ways with Motion Flow, the Motion Mixer, and the Crowd tools to combine animation or animate multiple characters.

Animating the Biped

There are two primary methods used in creating biped animation: footsteps method on page 8584 and freeform method on page 8586. Each method has advantages. You can convert from one method to the other, or you can use a combination of both techniques in a single animation. For detailed information, see the sections that follow: Creating Footstep Animation on page 4515 and Creating Freeform Animation on page 4571.

Biped Properties

The biped skeleton has some properties designed to help you animate faster and more accurately.

- **A human structure**—Joints on the biped are hinged to follow human anatomy. By default, the biped resembles a human skeleton and has a stable inverse kinematics hierarchy. This property means that when you move a hand or foot, the corresponding elbow or knee orients itself accordingly, and produces a natural human posture.

- **Customizable for non-human structures**—The biped skeleton can easily be made to work with a four-legged creature or an animal that naturally leans forward, such as a dinosaur.
Natural rotations—When you rotate the biped spine, the arms maintain their relative angle to the ground, rather than behaving as though fused to the shoulders. For example, take a biped in a standing position, with arms hanging at its sides. If you rotate the spine forward, the fingers touch the ground rather than pointing behind it. This position is more natural for the hands, which speeds the process of keyframing the biped. This feature also applies to the biped head. When you rotate the spine forward, the head maintains a forward-looking orientation.

Designed for footsteps—The biped skeleton is specially designed to animate with character studio footsteps, which help solve the common animation problem of locking the feet to the ground. Footstep animation also provides an easy way to rough out animation quickly. See the section Creating Footstep Animation on page 4515.

See also:
- Biped on page 4487
- Biped User Interface on page 4661

Understanding Physique

Physique is a modifier that, when applied to a mesh, allows the movements of an underlying skeleton to move the mesh seamlessly, like bones and muscle under a human skin. Physique works on all point-based objects including geometric primitives, editable meshes, patch-based objects, NURBS, and even FFD space warps. For NURBS and FFDs, Physique deforms the control points, which in turn deform the model. You can attach it to any skeleton structure including a biped, 3ds Max bones, splines, or any 3ds Max hierarchy. When you apply Physique to the skin objects and attach the skin to the skeleton, Physique determines how each component of the skeleton influences each vertex of the skin, based on settings you specify.
Physique affects a mesh after you click Attach To Node on the Physique rollout and select a root node in the viewports. During the attach process, Physique works its way through all of the children in a hierarchy, starting at the object you select, and creates its own links with associated envelopes for each link it finds. The links created by Physique are referred to within this documentation as the Physique deformation spline. Vertices that fall within envelopes are influenced to follow the links and animate the mesh. Splines and 3ds Max bones can also be added using the Add button in the Floating Bones rollout.

**Biped and Physique**

When the biped pelvis is selected in the viewports and Attach To Node is turned on, Physique traces its way from the pelvis down the legs to the toes. From the pelvis it also traces its way up through the spine and branches at the collar to the arms, hands, and fingers, and up the neck to the head. A link and associated envelopes are created for each link found. If any other objects, including 3ds Max bones, are linked to the biped, Physique treats them similarly: it creates a link and envelopes.

When you use Physique to attach a mesh to the biped, remember this: If your character has additional limbs, link 3ds Max bones to the biped for the extra
arms before using Attach To Node to create links and envelopes. When you apply Physique using Attach To Node, it creates links and envelopes for all the links in the biped, and for the linked bones. Link non-deformable objects like a sword after using Attach To Node. That way Physique doesn’t create a link and envelopes for the sword.

**Envelopes and Weighted Vertices**

The Physique modifier uses envelopes as its primary tool for controlling skin deformation. It also provides tendons and bulge angles for fine-tuning mesh deformation after envelopes are adjusted. All envelopes have an inner and outer bound (boundary). Vertices falling within the inner bound of a single link receive a full weight of 1.0 from that link. Those falling outside the outer bound receive no weight from that link. Vertices falling between the inner and outer bounds receive a weight from 0 through 1.

Vertices move together with the link that influences them. Where multiple envelopes encompass a vertex, that vertex receives weight from each envelope and follows each link to an average position based on these weights. This weighting from multiple links is considered blending. It is possible that weights assigned to some vertices don’t reach a total weight of 1.0 or greater. Rather than leaving these vertices behind, Physique by default normalizes them to a value of 1.0.

Adjusting falloff, overlap, scale, and other envelope parameters changes vertex weight distribution across links. This change, in turn, affects the way skin behaves as the biped moves. By and large, you correct the way skin deforms on a character by adjusting envelopes.

**Deformable and Rigid Envelopes**

There are two Envelope types per link: deformable and rigid on page 4970. Deformable envelopes follow the Physique deformation spline that runs through the joints in the hierarchy, and can be deformed using bulge angles, tendons, and link parameters. Rigid envelopes determine vertex-link assignment based upon the linear 3ds Max link and move in an immobile relationship to the link. Vertices in a rigid envelope, however, are deformed (blended) in the overlap area of other envelopes.

Typically you use deformable envelopes; however, game developers with game-engine restrictions might want to use rigid envelopes exclusively. Both rigid and deformable envelopes can be turned on for the same link. For example, by scaling both envelopes, you could deform the shoulder with a rigid envelope and the armpit with a deformable envelope.
The Number of Links That Can Affect a Vertex

Any number of overlapping envelopes (N Links on page 8651) can influence vertices. Normally, N Links are preferred. For special purposes such as games requirements, you can limit the number of links (envelopes) that can affect a vertex. The No Blending parameter is like the method used in version 1 of Physique: a vertex is assigned to only one link.

Physique Workflow

Before Physique is applied, align the biped to the mesh in Figure mode on page 4758. Use a pose with the arms outstretched so the hands are away from the torso. Save a figure file, so it’s easy to return to this pose whenever you need. Select the mesh and choose Physique in the Modify panel. Turn on Attach to Node and select the root node in the hierarchy (biped Pelvis or root node in a bones hierarchy, not the COM). In the Physique Initialization dialog box, click Initialize to create default envelopes based on the links in the hierarchy. The remainder of the work is adjusting envelopes and optionally adding bulge angles and tendons.

Envelope size, overlap, and other parameters are adjusted with the character in an animated position (with Figure mode turned off). By scrubbing the time slider back and forth, you can spot problem areas and adjust the envelopes affecting the problem areas. In Place mode is useful to keep the character stationary during envelope adjustment.

The finishing touches are link parameters, bulge angles, and tendons. You use link parameters to control skin sliding, the amount of twist, and crease blending as a character moves. Bulge angles let you expand areas like the biceps, and chest relative to the angle created by a link and its child in the hierarchy. Tendons can span multiple links in the hierarchy to stretch and pull a character skin.

See also:

- Physique on page 4944
- Physique User Interface on page 5013

Understanding Track Editing

There are several places to view your animation represented as tracks in 3ds Max. These views include the Track Bar on page 8071 and Track View on page 4473.
The tracks can be displayed as function curves, or as keys and ranges on a box graph. **character studio** makes special use of function curve editing capabilities with a customized version of the Track View - Curve Editor called the **Animation Workbench** on page 4475.

**Biped Curve Editing Using the Track Bar**

After creating animation of the biped in the viewport using keyframing tools from the Motion panel, you might need to work on the animation tracks, either to adjust key interpolation for smooth motion or to adjust ranges and affect timing. 3ds Max allows for some basic ways to do these tasks for all scene objects using direct key manipulation.

The simplest and most direct access to keys and ranges can be found on the track bar. Keys for selected biped objects are immediately visible there. With some limitations, you can create keys by Shift+dragging in the track bar. Right-clicking a key displays a menu; choosing from this menu gives quick access to key properties such as interpolation controls. This Key Properties dialog is also accessible from a list on the Motion panel > Assign Controller rollout.

A right-click on the time slider also displays the Create Key dialog, which is another quick way to set keyframes.

Selecting any two keys displays the range as a bar beneath the keys. You can reposition this range bar or resize it to adjust the timing of the animation. You can combine accelerator keys, like Ctrl and Alt, with left, middle, and right mouse buttons to extend or stretch the range displayed in the track bar.

You can expand the track bar to display the keys on function curves. From there, you can select and manipulate keys.

**Biped Curve Editing in Track View**

The same function-curve editing controls are found in Track View. Track View has two modes: Curve Editor and Dope Sheet.

**character studio** displays function curves for biped components in the Track View - Curve Editor.

Dope Sheet mode displays the footstep tracks and other biped keys as boxes. Here, you cut, copy, and paste keys to create repeated motion. You can use Time Editing in Dope Sheet mode, and cut, copy, paste, and insert time segments, complete with keys, into your animation.
Curve display can help pinpoint troublesome spots in your animation. You can see where a curve has problems, often corresponding to motion problems in the viewport animation. You move the keys to compensate for the problems.

**Understanding the Workbench**

The Workbench is a curve editor customized for use with *character studio*. It provides specialized tools for selecting and displaying curves, and also for locating and fixing errors and discontinuities in motion. It is a visualization tool that allows you to see and manipulate quaternion function curves represented as euler angles. Also you can see curves for the the position of a biped body part in any coordinate space.

The Workbench automatically limits selections to biped body parts and scene objects related to that biped. You can analyze these selections for errors using a variety of detectors, and correct them using the provided fixers. You can also apply filters to perform operations on different biped body parts to affect the overall animation without error identification.

Function Curve editing for Biped is also available in the 3ds Max Track View - Curve Editor and in the expanded track bar, but without the specialized Workbench tools.

Especially when working with imported motion-capture data, you might find that curve editing is difficult using the standard 3ds Max tool set. This difficulty can arise from the fact that motion-capture data often has a key on every frame, so curve manipulation becomes cumbersome and awkward. It is difficult to pinpoint the trouble spots visually. The Animation Workbench offers automatic functions to reduce keys or apply filters to the motion curves to smooth animation.
The Animation Workbench

See also:

- Working with the Workbench on page 4816
- Workbench User Interface on page 4823

Understanding Motion Flow

Motion Flow is a tool that graphically arranges clips (motion files), flowing from one motion to the next. You can use a Motion Flow graph to set up a series of clips with transitions between them. The biped then performs the series of motions in sequence.
Motion Flow graph with transitions between motion files

You can also create a network of clips on the graph, where each clip has a transition to two or more clips. With this type of graph, you can tell character studio to generate the actual motion sequence for you based on random selection.

Multiple transitions from each clip
A crowd simulation can also be used to generate a motion sequence from this type of graph. Each biped in the crowd chooses from the motions and transitions in the graph based on its desired destination and speed. These factors, in turn, are determined by the crowd parameters you set.

See also:
- Working with Motion Flow on page 4848
- Motion Flow Mode on page 4886
- Motion Flow Rollout on page 4888

**Understanding Crowds**

The Crowd system in character studio lets you create realistic simulations using large groups of characters, humanoid and otherwise, that behave and interact with one another by procedural means. You can use it to easily animate scenes containing hundreds of people and/or creatures, all with similar or widely varying sets of behaviors. These can vary dynamically according to other factors in the scene.
At the heart of the system are the Crowd and Delegate helper objects. A single Crowd object can control any number of delegates, which serve as stand-ins for crowd members. You can group delegates into teams, and assign behaviors such as Seek, Avoid, and Wander to individuals or teams. You can combine behaviors with weighting, so that, for example, a crowd member could seek a goal while wandering slightly.

Crowd simulations can range in sophistication from simple and straightforward to highly complex. Aiding at the latter end of the range is the Cognitive Controller feature, which lets you use the scripts to apply conditional transitions to sequences of behaviors. For example, you could tell a delegate to approach a goal until it gets within a certain distance, and then start moving away. Or you could use a Cognitive Controller to have a delegate move among a series of goals.
Another means of creating complex, dynamic crowd simulations is *motion synthesis*, which can be used in conjunction with the Cognitive Controller. The Crowd system offers two types of motion synthesis.

- When working with bipeds, you use the Motion Flow feature to allow [character studio](#) to create scripts for the bipeds that match the delegate behaviors.
- When working with non-bipedal characters, such as fish or birds, you use Clip Controllers that let you apply different animation segments to various types of motion. For example, a bird flaps its wings quickly while ascending but slowly while flying level, and stops flapping its wings during descent.

One of the most important requirements of crowd simulations is avoidance; if characters pass through each other or other objects in the scene, realism suffers. The Crowd system offers various behaviors to help achieve proper avoidance. It also provides the Vector Field, a special space warp, which, when applied to an irregularly shaped object, allows delegates to move around the object without penetrating it.

Used in combination, the Crowd-system tools described here can produce an endless variety of interesting, multi-character simulations. The Crowd topics in this manual provide detailed information about every aspect of crowd simulation.

**See also:**
- [Crowd Animation](#) on page 5104
- [Crowd Animation User Interface](#) on page 5152

### Understanding character studio Workflow

Biped, Physique, and the Crowd system work together within 3ds Max to provide a complete set of character animation tools. Although these components can be used in a variety of ways, it is helpful to approach [character studio](#) with a basic understanding of how a typical character animation is created.

The following sections provide a brief summary of the basic workflow and related benefits to creating a character with Biped and Physique. You might not use all the following steps, but you're likely to do them in the following order.
Create Skin Geometry

Create a basic skin shape for your character using any 3ds Max modeling tools and surface types. Be sure to place your character skin in a neutral pose with arms outstretched and legs spaced slightly apart. You might also want to add sufficient detail to your skin mesh or control points around joints to facilitate deformation during movement.

**NOTE** Physique deformations are based on a volume, which means you can refine your geometry later with minimal impact to skin behavior. Thus, you can create your animation before building your model, if you like.

Create a Biped Skeleton

Biped automates the creation of bipedal character skeletons. It also lets you introduce significant changes to the skeleton structure and sizing at any point during your animation without adversely affecting character motion. As a result, you can animate your character without knowing if it is short or tall, skinny, or fat. It also means that if the director changes the character proportions, the animation still works.

For more detail on posing a biped skeleton, see *Biped* on page 4487.

Attach the Skin

- Position the biped character within its modeled skin. Use *Figure mode* on page 4758 to scale bone lengths and to orient the skeleton correctly within the skin volume. Scale bone thickness as desired to achieve a good initial fit. Then save a figure file, so it’s easy to return to this pose.
- Use Physique to attach the skin geometry automatically to the biped or a 3ds Max bones hierarchy. The attachment is typically made to the root node in the hierarchy: the pelvis object on the biped or the root node on a bones hierarchy, not the center of mass. The attached skin is deformed as the biped or bones hierarchy moves.
- The links in the bones hierarchy are used to create a system of 3D envelopes that enclose nearby vertices. Envelopes typically overlap at the parent and child ends of links. Vertices within overlapping envelopes are blended to create smooth skin deformation over joints as the character moves.
Adjust Skin Behavior

Adjust Physique parameters and introduce skin behavior effects to achieve the desired characterization.

- Change default envelope shapes by adding cross sections and control points to isolate a more specific volume of vertices for each bone. Use exclusion lists or per-vertex weighting to apply fine-tuning control over individual vertices.

- Introduce bulge angles to change muscle shape based on the angle of a particular joint. Create tendons to simulate the motion of tendons under the skin, based on link movements.

- Adjust link parameters to change skin twisting, sliding, and creasing as the biped moves. Sliding allows the skin to compress at the biceps and forearm as the elbow is bent. Twisting controls the amount of skin twisting across a joint intersection.

- Create extra links using 3ds Max bones and dummy objects for added control. You can add links to the abdominal area to control compression, for example, or to create a link to animate the chest rising and falling as the character breathes. If a character has extra appendages, you can add 3ds Max bones to animate them. One common usage is to add a bone to animate the jaw.

For further detail, see Physique on page 4944.

Animate the Biped Skeleton

Once you’ve attached the skin to a biped structure, you can animate the biped freely and see the skin behavior update automatically, based on the current pose.

TIP  Physique skin deformation can slow down playback of your Biped animation. To improve performance, you can hide the skin object temporarily or reduce its resolution in the modifier stack.

You can also choose to develop Biped animations in a separate scene entirely, and apply them to your final skinned character when you are satisfied with your final motion.

A biped on page 4487 character is essentially an integrated hierarchy of bones that you can position freely using keyframes, IK goals, and footsteps. You can
position a biped character using all the rotation and transformation tools found in 3ds Max.

Many of the 3ds Max coordinate systems can be used to position the biped. Local coordinates are useful to move a limb along its axis (the local X axis is always the axis along the biped limb); world coordinates are handy when there is any confusion regarding which way is up. You can use world coordinates as a home base. In 3ds Max, the world Z axis is always up.

**NOTE** Rotations always occur about the local axis.

### Use Freeform Techniques

Biped provides a variety of methods for creating character motion easily. You can use a purely traditional approach by manually creating keyframes in freeform mode for different poses, letting the computer interpolate between joint positions and IK goals.

### Use a Footstep-Driven Technique

You can also choose a partially assisted approach by using footsteps and Biped dynamics to help you create a default walk, run, or jump cycle. You can then adjust the biped keyframes and footsteps individually.

When using footsteps, **biped dynamics** on page 8521 helps you by simulating gravity and balance.

- Gravity can help in a jumping motion to accelerate a character during the falling period and to bend the legs naturally on landing.
- Balance enables retaining the character balance by adjusting its position when the spine is rotated and keyframed.
- Dynamics can be turned off on a per-key basis or for the entire animation. The animator can override center of mass keyframes created using Dynamics calculation at any time. Simply set the dynamic properties of these keys or choose **Spline Dynamics** on page 8730 for keys generated by newly created footsteps.

### Convert Between Animation Types

Once you are satisfied with a particular footstep animation and its corresponding dynamic behavior, you can convert it on page 4570 to a freeform animation consisting of a simple combination of keyframes and IK goals. This
intelligent conversion gives you control of animation behavior at every frame, for every joint of the character.

**Use Layers to Apply Global Changes**

*Animation layers* on page 8507 offer you a powerful tool for introducing global changes to an existing character animation. For example, you can convert an upright running motion into a crouched run by adding a layer on top of an existing run motion. The layer would contain a single keyframe with the biped's spine rotated forward. You can stack up layered changes, allowing you to refine your motion composition and eventually collapse your layers into a standard non-layered keyframe animation.

**Use In Place Mode to Control the View**

*In Place Mode* on page 4656 is a tool that lets you keep your biped in view during animation playback. It offers a convenient way of adjusting and adding keyframes to a character without constantly changing your view to follow the character motion.

**Import Motion-Capture Files**

Motion-capture files can be imported from the BVH or CSM formats, edited, and saved as BIP files. You can import these files with or without footsteps and dynamics and combine them in Motion Flow mode with other animations. You can use the supplied motion-capture samples as is or adjust them to suit your needs using the collection of animation tools in Biped. The ability to import motion-capture marker files directly into *character studio* using the CSM file eliminates much of the cost of post-processing optical motion capture data. You can import motion-capture files with an additional prop bone, to define the motion of an object such as a sword or club.

You can also import *HTR/HTR2 motion-capture files* on page 7762, as well as *TRC files* on page 7765.

Motion-capture files can be imported with key reduction, making for more manageable tracks for subsequent editing.

**Use Track View for Keyframe Editing**

*Track View* on page 4801 allows you to edit keys and footsteps relative to the animation time line.
Footstep editing in Track View - Dope Sheet allows you to move footsteps in time. If you need a character to jump higher between footsteps, move the landing footsteps further down in time. Dynamics automatically compensate by making the character jump higher to keep it airborne longer.

You can also specify a freeform period in a footstep animation, using Track View - Dope Sheet. This allows you to take advantage of footsteps and dynamics for part of an animation, then switch to manual keyframing during the freeform period. This approach can be useful in animations where there is a mix of animation where the feet are on the ground and then off. Examples of this type of animation include running and diving, or walking and then sitting down.

Keyframe adjustment tools allow the following:

- Find the next or previous key for the selected biped body part.
- Use the Time spinner to slide a key back and forth in time.
- Change Tension, Continuity, and Bias for a key.
- Display trajectories.

You can place arms and legs of a character into the coordinate space on page 8541 of another object or the world to simulate interaction with fixed or moving objects. In Freeform mode, for example, putting the legs into world space on page 8769 prevents them from sliding or moving when keyframing the center of mass of the character. Putting a hand in the coordinate space of a ball allows the hand to move wherever the ball moves.

Many tools in 3ds Max can be leveraged with character studio. For example, you can use the Select and Link tool to attach objects to the biped.

If you want a character to pick up and carry an object and then put it down, you can use the Link controller to animate the duration of the attachment. 3ds Max bones can be used to animate character subassemblies, like pistons, and to create extra links for Physique.

**Use the Motion Mixer to Mix Animations**

You can use the Motion mixer on page 4002 to combine motions on a biped. For example, you could combine a walking motion with a cheering motion, and cause the biped to walk while cheering.
Use Motion Flow to Combine Animations

After you have created and modified various animation sequences, and stored them in biped motion files (BIP format), you can use Motion Flow mode on page 4886 to combine various motion files into longer animations that can be quickly previewed and edited. Motion Flow mode automatically places the animations end-to-end, allowing you to mix and match both freeform and footstep-driven motion files. Transitions between successive motions are automatically created for you, to provide a first-pass blending between overlapping frames of animation.

The Motion Flow transitions use velocity interpolation on page 8757 to create seamless transitions between clips. You can use the Transition Editor on page 4900 to modify a variety of blending parameters, including transition start frame, length, and angle between clips.

Refining Your Character

Great character animation is the result of many refinements that tune the overall personality of your character. You will find the need to refine progressively both the skinning behavior and the animation timing of your character. Biped and Physique make this iteration process straightforward by using the 3ds Max modifier stack and undo methods.

In addition, the ability of Biped to map motions between characters makes it easy to interchange great animations with existing characters, and tune their behaviors to achieve true integration of motion with character motivation and personality.

Use Crowds to Animate Groups of Characters

Once you've created animation sequences for characters or other models (such as a bird flapping its wings), you can replicate the models or characters and apply the motions to these groups using the Crowd system on page 5104. You can also combine them with a wide range of supplied behaviors to create lifelike activities in crowds, such as people streaming through a doorway, street traffic, or birds and fish flocking and avoiding obstacles. You can use Motion Flow mode to create motion clip networks. These allow characters to perform animation sequences appropriate to their current movement and transition smoothly between sequences. And you can use cognitive controllers in Crowd to transition between behaviors based on a variety of criteria. For more on crowd behaviors, see Creating a Crowd System on page 5105.
To work most efficiently with bipeds, it is important to follow the general workflow described in this topic.

**Create Skin Geometry**

Before you create a skeleton for a character, you should already have a character skin to put the skeleton into.

Create a basic skin shape for your character using any of the 3ds Max modeling tools and surface types. Be sure to place your character’s skin in a neutral pose with arms outstretched and legs spaced slightly apart. You may also want to add sufficient detail to your skin’s mesh or control points around joints to facilitate deformation during movement.

![Character mesh in a neutral pose](image)

**TIP** Before adding a biped skeleton, freeze your character mesh. When the mesh is frozen, you can still see it, but you can’t select or alter it, reducing the chance for error or frustration.

**Create a Biped Skeleton**

Once you have a character mesh, you can create a biped skeleton to fit inside. Use Figure mode on page 4758 to set up your biped.
Before you position the skeleton, use controls on the Structure rollout on page 4762 to alter the biped to match your mesh, setting the number of links for the spine, arms, neck, or fingers, or adding props to represent weapons or tools.

**TIP** You can use ponytails to create animated jaws, ears, or horns.

**NOTE** Certain biped body parts, including fingers, tails, ponytails, props, and clavicles, can be repositioned in Figure mode to suit different characters.

When you position the biped inside your mesh, start with the center of mass (COM), which is the parent of all objects in the biped hierarchy. The COM should be positioned in line with the hips of the mesh character. Scale the pelvis so that the legs fit properly in the mesh, and then use Move and Scale on the 3ds Max toolbar to position your biped skeleton.

**NOTE** In addition to the standard move, rotate, and scale operations, you can also use modifiers to adjust the parts of the biped.

**NOTE** Biped body parts cannot be removed, however unwanted parts can be hidden. If you delete a part the entire biped will be deleted.

The following list includes some tips for positioning your skeleton:

- Use the Page Up and Page Down keys to cycle through links.
- Use Rubber Band mode on page 8702 to move and scale the arm and leg links on your skeleton simultaneously.
- Use tools from the Bend Links rollout on page 4700, such as Bend Links Mode on page 8518 and Twist Links Mode on page 8752 to adjust tail, neck, spine, and ponytail links.
- The head, toes, and fingertips should extend slightly beyond the mesh extents to fulfill the requirements of Physique.
- Use the minimum number of fingers and toes. You need extra fingers or links only if you are planning on complex hand or foot animation. If your character is wearing gloves or shoes, then you probably only need one finger or toe, with one link.
- To create a biped with knees that bend backwards, rotate the biped calves or thighs of both legs 180 degrees about their local X-axis (along the length of the limb). When you exit Figure mode, the biped walks, runs, and jumps with reversed knees.
When working with a mesh in a symmetrical pose, pose one side of the skeleton, and use controls on the Copy/Paste rollout on page 4726 to paste the posture to the opposite side of the biped.

When you are satisfied with your pose, check the alignment in all viewports to make sure that the skeleton is positioned correctly in the mesh.

Once you have successfully positioned a skeleton inside your character mesh, you are ready to attach the mesh with Physique. For more on this workflow, see Understanding Physique on page 4470.
Creating a Biped

A biped model is a two-legged figure: human or animal or imaginary. Each biped is an armature designed for animation, created as a linked hierarchy. The biped skeleton has special properties that make it instantly ready to animate. Like humans, bipeds are especially designed to walk upright, although you can use bipeds to create multi-legged creatures. The joints of the biped skeleton are limited to match those of the human body. The biped skeleton is also specially designed to animate with character studio footsteps, which help solve the common animation problem of locking the feet to the ground.

The parent object of the biped hierarchy is the biped’s center of mass object, which is named Bip01 by default.

Creating a Biped

A button for creating a Biped appears in the Create panel under Systems. You create a biped by clicking this button and then dragging in the active viewport. You interactively define the height of the biped as you move the cursor.

During biped creation, you can change any of the default settings that are used to define its basic structure. The default settings, for Arms, Neck Links, Spine Links, and so on, are for a human figure.
If you turn on Most Recent .fig File, the biped you make will use the parameters stored in the last FIG (figure) file you’ve loaded.

**Changing Biped Parameters**

Like other 3ds Max objects, you can change biped parameters on the Create panel at creation time. However, to modify or animate a biped, you use parameters on the Motion panel. For more information on changing biped parameters, see Structure Rollout on page 4762.

**Creating a Biped Using AutoGrid**

The AutoGrid feature lets you create objects on the surface of other objects, rather than on the home grid. AutoGrid automatically creates a grid for construction. When you turn AutoGrid on, a tripod cursor is displayed in the viewport. As you move your mouse over the geometry in the scene, the tripod cursor rotates to match the orientation of the face it’s touching. A grid is created at that spot and is used to create the biped.
By turning on AutoGrid in the Create Panel > Object Type rollout, biped creation will respect the AutoGrid, letting you build bipeds with their feet on top of geometry.

**Procedures**

To create a biped on a surface:

1. On the Create panel > Systems, click Biped.
2. Turn on AutoGrid.
3. Move your cursor over any geometry in the viewport.
   A Transform gizmo moves with your cursor to indicate the location of the AutoGrid.
4. Drag out a biped.
   The biped feet will be in contact with the geometry.

**Understanding Biped Anatomy**

The geometry of a biped is a linked hierarchy of objects that by default resemble those of a human. The parent or root object of the biped is its center of mass (COM) on page 8530. This object is displayed as a blue octahedron near the center of the biped's pelvis. Moving the COM positions the entire biped.
You can select the center of mass by choosing Bip01 with the Select From Scene dialog on page 206.

You can also select the center of mass by clicking Body Horizontal, Body Vertical or Body Rotation on the Track Selection rollout on page 4686.

**Changing the Biped Hierarchy**

The biped hierarchy is a little different from a standard 3ds Max hierarchy in that you can’t delete any of the components of the skeleton. If you try to delete any part of the biped skeleton, you delete the entire hierarchy. If you want to create a partial biped, for example a biped with no head, simply hide the objects you don’t want to use.

**Repositioning Biped Body Parts**

You can reposition certain biped body parts in Figure mode to suit different characters. You can move entire arm assemblies by selecting the clavicles and moving them up or down. You can also reposition the fingers, tail and ponytails as you like. See Posing the Biped on page 4496.
Biped's structure also includes an option to add twist to any and all limbs. This feature uses a variable number of links to transfer twisting animation into the biped's associated mesh via Physique or Skin.

**Props**

The biped structure includes an option to add up to three props. Props appear next to the biped's hands and body by default, but can be modified or animated throughout the scene like any 3ds Max object.

**Adding Extra Biped Body Parts**

To add extra legs, arms, or other body parts you need to create 3ds Max geometry for those parts, then link them to the biped hierarchy. You can use Snapshot to duplicate biped body parts to create these as well. In either case you will need to animate them with standard 3ds Max rotations, because biped IK will not be available on these extra parts.

**Changing Initial Biped Anatomy**

Use the body parameters to change initial biped anatomy. The Body parameters are in the Create Biped rollout that appears in the Create panel when you create a biped.

**NOTE** You can change body parameters in the Create panel immediately only after creating a biped. Once you leave the Create panel, these settings are still available, but from the Structure rollout in the Motion panel. The body parameters in the Structure rollout are enabled when the biped is selected and Figure mode is active.

See also:
- Creating a Biped on page 4490
- Structure Rollout on page 4762

**Naming the Biped**

If your scene is going to contain more than one biped, it's a good idea to give the biped a unique name. By default, the first biped in a scene is called Bip01.
Succeeding bipeds have the same name except that the two-digit number is replaced by another number in sequence: 02, 03, 04, and so on.

Since the parent of the biped hierarchy is the biped's center of mass object, that is also the object selected when you choose Bip01. You can link the biped center of mass to other objects or dummies for additional animation control. For more information on the biped's hierarchy, see Understanding Biped Anatomy on page 4492.

**Procedures**

**To change the biped name upon creation:**

- Immediately after creating the biped and before moving to another panel, enter the new name in the Root Name field in the Create Biped rollout. The center of mass is renamed and the entire biped hierarchy inherits the new name.

**To change the biped name after creation:**

1. Select any part of the biped and go to the Motion panel.
2. In the Biped rollout, click the expander bar to display the Modes and Display groups.
3. Enter a new name in the Name field and press Enter.

**WARNING** Do not use the usual Name And Color rollout to rename a biped. This changes only the name of the biped's root object (its center of mass) without updating the names of other biped parts in the hierarchy.

**To create a Named Selection for the biped center of mass:**

1. Select the biped center of mass (diamond shaped object in the pelvis) in the viewports.
2. Type a name in the Named Selection Sets field on the 3ds Max toolbar.
3. Press Enter.
   - You can now choose this selection if the biped is hidden and you want to view the biped and edit biped parameters on the Motion panel.
**TIP** Give the center of mass selection the same name as your character in the Named Selection Sets field, "John," for example. With multiple characters, you can quickly select the character you want to edit by choosing the character's name in the Named Selection Sets dropdown.

---

**Posing the Biped**

After creating the default biped, you will often need to change the proportions of the skeleton to fit your model. Use Figure mode to change the biped structure in its rest pose.

Activating Figure mode returns the biped to its original location and orientation. With the biped in Figure mode, you can use the transform tools to change the proportions and positions of body parts. For instance, you might apply a non-uniform scale to shorten the legs or lengthen the arms.
Posing the Biped | 4497
Biped proportioned to fit inside of Dr. X character geometry

You might rotate the spine objects to create the figure for a hunchback or a dinosaur. Use the move tool to change the position of the thumb or the arms. You can even apply modifiers to the biped skeleton pieces, such as using an FFD on the biped head to adjust its shape.
Once you have a default biped, you’ll need to match its proportions to the character’s geometry. It is quite typical to find the character’s geometry with the arms outstretched. The common workflow is to freeze the character and then in Figure mode, reposition the biped, so the center of mass is at the base of the torso. The spine objects, legs, and feet are scaled and rotated to fit within the confines of the mesh, then the arms and hands, neck and head. The tail and ponytail objects can be used for animating wings, fins, jaws, ears, horns, or hair.
Once your biped proportions are correct, you can save them in a FIG file. Because Biped saves the character in the FIG file and animation in the BIP file, you can change the character’s proportions without affecting the animation.

**Changing the Biped Structure**

Bipeds don’t have to appear human. You can change their elements and form to create other kinds of characters. Although you can change some initial aspects of the biped’s structure in the Create panel, you use Figure mode to change all aspects of the biped’s structure after its creation.
or even walk on two legs.

Any number of bipeds can be in Figure mode at the same time, though you can only work on one biped at a time. When you select a biped, the Figure mode button indicates whether or not the biped is in Figure mode.

In Figure mode you can:

■ Specify the number of links in each part of the biped.

■ Define the position of the base of the fingers, toes, clavicles, spine, tail, ponytails, and props relative to the body.

■ Define the position of the feet relative to the ankles.

■ Define the default pose of the biped before animation is applied to it, for example define a hunchback.

■ Scale the biped and its various parts.

■ Simultaneously scale and position biped parts using Rubber Band mode on page 8702. See Rubber-Banding Arms and Legs on page 4507.

■ Create natural links for Physique using Triangle Pelvis.

■ Use forearm links to transfer twisting animation to the biped's associated mesh.

For more information on adjusting the biped's proportions, see Scaling Links on page 4505.
Working with Both Arms or Legs

As you pose your biped, there are two different methods for posing both arms or legs symmetrically.

The first method involves using Symmetrical on the Track Selection rollout on page 4686 to select both limbs simultaneously. With both limbs selected, you can rotate and scale the objects, and they will maintain a mirror-image relationship. You can also move the limbs, however they will not retain a symmetrical pose (with respect to the body) if you move them laterally.

The second method involves posing only one side of the biped, then copying the posture to the corresponding limbs on the other side.

NOTE You can scale biped limbs only in Figure mode on page 4758.

See also:
- Figure Mode on page 4758
- Biped Rollout on page 4669
- Creating a Skin on page 4946

Procedures

To work in Figure mode:

1. Select the biped you want to pose, and then go to the Motion panel. The Motion panel doesn't show Biped controls unless the biped is selected.

2. On the Biped rollout, click Figure mode.

The button turns blue to indicate a special edit mode. The biped's pose and location change to the one last specified when the biped was in Figure mode. If the biped was just created and, therefore, was never in Figure mode before, it changes to the pose and location it had when you created it. When you turn off Figure mode, the biped returns to its animated pose and location in the scene.

NOTE Biped disables all keyframe editing tools when Figure mode is active. Adjustments made in Figure mode are not animatable.
To fit biped legs to the skin:

1. Turn on Figure mode on the Biped rollout.
2. Use the Scale Transform gizmo to scale the Z-axis of the biped’s pelvis so the biped’s leg links are centered in each leg of the skin.
3. Select the biped’s two thigh links (LLeg and RLeg) and scale the X-axis of the thigh links so they end at the knees of the skin.
4. Select the biped’s two lower leg links (LLeg1 and RLeg1), and scale the X-axis of the lower leg links so the biped’s ankles are level with the ankles of the skin.
   
   **TIP** When the two upper legs are selected, you can press Page Down to select the lower legs.

5. In a left or right viewport, scale the biped’s feet so their profile roughly matches the profile of the feet of the skin.
6. Scale toes or move them along their local X-axis so each toe is aligned with the corresponding toe in the skin.
   
   The ends of the final toe links should go through the tips of the skin’s toes.
   
   You might have to change the number of biped toes to match the number of skin toes. A biped must have at least one toe on each foot. If the skin has no toes or the character is wearing footwear, the position and number of biped toes doesn’t matter, but they should still extend beyond the skin.

   **TIP** During the fitting process, try Freezing the skin object to prevent accidental selection.

To fit the spine to the skin torso:

1. On the Biped rollout, turn on Figure mode.
2. Select the lowest link of the spine (Bip01 Spine). Choose the Move transform, constrain movement to the spine link’s local X-axis, and move it vertically to the waist of the skin, just below the navel.
3 Scale the other spine links in their local X-axis so they fit the upper part of the skin’s torso.
   The neck link should begin where the skin’s neck begins.
   If the torso of the skin curves, you should also rotate spine links about their local Z-axes, to align the spine with the longitudinal center of the torso.

4 Scale the biped's neck in its local X-axis to match the length of the neck of the skin. The top of the last neck link (also the base of the head link) should be where you want the head to pivot. This is usually just below the ears, centered with the spine.
   Leave the head in its default position relative to the spine and neck links.

To fit both arms using copy/paste:

1 On the Biped rollout turn on Figure mode.

2 Rotate one upper arm (R Arm1 or L Arm1) in its local Y-axis to center its link in the upper arm of the skin.

3 Scale the upper arm so its link ends at the elbow of the skin.

4 Scale the lower arm (RArm2 or L Arm2) so its link ends at the wrist of the skin.
   If the skin’s arms are bent, rotate the lower arm to center its link as well.

5 Scale fingers, or move them along their local X-axis so each finger is aligned with the corresponding finger of the skin.
   The ends of the final finger links should go through the tips of the skin’s fingers. You might have to change the number of biped fingers to match the number of skin fingers.

6 When the arm is completely fitted to the skin, select all of it and on the Copy/Paste rollout, click Copy Posture.

7 On the Copy/Paste rollout, click Paste Posture Opposite to pose the opposite arm.

To pose both arms simultaneously:

1 On the Motion Panel > Biped rollout, turn on Figure mode.
2 Select the biped's left or right hand.

3 On the Track Selection rollout, click Symmetrical.
The opposite hand is also selected.

4 Move, rotate, and scale the hands until you have the position and size you want. Use PAGE UP and PAGE DOWN to move the different parts of the arm.

**NOTE** If you move limbs laterally, they will both move in the same direction, and will no longer be symmetrical about the body.

To create a symmetrical pose by copying one side of the biped to the other:

1 On the Motion Panel > Biped rollout, turn on Figure mode.

2 Move, rotate, and scale the left arm and leg of the biped until you have the position and size you need.

3 Select all of the bones in the left arm and leg.

4 On the Copy/Paste Rollout, create a collection, then turn on Posture and click Copy Posture.

5 On the Copy/Paste Rollout, click Paste Posture Opposite.
The right arm and leg assume the position and scale of their corresponding bones on the left.

**Scaling Links**

Use standard 3ds Max scale transforms to adjust a biped's posture by scaling the size of its links. You must be in Figure mode to scale the biped links. If you try to scale a biped without going into Figure mode, nothing happens.

As with rotation, when you scale biped links, Biped constrains the transform to use the link's Local coordinate system. The position of other biped links
can change so they remain attached to the resized link. If you shorten the thigh, the calf and ankle will maintain their size, but change their position.

To scale a link, select any scale icon from the Scale flyout on the Main Toolbar. When you select a body part to scale, use the Transform gizmo to scale along one axis at a time.

Use Scale and the Transform gizmo to scale links.
If your character is symmetrical, select body parts in pairs and scale them at the same time.

Select one body part and then click Symmetrical in the Track Selection rollout. Now both are selected.

You can also scale one and then use Copy Posture and Paste Posture Opposite from the Copy/Paste rollout. This approach ensures symmetry in your character.

**TIP** Use the Page Up and Page Down keys to move through your hierarchy as you work. For example, after you scale the thighs, press Page Down to select the calves.

Scaling the biped limbs to fit snugly to the mesh will help when Physique is used to associate the mesh with the biped. The Bounding Box option uses biped limb dimensions to size the envelopes. This saves time when you adjust envelopes in Physique.

See also:
- [Rubber-Banding Arms and Legs](#) on page 4507

**Rubber-Banding Arms and Legs**

Rubber Band mode provides a way to proportion the arm and leg links simultaneously. Rubber Band mode works with the Move transform rather than the Scale transform. When you move an arm or leg with Rubber Band mode turned on, both the link and its child are scaled in a single step.

Rubber-banding the upper arm rescales the upper and lower arm objects and moves the elbow link without affecting the position of the shoulder or the wrist. If you’ve spent a lot of time getting the fingers in the right place, you can reposition the elbow by rubber-banding, without affecting the hands.
Using Rubber Band to resize an arm without changing the hand position
Procedures

To rubber band an arm or leg link:

1. On the Motion panel > Biped rollout, turn on Figure mode.
2. Select the arm or leg link you want to rubber band.
3. Turn on the Move transform.
4. On the Biped rollout > Modes group, turn on Rubber Band mode.

**NOTE** This button is unavailable if you are not in Figure mode, or if a part of the biped other than the upper or lower arm or leg, or the center of mass is selected.

**NOTE** The Modes group is hidden by default. To display it, click the expansion bar on the Biped rollout.

5. Move the selected arm or leg link.
   As you move the arm or leg link, the hands and feet are stationary as the knees or elbows are positioned.

To adjust the biped center of mass with Rubber Band:

1. On the Motion panel > Biped rollout, turn on Figure mode.
2. Select the center of mass object (diamond shape) on the biped.
3. Turn on the Move transform.
4. On the Biped rollout > Modes group, turn on Rubber Band mode.
   This button is unavailable if you are not in Figure mode or if a part of the biped other than the upper or lower arm or leg or if the center of mass is selected.

5. Move the center of mass.
   While Rubber Band mode is active, the center of mass moves independently from the rest of the biped, which remains in the same position.
TIP Another way to adjust the biped’s balance is to change the value of Balance Factor. Balance Factor displays on the Key Info rollout when a Body Horizontal key is current. Balance Factor can be keyframed.

Biped Display Options

For greater speed in displaying bipeds, or to make your viewports less cluttered while you edit your scene, Biped lets you turn off the display of some biped elements. These display controls are found in the Motion panel > Biped rollout on page 4669 > Display group on page 4674, rather than on the Display panel.

These controls allow you to quickly turn on and off the biped bones, objects and footsteps, twist links and leg states, as well as footstep numbers and trajectories. There is also a Display Preferences dialog accessed from here that lets you control which bipeds are visible during Biped Playback.

NOTE The Display group is hidden by default. To display the group, click the expansion bar on the Biped rollout.

Procedures

To change biped display:

1. Go to the Motion panel.
2. On the Biped rollout > Display group, click a button corresponding to the display choices you want.

NOTE The Display group is hidden by default. To display the group, click the Modes And Display expansion bar on the Biped rollout.

Deleting a Biped

You can quickly and easily delete an entire biped from a scene.
Procedures

To delete a biped:

1. Use any selection tool to select the entire biped or any part of the biped.
2. Press Del or Delete on your keyboard.

Linking Character Body Parts to the Biped

With the Physique component, you can use Biped to animate a deformable skin, usually a mesh object. However, some animations don't require deformation. For example, a knight clad entirely in rigid metal armor doesn't need to deform as skin does. Also, figures seen from a distance don't require the same degree of realism as figures seen close up.
Characters available commercially often come in two varieties: jointless and jointed. Jointless characters have a seamless mesh at limb joints. Jointless characters should be attached to the biped using Physique. A jointed character has separate objects with ball joint geometry for the limbs, and lends itself to the linking technique described in this topic.

Linking objects and other geometry to the biped can also be used in cases such as the following:

- Link a weapon or a flower to the biped hand.
- Link eyeballs or teeth to the biped head.
- Link extra 3ds Max bones or splines to the biped to create extra envelopes when Physique is applied.
■ Link 3ds Max bones to the biped to automate mechanical assemblies when the biped is keyframed.

■ Link particle emitters to the biped hands or feet to create smoke or dust.

---

**NOTE** If you’ve linked particle emitters or 3ds Max bones (with the IK controller) to the biped, the Animate button must be on when you reposition the biped.

---

See also:

■ [Biped Rollout](on page 4669)

---

**Procedures**

**To link a mechanical character to the biped (without Physique):**

With mechanical or jointed characters, you can simply link objects to the biped without using the Physique modifier.

1. Load or create a mechanical or jointed model. Body parts in this model should be separate 3ds Max objects.

2. Create a biped.

3. On the Biped rollout turn on Figure mode, then position and fit the biped to your mesh objects.

4. Go through the mesh objects and use Select and Link on the 3ds Max toolbar to link each object to its corresponding part on the biped. All of keyframe animation applied to the biped will animate the model.

---

**TIP** If you plan to use 3ds Max linking and Physique together, link the body parts to the biped after applying Physique. In this way, Physique will not create superfluous links from the biped to the mechanical body parts when it is applied.

---

**Saving and Loading FIG Files**

Select a biped. > Motion panel > Biped rollout > Load File (in Figure Mode)
Select a biped. > Motion panel > Biped rollout > Save File (in Figure Mode)

Figure files save all information about a biped's anatomy: links, link positions, twist links, and Figure mode posture, and the scale of geometric elements. Figure (FIG) files have a .fig file name extension.

Figure files do not contain the actual biped skeleton, or any animation. They are used strictly for setting or saving a biped's pose in Figure mode.

Figure files are useful for quickly setting poses for similar or identical characters.

Clicking Load File brings the Open dialog, from which you can pick a FIG file and choose from the following twist poses on page 4695 options:

- **Load Twist Poses**: Loads both the twist links on page 4762 and twist poses data. (Default=on).
- **Don't Load Twist Poses**: Loads only the twist links data.

**NOTE** The pose presets are always available.

- **Load Twist Poses Only**: Loads only the twist poses data without the twist links.

**NOTE** The Twist and Bias values are not used without twist links. Refer to the Twist Poses rollout on page 4695 for details.

See also:

- **Figure Mode** on page 4758

**Procedures**

**To save a biped's figure information to a file:**

1. Select the biped to save.
2 On the Motion panel, activate Figure mode.

3 On the Motion panel > Biped rollout, click Save File.
4 In the file dialog, enter a name for the figure file, and then click OK.

**TIP** While you work on creating a biped pose, save your work frequently in a figure file.

To load a biped figure:
1 Select the biped to replace with a saved figure.

2 Activate Figure mode in the Motion panel.

3 On the Motion panel > Biped rollout, click Load File.
4 In the file dialog, choose the figure file to load.
5 Choose one of the three loading options, depending on whether or not you want to load twist poses, or to load twist poses only.
6 Click OK.

**WARNING** Loading a figure file replaces the selected biped’s pose and base parameters. If you have created a new pose or a new biped structure, save it in a figure file before you load a different biped figure.

---

**Footstep Animation**

Footstep animation is a central compositional tool in Biped. Footsteps are biped sub-objects, similar to gizmos on page 8593 in 3ds Max. In viewports, footsteps look like the diagrams often used to illustrate ballroom dancing. Each footstep’s position and orientation in the scene controls where the biped steps.
Footsteps

The language of footsteps allows you to more directly describe and compose the complex time and space relationships that are found in different forms of locomotion.

While the placement of footsteps appears in viewports, the timing appears in Track View - Dope Sheet Editor. There, each footstep appears as a block of time, with each block representing the time when the foot is planted in a footstep.
Footsteps are appropriate for animation where the biped is on the ground or uses the ground a great deal, such as walking, standing, jumping, running, dancing, and athletic motion. For movement that does not require the biped to interact with the ground, such as swimming or flying, freeform animation on page 4571 is more appropriate.

Footsteps are used to lock the foot to the ground. You can create the same result in freeform animation by simply creating planted keys on page 4707 for the feet.

Workflow

In general, you compose a footstep pattern with these actions:

1. Select the biped and access the Motion panel.
2. Click Biped rollout > Footstep Mode.
3. In the Footstep Creation rollout, click Walk, Run or Jump to choose the gait (a method or pattern of moving on foot). The gait sets the initial timing for footsteps you create.
   When you first create them, footsteps are inactive. They exist in the scene but don’t yet control the biped’s motion.
Create the footstep pattern in viewports. You can create footsteps in a few different ways, each available in the Footstep Creation rollout:

- Automatically create a number of footsteps with Create Multiple Footsteps, or
- Individually place each footstep with Create Footsteps (append) or Create Footsteps (at current frame). Use Auto Grid to create footsteps on a surface of a mesh.

Edit footstep placement by moving or rotating footstep icons in viewports.

Edit footstep timing in the Track View - Dope Sheet mode.

Activate the footsteps to create keys for the biped. The biped will now move through the footsteps using the placement and timing you set up.

Play the motion to test it out, looking only at the leg and foot motion and disregarding the upper body for now. If the footstep motion isn’t right, deactivate the footsteps, make changes to footstep placement or timing, reactivate the footsteps and play it again. Do this until the foot and leg motions are correct.

When footsteps are activated, keys are created for each of the tracks of the figure: the head, spine, pelvis, arms, legs, and, if appropriate, tail and ponytails. These keys form an initial sketch of your animation. The default keys, when interpolated on page 8612, form the basic, minimal motion required to animate the figure according to the footstep pattern. Most likely you will want to adjust or replace these keys.

Edit the animation of the upper body using ordinary 3ds Max animation methods: Turn on Auto Key and move or rotate the biped parts. You can also use the character studio Set Key tools on the Key Info rollout on page 4704.

Play the animation again and make any corrections to the upper body motion.

Footstep Method

In the viewports, footsteps represent support periods in space for the biped feet. You can move and rotate footsteps in viewports. In Track View, each footstep appears as a block that represents a support period in time for each of the biped’s feet. You can move footsteps in time in Track View. The footstep position and orientation in the viewport controls where the biped will step.
There are three ways to create footsteps for the biped:

- Place footsteps individually.
- Use the footstep tools to automatically create a walking, running or jumping animation.
- Import motion-capture data to footsteps.

A key advantage of the footstep method is the natural adaptation of the biped that occurs when the footsteps are edited in time and space. Editing footsteps in the viewports allows you to reposition all of the footsteps to move the entire animation. In Footstep mode, stride, length, width, and direction can be changed quickly for an entire animation and the biped automatically adapts.

Using the Footsteps Show/Hide button on the Display rollout, all footsteps can become visible. Move the footsteps in the viewports to position them for proper ground collision with the terrain object. For example, if the biped toes are rotated for the Lift key at the last frame of a footstep (to create more toe curl as the character walks) the leg automatically repositions itself to maintain foot contact with the ground (footstep).

These adaptations speed up the process of creating and editing animation for the biped. If necessary, the animator can prevent biped adaptation by using the Adapt Locks parameters on page 8498 on the Dynamics & Adaptation rollout on page 4755.

**Foot States**

Within a footstep animation, there can be four foot states: move, touch, plant, and lift. These correspond to the state of the biped feet in relationship to the footsteps. Use the foot state displays in the Biped rollout to determine the state of the biped feet when you are editing the biped foot or leg keys. The foot states can be displayed in the viewport by turning on Leg states in the Display group of the expanded Biped rollout. The Foot states are represented as colored keys in Track View - Dope Sheet.

**Footstep Mode**

When Footstep mode is active, footstep creation controls appear in the Motion panel.
Footstep controls in Motion panel
Using the default keyframes as a starting point, you can interactively insert, replace, or delete keyframes in order to refine the motion of the biped and fill in the details of movement that are unique to your animation.

**NOTE** By default, when Biped Dynamics on page 8521 is turned on in the Dynamics and Adaptation rollout, gravity (Dynamics Blend) and ballistic tension calculate the trajectory of the center of mass for all newly created keys in a footstep animation containing a running or jumping motion. If Spline Dynamics on page 8730 is turned on in the Dynamics and Adaptation rollout before footsteps are created and activated, the center of mass uses spline dynamics to calculate vertical motion, which does not take gravity into consideration. Using spline dynamics, you must set keys for the top of a jumping motion or the dip when the character lands; this trajectory is automatically calculated with biped dynamics.

**Footstep Editing**

At any point in the design process, you can choose to interactively edit your footstep's spatial pattern in the scene or the timing of footsteps in Track View. The keyframes adapt to each edit: changes to footstep location retain the details of all your keyframe positions. Keyframe timing remains synchronized
with changes to footstep timing, except in cases where default leg keys must be regenerated to account for timing edits that alter the basic gait pattern, such as creating a hop in the middle of a walk.

Use Footstep mode to create and edit footsteps. Use Keyframe mode (Footstep mode off) to create and edit your character’s keys. You can always edit the timing of both footsteps and keyframes in Track View.

While the biped's feet are airborne, you can animate its legs as you do its upper body. Biped does not create keys based on physics while the biped is off the ground, so animating the legs might be necessary to make long leaps realistic. Alternatively, you might want to make the biped appear to be floating in midair, or underwater, or have it ride a bicycle. See Freeform Editing Between Footsteps on page 4565.

You can make the biped interact with other objects in the scene: throwing or kicking a ball, opening a door, and so on. You do this by attaching a biped limb to an object in the scene.

An animatable IK Blend parameter lets you store the anchored position and combine inverse with forward kinematics. After you've set keys, be sure to remove the anchors.

TIP You can often get good results by loading an existing biped motion and then varying it. You'll find a set of sample motion files on the program disc in the \Samples\Motions directory.

NOTE On the time slider or in Track View, you can move one Biped key past another. See Moving Keys on page 4805.

Creating Footsteps

The topics in this section deal with the creation of footsteps for animating bipeds.

Planning for Footsteps

Spend a little time planning your footstep animation with pencil and paper first. This will make the task of setting up footsteps much easier. Answering the questions below can help orient your planning.
Planning for Footstep Placement

- How are the footsteps going to be positioned in viewports? Draw a sketch of their positions.
- What is the sequence of the footsteps? This will determine the footstep numbers. Footsteps always begin with the number 0. Number them in your diagram if you can.
- Is each footstep a left or right footstep?

Planning for Footstep Timing

- What is the support relationship between left and right footsteps? In other words, does the timing of the footsteps resemble a walk, run or jump pattern? A character doing a foxtrot or waltz, for example, is actually moving with “walk” timing – the character shifts weight from one foot to the other.
- How long, in frames, should each footstep be? How long are the biped's airborne periods?
- Are there any periods of time where the biped is standing on two feet for a while?
Choosing a Gait

A *gait* is a method or pattern of moving on foot.

When you create new footsteps, the timing is determined by the gait you have chosen (Walk, Run, or Jump) and the parameters for that gait. You must choose the gait before parameters can be set.

Choose the gait that most closely approximates the type of movement you want to create. You can alter or adjust the gait after footsteps have been created.

**Walk Gait**

In a walk, at least one foot is always in contact with the ground. A period where one or both feet are in contact with the ground is called a *support period*. If both feet are on the ground, this is known as a *double support period*.

Turn on Walk before creating footsteps to create this type of gait.

The gait parameters of a walk are:

- **Walk Footstep** The number of frames that each footstep remains on the ground.
- **Double Support** The number of frames in a double support period, that is, when both feet are on the ground.

**Run Gait**

With running, both feet are never on the ground at the same time. Either one foot is on the ground during the support period, or the body is airborne. While it is airborne, the body moves forward horizontally at a constant speed. In general, the longer the body is in the air, the higher it must fly after lifting off from the supporting foot to stay airborne for the specified period of time.

Turn on Run before creating footsteps to create this type of gait.

The gait parameters of a run are:

- **Run Footstep** The number of frames that each footstep remains on the ground.
- **Airborne** The number of frames that the biped is airborne, that is, when neither foot is on the ground.
Jump Gait

Jumping is a special case of running. Both feet are in contact with the ground at the same time, or airborne at the same time. As with running, forward motion is horizontal and constant, but vertical motion depends on the length of the jump.

Turn on Jump before creating footsteps to create this type of gait.

The gait parameters of a jump are:

Feet Down The number of frames in which both feet are on the ground.

Airborne The number of frames that the biped is airborne, that is, when neither foot is on the ground.

Changing these values changes the biped's jump behavior.

Setting Gait Parameters

Gait parameters can be found in two areas:

- If creating footsteps automatically with Create Multiple Footsteps, the gait parameters appear on the Create Multiple Footsteps dialog on page 4781.

- If creating footsteps manually with Create Footsteps (append) or Create Footsteps (at current frame), the gait parameters on the Footstep Creation rollout on page 4774 are used.

Changing these values changes the timing for any footsteps placed after the values are set.

Changing the Gait After Creating Footsteps

After creating the footsteps, you can change the gait by editing footstep timing in Track View’s Dope Sheet mode. See Editing Footstep Timing on page 4538.

Gait parameters are only one way to define the timing and nature of the biped’s gait. For a more complete description of gaits and other parameters that alter the nature of the biped's motion, see Adjusting Vertical Motion on page 4555.
Creating Footsteps Automatically

Automatic footstep creation is the easiest way to create a walk or run cycle. You can use this method to make the biped climb or descend a flight of stairs, hop repeatedly, and do a variety of motions. Automatic footstep creation places the footsteps for you, generating perfectly timed and spaced footsteps.

See also:
- Creating Footsteps Manually on page 4527
- Adjusting Vertical Motion on page 4555

Procedures

To create footsteps automatically:

1. Select any part of the biped.

2. On the Motion panel > Biped rollout, click Footstep Mode. You are now in Footstep mode, where you can create, activate, or edit footsteps.

3. In the Footstep Creation rollout, choose the gait you want to use for the footsteps: Walk, Run, or Jump. The selected gait determines the timing pattern of the automatically placed footsteps.

4. In the Footstep Creation rollout, click Create Multiple Footsteps. The Create Multiple Footsteps dialog on page 4781 appears. This dialog determines various aspects of the footstep sequence, such as how far each footstep will be placed from the previous footstep.

5. Set the multiple footstep parameters, and then click OK. This places footstep icons in the scene. To make the biped move through the footsteps, you must create keys for the footsteps.

6. Click Create Keys For Inactive Footsteps on the Footstep Operations rollout.
Keys have now been created for the footsteps.

Click Play Animation to see the animation.

Creating Footsteps Manually

Creating footsteps manually is useful for complicated footwork, such as dancing. Manual footstep creation allows you to place each new footstep carefully where you want it.

Multiple footsteps can also be generated automatically. To quickly generate a simple walking, running, or jumping footstep patterns, see Creating Footsteps Automatically on page 4526.

There are two ways to create footsteps manually:

- You can start creating footsteps at the current frame with Create Footsteps (at current frame) in the Footstep Creation rollout on page 4774. Any footsteps added subsequently will extend in time from the first footstep. If you attempt to create a footstep at the same time as an existing footstep on the same side, an alert appears and you are not allowed to create the footstep.

- You can also append footsteps onto the end of the existing footsteps with Create Footsteps (append) in the Footstep Creation rollout on page 4774. Then Biped computes the frame at which the first footstep should be created based on the chosen gait and the existing footsteps. This option is disabled if there are no existing footsteps.

As with all footsteps, any footsteps you create with these methods are inactive upon creation. You must activate them with Create Keys for Inactive Footsteps in order to make the biped move through them.

Preparing to Create Footsteps Manually

Before placing footsteps, you must choose the gait, then set parameters for the gait in the Footstep Creation rollout on page 4774.
Footstep creation and gait buttons

When you select the Walk, Run, or Jump gait, parameters for that gait appear on the Footstep Creation rollout. See Choosing a Gait on page 4524 for information on gaits and parameters.

Switching Between Left and Right Footsteps

By default, manually placed footsteps alternate left, right, left, right. The footstep cursor, which appears during individual footstep creation, shows you whether a left or right footstep will be placed next.

If you want to change the footstep side that will be placed when you next click, press Q to toggle between them. Pressing Q also changes the cursor, showing you which footstep side will be placed next.

Automatic Time Extension

During manual footstep creation, your display remains at the current frame. However, footsteps are created sequentially in time. If the footsteps you create require more frames than are in the active time segment, the footstep creation process extends the active time segment, which can create new frames.

Creating New Footsteps Between Existing Footsteps

If inactive footsteps exist, you can only create new, inactive footsteps within or directly before or after the time of the inactive footsteps. If you need to add more footsteps near a time where there are only active footsteps, deactivate all footsteps first, then add footsteps and activate them again. See Deactivating Footsteps on page 4532.

See also:

■ Choosing a Gait on page 4524
■ Creating Footsteps Automatically on page 4526
Editing Footstep Placement on page 4537

Procedures

To prepare for manual footstep creation:

1. On the Motion panel > Biped rollout, click Footstep Mode. You are now in Footstep mode, and can create, activate, or edit footsteps.

2. In the Footstep Creation rollout, choose the gait you want to use: Walk, Run, or Jump. See Choosing a Gait on page 4524 for details on gaits and their parameters.

3. In the Footstep Creation rollout, set parameters for the chosen gait.

To create footsteps beginning at the current frame:

1. Turn on Footstep Mode.

2. Click Create Footsteps (at current frame).

3. Click in a viewport to create a footstep. Move the cursor and click again to create another footstep. Repeat until you have created all the footsteps required.

   **TIP** Use the Top viewport to create the footsteps.

   Watch the footstep cursor to see whether a left or right footstep will be placed next. If you want to place two left or two right footsteps sequentially, place one footstep, then press Q once before placing the next one.

4. Move and rotate footsteps until you have achieved the desired pattern.

5. Click Create Keys For Inactive Footsteps.

6. Click Play Animation to see the animation.
To append footsteps onto the existing footsteps:

1. Make sure Footstep Mode is turned on.

2. If the existing footsteps are active, deactivate them first. Select all footsteps and click Deactivate Footsteps.

3. Click Create Footsteps (append).

4. Click in a viewport to create a footstep. Move the cursor and continue clicking to create more footsteps.

   **TIP** A Top viewport is usually best when you create footsteps individually.

5. Move and rotate footsteps until you have achieved the desired pattern.

6. Click Create Keys For Inactive Footsteps.

7. Click Play Animation to see the animation.

To create footsteps using AutoGrid:

The AutoGrid feature creates objects on a surface other than the default construction plane. You can use this feature to place footsteps on an irregular surface.

1. Using any 3ds Max modeling method, create a surface as the terrain for the biped to step on.

2. On Create panel > Systems, click Biped. In the Object Type rollout, turn on AutoGrid.

3. If you already have a biped to use, return to the Motion panel without creating a biped. If you need a biped, create the biped at this time, then access the Motion panel.

4. Turn on Footstep Mode.

5. Click Create Footsteps (at current frame). Move the cursor over the terrain. A transform gizmo moves with your cursor to indicate the location.
and orientation of the gizmo. Click to place a footstep, then move the
cursor and click again to place more footsteps.

6 When you have finished placing footsteps, click Create Keys For
Inactive Footsteps.
Keys have now been created for the footsteps.

7 Click Play Animation to see the animation.
The biped steps on the terrain, following the footsteps.

Activating Footsteps

When footsteps are created, they are inactive. To make the biped move
through the footsteps, you must activate them by clicking Create Keys for
Inactive Footsteps on the Footstep Operations rollout on page 4778.

When you activate footsteps, keys are created for the biped’s legs and feet,
causing the biped to step through the footsteps. In addition, keys are created
for the spine, arms, hips, and tail (if the biped has one) to make the biped
move naturally through the footsteps. Keys are not created for the head,
ponytails or props.

When keys are created for footsteps, a generic type of motion is generated for
the biped’s body based on footstep placement and timing. This movement is
intended as a starting point for your own animation, not as a final setup.

There are times when it is appropriate to deactivate footsteps, make changes,
and activate footsteps again. See Deactivating Footsteps on page 4532.

See also:
■ Creating Footsteps Automatically on page 4526
■ Creating Footsteps Manually on page 4527
Procedures

To activate footsteps:

1. While in Footstep mode, create footsteps using the automatic or manual method.

2. Move, rotate, delete and edit footsteps as desired.

3. Click Create Keys for Inactive Footsteps in the Footstep Operations rollout.

4. Click Play Animation to see the animation.

Deactivating Footsteps

When you change the position or timing of active footsteps, the biped's animation changes accordingly, causing the biped to step into the footsteps in their new positions with the new timing.

Deactivating footsteps temporarily suspends changes to animation when footsteps are changed. When you move deactivated footsteps or change their timing, the biped still continues to do the same motion it did before footsteps were deactivated.

Footsteps should be deactivated when you make substantial changes to footstep timing or placement.

Footsteps are deactivated by selecting footsteps and clicking Deactivate Footsteps in the Footstep Operations rollout on page 4778.

After making changes to the footsteps, click Create Keys for Inactive Footsteps in the Footstep Operations rollout on page 4778. This will recreate keys for the biped and cause it to follow the footsteps.

Active footsteps are pale in color, while inactive footsteps are brightly colored. This coloring appears both on footstep icons in viewports and on footstep keys in the Dope Sheet.
NOTE  Deactivating and reactivating footsteps causes all biped keys to be replaced with default animation keys for the current footstep pattern and timing.

When to Deactivate Footsteps

There are many situations where you will want or need to deactivate footsteps after activating them.

■ When you move or rotate active footsteps substantially, you might find that the original keys generated are no longer appropriate for your animation. If this happens, deactivate footsteps, move the footsteps into the correct locations, and activate footsteps again.

■ When changing footstep timing in the Curve Editor's Dope Sheet mode, you might receive an error message stating that what you are trying to do violates one of the rules of biped key placement. If this occurs, deactivate footsteps, make timing changes in the Dope Sheet, then activate footsteps again.

■ If you have a large number of active footsteps in the scene, moving footsteps and making timing changes can cause delays as all keys are adapted and updated. You might find your work is faster if you deactivate footsteps while making your changes.

■ If you have activated footsteps then changed the default animation, then find you want to return to the default animation, you can deactivate footsteps and activate them again to recreate the default animation.

Activation/Deactivation Workflow

The fastest workflow with footsteps is to deactivate footsteps and make changes, reactivate footsteps and play the animation to check your work, and repeat this process until the footstep timing and placement are correct. However, deactivating and reactivating footsteps replaces any biped keys with the default animation for the current footstep pattern and timing.

For this reason, it is recommended that you work with footsteps exclusively first, ignoring the upper body animation, and deactivate and reactivate footsteps as needed. When the motion of the feet is perfect or near-perfect, only then should you adjust the biped animation manually. Otherwise, you will lose all your manual animation work every time you deactivate and reactivate footsteps.
TIP Alternatively, you can use layers on page 4741 to store any upper body animations you want to preserve while you proceed with changes in your biped's footsteps.

Rules for Inactive Footsteps

When you click deactivate footsteps, only selected footsteps are deactivated. If you haven’t made any changes to the default animation, it is recommended that you deactivate all footsteps. However, if you’ve changed or added animation keys to part of the animation, you might want to deactivate only a portion of the footsteps.

When some but not all footsteps are currently deactivated, limitations are imposed on the changes you can make to footsteps:

- You cannot set, delete, move, or edit keys in any way; footstep tracks are disabled in the Dope Sheet.
- You can create footsteps only when the new footsteps are among and adjacent to existing inactive footsteps.
- You can delete only inactive footsteps, and at least one inactive footstep must remain.
- You cannot deactivate a set of nonsequential footsteps.

See also:

- Activating Footsteps on page 4531

Procedures

To deactivate footsteps:

1. Select the footsteps to deactivate.
   The footsteps you select must be in sequence; you cannot deactivate a nonsequential set of footsteps.

2. Click Deactivate Selected Footsteps in the Footstep Operations rollout.
   The footsteps are deactivated. Viewports and the Dope Sheet display them in bright colors again.
Understanding Footstep and Body Keys

When you activate footsteps, keys are created for biped body parts. Before you work with footstep placement and timing, it’s essential that you understand the default keys generated and how they relate to footstep editing.

Leg States

A leg moving through a footstep has four states, beginning with the foot on the ground. Then the foot lifts, moves through the air, and returns to the ground again. These leg states are labeled by character studio to help you work with footsteps and leg/foot keys more easily when editing footsteps.

These states are referred to in these topics to aid in understanding more advanced footstep concepts, so it’s important that you become familiar with them.

- **Touch** occurs at the leg keyframe where the foot first touches the footstep, and always corresponds with the start frame of a footstep in Track View. The Touch state is always one frame long.

- **Plant** occurs after touching, and before lifting. It is always in between the start and end frames of a footstep in Track View. The Plant state is usually more than one frame long.

- **Lift** occurs at the keyframe where the foot lifts off the ground, and always corresponds with the end frame of a footstep in Track View. The Lift state is always one frame long.

- **Move** occurs while the foot is in the air, and is always in the intervals between footsteps in Track View. In walking, while one foot moves, the body is supported by the other leg. In running or jumping, there are periods where the body is not supported and moves in midair.

For more information on these keys, see Editing Footstep Timing on page 4538.

You can display the current state of each leg by turning on Leg States in Biped rollout > Display group. The state name appears in viewports near the foot, corresponding to the state at the current frame.

**NOTE** State names appear only on footsteps that have been previously activated. If active footsteps have been deactivated and edited, the state names that appear will correspond to states the legs were in before deactivation. For this reason, leg states displayed between deactivation and reactivation might not be accurate.
Regardless of the footstep pattern, activating footsteps will always cause leg keys to be generated at each lift and touch frame. Although you can alter these keys to some degree by going to a touch or lift keyframe, turning on Auto Key and changing the leg positions or rotations, you cannot delete these keys.

To change the foot/leg animation after footsteps are activated, see Animating Legs and Feet on page 4546 and Adjusting Body Keys in Track View on page 4549.

**Body Keys**

When footsteps are activated, keys are also generated for the center of mass (COM) object, the blue tetrahedron at the center of the biped’s pelvis. The position and rotation of the COM determines the horizontal and vertical position of the biped body, as well as its rotation.

Unlike other biped parts or 3ds Max objects, the COM has three separate animation tracks, two for motion and one for rotation. You select these tracks by clicking the appropriate button on the Track Selection rollout on page 4686:

- **Body Horizontal**
- **Body Vertical**
- **Body Rotation** (displays keys for the Body Turning track)

Keys for these tracks are generated automatically when you activate footsteps. You can view the keys for each track on the Track Bar by turning off Footstep Mode and clicking the corresponding button listed above. These tracks are also visible in Track View’s Dope Sheet mode.

**NOTE** When you select the COM, only the keys corresponding to the selected track are displayed. If you select the COM and do not select a track, no keys are displayed on the Track Bar, even if the COM is animated. You can find out which COM track is selected by checking the status of the buttons displayed above. When a button is turned on, the track is selected.

You can animate the COM or change existing keys after footsteps are activated. To change COM keys after footsteps are activated, see Animating the Upper Body on page 4547 and Adjusting Body Keys in Track View on page 4549.
Editing Footstep Motion

The topics in this section deal with the editing of footstep motion when animating bipeds.

Editing Footstep Placement

After you've created footsteps, there are several ways to edit their placement in the scene.

■ You can use standard 3ds Max controls to select, move, rotate, or delete footsteps.

**NOTE** The 3ds Max scale transform will not scale the footstep icons themselves; the size of the icons is set by the size of the biped's feet. The biped foot size is originally set by the biped's height, then later by any scaling you perform on the feet in Figure Mode. See Posing the Biped on page 4496.

■ You can use the Bend and Scale controls in the Footstep Operations Rollout on page 4778 to edit the footsteps. The Bend value curves a selection of footsteps, while Scale changes the distance between selected footsteps.

Selecting Footsteps

To change footstep placement, you must first select the footsteps to change.

When Footstep Mode is turned on, footsteps can be selected with the same methods used to select 3ds Max objects:

■ Click footstep icons while holding down the Ctrl key.

■ Click and drag to draw a bounding box around footsteps you want to select.

■ Unselect footsteps by holding down the Alt key and clicking footsteps.

You can also select footsteps in Track View's Dope Sheet mode. See Editing Footstep Timing on page 4538.
Biped Key Adaptation

When you move, rotate, delete, bend, or scale active footsteps, **character studio** automatically alters biped keys to account for changes in balance and motion. This change is called **adaptation** on page 8498. For information on how adaptation occurs, see Editing Active Footsteps on page 4542.

Editing Footstep Timing

You can edit footstep timing in Track View.

Footstep keys have their own display in Track View's Dope Sheet mode. Footstep keys are displayed as blocks of color, each indicating a period of time when one of the biped's feet is in a footstep.

Footsteps in Track View

The footstep key colors match the colors of footstep icons in viewports. Just as with footstep icons, inactive footsteps are brightly colored, while active footsteps are displayed with pale colors.

The footstep key display relates directly to the different **states** on page 4535 the leg and foot can be in at any given time. The left edge of each footstep key indicates the foot is in the Touch state, while the right edge indicates the Lift state. The duration of the footstep key between Touch and Lift indicates the time the foot is in the Plant state. The space between footstep keys indicates a time when the foot is completely out of a footstep, a Move state.
You can change footstep timing in Track View by:

- Moving footstep keys to an earlier or later time.
- Moving footstep keys to change the time relationships between footsteps.
- Changing the lengths of footstep keys.
-Deleting footstep keys.

You must select footstep keys before you can change their timing.

**Selecting Footsteps for Time Editing**

Selecting footstep keys is the same as selecting footstep icons; when one is selected, the other is selected as well. Footstep keys can be selected in a number of ways for editing in Track View.

**NOTE** To select footsteps, you must have Footstep Mode turned on.

- Select footsteps in viewports as you would any 3ds Max object. Click a footstep to select it, and hold down the Ctrl key and click additional footsteps to select them. You can also draw a selection box around footsteps to select them.

Selecting footsteps also selects the footsteps in Track View. A selected footstep in Track View has a white border and a dot on both the left and right edges of the footstep key.

- Click the center of a footstep key in Track View to select it. Hold down the Ctrl key and click the center of additional footstep keys to select multiple footsteps.

- To select several footsteps at once, draw a selection box around the footstep keys in Track View.

- You can also select one edge of a footstep key by clicking the left or right edge in Track View. A single white dot appears at the selected edge. You
can change the duration of the footstep by increasing or decreasing the length of the key on the selected edge.

To select an edge, right-click the footstep track in Track View to display the Footstep Mode dialog on page 4797. Select one or more footstep keys, and use the controls in the Footstep Edge Selection group to select an edge.

**Editing Footstep Timing**

Editing the timing of footsteps is a simple matter of moving selected footsteps or selected edges in time.

Moving an entire footstep changes the time at which it starts and ends, but not its duration. Moving a footstep edge changes the duration of the footstep.

**Restrictions on Footstep Time Editing**

The timing for both active and inactive footsteps can be changed. Editing timing for active footsteps also changes keys for the center of mass and leg keys, but not the spine, arm or tail keys. This can cause the resulting animation to look different from the way you intended. For this reason, you might prefer to deactivate footsteps before editing timing. See Deactivating Footsteps on page 4532.

When editing footstep timing in Track View, the following limitations apply to both inactive and active footsteps:

- There must be at least one frame between footstep keys for the same foot.
- Footstep keys cannot start in negative frames.
- Every footstep must be at least two frames long.
- If you want to add footstep keys, use the tools on the Footstep Creation rollout. See Creating Footsteps Automatically on page 4526 and Creating Footsteps Manually on page 4527.
- Footsteps cannot be cloned.
To scale time of footsteps and body keys together, you can use Scale Time on the Track View toolbar.

**WARNING** Do not use the Re-scale Time option in the Time Configuration dialog to scale an animation that contains active footsteps. If you do so, biped keys might not adapt appropriately. Instead, use Scale Time on the Track View toolbar.

If you attempt to perform an illegal footstep timing change in Track View, an error message appears and the footstep timing pattern returns to the state it was in before you made edits.

**See also:**

- Adjusting Body Keys in Track View on page 4549

**Procedures**

**To display footstep keys in Track View:**

1. Choose Graph Editors menu > Track View - Dope Sheet.
2. If necessary, expand the Objects listing to display footstep keys.

**To move selected footsteps in time:**

- In Track View, drag any selected footstep key to drag all selected footstep keys in time.

**To change the duration of a footstep:**

1. In Track View, click the left or right edge of a footstep key.
   
   In addition to a white border, a small white dot appears to indicate the edge is selected.

2. Drag the selected edge to make the footstep key longer or shorter.

   You can adjust a selection of multiple footsteps this way.

   You can also adjust any combination of left edge, right edge, and center selections. Dragging in Track View adjusts any combination of edge or center selection.
To change the display of numbers of footstep keys:

1. In Track View, right-click the footstep track to display the Footstep Mode Dialog on page 4797.
2. Choose the values to display from the Footstep Number Display group.

To scale keys in time:

1. On the Track View toolbar, click Scale Time.
2. In the Track View window, click and drag to indicate the beginning and end of the time period you want to scale. 
3. Move the cursor over the selection region until a scale cursor appears. Drag to the left to reduce time, or drag to the right to increase time.

**Editing Active Footsteps**

One of the most powerful features of footsteps is the ability to adapt keyframes automatically to edits you make to your footstep pattern. By analogy, the footsteps become a kind of gizmo for manipulating the keyframes of your character’s animation. In most cases, edits you make to footsteps act upon your keys in an intuitive fashion.

In order to understand what happens when active footsteps are edited, you must first understand what happens to biped keys when footsteps are activated. See Understanding Footstep and Body Keys on page 4535.

**Key Adaptation for Footstep Placement Edits**

When you move or rotate active footsteps as described in Editing Footstep Placement on page 4537, the biped’s keys are immediately influenced by the edit. The following keyframe tracks are influenced in the vicinity of the edited footsteps:

- Body Horizontal keys change to step or hop within range of new footstep locations
- Body Vertical keys change to match possible changes in stride length, since the center of mass must move lower to step longer distances
- Body Turning (Body Rotation) keys change to bank into turns created by changes in path curvature or body speed
Right or left leg keys in a Move state (when the leg is not in a footstep) are adapted to step between new locations.

Other keys are preserved in the adaptation process. For example, if you animate the body to kneel while turned to the right, altering a nearby footstep will maintain the biped's height and turning motion as much as possible.

**Key Adaptation for Footstep Timing Edits**

To edit active footsteps in time, follow the methods described in Editing Footstep Timing on page 4538. Keyframes affected by the edit are updated immediately.

A fundamental factor in how your keyframes are adapted is whether the sequence of leg support transitions has changed. Changing the relationship between opposite leg keys effectively changes the gait, which causes entirely new keyframes to be generated at that point.

- If you move footstep keys in such a way that you remove an overlap or create a new overlap between opposite legs, you have changed the gait, and new keys will be generated for legs.
- If you do not change the overlap relationship between opposite legs, existing legs keys are retained.

**WARNING** Editing a jumping sequence so that the feet hit or leave the ground slightly out of phase rather than at the same time introduces a change in the leg support sequence. Hence, even in this case, the leg keys will be locally replaced with default keys.

**NOTE** If you scale the biped's feet in Figure mode after activating footsteps, then turn off Figure mode, character studio will recalculate the footstep display size and the footstep dynamics automatically.

**Locking Keys**

You can lock specified tracks to prevent them from adapting automatically when you move active footsteps. The controls in the Footstep Adapt Locks group on the Dynamics & Adaptation rollout on page 4755 lock specified tracks.
Procedures

To prevent keys from changing when active footsteps are edited:

1. On the Motion panel, on the Dynamics & Adaptation rollout, in the Footstep Adapt Locks group, select the types of keys you want to lock.

2. Move, rotate, scale, or bend active footsteps.
   The tracks you lock are unaffected by footstep editing.

Splicing Footsteps

You can copy the motion of a biped footstep sequence, and paste it either at the end or into the middle of another footstep sequence. This technique is called splicing on page 8729.

You can use splicing to build an extended, or cyclic, motion sequence out of shorter sequences. You can also copy footsteps from one biped and paste them onto another biped with this technique.

Splicing footsteps makes use of a footstep buffer to store footstep positions and keys. The buffer is a temporary area in memory where footsteps are stored.

TIP Use motion splicing when you want to edit segments of a single footstep-based animation. To build longer animations by connecting finished BIP files, use Motion Flow on page 4848 or the Motion Mixer on page 4002.

See also:

- Footstep Operations Rollout on page 4778

Procedures

To copy footsteps to the buffer:

1. Turn on Footstep mode.

2. Select a series of footsteps.

3. In the Footsteps Operations rollout, click Copy Footsteps.
To edit the footstep buffer:

You can edit the footstep buffer only when footsteps have been copied to the buffer, as described in the previous procedure.

1. On the Biped rollout > Modes group, click Buffer Mode. This button is active only when there are footsteps in the buffer.
   The viewports now display the footsteps in the footstep buffer, rather than the footsteps in the currently activated footstep sequence.

2. Edit footsteps or motion keys as you normally would – by moving and rotating footsteps, or turning on Auto Key and moving and rotating parts of the biped skeleton.

   **NOTE** You can’t splice (copy and paste) footsteps while in Buffer mode.

   If you load a BIP file by clicking Load File on the Biped rollout while Buffer mode is active, the footstep buffer is replaced with the motion in the BIP file.

3. Click Buffer Mode to turn it off.
   Now you can splice the edited buffer by pasting footsteps.

To splice the footstep buffer:

1. Click Paste Footsteps on the Footstep Operations rollout.
   The footsteps from the buffer appear in their saturated colors.

2. Use Select and Move from the 3ds Max toolbar to position the first pasted footstep at the point where you want to splice. When you move the first pasted footstep over an activated footstep of the same side, right or left, the activated footstep turns red to indicate splicing is possible.
   This step is usually easiest to do in a Top viewport.

   **NOTE** If you deselect the pasted footsteps by clicking elsewhere in a viewport, no paste occurs and the pasting process ends.

3. When you have moved the buffer footsteps to the desired location, release the mouse.
The contents of the footstep buffer are placed over the active footsteps. The first footstep in the buffer replaces the footstep that turned red, and the rest of the buffer footsteps follow.

4 The footstep that turned red and the remaining original footsteps now appear in the viewports. They will be near the activated footsteps, in their saturated colors. They can now be moved and pasted onto the end of the spliced motion, which will, in effect, perform an insert of the buffer motion. The red footstep and following footsteps can also be pasted anywhere in the footstep sequence. If you pasted onto the last footstep, this step does not occur.

If you don’t want to append the leftover footsteps, simply click anywhere in the viewport to dismiss them.

**WARNING** If any footstep in the buffer overlaps in time with a footstep previous to the one onto that you are pasting, a message appears and the paste will not be performed.

**TIP** To create a cycle of a motion with alternating footsteps, you must copy and paste at least three footsteps.

### Animating Legs and Feet

When you activate footsteps, keys are created for the legs and feet according to the footstep pattern and timing. Leg and foot keys are set at each Touch and Lift frame, and between footsteps.

Although the parts of the leg (thigh, calf, foot, toes) can move and rotate separately, one key dot appears on the Track Bar and in Track View for each leg structure unless you have turned on separate tracks in the Keyframing Tools rollout on page 4717.

When the foot is not in a footstep, you can move or delete keyframes, and animate or reposition any part of the leg or foot. Simply turn on Auto Key and move or rotate the leg or foot to its new position.

**Animating Legs and Feet in Footsteps**

The leg keys created at either end of each footstep are *locked*, meaning they cannot be moved or deleted. You can, however, change the animation at these frames, or add new keyframes within the timespan of the footstep key.
When the foot is in a footstep, you can animate or reposition the leg and foot to some degree:

- You can rotate the foot around its pivot point within the footstep.
- You can animate the pivot point with the Select Pivot option in Key Info rollout > IK bar. See Animating Pivots on page 4610.
- You cannot move a foot out of a footstep. If you do not want the foot to be in the footstep at a particular frame, change the timespan of the footstep key so it does not include that frame. See Editing Footstep Timing on page 4538.

### Animating the Upper Body

When you use footsteps to animate the legs and feet, animating the spine, neck, head, arms, and other upper body parts is accomplished in the same way as for freeform animation. Simply turn on Auto Key and start moving and rotating body parts. See Animating by Moving Links on page 4578 and Animating by Rotating Links on page 4581.

You can also click the Set Key button on the Key Info rollout on page 4704 to set keys for selected body parts at the current frame. This option allows you to move body parts as you like, setting keys only when you have decided to do so.

**WARNING** Do not use the 3ds Max Set Key button to set keys for the biped.

Animation on the center of mass (COM) works differently, depending on whether the biped is in a footstep at that particular frame.

- If at least one foot is in a footstep, moving or rotating the COM will animate the entire body along with the COM, except a foot that is in a footstep. A foot in a footstep will stay planted in the footstep and the leg will bend or straighten as the COM is moved up or down.

- If the biped is airborne (no footsteps at that frame), the COM can be moved horizontally and can be rotated, but cannot be moved vertically. This is because character studio automatically calculates how high the biped can go based on the biped's height and the current gravity setting. To make
the biped jump higher or lower during airborne periods, see Freeform Animation Between Footsteps on page 4565.

**Working with Existing Keys**

Because keys are created for the spine, arms, and tail when footsteps are activated, you will want to take care when creating new keyframes. As with 3ds Max animation, placing keyframes one or two frames apart creates jerking or popping motions.

To avoid placing keyframes on upper body parts too close together, you can do one of the following:

- Turn on the 3ds Max Key Mode toggle, select the body part, and use Next Key and Previous Key to move in time from one keyframe to another. Animate only on existing keyframes.
- Delete all the body part keys except the key at frame 0, and create entirely new keys throughout the animation.

**WARNING** If you delete all keys, including the key at frame 0, be sure to set a key at frame 0 before animating on other frames. character studio does not automatically place a key at frame 0 when you animate on frames other than 0, as 3ds Max does.

**Interdependencies Between Legs and Upper Body**

When footstep animation is used, animation of the upper body and animation of the legs are interdependent. Any time you change the position of the body’s center of mass, leg positions are automatically updated to ensure the feet still move from footstep to footstep.

Interdependencies between the upper body and legs are updated after a key has been set, sometimes causing the appearance of a pop in the leg position. However, in playing the animation you will find the motion to be smooth.

When you set a leg key while the foot is on the ground, the location of the foot is automatically recalculated based on the natural roll of the foot from its point of initial contact with the ground. The pivot points are based on collisions between the footstep plane, the two corners of the heel, and the bones that connect the toes’ links.
This ability to preserve interdependent relationships allows you easily to experiment and improvise with motion, since you are assured that edits to one body part will not corrupt the integrity of other parts.

In general, changes to the center of mass, spine, and pelvis cause the legs to adjust. Changes to the legs do not affect the center of mass's vertical position.

### Adjusting Body Keys in Track View

When you activate footsteps, keys are created for biped body parts. After activating footsteps, you can also create keys by turning on Auto Key and animating body parts. All these keys can be viewed in Track View – Dope Sheet mode.

In general, editing biped body keys in Track View is the same as editing keys of any sort in 3ds Max, with a few restrictions.

Before reading this section, please read Understanding Footstep and Body Keys on page 4535 for terms and definitions used in this section.

**NOTE** The information in this section applies only to biped body keys for the arms, legs, spine, neck, and other parts of the upper body. For rules for editing footstep keys, see Editing Footstep Timing on page 4538.

#### Locked Keys

Some biped keys are locked, meaning they cannot be moved in time. Locked keys are colored red in Track View.

Locked keys for the COM Body Vertical track are created at each footstep's lift and touch frames. These are the only keys that are locked. These keys can be moved in time by changing footstep duration in Track View.

Although you cannot move or delete a locked key in Track View, you can sometimes change the animation on the frame by going to the frame, turning on Auto Key and manually animating the key.

#### Restrictions on Biped Body Key Editing

All options available for editing biped body key timing are available only when Edit Keys on the Track View toolbar is turned on.
The following rules apply to the editing biped body key timing in Track View:

- You cannot move existing keys outside the area between the first and last footsteps, or to negative frames.
- You can use Add Keys to add keys to any biped body track. You cannot add keys outside the area between the first and last footsteps, or to negative frames.
- You can clone keys the same way you clone 3ds Max object keys, by selecting keys and holding down Shift as you drag them. You can also clone keys by copying and pasting postures. See Copying and Pasting Postures and Poses on page 4619.
- The Track View – Curve Editor can be used to view and edit curves showing the interpolation between body keys. You can also use the Workbench to analyze, edit and fix biped motion curves. See Working with the Workbench on page 4816.
- You can use Scale Keys to scale selected keys, except for locked keys.

**TIP** If you want to animate a biped performing movements with its upper body while standing, extend the length of the standing footsteps to cover the length of the standing animation, then add keys for the upper body.

See also:

- Animating the Upper Body on page 4547

**Shifting the Biped’s Balance**

After footsteps are activated, you can adjust the biped’s overall balance. There are two ways to adjust the biped’s balance:

- In the Biped rollout on page 4669, turn on Rubber Band Mode and move the biped’s COM, or
- Change or animate the Balance Factor parameter in the Key Info rollout on page 4704.
Rubber-Banding the COM

When Rubber Band mode is active, you can move the biped’s center of mass in relation to the rest of the body, changing the biped’s overall balance.
Rubber-banding the center of mass defines your character’s balance point in at-rest pose and in any resulting motion.

When a character is standing at rest, with feet side by side, the center of mass should be directly above the area where the feet touch the ground. The center of mass determines the center of your character’s distribution of weight. For most characters, the physical center of mass is located near the pelvis.

Typical placements for the center of mass are:

- Characters that stand erect, such as humanoids, use the default location of the center of mass within the pelvis.
- Characters that naturally lean forward, such as some dinosaurs and birds, should have the center of mass moved slightly forward of the pelvis. This is also good for robots and droid soldiers.
- Characters that are holding a heavy weight out in front of them, or overweight characters, might need their center of mass moved slightly forward of the pelvis.
- Characters that are pushing or pulling objects might need their center of mass moved slightly behind the pelvis.

**NOTE** If you place the center of mass too far in front of the pelvis, the character unnaturally compensates for balance. As each step is taken, the legs and body move in an awkward fashion, as if there was an invisible weight attached to the front of the character.
Center of mass moved behind the biped in rubber-band mode
Center of mass moved in front of the biped in rubber-band mode

For a tutorial that uses this technique, see “Creating the Illusion of Weight”.

**Balance Factor**

The balance factor on page 8516 is an animatable parameter that determines how the biped's hips and spine will compensate when the biped bends forward or backward.
The balance factor determines the degree and direction in which the head and/or hips swing out from their original vertical alignments when the biped bends over.

Results when balance factor is set to 0.0, 1.0 and 2.0 before the spine is animated to make the biped bend over.

The Balance Factor parameter can have any value from 0 to 2:

- When Balance Factor is 1 (the default value) and you rotate the spine forward, both the hips and head swing out from their original vertical alignment to a similar degree to compensate for the shift in weight. This value is suitable for times when the biped leans forward while standing.

- When Balance Factor is 0 and you rotate the spine forward, the COM keeps its original vertical alignment, and the head swings forward. There is no movement in the hips to compensate for the shift in body weight. This setting is good for animating a sitting biped who leans forward, to prevent its hips from shifting backward. It can also work well for characters with tails; the tail provides weight in back of the biped, so the hips don’t have to shift backward to compensate when the character bends over.

- When Balance Factor is 2 and you rotate the spine forward, the head retains its original vertical alignment while the COM swings backward. The hips compensate strongly for the shift in body weight. This setting can be useful for violent or acrobatic motions.
In order to affect the animation, the balance factor must be set before you animate the biped. The balance factor can be animated to give the biped different reactions to bending motions over the course of the animation.

The Balance Factor parameter appears in the Key Info rollout > Body section.

**Procedures**

To set the balance factor:

1. On the Motion panel, turn off Footstep Mode if it is turned on.
   **NOTE** The Key Info rollout is accessible only when Footstep Mode is turned off.

2. Expand the Body bar on the Key Info rollout.

3. Go to the frame where you want to set the Balance Factor.

4. Click Body Horizontal to select this track on page 8744.

5. If no Body Horizontal key exists at the frame where you want to set the Balance Factor, create one by clicking Set Key in the Key Info rollout.

6. Change the Balance Factor parameter. There is no need to click Set Key again after setting the Balance Factor parameter.

7. Rotate the biped's spine. The biped's hips and/or head shift position based on the Balance Factor value.

**Adjusting Vertical Motion**

A *ballistic gait* is any footstep pattern in which there are periods with no feet on the ground, causing the biped to become airborne, or *ballistic*. Running and jumping are ballistic gaits, while walking is not.

When Biped Dynamics is turned on in the Dynamics & Adaptation rollout on page 4755 and you activate footsteps, the Body Vertical keys that are automatically generated during a ballistic gait period will take gravity and
landing speed into account. The parameters described in this section affect Body Vertical keys created in this manner.

**Airborne Dynamics**

With footsteps, each airborne period always begins and ends with Body Horizontal and Body Vertical keys. These keys define the position of the biped at lift-off and touchdown.

When the biped is airborne and Biped Dynamics is turned on, the vertical motion is governed by physically based dynamics. Its airborne trajectory is based on the current gravity setting, the height of the Body Vertical key at lift-off and touchdown, and the amount of time in the air.

By default, there is no Body Vertical key at the peak of the biped's trajectory; the biped's peak airborne height is calculated and enforced automatically. You cannot, for example, set a Body Vertical key at the peak of an airborne trajectory and move the biped up or down. If you attempt to do so, the biped will snap back to its original airborne height. Although this will cause a Body Vertical key on page 4535 to appear on the Track Bar and in Track View, the key will have no effect on the biped's airborne height.

**Gravity and Timing**

In reality, the length of time a person, animal or insect stays in the air during a jump is based on two factors:

- How high the creature jumps, which in turn is based on how hard the creature pushes with its legs at the start of the jump. The creature's weight has no bearing on the height of the jump, except to affect its ability to give a good push at the start. A very light character might be taken by the wind and thus stay in the air longer, but that circumstance is not part of the gravitational equation.

- The gravitational pull of the planet from which the creature jumps.

From these two factors, you can calculate how long the creature will stay in the air. You can also perform this calculation backward; if you know how long the creature was in the air and the gravitational equation for the planet, you can figure out how high it jumped.
Jump height increases with time in air

**character studio** uses the latter method for calculating the height of a biped's jump. It knows from footstep timing how long the biped will be in the air, and it has a method for determining the “gravitational pull” in your scene.

The default gravity setting in **character studio** is based on the standard equation for calculating the Earth’s gravitational pull, which is an acceleration of approximately 32 feet/sec/sec. Because this equation depends on an accurate measure of distance, the biped's height is used as a guide to actual distances in the scene. For the purpose of gravitational computation, the biped is considered to be about 5’10” tall, the average height for a male human being.

Of course, some of your characters will not be the same height as the average man, so airborne periods between footsteps for these characters will appear inaccurate, with the biped jumping too high or too low for your purposes.
There are two solutions to this problem. You can change the amount of time the character is airborne between footsteps (see Editing Footstep Timing on page 4538), or you can accelerate gravity with the GravAccel parameter.

**Accelerating Gravity**

The GravAccel parameter on the Dynamics & Adaptation rollout on page 4755 alters the degree of gravitational pull imposed on the biped during its airborne periods between active footsteps.

The GravAccel default value is based on the standard calculation for the Earth's gravity and its effects on a man of average height. When the GravAccel parameter is increased, the effects of gravity are decreased, and the biped jumps higher. The GravAccel parameter can be set separately for each biped in the scene.
GravAccel values increase height of jump.
(Left=500, Middle=1000, Right=1500).

You can change GravAccel at any time during the animation process to affect the biped's vertical airborne motion, both for keys already created and for animation not yet created. This value cannot be animated; the current GravAccel value is used throughout the biped's footstep sequence.

Changes to the GravAccel parameter have no effect whatsoever on the amount of time the biped spends in the air.

**TIP** If you want to change GravAccel back to its default value but don't remember what that was, you can find out by creating another biped of the same height and noting its GravAccel value.
NOTE If there is not enough gravitational acceleration or time in the air to account for differences in vertical height (such as a biped falling from footsteps on a ledge in slow motion), the biped is placed on the ground at the touchdown frame, causing a discontinuity. You can fix this by either increasing GravAccel or increasing the amount of time between footsteps in Track View. See Editing Footstep Timing on page 4538.

Touch and Lift Dynamics

When footsteps are activated for a footstep pattern that includes airborne periods, Body Vertical keys are set at each Touch and Lift keyframe.

Based on the time in the air and the biped's height, character studio calculates the height to which the biped will jump. From this, character studio figures out how hard the biped's legs would have to push at the Lift frame to reach this height, and how much the legs would have to bend to absorb the force of the landing at the Touch frame. Body Vertical keys are set at the Lift and Touch frames accordingly.

You can adjust the timing of touch and lift dynamics by:

■ Changing Body Vertical keys at the Touch and Lift frames.
■ Setting, changing or deleting Body Vertical keys during a footstep.
■ Changing the stiffness or springiness of the biped's legs at Touch and Lift frames with the Ballistic Tension parameter.

Ballistic Tension

Ballistic tension refers to the stiffness or springiness of the biped's landing at the end of a jump, or takeoff at the start of a jump. The Ballistic Tension parameter on page 4704 changes the biped's motion only when it is set for footsteps immediately preceding or following an airborne period.

You can edit the Ballistic Tension parameter only at Body Vertical keyframes where the body touches down (a Touch key) or lifts off (a Lift key). On the Motion panel Track Selection rollout on page 4686, Body Vertical must be selected and a key must be present at the current frame. With footsteps, a Body Vertical key is always set automatically at the landing footstep's Touch frame and the takeoff footstep's Lift frame.

Ballistic Tension can range from 0 to 1, with 0.5 as the default value. Increasing Ballistic Tension to 1.0 makes the legs stiffer at takeoff or landing. Decreasing the tension to 0.0 makes the legs springier and less stiff.
Ballistic tension determines springiness of landing.
(Left = 0.0, Right = 1.0)

**Dynamics Blend**

The Dynamics Blend parameter in the Dynamics & Adaptation rollout on page 4755 determines whether biped dynamics or spline dynamics will be used during airborne periods.

With **biped dynamics** on page 8521, the height and trajectory of the biped during airborne periods is determined by gravity calculations and other biped-specific information.

With **spline dynamics** on page 8730, the airborne height and trajectory are not set for you automatically; you must set them manually with keyframes.
When Dynamics Blend is set to 1, biped dynamics are used. At 0, spline dynamics are used. You can animate this value to switch between the two during your animation.

**Procedures**

**To locate vertical center of mass keys:**

1. Select any part of the biped and access the Motion panel.
2. On the Track Selection rollout, click Body Vertical.
3. Use the Next Key and Previous Key buttons on the Key Info rollout to jump to the next or previous center of mass Body Vertical keyframes.

**TIP** If the selected vertical COM key is a touchdown key from an airborne period, you can change the Ballistic Tension parameter on the Key Info rollout to control knee bend. Turn on Trajectories on the Display rollout to view how changing parameters affects the trajectory.

**To set a Body Vertical key:**

1. On the Track Selection rollout, click Body Vertical.
2. Turn on Auto Key.
3. Click Select and Move on the main toolbar.
4. Click and drag the center of mass up or down in the viewports. The biped is repositioned vertically, a key is created in the center of mass Body Vertical track.

**To set ballistic tension:**

1. On the Biped rollout, turn off Footstep Mode if necessary.
2. In the Track Selection rollout, select the biped’s Body Vertical track.

3. Move to the Vertical track keyframe you want to adjust, either a Touch or Lift key. The Ballistic Tension parameter is available only on Touch and Lift keys.

4. In the Key Info rollout, expand the Body bar to access the Ballistic Tension parameter.

5. Adjust the Ballistic Tension value. Adjusting the ballistic tension changes the amount of crouch before a jump, and the amount of dampening that occurs after landing.

To change Dynamics Blend for multiple Body Vertical keys:

1. Choose Graphs Editors menu > Track View – Dope Sheet.

2. Select all the Body Vertical keys you want to change.

3. Right-click over one of the selected keys to display the TCB dialog.

4. Change the value of Dynamics Blend in the TCB dialog. This changes it for all selected keys.

**NOTE** This only affects the biped during airborne periods in a footstep animation. Changing Dynamics Blend keys in a walk motion does not affect the motion.

---

**Saving Footstep Animation**

After you have animated the biped with footsteps, you can save the data in either a BIP file or an STP file.

- A BIP file saves both the footsteps and any animation on the upper body. You can save the entire footstep sequence, or just a portion of it.

- An STP file saves just the footstep data. These files, in ASCII format, are sometimes used by game developers to save just the leg and foot motion data.
To save a either type of file, click Save File in the Biped rollout. Choose the desired file type from the Save as type pulldown.

For more detailed information on these file formats and how to work with them, see Loading and Saving BIP Animation on page 4638 and Loading and Saving STP Files on page 4646.

Footstep and Freeform Animation

character studio provides two distinct modes of animation, footstep and freeform.

Footstep animation on page 8584 was originally designed for bipedal characters, that is, characters that walk on two legs. It uses a structured system of dynamics and balance to create secondary motion in the upper body, including arm swinging and tail swaying that is automatically applied when footsteps are used. By using default footsteps, you are assured that the biped’s foot doesn’t slide or pass through the ground, and that the foot easily rolls from heel to the ball of the foot as is common in a typical walk.

Freeform animation on page 8584 provides a more traditional method of animating to those familiar with 3ds Max, or other character animation systems. Keys are set by using the character studio Set Key tools found in the Key Info rollout on page 4704, or by turning on Auto Key mode, moving the time slider and transforming the biped parts.

Freeform animation includes preset key types called planted, sliding, and free keys; these make it very quick to lock a biped’s foot or hand in space and get results similar to those of footstep animation.

You can add freeform animation to footstep animation during airborne periods, making it possible to use both footstep and freeform animation on the same biped.

Freeform animation is particularly useful for:

- Animating a character with more than two legs.
- Animating a biped switching between foot-based motion and freeform motion, such as a biped doing handstands, jumping into a swimming pool, or leaping up to begin flying through the air.
Freeform animation also provides animated pivot points on the feet and hands. This makes it possible for you to simulate the roll of a foot from heel to toe, or create detailed finger animation.

You can convert back and forth between footstep and freeform animation within some limitations. While it is easy to convert any footstep animation to freeform, there are limitations on the conversion from freeform animation to footsteps.

Because of these limitations, a common workflow is to use footstep animation to rough out the animation, then convert to freeform to finalize the motions. The totally freeform animation is not bound by the rules of the footstep method, so it's easy to do anything you want, such as add keys at the beginning or end of the clip.

See also:
- Footstep Animation on page 4515
- Freeform Animation on page 4571

Freeform Animation Between Footsteps

For certain types of footstep animation, it is necessary to suspend calculations of gravitational effects on the biped.

For example, if you want the biped to run, dive into a pool then climb out of the pool, you would create footsteps for the running and climbing portions of the animation but not the swimming portion. When you activate footsteps, the biped will become airborne during the swimming period, jumping high in the air between the running and climbing footsteps.

If you don’t suspend gravity during the airborne period, you won’t be able to change the biped's Body Vertical position to bring it down and place it in the pool. For more information on how the biped behaves during airborne periods between footsteps, see Adjusting Vertical Motion on page 4555.

To suspend gravity during an airborne period, you can create a freeform period in your animation. During a freeform period, you can animate the biped in freeform mode, which includes positioning the biped anywhere in the scene regardless of the length of the airborne period.

The Track View - Dope Sheet editor is used to insert a freeform period between footsteps. During a freeform period, vertical dynamics (gravitational effects) are suspended, and Body Vertical keys use spline dynamics on page 8730 instead.
See also:
- **Track View (Biped)** on page 4801

**Procedures**

To convert an airborne period to freeform mode:

1. Create a footstep animation with at least one airborne period, and activate the footsteps. For the simplest method of creating a footstep pattern with an airborne period, see **Creating Footsteps Automatically** on page 4526.

2. Access Track View by choosing Graph Editors menu > Track View - Dope Sheet from the 3ds Max menu.

3. Expand the footstep key display for the biped.

4. Right-click the footstep key display area. The Footstep Mode dialog appears.

5. In the Footstep Mode dialog, choose the Edit Free Form (no physics) option. In each airborne period in Track View, a hollow yellow box appears.
In the Track View footstep key display, click inside the yellow box for the airborne period for which you want to suspend gravity. This fills the yellow box, indicating that vertical dynamics are suspended for that period.

Play the animation. The biped uses vertical dynamics during all footstep motions except the freeform period.
No vertical dynamics during freeform period, then return to vertical dynamics during next airborne period.

**NOTE** If you activate footsteps after a freeform period has been set between footsteps, the biped might skip footsteps at one end of the freeform period. For this reason, you should activate footsteps before setting up a freeform period.

8 During the freeform period, animate the biped and set keyframes as you like.

To edit footstep timing after creating a freeform period, you must choose the Edit Footsteps option in the Footstep Mode dialog.
Converting Between Footstep and Freeform Animations

There might be times when you want to convert a footstep animation to a freeform animation, or vice versa. This can occur when someone gives you an animation file that's animated in one mode, while you prefer to work in the other.

Animators tend to develop a preference for either freeform or footstep animation. The ability to convert between the two means you can work in either format without concern for compatibility with other artists.

Using the Convert tool on the Motion panel > Biped rollout, you can convert between footstep and freeform animation.

There are no special considerations when converting from footsteps to freeform; this procedure works for all footstep sequences. However, to convert successfully from freeform to footstep animation, you must observe certain rules in order for footsteps to be generated.

Converting from Freeform to Footsteps

When converting from freeform to footsteps, footsteps are generated for a foot only during periods between two planted keys. In other words, the conversion process looks for times when a foot has two consecutive, identical keys with an IK Blend setting of 1 and Object space selected. In this case, a footstep icon is placed at the foot's location, with the duration of the footstep set by the time between the two identical keys. This is the only condition under which footsteps are generated.

If converting freeform animation to footsteps does not create the expected result, your freeform animation might need adjustment prior to conversion. See Using IK Keyframe Parameters on page 4598 for information on setting freeform planted keys.

If your freeform motion hasn't been prepared with planted keys for converting to footsteps, you can convert it to footsteps by loading it as a motion capture file and specifying footsteps as the extraction method. This technique uses a different method to determine footstep location and duration, and so can sometimes successfully convert to footsteps where the Convert command cannot. See Importing Motion-Capture Data on page 4918.
Procedures

To convert between footsteps and freeform animation:

1. On the Motion panel > Biped rollout, click Convert. Depending on which is the current animation method, either the Convert to Freeform dialog on page 4795 or the Convert to Footsteps dialog on page 4795 appears.

2. Change settings in the dialog as necessary, and click OK. If you're converting to freeform animation, the footstep patterns are removed from the viewport, gravity and dynamics are removed, and footstep mode is disabled. You are now working with a purely freeform animation. If you're converting to footsteps, and the operation is successful, footsteps appear in the viewport, biped dynamics on page 8521 is turned on, and Footstep mode is enabled.

Freeform Animation

While character studio calculates vertical dynamics and gravity based on its footstep-driven technology, you don't always want your character strictly under these controls. You might want the character to fly, swim, or to do something improbable in a physical world. For these situations, Biped supports a comprehensive set of freeform animation controls that allow you to take total creative control over your character's pose, movement, and timing.
Freeform animation of a biped swimming

**Character studio** gives you the option to animate characters using freeform mode exclusively, or to create freeform periods during a footstep animation. In freeform mode (without footsteps), you can pose every joint of your character exactly as you like using traditional keyframe methods. Hands and feet can be locked down in space by setting planted keys. You can also animate the pivot points for hands and feet to simulate rolling motion. You can blend dynamically between forward kinematics and inverse kinematics to introduce higher-level control.

To use freeform animation in Footstep mode, you create freeform periods between footsteps using Track View – Dope Sheet. You can convert an existing footstep animation into a freeform animation and back again. This lets you mix the use of footstep and freeform methods.

**WARNING** You can’t add a freeform period at the beginning or end of a footstep animation.

**TIP** If you want to do this, stretch out the timing for the first or last set of footsteps, then convert the footstep animation to freeform.

**Freeform Method**

A freeform animation contains no footsteps; instead it relies on the transforms of the biped body objects and center of mass. Use Freeform for motions like swimming or falling where footsteps are not necessary. If you are a familiar
with creating all of your keyframes manually to animate a character, you may want to use the freeform method exclusively.

To start a freeform animation, turn on Auto Key and start positioning the biped. You can also leave Auto Key off and use the red set key buttons on the Key Info rollout on page 4704 to create keyframes.

You can also create freeform animation by importing motion capture data and choosing freeform rather than footstep.

**TIP** Take advantage of both methods by combining footsteps and freeform animation. You can create a freeform period for any airborne period between footsteps. A freeform period replaces the ballistic motion calculated using the GravAccel value with a user defined spline motion.

If you are using footstep extraction with motion capture data, you often need a freeform interval to accommodate falling or tumbling motion in the data. The Fit to Existing option on the Motion Capture Conversion Parameters dialog allows for a combination of both methods. Extracting footsteps from motion capture files eliminates sliding feet, a common problem with motion capture data.

Note that while you can add a freeform period to a footstep animation, you cannot add a footstep period into a freeform animation. If you want to add a footstep animation to an existing freeform, you can use the motion flow editor to create a script that sequences the footstep with the freeform.

**Inverse Kinematics**

Footstep and freeform animations use the same inverse kinematics on page 8612 constraints and extensions. This means that in a footstep animation, you can now edit keys to change footstep duration. By definition, a footstep is the start and end of a sequence of IK constraints in World Space with an IK Blend value greater than 0. Deleting and inserting keys or changing IK space or IK blending alters footstep duration.

In cases involving edits that alter the length of ballistic intervals (when a biped is airborne), character studio ensures that there is a vertical key occurring at the lift-off and touchdown frames. This calculates the correct ballistic motion, so vertical keys are automatically inserted if not present.

There are three types of IK keys you can create: planted, sliding and free keys.

- **Planted keys** have an IK Blend of 1. They are joined to the Previous IK Key and are in Object space, rather than Body space. Planted keys lock the foot or hand to the ground, or to any object.
Sliding keys have moving IK constraints. Sliding footsteps are created if there is a moved IK constraint occurring in the footstep interval. In a footstep animation this means that the foot can be placed anywhere, even though there is a footstep icon. Footstep icons can be thought of as gizmos rather than the absolute location of a foot. Sliding keys have an IK blend of 1, and are in object space, but are not joined to the previous IK key.

Free keys have an IK blend of 0, and are in body space. They are not joined to the previous IK key. Free keys have no IK constraint.

IK constraints are implemented with a pivot-based system. This allows you to pivot a hand or foot around a selected pivot. For example, in a walking motion you can select a pivot on the heel of a foot and rotate the foot around it. You can then shift the pivot to the ball of the foot.

Procedures

To create a purely freeform animation:

1. Create a biped.
2. Move the time slider to any given frame then do one of the following:

   - Turn on Auto Key, then move or rotate any biped component. This sets a key for that component.
   - Pose any part of the biped, then in the Key Info rollout, click Set Key.
   - Pose the hands and feet and then in the Key Info rollout click Set Planted Key. This will create keys that cause the hands or feet to stick in space.

For more information on setting keys, see Setting Keys for Feet and Hands on page 4609.

NOTE character studio doesn't behave the same as 3ds Max when creating keys. It doesn't automatically create keys at frame 0 when you create your first set of keys at a later frame. For this reason, it's often useful to select all the parts of the biped at frame 0, then click Set Key to creating holding keys for all.
To create a freeform animation from a footstep animation:

1. Select the biped whose footstep animation you want to convert to freeform.

2. On the Motion panel Biped rollout, click Convert.
   A Convert To Freeform dialog is displayed. Click OK.
   Don't turn on Generate A Keyframe Per Frame unless you have a good reason to do so. Having a keyframe on every frame makes animation editing much more complex. Use this only if you are losing motion quality through a conversion process.

Creating Freeform Animation

The topics in this section deal with the creation of freeform animation for bipeds.

Selecting Biped Tracks

To animate your character with freeform methods, you need to know how to select the body part you want to animate, as well as the type of movement you want to affect for that part of the body. 3ds Max and Biped provide a number of different methods for selecting and moving these animation tracks. Several involve using the 3ds Max Track View, a powerful environment for viewing and managing the geometry and motion data in your scene.

For each biped body part, motion data is viewable in Track View or on the track bar. Once you've selected the biped object, using one of the methods described below, you can see its associated motion data on the track bar or displayed in the Transform branch for that object in Track View.

Biped lets you expand and collapse certain animation tracks to give you more control over your character's movement as you set keyframes. For example, tracks for body parts in the arms can be animated using five separate tracks for maximum control.

You can also collapse these tracks for simplicity, and use a single key to pose the entire arm. Tracks can be expanded or collapsed in this way for the arms, legs, ponytails, neck, tail, and spine.
In 3ds Max, you have the ability to display the motion data as function curves. You can see and manipulate function curves either in the Track View – Curve Editor, or by using the Workbench on page 4823. The Workbench provides specialized tools for analyzing and fixing motion problems found in the curves.

For fast track selection, you can also use the Track Selection rollout. These buttons let you quickly select the motion tracks for the horizontal and vertical movement of the biped center of mass, as well as selection of opposite limbs, or symmetrical limbs. Biped is unique in the way it separates the tracks for the center of mass into three tracks (one each for vertical, horizontal, and rotation).

See also:

- Dynamics & Adaptation Rollout on page 4755
- Track Selection Rollout on page 4686
- Track View (Biped) on page 4801

Selecting Tracks from the Track Selection Rollout

The center of mass has three separate animation tracks, two for motion and one for rotation. These tracks can be selected on the Track Selection rollout on page 4686:

- Body Horizontal
- Body Vertical
- Body Rotation (selects the Body Turning track)

Selecting Tracks with the Select By Name Tool

You can navigate to and select tracks for a given object using the text-entry field next to the Zoom Selected Object in Track View. Type the object name in the text field, using wildcards as necessary, and then press Enter.

Selecting Tracks from the Track View

You can navigate to a given object simply by traversing the Biped hierarchy in the Track View hierarchy window.
Note that child objects in the hierarchy are nested below parent objects. You may need to open several parent objects to get to the nested object you want. The biped tracks are grouped as follows:

- Center of Mass
- Footsteps
- Pelvis (branch1) Spine, Neck (branch), Head, Ponytail.
- Pelvis (branch2) Thigh, Calf, Foot, Toes.
- Pelvis (branch3) Tail.
- Neck (branch 1), Head
- Neck (branch 2), Clavicle, UpperArm, Forearm, Hand, Fingers.

Each of these tracks can be seen in Track View, expanded trackbar and Workbench.

Note that the hands and fingers are grouped with the arms, and the fingers and toes are grouped with the legs.

The body's translation keys are separated into vertical and horizontal tracks.

**Procedures**

**To access Track View, do one of the following:**

1. On the 3ds Max toolbar click Curve Editor.
2. Select any biped object in the viewport, then right-click and choose Curve Editor. The hierarchy list automatically displays the track of the selected biped object.
3. Choose Graph Editors menu > Track View - Curve Editor.

**To select from the screen:**

1. Place the cursor over the biped link whose tracks you want to examine. Use zoom controls, as necessary.
2. Pause over a part of the biped, and a tool-tip appears, informing you which object is at the cursor position.
3. Click to select the biped link.
**TIP** Another feedback device is available once you've made your selection. The selected object's name is displayed in the topmost field in the Modify, Hierarchy, Motion, and Display panels.

4  On the Track View, click Zoom Selected Object. The Track View hierarchy window repositions to show the selected object at the top of the window display. Nested below the object's name are the animation, or transform, tracks for that object, if any exist for the current motion.

**NOTE** By default, all keys for arm objects are in the Clavicle track, and all keys for leg objects are in the Thigh track. If you select a biped foot and click Zoom Selected Object, you may need to scroll up the Track View hierarchy to view the Thigh track transform keys. These keys also store foot transforms.

**TIP** Use controls in the Separate Tracks area of the Keyframing Tools rollout on page 4717 if you prefer transform tracks for individual objects.

To display footstep tracks:

1  Select any biped with footstep animation.

2  In the Biped rollout of the Motion panel turn on Footstep Mode.

3  Right-click in the viewport and choose Curve Editor.

4  On the Track View menu bar, choose Modes > Dope Sheet.

5  Click any footstep in the viewport and the hierarchy list navigates to the Footstep track.

**Animating by Moving Links**

Use the standard 3ds Max Move transform to move biped links.
As shown in the table below, there are two types of movements you can apply to a biped link:

- **General Move** – When you select and move the center of mass object, it and all of its children move; that is, the entire biped moves. When you move the center of mass and one or more legs are planted on the ground with IK constraints (IK Blend=1.0), the Biped tries to maintain the legs' planted position while the body moves.

- **Inverse Kinematics** – Applies to all parts of the arms, legs, fingers, and toes, except the clavicles. If you attempt to move a hand or foot beyond the biped's kinematic limit, the arm or leg straightens out and moves as far as possible in the direction you drag.

The pelvis, head, neck, non-base spine links, and non-base tail links cannot be moved. They can only be rotated, although they move when their parent moves.

When you select multiple biped parts and move them, the move applies only to selected biped parts that have no selected ancestors. For example, when the entire biped is selected, only its center of mass object is moved. When all of the finger joints are selected, the bases of all the fingers are moved.
**TIP** You can select the children of a hierarchy by double-clicking the parent.

To quickly select and move a biped and its entire animation to a new location in space, use Move All mode on page 4669.

Biped provides controls to help you give both arms or both legs the same pose. See Copy/Paste Rollout on page 4726 for more information.

<table>
<thead>
<tr>
<th>Biped Link</th>
<th>Link Name</th>
<th>Keyframe Mode</th>
<th>Figure Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Center of mass</td>
<td>Bip01 (default)</td>
<td>Positions entire biped</td>
<td>Positions entire biped</td>
</tr>
<tr>
<td>Pelvis</td>
<td>Pelvis</td>
<td>Does not move</td>
<td>Does not move</td>
</tr>
<tr>
<td>Head</td>
<td>Head</td>
<td>Does not move</td>
<td>Does not move</td>
</tr>
<tr>
<td>Neck</td>
<td>Neck</td>
<td>Does not move</td>
<td>Does not move</td>
</tr>
<tr>
<td>Spine Base</td>
<td>Spine</td>
<td>Does not move</td>
<td>Positions upper body relative to lower body</td>
</tr>
<tr>
<td>Tail Base</td>
<td>Tail</td>
<td>Does not move</td>
<td>Positions tail relative to body</td>
</tr>
<tr>
<td>Ponytail</td>
<td>Ponytail1, 11, and so on</td>
<td>Does not move</td>
<td>Positions ponytail relative to body</td>
</tr>
<tr>
<td>Clavicles</td>
<td>R Clavicle, L Clavicle</td>
<td>Do not move</td>
<td>Positions arms relative to body</td>
</tr>
<tr>
<td>Shoulders (upper arm)</td>
<td>R UpperArm, L UpperArm</td>
<td>IK from shoulder</td>
<td>IK from shoulder</td>
</tr>
<tr>
<td>Elbows (lower arm)</td>
<td>R Forearm, L Forearm</td>
<td>IK from hand</td>
<td>IK from hand</td>
</tr>
<tr>
<td>Hands</td>
<td>R Hand, L Hand</td>
<td>IK from hand</td>
<td>IK from hand</td>
</tr>
</tbody>
</table>
### Animating by Rotating Links

Use the standard 3ds Max Rotate transform to adjust a biped’s posture by rotating its links. Use the main toolbar button, or right-click and choose Rotate from the quad menu.

To make biped movement appear natural, certain biped joints are limited in how they can rotate, such as the elbows and knees. When a joint can rotate in all three axes, X, Y, and Z, it is said to have three degrees of freedom (DOF). A joint’s DOF can be modified by selecting it and then setting options on the Locks on page 3788 rollout of the Hierarchy panel.

**NOTE** Changing a joint’s DOF will not replace its default DOF, meaning a locked axis by default can not be unlocked manually.

The table below shows the degrees of freedom of each link. Biped allows a bit greater freedom than most human bodies are capable of. All rotations are performed in the local coordinate system.

<table>
<thead>
<tr>
<th>Biped Link</th>
<th>Link Name</th>
<th>Keyframe Mode</th>
<th>Figure Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fingers</td>
<td>Finger 0, 01, and so on</td>
<td>IK from finger</td>
<td>Positions finger relative to hand (if base selected)</td>
</tr>
<tr>
<td>Hips (upper leg)</td>
<td>R Thigh, L Thigh</td>
<td>IK from knee</td>
<td>IK from knee</td>
</tr>
<tr>
<td>Knees (lower leg)</td>
<td>R Calf, L Calf</td>
<td>IK from foot</td>
<td>IK from foot</td>
</tr>
<tr>
<td>Feet</td>
<td>R Foot, L Foot</td>
<td>IK from foot</td>
<td>IK from foot</td>
</tr>
<tr>
<td>Toes</td>
<td>Toe 0, 01, and so on</td>
<td>IK from toe</td>
<td>Positions toe relative to foot (if base selected)</td>
</tr>
</tbody>
</table>
**TIP** First select the link to rotate, then click Rotate. While the Motion panel is active, Biped sets the transform managers to reflect the degrees of freedom of that link. For example, if you select the pelvis and then click Rotate, Biped changes the coordinate system to Local and turns on the Y axis constraint. (For joints that have more than one degree of freedom, you might later need to change the axis constraint setting.)

To rotate the biped pelvis in all three dimensions, refer to *Pelvis as Ball Joint* on page 4583.

**Biped Motion Constraints**

Some biped parts have special-case conditions that govern how you can transform them, as described in the table and sections that follow.

<table>
<thead>
<tr>
<th>Biped Link</th>
<th>Link Name</th>
<th>Free Axes</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Center of mass</td>
<td>Bip01 (default)</td>
<td>X, Y, Z</td>
<td>Rotates entire biped</td>
</tr>
<tr>
<td>Pelvis</td>
<td>Pelvis</td>
<td>X, Y, Z</td>
<td>If feet are planted, adjusts legs to keep feet and toes above ground</td>
</tr>
<tr>
<td>Head</td>
<td>Head</td>
<td>X, Y, Z</td>
<td></td>
</tr>
<tr>
<td>Neck</td>
<td>Neck</td>
<td>X, Y, Z</td>
<td>Neck orientation does not affect head orientation</td>
</tr>
<tr>
<td>Spine</td>
<td>Spine, Spine1-4</td>
<td>X, Y, Z</td>
<td>Spine rotation adjusts overall balance</td>
</tr>
<tr>
<td>Tail</td>
<td>Tail, Tail1-4</td>
<td>X, Y, Z</td>
<td></td>
</tr>
<tr>
<td>Clavicles</td>
<td>R Arm, L Arm</td>
<td>Y, Z</td>
<td>Shoulder orientation does not affect clavicle orientation</td>
</tr>
</tbody>
</table>
### Biped Link | Link Name | Free Axes | Comments
--- | --- | --- | ---
Shoulders (upper arm) | R UpperArm, L UpperArm | X, Y, Z | Rotating pivots from shoulder to wrist
Elbows (lower arm) | R Forearm, L Forearm | X, Z | Hinge plus special rotation
Hips (upper leg) | R Thigh, L Thigh | X, Y, Z | Rotating pivots from hip to ankle
Knees (lower leg) | R Calf, L Calf | X, Z | Hinge plus special rotation
Hands | R Hand, L Hand | X, Y, Z | If feet are planted, adjusts legs to keep feet and toes above ground
Feet | R Foot, L Foot | X, Y, Z | 
Fingers | Finger0, 01, 02, Finger1, 11, 12, and so on | X, Y, Z | Finger bases have three free axes; other finger joints have Z only
Toes | Toe0, 01, 02 Toe1, 11, 12, and so on | X, Y, Z | Toe bases have three free axes; other toe joints have Z only

**Pelvis as Ball Joint**

The pelvis can be rotated in all three axes: X, Y, and Z. This ball joint provides three degrees of freedom, improving the flexibility of animating with a biped, because the pelvis gyrations are isolated from the center of mass (COM) rotation. This causes the COM to assume a smoother trajectory, which also influences the biped’s head and arms. As a result, they will look more natural moving in the body’s COM rotational space.
It's important to be aware of the following behavioral changes resulting from this:

- The three-DOF pelvis motion is displayed as three separate Euler or quaternion (TCB) function curves in the Curve Editor and Workbench.
- Using key reduction on the biped's spine produces improved results.
- Rotations on the new pelvic axes (X and Z) are keyable in layers and supported in MAXScript.
- The default parametric footstep animation is slightly adjusted to use the three-DOF pelvis.
- If a legacy biped asset such as a BIP file is loaded onto the 3ds Max biped, the pelvis-related data will be adapted to the new DOFs and the new coordinate space within which the pelvis rotates.
- Using the Motion Mixer or Motion Flow, assets containing new pelvic rotation tracks will be blended with old assets lacking these tracks.

Special Rotation: Elbows and Knees

Elbows and Knees perform a special rotation when you rotate them about their X axis. They don't actually rotate around their X axis; this does not make sense because they have one degree of freedom. Instead, the upper and lower arm/leg are rotated together about an invisible axis defined by the line stretching from the shoulder to the wrist, and the hip to the ankle. This special rotation can be very useful for positioning the arms and legs.

The special rotation can also be useful for creating characters with reverse knee bends. When the knees are rotated backward, at more than a 90-degree rotation from the front-facing human knee posture, Biped assumes the character has backward knees or bird legs, and uses this as a reference position for all .bip motions.
Rotating the forearm along the X axis rotates the arm elements about an invisible axis between the shoulder and wrist.

Balance: Spine

Biped uses only the spine, in conjunction with the center of mass, to maintain the biped's balance. Because of this, rotating all of the spine or any one of its links causes the horizontal position of the body to change relative to its center of mass. These adjustments are performed in the center of mass's local reference coordinate system, ensuring that the figure will rotate naturally about its center of mass; for example, during flips in the air.

On the Motion panel Key Info rollout on page 4704, you can turn this behavior off by setting Balance Factor to 0.0 for corresponding horizontal center of mass keys. The Balance Factor control is in the Body group on the rollout.

Independent Orientation: Arms, Head, Feet

Changing the orientation of a clavicle (the root Arm object) changes the position, but not the orientation, of its corresponding upper arm. In effect, the clavicles are a support from which the arms are suspended.

Likewise, the orientation of the neck changes the position, but not the orientation, of the head. Although linked to the neck, the head typically
rotates independently of the neck, and interpolation of these individually set orientations produces more natural-looking motion.

Similar to the head and arms, changing the orientation of the upper or lower leg changes the position, but not the orientation, of the corresponding foot. In this way, the foot orientation remains relative to the ground plane.

**Adjusting Keys with TCB Rotation**

Rather than creating extra keys to fine-tune the motion of the biped limbs, you can use the TCB controls to adjust ease in, ease out, and limb trajectory on keys that already exist.

**Visualizing Rotation Animations with Function Curves**

Another way to visualize your rotation animation is through the Curve Editor on page 3804. Each key you add is displayed and connected to other keys, creating a curve that represents your animation. You can use either the TCB Rotation Controller on page 3563 or the Euler XYZ Controller on page 3453 (on the Quaternion/Euler rollout on page 4693) to display your rotation curve as Quaternion or Euler, respectively. Each controller affects the curve differently based on separate rotation calculations. To learn more about this, refer to Working with Euler Curves on Biped Animation on page 4631.
Quaternions Rotation curve

Procedures

To change TCB for a biped arm:

1. On the Key Info rollout, turn on Trajectories.
2. Select a biped arm.
3. Use Next or Previous key to locate an arm key.
4. If the TCB group is not already displayed, click the TCB divider.
5. Change the Tension, Continuity, and Bias spinners.

The trajectory changes to reflect the new parameters. Play the animation to see the change.

TIP You can also access TCB controls by right-clicking on keys in the trackbar, Track View – Curve Editor or the Workbench Curve View.

Rotating Multiple Biped Links

You rotate multiple biped links to produce curling effects such as fingers curling around a glass or a tail curling up and down.
Selecting and rotating a hand and all its fingers causes the fingers to curl.
You can choose from two methods to rotate multiple links:

■ Select and rotate multiple links manually.

■ Enable **Bend Links Mode** on page 4700 and then select and rotate any spine, neck, or tail link to use the **character studio** technique of naturally bending the entire spine, neck, or tail.

**Selecting and Rotating Multiple Links**

When you select and rotate multiple biped links, the rotation is individually applied to each selected link. This is a convenient way to get fingers to curl, for example, or to keyframe a biped's arms, legs, multiple-jointed neck, or tail.

To select and rotate multiple links:

■ Select and rotate any number of links.
   Typically, you select an object and all of its children; for example, the hand and all of its fingers.

**Using Bend Links Mode and Twist Links Mode**

You can use **Bend Links Mode** on page 4700 to rotate multiple links for the biped's spine, neck, or tail. Bend Links transfers the rotation of one link to the other links in a natural way. When applied to the spine, it is particularly useful for positioning the biped's hips.

You can also use **Twist Links Mode** on the Bend Links rollout to twist multiple links along the X axis while preserving their relationship with the two other axes. Combining these two modes opens up a wider range of controls over your spine, neck or tail.

To rotate all links in the spine, neck, or tail:

1. On the Bend Links rollout, turn on **Bend Links Mode**.
2. Select and rotate a single spine, neck, or tail link. The other links in the spine, neck, or tail rotate to match the single link’s rotation.
3  On the Bend Links rollout, turn on Twist Links Mode.

4  Rotate the link in local X. The other links in the spine, neck, or tail twist properly to match the single link's rotation in X.

**TIP** You can use Bend Links mode either to pose the biped or to animate the spine, neck, or tail while in keyframe mode on page 8615.

**TIP** You can also use the other Twist Links tools in the Bend Links rollout on page 4700 to further control the links' rotation.

---

**Using Controllers**

*character studio* lets you add 3ds Max controllers to the biped object tracks. This allows you to mix the biped animation with standard 3ds Max animation techniques.

**Why Add Controllers**

Adding controllers to biped body parts lets you create animation that is difficult to do with *character studio* alone. For example, you can create “stretchy” cartoon arm or leg animation by adding a Scale controller to animate the bipeds arms and legs. You could make a character shaking by using a Noise controller for its limb rotations or for a Scale controller on the spine objects to make a character breathing. An Audio controller could be used to synchronize movement with sound.

**Biped SubAnims**

Different controllers can be added together, blended or sequenced in a list called a Biped SubAnim. These are the same as the weighted list controllers in 3ds Max. By animating the controller weights you can increase or decrease the effects of the different controllers. You can enable, disable or collapse the list controller animation tracks. If you collapse the track, you can then bring them into the Motion Mixer, Motion Flow, or Layer editor or export them to a game engine.
NOTE Biped SubAnims exhibits different behaviors based on whether you assign a controller or a constraint as the SubAnim. A SubAnim with a controller assigned will layer the controller animation with the existing biped animation. If you use a constraint, however, this will replace the existing Biped Animation.

TIP SubAnims are best used when combined with freeform animation. You can use them with footstep animations but you may experience unexpected results. If this happens, simply convert the footstep animation to freeform before applying the SubAnims.

**Assigning SubAnims**

Biped SubAnims can be applied several different ways. You can assign controllers to the Biped SubAnim in the Assign Controller on page 4666 rollout of the Motion panel.

Controllers can also be added in the Animation Workbench on page 4823 using the Controller button to display the controller list. Right-click and choose Assign Controller from the right-click menu. You can assign controllers to multiple objects by using the SubAnims filter.

**Procedures**

**To add a controller to a biped object:**

1. Select the biped object that you want to control, and set a key for that object.
2. In the Motion panel, expand the Assign Controller rollout. The Biped SubAnim entry is displayed in the list window.
3. Expand the Biped SubAnim entry in the Controller window. List controller entries are displayed for BipScale, BipRotation, and BipPosition.
4. Expand the list controller you want to add to and highlight the first Available entry. The Assign controller button becomes active.
5. Click the Assign Controller button. An Assign Controller dialog appears.
Choose the controller to want to use, and click OK.

Play the animation and observe the effect.

You can animate the parameters for the controllers using Track View or by right-clicking the list entry in the controller window and then choosing Properties.

Controllers can also be assigned in the Animation Workbench by displaying the Controllers list, choosing an Available entry, right-clicking and choosing Assign Controller.

To collapse a controller:

You can collapse a controller to use the animation in the Motion Mixer, or with Layers, or to export to a games engine.

1. Select the biped object with the controller, for example an arm with an added noise rotation controller.

2. On the Motion panel, in the Assign Controller rollout, click the Biped SubAnim controller you want to collapse.

3. Right-click the Biped SubAnim and choose Properties.
   A dialog appears with the Collapse choices.
   If a different dialog appears, you don't have the correct selection in the list window. Be sure you've selected the Biped SubAnim entry and not something else.

4. Turn on the tracks you want to collapse in the Enable group.

5. Turn on the options you want to use in the Collapse group.

6. To perform the collapse, click the Collapse button.
   The controller tracks are “baked” into the Biped tracks. The new keys will appear in the track bar, or in the Workbench Curve View if the Workbench is open.

To add controllers to multiple biped parts at the same time:

1. In the viewport select the biped parts to which you want to add list controllers.

2. Open the Workbench.
   The selection list in the Select panel has the biped parts highlighted.
3 Click the Controllers button on the Workbench toolbar. The controller list appears to the right of the select tab.

4 Select the tracks you want to affect.

5 On the Filter panel, locate the part to Filter group. Set it to Selected Parts if it isn’t already.

6 Choose a SubAnims filter from the drop-down list.

7 Adjust any other options you need to in the Filters tab, then click Position, Rotation, or Scale to add the subanims.

8 Expand the controller list to observe the newly added controllers.

**To animate the weights of an added controller:**

You can animate the weights of an added controller to determine when the effect takes place. A weight of 0 will yield no effect, a weight of 100 will provide the full effect. See the tutorial “Using Controllers with Biped” for an example of animating the weights.

1 Add a controller to a biped object, using either method outlined above.

2 Immediately after adding the controller select the appropriate BipScaleList, BipRotationList, or BipPositionList entry in the controller list, and expand it to see the Weights.

3 Expand the Weights and select Weight 0.

4 In the Keyframing Tools rollout on the Motion panel, click the Manipulate SubAnims button.

   Three new rollouts appear in the Motion panel: Position List, Scale List and Rotation List.

5 Navigate to the appropriate List rollout. In the Layer window highlight the Controller you wish to weight.

   The Weight field becomes available

6 Turn on Auto Key, move the time slider and enter values in that field, or use the spinner to set keys to animate the weights.
WARNING  Don’t even think about using the 3ds Max Set Key button to animate the weights. Avoid using this button with character studio as a rule. Use Auto Key or use the Key Info rollout set key buttons instead.

Using Props

Props are objects that a biped could be holding or carrying, such as a gun, sword, or briefcase. They are represented as boxes that are additional links in the biped hierarchy, an extension of the biped structure you can access at creation time or in Figure mode. If you are loading motion-capture data that contains prop information, this will transfer to the biped prop.

Each biped can have up to three props. Prop data will work seamlessly with other advanced features of character studio: in the Mixer, Motion Flow, Unification, and Layered edits.

Props are defined in the Structure rollout.

Props appear as boxes in the biped hierarchy. They can be moved, stretched, and scaled in Figure mode as other biped parts can. Props are supported by Physique, and are animated using the biped Transform controller in the same way as other objects. Create your prop and position it in relation to the biped in Figure mode. Props can be made to follow the motion of either hand by keyframing the Position and Rotation coordinate space of the prop.
Bipeds with multiple props as swords

Animating Prop Linkage

Props can change linked parents (similar to the 3ds Max Link controller) at any keyframe. This is done using the Position Space and Coordinate Space lists in the Prop section of the Key Info rollout on page 4704. Once a key is set on the prop at a given frame, you can set or change the coordinate space in which it is transformed by choosing a new space from the drop-down list. You set rotation and position coordinate space independently.
Position and rotation space controls

**Importing Motion-Capture Prop Data**

If your motion-capture file includes prop data, **character studio** can read that data and apply it to a prop object.

Upon loading a CSM file on page 8543, the motion data will be applied to the prop. If the prop switches from one hand to another, **character studio** will automatically determine the switch of the prop’s coordinate spaces as the prop is exchanged between the hands. This can be easily changed once the data is in the scene: go to the desired frame, choose a new coordinate space (as described in the previous section), then set a key. When loading a BIP file for retargeting onto other characters, the props move with each of the hands. **character studio** ensures that the hands come together at the precise position on the prop during transfers.

Props can be animated with 3ds Max controllers and that animation can then be collapsed onto the prop’s transform controller for editing with motion flow or the mixer.
Procedures

Example: To animate a biped swinging a prop with one hand:

1. Create a biped with a single prop.
   The biped appears with a single prop displayed as a box positioned near the biped's right hand.

2. On the Motion panel, on the Biped rollout, turn on Figure Mode.

3. Scale the prop so it is the correct size and proportion to be a sword.

4. Rotate and move the prop so it is in the correct orientation in relation to the right hand.

5. Turn off Figure mode.

6. Set a key for the prop at frame 0. To do this, make sure the prop is selected, then use the Set Key button in the Key Info rollout.

7. Now animate the biped as you like, or open a BIP file of a character swinging a sword.

8. Turn on Auto Key, then select the prop.

9. Animate the prop using standard 3ds Max transforms.

Example: To animate the biped switching the prop to the other hand:

1. Follow the steps in the previous procedure to animate the biped swinging the prop.

2. Move to the frame where you want the biped to switch the prop the other hand.

3. Move the biped's other hand so it is in contact with the prop, and set a key for the hand.

4. Select the prop and set a key for it.

5. Move the time slider ahead one frame and set another key for the prop.

6. On the Key Info rollout, expand the Prop section.
   The lists for Position and Rotation coordinate spaces should be available.
   Change the Position from the right hand to the left hand, and click Set Key again.
The prop will now follow the movement of the left hand in the frames that follow.

**NOTE** By default, the prop’s rotation remains in Body space. Depending on your animation, you might also want to set keys so the Rotation space is Right Hand before the switch, and Left Hand after the switch.

To collapse the transforms of a prop:

1. Animate the prop however you like. You can add list controllers to the prop as you can to any other part of the biped.
2. When the animation is correct, select the prop.
3. In the Motion panel hierarchy list, select the prop transform list you want to collapse, and then right-click. A quad menu appears.
4. Choose Properties from the quad menu.
5. In the dialog that is displayed, make the appropriate choices, and then click Collapse. After a short delay, the track bar displays the keys that have been added.

**TIP** If you see a different Properties dialog that doesn’t offer you the Collapse button, you are too low in the hierarchy. Select the next level up in the hierarchy and try again.

**Freeform and IK**

The topics in this section deal with using freeform animation and inverse kinematics (IK).

**Using IK Keyframe Parameters**

Biped’s inverse kinematics solution has three parameters set at each key of the arm and leg keyframe tracks.
As the limb moves through each key:

- **IK Blend** sets the motion interpolation to be a blend of forward and inverse kinematics. This allows you to blend swinging motions with hand-or-foot directed motions. Rotating an arm to move a hand is an example of forward kinematics. Using the position of the hand to move the arm is an example of inverse kinematics. The default blend is 0.0, or full forward kinematics. An IK Blend of 1.0 is full inverse kinematics.

- Body or Object determines the reference coordinate space of the IK path. This allows you to move the IK path with your character's body or temporarily attach the hands or feet to follow other objects. The default is Body.

- **Join To Prev IK Key** determines if the key should be part of the previous key (and have the same reference position as the previous key).

Biped has three automatic ways to set these parameters. Setting planted, sliding, or free keys creates keys with different combinations of these three parameters.

- Setting a planted key creates a key with IK Blend set to 1.0, Object and Join To Prev IK Key turned on.

- Setting a sliding key creates a key with IK Blend set to 1.0, Object turned on, and Join To Prev IK Key turned off.

- Setting a free key creates a key with IK Blend set to 0, and Body turned on. Join To Prev IK Key is turned off.

**IK Blend**

The IK Blend control is in the Key Info rollout on page 4704; visible when you expand the IK divider bar. You set IK Blend while in Keyframe mode.
IK group parameters

IK Blend can be set per key for any arm or leg track. The IK Blend setting determines whether, at a particular key, an arm or leg is moving through it using inverse kinematics, forward kinematics, or a blending of the two kinematic solutions.

An IK Blend value of 0.0 means full forward kinematics. The arm (or leg) is moved by interpolating the rotations of the joints at the keys. The hand (or foot) tends to move along sweeping circular arcs in this case, and the motion appears to be motivated by the apparent swinging at the joints.

An IK Blend value of 1.0 means full inverse kinematics with the hand (or foot) being used as an end-effector. A spline path is computed through the keys of the hand, and the hand moves along that spline. Joint angles for the rest of the arm are computed to allow the hand to follow the spline. The motion, in this case, appears to be directed by the hand (or foot).

An IK Blend value between 0.0 and 1.0 means a combination of inverse and forward kinematics; when IK Blend is closer to 0.0, forward kinematics are more heavily weighted in the solution, and when IK Blend is closer to 1.0, inverse kinematics are more heavily weighted.
It is best to use forward kinematics when you want the arms to swing, such as when a biped is walking. In the case of a boxer, however, since the hand should follow a directed path when punching, inverse kinematics should be used.

**To set the IK Blend value of a key:**

1. Select a single arm or leg track by selecting one or more parts of a biped’s arm or leg.
   The IK Blend spinner and the other controls in the IK area are enabled only when a single arm or leg track is selected.

2. Set a key if one doesn’t already exist.

3. Set the desired value of IK Blend.

**Body and Object Options**

By default, Biped calculates the kinematics solution using the coordinate system of the biped figure’s center-of-mass, or the Body coordinate system. This means that the IK path of the hand (or foot) translates and rotates with your character as it moves. For example, the boxer’s hand trajectory always moves relative to the weaving, bobbing, and turning of the boxer’s body.

The Object option is used for animating dynamic links between the limbs and other objects in the scene.

The IK Blend control activates when a biped arm or leg (hand and foot) key is current.

- 0 with Body turned on is **forward kinematics** on page 8585, or normal biped space.

- 1 with Body turned on is **inverse kinematics** on page 8612, creates more straight-line motion between biped keys.

- 1 with Object turned on, but no IK object specified, puts the limb fully into world space. Use this to control foot sliding in a freeform animation.

- 1 with Object turned on and an IK object specified puts the biped limb into the coordinate space of the selected object; the biped limb follows the specified object.
Join To Prev IK Key

This IK constraint is used to specify if a footstep is sliding or planted. If Join To Prev IK Key is on, then the biped foot maintains a reference position to the previous key, keeping the foot planted. If Join To Prev IK Key is off during a footstep, then the foot can be moved to a new position creating a sliding footstep.

Join To Prev IK Key also functions to lock the biped hands in space. Use Set Planted Key on the biped hands to lock their position in space.

**TIP** If you are having trouble with a foot or hand popping back to a previous ‘keyed’ position, check to make sure that the Join To Prev IK Key is off, especially when you’re using pivot points.

See also:

- Key Info Rollout on page 4704

Understanding Walk Cycle Constraints

Walking motions in both freeform and footstep animations should follow the rules of certain IK constraints. In both freeform and footstep animation, a footstep interval is the start and end of a sequence of IK constraints in world space, with IK Blend set to be greater than 0.0. A biped foot in the Move state should have body space turned on with an IK Blend of 0.0. By using these IK constraints, you can convert between the two animation methods seamlessly.

In a freeform walking animation, typically you need two key types for the legs:

- If the foot is planted on the ground, the key must have IK Blend=1.0 with Object Space and Join To Prev Key turned on.

- If the foot is in the air between footsteps, then IK Blend=0.0 with Body Space turned on, and Join To Prev Key turned off.

In the course of creating a walk or run cycle, you need to alternate these IK constraints for the feet. If the foot is sliding on the ground, then the IK constraints are IK Blend=1.0 in Object Space with Join To Prev Key tuned off. All of these IK parameters can be found on the Key Info rollout.

To speed up the process of applying these IK constraints, the Key Info rollout has three additional set key buttons: Set Planted Key, Set Sliding Key, and Set
Free Key. By clicking one of these buttons, all the necessary IK constraints are applied automatically. For example, by clicking Set Planted Key, all of the IK constraints necessary are applied at once; IK Blend=1.0 with object space and Join To Prev Key turned on.

See also:
- Key Info Rollout on page 4704

Walking Keys

Let's examine the IK constraints for one footstep. The footstep rolls on the heel of the foot, then rotates down flat on the ground, then raises up on the ball of the foot, rotates at the end of the toes, and finally lifts off of the ground.

Touch state: pivot planted at heel at frame 14

The foot is touching the ground at the heel. In the Key Info rollout, Set Planted Key is clicked to set IK Blend=1.0 with object space and Join To Prev Key turned on. A pivot is selected on the heel of the foot.
Pivot point shifts to ball of foot at frame 16.

The next keyframe is also a planted key, as the foot is flat on the ground. In the Key Info rollout, Set Planted Key is clicked. The pivot on the ball of the foot is selected.
Planted key set to lock pivot at frame 17

This key has the pivot on the ball of the foot as well. Click Set Planted Key. Two consecutive keys with the pivot at the ball of the foot are necessary to rotate the foot about the ball of the foot.
Heel lifts, toe remains flat at frame 18

After rotating the foot about the pivot at the ball of the foot, you set another planted key with the pivot on the toe.
Foot rotates off pivot at end of toe at frame 19.

Here is another planted key with a pivot at the end of the toe; the foot rotates about the tip of the toe.
Free Key allows foot to travel off the ground at frame 20.

Here, Click Set Free Key to set a free key, the foot is off of the ground.

The cycle is repeated to create a walk or run cycle in a freeform animation. The pivot points are selected by turning on Select Pivot on the IK Key Info rollout, selecting a pivot in the viewports, turning off Select Pivot and then rotating the foot in the viewports.

When Join To Prev is turned on, as it is with all planted footstep keys, the foot pivots at the previous key's pivot point. If you find that the foot is not rotating around the visible pivot, remember that it is using the previous key's pivot. In such a case, you must set two consecutive keys with the pivot at the same location: then the foot will rotate around the displayed pivot.

If you adhere to these rules in creating footsteps in a freeform animation, then you can use Convert in the Biped rollout to easily change from a freeform animation to a footstep animation. Note that IK constraints in a footstep animation are applied exactly the same way as in a freeform animation. If you examine a footstep animation, you will notice that the foot IK constraints follow the same rules as for a freeform animation. Footsteps are simply gizmos
that define a foot’s coordinate system. A foot can slide and move relative to
the footstep. Also, if you delete or add a key in a footstep animation, the
footstep duration is changed.

Setting Keys for Feet and Hands

You can animate biped’s body parts as you do other 3ds Max objects: by setting
keys for postures at keyframes.

character studio provides three different ways to set keys at the current frame:

■ Pose the biped body part, and then click one of the set
key buttons in the Key Info rollout.

■ Turn on the Auto Key button, and then pose the biped part.
You can transform the parts using transform tools, or you can copy and
paste poses and postures to keyframe the biped.

■ Right-click the time slider and use the Create Key dialog to create keys for
selected biped parts.

WARNING Do not use the large Set Key button, found below the viewports, when
animating a biped. Doing so will cause unpredictable results. Instead, always use
the Set Key buttons found on the Key Info rollout.

If you are animating a walk cycle or an intricate hand
animation, then you should make use of the three different types of set key
buttons in the Key Info rollout. Each set key button applies different IK
constraints, depending on whether a foot or finger is in a planted state, a
move state, or a sliding state. For more information on the three set key
buttons, see Key Info Rollout on page 4704.

You can also set keys to make hands and feet follow a stationary or animated
object. See Animating IK Attachments on page 4616.

If a Bones system using the IK controller or a particle emitter is linked to the
biped, the Auto Key button must be on in order to position the biped’s limbs.
This is also true for biped objects if you turn on 3ds Max Trajectories at the
top of the Motion panel, or if you choose Views > Show Ghosting.
The Set Key options on the Key Info rollout have the advantage that you can easily experiment with different poses for your character without unintentionally setting keys as a side-effect. Use the Set Key buttons to commit the changes you make to the pose. The Auto Key mode approach is especially useful when you make adjustments to keyframes that have already been set, or if you are used to working with Auto Key in 3ds Max and tend to forget to click the Set Key buttons.

**TIP** Use Set Key to insert a key on a frame where a key doesn't exist. You'll often want to refine the motion using controls in the Key Info rollout, without selecting and moving an object in the viewport.

Keyboard shortcut: Pressing 0 (zero) is equivalent to clicking Set Key on the Key Info rollout.

To use character studio-specific shortcuts, make sure that the Keyboard Shortcut Override Toggle on page 8420 is active.

---

**Ground Plane Collision Detection for the Pelvis and Feet**

When one or two feet are planted, and the pelvis or a planted foot is rotated, character studio detects collisions of the foot and its toes with the ground plane defined by the planted foot's footstep or pivot point. As the pelvis or foot is rotated, character studio uses inverse kinematics to alter the rotations of the leg joints so that the foot and its toes do not go below the plane defined by the footstep or pivot point.

**NOTE** A biped foot on a sliding footstep is a special case. The biped foot can be moved to any position and orientation for the duration of the footstep.

**NOTE** Changing rotation values for the legs and toes also maintains collision detection, but the position adjustment is not made until you set a key.

---

**Animating Pivots**

In both freeform and footstep animation, pivots allow you to rotate the biped's hands and feet around various points.
For example, by activating a pivot on the ball of a foot, you can rotate the foot around the ball of the foot. The biped’s hands and feet have the same number of pivots, and pivot location is similar. Pivots are active only if the biped hand or foot is in world or object coordinate space. In a walking motion, you can pivot on the heel first, then on the ball of the foot, and finally on the toes. Pivots are essentially extensions of the IK chain.
By setting a planted key for the hand, the hand is anchored in world space: you can move the biped or the collarbone and the hand remains planted. Pivots on the hands make it easy to animate hands and fingers.

While pivots are used in both freeform and footstep animation, the pivots are only visible and accessible when in Freeform mode.

**Biped IK**

To understand interactive IK limb manipulation using **character studio**, it is useful to distinguish two types of limb joints: primary and secondary.

The primary joints are the shoulder, elbow, hip, and knees. Animals use primary joints to coordinate the positioning of hands and feet, as these joints have the most influence and flexibility in positioning tasks. Even the placement of fingers and toes over specific spots is the task of the primary joints.

The secondary joints are the wrists, ankles, toes, and fingers. These joints are typically used for grasping and support rather than positioning, so they most frequently exercise independent joint angle control suited to a particular task, such as rotating the foot to raise the heels during walking, or curling the fingers around an object. Because these joints have little influence on end effector position, they are rarely engaged for positioning tasks. For example, if you want to place your finger on your nose, you will most naturally rotate only your shoulder and elbow, keeping your wrist stationary.

**character studio** mimics the IK behavior of "natural" systems. The primary joints are used for IK positioning, while the secondary joints are independently and precisely controlled by the animator. The secondary joints will not rotate unless the animator explicitly selects and rotates them. Therefore, if an IK pivot is set, and the limb is interactively manipulated, (say, the finger is moved onto the nose), only the primary joints adjust to satisfy the IK constraint. The secondary joints remain in place and will never "drift" in an IK solution; they simply obey the values set by the animator. Because there is no drift for the secondary joints, the animator does not have to tediously assign "tension" values to hold them in place.

If an IK pivot point constraint has been set, some by-products of **character studio** "natural IK" are that:

- Interactively rotating a secondary joint will always adjust the primary joints to hold the IK pivot in place.
- **character studio** "special rotations," the forearm/calf X-axis rotations, rotate the elbow about the axis from the shoulder to the wrist and rotate the knee about the axis from the hip to the ankle. These rotations give the
animator a direct way to interactively rotate the primary joints while holding the IK pivot in place.

- Interactively translating a limb part to move the IK pivot will alter only the primary joints.
- Interactively rotating a primary joint will move the IK pivot with it.

After an IK pivot has been placed, applying 1) and 2) gives the animator exact control over all possible IK solutions. The IK pivots can be easily moved by applying 3) and 4). In general, you don’t need to remember these “rules,” because the system works in an intuitive way. You merely need to position the pivots as desired, set the IK constraint, and then fine-tune the posture of the limb, if desired, by rotating the secondary joints and using the special rotation to adjust the primary joints.

**NOTE** During animation playback, the Ankle Tension parameter is used to set the relative importance of the interpolated ankle joint over the interpolated knee joint for intervals in between keyframes. This is relevant only to interpolation on bipeds.
Using IK constraints and pivots on the biped hands and feet allows you to animate quadrupeds.

See also:

- [Key Info Rollout](#) on page 4704

**Procedures**

**To use pivots:**

1 Select a biped hand or foot.

2 On the Key Info rollout, click Set key, and then choose Object. You can also select an object if you like at this point, by selecting a non-biped object in the viewport.

3 Turn on Select Pivot.

4 Select a pivot in the viewports.
Pivots are shown as red dots on the hands and feet. Use wireframe viewport shading if you have problems seeing the choices.

5 Turn off Select Pivot.

6 Rotate the hand or foot around the selected pivot.

**TIP** If you find that you are not rotating around the selected pivot, set two consecutive keys at adjacent keys with the same pivot.

**Animating a Quadruped**

While **character studio** was initially designed as an specialized program for animating two-legged, or bipedal characters, it works quite well for creatures that walk on four or more legs.

Here are some general rules to follow when animating characters that don't walk upright on two legs:

- Use Freeform animation, not Footstep animation, if your character walks on four legs all the time.
- Pose the biped to match the mesh in Figure mode, scaling and rotating body parts so the spine is horizontal, and the arms stretch to reach the ground.
- If appropriate for your mesh, set Leg Links to 4 and rotate the legs so the knees point backwards. You can set this value at creation time in the Create Biped rollout on the Create panel, or later using the Structure rollout on page 4762 on the Motion panel.
- Animate pivot points with planted keys to mimic the rolling of the feet from heel to toe. Treat the hands the same as the feet. Set planted keys on the hands and feet, then move the center of mass object to bend the knees and elbows. See Key Info Rollout on page 4704 for more information on the three set key buttons. The ForeFeet option lets you set planted keys for fingers in the same way you do for toes. This option is located on the Structure rollout on page 4762.
- You can save 3ds Max objects as part of the BIP file. If you need additional legs (for a centipede) or extra arms or wings you can use standard bone objects with IK chains, and save all of it with the BIP file.
The Balance Factor in the Key Info rollout Body group, is designed to synchronize upper body and lower body movement. Set Balance Factor to 0 if you find the movement of spine links is affecting the biped's hip movements in an undesirable way.

**Animating IK Attachments**

A biped can interact with other objects in the 3ds Max scene. Links between objects are usually static, unless you’re using the Link controller. In **character studio**, such attachments are “animatable” as well; during the course of an animation, the links between the hands, feet, and objects in the scene can change as your character interacts with them.

This capability is useful for:

- Creating freeform motions (without footsteps and gravity) that require that feet or hands be planted with IK, and then released. Examples are climbing a ladder, riding a bike, or rowing a boat.

- Motions that involve the temporary manipulation of objects, such as bouncing or kicking a ball, opening a door, or touching another biped.

An object to which a hand or foot can be attached is called an **IK object**. See the tutorial “Interacting with Objects” for lessons that show you how to make a biped iron clothing, ride a skateboard, bounce a basketball, climb a ladder, and pick up a briefcase.

**Procedures**

**To make a hand or foot follow an object:**

1. Create the object for the hand or foot to follow.
2. Select the biped's hand or foot.
3. In the **Key Info rollout** on page 4704, expand the IK divider to see the IK section of the rollout.
4. Click Set Key.

**TIP** You can select any part of the biped’s arm to set keys for the hand, or any part of the leg to set keys for the foot.
Once a key is set, the IK Blend value and other IK parameters become available.

5. Click Select IK Object, and choose the object for the hand or foot to follow.
   The object name appears in the field below the Body and Object radio buttons.

6. On frames where you want the hand or foot to start following the object, set a key, set IK Blend to 1.0 and choose the Object option on the Key Info rollout. You can also click Set Sliding Key to set these parameters all at once.

   **NOTE** If Object space is turned on with no IK object specified, the IK constraints will be in World space. In effect, the hand or foot will be attached to the world, and will not move during the time such a key is set.

   Set one key when you want the attachment to begin, and a second key when you want the attachment to stop. This defines an Object space interval, the duration of a temporary attachment.

7. On the frame that defines the end of an attachment interval, set IK Blend to 1.0, choose the Object option, and turn on Join to Prev IK Key. You can also click Set Planted Key to set these parameters all at once.

8. On frames where you don’t want the hand or foot to follow the object, set a key, set IK Blend to 0.0 and choose the Body option. You can also click Set Free Key to set these parameters all at once.

**To anchor a hand or foot:**

You can use anchoring to temporarily look a hand or foot to a specific point in space while you are animating IK attachments.

1. Move and rotate the hand or foot into the desired posture.
On the Keyframing Tools rollout, click the button for the limb you want to anchor: Anchor Right Arm, Anchor Left Arm, Anchor Right Leg, or Anchor Left Leg.

**NOTE** The arm or leg you select beforehand does not actually have to be the same as the arm or leg you are anchoring.

Set keys for the arm or leg as described in the previous procedure.

**NOTE** You can also use anchors to hold a foot or hand in position while you render the animation. However, be aware that anchors are turned off when you close the MAX file. If you want to use anchors from one session to the next, you must turn them on again the next time you open the file.

### Editing Freeform Animation

The topics in this section deal with the editing of freeform animation for bipeds.

### Editing Biped Keys

There are a few different ways to move among biped keys and edit them.

You can move back and forth between keys by clicking the Previous Key and Next Key buttons on the Key Info rollout. The fields to the right of these buttons indicate the key number and frame number.

As with other 3ds Max objects, you can also move back and forth between keys by turning on the 3ds Max Key Mode Toggle, selecting an element associated with a given track, and then using the 3ds Max buttons Next Frame and Previous Frame. For example, you can view keys, move between them, and set keys for a right arm track if any of the right arm's objects (clavicle, upper arm, lower arm, hand, fingers) are selected. Or use the
< and > keys on the keyboard to move back and forth between keys in Key Mode.

You can delete a key by clicking Delete Key in the Key Info rollout. The biped part that has the key must be selected, and the current frame must be the keyframe you want to delete. Keys that are locked (appearing in red in Track View) cannot be deleted.

**TIP** When you've selected the biped part you want to transform, click Lock Selection Set on the 3ds Max prompt line. Now you can transform the part without accidentally selecting a different part of the biped. The default keyboard shortcut for Lock Selection Set is the spacebar.

**Copying and Pasting Postures and Poses**

The Copy/Paste rollout on the Motion panel provides controls to help you copy and paste biped postures, poses, and tracks. A posture on page 8690 is the rotation and position of any selection of biped objects. A pose on page 8689 is the rotation and position of all the objects in a particular biped. A track on page 8744 is the animation for any selection of biped parts. For information on working with tracks, see Copying and Pasting Tracks on page 4649.
You can create and store postures, poses, and tracks in multiple buffers accessed by a drop-down list. You can choose from that list and see a thumbnail image associated with the selection, then paste that selection onto the same biped or any other biped in the scene. You can choose between posture, pose, or track for these operations.

Using these tools lets you work in a traditional pose-to-pose method of animating. You can create a variety of poses and postures, store them in the list, then in Auto Key mode, copy them to any biped at any frame to create animation.

Use the Copy Tracks function to copy the animation of biped parts onto other parts and other bipeds. You can further manipulate these tracks with the Curve Editor and Dope Sheet Editor, using all the standard tools found there. Copy Tracks works with both footstep and freeform animation.

**TIP** The *copy collections* on page 4727 feature acts as an additional layer of organization, allowing your copied postures, poses, and tracks to be grouped together so you can transfer them between files within a single session. After saving a collection, you can load it into another scene either by replacing the current collection or by appending yours to it. If you choose to append, the collection maintains the copy buffer structure.
NOTE You must create a copy collection before you can copy a biped’s posture, pose or track.

Using Paste Posture

The Paste Posture command is useful for copying a posture in one frame of an animation to another frame of the animation. Copy the posture, then turn on Auto Key and move to another frame, then paste the posture.

The Paste Posture and Paste Pose commands are also useful for copying a pose from one biped to another. Copy the pose or posture, select the other biped, and then paste.

Copying a posture then using Paste Posture Opposite is particularly useful for copying the posture of an arm or leg or a part of an arm or leg onto the opposite arm or leg of the same biped.

Both Paste Posture and Paste Posture Opposite work differently in and out of Figure mode. Out of Figure mode, only the orientation of the copied links is pasted. In Figure mode, both the orientation and the scale of the copied links are pasted. Also, when you paste the finger base, toe base, spine base, tail base, or clavicles in Figure mode, the position of that link relative to the biped’s body is pasted.

Copying the Entire Biped Pose

The Copy Pose functionality allows you to copy the rotation and position of all the parts of the entire biped at once. It doesn’t contain the animation track data, only the individual keys at that frame, and the buttons to copy tracks are unavailable when Copy Pose is in use.
Pose shows the whole biped

You can create animation using Copy Pose by simply copying different poses to the same biped at different frames, and setting keys for those poses. Copy Pose works with the character studio Set Key buttons found on the Key Info rollout on page 4704, and with Auto Key mode.

WARNING Don't use the Set Key Mode toggle or the large Set Keys button next to Auto Key. These will not produce the correct results.

Keyboard Shortcuts

The following are Biped keyboard shortcuts to the copy and paste posture commands. Make sure the Keyboard Shortcut Override Toggle on page 8420 is active.

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt+C</td>
<td>Copy Posture</td>
</tr>
<tr>
<td>Alt+V</td>
<td>Paste Posture</td>
</tr>
<tr>
<td>Alt+B</td>
<td>Paste Posture Opposite</td>
</tr>
</tbody>
</table>
Procedures

To copy a posture:

1. Select the set of biped parts that defines the part of the biped's posture you want to copy.

2. On the Copy/Paste rollout, click Create Collection and rename the new collection **Biped Posture**.

3. Click Posture to toggle Posture mode and then click Copy Posture. The thumbnail image appears in the image window below the Copied Postures drop-down list.

4. Rename the posture by editing the name in the Copied Postures name field. The posture of the set of selected objects in the biped is copied to the list. You can retrieve this posture and use it to paste (or paste opposite) to any biped at any frame.

For hands-on experience using the Copy/Paste rollout functions, see the lesson called “Creating a Simple Freeform Animation” found in the *Animating with Freeform* tutorial.

To paste the posture:

**NOTE** Turning on the Auto Key button before pasting posture automatically sets a key for all objects whose posture has changed.

1. Choose the Posture you want from the copied postures drop-down list.

2. Select the biped you want to paste to, or move to another frame for the same biped.

3. Click Paste Posture.

The copied posture is pasted onto the selected biped. It doesn’t matter which part of the biped is selected; all biped parts whose posture was saved by the most recent Copy are pasted.

**WARNING** If you paste a posture while the Auto Key button is off, no key is set. If you want the pasted posture to set a key, you must click the character studio Set Key button in the Key Info rollout while objects are still selected.
To paste a limb posture on the opposite limb:

1. On the Copy/Paste rollout, click Posture.
2. Select all of the limb, arm, or leg whose posture you want to copy.
3. Click Copy Posture.
   The posture thumbnail image is displayed in the image window, and the new posture name appears in the named posture field.
4. Rename the posture.
   The default names combine the chosen body track with the selected bodyparts. It’s a good idea to replace this with a descriptive name you can easily identify with the action it represents.
5. Click Paste Posture Opposite.
   The opposite limb now has the posture of the limb you copied.

To copy the entire pose of a biped:

1. Select any part of the biped whose pose you want to copy.
2. On the Copy/Paste rollout, click Create Collection and rename the new collection Biped Pose.
3. Click Copy Pose.
4. Advance to a new frame or select another biped.
5. Turn on Auto Key.
6. Click Paste Pose or Paste Pose Opposite.

**TIP** You can use Paste Pose Opposite to create symmetrical runs and walk cycles.
Mirroring Motion

Mirror, on the Keyframing Tools rollout on page 4717, mirrors the motion of the biped through both the X and Y axes of the World coordinate system. The entire biped animation, including all footsteps and keys, is mirrored symmetrically through an axis that joins the center for the biped to the world origin. For example, if a biped is walking from the center of the world grid toward the user, the mirror will change the motion so the biped is now walking away from the user.

Original motion
Mirrored motion

Use Mirror if you want to create the opposite of a motion you’ve already created. For example, if a biped walks to the left and swings its right arm, mirroring the motion results in a motion where the biped walks to the right and swings its left arm.

The mirrored motion replaces the existing motion for the biped. If you want to keep the existing motion and add the mirrored motion, use Paste Opposite in the Copy/Paste rollout.

**NOTE** This feature mirrors only those biped tracks that have at least one key. The position of a keyless object is not mirrored.

**Using Layers**

Layers allow you to add successive layers of animation above the original biped animation. This is a powerful way of making global changes to your character animation.

For example, simply add a layer, and rotate the spine forward at any frame, and a run cycle becomes a crouched run. The original biped motion is kept...
intact, and can be viewed by switching back to the original layer. Layers can be viewed individually, or as a composite of all the animation in all the Layers. Layers behave like a freeform animation on page 8586: the biped can adopt any position.

Layers allow you to easily adjust raw motion capture data containing keys at every frame. Simply add a layer, and keyframe the biped. You can also use layers to change the global position of the biped in a freeform or footsteps animation by adding a layer and moving the center of mass.

See also:
- Layers on page 8617
- Layers Rollout on page 4741

Procedures

To increment all keys using layers (global offset):

1. On the Motion panel Layers rollout, click Create Layer to create a new layer. Enter a name for the layer in the Layer name field.

2. Create an offset (or "increment") by setting one key. You can either use Auto Key mode, or click Set Key on the Key Info rollout on page 4704 (this can be done at any frame.)

3. Click Collapse to collapse the layer.

To increment an interval of keys with an envelope (blended offset):

1. Create a new named layer.

2. Create an offset by setting one key. You can use either Auto Key mode, or click Set Key on the Key Info rollout at the frame where the increment is to occur.

3. To create the envelope, use Snap Set Key to create keys before and after the incremented range.

4. Click Collapse to collapse the layer.
To increment an interval of keys without an envelope (nonblended offset):

1. Create a new named layer.

2. Create an offset by setting two keys. You can use either Auto Key mode, or click Set Key on the Key Info rollout. Set one key before the frame where the increment starts, and another after the frame where the increment ends.

3. Use Snap Set Key to create keys before and after the incremented range to clamp the motion to the offset only occurs in the range between the two keys.

4. Click Collapse to collapse the layer.

**Editing Trajectory Keys**

By turning on biped trajectories, selecting the center-of-mass track, and turning on Sub-Object: Trajectories, you can select a key on the trajectory. Then either use Bend Horizontal in the Keyframing Tools rollout on page 4717 to bend the trajectory about the selected key, or simply move the key. You can move center of mass trajectory keys either horizontally or vertically. This allows you to view the entire trajectory of the center of mass and bend or edit the trajectory.

**TIP** You can select the center of mass's horizontal or vertical tracks by clicking the appropriate button in the Track Selection rollout on page 4686.
Above: Bending the trajectory
Below: Moving a key on the trajectory

**WARNING** Do not use 3ds Max trajectories (Motion panel > Trajectories text button) to edit biped trajectories.
Procedures

To bend a biped trajectory:

1 Select an animated biped.

2 On the Biped rollout of the Motion panel, expand the horizontal bar (click the plus sign at the left) to display the Modes and Display groups.

3 In the Display group, turn on Trajectories.
   The trajectory is displayed in the viewport for whatever biped part is selected.

WARNING Don’t click the Trajectories button next to Parameters. That is for other scene objects, not bipeds.

4 In the Track Selection rollout, click Body Horizontal.
   The center of mass object trajectory is displayed.

5 At the top of the panel, below Selection Level, turn on Sub-Object, and choose Trajectories on the drop-down list if it isn’t already displayed.

6 In a viewport, select as many keys as you want on the trajectory.
   The selected keys turn red in the viewport.

7 If you want to bend the trajectory open the Keyframing Tools rollout and locate the Bend Horizontal spinner. Then adjust the Bend Horizontal values as desired.

To edit keys on the Center of Mass trajectory:

1 Load a Freeform animation.

2 In the Track Selection rollout, click Body Horizontal.
   The center of mass object trajectory is displayed.

3 On the Track Selection rollout click Body Horizontal or Body Vertical.

4 Turn on Sub Object Trajectories at the top of the Motion panel.

5 In the viewports select and move keys on the Center of Mass trajectory.
Working with Biped Animation

The topics in this section deal with some special cases of biped animation.

Working with Euler Curves on Biped Animation

You can control a biped's position and orientation using Euler curves in addition to quaternion curves in the Workbench and Curve Editor. Using the Euler XYZ controller is an efficient way to animate your biped because you can use Bezier tangents to change the interpolation of your XYZ curves (quaternion curves do not have tangents). To learn more about how the Euler XYZ and TCB Rotation controllers differ from each other, refer to Euler XYZ Rotation Controller on page 3453.

You can switch between Euler XYZ and TCB Rotation controllers via the Quaternion/Euler rollout on page 4693. The Curve Editor on page 4823 displays the animation curves based on the chosen controller. Each curve is labeled starting with one of the following:

- “Quaternion Rotation of the ...”
- “Tangent Euler Rotation of the ...”
- “TCB Euler Rotation of the ...”

You can animate most biped parts (center of mass, pelvis, spine, head, neck, arms, legs, and tail) in Euler. However, fingers and toes are considered differently, as all first base links are controlled as quaternion and any subsequent links as TCB/Euler. Fingers and toes do not have tangents.

Biped limbs with only one degree of freedom (DOF), such as forearms and lower legs, are controlled with a single TCB/Euler curve.

Tangent Euler Rotation curve
NOTE Props are not supported with the Euler controller.

Rotation curves on a biped (including its center of mass) are always set in local parent space, whether they are controlled in Euler or quaternion.

The XYZ function curves of an Euler rotation track are locked together. This means that creating a new key on one axis automatically does so for all axes. Also, moving a key in time drags all three axes with it.

Displaying Position Curves

Beziers position curves are available only for the biped's hands, feet, and center of mass (COM). Hands and feet's positions are set in world space while the COM position is set local to the world.

FK/IK key blending is illustrated as follows:

- Full lines represent IK periods.
- Gaps between lines represent FK periods.
- Vertical dotted lines represent a change in pivot points.

NOTE Keys set to Join to Prev IK Key on page 4598 are locked in value until the next un-joined key.

TIP The Workbench and Curve Editor are synchronized so changing the curve display from the Workbench toolbar on page 4823 also updates the display from the Curve Editor, as well as activate the corresponding tool from the Biped Toolbar on page 3873.
Curve Conversion Between Quaternion and Euler

When an animation converts from one controller to the other, its integrity is maintained as much as possible. This means that despite variations in key interpolation results, the keyframed poses are preserved.

If you convert a quaternion rotation curve to Euler, the resulting tangent keys are set to Smooth. If, on the other hand, you switch an Euler rotation curve to quaternion, the bezier interpolation from the tangents is maintained as much as possible. However, if that interpolation is too extreme and can not be matched by TCB values, it is then reduced to fit under quaternion limits.

Using Euler animations with Layers, Motion Mixer, and Motion Flow

Both Euler tangents and quaternion TCB data are stored in each keyframe. Therefore, even if you are using the Euler XYZ controller, you can still change the profile of your curves using quaternion/TCB control values (on the Key Info rollout).

If you add a new layer to an Euler controlled biped part, that layer is converted into quaternion until it is collapsed back with the original layer. On collapse, the curve changes back into Euler following the same conversion rules stated earlier.

When clips containing Euler animations are brought into the Motion Mixer, Euler tangents are preserved in the blending process. However, once they are mixed together in a mixdown, the resulting animation becomes quaternion.
TIP When creating a mixdown, you can preserve your Euler tangents by turning on A Keyframe Per Frame in the Mixer Preferences dialog on page 4043.

Motion Flow follows the same rules as the Motion Mixer. If clips brought into Motion Flow contain Euler animations, their tangents are preserved. However, creating an unified motion results in a quaternion animation.

TIP Euler tangents can be preserved when creating a unified motion by turning on A Keyframe Per Frame in the Unify Options dialog (by clicking Create Unified Motion in the Motion Flow Scripts Group on page 4896).

![Unify Options](image)

Turn on A Keyframe Per Frame to preserve Euler tangents.

Copy-Pasting Data between Euler and Quaternion Curves

When you copy a track and paste it onto another, its type (Euler or quaternion) is pasted as well. This sometimes results in animations switching from quaternion to Euler and vice-versa.

Euler tangents of copied poses or postures are never copied. If you copy an Euler track and paste it onto any type of track with Auto Key turned on, the current TCB or tangent values (depending on the type of track onto which you pasting) are ignored and instead set to Default.

Following the same rule, pasting a pose or posture on a Euler track with Auto Key turned on doesn't transfer the TCB values of the copied track. If a new key is created before pasting the track, the resulting tangent is set to Default.
Loading and Saving Biped Assets with Euler Curves

When you load an external biped asset file (BIP) onto a biped, they each might contain different animation controllers (for example, a Euler asset loaded onto a quaternion biped). When this happens, the biped animations are converted to match the controller from the biped asset file.

When you save a biped asset file, it stores both Euler tangents and quaternion TCB control values.

**NOTE** While this doesn't affect overall performance, it may slightly impact the biped asset file size.

Working with XRef Bipeds

Using the XRef Objects dialog on page 7456, you can externally reference bipeds in your scene. This lets you work efficiently in a collaborative environment because the changes that the artist applies to his source XRef biped updates your master scene content. See XRef Objects on page 7450 for more information.

Externally Referencing a Biped

When you create an XRef biped, certain modes on the Motion Panel's Biped rollout on page 4669 become unavailable as XRef data is read-only:

- **Figure Mode** on page 4758
- **Footstep Mode** on page 4774
- **Motion Flow Mode** on page 4886
- **Mixer Mode** on page 4102

As a result, you need to go back to the source scene in order to make desired changes to your biped.

Example: Changing the Structure of an Xref Biped

An integrator externally references a biped into his master scene. He discovers that the biped does not have the right number of spine and neck links, and that the arm links are too short to reach a specific goal target. Because Figure Mode is unavailable in the master scene, the artist currently in the source scene inputs the changes to the biped's structure, and then saves his file. This update now reflects in the master scene.
Example: Modifying the Footsteps of an Xref Biped

An integrator externally references a biped into his master scene. He sees the footstep animation but cannot edit it because Footstep Mode is unavailable. The artist currently in the source scene goes into Footstep Mode and alters the animation. This update now reflects in the master scene.

XRef Layer

Externally referencing a biped automatically creates a new “XREF LAYER” in the Layers rollout on page 4741, whether or not the source biped contains any animation. As a result, the original layer becomes a level one “Local Layer” which you can use to add animation on top of it.

NOTE If the XRef biped contains multiple animation layers in the source scene, 3ds Max collapses them into one layer before creating the XRef.

NOTE Saving animation on page 4638 from your XRef biped breaks the XRef link.

Loading, Saving, and Displaying Biped Motion

The topics in this section explain how to load, save, and display biped motion.

Working with Biped Motion Files

character studio uses a variety of file formats to save, load, and edit motion.

■ BIP file (.bip)
  The native character studio file format for saving biped motion. A BIP file saves all information about biped motion: footsteps, keyframe settings including limb rotation, the scale of the biped, the active gravity (GravAccel) value, and prop animation. IK Blend values for the keys and Object Space settings are also saved.
  See Loading and Saving BIP Animation on page 4638.

■ BVH file (.bvh)
  The BioVision motion capture format. Typically, BVH files are obtained from motion capture hardware that records the movements of a human performer. Data saved in a BVH file includes both skeletal data, and information about limb and joint rotations.
NOTE For the BVH file specification, see the BVH.rtf document on the program disc.

■ CSM file (.csm)
The Character Studio Marker format. This is an alternative format for recording motion capture data. It stores positional data for various markers on a biped figure.
See Motion Capture Rollout on page 4925.

NOTE For the CSM file specification, see the CSM.rtf document on the program disc.

■ MIX file (.mix)
A MIX file contains data from the Motion Mixer, such as trackgroups, tracks, and transitions.
See Using the Motion Mixer on page 4002.

■ MFE file (.mfe)
The Motion Flow Editor format saves scripts you create in the Motion Flow Editor, including clip references and transitions.
See Motion Flow Mode on page 4886.

■ MNM file (.mnm)
The Marker Name File format matches custom marker names in a CSM or BVH file with the standard, preset marker names used by a biped.

NOTE For BVH and CSM file specifications, see the BVH.rtf and CSM.rtf documents on the program disc.

■ STP file (.stp)
The Step file format saves footstep data. Unlike a BIP file, it does not save keys for the feet or upper body. STP files are ASCII files. The main purpose for this format is to enable developers to write programs that generate step files. Biped can later be used to create keys for the software-generated footsteps.
See Loading and Saving STP Files on page 4646.

Motion File History Lists

The file dialogs for Biped motion files include a history list that lets you quickly choose directories where you have recently saved or opened files. 3ds Max maintains a separate history list for each type of motion file.
NOTE When you load or save motion flow snippets, or mixer clips through the reservoir, if a file is already specified for that snippet or clip, its directory will appear at the top of the history list, even if that directory was not originally in the history list. If you cancel the load or save of the snippet or clip, that directory will not be added to the history. If you go ahead and load or save the snippet or clip, the directory will be added to the history.

Loading and Saving BIP Animation

Biped motion (BIP) files have a `.bip` file name extension. They save all information about biped motion: footsteps, keyframe settings including limb rotation, the scale of the biped, and the active gravity (GravAccel) value. IK Blend values for the keys and Object Space settings are also saved.

IK objects, props and other objects in the scene can also be saved with the BIP file.

There are several ways to create or acquire `.bip` files:

- By loading one of the sample animation files that come with 3ds Max. Refer to the Installation Guide for more details.

- By creating your own animation with footsteps or freeform methods, and saving the animation with the Save button in the Biped rollout. See the procedures that follow.

- By loading and filtering a motion capture file, then saving the animation with the Save button in the Biped rollout. See Filtering Motion-Capture and Marker Data on page 4919.

When you save a Motion Mixer on page 4002 (MIX) file or a Motion Flow Editor on page 4848 (MFE) file, the paths to the referenced BIP files are also saved. If these paths are broken (for example, if the BIP files have been moved or renamed), a Missing Motion Mixer Files dialog or Missing Motion Flow Files dialog, respectively, opens listing the missing files. To rectify this, open the Asset Tracking dialog on page 7586 and set a new path for the files.
Procedures

To load biped motion from an existing BIP file:

1. Select the biped you want to animate, and go to the Motion panel.

2. On the Biped rollout, make sure you are not in Figure mode, and click Load File.

   **NOTE** When Figure mode on page 4758 is active, the Load File option loads figure (FIG) files. Anything done in Figure mode changes the basic shape and structure of the biped. When Figure mode is turned off, the Load File tool loads BIP files, which animate the figure.

3. In the file dialog, choose the BIP motion file to load, and then click OK.

4. The biped repositions itself in the scene, as it assumes the initial position of the animation file. You might need to use Zoom Extents to see the biped after it is repositioned.

   **TIP** The Biped keyboard shortcut Alt+R sets the animation range to that of the currently selected biped. Since the length of the animation can change after loading a BIP file, this keystroke can be useful. To use it, make sure that the Keyboard Shortcut Override Toggle is active.

To save animation you have created or imported to a BIP file:

1. Animate the biped with footsteps and/or freeform animation.

2. Select the biped that has the animation you want to save, and go to the Motion panel.

3. On the Biped rollout, make sure you are not in Figure mode, and click Save File.

4. In the file dialog, enter a name for the motion file, and then click OK.
Importing and Exporting Animation Data

You can use character studio with 3ds Max FBX import/export support to simplify the animation of 3ds Max bones. To transform an animated biped into a set of animated bones, export it to FBX on page 7706 and then import your file.

Click the Help button on the FBX dialog to view the latest 3ds Max FBX Plug-in Guide.

Motion Mapping: Retargeting Biped Motion

One of the more powerful features of Biped is the ability to retarget or map the motion of any biped onto any other biped.

If you map the motion of a biped without a tail onto a biped with a tail, default tail motion for the biped with a tail will be computed. Default motion will also be computed when mapping the motion of a biped with fewer links in the legs, spine, or neck onto a biped with more links in the legs, spine, or neck. There are a few ways to perform motion mapping. You can:

- Go into Figure mode and change the structure of your biped. When you exit Figure mode, the new structure of the biped will adapt to the existing animation.
- Save a BIP or STP file from one biped, and load it onto another biped of a different structure and size.
- Copy footsteps from one biped, and paste them onto the footsteps of a differently structured and scaled biped.

Scale Stride Mode

Scale Stride mode gives you control over whether or not certain aspects of motion mapping occur.

If Scale Stride mode is active (the default):

- When you exit Figure mode after loading a FIG file or changing the biped's leg length, pelvis width, or height, the locations of the footsteps will be scaled to match the leg length and pelvis width, and gravity will be changed to match the new height of the biped.
When you load a BIP or STP file, the locations of the footsteps in the file will be scaled to match the leg length and pelvis width of the existing biped. Gravity will be adjusted to be proportional to the gravity stored in the file. (A motion stored in a BIP or STP file has a gravity value associated with it.)

When you paste footsteps copied from one biped onto another biped, the locations of the footsteps in the buffer will be scaled to match the leg length and pelvis width of the existing biped. Gravity will be adjusted to be proportional to the gravity stored in the file. (A motion stored in a BIP or STP file has a gravity value associated with it.)

If Scale Stride mode is not active, no computations will be performed in any of the above cases. Then you might see your biped moving over footsteps that are spaced inappropriately far apart or close together for the size of your biped. Typically, you should leave Scale Stride mode active, unless you want to maintain the spatial relationship between the biped and other objects in your scene.

**Procedures**

**To turn off Scale Stride mode:**

1. Select the biped, and go to the Motion panel.
2. On the Biped rollout, click the bar at the bottom to expand the rollout. (If the rollout is already expanded, the bar shows a minus sign at the left, instead of a plus.)
3. In the Modes group, click Scale Stride Mode to turn it off. The button changes to indicate stride scaling has been turned off.
4. Use Figure mode to edit the figure. When you return to Keyframe mode or Footstep mode, the biped's stride length is unchanged, regardless of the biped figure's new proportions.
Merging and Cloning a Character

At some point you might need to use the File > Merge command to merge a character into your scene. Also, you can use Merge to clone a biped that has a mesh with the Physique modifier applied, as described in this topic.

Cloning a Character

To clone a character (that is, a biped with a Physique mesh), save a scene that contains the character, change the original biped's name, and then use File > Merge to merge the copy from the saved file. You can merge from a saved version of the scene that is currently open. See the procedures for details.

Procedures

To merge a skinned biped:

1. Before you merge, make sure the root name of the biped you want to import is different from that of bipeds already in your scene. If there is a name conflict, select the conflicting biped, go to the Motion panel, and use the Structure rollout's Root Name field to change the biped's root name.
   If you skip this step, you will get a Duplicate Name dialog for every object in the merged biped's hierarchy!

2. Choose File > Merge, then choose the MAX file that contains the biped to import.
   The Merge dialog displays.

3. Click to turn on Select Subtree in the Merge dialog.

4. Locate and click the biped's center of mass name in the Merge dialog list. The default name for the biped center of mass is Bip01. If the biped was renamed on the Structure rollout, find the renamed center of mass in the list.
NOTE The center of mass is the root object in the biped hierarchy, if this is selected with Select Subtree turned on, then all the child links are selected, including extra bones and the mesh skin (the mesh skin is linked when Attach To Node is used in Physique).

In the illustration, the center of mass object is named *Hero*. With Select Subtree active, all the children are also selected when you click *Hero*, including the Physique mesh.
5  Click OK.
   Probably a Duplicate Name dialog is displayed. If it isn’t, the merge is done; if it is, see the following step.

6  On the Duplicate Name dialog, turn on Apply To All Duplicates, and then click Merge.

   **NOTE** Even when the bipeds in your scene have different root names from the biped you are merging, the biped finger/toe/head dummies in the file to be merged can have the same names as other biped dummies in your scene. This step merges these dummy objects. Dummies with duplicate names can appear in the Select From Scene dialog, so the duplicate names are not a problem.

   The biped and its animation is merged with the scene.

**To hide the finger, toe, and head dummy objects:**

The dummy objects for fingers, toes, and the head are visible on the newly merged biped. Usually these dummies are hidden from sight. They are used by Physique to create envelopes for all the finger tips, toe tips, and head; these dummies display when a character is merged. The quickest way to hide them again is simply to toggle the Objects button in the Biped rollout’s Display group, as described in these steps.

1  With the merged biped still selected, go to the Motion panel.

   ![Fingertip dummies displayed as blue cubes](image)

   The number of biped dummies varies according to how many fingers and toes the character has.
At the bottom of the Biped rollout, click the bar by the plus sign to expand the rollout.
(If the rollout is already expanded, the bar shows a minus sign at the left, instead of a plus.)

In the Display group, turn Objects off and then back on again to hide the biped finger/toe/head dummy objects.

**To clone a skinned biped:**

1. Save a copy of the scene that contains the biped you want to clone.
2. On the Structure rollout, change the original biped's root name, as described above.
3. Merge the saved biped, as described in the previous procedure, “To merge a skinned biped.”
   The original biped, with its Physique modifier, is cloned. It appears in the same location as the original biped.
4. On the Motion panel, on the Biped rollout, turn on Move All Mode.
5. Use Select And Move to move the clone to a new location in the scene.

**Combining BIP Motions**

*character studio* provides two main ways of combining BIP files to build more complex character animations: Motion Flow and the Motion Mixer.

- **Motion Flow** on page 4848 uses BIP files as *clips* in a *script*. The motion-flow script joins clips together using *transitions*. Transitions can be unconditional, they can be chosen at random, or they can be governed by rules such as collision detection. You can control when a transition begins and ends. You can use motion flow to animate a single biped, or a crowd of bipeds. Motion flow scripts are saved as Motion Flow Editor (MFE) files.

- The **Motion Mixer** on page 4002 also uses BIP files and MFE files as clips. In addition to creating transitions from one BIP animation to another, over
Mixer scripts can combine the upper-body movement of one biped with the lower-body movement of another, adjust the timing of movements, and provide a number of other effects. The Mixer is especially useful when you work with motion-capture files on page 4916. Mixer scripts are saved as BIP files or MIX files.

### Loading and Saving STP Files

Step (STP) files save footsteps, but don't save body keyframes.

The STP file format is an ASCII format that enables developers to write programs that generate step files for biped motion. The online document stp.rtf, provided with character studio in the ..\cstudio\docs directory, describes the STP format.

#### Procedures

**To load footprint data:**

1. Select the biped to animate via saved footsteps, go to the Motion panel.
2. On the Biped rollout, make sure you are not in Figure mode, then click Load File.
3. In the file dialog, choose Step Files (.STP) as the file type to load.
4. Choose the footprint file to load, and then click OK.

The footsteps are loaded onto the biped, and new default keys are generated to match the footsteps.

**To save footprint data:**

1. Select the biped whose footsteps you want to save, and go to the Motion panel.
2 On the Biped rollout, make sure you are not in Figure mode, then, click Save File.

3 In the file dialog, choose Step Files (.STP) as the file type to save.

4 Enter a name for the footstep file, and then click OK.

Using Motion-Capture Data

Besides animating a biped with footsteps or with keyframing (freeform animation), you can import a motion-capture file.

The overall workflow for motion capture is straightforward:

- Import the motion-capture data
  See Importing Motion-Capture Data on page 4918.

- Filter the data
  Motion-capture files are typically dense, with keys on every frame. Filtering the data reduces the number of keys, resulting in an animation with better performance. You filter the data with the Motion Capture Conversion Parameters dialog on page 4934. This dialog can reduce large numbers of keys at once. It is displayed when you use the Motion Capture rollout to load a BIP, BVH, or CSM file. Once you have loaded a motion-capture file, you can filter the data further by clicking Convert From Buffer (also on the Motion Capture rollout), which also displays this dialog.
  See Filtering Motion-Capture and Marker Data on page 4919.

- (Optional) Edit the data
  Once you are happy with the converted animation, you can use the freeform animation tools to make specific changes.

TIP The Motion Mixer on page 4002 provides another way to edit motion-capture data.

Motion-capture files can be one of three file types: the native character studio BIP format, the BioVision (BVH) format, or the Character Studio Marker (CSM) format.

For an introduction to using motion capture, see the tutorial “Working with Motion-Capture Data.”
Correcting Posture

A particular motion file might position a biped body part inappropriately. For example, the collarbones might be rotated down too far, affecting your mesh deformation. All you need to do is go into Figure mode, rotate the biped collarbones up, and then exit Figure mode: this corrects the collarbone position for the entire animation. The motion references the Figure mode position, if the biped is adjusted, and this adjustment is reflected in your animation when you exit Figure mode.

**TIP** Save a FIG file for the biped pose you used when you applied Physique. Then you can use the FIG file to reload this position if you need to reapply the Physique modifier or reinitialize the Physique settings.

How Biped Uses Figure Mode

When you animate the biped, the Biped plug-in maintains the at-rest pose you have created for these elements of the biped body:

- Spine
- Neck
- Clavicles
- Tail
- Ponytails
- Center of mass position, relative to the body.

When Biped adapts the keyframed motions stored in BIP files to different characters, the keyframes of the above elements are recreated as an offset from the at-rest posture associated with each character's figure. The at-rest posture associated with the arms and legs is always assumed to be a standing posture, with straight legs.

Restructuring a Biped to Match a BIP File

When you load a BIP file, there is an option to restructure the biped to match the file. If you turn this on when you load the file, the biped's structure will change to match the figure of the biped in the BIP file.
Talent Figure Mode and Adjust Talent Pose

Talent Figure Mode on page 4932 and Adjust Talent Pose on page 4933 on the Motion Capture rollout have a purpose similar to that of Figure mode. They are used to size and position biped body parts to better fit raw motion capture data. After importing motion capture data, you might discover that certain biped limbs or the biped scale need a global adjustment in order to provide a closer match to the figure of the talent who performed the motion.

See also:

- Motion Capture Rollout on page 4925

Copying and Pasting Tracks

Biped’s Copy/Paste rollout on the Motion panel provides controls for copying and pasting biped tracks from one part of the biped to another, or from one biped to a different biped. At the top of this rollout are three buttons: Posture, Pose, and Track.
This section covers the copying and pasting of tracks. For information on the other options on this rollout, see Copying and Pasting Postures and Poses on page 4619.

To copy and paste biped tracks, turn on Tracks. The remaining controls in the rollout change to reflect that you are working with tracks:

■ The copy button changes to a Copy Tracks button.

■ The two Paste buttons become Paste Tracks and Paste Tracks Opposite, respectively.

■ The Paste Horizontal, Paste Vertical, and Paste Rotation buttons in the Paste Options group become active.

**Procedures**

**To copy a track from one biped to another:**

1. Select any part of the biped and access the Motion panel.

2. On the Copy/Paste rollout, click Create Collection and rename the new collection *Biped Track*.

3. Click Track to use Track mode. Then, select the biped parts whose tracks you want to copy.

4. Click Copy Track.

   Biped creates a new track buffer, and adds it to the list as the active buffer. The buffer’s name indicates which biped parts you selected.

5. Select any part of the other biped.

6. In the Paste Options group, enable all three Paste buttons.

7. Click Paste Track or Paste Track Opposite.
The tracks for all biped parts are applied to the other biped regardless of which parts are selected on the biped.

Repositioning the Biped

The method you should use to reposition a biped depends on which tools were used to animate the biped.

- If the biped uses freeform or footstep animation, use Move All mode. This is also the easiest way to move a biped that is not animated.
- If the biped uses freeform animation \textit{and} IK attachment (that is, there are keys where IK Blend is greater than zero), then you need to use a dummy object.
- If the biped is animated with motion flow, use the Start Position spinners.

Procedures

\textbf{NOTE} The procedures in this topic assume that you have already selected the biped and gone to the Motion panel.

To reposition a freeform animation (with no IK attachment) or a footstep animation:

1. On the Biped rollout, turn on Move All Mode.
   
   The biped's center of mass is selected and displayed in a larger-than-usual size. On the main toolbar, Select And Move is turned on.
   
   Move All mode is a convenient way to select the biped's center of mass, and to reposition the biped. Use it when the biped is not yet animated, when the biped has freeform animation with no IK attachment, or when it has footstep animation.

   \textbf{NOTE} The alternative way to move a biped with footstep animation is to select all of its footsteps, rather than its center of mass.

2. Move the biped.
The Collapse button on the Move All dialog box allows you to reset the position and rotation values in the Move All dialog to zero, but does not change the position of the biped.

3 Turn off Move All Mode.

To reposition a biped with limbs attached to an Object Space object (IK attachment):

1 Create a dummy object and position it near the biped’s center of mass.

2 On the main toolbar, use Select And Link to link both the Object Space object and the biped’s center of mass to the dummy object.

   IMPORTANT Make sure you link both at the same frame.

3 Move the dummy object to reposition the biped.

To reposition a biped with limbs attached to world space (IK attachment):

A biped with limbs in world space has an IK Blend setting of 1.0 for each limb, with no Object Space object specified. For example, when you plant the feet of a biped so its knees will bend when you lower its center of mass, or you plant the hands of a biped doing pushups, typically you do not specify an Object Space object.

1 Create a dummy object near the biped’s center of mass.

2 On the main toolbar, use Select And Link to link both the biped’s center of mass and the biped part with planted keys to the dummy object.

   TIP To be on the safe side, you can double-click the upper limb and link all of the limb to the dummy.

   IMPORTANT Make sure you create all links at the same frame.

3 Move the dummy object to reposition the biped.
NOTE Depending on the animation, at some of attached object’s keys you might need to set IK Blend back to 0.0. Otherwise, the limb can get “stuck” in a posture.

To reposition a biped animated with a motion flow script:
By default, the biped's position at the beginning of a motion flow script is the position specified by the first BIP or STP file in the script.

1. Turn on Motion Flow mode.
3. Turn off Motion Flow mode.

To use layers to reposition a biped with freeform animation:
Using layers and Auto Key when you reposition a freeform biped gives you some editing choices, as described below.

1. On the Layers rollout, click Create Layer.

   NOTE If the biped uses footstep animation, the Move All Mode button will become unavailable.

2. Turn on Auto Key.
3. Reposition the biped as described in the previous procedure, “To reposition a freeform animation (with no IK attachment) or a footstep animation.”
4. Turn off Auto Key.
You now have these aids to animation editing:

- Lower layers show the biped's original position, as does the red stick figure.
- Clicking Snap Set Key on the Layers rollout snaps the biped to its position on the previous layer, and sets a position key. The animation is blended between the biped's new position and its previous position at frames where the key is set.

**Previewing Biped Motion**

There are two types of animation playback available within character studio: the 3ds Max Play Animation button and the Biped Playback button.

- You can use the Play Animation button in the viewport playback controls to play biped animation, the same as you can any other 3ds Max animation.
- Use the Biped Playback button on page 4670 on the Biped rollout to play back the animation with the biped displayed as a stick figure, while hiding everything else in the scene.

**NOTE** It is possible to turn on both buttons at once. This is not recommended. Depending on your system configuration, turning on Play Animation and Biped Playback at the same time can considerably slow down performance.

**Biped Playback**

Biped playback previews the motion of all existing, visible bipeds. If you hide a part or all of biped, the hidden biped or biped part does not appear in the Biped playback. Objects in the animation that are not bipeds do not appear in Biped playback. If the 3ds Max home grid is visible, a grid appears at Z=0 in the Biped playback viewport.

While Biped controls are visible in the Motion panel, you can also press V to start or stop Biped Playback. For this keyboard shortcut to work, the Keyboard Shortcut Override Toggle must be turned on.
Biped always previews the existing animation range. Biped Playback responds to the parameters in the 3ds Max Time Configuration dialog. If Real Time playback is chosen in this dialog, Biped plays back at the current frame rate, sometimes skipping frames if necessary. If Real Time is turned off, Biped plays back as fast as it can, depending on the capacity of the graphics card installed on your system.

**NOTE** Hardware acceleration has no effect on Biped playback. If you are using a hardware-accelerated display card, you might find 3ds Max playback to be faster under certain circumstances.

**Procedures**

**To preview biped motion using biped playback stick figure:**

1. Activate the viewport with the view you want to see.
2. Hide or show the bipeds you want to appear in the playback.
3. Select one of the visible bipeds, and go to the Motion panel.
4. On the Biped rollout, click Biped Playback.

   Stick-figure biped animation plays back in the active viewport. Animation plays back for all visible bipeds.

**To preview biped motion using the full biped model:**

1. Drag the time slider.
2. Click Play Animation.

Biped animation plays back in the active viewport.

Depending on your system, biped animation might not play back in real time using 3ds Max viewport playback.

**WARNING** You might miss critical frames of your animation if Real Time is selected in the Time Configuration dialog.
In Place Mode

Create or select a biped. > Motion panel > Biped rollout > Expand rollout > Modes group > In Place button on In Place flyout

**In Place mode** on page 8608 allows you to display biped motion as if it were occurring on a treadmill. Regardless of the distance the biped covers under control of the current motion file, the biped stays within the active viewport when you’ve turned on In Place Mode.

In Place playback prevents lateral (XY) movement of the biped center of mass during animation playback; vertical motion along the Z-axis is preserved. Biped limbs, footsteps, and center of mass keys can be adjusted in this mode. When the center of mass is moved on the XY axes in this mode, the footsteps move.

Use this feature to view biped playback without requiring a follow camera. In this viewing mode, visible footsteps appear to slide under the biped.

For export to games, this feature is valuable, as many game engines intelligently move the character’s center of mass laterally according to game play. In Place mode makes it easy to view, tune, and export animation in a manner that is complementary to game engine playback.

**NOTE** Trajectories do not display using In Place mode.

**In Place Mode Options**

The In Place Mode button is the default button on a three-button flyout. There are two further options:

- **In Place X Mode**  Locks center of mass X-axis motion. Use this for game export where the character stays in place but the swinging motion of the hips and upper body along the Y-axis is preserved.

- **In Place Y Mode**  Locks center of mass Y-axis motion. Use this for game export where the character stays in place but the swinging motion of the hips and upper body along the X-axis is preserved.
Using In Place Mode to Adjust Keyframes

In Place Mode is a good way to adjust keys on a biped that already has animation applied to it. Rather than scrolling the view at different frames to keep a running biped visible, turn on In Place Mode. Now when you scrub the time slider, or use the Next Key and Previous Key buttons, the biped remains visible. A key that needs adjustment can be quickly spotted and corrected.

**TIP** Judging lateral center-of-mass motion using In Place mode is difficult. In Place mode limits center-of-mass motion on the XY axes; all sense of body momentum on these axes is suspended during playback. You might want to turn off In Place playback to gain a sense of lateral momentum when setting or adjusting horizontal keys (Body Horizontal Track) for the center of mass.

Procedures

**To use In Place mode to adjust keyframes:**

1. Select a biped that has animation, and go to the Motion panel.
2. On the Biped rollout, click the bar at the bottom to expand the rollout. (If the rollout is already expanded, the bar shows a minus sign at the left, instead of a plus.)
3. In the Modes group, click In Place Mode to turn it on.
4. At the bottom of the 3ds Max window, turn on Auto Key.
5. Find a frame where the biped needs adjustment, and modify or add keys.

Trajectory Display

When a biped is animated, you can view its motion not only using Biped Playback, but you can also see the path, or trajectory, the biped (or selected biped links) follows throughout the motion.
Display of the trajectory of a biped's lower spine

You turn on trajectory display by clicking Trajectories in either of these user-interface locations:

- Motion panel > Biped rollout > Expand Biped rollout > Display group > Trajectories button
- Motion panel > Key Info rollout > Trajectories button

**TIP** Do not use 3ds Max trajectory controls to display or edit biped trajectories. These include the options accessed with Object Properties > Display Properties > Trajectory on the quad menu, and those under Motion panel > Trajectories text button.

Trajectories provide useful visual feedback as you edit keys, showing the effects on the motion path for the parameters you're adjusting. You also can use trajectory display to compare filtered and unfiltered motion capture data.

Changes to Tension, Continuity, Bias, Dynamics Blend, Ballistic Tension, and the overall gravity setting GravAccel are reflected in the trajectories.

**NOTE** Trajectories do not display while you play an animation using In Place mode.

You can customize the trajectory information for the selected biped link by using the Display Preferences dialog on page 4684. You can choose between Bone Base and Bone Tip, show an entire trajectory, or a moving range of frames.
See also:

- Biped Color-coded Keys and Trajectories on page 4806

Procedures

To edit biped trajectory keys in a viewport:

1. Select an animated biped and go to the Motion panel.
2. On the Track Selection rollout, turn on Body Horizontal or Body Vertical.
3. At the bottom of the Biped rollout, expand the Modes And Display sub-rollout if necessary by clicking its name.
4. In the Display group, turn on Trajectories.
5. Turn on Sub-Object selection level.
6. On the main toolbar, turn on Select And Move.
7. Use the Transform gizmo to move the keys on the trajectory.

Display Preferences

The Display Preferences dialog on page 4684 lets you customize how bipeds are displayed while you work with them. This topic introduces some of the commonly used options.
Use controls on this dialog to change footstep, trajectory, and playback display.

In the Trajectories group, you can choose between the Bone Base or Bone tip for trajectory display. You can show the entire trajectory, or define a range of frames for partial trajectory display.

In the Footsteps group, you can choose colors for the left and right footsteps, and generate various colors or standard colors in the viewport or Track View. You can also Show or Hide All Footsteps or Footstep Numbers.

In the Playback group, you can define which bipeds will appear in Biped Playback. (This can be useful for speeding performance if your scene contains a number of bipeds.)

See also:

- Display group on page 4674
Biped User Interface

The Biped user interface is split up into “modes” of operation. You activate these modes by selecting the appropriate button in the Biped rollout on the Motion panel, which is visible when a biped is selected.

There are four modes available:

- **Figure mode** is used to change the biped skeletal structure and to align the biped to a mesh.
- **Footstep mode** is used to create and edit footstep animation.
- **Motion Flow mode** is used to create scripts that combine motion files into longer animations.
- **Mixer mode** is used to view, save, and load animation created with the Motion Mixer.

As with other parts of 3ds Max, the rollouts change depending on the mode **character studio** is in. When no modes are active, the following rollouts are displayed:

- **Assign Controller Rollout** (character studio) on page 4666
- **Biped Apps Rollout** on page 4668
- **Biped Rollout** on page 4669
- **Track Selection Rollout** on page 4686
- **Quaternion/Euler Rollout** on page 4693
- **Twist Poses Rollout** on page 4695
- **Bend Links Rollout** on page 4700
- **Key Info Rollout** on page 4704
- **Keyframing Tools Rollout** on page 4717
- **Copy/Paste Rollout** on page 4726
- **Layers Rollout** on page 4741
The Assign Controller, Biped Apps, and Biped rollouts are displayed during all modes. The remaining rollouts depend on the mode.

In Figure mode, Structure is the only additional rollout.

In Footstep Mode, the rollouts displayed are: Footstep Creation, Footstep Operations, and Dynamics & Adaptation.

In Motion Flow mode, Motion Flow is the only additional rollout displayed.

In Mixer mode, Mixer is the only rollout displayed.

When no modes are active, you can edit tracks and keys, set IK constraints, work with layers, and work with motion capture data. You can also create freeform animation without any of the modes active simply by turning on the Auto Key button and moving or rotating any part of the biped.

**Motion Panel (Biped)**

Once you have created a biped, use the Biped controls on the Motion panel to animate the biped, load and save Biped files, and fit the biped to a mesh representing your character.

Create a biped if one does not exist, and select any part of the biped to see the controls on the Motion panel.

Depending on the active mode, the Motion panel contains the following rollouts:

- **Assign Controller Rollout (character studio)**
- **Biped Apps Rollout**
- **Biped Rollout**
- **Track Selection Rollout**
- **Copy/Paste Rollout**
- **Footstep Creation Rollout**
- **Footstep Operations Rollout**
- **Motion Flow Rollout**
The parent object of the biped is its center of mass, which appears as a blue octahedron near the center of the biped’s pelvis. The name of this object is the root name of the biped (*Bip01* by default).

The Center of Mass (COM) object is the root parent.

The center of mass is sometimes referred to as the COM.
**Center of Mass Animation Tracks**

Unlike other objects and biped body parts, the center of mass has three separate animation tracks:

- Body Horizontal
- Body Vertical
- Body Turning (selected with the Body Rotation button)

You can use these buttons, available on the Track Selection rollout on page 4686, to select each track as well as the COM itself.

**Rotating About a Different Pivot Point**

You can “decouple” rotation from the COM, and rotate the biped about a pivot point you choose. For instructions on how to do so, see To rotate the biped about a pivot that is not the COM on page 4689.

![Left: Pivot point moved to be near the biped’s feet. Right: Rotating the biped after moving the pivot.](image)

**Linking the Center of Mass Object**

Using the Select And Link tool on page 3631 you can link the center of mass object to another object if you need to reposition an animation sequence. An
example of this might be a surfer. You could create an animation of a biped running up and down the surfboard, hanging its toes off the end of the surfboard, and so on, and then link the center of mass object to the board. When you animate the surfboard, the biped animation would travel with it.

![Biped animation on surfboard](image)

The biped moves with the surfboard because the center of mass is linked to the surfboard.

Because the COM is the root object in the biped hierarchy, it is the only object in the biped that you can link directly to other objects in the scene by using Select And Link. To make other body parts, such as feet and hands, follow other objects in the scene, use the technique of IK attachment: see Animating IK Attachments on page 4616.

**Center of Mass Shadow**

The center of mass shadow object, the circle between the biped’s feet on the world plane, provides a sense of the position of the character’s center of mass, relative to the feet. Another use of the center of mass shadow is to link objects to it. For example, you might link a camera and its target to the shadow object, to make the camera to follow the character.
The center of mass shadow between the biped's feet.

**Motion Panel Rollouts (Biped)**

These topics describe the main Motion panel rollouts for Biped.

**Assign Controller Rollout (character studio)**

Select a biped's COM. > Motion panel > Assign Controller rollout

The Assign Controller rollout assigns and appends different transform controllers to individual objects. You can also assign controllers in Track View. Animation controllers are plug-ins that handle all of the animation tasks in 3ds Max. For a complete list of available Animation controllers, see Assign Controller on page 3897.
Interface

Assign Controller  Displays a selectable list of controllers for a selected track.

Once controllers have been added, right-click the Biped SubAnim entry in the list and choose Properties to display the SubAnims dialog.
Enable section

Enable  Selectively activates or disables the three list controllers. Choose any combination of Position, Rotation, and Scale.

Position List  When turned on, selects the Position controller to be collapsed into the Biped SubAnim track.

Rotation List  When turned on, selects the Rotation controller to be collapsed into the Biped SubAnim track.

Scale List  When turned on, selects the Scale controller to be collapsed into the Biped SubAnim track.

Collapse section

Position  Collapses the Position controller when you click Collapse.

Rotation  Collapses the Rotation controller when you click Collapse.

Don't Delete  Prevents the removal of the list controller after collapsing and hides the controller instead.

Per Frame  Creates a key per frame during the collapse, preventing the controller from collapsing onto the key times of the biped and SubAnim controller.

Collapse  Performs the collapse.

Biped Apps Rollout

Select a biped. > Motion panel > Biped Apps rollout

The Biped Apps rollout allows you to choose either of two tools for working with the biped motion.

Interface

Mixer  Opens the Motion Mixer, where you can layer animation files to customize biped motion.
See Using the Motion Mixer on page 4002.

**Workbench** Opens the Workbench, where you can analyze and adjust biped motion curves.
See Working with the Workbench on page 4816.

## Biped Rollout

Select the biped > Motion panel > Biped rollout

Use controls on the Biped rollout to put the biped into Figure, Footstep, Motion Flow, or Mixer modes, and to load and save BIP, STP, MFE, and FIG files. You'll find other controls on the Biped rollout, as well.

The Modes group on the Biped rollout lets you turn on the Buffer, Bend Links, Rubber Band, Scale Stride, and In Place mode.

The Display group on the Biped rollout lets you adjust how the biped is displayed, providing controls to show or hide Objects, Bones, Footsteps, and Trajectories.

In addition, the Biped rollout provides controls for converting footsteps into a freeform animation, or a freeform into a footstep animation.

**NOTE** The Modes group, Display group, and Name field are hidden by default. Click on the Modes and Display expansion bar to display them.

## Interface

![Biped Rollout Interface](image)

**Figure Mode** Use Figure mode on page 4758 to fit a biped to the mesh or mesh objects representing your character. Leave Figure mode on when you attach the mesh to the biped with Physique. Figure mode is also used to scale a biped with a mesh attached, to make biped "fit" adjustments after Physique.
is applied, and to correct posture in motion files that need a global posture change.

The **Structure Rollout** on page 4762 appears when Figure mode is active.

**NOTE** When Figure mode is turned on, the biped jumps from its animated position to its Figure mode pose. Animation is preserved when you exit Figure mode.

**Footstep Mode** Create and edit footsteps; generate a walk, run, or jump footstep pattern; edit selected footsteps in space; and append footsteps using parameters available in Footstep mode.

Two additional rollouts display on the Motion panel when **Footstep mode** on page 4774 is active:

■ **Footstep Creation rollout** on page 4774

■ **Footstep Operations rollout** on page 4778

**Motion Flow Mode** Create scripts and use editable transitions to combine BIP files together to create character animation in **Motion Flow mode** on page 4886. After creating a script and editing transitions, use Save Segment on the Biped rollout to store a script as one long BIP file. Save an MFE file; this enables you to continue Motion Flow work in progress.

**TIP** Use Motion Flow mode to cut motion capture files together.

**NOTE** The **Motion rollout** on page 4888 appears when Motion Flow mode is active.

**Mixer Mode** Activates any current **Mixer** on page 4002 animation on the Biped and displays the **Mixer rollout** on page 4102.

**Biped Playback** Plays the animation for all bipeds unless they are excluded on the **Display Preferences dialog** on page 4684. This playback mode usually gives real-time playback, which you may not get if you use Play on the 3ds Max toolbar.

**NOTE** In Biped Playback mode, the biped is displayed as bones only, with no other scene objects visible.
Load File  The Open dialog on page 4680 lets you load .bip, .fig or .stp files.

Save File  Opens the Save As dialog on page 4676, where you can save Biped files (.bip), figure files (.fig), and step files (.stp) files.

Convert  Convert a footstep animation to a freeform animation. This works in both directions. Displays the Convert to Freeform dialog on page 4795 or Convert to Footsteps dialog on page 4795 depending on the direction.
- Convert uses biped foot IK Blend values to extract footsteps.
- Use Convert to extract footsteps from an animation saved using Save Segment in Motion Flow mode.
- Convert the animation in either direction depending on how you like to work. Convert to freeform for unrestricted key editing. Convert to footsteps to take advantage of footsteps.

Move All Mode  Allows the biped to be moved and rotated with its relative animation intact. You can transform the biped interactively in the viewport or with the dialog box that opens when the button is active.
When this button is active, the biped’s center of mass enlarges to be more easily selected for translation.
The Collapse button on the Move All dialog box allows you to reset the position and rotation values in the Move All dialog to zero, but does not change the position of the biped.

Modes group

NOTE  The Modes group is hidden by default. To display it, click on the Modes & Display expander in the Biped rollout.

Buffer Mode  Edit segments of an animation in Buffer mode. Copy footsteps and associated biped keys into the buffer using Copy Footsteps on the Footstep Operation rollout first, then turn on Buffer mode to view and edit the copied segment of your animation.
Tip Paste buffered motion back to the original animation repeatedly to create looping motions.

Edit footstep and biped animation that have been copied into the buffer using Copy Footsteps on the Footsteps Operation rollout. The changes can be pasted back by turning off Buffer Mode, turning on Paste Footsteps on the Footstep Operation rollout, and overlapping the buffered footsteps with the original footsteps. The buffered motion is spliced into the original animation.

Rubber Band Mode Use this to reposition the biped elbows and knees without moving the biped hands or feet in Figure mode. Reposition the biped center of mass to simulate the physics of wind or weight pushing against the biped. Figure mode must be turned on to enable Rubber Band Mode.

To reposition biped knees and elbows, turn on Figure mode and turn on Rubber Band mode. Select the Move transform tool, then select and drag a biped upperarm or thigh in the viewports. Use this as an aid to fitting a biped to a mesh.

To reposition the biped center of mass relative to the rest of the biped skeleton, turn on Figure mode and turn on Rubber Band mode. Select the Move transform tool, then select and drag the center of mass in the viewports. Use this to account for wind force or pushing against a heavy object. See Shifting the Biped’s Balance on page 4550.

Moving the biped center of mass (blue diamond) behind the character, turns this default walk cycle into a struggle against a high wind.
NOTE Rubber Band mode behaves differently than Non-Uniform Scale. For example, if you "Rubber-Band" the biped thigh, the thigh and biped calf objects scale proportionally to keep the biped foot stationary. Using Non-Uniform Scale, the calf retains its scale and the foot moves.

Scale Stride Mode Footstep stride length and width are scaled to match the stride length and width of the biped figure. Scale Stride mode is on by default.

Displays when Scale Stride mode is off.
Scale Stride mode is on by default, so scaling occurs automatically when you load a .bip, .stp, or .fig file. Scaling occurs when you paste footsteps and when you scale the biped's legs or pelvis.
For example, if you load a .bip file that was saved from a larger biped, the footsteps come into your current scene scaled to match the selected smaller biped. If Scale Stride mode is off, the footsteps come into the current scene without being scaled down.
If you turn off Scale Stride mode and then go into Figure mode and scale the biped up or down, the footstep stride width and length remains the same when you exit Figure mode.

In Place Mode Use In Place mode to keep the biped visible in the viewports while the animation plays. Use this for biped key editing or adjusting envelopes with Physique. It prevents XY movement of the biped center of mass during animation playback; however, motion along the Z axis is preserved. This is a three-button fly-out. In Place mode is stored with the 3ds Max file.

In Place X Mode Lock center of mass X-axis motion. Use this for game export where the character stays in place but the swinging motion of the hips and upper body along the Y-axis is preserved.

In Place Y Mode Locks center of mass Y-axis motion. Use this for game export where the character stays in place but the swinging motion of the hips and upper body along the X-axis is preserved.
Biped keys for limbs, footsteps, and center of mass can be adjusted using In Place mode. When the center of mass is moved on the XY-axes in this mode, the footsteps move. View biped playback without requiring a follow camera. In this viewing mode, visible footsteps “slide” under the biped.
For export to games, this feature is valuable since many game engines intelligently move the character’s center of mass laterally according to gameplay. In Place mode makes it easy to view, tune, and export animation in a manner that is complimentary to game engine playback.

**TIP** Another way of following a moving character is to link a camera and camera target to the center of mass shadow, which is the disc between the biped’s feet.

**NOTE** Trajectories do not display when In Place mode is active.

### Display group

![Display group](image)

**NOTE** The Display group is hidden by default. To display it, click on the Modes and Display expander in the Biped rollout.

### Display Objects flyout

This flyout lets you display bones and objects, together or independently:

- **Objects** Displays biped body objects; these will render if you do not turn them off before rendering. Hide the biped objects before scene rendering. You can also hide individual body objects by using the standard 3ds Max Hide controls found in the Display panel and Display Floater.

- **Bones** Displays biped bones. Bones, which do not render, are represented as the color of the corresponding links. Displaying Bones is
useful for seeing exactly where the joints fall in relation to the biped objects.

- **Objects and Bones**  Displays bones and objects simultaneously.

**Display Footsteps flyout**  This flyout lets you display or hide footsteps and their numbers:

- **Show Footsteps and Numbers**  Displays biped footsteps and footstep numbers. Footstep numbers specify the order in which the biped will move along the path created by the footsteps. Footstep numbers are displayed in white and do not render, but do appear in preview renderings.

- **Show Footsteps**  Displays biped footsteps in the viewport, but no footstep numbers.
Footsteps are represented as green and blue foot-shaped outlines by default; these are also visible in preview renderings.

- **Hide Footsteps**  
  Turns off footsteps and footstep numbers in the viewport.

- **Twist Links**  
  Toggles the display of twist links used in biped. Default=on.

- **Leg States**  
  When this button is on, the viewport displays Move, Slide, and Plant at each foot at the appropriate frame.

- **Trajectories**  
  Displays trajectories for selected biped limbs.

**TIP**  
You can edit keys on the biped’s horizontal and vertical track by turning on Trajectories, turning on Sub-Object, selecting the horizontal or vertical center of mass track and transforming keys in the viewports. Use Trajectories when editing keyframe parameters to visualize their influence, and to compare raw and filtered motion capture data.

- **Display Preferences**  
  Displays the Display Preferences dialog on page 4684 which is used to change footstep colors, trajectory parameters, and to set the number of bipeds to be played back when you use Biped Playback on the Biped rollout. Footstep color preference is a good way to distinguish between the footsteps of two or more bipeds in a scene.

**Name Rollout**

The Name rollout lets you change the name of the biped. When you change the name in the Biped rollout, the center of mass is renamed and the entire biped hierarchy inherits the new name.

**Save As Dialog (Biped)**

Select a Biped. > Motion panel > Biped rollout > Save File

The Save As dialog lets you save biped (BIP), figure (FIG), and step (STP) files.
When saving FIG files (in Figure mode), the Save As dialog is a standard Windows Save File dialog. However, when you save BIP or STP files, you can save objects and animation controllers with the file.
Interface

Save As dialog for a FIG, BIP, or STP file

Save As

Save in: motion_mixer

File name: scared.bip

Save as type: Biped Files (*.BIP)

Save Segment at Current Position and Rotation

Save MAX Objects

Save List Controllers

Save As dialog for a FIG, BIP, or STP file
History This drop-down list lets you choose directories where you have recently saved Biped motion files. See Motion File History Lists on page 4637.

File Name The name of your FIG, BIP, or STP file.

Save as type Sets the file type for your saved file.

- Saves an incremented version of the segment without overwriting an existing file.

- **Figure file (.FIG)**  Saves the structure and position of a biped in Figure mode. After fitting the biped to a mesh in Figure mode, save a figure file. If the biped is accidentally moved in Figure mode, reload this file.

- **Biped file (.BIP)**  Saves a biped motion file. A BIP file includes footsteps and keyframe data. Biped files store the complete movement and allow you to create libraries of motion. Create your own BIP library by animating the biped and saving a BIP file.

- **Step file (.STP)**  Save footstep timing and location data in an ASCII format. Step files contain no body keys (spine, arms, etc.).

Save Segment Lets you select segments of your animation for your BIP or STP file.

- **From**: Starts saving at this frame of the named animation.

- **To**: Stops saving at this frame of the named animation.

- **Active Time Segment**: When on, animation in the active time segment is saved.

- **Biped Animation Period** When selected, only time containing biped animation is saved.

- **Edited Transition Interval**: Saves frames in a transition only. Select a clip on the Motion Flow Script rollout, open the Transition Editor, and then select Save Segment to activate this control.

  **TIP** Game developers can save only the motion in the transition.

A Keyframe per Frame Saves a key at every frame. Turn this on if you plan to extract footsteps using Load Motion Capture on the Motion Capture rollout.
Save MAX Objects group

Save MAX Objects When on, any IK, Head Target, or linked object in the scene is saved with the BIP file.

Object list Each object associated with the biped in the scene is displayed here along with its object type.

All When on, all associated objects are saved with the BIP file.

Selected When on, only the highlighted objects are saved with the BIP file.

Save List Controllers group

Save List Controllers When on, any animation controllers assigned to the biped are saved with the BIP file.

Controller List Each animation controller used with the biped in the scene is displayed here along with the object that it controls.

All When on, all associated animation controllers are saved with the BIP file.

Selected When on, only the highlighted animation controllers are saved with the BIP file.

Open Dialog (Biped)

Select a biped. > Motion panel > Biped rollout > Load File

The Open dialog lets you load biped (BIP), figure (FIG), and step (STP) files.

When you load a FIG file (in Figure mode), the Open dialog is a standard Windows Open File dialog. However, when you load a BIP or STP file, you can preview the animation and control how much information is loaded into your biped.

NOTE This option is unavailable when you load a BIP file into a clip or onto a biped that is in Edit Clip mode, because all the clips in the motion flow would have to be adapted.
Open dialog for BIP or STP files
History This drop-down list lets you choose directories where you have recently opened Biped motion files. See Motion File History Lists on page 4637.

File Name The name of your FIG, BIP, or STP file.

Files of Type Sets the type of file to load.

- **Figure file (.FIG)** Load a Figure file. Figure mode must be active to load a Figure file. Figure files allow you to apply the structure of one biped to another. Reload a Figure file if you accidentally lose your biped Figure mode pose; this pose is the biped fitted to a mesh.

- **Biped file (.BIP)** Load a biped motion file (clip). Motion files include footsteps, keyframe settings, the biped scale, and the active gravity value (GravAccel). IK Blend values for keys and IK objects and their animation are also loaded.

  If you select a BIP file saved with a previous version of character studio, the preview will not be visible. After selecting the file for loading, you will be notified that the file is obsolete and should be resaved, unless you have indicated that you no longer want to see this message.

- **Step file (.STP)** Load footsteps without body keyframes. Using this ASCII file format enables developers to write programs that generate step files for biped motion. Biped will generate body keys for the loaded steps. See stp.rtf in the cstudio\docs directory for more details on the step file format.

**NOTE** In Figure mode, you can load only FIG files. In other modes, you can load BIP and STP files.

Motion Preview Lets you scrub through the animation in a BIP or STP file manually before opening it.

Restructure biped to match file When on, the structure of the current biped is changed to match the structure in the BIP file.

Set lowest starting foot height to Z=0 (.bip files only) Sets the lowest starting foot height to Z=0. This is an option in the Load File dialog. Default=On.

In Biped, the height of a motion clip can be retained. This is important if you want to retain the height of a motion clip for motions adapted to characters of different sizes. If, for example, the character is jumping off a rock and you want to retain the Z position of the character, you would turn this option off.

Leave this option off if Motion Flow motions must be blended that begin and end at different heights, such as three clips that have the character mounting a bicycle, riding the bicycle, and dismounting the bicycle.

Turning off this option can, however, cause a jump in the motion during motion flow transitions. Turn this on for smooth transitions in Motion Flow.
mode. If adaptation takes place, the height is set so that the lowest foot at frame 0 starts at the Z=0 height. This lines up clips along the Z axis and creates smooth transitions.

**TIP** Use Load Motion Capture File on the Motion Capture rollout on page 4925 to load the raw version of the motion capture BIP files included with 3ds Max. These files have no footsteps and keys at every frame. Loading files using Load Motion Capture File allows you to filter the data and extract footsteps.

**Load MAX Objects group**

*Load MAX Objects* When on, *character studio* will import any IK, Head Target, or linked object saved with the BIP data.

*Object list* Each object saved with the BIP file is displayed in this list along with its object type. The only way to eliminate an object from the animation is to resave the BIP file without it and reload.

**NOTE** The settings for loading 3ds Max objects are only active if Load MAX Objects is checked and there are objects in the data.

*Prompt for Duplicates* Opens a Merge dialog for each object in the BIP file that has a duplicate in the scene. In this dialog, you can Merge, Skip, or Delete Old. If Prompt for Duplicates is off, the objects in your scene will be automatically overwritten.

*Retarget* When on, the position of the objects in the BIP file adapt to the size of the target biped, based on either height or limb sizes.

*Scale IK Object’s Size* When on, the imported objects are scaled in size to match the target biped.

**Load List Controllers group**

*Load List Controllers* When on, and sub-animation controllers saved with the BIP file are loaded onto your target biped.

*Controller list* Displays the sub-animation controllers in the BIP file.

**NOTE** The only way to eliminate a controller from the animation is to resave the BIP file without it and reload.
Display Preferences Dialog (Biped)

Select a biped > Motion panel > Biped rollout > Display group> Display Preferences

Use the controls in the Display Preferences dialog to change footstep colors and trajectory parameters, and to set the number of bipeds to play back when you use Biped Playback on the Biped rollout.

You access the Display Preferences dialog by clicking the Display Preferences button on the Display group in the Biped rollout.

Interface

Trajectories group

NOTE Trajectories do not display using In Place mode.

Bone base Displays bone base trajectories.
Bone Tip Displays bone tip trajectories (default).

Show Entire Trajectory Displays trajectories for all animated frames.

Before Trajectory Sets the number of frames to display trajectories before the current frame.

After Trajectory Sets the number of frames to display trajectories after the current frame. Using Before and After Trajectory will result in a “traveling” trajectory display that will move with the biped through space.

Footsteps group

Left Selects the color for left footsteps. Click the color swatch next to this selection to display the Color Selector and set the color for left footsteps.

Right Selects the color for right footsteps. Click the color swatch next to this selection to display the Color Selector and set the color for right footsteps.

Generate Various Colors Asks whether you want different colors for left and right footsteps. Based on your response, generates various colors for footsteps in the viewports. This works with multiple bipeds.

Generate Normal Colors Changes right footsteps to blue and left footsteps to green, the default. Applies to all bipeds in the viewports.

Viewport Colors in Track View Displays viewport footstep colors in Track View.

Normal Colors in Track View Displays normal footstep colors in Track View.

Show All Shows all footsteps.

Hide All Hides all footsteps.

Show All Numbers Shows all footstep numbers.

Hide All Numbers Hides all footstep numbers. Show and hide are useful when there are multiple bipeds in the viewports.

Playback group

Controls in this group limit the number of bipeds to play back when you use Biped Playback on the Biped rollout on the Motion panel.

Show Time Displays frame numbers in the viewport during playback.
**All Bipeds** Lists all bipeds in the scene. Select a biped name in the window and click the right arrow to move it into the list of bipeds that will be visible during playback with Biped Playback.

**Bipeds Visible in Playback** Lists bipeds visible during playback with Biped Playback. Select a biped name and click the left arrow to exclude it from this list.

### Track Selection Rollout

Select a biped > Motion panel > Track Selection rollout

The Track Selection rollout give you specialized tools for manipulating the biped center of mass (COM) on page 4663.

The center of mass object is the root of the biped hierarchy, and controls the entire biped structure. Changing its position and orientation affects the biped as a whole, which is an important part of posing and animating the biped. Also available on this rollout are tools for selecting symmetrical and opposite biped body parts.

You can select the COM in various ways:

- If the viewport rendering method on page 8374 is set to Wireframe, you can select the COM in your viewport; it’s an octahedron located near the center of the biped’s pelvis.

- You can turn on Move All Mode on the Biped rollout on page 4669, which enlarges the COM in your viewport. This is useful in shaded viewports where the biped pelvis covers the center of mass.

- You can open the Select From Scene dialog on page 206, which displays all visible objects in your scene. The first listed biped item (Bip01, for example) usually refers to the root; you can select it from there.

- You have access to three tools on the Track Selection rollout (on the Motion panel) to edit the COM’s position and orientation: Body Horizontal, Body Vertical, and Body Rotation. Choosing one automatically selects the center of mass.
Once the biped's center of mass is selected, you can move or rotate it using the Transform gizmo on page 8748. Controlling the COM using the Track Selection rollout tools is sometimes quicker because selecting the center of mass in your viewports can be difficult if your biped resides inside a bigger rigged model. As long as you select your biped by any limb, activating the COM tools from the Track Selection rollout automatically selects the center of mass with the proper Transform gizmo:

- Body Horizontal and Body Vertical enable the Move gizmo.
- Body Rotation enables the Rotate gizmo.

When you key the COM’s position or orientation using Set Key on page 8093 or Auto Key on page 8090, the animation data is stored within the respective biped transform tracks.

See also:

- Biped Color-coded Keys and Trajectories on page 4806

Procedures

To Edit the COM’s position and orientation:

1. Create a biped.

2. On the Motion panel, expand the Track Selection rollout and turn on Body Horizontal.
The Move Transform gizmo appears at the COM’s location, highlighting the X and Y axes because they are referring to the biped Horizontal Transform track.

The Transform gizmo centered on the biped’s COM.

**TIP** To avoid deselecting the COM inadvertently, you can use Lock Selection on page 3909 to keep your selection on the center of mass, ignoring all other objects in your scene.

**TIP** You can scale the Transform gizmo using the - (hyphen) and = (equal sign) shortcut keys. Scaling the gizmo makes it easier to use, but does not affect the transform values.

3. Select the Move gizmo’s Z axis.
   This turns off Body Horizontal and turns on Body Vertical.

4. Turn on Body Rotation on the Track Selection rollout.
   3ds Max replaces the Move Transform gizmo with the Rotate Transform gizmo. You can now change the biped’s orientation.

**To Lock all Biped COM Tools:**
This procedure follows the concept from the previous procedure, and centers on selecting multiple COM tracks at the same time, as well as locking them.

1. On the Track Selection rollout, turn on Body Horizontal.

2. Turn on Lock COM Keying.
Lock COM Keying allows you to activate all center of mass tracks at the same time.

3  
Turn on both Body Horizontal and Body Rotation.

4  
Select any other part of your biped.
The COM track controls become inactive. Note that Lock COM Keying is storing the selected controls.

5  
Reselect the biped COM either by selecting the blue octahedron near the center of the biped’s pelvis, or by clicking one of the three COM track controls.
Lock COM Keying restores the selected controls.

To rotate the biped about a pivot that is not the COM:
This is an example that shows the biped falling over by rotating about its feet.

NOTE  
These steps do not work when Move All Mode is active, because this mode always uses World coordinates.

1  
Select both of the biped’s feet, and set Planted keys for them.

2  
Select the biped’s COM.

3  
Click Select And Rotate to turn it on (or use the quad menu), and then choose Use Transform Coordinate Center from the Use Center flyout.

4  
From the Reference Coordinate System drop-down list, choose Pick.
TIP You can also use a Working pivot on page 3766 in place of one you pick.

5 In a viewport, click the pivot point you want to use. For this example, click a pivot point near the feet.

6 On the Track Selection rollout, click Lock COM Keying to turn it on, then turn on all three tracks (Body Horizontal, Body Vertical, and Body Rotation).

IMPORTANT This step is essential if you want to animate the rotation. If the COM is not locked, and all three tracks are not turned on, then when you click Set Key, 3ds Max sets keys only on those tracks that are selected. The resulting animation can be strange and unexpected.

7 On the Key Info rollout, click Set Key.

WARNING You must use the Biped Set Key. You cannot use Auto Key for this operation.

8 Move to a new frame, rotate the biped, and click Set Key again.

9 Continue working this way until the rotation is complete. To return to rotating the biped about its COM, choose World from the Reference Coordinate System drop-down list.

Interface

Body Track Tools (Center of Mass Tracks)

Body Horizontal and Body Vertical refer to the center of mass's translation axes while Body Rotation focuses on its rotate axes. Once you turn them on, you can move or rotate the COM by either using the Transform gizmo, by entering values in the Coordinate Display area on page 8081.
**TIP** You can also set COM positions using the Tension, Continuity, and Bias values on the **Key Info rollout** on page 4704 (in the TCB group).

When you activate Body Horizontal or Body Vertical, you have access to advanced **Biped Dynamics parameters** on page 8521, such as **Balance Factor** on page 8516 and **Ballistic Tension** on page 8517, which you can control from the **Key Info rollout** on page 4704 and **Dynamics & Adaptation rollout** on page 4755.

**NOTE** Tension, Continuity, and Bias affect the COM Body Vertical keys only when the value of **Dynamics Blend** on page 8557 is less than 1.0. To turn off gravity at a vertical center of mass key, set the value of Dynamics Blend to 0.0.

**TIP** To view the way a parameter change affects the animation, Turn on **Trajectories** on page 8748.

Keyed keys for COM tracks are color coded as follows:

- Keys containing Body Horizontal tracks are red.
- Keys containing Body Vertical are yellow.
- Keys containing Body Rotation are green.

**NOTE** If a frame contains multiple keyed COM tracks, the key’s color code is divided accordingly.

A key’s color reflects its keyed COM tracks.

**Body Horizontal** Selects the center of mass to edit horizontal biped motion.

The Body Horizontal track has a **Balance Factor** on page 4553 parameter that automatically orients the biped to maintain balance. This saves the animator from having to reposition the pelvis when the biped leans forward, backwards, or sideways.

**NOTE** You can animate **Biped Dynamics** on page 8521 parameters from no effect to full effect at each keyframe.

**Body Vertical** Selects the center of mass to edit vertical biped motion.
The Body Vertical track uses the Dynamics Blend parameter to control gravity in a footstep animation. A Dynamics Blend value of 1.0 uses the value of GravAccel on page 8597 (global gravity value) to calculate an airborne trajectory for the biped. No keyframes are required to position the biped in the air, a trajectory is calculated automatically. A value of 0.0 uses Spline Dynamics for the vertical position of the biped; you must create keyframes to position the biped vertically.

The Body Vertical track also has a Ballistic Tension on page 8517 parameter that controls how much the biped knees bend when the biped lands from an airborne period. This means that keys do not need to be created at the lowest position of the biped after landing; a trajectory is calculated automatically.

**NOTE** You can create keys manually to override the calculated trajectory during the landing period. However, vertical keys must have Dynamics Blend=0.0 in order to override fully the trajectory during the airborne period.

- **Body Rotation** Selects the center of mass to edit biped rotational motion. You can rotate the biped about a pivot point that is different from the COM. For instructions on how to do so, see the “Procedures” section above.

- **Lock COM Keying** When on, allows you to select multiple COM tracks at the same time. Once locked, the tracks are stored in memory, and are remembered every time the COM is selected.

  **NOTE** Locked COM tracks are also honored after a scene reset or a session change.

- **Symmetrical** Selects the matching object on the other side of the biped. For example, if the right arm is selected, clicking Symmetrical Tracks selects the left arm too. You can then make changes to both sides of the body at once. Symmetrical works for single and multiple biped parts.

- **Opposite** Selects the matching object on the other side of the biped, and deselects the current object. For example, if the right arm is selected, clicking Opposite Tracks selects the left arm and deselects the right arm. You can use Opposite Tracks for single or multiple objects.
Quaternion/Euler Rollout

Select the biped > Motion panel > Quaternion/Euler rollout

This rollout contains options to switch between Euler or quaternion controllers on biped animations. These choices offer alternative ways to control an animation in the Curve Editor. For more details, refer to Working with Euler Curves on Biped Animation on page 4631.

Procedures

To switch between quaternion and Euler rotation controllers:

1. Create a biped.

2. Turn on Auto Key.

3. Select the biped's upper arm and rotate it so it extends forward.

4. Go to frame 20 and rotate the upper arm so it extends sideways.

5. Go to frame 40 and rotate the upper arm back to its original orientation.

From left to right, the biped at frame 0, 20, and 40.

In the Motion Panel, on the Quaternion/Euler rollout, notice that the Quaternion option is active by default.

NOTE: If you change options for that biped limb, your choice is preserved in the 3dsmax.ini on page 60 file, from which it is restored after a scene reset or session change.
6 On the Biped Apps rollout, click Workbench to open it.

The animation is displayed as three separate TCB rotation curves labeled “Quaternion Rotation”.

7 On the Quaternion/Euler rollout, choose the Euler option.

The curves have been converted to display Euler controlled rotations. You now have access to the curve's tangent handles to change the curve's interpolation.

The animation is displayed as three separate Euler curves labeled “Tangent Euler Rotation”.

8 Choose a different axis ordering from the Axis Order drop-down list (under the Euler option).
The curve display changes to reflect the new ordering while preserving the biped posture.

9 Choose the Quaternion option to convert the curves back to a TCB interpolation.

**NOTE** Converting a curve from Euler to quaternion can affect its interpolation. See *Working with Euler Curves on Biped Animation* on page 4631 for details.

**Interface**

The following options set the rotation controller for biped animations.

- **Quaternion** Converts the selected biped animation to quaternion rotation.
  - If the biped selection has not been animated yet, this starts as the default option.
  - If you change options for any biped limb, your choice is preserved in the 3dsmax.ini file, from which it is restored after a scene reset or session change.

- **Euler** Converts the selected biped animation to Euler rotation.
  - **Axis Order**
    - Lets you choose the order in which the Euler rotation curves are calculated. Available only when Euler is active. Default=YZX.
    - Changing the ordering reflects on the curves, which are modified accordingly. However, this change does not affect the animation itself.

  **NOTE** This setting is independent of the Workbench Axis Order setting.

**Twist Poses Rollout**

Select a biped. > Motion panel > Twist Poses rollout

The toolset of this rollout lets you create and edit twist poses for a biped's limbs.
You can either use the rollout’s preset poses (which you can modify and rename), or create your own. When you add a new pose, you establish a reference between the selected’s limb relative orientation and the rollout’s Twist value of 0 (which means no twist). When more than one reference pose are set for a rotated limb, the limb's twisting is calculated based on the nearest pose.

**TIP** It is suggested that you add twist poses for all major limb rotated poses. This ensures that rotating your biped’s limb produces well-calibrated twisting.

**NOTE** You don’t technically have to enable twist links on page 4770 to use the Twist Poses rollout toolset. However, if your biped does not contain twist links, the Twist and Bias settings are not used.

The Twist Poses rollout tools only affect limbs with three degrees of freedom (DOF), such as upper arms and thighs, because you can control their twist links by rotating them. Two-DOF limbs (forearms and calves, for instance) differ due to the fact that you can only control their twist links if you rotate their child limb.

The upper arm can twist itself while the forearm needs the wrist to twist it.
NOTE If you select a two-DOF limb, the only available setting is the Bias value; you can change it to adjust the rotation distribution along the twist links.

Procedures

Example: To Add and Edit Twist Poses:

This procedure takes into account the concept of adding twist links on page 4770 to biped limbs and concentrates on using the tools from the Twist Poses rollout to set up basic poses.

1 Prepare a biped with five twist links on each upper arm.

TIP You can use See-Through on page 164 on the biped's limbs to better distinguish the twist links inside.

2 Exit Figure Mode, and then expand the Twist Poses rollout.

3 Select the right upper arm.
   The rollout controls are enabled because you selected a three-DOF limb.

4 Use Previous Key and Next Key to cycle through the different pose presets.
   TIP You can often use these presets as a starting point for posing your limbs.
5 Choose pose6 from the drop-down list. The biped's arm extends upwards and shows some twisting.

6 Click Set. This assigns the Twist value of 0 to the upper arm's twist links.

**NOTE** A twist change is always reflected on both sides (in this case, both upper arms).

7 Rotate the upper arm locally around its Y axis so it extends on the side.

8 Click Add to create a new pose. Rename it Arm At Side. This new pose resets the current Twist value of the twist links.

9 Rotate the upper arm locally around its X axis.
The twisting in the upper arm is calculated based on the limb’s proximity to the saved poses.

[Diagram of a human-like figure with an arm twisted]

Rotate the upper arm to verify the twist links.

**Interface**

- **Previous/Next Key**: Scrolls and selects through the list of twist poses.

- **Twist Poses List**: Lets you choose a preset or saved pose to apply to the biped’s selected limb. By default, five twist poses are available for each three-DOF limb: Up, front, lateral, down, and back. You can also rename the current twist pose.

- **Twist**: Sets the amount of twist rotation (in degrees) applied to the twist links linked to the selected limb. The twist links from the opposite side are so affected. Default=0. Range=–180 to 180.

**NOTE** Changing the Twist value automatically resets the current limb’s orientation to the active twist pose.

- **Bias**: Sets the distribution of rotation along the twist links. A setting of 1.0 concentrates the twist towards the top link while a setting of 0.0 instead concentrates it towards the bottom link. The default setting is 0.5, distributing...
the rotation evenly throughout the links. The twist links from the opposite side are so affected.

**NOTE** Changing the Bias value automatically resets the current limb's orientation to the active twist pose.

**NOTE** You can also set a Bias value for Two-DOF limbs.

**Add** Creates a new twist pose based on the selected limb's orientation and resets Twist and Bias to their default values.

**NOTE** Adding a new pose for one limb automatically makes it available for the limb on the opposite side.

**Set** Updates the active twist pose with the current Twist and Bias values.

**Delete** Removes the current twist pose.

**Default** Replaces all twist poses of all three-DOF limbs with five default preset poses.

**Bend Links Rollout**

Select the biped > Motion panel > Bend Links rollout

This toolset combines the Bend Links Mode, previously located on the Biped rollout, with other tools to allow an easier control over a chain link, such as a biped spine, neck or tail.
NOTE  Activating one of the Bend Links rollout modes deactivates any of the others. However, clicking Zero Twist or Zero All maintain any mode currently active.

NOTE  The Bend Links rollout is displayed in Mixer Mode, Motion Flow Mode or Footstep Modes.

Procedures

To bend a spine naturally using Bend Links Mode:

1  Select any link in the biped's spine.

2  Rotate the spine link. Notice that all chain links rotates the same way.

3  On the Bend Links rollout, click Bend Links Mode to activate it.

4  Rotate the spine link. The other links in the chain rotates to match the single link's rotation, creating a natural bend along the spine.

To twist a spine naturally using Twist Links Mode:

1  Select any link in the biped's spine.

2  On the Bend Links rollout, click Bend Links Mode to activate it.

3  Rotate the spine link until you reach a pronounced bend.

4  Rotate the spine link in local X. Notice that all chain links rotates in a weird way due to the fact that they do not maintain their relationship with the two other axis. Undo the rotation.
5 On the Bend Links rollout, click Twist Links Mode to activate it.
6 Rotate the spine link in local X. The rotation averages up the spine for all links while the spine maintains its existing profile.

To twist a spine link without affecting the chain using Twist Individual Mode:
1 Select the bottom link in the biped's spine, just above the pelvis.
2 On the Bend Links rollout, click Bend Links Mode to activate it.
3 Rotate the link so the spine's shape follows a noticeable curvature.
4 On the Bends Links rollout, click Twist Individual Mode to activate it.
5 Select a link in the middle of the spine and rotate it in local X. The rotation only affects the selected link.

To smooth out a spine using Smooth Twist Mode:
1 Select the bottom link in the biped's spine.
2 On the Bends Links rollout, click Twist Individual Mode to activate it.
3 Rotate the link 45 degrees in local X.
4 Select and rotate the spine's top link –45 degrees in local X
5 On the Bends Links rollout, click Smooth Twist Mode to activate it.
6 Rotate either the bottom or top spine link. The chain links rotates to smooth out the orientation difference between the two link extremities. Adjust the Smoothing Bias control to distribute the chain's rotation towards the base or top link.
Interface

Bend Links Mode This mode can be used to rotate multiple links of a chain without having to select all of them beforehand. Bend Links Mode transfers the rotation of one link to the other links, following a natural curvature.

NOTE Using Bend Links Mode in Auto Key mode or setting a key after twisting results in keys on all the links of the selected chain. See Separate Tracks on page 4717 for further details.

Twist Links Mode Similar to Bend Links Mode, this mode takes the rotation in local X applied to the selected link and increment it equally throughout the rest of the chain while maintaining the relationships between the links in the other two axes.

NOTE Using Twist Links Mode in Auto Key mode or setting a key after twisting results in keys on all the links of the selected chain. See Separate Tracks on page 4717 for further details.

Twist Individual Mode Similar to Bend Links Mode, this mode allows a selected chain link to be rotated in local X without affecting its parent or child. The chain therefore maintains its shape while the individual link is adjusted.

NOTE Using Twist Individual Mode in Auto Key mode or setting a key after twisting results in keys on all the links of the selected chain. See Separate Tracks on page 4717 for further details.

Smooth Twist Mode This mode takes into account the orientation in local X of the chain's first and last links in order to distribute the rotation of the other links. This results in a smooth rotation between every chain link. The rotation distribution can be set by adjusting the Smoothing Bias control or by rotating either the first or last link of the chain.
Smoothing Bias  
Sets the rotation distribution based on a value between 0.0 and 1.0. 0.0 biases towards the first link and 1.0 towards the last link of the chain. The chain’s smoothness can be interactively set by dragging the bias setting between those 2 values.

Zero Twist  
Resets every chain link’s rotation to 0 in local X based on the current orientation of the chain’s parent. This does not change the current shape of the chain.

Zero All  
Resets every chain link’s rotation to 0 in all axes based on the current orientation of the chain’s parent. This adjusts the current shape of the chain so it becomes parallel to the biped.

Key Info Rollout

Select the biped. > Motion panel > Key Info rollout

These tools are for navigating and editing biped keys.

Tools in the Key Info rollout allow you to do the following:

■ Find the next or previous key for the selected biped body part.
■ Use the Time spinner to slide a key back and forth in time.
■ Change Tension, Continuity, and Bias for a key and display trajectories.
■ Adjust biped dynamics.
■ Set planted, sliding, or free keys.
■ Set IK constraints and pivots for the biped hands and feet.

When the Body Vertical on page 4691 COM (center of mass) track is active, you can change the vertical dynamics of the motion, on a key-by-key basis. When the Body Horizontal COM track is active you can change the balance factor for shifts in weight distribution.

NOTE On the time slider or in Track View, you can move one Biped key past another. See Moving Keys on page 4805.
Activating Parameters

Groups of the Key Info rollout are unavailable depending on what part of the biped is selected and if a key is current. Body Vertical on page 4691, Body Horizontal on page 4691, and Body Rotation on page 4692 refer to the three tracks used to animate the biped center of mass. Select one of the three center of mass tracks on the Track Selection rollout, then use Next Key or Previous Key to find a key to edit.

■ If Body Vertical is active and a key is current, then parameters for Dynamics Blend, Ballistic Tension, Z Position, Time, and TCB parameters (Tension, Continuity and Bias) are active. Ballistic Tension is available only at keys just before or just after an airborne state, as between footsteps in a run or jump.

NOTE TCB controls are not effective at Body Vertical keys just before and just after an airborne period, between footsteps, if Dynamics Blend=1. Biped Dynamics calculates the airborne trajectory; in this case, lower the value of Dynamics Blend to use the TCB controls. In a walk sequence where footsteps overlap, Dynamics Blend has no effect you can use and TCB controls.

■ If Body Horizontal is selected and a key is current, the Balance Factor parameter, XY Position, Time, and TCB parameters are active. Z Position, Dynamics Blend, Ballistic Tension are unavailable.

■ If Body Rotation is selected and a key is current, only the Time and TCB parameters are active.

■ If a biped hand is selected and a key is current, then all parameters are active except parameters in the Body Dynamics group.

■ If a biped foot key is selected and current, then all parameters are active except for parameters in the Body Dynamics group.

■ If a biped leg is selected and a key is current, then Time and TCB parameters are active. XYZ Position and Body Dynamics parameters are made unavailable. In a footsteps animation, Time is made unavailable at a Touch and Lift key.

■ If a biped arm is selected and a key is current, then Time and TCB parameters are active. XYZ Position and Body Dynamics parameters are made unavailable.
Interface

The Key Info rollout is divided up into several groups: TCB, IK, Head, Body, and Prop. You can expand and hide each of these groups by clicking the line next to its name.

Next Key-Previous Key Find the next or previous keyframe for the selected biped part.
The field displays the key number.

Time Enter a value to specify when in time the key occurs.
Use this to fine tune keyframe timing on a character by moving a key backwards and forwards in time.

Set Key Creates keys at the current frame when you are moving biped objects. This is identical to Set Key on the 3ds Max toolbar.
You can experiment with different biped poses without updating the motion until you find the desired pose. You can also quickly fine tune your motion by setting a key and adjusting the key parameters on the Key Info rollout without having to transform the biped in the viewports.

NOTE If a biped key is current, then TCB, XYZ position spinners, and IK Blend parameters can be updated without using Set Key or having the Auto Key button turned on.

NOTE If 3ds Max bones using the IK Controller or 3ds Max Particle Emitters are linked to the biped, or if you are displaying 3ds Max trajectories or ghosting, the Auto Key button must be on while the biped is positioned. These objects update their parameters in real time as they are positioned.
**Delete Key** Deletes the key of the selected object at the current frame. By default, biped arm, hand, and finger keys are stored in the clavicle track. If you delete keys for any one of these objects, you lose positions for the rest of the arm objects at that frame. If you plan on extensive hand animation, turn on Arms in the Separate Tracks group of the Keyframing Tools rollout. This creates separate tracks for each biped arm object. Deleting an upper arm key will preserve hand and finger keys.

**Set Planted Key** Sets a biped key with IK Blend=1, Join To Previous IK Key turned on, and Object selected in the IK group. In a Footstep or Freeform animation, all footsteps that do not slide should have Join To Previous IK Key turned on.

**Set Sliding Key** Sets a biped key with IK Blend=1, Join To Previous IK Key turned off, and Object selected in the IK group. This creates a sliding footstep. Sliding footsteps display in the viewports with a line running through the middle of the footstep. Sliding footsteps are understood as footsteps with moving IK constraints. In a Footstep or Freeform animation, if the foot slides rather than being planted, use Set Sliding Key.

**Set Free Key** Sets a biped key with IK Blend=0, Join To Previous IK Key turned off, and Body selected in the IK group. In a Footstep or Freeform animation, a biped leg in a move state should have a “free” key.

To change the default values for TCB keys, right-click either Set Planted Key, Set Sliding Key, or Set Free Key to open the respective dialog.
Use When on, subsequent keys set with either Set Planted Key, Set Sliding Key, or Set Free Key use the TCB values from the respective dialog. Otherwise, the system uses the default values.

**Tension** Controls the amount of curvature in the animation curve. Default=25.

**Continuity** Controls the tangential property of the curve at the key. Default=25.

**Bias** Controls where the animation curve occurs with respect to the key. Default=25.

**Trajectories** Shows and hides trajectories for the selected biped object. You can edit keys on the biped's horizontal and vertical track by turning on Trajectories, turning on Sub-Object, selecting the horizontal or vertical center of mass track, and transforming keys in the viewports.

- You can bend the horizontal center of mass trajectory around selected horizontal keys by using the Bend Horizontal spinner in the Keyframing Tools rollout.

- Display trajectories to view how parameter changes in the Key Info rollout affects the biped motion. Changing Tension, Continuity, and Bias in the Tcb group affects the trajectory around the current key. Changing the value of IK Blend for a hand or foot will affect the trajectory between keys.

- Leave Trajectories on and turn on Show Buffer Trajectories on the Motion Capture rollout to compare a raw motion capture trajectory with the filtered trajectory on the biped. This assumes a motion capture file has been loaded.

- Changing Dynamics Blend for a center of mass vertical key or changing the value of GravAccel will change gravity in a foostep animation and will therefore affect the trajectory.
You can use the TCB controls to adjust easing and trajectories on keys that already exist.

**XYZ Position** Reposition the selected biped part using these spinners. A hand or foot can be repositioned in world coordinate XYZ. The biped center of mass can also be positioned using these spinners.

**TCB Graph** Charts the effect that changing the controller properties will have on the animation. The red mark at the top of the curve represents the key. The marks to the left and right of the curve represent an even division of time to either side of the key.

The TCB graph is a stylized representation of the animation around a single key.

**Ease To** Slows the velocity of the animation curve as it approaches the key. Default=0.

High Ease To causes the animation to decelerate as it approaches the key.

The default setting causes no extra deceleration.
Ease From  Slows the velocity of the animation curve as it leaves the key.
Default=0.
High Ease From causes the animation to start slow and accelerate as it leaves the key.
The default setting causes no change of the animation curve.

Tension  Controls the amount of curvature in the animation curve.
High Tension produces a linear curve. It also has a slight Ease To and Ease From effect.
Low Tension produces a very wide, rounded, curve. It also has a slight negative Ease To and Ease From effect.
The default value of 25 produces an even amount of curvature through the key.

Continuity  Controls the tangential property of the curve at the key. The default setting is the only value that produces a smooth animation curve through the key. All other values produce a discontinuity in the animation curve causing an abrupt change in the animation. Default=25.
High Continuity values create curved overshoot on both sides of the key.
Low Continuity values create a linear animation curve. Low continuity creates a linear curve similar to high tension except without the Ease To and Ease From side effect.
The default setting creates a smooth continuous curve at the key.

Bias  Controls where the animation curve occurs with respect to the key.
Default=25.
High Bias pushes the curve beyond the key. This produces a linear curve coming into the key and an exaggerated curve leaving the key.
Low Bias pulls the curve before the key. This produces an exaggerated curve coming into the key and a linear curve leaving the key.
The default setting distributes the curve evenly to both sides of the key.

IK group

This group lets you set IK keys and adjust parameters for IK keys.

NOTE  You can make and adjust settings for multiple selected IK-capable biped parts. For example, say at the same frame one foot has a planted key and the other has a sliding key. This means they both have (by default) IK Blend values of 1.0 and Ankle Tension values of 0.0. If you select both feet, all of the Key buttons near the top of the Key Info rollout are available, and you can change IK Blend and Ankle Tension values for both.
**IK Blend** Determines how character studio mixes forward kinematics and inverse kinematics to interpolate an intermediate position. An example of forward kinematics is moving the arm to control the hand. An example of inverse kinematics is moving the hand to control the arm.

Activates when a biped arm or leg (hand and foot) key is current.

- **0** with **Body** on page 4713 chosen is normal biped space (forward kinematics).
- **1** with **Body** on page 4713 chosen is inverse kinematics, which creates more straight-line motion between biped keys.
- **1** with **Object** on page 4713 chosen, but no **IK Object specified** on page 4713, puts the limb fully into world space.
- **1** with **Object** on page 4713 chosen and an **IK Object specified** on page 4713 puts the biped limb into the coordinate space of the selected object; the biped limb follows the specified object.

**Ankle Tension** Adjusts the precedence of the ankle joint over the knee joint. When set to 0, the knee takes precedence. When set to 1, the ankle takes precedence.

This effect is only visible between keyframes.

**Select Pivot** Activate to designate pivots around which the biped hands and feet should rotate. After clicking a pivot in the viewports, turn off Select Pivot and then rotate the hand or foot.

**TIP** For better accuracy in setting pivots, use the Pivot Selection dialog (see following).

**Pivot Selection Dialog** Opens a small dialog that shows the current pivot for the selected limb on the limb's respective hand or foot, and lets you change it. When the chart is green (or blue) and red, indicating that you're on an IK
key, the red dot indicates the current location of the pivot. To designate a different pivot, click another dot on the chart. This provides an alternative method to using Select Pivot (see preceding).

The dialog is named according to the displayed hand or foot, depicts the actual number of digits and joints in use, and resizes itself accordingly. The displayed chart uses three different schemes, depending on the context:

- Green/blue and red dots for the right/left hand or foot when on an IK key (pivot is editable)
- Gray and white dots when in an IK period but not on a key (pivot is visible but not editable)
- No dots if you’re in an FK (forward kinematics) period, or no limb or multiple limbs are selected (dialog disabled; no relevant data exist)

These are shown in the following illustration:

---

**NOTE** When on an IK key, the left hand and foot charts use a blue/red color scheme:

![Left Hand Dialog](image)

---

When you have turned on Knuckles on page 4768, the hand chart shows all bones; for example:
Join to Previous IK Key When on, places the biped foot in the coordinate space of the previous key. Turn off to put the biped foot into a new reference position.

Turn off and move the biped foot to create a sliding footstep, for example.

Body The biped limb is in biped coordinate space.

Object Object Space: the biped limb is either in World coordinate space or the coordinate space of the selected IK object. Coordinate space can be blended between keys.

Select IK Object Chooses an object for the biped's hand or foot to follow when IK Blend is 1 and Object is selected. The selected object's name is displayed next to the button.

This selection cannot be animated; only one IK object can be active for each hand and foot throughout the animation.

TIP If you want to change the object the hand or foot follows at different times in the animation, select a dummy object as the IK object, and assign a Link Constraint to the dummy object to make it link to different objects at different times.

Head group
The Head group lets you define a target object for the target to look at.

**Target Blend** Determines the extent to which the target blends with the head’s existing animation.

A setting of 1.0 causes the head to look directly at the target, 0.5 causes the head to blend half of its existing animation with looking at the target, and a setting of 0.0 causes the head to ignore the target, maintaining its existing animation.

![Select Look At Target](image)

**Select Look At Target** Click to select an object for the head to look at.

**NOTE** When an object is selected, its name is displayed next to the button.

---

**Body group**

![Body group parameters](image)

These parameters apply to the biped center of mass and are used by character studio to calculate the biped’s airborne trajectory based on gravity (GravAccel) and time between footsteps, the amount of knee bend on landing (Ballistic Tension) and how the biped objects adapt to maintain balance (Balance Factor).

**Balance Factor** Position the biped’s weight anywhere along a line that extends from the center of mass to the biped’s head. This center of mass (Body Horizontal track) parameter can be keyframed. To activate Balance Factor select the Horizontal Track (in the Track Selection rollout), set a key and enter a value in the Balance Factor field.

For example, to create a *sit then walk* sequence, you could shift the biped’s weight (balance) between 0 (the character is supported by the chair) for the sit key and 1 for the stand key (the character’s pelvis shifts to maintain balance).

If a character is seated, and reaches across the table, leave Balance Factor at 0; however the character leans, he will pivot from the center of mass. The pelvis will not move back to maintain balance.

In a walking motion, a value of 2 will swing the hips and keep the biped head steady; a value of 0 will keep the hips steady and swing the upper body.
A Balance Factor value of 0 in the first image causes the biped not to compensate for weight.

A Balance Factor value of 2 in the second image causes the biped pelvis to move away from the Center of Mass to compensate for weight.

The Balance Factor determines how far the biped's hips will shift forward or backward to compensate for forward or backward bending of the spine. When the biped has a normal weight distribution between the upper and lower body, the default value of 1 causes the hips to swing backward as the biped bends over to compensate for the forward weight.
At times, when the biped leans, you will want the biped's hips to refrain from shifting to compensate for the forward weight. This would be when the biped is sitting or falling down. A Balance Factor of 0 (the minimum value) causes the hips to stay still when the biped leans forward or backward.

A value of 0 places the biped's weight at the center of mass. A value of 1 places the biped's weight above the center of mass. A value of 2 places the biped's weight in the head. Click the spinner up arrow to move the biped's weight distribution toward the head. Range=0.0 to 2.0; Default=1.

**NOTE** You can also shift the center of mass by turning on Figure mode, selecting the center of mass object, and using Rubber Band mode on page 4669 to move the center of mass to a new position. This method cannot be keyframed, but it allows you to move the center of mass outside the biped body. For example, you can simulate pushing a heavy object by moving the center of mass behind the biped.

**Dynamics Blend** Select the Body Vertical track (center of mass vertical track) and control the amount of gravity in an airborne period, as in a running or jumping motion. This parameter has no effect on a walking motion where footsteps overlap.

The vertical center of mass track Dynamics Blend parameter is set to 1 for both keys (white squares) in the first jump, and to .5 in the second jump.

A value of 1 uses the GravAccel on page 4755 value to calculate gravity. A value of 0 removes the effects of gravity calculation and flattens a jumping or airborne motion.

**Ballistic Tension** Select the Body Vertical track (COM) and control the amount of spring or tension when the biped lands or takes off from a jump or run step. The change is subtle.

A walk cycle will not activate this value. The biped has to be airborne, then the Lift and Touch vertical keys will display a Ballistic Tension value.

If there are more than three vertical keys during a support period, you can also edit Ballistic Tension for the lift-off key; otherwise Biped uses the same
value for touchdown and lift-off, since it is assumed that there is only one vertical dip in the motion. Low values are high tension (less dip in the trajectory). Default=0.5; Range=0 to 1;

Prop group

The Coordinate Space pulldowns will set the Prop to refer to the World, Body, Right Hand or Left Hand coordinate space for position and rotation at the current frame.

Position Space Lets you set the prop position space to World, Body, Right Hand, or Left Hand.

Rotation Space Lets you set the prop rotation space to World, Body, Right Hand, or Left Hand.

Keyframing Tools Rollout

Select the biped. > Motion panel > Keyframing Tools rollout

Use controls on the Keyframing Tools rollout to clear animation on a biped or selected parts, mirror biped animation, and cause the Neck to rotate in body space rather than parent space. You can also bend the horizontal center of mass track around a selected horizontal key.

Separate Tracks

By default, 3ds Max uses an optimized method for key storage. For example, keys for the fingers, hand, forearm, and upper arm are stored in the Clavicle transform track. If you prefer instead to have a transform track available for
each arm object, use the Separate Tracks group to make these transform tracks available; transform tracks are displayed in Track View.

When the Separate FK Tracks options are on for the Arms and Fingers, only these tracks receive keys.

When the Separate FK Tracks options are off, all limb tracks receive keys.
**TIP** Separate Tracks are designed to be used with forward-kinematic (FK) rotations. Using the Move tool to change the position of a biped limb with Separate Tracks requires that you turn on Set Parents Mode. If Set Parents Mode is off, then the limb you move is stored relative to its parent objects, and the new parent positions are not stored. The parent objects will snap back to their originally stored location. Turning on Set Parents Mode ensures that the position of the entire biped limb is stored.

**NOTE** Separate Tracks are intended to be used as a preference. It is better to turn them on once for the tracks you plan to edit by hand. Turning off Separate Tracks that are currently on causes a key to be stored for every biped object in the limb for the frames where any biped keys previously existed.

**Procedures**

**Example: Use separate finger tracks to create a clenching fist:**

1. Create a biped with five fingers that have three joints apiece.

2. Turn on Set Parents Mode.

3. Turn on Separate FK Tracks for Arms.

4. Select the right hand and set a free key at frame 0.

5. Go to frame 30, move the hand up and forward, and then set a planted key.

6. Go to frame 40, set a free key (this will have IK on by default), select the pivot at the base of the hand (only hand pivots are present, not finger pivots), and reset the key.

7. The hand should now move up and then rotate at its base.

8. Select a finger. So far, it has no keys.

9. Animate each finger individually, so they curl up one at a time.
Interface

Enable Subanims Enables Biped subanims. For more information about Biped subanims, see Using Controllers on page 4590

Manipulate Subanims Modifies Biped subanims. For more information about Biped subanims, see Using Controllers on page 4590

Clear Selected Tracks Removes all keys and constraints from the selected objects and tracks.

Clear All Animation Removes all keys and constraints from the biped.
Mirror and Mirror In Place flyout This flyout offers two options. Both options mirror the animation locally, so that the right side of the biped now does what the left side does, and vice versa. Also, if the spline leaned to the left, it now leans to the right. The same goes for the neck, pelvis, head, and so on.

- **Mirror** Reflects the animation about the world-space XZ plane. This option reverses the biped’s position by 180 degrees, so it now faces in the opposite direction.

- **Mirror in Place** Reflects the animation locally, but at the initial frame, maintains the world-space position and orientation of the biped. The biped continues to face in the same direction.

Original animation: The biped turns to the left as it walks.
When you click Mirror, the animation and the biped turn completely around.

When you click Mirror In Place, the biped still moves forward, but now it turns to the right.

**Set Multiple Keys** Select keys using filters or apply a rotational increment to selected keys. Use this to change periodic motion keys in Track View. Displays the Set Multiple Keys dialog on page 4724.

**Set Parents Mode** When a limb key is created, keys are created for the parent objects also, provided Set Parents Mode is turned on. Use Set Parents Mode when you turn on Separate FK Tracks.

Set Parents Mode stores the position of the entire limb when a biped limb is moved using inverse kinematics instead of rotated using forward kinematics. For example, if Set Parents Mode is off and Separate Tracks are turned on for the biped arms, then the arm will snap back to its original position if you transform the biped hand.

If Separate Tracks are turned on for a biped body part, then turn on Set Parents Mode. This lets you use the Move transform to position the biped limbs.

**NOTE** Separate Tracks adds biped object transform tracks.

**Anchor Right Arm, Left Arm, Right Leg, Left Leg** Let you temporarily fix the location and orientation of hands and feet. Use anchors when you are setting up animation with inverse kinematics object space, in
which the arm or leg follows an object in the scene. Anchors ensure that the arm or leg keeps its alignment until you set the second key that establishes the object-space sequence.

**TIP** An alternative to anchors is to use Set Planted Key on the Key Info rollout on page 4704. When you use Set Planted Key, the limb is positioned to the previous IK key (Join To Previous IK Key).

**Show All in Track View** Shows all the curves for the options in the Keyframing rollout in the track view.

**Separate FK Tracks group**

By default, character studio stores a finger, hand, forearm, and upper-arm key in the Clavicle track. The toe, foot, and calf keys are stored in the thigh track. This optimized approach to key storage works well in most cases. If you need extra tracks, turn them on for a specific biped body part. For example, turn on Arms if you plan to create extensive finger-hand animation; if an arm key is deleted, it will not affect the finger-hand keys.

You must turn on Set Parents Mode for these toggles to take effect.

**Arms** Turn on to create separate transform tracks for the finger, hand, forearm, and upper arm.

By default, there is one finger track per hand. All finger keys are stored in the Finger0 transform track, the first link of the biped thumb.

**Neck** Turn on to create separate transform tracks for the neck links.

**Legs** Turn on to create separate toe, foot, and calf transform tracks.

**Tail** Turn on to create separate transform tracks for each tail link.

**Fingers** Turn on to create separate transform tracks for fingers.

**Spine** Turn on to create separate spine transform tracks.

**Toes** Turn on to create separate transform tracks for toes.

**Ponytail 1** Turn on to create separate ponytail 1 transform tracks.

**Ponytail 2** Turn on to create separate ponytail 2 transform tracks.

**Xtras** Turn on to create separate tracks for an extra tail. See Xtras group on page 4772.

**Drop-down list** Use this list to choose the specific extra tail for which you're creating tracks.
Set Multiple Keys Dialog

Select the Biped > Motion panel > Keyframing Tools rollout > Set Multiple Keys > Set Multiple Keys dialog

Keys can be selected manually in Track View or the Track Bar and an increment applied to the selected keys. State Filters in this dialog select certain biped keys for you, based on foot states (Touch, Plant, Lift, and Move). Select Left Leg and the Move state filter, then click Select to select all the left leg keys in a Move state for example (Move is the leg state between footsteps).
**Interface**

**Change Multiple Keys group**

These controls allow you to apply to a set of keys the rotation or IK translation of a limb at the current frame. First select the keys in Track View, then rotate or move the limb, then click Apply Increment.

**Apply Increment** Adjusts the rotation and/or position of a limb at the selected keys. Use this feature when you need to set the position of a limb over multiple keys.
**Scale Tail Keys** Exaggerates or tones down the default motion applied to the biped’s tail for three types of rotation. To activate all three spinners, select tail keys in the biped Tail track in Track View.

**Forward** Sets the amount of forward and backward swing in the tail.

**Sideways** Sets the amount of side-to-side swing of the tail.

**Twist** Sets the amount of local X axis rotation of each tail object.

**Select Multiple Keys group**

These controls allow you to select keys according to the foot state at that frame. This is very helpful when you want to apply an increment to all keys of a particular type in a particular track.

- First, select the tracks you want: Left Leg, Right Leg, Body Horizontal, Body Vertical.
- Then select the foot states: Touch, Plant, Lift, Move
- Then click Select to select all the matching keys. Selected keys are highlighted in white in Track View.

**Copy/Paste Rollout**

Create a biped or select one. > Motion panel > Copy/Paste rollout (not available in Footstep, Motion Flow, or Mixer modes)

Controls on the Copy/Paste rollout let you copy and then paste posture, pose, or track information from one part of a biped to another, or from one biped to a different one.

These are the three categories of information you can copy and paste:

- **Posture** The positioning of selected biped objects.
- **Pose** The positioning of the entire biped.
- **Track** The animation track from the selected biped objects.

**NOTE** Your copied information will be stored in the current copy collection.
**Copy Collections**

Copy collections are designed to make it easier to manage copied posture, pose, and track information by grouping it together. This improves the way copied animation data is organized when it is transferred between files within a session:

- You can display smaller sets of poses, postures, and tracks in the list.
- You can load more than one CPY on page 8542 file into a single scene.
- You can either append a loaded set to an existing one or replace it entirely.

**NOTE** You must create a copy collection before you can copy a biped's posture, pose or track.

**Copy/Paste Buffers**

In character studio, you can save multiple copy/paste buffers for each of the three modes: Posture, Pose, and Track. These are available from the Copied Postures/Poses/Tracks drop-down list; the active buffer that the Paste buttons use is the one whose name is visible in the field at the top of the list. A thumbnail view gives a preview of what the active buffer has saved.

Buffers are saved with your MAX scene file, and also remain available in your 3ds Max session, even if you reset.

The default name of a buffer depends on which mode you are in. In the Posture and Pose modes, the name of the buffer consists of abbreviated names of the body parts you selected, followed by a sequence number. For example, `RArmRFing1` is the first buffer for the posture or tracks of the biped's right arm and finger. In Pose mode, the name of the buffer is always “Pose,” followed by a sequence number. For example, `Pose03`.

To give a buffer a custom name, make it active, highlight its name in the field at the top of the buffer list, and then enter a new name.

For hands-on experience using the Copy/Paste rollout, see the lesson called “Creating a Simple Freeform Animation” found in the tutorial entitled Animating with Freeform.

**TIP** When copying poses or postures containing COM data, the Paste Options on page 4740 are activated.
Paste and Paste Opposite

For each mode, there are two paste options: Paste, and Paste Opposite. These are useful in different situations:

- **Paste**  
  In the Posture and Pose modes, Paste is useful for copying positioning from one biped to a different biped, or for restoring a biped's positioning at a different frame of an animation. In Track mode, Paste is useful mainly for copying movement from one biped to a different biped.

- **Paste Opposite**  
  In Posture mode, Paste Opposite is useful for making one limb assume the posture of the other, either at the same frame or different frames. In Pose mode, Paste Opposite reverses the biped's pose, or applies that reverse pose to a different biped. In Track mode, Paste Opposite can make a biped's limbs move symmetrically, or apply the opposite of the copied movement to a different biped.

**TIP** After pasting a pose or tracks to a different biped, often you have to reposition it. This is easily done with Move All mode.

**NOTE** If a copied pose, posture or track contains sub-animations, they can be pasted to another pose, posture or track as long as the same sub-animations already exist. Otherwise, they are ignored.

Procedures

Example: To load multiple collections between files within a single session:

1. Create a biped and load some animation onto it.

2. On the Copy/Paste rollout, click Create Collection and rename it **Upper**.
3. Select all of the biped’s links from the spine up and, after making sure you’re in **Posture mode** on page 4738, click Copy Posture. Repeat this step for every 10 frames of your animation.

4. Create a new collection and rename it *Lower*.

5. Go to frame 0. Select all of the biped’s links from the pelvis down and copy a posture at every 10 frames.

6. Choose the Upper collection from the Copy Collections drop-down list and save it. Then, select the Lower collection and save it as well.

7. Save your scene and reset it (File > Reset).

8. Create a new biped and load the Upper collection.
9 For every 10 frames, select the biped’s upper body and paste the corresponding posture from the Copied Postures drop-down list. Set a key for each pasted posture.

10 Load the Lower collection and repeat last step with the biped’s lower body selected, setting a key for each posture.

11 Delete the Lower collection.

12 Click Max Load Preferences and make sure both options are checked. Close the dialog and load the saved 3ds Max file. Notice that the Copy Collections drop-down list now contains three collections: two Upper collections (one from the current file and one from the incoming) and one Lower collection from the incoming file.

To capture different snapshots:

1 Under the thumbnail snapshot of the Copied Postures group, click Capture Snapshot from Viewport.

2 Rotate your current viewport to different user views and copy a biped posture. Notice that your snapshot matches the viewport angle.
3 Click Capture Snapshot Automatically and copy a posture again. Notice that your snapshot is displayed from a frontal view.

4 Click No Snapshot and copy another posture. The capture has been replaced by a gray canvas.

Example: To maintain copied COM data when pasting poses:

1 Create a biped and then create a new collection. Rename it **Poses**.

2 Make sure you're in Pose mode and click Copy Pose at frame 0. Then, go to frame 30.

3 Using tools from the **Track Selection rollout** on page 4686, move your biped away from its current position and rotate it in all three axes.
4 In the Paste Options group on page 4740, enable all three Paste buttons.

5 Click Paste Pose. The biped resets back to its original position and orientation since its copied COM data is maintained. Undo the step.

6 Disable Paste Rotation but keep the other two buttons enabled.

7 Click Paste Pose. The biped resets back to its original position but remains rotated. This is due to the fact that the copied COM orientation is not maintained on paste. Undo the step.

8 Disabled both Paste Horizontal and Paste Vertical but enable Paste Rotation once again. Click Paste Pose. This time, the biped’s position is maintained but not its orientation.
Example: To maintain COM offsets using By Velocity:

1. Create a biped. Then, on the Track Selection rollout on page 4686, turn on Body Horizontal.

2. Set a key at frame 0. Then, make sure Pose mode is selected and copy your biped's pose.

3. Go to frame 10 and move the Body COM 50 units in the Y axis. Set a new key.

4. In the Paste Options group on page 4740, enable Paste Horizontal but leave By Velocity unchecked.

5. Go to frame 30 and paste your biped's pose. The biped jumps to the center of your scene. Undo the step.

6. Go back in the Paste Options group and turn on By Velocity. Then, try pasting your pose again. Notice how the biped's COM position is now offsetted by another 50 units in Y.

Example: To set TCB/IK Values when pasting postures:

1. Create a biped and then create a new collection. Rename it Hands.

2. Select the biped's right hand and, on the Key Info rollout on page 4704, set a key.

3. In the TCB group, set Ease To to 10, Ease From to 50, and all three TCB values to 5.

4. In the IK group, set IK Blend to 0.5 and choose the Object Space option. Then, set another key.
5 Make sure you're in Posture mode and click Copy Posture.

6 Create a new biped next to the original one. Create a box next to its right hand.
7 In the IK group, constrain the biped's hand to the box by clicking Select IK Object and then selecting the box in your viewport. Keep the Body Space option selected.

8  On the Keyframing Tools rollout on page 4717, turn Separate Tracks off for the arms. Then turn Auto Key on.

9 In the Paste Options group on page 4740, set the Auto-Key TCB/IK Values to Default.

10 Click Paste Posture.

    The hand assumes the copied posture and the key's TCB and IK values are set to default. Keys are also set for the whole arm.
11 Go to frame 30 and turn Separate Tracks on.

12 Set Auto-Key TCB/IK Values to Copied and paste the posture.
   The copied value information is transferred to this new key. The key
   values are now 10 and 50 for the Ease To/Ease From, 5 for the TCB, and
   0.5 for the IK Blend. The box is still the IK Object and Object Space
   remains selected. Also notice that the hand is the only keyed limb.

13 Go to frame 15, set the Auto-Key TCB/IK Values to Interpolated and
   paste the posture again.
   This new key averages up the values based on the previous and next keys,
   setting Ease To/Ease From to 5 and 25, TCB to 15 and IK Blend to 0.25.
   Also, Body Space is selected from the previous key.

Interface

Create Collections Clears the current collection name and the poses,
postures and tracks associated with it.
**Load Collections** Loads a CPY file and displays its collection name at the top of the Copy Collections drop-down list, making it active.

**Save Collections** Saves all the postures, poses and tracks stored within the active collection of the current session in a CPY file.

**Delete Collection** Removes the current collection from the scene.

**Delete All Collection** Removes all collections from the scene.

**Max Load Preferences** Displays a dialog with options for actions to take upon Max file open.

The dialog contains options:
- **Keep Existing Collections** When on, sets biped to overwrite the existing Copy/Paste Buffer upon load. Default=Off.
- **Load Collections** When on, sets biped to load the Copy/Paste buffer from the incoming file, appending the current buffer. Default=On.

**Posture, Pose, and Track** Choose one of these buttons to choose which kind of information you are copying and pasting. The copy/paste buttons change to indicate the current mode. Default=Pose.

**Copy/Paste buttons** These buttons change according to the current mode, as described below in Posture on page 4738, Pose on page 4738 and Track on page 4738.

**Delete Selected** Deletes the selected posture, pose, or track buffer. The selected buffer is the active one; that is, the buffer whose name is currently displayed in the Copied Postures/Poses/Tracks list.
Delete All  Deletes all the buffers in the Copied Postures/Poses/Tracks list.

**Posture mode**

Copy Posture  Copies the posture of the selected biped objects and saves it in a new posture buffer.

Paste Posture  Pastes the posture of the active buffer onto the biped.

Paste Posture Opposite  Pastes the posture of the active buffer onto the opposite side of the biped.

**Pose mode**

Copy Pose  Copies the current pose of the entire biped and saves it in a new pose buffer.

Paste Pose  Pastes the pose of the active buffer onto the biped.

Paste Pose Opposite  Pastes the opposite of the pose of the active buffer onto the biped.

**Track mode**

Copy Track  Copies the tracks for the selected biped objects and creates a new track buffer.

Paste Track  Pastes the track or tracks in the active buffer onto the biped.

Paste Track Opposite  Pastes the track or tracks in the active buffer onto the opposite side of the biped.
**Copied Postures group**

**Copied Postures/Poses/Tracks list** For each of the modes, lists the buffers you have copied. The active buffer is the one that will be pasted by the paste buttons. To make a buffer active, choose it from the drop-down list. To change the name of a buffer, make it active, highlight its name, and enter a new name.

**Thumbnail buffer view** For Posture and Track mode, displays a schematic view of the parts of the biped in the active copy buffer. For Pose mode, displays a schematic view of the entire biped. This can help you preview the effect of pasting the active buffer.

![Thumbnail showing a copied left arm posture](image1)

![Thumbnail showing a copied pose](image2)

**Capture Snapshot from Viewport** When chosen, creates a snapshot of the active 2D or 3D viewport of entire biped.
Capture Snapshot Automatically When chosen, creates a front view snapshot of the isolated body parts.

No Snapshot When chosen, replaces the snapshot with a gray canvas.

Show/Hide Snapshot Toggles maximize/minimize of the snapshot view.

Paste Options group

The Horizontal, Vertical and Rotation copy options found in older versions of character studio have been replaced by the Paste Options. By default, copying poses or postures with the COM selected copies all three COM tracks.

Paste Horizontal/Vertical/Rotation buttons When turned on, the COM's Body Horizontal, Vertical or Rotation data are set to be pasted next time you perform a paste operation. Choosing to paste COM data maintains the world space positions and orientation of the copied COM onto the current data tracks. Otherwise, the COM's current positions and orientation are maintained when the copied data tracks are pasted. See Example: To maintain copied COM data when pasting poses: on page 4731

TIP This choice can be seen as pasting absolute or relative COM animation. The former will overwrite the current data with the copied one while the latter will maintain the current data, ignoring all copied information.

By Velocity When on, determines the values of the active COM tracks based on the previous trajectory of the COM through the scene. This option is only enabled when the Paste Horizontal/Vertical/Rotation buttons are active. See Example: To maintain COM offsets using By Velocity: on page 4733

NOTE If there is no previous trajectory from which to gather the velocity data, the COM result is considered as absolute.

Auto-Key TCB/IK Values Active only in Auto Key mode on page 8090.

NOTE If part of the copied biped is linked to an IK object, that object it is not transferable using the copy/paste process. However, the Join to Prev IK Key option is maintained, as well as they Body or Object options. If a copied pose or posture contains an IK Object, the data becomes baked into the biped's link while keeping the key in Object space.
NOTE If part of the pasted biped is linked to an IK object, that object is maintained even while the new pose or posture is honored. In other words, if an incoming pose requires a change in an existing link between a biped limb and an IK object, the link is maintained and adjusted accordingly.

**Default** Sets (on the Key Info rollout on page 4704) the TCB Ease To and Ease From to 0, and Tension, Continuity and Bias to 25. These settings are unrelated to what was copied or where it is pasted. Any IK key values already set are maintained. Otherwise, values will be obtained from the position in time between the previous and next keys.

**Copied** Sets the TCB/IK values to match those from the copied data. If a copied pose or posture is not on a key, the TCB/IK values are based on interpolation from the previous and next keys.

**Interpolated** Sets the TCB values to an interpolation from the animation on which you are pasting. If an existing key is being pasted, its TCB values are maintained. Along the same lines, existing IK values are also maintained when pasted. If no key is present, the IK values are set from the position in time between the previous and next keys.

### Layers Rollout

Select the Biped > Motion panel > Layers rollout

Controls on the Layers rollout allow you to add layers of animation above the original biped animation. This is a powerful way of making global changes to your character animation.

For example, add a layer to a run cycle and rotate the spine forward at any frame, and it becomes a crouched run. The original biped motion is kept intact and can be viewed by switching back to the original layer. You can view layers individually or as a composite of all the animation in all the layers. Layers behave like freeform animation; the biped can adopt any position.

**TIP** You can globally translate both footstep and freeform animation by doing a layered edit on the center of mass on page 4663. For example, by adding a layer and moving the center of mass you can move a freeform or footstep animation.

With layers, you can easily adjust raw motion-capture data, which contains keys at every frame. Simply add a layer and keyframe the biped. The original layer is displayed as red bones.
Honoring IK Constraints Across Layers

You can maintain a biped's IK constraints across layers by retargeting its hands and feet to the original layer. This assures that the biped's constrained body parts are honored and locked in place while you make animation changes on the upper layers.

You can also choose to retarget a biped using another one as reference. This is useful when you need to precisely match hands and feet positioning between two animated bipeds with different body proportions.

You can save an animation containing honored constraints across layers in a BIP on page 8520 file. However, if the layered animation links to another biped as reference, that link is not saved with the animation.
Procedures

Example: To Maintain IK Constraints Across Layers:

This procedure takes into account the fundamentals of animating across layers and expands on the concept of honoring IK constraints.

1 Prepare a biped with IK keys on its feet, and its left hand constrained to an IK object.

2 Select your biped and expand the Layers rollout on the Motion panel.

3 Create a new layer and rename it Low center of mass.
   The Retarget Left Arm button in the Retargeting group becomes active, which indicates that the current layer honors the IK constraint of the base layer for this body part.
4 Turn on Auto Key mode on page 8090.

5 On the Track Selection rollout, turn on Body Vertical. This selects the biped's center of mass.

6 Lower the center of mass on the Z axis until the biped's head is under the base layer's head display (represented as a red box).

TIP To avoid deselecting the center of mass, you can lock it by clicking the Selection Lock Toggle on page 8079 (or press the spacebar).
The entire biped is lowered except its left hand, which remains locked to the object because the current layer retargets it to match the respective IK constraint of the base layer.

Only the biped's left hand constraint is honored.

7 In the Retargeting group, turn on both Retarget Left Leg and Retarget Right Leg. Then, click Update.

The biped's IK feet are adjusted to match those of the base layer. The animation keys are updated to reflect the current layer's retargeted feet.

TIP If some body parts assume odd positions, simply drag the time slider on page 8068 a few frames past your current frame, and then drag it back home.
Both the biped's feet and left hand constraints are honored.

8 You can continue animating the biped to your liking. Collapse your layers when you are satisfied.

Example: To Maintain IK Constraints From a Reference Biped:
This procedure centers on using an animated biped as a retarget reference for another biped with disproportionate body parts. This method is often used when a motion is imported from raw data and adapted to bipeds with different proportions.

1 Prepare an animated biped or load a BIP on page 8520 file onto one.
2 Create a second biped alongside and rename it Disproportionate Biped.
3 Select *Disproportionate Biped* and enter *Figure Mode* on page 4758. You can now change the biped's structure.

4 Scale its upper arms and thighs to make them disproportionate from the rest of its body.

---

**TIP** You can quickly select body parts on both sides of a biped if you first select the body part, then click Symmetrical on the *Track Selection rollout* on page 4686.
5  Exit Figure Mode.

6  Keep *Disproportionate Biped* selected and expand the Layers rollout.

7  Click Select Reference Biped and select your original biped in the viewport.

*Disproportionate Biped* adopts the animation from the reference biped, whose name is now displayed next to the Select Reference Biped button.
8 Add a new layer and rename it *Retargeted Biped*.

9 Turn on both Retarget Left Arm and Retarget Right Arm, and then click Update.

Both hands precisely match those from the reference biped. The animation keys are updated to reflect the current layer's retargeted hands.
Both hands are retargeted to honor the base layer IK constraints.

10 Turn on both Retarget Left Leg and Retarget Right Leg. Then, click Update.
The feet are correctly retargeted to the reference biped, updating the respective animation keys.
The feet are retargeted to honor the base layer IK constraints.

11 Use Previous layer and Next Layer to switch between the original and Retargeted Biped layers. The base layer displays the non-targeted motion while Retargeted Biped shows an adjusted motion that matches both hands and feet from Disproportionate Biped with the original biped.

12 You can continue animating the biped to your liking. Collapse your layers when you are satisfied.
**Interface**

**Load and Save buttons**

You can load and save individual biped layers as BIP files.

- **Load Layer** Click to display a file selector and open a BIP file for the layer that is currently active.

3ds Max objects and list controllers are loaded only at the base layer (0). When you load into a higher layer, separate tracks are removed, and IK is removed for any limb.

If Retarget is on for a limb, the limb keys are removed. After you load a layer, retargetting does not happen automatically: you must click Update after you load the layer.
Save Layer Click to display a file selector and save the current layer's animation in a BIP file.
3ds Max objects are saved only at the base layer (0).

Previous-Next Layer Navigate through the layers using the up and down arrows.
Level This field displays the current layer (Level).
Active Toggles the displayed layer on and off.
Name Field Type a name to easily identify a layer.

Create Layer Creates a layer, and the Level field increments.
Position the biped to create keys in a layer.

Delete Layer Deletes the current layer.
All layer numbers 'above' the one deleted are decremented by one.

Collapse Layers Collapses all the layers into layer 0.
Legs that stray from the original footsteps in higher layers are "pulled in" to the original footsteps.

Snap Set Key Snaps the selected biped part to its original position in layer 0 and creates a key.
Use this in higher layers to return the selected biped part to the original motion. If a layer has a posture key that bends the character forward at frame 2 and you want to return the biped to its original posture motion at frame 50, use Snap Set Key at frame 50 with a spine object selected. The character will interpolate from its forward posture position to its original posture position between frame 2 and 50.

Activate Only Me View the animation in the selected layer.
Choose Play after turning on Activate Only Me to view a layer's keys in motion.
Activate All Activates all the layers. Playing the animation shows a composite of all the layers.

Visible Before Sets the number of preceding layers to display as stick figures.

Visible After Sets the number of succeeding layers to display as stick figures.

Key Highlight Displays keys by highlighting the stick figures.

Retargeting Group

The tools in this group let you animate a biped across layers while maintaining the IK constraints of the base layer. You can also choose to use a different biped in your scene to use as reference for your biped's retargeted hands and feet.

Biped’s Base Layer Choose this method to use the IK constraints from the selected biped's original layer as retarget reference. Default=active.

Reference Biped Choose this method to use the biped whose name is displayed next to the Select Reference Biped button as retarget reference.

Select Reference Biped Lets you choose a biped to use as retarget reference for the selected biped. The chosen biped's name is displayed next to the button.

Retarget Left Arm When on, the IK constraints of the base layer are honored for the biped's left arm.

Retarget Right Arm When on, the IK constraints of the base layer are honored for the biped's right arm.

Retarget Left Leg When on, the IK constraints of the base layer are honored for the biped's left leg.

Retarget Right Leg When on, the IK constraints of the base layer are honored for the biped's right leg.

Update Calculates the selected biped's hands and feet positions for every set key based on the retarget method (Base Layer or Reference Biped), the active retarget body parts buttons, and the IK Only option.
IK Only  When on, the biped’s constrained hands and feet are retargeted only during the frames on which they are IK controlled. When off, the hands and feet are retargeted during both IK and FK keys. Default=off.

Dynamics & Adaptation Rollout

Select the biped. > Motion panel > Dynamics & Adaptation rollout

The controls on the Dynamics & Adaptation rollout let you specify the way you want to create biped animation. The parameters let you modify gravity strength, dynamic properties for keys generated by newly created footsteps, the number of transform tracks available on the biped, and prevent key adaptation.

Biped Dynamics and Spline Dynamics

These parameters specify how new biped center of mass keys are created and therefore how you want to work with the biped. Turning on Spline Dynamics will create center of mass keys, without gravity and balance calculation, for newly created footsteps. This may feel more familiar to new users who are already familiar with spline interpolation.

Biped Dynamics calculates biped airborne trajectory, knee bend on landing and positions the biped to maintain balance when the spine is rotated. When parameters change, the biped adapts. Turn on Biped Dynamics and use this adaptation to your advantage.

You can always change from one method to the other on a per-key basis or for the entire animation at any time.

See also:

- Adjusting Vertical Motion on page 4555
**Interface**

**GravAccel** Sets the strength of the gravitational acceleration used to calculate the biped’s motion.

By default, this parameter is set to accurately simulate Newtonian gravity as found on the Earth’s surface.

At a value of 0, the biped still runs but the feet hardly get off the ground.

**Biped Dynamics** Creates new center-of-mass keys using Biped Dynamics. Keys for the center of mass (COM) Balance Factor and Dynamics Blend parameters are set to a value of 1. Biped calculates airborne trajectories and biped balance.

**NOTE** Use Dynamics Blend on the Key Info rollout > Body group to set a vertical COM key that is a blend between Dynamics and Spline Interpolation; a value of 1 is full Dynamics, a value of 0 is full Spline interpolation.

**Spline Dynamics** Creates new center-of-mass keys using full spline interpolation. All new vertical COM keys are created with Dynamics Blend=0, and all new horizontal COM keys are created with Balance Factor=0.
Footstep Adapt Locks group

Lock specified tracks to prevent automatic adjustments being made to those tracks when footsteps are moved in space or edited in time. All the locks except for Time work for footstep editing in space. Time locks upper body keys when footsteps are edited in time (Track View). Adapt Locks only applies to a Footstep animation, not a freeform animation.

When you move a footstep in space or adjust footstep timing, Biped automatically adapts existing keyframes to match the new footsteps. Adapt locks allows you to preserve the exact position of already created keys for a selected track.

Adapt Locks does not need to be on all the time. For example, if you want to raise all the footsteps along the world Z-axis, without changing the upper body position, turn on Footstep Adapt Locks group > Body Vertical Keys, turn on Footstep mode, select all the footsteps and move them up along the world Z-axis. The footsteps are repositioned, the legs are adapted, but the upper body retains the same motion rather than being raised with the footsteps. Now turn off Body Vertical Keys, and the upper body still retains its original motion.

Use Footstep Adapt Locks > Time to retain upper body motion while editing footstep duration in Track View. When the duration of a footstep is changed, the biped leg will adapt by re-timing the touch, plant, and lift keys. The biped upper body keys will retain their exact motion.

**Body Horizontal Keys** Turn on to prevent adaptation of body horizontal keys when footsteps are edited in space.

**Body Vertical Keys** Turn on to prevent adaptation of body vertical keys when footsteps are edited in space.

**Body Turning Keys** Turn on to prevent adaptation of body turning keys when footsteps are edited in space.

**Right Leg Move Keys** Turn on to prevent adaptation of right leg move keys (a leg move key, is a leg key between footsteps) when footsteps are edited in space.

**Left Leg Move Keys** Turn on to prevent adaptation of left leg move keys (a leg move key, is a leg key between footsteps) when footsteps are edited in space.

**Freeform Keys** Turn on to prevent adaptation of a freeform period in a footstep animation. The biped’s position during a freeform period will not move if footsteps after the freeform period are moved further away.
Time Turn on to prevent adaptation of upper body keys when footstep duration is changed in Track View.

NOTE Leg and foot keys for frames in which the foot is in contact with the ground are always automatically adapted.

Figure Mode

Select the Biped > Motion Panel > Biped rollout > Figure mode

While Figure mode is active, you can change biped structure and fit that structure to a character mesh. It can be used for a variety of other procedures as well.

- **Figure mode is a reference position to fit a biped to a mesh.** Use Figure mode to fit a biped to the mesh representing your character. This "reference" or Figure mode position, in which the biped is aligned to the mesh, is necessary when a mesh is linked or attached to the biped with Physique. After the biped is positioned to fit within a mesh, leave Figure mode on during the process of attaching a mesh to the biped with Physique, or when using Select And Link on the 3ds Max toolbar to link the mesh objects of a character to the biped. The relationship or "fit" position between the biped and the mesh can always be restored by turning on Figure mode, regardless of which motion file happens to be loaded. After fitting a biped to a mesh in Figure mode, use Save on the Biped rollout to save a figure file (.fig). If you accidentally reposition the biped in Figure mode, load the figure file.
Figure mode is used for biped adjustment after a mesh is attached to correct biped joint location. After using Physique to attach a mesh character to the biped, you may want to reposition a biped limb relative to the mesh. For example, if the biped shoulder joint is too far out relative to the mesh shoulder, then the Physique modifier must be inactivated, the biped limbs adjusted, and then a Reinitialize in Physique must be performed before reactivating the Physique modifier.

Figure mode is used for biped adjustment after a mesh is attached to correct posture in a motion file. Figure mode is also used to make adjustments after a character is attached or linked to the biped. After loading a .bip motion file, for example, you may find that the character is hunched too far forward during the entire animation. Rotating the biped's spine objects in Figure mode will correct the character's posture for the entire animation. This is a basic procedure where you simply rotate the biped limbs in Figure mode and then exit Figure mode; the posture will be corrected for the entire animation.

Figure mode is used to define biped structure. The Structure rollout on page 4762 is displayed when you work in Figure mode, allowing you to tailor the biped to your mesh character. After creating a biped, make all of your biped structure changes on the Structure rollout. For example, you may want to use one toe with one toe link if your character is wearing shoes or if your character's toes do not need to be keyframed individually. Set the biped structure before "fitting" the biped to the your mesh character.

Turn Figure mode on to scale a character. Use the height spinner on the Structure rollout to scale a complete character (a complete character has a biped and mesh attached with Physique).

Reverse-Knee Characters. If your character mesh has reverse knees, rotate the biped calves or thighs along the local X axis 180 degrees in Figure mode; the biped local X axis is along the length of the limb. character studio assumes you want a reverse knees character if the calves or thighs are rotated past 90 degrees in the local X axis. When Figure mode is turned off, the biped walks, runs, and jumps with reverse knees.

Moving the Head

While in Figure mode, you can move the head relative to the body. This is another way to help fit the biped into a character's skin.
You can move a biped’s head in Figure mode.

Notes on Fitting the Biped to a Mesh in Figure Mode

These are quick notes designed to give you a general sense of the issues involved when a biped is fitted to a mesh.

- Use the Structure rollout to set the number of toes and fingers; specify the number of links per finger and toe. One toe with one toe link is often sufficient if your character wears shoes, or if animating individual toes will not be necessary.
- Put the lowest biped spine object at the character's belt-line.
- Scale the biped fingers to slightly protrude from the character's hand.
- Rubber Band mode and scale are used to size the biped limbs to fit the biped to a mesh.
- Use the options from the Twist Links group on page 4770 to transfer twisting animation in the biped's associated mesh.
- Use Props to represent weapons or tools attached to your character.
- Use Select And Link on the 3ds Max toolbar to link non-deformable (mechanical) objects to the biped. Do this after Physique is applied to prevent Physique from generating extra links (Envelopes). Superfluous envelopes (links) can be turned off in Physique however, so this is not critical.

**NOTE** Objects like eyeballs and weapons should be linked to the biped after Physique is applied; otherwise links (Envelopes) will extend to these objects when Physique is applied.

- Reposition and use Ponytails on the Structure rollout to animate a character's jaw, ears, hat, hair and ponytails.
- A saved .fig file can be reloaded if the biped is repositioned in Figure mode by mistake.

Move the first link on each finger to position the fingers relative to the mesh; use local and world coordinate systems for this. Scale the finger links to position the joints. After positioning the thumb, rotate the first thumb link around the local X-axis until the local Z-axis creates a natural rotation for the thumb (refer to the image). A User view and toggling back and forth between a shaded and wireframe display is helpful when fingers are positioned.
**Structure Rollout**

Select the biped. > Motion panel > Biped rollout > Turn on Figure mode > Structure rollout

Turn Figure mode on to enable parameters on the Structure rollout. The Structure rollout provides parameters for changing the biped's skeletal structure to match your character mesh (dinosaur, robot, human, and so on). You can also add up to three props to your biped, to represent tools or weapons.

After setting parameters to suit your character, use the Height parameter to scale the biped to the size of the mesh representing your character. This is the first step in fitting a biped to a mesh in Figure mode.

**Procedures**

**To Scale a Biped and a Physique Mesh:**

- Select the biped, turn on Figure mode, and then change the biped height on the Structure rollout. The biped and mesh scale together.

**To Skin a Biped with Twist Links:**

This procedure takes into account the process of skinning a character and expands on the concept of using twist links to better deform a skinned mesh.

1. Position a biped within the mesh.

2. Select the biped and turn on Figure Mode.

3. On the Structure rollout, turn on the Twists option. This enables the input fields for all biped limbs.

   **NOTE** Horse Link is only available if your biped has four leg links.

4. Set Forearm to 5. Both forearms have five twist links.
TIP To get a better view of your twist links, you can select the forearms and turn on See-Through in the Display Properties rollout on page 164 on the Display panel (or press Alt+X).

See-Through turned on for the right forearm only.

5 Add a Skin modifier on page 1667 to the mesh.
6 Unfreeze all the biped twist bones.
7 On the Skin Parameters rollout of the Motion panel, add all the biped bones to the skin except the forearms.
8 Select and freeze the twist bones again.
9 Turn on Edit Envelopes on the Parameters rollout.
10 Select and adjust the Envelopes of the twist bones until the desired behavior is achieved, moving and rotating the hand to test.
Body Type group

The Body Type group lets you select the biped's body type:

- **Skeleton**  The skeleton body type provides a realistic skeleton which fits naturally into mesh skins.
- **Male**  The male body type provides a silhouette mold based on basic male proportions.
- **Female**  The female body type provides a silhouette mold based on basic female proportions.

- **Classic**  The classic body type is the same as the biped object from older versions of *character studio*.

---

**Arms** Sets whether arms will be generated for the current biped.

**Neck Links** Sets the number of links in the biped neck. Default=1. Range=1 to 25.

**Spine Links** Sets the number of links in the biped spine. Default=4. Range=1 to 10.

**Leg Links** Sets the number of links in the biped legs. Default=3. Range=3 to 4.

Setting Leg Links adds a *horse link*: an additional, lower leg bone suitable for animating quadrupeds, or humanoids with animal legs such as the Greek god Pan.

**Tail Links** Sets the number of links in the biped tail. A value of 0 specifies no tail. Default=0. Range=0 to 25.

**Ponytail1/2 Links** Sets the number of Ponytail Links. Default=0. Range=0 to 25.

You can animate hair with ponytail links. Ponytails are linked to a character’s head and can be used to animate other appendages. Reposition ponytails in Figure mode and use them to animate a character’s jaw, ears, nose, or anything that should move with the head.

Unlike the process of selecting the biped hand and dragging to reposition the entire arm, ponytails must be keyed using rotational transformations.

**Fingers** Sets the number of biped fingers. Default=1. Range=0 to 5.

When you turn on Knuckles, 3ds Max sets this value to 5. While Knuckles is on, you can reduce the number of fingers, depending on the character you want to animate.

**Finger Links** Sets the number of links per finger. Default=1. Range=1 to 4.

When you turn on Knuckles, 3ds Max sets this value to 4. While Knuckles is on, you can reduce the number of finger links, depending on the character you want to animate.

**Toes** Sets the number of biped toes. Default=1. Range=1 to 5.
**Toe Links** Sets the number of links per toe. Default=3. Range=1 to 3.

**TIP** Characters wearing shoes might need only one toe with one link.

**Props 1/2/3** Turns on up to three props, which can be used to represent tools or weapons attached to the biped. By default, prop 1 appears next to the right hand, prop 2 appears next to the left hand, and prop 3 appears centered between in front of the torso.

You can animate props throughout the scene, like any object. You can use 3ds Max controllers to animate props and can then collapse animation onto the prop’s transform controller for use in Mixer, Motion Flow, and Layer editing.

**Ankle Attach** Specifies the ankles’ point of attachment along the corresponding foot block. The ankles can be placed anywhere along the centerline of the foot block, from the heel to the toe.

*Ankle Attach=0.25 and Ankle Attach=0.5*

A value of 0 places the ankle attachment point at the heel. A value of 1 places the ankle attachment point at the toes. Click the spinner up arrow to move the ankle attach point toward the toes. Range=0 to 1.

**Height** Sets the height of the current biped.

Use to size the biped to your mesh character before Physique is attached. This parameter is also used in a procedure to scale your character after Physique is attached.

**Triangle Pelvis** Turn on to create links from the upper legs to the lowest biped spine object when Physique is attached. Normally the legs are linked to the biped pelvis object.

The pelvis area can be a problem when the mesh is deformed with Physique. Triangle Pelvis creates a more natural spline for mesh deformation.
Triangle Pelvis creates two links that extend from the legs to the lowest biped spine object. A link from the biped pelvis to the lowest spine object is also created. This provides natural deformation to this area after Physique is applied and the character is moving. If you are working on a new character, turn this on before applying Physique. If Bones is turned on in the Display rollout, links from the legs to the lower spine object are visible.

Triangle Neck When on, links clavicles to the top spine link instead of to the neck. Default=off.
Like Triangle Pelvis, this feature has no effect on how the biped animates. It is a convenience when you skin the biped using Physique. Some meshes deform more naturally with the triangular neck configuration. If you have a mesh where this is the case, turn on Triangle Neck before you apply Physique.

Left: A normal neck. The neck is the parent of each clavicle.
Right: Triangle Neck. The top segment of the spine (Spine3) is the parent of each clavicle.
**ForeFeet** When on, the biped hands and fingers behave as feet and toes: when you set Planted keys for a hand, rotating the hand does not affect the position of the fingers. Default=off.

This option turns the biped into a quadruped. You can think of the name of this option as also meaning “Four Feet.”

As with feet, the planted behavior applies only to IK periods of biped animation. After you set a Free key, the fingers rotate as children of the hands, using FK, until you set another Planted key.

This option is disable when Knuckles is turned on.

**Knuckles** When on, uses an anatomically correct hand structure, with bones for each digit. Default=off.

A standard biped hand. This setup doesn't allow for finely detailed hand animation.
A biped hand with Knuckles turned on. The hand has a small base and individual bones for all its digits, allowing for detailed animation.

**NOTE** As of Autodesk 3ds Max 2010, you always can rotate each bone of each digit with three degrees of freedom: that is, along any axis. And as with other biped bones (except for toes), you can use the Quaternion/Euler rollout on page 4693 to choose between quaternion or Euler rotation for bones in the hand.

When you turn on Knuckles, 3ds Max automatically sets the Fingers value to 5 and Finger Links to 4. Depending on the character you are animating, you can reduce the value of Fingers or Finger Links. Knuckles supports zero to five fingers on each hand, and from one to four finger links.

This option is disabled when ForeFeet is turned on.

- **Short Thumb**  When on, the thumb has one less bone that the four for the other digits. If other digits have four bones, the thumb has three, as in a human hand. When off, all five digits have the same number of bones. Default=on while Knuckles is on.
  
  You might want to turn off Short Thumb when you are creating a nonhuman character.
Short Thumb turned off while Finger Links = 4, so that all digits have four bones.

**Twist Links group**

The bone twist option, previously limited to the biped’s forearm, has been expanded to include all limbs. These settings allow better mesh deformation on skinned models (using Physique on page 4470 or Skin on page 1667) when twisting occurs on animated limbs. Use the Twist Poses rollout on page 4695 for better control over your twist links.
NOTE If a limb has twist links, they control skin deformation while the base link (the biped’s forearm, for example) drives the animation. Twist links cannot be animated.

**Twists** Enables twist links for biped limbs. When enabled, twist links become visible but remain frozen. You can unfreeze them using Unfreeze By Name or Unfreeze By Hit on the Freeze rollout on page 163.

**Upper Arm** Sets the number of twist links in the upper arms. Default=0. Range=0 to 10.

**Forearm** Sets the number of twist links in the forearms. Default=0. Range=0 to 10.

**Thigh** Sets the number of twist links in the thighs. Default=0. Range=0 to 10.

**Calf** Sets the number of twist links in the calves. Default=0. Range=0 to 10.

**Horse Link** Sets the number of twist links in the horse link: the additional, lower leg bone that appears when you set Leg Links on page 4765 to 4. Default=0. Range=0 to 10.

NOTE You must set Leg Links to 4 to enable Horse Link.
**Xtras group**

The Xtras group lets you add extra tails to the biped. Extra tails are like ponytails: they don’t use inverse kinematics, and you must animate them with forward kinematics such as rotation keys. On the other hand, extra tails don’t have to be attached to the head.

Animation for extra tails is saved in MAX and BIP files.

---

**Create Xtra** Click to create a new Xtra tail. By default, the parent of the tail is the biped’s root Center Of Mass (COM) object. You can change this by using the Pick Parent button.

**Delete Xtra** Click to delete the Xtra tail that is highlighted in the list. If you the Xtra tail you delete is parent to another tail, the child tail reverts to having the COM as its parent, but it is not repositioned.
Create Opposite Xtra Click to create another Xtra tail on the opposite side of the biped. First you must use the list to select the original Xtra tail’s name, and the original must not already have an opposite tail.

Synch Selection When on, any Xtra tail selected in the list is selected in viewports, and vice versa.

Select Symmetrical When on, selecting one tail selects the tail’s opposite as well.

Xtra name field Displays the name of the new Xtra tail. Edit this field to change the default name of the Xtra tail.

List of xtras Lists the biped’s Xtra tails, by name.

Links Sets the number of links in the tail. Default=1.

Parent name field (Motion panel only.) Displays the name of the tail’s parent object.

Pick Parent (Motion panel only.) Reassigns the parent object. Click this button to turn it on, then in a viewport, click a different part of the same biped. The part you pick becomes the tail’s parent.

Reorient to Parent (Motion panel only.) When on, the extra tail moves to the new parent object, and is oriented to the new parent. When off, assigning a new parent does not move the tail. Default=on.

Footstep Mode Rollouts

These topics describe the Motion panel rollouts that are open and active while a biped is in Footstep mode.
Footstep Mode

Select a Biped. > Motion panel > Biped rollout > Footstep Mode

When Footstep mode is active, you can create or edit footsteps to generate a walk, run, and jump footstep pattern. You also edit selected footsteps in space and append footsteps using parameters available in Footstep mode.

If footsteps are extracted during motion capture import, turn on Footstep mode to edit footsteps in the viewports.

A powerful feature in Biped is the ability to adapt keyframes when footsteps are edited in space or time. The following tracks are influenced in the vicinity when a footstep is edited in space:

- Body Horizontal keys change to step or hop within range of new footstep locations.
- Body Vertical keys change to match possible changes in stride length, since the body must be lower in order to step longer distances.
- Body Rotation keys change to bank into turns created by changes in path curvature or body speed.
- Right or left leg keys in a move state must be adapted to step between new locations.

**NOTE** If for some reason you do not want the adaptation to occur, use the Footstep Adapt Locks settings on the Dynamics & Adaptation rollout on page 4755 to keep the biped from correcting the body position.

Two additional rollouts display when Footstep mode is active: Footstep Creation rollout on page 4774 and Footstep Operations rollout on page 4778.

Footstep Creation Rollout

Select a Biped with footsteps > Motion panel > Biped rollout > Footstep Mode > Footstep Creation rollout

The Footstep Creation rollout, available on the Motion panel when Footstep mode is on, provides controls for creating and editing footsteps. Create a walk, run, or jump footstep pattern using these controls.
**TIP** All footsteps created here are inactive; you activate them using Create Keys For Multiple Footsteps on the Footstep Operations rollout on page 4778.

The timing parameters at the bottom of the rollout work with Create Footsteps (append) and Create Footsteps (at current frame) to change timing for newly created footsteps. These change depending on whether you select Walk, Run, or Jump mode.

---

### Procedures

**To create multiple footsteps:**

1. On the Biped rollout, click Footstep Mode.
   
   You are now in Footstep mode, and can create, activate, or edit footsteps.

2. On the Footstep Creation rollout, choose the gait you want to create: Walk, Run, or Jump.

3. Click Create Multiple Footsteps.
   
   The Create Multiple Footsteps dialog displays for the selected gait.

4. Set multiple footprint parameters, and then click OK.

5. On the Footstep Operations rollout, click Create Keys For Inactive Footsteps to activate the footsteps.

**To create footsteps manually, beginning at the current frame:**

1. On the Footstep Creation rollout, click Walk, Run, or Jump and set timing parameters for that gait.

2. Click Create Footsteps (at current frame).

3. Click in a viewport to create a footprint. Continue clicking to create more footsteps.

4. On the Footstep Operations rollout, click Create Keys For Inactive Footsteps.

5. Play the animation.
To append footsteps onto the existing footsteps:

1. On the Footstep Creation rollout, click Create Footsteps (append).

2. Click in a viewport to create a footstep. Continue clicking to create more footsteps.
   By default, footsteps alternate from foot to foot. The first click creates a right footstep, the next click creates a left footstep, and so on. Look at the prompt line and the cursor to see which type of footstep will be created next.

Interface

- Create Footsteps (append) Turn on Create Footstep mode. Manually place footsteps by clicking in any viewport. Hold the mouse button down after clicking to move a footstep. Release the mouse button to place the footstep.
  Each new footstep is appended to the end of the biped's footstep sequence. Create Footsteps alternates right and left footsteps as you create new ones. Press Q to toggle between a left and right footstep.
  Newly created footsteps are bright green for right footsteps and bright blue for left footsteps. Once the footsteps have been activated, the footsteps change color to pastel green and pastel blue.

- Create Footsteps (insert at current frame) Create footsteps at the current frame. Footstep creation alternates between left and right footsteps.

- Create Multiple Footsteps Create a walk, run, or jump footstep pattern automatically. Select a gait type before using Create Multiple Footsteps. Displays the Create Multiple Footsteps dialog. The dialog differs slightly depending on the gait (walk, run, jump) you have selected.
Create Multiple Footsteps Dialog: Walk on page 4781
Create Multiple Footsteps Dialog: Run on page 4787
Create Multiple Footsteps Dialog: Jump on page 4791

Walk Sets the biped gait to Walk. Any footsteps you add will have walk characteristics until you change to another mode (run or jump). Each new footstep will start before the end of the previous footstep on the opposite side.

Run Sets the biped gait to Run. Any footsteps you add will have run characteristics until you change to another mode (walk or jump). Each new footstep will start after the end of the previous footstep on the opposite side.

Jump Sets the biped gait to Jump. Any footsteps you add will have jump characteristics until you change to another mode (walk or run). Each new footstep will start at the same time as the most recent footstep on the opposite side. Alternately, it may start after the end of the previous footstep.

Timing parameters

<table>
<thead>
<tr>
<th>Run Footstep</th>
<th>6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Airborne</td>
<td>9</td>
</tr>
</tbody>
</table>

Use these parameters with Create Footsteps (append) or Create Footsteps (at current frame) to apply timing to newly created footsteps. These parameters are different for each gait and change as you select a different gait.

Walk Footstep  (Walk only): Specifies the number of frames a new footstep will be on the ground during a walk.

Double Support (Walk only): Specifies the number of frames when both feet will be on the ground at the same time during a walk.

Run Footstep  (Run only): Specifies the number of frames a new footstep will be on the ground during a run.

Airborne  (Run and jump only): Specifies the number of frames when the body will be in the air during a run or a jump.

2 Feet Down (Jump only): Specifies the number of frames when two sequential footsteps, on opposite sides, will be on the ground during a jump.
Footstep Operations Rollout

Select the Biped > Motion Panel > Biped rollout > Footstep Mode > Footstep Operations rollout

Once footsteps are created on the Footstep Creation rollout, use parameters on the Footstep Operations rollout to activate and deactivate footsteps, and to adjust the footstep path.

Interface

Create Keys for Inactive Footsteps Activates all inactive footsteps. Activation creates default keys for any footsteps that do not have them. If a footstep does not have keys, it is displayed as bright green (right foot) or bright blue (left foot). After keys are created for the footsteps, the footsteps change color to pastel green and pastel blue.

Inactive footsteps on the left and activated footsteps on the right
Deactivate Footsteps  Removes the body keys assigned to the selected footsteps, making those footsteps inactive. The footsteps themselves remain in the scene.

Delete Footsteps  Deletes the selected footsteps.

Copy Footsteps  Copies the selected footsteps and biped keys to the footstep buffer. Biped will only copy a continuous sequence of footsteps (2,3,4,5...). You can't copy discontinuous footsteps (3,4,7,8...). If any footsteps exist that have not been activated, the Copy button is grayed. Activate the footsteps first, then try again.

TIP  Turn on Buffer mode on the Biped rollout to view and edit only the buffered footsteps and biped motion.

A pasted footstep is inactive until it overlaps a like foot and turns red. Mouse up to activate the new footsteps.

Paste Footsteps  Pastes footsteps from the footstep buffer into a scene. The footsteps appear inactive in the scene. Move them so they overlap the active footsteps. When a footstep turns red, mouse up and the pasted footsteps will activate.
WARNING If any footstep in the buffer overlaps in time with a footstep previous to the one onto which you are pasting, a message appears and the paste is not performed. This can occur if the first footstep you are pasting and the original footstep you are pasting onto both have double support periods during the same duration of the footstep. The second pasted footstep and the footstep prior to the one you are pasting onto may overlap in time.

To correct the problem, you may want to move the right edge of the preceding footstep from the original scene to the left, or move the left edge of the second pasted footstep to the right while in buffer mode. Which option you choose depends on what footstep timing and support relations you want to end up with.

TIP To create a cycle of a motion with alternating footsteps, you must copy and paste at least three footsteps. All body keys between the start of the first step and end of the last step are also copied and pasted.

Bend Bends the path for the selected footsteps. The path is bent to the left or right as you move the spinner. Other footsteps after the selected footsteps will be moved to maintain their positions relative to the repositioned footsteps. The Bend spinner is grayed if inactive footsteps are present.

Scale Changes the width or length for the selected footsteps. The selected footsteps are scaled around the first footstep in the selection. First select the width or length box (or both), then use the spinner to set the amount of scaling. If any footsteps exist that have not been activated, the Scale spinner is grayed out. Activate the footsteps first, then try again.
Length When Length is selected, the Scale spinner changes the stride length of the selected footsteps. Length and Width may both be active at the same time.

Length=1 and Length=2

Width When Width is selected, Scale changes the stride width of the selected footsteps. Length and Width may both be active at the same time.

Width=1 and Width=2

Create Multiple Footsteps Dialog: Walk

Select the Biped. > Motion Panel > Biped rollout > Footstep Mode > Footstep Creation rollout > Walk > Create Multiple Footsteps > Create Multiple Footsteps Walk dialog

The Create Multiple Footsteps dialog for the walk gait creates a sequence of walking footsteps using a series of parameters.
This dialog displays when you select the Walk gait on the Motion panel's Footstep Creation rollout, then click Create Multiple Footsteps.

**NOTE** The Create Multiple Footsteps dialog appears differently depending on the gait chosen. For other gaits, see Create Multiple Footsteps Dialog: Run on page 4787 and Create Multiple Footsteps Dialog: Jump on page 4791.

### Procedures

**To make the biped walk up or down stairs:**

- In the First Step group, set Actual Stride Height to a value other than 0. A value higher than 0 will cause the biped to step up, while a value below 0 will make it step down.

**To make the biped walk in place:**

- In the First Step group, Set Parametric Stride Length to zero.

**To make the biped walk backward:**

- In the First Step group, set Parametric Stride Length to a value less than zero.
  The absolute value of the Parametric Stride Length is still the length of the stride.

**To make the biped speed up as it walks:**

1. In the Timing group, click Interpolate.
   The controls in the Last Step group are enabled.

2. In the Last Step group, set Time To Next Footstep to be a value less than Time To Next Footstep in the First Step group.
   You can adjust the values in either group, or both. The important thing is to make the Last Step a shorter time than the First Step.
Interface

Start Left Starts the footstep sequence with a left step.

Start Right Starts the footstep sequence with a right step.

Alternate Footsteps will alternate between right and left. Alternate is always selected when the Walk gait is selected. You can only clear Alternate when Run or Jump gaits are selected.

Number of Footsteps Determines the number of new footsteps to be created.

Parametric Stride Width Sets the stride width as a percentage of the pelvis width. A value of 1.0 produces a stride width equal to the pelvis width. A value of 3.0 produces a wide, waddling stride. Changes to this setting automatically change the Actual Stride Width.

Parametric describes the parameter in terms of biped anatomy, and Actual describes the value in 3ds Max units.
Stride Width=1 and Stride Width=3

**Actual Stride Width** Sets the stride width in modeling units. Changes to this setting automatically change the Parametric Stride Width.

**Total Distance** Displays the total distance the footsteps will travel with the current settings. This value cannot be changed directly.

**OK** Creates footsteps with the current settings.

**Cancel** Cancels footstep creation.

**Default** Resets the values on the dialog to default values.

**Timing group**

**Auto Timing** Sets timing parameters automatically. Auto Timing affects the following timing parameters for the Walk gait:

- **Walk footstep, Double Support**
  When Auto Timing is selected, these parameters are automatically adjusted to reasonable values. Control the footstep sequence by adjusting the Stride Length and Time To Next Footstep parameters.
  
  When Auto Timing is off, you can control the footstep sequence by adjusting the gait timing parameters, but you can't change the Time To Next Footstep parameter.

**Interpolate** Control acceleration or deceleration of the series of footsteps. When this box is selected, a second set of step parameters under Last Step is enabled.

Biped creates footsteps starting with the values of the parameters under First Step and ending with the values of the parameters under Last Step.
By interpolating between the two, Biped produces a footstep series that changes over time.

When Interpolate is cleared, the Last Step parameters are grayed out. Biped creates all the footsteps using only the parameters under First Step.

**Start After Last Footstep** Appends the newly created footsteps to the end of the existing footstep sequence.

**Start at Current Frame** Inserts the newly created footsteps at the current frame after the existing footstep sequence, allowing you to make a gap in time before the footsteps start again.

**First Step and Last Step groups**

**Parametric Stride Length** Sets the stride length for the new footsteps as a percentage of the length of the biped’s leg. The default value of 0.75 gives an average stride of normal proportions.

A value of 1.0 will produce a stride length equal to the leg length, which makes the biped stretch slightly to reach the next step. A value of 0.0 will make the biped walk in place. A negative stride length will make the biped walk backwards.

When a biped walks backwards, it does not simply reverse the forward movement but maintains the correct foot-state sequence with the toe touching the ground first, followed by the heel.

Adjusting Parametric Stride Length automatically changes the value for Actual Stride Length.

**Stride Length=0.75 and Stride Length=1**

**Actual Stride Length** Sets the stride length for new footsteps in 3ds Max units. The same rules apply as for Parametric Stride Length (described above).
Adjusting Actual Stride Length automatically changes the value for Parametric Stride Length.

**Actual Stride Height** Sets the rise or fall between footsteps. You can use this parameter to create a set of footsteps going up or down a slope or a stairway. The value for Actual Stride Height is the difference in height in units between each of the new footsteps. Positive values step up and negative values step down.

![Stride Height=5 units](image)

**Time to Next Footstep** Specifies the number of frames in each foot movement cycle. A cycle starts with the frame that a foot touches the ground, continues as the foot lifts and moves, and ends with the frame before the foot touches the ground again. This parameter is only enabled if Auto Timing is on.

**Speed** Displays the number of units the biped will move per frame. It changes in response to changes in the other parameters but cannot be adjusted directly. The following two parameters are only enabled when Auto Timing is off.

**Walk Footstep** Specifies the number of frames each footstep will be on the ground during a walk. The higher the number, the longer each biped foot remains in contact with the ground and, consequently, the slower the speed of the walking motion.
Footsteps 3 through 5 are on the ground for 22 frames each.

**Double Support** Specifies the number of frames both feet will be on the ground at the same time during a walk. The higher the number, the longer the period during which both feet remain in contact with the ground during each walk cycle and, consequently, the slower the speed of the walking motion.

The dotted line surrounds the double-support period (6 frames).

**Create Multiple Footsteps Dialog: Run**

Select the Biped > Motion Panel > Biped rollout > Footstep Mode > Footstep Creation rollout > Run > Create Multiple Footsteps > Create Multiple Footsteps Run dialog.

The Create Multiple Footsteps dialog for the run gait allows you to create a sequence of running footsteps by setting a series of parameters. This dialog will display when Run is selected on the Footstep Creation rollout first, and then Create Multiple Footsteps is clicked.

**Interface**

- **Start Left** Starts the footstep sequence with a left step.
- **Start Right** Starts the footstep sequence with a right step.
Alternate Turn on to alternate between right and left footsteps. When this box is cleared, all of the footsteps will be either right or left, producing the effect of a hopping run on one foot.

**Number of Footsteps** Determines the number of new footsteps to be created.

**Parametric Stride Width** Sets the stride width as a percentage of the pelvis width.

A value of 1.0 produces a stride width equal to the pelvis width. A value of 3.0 produces a wide, waddling stride. Changes to this setting automatically change the Actual Stride Width.

Parametric describes the parameter in terms of biped anatomy, and Actual describes the value in 3ds Max units.

![Stride Width=1 and Stride Width=3](image)

**Actual Stride Width** Sets the stride width in modeling units. Changes to this setting automatically change the Parametric Stride Width.

**Timing**

**Auto Timing** Sets timing parameters automatically.

Auto Timing affects the following timing parameters for the Run gait:

- Run footstep, Airborne
  When Auto Timing is selected, these parameters are automatically adjusted to reasonable values. You control the footstep sequence by adjusting the Stride Length and Time to Next Footstep parameters.
  When Auto Timing is off, you can control the footstep sequence by adjusting the gait timing parameters, but you can't change the Time to Next Footstep parameter.
**Interpolate** Control acceleration or deceleration of the series of footsteps. When this box is selected, a second set of step parameters under Last Step is enabled.

Biped creates the footsteps starting with the values of the parameters under First Step and ending with the values of the parameters under Last Step. By interpolating between the two, Biped produces a footstep series that changes over time.

When Interpolate is cleared, the Last Step parameters are grayed out. Biped creates all the footsteps using only the parameters under First Step.

**Start After Last Footstep** Appends the newly created footsteps to the end of the existing footstep sequence.

**Start at Current Frame** Inserts the newly created footsteps at the current frame after the existing footstep sequence allowing you to make a gap in time before the footsteps start again.

**First Step and Last Step**

**Parametric Stride Length** Sets the stride length for the new footsteps as a percentage of the length of the biped’s leg. The default value of 1.5 gives a typical running stride.

A value of 1.0 will produce a stride length equal to the leg length, which makes the biped stretch slightly to reach the next step. A value of 0.0 will make the biped run in place. A negative stride length will make the biped run backwards.

When a biped runs backwards, it does not simply reverse the forward movement but maintains the correct foot-state sequence with the toe touching the ground first, followed by the heel.

Adjusting Parametric Stride Length automatically changes the value for Actual Stride Length.
**Actual Stride Length** Sets the stride length for the new footsteps in 3ds Max units.

The same rules apply as for Parametric Stride Length (described above).

Adjusting Actual Stride Length automatically changes the value for Parametric Stride Length.

**Stride Height=5 units**

**Actual Stride Height** Sets the rise or fall between footsteps. You can use this parameter to create a set of footsteps going up or down a slope or a stairway. The value for Actual Stride Height is the difference in height in units between each of the new footsteps. Positive values step up and negative values step down.

**Time to Next Footstep** Specifies the number of frames in each foot movement cycle. A cycle starts with the frame in which a biped foot touches the ground, continues as the foot lifts and moves, and ends with the frame before the foot touches the ground again. This parameter is only enabled if Auto Timing is on.

**Speed** Displays the number of units the biped will move per frame. It changes in response to changes in the other parameters but cannot be adjusted directly. The following two parameters are only enabled when Auto Timing is off. You can use these parameters instead of Auto Timing to control the speed of the forward motion over the series of footsteps.

**Run Footstep** Specifies the number of frames each footstep will be on the ground during the run.

The higher the number, the longer the biped foot remains in contact with the ground and, consequently, the slower the speed of the running motion.
Footsteps 2 and 3 are on the ground for 5 frames each

**Airborne** Specifies the number of frames the body will be in the air between footsteps.
The higher the number, the longer the biped hangs in the air for each step and, consequently, the slower the speed of the running motion.

**Create Multiple Footsteps Dialog: Jump**

Select the biped. > Motion Panel > Biped rollout > Footstep Mode > Footstep Creation rollout > Jump > Create Multiple Footsteps > Create Multiple Footsteps Jump dialog

The Create Multiple Footsteps dialog for the jump gait allows you to create a sequence of jumps by setting a series of parameters. It displays when you’ve selected Jump on the Footstep Creation rollout on the Motion panel, and then click Create Multiple Footsteps.

**Interface**

**Start Left** Starts the footstep sequence with a left step.

**Start Right** Starts the footstep sequence with a right step.

**Alternate** When this box is selected, the footsteps will alternate between right and left. When this box is cleared, the footsteps will be either right or left steps, causing the biped to hop on one foot.

**Number of Footsteps** Determines the number of new footsteps to be created.

**Parametric Stride Width** Sets the stride width as a percentage of the pelvis width. A value of 1.0 produces a stride width equal to the pelvis width. A value of 3.0 produces a wide, waddling stride. Changes to this setting automatically change the Actual Stride Width.
Parametric describes the parameter in terms of biped anatomy, and Actual describes the value in 3ds Max units.

**Stride Width=1 and Stride Width=3**

**Actual Stride Width** Sets the stride width in modeling units. Changes to this setting automatically change the Parametric Stride Width.

**Timing**

**Auto Timing** Sets timing parameters automatically.

Auto Timing affects the following timing parameters for the Jump gait:

- **2 Feet Down, Airborne**
  
  When Auto Timing is selected, these parameters are automatically adjusted to reasonable values. You control the footstep sequence by adjusting the Stride Length and Time To Next Footstep parameters.
  
  When Auto Timing is off, you can control the footstep sequence by adjusting the gait timing parameters, but you can't change the Time To Next Footstep parameter.

**Interpolate** Allows you to control acceleration or deceleration of the series of footsteps. When this box is selected, a second set of step parameters under Last Step is enabled.

Biped creates the footsteps starting with the values of the parameters under First Step and ending with the values of the parameters under Last Step.

By interpolating between the two, Biped produces a footstep series that changes over time.

When Interpolate is cleared, the Last Step parameters are grayed out. Biped creates all the footsteps using only the parameters under First Step.
**Start After Last Footstep** Appends the newly created footsteps to the end of the existing footstep sequence.

**Start at Current Frame** Inserts the newly created footsteps at the current frame after the existing footstep sequence, allowing you to make a gap in time before the footsteps start again.

**First Step and Last Step**

**Parametric Stride Length** Sets the stride length for the new footsteps as a percentage of the length of the biped’s leg. The default value of 2.4 gives a jumping stride.

A value of 1.0 will produce a jump length equal to the leg length, which makes the biped stretch slightly to reach the next step. A value of 0.0 will make the biped jump in place. A negative stride length will make the biped jump backwards.

When a biped jumps backwards, it does not simply reverse the forward movement but maintains the correct foot-state sequence with the toe touching the ground first, followed by the heel.

Adjusting Parametric Stride Length automatically changes the value for Actual Stride Length.

![Stride Length=0.75 and Stride Length=1.0](image)

**Actual Stride Length** Sets the stride length for the new footsteps in 3ds Max units.

The same rules apply as for Parametric Stride Length (described above).

Adjusting Actual Stride Length automatically changes the value for Parametric Stride Length.

**Actual Stride Height** Sets the rise or fall between footsteps. You can use this parameter to create a set of footsteps going up or down a slope or a stairway.
The value for Actual Stride Height is the difference in height in units between each of the new footsteps. Positive values step up and negative values step down.

**Stride Height=5 units**

**Time to Next Footstep** Specifies the number of frames in each foot movement cycle. A cycle starts with the frame a particular foot touches the ground, continues as the foot lifts, moves, and ends with the frame before the foot touches the ground again. This parameter is only enabled if Auto Timing is on.

**Speed** Displays the number of units the biped will move per frame. This changes in response to changes in the other parameters but cannot be adjusted directly.

The following two parameters are only enabled when Auto Timing is off. You can use these parameters instead of Auto Timing to control the speed of the forward motion over the series of footsteps.

**2 Feet Down** Specifies the number of frames that the left and right footsteps will be on the ground during the jump. The higher the number, the longer the pause between each jump and, consequently, the slower the speed of the jumping motion.

The dotted line surrounds the 2 feet down period (15 frames)
**Airborne** Specifies the number of frames the body will be in the air during the jump.
The higher the number, the longer the biped hangs in the air for each jump and, consequently, the slower the speed of the jumping motion.

The dotted line surrounds the airborne period (13 frames)

**Convert to Freeform or Footsteps Dialogs**

Select the Biped. > Motion panel > Biped rollout > Convert

When you click Convert on the Biped rollout of the Motion panel, a Convert To dialog displays: Convert to Freeform or Convert to Footsteps, depending on the animation method of the currently loaded motion. Use Convert To Freeform for unrestricted key editing or Convert To Footsteps to take advantage of footsteps.

**NOTE** By default, jumping or airborne periods between footsteps are calculated by character studio based on gravity strength (GravAccel) and time between footsteps. Biped elevation during these jumping and airborne periods will be lost when converting to freeform from footsteps (unless you create a vertical COM key in the airborne period in the footstep animation), a freeform animation uses spline interpolation for the center of mass position and does not account for gravity. Elevation in airborne periods is restored if you convert back to footstep.

**When to Use Convert**

- Use Convert after using Save Segment in Motion Flow mode to save a script as a BIP file. Exit Motion Flow mode, load the BIP file and click Convert to extract footsteps. Save Segment applies IK Blend values of 1 to the biped foot keys for the keys at footsteps. If a freeform animation is part of the script in Motion Flow mode, and you want to convert the entire script motion to footsteps, then use the Save Keys at every Frame option in Save Segment and use Load Motion Capture File on the Motion Capture rollout. This will allow you to extract footsteps using the proximity method.
Use Convert if you are working on a footstep animation and want to switch to a freeform animation.

Use Convert if you have started a freeform animation and want to convert to a footstep animation. In order to convert a freeform animation to a footstep animation, the file must be properly set up by locking the feet to world space using IK Blend before converting to footsteps. When creating freeform animations, you should set your leg keys to IK Blend=1.0 during the periods you want the feet to be planted, and set the move keys to IK Blend=0.0. This will insure that the feet are locked and rid of unnecessary foot sliding as the body is moved. When converting, if the leg keys have been set up this way, Biped will extract footsteps during any duration where IK Blend=1.0.

Interface

Convert to Freeform dialog

Generate a keyframe per frame Creates keys at every frame.

NOTE Converting footsteps to freeform creates foot IK Blend values of 1 for the biped feet for the original footstep keys. This simplifies keyframing by putting the feet into world coordinate space, which prevents them from sliding when the biped is moved. These foot IK Blend values are also used when you click Convert (on the Biped rollout) to convert back to footsteps.
Convert to Footsteps dialog

Convert to footsteps

- Flatter Footsteps to Z = 0
- Generate a Keyframe per Frame

Generate a key per frame Creates a key at every frame, and extracts footsteps based on foot IK Blend values equal to 1. Save Segment in Motion Flow mode stores the active script as a BIP file without footsteps. The biped foot keys are assigned IK Blend values of 1 for the original footstep keys. After loading a BIP file saved using Save Segment in Motion Flow mode, use Convert (on the Biped rollout) to extract footsteps.

Convert is also useful if you have already converted from footsteps to freeform in which case the feet are assigned an IK Blend value of 1 for the keys that represented footsteps.

Flatten Footsteps to Z=0 The entire biped is repositioned to place the footsteps at Z=0.

**NOTE** An IK Blend value of 1 for the feet puts them into world coordinate space and prevents them from slipping while setting biped keys in a freeform animation.

Footstep Mode Dialog

Graph Editors menu > Track View – Dope Sheet > Right-click on a footstep track.

Right-click anywhere in the Footstep track in Track View (Dope Sheet) to display the Footstep Mode dialog. This is a modeless dialog and can remain visible while you continue to work in Track View.

This dialog allows you to:

- Control the duration information displayed with the footsteps.
- Create a freeform period between footsteps.
- Select the right or left edges of footstep blocks or the whole block.
Interface

**Edit Footsteps** In this mode (which is the default), you can edit the biped’s footsteps to change their duration; start and end frames; airborne duration; and so on.

**Edit Free Form (no physics)** In this mode, you can edit the biped's body keys for the frames at which the biped is airborne. Free Form suspends the physically based dynamics that normally control biped motion. This is essential when you want to make the biped fly, or sit down, or fall over. Note that the freeform period must be between footsteps.
The freeform area appears as a yellow block between the footsteps.

**Footstep Number Display group**

The footstep blocks can have any one of four time settings displayed for them. You can only show one of these at a time.

The footstep step number is always displayed on the footstep blocks (in boldface).

**Start and End Frame** Displays the start and end frames of the footstep (from Touch to Lift). Biped displays just the start frame if the footstep block is too small to show both. Zoom in to see both start and end numbers.

Both footsteps 0 and 1 begin at frame 0 and end at frame 19.

**Start Frame** Displays just the start frame number (Touch).

Both footsteps 0 and 1 begin at frame 0.

**Duration** Displays the number of frames that the foot is in contact with the ground (from Touch to Lift).
Both footsteps 0 and 1 are in contact with the ground for 20 frames.

**Double Support** Displays the number of overlapping frames in which both feet are in contact with the ground.
You can also turn on the following two numbers for the intervals between the footsteps. You can display both numbers at the same time by selecting both boxes.

Footsteps 0 and 1 share a double-support period of 20 frames.

**No Support** Displays the number of frames that the whole biped is airborne; that is, the frames in which neither of the feet have any contact with the ground.

The no-support period between frames 3 and 4 and 4 and 5 is 12 frames.

**Foot Air Duration** Displays the number of frames that each foot has no contact with the ground.
The foot air duration for the left footstep track between frames 3 and 5 is 31 frames.

Footstep Edge Selection group

Select Start of Footstep Selects the leftmost key for the current footstep selection.

Select Entire Footstep Selects the entire footstep.

Select End of Footstep Selects rightmost key for the current footstep selection.

Track View (Biped)

Graph Editors menu > Track View - Dope Sheet or Track View - Curve Editor

You can use the Dope Sheet to create and adjust biped keyframes, edit biped footsteps, and specify freeform periods. Biped keys display as dots on the tracks. Footsteps display as squares that can be moved in time. Biped dynamics and footsteps work together; if footsteps are moved in time, Biped adapts leg keys and vertical positions to account for the editing. There are a couple of restrictions: you can’t overlap footsteps on the same track, or move footsteps into negative time.
In this Track View - Dope Sheet view of a walking motion, footsteps are represented by colored squares, footstep numbers appear in boldface inside the squares, in between the start and end frames of the footstep. The numbers between the colored boxes represent foot-air duration.

The Curve Editor can be used to make adjustments to biped keyframe animation. The Curve Editor is a Track View mode that allows you to work with motion expressed as function curves on a graph. It lets you visualize the interpolation of the motion, the object transformations that character studio creates between the keyframes. You can see and control the motion and animation of the objects in the scene using the keys found on the curves. You can even draw curves directly on the graph.

**Footsteps in Track View - Dope Sheet**

By default, left leg footsteps are blue and right leg footsteps are green. Inactive footsteps are more saturated values of blue and green, active footsteps are pale blue and green. The left edge of each footstep block indicates when a foot touches a footstep (Touch State). The right edge of each footstep block indicates the last frame the foot is on a footstep (Lift State). The space between two footsteps indicates an airborne state for the foot (Move State). The period between the Touch and Lift States is the Plant State.

**Editing Biped Keys in Track View**

Track View is often used to change multiple keys simultaneously. For example, to change Dynamics Blend for all the vertical centers of mass keys, select all the vertical keys, display the TCB (Tension, Continuity, and Bias) dialog by right-clicking over the selected keys and change the Dynamics Blend parameter.
Right-click a key in Track View to display the TCB dialog.

**Separate Tracks**

By default, Biped stores all of the toe, foot, and calf keys in the thigh track. The finger, hand, forearms, and upper-arm keys are stored in the clavicle track. All the spine keys are stored in the spine 01 track. Although you can see all of these objects in the Track View hierarchy, they have no transform track, unless you enable them in the Separate Tracks group of the Keyframing Tools rollout on page 4717.

For example, if you rotate a biped foot, a key is created in the biped thigh track. This optimized approach works well in many cases. If your animation requires extensive hand and finger keyframing, turn on Arms on the Keyframing Tools rollout; all of the arm transform tracks are now enabled, down to the first finger link on each finger. Now if you delete an upper arm key, your finger-hand animation is preserved.

**How Dynamics and Footsteps Relate**

When footsteps are created, a footstep track displays in Track View – Dope Sheet. Footsteps appear as blue and green blocks, laid out to show their exact placement in time. If you compare the center of mass tracks to the footsteps, you will notice that frames where leading and trailing edges of the footsteps occur also have keys for the center of mass Body Vertical and Horizontal tracks. These keys contain dynamics information used by character studio to calculate
airborne body position relative to gravity, and leg bend on landing and balance. Biped Dynamics is the reason you do not need a vertical center of mass key at the top of a jumping motion or at the bottom of dip when the biped lands from an airborne period.

Click and drag the middle of a footstep to move it in time. Click and drag one edge of a footstep to stretch the footstep in time.

**NOTE** Changing the duration of footsteps or moving them relative to one another may change the “support relationships” of the footsteps. Whenever the support relationships change, Biped generates new keys and deletes any existing leg keys in the airborne period between the edited footsteps.

Because of Biped Dynamics, no keys are necessary for the highest part of this jumping motion or for the dip when the biped lands; character studio calculates the trajectory of the Body. This image shows the center of mass trajectory. Keyframes are white squares on the trajectory.

Simply change gravity (GravAccel on the Dynamics & Adaptation rollout), and the jumping motion is flattened. The biped looks like it’s hopping on the moon.
By selecting half the footsteps in Track View - Dope Sheet and moving them to the right in time, the biped has to jump higher to account for the added time to the next footstep. Notice that the yellow dots, representing frames, are tightly bunched together; there are more frames in this airborne period.

Here, the center of mass is moved in the Z plane. Now the biped heel never hits the ground; the biped appears to do a jump using just its toes. Here, character studio understands that you want to override the calculated trajectory and position the keyframe yourself.

Moving Keys

You can use the time slider to move one Biped key past another. The result is as if the original key were deleted from its original frame and copied to the new frame. Simply drag the key to the new frame, then release the mouse to complete the move. The key's various Biped properties (ease values, TCB values, IK blend, and so on) are not changed.

You can move a key past either the following key or the previous one. You can also move it past multiple keys. If you move a key onto a frame where a key is already present, it replaces the original key.

In Track View, you can move a key past another using the transform track. You can also scale keys forward in time such that some keys are now past the keys that weren't scaled. If keys move into negative time, a warning reminds you that keys in negative frames can't be used for footstep animation.
workaround is to set new keys in the negative frames, instead of moving existing ones.

If you change the key to Euler control (on the Quaternion/Euler rollout) and then drag it past another, the key’s tangent type is maintained.

If you add a layer (on the Layers rollout), set two keys, and then move the first one past the second one, this also works.

**Freeform Animation**

It is left to you to create all the keys in a freeform animation; Biped Dynamics is not active and does not recalculate body position. Balance Factor is active in a freeform animation. A completely freeform animation contains no footsteps.

To start an entirely freeform animation, simply create a biped and begin keyframing.

**NOTE** Once you initiate a freeform animation, you cannot add footsteps to it in Footstep mode. You can, however, convert your freeform animation to a footstep animation using Convert on the Biped rollout.

You will often want a freeform period in a footstep sequence; for a walk then fall type of motion for example. In cases like this, a freeform period is specified between footsteps in Track View using the Footstep Mode dialog on page 4797. A combination of footsteps and freeform is often required when motion capture data is imported. A freeform period is created using controls in the Footstep Mode dialog and display as a yellow boxes between footsteps in Track View.

Right-click the footstep track to display the Footstep Mode dialog; here you specify a freeform period, select multiple footstep edges, and set footstep numbering display options.

**Biped Color-coded Keys and Trajectories**

Biped uses color coding for IK keys in three places: Track View, Track Bar, and when trajectories are displayed in the viewports. Also, depending on the types of keys, trajectories themselves can be color coded. The color coding helps you visualize when IK and FK are in use, and the transitions between them.

This topic describes color coding of non-COM on page 8530 tracks. For information about COM key color coding, check here on page 4691.
Color-coded Keys in Track View and on the Track Bar

Biped IK keys as displayed in Track View and on the track bar use the following color scheme:

- orange for planted keys
- yellow for sliding keys
- blue for body-space IK keys with a non-zero value for IK Blend

All other keys use the default color: gray.

Visualizing Pivot Trajectories and Keys

To view trajectories for Biped parts in the viewports, go to the Motion panel and on the Biped rollout > Modes And Display sub-rollout, or on the Key Info rollout, turn on Trajectories.

- **Trajectories** Shows and hides trajectories for the selected biped object.
- You can edit keys on the biped's horizontal and vertical track by turning on Trajectories, turning on Sub-Object, selecting the horizontal or vertical center of mass track, and transforming keys in the viewports.
- You can bend the horizontal center of mass trajectory around selected horizontal keys by using the Bend Horizontal spinner in the Keyframing Tools rollout.
- Display trajectories to view how parameter changes in the Key Info rollout affects the biped motion. Changing Tension, Continuity, and Bias in the
Tcb group affects the trajectory around the current key. Changing the value of IK Blend for a hand or foot will affect the trajectory between keys.

- Leave Trajectories on and turn on Show Buffer Trajectories on the Motion Capture rollout to compare a raw motion capture trajectory with the filtered trajectory on the biped. This assumes a motion capture file has been loaded.
- Changing Dynamics Blend for a center of mass vertical key or changing the value of GravAccel will change gravity in a foostep animation and will therefore affect the trajectory.

To make Biped pivots easier to interpret and manipulate, Pivot trajectories and their keys are represented in the viewport during IK periods and display in the color of the associated key type:

- Orange for planted keys
- Yellow for sliding keys
- Blue for body-space IK keys

**TIP** One way to create a body-space IK key is to set a regular IK planted or sliding key, and then, at that frame, on the Key Info rollout > IK section, choose Body. Or you can convert an FK key that’s already set to Body by increasing its IK Blend value above 0.0.

During FK periods the node trajectory and its keys display in purple (the same keys are gray on the track bar).

During FK/IK blend periods the trajectory of the resulting blend is displayed and its color is determined by the amount of the blend; for example, a blend of 0.5 to a sliding key results in a trajectory that is a 50:50 blend of yellow and purple.

Because pivots are located in all extremes of the hands and feet, their trajectories discontinuous when both FK and IK periods are employed. The following figure shows a simple example of this. During the planted IK periods, the pivot trajectories show just the keys on the heel and toe (because the keys are planted, each pivot stays in place), and during the FK periods the trajectories are derived from the foot’s node pivot location. This gives you more-detailed information about the animation that is driving the foot.
Footstep trajectory

In following illustration, while the biped walks, the right hand reaches up to touch something in IK, as shown by the yellow trajectory, made by two sliding IK keys. Later, the biped touches its own face, using body space IK, as shown by the bright blue keys. The color transition in the trajectory from purple to blue indicates a changing blend from FK to body-space IK, showing the interpolated value of the IK Blend parameter.

Hand trajectory
Following is a chart showing the result of going from one key type to another. The last three rows of the chart show transitions between object and body space that produce pure FK. In the past, it was hard to know what type of trajectory these combinations produced. The new trajectory colors clarify the result.

In the chart, the letters have the following meanings:

- **O**: object space
- **B**: body space
- **IK**: a key where IK Blend > 0. It is always accompanied by the space: O or B.
- **FK**: a key where IK Blend = 0, no matter what space it's in

<table>
<thead>
<tr>
<th>From -&gt; To</th>
<th>Result</th>
<th>Trajectory Drawn</th>
<th>Trajectory Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>OIK -&gt; OIK</td>
<td>OIK</td>
<td>Pivot</td>
<td>Yellow</td>
</tr>
<tr>
<td>BIK -&gt; BIK</td>
<td>BIK</td>
<td>Node</td>
<td>Blue</td>
</tr>
<tr>
<td>FK -&gt; FK</td>
<td>FK</td>
<td>Node</td>
<td>Purple</td>
</tr>
<tr>
<td>BIK -&gt; BFK</td>
<td>BIK/BFK blend</td>
<td>Node</td>
<td>Blue -&gt; Purple</td>
</tr>
<tr>
<td>OIK -&gt; OFK</td>
<td>OIK/OFK blend</td>
<td>Node</td>
<td>Yellow -&gt; Purple</td>
</tr>
<tr>
<td>OIK -&gt; BFK</td>
<td>FK</td>
<td>Node</td>
<td>Purple</td>
</tr>
<tr>
<td>OIK -&gt; BFK</td>
<td>FK</td>
<td>Node</td>
<td>Purple</td>
</tr>
<tr>
<td>BIK -&gt; OFK</td>
<td>FK</td>
<td>Node</td>
<td>Purple</td>
</tr>
</tbody>
</table>

**NOTE** When separate tracks exist for either a limb or its digits, the FK trajectory of the bone base is always drawn, regardless of whether the trajectory display is set to Bone Base or Bone Tip on the Display Preferences dialog on page 4684.
Biped Shortcuts

The table in this topic shows the default keyboard shortcuts for character studio.

Use the Keyboard Shortcut Override toggle on page 8420 on the main toolbar to enable the character studio keyboard shortcuts. All character studio keyboard shortcuts activate when the Motion panel is active and the Keyboard Shortcut Override button is active. To customize your shortcuts, use the Customize User Interface dialog on page 8249.

See also:
- Keyboard Shortcuts on page 8419
- Keyboard Panel on page 8250
- Customize User Interface Dialog on page 8249

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activate Layer (Toggle)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bend Links Mode</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Body Horizontal</td>
<td></td>
<td>Selects the center of mass to edit horizontal biped motion</td>
</tr>
<tr>
<td>Body Rotation</td>
<td></td>
<td>Selects the center of mass to edit biped rotational motion</td>
</tr>
<tr>
<td>Body Vertical</td>
<td></td>
<td>Selects the center of mass to edit vertical biped motion</td>
</tr>
<tr>
<td>Action</td>
<td>Shortcut</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>--------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Buffer Mode</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Change Leg State</td>
<td>Alt+Ctrl+S</td>
<td>Toggles foot states of the selected leg at the current frame. View the state change in the leg states displayed on the Biped rollout.</td>
</tr>
<tr>
<td>Clear All Animation</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Clear Selected Tracks</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Collapse Layer</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Collapse Move All Mode Changes</td>
<td>Alt+M</td>
<td></td>
</tr>
<tr>
<td>Copy Posture</td>
<td>Alt+C</td>
<td>Copies the posture of the selected biped objects to the clipboard.</td>
</tr>
<tr>
<td>Create Layer</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delete Layer</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Display Biped Trajectory</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Display Bones</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Display Footstep Number</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Display Footsteps</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enable Subanims</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Action</td>
<td>Shortcut</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Figure Mode</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fix Graphs</td>
<td>Alt+Ctrl+F</td>
<td>Searches for any problem in the motion and prompts you whether or not to fix problems it encounters. Problems it looks for include overlapping keys, keys past the end of the footstep range, keys at negative frames, or illegal footstep timing. Click OK when prompted to fix these problems automatically.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Footstep Mode</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Free Mode</td>
<td></td>
<td></td>
</tr>
<tr>
<td>In Place Mode</td>
<td></td>
<td></td>
</tr>
<tr>
<td>In Place X Mode</td>
<td></td>
<td></td>
</tr>
<tr>
<td>In Place Y Mode</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Load .bip File</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lock Selected Keys (toggle)</td>
<td>Alt+Ctrl+L</td>
<td>Toggles locked keys (red) on and off for the selected leg or vertical track key at the current frame. In Track View, you can watch the key turn from red to gray, and back again, as you lock and unlock it.</td>
</tr>
<tr>
<td>Action</td>
<td>Shortcut</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>----------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Manipulate Subanims</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mirror</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mixer Mode</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Motion Flow Mode</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Move All Mode</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Next Layer</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Paste Posture</td>
<td>Alt+V</td>
<td>Pastes the posture from the clipboard onto the currently selected biped.</td>
</tr>
<tr>
<td>Paste Posture Opposite</td>
<td>Alt+B</td>
<td>Pastes Posture Opposite for the currently selected biped.</td>
</tr>
<tr>
<td>Play Biped</td>
<td>V</td>
<td>Toggles Biped playback.</td>
</tr>
<tr>
<td>Previous Layer</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reset all limb keys</td>
<td>Alt+K</td>
<td></td>
</tr>
<tr>
<td>Rubber Band Mode</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save .bip File</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Scale In Transform (toggle)</td>
<td>Alt+Ctrl+E</td>
<td>This toggle strips the scale from the biped. Developers should use this when exporting biped objects as regular 3ds Max links through the 3ds Max SDK.</td>
</tr>
<tr>
<td>Action</td>
<td>Shortcut</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>----------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Scale Stride Mode</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Set Free Key</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Set Key</td>
<td>0</td>
<td>Sets a biped key.</td>
</tr>
<tr>
<td>Set Layer Snap Key</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Set Multiple Keys</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Set Planted Key</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Set Range</td>
<td>Alt+R</td>
<td>Resets the total animation length to the length of the current biped footstep range.</td>
</tr>
<tr>
<td>Set Sliding Key</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Smooth Twist Mode</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Toggle Biped Keys in Track Bar</td>
<td>Alt+T</td>
<td></td>
</tr>
<tr>
<td>Track View Select end of footstep</td>
<td>Alt+D</td>
<td>Selects all right edges of the selected footsteps in Track View.</td>
</tr>
<tr>
<td>Track View Select entire footstep</td>
<td>Alt+S</td>
<td>Selects both edges of the selected footsteps in Track View.</td>
</tr>
<tr>
<td>Action</td>
<td>Shortcut</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>----------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| Track View Select start of  
footstep | Alt+A | Selects all left edges of the  
selected footsteps in Track  
View. |

Twist Links Mode

* Not available for customization in the Customize User Interface dialog.

### Working with the Workbench

The Workbench is a customized version of Track View that you use for correcting and improving biped animation. It extends the functionality of existing curve editors by giving you different options for visualizing and manipulating curves, and provides filters to perform general rotation, position and other biped-specific operations.

With the Workbench, you can analyze curves for error conditions and apply filters to the identified keyframes, or filter selected biped tracks to generally improve the motion of a track without errors.

**See also:**

- [Navigating the Workbench](#) on page 4818

### Workbench Workflow

Here are the overall steps you would follow to use the Workbench to analyze and fix a biped for problems:

1. Create your animation and play it. Visually note anything that jumps out at you as being wrong or incorrect.
2. With the biped selected in the viewport, open the Workbench by clicking the Workbench button in the Biped Apps rollout on the Motion panel.
3. Select the biped body part that seems to have the problem. You can select it in the viewport, or from the list in the Select panel.

Be aware that some biped objects share tracks. For example, all the objects in a leg or an arm share a single track.
4 On the Analyze panel, choose an analyzer from the drop-down list. Set the analysis conditions, then click Analyze. Any errors the analyzer encounters will be displayed in a list at the bottom of the Analyze panel. The Curve view also indicates the problem area by displaying a vertical bar.

5 On the Fix panel, select the errors you want to fix. Select the filter for the fix, adjust its parameters, and then click Fix Selected. You can select the errors one at a time, or in any combination. You can sort the errors by time or body part, depending on what kind of fix is needed.

Errors displayed as yellow lines in Curve View

If the results aren't satisfactory, try changing the parameters and fixing again. Repeat the process until you find the combination of parameters that correct the movement. Or try a different fixer or filter (these are described later in this topic).

Animation Workbench Tools

The Animation Workbench provides three types of tools to use with biped animation: analyzers, fixers, and filters.

Analyzers

These are used to find out-of-the ordinary properties in your animation. Certain analyzers parse the waveform of your motion tracks and detect variation from the curves. There are two detectors available that do this; Noise and Spike.
There are also analyzers for finding and fixing knee conditions, specifically knee wobble and extension.
For more information, see Analyze Panel on page 4832.

Fixers
Fixers address problems found by the analyzer. The fixers work by running a specified operation over just the analyzer result. They don’t change the complete animation, just areas around the problem.
For more information, see Fix Panel on page 4838.

Filters
Filters are operations that are performed on the specified animation tracks. Unlike fixers, they affect the complete specified time interval, not just the analyzer result.
The Rot Smoothing, Rot Blurring, Rot Boosting, Adv Rot Smoothing, Pos Smoothing, Pos Blurring and Pos Boosting filters are all variants of one type of filter. They all share the same parameters: Width and Damping.
For more information on these filter types, see Filters Panel on page 4843.

Navigating the Workbench
The Animation Workbench, a customized version of Track View, uses some of the standard Track View controls, and adds new ones of its own.
The areas of the Workbench interface include:
■ The Tab panels: Select, Analyze, Fix, and Filter
■ The Curve view, with Track View toolbars for key selection, manipulation, and view navigation.
■ The Workbench toolbar, with tools for choosing Coordinate space, display of sub-animations, and tools to hide the Tab area and controller list.

Each section of the Workbench User has specific navigation techniques.

See also:
■ Selecting Workbench Tracks on page 4821
Navigating the Tab Panel

Simply click the tabs to move from one panel to another. The tools displayed change with each panel. The overall workflow is left to right for the tabs, and top to bottom within each panel. Selections are displayed in lists: clicking a name in a list selects that entry. Operations are usually performed by clicking a button at the bottom of the panel.

Tip: The Tab panels can be hidden once the operations are performed and you don’t need to see the panels any more. Click the Tab button in the Workbench toolbar to hide the panel display.

Displaying the Controller List

Click the Controllers button in the Workbench toolbar to display the Controller List. When the controller list is displayed you can select multiple tracks as you like, right-click them and assign controllers using the pop-up menu. You can also get to properties for controllers such as Noise that don’t have keyframes.

Click the Controllers button in the Workbench toolbar to display the embedded curve editor’s Controller window. The biped body tracks shown are in the list are the ones that are selected in the Select panel on page 4829, in addition to any scene objects that are attached to those body parts or are used as IK objects for those body parts. The controller list is similar to the one in the curve editor.
Controller list displayed

Navigating the Curve View

Use the standard 3ds Max Track View navigation tools to adjust the view of curves in the Curve view window. Zoom, Zoom Extents Horizontal and Vertical, and Pan are often used to get a better view of an entire curve, or a portion of a curve. As a default, the curve view automatically displays the curve of whatever biped object is selected in the viewport.

The Workbench window can be resized to make it easier to work with curves. You can float or hide toolbars to give you even more room. You can dock toolbars left and right as well.

Docking the Workbench

You can dock the Workbench in a viewport. With the Workbench open, click or right-click the Point-Of-View viewport label, then from the POV viewport label menu on page 8122 choose Extended > Biped AnimationWorkbench. The open workbench docks in the viewport.

TIP This works best if you change your layout so there is at least one horizontal viewport.
Unlike the 3ds Max Track View – Dope Sheet and Curve Editor, the Workbench cannot be docked below the viewport trackbar.

**Show Layered Edit**

You can affect a layered range of keys by turning on Show Layered Edit. This is a special Workbench mode that extends the edit to affect keys surrounding the one you are editing. It works like soft selection in 3ds Max but gives you greater control over the displacement. It can help you blend your edits into existing motion.

**Selecting Workbench Tracks**

As a default behavior, whatever biped part is selected in the viewport will have its curves displayed in the Curve view. You can also use the **Select panel** on page 4829 to select biped parts by name. The functionality of the Select panel is derived from the **Selection Floater** on page 209; you can invert the selection set or enter a name into the Selection field to find a track.
You can also use the controller window as a selection mechanism. With the Controllers list visible you can click on track entries there to work on the curves.

**NOTE** Sometimes a curve will not appear in the display at first. Click Zoom Extents Horizontal and Zoom Extents Vertical to make sure the curve can be seen.

The Workbench toolbar lets you choose the type of curve to display and the coordinate space in which it is displayed. For example, if you know you are dealing with rotational errors, choose an *Rot* or *Quat* type curve. If it is an error of positional data, choose *Pos*.

If you open the Track View – Curve Editor or expand the track bar while you have the Workbench open, you will see a simultaneous display. The views are all synchronized, so selecting a track in one graph editor selects it in all.

When using footstep animation, you can see the footstep keys by opening a Track View – Dope Sheet window.

### Analyzing Curves

Once you have selected curves, you can analyze them to discover error conditions.

You choose between four kinds of detectors; Noise, Spike, Knee Wobble or Knee Extension. You can also select only a the portion of a curve to analyze. Perform the analysis by clicking the Analyze button. The errors are found based on the detector’s parameter settings. If no errors are found, try adjusting the parameters and clicking Analyze again. Lowering the Standard Deviation value will yield more errors.

When an error has been detected, the biped part name appears in the Analyze Results list. If multiple errors are detected, the entry displays a number that tells how many errors were found. Errors are also displayed in the Curve View as vertical brown lines.

Once errors have been located, you can use the tools on the Fix panel to correct those keys and the keys around them. Or you can use the error location merely to identify the keys, then manually make changes using standard interpolation techniques. Right-clicking a key in the Curve view will display the properties dialog that allows for such adjustments.
Results of the Analyze operation can be loaded or saved as a file using the Load or Save buttons at the bottom of the interface.

Results of the last analysis can be cleared using the Clear button, also found at the bottom of the panel.

**Fixing Curves**

After you have selected curves and analyzed them for error, you can use the tools found on the Fix panel to process the curves and reduce the errors.

The fixes are determined by which type of fixer you choose, and the parameters you set for that fixer. Clicking Fix Selected or Fix All at the bottom of the panel performs the Fix operation.

In general, fixes are made either by changing the position or value of a key, or by removing the key. The basic fixing techniques involve smoothing, blurring, boosting, or key deletion. This is similar to audio-editing software, where you view music as a waveform, and then edit the waves in various ways to alter the sound. Similarly, the motion of the biped body parts, as defined by position and rotation tracks, can be evaluated for error conditions regarding speed, angle, acceleration, or change of direction.

Of course, you can also fix curves manually. You can select the key on the curve and move it, using the standard Track View key buttons duplicated in the Workbench, such as Move, Slide, Scale or Delete Keys.

You can achieve a layered range of keys by turning on Show Layered Edit. This is a special Workbench mode that extends the edit to affect keys surrounding the one you are editing. It works like soft selection in 3ds Max but gives you greater control over the displacement. It can help you blend your edits into existing motion.

**Workbench User Interface**

Select a biped body part. > Motion panel > Biped Apps > Workbench

The Animation Workbench is a tool for working with biped function curves. It is a customized version of Track View, with many of the same toolbars and buttons, plus some new ones.

Working with the Workbench | 4823
In addition to the standard Track View features, the workbench has tools to help you select curves, analyze them for errors, and automatically fix those errors based on various settings. This is especially useful when working with motion-capture data, or other animation that has many keys.

Of course, you can also display and manipulate function curves for bipeds in the standard 3ds Max Track View and expanded track bar, as well. However, you have access to the automatic error-analysis tools only in the Workbench.

**NOTE** On the time slider or in Track View, you can move one Biped key past another. See *Moving Keys* on page 4805.

The Animation Workbench displays rotation curves in local biped space for both quaternion and euler rotations. This improves the speed of curve manipulation since the whole biped doesn't need to be calculated in order to draw a single curve.

**NOTE** This does not affect position curves, which are still evaluated in world space.

**NOTE** Curve display will only change for certain objects in COM space: base of spine, neck, clavicles, upper arms, upper thighs, and feet.

**See also:**
- *Working with the Workbench* on page 4816

**Procedures**

To display the local rotation curve of an animated spine link:

1. Create a biped and select its upper spine link.
2. Set a key at frame 0.
3. Go to frame 10, rotate the spine link 30 degrees in the local Z axis, then set a key.
4. Open the animation workbench.
Only one curve is displayed because the upper spine rotates in local space by default.

Select the biped’s head.

Notice how there are no curves in the workbench because the head doesn’t inherit the spine link’s rotation and doesn’t have an internal rotation of its own.

Interface

1. Tab panels (Select, Analyze, Fix, and Filter).
2. Display Tab panels
3. Display Controllers list
4. Workbench toolbar
5. Curve View
6. Curve View toolbars (same as Track View toolbars).
Animation Workbench Tab Panel

The Animation Workbench Tab panel consists of four panels:

- **Select panel** Provides tools to select curves for biped body parts. For more information on the Select panel user interface, see Select Panel on page 4829.

- **Analyze panel** Evaluates the curves for error conditions. For more information on the Analyze panel user interface, see Analyze Panel on page 4832.

- **Fix panel** Provides a variety of methods to be applied to the errors located by the analysis. For more information on the Fix tab user interface, see Fix Panel on page 4838.

- **Filters panel** These are a special type of fixer that perform an operation over each key that is selected. When no keys are selected it performs the operation over the whole curve rather than using the results of the last error analysis. Use this when you have errors visible in the motion, but the fixer refuses to find them. For more information on the Filter panel user interface, see Filters Panel on page 4843.

Use the Tab button on the Workbench toolbar to display and hide the Tab panel.

**Curve View**

To the right of the Tab area is the Curve View, where keys and curves for the selected biped parts are displayed. This is the same as the Track View Key window.

**Curve View Toolbars**

Directly above and below the Curve View are some of the standard 3ds Max Track View toolbars. They give access to tools used to navigate the view and manipulate the keys. The toolbars below the Curve View are used for selection and navigation; toolbars above the Curve View are used to move, slide, and scale keys; to scale values; and to add new keys.
Animation Workbench Toolbar

The Workbench toolbar extends the toolset found in the 3ds Max Track View. The Workbench toolbar includes:

- **Tab**  Hides or displays the Workbench Tab panel, which contains the tools for automated error analysis and correction fixers and filters.

- **Controllers**  Hides or displays a controller-window hierarchy list. This is the same list you see in standard Track View with the same right-click menus used to assign controllers.

- **Curve Type**  Determines which curves are displayed for the selected object. *Rot Curve, Rot Speed, Rot Accel, and Rot Jerk* curves represent rotation. *Pos Curve, Pos Speed, Pos Accel and Pos Jerk* curves represent position.

**NOTE**  Choosing *Rot Curve* or *Pos Curve* turns on Show Biped Rotation Curves or Show Biped, Position Curves, respectively, in the Biped toolbar of the Curve Editor on page 3873.

*Noise* curves represent random position and rotation. Each biped part can show any of these curves, except for the Horizontal and Vertical tracks, which show only positional curves, and the Turning track, which shows only angular curves.

The Axis order drop-down lets you choose the order in which the rotation curves are calculated. Curves in previous version of Character Studio were always drawn in XYZ. This ordering follows the same rules as the Euler Axis Order on the Quaternion/Euler rollout on page 4693.

The Axis order drop-down lets you choose the order in which the rotation curves are calculated. Curves in previous version of Character Studio were always drawn in XYZ. This ordering follows the same rules as the Euler Axis Order on the Quaternion/Euler rollout on page 4693.

When manipulating position curves, the Workbench allows the curves to be displayed relative to the World, the Biped Root, or any object in the scene as picked via the arrow button.

- **World**  Displays curves relative to the World.

- **Biped Root**  Displays curves relative to the biped root object (COM).

- **Scene Root**  Displays the curves relative to a selected object. Turn on the arrow button, then click the object in a viewport. The name of the object will be displayed on the button.
The X, Y, and Z buttons  Choose which curves of the selected object are displayed in the Workbench.

**NOTE** Toggling X, Y, or Z also toggles the corresponding Biped toolbar button of the Curve Editor on page 3873.

- **The 180 limit** Sets the Quat Curve to display as “clamped” between 180 and –180 degrees, instead of accumulated. Default=off.

- **Draw While Moving** Sets the Workbench to update the curves as you move keys. When off, curves display as optimized lines until you release the mouse after moving or changing a key. Default=on.

- **Show Layered Edit** When on, displays a graphic tool for adjusting sets of keys along a curve within a range. 
  
  To set the range, click to highlight one of the square handles, and then drag it. As you drag, the handle follows the curve.

  ![Handle follows curve.](image)

  To set a layered offset, click to highlight the circular handle, and then drag it to the desired position. The circular handle follows the curve unless you hold down the Esc key. If you drag while holding down Esc, you can move the handle off the curve, which scales the keys within the range.

- **Enable Sub Anims** When on, sets the Workbench to display the curves of the selected part’s subanim in combination with the position or rotation curves. Subanims are list controllers which can be added to provide additional animation controls to biped body parts. Default=off.
Biped Key Manipulation

Interactive key manipulation behaves in the Workbench much as it does in Track View. The difference is that you can't move keys beyond other keys. This has always been a restriction of biped animation.

Select Panel

Select a biped body part. > Motion panel > Biped Apps > Workbench > Select panel

The Select panel of the Animation Workbench provides tools for selecting bipeds or biped components. You can manipulate the selected biped part’s animation tracks via curves displayed in the Workbench, or by using the Analyze, Fix, and Filter panels to automatically identify errors and fix them.

The objects whose curves might be displayed are set using the selection drop-down list. To change the curves that are displayed go into the Controller window and select the curves you want to see.

Once you've made a selection, you can hide the entire Tab area by clicking the Tab button on the Workbench toolbar. This gives you more room to work on the curves in Curve View.

The functionality of the Select panel is similar to the standard 3ds Max Selection Floater on page 209.

See also:

- Analyze Panel on page 4832

Procedures

To display a biped body part curve in the Workbench, do one of the following:

1. On the Select panel, make sure Select From Scene is turned on, then in a viewport, click any biped object. The object's curve is displayed in the Workbench Curve window.
2. On the Select panel of the Animation workbench, click to highlight the name of the body part in the scrollable Selection list.
3 On the Workbench toolbar, turn on Controllers. In the hierarchy list, highlight the body part track whose curve you want to see.

**To hide or unhide the Tab panel:**

1 Click the Tab button on the Workbench toolbar.
   The Tab panel disappears from view.

2 Click the Tab button again.
   The Tab panel returns to view.
Interface

Select

Bip01
Bip01 Pelvis
Bip01 Spine
Bip01 Spine1
Bip01 Spine2
Bip01 Spine3
Bip01 Neck
Bip01 Head
Bip01 L Clavicle
Bip01 L UpperArm
Bip01 L Forearm
Bip01 L Hand
Bip01 L Finger0
Bip01 R Clavicle
Bip01 R UpperArm
Bip01 R Forearm

All  None  Invert

Subtree

Display  Select

Select From Scene

Working with the Workbench | 4831
Selection field Enter the name of the biped part you want to locate. That name (if found) will be highlighted in the Selection list. This is useful when you can't find an entry by scanning the list. You can use the question mark and asterisk characters as wildcards, in order to select multiple objects at once.

Selection list The Selection list displays all the body parts of all the bipeds in the scene. You can use the Shift, Ctrl, and Alt keys to build selection sets, as in the rest of 3ds Max.

All Selects every entry in the list.

None Clears the selection so nothing is highlighted.

Invert Selects everything not highlighted in the list.

Subtree group

Display Indents the list to show the biped hierarchy. Default=off.

Select When on, selecting one biped part selects both it and all of its children. Default=off.

Named selection list When you create a named selection in the scene, the named selection becomes available.

Select From Viewport When Select From Viewport is on, you can click the biped body parts directly in the viewport, rather than from the list. The curves are immediately displayed in the Workbench Curve View. This is handy if you don't know the name of the part you need to select.

Analyze Panel

Select a biped body part. > Motion panel > Biped Apps > Workbench > Analyze panel

The Analyze panel provides tools to evaluate the curves for the selected biped parts, and review them for certain error conditions. It can spot spikes and noise in the curves, and locate specific keyframes that are responsible for discontinuous motion.
The errors are displayed as brown lines over the curves, and are also listed at the bottom of the Analyze panel. You can then use the Fix panel to automatically fix errors, or you can fix errors by manually adjusting keys and curves in Curve view.

Brown lines on the curve show the errors.

See also:
- Fix Panel on page 4838

Procedures

To analyze a curve:

1. On the Select panel, choose the biped object whose curve you want to correct.

You can select the object from the Select list, in a viewport, or from the Controllers hierarchy.
2 Click the Analyze tab, then on the Analyze panel, choose the analyzer you want to use from the drop-down list. By default, there are two choices: Noise Detector and Spike Detector.

3 If you chose Noise Detector, choose the appropriate Property from the Property drop-down list.

4 Click Analyze. Any errors found are displayed in the error result list at the bottom of the panel. The errors also appear in Curve View as brown lines.

5 If no errors are found, try lowering the standard deviation value or make sure you have used the appropriate property when using the noise detector. For example, if you have a problem with the rotation of a leg, but you choose a Pos property, that error will not be detected.
Interface

Select | Analyze | Fix | Filter

Parts to Analyze:
- Display Curve Part
- Selected Parts

Time to Analyze:
- Entire Animation
- Active Time Segment
- From / To: [0]  [100]

Analyzers
- Noise Detector

Property
- Rot Speed

Standard Deviation: [3.0]

Bip01 Spine = 3

Analyze
Parts to Analyze  These options choose which parts to analyze:

■ Display Curve Part  When this is turned on, the curve displayed is analyzed.

■ Selected Parts  When this is turned on, the parts selected in the list or viewport are analyzed. Use this when you want to analyze an entire biped without displaying all of the curves in Curve View.

Time to Analyze  Sets the range to be analyzed. You can choose either:

■ Entire Animation  Analyzes the entire animation.

  NOTE  This is independent of the active 3ds Max time segment.

■ Active Time Segment  Choose this to use the active time segment, as set by the 3ds Max Time Configuration dialog.

■ From / To  These values let you specify a range with a particular start and end frame.

Analyzers group

Analyzers drop-down list  Lets you choose which analyzer will be used to evaluate the curves. Each analyzer can present its own individual settings. The default choices are Noise Detector and Spike Detector.

■ Noise Detector  Finds any large change in the animation, either rotational or positional as determined by the standard deviation value. Can operate on specific curves as determined by the selection in the Property drop-down list, regardless of what’s currently visible in the Workbench.

  NOTE  It’s important to understand that noise isn’t always bad. For example, in an animation of a person waving his hand, then suddenly punching: the movement from the wave to the punch, plus the pullback from the punch might be analyzed as noise, but it is noise that you want. The Workbench will identify the magnitude of these changes by showing you the acceleration and the jerk curves. By being selective with the fixers, you can smooth out only what you want to improve, and maintain the rest.

■ Spike Detector  Finds any large change in the animation that also contains a change in direction (in quaternion space or position space). Can operate on all curves in the animation, regardless of what’s currently visible in the Workbench. The analysis can be adjusted for Standard Deviation, which is the degree to which the animation departs from its overall pattern.
- **Knee Wobble**  Finds knees that wobble or shake when a foot is planted. Uses Frame and Fluctuation parameters to determine what is a wobble error.

- **Knee Extension**  Finds knees that overextend when a foot is planted. Uses a Knee Angle parameter to determine extension errors.

**Property drop-down list**  Lets you choose the criterion that the Noise detector uses to evaluate the curves errors. Use Rotational (Rot) properties to analyze rotational errors; use Position (Pos) properties to analyze move transform errors.

**NOTE**  This control is not available when using the Spike detector.

Options in this drop-down list include:

- **Rot Speed**  Looks for noise in the speed of the rotational angle.
- **Rot Accel**  Looks for noise in the acceleration of the rotational angle.
- **Rot Jerk**  Looks for noise in the jerk of the rotational angle.
- **Pos Speed**  Looks for noise in the speed of the position.
- **Pos Accel**  Looks for noise in the acceleration of the position.
- **Pos Jerk**  Looks for noise in the jerk of the position.

**Standard Deviation**  Lets you set the degree to which the animation can depart from its overall pattern. For example, in data that is somewhat noisy by design, the Noise detector can look for instances that are noisier. Lower deviation numbers mean higher sensitivity, and thus more errors found.

---

**Error results list**  Displays all errors that the analyzer finds. Each entry lists the name of the body part, and the number of errors found. Errors are also graphically highlighted with a vertical brown line in Curve View. Clicking an error entry in the list highlights that error in Curve View.

**Analyze**  Click to perform the analysis.

- **Clear Results**  Deletes the results of the latest analysis.
- **Load Analysis File**  Loads the results of a previous analysis.
Save Analysis Saves the results of the latest analysis.

Fix Panel

Select a biped body part. > Motion panel > Biped Apps > Workbench > Fix panel

The Fix panel provides access to the tools that can be used to automatically fix the errors found by the Analyze panel on page 4832.

A variety of methods is available to automatically correct errors found in the curves. Smoothing, blurring, and removing keys are all options. Or, if you prefer, you can correct the error manually by adjusting the interpolation per key, using standard 3ds Max methods. You can move the key on the curve, or right-click the key to access interpolation controls.

A fix is performed as a specific operation on a particular biped body part or set of parts, at a particular time. In general, fixes either change the value of a key or remove keys to produce corrected motion.

The results of last analysis are displayed in the Analyze Results list. Clicking an error in the list once displays the error as a yellow line over the curve; clicking the error twice updates the viewport scene, making the error the current frame. Errors can be sorted by Part or by Time.

Fixes can be applied to individual errors, selected errors, or to all errors at once.

See also:

■ Filters Panel on page 4843

Procedures

To fix an individual error:

1 Click to highlight the error in the Analyze Results list.
2 Choose the Fixer type you want to use to automatically correct the problem.
3 Click Fix Selected.
4 Observe the change in the Curve View.
5 Play the animation in the viewport to see if the error has been corrected.
6 If the error is still visible, try changing the parameters for the fixer, or choosing a different fixer. The Rot and Pos fixers attempt to solve the problem by changing the values of the keys; if they don’t give good results, it might be more useful to use the Remove Keys fixer.

To fix multiple errors:
1 Highlight all the errors in the Analyze Results list.
   You can use the Ctrl and Shift keys to add to your selection.
2 Choose the Fixer type you want to use to automatically correct the problem.
3 Click Fix All.
4 Check your results as you would if you were fixing a single error (see the previous procedure).

To remove keys from curves automatically:
1 On the Select panel, highlight the biped part in the list.
   **TIP** If you don’t know the name of the part, you can click it in a viewport.
2 On the Analyze panel, choose the appropriate Analyzer type and properties.
3 Click Analyze.
   The errors are listed in the error result list at the bottom of the panel.
4 On the Fix panel, choose the errors you want to fix.
5 In the Fixers drop-down list, choose Remove Keys.
6 Click Fix Selected.
   The removed keys will disappear from the list and the curves.
   **TIP** You can use the Delete Keys option and Interval Width to create a threshold for deleting keys. If you turn on Delete Keys, the Interval Width will disallow the deletion of keys based on that value. Use this if too many keys are being deleted when you use Remove Keys.
**Interface**

**Analyze Results error list** Displays all the errors the analyzer found for the selected body parts. The name of the Biped object is preceded by the frame number of the error. Clicking the error once displays a yellow line at that position on the character.
frame in the Curve View. Clicking it twice moves the current frame to match the error frame number: the viewports display that frame as well.

**Sort by:** Lets you change the display of the error analysis results.

- **Part:** Displays all the errors for each part listed together.
- **Time** Displays all the errors sequentially, by frame.

**Fixers** Determines the method used to attempt to correct the errors found by the analyzer. In general, try to match the fixer to the analyzer property. For example, if you have selected a Noise detector with Rot Speed, then choose a Fixer with Rot in the name as well. The exception to this would be when it is obvious that you'd prefer to remove the keys rather than modify them. In that case, choose a Remove Keys fixer.

Fixer options include:

- **Rot Smoothing** Corrects rotational errors by smoothing the curve. Can be repeated on the same track for greater effect. Slower than blurring, but keeps more detail of the curve.

- **Rot Blurring** Corrects rotational errors by blurring the curve. Good if you just want to keep the general shape of the animation, but don't want to keep the details. May remove too much detail in the animation.

- **Adv Rot Smoothing** Works even better than the normal smoothing filter when it comes to only modifying large changes. Can be repeated on the same track for greater effect. It is the slowest filter, great at keeping minute details, which can be very important, especially with motion-capture data when you want to keep nuances.

- **Pos Smoothing** Corrects move transform problems by smoothing the curve. Can be repeated on the same track for greater effect. Slower than blurring, but keeps more detail of the curve.

- **Pos Blurring** Corrects positional problems by blurring the curve. Good if you just want to keep the general shape of the animation, but don't want to keep the details. May remove too much detail in the animation.

- **Remove Keys** Fixes errors by deleting keys based on an interval setting.

- **Knee Wobble** Fixes knees that wobble or shake when a foot is planted. Uses a Knee Angle value as criteria for error status.

- **Knee Extension** Fixes knees that overextend when a foot is planted. Uses a Fluctuation value as criteria for error status.
Fixer parameters

Individual fixers display different parameters. These include:

- **Width**  Determines how much of the curve is affected around the keyframe. All the Fixers except for Remove Keys display this parameter.

- **Damping**  Determines how the fix is blended into the existing curve. Changes how effective the fixer should be. A higher value, the more dramatic the change. A damping value of 1.0 is normal behavior. All the Fixers except for Remove Keys display this parameter.

- **Delete Keys**  Allows for selective key removal based on Interval Width. When Delete Keys is used, keys are removed only within the Interval Width. When Delete Keys is not turned on, Remove Keys will remove the selected keys without considering the Interval Width. This parameter is available only when Remove Keys is the fixer.

- **Interval Width**  Determines the number of frames around the error to consider when deleting keys. This parameter is available only when Remove Keys is the fixer.

- **Knee Angle**  Sets the rotation angle to determine what constitutes knee extension errors. If the knee is planted and its angle is less than or equal to the knee limit angle, then the center-of-mass object is adjusted so that the knee angle doesn't exceed the limit. This parameter is available only when Knee Extension is the fixer.

- **Frames**  Determines the interval to consider for fluctuation evaluation. This parameter is available only when Knee Wobble is the fixer.

- **Fluctuation**  Establishes the amount of change allowed before knee wobble is identified. This parameter is available only when Knee Wobble is the fixer. If the knee angle fluctuates greater than the fluctuation threshold for 2 knee angles within the frame interval threshold, then the knee's angle is changed, so that the wobble is eliminated.

---

**Fix Selected**  Applies the Fixer operation to the selection in the Analyze Results error list.
Fix All  Applies the Fixer operation to all the errors, whether they are selected in the Analyze Results error list, or not.

Filters Panel

Select a biped part. > Motion panel > Biped Apps > Workbench > Filters panel

Filters are simply operations that can be performed to different biped body parts. They are similar to fixers, but they operate over an interval of time rather than on the results of the last analysis. Thus, you can use a filter without analyzing.

Certain filters share parameter types and functionality as fixers, though the values are not shared and are distinct for each filter. Use a filter whenever you want to perform a general operation over a body parts motion, like smooth out or boost up some noise.*

Procedures

To filter a track:

1  Choose the parts you want to filter: either just a particular curve, or an entire selection.

2  Choose the time range you want to filter: either the entire biped animation, the active time segment, or a custom range.

3  Choose the filter you want to apply. Adjust its individual parameter as required.

4  Click Filter at the bottom of the panel.

5  Observe the effect on the graph in the Curve view.

6  Play the animation in the viewport and observe the difference, if any. Click Undo if the results are unexpected or incorrect.
Interface

Parts to Filter:
- Display Curve Part
- Selected Parts

Time to Filter:
- Entire Animation
- Active Time Segment
- From / To: 0 123

Filters:
- Rot Smoothing

Width: 5
Damping: 1.0

Filter
Parts to Filter Sets the filter to act on either the display object or the entire selection of objects.

- **Display Curve Part** Sets the filter to act on the displayed object curves.

- **Selected Parts** Sets the filter to act on the active selection. Especially useful when working on the whole biped.

Time to Filter Sets the range to be filtered to either the entire biped animation, the active time segment, or a custom range of frames.

- **Entire Animation** Sets the time to filter to be the complete biped animation (disregarding the active time segment).

- **Active Time Segment** Sets the time to filter to be the scene active time segment. You set the active time segment in the 3ds Max Time Configuration dialog.

- **From / To** Sets the time to filter to a custom range of frames.

Filters group

**Filters list** Choose the filter to use from this drop-down list. The available filter types include smoothing, blurring, boosting, key reduction, and subanims.

- **Rot** filters work in quaternion rotation space, and modify the quaternions of the specified animation tracks.

- **Pos** filters work in the specified positional coordinate system, and modify the positions of the animation tracks.

- **Blurring** Uses basic Gaussian filters that take a weighted average over the width. Blurring filters are good for smoothing out noise, but can also over-smooth areas that aren't noisy. See **Blurring, Smoothing, and Boosting parameters** on page 4846, below.

- **Smoothing** filters, on the other hand, are much better than blurring filters for keeping the general shape of the track or curve. They affect only areas that have big changes. The drawback of the smoothing filters is that they don't change the curve as dramatically as the blurring filters do, so sometimes you'll need to run the smoothing filter multiple times to smooth out a particularly noisy area.

- **Adv Rot Smoothing** works even better than the normal angular smoothing filter when it comes to modifying only large changes and not small ones. See **Blurring, Smoothing, and Boosting parameters** on page 4846.
(There is no comparable “advanced position” fixer or filter.)

- **Boosting**  Boosting filters are the opposite of blurring filters. They increase, rather than decrease, changes in the track. Boosting filters are helpful if you want to make a track have more exaggeration or a little more jerkiness. See **Blurring, Smoothing, and Boosting parameters** on page 4846.

- **Sub Anims**  The Sub Anims filter manages sub-animation of biped objects. Clicking a button that corresponds to a transform (Position, Rotation, or Scale) displays a dialog that lets you assign a controller to that transform. Assigning a controller in this way assigns it only to the selected biped parts. This is very handy for adding controllers to multiple biped parts all at once. Also includes the ability to enable or disable the three list controllers selectively, and avoids creating SubAnims, where they already exist. See **Sub Anim parameters** on page 4847.

- **Key Reducer**  Creates tracks with fewer keys, by removing certain keys based on tolerance and key spacing parameters. This works similarly to how key reduction works during motion-capture import. See **Key Reducer parameters** on page 4847.

- **Knee Wobble**  Corrects knees that wobble or shake when a foot is planted. If the knee is determined to wobble by the filter, the center of mass object is adjusted to eliminate the wobble.

- **Knee Extension**  Corrects knees that overextend when a foot is planted. If the knee extension is identified by the filter, the center of mass object is adjusted to eliminate the extension.

**Blurring, Smoothing, and Boosting parameters**

- **Width**  Width is the size of the filter kernel width in frames. It tells you how much of the animation is taken into effect when filtering a specified keyframe.

- **Damping**  The Damping value changes how effective the filter should be. A higher value, the more dramatic the change. A damping value of 1.0 is normal filter behavior.
Sub Anim parameters

Enable Turns Position, Rotation, and Scale subanims on and off for the selected biped parts.

Collapse Adds the subanim animation of the selected biped part to that part’s Transform controller.

NOTE When you choose the Sub Anim filter, the Filter button at the bottom of the panel disappears. That’s because the operations of this filter are immediate.

Don’t Delete Maintains the subanim in the list as it’s collapsed onto the biped.

Per Frame Sets keys at every frame of the collapsed controller.

The Sub Anims filter tools are also available from the Motion panel. You can assign controllers to a biped subanim, and then collapse it by right-clicking and choosing Properties. The difference between using this in the Motion panel and in the Workbench is that you can apply subanims to multiple biped objects in one step when using the Workbench filter.

Key Reducer parameters

Create Key Per Frame When on, the filter creates a key per frame for every selected track. Default=off.
**Tolerance** Sets the maximum angular or positional deviation for a track (other than a COM track). Default=3.0.
Values are in units of translation for position tracks, and in degrees for rotation tracks.

**Key Spacing** Sets the minimum number of frames between keys (other than COM keys).
Tolerance is computed first, then Minimum Key Spacing computes further key reduction.

**COM Parameters** These Tolerance and Key Spacing settings affect key reduction only on specified center-of-mass (COM) tracks (horizontal, vertical, or rotational).

**Filter** Click to apply the active filter to the selected tracks.

---

**Working with Motion Flow**

Select a biped > Motion panel > Biped rollout > Motion Flow Mode

Motion flow mode provides an area to graphically arrange clips into a network and tools to create and edit transitions between clips. You can use Motion flow mode to organize clips into a network to animate one or more bipeds. The network of clips are joined together by transitions.

A motion flow script associates the network of clips with the biped. To animate one biped, you create a single motion flow script that uses a list of clips to animate the biped. To animate multiple bipeds or a crowd of bipeds, you can either use the random method of clip selection or a delegate-driven approach.
The random method simply picks clips at random and creates random scripts for each biped. This approach works well if the bipeds are standing still or are far apart and don’t require collision detection: a crowd of cheering fans at a ball game, for example. Clip and transition percentages are set with the Create Random Motion on page 4907 command during motion synthesis.

When dealing with a crowd, or multiple bipeds that are close together, the delegate driven approach is the best solution. This approach uses many parameters to simulate moving crowds and incorporates collision detection, surface follow and other parameters. The delegate-driven method uses a network of clips, but instead of random selection, it bases clip selection on a delegate’s speed and heading. In a delegate-driven crowd simulation, clips are arranged to follow a logical sequence. For example, the first clip could be a start walk clip, then a walk loop, then a branch to a turn right and turn left clip, then a slow to stop clip and so on. During motion synthesis, this arrangement is used to pick clips. If character studio senses a collision ahead, the slow to stop clip is selected, or a veer to avoid clip is chosen. For a detailed breakdown of delegate driven crowd behavior, see Crowd Animation on page 5104.
Placing Motions on the Motion Flow Graph

The Motion Flow Graph on page 4891 contains the tools you'll use to add clips to the dialog window, calculate optimized transitions, set random script transition values, move and delete clips, and display clip dependencies. Clips display as icons and transitions appear as arrows in the Motion Flow Graph.

The Motion Flow Graph displays when you click Show Graph on the Motion Flow rollout on page 4888 on the Motion panel.

The first step in Motion Flow mode is to add clips in the Motion Flow Graph for use in scripts. Clips represent all or part of a BIP file. Transitions represent different paths through the clips in the Motion Flow Graph. A transition looping back to the same clip represents a cycle or loop.

If a biped is using a shared motion flow, then the title of the graph dialog says "Shared Motion Flow Graph", followed by the name of the shared motion flow. Shared Motion Flows are used to control multiple bipeds with one shared motion flow.

There are two ways to create clips in the Motion Flow Graph on page 4891. The first method lets you create a blank clip to which you later assign a BIP file. The second method lets you create multiple clips at once by choosing several BIP files at once.
Procedures

To create clips in the Motion Flow Graph:

1. Select a biped

2. Open the Motion panel.

3. Click Motion Flow Mode on the Biped rollout.

4. On the Motion Flow rollout, click the Show Graph button to open the Motion Flow Graph.

5. On the Motion Flow Graph toolbar, click Create Clip.

6. Click a few times inside the Motion Flow Graph dialog. Clip icons will appear in the Motion Flow Graph on page 4891 that are named clip1, clip2 and so on.

7. On the Motion Flow Graph toolbar, click Select Clip/Transition.

8. Right-click over a clip in the window. A clip dialog is displayed.

9. Click Browse in the clip dialog and choose a BIP file. Optionally, set the start and end frame and then click OK. The selected icon displays the clip name in the Motion Flow Graph on page 4891; this clip can now be used for script creation.
11 Click Select Clip/Transition again and load BIP files for the other clips you created.

To create multiple clips in the Motion Flow Graph:

1 On the Motion Flow rollout, click the Show Graph button to open the Motion Flow Graph.

2 On the Motion Flow Graph toolbar, click Create Multiple Clips. The Open dialog appears. Use it to choose the location of your BIP files.

3 While holding down the Ctrl key, choose multiple clips in the Open dialog. Once processed, multiple clips appear in the Motion Flow Graph on page 4891 window.
NOTE The number of clips you can load depends on the amount of memory you have in your system.

Creating Transitions

Select a biped. > Motion panel > Biped rollout > Motion Flow Mode > Motion Flow rollout > Motion Flow Graph

Transitions, shown as arrows, link motion files (clips) together to create longer character animation and crowd simulations. Transitions can be created manually with the Transition Editor on page 4900 or automatically by character studio.
Transitions can also be optimized for better flow. To create optimized transitions, use the Optimize Selected Transition on the Motion Flow Graph toolbar or Optimize Transition in the Transition Editor. By default, minimum motion loss is used to compute transitions. Optimized transitions use an algorithm that minimizes foot sliding. Optimized transitions take longer to compute but yield very fluid results.

Crowd simulations can use dozens of motion clips so automatic creation of optimized transitions can be a big time saver. Whether you plan on animating one or many bipeds using Motion Flow mode you’ll need transitions between the clips in the Motion Flow Graph.

Procedures

To create transitions using From > To or To < From method:

1. On the Motion Flow rollout, click the Show Graph button to open the Motion Flow Graph.

2. On the Motion Flow Graph toolbar, click Create Multiple Clips. The Open dialog appears. Use it to choose the location of your BIP files.

3. While holding down the Ctrl key, choose multiple clips in the Open dialog.
Once processed, multiple clips appear in **Motion Flow Graph** on page 4891.

4. Turn on either Create Transition From -> To or Create Transition To <- From on the Motion Flow Graph toolbar and then drag from one clip to another clip.

The top set of clips are linked using Create Transition From->To. The bottom set of clips are linked using Create Transition To<-From.

**To create transitions using Create All Transitions:**

1. On the Motion Flow rollout, click the Show Graph button to open the Motion Flow Graph.

2. On the Motion Flow Graph toolbar, click Create Multiple Clips. The Open dialog appears. Use it to choose the location of your .bip files.

3. While holding down the Ctrl key, choose multiple clips in the Open dialog.
   
   Once processed, multiple clips appear in the Motion Flow Graph dialog.

4. Click Select Clip/Transition and select all the clips you added.
5 To create transitions between all the clips, turn on Create All Transitions on the Motion Flow Graph toolbar.

6 At the Biped dialog, click Yes to create transitions from each selected clip to itself.

![Motion Flow Graph](image)

Possible transitions from one clip to the next are automatically generated.

**To optimize transitions in the Motion Flow Graph:**

1 After adding several clips and transitions, click Select Clip/Transition and select one or more transitions.
On the Motion Flow toolbar, click Optimize Selected Transitions. The Transition Optimization dialog is displayed.

Click OK.

A processing bar scrolls across the top of the Motion Flow Graph on page 4891.
Creating a Motion Flow Script

Select a biped. > Motion panel > Biped rollout > Motion Flow Mode

A script is a list of clips (BIP files) that control the character you are animating. To create a script, add clips to the Motion Flow Graph on page 4891, then click Define Script in the Scripts section of the Motion Flow rollout on page 4888, and click a sequence of clips in the Motion Flow Graph. Default transitions are assigned if no transitions exist between the clips. The clip names and starting frame numbers display in the list on the Motion Flow Script list.

A sample script as it appears in the Scripts group on the Motion Flow rollout

Random scripts vary the order of the clips found in the Motion Flow Graph. Scripts are run in a top-down order to animate the character. Click Play to view scripted motions on the biped.

TIP As the length of a script varies, use Alt+R to set the Active Time in 3ds Max to the length of the script.
Once a script is put together, you have additional controls that let you adjust the starting frame, the starting X, Y, or Z locations and the starting rotation of the animation.

**Procedures**

**To create a Motion Flow script:**

1. Create a motion flow graph with three or more motion files.
   
   For information on how to set up the graph, see To create multiple clips in the Motion Flow Graph on page 4852.

2. In the Scripts section of the Motion Flow rollout, click Define Script, and then select a sequence of clips from the Motion Flow Graph dialog on page 4891.

   As you select the clips in the Motion Flow Graph dialog, they are added to the script list.
Transitions are automatically made in the Motion Flow Graph as you add clips to the script.

3. Give the script a new, descriptive name. Adding a descriptive name is less confusing if you ever append Motion Flow Editor files together.

4. Click the Play Animation button to see the biped move to the scripted clips.

5. Click Stop Animation. Change the Start Frame setting to 25 and move the frame slider. Now the biped will hold its start position until frame 25, then start moving.

6. Change the Start Position X:, Y:, or Z: setting. These settings let you control the position of the footsteps that the character follows.

7. Change the Start Rotation setting to 90.
Often, the footsteps in a BIP file are not oriented in the direction you want. This setting lets you adjust which direction the character faces.

**NOTE** Each Start setting affects the entire animation. You cannot select a single entry in the script and make a change to affect only that clip.

### Saving, Loading, and Appending Motion Flow Graphs

Select a biped. > Motion Flow mode > Motion Flow rollout

Scripts, transitions, and clip references are saved in a Motion Flow Editor MFE, file, for later editing. This format lets you save a Motion Flow and script from one biped and load it onto another biped.

You save, load, and append MFE files from the Motion Flow rollout.

**Procedures**

**To save Motion Flow Editor files:**

1. Create a Motion Flow Graph with three or more motion files.

   For information on how to set up the graph, see [To create multiple clips in the Motion Flow Graph](#) on page 4852.
2 Create a script using the clips in the Motion Flow Graph. For information on how to create a script, see To create Motion Flow Scripts on page 4859.

A sample script called Kicking Script containing four clips

3 Click the Save File button to save a Motion Flow Editor MFE file. The Save As dialog opens.
Specify a folder on your hard drive where you plan to store your Motion Flow Editor files.

**To load Motion Flow Editor files:**

1. Select a biped.

2. Open the Motion panel.

3. On the Biped rollout, click Motion Flow Mode.

4. On the Motion Flow rollout, click Load File. The Open dialog opens.
Navigate to the folder where your MFE files are stored.

Choose the file to load.

Click the Play Animation button to see the biped move to the scripted clips.

To append Motion Flow Editor files:

1. Select a biped.
2. Open the Motion panel.
3. On the Biped rollout, click Motion Flow mode.
4. On the Motion Flow rollout, click Load File. The Open dialog opens.
5 Select an MFE file from the folder where your Motion Flow Editor files are stored.

6 Click Append File.
   The Open dialog is displayed again.

7 Choose a different MFE file.
   A new script appears in the script drop-down list and the appended sequence of clips appears directly below the original sequence of clips in the Motion Flow Graph dialog, so you may have to scroll down to see it.

Customizing Transitions

Select a biped. > Motion panel > Biped rollout > Motion Flow Mode > Motion Flow rollout

A good transition links two clips together seamlessly. The motion through the transition should appear natural, as though the motion was captured as one long motion sequence. If clips do not transition smoothly, you might find it necessary to edit or customize your transitions.
There are two ways to manually edit transitions:

- In the Motion Flow Graph, you can right click a transition arrow.
- If you have defined a script, highlight a clip and click the Edit Transition
  button.

Transitions can be edited automatically by using the Optimize Transition
features. When you create a script, default transitions are set between the clips.
Default transitions use minimum motion loss and are quick to compute.
However, the best quality transitions are the optimized transitions. Optimized
transitions use a minimum foot sliding algorithm to compute the transition
and yield very good results.

Procedures

To manually customize transitions between two clips:

1. On the Biped rollout, select a biped and turn on Motion Flow
   mode.
2. Create or load a script with at least two clips.
   For information on how to create a script, see To create Motion Flow
   Scripts on page 4859
3. Choose the first clip in the clip list in the Scripts section on the Motion
   Flow rollout.
4. Click Edit Transition to display the Transition Editor for the selected
   clip and the clip following it in the list.
5. Scrub the Frame spinners in the Ghost areas of the Source Clip and
   Destination Clip, to find a place in both clips to start the transition.
   Two stick figures appear to help you find an appropriate start frame. The
   yellow figure represents the Source Clip and the red figure represents the
   Destination Clip.
   The stick figures can be positioned far apart during this process. Look for
   body motions in the two clips that will transition well.
6. Click Set Start Frame in both the Ghost areas when a good Start
   Frame is located.
Character studio repositions the destination clip for a best body fit between the two clips.

7 Set the transition duration in the Length field.
   A transition duration of 10 to 25 frames is normal.

8 Click OK.

9 Click Play Animation or scrub the time slider to view the transition.

To automatically customize transitions between two clips:

1 ⚙️ On the Biped rollout, select a biped and turn on Motion Flow mode.

2 Create or load a script with at least two clips.
   For information on how to create a script, see To create Motion Flow Scripts on page 4859

3 Choose the first clip in the clip list in the Scripts section on the Motion Flow rollout.

4 Click Edit Transition to display the Transition Editor for the selected clip and the clip following it in the list.

5 At the upper-left corner of the Transition Editor, click Next Transition in Script.

6 Click Optimize Transition.
   The Transition Optimization dialog is displayed.
Choose either Search Entire Clip or Search Near Existing Transition, and click OK.

Click OK on the Transition Editor dialog.

Click Play Animation or scrub the time slider to view the transition.

Creating Random Motion

You can randomly traverse clips in a motion flow graph to animate one or more bipeds using controls in the Create Random Motion dialog. You set parameters for random motion in the Motion Flow Graph, in the clip and transition dialogs, as well as in the Create Random Motion dialog.

You create random motion by first adding clips to the Motion Flow Graph and adding transitions between the clips. Clips and transitions are then given percentages, which are used to create random motion for one or more bipeds. You can manually control the “weighting” for a possible start clip, transitions, and frame range. This allows you to animate multiple bipeds in a crowd scene for example. A different script is created for each biped.
NOTE If you want to create random motion for multiple bipeds, they must be sharing a motion flow.

Details of Random Motions

When choreographing a random motion for your biped, the default “weighting” for all clips and transitions is set to 100. This ensures that all clips and transitions have an equal chance of being randomly chosen. You can adjust the weighting of transitions in the Motion Flow Graph or Transition Editor to give transitions a higher probability of being selected. You can also set a specific start clip for your biped to use while the remainder of the clips in the script are randomly chosen from the Motion Flow Graph.

To customize transition “weighting” and setting a start clip:

1 On the Biped rollout, select a biped and turn on Motion Flow Mode.
2 On the Motion Flow rollout, click Show Graph. This displays the Motion Flow Graph.

3 On the Motion Flow rollout, click Load File. The Open dialog is displayed.

4 Choose an MFE file from the folder where your Motion Flow Editor files are stored. The clips and transitions appear in the Motion Flow Graph. Each transition displays its “weighting” value, 100 by default.

5 Click Select Clip/Transition and right-click a transition that you want to adjust. The Transition Editor dialog is displayed.

6 Adjust the Probability setting to give the transition a higher or lower probability of being randomly chosen for the motion flow script.

   NOTE The Probability range is 0 to 100.

7 On the Motion Flow Graph toolbar, click Select Random Start Clips.
8 Select the clip you want used as the start clip. The clip turns purple and is assigned a weighting of 100. The selected clip will be used first by any biped using the random motion script.

9 In the Scripts section on the Motion Flow rollout, click Create Random Motion.

10 On the Create Random Motion dialog, set a value for Minimum Animation Length. This should be long enough to include the clips you want in the animation.

11 Click Create. A random script is created based on clips in the Motion Flow Graph and the Minimum Animation Length.

12 Click Play Animation or scrub the time slider to view the transition.

Procedures

To create a random script for one biped:

1 On the Biped rollout, select a biped and turn on Motion Flow mode.

2 On the Motion Flow rollout, click Show Graph. This displays the Motion Flow Graph.

3 On the Motion Flow Graph toolbar, click Create Multiple Clips. The Open dialog appears where you can choose the location of your BIP files.

4 After adding several clips and transitions, click Select Clip/Transition and select all the clips.
On the Motion Flow Graph, click Synthesize Motion Flow Graph and click Yes when asked if you want to create transitions from each selected clip to itself.

On the Motion Flow Graph toolbar, click Select Random Start Clips. All the transitions linking clips are weighted at 100, meaning all the transitions have a even chance of starting first.

Region select all the clips in the Motion Flow Graph. The clips all turn purple and are assigned a weighting of 100. All the clips have an even chance of starting first.
8 In the Scripts section on the Motion Flow rollout, click Create Random Motion.

9 On the Create Random Motion dialog set a value for Minimum Animation Length. This should be long enough to include the clips you want in the animation.

10 Click Create. A random script is created based on clips in the Motion Flow Graph. You can vary clip and transition percentages in the clip dialog or Transition Editor to favor a clip or transition if you like.

11 Click Play Animation or scrub the time slider to view the transition.

**Unifying Motion**

The Create Unified Motion command allows you to create one motion from a script. The entire unified motion is then available when you exit Motion Flow mode.
Create Unified Motion converts a script into a freeform unified motion. The created motion replaces animation present when the Motion Flow Mode button is turned off. This is useful if you want to make changes to the biped like raising its arms or turning its head.

**Procedures**

**Example: To create a unified motion:**

1. Create a biped.

2. On the Biped rollout, turn on Motion Flow Mode.

3. On the Motion Flow rollout, click Show Graph.
   This displays the Motion Flow Graph.

4. On the Motion Flow rollout, click Load File and open an MFE file.

5. Click Create Unified Motion.

6. On the Biped rollout, turn off Motion Flow mode.

7. Open the Layers rollout and click Create Layer.
   A new layer is created and you see a red skeleton appear on your biped.
8 Activate the Front viewport and turn on Auto Key.

9 At frame 0, select and rotate the biped's upper left arm about the Y axis.
10 Turn off Auto Key and click Play Animation.

Sharing Motion Flow

Shared Motion Flow on page 4909 allows you to assign one motion flow to multiple bipeds or crowds. Rather than building a motion flow network of clips for each biped, you can create a motion flow with all the clips and transitions to animate multiple bipeds. Random motion creation will use each biped’s own motion flow. If a biped’s motion flow happens to be a shared motion flow, then the shared motion flow will be used to compute random motion.

A biped that shares a motion flow shares only the clips you have added to the Motion Flow Graph. Scripts are unique to each biped, although the scripts point to the clips of the shared motion flow. You can manipulate each biped’s motion flow and scripts in the usual ways. You can create random motion on a biped that shares a motion flow, or create a motion flow script using the crowd system.
There are a few indicators in the user interface that show if a biped is using a shared motion flow. If it is, a white circle surrounds the Shared Motion Flow button when you edit that biped. If you edit that biped’s motion flow graph, the title of the graph dialog will say "Shared Motion Flow Graph", followed by the name of the shared motion flow.

**NOTE**  All bipeds in a shared motion flow should have the same leg scale and structure. Adaptation for differently sized bipeds does not occur in a shared motion flow. If you want differently sized bipeds in a crowd, then create a shared motion flow for each size.

**TIP**  The only way to save a shared motion flow, along with the bipeds sharing it, and keep everything hooked up correctly is to save it all in a .max file.

**Procedures**

**Example: To share a random motion flow among multiple bipeds:**

1. Create three bipeds.

2. On the Biped rollout, turn on Motion Flow Mode.

3. On the Motion Flow rollout, click Shared Motion Flow. The Shared Motion Flow dialog is displayed.

5 On the Shared Motion Flows dialog in the Parameters group, click Add.
6 On the Select dialog, choose all the bipeds.
   The bipeds are added to the list. If you add clips to the motion flow graph
   they will be shared by the bipeds.
7 Click OK to close the Shared Motion Flow dialog.
8 On the Motion Flow rollout, click Show Graph.
This displays the Motion Flow Graph.

9 Click Create Multiple Clips and add three or four clips (or more) to the Motion Flow Graph.
The Open dialog appears where you can choose the location of your BIP files.

10 After adding the clips, click Move Clips and arrange the clips so they are not so close to one another. This will make it easier to see the transitions later.

11 Click Select Clip/Transition and region-select all the clips.

12 On the Motion Flow Graph, click Create All Transitions, and click Yes when asked if you want to create transitions from each selected clip to itself.
On the Motion Flow Graph toolbar, turn on Select Random Start Clips.
All the transitions linking clips are weighted at 100, meaning all the transitions have an even chance of being randomly used.

Region-select all the clips in the Motion Flow Graph dialog. The clips all turn purple and are assigned a weighting of 100. Now all the clips have an even chance of starting first.
15 In the Scripts section of the Motion Flow rollout, click Create Random Motion. The Create Random Motion dialog is displayed.

16 On the Create Random Motion dialog, change the second value that follows Random Start Range to 10 or 20. This will stagger the beginning of each biped's movement.

17 Turn on Create Motion For All Bipeds Sharing This Motion Flow. Failure to do this will result in the motion flow being added only to the selected biped.

18 Click Create. A Unify Options dialog appears once for each of the bipeds in the scene. Click OK to accept the defaults. After the Unify Options dialogs, an alert dialog asks if you want to put all the bipeds into Motion Flow mode. Click Yes. 3ds Max creates a random script for each of the bipeds that share the motion flow. Footsteps appear in the viewports, and the bipeds' initial poses might change.
Click Play Animation or scrub the time slider to view the effect of the randomized script.

To apply a shared motion flow to a different group of bipeds:

**character studio** can save and load shared motion flow setups. With this facility, you can create and refine a crowd simulation using bipeds that don't have meshes attached, thus avoiding the computational overhead that Physique requires. Once the simulation is ready, you can save the shared motion flow setup, apply it to a similar set of bipeds with Physique applied, and then render the final animation with no further crowd setup required.

For best results, the two sets of bipeds should have the same number of members and be of comparable structure and size, and the biped structures should have the same root names.

1. **Create a biped/crowd simulation using a shared motion flow.**
   - For details, see Using bipeds in a crowd simulation on page 5142.

2. **On the Shared Motion Flow dialog, click Save and save the shared motion flow in SMF format.**

3. **Set up a new scene containing the same number of bipeds, each with a character mesh with Physique applied.** The easiest way to do this is to set up one such character and then clone it.
   - Make sure the bipeds have the same root names (e.g., Bip01, Bip02) as those in the original setup.

4. **Select one of the bipeds, and on the Motion panel, turn on Motion Flow mode, and then click Shared Motion Flow.**

5. **On the Shared Motion Flow dialog, click New, and then click Load and load the shared motion flow from step 2.**
   - The shared motion flow is loaded and applied to the new set of bipeds. The biped names appear in the dialog list. If “(wrong scale)” appears after any biped names, use the Reset Wrong Scales buttons to correct the scales.

6. **Click the Put Multiple Bipeds In Motion Flow button to place all of the bipeds in the list in Motion Flow mode, and then click OK to exit the dialog.**
7 Play the animation to ensure that it's correct, and then render.

Refer to Working with Crowd Animation on page 5104 for information regarding crowd animation.

Setting Up Paths for Motion Flow Files

On a Motion Flow Graph, the location of the referenced BIP files is saved in the MFE file. If a BIP file cannot be found, 3ds Max looks in the Animations directory specified by Configure User Paths > File I/O on page 8287.

If a BIP file is not found in the Animations directory, then 3ds Max looks for the file in the same location as the currently loaded MAX file. If it is still not found, 3ds Max appends the local path of the referenced file to the path to the current MAX file. The file is saved back to the same location in which it is found.

If a referenced BIP file cannot be found in its current location, there are two ways to resolve this.

■ From the Reset Unfound Motion Flow Files dialog, direct 3ds Max to the folder where the missing BIP file resides.
Find and move the missing BIP file to the specified Motion Flow folder.

**NOTE** When you find the BIP file, you can turn on the Add Directory To .INI File option and the directory is automatically added to your biped.ini file. Since the biped.ini file accepts multiple search paths, the new directory is added as another MoFloDir= line. 3ds Max will search the directories in the order they appear and will use the first instance of the file that it finds. When network rendering, the file names need to be UNC-compatible.

**Procedures**

**To load a Motion Flow scene from another system:**

1. Open a Motion Flow scene that was created on a different system.
   
   If referenced BIP files cannot be found, the Reset Unfound Motion Flow File dialog is displayed.
2 If any of the referenced BIP files are on your local drive, navigate to the folder where they reside and select the BIP file.

3 Turn on the Add Directory To .ini File option, and click Open.
   Turning on the Add Directory To .ini File option automatically adds another MoFlowDir= line to your biped.ini file.

   - Add directory to ini file

NOTE Turn on Add Directory to Search if you want to search for referenced BIP files during your current session, but do not want to add the directories to the biped.ini file.

4 Click Play Animation after paths for all the referenced BIP files are properly set.
Motion Flow Mode

Select a biped. > Motion panel > Biped rollout > Motion Flow Mode

In Motion Flow mode, you combine BIP files, using either velocity-interpolated transitions or optimized transitions that compute minimum foot sliding, to create longer character animations.

First you add clips and reference them to BIP files in the Motion Flow Graph. You then use these to create a script in the Motion Flow Script list. You adjust transitions between BIP files with the Transition Editor. You save scripts, transitions, and clip references in a Motion Flow Editor file (MFE) for later editing.

The Transition Editor uses ghosts to represent the source (yellow) and destination (red) clips. Use these stick-figure ghosts to judge body position and set a likely start frame in both clips for the transition.

Random Motion and Crowds

You can generate random motions for one or more bipeds using the Create Random Motion command. For example, you can use these to animate a crowd of bipeds. For a crowd, you must share one motion flow script among many bipeds.
If you are driving a crowd using delegates and behaviors, then rather than a completely random motion, character studio picks appropriate clips based on the delegate's speed and direction. If the delegate slows to a stop, character studio will find and use a clip that slows to a stop, if one exists.

In all crowd simulations you must load clips and create transitions before synthesizing the crowd motion. Often, many clips are used to synthesize crowds. Automatic transitions relieve you of having to create transitions between clips manually.

One additional rollout displays in Motion Flow mode: The Motion Flow rollout on page 4888 provides access to the Motion Flow Graph and lets you load and save motion flow files (MFE). The rollout also contains a Scripts section where you can create scripts, edit transitions, create a unified motion, and create random motions for the bipeds.

NOTE In Motion Flow mode, some character studio controls are disabled.

Workflow: Getting Started with Clips and Transitions in Motion Flow Mode

Create your own library of BIP files from imported and converted motion-capture data and from your own character animation. With a biped selected, turn on Motion Flow mode. On the Motion Flow rollout, turn on Show Graph to open the Motion Flow Graph. On the Motion Flow Graph, click Create Clip, and add clips in the Motion Flow dialog. Associate the clips to BIP files by first turning on Select Clips-Transitions on the Motion Flow Graph toolbar and then right-clicking a clip icon; a clip dialog appears, allowing you to browse for a clip.

Click Define Script on the Motion Flow rollout, then select a series of clips on the Motion Flow Graph. By left-clicking on a clip it will appear in the Scripts list. The clips are connected visually in the Motion Flow Graph with red arrows (active script) representing default transitions (Minimum Motion Loss). The default duration for a transition is 25 frames, which provides good results in many cases. Transitions, by default, use velocity interpolation between clips.

Use Edit Transition in the Scripts section to fine-tune the transitions between clips. Select a clip in the Scripts list, then from the Scripts commands, click Edit Transition; the Transition Editor on page 4900 displays, and the source and destination clip names are displayed at the top of the Transition Editor.

In the Source Clip area, Start Frame represents the frame in the source file where the transition starts. For example, if Source Clip Start Frame is 60, the transition from the source clip starts at frame 60. The duration of the transition is set in the Length field at the upper left; Length values are in frames. In this example, if Length is set to 10, the transition to the destination clip takes 10
frames. In the Destination Clip area, Start Frame represents the frame in the destination clip that the transition starts; a value of 80, for example, starts the transition at frame 80 of the destination clip. In this example, the source clip plays from 0 to 60, there is a 10 frame transition from frame 60 of the source clip to frame 90 of the destination clip (frames 80 to 90 cover the destination clip transition period), then the rest of the destination clip plays.

When the Transition Editor displays, the first things to try, before manually editing the transition, are the Optimized Transitions. Optimized transitions use a minimum foot sliding algorithm. The top right-hand corner of the Transition Editor dialog is the icon for optimized transitions. If the optimized transition is not satisfactory, try editing the transition manually.

Manual transition editing offers the most control; the Frame spinners in the Ghost areas of the Transition Editor allow you to scrub the source and destination clips while viewing two stick figures. Find a good start frame in both clips using the Frame spinners. Things to look for in both clips are similar supporting feet, body momentum that will appear natural, and arm motion similarities. If velocity changes between the clips are too abrupt, use the Length field to adjust the duration of the transition.

On the Motion Flow rollout, click Save File to save your work as an MFE file; transitions and scripts are saved. These BIP files contain no footsteps. Biped foot keys are saved with an IK Blend value of 1 for footsteps. To extract footsteps, exit Motion Flow mode, use Load File on the Biped rollout, and then click Convert. Convert looks at foot IK Blend values of 1 to extract footsteps.

**TIP** The location of any referenced BIP file is saved in the MFE file. If the BIP file cannot be found, a Missing Motion Flow Files dialog opens up respectively, in which the missing files are listed. To rectify this, open the Asset Tracking dialog on page 7586 and set a new path of the missing files.

**Motion Flow Rollout**

Select a biped. > Motion panel > Biped rollout > Motion Flow Mode > Motion Flow rollout

The Motion Flow rollout displays when Motion Flow mode is active on the Biped rollout. You can load, append, and save motion flow editor files (MFE), and open the Motion Flow Graph on page 4891 and Shared Motion Flow dialogs using controls on this rollout.
To load, append, or save a Motion Flow Editor (MFE) file, refer to the following procedures:

- To load Motion Flow Editor files on page 4863
- To append Motion Flow Editor files on page 4864
- To save Motion Flow Editor files on page 4861

**Interface**

![Motion Flow Interface](image)

**Motion Flow buttons**

![Motion Flow Buttons](image)
Load File Load a Motion Flow Editor file (MFE). Motion Flow Editor files include:

- **Clips** References to biped animation files.
- **Transitions** Names, attributes, and connections between clips.
- **Scripts** Different paths through a set of connected clips and transitions.

**TIP** The location of the referenced BIP files is saved in the MFE file. If the BIP file cannot be found, 3ds Max looks in the Animations directory specified by Configure User Paths > File I/O on page 8287.

If you load an MFE file onto a biped using a shared motion flow, you will get a warning and the biped will be removed from the shared motion flow. The biped will get the newly loaded motion flow and all its scripts.

**Append File** Append a Motion Flow Editor (MFE) file to the MFE that is already loaded. Displays a load file dialog. The appended graph will appear directly below the bottom of the existing graph in the graph window, so you may have to scroll down to see it.

**Save File** Save a Motion Flow Editor (MFE) file. Saving an MFE file from a biped having a shared motion flow will save the motion flow and its scripts as if it were not shared. It will be a normal MFE file.

**NOTE** To save a script as a BIP file, use Unified motion to have the scripted motion available when you exit Motion Flow mode.

**Show Graph** Opens the Motion Flow Graph on page 4891. The first step in script creation is to add clips to the Motion Flow Graph.

**Shared Motion Flow** Displays the Shared Motion Flows dialog on page 4909. Allows you to create, delete, and modify shared motion flows. Shared motion flows are used to animate one or more bipeds to simulate a crowd. If the selected biped is using a shared motion flow, then the icon has a white circle around it.
Scripts group

See Motion Flow Scripts Group on page 4896.

Motion Flow Graph Dialog

Select a biped. > Motion panel > Biped rollout > Motion Flow mode > Motion Flow rollout > Motion Flow Graph > Motion Flow Graph dialog

Use tools in the Motion Flow Graph to add clips to the graph, calculate optimized transitions, set random script transition values, move and delete clips, and display clip dependencies. Clips and transitions display as icons in the Motion Flow Graph dialog.

The Motion Flow Graph displays when you click Show Graph on the Motion Flow rollout on page 4888 on the Motion panel.

The first step in Motion Flow mode is to add clips in the Motion Flow Graph for use in scripts. Clips represent all or part of a BIP file. Scripts represent different paths through the clips in the Motion Flow Graph. The first clip in the current script is red. Transitions are shown as arrows between clips, red arrows represent the path through the active script. Black transition arrows indicate unloaded scripts. A transition looping back to the same clip represents a cycle or loop.

If the biped is using a shared motion flow, then the title of the graph window will say "**SHARED** Motion Flow Graph", followed by the name of the shared motion flow. Shared Motion Flows are used to control multiple bipeds with one shared motion flow.

By default, minimum motion loss is used to compute transitions. Optimized transitions use an algorithm that uses minimum foot sliding. Optimized transitions take longer to compute but yield very high quality results.

Random Scripts for One or More Bipeds

You can create random scripts by using the Create Random Motion command in the Script group on the Motion Flow rollout. Random scripts are created by randomly traversing clips in a motion flow graph. To use Create Random Motion, each biped must be in the same shared motion flow.

To use a shared motion flow to create random scripts for multiple bipeds, the first step is to click Shared Motion Flow on the Motion Flow rollout, and then add bipeds that will share one shared motion flow. On the Motion Flow Graph,
clips are added and transitions are created between all the clips. Then Create Random Motion is used to compute a random motion for all the bipeds.

Clips and transitions are given percentages that are used by character studio to generate random scripts. Percentages for clips and transitions are set in the clip dialogs and in the Transition Editor dialog.

You can load many clips and use Create All Transitions to create all possible transitions between the clips. You can then use Optimize Selected Transitions to create optimized transitions. Once the transitions are created, you can quickly create scripts with optimized transitions or generate random motions for a crowd of bipeds.

The MFE file stores pointers to the clips, transition parameters, and scripts.

See Placing Motions on the Motion Flow Graph on page 4850 to add clips to the graph, or Creating Random Motion on page 4868 to create a random script and transitions.

Interface

Create Clip Select and click in the dialog window to create clips.
The clips are empty. Right-click a clip using the Select Clip tool to display the Clip Properties dialog on page 4914; then select a BIP file and set its duration in the Clip Properties dialog. You can also set the Random Start Probability here. Random Start Probability is used when multiple clips are selected as possible start clips when you generate a random motion flow.

**NOTE** Setting clip duration is not critical for transitions; the Transition Editor on page 4900 allows you to start and end a transition on any frame of a clip.

**Create Multiple Clips** Load multiple motion files.
Displays an open file dialog. Select multiple files and click OK; multiple files are loaded into the Motion Flow Graph window.

**Set lowest starting foot height to Z=0 (BIP files only)** Sets the lowest starting foot height to Z=0. This is an option in the Load File dialog. Default=On.
In Biped, the height of a motion clip can be retained. This is important if you want to retain the height of a motion clip for motions adapted to characters of different sizes. If, for example, the character is jumping off a rock and you want to retain the Z position of the character, you would turn this option off.
Leave this option off if Motion Flow motions must be blended that begin and end at different heights, such as three clips that have the character mounting a bicycle, riding the bicycle, and dismounting the bicycle.
Turning off this option can, however, cause a jump in the motion during motion flow transitions. Turn this on for smooth transitions in Motion Flow mode. If adaptation takes place, the height is set so that the lowest foot at frame 0 starts at the Z=0 height. This lines up clips along the Z axis and creates smooth transitions.

**Create Transition From** -> To Create a transition between two clips.
Click+drag from one clip to another in the Motion Flow Graph dialog. Click on a single clip and then mouse up to create a loop transition. It is necessary to have this capability in order to create random scripts. You can create transitions which are not included in a script.

**Create Transition To** -> From Create a transition between two clips.
Click+drag to one clip from another in the Motion Flow Graph dialog. Click on a single clip and then mouse up to create a loop transition. It is necessary to have this capability in order to create random scripts. You can create transitions which are not included in a script.
**Create All Transitions** Creates transitions between every clip, including loop transitions. Select all the clips that require transitions, then click Create All Transitions. The transitions are not optimized. Use Optimize Selected Transitions to optimize the transitions. Optimized transitions take time to compute but are high quality.

**Delete Clip/Transition** Deletes a clip or transition.

If a script is dependent on the clip, a dialog displays a warning; clicking OK on the dialog deletes the clip and the script that is dependent on it.

If you delete the selected clips and transitions from a shared motion flow, it will delete all the scripts from all the bipeds sharing that motion flow which are dependent on those clips and transitions.

**Select Clip/Transition** Selects a motion clip or transition.

Right-click a clip to display the Clip Properties dialog on page 4914. Right-click a transition to display the Transition Editor dialog on page 4900.

**Move Clip** Moves clips within the Motion Flow Graph. This does not affect the animation.

**Pan** Pans the layout of the clips.

**Zoom** Adjusts the view magnification of the Motion Flow window. Drag up to increase magnification. Drag down to decrease magnification.

**Zoom Region** Click Zoom Region mode to drag a rectangular region and magnify that region to fill the Motion Flow Graph window.

**Fit to Window** Re-sizes the contents to fit the size of the Motion Flow Graph window.

**Save Clip Files** Lets you set a path where selected clip files can be stored.
Clip Mode Edit biped footsteps and limbs for the selected clip. Use Set Key on the Keyframing rollout to set biped limb keys. Clips turn green in the Motion Flow Graph window in Clip Mode.

Show Script Dependencies Displays the scripts that use the selected clip.
If you push the Show Script Dependencies button on a shared motion flow graph, it will check all the bipeds sharing that motion flow for scripts dependent on the selected clips and transitions.

Select Random Start Clips Turn on and select clips in the Motion Flow Graph window.
Press Ctrl+click to add clips. Selected clips are used by Create Random Motion in the Scripts group to start on one of the selected clips based on percentage. If three clips are selected using the default weighting of 100, then each clip has an equal chance of being the start clip.

Show Random Percentages Displays clip and transition percentages in the Motion Flow Graph window.
Random start clips display in purple and display their probability of starting a random script. This also shows the probability (0 - 100) that each transition will be chosen. Create Random Motion in the Scripts group uses clip and transition percentages to generate random scripts.

Optimize Selected Transitions Select one or more transitions and then click Optimize Selected Transition to optimize them. Displays the Transition Optimization dialog on page 4913 to set the location of the transition.
Optimized transitions take time to compute. A progress bar is displayed when you use this feature. Minimum foot sliding is the method used to compute an optimized transition.

Show Optimal Transition Costs Displays costs in the Motion Flow Graph window. The lower the number the better the transition.

Check All Transitions Checks the graph for overlapping transitions and transitions whose length is too long for the clip. It informs you of any problems, or tells you that none have been found.
Auto Clip Names

Names the clip based on the name of the motion file.
Turn off to name a clip yourself.

Motion Flow Scripts Group

Select a biped. > Motion panel > Biped rollout > Motion Flow Mode > Motion Flow rollout > Scripts group

Create and delete scripts, name scripts, edit transitions, edit clips, and position the entire animation using tools in the Scripts group. Create random motion for one or more bipeds using controls in this rollout. The Scripts group on the Motion Flow rollout is available only when Motion Flow mode on page 4886 is active.

Scripts

A Script is a list of clips (BIP files) that you constructed and are executed as you designed to animate a character. To create a script, add clips to the Motion Flow Graph, then select Define Script in the Scripts group and click a sequence of clips from the Motion Flow Graph window. Default transitions are assigned if no transitions exist between the clips. The clip names and starting frame numbers display in the list in the Scripts group.

Different scripts vary the order of the clips found in the Motion Flow Graph. Scripts are run in a top-down order to animate the character. Click Play to view script motion on the biped.

TIP As the length of a script varies, use Alt+R to set the Active Time in 3ds Max to the length of the script. Turn on the Keyboard Shortcut Override Toggle on the main toolbar to enable Biped shortcuts.

Transitions Between Clips

By default, when a script is created, Minimum Motion Loss is used to find likely start frames for the source and destination clips.

Editing transitions using the Transition Editor on page 4900 allows you to determine where a transition occurs in the source and destination clip. Transition duration and the orientation of the destination clip can also be adjusted in the Transition Editor.
Random Motion

The Create Random Motion command traverses clips in the Motion Flow Graph based on transition percentages. Transitions are given percentages, and character studio creates random scripts based on the transition percentages. This is a quick way to create crowd scenes or to try out different scripts on a single biped. For example, if five clips are present in the Motion Flow Graph and transitions exist between all the clips and each clip has a percentage or probability of being used, you can use Create Random Motion to create a script that is comprised of the five clips that are selected at random.

Position the Entire Animation

Use the Position, Rotation, and Start Frame controls to position the entire animation. If you are editing the script for a character in a scene with other objects or characters, use these controls to position the animation relative to the rest of the scene.

For more information regarding scripts, refer to Creating a Motion Flow Script on page 4858.

Interface
Define Script Displays the Biped Motion Flow Script dialog (no dialog displays if there are no scripts; in this case, simply select clips in the Motion Flow Graph).

The Biped Motion Flow Script dialog has the following options:

- **Create New Script** Names a new script. Select clips in Motion Flow Graph to create the clip list for the new script.

- **Redefine Script** Keeps the script name and removes clips in the list. Select clips in Motion Flow Graph to create a new clip list.

- **Insert Above Selected Clip item** Inserts a clip above the selected clip in the list. First select a clip in the list, choose Insert Above Selected Clip item, and then click a clip in the Motion Flow Graph.

- **Insert Below Selected Clip item** Inserts a clip below the selected clip in the list.

- **Append to End of Script** Appends a clip to the end of the clip list.

Create Random Motion Displays the Create Random Motion on page 4907 dialog.

Controls in the Create Random Motion dialog allow you to create random scripts to animate one or more bipeds. Random motion on multiple bipeds can be used to create a crowd scene.

Delete Script Deletes the current script; displays the previous script if one is present.

Create Unified Motion Converts a script into a Freeform unified motion. The created motion replaces animation present when Motion Flow Mode is turned off.

Go to Frame Make the first frame of the selected clip the current frame.

Cut Removes the selected clip from the script list and creates a default transition to the next clip on the list.

Copy Copy the selected clip to the clipboard.
Paste a clip from the clipboard.

Clip Mode Edit biped footsteps and limbs for the selected clip. Use Set Key on the Keyframing rollout to set biped limb keys.

Edit Clip Displays the Clip Properties dialog on page 4914. Change the start and end frame for the current clip, or replace the current clip with another one. You can also set the Random Start Probability here. Random Start Probability is used when multiple clips are selected as possible start clips when you generate a random motion flow. The clip name in the script list and the icon in the graph window are updated if the clip is replaced.

Edit Transition Displays the Transition Editor on page 4900 for the selected clip. Edit the transition for the selected clip and the clip following it. By default, when a script is created, Minimum Motion Loss is used to find start frames for the source and destination clips. Use Edit Transition to select your own start frames or to try out optimized transitions.

NOTE Right-clicking a transition “arrow” in the Motion Flow Graph also displays the Transition Editor, but it will only give you the basic transition editing tools. To edit the transition’s Source Clip-Frame Start and the Destination Clip, use the Edit Transition button.

Move the Entire Animation

Start Frame Set the start frame for the first clip in the script.
Start Position X Move the entire script along a world X-axis.
Start Position Y Move the entire script along a world Y-axis.
Start Position Z Move the entire script along a world Z-axis.
Start Rotation Rotate the entire script around the world Z-axis. All transformation and rotation is based on the original position and affect the entire script.
Transition Editor

Select a biped. > Motion panel > Biped rollout > Motion Flow Mode > Scripts group > Select a clip in the script list. > Click Edit Transition. > Transition Editor

Display the Transition Editor by selecting a clip in the list of the Scripts group and clicking Edit Transition in the same group or right-clicking a transition arrow in the Motion Flow Graph.

Transitions

A good transition links two clips together seamlessly; the motion through the transition should appear natural, as though the motion was captured as one long motion sequence. Like an AB roll transition in video editing, an appropriate section in both clips is selected for the transition (dissolve) from the source clip to the destination clip. Velocity differences between the source and destination clips are matched during the period of transition producing a seamless result. By default, Minimum Motion Loss is used to find likely start frames in the source and destination clips when clips are appended to a script. Optimized transitions can be computed by using Optimize Transition in the upper right-hand corner of the Transition Editor dialog. Optimized transitions use a minimum foot sliding method to compute transitions. Optimized transitions take longer to compute, but produces very smooth motions.

Although only one arrow is used to represent a transition between two clips in the Motion Flow Graph, any number of transitions can be named and stored in the Transition Editor representing that transition. If, for example, you create 5 different transitions between two clips for one script, all of these transitions are available in a new script that uses the same two clips. Think of Motion Flow Graph as a data storage area; if all of the scripts are deleted, the transitions are preserved and can be stored in an MFE file.

Automatic Transitions

When you create a script, default transitions are used between the clips. Default transitions use minimum motion loss and are quick to compute. However, the best quality transitions are the optimized transitions. Once the Transition Editor is open, the first thing to try, before manual editing, are the optimized transitions (upper-right corner of the dialog).
**Length (Transition Duration)**

Set the duration of a transition in the Length field. A value of 10, for example, creates a transition of 10 frames between the source and destination clips. During the period of transition, the velocity of the source clip is interpolated to the velocity of the destination clip. If the transition takes place at the last frame of the source clip and the first frame of the destination clip, and Length is set to 10, then the last frame of the source clip is interpolated with the first 10 frames of the destination clip.

**Editing Transitions Manually (Ghosts)**

Manually setting the Start Frame for the source and destination clips offers the most control. Unwanted motion in either clip can be avoided and judging the best Start Frames for both clips is left to you.

The Ghost area Frame spinners allow you to view and scrub the source and destination clips by displaying stick figures (ghosts); yellow and red stick figures represent the source and destination clips. When a suitable Start Frame is located for both clips, use Set Start Frame in the Ghost area to copy the Frame values to the Start Frame fields in the Source and Destination Clip areas.

Scrubbing the time slider over the transition period enables you to view the biped's transition from the yellow stick figure (source) to the red stick figure (destination).

**Other Transition Editor Features**

Rolling and Fixed specify whether a clip is rolling (in motion) or fixed (single frame) during the transition. Change the direction of the destination clip using the Angle field.

Other parameters in the Transition Editor allow you to create and name new transitions, scroll through the saved transitions, jump to the transition-starting frame, set automatic transition parameters, and go to the next transition in the script.

You can save all transitions and their attributes in an MFE file.

See Customizing Transitions on page 4865 to manually and automatically customize transitions.
Interface

Length Sets the number of frames for the duration of the transition. Transitions are calculated by matching velocities in both clips. Smooth out abrupt velocity changes using longer transitions.

Ease In Ease-in value for the source clip.

Ease Out Ease-out value for the destination clip.

Transition Focus Lets you specify a focus point on the biped where the transition takes place. The Mixer will attempt to match movement based on this selection. For example, if Left Foot is selected, the transition will use the left foot as a focal point during the transition, aligning the motion of the left foot in both clips as much as possible during the transition. Default=Auto.

- Auto The transition focus is calculated by averaging the overall position of the biped as it transitions from one clip to the next.
Center Of Mass  The transition focus is based on the center of mass position of the biped as it transitions from one clip to the next.

Left Foot  The transition focus is based on the left foot position of the biped as it transitions from one clip to the next.

Right Foot  The transition focus is based on the right foot position of the biped as it transitions from one clip to the next.

Both Feet  The transition focus is based on an averaged foot position of both of the biped's feet as it transitions from one clip to the next.

NOTE  The best way to see the differences between the transition foci is by watching the yellow and red ghosts.

Angle  Sets the direction of the destination clip.
The angle of the destination clip is automatically set for best body fit between the two clips when the Start Frame values change. Use Angle to change the direction of the destination clip.

Probability  Set a probability value for random transitions. This is used by Create Random Motion when a random script is generated.

Previous/Next Transition buttons, Start Frame controls, and Optimize button

Previous Transition  Go to the previous transition in the transition track.
Displays the previous transition in the Transition Editor, moves the time slider to the start frame of the previous transition and highlights the previous clip in the transition track.

Next Transition  Go to the next transition in the transition track.
Displays the next transition in the Transition Editor, moves the time slider to the start frame of the next transition and highlights the next clip in the Scripts list.

**Start Frame** This text field displays the number of the first frame of the transition.

![Go To Start Frame](image) **Go To Start Frame** Moves the time slider to the first frame of the transition.

![Optimize Transition](image) **Optimize Transition** Displays the Transition Optimization dialog on page 4079.

Options in the Transition Optimization dialog allow you to search for the range over which the optimizer searches for the transition.

### Source Clip and Destination Clip groups

<table>
<thead>
<tr>
<th>Source Clip</th>
<th>Destination Clip</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 - 38</td>
<td>0 - 18</td>
</tr>
<tr>
<td>Start: 32</td>
<td>Start: -17</td>
</tr>
</tbody>
</table>

- **Clip range** This text field displays the range of the source or destination clip. The ranges are relative to the clip itself, not to the frame range of the full animation.

- **Start Frame** Sets the transition start frame for the source or destination clip. The start frame is relative to the clip itself, not to the frame range of the full animation.

- **Transition options** These choices control how the transition is interpolated.
  - **Rolling** Retains the clip motion during the transition.
  - **Fixed** For the source clip, this option freezes the biped at the Start Frame position during the transition. For the destination clip, this option freezes the biped at the End Frame position. If Fixed is chosen for both the source and destination clips, the transition is a gradual interpolation from one frozen pose to another.
Ghost subgroups (Source and Destination clips)

The Ghost group Frame spinners allow you to view and scrub the source and destination clips by displaying stick figures (ghosts); yellow and red stick figures represent the source and destination clips. The source and destination bipeds might not be near each other during this scrubbing process; the destination clip will be repositioned when you click Set Start Frame is clicked. When you locate a suitable start frame, click Set Start Frame to copy the values in the Frame field to the Start Frame field. Monitor foot position status in the field provided.

Set Start Frame

Copy the value in the Frame field of the Ghost area to the Start Frame field in the Clip area. The position of the destination clip changes to match the biped body in the destination clip to the biped body in the source clip.

Locate an appropriate start frame for the source and destination clips by using the Frame spinner and viewing the positions of both stick figures, then click Set Start Frame.
The destination clip is rotated and positioned to match both bipeds. Use the Angle spinner to reorient the destination clip.

**Frame** Use the Frame spinner to scrub a stick figure back and forth, which allows you to determine a start frame for the source and destination clips. Visual feedback of the stick figures is a good way to judge which start frames are needed for the source and destination clips.

**Playback group**

These controls let you play back the transition from the Transition Editor dialog.

![Play Transition](image)

**Play Transition** Click to play the transition. Click again to stop playback.

**Speed** Chooses the playback speed.
- **1/4 x** Plays at one-quarter of real time.
- **1/2 x** Plays at half real time.
- **1 x** (The default.) Plays at real time (full speed).

**Frames Before/After** Set the number of frames to play before and after the transition period.

**Selected Only** When on, plays back only the selected biped. Default=off.

**Play Ghosts** When on, shows transition ghosts during playback. Default=off.
Create Transition Click to create a new transition. The transition number field increments. Any number of transitions can be stored.

NOTE Clicking OK saves the displayed transition. Create Transition is used only if you want to work on a new transition.

Delete Transition Click to delete a transition.

Previous Transition Go to the previous stored transition. This button is grayed if no previous transition exists.

Next Transition Go to the next stored transition. This button is grayed if no next transition exists.

Active transition Displays the number of the transition that is currently active.

Name field In this field, you can enter a name or a comment for the current transition. On the Motion Flow rollout, the text you enter here appears to the right of the original clip name.

OK Store transitions and exit the dialog.

Create Random Motion Dialog

Select a biped. > Motion panel > Motion Flow Mode > Motion Flow rollout > Scripts group > Create Random Motion > Create Random Motion dialog

You can randomly traverse clips in a motion flow graph to animate one or more bipeds using controls in the Create Random Motion dialog. Parameters for random motion are set in the Motion Flow Graph, in the clip and transition dialogs, as well as in the Create Random Motion dialog.

Random motion is created by first adding clips to the Motion Flow Graph window and adding transitions between the clips. Clips and transitions are then given percentages, which are used to create random motion for one or more bipeds. You can manually control the “weighting” for possible start clip,
.transitions, and frame range. This allows you to animate multiple bipeds in a crowd scene, for example. A different script is created for each biped.

If you want to create random motion for multiple bipeds, they must be sharing a motion flow. For more information about using random motions and transitions, refer to Creating Random Motion on page 4868.

Interface

**Create Random Motion**

- **Script Name** Type a name for the script to be generated.
- **Random Start Range** Set the start and end frame range over which the new script(s) will start.
- **Minimum Animation Length** Set the minimum animation length.

When a random motion is created, it is done by making a motion flow script which traverses the clips in the Motion Flow Graph, adding clips based on random calculations. It will add clips until the length of the script is greater than or equal to the minimum animation length, specified here.

- **first clip in script** Gets the start position and rotation from the first clip.

**Create Random Motion**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Script Name</td>
<td>Type a name for the script to be generated.</td>
</tr>
<tr>
<td>Random Start Range</td>
<td>Set the start and end frame range over which the new script(s) will start.</td>
</tr>
<tr>
<td>Minimum Animation Length</td>
<td>Set the minimum animation length.</td>
</tr>
<tr>
<td>Store as bip file</td>
<td>Store the motion flow script as a bip file.</td>
</tr>
<tr>
<td>File Name</td>
<td>Specify the file name.</td>
</tr>
<tr>
<td>Directory</td>
<td>Specify the directory.</td>
</tr>
<tr>
<td>Create</td>
<td>Create the random motion script.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Cancel the creation of the random motion script.</td>
</tr>
</tbody>
</table>

4908 | Chapter 15  character studio
**biped's current position/rotation** Uses the biped’s current position to start the script.

**Create motion flow script** Creates a script after computing the motion.
If this is on, a motion flow script will be created. If not, a script will still be created internally in order to generate the random motion, but it will be deleted after the random motion is generated.

**Append to existing script** Appends random motion to the existing script.

**Create unified motion** Creates a unified motion. The generated motion will be available when you exit Motion Flow mode.
If multiple bipeds are in the random calculation, then the motion is unified for each biped.

**Store as .bip file** Stores the random motion as a BIP file.
If multiple bipeds are in the random calculation, they are saved separately with incrementing numbers.

**File Name** Type a name for the BIP file.
The **.bip** extension is added automatically.

**Directory** Type a directory path or browse for the path.

**Browse** Browse to a directory.

**Create motion for all bipeds sharing this motion flow** Turn on to create a random script for each biped sharing the current biped’s motion flow.
You can create a shared motion flow by using the Shared Motion Flow command on the Motion Flow rollout and adding bipeds in the Shared Motion Flow dialog.

**Create** Creates random motion for the selected biped or all the bipeds in the shared motion flow.

**Cancel** Cancel and close the dialog.

---

**Shared Motion Flow Dialog**

Select a biped. > Motion panel > Biped rollout > Motion Flow Mode > Motion Flow rollout > Shared Motion Flow > Shared Motion Flow Dialog
Controls in the Shared Motion Flow dialog allow you to assign one motion flow to multiple bipeds. Instead of choreographing a motion flow script for individual bipeds, you can create a motion flow with all the clips and transitions to create a script to animate multiple bipeds.

Random motion creation will use each bipeds' own motion flow. If a biped's motion flow happens to be a shared motion flow, then the shared motion flow will be used to compute random motion.

A biped that shares a motion flow shares only the graph. Its scripts are unique to that biped, although the scripts point to the clips of the shared motion flow. You can manipulate that biped's motion flow and scripts. You can create random motion on a biped that shares a motion flow, or create a motion flow script via the crowd system.

A white circle around the Shared Motion Flow icon indicates that a biped is using a shared motion flow. If you edit that biped's motion flow graph, the title of the graph dialog will say "Shared Motion Flow Graph", followed by the name of the shared motion flow.

Bipeds in a shared motion flow should have the same lower body scale and structure. Adaptation for differently sized bipeds does not occur in a shared motion flow. If you want differently sized bipeds in a crowd, then create a shared motion flow for each size.

See Sharing Motion Flow on page 4876 for more details about setting up a shared motion flow.
**Interface**

**Shared Motion Flows list** Lists shared motion flows.

**New** Creates a new shared motion flow.

**Delete** Deletes the current shared motion flow.
The scripts of the bipeds sharing the deleted motion flow will be deleted. Those bipeds will have an empty motion flow graph and no scripts.

**Load** Loads a shared motion flow (SMF) file.
This file is created with the Save command (see following). The file contains the shared motion flow graph as well as the scripts for all bipeds sharing the motion flow.

Save Saves a shared motion flow (SMF) file. The file contains the shared motion flow graph as well as the scripts for all bipeds sharing the motion flow.

Use this facility to speed biped/crowd-simulation setup. Create and refine the crowd simulation with bipeds that don't use Physique, save the shared motion flow, load or create your final crowd members that use Physique, and then load the shared motion flow. For a procedure, see To apply a shared motion flow to a different group of bipeds: on page 4882.

Load .mfe Displays a load file dialog. Load an MFE file into the shared motion flow.

NOTE If you load a N MFE file, via the Motion Flow rollout, into a biped using a shared motion flow, you will get a warning and the biped will be removed from the shared motion flow. The biped will get the newly loaded motion flow and all its scripts. The shared motion flow will remain the same.

Bipeds Sharing this Motion Flow list Lists the bipeds that share this motion flow.

Add Displays a dialog where you can choose bipeds to add to the motion flow list.

Add bipeds to the list of bipeds that share a motion flow. When you add a biped, its current motion flow graph and motion flow scripts will be deleted. It will now have the shared motion flow graph. A biped can only share one motion flow graph. You must remove a biped from its shared motion flow in order to add it to a different shared motion flow.

Remove Removes the selected bipeds in the list from the current shared motion flow.

These bipeds' scripts will be deleted. They will have an empty motion flow graph.

Put Multiple Bipeds in Motion Flow Put the bipeds in the list into Motion Flow mode.

The crowd system needs Motion Flow mode to be turned on to perform calculations for motion. This is a convenient way of turning on Motion Flow mode for multiple bipeds.
Take Multiple Bipeds out of Motion Flow  Take the bipeds in the list out of Motion Flow mode.

Set Shared Moflow Leg Scale  Adapts the shared motion flow to the scale of the biped currently selected in the list. After this operation, the selected biped will have the correct leg scale, although other bipeds may not.

Reset Wrong Scales Just Legs:  Reset the leg scale only of the bipeds that have the wrong scale, so that they adapt appropriately to the shared motion flow.

Reset Wrong Scales Entire Figure:  Resets the entire figure structure of the bipeds that have the wrong scale, to match the figure structure of the correctly scaled biped.

When you add the first biped to the shared motion flow, the system adapts to the size of that biped. If the leg scale of a biped you add subsequently doesn't match that of the first biped, it will be marked in the list with "wrong scale" after it.

All the bipeds you plan on using in a shared motion flow must have the same lower body structure and scale.

Transition Optimization Dialog

Motion Flow Mode > Motion Flow Graph > Select transitions in the graph window. > Optimize Selected Transitions > Transition Optimization dialog

Motion Flow Mode > Motion Flow rollout > Scripts group > Select a clip in the Script list. > Edit Transition > Optimize Transition > Transition Optimization dialog

Options in the Transition Optimization dialog allow you to select the range over which the optimize algorithm will search for the transition. It can search either the whole clip, or it can search near the existing transition. You must specify the preferred length of the optimized transition. character studio will try to get as close to that length as possible, still opting to give you the best length.

If it searches about the existing transition, you must specify the number of frames about which it will search before and after the existing transition.

Optimized transitions compute for minimum foot sliding over the range of the transition. This method yields very high quality results.
Interface

Preferred Transition Length Specify the length of the optimized transition.

Search Entire Clip Search the entire clip for an optimized transition start frame.

Search Near Existing Transition Create an optimized transition near the existing transition. You may search the range about the existing transitions by setting before and after frame values.

Clip Properties Dialog

Motion Flow Mode > Motion Flow Graph > Right-click a clip in the Motion Flow Graph window. > Clip Properties dialog

Motion Flow Mode > Motion Flow script rollout > Select a clip in the list. > Edit Clip > Clip Properties dialog

Parameters in the Clip Properties dialog allow you to browse for a clip, set a start and end frame for the clip and set a random start probability for the clip. Random start probability is used when you use Create Random Motion to generate a random script for a biped.
Interface

Clip Name The clip name as it appears in the Motion Flow Graph.

File Name The path and file name of the motion clip.

Length The length of the clip in frames.


Set lowest starting foot height to Z=0 (.bip files only) Sets the lowest starting foot height to Z=0. This is an option in the Load File dialog. Default=On.

In character studio the height of a motion clip can be retained. This is important if you want to retain the height of a motion clip for motions adapted to characters of different sizes. If, for example, the character is jumping off a rock and you want to retain the Z position of the character, you would turn this option off. Leave this option off if Motion Flow motions must be blended that begin and end at different heights, such as three clips that have the character mounting a bicycle, riding the bicycle, and dismounting the bicycle.

Turning off this option can, however, cause a jump in the motion during motion flow transitions. Turn this on for smooth transitions in Motion Flow mode. If adaptation takes place, the height is set so that the lowest foot at frame 0 starts at the Z=0 height. This lines up clips along the Z axis and creates smooth transitions.

Start Frame Sets the start frame for the clip.

End Frame Sets the end frame for the clip.

Active Activates the clip. Inactive clips display as a green color in the Motion Flow Graph.
Random Start Probability Set a percentage for random start probability. This is used when multiple clips are selected as possible starting clips in a random motion flow. The Create Random Motion command allows you to generate random motion for one or more bipeds.

Working with Motion-Capture Data

Motion capture is the practice of getting motion data from live actors performing various actions. The motion data is captured (retrieved) via sensors placed at the actors' joints and extremities.

3ds Max does not perform motion capture, but it accepts motion-capture data in the most commonly used formats. This data can be imported to the biped and used as is, or combined with other motions with Motion Flow on page 4848 or the Motion Mixer on page 4002.

Motion-capture data typically needs some adjustment before it fits your biped or animation perfectly. When motion-capture data is imported to 3ds Max, it can be filtered to:

- Use fewer keyframes
- Create footstep motion
- Use props in the scene

In addition, some motion-capture files come with a separate marker file, which can be used to match the biped posture to the motion-capture actor.

How Motion-Capture Data is Acquired

Motion-capture data is typically acquired by one of several means:

- Optical sensing technology
  Optical systems have become quite popular over the last couple of years. These systems can offer the performer the most freedom of movement since they do not require any cabling. Optical systems incorporate directionally reflective balls, referred to as markers on page 8632, that attach to the performer. Optical systems require at least three video cameras, each of which is equipped with a light source that is aligned to illuminate the field of view for that camera. Each camera is in turn connected to a synchronized frame buffer. The computer is presented with each camera view in order to calculate a 3D position of each marker; the resulting data
stream therefore consists of 3D position data for each marker. This data is typically applied to an inverse kinematics system, to animate a skeleton.

- **Electro-magnetic sensing technology**
  This is a popular method used for performance capture. Magnetic capture involves the use of a centrally located transmitter, and a set of receivers that are strapped on to various parts of the performer’s body. These receivers are capable of measuring their spatial relationship to the transmitter. Each receiver is connected to an interface that can be synchronized to prevent data skew. The resulting data stream consists of 3D positions and orientations for each receiver. This data is typically applied to an inverse kinematics system to drive an animated skeleton. This magnetic approach shares the same lack of occlusion problems with the audio method, but it also shares the same negative factors, such as the hindrance of cables, lack of sufficient receivers, and the limited capture area. In addition, being magnetic, the system is affected by any sizable areas of metal in the vicinity of the capture area, such as girders, posts, and so on.

- **Prosthetic sensing technology**
  This is one of the early methods for capturing the motion from various parts of human anatomy. These methods include simple “on/off” type of motion-detection systems as well as complex motion-tracking systems. The latter type of prosthetic motion capture would be an ideal approach if it weren’t for the complex mechanical requirements and the performance-inhibiting qualities generally associated with such designs. However, the type of data provided can be clean, rotational data collected in real time without any occlusion problems. This method is based on a set of armatures that must be attached all over the performer’s body. The armatures are then connected to each other by using a series of rotational and linear encoders. These encoders are then connected to an interface that can simultaneously read all the encoders in order to prevent data skewing. Finally, through a set of trigonometry functions, the performer’s motion can be analyzed. These design restrictions seem to be quite difficult to overcome, and will probably limit the use of this type of device for character animation.

- **Acoustic sensing technology**
  Acoustic capture is another method currently used for performance capture. This method involves the use of a triad of audio receivers. An array of audio transmitters are strapped to various parts of the performer’s body. The transmitters are sequentially triggered to output a “click” and each receiver measures the time it takes for the sound to travel from each transmitter. The calculated distance of the three receivers is triangulated to provide a point in 3D space. An inherent issue with this approach is the sequential
nature of the position data it creates. In general, one would like to see a "snap shot" of the performer's skeletal position rather than a time-skewed data stream. This position data is typically applied to an inverse kinematics system, which in turn drives an animated skeleton.

Importing Motion-Capture Data

In character studio, you can import both rotation and position type motion-capture files.

- BioVision (.bvh) files contain limb and joint rotation data.
- character studio marker files (.csm) contain raw marker position data generated by a motion-capture device: markers are attached to an actor during a motion-capture performance. Marker files typically require some calibration. If necessary, the biped is sized to fit the markers first, then the biped limbs are oriented to align them to the markers. Marker files should be loaded with keys at every frame and no footstep extraction; this is required for calibration, and also enables the calibration controls. Calibration controls are the second row of buttons on the Motion Capture rollout.

In character studio, the .csm marker file format supports a prop bone in either or both hands. See Prop Bone on page 4924.

Key reduction, track selection, footstep extraction, and clip looping are some of the options available using the Motion Capture import filter. Key reduction makes it easy to manipulate the biped and personalize the imported motion-capture data. Extracting footstep from motion-capture data prevents inappropriate sliding feet, which are a common problem with motion-capture data.

Typically you do not use an entire motion-capture clip as is, unless you capture motions at a studio for your own production. You should become familiar with the body motion in the files you have, then use Motion Flow mode to cut portions of these files together to create animation. For example, take a stretch motion in one clip, and combine it with the walking motion in another clip. You can then save the edited script as a BIP file using the Save Segment command on the Biped rollout. Load this BIP file for standard motion editing. This provides a good starting place for you to edit the result to your liking.

All motion-capture controls are on the Motion Capture rollout on page 4925.
Filtering Motion-Capture and Marker Data

Select a Biped. > Motion panel > Motion Capture rollout > Click Load Motion Capture File.

Motion-capture and marker data typically have keys at every frame. Filtering motion-capture data reduces keys, simplifying the job of altering or personalizing the motion data.

Biped lets you filter the data of each track with its own filtering settings, so you have control over which nuances of motion you want to pick up without filling the rest of the tracks with unwanted keys. Filtering is done using the Motion Capture Conversion Parameters rollout.

Other filtering options include footstep filtering and extraction, looping the data, and importing a portion of the motion-capture file.

3ds Max ships with a variety of raw (unfiltered) motion-capture data files, in BIP, CSM, and BVH formats. Some of the same data is available in filtered versions, either with footsteps or freeform. Try your own filtering adjustments on the raw versions of this data. Importing the raw data displays the original motion very accurately when you select Show Buffer on the Motion Capture rollout. Use the Motion Capture buffer as a guide when adjusting and refining the filtered data. Several tools are available in the Motion Capture rollout to aid you in this process.

Create your own library of imported and optimized motion capture data by saving BIP files for use with other characters, or as part of a longer script in Motion Flow mode. Use a biped that has no mesh attached with Physique.

TIP Overall, you import the data, adjust it to your liking, and save it as a BIP file. You can also run standard BIP files through this filtering process to create loops or to extract footsteps from a freeform animation.

NOTE Marker files, such as CSM, contain position data. Hierarchical motion-capture files, such as BVH, contain joint rotation data.
Character Studio Marker Files

The *csm on page 8543* format is an ASCII file used to import positional marker data from motion-capture systems onto a biped.
The Show Markers command displays marker positions and names.

Procedures

To import a motion capture file:

1 Select a biped in the viewports.

2 On the Motion Capture rollout, click Load Motion Capture File.

3 Choose the file type: BVH, BIP, or CSM. Search for files in the `cstudio\motions\mocap` directories.

   **TIP** CSM marker files, loaded for the first time, should be imported with no key reduction and no footstep extraction. This enables the calibration buttons. Marker files typically need some calibration.

4 Select a file and click Open.

   The Motion Capture Conversion Parameters dialog displays (see Motion Capture Conversion Parameters Dialog on page 4934).

5 Select the filter options you want and click OK.

   The biped adapts itself to the motion data. If Footstep Extraction is turned on, footsteps appear.

   **TIP** Use a biped that does not have a mesh attached with Physique. Import motion-capture data with the idea of then saving a BIP file that can be used for any character. If skeletal scale information is loaded from a motion-capture file, a mesh with a Physique modifier might deform unnaturally.

To import a marker file:

Typically, when a marker file is loaded for the first time, it requires scale and position calibration. A raw marker file must be loaded, with no key reduction or footstep extraction, to enable the calibration functions. After calibration is performed, use Convert From Buffer to extract footsteps and reduce keys.

1 Select a biped.

2 On the Motion Capture rollout, click Load Marker Name File to load a marker name file (.mnm).
This step is not required if the marker names in the marker file adhere to the Biped marker naming convention.

3 On the Marker Name File dialog, click Load CSM Marker File, and choose the MNM file from the file open dialog that appears.

4 On the Motion Capture rollout, click Load Motion Capture File and choose a CSM marker file. The Motion Capture Conversion Parameters dialog displays (see Motion Capture Conversion Parameters Dialog on page 4934).

5 Adjust the filter parameters and click OK.

**NOTE** Load raw marker data (No Key Reduction, Freeform) to enable the marker calibration buttons.

The biped adapts itself to the marker data.

6 On the Motion Capture rollout, click Show Markers. On the Marker Display dialog, turn on Show Recognized Markers and the option for On All Objects.

7 Now, on the Motion Capture rollout, click Talent Figure Mode. Use Non-Uniform Scale or Rubber Band Mode (on the Biped rollout) to size the biped to the displayed markers.

**NOTE** This step is optional and should be used if you need to correct for slight differences in limb scale between the original talent who performed the motion and the scale of the biped after the data is imported. For example, if the leg is too short, scale the length of the leg in Talent Figure mode to adjust the knee position.

8 Click Talent Figure Mode again to exit the mode.

9 Key adaptation takes place when you exit Talent Figure mode. Now biped limb positions relative to the markers can be adjusted.

10 Align the biped limbs to the markers if necessary, then click Adjust Talent Pose to compute the offset for the entire animation.
11  Use Save Talent Figure Structure and Save Talent Pose Adjustment as a FIG and CAL file.

12  Load these files in the Motion Capture Conversion Parameters dialog when similar marker files are imported in the future.

At this point, you can use Convert From Buffer to extract footsteps and reduce keyframes. Both scale and position adjustments will be incorporated. Save the motion as an optimized BIP file.

**Sliding Footsteps**

Motion-capture and marker data typically have keys at every frame. Filtering motion-capture data reduces keys, making the job of altering or personalizing the motion data much simpler. You can create your own library of imported and optimized motion-capture data by saving BIP files for use with other characters or as part of a longer script in Motion Flow mode. Use a biped that has no mesh attached to it with Physique. You import the data, adjust it to your liking, and save it as a BIP file. You can also run standard BIP files through this filtering process to create loops or to extract footsteps from a freeform animation.

**Motion Capture Import**

Footstep motion capture is enabled automatically when importing motion capture data using the Sliding Tolerance and Sliding Angle controls in the Motion Capture Conversion Parameters dialog on page 4934.

**Footstep Extraction group**

The following options are active when Footstep Extraction is on during motion capture conversion.

**Extraction Tolerance** Sets the sensitivity of footstep extraction. Biped determines if the footstep is there by checking that the foot does not move beyond the distance determined by the Extraction Tolerance value. Smaller numbers are more sensitive and extract more footstep. The value is a percentage of foot length.

The default value is 0.15. Increase this value to 0.2 or 0.25 if too many footsteps are generated.
**Sliding Distance** Creates a sliding footstep when positional tolerance is reached. This value is a percentage of foot length. By default the foot must slide its own distance (100), before a sliding footstep is created. Use this with motion-capture files that contain sliding feet. A sliding footstep can be created manually by setting IK Blend > 0 for a biped foot at a "touch" state key (biped foot first touches a footstep).

**NOTE** Sliding footsteps display as a footstep with a line through the center.

**Sliding Angle** Creates a sliding footstep when rotational tolerance is reached. This value is in degrees. The default is set high (360 degrees), the foot must make a complete turn before a sliding footstep is created. Use this with motion-capture files that contain feet that pivot, as in a dance motion.

**NOTE** Sliding footsteps display as a footstep with a line through the center.

**Only Extract Footsteps Within Tolerance** Turns on Z-axis Tolerance. These controls filter out footsteps that do not fall within a given range of the ground plane. Use this when filtering motions, such as hopping or pitching a baseball, in which a foot might come off the ground and remain stationary, but its position is not intended as a footstep.

- **Tolerance** Value is a percentage of leg length.
- **From Z Level** Set a Z value (ground).

**Flatten Footsteps to Z=0** Moves extracted footsteps to Z=0. Use this to flatten out minor differences in the height of the extracted footsteps.

**Prop Bone**

In 3ds Max, the CSM marker file format supports a prop bone in either or both hands (left, right, or middle). There are nine additional markers for the top, bottom, and middle of the three prop types. If character studio detects these tracks, it creates a dummy helper on page 2840 object.
The length of the prop is the average distance between the top and bottom prop marker during animation. The prop will be oriented in the plane of the three prop markers, and its origin will be at the bottom prop marker.

The dummies are named bip01prop, bip02prop, and so on. If a prop of that name already exists, its animation and size is reset upon loading the CSM file. The Marker Display dialog contains a check box for toggling display of the prop markers. The prop track names are LPRPB, LPRPM, LPRPT, MPRPB, MPRPM, MPRPT, RPRPB, RPRPM, and RPRPT. These stand, respectively, for left prop bottom, left prop middle, left prop top, middle prop bottom, middle prop middle, middle prop top, right prop bottom, right prop middle, and right prop top. You can change the track names by editing the MNM file.

The props don't necessarily have a relation to the left and right hands. For example, a prop could be a hat.

**Motion Capture Rollout**

Create or select a biped. > Motion panel > Motion Capture rollout

The tools on the Motion Capture rollout on the Motion panel are typically used for working with raw motion-capture data. You can also load standard BIP files using Load Motion Capture File. For example, you might do this if you want to loop the motion.
This rollout includes tools for:

- Batch conversion of motion-capture files.
- Converting the motion-capture file stored in the motion capture buffer.
- Pasting one frame of motion-capture data from memory to selected biped limbs.
- Displaying raw motion-capture data as a stick figure.
- Displaying raw motion-capture trajectories.

The buttons in the bottom row are used mainly with marker files, although the calibration controls also work with raw BVH files. Import, calibrate, and filter marker files (CSM) using tools on the Motion Capture rollout. Markers are placed on an actor during motion capture to identify joints; calibration lets you adjust the biped relative to the original marker positions if necessary. Load only raw marker files with no key reduction or footsteps to enable marker calibration controls.

**NOTE** For BVH and CSM file specifications, see the BVH.rtf and CSM.rtf documents on the program disc.

### Motion-Capture Buffer

Raw motion data is automatically stored in the motion-capture buffer when files (CSM, BVH, and BIP) are loaded using Load Motion Capture File on page 4930. This buffered raw motion data is independent of the biped motion in your scene, and can be used in various ways:

- Use Convert From Buffer on page 4931 to try alternate filter settings quickly; this saves you from having to browse for the same file.

- After importing a BVH or BIP file using footstep extraction and key reduction, you can use Paste From Buffer on page 4931 on selected biped limbs (and COM) to paste keys from the raw motion-capture data to the filtered data; do this if critical motion has been lost in the filtering process.

- If you specify Load Buffer Only in the Motion Capture Conversion Parameters dialog on page 4934, the motion file is loaded into the motion-capture buffer without altering the biped animation. Use this to paste posture and limb keys from any file onto the biped animation in your scene.
When you load a motion-capture file, the motion-capture buffer is loaded with motion-capture data from that file. This buffer is altered during calibration. It is also used to show the motion-capture markers and trajectories.

Internally, there is only one motion-capture buffer. It is often large, so its contents are not saved before a file load or a calibration. Therefore, if you undo a motion-capture file load, the contents of the motion-capture buffer do not change. That’s why you’ll still see old markers and trajectories. It is not possible to undo calibration.

**Marker Files**

Unlike a BIP or BVH file that contains limb rotation data, a CSM marker file on page 8632 contains only marker position data. When a raw marker file is imported, only marker position data is buffered in the motion-capture buffer. 3ds Max uses the marker data to extract limb rotation data to position the biped. After using the calibration controls on the Motion Capture rollout to correct biped scale and posture relative to the markers, use Convert From Buffer on page 4931 to filter the raw marker data to key reduce and extract footsteps.

**NOTE** A CSM marker file is an ASCII file.

See also:

- Importing Motion-Capture Data on page 4918
- Marker Files on page 8632

**Procedures**

**To use Convert From Buffer:**

A motion-capture file should already be in memory. Use Load Motion Capture File on the Motion Capture rollout to import a motion-capture file if one is not already be in memory.

1. Select a biped.

2. On the Motion Capture rollout, click Convert From Buffer to display the Motion Capture Conversion Parameters dialog.

3. Adjust parameters, then click OK.
To compare raw and filtered trajectories:

1. Select a biped and turn on Show Buffer Trajectory on the Motion Capture rollout.

2. Click Trajectories on the Display rollout.
   As you select various biped parts, two trajectories are displayed. The yellow trajectory represents raw motion capture data in the motion capture buffer; the purple trajectory represents the filtered data.

To use Show Buffer:

1. Create a biped.

2. Use Load Motion Capture File on the Motion Capture rollout to import a motion-capture file.

3. Turn on Show Buffer on the Motion Capture rollout.
   A red stick figure appears, representing the raw motion-capture data.
   Play the animation; the animation of the biped representing filtered motion-capture data and the red stick figure play back together.

TIP For a very accurate visual comparison between raw motion capture data and filtered data, toggle Show/Hide Objects on the Display rollout to hide the biped. Toggle Show/Hide Bones in the same rollout to display only biped bones (the yellow stick figure), then play the animation with Show Buffer turned on. The two stick figures move together, and any discrepancies are easily spotted. To learn how to use Show Buffer with the Fit To Existing parameter in Motion Capture Conversion Parameters rollout, see To use Fit To Existing to import a motion capture file on page 4935.

To import a motion-capture file:

1. Select a biped.

2. If necessary, click Load Marker Name File on the Motion Capture rollout (see MNM Files on page 8640).

   NOTE This step is not required if the marker or joint names in the motion-capture file adhere to the character studio marker naming convention.
3 Click Load Motion Capture File. The Open dialog opens.

4 Choose a file type: BVH, BIP, or CSM.

5 Select a file and click Open. The Motion Capture Conversion Parameters dialog on page 4934 displays.

6 Select the filter options you want, and click OK. The biped adapts itself to the motion data. If Footstep Extraction is turned on, footsteps appear.

**NOTE** Load raw marker data (No Key Reduction, Freeform) to enable the marker calibration buttons.

**TIP** Use a biped that does not have a mesh attached to it with Physique. Import motion-capture data with the idea of then saving a BIP file that can be used for any character. If skeletal scale information is loaded from a motion-capture file, a mesh with the Physique modifier applied might deform unnaturally.

7 If a marker file was loaded, turn on Show Markers as a visual aid for biped scale and limb correction. If correction is necessary, adjust biped scale first. Keyframe adaptation takes place in order to accommodate a biped scale change. The remaining steps in this procedure are optional, unless you need to calibrate motion-capture files.

8 Click Talent Figure Mode and use Non-Uniform Scale or Rubber Band Mode (on the Biped rollout) to size the biped to the displayed markers.

9 Click Talent Figure Mode again to exit the mode. Key Adaptation takes place when you exit Talent Figure mode. Now, biped limb positions relative to the markers can be adjusted.

10 Align the biped limbs to the markers, if necessary, and then click Adjust Talent Pose to compute the offset for the entire animation.

11 Use Save Talent Figure Structure and Save Talent Pose Adjustment to save a size and position offset to a FIG and a CAL file, respectively. Load these files in the Motion Capture Conversion Parameters dialog when you import similar marker files in the future.
At this point, you can use Convert From Buffer to extract footsteps and reduce keyframes. Both scale and position adjustments will be incorporated. Save the motion as an optimized BIP file.

Interface

Load Motion Capture File Key reduce and extract footsteps from raw motion-capture data. Load BIP, CSM, or BVH files. After you open a file, the Motion Capture Conversion Parameters dialog on page 4934 opens. Following are descriptions of settings in the Open dialog.

Files of type

- **BIP** Filters the raw version of the motion-capture data that ships with 3ds Max. These are in a BIP format. Filter standard BIP files to convert footstep animation to a freeform animation; extract footsteps from a freeform animation; and to loop a BIP file.

- **BVH** BioVision motion-capture data file. Contains the “actor’s” skeletal and motion information. Once the motion-capture data is filtered and adjusted, save it as a BIP file for later use.

- **CSM** Imports a character studio marker file (ASCII format file). Optionally, load a Marker Name file (MNM), a Talent Structure file (FIG), and a Talent Pose file (CAL) before loading a CSM file. Marker files should be loaded with no key reduction and no footstep extraction to enable the calibration controls.

Restructure biped to match file (BIP files only) Turn on to change the biped structure to match the structure stored in the BIP file. The file loads with the stored biped structure. This is an Open dialog option. This option is unavailable when you load a BIP file into a clip or onto a biped that is in Edit Clip mode, because all the clips in the motion flow would have to be adapted.
NOTE CSM and BVH files always load with the biped structure stored in the file.

Set lowest starting foot height to Z=0 (BIP files only) Sets the lowest starting foot height to Z=0. This is an Open dialog option. Default=on.

In 3ds Max, the height of a motion clip can be retained. This is important if you want to retain the height of a motion clip for motions adapted to characters of different sizes. If, for example, the character is jumping off a rock, and you want to retain the Z position of the character, you would turn this option off. Leave this option off if Motion Flow motions must be blended that begin and end at different heights, such as three clips that have the character mounting a bicycle, riding the bicycle, and dismounting the bicycle.

Turning off this option can, however, cause a jump in the motion during motion flow transitions. Turn this on for smooth transitions in Motion Flow mode. If adaptation takes place, the height is set so that the lowest foot at frame 0 starts at the Z=0 height. This lines up clips along the Z-axis and creates smooth transitions.

First load raw marker data and turn on Show Markers to help you decide if calibration is necessary. If both scale and position calibration are necessary, calibrate scale first (Talent Figure mode) and then calibrate limb position. 3ds Max adapts biped keys after biped scale is changed in Talent Figure mode. Orient the biped limbs relative to the markers and click Adjust Talent Pose to apply this offset to the entire animation. Save Talent Figure Structure and Talent Pose to a FIG and a CAL file, respectively. Load a FIG and a CAL before loading a marker file that requires the scale and position offsets contained in these files.

NOTE Calibration files can be loaded in the Motion Capture Conversion Parameters dialog before filtering marker files.

Convert from Buffer Filters the most recently loaded motion-capture data. This data is stored in the motion-capture buffer. Displays the Motion Capture Conversion Parameters dialog.

The most recently imported motion-capture file is stored in its raw form in the motion-capture buffer. Convert From Buffer provides a quick way to try new conversion parameters in the Motion Capture Conversion Parameters dialog.

Paste from Buffer Pastes a frame of raw motion-capture data to the selected parts of the biped.
After importing a motion-capture file, you might discover a subtle movement has been lost in the process of reducing keyframes. Paste From Buffer can add a keyframe from the raw motion-capture data to a selected biped body part to restore this motion. Turn on Auto Key before using Paste From Buffer, or click Set Key after using Paste From Buffer to store the new position in a key.

Show Buffer Displays raw motion-capture data as a red stick figure. Use Show Buffer to compare raw and filtered motion-capture data. Ideally, the motion of the biped and the red stick figure are very similar. If this is not the case, alter the filter parameters and import the motion-capture file again, or select a biped object and use Paste From Buffer at selected frames to restore the lost motion.

Raw motion-capture data is buffered for the currently loaded or most recently imported motion-capture file, allowing easy comparison of the raw and filtered motion data. Show Buffer displays a red stick figure representing the raw buffered data; compare this to the filtered motion of the biped during playback.

Show Buffer Trajectory Displays buffered raw motion-capture data as yellow trajectories for the selected biped body parts. Use Show Buffer Trajectory to display a trajectory based on the buffered raw motion-capture data for any biped body part. Use this in combination with Show/Hide Trajectories on the Display rollout to see how closely the raw and filtered data match.

This assumes a motion-capture file has been imported.

Batch File Conversion Converts one or more CSM or BVH motion-capture files to filtered BIP format. Displays the Motion Capture Batch File Conversion dialog on page 4943.

Talent Figure Mode After loading a raw marker file, turn on Talent Figure mode to scale the biped relative to the markers. Calibration for the entire marker file takes place when you exit Talent Figure mode.

Keyframe adaptation takes place in order to accommodate the new biped scale; because of this, you should adjust the biped scale before adjusting the biped position relative to the markers.

Use Rubber Band mode on the Biped rollout and Non-Uniform Scale to size the biped in Talent Figure mode.
Ideally, you will not need to use this feature. When loading a motion-capture file, 3ds Max attempts to extract the appropriate figure scale from the given data. Use Talent Figure mode only if the extracted scale of the biped doesn’t match the scale of the original talent. Even minor differences in scale will alter the motion.

**NOTE** Calibration controls are enabled only when a marker or BVH file is imported in its raw form. Do not use key reduction or extract footsteps when you import a marker file for the first time.

**Save Talent Figure Structure** After changing the biped scale in Talent Figure mode, you can store the changes into a FIG file. Use this file in the Motion Capture Conversion Parameters dialog to adjust marker files created by the same actor.

**Adjust Talent Pose** After loading a marker file, use Adjust Talent Pose to correct the biped position relative to the markers. Align the biped limbs to the markers, then click Adjust Talent Pose to compute this offset for all the loaded marker data.

**NOTE** Calibration controls are enabled only when a marker or BVH file is imported in its raw form. Do not use key reduction or extract footsteps when you import a marker file for the first time.

**Save Talent Pose Adjustment** Saves a Talent Pose adjustment as a CAL file.

Save a CAL file after adjusting the biped relative to the markers. A CAL file is used for processing marker files that require the same adjustment. A CAL file can be loaded in the Motion Capture Conversion Parameters dialog during marker file importation.

**Load Marker Name File** Loads a Marker Name (MNM) file to map incoming marker names in motion-capture files (BVH or CSM) to the character studio marker naming convention. Displays the Marker Name File dialog.

**Load a CSM marker file** Browses for a marker file for use with a CSM file.

**Load a BVH marker file** Browses for a marker file for use with a BVH file.

When a BVH file is loaded, checks for and reports unknown track names, but loads the file anyway. Reports if any required tracks were not in the file and if so aborts the file load.
Use Uses the marker name file when importing motion capture files
If necessary, load a Marker Name File before loading a BVH or CSM file. Marker Name files are bundled with Character Studio to map marker names in popular third-party marker files. Edit these ASCII files if the marker files you have use unique names for markers.

**NOTE** For BVH and CSM file specifications, see the BVH.rtf and CSM.rtf documents on the program disc.

**Show Markers** Opens the Marker Display dialog on page 4943, with settings for specifying how markers are displayed.
Marker and marker names are displayed around the biped. You can use these to spot and adjust discrepancies; for example, the biped elbow position relative to the elbow marker. For information on how to correct these discrepancies, see Talent Figure mode on page 4932 and Adjust Talent Pose on page 4933.

**Motion Capture Conversion Parameters Dialog**

Create or select a biped. > Motion panel > Motion Capture rollout > Load Motion Capture File button > Open a file. Load motion capture data. > Motion panel > Motion Capture rollout > Convert from Buffer button

Motion-capture and marker data typically have keys at every frame. Filtering motion-capture data reduces keys, making the job of altering or personalizing the motion data much simpler. Other filtering options include footstep extraction, applying the skeletal structure stored in the motion-capture file to the biped, looping the data, importing a portion of the motion-capture file, and selecting tracks to load.

**Motion-Capture Buffer**

Any file imported using Load Motion Capture File is stored in its raw (nonfiltered) form in the motion-capture buffer. This buffer is used to try new filtering options with the Convert From Buffer command, and to paste keys from the raw motion-capture data to the biped using Paste From Buffer on the Motion Capture rollout. The Show Buffer command displays a stick figure that represents the buffered data.

You can create your own library of imported and optimized motion-capture data by saving .bip files for use with other characters or as part of a longer script in Motion Flow mode. Use a biped that has no mesh attached to it with
Physique. You import the data, adjust it to your liking, and save it as a .bip file. You can also run standard .bip files through this filtering process to create loops or to extract footsteps from a freeform animation.

**NOTE** Marker files contain position data. Regular motion-capture files contain joint rotation data.

### biped.ini Parameters

The `biped.ini` text file in the `plugcfg` directory has parameters for smoothing the values of motion-capture joint angles for the body's center of mass, the spine, and the head during import. The lines appear as below:

```
MocapHeightSmoothing=0
MocapBodyHorzSmoothing=0
MocapBodyRotSmoothing=0
MocapSpineSmoothing=0
MocapHeadSmoothing=0
```

Higher values of smoothing will cause the importer to filter and "smooth out" the data using a gaussian filter, taking out spikes and jerks in the motion. These values must be integers, and can range from 0 to any high number, but practical values would probably always be less than 10. For most cases, smoothing is not needed, so the default values are set to zero.

### Procedures

**To use Fit To Existing to import a motion-capture file:**

Use a motion-capture file that contains footsteps and other motion. A handspring motion would be ideal for this example.

1. Select a biped.
2. Click Motion panel > Motion Capture rollout > Load Motion Capture File.
   The Motion Capture Conversion Parameters dialog displays.
4. Set Footstep Extraction to On, then click OK.
   The motion-capture file loads.
5. Select Motion Capture rollout > Show Buffer to display raw motion-capture data as a red stick figure, then click Play.
During the “hand spring” period of the playback, the hands on the red stick figure representing the raw motion data touch the ground. The biped, using the filtered data, is positioned higher and cannot reach the ground.

Dynamics calculates the biped higher than the raw motion data because the footsteps before and after the handspring are so far apart in time. Creating a freeform period in Track View — Dope Sheet and reloading the same file using the Fit To Existing option will match the biped’s position to the motion-capture position during the handspring.

6 Find the Footsteps track for the biped in Track View.

7 Right-click the footsteps area of the Track View Edit window, then select Edit Free Form (No Physics) in the Footstep Mode dialog.

8 Click the “handspring” area between the footsteps. It turns to a solid yellow.
Motion-capture data will replace the keys in this freeform period.

9 Reload the same motion-capture file using the Fit To Existing option on the Motion Capture Conversion Parameters dialog.
The freeform area created in Track View is replaced with motion-capture data. The biped closely matches the red stick figure during the handspring part of the playback.
Interface

Motion Capture File Displays the file to be imported.

Footstep Extraction Motion capture data can be applied to the biped in one of three ways:

- **None: Freeform** No footsteps are extracted.
  For swimming or flying motion data, footstep extraction is not necessary. For a traditional approach to character keyframing, use this option to keyframe the biped without footsteos or Biped Dynamics; this is essentially a freeform animation.
■ **On** Extracts footsteps. Direction and style of the motion-capture data are easily edited.
   Allows changes to the toe structure of the biped after import; footsteps will readjust the character’s motion to maintain correct foot-toe-ground contact at all times, a common problem associated with motion-capture import.
   Inappropriate “sliding feet” in the motion data are corrected.

■ **Fit to Existing** Fits to existing footsteps.
   Use with motion data that has both footstep motion and flying, swimming, falling, or tumbling motions.
   First load the motion data using Perform Footstep Extraction. Create a freeform period for the flying, swimming, or falling portion of the data in Track View, and then reload the same motion capture file using the Fit to Existing option. The freeform area is loaded with data from the motion capture file without the influence of biped dynamics.

**Conversion** Chooses the type of key processing.

■ **Use Key Reduction** Reduces keys for simpler key editing.

■ **No Key Reduction** Does not reduce keys. Use this on files that are already key reduced or if you want to work with all the data in a raw motion-capture file.

**NOTE** Marker files imported for the first time should be loaded with no key reduction or footstep extraction to enable the calibration controls on the Motion Capture rollout.

■ **Load Buffer Only** Does not apply the data to the biped, but loads the data to the motion-capture buffer only. Use this either to compare your edited version with the original or to paste postures from the motion-capture buffer to the biped in the scene.

**TIP** To compare the filtered data with raw motion-capture data, use Show Buffer on the Motion Capture rollout on page 4925 rather than turning off key reduction.

**Up Vector** Sets the vertical axis used in the motion-capture data.

**Scale Factor** Multiplies the stored talent size by this value and size the biped accordingly.
Footstep Extraction group

Options here are active when Footstep Extraction is on.

**Extraction Tolerance** Sets the sensitivity of footstep extraction. **character studio** determines if the footstep is there by checking that the foot does not move beyond the distance determined by the Extraction Tolerance value. Smaller numbers are more sensitive and extract more footsteps. The value is a percentage of foot length.

The default value is 0.15. Increase this value to 0.2 or 0.25 if too many footsteps are generated.

**Sliding Distance** Creates a sliding footstep on page 4923 when positional tolerance is reached. This value is a percentage of foot length. By default, the foot must slide its own distance (100), before a sliding footstep is created.

Use this with motion-capture files that contain sliding feet. A sliding footstep can be created manually by setting IK Blend > 0 for a biped foot at a "touch" state key (biped foot first touches a footstep).

**NOTE** Sliding footsteps display as a footstep with a line through the center.

**Sliding Angle** Creates a sliding footstep on page 4923 when rotational tolerance is reached. This value is in degrees; the default is set high (360 degrees). The foot must make a complete turn before a sliding footstep is created.

Use this with motion-capture files that contain feet that pivot, as in a dance motion.

**NOTE** Sliding footsteps display as a footstep with a line through the center.

**Only Extract Footsteps Within Tolerance** Turns on Z-axis Tolerance. These controls filter out footsteps that do not fall within a given range of the ground plane. Use this when filtering motions, such as hopping or pitching a baseball, in which a foot might come off the ground and remain stationary, but its position is not intended as a footstep.

- **Tolerance** Value is a percentage of leg length.
- **From Z Level** Set a Z value (ground).

**Flatten Footsteps to Z=0** Moves extracted footsteps to Z=0. Use this to flatten out minor differences in the height of the extracted footsteps.
Load Frames group

Start Start importing at this frame. Default is frame 0, the first frame.

End Stop importing at this frame. Default is the last frame of the clip.

Loop Loop the data by the value set here.
This is relative. Succeeding loops start where the previous loop left off. The clips are not blended and may require editing unless the original clip was designed to loop.
Use this for clips designed to loop.

NOTE This often works best if Footstep Extraction is tuned off.

Key Reduction Settings group

Key reduction keeps the original motion intact and intelligently filters out more than 80 percent of the keys in the motion-capture file, making the process of altering the biped animation much simpler.

Use the Tolerance and Minimum Key Spacing settings to fine-tune key reduction for a specific track (body part). Specify whether or not to filter a track in the Filter column.

These settings are available only if Conversion is set to Use Key Reduction.
Tolerance  Sets the maximum angular or positional deviation for a track. Values are in units of translation for position tracks, and in degrees for rotation tracks.

Minimum Key Spacing  Sets the minimum number of frames between keys. Tolerance is computed first, then Minimum Key Spacing computes further key reduction. A Minimum Key Spacing value of 10 for the head track ensures that no two keys are closer than 10 frames for this track.

Filter  Turn off to prevent filtering of the motion capture data into a track. When this is off, there is no key reduction for the track.

Set All  Forces all tracks to the values set in these fields.
Higher values here can determine how much key reduction is possible while preserving the original motion.

**Limb Orientation group**

The biped elbow and knee hinge joints are perpendicular to the triangles formed by the shoulder-elbow-wrist and hip-knee-ankle respectively. Resolve errors in the motion-capture data that break this rule by using either the angle or point method.

<table>
<thead>
<tr>
<th>Limb</th>
<th>Knee:</th>
<th>Elbow:</th>
<th>Foot:</th>
<th>Hand:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Angle</td>
<td>angle</td>
<td>angle</td>
<td>angle</td>
<td>angle</td>
</tr>
<tr>
<td>Point</td>
<td>point</td>
<td>point</td>
<td>auto</td>
<td>auto</td>
</tr>
<tr>
<td>Auto</td>
<td>auto</td>
<td>auto</td>
<td>auto</td>
<td>auto</td>
</tr>
</tbody>
</table>

**Angle** Moves the knee or elbow position to create the biped joint key.

**Point** Rotates the shoulder-elbow-wrist or hip-knee-ankle to create the biped joint key.

**Auto** Auto reads exact hand and foot positions from the motion-capture data; *character studio* then places the knees and elbows in a natural position. For marker files involving running and walking, this option can clean up the data nearly instantly, regardless of how many markers were used and where they were placed.

**Talent Definition group**

Loads a Figure Structure File (.fig) and a Pose Adjustment file (.cal) prior to importing a marker file. Typically you correct a marker file by importing it and adjusting the biped scale and limb positions relative to the markers, then saving a .fig and a .cal file using Save Talent Figure Structure and Save Talent Pose Adjustment on the Motion Capture rollout. These files can then be loaded in the Talent Definition area when importing marker files created by the same actor in a motion capture session.
**Figure Structure** Loads a `.fig` file.

**Pose Adjustment** Loads a `.cal` file.

**Browse** Browses for a `.fig` or `.cal` file.

**Use** Use either or both the `.fig` and `.cal` files to adjust marker files during a marker file import procedure.

**Load Parameters** Loads a motion capture parameter file (`.moc`).

**Save Parameters** Saves a motion capture parameter file (`.moc`).

---

**Motion Capture Batch File Conversion Dialog**

Create or select a biped. > Motion panel > Motion Capture rollout > Batch File Conversion button

Converts one or more CSM or BVH motion-capture files to filtered BIP format.

**Interface**

**Source File Selection** Opens a dialog where you can specify motion-capture files to convert. Use Shift+click to select all files between two that you click. Use Ctrl+click to add individual files to the selection.

**Destination Directory** Specifies the directory in which to store the filtered files.

**Specify Conversion Parameters ...** Lets you choose how to specify conversion parameters:

- **Specify Conversion Parameters Once** Imported files use a single set of conversion parameters.

- **Specify Parameters For Each File** You specify conversion parameters for each file.

---

**Marker Display Dialog**

Create or select a biped. > Motion panel > Motion Capture rollout > Show Markers button
The Marker Display dialog lets you specify how markers from .csm files are displayed in the viewports.

For further information on markers and .csm files, see Character Studio Marker Files on page 8531.

**Interface**

Show Recognized Markers When on, displays the markers that character studio recognizes.

- On Selected Objects Displays the markers on selected objects only.
- On All Objects Displays the markers on all objects.

Show Prop Markers Enables the display of markers on prop bones on page 4924.

Show Unrecognized Markers Displays the markers that character studio does not recognize.

**Physique**

Use the Physique modifier to attach a skin to a skeleton structure such as a biped. The skin is a 3ds Max object: it can be any deformable, vertex-based
object such as a mesh, a patch, or a shape. When you animate the skeleton with skin attached, Physique deforms the skin to match the skeleton’s movement.

Animating the underlying skeleton enables you to animate a single contiguous model of a character that bends, creases, and bulges about an arbitrary number of joints within the attached skeleton.
With Physique, you can define how the skin behaves when it deforms. For example:

- You can make portions of the skin solid, excluding them from Physique's deformation, though solid portions still move along with the root node of the skeleton they are attached to. These solid portions are said to be root vertices.

- You can make portions of the skin deformable. They move with the deformation spline, the smooth curve running through the links of the skeleton they are attached to.

- You can make portions of the skin rigid, directly moving along with the skeleton they're attached to.

- You can add bulges to simulate bulging muscles. Bulges are controlled by editable cross sections of the skin, and by bulge angles that you set.

- You can add tendons to distribute the effect of one bone's motion to areas of the skin other than those around the bone itself.

- You can save Physique data to a Physique (.phy) file, preserving data common to all objects sharing a given Physique modifier. Later, you can reload the data file, either to restore the data that belongs to a particular skin or portion of skin.

Physique works with bipeds created and animated using the Biped plug-in, and with 3ds Max hierarchies, including the Bones systems. Physique also works with bones that are not in a hierarchy and splines.

See also:
- Posing the Biped on page 4496

Using Physique

Topics in this section provide an overall introduction to using Physique.

Creating a Skin

A mesh deformed by a skeletal structure is called a skin. In character studio, Physique is a modifier you apply to a skin to make it deformable by the biped,
or by another skeletal structure. The images below show meshes for different skeletons.
Meshes for Physique

A skin used with Physique can be any 3ds Max object that has vertices or control points. Specifically, a skin can be:

- An editable mesh or editable poly object. This is the most commonly used type of object for Physique. Often, it has been collapsed from an object with modifiers, or a compound object.
- An uncollapsed object with modifiers or a compound object.
- A parametric geometry primitive such as a cylinder. Geometric primitives are useful mainly for simple applications of Physique; for example, a cylinder with two bone links to depict an arm.
- A patch object.
- A spline or text shape.
- A NURBS object.
- A Free-Form Deformation (FFD) modifier.
A mesh object you import from another application such as AutoCAD®.

**TIP** Although you can apply Physique to a compound object or an object with modifiers, you should collapse the stack before applying Physique, if possible. This will maximize performance and reduce the amount of work you’ll need to do to get Physique working properly. An exception is the Optimize modifier, which can be useful for improving performance when applied below Physique on the stack.

**WARNING** After you collapse a compound or modified object, you can no longer edit it parametrically. If you work extensively with complex meshes of this sort, you can save two .max files: one to contain the original, editable objects and modifiers, and the other to contain only the collapsed mesh.

You can create a figure’s skin out of several objects. For example, you could have separate objects for the torso, legs and arms. In this case, select all the objects and apply Physique to all of them at once.

**Posing the Skin**

When you create a skin to use with a biped figure, you should pose the arms and legs of the skin in a standard *reference pose*.
Mesh in reference pose for use with bipeds

Use the following positions when you create the reference pose:

- Spread the legs somewhat apart, at a *parade rest* position.

- Spread the arms wide, level with shoulder height. The hands should be level with the arms, not dangling: palms facing down, fingers straight and slightly spread apart.

- Position the head so it will face in the correct direction when you load the biped’s at-rest standing pose. If the skin and biped are for a figure that stands erect, position the head normally. If the character stoops forward, for example, a chimpanzee, make the head face upward so that it will face forward after the spine is bent.
As a general rule, create a reference pose that has the limbs outstretched, but otherwise represents the character’s natural at-rest posture.

**Skin Simplicity**

The degree of detail on the model makes a difference in how well it works for skinning. On one hand, your skin must have a sufficient number of vertices so Physique can deform it smoothly. On the other hand, the fewer vertices the mesh has, the easier it will be for you to adjust Physique for the mesh. In addition, a highly complex mesh can slow your system’s performance when working with Physique.

If you plan to use an Editable Poly mesh, create the mesh with evenly-sized, rectangular polygons. Avoid using long, triangular polygons, as these do not deform smoothly with Physique. These attributes are particularly important around the hip and shoulder areas.

A common workflow is to create the simplest possible version of the mesh, apply Physique to it, and apply the MeshSmooth modifier above Physique on the stack. This makes Physique as easy as possible to work with, but retains mesh smoothness for rendering.
If you want to use a particular mesh but its polygons violate these guidelines, use 3ds Max to add or delete edges and polygons as needed before applying Physique to the mesh. Usually, these rules are not so important for the facial area of the model, where little deformation will take place with Physique.

For example, the character shown below was originally modeled as designed, but with no regard for the best polygon distribution for Physique. The numerous odd-shaped polygons (especially around the hips), and the pose with the legs too close together, would have made this model difficult to work with after Physique was applied.
The model was altered to work better with Physique by deleting edges and vertices, and reshaping many of the polygons in the hip area. The model was also altered to make the character assume the reference pose.
After MeshSmooth is applied to the simplified mesh, renderings of the two models look identical. However, the second model works much better with Physique.
Using Physique with a Biped

The skeleton to which you attach a skin using Physique can be a 3ds Max hierarchy, bones in a hierarchy, bones not in a hierarchy, and splines. Physique deforms the skin based on the relative position of the bone or links in the hierarchy. Specifically, it uses the length of each link and the angle between two connected links; it can also use the scale of a link.

The skeleton hierarchy can also be a 3ds Max system object that defines a behavior as well as a hierarchy. Three kinds of objects that are especially useful with Physique:

■ Bipeds are provided by character studio.
■ Bones are a standard Systems object provided with 3ds Max.
■ Splines can be used rather than a “bones” hierarchy.

You create both bones and bipeds using the Systems object category on the Create panel.

Bones are useful for facial animation, a face with moving lips for example, or for non-bipedal characters. Bipeds are the system of choice for humanoid and other bipedal characters.

Usually you create the Physique skin before you create the skeleton, because you must adapt the skeleton's dimensions to the dimensions of the skin, in order to optimize vertex assignment to the links in the hierarchy.
This Physique hierarchy is created with dummy objects linked to each other.

Physique mesh with a biped skeleton.
Physique can use a spline to deform the mesh.

Using Physique with 3ds Max Bones

3ds Max bones with or without the IK Controller can be used with the biped for various effects. They can be used with Physique to add extra links and envelopes for any character, or to animate assemblies on a robot or mechanical character. Bones can also be added to animate extra appendages, a hat, a jaw and so on.

NOTE If 3ds Max bones using the IK Controller are linked to the biped, the Auto Key button must be left on while the biped is positioned.
Two examples of compressible bones.

In the top image, 3ds Max bones are used to animate the linked piston assemblies. The bottom image shows 3ds Max bones used for added control when Physique is applied. In both cases the bones compress automatically as the biped is positioned.
Bones That Compress

One way to use bones with the biped is to use the Select And Link tool on the 3ds Max toolbar to link the root of the bone to one part of the biped and have the bone End Effector follow another part of the biped. As the biped moves these bones compress and expand.

In the image of the mechanical leg, piston objects are linked to the bones. As the bones compress and expand, they also animate the linked piston assembly. As the bones compress and expand in the abdominal area in the bottom image, the envelopes created by Physique for the bones compress and expand to animate this area on the mesh.

IK Solution

In the IK Controller Parameters rollout, you specify the accuracy of the IK solution and the frame duration of the solution. For bones that compress, you generally want an accurate solution to ensure that the bone follows the end effector perfectly, without any drift. In the image of the rollout Position has a value of 0, the least amount of allowable distance (Rotation is at its default value of 1, the Rotation End Effector is not used in this example). Iterations is set high, ensuring that that the solution is accurate, even if the character is scaled down a great deal. Start and End Time should span the animation.

There are many ways to use bones with the biped. You could automatically animate the bending of a hose that is attached to a character’s shoulder and mouth when the biped head rotates, for example. Bones attached to the biped
create links and envelopes when Physique is applied; these extra Physique links offer localized skin control if necessary.

![End Effectors panel]

**Procedures**

**To make compressible bones (bones with end effectors):**

1. Create a bones system with end effectors.
2. Link the root of the bone to the appropriate biped object.
3. On the Motion Panel specify an End Effector Parent.
4. Specify another part of the biped.
5. On the Motion Panel set the Position Threshold to 0.
6. On the Hierarchy panel > IK > Sliding Joints rollout, turn on all the sliding parameters.
7. Animate the character.
   The bones expand and compress with the motion of the character.

**To add a bone after Physique is applied using Reinitialize:**

1. Turn on Figure mode.
2. Add a bone where it is needed.
3 Link the root node of the bone to the biped.

4 On the Physique rollout, click Reinitialize.

5 On the Physique Initialization dialog, click Initial Skeleton Pose and then click Include New Bones. 
   Vertex Link Assignment turns on also.

6 Click Initialize.

7 Adjust envelopes in Sub-Object Envelope.

8 Turn off Figure mode.

   If you want the end of the bone to follow the biped, select the bone and delete the bone end effector in the Motion Panel

This bone is used to animate the character's nose.

To add a bone after Physique is applied using Add (Add Bone):

1 Turn on Figure mode.
2 Add a bone where it is needed.
3 Link the root node of the bone to the biped.
4 On the Physique Bones rollout, click Add.
5 In the viewports, click a bone.
   Repeat until all bones are added.
6 Adjust envelopes.
7 Turn off Figure mode.

Using Physique with 3ds Max Objects

The skeleton to which you attach a skin using Physique can be a 3ds Max hierarchy, bones in a hierarchy, bones not in a hierarchy, and splines. Physique deforms the skin based on the relative position of the bone or links in the hierarchy. Specifically, it uses the length of each link and the angle between two connected links; it can also use the scale of a link.

The skeleton hierarchy can also be a 3ds Max system object that defines a behavior as well as a hierarchy. There are two kinds of objects that are especially useful with Physique:

- Bones are a standard Systems object provided with 3ds Max. Bones can either be hierarchically linked or floating.
- Splines can be used rather than a “bones” hierarchy.

You create bones using the Systems object category on the Create panel. Bones are useful for facial animation, a face with moving lips for example, or for non-bipedal characters.

Usually you create the Physique skin before you create the skeleton, because you must adapt the skeleton’s dimensions to the dimensions of the skin, in order to optimize vertex assignment to the links in the hierarchy.
This Physique hierarchy is created with dummy objects linked to each other.

**Floating Bones**

Floating bones are bones that are not linked together and know nothing about each other. By adding floating bones to Physique, you can deform the mesh by animating the bones. This is in contrast to using Attach To Node and clicking the root of a hierarchy, like the biped pelvis. For Attach To Node to work all the bones should be linked together.
Spline-Based Physique Deformation

In addition to the biped and 3ds Max bones, Physique supports spline and NURBS curves for mesh deformation. By animating vertices on a spline, you can animate the mesh. You can use this technique for facial animation or to deform any mesh.

To control a mesh with a spline:

1. Place a spline inside a mesh.
2. Select the mesh and add the Physique modifier.
3. In the Physique Floating Bones rollout, click Add and select the spline in the viewports.
4. Select the spline, turn on Vertex Sub-Object, and move the spline vertices to animate the mesh.
See also:
- Using Physique with a Biped on page 4956

**Applying and Initializing Physique**

After you have created a skin and a skeleton, and fitted the skeleton to the skin, you apply the Physique modifier to the skin.
The process entails these steps:

- Selecting the mesh
- Turning on Figure mode (if a biped is used)
- Adding the Physique modifier to the stack
- Attaching the Physique skin to the skeleton
- Initializing Physique

See also:

- Physique Rollout on page 5013

Procedures

To attach a mesh to a bones hierarchy using Physique:

1. Select or create a bones hierarchy.

2. Position the bones hierarchy inside the mesh.
   
   **TIP** When you use a bones hierarchy with Physique, use frame 0 as your "figure mode." Don't include frame 0 in your animation. Use it as the place where you position the bones and fit them to the mesh.

3. Select the mesh.

4. Go to the Modify panel. Use the Modifier List to apply Physique to the mesh.

5. Click to turn on Attach To Node. In a viewport, select the root bone in the bones hierarchy.
   
   The Physique Initialization dialog on page 5024 is displayed.

6. Click Initialize, accepting the default settings.
   
   When you use Attach To Node to attach a Physique skin to a hierarchy, the Physique Initialization dialog appears.
NOTE  This dialog also appears when you want to reset Physique settings by clicking Reinitialize in the Physique rollout.

Physique initialization settings affect how envelopes are created and blending is handled. The Link Settings, Joint Intersections, and Cross Sections rollouts are used later to change default settings globally. For this reason, the Vertex-Link rollout is open when the dialog appears. This is where you determine the following default settings:

- Whether envelopes should be used to manage the vertex-to-link assignments
- Whether Physique uses deformable or rigid envelopes to manage the vertex-to-link assignments
- Number of links considered for blending

**Previewing Motion**

After you have attached the skin to the skeleton, Physique deforms the skin when the skeleton is animated. From this point on, you can preview animation to see how the Physique skin deforms and whether you can use it in a finished animation or need to correct and refine it further.

Very likely, you'll need to adjust some of the default envelope settings to ensure all vertices are being properly handled. It's by moving the skinned character in the viewports that you'll see vertex assignment problems.
A stray vertex on the right elbow not encompassed by an envelope.

See the Envelope Sub-Object on page 5060 topic for procedures and interface.

**TIP** Physique skins are usually too large for 3ds Max to play them back in real time at 30 frames per second. However, speed improvements in character studio will allow fluid motions of many skinned meshes. When you attempt to play back at 30 fps, 3ds Max may drop frames during playback, which makes it hard to see how Physique has animated the skin. Use the Time Configuration dialog to turn off real time playback. The animation plays back more slowly than usual, but it plays every frame.

**TIP** You can also specify which elements of the characters not to display in the viewports, and thereby speed up redraw. See Physique Level of Detail Rollout on page 5018.

For a skin attached to a complicated skeleton such as a biped, you will almost always need to correct some vertex assignments before the skin animates correctly. Most often, you'll do so simply by adjusting the envelope's shape. See .
**Envelopes**

Envelopes are Physique's primary tool to control skin deformation. Envelopes define an area of influence about a single link in the hierarchy and can be set to overlap adjacent links. Vertices that fall in the overlap area of the envelopes are weighted to produce smooth blending at joint intersections. Each envelope comprises a pair of inner and outer bounds, each with four cross sections.

**Deformable and Rigid Envelopes**

There are two envelope types: deformable and rigid.

- Deformable envelopes influence vertices they encompass to follow the deformation spline created through the hierarchy. Only the vertices encompassed by deformable envelopes can be affected by bulge angles or tendons.

- Vertices in a rigid envelope are linked to the node (the bone) and move in an immobile relationship to the link. Vertices in a rigid envelope, however, are deformed (blended) in the overlap area of other envelopes.
There is a twist parameter in Link Sub-Object that can be enabled in a rigid envelope. This allows the rigid envelope to twist along the length of the link.
Typically, you use deformable envelopes when you attach a mesh to the biped pelvis to produce a soft, flexible skin. Later you reassign certain links, such as the character’s head, to the rigid envelope to minimize the deformation. For special cases, you can turn on both deformable and rigid envelopes for the same link. This advanced feature allows you to average the effect of the two types of skin deformation for additional firmness in the skin. The forearms and legs are sometimes good candidates for this.
Blending Between Links

Blending between envelopes controls deformation.

Blending controls specify the influence of overlapping envelopes on vertices contained within the overlap area. By the actual shape of adjacent envelopes, you can control the degree of influence each has on blending at the overlap area.

You can further control the number of envelopes that participate in the blending effect, or whether no blending takes place at all. Where you specify no blending, a vertex in an overlap area is influenced by a single link only.
Inner and Outer Bounds

Where a vertex falls within the inner and outer bounds determines the percent of influence of the attached link(s). Vertices that fall within the inner bound have a weight of 1. Vertices that fall between the inner and outer bound have a weighted value that falls off to 0 at the outer bound.

Vertices are color-coded in the viewports according to their weight; the color is based on parameters you specify in the Blending Envelope Display Options Dialog on page 5049.

See also:
- Envelope Sub-Object on page 5060

Adjusting Default Envelope Shape

When you want to address vertex-linking anomalies, the first step is to resize or reposition the envelope about the problem link. Most often, the problem
is an envelope that is too small to surround, and thereby influence, certain vertices.

This can happen because your biped character misaligns slightly with the mesh, or the link lengths used to create envelopes with unbounded bones systems links were insufficient to surround all vertices attached to the link.

Another potential source of problems is overlapping inner bounds. This can sometimes create too strong a deformation at the joint.

You'll note problems with vertices as you preview motion. It sometimes looks like vertices got left behind when the link they were supposed to be attached to moves in 3D space. In fact, that's just what is happening: they weren't assigned to any link at all, and remain where they were at the initial skeletal pose: the pose of the mesh and its skeleton at the time Physique was applied and initialized.

The other case would be vertices being moved too much, resulting in a dent in the mesh. You'd fix this by decreasing the overlap of the envelopes affecting a joint.
Stray vertices (above) reassigned to correct link(s) by modifying envelope shape (below).

See also:

- Envelope Sub-Object on page 5060
- Fine-Tuning Envelopes on page 4979

Procedures

To adjust default envelope shape:

1. In the Selection Level group of the Blending Envelopes rollout, turn on Link. In a viewport, select any link.

2. In the Parameters group, turn on the Inner, Outer or Both option and then increase the value of Radial Scale until the outer envelope just surrounds the character mesh.

   **NOTE** With Both turned on, both the inner and outer bounds scale together.
3 Increase the Parent Overlap value until the inner (red) envelope appears through the mesh.

4 If necessary, decrease the Falloff value to strengthen this envelope.

To adjust envelopes around the biped’s pelvis:

The Biped Triangle Pelvis option was used in this model. Triangle Pelvis creates additional links from the legs to the lower spine.

Top: The default envelope from the pelvis to the lower spine object is too small.

Middle: Mesh appears “scrambled” because the pelvis doesn’t control all the vertices that surround it.
Bottom: Increasing the envelope size corrects the mesh problem in the pelvis area.

1. In the Selection Level group, turn on Link. In a viewport, select the middle link.

2. In the Parameters group, turn on Both, and then increase the value of Radial Scale until the outer envelope just surrounds the mesh in pelvis area.

   **NOTE** With Both turned on, both the inner and outer bounds scale together.

3. Increase the Parent Overlap value until the inner (red) envelope appears through the mesh.

4. If necessary, decrease the Falloff value to strengthen this envelope.

5. To finish correcting the pelvis area, adjust the Overlap of the thigh and buttock envelopes.

**To select and edit cross sections:**

1. On the Selection Level rollout, turn on Cross Section.

2. In the Envelope Parameters group, turn on Inner or Outer if you want to work with cross sections solely in that part of the envelope. Turn on Both to be able to work on both Inner and Outer cross sections at the same time.

3. Turn on Select Object on the Main toolbar, and in a viewport, click the cross section you want.

   As you move the cursor over a selectable cross section, it changes to a plus shape, letting you know the object at that location is selectable.

   By default, selected cross sections are yellow. (You can customize this color with the Blending Envelope Display Options dialog on page 5049.)

   You can use Ctrl+click to add other cross sections to the selection set.

4. Use Radial Scale to resize the selected cross section, and the transform tools to move, rotate, and scale it.
To move to the adjacent cross section within the current bound, click Next or Previous.

**TIP** You can also use the Control Point level to individually transform cross section control points.

To copy an envelope and its settings to a mirrored link (for example, from one thigh to the other):

1. Select the source link.
2. In the Edit Commands group, click Copy. The envelope settings are saved in a buffer.
3. Select the mirror link, and then in the Edit Commands group, click Paste. The envelope is applied to the opposite link, but without mirroring. It is now the currently selected envelope.
4. In the Edit Commands group, click Mirror. The selection flips about the mirror axis.
5. Use the Rotate transform on the Main toolbar to rotate the selection to its final orientation.

**Fine-Tuning Envelopes**

Once you have adjusted inner and outer bounds of envelopes at the Envelope Sub-Object level, you may find you need still finer control: choose either the Cross Section or Control Point selection level in the Blending Envelopes rollout.

**Using Cross Sections**

Both inner and outer envelope bounds are like *hulls* about *ribs*, the cross sections. For each envelope, there are by default four cross sections you can use to alter the envelope's shape.
Envelope cross sections can be scaled and moved.
Using Control Points

By default, each cross section consists of four control points. You can use these control points to alter the shape of a single cross section. The control points define the shape (perimeter) of the section. Moving one point affects the shape between itself and its neighbors on each side.

Rotating and Scaling

Control points are internally positioned using cylindrical coordinates, that is a distance from the link at some angle around the link. To move a control point, you must scale it to the correct distance from the link and then rotate it into the orientation you desire. The move tool actually serves the dual function of rotating and scaling at the same time.
By moving a control point the envelope is also scaled.

See also:
- Envelope Sub-Object on page 5060

**Customizing Vertex Assignments**

Use Vertex sub-object controls to customize vertex assignments.

There are a few different reasons you might want to customize vertex assignments:
- Override vertex-link assignments currently in effect.
- Change the blending type and weight.
- Assign vertices to their links yourself, bypassing Physique's envelope method for vertex-link assignment.
You might want to reassign link assignments in effect about adjacent fingers, for example, even after working to reshape envelope size and position. You may find that you need greater control in areas where adjacent envelopes overlap: perhaps movement in the ring finger is causing unwanted movement in some vertices for the middle finger. You'd use Vertex sub-object controls to remove ring-finger vertices from the middle finger links, in effect reassigning them solely to the ring-finger links.

When you choose Vertex as the sub-object to edit in the Physique modifier, the Physique Selection Status and Vertex-Link Assignment on page 5096 rollouts appear.

**Envelope Display Options**

This topic describes some options for controlling how envelopes display in the viewports.

**Interactive Redraw**

By default, Interactive Redraw, an option in the Envelope and Bulge sub-object levels, is turned off. After you change an envelope, the mesh is refreshed when you release the mouse button. Turn this option on for interactive viewing of how envelopes and bulges are affecting vertices. As you adjust the envelopes, the vertices move to show the effects of the resized envelopes.

**Changing Display Options**

You can change the display settings for envelopes and their component parts. Click the associated color sample to open the Color Selector and change color setting for:

- Inner and outer bounds on both deformable and rigid envelope types.
- Differently weighted vertices, as they fall within the inner bound, or between it and the outer bound.
- Selected cross sections and control points.
- Turn on or off the associated check box to determine whether any of the above envelope components are displayed.
- Number of sides for inner and outer bounds. The default is 4.
Choose Initial Skeletal Pose on page 5000 if you want to work in the position of the mesh and its skeleton at the time Physique was applied. Returning to this pose can be useful if the display becomes confused with the effects of unassigned vertices when the character moves through an animation.

See also:
- Fine-Tuning Envelopes on page 4979

Working with Deformable Envelopes

Once you've got the deformable envelopes working the way you want to control overall skin deformation, you might want to adjust the finer aspects of skin control.

Several different sub-object levels can help you fine-tune skin behavior:

- Skin bending, twisting, sliding, and scaling about single links are controlled at the Link sub-object level. See Adjusting Link Parameters on page 4986.

- Link sub-object primarily controls the deformation spline on page 8547. You use Link sub-object options to affect the shape of the spline and the smoothness of the skin. See Adjusting Link Parameters on page 4986.

- Crease behavior where links meet and bend is controlled at the Link sub-object level with Joint Intersection on page 5077 parameters.

- Muscle bulges as your character's limbs move through a range of motion are controlled at the Bulge sub-object level. See Creating Bulges on page 4991.

- Skin stretching, generally between non-contiguous links, is controlled at the Tendon sub-object level. Tendons provide a secondary movement (a pulling or stretching) based on links farther up or down the skeleton. See Creating Tendons on page 4995.

See also:
- Link Sub-Object on page 5068
- Bulge Sub-Object on page 5080
- Tendons Sub-Object on page 5090
Working with Rigid Envelopes

Vertices influenced by a rigid envelope follow the link itself rather than the deformation spline, as deformable vertices do. Low vertex-count models used for games are typically connected to the skeletons with rigid envelopes to simplify export to game engines. In such a case, each vertex can be simply described as assigned to a specific link. It can be located by giving a length along the link, a distance from the center of the link, and an angle around the link. As the link is transformed, all the vertices assigned to the vertex are uniformly transformed. This makes it simple for game engines to move the character’s skin.

The vertices move equally with the controlling link, so the skin appears rigid. For instance, in the case of a flexing arm, the skin between the wrist and elbow tightly follows the movement of the forearm, with no change in the spacing between vertices. The skin between the elbow and shoulder tightly follows the upper arm. Vertices around the elbow influenced by both links, smoothly blend to an average position between the two changed links.

Rigid and deformable envelopes can be mixed on a given character. You might, for instance, use deformable envelopes for most of the character, but choose rigid for the head and for a suit of armor around the torso.

NOTE In Link sub-object, you can turn on twisting for rigid envelopes. As the wrist twists the vertices on the forearm will twist also.

See also:

■ Envelope Sub-Object on page 5060

Working with Both Deformable and Rigid Envelopes

You can assign both Deformable and Rigid to a given link. For example, you might assign both to the shins, and size the envelopes differently to gain the benefits of both.

First, size the deformable envelope to affect the whole lower leg area and smoothly transition into the thigh and ankle areas. Next, you define a smaller rigid envelope to encompass the stiff unbendable section of the shin. Increase the weight of the rigid envelope to balance its effect against that of the deformable envelope.
Some users might use both envelopes as a way to have a bone affect two completely separate regions of a mesh. The envelopes are scaled so that the deformable envelope influences certain vertices on one side of the link and the rigid envelope affects the other side.

See also:

- Envelope Sub-Object on page 5060

Adjusting Link Parameters

Physique creates a continuous spline through each of the joints in the hierarchy. The spline is represented by an orange line within the object. It maintains continuity through each joint: as a joint angle changes, the spline passing through the joint remains a smooth curve. Physique relies on the deformation spline to obtain smooth bends of the skin object. Physique offers bias and tension controls to adjust the shape of the deformation spline.
Links depicted by deformable spline.

You can use controls at the Link sub-object level on page 5068 to adjust the skin behavior about a given link. These link parameters define how the skin deformation behaves, relative to the motion of the underlying skeleton.

There are four kinds of link parameters on page 5070:

- Bend parameters affect the curvature of the deformation spline through the joint at a given link. As a result the skin deformation can range from more angular at the joint to more like a stiff rubber tube.
Twist parameters control how the skin deforms when a joint rotates along its length, as in turning a doorknob. Consider, for example, winding up the rubber band on a toy airplane propeller; Twist parameters determine how the twist is distributed along the link and across the joint. Twist parameters apply to link rotation whose axis is the same as the axis along the length of the link.

Sliding parameters control how the skin moves along the length of a link as a joint rotates. On the outside, the side where the angle is greater than 180 degrees, the skin moves toward the joint. On the inside, the side where the joint angle is less than 180 degrees, the skin moves away from the joint. The sliding effect tightens the outside to keep detail at the joint and prevent the facets of the mesh from moving apart. It relaxes the inside to prevent the mesh from bunching up at the joint.

Radial Scale parameters affect the influence on the skin caused by scaling links of the skeleton. Certain settings, such as Breathe and Stretch, react to scaling of the skeleton, but only with standard 3ds Max bones or a 3ds Max hierarchy.

**NOTE** Bipeds and 3ds Max IK controllers don't support scaling. Link Scale provides a way to globally scale all the vertices influenced by the link. CS Amplitude scales the effect of bulge cross sections across the entire link. It can be used for animated scaling of the bones or for general mesh adjustments. The intent is not to edit the character itself, but rather the effect the bones have on it.

You set Link parameters at the sub-object level, in the Physique Link Settings rollout on page 5070.

**Partial Blending and Weight Assignments**

Most often, you will want to use envelopes to correct the way skin behaves as the biped moves. However, you can override envelopes by manually assigning vertex properties.

For example, you can remove the influence of inappropriate links from selected vertices. You can also change the weight distribution between links for a single vertex by using type-in weights.
In Cases where No Envelopes Use Partial Blending (the Default)

Vertex \( v \) is assigned to links \( l_1, l_2, \) and \( l_3 \), and the weights for these links are: \( w_1 = 0.2, w_2 = 0.3, \) and \( w_3 = 0.4 \).

In a non-partial blended case, the sum of these vertex weights is \( w_1 + w_2 + w_3 = 0.9 \) (less than 1.0).

With partial blending off, Physique will normalize the weights so they sum to 1.0. For example:

\[
\begin{align*}
  w_1' &= w_1 / (w_1 + w_2 + w_3) = \frac{0.2}{0.9} = 0.2222222... \\
  w_2' &= w_2 / (w_1 + w_2 + w_3) = \frac{0.3}{0.9} = 0.3333333... \\
  w_3' &= w_3 / (w_1 + w_2 + w_3) = \frac{0.4}{0.9} = 0.4444444...
\end{align*}
\]

so

\[ w_1' + w_2' + w_3' = 1.0 \]

In Cases where All Envelopes Use Partial Blending

The weight fill-in for vertices with a weight less than 1 will always fill with the weight of the root. Whenever a vertex is assigned to a group of links, all of which are partially blended, then the remaining weight will be assigned and blended with the root link.

This works well for a case where you want partial deformation falling off to no deformation. An example would be a static head, where you are deforming the head for facial expressions, but the head itself remains in place.

For example: vertex \( v \) is assigned to links \( l_1, l_2, \) and \( l_3 \). The weights for these links are: \( w_1 = 0.2, w_2 = 0.3, \) and \( w_3 = 0.4 \).

The sum of these vertex weights is \( w_1 + w_2 + w_3 = 0.9 \) (less than 1.0). We need an additional fill-in weight (\( w_f \)). The fill-in weight is determined by \( 1.0 - (w_1 + w_2 + w_3) = 0.1 \), or 10%. Physique fills in with weight \( w_f \) from the root (leaving the vertex partially undeformed).

The resulting deformation will be \( w_1*l_1 + w_2*l_2 + w_3*l_3 + w_f*root \). The root portion of this deformation is essentially an undeformed portion that simply follows the root of the skeleton.

In Cases where Some Envelopes Use Partial Blending and Some Do Not

The vertex weight fill-in in overlap areas will be based on the percentage of partial and non partial weights. For example, If the total weight of non partial links is 80% of the total summed partial and non partial weight, then 80% of
the fill-in will be more of the non partial deformation. The remaining 20% fill-in will come from the root.

Example: If Vertex $v$ is assigned to links $l_1$, $l_2$, and $l_3$, the weights for these links are: $w_1 = 0.2$, $w_2 = 0.3$, and $w_3 = 0.4$.

Let’s assume $l_1$ and $l_2$ are nonpartial, and $l_3$ is partial. The nonpartial weight is $w_1 + w_2 = 0.5$; the partial weight is $w_3 = 0.4$; the nonpartial weight is $0.5/(0.5+0.4) = .555555$, or 56%; and the fill-in weight is still $(1.0 - .9) = 0.1$.

Physique fills in with 56% of $wf$ with more of the nonpartial blended links. The remaining 44% of $wf$ is filled in with the root as in the partial blended case. This provides a smooth transition between the partial and nonpartial links.

**Bulges**

For some animations, simply attaching the skin and correcting its vertex assignments results in an animated skin you can use in final renderings. For other animations, you might need to give the skin more realistic movement: for example, muscles that bulge.

Physique lets you simulate an underlying musculature for the skin by adding **tendons** on page 4995 and bulges:

- Bulges change the skin’s profile to simulate bulging muscles. You create the bulge by establishing bulge angles, relationships between cross-sectional slices of the skin and specific poses of the skeleton joint. Imagine a cross section to be a slice through the skin’s mesh, perpendicular to the link. By making changes to cross sections, you in turn distort the shape of the mesh. Bulges in your character can be constructed by associating certain poses with related changes to the cross sections, in other words by defining **bulge angles**.
  
  At any joint angle, you can define a bulge angle, and you may define as many bulge angles as needed. The bulge angle consists of the current orientation of the joint together with any defined cross sections. In addition, you can adjust the influence of a bulge angle. Physique considers all the bulge angles as the character moves. The resulting bulge is created by interpolating the effects of the various bulge angles having some influence at the current joint angle.

  For example, to create a bulging biceps muscle, in Bulge sub-object level, on a selected link, insert a cross section near the center of the upper arm. Pose the arm into a flexed position, with the angle between upper and
lower arms at 90 degrees or less. Insert a bulge angle and adjust the cross
section so that it distorts the mesh appropriately. In the viewports and in
the Bulge Editor on page 5029, you can edit the shape of the bulge to look
like a flexed biceps muscle: higher and wider above the bone than below
it. Now as the elbow bends from a straight orientation up and toward the
shoulder, Physique bulges the biceps appropriately.
see Creating Bulges on page 4991 for more information about creating bulges.

Because bulges are optional, you can approach Physique animation in a couple
of ways:

■ Apply only as much detail as you need to get the effect you want for a
particular scene in your animation. This is probably the best approach
when the Physique animation is meant to be used only once, or is not the
main focus of the animation.

■ Define a fully deformable character, with bulges for its entire range of
motion. This is probably the best approach when you intend to reuse the
Physique character in an ongoing series of animations, for example, or in
a video game that has a variety of character action.

See also:

■ Bulge Sub-Object on page 5080

Creating Bulges

Bulges simulate bulging muscles. Physique creates bulges based on bulge angles
and cross section shapes you specify, not on keyframe settings.

You create a bulge by:

■ Reposing the character to a position where the bulge will have its greatest
effect. This can just be a matter of using the time slider to scrub to that
place in a loaded motion file.

■ Setting a bulge angle between two links, the currently selected link and its
child link in the hierarchy. The bulge angle is the angle of the joint where
the bulge has its full effect. When the joint has a different angle, Physique
interpolates so the bulge can grow as the joint flexes toward that angle.
See Setting Bulge Angles on page 4993 for more information.
NOTE The resulting bulge for any given frame in an animation is determined by the interpolated effects of all bulge angles for the link, based on the relationship of each bulge angle to the current joint angle. Bulge angles are not directly associated with keyframe parameters, but are relative to the skeleton’s behavior.

Bulge shape is interpolated as joint movement approaches a bulge angle.

- Creating and shaping the cross sections associated with the bulge angle. A link’s cross sections and its profile are spline controls of the shape of the skin. To create and shape cross sections, see Shaping the Bulge on page 4994.
  Each bulge angle affects both neighboring links. Therefore, each link contains a set of cross sections for each bulge at both its parent and child joint angles. For example, the forearm link can be deformed by bulge angles associated with both the elbow and wrist joints.
- Adjusting bulge parameters, including the joint intersection parameters. Bulge parameters control the smoothness and the strength of the bulge and are found at the Bulge sub-object level. Joint intersection parameters control how the skin behaves when bulges would overlap each other if there were no collision detection for skin vertices. They are in a Physique rollout for Link sub-objects. See Reinitializing Physique Settings on page 4998.

See also:
- Bulge Sub-Object on page 5080

### Setting Bulge Angles

A bulge angle associates an angle value and a name. By default, each link has one bulge angle whose default name is the name of the link followed by "Bulge 0". The default bulge angle's initial angle value is the angle between the link and its child when you first attach Physique to the skeleton.

Bulges are effective because they grow and shrink as the joint moves. The initial bulge angle defines one shape that the skin can deform to; this would normally be like a default musculature. With no other bulge angles defined, the skin would always look like the first bulge angle, regardless of pose. Additional bulge angles provide the other shapes the mesh can deform to.

In the simple case of a flexing biceps muscle, one bulge angle defines the relaxed position and another defines the muscle in its flexed pose. Both are exposed so you can add definition to the default character. As in a biceps muscle, a heavily-muscled character might have some shape even in a relaxed pose. This lets you change the baseline without disturbing the original mesh. You can actually use Physique bulge cross sections to model your character.

The cross section deformation for a given link is determined by interpolating between the contributions of all bulge angles that affect the link. This includes bulge angles for both the link's parent joint angle and its own (child) joint angle. Each bulge angle's contribution is determined by:

- Influence (how far away the bulge angle is from the current joint angle rotation)
- Power (an ease based on the influence of the angle)
- Weight (the relative strength of the bulge angle)
Keep in mind that bulge angles can be set for arbitrary rotations, and are not limited to single-axis hinge joints.

**See also:**
- Bulge Sub-Object on page 5080

**Fine-Tuning Bulges**

The Bulge Editor on page 5029 duplicates many of the controls available at the Bulge sub-object level. It gives you a focused, two-dimensional view of the current bulge settings.

**Shaping the Bulge**

Once you've inserted the bulge angle, and recorded the angle setting, you then shape the bulge by inserting and adjusting cross sections. You can either move and scale the cross sections, or adjust each one’s shape using control points.

**Adding More Poses to Your Character**

For more complex body movements, you may need to add bulges for different positions. Overall, you might want to build a generic character that works in a number of situations, regardless of the type of motion.

Some examples are:
- Moving the character into several extreme poses.
- Putting the arms high over the head and bending them into different positions.
- Making the character squat and lifting the legs into various positions.
- Adding bulge angles to the links at places where real muscles would bulge.

Once the skin reacts well to the full range of motions, you can then place the character into a less demanding pose and it should work perfectly.
Tendons

Tendons tie links together, extending the effect of moving one link to another link where the tendon is based. Their effect is similar to that of tendons in a body.

For example, raising an arm usually stretches the skin along the same side of the body. To get this effect using Physique, you could base a tendon on a spine link, then attach it to the upper arm or collarbone, so when the arm lifts, the skin around the torso stretches as well.

see Creating Tendons on page 4995 for more information about creating tendons.

See also:

■ Tendons Sub-Object on page 5090

Creating Tendons

Like tendons in an actual body, tendons in Physique on page 5090 link one bone to another. They spread the effect of moving one link to the skin around a different link. Tendons can improve the realism of skin movement when it is animated by Physique.

Basically, a tendon consists of base points that live on a cross section near the skin. A base point is attached to another link on the skeleton that pulls it. As the tendon base point is pulled, it deforms the skin around it. Several parameters control how much the point is pulled in each direction.

You insert the tendon cross section at the location where you want the skin to stretch. You then attach it to the link that influences the movement.

Each link can contain several tendon cross sections, and each control point may be attached to a separate link. In a practical application, however, such as in the area below the armpits, you might have two control points attached to each of the left and right clavicles.
Procedures

To create and attach a tendon:

1. Go to the Tendons sub-object level. In the Selection Level group of the Tendons rollout, turn on Link.

2. In a viewport, select a link.

3. In the Insert Settings group, click to turn on Insert.

4. In a viewport, position the cursor over the link. The cursor changes to a small star.

5. Click to create cross sections on the link.

6. Click to turn off Insert.

   **TIP** You can also right-click in a viewport to turn off tendon creation.

7. In the Selection Level group, turn on Cross Section.

8. Use the Rotate tool to rotate the cross section so the control points are positioned in useful places.

9. In the Tendon Parameters group, use the Radius spinner to scale the cross section radially so the control points fall close to the surface of the skin.

10. In the Selection Level group, turn on Control Point, then in a viewport, select one or more control points.

11. In the Edit Commands group, turn on Attach, then in a viewport, click a different link. Tendons span the area between the links.

12. Adjust the Pinch, Pull, and Stretch settings to adjust the skin behavior.

13. Adjust the Upper and Lower Boundary settings to control the extent of the effect on neighboring links.
To attach a tendon to another link:

1. In the Selection Level group of the Tendons rollout, turn on Control Point to make it the active selection level.

2. In a viewport, select one or more of the tendon's attach points. Click a point to select it; use Ctrl+click to add points to the selection; or drag a rectangular region to select multiple points.

3. In the Edit Commands group, turn on Attach.

4. In a viewport, click the link to which you want to attach the tendon. In the viewports, red lines appear showing the tendon's connection from its base to the other link. The skin mesh might also deform as a result of attaching the tendon.

   **TIP** The tendon can have fixed attach points that are not connected to another link. These are useful for giving some rigidity to the skin, as when (in an actual body) a bone lies close to the skin's surface. For example, you might leave two fixed attach points on either side of a character's chest area, to simulate the effect of the sternum. When all tendons are attached to other links, the skin over the base link can have a "squishy" appearance when it is animated. This is appropriate for some animated characters, but not for others.

To delete a tendon:

1. At the Link selection level in the Tendons sub-object, select the link that has the tendon you want to remove.

2. In the Insert Settings group, click Delete.

**Saving and Loading Physique Data**

You can save Physique data to a Physique (.phy) file to save data common to all objects that share a given Physique modifier. Later, you can reload the data file, either to restore the data that belongs to a particular skin or portion of skin, or to transfer the Physique of one skin (or portion) to a different one.
Reinitializing Physique Settings

When you need to reset vertex, envelope, and other skin parameters on a Physique mesh, click Reinitialize to display the Physique Initialization dialog. Using controls in this dialog, select the category to update, and apply the new global settings.

For example, if you've added a new bone to the hierarchy and want it included and influenced by the Physique modifier, use the reinitialization mechanism to effect its inclusion. Or maybe you've repositioned the biped structure relative to the mesh, you'd need to reinitialize Physique settings to recognize those changes.

Reinitializing with changed settings applies them as new defaults in the areas you choose. Reinitializing without changing settings on the Physique Initialization dialog is a method of erasing unsatisfactory changes you've made to the Physique settings, again in those areas you specify.
Reinitialization mode of Initialization dialog

**Initialization Group**

The Initialization group in the Physique Initialization dialog is where you name the category of settings to reset. (When you applied Physique to the mesh initially, these settings appeared unavailable; in fact, all settings are set at Initialization.)
WARNING Select only the check boxes for those settings you need to reset. If you select everything, your model is returned to the state it was in immediately after applying Physique. That's a quick way to discard changes that aren't working; just make sure that's what you want to do. If you change settings in rollouts on this dialog and fail to select the corresponding check box, those rollout settings are ignored and initial defaults are reestablished.

See also:
■ Reinitialize Physique on page 5026

Working with an Initial Pose

At times, you'll need to alter the fit of the hierarchy in the Physique mesh, or change its structure. To do so, you change the default, initial pose, which Physique uses as a reference for various operations, including reinitializing.

■ For a biped, you change the structure in Figure mode, then reinitialize the Initial Skeleton Pose.

■ For a Bones system with the HD IK solver, there is a Show Initial State check box in the Motion panel, on the IK Controller Parameters rollout.

■ For any other hierarchy, use frame 0 for the initial pose. Be sure your animation does not affect the position of the skeleton in frame 0.

See also:
■ Figure Mode on page 4758

Procedures

To load a file created with different system units:

NOTE If the System Unit Scale has a value that is different from that of the file you are loading, 3ds Max prompts you to rescale the scene. If you do so, any objects that have a Physique modifier exhibit a double scaling. Do the following:

1 Select the object.

2 Reinitialize with both Initial Skeletal Pose and Vertex Settings (the last check box) turned on.
Improving Interactive Performance

This topic presents some ways to improve the interactive performance of Physique.

Physique is multithreaded, and optimized for modifier stack changes below the Physique modifier.

Level of Detail Controls

The controls in the Physique Level of Detail rollout help you optimize performance while working with Physique, by letting you specify which skin deformations are refreshed automatically in viewports. The more complex the skin object, the more effective these controls can be at speeding up your work.

NOTE The 3ds Max renderer also heeds Level of Detail settings. Don’t forget to reset these controls before the final render.

Turning Blending On and Off

When Physique is first initialized, the Blending Between Links parameter in the Physique Initialization dialog is set to N Links. This means that every envelope must be considered when determining the influence on any vertex. You can reinitialize with No Blending (or only 2, 3, or 4 links) to reduce this calculation permanently, although at the cost of losing some or all blending at the joints.

NOTE Setting to No Blending is advised only for those developing characters to be used by real-time game engines.

You can also set No Blending at the Vertex sub-object level. You can temporarily disable Link Blending on the Physique Level of Detail rollout, on the Modify panel.

Using the Optimize Modifier with Physique

The standard 3ds Max Optimize modifier allows you to reduce the level of mesh detail in order to increase display performance and speed up screen refreshes. Optimize can be helpful with Physique when you work with complicated skin objects such as detailed biped figures.
There are stack update options that determine how the stack is updated. See the Physique Level of Detail rollout on page 5018 for a reference on the stack update options.

**WARNING** If the current stack update option is Reassign Globally, any modifier in the stack below Physique causes Physique to reevaluate vertex assignments each time the stack is changed. While this technique will improve performance in one way, it will hurt performance if you need repeatedly to make changes down in the stack.

### Procedures

**To optimize skin objects:**

1. Select the skin.
   - If the skin consists of multiple objects, select all of its component objects.
2. Apply an Optimize modifier to the skin.
   - The Optimize modifier's Parameters rollout appears on the Modify panel.
3. In the Optimize group of the Parameters rollout, increase the value of Face Threshold.
   - As you increase Face Threshold, Optimize reduces the number of faces in the mesh.

The optimized mesh displays more quickly and speeds up your work with Physique. However, it doesn't show full detail, and sometimes an optimized skin does not animate correctly, because of the reduced number of vertices.

**TIP** Always turn off Optimize before you render the animated skin.

### Scaling a Character

Using standard 3ds Max scale transform tools, you can adjust a biped's posture by scaling the size of its links. You must be in Figure mode to scale the biped links. If you try to scale a biped without going into Figure mode, nothing happens.
Procedures

To scale a biped that has a mesh attached to it by using Physique:

1. Select the biped.

2. On the Motion panel, on the Biped rollout, turn on Figure mode.

3. On the Structure rollout, change the biped’s height.
   The biped and mesh scale together.

To reinitialize a scaled mesh:

Reinitializing a scaled mesh might be necessary if you use Initial Skeleton Pose in Physique. In this case, the mesh appears at its size before scaling. To correct for this, perform the following steps:

1. On the Modify panel, either make Physique inactive, or highlight the skin so the active level is below the Physique modifier in the stack.

2. Scale and move the mesh until it matches the biped or bones.

3. Re-enable Physique, or highlight its name once more in the stack display.
   The mesh will get large because it is doubly scaled.

4. Reinitialize with Initial Skeleton Pose turned on.
   The mesh will shrink to the size you set during scaling.

Facial Animation

You can use Physique for facial animation, as an alternative to morphing. To do so, you must set up the face of a character with extra links. By setting up 3ds Max bones or other objects at appropriate locations on the mesh head, you can define a skeletal structure for moving the facial features.
Boxes form the facial skeletal structure.

You can also use splines linked to the biped head to deform the mesh. You can add a spline to a character that already has Physique applied by using Add in the Physique Bones rollout and clicking the spline in a viewport.
Splines used for detailed facial animation.

**Facial Bone Structure**

A common skeletal structure for the face includes:

- Bones to make the upper and lower lips open and close.
- Bones to push the outer corners of the mouth, as for a smile.
- Bones to make the eyes open and close.
- A bone to control the jaw opening and closing.
- The main head bone going straight up from the neck to the top of the head. This bone controls the head overall, and any vertices not affected by bones on the eyes, mouth and jaw. Use this bone to bend the head forward or backward.
**TIP** If you've never set up a facial bone structure before, refer to a text on character animation for information on the facial bones needed to create various expressions.

In general, the lower lip bones should be linked to the jaw, and upper lip, jaw and eye bones should be linked to the main head bone.

*Facial bone linkage*

If you use objects other than 3ds Max bones, you must create dummy objects at the end of each object used as a bone, and link each one to its corresponding bone before applying Physique. This is necessary because Physique extends links to the end of the second-to-last object in the hierarchy, not the last. In other words, if you don’t create and link the dummy objects to the bones, Physique will not extend links to the ends of the bones.
Dummy objects at ends of bones

Mesh objects that are to be animated along with the face, such as the eyes and hair, should not be linked to the bone structure until after Physique is applied. If you link them beforehand, Physique will treat them like bones. You can link these objects to the main head bone after you apply Physique.

Separate or Connected Head

There are two ways a setup like this could be used with a character body: The head could be attached to the body mesh, or it could be separate.

If possible, use a head that is separate from the body mesh. For human characters, this often works fine; most character animation doesn't provide a view of the underside of the neck, so your viewers will most likely never notice that they're separated. If you use a separate head, it will be easier to control the facial animation.

If you use a separate head, apply Physique to the head mesh alone. Click Attach to Node and pick the main head bone. Check the links to make sure they extend to the ends of the bones. Then, link the main head bone to the biped head.
If the character's head is connected to the mesh, link the main head bone to the biped head before applying Physique. Alternately, you can use the biped's head as the main head bone, linking the facial bones directly to the biped's head. When you apply Physique and click Attach to Node, pick the biped's COM as usual.

After applying Physique to the head or the entire structure, you can adjust envelopes and vertex assignments for the facial bones as you would for any biped bone.

**Animating the Facial Structure**

After you apply Physique to the structure, you can animate it by rotating or moving bones. 3ds Max [manipulators](#) on page 2861 are useful for setting up a custom user interface for bone animation.
Facial expressions animated with Physique and facial bones.

**TIP** Hierarchies other than bipeds can’t use Figure mode, so special consideration is needed to establish the initial skeletal pose. Position the facial bones in the “at rest” position at frame 0, and start keyframing the face at frame 1 or later.

You can perform lip sync animation by loading a sound track in Track View. By scrubbing the time slider, you can locate a sound and keyframe the dummies to appropriate positions.
Procedures

**To isolate lip vertices from influence by inappropriate links:**

When working with a complicated facial bone structure, envelopes for the lower lip are bound to affect vertices in the upper lip, and vice versa. In general, this can be corrected in at the Vertex sub-object level:

1. Select the head and on the Modify panel go to the Vertex sub-object level.
2. Turn on Initial Skeletal Pose.
3. Turn on Select, region-select vertices of the lower lip, then click Remove From Link.
4. Select the links of the upper lip, and click Lock Assignments.
5. Region-select vertices of the upper lip, and click Remove From Link.
6. Select links of the lower lip, and click Lock Assignments.

**Combining Physique with Other Modifiers**

Although you can apply Physique to an object with modifiers, this can affect performance. If you use other animated modifiers in combination with Physique, this reduction is unavoidable. If the other modifiers are not animated, you can collapse the stack to remove modifiers prior to Physique. This can significantly improve performance.

How Physique reevaluates vertices coming up the stack depends on the stack update options.

**Stack Update Options**

In Physique, there are three stack update options available from the Physique Level of Detail rollout on page 5018 to determine how Physique handles animated vertices coming up the modifier stack.

**Add Change**

Add Change adds in the changes from the stack and then applies mesh deformation. No vertex remapping or reassigning is done. This is the default option, and usually will give you the deformation that you want. There is no performance degradation from Physique.
**Remap Locally**

Remap Locally resets vertex position on the spline used for bending and the link position used to interpolate twist. Use this option when vertices are sliding along the length of the spline, and you want them to bend and twist based on the spline position but don't want the weights to change.

**Reassign Globally**

Reassign Globally does a complete vertex reassign for each frame. Use this option when vertices are moving to different envelopes and you want them reassigned to the new envelopes. This option should rarely be used. The only reason would be if vertices are sliding along a link and you want the twist to be interpolated based on the new position.

**Using Physique with Changing Geometry**

Physique can effectively handle dynamically changing geometry. That is, if the geometry coming through the modifier stack to Physique changes, Physique dynamically adjusts to accommodate the changes to the geometry, while maintaining its own parameter settings, including manual vertex assignments. This is why, when using Optimize, you can effectively change the resolution of the geometry deformed by Physique.

Only in situations where the changes dramatically increase the density of data is there ever a need to manually adjust vertex assignments. Physique remembers your manual vertex assignments, and uses these assignments to reassign vertices when the geometry changes.

**Physique and Free-Form Deformations (FFDs)**

You can apply Physique to a Free-Form Deformation (FFD) space warp, which in turn can animate a mesh that is bound to the FFD. For example, you could use this technique to animate a credit card or a box of cereal.

**Procedures**

**To apply Physique to an FFD to animate the entire mesh:**

1. Place an FFD (Box) space warp around the mesh to deform. The box should be large enough to encompass the mesh. The number of control points you use for the FFD can be fine-tuned later by going back down in the stack to the FFD to adjust the number of control points.
2 Select the FFD and apply the Physique modifier.

3 Click Attach To Node, and then click the biped pelvis or the root node of your bone structure.

4 If necessary, select the FFD space warp and adjust the vertex assignments of the control points so they are assigned to the proper links. This can be done in the same way as done using Physique with a mesh, only there are fewer assignments to deal with. Although fewer assignments provide smoother surface deformation with the FFD, control points and their link assignments must be thoughtfully placed.

5 Use Bind To Space Warp on the main toolbar to bind the mesh to the FFD space warp.

6 Link the mesh to the biped pelvis, or root node of the bone structure, so it follows the skeleton and FFD as they move around the scene.

To use an FFD to complement the effects of Physique on a portion of a character mesh:

TIP You can use this procedure to animate clothes or amorphous shapes.

1 Place an FFD (Box) space warp around the mesh to deform. The box should be large enough to encompass the mesh. The number of control points you use for the FFD can be fine-tuned later by going back down in the stack to the FFD to adjust the number of control points.

2 Select the FFD and the mesh and apply a Physique modifier to both.

3 Click Attach To Node and in a viewport, click the biped pelvis.

4 Select the mesh only, and add a Mesh Select modifier to the mesh above Physique in the modifier stack.

NOTE If you are using a NURBS model, use the NSurf Sel modifier (rather than Mesh Select) to select sub-object control vertices that lay inside the FFD lattice.

5 Go to the Vertex sub-object level (or Control Vertex), and select the set of vertices (or CVs) that lie inside the FFD space warp you are using.
6 While in Vertex sub-object level, bind the mesh to the FFD space warp. Now only the selected vertices or CVs will be affected by the FFD.

7 With the mesh selected, highlight the Physique level in the stack, and assign all vertices or CVs affected by the space warp as blue (rigid). These should be the same vertices or CVs selected in step 5, above.

8 Assign the rest of the vertices or CVs that fall outside the FFD as deformable, in the same way you normally assign vertices to links on page 5096 with Physique.

9 Select the FFD space warp. If necessary, adjust the vertex assignments of the control points so they are assigned to the proper links. You do this in the same way as you do when using Physique with a mesh, except there are fewer assignments to deal with. Although fewer assignments provide smoother surface deformation with the FFD, control points and their link assignments must be thoughtfully placed.

**Physique User Interface**

Select a mesh. > Modify panel > Modifier List > Physique.

Select a mesh that has the Physique modifier applied to it. > Modify panel > Floating Bones, Physique, and Physique Level of Detail rollouts

The main controls for the Physique modifier include the Physique and Floating Bones rollouts for attaching the mesh to the biped, splines, or bones. Additional controls in the Physique Level Of Detail rollout are for troubleshooting envelopes, bulges, and tendons. The sub-object controls are for fine-tuning envelopes, creating and adjusting tendons and bulges, and for vertex editing.

See also:

- Physique on page 4944

**Physique Rollout**

Select an object that has the Physique modifier applied to it. > Modify panel > Physique rollout
You use the buttons on the Physique rollout to link a mesh to a biped, a bones hierarchy, or a spline; to reinitialize the Physique parameters on a mesh; to open the Bulge Editor on page 5029; and to load or save Physique (PHY) files.

Procedures

To attach a mesh to a biped using Physique:

1. Select or create a biped.

2. Go to the Motion panel. On the Biped rollout, click to turn on Figure mode.

3. Position the biped inside your character mesh.

4. Select the mesh.

**IMPORTANT** If the mesh is made of multiple objects, select all of them.

5. Go to the Modify panel. Use the Modifier List to apply Physique to the mesh.

6. On the Physique rollout, click to turn on Attach To Node. In a viewport, select the biped's pelvis object. The **Physique Initialization dialog** on page 5024 is displayed.

7. Click Initialize, accepting the default settings.

   By default, the Object Bounding Box option is selected: Physique sizes envelopes to approximate the biped limbs.

8. Experiment with animating the biped, and adjust envelopes around problem areas. Use the Envelope sub-object level to edit the newly created envelopes.

To attach a mesh to a bones hierarchy using Physique:

1. Select or create a bones hierarchy.
2. Position the bones hierarchy inside the mesh.

**TIP** When you use a bones hierarchy with Physique, use frame 0 as your “figure mode.” Don’t include frame 0 in your animation. Use it as a place where you position the bones and fit them to the mesh.

3. Select the mesh.

4. Go to the Modify panel. Use the Modifier List to apply Physique to the mesh.

5. Click to turn on Attach To Node. In a viewport, select the root bone in the bones hierarchy. The Physique Initialization dialog displays.

6. Click Initialize, accepting the default settings.

7. Experiment with animating the bones, and adjust envelopes around problem areas. Use the Envelope sub-object level to edit the newly created envelopes.

**To add a bone after you’ve already used Attach To Node:**

1. Link the bone to the biped, then click Reinitialize.

2. Select the mesh, then go to the Modify panel. On the Physique rollout, click Reinitialize. The Physique Initialization dialog is displayed.

3. On the dialog, in the Initialize group at the upper left, click to turn on Initial Skeleton Pose. The toggle Include New Bone becomes available. Click to turn on Include New Bone, and then click Initialize.
To save Physique data:

1. With Physique active on the Modify panel, click Save Physique File on the Physique rollout. A file save dialog is displayed.
2. Enter a name for the new Physique file, and then click OK.

To load Physique data:

1. With Physique active on the Modify panel, click Open Physique File on the Physique rollout. A file open dialog is displayed.
2. Choose the Physique (PHY) file to open, and then click OK. A Physique Load Specification dialog is displayed.
3. Use the dialog to choose the kind of data to load, and then use the lists to match links in the PHY file with links in the scene.

**IMPORTANT** The number of links selected from the file (left column) must match the number of links in the active Physique modifier (right column).

4. Click OK. Physique updates the links you chose with the data that was saved.

**Interface**

- **Attach to Node** Attaches the mesh objects to the biped or to a bones hierarchy.
IMPORTANT  Put the biped in Figure mode and fit it to the mesh character before you click Attach To Node.

Turn on Attach To Node, then in a viewport, click the biped’s pelvis or the root node of a bones hierarchy.

NOTE  If you click a biped’s center of mass instead of its vertex, Physique corrects this by attaching to the pelvis instead.

After you select a node in the viewports, the Physique Initialization dialog on page 5024 is displayed. Accept the default values in this dialog, then click Initialize. Physique traverses the biped or bone hierarchy, and creates an envelope on page 5060 for each link it finds. (It can include additional bones that are linked to the biped.) The envelopes control Physique’s influence on the vertices of the mesh. When the hierarchy is animated, the mesh vertices move along with it.

Reinitialize  Displays the Physique Initialization dialog and resets any or all of the Physique attributes to the default values. For example, reinitializing on page 5026 with the Vertex Settings option selected reestablishes the relationship of a vertex and its original position relative to the Physique deformation spline. Settings for vertex-link assignments, bulges, and tendons can be reset from this dialog.

Bulge Editor  Displays the Bulge Editor on page 5029, which is a graphical alternative to the Bulge sub-object level for creating and editing bulge angles.

Open Physique File  Loads a saved Physique (.phy) file, which stores envelope, bulge angle, link, tendon, and vertex settings.

When you click Open Physique File to load a .phy file, the Physique Load Specification dialog on page 5044 is displayed. Select the links you want to import in the list on the left of the dialog, and apply them to the links you select in the list on the right of the dialog.

Any aspect of your Physique work can be loaded into any other character. You can choose from Link Settings, Bulges, Tendons, and Envelopes. You can also apply links from the file to differently named links in the current scene. For example, save and reload a .phy file to copy a bulge angle created on one character to a link on another character.
A bulge created on a bones hierarchy can be loaded and applied to Physique links created using a biped.

Loading a .phy file will not overwrite locked vertices. If you want to overwrite them, you must either go to the Vertex sub-object level and unlock them, or reinitialize and turn on the option Vertex - Link Assignments.

Save Physique File Saves a Physique (.phy) file, which contains envelope, bulge angle, link, and tendon settings.

Physique Level of Detail Rollout

Select an object that has the Physique modifier applied to it. > Modify panel > Physique Level of Detail rollout

Controls in the Physique Level Of Detail rollout not only optimize the viewports, but also affect the rendered result. The primary purpose of this rollout is for troubleshooting.

After you create bulge angles and tendons, you can turn off their influence to see exactly what they add to the deformation of the skin. This rollout also has controls for how changes in the modifier stack below Physique are handled.

Choose Deformable and turn on all its parameters during editing; this allows you to spot problem areas. Choose Rigid for the fastest viewport redraw.

Procedures

To troubleshoot bulges and tendons:

1. Select the mesh of a character that has bulges or tendons.

2. Go to the Modify panel.

3. On the Physique Level Of Detail rollout, in the Skin Update group, make sure Deformable is chosen.

4. Turn Bulges off, then on. Do the same with Tendons. Examine the mesh with and without the influence of bulges and tendons.
5 Use the Bulge Editor or the sub-object levels to adjust bulge and tendon settings.

**Interface**

- **Renderer** When chosen, settings in the Skin Update group affect rendered images.

- **Viewports** When chosen, settings in the Skin Update group affect viewports.
Skin Update group

**Deformable** When chosen, Physique deformation is active. Deformable yields the highest-quality rendering. The Deformable toggles are unavailable unless Deformable is chosen.

- **Joint Intersections** Turn off to remove joint intersection influence. Joint intersection influence allows the mesh to overlap itself; for example, at the elbow and knee joints. Default=on.
- **Bulges** Turn off to remove any bulge angle influence. Default=on.
- **Tendons** Turn off to remove any tendon influence. Default=on.
- **Skin Sliding** Turn off to remove skin sliding influence. Default=on.
- **Link Blending** Turn off to remove the influence of link blending. Default=on.

**Rigid** When chosen, forces all vertices to use Rigid assignments rather than Deformable. This is an easy way to isolate deformation problems. It also provides the quickest viewport redraw speed. You might choose this option while adjusting the animation of your skeleton.

- **Link Blending** Turn off to remove the influence of blending on rigid links. This toggle is unavailable unless Rigid is chosen. Default=on.

Stack Updates group

The controls in this group handle changes to vertex count that arise from (nonanimated) changes to the modifier stack.

If the vertex count changes, vertices are reassigned globally. Add Change adds in changes based on the vertices' initial position. The other options reset the initial position at each frame to do the remapping and reassigning. For this reason, turning on Add Change or making nonanimated stack changes should always be done at the initial position (Figure mode or frame 0).

- **Add Change** Adds in changes from the stack and then applies Physique deformation. No vertex remapping or reassigning is performed. Default=on. This option will generally give you the deformation you want. There is no performance penalty (from Physique) when this option is used.
- **Remap Locally** For deformable vertices, this resets the vertex position on the Physique deformation spline used for bending, as well as the link position used to interpolate twist. For rigid vertices, this option resets the link position used to interpolate twist. Default=off.
When vertices are sliding along the length of the spline and you want them to bend and twist based on the spline position, but don’t want vertex weights to change, turn this option on.

**Reassign Globally** Re-weights, and resets the position on the spline used for bending for moved vertices globally. The vertex link assignment, weighting, and spline position are reset for all moving points on every frame. (This is equivalent to Physique 2.2.) This option is like reinitializing on every frame. Default=off.

When vertices are moving to different envelopes and you want them reassigned to the new envelopes, use this option.

**Hide Attached Nodes** Toggles the display of the underlying skeletal system. This allows you to hide and unhide the biped, for example.

### Floating Bones Rollout

Select an object that has the Physique modifier applied to it. > Modify panel > Floating Bones rollout

“Floating” bones provide a way to use Physique without using a biped character. The Floating Bones rollout specifies the splines, bones hierarchy, or unattached bones you are using to deform a mesh. For example, Physique lets you animate a mesh by animating spline vertices or a bones system. When you attach the spline or parent bone to Physique, it creates envelopes for the selected spline or bones.

#### Procedures

**To have a spline influence a mesh:**

1. Create a spline and place it within a mesh that has Physique applied.

2. Select the mesh, and go to the Modify panel.

3. On the Floating Bones rollout, click Add.
   
   A Select Bones dialog is displayed.

4. Use the Select Bones dialog to select the spline.

5. Animate the spline vertices to animate the mesh.
**TIP** If you want to control the mesh by animating bones, follow the previous steps using bones instead of a spline.

**Interface**

Add Displays a Select Bones dialog so you can select splines or bones to use with Physique.

Reset Resets splines or bones in their initial position: Reset reassigns vertices, but leaves envelopes as is.

Delete To delete a spline or bone, click to highlight its name in the list, and then click Delete.

**Physique Shortcuts**

This topic summarizes the keyboard shortcuts for Physique.

Turn on the Keyboard Shortcut Override toggle on page 8420 to enable the character studio keyboard shortcuts.
All **character studio** keyboard shortcuts activate when the Motion panel is active and the Keyboard Shortcut Override button is active.

**See also:**
- [Keyboard Shortcuts](#) on page 8419
- [Keyboard Panel](#) on page 8250
- [Customize User Interface Dialog](#) on page 8249

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy Envelope</td>
<td>Ctrl+C</td>
<td></td>
</tr>
<tr>
<td>Delete</td>
<td>Ctrl+D</td>
<td></td>
</tr>
<tr>
<td>Next</td>
<td>PageDown</td>
<td></td>
</tr>
<tr>
<td>Next Selection Level</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>Paste Envelope</td>
<td>Ctrl+V</td>
<td></td>
</tr>
<tr>
<td>Previous</td>
<td>Page Up</td>
<td></td>
</tr>
<tr>
<td>Previous Selection Level</td>
<td>Shift+I</td>
<td></td>
</tr>
<tr>
<td>Reset Envelopes</td>
<td>Ctrl+E</td>
<td>Resets envelopes for selected links to their default values.</td>
</tr>
</tbody>
</table>

* Not available for customization in the Customize User Interface dialog.

**Physique Dialogs**

The topics in this section describe the support dialogs for Physique.
Physique Initialization Dialog

Select an object that has the Physique modifier applied to it. > Modify panel > Physique rollout > Click Attach to Node. > Select a root object in a viewport. > Physique Initialization dialog

Select an object that has the Physique modifier applied to it. > Modify panel > Physique rollout > Click Reinitialize. > Physique Initialization dialog.

Use the Physique Initialization dialog to specify link parameters and the type and size of envelopes to create for Physique links.

This dialog is displayed under two circumstances:

- When you apply Physique initially, using Attach To Node on the Physique rollout on page 5013 on the Modify panel.
- When you click Reinitialize on the Physique rollout.

Creating Physique Links and Envelopes for the First Time

When you use Attach To Node to attach the mesh to a skeleton for the first time, you can use parameters on the Vertex-Link Assignment rollout on page 5046 to specify envelope parameters. In most cases, the default parameters on the Vertex-Link Assignment rollout work well as a starting point for envelope type, envelope sizing, and blending between links.

Normally, you want deformable envelopes. Blending Between Links is set to N Links (a vertex can be influenced by all envelopes that overlap it). The Object Bounding Box option is chosen by default, and bases the size of the envelopes on the size of biped limbs or bone diameters.

Link Settings, Joint Intersections, and Cross Section Rollouts

Controls on these rollouts match those found in bulge sub-object on page 5080 and link sub-object on page 5068 and are used here to set default values. Unless you want to change the default settings for all link parameters and bulges, you do not need to change the settings in these rollouts.
Interface

**Physique Initialization**

- **Initialization**
  - Initial Skeleton Pose
  - Include New Bones
  - Link and Joint Settings
  - Bulges
  - Tendons
  - Vertex - Link Assignments
  - Vertex Settings

- **Link Settings**
- **Joint Intersections**
- **Cross Sections**
- **Vertex - Link Assignment**
  - Deformable
  - Rigid

**Blending Between Links:**

**Radial Falloff Envelopes**
- Create Envelopes
  - Object Bounding Box
  - Link Length
  - Overlap: 0.1
  - Smooth: 0.75
  - Falloff: 0.5

**Initialization group**

The Initialization check boxes are normally unavailable and not changeable during initialization. Although these options are unavailable, they are all turned on by default (except Include New Bones) for initialization, since all these settings are new when you use Attach To Node for the first time.

These check boxes become available when you click Reinitialize on the Physique rollout.
See Reinitialize Physique on page 5026 for a description of the controls in this group.

**Link Settings rollout**

The Link Settings rollout contains the default link values that will be assigned to all links. See Link Sub-Object on page 5068 for a command reference.

**Joint Intersections rollout**

The Joint Intersections rollout contains default joint intersection values that will be assigned to all links. See Link Sub-Object on page 5068 for a command reference.

**Cross Sections rollout**

The Cross Sections rollout on page 5048 sets the default Bulge Angle parameter settings for new bulges.

**Vertex-Link Assignment Rollout**

On the Vertex-Link Assignment rollout on page 5046 you can choose to create new envelopes and pick the type of blending between links.

---

**Reinitialize Physique**

Select an object that has the Physique modifier applied to it. > Modify panel > Physique rollout > Click Reinitialize.

The Reinitialize button on the Physique rollout is used mainly for resetting a particular attribute of your character's skin behavior. Among common uses are resetting bulges, deleting tendons, reassigning vertex-link assignments, or repositioning the biped relative to the attached mesh. Essentially, you can reinitialize to reset any single item in the Initialization group, or all items.

The toggles in the Initialization group of the Physique Initialization dialog are available only when you click Reinitialize.

**Reinitializing Old Files**

Files from versions of character studio prior to character studio go through a semi-automatic Physique reinitialization process. When you load an old file
that uses Physique, you’re prompted to put the biped or bones system into Figure mode or in the initial position, and then reinitialize. To reinitialize, select the mesh, open the Modify panel, and click Reinitialize. A dialog warns you to put the skeleton into the initial position. Click OK to reinitialize, and save the file after you have done so.

See also:

- Physique Initialization Dialog on page 5024

Interface

![Physique Initialization Interface](image)
Initialization group

**Initial Skeleton Pose** Uses the current hierarchy position (for example, the biped pose) as the default pose for defining how the skeleton fits inside the skin. The current pose becomes the new initial pose, replacing the pose used when you first attached the mesh to the biped. Default=off.

**NOTE** This toggle does not reassign vertices that you reassigned manually unless you also turn on Vertex-Link Assignments.

When using Physique with a biped, turn on Initial Skeleton Pose if you want to use Figure mode to reposition the biped relative to the mesh; for example, to reposition the biped shoulder joints. It is helpful first to turn off the Physique modifier, using the lightbulb icon in the modifier stack display. This lets you use Figure mode to scale and rotate the biped limbs independent of the mesh skin. Use this option after you scale a character (see Scaling a Character on page 5002).

**Include New Bones** Creates new links for any new object (bone) linked to the biped. Use this to add a bone to a mesh that has the Physique modifier applied. This toggle is unavailable unless Initial Skeleton Pose is on. Default=off.

**Link and Joint Settings** Resets link parameters and joint intersection parameters to their default values. Link parameters include Bend, Twist, Sliding, and Radial Scale values. For Radial Scale, this includes Scale, Amplitude, Stretch, and Breath. Default=off.

When this option is on, you can set new default values in the **Link Settings rollout** on page 5070 and the **Joint Intersections rollout** on page 5077.

**Bulges** Resets bulge angles to the default values. By default, one bulge angle is created per link. Turning on Bulges deletes any new bulge angles you might have created. Default=off.

When this option is on, you can set new default values for cross sections in the **Cross Sections rollout** on page 5048.

**Tendons** Resets tendons to the default values. Turning on Tendons deletes any tendons you might have created. Default=off.

**Vertex-Link Assignments** Re-evaluates which vertices fall within each envelope. (This can vary from the original default settings, depending on whether you have made changes to the envelopes.) Turning on Vertex-Link assignments also removes any custom vertex assignments. Turn on Vertex-Link Assignments if you want to replace all manual vertex reassignments with the default vertex assignments. Default=off.
When this option is on, you can set new default values in the Vertex-Link Assignment rollout on page 5046.

**Vertex Settings** Recalculates vertex parameters at the link to which each vertex is assigned. Turning on Vertex Settings does not reassign manually reassigned vertices. Use this option when you have changed the link parameters and want to recompute the vertex parameters based on these changes. This check box is automatically turned on if you turn on either Initial Skeleton Pose or Vertex-Link Assignments. Default=on.

**Bulge Editor**

Select an object that has the Physique modifier applied to it. > Modify panel > Physique rollout > Click Bulge Editor.

Creating and editing cross sections allows you to "bulge" the mesh. The Bulge Editor is an alternative to using the Bulge sub-object level to create and edit bulge angles. The difference is that the Bulge Editor allows you to create, select, and edit cross sections in schematic Cross Section and Profile views. Using the Bulge sub-object level, creating and editing bulge angles takes place in the viewports. All of the parameter changes you make in the Bulge Editor are also reflected on the mesh in the viewports.

On the Modify panel, you access the Bulge Editor from the Physique rollout on page 5013, from the Bulge rollout at the Bulge sub-object level on page 5080, or from the Link Settings rollout at the Link sub-object level.

**NOTE** The Bulge Editor works exclusively with bulge angles. To create and edit Tendons, use the Tendons sub-object level on page 5090.

**Using an Animation to Preview Limb Orientations**

For easier creation of bulge angles, you should create a simple animation that moves the limb into extreme orientations. In the case of the human arm, you might set keyframes with the arms down against the body; extended to the sides; bent at the elbows; and finally, more relaxed with the hands touching the shoulders. By scrubbing the time slider, you can easily choose one of many intermediate or extreme orientations. This saves time when you create Bulge Angles, because you won't need to exit Physique to manipulate the skeleton to change the orientation of the mesh. You can create and set multiple Bulge Angles without ever leaving the Bulge Editor or Bulge sub-object level.
Procedures

To create a new bulge angle using the Bulge Editor:

1. Click the Bulge Editor button at the top level of the Physique modifier, or at the Link or Bulge sub-object level. The Bulge Editor is displayed.

   **TIP** Accessing the Bulge Editor at the Bulge sub-object level provides the added benefit of letting you work in either the Bulge Editor or the Bulge rollout interchangeably.

2. In a viewport, click to select a link.

3. On the Bulge Editor toolbar, click Insert Bulge Angle. Physique creates a new bulge angle. The number of the bulge angle name in the Current Bulge Angle field increments.

4. Type a descriptive name in the Current Bulge Angle field.

   **TIP** It is a good idea to change the color of the newly created bulge angle. Do this by clicking Bulge Angle Color at the Bulge sub-object level, and selecting a color with the Color Selector.

5. If no appropriate cross sections exist, then on the Bulge Editor toolbar, click Insert CS Slice. Click the Profile view to create and position a cross section. The cross section is created at the location you clicked.

6. In the viewports, rotate the joint to the desired angle.

   This is most easily done by creating a preview animation, as described in Using an Animation to Preview Limb Orientations on page 5029: just move the time slider to a frame that has the angle you want. Otherwise, you will have to exit the Bulge sub-object level, select the appropriate limb, and rotate it. For example, to bulge the biceps on a biped, you might rotate the biped forearm to ninety degrees.

7. “Bulge” the mesh by editing cross section control points using the Bulge Editor's Cross Section view.
As you scale or move control points in the Cross Section view, the mesh "bulges" in the viewports.

8 On the Bulge Editor toolbar, click Set Bulge Angle on the Bulge Editor toolbar. Physique saves the current angle of the joint.
When the joint angle is reached, the mesh bulges. By default, Physique creates one bulge angle when it is first attached to the mesh. So to make an arm or leg that bulges when biped joints are rotated, you need to create and set only one additional bulge angle.

To change a bulge angle value:

1 On the Bulge Editor, make sure the bulge angle you want to reset is displayed in the Current Bulge Angle field.

2 In a viewport, change the angle between the active link and its child link.
  Rotate a biped limb or use the time slider to move to a frame that has the limb rotated correctly.

3 On the Bulge Editor toolbar, click Set Bulge Angle.
The angle of the joint is set for the displayed bulge angle. When the biped limb rotates to this angle, the mesh bulge effect is at full strength.

To choose a specific bulge angle for editing:

1 Expand the Current Bulge Angle drop-down list (click the downward pointing arrow at its right).
The full list of bulge angle names appears.

2 Click the name of the bulge angle you want to edit.
The Bulge Editor’s Cross Section and Profile views update to show the cross sections associated with the newly selected bulge angle.

To delete a bulge angle:

1 Expand the Current Bulge Angle drop-down list (click the downward pointing arrow at its right).
The full list of bulge angle names appears.

2 Click the name of the bulge angle you want to delete.
3 On the Bulge Editor toolbar, click Delete Bulge Angle.

**NOTE** You can’t delete the default bulge angle: a link must always have at least one bulge angle defined.

**To add a cross section:**

1 On the Bulge Editor, make sure that the bulge angle you want to edit is displayed in the Current Bulge Angle field.

2 On the Bulge Editor toolbar, turn on Insert CS Slice.

3 In the Profile view, click the link at the point where you want the cross section to be added.
   The cross section is created at the location you clicked.

**TIP** You can also add cross sections to the child link.

**To delete a cross section:**

1 In the Profile view, click to select a cross section.
   The selected cross section turns red.

2 On the Bulge Editor toolbar, click Delete CS Slice.

**NOTE** You cannot delete the default cross section at the joint between the link and its child.

**To make a cross section the active cross section:**

- In Profile view, click a cross section to select it.
  The selected cross section displays in Cross Section view. You can change its shape by selecting and editing control points in Cross Section view. This will bulge the mesh at the location of the cross section.
To select multiple cross sections:

You can change parameters for multiple cross sections by selecting them and then adjusting parameters in the Cross Sections panel on page 5042.

1. On the Bulge Editor toolbar, turn on Select And Translate CS.
2. In Profile view, click to select a cross section.
3. Select additional cross sections by doing one of the following:
   - Use Ctrl+click to add cross sections to the selection.
   - Drag a rectangular region in the Profile view. All cross sections that the region surrounds or crosses are selected.

   **TIP** Use Alt+click to remove a cross section from the selection.

To move cross sections along the link:

Moving a cross section repositions where on the mesh a bulge occurs.

1. Select the cross sections to move.
2. On the Bulge Editor toolbar, click Select And Translate CS.

   **TIP** If you are moving a single cross section, you can skip step 1 and click the cross section after you click Select And Translate CS Slice.

3. Drag left or right in the Profile view to move the cross section (or cross sections) left or right.

   **NOTE** You cannot move cross sections through each other.

To copy and paste cross sections:

1. Select the cross section to copy.
2. On the Bulge Editor toolbar, click Copy Selected CS.
3. Select a cross section to paste over.
4 On the Bulge Editor toolbar, click Paste Selected CS. The cross section you pasted now has the shape of the cross section you copied.

**NOTE** You can copy a cross section and paste it to a similar cross section on another link. Create a bulge angle and an appropriate cross section on the target link before pasting. If necessary, use Mirror Selected CS after pasting.

To change the shape of a cross section:

1 In the Profile view, click to select a cross section.

2 In the Cross Section view, use the transform tools to move, scale, or rotate the cross section’s control points.
   - You can also add or delete cross section control points.
   - You can also use freehand drawing to add control points.

To change the Profile view orientation:

1 In the Cross Section view, move the cursor to the outer end of the orientation bar. The cursor changes to a shape like the Cross Section view.

2 Drag to rotate the orientation bar. When you release the mouse, the Profile view updates to show the profile at the angle of the orientation bar.
Interface

![Image of Physique Bulge Editor window]

Toolbar

- **Select, Scale, and Rotate Control Points** Lets you select, scale, and rotate control points of a cross section in the Cross Section view. This is comparable to using the Move transform on geometry in viewports. Control points are simultaneously scaled and rotated around the link, which in effect "moves" them.

  Select a cross section in the Profile view first. Then select and move control points in the Cross Section view to change the bulge.

- **Select and Rotate Control Points** Lets you select and rotate control points in and around the center of the link in Cross Section view. This does not twist the mesh. If the cross section is not a circle, a bulge migrates around the mesh.

- **Select and Scale Control Points** Lets you select and scale control points about the link's center in the Cross Section view. If all cross section control points are scaled, the mesh bulges uniformly.

- **Draw Control Points** Lets you add control points by drawing freehand in the Cross Section view. The shape of the bulge changes based on the shape you draw.
In the Cross Section view, you can draw the cross section interactively, placing control points at each resolution step. You can freeze existing control points by selecting them in the Cross Section view and holding down the Ctrl key as you draw.

NOTE The number of control points created depends on the cross section Resolution (see Cross Sections panel on page 5042).

TIP You can also use this too in Profile view. When you draw in Profile view, you change the profile of the bulge while placing a control point on each cross section of the bulge angle. This is useful mainly when the bulge angle uses multiple cross sections. You can rotate the orientation bar to draw whichever profile you desire. (Imagine the Cross Section view being like drawing around the arm, and the Profile view like drawing along the length of the arm.)

Insert Control Points Lets you insert control points by clicking the cross section in the Cross Section view. A single control point is created each time you click.

Adding control points and changing their position lets you sculpt the cross section and control exactly where a bulge occurs on the mesh.

Delete Control Points Deletes control points. First select the control points in the Cross Section view, and then click this button.

Previous Link and Next Link Move to the next or previous link in the hierarchy. The Cross Section and Profile views update to display the appropriate bulge geometry.

IMPORTANT Profile view displays the parent link on the left and the child link on the right.

Mirror Selected CS Mirror the cross section across the vertical plane running between the green profile reference points at the top and bottom of Cross Section view. In other words, clicking this button causes the bulge to appear on the opposite side of the link.
Select and Translate CS  Lets you select and move a cross section along its link. The bulge on the mesh migrates up and down the link as the cross section is moved.

Insert Cross Section Slice  Lets you insert a cross section by clicking Profile view in the location you want the cross section to appear. A new cross section is created where you clicked, on either the parent or the child link.
Extra cross sections give you more control of how and where the mesh bulges.

Delete Cross Section Slice  Deletes the currently selected cross section. First, select the cross section in Profile view.

Copy Selected CS  Copies the selected cross section.
You can copy a cross section from one link to another link. Create a new bulge angle with an appropriate cross section in the target link first, then copy the cross section parameters form the source cross section, select the target cross section, and click Paste Selected CS.

Paste Selected CS  Pastes copied cross section parameters onto another cross section.
First, select a cross section in Profile view, and click Copy. Then select another cross section in the Profile view, and click Paste.

Set Bulge Angle  Associates the effect of the current bulge angle with the skeleton's current joint angle.
First, set the joint to the orientation at which you want the bulge to appear, then click this button. During animation, whenever the joint rotates near this angle, the mesh will bulge.

Insert Bulge Angle  Adds a new bulge angle for the selected link.
The Current Bulge Angle field displays a bulge angle name with the number incremented. You can enter a descriptive name for any new bulge angle; for example, Arm at 90.
By default, one initial bulge angle is created when Physique creates links. Only one additional bulge angle will allow you to bulge the mesh. You can create more bulge angles for further control, if you like.
Delete Bulge Angle  Deletes the current bulge angle. The current bulge angle displays in the Current Bulge Angle field.
First select a bulge angle in the Current Bulge Angle dropdown, and then click Delete Bulge Angle.

Select Nearest Bulge Angle  When on, selects the bulge angle nearest to the current joint angle.
If a joint bends over time, you can use this button in conjunction with the time slider to select a bulge angle. If you play the animation, you can see the Current Bulge Angle field change to reflect the bulge angle nearest to the current angle of the selected link and its child (if two or more bulge angles for the limb exist).

Current Bulge Angle field and drop-down list  Displays the current bulge angle. You can choose a bulge angle from the drop-down list to edit the bulge or change its name. To change the name, simply enter a new one in the edit field.

TIP When you create a bulge angle, give it a descriptive name.

When you create a new bulge angle by clicking Insert Bulge Angle, this field displays the default bulge angle name, which is the previous name with its sequence number incremented.

Cross Section view

Cross Section view displays an outline of the active cross section. In Profile view on page 5040, the active cross section is shown in a bright red color. In Cross Section view, you can edit cross sections to bulge the mesh.

NOTE It is possible to select multiple cross sections in Profile view using either a rectangular selection region or Ctrl-click. This allows you to enter settings on the Cross Sections panel on page 5042 for all selected cross sections at once. Only one active cross section, however, can be viewed and edited in Cross Section view. (Selected but inactive cross sections are shown in a dark red color in the Cross Section and Profile views.)
These are the elements of the cross section display:

**Gray square at center** Represents the link at the center of the cross section.

**Control points** When unselected, are shown as small black crosses on the control spline. When selected, they are shown as black squares with a white center.

**Resolution lines** Display as gray lines that surround the link radially. Control points snap to these lines as they are positioned.

You can increase or decrease the resolution by changing the Resolution setting. This control is on the Bulge rollout in Bulge Sub-Object. The Cross Section view, however, always displays 36 resolution lines.

**Red line** The control spline for the active cross section. The shape of the spline determines where mesh deformation occurs.

**Green line** Represents actual mesh deformation. (Typically this is less exaggerated than the control spline.)

When you drag the time slider or play an animation, this updates according to the angle of the limb and the bulge angle parameters.

**Orientation bar** The bright yellow radius indicates the orientation of the “slice” shown in profile view. Profile view always shows a vertical profile of Cross Section view, indicated by the green dots at the top and bottom of the
Profile view

Use Profile view to select, move, and copy cross sections on the selected link and its child. Highlight a cross section in Profile view to display and edit it in Cross Section view on page 5038.

Profile view is a schematic profile of two links. The currently selected link is on the left, and its child link is on the right. If the selected link is an end link, the outline of the right half of the Profile view turns gray.

Cross sections are shown as vertical bars across the profile. The active cross section is red. Unselected cross sections are white. Cross sections that are selected but not active are dark red.

You can use a rectangular selection region or Ctrl+click to select multiple cross sections. Although only one cross section at a time is active in Cross Section view, you can use the Cross Sections panel on page 5042 to change parameters for multiple cross sections.

Profile view shows a profile of the bulges you create. As in Cross Section view, the control spline is red and the deformation spline is green.
The profile is always a vertical profile of the Cross Section view. You can drag the orientation bar in Cross Section view to change the angle of the profile.

To insert a new cross section, turn on Create CS Slice and then click Profile view to set the cross section's location.

You can use the Draw tool in Profile view to change the control spline by freehand drawing. Drawing updates the cross section shapes.

**Bulge Angles panel**

At the right of the Bulge Editor are two panels for setting parameters. Use the Bulge Angles panel to change bulge settings for the currently active bulge angle.

**NOTE** These parameters are the same as those in the Bulge Angle Parameters group on the Bulge rollout at the Bulge sub-object level. Changing a value in one location changes it in the other.

**Influence** The range of angles through which the bulge influences the skin. Range=0 to 180. Default=90 degrees.
For example, if you’ve set a bulge angle for the joint at 90 degrees, an Influence value of 40 means that the bulge effect begins to appear when the rotating joint reaches 50 degrees (90 minus 40) or 130 degrees (90 plus 40).

**Power** Controls how smoothly or abruptly the bulge takes effect. At 0, the bulge takes effect immediately, without interpolated easing. As values increase, the bulge eases in gradually. A value of 10 will bulge the mesh abruptly when the set angle is reached. Range=0 to 10. Default=2.5.

**Weight** Increases the effect of the current bulge angle relative to the effect of any other bulges. Range=0.0 to 100.0. Default=1.0.

**Cross Sections panel**

At the right of the Bulge Editor are two panels for setting parameters. Use the Cross Sections panel to change the cross section settings for a particular link.

**NOTE** These parameters are the same as those in the Cross Section Parameters group on the Bulge rollout at the Bulge sub-object level. Changing a value in one location changes it in the other.

![Cross Sections](image)

**Cross Sections** Click to display the Cross Sections panel.

**Sections** Sets the number of cross sections for the selected link.
**TIP** Rather than manually inserting cross sections in Profile view, use Sections to create cross sections. For a thigh or biceps bulge, you might need only one additional cross section in the middle of the link.

Above: Sections=1

Below: Sections=8

**Divisions** Sets the number of control points on the selected cross sections. By default, control points are evenly distributed around the cross section control spline.

Above: Divisions=4

Below: Divisions=8

**Resolution** Sets the number of radial divisions around the cross section. Control points snap to the nearest resolution line.

** Entire Link** When on, selects all cross sections for all bulge angles in the selected link. Use this to globally change parameters for all cross sections on a link.
Entire Link also affects Copy Selected CS and Paste Selected CS. While Entire Link is on, Copy Selected CS copies all cross sections for all bulges, and Paste Selected CS pastes all cross sections for all bulges. Entire Link is useful for copying all the bulges from one arm or leg to another.

**NOTE** When you turn on Entire Link, a number of toolbar controls, including the Current Bulge Angle name field, become unavailable. On the Bulge rollout at the Bulge sub-object level, the Current Bulge Angle changes to read “Entire Link.”

**Physique Load Specification Dialog**

Select an object that has the Physique modifier applied to it. > Modify panel > Physique rollout > Click Open Physique (.phy) File. > Choose a file. > Physique Load Specification dialog

This dialog appears after you have chosen a Physique (.phy) file to load. It lets you specify which information you want to obtain from the file.
Interface

At the upper left of the dialog are check boxes that let you specify which kind of data to load. Turn off a check box to avoid loading that kind of data.

**Link Settings** Loads link parameters. Default=on.

**Bulges** Loads cross sections and bulge angles. Default=on.

**Tendons** Loads tendons. Default=on.

**Envelopes** Loads envelopes. Default=on.

**Locked Vertices** Loads locked vertices.

**All Links** Selects all links to load.

This button is enabled only if the number of saved links equals the number of open links. Click to select all links in both lists. If All Links is disabled, you must choose links by hand. Click the name of a link in a list to select it. Before
you click OK, the number of links to load must equal the number of links to update.

**No Links** Deselects all links in both lists. After deselecting all links, you must select the links to load and to update, before you click OK.

**Selected Links From File and Selected Links In Modifier** At the left of the dialog is a list of the links that were saved in the file, and at the right is a list of links in the currently open Physique skin and skeleton. You can choose which links to update with the saved data.

### Physique Initialization Rollouts

The topics in this section describe rollouts that appear on the Physique Initialization dialog.

### Vertex-Link Assignment Rollout

Select an object that has the Physique modifier applied to it. > Modify panel > Physique rollout > Click Attach to Node. > Select a root object in a viewport. > Physique Initialization dialog > Vertex-Link Assignment rollout

Select an object that has the Physique modifier applied to it. > Modify panel > Physique rollout > Click Reinitialize. > Physique Initialization dialog > Vertex-Link Assignment rollout

On the Vertex-Link Assignment rollout, you can choose to create new envelopes and pick the type of blending between links.
**Interface**

Deformable  Creates deformable envelopes for the links. Default=chosen. Deformable envelopes determine vertex-link assignment based on the deformation spline that Physique creates through the links.

Rigid  Creates rigid envelopes for the links. Default=not chosen. Rigid envelopes determine vertex-link assignment based upon the linear links in the hierarchy.

**Blending Between Links** This drop-down list lets you choose how links are initially blended. Default=N Links.

**TIP** Typically, you should leave this set to the default of N Links.

- **N Links**  Vertices are influenced by all overlapping envelopes.
- **No Blending**  Vertices are influenced by only one (1) link. This allows a mesh with the Physique modifier applied in **character studio 1** to work with **character studio 3**. Choose No Blending if you are developing characters for a game engine that doesn't support blending, or if you intend to use strictly **character studio 1**-style vertex-link assignments.

- **2, 3, or 4 Links**  Vertices are influenced by more than one link, but the number of links is limited to 2, 3, or 4, depending on your choice. Choose one of these options if you are developing characters for a game engine whose support of blending is limited.

### Radial Falloff Envelopes group

- **Create Envelopes**  When on, creates envelopes for the links. When off, envelopes are not created. Default=on.

---

**NOTE**  With no envelopes, you have to use hand-weighting for vertices. If you want to add envelopes when a model has none, reinitialize Physique.

- **Object Bounding Box**  Envelope size is based on the size of objects in the hierarchy, such as biped limbs, or bones.

- **Link Length**  Each envelope has a Radial Scale that is one-third of the length of the link.

- **Overlap**  Sets how far the envelopes overlap. Default=0.1.

- **Smooth**  Sets the distance between the inner and outer bounds of an envelope by scaling the outer boundary. Range=0.0 to 10.0. Default=0.75.

- **Falloff**  Sets the rate of falloff between the inner and outer boundary of an envelope. The falloff rate is a Bezier function. Range=0 to 10. Default=0.5.

### Cross Sections Rollout

Select an object that has the Physique modifier applied to it. > Modify panel > Physique rollout > Click Attach to Node. > Select a root object in a viewport. > Physique Initialization dialog > Cross Sections rollout

Select an object that has the Physique modifier applied to it. > Modify panel > Physique rollout > Click Reinitialize. > Physique Initialization dialog > Cross Sections rollout
The Cross Sections rollout lets you globally set how cross sections are initialized.

**Interface**

![Cross Sections Rollout](image)

**Number** Sets the initial number of cross sections per link. Default=2.

**Control Points** Sets the initial number of control points per cross section. Default=4.

**Radial Snap** Sets the initial number of snap positions per cross section (this is the value labeled “Resolution” in the Bulge Editor on page 5029 and at the Bulge sub-object level on page 5080).

**Sub-Object Options Dialogs**

The topics in this section describe support dialogs for Physique sub-object levels.

**Blending Envelope Display Options Dialog**

Select a mesh that has the Physique modifier applied to it. > Modify panel > Envelope sub-object level > Blending Envelopes rollout > Display group > Click Display Options.

This dialog lets you customize how Physique displays envelope blending at the Envelope sub-object level.
Interface

**NOTE** All check box settings except Control Points are on by default.

**Selected Deformable Envelope and Selected Rigid Envelope groups**

These two groups have the same controls. By default, deformable envelopes are shown in red, and rigid envelopes are shown in green.
Inner Envelope The check box toggles viewport display of inner envelopes. Click the color swatch to change the viewport color of the inner envelope boundary.

- **Sides** Sets the number of inner envelope sides shown in the viewport display.

Outer Envelope The check box toggles viewport display of outer envelopes. Click the color swatch to change the viewport colors of the outer envelope boundary.

- **Sides** Sets the number of outer envelope sides shown in the viewport display.

Weighted Vertices The check box toggles viewport display of weighted vertices. Click a color swatch to change viewport colors of weighted vertices in a particular percentage range.

**Selected Envelope Cross Sections group**

Cross Sections Toggles viewport display of cross sections. Click the color swatch to change the viewport color of selected cross sections.

Control Points Toggles viewport display of control points. Click the color swatch to change the viewport color of selected control points.

---

Bezier Patch Handles Click to set the viewport color of Bezier patch handles.

**Exclude Envelopes Dialog**

Select an object that has the Physique modifier applied to it. > Modify panel > Bulge sub-object level > Select an envelope. > Blending Envelopes rollout > Edit Commands group > Click Exclude.

At the **Envelope sub-object level** on page 5060, this dialog lets you exclude links from influencing other links. For example, you can exclude the right thigh link from influencing the left thigh link. Or, rather than scale the index finger envelopes to avoid influencing middle finger vertices, you might exclude the middle finger links from the index finger links.

**TIP** You can leave this modeless dialog open while you choose links in the viewports.
NOTE: If you have a Physique model created with character studio 1 or 2, excluding links will not work until you reinitialize Physique on page 5026 using the initial skeleton pose. In the Physique Initialization dialog, make sure Vertex-Link Assignments is turned on.

Interface

**Link Envelopes list (left side)** Displays the links available for exclusion. Selected links are not in this list.

**Exclude Envelopes for Selected Link list (right side)** Displays envelopes to exclude from the current link selection. The text field displays the name of the selected link, or “Multiple Links Selected.”

**Right arrow** Select links in the Link Envelopes List on the left, then click the right arrow to add them to the Exclude Envelopes For Selected Link list on the right.
Left arrow Select links in the Exclude Envelopes For Selected Links list on the right, then click the left arrow to remove them from the exclusion list.

Display Subtree When on, the Link Envelopes list increments links according to their level in the hierarchy. This visual aid can help you to find and select links. Default=off.

Clear Clears all links from the Exclude Envelopes For Selected Link list.

**Bulge Angle Display Properties Dialog**

Select a mesh that has the Physique modifier applied to it. > Modify panel > Bulge sub-object level > Bulge rollout > Display group > Click Display Options. This dialog lets you customize how Physique displays bulge angles at the Bulge sub-object level.
Interface

**Bulge Angle Display group**

*Sides* Specifies the number of sides the bulge angle envelope displays in the viewports. Default=4.

*Scale* Specifies the scale of envelope display in the viewports. Default=1.1.

*Default Color* Click to change the bulge angle envelope color in viewports.

**Active Viewport Display group**

*Selected Cross Sections* The check box toggles the display of selected cross sections. Default=on.

Click the color swatch to change the color of selected cross sections displayed in viewports.
**Selected Control Points** The check box toggles the display of selected control points. Default=on.
Click the color swatch to change the color of selected control points displayed in viewports.

**Orientation Bar** The check box toggles the display of the orientation bar. Default=on.
Click the color swatch to change the color of the orientation bar displayed in viewports.

**NOTE** The orientation bar is displayed in the viewports when the Bulge Editor is open.

**Profile** The check box toggles the display of the profile. Default=on.
Click the color swatch to change the color of the profile displayed in viewports.

**NOTE** The bulge profile displays in the viewports when the Bulge Editor is open.

**Tendon Display Options Dialog**

Select a mesh that has the Physique modifier applied to it. > Modify panel > Tendons sub-object level > Tendons rollout > Display group > Click Display Options.

This dialog lets you customize how Physique displays tendons at the Tendons sub-object level.
Interface

**Tendon Cross Sections** The check box toggles the display of tendon cross sections. Default=on.
Click the color swatch to change the color of tendon cross sections displayed in viewports.

**Tendon Attach Points** The check box toggles the display of tendon attach points. Default=on.
Click the color swatch to change the color of attach points displayed in viewports.

**Tendon Attached Links** The check box toggles the display of attached links. Default=on.
Click the color swatch to change the color of attached links displayed in viewports.

**Selected Tendon Elements group**

**Cross Sections** Click to change the viewport color of selected cross section.
Attach Points  Click to change the viewport color of selected attach points.

Attached Links Click to change the viewport color of selected attached links.

**Type-In Weights Dialog**

Select a mesh that has the Physique modifier applied to it. > Modify panel > Vertex sub-object level > Vertex-Link Assignment rollout > Vertex Operations group > Click Select by Link. > Click a link in a viewport. > Lock Assignments > Click Type-In Weights.

Lets you enter a weight for selected locked vertices. To use this dialog, select one or more vertices, then lock them, click Type-In Weights to display the Type-In Weights dialog, use the lists in the dialog to select a link, and then change the weight to that link in order to position the vertices (vertex positions update in viewports as the weight changes).

**NOTE** You'll primarily use Type-In Weights to correct flaws on low- to medium-resolution meshes. On a high-resolution mesh, adjusting envelopes should be used to correct deformation.

**TIP** Adjust weights for stubborn vertices that fall in blended regions between two or more envelopes. Subtle adjustments can be made to the vertex weights of specific links that would be difficult to achieve by adjusting envelopes alone.
Interface

**Link Name** Use the drop-down list to select a link and display the vertex weight to that link.

**Currently Assigned Links Only** When chosen, displays only those links that presently influence the selected vertices.

**All Links** When chosen, displays all available links.

**Weight** Displays the vertex weight for the active link (the link currently displayed by the Link Name list). Use the spinner to change the weight value, if necessary.

**Absolute** Uses an absolute value for vertex weight.

**Normalized** This option is unavailable in character studio.
**Relative Scale** Uses relative values for vertex weights.
This is the mode of choice when you work on multiple vertices. If a particular link is not having a strong enough effect on the selected vertices, you should lock them, open the Type-In Weights dialog, select the link, and choose Relative Scale. Then you can enter relative values in the Weight field. For example, entering **1.0** leaves weights the same, while entering **2.0** would double the effect of the selected link on the selected vertices.

**List of links** Displays a list of links, with weight values at the right. The weight field is blank when it displays absolute weights. (When more than one vertex is selected, each is likely to have a slightly different weight.) Click a link in this list to select it.

---

**Physique Sub-Objects**

Select an object that has the Physique modifier applied to it. > Modify panel
> In the modifier stack display, expand the Physique sub-object hierarchy.

The Physique modifier has five different sub-object levels. Each kind of sub-object has various controls.

[Diagram of Physique sub-objects]

- **Envelope** on page 5060
  Envelopes define a link's area of influence on mesh vertices.

- **Link** on page 5068
  Links are the segments of the Physique deformation spline on page 5069. Link sub-object controls adjust the way link movement affects the mesh.

- **Bulge** on page 5080
  Bulge controls are for creating flexing muscles.

- **Tendons** on page 5090
  Tendons provide a way for multiple links to affect an area of the mesh.

- **Vertex** on page 5096
For Physique, Vertex controls let you fine-tune the influence of envelopes.

**Physique Selection Status Rollout**

This rollout appears for all of the Physique sub-object levels. For all levels except Vertex, it shows the name of the hierarchy object associated with the active link. For the Vertex sub-object level, it prompts you to “Select Vertices” unless Select By Link or Assign To Link is active, in which case it displays the name of the hierarchy object associated with the active link, as it does at other sub-object levels.

**Envelope Sub-Object**

Select an object that has the Physique modifier applied to it. > Modify panel > Bulge sub-object level

Use Envelope sub-objects to adjust the way skin behaves. Each link has an envelope, and the shape of the envelope determines which vertices are affected by the link's movement. An envelope has an inner and an outer bound: outside these bounds, vertices are not effected. Inside these bounds, the envelope's influence is strongest at the inner bound. A Falloff setting lets you control how quickly influence falls as it approaches the outer bound.

Envelopes also control blending: they provide smooth deformation of the skin across joints. Vertices that fall between overlapping envelopes receive influence from each, thus creating a smoothly blended transition. The outer bounds of the envelopes of adjacent links should overlap enough to provide a smooth blend at the joints. You can adjust the relative strength of envelopes, giving one link's envelope more influence than another.

At the Envelope sub-object level, in addition to the settings already mentioned, you can adjust an envelope's Radial Scale. This is useful for making sure the envelope encloses vertices along the length of the link. The settings for Strength, Falloff, Radial Scale, and Overlap are grouped under Envelope Parameters on page 5065.
Envelopes have cross sections. You can add cross sections to refine the shape of an envelope, and you can move or scale a cross section’s control points to change the cross section’s shape. (Cross sections are also used to create bulges on page 5080.)

**TIP** You can also use tools on the Main toolbar to adjust envelopes. For example, you can use Non-Uniform Scale on envelopes and cross sections, or use Select And Move to move envelopes, cross sections, or control points on cross sections.

**Workflow**

The goal is to modify the envelopes so each vertex in the mesh is encompassed by at least one link’s envelope.

Usually the first adjustment is to assign a rigid envelope to the character’s head. A rigid envelope blends with other envelopes but retains the shape of the mesh. The head should not deform with the deformation spline.

With Initial Skeletal Pose turned on, check that the envelopes enclose all areas of the mesh. If you turn off Initial Skeletal Pose, the character adopts its animated position at the current frame. Use an animation that stretches the character around, such as a run or dance motion. Find a frame where the envelopes need adjusting, and edit the envelope parameters. Changing the envelopes with the character in an animated position will always reference the Initial Skeletal Pose.

These are some frequently encountered problems with the default vertex assignment:

- Vertices that don’t follow the skeleton.
  To correct this, increase the Radial Scale of an envelope’s outer boundary.

- Vertices at joints get pushed or dented in.
  Too many envelopes might be affecting these vertices. Try reducing the Radial Scale of the inner bound, and reduce the Overlap values of the links on both sides of the joint.

- Bending appears too linear or broken at the joint.
  Increase the envelope’s outer Overlap value toward the link on the other side of the joint.

Some further adjustments are described in the “Procedures” section that follows.
**NOTE** An envelope does not need to enclose Patch tangent handles. It needs to enclose only the patch vertices. This relieves you from having to scale the envelopes to a large size to encompass tangent handles.

**Procedures**

See *Adjusting Default Envelope Shape* on page 4974

**Interface**

Controls for Envelope sub-objects are on the Blending Envelopes rollout.
Selection Level group

**Link** Turn on to select links in the viewports and edit the selected link's envelope parameters.
For example, you might turn on Link, select a biceps link, Ctrl+click to add the opposite bicep to the selection, then edit envelope parameters for both links at the same time.

**Cross Section** Turn on to edit envelope cross sections, changing the envelope's shape and thus its area of influence.
For example, you might turn on Cross Section, select a cross section on the inner or outer boundary of an envelope, and then move or scale it. You might Non-Uniform Scale the cross section of a collar envelope so it avoids vertices in the chest area.

**Control Point** Turn on to edit the control points on a cross section.
For example, you might turn on Control Point, select a point on a cross section of an envelope, and move the point to change the envelope's shape and area of influence.

**Previous and Next** Click to move to the next or previous link, cross section, or control point, depending on which selection level is active.

Active Blending group

**Deformable**

**Rigid**

**Partial Blending**
**Deformable** When on, enables a deformable envelope for the selected links. Default=on.

By default, deformable envelopes are shown in red.

**Rigid** When on, enables a rigid envelope for the selected links. Default=off.

By default, rigid envelopes are shown in green.

**IMPORTANT** You can have both a deformable and a rigid envelope turned on for the same link. Normally, you use one or the other. By non-uniform scaling the rigid and deformable envelopes for one link, you can position one envelope on top of the other. For example, you could control the shoulder with a rigid envelope and the armpit with a deformable envelope. Both envelopes can also be turned off for a link.

**Partial Blending** Turns on partial blending for the selected links. Leave either a deformable or rigid envelope on, and then turn on Partial Blending. Physique calculates the weights of each link on a given vertex. If Partial Blending is off, and the total weight is less than 1, Physique normalizes the combined weight to 1. If Partial Blending is on, the weights are allowed to remain at a value of less than 1. The remainder is filled in by the root node, the equivalent of no influence. See **Partial Blending and Weight Assignments** on page 4988 for a detailed explanation of how Physique calculates these values.
Partial Blending on all the deformable envelopes for the bones in this character's jaw allows smooth mesh deformation when the bones are moved.

**Envelope Parameters group**

**Envelope type drop-down list** Shows the type of the selected envelope. If the link has both a rigid and a deformable envelope, you can use this list to choose which envelope's parameters you are adjusting.
**Strength** Changes the strength of the envelopes. Range=0.0 to 100.0. Default=1.0.
Strength applies to both the inner and outer envelope bounds.
Used primarily for areas where envelopes overlap, and you want one to be more influential than the other.

**Falloff** Changes the rate of falloff between the inner and outer bounds of an envelope. This is a Bezier curve function. Range=0.0 to 1.0. Default=0.1.
Vertices within the inner bound are fully influenced (weight=1.0) and those beyond the outer bound get no influence from the link (weight=0.0). Falloff determines the rate at which the influence falls off from 1.0 to 0.0.
The Inner, Outer, and Both buttons determine whether the controls that follow, Radial Scale, Parent Overlap, and Child Overlap, apply to the envelope's inner bound, its outer bound, or both at once. First, use the buttons to choose which bounds to adjust, then change values in the spinners.

**Inner** Turn on to change the values of the inner bound.

**Outer** Turn on to change the values of the outer bound.

**Both** Turn on to change the values for both inner and outer bounds at the same time.
When Both is selected, the values displayed for Radial Scale and Parent and Child Overlap reflect the values for the *inner* bound.

**Radial Scale** Radially scales the envelope bounds. Range=0.0 to 100.0. Default=1.0.

**Parent Overlap** Changes the envelope's overlap with the parent link in the hierarchy. Range= -1.0 to 10.0. Default=0.1.
A value of 0.0 causes the end of the envelope to fall on the joint. Values less than 0.0 bring the envelope inside the link, and values above 0.0 will overlap onto the adjoining link.

**Child Overlap** Changes the envelope's overlap with the child link in the hierarchy. Range= -1.0 to 10.0. Default=0.1.
A value of 0.0 causes the end of the envelope to fall on the joint. Values less than 0.0 bring the envelope inside the link, and values above 0.0 will overlap onto the adjoining link.
**Edit Commands group**

**NOTE** Which buttons are available in this group will vary, depending on whether Links, Cross Sections, or Control Points is the active selection level.

**Insert** Inserts a cross section or control point on a cross section.

**Delete** Deletes a cross section or control point.

**Copy** Copies an envelope or cross section.

**Paste** Pastes an envelope or cross section.

**Exclude** Clicking this button displays the Exclude Envelopes dialog on page 5051. You can exclude a link from influencing another link. For example, you can exclude the right thigh link from influencing the left thigh link. Or, rather than scale the index finger envelopes to avoid influencing middle finger vertices, exclude the middle finger links from the index finger links.

**Mirror** Mirrors the envelopes on a selected link, or mirrors selected cross sections in an envelope.

After a Mirror operation, you can adjust the orientation by clicking Rotate on the Main toolbar, choosing Local coordinates, and then clicking and dragging the link or cross section.

**TIP** To copy an envelope to its mirror, the sequence should be Copy, select the opposite link, Paste, then Mirror.
**Display group**

- **Interactive Redraw** When on, Physique dynamically updates the mesh while you adjust envelopes. When off, the mesh updates only when you enter a final value (you press Enter or Tab, or release the mouse). Default=on.

- **Initial Skeletal Pose** When on, puts the mesh character in the pose it was in just before Physique was applied. Default=off.

- **Display Options** Clicking this button displays the Blending Envelope Display Options dialog on page 5049, which lets you customize envelope display.

- **Shaded** Toggles shaded display of vertex weights in the viewports. Default=off.

**Link Sub-Object**

Select an object that has the Physique modifier applied to it. > Modify panel > Link sub-object level

Use parameters at the Link sub-object level to change how deformation around joints occurs. When a joint in the skeleton bends or rotates, Physique, by default, deforms vertices uniformly on either side of a joint. You can change these defaults by using the tools at the Link sub-object level. For example, you can adjust the amount of skin sliding that occurs along a limb as the limb bends, or change the angle of the crease between the upper arm and chest.
The deformation spline displays as a yellow curve that runs through the mesh.

Like a spline object, the deformation spline created by Physique is a continuous curve through several points. While a spline object runs continuously from
vertex to vertex, the deformation spline is a smooth curve running from joint to joint. The Bend, Bias, and Tension spinners can change the shape of the curve, much as you can rotate or scale the handles at a spline vertex.

The deformation spline also takes into consideration twisting and scaling of the skeleton’s links. At the Link sub-object level, you take control of the behavior of the deformation spline, and subsequently gain full control of the skin’s behavior relative to the skeleton’s movement.

**Link Settings Rollout**

Select a mesh that has the Physique modifier applied to it. > Modify panel > Link sub-object level > Link Settings rollout

Controls on the Link Settings rollout let you adjust the behavior of the selected link.

**See also:**

- Joint Intersections Rollout on page 5077
Active When on, activates the selected link. Default=on.
Turning off Active makes the link unavailable for vertex assignment, meaning that the link has no influence on any vertices. Vertices within range of this
link are not influenced by it, and can be “picked up” by other nearby envelopes, or can be manually assigned (without blending) to any other link. Turning off Active makes Physique ignore the link as if it were never part of the skeleton.

**Continuity** Maintains a smooth transition across the joint from the parent link to the current link. Default=on.

When Continuity is on, the effect of the link parameters passes smoothly across the joint to the connected link. When Continuity is off, Bend, Twist, and Radial Scale settings are limited to the current link, which produces an abrupt transition across the joint. This is analogous to breaking the spline handles on a spline shape.

**Bulge Editor** Displays the Bulge Editor on page 5029. The Bulge Editor displays bulge cross sections schematically, letting you create and edit bulge controls.

**Reinitialize Selected Links** Reinitializes the link and its vertex parameters based on the current link parameter settings. Clicking Reinitialize Selected Links does not change vertex assignments or manual reassignments.

For example, increasing the tension of a link can cause the spacing to change for the link’s cross sections. Reinitialize Selected Links smoothes the spline, and makes cross section spacing even again.

Think of the skin being snugly stuck to the link. As the link parameters change, the vertices can bunch up or stretch out. Clicking Reinitialize lets the skin “slip” to its original shape, establishing a new relationship to the deformation spline.

**Bend group**

![Bend](image)

**Tension** Sets the smoothness of a joint. Tension affects the curvature of the deformation spline through the joint. A low value, near 0.0, makes the spline linear and creates a sharp angle at the joint, like bending a hinge. High values, near 2.0, make the spline smooth through the joint, creating a rounded joint, like bending a firm hose. Range=0.0 to 2.0. Default=0.5.
**Bias** Displaces the pivot point about which vertices are bent. Bias pushes the effect along the spline toward one side of the joint or the other. The default value of 0.5 centers the bend at the joint. Values lower than 0.5 move the pivot onto the child link. At 0.0, the bend effect is limited to the selected link. Range=0.0 to 1.0. Default=0.5.

**Twist group**

Twist parameters control the way the skin deforms when a joint rotates along its length, as in turning a doorknob.

**Use Twist for Rigid** When on, twist is used for rigid as well as deformable envelopes. Default=off.

Turn off for the rigid envelope for a character's head: the head should not twist along the length of the link. You might want to turn this on for the forearm or upper-arm link if you’re using rigid envelopes.

**Tension** Values lower than 1.0 concentrate the effect closer to the joint. Values higher than 1.0 move the effect away from the joint. Range=0.0 to 2.0. Default=1.0.

**Bias** Shifts the distribution of the twist from one side of the joint to the other. The default value of 0.5 twists the selected link and the child link equally. Values greater than 0.5 twist the selected link and the child link equally. Values less than 0.5 shift the twist to the child link. Range= 0.0 to 1.0. Default=0.5

**Sliding group**

Physique User Interface | 5073
Skin sliding parameters control the amount of skin sliding that occurs when a joint rotates. Without skin sliding, vertices closest to the joint tend to compress on the inside and stretch apart on the outside, generally revealing the segments of the mesh. Outside sliding causes the vertices around the joint to move toward the joint, preventing localized stretching on the side that is greater than 180 degrees. Inside sliding causes the vertices to relax and slip away from the joint, preventing bunching of vertices on the side having an angle less than 180 degrees.

**TIP** Use sliding for knees and elbows.

**Inside** As values increase, skin moves away from the joint. Range=0.0 to 1.0. Default=0.0 (no inside sliding).

**Outside** As values increase, skin moves toward the joint. Range=0.0 to 1.0. Default=0.0 (no outside sliding).

Above: Inside and Outside set to 0.0 (no sliding)

Below: Inside and Outside set to 0.25 (sliding creates a smoother bend)
**FallOff** As values increase, the effect is localized to the joint. Range=0.0 to 1.0. Default=0.5.

**Radial Scale group**

Radial Scale parameters expand or contract the skin by scaling the radial distance perpendicular to the link. They apply to any combination of user-definable scale, bulge settings, or link length.

**Tension** Values between 0.0 and 1.0 concentrate the effect closer to the joint. The effect is closest to the joint when Tension is 0.0. Values greater than 1.0 move the effect away from the joint. Range=0.0 to 2.0. Default=0.5.

**Bias** Shifts the effect of radial scaling. At the default value of 0.5, scaling affects both the selected link and the child link. Values lower than 0.5 shift the scaling effect onto the selected link, and values greater than 0.5 shift scaling onto the child link. At 0.0, expansion and contraction are limited to the selected link. At 1.0, expansion and contraction are limited to the child link. Range=0.0 to 1.0. Default=0.5.

**Link Scale** Scales the entire link radially, independent of the effect of any cross sections. At 1.0, the link is “actual size” and this setting has no effect. Other values increase or decrease the radial scale of the link. Range=0.0 to 10.0. Default=1.0.

**CS Amplitude** Cross section amplitude has no effect unless the link has bulge angle cross sections. At 0.0, cross section deformation is turned off. Values greater than 1.0, up to the maximum of 10.0, exaggerate the effect of cross sections. Default=1.0.

**Stretch** When on, preserves the volume of the link’s skin when the length of the link changes. The effect is similar to stretching or squeezing a material that is only partly elastic, such as a tough rubber hose. Default=off.
Above: Stretch is turned on.

Below: Stretch is turned off.

As the bones change in length, the mesh expands and contracts when Stretch is on.

**Breathe** When on, scaling a skeleton node changes the radial scale of the link's skin. When off, scaling a node has no effect on the scale of the skin. Default=off.
Above: Breathe is turned on: the mesh is scaled as the object is scaled.

Below: Breathe is turned off: object scaling doesn't effect the mesh.

The linked objects are shown in white. The lowest, largest object is the one that has been scaled. These linked objects were used as the hierarchy for Physique.

**Joint Intersections Rollout**

Select a mesh that has the Physique modifier applied to it. > Modify panel > Link sub-object level > Joint Intersections rollout

When a joint bends, the skin can "collide." Without collision detection, it can overlap unrealistically. This is especially likely when one or both of the links have bulges. The joint intersection controls can detect skin collisions and correct overlap by creasing the skin.

By default, Physique draws a crease plane that bisects the joint and prevents vertices from each link from crossing the crease plane. The result can be a somewhat unnatural flattening of the bulges along the plane. Physique therefore provides controls that let you modify the effect of the crease plane.

Properly adjusted crease plane
You can modify the effect of the joint creases at both ends of the selected link. These joints are the parent’s joint and the link’s joint. Blend From and Blend To points define the distance along the link that is affected by the crease plane.

- The parent’s joint is between the selected link and its parent. The parent’s joint is numbered 0. For the parent joint, the joint is at 0.0 and the crease plane has an effect from the joint to the Blend From point. Between Blend From and Blend To, the crease plane has a partial effect, adjusted by the Bias setting. Vertices at locations greater than the Blend To point are not affected by the crease plane.

- The link’s joint is between the selected link and its child. The link’s joint is numbered 1. For the link’s joint, the joint is at 1.0 and the crease plane has an effect from the joint to the Blend To point. Between Blend To and Blend From, the crease plane has a partial effect, adjusted by the Bias setting. Vertices at locations less than the Blend From point are not affected by the crease plane.

**Procedures**

**To adjust joint intersection parameters:**

1. With Physique active on the Modify panel, go to the Link sub-object level.
2. In a viewport, click the link you want to work with.
3. Select Active for the crease you want to manipulate: choose Crease At Parent’s Joint or Crease At Link’s Joint.
5. Select the opposite link and adjust the opposite set of joint intersection parameters.

For example, if you are working with the joint between the selected link and its child (such as the biceps link), turn on Active for Crease At Link’s Joint and change settings. Then select the child link (the forearm) and activate its Crease At Parent’s Joint. Adjustments to the Parent’s Joint for this link affect the other side of the same crease.
Both the parent's and the link's joint have the same controls:

**Active** Turns off the effects of the joint intersection controls. When this box is cleared, Physique makes no compensation for overlapping bulges. Default=off.

**Blend From** The area between Blend From and Blend To contains vertices that are partially affected by the crease plane. These vertices will be shifted, but not as much as those between the crease plane and the point where this joint begins to blend (Blend From in the parent's case, Blend To in the link's case). The distance of the vertices from the crease plane determines the exact amount of shifting. Vertices within the blend region that are closer to the intersection plane are shifted more than the vertices further away from it. Default=0.0.

**Blend To** Indicates the distance beyond which the crease plane has no effect. Default=1.0.

**Bias** Sets the strength of the crease plane effect within the blended region. A value of 0.0 means that the intersection plane will have no effect within the
blended region; a value of 1.0 means that it will have a full effect within the blended region. Default=0.25.

**Bulge Sub-Object**

Select an object that has the Physique modifier applied to it. > Modify panel > Bulge sub-object level

After you have edited envelope sub-objects on page 5060 for good overall mesh deformation, you can create bulges to simulate muscle contraction and expansion when a character’s joint rotates.

A bulge angle requires two links: the selected link, and the child link of that selection (for example, an upper arm and forearm). The joint that separates the two is referred to as the *bulge joint*. Any rotation applied to this joint becomes the angle used to center the effect of a bulge angle.

Physique creates a single default bulge angle for each bulge joint in the attached skeleton. The angle of this joint is that of the initial skeleton pose. This is the pose the skeleton had when the Physique modifier was applied to the skeleton, or when you use Reinitialize on page 5026 and turn on Initial Skeleton Pose in the Physique Initialization dialog. To create a bulge, you need to add only a single additional bulge angle. You can add further bulge angles to refine the bulge effect.

**Workflow to Create a Biceps Bulge**

The overall steps for creating a biceps bulge are:

- Insert a new bulge angle.
  
  Give the new bulge angle a custom name and color.

- Set the bulge angle at a point where the joint is flexed; for example, at 90 degrees.

- Insert a cross section on the upper arm.

- Use control points (or the Bulge editor on page 5029) to shape the bicep bulge.

The following paragraphs elaborate these steps.
Above: Default bulge angle at the initial pose.

Below: Bicep bulges at the custom bulge angle of 90 degrees.
The new bulge angle has been assigned a red color.

To create a biceps bulge angle, go to the Bulge sub-object level. In the Selection Level group, turn on Link. Select the upper arm link, then click Insert Bulge Angle; the bulge angle name increments from 0 to 1 in the Current Bulge Angle field, indicating that a new bulge angle has been created. Type a descriptive name for the new bulge angle in the Current Bulge Angle field; for example, Arm at 90.

Click Bulge Angle Color and select a color for the newly created bulge angle. When Select Nearest Bulge Angle is active, the bulge angle color changes as the joint bends; this is a good visual indicator of which angle has the most influence at any given frame.

Scrub the time slider to a frame where the arm is bent to 90 degrees, then click Set Bulge Angle (you can also rotate the joint).

**NOTE** The Set Bulge Angle command records only the angle between the biceps and forearm, not the frame number where that angle occurs. The bulge will occur at any frame where the elbow is at the bulge angle.

In the Selection Level group, click Cross Section. Then in the Cross Section Parameters rollout, click Insert. In a viewport, position the cursor over the upper arm link, and click to place the new cross section for the biceps.
On the Selection Level rollout, click Control Point. To shape the cross section, move the cross section control points in the viewports, creating a bulge. Click Play. The biceps should grow as the angle of the character’s arm approaches 90 degrees. If Select Nearest Bulge Angle is active, the bulge angle gizmos change colors, depending on which angle has the greatest influence.

Go to the Link selection level and use Copy, Paste, and Mirror to create an identical bulge angle for the opposite arm.

**TIP** When you use Physique with a biped, load a .bip file that will rotate the character’s limbs. Turn on In Place mode before you scrub the time slider to locate appropriate limb angles. This keeps the character (the biped) in the viewports.

### Bulge Editor

The Bulge Editor on page 5029 duplicates many of the controls at the Bulge sub-object level. The benefit of using the Bulge Editor is that bulge angle data is represented graphically, and provides an alternative way of creating, selecting, and editing cross sections. Rather than editing cross section control points in the viewports to “bulge” the mesh, you might prefer to open the Bulge Editor and move control points in the Bulge Editor’s Cross Section view.

### Procedures

**To create a new bulge angle on a selected link:**

1. With Bulge sub-object active, turn on Link in the Selection Level group.

2. Select a link in a viewport.

3. Click Insert Bulge Angle. This creates a new bulge angle. The name in the Current Bulge Angle field increments.

   **NOTE** By default, one bulge angle is created by Physique in the initial skeletal pose; the arm is usually straight in this pose.

4. In the Current Bulge Angle field, enter a name, such as **Arm at 90**.

5. Click the Bulge Angle Color swatch and choose a color in the color selector. This makes identification easier.
Now you need to set a joint angle for the newly created bulge angle.

6 Move the time slider until the joint is at the desired angle. If the skeleton is not yet animated, you can exit the Bulge sub-object level, rotate the skeleton’s joint until it is at the desired angle, then return to the Bulge sub-object level.

7 Click Set Bulge Angle. The joint angle between the link and its child is recorded (for example, if a biped’s upper arm link is selected, Set Bulge Angle records the angle created by the upper arm and the forearm.)

8 In the Selection Level group, turn on Cross Section. Then in the Cross Section group, click Insert. In a viewport, click the link at the point where you want the new cross section to be.

9 Scale the cross section or move its control points to create the bulge.

To move individual control points, use the Control Point selection level.

10 Enter 80.0 in the Influence field. If the bulge angle is for a biceps bulge when the forearm and upper arm create a 90-degree angle, the bulge begins to appear at 10 degrees.

To copy all Bulge angles from one link to its opposite:

1 Go to the Bulge sub-object level.

2 In the Selection Level group, turn on Link. In a viewport, select a link to copy.

3 Choose Entire Link from the Current Bulge Angle drop-down list.

4 In the Cross Section Parameters rollout, click Copy.

5 In a viewport, select the opposite link.

6 In the Cross Section Parameters rollout, click Paste, and then click Mirror. All the bulge angles from the first link are pasted to the opposite link, then mirrored.
To choose a specific bulge angle for editing:

1. Click the arrow of the Current Bulge Angle drop-down list. The full list of bulge angle names appears for the current link.

2. Click the name of the bulge angle you want to edit. The viewports update to show the cross sections associated with the newly selected bulge angle.

To change a bulge angle value:

1. Make sure the bulge angle's name is displayed in the Current Bulge Angle drop-down list.

2. Move the time slider to a frame that displays the angle you want to record, or use transforms to change the angle between the active link and its child link.

3. In the Bulge Angle Parameters group, click Set Bulge Angle.

To delete a bulge angle:

1. Click the arrow of the Current Bulge Angle drop-down list. The full list of bulge angle names is displayed.

2. Click the name of the bulge angle you want to delete.

3. Click Delete Bulge Angle. You can’t delete the default bulge angle: a link must always have at least one bulge angle defined.

To use Select Nearest Bulge Angle:

The Select Nearest Bulge Angle button can help you identify the bulge angle that has the greatest effect at the current pose.

1. In the Selection Level group, click Select Nearest Bulge Angle.

2. Scrub the time slider or rotate the joint. The bulge angle named in the drop-down list changes to show the most influential bulge at each skeleton pose.
**Interface**

Controls for the Bulge sub-object level are on the Bulge rollout.
Selection Level group

**Link** Turn on to select links in the viewports. The Copy, Paste, and Mirror commands are enabled for links.

**Cross Section** Turn on to select and edit cross sections in order to "bulge" the mesh. The Insert, Delete, Copy, Paste, and Mirror commands are enabled for cross sections.

**Control Point** Turn on to edit cross section control points.

**Previous and Next** Click to select the next or previous link, cross section, or control point, depending on the selection level.

**Bulge Editor** Click to display the Bulge Editor on page 5029, which lets you create and edit bulge angles using the schematic Cross Section and Profile views.

**Select Nearest Bulge Angle** Turn on to select the bulge angle nearest to the current joint angle. If a joint bends over time, this lets you use the time slider to select a bulge angle. If you click Play, you can see the Current Bulge Angle field change to reflect the nearest bulge angle to the current angle of the selected link and its child (if two or more bulge angles for the limb exist).
Current Bulge Angle (field and drop-down list) Displays the current bulge angle. You can enter a descriptive name for a newly created bulge angle. When you click Insert Bulge Angle, this field displays the new bulge angle name. Use the drop-down list to select other bulge angles.

Entire Link This choice in the Current Bulge Angle drop-down list selects all cross sections for all bulge angles in the active link. Use this to change cross section settings globally for a link. This also affects the Copy and Paste commands. While Entire Link is chosen, Copy Cross Section copies all cross sections for all bulges, and Paste Cross Section pastes all cross sections for all bulges.

**TIP** Entire Link is useful for copying all the bulges from one arm or leg to another.

Bulge Angle Color Click the color swatch to change the color of the current bulge angle. Giving each bulge angle a different color is a convenient way to distinguish between them.

**Bulge Angle Parameters group**

Set Bulge Angle Changes the angle value to the skeleton's current joint angle on the current bulge angle (visible in the Current Bulge Angle field in the Selection Level group). First use Move or Rotate in a viewport to change the angle between the selected link and its child, then click Set Bulge Angle.

Insert Bulge Angle Adds a new bulge angle for the selected link. The Current Bulge Angle field displays a bulge angle name with the number
incremented. You can enter a descriptive name for a new bulge angle, such as *Arm at 90*.

By default, one Bulge Angle is created in the Figure mode pose when Physique creates links. Only one additional bulge angle is needed to bulge the mesh. You can create more bulge angles for further control, if you want.

**Delete Bulge Angle** Removes the current bulge angle from the selected link.

You cannot delete the default bulge angle.

**Influence** The range of angles through which the bulge influences the skin. Range =0 to 180. Default=90 degrees.

For example, if you've set a bulge angle for the joint at 90 degrees, an Influence value of 40 means that the bulge effect begins to appear when the rotating joint reaches 50 degrees (90 minus 40) or 130 degrees (90 plus 40).

**Power** Controls how smoothly or abruptly the bulge takes effect. At 0.0, the bulge takes effect immediately, without interpolated easing. As values increase, the bulge eases in gradually. A value of 10.0 will bulge the mesh abruptly when the set angle is reached. Range=0 to 10.0. Default=2.5.

**Weight** Increases the effect of the current bulge angle relative to the effect of any other bulges. Range=0.0 to 100.0. Default=1.0.

**Cross Section Parameters group**

![Cross Section Parameters](image)

**Sections** Sets the number of cross sections for the selected link.
**Divisions** Sets the number of control points around the cross section. By default, control points are evenly distributed around the circumference of the cross section.

**Resolution** Sets the number of radial divisions around the cross section. Control points snap to the nearest resolution line.

**NOTE** The buttons that follow, Insert, Delete, Copy, Paste, and Mirror, work according to which level is active in the Selection Level group.

**Insert** Creates a new cross section or control point.

**Delete** Deletes the active cross section or control point.

**Copy** Copies the active link (with its bulge angles) or cross section.

**Paste** Pastes a link (with its bulge angles) or cross section.
To copy and paste all the bulge angles from one link, choose Entire Link from the Current Bulge Angle drop-down list, and then click Copy. Select the opposite link and click Paste. Click Mirror to mirror the pasted link parameters.

**Mirror** Mirrors bulge angles and cross sections on bulge angles. If necessary, you can then use Select And Rotate to orient the bulge angles and cross sections.

### Display group

**Interactive Redraw** Turn on to deform the mesh in real time while you edit cross sections in the viewports. Turn off to update the mesh only when you release the mouse. Default=on.

**TIP** Turn off Interactive Redraw when working on a slow system, or with a dense mesh that takes a long time to compute.

**Initial Skeletal Pose** When on, puts the mesh into its original pose; that is, the pose it was in when Physique was first applied. Default=off.
**Display Options**  Click to display the Bulge Angle Display Properties dialog on page 5053, which lets you customize the viewport display of bulges.

**Tendons Sub-Object**

Select an object that has the Physique modifier applied to it. > Modify panel > Tendons sub-object level

While envelopes provide smooth skin deformations, tendons provide additional stretching in much the same way that actual human tendons do. For example, you might create pulling in the wrist (several joints away) when the fingers are moved. After adjusting the envelope sub-objects on page 5060 for good mesh deformation, you can use tendons to control the amount of skin stretching across multiple links.

**Workflow Example**

To create a tendon from the spine to the upper arm, go to the Tendon sub-object level. Select a spine link. In the Insert Settings group, click to turn on Insert, and then click the selected link to position the tendons. A tendon cross section is added to the link. Turn off Insert.

In the Selection Level group, turn on Cross Section. Using the Rotate tool (on the Main toolbar), rotate the cross section so its control points are in useful locations. In the Tendon Parameters group, use the Radius spinner to scale the cross section radius so the control points fall close to the surface of the skin.

In the Selection Level group, turn on Control Point. Select a control point on the spine tendon's cross section, click Attach, and then click the arm link. A tendon stretches from the spine to the arm.

Finally, adjust the values of Pull, Pinch, and Stretch to refine the movement of the skin.
Tendons connecting upper chest to arms

**Procedures**

See *Creating Tendons* on page 4995

**Interface**

Controls for Tendon sub-objects are on the Tendons rollout.
Selection Level group

**Link** Click to select a link.

**Cross Section** Click to select and edit tendon cross sections.

**Control Point** Click to edit control points on tendon cross sections.

**Previous and Next** Click to go to the previous or next link, tendon cross section, or control point (depending on the active selection level).

Insert Settings group

**Sections** Sets the number of base cross sections for the tendon. Default=1.

**Attach Points** Sets the number of attach points around the tendon’s base cross section. Default=6.

**Resolution** Sets the radial resolution around the base cross section. Attach points are constrained to one of the radial resolution lines. Default=60.
**Insert** Turn on to insert a new cross section on the selected link, or to insert a control point on a cross section. The action depends on the active selection level: Link, Cross Section, or Control Point.

**Delete** Click to delete the selected cross section or control point. The action depends on the active selection level: Link, Cross Section, or Control Point.

**Tendon Parameters group**

![Tendon Parameters](image)

- **Radius** Scales attach points relative to the center of the cross section. Default=The average circumference of the skin where the tendon base is located.

- **Pull** Defines the strength of pull *along the length of the link*. Default=1.0.

- **Pinch** Defines the amount of pinch *around the link circumference of the tendon base*. Default=1.0.

- **Stretch** Defines the amount of stretch *toward the attached link*. Default=1.0.

The Pull, Pinch, and Stretch values work together to control, along a particular dimension, the strength of the one link (the attached link; call it link B) on vertices assigned to another link (the link where the tendon cross sections are inserted; call it link A). Vertices on link A behave as if they were under the influence of link B.

Pull, Pinch, and Stretch can all range from -2.0 to 2.0. At the default value of 1.0, the tendon’s effect is full strength. Reducing the value of these parameters to a value between 0.0 and 1.0 reduces the strength of the tendon’s effect. At values below 0.0, the tendon deforms the skin in the opposite direction. Pull, Pinch, and Stretch values between 1.0 and 2.0 cause an exaggerated effect, which is not usually needed for realistic effects.

**TIP** Setting Stretch less than 0.0 can be useful in regions where movement typically pulls the skin inwards, as in the collarbone area or the buttocks.
**TIP** As a general rule, leave the tendon values at 1.0 when the tendon is attached to a nearby link. For example, leave them at 1.0 between the upper spine (at the chest) and the arms. Reduce the Pull, Pinch, and Stretch values to reduce the tendon's effect when the tendon is attached to a more distant link. For example, reduce them between a lower part of the spine and the arms.

**Edit Commands group**

**Attach** To attach a point, select the point, click to turn on Attach, then in a viewport, click a different link.

**Detach** At the Control Point selection level, detaches the tendon of the selected control point. At the Cross Section selection level, detaches all of the cross section's attached tendons. At the Link selection level, detaches all attached tendons on all cross sections of the selected link.

**Upper Boundary Conditions group**

**Connect to Child Link** When on, allows tendons to affect the child link. This lets you connect tendons across several links. Otherwise, there is a boundary between the links where no tendon effect occurs. Default=off.

**Upper Bound** Sets the upper boundary overlap. Upper Boundary values greater than 1.0 affect the child link. Default=1.0.
WARNING  Tendons that span several links can conflict with joint intersection parameters. In these cases, go to the Link sub-object level on page 5068, and turn off Active to deactivate the joint intersection parameters for the joints that the tendon spans. (These controls are in the Joint Intersections rollout on page 5077.)

**Pull Bias, Pinch Bias, Stretch Bias** Set the upper boundary falloff effect for these tendon parameters. Values of 0.0 have no effect. Increasing the value shifts the Pull, Pinch, or Stretch effect toward the child. Default=0.5.

**Lower Boundary Conditions group**

![Lower Boundary Conditions](image)

**Connect to Parent Link** When on, allows tendons to affect the parent link. This lets you connect tendons across several links. Otherwise, there is a boundary between the links where no tendon effect occurs. Default=off.

**Lower Bound** Sets the lower boundary overlap. Lower Boundary values less than 0.0 affect the parent link. Default=0.0.

WARNING  Tendons that span several links can conflict with joint intersection parameters. In these cases, go to the Link sub-object level on page 5068, and turn off Active to deactivate the joint intersection parameters for the joints that the tendon spans. (These controls are in the Joint Intersections rollout on page 5077.)

**Pull Bias, Pinch Bias, Stretch Bias** Set the lower boundary falloff effect for these tendon parameters. Values of 0.0 have no effect. Increasing the value shifts the Pull, Pinch, or Stretch effect toward the parent. Default=0.5.
Display group

**Interactive Redraw** Turn on to deform the mesh in real time while you edit cross sections in the viewports. Turn off to update the mesh only when you release the mouse. Default=on.

**TIP** Turn off Interactive Redraw when working on a slow system, or with a dense mesh that takes a long time to compute.

**Initial Skeletal Pose** When on, puts the mesh into its original pose; that is, the pose it was in when Physique was first applied. Default=off.

**Display Options** Click to display the Tendon Display Options dialog on page 5055, which lets you customize the viewport display of tendons.

**Vertex Sub-Object (Physique)**

Select an object that has the Physique modifier applied to it. > Modify panel > Vertex sub-object level

Most often, you will want to use envelopes to correct the way skin behaves as the biped moves. However, you can override envelopes by manually assigning vertex properties. For example, you can remove the influence of inappropriate links from selected vertices. You can also change the weight distribution between links for a single vertex by using type-in weights.

**Procedures**

**TIP** You don’t have to work locally, one link at a time. You can use region selection to select groups of vertices or groups of links, working with areas of the body and its skeleton all at once.
To check vertex assignments:

1. Go to the Vertex sub-object level.
2. In the Vertex Operations group, click to turn on Select By Link.
3. Make sure all three Vertex Type buttons are on.
4. In a viewport, click a link. Physique displays the vertices assigned to that link. If any vertices assigned to the link are out of place, reassign them to a different link, as described in the procedures that follow.
5. Repeat step 4 for other links in the skeleton.

To remove a link’s influence on vertices:

For example, you might want to remove the influence of the index finger links from the vertices of the middle finger.

1. Go to the Vertex sub-object level.
2. Turn on Select and select vertices in the viewports.
3. In the Vertex Operations group, turn on Remove From Link.
4. Click a link in a viewport. The vertices are removed from that link’s influence.

**NOTE** You can click additional links to remove their influence as well.

5. In the Vertex Operations group, turn on Lock Assignments.
   You must use Lock Assignments to ensure that these envelopes will not influence these vertices if envelope parameters are adjusted later.

To remove deformable vertices from a link’s influence:

1. Go to the Vertex sub-object level.
2. Make sure all three Vertex Type buttons are on, and then in the Vertex Operations group, click to turn on Select By Link.
Observe the assignments and determine which vertices are incorrectly influenced. Also note if the vertices are red (deformable) or green (rigid).

**NOTE** Blue vertices do not fall within the influence of any link and are thus assigned to the root.

3 Turn on Select, and in a viewport, select only the out-of-place vertices.

**NOTE** Alternatively, you can use Alt+click to deselect the vertices that are in the correct place.

4 In the Vertex Type group, click to turn off Rigid Vertices and Root Vertices. Leave Deformable Vertices on.

5 In the Vertex Operations group, click Remove From Link.

6 In the viewports, click each link that you want no longer to influence the selected deformable vertices.

To override vertex assignments manually:
This technique is used when envelope assignments are inappropriate, and you want to have specific vertices influenced by a specific link.

1 Go to the Vertex sub-object level.

2 Make sure all three Vertex Type buttons are on, and then select the vertices you want to reassign.

3 In the Vertex Operations group, click to turn on Assign To Link.

4 In the Vertex Type group, choose only the type of vertex assignment you want to use: deformable (red) or rigid (green.)

5 Choose No Blending from the Blending Between Links drop-down list. This setting will disregard the effects of blending envelopes and vertex weights, and let you assign the selection to any link manually.

6 In a viewport, click the link you want to influence the vertex.
NOTE When you assign deformable vertices, some vertices might turn blue; they are assigned to the root instead of the link you clicked. To assign these vertices as correctly deformable vertices, simply use Ctrl-click with the neighboring parent or child link. If the blue vertices now turn red, they are deformable.

7 In the Vertex Operations group, click Lock Assignments to preserve the manual assignment.

To make vertices rigid:

1 Go to the Vertex sub-object level.

2 Turn on Select, and in a viewport, select the vertices you want to make rigid.

3 In the Vertex Operations group, click to turn on Assign To Link.

4 Turn on Rigid Vertices (green) in the Vertex Type group, and turn off Deformable and Root Vertices.

5 Choose No Blending from the Blending Between Links drop-down list. This setting will disregard the effects of blending envelopes and vertex weights, and let you assign the selection to any link manually.

6 In a viewport, click the link these vertices are to be assigned to.

7 In the Vertex Operations group, click Lock Assignments. Small squares around the selected vertices indicate that the vertices are locked.

Interface

Controls for vertices in a mesh controlled by Physique are on the Vertex-Link Assignment rollout.

NOTE This is not the same as the rollout used by the Physique Initialization dialog.
Vertex Type group

There are three vertex types, differentiated by color:

- **Red**  Deformable vertices that follow Physique’s deformation spline.
- **Green**  Rigid vertices that do not deform but just follow the link they are assigned to.
- **Blue**  Vertices attached to the root node. Physique uses this color when it isn’t sure which link to assign the vertices to. These vertices don’t deform but follow the center of mass object. You should reassign blue vertices to be either rigid or deformable.

While a button of the appropriate color is turned on, you can select vertices of that color. Turn off a button to avoid selecting vertices of that color. You can’t turn off all three buttons at once.

Blending Between Links drop-down list

This list provides several options:

- **N Links**  Vertices within all overlapping envelopes are influenced. While this option is active, vertices can be assigned *only* to the envelopes they fall within. Envelopes are used by Physique in this case to define the blended weight of each vertex.
- **No Blending**  Vertices are influenced by only one link, as in character studio 1. This is useful as a general default if you are developing characters for a game engine that doesn’t support blending. At the Vertex sub-object level it is useful to override blending weights defined by envelopes, and assign vertices to links as either Rigid or Deformable. For example, after selecting vertices of the skull and face, turn on No Blending, turn on Rigid vertices, turn on Assign To Link, and then click the head link. This will override
the head envelope vertex assignments and assign these vertices as rigid to the head link. Use Lock Assignments to lock any changes (see below).

- **2, 3, 4 Links** Vertices are influenced only by the specified number of closest links. This is useful when developing characters for a game engine with limited blending.

**Vertex Operations group**

![Vertex Operations](image)

**Select** Selects vertices using the selection tools on the main toolbar.

**Select by Link** Selects vertices by link.

**Assign to Link** Assigns the selected vertices to a link.

To assign the currently selected vertices to a link, turn on Assign To Link and then click the link.

**Assign To Link** has a dependency on the envelopes defined for each link, and you must set Blending Between Links to "No Blending" to override this. After
vertices are assigned manually in this way, use Lock Assignments to keep them from being reassigned inadvertently during subsequent operations.

**NOTE** You must select or assign a link by clicking the link; you can't use the Select From Scene dialog to select or assign a link while you use Physique to work with vertices.

**Remove from Link** Remove the selected vertices from a link.

**NOTE** Select, Select By Link, Assign To Link, and Remove From Link will act only on vertices specified by the red, green, and blue Vertex Type ("+") buttons.

**Lock Assignments** Locks vertex assignments.

Lock will prevent any changes from being made to the weights and blending presently assigned to the selected vertices. After any manual assignment of vertices, they should be locked. Before using type-in weights, vertices must be locked. When manipulating envelopes in difficult areas of the character, you might choose to lock vertices that are working well before changing the envelopes to affect other vertices.

**NOTE** If additional data, such as more vertices, comes up the modifier stack, Physique notes the proximity of new vertices to the locked vertices. It then locks the new vertices based on proximity. Already locked vertices will not be unlocked.

**Unlock Assignments** Unlocks vertex assignments.

Click Unlock Assignments on selected locked vertices prior to reassigning them to another link, or changing their blending settings.

**Type-In Weights** Displays the Type-In Weights dialog on page 5057, which you use to enter a weight for selected locked vertices; only the weight for locked vertices can be changed.

To use this feature: select one or more vertices, then lock them. Click this button to display the Type-In Weights dialog, select a link from the drop-down list, and change the weight of that link to position the vertices (vertex positions update in the viewports as the weight changes).

You can use type-in weights for stubborn vertices that fall in blended regions between two or more envelopes. Subtle adjustments can be made to the vertex weights of specific links that would be difficult to achieve by adjusting envelopes alone.

**TIP** Type-In Weights is useful mainly for correcting flaws in low- to medium-resolution meshes. On a high-resolution mesh, adjusting envelopes should be used to correct deformation.
**Hide** Hides the selected vertices

**Unhide All** Unhides all vertices.

**Initial Skeletal Pose** When on, puts the mesh into its original pose; that is, the pose it was in when Physique was first applied. Default=off.

### Crowd Animation

The crowd-animation system in character studio is designed to simulate the behavior of real-life crowds. A crowd simulation emulates real-life situations by animating delegates on page 8549 (helper objects that act as representatives). You give the delegates overall guidelines on how to behave, and the crowd simulation calculates their motion.

![A crowd of bipeds](image)

You set these guidelines by assigning behaviors on page 8518 to delegates. A behavior specifies a particular type of activity, such as moving toward an object in the scene, avoiding obstacles, following a path or surface, and so forth. You can combine multiple behaviors to create a rich and complex crowd
A crowd simulation can be used to animate bipeds, or to drive the use of mesh animation on objects linked to delegates. In addition, you can use cognitive controllers to tell delegates how to behave in varying circumstances.

See also:
- Biped Crowds on page 5136
- Non-Biped Crowds on page 5148

Creating a Crowd System

This topic shows a basic procedure for creating and using a crowd system.

1. Add a Crowd helper on page 5110 object.

The crowd helper is the controlling object for the entire crowd simulation.

2. Create a Delegate helper on page 5110 object.
This is a prototype for your crowd; a representative member.

3 On the Modify panel > Motion rollout on page 5156, set appropriate speed and turning limits for the delegate.
This is analogous to defining how a particular animal or object moves. Is it a bird, a fish, a slug, or an airplane?

4 Make clones of the delegate, either with 3ds Max clone tools, or by scattering delegates on page 5110.
Create 3ds Max objects to be used with behaviors, such as grids or objects to seek or avoid. These objects often correspond to objects in your scene. For example, you could create a grid in an open doorway to attract delegates, or a box at an obstacle to repel delegates.
6 Add one or more behaviors on page 5115. Modify each behavior's settings to be appropriate for the members of your crowd.

7 Solve the simulation.
Watch the solved simulation. If it needs correction, make changes to behaviors or delegate parameters. Solve again, and continue until the simulation works as intended.

Create the objects that will follow the delegates, and align and link them to delegates on page 5131.

Creating Complex Simulations

The process described above creates a simple crowd simulation. You can also use other tools to further control the simulation:

- Use cognitive controllers on page 5133 to cause delegates to switch behaviors based on their proximity to objects in the scene, time elapsed in the simulation, and other factors.
- Use motion synthesis on page 5148 to cause different portions of the linked object’s animation to be used based on delegate speed, rotation, and other factors.
- Use bipeds and a motion flow network to animate the bipeds with delegates. See Biped Crowds on page 5136.

Creating Crowd Helpers

The crowd system in character studio uses two helper objects: Crowd and Delegate. The first step in creating a crowd simulation is the creation of these helpers. The crowd helper serves as the command center for setting up and solving crowd simulations, while delegates provide stand-ins for animated objects. The crowd helper controls are used to animate the delegates, then later you link objects to delegates to create the finished scene.

Crowd Helper

A crowd helper object appears in viewports as blue tetrahedron. The location and size of the crowd helper does not affect the simulation. For the easiest workflow, create the crowd helper with a relatively large size, and place it where you can easily select it. You'll rarely need more than one Crowd helper object per scene.
After you create delegates, you use the crowd helper to clone delegates and distribute the clones, add behaviors, apply behaviors to delegates, link delegates to animated objects, and much more.
Delegate Helpers

The Crowd system in **character studio** uses Delegate helper objects as intermediaries between the crowd simulation and the influenced objects. A delegate is a non-rendering pyramid-shaped object. Its apex points in the direction the crowd system uses as “forward” when it moves the delegate around.

Use one delegate per object to be animated by the crowd system. You can add delegates one by one, or use any of the standard 3ds Max methods for cloning objects, including Shift+clone and the Array function. However, the Crowd object offers a convenient **Scatter Objects** on page 5165 function that lets you clone delegates and distribute the clones over a surface or within a volume, with options for orientation and scaling.

**See also:**
- Delegate Helper Object on page 5154
- Crowd Helper Object on page 5162
Procedures

To create a Crowd helper object:

1. On the Create panel, click Helpers.
2. Click Crowd, and drag the helper object to a convenient size.

   **TIP** Make the crowd helper object large enough so you can easily select it in two or more viewports. The size of the helper does not affect the crowd simulation in any way.

To create a Delegate helper object:

1. On the Create panel, click Helpers.
2. Click Delegate. Drag in a viewport to set the delegate position, and then drag vertically to set the size.

   **TIP** The delegate always points “up” in the viewport you add it in. So if you want it to point “forward,” that is, toward the positive Y direction in the World coordinate system, you should create it in the Top viewport.

To clone and scatter delegates:

1. Create a Crowd helper and a Delegate helper.
2. Decide how to distribute the delegate clones, and create an object to define how the clones are to be positioned: a grid object, a primitive box or sphere, a shape, or any object to serve as a surface. Alternatively, you can choose to distribute clones in a circular area without the use of a distribution object.
3. Select the Crowd object and access the Modify panel.
4. Click the Scatter Objects button to open the Scatter Objects dialog on page 5165.
5. On the Clone tab, set the number of clones to create, and select the object to clone.
6 Click Generate Clones.
   This produces the specified number of clones in the same location. To vary positions, orientations, and/or sizes, proceed with the following steps.

7 On the Position tab > Placement Relative To Object group, choose a distribution option. Click the None button, and then select the distribution object you created earlier.
   Alternatively, to distribute delegates in a circular area, choose Placement In Area group > In Radial Area and set a center and radius.

8 Click Generate Locations.
   This distributes the clones.

9 On the Rotation tab, choose which of the cloned object's local axes are to look forward and up. Optionally, specify source and target objects for the clones' orientations, as well as limits for randomized deviations from the calculated orientation.

10 Click Generate Orientations.

11 On the Scale tab, for each axis, specify Average, Deviation, and, optionally, Same As settings and a random seed.

12 Click Generate Scales.
   At this point, you're basically finished. However, to create a series of randomized positions, orientations, and/or sizes for clones, follow the next two steps and repeat as necessary.

13 On the All Ops, turn on Positions, Rotations, and/or Scales. To vary the randomized positions, rotations, and/or scales, turn on the corresponding Inc Seed check boxes.

14 Click the Scatter button.
   You can combine the cloning, position, rotation, and scale functions in one operation by setting the options on their respective tabs without clicking the Generate buttons, and then using the All Ops tab to apply any or all scatter operations simultaneously. Also, you can use the All Ops tab > Select Objects To Transform to specify any objects to scatter; not just clones.
Adjusting Delegate Parameters

Delegate parameters define the nature of the delegate motion.

You can change delegate parameters in one of two ways:

- To adjust parameters for an individual delegate, select the delegate, access the Modify panel, and adjust parameters. For descriptions of parameters, see Delegate Helper Object on page 5154.

- To adjust parameters for several delegates at once, select the crowd helper object, access the Modify panel, and click Multiple Delegate Editing to access the Edit Multiple Delegates dialog on page 5182.

The speed parameters let you describe a delegate's average speed and maximum acceleration. You can also define how much a delegate slows down as it turns or goes upward, and how much it speeds up when it goes down.

Turning parameters let you indicate how quickly a delegate can turn, and how much it can turn upward and downward. And banking parameters describe how much and how quickly a delegate banks and its banking limit.

All of these parameters work together to describe different types of creatures. A small fish, for instance, can turn more quickly than a large bird. A fish's speed would not be effected when the fish traveled up or down, but a bird's speed might be altered by its upward or downward direction.

See also:
- Crowd Helper Object on page 5162
- Delegate Helper Object on page 5154

Assigning Behaviors

In the real world, different crowds exhibit diverse behaviors, and even members of the same crowd can conduct themselves in various ways. Included with the character studio Crowd system is an assortment of behaviors that let you simulate a range of crowd activities.

Behaviors let you assign procedural activity types to delegates on page 5154, which, in turn, affect objects linked to delegates. You can associate any number
of behaviors with each crowd object on page 5162, and then link delegates and
teams of delegates to each behavior. A specific behavior assigned to a Crowd
object belongs only to that crowd; it cannot be assigned to any other crowds.

Following is a list of available behaviors:

- **Avoid Behavior** on page 5209: Prevents delegates from colliding with objects
  in the scene, or with each other. Avoidance can use any combination of
  turning, braking/stopping, repelling, and vector field.

- **Orientation Behavior** on page 5213: Applies a fixed orientation or orientation
  range to delegates, so they face a specific direction instead of toward the
  destination. You can specify orientation in absolute terms, or relative to
  the direction the delegate currently faces.

- **Path Follow Behavior** on page 5217: Restricts motion to a spline or NURBS
  curve; options include back-and-forth patrol-type movement.

- **Repel Behavior** on page 5221: Forces delegates to move away from a target.

- **Scripted Behavior** on page 5223: Uses MAXScript to specify behavior.

- **Seek Behavior** on page 5224: Moves delegates toward a target or targets.

- **Space Warp Behavior** on page 5226: Uses any dynamics-oriented space warp
  to control movement, including wind and gravity. Vector Field, a
crowd-specific space warp that lets delegates avoid irregularly shaped objects
  while following their contours, is included with character studio.

- **Speed Vary Behavior** on page 5227: Lets delegates change speed for more
  realistic movement.

- **Surface Arrive Behavior** on page 5229: Lets delegates move toward and land
  on a surface, with custom speed and acceleration parameters.

- **Surface Follow Behavior** on page 5233: Delegates move along a surface, which
  can be animated. Also, you can specify whether the delegates are to move
  straight ahead or skirt hills and depressions.

- **Wall Repel Behavior** on page 5236: Uses a grid to repel delegates; ideal for
  keeping objects inside an enclosed, straight-sided room.

- **WallSeek Behavior** on page 5239: Uses a grid to attract delegates. You can
  use this as a doorway for crowd-controlled bipeds to walk through.

- **Wander Behavior** on page 5242: Induces a realistic semi-random movement
  for characters such as shoppers at a mall.
TIP If you need custom behaviors, you can create your own with scripting.

The first time you add a behavior to the scene, a new rollout appears for the behavior below the Setup rollout. This rollout lets you change settings for the behavior. Certain behaviors, such as Seek and Avoid, let you specify "target" objects.

TIP Behaviors are assigned generic names by default. It’s a good idea to rename them with more meaningful descriptors; for example, "Seek Ball" or "Avoid Fire".

To display the rollout for a different behavior in the scene, choose it from the drop-down list in the Behaviors group. To see the controls available in the rollout for a behavior type, follow the link from its entry in the above list.

In addition to the controls available in behavior rollouts, you can use the Behavior Assignments and Teams dialog on page 5188 to turn behaviors on and off (with the Active check box), and for all behaviors except Avoid, Orientation, and Surface Follow, you can set and animate Weight. The Active status is animatable for all behaviors.

Using Behaviors

To use a behavior, you apply it to a delegate or a team of delegates using the Behavior Assignments and Teams dialog on page 5188. In this dialog, each assignment of a behavior to a delegate is given a weight. You can modify and/or animate these weights to influence the simulation.

Behavior assignment weights can profoundly effect a simulation. When applying two or more behaviors to the same delegate, the weights define the relationship between the behaviors, making one more or less powerful than the other. One way to visualize a behavior assignment weight is to examine the behavior’s force vector during a crowd simulation. The vector’s length indicates the behavior’s weight upon the delegate.

Each behavior has its own parameters which appear in the Behavior rollout, available in the Crowd object’s Modify panel. These parameters describe how the behavior works, and can sometimes contribute to the behavior’s strength as well. For instance, Seek, Repel, Wall Seek, and Wall Repel, all have specific volumes of influence. Outside these volumes they have no effect and essentially have a weight of zero. This rollout lets you specify whether or not you wish to see behavior’s force vector dynamically displayed during a Crowd simulation, and what color that vector should be.

When working with the Crowd system, it is critical to play with behavior assignment weights, as well as each behaviors’ parameters. Typically, you run
the simulation repeatedly, changing the weights and parameters to get the desired result.

A few behaviors cannot be weighted. These are Avoid, Surface Follow, and Orientation. Avoid and Surface Follow take over after all of the other behaviors have been applied to a delegate. They can take stringent measures to affect the delegate, possibly overpowering other behaviors in order to meet their constraints. Orientation simply sets the delegate's facing direction. It cannot be weighted and does not apply a force.

**Behavior Tips**

A few helpful things to know about behaviors in **character studio**:

- You can create conditional behavioral systems with Crowd's Cognitive Controller feature. This uses the MAXScript scripting language to determine when to effect a transition from one behavior to another; we've provided a number of sample scripts for you to learn from and adopt to your own simulations in Cognitive Controller Editor on page 5199 and State Transition Dialog on page 5203.

- The Behavior rollout appears immediately after the Crowd object > Setup rollout in the Modify panel. However, it doesn't show up until you've added at least one behavior to the crowd object.

- The Crowd panel displays only one Behavior rollout at a time. To access a different one, choose its name from the drop-down list at the bottom of the Crowd object's Setup rollout.

- As with most scene entities in 3ds Max, it's a good idea to give behaviors custom names, such as "Seek Doorway" or "Follow Hilly Surface." You do this by clicking the behavior's name in the Setup rollout and entering a new one from the keyboard.

- The default behavior settings may not always give the ideal results. The optimal settings depend vary with the particulars of your simulation setup; in many cases, if not most, you'll need to experiment with the settings to get the results you want. In some cases, you might need to animate settings as well.

One particularly useful feature of the delegate is its ability to display, using colored vectors, the strength and direction of the various forces acting upon it during solution of the crowd simulation. Each force can have a unique, identifying color. For example, the Seek behavior uses green by default, while the Wander behavior uses aqua. You can change these colors to any you like.
If a simulation isn’t proceeding as expected, you can debug it by observing the vectors during the solution. And if the solution occurs too quickly, you can use the Step Solve feature to solve the simulation one frame at a time.

Procedures

To use assign behaviors to delegates:

This example shows how to create a basic crowd simulation with delegates and behaviors.

1. Run 3ds Max or reset 3ds Max.
2. Add a Crowd object and one or more Delegate objects on page 5154 to the scene. In general, add delegates in the Top viewport so that they point forward. The Crowd object's location is immaterial.
3. Select the Crowd object and open the Modify panel.
4. On the Setup rollout > Behaviors group, click the New button.
5. In the Select Behavior Type dialog, click a behavior and then click OK to close the dialog.
   A Behavior rollout appears for the behavior you chose.
6. If the behavior requires a target object or objects, such as Seek, click the None button and then select an object, or click Multiple Selection and select several objects.
7. Change other behavior settings as necessary.
8. Create and modify additional behaviors as necessary.
9. On the Setup rollout, click the Behavior Assignment button.
10. In the Assignment Design group, the two upper lists should each contain a single entry: the delegate on the left, and the behavior on the right. Select both items.
11. Click the New Assignment button to the right of the Assignment Design group. It’s a vertical button with five right-pointing arrows.
   This adds the new assignment to the list in the Behavior Assignments group.
Accept the changes and the OK button to close the Behavior Assignments and Teams dialog.

On the Modify panel, scroll down to the Solve rollout and click the Solve button.

Keys are created as follows: The delegate turns to point toward the sphere, banking as it turns, and then moves directly toward the sphere. When it reaches its target, it moves slightly beyond the sphere, and then repeats the turn-and-move motion until the end of the simulation. To prevent this, try starting with the two objects farther apart, or animating the sphere’s position.

**Directing Delegates**

One of the purposes of behaviors is to move delegates in a particular direction over the course of the simulation.

The following behaviors can be used to direct delegates:

- The **Seek behavior** on page 5224 is one of the most commonly used behaviors in the crowd system. With this behavior, you can cause delegates to move toward a specific object. The seek object can be animated, and the delegates will follow it.

- The **Wall Seek behavior** on page 5239 causes delegates to seek a rectangular area. Compare with the Seek behavior, which causes delegates to seek an object’s pivot point.

- The **Path Follow behavior** on page 5217 is also useful for pushing delegates in a specified direction. With this behavior, delegates follow a path but can “stray” from the path by a specified distance, creating slightly random motion along the path.

- With the **Surface Arrive behavior** on page 5229, delegates seek one or more objects as they do with the Seek behavior, but you can cause delegates to stop when they reach a target.

- You can use the **Surface Follow behavior** on page 5233 to cause delegates to move along a surface.

- With the **Space Warp behavior** on page 5226, you can use a vector field to push delegates around the field to avoid obstacles. See **Obstacle Avoidance** on page 5123.
After setting up a behavior, you must use Behavior Assignments on page 5188 to assign the behavior to a delegate or team.

**Procedures**

**To use the Seek behavior:**

1. Select the crowd helper and access the Modify panel.
2. In the Setup rollout > Behaviors group, click New. Choose Seek Behavior from the pop-up list.
   The Seek Behavior rollout appears below the Setup rollout.
3. In the Seek Behavior rollout on page 5224, click None to add one seek object, or click Multiple Selection to designate more than one object for the delegates to seek.
4. Change the default settings as desired.

**To use the Wall Seek behavior:**

1. On the Create panel, click Helpers, and click Grid. Create a grid in the scene.

   **TIP** For best results, do not use Mirror to copy a grid to be used with behaviors. Use Shift+Clone instead.

2. Move and rotate the grid to position it.

   **TIP** The Wall Seek behavior attracts delegates to the grid in the direction of grid's local Z axis. With the grid still selected, use the Local coordinate system to see the direction of the Z axis in viewports; the axis arrow points in the direction of the positive Z axis. Checking the Z-axis direction will speed the process of setting up the behavior.

3. Select the crowd object, and add a Wall Seek behavior.
4. In the Wall Seek Behavior rollout, click None, and pick the grid.
5. Choose Positive Axis to cause the delegates to be attracted to the Z-axis side of the grid. You can also choose Negative Axis to attract delegates to the opposite side of the grid, or Both to attract them to both sides.
6 If you want delegates to be attracted to the grid only when they are within a specified area in front of the grid (rather than when they are anywhere in the scene), turn on Use Distance. Use the Inner Distance and Outer Distance parameters to set the area in which delegates will be attracted to the grid. Turn on Display Distance to see the distance in viewports.

To use the Path Follow behavior:

1 On the Create panel, click Shapes. Create a shape to be used as a path for delegates.

2 Add a Path Follow behavior to the Crowd object.

3 In the Path Follow Behavior rollout, click the None button and pick the shape for the delegates to follow.

4 Set the Radius parameter to the number of units by which delegates can stray from the path. Change other settings as desired.

To use the Surface Arrive behavior:

1 Add a Surface Arrive behavior to the Crowd object.

2 Add an object or objects to serve as the target surface to the scene.

3 In the Surface Arrive Behavior rollout, click None or Multiple Selection to designate the one or more target objects.

4 Use the settings in the Location group to determine where the delegate will stop when it reaches a target object.

5 Use the settings in the Approach group to determine how the delegate will behave when it approaches the target.

To use the Surface Follow behavior:

1 Add a Surface Follow behavior to the Crowd object.

2 Add an object or objects to serve as the follow surface to the scene.
NOTE If you use multiple objects, they must intersect to form a contiguous surface. Each delegate will move to the closest surface, follow it to the next closest that it encounters, and then start following that one, and so on.

3 In the Surface Follow Behavior rollout, click None or Multiple Selection to designate the object or objects whose surface(s) the assignees are to follow.

4 If you like, use the settings in the Projection Vector group to force delegates to move in a specific direction.

Obstacle Avoidance

An important part of crowd behavior is avoidance of obstacles. Think of an obstacle as anything that impedes a crowd member's progress. Examples of obstacles include walls, telephone poles, and fences, as well as other crowd members. Encountering such objects can cause avoidance behavior, which consists of any combination of slowing down, turning, and stopping.

There are several ways to implement avoidance in character studio, including:

- The Avoid behavior on page 5209 is one of the most commonly used behaviors. Use this behavior to cause crowd members to avoid other crowd members, or spherical objects in the scene. It works by creating a spherical volume of avoidance around the avoided object, so it doesn't accommodate irregular objects.

  The Avoid behavior is unlike any other behavior in Crowd. After all the other behaviors exert their forces on the delegates, Avoid takes over and has the power to turn, slow down, and even stop a delegate in order to make it avoid an obstacle.

- Use the Wall Repel behavior on page 5236 to cause crowd members to avoid broad, flat objects such as walls and fences. You can set a maximum distance for the repel effect, and describe the rate at which the force away from the wall increases as a delegate approaches the wall.

  Unlike the Avoid behavior, which can stop or slow down a delegate, Wall Repel simply exerts a force on the delegate to turn it away from the wall. It does not guarantee wall avoidance. You must work with it's distance and falloff parameters, as well as its weight in the Assignments and Teams dialog, to control its strength.
Use the Repel behavior on page 5221 to cause crowd members to turn away from an object. It works exactly like Wall Repel except that it uses a spherical volume rather than a plane. You can set a maximum distance for the repel effect, and describe the rate at which the repel force increases as the delegate approaches the obstacle. Repel exerts a force on the delegate to turn it away from the obstacle. It does not guarantee avoidance. You must work with its Distance and Falloff parameters, as well as its weight in the Behavior Assignments and Teams dialog on page 5188, to control its strength. Repel can be used instead of the Avoid behavior as a simple avoidance technique for non-terrestrial creatures such as fish or birds.

Use a Vector Field on page 5258. This is a special type of space warp that crowd members can use to move around irregular objects such as a curved, concave surface. You can use the Vector Field space warp in conjunction with the Avoid behavior to make delegates slow down when they approach a complex object, and then go around it. This guarantees that the delegate will not pass through the obstacle's surface. You can also use the Vector Field space warp in conjunction with the Space Warp behavior on page 5226. This simply exerts a force on the delegate that mimics the contours of the object. It does not assure that the delegate will not pass through the surface of the obstacle. You can use a Vector Field with both the Space Warp and Avoid behaviors to combine their effects.

Procedures

To use the Avoid behavior:

1. Add an Avoid behavior to the Crowd object.
2. In the Avoid Behavior rollout, use the None button or the Multiple Selection button to designate the target object or objects to avoid.

   **TIP** To make an entire team of delegates avoid each other, choose all delegates in the team. The crowd system will cause each delegate to avoid all others except itself.

3. Turn on Display Hard Radius to see the radial avoidance area in viewports. Adjust the Hard Radius to the appropriate size for your delegates.
4. Adjust the Brake Pressure to determine whether a delegate will slow down when it encounters an avoided object.
5 Adjust the Look Ahead parameter to determine how many frames ahead each delegate will look to determine the best way to avoid others.

6 Use Behavior Assignments on page 5188 to assign the behavior to a delegate or team.

To use the Wall Repel behavior:

1 On the Create panel, click Helpers, and click Grid. Create a grid in the scene.

   **TIP** For best results, do not use Mirror to copy a grid to be used with behaviors. Use Shift+Clone instead.

2 Move and rotate the grid to position it.

   **TIP** The Wall Repel behavior repels delegates from the grid in the direction of grid's local Z axis. With the grid still selected, use the Local coordinate system to see the direction of the Z axis in viewports; the axis arrow points in the direction of the positive Z axis. Checking the Z-axis direction will speed the process of setting up the behavior.

3 Select the crowd object, and add a Wall Repel behavior.

4 In the Wall Repel Behavior rollout, click None, and pick the grid.

5 Choose Positive Axis to cause the delegates to be repelled from the Z-axis side of the grid. You can also choose Negative Axis to repel delegates from the opposite side of the grid, or Both to repel them from both sides.

6 If you want delegates to be attracted to the grid only when they are within a specified area in front of the grid (rather than when they are anywhere in the scene), turn on Use Distance. Use the Inner Distance and Outer Distance parameters to set the area in which delegates will be attracted to the grid. Turn on Display Distance to see the distance in viewports.

7 Use Behavior Assignments on page 5188 to assign the behavior to a delegate or team.

To use the Repel behavior:

1 Add a Repel behavior to the Crowd object.
2 In the Repel Behavior rollout, use the None button or the Multiple Selection button to designate the object or objects that are to repel delegates.

3 Change the default settings as desired.

4 Use Behavior Assignments on page 5188 to assign the behavior to a delegate or team.

To add a Vector Field space warp:

Adding a Vector Field space warp object works the same as adding a Box geometry primitive.

1 On the Object Type rollout, click Vector Field.

2 Drag in a viewport to set the initial dimensions.
   ■ If using the Cube creation method, this sets all three dimensions simultaneously.
   ■ If using the Box creation method, release the mouse button, and then move the mouse vertically to set the height.

3 Click to create the space warp.

To use a Vector Field space warp with delegates:

This procedure presents general guidelines for using the Vector Field space warp with delegates in a crowd simulation.

1 Create an object to serve as an obstacle. This object must be an editable mesh or geometric primitive; it can have modifiers.

2 Add a Vector Field space warp.

3 Position and scale the space warp lattice so that it encloses the obstacle object.
   The lattice should be significantly larger than the object. The object should be located roughly at the lattice center.

4 In the Lattice Parameters rollout, increase the Length Segs/Width Segs/Height Segs settings so that the lattice segments intersect the object at reasonable intervals.
   To determine appropriate Segs settings for your obstacle objects, first examine the object complexity. If the obstacle has a lot of detail, and
you want that detail reflected in the vector field, then you need a relatively high lattice resolution.

5 Click the Obstacle Parameters rollout > Compute Vectors group > Vector Field Object button (initially labeled “None”), and then in a viewport, click the object that will act as an obstacle in the crowd simulation. This specifies the obstacle object. The range volume grid appears on the object’s surface as an olive-colored wireframe.

6 Increase the Obstacle Parameters rollout > Compute Vectors group > Range setting. As you increase this setting, you’ll see the range volume grid expand. The range volume should enclose the space in which crowd members need to start turning in order to avoid the object.

7 Turn off Display group > Show Lattice and Show Range so that the vector field will be more easily visible when generated.

8 Turn on Display group > Show Vector Field.

9 In the Compute Vectors group, click the Compute button. This generates the vector field.

**TIP** To make the vector lines more evident, increase the Display group > VectorScale setting.

The vectors appear as blue lines surrounding the obstacle object. One vector is computed for each lattice intersection within the range volume grid. Each vector matches the normal of the object at the point on the object’s surface closest to the lattice point.

The vector force falls off with distance from the object, as shown by the progressively shorter vector lines toward the grid perimeter.

10 Add Crowd on page 5162 and Delegate on page 5154 helper objects.

11 Select the Crowd object and open the Modify panel.

12 In the Setup rollout > Behaviors group, click New.

13 In the Select Behavior Type dialog that is displayed, choose Space Warp Behavior, and then click OK.

14 In the Space Warp Behavior rollout that appears, click the button (initially labeled “None”), and then in a viewport, click the Vector Field space warp.
TIP  You might find it easier to use Select By Name to select the space warp.

15  In the Setup rollout, click the Behavior Assignments button, and use the Behavior Assignments And Teams dialog on page 5188 to assign your delegate or delegates to the space warp behavior.

16  Add any other objects or behaviors appropriate to the simulation.

17  Select the Crowd object, and then solve the simulation by clicking the Solve rollout > Solve button.

18  Fine tune the behavior associated with the Vector Field space warp by adjusting the Lattice parameters on page 5260 and Obstacle parameters on page 5261.

19  Continue computing the vector field and then solving the simulation after each adjustment. In certain cases you might need to animate the vector field parameters to keep objects within the field.

### Changing Delegate Orientation and Speed

You can use the Orientation behavior on page 5213 to change the direction in which a delegate moves, and the Speed Vary behavior on page 5227 to vary delegates' speed or make them stop moving altogether.

After setting up a behavior, you must use Behavior Assignments on page 5188 to assign the behavior to a delegate or team.

**Procedures**

**To use the Orientation behavior:**

1  Select the crowd helper and access the Modify panel.

2  In the Setup rollout > Behaviors group, click New. Choose Orientation Behavior from the pop-up list. The Orientation Behavior rollout appears below the Setup rollout.

3  To restrict the heading orientation with respect to the delegate's current heading, turn on Heading group > Relative. To restrict the heading to a specific direction or range, leave Relative off.
To restrict the pitch orientation with respect to the delegate's current pitch, turn on Pitch group > Relative. To restrict the pitch to a specific direction or range, leave Relative off.

Change the other default settings as desired.

To use the Speed Vary behavior:
1. Add a Speed Vary behavior to the Crowd object.
2. Adjust the Center and Deviation as needed to control delegate speed. Change other settings as desired.

Solving the Simulation

After you have set up behaviors for delegates, you must solve the simulation to generate keyframes on delegates. You solve the simulation by selecting the crowd object and clicking Solve in the Solve rollout on page 5244.

In order to generate the simulation as quickly as possible, delegate keys are saved after the solution is run, so there might be a pause between the end of the solution and return of control of 3ds Max to you. Also, any objects linked to delegates are hidden during the simulation.

You will most likely have to solve a simulation several times before it is correct. Watch the animation after the solution is calculated, correct behaviors or delegate parameters as necessary, then solve again.

You can speed up the solution calculation time by decreasing the frequency of keyframes or screen updates. You can also view the solution one frame at a time to help pinpoint trouble areas.

**Procedures**

**To solve a simulation:**
1. Set up a crowd simulation with a crowd helper, delegates and behaviors. See Assigning Behaviors on page 5115.
2. Select the crowd helper.
3. On the Modify panel, in the Solve rollout, set the Start Solve and End Solve parameters to set the start and end frames for the solution.
4. Click Solve.
TIP To use the keyboard shortcut for the Solve button, turn on the Keyboard Shortcut Override Toggle and then press the S key to run a solution.

Wait a few moments while the solution is calculated. The progress bar at the bottom of the screen tells you the status of the solution process.

To speed up the solution time:

1. Under Save every Nth Key, set the Positions and Rotations parameters to a higher number, such as 5. This causes the simulation to set delegate keyframes every five frames rather than at every frame.
2. Increase the Solve rollout > Display During Solve group > Frequency setting to a higher number, such as 100. This will cause the display to update with the new delegate locations only every 100 frames.

To troubleshoot the simulation:

In a crowd simulation, it is not uncommon for a short portion of the animation to have a unique problem that doesn’t appear on other frames. Use Step Solve to analyze short portions of your simulation when things don’t go as expected.

1. Move the time slider to the frame at which you want to start solving one frame at a time.
2. Click Step Solve.

To use the keyboard shortcut for the Step Solve button, turn on the Keyboard Shortcut Override Toggle and then press the T key to run a solution in step mode.

You can start at any frame. Zoom in to examine the vectors of misbehaving delegates.

3. Press the spacebar to solve the simulation one frame at a time.
4. Press Esc to exit Step Solve mode.
Linking Objects to Delegates

You can link objects or bipeds to delegates to make them follow the simulated animation.

You can link objects to delegates with 3ds Max linking. Alternatively, the crowd system has a tool for automatically aligning and linking objects with delegates.

When you want to use bipeds with delegates, you associate bipeds with delegates rather than link them. This approach enables the bipeds to use a motion flow network to determine their motion during the simulation. For an explanation of how to set up a biped crowd simulation, see Biped Crowds on page 5136.

Procedures

To link objects to delegates:

1. Set up a crowd simulation with a crowd helper and delegates. See Creating Crowd Helpers on page 5110.

2. Create a series of objects to follow the delegates.

    **TIP** In a later step, you will align each object’s local Y axis to point in its corresponding delegate’s forward direction. For this reason, you should take care to make sure your objects’ local Y axes point in the direction you consider to be “forward”. The easiest way to do this is to set up one object with its Y axis pointing in the forward direction, then clone the object.

3. Select the crowd helper, and access the Modify panel.

4. On the Setup rollout on page 5163, click Object/Delegate Associations. The Object/Delegate Associations dialog on page 5179 appears.

5. Click Add under the Objects list to add objects to link with delegates.

6. Click Add under the Delegates list to add delegates to link with the objects you added in the previous step.

    Each object in the Objects list will be associated with the delegate in the same position in the Delegates list. If necessary, reorder either list manually by highlighting entries and using the Shift Up/Shift Down buttons; these are the arrow buttons between the two lists.
To associate bipeds with delegates:

1. Set up a crowd simulation with a crowd helper and delegates.
2. Create several bipeds, one for each delegate.
3. Select the crowd helper, and access the Modify panel.
4. On the Setup rollout on page 5163, click Biped/Delegate Associations. The Associate Biped with Delegates dialog appears.
5. Click Add under the Biped list, and choose the bipeds to add to the list.
6. Click Add under the Delegates list, and choose the delegates to associate the bipeds with.
7. Turn on Set Delegates to Use Biped.
   This will turn on the Use Biped option for each delegate, which is a requirement for biped crowd simulations.
8. Choose Make Specified Associations to associate each biped with its corresponding delegate listed on the dialog. Alternatively, choose Associate Delegates With Closest Biped to associate each delegate with the biped nearest to it in the scene.
9. Click Associate to make the associations, and click Close.
   Unlike regular objects, bipeds are not aligned with delegates immediately. Each biped will align with its respective delegate when the simulation is solved.

**NOTE** In order for a biped crowd simulation to solve correctly, it must have a motion flow network for the bipeds to follow. See Biped Crowds on page 5136.
Cognitive Controllers

You can use the cognitive controller feature to cause crowd members to change behaviors during a simulation depending on the circumstances. For example, a character could wander randomly until it comes within a certain distance of a target, at which point it could head straight for the target.

In technical terms, cognitive controllers let you influence crowd simulations with scripted conditionals, effectively implementing a form of artificial intelligence. You use the Cognitive Controller editor on page 5199, a flowchart-style editor (much like the Motion Flow Graph dialog on page 4891) to set up a network of behaviors and behavior combinations, known as states. Then you then apply MAXScript-based transitions that specify when delegates are to move from one state to another. Even with a relatively simple setup, you can create simulations that make your characters appear to be living, conscious beings, making decisions as they move through the scene.

You can find procedures describing various examples of cognitive-controller transitions in the State Dialog on page 5202 topic:

- Testing a particle system parameter on page 5204
- Testing an object position
- Testing an atmospheric property on page 5204
- Testing the distance between two objects
- Testing a modifier parameter
- Testing another delegate's behavior on page 5205

See also:
- Cognitive Controller Editor on page 5199
- State Dialog on page 5202
- State Transition Dialog on page 5203

Procedures

To set up and use a cognitive controller:

This procedure describes a typical setup routine for creating and using a cognitive controller. The procedure assumes basic knowledge of crowd
simulation setup. For more information about crowd setup, see Crowd Helper Object on page 5162 and Setup Rollout on page 5163.

1 Create a scene containing a crowd object and one or more delegates. See Creating Crowd Helpers on page 5110.

2 Create at least two behaviors. See Assigning Behaviors on page 5115.

3 Open the Cognitive Controller editor on page 5199.

4 Click the New button to create a cognitive controller. character studio gives the controller the default name of “Cognitive Controller.” It's recommended that you give more descriptive names to cognitive controllers, such as "Seek/Wander". Do this by clicking on the name in the text box and editing it from the keyboard.

Creating a new cognitive controller automatically places you in Create State mode.

5 Click in the editor window to create and place a state. Continue clicking in different places to add as many states as necessary.

6 Right-click a state to open the State dialog on page 5202.

7 Again, it's recommended that you give more descriptive names to states, which you can do in the State dialog. Click the name (State or State#) in the text box and edit it from the keyboard.

Next, define a behavior or behaviors for each state.

8 Click the Add button.

9 In the Select Behaviors dialog, choose one or more behaviors.

If you choose multiple behaviors, you can specify different weights for each in the State editor. For example, you can combine a Seek behavior at full weight with a Wander behavior at half weight, so that the delegate will meander slightly as it seeks the target.

10 Close the Select Behaviors dialog, and then close the State editor.

11 Repeat steps 6–10 as necessary to define behaviors for the other states in the controller.

Next, use Create Transition to define the sequence of states during the simulation.
12 Decide on the sequence in which the states are to occur.

13 Click the Create Transition button.

14 Drag a line from one state to the next in the order that they are to execute. Click a state to create a transition from itself to itself. A transition arrow appears, pointing from the "source" state to the "destination" state. Each state can have any number of incoming and outgoing transitions. Specify different transition conditions for each to create as complex a state diagram as necessary.

Next, use the State Transition dialog to define a conditional for each transition.

15 Right-click a transition line.

16 In the State Transition dialog on page 5203, enter the name of the transition condition, and then click the Edit MAXScript button.

17 Use the MAXScript editor window to enter or load a script that defines the condition or conditions under which the transition is to occur. Typically, this is a function that tests a condition and returns 1 (if true) or 0 (if false).

**NOTE** See this topic in the online User Reference for sample MAXScript code for this function.

- **fn** - What follows is a MAXScript function.
- **test1** - The function name; this should also appear in the Transition dialog, as the transition condition. This function is executed first when the transition is tested. The script may contain any number of additional functions to be called from within a function in the script.
- **del** - Refers to the delegate to which the script is currently being applied. The transition script is executed once per frame for each delegate/team member the cognitive controller is assigned to. Thus, if you use "del" in the script rather than the name of a specific delegate, all delegates to which the cognitive controller is assigned are tested.
- **t** - The current time (frame number) in the simulation.
- **del.simpos.x** - The delegate's current position on the X-axis. The special function "simpos" is used to determine a delegate position during a
simulation solution. This is necessary because delegate positions aren’t available to MAXScript using the standard "[node].pos" function during a simulation.

- del.duration - The number of frames the delegate has been in the current state.
You can see a complete list of delegate-specific parameters that can be checked in the script by opening a MAXScript Listener window (press function key F11) and entering:

```maxscript
ShowProperties $delegate01
```
And because the delegate is a node, it also responds to standard MAXScript node-related functions, with the exception of "simpos," as noted above. Also, for information on how to access the transition properties, such as duration and priority, see the MAXScript Help.

For more examples of MAXScript conditionals that can be used with cognitive controllers, see State Transition Dialog on page 5203.

18 Use the State Transition dialog to set other parameters such as priority and duration.

19 Use the Behavior Assignments and Teams dialog on page 5188 to assign the cognitive controller to delegates or teams.

**NOTE** Crowd doesn’t let you use multiple cognitive controllers with a delegate. You can assign them, but when you solve, character studio notifies you that it will use only the first assigned cognitive controller.

### Using Motion Synthesis

You can create advanced, complex crowd simulations in character studio with motion synthesis, which lets character studio adjust the simulation results dynamically to account for differing conditions. Two different forms of motion synthesis are available: one for non-bipedal crowds, and a second for the more exacting requirements of biped crowds.

### Biped Crowds

The biped crowd is a special case of crowd simulation necessitated by the complex nature of legged animal movement. Biped locomotion exhibits
intricate dynamics and exacting IK foot constraints. As such, the smoothly curving trajectories computed from delegate motion parameters, while suitable for birds, fish, insects, and snakes, are not rich enough to animate the microstructure of bipedal motion. Therefore, several features in Crowd are focused on the special needs of bipeds.

In order to generate the required level of nuance, animated motion clips form the basis for the repertoire of biped movements. In other words, during a Biped/Crowd simulation, the delegates have no effect over the motion of the Biped, they only set goals to be achieved using clips available in the Motion Flow graph. With this approach, known as motion synthesis, the animator can precisely control details in the motion either by using hand animation or employing motion capture to produce a set of clips that describe how a member in the crowd behaves.

For example, if you wanted to animate a crowd of marathon runners making their way through the streets of a city, you would need motion clips for various kinds of walking, running, jogging, resting, drinking water, cheering, etc. In effect, each of the motions you might expect to see in a marathon race could be represented as a clip. But motion must be more than a fragmented collection of clips. You must also consider how motions might be sequenced. Which motion transitions are possible from a given motion clip?

To best understand this process, study this topic and follow the procedure Using bipeds in a crowd simulation on page 5142.

Motion Flow Network and Possible Scripts

Biped’s Motion Flow on page 4886 functionality provides the mechanism for defining how separate motions fit together into a fluid animation. In effect, the motion flow network describes which motions can follow from other motions. Once the motion flow network is defined, a broad set of animated actions is possible by following different paths through the network. In Biped, a path through the network is called a motion flow script.

For example, shown below is a motion flow network used in the sample file walkers.max. You can find this file in the cstudio\tutorials\biped_crowds folder in your 3ds Max path. This folder also contains the BIP files used in the motion flow network. You can access these files only if you have installed tutorials on your hard disk. For information on installing tutorials, see the Installation Guide.
This is a fairly simple network of possible motions, because the characters can only start, stop, turn at 90 degree angles left and right (walk_L90 and walk_R90), and do an about-face (walk_180). However, for more natural crowd interaction, it’s advisable to expand the motion flow network to include shorter, more finely tuned variations such as turning at 45 degree increments, moving in different directions while facing the same way, loitering motions, and moving at different speeds. The Biped Motion Library has a comprehensive list of clips for you to experiment with.

**TIP** You can create motion clips that curve slightly to the left and right by applying Biped’s footstep-bending operation to straight-line motion clips. If the clips are motion captured, you should employ footstep extraction during import in preparation for the bending operation. Adding clips that turn slightly will let the biped crowd simulation make minute corrections in heading in order to achieve goal locations more precisely.

Motion flow graphs that work best incorporate fine-tuned transitions. A good way to check your motion-flow transitions is by building test scripts as you build the graph: Add clips to the graph, add the necessary transitions, and optimize the transitions. Optimizing transitions works well as a starting point and, more often than not, produces the smoothest transitions. Next, make a new script that uses your transitions, and use the script to tweak the motion flow until the feet don’t slide.
The Shared Motion Flow Networks feature lets many bipeds use a single motion-flow network. Therefore, it’s practical to make motion-flow networks large without taxing your computer’s memory.

**Delegate-Directed Behavioral Goals**

You can give a biped a behavioral goal by associating it with a delegate in the Crowd system, and then assigning behaviors to the delegate.

For example, in the *walkers.max* sample, the behavioral goals of each of the biped’s delegates are to:

- Move toward the sphere using the Seek behavior.
- Avoid hitting each other using the Avoid behavior.

During a biped crowd simulation, *character studio* attempts to compute the best motion flow script for each biped member of the crowd that satisfies the behavioral goals of its associated delegate. In other words:

- The biped’s crowd delegate defines the behavioral goals of the biped.
- The possible motions to reach those goals are defined by the biped’s motion flow network.
- The Crowd object’s Solve operation computes the script, or path through the motion flow network, that best meets the goals of the biped’s delegate.

So in the *walkers.max* sample, the simulation will always choose the best available walking clip in the network that directs the biped’s delegate toward the sphere. Each biped’s script evolves as the crowd "Solve" computes. This is somewhat like a real-time “game engine” in that the crowd solver’s choice of the next best clip for a given biped is restricted by that biped’s currently active clip.

**Biped Crowd Avoidance, Priority, and Backtracking**

Because bipeds in crowds are always following motion flow scripts, the avoidance behavior for bipeds works differently. Unlike ordinary delegates, biped delegates can move only along motion flow-scripted paths, so if a collision takes place, *character studio* will backtrack on page 5248 to the previous clip in the current script and find another path. This may take some time to compute when complex crowd interactions are present since a single backtrack may not be enough. The computation will explore all paths from a given
backtracking clip, and if that fails, it will backtrack to the previous clip, and so on, until a solution is found.

In the example, if the current script of a biped is:

```csharp
walk_start
walk
walk_L90
```

and a collision is encountered during the `walk_L90` clip, the biped will backtrack to the end of the `walk` clip and attempt to try a different clip in place of the failed left turn. If that fails, it will try the next best choice, and so on.

---

**TIP** The inclusion of stopping and loitering motions in the motion flow network is sometimes helpful in preventing excessive backtracking since stopping is always an effective way to avoid collisions in a tight situation. In general, the more variation in speed and direction that is possible, the more quickly the backtracking feature will find a solution.

In order to make the backtracking computationally manageable, the biped crowd members are computed one at a time, in order of priority on page 5248. Thus, the crowd interaction is accumulated with each successive biped added to the animation. In other words, each waits its turn to compute its complete animation, which entails avoiding the bipeds that have been computed before it. It follows that bipeds with the lowest priorities generally encounter the most collisions, since they must steer around all the bipeds that have higher priorities.

---

**Preparing Characters for a Biped Crowd**

To create a biped crowd simulation, you will need several bipeds. Because the crowd simulation factors in each biped’s leg length when applying clips to the biped, your simulation will be more accurate if your bipeds are the correct size from the start.

One straightforward workflow would be:

- In a separate file, create or acquire a few character models for your scene.
- Skin the characters with Physique or with another method, such as the 3ds Max Skin modifier.
- Clone the characters and change something about each one, such as the color of clothing or hair, and the character’s height. See Scaling a Character on page 5002.
Give each character a unique name that will allow you to identify it in the simulation to some degree. Example: BigMan02, LittleGirl03. See Naming the Biped on page 4494.

For each character, disable the MeshSmooth modifier or other modifiers above Physique that add polygons.

Hide the character meshes and leave the bipeds visible.

This setup makes it easy to merge the characters into the crowd scene. When characters are merged, the meshes themselves will be hidden, which will improve system performance.

Preparing Motions for a Biped Crowd

The clips you use for a biped crowd simulation can be loaded from the CD that comes with character studio, imported from motion capture files, or created from scratch.

The integrity of transitions between clips in the motion flow network is very important when creating a biped crowd simulation. When creating transitions for a single biped, it's a simple matter to correct individual transitions after the motion flow script has been created. With a crowd, having to correct transitions for each biped after the simulation is complete would be extremely time-consuming. It is much more efficient to ensure your transitions are correct before starting to solve the simulation.

One way to make this process easier is to set up all motions so each has an ideal transition of exactly the same number of frames, such as 10 or 15. Then you can optimize transitions for this length, and all or most transitions will work flawlessly.

To check transitions, create a simple script for one biped using several transitions in the graph. Check the motion and work with transitions individually until they look right. You might not catch all bad transitions with this method, but you'll catch most of them. A "bad" transition would be one where the feet skip or hop when they should be walking, or any other undesirable change that occurs during a transition. See Customizing Transitions on page 4865.

After solving the biped crowd simulation the first few times, check again for bad transitions you might have missed the first time around. After a few simulations, most likely you will have found all or nearly all the bad transitions.
Restrictions

Some features of the crowd system are not designed to work with biped crowds. These behaviors and parameters have no effect on the crowd’s movements when bipeds are used with the simulation.

- Vector fields
- The Look Ahead parameter in the Avoid behavior

Procedures: Using Bipeds in a Crowd Simulation

The following sequence of procedures gives the basic steps for creating and saving a motion flow graph, assigning several bipeds to delegates, and then sharing the motion flow graph among the bipeds so that character studio automatically creates separate motion flow scripts for each biped, based on the behaviors assigned to its delegate.

NOTE These procedures assume you know how to animate bipeds with footsteps and keyframe methods, and save the animations as BIP files. To prepare for using Shared Motion Flow, you should create and save a range of biped motions such as start, walk, turn right, turn left, stop, and wait. See Loading and Saving BIP Animation on page 4638.

The first step is to create an appropriate motion flow graph and save it to disk.

To create the shared motion flow:

1. Add a biped, and then open the Motion panel.

2. Click the Biped rollout > Motion Flow Mode button.

3. Click the Motion Flow rollout > Show Graph button.

4. In the Motion Flow Graph toolbar, click the Create Multiple Clips button.
   This displays an Open dialog that lets you select any number of BIP files from the same directory to add simultaneously to the motion flow graph.
Use Click+Shift+click (click, and then Shift+click) to choose several contiguous files, and Ctrl+click to choose non-contiguous files.

5 Choose the BIP files you want character studio to use for motion synthesis, and then click the OK button.

The files are added to the graph as clips. Each clip is automatically named after the file from which it's derived.

**NOTE** For best results, especially with simulations in which bipeds are to turn at different angles, use as many different turning clips as possible. A minimal setup would include separate left-turn and right-turn walks at angles of 45, 90, 135, and 180 degrees.

The next step is to add transitions among the clips so character studio knows which actions can proceed to and from other actions. You can do this manually for greater control, but for initial testing, you can save time by letting character studio add and optimize transitions automatically.

6 Click the Synthesize Motion Flow Graph button. This uses the first 30 percent and the last 30 percent of each motion to create transitions.

The graph now shows arrows to and from each clip, as well as from each clip to itself. If you like, delete transitions that obviously don't belong, such as the ones from the stop and start clips to themselves.

Alternatively, you can use Create Transition to set up a custom graph.

7 Optimize the transitions. See Transition Optimization Dialog on page 4913.

When you solve the simulation, Crowd automatically generates a motion flow script for the biped, based on this graph. When you have a graph with multiple clips, as in this case, it chooses the starting clip for the script from one or more clips you designate as random start clips.

If you want to check the integrity of transitions before continuing, do so now. See Customizing Transitions on page 4865.

8 Click the Select Random Start Clips button, and then click a clip.
This tells character studio to start the script with this clip, and uses the default probability of 100 percent that the clip will be chosen.

If you want the various bipeds to start with different clips, select multiple random start clips by pressing and holding the Ctrl key as you click. The default Random Start Probability setting of 100 for all clips means that character studio will choose randomly among them for a starting clip for each biped’s script.

To change the likelihood of starting with specific clips, right-click a clip and modify its Random Start Probability setting. For example, say you want to start each biped’s script with any of three clips: clips A, B, and C. You want clip A to be chosen twice as often as clip B or C. In that case, using the Random Start Clips tool, you’d first click clip A, and then Ctrl+click clips B and C. Then you’d right-click each in turn, assigning a Random Start Probability of 60 to clip A, and 30 to both clips B and C.

NOTE The Probability values are arbitrary; what counts is their ratios. For example, values of 80/40/40 or 20/10/10 would work the same.

NOTE You can also set and change random starting clips and start probabilities in the Motion Flow graph after loading the MFE file into the Shared Motion Flow dialog, described later in this procedure.

NOTE If a motion flow script already exists for a biped, for example after you’ve solved a crowd simulation, character studio can use the first clip in the script for subsequent solutions.

9 In the Motion Flow rollout, click the Save File button, and save the graph in the MFE format.

The next step in using bipeds in a crowd simulation is to create the simulation.

To set up the crowd simulation:

1 Reset 3ds Max.

2 Set up a crowd simulation with any number of delegates, using behaviors appropriate to the crowd scene you want to create. Do not use bipeds at first; work with delegates only to rough out the motion of the crowd members.
When first starting out with motion synthesis, use smaller crowds of eight or so delegates.

Solve the simulation and adjust the settings as necessary to obtain the desired motion.

Merge bipeds and characters into the scene, and associate each delegate with a different biped using the delegate’s Motion Parameters rollout on page 5156 > Biped group settings.

You must select the biped’s center of mass (COM) object (typically named Bip0#), as indicated by the mouse cursor turning into a crosshairs icon when it’s over the COM in the active viewport.

Turn on Use Biped for each delegate.

To link up any number of delegates with bipeds, all at the same time, select the Crowd helper object and click the Setup rollout > Biped/Delegate Associations button on page 5185. Use the dialog to connect the pairs and turn on Use Biped for each delegate. See Linking Objects to Delegates on page 5131.

Set the biped/delegates to use a random start clip as the first clip. You can set this simultaneously for multiple delegates with the Edit Multiple Delegates dialog on page 5182.

To apply the shared motion flow:

Next, you use the Shared Motion Flow function to apply the saved motion flow graph to the bipeds.

Select any biped and open the Motion panel.

Click the Biped rollout > Motion Flow Mode button.

Click the Motion Flow rollout > Shared Motion Flow button.

In the Shared Motion Flow dialog, click the New button. This creates a new shared motion flow and assigns it a default name. You can change the name if you like.

Next, load a motion flow file.
5 Click the Parameters group > Load .mfe button, and use the Open dialog to load a motion flow file. Typically, this would be the one you saved earlier in the procedure. Next, specify the bipeds that will share this motion flow.

6 In the Parameters group, click the Add button, and use the Select dialog to specify the bipeds that will share the motion flow.

For your convenience, the Select dialog shows only center of mass objects for the bipeds in the scene.

After you click the Select button, the bipeds appear in the dialog, in the list under "Bipeds Sharing this Motion Flow."

7 To correctly share a motion flow, bipeds’ legs must be scaled the same. If any of the bipeds are scaled differently than the one you started with, an alert appears, and then, when you click the OK button in the alert box, the wrong-scale bipeds are noted as such in the list. At this point, you can select one of the bipeds in the list, and then click the Set Shared Motion Flow Scale button to match the others’ scale to that biped. Or you can click one of the Reset Wrong Scales buttons to rescale the wrong-scale bipeds or just their legs. Be sure to take one of these measures before proceeding.

One more step in the Shared Motion Flow dialog is necessary: You must activate Motion Flow mode for all the bipeds sharing the motion flow. A special button in the dialog lets you perform that action in one step.

8 Click the Put Multiple Bipeds in Motion Flow button. This activates Motion Flow mode for all the bipeds sharing the motion flow.

9 Click the OK button to exit the dialog.

To offset the delegates and test the simulation:

Delegate-controlled bipeds can begin their animation with their motion flow scripts’ first clip, if it exists, or with a random motion clip. But when you load a motion flow file into the Shared Motion Flow dialog, any scripts in the file are ignored. Thus, delegate-associated bipeds using motion flow in an unsolved crowd simulation have no existing scripts, and you must specify that they use
the random start clip that you set in the motion flow. You do this via the
delegates.

1 Use the Edit Multiple Delegates dialog > Biped group to specify Random
Start Clip for all the delegates.
   Solve the simulation.

2 Select the Crowd object, and go to the Modify panel.

3 In the Solve rollout, set the desired End Solve frame.

4 Click Solve to run the simulation.
   Crowd solves the simulation.

5 Check the solved simulation by dragging the frame slider and/or playing
back the animation.

To fine-tune the simulation:

Chances are good that adjustments will be required. You can resolve problems
in a number of different ways: Change the behavior and/or motion flow setups,
change delegate parameters, and so on.

If you find that bipeds are colliding and interpenetrating, you can take
advantage of Crowd’s special Priorities and Backtracking features. In fact, it is
strongly recommended that you use both options for most Crowd/Biped
simulations.

1 Use the Priority rollout on page 5248 controls for assigning different
   priorities to your delegates. Typically, delegates at the head of the crowd
   should have the highest priorities (that is, the lowest Priority settings).

2 In the Solve rollout > Biped group, turn on Biped/Delegates Only, then
   turn on Use Priorities, and then turn on Backtracking. If you’ve solved
   previously, it’s a good idea to turn on Delete Keys Before Solve as well.
   Now, when it solves the simulation, Crowd solves for one biped/delegate
   at a time, starting with the lowest-priority biped/delegate. As it solves for
   each subsequent biped/delegate, it looks for collisions, and when the
   occur, it backs up the solution to the end of the previous clip, and if
   necessary, previous clips, and then tries different paths through the
   motion flow graph. This method can take longer, which is why
   Backtracking is off by default, but it’s often the best way to resolve
   problems with colliding bipeds.
Non-Biped Crowds

Motion synthesis in character studio lets character studio derive character motion from a combination of crowd behaviors and either motion flow networks, when animating bipeds (see Biped Crowds on page 5136), or clip controllers, when working with non-bipedal creatures. In the latter case, using the Global Motion Clip and Master Motion Clip controllers, you can animate groups of creatures such as birds, butterflies, schools of fish, and insects. You can create clip controllers either as block controllers in Track View, or, more directly, with the Crowd helper controls on the Global Clip Controllers rollout.

Two Approaches to Animation

You can animate your creature either in place with looping animation but no transformational motion (such as a bird flapping its wings), or you can incorporate transformational motion into the animation as well (the bird moves upward while flapping its wings). In-place cyclic motion lends itself to flying or swimming motions like birds and fish, while adding lateral motion lends itself to crawling type animation where feet should be planted on the ground and not sliding. Depending on which you use, you toggle options on the Motion Clips tab of the Synthesis dialog. In both cases, you use crowd delegates driven by behaviors to motivate the creatures, which are linked to those delegates.

NOTE To animate a model for motion synthesis, apply modifiers to the model and animate their parameters. Modifiers such as Bend, Taper, Wave, and Xform produce animation you can use with motion synthesis. Do not use sub-object animation, such as animation of vertices on an Editable Mesh object.

Cyclic In-Place Animation

First you create a creature with a few short loop cycles, like the beating of wings, gliding, turning left and turning right. This creature is assigned as the Global Object or the master object from which the motion clips will be derived. Then clones of the original creature are created. The clones are positioned and linked to delegates. States are created to select which clips will play based on a state.

For example, if a bird (delegate) is pitching up or accelerating, the fast-beating clip is used; if the bird (delegate) slows to a stop, the wings-at-rest clip is used, and so on. During synthesis, character studio determines which state should be active depending on the speed and direction of the delegates. An active state determines which clip should be applied to the clones of the original...
object. Clips are blended together to create the animation. Available states are speed, acceleration, pitch, pitch velocity, heading velocity, or script (MAXScript).

**Animation with Lateral Motion**

For multi-legged creatures that walk, you can animate lateral motion as well as the cyclic motion of the legs moving. This is done to ensure that the creatures' feet do not slide as they move. **character studio** then uses the lateral motion information to create a state that perfectly matches the actual motion. **character studio** then strips the actual motion out. When a delegate approaches the speed and heading recorded in that state, the appropriate motion clip is triggered. This technique minimizes sliding feet.

Use the **character studio** crowd tools to create the initial motion for the delegates. Use a seek or avoid behavior to steer birds, for example. Your object with the loop animation is then copied and the copies are linked to the delegates to create the complete animation. The delegate handles the path and the clip controllers handle the looped animation.

You can create Master Motion Clip and Global Motion Clip in Track View by assigning a controller to the available controller under Block Control. It is, however, simpler to use the Crowd helper controls on the Global Clip Controller rollout to apply and use the clip controllers.

**See also:**
- [Synthesis Dialog](#) on page 5268
- [ClipState Dialog](#) on page 5280

**Global Motion Clip**

Global Motion Clips store the clips to be shared among multiple Master Motion Clips, which are assigned to the cloned objects during synthesis. Global Motion Clips also contain the logic for performing motion synthesis on a collection of objects with trajectories and states associated with clips. Controls for motion synthesis are found in the Synthesis dialog.

The way the motion clip keys are scaled and ordered depends upon user-defined states. Each state contains one or more motion clips that will be played when the state is active.
**Master Motion Clip**

Master Motion Clips are controllers that contain *motion clips*, or individual clips of animation. These motion clips are sequenced to create animation, and overlap slightly with automatic blending to smooth the transitions between clips.

**Procedures**

**To use Motion Synthesis with non-bipedal creatures:**

All of the work involved in copying and synthesizing clips takes place using controls in the *Synthesis dialog* on page 5268. This dialog has three tabs: Motion Clips, State, and Synthesis.

This procedure assumes that the global object is static and has animation that loops. For creatures with many legs, you can animate lateral motion on the global object and then strip out the lateral motion with the Synthesis dialog. This latter approach serves to minimize foot sliding in a multi-legged creature.

1. **Animate an object.**
   Create animation in one position, like a bird’s beating wings. Create a variety of animation like a gliding motion (wings still), wings beating slowly, and so on. To animate the object, apply modifiers and animate their parameters.

   This will be the Global object, from which animation clips will be derived.

2. **Using the Create panel > Helpers > Object Type rollout, add a Crowd object and a Delegate object.**

   Create the objects in the Top or Perspective viewport.

3. **Use Scatter Objects** on page 5165 in Crowd function to clone the delegate and optionally distribute the clones (you can also distribute them manually).

   Make sure you end up with an equal number of delegates and animated object clones.

   Next, associate and link the objects to the delegates.

4. **On the Setup rollout, click the Object/Delegate Associations button.**

   The *Object/Delegate Associations dialog* on page 5179 appears.

5. **Add the objects and delegates into their respective columns.**
6 Click Align Objects With Delegates, and then click Link Objects To Delegates, and then click OK to exit the dialog.
The objects align themselves with the delegates and are linked to the delegates.

Next, animate the delegates with behaviors. See Assigning Behaviors on page 5115 for information on using behaviors.

When you solve the simulation, the cloned objects follow the delegates, which are guided by behaviors. You then generate motion synthesis based on the delegate movement.

7 Select the Crowd object. On the Modify panel > Global Clip Controllers rollout, click New, and use the Select dialog to select the Global object from step 1.
The object appears in the Global Clip Controllers rollout list.

8 In the list, click the object, and then click the Edit button.
The Synthesis dialog displays. Its name is that of the object.

9 On the Motion Clips panel, turn off all check boxes in the From Global Object and Remove Local groups.
Use these options only if your original object has lateral motion to coordinate with footsteps.

10 On the Motion Clips panel, click New.
This opens the MotionClip Parameters dialog, which lets you set the name, color, and frame range for a motion clip.

11 Choose a descriptive name and a frame range for the motion clip.
For example, frames 0 through 10 might be your glide animation.

12 Continue to define clips using different frame ranges from the Global object's animation. Give the clips descriptive names.
Next, you define states whose parameters determine when motion synthesis is to use each clip.

13 Click the State tab, and then click New State.
A new state is added to the drop-down list at the top of the Synthesis States group. Give the state a descriptive name. In many cases, the state can use the same name as the motion clip that's to be associated with it.

Next, you specify the state's parameters; that is, how the delegate should be moving when the associated object is to use its motion clip. For
example, your glide motion should be active only if acceleration is less than 0.

14 Click Edit Properties and define how character studio should activate the clip, based on any combination of speed, acceleration, and so on. Click each appropriate tab, turn on its Use ... check box, and set parameters. Click Exit to exit the dialog.

When using a range, make sure the Min setting is lower than the Max setting. For example, when using a negative range such as -180 to -10, enter the number with the higher absolute value (-180) as the Min setting.

You should already have several motion clips. Now you need to associate a clip with this state. For example, if you've defined a state whose acceleration is less than 0, you might associate the Glide clip with it.

15 In the MotionClips group, click Add Clip, and in the Select MotionClip dialog, highlight a clip and click OK.

16 Repeat steps 14 and 15 for each state to be used in motion synthesis.

17 Go to the Synthesis panel, click New Master Motion Clip, and add all of the cloned objects.

18 Click Auto Blend All and then click Synthesize All.

The synthesis occurs as a progress bar displays. When the synthesis is completed, the Synthesis dialog reappears. You can now view the ClipState parameters' ranges and average values by clicking State panel > Edit properties. This is useful in fine-tuning state properties.

Click OK to exit the Synthesis dialog.

19 Click Play. It's not necessary to re-solve the simulation.

The objects follow the delegates and are animated using clips that are activated according to delegate motion and the states you created.

Crowd Animation User Interface

Crowd animation lets you simulate the behavior of crowds of people, animals, or other beings parametrically, using several different types of objects. The topics that follow describe the user interface for setting up a crowd simulation.
Crowd of mannequins in a subway station animated using character studio

- The Crowd helper object on page 5162 includes facilities for replicating and grouping objects and assigning behaviors on page 5188 to objects and groups. The Crowd object works directly on Delegate helper objects on page 5154, and indirectly on bipeds and other objects via delegates.

- Cognitive controllers on page 5199 can change delegate behavior based on circumstances in the simulation.

- Motion synthesis on page 5258 uses animation from the linked object based on delegate orientation, speed and other factors.

**Crowd Shortcuts**

This topic summarizes the keyboard shortcuts available for crowd animation.

To enable the character studio keyboard shortcuts, turn on the Keyboard Shortcut Override toggle on page 8420.
All **character studio** keyboard shortcuts activate when the Motion panel is active and the Keyboard Shortcut Override button is active.

See also:
- Keyboard Shortcuts on page 8419
- Keyboard Panel on page 8250
- Customize User Interface Dialog on page 8249

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solve</td>
<td>$</td>
<td>Solves crowd simulation.</td>
</tr>
<tr>
<td>Step Solve</td>
<td></td>
<td>Step-solves crowd simula-</td>
</tr>
<tr>
<td></td>
<td></td>
<td>tion.</td>
</tr>
</tbody>
</table>

**Delegate Helper Object**

Create panel > Helpers > Object Type rollout > Delegate

The Delegate is a special helper object used in crowd animation. It serves as an agent for motion created by a **Crowd object** on page 5162 and its behaviors. The Crowd object controls a delegate or delegates, whose motion can then be imparted to a biped or other object. Delegates cannot be rendered.
The delegate object is shaped like a pyramid. By default, the point of the pyramid indicates the forward direction, the delegate's local Y axis.

The delegate object has two rollouts, described in the topics that follow. Also, you can set parameters for multiple delegates simultaneously, optionally with random variation, using the Crowd object’s Edit Multiple Delegates dialog on page 5182.

See also:

- Creating Crowd Helpers on page 5110
- Crowd Helper Object on page 5162

**Geometry Parameters Rollout**

Create panel > Helpers > Object Type rollout > Delegate > Geometry Parameters rollout

Select a Delegate object. > Modify panel > Geometry Parameters rollout
Use these parameters to modify the delegate object's size.

** Interface **

![Geometry Parameters]

**Width, Depth, Height** Sets the width, depth, and height of the Delegate object. These fields also act as readouts when you create the delegate.

**NOTE** The Delegate is a helper object, and thus cannot be rendered. Thus the size of the Delegate object is primarily for use in scene setup, and for determining bounding box extents.

**Motion Parameters Rollout**

Create panel > Helpers > Object Type rollout > Delegate > Motion Parameters rollout

Select a Delegate object. > Modify panel > Motion Parameters rollout

The Motion Parameters rollout lets you specify a Delegate object’s characteristics, including speed, acceleration, and other factors. It also lets you associate the delegate with a biped.

**IMPORTANT** When using delegates with bipeds, only the settings in the Biped group have any effect in the simulation, because Biped gets all its speed and turning information from motion flow clips and behaviors.

**NOTE** You can set any or all motion parameters simultaneously for a number of delegates with the [Edit Multiple Delegates dialog] on page 5182.
**Interface**

<table>
<thead>
<tr>
<th>Motion Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Velocity Color:</td>
</tr>
<tr>
<td>Active</td>
</tr>
<tr>
<td>Show Forces:</td>
</tr>
<tr>
<td>Show Velocity:</td>
</tr>
<tr>
<td>Show Cog Control States</td>
</tr>
<tr>
<td>Constrain to XY Plane</td>
</tr>
<tr>
<td>Bound Box of Hierarchy</td>
</tr>
</tbody>
</table>

**Velocity Color** When Show Velocity is on, uses the specified color to draw a vector in the delegate's center during the simulation solution. The vector length indicates the delegate's relative speed. Default=black.

**Active** The delegate object is subject to control by a Crowd object. Default=on.

**Show Forces** The forces being applied to a delegate by any applicable behaviors are drawn as vectors whose length indicates the extent of the forces and whose orientation shows the direction in which the behavior is influencing the delegate to move. Default=on.

For example, if the delegate is affected by a *Space Warp behavior* on page 5226 and a *Wander behavior* on page 5242, the vectors (using default colors) are yellow and blue-green, respectively. These vectors are visible only during solution of the crowd simulation.

**Show Velocity** Uses the Velocity Color (see above) to draw a vector whose length depicts the delegate's relative speed. This vector is visible only during the solution of the crowd simulation. Default=off.

**Show Cog Control States** During a solution, a text label appears next to the delegate showing the name of the cognitive controller on page 5133 state or transition that currently directs its behavior, if any. Default=on.

**Constrain to XY Plane** The delegate remains at its initial height (position on the world Z axis) throughout the simulation. When off, the delegate's height can change during the simulation, for example when seeking an object at a different height. Default=on.

**Bound Box of Hierarchy** When on, the *Avoid behavior* on page 5209 uses the bounding box of the delegate and all of its children to perform its behavior. Default=on.
Speed group

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average Speed</td>
<td>5.0</td>
</tr>
<tr>
<td>Max Accel</td>
<td>0.1</td>
</tr>
<tr>
<td>Decel Weight</td>
<td>0.3</td>
</tr>
<tr>
<td>at Turn Angle</td>
<td>10.0</td>
</tr>
<tr>
<td>Decel Weight</td>
<td>0.1</td>
</tr>
<tr>
<td>at Incline Angle</td>
<td>90.0</td>
</tr>
<tr>
<td>Accel Weight</td>
<td>0.1</td>
</tr>
<tr>
<td>at Decline Angle</td>
<td>90.0</td>
</tr>
</tbody>
</table>

**Average Speed** Specifies the delegate's baseline velocity in 3ds Max units (or the current unit type) per frame. Default=5.0.

The delegate's speed can be modified during the simulation by a variety of factors, such as a linked biped's built-in speed and Deviation settings in a behavior.

**Max Acceleration** Multiplied times Average Speed to determine the maximum acceleration. Default=0.1.

For example, given the defaults of 5.0 for Average Speed and 0.1 for Max Accel, the acceleration or deceleration at any moment can be no greater than 0.5 units/frame/frame.

**Deceleration Weight** Specifies how much a delegate should slow down when turning.

The higher this setting, the more the delegate slows down when it reaches the turn angle (see following parameter). A value of 0 specifies no slowdown; a value of 1 tells the delegate to stop. Default=0.3.

The algorithm computes a value, d, which goes linearly from 0 to (1 - Decel Weight) as the turn angle of the delegate goes from 0 to the Turn Angle specified by the user. The speed of the delegate is then multiplied by d. For example, when the delegate turns at the Turn Angle or greater, its speed will be multiplied by (1 - Decel Weight), slowing it down as much as possible based on this parameter. When the delegate is not turning at all, its speed is not affected by the Decel Weight. When the delegate is turning at half the specified Turn Angle, d = Decel Weight / 2, so its speed will be multiplied by (1 - Decel Weight / 2).

As a practical example, take a delegate traveling at 10 units/frame. Decel Weight is set to 0.4, and At Turn Angle is set to 30. When the delegate has turned 15 degrees (half the At Turn Angle), the effective deceleration weight...
is 0.2. Subtract that quantity from 1 to get 0.8, and then multiply that times
the delegate's speed to get 8 units per second halfway into the turn. At the
full turn (30 degrees), the delegate travels at 6 units per frame.

**At Turn Angle** Specifies the turn angle at which Decel Weight's full slowdown
effect is applied. Default=10.0.

If the current turn angle is less than At Turn Angle, the algorithm divides the
latter by the former, and then divides the Decel Weight setting by the result
to derive the effective deceleration weight.

**Decelation Weight** Specifies how much the delegate should slow down
when moving at an upward slant. Default=0.1.

See **Decel Weight** on page 5158 for a full explanation.

**At Incline Angle** Specifies the upward slant angle at which Decel Weight's
full slowdown effect is applied. Default=90.0.

**Accelation Weight** Specifies how much the delegate should speed up
when moving at a downward slant. Default=0.1.

See **Decel Weight** on page 5158 for a full explanation, taking into account that
Accel Weight produces a speedup effect rather than a slowdown. Thus, the
effective acceleration weight is added to 1, not subtracted from it.

**At Decline Angle** Specifies the downward slant angle at which Accel Weight's
full speedup effect is applied. Default=90.0.

**Turning group**

<table>
<thead>
<tr>
<th>Turning</th>
<th>Max Turn Velocity</th>
<th>Max Turn Accel</th>
<th>Max Incline</th>
<th>Max Decline</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>30.0</td>
<td>3.0</td>
<td>90.0</td>
<td>90.0</td>
</tr>
</tbody>
</table>

These parameters affect the delegate's turning behavior; that is, how it changes
direction in response to forces applied by crowd behaviors.

You can use the **Orientation behavior** on page 5213 to affect how a delegate
turns and banks, independently of the actual path taken.

Turning applies to objects moving both on the ground and in the air.

**Max Turn Velocity** Specifies the maximum number of degrees a delegate can
turn per frame. Applies both to heading and pitch. Default=30.0.
Max Turn Accel Specifies how much the delegate's heading or pitch angle can change per frame. This controls angular acceleration and deceleration. For smooth turns, keep it relatively low. Default=3.0.

**TIP** If a delegate exhibits sluggish turning behavior during a simulation, try increasing Max Turn Velocity, Max Turn Accel, or both.

Max Incline Specifies the maximum number of degrees a delegate can turn upward at any given frame. For example, most birds can't fly straight up, so you might set this to 45 for a bird. Default=90.0.

Max Decline Specifies the maximum number of degrees a delegate can turn downward at any given frame. Default=90.0.

For example, for a bird that can't fly straight up but can fly straight down, you might set Max Incline to 45 and Max Decline to 90.

Banking group

<table>
<thead>
<tr>
<th>Banking</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Max Bank</td>
<td>30.0</td>
</tr>
<tr>
<td>Max Bank Velocity</td>
<td>3.0</td>
</tr>
<tr>
<td>Bank per Turn</td>
<td>1.0</td>
</tr>
</tbody>
</table>

These parameters affect the delegate's banking behavior; that is, how it tilts around its front-back axis as it changes direction while moving. Banking typically applies to objects moving in the air or on water, but can also apply to ground-based objects such as one- or two-wheeled vehicles.

Max Bank Specifies the maximum number of degrees a delegate can bank. Default=30.0.

Max Bank Velocity Specifies the maximum number of degrees a delegate can bank per frame. Default=3.0.

Bank per Turn The number of degrees the delegate will bank as a function of the turn angle at the current frame. For example, if Bank Per Turn=1, the delegate will bank one degree for every degree it is turning at a given frame. Default=1.0.
These parameters relate to the use of bipeds associated with delegates. In order to have a biped exhibit character animation as it follows the delegate's course, you must use motion flow methods. For a procedure, see To use bipeds in a crowd simulation on page 5142.

**Use Biped** Associates the delegate with a biped (specified with the None button), and causes the delegate's speed to be determined by that of the biped's existing motion. Its behavior (for example, seeking another object) remains defined by a crowd object.

**NOTE** This button is not available until a biped is designated via the None button.

**None (label)** Click this button and then select a biped to be associated with the delegate's motion.

You can select a biped by clicking its center of mass object (e.g., Bip01) in a viewport, or with the Pick Object dialog, which you can open by pressing H or by clicking the toolbar button Select By Name (you cannot use the Selection Floater). Thereafter, the name of the biped object appears on the button.

**TIP** When using the viewport, the mouse cursor changes to a crosshairs when positioned over a biped's center of mass.

**Start Frame** Specifies the frame at which the biped's first clip will begin to play.

If, when several bipeds share the same starting clip, you vary this setting per biped, they won't walk in lockstep formation. This is most useful when you take advantage of the ability of the Edit Multiple Delegates dialog on page 5182 to randomize the start frame for each delegate.
Priority
Sets the delegate priority, which determines the order of solution in
dipede/delegate simulations.
For details, see Priority Rollout on page 5248.

First clip choice method
Determines which motion clip in the shared motion
flow graph Crowd initially uses to animate the dipede linked with the delegate.

■ First clip of current script
Uses the first clip in the dipede’s motion flow
script, if a script exists. If this option is chosen, but there is no script, an
error message is generated.

■ Random start clip
Uses the random start clip or clips specified in the
shared motion flow graph, if random start clips have been designated. If
this option is chosen, but no random start clips have been designated, an
error message is generated.

Crowd Helper Object

Create panel > Helpers > Object Type rollout > Crowd

The Crowd helper object acts as the command center for controlling crowd
simulations in character studio. In most cases, you won’t need more than one
Crowd object per scene.

Crowd Behaviors

The Crowd object also lets you add behaviors to the scene, choose the current
behavior from a list, and provides a rollout for modifying that behavior.
Behaviors provided with character studio include:

Avoid Behavior on page 5209
Orientation Behavior on page 5213
Path Follow Behavior on page 5217
Repel Behavior on page 5221
Scripted Behavior on page 5223
Seek Behavior on page 5224
Space Warp Behavior on page 5226
Speed Vary Behavior on page 5227
Surface Arrive Behavior on page 5229
Surface Follow Behavior on page 5233
Wall Repel Behavior on page 5236
Wall Seek Behavior on page 5239
Wander Behavior on page 5242

See also:
- Creating Crowd Helpers on page 5110
- Delegate Helper Object on page 5154

**Setup Rollout**

Create panel > Helpers > Object Type rollout > Crowd > Setup rollout
Select a Crowd object. > Modify panel > Setup rollout

The Setup rollout of the Crowd helper object contains controls for setting up crowd functions.

**Interface**

A number of functions are available from a row of buttons at the top of the Setup rollout:

- **Scatter** Opens the Scatter Objects Dialog on page 5165.

- **Objects/Delegate Associations** Opens the Object/Delegate Associations dialog on page 5179.
**Biped/Delegate Associations** Opens the *Associate BipedsWith Delegates dialog* on page 5185.

**Multiple Delegate Editing** Opens the *Edit Multiple Delegates dialog* on page 5182.

**Behavior Assignments** Displays the *Behavior Assignments and Teams dialog* on page 5188.

**Cognitive Controllers** Displays the *Cognitive Controller editor* on page 5199.

### Behaviors group

Use these controls for adding, removing, and renaming behaviors.

**New** Launches the *Select Behavior Type dialog* on page 5196. Choose a behavior and then click OK to add the behavior to the scene. Then use the *Behavior Assignments and Teams dialog* on page 5188 to assign the behavior to a delegate or delegates in the scene.

The first time you add a behavior to the scene using this command panel, a new rollout appears for this behavior below the Setup rollout. This rollout lets you change settings for the behavior. To display the rollout for a different behavior in the scene, choose it from the drop-down list in the Behaviors group.

Following is a list of available behaviors:

- *Avoid Behavior* on page 5209
- *Orientation Behavior* on page 5213
- *Path Follow Behavior* on page 5217
- *Repel Behavior* on page 5221
- *Scripted Behavior* on page 5223
- *Seek Behavior* on page 5224
- *Space Warp Behavior* on page 5226
- *Speed Vary Behavior* on page 5227
- *Surface Arrive Behavior* on page 5229
- *Surface Follow Behavior* on page 5233
Wall Repel Behavior on page 5236
Wall Seek Behavior on page 5239
Wander Behavior on page 5242

**Delete** Deletes the current behavior.

If the behavior is currently in use, that is, it's assigned to a delegate or team, either directly in the Behavior Assignments and Teams dialog on page 5188 or indirectly through a cognitive controller, a small dialog appears asking you to confirm the deletion. If you delete a directly assigned behavior, its assignment is removed from the scene. If you delete a behavior used in a cognitive controller, it is removed from the state to which it was assigned.

**Behaviors List** Lists all behaviors in the current scene (added with New). Select a behavior from the list to have its rollout appear below the Setup rollout.

Note that behaviors that appear in this list aren't necessarily assigned to any delegates active in the crowd simulation. Likewise, a behavior whose rollout appears below the Setup rollout isn't necessarily active or assigned. To assign delegates and/or activate behaviors, use the Behavior Assignments and Teams dialog on page 5188.

You can rename a behavior by first selecting it from the list, and then clicking its name and entering a new one from the keyboard. It's a good idea to give descriptive names to behaviors; for example, *Avoid Red Team*.

**NOTE** If you add the first behavior in the scene from the Behavior Assignments and Teams dialog on page 5188, the text box remains empty and no rollout for the behavior appears. To edit the behavior, choose it from the list.

---

**Scatter Objects Dialog**

Create panel > Helpers > Object Type rollout > Crowd > Setup rollout > Scatter Objects

Select a Crowd object. > Modify panel > Setup rollout > Scatter Objects

The Scatter Objects dialog of the Crowd helper object includes facilities for creating crowds by cloning objects, such as delegates. It also lets you distribute the clones and other objects within a radial area, along a shape, across a grid object or surface, or within a box or sphere. You can also specify various orientation and scaling options for scatter objects.
See also:

- Creating Crowd Helpers on page 5110
Interface

Clone panel

Contains the basic options for cloning an object.
Object to Clone (None) Click this button, and then select an object in the scene to be cloned.

How Many Specifies the number of clones to be generated.

Copy/Instance/Reference Lets you specify how the object is cloned. It can be cloned as a copy, an instance or a reference.

Clone Hierarchy When on, all objects linked to the selected object are cloned as well, with the hierarchical structure retained intact for each clone.

Clone Controllers When on, any controllers (that is, animation) associated with the selected object are cloned as well.

Generate Clones Click this button to create the specified number of clones of the object whose name appears on the Object To Clone button. Cloned objects are all created in the same location; to distribute them, you must set distribution options on the Position panel, and then click the Generate Locations button.

After you generate clones, the original object and its newly created clones are scatter objects; that is, they're selected in the list in the All Ops panel (Select Objects To Transform), and are thus subject to subsequent operations on the Position, Rotation, and Scale panels. You can change this selection via the All Ops panel > Select Objects to Transform on page 5178 function or by generating clones again.
Position panel

Contains options for positioning objects using a reference (distribution) object. You can distribute objects randomly over the surface of a grid or other object, along a shape, or within the volume of a box or a sphere. You can choose only one option from the first two group boxes.
**Placement Relative to Object group**

**On Grid/Inside Sphere/Inside Box/On Surface/On Shape** Choose the appropriate item before selecting the reference object.

- **On Grid** distributes the scatter objects over the surface of a grid object.
- **Inside Box** and **Inside Sphere** distribute the scatter objects within the volume of a primitive box or sphere object, respectively.
- **On Surface** distributes the scatter objects over the surface of any renderable object. For example, you can create a landscape object for use as a distribution surface by applying a Noise modifier to a patch grid.
- **On Shape** distributes the scatter objects along a shape object: a spline or NURBS curve. If the shape consists of more than one curve, Scatter uses the lowest-numbered curve (typically the first one added).

**Offset** When using **On Surface**, specifies a consistent distance above the surface (using surface normals) for distribution. Available only when **On Surface** is chosen.

**Grid/Box/Sphere/Surface/Shape (None)** Click this button, and then select an object in the scene to be used as a reference object. Listed objects are limited to the chosen category.

**NOTE** With the Grid, Box, and Sphere choices, you can use only a grid helper object, a primitive sphere, or a primitive box as a reference object. A primitive sphere or box that has been converted to an editable mesh object can’t be used as a reference object. Also, the appropriate radio button (see the first item in this group) must be chosen before you select a reference object.

**Placement in Area group**

Contains options for positioning scatter objects in a radial area, without using a reference object.

**In Radial Area** Distributes the scatter objects randomly in a spherical or circular arrangement, using the remaining controls in this group box.

**Center** Specifies the center of the distribution in world coordinates.

**Radius** Specifies the maximum distance from the center within which objects are to be positioned.

**In XY Plane** Specifies that objects are to be distributed on the world XY plane only, resulting in a disc-like array.
Spacing group

Include children’s bounding boxes in spacing calculations When on, all of a hierarchical scatter object’s sub-objects are considered when determining spacing. When off, only the selected object is considered.

Spacing Specifies the minimum distance between scatter objects. The Spacing setting is multiplied by the size of the object’s bounding sphere to determine how close objects can get. If Spacing is left at 1.0, the default, objects normally cannot be positioned within each others’ bounding spheres. If Spacing is set to 2.0, objects are separated by a distance equal to or greater than the size of the bounding sphere.

Rand Seed Specifies a seed value for randomizing scatter objects' locations. If, for example, you use the same value for clones of a delegate and then a master object, each pair ends up in the same place. If a scene has more than one crowd, each should use a different seed to avoid having identical configurations.

Generate Locations Click this button to produce a set of locations for all scatter objects; that is, cloned objects or objects selected with the Select Objects to Transform on page 5178 button.

Inc(rement) Seed When on, and you click the Generate Locations button, Scatter adds 1 to the Rand Seed value, and redistributes the objects using the new random seed. Default=on.
Rotation panel

Contains options for orienting scatter objects. You can specify alternative forward and up axes, plus a target object toward which the objects will point. In addition, you can specify a source object; when using both source and target objects, the objects are rotated so they’re parallel to the line between the two.
Local Axes group

Use these settings to designate alternative forward and up axes. The default settings match the delegate axes.

**Forward +/-X/Y/Z:** Specifies which axis of the objects points forward, for use with the Look At Target option. When the + button is active, the default condition, the positive chosen axis is used. Click the + button to use the negative axis.

**Up +/-X/Y/Z:** Specifies which axis of the objects points upward; this axis is aligned with the world Z-axis. When the + button is active, the default condition, the positive chosen axis is used. Click the + button to use the negative axis.

**NOTE** You cannot specify the same axis as Local Forward and Local Up simultaneously. If you choose an axis for one that's already chosen for the other, character studio switches the other to a different axis.

Look From group

**Self/Selected Object** Determines the direction from which the objects look. By default, each object looks from its own position (Self), so that when several objects are looking at a single target, each is oriented differently. To orient each object so that it's parallel to an imaginary line between two objects (the "from" object and the "to" object), choose Selected Object and specify the object with the (None) button.

**None** (label) When choosing Selected Object as the Look From object, use this button to specify the "from" direction. Click the button, and then select an object from which the objects are to look.

Look At Target group

**Current Orientation/Selected Object** Determines the direction toward which the scatter objects look. By default, each object retains its current orientation. To orient each scatter object so that it's parallel to an imaginary line between two objects (the "look from" object and the "look at target" object), choose Selected Object and specify the object with the (None) button.

**None** (label) Use this button to specify the "to" direction. Click the button, and then select an object toward which the scatter objects are to look.

**Sideways Deviation** Sets a maximum deviation angle in degrees for the objects' sideways orientation. If the scatter objects should look in an object's general
direction but may look at a spot to either side of the target, use Sideways Deviation to set the maximum amount by which they can deviate from the calculated angle. The actual deviation amount for each object is calculated at random, based on the Deviation settings and the Rand Seed setting. Range=0.0 to 180.0.

**Up/Down Deviation** Sets a maximum deviation angle in degrees for the objects' up/down orientation.

If scatter objects should look in an object's general direction but may look at a spot above or below the target, use Up/Down Deviation to set the maximum amount by which they can deviate from the calculated angle. The actual deviation amount for each scatter object is calculated at random, based on the Deviation settings and the Rand Seed setting. Range=0.0 to 180.0.

---

**Rand Seed** Specifies a seed value for randomizing the scatter objects' orientations, based on the Deviation settings.

If you use the same value for clones of a delegate and then a master object, each pair ends up with the same orientation. If a scene has more than one crowd, each should use a different seed to avoid having identical configurations.

**Generate Orientations** Click this button to produce a set of orientations for all scatter objects; that is, cloned objects or objects selected with the Select Objects to Transform on page 5178 button.

**Inc(rement) Seed** When on, and you click the Generate Orientations button, Scatter adds 1 to the Rand Seed value, and reorients the scatter objects using the new random seed. Default=on.
Scale panel

Contains options for scaling scatter objects. You can apply uniform or non-uniform scaling, with optional per-axis deviation for scaling variation.

Each axis group has a "Same As" option that lets you scale that axis by the same amount as another. To prevent non-uniform scaling, set two axes to be
the same as the third. For example, set scaling in the X group, and then in the Y and Z groups, turn on Same as X.

**WARNING** These controls can apply non-uniform scaling to objects, which may produce unexpected results when performing other operations within 3ds Max.

### X group

**Scale** Sets scaling on the X-axis as a multiplier. Default=1.0.

**Deviation** Sets the maximum factor for randomization of scaling. For each scatter object, Deviation is multiplied by a random number between 0.0 and 1.0, and then added to the Scale multiplier.

**Same As Y/Z** Lets you use the same scaling as on the Y- or Z-axis, whether explicit or randomized. When you specify an axis, the parameters group for that axis becomes unavailable.

### Y group

**Scale** Sets scaling on the Y-axis as a multiplier. Default=1.0.

**Deviation** Sets the maximum factor for randomization of scaling. For each scatter object, Deviation is multiplied by a random number between 0.0 and 1.0, and then added to the Scale multiplier.

**Same As X/Z** Lets you use the same scaling as on the X- or Z-axis, whether explicit or randomized. When you specify an axis, the parameters group for that axis becomes unavailable.

### Z group

**Scale** Sets scaling on the Z-axis as a multiplier. Default=1.0.

**Deviation** Sets the maximum factor for randomization of scaling. For each scatter object, Deviation is multiplied by a random number between 0.0 and 1.0, and then added to the Scale multiplier.

**Same As X/Y** Lets you use the same scaling as on the X- or Y-axis, whether explicit or randomized. When you specify an axis, the parameters group for that axis becomes unavailable.
Rand Seed Specifies a seed value for randomizing the clones' scales, based on the Deviation settings. If you use the same value for clones of a delegate and then a master object, each pair ends up with the same scaling factor.

Generate Scales Click this button to scale all scatter objects; that is, cloned objects or objects selected with the Select Objects to Transform on page 5178 button.

Inc(crement) Seed When on, and you click the Generate Scales button, Scatter adds 1 to the Rand Seed value, and re-scales the scatter objects using the new random seed. Default=on.

All Ops panel

This panel lets you perform various permutations of cloning and transform operations in a single step, with or without successive randomization.
Operations group

Compute Clones  Turn on to clone the object chosen with the Object to Clone button on page 5168. When you click the Scatter button, the object is cloned, and then any specified transforms are applied to the clones. Turning on Clones makes the Select Objects To Transform button unavailable. The object to clone and cloning parameters must be specified on the Clone panel on page 5167.

Compute Positions/Rotations/Scales  Any options in this column that are turned on when you click the Scatter button cause the respective transforms to be applied to the current selection (see Select Objects To Transform, below) according to the settings in the Position panel on page 5169, Rotation panel on page 5172, and Scale panel on page 5175.

Inc(rement) Seed Positions/Rotations/Scales  Any options in this column that are turned on cause the respective Rand Seed settings to be incremented by 1 each time you click the Scatter button. Use this option to experiment with various randomized transform combinations for your clones.

Select Objects to Transform  Lets you designate objects to be affected by clicking the Scatter button. Clicking this button opens a version of the Select dialog that's unique to Scatter Objects functionality. If you've performed one or more cloning operations during the current session, the results of the most recent cloning are selected by default, including the original cloned object. For example, if you created 10 clones, 11 objects are selected. You can use the Select dialog to alter or replace this selection.

NOTE  The results of the most recent cloning operation remain selected even if you close and later reopen the Scatter Objects dialog.

Scatter  Performs any cloning and/or transforms that are turned on.

OK  Retains all changes and closes the dialog.

Cancel  Forgets any changes and closes the dialog.

Random Placement Difficulty Dialog

This dialog appears when character studio encounters difficulty placing cloned objects without overlapping using the Scatter Objects dialog on page 5165. The
dialog text tells you how many attempts character studio has made to place a specific object, and asks you if you want to try again.

**Interface**

![Random Placement Difficulty](image)

**Try Again** Click this button to force character studio to make N more attempts, where N is set in the How Many More Attempts field.

**Skip This One** Instructs character studio to stop trying to place the current object and proceed to the next.

**Quit Trying** Aborts the Generate Locations process; no more objects will be placed.

**Object/Delegate Associations Dialog**

Create panel > Helpers > Object Type rollout > Crowd > Setup rollout > Associate Objects with Delegates

Select a Crowd object. > Modify panel > Setup rollout > Associate Objects with Delegates

You can use this dialog to link any number of delegate-object pairs. You can also use this dialog to align objects with delegates, optionally matching scaling factors as well. Lastly, you can specify that the objects use the delegates' controllers.
Interface

Objects Lists objects available for linking, specified using the Add function (see following item). You can select any number of objects from this list for subsequent removal.

Add Click this to open the standard 3ds Max Select dialog, which lists all objects in the scene, including delegates. Make your selection, and then click the Select button to add the objects to the Objects list.

Remove Deletes the highlighted object or objects from the list.

Shift Up/Shift Down Use the arrow buttons between the two lists to move highlighted items higher or lower in the list.

When you click Align Objects With Delegates, Link Objects To Delegates, or Assign Delegate Controllers To Objects, character studio creates associations between pairs of items at matching positions in the lists.
Delegates Lists delegates available for linking, specified using the Add function (see following item). You can select any number of delegates from this list for subsequent removal.

Add Click this to open the standard 3ds Max Select dialog, which lists all delegates in the scene. Make your selection, and then click the Select button to add the delegates to the Delegates list.

Remove Deletes the highlighted delegate or delegates from the list.

Association via Linking group

Align Objects with Delegates Aligns each object with its corresponding delegate by moving and rotating the object on its local axes. Each delegate's local Y axis points in the forward direction, so aligned objects will be rotated so their Y axes point in the forward direction as well. This option works much like the 3ds Max Align feature.

Align Scale When on, clicking Align Objects with Delegates sets each object's absolute scaling factor to that of its corresponding delegates. This is useful if, for example, you've randomized delegates' sizes with the Scatter Objects Scale panel on page 5175, and want the associated objects to match.

Link Objects to Delegates Creates a hierarchy for each object-delegate pair, with the delegate as parent.

Association via Animation Replacement group

Assign Delegate Controllers to Objects Copies each delegate's controllers to the paired objects as an instance.

This is the same as using Track View > Copy Controller from the delegate, and then pasting the controller as an instance to the object. Does not link objects hierarchically with delegates.

Once you've set up the delegate animation the way you want it, if you then want to apply the animation to an object or objects *en masse*, use this function. You can then delete the delegates if you like.

OK Implements any changes and closes the dialog.

Cancel Eliminates any changes and closes the dialog.

NOTE Clicking OK has no intrinsic effect; in order to implement any of the dialog functions, you must first click at least one of the Align/Link/Assign buttons.
Edit Multiple Delegates Dialog

Create panel > Helpers > Object Type rollout > Crowd > Setup rollout > Multiple Delegate Editing

Select a Crowd object. > Modify panel > Setup rollout > Multiple Delegate Editing

The Edit Multiple Delegates dialog lets you define groups of delegates and set parameters for them. You can create and store up to 10 different configurations or settings combinations; each consists of one or more delegates and settings for the delegates.

The parameters are mostly the same as those found in the delegate object’s Motion Parameters rollout on page 5156, with the following exceptions and additions:

- Each setting has an associated SET check box, which lets you determine whether the setting has any effect. When off (the default), the setting has no effect. When on, the setting affects the specified delegate or delegates when you click the Apply Edit button.

- Each numeric parameter has two Value settings and an associated Random check box, which lets you specify a random value within a specified range for each member of the group. By default, Random is off, and the Value 1 setting is applied for all parameters with SET turned on. If you turn on Random for a parameter, its Value 2 setting becomes available. If you then specify a different setting for Value 2, character studio calculates a different random number between Value 1 and Value 2 for each delegate in the group.

TIP To reset a parameter to a specific value for all delegates in a group after it’s been set to a random value within a range, turn off Random and turn on SET for the parameter, then set Value1 to the desired value, and then click OK.

Procedures

To edit multiple delegates:

1. Select the Crowd object and open the Modify panel.

2. On the Setup rollout, click the Multiple Delegate Editing button. This opens the Edit Multiple Delegates dialog.
3 Optionally, in the dialog (bottom-left corner), choose a stored dialog setting to use from the 10 available settings.

4 If necessary, use the Delegates To Edit group box controls to add delegates to or remove them from the current setting.

5 Modify the remaining parameters as necessary. Be sure to turn on the SET check box for any parameters that are to change.

6 Click the Apply Edit button to make the changes and exit the dialog.

Interface
**Delegates to Edit group**

This group shows delegates belonging to the current settings combination in a list box and lets you add and delete members.

**Add** Click this button, and then choose delegates to add from the Select dialog.

**Remove** To remove delegates from the list, first choose the names of those to delete in the list box (drag to choose two or more contiguous names, or use Ctrl-click to choose non-contiguous names), and then click Remove.

**Set Parameters from Animation group**

Use this function to obtain motion parameters from an animated object and apply them to all specified delegates. It affects only Average Speed, Max Accel, and the Turning parameters.

Because this one animation will set most of the parameters of the delegate, it should be representative of a whole range of motion of the delegate. For example, the object should turn and accelerate. The animation should be somewhat lengthy so that averages are calculated correctly.

**Animated Object** Specifies an animated object. Click this button, and then choose the object from the list in the Select dialog.

**Set** After specifying the animated object, click this button to apply its parameters to the delegate settings. Also turns on the SET check box for any affected parameters.

**General group**

Rather than numeric values, the settings in this group are on-off switches, except for the first, Velocity Color. To change Velocity Color, click the color swatch, use the Color Selector dialog to pick a new color, and then turn on the Velocity Color SET check box. To change any other setting in the General group, click the check box to the right of the setting, and then turn on the setting's SET check box.

These settings are the same as those found in the delegate object's Motion Parameters rollout on page 5156.

**Speed group**

These parameters are the same as those found in the delegate object's Motion Parameters rollout on page 5156. For an explanation of the Random and SET check boxes, see the introduction to this topic.
Turning group

These parameters are the same as those found in the delegate object’s Motion Parameters rollout on page 5156. For an explanation of the Random and SET check boxes, see the introduction to this topic.

Banking group

These parameters are the same as those found in the delegate object’s Motion Parameters rollout on page 5156. For an explanation of the Random and SET check boxes, see the introduction to this topic.

Biped group

These parameters are the same as those found in the delegate object’s Motion Parameters rollout on page 5156. For an explanation of the Random and SET check boxes, see the introduction to this topic.

Stored Dialog Settings

Use this list to specify up to 10 different combinations of delegates and settings. To store a combination, choose a name from the list, and then specify the delegates and settings. To recall a combination, choose its name from the list. To rename a combination, choose its name from the list, and then highlight the name and edit it using the keyboard.

Check All Sets

Click this button to turn on all SET check boxes. This ensures that any changes you make in the dialog take effect when you click the Apply Edit button.

Apply Edit

Click Apply Edit to implement all changed settings and exit the dialog.

Close

Click Close to remember, but not implement, all changed settings and exit the dialog.

Cancel

Click Cancel to forget all changed settings and exit the dialog.

Associate Bipeds With Delegates Dialog

Create panel > Helpers > Object Type rollout > Crowd > Setup rollout > Biped/Delegate Associations button

Select a Crowd object. > Modify panel > Setup rollout > Biped/Delegate Associations button
Use this dialog to associate any number of delegates with an equal number of bipeds. Add delegates and bipeds to the two lists, and order them so the desired pairs are across from each other. Then choose Make Specified Associations and click the Associate button. Alternatively, you can remove existing delegate-biped associations, or simply associate each delegate with the biped nearest it in the scene.

**Interface**

Bipeds Lists bipeds available for linking, specified using the Add function (see following item). You can select any number of objects from this list for shifting up or down, or deleting.

To clear highlighted items, control-click them.

Add Click this to open the standard 3ds Max Select dialog, which lists all bipeds in the scene that are not currently listed in the Associate Bipeds with Delegates dialog. Make your selection, and then click the Select button to add the delegates to the Objects list.

Remove Removes the highlighted biped or bipeds from the list.
**Shift Up/Shift Down** Use the arrows between the two lists to move highlighted items higher or lower in the lists.

When Make Specified Associations is chosen and you click the Associate button, *character studio* creates associations between pairs of items at matching positions in the lists.

**Delegates** Lists delegates available for linking, specified using the Add function (see following item).

You can highlight any number of objects from this list for shifting up or down, or deleting.

To clear highlighted items, control-click them.

**Add** Click this to open the standard 3ds Max Select dialog, which lists all delegates in the scene that are not currently listed in the Associate Bipeds With Delegates dialog. Make your selection, and then click the Select button to add the delegates to the Delegates list.

**Remove** Removes the selected delegate or delegates from the list.

**Clear Associations** When this is on, and you click the Disassociate button, *character studio* eliminates any delegate-biped associations. Makes the Bipeds list and buttons unavailable.

**Make Specified Associations** When chosen, and you click the Associate button, *character studio* associates each parallel delegate-biped pair in the two lists. That is, the first delegate is associated with the first biped, the second delegate with the second biped, and so on.

**Associate Delegates With Closest Biped** When chosen, and you click the Associate button, *character studio* calculates the biped nearest each delegate in the scene and links the two together.

**Set Delegates to Use Biped** When on, and you click the Associate button, *character studio* turns on the Use Biped on page 5161 option for all delegates listed in the dialog.

---

**Associate/Disassociate** Implements specified changes, calculates any random values, and closes the dialog. Button text changes to "Disassociate" when the Clear Associations option is chosen.

**Close** Remembers any changed settings and closes the dialog. No new delegate settings are calculated or applied.

**Cancel** Ignores any changes and closes the dialog.
**Behavior Assignments and Teams Dialog**

Create panel > Helpers > Object Type rollout > Crowd > Setup rollout > Behavior Assignments

Select a Crowd object. > Modify panel > Setup rollout > Behavior Assignments

The Behavior Assignments and Teams dialog lets you group delegates into teams and assign behaviors and cognitive controllers to individual delegates and teams. It also lets you modify existing assignments.

The dialog is modeless; while it's open, you can use the Modify panel to adjust behaviors and set up new behaviors, as well as animate assignments' Weight settings.

**NOTE** Crowd doesn't let you use multiple cognitive controllers with a delegate. You can assign them, but when you solve, **character studio** notifies you that it will use only the first assigned cognitive controller.

**NOTE** The Enable Flashing option helps you see which delegates are affected by different actions in this dialog. When it's turned on, and you perform any of the following, the relevant delegates "flash" (highlight briefly) in the viewports:

- Click a delegate or team in the Assignment Design group
- Click an assignment in the Behavior Assignments group
- Add members to a team in the Teams group
- Remove members from a team in the Teams group

**Procedures**

**To group delegates into a team:**

1. In the Teams group, click the New Team button.
2. Use the Select Delegates dialog to designate the delegates in the team, and then click the OK button.
3. To change a team name, choose it from the drop-down list at the top of the Teams group, click on its name, and then use the keyboard to edit the text.
To remove team members, choose the team from the drop-down list at the top of the Teams group, select the members to remove from the lower list, and then click the Remove Members button.

To add team members, choose the team from the drop-down list at the top of the Teams group, click the Add Members button, and then use the Select Delegates dialog to designate the delegates to add.

To create a new behavior assignment:

This procedure gives the basic method for assigning a behavior or cognitive controller to a delegate or team.

1. If you want to assign the same behavior to more than one delegate, use the Teams group on page 5195 to collect delegates into teams.

   **NOTE** You can still assign behaviors to an individual delegate, even if it belongs to one or more teams.

2. Make sure no existing assignments in the Behavior Assignments group are highlighted. If any are, Ctrl+click them to clear the selections.
   If assignments are highlighted, **character studio** assumes you want to modify the existing assignments

3. In the Assignment Design group, select one delegate or team, and one or more behaviors or one cognitive controller.
   You can select only one item from either side of this group, with the exception of behaviors. If you choose multiple behaviors, **character studio** creates a separate assignment for each.

   **NOTE** When you select a delegate or team, it briefly highlights in the viewports to indicate the affected delegates.

4. Click the New Assignment button. This is the vertical button to the right of the assignment Design group, with five right-pointing arrows.
   This adds the assignments to the list in the Behavior Assignments group.

5. At this point, you can highlight an assignment, and then change its Weight setting, its Active status, delete it, or change the assignee and/or behavior/cognitive controller.

6. Click OK to accept the changes and close the dialog.
To modify an existing behavior assignment or assignments:

1. In the Behavior Assignments group, select the assignment or assignments to change.
   You can select multiple assignments by Ctrl+clicking for non-contiguous items or Shift+clicking for contiguous items, and then change the assignees or behaviors for all of them at once.

2. To change assignees, in the Assignment Design group, select a delegate or team.

3. To change the assigned behaviors, in the Assignment Design group, select a behavior or cognitive controller.

4. Click the Reset Assignment button. This is the vertical button to the right of the assignment Design group, with five right-pointing arrows.

5. Change the Weight setting and Active status as necessary.

6. Click OK to accept the changes and close the dialog.

Interface
### Assignment Design group

<table>
<thead>
<tr>
<th>Delegates</th>
<th>Behaviors</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delegate01</td>
<td>Avoid</td>
</tr>
<tr>
<td></td>
<td>Space Warp</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Teams</th>
<th>Cognitive Controllers</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear Selections</td>
<td>New Behavior</td>
</tr>
</tbody>
</table>

Lets you set up assignments by choosing a behavior or cognitive controller and a delegate or team to assign it to. Choose one item from the left side (upper or lower list), and one item from right side (upper or lower list). Then click the New/Reset Assignment button immediately to the right of the Assignment Design group (vertical button with five right-pointing arrows).

**TIP** With the exception of Behaviors, you can choose only one item from either side of this group. To assign the same behavior to more than one delegate, the most efficient method is to use the Teams group on page 5195 to gather delegates into teams.

You can select multiple behaviors for a new assignment to a delegate or team. When you click New Assignment, character studio creates a separate assignment for each highlighted behavior. For changing assignments, you're still restricted to choosing one behavior at a time. If you choose an existing assignment and multiple behaviors, the Reset Assignment button becomes unavailable.

- **Delegates** Lists delegates in the scene.
- **Behaviors** Lists existing behaviors.
To use a behavior that hasn't been added to the scene yet, click the New Behavior button at the bottom of this group.

**Teams** Lists teams in the scene.

To create a new team, use the controls in Teams group box.

**Cognitive Controllers** Lists existing cognitive controllers.

To create a new controller, click the Setup rollout > Cognitive Controllers on page 5199 button. You needn't first exit the Behavior Assignments and Teams dialog; when you close the editor, the new controllers are added to the Cognitive Controllers list.

**Clear Selections** Deselects all highlighted items in the Assignment Design and Behavior Assignments groups.

Use this before modifying an assignment, to avoid possible confusion.

**New Behavior** Opens the Select Behavior Type dialog on page 5196, which lets you add a behavior to the scene for use in an assignment.

To modify a new behavior, use the facilities available in the Crowd object's rollouts.

---

**NOTE** If you add the first behavior in the scene from this dialog, the text box in the Crowd object > Setup rollout remains empty, and no rollout for the behavior appears. To edit the behavior, choose it from the list.

**New Assignment/Reset Assignment** Click to assign a behavior or behaviors or a cognitive controller to a delegate or team.
This vertical button with five right-pointing arrows on it is situated between the Assignment Design and Behavior Assignments group. It's available only when two items in the Assignment Design group are highlighted (exception: Multiple behaviors can be highlighted). If no item in the Behavior Assignments group is highlighted, clicking the button creates a new assignment and adds it to the assignments list. If one or more items in the Behavior Assignments group are highlighted, clicking the button sets the highlighted assignments to use the highlighted delegate/team and behavior/cognitive controller combination.

**Behavior Assignments group**

<table>
<thead>
<tr>
<th>Delegate/Team</th>
<th>Behavior/Cog</th>
<th>Weight</th>
<th>Active</th>
</tr>
</thead>
<tbody>
<tr>
<td>Team0</td>
<td>Avoid Behavior</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Team0</td>
<td>Space Warp Behavior</td>
<td>1.00</td>
<td>X</td>
</tr>
</tbody>
</table>

Lets you create and modify behavior assignments.

**List box** Displays all current behavior assignments, including team or delegate name, assigned behavior or cognitive controller, weight setting, and active status.
Items are sorted in alphabetical first by Delegate/Team name, and then by Behavior/Cog name. A dashed line appears before a list entry if it’s the first item for that delegate or team.

To modify or delete an assignment, choose it from the list, whereupon character studio highlights the assigned components in the Assignment Design group. Make the changes using the remaining controls in this dialog.

**NOTE** You can select multiple assignments from the list by Ctrl+clicking for non-contiguous items or Shift+clicking for contiguous items. To clear an item, Ctrl+click it.

**Weight** The relative effect of the assigned behavior or cognitive controller. The higher an assignment’s Weight setting is than others’, the greater relative effect it will have. This setting is animatable. Default=1.0.

In most cases, you should keep Weight within a range of 0.0 to 1.0. Higher settings are available but shouldn't be used unless absolutely necessary.

**NOTE** The Weight setting is not relevant to the Avoid on page 5209, Orientation on page 5213, or the Surface Follow on page 5233 behavior, and is thus unavailable for assignments using any of those three.

**Active** When on, the assignment is currently in effect. When off, the assignment has no effect. This check box is animatable. Default=on.

**Delete** Deletes the highlighted behavior assignment.
Teams group

Let's you define, modify, and delete teams of delegates.

**NOTE** You can toggle the display of this group box with the No Teams/Teams button below the Behavior Assignments group.

**Drop-down list** Displays the name of the current team. To view a different team, choose it from the list. To change a team name, click in the box and then use the keyboard to edit the text.

**List box** Displays delegates in the current team.
**New Team** Adds a team to the list, and opens the Select Delegates dialog on page 5198 to let you specify new team members.
The default team name is "Team," followed by a number, starting with "0" and counting up.

**Delete Team** Deletes the current team.
Team members are not deleted from the scene.

**Add Members** Lets you add members to the current team. Use the Select Delegates dialog on page 5198 to specify new team members.

**Remove Members** Removes selected members from the team.
Removed members are not deleted from the scene.

**Create/Change Selection Set** Adds the current team to the list of selection sets, accessible from the Named Selection Sets list on the Main toolbar.
If the current team already is a selection set, and you subsequently changed the team’s makeup, click this button to update the members in the Named Selection Sets list.

**Enable Flashing** When on, and you click a list item in the dialog or create/modify a team, the relevant objects highlight briefly in the viewports to indicate which are affected. Default=on.
See the introductory note on page 5188 for details.

**OK** Click this button to accept all changes and close the dialog.

**No Teams/Teams** Toggles display of the Teams group box.
By default, the Teams group is displayed; click the No Teams button to turn it off. When it's off, click the Teams button to turn it on. The state of the toggle persists only during the current session.

---

**Select Behavior Type Dialog**

Create panel > Helpers > Object Type rollout > Crowd > Setup rollout > Behavior Assignments > New Behavior
Select a Crowd object. > Modify panel > Setup rollout > Behavior Assignments > New Behavior
Use this dialog to select the type of behavior to be added to a Crowd object.
Interface

The choices are:

Avoid Behavior on page 5209
Orientation Behavior on page 5213
Path Follow Behavior on page 5217
Repel Behavior on page 5221
Scripted Behavior on page 5223
Seek Behavior on page 5224
Space Warp Behavior on page 5226
Speed Vary Behavior on page 5227
Surface Arrive Behavior on page 5229
Surface Follow Behavior on page 5233
Wall Repel Behavior on page 5236
Wall Seek Behavior on page 5239
Wander Behavior on page 5242
Select Delegates Dialog

Create panel > Helpers > Object Type rollout > Crowd > Setup rollout > Behavior Assignments > Choose or add a team. > Add Members

Select a Crowd object. > Modify panel > Setup rollout > Behavior Assignments > Choose or add a team. > Add Members

The Select Delegates dialog lets you designate delegates to be assigned to teams using the Behavior Assignments and Teams dialog on page 5188 for assigning crowd behaviors.

Interface

List box  Lists all delegates in the scene.
All  Selects all delegates in the list.
None  Deselects all delegates.
Invert Inverts the current selection.

Selection Sets Choose an item from this to select all members of the selection set. You must first have created a selection set from one or more delegates.

OK Closes the dialog and implements changes.

Cancel Closes the dialog and ignores changes.

**Cognitive Controller Editor**

Create panel > Helpers > Object Type rollout > Crowd > Setup rollout > Cognitive Controllers

Select a Crowd object. > Modify panel > Setup rollout > Cognitive Controllers

The Cognitive Controller editor lets you combine behaviors into states. More important, it lets you sequence different behaviors on page 5115 and behavior combinations using state diagrams, where conditionals written in MAXScript impose changes in behavior.

For example, you can specify that a character or object is to wander aimlessly until it comes within a certain distance of another object, whereupon it heads straight for that object. Or you can specify that one character is to avoid another only when the second character is avoiding the first.

**NOTE** The MAXScript conditionals used in the cognitive controller typically consist of a single line of code. You can load and save them separately as .ms files, but they are also stored within the .max scene file in which they reside.

The editor interface consists of an icon-based toolbar above a window that contains the state diagram. When you first open the editor, no state diagrams exist. Begin by clicking the New button to create a new state diagram.

**TIP** If you find yourself consistently assigning two or more behaviors to delegates or teams, you can save time by combining the behaviors into a single-state cognitive controller, or "behavior module," and assigning that instead. The only disadvantage is that you can't animate the weights of behaviors used in the cognitive controller, but you can work around that by using transitions.

**NOTE** Crowd doesn't let you use multiple cognitive controllers with a delegate. You can assign them, but when you solve, character studio notifies you that it will use only the first assigned cognitive controller.
See also:

- State Dialog on page 5202
- State Transition Dialog on page 5203

Interface

Create State Let you create new states in the diagram. Click this button, and then click in the state diagram area to add states. A state appears as a rectangular box containing the name of the state. The first state you add is, by default, the first state in the controller that executes when the simulation is run. This is indicated by its red color; states you add subsequently are colored blue. To set a different state to execute first, use the Set Start State function.

You specify a state's name and behaviors by editing the state. To edit a state, right-click it. This opens the State dialog on page 5202.

Create Transition Let you link states with transitions. Click this button, and then drag between two states to create the transition, starting with the earlier state. The transition appears as a black arrow pointing from the first
state to the second. Alternatively, if you click a state with the Create Transition tool active, you create a transition that loops back to the state itself. Right-click a transition to specify its characteristics and conditions by editing the transition. This opens the State Transition dialog on page 5203.

**Set Start State** Normally the state that executes first in a cognitive controller is the one that was added first. Use this tool to choose a different state to execute first. The start state is red; the rest are blue. Typically you would use this when you have a circular sequence of states, and you want to change which state executes initially.

**Move State** Lets you move states around in the window by dragging them.

**Select State/Transition** Lets you select states and transitions for subsequent deletion. Selected states have white outlines, and selected transition lines are white. You can select multiple states by dragging a box around them. You can select multiple states and transitions by holding the Ctrl key as you click.

**Delete State/Transition** Lets you delete one or more states or transitions. First select any combination of states and transitions to delete, and then click this button.

**(Name)** Shows the name of the current state diagram. To display and/or edit another, choose it from the list. To change a state diagram's name, click the name in the box and use the keyboard to edit the text.

**New** Adds a new cognitive controller. By default, cognitive controllers are named “Cognitive Controller” followed by a number, but you can change this to anything you like.

**Delete** Deletes the current cognitive controller. This is an undoable operation.
State Dialog

Create panel > Helpers > Object Type rollout > Crowd > Setup rollout > Cognitive Controllers > right-click a state icon.

Select a Crowd object. > Modify panel > Setup rollout > Cognitive Controllers > right-click a state icon.

The State dialog lets you add behaviors to, and remove them from, a cognitive controller state in a crowd simulation, and specify weights for each behavior.

Interface

State name Displays the name of the state. To change the name, click this text and edit from the keyboard.

List Displays the names of all behaviors associated with the state. To remove a behavior or change its weight, click the behavior's name, and then make the appropriate changes using the controls below the list.
NOTE The order of behaviors in this list is immaterial; all behaviors execute simultaneously.

**Add** Opens the Select Behavior dialog, which displays the names of all behaviors on page 5208 in the current Crowd object that are not associated with the current state. Select a behavior (use Shift and/or Ctrl to choose multiple behaviors), and then click OK.

**Remove** Eliminates the highlighted behavior from the state.

**Weight** Specifies the selected behavior's relative influence in the state. Default=1.0.

The higher the weight in relation to other behaviors' weights, the more evident the results of the behavior in the state. In most cases, you should keep Weight within a range of 0.0 to 1.0. Higher settings are available but shouldn't be used unless absolutely necessary.

**OK** Closes the dialog and implements changes.

**Cancel** Closes the dialog and ignores changes.

## State Transition Dialog

Create panel > Helpers > Object Type rollout > Crowd > Setup rollout > Cognitive Controllers > Right-click a transition line.

Select a Crowd object. > Modify panel > Setup rollout > Cognitive Controllers > Right-click a transition line.

These settings control how character studio effects a transition from one state to another when using a cognitive controller on page 5199. For more detailed information, see To set up and use a cognitive controller on page 5133.

**The Transition Script**

The most important element of the transition is the MAXScript conditional script. This is a script associated with the controller that is executed once per frame, and can test any aspect or aspects of the scene and cause a transition or not, depending on whether the result of the test is successful (true, or 1) or unsuccessful (false, or 0).
character studio executes scripts once per frame per assigned delegate, so objects and effects can be animated and still let delegates react with accuracy.

All scripts used in transitions use the following structure:

```
fn [FunctionName] del t = (  
[MA maximaxScript code]
if [MAXScript conditional]
  then 1
  else 0 
)
```

The opening section contains "fn" (function) followed by the function name, which also must appear in the State Transition dialog, and then the input parameters "del t", and lastly "=" (. Following this there can be any MAXScript code, or none.

The closing section contains a necessary MAXScript conditional, and then "then 1 else 0". This means: If the result of the conditional is true, then return 1 (that is, the transition is to take place), or if the result of the conditional is false, then return 0 (that is, the transition is not to take place). You could reverse the order of the numbers 1 and 0 ("then 0 else 1") so that the conditional being true would cause no transition to take place, and vice-versa. Lastly, the function must end with a close parenthesis: ")".

Following are some examples of scripts that can be used in cognitive controllers, along with brief explanations. These are presented for you to modify and use in your own scenes.

**NOTE** See this topic in the online User Reference for sample code to test an object position, test the distance between two objects, and test a modifier parameter.

**Testing a Particle System Parameter**

This sample script tests the number of particles emitted by particle system Spray01, and returns positive if the number equals 100.

```
fn TestParticles del t = (  
  if (particleCount $Spray01) == 100
  then 1
  else 0 
)
```

**Testing an Atmospheric Property**

This sample script tests the Density parameter of a fog effect, and returns positive if it equals 50.
fn TestAtmos del t = {
    atmos_fog = getAtmospheric 1
    print atmos_fog.density -- to:debug
    if (atmos_fog.density == 50)
        then 1 else 0 )

Note the second line, which assigns the fog atmospheric to a variable named "atmos_fog". This is necessary only for atmospheric effects; with most standard objects, you simply use the object name preceded by a $, as in the two previous examples. The "1" following the getAtmospheric command refers to the atmospheric's position in the Rendering Effects dialog > Effects list.

Once you've executed this assignment, you can obtain a list of the atmospheric's properties by entering this command in the MAXScript Listener:

    ShowProperties atmos_fog

Also, the third line in the sample script isn't necessary for the cognitive controller; it simply prints the result of the test in the Listener window for debugging purposes.

**Testing Another Delegate's Behavior**

You might want to determine in a transition script which behavior is currently influencing a certain delegate. Crowd provides a MAXScript-based method for doing this. You can even check whether a particular delegate is specified as a target within that behavior. An example would be a cocktail party scene in which Betty avoids Harry if Harry is seeking Sally. But if Harry is avoiding Sally, then Betty will seek Harry.

The following example script is taken from the sample file party.max, which you can find in the Biped download available on this page, under 3ds Max 8 Tutorials – Scene and Support Files > Specialized. The scene uses a more complex scenario than the example described in the previous paragraph. Following is an overview, but to fully understand the setup, you should examine the scene. Study, in particular, the behavior assignments and cognitive controllers, which use a total of eight different transition scripts.

Six delegates are confined in a "room" defined by four grids, using a Wall Repel behavior. Delegates 1, 2, 3, and 5 simply wander at random during the simulation. However, delegate 4 uses a cognitive controller (cc1) that tells it to start wandering, and then switch to one of three Avoid behaviors if members of one of three arbitrary pairs of delegates come within 50 units of each other. Each of the Avoid behaviors targets a different group of three delegates, two of which include delegate 2. Delegate 6 is assigned a second cognitive controller (cc2) that uses the following script to tell it to switch to an Avoid behavior if
delegate 4 is avoiding delegate 2. The heart of the script is this line in function transfunc4:

NOTE See the online User Reference for this sample code.

Load the file, press F11 to open the Listener window, and then solve. The Listener window displays a message whenever delegate 4 is found to be avoiding delegate 2.

You can use this script as is in your own simulations to check for whether one delegate is avoiding a second by substituting the delegates' names in the above line, and also substituting the names of your Avoid behaviors in the list in transfunc4, adding or deleting lines as necessary.

The example script illustrates a second important point: Cognitive controller transition scripts can contain multiple functions. Crowd first executes the function specified in the State Transition dialog > Transition Condition field, and that function calls one or more additional functions in the script, which, of course, can also call functions. In this case, transfunc4 calls the first function, isDelegateAvoiding, passing it three parameters.

Lastly, the script contains a special function, getBehaviorType, that compares an input behavior against a list of known behaviors, and on a match, returns the known behavior. In this case, transfunc4 runs through the list of behaviors currently influencing Delegate04, testing each with getBehaviorType, and if an Avoid behavior is in effect, proceeds to check whether Delegate02 is an obstacle of that Avoid behavior. Use of this function is more efficient and flexible than testing for specific behaviors, especially if your scene contains many behaviors of the same type, or you're constantly editing behavior settings. You can see the returned behaviors by removing the comment (double hyphen) from the beginning of the following line in transfunc4.

NOTE See the online User Reference for this sample code.
Interface

Seek → Repel

Priority: 1
Duration: 10
Ease In: 0.5
Ease Out: 0.5

Transition Condition
TestDist
Edit MAXScript

Priority Sets the transition's precedence.
When more than one transition tests true, character studio uses the Priority setting to determine which transition occurs. It performs the transition with the lowest Priority setting. Thus, for example, a transition with a Priority setting of 0 takes precedence over one with Priority 1, and so on.

Duration The number of frames character studio takes to effect the transition between states.

Ease In The rate at which the transition begins. Default=0.5. Range=0 to 1.0. Lower values cause a more abrupt transition, while higher values cause a more gradual transition.

Ease Out The rate at which the transition ends. Default=0.5. Range=0 to 1.0. Lower values cause a more abrupt transition, while higher values cause a more gradual transition.
NOTE The sum of the values for Ease In and Ease Out must be less than or equal to 1.0. *character studio* won’t let you set a value for either parameter that would cause the sum to exceed 1.0. To increase the value of one parameter when its value equals 1.0 minus the other parameter, decrease the other parameter first.

**Transition Condition** The name of the MAXScript function that specifies when/how the transition is to occur.

This name must also appear at the beginning of the main function in the script, after "fn". The script can contain additional functions that are called by the main function and each other.

**Edit MAXScript** Opens an editor window for editing, saving, and loading the transition’s MAXScript script.

---

**OK** Closes the dialog and implements changes.

**Cancel** Closes the dialog and ignores changes.

### Behavior Rollout

Create panel > Helpers > Object Type rollout > Crowd > Setup rollout > New button

Select a Crowd object. > Modify panel > Setup rollout > New button

Select a Crowd object. > Modify panel > Setup rollout > Choose a behavior.

The Behavior rollout appears in the Crowd object command panel after you first add a behavior to the scene using the Setup rollout.

The rollout’s full name (for example: Avoid Behavior or Seek Behavior) depends on the current behavior, displayed in the text box in the Setup rollout. To display the rollout for a different behavior, choose the behavior from the drop-down list.

**NOTE** If you add the first behavior to the scene from the *Behavior Assignments and Teams Dialog* on page 5188, a behavior rollout does not automatically appear in the Crowd command panel. You must first choose the behavior from the drop-down list at the bottom of the Setup rollout.

For a detailed description of specific behaviors, refer to the topics that follow. For an overall look at behaviors, see *Assigning Behaviors* on page 5115.
**Avoid Behavior**

Create panel > Helpers > Object Type rollout > Crowd > Setup rollout > New button > Avoid Behavior

Select a Crowd object. > Modify panel > Setup rollout > New button > Avoid Behavior

The Avoid behavior lets you specify any object or objects that delegates must keep away from. As delegates approach designated objects during the crowd simulation, they steer clear of them while turning and/or braking as necessary.

This behavior uses three different methods to let delegates avoid each other and other objects: Steer To Avoid, Repel, and Vector Field.

Steer to Avoid behavior is best used for animals that steer around each other at close proximity. Earthbound animals and fish typically do this. Steering motion may be sudden since its action is often engaged for relatively short periods of time.

By contrast, Repel avoidance behavior mimics the continuous action of a repellent magnetic field. Birds, bats and flying insects are best animated with large Repel fields so that they can smoothly avoid each other while maintaining a comfortable margin of error. Repel forces prevent intrusion from all sides, regardless of the direction of travel. Thus even animals that rely mainly on Steer to Avoid will also need some degree of Repel avoidance to maintain spatial separation when they are moving through dense traffic. The forces of Repel avoidance are always directed uniformly outward in a spherical shape.

Use Vector Field avoidance for cases where crowd members must avoid hitting the more complex shapes of arbitrary 3ds Max objects. The outward forces of the Vector Field avoidance can constructed to form the shape of any object. For example, suppose you want to animate a school of fish swimming around a sunken ship. In this case, a vector field can be created so that it extends the shape of the ship into the surrounding space. The field is computed by scan converting the ship's surface normals into a 3D lattice that surrounds the ship. These normals will extend into space as "beacons" in the 3D lattice, telling the fish how to best swim away from the shape of the ship. As the fish enter the space of the vector field lattice, they can be precisely repelled along an avoidance force directed away from ship's surface.

**NOTE** In the explanations that follow, the word "target" is used to refer to the object or objects to be avoided.
### Interface

#### Avoid Behavior

- **Look Ahead**: 30
- **Hard Radius**: 1.0
- **Display Hard Radius**
- **Sleer To Avoid**
  - **Detour Angle**: 360.0
  - **Brake Pressure**: 2.0
- **Repel**
  - **Strength**: 0.2
  - **Radius**: 3.0
- **Display Repel Radius**
- **Vector Field**
  - **Strength**: 1.0
  - **Falloff**: 8.0
- **Display During Solve**
  - **Potential Collisions**
  - **Repel Activity**
  - **Look Ahead Radius**
  - **Force**

**None (label)** Specifies a single target. Click this button, and then click the target object in the viewport. The target name then appears on the button. If you’ve selected multiple targets using Multiple Selection (see next item), the word Multiple appears on the button. To see which objects are designated as targets, click the Multiple Selection button.

**Multiple Selection** Opens the Select dialog to let you designate multiple targets. When you have more than one target, you can set delegates to move toward the closest target in the group, or to a computed average of the target positions.
**Look Ahead** The number of frames in advance of the current frame that **character studio** looks for potential collisions. Default=30.

**Hard Radius** Distance from the target's pivot point, in multiples of the delegate's bounding sphere, where no penetration should occur. Default=1.0.

**TIP** Because the hard radius' center is the pivot point, Avoid may not work as expected with target objects whose pivot point is not centered, such as the box primitive. For best results, use the Hierarchy panel > Adjust Pivot rollout controls to center the pivot to the object.

**Display Hard Radius** Enables display of a wireframe sphere that depicts the extent of the Hard Radius setting. Default=off.

**Steer To Avoid group**

Steer To Avoid is used by delegates to steer precisely around anticipated future collisions based on the delegates' current speed and direction. Delegates using this approach can pass very close to one another.

**Detour Angle** Maximum necessary turning angle relative to the direction of delegate's goal that delegate will steer to avoid rather than slow down and wait. Default=360. Range=0-360.

**TIP** To disable turning for avoidance, thus allowing only braking, set Detour Angle to 0. This forces delegates to remain directed toward their goal so that they must slow down and wait until there is a clearing in front of them, much like an audience queuing to leave through an exit after a concert.

**Brake Pressure** Determines how strongly a delegate will react when it encounters an avoided object. Higher values make the delegate more likely to slow down or stop. Lower values will cause delegates to look for a way around the obstacle so they can keep going, sometimes causing delegates to veer off in unexpected directions. Default=2.0.

**Repel group**

Repel is a general separation force that is based only on the spatial position. Delegates use this to keep from getting into situations where they might side-swipe each other or where they might get so close that Steer To Avoid is too difficult to achieve.

**Strength** Determines the strength of the repelling force; higher values result in greater repulsion force. Default=0.2. Range=0.0 to 1.0.
**Radius**  Maximum distance from delegate's bounding sphere within which "repel" avoidance is sensed and carried out. Default=3.0.

**Falloff**  The rate at which the strength diminishes between the Repel radius and the hard radius. A value of 1.0 indicates a linear falloff. Higher values cause the strength to fall off to zero more rapidly with distance, thus focusing its effect closer to the delegate's hard radius. Lower values reduce the rate of diminishment, with a Falloff setting of 0.0 indicating that the strength is the same at the Radius distance as it is at the Hard Radius. Default=3.0.

**Display Repel Radius**  Enables display of a wireframe sphere that depicts the extent of the Repel setting. Default=off.

**Vector Field group**

If you've applied a Vector Field space warp on page 5258 to an object in your scene, you can specify the vector field as an object to avoid. The distinction is this: When used with the Space Warp behavior on page 5226, delegates use the vector field to steer around the object by being guided to travel perpendicular to the field's vectors. When used with the Avoid behavior, the delegate simply moves away in the direction of the vectors.

**TIP**  Sometimes when using Avoid with a vector field, the behavior might seem to be "fighting" with other behaviors (such as Seek) over delegate movement, causing a halting and/or wavering motion. In such cases, try reducing Brake Strength and/or increasing Falloff.

**Strength**  Higher values result in more powerful influence. Delegates will be directed to move perpendicular to the field. Default=1.0. Range=0.0 to 1.0.

**Falloff**  Higher values cause vector field influence to fall off to zero more rapidly with distance, thus focusing its effect closer to the delegate's hard radius. Default=8.0.

**Display During Solve group**

Use these switches for debugging a crowd simulation. During the solve, they display information about the simulation using graphical metaphors for different aspects of the Avoid behavior.

**Potential Collisions**  Displays a green line from the delegate to the location of a potential collision. Default=off.

**Repel Activity**  Displays a white line between the delegate and target when the repel force is in effect. Default=off.
Look Ahead Radius  Displays a sphere that shows the current distance used to check for potential collisions.

Color Swatch  Shows the color used to draw the Avoid force vector during the solution. Click the box to choose a different color. Default=red.

Force  When on, force exerted on one or more delegates by the Avoid behavior is drawn in the viewports as a colored line during the simulation solution. Default=on.

**Orientation Behavior**

Create panel > Helpers > Object Type rollout > Crowd > Setup rollout > New button > Orientation Behavior

Select a Crowd object. > Modify panel > Setup rollout > New button > Orientation Behavior

The Orientation behavior lets you control whether and how delegates rotate, independent of their direction of motion. Normally, a delegate always faces in the direction it is moving. You can use the Orientation behavior to specify limits to the delegate's rotational activity without affecting its path, which is generated by other behaviors. Use these settings, for example, to keep delegates facing in one direction while moving in another.

**NOTE** These settings do not affect the path a delegate takes, which is produced by other behaviors such as Seek and Avoid. They influence only the direction it faces as it traverses the path.
Interface

Use these controls to affect how delegates turn on the vertical axis. By default, heading is absolute, with 0 specifying the positive X axis in World coordinates. Thus, -90 would specify the negative Y axis, 90 the positive Y axis, and 180 or -180 the negative X axis.

**Heading group**

Use these controls to affect how delegates turn on the vertical axis. By default, heading is absolute, with 0 specifying the positive X axis in World coordinates. Thus, -90 would specify the negative Y axis, 90 the positive Y axis, and 180 or -180 the negative X axis.
For example, if you wanted a delegate to be able to turn between the positive X axis and the positive Y axis, you would set Max Heading to 0 and Min Heading to 90.

You can also specify heading limits in amounts relative to the delegate's heading at the time that the Orientation behavior takes effect by turning on the Relative check box.

**Relative** When on, Heading settings are applied relative to the delegate's heading at the time the behavior takes effect. When off, settings are absolute. Default=off.

**Min Heading** The minimum permissible heading. This number should be lower than the Max Heading value. Default=180. Range=-180 to 180.

**Max Heading** The maximum permissible heading. This number should be higher than the Min Heading value. Default=180. Range=-180 to 180.
Max Heading Vel(ocity) Specifies how much the delegate's heading can change per frame. This controls angular acceleration and deceleration. Default=180.

Head Response Determines how quickly the heading follows the direction the object is moving in. A value of 1.0 indicates maximum responsiveness, and will point in the direction the delegate is moving (within the limits) while a lower value means that it is less responsive. Default=1. Range=0 to 1.

Pitch group

Use these controls to affect how delegates turn on the left-right axis.

Relative When on, Pitch settings are applied relative to the delegate's pitch at the time the behavior takes effect. When off, settings are absolute. Default=off.

Min Pitch The minimum number of degrees a delegate can incline or decline. This number should be lower than the Max Pitch value. Default=-180. Range=-180 to 180.

Max Pitch The maximum number of degrees a delegate can incline or decline. This number should be higher than the Min Pitch value. Default=180. Range=-180 to 180.

Max Pitch Velocity Specifies how much the delegate's pitch can change per frame. This controls angular acceleration and deceleration. Default=180.

Pitch Response Determines how quickly the pitch follows the direction the object is moving in. A value of 1.0 indicates maximum responsiveness, so that will point in the direction the delegate is moving (within the limits) while a lower value means that it is less responsive. Default=1. Range=0 to 1.

Banking group

Use these controls to affect how delegates turn on the in-out axis. Banking is primarily a result of heading changes.

Max Bank The maximum number of degrees the delegate can bank. Default=30.0.

Max Bank Velocity The maximum number of degrees the delegate's bank angle can change per frame. This controls angular acceleration and deceleration. Default=3.0.

Bank per Turn The number of degrees the delegate will bank as a function of the turn angle at the current frame. For example, if Bank per Turn=1, the
delegate will bank one degree for every degree it is turning at a given frame. Default=1.0.

**Path Follow Behavior**

Create panel > Helpers > Object Type rollout > Crowd > Setup rollout > New button > Path Follow Behavior

Select a Crowd object. > Modify panel > Setup rollout > New button > Path Follow Behavior

The Path Follow behavior lets you direct delegates to traverse a specified path during a crowd simulation. Delegates can move forward or backward along paths, and when they reach the end, they can loop back to the start or reverse direction, or even continue in the same general direction.

If the delegate's start position isn't on the path at the start of the simulation, it moves to the path before following the path. During the solution, character studio intermittently displays an optional target icon to show the delegate's immediate goal; this changes as the simulation proceeds.
Interface

**None (label)** Click this button, then select a path object. Suitable path objects include splines and NURBS curves. If a path object contains more than one spline or curve, character studio uses the lowest-numbered element (usually the earliest created one).

**NOTE** You can assign a path object only from the Modify panel.

**Radius** The radial distance from the path, in units, within which the delegate stays while traversing the path. Default=20.0. Range=0.0 to 9,999,999.0.
Turning group

These parameters determine how delegates turn while following the path. Awareness determines how well a delegate anticipates turns in the path as it moves; you can apply random variation to Awareness with the Deviation setting.

**Awareness** Specifies how "intelligent" the delegate is while traversing this path. A high Awareness setting means that it takes into account the curve of the path while moving and will try to anticipate changes. A low value for Awareness, on the other hand, means that the delegate notices the path only when leaving it. Default=0.5. Range=0.0 to 1.0.

**NOTE** You can randomize awareness behavior with the Deviation and Seed settings.

**Deviation** Specifies the maximum amount by which Awareness should vary. *character studio* takes a random number between the negative and positive values of the Deviation setting, multiplies it by the Awareness setting, and adds the result to Awareness. Default=0.0. Range=0.0 to 1.0.

**NOTE** You can vary behaviors among different Path Follow behaviors that use the same Awareness and Deviation settings by changing the Seed value.

Starting Point

Determines where on the path the delegate begins to follow the path. The default choice is Beginning of Path.

*Hint:* To see a selected spline path's start point, open the Modify panel and turn on any sub-object level; the start point is represented with a unique indicator. Also in the Modify panel, with closed curves, you can see the vertex ordering at any sub-object level by turning on Selection rollout > Display group > Show Vertex Numbers. To see a NURBS curve's start point, go to the Curve sub-object level; the start point is indicated by a small green circle.

**Beginning of Path** The delegate first moves to the start of the path before following it.

**End of Path** The delegate first moves to the end of the path before following it. With closed curves, this is the same point as the beginning of the path.

**Nearest Point** The delegate first moves to the closest point on the path and then follows the path from there.
Direction

Determines the direction the delegate takes initially when following the path. The default choice is Forwards.

Forwards The delegate moves along path vertices in ascending order.

Backwards The delegate moves along path vertices in descending order.

Action at End of Path

Determines what the delegate does when it reaches the path end. The default choice is Loop.

Loop The delegate loops around the path, even if it isn't closed. If Beginning of Path or End of Path is chosen, it returns to the path's start or end point each time it finishes traversing the path. If Nearest Point is chosen, it returns to an arbitrary point determined by its position and the path shape.

Reverse The delegate reverses direction at the end of the path. Use this choice to simulate a back-and-forth "patrol" behavior.

Continue The delegate continues moving in the same direction it faced at the end of the path until the simulation ends or it's acted upon by another force or behavior.

Seed Specifies a seed value for randomizing Awareness. Default=1.

Color Swatch Shows the color used to draw the Path Follow force vector during the solution. Click the box to choose a different color. Default=blue.

Display Force When on, force exerted on the delegate(s) by the Path Follow behavior is drawn in the viewports as a vector during the simulation solution. Default=on.

Color Swatch Shows the color used to draw the target icon. Default=dark blue.

Display Target Enables display of the target icon, which appears during the solution when a new interim goal is calculated for the delegate. Default=on.

Target Scale Specifies the overall size of the target icon. Default=5.0.
Repel Behavior

Create panel > Helpers > Object Type rollout > Crowd > Setup rollout > New button > Repel Behavior

Select a Crowd object. > Modify panel > Setup rollout > New button > Repel Behavior

The Repel behavior lets you specify any object or objects (sources) that will force delegates to move away from them. This is basically the opposite of the Seek behavior on page 5224. If you want delegates to back away from an object, as opposed to turning to face the direction they’re moving, use Repel in conjunction with the Orientation behavior on page 5213.

**NOTE** Repel is set by default to work only within a specific radius around the source. If you want it to work at any distance, turn off Radius group > Use Radii.

Interface

None (label) Specifies a single source. Click this button, and then click the target object in the viewport. The target name then appears on the button.
If you’ve selected multiple sources using Multiple Selection (see next item), the word Multiple appears on the button. To see which objects are designated as sources, click the Multiple Selection button.

**Multiple Selection** Opens the Select dialog to let you designate multiple sources. When you have more than one source, you can set delegates to move toward the closest target in the group, or to a computed average of the source positions.

**Source of Repulsion group**

Determines repel activity when the behavior uses multiple sources. The default choice is Closest Source Only.

**Closest Source Only** Each delegate is repelled by the closest of the assigned sources. Use this to have delegates assigned a single Repel behavior move away from sources in different directions.

**Average Of Sources** All delegates move away from a common point determined by averaging all sources’ locations.

**Method group**

Determines whether delegate direction as influenced by the behavior is calculated by an angular method or a force method. Default=Force.

**Angle** Applies a force to the delegate based on the angle between the delegate's current direction and the direction it would need to take in order to be moving directly away from the source.

The magnitude of the force is greatest when the delegate is moving directly towards the source, and needs to turn around. It can be as little as 0 when the delegate is moving directly away from the source.

**Force** Always applies a force directly away from the source. The magnitude of the force is constant.

**Radius group**

Use the Radius settings to activate the Repel behavior only when the delegates are within a specific distance from the target. The relative strength of the force increases from 0 percent at the outer radius to 100 percent at the inner radius.

**Use Radii** When on, the behavior applies only to delegates closer to the target than the Outer Distance value. Default=on.
**Inner Radius** The distance from the target at which the force is applied at full strength. Default=0.0.

**Outer Radius** The distance from the target at which the force begins to be applied. Default=10.0.

**Falloff** Default=2.0.

**Display Radii** The radii are displayed when the force is active.

---

**Color Swatch** Shows the color used to draw the Repel force vector during the solution. Click the box to choose a different color. Default=violet.

**Display Force** When on, force exerted on the delegate(s) by the Repel behavior is drawn in the viewports as a vector during the simulation solution.

**Scripted Behavior**

Create panel > Helpers > Object Type rollout > Crowd > Setup rollout > New button > Scripted Behavior

Select a Crowd object. > Modify panel > Setup rollout > New button > Scripted Behavior

The Scripted behavior lets you create custom behaviors using MAXScript. A scripted behavior can incorporate one of three behavior types: Force, Constraint, or Orientation.

For detailed information on scripting behaviors, see the MAXScript Help, available from the Help menu.

**Interface**

![Scripted Behavior Interface](image)
Behavior Type Choose Force, Constraint, or Orientation.

Script Context Name Specify a name for the script.

Edit MAXScript Click to open an editor window.

Seek Behavior

Create panel > Helpers > Object Type rollout > Crowd > Setup rollout > New button > Seek Behavior

Select a Crowd object. > Modify panel > Setup rollout > New button > Seek Behavior

The Seek behavior lets you specify any object or objects as a stationary or moving target for delegates. Delegates move toward the target during the crowd simulation while turning as necessary.

Interface

![Seek Behavior Interface](image-url)
None (label) Specifies a single target. Click this button, and then click the target object in the viewport. The target name then appears on the button. If you’ve selected multiple targets using Multiple Selection (see next item), the word Multiple appears on the button. To see which objects are designated as targets, click the Multiple Selection button.

Multiple Selection Opens the Select dialog to let you designate multiple targets. When you have more than one target, you can set delegates to move toward the closest target in the group, or to a computed average of the target positions.

Seek Target group

Determines seek activity when the behavior uses multiple targets.

Closest Target Only Each delegate seeks the closest of the assigned targets. Use this to have delegates assigned a single Seek behavior move in different directions.

Average Of Targets All delegates move toward a common point determined by averaging all targets’ locations.

Method group

Determines whether delegate direction as influenced by the behavior is calculated by an angular method or a force method. Default=Angle.

Angle Applies a force to the delegate based on the angle between the delegate’s current direction and the direction it would need to take in order to be moving directly toward the target.

The magnitude of the force is greatest when the delegate is moving away from the target, and needs to turn around. It can be as little as 0 when the delegate is directly approaching the target.

Force Always applies a force directly towards the target. The magnitude of the force is constant.

Radius group

Use the optional radius settings to activate the Seek behavior only when the delegates are within a specific distance from the target. The relative strength of the Seek behavior increases from 0 percent beyond the outer radius to 100 percent at the inner radius.
Use Radii  When on, the Seek behavior applies only to delegates less than the Outer Radius distance from the target. Default=off.

Inner Radius  The distance from the target at which Seek is applied at full strength. Default=0.0.

Outer Radius  The distance from the target at which Seek begins to be applied. Default=10.0.

Falloff  Default=2.0.

Display Radii  The radii are displayed when the force is active.

_____

Color Swatch  Shows the color used to draw the Seek force vector during the solution. Click the box to choose a different color. Default=green.

Display Force  When on, force exerted on the delegate(s) by the Seek behavior is drawn in the viewports as a vector during the simulation solution. If Use Radii is turned on, the radii are also displayed when the force is active.

Space Warp Behavior

Create panel > Helpers > Object Type rollout > Crowd > Setup rollout > New button > Space Warp Behavior

Select a Crowd object. > Modify panel > Setup rollout > New button > Space Warp Behavior

The Space Warp behavior lets space warps, such as wind or gravity, influence a crowd simulation. You can use it to apply space warps in the Forces and Particles & Dynamics categories to crowd members.

In particular, use the Space Warp behavior to tie delegates to a Vector Field space warp on page 5258, so that they avoid penetrating an irregularly shaped object while following its contours.
**Interface**

None (label) Click this button, then select a space warp object.

Color Swatch shows the color used to draw the Space Warp force vector during the solution. Click the box to choose a different color.

Display Force When on, force exerted on the delegate(s) by the Space Warp behavior is drawn in the viewports as a vector during the simulation solution.

**Speed Vary Behavior**

Create panel > Helpers > Object Type rollout > Crowd > Setup rollout > New button > Speed Vary Behavior

Select a Crowd object. > Modify panel > Setup rollout > New button > Speed Vary Behavior

The Speed Vary behavior is useful for objects whose velocity changes at random as they move, such as sightseeing tourists. Its parameters let you specify how often a delegate should change speed, what speed range it should look at for a new speed, and how long it should accelerate to get to that new speed.
Interface

![Image of Speed Vary Behavior interface](image)

**Time group**

**Period** Specifies how many frames should elapse before a new speed is chosen.

**Deviation** Specifies the maximum amount by which Period should vary.

Each time a period ends, **character studio** takes a random number between the negative and positive values of the Deviation setting, multiplies it by the Period setting, and adds the result to Period. Default=0.5. Range=0.0 to 1.0.

**Speed group**

The mathematical formula for the new speed is as follows: new speed = (delegate's Average Speed*Center)*(1 + RN*Center Deviation), where RN is a random number between −1 and 1.

**Center** Specifies the speed the delegate should change to. Center is a multiplier: A value of 0.0 means to stop, a value of 1.0 means to move at its average speed on page 5158, and a value greater than 1.0 means to move faster than its average speed. Default=1.0. Range=0.0 to 99,999.0.

**Deviation** Specifies the maximum amount by which the delegate's calculated speed (Average Speed*Center) should vary.
Each time a period ends, character studio takes a random number between the negative and positive values of the Deviation setting, multiplies it by the calculated speed, and adds the result to the calculated speed. Default=0.25. Range=0.0 to 99,999.0.

**Accel Period** Specifies the rate at which the delegate's speed should change in relation to the period length.
A value of 0.0 means that the transition to the new speed will proceed as quickly as possible, and a value of 0.5 means the transition will take half the period. A value of 1.0 means the transition will take the entire period. Default=0.5. Range=0.0 to 1.0.

**Deviation** Specifies the maximum amount by which acceleration should vary.
Each time a period ends, character studio takes a random number between the negative and positive values of the Deviation setting, multiplies it by the Acceleration setting, and adds the result to Acceleration. Default=0.5. Range=0.0 to 1.0.

**Seed** Specifies a value for randomizing the Speed Vary behavior.

---

**Surface Arrive Behavior**

Create panel > Helpers > Object Type rollout > Crowd > Setup rollout > New button > Surface Arrive Behavior

Select a Crowd object. > Modify panel > Setup rollout > New button > Surface Arrive Behavior

The Surface Arrive behavior is similar to the Seek behavior on page 5224 in that it lets you specify an object or objects as a stationary or moving target for delegates. The principal difference is that Surface Arrive can cause delegates to stop when they reach the target. You can also specify, to some degree, where the delegate will stop on the object, and how it will approach the target before stopping.

An example of a use for this behavior would be birds flying over a row of telephone poles, then each one landing on top of a different pole.
None (label) Specifies a single target. Click this button, and then click the target object in the viewport. The target name then appears on the button. If you've selected multiple targets using Multiple Selection (see next item), the word Multiple appears on the button. To see which objects are designated as targets, click the Multiple Selection button.

Multiple Selection Opens the Select dialog to let you designate multiple targets.

When you have more than one target, you can set delegates to move toward the closest target in the group, or to a computed average of the target positions.

Arrival group

Specifies three aspects of the Surface Arrive behavior: Rate, Speed, and Distance.

Disable After Arriving When on, turns off the Surface Arrive behavior after the delegate arrives at the surface. Default=on.

Rate A multiple of the delegate's Max Accel on page 5158 setting that specifies the acceleration with which it will try to arrive. A value of 1.0 means to use the full acceleration of the delegate. Default=0.5.

Deviation Adds random variation to the to the Rate setting.

The actual deviation is calculated by multiplying the Deviation setting by a random number between -1 and 1, and then multiplying the result by the Rate setting. Default=0.0.

Speed The speed at which to arrive, relative to the speed of the target. Default=0.0.

Deviation Adds random variation to the Speed setting. Default=0.0.

The actual deviation is calculated by multiplying the Deviation setting by a random number between -1 and 1, and then multiplying the result by the Speed setting.

Distance The maximum radial distance from the target within which the behavior will be active. Default=9999999.0.

Until the delegate is within this radius, the behavior has no influence.

Deviation Adds random variation to the to the Distance setting.

The actual deviation is calculated by multiplying the Deviation setting by a random number between -1 and 1, and then multiplying the result by the Distance setting. Default=0.0.
Location group

**Offset** Specifies a consistent distance from the calculated arrival point, based on the surface normal, for the delegate to use. Default=0.0.

**Facing** When on, the delegate will try to arrive only at points on triangles on the surface that are facing it. Default=off.

**Random character studio** chooses a random point on the target surface as the arrival point.

When using the Random option, character studio chooses arrival points for delegates once, at the beginning of the simulation. This is the default choice.

**Closest character studio** chooses the closest point on the target surface as the arrival point.

If Closest is chosen, but Every Frame is off, character studio chooses arrival points for delegates once, at the beginning of the simulation.

**Every Frame** When on, character studio chooses arrival points for delegates at every frame. Available only when Closest is chosen. Default=off.

Every Frame is useful when the target object is rotating during the animation, but requires more time for calculation.

**Display Offset** When on, shows the Offset distance as lines emanating from each vertex in the surface object, perpendicular to the surface.

Approach group

The Height and Descent settings together specify the path the delegate will take for its arrival. They allow for a wide range of behavior, from soft, gradual landings to direct helicopter-type descents.

In both cases, the actual deviation is calculated by multiplying the Deviation setting by a random number between -1 and 1, and multiplying the result by the relevant value.

**Height** Specifies a distance from the arrival point along its face normal. This is the point that the delegate will go to first before descending to the arrival point.

**Deviation** Adds random variation to the to the Height setting. The actual deviation is calculated by multiplying the Deviation setting by a random number between -1 and 1, and then multiplying the result by the Height setting.
Descent Start Specifies the distance between the delegate and the arrival point at which the descent should start.

NOTE Be careful that Descent Start is set high enough that the delegate won’t overshoot when descending because its speed is too high and deceleration too low, compared to when it should start descending.

Deviation Adds random variation to the Descent Start setting. The actual deviation is calculated by multiplying the Deviation setting by a random number between -1 and 1, and then multiplying the result by the Descent Start setting.

Off This Normal When on, lets you set an approach vector to specify the angle at which the final approach occurs. Default=off.

X/Y/Z Use these settings to specify the final approach vector in world coordinates. For example, the vector specified by the default settings of X=0, Y=0, Z=1 means that the delegates will approach the target along the vertical world axis.

Seed Affects the random numbers used to calculate the Deviation settings. For similar randomization among different Surface Arrive behaviors, use the same Seed value.

Color Swatch Shows the color used to draw the target icon. Default=dark blue.

Display Target Enables display of the target icon, which appears during the solution when a new interim goal is calculated for the delegate. Interim goals are created when using the Approach group settings. Default=on.

Target Scale Specifies the overall size of the target icon. Default=5.0.

Surface Follow Behavior

Create panel > Helpers > Object Type rollout > Crowd > Setup rollout > New button > Surface Follow Behavior

Select a Crowd object. > Modify panel > Setup rollout > New button > Surface Follow Behavior
The Surface Follow behavior moves delegates with respect to object surfaces, which can be still or animated. For example, you can apply an animated Noise modifier to a patch grid to simulate a choppy water surface, and objects guided by Surface Follow will stay on top.

NOTE By default, a delegate influenced by Surface Follow picks a direction to move in at any given frame based on its current facing and the plane of the face it's currently over. Thus objects moving up a hill, while seeking a point at the bottom of the other side of the hill, tend to turn left or right to skirt the hill, rather than following the upward slope. You can override this with the Projection Vector option.

Interface

None (label) Specifies a single "target" object to use as a surface. Click this button, and then click the target object in the viewport. The target name then appears on the button.

If you've selected multiple targets using Multiple Selection (see next item), the word Multiple appears on the button. To see which objects are designated as targets, click the Multiple Selection button. The Select dialog appears with designated targets highlighted.
Multiple Selection Opens the Select dialog to let you designate multiple targets.
When you have more than one target, delegates initially move toward the closest target in the group, and then move over its surface until they encounter another target, at which point they switch to its surface, and so on.

Projection Vector group

These controls let you override the default direction calculated by the Surface Follow behavior by describing a virtual plane along which the delegate is to move. You do this by specifying a vector, in world coordinates, that's perpendicular to the desired virtual plane.

For example, if you want the delegate, when it encounters a hill, to keep moving forward, straight up and over the hill, instead of skirting it, you would use the default Projection Vector settings: X=Y=0, Z=1. This vector is aligned with the world Z (vertical) axis, so it specifies a plane parallel to the world XY plane. Thus, the delegate always moves straight ahead while following the surface.

Use Projection When on, Surface Follow calculates delegate direction from the specified vector, rather than using the default.

X/Y/Z Specifies a vector using world coordinates. Default=X=Y=0, Z=1. Range=-1.0 to 1.0.
If only one of these settings is not 0, then the projection vector is aligned with the non-zero axis. Combine non-zero settings to create angled planes for Surface Follow. For example, to create a virtual plane that's rotated 45 degrees clockwise about world Y axis, set X=Z=1 and Y=0. Also, while you can set all three axes to 0, that specifies no vector, and so effectively turns off Use Projection.

Position on Surface group

Offset Specifies the delegate's distance above the surface, using the surface normal. Recalculated at each frame.

Display Offset When on, shows the Offset distance as lines emanating from each vertex in the surface object, perpendicular to the surface.

Color Swatch Shows the color used to draw the Surface Follow target (see Display Target, next) during the solution. Click the box to choose a different color.
Display Target  When on, the interim goal for each delegate influenced by the Surface Follow behavior is drawn in the viewports as a wireframe sphere during the simulation solution.

If the delegate starts out away from the surface to be followed, the target is most visible before the delegate reaches the surface; the target is then positioned along the surface edge. While the delegate is actually following the surface, the target is usually coincident with the delegate, because Surface follow sets a new destination only a frame or two ahead.

Target Scale  Sets the target size.

Wall Repel Behavior

Create panel > Helpers > Object Type rollout > Crowd > Setup rollout > New button > Wall Repel Behavior

Select a Crowd object. > Modify panel > Setup rollout > New button > Wall Repel Behavior

The Wall Repel behavior uses one or more grid objects to repel delegates. When influenced by the Wall Repel force, delegates turn until they're heading away from the grid. It's useful for keeping objects inside a straight-sided enclosure, such as a room in a building.

You can set the grids to repel from either side or both sides, and optionally specify a maximum distance for repelling. You can also set the behavior to act as though each grid extends infinitely along its plane.

NOTE  The Wall Repel behavior simply applies a force on the delegate in the direction opposite the wall; it does not guarantee that the delegate won't go through the wall. If the delegate does go through the wall, adjust settings such as Inner and Outer Distance, and, in particular, try reducing Falloff.
Grid from which to repel

Set a repelling grid ("source") by clicking the None button and then selecting the grid. Thereafter, the grid’s name appears on the button.

To set multiple source grids, click Multiple Selection and use the Select dialog. With multiple source grids, the word "Multiple" appears on the large button.

Method group

Determines whether delegate direction as influenced by the behavior is calculated by an angular method or a force method. Default=Force.

Angle Applies a force to the delegate based on the angle between the delegate’s current direction and the direction it would need to take in order to be moving directly away from the source.
The magnitude of the force is greatest when the delegate is moving directly towards the source, and needs to turn around. It can be as little as 0 when the delegate is moving directly away from the source.

**Force** Always applies a force directly away from the source. The magnitude of the force is constant.

**Direction group**

Determines whether the grid repels from its positive-axis side, its negative-axis side, or both.

To determine which is the positive-axis side, select the grid, and then set the reference coordinate system to Local (the default system is View). Look at the grid in a viewport in which it appears edge-on. The side with the axis sticking out is the positive-axis side, and the opposite side is the negative-axis side.

---

**TIP** For ease of setup, when building a "room" from grids, make sure they all point inward (or outward).

**Positive Axis** The grid repels only from the positive-axis side.

**Negative Axis** The grid repels only from the negative-axis side.

**Both Axes** The grid repels from both sides.

**Distance group**

Use the distance settings to activate the Wall Repel behavior only when the delegates are within a specific distance from the target. The relative strength of the behavior increases from 0 percent at the outer radius to 100 percent at the inner radius.

**Use Distance** When on, the behavior applies only to delegates closer to the target than the Outer Distance value. Default=on.

**Inner Distance** The distance from the target at which the force is applied at full strength. Default=0.0.

**Outer Distance** The distance from the target at which the force begins to be applied. Default=10.0.

**Falloff** The rate at which the repelling force diminishes between the Inner Distance and the Outer Distance. Default=2.0.

A value of 1.0 indicates a linear falloff. Higher values cause the strength to fall off to zero more rapidly with distance, thus focusing its effect closer to the Inner Distance. Lower values reduce the rate of diminishment, with a
Falloff setting of 0.0 indicating that the strength is the same at the Outer Distance as it is at the Inner Distance.

Display Distance Shows the inner and outer distance settings as grids offset from the target grid in the viewports. The Inner Distance grid is light blue, while the Outer Distance grid is blue-white. Default=on.

Grid Spacing Alters the spacing of grid lines used to draw the Inner/Outer Distance grids. The lower the value, the closer the spacing. Default=500.

End force at grid edges When on, the force emanates only from the grid object. When off, the force emanates from an imaginary infinite grid created by extending the grid plane in all directions.

Color Swatch Shows the color used to draw the Wall Repel force during the solution. Click the box to choose a different color. Default=violet.

Display Force The force, when activated, is drawn in the viewports as a wireframe rectangle during the simulation solution. Default=on.

Wall Seek Behavior

Create panel > Helpers > Object Type rollout > Crowd > Setup rollout > New button > Wall Seek Behavior
Select a Crowd object. > Modify panel > Setup rollout > New button > Wall Seek Behavior
The Wall Seek behavior uses a grid object to attract delegates. When influenced by the Wall Seek force, delegates turn until they're heading toward the grid. It's useful for moving objects toward a rectangular area, such as a doorway.
You can set the grid to attract from either side or both sides, and optionally specify a maximum distance for attraction. You can also set the behavior to act as though the grid extends infinitely along its plane.
**Interface**

<table>
<thead>
<tr>
<th>Wall Seek Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grid to Seek:</td>
</tr>
<tr>
<td>None</td>
</tr>
<tr>
<td>Method:</td>
</tr>
<tr>
<td>angle</td>
</tr>
<tr>
<td>force</td>
</tr>
<tr>
<td>Direction:</td>
</tr>
<tr>
<td>Positive Axis</td>
</tr>
<tr>
<td>Negative Axis</td>
</tr>
<tr>
<td>Both Axes</td>
</tr>
<tr>
<td>Distance:</td>
</tr>
<tr>
<td>Use Distance</td>
</tr>
<tr>
<td>Inner Distance: 0.0</td>
</tr>
<tr>
<td>Outer Distance: 10.0</td>
</tr>
<tr>
<td>Falloff: 2.0</td>
</tr>
<tr>
<td>Display Distance:</td>
</tr>
<tr>
<td>Grid Spacing: 500</td>
</tr>
<tr>
<td>End force at grid edges</td>
</tr>
<tr>
<td>Display Force</td>
</tr>
</tbody>
</table>

**Grid to seek** Set the target grid by clicking the button (initially labeled “None”) and then selecting the grid. Thereafter, the grid’s name appears on the button.

**Method group**

Determines whether delegate direction as influenced by the behavior is calculated by an angular method or a force method. Default=Angle.

**Angle** Applies a force to the delegate based on the angle between the delegate’s current direction and the direction it would need to take in order to be moving directly toward the target.

The magnitude of the force is greatest when the delegate is moving away from the target, and needs to turn around. It can be as little as 0 when the delegate is directly approaching the target.
**Force** Always applies a force directly towards the target. The magnitude of the force is constant.

**Direction group**

Determines whether the grid attracts from its positive-axis side, its negative-axis side, or both.

To determine which is the positive-axis side, select the grid, and then set the reference coordinate system to Local (the default system is View). Look at the grid in a viewport and check the direction of the Z-axis arrow. This arrow determines the positive-axis direction. The opposite direction is the negative-axis direction.

- **Positive Axis** The grid attracts only from the positive-axis side.
- **Negative Axis** The grid attracts only from the negative-axis side.
- **Both Axes** The grid attracts from both sides.

**Distance group**

Use the distance settings to activate the Wall Seek behavior only when the delegates are within a specific distance from the target. The relative strength of the behavior increases from 0 percent at the outer distance to 100 percent at the inner distance.

- **Use Distance** When on, the behavior applies only to delegates closer to the target than the Outer Distance value. Default=on.
- **Inner Distance** The distance from the target at which the force is applied at full strength. Default=0.0.
- **Outer Distance** The distance from the target at which the force begins to be applied. Default=10.0.
- **Falloff** The rate at which the attracting force diminishes between the Inner Distance and the Outer Distance. Default=2.0.
  
  A value of 1.0 indicates a linear falloff. Higher values cause the strength to fall off to zero more rapidly with distance, thus focusing its effect closer to the Inner Distance. Lower values reduce the rate of diminishment, with a Falloff setting of 0.0 indicating that the strength is the same at the Outer Distance as it is at the Inner Distance.

- **Display Distance** Shows the inner and outer distance settings as grids offset from the target grid in the viewports. The Inner Distance grid is light blue, while the Outer Distance grid is blue-white. Default=on.
Grid Spacing  Alters the spacing of grid lines used to draw the Inner/Outer Distance grids. The lower the value, the closer the spacing. Default=500.

End force at grid edges  When on, the force emanates only from the grid object. When off, the force emanates from an imaginary infinite grid created by extending the grid plane in all directions.

Color Swatch  Shows the color used to draw the Seek force vector (and, if used, the radii) during the solution. Click the box to choose a different color. Default=violet.

Display Force  When on, force exerted on the delegates by the Seek behavior is drawn in the viewports as a vector during the simulation solution. If Use Radii is turned on, the radii are also displayed when the force is active.

Wander Behavior

Create panel > Helpers > Object Type rollout > Crowd > Setup rollout > New button > Wander Behavior
Select a Crowd object. > Modify panel > Setup rollout > New button > Wander Behavior

The Wander behavior imparts a random motion to delegates, letting you simulate meandering activity in which delegates move and turn in a haphazard manner. It works by randomly picking a new direction, and then turning and moving in that direction. You can specify how often to pick a new direction, how far to turn, and how fast or slow to turn while moving.

TIP  The trajectory calculated by the Wander behavior varies significantly for each object to which it’s applied. To create a group of wandering delegates all using the same trajectory, apply the Wander behavior to a delegate, solve the simulation, and then replicate the delegate using the Scatter Objects on page 5165 facility with Clone Controllers turned on.

Procedures

To use the Wander behavior:

1  Add a Wander behavior to the Crowd object.
2 Change the default settings as desired. Probably the most important is Period, which sets the number of frames between changes of direction.

3 Use Behavior Assignments on page 5188 to assign the behavior to a delegate or team.

**Interface**

**Time group**

- **Period** Specifies how many frames should elapse before a new direction is chosen. Default=10.

- **Deviation** Specifies the maximum amount by which Period should vary. Each time a period ends, character studio takes a random number between the negative and positive values of the Deviation setting, multiplies it by the Period setting, and adds the result to Period. Default=0.5. Range=0.0 to 1.0.

**Turning group**

- **Angle** Specifies how far to turn when changing direction. A small value means to change direction by only a small amount, while as the value approaches 1.0 the delegate will turn randomly in any direction. Default=0.5. Range=0.5 to 1.0.

- **Turn Period** Specifies how long over the current period it takes to turn. A value of 0.0 means that the delegate will rotate as quickly as possible to face a direction and then travel in that direction, while a value of 1.0 means the
delegate will take the entire period to rotate in that direction. Default=0.5. Range=0.5 to 1.0.

**Deviation** Specifies the maximum amount by which Angle should vary. Each time a period ends, character studio takes a random number between the negative and positive values of the Deviation setting, multiplies it by the Angle setting, and adds the result to Angle. Default=0.5. Range=0.0 to 1.0.

—

**Seed** Specifies a seed value for randomizing the Wander behavior.

**Color swatch** Shows the color used to draw the Wander force vector during the solution. Click the box to choose a different color.

**Display Force** When on, force exerted on the delegates by the Wander behavior is drawn in the viewports as a vector during the simulation solution.

### Solve Rollout

Create panel > Helpers > Object Type rollout > Crowd > Solve rollout

Select a Crowd object. > Modify panel > Solve rollout

Once you've set up the crowd simulation, use this rollout to set solution parameters and to solve the simulation. You can solve continuously or a frame at a time, starting at any frame.
**Interface**

**Solve** Runs the crowd simulation continuously, applying all specified behaviors to delegates to which they are assigned. Solving a simulation overwrites any previous solutions.

To abort a solution in progress and save all keys generated up to that point, press the Esc key. Alternatively, with complex simulations, you can save time by pressing Shift+Esc to abort a solution without saving keys.
Step Solve  Runs the crowd simulation one frame at a time, starting at the current frame as specified by the time slider position. Press the spacebar to advance one frame.

To abort a solution in progress and save all keys generated up to that point, press the Esc key. When you do so, character studio disregards any non-default settings for Save Every Nth Key. Alternatively, with complex simulations, you can save time by pressing Shift+Esc to abort a solution without saving keys.

**NOTE**  Step Solve always starts at the current frame; it disregards the Simulation Start setting.

Simulation Start  The first frame of the simulation. Default=0.

To make the solution repeatable, set this and keep it the same.

Start Solve  The frame at which you begin solving. Default=0.

This value must be greater than or equal to that of Simulation Start. If greater, the solve will begin in the middle of the simulation.

Start Solve should equal Simulation Start the first time you solve, so that when you set Start Solve to start in the middle of the simulation, the simulation up to that point will be correct.

**NOTE**  If you set Start Solve to a frame number lower than the first frame of the active time segment, character studio changes the first frame of the time segment to the Start Time value.

End Solve  Specifies the last frame considered for the solution. Default=100.

**NOTE**  If you set End Solve to a frame number higher than the last frame of the active time segment, character studio changes the last frame of the time segment to the End Solve value.

Delete Keys before Solve  Deletes the keys of active delegates in the range over which the solution takes place. Default=off.

This option leaves the first two keys so that the delegate doesn't end up with no keys and then pop to its current position. This is a useful feature for biped crowds; it lets you watch each biped compute, one after another, without the ones not yet computed still performing their old animation.

Save every Nth Key  Lets you specify the number of position and rotation keys saved after the solution.

Positions/Rotations  The frequency with which keys are saved for delegate positions and rotations. If 0, no keys are saved. If 1, a key is saved every frame. If 2, a key is saved every other frame, and so on. Defaults=1.
Display During Solve group

Update display When on, motion produced during solution of a crowd simulation appears in the viewports. Default=on.

Frequency How often the display is updated during the solution. If 1, the update occurs every frame. If 2, the update occurs every other frame, and so on. Default=1.

Vector Scale Globally scales all force and velocity vectors that are displayed during the simulation. Default=10.0.
Scaling vectors up helps to see them better when they are very small. It does not effect the simulation.

MAXScript group

This feature lets you execute a MAXScript script at each frame. Its primary purpose is for working with bipeds; specifically, to take advantage of available MAXScript calls to Biped that let you specify which clip the biped will be likely to choose next when using the shared motion flow feature. With this feature, you can write a script that dynamically selects the biped’s next clip during the Crowd simulation, based on which clip is currently being used, the frame number, the proximity of other bipeds, or anything else that you can find out in a script. Of course, this scripting feature can be used for other purposes as well.

Use MAXScript When on, a user-specified script is executed at each frame during the solution. Default=off.

Function Name The name of the function to be executed. This name must also specified in the script.

Edit MAXScript Click this button to open a MAXScript window for displaying and modifying the script.

Bipeds group

When solving simulations that use bipeds linked to delegates, it is strongly recommended that you use all three options in this group.

Biped/Delegates Only When on, only biped/delegates are included in the computation. Also, the options to use priorities and backtracking become available. These options are available only for biped-only computations. Default=off.
**Use Priorities** When on, biped/delegates are computed one delegate at a time, in order of their Priority values, from lowest to highest. Also, backtracking becomes available, and Step Solve becomes unavailable. Default=off.

**Backtracking** Turns on backtracking functionality when solving a crowd simulation that uses bipeds. Default=off.

When Backtracking is on during the solution, in the case of an impending collision between bipeds, the Crowd system will back up the simulation to the beginning of the current clip, and then try a different traversal of the lower-priority delegate/biped's motion flow graph. If necessary, the system will back up two or more clips.

**Priority Rollout**

Create panel > Helpers > Object Type rollout > Crowd > Priority rollout

Select a Crowd object. > Modify panel > Priority rollout

The Crowd system uses the Priority rollout settings when solving a simulation involving bipeds associated with delegates.

The Priority parameter is a positive integer assigned by the user to a delegate. When priorities are used, the Crowd simulation computes one biped at a time, based on its priority setting *from lowest to highest*; that is, a lower Priority setting means a higher priority. If the priorities of two biped/delegates are the same, the computation order of those two biped/delegates is randomly determined.

This topic describes the six different ways of setting a delegate's priority, and how priorities might be put to use in different situations.

**Using Priorities**

If you have a large crowd all going in one direction, you would typically want the delegates in front to solve first. In that case, using Proximity To An Object or Proximity To A Grid would be useful in setting priorities.

In a case where you start with a circle of bipeds, and you want them all to wander and mingle, you might not care about the bipeds' priorities. You could let them all have the same priority and let the system decide which goes first. However, it might be better to assign random priorities or make priorities unique, so that you are guaranteed the same order each time, and you can read the priority numbers to know what will happen next. This also lets you change the order if you need to.
Suppose you have two groups of bipeds, all of which are assigned random priorities. If you wanted to keep the priority relationships within each group, but make one group start after or before the other, you could use Increment Priorities to increment or decrement all the priorities in one group.

If none of the algorithms applies to your situation, you need some way to set the priorities by hand. It's useful to be able to set them visually. That's what the Assign By Picking method is for.

**Interface**

```
Priority

Start Priority: 0

Assign by Picking
PICK/ASSIGN

Assign by Computation
DELEGATES TO PRIORITIZE

Proximity to an Object:
None  Assign

Proximity to a Grid:
None  Assign

Assign Random Priorities

Make Priorities Unique

Increment Priorities
Increment: 0

Set Start Frames...

Display Priorities
Display Start Frames

Crowd Animation User Interface | 5249
**Start Priority** Sets the initial priority value. Applies to the first four methods of setting priorities: Assign By Picking, Proximity To An Object, Proximity To A Grid, and Assign Random Priorities. Default=0.

**NOTE** Priority is assigned in increasing order. Thus, a delegate with Priority value 0 goes before a delegate with Priority 1, 1 goes before 2, and so on.

**Assign by Picking group**

**Pick/Assign** Lets you assign successively higher Priority values to any number of delegates by selecting each in turn in the viewport. The first delegate you select is assigned the Start Priority value. The Priority value assigned to each succeeding delegate you select is incremented by one.

To stop assigning priorities, right-click in a viewport or click the Pick/Assign button again.

Delegate priorities appear in viewports as black numerals attached to each delegate; they're usually most easily seen in Wireframe views.

**NOTE** You can undo and/or redo assignments during the process.

**TIP** It's possible to assign two or more delegates the same priority value using this method. In such a case, for more predictable behavior, use Make Priorities Unique so that delegates don't share priorities.

**Assign by Computation group**

This group provides five different methods for assigning priorities to delegates, plus a button for selecting delegates to be affected by these methods.

**Delegates to Prioritize** Lets you use the Select dialog to specify delegates to be affected by subsequent use of other controls within this group. Select the delegates with the Select dialog, and then click Select to exit the dialog. This selection applies only to Proximity assignments (that is, Proximity To An Object and Proximity To A Grid).

**Proximity to an Object** Lets you assign priorities based on delegates' distance from a specific object. To specify the object, click the None button, and then select the object on which priorities are to be based. Lastly, click the Assign button to compute and assign priorities. The delegate closest to the object is assigned the Start Priority value, and each successively farther delegate is assigned the next highest priority.

For any delegates that are equidistant from the object, character studio assigns priorities randomly.
Proximity to a Grid  Lets you assign priorities based on delegates' distance from an infinite plane defined by a specific grid object. To specify the grid object, click the None button, and then select the grid object on which priorities are to be based. Lastly, click the Assign button to compute and assign priorities. The delegate closest to the grid object is assigned the Start Priority value, and each successively farther delegate is assigned the next highest priority.

For any delegates that are equidistant from the plane, character studio assigns priorities randomly.

Assign Random Priorities  Assigns random priorities to the selected delegates. The range of priority values assigned lies between the Start Priority value and that value plus the number of selected delegates.

Make Priorities Unique  Ensures that all delegates have unique priority values. If two delegates share the same priority, one of them will be given a new priority value that differs from the rest.

Increment Priorities  Increments the priorities of all selected delegates by the Increment value.

Increment  Sets the value by which the Increment Priorities button adjusts delegate priorities. Use a negative Increment value to decrement priorities. Default=0.

---

Set Start Frames  Opens the Set Start Frames dialog on page 5251, for setting start frames based on assigned priorities.

Display Priorities  Enables the display of assigned priority values as black numerals attached to the delegates. Default=off.

Display Start Frames  Enables the display of assigned start frame values as black numerals attached to the delegates. Default=off.

When both Display Priorities and Display Start Frames are on, the two values are displayed side by side, separated by a slash symbol (/). The priority appears to the left of the slash and the start frame appears to the right.

Set Start Frames Dialog

Create panel > Helpers > Object Type rollout > Crowd > Priority rollout > Set Start Frames button
Select a Crowd object. > Modify panel > Priority rollout > Set Start Frames button

When you include bipeds in a crowd simulation using a shared motion flow, you usually don’t want them all walking in lockstep formation. You can avoid this by setting different start frames to vary the animation frame at which each biped starts moving using its initial motion clip. In most cases, you would set start frames in the same order as priority, so you don’t get bipeds with earlier start frames stuck behind bipeds with later start frames. The Set Start Frames dialog lets you automatically assign start frames to delegates in the same order as priority.

This dialog assigns start frames to the delegates selected via the Delegates To Prioritize on page 5250 control. In general, you should first use a non-random method to assign priorities in the Priority rollout on page 5248, such as the Pick/Assign button or one of the Proximity options, and then assign start frames with this dialog. You can use the dialog to set a start frame for the highest-priority delegate (that is, the delegate with the lowest Priority setting), and then have start frames incremented randomly between two limits for the remaining delegates, based on priority order.

For instance, if you set Lowest Start Frame to 0, Minimum Number ... to 1, and Maximum Number to 3, you could get a start frame sequence like this: 0, 2, 5, 6, 8, and so on. If you want more regularly staggered start frames, set Minimum and Maximum to the same value. For example, with Lowest Frame=0 and Minimum/Maximum both set to 2, you’d get: 0, 2, 4, 6, 8, etc.

**Interface**

![Set Start Frames dialog]

Lowest Start Frame Sets the start frame assigned to the delegate with the lowest Priority setting.
**Minimum number of frames between consecutive start frames** The smallest value character studio will use to increment assigned start frames.

**Maximum number of frames between consecutive start frames** The largest value character studio will use to increment assigned start frames.

**Delegates with the same priority get the same start frame** character studio assigns the same start frame to any delegates with identical Priority settings. When off, character studio randomizes the order of same-priority delegates’ start frames. Default=on.

**OK** Assigns start frame values to selected delegates based on the dialog settings and priority order and closes the dialog.

**Cancel** Closes the dialog without changing start frame values.

**Smoothing Rollout**

Create panel > Helpers > Object Type rollout > Crowd > Smoothing rollout

Select a Crowd object. > Modify panel > Smoothing rollout

Smoothing works on existing animation keys (that is, a solved simulation) to create more natural-looking animation. Use these controls if solving a crowd simulation results in abrupt position or rotation changes of animated objects.

By default, smoothing works by reducing keys. As an option, it can also filter (average) existing animation keys to make changes more gradual, resulting in more natural motion.
**Interface**

- **Select Objects to Smooth** Opens the Select dialog, which lets you specify which objects' positions and/or rotations to smooth.

- **Filter delegate selection** When on, the Select dialog opened by the Select Objects To Smooth button shows only delegates. When off, it shows all scene objects. Default=on.

- **Whole Animation** Smoothes all animation frames. This is the default option.

- **Animation Segment** Smoothes only the frame ranges specified in the From and To fields.

- **From** When Animation Segment is chosen, specifies the first animation frame for smoothing.

---

5254 | Chapter 15  character studio
To When Animation Segment is chosen, specifies the last animation frame for smoothing.

**Positions** When on, selected objects' animation paths generated via the simulation are smoothed after the simulation has finished. Default=on.

**Rotations** When on, selected objects' rotations generated via the simulation are smoothed after the simulation has finished. Default=on.

**Reduction group**

**Reduce** Reduces the number of keys by keeping only every Nth key.

**Keep every Nth key N**: Limits the amount of smoothing by keeping every other key (N=2), or every third key (N=3), and so on. Default=2.

**Filtering group**

Smoothing works by averaging the delegate's current position and/or orientation with those several keyframes ahead and behind. All keyframes used in the calculation can be affected. These settings let you control the number of keyframes used and the extent of smoothing performed.

**Filter** When on, smoothing is performed using the remaining settings in this group.

**Past Keys** The number of keys prior to the current frame used for averaging position and/or rotation. Default=2.

**Future Keys** The number of keys after the current frame used for averaging position and/or rotation. Default=2.

**Smoothness** Determines the degree to which smoothing is performed. The higher the setting, the closer all keys involved in the calculation are moved toward the average value. Default=4.

The highest available Smoothness value is always 6. The lowest available value depends on the Past Keys and Future Keys settings.

---

**Perform Smoothing** Click this button to carry out the smoothing operation.

**NOTE** If neither the Reduce nor the Filter check box is turned on, no smoothing is performed.
Collisions Rollout

Create panel > Helpers > Object Type rollout > Crowd > Collisions rollout
Select a Crowd object. > Modify panel > Collisions rollout

During a crowd simulation, you can use this rollout to keep track of collisions defined by Avoid behaviors. A delegate whose hard radius as defined by the Avoid behavior intersects with the hard radius of anything it is avoiding is marked as having collided at that frame. If too many collisions occur, the simulation might not provide satisfactory results; in such cases, you might want to alter the simulation setup.

Interface

Hilite Colliding Delegates
When on, delegates that collide are highlighted in the collision color.

Only during collisions Colliding delegates are highlighted only in frames in which they actually collide.

Always Colliding delegates are highlighted in frames in which they collide and all subsequent frames.

Collision Color The color swatch indicates the color used to highlight colliding delegates. To change the color, click the swatch and use the Color Selector dialog to set a new color.

Clear Collisions Clears collision information from all delegates.
If you re-solve part of the simulation, new collision information for the recomputed frames will be computed. However, if you move a delegate manually, its collision information will remain the same, and may be incorrect. In such cases, use Clear Collisions to correct the collision information.
Geometry Rollout

Create panel > Helpers > Object Type rollout > Crowd > Geometry rollout
Select a Crowd object. > Modify panel > Geometry rollout
Use this parameter to modify the crowd object's size.

Interface

![Geometry Rollout Interface](image)

**Icon Size** Determines the size of the Crowd helper object's icon.
This setting is primarily for visibility; it has no effect on the crowd simulation.

Global Clip Controllers Rollout

Create panel > Helpers > Object Type rollout > Crowd > Global Clip Controllers rollout
Select a Crowd object. > Modify panel > Global Clip Controllers rollout
Use global clip controllers when assigning a non-biped animated object (such as a bird flapping its wings) to a delegate in a crowd simulation. Applications include synthesis of animation activity based on a variety of criteria, such as an object's speed, acceleration, and pitch.
This group of controls replicates the Track View controls for the same functionality. For an in-depth discussion of global clip controllers and related topics, see:
- **Non-Biped Crowds** on page 5148
- **Synthesis Dialog** on page 5268
- **ClipState Dialog** on page 5280
For a procedure covering clip controller usage, see:
- **To use Motion Synthesis with non-bipedal creatures**: on page 5150
Interface

(List) Lists objects designated as Global Objects, whose controllers can be used as animation clips to control other objects (typically clones).

To designate an object as a Global Object, click the New button, and then select the object in the Select dialog.

New To designate a Global Object and add it to the list, click this button, and then select the object in the Select dialog.

Edit To modify a Global Object's properties, click its name in the list, and then click this button. This opens the Synthesis dialog on page 5268.

Load Loads a previously saved Global Motion Clip (.ant) file from disk.

Save Stores the current Global Motion Clip settings on disk in the .ant file format.

Vector Field Space Warp

Create panel > Space Warps > Particles & Dynamics > Object Type rollout > Vector Field

A vector field is a special type of space warp that crowd members use to move around irregular objects such as curved, concave surfaces. The Vector Field gizmo, a box-shaped lattice, is placed and sized so that it surrounds the object to be avoided. The vectors are generated from the lattice intersections. These vectors are, by default, perpendicular to the surface of the object to which the field is applied; if necessary, you can smooth them out with a blending function. The crowd members move around the object by traveling perpendicular to the vectors.
You can use the vector field as a Space Warp behavior on page 5226, as the source object for an Avoid behavior on page 5209, or both. When used together, delegates slow down when they approach a complex object, and then go around it. This guarantees that delegates will not pass through the obstacle's surface.

The vector field includes settings for strength, falloff, and a push/pull effect, as well as options to display the lattice, the effective range, and the vectors.

**Create Method Rollout (Vector Field Space Warp)**

Create panel > Space Warps > Particles & Dynamics > Object Type rollout > Vector Field > Create Method rollout

The Create Method rollout for the Vector Field space warp lets you specify whether to create the vector field using the cube or box method.
Interface

Cube Forces length, width, and height to be equal.
Creating a cube-shaped space warp is a one-step operation. Starting at the center of the cube, drag in a viewport to set all three dimensions simultaneously. You can change the individual dimensions in the Lattice Parameters rollout.

Box Creates a standard box-shaped space warp from one corner to the diagonally opposite corner, with different settings for length, width, and height.

Lattice Parameters Rollout (Vector Field Space Warp)

Create panel > Space Warps > Particles & Dynamics > Object Type rollout > Vector Field > Lattice Parameters rollout
Select a Vector Field space warp. > Modify panel > Lattice Parameters rollout
Use these parameters to specify the Vector Field lattice size and number of segments.

Interface

Length/Width/Height Specify the dimensions of the lattice. The lattice should be larger than the Vector Field object.
**Length Segs / Width Segs / Height Segs** Specify the resolution of the Vector Field lattice. The greater the resolution, the higher the accuracy of the simulation.

**Obstacle Parameters Rollout (Vector Field Space Warp)**

Create panel > Space Warps > Particles & Dynamics > Object Type rollout > Vector Field > Obstacle Parameters rollout

Select a Vector Field space warp. > Modify panel > Obstacle Parameters rollout

A vector field on page 5258, generated around an obstacle object, allows crowd on page 5162 members to avoid that object in a scene. The field consists of a three-dimensional array of vectors which guide delegates or other objects around the obstacle. The settings in this rollout help determine how the vectors are generated and displayed, and how they affect other objects.

**NOTE** Objects are subject to a vector field's forces only if they are bound to the field with a Crowd object. For general usage guidelines, see To use a Vector Field space warp on page 5126.
### Display group

<table>
<thead>
<tr>
<th>Display</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Lattice</td>
<td>Displays the vector field lattice, a yellow wireframe box. Default=on.</td>
</tr>
<tr>
<td>Show Range</td>
<td>Displays the volume about the obstacle object within which vectors are generated, as an olive-colored wireframe. Default=on. The range starts out the same shape and size as the obstacle object, and is typically enlarged with the Compute Vectors group &gt; Range setting.</td>
</tr>
<tr>
<td>Show Vector Field</td>
<td>Displays vectors, which appear as blue lines emanating outward from lattice intersections within the range volume. Default=off.</td>
</tr>
<tr>
<td>Show Surface Samples</td>
<td>Displays short green lines emanating from sample points on the surface of the obstacle object. Default=off. These appear only after you've computed on page 5267 the vector field. See Sample Resolution on page 5267 for more information.</td>
</tr>
<tr>
<td>VectorScale</td>
<td>Scales the vectors so they're more visible or less obtrusive. Default=1.0.</td>
</tr>
</tbody>
</table>

**NOTE** You can select a Vector Field space warp in the viewport by clicking any of its visible elements except the range representation. If you've turned off display of all four elements, you can still select the space warp by clicking its gizmo, which, when viewed from the "top" (the orthographic viewport in which the warp was created), resembles a pair of crossed double-headed arrows in the shape of an X.

The check boxes in this group let you enable and disable display of four different elements of the Vector Field space warp.

**Show Lattice** Displays the vector field lattice, a yellow wireframe box. Default=on.

The vectors are generated at lattice intersections inside the vector field range.

**Show Range** Displays the volume about the obstacle object within which vectors are generated, as an olive-colored wireframe. Default=on.

The range starts out the same shape and size as the obstacle object, and is typically enlarged with the Compute Vectors group > Range setting.

**Show Vector Field** Displays vectors, which appear as blue lines emanating outward from lattice intersections within the range volume. Default=off.

**Show Surface Samples** Displays short green lines emanating from sample points on the surface of the obstacle object. Default=off. These appear only after you've computed on page 5267 the vector field. See Sample Resolution on page 5267 for more information.

**VectorScale** Scales the vectors so they're more visible or less obtrusive. Default=1.0.

**NOTE** This setting does not affect the strength of the vectors; only their visibility.
**Icon Size** Adjusts the size of the Vector Field space warp icon, a pair of crossed double-headed arrows. Increase the size for easier viewport selection. Default=size originally drawn in viewport.

**Force group**

These parameters determine how the vector field affects objects within its volume.

Changing any of the Force group settings does not require that you recalculate the vector field.

**NOTE** Using a vector field does not guarantee that delegates or particles remain at a particular distance from the obstacle. In some cases you might have to animate the Strength, Falloff, and/or Pull settings to keep delegates within the vector field.

**Strength** Sets the degree of effect the vectors have on the movement of an object entering the vector field. If Show Vector Field on page 5264 is on as you adjust Strength, you can see the vector lines change size in the viewports in real time. Default=1.0.

**NOTE** Sometimes, after changing strength, vectors will be too large or too small. In such cases, adjust the VectorScale on page 5264 parameter so that they display properly.

**Falloff** Determines the rate at which the strength of the vectors falls off with distance from the surface of the object. Default=2.0.

A value of 0 will make all the vectors the same size. A value greater than 0 will make them get smaller as they get farther away from the object surface. A value less then 0 will make them get larger as they get farther away.

**Parallel/Perpendicular** Sets whether the force generated by the vectors works parallel or perpendicular to the vector field. Default=Perpendicular.

Because the vectors are perpendicular to the object surface, and you typically would want delegates to travel parallel to the surface, you would normally use a perpendicular force.
Pull Adjusts objects' position relative to the field. Available only when Perpendicular is chosen. Default=0.0. Range=-1.0 to 1.0. Objects moving perpendicular to a vector field sometimes tend to drift away from it, due to lack of subsampling. The Pull parameter helps to pull objects back. Pull values greater than 0 create a pulling force towards the source of the vector field vector. Values less than 0 pull the force towards the direction in which the vector field's vector is pointing. A value of 0.0 produces a force perfectly perpendicular to the vector field's vector.

Compute Vectors group

Vector Field Object Lets you designate the obstacle object. Click this button, and then select the object around which the vector field is to be generated. Thereafter the object's name appears on the button (which is initially labeled “None”).

NOTE You can only use primitives and unmodified editable mesh objects as obstacles. Also, the object should be fully enclosed in the Vector Field lattice.

Range Determines the volume within which vectors are generated. Default=1.0. The range is represented in viewports as an olive-colored wireframe that starts out the same size and shape as the obstacle object. Increasing the Range setting moves the wireframe away from the obstacle object in the direction of its surface normals.

In crowd simulations, the Range outline is where the delegates start to "see" the obstacle object, and begin to turn to avoid it. If your crowd members are penetrating the obstacle, or even just coming too close to it before turning, increase the Range setting. Also try increasing the Vector Field lattice resolution and/or the Sample Res setting.
**Sample Resolution** Acts as a multiplier of the effective sampling rate used on the obstacle object's surface to calculate vector directions in the field. Default=1.

The basic sampling rate is determined by 3ds Max from the size of the lattice and the size of each polygon.

**Use Flipped Faces** Causes flipped normals to be used during the computation of the vector field. Default=off.

By default, vectors are generated in the same direction as the obstacle object's face normals, so that assuming these face normals point outward, objects move around its exterior in a crowd simulation. However, if you want objects to remain within an object's interior, turn on Use Flipped Faces.

**TIP** If you run a crowd simulation inside an object that is also being viewed from the inside, such as a room, you'll probably want the object's faces to point inward. In that case, use Editable Mesh/Edit Mesh > Surface Properties to flip the normals, and don't turn on Use Flipped Faces.

**Compute** Calculates the vector field. Always recalculate the vector field after changing any parameters except those in the Force group.

**Blend Vectors group**

Use the Blend Vectors parameters to reduce abrupt changes in the angles of neighboring vectors. For example, if you have a wavy surface, you might get wavy vectors very far out from the surface, which could adversely affect the simulation. Use Blend Vectors to correct this condition.

**Start Dist** The distance from the object at which you want to start blending the vectors. Default=0.0.

**Falloff** The falloff of the blend of the surrounding vectors. Default=2.0.
Blend segs X The number of adjacent lattice points to blend on the X-axis. Default=1.

Blend segs Y The number of adjacent lattice points to blend on the Y-axis. Default=1.

Blend segs Z The number of adjacent lattice points to blend on the Z-axis. Default=1.

Blend Click this button to implement the blending.

Motion Synthesis

The Crowd system in character studio can use two different types of motion synthesis, which lets character studio adjust the simulation results dynamically to account for differing conditions. This section deals with the application of motion synthesis to non-bipedal crowds, such as a flock of birds.

For information on using motion synthesis with bipeds, see Biped Crowds on page 5136.

Synthesis Dialog

Select a Crowd object. > Modify panel > Global Clip Controllers rollout > New > Choose a GlobalClip object. > Select the object in the list. > Edit > Synthesis dialog

Open Track View > Global Tracks > Block Control > GlobalClip Properties > Synthesis dialog

The Synthesis dialog is where you set up motion synthesis for non-bipedal crowd members. It uses three panels to split up the workflow. On the Motion Clips panel, you specify the global object from which the motion clips are to be derived; you also set up the motion clips here. Controls on the State panel let you set up states and link clips to states. The Synthesis panel controls let you blend clips and synthesize the motion for some or all crowd members.

Usage of the Synthesis dialog is closely associated with usage of the ClipState dialog. For a procedure that combines both, see To use Motion Synthesis with non-bipedal creatures: on page 5150.

See also:

■ ClipState Dialog on page 5280
Motion Clips Panel

Select a Crowd object. > Modify panel > Global Clip Controllers rollout > New > Choose a GlobalClip object. > Select the object in the list. > Edit > Synthesis dialog > Motion Clips panel

Open Track View > Global Tracks > Block Control > GlobalClip Properties > Synthesis dialog > Motion Clips panel

On the Motion Clips panel, you specify the global object from which the motion clips are to be derived. You also set up the motion clips here.

See also:
- Synthesis Dialog on page 5268
- State Panel on page 5272
- Synthesis Panel on page 5275
**Interface**

**Global Object** Click Global Object and pick the object that contains the animation (all the clips) in the Select Global Objects To Copy dialog.
Global Motion Clips group

List Window  The list of motion clips. The clips that you create appear in this list.

Edit Window  Rename or change the color for the selected motion clip.

From Global Object group

Create State  Create a new state with parameters specific to the motion clip, such as speed, heading, acceleration, and so on. character studio evaluates the motion and orientation of the object and creates a new state with parameters set accordingly.

Remove Local X, Y, Z, Orientation  Turn on any or all of these options to strip out transformation and orientation data from the motion clip.

The idea is to animate the global object with full lateral motion. character studio then creates states based on the actual motion of the global object. After the states are created, the animation is stripped from the object. When delegates linked to clones of the global object come close to the actual motion recorded in the state, then the appropriate state is used to trigger the motion clip.

This technique is used to minimize sliding feet. If you animate a creature with many legs, you should animate lateral motion as well a leg motion. Then you create clips that record and then strip out the lateral motion that you created. When the delegate approaches the speed and direction you created originally on the global object, then the leg motion clip will be activated by the state; leg motion will be accurate relative to speed, preventing sliding feet.

New  Lets you set up a new motion clip. Displays the MotionClip Parameters dialog on page 5278 where you can specify the name and duration of the clip. This selects all active controllers.

Modify  Lets you modify a motion clip's parameters. Highlight the clip to modify, and then click Modify. Displays the MotionClip Parameters dialog on page 5278, where you can specify the name and duration of the clip. Also, if you've changed the animation on the Global Object, you can re-apply it to a clip simply by clicking Modify and then clicking OK to close the dialog. The change will affect all the objects being synthesized.

Copy to Object  The keys from the highlighted motion clip are copied back to the Global Object. Deletes any existing animation keys in that part of the Global Object's animation.
You can use this function in several ways. First, if you've changed the animation on the Global Object, you can restore it from a stored motion clip with Copy To Object. Also, if you've edited the clip in Track View (Global Tracks > Block Control > Global Motion Clip: ...), you can apply it to the Global Object with Copy To Object.

**From Track View group**

**New** Lets you create a motion clip from an animation track in Track View. Specify a track in the Track View Pick dialog on page 5279. The MotionClip Parameters dialog on page 5278 displays upon exiting the Track View Pick dialog.

**Modify** Lets you modify a motion clip in the list by changing the Track View track from which it's derived, as well as the name and duration. Specify a track in the Track View Pick dialog on page 5279. The MotionClip Parameters dialog on page 5278 displays upon exiting the Track View Pick dialog.

**Add Selected** Creates a motion clip from only the selected tracks in Track View.

---

**Delete** Deletes the highlighted clip in the list.

**Load** Loads a motion clip file (.clp). Displays the Load Motion Clip dialog. Use the Save command to create a .clp file.

**Save** Saves a motion clip into a .clp file. Displays the Save Motion Clip dialog.

---

**OK** Accepts changes and closes the dialog.

**State Panel**

Select a Crowd object. > Modify panel > Global Clip Controllers rollout > New > Choose a GlobalClip object. > Select the object in the list. > Edit > Synthesis dialog > State panel

Open Track View > Global Tracks > Block Control > GlobalClip Properties > Synthesis dialog > State panel

Controls on the State panel let you set up states for non-bipedal motion synthesis and link motion clips to states.
See also:

- Synthesis Dialog on page 5268
- Motion Clips Panel on page 5269
- Synthesis Panel on page 5275

Interface
**Synthesis States drop-down list** Displays the current state. Choose a state to modify from the list. You can change the state name by editing the text in the list window.

**New State** Creates a new state and adds it to the list. The default name is “ClipState,” optionally followed by a number. You can change the state name by editing the text in the window.

**Delete State** Deletes the current state. This is undoable.

**Edit Properties** Lets you modify the current state. Displays the ClipState dialog on page 5280 for the current state.

**Clear Properties** Returns the state to the default settings and removes clips from the MotionClips window.

**MotionClips group**

**MotionClips window** Displays motion clips used by the current state. Use Add Clip to associate clips with the state. If you assign more than one clip to a state, character studio picks the clips randomly during synthesis based on their respective weights.

**MotionClip Weight** Determines the chance that a clip will be chosen during synthesis. Range=0 to 1000. Highlight the clip in the list, and then set its weight. A higher weight means that a clip is more likely to be chosen.

**Add Clip** Displays the Select MotionClip dialog. Highlight a clip and click OK to add a clip to the current state.

**Remove Clip** Removes the highlighted clip from the current state.

**Precedence** Sets the precedence for the current state. Range=0 to 1000. If multiple states qualify for activation based on their properties, character studio uses the clip associated with the one with the higher precedence first. If more than one state has the same precedence, then the one with the greater weight is played first.

**Weight** Specifies a weight value for a state. If two states have the same precedence, the state with a greater weight will be given higher priority considered during random selection.
**Animation Start Percent** Specifies where in the clip’s animation you want it to start playing when the state is active.

At the default value of 0, the animation will start once the state is active. If the value is 66, the animation will start playing two-thirds of the way in once the state becomes active. You can also randomize where the animation starts by specifying a Animation Start Deviation value other than 0.

**Animation Start Deviation** You can randomize where the animation starts by specifying a Animation Start Deviation value other than 0. Range=0.0 to 1.0.

**State Active Percent** Specifies the percentage of time the state needs to be valid over its interval in order for it to be selected. Range=0 to 100. Default=50.

**Clip Select Seed** Changes how the random selections occur.

If the value stays the same, you are guaranteed to get the same random selections for that state.

---

**OK** Accepts changes and closes the dialog.

### Synthesis Panel

Select a Crowd object. > Modify panel > Global Clip Controllers rollout > New > Choose a GlobalClip object. > Select the object in the list. > Edit > Synthesis dialog > Synthesis panel

Open Track View > Global Tracks > Block Control > GlobalClip Properties > Synthesis dialog > Synthesis panel

Controls in the Synthesis panel are for adding objects to be synthesized, selecting blend transition points, and performing the synthesis. When you synthesize, different sequences of motion clips are applied to each specified object based on the behavioral motion of its delegate.

**See also:**

- [Synthesis Dialog on page 5268](#)
- [Motion Clips Panel on page 5269](#)
- [State Panel on page 5272](#)
**Interface**

**Master Motion Clips list** Displays the objects to which the synthesized motion will be applied.

You can highlight any of these by clicking them, and select multiple items with Ctrl+click and Shift+click. Highlight all objects with the Select All button.

**New Master Motion Clip** Displays the Select Object To Copy dialog. Use this to specify the objects to which the synthesized motion will be applied.
These objects must all be structurally identical to the Global Object. In effect, they should be clones.

**Remove Animation** Strips the animation from the clones. After making clones of the original animated object, you can strip the animation from the clones. During synthesis, motion is applied based on which state is active.

**Collapse Selected** Collapses motion clips to keys on the highlighted objects. This deletes the Master Motion Clip for that object. You can then edit keys and make changes to the animation manually in the scene.

**Synthesize Selected** Analyzes the motion of the delegates linked to the highlighted objects in the Master Motion Clips list, determines which state definitions fit that motion throughout the animation, and applies the corresponding motion clips.

**Select All** Selects all of the objects in the Master Motion Clips list.

**Synthesize All** Analyzes the motion of the delegates linked to all objects in the Master Motion Clips list, determines which state definitions fit that motion throughout the animation, and applies the corresponding motion clips. A progress bar displays during synthesis. When synthesis is completed, the Synthesis dialog reappears, and you can view the calculated minimum, maximum, and average values of delegate motion for the different state properties in the ClipState dialog. You can use these values to fine-tune the state properties.

**State Select Seed** Sets a seed value for random state selection. During synthesis, it's possible that several states qualify for activation at the same time, in which case one state is chosen at random. The seed is used to modify the random value selected when determining which state to select.

**Synthesis Blend Parameters group**

During synthesis, clips aren't sequenced from end to end; instead, they partially overlap, with key blending or averaging occurring during the overlap intervals. This allows for smooth transitions between clips. During the blending or overlap period, weighting gradually shifts between the “from” and “to” clips, so the former's keys predominate at the beginning of the blend, and the latter's at the end.

You can specify explicitly how blending occurs between clips, or you can let **character studio** calculate blending parameters automatically. To specify blending, use the drop-down lists to choose a pair of clips to blend between,
and then set Blend Start to the frame in the “from” clip at which blending should begin. Alternatively, use Auto Blend or Auto Blend All to have character studio determine the best blend points.

If you use Auto Blend, you can then see the calculated blend start point for each pair of clips by choosing the clips from the drop-down lists.

**From Clip list** Lets you select the starting clip to blend; the clip to blend *from*.

**To Clip list** Lets you select the ending clip to blend; the clip to blend *to*.

**Blend Start** Displays the frame in the From clip at which the transition is to begin, whether the default, calculated, or set manually, and lets you change the start frame.

**Auto Blend** Automatically sets the Blend Start frame for the current From and To clips.

**Auto Blend All** Automatically sets the Blend Start frames for all possible pairs of clips.

**OK** Accepts changes and closes the dialog.

### MotionClip Parameters Dialog

Open Track View. > Global Tracks > Block Control > GlobalClip Properties > Synthesis dialog > Motion Clips panel > Click New (in the From Global Object group). > Motion Clip Parameters dialog

Select a Crowd helper. > Modify panel > Global Clip Controllers rollout > New > Choose a GlobalClip object. > Select the object in the list. > Edit > Synthesis dialog > Motion Clips panel > Click New (in the From Global Object group). > Motion Clip Parameters dialog

When setting up a crowd simulation with non-bipedal characters using motion synthesis, use this dialog, accessed from the Synthesis Dialog on page 5268, to define motion clips from the Global Object's animation.

Enter a clip name, frame range, and color using controls in the MotionClip Parameters dialog. character studio determines which clips to trigger by states that you define on the State panel on page 5272.
Interface

Name Enter a name for the new motion clip.

Start Specifies the first frame of the animation clip from the Global Object.

End Specifies the last frame of the animation clip from the Global Object.

Color Click the color swatch and choose a color in the color picker. This color is used in Track View when displaying the clip.

Track View Pick Dialog

Select a Crowd helper. > Modify panel > Global Clip Controllers rollout > New > Choose a GlobalClip object. > Select the object in the list. > Edit > Synthesis dialog > Motion Clips panel > Track View group > New > Track View Pick dialog

Track View > Global Tracks > Block Control > GlobalClip Properties > Synthesis dialog > Motion Clips panel > Track View group > New > Track View Pick dialog

Open the hierarchy and pick a track to use in the motion clip.
ClipState Dialog

Select a Crowd helper. > Modify panel > Global Clip Controllers rollout > New > Choose GlobalClip object. > Select object in list. > Edit > Synthesis dialog > State panel > New State > Edit Properties > Clip State dialog

Track View > Global Tracks > Block Control > GlobalClip Properties > Synthesis dialog > State panel > New State > Edit Properties > ClipState dialog

In character studio, in crowd animation with non-bipedal motion synthesis, a state is a particular property or set of properties of a delegate's animation; for example, the period during which it is pitched upwards and is decelerating. After determining the delegate's state, the motion synthesis engine chooses a motion clip for animating the object, or character, linked to the delegate; for example, a bird. When preparing a simulation that uses motion synthesis, you use the ClipState dialog to define states and associate states with motion clips.

You can define a state with any combination of these properties: speed, acceleration, pitch, pitch velocity, and heading velocity (plus a script). For
each active property, you can specify a range or a unique value that triggers the clip for its respective state.

When you use a range, be sure to set the Min setting lower than the Max setting. For example, when using a negative range such as –180 to –10, enter the number with the larger absolute value (–180) as the Min setting.

You can see the delegates' actual ranges and average values for all properties after synthesizing on page 5277 the clips.

The dialog has several panels, described in the topics that follow.

**NOTE** The dialog contains more tabs than can fit across its top. To see additional tabs, click the left or right arrow button near the upper-right corner of the dialog.

You can enable and disable each state property individually. For example, you can tell the motion synthesis to consider only speed and pitch when analyzing delegate motion. For each of a state's active properties, you can designate a range of values between which a state can be activated.

Alternatively, you can specify a single, unique motion value to be used when a state is active, such as a speed of 50 units per frame. In addition, you specify the In and Out values of the parameter as it approaches and then passes through that unique value. These values are analogous to the tangents of a curve. For each, you can pick Anything, Decreasing, Increasing, or Constant. For example, an animation of an object that has just landed after flying might have a Unique speed value of 0.0 (the object isn't moving laterally), a decreasing In value (the object decelerated before landing) and a constant Out value (the object remains stationary). Taking off, on the other hand, would have an increasing Out value.

If you don't specify state parameters, the state is a default state. For example, if you want the motion synthesis engine to choose random motion clips for an object, and you don't care about what the speed or pitch is, you create default states, and the synthesis engine will randomly pick which clip is active.

**TIP** When setting up states, it's useful to know the extents of state property values for delegate motion in the scene, such as maximum and minimum speed. To determine these, set up the clips and states you want to use, set the ranges to any values, and then synthesize (see the procedure below). After you synthesize, the different property panels of the ClipState dialog will show the actual ranges and average values of delegate motion. These values are saved with the scene.
NOTE The default name of this dialog is "ClipState" because that's the default name of the first state created on the Synthesis dialog > State panel. It's the dialog invoked by clicking the Edit Properties button. If you rename the state, the dialog assumes the changed name.

Automatic State Creation

character studio can create states automatically if you turn on Create State on the Synthesis dialog > Motion Clips panel. You can use this feature if you created a creature that contains lateral motion as well as looping motion.

If you turn on all the options in the Motion Clips panel > Remove Local group, then character studio creates a state that reflects the actual heading, speed, and acceleration of your creature. When a delegate approaches the heading and speed contained in this state, it triggers the appropriate motion clip. This method prevents sliding feet when animating multi-legged creatures.

See also:

■ Synthesis Dialog on page 5268

Speed Panel

Select a Crowd helper. > Modify panel > Global Clip Controllers rollout > New > Choose GlobalClip object. > Select object in list. > Edit > Synthesis dialog > State panel > New State > Edit Properties > Clip State dialog > Speed Panel

Track View > Global Tracks > Block Control > GlobalClip Properties > Synthesis dialog > State panel > New State > Edit Properties > ClipState dialog > Speed Panel

To have delegate speed considered for motion synthesis, turn on Use Speed, choose Range or Unique, and then make the appropriate settings.

Speed is measured in units per animation frame, where the unit is the current 3ds Max system unit. By default, this is Generic Units.
Use Speed Turn on to have the motion synthesis engine consider delegate velocity in determining whether to use the clip.
**Range** Choose Range to have the motion synthesis engine activate the clip when the delegate's speed falls inside the specified range.

**Range Display** After you synthesize on page 5277 the Master Motion Clips, displays delegates' minimum, average, and maximum speed.

**Min** Set the minimum speed value for the range.

**Max** Set the maximum speed value for the range.

---

**Unique** Choose Unique to have the motion synthesis engine activate the clip when the delegate's speed matches a specific value, optionally with a rising, falling, or constant value before or after the specified value.

**Value** Set a unique speed value.

**In/Out** These radio buttons let you specify the behavior of the parameter before and after the unique value is met. For example, with a flying object, to trigger a landing animation clip you might set the unique value to 0, the In setting to Decreasing, and the Out setting to Constant. This means that the object has slowed down and then stopped, and is now stationary.

- **Anything**  Speed before or after the target value is not relevant.
- **Decreasing** Speed decreases before or after it reaches the target value.
- **Constant** Speed before or after the target value is constant.
- **Increasing** Speed increases before or after it reaches the target value.

**Scale Playback Speed group**

These settings let you scale the rate at which the animation is played depending upon the speed of the delegate. By default, when Scale Animation is off, the object animation will always play at its normal rate. If you turn it on, you can then set a Base Speed, at which the animation should play at its normal rate, plus a percentage to specify how much the animation rate is modified by the actual delegate speed.

**Scale Animation** Scales the clip's animation based on speed.

For example, as a bird increases its velocity, its wings beat more rapidly. Scaling an animation scales the keys of the animation.
**Percentage** Specify how much to alter the playback speed based upon the difference between the delegate's speed and the Base Speed setting.

The formula used is this:

Animation Speed change % = (current speed/Base Speed – 1) x Percentage %

For example, if a delegate is moving 50 percent faster than the base speed, and the Scale Percentage value is 50, then the playback speed is scaled up by 25 percent.

**Base Speed** Specifies the delegate speed at which the animation should be played back at its normal rate.

---

**Acceleration Panel**

Select a Crowd helper. > Modify panel > Global Clip Controllers rollout > New > Choose GlobalClip object. > Select object in list. > Edit > Synthesis dialog > State panel > New State > Edit Properties > Clip State dialog > Acceleration Panel

Track View > Global Tracks > Block Control > GlobalClip Properties > Synthesis dialog > State panel > New State > Edit Properties > ClipState dialog > Acceleration Panel

To have delegate acceleration considered for motion synthesis, turn on Use Acceleration, choose Range or Unique, and then make the appropriate settings.

**Interface**

Acceleration is measured in units per frame per frame, where the unit is the current 3ds Max system unit. That is, the acceleration is determined by the rate at which the speed changes per frame.
Use Acceleration Turn on to have the motion synthesis engine consider delegate acceleration in determining whether to activate the state.
Range Choose Range to have the motion synthesis engine activate the clip when the delegate's acceleration falls inside the specified range.

Range Display After you synthesize on page 5277 the Master Motion Clips, displays delegates' minimum, average, and maximum acceleration.

Min Set a minimum acceleration value for the range.

Max Set a maximum acceleration value for the range.

Unique Choose Unique to have the motion synthesis engine activate the clip when the delegate's acceleration matches a specific value, optionally with a rising, falling, or constant value before or after the specified value.

Value Set a unique acceleration value.

In/Out These radio buttons let you specify the behavior of the parameter before and after the unique value is met.

Anything Acceleration before or after the target value is not relevant.

Decreasing Acceleration decreases before or after it reaches the target value.

Constant Acceleration before or after the target value is constant.

Increasing Acceleration increases before or after it reaches the target value.

Scale Playback Speed group

These settings let you scale the rate at which the animation is played, depending upon the acceleration of the delegate. By default, when Scale Animation is off, the object animation will always play at its normal rate. If you turn it on, you can then set a Base Acceleration, at which the animation should play at its normal rate, plus a percentage to specify how much the animation rate is modified by the actual delegate acceleration.

Scale Animation Scale the clip's animation based on acceleration.

For example, as a bird accelerates, its wings beat more rapidly. Scaling an animation scales the keys of the animation.

Percentage Specify how much to alter the playback speed based upon the difference between the delegate's acceleration and the Base Acceleration setting.
The formula used is this:

Animation Speed change % = (current speed/Base Acceleration – 1) x Percentage %

For example, if a delegate is accelerating 50 percent faster than the base acceleration, and the Scale Percentage value is 50, then the playback speed is scaled up by 25 percent.

**Base Acceleration** Specifies the delegate acceleration at which the animation should be played back at its normal rate.

**Pitch Panel**

Select a Crowd helper. > Modify panel > Global Clip Controllers rollout > New > Choose GlobalClip object. > Select object in list. > Edit > Synthesis dialog > State panel > New State > Edit Properties > Clip State dialog > Pitch Panel

Track View > Global Tracks > Block Control > GlobalClip Properties > Synthesis dialog > State panel > New State > Edit Properties > ClipState dialog > Pitch Panel

To have delegate pitch considered for motion synthesis, turn on Use Pitch, choose Range or Unique, and then make the appropriate settings.

Pitch is determined by the angle in degrees of the delegate about the world X-axis. In world coordinates, the delegate’s pitch is positive when it’s aimed upward, negative when it’s aimed downward, and 0 when it’s aimed parallel to the home grid.
Use Pitch Turn on to have the motion synthesis engine consider delegate pitch in determining whether to activate the state.
Range

Choose Range to have the motion synthesis engine activate the clip when the delegate's pitch falls inside the specified range.

**Range Display** After you synthesize on page 5277 the Master Motion Clips, displays delegates' minimum, average, and maximum pitch.

**Min** Set a minimum pitch for the range.

**Max** Set a maximum pitch for the range.

Unique

Choose Unique to have the motion synthesis engine activate the clip when the delegate's pitch matches a specific value, optionally with a rising, falling, or constant value before or after the specified value.

**Value** Set a unique pitch value.

**In/Out** These radio buttons let you specify the behavior of the parameter before and after the unique value is met.

- **Anything** Pitch before or after the target value is not relevant.
- **Decreasing** Pitch decreases before or after it reaches the target value.
- **Constant** Pitch before or after the target value is constant.
- **Increasing** Pitch increases before or after it reaches the target value.

**Scale Pitch Orientation group**

These settings let you scale the pitch at which the animation is played, depending upon the pitch of the delegate. By default, when Scale Pitch is off, the animated object will pitch normally. If you turn it on, you can then set a Base Pitch at which the animation should play, plus a percentage to specify how much the Base Pitch is modified by the actual delegate pitch. If the Percentage is 100, then only the Base Pitch will be used; anything else will scale between the base pitch and the delegate pitch. This is useful for when birds and other objects elevate, but don't pitch up.

**Scale Animation** Scales the clip's pitch based on delegate pitch.

**Percentage** Specify how much to alter the pitch based upon the difference between the delegate's pitch and the Base Pitch setting.

The formula used is this:
Pitch change % = \((\text{current pitch}/\text{Base Pitch} - 1) \times \text{Percentage} \)%

**Base Pitch** Specifies the delegate pitch at which the animation should be played back at its normal rate.

**Scale Playback Speed group**

These settings let you scale the rate at which the animation is played, depending upon the pitch of the delegate. By default, when Scale Animation is off, the object animation will always play at its normal rate. If you turn it on, you can then set a Base Pitch, at which the animation should play at its normal rate, plus a percentage to specify how much the animation rate is modified by the actual delegate pitch.

**Scale Animation** Scales the clip's animation based on pitch.

**Percentage** Specify how much to alter the playback speed based upon the difference between the delegate's pitch and the Base Pitch setting.

The formula used is this:

Animation Speed change % = \((\text{current speed}/\text{Base Pitch} - 1) \times \text{Percentage} \)%

For example, if a delegate's pitch velocity is 50 percent above its base pitch rate, and the Scale Percentage value is 50, then the playback speed is scaled up by 25 percent.

**Base Pitch** Specifies the delegate pitch at which the animation should be played back at its normal rate.

**Pitch Velocity Panel**

Select a Crowd helper. > Modify panel > Global Clip Controllers rollout > New > Choose GlobalClip object. > Select object in list. > Edit > Synthesis dialog > State panel > New State > Edit Properties > Clip State dialog > Pitch Velocity Panel

Track View > Global Tracks > Block Control > GlobalClip Properties > Synthesis dialog > State panel > New State > Edit Properties > ClipState dialog > Pitch Velocity Panel

To have delegate pitch velocity considered for motion synthesis, turn on Use Pitch Velocity, choose Range or Unique, and then make the appropriate settings.
Pitch velocity is determined by the rate of change in degrees per frame of the angle of the delegate about the world X-axis. In other words, pitch velocity measures how fast the delegate is changing its pitch.

**Interface**

The interface shown includes controls for setting the pitch velocity range, with options for minimum, average, and maximum rates. Users can select various input and output behavior options, such as 'Anything', 'Decreasing', 'Constant', and 'Increasing'. Additionally, there is a section for scaling playback speed with options for percentage and base pitch rate.
Use Pitch Velocity Turn on to have the motion synthesis engine consider pitch velocity in determining whether to activate the state.

---

Range The motion synthesis engine activates the clip when the delegate's pitch velocity falls inside the specified range.

Range Display After you synthesize on page 5277 the Master Motion Clips, displays delegates' minimum, average, and maximum pitch velocity.

Min Set a minimum pitch velocity for the range.

Max Set a maximum pitch velocity for the range.

---

Unique Choose Unique to have the motion synthesis engine activate the clip when the delegate's pitch velocity matches a specific value, optionally with a rising, falling, or constant value before or after the specified value.

Value Set a unique pitch velocity value.

In/Out These radio buttons let you specify the behavior of the parameter before and after the unique value is met.

- Anything Pitch velocity before or after the target value is not relevant.
- Decreasing Pitch velocity decreases before or after it reaches the target value.
- Constant Pitch velocity before or after the target value is constant.
- Increasing Pitch velocity increases before or after it reaches the target value.

Scale Playback Speed group

These settings let you scale the rate at which the animation is played, depending upon the pitch velocity of the delegate. By default, when Scale Animation is off, the object animation will always play at its normal rate. If you turn it on, you can then set a Base Pitch Rate, at which the animation should play at its normal rate, plus a percentage to specify how much the animation rate is modified by the actual delegate pitch velocity.

Scale Animation Scales the clip's animation based on pitch velocity.
**Percentage** Specify how much to alter the playback speed based upon the difference between the delegate's pitch velocity and the Base Pitch Rate setting. The formula used is this:

\[
\text{Animation Speed change \%} = (\text{current speed} / \text{Base Pitch Rate} - 1) \times \text{Percentage \%}
\]

For example, if a delegate's pitch velocity is 50 percent above its base heading rate, and the Scale Percentage value is 50, then the playback speed is scaled up by 25 percent.

**Base Pitch Rate** Specifies the delegate pitch velocity at which the animation should be played back at its normal rate.

### Heading Velocity Panel

Select a Crowd helper. > Modify panel > Global Clip Controllers rollout > New > Choose GlobalClip object. > Select object in list. > Edit > Synthesis dialog > State panel > New State > Edit Properties > Clip State dialog > Heading Velocity Panel

Track View > Global Tracks > Block Control > GlobalClip Properties > Synthesis dialog > State panel > New State > Edit Properties > ClipState dialog > Heading Velocity Panel

To have delegate heading velocity considered for motion synthesis, turn on Use Heading Velocity, choose Range or Unique, and then make the appropriate settings.

Heading velocity is determined by the rate of change in degrees per frame of the angle of the delegate about the world Z-axis. In other words, heading velocity measures how fast the delegate is changing its heading.
Interface

Use Heading Velocity: Turn on to have the motion synthesis engine consider heading velocity in determining whether to activate the state.
Choose Range to have the motion synthesis engine activate the clip when the delegate's heading velocity falls inside the specified range.

**Range Display** After you synthesize on page 5277 the Master Motion Clips, displays delegates' minimum, average, and maximum heading velocity.

**Min** Set a minimum heading rate value for the range.

**Max** Set a maximum heading rate value for the range.

---

**Unique** Choose Unique to have the motion synthesis engine activate the clip when the delegate's heading rate matches a specific value, optionally with a rising, falling, or constant value before or after the specified value.

**Value** Set a unique heading rate value.

**In/Out** These radio buttons let you specify the behavior of the parameter before and after the unique value is met.

- **Anything** Heading velocity before or after the target value is not relevant.
- **Decreasing** Heading velocity decreases before or after it reaches the target value.
- **Constant** Heading velocity before or after the target value is constant.
- **Increasing** Heading velocity increases before or after it reaches the target value.

---

**Scale Playback Speed group**

These settings let you scale the rate at which the animation is played, depending upon the heading velocity of the delegate. By default, when Scale Animation is off, the object animation will always play at its normal rate. If you turn it on, you can then set a Base Heading Rate, at which the animation should play at its normal rate, plus a percentage to specify how much the animation rate is modified by the actual delegate heading velocity.

**Scale Animation** Scales the clip's animation based on heading velocity.

**Percentage** Specify how much to alter the playback speed based upon the difference between the delegate's heading velocity and the Base Heading Rate setting.

The formula used is this:
Animation Speed change % = (current speed/Base Heading Rate – 1) x Percentage %

For example, if a delegate's heading velocity is 50 percent above its base heading rate, and the Scale Percentage value is 50, then the playback speed is scaled up by 25 percent.

**Base Heading Rate** Specifies the delegate heading velocity at which the animation should be played back at its normal rate.

### Script Panel

Select a Crowd helper. > Modify panel > Global Clip Controllers rollout > New > Choose GlobalClip object. > Select object in list. > Edit > Synthesis dialog > State panel > New State > Edit Properties > Clip State dialog > Script Panel

Track View > Global Tracks > Block Control > GlobalClip Properties > Synthesis dialog > State panel > New State > Edit Properties > ClipState dialog > Script Panel

The script state option lets you create a MAXScript script that takes two parameters: node and time. The script typically tests one or more values, and then returns 1 if the condition (the result of the test) is true or 0 if it's false. This result determines whether or not the state is to be activated.

Scripts used by the clip controller are similar to those used by the cognitive controller on page 5199, with the exception that a special time-related statement is required.

In the following sample script, "del" is the delegate's node, and "t" is the time. The name of the scripted function, "stoppedScript," would also need to be entered into the name field in the Script panel of the ClipState dialog. Unlike cognitive controller scripts, the statement "at time t" needs to be invoked because the animation is not running when the synthesis takes place.

```plaintext
fn stoppedScript del t = (
    at time t
    if del.pos.z < 65 then 1 else 0
)
```
### Use Script

Turn this on to use a MAXScript script to control a clip.

**Script**
Enter the name of the function defined by the script, also found at the start of the script.
character studio File Formats and Index of character studio Procedures

There are two topics in this section: a summary of the file formats used by character studio, and an index to the procedures in the character studio, topics.

character studio File Formats

character studio uses several proprietary file formats for various functions.

BIP Motion file. Includes biped motion and the size of the original biped so motion can be accurately loaded to other bipeds. Can be loaded directly onto a biped, or used to combine motions with Motion Flow or the Motion Mixer. See Loading and Saving BIP Animation on page 4638.

FIG Figure file. Contains the sizes and poses of each biped body part, and overall biped size. Use this file to save and load a biped pose in Figure mode. See Saving and Loading FIG Files on page 4513.

CPY Copy file. Contains postures, poses and tracks you have copied with the Copy/Paste rollout. See Copying and Pasting Postures and Poses on page 4619 and Copying and Pasting Tracks on page 4649.

MFE Motion Flow Graph file. Contains the motion flow graph, and a motion flow script if one was present for the biped upon saving. See Saving, Loading, and Appending Motion Flow Graphs on page 4861.

MIX Motion Mixer file. Contains clip data, tracks and trackgroups, transitions between clips, track/clip weights, and scale, trim and time warp information for edited clips. See Exporting Animation to the Biped on page 4043.

PHY Physique file. Contains information on envelope sizes and vertex weights set up with the Physique modifier. See Saving and Loading Physique Data on page 4997.

STP Step file. Contains footstep data. See Loading and Saving STP Files on page 4646.
BVH, CSM, MNM These file formats contain motion-capture data. They are not specific to character studio. See BVH File on page 8530, CSM File on page 8543, or MNM File on page 8640 in the glossary.

Index of character studio Procedures

These procedures appear elsewhere in this User Reference, in their associated topics. Here, they are organized by feature.

Biped and Physique

Creating a Biped

To delete a biped: on page 4511
To create a biped on a surface: on page 4492
To change the biped name upon creation: on page 4495
To change the biped name after creation: on page 4495
To create a Named Selection for the biped center of mass: on page 4495

Loading and Viewing Motion

To save animation you have created or imported to a BIP file: on page 4639
To load biped motion from an existing BIP file: on page 4639
To preview biped motion using biped playback stick figure: on page 4655
To preview biped motion using the full biped model: on page 4655

Animating the Biped with Freeform

To use pivots: on page 4614
To make a hand or foot follow an object: on page 4616
To anchor a hand or foot: on page 4617

Animating the Biped with Footsteps

To create footsteps automatically: on page 4526
To create multiple footsteps: on page 4775
To create footsteps beginning at the current frame: on page 4529
To make the biped walk up or down stairs: on page 4782
To make the biped walk in place: on page 4782
To make the biped walk backward: on page 4782
To prepare for manual footstep creation: on page 4529
To create footsteps manually, beginning at the current frame: on page 4775
To append footsteps onto the existing footsteps: on page 4776
To create footsteps using AutoGrid: on page 4530
To make the biped speed up as it walks: on page 4782
To activate footsteps: on page 4532
To deactivate footsteps: on page 4534

Editing Footsteps

To save footstep data: on page 4646
To move selected footsteps in time: on page 4541
To change the duration of a footstep: on page 4541
To scale keys in time: on page 4542
To prevent keys from changing when active footsteps are edited: on page 4544
To turn off Scale Stride mode: on page 4641
To display footstep tracks: on page 4578
To display footstep keys in Track View: on page 4541
To change the display of numbers of footstep keys: on page 4542
To convert an airborne period to freeform mode: on page 4566
To convert between footsteps and freeform animation: on page 4571
To create a purely freeform animation: on page 4574
To create a freeform animation from a footstep animation: on page 4575
To save footstep data: on page 4646
To copy footsteps to the buffer: on page 4544
To edit the footstep buffer: on page 4545
To splice the footstep buffer: on page 4545

Editing Biped Keys

To use In Place mode to adjust keyframes: on page 4657
To set the balance factor: on page 4555
To set ballistic tension: on page 4562
To set the IK Blend value of a key: on page 4601
To locate vertical center of mass keys: on page 4562
To set a Body Vertical key: on page 4562
To change TCB for a biped arm: on page 4587
To select and rotate multiple links: on page 4589
To rotate all links in the spine, neck, or tail: on page 4589
To change Dynamics Blend for multiple Body Vertical keys: on page 4563
To bend a biped trajectory: on page 4630
To edit keys on the Center of Mass trajectory: on page 4630
To edit biped trajectory keys in a viewport: on page 4659
To use In Place mode to adjust keyframes: on page 4657

Motion-Capture Data

To import a motion-capture file: on page 4928
To import a marker file: on page 4921
To use Fit To Existing to import a motion-capture file: on page 4935
To use Convert From Buffer: on page 4927
To compare raw and filtered trajectories: on page 4928
To use Show Buffer: on page 4928

Motion Flow

To create clips in the Motion Flow Graph: on page 4851
To create multiple clips in the Motion Flow Graph: on page 4852
To create transitions using From > To or To < From method: on page 4854
To create transitions using Create All Transitions: on page 4855
To optimize transitions in the Motion Flow Graph: on page 4856
To create a Motion Flow script: on page 4859
To save Motion Flow Editor files: on page 4861
To load Motion Flow Editor files: on page 4863
To append Motion Flow Editor files: on page 4864
To manually customize transitions between two clips: on page 4866
To automatically customize transitions between two clips: on page 4867
To create a random script for one biped: on page 4871
To customize transition “weighting” and setting a start clip: on page 4869
Example: To create a unified motion: on page 4874
Example: To share a random motion flow among multiple bipeds: on page 4877
To apply a shared motion flow to a different group of bipeds: on page 4882
To load a Motion Flow scene from another system: on page 4884

Posing the Biped

To link a mechanical character to the biped (without Physique): on page 4513
To fit biped legs to the skin: on page 4503
To fit the spine to the skin torso: on page 4503
To fit both arms using copy/paste: on page 4504
To pose both arms simultaneously: on page 4504
To create a symmetrical pose by copying one side of the biped to the other: on page 4505
To copy a posture: on page 4623
To paste the posture: on page 4623
To copy a track from one biped to another: on page 4650
To copy the entire pose of a biped: on page 4624
To attach a mesh to a bones hierarchy using Physique: on page 5014
Applying Physique

To attach a mesh to a biped using Physique: on page 5014
To adjust default envelope shape: on page 4976
To adjust envelopes around the biped's pelvis: on page 4977
To add a bone after you've already used Attach To Node: on page 5015
To troubleshoot bulges and tendons: on page 5018
To select and edit cross sections: on page 4978
To copy an envelope and its settings to a mirrored link (for example, from one thigh to the other): on page 4979
To copy all Bulge angles from one link to its opposite: on page 5083
To use Select Nearest Bulge Angle: on page 5084
To remove a link's influence on vertices: on page 5097
To check vertex assignments: on page 5097
To remove deformable vertices from a link's influence: on page 5097
To override vertex assignments manually: on page 5098
To make vertices rigid: on page 5099
To have a spline influence a mesh: on page 5021
To apply Physique to an FFD to animate the entire mesh: on page 5011
To use an FFD to complement the effects of Physique on a portion of a character mesh: on page 5012
To make compressible bones (bones with end effectors): on page 4961
To add a bone after Physique is applied using Reinitialize: on page 4961
To add a bone after Physique is applied using Add (Add Bone): on page 4962
To optimize skin objects: on page 5002
To reinitialize a scaled mesh: on page 5003

Bulges

To create a new bulge angle using the Bulge Editor: on page 5030
To create a new bulge angle on a selected link: on page 5082
To add a cross section: on page 5032
To change the shape of a cross section: on page 5034
To make a cross section the active cross section: on page 5032
To choose a specific bulge angle for editing: on page 5031
To change a bulge angle value: on page 5031
To select multiple cross sections: on page 5033
To move cross sections along the link: on page 5033
To copy and paste cross sections: on page 5033
To change the Profile view orientation: on page 5034
To delete a bulge angle: on page 5031
To delete a cross section: on page 5032

Links and Tendons

To adjust joint intersection parameters: on page 5078
To create and attach a tendon: on page 4996
To attach a tendon to another link: on page 4997
To delete a tendon: on page 4997

Saving and Reusing Physique Information

To save Physique data: on page 5016
To load Physique data: on page 5016
To merge a skinned biped: on page 4642
To clone a skinned biped: on page 4645

Figure Mode

To work in Figure mode: on page 4502
To adjust the biped center of mass with Rubber Band: on page 4509
To rubber band an arm or leg link: on page 4509
To Scale a Biped and a Physique Mesh: on page 4762
To save a biped's figure information to a file: on page 4514
To load a biped figure: on page 4515

Layers

To increment all keys using layers (global offset): on page 4627
To increment an interval of keys with an envelope (blended offset): on page 4627
To increment an interval of keys without an envelope (nonblended offset): on page 4628
To use layers to reposition a biped with freeform animation: on page 4653

Props

Example: To animate a biped swinging a prop with one hand: on page 4597
Example: To animate the biped switching the prop to the other hand: on page 4597
To collapse the transforms of a prop: on page 4598

Controllers and Biped

To add a controller to a biped object: on page 4591
To collapse a controller: on page 4592
To add controllers to multiple biped parts at the same time: on page 4592
To animate the weights of an added controller: on page 4593

Miscellaneous

To load a file created with different system units: on page 5000
To hide the finger, toe, and head dummy objects: on page 4644
To change biped display: on page 4510
To select from the screen: on page 4577
To reposition a freeform animation (with no IK attachment) or a footstep animation: on page 4651
To reposition a biped with limbs attached to an Object Space object (IK attachment): on page 4652
To reposition a biped with limbs attached to world space (IK attachment): on page 4652
To reposition a biped animated with a motion flow script: on page 4653
To scale a biped that has a mesh attached to it by using Physique: on page 5003
Facial Animation on page 5003
To isolate lip vertices from influence by inappropriate links: on page 5010

Crowd System

Crowd and Delegate Helpers

To create a Crowd helper object: on page 5113
To create a Delegate helper object: on page 5113
To clone and scatter delegates: on page 5113
To link objects to delegates: on page 5131
To associate bipeds with delegates: on page 5132
To edit multiple delegates: on page 5182
To group delegates into a team: on page 5188

Behaviors

To create a new behavior assignment: on page 5189
To use assign behaviors to delegates: on page 519
To modify an existing behavior assignment or assignments: on page 5190
To use the Avoid behavior: on page 5124
To use the Orientation behavior: on page 5128
To use the Path Follow behavior: on page 5122
To use the Repel behavior: on page 5125
To use the Seek behavior: on page 5121
To add a Vector Field space warp: on page 5126
To use a Vector Field space warp with delegates: on page 5126
To use the Speed Vary behavior: on page 5129
To use the **Surface Arrive behavior**: on page 5122
To use the **Surface Follow behavior**: on page 5122
To use the **Wall Repel behavior**: on page 5125
To use the **Wall Seek behavior**: on page 5121
To use the **Wander behavior**: on page 5242

**Solving a Crowd Simulation**

To solve a simulation: on page 5129
To speed up the solution time: on page 5130
To troubleshoot the simulation: on page 5130

**Cognitive Controllers**

To set up and use a cognitive controller: on page 5133
Testing a Modifier Parameter
Testing a **Particle System Parameter** on page 5204
Testing an **Atmospheric Property** on page 5204
Testing an Object Position
Testing Another Delegate’s Behavior on page 5205
Testing the Distance Between Two Objects

**Motion Synthesis**

To use **Motion Synthesis with non-bipedal creatures**: on page 5150
Procedures: Using Bipeds in a Crowd Simulation on page 5142

**Motion Mixer**

**General**

To access the Motion Mixer from the Motion panel: on page 4006
To display the Motion Mixer in a viewport: on page 4007
To remove the Motion Mixer from a viewport: on page 4007
To add a biped to the Motion Mixer: on page 4011
To add a non-biped object to the Motion Mixer: on page 4011
To see the motions in the Motion Mixer on the biped in the scene: on page 4015

Loading Clips
To import BIP clips from a file: on page 4014
To import clips from the Reservoir: on page 4014
To import clips from a motion flow script: on page 4015
To replace one clip with another: on page 4017
To replace a clip with motion from a biped in the scene: on page 4017
To clone a clip: on page 4017

Clip Timing
To move a clip in time within a track: on page 4016
To move all clips horizontally on one track: on page 4016
To move a clip to another track: on page 4016
To change the length of a clip without changing its speed: on page 4024
To change the speed of an entire clip: on page 4025
To prepare to warp a clip's time: on page 4035
To warp a clip's time: on page 4036
To add multiple time warps to a clip: on page 4038

Trackgroups
To add a new trackgroup for the biped: on page 4020
To filter and name a trackgroup: on page 4021
To convert a clip track from one type to another: on page 4010
To add a Transition or Layer track to a trackgroup: on page 4009

Transitions
To create a transition between two clips: on page 4030
To change the focus on a foot-based transition with Biped animation: on page 4031
To adjust a weight curve: on page 4033

Biped Balance
To adjust balance using the balance track: on page 4040
To fine-tune balance compensation on the pelvis and spine: on page 4042

Saving Mixer Data
To perform a mixdown and copy it to the biped: on page 4045
To save Motion Mixer data to a MIX file: on page 4046

Reservoir
To access the Reservoir: on page 4049
To add clips to the Reservoir: on page 4049
To replace a clip in the Reservoir: on page 4050
To save an instanced clip to a new clip: on page 4050
To save multiple instanced clips from the Reservoir: on page 4051
To remove clips not used in the Motion Mixer from the Reservoir: on page 4051

Workbench
General
To display a biped body part curve in the Workbench, do one of the following: on page 4829
To hide or unhide the Tab panel: on page 4830

Workbench Panels
To analyze a curve: on page 4833
To fix an individual error: on page 4838
To fix multiple errors: on page 4839
To remove keys from curves automatically: on page 4839
To filter a track: on page 4843
Lights and Cameras

Lights and cameras are scene objects that simulate their real-world counterparts.

“Little Village Far, Far Away”
Copyright © 2000 Eni Oken

Lights provide illumination for the geometry of a scene: they can light the scene from “offstage,” or, with a little extra work, they can appear within the scene itself. Standard lights are simple and easy to use. Photometric lights are more complex, but provide a physically accurate model of real-world lighting. The Daylight and Sunlight systems create outdoor lighting.
lighting that simulates sunlight based on location and time of day, month and year. You can animate the time of day to create shadow studies.

Cameras frame the scene, providing a controllable point of view. You can animate camera movement. Cameras can simulate some aspects of real-world photography, such as depth-of-field and motion blur.

**Lights**

Create panel > Lights

Create menu > Lights

Lights are objects that simulate real lights such as household or office lamps, the light instruments used in stage and film work, and the sun itself. Different kinds of light objects cast light in different ways, emulating different kinds of real-world light sources.
When there are no lights in a scene, the scene is shaded or rendered with default lighting. You add lights to give the scene a more realistic appearance. Lighting enhances the clarity and three-dimensionality of a scene. In addition to general lighting effects, lights can be used to project images. (See Advanced Effects Rollout on page 5457.)

Light objects replace the default lighting. As soon as you create a light, the default lighting is turned off. If you delete all the lights in the scene, default lighting is turned back on. The default lighting consists of two invisible lights: one is above and to the left of the scene, and the other is below and to the right.

**TIP** One way to begin your work on lighting a scene is to convert the default lighting into light objects by using the command Add Default Lights To Scene on page 152.

**NOTE** A scene's lighting is also affected by the Ambient Light setting on the Environment And Effects dialog > Environment panel on page 7163.

### Types of Lights

3ds Max provides two types of lights: photometric and standard. All types are displayed in viewports as light objects. They share many of the same parameters, including shadow generators.

#### Photometric Lights

Photometric lights on page 5348 use photometric (light energy) values that enable you to more accurately define lights as they would be in the real world. You can set their distribution, intensity, color temperature, and other characteristics of real-world lights. You can also import specific photometric files available from lighting manufacturers to design lighting based on commercially available lights.

**TIP** For the most physically accurate, photorealistic lighting, use Photometric lights and the mental ray renderer on page 6675. When you render with mental ray, use Final Gather on page 6760 and the mental ray Photographic exposure control on page 7219. With this setup, you also can do lighting analysis of your model.

#### Standard Lights

Standard lights on page 5398 are computer-based objects that simulate lights such as household or office lamps, the light instruments used in stage and film work, and the sun itself. Different kinds of light objects cast light in
different ways, simulating different kinds of light sources. Unlike photometric lights, Standard lights do not have physically-based intensity values.

A nighttime scene that uses standard lights for atmosphere rather than realism

**Tips**

- You can animate not only the location of a light, but also its color, intensity and some other creation parameters. See *Animating Lights* on page 5339.

- You can use the *Place Highlight* on page 976 command to change a light's position. See the Procedures in *Working with Lights* on page 5319.

- A *Light viewport* on page 8165 can be a useful way to adjust lights other than omni lights.

- To simulate sunlight, use a *daylight or sunlight system* on page 5491, which allows you to set the date, time, and geographic location of your model. The daylight system is photometric, while the sunlight system uses a standard directional light.

**NOTE** The standard *Skylight* on page 5412 light is distinct from the photometric daylight lights. The Skylight light is for use with *light tracing* on page 6601.
Name and Color Rollout (Lights)

Create panel > Lights > Create a light. > Name and Color rollout
Create menu > Photometric Lights > Create a light. > Modify panel > Name
and Color rollout
Create a light. > Modify panel > Name and Color rollout

The Name And Color rollout lets you change the name and geometry color
of a light. Changing the color of the light geometry can be useful when
working with many lights. For example, in a scene with many different types
of lights, you could make all spotlights red, and all omni lights blue to easily
distinguish them.

Changing a light's geometry color has no effect on the color of the light itself.
You can set the color the light emits on its Intensity/Color/Attenuation rollout
on page 5379 for photometric lights, or the Intensity/Color/Attenuation rollout
on page 5431 for standard lights.

Procedures

To change the color of a light’s geometry:

1. Create or select a light in your scene.
2. In the Name and Color rollout, click the color swatch to open a Color
   Selector on page 371.
3. Choose a new color and click OK.

To change the name of a light:

1. Create or select a light in your scene.
2. In the Name and Color rollout, click the name field and enter the new
   name, then press the Enter key.
   The light's name has changed.

Interface

![Image of Name and Color Rollout]
Name  The name of the selected light.

**NOTE** When you rename a target-type light, the target object will be renamed to match the light.

Color  The color of the light’s geometry. This has no effect on the color the light emits.

---

**Using Lights**

These topics provide a general introduction to using lights in 3ds Max.

In general, these are the reasons to use light objects:

- To improve the illumination of a scene.
  The default illumination in viewports might not be bright enough, or it might not illuminate all faces of a complicated object.

- To enhance a scene’s realism through realistic lighting effects.
  *Guidelines for Lighting* on page 5330 has suggestions about making lighting appear realistic.

- To enhance a scene’s realism by having lights cast shadows.
  All kinds of lights can cast shadows. Also, you can selectively control whether an object casts or receives shadows. See *Shadow Parameters* on page 5448.

- To cast projections in a scene.
  All kinds of lights can project still or animated maps. See the Projector Map group in the Advanced Effects rollout on page 5457.

- To help model a source of illumination in the scene, such as a flashlight.
  Light objects don’t render, so to model a source of illumination, you also need to create geometry that corresponds to the light source. Use a self-illuminating on page 8714 material to make the geometry appear as if it’s emitting light.

- To create lighting scenes using manufacturers’ IES on page 5376, CIBSE on page 8532, or LTLI on page 8625 files.
  You can visualize commercially available lighting in your model by creating photometric lights on page 5348 based on manufacturer’s photometric data files. By experimenting with different fixtures, and varying the light intensity and color temperature, you can design a lighting system that
produces the results you want. See Photometric Lights: Web Distribution on page 5371.

## Working with Lights

The procedures in this topic apply to both standard and photometric lights. Here are some general tips about working with lights:

- You can add lights using the Substitute modifier on page 1759 to replace AutoCAD blocks with 3ds Max light objects or luminaires on page 271.

- One simple way to light a scene is to convert the default lighting into light objects by using the command Add Default Lights To Scene on page 152.

  **NOTE** Add Default Lights To Scene works only if you have used the Viewport Configuration dialog on page 8374 to have the scene use two default lights.

- You can turn the display of light objects on and off with an option in the Display panel on page 8217. See the “Procedures” section, below.

- You can change the renderability of lights in your scene using the Renderable option on the General panel on page 283 of the Object Properties dialog.

- You can change the renderability of a group of lights in your scene using the Layer Manager on page 7956.

  **NOTE** In order to be turned on/off through the Layer Manager, lights must have their Render Options set to ByLayer in the General panel on page 283 of the Object Properties dialog.

  **TIP** To automatically set new lights as renderable ByLayer, turn on New Lights Renderable By Layer on the General panel on page 8299 of the Preferences dialog.

- You can use the Place Highlight on page 976 button to change a light’s position. See the “Procedures” section, below.

- A Light viewport on page 8165 can be a useful way to adjust spotlights in your scene.
Procedures

To create a light:

1. On the Create panel, click Lights.

2. Choose Standard or Photometric from the drop-down list. Standard is the default.

3. In the Object Type rollout, click the type of light you want to create.

4. Click a viewport to create the light. This step varies slightly depending on the type of light. For example, if the light has a target, you drag and click to set the target’s location.

Light objects replace the default lighting. As soon as you create a light, the default lighting is turned off. If you delete all lights in the scene, the default lighting is restored.

5. Set the creation parameters.

   Like all objects, lights have a name, a color, and a General Parameters rollout.

To create shadows, do one of the following:

1. In the General Parameters rollout, make sure On is checked in the Shadows group. Adjust shadow parameters in the Shadow Parameters rollout and the additional (Shadow Map on page 5486, Advanced Ray-traced on page 5468, Area Shadows, on page 5472 or Ray Traced Shadows on page 5484) shadow rollouts.

2. Right-click the light, and turn on Cast Shadows in the Tools 1 (upper-left) quadrant of the quad menu.

   Turning on Cast Shadows also turns on the On toggle in the Shadows group of the General Parameters rollout, and vice versa.

   Shadows are visible only when rendered, either in a full rendering on page 6505, in a viewport on page 5335, or with ActiveShade on page 6550.

   **TIP** To turn shadows on or off for multiple lights, select the lights and then use the Light Lister on page 5343.

   You can set an object to not cast or not receive shadows. By default, objects do both. See Object Properties on page 283.
To control the display of light objects:

- On the Display panel, on the Hide By Category rollout, turn on Lights.
  All light objects in the scene disappear, but the lighting itself is unchanged.
  Light objects can cast light whether or not their display is turned off. The
  Zoom Extents commands are affected by whether light icons are displayed
  or not. When lights are displayed, Zoom Extents on page 8144 and Zoom
  Extents All on page 8138 includes the lights in the zoom.

  **TIP** To control whether a light casts light in the scene, you can use its On
  toggle, or you can toggle its Renderable property on the light's Object
  Properties dialog on page 283.

To change a light's parameters:

1. Select the light.

   **TIP** Lights can be hard to select by clicking. Use the keyboard shortcut H to
   select the light by name.

2. Open the Modify panel.

3. Change the light's parameters in the General Parameters rollout and other
   rollouts available for that light.

To position a light so it highlights a face:

1. Make sure the viewport you plan to render is active, and that the object
   you want to highlight is visible in it.
   The result of Place Highlight depends on what is visible in the viewport.

2. Select a light object.

3. On the Main toolbar, choose Place Highlight from the Align flyout on page 966.
   You can also choose Tools menu > Place Highlight.

4. Drag over the object to place the highlight.
When you place an omni light on page 5410, free direct light on page 5407, or a photometric Free Light on page 5354, 3ds Max displays a face normal for the face the mouse indicates.

When you place a target direct light on page 5405 or photometric Target Light on page 5351, 3ds Max displays the light's target and the base of its cone.

5 Release the mouse when the normal or target display indicates the face you want to highlight.

The light now has a new position and orientation. You can see the highlight illumination in shaded viewports that show the face you chose, and when you render those views.

Place Highlight on page 976 works with any kind of selected object. You can also use Place Highlight with a selection set of multiple objects. All objects maintain their initial distance from the face.

NOTE For materials, highlight rendering depends on the material's specular properties and the type of rendering you use.

Properties of Light

This topic describes light in the real world. When you light a scene, it can be helpful to know how light naturally behaves.

When light rays strike a surface, the surface reflects them, or at least some of them, enabling us to see the surface. The appearance of a surface depends on the light that strikes it combined with the properties of the surface material, such as color, smoothness, and opacity.

Materials on page 5620 let you specify the visual properties of surfaces.

Intensity

The intensity of light at its point of origin affects how brightly the light illuminates an object. A dim light cast on a brightly colored object shows only dim colors.
Left: A room lit by candles, which are a low-intensity source.
Right: The same room lit by a higher-intensity light bulb.

**Angle of Incidence**

The more a surface inclines away from a light source, the less light it receives and the darker it appears. The angle of the surface normal relative to the light source is known as the *angle of incidence*.

When the angle of incidence is 0 degrees (that is, the light source strikes the surface perpendicularly), the surface is illuminated with the full intensity of the light source. As the angle of incidence increases, the intensity of illumination decreases.
Angle of incidence affects intensity.

Attenuation

In the real world, light diminishes over distance. Objects far from the light source appear darker; objects near the source appear brighter. This effect is known as attenuation.

In nature, light attenuates at an inverse square rate. That is, its intensity diminishes in proportion to the square of the distance from the light source. It is common for attenuation to be even greater when light is dispersed by the atmosphere, especially when there are dust particles in the atmosphere, or fog or clouds.
A. Inverse decay
B. Inverse square decay
The graphs show the decay curves.

Reflected Light and Ambient Light

The light an object reflects can illuminate other objects. The more light a surface reflects, the more light it contributes to illuminating other objects in its environment.

Reflected light creates ambient light. Ambient light has a uniform intensity and is uniformly diffuse. It has no discernible source and no discernible direction.
A. Direct light
B. Reflected light
C. Resulting ambient light

Color and Light

The color of light depends partly on the process that generates the light. For example, a tungsten lamp casts orange-yellow light, a mercury vapor lamp casts cold blue-white light, and sunlight is yellow-white. Light color also depends on the medium the light passes through. For example, clouds in the atmosphere tint daylight blue, and stained glass can tint light a highly saturated color.

Light colors are additive colors; the primary light colors are red, green, and blue (RGB). As multiple colored lights mix together, the total light in the scene gets lighter and eventually turns white.
Additive mixing of colored lights

**Color Temperature**

Color temperature describes a color in terms of degrees Kelvin (K). This is useful for describing the color of light sources and other color values that are close to white. The following table shows color temperatures for some common types of light, with the equivalent hue number (from the HSV color description).

If you use these hue numbers for lights in a scene, set the value to full (255) and then adjust the saturation to meet the needs of your scene. Mentally we tend to correct light color so that objects appear to be lit by white light; usually the effect of color temperature in a scene should be subtle.

<table>
<thead>
<tr>
<th>Light source</th>
<th>Color Temperature</th>
<th>Hue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overcast daylight</td>
<td>6000 K</td>
<td>130</td>
</tr>
<tr>
<td>Noontime sunlight</td>
<td>5000 K</td>
<td>58</td>
</tr>
<tr>
<td>White fluorescent</td>
<td>4000 K</td>
<td>27</td>
</tr>
</tbody>
</table>
### Lighting in 3ds Max

Lighting in 3ds Max simulates natural lighting. However, standard lights are simpler than natural lighting. Using photometric lights on page 5348 with a radiosity solution on page 6615 with your lights provides a better model of the real world.

#### Intensity

The intensity of a standard light is its HSV Value. At full value (255), the light is at its brightest; at 0, the light is completely dark.

**NOTE** See Designing Materials on page 5620 for more information about material color and how it interacts with light intensity.

The intensity of a photometric light is set by a real-world intensity value, measured in either lumens, candelas, or lux. See Intensity/Color/Attenuation Rollout (Photometric Lights) on page 5379.

#### Angle of Incidence

3ds Max uses a vector from the light object to the face, along with the face normal, to calculate the angle of incidence.

A surface is fully illuminated when the angle of incidence is 0 degrees (that is, the light source strikes the surface perpendicularly). If the angle of incidence

<table>
<thead>
<tr>
<th>Light source</th>
<th>Color Temperature</th>
<th>Hue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tungsten/halogen lamp</td>
<td>3300 K</td>
<td>20</td>
</tr>
<tr>
<td>Incandescent lamp (100 to 200 W)</td>
<td>2900 K</td>
<td>16</td>
</tr>
<tr>
<td>Incandescent lamp (25 W)</td>
<td>2500 K</td>
<td>12</td>
</tr>
<tr>
<td>Sunlight at sunset or sunrise</td>
<td>2000 K</td>
<td>7</td>
</tr>
<tr>
<td>Candle flame</td>
<td>1750 K</td>
<td>5</td>
</tr>
</tbody>
</table>
increases, attenuation is in effect, or if the light has a color, the surface intensity can be reduced.

In other words, the position and orientation of the light, relative to the object, are what control the angle of incidence in a scene. The Place Highlight command on page 976 is one way to fine-tune the location of a light.

**Attenuation**

For standard lights, attenuation on page 8513 is turned off by default. To shade or render a scene with attenuation, you turn it on for one or more lights. All types of standard lights support attenuation. You can set explicitly where attenuation begins and where it ends. This is partly so you don’t have to worry about setting up strictly realistic distances between light objects and the objects they illuminate. More importantly, this feature lets you fine-tune the effect of attenuation.

In outdoor scenes, attenuation can enhance the effect of distance. (Another way to model environmental effects is to use the atmospheric settings when you render. See Environment and Atmosphere Effects on page 7162.) In an indoor setting, attenuation is useful for low-intensity light sources such as candles.

Photometric lights always attenuate, using an inverse-square falloff, as in nature. (In the case of the IES Sun Light, its great intensity makes its attenuation hardly apparent.)

**Reflected Light and Ambient Light**

Rendering with the default renderer and standard lights does not calculate the effect of lights reflected from objects in the scene. Because of this, lighting a scene with standard lights often requires you to add more light objects than would be needed in real life. You can, however, use radiosity on page 6615 to show the results of reflected light.

When you do not use a radiosity solution, you can use the Environment panel on page 7163 to adjust the color and intensity of ambient light. Ambient light affects contrast. The higher the intensity of ambient light, the lower the contrast in the scene. The color of ambient light tints the scene. Sometimes ambient light is bounced light that gets its color from other objects in the scene. Most of the time, however, the color of ambient light should be the complement of the color of the principal light source for the scene.
To better simulate reflected light and variations in it due to the varying reflectivity of objects in the scene, you can add more lights to a scene and set them to exclude the objects you don’t want them to affect. You can also set up lights to affect only the ambient component of surfaces. See General Lighting Parameters on page 5424.

Color

You can set the color of 3ds Max lights. You can use the RGB values for color temperatures as a guide for the principal lighting of a scene; see Properties of Light on page 5322. Be aware, however, that we tend to perceive scenes as always being lit by white light (this is a perceptual phenomenon known as color constancy), so accurately reproducing the color of a light source can make the rendered scene appear to be tinted oddly. Use the light source values as a general guideline only.

Guidelines for Lighting

The guidelines for lighting used by photographers, filmmakers, and stage designers can also help you set up the lighting for scenes in 3ds Max.

Your choice of lighting depends on whether your scene simulates natural or artificial illumination. Naturally lit scenes, such as daylight or moonlight, get their most important illumination from a single light source. Artificially lit scenes, on the other hand, often have multiple light sources of similar intensity.

NOTE If you use standard instead of photometric lights, both kinds of scenes require multiple secondary light sources for effective illumination.

Whether a scene is indoors or outdoors can also affect your choice of material colors. See Designing Materials on page 5620.
Natural Light

Outdoor scene with natural sunlight

At ground level, for practical purposes, sunlight has parallel rays coming from a single direction. The direction and angle vary depending on the time of day, the latitude, and the season.

In clear weather, the color of sunlight is a pale yellow: for example, RGB values of 250, 255, 175 (HSV 45, 80, 255). Cloudy weather can tint sunlight blue, shading into dark gray for stormy weather. Particles in the air can give sunlight an orange or brownish tint. At sunrise and sunset, the color can be more orange or red than yellow.

3ds Max provides several daylight systems to simulate the sun. See Sunlight and Daylight Systems on page 5491. A single daylight system is appropriate as the main light source for sunlit scenes.

When rendering with mental ray, you can gather skylight from a daylight system efficiently into an interior with the mr Sky Portal on page 5537.

Shadows are more distinct the clearer the day is, and can be essential for bringing out the three-dimensionality of a naturally lit scene.

A directional light can also simulate moonlight, which is white but dim compared to the sun.
Artificial light, whether used indoors or outdoors at night, uses multiple lights. The following guidelines are for creating normally lit, easily legible scenes. You don’t have to follow the guidelines, of course, but then you call attention to the lighting itself, rather than to the subject of the scene.

The subject of a scene should be lit by a single bright light, known as the key light. Position the key light in front of the subject and slightly above.

In addition to the key light, position one or more other lights to illuminate the background and the side of the subject. These are known as fill lights. Fill lights are less bright than the key light.

When you use only one fill light, the angle at ground level between it, the subject, and the key light should be approximately 90 degrees.

Key-and-fill lighting emphasizes the subject of a scene. It also emphasizes the three-dimensionality of the scene.

In 3ds Max, a spotlight is usually best for the key light, and either spotlights or omni lights are good for creating the fill lighting. See Target Spot on page 5399, Free Spot on page 5402, and Omni on page 5410. Ambient light can be another element of your fill lighting.
You can also add lights to emphasize secondary subjects in a scene. In stage terminology, these lights are known as *specials*. Special lights are usually brighter than the fill light but less bright than the main key light.

To design using physically based energy values, distributions, and color temperature, you can create *photometric lights* on page 5348.

**Ambient Light**

![Ambient Light](image)

Left: No ambient light  
Middle: Default ambient light  
Right: User-adjusted ambient light

Ambient light in 3ds Max simulates the general illumination from light reflecting off diffuse surfaces. Ambient settings determine the illumination level of surfaces in shadow, or those not receiving direct illumination from light sources. The Ambient level on the Environment dialog establishes the scene’s basic illumination level before any light sources are taken into account, and is the dimmest any portion of the scene can ever become.

Ambient light is most often used for exterior scenes, when the sky’s broad lighting produces an even distribution of reflected light to surfaces not in direct sun. A common technique for deepening the shadows is to tint the ambient light color to be the complement of the scene’s key light.

Unlike the outside, interior scenes typically have numerous lights, and a general ambient light level is not ideal for simulating the diffuse reflection of local light sources. For interiors, it’s common to set the scene’s environment ambient level to black, and use lights that effect ambient only to simulate the regional areas of diffuse reflection.

You set the scene’s ambient light using the Environment And Effects dialog > Environment panel on page 7163. You set a light to affect only ambient illumination with its Advanced Effects rollout on page 5457 > Ambient Only check box.
Positioning Light Objects

Once you have placed lights in your scene, you can use transforms to change a light’s position or orientation.

Transforming Lights

Use transforms on light objects as follows:

Move: Use Move on page 914 to change the position of lights. You can also use it to change the position of light targets.

Rotate: Use Rotate on page 915 to change the orientation of lights.

NOTE You can’t rotate a target light about its local X or Y axes. Instead, use Move to move the light or its target. Rotating the light about its local Z axis can be useful if the light uses a rectangular beam or projects a bitmap.

Rotating a plain omni light or a photometric light with spherical distribution has no effect, as these lights cast light uniformly in all directions. However, rotating an omni light or a spherical light with projection causes the projected image to rotate.

Scale: Scaling Point, Linear, or Area lights has no effect. Using Scale on page 918 with spotlights and directional lights changes the size of their light beam and attenuation ranges. Scaling omni lights changes only the attenuation ranges. Scaling photometric lights changes their attenuation rate.

Light viewports on page 8165 are another convenient way to transform and change parameters of spotlights and directional lights.

TIP When you adjust lights, it can be useful to turn off Adaptive Degradation on page 123. If Adaptive Degradation is on and shaded viewports begin to display in wireframe, you won’t see the result of the changes you make to lights.

Placing Highlights

You use Place Highlight on page 976 to position a light to create a specular highlight at a designated point on an object. Place Highlight is one of the buttons on the Align flyout. Place Highlight moves or rotates the selected
light object to aim it at a face on an object you pick. The light maintains its original distance from the face. Place Highlight works with any kind of selected object. You can also use Place Highlight with a selection set that contains more than one object. All objects maintain their initial distance from the face.

**Previewing Shadows and Other Lighting in Viewports**

You can preview shadows in shaded viewports. To do so, you must be using the Direct3D driver (see Graphics Driver Setup Dialog on page 8313) and your system must have a graphics card that supports the SM (Shader Model) 2.0 or 3.0 standard.

**TIP** You can check whether your system supports interactive shadows by choosing Help menu > Diagnose Video Hardware on page 156.

In Autodesk 3ds Max 2010, with SM3.0 hardware shading, viewports can preview soft-edged shadows as well as hard-edged shadows. They can also preview ambient occlusion on page 5850 and exposure control on page 7207 as well as lighting and shadows. See Lighting and Shadows on page 8392 for more information.

![Shaded viewport with no shadows, no exposure control](image)
Shaded viewport with exposure control and hard-edged shadows

Shaded viewport with exposure control and soft-edged shadows
If the light is a photometric light that uses an area for shadow casting, the viewport preview can show area shadows. Area shadows are not on by default: to enable them, enter the following line in the MAXScript Listener on page 8229:

```maxscript
viewportSSB.AreaShadow = True
```

**NOTE** For area shadows to display, Soft Shadow must be enabled in the Viewport Configuration > Lighting And Shadows panel on page 8392. Soft Shadow requires SM3.0-level hardware shading.

Viewport shadows cast by a light with a disc-shaped area

Viewport display of area shadows is not necessarily accurate. In general, lighting and shadow previews in viewports are a convenience. These settings and the viewport appearance don't necessarily match what will happen when you render.

Shadows don't appear in a viewport if they wouldn't appear in a rendering; for example, if an object is set to not cast or receive shadows, it won't do so in viewports, and if a light is turned off or is not shadow casting, then it has no effect on the viewport display. There is one exception to this: viewport
shadows don’t check a light’s Exclude/Include list, and so excluded objects can cast shadows in viewports.

Hardware-shaded viewport with shadows but no Ambient Occlusion

Hardware-shaded viewport with shadows and Ambient Occlusion
With AO, shadows appear denser and more realistic.

Procedures

To set up viewports for previewing shadows, enable hardware shading by doing one of the following:

- Click or right-click the Shading viewport menu label. From the Shading viewport label menu on page 8130, choose Lighting And Shadows > Enable Hardware Shading (if it is not turned on already).

- In the Viewport Configuration dialog > Lighting And Shadows panel on page 8392 > Illuminate Scene With group, turn on Enable Hardware Shading.
Also on the Lighting And Shadows panel, in the Quality / Hardware Support group, you can choose the hardware shading level: either Good or Best. Good displays shadows using SM2.0, and Best displays shadows using SM3.0.

To view shadows in a viewport:

1. Click or right-click the Shading viewport menu label. From the Shading viewport label menu on page 8130, choose Lighting And Shadows > Enable Shadows to turn it on.
2. Select a light.
3. Right-click a viewport, and on the Tools 1 (upper-left) quadrant of the quad menu on page 8063, choose Cast Shadows to turn on shadows.

To turn on shadows for multiple lights:

1. From the Main menu choose Tools > Light Lister on page 5343.
2. In the Light Lister dialog, turn on the Shadows toggle for each light object you want to cast shadows.
   
   If you have already enabled shadows in a viewport, their display updates immediately.

### Animating Lights

You animate lights by using transforms or changing creation parameters on different keyframes while the Auto Key button on page 8090 is on. During animation, light transforms and parameter values are interpolated between keyframes.

**Moving and Rotating Light Objects**

You can use the following methods to move and rotate light objects.

- Move an omni light on page 5410 when it’s a "practical" light within a scene (a light that appears in the scene itself). Combine the light with a self-illuminating geometric object. If you want to move a target type of light, select both the light and its target to animate them together.

- Move a Photometric Preset light, or a Free or target light when it’s a "practical" light within a scene (a light that appears in the scene itself).
Combine the light with a self-illuminating geometric object. If you want to move a target type of light, select both the light and its target to animate them together.

- Use a **free spotlight** on page 5402 when a spotlight is to move within the scene. Free spotlights are especially intended to be animated along a path, using a **Path constraint** on page 3596. Unlike target spotlights, free spotlights can bank as they travel. Use **target spotlights** on page 5399 when the light position is fixed.
- If you do need to move a target spotlight, link both the light and its target to a **dummy object** on page 2840, then assign the path constraint to the dummy object.
- Use a **LookAt Constraint** on page 3585 to have a spotlight track a moving object. If the spotlight is a target spotlight, its previous target is ignored. If the spotlight is a free spotlight, it effectively becomes a target spotlight, with the looked-at object the target.
- Change the parameters of a **daylight system** on page 5491 or sunlight system to simulate different times of day or year.

### Animating Light Creation Parameters

The following techniques can be used to animate Modify panel parameters for lights.

- To dim or brighten a light over time, animate its Multiplier parameter.
- To dim or brighten a standard light over time, animate its Multiplier value or **Filter Color** parameter.
- To change the color of a light over time, animate its color parameters. Use a **smooth tangent** on page 3420 for color change keys unless you want the color to change abruptly.
- To make a standard light flash on and off, set its Multiplier to 0 in repeated keyframes, and assign a **step tangent** on page 3420 to this parameter.
Light Include/Exclude Tool

By default, the Light Include/Exclude tool is unavailable in the 3ds Max user interface. You can add it as a custom keyboard shortcut, quad or menu item, or toolbar button by using the Customize User Interface dialog on page 8249.

The Light Include/Exclude tool is a modeless dialog that lets you include or exclude objects on a light-by-light basis. When excluded, an object is not illuminated by the selected light and receives no shadows.

This dialog requires at least one light object in your scene. For a selected light, this dialog is a shortcut to the same functionality available on the Exclude/Include dialog on page 5445.

Although light exclusion does not occur in nature, this feature is useful when you need exact control over the lighting in your scene. Sometimes, for example, you'll want to add lights specifically to illuminate a single object but not its surroundings, or you’ll want a light to cast shadows from one object but not from another.

NOTE By default, no objects are excluded for a new light. It’s necessary only to include objects that have previously been excluded.

See also:
■ Lights on page 5314
■ Light Lister on page 5343

Procedures

To exclude an object from receiving light:

1 In the scene, select the object or objects to exclude.
2 Open the Light Incl/Exl dialog.
   See the path annotation, above. To use the Light Include/Exclude tool, you have to create a custom keyboard shortcut, quad or menu item, or toolbar button.
3 In the Geometry group, choose Exclude.
4 Click the Assign To Light button.
5 In the scene, click a light. If the light is hard to locate, use the Pick Object dialog on page 206(keyboard shortcut H) to pick the light.
The object is now excluded from the light. The Objects list at the bottom of the dialog lists the object.

6 Render to see the effect.

**Interface**

![Light Incl/Excl dialog box](image)

**Geometry group**

**Include**, **Exclude** Toggles the state of a selected object to receive light from a particular light object. Default=include.

**Assign to Light** Activates selection so you can choose the light you want to use. You can only choose one light at a time.
**List Light Properties group**

These controls let you view and edit the include/exclude status of objects on a light-by-light basis.

**Current displayed light** Names the currently selected light.

**Choose Light** Activates selection so you can choose another light.

**Clear Light** Empties the Objects list, removing any included or excluded objects assigned to the currently displayed light.

**Include, Exclude** Reverses the state of included or excluded objects to receive light from the currently displayed light.

**Objects** Lists objects selected for inclusion or exclusion by the currently displayed light.

**Help** Provides a quick reminder of procedures.

**Light Lister**

Tools menu > Light Lister

The Light Lister is a modeless dialog that lets you control a number of features for each light. You can also make global settings that affect every light in your scene.

To display information, this dialog requires at least one light object in your scene. For a selected light, this dialog is a shortcut to the same functionality available on the Modify panel > Parameters rollout. Global settings are duplicated on the Environment panel on page 7163.

**NOTE** The Light Lister cannot control more than 150 unique light objects at a time (instances of a light don't count). If there are more than 150 unique lights in your scene, the Lister displays controls for the first 150 it finds, and a warning that you should select fewer lights. Select fewer lights and then use the Selected Lights configuration.

See also:

- Light Include/Exclude Tool on page 5341
Procedures

To use global settings:

1. On the Light Lister dialog, on the Configuration rollout, choose General Settings.
   The General Settings rollout appears.

2. Make changes to the settings. See Interface, below.

To set individual lights:

1. On the Configuration rollout, choose All Lights. The Lights rollout displays settings for all the scene lights (subject to the limit of 150 lights described above). Alternatively, you can select the lights to adjust, and then on the Configuration rollout choose Selected Lights.

   **TIP** If you change the light selection, the Light Lister does not update interactively. Click Refresh to update the list.

2. On the Lights rollout, change the settings for any light on the list. See Interface, below.
   Some changes show up immediately in the viewport.

Interface

Configuration rollout

<table>
<thead>
<tr>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Lights</td>
</tr>
</tbody>
</table>

Chooses which lights and controls to affect, and lets you update light settings.

**All Lights** The Lights rollout shows all lights in the scene (subject to the 150-light restriction, described above).

**Selected Lights** The Lights rollout shows only selected lights.

**General Settings** Displays the General Settings rollout.

**Refresh** Updates the list of lights to use the current light selection (if Selected Lights is active) and current scene settings.

**NOTE** When the Light Lister needs to be updated, the Refresh button is highlighted in yellow.
General Settings rollout

These controls are for general lighting settings.

- **Selected Lights**  When chosen, general settings affect only selected lights.

- **All Lights**  When chosen, general settings affect all lights in the scene (subject to the 150-light restriction, described above).

**On**  When on, affected lights are active in the scene. When off, affected lights go dark in the viewports and renderings.

**Multiplier**  Increases or decreases the light intensity of standard lights. See [General Lighting Parameters](#) on page 5424 for standard lights.

**Color**  By default, the color of all standard lights is white. Click to display the [Color Selector](#) on page 371 and change the light color for affected lights.

**WARNING**  For photometric lights, this changes the filter color, not the color temperature.

**Shadows**  When on, affected lights cast shadows. When off, they don't cast shadows.

**Shadow type drop-down list**  Selects the shadow type for affected lights.

**Map Size**  Sets the size (in pixels squared) of the shadow map used by affected lights.

**Bias**  Setting depends on which shadow type is selected. In general, bias moves the shadow toward or away from the shadow-casting object. For specific effects, see [Shadow Map Parameters](#) on page 5486 and [Ray-Traced Shadow Parameters](#) on page 5484.

**Sm. Range (Sample Range)**  For shadow-mapped shadows, sets the Sample Range value. See [Shadow Map Parameters](#) on page 5486. This value has no effect for ray-traced or area shadows.

**Transp. (Transparency)**  When on, turns on transparency for advanced ray-traced and area shadows. Has no effect on shadow-mapped or standard ray-traced shadows. Default=off.
**Int. (Integrity)** For advanced ray-traced shadows or area shadows, sets the Shadow Integrity. See *Advanced Ray-Traced Parameters Rollout* on page 5468 or *Area Shadows Rollout* on page 5472.

**Qual. (Quality)** For advanced ray-traced shadows or area shadows, sets the Shadow Quality. See *Advanced Ray-Traced Parameters Rollout* on page 5468 or *Area Shadows Rollout* on page 5472.

**Decay** (For standard lights.) Sets the type of decay: None, Inverse, or Inverse Square. See *Intensity/Color/Attenuation Parameters* on page 5431.

**Start** (For standard lights.) Sets the start range for decay. See *Intensity/Color/Attenuation Parameters* on page 5431.

**Length** (For photometric lights.) Sets the Length value for Line and Rectangle lights. See *Shape/Area Shadows Rollout* on page 5389.

**Width** (For photometric lights.) Sets the Width value for Rectangle lights. See *Shape/Area Shadows Rollout* on page 5389.

**Global Tint** Adds a color tint to all lights in the scene except ambient light. Click to use the *Color Selector* on page 371. The tint is in addition to the global light color, or the color of individual lights. The default setting, white, has no tinting effect.

**Global Level** Increases or decreases the overall lighting level for Standard lights. Default=1.0.

**NOTE** This setting, designed for standard lights, reduces the level of photometric lights to near darkness. If you have photometric lights in your scene, leave this setting at the default.

**Ambient Color** Changes the ambient color on page 8504, the color seen in shadows. Click to use the *Color Selector* on page 371.

**Lights rollout**

<table>
<thead>
<tr>
<th>Lights rollout</th>
<th>Standard Lights</th>
<th>Photometric Lights</th>
</tr>
</thead>
<tbody>
<tr>
<td>On/Off</td>
<td>Multiple</td>
<td>On/Off</td>
</tr>
<tr>
<td>Int.</td>
<td>Color</td>
<td>Intensity/Color/Attenuation Parameters</td>
</tr>
<tr>
<td>Qual.</td>
<td>Shadows</td>
<td>Shadows</td>
</tr>
<tr>
<td>Decay Start</td>
<td>Size</td>
<td>Size/Range Transp. Int.</td>
</tr>
<tr>
<td>Start</td>
<td>Bias</td>
<td>Bias</td>
</tr>
<tr>
<td>Length Width</td>
<td>Map/Color/Shape</td>
<td>None</td>
</tr>
<tr>
<td>Width</td>
<td></td>
<td>None</td>
</tr>
</tbody>
</table>

---

5346 | Chapter 16   Lights and Cameras
This rollout is visible while All Lights or Selected Lights is active on the Configuration rollout. Its controls are for individual light objects. This rollout displays two lists: one for standard lights, and another for photometric lights.

**Blank gray button (Select)** Click to select the named light. This button turns white for selected lights. Selecting a light opens the Modify panel for that light. This button has a gray box in the middle for the light that appears in the Modify panel. The gray box appears whether the light is selected or not. Clicking Select deselects all other lights. If the entry is for an instanced light, clicking Select selects all instances (see the description of the Name field that follows). If the light is part of a group, the entire group is selected. If you are in Selected Lights mode (on the Configuration rollout), the list of selected lights is not refreshed automatically.

**NOTE** You can set the controls for a light without selecting it.

**Check box** Turns the light on or off. Default=on.

**Name** Shows the name of the light object.

If there are multiple instances of a light, only one entry appears in the Light Lister, and the Name field becomes a drop-down list. The list lets you see the names of all instances, but it has no other effect: parameter changes made in the Light Lister affect all instances of the light.

**Multiplier** (Standard lights only.) Increases or decreases the intensity of the light. Default=1.0.

**NOTE** This control is unavailable if the light has a procedural controller.

**Intensity** (Photometric lights only.) Sets the light intensity, in candelas. Default=1500.0.

**NOTE** This control is unavailable if the light has a procedural controller.

**Color** Click to display the **Color Selector** on page 371 and change the light color. Default=white.

**WARNING** For photometric lights, this changes the filter color, not the color temperature.

**Shadows** Turns shadow casting on or off. Default=on.

**Shadow type drop-down list** Selects the shadow type for the light.

**Map Size** Available only when shadow map shadows is on. Sets the size (in pixels squared) of the shadow map used by all lights.
Bias Setting depends on which shadow type is selected. In general, bias moves the shadow toward or away from the shadow-casting object. See Shadow Map Parameters on page 5486 and Ray-Traced Shadow Parameters on page 5484 for specific effects.

Sm. Range For shadow-mapped shadows, sets the Sample Range value. See Shadow Map Parameters on page 5486. This value has no effect for ray-traced shadows. Default=4.0.

Transp. (Transparency) When on, turns on transparency for advanced ray-traced and area shadows. Has no effect on shadow-mapped or standard ray-traced shadows. Default=off.

The shadow transparency control is on the Optimizations rollout on page 5479.

Int. (Integrity) For advanced ray-traced shadows or area shadows, sets the Shadow Integrity. See Advanced Ray-Traced Parameters Rollout on page 5468 or Area Shadows Rollout on page 5472. Default=1.

Qual. (Quality) For advanced ray-traced shadows or area shadows, sets the Shadow Quality. See Advanced Ray-Traced Parameters Rollout on page 5468 or Area Shadows Rollout on page 5472. Default=2.

Decay (Standard Lights only.) Sets the type of decay: None, Inverse, or Inverse Square. See Attenuation Parameters on page 5431. Default=None.

Start (Standard lights only.) Sets the start range for decay. See Attenuation Parameters on page 5431. Default=0.0.

Length (Photometric lights only.) Sets the Length value for Line and Rectangle photometric lights. See Shape/Area Shadows Rollout on page 5389.

Width (Photometric lights only.) Sets the Width value for Rectangle photometric lights. See Shape/Area Shadows Rollout on page 5389.

Photometric Lights

Photometric lights use photometric on page 8683 (light energy) values that enable you to more accurately define lights as they would be in the real world. You can create lights with various distribution and color characteristics, or import specific photometric files available from lighting manufacturers.

NOTE Photometric lights always attenuate using an inverse-square falloff, and rely on your scene using realistic units.
When you create lights from the Create panel, photometric lights appear as the default.

3ds Max includes the following types of photometric light objects:

- **Target Light (Photometric)** on page 5351
- **Free Light (Photometric)** on page 5354
- **mr Sky Portal** on page 5537

**NOTE** The remainder of this section discusses standard photometric lights, target and free. It does not discuss the **mr Sky Portal** on page 5537. Additional photometric light types are provided as part of the Daylight system; see **Sunlight and Daylight Systems** on page 5491.

### Distribution Capabilities of Photometric Lights

You can choose how a photometric light is distributed. This can model how the light is generated and how it is mounted. There are four options:

- **Uniform Spherical** on page 5367
- **Uniform Diffuse** on page 5368
- **Spotlight** on page 5369
- **Photometric Web** on page 5371

The drop-down list that lets you choose the distribution type appears on the **General Parameters rollout** on page 5361 for photometric lights. In viewports, Uniform distribution is represented by a small sphere (the position of the sphere indicates whether the distribution is Spherical or Hemispherical), Spotlight distribution is represented by a cone, and Web distribution is represented as the shape of the web.

### Light Shapes for Shadow Generation

While your distribution choice affects how light is spread throughout the scene, the light shape affects the way objects cast shadows. This setting is an
independent choice. In general, larger areas cast softer shadows. There are six options:

- **Point**
  Objects cast shadows as if the light were emitted from a single geometric point, like a naked lightbulb.

- **Line**
  Objects cast shadows as if the light were emitted from a line, like a fluorescent tube.

- **Rectangle**
  Objects cast shadows as if the light were emitted from a rectangular area, like a skylight.

- **Disc**
  Objects cast shadows as if the light were emitted from a disc, like a circular porthole.

- **Sphere**
  Objects cast shadows as if the light were emitted from a sphere, like a globular lighting fixture.

- **Cylinder**
  Objects cast shadows as if the light were emitted from a cylinder, like a tubular lighting fixture.

You choose the light shape on the **Shape/Area Shadows rollout** on page 5389.

**Lights from Older Scenes**

Prior to 3ds Max 2009, there were several types of photometric light, based on the light shape for shadow calculation. There are now just the two types of photometric light, Target and Free, and you choose the shape for shadow casting independently of the light type.

When you open a scene created in an earlier version of 3ds Max, the scene’s photometric lights are converted to their equivalent in the new scheme. For example, a Target Linear Light with Isometric distribution becomes a Target Light with Line shadows and Uniform Spherical distribution. No information is lost, and the light behaves as it did in prior releases.
Parameters for Photometric Lights

The parameters specific to photometric lights are described in Rollouts for Photometric Lights on page 5355. Other photometric light parameters are shared with standard lights, and are described in the following topics:

Name and Color Rollout (Lights) on page 5317
Common Lighting Rollouts and Dialogs on page 5445
Shadow Types and Shadow Controls on page 5466

Notes

- A scene's lighting can also be affected by the Ambient Light setting on the Environment panel on page 7163.
- You can use the Place Highlight on page 976 command to change a light's position.
- You can use templates on page 5356 to create lights that have the properties of common lamp types.

Target Light (Photometric)

Create panel > Lights > Photometric > Target Light button
Create menu > Lights > Photometric Lights > Target Light.

A target light has a target sub-object that you can use to aim the light.

Viewport representations of Target lights with spherical, spotlight, and web distribution
NOTE When you add a Target light, 3ds Max automatically assigns a Look At controller on page 3502 to it, with the light's target object assigned as the Look At target. You can use the controller settings on the Motion panel to assign any other object in the scene as the Look At target.

NOTE When you rename a Target Point light, the target is automatically renamed to match. For example, renaming TPhotometricLight01 to Klieg causes TPhotometricLight01.Target to become Klieg.Target. The target's name must have the extension .Target. Renaming the target object does not rename the light object.

Procedures

To create a Target light:

1. On the Create panel, click Lights.
2. Choose Photometric from the drop-down list. (The default is Standard.)
3. In the Object Type rollout, click Target Light.
4. Drag in a viewport. The initial point of the drag is the location of the light, and the point where you release the mouse is the location of the target.
   The light is now part of the scene.
5. Set the creation parameters.
   You can use the Move transform to adjust the light’s position and direction.

To select the target:

The target, displayed as a small square, is often in the same area as objects that you want to illuminate. It can be difficult to select it by clicking.

1. First select the target point light.
2. Right-click the light and choose Select Target from the quad menu on page 8052.
   You can also choose Lights from the Selection Filters list on the toolbar, and then click the target. Clicking the line that connects the light and its target selects both objects.
To adjust the light and target position:

1. Select the light or target or both.

2. On the Main toolbar, click Move. Drag the selection to adjust the light.
   You can also right-click the light and choose Move from the quad menu > Transform quadrant.

Because the light is always aimed at its target, you can’t rotate it about its local X or Y axes. However, you can select and move the target object as well as the light itself. When you move either the light or the target, the light’s orientation changes so it always points at the target.

You can use the Place Highlight on page 976 command to change a light’s position.

For target lights with spotlight distributions, you can also adjust the light using a Light viewport on page 8165.

To change a viewport to a light view:

**NOTE** The viewport can only be set to a light view when the target light’s distribution is spotlight.

1. Click or right-click the Point-Of-View viewport label.
   3ds Max opens the POV viewport label menu on page 8122.

2. Choose Lights.
   3ds Max opens a submenu that shows the name of each light. By default, Target lights are named TPhotometricLight01, TPhotometricLight02, and so on.

3. Choose the name of the light you want.
   The viewport now shows the light’s point of view. You can use the Light viewport on page 8165 controls to adjust the light.

**TIP** The default keyboard shortcut for Light viewports is $.
Free Light (Photometric)

Create panel > Lights > Photometric > Free Light button
Create menu > Lights > Photometric Lights > Free Light.
A free light has no target sub-object. You can aim it by using transforms.

![Viewport representations of a Free light with spherical, spotlight, and web distribution](image)

Procedures

To create a Free light:

1. On the Create panel, click Lights.
2. Choose Photometric from the drop-down list. (Standard is the default.)
3. In the Object Type rollout, click Free Light.
4. Click the viewport location where you want the light to be.
   The light is now part of the scene. Initially it points away from you in the viewport you clicked (down the negative Z-axis of the viewport).
5. Set the creation parameters.
   You can position the light on page 5334 and adjust its direction with the transform tools or by using a Light viewport. You can also adjust the light's position with the Place Highlights on page 976 command.

To adjust the light position:

1. Select the light.
2. On the Main toolbar, click Move or Rotate. Drag the selection to adjust the light.
You can also right-click the light and choose Move or Rotate from the quad menu > Transform quadrant.

**TIP** You can also adjust the light's position with the Place Highlight on page 976 command.

**To change a viewport to a light view:**

**NOTE** This is only available for lights with Spot distribution.

1. Click or right-click the Point-Of-View (POV) viewport label.  
3ds Max opens the **POV viewport label menu** on page 8122.

2. Choose Lights.  
3ds Max opens a submenu that shows the name of each light. By default, Free Point lights are named *PhotometricLight01, PhotometricLight02*, and so on.

3. Choose the name of the light you want.  
The viewport now shows the light's point of view. You can use the **Light Viewport Controls** on page 8165 to adjust the light.

**TIP** The default keyboard shortcut for Light viewports is $.

---

**Rollouts for Photometric Lights**

The topics in this section describe rollouts whose controls are specific to photometric lights.

**See also:**

- **Name and Color Rollout (Lights)** on page 5317
- **Common Lighting Rollouts and Dialogs** on page 5445
- **Shadow Types and Shadow Controls** on page 5466
Templates Rollout

Create panel > Lights > Photometric Lights > Create a light. > Modify panel > Templates rollout

Create panel > Lights > Photometric Lights > Create a light. > Modify panel > Templates rollout

The Templates rollout lets you choose from among a variety of preset light types.

In general, when you create lights for a new scene (as opposed to using an existing 3ds Max scene), we recommend that you do one of the following:

■ Choose a light from the template list.
■ Download a light description from a lighting manufacturer’s Web site. See Web Distribution (Photometric Lights) on page 5371.
■ Use the lights provided with the model that was created in AutoCAD, Revit, or another application that provides photometric lights.

Interface

Select a Template Use this drop-down list to choose the kind of light you want to use. 3ds Max offers these selections:

■ 40 Watt (W) bulb
■ 60W bulb
■ 75W bulb
■ 100W bulb
■ Halogen spotlight
■ 21W halogen bulb
When you choose a template, the parameters of the light update to use the values of that light, and the text area above the list displays a description of the light. If you choose a category heading instead of a light type, the text area prompts you to choose an actual light.

Common Lamp Values for Photometric Lights

The tables in this topic list some commonly used lamps values that you can use as a guide for defining photometric lights.

The information in the tables is approximate; however, you can refer to manufacturer's documentation for more precise photometric data for these lamps.

General-Purpose Lamps

NOTE In the tables below, “Class.” stands for “Classification”; the values under “Intensity” are expressed in candelas.
### M16 Low Voltage Lamps

<table>
<thead>
<tr>
<th>Class.</th>
<th>Watts</th>
<th>Type</th>
<th>Intensity</th>
<th>Beam</th>
<th>Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Narrow Beam</td>
<td>20</td>
<td>Spot</td>
<td>3300</td>
<td>6</td>
<td>12</td>
</tr>
<tr>
<td>Narrow Beam</td>
<td>50</td>
<td>Spot</td>
<td>9150</td>
<td>12</td>
<td>25</td>
</tr>
<tr>
<td>Medium Beam</td>
<td>50</td>
<td>Spot</td>
<td>3000</td>
<td>25</td>
<td>50</td>
</tr>
<tr>
<td>Wide Beam</td>
<td>20</td>
<td>Spot</td>
<td>460</td>
<td>38</td>
<td>75</td>
</tr>
<tr>
<td>Wide Beam</td>
<td>50</td>
<td>Spot</td>
<td>1500</td>
<td>38</td>
<td>75</td>
</tr>
</tbody>
</table>

FieldBeamIntensityTypeWattsClass.

A-19/ Med

<table>
<thead>
<tr>
<th>Watts</th>
<th>Type</th>
<th>Intensity</th>
<th>Beam</th>
<th>Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>60</td>
<td>Point</td>
<td>70</td>
<td></td>
<td></td>
</tr>
<tr>
<td>75</td>
<td>Point</td>
<td>95</td>
<td></td>
<td></td>
</tr>
<tr>
<td>100</td>
<td>Point</td>
<td>139</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**M16 Low Voltage Lamps**
### Par36 Low Voltage Lamps

<table>
<thead>
<tr>
<th>Class.</th>
<th>Watts</th>
<th>Type</th>
<th>Intensity</th>
<th>Beam</th>
<th>Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Narrow Beam</td>
<td>25</td>
<td>Spot</td>
<td>4200</td>
<td>9</td>
<td>15</td>
</tr>
<tr>
<td>Narrow Beam</td>
<td>50</td>
<td>Spot</td>
<td>8900</td>
<td>10</td>
<td>15</td>
</tr>
<tr>
<td>Medium Beam</td>
<td>50</td>
<td>Spot</td>
<td>1300</td>
<td>30</td>
<td>60</td>
</tr>
<tr>
<td>Wide Beam</td>
<td>25</td>
<td>Spot</td>
<td>250</td>
<td>36</td>
<td>75</td>
</tr>
<tr>
<td>Wide Beam</td>
<td>50</td>
<td>Spot</td>
<td>600</td>
<td>39</td>
<td>75</td>
</tr>
</tbody>
</table>

### Par56 Line Voltage Lamps

<table>
<thead>
<tr>
<th>Class.</th>
<th>Watts</th>
<th>Type</th>
<th>Intensity</th>
<th>Beam</th>
<th>Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Narrow Beam</td>
<td>300</td>
<td>Spot</td>
<td>68000</td>
<td>9</td>
<td>15</td>
</tr>
</tbody>
</table>
### Field Beam Intensity

<table>
<thead>
<tr>
<th>Class.</th>
<th>Watts</th>
<th>Type</th>
<th>Intensity</th>
<th>Beam</th>
<th>Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Narrow Beam</td>
<td>500</td>
<td>Spot</td>
<td>95000</td>
<td>9</td>
<td>15</td>
</tr>
<tr>
<td>Medium Beam</td>
<td>300</td>
<td>Spot</td>
<td>24000</td>
<td>18</td>
<td>36</td>
</tr>
<tr>
<td>Medium Beam</td>
<td>500</td>
<td>Spot</td>
<td>47500</td>
<td>18</td>
<td>36</td>
</tr>
<tr>
<td>Wide Beam</td>
<td>300</td>
<td>Spot</td>
<td>10000</td>
<td>30</td>
<td>60</td>
</tr>
<tr>
<td>Wide Beam</td>
<td>500</td>
<td>Spot</td>
<td>18000</td>
<td>30</td>
<td>60</td>
</tr>
</tbody>
</table>

### Par38 Line Voltage Lamps

<table>
<thead>
<tr>
<th>Class.</th>
<th>Watts</th>
<th>Type</th>
<th>Intensity</th>
<th>Beam</th>
<th>Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Narrow Beam</td>
<td>45</td>
<td>Spot</td>
<td>4700</td>
<td>14</td>
<td>28</td>
</tr>
<tr>
<td>Narrow Beam</td>
<td>75</td>
<td>Spot</td>
<td>5200</td>
<td>12</td>
<td>25</td>
</tr>
<tr>
<td>Narrow Beam</td>
<td>150</td>
<td>Spot</td>
<td>10500</td>
<td>14</td>
<td>28</td>
</tr>
</tbody>
</table>
### Field Beam Intensity Type Watts Class

<table>
<thead>
<tr>
<th>Class</th>
<th>Watts</th>
<th>Type</th>
<th>Intensity</th>
<th>Beam</th>
<th>Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Medium Beam</td>
<td>45</td>
<td>Spot</td>
<td>1700</td>
<td>28</td>
<td>60</td>
</tr>
<tr>
<td>Medium Beam</td>
<td>75</td>
<td>Spot</td>
<td>1860</td>
<td>30</td>
<td>60</td>
</tr>
<tr>
<td>Medium Beam</td>
<td>150</td>
<td>Spot</td>
<td>4000</td>
<td>30</td>
<td>60</td>
</tr>
</tbody>
</table>

### R40 Line Voltage Lamps

<table>
<thead>
<tr>
<th>Class</th>
<th>Watts</th>
<th>Type</th>
<th>Intensity</th>
<th>Beam</th>
<th>Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Narrow Beam</td>
<td>150</td>
<td>Spot</td>
<td>5400</td>
<td>22</td>
<td>50</td>
</tr>
<tr>
<td>Wide Beam</td>
<td>150</td>
<td>Spot</td>
<td>1040</td>
<td>76</td>
<td>130</td>
</tr>
<tr>
<td>Wide Beam</td>
<td>300</td>
<td>Spot</td>
<td>1950</td>
<td>76</td>
<td>130</td>
</tr>
</tbody>
</table>

### General Parameters Rollout (Photometric Lights)

Create panel > Lights > Photometric Lights > Create a light. > Modify panel > General Parameters rollout.
Create menu > Photometric Lights > Create a light. > Modify panel > General Parameters rollout.

This General Parameters rollout is displayed for photometric lights. These controls turn a light on and off, and exclude or include objects in the scene. They also let you set the type of light distribution.

On the Modify panel, the General Parameters rollout also lets you control the light’s target object and change the light from one type to another.

The General Parameters rollout also lets you turn shadow-casting on or off for the light, and choose which type of shadow the light uses. See Shadow Types and Shadow Controls on page 5466 and Shadow Parameters on page 5448.

**Procedures**

**To turn a light on and off:**
- Turn the On toggle on or off.
  Default=on.

**To have a light cast shadows:**
- In the General Parameters rollout > Shadows group, make sure On is selected.

The light will now cast shadows when you render the scene.

![Left: With Spotlight distribution, the projection cone can truncate shadows. Right: With Uniform Spherical distribution, the light casts complete shadows.](image)

**To have a light use the global settings for shadows:**
- On the General Parameters rollout, in the Shadow Parameters group, turn on Use Global Settings.
When Use Global Settings is on, the other shadow controls are set to the values used by all other shadow-casting lights in the scene that have Use Global Settings set.

Changing the affected parameters for one light with Use Global Settings set, changes them for all lights with Use Global Settings set.

**To set a light’s shadow parameters individually:**

- On the General Parameters rollout, turn off Use Global Settings. The settings revert to the individual settings for the light.

By default, Shadow Map is the active shadow type. In the Shadow Map Params rollout on page 5486, the default settings are: Map Bias=1; Size=512; Sample Range=4.0; Absolute Map Bias=Off.

![Scene with shadow-mapped shadows](image)

Shadows rendered using default parameter settings

**TIP** When you render a scene, you can turn rendering of shadows on or off.

**To cast area shadows:**

- On the General Parameters rollout, choose Area Shadows from the drop-down list.
  
  Use controls on the Area Shadows rollout on page 5472 to adjust the shadow properties.
To cast advanced ray-traced shadows:

Advanced ray-traced shadows are similar to ray-traced shadows, however they provide control over antialiasing on page 8501, letting you fine-tune how shadows are generated.

- On the General Parameters rollout, choose Advanced Ray-traced Shadows from the drop-down list.
  Use controls on the Advanced Ray-traced Params rollout on page 5468 to adjust the shadow properties.

To cast shadow-mapped shadows:

1. On the General Parameters rollout, choose Shadow Maps from the drop-down list.
2. Go to the Shadow Map Params rollout on page 5486.
   - Use the Size spinner to set the size of the shadow map.
   - Use the Bias spinner to adjust the shadow offset, if necessary.
   - Use the Sample Range spinner to create a soft-edged shadow.

To cast ray-traced shadows:

Ray-traced shadows on page 8696 are generated by tracing the path of rays sampled from a light source. Ray-traced shadows are more accurate than shadow-mapped shadows.

1. On the General Parameters rollout, in the Shadows groupo, choose Ray-Traced Shadows from the drop-down list.
2. Use controls on the Ray Traced Shadow Params rollout on page 5484 to adjust the shadow offset, if necessary.

To keep an object from casting shadows:

1. Select the object.
2. Right-click the object to display the quad menu and choose Properties from the Transform quadrant.
   The Object Properties dialog on page 283 is displayed.
3. Turn off Cast Shadows, and then click OK.
   Now when you render the scene, the object casts no shadows.
To make an object not receive shadows:

1. Select the object.
2. Right-click the object to display the quad menu and choose Properties from the lower-right (Transform) quadrant.
   The Object Properties dialog on page 283 is displayed.
3. Turn off Receive Shadows, and then click OK.
   Now when you render the scene, the object receives no shadows.

**NOTE** You can also prevent objects from casting shadows by excluding them from a light.

### Interface

**Light Properties group**

**On** (Both Create panel and Modify panel) Turns the light on and off. When On is on, shading and rendering use the light to illuminate the scene. When On is off, the light is not used in shading or rendering. Default=on.

In viewports, the interactive renderer shows the effect of turning lights on or off.
**Targeted** When on, the light has a target. When off, you aim the light using transforms. This toggle lets you change the light from a target light to a free light, or vice versa.

**Target Distance** Shows the target distance. For a target light, this field simply displays the distance. For a free light, you can enter a value to change the distance.

**Shadows group**

**On** Determines whether the current light casts shadows or not. Default=on.

**Shadow Method drop-down list** Determines whether the renderer uses shadow maps on page 8719, ray-traced shadows on page 8696, advanced ray-traced shadows on page 8696, or area shadows on page 8510, to generate shadows for this light.

The “mental ray Shadow Map” type is provided for use with the mental ray renderer on page 6675. When you choose this shadow type and enable shadow maps (on the Shadows & Displacement rollout on page 6756 of the Render Setup dialog), shadows use the mental ray shadow-map algorithm. If this type is chosen but you render with the default scanline renderer, no shadows appear in the rendering.

**NOTE** When shadow maps are enabled and the shadow map type is Shadow Map, the mental ray renderer attempts to translate the shadow map settings into comparable settings for mental ray shadow maps. (The results might not be what you expected.) In all other cases, the mental ray renderer generates ray-traced shadows.

Each shadow type has its particular controls:

- **Advanced ray-traced shadows**  See Advanced Ray-Scoped Parameters Rollout on page 5468 and Optimizations Rollout on page 5479.
- **Area shadows**  See Area Shadows Rollout on page 5472 and Optimizations Rollout on page 5479.
- **mental ray shadow maps**  See mental ray Shadow Map Rollout on page 5482.
- **Ray-traced shadows**  See Ray-Traced Shadow Parameters Rollout on page 5484.
- **Shadow maps**  See Shadow Map Parameters Rollout on page 5486.
TIP  Use ray-traced or advanced ray-traced shadows when you want shadows cast by opacity-mapped objects. Shadow-mapped shadows don’t recognize the transparent portions of the mapping, and as a result they don’t look convincing.

**Use Global Settings** Turn on to use global settings for shadows cast by this light. Turn off to enable individual control of the shadows. If you choose not to use the global settings, you must choose which method the renderer will use to generate shadows for this particular light.

When Use Global Settings is on, the shadow parameters switch over to show you what the global settings are. This data is shared by every other light of this class. When Use Global Settings is off, the shadow parameters are specific to that particular light.

**Exclude button** Excludes selected objects from the effects of the light. Click this button to display the Exclude/Include dialog on page 5445.

Excluded objects still appear lit in shaded viewports. Exclusion takes effect only when you render the scene.

**Light Distribution (Type) group**

**Drop-down list** The light distribution drop-down list lets you choose the type of light distribution. There are four options:

- **Photometric Web** on page 5371
  When you choose this option, the Distribution (Photometric File) rollout on page 5393 opens on the command panel.

- **Spotlight** on page 5369
  When you choose this option, the Distribution (Spotlight) rollout on page 5394 opens on the command panel.

- **Uniform Diffuse** on page 5368

- **Uniform Spherical** on page 5367
  Uniform distribution, whether diffuse or spherical, has no additional settings, so these choices don’t display a special Distribution rollout.

**Uniform Spherical Distribution (Photometric Lights)**

Create panel > Lights > Photometric Lights > Click Target Light or Free Light. > General Parameters rollout > Light Distribution (Type) group > Choose Uniform Spherical from the drop-down list.
Uniform spherical distribution, as its name implies, casts light equally in all directions.

Uniform spherical light distribution

Viewport representation of a Target light with uniform spherical distribution

**Uniform Diffuse Distribution (Photometric Lights)**

Create panel > Lights > Photometric Lights > Click Target Light or Free Light. > General Parameters rollout > Light Distribution (Type) group > Choose Uniform Diffuse from the drop-down list.

Uniform diffuse distribution casts diffuse light in one hemisphere only, as if the light were emitted from a surface.
Uniform diffuse distribution obeys Lambert’s cosine law: the light has the same apparent intensity when viewed from any angle.

[Diagram of uniform diffuse light distribution]

**NOTE** Uniform Diffuse distribution was known simply as Diffuse distribution in releases prior to Autodesk 3ds Max 2010.

**Spotlight Distribution (Photometric Lights)**

Create panel > Lights > Photometric Lights > Click Target Light or Free Light. > General Parameters rollout > Light Distribution (Type) group > Choose Spotlight from the drop-down list.

Spotlight distribution casts a focused beam of light like a flashlight, a follow spot in a theater, or a headlight. The light’s *beam angle* controls the main strength of the beam, and the *field angle* controls the “spill” of light outside the main beam.
NOTE Be aware that the scanline renderer and the mental ray renderer treat the beam angle and field angle differently. With the scanline renderer, the beam casts light at full intensity, and the field angle limits the area where the beam is cast. With the mental ray renderer, the center of the beam is at 100 percent, but it fades to 50 per cent at the beam angle, and to a value near 0 at the field angle; however, some light might be cast outside the field angle as well.

Spotlight distribution

Viewport representation of a Target light with spotlight distribution

Spotlight settings appear on the Distribution (Spotlight) rollout on page 5394.
**Photometric Web Distribution (Photometric Lights)**

Create panel > Lights > Photometric Lights > Click Target Light or Free Light. > General Parameters rollout > Light Distribution (Type) group > Choose Photometric Web from the drop-down list.

Photometric Web distribution uses a photometric web definition on page 5372 to distribute the light. A photometric web is a 3D representation of the light intensity distribution of a light source. Web definitions are stored in files. Many lighting manufacturers provide web files that model their products; these are often available on the Internet.

A web file can be in the IES on page 5376, LTLI on page 8625, or CIBSE on page 8532 format. Controls for assigning the web file are on the Distribution (Photometric File) rollout on page 5393.

![Example of web distribution](image-url)

*Example of web distribution*
Viewport representations of lights with various web distributions


Procedure

To create a light from a manufacturer’s IES file:

1. Create a Target or Free photometric light.

2. In the General Parameters rollout > Light Distribution (Type) group, choose Photometric Web File from the Distribution list.
   A Distribution (Photometric File) rollout opens on the command panel.

3. In the Distribution (Photometric File) rollout, click the button labelled Choose Photometric File.
   A file selection dialog appears. Choose the IES file that you want to use.

Photometric Webs

A photometric web is a 3D representation of the light intensity distribution of a light source. This directional light distribution information is stored in a photometric data file in the IES format using the IES LM-63-1991 standard file format on page 5376, or in the LTL1 or CIBSE formats for photometric data. You can load photometric data files provided by various manufacturers as web parameters. In viewports, the light object changes to the shape of the photometric web you choose.

To describe the directional distribution of the light emitted by a source, 3ds Max approximates the source by a point light placed at its photometric center. With this approximation, the distribution is characterized as a function of the outgoing direction only. The luminous intensity of the source for a predetermined set of horizontal and vertical angles is provided, and 3ds Max computes the luminous intensity along an arbitrary direction by interpolation.
Web Diagrams

Photometric data is often depicted using a diagram. Diagrams that show rotation about an axis are known as goniometric.

Goniometric diagram of a web distribution

This type of diagram visually represents how the luminous intensity of a source varies with the vertical angle. However, the horizontal angle is fixed and, unless the distribution is axially symmetric, more than one goniometric diagram may be needed to describe the complete distribution.

In the 3ds Max user interface, web files are displayed as thumbnail diagrams.
The bright red outline shows the beam. For some webs, a darker red outline shows the (less bright) field.

**Photometric Web**

The photometric web is a three-dimensional representation of the light distribution. It extends the goniometric diagram to three dimensions, so that the dependencies of the luminous intensity on both the vertical and horizontal angles can be examined simultaneously. The center of the photometric web represents the center of the light object.

The luminous intensity in any given direction is proportional to the distance between this web and the photometric center, measured along a line leaving the center in the specified direction.
Example 1: Uniform Spherical Distribution

A sphere centered around the origin is a representation of uniform spherical distribution, also known as isotropic distribution. All the points in the diagram are equidistant from the center and therefore light is emitted equally in all directions.
Example 2: Ellipsoidal Distribution

In this example, the points in the negative Z direction are the same distance from the origin as the corresponding points in the positive Z direction, so the same amount of light shines upward and downward. No point has a very large X or Y component, either positive or negative, so less light is cast laterally from the light source.

**IES Standard File Format**

You can create a photometric data file in the IES format using the IES LM-63-1991 standard file format for photometric data. (IES stands for Illuminating Engineering Society.)

This topic describes only the information relevant to 3ds Max. For a complete description of the IES standard file format, see *IES Standard File Format for*
The luminous intensity distribution (LID) of a luminaire is measured at the	nodes of a photometric web for a fixed set of horizontal and vertical angles.
The poles of the web lie along the vertical axis, with the nadir corresponding
to a vertical angle of zero degrees. The horizontal axis corresponds to a
horizontal angle of zero degrees and is oriented parallel to the length of the
luminaire. This type of photometric web is generated by a Type C goniometer
and is the most popular in North America; other types of goniometry are
supported by the IES standard file format but are not discussed here.

The photometric data is stored in an ASCII file. Each line in the file must be
less than 132 characters long and must be terminated by a
carriage-return/line-feed character sequence. Longer lines can be continued
by inserting a carriage-return/line-feed character sequence. Each field in the
file must begin on a new line and must appear exactly in the following
sequence:

1  IESNA91
2  [TEST] the test report number of your data
3  [MANUFAC] the manufacturer of the luminaire
4  TILT=NONE
5  1
6  The initial rated lumens for the lamp used in the test or -1 if absolute
   photometry is used and the intensity values do not depend on different
   lamp ratings.
7  A multiplying factor for all the candela values in the file. This makes it
   possible to easily scale all the candela values in the file when the
   measuring device operates in unusual units—for example, when you
   obtain the photometric values from a catalog using a ruler on a
   goniometric diagram. Normally the multiplying factor is 1.
8  The number of vertical angles in the photometric web.
9  The number of horizontal angles in the photometric web.
10  1
11  The type of unit used to measure the dimensions of the luminous opening.
    Use 1 for feet or 2 for meters.
The width, length, and height of the luminous opening. Currently, Lightscape ignores these dimensions because you can associate a given luminous intensity distribution with any of the luminaire geometric entities supported by Lightscape. It is normally given as 0 0 0.

1.0 1.0 0.0

The set of vertical angles, listed in increasing order. If the distribution lies completely in the bottom hemisphere, the first and last angles must be 0° and 90°, respectively. If the distribution lies completely in the top hemisphere, the first and last angles must be 90° and 180°, respectively. Otherwise, they must be 0° and 180°, respectively.

The set of horizontal angles, listed in increasing order. The first angle must be 0°. The last angle determines the degree of lateral symmetry displayed by the intensity distribution. If it is 0°, the distribution is axially symmetric. If it is 90°, the distribution is symmetric in each quadrant. If it is 180°, the distribution is symmetric about a vertical plane. If it is greater than 180° and less than or equal to 360°, the distribution exhibits no lateral symmetries. All other values are invalid.

The set of candela values. First all the candela values corresponding to the first horizontal angle are listed, starting with the value corresponding to the smallest vertical angle and moving up the associated vertical plane. Then the candela values corresponding to the vertical plane through the second horizontal angle are listed, and so on until the last horizontal angle. Each vertical slice of values must start on a new line. Long lines may be broken between values as needed by following the instructions given earlier.

Here is an example of a photometric data file on page 5378.

**Example of a Photometric Data File**

This topic shows an example of a photometric data file.

See also:

- IES Standard File Format on page 5376
Intensity/Color/Attenuation Rollout (Photometric Lights)

Create panel > Lights > Photometric Lights > Create a light. > Modify panel > Intensity/Color/Attenuation rollout

Create panel > Lights > Photometric Lights > Create a light. > Modify panel > Intensity/Color/Attenuation rollout

The Intensity/Color/Attenuation rollout lets you set the color and intensity of the light. You can also, optionally, set a limit for its attenuation.

Interface
**Color group**

**Light** Pick a common lamp specification to approximate the spectral character of your light. The color swatch next to the Kelvin parameter is updated to reflect the light you select.

These are the options when you specify color using the Light drop-down list (HID stands for high-intensity discharge):

- D50 Illuminant (Reference White)
- D65 Illuminant (Reference White) (the default)
- Fluorescent (Cool White)
- Fluorescent (Daylight)
- Fluorescent (Lite White)
- Fluorescent (Warm White)
- Fluorescent (White)
- Halogen
- Halogen (Cool)
- Halogen (Warm)
- HID Ceramic Metal Halide (Cool)
- HID Ceramic Metal Halide (Warm)
- HID High Pressure Sodium
- HID Low Pressure Sodium
- HID Mercury
- HID Phosphor Mercury
- HID Quartz Metal Halide
- HID Quartz Metal Halide (Cool)
- HID Quartz Metal Halide (Warm)
- HID Xenon
- Incandescent filament lamp
NOTE The default choice, D65 Illuminant (Reference White), approximates a midday sun in western or northern Europe. “D65” is a white value defined by the Comission Internationale de l’Éclairage (CIE), the International Lighting Commission.
Different lamp types used for the foreground light:
Top: D50 Illuminant (Reference White)
Middle: Fluorescent (Cool White)
Bottom: HID High Pressure Sodium

**Kelvin** Set the color of the light by adjusting the color temperature on page 5327 spinners. The color temperature is displayed in degrees Kelvin. The corresponding color is visible in the color swatch next to the temperature spinners.

**Filter Color** Use a color filter to simulate the effect of a color filter placed over the light source. For example, a red filter over a white light source casts red light. Set the filter color by clicking the color swatch to display the Color Selector on page 371. Default=white (RGB=255,255,255; HSV=0,0,255).

Foreground light given a dark green filter color

**Intensity group**

These controls specify the strength or brightness of photometric lights in physically based quantities.
You set the intensity of a light source using one of the following units:

- **Im (lumen)**  Measures the overall output power of the light (luminous flux on page 8625). A 100-watt general purpose light bulb has a luminous flux of about 1750 lm.

- **cd (candela)**  Measures the maximum luminous intensity on page 8625 of the light, usually along the direction of aim. A 100-watt general purpose light bulb has a luminous intensity of about 139 cd.

- **lx at (lux)**  Measures illuminance on page 8606 caused by the light shining on a surface at a certain distance and facing in the direction of the source. The lux is the International Scene unit, which is equivalent to 1 lumen per square meter. The AS unit for illuminance is the footcandle (fc) which is equivalent to 1 lumen per square foot. To convert from footcandles to lux, multiply by 10.76. For example, to specify an illuminance of 35 fc, set illuminance to 376.6 lx.

  To specify the illuminance of a light, set the lx value on the left, and then in the second value field, enter the distance at which that illuminance is measured.

  **NOTE**  You can obtain these values directly from lighting manufacturers. A table of some common lamp types is provided in Photometric Lights: Common Lamp Values on page 5357.

**Dimming group**

**Resulting Intensity**  Displays the intensity caused by the dimming, using the same units as the Intensity group.

**Dimming percentage**  When the toggle is on, the value specifies a “multiplier” that dims the intensity of the light. At 100 percent, the light has its full intensity. At lower percentages, the light is dimmed.
Incandescent light in the foreground
Incandescent lamp color shift when dimming When on, the light simulates an incandescent light by turning more yellow in color as it is dimmed.
Dimmed foreground light with color shift turned on

**Far Attenuation group**

You can set the attenuation range for a photometric light. Strictly speaking, this is not how real-world lights behave, but setting an attenuation range can help improve rendering time dramatically.

**TIP** If your scene has a large number of lights, use Far Attenuation to limit the portion of the scene each light illuminates. For example, if an office area has rows of overhead lights, you could set Far Attenuation ranges to keep the lights’ illumination from being calculated when you render the reception area instead of the main office. As another example, a staircase might have recessed lights on each stair, as many theaters do. Setting a small Far Attenuation value for these lights can prevent their (negligible) illumination from being calculated when you render the theater as a whole.

Far attenuation works only with the [mental ray renderer](#) on page 6675.
**IMPORTANT** Unlike the attenuation ranges for standard lights, the attenuation range for photometric lights *does not change* the attenuation rate, which is always inverse square. The attenuation range is simply a way of limiting which parts of the scene are illuminated by the light, in order to reduce the amount of calculation required to render the scene.

**Use** Enables far attenuation for the light.

**Show** Displays the far attenuation range settings in viewports. For spotlight distribution, attenuation ranges appear as lens-shaped sections of the cone. For other distributions, the ranges appear as spheres. By default, Far Start is light brown and Far End is dark brown.

**NOTE** The attenuation ranges are always visible when a light is selected, so turning off this check box has no apparent effect until you deselect the light.

**Start** Sets the distance at which the light begins to fade out.

**End** Sets the distance at which the light has faded to zero.
Shape/Area Shadows Rollout

Create panel > Lights > Photometric Lights > Create a light. > Modify panel > Shape/Area Shadows rollout

Create panel > Lights > Photometric Lights > Create a light. > Modify panel > Shape/Area Shadows rollout

The Shape/Area Shadows rollout lets you choose the light shape used to generate shadows.

NOTE These controls work only with the mental ray renderer on page 6675. The scanline renderer on page 6588 does not calculate photometric area shadows (although with the scanline renderer you can use Area shadows on page 5472 to get a similar effect). Also, the scanline renderer does not render a photometric area light as self illuminating, or display its shape in renderings.

Interface

**Emit Light From (Shape) group**

**Drop-down list** Use the list to choose the shadow-generating shape. When you choose a shape other than Point, dimension controls appear in the Emit Light group, and a Shadow Samples control appears in the Rendering group.

- **Point** Calculates shadows as if the light were emitted from a point. The Point shape has no other controls.
- **Line**  Calculates shadows as if the light were emitted from a line. The Linear shape has a Length control.

- **Rectangle**  Calculates shadows as if the light were emitted from a rectangular area. The Area shape has Length and Width controls.

- **Disc**  Calculates shadows as if the light were emitted from a disc. The Disc shape has a Radius control.

- **Sphere**  Calculates shadows as if the light were emitted from a sphere. The Sphere shape has a Radius control.

- **Cylinder**  Calculates shadows as if the line were emitted from a cylinder. The Cylinder shape has Length and Radius controls.

**Rendering group**

**Light Shape Visible in Rendering** When on, the shape of the light is visible in renderings as a self-illuminated (glowing) shape, provided the light object is within the field of view. When off, the light’s shape is not rendered, only the light it casts. Default=off.

See [Self-Illuminating Photometric Lights](#) on page 5390 for more information about this option.

**Shadow Samples** Sets the overall quality of shadows for lights that have an area. If the rendered image appears grainy, increase this value. If rendering is too time consuming, decrease it. Default=32.

This setting doesn’t appear in the interface when Point is chosen as the shadow shape.

**Self-Illuminating Photometric Lights**

You can make a photometric light self illuminating by turning on the Light Shape Visible In Rendering option in the Shape/Area Shadows rollout on page 5389.

When you turn on Light Shape Visible In Rendering, by default 3ds Max turns off Specular in the Advanced Effects rollout on page 5457. This prevents unwanted effects if the area of the photometric light is small. Small lights
have a high luminance, and also are hard for specular rays to find: the result can be overly bright spots in your rendering.

- If the self-illuminating photometric light has a small area, leave Specular turned off.
- If the self-illuminating light has a large area (for example, a skylight or a fluorescent tube), turn Specular back on for the most realistic effect.

**Combining Self-Illuminating Photometric Lights and Self-Illuminating Materials**

To make a light fixture visible to the renderer, we recommend modeling the light fixture with actual geometry that has a self-illuminating material applied to it.

*The square white surface is geometry representing the light.*

*A photometric light is placed at the same location.*

This doesn’t pose a problem unless you create a radiosity solution on page 6615 that uses Final Gather. Final Gather treats the self-illuminated material as an additional diffuse light source, and the resulting rendering is too bright.
The intended effect of the light alone.

The light plus Final Gather creates illumination that is too bright.

If this problem arises, do one or both of the following:

■ Turn off Specular for the photometric light.

■ Turn off Object Properties > Advanced Lighting > Geometric Object Radiosity Properties > Radiosity-only Properties > Diffuse (reflective & translucent) for objects with surfaces affected by this problem.
Distribution (Photometric File) Rollout

Create panel > Lights > Photometric Lights > Create a photometric light. > General Parameters rollout > Choose Photometric Web File as the distribution type. > Distribution (Photometric File) rollout

Create menu > Lights > Photometric Lights > Create a photometric light. > General Parameters rollout > Choose Photometric Web File as the distribution type. > Distribution (Photometric File) rollout

The Distribution (Photometric File) rollout appears on the Modify panel when you create or select a photometric light with a photometric web distribution on page 5371. Use these parameters to select a photometric web file and to adjust the orientation of the web.

Interface

Web diagram After you choose a photometric file, this thumbnail shows a schematic diagram of the light’s distribution pattern.
Thumbnails of photometric web files

The bright red outline shows the beam. For some webs, a darker red outline shows the (less bright) field.

Choose Photometric File  Click to select a file to use as a photometric web. The file can be in the IES, LTII, or CIBSE format. Once you have chosen a file, this button displays the file name (without the .ies, .ltli, or .cibse name extension).

While you browse for a photometric web file, the file dialog also shows the thumbnail for the highlighted file.

X Rotation  Rotates the photometric web about the X axis. The center of rotation is the photometric center of the web. Range=–180 degrees to 180 degrees.

Y Rotation  Rotates the photometric web about the Y axis. The center of rotation is the photometric center of the web. Range=–180 degrees to 180 degrees.

Z Rotation  Rotates the photometric web about the Z axis. The center of rotation is the photometric center of the web. Range=–180 degrees to 180 degrees.

Distribution (Spotlight) Rollout

Create panel > Lights > Photometric Lights > Create a photometric light. > General Parameters rollout > Choose Spotlight as the distribution type. > Distribution (Spotlight) rollout

Create menu > Lights > Photometric Lights > Create a photometric light. > General Parameters rollout > Choose Spotlight as the distribution type. > Distribution (Spotlight) rollout
The Distribution (Spotlight) rollout appears on the Modify panel when you create or select a photometric light with spotlight distribution on page 5369. These parameters control hotspots and falloff on page 8604 for spotlights.

**Procedures**

To see the spotlight cone in viewports:

The cone is always visible while the light is selected. This setting keeps the cone visible when the light is unselected.

1. Select the spotlight.
2. In the Distribution (Spotlight) rollout, turn on Cone Visible In Viewport When Unselected.
3. Select another object, deselecting the light.

A wireframe outline of the light cone appears. The beam angle region is outlined in light blue, and the field angle region is outlined in dark gray.

![Spotlight cone displayed in a viewport](image)
To adjust the beam angle and field angle, do one of the following:

- Use the Hotspot/Beam and Falloff/Field spinners to increase or decrease the size of the beam angle and field angle regions. For spotlights, these angles are expressed in degrees.
- Use manipulators to adjust beam angle and field angle by dragging in a viewport, as described in the procedure that follows.

By default, the field angle is always constrained to be at least two degrees or two units greater than the beam angle. The size of this constraint is a preference that you can change in the Rendering panel on page 8342 of the Preferences dialog. The falloff value can range from 0 to 10,000 units.

When the beam angle and field angle values are close in value, the light casts a hard-edged beam.

To use manipulators to control beam angle and field angle:

1. Select the spotlight.
   
   **TIP** When you select multiple spotlights, all their manipulators are accessible.

2. On the default main toolbar, click to turn on Select And Manipulate.

   Now when you move the mouse over the beam angle or field angle circle, the circle turns red to show you can adjust it by dragging. Also, a tooltip displays the spotlight name, the parameter, and its value.

3. Drag the beam angle or field angle circle to adjust the value.

   The beam angle and field angle constrain each other, as their spinner controls do.

   Spotlight manipulators are described at the end of this topic.
Interface

Cone visible in viewport when unselected Turns display of the cone on or off.

NOTE The cone is always visible when a light is selected, so turning off this check box has no apparent effect until you deselect the light.

Hotspot/Beam Adjusts the angle of the cone of a light. The Beam value is measured in degrees. For photometric lights, the Beam angle is the angle at which the light's intensity has fallen to 50 per cent of its full intensity. Default=30.0.

Falloff/Field Adjusts the angle of a light's Field. The Field value is measured in degrees.

For photometric lights, the Field angle is the angle at which the light's intensity has fallen close to zero. Default=60.0.

NOTE The beam angle is similar to the hotspot angle for standard lights, but all of a hotspot is at 100 per cent intensity. The field angle is similar to the falloff angle for standard lights, but at the falloff angle, intensity fades to zero; photometric lights use a smoother curve, so some light might be cast outside the field angle.

You can manipulate the beam angle and field angle by dragging manipulators in viewports, as described in the previous procedures, and the later section "Manipulators for Spotlights."

You can also adjust beam and field angles in a Light viewport (looking at the scene from the point of view of the spotlight).
Manipulators for Spotlights

Manipulators are visible and usable while the Select And Manipulate button on page 2838 is turned on. This button is on the default main toolbar on page 8035. When you move the mouse over a manipulator, the manipulator turns red to show that dragging or clicking it will have an effect. Also, a tooltip appears, showing the name of the object, the parameter, and its value.

**TIP** When you select multiple spotlights, all their manipulators are accessible.

For more information on using the spotlight manipulators, see the Procedures section at the top of this topic.

Beam manipulator: In a viewport, drag the beam circle to adjust the beam value.

Field manipulator: In a viewport, drag the field circle to adjust the field value.

The beam and field angles constrain each other, as their spinner controls do.

Standard Lights

Standard lights are computer-based objects that simulate lights such as household or office lamps, the light instruments used in stage and film work, and the sun itself. Different kinds of light objects cast light in different ways, simulating different kinds of real-world light sources. Unlike photometric lights on page 5348, standard lights do not have physically-based intensity values.

For parameters specific to a particular kind of light, see the description of that light type. Parameters specific to standard lights in general, as well as rollouts specific to spotlights and directional lights, are described in Rollouts for Standard Lights on page 5424.
Target Spotlight

Create panel > Lights > Standard > Target Spot button
Create menu > Standard Lights > Target Spotlight

A spotlight casts a focused beam of light like a flashlight, a follow spot in a theater, or a headlight. A target spotlight uses a target object to aim the camera.
NOTE  When you add a target spotlight, 3ds Max automatically assigns a Look At controller on page 3502 to it, with the light’s target object assigned as the Look At target. You can use the controller settings on the Motion panel to assign any other object in the scene as the Look At target.

See also:

- Lights on page 5314
- Name and Color Rollout (Lights) on page 5317
- General Parameters Rollout (Standard Lights) on page 5424
- Intensity/Color/Attenuation Rollout (Standard Lights) on page 5431
- Advanced Effects Rollout on page 5457
- Shadow Parameters on page 5448
- Spotlight Parameters on page 5439

Procedures

To create a target spotlight:

1. On the Create panel, click Lights.
Standard is the default choice of light type.

2 In the Object Type rollout, click Target Spot.

3 Drag in a viewport. The initial point of the drag is the location of the spotlight, and the point where you release the mouse is the location of the target.
   The light is now part of the scene.

4 Set the creation parameters.

To adjust a target spotlight:

1 Select the light.

2 ![Image of Move tool] Use Move on the main toolbar to adjust the light. As an alternative, right-click the light and choose Move.
   Because the spotlight is always aimed at its target, you can’t rotate it about its local X or Y axis. However, you can select and move the target object as well as the light itself. When you move either the light or the target, the light’s orientation changes so it always points at the target.

   **NOTE** The target’s distance from the light does not affect the attenuation or brightness of the light.

To select the target:

The target, displayed as a small square, is often in the same area as objects that you want to illuminate. It can be difficult to select it by clicking.

1 Select the spotlight itself.

2 Right-click the light and choose Select Target from the upper-left (Tools 1) quadrant of the quad menu.
   Clicking the line that connects the light and its target selects both objects.
   However, region selection doesn’t recognize the link line.
   Another way to adjust a spotlight is to use a Light viewport on page 5439.

To change a viewport to a Light view:

1 Click or right-click the POV viewport label.
   3ds Max opens the Point-Of- View viewport label menu. on page 8122.
Choose Lights.
The Lights submenu shows the name of each spotlight or directional light in the scene.

Choose the name of the light you want.
The viewport now shows the light's point of view. You can use the Light viewport on page 8165 to adjust the light.
The default keyboard shortcut for switching to a Light viewport is $.

Interface

When you rename a target spotlight, the target is automatically renamed to match. For example, renaming Light01 to Klieg causes Light01.Target to become Klieg.Target. The target's name must have the extension .Target. Renaming the target object does not rename the light object.

Free Spotlight

Create panel > Lights > Standard > Free Spot button
Create menu > Standard Lights > Free Spotlight

A spotlight casts a focused beam of light like a flashlight, a follow spot in a theater, or a headlight. Unlike a targeted spotlight, a Free Spot has no target object. You can move and rotate the free spot to aim it in any direction.
To create a free spotlight:

1. On the Create panel, click Lights. Standard is the default choice of light type.
2. In the Object Type rollout, click Free Spot.
3. Click the viewport location where you want the light to be.
The light is now part of the scene. It points away from you in the viewport you clicked.

You can adjust the light's direction with Move and Rotate or by using a Light viewport.

4 Set the creation parameters.

To change a viewport to a Light view:

1 Click or right-click the POV viewport label.  
3ds Max opens the Point-Of-View viewport label menu. on page 8122.

2 Choose Lights.  
The Lights submenu shows the name of each spotlight or directional light in the scene.

3 Choose the name of the light you want.  
The viewport now shows the light's point of view. You can use the Light Viewport Controls on page 8165 to adjust the light.

The default keyboard shortcut for switching to a Light viewport is $.

Interface

You aim a free spotlight by adjusting its orientation in a scene using Move and Rotate.

The free spotlight is useful when you want a spotlight to follow a path and either don't want to bother with linking a spotlight and target to a dummy object on page 8555, or you need banking along the path.

General Parameters rollout

When you create a Free Spot light, the Targeted parameter is adjustable on the General Parameters rollout on page 5424. This is a fixed value for target lights.

Targeted When on, 3ds Max sets a point to use as an invisible target about which the Free Spot can orbit. The spinner adjusts the distance to the target. The target distance is animatable.
Target Directional Light

Create panel > Lights > Standard > Target Direct button
Create menu > Standard Lights > Target Directional Light

Directional lights cast parallel light rays in a single direction, as the sun does (for all practical purposes) at the surface of the earth. Directional lights are primarily used to simulate sunlight. You can adjust the color of the light and position and rotate the light in 3D space.

Top: Top view of a target directional light
Bottom: Perspective view of the same light

A target directional light uses a target object to aim the light.
Because directional rays are parallel, directional lights have a beam in the shape of a circular or rectangular prism instead of a "cone."

**NOTE** When you add a target directional light, 3ds Max automatically assigns a Look At controller on page 3502 to it, with the light’s target object assigned as the Look At target. You can use the controller settings on the Motion panel to assign any other object in the scene as the Look At target.

**NOTE** Direct lights are supported in a radiosity solution on page 6615 only if they are pointed downwards, outside the boundary box of the scene geometry.

See also:

- Lights on page 5314
- Name and Color Rollout (Lights) on page 5317
- General Parameters Rollout (Standard Lights) on page 5424
- Intensity/Color/Attenuation Rollout (Standard Lights) on page 5431
- Advanced Effects Rollout on page 5457
- Shadow Parameters on page 5448
- Directional Parameters on page 5436

**Procedures**

To create a target direct light:

1. On the Create panel, click Lights. Standard is the default choice of light type.
2. In the Object Type rollout, click Target Direct.
3. Drag in a viewport. The initial point of the drag is the location of the light, and the point where you release the mouse is the location of the target.
   The light is now part of the scene.
4. Set the creation parameters.
   To adjust the light’s direction, move the target object.
To change a viewport to a Light view:

1. Click or right-click the POV viewport label.
   3ds Max opens the Point-Of-View viewport label menu on page 8122.

2. Choose Lights.
   The Lights submenu shows the name of each spotlight or directional light in the scene.

3. Choose the name of the light you want.
   The viewport now shows the light's point of view. You can use the Light Viewport Controls on page 8165 to adjust the light.
   The default keyboard shortcut for switching to a Light viewport is $.

Interface

Clicking the line that connects the light and its target selects both objects. However, region selection doesn't recognize the link line.

When you rename a target directional light, the target is automatically renamed to match. For example, renaming Light01 to Sol causes Light01.Target to become Sol.Target. The target's name must have the extension .Target. Renaming the target object does not rename the light object.

Free Directional Light

Create panel > Lights > Standard > Free Direct button
Create menu > Standard Lights > Directional Light

Directional lights cast parallel light rays in a single direction, as the sun does (for all practical purposes) at the surface of the earth. Directional lights are primarily used to simulate sunlight. You can adjust the color of the light and position and rotate the light in 3D space.
Top: Perspective view of a free directional light
Bottom: Top view of the same light

Unlike a targeted directional light, a Free Direct light has no target object. You can move and rotate the light object to aim it in any direction.

A Free Direct light is used when you select a Standard sun in your Daylight system on page 5491.

Because directional rays are parallel, directional lights have a beam in the shape of a circular or rectangular prism instead of a "cone."

**NOTE** Direct lights are supported in a radiosity solution on page 6615 only if they are pointed downwards, outside the boundary box of the scene geometry.
Procedures

To create a free direct light:

1. On the Create panel, click Lights.
   Standard is the default choice of light type.
2. In the Object Type rollout, click Free Direct.
3. Click a viewport.
   The light is now part of the scene. It points away from you in the viewport you clicked.
4. Set the creation parameters.
   To adjust the light's direction, you can rotate it as you would any object.

To change a viewport to a Light view:

1. Click or right-click the POV viewport label.
   3ds Max opens the Point-Of-View viewport label menu. on page 8122.
2. Choose Lights.
   The Lights submenu shows the name of each spotlight or directional light in the scene.
3. Choose the name of the light you want.
   The viewport now shows the light's point of view. You can use the Light Viewport Controls on page 8165 to adjust the light.
The default keyboard shortcut for switching to a Light viewport is $.

**Interface**

**Directional Parameters rollout**

When you create a Free Direct light, the Targeted parameter is adjustable on the General Parameters rollout on page 5424. This is a fixed value for target lights.

**Targeted** When on, 3ds Max sets a point to use as an invisible target about which the Free Direct light can orbit. The spinner adjusts the distance to the target.

This parameter also affects the length of the light's cone display.

**Omni Light**

Create panel > Lights > Standard > Omni button
Create menu > Standard Lights > Omni Light

An Omni light casts rays in all directions from a single source. Omni lights are useful for adding "fill lighting" to your scene, or simulating point source lights.
Omni lights can cast shadows and projections. A single shadow-casting omni light is the equivalent of six shadow-casting spotlights, pointing outward from the center.

When you set a map projected by an Omni light to be projected using the Spherical, Cylindrical, or Shrink Wrap Environment coordinates, the map is projected in the same way as it would be mapped to the environment. When you use the Screen Environment coordinates or Explicit Map Channel Texture coordinates, six copies of the map are projected radially.

**TIP** Omni lights can generate up to six **quadtrees** on page 8694, so they generate ray-traced shadows more slowly than spotlights. Avoid using ray-traced shadows with omni lights unless your scene requires this.

**See also:**

- **Lights** on page 5314
- **Name and Color Rollout (Lights)** on page 5317
- **General Parameters Rollout (Standard Lights)** on page 5424
- **Intensity/Color/Attenuation Rollout (Standard Lights)** on page 5431
- **Advanced Effects Rollout** on page 5457
- **Shadow Parameters** on page 5448
Procedures

To create an omni light:

1. On the Create panel, click Lights. Standard is the default choice of light type.

2. In the Object Type rollout, click Omni.

3. Click the viewport location where you want the light to be. If you drag the mouse, you can move the light around before releasing the mouse to fix its position. The light is now part of the scene.

4. Set the creation parameters. To adjust the light's effect, you can move it as you would any object.

Skylight

Create panel > Lights > Standard > Skylight button
Create menu > Lights > Skylight

The Skylight light models daylight. It is meant for use with the Light Tracer on page 6601. You can set the color of the sky or assign it a map. The sky is modeled as a dome above the scene.
Model rendered with a single skylight, and light tracing

When you render with the default scanline renderer on page 6589, Skylight works best with advanced lighting: either the Light Tracer, or radiosity on page 6615.

**WARNING** When you render with the mental ray renderer on page 6675, objects illuminated by a Skylight appear dark unless you turn on Final Gathering on page 8576. The toggle for Final Gathering is on the Final Gather rollout on page 6760 of the Render Setup dialog.
A skylight is modeled as a dome above the scene.

**TIP** There are several ways to model daylight in 3ds Max, but if you use the Light Tracer, a Skylight often gives the best results.

**TIP** If you encounter visual anomalies when rendering a bump-mapped material with a Skylight, convert the material to an Advanced Lighting Override material on page 6166 and then reduce the Indirect Light Bump Scale value.

**Using a Map with the Skylight**

If you use a map with a Skylight, the following guidelines can improve its effect:

- Make sure that the mapping coordinates are spherical or cylindrical.
- For light tracing, make sure you use sufficient samples. A good rule of thumb is to use at least 1,000 samples: set Initial Sample Spacing to 8x8 or 4x4, and increase the value of Filter Size to 2.0.
- Use an image-processing application to blur the map before you use it. With a blurred map, you can use fewer samples to obtain good results. When used with Skylight, a blurred map will still render well.

Be aware that using sufficient samples with a mapped Skylight will take longer to render than if the light were not mapped.
Skylight and Radiosity in Architectural Design

In order for radiosity to be processed correctly when a Skylight is added to the scene, you need to make sure that walls have closed corners and floors and ceilings have thickness under and over the walls. In essence, your 3D model should be built just like the real-world structure is built.

If you build your model with walls that meet along a single edge or floors and ceilings are simple planes, when you process radiosity after adding a Skylight, you can end up with “light leaks” along those edges.

Some of the ways to repair a model so light leaks do not occur are as follows:

- Make sure floors and ceilings have thickness.
  You can fix this by extruding those surfaces at a sub-object level or by applying modifiers like Shell on page 1655 or Extrude on page 1425.

- Use the Wall command on page 491 to create walls.
  The Wall command is programmed to make sure corners are constructed of solid objects instead of leaving a single, thin edge.

- Ensure that floor and ceiling objects extend beyond walls.
  Floor objects need to extend under walls and ceilings need to extend over walls.

By building your 3D model using these guidelines, light leaks will not occur when you process radiosity after adding a Skylight to the scene.

Using Render Elements with a Skylight

If you use Render Elements on page 6807 to output the lighting element on page 6827 of a skylight in a scene using either radiosity or the light tracer, you cannot separate the direct, indirect, and shadow channels of the light. All three elements of the skylight lighting are output to the Indirect Light channel.

Procedures

To create a Skylight:

1. On the Create panel, click Lights. Standard is the default choice of light type.
2. In the Object Type rollout, click Skylight.
3. Click a viewport.
The light is now part of the scene.

NOTE The position of the Skylight, and its distance from objects, has no effect. The Skylight object is simply a helper. Skylight always comes from "overhead."

4 Set the creation parameters.

**Interface**

- **On** Turns the light on and off. When On is on, shading and rendering use the light to illuminate the scene. When off, the light is not used in shading or rendering. Default=on.

- **Multiplier** Amplifies the power of the light by a positive or negative amount. For example, if you set the multiplier on page 8649 to 2, the light will be twice as bright. Default=1.0.

  Using this parameter to increase intensity can cause colors to appear "burned out." It can also generate colors not usable in videos. In general, leave Multiplier set to its default of 1.0 except for special effects and special cases.
**Sky Color group**

**Use Scene Environment** Colors the light using the environment set up on the Environment panel on page 7163. This setting has no effect unless light tracing is active.

**Sky Color** Click the color swatch to display a Color Selector on page 371 and choose a tint for the Skylight.

**Map controls** These let you use a map to affect Skylight color. The button assigns a map, the toggle sets whether the map is active, and the spinner sets the percentage of the map to use (when the value is less than 100%, map colors are mixed with the Sky Color).

**TIP** For best results, use an HDR File on page 7866 for illumination.

The map has no effect unless light tracing is active.

**Render group**

**NOTE** If the renderer is not set to Default Scanline, or if the Light Tracer is active, these controls are disabled.

**Cast Shadows** Causes the skylight to cast shadows. Default=off.

**NOTE** The Cast Shadows toggle has no effect when using radiosity or the light tracer.

**NOTE** Skylight objects will not cast shadows in an ActiveShade rendering on page 6550.

**Rays per Sample** The number of rays used to calculate skylight falling on a given point in the scene. For animation, you should set this to a high value to eliminate flickering. A value of around 30 should eliminate flickering.
Increasing the number of rays increases the quality of your image. However, it also increases rendering time.

**Ray Bias** The closest distance at which objects can cast shadows on a given point in the scene. Setting this value to 0 can cause the point to cast shadows upon itself, and setting it to a large value can prevent objects close to a point from casting shadows on the point.

**mr Area Omni Light**

Create panel > Lights > mr Area Omni button > Area Light Parameters rollout

When you render a scene using the mental ray renderer on page 6675, an area omni light emits light from a spherical or cylindrical volume, rather than from a point source. With the default scanline renderer, the area omni light behaves like any other standard omni light.

**NOTE** In 3ds Max, area omni lights are created and supported by a MAXScript script. Only the mental ray renderer uses the parameters on the Area Light Parameters rollout. See Enhancements to Standard Features on page 6686 for more details.

**TIP** Area lights take longer to render than point lights. To create a quick test (or draft) rendering, you can use the Area/Linear Lights as Point Lights toggle in the Common Parameters rollout on page 6568 of the Render Setup dialog to speed up your rendering.
Procedures

To create an area omni light:

1. On the Create panel, click Lights.
2. On the Object Type rollout, click mr Area Omni.
3. Click in a viewport.
4. Set the shape and size of the area light in the Area Light Parameters rollout.
   While you use the spinners to adjust the size of the area light, a gizmo (yellow by default) appears in viewports to show the adjusted size. This gizmo disappears once you finish adjusting the value.

   TIP: You can use Rotate to adjust the orientation of a cylindrical area omni light. However, no gizmo appears while you rotate the light.

To convert a standard 3ds Max light to an area light:

1. Select one or more lights.
2. Go to the Utilities panel.
3. On the Utilities rollout, click MAXScript.
   The MAXScript rollout is displayed.
4. On the MAXScript rollout, choose “Convert To mr Area Lights” from the Utilities drop-down list.
   The “Convert To mr Area Lights” rollout is displayed.
5. On the “Convert To mr Area Lights” rollout, click Convert Selected Lights.
   A MAXScript alert is displayed, that says "Delete Old Lights?" Click Yes to delete the original light and replace it with the area light. Click No to leave the original light in place. If you click No there are now two lights in the scene: the original light, and the area light based on it.
6 Click Close to dismiss the “Convert To mr Area Lights” and MAXScript rollouts.

**Interface**

<table>
<thead>
<tr>
<th>Area Light Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>On</strong></td>
</tr>
<tr>
<td><strong>Show Icon in Renderer</strong></td>
</tr>
<tr>
<td><strong>Type:</strong> Sphere</td>
</tr>
<tr>
<td><strong>Radius:</strong> 20.0</td>
</tr>
<tr>
<td><strong>Height:</strong> 20.0</td>
</tr>
<tr>
<td><strong>Samples:</strong></td>
</tr>
<tr>
<td>U: 5</td>
</tr>
<tr>
<td>V: 5</td>
</tr>
</tbody>
</table>

**On** Turns the area light on and off. When On is on, the mental ray renderer uses the light to illuminate the scene. When On is off, the mental ray renderer doesn’t use the light. Default=on.

**Show Icon in Renderer** When on, the mental ray renderer renders a dark shape at the light's location. When off, the area light doesn't render. Default=off.

**Type** Changes the shape of the area light. The choices are Sphere, for a spherical volume, and Cylinder, for a cylindrical volume. Default=Sphere.

**TIP** You can use Rotate to adjust the orientation of a cylindrical area omni light. However, no gizmo appears while you rotate the light.

**Radius** Sets the radius of the sphere or cylinder, in 3ds Max units. Default=20.0.

**Height** Available only when Cylinder is the active type of area light. Sets the height of the cylinder, in 3ds Max units. Default=20.0.

As you use these spinners to adjust the size of the area light, a gizmo appears in viewports to show the adjusted size. This gizmo disappears once you finish adjusting the value.
Samples group

**U and V** Adjust the quality of shadows cast by the area light. These values specify how many samples to take within the light’s area. Higher values can improve rendering quality at a cost of rendering time. For a spherical light, U specifies the number of subdivisions along the radius, and V specifies the number of angular subdivisions. For a cylindrical light, U specifies the number of sampled subdivisions along the height, and V specifies the number of angular subdivisions. Default=5 for both U and V.

**mr Area Spotlight**

Create panel > Lights > mr Area Spot button > Area Light Parameters rollout

When you render a scene using the mental ray renderer on page 6675, an area spotlight emits light from a rectangular or disc-shaped area, rather than from a point source. With the default scanline renderer, the area spotlight behaves like any other standard spotlight.

**NOTE** In 3ds Max, area spotlights are created and supported by a MAXScript script. Only the mental ray renderer uses the parameters in the Area Light Parameters rollout. See Enhancements to Standard Features on page 6686 for more details.

**TIP** Area lights take longer to render than point lights. To create a quick test (or draft) rendering, you can use the Area/Linear Lights as Point Lights toggle on the Common Parameters rollout on page 6568 of the Render Setup dialog to speed up your rendering.

See also:

- mr Area Omni Light on page 5418

Procedures

To create an area spotlight:

1. Go to the Create panel and click Lights.
2. On the Object Type rollout, click mr Area Spot.
3 Drag in a viewport. The initial point of the drag is the location of the light, and the point where you release the mouse is the location of the target.

The mental ray renderer will ignore the spotlight cone, but the location of the spotlight target determines the orientation of the plane of the area light, and the direction in which it's projected.

4 Set the shape and size of the area light in the Area Light Parameters rollout.

While you use the spinners to adjust the size of the area light, a gizmo (yellow by default) appears in viewports to show the adjusted size. This gizmo disappears once you finish adjusting the value.

To convert a standard 3ds Max light to an area light:

1 Select one or more lights.

2 Go to the Utilities panel.

3 On the Utilities rollout, click MAXScript.
   The MAXScript rollout is displayed.

4 On the MAXScript rollout, choose Convert To Area Lights from the Utilities drop-down list.
   The Convert To Area Lights rollout is displayed.

5 On the Convert To Area Lights rollout, click Convert Selected Lights. A MAXScript alert is displayed, that says "Delete Converted Lights?" Click Yes to delete the original light and replace it with the area light. Click No to leave the original light in place. If you click No there are now two lights in the scene: the original light, and the area light based on it.

6 Click Close to dismiss the Convert To Area Lights and MAXScript rollouts.
Interface

On Turns the area light on and off. When On is on, the mental ray renderer uses the light to illuminate the scene. When On is off, the mental ray renderer doesn’t use the light. Default=on.

Show Icon in Renderer When on, the mental ray renderer renders a dark shape where the area light is. When off, the area light is invisible. Default=off.

Type Changes the shape of the area light. Can be either Rectangle, for a rectangular area, or Disc, for a circular area. Default=Rectangle.

Radius Available only when Disc is the active type of area light. Sets the radius of the circular light area, in 3ds Max units. Default=20.0.

Height and Width Available only when Rectangle is the active type of area light. Set the height and width of the rectangular light area, in 3ds Max units. Default=20.0 for both Height and Width.

While you use these spinners to adjust the size of the area light, a gizmo (yellow by default) appears in viewports to show the adjusted size. This gizmo disappears once you finish adjusting the value.

Samples group

U and V Adjust the quality of shadows cast by the area light. These values specify how many samples to take within the light’s area. Higher values can improve rendering quality at a cost of rendering time. For a rectangular light, U specifies the number of sampled subdivisions in one local dimension, and V the number of subdivisions in the other local dimension. For a circular (disc)
light, U specifies the number of subdivisions along the radius, and V specifies the number of angular subdivisions. Default=5 for both U and V.

Rollouts for Standard Lights

The topics in this section describe rollouts whose controls are specific to standard lights.

See also:
- Name and Color Rollout (Lights) on page 5317
- Common Lighting Rollouts and Dialogs on page 5445
- Shadow Types and Shadow Controls on page 5466

General Parameters Rollout (Standard Lights)

Create panel > Lights > Standard Lights > Create a standard light. > General Parameters rollout

Create panel > Lights > Standard Lights > Create a standard light. > General Parameters rollout

This General Parameters rollout is displayed for standard lights. These controls turn a light on and off, and exclude or include objects in the scene.

On the Modify panel, the General Parameters rollout also lets you control the light's target object and change the light from one type to another.

The General Parameters rollout also lets you turn shadow-casting on or off for the light, and choose which type of shadow the light uses. See Shadow Types and Shadow Controls on page 5466 and Shadow Parameters on page 5448.

Procedures

To turn a light on and off:
- Turn the On toggle on or off.
  Default=on.
TIP To make a standard light flash on and off, set its Multiplier parameter to 0 in repeated keyframes, and assign a step tangent on page 3420 to this parameter.

To have a light cast shadows:

- In the General Parameters rollout > Shadows group, make sure On is selected.

The light will now cast shadows when you render the scene.

Left: A spotlight’s projection cone truncates shadows.
Right: An omni light casts complete shadows.

NOTE With Overshoot turned on, standard spotlights cast light in all directions but cast shadows only within the falloff cone; standard directional lights cast light throughout the scene, but cast shadows only within the falloff area.

To have a light use the global settings for shadows:

- On the General Parameters rollout, turn on Use Global Settings. When Use Global Settings is on, the other shadow controls are set to the values used by all other shadow-casting lights in the scene that have Use Global Settings set.

Changing the affected parameters for one light with Use Global Settings set, changes them for all lights with Use Global Settings set.

To set a light’s shadow parameters individually:

- On the General Parameters rollout, turn off Use Global Settings. The settings revert to the individual settings for the light.
By default, Shadow Map is the active shadow type. In the Shadow Map Params rollout on page 5486, the default settings are: Map Bias=1; Size=512; Sample Range=4.0; Absolute Map Bias=Off.

Scene with shadow-mapped shadows

Shadows rendered using default parameter settings

NOTE When you render a scene, you can turn rendering of shadows on or off.

To cast area shadows:

■ On the General Parameters rollout, choose Area Shadows from the drop-down list.
  Use controls on the Area Shadows rollout on page 5472 to adjust the shadow properties.

To cast advanced ray-traced shadows:

Advanced ray-traced shadows are similar to ray-traced shadows, however they provide control over antialiasing on page 8501, letting you fine-tune how shadows are generated.

■ On the General Parameters rollout, choose Advanced Ray-traced Shadows from the drop-down list.
  Use controls on the Advanced Ray-traced Params rollout on page 5468 to adjust the shadow properties.
To cast shadow-mapped shadows:

1. On the General Parameters rollout, choose Shadow Maps from the drop-down list.
2. Go to the Shadow Map Params rollout on page 5486.
   - Use the Size spinner to set the size of the shadow map.
   - Use the Bias spinner to adjust the shadow offset, if necessary.
   - Use the Sample Range spinner to create a soft-edged shadow.

To cast ray-traced shadows:

Ray-traced shadows on page 8696 are generated by tracing the path of rays sampled from a light source. Ray-traced shadows are more accurate than shadow-mapped shadows.

1. On the General Parameters rollout, choose Ray-Traced Shadows from the drop-down list.
2. Use controls on the Ray Traced Shadow Params rollout on page 5484 to adjust the shadow offset, if necessary.

To keep an object from casting shadows:

1. Select the object.
2. Right-click the object to display the quad menu and choose Properties from the Transform quadrant.
   The Object Properties dialog on page 283 is displayed.
3. Turn off Cast Shadows, and then click OK.
   Now when you render the scene, the object casts no shadows.

To make an object not receive shadows:

1. Select the object.
2. Right-click the object to display the quad menu and choose Properties from the lower-right (Transform) quadrant.
   The Object Properties dialog on page 283 is displayed.
3. Turn off Receive Shadows, and then click OK.
   Now when you render the scene, the object receives no shadows.
NOTE You can also prevent objects from casting shadows by excluding them from a light.

Interface

Light Type group (Modify panel)

On (Both Create panel and Modify panel) Turns the light on and off. When On is on, shading and rendering use the light to illuminate the scene. When On is off, the light is not used in shading or rendering. Default=on.

In viewports, the interactive renderer shows the effect of turning lights on or off.

Light Type List Changes the type of the light. If you have selected a standard light type on page 5398, the light can be changed to an omni, spot, or directional light. If you have selected a photometric light type on page 5348, you can change the light to a point, linear, or area light.

This parameter is available only in the Modify panel.

Targeted When on, the light is targeted. The distance between the light and its target is displayed to the right of the check box. For a free light, you can set this value. For target lights, you can change it by turning off the check box, or by moving the light or the light's target object.
Shadows group

On Determines whether the current light casts shadows or not. Default=on.

Shadow Method drop-down list Determines whether the renderer uses shadow maps on page 8719, ray-traced shadows on page 8696, advanced ray-traced shadows on page 8696, or area shadows on page 8510, to generate shadows for this light.

The “mental ray Shadow Map” type is provided for use with the mental ray renderer on page 6675. When you choose this shadow type and enable shadow maps (on the Shadows & Displacement rollout on page 6756 of the Render Setup dialog), shadows use the mental ray shadow-map algorithm. If this type is chosen but you render with the default scanline renderer, no shadows appear in the rendering.

NOTE When shadow maps are enabled and the shadow map type is Shadow Map, the mental ray renderer attempts to translate the shadow map settings into comparable settings for mental ray shadow maps. (The results might not be what you expected.) In all other cases, the mental ray renderer generates ray-traced shadows.

Each shadow type has its particular controls:

■ Advanced ray-traced shadows See Advanced Ray-Traced Parameters Rollout on page 5468 and Optimizations Rollout on page 5479.

■ Area shadows See Area Shadows Rollout on page 5472 and Optimizations Rollout on page 5479.

■ mental ray shadow maps See mental ray Shadow Map Rollout on page 5482.

■ Ray-traced shadows See Ray-Traced Shadow Parameters Rollout on page 5484.

■ Shadow maps See Shadow Map Parameters Rollout on page 5486.

TIP Use ray-traced or advanced ray-traced shadows when you want shadows cast by opacity-mapped objects. Shadow-mapped shadows don't recognize the transparent portions of the mapping, and as a result they don't look convincing.

Use Global Settings Turn on to use global settings for shadows cast by this light. Turn off to enable individual control of the shadows. If you choose not to use the global settings, you must choose which method the renderer will use to generate shadows for this particular light.

Standard Lights | 5429
When Use Global Settings is on, the shadow parameters switch over to show you what the global settings are. This data is shared by every other light of this class. When Use Global Settings is off, the shadow parameters are specific to that particular light.

**Exclude button** Excludes selected objects from the effects of the light. Click this button to display the *Exclude/Include dialog* on page 5445. Excluded objects still appear lit in shaded viewports. Exclusion takes effect only when you render the scene.

**Roll Angle Manipulator**

To change the roll angle of a target light, you can use a manipulator. This can be useful if the light does not cast a round beam, or if it is a projector light (see *Advanced Effects Rollout* on page 5457). To display the manipulator, select the light, right-click it, and then click Roll Angle Manipulator Toggle on the Tools 2 (lower left) quadrant of the quad menu.

Drag the circular portion of the manipulator to rotate the light by an arbitrary number of degrees. Click one of the red or green “clock hands” of the manipulator to rotate the light in 90-degree increments.
NOTE You can also access the roll angle manipulator by selecting the light object and then turning on Select And Manipulate on page 2838 on the main toolbar.

Intensity/Color/Attenuation Rollout (Standard Lights)

Create panel > Lights > Create a Standard light. > Attenuation Parameters rollout

The Intensity/Color/Attenuation rollout allows you to set the color and intensity of your light. You can also define the attenuation of your light.

Attenuation settings cause distant objects to be dimmer.

Attenuation on page 8513 is the effect of light diminishing over distance. In 3ds Max, you can set attenuation values explicitly. The effects can vary from real-world lights, giving you more direct control over how lights fade in or fade out.

NOTE With no attenuation, an object can paradoxically appear to grow brighter as it moves away from the light source. This is because the angle of incidence more closely approaches 0 degrees for more of the object’s faces.

Two sets of values control attenuation for objects. The Far attenuation value sets the distance at which the light drops off to zero. The Near attenuation value sets the distance at which the light "fades in." Both these controls are turned on and off by a toggle called Use.
When Use is set for far attenuation, the light at its source uses the value specified by its color and multiplier controls. It remains at this value from the source to the distance specified by Start, then its value drops off to zero at the distance specified by End.

![Adding attenuation to a scene](image)

Adding attenuation to a scene

When Use is set for Near attenuation, the light value remains at zero up to the distance specified by Start. From Start to the distance specified by End, its value increases. Beyond End, the light remains at the value specified by the color and multiplier controls, unless far attenuation is also active.

You can’t set the Near and Far attenuation distances so they overlap.

The Decay controls are an additional way to make a light fade out.

**TIP** When lights are attenuated, the light might be too bright on near surfaces or too dim on far surfaces. If you see this in renderings, exposure control can help correct the problem. It adjusts the larger dynamic range of the (simulated) physical scene, into the smaller dynamic range of the display. See Environment Panel on page 7163 for additional information on exposure control.

**Procedures**

To choose the color of a light using the color selector:

1. Click the color swatch next to the On check box.
   A modal Color Selector on page 371 is displayed.

2. Use the Color Selector to choose a new color, and then click OK.
   Shaded viewports update to show the new light color, which also appears in renderings.
To change a light's intensity:

- Increase the light's Multiplier value.

To use attenuation:

1. Set the Start and End values.
2. Turn on Use.
   
   Attenuation is now in effect for this light when the scene is shaded or rendered.

   **NOTE** You can also change the decay type (and values) to reduce the light's intensity over distance.

To see the attenuation range in viewports:

- Set Show for far or near attenuation.
  
  You can preview the effect of attenuation in shaded viewports only if you turn this on as an option in viewport preferences on page 8308.

### Interface

![Intensity/Color/Attenuation Interface](image)
**Multiplier** Amplifies the power of the light by a positive or negative amount. For example, if you set the multiplier on page 8649 to 2, the light will be twice as bright. A negative value subtracts light and thus is useful for selectively placing dark areas in the scene. Default=1.0.

Using this parameter to increase intensity can cause colors to appear "burned out." It can also generate colors not usable in videos. In general, leave Multiplier set to its default of 1.0 except for special effects and special cases.

High Multiplier values wash out colors. For example, if you set a spotlight to be red but then increase its Multiplier to 10, the light is white in the hotspot and red only in the falloff area, where the Multiplier isn't applied.

Negative Multiplier values result in "dark light." That is, the light darkens objects instead of illuminating them.

**Color Swatch** Shows the color of the light. Clicking the color swatch displays the Color Selector on page 371 so you can choose a color for the light.

**Decay group**

Decay is an additional way to make a light's intensity reduce over distance.

**Type** Sets the type of decay to use. There are three types to choose from.
- **None** (The default.) Applies no decay. The light maintains full strength from its source to infinity, unless you turn on far attenuation.
- **Inverse** Applies inverse decay. The formula is luminance=R₀ /R, where \( R₀ \) is the radial source of the light if no attenuation is used, or the Near End value of the light if attenuation is used. \( R \) is the radial distance of the illuminated surface from \( R₀ \).
- **Inverse Square** Applies inverse-square decay. The formula for this is \((R₀ /R)^2\). This is actually the "real-world" decay of light, but you might find it too dim in the world of computer graphics. This is the decay formula used by photometric lights on page 5348.

**TIP** If Inverse Square decay makes the scene too dim, you can try using the Environment Panel on page 7163 to increase the Global Lighting Level value.

The point at which decay begins depends on whether or not you use attenuation:
- With no attenuation, decay begins at the source of the light.
- With near attenuation, the decay begins at the Near End position.
Once the beginning point is established, the decay follows its formula to infinity, or until the light itself is cut off by the Far End distance. In other words, the distance between Near End and Far End does not scale, or otherwise affect, the apparent ramp of decaying light.

**TIP** Because decay continues to calculate dimmer and dimmer values as the distance of the light throw increases, it’s a good idea to set at least the Far End of attenuation to eliminate unnecessary calculations.

Near Attenuation group

**Start** Sets the distance at which the light begins to fade in.

**End** Sets the distance at which the light reaches its full value.

**Use** Enables near attenuation for the light.

**Show** Displays the near attenuation range settings in viewports. For spotlights, attenuation ranges appear as lens-shaped sections of the cone. For directional lights, the ranges appear as circular sections of the cone. For omni lights and spot or directional lights with Overshoot turned on, the ranges appear as spheres. By default, Near Start is dark blue and Near End is light blue.

**NOTE** The attenuation ranges are always visible when a light is selected, so turning off this check box has no apparent effect until you deselect the light.

Far Attenuation group

Setting a Far Attenuation range can help improve rendering time dramatically.

**TIP** If your scene has a large number of lights, use Far Attenuation to limit the portion of the scene each light illuminates. For example, if an office area has rows of overhead lights, you could set Far Attenuation ranges to keep the lights’ illumination from being calculated when you render the reception area instead of the main office. As another example, a staircase might have recessed lights on each stair, as many theaters do. Setting a small Far Attenuation value for these lights can prevent their (negligible) illumination from being calculated when you render the theater as a whole.

**Start** Sets the distance at which the light begins to fade out.

**End** Sets the distance at which the light has faded to zero.

**Use** Enables far attenuation for the light.
Show Displays the far attenuation range settings in viewports. For spotlights, attenuation ranges appear as lens-shaped sections of the cone. For directional lights, the ranges appear as circular sections of the cone. For omni lights and spot or directional lights with Overshoot turned on, the ranges appear as spheres. By default, Far Start is light brown and Far End is dark brown.

**NOTE** The attenuation ranges are always visible when a light is selected, so turning off this check box has no apparent effect until you deselect the light.

### Directional Parameters

Create a standard Target Direct or Free Direct light. > Directional Parameters rollout

The Directional Parameters rollout appears when you create or select a target direct on page 5405 or free direct on page 5407 light. These parameters control hotspots on page 8604 and falloff on page 8604.

### Procedures

**To see the directional cone in viewports:**

The cone is always visible while the light is selected. This setting keeps the cone visible when the light is unselected.

1. Select the spotlight.
2. In the Directional Parameters rollout > Light Cone group, turn on Show Cone.
3. Select another object, deselecting the light.

A wireframe outline of the light’s cone appears. The hotspot region is outlined in light blue, and the falloff region is outlined in dark gray. The cone is always visible while the light is selected.

**Tip** The hotspot and falloff borders are not visible in shaded viewports. Use the cone values to adjust hotspot and falloff in the viewport. Render the scene to see the full effect of the light’s border.
To adjust the hotspot and falloff:

- Use the Hotspot and Falloff spinners to increase or decrease the size of the hotspot and falloff regions. For directional lights, Hotspot and Falloff are expressed in units.
  
  By default, the falloff value is always constrained to be at least two degrees or two units greater than the hotspot value. The size of this constraint is a preference that you can change in the Rendering panel on page 8342 of the Preferences dialog. The falloff value can range from 0 to 10,000 units. When the hotspot and falloff values are equal, the light casts a hard-edged beam.

To set the shape of the light beam:

1. Choose either Rectangle or Circle.
   
   The shape of the light's cone changes to reflect the shape you chose.

2. If you chose Circle, you are done. If you chose Rectangle, you can now adjust the aspect ratio on page 8511 of the rectangular light using the spinner labeled Aspect.

To change a rectangular light's aspect ratio:

1. Choose Rectangle, as described above.

2. Change the Aspect value to the aspect ratio that you want.
   
   The Bitmap Fit button is another way to set the aspect ratio. It is mainly used with projections.
Interface

Light Cone group

These parameters control hotspots on page 8604 and falloff on page 8604 for spotlights.

**Show Cone** Turns display of the cone on or off.

**NOTE** The cone is always visible when a light is selected, so clearing this check box has no apparent effect until you deselect the light.

**Overshoot** When Overshoot on page 8672 is set, the light casts light in all directions. However, projections and shadows occur only within its falloff cone.

**Hotspot/Beam** Adjusts the size of a light's cone. The Hotspot value is measured in 3ds Max units. Default=43.0.

**Falloff/Field** Adjusts the size of a light's falloff. The Falloff value is measured in 3ds Max units. Default=45.0.

You can also adjust hotspot and falloff angles in a Light viewport on page 5439 (looking at the scene from the point of view of the spotlight).

**Circle/Rectangle** Determine the shape of the falloff and hotspot areas. Set Circle when you want a standard, circular light. Set Rectangle when you want a rectangular beam of light, such as light cast through a window or doorway.

**Aspect** Sets the aspect ratio on page 8511 for the rectangular light beam. The Bitmap Fit button lets you make the aspect ratio match a specified bitmap. Default=1.0.
**Bitmap Fit** If the light's projection aspect is rectangular, sets the aspect ratio to match a particular bitmap. This is useful when you are using the light as a projector light on page 8693.

**Spotlight Parameters**

Create a standard Target Spotlight or Free Spotlight. > Spotlight Parameters rollout

The Spotlight Parameters rollout appears when you create or select a Target Spot on page 5399 or Free Spot on page 5402.

**Procedures**

To see the spotlight cone in viewports:

The cone is always visible while the light is selected. This setting keeps the cone visible when the light is unselected.

1. Select the spotlight.
2. In the Spotlight Parameters rollout > Light Cone group, turn on Show Cone.
3. Select another object, deselecting the light. A wireframe outline of the light's cone appears. The hotspot region is outlined in light blue, and the falloff region is outlined in dark gray.
To adjust the hotspot and falloff, do one of the following:

- Use the Hotspot and Falloff spinners to increase or decrease the size of the hotspot and falloff regions. For spotlights, Hotspot and Falloff are expressed in degrees.

- Use manipulators to adjust hotspot and falloff by dragging in a viewport, as described in the procedure that follows.

By default, falloff value is always constrained to be at least two degrees or two units greater than the hotspot value. The size of this constraint is a preference that you can change in the Rendering panel on page 8342 of the Preferences dialog. The falloff value can range from 0 to 10,000 units.

When the hotspot and falloff values are close in value, the light casts a hard-edged beam.

To use manipulators to control hotspot and falloff:

1. Select the spotlight.
TIP When you select multiple spotlights, all their manipulators are accessible.

2 On the default main toolbar, click to turn on Select And Manipulate.
Now when you move the mouse over the hotspot or falloff circle, the circle turns red to show you can adjust it by dragging. Also, a tooltip displays the spotlight name, the parameter, and its value.

3 Drag the hotspot or falloff circle to adjust the value.
The hotspot and falloff constrain each other, as their spinner controls do.
Spotlight manipulators are described at the end of this topic.

To set the shape of the light beam:

1 Choose either Rectangle or Circle.
The shape of the light's cone changes to reflect the shape you chose.

2 If you chose Circle, you are done. If you chose Rectangle, you can now adjust the aspect ratio on page 8511 of the rectangular light in the Aspect field.

To change a rectangular light's aspect ratio:

1 Choose Rectangle, as described above.

2 Change the Aspect value to the aspect ratio that you want.
The Bitmap Fit button is another way to set the aspect ratio. It is mainly used with projections.
Interface

Light Cone group

These parameters control hotspots and falloff on page 8604 for spotlights.

Show Cone

Turns display of the cone on or off.

**NOTE** The cone is always visible when a light is selected, so turning off this check box has no apparent effect until you deselect the light.

Overshoot

When Overshoot on page 8672 is on, the light casts light in all directions. However, projections and shadows occur only within its falloff cone.

Hotspot/Beam

Adjusts the angle of a light's cone. The Hotspot value is measured in degrees. Default=43.0.

Falloff/Field

Adjusts the angle of a light's falloff. The Falloff value is measured in degrees. Default=45.0.

For photometric lights, the Field angle is comparable to the Falloff angle. It is the angle at which the light's intensity has fallen to zero.

You can manipulate the hotspot and falloff by dragging manipulators in viewports, as described in the previous procedures, and the later section "Manipulators for Spotlights."

You can also adjust hotspot and falloff angles in a Light viewport (looking at the scene from the point of view of the spotlight).
Circle/Rectangle  Determine the shape of the falloff and hotspot areas. Set Circle when you want a standard, circular light. Set Rectangle when you want a rectangular beam of light, such as light cast through a window or doorway.

Aspect  Sets the aspect ratio on page 8511 for the rectangular light beam. The Bitmap Fit button lets you make the aspect ratio match a specified bitmap. Default=1.0.

Bitmap Fit  If the light's projection aspect is rectangular, sets the aspect ratio to match a particular bitmap. This is useful when you are using the light as a projector light on page 8693.

Manipulators for Spotlights

Manipulators are visible and usable while the Select And Manipulate button on page 2838 is turned on. This button is on the default main toolbar on page 8034. When you move the mouse over a manipulator, the manipulator turns red to show that dragging or clicking it will have an effect. Also, a tooltip appears, showing the name of the object, the parameter, and its value.

TIP  When you select multiple spotlights, all their manipulators are accessible.

For more information on using the spotlight manipulators, see the Procedures section at the top of this topic.

Hotspot manipulator: In a viewport, drag the hotspot circle to adjust the hotspot value.

Falloff manipulator: In a viewport, drag the falloff to adjust the falloff value.

The hotspot and falloff constrain each other, as their spinner controls do.

Hair Light Attr(ributes) Rollout

Add a supported light. > Select an object with the Hair And Fur modifier applied. > Render Settings > Effects panel > Select the light (in a viewport). > Hair And Fur rollout > Lighting group > Click Add Hair Properties. > Modify panel > Hair Light Attr rollout

Add a supported light and an object with the Hair And Fur modifier applied. > Rendering menu > Effects > Highlight the Hair And Fur render effect. > Hair And Fur rollout > Lighting group > Select the light (in a viewport). > Click Add Hair Properties. > Modify panel > Hair Light Attr rollout

Standard Lights | 5443
The Hair Light Attr(ibutes) rollout lets you adjust properties for the hair shadow map generated by the light. This rollout appears for supported lights at render time. If you want to adjust a light’s hair settings before render time, you can display it explicitly by following the steps shown in the path annotations at the beginning of this topic.

You specify which lights to use in the Hair And Fur render effect on page 7061. By default, Use All Lights At Render Time on page 7067 is on, so all supported lights in the scene can illuminate hair. Use this rollout to set hair-specific shadow-map values. Hair shadows ignore the light's ordinary shadow-map settings (for other 3ds Max objects).

**IMPORTANT** The settings on this rollout apply only to “buffer”-rendered hair (the default rendering method, set in the Hair And Fur render effect). The “geometry” and “mr prim” methods use the light's ordinary shadow settings.

**Interface**

<table>
<thead>
<tr>
<th>Light hair</th>
<th>Resolution</th>
<th>Fuzz</th>
</tr>
</thead>
<tbody>
<tr>
<td>☑</td>
<td>512</td>
<td>4.0</td>
</tr>
</tbody>
</table>

**Light hair** When on, the light can illuminate and cast shadows from the hair.

**NOTE** The light must also be set to cast shadows (General Parameters rollout > Shadows > On).

**Resolution** Sets the size (in pixels squared) of the shadow map that's computed for the light.

The shadow map size specifies the amount of subdivisions for the map. The higher the value, the more detailed the map will be, but the more memory is required.

**Fuzz** Sets the softness of the shadow edges. See Sample Range on page 8704.
Common Lighting Rollouts and Dialogs

The topics in this section describe rollouts and dialogs whose controls are common to both photometric and standard lights.

See also:

- Name and Color Rollout (Lights) on page 5317
- Rollouts for Photometric Lights on page 5355
- Rollouts for Standard Lights on page 5424
- Shadow Types and Shadow Controls on page 5466

Exclude/Include Dialog

Create a light. > General Parameters rollout > Exclude button

Rendering menu > Render > Render Setup dialog > Render Elements panel > Render Elements rollout > Add button > Render Elements dialog > Select an existing Matte element in the list. > Matte Texture Element rollout > Include button
The Exclude/Include dialog determines which objects are not illuminated by a selected light, or which objects are considered in a Matte render element on page 6807.

Although light exclusion does not occur in nature, this feature is useful when you need exact control over the lighting in your scene. Sometimes, for example, you'll want to add lights specifically to illuminate a single object but not its surroundings, or you'll want a light to cast shadows from one object but not from another.

**Procedures**

**To exclude objects from a light:**

1. In the General Parameters rollout, click Exclude. The Exclude/Include dialog is displayed.
2. Make sure Exclude is on.
3. Choose to exclude objects from Illumination, Shadow Casting, or Both.
4. In the list of object names on the left, highlight the objects you want to exclude.
5. Click the arrow pointing to the right to move the selected object names into the right-hand list. Objects in the right-hand list will be excluded. To remove an object from this list, highlight its name and click the arrow pointing to the left. To remove all objects from this list, click Clear.
6. Click OK.
   - Now when you shade or render the scene, the light will have no effect on the objects you chose.
   - The object still appears lit in shaded viewports. Exclusion takes effect only when you render the scene.

**To include objects that were excluded:**

1. Click Exclude.
   - The Exclude/Include dialog is displayed.
2. Select the names of objects in the right-hand list, and then click the arrow pointing to the left.
3. Click OK.
To include all excluded objects at once:

1. Click Exclude or Include.
   The Exclude/Include dialog is displayed.

2. Click Clear.

3. Click OK.

**Interface**

The Exclude/Include dialog contains the following controls:

- **Exclude/Include** Determines whether the light (or Matte render element) will exclude or include the objects named in the list on the right.

- **Illumination** Excludes or includes illumination of the object’s surface.

  **NOTE** This control has no effect on the matte render element.
Shadow Casting  Excludes or includes creation of the object's shadow.

**NOTE** This control is not available with the matte render element.

**Both**  Excludes or includes both of the above.

**NOTE** This control is not available with the matte render element.

Scene Objects  Select objects from the Scene Objects list on the left, then use the arrow buttons to add them to the exclusion list on the right.

The Exclude/Include dialog treats a group as an object. You can exclude or include all objects in a group by selecting the group's name in the Scene Objects list. If a group is nested within another group, it isn't visible in the Scene Objects list. To exclude a nested group or individual objects within the group, you have to ungroup them before you use this dialog.

Search field  The edit box below the Scene Objects list searches for objects by name. You can enter names that use wildcards.

Display Subtree  Indents the Scene Objects list according to the object hierarchy.

Case Sensitive  Uses case sensitivity when searching object names.

Selection Sets  Displays a list of named selection sets on page 217. Choosing a selection set from this list selects those objects in the Scene Objects list.

Clear  Clears all entries from the Exclude/Include list on the right.

**Shadow Parameters**

Create panel > Lights > Create a light. > Shadow Parameters rollout

The Shadow Parameters rollout is displayed for all light types except Skylight and IES Sky, and for all shadow types. It lets you set shadow colors and other general shadow properties.
A bridge’s shadow cast by sunlight

The controls also let atmospheric effects cast shadows.

See also:

- Advanced Ray-Traced Parameters Rollout on page 5468
- Area Shadows Rollout on page 5472
- mental ray Shadow Map Rollout on page 5482
- Optimizations Rollout on page 5479
- Ray-Traced Shadow Parameters Rollout on page 5484
- Shadow Map Parameters Rollout on page 5486
Interface

Color Displays a Color Selector on page 371 to choose a color for the shadows cast by this light. Default=black.
You can animate the shadow color.

Dens. (density) Adjusts the density of shadows.
The shadow density increases from right to left.

Increasing the Density value increases the density (darkness) of shadows. Decreasing Density makes shadows less dense. Default=1.0.

Density can have a negative value, which can help simulate the effect of reflected light. A white shadow color and negative Density render dark shadows, though the quality of these is not as good as a dark shadow color and positive Density.

You can animate the Density value.

**Map check box** Turn on to use the map assigned with the Map button. Default=off.

**Map** Assigns a map to the shadows. The map's colors are blended with the shadow color. Default=none.

**Light Affects Shadow Color** When on, blends the light's color with the shadow color (or shadow colors, if the shadow is mapped). Default=off.
A checker map is used to alter the shadow cast by the piano.

**Atmosphere Shadows group**

These controls let atmospheric effects such as Volume Fog on page 7188 cast shadows.

**On** When on, atmospheric effects cast shadows as the light passes through them. Default=off.

**NOTE** This control is independent of the On toggle for normal Object Shadows. A light can cast atmospheric shadows but not normal shadows, or vice versa. It can cast both kinds of shadows, or neither.

**Opacity** Adjusts the opacity of the shadows. This value is a percentage. Default=100.0.

**Color Amount** Adjusts the amount that the atmosphere's color is blended with the shadow color. This value is a percentage. Default=100.0.
Atmospheres and Effects for Lights

Modify panel > Select light object. > Atmospheres & Effects rollout

The Atmospheres & Effects rollout lets you assign, delete, and set up parameters for atmospheres and rendering effects associated with the light. This rollout appears only in the Modify panel; it doesn’t appear at creation time.

Adding an atmosphere or effect associates that atmosphere or effect with the light object. This rollout is a shortcut to either the Environment panel on page 7163 or the Effects panel on page 7058 on the Environment And Effects dialog.

Procedures

To add a new atmosphere or rendering effect:

1. In the Atmospheres & Effects rollout, click Add. This displays the Add Atmosphere or Effect dialog on page 5455.
2 In the dialog, choose Atmosphere, Effect, or All. Choose New.

3 Choose an atmosphere or effect in the list, then click OK.
   This associates a new atmosphere or rendering effect with the light.

To add an existing atmosphere or rendering effect:

1 In the Atmospheres & Effects rollout, click Add. This displays the Add Atmosphere or Effect dialog on page 5455.

2 In the dialog, choose Existing.

3 Choose an atmosphere or effect in the list, then click OK.
   This creates a duplicate atmosphere or rendering effect for the light. Its settings are initially identical to the atmosphere or effect you chose. You can adjust them using Setup.

To delete an atmosphere or rendering effect:

- In the Atmospheres & Effects rollout, choose the name of an atmosphere or effect in the list, then click Delete.

To set up the parameters for an atmosphere or rendering effect:

- In the Atmospheres & Effects rollout, choose the name of an atmosphere or effect in the list, then click Setup.
   If you chose an atmosphere, clicking Setup displays the Environment panel on page 7163. If you chose an effect, clicking Setup displays the Effects panel on page 7058.

Interface

These controls are displayed for all light types.
Add Displays the Add Atmosphere or Effect dialog on page 5455, which lets you add an atmosphere or a rendering effect to the light.

Delete Deletes the atmosphere or effect you have selected in the list.

List of atmospheres and effects Displays the names of all atmospheres or effects you have assigned to this light.

Setup Lets you set up the atmosphere or rendering effect you have selected in the list. If the item is an atmosphere, clicking Setup displays the Environment panel on page 7163. If the item is an effect, clicking Setup displays the Effects panel on page 7058.

**Add Atmosphere or Effect Dialog**

Modify panel > Select light object. > Atmospheres & Effects rollout > Add button

The Add Atmosphere Or Effect dialog lets you associate an atmosphere or a rendering effect with the light. The list shows either atmospheres, rendering effects, or both. It shows only atmospheres and effects that can be associated with light objects, or that use light objects as their apparatus.
List of atmospheres and effects Displays the atmospheres or effects that you can associate with the light.

List filter group

These radio buttons choose what to show in the list.

Atmosphere Lists only atmospheres.

Effect Lists only rendering effects.

All Lists both atmospheres and rendering effects.

New or existing group

These radio buttons choose between new or existing effects.

New Lists only new atmospheres or effects.

Existing Lists only atmospheres or effects that have been already assigned to the light.

Adding an existing atmosphere or effect creates a new atmosphere or effect whose settings are initially identical to the previous one.
Advanced Effects Rollout

Create panel > Lights > Create a light. > Advanced Effects rollout

The Advanced Effects rollout provides controls that affect how lights affect surfaces, and also includes a number of fine adjustments and settings for projector lights.

You can make a light object on page 5314 into a projector by choosing a map for the light to project. A projected map can be a still image or an animation.

Casting a projection with a light

NOTE If your scene includes animated bitmaps, including materials, projector lights, environments, and so on, the animation file is reloaded once per frame. If your scene uses multiple animations, or if the animations are large files, this can slow down rendering performance.
Procedures

To make a light a projector:

1. Open the Material Editor on page 5641. The Material Editor is where you adjust the map's parameters.

2. Use an unused sample slot to display a map.

3. Drag the map from the Material Editor to the light's Map button in the Advanced Effects rollout. A dialog asks if the projection map should be a copy or an instance. Choose Instance. If you choose Copy, adjusting the map in the Material Editor has no effect on the projected map.

You can also drag from any other used map button, as in the Environment dialog.

Assigning the map displays the map name in the button, and turns on the Projector toggle. After you have set up the map, you can turn off Projector to test rendering the scene without the projected image.

An alternative is to click the Map button. This displays the Material/Map Browser on page 5724, which lets you choose the map type. At this point, the light behaves as a projector. To assign a map or adjust its parameters, you need to use the Material Editor.

NOTE Lights project maps only within their cone, even if Overshoot is turned on.

To put the map in the Material Editor:

- Drag from the light's Map button to an unused sample slot in the Material Editor.

NOTE Sample slots with white triangles in the corners indicate materials that are used in the current scene.

You can adjust the map in the Material Editor by changing the map's parameters.

To blur a projection map:

- Increase the value of Blur Offset in the map's Coordinates rollout in the Material Editor.
You can animate Blur Offset to have a projected map go in or out of focus.

To make the shape of the light fit the projected bitmap:

**NOTE** This procedure only applies to standard spot and direct lights.

1. Choose a bitmap to project, as described in the preceding procedures.
2. Make sure the light's shape is set to Rectangular, and then click Bitmap Fit.
   A file selection dialog is displayed.
3. Choose the same bitmap you chose for the standalone map, and then click OK.
   You can also choose a bitmap other than the one the light projects.

**Interface**

**Affect Surfaces group**

**Contrast** Adjusts the contrast between the diffuse and ambient areas of the surface. Leave this set to 0 for normal contrast. Increase the value to increase the contrast for special effects: for example, the harsh light of outer space. Default=0.0.

**Soften Diffuse Edge** Increasing the value of Soften Diffuse Edge softens the edge between the diffuse and ambient portions of a surface. This helps
eliminate edges that can appear on a surface under certain circumstances. Default=50.

**NOTE** Soften Diffuse Edge reduces the amount of light, slightly. You can counter this, to some extent, by increasing the Multiplier value.

**Diffuse** When on, the light affects the diffuse properties of an object’s surface. When off, the light has no effect on the diffuse surface. Default=on.

**Specular** When on, the light affects the specular properties of an object’s surface. When off, the light has no effect on the specular properties. Default=on.

For example, by using the Diffuse and Specular check boxes you can have one light color the specular highlights of an object, while not coloring its diffuse area, and then have a second light color the diffuse portion of the surface while not creating specular highlights.

**Ambient Only** When on, the light affects only the ambient component of the illumination. This gives you more detailed control over the ambient illumination in your scene. When Ambient Only is on, Contrast, Soften Diffuse Edge, Diffuse, and Specular are unavailable. Default=off.

The effect of Ambient Only isn’t visible in viewports. It appears only when you render the scene.

A: Affect specular only

B: Affect diffuse only

C: Affect ambient only

A

B

C
**Projector Map group**

These controls make the photometric light a projector.

**Check box** Turn on to project the map selected by the Map button. Turn off to turn off projection.

**Map** Names the map used for the projection. You can drag from any map specified in the Material Editor, or any other map button (as on the Environment panel), and drop that map on the light’s Map button. Clicking Map displays the Material/Map Browser. You can choose the map type using the Browser, then drag the button to the Material Editor, and use the Material Editor to select and adjust the map.

---

**mental ray Indirect Illumination Rollout (for Lights)**

Create panel > Lights > Create a light. > Modify panel > mental ray Indirect Illumination rollout

**NOTE** This rollout does not appear on the Create panel.

The mental Indirect Illumination rollout provides controls for light behavior with the [mental ray renderer](/help/mental-ray-renderer) on page 6675. The settings on this rollout have no effect on rendering with the default scanline renderer, or on advanced lighting (the light tracer or a radiosity solution). These settings control how the light behaves when it generates indirect illumination; that is, [caustics](/help/caustics) on page 6700 and [global illumination](/help/global-illumination) on page 6706.

**TIP** By default, each light uses the global settings found in the Light Properties group on the Render Setup Dialog > Indirect Illumination panel. It is more convenient to adjust all lights in the scene at once. If you need to adjust a specific light, you can use the multiplier controls for energy and photons. In general, you should rarely, if ever, need to turn off Use Global Settings and specify local light settings for indirect illumination.

**IMPORTANT** In addition to the values specified here, the light must also be set to generate caustics, global illumination, or both. These controls are on the mental ray panel on page 300 of the Object Properties dialog. You also need to turn on Caustics, Global Illumination, or both, on the Render Setup Dialog > Indirect Illumination panel > [Caustics and Global Illumination Rollout (mental ray Renderer)](/help/caustics-and-global-illumination-rollout) on page 6771.
Interface

Automatically Calculate Energy and Photons When on, the light uses the global light settings for indirect illumination, rather than local settings. Default=on.
When this toggle is on, only the controls in the Global Multipliers group are available.

Global Multipliers group

Energy Multiplies the global Energy value to increase or decrease the energy of this particular light. Default=1.0.

Caustic Photons Multiplies the global Caustic Photons value to increase or decrease the count of photons used to generate caustics by this particular light. Default=1.0.

GI Photons Multiplies the global GI Photons value to increase or decrease the count of photons used to generate global illumination by this particular light. Default=1.0.
Manual Settings group

When Automatically Calculate is off, the Global Multipliers group becomes unavailable, and the manual settings for indirect illumination become available.

On When on, the light can generate indirect illumination effects. Default=off.

Filter color Click to display a Color Selector on page 371 and choose a color that filters the light energy. Default=white.

Energy Sets the energy of the light. Energy, or "flux," is the amount of light used in indirect illumination. Each photon carries a fraction of the light’s energy. This value is independent of the light intensity determined by the light’s color and Multiplier, so you can use the Energy value to fine-tune indirect illumination effects without changing the light’s other effects in a scene (such as providing diffuse illumination). Default=50000.0.

Decay Specifies how photon energy decays as it moves away from the light source. Range=0.0 to 100.0. Default=2.0 (inverse square; physically correct falloff).

This value is applied as an exponent to the distance ($r$) between the light source and each indirectly illuminated point to determine the energy at that point, in the formula $1/r^{\text{Decay}}$, and is intended for tweaking the GI solution. The most commonly used values are:

■ **0.0 (no decay)** The energy doesn't decay, and photons provide equal indirect illumination throughout the scene.

■ **1.0 (inverse)** The energy decays proportionally to its distance from the light, with linear falloff. That is, a photon’s energy is $1/r$, where $r$ is the distance from the light source.
2.0 (inverse square)  The energy decays at an inverse square rate. That is, a photon’s energy is the inverse of the square of the distance \((r)\) from the light source \((1/r^2)\).

In the real world, light decays at the inverse square rate, but this gives strictly realistic results only if you provide a realistic value for the energy of the light. You can use other values to help adjust indirect illumination without worrying about physical accuracy.

Caustic Photons  Sets the number of photons emitted by the light for use in caustics. This is the number of photons in the photon map on page 8684 used for caustics. Increasing this value increases the accuracy of caustics, but also increases the amount of memory used and the length of render time. Decreasing this value improves memory usage and render time, and can be useful for previewing caustic effects. Default=10000.

GI Photons  Sets the number of photons emitted by the light for use in global illumination. This is the number of photons in the photon map used for global illumination. Increasing this value increases the accuracy of global illumination, but also increases the amount of memory used and the length of render time. Decreasing this value improves memory usage and render time, and can be useful for previewing global-illumination effects. Default=10000.

mental ray Light Shader Rollout

Select a light. > Modify panel > mental ray Light Shader rollout

Note: This rollout appears only if you have enabled the mental ray extensions by using the mental ray Preferences panel.

NOTE  This rollout does not appear on the Create panel; only on the Modify panel.

The mental ray Light Shader rollout lets you add mental ray shaders on page 6385 to lights. When you render with the mental ray renderer on page 6675, light shaders can alter or adjust the light’s effect.

To adjust the settings for a light shader, drag the shader’s button to an unused Material Editor sample slot. If 3ds Max prompts you to choose Instance or Copy, be sure to choose Instance. (If you edit a copy of the shader, you will have to drag the sample slot back to the shader button on the Light Shader rollout before any changes take effect.)
Interface

Enable When on, rendering uses the light shaders you have assigned to this light. When off, the shaders have no effect on rendering. Default=off.

Light Shader Click the button to display a Material/Map Browser on page 5724 and choose a light shader. Once you have chosen a shader, its name appears on the button.

These are the light shaders provided with 3ds Max:

<table>
<thead>
<tr>
<th>Shader</th>
<th>Library</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ambient/Reflective Occlusion</td>
<td>base</td>
</tr>
<tr>
<td>Light Infinite</td>
<td>base</td>
</tr>
<tr>
<td>Light Point</td>
<td>base</td>
</tr>
<tr>
<td>Light Spot</td>
<td>base</td>
</tr>
</tbody>
</table>

Photon Emitter Shader Click the button to display a Material/Map Browser on page 5724 and choose a shader. Once you have chosen a shader, its name appears on the button.

NOTE No photon emitter shaders are provided with 3ds Max. This option is for users who have access to light map shaders via other shader libraries or custom shader code.
Shadow Types and Shadow Controls

Create panel > Lights > Create or select a light. > General Parameters rollout > Shadows group > Shadow type

Create menu > Lights > Create or select a light. > General Parameters rollout > Shadows group > Shadow type

Select a light > Modify panel > General Parameters rollout > Shadows group > Shadow type

The General Parameters rollout for both photometric and standard lights lets you turn shadow-casting on or off for the light, and choose which type of shadow the light uses.

The following table describes the advantages and disadvantages of each shadow type:

<table>
<thead>
<tr>
<th>Shadow Type</th>
<th>Advantages</th>
<th>Disadvantages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advanced Ray-Traced</td>
<td>Supports transparency and opacity mapping.</td>
<td>Slower than shadow maps. Does not support soft shadows.</td>
</tr>
<tr>
<td></td>
<td>Uses less RAM than standard ray-traced shadows.</td>
<td>Processes at every frame.</td>
</tr>
<tr>
<td></td>
<td>Recommended for complex scenes with many lights or faces.</td>
<td></td>
</tr>
<tr>
<td>Area Shadows</td>
<td>Supports transparency and opacity mapping.</td>
<td>Slower than shadow maps. Processes at every frame.</td>
</tr>
<tr>
<td></td>
<td>Uses very little RAM. Recommended for complex scenes with</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Shadow Type</td>
<td>Advantages</td>
<td>Disadvantages</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Shadow Maps</td>
<td>Can be quicker than ray-traced shadows with the mental ray renderer.</td>
<td>Not as accurate as ray-traced shadows.</td>
</tr>
<tr>
<td>mental ray Shadow Maps</td>
<td>Can be quicker than ray-traced shadows with the mental ray renderer.</td>
<td>Not as accurate as ray-traced shadows.</td>
</tr>
<tr>
<td>Ray-traced Shadows</td>
<td>Supports transparency and opacity mapping. Processes only once if there are no animated objects.</td>
<td>Can be slower than shadow maps. Does not support soft shadows.</td>
</tr>
<tr>
<td>Shadow Maps</td>
<td>Produces soft shadows. Processes only once if there are no animated objects. Fastest shadow type.</td>
<td>Uses a lot of RAM. Does not support objects with transparency or opacity maps.</td>
</tr>
</tbody>
</table>

**NOTE** When using photometric lights with shadow maps, a hemispherical shadow map is created for the entire light sphere. To capture sufficient detail with complex scenes, the map resolution must be very large. For best results with photometric lights, use ray-traced shadows instead of shadow maps.

**Shadow Types and the Active Renderer**

The renderer you use also affects your choice of a shadow type. The scanline renderer on page 6588 does not generate mental ray Shadow Map shadows,
while the mental ray renderer on page 6675 does not support Advanced Ray-Traced or Area shadows.

<table>
<thead>
<tr>
<th>Shadow type</th>
<th>Scanline renderer</th>
<th>mental ray renderer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advanced Ray-Traced</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>mental ray Shadow Map</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Area</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Shadow Map</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Ray-Traced</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

**Notes:**

- When the scanline renderer encounters a light set to “mental ray Shadow Map” shadows, the scanline renderer does not generate shadows for that light.

- When the mental ray renderer encounters a light set to Advanced Ray-Traced or Area shadows, it generates ray-traced shadows instead. (And it displays a warning to this effect.)

- While the mental ray renderer does not use the Area shadow type, it *can* generate area shadows: use a photometric light set to a light shape other than Point. See Shape/Area Shadows Rollout on page 5389.

**See also:**

- Shadow Parameters on page 5448

**Advanced Ray-Traced Parameters Rollout**

Create panel > Lights > Create or select a light. > General Parameters rollout > Shadows group > Shadow type > Advanced Ray-traced Shadows

Advanced Ray-traced shadows are similar to ray-traced shadows on page 8696; however, they give you more control over shadow behavior. Additional controls are available in the Optimizations rollout on page 5479.
The mental ray renderer on page 6675 does not support Advanced Ray-Traced shadows. When it encounters a light with this shadow type, it generates ray-traced shadows instead, and displays a warning to that effect.

![Advanced ray-traced shadows cast by an area light.](image)

**Interface**

![Advanced Ray Traced Params interface](image)
Basic Options group

Mode Selects the type of raytracing for generating shadows:
- **Simple** Casts a single ray of light toward the surface. No antialiasing is performed.
- **1-Pass Antialias** Casts a bundle of rays. The same number of rays is cast from each illuminated surface. The number of rays is set using the Shadow Integrity spinner.
- **2-Pass Antialias** (The default.) Casts two bundles of rays. The first batch of rays determines if the point in question is fully illuminated, shadowed, or in the penumbra (soft area) of the shadow. If the point is in the penumbra, a secondary batch of rays is cast to further refine the edge. The number of initial rays is specified using the Shadow Integrity spinner. The number of secondary rays is specified using the Shadow Quality spinner.

2 Sided Shadows When on, backfaces are not ignored when calculating shadows. Objects seen from the inside are not lit by lights from the outside. This costs a bit more render time. When off, backfaces are ignored. Rendering is quicker, but outside lights illuminate object interiors. Default=off.

The faces inside the sliced sphere do not cast shadows if 2-Sided Shadows is not selected.

Antialiasing Options group

**Shadow Integrity** The number of rays cast from an illuminated surface. This is disabled when the raytracing mode is Simple.
**Shadow Quality** The number of secondary rays cast from an illuminated surface. This is disabled when the raytracing mode is Simple or 1-Pass Antialias.

**Shadow Spread** The radius, in pixels, to blur the antialiased edge. This is disabled when the raytracing mode is Simple.

![Increasing the Shadow Spread value softens shadow edges.](image)

**NOTE** As this value increases, so does the quality of the blur. However, increasing this value also increases the likelihood of missing small objects. To avoid this problem, increase the value of Pass 1 Quality.

**Shadow Bias** Shadow bias on page 8718 is the minimum distance from the point being shaded that an object must be to cast a shadow. This prevents blurred shadows from affecting surfaces they shouldn’t.

**NOTE** As you increase the blur value, you should also increase the bias.

**Jitter Amount** Adds randomness to the ray positions. The rays are initially in a very regular pattern, which can show up in the blurry part of the shadow as regular artifacts. Jittering will convert these artifacts to noise, which is generally less noticeable to the eye. Recommended values are 0.25 to 1.0.
However, very blurry shadows will require more jitter. This is disabled when the raytracing mode is Simple.

**Area Shadows Rollout**

Create panel > Lights > Create or select a light. > General Parameters rollout > Shadows group > Shadow type > Area Shadows rollout

The Area Shadow generator can be applied to any light type to achieve the effect of an area shadow effect. In order to create an area shadow, the user needs to specify the dimensions of a virtual light created to “fake” an area shadow.

The mental ray renderer on page 6675 does not support Area shadows. When it encounters a light with this shadow type, it generates ray-traced shadows instead, and displays a warning to that effect. While the mental ray renderer does not use the Area shadow type, it can generate area shadows: use a photometric light set to a light shape other than Point. See Shape/Area Shadows Rollout on page 5389.

**NOTE** When you use area lights, try to make the properties of the light match the properties in the Area Light Dimensions group of the Area Shadows rollout.

**TIP** Area shadows can take a fair amount of time to render. If you want to create a quick test (or draft) rendering, you can use the Area/Linear Lights as Point Lights toggle in the Common Parameters rollout on page 6568 of the Render Setup dialog to speed up your rendering. When this toggle is on, the shadows are processed as if the light object is a point source.
Area shadows create a soft edge that becomes more noticeable as the distance between the object and the shadow increases.

A: Penumbra (soft area)
B: Shadow

Area shadow cast by a point light
**Basic Options group**

**Mode** Selects the way the area shadows are generated:

- **Simple**  
  Casts a single ray from the light toward the surface. No antialiasing on page 8501 or area light calculation is performed.

- **Rectangle Light**  
  Casts rays from the light in a rectangular array.

- **Disc Light**  
  Casts rays from the light in a circular array.

- **Box Light**  
  Casts rays from the light as if it were a box.

- **Sphere Light**  
  Casts rays from the light as if it were a sphere.
The shape of the area shadow array affects how shadows are cast.

Left: Rectangle

Right: Box

**2-Sided Shadows** When on, backfaces are not ignored when calculating shadows. Objects seen from the inside are not lit by lights from the outside. This costs a bit more render time. When off, backfaces are ignored. Rendering is quicker, but outside lights illuminate object interiors.
The faces inside the sliced sphere do not cast shadows if 2-Sided Shadows is off.

**Antialiasing Options group**

**Shadow Integrity** Sets the number of rays in the initial bundle of rays cast. These rays are projected from every surface that receives light from the light source.

The number of rays is as follows:

1 = 4 rays
2 = 5 rays
3 to N = NxN rays.

For example, setting Shadow Integrity to 5 generates 25 rays.

This is the primary control for “finding” small objects and thin spaces between objects. If the shadows are missing a small object in your scene, try increasing Shadow Integrity one step at a time. Also, if the penumbra (soft area) is blotchy, try increasing this setting.
Increasing the Shadow Integrity value creates more accurate shadow contour and detail.

**Shadow Quality** Sets the total number of rays cast in the penumbra (soft area) region, including the rays fired in the first pass.

These rays are projected from every point that is in the penumbra, or antialiased edge of the shadow, to smooth it out.

The number of rays is as follows:

- \(2^5\) rays
- \(3\) to \(N = N \times N\)

For example, setting Shadow Quality to 5 generates 25 rays.

The Shadow Quality value should always be greater than the Shadow Integrity value. This is because 3ds Max overlays the secondary rays atop the first pass's rays using the same algorithm.

Increase Shadow Quality to fix banding in the penumbra, and eliminate the noise pattern from jittering.
Increasing the Shadow Quality value produces a more accurate penumbra (soft area) within the contour defined by the Shadow Integrity value.

**Sample Spread** The radius, in pixels, to blur the antialiased edge.

**NOTE** As this value increases, so does the quality of the blur. However, increasing this value also increases the likelihood of missing small objects. To avoid this problem, increase the value of Shadow Integrity.

**Shadow Bias** Shadow bias on page 8718 is the minimum distance that an object must be from the point being shaded in order to cast a shadow. This prevents blurred shadows from affecting surfaces they shouldn't.

**NOTE** As you increase the blur value, you should also increase the bias.

**Jitter Amount** Adds randomness to the ray positions. The rays are initially in a very regular pattern, which can show up in the blurry part of the shadow as regular artifacts. Jittering will convert these artifacts to noise, which is generally less noticeable to the eye. Recommended values are 0.25 to 1.0. However, very blurry shadows require more jitter.
Increasing jitter blends the individual shadow samples.

**Area Light Dimensions group**

3ds Max uses these dimensions to compute the area shadowing. They do not affect the actual light object.

- **Length** Sets the length of the area shadow.
- **Width** Sets the width of the area shadow.
- **Height** Sets the height of the area shadow.

**Optimizations Rollout**

Create panel > Lights > Create a light. > General Parameters rollout > Shadows group > Select Advanced Ray-traced Shadows or Area Shadows. > Optimizations rollout

The Optimizations rollout provides additional controls for Advanced Ray-traced Shadow on page 8696 and Area Shadow on page 8510 generation.
See also:

- General Parameters Rollout (Standard Lights) on page 5424
- Shadow Parameters on page 5448
- Area Shadows Rollout on page 5472
- Advanced Ray-Traced Parameters Rollout on page 5468

Interface

Transparent Shadows group

On When checked, transparent surfaces will cast a colored shadow. Otherwise, all shadows are black.

NOTE Shadows will generate faster with this value turned off.
A stained glass appears solid with the transparency optimization turned off.

**Antialiasing Threshold** The maximum color difference allowed between transparent object samples before antialiasing on page 8501 is triggered. Increasing the value of this color will make the shadow less sensitive to aliasing artifacts and improve speed, decreasing the value will increase the sensitivity, improving quality.

**Antialias Suppression group**

**Supersampled Material** When on, only pass 1 is used during 2-pass antialiasing when shading a supersampled on page 8735 material.

**NOTE** When off, rendering time can increase without resulting in a better image.

**Reflect/Refract** When on only pass 1 is used during 2-pass antialiasing when shading reflections or refractions.

**NOTE** When off, rendering time can increase without resulting in a better image.
Coplanar Face Culling group

Skip Coplanar Faces Prevents adjacent faces from shadowing each other. This is of particular concern at the terminator on curved surfaces such as spheres.

Threshold The angle between adjacent faces. Range = 0.0 (perpendicular) to 1.0 (parallel).

mental ray Shadow Map Rollout

Create panel > Lights > Create a light. > General Parameters rollout > Shadows group > Select “mental ray Shadow Map shadows.” > mental ray Shadow Map rollout

Choosing “mental ray Shadow Map” as the shadow type tells the mental ray renderer on page 6675 to generate shadows using the mental ray shadow-map algorithm.

The scanline renderer on page 6589 does not support “mental ray Shadow Map” shadows. When it encounters a light with this shadow type, it doesn’t generate shadows for this light.

NOTE mental ray shadow-mapped shadows are always “2-sided”; in other words, mental ray shadow-mapped shadows do not take face normals into account while rendering.
Map Size Sets the resolution of the shadow map. The size of the map is the square of this value. Greater resolutions require more time to process, but produce more accurate shadows. Default=512.

Sample Range When greater than zero, generates soft-edged shadows. This value specifies the area of the map to soften, by removing portions of the map as specified by Samples. Default=0.0.

If you set Sample Range to be greater than zero, you must also set Samples to be greater than zero, to obtain a soft shadow effect.

Directional lights require Sample Range to have a greater value than spotlights require.

Samples Sets the number of samples to remove from a shadow map when generating soft shadows. Default=1.

Use Bias When on, changes the shadow bias on page 8718. Increasing the value moves the shadow farther away from the shadow casting object. Default=10.

Transparent Shadows group

Enable When on, shadow maps are saved with multiple Z-layers, and can have transparency. Default=off.

Color When on, surface color affects the color of the shadow. Default=on. Turning off Color saves memory at rendering time.
**Merge Dist.** The minimum distance between two surfaces for them to be considered “distinct.” If two surfaces are closer than this value, the shadow map treats them as a single surface. When set to 0.0, the mental ray renderer automatically calculates a distance value to use. Default=0.0 (automatic).

Larger Merge Distance values reduce memory consumption, but can reduce shadow quality. Low Merge Distance values increase memory consumption and slow down rendering speed.

**Samp./Pixel** The number of samples used to generate a pixel in the shadow map. Higher values increase the quality and detail of the shadow, at a cost of render time. Default=5.

If a mapped shadow appears to be aliased on page 8501, increase the value of Samples/Pixel. This setting is especially useful when shadows are cast by finely detailed geometry.

**Ray-Traced Shadow Parameters Rollout**

Create a light. > General Parameters rollout > Shadows group > Choose Ray Traced Shadows. > Ray Traced Shadow Params rollout

The Ray-Traced Shadow Parameters rollout appears when you have chosen raytracing as the shadow-generation technique for a light. You select this in the General Parameters rollout on page 5424.

Both the scanline renderer on page 6589 and the mental ray renderer on page 6675 support Ray-Traced shadows.

**TIP** If you are using the scanline renderer, Advanced Ray-Traced Shadows on page 5468 give you greater control over the appearance of shadows.
Ray-traced shadows

**Interface**

- **Ray Bias** Shadow bias on page 8718 moves the shadow toward or away from the shadow-casting object (or objects).

  If the Bias value is too low, shadows can "leak" through places they shouldn't, producing moire patterns or making out-of-place dark areas on meshes. If Bias is too high, shadows can "detach" from an object. If the Bias value is too extreme in either direction, shadows might not be rendered at all.

- **2-Sided Shadows** When on, backfaces are not ignored when calculating shadows. Objects seen from the inside are not lit by lights from the outside.
This costs a bit more render time. When off, backfaces are ignored. Rendering is quicker, but outside lights illuminate object interiors. Default=on.

The faces inside the sliced sphere do not cast shadows if 2-Sided Shadows is not selected.

NOTE The mental ray renderer disregards this setting, and always renders 2-sided shadows.

Max Quadtree Depth Adjusts the depth of the quadtree on page 8694 used by the ray-tracer. Greater quadtree depth values can improve ray-tracing time at the cost of memory use. However, there is a depth value where the performance improvement is offset by the time it takes to generate the quadtree itself. This depends on the geometry of the scene. Default=7.

TIP An Omni light can generate up to six quadtrees, so it generates ray-traced shadows more slowly than spotlights. Avoid using ray-traced shadows with omni lights unless your scene requires this.

Shadow Map Parameters Rollout

Create a light. > General Parameters rollout > Shadows group > Choose Shadow Map. > Shadow Map Params rollout

The Shadow Map Parameters rollout is displayed when you have chosen shadow mapping as the shadow-generation technique for a light. You select this in the General Parameters rollout on page 5424.
Both the scanline renderer on page 6589 and the mental ray renderer on page 6675 support Shadow Map shadows.

**NOTE** When using photometric lights with shadow maps, a hemispherical shadow map is created for the entire light sphere. To capture sufficient detail with complex scenes, the map resolution must be very large. For best results with photometric lights, use ray-traced shadows instead of shadow maps.

**Interface**

Bias: Shadow bias on page 8718 moves the shadow toward or away from the shadow-casting object (or objects).

Left: Default shadows

Right: Increasing the Bias value separates the shadow from the object.
If the Bias value is too low, shadows can "leak" through places they shouldn't, produce moire patterns or making out-of-place dark areas on meshes. If Bias is too high, shadows can "detach" from an object. If the Bias value is too extreme in either direction, shadows might not be rendered at all.

This value depends on whether Absolute Map Bias is on or off:

■ When Absolute is off (the default), Bias is calculated based on the scene extents, and then normalized to one. This provides similar default shadow results, regardless of scene size. User adjustments to Bias are typically low decimal values near 1.0 (for example, 1.2).

■ When Absolute is on, Bias is a value in 3ds Max units. User adjustments to Bias depend on the size of the scene, and can range from values close to zero to values in the hundreds (see the Tip at the end of this topic).

Left: Too small a Bias value causes shadow "leaks."

Right: Increasing the Bias value fixes the problem.

Size Sets the size (in pixels squared) of the shadow map that's computed for the light.
The shadow map size specifies the amount of subdivisions for the map. The greater the value, the more detailed the map will be.

Left: Size set to 32.
Right: Size set to 256.

**Sample Range** The *sample range* on page 8704 determines how much area within the shadow is averaged. This affects how soft the edge of the shadow is. Range=0.01 to 50.0.
Increasing the Sample Range blends the shadow edges and creates a smooth effect, hiding the granularity of the map.

**Absolute Map Bias** When on, the bias for the shadow map is not normalized, but is instead based on a fixed scale expressed in 3ds Max units. This value does not change during an animation. You must choose the value, based on the size of the scene extents.

When off, the bias is computed relative to the rest of the scene, and then normalized to 1.0. This provides a common starting bias value in scenes of any size. If the scene extents change, this internal normalization can vary from frame to frame. Default=off.

**TIP** Leaving Absolute Map Bias off gives good results in most situations, because the bias is internally balanced to match the scene size. In animations, however, if moving objects cause a large change in the scene extents (or if objects are unhindered, and so on), the normalized bias value might become inappropriate, causing shadows to flicker or disappear. If this happens, turn on Absolute Map Bias. You will have to set the Bias control to a value appropriate for the scene. As a rule of thumb, try a Bias value that is the distance between the light and the target object, divided by 100.

**2-Sided Shadows** When on, backfaces are not ignored when calculating shadows. Objects seen from the inside are not lit by lights from the outside. When off, backfaces are ignored, which can cause outside lights to illuminate object interiors. Default=on.
The faces inside the sliced sphere do not cast shadows if 2-Sided Shadows is not selected.

NOTE The mental ray renderer disregards this setting, and always renders 2-sided shadows.

Sunlight and Daylight Systems

Create panel > Systems > Sunlight button/Daylight button
Create menu > Lights > Daylight System
Create menu > Systems > Daylight System

The Sunlight and Daylight systems use light in a system that follows the geographically correct angle and movement of the sun over the earth at a given location. You can choose location, date, time, and compass orientation. You can also animate the date and time. This system is suitable for shadow studies of proposed and existing structures. In addition, you can animate Latitude, Longitude, North Direction, and Orbital Scale.

Sunlight and Daylight have a similar user interface. The difference is that:

- Sunlight uses a directional light on page 5407.
- Daylight combines Sunlight on page 8734 and Skylight on page 8723. The Sunlight component can be an IES Sun light on page 5506, an mr Sun light on page 5524, or a standard light (a target direct light on page 5405). The
Skylight component can be an IES Sky light on page 5509, an mr Sky light on page 5527, or a Skylight on page 5412.

- The IES Sun and IES Sky lights are photometric lights. It is appropriate to use them if you are creating a rendering that uses radiosity on page 6615 with exposure control on page 7207.

- The mr Sun and mr Sky lights are also photometric, but are intended for use with the mental ray Sun & Sky on page 5513 solution.

- The Standard light and Skylight are not photometric. It is appropriate to use them if your scene uses standard lighting (Sunlight with its Directional light works for this, too), or if you are using light tracing on page 6601.

When you first create a Daylight system, the default creation parameters are set to midday (noon) on the summer solstice (June 21). Use the Get Location button in the Control Parameters rollout (see below) to choose the correct geographic location. If the rollout is not available, select the Daylight01 object in the viewport to gain access.

**NOTE** When you create a Daylight system, if no exposure control is in effect, the program prompts you to use the Logarithmic Exposure Control on page 7215 if the renderer is set to Default Scanline, or the mr Photographic Exposure Control on page 7219 if the renderer is set to mental ray. It is recommended that you click Yes to effect this change.
NOTE When you create a Sunlight system or a Daylight system that uses a target direct light for the sun, the directional light’s hotspot is set to encompass all geometry in the scene, so that shadows will render correctly. Specifically, the diameter of the hotspot is set to 65 per cent of the longest diagonal length of the scene extents on page 8710.

Procedures

To create a Sunlight or Daylight system:

1. On the Create panel, click Systems and then click Sunlight or Daylight. Alternatively, you can create a Daylight system from the Create menu > Lights or Systems submenu. Whichever method you use, if you add a Daylight system while no exposure control method is in effect, 3ds Max automatically prompts...
you to apply an appropriate exposure control. Always use the exposure control that’s best suited to the current renderer:

<table>
<thead>
<tr>
<th>Renderer</th>
<th>Recommended Exposure Control</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Scanline</td>
<td>Logarithmic</td>
</tr>
<tr>
<td>mental ray</td>
<td>mr Photographic</td>
</tr>
</tbody>
</table>

2. Choose a viewport in which to create a compass rose (the compass direction of your "world"). This should be a Top or Perspective/Camera view.

3. Drag to create the radius of a compass rose (the radius is for display purposes only), and then release the mouse button and move the mouse to set the orbital scale of the sun light over the compass rose. This can be any distance you find convenient, since directional and IES Sun lights produce parallel illumination regardless of where their icon is located. Click to finish.

Upon creation you have two objects in your scene:

- The compass rose on page 2860, which is a helper object that provides the world direction for your sun.
- The light itself, which is a child of the compass rose, and is permanently targeted on the center of the compass rose.

If you created a Daylight system, the Daylight Parameters rollout on the Modify panel lets you choose the type of sunlight and skylight. The Sunlight drop-down list lets you choose IES Sun, mr Sun, or Standard (directional). The Skylight drop-down list lets you choose IES Sky, mr Sky, or Skylight. These lists also offer you the options of choosing no sunlight or no skylight.

Controls for the geographic location and time of day are on the Motion panel. The default time is noon, and the default date and time zone are based on your computer’s local settings. The default location is San Francisco, CA.

The directional light created by the system is managed by two special controllers: Solar Date and Solar Time. After you create your system, you can access its creation parameters (time and date, location, and orbital scale) in the Motion panel for the directional light. The parameters are interrelated, so you can adjust them in any order. Generally, it’s easiest to choose a location first, and then adjust the date and time. You can
access the parameters for selected sunlight or skylight objects in the Modify panel. The radius of the compass rose is also editable from the Modify panel, after selecting the compass rose object.

If Date/Time position is selected the Sun and Sky multipliers are automatically set and animated according to their position. They can be edited only by using the Manual Position override.

TIP If your scene rendering with Daylight is too bright or too dark, use an exposure control on page 7207.

Example: To create a shadow study:

1. Choose Create menu > Daylight System, and when prompted to add an exposure control, click Yes. Add the Daylight system in a viewport.
2. On the Modify panel, set the date and Location.

   NOTE Once you’ve created the Daylight system, you’ll find these controls on the Motion panel.

3. Turn on Auto Key.
4. In the Control Parameters > Time group, adjust the Hours setting to a start time in early morning, such as 6.
5. Click the Go To End button.
6. Set Hours to a time in the late afternoon, such as 18.
7. For a complete view of your environment and its shadows, render an animation from a Top viewport or a view above your scene.

Interface

Daylight Parameters rollout (Daylight system only)

The Daylight Parameters rollout lets you define the daylight system's sun object. You can set the sunlight and skylight behaviors.
This rollout appears on the Modify panel when the light component of the Daylight system is selected.

Sunlight Choose an option for sunlight in your scene:
- **IES Sun** Uses an IES Sun object on page 5506 to simulate the sun.
- **mr Sun** Uses the mr Sun light on page 5524 to simulate the sun.
- **Standard** Uses a Target Direct light on page 5405 to simulate the sun.
- **No Sunlight** No sunlight is simulated.

Active Turns sunlight on and off in the viewport.

Skylight Choose an option for skylight in your scene:
- **IES Sky** Uses an IES Sky on page 5509 object to simulate skylight.
- **mr Sky** Uses the mr Sky light on page 5527 to simulate the sun.
- **Skylight** Uses a Skylight on page 5412 object to simulate skylight.
- **No Skylight** No skylight is simulated.

Active Turns skylight on and off in the viewport.
**Position group**

**Manual** When chosen, you can manually adjust the location of the daylight assembly head object in your scene, as well as the intensity value of the sunlight.

**Date, Time and Location** When chosen, daylight uses the geographically correct angle and movement of the sun over the earth at a given location.

**NOTE** When Date, Time And Location is active, adjusting the light’s intensity has no effect.

**Weather Data File** When chosen, daylight derives the angle and intensity of the sun from a weather data (EPW) file.

**Setup** When Manual or Date, Time And Location is chosen, opens the Motion panel on page 8215, allowing you to adjust the time, location, and site of your daylight system.

When Weather Data File is chosen, opens a Configure Weather Data dialog on page 5500 so you can choose which weather data you want the daylight system to use.

**Control Parameters rollout**

This rollout appears on the Create panel, and on the Motion panel when the light component of the Daylight or Sunlight system is selected.
Control source radio buttons (Daylight system only)

**Manual** When chosen, you can manually adjust the location of the sun object in your scene, as well as the intensity value of the sun object.

**Date, Time and Location** When chosen, daylight uses the geographically correct angle and movement of the sun over the earth at a given location.

**NOTE** When Date, Time And Location is active, adjusting the light’s intensity has no effect.

**Weather Data File** When chosen, daylight derives the angle and intensity of the sun from a weather data (EPW) file.
Click the button to open a Configure Weather Data dialog on page 5500, where you can specify the EPW file and choose which weather data you want the daylight system to use.

**Azimuth and Altitude**

*Azimuth/Altitude* Displays the azimuth and altitude of the sun. Azimuth is the compass direction of the sun in degrees (North=0, East=90). Altitude is the height of the sun above the horizon in degrees (Sunrise or Sunset=0).

**Time group**

Provides settings for the time, date, and time zone.

If the location you choose uses Daylight Savings Time, turn on the Daylight Saving Time checkbox. The Sunlight system adjusts the sun's azimuth and altitude accordingly during the summer months.

*Hours/Mins/Secs* Specify the time of day.

*Month/Day/Year* Specify the date.

*Time Zone* Time zones range from −12 to 12. If you're uncertain about a time zone, you can look them up in Window's Date > Time Properties dialog (available through My Computer > Control Panel > Date > Time). Click the Time Zone tab, and then display the list of world locations and their time zones.

*Daylight Savings Time* When on, calculates daylight savings by adjusting azimuth and altitude during the summer months.

**Location group**

Provides controls for setting the location of your scene in the world.

*Get Location* Displays the Geographic Location dialog on page 5503, which lets you set the latitude and longitude values by selecting a location from a map or a list of cities.

**NOTE** For precise locations, enter exact coordinates using Latitude/Longitude.

[city name text box] Displays the name of the city you choose from the Geographic Location dialog. If you adjust the Latitude or Longitude spinners after choosing a location, this area becomes blank.
**Latitude/Longitude** Specify the location based on the latitude and longitude.

**NOTE** Negative longitude values are west of the Greenwich meridian; positive values are to the east of the meridian. This differs from versions prior to Autodesk 3ds Max 2010, in which the polarity of longitude values was incorrectly reversed.

**North Direction** Sets the rotational direction of the compass rose in the scene. This is the geographical orientation of the compass rose. By default, north is 0 and points along the positive Y axis of the ground plane. Positive X (East) is 90 degrees. Adjust the North Direction to correspond to your site. Accuracy of the system depends on this correspondence.

**Model Scale group**

**Orbital Scale** Sets the distance of the sun (the directional light) from the compass rose. Because a directional light casts parallel beams, this distance has no effect on the accuracy of the sunlight. However, the light must point toward your model (not away from it), and the light's hotspot and falloff do have an effect.

The best way to ensure that the light is set up correctly is to change one viewport to the light's view (for example, Sun 01). Then adjust the light's location using Dolly on page 8167, and set the hotspot so it illuminates the whole model, with no falloff.

**Daylight System Dialogs**

The topics in this section describe dialogs that support the daylight and sunlight systems.

**Configure Weather Data Dialog**

Create a Daylight system. > Create or Modify panel > Daylight Parameters rollout > Position group > Choose Weather Data File. > Click Setup. > Configure Weather Data dialog

Create a Daylight system. > Motion panel > Control Parameters rollout > Choose Weather Data File. > Click setup button. > Configure Weather Data dialog

The Configure Weather Data dialog lets you choose which contents of a weather data (EPW) file you want to use.
Interface

Load Weather Data Click to load a weather data (EPW) file. When you have loaded a file, the name field shows its name and path.

Click the X button to unload a file you have loaded.

Location and time fields When a weather data file is loaded, these fields show the location where the file was recorded, the start and end dates, how often the data was recorded (Data Period), and the total number of periods saved in the file.

Use Weather Data group

Use Specific Date/Time (The default.) Chooses a specific date and time to use. By default, this is the first entry in the weather data file.

Change Time Period Click to open a Select A Time Period From Weather Data dialog on page 5502 and choose the period you want to use.
Display Data as Animation Animates the daylight system based on multiple periods contained in the weather data file.

Start The period where the animation begins. Click Change Time Period to open a Select A Time Period From Weather Data dialog on page 5502 and choose the period you want to use.

End The period where the animation ends. Click Change Time Period to open a Select A Time Period From Weather Data dialog on page 5502 and choose the period you want to use.

Skip Hours When on, omits the hours between the two values, using a 24-hour clock. Default=off.

Skip Weekends When on, skips weekends. Default=off.

One Frame Per Choose the time unit by which the animation is subdivided. The options are:

- Period
- Day
- Week
- Month
- Season

Default=Period.

Total Frames Displays the total number of frames that 3ds Max will generate, based on the period settings you have chosen.

Match Timeline Click to set the end of the active animation time segment equal to the last keyframe generated by the weather data.

Select a Time Period from Weather Data Dialog

Create a Daylight system. > Create or Modify panel > Daylight Parameters rollout > Position group > Choose Weather Data File. > Click Setup. > Configure Weather Data dialog > Click Change Time Period. > Select a Time Period from Weather Data dialog

Create a Daylight system. > Motion panel > Control Parameters rollout > Choose Weather Data File. > Click setup button. > Configure Weather Data dialog > Click Change Time Period. > Select a Time Period from Weather Data dialog
The Select A Time Period From Weather Data dialog works in conjunction with the Configure Weather Data dialog on page 5500. It lets you choose a single time period from the weather data (EPW) file.

**Interface**

![Select a Time Period from Weather Data dialog](image)

**Selected Time Period** Displays the currently selected time period. Default=The first period in the weather data file.

**Select from the range of Time Periods in the Weather Data File group**

**Period Selector** Drag this slider to browse the time periods available in the file.

**Increment Period Selector by** Use the Months, Days, Hours, or Minutes spinner controls to move the Period Selector by the corresponding unit of time. If the file does not contain increments at that time level, the spinner has no effect.

**Geographic Location Dialog**

Select a Sunlight or Daylight system. > Motion panel > Location group > Get Location button

The Geographic Location dialog is part of the Sunlight and Daylight systems' on page 5491 interface. It lets you set the latitude and longitude values by selecting a location from a map or a list of cities. The dialog displays a list of cities at left, and a map on the right.
Procedures

To use a map:

1. In the Location group on the Control Parameters rollout, click the Get Location button.
2. On the Geographic Location dialog choose a map from the Map list.
3. Click in the map to specify a location.
   3ds Max displays a small cross at the location you picked. If Nearest Big City is on, it places the cross at the nearest large city on the list, and highlights the city's name in the list.
4. Click OK to set the Latitude and Longitude to the location of the cross.

To choose a city by name:

1. Choose a map from the Map list.
   The City list updates to show cities in the region of the map.
2. Choose the name of a city from the list.
3. Click OK to set the Latitude and Longitude to the location of the city.
Interface

City Displays a list of cities within the selected Map region. As an alternative to selecting a location by clicking the map, you can select a city directly from this list. The cross on the map moves to the location of the selected city.

Map Lets you choose a map for a portion of the world, or you can choose the World map, which includes the entire world.

Nearest Big City When on, clicking the map moves the cross to the nearest listed city, which becomes highlighted in the list. When off, clicking the map places the cross exactly where you clicked, and its position generates the Latitude and Longitude values for that position, regardless of any cities that might be nearby.

IES Sun and Sky

The IES Sun and IES Sky objects are photometric light objects that simulate the sun and sky. IES stands for Illuminating Engineering Society; see IES Standard File Format on page 5376.
IES Sun Light (Photometric)

Create panel > Systems > Create a Daylight system in your scene. > Modify panel > Daylight Parameters rollout > Sunlight > Choose IES Sun.

IES Sun is a physically-based light object that simulates sunlight on page 8734. When used in conjunction with a daylight system on page 5491, its values are set automatically based on geographic location, time, and date. (IES stands for Illuminating Engineering Society; see IES Standard File Format on page 5376.)

Outdoor scene illuminated by the IES Sun light

The mental ray renderer gives physically accurate results for IES Sun, and renderings that use it will appear similar to renderings done with the default
scanline renderer. You do not need to turn on Final Gather for light from IES Sun to render.

The Daylight system on page 5491 combines the two daylight components of sun and sky in a unified interface.

**TIP** If you use the IES sun or sky with the Logarithmic Exposure Control on page 7215, turn on both the Daylight and Exterior options. This will provide greater control for properly mapping the higher energy levels to RGB colors. In addition, it is important to set the Physical Scale to the brightest light source in your scene. If the IES Sun is used, set the Physical Scale to 90000 cd.

### Interface

<table>
<thead>
<tr>
<th>Sun Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>On</strong></td>
</tr>
<tr>
<td><strong>Targeted</strong></td>
</tr>
<tr>
<td><strong>Intensity</strong></td>
</tr>
<tr>
<td><strong>Shadows</strong></td>
</tr>
<tr>
<td><strong>On</strong></td>
</tr>
<tr>
<td><strong>Shadow Map</strong></td>
</tr>
<tr>
<td><strong>Use Global Settings</strong></td>
</tr>
</tbody>
</table>

**On** Turns sunlight on and off in the viewport.

**Targeted** Applicable only when you add the IES Sun light directly, rather than as part of a Daylight system on page 5491. When on, the light is targeted and you can change the target distance by moving the target. The distance between the light and its target is displayed to the right of the check box. When off, you can set this value directly.

**Cast Shadows** Sets whether the sunlight casts shadows or not.

**Intensity** The intensity of the sunlight. The color swatch to the right of the spinner opens the Color Selector on page 371 to set the color of the light. Typical intensities in a clear sky are around 90,000 lux.

**NOTE** Intensity is set automatically and cannot be set manually if the sun is under the control of a daylight system.
**Shadows group**

**On** Determines whether the sunlight casts shadows or not.

**Shadow Method drop-down list** Determines whether the renderer uses shadow maps on page 8719, ray-traced shadows on page 8696, advanced ray-traced shadows on page 8696, mental ray shadow maps on page 5482, or area shadows on page 8510 to generate shadows for this light. Each shadow type has a rollout with its associated controls.

---

**TIP** When you use the mental ray renderer and mental ray shadow maps, you can set up soft-edged shadows.

**Use Global Settings** Turn on to use global settings for shadows cast by this light. Turn off to enable individual control of the shadows. If you choose not to use the global settings, you must choose which method the renderer will use to generate shadows for this particular light.

When Use Global Settings is on, the shadow parameters switch over to show you what the current global setting is. This data is shared by every other light of this class. When Use Global Settings is off, the shadow parameters are specific to that particular light.

**Exclude** Excludes selected objects from the effects of the light. Click this button to display the Exclude/Include dialog on page 5445. Excluded objects still appear lit in shaded viewports. Exclusion takes effect only when you render the scene.

---

**Advanced Effects Rollout**

- **Affect Surfaces:**
  - **Contrast:** Adjusts the contrast between the diffuse and ambient areas of the surface. Leave this set to 0 for normal contrast. Increase the value to increase the contrast for special effects: for example, the harsh light of outer space. Default=0.0.
  - **Soften Diff. Edge** Increasing the value of Soften Diffuse Edge softens the edge between the diffuse and ambient portions of a surface. This helps
eliminate edges that can appear on a surface under certain circumstances. Default=50.

**NOTE** Soften Diffuse Edge slightly reduces the intensity of the light. You can counter this, to some extent, by increasing the Multiplier value.

**Diffuse** When on, the light affects the diffuse properties of an object's surface. When off, the light has no effect on the diffuse surface. Default=on.

**Specular** When on, the light affects the specular properties of an object's surface. When off, the light has no effect on the specular properties. Default=on.

For example, by using the Diffuse and Specular check boxes you can have one light color the specular highlights of an object, while not coloring its diffuse component, and then have a second light color the diffuse component of the surface while not creating specular highlights.

**Optimizations rollout**

This rollout is identical to the Optimizations rollout on page 5479 for advanced ray-traced and area shadows.

**IES Sky Light (Photometric)**

Create panel > Systems > Create a Daylight system in your scene. > Modify panel > Daylight Parameters rollout > Skylight > IES Sky

IES Sky is a physically-based light object that simulates atmospheric effects on skylight on page 8723. (IES stands for Illuminating Engineering Society; see IES Standard File Format on page 5376.)
Outdoor scene lit by the IES sky light

The **Daylight system** on page 5491 combines the two daylight components of sun and sky in a unified interface. It allows you to set date and time positions with the light type you want to use.

IES Sky works correctly only when the sky object is pointing down from the Z axis, meaning that it points down when looking from the Top view.

When using the default scanline renderer, IES Sky produces the best results when used in conjunction with one of the **advanced lighting options** on page 6600: radiosity or light tracing.
WARNING When you render with the mental ray renderer on page 6675, objects illuminated by IES Sky appear dark unless you turn on Final Gathering on page 8576. The toggle for Final Gathering is on the Final Gather rollout on page 6760 of the Render Setup dialog.

Using Render Elements with an IES Sky Light

If you use Render Elements on page 6807 to output the lighting element on page 6827 of an IES Sky light in a scene using either radiosity or the light tracer, you cannot separate the direct, indirect, and shadow channels of the light. All three elements of the IES Sky lighting are output to the Indirect Light channel.

See also:
- IES Sun Light (Photometric) on page 5506

Interface

On Turns the sky light on and off in the viewport.

Multiplier Adjusts the intensity of the skylight.
When this is set to 1.0, the intensity will be physically accurate based on angle. You can, however, override this by changing the value. This is useful for doing night shots with artificial lighting.

Sky Color The color swatch opens the Color Selector on page 371, which lets you set the color of the sky.
Coverage group

Clear, Partly Cloudy, Cloudy This choice determines the extent to which light is scattered through the sky. Use the slider to set the control to one of the named settings or anywhere in between.

Render group

NOTE These controls are unavailable when the mental ray renderer is active.

Cast Shadows Causes the sky light to cast shadows.
A great deal of processing is dedicated to the calculation of the subtle shadows cast by skylight on page 8723. If shadows are not important in your model, you can disable them and save substantial amounts of processing time. However, the results will not be as realistic.

NOTE The Cast Shadows toggle has no effect when using radiosity or the light tracer.

NOTE IES Sky objects will not cast shadows in an ActiveShade rendering on page 6550.

Rays per Sample The number of rays used to calculate skylight falling on a given point in the scene. For animation you should set this to a high value to eliminate flickering. A value of around 30 should eliminate flickering.

Increasing the number of rays increases the quality of your image. However, it also increases rendering time.
**Ray Bias** The closest distance at which objects can cast shadows on a given point in the scene. Setting this value to 0 can cause the point to cast shadows upon itself, and setting it to a large value can prevent objects close to a point from casting shadows on the point.

**mental ray Sun & Sky**

Daylight system > Modify panel > Daylight Parameters rollout > Sunlight/Skylight drop-down lists > mr Sun/mr Sky

The mental ray Sun & Sky solution is designed to enable physically plausible daylight simulations and accurate renderings of daylight scenarios.

In 3ds Max, this is achieved through the use of two special photometric lights and an environment shader that all work together:

- The mr Sun photometric light is responsible for the sunlight; the direct light from the sun.

The scene is lit by mr Sun only.

- The mr Sky photometric light is responsible for the skylight; it simulates the real-world phenomenon of indirect light created by the scattering of sunlight in the atmosphere.
The scene is lit by mr Sky only.

- The mr Physical Sky environment shader is responsible for the visible representation of the sun disk and the sky, both to the camera and in reflections and refraction, as well as for the virtual ground plane (gray in the following illustration).
mr Physical Sky is visible, but no lighting is present in the scene.

These lights are meant to be used together: mr Sun and mr Sky appear within the 3ds Max Daylight system on page 5491. When used in combination, this solution is called Sun & Sky.

**TIP** You can view the Sun & Sky combination in a viewport, which makes adjusting parameters fully interactive. For details, see this procedure on page 5519.

**NOTE** Sun & Sky is a true high-dynamic range photometric lighting system that requires the mr Photographic Exposure Control on page 7219 to be enabled. In some of the mental ray rendering presets on page 6561, such as those starting with "mental.ray.daylight," this is done automatically. Also, when you add a Daylight System from the Create menu, you have the option to activate the exposure control automatically.

**Using Sun & Sky with SSS Materials**

To use a mental ray fast SSS material on page 5946 together with the high-dynamic range Sun & Sky solution, be sure to turn on Scatter Indirect Illumination on the material's Advanced Options rollout so that the material can scatter the skylight, which is considered indirect.
Also, turn off Screen (Soft) Compositing Of Layers, also on the Advanced Options rollout; otherwise the output of the SSS shaders is clamped to a low dynamic range and will appear to render black.

**Common Parameters**

Certain parameters do the same things in mr Sun, mr Sky, and mr Physical Sky. For physical correctness, it is necessary to keep these parameters in sync with each other in all three elements. For example, a sun with a different Haze value than the sky cannot be guaranteed to be physically plausible.

For this reason the concept of parameter inheritance is included. Both the mr Sun light and the mr Physical Sky shader have check boxes labeled “Inherit from mr Sky” that are on by default. When these are on, the common parameters are all guided by the mr Sky light, which is the central point of control.

With parameter inheritance, you can concentrate on tweaking the parameters in one spot (mr Sky) and, as long as Inherit From mr Sky is on for both mr Sun and mr Physical Sky, you're sure to obtain consistent results.

**Procedures**

**To use mental ray Sun & Sky:**

1. Make sure mental ray on page 6675 is the active renderer.
2. From the Create menu, choose Lights > Daylight System. You can also find Daylight System on the Create menu under Systems, and from Create panel > Systems.
3. You're prompted to use the mr Photographic Exposure Control on page 7219. Click Yes to do so automatically.
4. Create a Daylight system in the Perspective (or a Camera) viewport: Drag and release to create the compass rose, move the mouse to position the light, and then click to place the light and finish creating the system.
5. Go to the Modify panel, and on the Daylight Parameters rollout, set Sunlight to mr Sun and Skylight to mr Sky.
6 When you choose mr Sky, you’re prompted to add a mr Physical Sky environment map. Click Yes to do so.

The parameters rollouts for mr Sun and mr Sky now appear on the Modify panel.

7 Open the Environment dialog on page 7163 (press 8) and make sure Common Parameters > Environment Map is set to mr Physical Sky, Exposure Control on page 7207 is set to mr Photographic Exposure Control.
**TIP** Should you wish to edit the mr Physical Sky parameters, an easy way to access them is to open the Material Editor (press M) and then drag the Environment Map button from the Environment panel > Common Parameters rollout to a material slot (sample sphere) in the Material Editor. When prompted for the copy method, choose Instance.

Open the **Render Setup dialog** on page 6506 (F10) to the Indirect Illumination panel and make sure Enable Final Gather is on. Choose the Draft preset as a starting point; this is the leftmost position of the FG Precision Presets slider.
IMPORTANT When using Sun & Sky, make sure Enable Final Gather is on. Because the skylight is a form of indirect light, it can be rendered only with the help of Final Gather. Without final gathering, Sun shadows render as unnaturally dark or black rather than bluish, as they are in the real world.

9 Render with Sun & Sky. To specify different times, dates, and locations in the Daylight system for different effects, use the Motion panel > Control Parameters settings or turn on Manual Override to place the sun by hand.

TIP For a more pleasing image, adjust the mr Photographic Exposure Control settings.

To see the sun and sky in the viewport:
The ability to display the mental ray Sun & Sky solution in the viewport lets you adjust parameters interactively, so that you can visualize the results immediately without having to render. Keep in mind, though, that the viewport representation is an approximation of the final result, so you’ll still need to render while fine-tuning the settings.

NOTE To use this feature, the display driver must be set to Direct3D (see Graphics Driver Setup Dialog on page 8313).

1 Follow the above procedure on page 5516 for adding mental ray Sun & Sky to your scene.

2 Open the Viewport Background dialog: Views menu > Viewport Background.

3 In the Background Source group, turn on Use Environment Background.
4 At the bottom of the dialog, make sure Viewport is set to Perspective, and then turn on Display Background in the lower-right group of controls.

5 Click OK.
   After a moment, the viewport background changes to show the environment.

6 If necessary, orbit the Perspective viewport so you get a view of the horizon.
Go to the Motion panel, select the Daylight object if necessary, and then change the Time group > Hours or Month setting using the spinner control. As you adjust the setting, the sky light reflects the change.

Adjust the hour so the sun is near the horizon, and then, if necessary, orbit the viewport so the sun is visible.
Go back to the Modify panel and adjust the settings on the mr Sky Parameters rollouts such as Multiplier and Red/Blue Tint. As you adjust the settings, the viewport shows the changes.

**Interface**

**Interface (common parameters)**

The most important common parameters are those that drive the entire shading and colorization model.

**NOTE** mr Sun and mr Physical Sky can inherit parameters from mr Sky even if the latter is off.
Multiplier A scalar multiplier for the light output. Default=1.0.

Haze In mr Physical Sky, the Haze setting corresponds to the Haze setting used by the Haze-Driven sky model on page 5529.

Horizon Height The vertical position of the horizon.
The default value, 0.0, places the horizon at a standard height. However, because the horizon is infinitely far away, this can cause trouble joining up with any finite geometry that is supposed to represent the ground. It can also cause issues rendering locations that are supposed to be at a high altitude, like mountain tops or the top of New York skyscrapers where the horizon really is visibly “below” the viewer.

This parameter allows tuning the position of the horizon. Note that this horizon doesn’t actually exist at a specific height in 3D space; it is a shading effect for rays that go below a certain angle. This parameter tweaks that angle. The total range available range is somewhat extreme, reaching from -10.0 (the horizon is “straight down”) to 10.0 (the horizon is at the zenith). In practice, only much smaller values are actually useful. For example, to push the horizon down just below the edge of a finite visible ground plane, use −0.2.

NOTE The Horizon height affects not only the visual representation of the horizon in the mr Sky light, but also the color of the mr Sun itself. In other words, the point where the sun “sets” will change for a Horizon height settings other than 0.0.
Horizon Blur The “blurriness” with which the horizon is rendered.
At 0.0 the horizon is completely sharp. Generally only values lower than 0.5 are useful, but the full range is up to 10.0 for a horizon that consists of blur only, with no actual horizon at all.

Ground Color The color of the virtual ground plane. Note that this is a diffuse reflectance value (that is, albedo). The ground appears as a Lambertian reflector with this diffuse color, lit by the sun and sky only, and does not receive any shadows.

TIP Some sky models neglect the influence of bounce light from the ground, assuming only the sky is illuminating the scene. To compare the output of mr Sky with, for example, the IES Sky light, set Ground Color to black.

Night Color The minimum color of the sky: The sky will never become darker than this value. It can be useful for adding things like moon, stars, high-altitude cirrus clouds that remain lit long after sunset, etc. As the sun sets and the sky darkens, the contribution from Night Color is unaffected and remains as the base light level.

Red/Blue Tint Gives artistic control over the redness of the light. The default value of 0.0 is the physically correct value (calculated for a 6500K whitepoint), but can be changed with this parameter, which ranges from –1.0 (extremely blue) to 1.0 (extremely red).

Saturation Also an artistic control, where 1.0 is the physically calculated saturation level. The parameter ranges from 0.0 (black and white) to 2.0 (extremely boosted saturation).

mr Sun

Daylight system > Modify panel > Daylight Parameters rollout > Sunlight drop-down list > mr Sun

The mr Sun light is intended for use in the mental ray Sun & Sky combination. This topic mainly provides information on parameters unique to this component. A number of mr Sky parameters are common to all three Sun & Sky components. For some of those parameters, this topic provides a brief explanation plus a link to the main topic with additional details.

TIP You can view the Sun & Sky combination in a viewport, which makes adjusting parameters fully interactive. For details, see this procedure on page 5519.
See also:

- mental ray Sun & Sky on page 5513
- mr Sky on page 5527
- mr Physical Sky on page 5532

Interface

mr Sun Basic Parameters rollout

**On** Turns the mr Sun light on and off. Default=on.

**Multiplier** A scalar multiplier for the light output. Default=1.0.

**Targeted** Applicable only when you add an mr Sun light directly to the scene via Create panel > Lights > Photometric, rather than as part of a Daylight system on page 5491. When on, the light is targeted and you can change the target distance by moving the target. The distance between the light and its target is displayed to the right of the check box. When off, you can set this value directly. Default=on.

**Shadows group**

**On** Toggles shadowing for the light. Default=on.
**Softness** The softness of shadow edges. The default value of 1.0 accurately matches the softness of real solar shadows. Lower values make the shadows sharper and higher values make them softer.

**Softness** The number of shadow samples for the soft shadows. If it is set to 0, no soft shadows are generated. Default=8.

### Inherit from mr Sky group

**NOTE** mr Sun can inherit parameters from mr Sky even if the latter is off.

**Inherit from mr Sky** Uses the equivalent settings from the mr Sky Parameters rollout for the remaining mr Sun Parameters rollout settings. Default=on.

For further information, see Common Parameters on page 5516.

### Nonphysical Tuning group

These controls are available only when “Inherit From mr Sky” is off.

**Red/Blue Tint** Provides artistic control over the redness of the sky light. The default value of 0.0 is the physically correct value (calculated for a 6500K whitepoint), but can be changed with this parameter, which ranges from -1.0 (extremely blue) to 1.0 (extremely red).

**Saturation** Provides artistic control over saturation of the sky light. The default value of 1.0 is the physically calculated saturation level. Possible values range from 0.0 (black and white) to 2.0 (extremely high saturation).

### mr Sun Photons rollout

Use these settings to focus global-illumination photons on an area of interest. For example, if you've modeled a huge city as a backdrop, but are rendering only a room interior, you probably don’t want mental ray to shoot photons over the entire city, with the result that only a few will find their way into the room.

<table>
<thead>
<tr>
<th>mr Sun Photons</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Photon Target</td>
<td>✔</td>
</tr>
<tr>
<td>Radius:</td>
<td>0.0</td>
</tr>
</tbody>
</table>

**Use Photon Target** When on, uses the Radius setting with respect to the light target.
**Radius** Sets the radial distance from the target in which the mr Sun casts GI photons.

**mr Sky**

Daylight system > Modify panel > Daylight Parameters rollout > Skylight drop-down list > mr Sky

The mr Sky light is intended for use in the mental ray Sun & Sky combination. This topic mainly provides information on parameters unique to this component. A number of mr Sky parameters are common to all three Sun & Sky components. For some of those parameters, this topic provides a brief explanation plus a link to the main topic with additional details.

**TIP** You can view the Sun & Sky combination in a viewport, which makes adjusting parameters fully interactive. For details, see this procedure on page 5519.

See also:
- [mental ray Sun & Sky on page 5513](#)
- [mr Sun on page 5524](#)
- [mr Physical Sky on page 5532](#)

**Interface**

**mr Sky Parameters rollout**

![mr Sky Parameters rollout](image)

**On** Turns the light on and off.

**Multiplier** A scalar multiplier for the light output. Default=1.0.
**Ground Color** The color of the virtual ground plane. Note that this is a diffuse reflectance value (that is, albedo). The ground appears as a Lambertian reflector with this diffuse color, lit by the sun and sky only, and does not receive any shadows.

**TIP** Some sky models neglect the influence of bounce light from the ground, assuming only the sky is illuminating the scene. To compare the output of mr Sky with, for example, the IES Sky model, set Ground Color to black.

**Sky Model** Lets you choose the sky model to use. There are three choices:
- Haze Driven on page 5529
- Perez All Weather on page 5530
- CIE on page 5531

Use the Perez or CIE model when you want light from the sky to be physically accurate.

**mr Sky Advanced Parameters rollout**

**Horizon group**

**Height** The vertical position of the horizon. Default=0.0. For details, see Horizon Height on page 5523.
Blur The “blurriness” with which the horizon is rendered. Default=0.1. At 0.0 the horizon is completely sharp. Generally only values lower than 0.5 are useful, but the full range is up to 10.0 for a horizon that consists of blur only, with no actual horizon at all.

Night Color

Night Color The minimum color of the sky: the sky will never become darker than this value. This adjustment can be useful for adding things like the moon, stars, high-altitude cirrus clouds that remain lit long after sunset, and so on. As the sun sets and the sky darkens, the contribution from Night Color is unaffected and remains as the base light level.

Non-Physical Tuning group

Red/Blue Tint Provides artistic control over the redness of the sky light. The default value of 0.0 is the physically correct value (calculated for a 6500K whitepoint), but can be changed with this parameter, which ranges from –1.0 (extremely blue) to 1.0 (extremely red).

Saturation Provides artistic control over saturation of the sky light. The default value of 1.0 is the physically calculated saturation level. Possible values range from 0.0 (black and white) to 2.0 (extremely high saturation).

Aerial Perspective group

Aerial Perspective toggle When on, enables the Visibility Distance setting. When off, disables the effect of Visibility Distance. Default=on.

Visibility Distance Aerial Perspective is a term used by painters to convey how distant objects are perceived as hazier and tinted towards the blue end of the spectrum. mr Sky emulates this with the Visibility Distance parameter. When nonzero, it defines the “10% distance”, that is, the distance at which approximately 10% of haze is visible at a Haze level of 0.0.

Haze-Driven Sky Model

Create a Daylight system. > Choose mr Sky as the sky light. > Choose Haze Driven as the sky model. > mr Sky: Haze Driven rollout

This sky model uses a Haze value to specify the amount of water vapor or other particulate matter in the air. Possible values range from 0.0 (a completely clear day) to 15.0 (extremely overcast, or a sandstorm in the Sahara). The Haze
value influences the intensity and color of the sky and horizon, the intensity and color of sunlight, the softness of the sun’s shadows, the softness of the glow around the sun, and the strength of the aerial perspective.

**NOTE** The Haze-Driven sky model was the only sky model available in versions prior to Autodesk 3ds Max 2010.

**Interface**

**Haze** The amount of particulate matter in the air. Possible values range from 0.0 (a completely clear day) to 15.0 (extremely overcast, or a sandstorm in the Sahara). Default=0.0.

You can animate this value.

**Perez All-Weather Sky Model**

Create a Daylight system. > Choose mr Sky as the sky light. > Choose Perez All Weather as the sky model. > mr Sky: Perez Parameters rollout

The Perez All-Weather sky model is a physically accurate sky model recognized as an industry standard. It is controlled by two illuminance values.

**NOTE** The Perez model is suitable for daytime, but not for twilight or night scenes. For scenes where the sun is low or absent, use the Haze model, or the CIE model if you are concerned with photometric accuracy.

When you render while the Perez sky model is active, the sky color derives from the Haze value in the mr Physical Sky shader on page 5532. By default this is 0.0 (a clear sky, blue in the daytime), but you can use the shader to change the Haze value.
Interface

Diffuse Horizontal Illuminance The illuminance of the sky measured by a luminance meter placed horizontally, outdoors, excluding the contribution from the sun. Default=10000.0 lx. You can animate this value.

Direct Normal Illuminance The illuminance of the sun measured by a luminance meter aimed directly at the sun. Default=10000.0 lx. You can animate this value.

NOTE If you have chosen American units as the active lighting units, the illuminance values appear as footcandles (fc) rather than lux (lx).

CIE Sky Model

Create a Daylight system. > Choose mr Sky as the sky light. > Choose CIE as the sky model. > mr Sky: CIE Parameters rollout

The CIE sky model is a physically accurate sky model recognized as an industry standard. (CIE stands for Commission Internationale de l’Éclairage: the International Lighting Commission.) It is controlled by two illuminance on page 8606 values, and you can choose either an overcast or a clear sky.

When you render while the CIE sky model is active, the sky color derives from the Haze value in the mr Physical Sky shader on page 5532. By default this is 0.0 (a clear sky, blue in the daytime), but you can use the shader to change the Haze value.
Interface

**Diffuse Horizontal Illuminance** The illuminance of the sky measured by a luminance meter placed horizontally, outdoors, excluding the contribution from the sun. Default=10000.0 lx.

You can animate this value.

**Direct Normal Illuminance** The illuminance of the sun measured by a luminance meter aimed directly at the sun. Default=10000.0 lx.

You can animate this value.

**Overcast Sky** (The default.) Specifies an overcast sky.

**Clear Sky** Specifies a clear sky.

---

**NOTE** If you have chosen American units as the active lighting units, the illuminance values appear as footcandles (fc) rather than lux (lx).

---

**mr Physical Sky**

Daylight system > Modify panel > Daylight Parameters rollout > Skylight drop-down list > mr Sky > Confirm prompt.

The mr Physical Sky shader is intended primarily for use in the mental ray Sun & Sky combination. This topic mainly provides information on parameters unique to this component. A number of mr Physical Sky parameters are common to all three Sun & Sky components. For some of those parameters, this topic provides a brief explanation plus a link to the main topic with additional details.

**TIP** You can view the Sun & Sky combination in a viewport, which makes adjusting parameters fully interactive. For details, see this procedure on page 5519.
See also:

- mental ray Sun & Sky on page 5513
- mr Sky on page 5527
- mr Sun on page 5524

Procedures

The main difference between the mr Physical Sky Parameters rollout described here and the mr Sky Parameters rollout on page 5527 on the command panel is that this rollout lets you apply maps or shaders to the various parameters. However, this version of the rollout isn't quite as accessible; you must use the Material Editor to get at the controls.

To access the mr Physical Sky rollout:

1. Add an mr Sky on page 5527 component to the Daylight system on page 5491 (and confirm the addition of the mr Physical Sky environment map), or apply an mr Physical Sky shader as an environment map on page 7163 or in the Camera Shaders group of the Camera Effects rollout on page 6747.

2. Open the Material Editor on page 5641 and choose a sample slot.

3. Click the Get Material button.
   
   This opens the Material/Map Browser dialog on page 5724.

4. On the Material/Map Browser, in the Browse From group on the left side, choose Scene.
   
   The Browser lists maps and materials in the scene.

5. Find the mr Physical Sky map and double-click it to load it into the active sample slot.
   
   You can now edit the shader parameters and apply maps and shaders on the mr Physical Sky Parameters rollout.

   **TIP**  Alternatively, you can simply drag the map button from the Environment panel or Camera Effects rollout to a sample slot in the Material Editor.
Interface

NOTE This rollout is available only in the Material Editor. To access the rollout, follow the above procedure.

Sun Disk Appearance group

Use these settings to adjust the visible appearance of the sun in the sky.

Disk Intensity The brightness of the sun.

Glow Intensity The brightness of the glow surrounding the sun.

Scale The size of the sun disk.
Use Custom Background Map When on but no background map is specified, the background of the rendering is transparent black, suitable for external compositing. If you supply a background shader by clicking the button and then specifying a map or shader, the background of the rendering will come from that shader (for example, a texture map that uses a background photograph). In either case the mr Physical Sky will still be visible in reflections and refraction.

To apply a map or shader to this parameter, click the None button.

NOTE The background area in the rendered image’s alpha channel is always fully transparent, as is the case in general in 3ds Max.

Inherit from mr Sky Uses the equivalent settings from the mr Sky Parameters rollout for the remaining mr Physical Sky Parameters rollout settings, except for Aerial Perspective. Default=on.

For further information, see Common Parameters on page 5516.

Haze The amount of particulate matter in the air. Possible values range from 0.0 (a completely clear day) to 15.0 (extremely overcast, or a sandstorm in the Sahara). Default=0.0.

For details, see Haze on page 5523.

To apply a map or shader to this parameter, click the None button.

Horizon and Ground group

Horizon Height The vertical position of the horizon. Default=0.0.

For details, see Horizon Height on page 5523.

Blur The “blurriness” with which the horizon is rendered. Default=0.1.

At 0.0 the horizon is completely sharp. Generally only values lower than 0.5 are useful, but the full range is up to 10.0 for a horizon that consists of blur only, with no actual horizon at all.

Ground Color The color of the virtual ground plane. Note that this is a diffuse reflectance value (that is, albedo). The ground appears as a Lambertian reflector with this diffuse color, lit by the sun and sky only, and does not receive any shadows.

To apply a map or shader to this parameter, click the None button.
TIP Some sky models neglect the influence of bounce light from the ground, assuming only the sky is illuminating the scene. To compare the output of mr Sky with, for example, the IES Sky model, one must therefore set Ground Color to black.

After Dark group

Night Color The minimum color of the sky: The sky will never become darker than this value. It can be useful for adding things like moon, stars, high-altitude cirrus clouds that remain lit long after sunset, etc. As the sun sets and the sky darkens, the contribution from Night Color is unaffected and remains as the base light level.

To apply a map or shader to this parameter, click the None button.

Non-Physical Tuning group

Red/Blue Tint Provides artistic control over the redness of the sky light. The default value of 0.0 is the physically correct value (calculated for a 6500K whitepoint), but can be changed with this parameter, which ranges from -1.0 (extremely blue) to 1.0 (extremely red).

To apply a map or shader to this parameter, click the None button.

Saturation Provides artistic control over saturation of the sky light. The default value of 1.0 is the physically calculated saturation level. Possible values range from 0.0 (black and white) to 2.0 (extremely high saturation).

To apply a map or shader to this parameter, click the None button.

Aerial Perspective group

NOTE This parameter is for advanced users, and functions only when you use mr Physical Sky is used as a lens shader or volume shader. When used as a lens shader, the aerial perspective “mist” applies to primary rays only; it doesn’t appear in reflections. When used as a volume shader, it applies to the entire scene and every ray in it, including reflections and refraction.

Visibility Distance Aerial Perspective is a term used by painters to convey how distant objects are perceived as hazier and tinted towards the blue end of the spectrum. mr Sky emulates this with the Visibility Distance parameter. When nonzero, it defines the “10% distance”, that is, the distance at which approximately 10% of haze is visible at a Haze level of 0.0.
mr Sky Portal

Create panel > Lights > Photometric > mr Sky Portal
Create menu > Lights > Photometric > mr Sky Portal

The mr (mental ray) Sky Portal object provides an efficient method of “gathering” existing sky lighting in interior scenes without requiring high final gather or global illumination settings that would result in excessively long render times. In effect, a portal acts as an area light that derives its brightness and coloring from the environment.

**IMPORTANT** For mr Sky Portal to work correctly, the scene must contain a Skylight component. This can be an IES Sky light on page 5509, an mr Sky light on page 5527, or a Skylight on page 5412.

**Procedures**

**Example: To use the mr Sky Portal object:**

1. Make sure mental ray is the active production renderer on page 6582.
2. Create a scene with a windowed interior. Set up a camera in the interior and set a viewport to show the camera view.
3. Add a Daylight system:
   1. Create menu > Systems > Daylight System. When prompted use the mr Photographic Exposure Control, click Yes.
2 On the mr Photographic Exposure Control rollout on page 7219 set Preset to Physically Based Lighting, Indoor Daylight. This changes the exposure value to 10.0.

3 Change the Sunlight object to mr Sun and the Skylight object to mr Sky. (see mental ray Sun & Sky on page 5513)

For best results, position the sun so it’s not shining directly into the interior or turn it off. Otherwise the direct lighting could overwhelm the indirect lighting from the portal, especially when using final gathering and/or global illumination.
For each window, add an mr Skylight Portal object. The portal object is a wireframe rectangle with a central, perpendicular arrow showing the direction of light flow, or flux. Make each portal slightly larger than its respective opening, and position it immediately outside or inside the opening.
**TIP** To help place the portal object as close as possible to the outside surface, use AutoGrid on page 2792. Also, make sure portals do not overlap; this would cause the illumination from the overlapping area to be doubled.

Adding the Sky Portal object with AutoGrid on. Note the Light Flux Direction arrow pointing outward.

5 Make sure all portals’ arrows are pointing inside. If a portal’s arrow points outside, toggle its Flip Light Flux Direction check box on the mr Skylight Portal Parameters rollout.
With Flip Light Flux Direction on, the arrow points inward.

6 Turn on Final Gather on page 6760 and render the scene. If the image looks grainy, increase the Shadow Samples setting on the mr Skylight Portal Parameters rollout.
Scene lit by mr Sky Portal with final gather at Draft preset, no diffuse bounces
Interface

mr Skylight Portal Parameters rollout

On Toggles the illumination from the portal. When off, the portal has no effect on scene lighting.

Multiplier Amplifies the power of the light. For example, if you set the value to 2.0, the light will be twice as bright.

Filter Color Tints the coloring coming in from the outside.

Dimensions Set the Length and Width using these controls.

TIP To change the arrow size, use the Preferences > Viewports panel > Viewport Parameters group on page 8310 > Non-Scaling Object Size setting.

Flip Light Flux Direction Determines the direction in which light flows through the portal. The arrow must point toward the interior for the portal to cast light from the sky or environment. If it points outside, toggle this setting.

Shadows

On Toggles shadow casting by the light from the portal.
By default, the portal casts shadows only from objects inside the portal; that is, on the arrow side.
From “Outdoors” When on, casts shadows from objects outside the portal; that is, on the side away from the arrow icon. This is off by default, because turning it on can significantly increase render times.

Shadow Samples The overall quality of shadows cast by the portal. If the rendered image is grainy, increase this value.

Advanced Parameters rollout

Visible to Renderer When on, the mr Sky Portal Object appears in the rendered image. Turn this on to prevent outside objects from appearing in the window.

Transparency Filters the view outside the window. Changing this color doesn’t change the light coming in, but has the effect of darkening outside objects, which can help if they’re overexposed. To avoid recoloring the outside view, use a shade of gray, such as R=G=B=0.5.

Color Source Sets the source of the light from which the mr Sky Portal derives its illumination.

- **Use existing Skylight** Uses the skylight. By default, with the mr Sky light using the mr Physical Sky environment map at their default values, this tends to give a bluish illumination, as with real-world skylight.

- **Use Scene Environment** Uses the environment map for illumination color. Use this if your sky light and environment map are different colors, and you wish to use the latter for the interior illumination.

- **Custom** Lets you use any map for the illumination coloring. Choose Custom, and then click the button (“None”) to open the Material/Map Browser. Choose a map and click OK.
Cameras

Create panel > Cameras
Create menu > Cameras

Cameras present a scene from a particular point of view. Camera objects simulate still-image, motion picture, or video cameras in the real world.

With a Camera viewport on page 8154 you can adjust the camera as if you were looking through its lens. Camera viewports can be useful for editing geometry as well as setting up a scene for rendering. Multiple cameras can give different views of the same scene.

The Camera Correction modifier on page 5607 lets you correct a camera view to 2-point perspective, in which vertical lines remain vertical.

If you want to animate the point of view, you can create a camera and animate its position. For example, you might want to fly over a landscape or walk through a building. You can animate other camera parameters as well. For example, you can animate the camera's field of view to give the effect of zooming in on a scene.

The Display panel's Hide By Category on page 159 rollout has a toggle that lets you turn the display of camera objects on and off.

A convenient way to control the display of camera objects is to create them on a separate layer on page 7953. You can hide them quickly by turning off the layer.

**TIP** The Camera Match utility on page 5609 allows you to start with a background photograph and create a camera object that has the same point of view. This is useful for site-specific scenes.

There are two kinds of camera objects:

- A Target camera on page 5556 views the area around a target object. When you create a target camera, you see a two-part icon representing the camera and its target (a white box). The camera and the camera target can be animated independently, so target cameras are easier to use when the camera does not move along a path.

- A Free camera on page 5554 views the area in the direction the camera is aimed. When you create a free camera, you see a single icon representing the camera and its field of view. The camera icon appears the same as a target camera icon, but there is no separate target icon to animate. Free
cameras are easier to use when the camera's position is animated along a path.

An example of a camera in a scene.
The result after rendering through the camera.

You can create cameras from the Create menu > Cameras submenu, or by clicking the Cameras button on the Create panel. You can also create a camera by activating a Perspective viewport, and then choosing Views menu > Create Camera From View.

After you have created a camera, you can change viewports to display the camera's point of view. While a camera viewport is active, the navigation buttons change to **camera navigation buttons** on page 8154. You use the Modify panel in conjunction with a camera viewport to change the camera's settings.

While you use the navigation controls for a camera viewport, you can constrain Truck, Pan, and Orbit movement to be vertical or horizontal only with the Shift key.

You can move a selected camera so its view matches that of a Perspective, Spotlight, or another Camera view.

**Choosing a Camera for Vertical Views**

If you need an animated camera to look vertically upward or downward, use a free camera. If you use a target camera you might run into a problem of unexpected movement. 3ds Max constrains a target camera's up-vector (its
local positive Y axis) to be as close as possible to the world positive Z axis. This is no problem when you are working with a static camera. However, if you animate the camera and put it in a nearly vertical position, either up or down, 3ds Max flips the Camera view to prevent the up-vector from becoming undefined. This creates sudden changes of view.

Camera Object Icons

Camera objects are visible in viewports unless you choose not to display them. However, the geometry that appears in the viewport is only an icon meant to show you where the camera is located and how it is oriented.

Target cameras on page 5556 create a double icon, representing the camera (a blue box intersecting a blue triangle) and the camera target (a blue box). Free cameras on page 5554 create a single icon, representing the camera and its field of view.

A free camera has no target. A target camera has a target sub-object.

You cannot shade camera objects. However, you can render their icons using Animation menu > Make Preview and turning on Cameras in the Display In Preview group.

The display of camera object icons is not scaled when you change the scale of the viewport. When you zoom in on a camera, for example, the icon size does not change. To change the size of camera object icons, you can use the Viewports panel on page 8308 of the Preferences dialog, and change the value of Non-Scaling Object Size.
Scale transforms have the following effects on a camera object:

- Uniform Scale has no effect on a target camera, but does change the free camera's Target Distance setting.

- Non-Uniform Scale and Squash change the size and shape of the free camera's FOV cone. You see the effect in the viewport, but the camera's parameters do not update. Non-Uniform Scale and Squash will change the size and shape of a target camera's icon, but have no visible effect in the viewport.

**mental ray Camera Shaders**

When you use the mental ray renderer on page 6675, you can apply shaders to the camera used to render the scene. Specifically, you can assign shaders to modify the camera's lens, its output, or its volume (effectively making a volume out of the entire scene).
The scene's colors desaturated using the Night shader
Lens shader: lume Night shader with Multiplier set to 0.5

You assign camera shaders using the Render Setup dialog > Camera Effects rollout on page 6747 while the mental ray renderer is active.

NOTE No camera output shaders are provided with 3ds Max. You might have access to light map shaders if you have obtained them from other shader libraries or custom shader code.

See also:
■ Common Camera Parameters on page 5570
■ Characteristics of Cameras on page 5558
■ Using Transforms to Aim a Camera on page 5581
■ Using Clipping Planes to Exclude Geometry on page 5582
■ Using the Horizon to Match Perspective on page 5583
■ Animating Cameras on page 5585
Procedures

To render a scene using a camera:

1. Create the camera and aim it at the geometry you want to be the subject of your scene. To aim a target camera, drag the target in the direction you want the camera to look. To aim a free camera, rotate and move the camera icon.

2. With one camera selected, or if only one exists in the scene, set a Camera viewport for that camera by activating the viewport, then press C. If multiple cameras exist and none or more than one are selected, 3ds Max prompts you to choose which camera to use.
   You can also change to a Camera viewport by clicking or right-clicking the Point-Of-View viewport label, and then from the **POV viewport label menu** on page 8122 choosing Cameras > the name of the camera of choice.

3. Adjust the camera's position, rotation, and parameters using the Camera viewport's navigation controls. Simply activate the viewport, then use the Truck, Orbit, and Dolly Camera buttons. Alternately you can select the camera components in another viewport and use the move or rotate icons.
   If you do this while the **Auto Key button** on page 8090 is on, you animate the camera.

4. Render the camera viewport.

To change a viewport to a Camera view:

1. Click or right-click the POV viewport label.
   3ds Max opens the **Point-Of-View viewport label menu**. on page 8122.

2. Choose Cameras.
   The Cameras submenu shows the name of each spotlight or directional light in the scene.

3. Choose the name of the camera you want.
   The viewport now shows the camera's point of view.
   The default keyboard shortcut for camera viewports is C.
   Making a camera viewport active does not automatically select the camera. To adjust a camera by using its viewport and the Modify panel at the same time, select the camera and then make the Camera viewport active.
As in other viewports, in Camera viewports you can opt to see a display of safe frame areas to help you compose the final rendered output.

**To control the display of camera objects, do one of the following:**

- Go to the Display panel and in the Hide By Category rollout, turn Cameras on or off.
- Choose Tools menu > Display Floater, and on the Object Level tab turn Cameras on or off.
  
  When Hide > Cameras is off, cameras appear in viewports; when Hide > Cameras is on, they don’t appear.
  
  When camera icons are displayed, the Zoom Extents commands on page 8138 include them in views. When camera icons are not displayed, the Zoom Extents commands ignore them.

**To change the display size of camera icons:**

- Choose Customize > Preferences > Viewports, and set Non-Scaling Object Size (default=1.0 in current units).

  **NOTE**  This also changes the size of light icons, helper objects, and other non-scaling objects in the scene.

**To use the Modify panel in conjunction with a Camera viewport:**

1. Select the camera in any viewport.

2. Right-click the Camera viewport to activate the viewport without deselecting the camera.
   
   The Camera viewport becomes active, but the camera is still selected in the other viewports.

3. Adjust the camera using its Parameters rollout in the Modify panel and the navigation buttons.
   
   The Camera viewport updates as the parameters are changed.

**To constrain Pan and Orbit to be vertical or horizontal:**

- Hold down Shift as you drag in the viewport.
The initial direction of the drag sets the constraint. If you drag vertically at first, the pan or orbit is constrained to be vertical; if you drag horizontally at first, the constraint is horizontal.

The Zoom Extents All flyout and the Min/Max toggles remain visible. These controls aren't specific to camera views. Clicking Zoom Extents All affects other kinds of viewports, but does not affect Camera viewports.

To see the safe frame:

- Click or right-click the Point-Of-View viewport label. From the POV viewport label menu on page 8122, choose Show Safe Frame. The safe frames on page 8703 are displayed in three concentric boxes. The outermost safe frame matches the render output resolution. The safe frame on page 8703 matches the render output resolution.

Boxes in the viewport indicate safe frames.

To match a camera to a viewport:

1. (Optional) Select a camera.
2 Activate a Perspective viewport.

3 If no camera was selected, 3ds Max creates a new target camera whose field of view matches the viewport. If you first selected a camera, the camera is moved to match the Perspective view. 3ds Max also changes the viewport to a camera viewport for the camera object, and makes the camera the currently selected object.

**Free Camera**

Create panel > Cameras > Free
Create menu > Cameras > Free Camera

Free cameras view the area in the direction where the camera is aimed. Unlike target cameras, which have two independent icons for the target and the camera, free cameras are represented by a single icon, making them easier to animate. Free cameras can be used when the camera’s position is animated along a trajectory on page 8746, as in a walkthrough of a building or when the camera is attached to a moving vehicle. The free camera can bank as it travels along the path. If the camera needs to be directly overhead in a scene, use a free camera to prevent it from spinning.
A free camera can move and be oriented without restrictions.

**Initial Direction of a Free Camera**

A free camera’s initial direction is along the negative Z axis of the active construction grid of the viewport you click.

In other words, if you click in an orthographic viewport, the initial camera direction is directly away from you. Clicking the Top viewport aims the camera downward, clicking the Front viewport aims the camera at the scene from the front, and so on.

Clicking in a Perspective, User, Light, or Camera viewport aims the free camera downward, along the negative Z axis of the World Coordinate System.

Because the camera is created on the active construction plane, where you also create geometry, you might have to move the camera before you can see objects in its Camera viewport. Check the camera’s position from several viewports to correct.
Procedures

To create a free camera:

1  Do one of the following:
   ■ Choose Create menu > Cameras > Free Camera.
   ■ Click Cameras on the Create panel, then click Free on the Object Type rollout.

2  Click the viewport location where you want the camera to be. The kind of viewport you click determines the free camera's initial direction: the initial direction is along the negative Z axis of the active construction grid of the viewport you click.
   The camera is now part of the scene.

3  Set the creation parameters.

4  Rotate and move the camera to adjust the point of view.

Interface

See Common Camera Parameters on page 5570.

Target Camera

Create panel > Cameras > Target
Create menu > Cameras > Target Camera

A target camera "views" the area around the target icon that you place when you create the camera. A target camera is easier to aim than a free camera because you simply position the target object at the center of interest.

You can animate both the target camera and its target to create interesting effects. To animate both the target and camera along a path, it is best to link them both to a dummy object, then animate the dummy.
NOTE When you add a target camera, 3ds Max automatically assigns a Look At controller on page 3502 to it, with the camera's target object assigned as the Look At target. You can use the controller settings on the Motion panel to assign any other object in the scene as the Look At target.

Target cameras always face their target.

**Procedures**

**To create a target camera:**

1. Do one of the following:

   - Click Cameras on the Create panel, then click Target in the Object Type rollout.
   - Choose Create menu > Cameras > Target Camera.

2. Drag in a viewport. The initial point of the drag is the location of the camera, and the point where you release the mouse is the location of the target.
The camera is now part of the scene. It is aimed at the target, which is a separate object.

3 Set the creation parameters.

**Interface**

See [Common Camera Parameters](#) on page 5570 for a description of the common camera parameters.

The distance from the camera to the target is displayed at the bottom of the Parameters rollout. You can animate this parameter, or directly animate the target object's location.

When you rename a target camera, the target is automatically renamed to match. For example, renaming *Camera01* to *Rolli* causes *Camera01.Target* to become *Rolli.Target*. The target's name must have the extension .Target. Renaming the target object does not rename the camera object.

Clicking the line that connects the camera and its target selects both objects. However, region selection doesn't recognize the link line.

If a target camera is already selected, you add its target to the selection by right-clicking the camera, and then choosing Select Target from the quad menu > Tools1 quadrant. Or you can hold down the Ctrl key and click the target to add it to the selection set.

**Using Cameras**

These topics provide a general introduction to using cameras in 3ds Max.

**Characteristics of Cameras**

Real-world cameras use lenses to focus the light reflected by a scene onto a focal plane that has a light-sensitive surface.
Real-world camera measurements.
A: Focal length
B: Field of view (FOV)

Focal Length

The distance between the lens and the light-sensitive surface, whether film or video electronics, is called the focal length of the lens. Focal length affects how much of the subject appears in the picture. Lower focal lengths include more of the scene in the picture. Higher focal lengths include less of the scene but show greater detail of more distant objects.

Focal length is always measured in millimeters. A 50mm lens is a common standard for photography. A lens with a focal length less than 50mm is called a short or wide-angle lens. A lens with a focal length longer than 50mm is called a long or telephoto lens.

Field of View (FOV)

The field of view (FOV) controls how much of the scene is visible. The FOV is measured in degrees of the horizon. It is directly related to the focal length of the lens. For example, a 50mm lens shows 46 degrees of the horizon. The
longer the lens, the narrower the FOV. The shorter the lens, the wider the FOV.

**Relationship Between FOV and Perspective**

Short focal lengths (wide FOV) emphasize the distortions of perspective, making objects seem in-depth, looming toward the viewer.

Long focal lengths (narrow FOV) reduce perspective distortion, making objects appear flattened and parallel to the viewer.

*Upper left: Long focal length, narrow FOV*  
*Lower right: Short focal length, wide FOV*

The perspective associated with 50 mm lenses appears normal, partly because it is close to what the eye sees, and partly because such lenses are so widely used for snapshots, news photos, cinema, and so on.

**Differences Between Camera Objects and Real-World Cameras**

Many other controls on real-world cameras (such as those for focusing a lens, and advancing film) aren’t needed for computer rendering and have no counterpart in the camera objects.
3ds Max does have counterparts for the camera movements used in movie making, such as truck, dolly, and pan. See Camera Viewport Controls on page 8154.

**Procedures**

**To match a real-world camera frame proportion:**

1. Choose Rendering > Render Setup.  
The Render Setup dialog opens.

2. In the Output Size group, click the arrow to display the list of real world output sizes.

3. Select the type you want (both film and video output sizes are available).

4. Right-click the Camera viewport label, and turn on Show Safe Frame.  
The Safe Frame proportions will match those of the selected output size.

**Exposure Control in Real-World Cameras**

3ds Max uses concepts from the photographic world to help you design proper lighting conditions. Shutter speed and aperture are particularly important concepts to understand. They are used to control the amount of light in a scene. They also control focus effects.

If you are not familiar with how camera shutter speed and aperture can affect scene lighting and focus, read on. Otherwise, skip this section.
Aperture

In photography, the aperture controls the amount of light passing through a camera lens. Most often, an iris diaphragm is used to control the opening. The various settings are called f-stops. The smaller the f-stop, the larger the opening. Standard f-stop values are f1.8, f2.8, f4, f5.6, f8, f11 and f16.

Figure A = f1.8
Aperture can also be used to control depth of field. Depth of field is a technique used to focus on a fixed point in a scene, called a focal plane. The area around the focal plane remains in focus, while the rest of the image is blurred. More blurring occurs when the aperture is wider (set to a smaller f-stop).

The next illustration shows the effect of depth of field in a scene. The focal plane is set short, so that the chair is in focus, leaving the background blurred.

**Shutter Speed Control**

A camera shutter is set to various speeds, each of which determine the length of time a film is exposed. Shutter mechanisms are commonly blinds-like components that open progressively. Most often, they open up vertically, although they can also open up horizontally. Some devices, especially motion-picture cameras, have rotating shutters.

If the blades move slowly, a bigger slit opens and more light comes in. This is useful for dark environments or ones where there isn’t a lot of motion.
(Fast-moving objects, like a car racing by, blur when shutter speed is set too low.)

If the blades move fast, the slit is smaller and less light travels through the lens. This is useful for fast-moving action or bright environments with sun, snow, and sand.
Aperture and Shutter Speed

The following graphic illustrates the amount of light going through a lens set to an aperture opening of f11. In Figure A, shutter speed is fast and only a small amount of light travels through. In Figure B, shutter speed is slow and more light travels through.
Usually, you need to adjust both the shutter speed and aperture value to ensure that an optimum amount of light enters the camera.

In an exterior setting on a sunny day, for example, you would combine a faster shutter speed with a small aperture to compensate for the bright environment.

If the day is cloudy, however, you might want to reduce the speed so that more light travels through the lens. Otherwise, your shot will be underexposed and appear too dark.

If your environment includes fast-moving objects, you may choose to use a faster shutter speed to prevent blurring. To compensate for the faster shutter speed, you would also need to open the aperture to let in more light.
The challenge is to strike an effective balance between shutter speed and aperture. A setting that works well in one situation might not necessarily work well in another.

**Summary**

As you develop your scenes in 3ds Max, you will need to experiment with various aperture and shutter-speed settings to obtain the right lighting condition.

3ds Max provides you with a variety of exposure presets formulated to suit specific environmental conditions. You can then fine-tune your exposure by manually adjusting shutter speed and f-stops as needed.
The next three illustrations show the effects different exposure settings can have on an identical scene.

Properly exposed scene: shutter speed 1/500s at f8.
Underexposed scene: shutter speed 1/1000s at f16.
Overexposed scene: shutter speed 1/100s at f5.6.

**Common Camera Parameters**

Create panel > Cameras > Target button or Free button > Parameters rollout

Most of the camera controls are common to both kinds of cameras. This topic describes those controls.

**Procedures**

To view a wider area, do either of the following:

1. Use the FOV spinner to increase the camera's field of view.
2. Click a button with a shorter focal length. Use the Lens spinner to give the focal length a value other than the preset "stock" values on the buttons.
To view a narrower area, do either of the following:

1. Change the FOV parameter to decrease the camera's field of view.
2. Click a button with a longer focal length. Use the Lens parameter to give the focal length a value other than the preset "stock" values on the buttons.

In a camera viewport, the FOV button lets you adjust the field of view interactively.

The camera viewport Perspective button also changes the FOV in conjunction with dollying the camera.

**NOTE** Only the FOV value is saved with the camera. The focal length value is merely an alternative way to express and select the FOV.

To set the camera lens size:

1. In the Stock Lenses group, click a button to choose a stock focal length.
2. Set the Lens spinner to a custom focal length.

**TIP** If you want to maintain the same lens, avoid using the FOV or Perspective controls among the navigation icon buttons, and don't change the FOV spinner.

**IMPORTANT** When a camera viewport is active, changing the Output Size or (custom) Aperture Width in the Render Setup dialog on page 6506 will change the camera's Lens setting.

To match a camera to a film or video format:

1. On the Render Setup dialog, in the Output Size group, choose the type of output you want. Use either of the following methods.
   - Choose a preset, such as HDTV (video), from the drop-down list. The Aperture Width is locked to the preset's values.
   - Choose Custom and then set the desired Aperture Width value. (You can adjust the other output values at any later time. They have no affect on the camera lens settings, although they do affect the cropping of the scene.)
After setting Aperture Width, set the Lens value for the camera to the type of camera lens you want to emulate (for example, 50mm). To maintain the same lens, avoid using the FOV or Perspective controls among the navigation icon buttons.

To find a lens's focal length:

- To find the focal length of a lens based on changes in aperture width, open the Render Setup dialog on page 6506, choose Custom from the Output Size drop-down list, and specify a value in the Aperture Width spinner. The new value of the camera's Lens parameter is based on the new Aperture Width value.

To display a camera's cone:

- Turn on Show Cone.
  The camera's field-of-view cone appears outlined in light blue.

NOTE A camera’s cone is always visible while the camera object is selected, regardless of the Show Cone setting.

To display a camera's horizon line:

- Turn on Show Horizon.
  A dark gray line appears at the level of the horizon in the camera's viewport.
The horizon line might not be visible if the horizon is beyond the camera’s field of view, or if the camera is tilted very high or low.

To change the environment range:

- Adjust the value of Near Range or Far Range.
  By default, the Near Range=0.0 and the Far Range equals the Far clipping plane value.
  Environment ranges determine the near and far range limits for atmospheric effects you set in the Environment dialog.

To see the environment ranges in viewports:

- Turn on Show.
  The environment range displays as two planes. The plane closest to the camera is the near range and the one farthest from the camera is the far range.
To set clipping planes:

1. Turn on Clip Manually.
   When Clip Manually is off, the camera ignores the location of the Near and Far clipping planes, and their controls are unavailable. The camera renders all geometry within its field of view.

2. Set the Near Clip value to position the near clipping plane.
   Objects closer to the camera than the Near distance are not visible to the camera and aren't rendered.

3. Set the Far Clip value to position the far clipping plane.
   Objects farther from the camera than the Far distance are not visible to the camera and aren't rendered.
   You can set the Near clipping plane close to the camera so that it doesn't exclude any geometry, and still use the Far plane to exclude objects.
   Similarly, you can set the Far clipping plane far enough from the camera that it doesn't exclude any geometry, and still use the Near plane to exclude objects.
   The Near value is constrained to be less than the Far value.
   If the clipping plane intersects an object, it cuts through that object, creating a cutaway view.
To apply a multi-pass rendering effect to a scene:

1 In the Multi-Pass Effect group, turn on Enable and choose either Depth Of Field or Motion Blur.

2 In the Multi-Pass Effect group, turn on Enable.
   Depth Of Field is the only multi-pass effect that is provided with 3ds Max by default.

3 In the Multi-Pass Effect group, turn on Enable and choose Depth Of Field.

4 Use the Depth Of Field Parameters rollout on page 5590 or the Motion Blur Parameters rollout on page 5594 to set the values for the effect you chose.

5 Activate a camera viewport.

6 In the Multi-Pass Effect group, click Preview to preview the effect in the camera viewport.
   The Preview button has no effect if a camera viewport isn’t active.

7 Render the scene or animation.
## Interface

<table>
<thead>
<tr>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lens: 41.456 mm</td>
</tr>
<tr>
<td>FOV: 45.0 deg</td>
</tr>
<tr>
<td>Orthographic Projection</td>
</tr>
</tbody>
</table>

### Stock Lenses

<table>
<thead>
<tr>
<th>Stock Lenses</th>
</tr>
</thead>
<tbody>
<tr>
<td>15mm</td>
</tr>
<tr>
<td>28mm</td>
</tr>
<tr>
<td>85mm</td>
</tr>
</tbody>
</table>

### Type

- Free Camera

### Environment Ranges

- Show
- Near Range: 0.0
- Far Range: 1000.0

### Clipping Planes

- Clip Manually
- Near Clip: 1.0
- Far Clip: 1000.0

### MultiPass Effect

- Enable
- Preview
- Depth of Field
- Render Effects Per Pass

| Target Distance: 1.0 |
**Lens** Sets the camera's focal length in millimeters. Use the Lens spinner to give the focal length a value other than the preset "stock" values on the buttons in the Stock Lenses group box.

Changing the Aperture Width value on the Render Setup dialog also changes the value in the Lens spinner field. This doesn't change the view through the camera, but it does change the relationship between the Lens value and the FOV value, as well as the aspect ratio of the camera's cone.

**FOV Direction flyout** Lets you choose how to apply the field of view (FOV) value:

- **Horizontal** (The default.) Applies the FOV horizontally. This is the standard way to set and measure the FOV.
- **Vertical** Applies the FOV vertically.
- **Diagonal** Applies the FOV diagonally, from one corner of the viewport to the other.

**FOV** Determines how wide an area the camera views (field of view on page 8569). When FOV Direction is horizontal (the default), the FOV parameter directly sets the arc of the camera's horizon on page 8602, measured in degrees. You can also set the FOV Direction to measure FOV vertically or diagonally. You can also adjust the field of view interactively in a camera viewport on page 8154 by using the FOV button.

**Orthographic Projection** When on, the camera view looks just like a User view. When off, the camera view is the standard perspective-like view. While Orthographic Projection is in effect, the viewport navigation buttons behave as they ordinarily do, except for Perspective. Perspective function still moves the camera and changes the FOV, but the Orthographic Projection cancels the two out, so you don't see any change until you turn off Orthographic Projection.

**Stock Lenses group**

15mm, 20mm, 24mm, 28mm, 35mm, 50mm, 85mm, 135mm, 200mm These preset values set the camera's focal length in millimeters.

**Type** Changes the camera's type from a Target camera on page 5556 to a Free camera on page 5554, and vice versa.
NOTE When you switch from a target camera to a free camera, any animation applied to the camera's target is lost, because the target object goes away.

Show Cone Displays the cone (actually a pyramid) defined by a camera's field of view. The cone appears in the other viewports but does not appear in a camera viewport.

Show Horizon Displays the horizon line. A dark gray line appears at the level of the horizon in the camera's viewport.

Environment Ranges group

Near Range and Far Range Determine the near and far range limits for the atmospheric effects set on the Environment panel on page 7163. Objects between the two limits fade between the Far % and Near % values.

Show Displays rectangles within the camera's cone to show the Near and Far range settings.
Top: Conceptual image of the Near and Far ranges.
Bottom: Result after rendering.

**Clipping Planes group**

Sets options to define clipping planes on page 8532. In viewports, clipping planes are displayed as red rectangles (with diagonals) within the camera's cone.

**Clip Manually** Turn on to define clipping planes.
When Clip Manually is off, geometry closer to the camera than 3 units is not displayed. To override this, use Clip Manually.

**Near Clip and Far Clip** Sets near and far planes. Objects closer than the near clipping plane or farther than the far clipping plane are invisible to the camera. The limit of the Far Clip value is 10 to the power of 32.
With manual clipping on, the near clipping plane can be as close to the camera as 0.1 unit.

**WARNING** Extremely large Far Clip values can produce floating-point error, which can cause Z-buffer problems in the viewport, such as objects appearing in front of other objects when they shouldn’t.
Conceptual image of Near and Far clipping planes.

**Multi-Pass Effect group**

These controls let you assign a depth-of-field or motion blur effect to the camera. When generated by a camera, these effects generate blurring by rendering the scene in multiple passes, with offsets. They increase rendering time.

**TIP** The depth-of-field and motion blur effects are mutually exclusive. Because they rely on multiple rendering passes, applying both to the same camera could be prohibitively slow. If you want to use both depth-of-field and motion blurring in the same scene, use multi-pass depth-of-field (using these camera parameters) and combine it with **object motion blur** on page 8658.

**Enable** When on, previewing or rendering uses the effect. When off, the effect is not rendered.

**Preview** Click to preview the effect in an active camera viewport. This button has no effect if the active viewport is not a camera view.
Effect drop-down list  Lets you choose which multi-pass effect to generate, Depth Of Field on page 5590 or Motion Blur on page 5594. These effects are mutually exclusive. Default=Depth Of Field.

This list also lets you choose Depth of Field (mental ray) on page 5589, which lets you use the mental ray renderer's depth of field effect.

**NOTE**  The rollout for the chosen effect appears, by default, after the Parameters rollout.

Render Effects Per Pass  When on, applies rendering effects on page 7057, if any are assigned, to each pass of the multi-pass effect (depth of field or motion blur). When off, applies rendering effects only after the passes that generate the multi-pass effect. Default=off.

Turning off Render Effects Per Pass can improve the render time for multi-pass effects.

Target Distance  With a free camera, sets a point to use as an invisible target so that you can orbit a camera around that point. With a target camera, indicates the distance between the camera and its target.

### Using Transforms to Aim a Camera

You can use transforms to aim a camera and change its orientation in the scene.

Move on page 914 adjusts the position of the camera object or the position of a target camera’s target on page 5556.

Because the target is displayed as a small square, and because it is often in the same area as objects that are the subject of the camera, it can be hard to select by clicking. Select the camera object, right-click, then choose Select Target from the Tools 1 (upper-left) quadrant of the quad menu. You can also choose Cameras from the Selection Filters list on the toolbar, and then click the target.

Rotate on page 915 adjusts the orientation of the camera object. This transform is most useful with free cameras on page 5554.

You can’t rotate a Target camera about its local X and Y axes, because it is constrained to aim at its target. Use Move to move the camera or its target.
Also, if you rotate a Target camera to a nearly vertical position, either up or down, 3ds Max must flip the Camera view to prevent the up-vector from becoming undefined. If you need a camera to look vertically upward or downward, use a Free camera.

In a Camera viewport, you can also use the navigation buttons on page 8154 to adjust the camera interactively. Some navigation buttons, such as Dolly and Orbit actually move the camera or its target.

**Using Clipping Planes to Exclude Geometry**

Clipping planes let you exclude some of a scene’s geometry and view or render only certain portions of the scene. Each camera object has a near and a far clipping plane. Objects closer than the near clipping plane or farther than the far clipping plane are invisible to the camera.

Clipping planes are useful for rendering selected portions of a scene that has a lot of complex geometry. They can also help you create cutaway views.

Left: Clipping plane excludes the foreground chair and the front of the table.
Right: Clipping plane excludes the background chair and the rear of the table.
Clipping plane settings are part of the camera’s parameters on page 5570. The location of each clipping plane is measured along the camera’s line of sight (its local Z axis) in the current units for the scene.

You can set the near clipping plane close to the camera so that it doesn’t exclude any geometry, and still use the far plane to exclude objects. Similarly, you can set the far clipping plane far enough from the camera that it doesn’t exclude any geometry, and still use the near plane to exclude objects.

The near value is constrained to be less than the far value.

If the clipping plane intersects an object, it cuts through that object, creating a cutaway view. (How much of the cutaway object is visible depends on whether the object’s material is two-sided or not.)

You can also use clipping planes in non-camera viewports. Simply click or right-click the Point-Of-View (POV) viewport label, and from the POV viewport label menu on page 8122, choose Viewport Clipping on page 8117.

**WARNING** If you use the mental ray renderer on page 6675, geometry outside the clipping planes might still appear in renderings.

### Using the Horizon to Match Perspective

The horizon of a scene is the edge of vision at the height of the camera, parallel with the world coordinate plane. You can view the horizon in camera viewports.
A camera is level when it and its target are the same height from the world coordinate plane. In other words, the camera’s local Z axis is parallel to the world plane. When the camera is level, the horizon line is centered in the viewport. As the camera tilts up, the horizon line lowers; as it tilts down, the horizon line raises.

The horizon line control is in the camera’s Parameters rollout on page 5570.

The horizon line can help you match the perspective of your scene to the perspective of a still image. In general, matching perspective involves the following steps:

1. Display the horizon line. Use it to help you adjust the camera and target so they are level.

2. Display the image in the camera viewport. Use Views > Viewport Background and choose Files in the Background Source group. If the image's horizon and the camera horizon don't match, you have to offset the image, perhaps by using a paint program.
3. Use Orbit to move the camera until the perspective of the scene roughly matches that of the still image.

4. Adjust the camera's perspective to fine-tune the perspective match.

5. Use Move with the camera or target to position the scene against the background.
   - If you raise or lower the camera, raise or lower the target by an equal amount, in order to keep them level and maintain the horizon.
   - You can also use the Camera Match utility to match the perspective of a camera to a photograph. You will need accurate scene measurements to do so.

**Animating Cameras**

You animate a camera by using transforms or changing its creation parameters in different keyframes while the Set Key or Auto Key button is on. 3ds Max interpolates camera transforms and parameter values between keyframes, as it does for object geometry.

See Auto Key Animation Mode and Track View for further descriptions of animation. This topic summarizes some possibilities and suggests some techniques.

In general, it’s best to use a free camera when the camera is to move within the scene; use a target camera when camera position is fixed.

**Moving a Camera Along a Path**

Having a camera follow a path is a common way to create architectural walkthroughs, roller coaster rides, and so on.

- If the camera must bank or tilt close to the vertical (as on a roller coaster), use a free camera. Assign the Path constraint directly to the camera object. The camera follows the path, and you can adjust its point
of view by adding pans or rotate transforms. This is comparable to filming with a hand-held camera.

- For a target camera, link both the camera and its target to a dummy object on page 2840, then assign the path constraint to the dummy object. This is comparable to mounting the camera on a tripod on a dolly. It is easier to manage than having, for example, separate paths for the camera and its target.

**Following a Moving Object**

You can use a LookAt constraint on page 3585 to have the camera automatically follow a moving object.

- The LookAt constraint makes the object replace the camera’s target.
  - If the camera is a target camera, its previous target is ignored.
  - If the camera is a free camera, it effectively becomes a target camera. While the LookAt constraint assignment is in effect, the free camera cannot rotate around its local X and Y axes, and can’t be aimed vertically because of the up-vector constraint.

- An alternative is to link on page 3631 a target camera’s target to the object.

**Panning**

You can animate the pan of any camera very easily by following these steps:

1. Select the camera.
2. Activate the Camera viewport.
3. Turn on the Auto Key button and advance the time slider to any frame.
4. Use the Pan button (in the viewport navigation tools) and pan.

**Orbiting**

You can animate the orbiting of any camera very easily by following these steps:

1. Select the camera.
2. Activate the Camera viewport.
3 Turn on the Auto Key button and advance the time slider to any frame.

4 Use the Orbit button (in the viewport navigation tools) and orbit.

   The target camera revolves around its target; the Free camera revolves around its target distance.

**Zooming**

Zooming moves toward or away from the camera's subject matter by changing the focal length of the lens. It differs from dollying, which physically moves the camera but leaves the focal length unchanged. You can zoom by animating the value of the camera's FOV parameter on page 5570.

**Creating Animated Cutaway Views**

You can animate the creation of a cutaway view by animating the location of the near or far clipping planes on page 5582, or both.

**Multi-Pass Rendering Effects**

Create panel > Cameras > Target or Free > Parameters rollout > Multi-Pass Effect group

Cameras can create two kinds of rendering effects: depth of field and motion blur.
Motion blur applied to wings of the flying dragon

Multi-pass rendering effects use multiple renderings of the same frame, with slight camera movement between each rendering. The multiple passes simulate the blurring that film in a camera would register under certain conditions.

Although it is not a multi-pass effect, the choices in the drop-down list also let you specify the depth-of-field value for the mental ray renderer on page 6675. See Depth of Field Parameter (mental ray Renderer) on page 5589.
Depth of Field Parameter (mental ray Renderer)

Create panel > Cameras > Target button or Free button > Parameters rollout > Multi-Pass Effect group > Turn on Enable and choose Depth Of Field (mental ray). Depth Of Field Parameters rollout

On the Parameters rollout on page 5570, a “Depth Of Field (mental ray)” choice supports the mental ray renderer’s depth-of-field effects. To use this, turn on Enable in the camera’s Multi-Pass Effect group. Also turn on Depth Of Field on the Camera Effects rollout of the Render Setup dialog on page 6506.

The mental ray depth-of-field is exclusive of the multi-pass version of the depth-of-field effect. The mental ray renderer also supports motion blur for cameras, but the controls are not on the camera’s Parameters rollout: use the Motion Blur toggle on the Object Properties dialog for camera objects. This setting has no effect on the default 3ds Max scanline renderer.

NOTE When you use the mental ray renderer, reflected or refracted light rays do not always respect a camera’s clipping planes (set in the Clipping Planes group of the Parameters rollout). Also, large clipping-plane values can cause poor quality in the rendering of shadow maps. To fix this, narrow the clipping range or use ray-traced shadows.

Interface

f-Stop

Sets the camera’s f-Stop. Increasing the f-Stop value narrows the depth of field, and decreasing the f-Stop value broadens the depth of field. Default=2.0.

The f-Stop can have a value less than 1.0. This is not realistic in terms of an actual camera, but it can help you adjust the depth of field for scenes whose scale does not use realistic units.
Multi-Pass Depth of Field Parameters for Cameras

Create panel > Cameras > Target button or Free button > Parameters rollout > Multi-Pass Effect group > Choose Depth Of Field effect. > Depth Of Field Parameters rollout

Cameras can generate depth-of-field effects. Depth of field is a multi-pass effect on page 6672. You turn it on in the Parameters rollout on page 5570 for cameras. Depth of field simulates a camera's depth of field by blurring areas of the frame at a distance from the camera's focal point (that is, its target or target distance).

Multi-pass depth of field

Top: Focus is in the middle distance, near and far objects are blurred.
Bottom left: Focus on near objects, far objects are blurred.
Bottom right: Focus on far objects, near objects are blurred.

You can preview depth of field in viewports.

![Previewing multi-pass depth of field in a shaded and a wireframe viewport](image)

**IMPORTANT**  This effect is for the default scanline renderer. The mental ray renderer on page 6675 has its own depth-of-field effect. See Depth of Field Parameter (mental ray Renderer) on page 5589.

**TIP**  To reduce the visible effect of multiple camera passes, try setting the antialiasing filter to Blend, with a Width value in the range 4.0 to 5.0, and a Blend value in the neighborhood of 0.1. (You choose the antialiasing filter and adjust its settings in the Default Scanline Renderer rollout on page 6589.) Also, try reducing the Dither Strength value, in the effect's Pass Blending group, to the neighborhood of 0.2.

**NOTE**  There is also a depth-of-field rendering effect on page 7159.

See also:

- Multi-Pass Motion Blur Parameters for Cameras on page 5594
Interface

NOTE The multi-pass depth-of-field parameters are animatable.

Focal Depth group

Use Target Distance When on, uses the camera's target distance as the point about which to offset the camera for each pass. When off, uses the Focal Depth value to offset the camera. Default=on.
Focal Depth When Use Target Distance is off, sets the depth from which the camera is offset. Can range from 0.0 to 100.0, where 0.0 is at the camera’s location and 100.0 is in the extreme distance (effectively, infinity). Default=100.0.

Low values of the Focal Depth give wildly blurry results. High Focal Depth values blur the distant portions of the scene. In general, using Focal Depth instead of the camera’s Target Distance tends to blur the entire scene.

Sampling group

Display Passes When on, the rendered frame window displays the multiple rendering passes. When off, the frame window displays only the final result. This control has no effect on previewing depth of field in camera viewports. Default=on.

Use Original Location When on, the first rendering pass is in the camera’s original location. When off, the first rendering pass is offset like all subsequent passes. Default=on.

Total Passes The number of passes used to generate the effect. Increasing this value can increase the effect’s accuracy, but at a cost of rendering time. Default=12.

Sample Radius The radius by which the scene is shifted to generate blurriness. Increasing this value increases the overall blurriness of the effect. Decreasing it reduces the blurriness. Default=1.0.

Sample Bias Weights the blurring toward or away from the Sample Radius. Increasing this value increases the magnitude of depth-of-field blurring, giving a more even effect. Decreasing it decreases the magnitude, giving a more random effect. Can range from 0.0 to 1.0. Default=0.5.

Pass Blending group

The multiple depth-of-field passes are blended by dithering, which you can control by the parameters in this group.

These controls apply only to renderings of the depth-of-field effect, not to previews in viewports.

Normalize Weights Passes are blended with random weighting to avoid artifacts such as streaking. When Normalize Weights is on, the weights are normalized, giving a smoother result. When off, the effect is a bit sharper but usually grainier. Default=on.
**Dither Strength** Controls how much dithering is applied to the rendered passes. Increasing this value increases the amount of dithering, and can make the effect grainier, especially at the edges of objects. Default=0.4.

**Tile Size** Sets the size of the pattern used in dithering. This value is a percentage, where 0 is the smallest tile, and 100 is the largest. Default=32.

**Scanline Renderer Params group**

These controls let you disable antialiasing or antialias filtering when you render the multi-pass scene. Disabling these rendering passes can improve render time.

These controls apply only to renderings of the depth-of-field effect, not to previews in viewports.

**Disable Filtering** When on, disables the filtering pass. Default=off.

**Disable Antialiasing** When on, disables antialiasing. Default=off.

**Multi-Pass Motion Blur Parameters for Cameras**

Create panel > Cameras > Target button or Free button > Parameters rollout > Multi-Pass Effect group > Choose Motion Blur effect. > Motion Blur Parameters rollout

Cameras can generate motion blur effects. Motion blur is a multi-pass effect on page 6672. You turn it on in the Parameters rollout on page 5570 for cameras. Motion blur simulates the motion blur of a camera by offsetting rendering passes based on movement in the scene.
Above: Motion blur applied to wings of the flying dragon
Below: Multiple passes appear in successive refreshes of the rendered frame window.

You can preview motion blur in viewports.
Previewing multi-pass motion blur in a wireframe and a shaded viewport

**IMPORTANT** This effect is for the default scanline renderer. The mental ray renderer on page 6675 has its own depth-of-field effect. See Motion Blur with the mental ray Renderer on page 6693.

**TIP** To reduce the visible effect of multiple camera passes, try setting the antialiasing filter to Blend, with a Width value in the range 4.0 to 5.0, and a Blend value in the neighborhood of 0.1. (You choose the antialiasing filter and adjust its settings on the Default Scanline Renderer rollout on page 6589.) Also, try reducing the Dither Strength value, in the effect's Pass Blending group, to the neighborhood of 0.2.
NOTE The multi-pass motion blur parameters are animatable.

Sampling group

Display Passes When on, the rendered frame window displays the multiple rendering passes. When off, the frame window displays only the final result. This control has no effect on previewing motion blur in camera viewports. Default=on.

Total Passes The number of passes used to generate the effect. Increasing this value can increase the effect’s accuracy, but at a cost of rendering time. Default=12.

Duration (frames) The number of frames in the animation to which the motion blur effect will be applied. Default=1.0.
**Bias** Changes the blurring so that it appears to derive more from frames before or after the current frame. Range=0.01 to 0.99. Default=0.5.

By default, the blurring comes equally from frames before and after the current frame; that is, a blurred object appears at the center of the blurred area. This is the closest to what an actual camera would capture. Increasing the Bias value moves the blurring behind the blurred object, in relation to its direction of motion. Decreasing it moves the blurring in front of the blurred object. Extreme values move most of the blurring very close to the blurred object, which makes it difficult to see. For best results, use intermediate Bias values in the range 0.25 to 0.75.

**Pass Blending group**

The multiple motion blur passes are blended by dithering, which you can control by the parameters in this group.

These controls apply only to renderings of the motion blur effect, not to previews in viewports.

**Normalize Weights** Passes are blended with random weighting to avoid artifacts such as streaking. When Normalize Weights is on, the weights are normalized, giving a smoother result. When off, the effect is a bit sharper but usually grainier. Default=on.

**Dither Strength** Controls how much dithering is applied to the rendered passes. Increasing this value increases the amount of dithering, and can make the effect grainier, especially at the edges of objects. Default=0.4.

**Tile Size** Sets the size of the pattern used in dithering. This value is a percentage, where 0 is the smallest tile, and 100 is the largest. Default=32.

**Scanline Renderer Params group**

These controls let you disable antialiasing or antialias filtering when you render the multi-pass scene. Disabling these rendering passes can improve render time.

These controls apply only to renderings of the motion blur effect, not to previews in viewports.

**Disable Filtering** When on, disables the filtering pass. Default=off.

**Disable Antialiasing** When on, disables antialiasing. Default=off.
Walkthrough Assistant

Animation menu > Walkthrough Assistant

The Walkthrough Assistant lets you easily create a predefined walkthrough animation of your scene by placing a camera on a path and setting the height, turning the camera and viewing a preview. This feature is available from the Animation Menu.

Procedures

To create a Walkthrough camera:

1. Choose Walkthrough Assistant from the Animation menu.
   
   The Walkthrough Assistant floater is displayed.

2. In the Main Controls rollout, click the Create New Camera button.
   
   A free camera named Walkthrough_Cam01 is created and displayed in the viewports. The camera is also listed by name in the Cameras list. If the camera is not visible in any viewport, zoom out to see it.
   
   Additional rollouts are also displayed in the floater.

   **NOTE** You can rename the camera with a more descriptive name from the Modify panel.

To set the camera path:

1. After the camera is created, create a path in the scene using the desired spline shape or NURBS curve.

   **NOTE** Text and Section are generally not useful shapes for creating a camera path.

   **TIP** You will have smoother camera movements if you set the Creation Method for the spline shape to Smooth or Bezier instead of Corner.

2. Click Pick Path from the Path Control group, and select the path you created.

3. Click the Play button or scrub the time slider to see the camera move along the path.
4 Activate the Perspective viewport, then click the Set Viewport to Camera button in the Cameras group.
   Now you can see what the camera sees.
   You will probably need to adjust the camera height and tilt at this point.

To adjust the camera height and tilt:

1 In the Path Control group, turn on Move Path to Eye Level. The path is set to the height specified for Eye Level.
2 Set the desired height using the numerical height spinner. The path moves in the viewports in real time.
   You can use Select and Move to place the path to the desired height if you find it faster than entering a value.
3 Activate the Top viewport. In the View Controls rollout, move the slider in the Turn Head group to position the camera head towards the desired object in the scene.
4 Use the numerical spinner for Head Tilt Angle to change the angle of the camera head.

   **TIP** You can also use Select and Rotate to position the camera head.

5 Play the animation or scrub the time slider to see how the camera presents the scene.

To adjust the camera controls:

1 In the Advanced Controls rollout, use the numerical spinner to change the Field of View.
   If you want less of the scene to be seen, decrease the setting. Conversely, increase the setting if you want more of the scene to display.
2 Set the Target Distance to the range you want objects to be seen clearly in focus.

To animate the camera tilting and turning:

1 Move the time slider to Frame 0.
2 Turn on the Auto Key button.
3 Slide the Turn Head control to turn the camera head left, center, or right. If desired, adjust the Head Tilt Angle control up or down.

4 Use the time slider to advance the camera to the next place where you want to turn or tilt the camera differently.

5 When you’ve completed setting rotation keys for the camera, play the animation.

6 If you are not pleased with the results, click the Remove All Head Animation button in the Views Control rollout to quickly delete all the keys. To quickly reset the camera head position, click the Reset Eyes Level button.

**NOTE** Walkthrough Assistant uses a Bezier controller for the camera rotation. If you set too many keys or put keys too close together you may experience unexpected results such as “spinning” where the camera completely rotates about its Z axis. Go to Track View and adjust the rotation keys for the camera to correct this.

---

To render a preview:

- In the Render Preview rollout, click the Render Preview button to see a preview of what the camera sees.

**NOTE** The current renderer settings, such as mapping and shadows, will affect the preview.

---

To create a targeted camera:

1 In the Main Controls rollout, select Targeted.

2 Click the Create New Camera button. A camera and its target are placed in the scene. The camera is named incrementally and added to the Camera list.
   
   The Targeted toggled is also turned on in the Cameras group.

**NOTE** You can also change an existing free camera into a target camera by turning on Targeted.

3 Click the Pick Path button and select a spline.

4 In the Look-At-Camera rollout, click Object.
5 Click the Pick Target Object button, and select an object on which you want the camera to focus.
The target is moved to the object. If you had selected a path, the target would move to the path.

6 Click the Set Viewport to Camera button. The viewport label changes to reflect the current camera name and displays what the Targeted camera sees.

7 Click the Play Animation button or scrub the time slider to view the animation.
Interface

Main Controls rollout

Camera Creation group

Create New Camera  Automatically creates a free or targeted camera in the scene. Cameras are named *Walkthrough_Cam* followed by a sequence number.

- **Free**  (The default.) When chosen, the new camera is a free camera.
- **Targeted**  When chosen, the new camera is a target camera.
Cameras group

Cameras list Lists cameras in the scene by name.

Targeted Controls whether a selected camera in the Camera list is targeted or free. Turning on Targeted for a free camera will change it to targeted; turning it off for a targeted camera will change it to a free camera. Default=off.

Set Viewport to Camera Changes the active viewport to a camera viewport.

Path Control group

Pick Path Click this button to select a path in the scene. After you select a path, the button label changes to the object's name. Click the Clear Path button to disassociate the camera from the selected path.

Move Path to Eye Level When turned on, moves the path to the height set for Eye Level. When turned off, it moves the path to its original height when created.

Eye Level Allows you to specify a precise height of the path that either raises or lowers the camera view.

Render Preview rollout

Click to Render Preview Renders a preview. The preview appears in the small window in the Walkthrough Assistant floater.
View Controls rollout

This rollout only displays if a free camera is created or selected.

Turn Head group

**Turn Head Slider** Rotates the camera head as it moves along the path. This allows you to create the illusion that you are turning your head as you walk through the scene. Choices are Left, Center, Right. To animate the head turning, use the Auto Key button. This creates Z Rotation keys that can be adjusted in Track View.

**Head Tilt Angle** Rotates the camera as it moves along the path. This creates the illusion that you are tilting your head up or down as you walk through the scene. To animate, use the Auto Key button. This creates X Rotation keys that can be adjusted in Track View.

**NOTE** The Turn Head and Head Tilt Angle controls use a Bezier controller for rotation of the walkthrough camera. If you create too many keys, or place them too closely together you can experience unexpected results. For best results, start at the beginning and add keys as you move to the end, creating as few keys as possible.

**Reset Eyes Level** Constrains the head tilt to be level with the path.

**Remove All Head Animation** Deletes all key frames created when the Auto Key was enabled.
Look-At-Camera rollout

This rollout only displays if a targeted camera is created or selected.

Look-At-Camera group

Path When selected, allows you to select a path the camera's target will use.

Object When selected, allows you to select an object the camera's target will use.

Pick Target Path Press this button to select a path or object in the scene. Click the Clear Path button to disassociate the camera's target from the selected path or object.

Advanced Controls rollout

Camera Controls group

Field of View Adjusts the amount of the scene visible in the viewport and the perspective flare. Extreme values will create distortion in the viewport.
**Target Distance** Sets the distance the target is from the camera. This controls the size of the camera icon in the viewport. In a free camera, the point the camera orbits around is controlled by the target distance.

**Path Controls group**

**Constant Speed** Turn this on to maintain a constant speed along a path. When off, the velocity of the object along the path varies depending on the distance between the vertices on the path.

**Follow Path** When this is turned on, the camera stays perpendicular to the path. When this is turned off, the camera does not turn as it follows along the path.

---

**Camera Correction Modifier**

Select a camera. > Right-click. > Tools 1 (upper-left) quadrant of the quad menu > Apply Camera Correction Modifier

Select a camera. > Modifiers Menu > Cameras > Camera Correction

The Camera Correction modifier applies two-point perspective to a camera view. By default, camera views use three-point perspective, in which vertical lines appear to converge with height. In two-point perspective, vertical lines remain vertical.

The amount of correction you need to use depends on how steeply the camera tilts. For example, a camera that looks up from ground level to the top of a high building will need more correction than a camera that looks toward the horizon.

---

**NOTE** This modifier doesn’t appear on the Modify panel’s Modifier List.
Normal camera view (left) and corrected camera view (right)

Procedures

To apply two-point perspective to a camera:

1. Select a camera.

   **TIP** For best results, set a viewport to this camera’s view. The change in perspective appears both in the viewport and when you render this view.

2. Apply the Camera Correction modifier.

3. On the 2-Point Perspective Correction rollout, click Guess.
   The Camera Correction modifier creates a first-guess Amount value for the two-point perspective.

4. Adjust the Amount and Direction to get the effect you want.
   In the viewports, the camera’s field-of-view “cone” distorts or moves to show the perspective adjustments.

5. Render the view.
Interface

Amount Sets the amount of correction for two-point perspective. Default=0.0.

Direction Biases the correction. Default=90.0.
Setting Direction greater than 90.0 biases the correction to the left. Setting it less than 90.0 biases it to the right.

Guess Click to have the Camera Correction modifier set a first-guess Amount value.

Camera Match Utility

Tools menu > Camera Match
Utilities panel > Utilities rollout > Camera Match button

The Camera Match utility uses a bitmap background photo and five or more special "CamPoint" objects to create or modify a camera so that its position, orientation, and field-of-view matches that of the camera that originally created the photo.

Procedures

The general process to follow in using Camera Match is described in the following procedures.
To use camera matching:

1. Load a bitmap as a background for the renderer.
2. Load a bitmap as a background for the viewport.
3. Identify on the bitmap at least five features that will be used for the match. These should be objects or corners of objects in the scene that can be identified and tracked. They should remain visually throughout the scene, and should not change their shape too much or they won’t work.
4. Create CameraPoints, which are helper objects found in these locations: Create panel > Helpers > Camera Match > Object Type rollout > CamPoint, and Create menu > Helpers > Camera Point.
   You must have accurate measurements of distances between at least five features in your scene, which can’t be all on a single plane. Try to use points that are distributed throughout the scene rather than features that are all clustered in the front or back. This will give the most accurate results.
5. Position these CameraPoints to correspond to points in your photo. You can use the Transform Type-In on page 899 to position the points in the correct locations in 3D space.
6. Use the Camera Match utility to assign the CameraPoints to pixel locations on the bitmap.
7. Choose Create Camera and a camera is created to match the one that took the picture.
   If there are errors and the camera cannot be created, readjust the point positions in 3D space, and reassign them to the bitmap. It’s easy to make a mistake doing either, but once you get it right the match should work.

To establish the bitmap background for the renderer:

1. Reset 3ds Max, and enlarge the Perspective viewport to full screen.
2. From the Rendering menu choose Environment.
3. In the Common Parameters rollout, under Environment Map, click the gray box marked None. This launches the Material/Map Browser.
4. Be sure to set Browse From to New; if it isn’t set already, then choose Bitmap from the list and click OK. The Select Bitmap Image File dialog appears.
5 Navigate and select the appropriate bitmap and then choose Open. Use Map is turned on automatically.

6 Render the viewport to verify that the background appears in the rendering. Press Shift+Q to render.

**To establish the bitmap background to display in the viewport:**

1 Choose Views menu > Viewport Background on page 128. This opens the Viewport Background dialog

2 In the Background Source group, click Files. This launches the Select Background Image dialog.

3 Navigate and select the appropriate bitmap and then choose Open.

4 Set Aspect Ratio to Match Bitmap.

5 Make sure Display Background is turned on, and then choose OK. The background appears in the viewport.

**NOTE** You can click the Use Environment Background button, but then you don’’t have the Aspect Ratio controls.

**To create CamPoint objects:**

1 In the Helpers group of the Create panel, open the list and select Camera Match.

2 Choose Create menu > Helpers > CamPoint.

3 On the Object Type rollout, click the CamPoint button.

4 Create your CamPoint objects anywhere in the scene, and reselect each of them to enter their absolute coordinates using the Transform Type-In.

5 Open the Keyboard Entry rollout.

6 Enter the coordinates of the first CamPoint object (0,0,0), click the Create button, and then enter the name in the name field.
TIP To use the keyboard, first click in the X field, enter its value, and then press Tab to move to the next field and enter its value. Continue this until you tab to the Create button, and then press Enter to create the CamPoint, followed by Tab to move back to the X field, where you can start again. You can create all the CamPoint objects with default names, and then use the Select By Name floater (Tools > Selection Floater) to select and rename the six pointers.

7 Repeat the above steps for the remaining CamPoint objects.

NOTE An alternative method is to create the CamPoint objects anywhere in the scene, and then reselect each of them and enter their absolute coordinates using the Transform Type-In.

You now have the CamPoint objects occupying real-world coordinate positions that correspond to the structure in the bitmap image. The last sequence of steps involves using the Camera Match utility to specify the screen coordinate points, one for each CamPoint object, and generating a camera position based on the data.

To use the Camera Match utility:

1 On the Utilities panel, click the Camera Match button.
   The Camera Match utility appears, listing the CamPoint objects.

2 Select the first CamPoint object and click the Assign Position button.

3 Place the cursor over the corresponding feature in the bitmap and click.
   A small, red cross appears.

4 If the dot is not in the right position, you can either click again with the mouse or adjust the Input Screen Coordinates to tweak its position.

5 Select the second object in the list, and repeat steps 3 and 4.

6 Repeat for all the points. By setting the red crosses, you’ve indicated the X and Y pixel position on the bitmap and correlated it with each CamPoint as it exists in 3D space.

7 Once you have all of the points set, click the Create Camera button.
   A camera is created in the scene based on the location of the CamPoint objects and the specifications of the screen coordinates points.
NOTE If the Current Camera Error reading is greater than five, at least one of your screen coordinate points is placed wrong. Check each of them, and review the description following step 5. After reassigning the points, select the existing camera and click the Modify Camera button to recalculate the camera position.

8 Press C to switch the Perspective view to that of the new camera.

Interface

CamPoint Info rollout

List window Displays a list of the CamPoint helper objects in the scene. You select the CamPoint objects from this list to assign screen coordinate points. Note that if you select a CamPoint object in the viewport, it’s highlighted in this list as well.

Input Screen Coordinates

X/Y Fine-tunes the position of the screen coordinate points in 2D space.

Use This Point Turns off a specific coordinate point without deleting it. Select the corresponding CamPoint in the list, and then turn off Use This Point. This feature is typically used for troubleshooting when the Current Camera Error is too high (greater than five, for example).
Assign Position Click a location on the viewport bitmap to place a screen coordinate point visually against the background image. The point you place corresponds to the currently selected CamPoint object. After activating the Assign Position button, select a CamPoint object from the list, and then click in the viewport at a position on the bitmap background that corresponds with where the associate CamPoint object should be in the 3D scene. After repeating this process with each CamPoint object in the list, you can click the Create Camera button to create a camera that matches the placed coordinates with their associate CamPoint objects.

Camera Match rollout

Create Camera Creates a camera in the scene whose position, orientation, and field of view is based on the current location of the CamPoint helpers and the assigned screen coordinate points.

Modify Camera Modifies the position, orientation and FOV of an existing, selected camera based on the CamPoint helpers and assigned screen coordinate points.

Iterations Maximum number of iterations used to calculate the camera position. Default is 500, though a stable solution is usually found in less than 100 iterations.

Freeze FOV Prevents the FOV (field of view) of the camera from being changed when using the Create Camera or Modify Camera buttons. Use if the FOV of the camera that took the photograph is known and you want to preserve it.
Current Camera Error Displays the total error that remains between the placed screen coordinate points, the CamPoint helpers, and the camera position after the final computation. The calculations involved in the camera match are seldom perfect. A good error range is about 0 to 1.5.

Close Exits the Camera Match utility.

CamPoint Helper

Create panel > Helpers > Camera Match > CamPoint
Create menu > Helpers > Camera Point

CamPoint helper objects are used by the Camera Match utility on page 5609 to reproduce in a camera the same settings (position, roll, and FOV) that were used by a real-world camera to shoot a background image. This allows you to view your scene from the same perspective as the background image, which is a key step to mixing computer-generated and photographically-generated images in a single composited shot.

Place CamPoint objects in the scene at locations that will be visible in the background photograph. By comparing the X/Y/Z position of several camera point objects to their analogous positions in a background image, the Camera Match utility is able to determine the real-world camera’s settings, and use these settings to either create a new camera or move/reset an existing camera to match them.

Clicking CamPoint displays the Keyboard Entry and Camera Match Point rollouts, which you use to create and name the camera points.

Procedures

To create a camera match point:

1. On the Create panel, click the Helpers button.

2. Choose Camera Match from the list and click the CamPoint button in the Object Type rollout.
   The button turns yellow when it is active. You are now ready to create a camera point.

3. Choose Create menu > Helpers > Camera Point.
4 Click in the viewport to create a CamPoint helper object. Alternatively, you can use the keyboard to create a CamPoint object by expanding the Keyboard Entry rollout, entering values in the fields, and then clicking Create.

To position camera match points in your scene, do one of the following:

1 Create your camera match points using keyboard entry. Use this if you have accurate actual measurements of the locations of the points.

2 Build geometry that matches your scene geometry, and then snap the points to the geometry using snaps. Use this technique when you don’t have measurements and can approximate the geometry.

3 Create your camera match points interactively, and then use Transform Type-In to move them to the correct locations.
Interface

Name and Color rollout

Lets you name the CamPoint object before you create it. If you want to name it after you create it, change its name in the Modify panel.

Keyboard Entry rollout

X, Y, Z Let you enter the X, Y, and Z coordinates where a CamPoint object will be inserted. Field values reflect the current Unit setup.
**Create** Inserts the CamPoint object into the scene.

**Camera Match Point rollout**

**Show Axis Tripod** Controls whether an axis tripod is displayed with the Camera point object. Default=on.

**Axis Length** Controls the length of the axis tripod. When Show Axis Tripod is on you can watch the tripod change length in the viewport while you adjust the spinner arrows. When Show Axis Tripod is off, you can still make adjustments the Axis Length value, but the axis tripod won’t be displayed.
Materials describe how an object reflects or transmits light. Within a material, maps can simulate textures, applied designs, reflections, refractions, and other effects. (Maps can also serve as environments and projections from lights.) The Material Editor is the dialog you use to create, alter, and apply the materials in your scene.

Image by Michael McCarthy
Designing Materials

These topics give you an overview of using the Material Editor to design materials on page 8635. The Material Editor on page 5641 gives you a wide variety of options for designing material, as well as myriad controls. If you’re new to the Material Editor, read this topic for a general idea about working with materials, and what the most important options are.

Materials make objects look more convincing.

For more details, follow the links in the workflow outline.

Workflow Outline

In general, when you create a new material and apply it to an object, you follow these steps:

1  Make a sample slot on page 5621 active, and enter a name for the material you are about to design.

2  Choose the material type on page 5623.
TIP 3ds Max provides two renderers: the default scanline renderer on page 6589 and the mental ray renderer on page 6675, each with distinctive capabilities. You choose a renderer for each scene based on its features. It is a good idea to design materials with a particular renderer in mind. The mental ray Connection rollout on page 5763 lets you add features unique to the mental ray renderer to basic 3ds Max materials.

When rendering with mental ray, we recommend that you use materials from the ProMaterials on page 5772 group. These are commonly used materials (ceramic, concrete, hardwood, and so on) that have accurate real-world properties. ProMaterials are based on the Arch & Design material on page 5858. Arch & Design is a general-purpose material that also has real-world properties, and a large number of options. When you grow familiar with mental ray rendering, you might choose to use the Arch & Design material itself, or some of the special-purpose on page 5921 mental ray materials that are also available.

3 For a Standard or Raytrace material, choose the shading type on page 5960.
4 Enter settings for the various material components on page 5624: diffuse color, glossiness, opacity, and so on.

NOTE Lights and Shading on page 5625 describes how lights affect the appearance of a material. Choosing Colors for Realism on page 5965 gives guidelines on getting good results from non-physical materials such as the Standard material.

5 Assign maps on page 5627 to the components you want to map, and adjust their parameters.
6 Apply on page 5626 the material to the object.
7 If necessary, adjust the UV mapping coordinates on page 5636 in order to orient maps with objects correctly.
8 Save on page 5638 the material.

**Sample Slots and Material Name**

The sample slots on page 5650 display previews of materials. They are the most prominent feature of the Material Editor interface. Below and to the right of the sample slots are various tool buttons on page 5663 for the Material Editor. Below the tool buttons is a name field that shows the name of the material.
**TIP** Always give a material a unique, intelligible name as soon as you begin to work on it.

By default, six sample slots are visible at once. The Material Editor actually holds 24 materials at one time. You can use the scroll bars to move among the sample slots, or you can change the number of sample slots visible at once to 15 or 24 slots. Seeing more slots at once can be helpful if you are working with a complex scene.

**IMPORTANT** While the Material Editor can edit no more than 24 materials at a time, a scene can contain an unlimited number of materials. When you are through editing one material, and have applied it to objects in the scene, you can use that sample slot to get on page 5687 a different material from the scene (or create a new one) and then edit it.

To increase the number of sample slots visible at once, right-click a slot and then choose 5 X 3 Sample Windows or 6 X 4 Sample Windows from the pop-up menu.
NOTE The right-click menu also has an Options choice on page 5681. This displays a dialog with various options for sample display. Exploring these options can help you learn to preview materials effectively. However, keep in mind that these settings affect the sample display only. They change nothing in the 3ds Max scene.

When more sample slots are visible, the images are smaller, but you can display a larger, floating, and resizable material sample by double-clicking the slot you want to see better.

Click a sample slot to make it active. Now you can design a new material from scratch, or you can load a previously stored material by clicking Get Material on page 5687, which displays the Material/Map Browser. The Browser is a dialog that lets you choose materials and maps from a material library, from the scene, and so on.

You can also copy a material from one sample slot to another. Drag the slot with the material to another slot. To avoid confusion, rename the copy in the new sample slot before you begin to make changes to it.

Choosing a Material Type

Every material has a type. In general, you choose a material type based on what you are trying to model, and how accurate (in terms of real-world, physical lighting) you want your model to be.

3ds Max provides two renderers: the default scanline renderer on page 6589 and the mental ray renderer on page 6675, each with distinctive capabilities. It is a
good idea to design materials with a particular renderer in mind. The main choice is whether you want your rendering to be physically accurate.

- If physical accuracy is not a concern, you can use the scanline renderer and the Standard material on page 5960 along with other non-photometric materials. These give you a wide variety of physical effects.

- You can also use the scanline renderer to create accurate lighting by using radiosity on page 6615. In this case, we recommend you use the Architectural material on page 6148. An alternative when you use radiosity is to set up the scene with standard materials, but then apply physical characteristics to them with the Advanced Lighting Override material on page 6166.

- The mental ray renderer assumes that lighting is physically accurate. It can also generate some effects the scanline renderer cannot. The mental ray renderer provides the best results when you model a scene with accurate units, photometric lights on page 5348, and mental ray materials on page 5772.

**TIP** When rendering with mental ray, we recommend that you use materials from the ProMaterials on page 5772 group. These are commonly used materials (ceramic, concrete, hardwood, and so on) that have accurate real-world properties. ProMaterials are based on the Arch & Design material on page 5858. Arch & Design is a general-purpose material that also has real-world properties, and a large number of options. When you grow familiar with mental ray rendering, you might choose to use the Arch & Design material itself, or some of the special-purpose on page 5921 mental ray materials that are also available.

**Material Components**

A material's components describe its visual and optical properties. The components in the Architectural material on page 6148 are based on physical qualities; for example, diffuse color, shininess, transparency, and so on. The components in a Standard material on page 5962 include color components, highlight controls, self-illumination, and opacity. Like the Standard material, the Raytrace material on page 6064 uses a nonphysical model to describe surfaces. (Standard and Raytrace material components also vary depending on which shader on page 5960 you use.)

Like the Architectural material, the components of mental ray materials on page 5772 always model physical properties.
You can assign maps to many components, including color components such as Diffuse, and value components such as Transparency or Opacity. Maps can increase the complexity and realism of the material's appearance.

Lights and Shading

Materials work in combination with lights on page 5314. The intensity of light that falls on a surface determines the intensity of color to display.

Three factors contribute to the intensity of light where it falls on an object:

- **Light intensity**: A light's original intensity at its point of origin.

- **Angle of incidence**: The more a surface inclines away from the light source, the less light it receives and the darker it appears. The angle between a ray of light and the face normal on page 8654 of a surface is the angle of incidence for that face. When the angle of incidence is 0 degrees (that is, the light strikes the face perpendicularly), the face is illuminated at full intensity unless the light is attenuated. Full intensity is the light's Multiplier value times the value of the face's surface color. The Multiplier value is 1.0 by default; the surface value is the Value component of the surface color's HSV description on page 8698. As the angle of incidence increases, the intensity of the face illumination decreases.
Distance: Light diminishes over distance. This effect is known as attenuation on page 8513. By default, attenuation is turned off, but you can turn it on and specify the distance over which it operates.

Lights and the Component Colors of a Standard Material

As the names of a standard material’s color components on page 5624 imply, the kind of light that strikes a surface with a material determines how the surface appears when it is shaded.

- **Ambient color** appears where the surface is lit by ambient light alone (where the surface is in shadow).
- **Diffuse color** appears where light falls directly on the surface. It is called "diffuse" because light striking it is reflected in various directions. Highlights, on the other hand, are reflections of light sources.
- **Specular highlights** appear where the viewing angle is equal to the angle of incidence. Glancing highlights appear where the angle of incidence is high, relative to the observer or camera (that is, the light ray is nearly parallel to the surface). Shiny surfaces usually have specular highlights. Glancing highlights are characteristic of metallic surfaces. Some surfaces are completely reflective, or nearly so. These reflect their environment as well as the light sources that illuminate them. To model such surfaces, you need to use reflection mapping on page 6375 or ray tracing (see Raytrace Material on page 6064).

The three color components blend at the edges of their regions. Between ambient and diffuse, the blending is calculated by the shader. Between diffuse and specular, you set the amount of blending by using the standard material’s highlight controls.

Applying a Material to an Object

You use the Material Editor to apply a material to objects.

There are two ways to apply a material to an object:

- If the sample slot is active and the object is already selected, click Assign Material To Selection on page 5690.
- Drag from the sample slot to the object.
As you drag, a tooltip appears over each object beneath the mouse, showing the object's name. You can apply the material whether the object is selected or not. Release the mouse to apply the material.

Applying a material overrides any previous material assignment the object might have had. Once the material is applied, while the sample slot is active, the material is "hot" and changes you make to it affect the object automatically. See Sample Slots on page 5650 for more about hot and cold materials.

The Undo command on page 240 works for material assignment.

You can apply only one material to an object. To overcome this restriction, use a Multi/Sub-Object material on page 6120. This is a container for various sub-materials that correspond to specified sub-objects such as different faces in a mesh, NURBS surfaces in a NURBS model, and so on.

You can apply the same material to multiple objects in the scene.

See also:
- Dragging and Dropping Maps and Materials on page 5657
- Drag and Drop Sub-Object Material Assignment on page 5659

Using Maps to Enhance a Material

Maps provide images, patterns, color adjustments, and other effects you can apply to the visual/optical components of a material. Without maps, material design in 3ds Max is limited. Maps give the Material Editor its full flexibility, and can give you dramatic results.

Spheres with various maps applied to them (as well as a reflection map applied to the surface beneath them)
The simplest use of a map is to assign a pattern to a material’s Diffuse color. Diffuse mapping on page 6031 is also known as "texture mapping." It applies an image or pattern to geometry the material is applied to.

**WARNING** When you change the shading type on page 5960 of a standard material, you lose the settings (including map assignments) for any parameters that the new shader does not support. If you want to experiment with different shaders for a material with the same general parameters, copy the material to a different sample slot on page 5650 before you change its shading type. That way, you can still use the original material if the new shader doesn't give you the effect you want.

**Example of Using Maps**

1. Start with a plain material.

2. Apply a bitmap to the material’s Diffuse component (texture mapping).
Select the walls of the building, then apply the material to the walls.

Planks bitmap for the wall texture
If the texture alignment needs adjusting, use a UVW Map modifier on page 1932.
Texture map aligned to fit the geometry

5. Apply a map to the material's Bump component (bump mapping).
Bitmap for adding bumps to the plank material

(This is simply the same image saved as black-and-white.)
6 Increase the Amount of the Bump map to increase the bump map effect.
Map Terminology

The term "material map" is sometimes used to describe a map assigned in the material editor. A material map applies a color or pattern to a surface. This is different from maps used for displacement mapping with the Displace modifier on page 1313, environment mapping for backgrounds, or projection mapping from lights.

The term "texture map" is sometimes used as well. It is interchangeable with "diffuse map"; that is, with a map that applies colors to geometry, as opposed to a map that create reflections, bumps, and so on.

In the Material/Map Browser on page 5724, maps are categorized according to how the map software functions. The categories are:

- **2D maps**
  A bitmap on page 6213 is the prototypical 2D map. 2D maps apply pictures and patterns to the surface of objects.

- **3D maps**
3D maps are generated procedurally. 3D maps apply patterns throughout an object's geometry.

- **Compositors**
  Compositors combine other maps.

- **Color Modifiers**
  Color modifiers are usually composited with another map to adjust its color. The Vertex Color map is a special case that displays the colors you assign to vertices in a mesh.

- **Other**
  "Other" maps include maps that simulate reflection or refraction.

The names of individual map types describe the pattern or effect they create, such as Checker map, Bitmap, Gradient, Flat Reflection, and so on.

**NOTE** In some cases the user interface also uses "map" to describe not the map type, but the visual component being mapped. For example, a "diffuse map" means a map of any type applied to a material's diffuse component. This is an ambiguity in the use of "map" that can be a bit confusing when you first encounter it.

**Assigning Maps**

For a standard material on page 5962, you assign maps using the Maps rollout. Click the Map button in line with the name of the visual component you want to map. The Material/Map Browser on page 5724 is displayed. Select the map type (for example, Bitmap) from the list of maps, and then click OK. Double-clicking the map's name in the Browser also assigns the map type.

The Browse From group box in the Browser creates new maps by default. You can also use it to obtain maps from a library (see Saving A Material), from the current scene, from objects selected in the scene, or from elsewhere in the material editor.

In the Browser, you can turn on icons of differing sizes to preview maps before you assign them.

A Standard material's Basic Parameters rollout has shortcut buttons for assigning a map to some of the material's visual components. These small buttons are equivalent to the buttons in the Maps rollout. Assigning a map to a button in one rollout changes the corresponding button in the other.

Each type of map has its own set of parameters and controls. If the map is a Checker map, for example, you can choose the colors of the checkers, and
whether a checker color has a map of its own. You can change tiling values to affect the scale of the checkers, adjust noise parameters to make the checkers irregular, and so on.

**NOTE** To save loading time, if a map with the same name is in two different locations (in two different paths), it is loaded only once. This poses a problem only if your scene includes two maps that have different content but the same name. In this case, only the first map encountered will appear in the scene.

**Navigating the Material/Map Tree**

When you build a material of any complexity, you are building a material/map tree. The root of the tree is the material itself. The branches are the maps you have assigned to the material's components. Some maps can themselves contain maps, as in a map applied to one color of a Checker material on page 6227, so the tree can be more than two levels deep, and can actually be as deep as you need it to be.

The Material/Map Navigator on page 5703 is a dialog that displays the tree for the current material. It is useful for finding a map and displaying its parameters. Click the map to display its rollouts in the Material Editor. To copy a map to a different component of the same material, you can also drag the map's name from the Navigator to a map button in the Material Editor.

The Go Forward To Sibling and Go To Parent buttons also navigate the map tree. Go Forward To Sibling moves laterally in the map tree, while Go To Parent moves up the tree. (To move down the tree, click a map button that has a map assigned to it.) Another way to move between parents and children in the tree is to drop down the material name field on page 5706 and click the name of a map or material.

**Mapping Coordinates**

An object assigned a 2D mapped material (or a material that contains 2D maps) must have mapping coordinates. These coordinates specify how the map is projected onto the material, and whether it is projected as a "decal," or is tiled or mirrored. Mapping coordinates are also known as UV or UVW coordinates on page 8754. These letters refer to coordinates in the object's own space, as opposed to the XYZ coordinates that describe the scene as a whole.

5636 | Chapter 17  Material Editor, Materials, and Maps
Mapping coordinates shown as U and V axes local to a surface.

Most renderable objects have a Generate Mapping Coordinates parameter. This is on by default, but if it’s off and the object contains a mapped material, when you try to render, you get a warning.

Some objects, such as editable meshes, don’t have automatic mapping coordinates. For these types of objects, you can assign coordinates by applying a UVW Map Modifier on page 1932.

If the material appears the way you want it with the default mapping, you don’t need to adjust the mapping. If you need to adjust it, use the map’s Coordinates rollout. There are two typical sets of coordinates parameters: one for 2D maps such as Bitmaps on page 6213, and another for 3D maps such as Noise on page 6303. See Coordinates Rollout (2D) on page 6201 and Coordinates Rollout (3D) on page 6278.

**NOTE** The UVW Remove utility on page 6200 provides a way to remove mapping coordinates or an entire material from selected objects.
Saving a Material

While a material is in the Material Editor or applied to an object, it is part of the scene, and is saved with the scene. However, for complicated scenes it is inconvenient to have all materials active in the Material Editor. You can also save a material by putting it into a material library. Some libraries are provided in the \materiallibraries subdirectory. The file 3dsmax.mat is the default library. You can add your material to this library, or create your own libraries.

Procedures

To save a material in a library:

This stores a material in the current material library. To use a different library, first open it using the Material/Map Browser on page 5724.

1 In the Material Editor, click the sample sphere for the material to save.

2 On the Material Editor toolbar, click Put to Library on page 5694. This opens the Put to Library dialog on page 5717. Change the material name or leave it as is, and then click OK.

3 Choose Rendering > Material/Map Browser, or, on the Material Editor toolbar, click Get Material on page 5687. The Material/Map Browser on page 5724 opens.

4 In the Browser > Browse From group, choose Mtl Library, if necessary. The stored material appears in the list.

5 In the Browser > File group, click Save to save the library with the current name (if any) or Save As to save it as a different file.

TIP You can use the Merge function in the File group to add materials from the current library to another library.

Material XML Exporter Utility

Utilities panel > Utilities rollout > More button > Utilities dialog > Material XML Export
You can export materials you create in 3ds Max to XML files, which can then be shared with other 3ds Max users or used in AutoCAD Architecture (formerly Autodesk Architectural Desktop) to modify material definitions.

**NOTE** You can add an exported XML material to your 3ds Max scene by dragging and dropping from a Web site or Windows Explorer onto an object in your scene, or by importing it directly onto objects.

### Interface

#### Selection Method group

The Selection Method group lets you set the method for selecting the materials you wish to export.

**Material/Map Browser** Lets you select a material to export from the

**Material/Map browser** on page 5724.
**Object List** Lets you specify objects using the Select Object For Material Modifier Export dialog, which works like the Select From Scene dialog on page 206. All materials assigned to the selected objects are exported.

**Pick Object in Scene** Lets you select an object from your scene. Any materials assigned to the selected object are exported.

**All Objects in Scene** Exports all of the assigned materials in your scene.

**Output Format group**

The Output Format group defines the format of the XML Material output.

**Native XML (vizML)** Materials are exported as raw XML.

**TIP** Use this format for sharing XML material files within 3ds Max.

**Tool Catalog** Materials are exported to the ATC (Autodesk Tool Catalog) format.

This file type is suitable for display in the AutoCAD Content Browser and the Autodesk VIZ Content Browser.

**NOTE** This file type cannot be imported to 3ds Max unless you also have Autodesk VIZ Render installed on the same system.

**Specify XSLT** This option lets you apply your own XSL transform to the XML output.

**Export group**

The Export group lets you define the parts of the material assignments to export.

**Material** Exports the material definitions.

**Create Thumbnails** Exports thumbnails for each material.

**NOTE** Thumbnail images are referenced by the ATC and displayed in the AutoCAD Content Browser and Autodesk VIZ Content Browser.

**Mapping Modifiers** Exports the mapping modifiers applied to specific objects.

**Export** This button begins the XML export process, using the defined selection method, output format, and export parameters.
Upon clicking Export, you are prompted to set the path or URL to store in the XML file as the path to any referenced bitmap files. The default is an empty string, which means no path will be prepended to the bitmap filenames when written to XML. When the material is later imported, it will be assumed that the referenced bitmap file can be found in the bitmap search path.

If you have elected to export thumbnails or to apply your own XSL transform, you are then prompted to set a path to store the thumbnail files and to locate your XSLT file, respectively.

Material Editor

Main toolbar > Material Editor
Rendering menu > Material Editor
Keyboard > M

The Material Editor provides functions to create and edit materials on page 8635 and maps on page 8631.

Materials create greater realism in a scene. A material describes how an object reflects or transmits light. Material properties work hand-in-hand with light properties; shading or rendering combine the two, simulating how the object would look in a real-world setting.

You apply materials to individual objects or selection sets; a single scene can contain many different materials.

NOTE Creating a new material clears the Undo/Redo lists.

Procedures

To view the Material Editor:

- Click the Material Editor button on the main toolbar, or press M.

The Material Editor dialog has sample slots on page 5650 for viewing previews of materials. When you first view the Material Editor, the material previews have a uniform default color.

To give a material a different name:

- Edit the name field that appears below the Material Editor toolbar.
The name of the active material appears in the title bar of the Material Editor dialog. The name of the material is not a file name: it can contain spaces, numbers, and special characters.

The name field displays only 16 characters, but a material name can be longer than that.

To make a copy of a preview material:

- On the Material Editor toolbar, click Make Material Copy on page 5692.

To get a material from a scene:

If a material that you want to change has been saved in the scene, but not in the Material Editor, you can load the material by getting it from the scene.

1. Click a sample slot to make it active.
   Be careful not to click the sample slot of a material you want to use later.

2. On the Material Editor toolbar, click Get Material on page 5687. A modeless Material/Map Browser on page 5724 is displayed.

3. In the Browse From group box at the upper left, make sure that either Selected or Scene is chosen.
   The Selected option lists only materials in the current selection. If no objects are selected, the list of materials is blank.
   The Scene option lists all the materials currently in the scene.

4. In the list of materials, double-click the name of the material you want. You can also drag the material name to the sample slot.
   The material you chose replaces the previous material in the active sample slot.

WARNING When you get a material from a scene, it is initially a hot material on page 8603.

To apply a material to objects in a scene:

- Drag the sample slot that contains the material you want to apply to an object in the scene.
If the object isn't selected, or if it's the only object selected in the scene, the material is applied immediately. If the object is one of several selected objects in the scene, 3ds Max prompts you to choose whether to apply the material to the single object only or to the whole selection (the latter is the default choice).

You can also apply materials to a selection by clicking Assign Material To Selection on page 5690 on the Material Editor toolbar.

NOTE When you apply a material to an object or selection, that material becomes a hot material on page 8603 (its sample slot is displayed with white corner brackets). When you change the properties of a hot material, the scene immediately updates to reflect those changes. Every object with that material changes its appearance, not just the objects in the current selection.

To remove a material from an object:

2. Drag the entry NONE from the top of the list in the Browser to the object. The object now has no material applied to it.

To make a material no longer hot so it doesn't change the current scene, click Make Material Copy on page 5692.

To put a material back into a scene:

1. On the Material Editor toolbar, click Put Material To Scene on page 5689. The material in the active sample slot is now a hot material on page 8603. The Put Material button is available only when (1) the material in the active sample slot has the same name as a material in a scene, and (2) the
material in the active sample slot is not hot. In other words, this command is meant to fit into the following overall sequence of handling materials:

- You create a hot material either by applying it to objects in the scene or by getting it from the scene.

- You make a copy of the material.

- You make changes to the copy of the material.

- You update the scene by putting the changed material back into the scene.
  These steps are not as immediate as changing a material while it is hot, but they help you avoid changing the scene’s materials unintentionally or in unexpected ways.
  When a material in the Material Editor is applied to objects in the scene, you can select the objects from the Material Editor.

To select objects that have the same material applied:
When a material in the Material Editor is applied to objects in the scene, you can select the objects from the Material Editor.

1. Click a sample slot that contains a material in the scene.
   White corner brackets indicate materials that are in the scene.

2. Click Select By Material on page 5686.
   This button is unavailable unless the active sample slot contains a material in the scene.
   The Select Objects dialog on page 206 opens. The names of objects with the active material applied are highlighted when the dialog appears.

3. Click Select to select objects that have the active material applied to them.
   You can also change the selection by choosing other objects. If you change the selection, you can then apply the active material to newly selected objects by clicking Assign Material To Selection on page 5690.
To get a material from a library:

1 On the Material Editor toolbar, click Get Material on page 5687. A modeless Material/Map Browser on page 5724 opens.

2 In the Browse From group box at the upper left, choose Material Library if necessary.
   If you have opened a library, the list of materials shows the contents of the library.
   If you haven't opened a library, click Open in the File group on the Browser. This opens the Open Material Library file dialog; use it to open a material library. After you open the library, its contents appear in the list of materials.

3 In the list of materials, double-click the name of the material you want. You can also drag the name of the material to the sample slot.
   The material you chose replaces the previous material in the active sample slot.

To save a material in a library:

1 Click the sample slot that has the material you want to save.

2 On the Material Editor toolbar, click Put To Library on page 5694.

3 A Put To Library dialog on page 5717 appears.

4 Change the material name or leave it as is, and then click OK.
   The material is saved in the currently open library. If no library is open, a new library is created. You can save the new library as a file using the Material/Map Browser on page 5724 file controls.

Interface

The Material Editor interface consists of a menu bar at the top, sample slots (the spheres) below the menu bar, and toolbars along the bottom and side of the sample slots. For links to topics describing these interface elements as well as overviews of materials and maps, see the end of this section.

The Material Editor interface also includes a number of rollouts whose contents depend on the active material (click a material's sample slot to make it active).
Each rollout contains standard controls such as drop-down lists, check boxes, numeric fields with spinners, and color swatches.

In many cases, associated with a control (typically to its right) is a map shortcut button: a small, square, blank button, which you can click to apply a map to the control. If you have assigned a map to a control, the button displays the letter M. An uppercase M means that the corresponding map is assigned and active. A lowercase m means that the map is assigned but inactive (turned off). You turn maps on and off with the check boxes on the Maps rollout on page 6021 (see this procedure on page ? and the one following it). You can also right-click the map shortcut button to access functions such as copy and paste (see Copying and Pasting: Right-Click Menu for Materials, Maps, Bitmaps, and Colors on page 5647).
For choosing materials, see Material/Map Browser on page 5724. For applying materials using drag and drop techniques, see Dragging and Dropping Maps and Materials on page 5657.

For an overview of how to use the Material Editor, see Designing Materials on page 5620.

**Copying and Pasting: Right-Click Menu for Materials, Maps, Bitmaps, and Colors**

Material Editor > Right-click a Type button, sub-materials button, map button, bitmap button, or color swatch.

Elsewhere in the user interface > Right-click a map button or color swatch.

A set of right-click pop-up menus in the Material Editor (and elsewhere in 3ds Max user interface) lets you copy and paste, and otherwise manage materials, maps, bitmaps, and colors.

You see these menus only if copy and paste actions are appropriate. For example, if you copy a material and then right-click a map button, nothing happens.

**Material Right-Click Menu**

When you right-click a button that represents a material, this menu appears. This includes the Type button on page 5706 for a material, and sub-material buttons such as you find in the Multi/Sub-Object material on page 6120, the Blend material on page 6107, and others.

```
Cut
Copy
Paste (Copy)
Paste (Instance)
Clear
```

Cut Makes a copy of the material. If you right-click a sub-material button, this also removes the material from that sub-material component. If you right-click the Type button, Cut is equivalent to Copy.

Copy Makes a copy of the material.
Paste (Copy) Pastes a copy from the copy buffer. This item doesn't appear if you haven't yet copied a material.

Paste (Instance) Pastes an instance from the copy buffer. This item doesn't appear if you haven't yet copied a material.

Clear If you right-click a sub-material button, Clear removes the material from that sub-material component without making a copy of it. If you right-click the Type button, Clear has no effect.

Map Right-Click Menu

When you right-click the button for a map component (a “map slot”), the menu you see depends on whether a map has been assigned yet.

When a Map Has Been Assigned

The following menu appears if a map has been assigned:

<table>
<thead>
<tr>
<th>Cut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy</td>
</tr>
<tr>
<td>Paste (Copy)</td>
</tr>
<tr>
<td>Clear</td>
</tr>
<tr>
<td>Open</td>
</tr>
<tr>
<td>Reveal Location in Explorer</td>
</tr>
</tbody>
</table>

Cut Removes the assigned map, and puts a copy of it in the copy buffer.

Copy Copies the map without removing it.

Paste (Copy) Pastes a copy from the copy buffer. This item doesn't appear if you haven't yet copied a map.

Clear Removes the assigned map without copying it.

Open For bitmaps on page 6213, launches whichever application is associated with the currently assigned 2D map.

This item does not appear for other map types such as procedural maps.

Reveal Location in Explorer Launches a copy of Windows Explorer to display the folder where the map is saved.
When No Map Has Been Assigned

If no map has been assigned, all you can do is paste another:

<table>
<thead>
<tr>
<th>Paste (Copy)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paste (Instance)</td>
</tr>
</tbody>
</table>

**Paste (Copy)** Pastes a copy from the copy buffer.
**Paste (Instance)** Pastes an instance from the copy buffer.

When No Map Has Been Either Assigned or Copied

If no map has been assigned and you haven't copied a map yet, then no right-click menu appears at all.

**Bitmap Right-Click Menu**

This menu appears when you click a button that specifies an external bitmap on page 8523. See **Bitmap 2D Map** on page 6213.

<table>
<thead>
<tr>
<th>Copy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paste</td>
</tr>
<tr>
<td>Open</td>
</tr>
<tr>
<td>Reveal Location in Explorer</td>
</tr>
</tbody>
</table>

**Copy** Copies the bitmap.
**Paste** Pastes the bitmap from the copy buffer.
**Open** Launches whichever application is associated with the bitmap.
**Reveal Location in Explorer** Launches a copy of Windows Explorer to display the folder where the bitmap is saved.

**Color Swatch Right-Click Menu**

This menu appears when you right-click a color swatch.

**NOTE** This menu does not apply to the VertexPaint modifier's **Color Palette** on page 1984, which has its own right-click menu.
Sample Slots

Material Editor > Sample slots display

The sample slots let you maintain and preview materials and maps. Each slot previews a single material or map. You can change the material by using the Material Editor controls, and you can apply the material to objects in the scene. The easiest way to do this is to drag the material from the sample slot to objects in viewports. See Dragging and Dropping Maps and Materials on page 5657.
IMPORTANT While the Material Editor can edit no more than 24 materials at a time, a scene can contain an unlimited number of materials. When you are through editing one material, and have applied it to objects in the scene, you can use that sample slot to get on page 5687 a different material from the scene (or create a new one) and then edit it.

You can display a sample slot in a window of its own. This magnifies the sample slot, which can make it easier to preview the material. You can resize the magnified window to make it even larger. To magnify a sample slot, double-click it, or right-click and choose Magnify from the pop-up menu. See Sample Slot Right-Click Menu on page 5654.

The Material Editor has 24 sample slots. You can view them all at once, six at a time (the default), or 15 at a time. When you view fewer than 24 slots at once, scroll bars let you move among them. See Material Editor Options on page 5681 and Sample Slot Right-Click Menu on page 5654.

A material in a slot is shown on a sample object. By default, the object is a sphere. Use the Sample Type flyout on page 5673 to change the sample object.

Sample slot showing a material

By default, a standalone map in a slot fills the whole slot. This is when the slot shows only a standalone map at the top of a tree; when the map is assigned to a material, the slot shows it as part of the material, mapped to the sample object. See Get Material on page 5687 and Material Editor Options on page 5681.
The Material Editor renders only the active sample sphere for the current frame.

Hot and Cool Materials

A sample slot is "hot" on page 8603 when the material in the slot is assigned to one or more surfaces in the scene. When you use the Material Editor to adjust a hot sample slot, the material in the scene changes at the same time.

The corners of a sample slot indicate whether the material is a hot material:

■ No triangle: The material is not used in the scene.
■ Outlined white triangle: The material is hot. In other words, it's instanced in the scene. Changes you make to the material in the sample slot will change the material displayed in the scene.
■ Solid white triangle: The material is not only hot, but is applied to the currently selected object.

Left: "Hot" material applied to currently selected object.
Middle: "Hot" material assigned to scene but not to currently selected object.
Right: "Cool" material: active but not assigned to scene.

A material is "cool" on page 8541 if it is not applied to any object in the scene. To make a hot sample slot cool, click Make Material Copy on page 5692. This copies the material in the sample slot on top of itself so that it's no longer used in the scene.

You can have the same material (with the same name) in more than one sample slot, but only one slot containing that material can be hot. You can have more than one hot sample slot, as long as each has a different material.

If you drag to copy a material from a hot slot to another slot, the destination slot is cool, and the original slot remains hot.

See also:
■ Sample Slot Right-Click Menu on page 5654
■ Dragging and Dropping Maps and Materials on page 5657
■ Creating a Custom Sample Object on page 5660

Procedures

To use a sample slot:
■ Click the sample slot to make it active.
  The active sample slot is displayed with a white border around it.
  The sample slot shows a sample object shaded with a material. (By default, the sample object is a sphere.) The sample object is lit by a light source above it and slightly toward the viewer. For the sphere, the highlight is in the upper-left quadrant. The diffuse color shows most clearly above and to the left of the highlight, shading toward the ambient color at the sphere's lower right.

To change the preview shape:
1 Make sure the sample slot of the material you want to view is active.
2 Use the Sample Type flyout on page 5673 to choose the shape you want to view. The flyout gives you three options: sphere (the default), cylinder, or box.
  The new shape is displayed in the sample slot, with the material mapped to it.
To render the current mapping level:

1. Move to the level of the map hierarchy that you want to render.
2. Right-click in the sample slot, and choose Render Map from the pop-up menu.
   The Render Map dialog on page 5718 is displayed.
3. Choose Single or the range of frames you want to render.
4. In the Dimensions group box, specify the pixel resolution of the map.
5. Click the Files button, and specify a path and file name for the file. Make sure Save To File is on unless you want to see the image only in a Rendered Frame Window on page 6513.
6. Click Render.
   A Rendered Frame Window appears displaying the map. If Save To File is on, the image is also saved to disk.

Sample Slot Right-Click Menu

Material Editor > Right-click active sample slot.

When you right-click the active sample slot, a pop-up menu is displayed. For other sample slots, click or right-click once to select them, then right-click to use the pop-up menu.

The pop-up menu is available in magnified sample slot windows. See the "Magnify" option, below.
Interface

- Drag/Copy
- Drag/Rotate
- Reset Rotation
- Render Map...
- Options...
- Magnify...

Select by Material
Highlight Assets in ATS Dialog

- 3 x 2 Sample Windows
- 5 x 3 Sample Windows
- 6 x 4 Sample Windows

The pop-up menu has these options:

**Drag/Copy** Sets dragging a sample slot to copy mode. When on, dragging a sample slot copies the material from one sample slot to another, or from the sample slot to an object in the scene or a material button.

**Drag/Rotate** Sets dragging a sample slot to rotate mode. When on, dragging in the sample slot rotates the sample object. This helps you preview the material. Drag over the object to rotate it about its X or Y axis; drag in the corners of the sample slot to rotate the object about its Z axis. In addition, if you press Shift before dragging in the center, the rotation is constrained to the vertical or horizontal axis, depending on your initial drag direction.
If you have a three-button mouse and are using Windows NT, the middle mouse button rotates the sample object while Drag/Copy mode is active.

**Reset Rotation** Resets the sample object to its default orientation.

**Render Map** Renders the current map, creating a bitmap or an AVI file (if the map is animated). Only the current map level renders. That is, the rendering shows the image displayed when Show End Result is turned off.
If you're at a material level instead of a map level, this menu item is disabled.

**Options** Displays the Material Editor Options dialog on page 5681. This is an alternative to clicking the Options button.

**Magnify** Generates a magnified view of the current sample slot. The magnified sample is displayed in its own, floating (modeless) window. You can display up to 24 magnified windows, but you can’t display the same sample slot in
more than one magnified window at a time. You can resize magnify windows. Clicking a magnify window activates the sample slot, and vice versa.

**Shortcut** Double-click a sample slot to display the magnified window. The magnify window's title bar displays the contents of the editable material name field on page 5706. It varies depending on which level of the material is active.

![Magnify Window](image)

**Auto** Turn off to prevent the magnified window from updating automatically. This can save rendering time, especially when you have resized the magnified window to make it larger. Default=on.

**Update** Click to update the magnified window. This button is unavailable unless Auto is turned off.

Dragging a different sample slot to the magnify window changes the contents of the magnify window.

**Select By Material** Selects objects based on the material in the sample slot. This choice is unavailable unless the active sample slot contains a material used in the scene.

**Highlight Assets in ATS Dialog** If the active material uses maps that are tracked assets on page 7585 (typically bitmap textures), opens the Asset Tracking dialog with the assets highlighted.
This choice is unavailable if the material has no maps, or the maps it uses are not tracked.

Sample Windows options

The Material Editor always has 24 sample slots available. You can choose to display fewer sample slots at a larger size. When you do, scroll bars let you move around among the sample slots.

3 X 2 Sample Windows Displays a 3 x 2 array of sample slots. (The default: 6 windows.)

5 X 3 Sample Windows Displays a 5 X 3 array of sample slots. (15 windows.)

6 X 4 Sample Windows Displays a 6 X 4 array of sample slots. (24 windows.)

Dragging and Dropping Maps and Materials

You can move materials from sample slots to objects using a drag-and-drop operation. You can also drag to and from map and material buttons. See the following lists to determine where in the interface you can drag from and drag to.

When dragging materials, use the Undo command on page 240 to cancel material assignments.

Where You Can Drag From

- **Sample Slots** on page 5650
  The content you drag from a sample slot is always at the top level of the sample slot, regardless of which level is currently displayed. If the sample slot contains a material, you can't drag from the sample slot to a map button, even if you're at the map level of the material.

- Material preview and map preview

- The Material Editor Type button on page 5706

- **Material/Map Browser** on page 5724 lists (text or icon lists)
  You can't drag from the modal version of the Browser (when OK and Cancel buttons are present).

- The sample slot in the Browser

- Material map buttons (see below)
- A projector light map button (see Advanced Effects Rollout on page 5457)
- The Environment Background on page 7163 map button
- Fog on page 7182 Color and Opacity map buttons
- Displace modifier on page 1313 map buttons

Material Map Buttons

The material map buttons you can drag from include:
- The buttons in the Maps rollout on page 6021
- The small shortcut map buttons on the Basic Parameters rollouts on page 5989.
- Any map buttons at any level.
- Sub-material buttons, such as those found in the Multi/Sub-Object material on page 6120.

Where You Can Drag To

- All of the items in the previous list.
- Objects in viewports.
  Drag from a material button, sample slot, or Browser listing into the viewport and over an object. When you release the mouse, the material is applied.
  If you drag a material over two or more selected objects, an alert message asks if you want to apply the material to the object or to the selection. Choose the option you want, and click OK.
- The Material Editor Type button on page 5706.
  You can drag to the Type button only from the Browser. If the Type button shows a standalone map, you can drag only a map to it. If it shows a material type, you can drag only a material to it.
- All of the items in the previous list, except that you can drag to the Browser only when it displays a material library.
  When the Browser is set to browse from a Material Library, dragging materials and maps into the Browser adds them to the library.
- Any palette in the Content Browser. You can drag individual materials, selections of materials, or entire panels or palettes into the Content Browser.
A Face, Polygon, Patch, or Element sub-object selection of an editable surface object (mesh, patch, or poly).

A Face, Polygon, Patch, or Element sub-object selection created by the Edit Mesh modifier on page 1321 or Edit Patch on page 1329; or by one of these selection modifiers: Mesh Select on page 1500, Patch Select on page 1562, or Poly Select on page 1582.

See also:
- Applying a Material to an Object on page 5626
- Drag and Drop Sub-Object Material Assignment on page 5659

Drag and Drop Sub-Object Material Assignment

You can apply a material to a selection of renderable sub-objects, such as faces in a mesh. In the Material Editor, you can use Assign Material To Selection on page 5690. You can also drag the material from the Material Editor or the Material/Map Browser on page 5724 to the selected faces. This can create a new Multi/Sub-Object material on page 6120 on the fly.

You can disable drag-and-drop of materials to sub-objects. To do so, go to the General tab on page 8299 of the Preferences dialog on page 8298, and in the Sub-Materials group, turn off Assign Automatically. This check box is on by default.

How the Multi/Sub-Object Material Is Created

The Multi/Sub-Object material is created in one of three ways, depending on what material is already applied to the selected sub-objects:

- **No material applied**
  - If the selected faces have no material applied, a new Multi/Sub-Object material is created. The dragged material becomes a sub-material in the new material. If material IDs already exist, they are preserved.

- **Existing material applied (other than Multi/Sub-Object material)**
  - A new Multi/Sub-Object material is created and applied to the selected faces. The existing material is moved into the Multi/Sub-Object material and becomes the first sub-material. Unselected faces get material ID #1, the selected faces get material ID #2, and the dragged material becomes...
part of the Multi/Sub-Object material. Existing material IDs are not preserved.

■ Multi/sub-object material applied
If the existing Multi/Sub-Object material is already applied more than once in the scene, the material is copied and the new copy is applied to the selected faces.
If the Multi/Sub-Object material is only applied once in the scene, then the existing material is used. The dragged material is added to the existing Multi/Sub-Object material.
If the dragged material already is a part of the Multi/Sub-Object material, then the selected faces receive the corresponding material ID number. If the selected faces all have the same material ID number, and no unselected faces are already using this number, then this number is used and the new material replaces the old sub-material at this ID. Otherwise, a new material ID number is assigned to the faces, and used for the dragged material. In this case, any existing material IDs are preserved.

**Procedures**

To drag materials onto sub-object selections:
1. In the Modify panel > modifier stack, choose Face as the sub-object level.
2. Select faces of an editable mesh object.
3. Drag a material from a Material Editor sample slot to the selected faces.
4. In the modifier stack, click to turn off Sub-Object and return to the object level.
5. On the Material Editor, click Pick Material From Object, then use the eyedropper to get the material from the sphere.
   The new Multi/Sub-Object material appears in the active sample slot.

**Creating a Custom Sample Object**

Material Editor > Right-click the active sample slot. > Right-click menu > Options > Material Editor Options dialog
Material Editor > Material Editor Options > Material Editor Options dialog
By default, the sample object in a sample slot is a sphere. You can use the Sample Type flyout on page 5673 to change this to a cube or a cylinder. You can also create a custom sample object by creating a 3ds Max scene that shows the object.

Custom sample object fits within a 100-unit cube

Overview of Using a Custom Sample Object

See Procedures for more details.

The scene you create should contain a single object that fits into an imaginary cube that is 100 units on each side. The object must be at the root level of the scene: it can't be linked to other objects. If more than one object is in the scene, only the first object listed in the Track View hierarchy is used as the sample object.

If the object is of a type that doesn't have a Generate Mapping Coords check box, apply a UVW Map modifier on page 1932 to it.

After you have saved the single-object scene as a MAX file, use the Custom Sample Object group in the Material Editor Options dialog on page 5681 to specify the file. When you specify the file, a new button is displayed at the
right of the Sample Type flyout. This button, which shows an object with a question mark, displays the sample object file you chose.

If the sample object scene contains only the object, sample slots display it with default lighting. If the scene also contains a camera and lights, you can use the camera to specify the view, and the lights to light the object as you choose. Turn on Load Camera and/or Lights in the Custom Sample Object group.

Procedures

To set up a custom sample object:

1. Create a scene with a single object, such as a pyramid.
   The object should fit into an imaginary cube that is 100 units on each side. Also, the object must be at the root level of the scene: it can't be linked to other objects.
   If more than one object is in the scene, the Material Editor uses the first object listed in the Track View hierarchy.

2. If the object does not have built-in mapping coordinates (via a Generate Mapping Coords check box), then assign a UVW Map modifier on page 1932 to it to provide mapping coordinates.
   If the object has a Generate Mapping Coords check box, it's on by default, and the Material Editor uses those coordinates. If you want to use coordinates other than those built into the object, assign a UVW Map modifier and set up your own coordinates.

3. Save the scene as a MAX file.

4. In the Material Editor Options dialog, click the File Name button in the Custom Sample Object group box, and choose the file that contains your object.

5. Activate the sample slot in which you want to see the custom object, then choose the button at the far right of the Sample Type flyout.
   Your custom object is displayed in the sample slot.
   If the size of your object is not quite right for the sample slot, adjust its size and save the scene again. To update the sample slot so it uses the newly saved MAX file, open the Material Editor Options dialog, and then click OK.
To use a camera and lights with the custom sample object:

1. Create a camera in the scene that contains your sample object, and then adjust the camera to show the object as you want it seen in sample slots.

   **TIP** Viewports have a different aspect ratio than sample slots, so using [Zoom Extents](#) on page 8144 on the sample object usually results in the object appearing smaller in a sample slot. Perform Zoom Extents on the object, and then before you save the file, zoom in a little farther so the object more than fills the viewport. The sample slot projection is based on the width of the sample object's geometry, not on the image in the viewport.

   If more than one camera is in the scene, the Material Editor uses the first camera listed in the Track View hierarchy.

2. If you want to use your own lighting rather than the default sample-slot lighting, set up as many lights as you need. If you want to use the sample-slot lighting, do not add any lights to the scene.

3. Save the MAX file.

4. In the Material Editor Options dialog, specify the file as the Custom Sample Object file.

5. Turn on Load Camera and/or Lights.

   Sample Slots set to use the custom object now display the object as seen through the camera. If lights are in the scene, those lights are used in the sample slot instead of the default lights.

---

**Material Editor Tools**

Main toolbar > Material Editor

Above the Material Editor sample slots on page 5650 is the menu bar. Below and to the right of the sample slots are buttons and other controls that you use to manage and change maps and materials.
Material Editor tools below and to the right of the sample slots

Material Editor Menu Bar on page 5666
Reflectance and Transmittance Display on page 5669

NOTE These fields are not displayed unless you change a toggle in Preferences > Advanced Lighting.

Buttons below the sample slots (the "toolbar")

- Get Material on page 5687
- Put Material to Scene on page 5689
- Assign Material to Selection on page 5690
- Reset Map/Mtl to Default Settings on page 5691
Make Material Copy on page 5692

Make Unique on page 5692

Put to Library on page 5694

Material ID Channel on page 5694

Show Map in Viewport on page 5696

Show End Result on page 5701

Go to Parent on page 5702

Go Forward to Sibling on page 5702

Buttons to the right of the sample slots

Sample Type on page 5673

Backlight on page 5674

Background on page 5675

Sample UV Tiling on page 5676

Video Color Check on page 5678

Make Preview, Play Preview, Save Preview on page 5679

Material Editor Options on page 5681
Procedures

To use the Material Editor Options dialog:

1. Click Options to the right of the sample slots.
2. Set the options as you want, and then click OK.

To change the preview shape:

1. Activate the sample slot of the material you want to view.
2. Use the Sample Type flyout to choose the shape you want to view.
   The new shape is displayed in the sample slot, with the material mapped to it.
   The flyout gives you three options: sphere (the default), cylinder, or box.
   An additional custom object option is available if you define a custom object as described in Creating a Custom Sample Object.

Material Editor Menu Bar

Material Editor > Menu bar

The Material Editor menu bar appears at the top of the Material Editor window.
It provides another way to invoke the various Material Editor tools.
Material Menu

The Material menu provides the most commonly used Material Editor tools.

- Get Material on page 5687
- Pick from Object on page 5705
- Select By Material on page 5686
- Highlight Assets in ATS Dialog: If the active material uses maps that are tracked assets on page 7585 (typically bitmap textures), opens the Asset Tracking dialog with the assets highlighted.
- Assign to Selection on page 5690
- Put to Scene on page 5689
- Put to Library on page 5694
- Change Material/Map Type: Equivalent to clicking the Material Type Button on page 5706.
- Make Material Copy on page 5692
- Launch Magnify Window: Equivalent to double-clicking the active sample slot on page 5650, or choosing Magnify on its right-click menu on page 5654.
- Save as .FX File: See DirectX Manager Rollout on page 5771.
- Make Preview on page 5679
- View Preview on page 5679
- Save Preview on page 5679
- Show End Result on page 5701
- Show Materials in Viewport As on page 155
- Reset Sample Slot Rotation: Returns the active sample slot's object to its default orientation; equivalent to choosing Reset Rotation on the sample slot right-click menu on page 5654.
- Update Active Material: If Material Editor Options dialog on page 5681 > Update Active Only is on, choosing this updates the active material in its sample slot.
Navigation Menu

The Navigation menu provides tools that navigate a material’s hierarchy.

■ Go to Parent on page 5702
■ Go Forward to Sibling on page 5702
■ Go Backward to Sibling Like Go Forward To Sibling, but navigates to the preceding sibling map in the tree instead of the succeeding one.

Options Menu

The Options menu provides some additional tools and display choices.

■ Propagate Materials to Instances on page 5674
■ Manual Update Toggle Equivalent to the Manual Update toggle in the Material Editor Options dialog on page 5681.
■ Copy/Rotate Drag Mode Toggle Equivalent to choosing either Drag/Copy or Drag/Rotate on the sample slot right-click menu on page 5654.
■ Background on page 5675
■ Custom Background Toggle If you have used the Material Editor Options dialog on page 5681 to assign a custom background, this toggles its display.
■ Backlight on page 5674
■ Cycle 3X2, 5X3, 6X4 Sample Slots Cycles through the equivalent choices on the sample slot right-click menu on page 5654.
■ Options Opens the Material Editor Options dialog on page 5681.

Utilities Menu

The Utilities menu provides map rendering and selecting objects by material.

■ Render Map Equivalent to choosing Render Map on the sample slot right-click menu on page 5654.
■ Select Objects by Material on page 5686
■ Clean MultiMaterial on page 6492
■ Instance Duplicate Map on page 6497
■ **Reset Material Editor Slots**  Replaces all materials in the Material Editor with the default material type. This action is not undoable, but you can restore the previous state of the Material Editor with the Restore Material Editor Slots command (see below).

■ **Condense Material Editor Slots**  Sets all unused materials in the Material Editor to the default type, retaining only materials in the scene and moving those materials to the first slots in the editor. This action is not undoable, but you can restore the previous state of the Material Editor with the Restore Material Editor Slots command (see below).

■ **Restore Material Editor Slots**  When you use either of the two previous commands, 3ds Max saves the current state of the Material Editor in a buffer; using this command restores the state of the editor using the buffer contents.

**TIP** The buffer that holds the material definitions survives the Application menu on page 7989 > Reset command. Thus, if you use either the Reset Material Editor Slots or the Condense Material Editor Slots function, and then reset 3ds Max, you can then use Restore Material Editor Slots to bring all materials back into the Material Editor. This makes it easy to use the same materials in different projects.

For best results, follow this procedure:

1. Save your scene.

2. Use the Reset Material Editor Slots or Condense Material Editor Slots function.

3. Reset 3ds Max. When prompted to save the scene, click No. Otherwise, you might lose material definitions in the Material Editor that were saved with the scene.

4. Open the Material Editor and choose Utilities menu > Restore Material Editor Slots. The Material Editor status before step 2 is restored.

---

**Reflectance and Transmittance Display**

Material Editor > Reflectance and Transmittance fields (below the sample slots)

These fields show the reflectance and transmittance of the active material. Both the average value and the maximum value are shown.
NOTE These fields appear only when you turn on Material Editor > Display Reflectance & Transmittance Information on the Radiosity panel on page 8362 of the Preferences dialog.

<table>
<thead>
<tr>
<th>Reflectance</th>
<th>Transmittance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Avg: 67%</td>
<td>Avg: 0%</td>
</tr>
<tr>
<td>Max: 67%</td>
<td>Max: 0%</td>
</tr>
</tbody>
</table>

These fields can change according to the current Show End Result setting on page 5701. When Show End Result is off, the reflectance and transmittance show the properties of the current element in the material hierarchy, not the properties of the material overall.

The reflectance and transmittance values of a material are particularly important when you are preparing a radiosity solution on page 6615 to obtain a physically accurate lighting simulation. If a material’s reflectance or transmittance values are not what your scene needs, you need to adjust these values.

Materials and Radiosity

Upper left: Washed-out walls due to high reflectance.
Right: Better radiosity achieved by reducing the HSV Value (V) of materials in the scene.

To get good radiosity results, keep these points in mind as you design materials:

■ Before you generate a radiosity solution, check the reflectance value of all materials in the scene, to make sure it is not too high. The reflectance of a material determines how much of the light energy it receives is subsequently used in the radiosity calculation. Keep this value within the range of the physical materials you are simulating. (See the table in the description of “Reflectance,” below.)

■ Don’t be concerned if a material preview seems too dark. For example, a white wall with the maximum recommended reflectance of 80% appears gray. The color balance will be adjusted correctly by the exposure control on page 7207 in the final rendering.

■ Bitmaps used as diffuse textures have already been illuminated by the scanner, digital camera, or paint program in which you created them. To bring them into the proper reflectance range, you might have to dim them by reducing the RGB Level value in the bitmap’s Output rollout on page 6192.

Left: Wood grain bitmap as originally photographed has too high a reflectance.

Right: Reducing the RGB Level value reduces the map’s reflectance.
Reflectance Reflectance is the percentage of diffuse light energy that is reflected from a material. When you increase a material’s HSV value (V), the material reflects more diffuse light. Decreasing a material’s Opacity also decreases its reflectance.

Typically, the reflectance of a material should never be greater than 85%. This is an unusually high value that will lead to poor-quality renderings. In the real world, even the whitest wall reflects no more than 80% of the light it receives.

One source of high reflectance can be a map assigned to the material’s diffuse component. For example, a white tile bitmap might create high reflectance. In this case, you can reduce reflectance by reducing the RGB Level in the bitmap’s Output rollout.

An alternate way to reduce a bitmapped material’s reflectance is to set the diffuse color of the material to black, and then reduce the diffuse map’s Amount (in the parent material’s Maps rollout on page 6021). You can use this method to reduce the reflectance of 3D procedural maps on page 6278 as well.

Here are some typical reflectance ranges for common materials:

<table>
<thead>
<tr>
<th>Material</th>
<th>Minimum</th>
<th>Maximum</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ceramic</td>
<td>20%</td>
<td>70%</td>
</tr>
<tr>
<td>Fabric</td>
<td>20%</td>
<td>70%</td>
</tr>
<tr>
<td>Masonry</td>
<td>20%</td>
<td>50%</td>
</tr>
<tr>
<td>Metal</td>
<td>30%</td>
<td>90%</td>
</tr>
<tr>
<td>Paint</td>
<td>30%</td>
<td>80%</td>
</tr>
<tr>
<td>Paper</td>
<td>30%</td>
<td>70%</td>
</tr>
<tr>
<td>Plastic</td>
<td>20%</td>
<td>80%</td>
</tr>
<tr>
<td>Stone</td>
<td>20%</td>
<td>70%</td>
</tr>
<tr>
<td>Wood</td>
<td>20%</td>
<td>50%</td>
</tr>
</tbody>
</table>
Transmittance Transmittance is the amount of light energy transmitted through a material. A completely opaque material has 0% transmittance. When the material is transparent (like clear glass), the energy transmitted is specular, and light passes directly through the material (subject to refraction). The value of specular transmittance is an interaction between the material’s Opacity value on page 5997 and its filter color on page 8573. When the filter color is pure white, specular transmittance is the inverse of Opacity.

When the material is translucent (like frosted glass), the energy transmitted is diffuse, and scattered in all directions. The value of diffuse transmittance is based on the HSV value (V) of the translucent color on page 6002. Diffuse transmittance happens only for materials that use the Translucent shader on page 5988, or Raytrace materials on page 6064, that specify translucency.

Usually, when a material has high transmittance, it has low reflectance, and the other way around.

Sample Type

Material Editor > Sample Type

The Sample Type flyout lets you choose which geometry to display in the active sample slot on page 5650.

This flyout has three buttons:

- **Sphere (the default)** Displays the material on a sphere.

- **Cylinder** Displays the material on a cylinder.

- **Cube** Displays the material on a cube.

- **Custom** Displays the material on a custom object. This button appears only if you have used the Material Editor Options dialog on page 5681 to specify a custom object for sample slots.
See also:
- Creating a Custom Sample Object on page 5660

Propagate Materials to Instances

Material Editor > Options menu > Propagate Materials to Instances

When Propagate Materials To Instances is on, any material assignment you make will be propagated to all instances of the object in your scene, including imported AutoCAD blocks and ADT style-based objects; these object types are common in DRF files. Assignments are also propagated to instances of Revit objects and of other instances that you've made in the current scene.

When Propagate Materials To Instances is off, materials are assigned in traditional 3ds Max fashion; each object has a unique material assignment.

Backlight

Material Editor > Backlight

Material Editor menu > Options menu > Backlight

Turning on Backlight adds a backlight to the active sample slot. This button is on by default.
The effect is most easily seen with the sample spheres, where the backlight highlights the lower-right edge of the sphere.

Backlight is especially useful whenever you're creating metal on page 5980 and Strauss on page 5985 materials. Backlight lets you see and adjust the specular highlight created by glancing light, which is much brighter on metals.

**Sample Slot Background**

Material Editor > Background

Material Editor menu > Options menu > Background

Turning on Background adds a multicolored checkered background to the active sample slot. The pattern background is helpful when you want to see effects of opacity and transparency.
The Material Editor Options dialog on page 5681 also lets you assign a bitmap to use as a custom background.

Sample UV Tiling

Material Editor > Sample UV Tiling

The buttons on the Sample UV Tiling flyout adjust the repetition of the map on page 8631 pattern on the sample object in the active sample slot.
1x1, 2x2, and 3x3 sample tiling

The tiling pattern you set with this option affects only the sample slot. It has no effect on the tiling on the geometry in the scene, which you control with parameters in the map’s own coordinates rollout.

- 1 x 1 (the default) Tile once in the U dimension and once in V. This is equivalent to no tiling at all.
- 2 x 2 Tile twice in U and twice in V.
- 3 x 3 Tile three times in U and three times in V.
- 4 x 4 Tile four times in U and four times in V.

The buttons specify the number of times the pattern repeats over the surface of the sample object. Because maps are mapped spherically around the sample sphere, the tiling on page 8742 repetition covers the entire surface of the sphere. The sample cylinder maps cylindrically. The sample cube uses box mapping; the tiling appears on each side of the cube. Custom sample objects use the default mapping coordinates for that kind of object, unless the object has a
UVW Map modifier on page 1932 applied to it, in which case the modifier controls the mapping.

This flyout is unavailable when the sample slot displays a standalone (top-level) map.

See also:
- Creating a Custom Sample Object on page 5660

**Video Color Check**

Material Editor > Video Color Check

Video Color Check checks the material on the sample object for colors that are beyond the safe NTSC on page 8654 or PAL on page 8674 threshold.

Left: Material with oversaturated colors

Right: Video color check shows black areas that are beyond the video threshold

Such colors tend to blur or fuzz when transferred from computer to video. Pixels containing these "illegal" or "hot" colors are flagged on the sample object.
You can have 3ds Max correct illegal colors automatically when you render, depending on the settings in the Rendering tab on page 8342 of the Customize/Preferences dialog on page 8298.

Use this option as a guide only. The colors in a rendered scene depend not only on the material color but also on the intensity and color of the lighting. A material that shows as safe in the sample slot might become illegal if rendered under several bright lights. A safe practice for video is to use colors whose saturation is less than 80 to 85 percent.

**Procedures**

**To check for illegal video colors:**

1. On the Material Editor, turn on Video Color Check on page 5678. The active sample slot now renders "illegal" pixels as black. Illegal pixels have a color that is beyond the safe video threshold.
   
   If Video Color Check detects illegal colors, try reducing the saturation of the material colors in question.

2. You can also check for legal video colors when you render a scene.

**To change the video system:**

NTSC on page 8654 is the default video system to check. You can change the video checking to PAL on page 8674.

- In the Tools menu > Options > Options dialog > Rendering panel on page 8342 > Video Color Check group, change the setting to PAL.

The sample slot does not automatically update when you change the video system preference. Turn video checking off and back on to see the change.

**NOTE** The Rendering panel also shows options for choosing alternate ways to display illegal pixels. These apply to renderings only, not to the sample slots in the Material Editor.

**Make Preview, Play Preview, Save Preview**

Material Editor > Make/Play/Save Preview flyout
Material Editor menu > Material menu > Make Preview, View Preview, or Save Preview

You can use animated maps to add movement to a scene. For example, to simulate a sky view, you could map an animation of moving clouds to a clerestory window. The Make Preview options let you experiment with the effect in the Material Editor before you apply it to your scene.

The buttons on the Make Preview, Play Preview, Save Preview flyout let you preview the effect of an animated map on the object in a sample slot (see Sample Type on page 5673 for alternatives to the default sphere.) You can use an AVI file on page 7832, or IFL file on page 7841 as a source for the animation. The finished preview is saved as a new AVI file and automatically played back. You can also view the preview in a sample slot by dragging the time slider.

This flyout has three options:

- **Make Preview**  Displays a Create Material Preview dialog on page 5711 to create an AVI file of the animated material. When the preview is complete, it is saved as _medit.avi in the \previews subdirectory. The file is then opened in the Windows Media Player and played back. Without this option, the only other way to preview a complex animated material in real time is to use the renderer on page 6568 to render an animated sequence and save it to an AVI file, a digital disk recorder, or a video tape recorder.

- **Play Preview**  Uses the Windows Media Player to play the current _medit.avi preview file in the \previews subdirectory.

- **Save Preview**  Saves the _medit.avi preview to an AVI file of a different name in the \previews subdirectory.

**Procedures**

To create a preview of an animated material:

1. Choose Make Preview from the flyout.
2. In the Create Material Preview dialog, set the preview conditions you want, and then click OK.
The preview is created, and then plays.

**To play back a preview of an animated material:**

- Choose Play Preview from the flyout.
  
  The Material Editor starts the Windows Media Player. The Player then loads the current `_medit.avi` preview file in the `\previews` subdirectory and plays it in a separate window.

**To view an animated material in a sample slot:**

- Drag the time slider through the range of frames.
  
  By default, all sample slots with animated maps update at the same time. To change this, see Material Editor Options Dialog on page 5681.

**To save a preview under a different name:**

1. Choose Save Preview from the flyout.
   
   The Material Editor displays a File Save dialog.

2. Enter a new name for the preview, and then click OK to save the file in the `\previews` subdirectory.

**To play a renamed preview:**

1. Choose Rendering menu > View Image Image.

2. In the View File dialog, change to the `\previews` subdirectory.

3. Select the renamed preview file and click Open.
   
   The preview is played in a separate window.

---

**Material Editor Options**

Material Editor > Material Editor Options

Material Editor menu > Options menu > Options

This button displays the Material Editor Options dialog to let you control how materials and maps are displayed in the sample slots on page 5650.
These settings are “sticky”; they survive a reset, and even quitting and restarting 3ds Max.

**NOTE** The controls to assign a renderer for the sample slots are on the Assign Renderer rollout on page 6582.

**Interface**
Manual Update When on, the sample slots don’t update their contents until you click them. This option affects only the updating of the sample slots; it doesn’t affect the icon displays in the Browser. Default=off.

Don’t Animate When on, animated maps are not updated in the sample slots while you play an animation or drag the time slider. However, the animation is updated to the current frame when you stop the animation or release the time slider. An animated map can use an AVI file on page 7832 or IFL file on page 7841 as a source. Default=off.

Animate Active Only When on, only the active sample slot is animated when you play an animation or drag the time slider. This option is good for situations where you have multiple animated materials in the Material Editor, but you only need to see one at a time. This check box is unavailable when Don’t Animate is on. Default=off.

Update Active Only When on, sample slots do not load or generate maps until you make one sample slot active. This can save time while you use the Material Editor, especially when your scene uses a lot of materials with maps. Default=off.

Antialias Turns on antialiasing on page 8501 in the sample slots. Default=off.

Progressive Refinement Turns on progressive refinement in the sample slots. When on, samples are rendered quickly, with large pixels, then rendered a second time in greater detail. Default=off.

Simple Multi Display Below Top Level When on, the sample sphere for a Multi/Sub-Object material displays the multiple patches only at the top level of the material. The sub-materials are displayed over the entire sphere. When you use nested Multi/Sub-Object materials, the multiple patches again appear at the top level of the nested material, but the sample sphere is again whole when displaying any of the sub-materials. Default=on.

Display Maps as 2D When on, sample slots display maps, including standalone maps, in 2D. The map fills the entire slot. When off, maps are displayed on the sample object, as materials are. Default=on.

Custom Background Lets you specify a custom background for the sample slots, instead of the default checkers background. Click the file-assignment button to display a file dialog from which you can select the custom background. This can be any bitmap format supported by 3ds Max. Turn on Custom Background to use the new background instead of the checkered background. The custom background is stored in the 3dsmax.ini on page 60 file, so it is available from session to session. Default=off.
**Display Multi/Sub-Object Material Propagation Warning** Toggles display of warning dialog when you apply a Multi/Sub-Object material on page 6120 to an instanced ADT style-based object.

**Auto-Select Texture Map Size** When on, and you have a material that uses a texture map set to Use Real-World Scale, ensures that the map will be displayed correctly on the sample sphere. Turn off to be able to enable Use Real-World Map Size For Geometry Samples (see following).

**NOTE** If a material uses several texture maps at different levels, and only one is set to Use Real-World Scale, the sample sphere will render with real-world size coordinates.

**Use Real-World Map Size For Geometry Samples** This is a global setting that allows you to manually choose which style of texture coordinates are used. When on, real-world coordinates are used for the sample slot display. Otherwise, the old style of 3ds Max mapping coordinates is active. When off, you must turn on Use Real-World Scale on the map's Coordinates rollout to see the sample sphere as you'd expect. Available only when Auto-Select Texture Map Size (above) is off. Default=off.

---

**Top Light color / Back Light color** Specify the two lights used in the sample slots. Click the color swatch to alter the color of either light. Adjust the Multiplier spinners to multiply the values (intensity) of the lights.

Use the Default buttons to return to the initial settings.

**Ambient Light** Shows the color of ambient light on page 8504 used in the sample slots. Click the color swatch to change the color. When the lock button is on, changing the Ambient Light color here or on the Environment panel on page 7163 changes both; when off, changing one setting does not affect the other.

Use the Default button to return to the initial setting.

**Background Intensity** Sets the background intensity in the sample slots. The range is from 0 (black) to 1 (white). Default=0.2.

Use the Default button to return to the initial setting.

**Render Sample Size** Sets the scale of the sample sphere to any size, making it consistent with the object or objects in the scene that have the texture on them. This setting affects how 2D and 3D maps are displayed providing that the sample spheres are set to display real-world scale.
NOTE The size is scaled to use the current units.

This is a global option that affects all the sample slots. Default=100.0 (Imperial units) and 2.54m (Metric units).

Use the Default button to return to the initial setting.

**Default Texture Size** Controls the initial size (both height and width) of a newly created real-world texture. You see the result of changing this option only when you create a new texture in a material; the change appears in the Coordinates rollout on page 6201. Default=48.0 (Imperial units) and 1.219m (Metric units).

NOTE This setting applies to real-world textures only. For the default size to be applied to newly created textures, the Preferences dialog > General panel > Use Real-World Texture Coordinates check box must be on.

Use the Default button to return to the initial setting.

**DirectX Shader group**

These options affect the viewport behavior of the DirectX Shader material on page 6175.

**Force Software Rendering** When on, forces DirectX Shader materials to use the selected software render style for viewports. When off, the FX file specified in the DirectX Shader is used unless the material's local Force Software Rendering toggle is on. Default=off.

**Shade Selected** When Force Software Rendering is on, selected objects, and only selected objects, are shaded by the DirectX Shader material. This toggle is unavailable unless Force Software Rendering is on. Default=off.

**Custom Sample Object group**

Controls in this group let you specify a custom sample object on page 5660 to use in the sample slots on page 5650.

**File Name** Selects the MAX scene file.

The scene should contain a single unlinked object that fits in an imaginary cube 100 units on a side. The object must be either a primitive with a Generate Mapping Coords. check box, or have a UVW Map modifier on page 1932 applied to it. The scene can contain a camera and lights.

**Load Camera and/or Lights** Turn on to have sample slots use the camera and lights in the scene, instead of the default sample slot lighting.
Slots group

These options let you choose how many sample slots to display at a time.

The Material Editor always has 24 sample slots available. You can choose to display fewer sample slots at a larger size. When you do, scroll bars let you move around among the sample slots.

3 X 2 Specifies a 3 x 2 array of sample slots. (The default: 6 windows.)
5 X 3 Specifies a 5 X 3 array of sample slots. (15 windows.)
6 X 4 Specifies a 6 X 4 array of sample slots. (24 windows.)

Apply Applies the current settings, except for changes to the Slots group, without leaving the Material Editor Options dialog. This is useful when you adjust lighting values for the sample slots.

OK Closes the dialog and applies any changes you made.

Cancel Closes the dialog and cancels any changes you made, including changes you applied with the Apply button.

Select By Material

Material Editor vertical toolbar > Select By Material button
Material Editor > Material menu > Select by Material
Material Editor > Utilities menu > Select Objects by Material

Select By Material allows you to select objects based on the active material in the Material Editor. This command is unavailable unless the active sample slot contains a material used in the scene.

Choosing this command opens the Select Objects dialog, which works like Select From Scene on page 206. All objects that have the selected material applied to them are highlighted in the list.

NOTE Hidden objects don’t appear in this list, even if the material is applied to them. However, in the Material/Map Browser on page 5724, you can choose Browse From: Scene, turn on By Object, and then browse from the scene. This lists all objects in the scene, hidden and unhidden, along with their assigned materials.
Procedures

To select objects that have the same material applied:

1. Click a sample slot that contains a material in the scene. White corner brackets indicate materials that are in the scene.

2. Click Select By Material on page 5686 in the Material Editor. This button is unavailable unless the active sample slot contains a material in the scene. The Select Objects dialog on page 206 opens. The names of objects with the active material applied are highlighted.

3. Click Select to select objects with the active material applied. You can also change the selection by choosing other objects. If you change the selection, you must then click Assign Material To Selection on page 5690 to apply the active material to newly selected objects.

Get Material

Material Editor > Get Material

Material Editor menu > Material menu > Get Material

Get Material displays the Material/Map Browser on page 5724 to allow you to choose a material on page 8635 or map on page 8631.

Procedures

To get a material from a scene:

1. Click a sample slot to make it active. Be careful not to click the sample slot of a material you want to use later.

2. On the Material Editor toolbar, click Get Material on page 5687. A modeless Material/Map Browser on page 5724 is displayed.

3. In the Browse From group box at the upper left, make sure that either Selected or Scene is chosen.
The Selected option lists only materials in the current selection. If no objects are selected, the list of materials is blank.

The Scene option lists all the materials currently in the scene.

4 In the list of materials, double-click the name of the material you want to get.
You can also drag the material name to the sample slot.
The material you chose replaces the previous material in the active sample slot.

**WARNING** When you get a material from a scene, initially it is a hot material.

To get a material from a library:

1 On the Material Editor toolbar, click Get Material. A modeless Material/Map Browser is displayed.

2 In the Browse From group box at the upper left, make sure that Material Library is chosen.
If you have opened a library, the list of materials shows the contents of the library.
If you haven't opened a library, click Open in the file area of the Browser. A file dialog is displayed. Choose a library. After you open the library, the list of materials updates to show the library contents.

**NOTE** Open also lets you get materials from a 3ds Max scene (a .max file).

3 In the list of materials, double-click the name of the material you want to get.
You can also drag the name of the material to the sample slot.
The material you chose replaces the previous material in the active sample slot.

To create a standalone map tree:

1 Activate a sample slot.

2 On the Material Editor toolbar, click Get Material.
3 In the Material/Map Browser on page 5724, make sure Browse From is set to New.

4 In the Show group box, turn off Materials so only maps are displayed in the list.

5 Double-click the name of the map type (not a material type) you want to use, or drag the map to a sample slot.
   The sample slot now contains a standalone map not associated with material parameters.

6 Use the Material Editor to modify the map as you would any other map.
   By default, the sample slots distinguish maps from materials by displaying maps as 2D surfaces without lighting or shading.

To remove a material from an object:

1 On the Material Editor toolbar, click Get Material.
   The Material/Map Browser appears.

2 Drag the entry NONE from the top of the list in the Browser to the object.
   The object now has no material applied to it.

Put Material to Scene

Material Editor > Put Material to Scene
Material Editor menu > Material menu > Put to Scene

Put Material To Scene updates a material in the scene after you edit the material.

Put Material To Scene is available only when:

- The material in the active sample slot has the same name as a material in a scene.
- The material in the active sample slot is not hot.
In other words, this command is intended to fit into the overall sequence of handling materials:

- You create a hot material either by applying it to objects in the scene or by getting it from the scene.
- You make a copy of the material.
- You make changes to the copy of the material.
- You update the scene by putting the changed material back into the scene.

Notes

- If you apply a mapped material to a parametric object whose Generate Mapping Coords option is off, 3ds Max automatically turns on mapping coordinates at render time. In addition, if you apply a mapped material with Show Map in Viewport active to an object, that object’s Generate Mapping Coords option is turned on if necessary.

- The Show Map In Viewport flag is now saved with individual materials, so you can drag mapped materials from the modeless Browser onto objects in your scene, and the mapping appears in the viewports.

Procedures

To put a material back into a scene:

- On the Material Editor toolbar, click Put Material To Scene. The material in the active sample slot is now a hot material on page 8603.

Assign Material to Selection

Material Editor > Assign Material to Selection

Material Editor menu > Material menu > Assign to Selection

Assign Material to Selection applies the material in the active sample slot to the currently selected object or objects in the scene. At the same time, the sample slot becomes hot on page 8603.
If you apply a mapped material to a parametric object whose Generate Mapping Coords option is off, 3ds Max automatically turns on mapping coordinates at render time. In addition, if you apply a mapped material with Show Map In Viewport on page 5696 active to a parametric object, that object's Generate Mapping Coords option is turned on if necessary.

The Show Map In Viewport flag is saved with individual materials, so when you drag mapped materials from the modeless Browser on page 5724 onto objects in your scene, the mapping appears in the viewports.

The Undo command works for material assignment.

**Procedures**

**To apply a material to objects in a scene:**

1. Select the sample slot that contains the material you want to apply.
2. Select the objects you want to apply the material to.
3. Do either of the following:
   - Drag from the sample slot to the objects. If more than one object is selected, you are asked whether you want to apply to the single object or to the whole selection.
   - ![Click Assign Material To Selection on page 5690 on the Material Editor toolbar.](image)

**WARNING** When you apply a material to an object or selection, that material becomes a hot material on page 8603. When you change the material's properties, the scene immediately updates to reflect those changes. Any object with that material will change its appearance, not just the objects in the current selection. When a material is hot, its sample slot is displayed with white corner brackets.

To make a material no longer hot so it doesn't change the current scene, click Make Material Copy on page 5692.

**Reset Map/Mtl to Default Settings**

Material Editor > Reset Map/Mtl to Default Settings
Reset Map/Mtl to Default Settings resets the values for the map or material in the active sample slot.

The material colors are removed and set to shades of gray. Glossiness, opacity, and so on are reset to their default values. Maps assigned to the material are removed.

If you are at a map level, this button resets the map to default values.

Reset changes the name on page 5706 only when this field names a material used in the scene.

**Make Material Copy**

Material Editor > Make Material Copy

Material Editor menu > Material menu > Make Material Copy

Make Material Copy "cools" on page 8541 the current hot on page 8603 sample slot by copying the material to itself.

The sample slot is no longer hot, but the material retains its properties and name. You can adjust the material without affecting it in the scene. Once you've got what you want, you can click Put Material to Scene on page 5689 to update the material in the scene and change the sample slot to hot again.

**Make Unique (Material Editor)**

Material Editor > Make Unique

Make Unique makes a map instance on page 8611 into a unique copy. It also makes an instanced sub-material into a unique, standalone sub-material. It gives the sub-material a new material name. A sub-material is a material within a Multi/Sub-Object material on page 6120.

Using Make Unique prevents changes to the top-level material instance from affecting the sub-material instance within the Multi/Sub-Object material.

You can also use Make Unique at the map level, when a map is instanced to different components of the same material.
**NOTE** If you drag an instanced map to a Material Editor sample slot, the Make Unique button will not be available, because it is not clear from the context what it would be unique relative to. Instead, you need to bring one of the parent maps or materials into the Material Editor, browse down into the map, and then make the map unique relative to that parent.

**Procedures**

**Example: Create an instanced sub-material:**

1. Create a box and a sphere.

2. Open the Material Editor.

3. Choose a sample slot, click the Material Type button, choose Multi/Sub-Object in the Material/Map Browser, and then click OK.

4. Select the box, and then apply the new Multi/Sub-Object material to it.

5. Drag one of the Sub-Material buttons from the Material Editor to the sphere.

6. Choose a different sample slot, and use the Pick Material From Object button to get the sub-material applied to the sphere. At this point, the material applied to the sphere and the sub-material are instances of each other.

7. Go to the parameters for the instanced sub-material by clicking its Sub-Material button.

8. The Make Unique button is now available. Click it to make the sub-material unique again, and assign it a new material name. Make Unique is not available for the top-level instance of the sub-material.
Put to Library

Material Editor > Put to Library
Material Editor menu > Material menu > Put to Library

Put To Library adds the selected material to the current library.

A Put To Library dialog on page 5717 is displayed, which lets you enter a name for the material that's different from the one you used in the Material Editor.

The material becomes visible in the material library display in the Material/Map Browser on page 5724. The material is saved to the library file on disk. (You can also save a library by using the Save button in the Material/Map Browser.)

Procedures

To save a material in a library:

1. Click to select the sample slot that has the material you want to save.

2. On the Material Editor toolbar, click Put To Library on page 5694.

3. A Put To Library dialog on page 5717 is displayed.

4. Either change the material name or leave it as is, and then click OK.

   The material is saved in the currently open library. If no library is open, a new library is created. You can save the new library as a file using the Material/Map Browser on page 5724 file controls.

Material ID Channel Flyout

Material Editor > Material ID Channel flyout

The buttons on the Material ID Channel flyout tag a material as a target for a Video Post on page 7247 effect or a rendering effect on page 7057, or for storing with a rendered image saved in RLA on page 7873 or RPF on page 7875 file format (so that the channel value can be used in a post-processing application). The material ID value is the counterpart of a G-buffer value on page 8589 for objects.
Zero (0), the default, indicates that no material ID channel is assigned.

A value from 1 to 15 means to apply a Video Post or rendering effect that uses this channel ID to this material.

For example, you might want a material to glow wherever it appears in the scene. The material is in the Material Editor and the glow comes from a rendering effect. First, you add a Glow rendering effect on page 7073 and set it up so that it operates on ID 1. Use Material ID Channel to give the material an ID number of 1, then apply the material to objects in the scene in the usual way.

To save the channel data with the rendering, use the RLA or RPF format.

WARNING The mental ray renderer on page 6675 does not recognize Z-depth with G-buffers. G-buffer data is saved on a single layer. Also, the mental ray renderer does not support the following effects:

- Glow lens effect on page 7073 (rendering effect)
- Ring lens effect on page 7080 (rendering effect)
- Lens effects Focus filter on page 7339 (Video Post)

Procedures

To assign a material ID channel to a material:

- Choose a channel number from the Material ID Channel flyout.

NOTE Giving a material a nonzero ID channel number tells the renderer to generate a material ID channel containing that value. This information is stored in images only if you save the rendered scene in RLA or RPF format. However, the ID channel data is available to rendering effects at render time.
Show Standard/Hardware Map in Viewport

Material Editor > Show Standard/Hardware Map in Viewport

Material Editor menu > Material menu > Show Materials in Viewport As on page 155

This control lets you switch between using software and hardware (DirectX 9.0c and above) for the viewport display, and also toggles the display of mapped materials on the surfaces of objects in shaded viewports with the interactive renderer on page 8757. The control is actually a flyout on page 8582 with four possible states:

- **Show Standard Map in Viewport [off]:** Uses the legacy software display and disables viewport display of all maps for the active material.

- **Show Standard Map in Viewport [on]:** Uses the legacy software display and enables viewport display of all maps for the active material.

Left: Map shown on sample cube

Right: Map shown in a viewport
Show Hardware Map in Viewport [off]: Uses the hardware display and disables viewport display of all maps for the active material.

Show Hardware Map in Viewport [on]: Uses the hardware display and enables viewport display of all maps for the active material.

Comparison of Standard and Hardware Displays

The ability to render materials in the viewports using a hardware-based display mode lets you view and adjust certain parameters interactively without having to generate a final render, saving time when editing materials. The hardware display does not fully support all material parameters, however. When considering which display mode to use for a material, take these points into consideration:

<table>
<thead>
<tr>
<th>Software Display</th>
<th>Hardware Display</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supports all materials</td>
<td>Supports only Standard and Arch &amp; Design materials</td>
</tr>
<tr>
<td>Supports Diffuse maps only</td>
<td>Supports Diffuse, Specular, and Bump maps, as well as Anisotropy and BRDF settings</td>
</tr>
<tr>
<td>No reflection</td>
<td>Reflects the sky shader on page 5532</td>
</tr>
<tr>
<td>Calculates specularity on per-face basis</td>
<td>Calculates specularity on per-pixel basis</td>
</tr>
<tr>
<td>Faster, no special hardware requirements</td>
<td>Slower but more accurate, requires a DirectX9.0c-compliant video card</td>
</tr>
<tr>
<td>Renders faceted display modes correctly</td>
<td>Renders faceted display modes as smoothed</td>
</tr>
</tbody>
</table>

The following image, taken from the 3ds Max viewport, shows two spheres to which are applied two copies of an Arch & Design material with identical settings, including texture-mapped diffuse color and bump mapping, a high
reflectivity level, and a Checker map applied to the Anisotropy channel. The scene also includes a Daylight system with mr Sun and Sky, with the Environment Map set to mr Physical Sky. The only difference is that the material on the left-hand sphere is set to Show Standard Map in Viewport, while the material on the right-hand sphere is set to Show Hardware Map in Viewport. The latter shows the bump mapping, reflection of the sky, and the checkered anisotropy in the specular highlight. The spheres render identically, and look similar to the right-hand sphere.

Usage Notes

Please observe the following important aspects of using these controls:

- The hardware display applies only to the Standard on page 5962 and Arch & Design on page 5858 materials; when it’s active, 3ds Max still uses 3ds Max display to render all other materials.

- Choosing the alternate flyout button does not toggle its state. For example, if Show Standard Map in Viewport is off for the active material, choosing Show Hardware Map in Viewport simply switches the material to hardware display mode; it does not turn on the maps. You must toggle the control explicitly.

- This control is also available at the map level, where it functions only as a toggle for the option set at the material level, and applies only to the
active map. So, for example, with the hardware display you could enable viewport display of the bump map while disabling display the diffuse map, although both would appear in the final rendered image. Changing the setting at the material level overrides any map-level settings.

**NOTE** If the toggle is unavailable at a map level, it means viewport display of the map is unsupported. One possible reason is that the map is nested too deep in the material tree.

- Hardware viewport rendering requires a DirectX9.0c-compliant video card. Also, hardware viewport rendering is supported only by the Direct3D display driver on page 8325.

- These options do not apply to XRef materials on page 6183, including materials from XRef objects on page 7450 and XRef scenes on page 7477.

- Displaying mapped materials in a viewport can slow performance. If you don't need to view the map, turn off its viewport display.

- You can toggle Show Standard/Hardware Map In Viewport for all materials by choosing Views menu > Show Materials in Viewport As on page 155.

- The state of this button is saved with the material in the library. When you apply a mapped material while Show Map In Viewport is active, the object's Generate Mapping Coords. check box is turned on. This means that you can drag mapped materials from the Material Library in the Browser over objects in your scene, and have the mapped material appear in the viewports.

- In the Material/Map Browser on page 5724 and Material/Map Navigator on page 5703, icons of materials and maps for which Show Map in Viewport is on are red, as shown in the following example:
Requirements

For mapped materials to display in the viewport, the following conditions must be met:

- **Mapping coordinates** on page 8628 must be applied to the object. This is already the case with most primitive objects, which by default have Generate Mapping Coords on at creation. If an object doesn't have mapping coordinates, you can turn this on, or apply a mapped material to the object (if it has a Generate Mapping Coords check box), or apply a **UVW Map modifier** on page 1932 or a **Unwrap UVW modifier** on page 1837.

- A mapped material must be applied to the object.

- **Show Map In Viewport** must be on, either at the level of the material that contains the map on page 8631, or at the top level of the material.

  **NOTE** With the **software display driver** on page 8317, viewports don't accurately display a map with transparency that has UV tiling or mirroring. Also, this driver cannot display a map on a faceted material.

3D Maps in Viewports

Show Map In Viewport works for 3D procedural maps as well as 2D maps. 3D map display in viewports is not necessarily accurate. To improve the 3D preview, you can use the **Material Editor Options dialog** on page 5681 to set the 3D Map Sample Scale to equal a main dimension of the object you are applying the map to. For example, if you want to use the planet map on a sphere with a radius of 20, change the map scale from 100 (the default) to 20.

Particle Age and Particle MBlur maps do not preview in viewports.

Multiple Maps in Viewports

Viewports can display multiple maps. For multiple map display, the display driver must be **OpenGL** on page 8319 or **Direct3D** on page 8325. The **software display driver** on page 8317 does not support multiple map display.

The **composite map** on page 6331 and **mix map** on page 6339 support multiple map display.

In addition, turning on Show Map In Viewport at the top level of a **standard material** on page 5962 lets you view maps on both the diffuse and opacity components (though not on other mapped components).
Procedures

To view maps interactively:

1. Select an object.

2. In the object’s creation parameters, make sure that Generate Mapping Coords. is on. (If this option isn’t enabled, the object can’t be mapped.) If the object type does not have a mapping coordinates check box, apply a UVW Map on page 1932 modifier.

3. In the Material Editor, apply the mapped material to the object.

4. Turn on Show Standard Map In Viewport, or with the Standard or Arch & Design material, alternatively turn on Show Hardware Map in Viewport. The map appears on objects assigned the material in all shaded viewports. Now when you adjust a map, the viewports update to display the adjustments.

To turn off interactive texture display:

- Turn off Show Map In Viewport. The object is shaded but the map no longer appears.

Show End Result

Material Editor > Show End Result

Material Editor menu > Material menu > Show End Result

Show End Result lets you look at the material at the level you’re on instead of looking at the end result of all the other maps on page 8631 and settings.

When this button is off, the sample slot shows only the current level of the material. This tool is useful when you are working with compound
materials on page 8535. It would be difficult to see exactly what effect you’re creating on a particular level if you didn’t have the ability to turn off the display of the other levels.

**Go to Parent**

Material Editor > Go to Parent

Material Editor menu > Navigation menu > Go to Parent

Go To Parent moves up one level in the current material.

This button is available only when you are not at the top level of a compound material on page 8535. You can tell you’re at the top level when this button is unavailable and the name in the edit field matches the name in the Material Editor title bar.

A typical situation is one in which you have a material with a Diffuse map. The Material level is the parent and the Diffuse map is the child. The Go To Parent button becomes available at the level of the Diffuse map.

**TIP** You can also navigate through the levels of a material with the Material/Map Navigator on page 5703.

**Go Forward to Sibling**

Material Editor > Go Forward to Sibling

Material Editor menu > Navigation menu > Go Forward to Sibling

Go Forward To Sibling moves to the next map or material at the same level in the current material.

This button is available only when you are not at the top level of a compound material on page 8535, and there is more than one map or material at the current level.

A typical situation is one in which you have a material with a Diffuse map, a Bump map, and a Glossiness map. The Material level is the parent and the Diffuse map, Bump map, and Glossiness map are its children. Go Forward To Sibling becomes available at the level of the children and allows you to go from one to another.
You can also navigate through the levels of a material with the Material/Map Navigator on page 5703.

**Material/Map Navigator**

Material Editor > Material/Map Navigator

The Material/Map Navigator is a modeless dialog that provides quick navigation through the hierarchy of maps on page 8631 in a material on page 8635, or of sub-materials in a compound material on page 8535.

The Navigator displays the material and maps in the currently active sample slot. You can navigate the hierarchy of the current material by clicking the material or map listed in the Navigator. Conversely, as you navigate the material in the Material Editor, the current level is highlighted in the Navigator. The selected material or map becomes active in the sample slot, while the rollouts for the selected material or map are displayed below.

You can also drag from the Navigator to any valid sample slot or button in the user interface.

Use the view buttons at the top to change the display. The list displayed in the Navigator is similar to the one displayed in the Track View hierarchy.

**See also:**

- Material/Map Browser on page 5724
Interface

NOTE Icons of materials and maps for which *Show Standard/Hardware Map in Viewport* on page 5696 is on are red.

Also, the names of instanced on page 8611 materials and maps appear in boldface. Both of these effects are shown in the following illustration:

The view buttons are as follows:
View List Displays the materials and maps in list format. Blue spheres are materials. Green parallelograms are maps. The green parallelograms turn red if Show Map in Viewport is on for a material.

View List + Icons Displays the materials and maps as small icons in a list.

View Small Icons Displays the materials and maps as small icons. As you move the mouse over the icons, tooltip labels show you the name of the material or map.

View Large Icons Displays the materials and maps as large icons. As you move the mouse over the icons, tooltip labels show you the name of the material or map.

The large icons are labeled with the name of the material or map and are displayed using progressive refinement. That is, samples are rendered quickly, with large pixels, then rendered a second time in greater detail.

Pick Material From Object (Eyedropper)

Material Editor > Pick Material From Object

Material Editor menu > Material menu > Pick from Object

Pick Material From Object lets you select a material from an object in the scene. Click the eyedropper button, and then move the eyedropper cursor over the objects in the scene. When the eyedropper cursor is over an object containing a material, it fills with "ink" and a tooltip with the name of the object pops up. Click the object. The material is placed in the active sample slot.

If the material is already in the active sample slot, the eyedropper has no effect.

If the eyedropper cursor is over an editable mesh on page 2192 with faces selected at the sub-object level, and the mesh has a Multi/Sub-Object material on page 6120 applied to it, then the eyedropper picks up the sub-material. However, if the selected faces have more than one sub-material assigned to them, then the eyedropper picks up the entire Multi/Sub-Object material.
Name Field (Materials and Maps)

Material Editor > Material Name field

The Name field displays the name of the material or map. Default material names are "01 − Default," and so on, the number changing to reflect the material's sample slot. Maps are named "Map #1," and so on.

You can edit this field to change the name of the material in the active sample slot. You can also edit the names of maps and sub-materials assigned at lower levels of the map or material hierarchy.

The name of the material is not a file name: it can contain spaces, numbers, and special characters. It can be of any length.

This field also functions as a drop-down list. At the top level, it shows only the material or map name. At lower levels of the hierarchy, drop the list down to see the names of ancestors to the map or material. The top level is at the top of the list, the current level is at the bottom, and intermediate levels appear between them.

Procedures

To give a material a different name:

- Edit the name field that appears below the Material Editor toolbar.
  The name of the active material appears in the title bar of the Material Editor dialog.

Type Button (Materials and Maps)

Material Editor > Type button

Material Editor menu > Material menu > Change Material/Map Type

Click the Type button to display the Material/Map Browser on page 5724 and choose which material type or map type to use.

When changing a material's type, the original material type is replaced unless you choose a compound material on page 8535, in which case a Replace Material dialog on page 5721 is displayed. The Replace Material dialog lets you choose between discarding the original material or using it as a sub-material within the new material.
For a standalone map (a map at the top level), clicking the Type button lets you change the map type instead of the material type. However, you can’t use this button to make a map standalone. To make a standalone map, you have to click Get Material on page 5687 and choose a map from the Browser it displays.

When you change the type of a standalone map, a Replace Map dialog on page 5721 is displayed. The Replace Map dialog lets you choose between discarding the original map or using it as a sub-map within the new map.

**Animating Materials**

This topic provides some suggestions about how to animate materials.

**Animating Basic Materials**

In general, you animate a basic material by changing its parameters in different keyframes while Auto Key is active. 3ds Max interpolates values between keyframes, as it does when you animate transforms and modifiers.

Be aware that the tracks for a material assigned to an object are distinct from the material tracks that belong to the Material Editor: animating a material in the Material Editor affects the scene only if the material is hot on page 8603.

**Animating Mapped Materials**

As with basic materials, you can create animation keys for map parameters.

The noise parameters and the Noise map on page 6303 itself provide the Phase parameter specifically for animating the noise function.

You can also produce an animated material by applying an animated bitmap as a map. This automated bitmap can be an AVI on page 7832 or MOV on page 7849 file, or an image sequence in the form of an IFL on page 7841 file.

**Changing One Material into Another**

Probably the easiest way to animate the change of one material into another is to create a Blend material on page 6107, make the two other materials its sub-materials, and then animate its Mix Amount parameter.
Preview and Playback

When you animate a material, or use an animated bitmap in a material, you can create and view a preview of this material before you decide to use it in a fully rendered animation.

Creating and Playing Animated Material Previews

You can create a preview movie of an animated material. Use Make Preview on page 5679 in the Material Editor. Clicking this button displays the Create Material Preview dialog on page 5711, which like the Renderer has controls for which frames to render, playback speed, and output size.

The preview movie is saved in the \previews subdirectory in a file called _medit.avi. Each time you create a new preview, the Material Editor overwrites this file. To keep a preview movie on hand, save it under a different name by using the Save Preview button on the same flyout as Make Preview.

Procedures

To create a preview of an animated material:

1  Choose Make Preview from the flyout.
2  In the Create Material Preview dialog, set the preview conditions you want, and then click OK.
   The Material Editor creates the preview.

To play back a preview of an animated material:

1  Choose Play Preview from the flyout.
   The Material Editor starts the Windows Media Player with the active preview movie loaded.
2  Click Play to view the preview movie.

To save a preview movie under a different name:

1  Choose Save Preview from the flyout.
   The Material Editor displays a file save dialog.
2  Enter a new name for the preview, and then click OK.
Synchronizing an Animated Bitmap with the Scene

Material editor > Bitmap map > Time rollout

Bitmaps on page 6213 have a Time rollout with controls that let you synchronize an animated bitmap with scene animation.

Interface

Start Frame The frame number of the 3ds Max scene at which the bitmap animation begins to play.

Playback Rate Sets the bitmap's playback rate. This value is a multiplier: 1.0 is one bitmap frame per scene frame, 2.0 is twice as fast, 3.33 is 1/3 as fast, and so on. Default=1.0.

Sync Frames to Particle Age When on, 3ds Max synchronizes the frames of a bitmap sequence to the age of particles to which the map is applied. With this effect, each particle displays the sequence from the start when it is born, rather than being assigned whichever frame is current. Default=off.

When using Particle Flow, assign the material containing the Bitmap map to a Material Dynamic operator. For more details and a procedure, see Material Dynamic Operator on page 3168.

NOTE This functionality is not supported by the mental ray renderer.

End Condition group

Determines what happens after the last frame of the bitmap animation if the animation is shorter than the scene.

Loop Causes the animation to repeat over and over again from the beginning.
Ping-Pong Causes the animation to be played forward and then backward repeatedly, making every animated sequence "loop smoothly."

Hold Freezes on the last frame of the bitmap animation.

Material Editor Subdialogs

The topics in this section describe support dialogs for the Material Editor.

Copy (Instance) Map Dialog

Material Editor > Drag one map button to another.

The Copy (Instance) Map dialog is displayed when you copy a map by dragging and dropping a map button. It gives you the choice of copying the map, making the newly assigned map an instance of the one you dragged, or swapping maps.

You can drag map buttons in the Maps rollout, in the Basic Parameters rollout, or from one rollout to the other.

TIP When you use the same map for multiple parameters, such as both self-illumination and opacity, it is usually easier to work with an instance rather than a copy.

Interface

![Copy (Instance) Map Dialog](image)
Instance Makes an instance of the map you dragged. The newly assigned map is not independent. Adjusting the parameters of one map or the other changes both of them.

Copy Copies the map you dragged. The newly assigned map is a copy whose parameters you can adjust independently.

Swap Swaps the maps. This option isn't displayed when you drag from one rollout to another.

Copy or Swap Colors Dialog

Material Editor > Basic Parameters rollout or Extended Parameters rollout or both > Drag one color swatch to another.

The Copy or Swap Colors dialog is displayed when you copy a color by dragging and dropping a color swatch. It gives you the choice of copying the color or swapping the colors, trading one for the other.

Interface

Swap Swaps the colors.

Copy Copies the color you dragged.

Create Material Preview Dialog

Material Editor > Make/Play/Save Preview flyout > Make Preview

The Create Material Preview dialog is displayed when you click Make Preview on page 5679 to preview an animated material. By default, the preview is saved in the \previews subdirectory with the name _medit.avi. You can use Save
Preview to give the preview a different name so it won't be overwritten the next time you use Make Preview.

**Interface**

![Create Material Preview window](image)

**Preview Range group**

- **Active Time Segment** Renders the *active time segment* on page 8496.
- **Custom Range** Renders a custom range from the start to the end frame you specify in the spinners below.
**Frame Rate group**

These controls specify the playback rate.

**Every Nth Frame** Renders a regular sampling of the animation. For example, a value of 8 includes only every eighth frame in the preview. Default=1 (every frame).

**Playback FPS** Specifies the playback rate in frames per second. Default=30 (full speed).

**Image Size group**

**Percent of Output** Specifies the resolution of the preview. This value is a percentage; 100 percent has a resolution of 101 x 99 pixels (the size of a sample slot in the 3 x 2 array). Default=100.

**Duplicate Name Dialog (Material Library)**

Material Editor > Get Material or Type button > Browse From group > Select Mtl Library. > File group > Open material library. > File group > Merge > Merge Material Library dialog > Open another material library or a 3ds Max scene. > Merge dialog > Select materials to merge > OK

File > XRef Objects > XRef Objects dialog > Create XRef Record from File > Choose a file. > Select objects to XRef. > Duplicate Name dialog

The Duplicate Name dialog is displayed if, after you click OK in the Merge dialog on page 5715, one or more materials to merge have the same name as materials in the open library.

If this dialog appears while you are using XRef Objects on page 7450, in the XRef Objects dialog you can see the updated material name in the “Scene Name” column, while the original name in the source scene appears in the “Source Name” column.
**Interface**

**Duplicate Name**

Object grid2 has the same name as an object in the scene.

- **Merge**
  - grid2

- **Skip**
  - □ Apply to All Duplicates:

- **Delete Old**

- **Auto-Rename**

**Material name** At the right, the dialog displays a duplicate material name. You can edit the name to make it unique before you merge it with the open (current) library by clicking the Merge button.

**Apply to All Duplicates** If you turn this on before you use the buttons, all subsequent incoming materials with duplicate names are treated the same way as the current one, and no further alert messages are displayed. Use this option when you know that you've got several duplicate materials, and don't need constant reminders. This check box is unavailable if you edit the material name.

- **Merge** Merges the material with the open, current library. This button is unavailable unless you edit the duplicate name to be a different, unique name.

- **Skip** Skips this material and doesn't merge it with the open, current library.

- **Delete Old** Deletes the "old" material in the open, current library and replaces it with the material to merge.

- **Auto-Rename** Click to have 3ds Max automatically rename the material by appending a sequence number to the duplicate material name.

- **Cancel** Cancels further merging of materials with duplicate names. If you have already merged some materials, they appear in the open, current library.
Merge Dialog (Material Library)

Material Editor > Get Material or Type button > Browse From group > Select Mtl Library. > File group > Open material library. > File group > Merge > Merge Material Library dialog > Open another material library or a 3ds Max scene.

The Merge dialog displays a list of materials to merge with the open library. The materials are from a different material library or from a 3ds Max or VIZ Render (DRF on page 7650) scene.

Procedures

To merge all materials:

- Click All.

To select a single material to merge:

- Click the material's name.

To select materials to merge one by one:

1. Click a material's name.
2. Hold down Ctrl, and click other material names.

To select a group of contiguous materials to merge:

1. Click a material's name.
2. Hold down Shift, and click another material's name.
   The dialog selects the two materials you clicked, and all materials whose names lie between the two.
Interface

Material list Shows the names of all materials in the library or scene.

All Selects all materials in the list.

None Deselects all materials in the list.

Merge Material Library Dialog

Material Editor > Get Material or Type button > Material/Map Browser > Browse From group > Select Mtl Library. > File group > Open material library. > File group > Merge
The Merge Material Library dialog lets you merge materials in the open material library with materials in another material library or another 3ds Max or VIZ Render (DRF on page 7650) scene.

**Interface**

This is a standard Windows file dialog. It lets you select either material library (MAT) files, 3ds Max (MAX), or VIZ Render (DRF on page 7650) scene files.

When you click OK, a further Merge dialog on page 5715 is displayed. This lets you select by name the materials you want to merge with the open library.

**Put to Library Dialog**

Material Editor > Put To Library

The Put To Library dialog is displayed when you want to save the material in an active sample slot on page 5650 into a material library file. It lets you change the material’s name before you save it.
Interface

Name Shows the name of the material to save. You can edit this name to save it under a different name.

Render Map Dialog

Material Editor > Right-click a sample slot. > Render Map > Render Map dialog

The Render Map dialog is displayed when you use Render Map on the Sample Slots Right-Click Menu on page 5654 to render the map displayed in a sample slot.
Interface

**Time Output group**

These controls specify how many frames to render.

- **Single** Renders a single frame.

- **Every Nth Frame** Renders a regular sampling of the animation. For example, a value of 8 includes only every eighth frame in the preview. Default=1 (every frame).

- **Active Time Segment** Renders the active time segment on page 8496.

- **Range** Renders a custom range from the start to the end frame you specify in the spinners below.
Dimensions group

These controls specify the size of the rendered frames, in pixels.

Width Specifies the frame width, in pixels.
Height Specifies the frame height, in pixels.

Output group

These controls let you save the rendered map to a file.

Files Click to display a file dialog that lets you specify where to save the rendered map.
When you click Save in the file dialog, you might see an additional dialog that gives you options specific to the file type you chose. These are the file formats available for a rendered map:
AVI on page 7832
BMP on page 7834
Kodak Cineon on page 7834
Encapsulated Postscript on page 7839
JPEG on page 7848
PNG on page 7862
MOV (QuickTime) on page 7849
SGI on page 7877
RLA on page 7873
RPF on page 7875
Targa on page 7878
TIFF on page 7880

Save to File When on, the rendered map is saved to a file. When off, the map is rendered only to a Rendered Frame Window on page 6513. This check box is unavailable unless you use Files to specify a file name, when it defaults to on.

File name field Displays the name of the file you chose.

Render Renders the map to a feature-reduced version of the Rendered Frame Window on page 6513, and to a file if you chose one.
Replace Map Dialog

Material Editor > Go to a map level or a standalone map. > Type button > Material/Map Browser > Choose a compound map.

The Replace Map dialog is displayed when you change a map type to any type of map that can have sub-maps. It gives you the choice of replacing the original ("old") map completely, or using the original map as a sub-map of the new map.

Interface

Discard old map Discards the old map.
Keep old map as sub-map Retains the old map as a sub-map.

Replace Material Dialog

Material Editor > Type button > Material/Map Browser > Choose a compound material.

The Replace Material dialog is displayed when you change a material type to one of the compound material types on page 6106. It gives you the choice of replacing the original ("old") material completely, or using the original material as a sub-material of the new material.
Interface

Discard old material  Discards the old material.

Keep old material as sub-material  Retains the old material as a sub-material.

Update Scene Materials Dialog

Material Editor > Get Material > Material/Map Browser > Update Scene Materials from Library > Update Scene Materials dialog

The Update Scene Materials dialog lets you use a library to update materials in the scene. It appears only when you click Update Scene Materials From Library in the Material/Map Browser on page 5724, and the scene contains materials that have the same name as materials in the library.

Procedures

To update a material in the scene and replace it with a material from the library:

- In the Update Scene Materials dialog, select the name of the material, and then click OK.

To leave a material in the scene unchanged, do one of the following:

1. In the Update Scene Materials dialog, make sure the name of the material is not selected, and then click OK.
2  Click Cancel.

**Interface**

**Material name list** Shows the materials that have the same name in the library and in the scene.

*All* Selects all material names in the list.

*None* Deselects all material names in the list.
Material/Map Browser

Material Editor > Get Material > Material/Map Browser

Rendering menu > Material/Map Browser

Material Editor > Click Material Type button or Map Type button. > Material/Map Browser

Procedures on page 5726 Interface on page 5728

The Material/Map Browser lets you choose a material on page 8635, map on page 8631, or mental ray shader on page 6385.

When you click Get Material on page 5687, the Browser that is displayed is modeless (you can leave it displayed while you do other work). However, when you display the Browser by clicking the Type on page 5706 button, a map assignment button in the Environment dialog on page 7163, or from a projector light (see Advanced Effects Rollout on page 5457), it appears as a modal dialog with OK and Cancel buttons.

You can leave the modeless Browser displayed, and drag materials from its listings to material or map sample slots and buttons in the user interface. When the Browser displays a material library, you can also add materials to the library by dragging them from the Material Editor sample slots on page 5650.

When you double-click a material, map, or shader in the Browser, it places that material, map, or shader in the Material Editor's active sample slot. It automatically chooses between an instance or a copy, as follows:

- Browsing New Materials: Creates a new material.
- Browsing a library: Makes a copy.
- Browsing the Material Editor, Scene, or Selected: Depends on the status of the map or material.

When you browse the Material Editor, the Scene, or Selected objects, the choice between making a copy or an instance depends on the status of the material, as follows:

- If the material or map is already in the active slot, the Browser does nothing.
If the material or map is in some other sample slot, the Browser puts a copy in the active slot.

In all other cases, the Browser makes an instance of the material or map.

**Browsing mental ray Materials and Maps**

When you use the mental ray renderer on page 6675, you might want to use the materials and shaders that provide effects for this renderer only. (The default scanline renderer renders these materials and shaders only as black or white, or it simply ignores their effects.) The Material/Map Browser lists mental ray maps and materials only if you assign the mental ray renderer as the currently active renderer.

Once you have enabled the renderer, when you use the Browser, it shows mental ray materials and shaders. Materials are displayed with a yellow sphere, rather than blue for standard materials, and shaders are displayed with a yellow parallelogram, rather than green as for standard maps.

- Bump (3dsmax)
- Cellular
- Checker
- Composite
- Dent
- DGS Material (3dsmax)
- Dielectric (base)
- Dielectric Material (3dsmax)
- Edge (lume)
- Facade (lume)
- Falloff
- Flat Mirror
- Glass (lume)
- Glow (lume)
- Gradient

Mental ray maps in the browser's list are shown with yellow icons.

When you use the mental ray Connection rollout on page 5763, or other shader buttons specific to mental ray materials and shaders, the shaders that appear in the Browser's list are restricted to those that the mental ray renderer allows for that particular shader component. By default, only shaders that ship with 3ds Max are listed. If you have acquired other shader libraries, you might see the names of shaders that are not mentioned in this reference.
NOTE You can see the listing of materials, maps, or shaders that are incompatible with the current renderer, if you turn on the Incompatible toggle in the Show group, as described under “Interface,” below.

See also:

■ Material/Map Navigator on page 5703

Procedures

To navigate materials with the Browser:

TIP Use the Browser primarily in Root Only mode, to see only the top levels of the materials. This provides a simpler view of your materials, and speeds redraws when you’re using any of the icon display modes. (You can also create thumbnails to speed up redraws, as described below.)

1 In the Material Editor, choose any sample slot you want that contains a complex, multilevel material.
2 In the Browser > Browse From group, choose Active Slot mode to display all levels of the active sample slot.
3 Click any of the items in the Browser’s material/map list to move to that level of the current material.
4 When you want to switch to a different material, select its sample slot in the Material Editor, and its hierarchy will appear in the Browser.
5 Again, click the items in the Browser to change levels.

To delete an assigned map:

1 While viewing the map parameters, click the Map Type button.
2 In the Material/Map Browser, choose NONE as the new map type.

TIP You can also remove a material or map by dragging the NONE item from the Browser over to the object or map button.

To merge material libraries:

1 In the Browse From group, choose Mtl Library, and then click the Merge button.
2 In the **Merge Material Library dialog** on page 5716, select a material library other than the current library, or select a 3ds Max or **VIZ Render** (DRF on page 7650) scene.

A **Merge dialog** on page 5715 is displayed, listing all materials in the specified library, or all materials assigned to the 3ds Max or **VIZ Render** file. Below the list are All and None buttons to help in the selection.

3 Select the materials in the list that you want to merge, and then click **OK**.

The selected materials are merged into the current material library.

4 Save the library to save your changes.

**To save the sample spheres as thumbnail images:**

1 Open the Browser. In the Browse From group, choose Mtl Library.

2 Choose View Small Icons.

3 Display all of the icons in the library by either scrolling through all of them, or by enlarging the Browser so that all of the icons have been displayed at least once.

The action of displaying the icons automatically creates thumbnails in memory.

**IMPORTANT** If you want to include thumbnails of the sub-materials and maps, be sure to turn off Root Only.

4 Save the library.

When you save the library, you save the thumbnail images of the samples as they appeared in the Browser at that time. If you change any of the materials or maps later, you must re-save the library in order to update the thumbnails. If you do not re-save the library after altering or adding a materials, the icon of the material will still appear correctly, but it will be rerendered when it first appears in the Browser, while all the other icons will appear immediately.
Interface

5728 | Chapter 17  Material Editor, Materials, and Maps
The Material/Map Browser contains the following controls:

**Material/Map list** The main part of the Material/Map Browser dialog is a scrollable list of materials and maps. The list indicates a material with a blue sphere, and indicates a map with a green parallelogram. When you list both materials and maps, the materials are listed first.

**NOTE** Icons of materials and maps for which Show Standard/Hardware Map in Viewport on page 5696 is on are red.

Also, the names of instanced on page 8611 materials and maps appear in boldface. Both of these effects are shown in the following illustration:

```
07 - Default ( Multi/Sub-Object )
  [1] : Material #25 ( Standard )
       Diffuse Color: Map #5 ( FLOWER3.TGA )
  [2] : Material #26 ( Standard )
       Diffuse Color: Map #6 ( JAGLEAF.TGA )
  [3] : Material #27 ( Standard )
       Diffuse Color: Map #6 ( JAGLEAF.TGA )
  [4] : Material #29 ( Standard )
  [5] : Material #29 ( Standard )
```

**Text entry** As you enter a material name in this field, the first matching text item is selected in the list. Press Enter to select the next matching name, and so on.

For example, if you enter ch when the list includes the material names Cherry Red, Chrome Blue, and Chrome Zinc, Cherry Red is selected first. Press Enter, and the Chrome Blue is selected. Press Enter again, and Chrome Zinc is selected. The search is not case-sensitive.

**Sample slot** Below the text-entry field is a single sample slot. This displays a sample of the current selection. You can drag the sample to any other sample slot or material button. The sample slot display is interruptible, so you can quickly click from one list item to the next without waiting. In addition, if you complete the display of one sample, then move on to another sample, when you return to the first sample, it displays instantly.

**Tool buttons**

The first part of this row of buttons controls how you view the list. The second part is for managing material libraries.
To speed up the display of the sample spheres in the Browser, the smaller of the sample spheres (those displayed when you choose View Small Icons or View List + Icons) can be saved as thumbnail images in the material library file. (See the Procedures for this topic, above.)

Keep in mind that the saved thumbnails increase the size of the material library file.

- **View List** Displays the materials and maps in list format. Blue spheres are materials. Green parallelograms are maps. The green parallelograms turn red if Show Map in Viewport is on for a material.

- **View List + Icons** Displays the materials and maps in a list with small icons.

- **View Small Icons** Displays the materials and maps as small icons. As you move the mouse over the icons, tooltip labels pop up, showing you the name of the material or map.

- **View Large Icons** Displays the materials and maps as large icons. The large icons are labeled with the name of the material or map and are displayed using progressive refinement—samples are rendered quickly, with large pixels, then rendered a second time in greater detail.

- **Update Scene Materials from Library** Updates materials in the scene with the materials of the same name stored in the library.

  When you click Update Scene Materials from Library, the Update Scene Materials dialog on page 5722 is displayed. This dialog lists materials in the library that have the same name as materials in the scene. In the list, select the materials you want to update in the scene, and then click OK.

  If no materials exist in the scene that match the names in the library, an alert informs you of this.

  This button is available only when the Browser is viewing a library.

- **Delete from Library** Removes the selected material or map from the library display. The library on disk is not affected until you save it. Use Open to reload the original library from disk. This button is only active when you select a named material that exists in the current library.
This button is available only when the Browser is viewing a library.

Clear Material Library Removes all materials from the library display. The library on disk is not affected until you save it. Use Open to reload the original library from disk. This button is available only when the Browser is viewing a library.

**Browse From group**

The controls in this group choose the source of the materials displayed in the material/map list.

**Material Library** Displays the contents of a material library file from disk. When you set this option, the buttons under File become active (see below). You can also load a library from a MAX file. When browsing from the Material Library in the Material/Map Browser, choose Open, and then choose 3ds Max (*.max) from Files of type. Select and load a .max file. All materials assigned in that scene are listed in the Browser. To convert the collection of materials to a library file, click Save, and save it as a MAT (*.mat) file.

**Material Editor** Displays the contents of the sample slots.

**Active Slot** Displays the contents of the currently active sample slot. This option is unavailable in the modal version of the Browser. When you choose this mode, all check boxes in the Show group box are made available. The entire material and map tree of the active material is displayed, regardless of the state of these check boxes in other Browse From modes. You can also use Active Slot mode to navigate the hierarchy of the active material. When Active Slot is chosen, clicking an item in the material/map list moves Material Editor controls to that level of the material.

**Selected** Displays the material applied to the selected objects.

**Scene** Displays all materials applied to objects in the scene. All maps assigned to the scene, including Environment Background or spotlight projector maps, are displayed in the Browser list.

**New** Displays the set of material/map types for you to create a new material.
Show group

These options filter what is displayed in the list. Either Materials or Maps is always on, and both can be on at the same time. The first two options can be unavailable, depending on the active Browse From and View settings.

**Materials** Turns display of materials and sub-materials on or off. This is always unavailable in the modal version of the Browser.

**Maps** Turns display of maps on or off. This is always unavailable in the modal version of the Browser.

**Incompatible** When on, displays materials or maps and shaders that are incompatible with the currently active renderer. The incompatible materials are displayed in gray. You can still assign incompatible materials, maps, or shaders to buttons where they would be legal, but if you use the current renderer, the results might not be correct. Default=off.

Root/Object group

**Root Only** When on, the material/map list displays only the root of the material hierarchy. When off, the list displays the full hierarchy. The default state of Root Only depends on how you display the Browser. Generally, when you display the modeless Browser, you’re selecting materials rather than maps (to begin with), so Root Only is on. However, when you display the modal Browser (by clicking a map button anywhere in the user interface), Root Only is off so you can see all the maps.

**By Object** This is available only when you’re browsing from either Scene or Selected. When on, the list displays materials by their object assignment in the scene. At the left are the names of the objects arranged alphabetically, with a yellow cube icons as in Track View on page 3790. Applied materials are shown as children of the objects. When off, the list displays only material names.
File group

![File group button group](image)

This button group (or a subset) appears when you've set **Browse From** on page 5731 to Material Library, Material Editor, Selected, or Scene. When browsing from the Material Library, all four buttons appear; otherwise, only the Save As button appears.

**Open** Opens a file dialog that you can use to find and load a material library.

**NOTE** When you first click Open, the file dialog uses the default location, which is the `materiallibraries` folder in the current **project folder** on page 7583. However, the material libraries included with 3ds Max are installed in the `materiallibraries` folder in the program install folder. For convenience, copy any material libraries you want to use from the install location to your project folder.

Also, because the supplied material libraries use image files that are located in the `Maps` folder in the program folder, be sure to add this folder and its subpaths to the user paths (see **External Path Configuration** on page 8289).

**Merge** Merges materials from another material library or scene. When you click Merge, the **Merge Material Library dialog** on page 5716 is displayed. This file dialog lets you choose a material library or a scene. When you choose a library or scene to merge, the **Merge dialog** on page 5715 is displayed. This lets you select which materials to merge. If there are duplicate names among the materials you're merging, the **Duplicate Name dialog** on page 5713 is displayed so you can resolve the name conflicts.

**Save** Saves the open material library.

**Save As** Saves the open material library under another name.
Display group

This group of radio buttons is displayed only when you've chosen New under Browse From. It controls what types of maps the Browser displays in the material/map list. (The Browser displays materials regardless of this setting.)

- **2D Maps** Lists only 2D map types.
- **3D Maps** Lists only 3D (procedural) map types.
- **Compositors** Lists only compositor map types.
- **Color Mods** Lists only color modifier map types.
- **Other** Lists reflection and refraction map types.
- **All** (The default.) Lists all map types.

**Material Explorer**

Rendering menu > Material Explorer

*Point-Of-View (POV) viewport label menu* on page 8122 > Extended > Material Explorer

The Material Explorer lets you browse and manage all the materials in a scene.

While the Material Editor lets you set the properties of individual materials, it is limited in the number of materials it can display at any one time. With the Material Explorer, you can browse all the materials in a scene, see the objects to which a material is applied, change material assignment, and manage materials in other ways.
The Material Explorer interface has two panels: the upper Scene panel and the lower Material panel. The Scene panel is similar to the Scene Explorer on page 7888. It lets you browse and manage all the materials in the scene. The
Material panel is more like the Material/Map Navigator on page 5703: it lets you browse and manage the components of a single material.

**Scene (Upper) Panel (Material Explorer)**

Rendering menu > Material Explorer > Scene (upper) panel

Point-Of-View (POV) viewport label menu on page 8122 > Extended > Material Explorer > Scene (upper) panel

The upper Scene panel of the Material Explorer lets you browse and manage all the materials in a scene.

Some of the things you can accomplish using the Scene panel of the Material Explorer are:

- Browsing the materials in the scene
- Finding which maps materials use
- Seeing which materials are applied to which objects
- Changing material assignment
- Changing map assignment
- Changing material, map, or object names

**Procedure**

To change a material assignment, do one of the following:

- Drag a material’s thumbnail or icon (to the left of its name) from the Material Explorer Scene panel onto an object in a viewport.

- Select multiple objects, and then drag a material's thumbnail or icon (to the left of its name) from the Material Explorer Scene panel onto one of the objects. 3ds Max asks whether you want to assign the material to the object or to the entire selection.

- Drag a material’s thumbnail or icon (to the left of its name) from the Material Explorer Scene panel onto the name of a geometry object in the Scene Explorer on page 7888.
To change a map assignment:

- Drag the map's thumbnail or icon (to the left of its name) from one entry in the Material Explorer to another map thumbnail or icon in the Material Explorer (either panel).
  3ds Max opens a Copy (Instance) Map dialog on page 5710 so you can choose whether to swap the two maps, or make the updated map either a copy or an instance of the original.

To edit a material:

- Drag the material’s thumbnail or icon (to the left of its name) to an unused sample slot in the Material Editor on page 5641.
  If the material is already in a sample slot, 3ds Max won’t let you drop it on the new sample slot.

To change a material type:

- Drag a material type from the Material Browser onto the name or thumbnail of a material in the Material Explorer.
Interface

The main window of the Material Explorer Scene panel shows several columns with information about the materials in the scene. At the left side of this window is a hierarchy of maps and objects; by default, the hierarchy shows thumbnails for the various materials. Other controls include a menu bar, toolbar, and to the left of the main window, various display buttons.

The main window lets you edit certain cells, to change material, map, or object names, or certain properties of a material or map. See Columns (Material Explorer Scene Panel) on page 5747 for details.

Viewing Objects and Maps

To see the objects assigned to a material, click the plus-sign (+) icon to expand that material’s hierarchy.
Hierarchy of a material applied to four objects

If you turn on Display > Display Sub-Materials/Maps, the hierarchy of a material also shows the maps used by that material. The maps appear above the objects that use the material.

Maps displayed as part of the material hierarchy

The hierarchy can grow more complex if a material is a Multi/Sub-Object material whose sub-materials might use maps, and so on.
Menu Bar (Material Explorer Scene Panel)

Rendering menu > Material Explorer > Scene upper) panel > Menu bar

Point-Of-View (POV) viewport label menu on page 8122 > Extended > Material Explorer > Scene (upper) panel > Menu bar

The Scene panel menu bar contains various options for managing materials and the display of the window in the upper Scene panel.

**Select Menu**

Some of these choices correspond to buttons on the Selection toolbar on page 5744.

- **Select All** Selects all entries in the scene.
- **Select All Materials** Selects all materials in the scene.
- **Select All Maps** Selects all maps in the scene.

**NOTE** For most scenes, the effect of this choice isn’t apparent unless you also turn on Display Sub-Materials/Maps.

- **Select None** Deselects all entries.
- **Select Invert** Inverts the current selection: all selected entries become deselected, and all entries not selected become selected.
- **Select Children** This choice is a toggle. When on, selecting a material or object also selects the children of that entry. Default=off.
These choices are toggles that affect the behavior of the Find field on the Find toolbar on page 5744.

**Find Case Sensitive** When on, the search string is case sensitive: “house” is not the same as “House”. Default=off.

**Find Using Wildcards** When on, the search string can use wildcard characters such as * and ?. Default=on.

**Find Using Regular Expressions** When on, the search string can use ; for example, “gr(ale)y”. Default=off.

**Display Menu**

These choices correspond to the Display buttons on page 5745.

**NOTE** The Display menu also appears as a pop-up menu when you right-click a cell in the upper window.

**Display Thumbnails** When on, the hierarchy displays a thumbnail for each material and map. When off, it displays a generic icon materials and maps. Default=on.

**Display Materials** When on, the hierarchy includes materials. When off, it does not show materials at all. Default=on.

**Display Maps** When on, the hierarchy of each material includes includes the maps used by that material. Default=on.

**NOTE** For most scenes, the effect of this isn’t apparent unless you also turn on Display Sub-Materials/Maps.

**Display Objects** When on, the hierarchy of each material includes the objects to which that material is applied. Default=on.

**Display Sub-Materials/Maps** When on, the hierarchy includes sub-materials and maps applied to material channels. Default=off.

**Display Unused Map Channels** When on, the hierarchy display includes unused map channels. Default=off.

These two sorting options are mutually exclusive. They correspond to a pair of Display buttons on page 5745.
Sort By Material (The default.) While active, the hierarchy is sorted by material name.

Sort By Object While active, the hierarchy is sorted by object.

These choices control the hierarchy display.

Expand All Expands the hierarchy to display all entries.

Expand Selected Expands the hierarchy of selected entries.

Expand Objects Expands the hierarchy of all objects.

Collapse All Collapses the entire hierarchy.

Collapse Selected Collapses the hierarchy of selected entries.

Collapse Materials Collapses the hierarchy of all materials.

Collapse Objects Collapses the hierarchy of all objects.

Tools Menu

Save Material As Material Library Opens a file dialog that lets you save the materials in the scene as a material library (.mat) file.

Select Object By Material Opens a Select Objects dialog on page 206. The names of objects with the active material applied are highlighted. Click to select the objects that have had this material applied. This choice is unavailable if no materials are selected in the Explorer, or if multiple materials are selected.

Bitmap/Photometric Paths Opens the Bitmap / Photometric Path Editor dialog on page 7630, which lets you manage the paths of bitmaps in the scene.

Proxies Setup Opens the Global Settings And Defaults For Bitmap Proxies dialog on page 7601, which lets you manage how 3ds Max creates and uses proxy versions of bitmaps incorporated in materials. This dialog is a feature of Asset Tracking on page 7585.

Delete Sub-Materials/Maps When one or more sub-materials or maps applied to a material are selected, deletes the selected sub-materials or maps.
Lock Cell Editing When on, prevents you from editing cells in the Explorer: clicking a cell has no effect, other than to highlight and select the row it is in. Default=off.

Customize Menu

Configure Columns Opens the Configure Columns dialog so you can add columns to the Scene (upper) window. See Columns (Material Explorer Scene Panel) on page 5747.

Toolbars Displays a submenu that lets you choose which of the Material Explorer toolbars appear.
- Find Toggles display of the Find toolbar.
- Selection Toggles display of the Selection toolbar.
- Tools Toggles display of the Tools toolbar.

Save Current Layout as Default Saves the current Material Explorer layout so that it appears this way in your next session with 3ds Max.

The layout file for the Material Explorer is called defaultmaterialexplorer.ini. It is saved in `C:\documents and settings\<user name>\local settings\application data\autodesk\3ds max\<version>\enu\plugcfg\explorerconfig\material explorer\`. You can revert to the default layout by deleting this file and restarting 3ds Max.

Toolbar (Material Explorer Scene Panel)

Rendering menu > Material Explorer > Scene (upper) panel > Toolbar

Point-Of-View (POV) viewport label menu on page 8122 > Extended > Material Explorer > Scene (upper) panel > Toolbar

The upper Scene panel of the Material Explorer has a toolbar with various search, selection, and other controls.

Interface

The toolbar actually consists of three smaller toolbars: Find, Selection, and Tools. You can toggle the display of these smaller toolbars by using the Toolbars options on the Customize menu on page 5743.
Find toolbar

Find Enter text in this field to search for that text in the Name column. As you type, the Material Explorer highlights materials or objects whose name matches the search string.

If Sync to Material Explorer on page 5745 is on, the Material (lower) panel also displays the first material that is found. If the Material Explorer finds an object rather than a material, the Material (lower) panel shows the material that is applied to that object.

Some options on the Select menu on page 5740 control how the Explorer performs the search.

Selection toolbar

Some of these buttons correspond to choices on the Select menu on page 5740.

Select All Materials Selects all materials in the scene.

Select All Maps Selects all maps in the scene.

NOTE For most scenes, the effect of this choice isn’t apparent unless you also turn on Display Sub-Materials/Maps.

Select All Selects all entries in the scene.

Select None Deselects all entries in the scene.

Select Invert Inverts the current selection: all selected entries become deselected, and all entries not selected become selected.
Tools toolbar

![Lock cell editing](image)

**Lock cell editing** When on, prevents you from editing cells in the Explorer: clicking a cell has no effect, other than to highlight and select the row it is in. Default=off.

![Sync to Material Explorer](image)

**Sync to Material Explorer** When on, synchronizes selections in the Material (lower) panel with the Scene (upper) panel. When off, changing the selection in the Scene panel doesn’t change the Material panel, which continues to show the last material you selected before turning off Sync To Material Explorer. Default=on.

![Sync to Material Level](image)

**Sync to Material Level** When on, the lower Material panel always shows the full hierarchy of the material highlighted in the upper Scene panel, even if only a component of the material is highlighted. When off, the lower Material panel shows only the hierarchy of the individual material component that is highlighted in the upper Scene panel. Default=on.

**Display Buttons (Material Explorer Scene Panel)**

Rendering menu > Material Explorer > Scene (upper) panel > Display buttons (left side of the panel)

*Point-Of-View (POV) viewport label menu* on page 8122 > Extended > Material Explorer > Scene (upper panel > Display buttons (left side of the panel)

The display buttons appear to the left of the main window of the upper Scene panel. They control display of the hierarchy in the window.

These buttons correspond to choices on the Display menu on page 5741.
Interface

Display Thumbnails  When on, the hierarchy displays thumbnails. Default=on.

Display Materials  When on, the hierarchy includes materials. Default=on.

Display Maps  When on, the hierarchy includes maps. Default=on.

NOTE  For most scenes, the effect of this isn’t apparent unless you also turn on Display Sub-Materials/Maps.

Display Objects  When on, the hierarchy includes objects. Default=on.

Display Sub-Materials/Maps  When on, the hierarchy includes sub-materials and maps applied to material channels. Default=off.

Display Unused Map Channels  When on, the hierarchy includes unused map channels. Default=off.

Sort By Object / Sort By Materials  These two options toggle each other.

Sort By Object  While this is active, the Name list is sorted by object.

Sort By Material  (The default.) While this is active, the Name list is sorted by material name.
Columns (Material Explorer Scene Panel)

Rendering menu > Material Explorer > Scene (upper) panel

Point-Of-View (POV) viewport label menu on page 8122 > Extended > Material Explorer > Scene (upper) panel

The main window of the Material Explorer upper Scene panel can contain several columns with information about materials in the scene. Some kinds of columns contain editable cells.

Right-Click Menu for Column Labels

When you right-click the label of a column in the Material Explorer Scene panel, 3ds Max opens a menu that has several options to control column display:

- **Sorting choices** Let you choose how the column is sorted. Also, you can cycle through these options by clicking the column label.

- **Configure Columns** Displays a dialog that lets you configure which columns appear in the window. See the procedure To add columns to the table on page 5748.

- **Best Fit options** Choose Best Fit to resize the column whose label you right-clicked, or choose Best Fit (All Columns) to resize all columns. Columns are resized to fit the width of their contents.

**TIP** Right-clicking a column label and choosing Best Fit (All Columns) is a good way to see the information in your current window layout.
Procedures

To add columns to the table:

1. Right-click a column label and then choose Configure Columns from the context menu.
   This opens the Configure Columns dialog.
TIP Another way to access Configure Columns is from the Customize menu.

2 Drag a column label from the Configure Columns dialog to one of the Material Explorer column labels. The new column is inserted to the left of the existing column.

3 Continue adding columns as desired. When finished, close the Configure Columns dialog.

To remove a column from the table:

1 Drag the column label downward until the mouse cursor changes to an X icon.

2 Release the mouse button.

NOTE Even if you remove the Name column, the hierarchy remains at the left side of the window.

To sort the list based on a column or columns:

1 Click a column label. This performs a single-level sort based on the column contents, in ascending order, as indicated by an up arrow on the right side of the label. For example, clicking the Name label sorts the table in ASCII order, starting with punctuation, then numbers, then letters.

NOTE Object hierarchies remain together when the list is sorted. Child objects at the same level are sorted only with respect to one another, not objects on other hierarchical levels.
To reverse the sort order, click the same column label again. Alternatively, right-click a column label and choose Sort Ascending or Sort Descending. You can sort any number of different columns this way to perform a multi-level sort.

To remove sorting:
- Right-click the column label and choose Clear Sort State.

To rearrange columns:
- Drag a column label on top of another one. This moves the column to the left of the target column.

To resize a column:
- Drag the divider on the right side of the column label.
  Alternatively, to auto-resize a column, double-click the divider on the right side of the label.

Interface

This section lists the available columns, briefly describes each column’s function, and notes whether the column appears by default in the Material Explorer.

Name Shows the names of materials, objects, maps, and sub-materials. You can edit cells in this column: click a cell, then click or drag on it again to highlight text, and type a new name for the material, object, or map. Default column.

NOTE Even if you hide the Name column, the hierarchy always appears on the left-hand side of the upper panel window.

Type Shows the type of material, map, or submaterial. For objects, cells in this column are blank. Default column.

Show In Viewport For materials and maps, shows whether Show Standard/Hardware Map in Viewport on page 5696 is active. If you are using standard (software) display and Show Map In Viewport is on, the cell says “Standard : Maps”; if Show Map In Viewport is off, the cell says “Standard : No Maps.” If you are using hardware shading (hardware display) and Show
Map In Viewport is on, the cell says “Hardware : Maps”; if Show Map In Viewport is off, the cell says “Hardware : No Maps.”
For objects, this cell says “None.”
You can edit cells in this column: click the cell to display a drop-down list that lets you toggle the Show Map In Viewport state.

**NOTE** With standard (software) shading, only one map at a time can be shown in the viewport, but with hardware shading, multiple maps can be shown.

Default column.

**Material ID** For materials, shows the Material ID on page 5694. You can edit cells in this column: click a cell, then drag across the value. While the value is highlighted, you can type a new Material ID value, or you can click the spinner arrows that appear in the cell to change the Material ID. (You can also drag on the spinner’s up-arrow or down-arrow button to change the value more rapidly.)
For objects and maps, the cells in this column are blank.
Default column.

**Texture Size** For bitmaps, shows the dimensions of the map; for example, “512*512”.
For materials, objects, and procedural maps (whether 2D or 3D), the cells in this column are blank.

---

**Material (Lower) Panel (Material Explorer)**

Rendering menu > Material Explorer > Material (lower) panel

Point-Of-View (POV) viewport label menu on page 8122 > Extended > Material Explorer > Material (lower) panel

The lower Material panel of the Material Explorer lets you browse and manage a single material.

Some of the things you can accomplish using the Material panel of the Material Explorer are:

- Browsing the maps assigned to a material
- Replacing a map in a material
- “Cleaning” materials by changing duplicate maps to instances, and by removing unused sub-materials
When you select a material in the upper Scene panel, it appears in the lower Material panel. When you select multiple materials in the upper Scene panel, in general the first material you select is the one that appears in the lower Material panel.

**Procedure**

To change a material assignment, do one of the following:

- Drag the material’s thumbnail or icon (to the left of its name) from the Material Explorer Material panel onto an object in a viewport.

- Select multiple objects, and then drag the material’s thumbnail or icon (to the left of its name) from the Material Explorer Material panel onto one of the objects. 3ds Max asks whether you want to assign the material to the object or to the entire selection.

- Drag the material’s thumbnail or icon (to the left of its name) from the Material Explorer Material panel onto the name of a geometry object in the Scene Explorer.

To change a map assignment:

- Drag the map’s thumbnail or icon (to the left of its name) from one entry in the Material Explorer to another map thumbnail or icon in the Material Explorer (either panel). 3ds Max opens a Copy (Instance) Map dialog so you can choose whether to swap the two maps, or make the updated map either a copy or an instance of the original.

To edit a material:

- Drag the material’s thumbnail or icon (to the left of its name) to an unused sample slot in the Material Editor. If the material is already in a sample slot, 3ds Max won’t let you drop it on the new sample slot.
Interface

The Material panel is similar to the Scene panel: there is a window with columns and a menu bar. The main difference is that the lower Material panel shows only one material at a time. (You can use Display buttons for this panel as well, but they aren’t visible by default.)

Like the upper Scene panel, the main portion of the lower Material panel is a window with columns that describe map and material properties. The Material Explorer lets you edit some of the properties in these columns. Columns in the Material panel differ from those in the Scene panel: see Columns (Material Explorer Material Panel) on page 5755.

Menu Bar (Material Explorer Material Panel)

Rendering menu > Material Explorer > Material (lower) panel > Menu bar
Point-Of-View (POV) viewport label menu on page 8122 > Extended > Material Explorer > Material (lower) panel > Menu bar

The lower Material panel menu bar contains various options for managing materials and the display of the lower panel window.

Select Menu

The choices here are the same as for the upper Scene panel Select menu on page 5740, except that the choices to control name searching aren’t present.
Display Menu

Most of the choices here are the same as for the upper Scene panel Display Menu on page 5741, except that the choices about object display aren't present.

**Sync to Material Level** Synchronizes selection of map and sub-material levels in the Scene (upper) and Material (lower) panels. When both this choice and Sync To Material Explorer are on, selecting a material, map, or sub-material in the upper Scene panel displays the entire material tree in the lower Material panel. When Sync To Material Explorer is on but Sync To Material Level is off, selecting a map or sub-material in the upper Scene panel displays only that map or sub-material in the lower Material panel. Default=on.

Tools Menu

**Render Map** Opens a Render Map dialog on page 5718 so you can render the selected map.
This choice is unavailable if you've selected a material instead of a map.

**Clean MultiMaterials** Opens the Clean MultiMaterial utility on page 6492 so you can remove unused sub-materials.

**Instance Duplicate Maps** Opens the Instance Duplicate Maps utility on page 6497, so you can improve scene and rendering performance by turning duplicate maps into instances.

**Change Material/Map Type** Opens the Material/Map Browser on page 5724 so you can change the material or map type.

**Delete Sub-Materials/Maps** When one or more sub-materials or maps applied to a material are selected, deletes the selected sub-materials or maps.

Customize Menu

**Toolbars** Opens a submenu with one choice, “Display,” that toggles display buttons to the left of the lower panel main window. These buttons mostly correspond to entries on the lower panel Display menu on page 5754.

**Thumbnail Size** Displays a submenu with two choices for thumbnail size in the lower window: Medium (the default), or Large.

---

**Sync to Material Explorer** When on, synchronizes selections in the lower Material panel with the upper Scene panel. When off, changing the selection in the Scene panel doesn't change the Material panel, which continues to
show the last material you selected before turning off Sync To Material Explorer. Default=on.

Columns (Material Explorer Material Panel)

Rendering menu > Material Explorer > Material (lower) panel

Point-Of-View (POV) viewport label menu on page 8122 > Extended > Material Explorer > Material (lower) panel

The main window of the Material Explorer lower Material panel can contain several columns with information about the currently selected material. Some kinds of columns contain editable cells.

Right-Click Menu for Column Labels

When you right-click the label of a column in the Material Explorer lower panel, 3ds Max opens a menu that has several options to control column display:

- **Sorting choices**  Let you choose how the column is sorted.
  Also, you can cycle through these options by clicking the column label.

- **Configure Columns** Displays a dialog that lets you configure which columns appear in the window. See the procedure To add columns to the table on page 5755.

- **Best Fit options** Choose Best Fit to resize the column whose label you right-clicked, or choose Best Fit (All Columns) to resize all columns. Columns are resized to fit the width of their contents.

**TIP** Right-clicking a column label and choosing Best Fit (All Columns) is a good way to see the information in your current window layout.

Procedures

To add columns to the table:

1. Right-click a column label and then choose Configure Columns from the context menu.
   This opens the Configure Columns dialog.
2 Drag a column label from the Chooser dialog to one of the Material Explorer column labels.
The new column is inserted to the left of the existing column.

3 Continue adding columns as desired. When finished, close the Configure Columns dialog.

To remove a column from the table:

1 Drag the column label downward until the mouse cursor changes to an X icon.
2 Release the mouse button.

**NOTE** Even if you remove the Name column, the hierarchy remains at the left side of the window.

To sort the list based on a column or columns:

1 Click a column label.
   This performs a single-level sort based on the column contents, in ascending order, as indicated by an up arrow on the right side of the label. For example, clicking the Name column label sorts the table in ASCII order, starting with punctuation, then numbers, then letters.

**NOTE** Object hierarchies remain together when the list is sorted. Child objects at the same level are sorted only with respect to one another, not objects on other hierarchical levels.

2 To reverse the sort order, click the same column label again.
Alternatively, right-click a column label and choose Sort Ascending or Sort Descending. You can sort any number of different columns this way to perform a multi-level sort.

**To remove sorting:**

- Right-click the column label and choose Clear Sort State.

**To rearrange columns:**

- Drag a column label on top of another one. This moves the column to the left of the target column.

**To resize a column:**

- Drag the divider on the right side of the column label.
- Alternatively, to auto-resize a column, double-click the divider on the right side of the label.

---

**Interface**

**Name** Shows the names of materials, maps, and sub-materials. You can edit cells in this column: click a cell, then click or drag on it again to highlight text, and type a new name for the material or map.

**NOTE** Even if you hide the Name column, the hierarchy always appears on the left-hand side of the lower panel window.

Default column.

**Property** For maps, shows the name of the material channel to which the map has been assigned. For example, “Diffuse Color (Reflectance).” For materials, cells in this column are blank.

Default column.

**Texture Size** For bitmaps, shows the dimensions of the map; for example, “512*512”. For materials and procedural maps (whether 2D or 3D), the cells in this column are blank.

Default column.

**UV Coordinates** For 2D maps, cells in this column correspond to the Mapping List on the Coordinates rollout for 2D maps on page 6201. You can edit these
cells: click the cell to display a drop-down list that lets you choose among mapping types.
For materials and 3D procedural maps, the cells in this column show “None.”

**Mapping Channel** For 2D and 3D maps, cells in this column show the Map Channel value on page 8627. You can edit cells in this column: click a cell, then drag across the value. While the value is highlighted, you can type a new Map Channel value, or you can click the spinner arrows that appear in the cell to change the Map Channel value. (You can also drag on the spinner’s up-arrow or down-arrow button to change the value more rapidly.)
For 3D procedural maps, the Mapping Channel value doesn’t appear unless the Coordinates > Source value is set to Explicit Mapping Channel. See *Coordinates Rollout (3D)* on page 6278.
For materials, the cells in this column are blank.

**Types of Materials**

Rendering menu > Material Editor > Type button > Material/Map Browser > In Show group, turn off Maps. > Material types are listed.
Materials create greater realism in a scene. A material describes how an object reflects or transmits light. You assign materials to individual objects or selection sets; a single scene can contain many different materials. Different materials have different uses.

**Procedures**

**To get a material:**

1. Click Get Material on the Material Editor toolbar.
   The Material/Map Browser on page 5724 is displayed.
2. Double-click a material type (not a map type) in the list, or drag the material to a sample slot.
   The Material Editor replaces the original material.

**To change a material type:**

1. At the level of a material, click the Type button below the Material Editor toolbar.
A modal Material/Map Browser on page 5724 is displayed. If you were at a material when you clicked Type, the Browser lists only materials (if you were at a map, it lists only maps).

2 Choose a material from the list, and then click OK.
If you choose a compound material, a Replace Material on page 5721 dialog is displayed. This dialog lets you choose whether to keep or discard the original material.
The Material Editor now displays controls for the new material.

**SuperSampling Rollout**

Material Editor > Architectural material > SuperSampling rollout
Material Editor > Raytrace material > SuperSampling rollout
Material Editor > Standard material > SuperSampling rollout
The SuperSampling rollout is used by the Architectural, Raytrace, and Standard materials. It lets you choose a supersampling method on page 8735.
Supersampling performs an additional antialiasing on page 8501 pass on the material. This requires more time but can improve image quality.
Supersampling is especially helpful when you need to render very smooth specular highlights, subtle bump mapping, or high resolutions.

In 3ds Max the default is to apply a single supersampling method to all materials in the scene. This feature gives you more control over your scenes, especially larger models that make use of many materials, by letting you control the supersampling at a global level from the Rendering dialog. You can override this locally by turning off Use Global Settings. It also gives you file compatibility and workflow replication with DRF files imported from VIZ Render.

**NOTE** SuperSampling settings are ignored by the mental ray Renderer on page 6675, which has its own sampling method.

Use supersampling when you notice artifacts in your final renderings. For example, a thin bump map might produce scintillating, jagged bumps that supersampling can correct. Supersampling requires considerably more time to render, although it does not necessarily require any additional RAM.
NOTE  Supersampling is not processed when you turn off Antialiasing in the production renderer on page 6568. You can also globally disable supersampling for all materials using the parameters for the default scanline renderer on page 6589. Globally disabling supersampling can speed up test renderings.

Supersampling uses smaller sampling points, and returns averaged values to increase the antialiasing effect.

Supersampling and Antialiasing

Supersampling is one of several antialiasing techniques. Textures, shadows, highlights, and raytraced reflections and refractions all have their own preliminary antialiasing strategies. Supersampling is an additional step that provides a “best guess” color for each rendered pixel. The supersampler's output is then passed on to the renderer, which performs a final antialiasing pass.

A single rendered pixel represents an area of the scene's geometry. The pixel can stand in for multiple colors, especially when it appears at the edge of an object or a region of color. This is where aliasing effects occur.

When supersampling is turned off, 3ds Max simply looks at the center of the geometry covered by the pixel, and uses that for the pixel color.
When you turn on supersampling, a supersampler performs an additional antialiasing pass on the material. You can choose one of four supersamplers. As the name implies, a supersampler takes additional samples of geometry color in or near each pixel, in order to obtain a more accurate pixel color that is less prone to aliasing error.

These are the supersampling methods:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adaptive Halton</td>
<td>Spaces samples along both X and Y axes according to a scattered, “quasi random” pattern. Depending on Quality, the number of samples can range from 4 to 40. This method is adaptive, as described below.</td>
</tr>
<tr>
<td>Adaptive Uniform</td>
<td>Spaces samples regularly, from a minimum quality of 4 samples to a maximum of 36. The pattern is not square, but skewed slightly to improve accuracy in the vertical and horizontal axes. This method is adaptive, as described below.</td>
</tr>
<tr>
<td>Hammersley</td>
<td>Spaces samples regularly along the X axis, but along the Y axis it spaces them according to a scattered, “quasi random” pattern. Depending on Quality, the number of samples can range from 4 to 40. This method is not adaptive.</td>
</tr>
<tr>
<td>MAX 2.5 Star</td>
<td>The sample at the center of the pixel is averaged with four samples surrounding it. The pattern is like the fives on dice. This is the supersampling method that was available in 3ds Max 2.5.</td>
</tr>
</tbody>
</table>
Regular sampling, as performed by the Adaptive Uniform and MAX 2.5 Star methods, is more prone to aliasing than the irregular patterns performed by the Adaptive Halton and Hammersley methods.

You can set a variable Quality value for the Adaptive Halton, Adaptive Uniform, and Hammersley methods. Quality can range from 0.0 to 1.0. A quality of 0.0 is minimal, with about four samples per pixel. A quality of 1.0 is the highest possible, with between 36 and 40 samples per pixel. High-quality supersampling is very time consuming.

Another setting for the Adaptive Halton and Adaptive Uniform supersamplers is the Adaptive toggle, which works in conjunction with the Threshold spinner. When Adaptive is on, these methods take fewer samples unless a change in color is greater than the Threshold value. In that case, they take the full number of samples specified by the Quality. To reduce the amount of time the supersampler spends, leave the Adaptive check box on.

**Interface**

- **Use Global Settings** When on, the material uses the supersampling options set in the Default Scanline Renderer rollout on page 6589. Default=on.

- **Enable Local Supersampling** When on, applies supersampling to the material. Default=off

- **Sampler drop-down list** Lets you choose which supersampling method to apply. The list is not active unless Use Global Settings is turned off. Default=Max 2.5 Star.

- **Supersample Maps** When on, the maps applied to the material are supersampled as well. When off, the supersampler uses pixel averages for maps. This switch is active only when Use Global Settings is turned off. Default=on.

- **Quality** Adjusts the quality of supersampling by controlling the number of samples used for each pixel. At the minimum value, 0.0, four samples are...
taken per pixel. At the maximum value, 1.0, about 40 samples are taken per
pixel (the value varies depending on which shader is active). Range=0.0 to
1.0. Default=0.5.

This spinner is unavailable for the Max 2.5 Star method.

Adaptive Visible only for the Adaptive Halton and Adaptive Uniform methods. When on, these methods take fewer samples than the Quality specifies unless samples show a change in color greater than the Threshold value. In that case, they take all the samples specified by the Quality. Turning on Adaptive On can reduce the amount of time required to supersample. Default=on.

Threshold Controls the Adaptive methods. Visible only for the Adaptive Halton and Adaptive Uniform methods. A change in color greater than the Threshold value causes the adaptive methods to take the full number of samples specified by the Quality. If the color does not change as much, the adaptive method takes fewer samples and does not require as much processing time. Can range from 0.0 to 1.0. Setting Threshold to 0.0 has the same effect as turning off Adaptive On. Default=0.1.

mental ray Connection Rollout

Material Editor > Click a sample slot that contains a material other than a Multi/Sub-Object or a mental ray material. > mental ray Connection rollout

The mental ray Connection rollout is available for all types of materials except the Multi/Sub-Object material and the mental ray materials themselves (for which it would be redundant). With this rollout you can add mental ray shading to conventional 3ds Max materials. These effects are visible only when you use the mental ray renderer on page 6675.

IMPORTANT The mental ray Connection rollout does not appear unless you have enabled the mental ray extensions by using the mental ray Preferences panel on page 8363. In addition, you can’t assign shaders to the options in this rollout unless the mental ray renderer is the currently active renderer.
Interface

For each kind of shader on this rollout, there is a toggle and a button.

- The toggle controls whether the assigned shader is active or not. If no shader is assigned, the toggle has no effect.

- The button lets you assign a shader to the component type. Clicking it displays the Material/Map Browser on page 5724: assigning a shader is just like assigning a map to a component of a standard material. While a shader is assigned, its name appears on the button.

- In addition to the toggle and button, some of the shader types have a lock button to the right. When button is on, the component is inherited...
from the base material, and you can't assign a shader. For example, by
default the Surface component is locked, and the surface is shaded using
the settings of the 3ds Max material (basic parameters, maps, and so on).
Turn off this button to replace the base material's settings with a mental
ray shader.

NOTE Using a shader for the Surface component can result in a material whose
appearance in mental ray renderings is completely different from the
appearance it has in the sample slot, viewports, and scanline renderings.

**Basic Shaders group**

**Surface** Shades the surface of objects that have this material. Default=locked
to parent material.

In addition to any of the usual 3ds Max materials, the surface component can
be assigned the following mental ray materials or shaders:

<table>
<thead>
<tr>
<th>Shader</th>
<th>Library</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bump</strong> on page 6397</td>
<td>3ds Max</td>
</tr>
<tr>
<td><strong>DGS Material</strong> on page 6398</td>
<td>3ds Max</td>
</tr>
<tr>
<td><strong>Dielectric</strong></td>
<td>base</td>
</tr>
<tr>
<td><strong>Dielectric Material</strong> on page 6403</td>
<td>3ds Max</td>
</tr>
<tr>
<td><strong>Edge</strong></td>
<td>lume</td>
</tr>
<tr>
<td><strong>Facade</strong></td>
<td>lume</td>
</tr>
<tr>
<td><strong>Glass</strong></td>
<td>lume</td>
</tr>
<tr>
<td><strong>Glow</strong></td>
<td>lume</td>
</tr>
<tr>
<td><strong>Landscape</strong></td>
<td>lume</td>
</tr>
<tr>
<td>Shader</td>
<td>Library</td>
</tr>
<tr>
<td>------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Material to Shader</td>
<td>3ds Max</td>
</tr>
<tr>
<td>page 6412</td>
<td></td>
</tr>
<tr>
<td>Metal</td>
<td>lume</td>
</tr>
<tr>
<td>Ocean</td>
<td>lume</td>
</tr>
<tr>
<td>Opacity</td>
<td>base</td>
</tr>
<tr>
<td>Reflect</td>
<td>base</td>
</tr>
<tr>
<td>Refract</td>
<td>base</td>
</tr>
<tr>
<td>Shader List</td>
<td>3ds Max</td>
</tr>
<tr>
<td>page 6420</td>
<td></td>
</tr>
<tr>
<td>Stain</td>
<td>lume</td>
</tr>
<tr>
<td>Translucency</td>
<td>lume</td>
</tr>
<tr>
<td>Transmat</td>
<td>physics</td>
</tr>
<tr>
<td>Transparency</td>
<td>base</td>
</tr>
<tr>
<td>Two Sided</td>
<td>base</td>
</tr>
<tr>
<td>UV Generator</td>
<td>3ds Max</td>
</tr>
<tr>
<td>page 6422</td>
<td></td>
</tr>
<tr>
<td>Water Surface</td>
<td>lume</td>
</tr>
<tr>
<td>Wet-Dry Mixer</td>
<td>lume</td>
</tr>
<tr>
<td>XYZ Generator</td>
<td>3ds Max</td>
</tr>
<tr>
<td>page 6430</td>
<td></td>
</tr>
</tbody>
</table>
NOTE Unlike a standard 3ds Max material, if you assign the Surface component a bitmap with tiling turned off, the original surface color does not “show through.” In renderings, you see only the untiled map, and none of the rest of the object.

**Shadow** Assigns a shadow shader. Default=locked to parent material.
The shadow component can be assigned the following shaders:

<table>
<thead>
<tr>
<th>Shader</th>
<th>Library</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edge Shadow</td>
<td>lume</td>
</tr>
<tr>
<td>Facade</td>
<td>lume</td>
</tr>
<tr>
<td>Glass</td>
<td>lume</td>
</tr>
<tr>
<td>Glow</td>
<td>lume</td>
</tr>
</tbody>
</table>

**Material to Shader** on page 6412 3ds Max

<table>
<thead>
<tr>
<th>Shader</th>
<th>Library</th>
</tr>
</thead>
<tbody>
<tr>
<td>Metal</td>
<td>lume</td>
</tr>
</tbody>
</table>

**Shader List** on page 6420 3ds Max

<table>
<thead>
<tr>
<th>Shader</th>
<th>Library</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shadow Transparency</td>
<td>base</td>
</tr>
<tr>
<td>Translucency</td>
<td>lume</td>
</tr>
<tr>
<td>Transmat</td>
<td>physics</td>
</tr>
<tr>
<td>Water Surface Shadow</td>
<td>lume</td>
</tr>
</tbody>
</table>

**Caustics and GI group**

**Photon** Assigns a photon shader. Photon shaders affect how object surfaces respond to photons; that is, they control how the surfaces behave when generating caustics and global illumination. Default=locked to parent material.
The photon component can be assigned the following shaders:

<table>
<thead>
<tr>
<th>Shader</th>
<th>Library</th>
</tr>
</thead>
<tbody>
<tr>
<td>DGS Material on page 6398</td>
<td>3ds Max</td>
</tr>
<tr>
<td>Dielectric Material Photon on page 6403</td>
<td>3ds Max</td>
</tr>
<tr>
<td><strong>Edge</strong></td>
<td>lume</td>
</tr>
<tr>
<td><strong>Glow</strong></td>
<td>lume</td>
</tr>
<tr>
<td><strong>Material to Shader on page 6412</strong></td>
<td>3ds Max</td>
</tr>
<tr>
<td><strong>Metal</strong></td>
<td>lume</td>
</tr>
<tr>
<td><strong>Photon Basic</strong></td>
<td>base</td>
</tr>
<tr>
<td><strong>Translucency</strong></td>
<td>lume</td>
</tr>
<tr>
<td><strong>Transmat</strong></td>
<td>physics</td>
</tr>
</tbody>
</table>

**Photon Volume** Assigns a photon volume shader. Photon volume shaders affect how an object’s volume responds to photons; that is, they control how the volume behaves when generating caustics and global illumination. The photon volume component can be assigned the following shaders:

<table>
<thead>
<tr>
<th>Shader</th>
<th>Library</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Material to Shader on page 6412</strong></td>
<td>3ds Max</td>
</tr>
<tr>
<td><strong>Parti Volume Photon</strong></td>
<td>physics</td>
</tr>
<tr>
<td><strong>Shader List on page 6420</strong></td>
<td>3ds Max</td>
</tr>
</tbody>
</table>
**Extended Shaders group**

**Displacement** Assigns a displacement shader on page 6713. Default=locked to parent material.

The displacement component can be assigned the following shaders:

<table>
<thead>
<tr>
<th>Shader</th>
<th>Library</th>
</tr>
</thead>
<tbody>
<tr>
<td>3D Displacement</td>
<td>3ds Max</td>
</tr>
<tr>
<td>Material to Shader</td>
<td>3ds Max</td>
</tr>
<tr>
<td>Ocean</td>
<td>lume</td>
</tr>
</tbody>
</table>

**Volume** Assigns a volume shader on page 6710.

The volume component can be assigned the following shaders:

<table>
<thead>
<tr>
<th>Shader</th>
<th>Library</th>
</tr>
</thead>
<tbody>
<tr>
<td>Beam</td>
<td>lume</td>
</tr>
<tr>
<td>Material to Shader</td>
<td>3ds Max</td>
</tr>
<tr>
<td>Mist</td>
<td>lume</td>
</tr>
<tr>
<td>Parti Volume Photon</td>
<td>physics</td>
</tr>
<tr>
<td>Shader List</td>
<td>3ds Max</td>
</tr>
<tr>
<td>Submerge</td>
<td>lume</td>
</tr>
</tbody>
</table>

**Environment** Assigns an environment shader. The environment shader provides an environment local to the material. It is visible if the material is reflective or transparent.

The environment component can be assigned the following shaders:

<table>
<thead>
<tr>
<th>Shader</th>
<th>Library</th>
</tr>
</thead>
<tbody>
<tr>
<td>Environment</td>
<td>3ds Max</td>
</tr>
</tbody>
</table>
**Advanced Shaders group**

**Contour** Assigns a contour shader on page 6714. The contour component can be assigned the following shaders:

<table>
<thead>
<tr>
<th>Shader</th>
<th>Library</th>
</tr>
</thead>
<tbody>
<tr>
<td>Combi</td>
<td>contour</td>
</tr>
<tr>
<td>Curvature</td>
<td>contour</td>
</tr>
<tr>
<td>Depth Fade</td>
<td>contour</td>
</tr>
<tr>
<td>Factor Color</td>
<td>contour</td>
</tr>
<tr>
<td>Layer Thinner</td>
<td>contour</td>
</tr>
<tr>
<td>Simple</td>
<td>contour</td>
</tr>
<tr>
<td>Width From Color</td>
<td>contour</td>
</tr>
<tr>
<td>Width From Light</td>
<td>contour</td>
</tr>
<tr>
<td>Width From Light Dir</td>
<td>contour</td>
</tr>
</tbody>
</table>

**Light Map** Assigns a light map shader.

**WARNING** No light map shaders are provided with 3ds Max. This option is for users who have access to light map shaders via other shader libraries or custom shader code.
Optimization group

Flag Material as Opaque When on, indicates that the material is fully opaque. This tells the mental ray renderer that it doesn't need to process transparency for this material, or to use the shadow shader. This can improve rendering time. Default=off.

DirectX Manager Rollout

Material Editor > DirectX Manager rollout

Lets you select a DirectX viewport shader for viewing Direct3D hardware shaders. DirectX shaders require the Direct3D graphics driver on page 8325, which uses DirectX. With DirectX shading, materials in a viewport more accurately represent how the material will appear in another application, or on other hardware such as a game engine.

DirectX viewport shaders are especially useful for previewing texture-baked materials on page 6843.

TIP
To display a material using a DirectX shader, rather than 3ds Max software, choose Show Hardware Map In Viewport from the Show Standard/Hardware Map In Viewport flyout, then click this button to turn it on.

Hardware viewport rendering requires a DirectX9.0c-compliant video card. Also, hardware viewport rendering is supported only by the Direct3D display driver on page 8325. See Show Standard/Hardware Map in Viewport on page 5696 for more information.

3ds Max provides two DirectX shaders:

- **LightMap shader** on page 6179
- **Metal Bump shader** on page 6180

NOTE This rollout does not appear for Multi/Sub-Object and Shell materials, which are simply containers of other materials.

See also:

- **DirectX Shader Material** on page 6175
Interface

Save as .FX File  Click to display a Save Effect File dialog that lets you save the active material as an FX file on page 8589.

Enable Plugin Material  Turn on to use the chosen DirectX shader in shaded viewports. Default=off.
When not enabled, viewports continue to use the default viewport (interactive) renderer on page 8757 (or the ActiveShade renderer on page 6550, if that has been chosen).
This toggle is unavailable if no shader plug-in has been chosen from the drop-down list, and when DX Display Of Standard Material is on.
Plug-in drop-down list  Use the drop-down list to choose a DirectX viewport shader.
The list is unavailable when DX Display Of Standard Material is on.

mental ray Materials

3ds Max comes with several materials created specifically for use with the mental ray renderer on page 6675. These materials are visible in the Material/Map Browser on page 5724 when mental ray is the active renderer.

NOTE  When you wire the parameters of an object with a mental ray material assigned, the names of material parameters might differ from those in the Material Editor interface. Also, parameters not supported by 3ds Max might appear as blanks in the wiring menu.

ProMaterials

ProMaterials™ are mental ray materials that model materials commonly used in construction, design, and the environment. They correspond to Autodesk
Revit materials, so they provide a way to share surface and material information if you also use that application.

ProMaterials are based on the Arch & Design material on page 5858. Like that material, they work best when used with physically accurate (photometric) lights, and geometry that is modeled in real-world units. On the other hand, the interface of each ProMaterial is much simpler than the Arch & Design material interface, and lets you achieve realistic, physically correct results with comparatively little effort.

**NOTE** The ProMaterials library is a set of mental ray material libraries based on manufacturing-supplied data and professional images. This includes building and design materials such as professional wall paint with glossy or matte finishes, solid glass, and concrete. These materials provide a convenient way of creating realistic textures. There is actually one library (MAT) file that corresponds to each ProMaterial: when you use the Material/Map Browser to browse library files, you see library names such as `autodesk.max.promaterials.ceramic.mat`, `autodesk.max.profmaterials.concrete.mat`, and so on.

### Ceramic ProMaterial (mental ray)

Material Editor > Type button > Material/Map Browser > Choose ProMaterials: Ceramic, and then click OK.

Note: The Ceramic material appears in the Browser only if mental ray is the active renderer.

This material has the appearance of glazed ceramic, including porcelain.
Ceramic ProMaterial applied to the statue
Interface

Parameters rollout

Type The type of ceramic material (Ceramic or Porcelain). Default=Ceramic.
Left: Ceramic (the default)
Right: Porcelain

Color (Reflectance) The color of the rendered appearance of the material.
Changing the ceramic color

- **Map button** Click to assign a map to this component.

**TIP** To specify a grout color, use an image file that shows both the tile color and the grout color.

**Surface Finish** The texture of the finished surface (High Gloss, Satin, or Matte). Default=High Gloss.
Left: High Gloss (the default)
Middle: Satin
Right: Matte

**Surface Bumps** Bump pattern to use on the finished surface (for example, to represent the surface roughness). Can be None, Wavy, or Custom. Default=None.
To define bumps using an image, select Custom and then assign a map.
- **Custom Map** Click to assign a bump map.
- **Amount** Adjusts the amount of mapping. Default=0.05.

**Tiling Pattern** An additional bump pattern, superimposed on the Finish Bumps pattern (for example, to define grout lines). To define bumps using an image, select Surface Bumps > Custom.
- **Custom Map** Click to assign a tiling pattern map.
- **Height** Adjusts the height of the tiling. Default=0.25.
Special Effects rollout

See Ambient Occlusion Controls on page 5850 and Round Corners on page 5855.

Performance Tuning Parameters rollout

See Performance-Tuning Controls on page 5857.

Maps rollout

Ceramic Material Parameters > Color (Reflectance) Lets you assign a map to the Color component. The toggle at the left controls whether the map is active; when you assign a map, it turns on by default.
Special Effects > Fillet Radius See Round Corners on page 5855.

The button to the right of each main shader button is for shaders that can return multiple parameters. If a shader that returns multiple parameters is assigned to the component, the button’s tooltip shows the parameter name. Clicking the button displays a Connect Parameter To Shader dialog on page 6392, which lets you change which parameter is being used.

IMPORTANT UV Coordinates on page 6430 and XYZ Coordinates on page 6434 are the only shaders with multiple return values provided with 3ds Max. You might encounter multiple return values in shaders provided with other shader libraries or custom shader code.

Concrete ProMaterial (mental ray)

Material Editor > Type button > Material/Map Browser > Choose ProMaterials: Concrete, and then click OK.

Note: The Concrete material appears in the Browser only if mental ray is the active renderer.

This material has the appearance of concrete.
Concrete ProMaterial applied to the statue

Interface

Parameters rollout

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color (Reflectance)</td>
<td></td>
</tr>
<tr>
<td>Surface Finish</td>
<td>Straight Br</td>
</tr>
<tr>
<td>Amount</td>
<td>0.3</td>
</tr>
<tr>
<td>Sealant</td>
<td>None</td>
</tr>
<tr>
<td>Brightness Variations</td>
<td>None</td>
</tr>
<tr>
<td>Custom Map</td>
<td>None</td>
</tr>
</tbody>
</table>
Color (Reflectance) The color of the rendered appearance of the material.

- **Map button** Click to assign a map to this component.

**Surface Finish** Texture of the finished surface: Straight Broom, Curved Broom, Smooth, Polished, or Custom. Default = Straight Broom.

Left: Straight Broom (the default)

Right: Curved Broom

(A Curved Broom finish is also used on the walls of the house.)
Left: Smooth
Right: Polished

To define the finish using an image, choose Surface Finish > Custom, and then assign a texture map.

- **Custom Map** Click to assign a bump map.
- **Amount** Adjusts the amount of bump mapping. Default=0.3.

**Sealant** The substance used to seal the surface: None, Epoxy, or Acrylic. Default=None.
Left: Epoxy
Right: Acrylic

**Brightness Variations** Simulates discoloration due to weather: None, Automatic, or Custom. Default=None.

To define a weathering pattern using an image, choose Brightness Variations > Custom, and then assign a map.

- **Custom Map** Click to assign a brightness map.
Special Effects rollout

See Ambient Occlusion Controls on page 5850 and Round Corners on page 5855.

(Texture) Coordinates for Built-In Textures rollout

Specifies how to map the Surface Finish texture.

UV Channel Specifies the map channel ID to use. Default=1.

Tiling Scales the built-in texture to the geometry. The default value of 1.0 is a one-to-one mapping. Larger values tile the texture. Default=1.0.

Performance Tuning Parameters rollout

See Performance-Tuning Controls on page 5857.
Maps rollout

Concrete Material Parameters > Color (Reflectance) Lets you assign a map to the Color component. The toggle at the left controls whether the map is active; when you assign a map, it turns on by default.

Special Effects > Fillet Radius See Round Corners on page 5855.

The button to the right of each main shader button is for shaders that can return multiple parameters. If a shader that returns multiple parameters is assigned to the component, the button’s tooltip shows the parameter name. Clicking the button displays a Connect Parameter To Shader dialog on page 6392, which lets you change which parameter is being used.

IMPORTANT UV Coordinates on page 6430 and XYZ Coordinates on page 6434 are the only shaders with multiple return values provided with 3ds Max. You might encounter multiple return values in shaders provided with other shader libraries or custom shader code.

Generic ProMaterial (mental ray)

Material Editor > Type button > Material/Map Browser > Choose ProMaterials: Generic, and then click OK.

Note: The Generic material appears in the Browser only if mental ray is the active renderer.

This material is a generic interface for creating a custom appearance.
Generic ProMaterial applied to the statue, using a bitmap for color

Interface

Parameters rollout

<table>
<thead>
<tr>
<th>Simple Generic Material Parameters</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Diffuse Color (Reflectance)</td>
<td></td>
</tr>
<tr>
<td>Reflectivity Perpendicular to Surface</td>
<td>0.2</td>
</tr>
<tr>
<td>Reflectivity Parallel to Surface</td>
<td>1.0</td>
</tr>
<tr>
<td>Surface Glossiness</td>
<td>1.0</td>
</tr>
<tr>
<td>Surf. Imperfections</td>
<td>None</td>
</tr>
<tr>
<td>Surf. Imperfections (Bump) Amount</td>
<td>0.3</td>
</tr>
</tbody>
</table>
Diffuse Color (Reflectance) The color of the rendered appearance of the material.
- **Map button** Click to assign a map to this component.

Reflectivity Perpendicular to Surface Measurement of how much the material reflects when the surface is directly facing the camera. Enter a value between 0 (no reflections) and 1 (maximum reflections). Default=0.2.
- **Map button** Click to assign a map to this component.

Reflectivity Parallel to Surface Measurement of how much the material reflects when the surface is at an angle to the camera. Enter a value between 0 (no reflections) and 1 (maximum reflections). Default=1.0.
- **Map button** Click to assign a map to this component.

Surface Glossiness Measurement of the glossy quality of the surface, which affects the size and intensity of highlights. Enter a value between 0 (dull) and 1.0 (a perfect mirror). Default=1.0.
- **Map button** Click to assign a map to this component.

Surface Imperfections Click to assign a bump map to the surface.

Surface Imperfections (Bump) Amount Adjusts the amount of bump mapping. Default=0.3.

**Transparency rollout**

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transparency</td>
<td>0.0</td>
</tr>
<tr>
<td>Translucency</td>
<td>0.0</td>
</tr>
<tr>
<td>Index of Refraction</td>
<td>1.52</td>
</tr>
<tr>
<td>Cutout Opacity</td>
<td>1.0</td>
</tr>
<tr>
<td>Backface Cull</td>
<td></td>
</tr>
</tbody>
</table>

**Transparency** Measurement of how much light passes through the material. Enter a value between 0 (completely opaque) and 1 (completely transparent).
When Transparency is 0, Translucency and Index Of Refraction are ignored. Default=0.0.

- **Map button** Click to assign a map to this component.

**Translucency** Measurement of how much light is scattered by the material, so that objects behind the material cannot be seen clearly. Enter a value between 0 (not translucent) and 1 (completely translucent). Default=0.0.

- **Map button** Click to assign a map to this component.

**Index of Refraction** Measurement of how much a ray of light bends when entering the material. Enter a value between 0 (no refraction) and 5 (the most refraction). Default=1.52 (a typical value for transparent glass).

**Cutout Opacity** Specifies shapes cut into the surface of the material. Click the map button to specify cut-outs using an image. The value is the amount of transparency of the cutouts. Range: 0.0 to 1.0. Default=1.0 (completely transparent).

- **Map button** Click to assign a map to this component.

**Backface Cull** When on, faces whose normal points away from the camera are ignored when creating cutouts. Default=off.

- **Map button** Click to assign a map to this component.

**Self Illumination rollout**

![Self Illumination rollout](image)

**Luminance (cd/m^2)** Light emitted by the surface, measured in candelas per square meter. Default=0.0.

**Color Temperature (Kelvin)** The color of the self-illumination, described in terms of degrees Kelvin (K). This is useful for describing color values that are close to white. Default=6500.0 (close to overcast daylight).
**Filter Color** The color transmitted through the material if it is transparent or translucent.

- **Map button** Click to assign a map to this component.

**Ambient Occlusion rollout**

![Ambient Occlusion rollout](image)

See [Ambient Occlusion Controls](#) on page 5850.

**Round Corners rollout**

![Round Corners rollout](image)

See [Round Corners](#) on page 5855.

**Performance Tuning Parameters rollout**

![Performance Tuning Parameters rollout](image)

See [Performance-Tuning Controls](#) on page 5857.
Maps rollout

Simple Generic Material Parameters group

Diffuse Color (Reflectance) Lets you assign a map to the Color component. The toggle at the left controls whether the map is active; when you assign a map, it turns on by default.

Reflectivity Perpendicular Lets you assign a map to the Reflectivity Perpendicular To Surface component.

Reflectivity Parallel Lets you assign a map to the Reflectivity Parallel To Surface component.

Surface Glossiness Lets you assign a map to the Surface Glossiness component.

Transparency group

Transparency Lets you assign a map to the Transparency component.

Translucency Lets you assign a map to the Translucency component.
Cutout Opacity  Lets you assign a map to the Cutout Opacity component.

Backface Cull  Lets you assign a map to the Backface Cull component.

Self Illumination group

Filter Color  Lets you assign a map to the Filter Color component.

Round Corners group

Fillet Radius  See Round Corners on page 5855.

IMPORTANT  UV Coordinates on page 6430 and XYZ Coordinates on page 6434 are the only shaders with multiple return values provided with 3ds Max. You might encounter multiple return values in shaders provided with other shader libraries or custom shader code.

Glazing ProMaterial (mental ray)

Material Editor > Type button > Material/Map Browser > Choose ProMaterials: Glazing, and then click OK.

Note: The Glazing material appears in the Browser only if mental ray is the active renderer.

This material is for thin, transparent surfaces such as glazing in windows and doors.
In a daylight scene, glazing in the doors admits light into the room.
In a twilight scene, the glazing generates reflections.

**Interface**

**Parameters rollout**

<table>
<thead>
<tr>
<th>Glazing Material Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color (Transmittance)</td>
</tr>
<tr>
<td>Custom Color</td>
</tr>
<tr>
<td>Refraction Levels (N. Poly to Traverse)</td>
</tr>
<tr>
<td>Reflectance</td>
</tr>
</tbody>
</table>

**Color (Transmittance)** The color of the glass. Can be Clear, Green, Gray, Blue, Blue-Green, or Custom Color. Default=Clear.
**Custom Color** When you set Color (Transmittance) to Custom Color, you can use this color swatch to assign a color other than one of the predefined choices.

- **Map button** Click to assign a map to this component.

**Refraction Levels (N. Poly to Traverse)** The number of layers in the glazing. Range: 1 to 6. Default=2.

**Reflectance** The normalized percentage of light striking the glass that bounces off again (like a reflection) rather than being absorbed or passing through (transmittance). Enter a value between 0.001 and 1.0 (100 per cent). Default=0.1.

**Performance Tuning Parameters rollout**

See [Performance-Tuning Controls](page 5857).

**Maps rollout**

- **Glazing Material Parameters > Custom Color** When you set Color (Transmittance) to Custom Color, you can assign a map to the color component. The toggle at the left controls whether the map is active; when you assign a map, it turns on by default.

The button to the right of each main shader button is for shaders that can return multiple parameters. If a shader that returns multiple parameters is assigned to the component, the button's tooltip shows the parameter name. Clicking the button displays a [Connect Parameter To Shader dialog](page 6392), which lets you change which parameter is being used.
IMPORTANT UV Coordinates on page 6430 and XYZ Coordinates on page 6434 are the only shaders with multiple return values provided with 3ds Max. You might encounter multiple return values in shaders provided with other shader libraries or custom shader code.

Hardwood ProMaterial (mental ray)

Material Editor > Type button > Material/Map Browser > Choose ProMaterials: Hardwood, and then click OK.

Note: The Hardwood material appears in the Browser only if mental ray is the active renderer.

The Hardwood material has the appearance of wood.

NOTE In Revit, this material is simply called “Wood.”

Hardwood ProMaterial applied to the statue, using an oak burl bitmap
Hardwood ProMaterial applied to the statue, using a driftwood bitmap and no finish

Interface

Parameters rollout

<table>
<thead>
<tr>
<th>Hardwood Material Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base Hardwood</td>
</tr>
<tr>
<td>Stain Application</td>
</tr>
<tr>
<td>→ Color</td>
</tr>
<tr>
<td>Surface Finish</td>
</tr>
<tr>
<td>Application Type</td>
</tr>
<tr>
<td>Surface Imperfections</td>
</tr>
<tr>
<td>→ Custom Map</td>
</tr>
<tr>
<td>→ Amount</td>
</tr>
</tbody>
</table>
**Base Hardwood**  Click to select an image used to represent the surface of the wood.

**Stain Application**  Specifies whether the wood is stained: can be either None or Enabled. Default=None.

- **Color**  Shows the color of the stain used when Stain Application = Enabled. Click the color swatch to change the stain color.

![Left: No stain](image1)
![Middle: Default stain color](image2)
![Right: Changing the stain color](image3)

**Surface Finish**  Texture of the finished surface. Can be Glossy, Semi-Glossy, Satin, or Unfinished. Default=Glossy.
Left: Glossy (the default)
Right: Semi-Glossy
Left: Satin
Right: Unfinished

**Application Type** The purpose of the wood (what it is used for): either Flooring or Furniture. Flooring applies a slight warping to the surface. Default=Flooring.
Furniture application type used for the boards of the porch

The surface is completely smooth.
Flooring application type used for the boards of the porch

The warping effect is subtle, but you can see it in the reflections of the wall and the columns. You can also see some extra shadows toward the rear of the porch, near the railing of the terrace.

**Surface Imperfections** Bump pattern to use on the finished surface. Can be None, Automatic, or Custom. Default=None.

- **Custom Map** When Surface Imperfections = Custom, click to choose the bump map.

- **Amount** The amount of bump mapping. Default=0.2.
Special Effects rollout

![Special Effects rollout](image)

See Ambient Occlusion Controls on page 5850 and Round Corners on page 5855.

Performance Tuning Parameters rollout

![Performance Tuning Parameters rollout](image)

See Performance-Tuning Controls on page 5857.

Maps rollout

![Maps rollout](image)

Special Effects > Fillet Radius See Round Corners on page 5855.

The button to the right of each main shader button is for shaders that can return multiple parameters. If a shader that returns multiple parameters is assigned to the component, the button's tooltip shows the parameter name.
Clicking the button displays a Connect Parameter To Shader dialog on page 6392, which lets you change which parameter is being used.

**IMPORTANT** UV Coordinates on page 6430 and XYZ Coordinates on page 6434 are the only shaders with multiple return values provided with 3ds Max. You might encounter multiple return values in shaders provided with other shader libraries or custom shader code.

### Masonry/CMU ProMaterial (mental ray)

Material Editor > Type button > Material/Map Browser > Choose ProMaterials: Masonry/CMU, and then click OK.

Note: The Masonry/CMU material appears in the Browser only if mental ray is the active renderer.

This material has the appearance of concrete masonry units (CMUs) or masonry.

![Masonry/CMU ProMaterial applied to the statue](image_url)
Interface

Parameters rollout

![Masonry/CMU Material Parameters](image)

**Type** The type of masonry material: CMU or Masonry. Default=CMU.

Left: CMU (the default)
Right: Masonry
**Color (Reflectance)** The color of the rendered appearance of the material.

- **Map button** Click to assign a map to this component.

**Surface Finish** Texture of the finished surface. Can be Glossy, Matte, or Unfinished. Default=Glossy.

Left: Glossy (the default)
Middle: Matte
Right: Unfinished

**Pattern** Bump pattern to use on the finished surface. Can be None or Custom. Default=None.

- **Custom Map** When Pattern = Custom, click to choose the bump map.
- **Height** The amount of bump mapping. Default=0.25.
Special Effects rollout

See Ambient Occlusion Controls on page 5850 and Round Corners on page 5855.

Performance Tuning Parameters rollout

See Performance-Tuning Controls on page 5857.

Maps rollout

Masonry/CMU Material Parameters > Color (Reflectance) Lets you assign a map to the Color component. The toggle at the left controls whether the map is active; when you assign a map, it turns on by default.
Special Effects > Fillet Radius See Round Corners on page 5855.

The button to the right of each main shader button is for shaders that can return multiple parameters. If a shader that returns multiple parameters is assigned to the component, the button’s tooltip shows the parameter name. Clicking the button displays a Connect Parameter To Shader dialog on page 6392, which lets you change which parameter is being used.

**IMPORTANT** UV Coordinates on page 6430 and XYZ Coordinates on page 6434 are the only shaders with multiple return values provided with 3ds Max. You might encounter multiple return values in shaders provided with other shader libraries or custom shader code.

**Metal ProMaterial (mental ray)**

Material Editor > Type button > Material/Map Browser > Choose ProMaterials: Metal, and then click OK.

Note: The Metal material appears in the Browser only if mental ray is the active renderer.

This material has the appearance of metal.
Bronze Metal ProMaterial applied to the statue
**Interface**

**Parameters rollout**

![Metal Material Parameters](image)

**Type** The type of metal: Aluminum, Anodized Aluminum, Chrome, Copper, Brass, Bronze, Stainless Steel, or Zinc. Default=Aluminum.
Left: Aluminum (the default)
Right: Anodized Aluminum
Left: Chrome
Right: Copper
Left: Brass
Right: Bronze
Left: Stainless Steel
Right: Zinc

**Color (Reflectance)** The color of the metal when Type equals Anodized Aluminum.

**Patina** For Copper or Bronze, the degree of discoloration due to oxidation or the application of a chemical compound. Enter a value between 0.0 (none) and 1.0 (full). Default=0.0.

**NOTE** The Patina renders correctly only on curved surfaces.
Patina on bronze
Left: None
Right: Patina=0.5
Patina on bronze
Left: Patina=0.75
Right: Patina=1.0 (the maximum)

Surface Finish Texture of the finished surface. Can be Polished, Semi-Polished, Satin, or Brushed. Default=Polished.
Surface Finish on stainless steel
Left: Polished surface (the default)
Right: Semi-Polished
Surface Finish on stainless steel

Left: Satin
Right: Brushed

**Relief Pattern** Decorative design pressed onto the surface of the metal (in effect, a bump map). Choose a pattern, or choose Custom to define the relief pattern using an image. Can be None, Knurl, Diamond Plate, Checker Plate, or Custom. Default=None.

- **Pattern Height** Height of the relief pattern. Enter 0.0 to make the surface flat. Enter a value up to 2.0 to increase the depth of the relief pattern. Default=0.3.

- **Custom Map** When Relief Pattern = Custom, click to choose the bump map.

**Cutouts/Perforations** Shapes cut into the surface of the metal. Can be None, Round Holes, Square Holes, or Custom. Choose a shape, or choose Custom to define cut-outs using an image. Default=None.
Round-hole cutouts in copper

Left: Texture Coordinates > Tiling = 1.0 (the default)

Middle: Texture Coordinates > Tiling = 3.0

Right: Texture Coordinates > Tiling = 10.0

■ Custom Map When Cutouts/Perforations = Custom, click to choose the map that specifies holes in the metal.

Special Effects rollout

See Ambient Occlusion Controls on page 5850 and Round Corners on page 5855.
Performance Tuning Parameters rollout

![Performance Tuning Parameters rollout](image)

See Performance-Tuning Controls on page 5857.

(Texture) Coordinates for Built-In Textures rollout

![(Texture) Coordinates for Built-In Textures rollout](image)

Specifies how to map the Surface Finish, Relief Pattern, and Cutout textures.

UV Channel Specifies the map channel ID to use. Default=1.

Tiling Scales the built-in textures to the geometry. The default value of 1.0 is a one-to-one mapping. Larger values tile the textures. Default=1.0.

Maps rollout

![Maps rollout](image)

Round Corners > Fillet Radius See Round Corners on page 5855.

The button to the right of each main shader button is for shaders that can return multiple parameters. If a shader that returns multiple parameters is assigned to the component, the button’s tooltip shows the parameter name. Clicking the button displays a Connect Parameter To Shader dialog on page 6392, which lets you change which parameter is being used.
IMPORTANT UV Coordinates on page 6430 and XYZ Coordinates on page 6434 are the only shaders with multiple return values provided with 3ds Max. You might encounter multiple return values in shaders provided with other shader libraries or custom shader code.

**Metallic Paint ProMaterial (mental ray)**

Material Editor > Type button > Material/Map Browser > Choose ProMaterials: Metallic Paint, and then click OK.

Note: The Metallic Paint material appears in the Browser only if mental ray is the active renderer.

This material has the appearance of metallic paint, as on an automobile.

![Metallic Paint ProMaterial applied to the statue](image)

mental ray Materials | 5821
Interface

Parameters rollout

Color (Reflectance) Color of the metallic paint.

Map button Click to assign a map to this component.

Surface Finish Texture of the finished surface. Can be Glazed, Glossy, or Satin. Default=Glazed.

Flakes When set to Enable, adds flakes or flecks to the paint. Default=None.

Flakes Color Color of the flakes, when Flakes equals Enabled.

Special Effects rollout

See Ambient Occlusion Controls on page 5850 and Round Corners on page 5855.
Performance Tuning Parameters rollout

![Performance Tuning Parameters rollout](image)

See Performance-Tuning Controls on page 5857.

Maps rollout

![Maps rollout](image)

**Metallic Paint Material Parameters > Color (Reflectance)** Lets you assign a map to the Color component. The toggle at the left controls whether the map is active; when you assign a map, it turns on by default.

**Round Corners > Fillet Radius** See Round Corners on page 5855.

The button to the right of each main shader button is for shaders that can return multiple parameters. If a shader that returns multiple parameters is assigned to the component, the button's tooltip shows the parameter name. Clicking the button displays a Connect Parameter To Shader dialog on page 6392, which lets you change which parameter is being used.

**IMPORTANT** UV Coordinates on page 6430 and XYZ Coordinates on page 6434 are the only shaders with multiple return values provided with 3ds Max. You might encounter multiple return values in shaders provided with other shader libraries or custom shader code.
Mirror ProMaterial (mental ray)

Material Editor > Type button > Material/Map Browser > Choose ProMaterials: Mirror, and then click OK.

Note: The Mirror material appears in the Browser only if mental ray is the active renderer.

This material acts as a mirror.

![Mirror ProMaterial applied to a flat surface behind the statue](image)

**Interface**

**Parameters rollout**

<table>
<thead>
<tr>
<th>Mirror Material Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tint Color (Reflectance)</td>
</tr>
</tbody>
</table>

Tint Color (Reflectance) Color of the mirror surface.
Special Effects rollout

![Special Effects rollout](image)

See Round Corners on page 5855.

Performance Tuning Parameters rollout

![Performance Tuning Parameters rollout](image)

See Performance-Tuning Controls on page 5857.

Maps rollout

![Maps rollout](image)

Special Effects > Fillet Radius See Round Corners on page 5855.

The button to the right of each main shader button is for shaders that can return multiple parameters. If a shader that returns multiple parameters is assigned to the component, the button's tooltip shows the parameter name. Clicking the button displays a Connect Parameter To Shader dialog on page 6392, which lets you change which parameter is being used.

**IMPORTANT** UV Coordinates on page 6430 and XYZ Coordinates on page 6434 are the only shaders with multiple return values provided with 3ds Max. You might encounter multiple return values in shaders provided with other shader libraries or custom shader code.
Plastic/Vinyl ProMaterial (mental ray)

Material Editor > Type button > Material/Map Browser > Choose ProMaterials: Plastic/Vinyl, and then click OK.

Note: The Plastic/Vinyl material appears in the Browser only if mental ray is the active renderer.

This material has a synthetic appearance, as of plastic or vinyl.
Interface

Parameters rollout

Color (Reflectance) The color of the rendered appearance of the material.

Map button Click to assign a map to this component.

Type The type of material. Can be Plastic (Solid), Plastic (Transparent), or Vinyl. Default=Plastic (Solid).
Left: Plastic (Solid) (the default)
Middle: Vinyl
Right: Plastic (Transparent)

Surface Finish: Texture of the finished surface. Can be Polished, Glossy, or Matte. Default=Polished.

Surface Bumps: Bump pattern to use on the finished surface. Can be None or Custom. Default=None.
- Custom Map: When Surface Bumps = Custom, click to choose the bump map.

Amount: The amount of bump mapping. Default=0.05.

Pattern: An additional bump pattern, superimposed on the Finish Bumps pattern. Can be None or Custom. Default=None.
- Custom Map: When Pattern = Custom, click to choose the bump map.
- Height: The amount of bump mapping. Default=0.05.
Special Effects rollout

See Ambient Occlusion Controls on page 5850 and Round Corners on page 5855.

Performance Tuning Parameters rollout

See Performance-Tuning Controls on page 5857.

Maps rollout
Plastic/Vinyl Material Parameters > Color (Reflectance) Lets you assign a map to the Color component. The toggle at the left controls whether the map is active; when you assign a map, it turns on by default.

Special Effects > Fillet Radius See Round Corners on page 5855.

The button to the right of each main shader button is for shaders that can return multiple parameters. If a shader that returns multiple parameters is assigned to the component, the button's tooltip shows the parameter name. Clicking the button displays a Connect Parameter To Shader dialog on page 6392, which lets you change which parameter is being used.

IMPORTANT UV Coordinates on page 6430 and XYZ Coordinates on page 6434 are the only shaders with multiple return values provided with 3ds Max. You might encounter multiple return values in shaders provided with other shader libraries or custom shader code.

Solid Glass ProMaterial (mental ray)

Material Editor > Type button > Material/Map Browser > Choose ProMaterials: Solid Glass, and then click OK.

Note: The Solid Glass material appears in the Browser only if mental ray is the active renderer.

This material has the appearance of solid glass.
Solid Glass ProMaterial applied to the statue
Interface

Parameters rollout

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color (Transmittance)</td>
<td>Clear</td>
</tr>
<tr>
<td>Custom Map</td>
<td></td>
</tr>
<tr>
<td>Reflectance</td>
<td>0.05</td>
</tr>
<tr>
<td>Index of Refraction</td>
<td>1.52</td>
</tr>
<tr>
<td>Reference Thickness</td>
<td>6.0</td>
</tr>
<tr>
<td>Surface Roughness</td>
<td>0.0</td>
</tr>
<tr>
<td>Surface Imperfections</td>
<td>None</td>
</tr>
<tr>
<td>Custom Map</td>
<td>None</td>
</tr>
<tr>
<td>Amount</td>
<td>0.3</td>
</tr>
</tbody>
</table>

**Color (Transmittance)** The color of the glass. Can be Clear, Green, Gray, Blue, Blue-Green, Bronze, or Custom Color. Default=Clear.

Left: Clear (the default)
Middle: Green
Right: Gray
Left: Blue  
Middle: Blue-Green  
Right: Bronze

- **Custom Map** When Color (Transmittance) equals Custom Color, you can either click the color swatch to assign the glass material a custom color, or click the map button to assign a map to this component.

**Reflectance** Sets the reflectivity of the glass. Default=0.05.

**Index of Refraction** Sets the Index Of Refraction (IOR). Default=1.52 (a typical value for glass).

**Reference Thickness** Sets the apparent thickness of the glass: this value is independent of the geometry to which the material is applied. Default=6.0.

**Surface Roughness** Sets the roughness of the glass surface. Default=0.0.

**Surface Imperfections** Sets a surface pattern for the glass. Can be None, Rippled, Wavy, or Custom. Default=None.

- **Custom Map** When Surface Imperfections = Custom, click to choose the bump map.

- **Amount** The amount of bump mapping. Default=0.3.
**Special Effects rollout**

![Special Effects rollout](image)

See [Round Corners](#) on page 5855.

**Performance Tuning Parameters rollout**

![Performance Tuning Parameters rollout](image)

See [Performance-Tuning Controls](#) on page 5857.

**Maps rollout**

![Maps rollout](image)

**Solid Glass Material Parameters > Custom Map** Lets you assign a map to the Color (Transmittance) component. The toggle at the left controls whether the map is active; when you assign a map, it turns on by default.

**Special Effects > Fillet Radius** See [Round Corners](#) on page 5855.
The button to the right of each main shader button is for shaders that can return multiple parameters. If a shader that returns multiple parameters is assigned to the component, the button's tooltip shows the parameter name. Clicking the button displays a Connect Parameter To Shader dialog on page 6392, which lets you change which parameter is being used.

**IMPORTANT** UV Coordinates on page 6430 and XYZ Coordinates on page 6434 are the only shaders with multiple return values provided with 3ds Max. You might encounter multiple return values in shaders provided with other shader libraries or custom shader code.

**Stone ProMaterial (mental ray)**

Material Editor > Type button > Material/Map Browser > Choose ProMaterials: Stone, and then click OK.

Note: The Stone material appears in the Browser only if mental ray is the active renderer.

This material has the appearance of stone.
Stone ProMaterial applied to the statue, using a red granite texture map
Stone ProMaterial applied to the statue, using a travertine texture map

Interface

Parameters rollout

<table>
<thead>
<tr>
<th>Stone Material Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color (Reflectance)</td>
</tr>
<tr>
<td>Surface Finish</td>
</tr>
<tr>
<td>Surface Bumps</td>
</tr>
<tr>
<td>→ Custom Map</td>
</tr>
<tr>
<td>→ Amount</td>
</tr>
<tr>
<td>Pattern</td>
</tr>
<tr>
<td>→ Custom Map</td>
</tr>
<tr>
<td>→ Height</td>
</tr>
</tbody>
</table>
**Color (Reflectance)** The color of the material.

- **Map button** Click to assign a map to this component.

**Surface Finish** Texture of the finished surface. Can be Polished, Glossy, Matte, or Unfinished. Default=Polished.

Left: Polished (the default)

Right: Glossy
Left: Matte
Right: Unfinished

Surface Bumps Bump pattern to use on the finished surface. Can be None, Polished Granite, Stone Wall, Glossy Marble, or Custom. Default=None.
Left: None

Right: Polished Granite
Left: Stone Wall
Right: Glossy Marble

- **Custom Map** When Surface Bumps = Custom, click to choose the bump map.
- **Amount** The amount of bump mapping. Default=0.5.

**Pattern** An additional bump pattern, superimposed on the Surface Bumps pattern. Can be None or Custom. Default=None.
- **Custom Map** When Pattern = Custom, click to choose the bump map.
- **Height** The amount of bump mapping. Default=0.25.
Special Effects rollout

See Ambient Occlusion Controls on page 5850 and Round Corners on page 5855.

Performance Tuning Parameters rollout

See Performance-Tuning Controls on page 5857.

(Texture) Coordinates for Built-In Textures rollout

Specifies how to map the Surface Finish, Surface Bumps, and Pattern textures.

UV Channel Specifies the map channel ID to use. Default=1.

Tiling Scales the built-in textures to the geometry. The default value of 1.0 is a one-to-one mapping. Larger values tile the textures. Default=1.0.
Maps rollout

Stone Material Parameters > Color (Reflectance) Lets you assign a map to the Color component. The toggle at the left controls whether the map is active; when you assign a map, it turns on by default.

Special Effects > Fillet Radius See Round Corners on page 5855.

The button to the right of each main shader button is for shaders that can return multiple parameters. If a shader that returns multiple parameters is assigned to the component, the button's tooltip shows the parameter name. Clicking the button displays a Connect Parameter To Shader dialog on page 6392, which lets you change which parameter is being used.

IMPORTANT UV Coordinates on page 6430 and XYZ Coordinates on page 6434 are the only shaders with multiple return values provided with 3ds Max. You might encounter multiple return values in shaders provided with other shader libraries or custom shader code.

Wall Paint ProMaterial (mental ray)

Material Editor > Type button > Material/Map Browser > Choose ProMaterials: Wall Paint, and then click OK.

Note: The Wall Paint material appears in the Browser only if mental ray is the active renderer.

This material has the appearance of a painted surface.

NOTE In Revit, this material is simply called "Paint."
Wall Paint ProMaterial applied to the house, using the default color

**Interface**

**Parameters rollout**

<table>
<thead>
<tr>
<th>WallPaint Material Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color (Reflectance)</td>
</tr>
<tr>
<td>Surface Finish</td>
</tr>
<tr>
<td>Application Method</td>
</tr>
</tbody>
</table>

**Color (Reflectance)** Color of the paint.
Changing the color of the paint

**Surface Finish** Texture of the paint. Can be Gloss, Semi-Gloss, Pearl, Platinum, Eggshell, or Flat. Default=Flat.

Left: Gloss
Right: Semi-Gloss
Application Method

The method used to apply the paint to the surface. Can be Roller, Brush, or Spray. Default=Roller.
Special Effects rollout

![Special Effects Rollout]

See Ambient Occlusion Controls on page 5850 and Round Corners on page 5855.

Performance Tuning Parameters rollout

![Performance Tuning Parameters Rollout]

See Performance-Tuning Controls on page 5857.

Maps rollout

![Maps Rollout]

Special Effects > Fillet Radius See Round Corners on page 5855.

The button to the right of each main shader button is for shaders that can return multiple parameters. If a shader that returns multiple parameters is assigned to the component, the button's tooltip shows the parameter name.
Clicking the button displays a Connect Parameter To Shader dialog on page 6392, which lets you change which parameter is being used.

**IMPORTANT** UV Coordinates on page 6430 and XYZ Coordinates on page 6434 are the only shaders with multiple return values provided with 3ds Max. You might encounter multiple return values in shaders provided with other shader libraries or custom shader code.

---

**Water ProMaterial (mental ray)**

Material Editor > Type button > Material/Map Browser > Choose ProMaterials: Water, and then click OK.

Note: The Water material appears in the Browser only if mental ray is the active renderer.

This material has the appearance of water.

Two uses of water:

In the foreground, the water is set to Swimming Pool and its color to Tropical.
In the background, the water is set to Sea/Ocean (both type and color).
Interface

Parameters rollout

![Water Material Parameters](image)

**Type** Type of water source. Can be Swimming Pool, Reflecting Pool, Stream/River, Pond/Lake, or Sea/Ocean. Default = Swimming Pool.

**Color** Color of the water (ignored when the Type equals Swimming Pool). Choose a predefined water color, or choose Custom to specify a color. Can be Tropical, Algae/Green, Murky/Brown, Reflecting Pool, Stream/River, Pond/Lake, Sea/Ocean, or Custom Color. Default=Tropical.

- **Custom Color** When Color equals Custom Color, click to change the water color.

**Wave Height** Relative height of waves in the water. Enter a value between 0 (no waves) and 5 (big waves). Default=0.5.

**Performance Tuning Parameters rollout**

![Performance Tuning Parameters](image)

See Performance-Tuning Controls on page 5857.
**Common ProMaterials Controls**

These topics describe controls that are common to all or most of the materials in the ProMaterials library.

**Ambient Occlusion Controls**

Material Editor > Type button > Material/Map Browser > Choose a ProMaterials material, and then click OK. > Special Effects rollout or Ambient Occlusion rollout > Ambient Occlusion controls

Note: ProMaterials appear in the Browser only if mental ray is the active renderer. Not all ProMaterials support ambient occlusion.

Ambient Occlusion (AO) is a method spearheaded by the film industry for emulating the look of true global illumination by using shaders that calculate the extent to which an area is occluded, or prevented from receiving incoming light.

Used alone, an AO shader, such as the separate mental ray Ambient/Reflective Occlusion shader, creates a grayscale output that is dark in areas light cannot reach and bright in areas where it can.

The following image illustrates the main results of AO: dark crevices and areas where light is blocked by other surfaces, and bright areas that are exposed to the environment.
An example of AO applied to a scene

One important aspect of AO is that the user can see how far it looks for occluding geometry.
AO looked up within a shorter radius

Using a radius creates a localized AO effect: only surfaces within the given radius are considered as occluders. This also speeds up rendering. The practical result is that the AO provides nice “contact shadow” effects and makes small crevices visible.

Interface

Depending on the material, the ambient occlusion controls appear either on the Special Effects rollout or the Ambient Occlusion rollout. Not all ProMaterials support ambient occlusion.

The following illustration depicts a model helicopter that is lit almost exclusively by indirect light. Note how the helicopter does not feel “grounded” in the left-hand image and the shadows under the landing skids are too vague. The right-hand image uses AO to “punch out” the details and the contact shadows.
There are four controls for ambient occlusion:

**Ambient Occlusion** When on, enables ambient occlusion (AO) and makes the remaining group controls available. Default=off.

**Samples** The number of samples (rays) shot for creating AO. Higher values yield smoother results but render more slowly, while lower values render faster but look grainier. Values in the range 16–64 cover most situations. Default=16.

**Max Distance** Defines the radius within which mental ray looks for occluding objects. Smaller values restrict the AO effect to small crevices only but are much faster to render. Larger values cover larger areas but render more slowly. Default=4.0.

The following illustrations show the raw AO contribution with two different distances:

*Left: Higher Max Distance value
Right: Lower Max Distance value*
TIP To specify an infinite radius, set Distance to 0.0.

**Use Color from Other Mats (Exact AO)** When on, derives the AO coloring from surrounding materials, for more accurate overall results (also known as *color bleeding*). For example, a glowing material would return a brighter color than a dark material.

In the following pair of illustrations, the first image shows the problem with the traditional AO: it applies to all indirect illumination and always makes it darker. It is most noticeable on the glowing sphere, which has a dark spot under it, but can also be perceived on the floor in front of the cube which is suspiciously dark, even though the cube is strongly lit on the front, as well as between the legs of the horse and the underside of the red sphere.

In contrast, the second image has Use Color From Other Mats on for all materials, so the floor is lit correctly by the glowing ball, there is a hint of white bounce light on the floor from the cube, and light appears between the legs of the horse and on the underside of the red ball.
Use Color From Other Mats is on

If you find that using AO creates a “dirty” look with excessive darkening in corners, or dark rims around self-illuminated objects, turn on Use Color From Other Mats for a more accurate result.

Round Corners

Material Editor > Type button > Material/Map Browser > Choose a ProMaterials material, and then click OK. > Special Effects rollout or Round Corners rollout > Round Corners controls

Note: ProMaterials appear in the Browser only if mental ray is the active renderer. Not all ProMaterials support round corners.

Computer-generated imagery tends to look unrealistic, partly because edges of objects are geometrically sharp, whereas most edges in the real world are slightly rounded, chamfered, worn, or filleted in some manner. This rounded edge tends to “catch the light” and create highlights that make edges more visually appealing.

Many ProMaterials can create the illusion of rounded edges at render time. This feature is intended primarily to speed up modeling, so that you need not explicitly fillet or chamfer edges of an object such as a tabletop.
The function is not a displacement; it is merely a shading effect, such as bump mapping, and it is best suited for straight edges and simple geometry, not for advanced, highly curved geometry.

**Interface**

Depending on the material, the round corner controls appear either on the Special Effects rollout or the Round Corners rollout. Not all ProMaterials support round corners.

This effect rounds off corners and straight edges as a rendering effect only; it has no effect on geometry.

The rounding effect happens to convex corners and surfaces that actually intersect. Concave corners that merely touch will not display the effect. To get the effect to work in concave corners the objects must be pushed into each other a little. The effect is intended for straight edges and is not guaranteed to work properly for highly curved, complex intersections.

There are three controls for round corners:

**Round Corners** When on, rounds off corners and straight edges at render time. Default=off.

**NOTE** For some ProMaterials, there is no Round Corners toggle. In this case, the Fillet Radius defaults to 0.0. To enable rendering with round corners, increase the Fillet Radius value.

**Fillet Radius** Specifies the radius of the filleted corners and/or edges. Default=0.25.
You can apply a map to this parameter, to create variations in the amount of corner rounding.

**Blend With Other Materials** By default, the rounding effect happens only between surfaces of the same material, but if you turn this on the filleting is performed against any material. Default=off. In the following image, the melted chocolate is rounded off against the submerged objects even though they use different materials. In actuality, the melted chocolate is a completely flat plane.

![Objects in melted chocolate](image)

**Performance-Tuning Controls**

Material Editor > Type button > Material/Map Browser > Choose a ProMaterials material, and then click OK. > Performance Tuning Parameters rollout

Note: ProMaterials appear in the Browser only if mental ray is the active renderer.

The performance-tuning parameters let you tune performance by limiting the amount of calculation a ProMaterial has to perform. There are four parameters, but for each material, only the relevant settings appear in the interface.

**Reflection Glossy Samples** Defines the maximum number of samples (rays) that mental ray shoots to create glossy reflections. Higher values cause slow rendering but create a smoother result. Lower values render faster but create a grainier result. Generally 32 is enough for most cases. Default=8 for most ProMaterials, 0 for Mirror.
NOTE When Reflection Glossy Samples equals 0, the reflections take the form of a “perfect mirror” and only one ray is shot, regardless of the actual value of Glossiness. You can use this to boost performance for surfaces with very weak reflections.

**Reflection Glossy Samples** Defines the maximum number of samples (rays) that mental ray shoots to create glossy refraction. Higher values cause slow rendering but create a smoother result. Lower values render faster but create a grainier result, like frosted glass. Generally 32 is enough for most cases. Default=8.

NOTE When Refraction Glossy Samples equals 0, the refraction takes the form of a “perfect lens” and only one ray is shot. You can use this to boost performance for draft renderings.

**Reflection Max Trace Depth** When this trace depth is reached, mental ray stops calculating reflections. Default=0.

**Refraction Max Trace Depth** When this trace depth is reached, mental ray stops calculating refractions. Default=0.

### Arch & Design Material (mental ray)

Material Editor > Type button > Material/Map Browser > Arch & Design Material

Material Editor > any material > Click a Map button. > Material/Map Browser > Car Paint Shader

**Note:** The Arch & Design material appears in the Browser only if the mental ray renderer is the currently active renderer.

The mental ray Arch (architectural) & Design material improves the image quality of architectural renderings and improves workflow and performance in general and for glossy surfaces such as floors in particular. Special features include self-illumination, advanced options for reflectivity and transparency, ambient occlusion settings, and the ability to round off sharp corners and edges as a rendering effect.

**TIP** The Arch & Design material supports hardware-based viewport display for improved feedback while editing its parameters. For more information, see Show Standard/Hardware Map in Viewport on page 5696.
**TIP** The Arch & Design material interface has built-in descriptions of all of its important parameters. To view a tooltip describing a parameter of interest, position the mouse cursor over the control’s spinner, color swatch, check box, etc.

See also:

- Arch & Design Material (mental ray): Overview on page 5893
- Arch & Design Material (mental ray): Tips and Tricks on page 5907

**Procedures**

**To create a physically correct, self-illuminated surface:**

An example of this application is a realistic halogen pendant luminaire with a translucent shade, such as frosted glass.

1. Create your geometry and obtain or create a photometric file of the luminaire. Determine the lamp color and intensity, as measured or provided by the manufacturer; for example: 1,500 cd/m2 and 3,700 degrees Kelvin. Enable tone mapping on page 7207 and global illumination on page 6706.

2. Create a photometric light (the halogen lamp) and set its color and intensity.

3. Turn off the light source’s Affect Specular property.

4. Create and place the light-shade geometry and apply an Arch & Design material to it.

5. On the Self Illumination (Glow) rollout, set the same color and intensity you applied to the light source. Also turn off the Illuminates The Scene (When Using FG) check box in the Glow Options group.
6 Render the scene.

**Interface**

Main material parameters rollout on page 5861
BRDF rollout on page 5871
Self Illumination (Glow) rollout on page 5873
Special Effects rollout on page 5877
Advanced Rendering Options rollout on page 5882
Fast Glossy Interpolation rollout on page 5888
Special Purpose Maps rollout on page 5891
General Maps rollout on page 5893

**Templates rollout**

Provides access to Arch & Design material presets for quickly creating different types of materials such as wood, glass, and metal. You can also use these as starting points for generating customized materials. Choose a template from the drop-down list; a description of the material then appears in the left-hand pane.

**NOTE** The Arch & Design material works only with the mental ray renderer, so in order to see it represented accurately in the sample slots, you must first set mental ray to render in the Material Editor. For details, see Assign Renderer Rollout on page 6582.
Main material parameters rollout

Diffuse group

Diffuse Level: Diffuse Level on page 5999 controls the brightness of the diffuse color component. Range=0.0 to 1.0. Default=1.0.

NOTE Because the material is energy conserving, the actual diffuse level used depends on the reflectivity and transparency, as discussed in the introductory section, above.

Color: Controls the diffuse color on page 8552. The diffuse color is the color in direct light. Default=50% gray.

Roughness: Roughness on page 6001 controls how quickly the diffuse component blends into the ambient component. Range=0.0 to 1.0. Default=0.0.

The diffuse component uses the Oren-Nayar shading model. When the Roughness value is 0.0 this is identical to classical Lambertian shading, but with higher values the surface gets a more “powdery” look, as shown in the following illustration.
Reflection group

Reflectivity The overall level of reflectivity. Range=0.0 to 1.0. Default=0.6. The Reflectivity and Color values combine to define the level of reflections as well as the intensity of the traditional highlight, also known as the specular highlight.

This value is the maximum value; the actual value also depends on the angle of the surface and comes from the BRDF curve. This curve (see BRDF rollout on page 5871) lets you define 0-degree reflectivity for surfaces facing the view and 90-degree reflectivity for surfaces perpendicular to the view.
Center: Angle-dependent reflectivity, with 0-degree reflectivity of 0.1 and a 90-degree reflectivity of 1.0

Right: Constant reflectivity, with both 0-degree reflectivity and 90-degree reflectivity of 0.9

NOTE In the preceding illustration, the high reflectivity automatically “subtracts” from the white diffuse color. If this didn’t happen, the material would become unrealistically overbright, and would break the laws of physics.

Color The overall color of reflected light. Default=white.

Glossiness Defines the surface “glossiness,” ranging from 1.0 (a perfect mirror) to 0.0 (a diffusely reflective surface). Default=1.0.

Glossy Samples Defines the maximum number of samples (rays) that mental ray shoots to create glossy reflections. Higher values cause slow rendering but create a smoother result. Lower values render faster but create a grainier result. Generally 32 is enough for most cases.

Available only when Glossiness does not equal 1.0. Because a Glossiness value of 1.0 creates a “perfect mirror,” it is meaningless to shoot multiple rays for this case, hence only one reflection ray is shot.

NOTE If you set Glossy Samples to 0, the reflections take the form of a “perfect mirror” and only one ray is shot, regardless of the actual value of Glossiness. You can use this to boost performance for surfaces with very weak reflections. The highlight still respects the Glossiness value.
Glossy reflections need to trace multiple rays to yield a smooth result, which can affect performance. For this reason, the material includes the following two special features designed to enhance performance:

**Fast (interpolate)** When on, a smoothing algorithm allows rays to be reused and smoothed. The result is faster and smoother glossy reflections at the expense of accuracy. Interpolation is explained in greater detail in the section on the Fast Glossy Interpolation rollout on page 5888.

**NOTE** This method works best on flat surfaces.

**Highlights+FG only** When on, mental ray traces no actual reflection rays. Instead, only the highlights are shown, as well as soft reflections emulated with the help of using Final Gathering.

The Highlights+FG Only mode takes no additional rendering time compared to a non-glossy (diffuse) surface, yet can yield surprisingly convincing results. While it might not be completely convincing for “hero” objects in a scene, it can work very well for less-essential scene elements. It tends to work best on materials with weak reflections or extremely glossy (blurred) reflections, as shown in the following illustration:

![Image of two cups, one with real reflections, the other with Highlights+FG Only reflections](image)

The two cups on the left use real reflections, while those on the right use Highlights+FG Only.

**Metal material** Metallic objects actually influence the color of their reflection, whereas other materials do not. For example, a gold bar will have gold colored reflections, but a red glass orb does not have red reflections. This is supported through the Metal Material option:

- When off, the Reflection Color parameter defines the color, and the Reflectivity parameter together with the BRDF settings defines the intensity and colors of reflections.
When on, the Diffuse Color parameter defines the color of reflections, and Reflectivity parameter sets the “weight” between diffuse reflections and glossy (metallic) reflections.

Left: Non-metallic reflections (Metal Material is off). Reflections clearly contain the color of the objects they reflect and are not influenced by the color of the materials.

Center: Metallic reflections (Metal Material is on). Now the color of reflections are influenced by the color of the object.

Right: A variant of this with Reflectivity=0.5, creating a 50:50 mix between colored reflections and diffuse reflections

**Refraction group**

Transparency Defines the level of refraction. Range=0.0 to 1.0. Default=0.0. Due to the material's energy-conserving nature, the value set in the Transparency parameter is the maximum value; the actual value depends on the reflectivity as well as the BRDF curve.

Color Defines the color of refraction. While this color can be used to create “colored glass,” a slightly more accurate method to do this is described in the Colored Glass section on page 5909 of the Tips & Tricks topic.

Glossiness Defines the sharpness of the refraction/transparency, ranging from 1.0 (completely clear transparency) to 0.0 (extremely diffuse or blurry transparency). Default=1.0.
Glossy refraction needs to trace multiple rays to yield a smooth result, which can affect performance. For this reason, the material includes the following special feature designed to enhance performance:

**Fast (interpolate)** When on, a smoothing algorithm allows rays to be reused and smoothed. The result is faster and smoother glossy refraction at the expense of accuracy. Interpolation is explained in greater detail in the section on the Fast Glossy Interpolation rollout on page 5888.

**NOTE** This method works best on flat surfaces.

**Glossy Samples** Defines the maximum number of samples (rays) that mental ray shoots to create glossy refraction. Higher values cause slow rendering but create a smoother result. Lower values render faster but create a grainier result, like frosted glass. Generally 32 is enough for most cases.

Available only when Glossiness does not equal 1.0. Because a Glossiness value of 1.0 creates a perfectly clear (non-blurry) transparency, it is meaningless to shoot multiple rays for this case, hence only one refraction ray is shot.

**NOTE** If you set Glossy Samples to 0, the refraction takes the form of a “perfect lens” and only one ray is shot, regardless of the actual value of Glossiness. You can use this to boost performance for draft renderings.

**IOR** The Index of Refraction, which is a measurement of how much a ray of light bends when entering a material.

The direction in which light bends depends on whether it is entering or exiting the object. The Arch & Design material use the direction of the surface normal
as the primary cue for figuring out whether it is entering or exiting. It is therefore important to model transparent, refractive objects with the surface normals pointing in the proper direction.

The IOR can also be used to define the BRDF curve, which is what happens in the class of transparent materials known as “dielectric” materials, and is illustrated here:

Left: IOR=1.0; Center: 1.2; Right: 1.5

The leftmost cup looks completely unrealistic and is almost invisible. Because an IOR of 1.0, which equals that of air, is impossible in solid matter, we get no change in reflectivity across the material and hence perceive no edges or changes of any kind. On the other hand, the center and rightmost cups have realistic changes in reflectivity guided by the IOR.

Instead of basing the reflectivity on the IOR, you can instead use the BRDF mode to set it manually:
Different types of transparency

As in the previous illustration, the leftmost cup acquires its curve from the index of refraction. The center cup has a manually defined curve, which has been set to a 90 degree reflectivity of 1.0 and a 0 degree reflectivity of 0.2; this looks a bit more like metallized glass. The rightmost cup uses the same BRDF curve, but instead is set to thin-walled transparency on page 5885. Clearly, this method is better for making non-refractive objects than simply setting IOR to 1.0, as we tried above.

Translucency group

Translucency is handled as a special case of transparency; in order to use translucency there must first exist some level of transparency. The implementation of translucency in the Arch & Design material is a simplification concerned solely with the transport of light from the back of an object to its front faces and is not true SSS (subsurface scattering) effect. You can create an SSS-like effect by using glossy transparency coupled with translucency, but this is neither as fast nor as powerful as the dedicated SSS shaders on page 5946.

Translucency When on, the remaining Translucency become available and take effect when rendering.

Weight Determines how much of the existing transparency is used as translucency. For example, if Weight=0.0, all of the transparency is used as transparency. If Weight=0.3, 30 percent of the transparency is used as translucency.
Translucency is intended for use primarily in thin-walled mode on page 5885, as in the example above) to model things like curtains, rice paper, and similar effects. In thin-walled mode it simply allows the shading of the reverse side of the object to bleed through. The shader also operates in solid mode on page 5885, but, as explained above, the SSS shaders are better suited for such purposes.

Color The translucency color.
**Anisotropy group**

**Anisotropy** Controls the anisotropy, or shape, of the highlight. At 1.0, the highlight is round; that is, no anisotropy. At 0.01, the highlight is elongated. One axis of the highlight graph changes to show changes in this parameter. Default=1.0.

![Image showing anisotropy effect](image)

Left: Anisotropy=1.0; Center: Anisotropy=4.0; Right: Anisotropy=8.0

**Rotation** Changes the orientation of the highlight. The sample slot shows changes in orientation. This value can range from 0.0 to 1.0, with 1.0=360 degrees. So, for example, 0.25=90 degrees and 0.5=180 degrees. Default=0.0.

![Image showing rotation effect](image)

Left: Anisotropy Rotation=0.0; Center: Anisotropy Rotation=0.25; Right: Anisotropy Rotation=[texture map]
**TIP** When using texture-mapped Anisotropy Rotation, make sure the texture is not antialiased (filtered). You can achieve this by setting the map's Blur parameter to 0.0. Otherwise the antialiased pixels cause local vortices in the anisotropy that appear as seam artifacts.

**Automatic/Map Channel** Lets you optionally apply anisotropy to a specific map channel.

If the Map Channel setting is Automatic, the base rotation follows the object's local coordinate system. If it is any other value (in other words, a specific map channel), the space that defines the stretch directions of the highlights is derived from that channel's texture space.

**WARNING** Deriving the anisotropy from the texture space creates only one space per triangle and can cause visible seams between triangles.

Also see **Brushed Metal** on page 5919.

**BRDF rollout**

BRDF stands for *bidirectional reflectance distribution function*. As explained in the **introduction** on page 5900, this property lets the material's reflectivity be ultimately guided by the angle from which the object surface is viewed.
[BRDF method] Lets you choose how the BRDF curve is defined:

- **By IOR (fresnel reflections)**  How the reflectivity depends on the angle is guided solely by the material's index of refraction. This is known as *Fresnel reflections* and follows the behavior of most dielectric materials such as water and glass.

- **Custom Reflectivity Function**  When chosen, the following settings determine reflectivity based on angle of view.
  - **0 deg. refl.**  Defines the reflectivity for surfaces directly facing the viewer (or incident ray).
  - **90 deg. refl.**  Defines the reflectivity of surfaces perpendicular to the viewer.
  - **Curve shape**  Defines the falloff of the BRDF curve.

This mode is used for most hybrid materials or for metals. Most materials exhibit strong reflections at grazing angles; hence the 90 degree reflectivity parameter can generally be kept at 1.0, using the Reflectivity parameter to guide the overall reflectivity instead. Metals tend to be fairly uniformly
reflective and the 0 degree reflectivity value is high (0.8–1.0), but many other layered materials, such as linoleum and lacquered wood have lower 0 degree reflectivity values, in the range 0.1–0.3). For further information, see Quick Guide to Some Common Materials on page 5907.

**Reflectivity vs. Angle graph** Depicts the combined Custom Reflectivity Function settings.

**Self Illumination (Glow) rollout**

These parameters let you specify luminous surfaces within the Arch & Design material, such as a translucent lamp shade. Such a surface does not actually cast light, but it can optionally act as a source of indirect light when Final Gather on page 6760 is in effect, and thus can have an impact on scene lighting in the rendered image.

The optimal settings for self-illuminated surfaces depend on the lighting conditions and desired effects. This table provides recommended initial settings for lights and the glow options under different circumstances:

<table>
<thead>
<tr>
<th>Light Object</th>
<th>Self-Illuminated Surface</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Affect Specular</td>
</tr>
<tr>
<td><strong>Area Lights</strong></td>
<td>Off</td>
</tr>
<tr>
<td><strong>Point Lights</strong></td>
<td>On</td>
</tr>
<tr>
<td><strong>Glowing Object</strong></td>
<td>not applicable</td>
</tr>
</tbody>
</table>

**TIP** The easiest way to toggle the Affect Specular and Affect Diffuse switches for a light source is to select it in the viewport, right-click it, and then use the Tools 1 quadrant settings. This applies to only one light source at a time.
Self Illumination (Glow) When on, the material is set to be self-illuminating, and the remaining rollout settings become available. Default=off.

Color group

To set the illumination color, choose either option and adjust its parameter:

- **Light**  Pick a common lamp specification to approximate the spectral character of the desired illumination.
- **Kelvin**  Set the color of the self-illuminated surface by adjusting the color temperature spinner. The color temperature is displayed in degrees Kelvin.

**Filter** Use a color filter to simulate the effect of a color filter placed over the self-illuminated surface. For example, a red filter over a white luminance source casts red light. Set the filter color by clicking the color swatch to display the Color Selector on page 371. Default=white (RGB=255,255,255; HSV=0,0,255).

Luminance

To set the brightness of the illuminated surface, choose either option and then adjust the numeric setting.

- **Physical Units**  Sets the brightness in candelas per square meter. This is a physical value that takes the physical scale into account.
- **Unitless**  Uses an arbitrary numeric value to represent the brightness.
When Physical Units is chosen, sets the brightness in cd/m². When Unitless is chosen, sets the brightness as an arbitrary value. The following table shows some representative real-world luminance values.

<table>
<thead>
<tr>
<th>Object</th>
<th>Brightness in cd/m²</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cathode-ray tube (CRT) television screen</td>
<td>250</td>
</tr>
<tr>
<td>Liquid-crystal diode (LCD) television screen</td>
<td>140</td>
</tr>
<tr>
<td>Bright light-emitting diode (LED) panel on an electronic device such as a DVD player</td>
<td>100</td>
</tr>
<tr>
<td>Frosted lens in front of a desk lamp</td>
<td>10,000 (average)</td>
</tr>
<tr>
<td>Frosted lens in front of a residential recessed halogen lamp</td>
<td>10,000 (average)</td>
</tr>
<tr>
<td>Exterior of a ceramic lamp shade on a decorative fixture</td>
<td>1300</td>
</tr>
<tr>
<td>Interior of a ceramic lamp shade on a decorative fixture</td>
<td>2500</td>
</tr>
<tr>
<td>Frosted incandescent bulb inside a decorative fixture</td>
<td>210,000</td>
</tr>
<tr>
<td>Cloudy sky in the afternoon</td>
<td>8,000</td>
</tr>
<tr>
<td>White ceiling in a brightly daylit room on a cloudy day, oriented north</td>
<td>140</td>
</tr>
<tr>
<td>Reflection from a cloudy sky on a varnished wooden floor</td>
<td>875</td>
</tr>
<tr>
<td>Dark asphalt on a cloudy afternoon, outdoors</td>
<td>115</td>
</tr>
</tbody>
</table>
Glow Options

Visible in Reflections When on, the illumination produced by the settings on this rollout appears in reflections on other surfaces. When off, the object is still reflected, but the illumination is not.

Illuminates the Scene (when using FG) When on, and Final Gather on page 6760 is in effect, the self-illuminated surface acts as an indirect light source and contributes to the final gather lighting in the scene. When off, has no effect on final gather.
Self-illuminated spheres illuminating the scene

Special Effects rollout

- Ambient Occlusion
  - Samples: 15
  - Max Distance: 4.0
- Use Color From Other Materials (Exact AO)
- Shadow Color:
- Custom Ambient Light Color:
- Global Ambient Light Color

- Round Corners
  - Fillet Radius: 0.25
  - Blend With Other Materials

Note: This is strictly a shading effect (like a bump map) and is only guaranteed to work on straight edges.
Provides settings for ambient occlusion on page 5903 (AO) and round corners/edges.

**Ambient Occlusion group**

Ambient occlusion helps emulate the look of global illumination by creating darker areas where light doesn’t reach without actually generating shadows. With the Arch & Design material, you can specify ambient occlusion on a per-material basis.

The following illustration depicts a model helicopter that is lit almost exclusively by indirect light. Note how the helicopter does not feel “grounded” in the left-hand image and the shadows under the landing skids are too vague. The right-hand image uses AO to “punch out” the details and the contact shadows.

![Left: Without AO; Right: With AO](image)

**Ambient Occlusion** When on, enables ambient occlusion (AO) and makes the remaining group controls available.

**Samples** The number of samples (rays) shot for creating AO. Higher values yield smoother results but render more slowly, while lower values render faster but look grainier. Values in the range 16–64 cover most situations.

**Max Distance** Defines the radius within which mental ray looks for occluding objects. Smaller values restrict the AO effect to small crevices only but are much faster to render. Larger values cover larger areas but render more slowly. The following illustrations show the raw AO contribution with two different distances:
TIP To specify an infinite radius, set Distance to 0.0.

**Use Color From Other Materials (Exact AO)** When on, derives the AO coloring from surrounding materials, for more accurate overall results (also known as *color bleeding*). For example, a glowing material would return a brighter color than a dark material.

**NOTE** When this parameter is on, the function of the Shadow Color setting (see following) changes to let you specify the extent of color bleeding from nearby materials.

In the following pair of illustrations, the first image shows the problem with the traditional AO: It applies to all indirect illumination and always makes it darker. It is most noticeable on the glowing sphere, which has a dark spot under it, but can also be perceived on the floor in front of the cube which is suspiciously dark, even though the cube is strongly lit on the front, as well as between the legs of the horse and the underside of the red sphere.

In contrast, the second image has Use Color From Other Materials on for all materials, so the floor is lit correctly by the glowing ball, there is a hint of white bounce light on the floor from the cube, and light appears between the legs of the horse and on the underside of the red ball.
Use Color From Other Materials is off

If you find that using AO creates a “dirty” look with excessive darkening in corners, or dark rims around self-illuminated objects, turn on Use Color From Other Materials for a more accurate result.

**Shadow Color** When Use Color From Other Materials (see preceding) is off, sets the darkness of the AO shadows. It is used as the multiplier value for completely occluded surfaces. In practice, a black color makes the AO effect very dark; a middle-gray color makes the effect less noticeable (brighter), and so on.
When Use Color From Other Materials is on, this setting determines the ratio between the standard AO functionality with Shadow Color set to black and the color bleeding from other materials. For example, at the default setting, RGB=0.2, 20 percent of the AO shadow color is derived from black and 80 percent is derived from the color of the nearby material. If you set Shadow Color to RGB=0.0 (black), then 100 percent of the shadow color comes from nearby materials. If you set Shadow Color to RGB=1.0 (white), then 100 percent of the shadow color comes from black; this is the same as turning off Use Color From Other Materials and setting Shadow Color to black.

**Custom/Global Ambient Light Color** You can specify a color for the ambient light used in AO, or use the global color specified on the Environment panel on page 7163 > Common Parameters rollout.

This parameter is used for doing more traditional AO; that is, supplying an imagined “ever-present ambient light” that is then attenuated by the AO effect to create shadows.

While traditional AO is generally used when rendering without other indirect light, you can also combine it with existing indirect light. Bear in mind that this “ever-present ambient light” is inherently non-physical, but can possibly help lighten some troublesome dark corners.

**Round Corners group**

This effect rounds off corners and straight edges as a rendering effect only; it has no effect on geometry.

The rounding effect happens to convex corners and surfaces that actually intersect. Concave corners that merely touch will not display the effect. To get the effect to work in concave corners the objects must be pushed into each other a little. The effect is intended for straight edges and is not guaranteed to work properly for highly curved, complex intersections.

**Round Corners** When on, rounds off corners and straight edges at render time.

**Fillet Radius** Specifies the radius of the filleted corners and/or edges.

**Blend With Other Materials** By default, the rounding effect happens only between surfaces of the same material, but if you turn this on the filleting is performed against any material.

In the following image, the molten chocolate is rounded off against the submerged objects even though they use different materials. In actuality, the molten chocolate is a completely flat plane.
Objects in molten chocolate

Advanced Rendering Options rollout

These parameters define performance-boosting options.
Reflections group

Max Distance Allows limiting reflections to a certain distance, which both speeds up rendering and avoids pulling distant objects into extremely glossy reflections.

Fade to end color When on, reflections fade to this color. When off, reflections fade to the environment color. The former tends to be more useful for indoor scenes; the latter, for outdoor scenes.

Available only when Max Distance is on.

Max Trace Depth When this trace depth is reached, the material behaves as if the Highlights+FG Only switch is on; that is, it shows only highlights and “emulated” reflections created with the help of Final Gathering.

Cutoff Threshold The level at which reflections are rejected; that is, not traced. It’s a relative value: For example, the default setting of 0.01 means that rays that contribute less than 1 percent to the final pixel are ignored. A setting of 0.25 means that mental ray discards rays that contribute less than a quarter of the value of the final pixel.

Refraction group

The optimization settings for refraction (transparency) are nearly identical to those for reflections. The exception is that of Color At Max Distance, which behaves differently.

Max Distance Allows limiting refraction to a certain distance.
**Color at Max Distance** When on, the material simulates physically correct absorption. At the distance specified by Max Distance, the refracted image has the color given by Color At Max Distance, but the rays are not limited in reach. At twice the distance, the influence of Color At Max Distance is double, at half the distance half, etc.

When off, transparency rays simply fade to black. This is like smoked glass and other highly absorbent materials. Transparency just stops at the specified distance. This has the same performance advantage as using the Max Distance for reflections: Tracing shorter rays is much faster.

Available only when Max Distance is on.

---

**Left: No limit (Max Distance=off); Center: Fade to black; Right: Fade to blue**

**Max Trace Depth** When this trace depth is reached, the material refracts black.

**Cutoff Threshold** The level at which refraction is rejected; that is, not traced. It’s a relative value: For example, the default setting of 0.01 means that rays that contribute less than 1 percent to the final pixel are ignored. A setting of 0.25 means that mental ray discards rays that contribute less than a quarter of the value of the final pixel.

**Advanced Reflectivity Options group**

**Visible area lights cause no Highlights** When on, mental ray area lights (Omní on page 5418 and Spotlight on page 5421) with the Show Icon In Renderer property on create no specular highlights. Default=on.

The Show Icon In Renderer check box is found on the light’s Area Light Parameters rollout. When on, the light is visible and reflects in any glossy,
reflective objects. If both the reflection of the visible area light and the highlight is rendered, the light is added twice, causing an unrealistic brightening effect. When on, this switch causes visible area lights to lose their highlights and instead only appear as reflections. Note that this does not apply to the Highlights+FG Only on page 5864 mode, which doesn't actually reflect anything.

**Skip reflections on inside (except total internal reflection)** Most reflections inside transparent objects are very faint, except in the special case that occurs at certain angles known as total internal reflection (TIR). When on, this option saves rendering time by ignoring the weak reflections completely but retaining the TIRs. Default=on.

**Relative Intensity of Highlights** Defines the intensity of specular highlights vs. the intensity of true reflections. When the value is 1.0, the two intensities are equal. A lower value subdues the intensity of highlights compared to reflections, while a higher value intensifies the highlights.

**Advanced Transparency Options group**

The options give you control over some of the deepest details of the Arch & Design material.

**Glass/Translucency treat objects as...**

- **Solid** The object behaves as if it is made of a solid, transparent substance.
- **Thin-walled** The object behaves as if made of wafer-thin sheets of a transparent material.

For more information, see Solid versus Thin-Walled on page 5902.
When Caustics are enabled, transparent objects: When not rendering caustics, the Arch & Design material uses a shadow shader to create transparent shadows. For objects such as window panes this is perfectly adequate, and actually creates a better result than using caustics, because the direct light is allowed to pass more or less undisturbed through the glass into a space such as a room.

Traditionally, enabling caustics in mental ray causes all materials to stop casting transparent shadows and instead start to generate refractive caustics. In most architectural scenes this is undesirable; you might want a glass decoration on a table to generate caustic effect, but still want the windows to the room to let in normal direct light. This switch makes this possible at the material level.

- **Refract light and generate Caustic effects**  The material refracts light and generates caustics.
- **Use Transparent Shadows**  No caustics are produced; the material and object simply transmit the light, with greater shadowing in thicker areas.

In the following illustration, the left side shows the result with Use Transparent Shadows chosen, and the right side shows the result with Refract Light And Generate Caustic Effects chosen. You can freely mix the two modes in the same rendering. Photons are automatically treated accordingly by the built-in photon shader, shooting straight through as direct light in the former case, and being refracted as caustics in the latter.
Left: Using transparent shadows; Right: Using refractive caustics.

**Back Face Culling** When on, enables a special mode that makes surfaces invisible to the camera when seen from the reverse side. You can use this to create “magic walls” in a room. If all walls are planes with the normals facing inwards, the Back Face Culling switch allows the room to be rendered from “outside.” The camera can see into the room, but the walls will still exist and cast shadows, bounce photons, etc. while being invisible when the camera goes outside.

Left: Back Face Culling=off; Right: Back Face Culling=on

**Transparency propagates Alpha channel** Defines how transparent objects treat any alpha channel information in the background. When on, refraction and other transparency effects propagate the alpha of the background “through” the transparent object. When off, transparent objects have an opaque alpha.
Indirect Illumination Options

FG/GI multiplier  Allows tweaking of how strongly the material responds to indirect light.

FG Quality  A local multiplier for the number of final gather rays shot by the material.

Fast Glossy Interpolation rollout

Glossy reflections and refraction can be interpolated, which causes them to render faster and look smoother. Interpolation works by precalculating glossy reflection in a grid across the image. The number of samples (rays) taken at each point is governed by the Reflection > Glossy Samples on page 5863 or Refraction > Glossy Samples on page 5866 parameters, as in the non-interpolated case.

Note that interpolation can cause artifacts. Because it is done on a low-resolution grid, it can lose details. And because it blends neighbors of this low-resolution grid, it can cause oversmoothing. For this reason it is useful primarily with flat surfaces. Interpolation does not work well with wavy, highly detailed surfaces or surfaces that use bump maps.

Interpolation grid density  The resolution of the grid used for interpolating glossy reflections and refraction. Choose a setting from the drop-down list.

Within the grid, data is stored and shared across the points. Using a lower grid resolution is faster, but causes greater loss of detail information.
Reflective interpolation group

**Neighboring points to look up** Defines how many stored grid points (in an N by N group around the currently rendered point) is looked up to smooth out reflective glossiness. The default is 2, and higher values will “smear” the glossiness more, but are hence prone to more oversmoothing artifacts.

In the following illustration, the reflection of the left cup in the floor does not use interpolation, and some grain is evident (here intentionally exaggerated). The floor tiles under the other two cups use a half-resolution interpolation with point lookup set to 2 (center) and 4 (right), respectively.

![Left: No interpolation; Center: Looking up two points; Right: Looking up four points.](image)

The preceding image also illustrates one of the consequences of using interpolation: The foot of the left cup, which is near the floor, is reflected quite sharply, and only the parts of the cup far from the floor are blurry. However, the interpolated reflections of the right cups have a base level of blurriness, due to the smoothing of interpolation, which makes even the closest parts somewhat blurry. In most scenes with weak glossy reflections this discrepancy will never be noticed, but in other cases this can make things like legs of tables and chairs feel “unconnected” with a glossy floor, if the reflectivity is high. To resolve this, you can use the High Detail Distance setting (see following).

**High detail distance** Allows tracing of a second set of detail rays to create a “clearer” version of objects within the specified radius.

In the following illustration, all three floor tiles use interpolation but the two on the right use different distances for the detail distance.
This also allows an interesting trick: Set Reflection > Glossy Samples to 0, which renders reflections as if they were mirror-perfect, but also use interpolation to introduce blur into this reflection, and perhaps use High Detail Distance to make nearby parts less blurry. This is a fast way to obtain a glossy reflection.

The floor tiles in the following illustration are rendered with mirror reflections, and the blurriness comes solely from the interpolation. This renders as fast as or faster than pure mirror reflections, yet gives a satisfying illusion of true glossy reflections, especially when utilizing the High Detail Distance option, as on the right.
Single Sample from Environment  Creating realistically blurry glossy reflections normally requires taking multiple samples from the environment, which can result in grainy, slow-rendering environment reflections. With this check box on, mental ray instead takes only one sample, thus preventing the grain. This also prevents blurring the environment, so it is best used together with a local, “pre-blurred” environment map. You can do the pre-blurring in an image-processing program or with the Material Editor > Coordinates rollout on page 6201 > Blurry and Blur Offset settings.

Refractive interpolation group

Neighboring points to look up Defines how many stored grid points (in an N by N group around the currently rendered point) are looked up to smooth out refractive glossiness. The default is 2; higher values tend to “smear” the glossiness more, but are hence prone to more oversmoothing artifacts.

Special Purpose Maps rollout

Let you apply bump, displacement, and other maps. Each left-justified setting has a check box for enabling and disabling the map, and a button for defining the map.

Bump  Lets you apply a bump map and multiplier.

Do not apply bumps to the diffuse shading When off, the bumps apply to all shading components: diffuse, highlights, reflections, refractions, etc. When on, bumps are applied to all components except the diffuse. This means bumps are seen in reflections, highlights, etc. but the diffuse shading shows no bumps. It is as if the material’s diffuse surface is smooth, but is covered by a bumpy lacquer coating.
Left: Do Not Apply Bumps ...=off; Right: Do Not Apply Bumps ...=on

**Displacement** Lets you apply a displacement map and multiplier.

**Cutout** Lets you apply an opacity map to completely remove parts of objects. A classic example is to map an image of a tree to a flat plane and use opacity to cut away the parts of the tree that are not there.

Left: Mapped transparency; Right: Using Cutout

**Environment** Lets you apply an environment map and shader.

**Additional Color/Self illum.** Lets you apply any shader. The output of this shader is added on top of the shading done by the Arch & Design material.
and can be used for self-illumination-type effects, as well as adding any additional shading you want.

**General Maps rollout**

This rollout enables application of maps or shaders to any of the Arch & Design material parameters. Of course, you can apply a shader to a parameter at its standard location in the user interface by clicking its Map button, so the principal value of this rollout is that it also lets you toggle a parameter’s shader, using the check box, without removing the map.

**Arch & Design Material (mental ray): Overview**

This topic serves as an introduction to the Arch & Design material for mental ray. For a detailed reference to the material interface, see Arch & Design Material (mental ray) on page 5858. For a variety of suggestions for using the material to create specific effects, see Arch & Design Material (mental ray): Tips and Tricks on page 5907.
What Is the Arch & Design Material?

The mental ray Arch & Design material is a monolithic material shader designed to support most materials used in architectural and product-design renderings. It supports most hard-surface materials such as metal, wood and glass. It is especially tuned for fast glossy reflections and refractions (replacing the DGS material on page 6398) and high-quality glass (replacing the dielectric material on page 6403).

The major features are:

- Easy to use, yet flexible - controls are arranged logically in a most-used-first fashion.
• **Templates** - allow fast access to settings combinations for common materials.

• **Physically accurate** - the material is energy conserving, making it impossible to create shaders that break the laws of physics.

• **Glossy performance** - advanced performance boosts including interpolation, emulated glossiness, and importance sampling.

• **Tweakable BRDF** (bidirectional reflectance distribution function) - the user can define how reflectivity depends on angle.

• **Transparency** - “Solid” or “thin” materials: transparent objects such as glass can be treated as either solid (refracting, built out of multiple faces) or thin (nonrefracting, can use single faces).

• **Round corners** - simulate fillets to allow sharp edges to still catch the light in a realistic fashion.

• **Indirect Illumination control** - set the final gather accuracy or indirect illumination level on a per-material basis.

• **Oren-Nayar diffuse** - allows “powdery” surfaces such as clay.

• **Built-in Ambient Occlusion** - for contact shadows and enhancing small details.

• **All-in-one shader** - photon and shadow shader built in.

• **Waxed floors, frosted glass and brushed metals** - all fast and easy to set up.

**Physics and the Display**

The Arch & Design material attempts to be physically accurate, hence its output has a high dynamic range. How visually pleasing the material looks depends on how colors inside the renderer are mapped to colors displayed on the screen.

When rendering with the Arch & Design material it is highly recommended that you operate through a tone mapper/exposure control such as the mr Photographic Exposure Control on page 7219 in conjunction with gamma correction on page 8330, or at the very least use gamma correction.
A Note on Gamma

Describing all the details of gamma correction is beyond the scope of this topic; this is just a brief overview.

The color space of a normal, off-the-shelf computer screen is not linear. The color with RGB value 200 200 200 is not twice as bright as a color with RGB value 100 100 100, as one might expect.

This is not a bug because, due to the fact that our eyes see light in a nonlinear way, the former color is actually perceived to be about twice as bright as the latter. This makes the color space of a normal computer screen roughly perceptually uniform. This is a good thing, and is actually the main reason 24-bit color (with only 8 bits or 256 discrete levels for each of the red, green and blue components) looks as good as it does to our eyes.

The problem is that physically correct computer graphics operates in a true linear color space where a value represents actual light energy. If one simply maps the range of colors output to the renderer naively to the 0–255 range of each RGB color component it is incorrect.

The solution is to introduce a mapping of some sort. One of these methods is called gamma correction.

Most computer screens have a gamma of about 2.2 (known as the sRGB color space), but 3ds Max defaults to a gamma of 1.8, which makes everything look too dark (especially midtones), and light does not “add up” correctly.

Using a gamma of 2.2 is the theoretically correct value, making the physically linear light inside the renderer appear in a correct linear manner on screen.

However, because the response of photographic film isn’t linear either, users find that this theoretically correct value looks too bright and washed out. A common compromise is to render to the default gamma of 1.8, making things look more photographic; that is, as if the image had been shot on photographic film and then developed. However, when exporting and importing images (for example, as texture maps) with external image-editing programs, for best results set all gamma values on Preferences > Gamma and LUT Preferences on page 8330 to 2.2.

Tone Mapping

Another method for mapping the physical energies inside the renderer to visually pleasing pixel values is known as tone mapping. You can accomplish this either by rendering to a floating-point file format and using external software, or with a plug-in that allows the renderer to do it on the fly. In 3ds
Max such plug-ins are known as exposure controls and are accessed from the Environment dialog.

**Use Final Gathering and Global Illumination**

The Arch & Design material is designed to be used in a realistic lighting environment; one that incorporates full direct and indirect illumination. mental ray provides two basic methods for generating indirect light: Final Gathering and Global Illumination. For best results, be sure to use at least one of these methods.

At the very least, enable Final Gathering, or use Final Gathering combined with Global Illumination (photons) for quality results. Performance tips for using Final Gather and Global Illumination can be found [here](#) on page 5907.

If you use an environment for your reflections, make sure the same environment (or a blurred copy of it) is used to light the scene through Final Gathering. In 3ds Max this means you should include a Skylight on page 5412 in your scene set to Use Scene Environment, or use Daylight system on page 5491 with Skylight set to mr Sky.

**Use Physically Correct Lights**

Traditional computer-graphics light sources live in a cartoon universe where the intensity of the light doesn’t change with the distance. The real world doesn’t agree with that simplification. Light decays when leaving a light source due to the fact that light rays diverge from their source and the intensity of the light changes over distance. This decay of a point light source is $1/d^2$; in other words, light intensity is proportional to the inverse of the square of the distance to the source.

One of the reasons for this traditional oversimplification is the fact that in the early days of computer graphics, tone mapping was not used and problems of colors blowing out to white in the most undesirable ways was rampant. (Raw clipping in sRGB color space is displeasing to the eye, especially if one color channel clips earlier than the others. Tone mapping generally solves this by “soft clipping” in a more suitable color space than sRGB.)

However, as long as only Final Gathering (FG) is used as indirect illumination method, such traditional simplifications still work. Even light sources with no decay still create reasonable renderings. This is because FG is concerned only with the transport of light from one surface to the next, not with the transport of light from the light source to the surface.
It’s when working with Global Illumination (GI) (that is, with photons) the
troubles arise.

When GI is enabled, light sources shoot photons. For the Arch & Design
material (or any other mental ray material) to be able to work properly, it is
imperative that the energy of these photons to match the direct light cast by
that same light. And since photons model light in a physical manner, decay
is built in.

Hence, when using GI:

■ Light sources must emit photons at the correct energy.
■ The direct light must decay in a physically correct way to match the decay
  of the photons.

Therefore it is important to make sure the light shader and the photon emission
shader of the lights work well together.

In 3ds Max this is most easily solved by using the photometric lights on page
5348. All of these lights are guaranteed to have their photon energy in sync with
their direct light. It is built in and automatic and one does not need to worry
about it.

Features

The Shading Model

From a usage perspective, the shading model consists of three components:

■ Diffuse - diffuse channel /including Oren Nayar “roughness”).
■ Reflections - glossy anisotropic reflections (and highlights).
■ Refraction - glossy anisotropic transparency (and translucency).
The Arch & Design material shading model

Direct and indirect light from the scene cause diffuse reflections as well as translucency effects. Direct light sources also create specular highlights.

Ray tracing is used to create reflective and refractive effects, and advanced importance-driven multi-sampling is used to create glossy reflections and refraction.

The rendering speed of the glossy reflections/refraction can further be enhanced by interpolation as well as “emulated” reflections with the help of Final Gathering.

Conservation of Energy

One of the most important features of the material is that it is automatically energy conserving. This means that it makes sure that diffuse + reflection + refraction <= 1. In other words, no energy is magically created and the incoming light energy is properly distributed to the diffuse, reflection and refraction components in a way that maintains the first law of thermodynamics.

In practice, this means, for example, that when adding reflectivity, the energy must be taken from somewhere, and hence the diffuse level and the transparency will be automatically reduced accordingly. Similarly, adding transparency happens at the cost of the diffuse level.
The rules are as follows:

- Transparency takes energy from diffuse; that is, at 100% transparency, there is no diffuse at all.
- Reflectivity takes energy from both diffuse and transparency; that is, at 100% reflectivity there is neither diffuse nor transparency.
- Translucency is a type of transparency, and the Translucency Weight parameter defines the percentage of transparency vs. translucency.

From left to right: Reflectivity=0.0, 0.4, 0.8, and 1.0

From left to right: Transparency=0.0, 0.4, 0.8, and 1.0

Conservation of energy also means that the level of highlights is linked to the glossiness of a surface. A high Reflection Glossiness value causes a narrow, intense highlight, while a lower value causes a wider, less intense highlight. This is because the energy is now spread out and dissipated over a larger area.

**BRDF: How Reflectivity Depends on Angle**

In the real world, the reflectivity of a surface is often view-angle dependent. A fancy term for this is *bidirectional reflectance distribution function* (BRDF); that is, a way to define how much a material reflects when seen from various angles.
The reflectivity of the wood floor depends on the view angle.

Many materials exhibit this behavior. The most obvious examples are glass, water, and other dielectric materials with Fresnel effects (where the angular dependency is guided strictly by the index of refraction), but other layered materials such as lacquered wood and plastic display similar characteristics.

The Arch & Design material allows this effect to be defined by the index of refraction, and also allows an explicit setting for the two reflectivity values for:

- 0 degree faces (surfaces directly facing the camera)
- 90 degree faces (surfaces 90 degrees to the camera)

For more information, see BRDF rollout on page 5871.

**Reflectivity Features**

The final surface reflectivity is in reality caused by the sum of three components:

- The diffuse effect
- The actual reflections
- Specular highlights that simulate the reflection of light sources

Diffuse, reflections, and highlights
In the real world, highlights are just glossy reflections of the light sources. In computer graphics it's more efficient to treat these separately. However, to maintain physical accuracy the material automatically keeps highlight intensity, glossiness, anisotropy, etc. in sync with the intensity, glossiness and anisotropy of reflections. Thus, there are no separate controls for these as both are driven by the reflectivity settings.

**Transparency Features**

The material supports full glossy anisotropic transparency and includes a translucent component, described in detail here on page 5868.

---

**Translucency**

**Solid versus Thin-Walled**

The transparency/translucency property can treat objects as either solid or thin-walled.

If all objects were treated as solids at all times, every window pane in an architectural model would have to be modeled as two faces: an entry surface that refracts the light slightly in one direction, and immediately following it an exit surface, where light is refracted back into the original direction.

Not only does this entail additional modeling work, it is a waste of rendering power to simulate refraction that has very little net effect on the image. Hence the material allows modeling the entire window pane as a single flat plane, foregoing any actual refraction of light.
Solid vs. thin-walled transparency and translucency

In the preceding illustration the helicopter canopy, the window pane, the translucent curtain, and the right-hand sphere all use thin-walled transparency or translucency, whereas the glass goblet, the plastic horse, and the left-hand sphere all use solid transparency or translucency.

Cutout Opacity

Beyond the “physical” transparency, which models an actual property of the material, the material provides a completely separate, non-physical “cutout opacity” channel to allow “billboard” objects such as trees, or to cut out objects such as a chainlink fence with an opacity mask.

Special Effects

Built-in Ambient Occlusion

Ambient Occlusion (AO) is a method spearheaded by the film industry for emulating the look of true global illumination by using shaders that calculate the extent to which an area is occluded, or prevented from receiving incoming light.
Used alone, an AO shader, such as the separate mental ray Ambient/Reflective Occlusion shader, creates a grayscale output that is dark in areas light cannot reach and bright in areas where it can:

The following image illustrates the main results of AO: dark crevices and areas where light is blocked by other surfaces, and bright areas that are exposed to the environment.

An example of AO applied to a scene

One important aspect of AO is that the user can how far it looks for occluding geometry.
AO looked up within a shorter radius

Using a radius creates a localized AO effect: Only surfaces within the given radius are considered as occluders. This also speeds up rendering. The practical result is that the AO provides nice “contact shadow” effects and makes small crevices visible.

The Arch & Design material gives you two ways to utilize its built-in AO:

■ Traditional AO for adding an omnipresent ambient light that is then attenuated by the AO to create details.

■ Use AO for detail enhancement together with existing indirect lighting methods such as Final Gathering or photons.

The latter method is especially interesting when using a highly smoothed indirect illumination solution, such as a high photon radius or an extremely low final gather density, which could otherwise lose small details. By applying the AO with short rays these details can be brought back.
Round Corners

Computer-generated imagery tends to look unrealistic, partly because edges of objects are geometrically sharp, whereas most edges in the real world are slightly rounded, chamfered, worn, or filleted in some manner. This rounded edge tends to “catch the light” and create highlights that make edges more visually appealing.

The Arch & Design material can create the illusion of rounded edges at render time. This feature is intended primarily to speed up modeling, so that you need not explicitly fillet or chamfer edges of objects such as a tabletop.

![Left: No round corners; Right: Round corners](image)

The function is not a displacement; it is merely a shading effect, like bump mapping, and is best suited for straight edges and simple geometry, not advanced, highly curved geometry.

Performance Features

Finally, the Arch & Design material contains a large set of built-in functions for optimal performance, including but not limited to:

- Advanced importance sampling with ray rejection thresholds
- Adaptive glossy sample count
- Interpolated glossy reflection/refraction with detail enhancements
- Ultra-fast emulated glossy reflections (Highlights+FG Only mode)
- The option to ignore internal reflections for glass objects
- The choice between traditional transparent shadows, suitable for objects such as a window pane, and refractive caustics, suitable for solid glass objects, on a per-material basis.
Arch & Design Material (mental ray): Tips and Tricks

This topic contains information to help you more effectively use the Arch & Design material on page 5858 for mental ray.

See also:

- Arch & Design Material (mental ray): Overview on page 5893
- Arch & Design Material (mental ray) on page 5858

Final Gather Performance

The final gather algorithm in mental ray 3.5 is vastly improved from earlier versions, especially in its adaptiveness. This means you can often use much lower ray counts and much lower densities than in previous versions of mental ray.

In many cases, you can render still images with such extreme settings as 50 rays and a density of 0.1. If this causes “oversmoothing” artifacts, you can use the built-in ambient occlusion on page 5878 to solve those problems.

When using final gather together with GI (photons), make sure the photon solution is fairly smooth by first rendering with Final Gather disabled first. If the photon solution is noisy, increase the photon search radius until it “calms down,” and then enable Final Gather.

Quick Guide to Some Common Materials

Following are some quick rules of thumb for creating various materials. Each assumes the basic default settings as a starting point.

General Rules of Thumb for Glossy Wood, Flooring, and So On

These are the kind of “hybrid” materials you might require for architectural renderings; lacquered wood, linoleum, etc.

For these materials, set BRDF to Custom Reflectivity Function; that is, you'll define a custom BRDF curve. Start out with 0 degree reflectivity of 0.2, 90 degree reflectivity of 1.0, and apply a suitable texture map to the Diffuse Color. Set Reflectivity between 0.6 and 1.0.
How glossy is the material? Are reflections clear or blurry? Are they strong or weak?

- For clear, fairly strong reflections, keep Reflection Glossiness at 1.0.
- For slightly blurry but strong reflections, set a lower Reflection Glossiness value. If performance becomes an issue try turning on Fast (interpolate).
- For slightly blurry but also very weak reflections, you can “cheat” by applying a lower Reflection Glossiness value for broader highlights while setting Reflection Glossy Samples to 0. This shoots only one mirror ray for reflections, but if they are very weak, the viewer can often not really tell.
- For moderately blurry surfaces, set an even lower Reflection Glossiness value and maybe increase the Reflection Glossy Samples value. Again, for improved performance turn on Fast (interpolate).
- For extremely blurry surfaces or surfaces with very weak reflections, try turning on Highlights+FG Only.

A typical wooden floor could use Reflection Glossiness of 0.5, Reflection Glossy Samples of 16, Reflectivity of 0.75, a nice wood texture for Diffuse Color, perhaps a slight bump map. If bumpiness should appear only in the lacquer layer, turn on Special Purpose Maps rollout > Do Not Apply Bumps To The Diffuse Shading.

Linoleum flooring could use the same settings but with a different texture and bump map, and probably with slightly lower Reflectivity and Reflection Glossiness values.

**Ceramics**

Ceramic materials are glazed; that is, they’re covered by a thin layer of transparent material. They follow rules similar to the general materials mentioned above, but set the BRDF method on page 5871 to By IOR (fresnel reflections) and set IOR to about 1.4 and Reflectivity to 1.0.

Set the Diffuse Color to a suitable texture or color, such as white for white bathroom tiles.

**Stone Materials**

A stone object usually has a fairly matte finish, or has reflections that are so blurry they are nearly diffuse. You can simulate the “powdery” character of stone with the Diffuse Roughness parameter; try 0.5 as a starting point. Porous stone such as brick would have a higher value.
Stone would have a very low Reflection Glossiness (lower than 0.25) and one can most likely use Highlights+FG Only to good effect for very good performance. Use a nice stone texture for Diffuse Color, some kind of bump map, and perhaps a map that varies the Reflection Glossiness value.

The Reflectivity would be around 0.5-0.6 with By IOR (fresnel reflections) off and 0 degree reflectivity at 0.2 and 90 degree reflectivity at 1.0

**Glass**

Glass is a dielectric, so By IOR (fresnel reflections) should definitely be on. The IOR of standard glass is 1.5. Set Diffuse Level to 0.0, Reflectivity to 1.0 and Transparency to 1.0. This is enough to create basic, completely clear refractive glass.

If this glass is for a window pane, turn Thin-walled on. If this is a solid glass block, turn Thin-walled off and consider if caustics are necessary or not, and set Refractive Caustics accordingly.

If the glass is frosted, set Refraction Glossiness to a suitable value. Tune the Refraction Samples for good quality or turn on Fast (interpolate) for performance.

**Colored Glass**

For clear glass, use the tips in the preceding section. Colored glass, however, is a different story.

Many shaders set the transparency at the surface of the glass. And indeed this is what happens if one simply sets a Refractive Color to some value, such as blue. For glass with Thin-walled turned on this works perfectly. But for solid glass objects this is not an accurate representation of reality.

The scene in following illustration contains two glass blocks of different sizes, a sphere with a spherical hole inside it, and a glass horse.

*NOTE* The spherical hole was created by inserting a second sphere with its normals flipped inside the outer sphere. Don’t forget to flip the normals of such surfaces or they will not render correctly.
The problems are evident:

- The two glass blocks are of different thicknesses, yet they are exactly the same level of blue.
- The inner sphere is darker than the outer one.

Why does this happen?

Consider a light ray that enters a glass object. If the color is located at the surface, the ray is colored somewhat as it enters the object, retains this color through the object, and receives a second coloration (attenuation) when it exits the object:
Diagram for glass with color changes at the surface

In the above illustration the ray enters from the left, and at the entry surface it drops in level and gets slightly darker (the graph illustrates the level schematically). It retains this color throughout its travel through the medium and then drops in level again at the exit surface.

For simple glass objects this is quite sufficient. For any glass using Thin-walled on page 5885 it is by definition the correct thing to do, but for any complex solid it is not. It is especially wrong for negative spaces inside the glass (like the sphere in our example) because the light rays have to travel through four surfaces instead of two, getting two extra steps of attenuation at the surface.

In real colored glass, light travels through the medium and is attenuated as it goes. In the Arch & Design material this is accomplished by turning on
Advanced Rendering Options > Refraction > Max Distance, setting the Color At Max Distance, and setting the Refraction Color to white. This is the result:

Glass with color changes within the medium

The result is clearly much more satisfactory: The thick glass block is a deeper blue than the thin one, and the hollow sphere now looks correct. In diagram form it looks as follows:
### d=Max Distance where attenuation is Color at Max Distance

The ray enters the medium and is attenuated throughout its travel. The strength of the attenuation is such that precisely the Max Distance (d in the figure) the attenuation matches that of Color At Max Distance. In other words, at this depth the attenuation is the same as was received immediately at the surface with the previous scene. The falloff is exponential, so at double the Max Distance value the effect is that of Color At Max Distance squared, and so on.

There is one minor tradeoff:

To render the shadows of a material correctly using this method, you must either use caustics or make sure mental ray is rendering shadows in Segments mode (see Shadows & Displacement Rollout (mental ray Renderer) on page 6756).
Using caustics naturally gives the most correct-looking shadows (the above image was rendered without caustics), but requires that the scene has caustic photons enabled and contains a physical light source that shoots caustic photons.

On the other hand, the mental ray Segments shadows have a slightly lower performance than the more widely used Simple shadow mode. But if it is not used, the shadow intensity will not take the attenuation through the media into account properly. However, the image might still look pleasing.

**Water and Liquids**

Water, like glass, is a *dielectric* with an IOR of 1.33. Hence, the same principles as for glass (above) apply to bodies of water, which truly need to refract their environment. An example is water running from a tap. Colored liquids use the same principles as colored glass.

To create a liquid in a container, as in the preceding image, it is important to understand how the Arch & Design material handles refraction through multiple surfaces vs. the real-world behavior of light in such circumstances.

What is important for refraction is the transition from one medium to another with a different IOR. Such a transition is known as an *interface*.

For lemonade in a glass, imagine a ray of light travelling through the air (IOR=1.0). When it enters the glass, it is refracted by the IOR of the glass (1.5). The ray then leaves the glass and enters the liquid; that is, it passes through an interface from a medium of IOR 1.5 to another medium of IOR 1.33.
One way to model this in computer graphics is to make the glass one separate closed surface, with the normals pointing outward from the surface of the glass and an IOR of 1.5, and a second, closed surface for the liquid, with the normals pointing outward and an IOR of 1.33, leaving a small air gap between the container and the liquid.

This approach works, but can cause a problem: When light goes from a higher IOR to a lower there is a chance of an effect known as total internal reflection (TIR). This is the effect you see when diving into a swimming pool and then looking up: You can see the objects above the surface only in a small circle straight above. Anything below a certain angle shows only a reflection of the pool and things below the surface. The larger the difference in the IOR of the two media, the greater the chance of TIR.

So in our example, as the ray goes from glass (IOR=1.5) to air, there is a large chance of TIR. But in reality the ray would move from a medium of IOR=1.5 to one of IOR=1.33, which is a much smaller step with a much smaller chance of TIR. This looks different:

![Left: Correct refraction; Right: the “air gap” method](image)

The result on the left is the correct one, but how it is obtained?

The solution is to rethink the modeling, and not to think in terms of media, but in terms of interfaces. In our example, we have three different interfaces, where we can consider the IOR as the ratio between the IORs of the outside and inside media:

- air-glass interface (IOR=1.5/1.0=1.5)
- air-liquid interface (IOR=1.33/1.0=1.33)
- glass-liquid interface (IOR=1.33/1.5=0.8)

In the most common case of an interface with air, the IOR to use is the IOR of the media (because the IOR of air is 1.0), whereas in an interface between two different media, the situation is different.

To correctly model this scenario, then, we need three surfaces, each with a different Arch & Design material applied:

- the air-glass surface (blue), with normals pointing out of the glass, covering the area where air directly touches the glass, having an IOR of 1.5
- the air-liquid surface (green), with normals pointing out of the liquid, covering the area where air directly touches the liquid, having an IOR of 1.33
- the glass-liquid surface (red), with normals pointing out of the liquid, covering the area where the glass touches the liquid, having an IOR of 0.8

The three interfaces for a liquid in a glass

By setting suitable Max Distance and Color At Max Distance values for the two liquid materials (to get a colored liquid), we obtain the glass on the left in the preceding rendered image.

**Ocean and Water Surfaces**

A water surface is a slightly different matter than a visibly transparent liquid. The ocean isn’t blue; it is reflective. Not much of the light that penetrates the surface of the ocean gets anywhere of interest. A small amount of light is scattered back up again, doing a bit of literal subsurface scattering.

To make an ocean surface with the Arch & Design material, follow these steps:
1 Set Diffuse Level to 0.0, Reflectivity to 1.0, and Transparency to 0.0. That's right: No refraction is necessary.

2 Set IOR to 1.33 and turn on By IOR (fresnel reflections). Apply an interesting wobbly shader to Bump (Ocean (lume) works well here) and your ocean is basically done.

This ocean has reflections guided only by the IOR. But this might work fine; try it. Just make sure there is something there for it to reflect. Add a sky map, objects, or a just a blue gradient background. There must be something or it will be completely black.

The ocean isn’t blue; the sky is.

For a more tropical look, try setting Diffuse Color to a slightly blue-green color, set the Diffuse Level to a fairly low number such as 0.1, and turn on Do Not Apply Bumps To The Diffuse Shading.

Now you have a base color in the water that emulates the small amount of scattering that occurs in the top level of the ocean.
Enjoy the tropics.

**Metal**

Metals are reflective, which means they need something to reflect. The best looking metals come from having a true HDRI environment, either from a spherically mapped HDRI photo, or something like the mental ray physical sky.

To create classic chrome, turn off By IOR (fresnel reflections), set Reflectivity to 1.0, 0 degree reflectivity to 0.9 and 90 degree reflectivity to 1.0. Set Diffuse Color to white, and turn on Metal Reflections.

This creates an almost completely reflective material. Tweak the Reflection Glossiness parameter for various levels of blurry reflections. Also consider using the **Round Corners effect** on page 5881, which tends to work very well with metallic objects.

Metals also influence the color of their reflections. Because you turned on Metal Reflections, this is already happening; try setting the Diffuse Color to a golden color to create gold.

Try various levels of Reflection Glossiness (with the help of Fast (interpolate) for performance, when necessary).

You can also change the Reflectivity value. This has a slightly different meaning when Metal Material is on; it blends between the reflections (colored by the Diffuse Color) and normal diffuse shading. This allows a blend between the glossy reflections and the diffuse shading, both driven by the same color. For
example, an aluminum material would need a bit of diffuse blended in, whereas chrome would not.

![Gold, silver, and copper](image)

**Brushed Metal**

Brushed metal is an interesting special case. In some cases, creating a brushed metal requires only turning down the Reflection Glossiness to a level where you obtain a very blurred reflection. This is sufficient when the brushing direction is random or the brushes are too small to be visible even as an aggregate effect.

For materials that have a clear brushing direction and/or where the actual brush strokes are visible, creating a convincing look is slightly more involved. The tiny grooves in a brushed metal surface all work together to cause anisotropic reflections. This can be illustrated by the following schematic, which simulates the brush grooves by modeling many tiny adjacent cylinders, shaded with a simple Phong shader:
Many small adjacent cylinders

As you can see, the specular highlights in the cylinders work together to create an aggregate effect which is the anisotropic highlight.

Also note that the highlight isn’t continuous; it is actually broken up into small, adjacent segments. So the primary visual cues that a material is brushed metal are:

- Anisotropic highlights that stretch out in a direction perpendicular to the brushing direction
- A discontinuous highlight with breaks in the brushing direction

Many attempts to simulate brushed metals have looked only at the first effect: the anisotropy. Another common mistake is to think that the highlight stretches in the brushing direction. Neither is true.

Hence, to portray brushed metals, it is necessary to simulate these two visual cues. The first is simple: Use Anisotropy and Anisotropy Rotation to make anisotropic highlights. The second can be done in several ways:

- with a bump map
- with a map that varies the Anisotropy or Reflection Glossiness values
- with a map that varies the Reflection Color
Each has advantages and disadvantages, but the one we suggest here is the last one. The reason for choosing this method is that it works well with interpolation.

1. Create a map for the brush streaks. The possible ways to do this include painting a map in a paint program, or using a Noise map that has been stretched heavily in one direction. The map should vary between middle-gray and white.

2. Apply this map to the Reflection Color in a scale suitable for the brushing.

3. Set Diffuse Color to white (or the color of the metal) but set Diffuse Level to 0.0 (or a small value).

4. Make sure Metal Material is on.

5. Set Reflection Glossiness to 0.75.

6. Set Anisotropy to 0.1 or a similar value. Use Anisotropy Rotation to align the highlight properly with the map. If necessary use Anisotropy Channel to base it on the same texture space as the map.

---

**Special-Purpose mental ray Materials**

The mental ray materials described in this section have more specific uses than ProMaterials or the Arch & Design material.
Car Paint Material/Shader (mental ray)

Material Editor > Type button > Material/Map Browser > Car Paint Material
Material Editor > any material > Click a Map button. > Material/Map Browser > Car Paint Shader

Note: The Car Paint material and shader appear in the Browser only if the mental ray renderer is the currently active renderer.

Car Paint has components for a paint layer with embedded metal flakes, a clear-coat layer, and a Lambertian dirt layer.

Car Paint is available as both a mental ray material and shader; both have identical parameters, and support the following unique characteristics of real-world car paint:

- The lowest surface, applied directly to the car body, is a thin layer of pigment. The properties of this layer are such that the perceived color changes depending on the viewing angle as well as the incident angle of the incoming light.

- Tiny metal flakes are suspended within this layer. The flakes reflect light and can be seen glittering on a sunny day, due to individual flakes reflecting sunlight directly at the observer.

- On top of this is a clear-coat layer, which can be more or less reflective and more or less glossy, depending on the quality of the layer and any added wax coating. Most notably, this layer tends to exhibit a pronounced Fresnel effect, reflecting more light at glancing angles.

- An optional, topmost Lambertian dirt layer can help give an "unwashed" look.
Interface

Diffuse coloring rollout

Ambient/Extra light The ambient light component.

**NOTE** This parameter is treated differently from the ambient/ambience parameter pair of many other base shaders in that it is influenced by the additional Diffuse Coloring parameters, and hence represents incoming light, rather than the object's "ambient color."

Base color The base diffuse color of the material.

Edge color The color seen at glancing angles (that is, edges), which tends to appear much darker. For deep metallic paints seen on sports cars it tends to be almost black.
**Edge bias** The falloff rate of the color towards the edge. Higher values make the edge region narrower; lower values make it wider. The useful range is 0.0 to approximately 10.0, where the value 0.0 turns the effect off.

Color shift due to view angle, shifting between a red base color and a blue edge color (atypical colors chosen for demonstration purposes) with varying Edge Bias values

**Light facing color** The color of the area facing the light source.

**Light facing color bias** The falloff rate of the color towards the light. Higher values make the colored region facing the light smaller/narrower; lower values make it larger/wider. The useful range is 0.0 to approximately 10.0, where the value 0.0 turns the effect off.

Color shift due to view angle, shifting between a red base color and a green light facing color (atypical colors chosen for demonstration purposes) with varying Light Facing Color Bias values

**Diffuse weight** Controls the overall level of the Diffuse Coloring parameters.

**Diffuse bias** Modifies the falloff of the diffuse shading. Higher values push the diffuse peak towards the light source, and lower values flatten the diffuse peak. The useful range is approximately 0.5 to 2.0, where 1.0 represents standard Lambertian shading.
Flakes rollout

**Flake color** The color (reflectivity) of the flakes, which is generally white.

**Flake weight** A scalar multiplier for the flake color.

**Flake reflections (ray traced)** The amount of ray-traced reflection in the flakes, which allows glittery reflections of, for example, an HDRI environment. The value 0.0 turns the effect off.
This effect should generally be very subtle; a value of 0.1 is often enough. The final intensity of reflections also depends on the Flake Color and Flake Weight values.

**Flake specular exponent** The Phong specular exponent for the flakes.

**Flake density** The density of the flakes. The useful range is from 0.1 to approximately 10.0, where lower values indicate sparser flakes and higher values indicates denser flakes.

**Flake decay distance** The distance at which the influence of the flakes fades out. A value of 0.0 disables fading. Any positive value causes the Flake Weight value to be modulated so that it reaches zero at this distance.

Because flakes are relatively small, using can introduce rendering artifacts if their visual density becomes significantly smaller than a pixel. If the oversampling of the rendering is set high, small flakes can also potentially trigger massive oversampling and hence overlong rendering times needlessly, because the averaging caused by the oversampling will essentially cancel out the flake effect. If you experience these issues, use Flake Decay Distance to counteract them.
Flakes at different distances with no flake decay. The farthest flakes might cause flicker in animations, or trigger unnecessary oversampling and long render times (rendered here with low oversampling for illustrative purposes).

Using flake decay. The flake strength diminishes with distance. The same intentionally low oversampling as in the previous image has been used.

**Flake strength** The difference between the orientation of the flakes. The useful range is 0.0 to 1.0 where 0.0 means that all flakes are parallel to the surface, while higher values vary the orientation of flakes increasingly.

**Flake scale** The size of the flakes. The procedural texture is calculated in object space, and will hence follow the object. Thus, the scale is influenced by any scale transformation on the object.
**Specular reflections rollout**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Specular Color #1</strong></td>
<td>The color of the primary specular highlight.</td>
</tr>
<tr>
<td><strong>Specular Weight #1</strong></td>
<td>A scalar multiplier applied to Specular Color #1.</td>
</tr>
<tr>
<td><strong>Specular exponent #1</strong></td>
<td>The Phong exponent of Specular Color #1.</td>
</tr>
<tr>
<td><strong>Specular Color #2</strong></td>
<td>The color of the secondary specular highlight.</td>
</tr>
<tr>
<td><strong>Specular Weight #2</strong></td>
<td>A scalar multiplier applied to Specular Color #2.</td>
</tr>
<tr>
<td><strong>Specular exponent #2</strong></td>
<td>The Phong exponent of Specular Color #2.</td>
</tr>
<tr>
<td><strong>Glazed specularity #1</strong></td>
<td>Enables a special mode on the primary specular highlight called <em>glazing</em>. By applying a threshold to the specular highlight, it makes the surface appear more polished and shiny. For a new sports car with a lot of wax, turn this on. For a beat-up car in the junkyard, turn it off.</td>
</tr>
</tbody>
</table>

**Left to right:** Flake specularity only; standard specularity; "glazed" mode enabled; "glazed" mode specularity with flakes
Reflectivity rollout

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reflection color</td>
<td>The color of the reflections in the clear-coat layer. This is generally white.</td>
</tr>
<tr>
<td>Edge factor</td>
<td>Clear coat tends to reflect more at glancing angles (edges). This parameter defines the &quot;narrowness&quot; of this edge.</td>
</tr>
<tr>
<td>Edge reflections weight</td>
<td>The reflective strength at the edge (generally 1.0).</td>
</tr>
<tr>
<td>Facing reflections weight</td>
<td>The reflective strength at facing angles (generally low: 0.1 - 0.3).</td>
</tr>
<tr>
<td>Glossy reflection samples</td>
<td>Enables a glossy clear coat. This parameter sets the number of glossy reflection rays traced. A value of 0 disables glossiness.</td>
</tr>
<tr>
<td>Glossy reflections spread</td>
<td>Sets the amount of glossiness. Cars are generally near-mirrors so this value should be kept small.</td>
</tr>
<tr>
<td>Max distance</td>
<td>Limits the reach of reflective rays.</td>
</tr>
<tr>
<td>Single environment sampling</td>
<td>Optimizes lookup of environment maps.</td>
</tr>
</tbody>
</table>
Dirty layer (lambertian) rollout

Real cars are rarely clean. This shows the dirt layer (hand-painted dirt-placement map), including a bump map applied in the dirty regions.

A simple Lambertian dirt layer covers the underlaying paint and clear-coat layers.

<table>
<thead>
<tr>
<th>Dirty layer (lambertian)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dirt color</td>
</tr>
</tbody>
</table>

Dirt color The color of the dirt.

Dirt weight The amount of dirt in the layer. This is typically connected to a texture shader to obtain variations in the dirt across the surface. If the value is 0.0, no dirt is added.

Advanced options rollout

<table>
<thead>
<tr>
<th>Advanced options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Irradiance weight (direct illumination)</td>
</tr>
<tr>
<td>Global weight</td>
</tr>
</tbody>
</table>
Irradiance weight (indirect illumination) The influence of indirect light (photons and final gathering) on the surface. It is internally divided by pi (3.14159); for example, a value of 1.0 means the standard 1.0/pi weight.

Global weight A global tuning parameter that affects the entire diffuse, flake, and specular subsystems. It does not affect reflections or dirt.

Shaders rollout

This rollout enables application of maps or shaders to any of the Car Paint parameters. Of course, you can apply a shader to a parameter by clicking its Map button, so the principal value of this rollout is that it also lets you toggle a parameter's shader, using the check box, without removing the map.

Matte/Shadow/Reflection (mi) Material

Material Editor > Type button > Material/Map Browser > Matte/Shadow/Reflection (mi)

Note: The Matte/Shadow/Reflection (mi) material appears in the Browser only if the mental ray renderer is the currently active renderer.

The Matte/Shadow/Reflection (mi) material, part of the Production Shaders on page 6434 library, is used to create “matte objects”; that is, objects that represent real-world objects in a photograph used as the scene background (also known as the plate). The material provides a wealth of options for marrying a photographic background with the 3D scene, including support for bump mapping, ambient occlusion, and indirect illumination.

Applications include:

- Blocking another 3D object from the camera view, thus allowing the 3D object to appear to be behind the object in the photo.
- Allowing 3D objects to cast shadows and occlusion on and receive shadows from objects in the photo.
- Adding reflections of 3D objects to objects in the photo.
- Allowing the interplay of indirect light between 3D objects and objects in the photo.

In all these cases the material is applied to a matte object that represents an object in the background plate, and the 3D object uses a traditional material.
For additional information, see Help menu > Additional Help > mr Production Shader Library > Matte/Shadow Objects and CameraMaps, as well as the Tech Note (following).

**Tech Note**

The Matte/Shadow/Reflection shader works by doing a form of differential shading. In other words, it determines the amount of light a point would receive if it were not in shadow, compares it to the amount of light the point actually receives, and shades it by the relative difference.

This means that any point that is fully lit, unshadowed by any object, returns the same color it already had, completely disregarding the actual intensity of that light. If half of the incoming light is blocked, the point will be shaded at 50 percent intensity, regardless of the full-intensity amount in an absolute sense.

An important feature of the Matte/Shadow/Reflection material is that it is non-self-shadowing, non-self-occluding, non-self-reflecting, and does not cast indirect light onto itself. Because it is designed to act as a stand-in for objects present in a photographic plate, which already contains self-shadowing, self-reflection, and so on, the material automatically excludes these effects. However, it is still able to cast shadows on other objects, receive shadows from other objects, reflect other objects, and so on, without creating unwanted double shadows or double reflections for such effects already present in the plate.

**Procedure**

This multi-part procedure provides step-by-step instructions for a simple case of combining a 3D object with a photograph using the Matte/Shadow/Reflection material, the Environment/Background Camera Map shader, and the Environment Probe/Chrome Ball shader.

Prerequisites:

- A photo of a background
A photo of a chrome ball, also known as a light probe, shot from the same camera angle and cropped so the edges touch the image.
Ideally, these should be HDR photos, but non-HDR images can also work well.

To use the production shaders to marry a 3D scene with a photographic background:

1. First set up the viewport:
   1. Make sure mental ray is the active renderer.
   2. Activate a Perspective viewport.
   3. Use Viewport Background on page 128 to set the background image (see the procedure introduction, above).
   4. On the Viewport Background dialog, make sure both Display Background and Match Rendering Output are on.
5 Click OK to continue.

2 Open the Environment And Effects dialog to the Environment panel (press 8).

3 On the Common Parameters rollout, click the Environment Map button (reads “None”).

4 From the list that opens, choose Environment/Background Switcher (mi).

5 Open the Material Editor.

6 Drag the Environment Map button from the Environment And Effects dialog to a sample slot in the Material Editor. Use the Instance option.

7 On the Material Editor > Environment/Background Switcher (mi) Parameters rollout, click the Background map button (all the way to the right of the parameter).

8 From the list that opens, choose Environment/Background Camera Map (mi).

9 On the Environment/Background Camera Map (mi) Parameters rollout, click the Browse button and again open the background image.

10 In the Material Editor, click the Go To Parent button to return to the Switcher map.

11 Click the map button to the right of Environment/Reflections.

12 From the list that appears, choose Environment Probe/Chrome Ball (mi).

13 On the Environment Probe/Chrome Ball (mi) Parameters rollout, click the Browse button and open the image containing the cropped photo of the chrome ball.

   If the two photos have different exposures, use the Multiplier setting for either or both maps to match them.

   Next you’ll make a rudimentary model that represents objects already present in the background. At the very least you need a simple plane for the “ground” to place things on.

**NOTE** It is easier to see if you maximize the viewport and use wireframe display mode.
14 Align the viewport so it matches the angle of the photograph as closely as possible.

15 From the Create menu, choose Lights > Standard Lights > Skylight and then click in the Perspective viewport to add a Skylight to the scene.

16 On the Skylight Parameters rollout for the light, set Sky Color to Use Scene Environment.

This retrieves the appropriate ambient color from the chrome ball photo.

17 Create some geometry. For this example, add a plane to represent the ground.

18 Add a teapot on top of the plane. You’ll use this temporarily to tune the shadows.

19 In the Material Editor, create an Arch & Design material, change the color to white, and apply it to the teapot.

20 Select the ground plane.

Next you’ll set up the Matte/Shadow/Reflection material.

21 In the Material Editor, activate the existing Environment/Background Switcher map.

22 Right-click the Background map button and choose Copy.

23 Activate an unused sample sphere and create a new Matte/Shadow/Reflection material.

24 On the Matte/Shadow/Reflection Parameters rollout, right-click the Camera Mapped Background map button and choose Paste (Instance).

This places the same background map that is used in the environment switcher into the background map in the material as an instance.

This completes the basic setup. If you render now, you should see the teapot superimposed over the background image. The teapot should have a soft shadow underneath, which comes from the ambient occlusion.
Part 2: Marrying 3D with a photo:

Now you’ll tune the lighting in the scene. Generally you need at least one key light to cast a directional shadow.

1  Add a light source such as mr Area Omni and place it in a location similar to where the main light seems to be coming from in the photo.

2  Tune the light so that the lighting direction and intensity on the teapot seems reasonable compared to the objects in the photo, and so the shadow directions seem to match. For now, ignore the shadow intensity; just consider the lighting on the teapot itself.
3  Now tune the overall intensity of the shadow with the Ambient/Shadow Intensity parameter to match existing shadows in the photo. If the shadow needs tinting, use the Ambient/Shadow Color setting. You might also need to modify the AO Max Distance value to make contact shadows more or less pronounced.

4  You can adjust the shadow softness with the mr Area Omni light’s Radius setting, on the Area Light Parameters rollout.
The scene is now set up, although further tuning might be necessary.

5  Delete the teapot.
6  Add any objects you want to use to the scene.
7  Add any additional stand-in matte objects that you can use to occlude objects, receive and cast shadows, etc., to the scene, and apply the same Matte/Shadow/Reflection material to them.
Part 3: Prepare for compositing:

So far the rendered 3D content has been added on top of the background directly in the renderer. Generally, you want to do this in an external compositing program, as follows:

1. Open the Material Editor.
2. Activate the Environment/Background Switcher shader (the one you instanced from the Environment panel).
3. Right-click the Background map button and choose Cut.
4. Click the color swatch next to Background and make sure the color is transparent black; in other words, Red, Green, Blue, and Alpha all equal 0.0. These are the default values, so no changes should be necessary. Close the Color Selector dialog.
5. Activate the Matte/Shadow/Reflection material and cut the Camera Mapped Background map.
6. To the Matte/Shadow/Reflection material > Camera Mapped Background map, apply a new Environment/Background Switcher shader.
7 Right click the Environment/Reflection map button (not the Background map button) and choose Paste (Instance) to apply the previously used map.

8 Click the Background color swatch and make sure the color is transparent black as well.

The scene now contains two Switcher nodes: one used in the environment (switching between transparent black and the chrome ball) and one in the material (switching between transparent black and the camera map).

If you render now, the resulting image still properly contains all the reflections, light, etc., from the background, but not the background itself. Shadows exist in the alpha channel, so the image is suitable for compositing directly on top of the background image.

A Note on Gamma

The foregoing procedure does not cover gamma.

If you use a gamma-correct workflow, which yields a superior result, with literal mental ray textures (that is, you use the big Browse button to refer directly to a bitmap file, rather than inserting a Bitmap map), you must set
the gamma of this bitmap explicitly in the appropriate Reverse Gamma Correction parameters.

**NOTE** Intentionally exaggerating the Reverse Gamma Correction setting on the chrome ball photo can turn a low-dynamic-range photo into a “faux” HDR image by artificially exaggerating its contrast.

**Interface**

**Matte/Shadow/Reflection Parameters rollout**

![Matte/Shadow/Reflection Parameters rollout](image)

**Camera Mapped Background** Sets the color or map for the matte material. To use the scene background, click the map button, browse from the scene, and choose the background map.

**NOTE** Unlike the standard Matte/Shadow material on page 6099, this material does not automatically pick the background (that is, the scene environment) as its color; rather, it's necessary to provide the background explicitly. There are several ways to do this:

- The most common method is to use a screen-projected map. However, using a Bitmap map with Screen environment mapping will not work correctly, because it does not handle reflections correctly. Instead, for this purpose, we recommend using the Environment/Background Camera Map shader on page 6437. This shader projects the texture back from the current rendering camera.

- Alternatively, you can apply the color in any applicable UV texture space, perhaps if you previously projected the texture into that texture space.

- A third option is to project the background at render time with the Camera Map Per Pixel map on page 6452.

**Mask/Opacity** The opacity of the material.
**TIP** One use case for the Mask/Opacity setting on page 5941 is to refine a rough stand-in object. For example, the plate might contain a person’s arm, and you want to put in a CG object that goes behind the person’s arm and/or has shadows thrown onto it by the person’s arm. You could create simple stand-in geometry (maybe even a cylinder) and then use a screen-projected opacity map that defines the exact edges of the arm. Also, if the arm in the plate is motion-blurred or out of focus, you can feather the opacity mask accordingly.

**Bump** Specifies a bump map for the material.

**Bump Amount** The multiplier for the bump map.

**Shadows rollout**

**Receive Shadows** When on, the surface can receive shadows. If Shadow Casting Lights List is off, all lights cast shadows on the surface.

**Ambient/Shadow Intensity** The amount of environmental light in the scene, which in a practical sense is how dark the shadows are. The Matte/Shadow/Reflection material does not use Skylights to generate shadows; any such shadows must come from the ambient occlusion feature. So when the shader is used together with a Skylight, this value should be similar to the level of light the Skylight provides.

The units value for this setting depends on the lighting unit. If you use the mr Photographic Exposure Control on page 7219, and set Physical Scale to Physical Units (cd/m²), this value will be in physical values, and might need to be in the hundreds (or thousands for an outdoor shot lit by mental ray Sun...
& Sky on page S513). However, if you don’t use the exposure control, or set it Physical Scale to Unitless, this parameter is in a "traditional" unit space where 0 is black and 1 is white.

**NOTE** This "ambient" light is affected by ambient occlusion, so it is darkened by the occlusion at contact points and in areas hidden under objects.

**Ambient/Shadow Color** Setting a color or map here tints the shadows. For accurate shadow tint, use a neutral color.

**Shadow Casting Lights List** When on, you can use the Add/Replace/Delete buttons to edit the list, specifying lights that are to cast shadows on the surface. For the lights list to be in effect, Receive Shadows must also be on.

When off, and Receive Shadows is on, all lights in the scene cast shadows on the surface.

**NOTE** Shadow-casting lights act as representations of any real-world lights in the background plate, such as the sun or any artificial light sources. For further information, see Direct Illumination rollout on page 5945, following.

### Ambient Occlusion rollout

- **Use Ambient Occlusion (AO)** When on, ambient occlusion affects the surface.

- **AO Samples** The number of ambient-occlusion rays that are shot.

- **AO Max Distance** The reach of ambient-occlusion rays. At 0, the ray distance is not limited. Using short rays increases performance but localizes the ambient-occlusion effect.

- **AO Shadow Strength** The darkness of shadows the ambient occlusion causes. The default value is black, but you can cause a less-pronounced shading effect by using a lighter color.
Reflections rollout

Receive **Reflections** When on, the surface reflects its surroundings.

**Reflection Color** Reflections are tinted this color. For accurate reflections, use a neutral color.

**Reflections (Subtractive Color)** The subtractive color for reflections. This amount is removed from the plate before reflections are added. If black, nothing is removed, and reflections are added purely additively on top of the plate. If 50% gray, the plate pixels are attenuated to 50% of their intensity, and the reflections are added on top of that, and so on. Use this setting is used if the plate contains an area with many reflections that need to be removed before the new, synthetic reflection is added.

**Glossiness** The glossiness of reflections.

**Glossy Samples** The number of glossy-reflection samples.

**Max Distance** At values other than 0, limits the distance from which reflections are cast.

**Max Distance Falloff** The falloff curve for reflections at Max Distance. Lower values cause more rapid falloff.
**Indirect Illumination rollout**

![Indirect Illumination](image)

**Receive Indirect Illumination** When on, indirect light (final gather and global illumination) is gathered and scaled by the Indirect Illumination Multiplier value (see following).

**Indirect Illumination Multiplier** The multiplier for gathered indirect light.

**Direct Illumination rollout**

**NOTE** The lights specified on this rollout actually illuminate the background, unlike shadow-casting lights on page 5943. Thus, for the effect to be correct, make sure no light source exists in both lists.

![Direct Illumination](image)

**Receive Direct Illumination** When on, the surface renders where struck by direct illumination. If Illuminating Lights List is off, all lights in the scene illuminate the surface.

**Illuminating Lights List** When on, you can use the Add/Replace/Delete buttons to edit the list, specifying lights that are to illuminate the surface. For the lights list to be in effect, Receive Direct Illumination must also be on.
Maps Rollout

This rollout enables application of maps or shaders to the applicable material parameters. Of course, you can apply a shader to a parameter at its standard location in the user interface by clicking its map button (square button at the right side of the parameter), so the principal value of this rollout is that it also lets you toggle a parameter's shader, using the check box, without removing the map.

Subsurface Scattering (SSS) Materials

Material Editor > Type button > Material/Map Browser > Choose SSS Fast Material (mi), SSS Fast Skin Material (mi), SSS Fast Skin Material+Displace (mi), or SSS Physical Material (mi), and then click OK.

Note: The SSS materials appear in the Browser only if mental ray is the active renderer.

The subsurface scattering (SSS) materials are provided especially to model skin and other organic materials whose appearance depends on more than one layer of light scattering. 3ds Max provides four of these materials. Each material is a top-level wrapper (a “phenomenon”) for shaders whose controls are documented in the Standard mental ray Shader Libraries document. Click a link to see the mental images documentation for the shader.

**TIP** When you follow a link to the documentation for mental images library shaders, scroll up a bit in your browser. The links tend to go past the title of the section, and there might be introductory content above the link location. If the link goes to the beginning of a section, scroll down instead.

<table>
<thead>
<tr>
<th>Material Name</th>
<th>mi Library Shader Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>SSS Fast Material (mi)</td>
<td>misss_fast_simple_phen</td>
</tr>
<tr>
<td>SSS Fast Skin Material (mi)</td>
<td>misss_fast_skin_phen</td>
</tr>
<tr>
<td>SSS Fast Skin Material+Displace (mi)</td>
<td>misss_fast_skin_phen_d</td>
</tr>
<tr>
<td>SSS Physical Material (mi)</td>
<td>misss_physical</td>
</tr>
</tbody>
</table>
Also see Subsurface Scattering Shaders and the topics that follow it for more general information. See Physically Correct Subsurface Scattering for background information and tips about the Physical material.

**NOTE** The SSS Physical Material can also be used as a shader for the Surface and Photon components of a mental ray material on page 5951.

For a downloadable tutorial offering a practical demonstration of using the SSS Fast Skin material, see this Web page.

**Light Controls for the SSS Physical Material**

The SSS Physical material includes light controls that correspond to the *lights* array in the parameters for the `misss_physical` shader.

**Lights** When on, the material is illuminated only by those lights specified in the list. When Lights is turned off, all lights in the scene affect the material. Default=off.

The remaining light controls are available only when Lights is on.

- **List of lights** Displays the lights you have chosen to illuminate this material.

- **Add** Adds a light to the list. Click Add to turn it on, then click the light object in a viewport.

- **Replace** Replaces a light in the list. Highlight a light’s name in the list, click Replace to turn it on, then click the replacement light object in a viewport.

- **Delete** Deletes a light from the list. Highlight a light’s name in the list, then click Delete.

**Utility mental ray Materials**

The utility mental ray materials allow you to combine a material with multiple maps.

**Utility Bump Combiner Material (mental ray)**

Material Editor > Type button > Material/Map Browser > Utility Bump Combiner (adsk)
Note: The Bump Combiner material appears in the Browser only if the mental ray renderer is the currently active renderer.

The Bump Combiner lets you combine a material with up to three separate bump maps.

**Interface**

**Parameters rollout**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Shading</strong></td>
<td>Click the button to specify a base material. This can be any material that mental ray supports.</td>
</tr>
<tr>
<td><strong>Global Multiplier</strong></td>
<td>Adjusts the strength of bump mapping for the material as a whole. This value overrides the individual bump map multiplier values. Can range from 0.0 to 20.0. Default=1.0.</td>
</tr>
<tr>
<td><strong>Bump 1</strong></td>
<td>Click to add a bump map to the material.</td>
</tr>
<tr>
<td><strong>Multiplier</strong></td>
<td>Adjusts the strength of the bump map. Can range from 0.0 to 20.0. Default=1.0.</td>
</tr>
<tr>
<td><strong>Bump 2</strong></td>
<td>Click to add a bump map to the material.</td>
</tr>
<tr>
<td><strong>Multiplier</strong></td>
<td>Adjusts the strength of the bump map. Can range from 0.0 to 20.0. Default=1.0.</td>
</tr>
<tr>
<td><strong>Bump 3</strong></td>
<td>Click to add a bump map to the material.</td>
</tr>
<tr>
<td><strong>Multiplier</strong></td>
<td>Adjusts the strength of the bump map. Can range from 0.0 to 20.0. Default=1.0.</td>
</tr>
</tbody>
</table>

**Shading** Click the button to specify a base material. This can be any material that mental ray supports.

**Global Multiplier** Adjusts the strength of bump mapping for the material as a whole. This value overrides the individual bump map multiplier values. Can range from 0.0 to 20.0. Default=1.0.

**Map button** Click to apply a map to the Global Multiplier value.

**Bump 1, Bump 2, and Bump 3** Click to add a bump map to the material.

**Multiplier** Adjusts the strength of the bump map. Can range from 0.0 to 20.0. Default=1.0.

**Map button** Click to apply a map to the Multiplier value.
Maps rollout

<table>
<thead>
<tr>
<th>Maps</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Global Multiplier</td>
<td>None</td>
</tr>
<tr>
<td>Multiplier 1</td>
<td>None</td>
</tr>
<tr>
<td>Multiplier 2</td>
<td>None</td>
</tr>
<tr>
<td>Multiplier 3</td>
<td>None</td>
</tr>
</tbody>
</table>

Global Multiplier Lets you assign a map to the Global Multiplier. The toggle at the left controls whether the map is active; when you assign a map, it turns on by default.

Multiplier 1, Multiplier 2, and Multiplier 3 Let you assign maps to the three bump map Multiplier values.

The button to the right of each main shader button is for shaders that can return multiple parameters. If a shader that returns multiple parameters is assigned to the component, the button's tooltip shows the parameter name. Clicking the button displays a Connect Parameter To Shader dialog on page 6392, which lets you change which parameter is being used.

Utility Displace Combiner Material (mental ray)

Material Editor > Type button > Material/Map Browser > Utility Displace Combiner (adsk)

Note: The Displace Combiner material appears in the Browser only if the mental ray renderer is the currently active renderer.

The Displace Combiner lets you combine a material with up to three separate displacement maps.
Interface

Parameters rollout

Shading Click the button to specify a base material. This can be any material that mental ray supports.

Global Multiplier Adjusts the strength of displacement mapping for the material as a whole. This value overrides the individual displacement shader multiplier values. Can range from 0.0 to 20.0. Default=1.0.

Map button Click to apply a map to the Global Multiplier value.

Displace Shader 1, Displace Shader 2, and Displace Shader 3 Click to add a displacement map to the material.

Multiplier Adjusts the strength of the displacement map. Can range from 0.0 to 20.0. Default=1.0.

Map button Click to apply a map to the Multiplier value.

Maps rollout
Global Multiplier Lets you assign a map to the Global Multiplier. The toggle at the left controls whether the map is active; when you assign a map, it turns on by default.

Multiplier 1, Multiplier 2, and Multiplier 3 Let you assign maps to the three displacement shader Multiplier values.

The button to the right of each main shader button is for shaders that can return multiple parameters. If a shader that returns multiple parameters is assigned to the component, the button's tooltip shows the parameter name. Clicking the button displays a Connect Parameter To Shader dialog on page 6392, which lets you change which parameter is being used.

mental ray Material

Material Editor > Type button > Material/Map Browser > mental ray

Note: The mental ray material appears in the Browser only if the mental ray renderer is the currently active renderer.

The mental ray material lets you create a material exclusively for use by the mental ray renderer on page 6675. The mental ray material has components for the surface shader, and for the other nine optional shaders that make up a material in mental ray.

**IMPORTANT** You must assign a shader to the material's Surface component. Otherwise, the mental ray material will not be visible when you render.

Material Shaders Rollout (mental ray Material)

Material Editor > Type button > Material/Map Browser > mental ray > Material Shaders rollout

Note: The mental ray material appears in the Browser only if mental ray is the active renderer.

The Material Shaders rollout provides controls for the main kinds of component shaders you are likely to assign.

**IMPORTANT** You must assign a shader to the material's Surface component. Otherwise, the mental ray material will not be visible when you render.
See also:

- Advanced Shaders Rollout (mental ray Material) on page 5958

**Interface**

Each shader component has a toggle at the left of its name. When the toggle is on, the shader is used in rendering. When the toggle is off, the shader is not used, even if it has been assigned. Clicking the button to the right of the component name displays the Material/Map Browser on page 5724 so you can assign a particular shader to the component.

**Basic Shaders group**

**Surface** Shades the surface of objects that have this material.
In addition to any of the usual 3ds Max materials, the surface component can be assigned the following mental ray materials or shaders:

<table>
<thead>
<tr>
<th>Shader</th>
<th>Library</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ambient/Reflective Occlusion</td>
<td>base1 (see note, below)</td>
</tr>
<tr>
<td>Bump on page 6397</td>
<td>3ds Max</td>
</tr>
<tr>
<td>Car Paint Shader (mi) on page 5922</td>
<td>3ds Max</td>
</tr>
<tr>
<td>DGS Material on page 6398</td>
<td>3ds Max</td>
</tr>
<tr>
<td>Dielectric</td>
<td>base</td>
</tr>
<tr>
<td>Dielectric Material on page 6403</td>
<td>3ds Max</td>
</tr>
<tr>
<td>Edge</td>
<td>lume</td>
</tr>
<tr>
<td>Facade</td>
<td>lume</td>
</tr>
<tr>
<td>Glass</td>
<td>lume</td>
</tr>
<tr>
<td>Glow</td>
<td>lume</td>
</tr>
<tr>
<td>Landscape</td>
<td>lume</td>
</tr>
<tr>
<td>Material to Shader on page 6412</td>
<td>3ds Max</td>
</tr>
<tr>
<td>Metal</td>
<td>lume</td>
</tr>
<tr>
<td>mr Physical Sky on page 5532</td>
<td>3ds Max</td>
</tr>
<tr>
<td>Shader</td>
<td>Library</td>
</tr>
<tr>
<td>----------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Ocean</td>
<td>lume</td>
</tr>
<tr>
<td>Opacity</td>
<td>base</td>
</tr>
<tr>
<td>Reflect</td>
<td>base</td>
</tr>
<tr>
<td>Refract</td>
<td>base</td>
</tr>
<tr>
<td><strong>Shader List</strong> on page 6420</td>
<td>3ds Max</td>
</tr>
<tr>
<td>SSS Physical Material</td>
<td>subsurface scattering</td>
</tr>
<tr>
<td>Stain</td>
<td>lume</td>
</tr>
<tr>
<td>Texture Wave</td>
<td>base</td>
</tr>
<tr>
<td>Translucency</td>
<td>lume</td>
</tr>
<tr>
<td>Transmat</td>
<td>physics</td>
</tr>
<tr>
<td>Transparency</td>
<td>base</td>
</tr>
<tr>
<td>Two Sided</td>
<td>base</td>
</tr>
<tr>
<td><strong>UV Generator</strong> on page 6422</td>
<td>3ds Max</td>
</tr>
<tr>
<td>Water Surface</td>
<td>lume</td>
</tr>
<tr>
<td>Wet-Dry Mixer</td>
<td>lume</td>
</tr>
<tr>
<td><strong>XYZ Generator</strong> on page 6430</td>
<td>3ds Max</td>
</tr>
</tbody>
</table>
NOTE As of the current version of 3ds Max, the Ambient/Reflective Occlusion shader has been updated to support certain capabilities for texture baking (see this note on page 6853). If you load a file containing a material that uses the older version of the shader, that same version is still used in the scene, and the shader is renamed "Ambient/Reflective Occlusion (base) (old)". The old version of the shader continues to be used in the scene until you reapply it in the Material Editor.

NOTE Unlike a standard 3ds Max material, if you assign the Surface component a bitmap with tiling turned off, the original surface color does not “show through.” In renderings, you see only the untiled map, and none of the rest of the object.

**Shadow** Assigns a shadow shader.
The shadow component can be assigned the following shaders:

<table>
<thead>
<tr>
<th>Shader</th>
<th>Library</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Edge Shadow</em></td>
<td>lume</td>
</tr>
<tr>
<td><em>Facade</em></td>
<td>lume</td>
</tr>
<tr>
<td><em>Glass</em></td>
<td>lume</td>
</tr>
<tr>
<td><em>Glow</em></td>
<td>lume</td>
</tr>
<tr>
<td><strong>Material to Shader on page 6412</strong></td>
<td>3ds Max</td>
</tr>
<tr>
<td><em>Metal</em></td>
<td>lume</td>
</tr>
<tr>
<td><strong>Shader List on page 6420</strong></td>
<td>3ds Max</td>
</tr>
<tr>
<td><em>Shadow Transparency</em></td>
<td>base</td>
</tr>
<tr>
<td><em>Translucency</em></td>
<td>lume</td>
</tr>
<tr>
<td><em>Transmat</em></td>
<td>physics</td>
</tr>
<tr>
<td><em>Water Surface Shadow</em></td>
<td>lume</td>
</tr>
</tbody>
</table>
Caustics and GI group

Photon Assigns a photon shader. Photon shaders modify the appearance of caustics and global illumination. They modify light energy (luminous flux) rather than color (radiance).

The photon component can be assigned the following shaders:

<table>
<thead>
<tr>
<th>Shader</th>
<th>Library</th>
</tr>
</thead>
<tbody>
<tr>
<td>DGS Material on page 6398</td>
<td>3ds Max</td>
</tr>
<tr>
<td>Dielectric Material Photon on page 6403</td>
<td>3ds Max</td>
</tr>
<tr>
<td>Edge</td>
<td>lume</td>
</tr>
<tr>
<td>Glow</td>
<td>lume</td>
</tr>
<tr>
<td>Material to Shader on page 6412</td>
<td>3ds Max</td>
</tr>
<tr>
<td>Metal</td>
<td>lume</td>
</tr>
<tr>
<td>Photon Basic</td>
<td>base</td>
</tr>
<tr>
<td>SSS Physical Material</td>
<td>subsurface scattering</td>
</tr>
<tr>
<td>Translucency</td>
<td>lume</td>
</tr>
<tr>
<td>Transmat</td>
<td>physics</td>
</tr>
</tbody>
</table>

Photon Volume Assigns a photon volume shader. Like a photon shader, a photon volume shader modifies caustics and global illumination, but it affects photons that pass through the inside of the object, rather than photons that collide with its surface.

The photon volume component can be assigned the following shaders:

<table>
<thead>
<tr>
<th>Shader</th>
<th>Library</th>
</tr>
</thead>
<tbody>
<tr>
<td>Material to Shader on page 6412</td>
<td>3ds Max</td>
</tr>
</tbody>
</table>
### Extended Shaders group

**Bump** Assigns a bump shader. Bump shading for mental ray materials is similar to bump mapping on page 6049 for standard materials.

The bump component can be assigned the following shaders:

<table>
<thead>
<tr>
<th>Shader</th>
<th>Library</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bump</strong> on page 6397</td>
<td>3ds Max</td>
</tr>
<tr>
<td><strong>Ocean</strong></td>
<td>lume</td>
</tr>
</tbody>
</table>

**Displacement** Assigns a displacement shader on page 6713.

The displacement component can be assigned the following shaders:

<table>
<thead>
<tr>
<th>Shader</th>
<th>Library</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>3D Displacement</strong> on page 6394</td>
<td>3ds Max</td>
</tr>
<tr>
<td><strong>Material to Shader</strong> on page 6412</td>
<td>3ds Max</td>
</tr>
<tr>
<td><strong>Ocean</strong></td>
<td>lume</td>
</tr>
</tbody>
</table>

**Volume** Assigns a volume shader on page 6710.

The volume component can be assigned the following shaders:

<table>
<thead>
<tr>
<th>Shader</th>
<th>Library</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Beam</strong></td>
<td>lume</td>
</tr>
</tbody>
</table>
Environment Assigns an environment shader. Like an environment you assign using the Render Setup dialog, the environment shader changes the scene background.

The environment component can be assigned the following shaders:

<table>
<thead>
<tr>
<th>Shader</th>
<th>Library</th>
</tr>
</thead>
<tbody>
<tr>
<td>Environment</td>
<td>3ds Max</td>
</tr>
<tr>
<td>Material to Shader</td>
<td>3ds Max</td>
</tr>
<tr>
<td>Shader List</td>
<td>3ds Max</td>
</tr>
<tr>
<td>Submerge</td>
<td>lume</td>
</tr>
</tbody>
</table>

Optimization group

Flag Material as Opaque When on, indicates that the material is fully opaque. This tells the mental ray renderer that it doesn't need to process transparency for this material, or to use the shadow shader (if one has been assigned). This can improve rendering time. Default=off.

Advanced Shaders Rollout (mental ray Material)

Material Editor > Type button > Material/Map Browser > mental ray > Advanced Shaders rollout
Note: The mental ray material appears in the Browser only if the mental ray renderer is the currently active renderer.

The Advanced Shaders rollout provides controls for two component shaders that aren't always used.

**Interface**

Each shader component has a toggle at the left of its name. When the toggle is on, the shader is used in rendering. When the toggle is off, the shader is not used, even if it has been assigned. Clicking the button to the right of the component name displays the Material/Map Browser on page 5724 so you can assign a particular shader to the component.

**Contour** Assigns a contour shader on page 6714 to the material.

The contour component can be assigned the following shaders:

<table>
<thead>
<tr>
<th>Shader</th>
<th>Library</th>
</tr>
</thead>
<tbody>
<tr>
<td>Combi</td>
<td>contour</td>
</tr>
<tr>
<td>Curvature</td>
<td>contour</td>
</tr>
<tr>
<td>Depth Fade</td>
<td>contour</td>
</tr>
<tr>
<td>Factor Color</td>
<td>contour</td>
</tr>
<tr>
<td>Layer Thinner</td>
<td>contour</td>
</tr>
<tr>
<td>Simple</td>
<td>contour</td>
</tr>
<tr>
<td>Width From Color</td>
<td>contour</td>
</tr>
<tr>
<td>Width From Light</td>
<td>contour</td>
</tr>
</tbody>
</table>
Library Shader

contour

NOTE Contours don’t render unless you have also enabled them on the Render Setup dialog > Renderer panel > Camera Effects rollout on page 6747.

Light Map Assigns a light map shader to the material.

WARNING No light map shaders are provided with 3ds Max. This option is for users who have access to light map shaders via other shader libraries or custom shader code.

Standard Material and Related Materials (Not Photometric)

This section describes the Standard material and other materials that are not photometric. These materials can be suitable for games and animation, but not for physically accurate lighting models.

Shading Type

The Standard and Raytrace materials let you specify a shading type. Shading types are handled by a "shader," which describes how the surface responds to light.

WARNING When you change the shading type of a material, you lose the settings (including map assignments) for any parameters that the new shader does not support. If you want to experiment with different shaders for a material with the same general parameters, copy the material to a different sample slot on page 5650 before you change its shading type. That way, you can still use the original material if the new shader doesn’t give you the effect you want.
Samples of different shading for a standard material
1. Anisotropic
2. Blinn
3. Metal
4. Multi-layer
5. Oren-Nayar-Blinn
6. Phong
7. Strauss
8. Translucent

Several different shaders are available. Some of these are not available for the Raytrace material, as indicated below. Blinn is the most general-purpose of
these shaders. The others have special purposes, especially regarding how the material creates highlights.

- **Anisotropic** on page 5978
  Creates surfaces with noncircular, "anisotropic" highlights; good for modeling hair, glass, or metal.

- **Blinn** on page 5979
  Creates smooth surfaces with some shininess; a general-purpose shader.

- **Metal** on page 5980
  Creates a lustrous metallic effect.

- **Multi-Layer** on page 5982
  Creates more complex highlights than Anisotropic by layering two anisotropic highlights.
  Not available for Raytrace material.

- **Oren-Nayar-Blinn** on page 5983
  Creates good matte surfaces such as fabric or terra-cotta; similar to Blinn.

- **Phong** on page 5979
  Creates smooth surfaces with some shininess; similar to Blinn, but doesn't handle highlights (especially glancing highlights) as well.

- **Strauss** on page 5985
  Creates both nonmetallic and metallic surfaces; has a simple set of controls.
  Not available for Raytrace material.

- **Translucent** on page 5988
  Translucent shading is similar to Blinn shading, but it also lets you specify translucency, where light is scattered as it passes through the material. You can use translucency to simulate frosted and etched glass.
  Not available for the Raytrace material.

### Standard Material

Material Editor > Type button > Material/Map Browser > Standard

The Standard material type provides a fairly straightforward way to model surfaces. In the real world, the appearance of a surface depends on how it reflects light. In 3ds Max, a standard material simulates a surface's reflective properties. If you don't use maps on page 8631, a standard material gives an object a single, uniform color.
This topic introduces the controls for Standard material, exclusive of mapping.

**TIP** The Standard material supports hardware-based viewport display for improved feedback while editing its parameters. For more information, see Show Standard/Hardware Map in Viewport on page 5696.

**Standard Color Components**

A surface of a "single" color usually reflects many colors. Standard materials typically use a four-color model to simulate this. (This can vary, depending on which shader on page 5969 you use.)

- **Ambient color** on page 8504 is the color of the object in shadow.
- **Diffuse** on page 8552 is the color of the object in direct, "good" lighting.
- **Specular** on page 8728 is the color of shiny highlights.

**NOTE** Some shaders generate the specular color procedurally, rather than letting you choose it.
Filter on page 8573 is the color transmitted by light shining through the object. The Filter color component isn't visible unless the material's Opacity is less than 100 percent.

NOTE The Raytrace material on page 6064 uses a different, six-color model to simulate surfaces. Several components are similar to those in the Standard Material, but they behave differently in Raytrace.

When we describe an object's color in conversation, usually we mean its diffuse color. The choice of an ambient color depends on the kind of lighting. For moderate indoor lighting, it can be a darker shade of the diffuse color, but for bright indoor lighting and for daylight, it should be the complement of the primary (key) light source. The specular color should be either the same color as the key light source, or a high-value, low-saturation version of the diffuse color.

For more tips on choosing color components, see Choosing Colors for Realism on page 5965.

WARNING When you change the shading type of a material, you lose the settings (including map assignments) for any parameters that the new shader does not support. If you want to experiment with different shaders for a material with the same general parameters, copy the material to a different sample slot on page 5650 before you change its shading type. That way, you can still use the original material if the new shader doesn't give you the effect you want.

Other Standard Material Components

A standard material's specular color appears in highlights. You can control the size and shape of the highlight. A polished surface has a small and strong highlight. A matte surface has a large, weak highlight, or no highlight at all.

Standard materials also have controls for making the object appear transparent, and for making it self-illuminating so that it appears to glow.

Along with the material's color components, components also refers to the parameters that control highlights, transparency, self-illumination, and so on.

See also:

■ Choosing Colors for Realism on page 5965
Choosing Colors for Realism

Materials add greater realism to a scene only if you choose their colors and other properties to appear like real-world objects. This topic presents some general guidelines for choosing standard material colors. When possible, you should also observe colors in the objects you are modeling, especially under different lighting conditions.

For objects on which you want the viewer to focus attention, an unmapped standard material doesn't often provide the level of realistic detail you probably want. However, for distant and peripherally visible objects, as well as some kinds of real-world materials, such as molded plastic, an unmapped standard material can work well. Keeping the number of maps to a minimum can help keep down the file size.

Indoor and Outdoor Lighting

Whether a scene is indoors or outdoors affects your choice of material colors, just as it affects the way you set up lights on page 5314. Full sunlight is bright and unidirectional. Most indoor lighting is less intense and more even (that is, multidirectional) than daylight. However, some special indoor lighting (and nighttime outdoor lighting), as for the stage, also features intense, directional light.

Direct sunlight has a yellow tint. Materials for objects to appear in daylight should have a specular color of a pale, unsaturated yellow (for example, RGB values of 240, 240, 188). The ambient color should be the complement of the specular: a deep, dark purple with a hint of the diffuse color.

Materials for objects to appear under normal interior lighting should have a specular color that is close to white. (Our perception compensates for the yellow or green tint that is often present in artificial light.) The ambient color can often have the same hue as the diffuse color, but with a darker value.

Materials for objects to appear under spotlights should follow the general guidelines for daylight materials. The specular color should match the spotlight's color, and the ambient color should be a very dark value of the spotlight color's complementary hue, mixed with a bit of the material's diffuse color.
If you want to render an object under changing lighting conditions, you can choose colors that are a compromise between the optimal colors for each kind of lighting, or you can animate on page 5707 the material so that its colors change to suit the changing light.

**Representing Natural Materials**

Outdoor scene with natural materials

Most natural materials have a matte surface with little or no specular color. For natural materials such as these, use the following guidelines:

- **Ambient color**: The ambient color depends on whether the scene is indoors or outdoors, as previously described.

- **Diffuse color**: Choose a color found in nature. It is best to use the observed color of the object itself, or a similar object.

- **Specular color**: Make the specular color the same hue as the diffuse, but with a higher value and a lower saturation.

- **Glossiness**: Set the Glossiness to a low value.
Some foliage, bird feathers, fish scales, and so on, are shiny. For materials such as these, set the Glossiness to higher values. You might also want to change the specular color so it’s closer to the lighting color than the surface’s diffuse color.

Water is reflective, and is best modeled by a color component in combination with a reflection map on page 6375 or a water map on page 6320.

While metal is a natural material, its special visual characteristics are most apparent when it has been polished. Standard material represents this by using a special shading type, described later in this topic.

**Representing Manufactured Materials**

Manufactured materials often have a synthetic color rather than an “earth tone.” Also, many manufactured materials, such as plastics and porcelain glazes, are very shiny. For manufactured materials, use the following guidelines:

- **Ambient color:** The ambient color depends on whether the scene is indoors or outdoors, as previously described.
- **Diffuse color:** Although the diffuse color doesn't have to be an "earth tone," as with natural materials you should use the observed color of the object or a similar object.

- **Specular color:** Make the specular color close to white, or to the color of the light source. White is especially characteristic of plastic materials.

- **Glossiness:** Set the glossiness to a high value.

**Representing Metallic Objects**

![Metallic cup and ice cream scoop](image)

Polished metal has a characteristic "glancing" highlight that appears where the light is at a high angle of incidence. To generate this effect, Metal shading uses the Cook/Torrance illumination model.

For metallic materials, you can use the Metal shading type. This disables the specular color and highlight controls. The Metal shader calculates its own specular color, which can vary between the diffuse color and the color of the light.
In the diffuse region of a metal material, the ambient component is greater than it is for other kinds of materials.

The Anisotropic, Multi-Layer, and Strauss shaders give you further options for modeling polished metal.

If the metallic object is the focus of the scene, you can improve realism by using a Blend material on page 6107 to combine metallic shading with a reflection map on page 6375.

TIP When you preview metallic surfaces, it is useful to turn on a backlight. This displays the metal’s glancing highlight. The Backlight button is to the right of the sample slots.

---

**Shader Basic Parameters Rollout**

Material Editor > Standard material > Shader Basic Parameters rollout > Choose shader from drop-down list.

The Shader Basic Parameters rollout lets you choose the type of shader to use with a Standard material on page 5962. Some additional controls affect how the material appears.

**Procedures**

To set a material’s shading type:

1. On the Shader Basic Parameters rollout, open the shader drop-down list.
2. Click the name of the shader type to use for the active material.

To use Wire mode:

- On the Shader Basic Parameters rollout, turn on Wire. The material is now shaded as a wireframe mesh. The wire portions of the geometry do not change; color components, shininess, and so on, remain the same.

    For a wireframe material, turn on the 2-Sided option as well.

    You have two choices for how wireframe materials are rendered. The controls for tuning wireframe shading are on the Extended Parameters on page 6013 rollout.
If you choose Pixels, the thickness of the wires maintains the same apparent thickness regardless of the scale of the geometry or how near or far the object is positioned. In other words, pixel wires have a constant display size as if the wires were traced over an image. If you choose Units, the wires behave as if they were modeled in the geometry. They appear thinner at a distance and thicker at close range. Scaling a wireframe object does scale wire width.

**Interface**

[shader drop-down list] Chooses a shader. The material’s Basic Parameters rollout can change to show the controls for the shader you choose. Default shader=Blinn

There are seven different shaders. Some are named for what they do; others are named for their creators. These are the basic material shaders:

- **Anisotropic** on page 5978: For surfaces with elliptical, "anisotropic" highlights. These highlights are good for modeling hair, glass, or brushed metal.
- **Blinn** on page 5979: For rounder, softer highlights than Phong shading
- **Metal** on page 5980: For metallic surfaces
- **Multi-Layer** on page 5982: For surfaces with more complex highlights than Anisotropic
- **Oren-Nayar-Blinn** on page 5983: For matte surfaces such as fabric or terra-cotta
- **Phong** on page 5984: For surfaces with strong, circular highlights
- **Strauss** on page 5985: For metallic and nonmetallic surfaces. The Strauss shader has a simpler interface than other shaders.
- **Translucent** on page 5988: Similar to Blinn shading, the Translucent shader also lets you specify translucency, where light is scattered as it passes through the material.

For more information about the shaders, including illustrations, see **Understanding Shaders** on page 5971.
**Wire** Renders the material in *wireframe mode* on page 8766. You can set the size of the wire in *Extended Parameters* on page 6013.

**2-Sided** Makes the material 2-sided on page 8493. Applies the material to both sides of selected faces.

**Face Map** Applies the material to the faces of the geometry. If the material is a mapped material, it requires no *mapping coordinates* on page 8628. The map is automatically applied to each facet of the object.

**Faceted** Renders each face of a surface as if it were flat.

### Understanding Shaders

For standard materials, a *shader* is an algorithm that tells 3ds Max how to calculate surface rendering. Each shader has a unique set of characteristics in order to serve a particular purpose. Some are named for what they do well, such as the Metal shader. Others are named for the person who developed them, such as the Blinn and Strauss shaders. The default shader in 3ds Max is the Blinn shader.

**NOTE** In addition to the shaders listed below, 3ds Max supports plug-in shader types.

The following list describes the shaders supplied with 3ds Max:

- **Anisotropic**: Used for brushed metal or hair. Creates a highlight that is stretched and angled, rather than the standard circular highlight.
- **Blinn**: Has the same features as the Phong shader, but its mathematics are more accurate. This is the default shader for Standard materials.

- **Metal**: Used for making metals.
- **MultiLayer**: Two anisotropic shaders in one. Used to make two different highlights with independent controls. Simulates materials such as a metal that is covered with a shiny coat of wax.

- **Oren-Nayar-Blinn**: An adaptation of the Blinn shader. It gives objects a porous, non-plastic appearance, and is suitable for surfaces like skin.
- **Phong**: A classic shading method that was the first to enable specular highlights. Suitable for plastic surfaces.

- **Strauss**: Suitable for metals. Allows you to control the degree of metallic characteristics of the material.
Translucent Shader: Translucent shading is similar to Blinn shading, but it also lets you specify translucency. A translucent object allows light to pass through, and also scatters light within the object. You can use translucency to simulate frosted and etched glass.

Comparing Shader Parameters

A shader is an algorithm that tells 3ds Max how to calculate surface rendering. Each shader has a unique set of characteristics in order to serve a particular purpose.

Compare the parameters of different shader types:

1. Open the Material Editor and click an available sample slot.
2. In the list on the Shader Basic Parameters rollout, change Blinn to Anisotropic.
The Blinn Basic Parameters rollout changes to the Anisotropic Basic Parameters rollout. Observe the differences in the available basic parameters.
Select each shader type from the list and compare its parameters with the others. Some parameters are shared in common, but each shader has its own unique combination of settings.

For more information on shader types, see Shader Basic Parameters Rollout on page 5969.
Anisotropic Shader

Material Editor > Standard material > Shader Basic Parameters rollout > Anisotropic shader > Anisotropic Basic Parameters rollout

The Anisotropic shader creates surfaces with elliptical, "anisotropic" highlights. These highlights are good for modeling hair, glass, or brushed metal. The basic parameters are similar to those for Blinn or Phong shading on page 5979, except for the Specular Highlight parameters, and Diffuse Level controls such as those for Oren-Nayar-Blinn shading on page 5983.

Anisotropic highlights are elliptical, with differing U and V dimensions.

Anisotropy measures the difference between sizes of the highlight as seen from two perpendicular directions. When anisotropy is 0, there is no difference at all. The highlight is circular, as in Blinn or Phong shading. When anisotropy is 100, the difference is at its maximum. In one direction the highlight is very sharp; in the other direction it is controlled solely by Glossiness.

For more complex highlights, see the Multi-Layer shader on page 5982.
See also:
- Shader Basic Parameters Rollout on page 5969
- Basic Parameters Rollout (Standard Material) on page 5989
- Anisotropic Highlights on page 6004

Blinn Shader

Material Editor > Standard material > Shader Basic Parameters rollout > Blinn shader > Blinn Basic Parameters rollout

Blinn shading is a subtle variation on Phong shading. The most noticeable difference is that highlights appear rounder. In general, you don't need to use the Soften parameter (described in Blinn, Oren-Nayar-Blinn, and Phong Highlights on page 6006) as often as you do with Phong shading.

Blinn shading tends to have soft, round highlights.
With Blinn shading, you can obtain highlights produced by light glancing off the surface at low angles. These highlights are lost when you increase the value of Soften using Phong shading.

The Blinn and Phong shaders have the same basic parameters on page 5989.

See also:
- Shader Basic Parameters Rollout on page 5969
- Basic Parameters Rollout (Standard Material) on page 5989
- Blinn, Oren-Nayar-Blinn, and Phong Highlights on page 6006

**Metal Shader**

Material Editor > Standard material > Shader Basic Parameters rollout > Metal shader > Metal Basic Parameters rollout

Metal shading provides realistic-looking metallic surfaces and a variety of organic-looking materials.

Metal shading has a distinct curve for specular highlights. Metal surfaces also have glancing highlights. Metal materials calculate their own specular color, which can vary between the material's diffuse color and the color of the light. You can't set a metal material's specular color.
Metal shading has distinctive highlights.

Because there's no separate specular highlight, the two specular highlight spinners behave differently than the spinners for Blinn and Phong shading on page 5979. The Specular Level spinner still controls intensity, but the Glossiness spinner affects both the intensity and size of the specular areas.

**TIP** When you create a metal material, make sure the backlight on page 5674 is on in the sample slot.

See also:

- Shader Basic Parameters Rollout on page 5969
- Basic Parameters Rollout (Standard Material) on page 5989
- Metal Highlights on page 6008
Multi-Layer Shader

Material Editor > Standard material > Shader Basic Parameters rollout >
Multi-Layer shader > Multi-Layer Basic Parameters rollout

The Multi-Layer shader is similar to the Anisotropic shader on page 5978, but it has a set of two specular highlight controls. The highlights are layered, letting you create complex highlights that are good for highly polished surfaces, special effects, and so on.

Upper left: No highlights
Upper right: Single highlight
Lower middle: Multiple highlights from the multi-layer shader

Highlights in the Multi-Layer shader can be anisotropic. Anisotropy measures the difference between sizes of the highlight as seen from two perpendicular directions. When anisotropy is 0, there is no difference at all. The highlight is circular, as in Blinn or Phong shading. When anisotropy is 100, the difference is at its maximum. In one direction the highlight is very sharp; in the other direction it is controlled solely by Glossiness.

See also:

- Shader Basic Parameters Rollout on page 5969
- Basic Parameters Rollout (Standard Material) on page 5989
Oren-Nayar-Blinn Shader

Material Editor > Standard material > Shader Basic Parameters rollout > Blinn shader > Oren-Nayar-Blinn shader > Oren-Nayar-Blinn Basic Parameters rollout

The Oren-Nayar-Blinn shader is a variant of the Blinn shader on page 5979. It contains additional "advanced diffuse" controls, Diffuse Level and Roughness, that you can use to give the material a matte effect. This shader is good for matte surfaces such as fabric, terra-cotta, and so on.

Oren-Nayar-Blinn shading typically has a matte appearance.

See also:

- Shader Basic Parameters Rollout on page 5969
- Basic Parameters Rollout (Standard Material) on page 5989
- Blinn, Oren-Nayar-Blinn, and Phong Highlights on page 6006
Phong Shader

Material Editor > Standard material > Shader Basic Parameters rollout > Phong shader > Phong Basic Parameters rollout

Phong shading smoothes the edges between faces and renders highlights realistically for shiny, regular surfaces. This shader interpolates intensities across a face based on the averaged face normals of adjacent faces. It calculates the normal for every pixel of the face.

Phong-shaded highlights are typically less regular than Blinn highlights.

Phong shading can accurately render bump, opacity, shininess, specular, and reflection maps.

The Blinn and Phong shaders have the same basic parameters on page 5989.

See also:
- Shader Basic Parameters Rollout on page 5969
- Basic Parameters Rollout (Standard Material) on page 5989
- Blinn, Oren-Nayar-Blinn, and Phong Highlights on page 6006
**Strauss Shader**

Material Editor > Standard material > Shader Basic Parameters rollout > Strauss shader > Strauss Basic Parameters rollout

The Strauss shader is for modeling metallic surfaces. It uses a simpler model and has a simpler interface than the Metal shader on page 5980.

Sample of Strauss shading

**NOTE** The Strauss shader’s Basic Parameters rollout differs a great deal from the Basic Parameters rollouts for other shaders, and is described in this topic.

See also:
- Shader Basic Parameters Rollout on page 5969

**Procedures**

To change the color of a Strauss material:

1. Click the Color swatch.
The Color Selector on page 371 is displayed.

2 In the Color Selector, change the values of the color.
   As you change color values, the color also changes in the sample in the sample slot.

To reduce a material's opacity:

- Change Opacity to a value less than 100%.
The material becomes more transparent. A fully transparent object (0% Opacity) is nearly invisible except for the light it reflects: the specular highlights.
To preview transparency in the sample slots, view the sample object against a background. Click the checkered Background on page 5675 button to the right of the sample slots.
Transparent materials render more realistically when you turn on 2-Sided in the material's Shader Basic Parameters on page 5969.

To increase or decrease the size and intensity of highlights:

- Change the Glossiness value.
The width of the Highlight curve and the highlights in the preview change. At 0% glossiness, the curve is at its maximum width. At 100% glossiness, the curve is extremely narrow.
Increasing Glossiness also dims the diffuse color.

To make the material appear more metallic:

1 Increase the Glossiness value.
The metallic effect requires visible highlights.

2 Increase the value of Metalness.
Highlights become more focused, and the (diffuse) color component is dimmed.
**Interface**

![Strauss Basic Parameters]

**Color** Controls the color of the material. This corresponds to the diffuse color on page 8552 you specify for other kinds of shaders. With the Strauss shader, you control only this color. The shader calculates the ambient and specular color components.

Click the map button to assign a map to the color component. See Diffuse Mapping on page 6031. This button is a shortcut: you can also assign color mapping in the Maps on page 6021 rollout.

**Glossiness** Affects the size and intensity of the specular highlight. As you increase the value, the highlight gets smaller and the material appears shinier. Default=25.

Glossiness also controls the strength of reflection maps assigned to a Strauss material.

Click the map button to assign a map to the glossiness component. See Glossiness Mapping on page 6039. This button is a shortcut: you can also assign glossiness mapping in the Maps on page 6021 rollout.

**Metalness** Changes the metallic appearance of a material. Increasing the Metalness value increases the metallic appearance, with glancing as well as primary highlights. Because a metallic appearance principally depends on highlights, the Metalness value has little effect unless you also increase the Glossiness value. Default=0.

**Tip** When you create a metal material, make sure the backlight on page 5674 is on in the sample slot.

**Opacity** Sets the opacity/transparency of the material as a percentage. The effect is best previewed against a pattern background on page 5675 in the sample slot. You can control opacity falloff on page 8663 in the Extended Parameters. Default=100.
Click the map button to assign a map to the opacity component. See **Opacity Mapping** on page 6042. This button is a shortcut: you can also assign opacity mapping in the **Maps rollout** on page 6021.

**Highlight graph** This curve shows the effect of adjusting the value of Glossiness. As you decrease Glossiness, the curve grows shorter; as you increase it, the curve grows taller.

## Translucent Shader

Material Editor > Standard material > Shader Basic Parameters rollout > Translucent shader > Translucent Basic Parameters rollout

Translucent shading is similar to Blinn shading, but it also lets you specify translucency. A translucent object allows light to pass through, and also scatters light within the object. You can use translucency to simulate frosted and etched glass.

![Image: The projection screen uses translucency](image)

Translucency is inherently a two-sided effect: with the translucent shader, backface illumination appears on front faces. To generate translucency, both sides of the material receive diffuse light, though only one side is visible in renderings and shaded viewports unless you turn on 2-Sided (in the Shader Basic Parameters rollout).

If you use **radiosity** on page 6615, it will process light transmitted by translucency. The accuracy of this depends on the mesh: the more subdivided the faces are, the more accurate the solution will be (at a cost of processing time).

For specular highlights, you have a choice: to model materials like translucent plastic, you can choose to have highlights on both sides; to model materials like frosted glass, which is reflective on one side only, you can choose to have highlights on only one side. This is controlled by the Backside Specular toggle in the translucent highlight controls.

**TIP** To simulate frosted glass, a fine-grained bump map can also help.
The translucent effect appears only in renderings. It does not appear in shaded viewports.

**NOTE** The translucent shader does not simulate the scattering of light within the object. Because of this, it is better at simulating thin objects such as glass or paper, than at thick objects. For thicker objects, the light passing through might saturate excessively. To avoid this, try reducing the HSV Value of the material's Translucent Color.

Translucent materials also capture shadows cast on the backfaces of the material. However, because the translucent shader doesn't scatter light, for thicker objects the effect is not an accurate simulation of real-world translucency.

**WARNING** Do not use shadow maps with the translucent shader. Shadow maps result in artifacts at the edge of translucent objects.

See also:
- Shader Basic Parameters Rollout on page 5969
- Basic Parameters Rollout (Standard Material) on page 5989
- Translucency Setting on page 6002
- Translucent Highlights on page 6012

**Basic Parameters Rollout (Standard Material)**

Material Editor > Standard material > Basic Parameters rollout for the shader you've chosen

The Basic Parameters rollouts for Standard materials contain controls that let you set the color of your material, the shininess, the transparency, and so on, and specify maps on page 8631 to use for the various components of the material.
Example: The Basic Parameters rollout for the Anisotropic shader.

Basic Parameters rollouts vary depending on which shader is chosen.

The Basic Parameters rollout changes depending on which kind of shader you choose in the Shader Basic Parameters on page 5969.

NOTE The Strauss shader’s Basic Parameters rollout is simpler than those for other shaders. See Strauss Shader on page 5985 for a description.

Component Controls

The first part of the Basic Parameters rollout contains controls for overall material components. They are described in the following topics:

- Color Controls on page 5991 let you choose the material's color components, or replace them with maps.
- Self-Illumination on page 5995 makes a material appear lit from within. Self-illumination is not available for the Strauss shader on page 5985.
- Opacity on page 5997 controls how opaque or transparent a material is.
- **Diffuse Level** on page 5999 controls the brightness of the diffuse color component. Diffuse Level is available only for the *Anisotropic* on page 5978, *Multi-Layer* on page 5982, and *Oren-Nayar-Blinn* on page 5983 shaders.

- **Roughness** on page 6001 controls how quickly the diffuse component blends into the ambient component. Roughness is available only for the *Multi-Layer* on page 5982 and *Oren-Nayar-Blinn* on page 5983 shaders.

### Highlight Controls

The second part of the Basic Parameters rollout contains controls for specular highlights, which in some ways are the greatest difference between the various shaders. See these topics for a description:

- **Anisotropic Highlights** on page 5978
- **Blinn, Oren-Nayar-Blinn, and Phong Highlights** on page 6006
- **Metal Highlights** on page 6008
- **Multi-Layer Highlights** on page 6009

For information on highlights with the Strauss shader, see *Strauss Shader* on page 5985.

### Translucency Controls

For the *Translucent shader* on page 5988, an additional group on the Basic Parameters rollout contains controls for translucency on page 6002.

### Color Controls

Material Editor > Standard material > Anisotropic, Blinn, Metal, Multi-Layer, Oren-Nayar-Blinn, or Phong Basic Parameters rollout > First group in the rollout (unlabeled)

Color controls set the colors for different color components. You can set the color by clicking the color swatch to display the *Color Selector* on page 371.
NOTE The Metal shader does not have a Specular component, because it generates the specular color automatically. The Multi-Layer shader can have two different Specular color components, so for this material the Specular color swatches are found in the Specular Highlights group. The Strauss shader has only a single color component, which corresponds to Diffuse.

1. Specular color
2. Diffuse color
3. Ambient color

Copying and Locking Color Components

For convenience in changing color components, the Material Editor lets you copy one color component to another by dragging, and to lock two color components together with the lock buttons to the left of the Ambient and Diffuse, and Diffuse and Specular color swatches.

When you drag and drop a color swatch, the Copy or Swap Colors dialog on page 5711 asks if you want to copy the color or swap the two colors.

In general, materials with two identical color components do not look realistic, and except for materials that are close to solid black, you should avoid using
copied or locked color components in materials you use in a scene. Color copying and locking are best used as conveniences when you design a new basic material.

**Shortcut Map Buttons**

The small buttons to the right of the color swatches access the Material/Map Browser on page 5703, where you select a map for that component. These buttons are shortcuts: you can also use the corresponding buttons in the Maps rollout on page 6021 If you have assigned a map to one of these color components, the button displays the letter M. An uppercase M means that the corresponding map is assigned and active. A lowercase m means that the map is assigned and inactive (turned off).

The lock button to the right of the Diffuse map button locks Ambient mapping to Diffuse mapping. It is on by default. Usually it makes sense to use the same map for the ambient and diffuse components. To use different maps for ambient and diffuse, turn off the lock button. A map shortcut button for Ambient appears.

**Procedures**

To **change a color component:**

1. Click the color swatch next to the color component you want to change. The Material Editor displays a Color Selector on page 371.
2. Use the Color Selector to change the values of the color component. As you change color values, the color component also changes in the sample slot.

To **copy one color component to another:**

1. Drag the color swatch of the color you want to copy to the color swatch of the other color component. A Copy or Swap Colors dialog on page 5711 is displayed.
2. Click Copy to replace the second color swatch with the color you dragged. Click Swap to swap the two color components.
To lock two color components:

1. Click the lock button between Ambient and Diffuse or between Diffuse and Specular.
   The Material Editor displays an alert that asks whether you want to lock the two color components.

2. Click Yes.
   The color above replaces the color below. In other words, Ambient replaces Diffuse and Diffuse replaces Specular.
   If two colors are locked, and you lock the other two, all three component colors are replaced by the active color.
   While two colors are locked, adjustments to one color component affect the other as well.

To unlock two color components:

- Click the lock button to turn it off.
  The two colors remain the same until you change one of them, or both.

Interface

Ambient Controls the ambient color on page 8504. The ambient color is the color in shadow (indirect light).

Diffuse Controls the diffuse color on page 8552. The diffuse color is the color in direct light.

Specular Controls the specular color on page 8728. The specular color is the color of the highlight on a shiny object. You can control the size and shape of highlights in the Specular Highlights group, described below.
Self-Illumination Setting

Material Editor > Standard material > Anisotropic, Blinn, Metal, Multi-Layer, Oren-Nayar-Blinn, or Phong Basic Parameters rollout > Self-Illumination group

These controls make the material self-illuminated on page 8714. Self-illumination creates the illusion of incandescence by replacing shadows on the surface with the diffuse color. As you increase self-illumination, the self-illumination color takes over from the ambient color. At a setting of 100, the material shows no shaded areas, although it can show specular highlights.

The self-illumination color appears in viewports. (In releases prior to 3ds Max 5, viewports showed the self-illumination value but not the color.)

**NOTE** The Strauss shader on page 5985 does not have self-illumination.

There are two ways to specify self-illumination. You can turn on the check box and use a self-illumination color, or turn off the check box and use a monochrome spinner, which is comparable to using a gray scale self-illumination color.

Self-illuminated materials do not show shadows cast onto them, and they are unaffected by the lights in the scene. The brightness (Value in the HSV color description on page 8698) remains the same regardless of the scene's lighting.

To make a visible light source in a scene, you can combine a geometric object with a light object, and give the geometric object a self-illuminating surface. For example, you could create a lofted light bulb shape, assign it a self-illuminating white or yellowish material, and place an omni light in the same location.

To make a material both self-illuminating and transparent, use the Additive transparency type in combination with self-illumination. See Extended Parameters on page 6013.
A self-illuminated object using a percentage value and a color

**Procedures**

**To make a material self-illuminating:**

1. Click the color swatch in the Self-Illumination group.
2. In the **Color Selector** on page 371, choose a color for self-illumination.
3. Use the color’s Value parameter (in the HSV model) to increase or decrease the amount of **self-illumination** on page 8714.

You can also set self-illumination with a monochrome spinner. To do so, turn off the self-illumination check box and adjust the spinner.

The self-illumination color is mixed with the material’s diffuse color. The closer to black the self-illumination color, the more diffuse color is used. As self-illumination increases, the sample object appears flatter and more luminous.
Interface

**Color check box** When on, the material uses a special self-illumination color. When off, the material uses the diffuse color for self-illumination, and displays a spinner to control the self-illumination amount. Default=off.

**Color swatch** When Color is on, the color swatch shows the self-illumination color. To change the color, click the swatch and then use the Color Selector on page 371. Adjusting the Value (in the color's HSV description on page 8698) adjusts the amount of self-illumination. The greater the Value, the more the self-illumination color dominates both the ambient and diffuse color components.

**Mono spinner** When Color is off, the diffuse component is used as the self-illumination color, and this spinner lets you adjust the amount of self-illumination. At 0, there is no self-illumination. At 100, the diffuse color takes over from the ambient color.

Click the map button to assign a map to the self-illumination component. See Self-Illumination Mapping on page 6041. This button is a shortcut: you can also assign self-illumination mapping in the Maps rollout on page 6021.

**Opacity**

Material Editor > Standard material > Anisotropic, Blinn, Metal, Multi-Layer, Oren-Nayar-Blinn, or Phong Basic Parameters rollout > Opacity group (unlabeled)

Opacity controls whether a material is opaque, transparent, or translucent. (A more physically accurate way to generate translucency is to use the Translucent shader on page 5988.)
Controlling opacity using the Opacity setting (left) or an opacity map (right).

Procedures

To reduce a material’s opacity:

- Change Opacity to a value less than 100%.
  The material becomes more transparent. A fully transparent object (0% Opacity) is nearly invisible except for the light it reflects (the specular highlights).

To preview transparency in the sample slots, view the sample object against a background. Click the checkered Background button on page 5675 to the right of the sample slots.

Transparent materials render more realistically when you turn on 2-Sided in the material’s Shader Basic Parameters on page 5969.
Interface

**Opacity** Sets the opacity/transparency of the material as a percentage. The effect is best previewed against a pattern background on page 5675 in the sample slot. You can control opacity falloff on page 8663 in the Extended Parameters. Click the map button to assign a map to the opacity component. See **Opacity Mapping** on page 6042. This button is a shortcut: you can also assign opacity mapping in the **Maps rollout** on page 6021.

**Diffuse Level**

Material Editor > Standard material > Anisotropic, Multi-Layer, or Oren-Nayar-Blinn Basic Parameters rollout > Diffuse Level group (unlabeled) or Advanced Diffuse group

Diffuse Level controls the brightness of the material's diffuse component.
NOTE The Blinn, Metal, Phong, and Strauss shaders do not have Diffuse Level control.

Procedures

To adjust the diffuse level:

- Change the value of Diffuse Level. The material grows lighter or darker. Lowering the Diffuse Level dims the material’s diffuse color without affecting the specular highlight. Diffuse Level is intended primarily so you can create a map on page 6033 that makes portions of the material very dark.

Interface

![Interface image]
Diffuse Level  Increasing this value increases diffuse brightness, and decreasing it reduces diffuse brightness without affecting the specular highlight. You can increase the diffuse level over and above the diffuse color's Value (in its HSV description on page 8698). This parameter can range from 0 to 400. Default=100. Click the map button to assign a map to the diffuse level parameter. See Diffuse Level Mapping on page 6033. This button is a shortcut: you can also assign diffuse level mapping in the Maps rollout on page 6021.

Roughness

Material Editor > Standard material > Multi-Layer or Oren-Nayar-Blinn Basic Parameters rollout > Advanced Diffuse group (unlabeled for Multi-Layer)

Roughness controls the rate at which the diffuse component blends into the ambient component.

NOTE The Roughness parameter is available only with the Oren-Nayar-Blinn on page 5983 and Multi-Level on page 5982 shaders, and with the Arch & Design material (mental ray) on page 5858.
Procedures

To adjust the roughness:

- Change the value of Roughness.
  Increasing roughness makes the material have a flatter, more matte appearance.

Interface

![Roughness interface](image)

**Roughness** As you increase this value, the matte appearance of the material increases. It also grows darker and appears more flat. At 0, the roughness is the same as it is with Blinn shading on page 5979. Range (Oren-Nayar-Blinn and Multi-Layer)=0 to 100. Range (Arch & Design material)=0.0 to 1.0. Default=0.

Click the map button to assign a map to Roughness. This button is a shortcut: you can also assign Diffuse Roughness mapping on the Maps rollout on page 6021 (Oren-Nayar-Blinn and Multi-Layer) or General Maps rollout on page 5893 (Arch & Design material). See Diffuse Roughness Mapping on page 6035.

Translucency Setting

Material Editor > Standard material > Shader Basic Parameters rollout > Translucent shader > Translucent Basic Parameters rollout > Translucency group

The translucency controls are available for the Translucent shader on page 5988.

**WARNING** Do not use shadow maps with the translucent shader. Shadow maps result in artifacts at the edge of translucent objects.

Procedures

To make a material translucent:

- Increase the HSV Value (V) on page 8698 of the Translucent Color.
  As the Value increases, the material becomes more translucent. The Hue of the Translucent Color tints the light that is scattered within the material.
Translucent materials render more realistically when you turn on 2-Sided in the material's Shader Basic Parameters on page 5969. The translucent effect does not appear in shaded viewports.

The projection screen uses translucency

**Interface**

**Translucent Clr (Color)** Specifies a translucency color. This is the color of light that is scattered within the material. It does not need to be the same as the filter color, which is light transmitted by the material. The two color values are multiplied. Click the color swatch to change the translucent color. Click the button to assign a map to the translucent color component.

**Filter Color** Specifies a filter color on page 8573 that is multiplied by the translucent color. Click the color swatch to change the filter color. Click the button to assign a map to the filter color component.

The filter, or transmissive color, is the color transmitted through transparent or semi-transparent materials such as glass. You can use the filter color with volumetric lighting to create effects such as colored light through a stained-glass window. Ray-traced shadows on page 8696 cast by transparent objects are tinted with the filter color.

**Opacity** Sets the opacity/transparency on page 5997 of the material as a percentage. The effect is best previewed against a pattern background on page 5675 in the sample slot.

Click the map button to assign a map to the opacity component. See Opacity Mapping on page 6042. This button is a shortcut: you can also assign opacity mapping in the Maps rollout on page 6021.
Specular Highlight Controls

The topics in this section describe the various controls for different kinds of Standard material highlights.

Anisotropic Highlights

Material Editor > Standard material > Anisotropic Basic Parameters rollout > Specular Highlight group

Material Editor > Raytrace material > Raytrace Basic Parameters rollout > Shading: Anisotropic > Specular Highlight group

Anisotropic highlights are good for modeling hair, glass, or brushed metal.

NOTE For the Raytrace material on page 6064, the Specular Color component appears in the Specular Highlight group. Also, highlight controls that don’t pertain to the current shader are labeled “N / A.”

 Procedures

To increase or decrease the size of a highlight:

■ Change the Glossiness value.
  The width of the Highlight curves and the highlights in the preview change. At 0% glossiness, the curves are at their maximum width. At 100% glossiness, both curves are extremely narrow.

To increase or decrease the strength of a highlight:

■ Change the value of Specular Level.
  The intensity of the Highlight curves and the highlights in the preview change. At 0% specular level, there is no highlight. At 100% specular level, the curves are at their maximum height with no overloading. At values greater than 100%, the curves are overloaded: they grow wider, and a wider area is at the maximum highlight intensity.
  The shape of the Highlight curves affects the blending between the specular and diffuse color regions of the material. The steeper the curve, the less blending there is and the sharper the edge of the specular highlight.
To adjust the shape (anisotropy) of the highlight:

- Change the value of Anisotropy.
  The width of the white highlight curve and the highlights in the preview change. At 0% anisotropy, both highlight curves are the same and the highlight is circular, as in Blinn and Phong shading. At 100% anisotropy, the white highlight curve and the highlights are extremely narrow.

To adjust the orientation of the highlight:

- Change the value of Orientation.
  Highlights in the preview show the change in orientation. The display of the highlight curve does not change.

Interface

Specular Level Affects the intensity of the specular highlight. As you increase the value, the highlight grows brighter. Default=0 for a Standard material, 50 for a Raytrace material.

Click the map button to assign a map to the specular level component. See Specular Level Mapping on page 6038. This button is a shortcut: you can also assign specular level mapping in the Maps rollout on page 6021.

Glossiness Affects the size of the specular highlight. As you increase the value, the highlight gets smaller and the material appears shinier. Default=25.

Click the map button to assign a map to the glossiness component. See Glossiness Mapping on page 6039. This button is a shortcut: you can also assign specular level mapping in the Maps rollout on page 6021.

Anisotropy Controls the anisotropy, or shape, of the highlight. At 0, the highlight is round. At 100, the highlight is extremely narrow. One axis of the Highlight graph changes to show changes in this parameter. Default=50.
Orientation Changes the orientation of the highlight. The sample slot shows changes in orientation. This is a value in degrees that can range from 0 to 9,999. Default=0.

Highlight graph These two intersecting curves show the effect of adjusting the values of Specular Level, Glossiness, and Anisotropy. As you decrease Glossiness, the curves grow wider; as you increase Specular Level, the curves grow taller. As you adjust Anisotropy, the white curve changes to show how wide or narrow the highlight is.

Blinn, Oren-Nayar-Blinn, and Phong Highlights

Material Editor > Standard material > Blinn, Oren-Nayar-Blinn, or Phong Basic Parameters rollout > Specular Highlight group

Material Editor > Raytrace material > Raytrace Basic Parameters rollout > Shading: Blinn, Oren-Nayar-Blinn, or Phong > Specular Highlight group

The Blinn on page 5979, Oren-Nayar-Blinn on page 5983, and Phong on page 5984 shaders all have circular highlights and share the same highlight controls. Blinn and Oren-Nayar-Blinn highlights are somewhat softer and rounder than Phong highlights.

NOTE For the Raytrace material on page 6064, the Specular Color component appears in the Specular Highlight group. Also, highlight controls that don’t pertain to the current shader are labeled “N/A.”

Procedures

To increase or decrease the strength of a highlight:

■ Change the value of Specular Level.
  The intensity of the Highlight curve and the highlight in the preview change. At 0% specular level, there is no highlight. At 100% specular level, the curve is at its maximum height with no overloading. At values greater than 100%, the curve is overloaded: it grows wider, and a wider area is at the maximum highlight intensity.
  The shape of the Highlight curve affects the blending between the specular and diffuse color regions of the material. The steeper the curve, the less blending there is and the sharper the edge of the specular highlight.
To increase or decrease the size of a highlight:

- Change the Glossiness value.
  The width of the Highlight curve and the highlight in the preview change.
  At 0% glossiness, the curve is at its maximum width. At 100% glossiness,
  the curve is extremely narrow.

Interface

**Specular Level** Affects the intensity of the specular highlight. As you increase
the value, the highlight grows brighter. Default=0 for a Standard material, 50
for a Raytrace material.
Click the map button to assign a map to the specular level component. See
Specular Level Mapping on page 6039. This button is a shortcut: you can also
assign specular level mapping in the Maps rollout on page 6021.

**Glossiness** Affects the size of the specular highlight. As you increase
the value, the highlight gets smaller and the material appears shinier. Default=10 for a
Standard material, 40 for a Raytrace material.
Click the map button to assign a map to the glossiness component. See
Glossiness Mapping on page 6039. This button is a shortcut: you can also assign
specular level mapping in the Maps rollout on page 6021.

**Soften** Softens the effect of specular highlights, especially those formed by
glancing light. When Specular Level is high and Glossiness is low, you can
get harsh backlights on surfaces. Increase the value of Soften to mitigate this
effect. At 0, there is no softening. At 1.0, the maximum amount of softening
is applied. Default=0.1.

**NOTE** The Soften control was a check box in releases prior to 3ds Max 2. When
you load a material created in an earlier version of 3ds Max, if Soften was originally
off, the new Soften value is 0.0. If Soften was originally on, the new Soften value
is 0.6.
**Highlight graph** This curve shows the effect of adjusting the values of Specular Level and Glossiness. As you decrease Glossiness, the curve grows wider; as you increase Specular Level, the curve grows taller.

**Metal Highlights**

Material Editor > Standard material > Metal Basic Parameters rollout > Specular Highlight group

Material Editor > Raytrace material > Raytrace Basic Parameters rollout > Shading: Metal > Specular Highlight group

Metal-shaded materials generate their own specular color. Also, the highlight curve for the Metal shader differs in shape from the curve for Blinn Oren-Nayar-Blinn, and Phong highlights on page 6006.

**NOTE** For the Raytrace material on page 6064, the Specular Color component appears in the Specular Highlight group. Also, highlight controls that don’t pertain to the current shader are labeled “N/A.”

**Procedures**

**To increase or decrease the size and intensity of a highlight:**

- Change the Glossiness value.
  The width of the Highlight curve and the highlights in the preview change. At 0% glossiness, the curve is at its maximum width. At 100% glossiness, the curve is extremely narrow.

**To increase or decrease the strength of a highlight:**

- Change the value of Specular Level.
  The intensity of the Highlight curve and the highlight in the preview change. At 0% specular level, there is no highlight. At 100% specular level, the curve is at its maximum height with no overloading. At values greater than 100%, the curve is overloaded: it grows wider, and a wider area is at the maximum highlight intensity.
  Increasing the Specular Level also dims the diffuse color.
  The shape of the Highlight curve affects the blending between the specular and diffuse color regions of the material. The steeper the curve, the less blending there is and the sharper the edge of specular and glancing highlights.
Interface

Specular Level Affects the intensity of the specular highlight. As you increase the value, the highlight grows brighter and the diffuse color grows dimmer. Default=10 for a Standard material, 50 for a Raytrace material.

Click the map button to assign a map to the specular level component. See Specular Level Mapping on page 6038. This button is a shortcut: you can also assign specular level mapping in the Maps on page 6021 rollout.

Glossiness Affects the size of the specular highlight. As you increase the value, the highlight curve grows narrower and the highlight gets smaller. Default=10 for a Standard material, 40 for a Raytrace material.

Click the map button to assign a map to the glossiness component. See Glossiness Mapping on page 6039. This button is a shortcut: you can also assign specular level mapping in the Maps on page 6021 rollout.

Highlight graph This curve shows the effect of adjusting the values of Specular Level and Glossiness. As you decrease Glossiness, the curve grows wider; as you increase Specular Level, the curve grows taller.

Multi-Layer Highlights

Material Editor > Standard material > Multi-Layer Basic Parameters rollout > First Specular Layer/Second Specular Layer groups

Multi-layer highlights consist of two layers, each of them anisotropic. The highlights are transparent to each other. Where they overlap, the Multi-Layer shader blends their colors.

Procedures

To increase or decrease the size of a highlight (specular) layer:

- Change the Glossiness value.
The width of the Highlight curves and the highlights in the preview change. At 0% glossiness, the curves are at their maximum width. At 100% glossiness, both curves are extremely narrow.

To increase or decrease the strength of a highlight (specular) layer:
- Change the value of Specular Level.
The intensity of the Highlight curves and the highlights in the preview change. At 0% specular level, there is no highlight. At 100% specular level, the curves are at their maximum height with no overloading. At values greater than 100%, the curves are overloaded: they grow wider, and a wider area is at the maximum highlight intensity.

The shape of the Highlight curves affects the blending between the specular and diffuse color regions of the material. The steeper the curve, the less blending there is and the sharper the edge of the specular highlight.

To adjust the shape (anisotropy) of a highlight (specular) layer:
- Change the value of Anisotropy.
The width of the white highlight curve and the highlights in the preview change. At 0% anisotropy, both highlight curves are the same and the highlight is circular, as in Blinn and Phong shading. At 100% anisotropy, the white highlight curve and the highlights are extremely narrow.

To adjust the orientation of a highlight (specular) layer:
- Change the value of Orientation.
Highlights in the preview show the change in orientation. The display of the highlight curve does not change.
The First Specular Layer and Second Specular Layer groups have identical controls, which can have different settings.

**Color** Controls the specular color on page 8728 of this highlight. The specular color is the color of the highlight on a shiny surface.

**Level** Affects the intensity of this specular highlight. As you increase the value, the highlight grows brighter. Default: First layer=5, Second layer=0.

Click the map button to assign a map to the specular level component. See Specular Level Mapping on page 6038. This button is a shortcut; you can also assign specular level mapping in the Maps rollout on page 6021.

**Glossiness** Affects the size of this specular highlight. As you increase the value, the highlight gets smaller and the material appears shinier. Default: First layer=10, Second layer=25.

Click the map button to assign a map to the glossiness component. See Glossiness Mapping on page 6039. This button is a shortcut; you can also assign specular level mapping in the Maps rollout on page 6021.
Anisotropy  Controls the anisotropy, or shape, of this highlight. At 0, the highlight is round. At 100, the highlight is extremely narrow. One axis of the Highlight graph changes to show changes in this parameter. Default=0.

Orientation  Changes the orientation of this highlight. The sample slot shows changes in orientation. This is a value in degrees that can range from 0 to 9,999. Default=0.

Highlight graph  These two intersecting curves show the effect of adjusting the values of Level, Glossiness, and Anisotropy. As you decrease Glossiness, the curves grow wider; as you increase Specular Level, the curves grow taller. As you adjust Anisotropy, the white curve changes to show how wide or narrow the highlight is.

Translucent Highlights

Material Editor > Standard material > Translucent Basic Parameters rollout > Specular Highlight group

Like the Blinn shader, the Translucent shader has circular highlights.

Procedures

To increase or decrease the strength of a highlight:

■  Change the value of Specular Level.
   The intensity of the Highlight curve and the highlight in the preview change. At 0% specular level, there is no highlight. At values greater than 100%, the curve is overloaded: it grows wider, and a wider area is at the maximum highlight intensity. At 100% specular level, the curve is at its maximum height with no overloading.
   The shape of the Highlight curve affects the blending between the specular and diffuse color regions of the material. The steeper the curve, the less blending there is and the sharper the edge of the specular highlight.

To increase or decrease the size of a highlight:

■  Change the Glossiness value.
   The width of the Highlight curve and the highlight in the preview change. At 0% glossiness, the curve is at its maximum width. At 100% glossiness, the curve is extremely narrow.
Interface

Specular Level Affects the intensity of the specular highlight. As you increase
the value, the highlight grows brighter. Default=0.

Click the map button next to the spinner to assign a map to the specular level
component. See Specular Level Mapping on page 6038. This button is a shortcut:
you can also assign specular level mapping in the Maps rollout on page 6021.

Glossiness Affects the size of the specular highlight. As you increase the value,
the highlight gets smaller and the material appears shinier. Default=10.

Click the map button next to the spinner to assign a map to the glossiness
component. See Glossiness Mapping on page 6039. This button is a shortcut:
you can also assign specular level mapping in the Maps rollout on page 6021.

Backside specular When on, both sides of the material receive a specular
highlight. When off, only the front side of the material receives a highlight.
Default=on.

Leave Backside Specular on to model materials like translucent plastic. Turn
it off to model materials like frosted glass.

TIP When Backside Specular is turned off, the front side is always the one that
receives a specular highlight. You can change this by reversing the normals of
surfaces that have the translucent-shaded material.

Extended Parameters Rollout (Standard Material)

Material Editor > Standard material > Extended Parameters rollout

The Extended Parameters rollout is the same for all shading types of Standard
material. It has controls related to transparency and reflection, as well as
options for Wire mode.

This topic contains tables of the Index of Refraction for some common physical
materials. These can be used to create Standard materials with realistic
transparency.
Additive Opacity and the Alpha Channel

By default, additive opacity does not generate an alpha value. In other words, the alpha value is zero, indicating no transparency. This gives correct results with backgrounds in renderings, but if you want to composite objects with additive opacity using video post on page 7247 or a different compositing program, you might want to have additive opacity render with transparency. To do so, add the following line to the [Renderer] section of the 3dsmax.ini file, and then restart 3ds Max:

\texttt{AlphaOutOnAdditive}=1

To revert to the default method of rendering additive opacity, in the 3dsmax.ini file, change the value of AlphaOutOnAdditive back to 0 (zero), and then restart 3ds Max.

Interface

Advanced Transparency group

These controls affect the opacity falloff on page 8663 of a transparent material.

\underline{NOTE} For the Translucent shader on page 5988, these controls do not appear. They are replaced by the Translucency controls on page 6002 on the Basic Parameters rollout.

\textbf{Falloff} Chooses whether falloff is in or out, and how great it is.

\begin{itemize}
  \item \textbf{In} Increases transparency toward the inside of the object, as in a glass bottle.
  \item \textbf{Out} Increases transparency toward the outside of the object, as in a cloud of smoke.
\end{itemize}

\textbf{Amt (Amount)} Specifies the amount of transparency at the outside or inside extreme.
Type These controls choose how transparency is applied.

- **Filter** on page 8573 computes a filter color that it multiplies by the color behind the transparent surface. Click the color swatch to change the filter color. Click the button to assign a map to the filter color component. The filter, or transmissive color, is the color transmitted through transparent or semi-transparent materials such as glass. You can use the filter color with volumetric lighting to create effects such as colored light through a stained-glass window. Ray-traced shadows on page 8696 cast by transparent objects are tinted with the filter color.

- **Subtractive** on page 8733 subtracts from the color behind the transparent surface.

- **Additive** on page 8499 adds to the color behind the transparent surface.

**Index of Refraction** Sets the index of refraction (IOR) used by refraction maps and raytracing. The IOR controls how severely the material refracts transmitted light. Left at 1.0, the IOR of air, the object behind the transparent object does not distort. At 1.5 the object behind distorts greatly, like a glass marble. At an
IOR slightly less than 1.0, the object reflects along its edges, like a bubble seen from under water. Default=1.5.

Common IORs (assuming the camera is in air or a vacuum) are:

<table>
<thead>
<tr>
<th>Material</th>
<th>IOR Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vacuum</td>
<td>1.0 (exactly)</td>
</tr>
<tr>
<td>Air</td>
<td>1.0003</td>
</tr>
<tr>
<td>Water</td>
<td>1.333</td>
</tr>
<tr>
<td>Glass</td>
<td>1.5 (clear glass) to 1.7</td>
</tr>
<tr>
<td>Diamond</td>
<td>2.418</td>
</tr>
</tbody>
</table>

In the physical world, the IOR results from the relative speeds of light through the transparent material and the medium the eye or the camera is in. Typically this is related to the object’s density; the higher the IOR, the denser the object.

You can also use a map to control the index of refraction. IOR maps always interpolate between 1.0 (the IOR of air) and the setting in the IOR parameter. For example, if the IOR is set to 3.55 and you use a black-and-white Noise map to control IOR, the IORs rendered on the object will be set to values between 1.0 and 3.55; the object will appear denser than air. If, on the other hand, your IOR is set to 0.5, then the same map values will render between 0.5 and 1.0, as if the camera were under water and the object was less dense than the water.

Here are some more IOR values for various materials:

<table>
<thead>
<tr>
<th>Material</th>
<th>IOR Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Carbon Dioxide, Liquid</td>
<td>1.200</td>
</tr>
<tr>
<td>Ice</td>
<td>1.309</td>
</tr>
<tr>
<td>Acetone</td>
<td>1.360</td>
</tr>
<tr>
<td>Ethyl Alcohol</td>
<td>1.360</td>
</tr>
<tr>
<td>Material</td>
<td>IOR Value</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-----------</td>
</tr>
<tr>
<td>Sugar Solution 30%</td>
<td>1.380</td>
</tr>
<tr>
<td>Alcohol</td>
<td>1.329</td>
</tr>
<tr>
<td>Flourite</td>
<td>1.434</td>
</tr>
<tr>
<td>Quartz, Fused</td>
<td>1.460</td>
</tr>
<tr>
<td>Calspar2</td>
<td>1.486</td>
</tr>
<tr>
<td>Sugar Solution 80%</td>
<td>1.490</td>
</tr>
<tr>
<td>Glass, Zinc Crown</td>
<td>1.517</td>
</tr>
<tr>
<td>Glass, Crown</td>
<td>1.520</td>
</tr>
<tr>
<td>Sodium Chloride</td>
<td>1.530</td>
</tr>
<tr>
<td>Sodium Chloride (Salt) 1</td>
<td>1.544</td>
</tr>
<tr>
<td>Polystyrene</td>
<td>1.550</td>
</tr>
<tr>
<td>Quartz 2</td>
<td>1.553</td>
</tr>
<tr>
<td>Emerald</td>
<td>1.570</td>
</tr>
<tr>
<td>Glass, Light Flint</td>
<td>1.575</td>
</tr>
<tr>
<td>Lapis Lazuli</td>
<td>1.610</td>
</tr>
<tr>
<td>Topaz</td>
<td>1.610</td>
</tr>
<tr>
<td>Carbon Bisulfide</td>
<td>1.630</td>
</tr>
<tr>
<td>Material</td>
<td>IOR Value</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-----------</td>
</tr>
<tr>
<td>Quartz 1</td>
<td>1.644</td>
</tr>
<tr>
<td>Sodium Chloride (Salt) 2</td>
<td>1.644</td>
</tr>
<tr>
<td>Glass, Heavy Flint</td>
<td>1.650</td>
</tr>
<tr>
<td>Methylene Iodide</td>
<td>1.740</td>
</tr>
<tr>
<td>Ruby</td>
<td>1.770</td>
</tr>
<tr>
<td>Sapphire</td>
<td>1.770</td>
</tr>
<tr>
<td>Glass, Heaviest Flint</td>
<td>1.890</td>
</tr>
<tr>
<td>Crystal</td>
<td>2.000</td>
</tr>
<tr>
<td>Chromium Oxide</td>
<td>2.705</td>
</tr>
<tr>
<td>Copper Oxide</td>
<td>2.705</td>
</tr>
<tr>
<td>Amorphous Selenium</td>
<td>2.920</td>
</tr>
<tr>
<td>Iodine Crystal</td>
<td>3.340</td>
</tr>
</tbody>
</table>

**Wire group**

![Wire control panel](image)

---

*6018 | Chapter 17  Material Editor, Materials, and Maps*
Size  Sets the size of the wire in wireframe mode on page 8766. You can set either pixels or current units.

In  Chooses how to measure wire.

- **Pixels**  (The default.) Measures wire in pixels. With pixels, wires maintain the same apparent thickness regardless of the scale of the geometry or how near or far the object is positioned.

- **Units**  Measures wire in 3ds Max units. With units, the wires appear thinner at a distance and thicker at close range, as if they were modeled in the geometry.

**Reflection Dimming group**

These controls dim reflection maps that are in shadow.
Reflection dimming
Above: None
Below: 0.0 (100% dimming)

Apply Turn on to use reflection dimming. When off, the reflection-mapped material is not affected by the presence or absence of direct light. Default=off.

Dim Level The amount of dimming that takes place in shadow. At 0.0, the reflection map is completely dark in shadow. At 0.5, the reflection map is half dimmed. At 1.0, the reflection map is not dimmed and the material appears as if Apply were turned off. Default=0.0.

RefL. Level Affects the intensity of the reflection that is not in shadow. The Reflection Level value multiplies the illumination level of the lit area of the reflection, to compensate for dimming. In most cases, the default value of 3.0
keeps the reflection in the lit area at about the same level it would appear if reflection dimming were not on.

**Maps Rollout (Standard Material)**

Material Editor > Standard material > Maps rollout

A material's Maps rollout lets you access and assign maps on page 8631 to various components of the material.

You can choose from a large variety of map types. To find descriptions of these types, and how to set their parameters, see Map Types on page 6185.

**Assigning the Same Map to Different Parameters**

Applying the same map to different parameters is useful in some cases. For example, using a pattern to map both self-illumination and opacity can make the pattern appear to glow and hover in space.

**Blending Map Amounts for Opacity and Other Material Components**

When you map a scalar component (such as Specular Level, Glossiness, Self-Illumination, and Opacity), the component's value in the Basic Parameters on page 5989 rollout is blended with its associated map Amount in the Maps rollout.

For example, when the Opacity spinner is set to 0, the map Amount spinner completely controls Opacity. That is, reducing the Amount value increases the transparency of the entire surface. On the other hand, when Opacity is 100, reducing the map's Amount value increases the opacity of the entire surface. You can adjust a Checker Opacity map so that the opaque areas remain opaque, while the transparent areas become semi-transparent.

Other scalar components behave in the same way. Setting the map's Amount to 100 applies all of the map. Setting the Amount to 0 is the equivalent of turning the map off. Intermediate Amount values are blended with the value of the scalar component.

When you load old 3ds Max files or bring earlier materials from the Browser into the Materials Editor, the spinner values for Opacity, Specular Level, Glossiness, and Self-Illumination are altered, where necessary, to maintain the equivalent material effect.
**Ambient and Diffuse Map Lock**

In the Maps rollout, the lock button to the right of the Diffuse Color map button locks ambient mapping to diffuse mapping. It is on by default. Usually it makes sense to use the same map for the ambient and diffuse components. To use different maps for ambient and diffuse, turn off the lock button. The map button for Ambient Color becomes available.

**Procedures**

To assign a map:

1. In the Maps rollout, click a map button.
   
   A modal Material/Map Browser on page 5724 is displayed.

2. Use the Browse From buttons to choose where you want to look.
   
   If you choose Material Library and the dialog's display area is blank, you need to open a library file. Click the Open button and then choose the library to browse.

3. Use the display buttons to choose how you view maps.
   
   - View List shows each map by name.
   - View List + Icons shows a small preview and each map's name.
   - View Small Icons shows a small preview for each map.
   - View Large Icons shows a large preview for each map, along with the map's name.

   **TIP** You can resize the Browser dialog to increase the size of the display area. This is especially useful when you view large icons.

4. Double-click the map you want.
To use the same map for different parameters:

1. In the Maps rollout, use a map button to assign a map. The Material Editor is now at the map level, and displays controls for the map parameters.

2. Click Go To Parent to return to the material level, and then open the Maps rollout.

3. Drag the assigned map button to another map button. The Copy (Instance) Map dialog on page 5710 is displayed.

4. Choose Copy or Instance, and then click OK. If you choose Swap, the Material Editor swaps the two button assignments.

To view the parent material’s parameters:

- If you are currently at the map level in the Material Editor, click Go To Parent. The parameters for the map’s parent material are displayed. Also, the Show End Result and Go To Parent buttons become unavailable.

To view a map’s parameters:

- If you are currently at the material level in the Material Editor, click the button that corresponds to the map. The parameters for the map are displayed. Also, the Show End Result on page 5701 and Go To Parent on page 5702 buttons become available. In the Basic Parameters rollout, if a map has been assigned to a color component or parameter, the corresponding button displays a letter M. In the Maps rollout, if a map has been assigned, the corresponding button displays the map name.

To view a map’s location:

- Click Material/Map Navigator to view the Navigator. The Material/Map Navigator on page 5703 displays the hierarchy of the current material, which contains the map.
To go to a map using the Navigator:

- In the Material/Map Navigator on page 5703, click the name of the map, or the green or red parallelogram to the left of the map's name. The Navigator goes to the level of the map, and the Material Editor displays the controls for the map you clicked.
  As the Navigator’s map tree shows, maps for basic material components and parameters are one level below the material itself.

To preview a map in a sample slot:

1. Go to the level of the map, as described in previous procedures. The Material Editor displays the map's parameters.

2. Turn off Show End Result on page 5701.
   The sample slot shows the map instead of the material. If the map contains sub-maps, these are also visible.
   By default, the sample slot displays a map with no three-dimensional shading. You can change this in the Material Editor Options dialog on page 5681.

To view the map interactively:

1. Select an object.

2. In the object's creation parameters, make sure that Generate Mapping Coords is on.
   If the object type does not have a Generate Mapping Coordinates toggle, you need to assign mapping coordinates by applying a UVW Map modifier on page 1932.

3. In the Material Editor, assign the mapped material to the object.

4. If you are at the material level (the top level), click the appropriate map button to go to the map level.

5. Turn on Show Map In Viewport on page 5696.
   The map appears on objects assigned the material in all shaded viewports. Now when you adjust the map, the viewports update to display the adjustments.
Turning on Show Map In Viewport for one map automatically turns this button off for all other maps the material has.

Viewports can display 2D maps such as Checker and Bitmap. Viewports can also display most kinds of 3D maps. The exceptions are Particle Age and Particle MBlur. Also, the appearance of the Falloff map in viewports give only a vague indication of how it will appear when rendered.

Show Map In Viewport is unavailable if the active map type cannot display in viewports.

Displaying mapped materials in a viewport can slow performance. If you don’t need to view the texture, turn off its viewport display.

To turn off interactive texture display:

1. Go to the map level.
   If you are at the material level, click the appropriate map button to go to the map level.

2. Turn off Show Map in Viewport on page 5696.
   The object is shaded but the map no longer appears.

To turn a map off:

■ On the Maps rollout, turn off the map's check box. The check box is to the left of the map's name.
   When a map is off, a lowercase m appears on the corresponding map button.

To turn a map on:

■ In the Maps rollout, turn on the map's check box. The check box is to the left of the map's name.
When a map is on, an uppercase M appears on the corresponding map button.

**To change a map's strength:**

- In the Maps rollout, adjust the map's Amount spinner.
  The material's sample slot reflects the change.

---

**NOTE** Adjusting a map's output (in the map's Output rollout) can also change the map's strength.

---

**To move directly to an ancestor:**

1. Below the Material Editor toolbar, click the arrow to the right of the map's name field on page 5706.
   A drop-down list of ancestors is displayed.

2. Click a name in the Ancestor list.
   With this list, you can skip intermediate levels in the tree.

   ![The Ancestor drop-down list shows only part of the tree. It does not show side branches and siblings. To view these, use the Material/Map Navigator on page 5703 or the Go Forward To Sibling on page 5702 and Go To Parent on page 5702 buttons on the Material Editor toolbar.](image)

---

**To change a map type:**

1. At the level of a map, click the button labeled Type below the Material Editor toolbar.
   A modal Material/Map Browser on page 5724 is displayed. If you were at a map, it lists only maps (if you were at a material when you clicked Type, the Browser lists only materials).

2. Choose a map type from the list, and then click OK.
   If you change a map type and the new map type can have component maps, a Replace Map dialog is displayed. This dialog gives you a choice between discarding the original map or using it as a component map.
   If the new map type does not have components, it simply replaces the original map type.
To create a standalone map tree:

1. Activate a sample slot.

2. Click Get Material on page 5687.

3. In the Material/Map Browser on page 5724, make sure Browse From is set to New.

4. Double-click the name of the map type (not a material type) you want to use, or drag the map to a sample slot.

   The sample slot now contains a standalone map not associated with material parameters.

5. Use the Material Editor to modify the map as you would any other map.

   By default, the sample slot displays a map with no three-dimensional shading. You can change this in the Material Editor Options dialog on page 5681.
The Maps rollout contains a wide button for each map type. Click this button to select a bitmap file stored on disk or to select a procedural map type on page 8691. After you select a map, its name and type appears on the button. Use the check box to the left of the button to turn the effect of the map off and on. When the check box is off, the map is not computed and has no effect in the renderer.
The Amount spinner determines the amount that the map affects the material expressed as a percentage of full intensity. For example, a diffuse map at 100% is completely opaque and covers the base material. At 50%, it is semi-transparent and the base material (the diffuse, ambient, and other colors of the material without mapping) shows through.

The Maps rollout can have unused, disabled control rows at the bottom. This is because the number of components that can be mapped varies depending on the current shader on page 5969. The last four rows are always Bump, Reflection, Refraction, and Displacement, in that order.

**NOTE** The sub-material and sub-map buttons for most materials and maps have check boxes beside each button. These turn that branch of the material or map off or on. For example, in the Top/Bottom material, the Top Material and Bottom Material buttons each have check boxes. Similarly, the Checker map has two map buttons, one for each color. Each button has check box beside it that lets you turn off that color's map.

**Ambient Color Mapping**

Material Editor > Standard material > Maps rollout > Ambient button

You can select a bitmap file or procedural map on page 8691 to map an image to the material's ambient color on page 8504. The image is painted on the shaded parts of the object.
Mapping the ambient color

By default, diffuse mapping maps the ambient component as well, so you seldom need to use a different map for diffuse and ambient components. If you do want to apply a separate ambient map, first click to turn off the lock button to the right of the long Map buttons in the Maps rollout on page 6021. This unlocks ambient and diffuse mapping. The Map button for ambient color becomes available. You can then click the ambient button to select a map.

**NOTE** Ambient color mapping is not visible in viewports or renderings unless the level of ambient light is greater than default value of black. Choose Rendering > Environment, then adjust the level of ambient light using the Environment dialog on page 7163.
Procedures

To map the ambient color:

1. Make sure the ambient and diffuse components have their maps unlocked. Click to turn off the lock button. The Map button for ambient color becomes available.

2. Click the Map button for Ambient color.
   The Material/Map Browser on page 5703 is displayed.

3. Choose from the list of map types, and then click OK.
   The Material Editor is now at the map level, and displays controls for the map parameters.

4. Use the map controls to set up the map.

Diffuse Color Mapping

Material Editor > Standard material > Maps rollout > Diffuse button (or Color button for the Strauss shader)

You can select a bitmap file or procedural map on page 8691 to assign a pattern or texture to a material's diffuse color on page 8552. The colors of the map replace the material’s diffuse color component. This is the most common kind of mapping.
Applying a texture by mapping the diffuse color

Mapping the diffuse color is like painting an image on the surface of the object. For example, if you want a wall to be made out of brick, you can choose a map with an image of bricks, such as Bricks on page 6269.

By default, diffuse mapping applies the same map to the ambient color on page 8504 as well. You seldom need to use a different map for diffuse and ambient components.

It isn’t strictly necessary to lock the ambient and diffuse maps. By turning the lock off and using a different map for each component, you can obtain interesting blend effects. But in general, the purpose of diffuse mapping is to simulate a single surface that is more complex than a basic material, and for this purpose the lock should be on.

Procedures

To map the diffuse color:

1. Make sure the ambient and diffuse components have their maps locked. This button is to the right of the map shortcut buttons for Ambient and Diffuse on the Basic Parameters rollout, and on the Maps rollout in a
similar position. It is on by default. When it is on, the map button for the ambient color component is unavailable.

2  Click the Map button for Diffuse color.
   The Material/Map Browser on page 5703 is displayed.

3  Choose from the list of map types, and then click OK.
   The Material Editor is now at the map level, and displays controls for the map parameters.

4  Use the map controls to set up the map.

Diffuse Level Mapping

Material Editor > Standard material > Shader Basic Parameters rollout > Anisotropic, Oren-Nayar-Blinn, or Multi-Level shader > Maps rollout > Diffuse Level button

You can select a bitmap file or procedural map on page 8691 to control the Diffuse Level parameter. White pixels in the map leave the diffuse level unchanged. Black pixels reduce the diffuse level to 0. Intermediate values adjust the diffuse level accordingly.
Mapping diffuse level
Top: No mapping
Bottom: Mapping diffuse level with a bitmap

The diffuse level parameter is available with the Anisotropic on page 5978, Oren-Nayar-Blinn on page 5983, and Multi-Level on page 5982 shaders.

Reducing the Amount of the diffuse level map reduces the map's effect, and increases the effect of the Diffuse Level value on the Basic Parameters rollout. When the Amount is 0 percent, the map isn't used at all.
Procedures

To map the diffuse level value:

1. Click the Map button for Diffuse Level.
   The Material/Map Browser on page 5703 is displayed.

2. Choose from the list of map types, and then click OK.
   The Material Editor is now at the map level, and displays controls for the map parameters.

3. Use the map controls to set up the map.

Diffuse Roughness Mapping

Material Editor > Standard material > Shader Basic Parameters rollout > Oren-Nayar-Blinn or Multi-Level shader > Maps rollout > Diff. Roughness button

You can select a bitmap file or procedural map on page 8691 to control the Roughness parameter on the Basic Parameters rollout. White pixels in the map increase roughness. Black pixels reduce roughness to 0. Intermediate values adjust roughness accordingly.
Roughness map adds a textured pattern to the vase.

**NOTE** The Roughness parameter is available only with the Oren-Nayar-Blinn on page 5983 and Multi-Level on page 5982 shaders, and with the Arch & Design material (mental ray) on page 5858.

Reducing the Amount of the Diffuse Roughness map reduces the map's effect, and increases the effect of the Roughness value on the Basic Parameters rollout. When the Amount is 0 percent, the map isn't used at all.

**Procedures**

To map the roughness value:

1. Click the Map button for Diffuse Roughness (Diff. Roughness).
   The Material/Map Browser on page 5703 is displayed.

2. Choose from the list of map types, and then click OK.
   The Material Editor is now at the map level, and displays controls for the map parameters.

3. Use the map controls to set up the map.
Specular Color Mapping

Material Editor > Standard material > Maps rollout > Specular button

You can select a bitmap file or procedural map on page 8691 to apply an image to the material's specular color component on page 8728. The map's image appears only in the specular highlight areas.

Mapping the specular highlight

When the amount spinner is at 100, all specular color is provided by the map. Specular mapping is used primarily for special effects such as placing an image in a reflection. The important thing to remember is that, unlike Specular Level or Glossiness mapping, which alter the intensity and location of specular highlights, specular mapping alters the color of specular highlights.

Procedures

To map the specular color:

1. Click the Map button for Specular color.
   The Material/Map Browser on page 5703 is displayed.
2 Choose from the list of map types, and then click OK. The Material Editor is now at the map level, and displays controls for the map parameters.

3 Use the map controls to set up the map.

**Specular Level Mapping**

Material Editor > Standard material > Maps rollout > Specular Level button

You can select a bitmap file or procedural map on page 869 to alter the intensity of specular highlights, based on the intensity of the bitmap. White pixels in the map produce full specular highlights. Black pixels remove the specular highlights completely, and intermediate values reduce the specular highlights accordingly.

Mapping the specular level: the sea reflects more than the land.

Mapping the specular level component is different from mapping specular color. Mapping the specular level alters the **intensity** of highlights, while specular mapping alters the **color** of highlights.
Specular level mapping usually works best when you assign the same map to both Specular Level and Glossiness. (In the Maps on page 6021 rollout, you can do this by dragging from one map button to another.)

**Procedures**

**To map the specular level value:**

1. Click the Map button for the Specular Level value.
   The Material/Map Browser on page 5703 is displayed.
2. Choose from the list of map types, and then click OK.
   The Material Editor is now at the map level, and displays controls for the map parameters.
3. Use the map controls to set up the map.

**Glossiness Mapping**

Material Editor > Standard material > Maps rollout > Glossiness button

You can select a bitmap file or procedural map on page 8691 that affects where specular highlights appear. A map assigned to glossiness determines which areas of the whole surface are more glossy and which areas are less glossy, depending on the intensity of colors in the map. Black pixels in the map produce full glossiness. White pixels remove glossiness completely, and intermediate values reduce the size of the highlight.
An object with glossiness mapping. The sea appears more reflective than the land.

Mapping the glossiness component is different from mapping specular color. Mapping glossiness alters the location of highlights, while specular mapping alters the color of highlights.

Glossiness mapping usually works best when you assign the same map to both Glossiness and Specular Level. (In the Maps rollout, you can do this by dragging from one map button to the other.)

**Procedures**

**To map the glossiness value:**

1. Click the Map button for the Glossiness value.
   
   The Material/Map Browser on page 5703 is displayed.

2. Choose from the list of map types, and then click OK.
   
   The Material Editor is now at the map level, and displays controls for the map parameters.

3. Use the map controls to set up the map.
Self-Illumination Mapping

Material Editor > Standard material > Maps rollout > Self-Illumination button

You can select a bitmap file or procedural map on page 8691 to map the self-illumination on page 8714 value. This makes portions of an object appear to glow. White areas of the map render as fully self illuminating. Black areas render with no self-illumination. Gray areas render as partially self illuminating, depending on the grayscale value.

Mapping self-illumination

Self-illumination means that the glowing area is not affected by lights in the scene (its ambient color component goes away), and does not receive shadows.

Procedures

To map the self-illumination value:

1 Click the Map button for Self-Illumination.

   The Material/Map Browser on page 5703 is displayed.

2 Choose from the list of map types, and then click OK.
The Material Editor is now at the map level, and displays controls for the map parameters.

3 Use the map controls to set up the map.

**Opacity Mapping**

Material Editor > Standard material > Maps rollout > Opacity button

You can select a bitmap file or **procedural map** on page 8691 to make an object partially transparent. Lighter (higher-value) areas of the map render as opaque; darker areas render as transparent; and values in between are semi-transparent.

![Opacity Mapping Diagram](image)

The gray levels of an opacity map determine the amount of opacity.

Setting the opacity map's Amount to 100 applies all of the map. Transparent areas are fully transparent. Setting the Amount to 0 is the equivalent of turning the map off. Intermediate Amount values are blended with the Opacity value on the Basic Parameters rollout. Transparent areas of the map become more opaque.
Specular highlights are applied to transparent areas of the opacity map, as well as to opaque areas, creating the effect of glass. If you want the transparent areas to look like holes, map the specular level on page 6039 as well.

**Procedures**

**To map the opacity value:**

1. Click the Map button for Opacity.
   
   The Material/Map Browser on page 5703 is displayed.

2. Choose from the list of map types, and then click OK.
   
   The Material Editor is now at the map level, and displays controls for the map parameters.

3. Use the map controls to set up the map.

**Filter Color Mapping**

Material Editor > Standard material > Maps rollout > Filter Color button

The filter, or transmissive color, is the color transmitted through transparent or semi-transparent materials such as glass.
Mapping filter color

You can select a bitmap file or procedural map on page 8691 to map the filter color component. This map applies a transparent-color effect based on the intensity of the map's pixels.

You can combine a mapped filter color with volumetric lighting on page 7196 to create effects such as colored light through a stained-glass window. Ray-traced shadows on page 8696 cast by transparent objects are tinted by the filter color.

Procedures

To map the filter color:

1. Click the Map button for Filter color.
   The Material/Map Browser on page 5703 is displayed.

2. Choose from the list of map types, and then click OK.
   The Material Editor is now at the map level, and displays controls for the map parameters.

3. Use the map controls to set up the map.
Anisotropy Mapping

Material Editor > Standard material > Shader Basic Parameters rollout > Anisotropic or Multi-Level shader > Maps rollout > Anisotropy button

You can select a bitmap file or procedural map on page 8691 to control the Anisotropy parameter. The map controls the shape of the anisotropic highlight, roughly (but not necessarily) within the area specified by the glossiness parameter. Black and white values have little effect. Maps with a good deal of grayscale values, such as Noise on page 6303 or Falloff on page 6294, can be very effective.

Mapping anisotropy. The stretch of the highlight depends on the level of gray in the map.

The anisotropy parameter is available with the Anisotropic on page 5978 and Multi-Level on page 5982 shaders.

The effect of mapping anisotropy is not very apparent unless the specular level is fairly high and glossiness is fairly low.
Reducing the Amount of the anisotropy map reduces the map’s effect, and increases the effect of the Anisotropy value on the Basic Parameters rollout. When the Amount is 0 percent, the map isn’t used at all.

Procedures

To map the anisotropy value:

1. Click the Map button for Anisotropy.
   The Material/Map Browser on page 5703 is displayed.

2. Choose from the list of map types, and then click OK.
   The Material Editor is now at the map level, and displays controls for the map parameters.

3. Use the map controls to set up the map.

Orientation Mapping

Material Editor > Standard material > Shader Basic Parameters rollout > Anisotropic or Multi-Level shader > Maps rollout > Orientation button

You can select a bitmap file or procedural map on page 8691 to control the Orientation parameter. Orientation controls the position of the anisotropic highlight. Mapping orientation changes the highlight’s position. Black and white values have little effect. Maps with a good deal of grayscale values, such as Noise on page 6303 or Falloff on page 6294, can be very effective. You can also get a good effect using the same map for orientation mapping and bump mapping on page 6049.
Mapping anisotropy orientation

The orientation parameter is available with the Anisotropic on page 5978 and Multi-Level on page 5982 shaders.

Reducing the Amount of the orientation map reduces the map's effect, and increases the effect of the Orientation value on the Basic Parameters rollout. When the Amount is 0 percent, the map isn't used at all.

The effect of mapping orientation, like anisotropy, is not very apparent unless the specular level is fairly high and glossiness is fairly low.

**TIP** Using an instance of the same map to control both anisotropy and orientation can give you good control over anisotropic highlights.

**Procedures**

**To map the orientation value:**

1. Click the Map button for Orientation.
   
   The Material/Map Browser on page 5703 is displayed.

2. Choose from the list of map types, and then click OK.
The Material Editor is now at the map level, and displays controls for the map parameters.

3 Use the map controls to set up the map.

**Metalness Mapping**

Material Editor > Standard material > Shader Basic Parameters rollout > Strauss shader > Maps rollout > Metalness button

You can select a bitmap file or procedural map on page 8691 to control the Metalness parameter. White pixels in the map increase metalness. Black pixels reduce metalness to 0. Intermediate values adjust metalness accordingly.
The metalness parameter is available with the Strauss shader on page 5985. Reducing the Amount of the metalness map reduces the map's effect, and increases the effect of the Metalness value on the Basic Parameters rollout. When the Amount is 0 percent, the map isn't used at all.

**Procedures**

**To map the metalness value:**

1. Click the Map button for Metalness. The Material/Map Browser on page 5703 is displayed.
2. Choose from the list of map types, and then click OK. The Material Editor is now at the map level, and displays controls for the map parameters.
3. Use the map controls to set up the map.

**Bump Mapping**

You can select a bitmap file or procedural map on page 8691 to use for bump mapping. Bump mapping makes an object appear to have a bumpy or irregular surface. When you render an object with a bump-mapped material, lighter (whiter) areas of the map appear to be raised, and darker (blacker) areas appear to be low.
An object with two different bump maps.

**NOTE** The effect of a bump map is not previewed in viewports. You must render the scene to see the bump effect.

Bump mapping uses the intensity of the map to affect the surface of the material. In this case, the intensity affects the apparent bumpiness of the surface: white areas protrude, and black areas recede.

Use bump maps when you want to take the smoothness off a surface, or to create an embossed look. Keep in mind, however, that the depth effect of a bump map is limited. If you want extreme depth in a surface, you should use modeling techniques instead. For example, the Displace modifier on page 1313 pushes surfaces or faces in and out based on the intensity of a bitmap image. *(Displacement mapping on page 6059 is another way to do emboss a surface.)*

Grayscale images can make effective bump maps. Maps that shade between white and black generally work better than maps with hard edges between the white and black areas.

The bump map Amount adjusts the degree of bumpiness. Higher values render as higher relief; low values render as low relief.
The bumps are a simulation created by perturbing face normals before the object is rendered. Because of this, bumps don't appear on the silhouette of bump-mapped objects.

**TIP** If you render a bump-mapped material and notice aliasing in the highlights, try turning on supersampling on page 5759 and rendering again.

**NOTE** Most controls on the Output rollout on page 6192 don't affect bump mapping. Only the Invert toggle is considered; it reverses the direction of the bumps.

**Procedures**

**To assign a bump map:**

1. Click the Map button labeled Bump. The Material/Map Browser on page 5724 is displayed.
2. Choose from the list of map types on page 6185, and then click OK. The Material Editor is now at the map level, and displays controls for the map parameters. (If you choose Bitmap as the map type, you first see a file dialog that lets you choose the image file.)
3. Use the map controls to set up the map.

**TIP** To avoid aliasing caused by a 2D bump map, go to the bump map's Coordinates rollout. Set Blur to be in the range 0.3 to 0.6, and increase Blur Offset to be greater than 0.0. The default Blur and Blur Offset values work well for mapping other material components, but for bump mapping, lower Blur and higher Blur Offset values give better results.

**To remove a bump map from a material:**

**TIP** You can disable the map without removing it. Simply turn off the toggle immediately to the left of the map button on the Special Effects rollout.

1. If the Material Editor is displaying the map controls, click the Type button on page 5706 to display the Material/Map Browser. If the map controls aren't visible, click the Bump map button to display them, and then click the Type button.
2. In the Browser, choose NONE as the map type, and then click OK.
The map is removed.

**Reflection Mapping**

Material Editor > Standard material > Maps rollout > Reflection button

You can select a bitmap file or [procedural map](#) on page 8691 to use as a reflection map.

---

**Reflection created by mapping**

You can create three kinds of reflection: basic reflection maps, automatic reflection maps, and [flat-mirror](#) on page 8579 reflection maps.

- A basic reflection map creates the illusion of chrome, glass, or metal by applying a map to the geometry so that the image looks like a reflection on the surface.

- An automatic reflection map uses no mapping at all, but looks outward from the center of the object, and maps what it sees onto the surface.
Another way to generate reflections automatically is to assign a Raytrace map on page 6364 to be the reflection map.

A flat-mirror reflection map is applied to a series of coplanar faces and reflects objects facing it, exactly like a real mirror. Reflection maps don't need mapping coordinates on page 8628 because they're locked to the world, not to the geometry. The illusion of a reflection is created because the map doesn't move with the object, but with changes in the view, as do real reflections.

The most common use of reflection maps in a realistic scene is to add just a touch of reflection to an otherwise non-reflective surface. By default, reflection map strength is 100 percent, as it is for other maps. For many kinds of surfaces, however, reducing the strength gives the most realistic result. A polished table top, for example, primarily shows a wood grain; the reflections are secondary.

Reflection maps look more realistic if you increase the Glossiness and Specular Level values in the Basic Parameters rollout on page 5989. They are also affected by the diffuse on page 8552 and ambient on page 8504 color values. The darker the color, the stronger the mirror effect.

Even when the Amount spinner is at 100, the reflection map is tinted by the ambient, diffuse, and specular on page 8728 colors.

In metal materials, the Diffuse color tints the reflection map. Specifically, the color from the reflection map is multiplied by the diffuse color (including a diffuse map, if one exists). The value (in the HSV on page 8698 description) of the diffuse color controls the reflection map intensity. If the diffuse color value is 255, the reflection is at full intensity; if the value is 0, the map is not visible.

In non-metal materials, the Specular color multiplies only reflection maps. The value (in the HSV on page 8698 description) of the specular color affects the reflection intensity. If the specular color value is 255, the reflection is at full intensity; if the value is 0, the map is not visible.

**Procedures**

**To create an automatic reflection:**

1. In the Maps rollout, click the Map button labeled Reflection.
2. In the Material/Map Browser on page 5703, choose the Reflect/Refract map type, and then click OK.
Adjusting the map's Strength slider in the parent material's Maps rollout controls how reflective the material is. At 100 percent, the material is fully reflective.

To assign a bitmap as a reflection map:

1. In the Maps rollout, click the Map button labeled Reflection. In the Material/Map Browser on page 5703, double-click Bitmap.
2. In the Bitmap Parameters rollout, click the Bitmap button.
3. Use the file dialog to choose the bitmap file.
4. Reduce the Reflection map's Amount to get the effect you want.

Refractions are similar to reflections. Bitmaps simulate reflections, while Reflect/Refract maps generate them based on the scene's background and geometry.

**Refraction Mapping**

Material Editor > Standard material > Maps rollout > Refraction button

You can select a bitmap file or a procedural map on page 8691 such as Reflect/Refract on page 6375 to use for refraction mapping.
Refractions show the scene or background through a refractive object.

Refraction mapping is similar to reflection mapping. It maps the view onto the surface in such a way that the image looks like you're seeing it through the surface, rather than being reflected off it.

Like a reflection map, a refraction map's orientation is locked to the view rather than to the object. That is, as you move or rotate the object, the position of the refracted image remains fixed.

Setting the Index of Refraction

The physical properties of refractive objects often distort the image. A special parameter adjusts this distortion. It is in the parent material's Extended Parameters rollout on page 6013.

Index of Refraction The index of refraction (IOR) controls how severely the material refracts transmitted light. Left at 1.0, the IOR of air, the object behind the transparent object does not distort. At 1.5 the object behind distorts greatly (like a glass marble). At an IOR slightly less than 1.0, the object reflects along its edges (like a bubble seen from under water). Default=1.5 (the IOR of typical glass).
Common IORs (assuming the camera is in air or a vacuum) are:

<table>
<thead>
<tr>
<th>Material</th>
<th>IOR Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vacuum</td>
<td>1.0 (exactly)</td>
</tr>
<tr>
<td>Air</td>
<td>1.0003</td>
</tr>
<tr>
<td>Water</td>
<td>1.333</td>
</tr>
<tr>
<td>Glass</td>
<td>1.5 to 1.7</td>
</tr>
<tr>
<td>Diamond</td>
<td>2.418</td>
</tr>
</tbody>
</table>

In the physical world, the IOR results from the relative speeds of light through the transparent material and the medium the eye or the camera is in. Typically this is related to the object's density. The higher the IOR, the denser the object.

You can also use a map to control the index of refraction. IOR maps always interpolate between 1.0 (the IOR of air) and the setting in the IOR parameter. For example, if you set the IOR to 3.55 and use a black-and-white Noise map to control IOR, the IORs rendered on the object will be set to values between 1.0 and 3.55; the object will appear denser than air. If, on the other hand, you set the IOR to 0.5, then the same map values will render between 0.5 and 1.0: as if the camera is under water and the object is less dense than the water.

Here are some more IOR values for various materials:

<table>
<thead>
<tr>
<th>Material</th>
<th>IOR Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Carbon Dioxide, Liquid</td>
<td>1.200</td>
</tr>
<tr>
<td>Ice</td>
<td>1.309</td>
</tr>
<tr>
<td>Acetone</td>
<td>1.360</td>
</tr>
<tr>
<td>Ethyl Alcohol</td>
<td>1.360</td>
</tr>
<tr>
<td>Sugar Solution 30%</td>
<td>1.380</td>
</tr>
<tr>
<td>Alcohol</td>
<td>1.329</td>
</tr>
<tr>
<td>Material</td>
<td>IOR Value</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-----------</td>
</tr>
<tr>
<td>Flourite</td>
<td>1.434</td>
</tr>
<tr>
<td>Quartz, Fused</td>
<td>1.460</td>
</tr>
<tr>
<td>Calspar2</td>
<td>1.486</td>
</tr>
<tr>
<td>Sugar Solution 80%</td>
<td>1.490</td>
</tr>
<tr>
<td>Glass</td>
<td>1.500</td>
</tr>
<tr>
<td>Glass, Zinc Crown</td>
<td>1.517</td>
</tr>
<tr>
<td>Glass, Crown</td>
<td>1.520</td>
</tr>
<tr>
<td>Sodium Chloride</td>
<td>1.530</td>
</tr>
<tr>
<td>Sodium Chloride (Salt) 1</td>
<td>1.544</td>
</tr>
<tr>
<td>Polystyrene</td>
<td>1.550</td>
</tr>
<tr>
<td>Quartz 2</td>
<td>1.553</td>
</tr>
<tr>
<td>Emerald</td>
<td>1.570</td>
</tr>
<tr>
<td>Glass, Light Flint</td>
<td>1.575</td>
</tr>
<tr>
<td>Lapis Lazuli</td>
<td>1.610</td>
</tr>
<tr>
<td>Topaz</td>
<td>1.610</td>
</tr>
<tr>
<td>Carbon Bisulfide</td>
<td>1.630</td>
</tr>
<tr>
<td>Quartz 1</td>
<td>1.644</td>
</tr>
<tr>
<td>Material</td>
<td>IOR Value</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------</td>
</tr>
<tr>
<td>Sodium Chloride (Salt) 2</td>
<td>1.644</td>
</tr>
<tr>
<td>Glass, Heavy Flint</td>
<td>1.650</td>
</tr>
<tr>
<td>Methylene Iodide</td>
<td>1.740</td>
</tr>
<tr>
<td>Ruby</td>
<td>1.770</td>
</tr>
<tr>
<td>Sapphire</td>
<td>1.770</td>
</tr>
<tr>
<td>Glass, Heaviest Flint</td>
<td>1.890</td>
</tr>
<tr>
<td>Crystal</td>
<td>2.000</td>
</tr>
<tr>
<td>Diamond</td>
<td>2.418</td>
</tr>
<tr>
<td>Chromium Oxide</td>
<td>2.705</td>
</tr>
<tr>
<td>Copper Oxide</td>
<td>2.705</td>
</tr>
<tr>
<td>Amorphous Selenium</td>
<td>2.920</td>
</tr>
<tr>
<td>Iodine Crystal</td>
<td>3.340</td>
</tr>
</tbody>
</table>

Tip: The Reflect/Refract on page 6375 map type used as a Refraction map doesn’t effectively model a material surrounding an object, such as a pencil in a glass of water. For this effect, use either the Thin Wall Refraction on page 6382 or the Raytrace map type on page 6364.

**Procedures**

To create an automatic refraction:

1. In the Maps rollout, click the Map button labeled Refraction.
2 In the Material/Map Browser on page 5703, choose the Reflect/Refract on page 6375 map type, and then click OK.

At a Refraction Amount of 100 percent, the material is extremely refractive, regardless of the material's Opacity setting. At a Refraction Amount of 0 percent, the map is turned off. When the Amount is less than 100 percent, both the Reflect/Refract map and the Opacity setting control transparency.

To assign a bitmap as a refraction map:

1 In the Maps rollout, click the Refraction map button.
2 Use the Material/Map Browser on page 5703 to choose the Bitmap type.
3 Use the file dialog to choose the bitmap file.

For bitmapped refractions, you don't necessarily want to reduce the map strength.

Displacement Mapping

Material Editor > Standard material > Maps rollout > Displacement button

A displacement map displaces the geometry of surfaces. The effect is similar to using the Displace on page 1313 modifier. Unlike bump mapping on page 6049, displacement mapping actually changes the geometry of the surface or patch tessellation. Displacement maps apply the gray scale of the map to generate the displacement. Lighter colors in the 2D image push outward more strongly than darker colors, resulting in a 3D displacement of the geometry.
Using displacement mapping to alter a surface

**WARNING** A displacement map generates many triangular faces per surface, sometimes over 1M faces per surface. While displacement mapping can create good effects, there is a large cost in terms of time and memory.

The displacement Amount is measured as a percentage of the diagonal of the bounding box for the object that contains the patch or surface. This makes the displacement effect consistent for all surfaces in an object, and it also means that when you scale the object, the displacement is scaled with it.

You can apply a displacement map directly to the following kinds of objects:

- Bezier patches on page 2408
- Editable meshes on page 2192
- Editable polymeshes on page 2240
- NURBS surfaces on page 2416

For other kinds of geometry such as primitives, extended primitives, compound objects, and so on, you can’t apply displacement mapping directly. To use displacement mapping with these kinds of objects, apply a **Disp Approx** on page 1310 (Displacement Approximation) modifier. This makes the object's
surface displaceable. Disp Approx works with any kind of object that you can convert to an editable mesh.

Displacement mapping isn't visible in viewports unless you apply a modifier to make it so.

- For NURBS surfaces, you can make displacement mapping visible in viewports and editable as a mesh object by using the Displace NURBS on page 1071 world space modifier.

- For editable meshes and objects with Disp Approx applied to them, use the Displace Mesh on page 1068 modifier to obtain the same effect.

**NOTE** If you apply a UVW Map on page 1932 modifier to the surface, all maps obtain their coordinates from the modifier except for the displacement map, which always obtains its coordinates from the original surface or the Disp Approx modifier.

Under certain circumstances, such as when the underlying mesh is fairly simple, displacement mapping of an editable mesh can cause problems because of the way the underlying mesh is tessellated. (These problems don't occur when you apply displacement mapping to a NURBS surface.) When this happens, smoothing does not work properly and you can see the underlying wireframe mesh in the surface itself. To correct this problem, use these techniques:

- Avoid applying displacement mapping to large areas of a single color. Map the diffuse color and use a small amount of variation, such as slight amount of noise, in the map you use for the diffuse color.

- Add a small amount of noise to the map you use for displacement. This can complicate the tessellation enough to ease the problem.

- Add detail to the mesh. The more initial faces, and the smoother the mesh curvature, the more even the displacement mapping will be.

**Procedures**

To apply a displacement map to a NURBS surface, editable mesh, or patch:

1. In a material's Maps rollout, click the map button for Displacement. The Material/Map Browser on page 5703 is displayed.

2. Choose from the list of map types, and then click OK.
The Material Editor is now at the map level, and displays controls for the map parameters.

3 Use the map controls to set up the map.

To apply a displacement map to other kinds of objects:

1 Select the object. Go to the Modify panel and choose Disp Approx from the Modifiers drop-down list. You can adjust the Disp Approx modifiers parameters, or you can leave them at their default settings.

2 Go to the Material Editor.

3 In a material's Maps rollout, click the map button for Displacement. The Material/Map Browser on page 5703 is displayed.

4 Choose from the list of map types, and then click OK. The Material Editor is now at the map level, and displays controls for the map parameters.

5 Use the map controls to set up the map. For example, if you chose Bitmap as the map type, you now need to select the bitmap file to use.

Dynamics Properties Rollout

Material Editor > Standard material > Dynamics Properties rollout

The Dynamics Properties rollout lets you specify surface properties that affect the animation of an object upon collision with another object. If there are no collisions in your simulation, these settings have no effect. The dynamics properties are used by the Dynamics utility on page 4190.

Since the Dynamics Properties rollout is available at the top level of any material (including submaterials), you can specify different surface dynamic properties for each face in an object. There are also controls in the Dynamics utility that let you adjust the surface properties at the object level, but only the Materials Editor lets you alter the surface properties at the sub-object level, through use of a Multi/Sub-Object material on page 6120.
As a default, the values in the Dynamics Properties rollout provide a surface that's similar to Teflon-coated hardened steel.

**Interface**

<table>
<thead>
<tr>
<th>Dynamics Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bounce Coefficient:</strong> 1.0</td>
</tr>
<tr>
<td><strong>Static Friction:</strong> 0.0</td>
</tr>
<tr>
<td><strong>Sliding Friction:</strong> 0.0</td>
</tr>
</tbody>
</table>

**Bounce Coefficient** Sets how far an object bounces after hitting a surface. The higher the value, the greater the bounce. A value of 1 represents a "perfectly elastic collision," or a bounce in which no kinetic energy is lost. Default=1.0. If you've seen the desktop toy with four ball bearings swinging back and forth on strings and hitting one another, you've seen an example that comes very close to a bounce coefficient of 1. Generally, hardened steel or a super ball have a bounce near 1, while lead has a bounce near 0.

**Static Friction** Sets how difficult it is for the object to start moving along a surface. The higher this value, the more difficult. Default=0.0. If something weighs ten pounds and sits on Teflon (a static friction of near 0), it takes almost no force to make it move sideways. On the other hand, if it sits on sandpaper, then the static friction might be very high, on the order of 0.5 to 0.8. A static friction near 1 is very difficult to create in the real world without adhesives or friction material.

**Sliding Friction** Sets how difficult it is for the object to keep moving over a surface. The higher this value, the more difficult for the object to keep moving. Default=0.0. Once two objects begin to slide over one another, static friction disappears and sliding friction takes over. Generally, sliding friction is lower than static friction due to surface tension effects. For example, once steel starts sliding over brass (a value of static friction that might run from 0.05 to 0.2), the sliding friction drops to a significantly lower value, on the order of .01 to 0.1. For some materials, such as specific friction materials like brake linings, sliding friction is just as high as static friction because it is used in conjunction with a nearly frictionless material such as hardened polished steel.
Raytrace Material

Material Editor > Type button > Material/Map Browser > Raytrace

Raytrace material is an advanced surface shading material. It supports the same kinds of diffuse surface shading that a standard material does. It can also create fully raytraced reflections and refractions. It also supports fog, color density, translucency on page 8751, fluorescence on page 8581, and other special effects.

Balls using raytrace material to reflect each other

The reflections and refractions Raytrace material generates are more accurate than those produced by the Reflect/Refract on page 6375 map. Rendering raytraced objects can be slower than using Reflect/Refract. On the other hand, Raytrace is optimized for rendering 3ds Max scenes. You can further optimize it for your scene by excluding specific objects from raytracing.

**NOTE** If you want accurate, raytraced reflections or refractions in a standard material you can use the Raytrace map on page 6364, which uses the same raytracer. The Raytrace map and material share global parameter settings.

**IMPORTANT** Raytrace map and Raytrace material use a surface's normal to decide whether a ray is entering or exiting a surface. If you flip the normals of an object, you can get unexpected results. Making the material 2-Sided doesn't correct the problem as it often does with reflections and refractions in Standard materials.

In some cases, the colors in the Basic Parameters rollout of Raytrace material behave differently from colors in standard materials. Standard material has a diffuse shading model that does an excellent job of rendering solid,
nonreflective objects such as plastic, ceramic, and so on. In effect, this model applies color to the object. The color components in Raytrace material, on the other hand, attempt to model their physical counterparts in nature.

In Raytrace material, the surface reflects its Diffuse color component without specular reflection, while the Reflect color component controls the amount of specular reflection. These two material components are layered together. The results you see depend on the layering effect. For example, if the material is not transparent and completely reflective, no diffuse color is visible. If the material is not transparent and completely nonreflective, only the diffuse color is visible.

The Dynamics Properties rollout for the Raytrace material contains the same controls as the dynamics properties for a standard material on page 5962.

Raytrace material has a large user interface with a lot of controls. In general, if you are using Raytrace to create reflections and refractions, the controls in the Basic Parameters rollout are the only ones you need to adjust. The Extended Parameters rollout for Raytrace has controls for special effects. The Raytracer Controls rollout affects the raytracer itself. Use the Raytracer Controls to turn the raytracer on or off, and to toggle other options. Use the Raytracer Global Parameters rollout on page 6666 (Rendering > Raytrace Globals) to set options globally (for all Raytrace materials and maps in the scene), including recursion depth.

See also:

- SuperSampling Rollout on page 5759
- Raytracer Global Parameters Rollout on page 6666

**Raytrace Basic Parameters Rollout**

Main toolbar > Material Editor > Type button > Material/Map Browser > Choose Raytrace. > Raytrace Basic Parameters rollout

The Raytrace Basic Parameters rollout for a Raytrace material on page 6064 controls the material’s shading, color components, reflectivity or refractivity, and bumps.
The basic parameters in this rollout are similar to the basic parameters for standard materials, but the color components of a Raytrace material behave differently.

As with standard materials, you can use a map for Raytrace color components and various other parameters. The small buttons to the right of the color swatches and parameters take you to the Material/Map Browser on page 5724, where you select a map of corresponding type. These are shortcuts that also have corresponding buttons in the Maps rollout. If you have assigned a map to one of these colors, the button displays the letter M. An uppercase M means that the corresponding map is assigned and active. A lowercase m means that the map is assigned and inactive (turned off).
Shading drop-down list Chooses a shader. Depending on the shader you choose, the Specular Highlight can change to show the controls for that shader. The alternatives are:

- **Anisotropic**: on page 6004 For surfaces with elliptical, "anisotropic" highlights.
- **Blinn**: on page 6006 For rounder, softer highlights than Phong shading.
- **Metal**: on page 6008 For metallic highlights.
- **Oren-Nayar-Blinn**: on page 6006 For matte surfaces such as fabric or terra-cotta.
- **Phong**: on page 6006 For surfaces with strong, circular highlights. Phong is the default shading type.

2-Sided Same as for standard materials. When on, shades and raytraces both sides of faces. By default, objects are one-sided in order to speed up rendering. If you have a 2-sided, reflective and refractive object, and you use the raytrace map on page 6364 rather than the material, the raytracer runs until it hits the maximum recursion level. This can be time-consuming.

Wire Same as for standard materials. When on, renders the material in wireframe mode on page 8766. You can specify the wire size in the Extended Parameters rollout.

With pixels, wires maintains the same apparent thickness regardless of the scale of the geometry or how near or far the object is positioned. With units, the wires appear thinner at a distance and thicker at close range, as if they were modeled in the geometry.

Face Map Applies the material to the faces of the geometry. If the material is a mapped material, it requires no mapping coordinates on page 8628. The map is automatically applied to each facet of the object.

Faceted Renders each face of a surface as if it were flat.

**NOTE** Raytrace material has the same SuperSampling on page 5759 options as a Standard material.

Ambient This is not the same as the standard ambient color. For Raytrace material, this controls an ambient absorption factor: that is, how much the material absorbs ambient light. Setting Ambient to white is the same as locking the ambient and diffuse colors in a standard material. Default=black.

- **Ambient Color check box**  When on, the material uses an ambient color. When off, the material uses a spinner to set a grayscale value only. Default=on.
■ **Color swatch**  When on, the color swatch shows the ambient color. To change the color, click the swatch and then use the **Color Selector** on page 371.

■ **Mono spinner**  When the check box is off, the ambient component is gray, and this spinner lets you adjust the gray value. Click the map button to assign a map to the ambient component. See **Ambient Mapping** on page 6029. This button is a shortcut: you can also assign ambient mapping on the **Raytrace Maps rollout** on page 6082.

**Diffuse**  Sets the diffuse color. This is the same as the standard diffuse color. It is the color that the object reflects, without specular reflection. Reflection and transparency effects are layered on top of the diffuse result. When Reflect is 100% (pure white), the diffuse color isn't visible. (This differs from the standard material.) Default=50% gray.

**Reflect**  Sets the specular reflection color. This is the color that the reflected environment (that is, the rest of the scene) is filtered through. The color's Value controls the amount of reflection. If your reflect color is saturated and the diffuse color is black, the effect is like colored chrome (for example, colored Christmas tree balls). Default=black (no reflection).

If raytracing is off (on the Raytracer Controls rollout), the object still reflects the environment, but ignores other objects in the scene. The environment can be the background color, the environment map, or the map in the Raytrace material's Environment component.

**TIP**  If you turn off raytraced reflections, set the Reflect color to a color other than black, and use a Reflect/Refract map for the local environment (see the Environment parameter, below), you get the same effect as a reflection map in a standard material. This can improve rendering time.

**NOTE**  Raytrace reflects and transmits the IDs in **material ID channel** on page 5694 (G-buffer on page 8589), so it can create glowing reflections, and so on.

■ **Reflect Color check box**  When on, the material uses a reflection color. When off, the material uses a spinner to set a grayscale value only. Default=on.

■ **Color swatch**  When the check box is on, the color swatch shows the reflection color. To change the color, click the swatch and then use the **Color Selector** on page 371.

■ **Mono spinner**  When the check box is off, the reflection color component is gray, and this spinner lets you adjust the gray value.
- **Fresnel**  Clicking the check box a second time displays this option. When active, applies a Fresnel effect to the reflection. This can add a bit of refraction to the reflecting object, depending on the viewing angle of the object.

Click the map button to assign a map to the reflect component. This button is a shortcut: you can also assign reflect mapping in the Raytrace Maps rollout on page 6082.

**Luminosity**  Similar to the Standard material's self-illumination component, except that it does not depend on the diffuse color. You can have a blue diffuse object with red luminosity. Default=black.

---

**NOTE**  When Luminosity is off, the name of this control changes to Self-Illum (Self-Illumination).

- **Luminosity check box**  When on, the material uses a luminosity color. When off, the material uses a spinner to set a grayscale value only for self-illumination. Default=on.

- **Color swatch**  When the check box is on, the color swatch shows the luminosity color. To change the color, click the swatch and then use the Color Selector on page 371.

- **Mono spinner**  When the check box is off, the luminosity color component is gray, and this spinner lets you adjust the gray value.

---

Click the map button to assign a map to the luminosity component. This button is a shortcut; you can also assign reflect mapping in the Raytrace Maps rollout on page 6082.

**Transparency**  Similar to the standard material's filter color for transmitted light, combined with the standard material's opacity controls. This color filters scene elements that are behind the object with Raytrace material. Black is opaque, white is fully transparent, and any value in between filters objects behind the raytraced object. A fully saturated color in both the diffuse and transparency components gives the effect of tinted glass. If you want more of an opaque look, pick the color you want as a transparent color, copy it to the diffuse color, make the diffuse color fully saturated, and then adjust the transparency to get the effect you want. Default=black (no transparency). If raytracing is turned off (in the Raytracer Controls rollout), the object still refracts the environment mapping, but ignores other objects in the scene.
NOTE  By separating the diffuse, reflect, and transparency components, Raytrace material gives you a great deal of control over how the object reacts to its environment. For example, an object might diffusely reflect red, specularly reflect green, and transmit blue. This is not a real-world effect, but it can be useful.

- **Transparency Color check box**  When on, the material uses a transparency color. When off, the material uses a spinner to set a grayscale value only. Default=on.

- **Color swatch**  When the check box is on, the color swatch shows the transparency color. To change the color, click the swatch and then use the Color Selector on page 371.

- **Mono spinner**  When the check box is off, the transparency color component is gray, and this spinner lets you adjust the gray value.

Click the map button to assign a map to the transparency component. See Filter Color Mapping on page 6043. This button is a shortcut: you can also assign reflect mapping in the Raytrace Maps rollout on page 6082.

**Index of Refr. (Refraction)**  The index of refraction (IOR) controls how severely the material refracts transmitted light. At 1.0, the IOR of air, the object behind the transparent object does not distort. At 1.5, the object behind distorts greatly, like a glass marble. At an IOR slightly less than 1.0, the object reflects along its edges, like a bubble seen from under water. Default=1.55.

Common IORs (assuming the camera is in air or a vacuum) are:

<table>
<thead>
<tr>
<th>Material</th>
<th>IOR Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vacuum</td>
<td>1.0 (exactly)</td>
</tr>
<tr>
<td>Air</td>
<td>1.0003</td>
</tr>
<tr>
<td>Water</td>
<td>1.333</td>
</tr>
<tr>
<td>Glass</td>
<td>1.5 to 1.7</td>
</tr>
<tr>
<td>Diamond</td>
<td>2.418</td>
</tr>
</tbody>
</table>

In the physical world, the IOR results from the relative speeds of light through the transparent material and the medium the eye or the camera is in. Typically
this is related to the object's density, and the higher the IOR, the denser the object.

You can also use a map to control the IOR. IOR maps always interpolate between 1.0 (the IOR of air) and the setting in the IOR parameter. For example, if the IOR is set to 3.55 and you use a black-and-white Noise map to control IOR, the IORs rendered on the object will be set to values between 1.0 and 3.55. The object will appear denser than air. If, on the other hand, your IOR is set to 0.5, then the same map values will render between 0.5 and 1.0, as if the camera were under water and the object was less dense than the water.

Here are some more IOR values for various materials:

<table>
<thead>
<tr>
<th>Material</th>
<th>IOR Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Carbon Dioxide, Liquid</td>
<td>1.200</td>
</tr>
<tr>
<td>Ice</td>
<td>1.309</td>
</tr>
<tr>
<td>Acetone</td>
<td>1.360</td>
</tr>
<tr>
<td>Ethyl Alcohol</td>
<td>1.360</td>
</tr>
<tr>
<td>Sugar Solution 30%</td>
<td>1.380</td>
</tr>
<tr>
<td>Alcohol</td>
<td>1.329</td>
</tr>
<tr>
<td>Flourite</td>
<td>1.434</td>
</tr>
<tr>
<td>Quartz, Fused</td>
<td>1.460</td>
</tr>
<tr>
<td>Calspar2</td>
<td>1.486</td>
</tr>
<tr>
<td>Sugar Solution 80%</td>
<td>1.490</td>
</tr>
<tr>
<td>Glass</td>
<td>1.500</td>
</tr>
<tr>
<td>Glass, Zinc Crown</td>
<td>1.517</td>
</tr>
<tr>
<td>Material</td>
<td>IOR Value</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------</td>
</tr>
<tr>
<td>Glass, Crown</td>
<td>1.520</td>
</tr>
<tr>
<td>Sodium Chloride</td>
<td>1.530</td>
</tr>
<tr>
<td>Sodium Chloride (Salt) 1</td>
<td>1.544</td>
</tr>
<tr>
<td>Polystyrene</td>
<td>1.550</td>
</tr>
<tr>
<td>Quartz 2</td>
<td>1.553</td>
</tr>
<tr>
<td>Emerald</td>
<td>1.570</td>
</tr>
<tr>
<td>Glass, Light Flint</td>
<td>1.575</td>
</tr>
<tr>
<td>Lapis Lazuli</td>
<td>1.610</td>
</tr>
<tr>
<td>Topaz</td>
<td>1.610</td>
</tr>
<tr>
<td>Carbon Bisulfide</td>
<td>1.630</td>
</tr>
<tr>
<td>Quartz 1</td>
<td>1.644</td>
</tr>
<tr>
<td>Sodium Chloride (Salt) 2</td>
<td>1.644</td>
</tr>
<tr>
<td>Glass, Heavy Flint</td>
<td>1.650</td>
</tr>
<tr>
<td>Methylene Iodide</td>
<td>1.740</td>
</tr>
<tr>
<td>Ruby</td>
<td>1.770</td>
</tr>
<tr>
<td>Sapphire</td>
<td>1.770</td>
</tr>
<tr>
<td>Glass, Heaviest Flint</td>
<td>1.890</td>
</tr>
</tbody>
</table>
### Specular Highlight group

The controls in this group affect the appearance of specular highlights. Specular highlights simulate the surface of the raytraced object reflecting the lights in the scene. Changing the color or intensity of lights in the scene can change the appearance of specular highlights.

As in standard materials, as you adjust the values in this group the highlight curve at the right changes to give you an idea of the effect. The material preview in the sample slot also updates.

**Specular Color** Sets the specular color on page 8728, assuming there are white lights in the scene.

Click the color swatch to display the Color Selector on page 371 and change the highlight color.

Click the map button to assign a map to the specular color. See Specular Mapping on page 6037. This button is a shortcut: you can also assign specular level mapping in the Raytrace Maps rollout on page 6082.

The remaining controls in the Specular Highlight group depend on the active shader, as shown next to “Shading:” at the top of this rollout. These highlight controls are the same as for the Standard material shaders.

These are the highlight controls available to Raytrace materials:

- Anisotropic highlights on page 6004
- Blinn, Oren-Nayar-Blinn, and Phong highlights on page 6006

---

<table>
<thead>
<tr>
<th>Material</th>
<th>IOR Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Crystal</td>
<td>2.000</td>
</tr>
<tr>
<td>Diamond</td>
<td>2.418</td>
</tr>
<tr>
<td>Chromium Oxide</td>
<td>2.705</td>
</tr>
<tr>
<td>Copper Oxide</td>
<td>2.705</td>
</tr>
<tr>
<td>Amorphous Selenium</td>
<td>2.920</td>
</tr>
<tr>
<td>Iodine Crystal</td>
<td>3.340</td>
</tr>
</tbody>
</table>
Environmental and Raytrace Extended Parameters Rollout

**Environment** Specifies an environment map that overrides the global environment map. Both Reflect and Transparency use the scene-wide environment map unless you use this button to specify another map. With this control, you can use different environment maps on a per-object basis, or provide an environment to specified objects when the scene as a whole has none.

This map overrides the scene-wide environment for both reflection and refraction. To override for refraction alone, see the Transparency Environment control in the Extended Parameters rollout.

Use the check box to turn this map on or off.

**TIP** You can use any map as the Raytrace environment, including the Reflect/Refraet on page 6375 map. Reflect/Refraction is often adequate for getting the required look, and it usually renders more quickly than raytracing the entire scene, especially if the Raytrace material is transparent. If you are using Raytrace material just to get the glass to look right on a car's headlight or on a light bulb hanging in the middle of a room, turn off the raytracer and use an environment map instead.

**Lock button** Locks the Environment map to the Transparency Environment map (found on the Extended Parameters rollout on page 6074). When on, the Transparency Environment map controls are disabled, and a map applied to the Raytrace Environment applies to the Transparency Environment as well. When off, the Transparency Environment map controls are enabled, and the Transparency Environment can have a different map assigned to it. Default=on.

Changing this button's setting here also changes it on the Extended Parameters rollout on page 6074 and the Maps rollout on page 6082.

**Bump** This is the same as bump mapping on page 6049 for Standard materials. Click the button to assign the map. Use the spinner to change the bump Amount. Use the check box to turn the map on or off.

---

**Raytrace Extended Parameters Rollout**

Material Editor > Type button > Material/Map Browser > Raytrace > Extended Parameters rollout

---

Metal highlights on page 6008

**NOTE** Highlight controls that don’t pertain to the current shader are labeled “N/A.”
The Extended Parameters rollout for a Raytrace material on page 6064 controls the material's special effects, transparency properties, and advanced reflectivity.

**Interface**

![Extended Parameters rollout](image)

Except for the wireframe controls, the controls in the Extended Parameters rollout for Raytrace material are specific to the Raytrace material.

**Special Effects group**

The controls in this group are special effects. They are powerful, but you might need to experiment to use them effectively.
Extra Lighting Adds light to the surface of objects with the Raytrace material. You can view this as an ambient lighting color that you can control on a per-material basis, but don't confuse it with the ambient absorption from the Basic Parameters rollout.

By mapping this parameter, you can simulate radiosity: the ambient light that results from reflected light in a scene. One effect of radiosity is color bleeding. For example, in strong light a white shirt next to an orange wall will show a reflected orange color.

Translucency Creates a translucent effect on page 8751. The Translucency color is a non-directional diffuse reflection. The diffuse color on an object depends upon the angle between the surface normal and the position of the light source. By ignoring the surface normal alignment, this color component simulates translucent materials.

For thin objects, the appearance can be like shining a light on the back of a piece of rice paper. You can cast shadows onto the back of the paper and see
them projected through the paper; this works well with a projector light. On thicker objects, you can get some good wax-like effects.

**Fluorescence and Fluor. Bias** Creates an effect similar to black light on a black light poster. The light from a black light is largely ultraviolet, outside the visible spectrum. Under black light, fluorescent paints flare or glow. The fluorescence in Raytrace material takes whatever light it sees in the scene, applies the Bias to it, and then, regardless of the color of the lights in the scene, illuminates the fluorescent material as if it were lit by white light. At 0.5, the Bias makes Fluorescence behave just like diffuse coloring. Bias values higher than 0.5 increase the fluorescent effect, making the object brighter than other objects in the scene. Bias values lower than 0.5 make the object dimmer than other objects in the scene. You can get some chromatic shifting effects with this.

**TIP** Full saturation and value for the Fluorescence color help give the effect of commercial fluorescent paints.

**TIP** A slight amount of Fluorescence can add to the realism of skin and eyes.

**Wire group**

**Size** Sets the size of the wire in wireframe mode. You can set either pixels (the default) or current units.

**In** Chooses how to measure wire. With pixels, wires maintain the same apparent thickness regardless of the scale of the geometry or how near or far the object is positioned. With units, the wires appear thinner at a distance and thicker at close range, as if they were modeled in the geometry.

**Pixels** (The default.) Measures wire in pixels.

**Units** Measures wire in 3ds Max units.

**Advanced Transparency group**

The controls in this group let you further tune transparency effects.

**Transp. (Transparency Environment)** Similar to the environment map in Basic Parameters, but overrides the scene's environment map for transparency (refraction) only. Transparent objects refract this map, while reflections still reflect the scene (or the Basic Parameters Environment map, if one is chosen). Click the button to choose the Transparency Environment map. Use the check box to toggle the effect of the map.
Lock button  Locks the Transparency Environment map to the Environment map (found on the Basic Parameters rollout on page 6065). When on, the Transparency Environment map controls are disabled, and a map applied to the Raytrace Environment applies to the Transparency Environment as well. When off, the Transparency Environment map controls are enabled, and the Transparency Environment can have a different map assigned to it. Default=on. Changing this button’s setting here also changes it on the Basic Parameters rollout on page 6065 and the Maps rollout on page 6082.

Density  The density controls are for transparent materials. If the material is opaque (the default), they have no effect.

Color  Sets a transmission color based on thickness. While filter (Transparency) color tints objects behind the transparent object, the density color gives the appearance of color within the object itself, like tinted glass.

To use, first make sure the object is transparent. Click the color swatch to display the Color Selector. Choose a color, and then turn on the check box. The Amount controls the amount of density color. Reducing this value reduces the density color effect. Range=0 to 1.0. Default=1.0.

A thin piece of tinted glass is mainly clear, while a thick piece of the same glass has more color. The Start and End controls help you simulate this effect. They are expressed in world units. Start is the position in the object where the density color begins to appear. (Default=0.0.) End is the position in the object where the density color reaches its full Amount value. (Default=25.0) To have a lighter effect, increase the End value. To have a heavier effect, reduce the End value.

The object must be at least as thick as the Start value before the density color is visible.

You can map this color component.

Fog  Density fog is also a thickness-based effect. It fills the object with a fog that is both opaque and self illuminated. The effect is like smoke trapped in a glass, or wax at the tip of a candle. Colored fog in tubular objects can resemble neon tubes.

To use, first make sure the object is transparent. Click the color swatch to display the Color Selector. Choose a color, and then turn on the check box. The Amount controls the amount of density fog. Reducing this value reduces the density fog effect and makes the fog translucent. Range=0 to 1.0. Default=1.0.

The Start and End controls let you adjust the fog effect based on the object’s dimensions. They are expressed in world units. Start is the position in the object where the density fog begins to appear. (Default=0.0.) End is the position
in the object where the density fog reaches its full Amount value.
(Default=25.0) To have a lighter effect, increase the End value. To have a
heavier effect, reduce the End value.
You can map this color component.

**Render objects inside raytraced objects** Turns the rendering of objects inside
raytraced objects on or off. Default=on.

**Render atmospherics inside raytraced objects** Turns the rendering of
atmospheric effects inside raytraced objects on or off. Atmospheric effects
include fire, fog, volume light, and so on. Default=on.

**Reflections group**

Controls in this group give you finer control over reflections.

**Type** When set to **Default**, reflections are layered with the Diffuse color. For
example, if the material is not transparent and completely reflective, no diffuse
color is visible. When set to **Additive**, reflections are added to the Diffuse color,
as in Standard materials on page 5962. The diffuse component is always visible.

**Gain** Controls reflection brightness. The lower the gain value, the brighter
the reflection. At a gain of 1.0, no reflection is visible. Default=0.5.

**Raytracer Controls Rollout**

Material Editor > Type button > Material/Map Browser > Raytrace material >
Raytracer Controls rollout

The Raytracer Controls rollout for a Raytrace material on page 6064 controls
affect the operation of the raytracer itself. It can help you improve rendering
performance.
Interface

Local Options group

**Enable Raytracing** Turns the raytracer on or off. Default=on.
Even with raytracing off, Raytrace material and Raytrace map still reflect and refract the environment, including both the environment map for the scene, and the environment map assigned to the Raytrace material.

**Raytrace Atmospherics** Turns the raytracing of atmospheric effects on or off. Atmospheric effects include fire, fog, volume light, and so on. Default=on.

**Enable Self Reflect/Refract** Turns self reflection/refraction on or off. Default=on.
Can an object reflect itself? For example, a teapot's body reflects the teapot's handle, but a sphere will never reflect itself. If you don't need this effect, you can improve render time by turning off this toggle.
**TIP** If you have a transparent object such as glass, and Enable Self Reflect/Refract is on, you don’t have to make the object 2-sided on page 8493. The raytracer sees back faces when exiting refractive objects.

**Reflect/Refract Material IDs** When on, the material reflects effects assigned to material IDs in the renderer's G-buffer on page 8589 on or off. Default=on. By default, Raytrace material and Raytrace map reflect effects assigned to a material's ID, so that G-buffer effects are not lost. For example, if a raytraced object reflects a lamp made to glow with the Video Post Glow filter (Lens Effects Glow), the reflection glows as well.

**Raytracer Enable group**

These two check boxes turn raytracing of reflections or refractions on or off for this material. If you are using the Raytrace material to create only reflections or refractions, turn off the one you aren’t using to improve rendering time.

**Raytrace Reflections** Turns raytracing of reflective objects on or off. Default=on.

**Raytrace Refractions** Turns raytracing of transparent objects on or off. Default=on.

**Local Exclude** Displays the local Exclude/Include dialog on page 6092. An object that is excluded locally is excluded from this material only.

**TIP** Using exclusion lists is one of the best and simplest ways to speed up the raytracer.

**Bump Map Effect** Adjusts the effect of bump maps on raytraced reflections and refractions. Default=1.0.

**Falloff End Distance group**

**Reflect** Dims reflections to black at this distance. Default=100.0.

**Refract** Dims refractions to black at this distance. Default=100.0.

**NOTE** The toggles for Reflect Falloff and Refract Falloff aren’t animatable.

**Raytraced Reflection and Refraction Antialiaser group**

Controls in this group let you override the global antialiasing settings for raytraced maps and materials. They are unavailable if antialiasing is turned...
off globally. To turn on antialiasing globally, choose Rendering > Raytrace
Globals to display the Raytracer Global Parameters rollout on page 6666.

On When on, uses antialiasing. Default=unavailable unless global antialiasing
is on; on if global antialiasing is turned on.

Drop-down list Chooses which antialiasing settings to use. There are three
options:
   ■ **Use Global Antialiasing Settings** (The default.) Uses the global antialiasing
     settings.
     Click ... to open the Raytracer Global Parameters rollout on page 6666.

   ■ **Fast Adaptive Antialiaser** Uses the Fast Adaptive antialiaser, regardless of
     the global setting.
     Click ... to open the Fast Adaptive Antialiaser dialog on page 6095.

   ■ **Multiresolution Adaptive Antialiaser** Uses the Multiresolution Adaptive
     antialiaser, regardless of the global setting.
     Click ... to open the Multiresolution Adaptive Antialiaser dialog on page
     6097.

When you change settings for an antialiaser locally, you don’t affect the global
settings for that antialiaser.

**Raytrace Maps Rollout**

Material Editor > Type button > Material/Map Browser > Raytrace material >
Maps rollout

As with a standard material, the Maps rollout for a Raytrace material on page
6064 contains map buttons for the components of the Raytrace material that
can be mapped.

You can choose from a large variety of map types. See Map Types on page 6185
to find descriptions of these types, and how to set their parameters.

**Assigning the Same Map to Different Parameters**

Applying the same map to different parameters is useful in some cases. For
example, using a pattern as both a self-illumination map and an opacity map
can make the pattern appear to glow and hover in space.
Blending Map Amounts for Opacity and Other Material Components

The Specular Level, Glossiness, Self-Illumination, and Opacity values in the four spinners in the Basic Parameters rollout are blended with their associated map Amount values in the Maps rollout.

When the Opacity spinner is set to 0, the map Amount spinner completely controls Opacity. That is, reducing the Amount value increases the transparency of the entire surface. On the other hand, when Opacity is 100, reducing the map Amount value increases the opacity of the areas where the Opacity map is less than 1. For example, you can now adjust a Checker Opacity map so that the solid areas remain solid, while the clear areas are semi-transparent.

The Specular Level, Glossiness, and Self-Illumination channels all behave in the same way. A setting of 100 applies all of the map; a setting of 0 is the equivalent of turning the map off.

When you load old 3ds Max files or bring earlier materials from the Browser into the Materials Editor, the spinner values for Opacity, Specular Level, Glossiness, and Self-illumination are altered, where necessary, to maintain the equivalent material effect.

Procedures

To assign a map:

1. Click a map button.
   A modal Material/Map Browser on page 5724 is displayed.

2. Use the Browse From buttons to choose where you want to look.
   If you choose Material Library and the dialog's display area is blank, you need to open a library file. Click the Open button and then choose the library to browse.

3. Use the display buttons to choose how you view maps.
   ■ View List shows each map by name.
   ■ View List + Icons shows a small preview and each map's name.
   ■ View Small Icons shows a small preview for each map.
   ■ View Large Icons shows a large preview for each map, along with the map's name.
TIP: You can resize the Browser dialog to increase the size of the display area. This is especially useful when you view large icons.

4 Double-click the map you want.

To use the same map for different parameters:

1 In the Maps rollout, use a map button to assign a map. The Material Editor is now at the map level, and displays controls for the map parameters.

2 Click Go To Parent to return to the material level, and then open the Maps rollout.

3 Drag the assigned map button to another map button. The Copy (Instance) Map dialog on page 5710 is displayed.

4 Choose Copy or Instance, and then click OK. If you choose Swap, the Material Editor swaps the two button assignments.

To view the parent material's parameters:

While you are at the map level, if you are currently at the map level in the Material Editor, click Go To Parent. The parameters for the map's parent material are displayed. Also, the Show End Result and Go to Parent buttons become unavailable.

To view a map's parameters:

If you are currently at the material level in the Material Editor, click the button that corresponds to the map. The parameters for the map are displayed. Also, the Show End Result on page 5701 and Go to Parent on page 5702 buttons become available. In the Basic Parameters rollout, if a map has been assigned to a color component or parameter, the corresponding button displays a letter M. In the Maps rollout, if a map has been assigned, the corresponding button displays the map name.
To view a map's location:

- Click Material/Map Navigator to view the Navigator.
  The Material/Map Navigator on page 5703 displays the hierarchy of the current material, which contains the map.

To go to a map using the Navigator:

- In the Material/Map Navigator on page 5703, click the name of the map, or the green or red parallelogram to the left of the map's name.
  The Navigator goes to the level of the map, and the Material Editor displays the controls for the map you clicked.
  As the Navigator's map tree shows, maps for basic material components and parameters are one level below the material itself.

To preview a map in a sample slot:

1. Go to the level of the map, as described in previous procedures.
   The Material Editor displays the map's parameters.

2. Turn off Show End Result on page 5701.
   The sample slot shows the map instead of the material. If the map contains sub-maps, these are also visible.
   By default, the sample slot displays a map with no three-dimensional shading. You can change this in the Material Editor Options dialog on page 5681.

To view the map interactively:

1. Select an object.
2. In the object's creation parameters, make sure that Generate Mapping Coords is on.
   If the object type does not have a Generate Mapping Coordinates toggle, you need to assign mapping coordinates by applying a UVW Map modifier on page 1932.
3. In the Material Editor, assign the mapped material to the object.
4. If you are at the material level (the top level), click the appropriate map button to go to the map level.
Turn on Show Map in Viewport on page 5696.

The map appears on objects assigned the material in all shaded viewports. Now when you adjust the map, the viewports update to display the adjustments.

Turning on Show Map In Viewport for one map automatically turns this button off for all other maps the material has.

Viewports can display 2D maps such as Checker and Bitmap. They cannot display other kinds of maps such as 3D maps. Show Map in Viewport is unavailable if the active map type cannot display in viewports.

TIP Displaying mapped materials in a viewport can slow performance. If you don't need to view the texture, turn off its viewport display.

To turn off interactive texture display:

1. Go to the map level.
   If you are at the material level, click the appropriate map button to go to the map level.

2. Turn off Show Map in Viewport on page 5696.
   The object is shaded but the map no longer appears.

To turn a map off:

- Turn off the map's check box.
  The check box is to the left of the map's name on the Maps rollout.

To turn a map on:

- Turn on the map's check box.
  The check box is to the left of the map's name on the Maps rollout.

To change a map's strength:

- Adjust the map's Amount spinner in the Maps rollout.
  The material's sample slot reflects the change.

NOTE Adjusting a map's output (in the map's Output rollout) can also change the map's strength.
To move directly to an ancestor:

1. Click the arrow to the right of the map's name on page 5706 field. A drop-down list of ancestors is displayed.
2. Click a name in the Ancestor list.
   With this list, you can skip intermediate levels in the tree.
   The Ancestor drop-down list shows only part of the tree. It does not show side branches and siblings. To view these, use the Material/Map Navigator on page 5703.
   You can also use the Go Forward to Sibling on page 5702 and Go to Parent on page 5702 buttons.

To change a map type:

1. At the level of a map, click the button labeled Type below the Material Editor toolbar.
   A modal Material/Map Browser on page 5724 is displayed. If you were at a map, it lists only maps (if you were at a material when you clicked Type, the Browser lists only materials).
2. Choose a map type from the list, and then click OK.
   If you change a map type and the new map type can have component maps, a Replace Map dialog is displayed. This dialog gives you a choice between discarding the original map or using it as a component map.
   If the new map type does not have components, it simply replaces the original map type.
The Maps rollout for Raytrace contains a wide button for each map type. Click this button to select a bitmap file stored on disk or to select a procedural-map type on page 8691. After you select a map, its name and type appears on the button. Use the check box to the left of the button to turn the effect of the

```
<table>
<thead>
<tr>
<th>Map</th>
<th>Amount</th>
<th>Map</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ambient</td>
<td>100</td>
<td>None</td>
</tr>
<tr>
<td>Diffuse</td>
<td>100</td>
<td>None</td>
</tr>
<tr>
<td>Diffusion</td>
<td>100</td>
<td>None</td>
</tr>
<tr>
<td>Reflect</td>
<td>100</td>
<td>None</td>
</tr>
<tr>
<td>Transparency</td>
<td>100</td>
<td>None</td>
</tr>
<tr>
<td>Luminosity</td>
<td>100</td>
<td>None</td>
</tr>
<tr>
<td>IOR</td>
<td>100</td>
<td>None</td>
</tr>
<tr>
<td>Spec. Color</td>
<td>100</td>
<td>None</td>
</tr>
<tr>
<td>Specular</td>
<td>100</td>
<td>None</td>
</tr>
<tr>
<td>Glossiness</td>
<td>100</td>
<td>None</td>
</tr>
<tr>
<td>N / A</td>
<td>100</td>
<td>None</td>
</tr>
<tr>
<td>N / A</td>
<td>100</td>
<td>None</td>
</tr>
<tr>
<td>Extra Lighting</td>
<td>100</td>
<td>None</td>
</tr>
<tr>
<td>Translucency</td>
<td>100</td>
<td>None</td>
</tr>
<tr>
<td>Fluorescence</td>
<td>100</td>
<td>None</td>
</tr>
<tr>
<td>Color</td>
<td>100</td>
<td>None</td>
</tr>
<tr>
<td>Fog</td>
<td>100</td>
<td>None</td>
</tr>
<tr>
<td>Bump</td>
<td>30</td>
<td>None</td>
</tr>
<tr>
<td>Environment</td>
<td>100</td>
<td>None</td>
</tr>
<tr>
<td>Trans.Environ</td>
<td>100</td>
<td>None</td>
</tr>
<tr>
<td>Displacement</td>
<td>100</td>
<td>None</td>
</tr>
</tbody>
</table>
```
map off and on. When the check box is off, the map is not computed and has no effect in the renderer.

The Amount spinner determines the amount that the map affects the material, expressed as a percentage of full intensity. For example, a diffuse map at 100% is completely opaque and covers the base material. At 50%, it is semi-transparent and the base material (the diffuse, ambient, and other colors of the material without mapping) shows through.

**Lock button** Locks the Environment map to the Transparency Environment map. When on, the Transparency Environment map controls are disabled, and a map applied to the Raytrace Environment applies to the Transparency Environment as well. When off, the Transparency Environment map controls are enabled, and the Transparency Environment can have a different map assigned to it. Default=on.

Changing this button’s setting here also changes it on the **Basic Parameters rollout** on page 6065, and the **Extended Parameters rollout** on page 6074.

**Diffusion Mapping**

The Diffusion map component lets you apply an additional, second texture to modify the Diffuse component. Typically, you will want to reduce the Amount of this map to allow the main Diffuse map to show through.

For example, you might have a clean, bright image for a billboard. You use this image as the Diffuse map, and then use a second map as a Diffusion map to apply soot and city grime.

**TIP** Animating the Amount can change the appearance of the material over time, letting the Diffusion map either conceal or reveal the underlying Diffuse map.

**NOTE** Show Map In Viewport does not display the Diffusion map.

**Raytrace Dynamics Properties Rollout**

Material Editor > Type button > Material/Map Browser > Raytrace material > Dynamics Properties rollout

As with a standard material, the Dynamics Properties rollout for a Raytrace material on page 6064 lets you specify surface properties that affect the animation of an object upon collision with another object. If there are no collisions in your simulation, these settings have no effect.
Since the Dynamics Properties rollout is available at the top level of any material (including sub-materials), you can specify different surface dynamic properties for each face in an object. There are also controls in the Dynamics utility that let you adjust the surface properties at the object level, but only the Materials Editor lets you alter the surface properties at the sub-object level, through use of a Multi/Sub-Object material on page 6120.

As a default, the values in the Dynamics Properties rollout provide a surface that's similar to Teflon-coated hardened steel.

**Interface**

![Dynamics Properties](image)

**Bounce Coefficient** Sets how far an object bounces after hitting a surface. The higher the value, the greater the bounce. A value of 1 represents a "perfectly elastic collision," or a bounce in which no kinetic energy is lost. Default=1.0.

If you've seen the desktop toy with four ball bearings swinging back and forth on strings and hitting one another, you've seen an example that comes very close to a bounce coefficient of 1. Generally, hardened steel or a super ball have a bounce near 1, while lead has a bounce near 0.

**Static Friction** Sets how difficult it is for the object to start moving along a surface. The higher this value, the more difficult. Default=0.0.

If something weighs ten pounds and sits on Teflon (a static friction of near 0), it takes almost no force to make it move sideways. On the other hand, if it sits on sandpaper, then the static friction might be very high, on the order of 0.5 to 0.8. A static friction near 1 is very difficult to create in the real world without adhesives or friction material.

**Sliding Friction** Sets how difficult it is for the object to keep moving over a surface. The higher this value, the more difficult for the object to keep moving. Default=0.0.

Once two objects begin to slide over one another, static friction disappears and sliding friction takes over. Generally, sliding friction is lower than static friction due to surface tension effects. For example, once steel starts sliding...
over brass (a value of static friction that might run from 0.05 to 0.2), the sliding friction drops to a significantly lower value, on the order of .01 to 0.1. For some materials, such as specific friction materials like brake linings, sliding friction is just as high as static friction because it is used in conjunction with a nearly frictionless material such as hardened polished steel.

**Raytracing Acceleration Parameters Dialog**

Rendering menu > Raytracer Settings > Render Setup dialog > Raytracer panel > Raytracer Global Parameters rollout > Global Raytrace Engine Options group > Acceleration Controls button

The controls in this dialog let you override the default acceleration values and specify your own requirements. Typically you don’t need to use them, but if you are familiar with the requirements of your scene, they can help you optimize raytrace rendering for your specific needs and time constraints.

Raytracing subdivides the scene, organizing it into a tree for raytrace purposes. A node in this tree is known as a “voxel.” Voxel trees are dynamic, and you can’t explicitly specify the structure of the tree. (If you set Max. Divisions to 2, the tree is an octree, which is possibly a more familiar data structure.)

**TIP** If your scene is particularly unbalanced (for example, it has a giant planet object and a cluster of small spacecraft objects) keep the Balance setting low.

**Interface**

**Face Limit** Sets the maximum number of faces allowed in a lattice voxel before it is subdivided. Default=10.

**Balance** Determines the sensitivity of the subdivision algorithm. Increasing this value uses more memory but can increase performance. Default=4.0.
Max. Divisions  Sets the initial lattice dimension. For example, 4 is a 4 x 4 x 4 lattice. Default=30.

Max. Depth  Sets the maximum number of lattice subdivisions. Default=8.

**Raytrace Exclude/Include Dialog**

Rendering menu > Raytrace Global Include/Exclude

Material Editor > Raytrace material > Raytracer Controls rollout > Local Exclude button

Material Editor > Raytrace map > Raytracer Parameters rollout > Local Exclude button

Rendering menu/main toolbar > Raytracer Settings > Render Setup dialog > Raytracer panel > Raytracer Global Parameters rollout > Global Raytrace Engine Options group > Exclude button

These dialogs let you specify which objects the raytracer will and won't see. This is a good optimization when you are working with complex scenes and all you really need is for an object to reflect itself or some other, simpler elements in the scene.
The global dialog affects all Raytrace materials and Raytrace maps in your scene. The local dialog affects only the current material or map.

**TIP** Another good use for exclusion can be when you are working on a scene where the world-space scale of objects is not realistic. For example, consider an animation of a space dog-fight, with a planet and its moon in the background. You would use a planet that was actually much smaller, relative to the fighters, than an actual planet. (For example, the planet might be only five times bigger than the fighters, and the moon only half as big as the fighters.) If the fighters are reflective, the reflections of the planet and moon will be incorrect and will give away the fact that you are using miniatures. In this case, raytrace the reflective fighters, and laser blasts, and so on, but exclude the planet and moon props from the raytracer. Create an environment map that represents the planet and moon at their correct scale, and make that the Raytrace material’s local environment. When you render, the scale of the planet and moon geometry appears to be correct, and the reflections on the fighters will behave as your eye expects.
Both the Global and the Local Exclude/Include dialogs contain the following controls:

Exclude/Include Choose whether raytracing will exclude or include the objects named in the list on the right.

Illumination / Shadow Casting / Both For the raytracer, this is turned off (always set to Illumination).

Scene Objects Select objects from the Scene Objects list on the left, then use the arrow buttons to add them to the exclusion list on the right.

The Exclude/Include dialog treats a group as an object: you can exclude or include all objects in a group by selecting the group's name in the Scene Objects list. If a group is nested within another group, it isn't visible in the Scene Objects list.
Search Field  The edit box above the Scene Objects list lets you search for object names by entering names that use wildcards.

Display Subtree  When on, indents the list according to the object hierarchy.

Case Sensitive  When on, uses case sensitivity when searching object names.

Selection Sets  Displays a list of named selection sets. Choosing a selection set from this list selects those objects in the Scene Objects list.

Clear  Clears all entries from the Exclude/Include list on the right.

OK  Closes the dialog and retains the exclude or include operations you performed.

Cancel  Closes the dialog and cancels the exclude or include operations you performed.

Raytrace Antialiaser Dialog: Fast Adaptive Antialiaser

Rendering menu > Raytracer Settings > RaytracerGlobal Parameters dialog > Global Ray Antialiaser group > Turn on global ray antialiasing. > Choose Fast Adaptive Antialiaser from the drop-down list. > ... button

Material Editor > Type button > Material/Map Browser > Raytrace material > Raytracer Controls rollout > Raytraced Reflection and Refraction Antialiaser group (enabled only if antialiasing is globally enabled) > Choose Fast Adaptive Antialiaser from the drop-down list. > ... button

Material Editor > Type button > Material/Map Browser > Raytrace map > Raytracer Parameters rollout > Raytraced Reflection and Refraction Antialiaser group (enabled only if antialiasing is globally enabled) > Choose Fast Adaptive Antialiaser from the drop-down list. > ... button

The Fast Adaptive Antialiaser dialog changes settings for the Raytrace material and maps Fast Adaptive antialiaser. You can use this dialog either globally, from the Raytracer Global Parameters rollout on page 6666, or locally, from the Raytracer Controls rollout on page 6079. When you locally change settings for an antialiaser, you don't affect the global settings for that antialiaser.
Blur / Defocus (Distance Blur) group

Blur Offset is similar to blur offset for Bitmaps, while defocus is based on distance.

*Blur Offset* Affects the sharpness or blurriness of the reflections or refractions without regard to distance. You can use Blur Offset to soften or defocus the details of a reflection or refraction. The value is specified in pixels. Default=0.0.

**TIP** The default Blur Offset setting usually produces good results. If you see aliasing in reflections or refractions, increase its value in increments of 0.5 until the aliasing goes away.

See *Blur/Blur Offset* on page 8525.

*Blur Aspect* This is an aspect ratio that changes the shape of the blur. Usually you will not need to change it. Default=1.0.
**TIP** If you see aliasing that occurs mostly along horizontal lines, try increasing Blur Aspect to 1.5. This changes the shape of the blurred effect. The reverse is also true. If aliasing occurs mostly along vertical lines, try decreasing Blur Aspect to 0.5.

**Defocusing** Defocusing is a blur based on distance. With Defocus, objects near the surface are not blurred, but objects farther away are blurred. The rays cast are spread as they leave the Raytrace material object’s surface. Default=0.0.

**TIP** Increasing the value of Defocusing can give a good distance blurring effect. Small adjustments are usually adequate. Try starting with a value less than 0.1, and increase or decrease it as necessary. Also try adjusting Reflect Falloff in Raytrace material or Attenuation in Raytrace map to get the best distance blurring effect.

**Defocus Aspect** This is an aspect ratio that changes the shape of the defocusing. Usually you will not need to change it. Default=1.0.

**Raytrace Antialiaser Dialog: Multiresolution Adaptive Antialiaser**

Rendering menu > Raytracer Settings > Render Setup dialog > Raytracer panel > Raytracer Global Parameters rollout > Raytracer Global Parameters > Global Ray Antialiaser group > Turn on global antialiasing. > Choose Multiresolution Adaptive Antialiaser from the drop-down list. > ... button

Material Editor > Type button > Material/Map Browser > Raytrace material > Raytracer Controls rollout > Raytraced Reflection and Refraction Antialiaser group (enabled only if antialiasing is globally enabled) > Choose Multiresolution Adaptive Antialiaser from the drop-down list. > ... button

The Multiresolution Adaptive Antialiaser dialog changes settings for the Raytrace material and maps Multiresolution Adaptive antialiaser. You can use this dialog either globally, from the Raytracer Global Parameters rollout on page 6666, or locally, from the Raytracer Controls rollout on page 6079. When you locally change settings for an antialiaser, you don’t affect the global settings for that antialiaser.
**Interface**

**Multiresolution Adaptive Antialiaser**

This Antialiaser uses a multiresolution, adaptive antialiasing kernel. It can be useful for large amounts of reflection / refraction blurring or defocusing, however, due to the amount of rays it casts, it can be computationally expensive.

If you are not doing blurry reflections or refractions, the material's supersampling settings may be all you need to anti alias ray traced surfaces.

**Adaptive Control group**

**Initial Rays** Sets the initial number of rays cast per pixel. Default=4.

**Threshold** Determines the sensitivity of the adaptation algorithm. It can range from 0 to 1, where 0 always casts the maximum number of rays and 1 always casts only the minimum number of rays. Default=0.1.

**Max. Rays (Maximum Rays)** Sets the maximum number of rays the algorithm will cast. Default=32.
Blur / Defocus (Distance Blur) group

Blur Offset is similar to blur offset on page 8525 for bitmaps, while Defocusing is based on distance.

**Blur Offset** Affects the sharpness or blurriness of the reflections or refractions without regard to distance. You can use Blur Offset to soften or defocus the details of a reflection or refraction. The value is specified in pixels. Default=0.0.

**TIP** The default Blur Offset setting usually produces good results. If you see aliasing in reflections or refractions, increase its value in increments of 0.5 until the aliasing goes away.

**Blur Aspect** This is an aspect ratio that changes the shape of the blur. Usually you will not need to change it. Default=1.0.

**TIP** If you see aliasing that occurs mostly along horizontal lines, try increasing Blur Aspect to 1.5. This changes the shape of the blurred effect. The reverse is also true. If aliasing occurs mostly along vertical lines, try decreasing Blur Aspect to 0.5.

**Defocusing** Defocusing is a blur based on distance. With Defocus, objects near the surface are not blurred, but objects farther away are blurred. The rays cast are spread as they leave the Raytrace material object’s surface. Default=0.0.

**TIP** Increasing the value of Defocusing can give a good distance blurring effect. Small adjustments are usually adequate. Try starting with a value less than 0.1, and increase or decrease it as necessary. Also try adjusting Reflect Falloff in Raytrace material or Attenuation in Raytrace map to get the best distance blurring effect.

**Defocus Aspect** This is an aspect ratio that changes the shape of the defocusing. Usually you will not need to change it. Default=1.0.

Matte/Shadow Material

Material Editor > Type button > Material/Map Browser > Matte/Shadow

The Matte/Shadow material allows you to make whole objects (or any subsets of faces) into matte objects on page 8636 that reveal the current background color or environment map on page 8561.
Simply rendering the framed photo against a background shows the photo in front of the background.
A matte object hides parts of the photo, revealing the background to make it appear the photo is behind the goblets.

It can also receive shadows cast on it from non-matte objects in the scene. Using this technique, you can cast shadows on backgrounds by building matte proxy objects and placing them in front of similarly shaped objects in the background.
Creating a matte object for casting shadows against a background image

Matte/Shadow materials can also have reflections.

**NOTE** The Matte/Shadow effect is visible only when you render the scene. It isn't visible in viewports.

**TIP** When rendering with mental ray, for best results and greater flexibility use the **Matte/Shadow/Reflection (mi) material** on page 5930 instead of this one. Because of the availability of the mental ray-specific material, the Matte/Shadow material is designated **Incompatible** on page 5732 when mental ray is active.
Procedures

To render objects seamlessly against a background environment:

There are three ways you can render objects to blend seamlessly into a background environment:

■ Assign a Matte/Shadow Material.
■ Assign a 100% self-illuminated diffuse texture to an object using Camera Mapping.
■ Assign a 100% self-illuminated diffuse texture using Environment/Screen projection.

Use the Plate Match/MAX R2.5 antialiasing whenever you are trying to match foreground objects with an unfiltered background, or trying to match the antialiasing qualities of the 3ds Max 2.5 renderer. See the description of Antialiasing Filter in the description of the Default Scanline Renderer on page 6589.

Example: To see the effect of Affect Alpha and Matte Reflection:

1 Create a scene with one or more objects on a box platform, and one or more shadow-casting spotlights.

TIP If you use only one spotlight, increase its Multiplier value.

2 Assign a Matte/Shadow material to the box, and render the scene with default Matte/Shadow parameters (Opaque Alpha is on, and Affect Alpha is off).

3 On the Rendered Frame Window on page 6513 that opens, turn on Display Alpha Channel. The objects all appear as white silhouettes, including the platform.

4 On the Matte/Shadow Basic Parameters rollout, turn off Opaque Alpha, and turn on Receive Shadows and Affect Alpha.

5 Press F9 (Render Last on page 6564). The silhouette of the box no longer appears, but the other objects and their shadows appear.
6 On the Matte/Shadow Basic Parameters rollout, click the Map button in the Reflection group, and use the Material/Map Browser on page 5724 to assign a Flat Mirror on page 6358 map to the box's material. On the Flat Mirror Parameters rollout, turn on Render group > Assign To Faces With ID and leave the value set to 1.

7 Press F9 (Render Last on page 6564).

8 On the Rendered Frame Window, turn off Display Alpha Channel.

The reflections of the objects appear on the box, even though the box itself is invisible.

Interface
**Matte group**

**Opaque Alpha** Determines whether or not the matte material appears in the alpha channel. If you turn off Opaque Alpha, the matte object will not make an alpha channel, and the image can be used for compositing, just as if there are no matte objects in the scene. Default=off.

**Atmosphere group**

These options determine whether fog effects are applied to the matte surfaces, and how they are applied.

**Apply Atmosphere** Turns the fogging of matte objects on and off.

When applying fog, you can choose between two different methods. You can either apply fog as if the matte surface is at an infinite distance from the camera or you can apply it as if the matte surface is actually at that point on the object being shaded. In other words, you can apply the fog to the matte surface in either 2D or 3D. The following controls determine how this is applied:

**At Background Depth** This is the 2D method. The scanline renderer on page 8709 fogs the scene, and then renders its shadows. In this case, the shadows won't be lightened by the fog. If you want to lighten the shadows, you need to turn up the shadow brightness.

**At Object Depth** This is the 3D method. The renderer first renders the shadows, and then fogs the scene. Since this varies the amount of fog over the 3D matte surface, the generated matte/alpha channels don't blend perfectly into the background. Use At Object Depth when the matte object is meant to be a 3D object in the scene that the 2D background represents.

**Shadow group**

This group determines whether the matte surfaces receive shadows that are cast upon them, and how they receive them.

**Receive Shadows** Renders shadows on the matte surfaces. Default=on.

**Affect Alpha** When on, shadows cast on a matte material are applied to the alpha channel. This lets you render bitmaps with alpha channels that you can composite later. Default=on.

Affect Alpha is available only when Opaque Alpha (in the Matte group box) is turned off.
When Affect Alpha is on, the higher the Shadow Brightness value, the more transparent the shadow, allowing the background to show through more, and making the shadow appear brighter.

**Shadow Brightness** Sets shadow brightness. At 0.5, the shadows will not be attenuated on the matte surface; at 1.0, the shadows are brightened to the color of the matte surface; and at 0.0 they are darkened to completely obliterate the matte surface.

**Color** Displays a Color Selector on page 371 to let you choose the color of the shadow. Default=black.

Setting shadow color is especially useful when you're using a Matte/Shadow material to composite your shadows against a background image, such as video. It lets you tint your shadows to match pre-existing shadows in the image.

**Reflection group**

Controls in this group determine whether the matte surfaces can have reflections. You create matte reflections using a shadow map.

**TIP** Matte reflections don't successfully create an alpha channel unless you render them against a black background.

**Amount** Controls the amount of reflection to use. This is a percentage that can range from 0 to 100. This control is unavailable unless you have assigned a map. Default=50.

You can animate this parameter.

**Map** Displays the Material/Map Browser on page 5724 so you can assign a map to use for reflections. The reflection is independent of the environment unless you choose a Reflect/Refract on page 6358 or Flat Mirror map on page 6358.

**Compound Materials**

Compound materials combine two or more sub-materials. Compound materials are similar to compositor maps on page 6331, but they exist at the material level. Applying a compound material to an object creates a compound effect that often uses mapping. You load or create compound materials using the Material/Map Browser.

Using a filter control, you can choose whether the Browser lists maps or materials or both.
Different types of materials create different effects, behave in particular ways, or are provided as ways to combine multiple materials.

**NOTE** The sub-material buttons and sub-map buttons for most materials and maps have check boxes beside each button. These let you turn that branch of the material or map on or off. For example, in the Top/Bottom material, the Top Material and Bottom Material buttons each have check boxes. Similarly, the Checker map has two map buttons, one for each color. Each button has a check box beside it that lets you disable that color's map.

**Procedures**

To have the Browser list only materials:

- At the top of the Show group, leave Materials on and turn off Maps.

**NOTE** This option is available only at the material level in the Material Editor.

**Blend Material**

Material Editor > Type button > Material/Map Browser > Blend

The Blend material lets you mix two materials on a single side of the surface. Blend has an animatable Mix Amount parameter that lets you draw material morphing on page 8643 function curves to control the way that the two materials are blended over time.
Blend material combines bricks and stucco.

**NOTE** If even one sub-material has its shading set to Wire (see Shader Basic Parameters Rollout on page 5969), the entire material displays and renders as a wire material.

### Procedures

**To create a Blend material:**

1. Activate a sample slot in the Material Editor.
2. Click the Type button.
3. In the Material/Map Browser on page 5724, choose Blend and then click OK.

A Replace Map on page 5721 dialog is displayed. This dialog asks whether you want to discard the original material in the slot, or retain it as a sub-material.

Blend materials have similar controls to Mix maps.

**To specify a component material:**

- In the Blend Basic Parameters rollout, click one of the two material buttons.
The parameters for the sub-material are displayed. By default, a sub-material is a Standard material with Blinn shading.

To control the mix amount:

- In the Basic Parameters rollout, adjust the Mix Amount value. You can also control the mix amount by using a map.

Map used to reveal brick beneath stucco

To control the mix amount using a map:

- In the Basic Parameters rollout, click the map button next to Mask. The Browser is displayed so you can select a map type. The intensity of pixels in this mixing map controls the mix. When the intensity is close to zero, one of the component colors or maps is visible; when it is close to full intensity, the other component is visible.

**TIP** Using a Noise map for the mixing map can give good effects that have a natural appearance. Mix Amount is unavailable while a map is assigned to this parameter. If Use Curve is turned off, the mixing map is used as is. If Use Curve is on, you can shift the effect of the mixing map's gradient ramp to reveal more of one material and less of the other.
Interface

**Material 1/Material 2** Set the two materials to be blended. Use the check boxes to turn the materials on and off.

**Interactive** Chooses which of the two materials is displayed on object surfaces in viewports by the interactive renderer. If one material has Show Map in Viewport on page 5696 on, this takes precedence over the Interactive setting. Only one map at a time can be displayed in viewports.

**Mask** Sets a map to use as a mask. The degree of blending between the two materials depends on the intensity of the mask map. Lighter (whiter) areas of the mask show more of Material 1, while darker (blacker) areas of the mask show more of Material 2. Use the check box to turn the mask map on or off.

**Mix Amount** Determines the proportion of the blend (percentage). 0 means only Material 1 is visible on the surface; 100 means only Material 2 is visible. Unavailable if you have assigned a mask map and the mask's check box is on.
You can animate this parameter. *Create Material Preview* on page 5679 is useful for testing the effect.

**Mixing Curve group**

The mixing curve affects how gradual or how sharp the transition between the two colors being blended will be. It affects the blend only when a mask map is assigned.

**TIP** For mottled effects, blend two standard materials using a noise map as a mask.

**Use Curve** Determines whether the Mixing Curve affects the mix. This control is available only when a mask is assigned and active.

**Transition Zone** These values adjust the level of the Upper and Lower limits. If the two values are the same, the two materials meet at a definite edge. Wider ranges give more gradual blending from one sub-material to the other. The mixing curve displays the effect of changing these values.

**Composite Material**

Material Editor > Type button > Material/Map Browser > Composite

Composite material composites on page 8534 up to 10 materials. The materials are superimposed from top to bottom, as listed in the rollout. Materials are combined using additive opacity on page 8499, subtractive opacity on page 8733, or mixed using an Amount value.

**NOTE** If even one sub-material has its shading set to Wire (see Shader Basic Parameters Rollout on page 5969), the entire material displays and renders as a wire material.

**See also:**

- Composite Map on page 6331
Interface

Base Material Displays the Material/Map Browser on page 5724, where you assign the base material. By default, the base material is a Standard material.
The other materials are composited by superimposing them on top of this material, in order from top to bottom.

**Mat 1 through Mat 9** Each of these nine groups contains controls for a material to composite. By default, no materials are assigned.

**Check box** When on, uses the material in the composite. When off, doesn't use it. Default=on.

**Button** Displays the Material/Map Browser on page 5724, where you assign a material to composite.

**ASM buttons** These buttons control how the material is composited. Default=A.

- **A** This material uses additive opacity on page 8499. Colors in the material are summed based on their opacity.

- **S** This material uses subtractive opacity on page 8733. Colors in the material are subtracted based on their opacity.

- **M** This material mixes materials based on the Amount value (see following). Both color and opacity are blended as they are when you use a Blend material on page 6107 with no mask.

**Amount** Controls the amount of mixing. Default=100.0.

For additive (A) and subtractive (S) compositing, the Amount value can range from 0 to 200. When the Amount is 0.0, no compositing happens, and the material below is not visible. When the Amount is 100.0, the composite is complete. When the amount is greater than 100.0, compositing is "overloaded": transparent portions of the material become more opaque, until the material below is no longer visible.

For mix (M) compositing, the Amount can range from 0.0 to 100.0. When the Amount is 0.0, no compositing happens, and the material below is not visible. When the amount is 100.0, compositing is complete, and only the material below is visible.

**Double-Sided Material**

Material Editor > Type button > Material/Map Browser > Double-Sided

The Double-Sided material lets you assign two different materials to the front and back faces of an object.
On the right, a double-sided material creates a pattern for the inside of the trash can.

NOTE If even one sub-material has its shading set to Wire (see Shader Basic Parameters Rollout on page 5969), the entire material displays and renders as a wire material.

Procedures

To create a double-sided material:

1. Activate a sample slot in the Material Editor.
2. Click the Type button.
3. In the Material/Map Browser, choose Double-Sided and then click OK. A Replace Map dialog on page 5721 is displayed. This dialog asks whether you want to discard the original material in the slot, or retain it as a sub-material.
   The Double-Sided material controls let you choose the two materials, and the translucency of the material overall.
To choose the outer material:

■ Click the button labeled Facing Material.
The parameters for the sub-material are displayed. By default, a sub-material is a Standard material with Blinn shading.

To choose the inner material:

1 Go back to the parent material (parameters for the Double-Sided material).
2 On the Double-Sided Basic Parameters rollout, click the button labeled Back Material.
The parameters for the sub-material are displayed. By default, a sub-material is a Standard material with Blinn shading.

To make the material translucent:

■ Set Translucency to a value greater than 0.
The Translucency control affects the blending of the two materials. When Translucency is 0, there is no blend. When Translucency is 100.0 percent, the outer material is visible on inner faces and the inner material is visible on outer faces. At intermediate values, the specified percentage of the inner material "bleeds through" and is visible on outer faces.

Interface

Translucency

Sets the amount that one material shows through the other. This is a percentage that can range from 0.0 to 100.0. At 100 percent, the outer material is visible on inner faces and the inner material is visible on outer faces. At intermediate values, the specified percentage of the inner material "bleeds through" and is visible on outer faces. Default=0.0.
You can animate this parameter.
Facing Material and Back Material  Click to display the Material/Map Browser on page 5724 and choose a material for one side or the other. Use the check boxes to turn the materials on or off.

**Morpher Material**

Material Editor > Type button (labeled Standard by default) > Material/Map Browser > Morpher material

Procedures on page 6117 Interface on page 6118

The Morpher material works hand-in-hand with the Morpher modifier. You can use it to make the cheeks of a character blush, or to wrinkle a character's forehead when the eyebrows are raised. With the Morpher modifier's channel spinners, you can blend materials the same way you morph the geometry.

The Morpher material has 100 material channels that map directly to the 100 channels in the Morpher modifier. After you apply the Morpher material to an object and bind it to the Morpher modifier, you use the channel spinners in the Morpher modifier to morph materials and geometry. Empty channels in the Morpher modifier, with no geometry morph data, can be used to morph materials only.

**NOTE**  The mental ray renderer on page 6675 does not support the Morpher material.

**NOTE**  If even one sub-material has its shading set to Wire (see Shader Basic Parameters Rollout on page 5969), the entire material displays and renders as a wire material.

See also:

- Morpher Modifier on page 1518

**Applying the Morpher Material**

An object must have at least one Morpher modifier in its modifier stack. You can assign the material to an object and bind it to the object's Morpher modifier in either of two ways.

- After the Morpher modifier is applied to an object, use the Assign New Material command in the Global Parameter rollout of the Morpher modifier. This is the simplest way, and applies the Morpher Material to the object and binds the material to the Morpher modifier at the same time.
Open the Material Editor, select the Morpher material, and click Choose Morph Object in the Parameters rollout, then click the object in the viewports. After clicking the object, a dialog displays in the viewports, select the Morpher modifier from the dialog (an object may have multiple Morpher modifiers). This binds the Morpher material to the Morpher modifier.

**NOTE** You can bind a Morpher material to only one Morpher modifier.

**Procedures**

**Example: To apply and use the Morpher material:**

1. Create a sphere in the Perspective viewport.

2. On the Modify panel, right-click the sphere's entry in the modifier stack display, and choose Convert To: Editable Mesh.

3. From the Modifier List, choose Morpher.
   This applies the Morpher modifier to the sphere.

   The Morpher material is now applied to the object and bound to the Morpher modifier.

5. Open the Material Editor, and click Pick Material From Object (the eyedropper), then click the sphere in the viewports.
   The Material Editor displays the Morpher material parameters.

6. On the Morpher Basic Parameters rollout, in the Modifier Connection group, click Choose Morph Object. In the dialog that appears, click Morpher to highlight that modifier, and then click Bind.

7. On the Morpher Material Parameters rollout, click the Mat 1 slot.


9. On the Basic Parameters rollout, click the Diffuse color swatch.

10. On the Color Selector, choose a bright yellow, and close the color selector.
    Leave the Material Editor open.
11 Turn on the Auto Key button, then move the time slider to frame 50.

12 Select the sphere, and then open the Modify panel.

13 On the Morpher modifier's Channel List rollout, set the channel 1 spinner to 100.
   In the Material Editor, the color of the sample sphere changes to yellow.

14 Turn off Auto Key.

15 On the main toolbar, click Render.
   The sphere is yellow. If you render an animation the sphere changes from a grey color to yellow.

**Interface**

The Morpher material interface is on a Parameters rollout in the Material Editor.
**Modifier Connection group**

**Choose Morph Object** Click this option, then select an object in the viewports that has a Morpher modifier applied to it. Clicking an object in the viewports displays the Choose Morpher modifier dialog. Choose a Morpher modifier, and click Bind.

![Choose Morpher Modifier dialog](image)

**Name Field** Displays the name of object to which the Morpher material is applied. If no object has been specified, the field displays "No Target".

**Refresh** Updates the channel data.

**Marker List** This list is identical to the marker list in the Morpher modifier. Markers you save in the Morpher modifier appear here.

**Base Material group**

**Base material button** Click to apply a base material to the object. The base material represents what the model looks like before any channel blending takes place.

**Channel Material Setup group**

**Map #** 100 material channels are available. The scroll bar allows you to scroll through all the channels. Double-click a channel to jump to the material parameters for that channel.
There is a one-to-one correspondence between the channels in the Morpher material and the Morpher modifier. A material in channel 1 of the Morpher material is controlled by the channel 1 spinner in the Morpher modifier.

**Material on/off toggle**

Turns a channel on and off. Channels that are off do not affect the morph result.

**Mixing Calculation Options group**

The system can slow down if there are many active materials being blended. Options in this group allow you to control when the morph result will be computed.

- **Constantly** Choose to compute the material morph result all the time.
- **When Rendering** Choose to compute the material morph result at render time.
- **Never Calculate** Choose to bypass material blending.

**Multi/Sub-Object Material**

Material Editor > Type button > Material/Map Browser > Multi/Sub-Object

The Multi/Sub-Object material lets you assign different materials at the sub-object level of your geometry. You create a multi-material, assign it to an object, and then use the **Mesh Select modifier** on page 1500 to select faces and choose which of the sub-materials in the multi-material are assigned to the selected faces.
If the object is an editable mesh on page 2192, you can drag and drop materials to different selections of faces, building a Multi/Sub-Object material on the fly. See Drag and Drop Sub-Object Material Assignment on page 5659.

You can also create a new Multi/Sub-Object material by dragging to faces selected with the Edit Mesh modifier on page 1321.

Sub-material IDs do not depend on the order of the list, and you can enter new ID values.

The Make Unique button on page 5692 in the Material Editor lets you make an instanced sub-material into a unique copy.

At the Multi/Sub-Object material level, the sample slot's sample object shows a patchwork of the sub-materials. When you edit a sub-material, the sample slot display depends on the setting of the Simple Multi Display Below Top Level toggle in the Material Editor Options dialog on page 5681.
Using Multi/Sub-Object Materials

Here are some usage tips with regards to mesh editing and managing sub-materials.

- When working at sub-object levels of Editable Meshes, Polys, Patches and Splines, or with objects that have Edit Mesh, Spline or Patch modifiers applied to them, you can browse by sub-material names if the object has a multi-sub-object material applied to it.

- Sub-materials that are not assigned to an object, or surface of an object, can be ‘cleaned’ from the Multi-Sub-Object material by using the Clean MultiMaterial utility on page 6492.

- Duplicate maps, assigned to materials, can be changed to instances by using the Instance Duplicate Maps utility on page 6497.

Procedures

To create a Multi/Sub-Object material:

1. Activate a sample slot in the Material Editor.
2. Click the Type button.
3. In the Material/Map Browser on page 5724, choose Multi/Sub-Object and then click OK.
   A Replace Map dialog on page 5721 is displayed. This dialog asks whether you want to discard the original material in the slot, or retain it as a sub-material.
   The controls for a Multi/Sub-Object material are essentially a list of the sub-materials it contains.

To assign a sub-material:

- On the Multi/Sub-Object Basic Parameters rollout, click a sub-material button.
  The parameters for the sub-material appear. By default, a sub-material is a Standard material with Blinn shading.

To make one of the sub-materials a solid color:

- On the Multi/Sub-Object Basic Parameters rollout, click the color swatch next to the sub-material button.
In the Color Selector on page 371, choose a color. The color swatches for sub-materials are shortcuts. They assign the color you choose to the sub-material's Diffuse component.

**To assign one of the sub-materials to a sub-object selection:**

1. Select the object, and assign a Multi/Sub-Object material to it.

2. On the Modify panel on page 8184, apply Mesh Select on page 1500 to the object.

3. Click Sub-Object and choose Face as the sub-object category.

4. Select the faces to which you will assign a sub-material.

5. Apply a Material modifier on page 1490, and set the material ID value to the number of the sub-material you want to assign.
   
   The viewport updates to show the sub-material assigned to the selected faces.

   The material ID values in the Multi/Sub-Object material and the material ID numbers in the Select Face rollout correspond. If you set the ID to a number that doesn't correspond to a material contained in the Multi/Sub-Object material, the faces render as black.

**WARNING** Some geometric primitives do not use 1 as the default material ID, and some, such as hedra or box, have multiple material IDs by default.

**TIP** You can also use the Edit Mesh modifier on page 1321 to assign a contained material to selected faces. Apply Edit Mesh to the object, go to the Face sub-object level, and select the faces to assign. Then on the Edit Surface rollout, set the material ID value to the ID of the sub-material. (You can drag and drop on page 5659 a Multi/Sub-Object material to an Edit Mesh modifier as you can to an editable mesh object.)

**To add a new sub-material:**

- Click Add. A new sub-material is added to the end of the list. By default, the new sub-material's ID number is one greater than the highest material ID already in use.
To remove a sub-material:

1. Select the sub-material by clicking its small sample sphere in the Multi/Sub-Object Basic Parameters rollout.
   The small sample sphere is surrounded by a black and white border to show the sub-material is selected.
   If the list of sub-materials is longer than the rollout will hold, you can use the scroll bar at the right to display other parts of the list.

2. Click Delete.
   The sub-material is removed.
   Deleting a sub-material is an undoable operation.
**Interface**

**Number** This field displays the number of sub-materials contained in the Multi/Sub-Object material.

**Set Number** Sets the number of sub-materials make up the material. At the Multi/Sub-Object material level, the sample slot's sample object shows a patchwork of the sub-materials. (When you edit a sub-material, the sample slot display depends on the setting of the Simple Multi Display Below Top Level toggle on the Material Editor Options dialog on page 5681.)
Reducing the number of sub-materials removes sub-materials from the end of the list. You can undo Set Number when you have used it to delete materials.

**Add** Click to add a new sub-material to the list. By default, the new sub-material's ID number is one greater than the highest material ID already in use.

**Delete** Click to delete the currently chosen sub-material from the list. You can undo deleting a sub-material.

**Sort list controls**

These buttons appear above three of the columns in the sub-materials list.

**ID** Click to sort the list so it begins with the sub-material that has the lowest material ID, and ends with the sub-material that has the highest material ID.

**Name** Click to sort the list by the names you have entered in the Name column.

**Sub-Material** Click to sort the list by the sub-material names that appear on the Sub-Material buttons.

**List of sub-materials**

Each sub-material has a single entry in this list. The rollout displays up to 10 sub-materials at a time. If the Multi/Sub-Object material contains more than 10 sub-materials, you can scroll the list using the scrollbar at the right.

Each sub-material in the list has the following controls:

**Small sample sphere** The small sample sphere is a "mini-preview" of the sub-material. Click it to select this sub-material. You must select a sub-material before you delete it.

**ID** Shows the ID number assigned to this sub-material. You can edit this field to change the ID number. If you assign two sub-materials the same ID, a warning message appears at the top of the rollout.

When the Multi/Sub-Object material is applied to an object, faces in the object assigned the same material ID number render with this sub-material.

You can click Sort by ID to sort the sub-material list by this value, from lowest to highest.

**NOTE** Sometimes the Sub-Material button shows a material number. This is not the sub-material ID.
**Name** Lets you enter a custom name for the material. A sub-material name appears in the *Name* on page 5706 field when you're at the level of the sub-material. It also appears in the Browser and the Navigator.

**Sub-Material button** Click the sub-material button to create or edit one of the sub-materials. Each of the sub-materials is a complete material in its own right, with as many maps on page 8631 and levels as you want.

By default, each sub-material is a *Standard material* on page 5962 with *Blinn shading* on page 5979.

**Color swatch** Click the color swatch to the right of the Sub-Material button to display the *Color Selector* on page 371 and choose a diffuse color for the sub-material.

**On/Off toggle** Turns the sub-material on or off. When a sub-material is off, it appears black in the sample slot and on objects in the scene. Default=on.

---

**Shellac Material**

Material Editor > Type button > Material/Map Browser > Shellac

Shellac material mixes two materials by superimposing one over the other. Colors in the superimposed material, called the “shellac” material, are added to colors in the base material. A Shellac Color Blend parameter controls the amount of color mixing.
Top: Base material  
Middle: Shellac material  
Bottom: Materials combined with a shellac color blend value of 50%
NOTE If even one sub-material has its shading set to Wire (see Shader Basic Parameters Rollout on page 5969), the entire material displays and renders as a wire material.

Interface

- **Base Material** Goes to the level of the base sub-material. By default, the base material is a Standard material with Blinn shading.

- **Shellac Material** Goes to the level of the shellac material. By default, the shellac material is a Standard material with Blinn shading.

- **Shellac Color Blend** Controls the amount of color mixing. At 0.0, the shellac material has no effect. Increasing the Shellac Color Blend value increases the amount of shellac material color blended into the base material color. There is no upper limit on this parameter. Large values "overload" the shellac material colors. Default=0.0.
  You can animate this parameter.

**Top/Bottom Material**

Material Editor > Type button > Material/Map Browser > Top/Bottom

The Top/Bottom material lets you assign two different materials to the top and bottom portions of an object. You can blend the materials into one another.
Top/bottom material gives the pot a charred bottom.

The object's top faces are those whose normals point up. The bottom faces have normals that point down. You can choose whether "up" and "down" refer to the scene's world coordinates or to the object's local coordinates.

NOTE If even one sub-material has its shading set to Wire (see Shader Basic Parameters Rollout on page 5969), the entire material displays and renders as a wire material.

Procedures

To create a top/bottom material:

1. Activate a sample slot in the Material Editor.
2. Click the Type button.
3. In the Material/Map Browser on page 5724, choose Top/Bottom and then click OK.
   A Replace Map on page 5721 dialog is displayed. This dialog asks whether you want to discard the original material in the slot, or retain it as a sub-material.
The Top/Bottom material controls let you choose the two materials, and also the transition between them.

**To choose the top or bottom material:**
- On the Top/Bottom Basic Parameters rollout, click the Top Material button or the Bottom Material button.
  The parameters for the sub-material appear. By default, a sub-material is a Standard material with Blinn shading.

**To swap the two component materials:**
- In the Basic Parameters rollout, click Swap.
  The remaining controls, described in the "Interface" section, affect the transition between top and bottom.

**Interface**

![Top/Bottom Basic Parameters](image)

**Top Material and Bottom Material** Click to display the parameters for the top or bottom sub-material. By default, a sub-material is a Standard material with Blinn shading.

The check box to the right of each button lets you turn off that material, making it invisible in the scene and in the sample slot.

**Swap** Swaps the position of the top and bottom materials.
**Coordinates group**

Controls in this group let you choose how 3ds Max determines the boundary between top and bottom.

**World** Faces point up or down according to the scene's world coordinates. When you rotate the object, the boundary between top and bottom faces remains in place.

**Local** Faces point up or down according to the object's local coordinates. When you rotate the object, the material rotates with it.

**Blend** Blends the edge between the top and bottom sub-materials. This is a percentage that can range from 0 to 100. At 0, there is a sharp line between the top and bottom sub-materials. At 100, the top and bottom sub-materials tint each other. Default=0.

You can animate this parameter.

**Position** Determines where the division between the two materials lies on an object. This is a percentage that can range from 0 to 100. 0 is at the bottom of the object, and displays only the top material. 100 is at the top of the object, and displays only the bottom material. Default=50.

You can animate this parameter.

**Ink 'n Paint Material**

Material Editor > Type button > Material/Map Browser > Ink 'n Paint

The Ink 'n Paint material creates cartoon effects. Rather than the three-dimensional, realistic effect most other materials provide, Ink 'n Paint provides flat shading with “inked” borders.
Snake rendered with ink 'n paint

Because Ink 'n Paint is a material, you can create a scene that combines 3D-shaded objects with flat-shaded cartoon objects.
Rendering that combines realistic shading with cartoon shading

In the Ink ‘n Paint material, ink and paint are two separate components, with customizable settings.
Left: The paint component only
Right: The ink component only

**TIP** Ink 'n Paint uses the raytracer settings on page 6666, so adjusting raytrace acceleration can have an effect on the speed of Ink 'n Paint. Also, while you work with Ink 'n Paint, disabling antialiasing can speed up the material, until you're ready to create final renderings. (Turning off Ink really speeds it up.)

**NOTE** Motion blur does not work with Ink 'n Paint. (Typically, hand-drawn cartoons are not motion blurred.)

**NOTE** Shadows don’t appear on objects shaded with Ink 'n Paint unless the value of Paint Levels is 4 or greater.

**WARNING** Ink 'n paint will only give correct results when rendered from a camera or perspective view. It does not work in orthographic views.
Using Ink 'n Paint

You can use Ink 'n Paint on multiple objects, but in general, it tends to work best if you do the following:

1 Collect the objects for cartoon rendering into a single surface model such as an Editable Mesh.

2 Assign different material ID values to portions of the model you want to color differently.
   Typically, you would do this at the Element sub-object level, although you can certainly apply different material IDs to faces and polygons as well.

3 Create a Multi/Sub-Object material. In it, create a sub-material for each of the colors in the model. Make each sub-material an Ink 'n Paint material, then assign colors and maps using each sub-material's Paint controls.
   If necessary, adjust the Ink controls as well.

TIP ActiveShade on page 6550 works with the Ink 'n Paint material, and can be a good way to preview the material's effect.

Troubleshooting

Here are some commonly encountered problems, and potential solutions:

■ Internal ink lines are missing.
   The Overlap bias is probably too high. Decrease it. If Underlap is turned on, this might also have too high a bias.
   Another possible reason is that you have a self-intersecting object, or an object built by attaching smaller objects, thus creating intersecting faces.
   In this case, set up the objects to use the Mat ID or SmGroup ink components. If elements already have differing material IDs, try turning off Only Adjacent Faces.

■ Ink looks sloppy on sloping parts of the object.
   The Overlap or Underlap bias might be too low. Try increasing it.

■ Ink looks sloppy between interpenetrating objects.
   Find out which ink component is the sloppy one. Then adjust its bias control.

■ Ink lines disappear or are too narrow when Variable Width is on.
Turn on Clamp. You can also try to see if reducing the lighting level helps. Or, you can try turning off Variable Width, then assigning a Falloff map on page 6294 to the Ink Width component.

**TIP** To isolate which ink component is causing a problem, you can try assigning each component a different, distinctive (and easy to read) color, then rendering the image.

**WARNING** Ink ‘n paint will only give correct results when rendered from a camera or perspective view. It does not work in orthographic views.

**Interface**

**Basic Material Extensions rollout**

<table>
<thead>
<tr>
<th>Basic Material Extensions</th>
<th>2-Sided</th>
<th>Face Map</th>
<th>Faceted</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>2-Sided</strong> Makes the material 2-sided on page 8493. Applies the material to both sides of selected faces.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Face Map</strong> Applies the material to the faces of the geometry. If the material is a mapped material, it requires no mapping coordinates on page 8628. The map is automatically applied to each facet of the object.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Faceted</strong> Renders each face of a surface as if it were flat.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Fog BG when not painting</strong> When paint is turned off, the painted areas of the material color are the same as the background. This toggle, when on, lets the background in paint areas be affected by fog between the camera and the object. Default=off.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Opaque alpha</strong> When on, the alpha channel is opaque even if ink or paint is turned off. Default=off.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Bump Adds bump mapping to the material.
- **Toggle** When on, enables the bump map.
- **Spinner** Controls the bump map amount.
- **Map button** Click to assign a map to use for bump mapping.

**Displacement** Adds displacement mapping to the material.
- **Toggle** When on, enables the displacement map.
- **Spinner** Controls the displacement map amount.
- **Map button** Click to assign a map to use for displacement mapping.

**Paint Controls rollout**

Paint is the main color of the material.

There are three main components of the “paint” of Ink 'n Paint. Each has several associated controls, most of which are documented toward the end of this section.

**Lighted** The fill color for the lighted side of objects. Default=light blue. Turning off this component makes the object invisible, except for the ink. Default=on.
Left: A lighted character

Right: Lighted and Highlight both turned off to render only the ink

- **Paint Levels**  The number of shades of color that are rendered, from light to dark. Lower values make objects look flatter. Range=1 to 255. Default=2.

Increasing the value of Levels increases the number of shades of the basic color seen in the lighted area.

**Shaded**  The value in the spinner at the left is the percent of the Lighted color that appears on the unlighted side of objects. Default=70.0.

Turning off this component displays a color swatch, which you can use to assign a distinct color to shaded areas. Default=on.
Increasing the value of Shaded increases the saturation of the shaded area. You can also use Shaded to assign a distinct color for shading.

**Highlight** The color of the specular highlight. Default=white. When this component is off, there is no specular highlight. Default=off.

**TIP** A specular highlight can destroy the illusion of 2D. Use this component sparingly.

Left: No highlights
Right: Highlight on

- **Glossiness**  The size of the specular highlight. The greater the Glossiness, the smaller the highlight. Default=50.0.

![Glossiness examples](image)

*Increasing glossiness decreases the size of the highlight.*

**Color component controls:**

These are the controls that are duplicated for each of the paint components. Each has an on/off toggle, a main control, and then on the right, a set of map controls.

- **Check box**  The check box at the left of the rollout enables or disables that particular component. In the case of Shaded, it toggles between a percentage value (of the Lighted color) or a distinct Shaded color.

- **Color swatch or spinner**  The main control for each component. Click a color swatch to display a Color Selector on page 371 and set the color of the component. In the case of Shaded, this control can also be a percentage spinner.

![Color swatch example](image)

- **Map spinner**  The spinner to the right of the main control is the percentage of the map to use. Default=100.0.
Mapping the Lighted component

Right rear: The original, unmapped material

Left: Lighted component with a falloff map applied

Right front: Lighted component with a bitmap applied

- **Map check box**  The check box between the spinner and the button enables or disables the map. Default=off until a map is assigned, then on.

- **Map button**  Click the button to assign a map to this component. While a map is assigned and enabled, at 100 percent it completely overrides the main color component. At lower percentages, the map is blended with the color.

**Ink Controls rollout**

Ink is the linework, the outlines, in the material.
Except for Ink Width, each of the ink components has an on/off toggle and a color swatch. Click the color swatch to display a Color Selector on page 371 and change the ink component's color. Each ink component, Ink Width included, also has a set of map controls.

**Ink** When on, the rendering is “inked.” When off, no ink lines appear. Default=on.
Ink Quality  Affects the shape of the brush and the number of samples it uses. When Quality equals 1, the brush is a “+” shape, and samples are taken over an area of 5 pixels. When Quality equals 2, the brush is octagonal and the samples are taken over an area of 9 to 15 pixels. When Quality equals 3, the brush is nearly circular, and samples are taken over an area of 30 pixels. Range=1 to 3. Default=1.

**TIP** For most models, increasing the Quality value introduces only a very subtle change, and can take considerably longer to render. Do so only when a sub-object’s ink shows too many artifacts in the finished rendering, using the default Ink Quality. (Don’t rely on the ActiveShade preview, which will tend to be aliased.)

Ink Width  The width of the ink, in pixels. This is specified by the spinner labeled Min (minimum) unless Variable Width is on. When Variable Width is on, the Max (maximum) spinner is also enabled, and the ink width can vary between the minimum and maximum values. Default: Min=2.0, Max=4.0.
**Variable Width** When on, the ink's width can vary between the minimum and maximum Ink Width values. Ink with Variable Width looks a bit more streamlined than ink with a constant width. Default=off.

**Clamp** When Variable Width is on, sometimes the scene lighting causes some ink lines to become so thin they nearly disappear. If this happens, turn on Clamp, which forces the ink width to always remain between the Min and Max values, regardless of the lighting. Default=off.

**Outline** The ink where the outer edges of the object appear against the background or in front of a different object. Default=on.
Intersection Bias  Use this to adjust artifacts that might appear when two objects intersect each other. In effect, this moves the inked object closer to the rendering point of view, or farther away, so Ink 'n Paint can decide which object is in front. Positive values push the object away from the point of view, negative values pull it closer. Default=0.0.

Overlap  The ink used when a portion of an object overlaps itself. Default=on.

Overlap Bias  Use this to adjust artifacts that might appear in ink that traces the overlap. It says how far the overlap has to be in front of the rear surface for Overlap ink to turn on. Positive values push the object away from the point of view, negative values pull it closer. Default=10.0.

Underlap  Similar to Overlap, but applies ink to the farther surface rather than the nearer one. Default=off.

Underlap Bias  Use this to adjust artifacts that might appear in ink that traces the underlap. It says how far the underlap has to be behind the front surface for Underlap ink to turn on. Positive values push the object away from the point of view, negative values pull it closer. Default=0.0.

SmGroup  The ink drawn between the boundaries of smoothing groups on page 8724. In other words, it inks the edges of the object that have not been smoothed. Default=on.
Mat ID The ink drawn between different material ID values on page 8633. Default=on.

**TIP** If two Ink ’n Paint materials overlap in the viewport, and both have Mat ID on, you will often get a doubly thick ink line where they overlap. To correct this, turn off the Mat ID component for one of these materials.

Inking the edges between sub-materials

- **Only Adjacent Faces** When on, inks the material ID edge between adjacent faces, but not between one object and another. When off, inks the material ID edge between two objects or other non-adjacent faces. Default=on.

- **Intersection Bias** When Only Adjacent Faces is turned off, use this to adjust any artifacts that appear at the boundary between two objects with different material IDs. Default=0.0.

**Map controls** There are map controls for each of the ink components: Width, Outline, Overlap, Underlap, SmGroup, and Mat ID. These work the same as they do for the material’s paint components, as described above.
Mapping the outline and overlap components to simulate the look of drawing on paper

**Photometric Materials (Non-mental ray)**

This section describes photometric materials that do not use mental ray or the mental ray renderer.

**Architectural Material**

The settings for an Architectural material are physical properties, so it provides the greatest possible realism when used with photometric lights on page 5348 and radiosity on page 6615. With this combination of features, you can create lighting studies with a high degree of accuracy.
Architectural materials used with photometric lights and a radiosity solution create a realistic rendering with accurate lighting levels.

It is not recommended that you use the Architectural material with standard 3ds Max lights in the scene, or with the Light Tracer. The point of this material is to provide accurate modeling. Use it with photometric lights and radiosity. The mental ray renderer, on the other hand, can render the Architectural material, with some limitations described below.

**TIP** If you don't need the degree of realism that the Architectural material provides, you can use a standard material on page 5962 or other material type.
Material Templates

When you create a new material, you can choose from a variety of templates. A template is simply a set of preset material parameters, which approximates the kind of material you want to create, and gives you a starting point. See Templates Rollout on page 6150.

Rendering Architectural Materials with the mental ray Renderer

The mental ray Renderer on page 6675 can render Architectural materials. There are some limitations, as follows:

- Emit Energy (Based on Luminance): This setting is ignored. The Architectural material does not contribute to the scene's lighting.
- Sampling Parameters: These settings are ignored, as the mental ray renderer uses its own sampling.

Tip When rendering with mental ray, instead of the Architectural material, we highly recommend that you use the Arch & Design material on page 5858. This material was designed especially for mental ray and provides superior flexibility, rendering characteristics, and speed.

See also:

- SuperSampling Rollout on page 5759
- mental ray Connection Rollout on page 5763

Templates Rollout

Material Editor > Architectural material > Templates rollout

The Templates rollout gives you a list of material types to choose from. A template is simply a set of preset parameters for the Physical Qualities rollout, which approximates the kind of material you want to create, and gives you a starting point. Once you choose a template, you can adjust its settings and add maps on page 6185 to enhance realism and improve the material's appearance.

The templates do not affect the Diffuse Color on the Physical Qualities rollout, only the numeric settings.
Interface

Template drop-down list Chooses the kind of material you are designing. Each template provides preset values for the various material parameters. These are the material templates provided with 3ds Max. The purpose of most templates is clear, so the table doesn’t comment on all of them.

<table>
<thead>
<tr>
<th>Template</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ceramic Tile - Glazed</td>
<td></td>
</tr>
<tr>
<td>Fabric</td>
<td></td>
</tr>
<tr>
<td>Glass - Clear</td>
<td></td>
</tr>
<tr>
<td>Glass - Translucent</td>
<td></td>
</tr>
<tr>
<td>Ideal Diffuse</td>
<td>A neutral white material</td>
</tr>
<tr>
<td>Masonry</td>
<td>A good base for a diffuse map</td>
</tr>
<tr>
<td>Metal</td>
<td>Shiny and reflective</td>
</tr>
<tr>
<td>Metal - Brushed</td>
<td>Less shiny</td>
</tr>
<tr>
<td>Metal - Flat</td>
<td>Even less shiny</td>
</tr>
<tr>
<td>Metal - Polished</td>
<td>Highly shiny</td>
</tr>
<tr>
<td>Mirror</td>
<td>Completely shiny</td>
</tr>
<tr>
<td>Paint Flat</td>
<td>Another neutral white material</td>
</tr>
<tr>
<td>Template</td>
<td>Comments</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>Paint Gloss</td>
<td>Also white, but shiny</td>
</tr>
<tr>
<td>Paint Semi-Gloss</td>
<td>Also white, only slightly shiny</td>
</tr>
<tr>
<td>Paper</td>
<td></td>
</tr>
<tr>
<td>Paper - Translucent</td>
<td></td>
</tr>
<tr>
<td>Plastic</td>
<td></td>
</tr>
<tr>
<td>Stone</td>
<td>A good base for a diffuse map</td>
</tr>
<tr>
<td>Stone Polished</td>
<td>Has a bit of shininess; also a good base for</td>
</tr>
<tr>
<td></td>
<td>a diffuse map</td>
</tr>
<tr>
<td>User Defined</td>
<td>Neutral; a good base for a diffuse map</td>
</tr>
<tr>
<td>User-Defined Metal</td>
<td>Somewhat shiny; also a good base for</td>
</tr>
<tr>
<td></td>
<td>a diffuse map</td>
</tr>
<tr>
<td>Water</td>
<td>Completely clear and shiny</td>
</tr>
<tr>
<td>Wood Unfinished</td>
<td>Neutral; a good base for a map</td>
</tr>
<tr>
<td>Wood Varnished</td>
<td></td>
</tr>
</tbody>
</table>

**Physical Qualities Rollout**

Material Editor > Architectural material > Physical Qualities rollout

When you create a new Architectural material on page 6148 or edit an existing one, the settings on the Physical Qualities rollout are the ones you are most likely to need to adjust.
Procedures

To match a material's luminance to a light:

**WARNING** Only photometric lights give correct luminance. Also, the mental ray renderer disregards the Emit Energy setting.

- Click to turn on Set Luminance From Light (below the Luminance setting), then in a viewport, click the light. After you choose the light, the button turns off once more.

**TIP** If you are using a radiosity solution on page 6615, make sure to turn on Emit Energy (Based On Luminance) for any material whose luminance is greater than zero. This control is on the Advanced Lighting Override rollout on page 6159.

Interface

![Interface Diagram]

**Diffuse Color** Controls the diffuse color on page 8552. The diffuse color is the color this material has in direct light. Click the color swatch to display the Color Selector on page 371 and change the diffuse color.
Set color to texture average  Click to change the diffuse color to an average of the colors in the current diffuse map. (If no map is assigned, this button has no effect.)

This button is useful when you are going to reduce the diffuse map’s Amount. When the diffuse map pattern appears over an average of itself, for most kinds of materials the effect is more realistic than when the pattern appears over an unrelated color.

**WARNING** This button will change the diffuse color even if the diffuse map is turned off.

**Diffuse Map** These controls assign a map to the material’s diffuse component. To assign a map, click the oblong button (labeled “None” by default). This displays the Material/Map Browser. In the Browser, choose the map type, and then click OK. If you choose Bitmap as the map type, an additional dialog prompts you to choose the particular bitmap file to use.

While a map is assigned to the material, its name appears as the map button’s label.

- **Amount spinner**  The spinner at the left sets the amount of diffuse map to use. This value is a percentage: at 100.0, only the map is visible; at lower amounts, the diffuse color shows through; at 0.0, the map is not visible at all.
- **On/off**  The check box between the spinner and the map button is an on/off switch. When on, the map appears in the material. When off, the map does not appear.

**Shininess** Sets the shininess of the material. This value is a percentage: at 100.0, the material is as shiny as possible; at lower values, it is less shiny; at 0.0, it is not shiny at all.

In general, the shinier a material is, the smaller its specular highlights appear. Specular highlights are reflections of the lights that illuminate the material. (The index of refraction can also affect the size of highlights.) Shininess also controls how much the material reflects other objects in the scene.

**NOTE** Shininess alone is not sufficient to produce specular reflections and highlights on a surface. You must also consider the Index Of Refraction (IOR), described below.
The amount spinner for a shininess map scales the map. If no map is assigned, the spinner value is used by itself.

**Transparency** Controls how transparent the material is. This value is a percentage: at 100.0, the material is completely transparent; at lower values, the material is partly opaque; and at 0.0, the material is completely opaque.

**TIP** The effect of transparency is best previewed against a pattern background. If the material preview doesn’t show a pattern of colored checks, right-click the material preview or the map preview, and choose Background from the pop-up menu.

The amount spinner for a transparency map scales the map. If no map is assigned, the spinner value is used by itself.

**Translucency** Controls how translucent the material is. A translucent object transmits light, but also scatters it within the object. This value is a percentage: at 0.0, the material is completely opaque; at 100.0, the material is as translucent as possible.

The amount spinner for a translucency map scales the map. If no map is assigned, the spinner value is used by itself.

**Index of Refraction** The index of refraction (IOR) controls how severely the material refracts transmitted light, and how reflective the material appears. At 1.0, the IOR of air, the object behind the transparent object does not distort. At 1.5, the object behind distorts greatly, like a glass marble. Range=1.0 to 2.5.

Common IORs (assuming the camera is in air or a vacuum) are:

<table>
<thead>
<tr>
<th>Material</th>
<th>IOR Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vacuum</td>
<td>1.0 (exactly)</td>
</tr>
<tr>
<td>Air</td>
<td>1.0003</td>
</tr>
<tr>
<td>Water</td>
<td>1.333</td>
</tr>
<tr>
<td>Glass</td>
<td>1.5 to 1.7</td>
</tr>
<tr>
<td>Diamond</td>
<td>2.418</td>
</tr>
</tbody>
</table>

Photometric Materials (Non-mental ray) | 6155
In the physical world, the IOR results from the relative speeds of light through the transparent material and the medium the eye or the camera is in. Typically this is related to the object’s density: the higher the IOR, the denser the object. The IOR affects how shiny a material appears; or, in the case of transparent materials such as water or glass, the amount of distortion. For nontransparent materials, the higher the IOR, the more light is reflected from the material, and the shinier the material appears.

A refractive index of 1.0 means that all light is transmitted into the material. In this case, even if the material has a high Shininess value, the surface appears perfectly diffuse, and shows no specular highlights.

**Luminance cd/m²** When its luminance is greater than 0.0, the material appears to glow, and if you turn on Emit Energy (see below), it contributes energy to the *radiosity solution* on page 6615. Luminance is measured in candelas per meter squared.

The amount spinner for a luminance map scales the map. If no map is assigned, the spinner value is used by itself.

**Set luminance from light** Obtains the material’s luminance from a light in the scene. Click to turn on this button, then click a light in a viewport. The material’s luminance is set to match the luminance of the light, and the button is turned off once more.

**2-Sided** When on, makes the material 2-sided on page 8493. Applies the material to both sides of selected faces.

**Raw Diffuse Texture** When on, excludes the material from lighting and exposure control. This makes the material render with a completely flat look, using the pure RGB values of the diffuse color or map. Default=off.

### Special Effects Rollout

When you create a new *Architectural material* on page 6148 or edit an existing one, the settings on the Special Effects rollout let you assign maps that create bumps or displacement, adjust light intensity, or control transparency.
Interface

**Bump controls** These controls assign a bump map on page 6049 to the material. To assign a map, click the oblong button (labeled “None” by default). This displays the Material/Map Browser. In the Browser, choose the map type, and then click OK. If you choose Bitmap as the map type, an additional dialog prompts you to choose the particular bitmap file to use. While a map is assigned to the material, its name appears as the map button’s label.

- **Amount spinner** The spinner at the left sets the amount of bump mapping to use. At 1000.0, bump mapping has its greatest effect; at lower amounts, the bumps are less pronounced; at 0.0, the bumps are not visible at all. Negative values reverse the direction of the bump effect. Range: –1000.0 to 1000.0.

- **On/off** The check box between the spinner and the map button is an on/off switch. When on, the map is used in the material. When off, the map is not used.

**Displacement controls** These controls assign a displacement map on page 6059 to the material. To assign a map, click the oblong button (labeled “None” by default). This displays the Material/Map Browser. In the Browser, choose the map type, and then click OK. If you choose Bitmap as the map type, an additional dialog prompts you to choose the particular bitmap file to use. While a map is assigned to the material, its name appears as the map button’s label.
**Amount spinner** The spinner at the left sets the amount of displacement mapping to use. At 1000.0, displacement mapping has its greatest effect; at lower amounts, the displacement is less pronounced; at 0.0, the displacement are not visible at all. Negative values reverse the direction of the displacement. Range: –1000.0 to 1000.0.

**On/off** The check box between the spinner and the map button is an on/off switch. When on, the map is used in the material. When off, the map is not used.

**Intensity controls** These controls assign an intensity map to the material, modulating the material's brightness. The map is treated as a black-and-white scale of intensity values.

**TIP** Applying a low-frequency Noise map on page 6303 to the intensity can help reduce the “computer-generated” look of a texture, and add a natural feel to surfaces such as bricks and carpets lit by daylight.

To assign a map, click the oblong button (labeled “None” by default). This displays the Material/Map Browser. In the Browser, choose the map type, and then click OK. If you choose Bitmap as the map type, an additional dialog prompts you to choose the particular bitmap file to use. While a map is assigned to the material, its name appears as the map button's label.

**Amount spinner** The spinner at the left sets the amount of intensity mapping to use. At 100.0, intensity mapping has its greatest effect; at lower amounts, the effect is less pronounced; at 0.0, the map has no effect; and at values less than 0.0, the material is dimmed. Range: 0.0 to 100.0.

**On/off** The check box between the spinner and the map button is an on/off switch. When on, the map is used in the material. When off, the map is not used.

**Cutout controls** These controls assign a cutout map on page 6164 to the material. To assign a map, click the oblong button (labeled “None” by default). This displays the Material/Map Browser. In the Browser, choose the map type, and
then click OK. If you choose Bitmap as the map type, an additional dialog prompts you to choose the particular bitmap file to use.

While a map is assigned to the material, its name appears as the map button's label.

Type Spinner

The spinner at the left sets the amount of cutout mapping to use. This value is a percentage: at 100.0, the map has its full effect; lower amounts have the effect of darkening the map, reducing its effect and increasing transparency. At 0.0, the map is completely black, making objects with this material completely transparent.

On/off

The check box between the spinner and the map button is an on/off switch. When on, the map is used in the material. When off, the map is not used.

**Advanced Lighting Override Rollout**

Material Editor > Architectural material > Advanced Lighting Override rollout

When you create a new Architectural material on page 6148 or edit an existing one, the settings on the Adjust Radiosity rollout let you adjust how the material behaves in a radiosity solution on page 6615.

**Obtaining a Better Image**

Materials with a bright diffuse color or high shininess can be highly reflective. This can lead to overexposed or washed-out radiosity solutions. In general, the best way to adjust this is to reduce the HSV Value (V) of a material's diffuse color; or, for a material with a diffuse map, reduce the map's RGB level. In some situations, the controls on this rollout can improve the appearance of the radiosity solution. Examples of situations where the material's radiosity settings can help include color bleeding and large dark areas:

- You might want to reduce Reflectance Scale or Color Bleed Scale when a large area of color (for example, a red carpet in a room with white walls) creates excessive color bleeding. This might be physically accurate, but the eye adjusts for such effects, and the radiosity result might look better with less reflectance or less color bleeding.
Left: Excessive bleeding of the floor color onto the walls and ceiling.

Right: Reducing the floor’s Reflectance Scale causes less bleeding.

- You might want to increase Reflectance Scale when the scene includes a large dark area (for example, a black floor). This can lead to a very dark radiosity result. You can maintain the floor’s color but increase reflectance, giving the solution the colors you want while increasing its brightness.

The room is lit only by spotlights pointed at the floor. Increasing reflectance of the floor brightens the entire room.
**TIP** Check the reflectance and transmittance display on page 5669 to get an idea of how the current material will affect the radiosity solution.

**Interface**

**WARNING** There is no problem with reducing the default scale, but increasing it for any of these parameters might cause colors to “burn out”: if the scale is too great, they render as pure white, appearing overexposed.

![Advanced Lighting Override](image)

**Emit Energy (Based on Luminance)** When on, the material contributes energy to the radiosity solution, based on the material’s luminance value (see above).

**NOTE** The [mental ray renderer](page 6675) does not use this setting. The Architectural material does not contribute to the scene’s lighting.

Increasing the Luminance (above 0.0) makes an object appear to glow in ordinary renderings, but does not contribute energy to the radiosity solution. To have radiosity processing take a self-illuminating material into account, turn on Emit Energy (Based On Luminance).
Upper left: By default, luminous neon lights do not influence the scene light.

Right: With Emit Energy on, the radiosity solution takes luminance into account.

**TIP** When you increase luminance to achieve a special effect in the rendering (for example, to make the globe surrounding a lamp appear to be glowing), probably you shouldn't turn on Emit Energy (in the example, both the globe and lamp would then add light to the scene). When you increase luminance because the object really glows (for example a neon light tube), then you should turn on Emit Energy, so that the object contributes light to the scene.

**Color Bleed Scale** Increases or decreases the saturation of reflected color. Range=0.0 to 1000.0. Default=100.0.
Color Bleed increases or decreases the saturation of reflected color.

**Indirect Bump Scale** Scales the effect of the base material’s bump mapping on page 6049 in areas lit by indirect light. When this value is zero, no bump mapping is done for indirect light. Increasing Indirect Light Bump Scale increases the bump effect under indirect lighting. This value does not affect the Bump amount in areas where the base material is lit directly. Range=–999.0 to 999.0. Default=100.0.

**TIP** This parameter is useful because indirect bump mapping is simulated and not always accurate. Indirect Light Bump Scale lets you adjust the effect by hand.

**Reflectance Scale** Increases or decreases the amount of energy the material reflects. Range=0.0 to 1000.0. Default=100.0.

**TIP** Don’t use this control to increase self-illumination. Use the material’s Luminance instead. The Luminance control is on the **Physical Qualities rollout** on page 6152.
Transmittance Scale Increases or decreases the amount of energy the material transmits. Range=0 to 1000.0. Default=100.0.

Transmittance Scale increases or decreases the energy of transmitted rays.

Cutout Mapping

Material Editor > Architectural material > Special Effects rollout > Cutout map button

Assigning a bitmap on page 6213 or procedural map on page 8691 to the Cutout component of an Architectural material on page 6148 makes the material partially transparent. Lighter (higher-value) areas of the map render as opaque; darker areas render as transparent; and values in between are semi-transparent.

Setting the cutout map's Amount to 100 applies all of the map. Transparent areas are fully transparent. Setting the Amount to 0 is the equivalent of turning the map off. Intermediate Amount values are blended with the Transparency value on the Physical Qualities rollout. Transparent areas of the map become more opaque.
The gray levels of a cutout map determine the amount of transparency.

**Procedures**

**To use a cutout map:**

1. Click the Cutout map button.
   The Material/Map Browser on page 5724 is displayed.

2. Choose from the list of map types on page 6185, and then click OK.
   The Material is now at the map level, and displays map controls.
   (If you choose Bitmap as the map type, you first see a file dialog that lets you choose the image file.)

3. Use the map controls to set up the map.
To remove a cutout map from a material:

**TIP** You can disable the map without removing it. Simply turn off the toggle immediately to the left of the map button on the Special Effects rollout.

1. If the Material Editor is displaying the map controls, click the Type button on page 5706 to display the Material/Map Browser. If the map controls aren’t visible, click the Cutout map button to display them, and then click the Type button.

2. In the Browser, choose NONE as the map type, and then click OK. The map is removed.

**Advanced Lighting Override Material**

Activate Default Scanline Renderer. > Material Editor > Type button > Material/Map Browser > Advanced Lighting Override

This material lets you directly control the radiosity properties of a material. Advanced Lighting Override is always a supplement to a base material, which can be any renderable material. The Advanced Lighting Override material has no effect on ordinary renderings. It affects the radiosity solution on page 6615 or light tracing on page 6601.

**NOTE** This material is unavailable with the mental ray renderer.

Advanced Lighting Override has two main uses:

- Adjusting the material properties used in a radiosity solution or light tracing
- Creating special effects such as having self-illuminating objects contribute energy to the radiosity solution

As the rollout for the Advanced Lighting Override material states, you don’t have to apply this material to obtain a radiosity solution, and most models will never require it.

**IMPORTANT** The mental ray renderer on page 6675 does not support the Advanced Lighting Override material.
Obtaining a Better Image

Materials that use default settings can be highly reflective. This can lead to overexposed or washed-out radiosity solutions. In general, the best way to adjust this is to reduce the HSV Value (V) of a material color; or, for a bitmapped material, reduce the RGB Level. In some situations, Radiosity Override can improve the appearance of the radiosity solution. Examples of situations where Radiosity Override can help include color bleeding and large dark areas:

- You might want to reduce Reflectance Scale or Color Bleed when a large area of color (for example, a red carpet in a room with white walls) creates excessive color bleeding. This might be physically accurate, but the eye adjusts for such effects, and the radiosity result might look better with less reflectance or less color bleeding.

Left: Excessive bleeding of the floor color onto the walls and ceiling.

Right: Radiosity Override material reduces the floor's reflectance, causing less bleeding.

- You might want to increase Reflectance Scale when the scene includes a large dark area (for example, a black floor). This can lead to a very dark radiosity result. You can maintain the floor's color but increase reflectance, giving the solution the colors you want while increasing its brightness.
The room is lit only by spotlights pointed at the floor. Increasing reflectance of the floor brightens the entire room.

**TIP** Check the reflectance and transmittance display on page 5669 to get an idea of how the current material will affect the radiosity solution or light-traced rendering.

### Creating Special Effects

Self-illumination on page 5995 makes an object appear to glow in ordinary renderings, but does not contribute energy to the radiosity solution. To have radiosity processing take a self-illuminating material into account, make this material the base material of Advanced Lighting Override, then increase the value of Luminance Scale.
Upper left: By default, self-illuminated neon lights do not influence the scene light.
Right: Advanced Lighting Override material scales the neon lights’ Luminance so the radiosity solution can take it into account.

Luminance scale takes self-illumination mapping on page 6041 into account. You can use this to model effects such as a computer monitor in a darkened room.

The Special Effects group of the Advanced Lighting Override material also has a control for adjusting the quality of bump mapping on page 6049 in areas of indirect lighting.

Procedures

To adjust a material’s reflectance and transmittance:

1. Create a material for your scene.
2. Click the Type button and choose Advanced Lighting Override.
3. In the Replace Material dialog on page 5721, choose Keep Old Material As Sub-Material, and click OK.
4 Adjust the Reflectance Scale and Transmittance Scale parameters. As you do, watch the Reflectance and Transmittance display, and make sure the values are good for a radiosity solution. For example, 85 percent reflectance is about the highest that will work with radiosity. Most real-world materials have much lower reflectance.

See Reflectance and Transmittance Display on page 5669 for some reflectance properties of real-world materials.

To make a self-illuminating material emit radiosity energy:

1 Create a material that is self-illuminating.
2 Click the Type button and choose Advanced Lighting Override.
3 In the Replace Material dialog on page 5721, choose Keep Old Material As Sub-Material, and click OK.
4 Increase the value of Luminance Scale to have the material emit energy for radiosity processing.
Interface

Override Material Physical Properties group

These parameters control the base material’s advanced lighting properties directly.

**WARNING** There is no problem with reducing the default scale, but increasing it for any of these parameters might cause colors to “burn out”: if the scale is too great, they render as pure white, appearing overexposed.

**Reflectance Scale** Increases or decreases the amount of energy the material reflects. Default=1.0.
Reflectance Scale increases or decreases the energy of reflected rays.

**TIP** To increase self-illumination, use Luminance Scale on page 6173 in the Special Effects group, not this control.

**Color Bleed** Increases or decreases the saturation of reflected color. Default=1.0.

Color Bleed increases or decreases the saturation of reflected color.

**Transmittance Scale** Increases or decreases the amount of energy the material transmits. Default=1.0.
Transmittance Scale increases or decreases the energy of transmitted rays.

NOTE This parameter affects only radiosity. It has no effect on light tracing.

Special Effects group

These parameters relate to specific components in the base material.

Luminance Scale (cd/m^2) When greater than 0, scales the self-illumination component on page 5995 of the base material. Use this parameter to have self-illuminating objects contribute energy to the radiosity or light-traced solution. Cannot be less than zero. Default=0.0. Typically, a value of 500 or more will give good results.

Indirect Light Bump Scale Scales the effect of the base material’s bump mapping on page 6049 in areas lit by indirect light. When this value is zero, no bump mapping is done for indirect light. Increasing Indirect Light Bump Scale increases the bump effect under indirect lighting. This value does not affect the Bump amount in areas where the base material is lit directly. Cannot be less than zero. Default=1.0.

TIP This parameter is useful because indirect bump mapping is simulated and not always accurate. Indirect Light Bump Scale lets you adjust the effect by hand.

Base Material Click to go to the base material and adjust its components. You can also replace the base material with a different material type.

To return from the base material to the Advanced Lighting Override level, click Go To Parent.
Materials to Support Hardware Shading and Rendering to Texture

The materials described in this section specifically support hardware shading (as in hardware-driven viewports or a game engine), and the Render to Texture on page 6843 feature.

Shell Material

Render to a texture. > Material Editor > Pick Material from Object > Click object with “baked” material.

The Shell material is for use with texture baking on page 6843. When you use Render To Texture to bake a texture, it creates a Shell material that contains two materials: the original material used in the rendering, and the baked material. The baked material is a bitmap that is saved to disk by Render To Texture. It is “baked,” or attached to an object in the scene.

The Shell material is a container for other materials, like Multi/Sub-Object. It also lets you control which material is used in which renderings.

NOTE The Material/Map Browser lists the Shell material when you assign a new material. You can apply two materials to a single object this way, but changing a material’s type to Shell does not generate a baked texture that is saved to disk.

Procedures

To load a shell material into a sample slot:

1. Click an unused sample slot.

2. Click Pick Material From Object.

3. In a viewport, click an object that has a baked material.
   The sample slot now contains the baked material, and the Shell Material Parameters rollout is displayed.
Interface

Original Material Displays the name of the original material. Click the button to view that material and adjust its settings.

Baked Material Displays the name of the baked material. Click the button to view that material and adjust its settings.

In addition to the color and mapping of the original material, the baked material can include shadows from lighting, and other information. Also, a baked material has a fixed resolution.

Viewport Use these buttons to choose which material appears in shaded viewports: the original material (upper button) or the baked material (lower button).

Render Use these buttons to choose which material appears in renderings: the original material (upper button) or the baked material (lower button).

DirectX Shader Material

Material Editor > Type button > Material/Map Browser > DirectX Shader

The DirectX Shader material enables you to shade objects in viewports using DirectX (Direct3D) shaders. With DirectX shading, materials in a viewport more accurately represent how the material will appear in another application, or on other hardware such as a game engine. You can use this material only when you are using the Direct3D Display driver on page 8325 and DirectX 9.0 or DirectX 10.0 is chosen as the Direct3D version.
NOTE Typically, this material is visible in the Browser only if DirectX 9 or DirectX 10 is available on your system, and you are using the Direct3D display driver with DirectX 9.0 or DirectX 10.0 chosen as the Direct3D version. If this material is not visible, you can see it (in gray) by turning on Incompatible in the Show group.

The DirectX Shader material can use the following types of shaders:

- **FX files** on page 8589
- **CGFX files** on page 8530
  Sample FX and CGFX files are provided in the \fx folder in the 3ds Max program directory.
- **XSML files** on page 8771
  You can create XSML shader files using the mental mill® application from mental images®.

**IMPORTANT** For a MetaSL shader to work with mental ray, you must save it as a phenomenon. Phenomena are described in the mental mill® Artist Edition User Guide.

See also:

- **DirectX Shader group** on page 5685

**Light Support**

Typically FX and CGFX shaders are coded to use a specific number of lights: usually just a single light. If the FX/CGFX file you open is coded this way, the shader-specific rollouts display a control that lets you pick the light to use. For example:

![Light Position control](image)

XSML shaders, on the other hand, are not coded to use specific lights, so they use all active lights in the scene.
**Bitmap Support**

When you assign a map to a mappable component of a DirectX shader, you can choose from among these map types:

- **All DX Formats**
  Shows all the file types listed in the remainder of this list.

- **BMP files** on page 7834

- **DDS files** on page 7836

- **JPEG files** on page 7848

- **Radiance image (HDR) files** on page 7866

- **PNG files** on page 7862

- **PSD files** on page 7863
  When you open a Photoshop PSD file that contains layers, 3ds Max displays a dialog that lets you choose to either collapse the layers and display the composited image, or use just a single layer.

- **TGA files** on page 7878

**Interface**

**DirectX Shader rollout**

![DirectX Shader rollout](image)

**Shader button** Click to display a file dialog that lets you open a Direct3D Effects (FX) file. By default, the `default.fx` file is chosen.

To open a CGFX or XSML file, choose that file type from the Files Of Type drop-down list in the file dialog.

**Reload** Click to reload the active shader file. To update a shader file, you can edit it and then click Reload. You don't have to restart 3ds Max to see the effect of the changes to the shader.
Shader-specific rollouts

The rollouts that appear below the DirectX Shader rollout and above the Software Rendering rollout are the interface to the shader you chose. These rollouts are specific to each shader.

When you load a shader that is not appropriate for 3ds Max, then instead of parameters you might see a rollout that displays an error message. For example:

An XSML file can contain more than one shader. When you open one of these, 3ds Max prompts you to choose which shader the material will use. For example:

Software Render Style rollout

Specifies a material that controls software shading and rendering of objects to which the DirectX Shader material is applied. Viewports use DX shading unless the Software or OpenGL driver is active. Renderings always use software shading.
Usually you will want to choose a material that clearly identifies which objects in your scene have the DirectX Shader material applied.

**NOTE** The DirectX Shader material has no specific settings for software shading. Any type of 3ds Max material will do. Scenes from previous versions that used DX-specific settings are assigned a Standard material with equivalent rendering properties.

If DirectX is not available on your system, but you assign the DirectX Shader material anyway (by using the Material/Map Browser's Incompatible option), this is the only rollout that appears in the Material Editor.

**LightMap Shader Rollout**

Material Editor > DirectX Manager rollout > Choose LightMap from the drop-down list. > LightMap Shader rollout appears.

When you have chosen LightMap as the DirectX viewport shader on page 5771, this rollout appears. The LightMap shader can display both a base texture and a lighting map. Typically both these maps come from rendering to textures (texture baking) on page 6843. The base texture typically would be a completed map, a blend map, or a diffuse map. You can choose these map types, as well as lighting map, to render as elements of a baked texture on page 6848.

**NOTE** In order to use the LightMap shader, you must have 3ds Max configured to use the Direct3D graphics driver. To change the graphics driver configuration, refer to the Viewport Preferences on page 8308 topic.

**Interface**

![LightMap Shader Rollout](image)

Materials to Support Hardware Shading and Rendering to Texture | 6179
Base Texture group

**Button** Shows the name of the base texture. Click the button to display that material's parameters, and adjust them if necessary.

**Toggle** When on, shaded viewports display the base texture. When off, it is not displayed.

If both the Base Texture and Light Map toggles are off, the material appears black in viewports.

**Mapping Channel** Shows the map channel on page 8627 this texture uses.

Light Map group

**Button** Shows the name of the lighting map.

**Toggle** When on, shaded viewports display the lighting map. When off, it is not displayed.

If both the Base Texture and Light Map toggles are off, the material appears black in viewports.

**Mapping Channel** Shows the map channel this texture uses.

Metal Bump Shader Rollout

Material Editor > DirectX Manager rollout > Choose LightMap from the drop-down list. > Metal Bump Shader rollout appears.

When you have chosen Metal Bump as the DirectX viewport shader on page 5771, this rollout appears. The Metal Bump shader can display a variety of texture-baked maps on page 6843, including normal maps for an embossed effect. It is good for displaying shiny surfaces.

**NOTE** In order to use the Metal Bump shader, you must have 3ds Max configured to use the Direct3D graphics driver. To change the graphics driver configuration, refer to the Viewport Preferences on page 8308 topic.

The Metal Bump shader's results are always visible in viewports, regardless of the object type.

**WARNING** The Metal Bump shader lets you adjust settings to get various effects in shaded viewports. These settings will not necessarily apply when you display the texture-baked object on other Direct3D devices.
See also:
- Baked Texture Elements on page 6848

**Interface**

![Viewport Shader - Metal Bump interface](image)

Materials to Support Hardware Shading and Rendering to Texture | 6181
Ambient & Diffuse group

Ambient Color When not black, tints the object's ambient color. Click the color swatch to display a Color Selector on page 371 and choose the ambient color. Default=black.

Diffuse Color When not white, tints the diffuse color. Click the color swatch to display a Color Selector and choose the diffuse color. Default=white.

Texture 1 Displays a texture map for the diffuse color. Typically this would be a texture-baked diffuse map, completed map, or blend map. See the section “Map Controls,” below, for a description of the individual controls.

Texture 2 Displays a second texture map for the diffuse color. Typically this would be a texture-baked lighting map or shadows map. See the section “Map Controls,” below, for a description of the individual controls.

Use Alpha When on, displays the alpha channel. When off, does not. Default=off.

Mix Amount Adjusts the mixing of the two texture maps in shaded viewports.

Specular group

Enable When on, enables specular highlights for the object. Default=off.

Specular Color Specifies a specular color for the object. Click the color swatch to display a Color Selector and choose a color. Default=white.

Texture Displays a specular map for the object. Typically this would be a texture-baked specular map. See the section “Map Controls,” below, for a description of the individual controls.

Bump group

Normal Displays a normal map for the object. Typically this would be a texture-baked normals map. See the section “Map Controls,” below, for a description of the individual controls.

Bump Displays a bump map for the object. Typically this would be a bump map used for the original material.
See the section “Map Controls,” below, for a description of the individual controls.

**Bump Intensity** Adjusts the intensity of the bumps in shaded viewports.

**Reflection group**

**Cubemap** Displays a reflection map projected cubically (around the scene). Typically this would be an environment map.

**Reflection Intensity** Adjusts the intensity of reflections in shaded viewports.

**Pick object and create** Click to choose an object and have 3ds Max generate the reflections used in the viewport.

**Sync Standard Material**

When on, adjustments you make to the Metal Bump shader update settings in the active standard material, letting you save the changes you made. When off, the standard material is unchanged. Default=off.

**Map Controls**

In this rollout, all texture maps have the same general controls. The rollout appears only when you are using the DirectX viewport shader.

**Toggle** When on, the map is used in viewports. When off, it is not used. Default=on if a map is assigned, off otherwise.

**Map button** Click to choose the texture map to use for this component of the object.

**Map Channel** Specifies the map channel on page 8627 used by this map. This control is not present for the cubic reflection map.

**XRef Material**

Material Editor > Type button > Material/Map Browser > XRef Material

The XRef material lets you externally reference a material applied to an object in another scene file. As with XRef objects on page 7450, the material resides in a separate source file. You can set the material properties only in the source file. When you change them in the source file and then save it, the material's appearance can change in the master file that contains the XRef.
NOTE If an XRef object has a material applied to it in the original source file (and Merge Materials is turned off when you reference the source file), then that material is automatically externally referenced in the scene, and can be loaded in the Material Editor if you browse from the scene. When you explicitly use the Material Editor to create an XRef material, you don’t have to have any XRef objects from that particular source file. However, the record’s source file and material do appear in the XRef Objects dialog on page 7456.

The Show Map In Viewport button works for an XRef material only if the same button is turned on in the source file. Otherwise, it is disabled.

Interface

Highlight Corresponding XRef Record in the XRef Objects Dialog Click to open the XRef Objects dialog on page 7456 that highlights the source file’s current record with its object displayed in the XRef Entities list. If no file and object have yet been selected for the material, the XRef Objects dialog is displayed, and lets you browse for the file and material to use.

File name field Displays the path and file name of the scene file containing the source of the XRef material. You can edit this to point to a different path and file.
**File name display** Displays the file name only, without the path.

**Path button** Click to display the Open File dialog from which you can specify a different path and file name for the source file. After you choose the file, 3ds Max displays the XRef Merge dialog on page 7471 that lets you choose the object whose material you want to reference.

**Object name field** Displays the name of the source object pointed to in the source file.

**Object name and material** Displays the name of the source object followed by the material name in parentheses. For example, “Shaker (Chrome).”

**Path button** Click to display the XRef Merge dialog on page 7471 pointing to the scene in the XRef File Name field. Here, you can specify a different object whose material you want to reference.

**Status line** Displays the status of the material. For example, if the file and object are both found, this field says “Status: XRef Resolved.”

### Maps and Shaders

The most common use for maps on page 8631 is to improve the appearance and realism of Materials on page 8635. You can also use maps to create environments on page 7163 or projections from lights (see Advanced Effects Rollout on page 5457).

Maps can simulate textures, applied designs, reflections, refractions, and other effects. Used with materials, maps add details without adding complexity to the geometry of an object. (Displacement mapping on page 6059 can add complexity.)

With the mental ray renderer, a shader can be the equivalent of a map. You assign a shader to a material in the same way you assign a map.

**NOTE** mental ray shaders can apply to other scene elements such as cameras; see mental ray Shaders on page 6385 for more information.

### Accessing Map Types

You use the Material/Map Browser on page 5724 to load a map or create a map of a particular type. The Browser groups maps into categories according to
their type. You can choose whether the Browser lists maps, materials, or both; you can choose which map types.

**To list map types by category:**

1. Open the Material Editor.
2. Click Get Material to display the Material/Map Browser.
3. On the left side of the Material/Map Browser, in the Show group, turn off Materials. Leave Maps turned on.
4. In the lower set of buttons, choose the category you want listed, or choose All to show all map types.
   The list is displayed in the right panel of the Browser.

**To open the Browser from the Material Editor:**

As you work with materials, you can open the Material/Map Browser from the Material Editor.

1. Open the Material Editor.
2. On the Material Editor toolbar, click Get Material to display the Material/Map Browser.

**Maps and mental ray Shaders**

When the [mental ray renderer](#) is active, the Material/Map Browser also lists mental ray shaders. Shaders are similar to maps, but use yellow icons. You assign them the way you do maps. The mental ray shaders don't fit into the map categories described in the previous section, and aren't described in this topic. See [mental ray Shaders](#) for links to shader descriptions.
mental ray maps in the browser’s list are shown with yellow icons.

**TIP** When the default scanline renderer is active, you can view mental ray shaders in the Browser list, and assign them, by turning on Incompatible in the Show group. Incompatible shaders in the list are displayed in gray.

**Maps and Mapping Coordinates**

Maps have a spatial orientation. When you apply a material with maps in it to an object, the object must have mapping coordinates. These are specified in terms of UVW axes local to the object.

Most objects have a Generate Mapping Coordinates toggle. You can turn this on to provide default mapping coordinates. If the object has this toggle, it is also turned on automatically when you render the scene, or use Show Map In Viewport on page 5696.

Some objects, such as editable meshes, don’t have automatic mapping coordinates. For these types of objects, you can assign coordinates by applying a UVW Map modifier on page 1932. If you assign a map that uses a mapping channel, but don’t apply a UVW Map modifier to the object, the renderer displays a warning that lists objects that require mapping coordinates. You can also use UVW Map to change an object’s default mapping.

See Mapping Coordinates on page 5636.
UVW Mapping Coordinate Channels

Each object can have from 1 to 99 UVW mapping coordinate channels. The default mapping (from the Generate Mapping Coordinates toggle) is always UVW 1. The UVW Map modifier can send coordinates to any of these channels.

Each map in a material can use any UVW channel (if present), or other type of mapping that depends on whether the map is 2D or 3D.

You can set the mapping channel used by NURBS surface on page 2454 sub-objects in their creation or modification parameters.

Mapping for 2D Maps

You can position a 2D map on the surface of an object by using a map channel, any assigned vertex color, or the local or world coordinate systems. You can also choose different environment mappings. See Coordinates Rollout (2D) on page 6201.

Mapping for 3D Maps

You can position a 3D map within the volume of an object by using a map channel, any assigned vertex color, or the local or world coordinate systems. See Coordinates Rollout (3D) on page 6278.

Noise for Maps

Random noise values increase the complexity of maps and can give them a more natural look. For 2D maps, see Noise Rollout (2D) on page 6211. For 3D maps, you can assign a separate Noise map. See Noise Map on page 6303.

Real-World Mapping

Real-world mapping is an alternative mapping paradigm in 3ds Max that is off by default. The idea behind real-world mapping is to simplify the correct scaling of texture-mapped materials applied to geometry in the scene. This feature lets you create a material and specify the actual width and height of a 2D texture map in the Material Editor. When you assign that material to an object in the scene, the texture map appears in the scene with correct scaling.

For real-world mapping to work, two requirements must be met. First, the correct style of UV texture coordinates must be assigned to the geometry. Essentially, the size of the UV space needs to correspond to the size of the
geometry. To this end, a new option called Real-World Map Size has been added to many of the dialogs and rollouts that let you generate texture coordinates (see list at the end of this topic). Any dialog or rollout that lets you turn on Generate Mapping Coords also lets you enable Real-World Map Size. Also, you can toggle this option globally on the Preferences dialog > General panel on page 8299.

Most object parameters settings now include a Real-World Map Size toggle.

The second requirement is available in the Material Editor. All 2D texture maps, such as Bitmap, provide a Use Real-World Scale check box on the Coordinates rollout on page 6201. Like Real-World Map Size, this check box is off by default; when on, the U/V parameter names change to Width/Height and the Tiling label changes to Size. You can then specify the horizontal/vertical offsets and size of the texture map in current system units on page 8370.
2D map coordinates settings now include a Use Real-World Scale toggle.

Following is a list of affected features (note links to topics with more extensive information):

- Bevel Modifier
- Bevel Profile Modifier
- Box Primitive
- Capsule Extended Primitive
- C-Ext Extended Primitive
- ChamferBox Extended Primitive Create panel > Geometry button
- ChamferCyl Extended Primitive
- Cone Primitive
- CV Curve
- Cylinder Primitive Create panel
- Doors
- Editable Spline
- Extrude Modifier
- Gengon Extended Primitive
- GeoSphere Primitive
- Importing AutoCAD Drawing
- Importing DXF Files
- Lathe Modifier
- L-Ext Extended Primitive
- L-Type Stair
- Loft > Surface Parameters Rollout
- Material Editor Coordinates Rollout
- Material Editor Options on page 5681
- OilTank Extended Primitive
- Plane Primitive
- Point Curve
- Pyramid Primitive
- Railing
- Renderable Spline Modifier
- Sphere Primitive
- Spindle Extended Primitive
- Spline Rendering File Link Settings
- Splines and Extended Splines
- Stairs
- Sweep Modifier
- Teapot Primitive
- Torus Primitive
- Tube Primitive
- UVW Map Modifier on page 1932
- Wall
Windows

Output Rollout

Material/Map Browser on page 5724
> Choose a map type (Bitmap, Cellular, Falloff, Gradient, Gradient Ramp, Mix, Noise, or Output).
> Double-click the map type to apply it to the active sample slot.
> Output rollout (displayed near the bottom of the Material Editor)

After applying a map and setting its internal parameters, you can adjust its output parameters to determine the rendered appearance of the map.

NOTE Most controls on the Output rollout are for color output, and don’t affect bump mapping on page 6049 except for Invert toggle, reverses the direction of the bumps, and Bump Amount.

Also, the results of the Output rollout settings are visible in the Material Editor, but not in viewports with map display enabled.
These controls appear on the Output rollout for a number of 2D and 3D maps:

**Invert** Reverses the hues of the map, like a negative color photo. Default=off.
**Output Amount** Controls the amount of the map being mixed into a composite material. Affects the saturation and alpha value of the map. Default=1.0.

**Clamp** When on, this parameter limits the values of the colors to no greater than 1.0. Turn this on when you're increasing the RGB Level, but don't want the map to appear self-illuminated. Default=off.

**NOTE** If you set the RGB Offset to a value greater than 1.0 while Clamp is on, all colors become white.

**RGB Offset** Adds to the RGB values of the map colors by the amount set by the spinner, which affects the tonal value of the colors. Eventually the map becomes white and self-illuminated. Lowering the value decreases the tonal value toward black. Default=0.0.

**Alpha from RGB Intensity** When on, an alpha channel is generated based on the intensity of the RGB channels in the map. Black becomes transparent and white becomes opaque. Intermediate values are translucent according to their intensity. Default=off.

**RGB Level** Multiplies the RGB values of the map colors by the amount set by the spinner, which affects the saturation of the color. Eventually the map becomes fully saturated and self-illuminated on page 8714. Lowering the value decreases the saturation and makes the map colors grayer. Default=1.0.

**Enable Color Map** Turn on to use the Color Map. See “Color Map group.” Default=off.

**Bump Amount** Adjusts the amount of bumpiness. This value has an effect only when the map is used as a bump map. Default=1.0.

For example, suppose you have a map instanced for both the Diffuse and the Bump components. If you want to adjust the amount of bumpiness without affecting the Diffuse colors, adjust this value, which changes the amount of bumpiness without affecting the map's use in other material components.

**Color Map group**

The Color Map settings at the bottom of the Output rollout are available only when Enable Color Map is on (see preceding).
The Color Map graph lets you adjust the tonal range of an image. The point at 1,1 controls highlights, the point at 0.5,0.5 controls midtones, and the point at 0,0 controls shadows.

You adjust the shape of the graph by adding points to the line and moving or scaling them. You can add Corner, Bezier-Smooth, or Bezier-Corner points. When a move or scale option is active, points can be selected much like objects in a viewport, by clicking a point, dragging a region around one or more points, and holding down Ctrl to add or subtract from the selection.

When you select an individual point, its exact coordinates are displayed in the two fields below the graph at the lower left. You can enter values directly in these fields, but the values are automatically constrained as they are when you manually move or scale a point.

You can zoom into the graph to make detailed adjustments. As you zoom in, the graph updates to show decimal measurements along the left vertical axis. You can pan anywhere on the graph with the horizontal and vertical scroll bars, use a button option, or the middle mouse button. Points can be deleted, and you can reset the graph to its default at any time.
**RGB/Mono** Specifies a map curve to either filter the RGB channels separately (RGB) or in combination (Mono).

**Copy CurvePoints** When turned on, points added to a Mono graph are copied when you switch to an RGB graph. If you start with an RGB graph, the points are copied to a Mono graph. You can animate the control points but not the Bezier handles.

**IMPORTANT** When Copy CurvePoints is on, animation created in Mono mode is carried over to RGB mode and you can switch channels. The reverse doesn’t work.

The following controls affect the points on the graph:

**Move flyout**

Moves a selected point in any direction, limited by the unselected points on either side.

Constrains movement to the horizontal.

Constrains movement to the vertical.

On a Bezier smooth point, you can move the point or either handle.

**Scale Point** Changes the output amount of control points while maintaining their relative position. On a Bezier corner point, this control is effectively the same as a vertical move. On a Bezier smooth point, you can scale the point itself or either handle. As with the move controls, scale is limited by the unselected points on either side.

**Add Point flyout**

Adds a Bezier corner point anywhere on the graph line. The point makes a sharp angle when moved.

Adds a Bezier smooth point anywhere on the graph line. Handles attached to the point create smooth curves when moved.
When either Add Point button is active, you can use Ctrl+click to create the other type of point. This eliminates the need to switch between buttons.

- **Delete Point** Removes selected points.

- **Reset Curves** Returns graph to its default, a straight line between 0,0 and 1,1.

The following controls affect the view of the graph. The change in view does not affect the graph’s results.

- **Pan** Drags the graph in any direction within the viewing window.

- **Zoom Extents** Shows the entire graph.

- **Zoom Horizontal Extents** Shows the entire horizontal range of the graph. The scale of the curve will be distorted.

- **Zoom Vertical Extents** Shows the entire vertical range of the graph. The scale of the curve will be distorted.

- **Zoom Horizontally** Compresses or expands the graph in a horizontal direction.

- **Zoom Vertically** Compresses or expands the view of the graph in a vertical direction.

- **Zoom** Zooms in or out around the cursor.

- **Zoom Region** Draws a rectangular region around any area of the graph, then zooms to that view.
Missing Map Coordinates Dialog

Material Editor > Assign a mapped material to an object that has no UVW Map modifier. > Map level > Coordinates rollout > Change Map Channel to a value other than 1. > Render

Application menu on page 7989 > Open > Open a MAX scene. > One or more maps in the MAX file can’t be found.

Quick Access toolbar on page 7995 > Click the Open button. > Open a MAX scene. > One or more maps in the MAX file can’t be found.

The Missing Map Coordinates dialog is displayed when you attempt to render one or more objects with materials whose maps use a map channel on page 8627 other than channel 1. (Channel 1 is an exception because channel 1 mapping coordinates are automatically turned on when you assign a mapped material to an object.) Only maps with Show Map In Viewport toggled on are listed as missing.

To use other map channels, you must assign a UVW Map modifier on page 1932 to the object. In UVW Map, set Map Channel to match the value used in the material.

If the material has multiple maps that use multiple channels, you must assign a separate UVW Map modifier for each channel besides channel 1.

If the object is a NURBS surface sub-object on page 2603, you don't need to use UVW Map. Instead, set the map channel on the surface sub-object's Material Properties rollout on page 2544.

The Missing Map Coordinates dialog is also displayed when you open a MAX file that references bitmaps that can’t be found in their original location, or are at a location not specified via the Configure User Paths dialog on page 8284. To open the MAX file, click the Browse button on the Missing Map Coordinates dialog. This opens the Configure User Paths dialog so you can assign one or more paths for the MAX file to access. These settings are then stored with the MAX file.

NOTE When you open a MAX file that references bitmaps that can’t be found, you might also see a Missing Map/Photometric Files dialog on page 7612, which lets you browse for the missing files.
The list shows the map channel followed by the name of the object.

**Continue** Proceeds with the rendering. The objects listed will not show maps in the material assigned to them, and might not be visible at all.

**Cancel** Cancels rendering.
UVW Remove Utility

Utilities panel > Utilities rollout > More button > Utilities dialog > UVW Remove

The UVW Remove utility removes mapping coordinates or materials from the currently selected objects.

Interface

<table>
<thead>
<tr>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Removes mapping and / or materials from selected nodes</td>
</tr>
<tr>
<td>1 Object(s) Selected</td>
</tr>
</tbody>
</table>

Remove:

- UVW
- Material

Set Gray

NOTE The utility can remove UVW mapping only from collapsed editable mesh objects; that is, editable meshes with no modifiers.

Materials Click to remove material assignment from the selected objects.

Set Gray If this is on when you click the Materials button, the object color is set to a neutral gray. Default=off.

2D Maps

2D Maps are two-dimensional images that are typically mapped onto the surface of geometric objects, or used as environment maps to create a background for the scene. The simplest 2D maps are bitmaps; other kinds of 2D maps are generated procedurally.
Coordinates Rollout (2D)

Material Editor > Select sample slot. > Get Material > Material/Map Browser >
Turn on 2D Maps. > Double-click a map type to apply it to sample slot. >
Coordinates rollout is displayed on the Material Editor.

In the Coordinates rollout, by adjusting coordinate parameters, you can move
a map relative to the surface of the object to which it is applied and achieve
other effects.

Tiling

Often when you apply a bitmap, especially as a texture pattern, you want the
pattern to repeat. This effect is known as tiling, as in a tiled floor or fountain.
You control tiling directly from the Coordinates rollout for any 2D map.

In default mapping, tiling is active, but because the map is scaled to fit the
object, you don't see the effect of tiling unless you offset the UV coordinates
or rotate the map. In this case, the portions of the surface from which the
bitmap has moved away are filled by other portions of the map. Tiling wraps
the object with the map image.
**Mirroring**

Mirroring a map is an effect related to tiling. It repeats the map and flips the repeated copy.

As with tiling, you can mirror in the U dimension, the V dimension, or both. The Tiling parameter for each dimension specifies how many copies of the map are shown. Each copy is flipped relative to its neighbors.

![Mirroring a map](image)

**Tiling and Mirroring Combined**

Because mirroring defaults to two reflected images of the map, the meaning of the Tiling value differs when Mirror is set.

In a single mapping dimension (U or V), a value of 1.0, the default, shows two copies of the bitmap; a value of 2.0 shows four copies; a value of 1.5 shows three copies; and so on. Mirroring in both dimensions multiplies the effect.

![Mirroring and Tiling Combined](image)
Decals

Decals are useful for mapping single designs, small elements such as stickers, or light switches.

A 2D map used as a decal appears only once and is not repeated as with tiling. Wherever the decal doesn’t appear on the surface, the surface is rendered as a basic material, with the component colors specified at the material level. With map trees, a decal might appear on top of a different bitmap or other map type.
Decal mapping

**Procedures**

To set tiling:

1. In the Coordinates rollout, make sure Use Real-World Scale is turned off and Tile is turned on for the U or V coordinate, or for both.

2. In the Coordinates rollout, make sure Tile is turned on for the U or V coordinate, or for both.

3. Set the Tiling value for the corresponding coordinates.
   In the Material Editor, the sample slot changes to show the tiling value you chose.

- The Tiling value is the number of times the bitmap repeats along the specified dimension. A value of 1.0, the default, maps the bitmap exactly once; a value of 2.0 maps the bitmap twice, and so on. Fractional values map a fractional portion of the bitmap in addition to copies of the whole map. For example, a value of 2.5 maps the bitmap two and a half times.

- Tiling values less than one increase the size of the map relative to the object. For example, a value of 0.5 maps half of the bitmap.

- Tiling is uniform if both the U and V dimensions are tiled by the same amount.
To preview the effect of tiling:

- In the Material Editor, use the Tiling flyout to choose a 1x, 2x, 3x, or 4x tiling preview. The button you choose changes tiling in the active sample slot to 1.0, 2.0, 3.0, or 4.0 in both U and V. The flyout setting has no effect on the material or its mapping. It does not change the Tiling value or the check box setting. It only helps you preview the effect of changing these settings.

To set mirroring:

1. On the Coordinates rollout, make sure Mirror is turned on for the U or V coordinate, or both. Mirror and Tile are exclusive settings: if one is set when you choose the other, the original setting turns off.

2. Set the Mirror value for the corresponding coordinate or coordinates. The material preview changes to show the Mirror value you chose.

To create a decal:

1. In the Material Editor, choose a bitmap as a diffuse map.

2. On the map's Coordinates rollout, turn off both Mirror and Tile for both the U and V coordinates. Change the mapping to Planar From Object XYZ.

3. Adjust the X and Y Tiling parameters to scale the decal. Changing the Tiling value changes the size of the mapped bitmap as it does when you tile the map, but with Mirror and Tile turned off, the bitmap appears only once.

4. Adjust the X and Y Offset parameters to position the decal.

**NOTE** You can also use the Parameters rollout's Cropping and Placement controls to achieve a decal effect.

To offset the position of a map:

1. In the Coordinates rollout, make sure Use Real-World Scale is turned on.
2 On the Coordinates rollout, set the U and V values to be between 0.0 and 100, or between -100 and 0.0.

3 Set the Offset Width and Height values to be between 0.0 and 100, or between -100 and 0.0.

On the surface of the object, the map shifts in the directions you chose. UV offsets are especially useful when you have turned tiling off and want the bitmap to appear in a single location.

To rotate the map:
- On the Coordinates rollout, set the Angle U, V, and W spinners.
  Positive angles rotate the map in the clockwise direction; negative angles rotate it counterclockwise.
  The angle can be up to 360 degrees, which rotates the map completely and has no visible effect unless you are animating the map's rotation.
  You can also click Rotate to use the Rotate Mapping Coordinates dialog, which lets you change the rotation by dragging the mouse.

To increase or decrease antialiasing:
- On the map's Coordinates rollout, increase or decrease the Blur value.
  For diffuse maps and other maps besides bump maps, the Blur value is most effective in the 0.5-20 range. Lower values decrease antialiasing; higher values increase it.
  The Blur Offset parameter adjusts the image before antialiasing Blur is applied. If all you need is antialiasing, leave Blur Offset at its default of 0.0.

To make a map image fuzzier:
- On the map's Coordinates rollout, increase the Blur Offset value.
  Blur Offset is a very strong parameter. The Blur Offset spinner has increments of 0.001 Values greater than 0.1 are likely to be too high.

To make a map image sharper:
- On the map's Coordinates rollout, decrease the Blur Offset value to a value below 0.0.
  The negative Blur Offset value sharpens the image.
Interface

These controls appear on the Coordinates rollout for many 2D maps:

**Mapping Type** Base your choice on how you're using the map: applied to an object surface, or to the environment:

- **Texture** Applies the map as a texture on page 8741 to a surface. Select the type of coordinates from the Mapping list.

- **Environ** Uses the map as an environment map on page 8561. Select the type of coordinates from the Mapping list.

**Mapping** List entries vary depending on choice of Texture or Environ mapping:

- **Explicit Map Channel** Uses any map channel. When selected, the Map Channel field becomes active, and you can choose any channel from 1 to 99.

- **Vertex Color Channel** Uses assigned vertex colors as a channel. See Editable Mesh on page 2192 for details on assigning vertex color. See also Vertex Color Map on page 6355 and Assign Vertex Colors Utility on page 6477.

- **Planar from Object XYZ** Uses planar mapping based on the object's local coordinates (disregarding the pivot point location). For rendering purposes, planar mapping doesn't project through to the back of the object unless you turn on Show Map On Back.
Planar from World XYZ  Uses planar mapping based on the scene’s world coordinates (disregarding the object’s bounding box). For rendering purposes, planar mapping doesn't project through to the back of the object unless you turn on Show Map On Back.

Spherical Environment/Cylindrical Environment/Shrink-wrap Environment  Projects the map into the scene as though it were mapped to an invisible object in the background. See Environment Map on page 8561.

Screen  Projects as a flat backdrop in the scene.

Show Map on Back  When on, planar mapping (Planar from Object XYZ, or with the UVW Map modifier) projects through to render on the back of the object. When off, planar mapping doesn't render on the object's back. Default=on.

This toggle is available only when Tiling is off in both dimensions. Its effect is visible only when you render the scene.

NOTE  In viewports, planar mapping always projects to the back of the object, whether Show Map On Back is turned on or not. To override this, turn off Tiling.

Use Real-World Scale  When turned on, applies the map to objects using the real-world Width and Height values instead of UV values. Default=off.

When Real-World Scale is on, the texture placement is relative to the corner of the texture map so alignment with architectural objects like walls is more efficient. When off, the texture placement is relative to the center of the texture map.

Offset  Changes the position of the map in UV coordinates on page 8754. The map moves in relation to its size. For example, if you want to shift the map its full width to the left, and half its width downward from its original position, you enter -1 in the U Offset field and 0.5 in the V offset field.

UV/VW/WU  Changes the mapping coordinate on page 8628 system used for the map. The default UV coordinates project the map onto the surface like a slide projector. The VW and WU coordinates rotate the map so that it is perpendicular to the surface.

Tiling  Determines the number of times the map is tiled on page 8742 (repeated) along each axis.
**Mirror** Mirrors on page 8742 the map left-to-right (U axis) and/or top-to-bottom (V axis).

**Tile** Turns tiling on or off in the U or V axis.

**When Use Real-World Scale Is Off**

![Coordinates](image)

**Offset** (UV) Changes the position of the map in UV coordinates on page 8754. The map moves in relation to its size. For example, if you want to shift the map its full width to the left, and half its width downward from its original position, you enter -1 in the U Offset field and 0.5 in the V offset field.

**UV/VW/WU** Changes the mapping coordinate on page 8628 system used for the map. The default UV coordinates project the map onto the surface like a slide projector. The VW and WU coordinates rotate the map so that it is perpendicular to the surface.

**Tiling** Determines the number of times the map is tiled on page 8742 (repeated) along each axis.

**Mirror** Mirrors on page 8742 the map left-to-right (U axis) and/or top-to-bottom (V axis).

**Tile** Turns tiling on or off in the U or V axis.
When Use Real-World Scale Is On

Offset (Width/Height) Move the map horizontally or vertically along the width or height of the object to which the material is applied. The offset distance is relative to the lower-left corner of the map.

UV/VW/WU Changes the mapping coordinate on page 8628 system used for the map. The default UV coordinates project the map onto the surface like a slide projector. The VW and WU coordinates rotate the map so that it is perpendicular to the surface.

Size Determines the real world width and height of the map.

For example, if you scan a piece of marble that is 12” x 8” and then assign this image as the Diffuse Map, you can type 12” (or 1’) and 8” as the Width and Height. This ensures that the scale of the marble is correct in the rendered scene.

NOTE The default setting for the texture size can be set using the Default Texture Size option in the Material Editor Options Dialog on page 5681.

Mirror Mirrors on page 8742 the map horizontally and/or vertically.

Tile Turns horizontal and/or vertical tiling on or off.
NOTE If the Use Real-World Size switch is turned off in the Material Editor, the Real-World Map Size settings in modifiers like UVW Map or for primitives like Box will not work. Likewise, moving vertices at a sub-object level or scaling an object, in general, will not honor the Use Real-World Scale settings.

---

**Angle U/V/W** Rotates the map about the U, V, or W axis (in degrees).

**NOTE** When using the Environ mapping type, you can rotate the map only on the W axis. Rotating on the U or V axis has no effect.

**Rotate** Displays a schematic Rotate Mapping Coordinates dialog that lets you rotate the map by dragging on an arcball diagram (similar to the arcball used to rotate viewports, although dragging inside the circle rotates along all three axes, and dragging outside it rotates about the W axis only). The Angle UVW values change as you drag in the dialog.

**Blur** Affects the sharpness or blurriness of the map based on its distance from the view. The farther away the map is, the greater the blurring. The Blur value blurs maps in world space. Blur is primarily used to avoid aliasing on page 8501.

**Blur Offset** Affects the sharpness or blurriness of the map without regard to its distance from the view. Blur Offset blurs the image itself in object space. Use this option when you want to soften or defocus the details in a map to achieve the effect of a blurred image.

See [Blur/Blur Offset](#) on page 8525.

### Noise Rollout (2D)

Material Editor > Select sample slot. > Get Material > Material/Map Browser > Turn on 2D Maps. > Select a map type. > Drag map from Browser thumbnail to sample slot. > Noise rollout is displayed in the Material Editor.

You can add a random noise to the appearance of your material. Noise perturbs the UV mapping of pixels by applying a fractal noise function.

Noise patterns can be very complex and are a versatile way to create apparently random patterns. They are also good for simulating surfaces found in nature, as is characteristic of fractal images.

Noise parameters interact closely with each other. Slight variations in each can create noticeably different effects.
NOTE  Noise settings aren’t displayed in viewports.

Above: A checker map and a bitmap
Below: The same maps with noise applied

Procedures

To add noise to a material:

1. In the Noise rollout, select On.
2. Adjust the three noise parameters to get an effect you like.

To remove noise from a material:

■ In the Noise rollout, turn off On.
  Noise is no longer applied to the map.

To animate the noise effect:

1. Turn on the Auto Key button.
2 Move to a non-zero frame.

3 In the Noise rollout, turn on Animate.

   By default, animation keys are set at either end of the active frame range.

4 Change the Phase value at different keyframes.

Interface

These controls appear on the Noise rollout for many 2D maps:

**On** Determines whether the Noise parameters affect the map.

**Amount** Sets the strength of the fractal function, expressed as a percentage. If the amount is 0 there is no noise. If the amount is 100 the map becomes pure noise. Default=1.0.

**Levels** Or iterations: the number of times the function is applied. The effect of the level is dependent on the Amount value. The stronger the amount, the greater the effect of increasing the Levels value. Range=1 to 10; Default=1.

**Size** Sets the scale of the noise function relative to geometry. At very small values, the noise effect becomes white noise. At large values, the scale can exceed the scale of the geometry, in which case it has little or no effect. Range=0.001 to 100; Default=1.0.

**Animate** Determines whether animation is on the noise effect. This parameter must be turned on if you intend to animate the noise.

**Phase** Controls the speed of the animation of the noise function.

**Bitmap 2D Map**

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser > Bitmap
A **bitmap** is an image produced by a fixed matrix of colored pixels, like a mosaic. Bitmaps are useful for creating many kinds of materials, from wood grains and wall surfaces to skin and feathers. You can also use an animation or video file instead of a bitmap to create an animated material.

When you assign the Bitmap map, the Select Bitmap Image File dialog on page 6222 opens automatically. Use this dialog to specify a file or sequence as the bitmap image.

The Bitmap map can synchronize the frames of a bitmap sequence to the age of particles to which the map is applied. With this effect, each particle displays the sequence from the start when it is born, rather than being assigned whichever frame is current. This is achieved by turning on the Sync Frames To Particle Age check box on page 5709. Also, when using Particle Flow, assign the material containing the Bitmap map to a Material Dynamic operator. For more details and a procedure, see Material Dynamic Operator on page 3168.

**NOTE** To save loading time, if a map with the same name is in two different locations (in two different paths), it is loaded only once. This poses a problem only if your scene includes two maps that have different content but the same name. In this case, only the first map encountered will appear in the scene.
**Supported File Types**

The Material Editor supports the following file formats:

- **AVI files** on page 7832
- **BMP files** on page 7834
- **CIN files (Kodak Cineon)** on page 7834
- **DDS files** on page 7836
- **GIF files** on page 7841
- **HDRI files** on page 7866 (.hdr and .pic files)
- **IFL files** on page 7841
- **JPEG files** on page 7848
- **MOV files (QuickTime Movies)** on page 7849
- **MPEG files** on page 7850
- **OpenEXR files** on page 7850
- **PNG files** on page 7862
- **PSD files** on page 7863
- **RGB files (legacy SGI format)** on page 7877
- **RLA files** on page 7873
- **RPF files** on page 7875
- **SGI Image File for Flight Studio (RGB, RGBA, ATTR, INT, and INTA files)** on page 7719
- **TGA files (Targa)** on page 7878
- **TIFF files** on page 7880
- **YUV files** on page 7882

**NOTE** If your scene includes animated bitmaps with materials, projector lights, or environments, the animation file is reloaded once per frame. If your scene uses multiple animations, or if the animations are large files, rendering will be slower.

See also:

- **Coordinates Rollout (2D)** on page 6201
Procedures

To crop an image:

1. On the Bitmap Parameters rollout, click the Bitmap button and assign a bitmap.
2. In the Cropping/Placement group, turn on Apply to see the results of cropping in the sample slot (and in shaded viewports if Show Map In Viewport is active).
3. Turn on Crop.
4. Click View Image to display the bitmap.
   A frame window appears, displaying the image surrounded by a region outline (a dashed line at the outer edges of the image, with handles on the sides and corners).
5. Specify a cropping region by adjusting the spinners at the top of the window, or by dragging the region outline.

To place an image:

1. On the Bitmap Parameters rollout, click the Bitmap button and assign a bitmap.
2. In the Cropping/Placement group, turn on Apply to see the results of cropping in the sample slot (and in shaded viewports if Show Map In Viewport is active).
3. Turn on Place.
4. Click View Image.
   A frame window appears, displaying the image surrounded by a region outline (a dashed line at the outer edges of the image, with handles on the sides and corners).
5. Move the image by adjusting the spinners at the top of the window, or by dragging the region outline.
   The reduced image "decals" on the sample sphere. The diffuse color is visible around the image.
To use the alpha channel that is part of the bitmap:

1. On the Maps rollout, assign the map to the Opacity component.
   (You can assign a copy or instance of this map to other components, such as Diffuse, as well.)

2. Click the map button for the Opacity component.
   This lets you adjust the settings for the Opacity map.

3. In the Bitmap Parameters rollout > Alpha Source group, choose Image Alpha.
   This option is not available if the bitmap does not have an alpha channel.

4. In the Bitmap Parameters rollout > Mono Channel Output group, choose Alpha.
   This option is not available if the bitmap does not have an alpha channel.
   The bitmapped material will now have the transparency specified by the alpha channel. This will appear in renderings. Transparency does not appear in viewports or ActiveShade renderings.

To create an alpha channel based on intensity:

- In Bitmap Parameters rollout > Alpha Source group, turn on RGB Intensity.
  3ds Max creates an alpha channel. Full-intensity areas of the image are opaque, zero-intensity areas are transparent, and intermediate colors become partially transparent.

To use a completely opaque bitmap:

- In Bitmap Parameters rollout > Alpha Source group, turn on None (opaque).
  3ds Max ignores the bitmap's alpha channel, if present, and does not create a new one.
Interface

Bitmap Parameters rollout

![(Bitmap Parameters rollout diagram)](image)

**Bitmap** Selects the bitmap using the standard file browser. After selection, the full path name appears on this button.

**Reload** Reloads the bitmap file using the same name and path. You don’t need to use the file browser to reload the bitmap after you’ve updated it in your paint program.

Clicking reload for any instance of the map updates the map in all sample slots and in the scene.

**Filtering group**

*Filtering* on page 8574 options let you select the method of pixel averaging used in *antialiasing* on page 8501 the bitmap.
Pyramidal Requires less memory and is adequate for most purposes.

Summed Area Requires much more memory, but yields generally superior results.

None Turns off filtering.

Mono Channel Output group

Some parameters, such as opacity or specular level are a single value as opposed to a material's three-value color components. Controls in this group determine the source of the Output mono channel in terms of the input bitmap.

RGB Intensity Uses the intensity of the red, green, and blue channels for mapping. The color of the pixels is ignored and only the value or luminance of the pixels is used. The colors are computed as gray values in the range between 0 (black) and 255 (white).

Alpha Uses the intensity of the alpha channel on page 8502 for mapping.

RGB Channel Output group

The RGB Channel Output determines where the output RGB part comes from. The controls in this group affect only maps for material components that display color: Ambient, Diffuse, Specular, Filter Color, Reflection, and Refraction.

RGB Displays the full color values of the pixels. (Default)

Alpha as Gray Displays tones of gray based on the levels of the alpha channel.

Cropping/Placement group

The controls in this group let you crop the bitmap or reduce its size for custom placement. Cropping a bitmap means to reduce it to a smaller rectangular area than it originally had. Cropping doesn't change the scale of the bitmap.

Placing a bitmap lets you scale the map and place it anywhere within its tile. Placing can change the bitmap's scale, but shows the entire bitmap. The four values that specify the placement and size of the cropping or placement region are all animatable.

Cropping and placement settings affect the bitmap only as it's used for this map and any instances of the map. They have no effect on the bitmap file itself.

Apply Turn on to use the cropping or placements settings.
**View Image** Opens a window that shows the bitmap surrounded by a region outline with handles at its sides and corners. To change the size of the crop area, drag the handles. To move the region, position the mouse cursor inside it and drag.

To see the results of editing the region, turn on Apply (see preceding). This shows changes in the region as you make them.

The bitmap window has U/V and W/H (width/height) controls on its toolbar. Use these to adjust the location and size of the image or crop area.

When Place is chosen, dragging the region area handles changes the scale of the bitmap (hold down Ctrl to preserve the bitmap's aspect ratio), and dragging the image changes its location within the tile area.

The UV/XY button at the right of the window toolbar lets you switch between using UV or XY coordinates in the toolbar spinners (Default=UV).

**Crop** Makes cropping active.

**Place** Makes placement active.

**U/V** Adjusts the bitmap location.

**W/H** Adjusts the width and height of the bitmap or crop area.

**Jitter Placement** Specifies the amount of random offset. At 0, there is no random offset. Range = 0.0 to 1.0

When Place is turned on, the size and position specified by the spinners or editing window are ignored. 3ds Max then chooses a random size and tile position for the image.

**Alpha Source group**

Controls in this group determine the source of the Output alpha channel in terms of the input bitmap.

**Image Alpha** Uses the image's alpha channel (disabled if the image has no alpha channel).

**RGB Intensity** Converts the colors in the bitmap to grayscale tonal values and uses them for transparency. Black is transparent and white is opaque.

**None (Opaque)** Does not use transparency.

**Premultiplied Alpha** Determines how alpha is treated in the bitmap. When turned on, the default, **premultiplied alpha** on page 8690 is expected in the file. When turned off, the alpha is treated as non-premultiplied, and any RGB values are ignored.
TIP If you apply an alpha image as a Diffuse map, for example, and it doesn't
deal correctly, the bitmap file probably contains non-premultiplied alpha; the
RGB values are maintained separately from the alpha values. To correct this, turn
off Premultiplied Alpha.

Time rollout

These controls let you change the start time and speed of animation (AVI on
page 7832 or MOV on page 7849) files used as animated texture maps. They make
it easier to use sequences of images as maps in scenes, because you can control
the timing very precisely

Start Frame Specifies the frame where the playback of the animated map will
begin.

Playback Rate Lets you speed up and slow down the rate that the animation
is applied to the map (for example, 1.0 is normal speed, 2.0 is twice as fast,
.333 is 1/3 as fast).

Sync Frames to Particle Age When on, 3ds Max synchronizes the frames of
a bitmap sequence to the age of particles to which the map is applied. With
this effect, each particle displays the sequence from the start when it is born,
rather than being assigned whichever frame is current. Default=off.
When using Particle Flow, assign the material containing the Bitmap map to
a Material Dynamic operator. For more details and a procedure, see Material
Dynamic Operator on page 3168.

NOTE This functionality is not supported by the mental ray renderer.
**End Condition group**

Determines what happens after the last frame of the bitmap animation if the animation is shorter than the scene.

**Loop** Causes the animation to repeat over and over again from the beginning.

**Ping-Pong** Causes the animation to be played forward and then backward repeatedly, making every animated sequence "loop smoothly."

**Hold** Freezes on the last frame of the bitmap animation.

---

**Select Bitmap Image File Dialog**

Material Editor > Maps Rollout > Click any map selector button. > Material/Map Browser > Double-click Bitmap. > Select Bitmap Image.

Material Editor > Bitmap map > Bitmap Parameters rollout > Bitmap button

The Select Bitmap Image dialog allows you to choose a file or sequence of files for a map. If a sequence of files is selected by turning on Sequence, the *Image File List Control dialog on page 7844* is opened when you click Setup or Open.

**Procedures**

**To select a bitmap image for a map:**

1. In the Material Editor, open the Maps rollout.
2. Click any button in the Map column.
   
   This adds a map into the channel you've selected. For example, clicking in the Map column of the Diffuse channel creates a diffuse or texture map.
   
   The Material Map Browser is displayed.
3. In the Material/Map Browser, double-click Bitmap.
   
   The Select Bitmap Image dialog is displayed.
4. In the Select Bitmap Image dialog, navigate the Look In field to select the appropriate directory.

**NOTE** The Select Bitmap Image File dialog uses the last location where a bitmap was chosen, rather than the default bitmap path defined in Customize > Configure User Paths.
5 Highlight the file name in the file list window.

6 Click Open to close the dialog.

**To select a set of still images as a bitmap sequence:**

1 In the Material Editor, open the Maps rollout.

2 Click any button in the Map column.
   This adds a map into the channel you’ve selected. For example, clicking in the Map column of the Diffuse channel creates a diffuse or texture map.
   The Material Map Browser is displayed.

3 In the Material/Map Browser, double-click Bitmap.
   The Select Bitmap Image dialog is displayed.

4 In the Select Bitmap Image dialog, navigate the Look in field to select the directory containing the sequence of files.

5 If necessary, change file type to match the file extension of the sequence, or choose All Formats.

6 Turn on Sequence, and choose the name of the first sequential file.

7 Click the Setup button.
   The Image File List Control Dialog opens.

8 Click the Browse button and set the Target path to a writable directory on your hard disk. Do not set the path to a CD-ROM drive.

9 Choose the options you want and click OK.
   The IFL file is written to the target directory.

**Interface**

**TIP** You can resize the dialog by dragging an edge or a corner.
**History** Displays a list of the most recent directories searched. Whenever an image is selected, the path used is added to the top of the history list as the most recently used path. The history information is saved in the `3dsmax.ini` file.

**Look In** Opens a navigation window to browse other directories or drives.

**Up One Level** Moves you up a level in the directory structure.

**Create New Folder** Lets you create a new folder while in this dialog.
**List** Displays the contents of a directory without the details.

**Details** Displays the contents of a directory with all the details.

**List Window** When details are turned on, the contents of the directory are displayed with Name, Size, Type, Date Modified, and Attributes. You can sort based on each of these columns by clicking the column label.

**File Name** Displays the file name of the file selected in the list.

**Files of Type** Displays all the file types that can be displayed. This serves as a filter for the list.

**Open** Selects the highlighted file and closes the dialog.

**Cancel** Cancels the selection and closes the dialog.

**Devices** Lets you choose the hardware output device, for example, a digital video recorder. The device, its driver, and its 3ds Max plug-in must all be installed on your system to use the device.

**Setup** When Sequence is turned on, and there are sequential files in the directory displayed, this Setup displays an Image File List Control dialog on page 7844 to create an IFL file.

**Info** Displays expanded information about the file, such as frame rate, compression quality, file size, and resolution. The information here depends on the type of information that is saved with the file type.

**View** Displays the file at its actual resolution. If the file is a movie, the Media Player is opened so the file can be played.

**Gamma Group**

These controls are available only when Preferences dialog > Gamma and LUT panel on page 8330 > Enable Gamma/LUT Correction is on.

**IMPORTANT** When combining standard (low-dynamic-range) and high-dynamic-range images in the same scene, make sure to treat each image’s gamma correctly. For more information, see Gamma Pipeline on page 8341.

**Gamma** Specifies how to handle gamma with the bitmap image.

- **Use image’s own gamma** Uses the gamma of the incoming bitmap.
Use system default gamma  Replaces the image gamma with the system default gamma, as set on the Gamma and LUT panel on page 8330 of the Preferences dialog.

Override  Defines a new gamma for the bitmap that is neither the image's own, nor the system default.

NOTE  In general, it is less confusing to use the system default gamma for incoming bitmaps. But if you are using bitmaps created (or edited) by a variety of other programs, and need to adjust gamma differently for each program, then use Override.

Sequence  Creates an "Image File List " using the given information. Note that each time an image is selected, an evaluation is done to see if an IFL sequence can be created. If the selected image does not yield a list, this option box is unavailable. In the past, it was necessary to enter a wild card in order to create a list. Now it is possible to use wild card to filter files in the file selector.

Preview  Displays the image as a thumbnail in the image window.

Image Window  Displays a thumbnail of the selected file.

If gamma correction or look-up table (LUT) correction on page 8330 is active, 3ds Max applies the correction to this thumbnail image.

Statistics  Displays the resolution, color depth, image type, and number of frames of the selected file.

The image type description has changed in Autodesk 3ds Max 2010 to be more readable. For example, a full-color image with an alpha channel will show “RGBA Color 16 Bits/Channel”; a bitmap with a limited color depth might show “Indexed Color 8 Bits/Pixel,” and so on.

Location  Displays the full path for the file. With this information at the bottom of the dialog, you always know exactly where you are.
Checker Map

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser > Checker

The Checker map applies a two-color checkerboard pattern to the material. The default checker map is a pattern of black and white squares. Checker maps are 2D procedural maps. The component checkers can be either colors or maps.

![Checker map example](image)

Checker map used for the tablecloth and (in a composite) for the floor of the ice-cream shop

**TIP** Turning on Noise for a Checker map can be an effective way to create irregular patterns with a natural appearance.

See also:

- Coordinates Rollout (2D) on page 6201
- Noise Rollout (2D) on page 6211
Procedures

To create a Checker map:

1. Click a map button to assign a map.
2. Choose Checker in the Material/Map browser, and then click OK.

To change the color of one set of squares:

1. In the Checker Parameters rollout, click a color swatch to display the Color Selector on page 371.
2. Adjust the color.
3. Click Close.

To use a map for one set of squares:

- In the Checker Parameters rollout, click a map button to assign a map to a color.

To soften the edge between the two checker colors:

- In the Checker Parameters rollout, increase the value of Soften. When Soften equals 0.0, there is a hard edge between the checker colors. Low positive values soften or blur the checker boundary. Larger Soften values can blur the entire material.

To swap the two checker components:

- In the Checker Parameters rollout, click Swap.

Interface
Soften Blurs the edges between the checkers. A little blurs a lot.

Swap Switches the position of the two checkers.

Color #1 Sets the color of one of the checkers. Click to display the Color Selector on page 371.

Color #2 Sets the color of one of the checkers. Click to display the Color Selector on page 371.

Maps Selects a map to use within the area of the checker color. For example, you could put an additional checkerboard within one of the checker colors. The check boxes enable or disable their associated map.

**Combustion Map**

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser > Combustion

With the Combustion map, you can create maps interactively using the Autodesk Combustion software and 3ds Max at the same time. As you use Combustion to paint on a bitmap, the material updates automatically in the Material Editor and in shaded viewports.

**IMPORTANT** The Combustion map works only if Autodesk Combustion is installed on your system.

Only Combustion 2.1 and later formats are supported. Maps in the Combustion 1 format are not supported in 3ds Max.

**IMPORTANT** The mental ray renderer on page 6675 does not support the Combustion map.

See also:

- CWS (Combustion Workspace) Files on page 7835
- Noise Rollout (2D) on page 6211

**About the 3ds Max and Combustion Integration**

You can use Combustion as a material map in 3ds Max. With a Combustion map, you can create a material from a Paint or composite operator, and in
turn apply that material to objects in a 3ds Max scene. The Combustion map can include Combustion effects, and it can be animated.

In addition, with Combustion you can import 3ds Max scenes that have been rendered to a rich pixel file on page 7875 (RPF on page 7875 or RLA on page 7873 file). The imported rich pixel rendering becomes an element of your composite. You can adjust its 3D position relative to video elements of the composite, and you can apply Combustion 3D Post effects to objects within it. See the Combustion User’s Guide for more information.

**NOTE** Because 3ds Max runs only on Windows, you cannot use Combustion to create material maps on a Macintosh.

### 3ds Max Materials and the Combustion Map

In 3ds Max, a material on page 8635 is data that you assign to the surface or faces of an object so that it appears a certain way when rendered. Materials affect the color of objects, their shininess, their opacity, and so on.

The Material Editor on page 5641 is the portion of 3ds Max that creates and manages materials. In the Material Editor, you can assign maps to a material's color components and to its numeric components such as opacity. Maps add images, patterns, color adjustments, and other effects to the visual properties of the material.

In the 3ds Max Material Editor, you assign a map by clicking the map button for a component color or other component. This displays the Material/Map Browser, which lets you choose the map type.

3ds Max provides several types of maps on page 8631. The most basic is a 2D map, a two-dimensional image that is typically mapped onto the surface of geometric objects.

Other uses of 2D maps are as environments to create a background for the scene, as projections from lights, and as displacements to "emboss" geometry.

A Combustion map is a 2D map on page 6200. It is a Combustion project used by the 3ds Max Material Editor, so like any Combustion project, it is vector-based, animatable, and fully editable. From within the Material Editor, you can have Combustion create a new project from scratch, or use an existing composite or Paint branch. You can synchronize the Combustion Timeline with the 3ds Max time slider so animated materials synchronize with your 3D scene.

With a Combustion map, you can paint in either program: that is, you can paint either in the Combustion viewport or on 3ds Max objects. Both programs
update the paint display. You also have the option of using Combustion to paint on an "unwrapped" projection of 3ds Max object geometry.

In addition, with Combustion effects that require you to pick a point, such as Lens Flare or Ripple, you can use either program, Combustion or 3ds Max, to pick the point.

**Tips for Working with a Combustion Map in 3ds Max**

- If you have a dual-screen configuration, you can set it up so you can see both the 3ds Max and the Combustion windows at the same time. Otherwise, you need to use Alt+Tab to switch between the two windows.

- To work with Combustion, the 3ds Max object must have mapping coordinates on page 8628. Primitive objects have a Generate Mapping Coordinates toggle, which is automatically enabled when you assign a mapped material to the object. Some objects, such as editable meshes, do not have a Generate Mapping Coordinates toggle. For these kinds of objects, go to the Modify panel and apply a UVW Map modifier on page 1932.

- Sometimes it can be hard to see how the Combustion operator is oriented to the 3ds Max object's mapping coordinates. It can help to paint some temporary strokes in Combustion to see how they are aligned in 3ds Max viewports. Displaying the mapping coordinates in Combustion can help. See the procedure, "To display an unwrapped mesh." on page 6234 It can also help to paint directly on the object in a 3ds Max viewport. See the procedure, "To paint directly on the 3D object." on page 6236

**Procedures**

**To create a new Combustion map:**

1. Open the Material Editor.

2. Drag an unused sample slot from the Material Editor to the object you want to paint.

3. In the Material Editor, click the map button for the Diffuse Color component. This button is on the material's Basic Parameters rollout.
All standard materials have a Basic Parameters rollout, whose controls vary depending on the chosen shader. The Strauss shader has only one color component, labeled Color.

The Material/Map Browser appears.

4 In the Material/Map Browser, choose Combustion, and click OK. A Combustion map is assigned to the Diffuse Color, and a black material map appears in the active sample slot.

5 Click to turn on Show Standard Map In Viewport. In the scene, the object turns black in shaded viewports.

6 In the Parameters rollout, click Edit.
This launches Combustion, which displays the New Workspace dialog.

7 Set up the new project.

The composite or Paint branch that you create in Combustion appears on the object in 3ds Max viewports, as well as in the sample slot for the material with the Combustion map. The workspace name and path are assigned to the material, and appear on the Project button in the material's Combustion Parameters rollout.

For example, you can use the Paint operator in Combustion. When you release the mouse, the stroke appears on the 3ds Max object.
Paint operator in Combustion

Painted object in 3ds Max
To display an unwrapped mesh:

In the 3ds Max Material Editor, you can use the Unwrap Mesh feature to display your 3D object as a 2D mesh in Combustion. You can adjust the color and size of the mesh.

The mesh display is only an overlay to help you orient paint strokes and other Combustion effects. It is displayed in Combustion but is not a part of the composite or the map.

1. Create a Combustion map.
2. In the 3ds Max Material Editor, enable Unwrap Selected in the Live Edit group.

In Combustion, a mesh appears. This is an "unwrapped" projection of the 3D object.
To set the mesh parameters:

- In Combustion, choose File > Preferences > Mesh.

<table>
<thead>
<tr>
<th>Use</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Anti-Alias Mesh</td>
<td>Remove jaggies from the mesh.</td>
</tr>
<tr>
<td>Display During Playback</td>
<td>Display the mesh when you play back the animation.</td>
</tr>
<tr>
<td>Color</td>
<td>Click the color box to set the color of the mesh using a color picker.</td>
</tr>
</tbody>
</table>

To paint directly on the 3D object:

1. Create a Combustion map.
2 In Combustion, select one of the following drawing tools:

- Freehand
- Straight Line
- Rectangle
- Ellipse

3 In the 3ds Max Material Editor, enable Paint in the Live Edit group of the Combustion Parameters rollout.

In the 3ds Max viewport, a pen cursor appears. Drag the cursor over the object to paint on it.
When you release the cursor, the Paint object also appears in Combustion.

To animate Combustion Paint strokes:

1. Create a Combustion map.

2. In Combustion, set the time scale to start at frame number 0. Choose File > Preferences. In the Preferences dialog select General, set Display Time As to Frames (From 0), and then click OK.

3. In the 3ds Max Material Editor, enable Track Time in the Live Edit group of the Combustion Parameters rollout.
   Now the time slider in 3ds Max controls the Timeline indicator in Combustion.

4. In 3ds Max, move the time slider to a frame and create a Paint object. The Paint object appears on that frame in both Combustion and 3ds Max.

5. Move to another frame and use Combustion to modify the Paint object. Combustion uses interpolation to determine the appearance of the Paint object between keyframes. If you add a new Paint object, that object simply appears, starting on the frame where you created it.

6. Continue advancing in the clip, adding and modifying Paint strokes and effects to create your animated material. For more information on animating objects in Combustion, refer to the Combustion User’s Guide.
You can add Paint strokes in either program, but to modify them you must use Combustion.

**NOTE** Remember, Combustion tracks the time slider in 3ds Max, but 3ds Max does not track the Timeline indicator in Combustion. If the 3ds Max viewport does not appear to be updating as you paint in Combustion, you might be painting on a different frame than the one displayed in 3ds Max. To find your Paint objects, move to the correct frame in 3ds Max.

To use an existing Combustion workspace as a material map in 3ds Max:

1. Open the Material Editor and select an unused sample slot.
2. In the Material Editor, expand the Maps rollout, and click the Map button next to the Diffuse Color component.
The Material/Map Browser appears.

3  In the Material/Map Browser, choose Combustion, and click OK. A Combustion map is assigned to the Diffuse Color, and a black material map appears in the active sample slot.

4  In the Combustion Parameters rollout, click the Project bar.

![Project bar](image)

The Open Project dialog appears.

5  Browse for the workspace file (.cws) that you want to use as a map, and click the Open button.

The Combustion workspace name and path appear in the Project button. To apply the map to an object, drag the sample slot from the Material Editor to the object in a 3ds Max viewport.

To edit the map, click the Edit button in the Parameters rollout. In Combustion, the workspace corresponding to the selected map opens, and you can edit the image.

**To paint geometry with a bitmapped material already assigned to it:**

1  In 3ds Max, select the object that you want to paint.

2  In the Material Editor, select an unused sample slot.

3  Click the Pick Material From Object button, then click the object in the viewport to put the object's material in the selected sample slot.

![Pick Material From Object button](image)

4  Open the Maps rollout and note the name of the bitmap file. Click Map to go to the bitmap level of the material.

5  Click the map's Type button.

The Material/Map Browser appears.

6  In the Material/Map Browser, choose Combustion to change the type from Bitmap to a Combustion map.
7 On the Paint Parameters rollout, click the blank Project button, and then choose the same bitmap.

8 Click Edit.
Combustion is launched and the Import Footage dialog appears. Import the same bitmap.
To paint on the bitmap, select Paint. You can also key or color correct the bitmap, or use it to build a composite. For more information, see the Combustion User’s Guide.

9 In the 3ds Max Material Editor, click to turn on Show Standard Map In Viewport.
In the scene, the object is mapped in shaded viewports.

Object with original bitmap
To paint selected faces:

Use a Multi/Sub-Object material to control the location of your painting. Any sub-material can have a Combustion map, so you can use Combustion to affect only the selected faces.

1. In 3ds Max, select the object you want to paint.

2. In the Modify panel, apply an Edit Mesh modifier to the object. (Choose Edit Mesh from the Modifier drop-down list.)
   
   If you are working with an editable mesh object, or a patch or NURBS surface, skip step 2. For geometry primitives, an option is to convert the object to a mesh, patch, or NURBS surface before step 3. However, you then lose the ability to adjust object parameters (for example, the radius of a sphere, the height of a box).

3. Choose Face as the sub-object selection level. Select the faces on which you want to paint.
4 Drag a material from a sample slot in the Material Editor onto the selected faces.

5 In the modifier stack display, choose the object again, to disable sub-object selection.

6 In the Material Editor, use Pick Material From Object to grab the material from the geometry.

You now have a new Multi/Sub-Object material. The original material appears as a sub-material applied to the selected faces.

7 In the Multi/Sub-Object material, go to the material assigned to the faces you want to paint.

A Multi/Sub-Object material is simply a container for multiple sub-materials assigned to different faces of the same object. Click a Sub-Material button to go to a sub-material.
8 Assign a Combustion map to the Diffuse component of the sub-material applied to the selected faces.

9 Click Edit to launch Combustion.

10 Use the tools in Combustion to modify the material.

To modify a Combustion map:

1 In the Material Editor, select the material you want to modify.
Material maps created in Combustion are vector-based and fully modifiable.

2 In the Combustion Parameters rollout, click the Edit button.
The workspace corresponding to the Combustion map opens in Combustion. As you modify the workspace in Combustion the map is updated in 3ds Max.

3 In Combustion, save the workspace before you disable the Edit button in 3ds Max.

To create a displacement map:
In 3ds Max, the Displace modifier on page 1313 acts as a force field to push and reshape an object's geometry. You can apply its variable force directly from the modifier gizmo, from a bitmap image, or from a Combustion workspace.

The grayscale component of the image is used to generate the displacement. Lighter colors in the image push outward more strongly than darker colors, resulting in a 3D displacement of the geometry.

1 In 3ds Max, select the object to which you want to apply the displacement map.

In this example, the displacement is applied to a box primitive.

In the object's Parameters rollout, increase the number of Length and Width Segments. The closer the number of segments approaches the resolution of the displacement map, the more accurate is the result.

In the example, 150 by 150 gives good results.

2 Apply a Displace modifier: in the Modify panel, choose Displace from the Modifier drop-down list.
3 In the Parameters rollout, Image group, click the Map button.

4 The Material/Map Browser appears. Select Combustion and click OK. The Map button now reads Map #1 (Combustion).

5 Open the Material Editor, and then click and drag the Map #1 (Combustion) button to an unused sample slot in the Material Editor. An Instance (Copy) Map dialog is displayed.
6 Select Instance and click OK.

7 In the Material Editor, Combustion Parameters rollout, click Edit. This launches Combustion. In the New dialog, set the Type To Paint, and create a grayscale image to use as a displacement map. For more information, see the Combustion User’s Guide.

8 In 3ds Max, increase the Displacement strength in the modifier Parameters rollout. As you increase the strength, you can see the result of the displacement map on the selected object.
9 In Combustion, save your project, then in 3ds Max, disable Edit in the Combustion Parameters rollout to exit Edit mode.

Interface

2D Mapping Coordinates

Like any 2D map in 3ds Max, mapping coordinates control how a Combustion map is positioned on objects.

For geometric primitives, mapping coordinates are usually provided automatically. For some kinds of geometry, such as meshes on page 2192, patches on page 2408, and NURBS surfaces on page 2416, you must apply a UVW Map modifier on page 1932 to provide mapping coordinates.

Controls in a 2D map's Coordinates rollout on page 6201 affect how the map is positioned.
When you work with a Combustion map, these are the important points to remember:

- When you apply a Combustion map to an object, leave mapping set to the default values of Texture and Explicit Map Channel.
- When you use a Combustion map as an environment map, set mapping to Environ and then choose the mapping shape from the Mapping drop-down list.
- The offset, tiling, mirror, and angle controls are useful especially when the size of the projected Combustion map is smaller than the geometry.
- You can choose between UV, VW, and WU projections. (You can also do this from the Combustion Parameters rollout, as described below.) UV projects onto the surface of geometry like a slide projector. VW and WU project the map at right angles to the geometry. With a Combustion map, UV is almost always the most useful choice.

**Combustion Parameters rollout**

The Combustion Parameters rollout appears when you assign a Combustion map to a material.
Project Loads the file to use in Combustion. You can load only file types supported by Autodesk Combustion, such as Combustion workspace files (cws), or footage and image file formats supported by Combustion (see the Combustion User's Guide for information on supported footage formats).

Edit Launches Combustion from the 3ds Max Material Editor. If a project is loaded, it is opened in Combustion. If no project is loaded, Combustion displays the New dialog. This dialog lets you specify a project type, name, video format, duration, and background color.

Live Edit group

These controls affect how you use Combustion with 3ds Max.

Operator Switches control to Combustion, where you can select an operator. The results of the operator appear as the image in the Combustion map. The operator does not have to be the last operator in the pipe. While Combustion is active, you can also adjust the operator. The Combustion map updates to show the results.
**Unwrap Selected** Takes the current UVW mapping coordinates of the currently selected 3D object (or the current Face sub-object selection), and displays them in Combustion. This can help you coordinate the map and the mesh as you paint. The Unwrap display is only an overlay. It is displayed in Combustion but is not a part of the composite or the map.

**UV List** Changes the mapping coordinate system (the direction in which the map is projected) from UV to VW or UW. UV projects onto the surface of geometry like a slide projector. VW and WU project the map at right angles to the geometry. With a Combustion map, UV is almost always the most useful choice.

**UV** Specifies which mapping channel to unwrap and paint. Range=1 to 99.

**Track Time** Links the Timeline in Combustion to the time slider in 3ds Max. When Track Time is enabled, you can use the time slider in 3ds Max to navigate between frames in Combustion.

**NOTE** This control is not bidirectional; changing the frame in Combustion does not change the frame in 3ds Max.

**Paint** When enabled, displays a paint cursor in 3ds Max viewports. You can then paint directly on the 3D geometry. Dragging the cursor in the viewport over the geometry in 3ds Max creates paint strokes inside Combustion.

**Constrain To UV** When enabled, constrains paint strokes to remain within the edges of the UV mapping coordinates. When paint strokes are unconstrained on an object such as a box, they can jump to the other side of the map when you cross a map’s edge. This can give erratic results. To prevent this, enable Constrain To UV.

In general, use the Constrain To UV option when you paint on boxes and other objects with planar maps. Disable this option when you want to paint on spherical maps or anywhere else the mapping has a singularity (where the edges of the map converge to a single point).

**Selected Faces** Constrains the Combustion image to only the faces selected. This gives additional control or masking based on faces rather than UV mapping.

**Project Info group**

These readouts display the format of the Combustion Paint or composite operator. They are active when a Combustion workspace is loaded or Edit mode is active.

**Width** Sets horizontal resolution of the frame in pixels.
**Height** Sets vertical resolution of the frame in pixels.

**Frames** Sets number of frames in the Combustion workspace.

**Rate** Sets playback speed in frames per second.

**Custom Resolution group**

With these controls, you can customize the resolution of the Combustion map.

**Enable** Enables the Width and Height controls.

**Width and Height**
- **Width** changes the horizontal resolution of the map.
- **Height** changes the vertical resolution of the map.

**Time group**

These controls relate frames in the Combustion workspace to frames in the Combustion map. See the controls under "End Condition Group" for how to handle the map when it contains fewer frames than the 3ds Max scene.

**Start Frame** Determines which frame of the Combustion sequence is used as the first frame of the Combustion map in 3ds Max.

**Duration** Sets how many frames of the Combustion file sequence are used by the Combustion map in 3ds Max.

**Filtering group**

These controls determine the method for calculating antialiasing on page 8501:

**Pyramidal** Sets the default antialiasing method. This method is faster than Summed Area filtering.

**Summed Area** Implements a better method of antialiasing. Summed Area filtering uses more memory than Pyramidal. If it has to use virtual memory, it can dramatically increase rendering time.

**None** Performs no antialiasing. This option takes the least time to render, but yields the lowest quality results.

**End Condition group**

These controls define what the 3ds Max renderer should do when the duration of the Combustion project (or the range of frames used in the Combustion map) is shorter than the rendering sequence in 3ds Max.
Loop  Plays the Combustion project animation repeatedly until the rendering sequence ends.

Ping Pong  Plays the animation forward, then backward, and repeatedly plays forward and backward until the rendering sequence is completed.

Hold  Plays the animation once, then repeatedly displays the last frame of the project until the rendering sequence is completed.

Gradient Map

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser > Gradient

Gradients shade from one color to another. You specify two or three colors for the gradient; 3ds Max interpolates intermediate values. Gradient maps are 2D maps.

Gradient maps used for the stoplight lamps, and for the background of the scene
TIP You can swap colors by dragging one color swatch over another, then clicking Swap in the Copy or Swap Colors dialog. To reverse the overall direction of the gradient, swap the first and third colors.

Gradient-mapped material tiled (left) and with noise (right)

See also:
- Coordinates Rollout (2D) on page 6201
- Noise Rollout (2D) on page 6211
- Output Rollout on page 6192

Procedures

To create a Gradient map:
1. Click a map button to assign a map.
2. Choose Gradient in the Material/Map Browser, and then click OK.

To change a gradient color:
1. In the Gradient Parameters rollout, click a color swatch to display the Color Selector on page 371.
2. Adjust the color.
3. Click one of the other color swatches.
4. Adjust the color.
To choose the kind of gradient:

- Choose either Linear or Radial.
  A linear gradient shades from one color to another along a line. A radial gradient has one color on the inside and another on the outside, shading in a circular pattern.

To use a map for a color in the gradient:

- In the Gradient Parameters rollout, click a map button to assign a map to a color.

To adjust the position of the second color:

- Change the Color 2 Position value.
  At the default value of 0.5, the second color is between the first and third colors. For a linear gradient, the second color's position ranges from the bottom at 0.0 to the top at 1.0. For a radial gradient, the second color's position ranges from the inside at 0.0 to the outside at 1.0.
**Interface**

**Color #1-3** Sets the three colors that the gradient interpolates between. Displays the *Color Selector* on page 371. You can drag and drop the colors from one swatch to another.

**Maps** Displays a *map* on page 8631 instead of the color. Maps are blended into the gradient in the same way that the gradient colors are blended. You can add nested procedural gradients in each window to make 5-, 7-, 9-color gradients, or more.

The check boxes enable or disable their associated maps.

**Color 2 Position** Controls the center point of the middle color. The position ranges from 0 to 1. When it is 0, color 2 replaces color 3. When it is 1, color 2 replaces color 1.

**Gradient Type** Linear interpolates the color based on the vertical position (V coordinate) while radial interpolates based on the distance from the center of
the map (center is: $U=0.5, V=0.5$). With both of these, you can rotate the gradient using the angle parameter under Coordinates, which is animatable.

**Noise group**

**Amount** When nonzero (ranges from 0 to 1), applies a noise effect. This perturbs the color interpolation parameter using a 3D noise function based on $U$, $V$, and Phase. For example, a given pixel is halfway between the first and second color (the interpolation parameter is 0.5). If noise is added, the interpolation parameter would be perturbed by some amount so that it may become less or more than 0.5.

**Regular** Generates plain noise. This is the same as Fractal noise with the Levels setting at 1. When the noise type is set to Regular, the Levels spinner becomes disabled (because Regular is not a fractal function).

**Fractal** Generates noise using a fractal algorithm. The Levels option sets the number of iterations for the fractal noise.

**Turbulence** Generates fractal noise with an absolute value function applied to it to make fault lines. The noise amount must be greater than 0 to see any effects of turbulence.

**Size** Scales the noise function. Smaller values give smaller chunks of noise.

**Phase** Controls the speed of the animation of the noise function. A 3D noise function is used for the noise. The first two parameters are $U$ and $V$ and the third is phase.

**Levels** Sets the number of fractal iterations or turbulence (as a continuous function).

**Noise Threshold group**

When the noise value is above the Low threshold and below the High threshold, the dynamic range is stretched to fill 0–1. This produces a smaller discontinuity at the threshold transition and thus causes less potential aliasing.

**Low** Sets the low threshold.

**High** Sets the high threshold.

**Smooth** Helps make a smoother transition from the threshold value to the noise value. When smooth is 0, no smoothing is applied. When it is 1, the maximum amount of smoothing is applied.
Gradient Ramp Map

Material Editor > Maps rollout > Click a Map button > Material/Map Browser > Gradient Ramp

Gradient Ramp is a 2D map similar to the Gradient map. It shades from one color to another. In this map, however, you can specify any number of colors or maps for the gradient. There are a variety of controls, making highly customized gradients possible. Almost any parameter of Gradient Ramp can be animated.

Gradient ramp used for the layers of the cake

See also:
- Coordinates Rollout (2D) on page 6201
- Noise Rollout (2D) on page 6211
- Output Rollout on page 6192
Procedures

To create a material with a Gradient Ramp map:

1. Open the Material Editor, and choose an unused sample slot.
2. Close the Basic Parameters rollout, and open the Maps rollout.
3. Click the Map button for Diffuse to display the Material/Map Browser.
4. In the Browser list, click Gradient Ramp. The map appears in the upper-left of the Browser window. Click OK. Gradient Ramp map is applied to the sample slot as the Browser closes.
5. In the Material Editor, under its toolbar, give the material a name to identify its use in your scene.
   When you replace an existing map with a gradient ramp map, choosing to Keep Old Map as Submap in the Replace Map dialog, the old map becomes assigned to the first flag as a texture.
Gradient Ramp-mapped material with a colored gradient
Interface

Gradient bar shows default gradient and interpolation types

**Gradient bar** Presents an editable representation of the gradient being created. The effect of the gradient moves from left (start point) to right (end point). By default, three flags appear along the bottom edge of a red/green/blue gradient. Each flag controls a color (or map). The currently selected flag is green, and its RGB value and its position in the gradient (in the range 0 to 100) appear above the gradient bar. Each gradient can have any number of flags.

The gradient bar has the following features:

- Click anywhere along the bottom edge to create additional flags.
- Drag any flag to adjust the position of its color (or map) within the gradient. The start and end flags (Flag #1 at 0 and Flag #2 at 100) cannot be moved. However, other flags can occupy these positions and still be moved.
More than one flag can occupy a given position. If two flags are at the same position, a slight edge appears between the colors. With three or more flags at the same position, the edge is a hard line.

**Right-click options for gradient bar** Right-click in the gradient bar to display a menu with these options:

- **Reset** Returns gradient bar to defaults.
- **Load Gradient** Loads an existing gradient (DGR) file into the gradient bar.
- **Save Gradient** Loads your current gradient bar as a DGR file.
- **Copy, Paste** Copies a gradient and pastes it into another Gradient Ramp map.
- **Load UV Map** Selects a UV map.
- **Load Bitmap** Selects a bitmap.
- **Flag Mode** Toggles flag display.

**Right-click options for flags** Right-click any flag to display a menu with the following options:

- **Copy and Paste** Lets you copy the current key and paste it to replace another key. The other key could be in another Gradient Ramp as well as the current one.
- **Edit Properties** Choose this option to display the Flag Properties dialog on page 6264.
- **Delete** Deletes the flag.

**Gradient Type** Chooses the type of gradient. The following Gradient types are available. These affect the entire gradient.

- **4 Corner** An asymmetrical linear transition of colors.
- **Box** A box.
- **Diagonal** A linear diagonal transition of colors.
- **Lighting** Based on the light intensity value. No light=far left; brightest light=far right.
- **Linear** A smooth, linear transition of colors.
- **Mapped** Lets you assign a map to use as the gradient. Enables the Source Map controls for specifying the map and turning it on and off.
■ Normal  Based on the angle between the vector from the camera to the object and the surface normal vector at the sample point. The leftmost flag of the gradient is 0 degrees; the rightmost flag is 90 degrees.

■ Pong  A diagonal sweep that repeats in the middle.

■ Radial  A radial transition of colors.

■ Spiral  A smooth, circular transition of colors.

■ Sweep  A linear sweep transition of colors.

■ Tartan  A plaid.

Interpolation  Chooses the type of interpolation. The following Interpolation types are available. These affect the entire gradient.

**NOTE** Gradients are ordered from left to right. The “next” flag is to the right of the current flag; the “previous” flag is to the left.

Custom  Sets an individual interpolation type for each flag. Right-click the flag to display the Flag Properties dialog on page 6264 and set the interpolation.

Ease In  Weighted more toward the next flag than the current flag.

Ease In Out  Weighted more toward the current flag than the next flag.

Ease Out  Weighted more toward the previous flag than the next flag.

Linear  Constant from one flag to the next. (Default.)

Solid  No interpolation. Transitions are a sharp line.

Source Map  Click to assign a map to a mapped gradient. The check box turns the map on or off.

The Source Map controls are available only when Mapped is the chosen gradient type.

Noise group

Amount  When nonzero, a random noise effect is applied to the gradient, based on the interaction of the gradient ramp colors (and maps, if present). The higher this value, the greater the effect. Range=0 to 1.

Regular  Generates plain noise. Basically the same as fractal noise with levels disabled (because Regular is not a fractal function).
Fractal  Generates noise using a fractal algorithm. The Levels option sets the number of iterations for the fractal noise.

Turbulence  Generates fractal noise with an absolute value function applied to it to make fault lines. Note that the noise amount must be greater than 0 to see any effects of turbulence.

Size Sets the scale of the noise function. Smaller values give smaller chunks of noise.

Phase Controls the speed of the animation of the noise function. A 3D noise function is used for the noise; the first two parameters are U and V and the third is phase.

Levels Sets the number of fractal iterations or turbulence (as a continuous function).

Noise Threshold group

When the noise value is above the Low threshold and below the High threshold, the dynamic range is stretched to fill 0 to 1. This causes a smaller discontinuity at the threshold transition and produces less potential aliasing.

High Sets the high threshold.

Low Sets the low threshold.

Smooth Helps make a smoother transition from the threshold value to the noise value. When Smooth is 0, no smoothing is applied. When Smooth is 1, the maximum amount of smoothing is applied.

Flag Properties Dialog

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser > Gradient Ramp > Gradient Ramp Parameters rollout > Right-click a flag at the bottom of the gradient bar. > Edit Properties > Flag Properties dialog

By setting parameters on the Flag Properties dialog, you can customize the effect of each flag on the Gradient Ramp map. You have access to all flags from this dialog.

See also:

■ Gradient Ramp Map on page 6258
Interface

**Flag Properties**

**Name field** Select any flag with the spinners. The selected flag turns green on the gradient bar. Use this field to rename a flag to represent its use in the gradient.

**Interpolation** Disabled unless the Interpolation type for the Gradient Ramp map is set to Custom. The available interpolation types for flags are similar to the corresponding ones in the Gradient Ramp map:

**NOTE** Gradients are ordered from left to right. The “next” flag is to the right of the current flag; the “previous” flag is to the left.

**Ease In** Weighted more toward the next flag than the current flag.

**Ease In Out** Weighted more toward the current flag than the next flag.

**Ease Out** Weighted more toward the previous flag than the next flag.

**Linear** Constant from one flag to the next. (Default.)

**Solid** No interpolation. Transitions are a sharp line.

**Texture** Assigns a map in place of a color. When unselected, the flag turns blue to indicate a map assignment.
**Color** Click the color swatch to change the color controlled by the selected flag.

**Position** Shows the current position of the selected flag. Use the spinners to reposition the flag, or enter a value directly. Position is not available for the start and end flags, because these flags can’t be moved.

**Animation keys** Animation keys are created by default for Color and Position, and the keys are active, indicated by the green triangles next to the Color and Position labels. You can turn these keys off if you don’t intend to animate the gradient.

## Swirl Map

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser > Swirl

Swirl is a 2D procedural map that generates patterns similar to the swirls in two-flavor ice creams. Like other two-color maps, either color can be replaced with other maps, so it’s possible to swirl marble with wood, for example.

Swirl used to create the whirlpool
See also:

- Coordinates Rollout (2D) on page 6201
- Noise Rollout (2D) on page 6211

Procedures

To create a Swirl-mapped material:

1. Open the Material Editor, and choose an unused sample slot.
2. Close the Basic Parameters rollout, and open the Maps rollout.
3. Turn on Diffuse Color. Click its Map button to display the Material/Map Browser.
4. In the Browser list, click Swirl. The map appears in the upper-left of the Browser window. Click OK.
   Swirl map is applied to the sample slot as the Material/Map browser closes.
5. In the Material Editor, under its toolbar, give the material a name to identify its use in your scene.
Interface

Swirl Color Setup group

**Base** The underlying layer for the swirl effect. Click the color swatch to change. Click None to assign a map in place of a color. The check box enables or disables the map.

**Swirl** Mixed with the Base color or map, produces the swirl effect. Click the color swatch to change this color. Click None to assign a map in place of a color.

**Swap** Reverses the color or map assignments for Base and Swirl.

**Color Contrast** Controls the contrast between Base and Swirl. At 0, the swirl is blurred. Higher values increase the contrast until all colors become black and white, even if Swirl Intensity and Swirl Amount are very high. Range=0 to 4.0; Default=0.4.
Swirl Intensity Controls the intensity of the swirl color. Higher values create a more vibrant mix of colors. At 0, the swirl effect disappears. Range=-10 to 10.0; Default=2.0.

Swirl Amount Controls the quantity of the Swirl color that gets mixed into the Base color. If set to 0, only the base color is used. Range=0 to 3.0; Default=1.0.

Swirl Appearance group

Twist Changes the number of spirals in the swirl effect. Higher values increase the number of spirals. Negative values change the direction of the twist. At 0, the colors are randomly distributed, not swirled. Range=-20.0 to 20.0; Default=1.0.

Constant Detail Changes the level of detail within a swirl. Lower values minimize the level of detail within the swirl. At 0, all detail is lost. Higher values increase detail until the swirl effect disappears. Values are in whole numbers. Range=0 to 10; Default=4.

Swirl Location group

Center Position X and Y Adjusts the location of the swirl’s center on the object.

Lock X and Y values remain identical as you adjust them. By turning off Lock and adjusting either the X or Y position, you can “slide” the swirl effect across the object. Default=on.

Configuration group

Random Seed Sets a new starting point for the swirl effect. Changes the swirl pattern while maintaining other parameters. Range=0 to 65,535; No default.

Tiles Map

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser > Tiles

Using the Tiles procedural map, you can create brick or stacked tiling of colors or material mappings. There are commonly defined architectural brick patterns available, or you can design custom patterns.
Tiles used for the walls of a house

With the Tiles map, you can:

■ Assign many of the maps available through the Material Editor.
■ Load textures and use colors in the pattern.
■ Control the number of tiles in columns and rows.
■ Control the size of the grout gap and its roughness.
■ Apply random variance in the pattern.
■ Control the stacking layout by shifting how the tiles line up.

See also:

■ Coordinates Rollout (2D) on page 6201
■ Noise Rollout (2D) on page 6211
Procedures

Example: To create a brick wall:

1 Create a wall using a Box primitive, or use an existing surface in one of your scenes.

2 Open the Material Editor on page 5641. Select an unused sample slot.

3 Click the Maps rollout to open it. Click the Map button for Diffuse to display the Material/Map Browser.

4 In the map list, select Tiles, then click OK. The Tiles map is now assigned to the sample slot. On the Material Editor, you see new rollouts appear for this map.

5 On the Standard Controls rollout, use Preset Type to select the type of tiles for the wall. Stack Bond is the default.

6 On the Material Editor toolbar, click Assign Material To Selection to apply the tile map to the wall. Then click Show Map In Viewport to see the applied map.

7 Open the Advanced Controls rollout. Under Tiles Setup, adjust Horizontal and Vertical Count. The default is eight rows high, with three repeats of the pattern in each row. Visually scale the size of the tiles to your scene. Also adjust Texture as well as Color and Fade Variance to fine-tune the appearance of the tiles.

8 Under Grout Setup, adjust parameters for the texture of the grout, gap spacing between tiles, and roughness of the grout. You can also create missing bricks in the map by setting % Holes to a value above 0.

9 Under Miscellaneous, you can vary the color of the tiles by using the Random Seed option.

Example: To match the tiles on the top and side of a wall:

1 Select a wall mapped with tile.

2 On the Modify panel, choose Editable Mesh.

3 Turn on Sub-Object > Face.
4 Select the top face of the wall.

5 Open the Material Editor. Drag the wall’s tile material to an unused sample slot to duplicate the material.

6 Under Tiles Setup, adjust the horizontal and vertical count of the new material to match the side of the wall.

7 Apply the new tile material to the selected faces on the top of the wall.

8 Under Stacking Layout, align the tiles by using the Line Shift option.

Interface

**Standard Controls rollout**

![Standard Controls rollout](image)

**Preset Type** Lists the commonly defined architectural tile bonds, or patterns, plus a custom pattern, which you design by selecting options under the Advanced Controls and Stacking Layout rollouts. The following illustrations show some of the different bonds:

![Common Flemish](image)
Advanced Controls rollout

Show Texture Swatches Updates to show the texture assigned by a map for Tiles or Grout.
**Tiles Setup group**

**Texture** Controls the display of the current texture map for the tiles. When on, the texture is used as the tile pattern instead of the color swatch. When turned off, the color of the tiles is displayed; clicking the color swatch displays the [Color Selector](#) on page 371.

**None** Acts as a target where you drag and drop maps for the tiles. When you click this button with a map assigned, 3ds Max displays the rollout for the map. You return this button to None (removing the assigned map) by dragging and dropping a None map from the Map/Material Browser.

**Horiz. Count** Controls the number of tiles in a row.

**Vert. Count** Controls the number of tiles in a column.

**Color Variance** Controls the color variation among the tiles.

**Fade Variance** Controls the fading variation among the tiles.

**Grout Setup group**

**Texture** Controls the display of the current texture map for the grout. When on, the texture is used as the grout pattern instead of the color swatch. When off, the color of the grout is displayed, and clicking the color swatch displays the [Color Selector](#) on page 371.

**None** Acts as a target where you drag and drop maps for the grout. When you click this button with a map assigned, 3ds Max displays the rollout for the map. You return this button to None (removing the assigned map) by dragging and dropping a None map from the Map/Material Browser.

**Horizontal Gap** Controls the horizontal size of the grout between the tiles. This value is locked by default to the vertical gap, so that both values change as you edit one or the other. To unlock them, click the lock icon.

**Vertical Gap** Controls the vertical size of the grout between the tiles. This value is locked by default to the horizontal gap, so that both values change as you edit one or the other. To unlock them, click the lock icon.

**% Holes** Sets the percentage of holes in the tiled surface caused by missing tiles. The grout shows through the holes.

**Rough** Controls the roughness of the edges of the grout.
**Miscellaneous group**

**Random Seed** Randomly applies patterns of color variation to the tiles. Does not require any other setting to generate completely different patterns.

**Swap Texture Entries** Swaps the texture maps or colors between the tiles and the grout.

**Stacking Layout group**

**NOTE** This group of controls is active only when Custom Tiles is selected in Standard Controls rollout > Pattern Setup > Preset Type.

**Line Shift** Shifts every second row of tiles a distance of one unit.

**Random Shift** Randomly shifts all rows of tiles a distance of one unit.

**Row and Column Editing group**

**NOTE** This group of controls is enabled only when Custom Tiles is selected in Standard Controls rollout > Pattern Setup > Preset Type.

**Row Modify** When on, creates a custom pattern for rows, based on the values of Per Row and Change. Default=off.

- **Per Row** Specifies which rows to change. When Per Row equals 0, no rows change. When Per Row equals 1, every row changes. When Per Row is a value greater than 1, the change appears every $N$ rows: a value of 2 changes every second row, a value of three changes every third row, and so on. Default=2.

- **Change** Changes the width of tiles in the affected rows. A value of 1.0 is the default tile width. Values greater than 1.0 increase the width of tiles, and values less than 1.0 decrease it. Range=0.0 to 5.0. Default=1.0.
  A value of 0.0 is a special case: When the Change value is 0.0, no tiles appears in that row, and the underlying material shows through.

**Column Modify** When on, creates a custom pattern for columns, based on the values of Per Column and Change. Default=off.

- **Per Column** Specifies which columns to change. When Per Column equals 0, no columns change. When Per Column equals 1, every column changes. When Per Column is a value greater than 1, the change appears every $N$ columns: a value of 2 changes every second column, a value of three changes every third column and so on. Default=2.
- **Change** Changes the height of tiles in the affected columns. A value of 1.0 is the default tile height. Values greater than 1.0 increase the height of tiles, and values less than 1.0 decrease it. Range=0.0 to 5.0. Default=1.0. A value of 0.0 is a special case: When the Change value is 0.0, no tile appears in that column, and the underlying material shows through.

### 3D Maps

3D maps are patterns generated procedurally in three dimensions. For example, Marble has a grain that goes through the assigned geometry. If you cut away part of an object with marble assigned as its texture, the grain in the cutaway portion matches the grain on the object's exterior.

### Coordinates Rollout (3D)

Material Editor > Select sample slot. > Get Material > Material/Map Browser > Turn on 3D Maps. > Double-click a map type to apply it to sample slot. > Coordinates rollout is displayed in Material Editor.

By adjusting coordinate parameters, you can move a map relative to the volume of the object to which it is applied.

### Interface

![Coordinates Rollout](image)

6278 | Chapter 17  Material Editor, Materials, and Maps
Source Choose the coordinate system to use. There are four options:

- **Object XYZ**  Uses the object’s local coordinate system.
- **World XYZ**  Uses the scene’s world coordinate system.
- **Explicit Map Channel**  Activates the Map Channel field. You can choose any channel from 1 to 99.
- **Vertex Color Channel**  Assigns vertex colors as a channel. See Editable Mesh on page 2192 for details on assigning vertex color. See also Vertex Color Map on page 6355.

When one of the map channels is set, it locks the map into position on the vertices of the object so that the map "sticks" to the object as it deforms during animation.

When an object is deforming through its own local space (for example, when it is bending or twisting), the object appears to move through the map, because it passes through the XYZ coordinates of the 3D texture.

**Map Channel** Unavailable unless the source is Explicit Map Channel. When available, you can choose any channel from 1 to 99.

**Offset** Moves the map pattern along the specified axis.

**Tiling** Tiles on page 8742 the map pattern along the specified axis and makes the pattern narrower.

**Angle** Rotates the map pattern along the specified axis.

**Blur** Affects the sharpness or blurriness of the map based on its distance from the view. The farther away the map is, the greater the blurring. The Blur value blurs maps in world space. Blur is primarily used to avoid aliasing on page 8501.

**Blur Offset** Affects the sharpness or blurriness of the map without regard to its distance from the view. Blur Offset blurs the image itself in object space. Use when you want to soften or defocus the details in a map to achieve the effect of a blurred image.

**Cellular Map**

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser > Cellular
The Cellular procedural map generates a pattern that's useful for a variety of visual effects, including mosaic tiling, pebbled surfaces, and even ocean surfaces.

Cellular maps create the goblet textures.

**TIP** The Material Editor sample slot doesn't show the cellular effect very clearly. For a better visual aid to getting the effect you want, assign the map to geometry and render the scene.

**See also:**
- Coordinates Rollout (3D) on page 6278
- Output Rollout on page 6192

**Procedures**

**Example: To create confetti:**

1. Assign the Cellular map as a Diffuse map.
2. Set the parameters as follows:
Cell Color (use RGB values after clicking color swatch): **202, 75, 171**
Variation: **55**
Division Colors (use RGB values after clicking the color swatch):
- First: **127, 150, 197**
- Second: **0, 119, 163**
Cell Characteristics:
- Circular
- Size: **2.4**
- Spread: **0.43**
- Fractal: off
Thresholds:
- Low: **0.19**
- Mid: **0.65**
- High: **0.86**

**Example: To create alien skin:**

1. Assign the Cellular map as a Diffuse map.
2. Set the parameters as follows:
   - Cell Color (use RGB values after clicking the color swatch): **52, 107, 58**
   - Variation: 0.0
   - Division Colors (use RGB values after clicking the color swatch):
     - First: **112, 119, 64**
     - Second: **143, 137, 112**
Cell Characteristics:
- Circular
- Size: **7.9**
- Spread: **0.61**
- Fractal: on
■ Iterations: 2.0

Thresholds:
■ Low: 0.17
■ Mid: 0.64
■ High: 1.0

3 Copy the Diffuse map to the Bump map.
   If you increase the Bump amount, increase the Cellular bump map's
   Bump Smoothing value as well.

Example: To create a tile mosaic:

1 Assign the Cellular map as a Diffuse map.

2 Set the parameters as follows:
   Cell Color (use RGB values after clicking the color swatch): 141, 120, 87
   Variation: 54
   Division Colors (use RGB values after clicking the color swatch):
   ■ First: 128, 128, 128
   ■ Second: 221, 221, 221
   Cell Characteristics:
   ■ Chips
   ■ Size: 7.0
   ■ Spread: 0.35
   ■ Fractal: off
   Thresholds:
   ■ Low: 0.42
   ■ Mid: 0.76
   ■ High: 1.0

3 Assign a Mix map as the Bump map.
4 Click Material/Map Navigator to display the Navigator. Copy the Cellular Diffuse map by dragging it from the Navigator to the Color #2 map window of the Mix map.

5 A dialog is displayed. You are asked if this should be an instance or a copy. Select Copy and click OK.

6 Assign a Noise map to the Color #1 map window of the Mix map.

7 Set the Noise parameters as follows:
   Noise Type: Fractal
   Levels: 6.0
   Size: 9.3

8 In the Mix Parameters rollout of the Mix map, set the Mix Amount to 0.5.

9 Go to top level of the material. In the Maps rollout, set Bump Amount to 82.
Interface

Cell Color group

These controls specify the color of the cells.

Color swatch Displays the Color Selector on page 371. Choose a color for the cells.

Map button Assigns a map to the cells, rather than a solid color.
Check box When on, enables the map. When off, disables the map (cell color reverts to the color swatch).

Variation Varies the color of the cells by randomly altering RGB values. The higher the variation, the greater the random effect. This percentage value can range from 0 to 100. At 0, the color swatch or the map completely determines the cell color. Default=0.

Division Colors group

These controls specify the color of the divisions between cells. Cell divisions are a ramp between two colors or two maps.

Color swatches Display the Color Selector for choosing a cell division color.

Map buttons Assigns a map to one of the cell division colors.

Check boxes When on, enables the associated map. When off, disables the associated map (the division color reverts to the color swatch).

Cell Characteristics group

These controls change the shape and size of the cells.

Circular/Chips Lets you choose how cell edges look. With Circular, the cells are circular. This gives a more organic, or bubbly look. With Chips, the cells have linear edges. This gives a more chipped or mosaic appearance. Default=Circular.

Size Alters the overall scale of the map. Adjust this value to fit the map to your geometry. Default=5.0.

Spread Alters the size of individual cells. Default=0.5.

Bump Smoothing When you use a cellular map as a bump map on page 6049, you might encounter aliasing or jaggliness at the boundaries of the cells. If this occurs, increase this value. Default=0.1.

Fractal Defines the cellular pattern as a fractal, thus enabling the three following additional parameters. Default=off.

Iterations Sets the number of times the fractal function is applied. Caution: Increasing this value increases rendering time. Default=3.0.

Adaptive When on, the number of fractal iterations is set adaptively. That is, the number of iterations increases the closer the geometry is to the scene’s point of view, and decreases in the distance. This reduces aliasing and also saves time while rendering. Default=on.
**Roughness** When you use the Cellular map as a bump map on page 6049, this parameter controls how rough the bumps are. When Roughness is zero, each iteration is half the strength of the previous iteration, and half the size. As Roughness increases, each iteration is closer in strength and size to the previous iteration. When Roughness is at its maximum value of 1.0, each iteration is the same size and strength as the previous. In effect, this turns off the fractalization. Roughness has no effect unless Iterations is greater than 1.0. Default=0.0.

**Thresholds group**

These controls affect the relative size of cells and divisions. They are expressed as normalized percentages (0 to 1) of the sizes specified by the default algorithm.

- **Low** Adjusts the size of the cells. Default=0.0.
- **Mid** Adjusts the size of the first division color, relative to the second. Default=0.5.
- **High** Adjusts the overall size of divisions. Default=1.0.

**Dent Map**

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser > Dent

Dent is a 3D procedural map. During scanline rendering, Dent creates a random pattern based on fractal noise. The effect of the pattern depends on the map type.
Dent map gives texture to the cup on the left; cup on the right has same pattern, but without dents.

Effect of default parameters
Defaults: Iterations=2, Size=200, Strength=20

Dent was designed to be used primarily as a bump map, and its default parameters are optimized for this usage. As a bump map, Dent renders three-dimensional dents over the surface of an object. Editable parameters control the size, depth, and complexity of the denting effect.

Dent can also be used with other maps. With a diffuse color map, for example, the two colors assigned to Dent mix in random swirls over the surface of the object. Either of the colors can be replaced by other maps.
Dent bump maps
At left, default parameters produce fairly uniform dents over surface.
At right, increased Strength parameter creates a deeper and more irregular pitting effect.

Dent diffuse maps
At left, Dent as a two-color diffuse map.
At right, colors replaced with Dent and Marble maps.

See also:
■ Coordinates Rollout (3D) on page 6278

Procedures

To make a Dent map:

1 In the Material Editor, click a sample slot to make it active.
2 Open the Maps rollout.
3 Click Bump or other map button to display the Material/Map Browser.
4 Double-click Dent in the list of map types.
The Material Editor displays the Coordinates and Dent Parameters rollouts.
5 Set parameters on the Dent Parameters rollout.
The active sample slot updates to show the Dent effect.
To replace a color:

1. Click a color swatch labeled Color #1 or Color #2.
2. In the standard Color Selector on page 371, choose a replacement color. The color updates in the color box and sample slot.

To swap a color:

- Click Swap.
  The position of the two colors is reversed in the color boxes and sample slot.

To replace a color with a map:

1. Click a Map bar marked None next to one of the color swatches. The Material/Map Browser is displayed.
2. Select a map from the list.
  The sample slot updates to show the map in place of the color.

**Interface**

![Dent Parameters](image)

**Size** Sets the relative size of dents. As the size increases, the number of dents decreases when other settings are the same. Default=200.
Decreasing Size creates the appearance of tiny dents spaced fairly evenly. The effect can resemble a "sand-covered" surface.
Increasing Size creates the appearance of distinct grooves and gouges on a surface. The effect sometimes has a "hardened lava" look.
Size=10, 500, and 1000

Iterations=1, Strength=20 (default)

Size=10, 500, and 1000

Iterations=3, Strength=20 (default)

Each set of three spheres uses the same size range, but varies the number of iterations. Strength is held constant in both sets.

**Strength** Determines the relative coverage of the two colors. Higher values increase the coverage of Color #2, while lower values increase the coverage of Color #1. Default=20.

When using Dent as a bump map, increasing the Strength value typically makes the dents look deeper.

In the following illustrations, each set of three spheres uses the same Strength range, but varies the Size value between the two sets. The Iterations value is the same in both sets.
Size=1000, Iterations=3

Strength=5, 20 (default), and 100

**Iterations** Sets the number of calculations used to create the dents. Default=2. Dent is based on a fractal-noise equation. During rendering, a dented surface is calculated one or more times to produce the finished effect. Each calculation pass is an iteration.

As a surface is calculated, each iteration adds to the number of dents and the complexity and randomness of the final surface (dents become dented).

The Dent texture requires heavy calculation, especially at higher iterations. This can slow down rendering time considerably.

Size=500, Strength=20

The three spheres have uniform settings for size and strength. Only the number of iterations varies.

**Swap** Reverses the position of colors or maps.

**Colors** Allows choice of two colors where appropriate for a color component (such as Diffuse). Defaults=black for Color #1 and white for Color #2.

Dent can create patterns in an object’s color as well as its surface. By using Dent as a diffuse color map, the entire surface is affected.
Two colors are mixed to produce a random pattern, governed by size, strength, and iteration settings. The default colors are black and white, but either can be replaced or swapped.

Left sphere: Sets the color to black and white.
Middle sphere: Replaces white with red.
Right sphere: Swap black and red.

By adjusting Strength, Size, and Iterations parameters, you vary the Dent patterns on a diffuse color map.

- Size sets the density of the dent pattern. At low settings, the pattern is dense. As Size increases with other settings held constant, the pattern becomes increasingly sparse.

- Strength sets the color strength in the dent pattern. At low settings, Color #1 (black) dominates the pattern. As Strength increases, Color #2 (white) replaces Color #1.

- Iterations sets the color iterations in the dent pattern. At low settings, Color #1 is dominant. As iterations increase, Color #2 gradually increases in the pattern.

Dent is applied as a diffuse map in the following examples. Colors are default black and white.

Size=500, Strength=60
Iterations=2

Size=100, 500, and 1000
Maps Replaces colors with maps in the dent pattern. The check boxes enable or disable their associated map.

You can assign maps to one or both of the Dent color slots. Any kind of map can be used, including Dent. The map overrides the assigned color, which has no effect.

In the three spheres below, the assigned colors are progressively replaced with maps. Parameters of the original Dent map are the same for all spheres.

Left sphere: Applies Dent as a diffuse map. Color #1 is black; Color #2 is red.
Middle sphere: Replaces black with Dent map (all defaults).

Right sphere: Replaces red with Marble map (all defaults).

**Falloff Map**

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser > Falloff

The Falloff map generates a value from white to black, based on the angular falloff of the face normals on the surface of the geometry.

Falloff map creates the appearance of translucency.

The direction used to specify the angular falloff varies, depending on the methods you choose. However, with the default settings, the map generates white on faces whose normals point outward from the current view, and black on faces whose normals are parallel to the current view.

Falloff map provides a greater variety of opacity falloff effects than those in the Falloff settings in a standard material's Extended Parameters rollout on
You assign the Falloff map as an opacity map on page 6042. However, you can also use Falloff for special effects, such as an iridescent look.

**NOTE** When old files that use Falloff maps are brought into 3ds Max, the old Falloff interface is displayed, replacing the new Falloff interface.

See also:
- For functionality shared with other 3D maps, see **Output Rollout** on page 6192

**Procedure**

**To control opacity using a Falloff map:**

1. Assign the Falloff map as an opacity map.
2. Render to see the effect.
3. Adjust the falloff parameters to vary the effect.
Interface

Falloff Parameters rollout

**Front : Side** By default, "Front : Side" is the name of the group at the top of this rollout. Front : Side indicates Perpendicular/Parallel falloff. This name changes depending on the falloff type selected. In all cases, the name on the left refers to the top set of controls, and the name on the right to the bottom set.

The controls are as follows:

- Click the color swatches to assign colors.
- Use the numeric fields and spinners to adjust the relative strength of the colors.
Click the buttons marked None to assign maps.

Turn on the check boxes to activate the maps; otherwise the colors are used. These are on by default.

Click Swap Colors/Maps (the curved arrow) to exchange the assignments.

**Falloff Type** Chooses the kind of falloff. Five options are available:

- **Perpendicular/Parallel** Sets the angular falloff ranges between face normals that are perpendicular to the falloff direction and normals that are parallel to the falloff direction. The falloff range is based on a 90-degree change in face normal direction. (Default.)

- **Towards/Away** Sets the angular falloff ranges between face normals that face toward (parallel to) the falloff direction and normals that face away from the falloff direction. The falloff range is based on a 180-degree change in face normal direction.

- **Fresnel** Based on adjustments to the Index of Refraction (IOR). Results in dim reflections on surfaces facing the view, with much brighter reflections on angled faces, creating highlights like those on the sides of a glass.

- **Shadow/Light** Adjusts between two subtextures based on how much light is falling on the object.

- **Distance Blend** Adjusts between two subtextures based on Near Distance and Far Distance values. Uses include reducing aliasing on large terrain objects and controlling the shading in non-photorealistic environments.

**Falloff Direction** Chooses the direction of falloff. Five options are available:

- **Viewing Direction (Camera Z-Axis)** Sets the falloff direction relative to the camera (or screen). Changing object orientation doesn't affect the falloff map. (Default.)

- **Camera X/Y Axis** Similar to Camera Z-Axis. For example, using Camera X-Axis with the Toward/Away falloff type runs the gradient from left (Toward) to right (Away).

- **Object** Uses an object whose position determines the falloff direction. Click the wide button next to Object in the Mode Specific Parameters group, and then pick an object in the scene. The falloff direction is the direction from the point being shaded toward the object's center.
on the side toward the object center get the Towards value, and those away from the object get the Away value.

- **Local X/Y/Z Axis** Sets the falloff direction to one of the object’s local axes. Changing the orientation of the object changes the falloff direction.

- **World X/Y/Z Axis** Sets the falloff direction to one of the world coordinate system axes. Changing object orientation doesn’t affect the falloff map.

When no object is chosen, the falloff direction uses the local X, Y, or Z axis of the object being shaded.

**Mode Specific Parameters group**

The first parameter applies and is available only when you set Falloff Direction on page 6297 to Object:

- **Object** Picks object from scene and puts its name on the button.

The following are parameters for the Fresnel falloff type:

- **Override Material IOR** Allows change to the Index of Refraction set by the material.

- **Index of Refraction** Sets a new Index of Refraction. This option is unavailable unless Override Material IOR is turned on.

The following are parameters for the Distance Blend falloff type:

- **Near Distance** Sets the distance at which the blend effect begins.

- **Far Distance** Sets the distance at which the blend effect ends.

- **Extrapolate** When on, the effect continues beyond the Near and Far distances.
Mix Curve rollout

Using the graph on the Mix Curve rollout, you can precisely control the gradient produced by any falloff type. You see the resulting gradient in the bar below the graph.

**Move flyout**

- Moves a selected point in any direction, limited by the unselected points on either side.
- Constrains movement to the horizontal.
- Constrains movement to the vertical.

**Scale Point** Scales the selected point within the range of its gradient. On a Bezier corner point, this control is effectively the same as a vertical move. On a Bezier smooth point, you can scale the point itself or either handle. As with the move controls, scale is limited by the unselected points on either side.
Add Point flyout

+ Adds a Bezier corner point anywhere on the graph line. The point makes a sharp angle when moved.

+ Adds a Bezier smooth point anywhere on the graph line. Handles attached to the point create smooth curves when moved. On a Bezier smooth point, you can move the point or either handle.

Delete Point Removes selected points.

Reset Curves Returns graph to its default, a straight line between 0 and 1.

Marble Map

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser > Marble

The Marble map produces a marbled surface with colored veins against a colored background. A third color is automatically generated.
Marble map used for the balusters

NOTE Another way to create marble is to use the Perlin Marble Map on page 6310.

See also:

- For functionality shared with other 3D maps, see Coordinates Rollout (3D) on page 6278.

Procedures

To create a Marble map:

1. Click a map button to assign a map.

2. Choose Marble in the Material/Map Browser, and then click OK.

To adjust the size of Marble veins:

- In the Marble Parameters rollout, change the Size value to change the overall scale of the vein pattern, and change Vein Width to change the width of veins relative to the overall scale.
The larger the Size value, the wider the veins. The larger the Vein Width value, the more veins appear relative to the overall pattern.

To change vein color:

1. In the Marble Parameters rollout, click a color swatch to display the Color Selector on page 371.
2. Adjust the color.
3. Click Close to dismiss the dialog.

To use a map for a vein:

- In the Marble Parameters rollout, click a map button to assign a map to a color.

To swap the two vein colors:

- In the Marble Parameters rollout, click Swap.

To adjust mapping coordinates:

- In the Coordinates rollout, adjust Offset, Tiling, or Angle.

Interface

- Size: Sets the spacing between the veins.
- Vein Width: Sets the width of the veins.
- Swap: Switches the position of the two colors or maps.
Color # 1 and Color # 2 Displays the Color Selector on page 371. Select one color for the veins (color 1) and another for the background (color 2). A third color is generated from the two colors you select.

Maps Selects the bitmaps or procedural maps on page 8691 to appear in the veins or in the background color. Turn on the check boxes to make the maps active.

Noise Map

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser > Noise

The Noise map creates random perturbation of a surface based on the interaction of two colors or materials.

Noise map used for the edges of the street

See also:

■ Coordinates Rollout (3D) on page 6278
Procedures

To change a component color:
1. In the Noise Parameters rollout, click a color swatch to display the Color Selector on page 371.
2. Adjust the color.
3. Click OK to dismiss the dialog.

To use a map for a component:
- In the Noise Parameters rollout, click a map button to assign a map to a color.

To swap the two component colors:
- In the Noise Parameters rollout, click Swap.

To adjust mapping coordinates:
- In the Coordinates rollout, adjust Offset, Tiling, or Angle.

Interface

NOTE For the Noise map, the tiling and mirroring controls are disabled in the Texture Tiling And Output rollout.
Noise Type

- **Regular**  (The default.) Generates plain noise. Basically the same as fractal noise with the Levels setting at 1. When the noise type is set to Regular, the Levels spinner is inactive (because Regular is not a fractal function).

- **Fractal**  Generates noise using a fractal algorithm. The Levels option sets the number of iterations for the fractal noise.

- **Turbulence**  Generates fractal noise with an absolute value function applied to it to make fault lines.

![Noise Type Options](Image)

Regular, Fractal, Turbulence

Size Sets the scale of the noise function, in 3ds Max units. Default=25.0.

**Noise Threshold** When the noise value is above the Low threshold and below the High threshold, the dynamic range is stretched to fill 0 to 1. This creates
a smaller discontinuity (technically, 1st order instead of 0 order) at the threshold transition and produces less potential aliasing on page 8501.

- **High**  Sets the high threshold. Default=1.0.
- **Low**  Sets the low threshold. Default=0.0.

**Levels** Determines how much fractal energy is used for the Fractal and Turbulence noise functions. You can set the exact amount of turbulence you want, and also animate the number of fractal levels. Default=3.0.

**Phase** Controls the speed of the animation of the noise function. Use this option to animate the noise function. Default=0.0.

**Swap** Switches the position of the two colors or maps.

**Color # 1 and Color # 2** Display the Color Selector on page 371 so you can choose one or the other of the two principal noise colors. Intermediate color values are generated from the two colors you select.

**Maps** Select the bitmaps or procedural maps to appear in one or the other noise color.

Turn on the check boxes to make the maps active.

**Particle Age Map**

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser > Particle Age

The Particle Age map is for use with particle systems on page 8678. Typically you assign the Particle Age map as a Diffuse map on page 6031, or in Particle Flow with the Material Dynamic operator on page 3168. It alters the color (or map) of a particle based on the particle’s life. The particles in a system begin as one color. At a specified age, they begin changing (by interpolation) to a second color, and then they change again to a third color before they die out.
Particle age changes the appearance of particles over time.

TIP This map works well with the Particle MBlur map on page 6308. For example, you could assign Particle Age as a diffuse map on page 6031 and Particle MBlur as an Opacity map on page 6042. Another way to use Particle Age is in the mask channel of a Blend on page 6107 material. In this case, you could set up two of the colors to white, and one to black, which would make the particles change materials over their age. In addition, you could set up one of the two materials with an effects channel on page 8589 and use a Glow on page 7325 filter on it through Video Post.

See also:

- For functionality shared with other 3D maps, see Output Rollout on page 6192.
Interface

**Interface**

Color #1 Sets the color of a particle at its birth.
Click the button to the right of the color swatch to assign a map instead of a solid color. The check box turns the map on or off.

Age #1 Sets the age where a particle starts changing from Color #1 to Color #2, expressed as a percentage of the particle's entire life.

Color #2 Sets the color of a particle in mid-life. You can also assign a map to this color.

Age #2 Sets the age where a particle's color equals Color #2, expressed as a percentage of the particle's entire life.

Color #3 Sets the color of a particle at its death. You can also assign a map to this color.

Age #3 Sets the age where a particle changes to Color #3, expressed as a percentage of the particle's entire life.

**Particle MBlur Map**

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser > Particle MBlur
The Particle MBlur (Motion Blur) map is for use with particle systems on page 8678. The map alters the opacity of the leading and trailing ends of particles based on their rate of motion. The map is usually applied as an opacity map, but you can use it as a diffuse map for special effects.

Particle MBlur makes particles blur as they move.

The following conditions must be in effect to achieve particle motion blur:

- The Particle MBlur map must be in the same material that is assigned to the particles. For best results, it should be assigned as an opacity map.
- The particle system must support the Particle MBlur map. Particle systems that support Particle MBlur include PArray, PCloud, Super Spray, and Spray.
- In the particle system's Particle Rotation rollout, in the Spin Axis Controls group, the Direction of Travel/MBlur option must be on.
- In this same group, the Stretch spinner must be greater than 0 to stretch the particles as a percent of their length based on the particle Speed setting.
- The correct type of particle must be used. MBlur works on all particle types except Constant, Facing, Metaparticles, and PArray Object Fragments. Also,
in the Standard Particles category, MBlur does not support the Triangle and SixPoint particle types.

- The material assigned to the particle system must not be a Multi/Sub-Object material.

**Interface**

![Particle Motion Blur Parameters](image)

**Color #1** A particle approaches this color as it reaches its slowest speed. By default, this color is white to provide the opaque end of the range for an opacity map.

**Color #2** A particle approaches this color as it speeds up. As a default, this color is black to provide transparency in an opacity map.

Typically, you don't need to change either of these two colors.

**Sharpness** Controls the transparency, relative to the speed. If Sharpness is set to 0, the entire particle is blurry and transparent, no matter how slow it is traveling. The default works well in many cases. Default=2.0.

**Perlin Marble Map**

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser > Perlin Marble

The Perlin Marble map generates a marble pattern using the Perlin Turbulence algorithm. This map is an alternative to Marble on page 6300, which is also a 3D material.
Perlin marble used for the texture of the goblet

See also:

- Coordinates Rollout (3D) on page 6278
Interface

Size Sets the size of the marble pattern. Change this to change the scale of marble, relative to the object's geometry. Default=50.

Levels Sets the number of times the turbulence algorithm is applied. Can range from 1.0 to 10.0. The higher the value, the more complicated the marble pattern. Default=8.0.

Color 1 and Color 2 groups

The controls in these groups are identical. They determine the two main colors of the marble.

Color swatch Click to display the Color Selector on page 371. and change the color.

Map Click to assign a map instead of a solid color. The check box turns the map on or off.

Saturation Controls the saturation of the color in the map, without altering the color displayed in the color swatch. Lower values darken the color, and
higher values lighten it. Range=1 to 100; Default=85 for Color 1, 70 for Color 2.

Swap  Click to swap Color 1 and Color 2.

Smoke Map

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser > Smoke

Smoke is a 3D map that generates amorphous, fractal-based turbulent patterns. It's primarily designed for animated opacity mapping on page 6042 to simulate the effects of smoke in a beam of light, or other cloudy, flowing mapping effects.

Smoke map used to create clouds in the sky

See also:
- Coordinates Rollout (3D) on page 6278
Interface

Size Changes the scale of the smoke "clumps." Default=40.

# Iterations Sets the number of times the fractal function is applied. The higher the value, the more detail within the smoke, but the longer the calculation time. Default=5.

Phase Shifts the turbulence within the smoke pattern. Animate this parameter to animate the movement of the smoke. Default=0.0.

Exponent Makes color #2, representing the smoke, sharper and more wispy. As this value increases, the smoke "tendrils" become smaller within the pattern. Default=1.5.

Swap Exchanges the colors.

Color #1 Represents the smokeless portion of the effect.

Color #2 Represents the smoke.

Because this map is usually used as an opacity map, you can adjust the luminance of the color values to alter the contrast of the smoke effect.

- Click a color swatch to change the color. Usually you only need to do this to adjust luminance.
- Click a map button to assign a map instead of a solid color. Turn on the check box to activate the map.
**Speckle Map**

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser > Speckle

Speckle is a 3D map that generates a speckled surface pattern that's useful for diffuse mapping on page 6031 and bump mapping on page 6049 to create granite-like and other patterned surfaces.

![Speckle map used for rocks](image)

See also:

- Coordinates Rollout (3D) on page 6278
**Interface**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Size</strong></td>
<td>Adjusts the size of the speckles. Use this to make the speckles match your geometry. Default=0.1.</td>
</tr>
<tr>
<td><strong>Swap</strong></td>
<td>Exchanges the two color components.</td>
</tr>
<tr>
<td><strong>Color #1</strong></td>
<td>Represents the color of the speckles.</td>
</tr>
<tr>
<td><strong>Color #2</strong></td>
<td>Represents the color of the background. Click one of the swatches to display the <a href="#">Color Selector</a> on page 371 and change one of these component colors.</td>
</tr>
<tr>
<td><strong>Maps</strong></td>
<td>Click a button to assign a map that replaces one of the color components. Turning off the check box turns off the associated map (the Speckle map reverts to the associated color component).</td>
</tr>
</tbody>
</table>

**Splat Map**

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser > Splat

Splat is a 3D map that generates a fractal surface pattern that is useful as a [Diffuse map](#) on page 6031 for creating a pattern similar to splattered paint.
Splat map used for the patterns in ice cream

See also:
- Coordinates Rollout (3D) on page 6278

Interface
**Size** Adjusts the size of the splats. Use this to make the splats match your geometry. Default=40.

**# Iterations** Sets the number of times the fractal function is evaluated. The higher the number, the more detailed the splats, but the longer the calculation time. Default=4.

**Threshold** Determines how much of Color #1 is mixed with Color #2. At 0, only Color #1 is displayed; at 1, only Color #2 is displayed. Default=0.2.

**Swap** Exchanges the two color components.

**Color #1** Represents the color of the background.

**Color #2** Represents the color of the splats.

Click one of the swatches to display the **Color Selector** on page 371 and change one of these colors.

**Maps** Assigns a map to replace one of the color components. Turning off the check box turns off the associated map (the Splat map reverts to the associated color component).

### Stucco Map

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser > Stucco

Stucco is a 3D map that generates a surface pattern that is useful for **bump mapping** on page 6049 for creating the effect of a stuccoed surface.
Stucco map used for a plaster wall

See also:

- Coordinates Rollout (3D) on page 6278

Interface
Size Adjusts the size of the indentations. Use this to make the scale of the stucco match your geometry. Default=20.

Thickness Blurs the border between the two colors. At 0, the borders are sharp. The higher the Thickness, the more the borders are blurred and the less distinct the indentations are. When you use Stucco as a bump map, the indentations are very faint at 0.5 and disappear at values not much greater. Default=0.15.

Threshold Determines how much of Color #1 is mixed with Color #2. At 0, only Color #2 is displayed; at 1, only Color #1 is displayed. Default=0.57.

Swap Exchanges the two color components.

Color #1 Represents the color of the indentations.

Color #2 Represents the background stucco color.
Click one of the swatches to display the Color Selector on page 371 and change one of these component colors.

TIP Because the Stucco map is meant to be used as a bump map, usually you don't need to adjust the default colors.

Maps Assigns a map to replace one of the color components. Turning off the check box turns off the associated map (the Stucco map reverts to the associated color component).

Waves Map

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser > Waves

Waves is a 3D map that creates watery or wavy effects. It generates a number of spherical wave centers and randomly distributes them over a sphere. You can control the number of wave sets, the amplitude, and the speed of the waves. This map works effectively as both a diffuse and bump map at the same time. It can also be useful in combination with an opacity map.
Waves map used for the pool in the fountain

**Interface**

<table>
<thead>
<tr>
<th>Waves Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Num Wave Sets: 3</td>
</tr>
<tr>
<td>Wave Len Max: 50.0</td>
</tr>
<tr>
<td>Wave Len Min: 50.0</td>
</tr>
<tr>
<td>Amplitude: 1.0</td>
</tr>
<tr>
<td>Wave Radius: 1000.0</td>
</tr>
<tr>
<td>Wave Len: 50.0</td>
</tr>
<tr>
<td>Phase: 0.0</td>
</tr>
<tr>
<td>Distribution: 3D</td>
</tr>
<tr>
<td>Random Seed: 30159</td>
</tr>
<tr>
<td>Maps</td>
</tr>
<tr>
<td>Color #1: None</td>
</tr>
<tr>
<td>Color #2: None</td>
</tr>
<tr>
<td>Swap</td>
</tr>
</tbody>
</table>

**Num Wave Sets** Specifies how many wave sets are used in the pattern. Wave sets are groups of radially symmetrical waves that originate from randomly.
computed points along the surface of an imaginary sphere inside the object (a circle, in the case of 2D wave distribution). For calm water, set this to a low number. Use a high number for choppy water. Range= 1 to 50; Default=10.

**Wave Radius** Specifies the radius, in 3ds Max units, of the imaginary sphere (3D distribution) or circle (2D distribution) whose surface is the origin of each wave set. A large radius produces large circular wave patterns, while a small radius produces dense, smaller waves. Default=800.

**Wave Len Max and Wave Len Min** Define the interval used to randomly chose each wave center. If these two values are close together, the water appears more regular. If they're farther apart, the water is less regular. Default Max=50.0; Default Min=5.0.

**Amplitude** Adjusts the strength and the depth of the waves by increasing the contrast between the two colors. Default=1.0.

**Phase** Shifts the wave pattern. Animate this parameter to animate the motion of the pattern.

**Distribution 3D/2D** 3D distributes the wave centers on the surface of an imaginary sphere, affecting all sides of a 3D object. 2D distributes the wave in circles centered on the XY plane, which is more appropriate for flat water surfaces such as oceans and lakes.

**Random Number Seed** Provides a seed number to generate the water pattern. The pattern changes with each seed, but all other settings are maintained.

**Swap** Exchanges the colors.

**Color #1 and #2** Click the color swatches to change the colors used in the pattern. Use one color for the wave troughs and the other for the wave peaks. You can also click the map buttons to replace one or both colors with a mapped pattern. The check box enables or disables the map.

**Wood Map**

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser > Wood

Wood is a 3D procedural map that renders a wavy grain-like pattern throughout the volume of an object. You can control the direction, thickness, and complexity of the grain.
Wood map used for the seat of the bench

Wood is primarily intended as a diffuse color map. Two colors assigned to Wood mix to form the grain pattern. Either of the colors can be replaced by other maps.

Wood can also be applied to other map types. When used as a bump map, Wood renders the grain pattern as a three-dimensional engraving of the surface.

Wood mapped to a box and cylinder
Wood used as a bump map

Procedures

To replace a color:

1. Click a color swatch labeled Color #1 or Color #2.
2. In the standard Color Selector on page 371, choose a replacement color. The color updates in the color box and sample slot.

To exchange colors:

- Click Swap. The position of the two colors is reversed in the color boxes and sample slot.

To replace a color with a map:

1. Click a Map bar marked None next to one of the color swatches. This displays the Material/Map Browser.
2. Select a map from the list. The sample slot updates to show the map in place of the color.
Interface

Coordinates rollout

**Tiling** Controls grain complexity or "distortion." By increasing this parameter along a given axis, the grain becomes increasingly compressed and wavy along that axis. Default=1.0 (X, Y, and Z axes).

Box A shows the default on all three axes. Boxes B and C show progressively higher Tile settings for the X axis. Increasing Tile on other axes produces similar effects.

A: Tile, X axis=1.0 (default)
B: Tile, X axis=4.0
C: Tile, X axis=8.0
Grain Thickness=3

Tile, X axis=4.0 for both
Axial Noise=1 (left), 4 (right)
Grain Thickness=3

By combining Tile with Axial Noise, even greater distortion is possible. The bottom left box is the same as B, with Tile at 4.0 on the X axis. The bottom right box adds Axial Noise at 4.0.

Angle Controls grain direction.
Default Grain: Wood is rendered with the grain running along the X axis of the object. This is illustrated by the left cube below. The default angle is 0 for X, Y, and Z axes.
Rotated Grain: By rotating the direction of the grain around an axis, you change the rendered effect. In the right cube, the Y axis is set to 90. This rotates the grain direction 90 degrees around the Y axis so that the grain is now running along the Z axis.
Other Angle Effects: Varying a single angle can create distorted grain effects (cylinder at left). Varying the three angles by a uniform amount keeps the grain running parallel through an object (cylinder at right).

Angle=0,0,0 (defaults) and 0,90,0
Radial, Axial Noise=1 (defaults)
Grain Thickness=3
Angle=0, 30, 0 and 30, 30, 30
Radial, Axial Noise=1 (defaults)
Grain Thickness=3

(See Coordinates Rollout (3D) on page 6278 for a description of the other parameters in this rollout.)

**Wood Parameters rollout**

**Grain Thickness**
Sets the relative thickness of the color bands that make up the grain. Default=7.

Defaults: Grain Thickness=7, Radial Noise=1.0, Axial Noise=1.0
The effect of thickness is relative to the context of the object. A grain that appears unrealistically wide on a small table might be acceptable on a large overhead beam.

Decreasing Grain Thickness creates grain lines that are closer together. The effect can resemble the fine grain of slow-growth hardwoods. At 0, grain disappears, resulting in what can look like composition board made from sawdust.

Increasing Grain Thickness creates grain lines that are farther apart. The effect can resemble tropical woods that grow continuously.

Grain thickness is shown increasing with identical noise settings.

Grain Thickness=1, 3
Radial, Axial Noise=1 (defaults)

Grain Thickness=7 (default), 14
Radial, Axial Noise=1 (defaults)

**Radial Noise** Sets the relative randomness of the pattern on a plane perpendicular to the grain, the circular ring structure (cylinder B). Default=1.0.

**Axial Noise** Sets the relative randomness of the pattern on a plane parallel with the grain, along the length of the grain (cylinder A). Default=1.0.

Noise settings let you set the randomness or "irregularity" of the grain pattern in two directions. Without any noise, rings and grain are uniform and look inorganic (upper-left cylinder). The defaults for both parameters produce moderate irregularities (upper-right cylinder).
Radial, Axial Noise=0,0 and 1,1
Angle Y=90, Grain Thickness=3

A: Radial, Axial Noise=0,2
B: Radial, Axial Noise=2,0
C: Radial, Axial Noise=2,2
Angle Y=90, Grain Thickness=3

Cylinders A and B show each parameter acting alone. Cylinder C shows the combination of the same settings.

Swap Exchanges the position of the colors.

Colors Selects any two colors for the grain pattern. Defaults=brownish yellow for Color #1 and dark brown for Color #2. Either color can be replaced or swapped.

The choice of colors, along with grain pattern, is the primary way to represent different types of wood. In fairly uniform woods like yellow pine or redwood, the two colors are often near the same settings (examples B and C). Lighting also makes a difference in the apparent colors.
A: Default colors

B: Color #1=RGB 160,125,50
Color #2=RGB 170,135,25

C: Color #1=RGB 140,90,0
Color #2=RGB 130,80,50
Grain Thickness=3
Other settings at defaults

Maps Replace colors with maps. The check boxes enable or disable their associated maps.

You can assign maps to one or both of the Wood color slots. Any kind of map can be used, including Wood. The map overrides the assigned color, which has no effect.

The left box uses defaults. The right box is the same, except that Color #1 has been replaced with a Checker map, whose colors have been changed to wood tones.

Left: Default
Right: Color #1 replaced with Checker map
Grain Thickness=3
Other settings at defaults

Compositor Maps

Compositors are meant specifically for compositing other colors or maps. In image processing, compositing images refers to superimposing two or more images to combine them.

Composite Map

Material Editor > Maps rollout > Click a Map button > Material/Map Browser > Composite

The Composite map type is made up of other maps on page 8631, which you layer atop each other using the alpha channel on page 8502 and other methods. For this type of map, you can use overlay images that already contain an alpha channel, or employ built-in masking tools for overlaying only certain parts of a map.
Composite map combines stars, moon, and a glow into the sky.

The controls for a Composite map include the list of the maps it combines along with a blend mode, opacity setting, and mask for each.

Viewports can display the multiple maps in a composite map. For multiple map display, the display driver must be OpenGL on page 8319 or Direct3D on page 8325. The software display driver on page 8317 does not support multiple map display.
Procedures

To assign a map or mask:

1. On a Layer rollout, click an empty map or mask button. These are the large, square buttons labeled “None.” The map button is on the left side; the mask button is on the right.
   The Material/Map Browser opens.

2. Choose a map type either by double-clicking its name in the list, or by highlighting its name and then clicking OK. Make any further changes as necessary for the map type, such as assigning an image file for a Bitmap map.

To change the number of map layers:

- To increase the number of layers, on the Composite Layers rollout, click the button.
  The read-only Total Layers numeric field displays the current number of layers.

- To decrease the number of layers, find the layer to delete and click its (Delete this layer) button.

To change the order of layers:

- Drag a layer by its title bar to a new location. As you drag the layer, a blue line appears where it will be repositioned. This works the same way as reordering any rollouts.
  After you move a layer, the layers are renumbered to remain in order. For example, if there are four layers, and you move Layer 4 above Layer 1, Layer 4 becomes Layer 2, Layer 2 becomes Layer 3, and Layer 3 becomes Layer 4.
Interface

**Composite Layers rollout**

**Total Layers** The numeric field shows the number of map layers. To add a layer at the top of the stack of layers, click the button.

**Layer rollout**

The Composite map uses a separate rollout for each layer's controls, with as many rollouts as there are layers. Each layer rollout is titled with the optional name first, followed by “Layer” and then the layer number.

The layers are applied in order of increasing number; the layering in the material reflects the order of layers in the interface. Layer 1 is lowest; layer 2 is immediately above layer 1, and so on.

The map composites layers in the same order. Layer 2 modifies the output of Layer 1; Layer 3 modifies the output of Layer 2, and so on.
**Hide this layer** When on, the layer is hidden and has no effect on the output. When a layer is hidden, the button looks like this:

**Color Correct This Texture** Applies a Color Correction map on page 6346 to the map and opens the Color Correction map interface. You can use its controls to modify the map colors.

To return to the Composite map interface, click (Go To Parent) on the Material Editor toolbar.

After the Color Correction map is assigned, you can return to it from the Composite map interface by clicking this button again.

[map] To assign a map to the layer, click this button and then use the Material/Map Browser.

Before assigning a map, the button reads “None.” When a map is assigned, the button image is a thumbnail of the map, and clicking it takes you to the parameters for the map.

**Delete this layer** Deletes the layer. This function is undoable.

Available only when the map contains more than one layer.

**Rename this layer** Opens a small dialog for naming or renaming the layer.

By default, each layer is named “Layer #” where # is the layer number. If you name a layer, the text you enter precedes this default name; for example, “Decal Layer 3.” The space between the custom name and the default name is inserted automatically. If you’ve already named a layer, that name appears in the renaming dialog when you open it.

**Duplicate this layer** Creates an exact copy of the layer and inserts it immediately adjacent to the layer.

**Opacity** The relative transparency of the unmasked portions of the layer. At 100, the layer is completely opaque. As you lower the Opacity value, more of the underlying layers show through.
To assign a mask map to the layer, click this button and then use the Material/Map Browser. The mask works the same as the Mask map on page 6338: Black areas are transparent; white areas are opaque; and gray areas allow degrees of transparency. So, for example, if the layer is to be a decal, the decal image area would be white and the rest of the image map would be black, so underlying layers can show through.

After a mask map is assigned, the button image is a thumbnail of the map, and clicking it takes you to the parameters for the map.

To turn off the mask temporarily, click this button. When a mask is hidden, the button looks like this:

 Applies a Color Correction map on page 6346 to the mask map and opens the Color Correction map interface. You can use its controls to modify the map colors.

To return to the Composite map interface, click (Go To Parent) on the Material Editor toolbar.

After the Color Correction map is assigned, you can return to it from the Composite map interface by clicking this button again.

Use the drop-down list to choose how the layer pixels interact with those in underlying layers. In the following descriptions, A refers to the current (front) layer and B refers to the result or output of underlying layers.

<table>
<thead>
<tr>
<th>Blend Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal</td>
<td>Displays A without any blending. This is the default setting.</td>
</tr>
<tr>
<td>Average</td>
<td>Adds A and B and then divides by 2.</td>
</tr>
<tr>
<td>Addition</td>
<td>Adds each A and B pixel.</td>
</tr>
<tr>
<td>Subtract</td>
<td>Subtracts A from B.</td>
</tr>
<tr>
<td>Darken</td>
<td>Compares the values of A and B, and, for each pixel, uses the darker of the two.</td>
</tr>
</tbody>
</table>

Because Layer 1 has no underlying layers, its blend mode setting has no effect.
- **Multiply**: Multiplies the color values of each A and B pixel. Because non-white color channels have values of less than 1.0 (using a range of 0.0 to 1.0), multiplying them tends to darken colors.

- **Color Burn**: Colorizes darker pixels from B with the color from A.

- **Linear Burn**: Same as Color Burn but with less contrast.

- **Lighten**: Compares the A and B pixels at each location and uses the lighter of the two.

- **Screen**: Makes the light areas much lighter, and the darker areas somewhat lighter.

- **Color Dodge**: Colorizes lighter pixels from B with the A color.

- **Linear Dodge**: Same as Color Dodge but with lower contrast.

- **Spotlight**: Like Multiply but with twice the brightness.

- **Spotlight Blend**: Same as Spotlight but also adds ambient illumination to B.

- **Overlay**: Darkens or lightens the pixels depending on the B color.

- **Soft Light**: If the A color is lighter than mid-gray, the image is lightened. If the A color is darker than mid-gray, the image is darkened.

- **Hard Light**: If a pixel color is lighter than mid-gray, screen mode is applied. If a pixel color is darker than mid-gray, multiply mode is applied.

- **Pinlight**: Replaces the B colors depending on the brightness of the A color. If the A color is lighter than mid-gray, B colors darker than the A color are replaced. And vice-versa: If the A color is darker than mid-gray, B colors lighter than the A color are replaced.

- **Hard Mix**: Produces either white or black, depending on similarities between A and B.

- **Difference**: For each pixel pair, subtracts the darker one from the brighter one.

- **Exclusion**: Similar to Difference but with lower contrast.

- **Hue**: Uses the color from A; the value (brightness) and saturation from B.

- **Saturation**: Uses the saturation from A; the value and hue from B.
- **Color**  Uses the hue and saturation from A; the value from B.
- **Value**  Uses the value from A; the hue and saturation from B.

**Mask Map**

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser > Mask

With the Mask map, you can view one material through another on the surface. The mask controls where a second map is applied to the surface.

![Mask map example](image)

Mask map applies labels to the fire extinguisher.

By default, lighter (whiter) areas of the mask are opaque, showing the map. Darker (blacker) areas of the mask are transparent, showing the underlying material. You can use Invert Mask to reverse the mask's effect.
Interface

These are the controls for the Mask map:

**Map** Selects or creates the map to be viewed through the mask.

**Mask** Selects or creates the map to use as a mask.

**Invert Mask** Inverts the effect of the mask.

**Mix Map**

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser > Mix

With the Mix map, you can combine two colors or materials on a single side of the surface. You can also animate the Mix Amount parameter, and draw map morphing on page 8643 function curves to control how the two maps are blended over time.
Mix map blends skull and crossbones with the reflected scene.

Viewports can display both maps in a mix map. For multiple map display, the display driver must be OpenGL on page 8319 or Direct3D on page 8325. The software display driver on page 8317 does not support multiple map display.

See also:

■ Output Rollout on page 6192

Procedures

To change a component color:

1. In the Mix Parameters rollout, click one of the two color swatches to display the Color Selector on page 371.

2. Adjust the color.

To use a map as a component:

1. In the Mix Parameters rollout, click a map button next to one of the two color swatches.
The Material/Map Browser is displayed.

2 Select a map type.

**To exchange the two component colors:**

- In the Mix Parameters rollout, click Swap.

**To control the mix amount:**

- In the Mix Parameters rollout, adjust the Mix Amount value. Mix Amount is the percentage of Color #2 used in the mix.
  You can also control the mix amount by using a map.

**To control the mix amount using a map:**

1 In the Mix Parameters rollout, click the map button next to Mix Amount.
   The Browser appears so you can select a map type.

2 The intensity of pixels in this mixing map controls the mix. When the intensity is close to 0, one of the component colors or maps is visible; when it is close to full intensity, the other component is visible.

**TIP** Using a Noise map for the mixing map can give good effects that have a natural appearance.

In the Mix Parameters rollout, Mix Amount is inactive while a map is assigned to this parameter. If Use Curve is off, the mixing map is used as is. If Use Curve is on, you can shift the effect of the mixing map's gradient ramp, offsetting it one way or the other and revealing more or less of the mix components.

**To control the mix amount using the mix curve:**

1 In the Mixing Curve group, turn on Use Curve.

2 Change the shape of the curve by adjusting the Transition Zone values.
**Interface**

**Swap** Exchanges the two colors or maps.

**Color # 1, Color # 2** Displays the **Color Selector** on page 371 to select the two colors to be mixed.

**Maps** Select or create the bitmaps or procedural maps to be mixed instead of each color.

The check boxes enable or disable their associated maps.

Black areas of the map reveal color #1, and white areas of the map reveal color #2. Gray values reveal intermediate mixes.

**Mix Amount** Determines the proportion of the mix. 0 means only Color 1 is visible on the surface, 1 means only Color 2 is visible. You can also use a map instead of the mix amount. The two colors will mix in greater or lesser degree according to the intensity of the map.
Mixing Curve group

These parameters control how gradual or how sharp the transition between the two colors being mixed will be. (This really only has meaning when you have a map applied to Mix Amount.)

**TIP** Try mixing two standard materials using a noise map as a mask for some interesting mottled effects.

**Use Curve** Determines whether the Mixing Curve effects the mix.

**Transition Zone** Adjusts the level of the upper and lower limits. If the two values are the same, the two materials will meet at a definite edge. Wider ranges give more gradual mixing.

**RGB Multiply Map**

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser > RGB Multiply

The RGB Multiply map is typically used for bump maps on page 6049, where you might want to combine two maps to achieve the correct result.
Left: No bump mapping on the ashtray
Right: RGB Multiply used as a bump map to enhance the texture of the ashtray

This map combines two maps by multiplying their RGB values. For each pixel, the red of one map is multiplied times the red of the second map, the blue times the blue, and the green times the green.

If the maps have alpha channels, RGB Multiply can output either map’s alpha channel, or a new alpha channel created by multiplying the alpha channel values of the two maps.

You can also make one of the maps a solid color. This tints the other map.
Interface

Color #1, Color #2 Click a map button to assign one of the maps. The check box disables or enables the map. To tint one of the maps, turn off the other map and click its color swatch to choose the tint color, using the Color Selector on page 371.

Alpha From group

The buttons in this group let you determine how to generate alpha for the map. If neither map has an alpha channel, these options have no effect.

Map #1 Uses the first map's alpha channel.

Map #2 Uses the second map's alpha channel.

Multiply Alphas Generates a new alpha channel by multiplying the alpha channels of the two maps.

Color Modifier Maps

Color Modifier maps alter the colors of pixels in a material.
Color Correction Map

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser > Color Correction

The Color Correction map provides an assortment of tools for modifying the colors of an incorporated, underlying map, using a stack-based method. Tools for correcting color include monochrome, inversion, custom rewiring of color channels, hue shift, and adjustment of saturation and lightness. Color-adjustment controls in many cases mirror those found in Autodesk Toxik and Autodesk Combustion.

Interface

IMPORTANT The Color Correction map uses a stack-based approach, with modifications applied per rollout, starting at the top of the interface and ending at the bottom. Settings from the Texture rollout are applied first, then the Channels rollout settings are applied to the output of the Texture rollout, and so on. The order is:

1. Texture rollout
2. Channels rollout
3. Color rollout
4. Lightness rollout

Because of this enforced order, it is not possible to reorder the rollouts for this map.
Texture rollout

[color swatch] 3ds Max uses this color if no map is specified. To change the color, click the swatch and use the Color Selector on page 371 controls.

[map button] To specify a map, click this button, initially labeled “None.” After you specify a map using the Material/Map Browser on page 5724, the button label shows the name and type of the map.
TIP If you replace an existing map with the Color Correction map, 3ds Max prompts you to choose whether to keep the old map as a sub-map. If you do so, the old map is placed in this slot.

Channels rollout

[channel operation] Choose the initial operation to be performed on the map color channels:

- **Normal** Passes the color channels unaltered to the Color rollout controls.
- **Monochrome** Converts all color channels to shades of gray.
- **Invert** Replaces the red, green, and blue color channels with their inverses. The inverse for each channel is calculated by subtracting the value from the maximum value: 1.0 in the case of floating-point colors, or 255 for eight-bit channels. So, for example, red changes to cyan (green + blue); green changes to magenta (red + blue); and blue changes to yellow (red + green).
- **Custom** Lets you apply different settings to each channel using the remaining controls on the rollout.

TIP You can use one of the preset channel operations (Normal/Monochrome/Invert) as a starting point for customization. Choose the preset, and then choose Custom. The previous settings remain active and available for changing.

Red/Green/Blue/Alpha Lets you specify channel operations on a per-channel basis. Available only when Custom is the active choice. Otherwise these fields show the current setting, such as Monochrome for the RGB channels.

Use the drop-down list to choose an replacement value or channel for each channel:

- **Red/Green/Blue/Alpha** Replaces the channel with the channel you choose. For example, if you set Blue=Red, the blue component of each pixel takes on the current value of the red component of that pixel.

- **Red (Inverse)/Green (Inverse)/Blue (Inverse)/Alpha (Inverse)** Replaces the channel with the inverse of the channel you choose. For example, if you set Blue=Red (Inverse), the blue component of each pixel takes on the inverse of the current value of the red component of that pixel.

The inverse for each channel is calculated by subtracting the value from the maximum value: 1.0 in the case of floating-point colors, or 255 for eight-bit channels. So, for example, red changes to cyan (green + blue);
green changes to magenta (red + blue); and blue changes to yellow (red + green).

- **Monochrome**  Converts the color channel to grayscale. To determine the grayscale value for a channel, 3ds Max adds the values of the red, green, and blue channels for each pixel and then divides by three. For example, if the RGB values are 0.5, 0.4, and 0.0, then the monochrome value for any channel of that pixel would be 0.3.

- **One**  Sets the channel to the highest possible value; in effect, turns it all the way on. For example, if the original color of a pixel in a 24-bit or 32-bit map is R=50; G=75; and B=100, then the result of setting Green=One would be R=50; G=255; and B=100.

- **Zero**  Sets the channel to the lowest possible value; in effect, turns it off. For example, if the original color of a pixel is R=50; G=75; and B=100, then the result of setting Green=Zero would be R=50; G=0; and B=100.

### Color rollout

This rollout gives you three controls for overall color conversion. These controls work on the output of the Channels rollout. To use the original map, make sure the Channels rollout is set to Normal.

- **Hue Shift**  Lets you change colors using a standard Hue spectrum. Use the slider or the numeric control to determine how to remap colors in the map. To reset to 0, right-click the slider. Range=-180 to 180.

This control works the same as the Hue Shift control in Autodesk Combustion and Autodesk Toxik.

- **Saturation**  The intensity or purity of the map colors. Lowering the Saturation value removes color, causing the image to tend toward grayscale, while raising it intensifies the color. To modify the value, use the slider or the numeric control. To reset to 0, right-click the slider. Range=-100 to 100.

This control works the same as the Saturation control in Autodesk Combustion and Autodesk Toxik.

- **Hue Tint**  Colorizes all non-white map pixels according to the color swatch value. Grayscale values, including black and white, have no effect.

- **Strength**  The degree to which the Hue Tint setting affects the map pixels. Range=0 to 100.
Lightness rollout: Standard

The Standard option on the Lightness rollout gives you two easy-to-use controls:

**Brightness**  The overall luminance of the map image. To modify the value, use the slider or the numeric control. To reset to 0, right-click the slider. Range=-100 to 100.

**Contrast**  The difference between brighter and darker portions of the map image. To modify the value, use the slider or the numeric control. To reset to 0, right-click the slider. Range=-100 to 100.

Lightness rollout: Advanced

The Advanced controls are similar to those available in the Photo Lab feature of Autodesk Toxik. This tool lets you simulate camera exposure and photo-development changes in maps. You can change the exposure to brighten or darken a map in incremental steps, providing perceptually relative uniform changes in luminance. Photo-development adjustments can produce images with different color distribution.

[exposure method]  Choose from the drop-down list the method by which to express exposure:

- **Gain**  The pixel color values are multiplied by this value.

- **F-Stop**  As in photography, increasing by 1 doubles the luminance, and increases gain by a factor of 2.
- **Printer Lights**  A definable setting (see Printer Lights per Stop) where increasing this value by the value of the Printer Lights per Stop setting (N) doubles the luminance (N printer lights=1 f-stop)

**RGB/R/G/B** You can change the settings for all three color channels simultaneously (RGB) and for each channel individually. In addition, you can toggle the settings for the individual channels with the check boxes.

**Gamma/Contrast** The amount of gamma correction can be expressed in terms of contrast or in terms of the usual gamma exponent. Increasing the gamma exponent decreases contrast.

**Pivot** Gamma correction is applied about a pivot value. That is, pixel values equal to the pivot value are left unchanged. This is useful when you want to use gamma correction to change the contrast of an map but do not want to affect a particular luminance level.

**Lift/Offset** The lift is simply a uniform offset added to all the pixel values (different offsets for different color components). Lift is usually applied as the last step of the process and can be used to control the overall brightness of the map.

**Printer Lights per Stop** When using the Printer Lights exposure method, this setting determines the number of printer lights equivalent to one f-stop; that is, the number required to double or halve the exposure.

**Output Map**

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser > Output

With Output map, you can apply output settings to procedural maps, such as Checker or Marble, that don't have these settings.
Interface

Output Parameters rollout

In this rollout, you choose the map to apply the output controls to.

Map  Displays a modal version of the Material/Map Browser so you can choose the map type.
The check box turns the map on or off.

Output rollout

The controls in this rollout are the same as for maps with a built-in output option. See Output Rollout on page 6192.
RGB Tint Map

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser > RGB Tint

RGB Tint adjusts the value of the three color channels in an image. Three color swatches represent these channels. Changing a color swatch adjusts the value of its associated color channel.

The channels are named Red, Green, and Blue for their default colors, but you can assign them any color. You are not limited to variations of red, green, and blue.

Procedures

To tint a map:

1. In the RGB Tint Parameters rollout, click the Map button marked None. The Material/Map Browser is displayed.
2. Select the map you want to tint.
3. Click the R, G, or B color swatch. The Color Selector on page 371 is displayed.
4. Choose a new color. The red, green, or blue value of each pixel in the underlying map changes accordingly.
To change the saturation of one color in an image:

1. Click the R, G, or B color swatch.
2. On the Color Selector, increase or decrease Value to vary the color from light to dark.

To replace one color with another:

1. Click the R, G, or B color swatch.
2. On the Color Selector, increase or decrease Hue to change the color.

**Interface**

![RGB Tint Parameters](image)

R/G/B The red, green, and blue on page 8698 color swatches display the Color Selector on page 371 to adjust the value of the specific channel.

Map Displays the Material/Map Browser to select the map to be tinted. The check box turns the effect of the map on or off.

**Vertex Color Map**

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser > Vertex Color

Vertex Color map makes any vertex coloring applied to an object available for rendering. You can assign vertex colors using the VertexPaint Modifier on page 1959, the Assign Vertex Colors utility on page 6477, or the vertex controls for an editable mesh on page 2203, editable patch on page 2373, or editable poly on page 2258.
Mapping vertex colors

While vertex color assignment is primarily used for special applications, such as game engines or radiosity renderers, you can also use it to create colorful, gradient surface effects. You can also use it in design visualization: Use the VertexPaint Modifier on page 1959 to paint your landscape different colors to represent grass, shrubbery, parking areas, etc., and then use Vertex Color map to use the vertex coloring in your rendered images. Incidentally, when you use the Terrain object's on page 730 Color By Elevation function, 3ds Max assigns a material that uses a Vertex Color map as the diffuse component.

**TIP** To view vertex colors in a viewport, right-click the object, choose Properties from the quad menu, and then turn on Vertex Channel Display in the Display Properties group.

**Procedures**

**To use the vertex color map:**

1. Assign vertex colors to an object.
2. Assign a material to the object, then assign a Vertex Color map to the material's diffuse component.
3. Optionally, if manipulating the map channels with the Channel Info utility on page 6486, choose a map channel or sub-channel to render.
4. Render the scene.
These parameters let you define which map channel or sub-channel is to be rendered. One application is to support usage of the Vertex Color map in conjunction with the Channel Info utility on page 6486.

The settings are interlinked; changing one parameter will change the other two, as appropriate.

**Map Channel** Lets you specify which map channel to use. Range=0 to 99. Default=0.

Notes regarding this setting:

- If you set Map Channel to a channel that doesn't contain any vertex coloring data, attempting to render will generate a Missing Map Coordinates error message. To resolve this, apply vertex coloring to that channel.

- By default, the vertex coloring in map channel 1 is a color gradient derived from the UVW texture coordinates by converting UVW values to RGB values. Thus, at UV=0,0 (the lower-left corner of the map), the coloring is black; at UV=1,0, the coloring is red, and at UV=1,1 (the upper-right corner), the coloring is yellow (red + green=yellow). You can change these colors with a tool such as VertexPaint modifier on page 1959.

- Map Channel cannot be set to a negative value, thus the map doesn't support rendering of the vertex illumination (-1) or vertex alpha (-2) channel.

**Sub Channel** Lets you can specify that the map will use either the Red, Green, or Blue sub-channel of the specified map channel, or all sub-channels.

**Channel Name** After assigning the material with the Vertex Color map to an object with named map or vertex-color channels (see Channel Info Utility on
page 6486), you can click Update, and then, from this drop-down list, choose a named map channel from the object.

**Update** Refreshes the contents of the Channel Name drop-down list. Use Update after applying the material to an object, or after adding channels to the object.

**NOTE** There could be conflicts if one material with a Vertex Color map is assigned to objects with different named Map Channels, where one channel's name may be displayed in preference to another's.

---

**Reflection and Refraction Maps**

These maps, grouped as "Other" in the Material/Map Browser on page 5724, are maps that create reflections and refractions.

**Flat Mirror Map**

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser > Flat Mirror

The Flat Mirror on page 8579 map produces a material that reflects surrounding objects when it is applied to a collection of coplanar faces. You assign it as a material's reflection map on page 6052.
Flat mirror map reflects the ice-cream shop’s interior.

Reflect/Refract maps don’t work well for flat surfaces because each face reflects part of the environment based on where its surface normal points. Using this technique, a large flat face can reflect only a small part of the environment. Flat Mirror automatically generates a reflection that encompasses a larger part of the environment, to better simulate a mirror-like surface.

Rules for Using Flat Mirror

Flat Mirror cannot generate reflections correctly unless you observe these rules:

- Assign Flat Mirror to selected faces only.
  There are two ways to do this. You can make the Flat Mirror material a sub-material of a Multi/Sub-Object on page 6120 material, or you can use the Apply To Faces With ID control.

- If you assign Flat Mirror to multiple faces, the faces must lie in a plane.

- Non-coplanar faces in the same object cannot have the same Flat Mirror material.
  In other words, if you want two different planes of an object to have flat reflections, you must use a Multi/Sub-Object material. Assign Flat Mirror
to two different sub-materials, and assign different material IDs to the to
different planar faces.

- The material ID used by the Flat Mirror sub-material must be unique to
  the coplanar faces in the object.
  If you assign Flat Mirror using Apply to Faces with ID, faces without that
  ID display the nonreflective components (diffuse color, and so on) of the
  material with the Flat Mirror reflection map.

Procedures

To assign a flat mirror to one face of an object:

1 In the Material Editor, create a standard material.
2 Assign a Flat Mirror map as the material's reflection map.
3 In the Flat Mirror Parameters rollout > Render group, turn on Apply To
   Faces With ID, and choose the material ID number the mirrored face will
   have.
4 Follow the next set of steps for assigning the material to the object.

To assign the mirror to a flat surface:

1 Select an object.
2 In the Modify command panel, apply Edit Mesh to the object.
3 Make sure Sub-Object is selected, and choose Face as the sub-object level.
4 Select a single face or multiple faces that lie in a single plane.
5 Assign the faces the material ID you chose for the Flat Mirror map.
6 Assign the material to the object.

To assign a flat mirror using a Multi/Sub-Object material:

1 In the Material Editor, create a Multi/Sub-Object material.
2 Click one of the unused material buttons in the Multi/Sub-Object
   material's parameters.
3 In the new Standard sub-material, open the Maps rollout and click the
   map button for Reflection.
4 In the Material/Map Browser, choose Flat Mirror, and then click OK.
Flat Mirror controls are similar to those for automatic reflection and refraction.

5 Apply Edit Mesh to the object, and then in the stack view area of the **modifier stack display** on page 8187, choose Face as the sub-object level.

6 Select a single face or multiple faces that lie in a single plane.

7 Assign the faces the material ID corresponding to the Flat Mirror sub-material slot.

Using a Multi/Sub-Object material, you can apply Flat Mirror to different faces of the object that are not coplanar. However, faces that are not coplanar must use different sub-material slots, otherwise 3ds Max doesn’t correctly generate the flat mirror reflections.
Interface

Blur group

**Apply Blur** Turns on filtering to blur the maps. Antialiasing is also applied to the Distortion effect, if any, when Apply Blur is turned on.
Blur Affects the sharpness or blurriness of the generated map based on its distance from the object. The farther away the map is, the greater the blurring. Blur is primarily used to avoid aliasing on page 8501. It's a good idea to use a small amount of blurring for all maps in order to avoid the scintillation or aliasing that can occur when pixel details are reduced off in the distance. Default=1.0.

**Render group**

**First Frame Only** The renderer creates the automatic flat mirror only on the first frame.

**Every Nth Frame** The renderer creates the automatic flat mirror based on the frame rate on page 8585 set by the spinner.

**Use Environment Map** When off, environment maps are ignored by the mirror during rendering. It's useful to turn this off when you have mirrors in the scene and you're rotoscoping against a flat screen environment map. A screen environment map does not exist in 3D space the way the other environment-map types do, and will not render properly. Default=on.

**Apply to Faces with ID** Specifies the material ID number where you want the mirror assigned.

You can assign a flat-mirror material to an object without having to make it a component of a Multi/Sub-Object on page 6120 material. The restriction is that the other faces on the object must be able to use the nonmirrored properties of the same material (its diffuse color, and so on). If the other faces need completely different material characteristics, you need to use a Multi/Sub-Object material.

For example, if you have an object, such as a box, with unique material IDs for each side, you can use Apply To Faces With ID to specify the side of the box that will show the mirror reflection. The remaining sides of the box will have the same material characteristics, but without the reflection.

**Distortion group**

To simulate irregular surfaces, you can distort the flat-mirror reflections. Distortion can be based on a bump map or on noise controls built into Flat Mirror material.

**None** No distortion.

**Use Bump Map** Distorts the reflection using the material's bump map.

A flat mirror surface that has a Bump map will appear bumpy, but its reflection won't be distorted by the bumps unless you use this option.
**Use Built-In Noise** Distorts the reflection using the settings in the Noise group.

**Distortion Amount** Adjusts the amount of distortion to the reflected image. This is the only value that affects the amount of distortion. No matter how high the Bump map's Amount spinner is set, or how extreme the Noise settings, if this Distortion Amount is set to 0, no distortion appears in the reflection itself. This control is inactive when None is chosen.

**Noise group**

The controls in this group are inactive unless you choose Use Built-In Noise as the active distortion type.

**Regular** Generates plain noise. Basically the same as Fractal noise with the Levels setting at 1. When the noise type is set to Regular, the Levels spinner is inactive (because Regular is not a fractal function).

**Fractal** Generates noise using a fractal algorithm. The Levels setting determines the number of iterations for the fractal noise.

**Turbulence** Generates fractal noise with an absolute value function applied to it to make fault lines.

**Phase** Controls the speed of the animation of the noise function. A 3D noise function is used for the noise, so that the first two parameters are U and V and the third is phase.

You can animate this parameter to animate the noise effect.

**Size** Sets the scale of the noise function. Smaller values give smaller chunks of noise.

**Levels** Sets the number of fractal iterations or turbulence (as a continuous function).

**Raytrace Map**

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser > Raytrace

Raytrace map provides fully raytraced reflections and refractions. The reflections and refractions it generates are more accurate than those produced by the reflect/refract map on page 6375. Rendering raytraced objects is slower than using Reflect/Refract. On the other hand, Raytrace is optimized for rendering 3ds Max scenes, and you can further optimize it for your scene by excluding specific objects or effects from raytracing.
Raytrace map creates highly reflective and refractive surfaces.

You can also use the Raytrace material on page 6064, which uses the same raytracer to generate accurate, raytraced reflections and refractions. The differences between Raytrace map and Raytrace material are:

- You use Raytrace map as you do other maps. This means you can add raytraced reflections or refractions to any kind of material.
- You can assign Raytrace map to material components other than reflect or refract, although these are the main ways to use this map.
- Raytrace map has more extensive attenuation controls than Raytrace material.
- Raytrace map often renders more quickly than Raytrace material.

Raytrace Map and Raytrace material have the same name because they use the same raytracer and share global parameters.

**NOTE** Raytracing does not always work correctly in orthographic viewports (left, front, and so on). It works correctly in perspective viewports and camera viewports.
Raytracer Parameters Rollout

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser > Raytrace > Raytracer Parameters rollout

This rollout contains the main controls for the Raytrace map on page 6364.

Interface

Local Options group

Enable Raytracing Turns the raytracer on or off. Default=on.
Even with raytracing off, Raytrace material and Raytrace map still reflect and refract the environment, including both the environment map for the scene, and the environment map assigned to the Raytrace material.

Raytrace Atmospherics Turns the raytracing of atmospheric effects on or off. Atmospheric effects include fire, fog, volume light, and so on. Default=on.
Enable Self Reflect/Refract  Turns self reflection/refraction on or off. Default=on.

Can an object reflect itself? For example, a teapot's body reflects the teapot's handle, but a sphere will never reflect itself. If you don't need this effect, you can improve render time by turning off this toggle.

**TIP** If you have a transparent object such as glass, and have self reflect/refract turned on, you don't have to make the object 2-sided on page 8493. The raytracer sees back faces when exiting refractive objects.

**Reflect/Refract Material IDs**  When on, the material reflects effects assigned to material IDs in the renderer's G-buffer on page 8589 on or off. Default=on. By default, Raytrace material and Raytrace map reflect effects assigned to a material's ID, so that G-buffer effects are not lost. For example, if a raytraced object reflects a lamp made to glow with the Video Post Glow filter (Lens Effects Glow), the reflection glows as well.

**Trace Mode group**

With options in this group, you select whether to cast reflected or refracted rays.

**Auto Detect**  If assigned to the material's Reflection component, the raytracer will reflect. If assigned to Refraction, it will refract. If you assign Raytrace to any other component, you have to manually specify whether you want reflected rays or refracted rays. (Default.)

**NOTE**  Auto Detect might fail when you use Raytrace map in a material with a strong bump map. When you use a strong bump map, choose one of the explicit options.

**Reflection**  Casts reflected rays off the object's surface.

**Refraction**  Casts refracted rays into or through the object's surface.

**NOTE**  Raytrace reflects and transmits the IDs in material ID channel on page 5694 (G-buffer on page 8589), so it can create glowing reflections, and so on.

**Local Exclude**  Click to display the local Include/Exclude dialog on page 6092. An object that is excluded locally is excluded from this map only.

**TIP**  Using exclusion lists is one of the best and simplest ways to speed up the raytracer.
Background group

Use Environment Settings  Respects the environment settings of the current scene.

Color Swatch  Overrides the environment settings with the specified color.

Map Button  Overrides the environment settings with the specified map.
By specifying an environment map, you override the environment map for the scene as a whole. Both reflection and refraction use the scene-wide environment map unless you use this option to specify another map. With this control, you can use different environment maps on a per-object basis, or provide an environment to specified objects when the scene as a whole has none.

Raytraced Reflection and Refraction Antialiaser group

Controls in this group let you override the global antialiasing settings for raytraced maps and materials. They are unavailable if antialiasing is turned off globally. To turn on antialiasing globally, choose Rendering > Raytracer Settings to open the Raytracer Global Parameters rollout on page 6666.

On  When on, uses antialiasing. Default=unavailable unless global antialiasing is turned on; on if global antialiasing is turned on.

Drop-down list  Chooses which antialiasing settings to use. There are three options:
- Use Global Antialiasing Settings  (The default.) Uses the global antialiasing settings.
  Click ... to open the Raytracer Global Parameters rollout on page 6666.
- Fast Adaptive Antialiaser  Uses the Fast Adaptive antialiaser, regardless of the global setting.
  Click ... to open the Fast Adaptive Antialiaser dialog on page 6095.
- Multiresolution Adaptive Antialiaser  Uses the Multiresolution Adaptive antialiaser, regardless of the global setting.
  Click ... to open the Multiresolution Adaptive Antialiaser dialog on page 6097.

When you change settings for an antialiaser locally, you don’t affect the global settings for that antialiaser.
Raytrace: Attenuation Rollout

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser > Raytrace > Attenuation Rollout

When a ray is reflected off an object or refracted through it, by default the ray travels through space forever, with no attenuation. The controls in this rollout allow you to attenuate rays, so their strength diminishes over distance.

In the Raytrace map on page 6364, attenuation is implemented by a clipping algorithm. Objects beyond the maximum attenuation range aren’t even considered by the raytracer. Because of this, assigning attenuation can speed up rendering time.

**Interface**

![Attenuation Rollout Interface](image)

**Falloff Type** Choose the falloff to use.
- **Off** Turns off attenuation. (Default.)
- Linear  Sets linear attenuation. Linear attenuation is calculated between the start and end range values.

- Inverse Square  Sets inverse square attenuation. Inverse square attenuation is calculated beginning at the start range, and doesn’t use the end range. Inverse square is the actual attenuation rate for light in the real world. However, it doesn’t always give the effect you want in a rendered scene.

- Exponential  Sets exponential attenuation. Exponential attenuation is calculated between the start and end range values. You also specify the exponent to use.

- Custom Falloff  Specifies a custom curve to use for attenuation (falloff).

Start Range  The distance in world units where attenuation begins. Default=0.0.

End Range  Sets the distance in world units where the ray is fully attenuated. Default=100.0.

This is not used by inverse square attenuation.

Exponent  Sets the exponent used in exponential falloff. Default=2.0.

This is used only by exponential attenuation.

Color

These controls affect the behavior of light rays as they attenuate out. By default, as a ray fades out, it is rendered as the background color.

You can set a custom color instead.

Background  As the ray attenuates out, returns the background (either the scene’s background or the background specified locally in the Raytracer Parameters rollout) rather than the actual color of what the reflected/refracted ray sees. (Default.)

Specify  Sets the color that is returned by the ray as it attenuates out.

If you choose not to use the background color, black or gray usually work best as the attenuation color.

Custom Falloff group

These controls are inactive unless the Falloff Type is set to Custom Falloff.

Custom Falloff  Uses the falloff curve to determine the falloff between the start and the end ranges.
These are the controls for custom attenuation. The custom attenuation curve is at the left. The gray scale bar below the curve shows how the curve will affect the falloff as light rays diminish in strength.

**Near** Sets the strength of the reflected/refracted ray at the start range distance. This is a normalized percentage that can range from 0.0 to 1.0. Default=1.0.

**Control 1** Controls the shape of the curve near the curve start. Default=0.667.

**Control 2** Controls the shape of the curve near the curve end. Default=0.333.

**Far** Sets the strength of the reflected/refracted ray at the end range distance. This is a normalized percentage that can range from 0.0 to 1.0. Default=0.0.

**Raytrace: Basic Material Extensions Rollout**

Material Editor > Maps rollout > Click a Map button > Material/Map Browser > Raytrace > Basic Material Extensions Rollout

This rollout contains controls for fine-tuning the effect of the Raytrace map on page 6364.

**Interface**

![Image of Raytrace: Basic Material Extensions Rollout](Image)

**Reflectivity/opacity** These controls affect the intensity of the raytracer's results.

- **Spinner** Controls the amount of raytracing used by the material it is assigned to. Analogous to the Output Amount parameter in the Output rollout of the Bitmap map type on page 6213.

- **Map button** Assigns a map that controls the amount of raytracing. You can vary the amount of raytracing used over the surface of the object.
Tint With these controls, you can tint the colors returned by the raytracer. Tinting applies only to reflected colors; it doesn't affect the material's diffuse component.

- **Check box**  
  Enables or disables the map.

- **Tint**  
  Turns basic tinting on or off. Default=off.

- **Color swatch**  
  Assigns a tint color for reflections. Default=white.

- **Amount spinner**  
  Sets the amount of tinting used. Default=1.0.

- **Map button**  
  Assigns a map to use for tinting. You can vary the tint colors over the surface of the object.

- **Check box**  
  Enables or disables the map.

**Bump Map Effect**  
Controls the effect of a bump map on rays that the surface reflects and refracts. For example, you might want to make a glass object highly bumpy, but reduce the bump effect on refracted parts of the scene.

*Bump Map Effect equals 1.0.*

The refraction of tiles behind the glass is distorted by the bump map.
Bump Map Effect equals 0.0.
The refraction of tiles behind the glass is not distorted.

Bump Map Effect is active only when raytracing is enabled.

**Raytrace: Refractive Material Extensions Rollout**

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser > Raytrace > Refractive Material Extensions Rollout

With the controls in this rollout, you can fine-tune the effect of the Raytrace map on page 6364 on a material's refraction component.
Interface

Internal Density Effects

Color With these controls, you can specify a transmission color based on thickness. The density color gives the appearance of color within the object itself, like tinted glass.

■ Enable Turns color density on or off.

■ Color swatch Displays a Color Selector on page 371. Choose the transmission color.

■ Amount Controls the amount of density color. Reducing this value reduces the density color effect. Range=0 to 1.0. Default=1.0.

■ Color Map Assigns a map to the density color component. Use the check box to enable or disable the map.

■ Start and End A thin piece of tinted glass is mainly clear, while a thick piece of the same glass has more color. Start and End Distance, expressed in world units, controls help you simulate this effect. Start is the position in the object where the density color begins to appear (Default=0.0). End
is the position in the object where the density color reaches its full Amount value. To have a lighter effect, increase the End value. To have a heavier effect, reduce the End value.

**Fog** Density fog is also a thickness-based effect. It fills the object with a fog that is both opaque and self illuminated. The effect is like smoke trapped in a glass, or wax at the tip of a candle. Colored fog in tubular objects can resemble neon tubes.

- **Enable**  Turns fog on or off.

- **Color swatch**  Displays a Color Selector on page 371 for choosing the fog color.

- **Amount**  Controls the amount of density fog. Reducing this value reduces the density fog effect and makes the fog translucent. Range=0 to 999999.0. Default=1.0.

- **Color Map**  Assigns a map to the fog component. Use the check box to enable or disable the map.

- **Start and End**  Start and End Distance controls, expressed in world units, adjust the fog effect based on the object's dimensions. Start is the position in the object where the density fog begins to appear (default=0.0). End is the position in the object where the density fog reaches its full Amount value. To have a lighter effect, increase the End value. To have a heavier effect, reduce the End value.

**Render objects inside raytraced objects**  Turns the rendering of objects inside raytraced objects on or off. Default=on.

**Render atmospherics inside raytraced objects**  Turns the rendering of atmospheric effects inside raytraced objects on or off. Atmospheric effects include fire, fog, volume light, and so on. Default=on.

**Treat Refractions as Glass (Fresnel effect)**  When on, applies a Fresnel effect to the refraction. This can add a bit of reflection to the refracting object, depending on the viewing angle of the object. When off, the object is refractive only. Default=on.

**Reflect/Refract Map**

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser > Reflect/Refract
The Reflect/Refract map produces a reflective or refractive surface. To create reflection, assign this map type as the material’s reflection map on page 6052. To create refraction, assign it as the refraction map on page 6054.

NOTE A reflective object can reflect another reflective object. In the real world, this creates a virtually infinite number of interreflections. In 3ds Max, you can set the number of interreflections within a range from 1 to 10. You set this Rendering Iterations parameter on the Render Setup dialog on page 6539.

This map works by using six renderings in the form of a cube that surrounds the objects. Reflect/Refract views the cubic maps from the perspective of the pivot point on page 8686 of the object, mapping them onto the object’s surface as a spherical reflection map.

You can choose to generate the cubic maps automatically, or to load previously created maps.

A reflective surface reflects the surrounding maps like a mirror. A refractive surface creates the illusion that the surrounding maps are seen through the surface.
NOTE Reflect/Refract is meant to be used with curved or irregularly shaped objects. For mirror-like flat surfaces that you want to reflect the environment accurately, use Flat Mirror on page 6358 material. For more accurate refractions, especially for an object in a refractive medium (such as a pencil in a glass of water), use Thin Wall Refraction material on page 6382.

Automatic Cubic Maps

When you choose automatic cubic maps, 3ds Max generates the maps based on the perspective of the mapped object’s pivot point. Automatic maps are based on the geometry of the scene.

The advantage to using automatic maps is that the six views are automatically generated at rendering time and can be easily updated for each frame of an animation. The disadvantage is that regenerating the maps increases rendering time. In addition, the maps exist only for the rendering and can't be edited or otherwise manipulated.

In the Material Editor, automatic reflections or refractions reflect or refract the background of the sample slot.

Assigning Cubic Maps

When you choose to load cubic maps from files, you use the controls in the From File group. The advantage to using From File is that the bitmap files already exist and take less rendering time. In addition, you can edit the bitmap images. The disadvantage is that it's more difficult to use bitmaps to render an animation because first you need to create the animated bitmaps.

IMPORTANT Assigned cubic maps must be square, and each of the six maps must be the same size.

You can automatically load six bitmaps at once if the six bitmaps have valid cubic-map file names. The first part of all six file names must be the same, and the last part is an underscore followed by a two-letter abbreviation of the map position, as shown in the following table:

<table>
<thead>
<tr>
<th>Last Part of Cubic Map File Name</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>_UP</td>
<td>Up</td>
</tr>
<tr>
<td>_DN</td>
<td>Down</td>
</tr>
</tbody>
</table>
For example, if you have six bitmaps on disk, labeled `view_up.bmp`, `view_fr.bmp`, `view_lf.bmp`, and so on, when you click one of the file buttons and choose the bitmap for that position, all six views are loaded.

If you select a bitmap whose name doesn't follow the convention, or you select one with a valid cubic-map name but assign it to the wrong button, only that bitmap will be loaded.

Since all assigned bitmaps must be the same size, when you assign a new bitmap to one of the windows, the sample slot doesn't update automatically. This avoids generating an error message each time you assign a bitmap. Once you've assigned all six maps and are sure they are square and the same size, click the Reload button to update all of the maps and redisplay the sample slot.

You can also use the Reload button to see your changes after you've edited one of the cubic maps by using a paint program.

**Rendering Cubic Maps**

The controls in the Render Cubic Map Files group let you generate the maps automatically and save them to disk. Use the To File button to specify the folder and file name of the Up (_UP) bitmaps. Click Pick Object and Render Maps, and then click the object to map. 3ds Max creates the files and also assigns them to the six From File map buttons.

Rendering cubic maps has the same effect as automatic with the advantage that map rendering doesn't have to take place at scene rendering time. The disadvantage is that you can't create an automatically animated reflections or refractions this way.
Using Animated Cubic Maps

The cubic maps can be animations instead of bitmaps. Be sure that each is square and all have the same resolution. If you want the animated reflections to match animated changes in the scene, use automatic maps and set them to render every Nth frame.

Procedures

To generate and save cubic maps:

1. In the Source group, choose From File.

2. In the Render Cubic Map Files group, click the button next to To File. A file dialog is displayed. Type a name for one of the six cubic bitmap files. You're specifying the name of the Up bitmap. There are two ways to do this:
   - Specify the entire file name; for example, myview_up.bmp.
   - Specify the file prefix and extension only; for example, myview.bmp.

   **IMPORTANT** You must specify at least a prefix and extension. The "_UP" is added automatically.

3. Click Pick Object and Render Maps.

4. Click an object in your scene where you want the six views rendered. This is usually the same object where you will apply the material, but it doesn’t have to be.

   After selecting the object, a window opens temporarily that shows the six views as they render and are saved to disk. Their file names then appear on the six buttons in the From File group. Each of the six file names is identical, except for a two-letter suffix indicating the direction of the rendered view.
**Source** Chooses the source of the six cubic maps.

**Automatic** Automatically generates by looking out in six directions from the pivot of the object with the material, then mapped onto the surface during rendering.
rendering. When on, the options in the Automatic group are active, letting you choose whether the maps will be generated only once, or regenerated at specified frames in the animation.

**From File** When on, you can specify the bitmaps to use.

When From File is active, the controls in the Render Cubic Map Files group are also available. You can generate the six cubic reflection maps automatically and save them to files, where you can load them with the From Files controls.

**Size** Sets the size of the Reflect/Refract maps. The default value of 100 produces distinct images. Lower values lose progressively more detail.

**Use Environment Map** When off, environment maps are ignored by Reflect/Refract map during rendering. It's useful to turn this off when you have mirrors in the scene and you're rotoscoping against a flat screen environment map. A screen environment map does not exist in 3D space the way the other environment-map types do, and will not render properly.

**Blur group**

**Apply** Turns on filtering to blur the maps.

**Blur Offset** Affects the sharpness or blurriness of the map without regard to its distance from the object. Use Blur Offset when you want to soften or defocus the details in a map to achieve the effect of a blurred image.

**Blur** Affects the sharpness or blurriness of the generated map based on its distance from the object. The farther away the map is, the greater the blurring. Blur is primarily used to avoid aliasing on page 8501. It's a good idea to use a small amount of blurring for all maps in order to avoid the scintillation or aliasing that can occur when pixel details are reduced off in the distance. Default=1.

**Atmosphere Ranges group**

If your scene contains environmental Fog on page 7182, the cubic maps must have near and far range settings to properly render the fog from the point of view of the object assigned the material. The Near and Far spinners in this group let you specify a fog range relative to the object.

**Near** Sets the near range for fog.

**Far** Sets the far range for fog.

**Get From Camera** Uses the Near and Far atmosphere range settings of a camera in the scene. Click this option, and then select the camera.
These values aren't dynamically linked to the camera object. They are simply copied from the camera's range values at the time you click the camera. If the camera's range values later change, the map's Near and Far values remain the same.

**Automatic group**

This controls are active only when Automatic is the active source for the Reflect/Refract maps.

**First Frame Only** Tells the renderer to create automatic maps only on the first frame.

**Every Nth Frame** Tells the renderer to create animated auto maps based on the frame rate on page 8585 set by the spinner.

**From File group**

These controls are active when From File is active as the Reflect/Refract source. Here you assign the six bitmaps to be used as the cubic maps.

**Up / Down / Left / Right / Front / Back** Assigns one of the six cubic maps. If the map is one of a set of six with the correct file name, all six are loaded. If the map doesn't follow file naming conventions, or you assign it to a button of a different position (_UP to Front, for example), only that map is assigned. You must assign the others manually.

**Reload** Reloads the assigned maps and updates the sample slot.

You can edit one or more of the cubic maps using a paint program, then click Reload to update the material and the scene.

**Render Cubic Map Files group**

**To File** Choose a file name for the Up map (_UP).

**Pick Object and Render Maps** Active when you choose a file. Click to turn on, then select the mapped object to render the six cubic maps. Assign the cubic maps to the six From File buttons.

**Thin Wall Refraction Map**

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser > Thin Wall Refraction
Thin Wall Refraction simulates the "jog," or offset effect, you find when you view part of an image through a plate of glass. For objects that model glass, such as a Box in the shape of a window pane, this map is faster, uses less memory, and provides a much better visual effect than the Reflect/Refract map.

**TIP** At 100% refraction and opacity, you can see no diffuse color or mapping, and there is not much illusion of a refractive material. The effect is invisible. In the Maps rollout of the parent material, set Refraction Amount to 50%, and in the Basic Parameters rollout, set Opacity to a value greater than 0.

**Procedures**

To assign the Thin Wall Refraction map to a material:

1. Click the Map button for Refraction in the material's Maps rollout.
2. In the Material/Map Browser, choose Thin Wall Refraction.
3. Adjust the map's parameters.
4. In the parent material, set the Refraction Map Amount to 50%.
Assign the material to an object.

**Interface**

**Blur group**

These controls are for antialiasing.

**Apply Blur** Turns on filtering to blur the maps.

**Blur** Affects the sharpness or blurriness of the generated map based on its distance from the object. The farther away the map is, the greater the blurring. Blur is primarily used to avoid aliasing on page 8501. It's a good idea to use a small amount of blurring for all maps in order to avoid the scintillation or aliasing that can occur when pixel details are reduced off in the distance. Default=1.0.

**Render group**

These controls affect how the refraction should behave in animations.

**First Frame Only** Tells the renderer to create the refracted image only on the first frame.

This is the fastest option. You can use it if the camera and refractive object don't move.
**Every Nth Frame** Tells the renderer to regenerate the refracted image based on the frame rate on page 8585 set by the spinner. Every single frame provides the most accurate result, but takes longest to render.

**Use Environment Map** When off, environment maps are ignored by the refraction during rendering. It's useful to turn it this off when you have refractions in the scene and you're rotoscoping against a flat screen environment map. A screen environment map does not exist in 3D space the way the other environment map types do, and will not render properly. Default=on.

**Refraction group**

These controls are specific to the Thin Wall Refraction effect:

**Thickness Offset** Affects the size of the refractive offset, or jog effect. At 0, there's no offset, and the object can appear invisible in the rendered scene. At 10.0, the offset is at its greatest. Range from 0.0 to 10.0; Default=0.5.

**NOTE** The IOR (index of refraction) spinner in the parent material's Extended Parameters rollout also affects the offset effect.

**Bump Map Effect** Affects the magnitude of refraction due to the presence of a bump map. This parameter multiplies the current bump map Amount in the parent material. Reduce this value to reduce the effect of the secondary refraction; increase this value to increase the effect. If there is no bump map assigned, this value has no effect. Default=1.0.

If there is unevenness in the surface of the glass, there is a secondary refraction. Thin Wall Refraction generates this secondary refraction if the material also has a bump map present. The algorithm guesses at the scaling of the secondary refraction, and can create too large an effect. If this happens, scale the effect down by reducing this value to less than one.

**mental ray Shaders**

In mental ray, a shader is a function that calculates light effects. There can be shaders for lights, cameras (lens shaders), materials, shadows, and so on.
NOTE In 3D modeling, the term “shader” typically refers to an algorithm that specifies how a surface responds to light. (The shaders for standard 3ds Max fall into this category.) With the mental ray renderer, “shader” has a more general sense of any algorithm used in rendering.

The mental ray renderer on page 6675 can render most types of 3ds Max materials and maps. See 3ds Max Materials in mental ray Renderings on page 6683. In addition, if you have enabled mental ray extensions (see mental ray Preferences on page 8363), you can apply a variety of shaders to materials. Materials designed for use with the mental ray renderer have specific components to which you can assign a shader. And for standard 3ds Max material types, the mental ray Connection rollout on page 5763 lets you add mental ray shading.

WARNING When you use the scanline renderer, mental ray shaders typically appear as black or white surfaces, or they are ignored entirely.

You assign a mental ray shader the same way you do a map. In the Material/Map Browser on page 5724, mental ray shaders appear with a yellow icon, instead of the green icon used for maps.

mental ray maps in the browser’s list are shown with yellow icons.

The shaders listed in the Browser depend on which type of shader component you have chosen in the Material Editor. For example, when you assign a Surface shader, the Browser lists a variety of shaders and standard 3ds Max maps. But when you assign a more special-purpose Contour shader, the Browser lists only those shaders that generate contour lines.
Other kinds of special-purpose shaders include shaders for cameras and lights. Buttons to assign camera shaders are found on the Render Setup dialog > Camera Effects rollout on page 6747, and the controls to assign light shaders are on a light object's mental ray Light Shader rollout on page 5464. This rollout appears only on the Modify panel, not the Create panel.

The shaders listed in the Browser come from several libraries that are provided with 3ds Max. Shaders created specifically for 3ds Max are described in this document. Shaders provided with the mental images or lume shader libraries have their own online documentation.

In addition to the shaders described in the topics that follow, 3ds Max includes these shaders:

- The Car Paint on page 5922 material is also available as a shader, with the same set of parameters.
- The mr Sun on page 5524, mr Sky on page 5527, and mr Physical Sky on page 5532 shaders are components of the mental ray Sun & Sky on page 5513 solution.
- Volume shading on page 6710 can be applied to a camera or material.
- Displacement shading on page 6713 adds surface detail to models at render time.
- Contour shading on page 6714 lets you render vector-based contour lines, or outlines.

When you wire the parameters of an object whose material has mental ray shaders assigned, names of shader parameters might differ from those in the Material Editor interface. Also, parameters not supported by 3ds Max might appear as blanks in the wiring menu.

If your installation includes shader libraries other than those listed in this reference (whether obtained from a third-party source, or custom written), then the Browser might list those shaders as well. Documentation for third-party or custom shaders should come from the shader's provider.
Where Shaders Are Installed

Shaders provided with 3ds Max are installed in the subdirectory \mentalray\shaders_standard\, below the 3ds Max root directory. The \include folder is for the MI include files, and the \shaders folder is for the DLLs.

Third-party shaders should not be installed in \shaders_standard. They should be installed either in \shaders_3rdparty or \shaders_autoload. If a third-party shader is present in \shaders_autoload, it is loaded automatically when you start 3ds Max. If a third-party shader is present in \shaders_3rdparty, you must update the file 3rdparty.mi so it explicitly loads the shader. The MI file \shaders_3rdparty\3rdparty.mi contains comments that explain how to add load statements.

NOTE Shaders listed in the MI file are loaded in reverse order: that is, from the bottom of the list to the top.

mental images Shader Libraries

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser > Pick a mental ray shader other than a custom 3ds Max shader or a lume shader.

Note: Shaders appear in the Browser only if the mental ray renderer is the currently active renderer.

The shaders provided with standard libraries from mental images are meant for use with the mental ray renderer on page 6675. There are three standard libraries: Base Shaders (base.mi), Physics Shaders (physics.mi), and Contour Shaders (contour.mi).

NOTE In the mental image libraries, the names of base shaders have the prefix “mib_” and the names of contour shaders have the prefix “contour_”. These prefixes don't appear in the 3ds Max user interface or in the table that follows. (Names of physics shaders have no conventional prefix.)

The following table lists the mental images library shaders provided with 3ds Max.
**TIP** When you follow a link to the documentation for mental images library shaders, scroll up a bit in your browser. The links tend to go directly to the shader’s declaration code, and often there are some introductory paragraphs directly above the code. If the link goes to the beginning of a section, scroll down instead.

<table>
<thead>
<tr>
<th>Shader</th>
<th>Library</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ambient/Reflective Occlusion</td>
<td>base</td>
</tr>
<tr>
<td>Combi</td>
<td>contour</td>
</tr>
<tr>
<td>Contour Composite</td>
<td>contour</td>
</tr>
<tr>
<td>Contour Contrast Function Levels</td>
<td>contour</td>
</tr>
<tr>
<td>Contour Only</td>
<td>contour</td>
</tr>
<tr>
<td>Contour PS (PostScript)</td>
<td>contour</td>
</tr>
<tr>
<td>Contour Store Function</td>
<td>contour</td>
</tr>
<tr>
<td>Curvature</td>
<td>contour</td>
</tr>
<tr>
<td>Depth Fade</td>
<td>contour</td>
</tr>
<tr>
<td>DGS Material Photon</td>
<td>physics</td>
</tr>
<tr>
<td>Dielectric</td>
<td>base</td>
</tr>
<tr>
<td>Factor Color</td>
<td>contour</td>
</tr>
<tr>
<td>Layer Thinner</td>
<td>contour</td>
</tr>
<tr>
<td>Light Infinite</td>
<td>base</td>
</tr>
<tr>
<td>Light Point</td>
<td>base</td>
</tr>
<tr>
<td>Shader</td>
<td>Library</td>
</tr>
<tr>
<td>-----------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Light Spot</td>
<td>base</td>
</tr>
<tr>
<td>Opacity</td>
<td>base</td>
</tr>
<tr>
<td>Parti Volume</td>
<td>physics</td>
</tr>
<tr>
<td>Photon Basic</td>
<td>base</td>
</tr>
<tr>
<td>Reflect</td>
<td>base</td>
</tr>
<tr>
<td>Refract</td>
<td>base</td>
</tr>
<tr>
<td>Shadow Transparency</td>
<td>base</td>
</tr>
<tr>
<td>Simple</td>
<td>contour</td>
</tr>
<tr>
<td>Texture Remap</td>
<td>base</td>
</tr>
<tr>
<td>Texture Rotate</td>
<td>base</td>
</tr>
<tr>
<td>Texture Wave</td>
<td>base</td>
</tr>
<tr>
<td>Transmat</td>
<td>physics</td>
</tr>
<tr>
<td>Transmat Photon</td>
<td>physics</td>
</tr>
<tr>
<td>Transparency</td>
<td>base</td>
</tr>
<tr>
<td>Two Sided</td>
<td>base</td>
</tr>
<tr>
<td>Width From Color</td>
<td>contour</td>
</tr>
<tr>
<td>Width From Light</td>
<td>contour</td>
</tr>
<tr>
<td>Width From Light Dir</td>
<td>contour</td>
</tr>
</tbody>
</table>
NOTE You can also access the mental images shader help by choosing Help > Additional Help, opening the mental ray 3.6 Reference, and then highlighting mental ray Shader Reference on the Contents panel.

Shaders in the LumeTools Collection

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser > Pick a shader with “(lume)” in its name.

Note: Shaders appear in the Browser only if the mental ray renderer is the currently active renderer.

The LumeTools Collection of shaders provide a variety of naturalistic effects when used with the mental ray renderer on page 6675. In the Material/Map Browser, the name of these shaders is followed by “(lume).” These are the lume shaders provided with 3ds Max:

- Beam
- Distortion
- Edge and Edge Shadow
- Facade
- Glass
- Glow
- Landscape
- Metal
- Mist
- Night
- Ocean
- Stain
- Submerge
- Translucency
- Water Surface
- Wrap Around
NOTE You can also access the lume shader help by choosing Help > Additional Help, opening the mental ray Reference, and then highlighting LumeTools Collection on the Contents panel.

Connect Parameter to Shader Dialog (mental ray)

Material Editor > mental ray Connection rollout > Click a shader button. > Material/Map Browser > Pick a mental ray shader that returns multiple values.

Material Editor > Shader controls > Click a shader button. > Material/Map Browser > Pick a mental ray shader that returns multiple values.

Material Editor > DGS material > Click a shader button. > Material/Map Browser > Pick a mental ray shader that returns multiple values.

Material Editor > Shader controls > Click a shader return parameter button (to the right of the main shader button).

Note: The mental ray Connection rollout is available in the Material Editor only if you have enabled the mental ray extensions by using the mental ray Preferences panel. In addition, shaders don’t appear unless the mental ray renderer is the currently active renderer.

Some mental ray shaders return multiple values. If you choose one of these, a Connect Parameter To Shader dialog appears. Choose one of the return values in the list, and then click OK.

IMPORTANT UV Coordinates on page 6430 and XYZ Coordinates on page 6434 are the only shaders with multiple return values provided with 3ds Max. You might encounter multiple return values in shaders provided with other shader libraries or custom shader code.

The components for some mental ray materials and shaders can be assigned other shaders. For these components, the main shader button is accompanied on the right by a small button. If no shader is assigned, or the shader assigned has only a single return value, the button is disabled and shows a dot in the middle. If the shader assigned can return multiple values, text appears in this button, and a tooltip shows the parameter name. Clicking the button displays the Connect Parameter To Shader dialog, allowing you to change the parameter being used.
Interface

List of return values Lists the parameters that the shader returns. The type of each parameter is indicated in parentheses, following the parameter's name.

Show Compatible Only When on the list shows only the return values whose type is compatible with the component the shader is assigned to. When off, shows all return values from the shader, whether they are compatible or not. Default=on.

3ds Max Custom Shaders

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser > Pick a mental ray shader other than a mental images library shader or a lume shader.

Note: Shaders appear in the Browser only if the mental ray renderer is the currently active renderer.

The topics in this section describe custom shaders for use with the mental ray renderer on page 6675, and 3ds Max.
3D Displacement Shader (mental ray)

Material Editor > mental ray Connection rollout > For the Displacement component, turn off the lock button. > Click the button for the Displacement component. > Material/Map Browser > 3D Displacement (3dsmax)

Material Editor > mental ray material > Click the button for the Displacement component. > Material/Map Browser > 3D Displacement (3dsmax)

Note: Shaders appear in the Browser only if the mental ray renderer is the currently active renderer.

A 3D Displacement shader displaces the geometry of surfaces. The effect is similar to displacement mapping of a standard material. You can apply mental ray displacement to any kind of object, unlike standard displacement mapping, which is restricted to surface models (meshes, patches, polys, and NURBS surfaces).

Displaced surfaces are smooth if the displaced polygons share normals; otherwise, the displaced surfaces are faceted. Also, unless normals are shared, faces can become separated in the displaced mesh. To prevent this, make sure adjacent surfaces belong to the same shading group.

When the mental ray renderer is the active renderer, mental ray displacement is the only displacement method used, unless your scene includes a Displace modifier on page 1313, which always uses standard 3ds Max displacement.

TIP Before you render, you can disable or enable displacement by using the Displacement toggle in the Options group on the Common Parameters rollout on page 6568.

Global settings for the mental ray displacement method are in the Displacement group on the Render Setup dialog > Renderer panel > Shadows And Displacement rollout on page 6756.

See also:

■ mental ray Displacement on page 6713

■ mental ray Connection Rollout on page 5763

■ mental ray Material on page 5951
NOTE The button to the right of the Factor and Direction Strength controls is a shortcut shader button. Clicking one of these buttons displays the Material/Map Browser on page 5724 so you can assign a shader to this component. When a map or a shader has been assigned to a component, this button displays the letter “M,” and the comparable button on the Shaders rollout displays the map or shader name.

Object Independent When on, the displacement effect is independent of the size of the object’s bounding box. When off, the displacement effect is scaled according to the size of the object. Default=on.

Scaling the displacement based on object size is the standard behavior for regular 3ds Max displacement mapping.

Displacement Length This is the length of displacement when Object Independent is on, the extrusion map is at 100 per cent (white) and the Extrusion Strength equals 1.0. Lower gray levels in the extrusion map, or other
values of Extrusion Strength, scale the amount of displacement. When Object Independent is off, this value is disregarded. Default=1.0.

**Extrusion Strength** Controls the height of the displacement. This value is a multiplier: at the default value of 1.0, the map's effect is unchanged. Greater values increase the effect of the map, and lower values decrease it. Default=1.0.

**Extrusion Map** Click to display the Material/Map Browser on page 5724 and choose a map to use for the displacement. Displacement maps apply the gray scale of the map to generate the displacement. Lighter colors in the 2D image push outward more strongly than darker colors, resulting in a 3D displacement of the geometry.

**Direction Strength** Controls the strength of the direction shader. Default=0.0.

**IMPORTANT** Adding a direction shader has no visible effect unless you set Direction Strength to be greater than its default value of zero. (Direction Strength values less than zero have no effect.)

**Direction Map** Click to display the Material/Map Browser on page 5724 and choose a shader to use for the map direction. The direction of the displacement is perturbed according to the RGB values of the shader output or map pixels. Red values offset in the U axis, Green values offset in V, and Blue values offset in W (using the object-local UVW coordinates).

**Shaders rollout**

The controls on this rollout let you assign a map or shader to the Factor or Direction Strength parameters. Click the button for a component to display the Material/Map Browser on page 5724 and assign the map or shader. Use the toggle at the left to turn the effect of the map off or on.

The button to the right of each main shader button is for shaders that can return multiple parameters. If a shader that returns multiple parameters is assigned to the component, the button's tooltip shows the parameter name. Clicking the button displays a Connect Parameter To Shader dialog on page 6392, which lets you change which parameter is being used.

**IMPORTANT** UV Coordinate on page 6430 and XYZ Coordinate on page 6434 are the only shaders with multiple return values provided with 3ds Max. You might encounter multiple return values in shaders provided with other shader libraries or custom shader code.
Bump Shader (mental ray)

Material Editor > mental ray material > Click the button for the Surface or Bump component. > Material/Map Browser > Bump (3dsmax)

Note: Shaders appear in the Browser only if the mental ray renderer is the currently active renderer.

The Bump shader provides bump mapping for the mental ray renderer. Bumps are created by perturbing face normals before the object is rendered, using the same method as bump mapping on page 6049 for the scanline renderer.

**WARNING** Although you can assign a Bump shader to the Surface component, if you assign only a Bump shader, the surface will render as black. For the Surface component, use the Bump shader in a Shader List on page 6420, or for the mental ray material on page 5951, use the Bump component itself.

Interface

Bump (3dsmax) Parameters rollout

**Multiplier** Adjust the bump effect by multiplying the map values. Negative Multiplier values reverse the bump effect: hollow areas now protrude, and raised areas become hollow. Default=1.0.

**Map** Click to display the Material/Map Browser on page 5724 and choose a map to use for generating bumps. Bump mapping uses the intensity of the map to affect the surface of the material. The intensity affects the apparent bumpiness of the surface: white areas protrude, and black areas recede.
Shaders rollout

The controls on this rollout let you assign a map or shader to the Multiplier parameter. Click the button for a component to display the Material/Map Browser on page 5724 and assign the map or shader. Use the toggle at the left to turn the effect of the map off or on.

The button to the right of the main shader button is for shaders that can return multiple parameters. If a shader that returns multiple parameters is assigned to the component, the button’s tooltip shows the parameter name. Clicking the button displays a Connect Parameter To Shader dialog on page 6392, which lets you change which parameter is being used.

IMPORTANT UV Coordinate on page 6430 and XYZ Coordinate on page 6434 are the only shaders with multiple return values provided with 3ds Max. You might encounter multiple return values in shaders provided with other shader libraries or custom shader code.

DGS Material Shader (mental ray)

Material Editor > mental ray Connection rollout > Unlock the Surface or Photon component. > Click the shader button for the Surface or Photon component. > Material/Map Browser > DGS Material (3dsmax)

Material Editor > mental ray material > Click the button for the Surface or Photon component. > Material/Map Browser > DGS Material (3dsmax)

Note: Shaders appear in the Browser only if the mental ray renderer is the currently active renderer.

DGS stands for Diffuse, Glossy, Specular. This shader is a mental ray phenomenon (a scripted shader tree) that provides a physically accurate simulation of a surface. With the mental ray Connection rollout of a basic 3ds Max material, or a mental ray material, you can assign the DGS Material shader to either the Surface or Photon component.

This shader provides a custom 3ds Max interface to the “DGS Material Photon” shader that is part of the mental images physics library.
Interface

Parameters rollout

NOTE The button to the right of the first six controls is a shortcut shader button. Clicking one of these buttons displays the Material/Map Browser on page 5724 so you can assign a shader to this component. When a map or a shader has been assigned to a component, this button displays the letter “M,” and the comparable button on the Shaders rollout displays the map or shader name.

**Diffuse** Click the color swatch to display a Color Selector on page 371 and change the material's diffuse color.

**Glossy Highlights** Click the color swatch to display a Color Selector and change the color of glossy highlights.
Specular Click the color swatch to display a Color Selector and change the color of mirror reflections. When the specular color is white, the material is 100 percent reflective, like a mirror. When the specular color is black, the material does not reflect any of its surroundings.

Shiny Sets the width of glossy highlights. The larger this value, the smaller the highlights. Default=30.0.

Transparency Specifies the transparency. The effective range of Transparency is from 0.0 to 1.0. At 0.0 the material is fully opaque. At 1.0 it is fully transparent. Default=0.0.

**WARNING** You can set the value of Transparency to be greater than 1.0, but this has no effect. An anomaly of the user interface for shaders in the mental ray and lume libraries, is that spinner values are not “clamped” to lie within their effective ranges, as they are for controls in 3ds Max.

The value of Transparency also indirectly specifies the reflectivity of the material, which is calculated as 1.0 minus the Transparency value.

Index Of Refraction Specifies the IOR. In the physical world, the IOR results from the relative speeds of light through the transparent material and the medium the eye or the camera is in. Typically this is related to the object’s density. The higher the IOR, the denser the object. Default=1.5.

See Extended Parameters Rollout (Standard Material) on page 6013 for a list of IOR values for commonly encountered materials.

**NOTE** When the IOR equals 1.0, there is no refraction, and calculating the transparency can take less time than when the material is refractive.

Lights When on, the material is illuminated only by those lights specified in the list. When Lights is turned off, all lights in the scene affect the material. Default=off.

The remaining light controls are unavailable unless Lights is turned on.

- **List of lights** Displays the lights you have chosen to illuminate this material.
- **Add** Adds a light to the list. Click Add to turn it on, then click the light object in a viewport.
- **Replace** Replaces a light in the list. Highlight a light’s name in the list, click Replace to turn it on, then click the replacement light object in a viewport.
Delete  Deletes a light from the list. Highlight a light's name in the list, then click Delete.

Shaders rollout

The controls on this rollout let you assign a map or shader to one of the basic parameters of the DGS Material shader. This is comparable to mapping a component of a standard material; by adding shaders, you can create a shader tree that generates complex effects.

Click the button for a component to display the Material/Map Browser on page 5724 and assign the map or shader. Use the toggle at the left to turn the effect of the map off or on.

The button to the right of each main shader button is for shaders that can return multiple parameters. If a shader that returns multiple parameters is assigned to the component, the button's tooltip shows the parameter name. Clicking the button displays a Connect Parameter To Shader dialog on page 6392, which lets you change which parameter is being used.

**IMPORTANT**  UV Coordinates on page 6430 and XYZ Coordinates on page 6434 are the only shaders with multiple return values provided with 3ds Max. You might encounter multiple return values in shaders provided with other shader libraries or custom shader code.
For all the DGS Material shader components, the available mental ray shaders are the same:

<table>
<thead>
<tr>
<th>Shader</th>
<th>Library</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bump</strong> on page 6397</td>
<td>3ds Max</td>
</tr>
<tr>
<td>DGS Material (this shader)</td>
<td>3ds Max</td>
</tr>
<tr>
<td><strong>Dielectric</strong></td>
<td>base</td>
</tr>
<tr>
<td><strong>Dielectric Material</strong> on page 6403</td>
<td>3ds Max</td>
</tr>
<tr>
<td><strong>Edge</strong></td>
<td>lume</td>
</tr>
<tr>
<td><strong>Facade</strong></td>
<td>lume</td>
</tr>
<tr>
<td><strong>Glass</strong></td>
<td>lume</td>
</tr>
<tr>
<td><strong>Glow</strong></td>
<td>lume</td>
</tr>
<tr>
<td><strong>Landscape</strong></td>
<td>lume</td>
</tr>
<tr>
<td><strong>Material to Shader</strong> on page 6412</td>
<td>3ds Max</td>
</tr>
<tr>
<td><strong>Metal</strong></td>
<td>lume</td>
</tr>
<tr>
<td><strong>Ocean</strong></td>
<td>lume</td>
</tr>
<tr>
<td><strong>Opacity</strong></td>
<td>base</td>
</tr>
<tr>
<td><strong>Reflect</strong></td>
<td>base</td>
</tr>
<tr>
<td><strong>Refract</strong></td>
<td>base</td>
</tr>
<tr>
<td><strong>Shader List</strong> on page 6420</td>
<td>3ds Max</td>
</tr>
</tbody>
</table>
Dielectric Material Shader (mental ray)

Material Editor > mental ray Connection rollout > Unlock the Surface or Photon component. > Click the shader button for the Surface or Photon component. > Material/Map Browser > Dielectric Material (3dsmax) or Dielectric Material Photon (3dsmax)

Material Editor > mental ray material > Click the button for the Surface or Photon component. > Material/Map Browser > Dielectric Material (3dsmax) or Dielectric Material Photon (3dsmax)

Note: Shaders appear in the Browser only if the mental ray renderer is the currently active renderer.

The Dielectric Material shader creates transparent, refractive materials that are physically accurate. A dielectric material, such as glass, is a material whose surface transmits most light that strikes it at angles close to perpendicular (90 degrees), but reflects most light that strikes at glancing angles (close to zero degrees).
When applied to the Surface component, this shader affects the surface's appearance. When applied to the Photon component, it affects its photon behavior for caustics and global illumination. (The Glass material is a mental ray phenomenon (a scripted shader tree) that is equivalent to a mental ray material on page 5951 with a Dielectric Material shader assigned to both its Surface and Photon components, with the parameter settings identical for both.)

**NOTE** This material does not use a shadow shader, so shadows will always be opaque unless you use a Dielectric Material shader for the Photon component, and generate caustics when you render.

**Adjacent Refractive Materials**

Two controls, Outside Light Persistence and Index Of Refraction (Out), are for situations where you are modeling two adjacent refractive materials. Consider a drink in a martini glass. The glass has an index of refraction (IOR) of 1.5, while the alcohol in the glass has an IOR of about 1.3. To create a physically accurate model of this situation, use *three* glass materials: one for the glass itself, one for the alcohol, and a third material for the surfaces where they touch each other. For this third material, set the “inside” IOR to 1.3, and the outside IOR to 1.5.
Interface

![Dielectric Material (3dsmax) Parameters](image)

**Light Persistence** In conjunction with the Persistence Distance, controls the percentage of light that the volume transmits. For example, if the color is set to R=G=B=0.5 and the Persistence Distance is set to 2.0, then objects with a thickness of 2.0 units will appear 50 per cent transparent. Default=white (R=G=B=1.0).

Because transparency depends on the thickness of the object, objects with varying thickness show different transparency depending on the angle from which they are viewed.

**Index Of Refraction** Specifies the Index Of Refraction (IOR). In the physical world, the IOR results from the relative speeds of light through the transparent material and the medium the eye or the camera is in. Typically this is related to the object's density. The higher the IOR, the denser the object. Default=1.5.

See Extended Parameters Rollout (Standard Material) on page 6013 for a list of IOR values for commonly encountered materials.

**Outside Light Persistence** In conjunction with the Persistence Distance, controls the percentage of light transmitted on the other side of a surface. When set to the default of black, this control has no effect. See the section “Adjacent Refractive Materials,” above. Default=black (R=G=B=0.0).
**Index Of Refraction (out)** Sets the IOR on the other side of a surface. When set to the default of zero, this control has no effect. See the section “Adjacent Refractive Materials,” above. Default=0.0.

**Persistence Distance** In conjunction with the Light Persistence color, controls the percentage of light that the volume transmits. It is the distance at which light transmission is reduced to the percentage specified by the Light Persistence RGB values. Default=1.0.

If you specify an Outside Light Persistence color, that setting also uses the Persistence Distance.

**Ignore Normals** When on, the renderer does not use normals to decide whether a light ray is entering or leaving the object. Normally, the shader uses normals to decide whether a ray is entering or leaving an object. (It is entering if the normal points toward the ray, leaving if the normal points away from the ray.) This can present a problem for rendering objects whose normals are not unified. When Ignore Normals is on, the shader decides whether a ray is entering or leaving the object by counting the number of times the ray has intersected the object. Default=off.

**Opaque Alpha** When on, refracted rays that touch the environment don’t generate a transparent alpha value. (This is how 3ds Max usually treats the environment.) When off, refracted rays that touch the environment render a transparent alpha value, which can help if you plan to use the rendering as part of a composite. Default=off.

**Phong Coefficient** When greater than zero, generates Phong highlights on the surface. The highlights appear in the sample slot. In general this value must be greater than 10 for highlights to be apparent. Default=0.0.

**Environment Shader (mental ray)**

Material Editor > mental ray Connection rollout > Assign a shader to the Environment component. > Material/Map Browser > Environment (3dsmax)

Material Editor > mental ray material > Assign a shader to the Environment component. > Material/Map Browser > Environment (3dsmax)

Note: Shaders appear in the Browser only if the mental ray renderer is the currently active renderer.

The Environment shader lets you specify an environment that is local to the material. Controls for the Environment shader are similar to those for a scene's environment on the Render Setup dialog > Environment panel. However, the
local Environment shader doesn’t affect the scene background. Instead, it provides an environment that the material can reflect or refract.

If an environment map is present, it generates the reflections or refractions, and they are not ray traced.

Interface

![Interface Image]

Parameters rollout

**NOTE** The buttons to the right of the UseAlpha and Color controls are shortcut shader buttons. Clicking one of these buttons displays the Material/Map Browser on page 5724 so you can assign a shader to this component. When a map or a shader is assigned to a component, this button displays the letter “M,” and the comparable button on the Shaders rollout displays the map or shader name.

**UseAlpha** When on, uses the map’s alpha channel, if it has one. The alpha channel specifies those portions of the map that are transparent or translucent. Default=off.

**Color** Click the color swatch to display a Color Selector on page 371 and choose a color to use as the environment.

**Map** Click the button to display a Material/Map Browser on page 5724 and choose a map to use as the environment.
**Shaders rollout**

The controls on this rollout let you assign a map or shader to the UseAlpha and Color parameters. Click the button for a component to display the Material/Map Browser on page 5724 and assign the map or shader. Use the toggle at the left to turn the effect of the map off or on.

The button to the right of each main shader button is for shaders that can return multiple parameters. If a shader that returns multiple parameters is assigned to the component, the button’s tooltip shows the parameter name. Clicking the button displays a Connect Parameter To Shader dialog on page 6392, which lets you change which parameter is being used.

**IMPORTANT** UV Coordinates on page 6430 and XYZ Coordinates on page 6434 are the only shaders with multiple return values provided with 3ds Max. You might encounter multiple return values in shaders provided with other shader libraries or custom shader code.

**Glare Shader (mental ray)**

Render Setup dialog > Renderer panel > Camera Effects rollout > Camera Shaders group > Click the Output button. > Material/Map Browser > Glare

The Glare shader, when used as a camera output shader on page 6753, creates a halo around very bright areas in the rendered image. It’s applied in two dimensions after rendering, so it can partially obscure darker objects between the bright area and the camera for greater realism.

---

*Interior lit by mr Sky Portal; no glare*  
*Interior with Glare shader for output; default Glare settings*
NOTE The glare effect from this shader is intended purely for illustrative purposes. It is not designed to be physically accurate and is not suited for precise simulation purposes.

Procedure

To use the Glare shader:

Using and adjusting the Glare output shader requires first assigning it on the Render Setup dialog, and then instancing it in the Material Editor. This procedure delineates the steps for doing so.

1. Make sure mental ray is the assigned renderer.
2. Open the Render Setup dialog (press F10), and on the Renderer panel, go to the Camera Effects rollout.
3. On the Camera Effects rollout, click the Output button (labeled “None” by default).
   This opens the Material/Map Browser dialog.
4. In the shader list, double-click the Glare entry.
   This assigns the shader and closes the browser.
5. Render the scene.
   If the results are satisfactory, you can stop here. The remaining steps concern adjusting the shader settings.
6. Open the Material Editor (press M), and, if necessary, the Render Setup dialog.
7. Drag the Output button from the Camera Shaders group on the Render Setup dialog to a sample slot on the Material Editor. When the Instance (Copy) Map dialog prompts you, choose Instance, if necessary, and click OK.
   This places an instance of the Glare shader in the sample slot. Editing this instance also modifies the output shader you originally assigned.
8. Adjust the Glare Parameters as necessary, rendering as you go to view the results.
**Interface**

- **Quality**: Lets you set the tradeoff between detail and speed. Lower Quality settings cause Glare to run more quickly, but can result in a boxy-looking glare halo, while a higher Quality value gives a better overall effect at the cost of rendering time. A mid-level setting is appropriate for most scenes.

- **Spread**: Controls how sensitive Glare is to bright objects. Lower values for Spread produce smaller glare halos while higher values cause larger glare halos. Very high values can cause dark objects to have halos.

  **TIP** The best way to enlarge an object's halo is to increase its brightness, not to increase the Spread value.

- **Streaks**: When on, uses an image file you specify to create a streaking effect, such as is visible when looking at bright images through glass or, in photographs, through a camera lens.

- **Streak Image**: Click to choose an image file to be used to create the streak effect. This file takes effect only when Streaks is on.

- **Streaks Weight**: Controls the blending between the "normal" glare and the streaks image. A value of 0.0 disables streaks, while a value of 1.0 makes the streaks fully visible.

- **Resolution for Glare Processing**: An absolute value specifying the image size, in pixels, on which the Glare computation occurs. If you image is rendered at 5000 x 5000 and Resolution for Glare Processing is set to 350, Glare will effectively compute on a 350 x 350 image internally and reapplied on the final image, possibly resulting in an inadequate glare effect.
Replace Rendered Image with Glare Only Generates an overlay image of the glare effect only; the original underlying image is removed. This mode is useful when render speed is critical, so that Glare can be run on a lower-resolution image to produce an overlay, which you can then composite with a higher-resolution underlying image.

**Height Map Displacement Shader (mental ray)**

Material Editor > mental ray Connection rollout > For the Displacement component, turn off the lock button. > Click the button for the Displacement component. > Material/Map Browser > Height Map Displacement (3dsmax)

Material Editor > mental ray material > Click the button for the Displacement component. > Material/Map Browser > Height Map Displacement (3dsmax)

Note: Shaders don’t appear unless the mental ray renderer is the currently active renderer.

The Height Map Displacement shader displaces the geometry of surfaces, and is specifically intended for use with height maps generated by normal mapping; see Creating and Using Normal Bump Maps on page 6856.

**IMPORTANT** When applying a material containing this map to an object, the mental ray Displacement > Smoothing option must be off. If such materials are applied to all objects in the scene, you can turn off Smoothing globally on page 6759. Otherwise, turn off smoothing for each object whose material uses a height map via the Object Properties > mental ray panel on page 300 (turn off Use Global Settings and then turn off Smoothing).

**TIP** Avoid the temptation to apply MeshSmooth to a model when creating a height map for it. This changes the shape of the model so the height values will not be correct. The low-res model must have exactly the same shape when the map is created and when it is used for displacement. Also, MeshSmooth does not use the same algorithm as the mental ray displacement smoothing, so using both forms of smoothing won’t work perfectly. The best results are obtained by not smoothing the low-res model when the map is created and also not using mental ray smoothing.

Also, avoid using a paint program to modify the height map. The values in the height map depend on the shape of both the low-res and high-res models, and it’s easy to damage the mathematical accuracy. If you paint any changes onto the map, you must be careful to preserve the faceted look, and avoid the temptation to blur away the facets.
You might try painting in Additive and Subtractive mode to add or subtract to the displacement, because Normal mode will set a fixed displacement, making it difficult for an artist to control the result.

See also:

- 3D Displacement Shader (mental ray) on page 6394
- mental ray Displacement on page 6713
- mental ray Connection Rollout on page 5763
- mental ray Material on page 5951

Interface

<table>
<thead>
<tr>
<th>Height Map Displacement (3dsmax) Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum Height ............................. -10.0</td>
</tr>
<tr>
<td>Maximum Height ............................. 10.0</td>
</tr>
<tr>
<td>Height Map ................................. None</td>
</tr>
</tbody>
</table>

Height Map Displacement (3dsmax) Parameters rollout

Be sure to enter the same values for Minimum and Maximum Height as the equivalents on the Projection Options dialog, as specified below.

Minimum Height The “Min Height” value specified on the Render to Texture: Projection Options dialog on page 6888 when creating the height map. Default=-10.0.

Maximum Height The “Max Height” value specified on the Render to Texture: Projection Options dialog on page 6888 when creating the height map. Default=10.0.

Height Map The height map itself (usually a bitmap).

Material to Shader (mental ray)

Material Editor > mental ray Connection rollout > Assign a shader. > Material/Map Browser > Material to Shader
Material Editor > mental ray or DGS material > Assign a shader. > Material/Map Browser > Material to Shader

Note: Shaders appear in the Browser only if the mental ray renderer is the currently active renderer.

Lets you use a regular 3ds Max material as a shader. Depending on the component to which this shader is assigned (Surface, Shadow, Displacement, Volume, and so on), the mental ray renderer uses the appropriate material component.

For example, if you want a mental ray material's Surface component to look like a standard material you have, assign Material To Shader as the Surface shader, and then assign it the standard material.

NOTE Material To Shader doesn't work as an environment background. Use the original 3ds Max material, instead.

TIP To edit the material assigned to Material To Shader, you can drag the button to an unused sample slot in the Material Editor (be sure to choose Instance when prompted). Or you can follow these steps:

1 In an unused sample slot, create the material and adjust its settings.
2 Save the material to a library.
3 Assign the Material To Shader to its component.
4 When you click the Material To Shader's shader button, browse from the library and load the material you prepared in advance.

If you need to further adjust the material, you can repeat these steps (without having to reassign the Material To Shader).

Interface

Material button Click to display the Material/Map Browser on page 5724 and choose the material to use for shading.
**mr Labeled Element Shader (mental ray)**

Material Editor > any material > Click a map button > Material/Map Browser > mr Labeled Element

Note: Shaders appear in the Browser only if the mental ray renderer is the currently active renderer.

The mr Labeled Element shader doesn’t actually function as a shader, but instead works in conjunction with the mr Labeled Element render element on page 6835 to let you output any branch of a shader tree (a string of nested maps) as a render element. For example, if you use the Checker map as a diffuse map, and you use a Perlin Marble map as one of the two checker colors, you can render only the checker-map components that contain the marble map to a custom element for subsequent compositing.

For details on using the mr Labeled Element shader, see To use the mr Labeled element: on page 6835.

**Interface**

**Shader/Map to Store (Passthrough)** Click the map button to assign a shader or map or shader/map branch to be passed to the render element. If a shader or map is already assigned, the button is labeled “M”; click the button to edit the shader or map.

**Label** Enter the same name as that assigned to the render element.

---

**Multi/Sub-Map Shader (mental ray)**

Material Editor > any material > Click a map button > Material/Map Browser > Multi/Sub-Map

Note: Shaders appear in the Browser only if the mental ray renderer is the currently active renderer.
The Multi/Sub-Map shader provides the ability to assign different colors or maps to a single parameter of a material. For example, you could create an array of pebbles on a terrain and assign a single Arch & Design material to all of the pebbles. To introduce color variation, place a Multi/Sub-Map shader in the Diffuse slot of the material. In doing so, you would maintain the same BRDF properties for all pebbles, varying only the diffuse color. Judicious use of Multi/Sub-Map can vastly reduce the required number of materials in complex scenes.

Multi/Sub-Map can vary the assigned color or map at random, or based on object, material, or smoothing group ID. You can define up to 20 colors or maps to different IDs and for higher IDs you can repeat the assignment cycle or specify an out-of-range color or map.

![Left: Auditorium seats colors vary object ID; Right: colors vary at random](image)

**NOTE** The Multi/Sub-Map shader does not display correctly in shaded viewports. In general, it is recommended that you leave Show Map In Viewport off for materials that use the shader as the Diffuse map.
Interface

![Multi/Sub-Map Parameters](image)

- Switch Color/Map based on: Object ID
- Default/Out-of-range Color: [Red]
- Number of Colors/Maps to Use: 20
- Repeat: [ ]
- Color/Map #1 - #20: [Color Swatches]

---

**6416 | Chapter 17  Material Editor, Materials, and Maps**
Switch Color/Map based on Choose the basis on which to assign a color or map:

- **Object ID**  Uses the Object ID on page 293 value. Objects whose ID is 1 are assigned Color/Map #1, and so on.

  **NOTE** Objects whose ID is 0 (the default), or, if Repeat on page 6417 is off, with an ID value higher than the upper limit as determined by value of **Number of Colors/Maps to Use** on page 6417, are assigned the **Default/Out-of-range Color** on page 6417 (or map).

- **Material ID**  Uses the Material ID on page 8633. Faces whose Material ID is 1 are assigned Color/Map #1, and so on.

  **NOTE** If Repeat on page 6417 is off, faces with an Material ID value higher than the upper limit as determined by value of **Number of Colors/Maps to Use** on page 6417 are assigned the **Default/Out-of-range Color** on page 6417 (or map).

- **Smoothing Group**  Uses the smoothing group ID on page 383. Faces in smoothing group 1 are assigned Color/Map #1, and so on. For faces assigned to multiple smoothing groups, Multi/Sub-Map uses the highest assigned value.

  **NOTE** Faces that don’t belong to any smoothing group, or, if Repeat on page 6417 is off, with a smoothing group ID value higher than the upper limit as determined by value of **Number of Colors/Maps to Use** on page 6417, are assigned the **Default/Out-of-range Color** on page 6417 (or map).

- **Random**  Assigns colors or maps at random. The randomization is fixed and does not change upon re-rendering the scene or reassigning the material.

**Default/Out-of-range Color** The color or map assigned to objects or faces whose ID does not fall within the specified range (1 to **Number of Colors/Maps**). Does not apply to the Random option.

**Number of Colors/Maps to Use** The highest ID value to use. If Repeat is off, IDs higher than this value (or set to 0) are assigned the Default/Out-of-range Color. Range=1 to 20.

**Repeat** When on, the assigned colors/maps cycle through values higher than the Number Of Colors/Maps To Use setting. For example, if Number Of Colors/Maps To Use is set to 7, objects or faces with ID 8 or 15 would use Color/Map #1, IDs set to 9 or 16 would use #2, and so on.
When off, any IDs outside the specified range (1 to Number of Colors/Maps) use the Default/Out-of-range Color on page 6417.

**Color/Map #1-20** For each Color/Map parameter, specify a color or map to use. If you assign a map, it overrides the color unless you disable the map using a check box on the Maps rollout.

To assign a map, click the map button to the right of the color swatch and choose a map from the Material/Map Browser.

**Maps rollout**

This rollout provides check boxes for enabling and disabling the map/color assignments and buttons for assigning maps.

---

### Object Color Shader (mental ray)

Material Editor > any material > Click a map button > Material/Map Browser > Object Color

Note: Shaders appear in the Browser only if the mental ray renderer is the currently active renderer.

The Object Color shader lets you use the object’s wireframe color on page 8765 as a map or shader in any material. You can use the color or a single channel of it (red, green, or blue) as is, or modify the color with two other colors or maps depending on its intensity.

As with the Multi/Sub-Map shader on page 6414, you can assign a single material containing the Object Color shader in a map slot (typically Diffuse) to any number of objects, with the result that each object’s final appearance varies, depending, in this case, on its wireframe color.

**NOTE** The Object Color shader does not display correctly in shaded viewports. In general, it is recommended that you leave Show Map In Viewport off for materials that use the shader as the Diffuse map.
Object Color shader used for ink color in Ink ‘n Paint material

**Interface**

**Use Channel(s)** Choose to extract the actual color (RGB) of the object’s wireframe color, or an individual component of the color: red, green, or blue.

**White/Black** These two colors (or maps) are blended based on the intensity (value) of the channel. With lighter intensities, more of the White color is used, and with darker intensities, more of the Black color is used.

At their default values, these settings leave the object color or channel intact. However, if you change them, the result is a range of colors based on the
mixture of the two and the intensities of the extracted channels. For example, if you set Use Channel(s) to RGB (the default), and set the White color to red and the Black color to blue, then the resulting output would range from red to purple to blue, depending on the original object-color intensity.

Top: Spheres in viewport showing object colors
Inset: Object Color parameters
Bottom: Rendered spheres with same material

**Shader List (mental ray)**

Material Editor > mental ray Connection rollout > Assign a shader. > Material/Map Browser > Shader List
Material Editor > mental ray, DGS, or Glass material > Assign a shader. > Material/Map Browser > Shader List

Note: Shaders appear in the Browser only if the mental ray renderer is the currently active renderer.
The Shader List shader provides an interface for constructing a mental ray shader list. A shader list combines the effect of multiple shaders: each shader is called in turn, the first one’s output being treated as input to the next, and so on.

**Interface**

- **List of shaders** Shows the names of the shaders in the list. Highlight a shader’s name to alter its position in the list, or to access its parameters. Each active shader in the list is called in order, from top to bottom.
- **Up** Moves the selected shader up in the list.
- **Down** Moves the selected shader down in the list.
- **Add Shader** Displays a Material/Map Browser on page 5724 so you can choose a shader to add to the list.
- **Remove Selected** Removes the selected shader from the list.
Selection group

On When on, the shader is active. When off, the shader is inactive and isn't called. You can use this toggle to disable a shader without removing it from the list entirely.

Shader button Shows the name of the currently selected shader. Click the button to view that shader's parameters in the Material Editor.

When you are done adjusting an individual shader's parameters, you can click Go To Parent to return to the Shader List Parameters rollout.

UV Generator Shader (mental ray)

Material Editor > Any shader with a Coords parameter (or other vector value). > Click the shader button. > Material/Map Browser > UV Generator (3dsmax)

Material Editor > mental ray Connection rollout > Unlock the Surface component and click the shader button. > Material/Map Browser > UV Generator (3dsmax)

Material Editor > DGS material > Assign a shader to any component. > Material/Map Browser > UV Generator (3dsmax)

Note: Shaders appear in the Browser only if the mental ray renderer is the currently active renderer.

The UV Generator shader returns 2D mapping coordinates. You can use its settings to adjust a 2D map. The parameters for this shader are equivalent to parameters on the Coordinates rollout for 2D maps on page 6201.

UV Generator Parameters Rollout

Material Editor > Any shader with a Coords parameter (or other vector value). > Click the shader button. > Material/Map Browser > UV Generator (3dsmax) > UV Generator (3dsmax) Parameters rollout

Material Editor > mental ray Connection rollout > Unlock the Surface component and click the shader button. > Material/Map Browser > UV Generator (3dsmax) > UV Generator (3dsmax) Parameters rollout
Material Editor > DGS material > Assign a shader to any component. >
Material/Map Browser > UV Generator (3dsmax) > UV Generator (3dsmax)
Parameters rollout

Note: Shaders appear in the Browser only if the mental ray renderer is the
currently active renderer.

The parameters for this shader are equivalent to parameters on the Coordinates
rollout for 2D maps on page 6201.
### Interface

<table>
<thead>
<tr>
<th>UV Generator (3dsmax) Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>MapSlotType</td>
</tr>
<tr>
<td>EnvType</td>
</tr>
<tr>
<td>MapChannel</td>
</tr>
<tr>
<td>UVWSource</td>
</tr>
<tr>
<td>ShowMapOnBack</td>
</tr>
<tr>
<td>UOffset</td>
</tr>
<tr>
<td>UScale</td>
</tr>
<tr>
<td>UWrap</td>
</tr>
<tr>
<td>UMirror</td>
</tr>
<tr>
<td>VOffset</td>
</tr>
<tr>
<td>VScale</td>
</tr>
<tr>
<td>VWrap</td>
</tr>
<tr>
<td>VMirror</td>
</tr>
<tr>
<td>UAngle</td>
</tr>
<tr>
<td>VAngle</td>
</tr>
<tr>
<td>WAngle</td>
</tr>
<tr>
<td>UVAxis</td>
</tr>
<tr>
<td>Clipping</td>
</tr>
<tr>
<td>Blur</td>
</tr>
<tr>
<td>BlurOffset</td>
</tr>
<tr>
<td>Noise</td>
</tr>
<tr>
<td>Animate</td>
</tr>
<tr>
<td>Amount</td>
</tr>
<tr>
<td>Size</td>
</tr>
<tr>
<td>Level</td>
</tr>
<tr>
<td>Phase</td>
</tr>
<tr>
<td>RealWorldMapSize</td>
</tr>
</tbody>
</table>

6424 | Chapter 17  Material Editor, Materials, and Maps
**MapSlotType** Chooses whether the map is applied as an environment map or a texture map. Default=0 (Texture).
- 0 is for a Texture map.
- 1 is for an Environment map.

**EnvType** If the map is applied as an environment map, this value chooses the mapping type. If the map is applied as a texture map, this value is ignored. Default=4 (screen).
- 1 is for Spherical.
- 2 is for Cylindrical.
- 3 is for Shrink-Wrap.
- 4 is for Screen.

Screen projection projects as a flat backdrop in the scene. See UVW Map Modifier on page 1932 for a description of spherical, cylindrical, and shrink-wrap projection.

**MapChannel** If the map is applied as a texture map and UVWSource is set to 0 (Explicit), this value sets the map channel index; otherwise, this value is ignored. Range=1 to 99. Default=1.

**UVWSource** If the map is applied as a texture map, this value chooses the source of UVW coordinates. If the map is applied as an environment map, this value is ignored. Default=0 (Explicit).
- 0 is for Explicit.
  - When Explicit is the source, use MapChannel to set the specific map channel.
- 1 is for Object XYZ.
  - Object XYZ uses planar mapping based on the object's local coordinates (disregarding the pivot point location). For rendering purposes, planar mapping doesn't project through to the back of the object unless you turn on ShowMapOnBack.
- 2 is for World XYZ.
  - World XYZ uses planar mapping based on the scene's world coordinates (disregarding the object's bounding box). For rendering purposes, planar mapping doesn't project through to the back of the object unless you turn on ShowMapOnBack.
ShowMapOnBack  When on, planar mapping (Planar from Object XYZ, or with the UVW Map modifier) projects through to render on the back of the object. When off, planar mapping doesn't render on the object's back. Default=on.

This toggle is available only when Tiling is off in both dimensions. Its effect is visible only when you render the scene.

NOTE In viewports, planar mapping always projects to the back of the object, whether Show Map On Back is turned on or not. To override this, turn off Tiling.

UOffset  Changes the U position of the map in UV coordinates on page 8754. The map moves in relation to its size. Default=0.0.

For example, if you want to shift the map its full width to the left, and half its width downward from its original position, you enter -1 in the U Offset field and 0.5 in the V offset field.

UScale  Determines the number of times the map is tiled on page 8742 (repeated) along the U axis. Default=1.0.

UWrap  Turns tiling on or off in the U axis. Default=on.

UMirror  Mirrors on page 8742 the map left-to-right along the U axis. Default=off.

VOffset  Changes the V position of the map in UV coordinates. Default=0.0.

VScale  Determines the number of times the map is tiled (repeated) along the V axis. Default=1.0.

VWrap  Turns tiling on or off in the V axis. Default=on.

VMirror  Mirrors the map top-to-bottom along the V axis. Default=off.

UAngle, VAngle, and WAngle  Rotate the map about the U, V, or W axis (in degrees). Default=0.0.

UVAxis  Changes the mapping coordinate system used for the map. The default UV coordinates project the map onto the surface like a slide projector. The VW and WU coordinates rotate the map so that it is perpendicular to the surface. Default=0 (UV).

- 0 is for UV.
- 1 is for VW.
- 2 is for WU.

Clip  When on, UVs are clipped. When off, UVs are wrapped. Default=on.
**Blur** Affects the sharpness or blurriness of the map based on its distance from the view. The farther away the map is, the greater the blurring. The Blur value blurs maps in world space. Blur is primarily used to avoid aliasing on page 8501. Default=1.0.

**BlurOffset** Affects the sharpness or blurriness of the map without regard to its distance from the view. Blur Offset blurs the image itself in object space. Use this option when you want to soften or defocus the details in a map to achieve the effect of a blurred image. See Blur/Blur Offset on page 8525. Default=0.0

**Noise** When on, noise settings affect the map. When off, no noise is applied. Default=off.

**Animate** Determines if the noise effect is animated. This parameter must be turned on if you intend to animate the noise. Default=off.

**Amount** Sets the strength of the fractal function, expressed as a percentage. If the amount is 0 there is no noise. If the amount is 100 the map becomes pure noise. Default=1.0.

**Size** Sets the scale of the noise function relative to geometry. At very small values, the noise effect becomes white noise. At large values, the scale can exceed the scale of the geometry, in which case it has little or no effect. Range=0.001 to 100. Default=1.0.

**Level** Or iterations: the number of times the function is applied. The effect of the level is dependent on the Amount value. The stronger the amount, the greater the effect of increasing the Level value. Range=1 to 10. Default=1.

**Phase** Controls the speed of the animation of the noise function. Default=0.0.

**RealWorldMapSize** Controls the scaling method used for texture mapped materials that are applied to the object. The scaling values are controlled by the Use Real-World Scale settings found on the applied material's Coordinates rollout. Default=on.

**Shaders Rollout (UV Generator)**

Material Editor > Any shader with a Coords parameter (or other vector value). > Click the shader button. > Material/Map Browser > UV Generator (3dsmax) > Shaders rollout
Material Editor > mental ray Connection rollout > Unlock the Surface component and click the shader button. > Material/Map Browser > UV Generator (3dsmax) > Shaders rollout

Material Editor > DGS material > Assign a shader to any component. > Material/Map Browser > UV Generator (3dsmax) > Shaders rollout

Note: Shaders appear in the Browser only if the mental ray renderer is the currently active renderer.

The controls on this rollout let you assign a map or shader to one of the basic parameters of the UV Generator shader. This is comparable to mapping a component of a standard material; by adding shaders, you can create a shader tree that generates complex effects.
The button to the right of each main shader button is for shaders that can return multiple parameters. If a shader that returns multiple parameters is assigned to the component, the button's tooltip shows the parameter name.
Clicking the button displays a Connect Parameter To Shader dialog on page 6392, which lets you change which parameter is being used.

**IMPORTANT** UV Coordinates on page 6430 and XYZ Coordinates on page 6434 are the only shaders with multiple return values provided with 3ds Max. You might encounter multiple return values in shaders provided with other shader libraries or custom shader code.

### UV Coordinate Shader (mental ray)

Material Editor > Any shader with a Coords parameter or other vector value. > Click the shader button. > Material/Map Browser > UV Coordinate (3dsmax)

Note: Shaders appear in the Browser only if the mental ray renderer is the currently active renderer.

This shader is identical to the UV Generator shader on page 6422, except that it returns two values instead of one.

- The UV coordinate (same value as UV Generator would return)
  This value is named UV.
- The UV coordinate's derivative
  This value, also a vector, is named dUV.

When you choose this shader, a Connect Parameter To Shader dialog on page 6392 is displayed, prompting you to choose which of the two values to use. You can later change the choice of value by using the “dot” button to the right of the main shader button.

**Interface**

The UV Coordinate shader has the same parameters as the UV Generator shader. See UV Generator Parameters Rollout on page 6422 for a description of the basic settings.

### XYZ Generator Shader (mental ray)

Material Editor > Any shader with a Coords parameter (or other vector value). > Click the shader button. > Material/Map Browser > XYZ Generator (3dsmax)
Material Editor > mental ray Connection rollout > Unlock the Surface component and click the shader button. > Material/Map Browser > XYZ Generator (3dsmax)

Material Editor > DGS material > Assign a shader to any component. > Material/Map Browser > XYZ Generator (3dsmax)

Note: Shaders appear in the Browser only if the mental ray renderer is the currently active renderer.

The XYZ Generator shader returns 3D mapping coordinates. You can use its settings to adjust a 3D map. The parameters for this shader are equivalent to parameters on the Coordinates rollout for 3D maps on page 6278.

**XYZ Generator Parameters Rollout**

Material Editor > Any shader with a Coords parameter (or other vector value). > Click the shader button. > Material/Map Browser > XYZ Generator (3dsmax) > XYZ Generator (3dsmax) Parameters rollout

Material Editor > mental ray Connection rollout > Unlock the Surface component and click the shader button. > Material/Map Browser > XYZ Generator (3dsmax) Parameters rollout

Material Editor > DGS material > Assign a shader to any component. > Material/Map Browser > XYZ Generator (3dsmax) > XYZ Generator (3dsmax) Parameters rollout

Note: Shaders appear in the Browser only if the mental ray renderer is the currently active renderer.

The parameters for this shader are equivalent to parameters on the Coordinates rollout for 3D maps on page 6278.
Interface

<table>
<thead>
<tr>
<th>XYZ Generator (3dsmax) Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>CoordinateSystem ................. 0</td>
</tr>
<tr>
<td>MapChannel ....................... 1</td>
</tr>
<tr>
<td>Offset .................. 0.0 0.0 0.0</td>
</tr>
<tr>
<td>Tiling ........... 1.0 1.0 1.0</td>
</tr>
<tr>
<td>Angle ............ 0.0 0.0 0.0</td>
</tr>
<tr>
<td>Blur ............ 0.0 0.0 0.0</td>
</tr>
<tr>
<td>BlurOffset .. 0.0 0.0 0.0</td>
</tr>
</tbody>
</table>

**CoordinateSystem** Chooses the source coordinate system. Default=0 (Object XYZ).
- 0 is for Object XYZ.
  Object XYZ uses the object’s local coordinate system.
- 1 is for Explicit Map Channel.
  Lets you use the MapChannel value to choose any channel from 1 to 99.
- 3 is for World XYZ.

**MapChannel** When Explicit Map Channel is the coordinate system source, this value lets you set the map channel; otherwise, it is ignored. Range=1 to 99. Default=1.

**Offset** Moves the map pattern in X, Y, and Z. Default=(0.0, 0.0, 0.0).

**Tiling** Tiles on page 8742 the map pattern in X, Y, and Z, and makes the pattern narrower. Default=(1.0, 1.0, 1.0).

**Angle** Rotates the map pattern in X, Y, and Z. Default=(0.0, 0.0, 0.0).

**Blur** Affects the sharpness or blurriness of the map based on its distance from the view. The farther away the map is, the greater the blurring. The Blur value blurs maps in world space. Blur is primarily used to avoid aliasing. Default=1.0.

**BlurOffset** Affects the sharpness or blurriness of the map without regard to its distance from the view. Blur Offset blurs the image itself in object space. Use when you want to soften or defocus the details in a map to achieve the effect of a blurred image. Default=0.0.
Shaders Rollout (XYZ Generator)

Material Editor > Any shader with a Coords parameter (or other vector value). > Click the shader button. > Material/Map Browser > XYZ Generator (3dsmax) > Shaders rollout

Material Editor > mental ray Connection rollout > Unlock the Surface component and click the shader button. > Material/Map Browser > XYZ Generator (3dsmax) > Shaders rollout

Material Editor > DGS material > Assign a shader to any component. > Material/Map Browser > XYZ Generator (3dsmax) > Shaders rollout

Note: Shaders appear in the Browser only if the mental ray renderer is the currently active renderer.

The controls on this rollout let you assign a map or shader to one of the basic parameters of the XYZ Generator shader. This is comparable to mapping a component of a standard material; by adding shaders, you can create a shader tree that generates complex effects.

Interface

The button to the right of each main shader button is for shaders that can return multiple parameters. If a shader that returns multiple parameters is assigned to the component, the button's tooltip shows the parameter name. Clicking the button displays a Connect Parameter To Shader dialog on page 6392, which lets you change which parameter is being used.
IMPORTANT UV Coordinates on page 6430 and XYZ Coordinates on page 6434 are the only shaders with multiple return values provided with 3ds Max. You might encounter multiple return values in shaders provided with other shader libraries or custom shader code.

**XYZ Coordinate Shader (mental ray)**

Material Editor > Any shader with a Coords parameter or other vector value. > Click the shader button. > Material/Map Browser > XYZ Coordinate (3dsmax)

Note: Shaders appear in the Browser only if the mental ray renderer is the currently active renderer.

This shader is identical to the XYZ Generator shader on page 6430, except that it returns two values instead of one.

- The XYZ coordinate (same value as XYZ Generator would return)
  - This value is named XYZ.

- The XYZ coordinate's derivative
  - This value, also a vector, is named dXYZ.

When you choose this shader, a Connect Parameter To Shader dialog on page 6392 is displayed, prompting you to choose which of the two values to use. You can later change the choice of value by using the “dot” button to the right of the main shader button.

**Interface**

The XYZ Coordinate shader has the same parameters as the XYZ Generator shader. See XYZ Generator Parameters Rollout on page 6431 for a description of the basic settings.

**Production Shaders**

The Production Shaders category of advanced mental ray shaders comprises several texture shaders, a lens shader, and two output shaders, all covered in this section. Also part of the Production Shaders library is the Matte/Shadow/Reflection material on page 5930.
Texture Shaders

The topics in this section describe shaders that manage environment maps, and a shader to manage gamma and gain.

Environment/Background Switcher (mi)

Environment and Effects dialog > Click Environment Map button. > Material/Map Browser > Environment/Background Switcher (mi)

NOTE Shaders appear in the Browser only if the mental ray renderer is the currently active renderer.

The Environment/Background Switcher map lets you use one map as a background and another as an environment map, to provide environmental reflections.

In typical usage, you use the Environment/Background Switcher as an Environment map. As the Background map you apply a background image, preferably using the Environment/Background Camera Map (mi) on page 6437 shader.

As the Environment/Reflections map, use an environment map. If you have a plain photograph of a chrome ball taken from a similar camera angle as the background, you can use Environment Probe / Chrome Ball (mi) on page 6440 shader for easy, automatic unwrapping, or, if you have a fully unwrapped environment-map image, use a Bitmap map in Spherical Environment mode.

For details, see the following procedure.

NOTE While the Environment/Background Switcher is most commonly used as an environment map, it can be used in other places as well. It will use the Background result for anything that is seen directly by the camera, and the Environment/Reflection for anything seen indirectly, as in reflections, refractions, etc.
Procedure

To use the Environment/Background Switcher map:

This procedure assumes you have two photographs: one of a background, and another an image of a mirror/chrome ball, both taken from roughly the same camera position. The photo of the chrome ball should be cropped so that it exactly touches the edges of the ball. The best result is obtained if at least the chrome ball photo is HDR, but good results can be achieved with a traditional, non-HDR photograph.

NOTE This workflow applies to stills or video sequences with only slight camera movement. For any complex fly-around camera motion, the simple “auto-unwrapping” performed by the Environment Probe/Chrome Ball shader will not suffice.

1. Open the Environment And Effects dialog to the Environment panel on page 7163.
2. On the Common Parameters rollout, click the Environment Map button. This opens the Material/Map Browser.
3. From the browser list, choose Environment/Background Switcher (mi). The Environment Map button label now shows the name of the map.
4. Open the Material Editor.
5. Drag the Environment Map button to a sample sphere in the Material Editor. Confirm the Instance choice. This displays the Environment/Background Switcher (mi) Parameters rollout in the Material Editor.
6. Click the Background map button. From the Material/Map Browser, choose a map; Environment/Background Camera Map (mi) on page 6437 is the recommended choice. This displays the map’s parameters rollout. Click the Map button (”Browse”) and choose a bitmap file for the background image.

7. Click Go To Parent to return to the Switcher controls.
8. Click the Environment/Reflections map button. From the Material/Map Browser, choose a map; Environment Probe / Chrome Ball (mi) on page 6440 is the recommended choice.
This displays the map’s parameters rollout. Click the Map button ("Browse") and choose a bitmap file for the background image. Ideally, the bitmap is an HDR photograph of a chrome or mirror ball taken from the camera perspective in the scene, but a non-HDR photo also works well.

Or, if you have a fully unwrapped environment map photo, use it as a Bitmap map and, on the Coordinates rollout, choose Environ and set Mapping to Spherical Environment.

9 Adjust the various maps’ parameters as necessary and then render the scene.

**Interface**

<table>
<thead>
<tr>
<th>Environment/Background Switcher (mi) Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Background .................................</td>
</tr>
<tr>
<td>Environment/Reflections ....................</td>
</tr>
</tbody>
</table>

**Background** Specifies the background color or map. The background shows up wherever it is not blocked by a foreground object, or transmitted by a transparent object.

**Environment/Reflections** Specifies the environment color or map. This image or color shows up in reflective surfaces.

**Environment/Background Camera Map (mi)**

Material Editor > Click any map button. > Material/Map Browser > Environment/Background Camera Map (mi)

**NOTE** Shaders appear in the Browser only if the mental ray renderer is the currently active renderer.

This shader is similar in function to using a Bitmap map with environment mapping set to Screen as an Environment Map. However, Screen mapping simply chooses a pixel from the map based on the coordinates of the currently rendered pixel. This does not work well with reflections.

In contrast, the Environment/Background Camera Map shader correctly renders “back transformation.” In other words, for a point seen in a reflection, it takes
the reflected point's 3D coordinate, convert it to its matching onscreen position (if any), and looks up the map based on this new 2D location (or returns a special value if the point is offscreen).

**Back Transformation**

In the following discussion of back transformation in the context of the Environment/Background Camera Map, refer to this illustration:

Imagine the green ray coming from the camera hitting the screen (blue rectangle) at the green "+". Using the Bitmap map set to Screen environment mapping mode as the Environment Map, the background-image location corresponding to this screen coordinate will be used for anything that happens to this ray. Even when it hits the teapot and bounces to the floor (green dot), this would be still be textured with the texture background pixel from the green "+" location.

In contrast, the Environment/Background Camera Map shader would transform the point (green dot) to a new screen coordinate (imaginary red ray) and use the value from the red "+" instead.
The yellow ray, however, hits the reflective object at some other location, and its reflected location (yellow dot) is outside the screen. For these cases, the shader would use its Off-screen settings.

**Interface**

![Environment/Background Camera Map (mi) Parameters](image)

- **Map** Click the Browse button to specify a bitmap file containing the background image. Alternatively, click the map button to specify a procedural map.

- **Multiplier** A multiplier for the background image.

- **Reverse Gamma Correction** Applies inverse gamma correction to the texture.

- **Per-Pixel Matching** Matches the image to the background on a pixel-per-pixel basis, with the bottom-left pixel of the map matched exactly to the bottom-left rendered pixel. If the pixel size of the map differs from the pixel size of the rendered output, the renderer issues a warning. However, it still renders the image, cropping or padding it as necessary.

- **Force Transparent Alpha** When on, forces the background alpha to 0. When off, mental ray uses the actual alpha from the bitmap image or procedural map. If the file contains no alpha data, returns opaque alpha values when off.

- **Off-screen Rays return Environment** When on, uses the scene environment for off-screen points.

Because the shader back-transforms points such as those seen in reflections into screen space, it might happen that parts of surfaces reflect points that are not on the screen. Because the projected map contains data only for points on the screen, this option allows a reasonable alternative for off-screen points.
Off-screen Color (When Above Off) Defines the color of off-screen points when Off-Screen Rays Return Environment (see previous) is off.

Environment Probe / Chrome Ball (mi)

Material Editor > Click any map button. > Material/Map Browser > Environment Probe/Chrome Ball (mi)

NOTE Shaders appear in the Browser only if the mental ray renderer is the currently active renderer.

This shader is intended as an environment shader (apply as an Environment Map), because it looks up based on the ray direction. It maps the proper direction to a point on the chrome ball and retrieves its color.

In the visual effects industry it is common practice to photograph a chrome ball (also known as a “light probe”) on set, as well as a gray ball on page 6441 for lighting reference.

Ideally, one shoots these at multiple exposures and uses software such as Photosphere (Macintosh) or HDRShop (PC) to combine them into a single high-dynamic-range image and/or unwrap the chrome/gray ball into a spherical environment map.

However, it is often difficult to regain the proper orientation of spherical map so it matches the camera used to render the CG scene. Furthermore, a single photo of a chrome/gray ball contains poor data for certain angles that one might want to avoid seeing in the final render.

These shaders are intended to simplify a special case: When the chrome/gray ball is already shot from the exact camera angle from which the final image is to be rendered.

It simply utilizes the mental ray camera coordinate space and applies the chrome/gray ball in this space, hence the orientation of the reflections will always “stick” to the rendering camera.

For additional information and illustrations, see Help menu > Additional Help > mr Production Shader Library > Chapter 6: Mirror/Gray Ball Shaders.
Interface

Chrome/Mirror Ball Image Click the Browse button to specify the file containing the chrome ball image. The image should be cropped so the ball exactly touches the edges of the image. Alternatively, click the map button to specify a procedural map.

Multiplier A multiplier for the chrome ball image.

Reverse Gamma Correction Applies an inverse gamma correction to the texture.

Blur (literal mental ray image files only) Blur the image. This applies only to literal mental ray textures; that is, bitmap images specified with the Browse button, rather than maps specified with the map button.

Environment Probe / Gray Ball (mi)

Material Editor > Click any map button. > Material/Map Browser > Environment Probe/Gray Ball (mi)

NOTE Shaders appear in the Browser only if the mental ray renderer is the currently active renderer.

This shader can be used either as an environment shader or a texture shader, because it looks up based on the direction of the surface normal. It will map the normal vector direction to a point on the gray ball and retrieve its color.

In the visual effects industry it is common practice to photograph a chrome ball on page 6440 (also known as a “light probe”) on set, as well as a gray ball for lighting reference.

Ideally, one shoots these at multiple exposures and uses software such as Photosphere (Macintosh) or HDRShop (PC) to combine these into a single mental ray Shaders | 6441
high-dynamic-range image and/or unwrap the chrome/gray ball into a spherical environment map.

However, it is often difficult to regain the proper orientation of spherical map so it matches the camera used to render the CG scene. Furthermore, a single photo of a chrome/gray ball contains poor data for certain angles that one might want to avoid seeing in the final render.

These shaders are intended to simplify a special case: When the chrome/gray ball is already shot from the exact camera angle from which the final image is to be rendered.

It simply utilizes the mental ray camera coordinate space and applies the chrome/gray ball in this space, hence the orientation of the reflections will always “stick” to the rendering camera.

For additional information and illustrations, see Help menu > Additional Help > mr Production Shader Library > Chapter 6: Mirror/Gray Ball Shaders.

**Interface**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grey Ball Image</td>
<td>Click the Browse button to specify the file containing the gray ball image. The image should be cropped so the ball exactly touches the edges of the image. Alternatively, click the map button to specify a procedural map.</td>
</tr>
<tr>
<td>Multiplier</td>
<td>A multiplier for the gray ball image.</td>
</tr>
<tr>
<td>Reverse Gamma Correction</td>
<td>Applies an inverse gamma correction to the texture.</td>
</tr>
<tr>
<td>Blur (literal mental ray image files only)</td>
<td>Blur the image. This applies only to literal mental ray textures; that is, bitmap images specified with the Browse button, rather than maps specified with the map button.</td>
</tr>
</tbody>
</table>
Utility Gamma & Gain (mi)

Material Editor > Click any map button. > Material/Map Browser > Utility Gamma & Gain (mi)

This is a simple shader that applies a gamma and a gain (multiplication) of a color or map. It provides an alternative way of controlling gamma in 3ds Max. Many similar shaders exist in various OEM integrations of mental ray, so you also can use this shader for standalone mental ray and for cross-platform phenomena development.

**NOTE** Shaders appear in the Browser only if the mental ray renderer is the currently active renderer.

The shader can also be used as a simple gamma lens shader, in which case the input is not used, but the eye ray color is used instead.

**Interface**

![Utility Gamma & Gain (mi) Parameters](image)

**Input** Specifies the input color or map.

**Gamma** The gamma applied to the input.

**Gain (multiplier)** The multiplier for the input.

**Reverse Gamma Correction (De-Gamma)** When off, the shader takes the input, multiplies it by the Gain value, and then applies a gamma correction of Gamma to the color. When on, the shader takes the input, applies a reverse gamma correction of Gamma to the color, and then divides it by the Gain value.
Lens Shader

The topic in this section describes a shader for rendering a subset of objects in a scene.

Render Subset of Scene/Masking (mi)

Render Setup dialog > Renderer panel > Camera Effects rollout > Camera Shaders group > Lens button > Material/Map Browser > Render Subset of Scene/Masking (mi)

NOTE Shaders appear in the Browser only if the mental ray renderer is the currently active renderer.

This shader allows re-rendering a subset of the objects in a scene, defined by object or material. It is intended for a “quick fix” solution when almost everything in a scene is perfect, but just one object or material needs a small tweak.

NOTE This shader works for first-generation rays only. Thus, for example, refracted or reflected rays from an object do not show up in the rendering.

Procedure

To use the Render Subset of Scene/Masking map:

1. Open the Render Setup dialog to the Renderer panel on page 6731.
2. On the Camera Effects rollout, click the Camera Shaders group > Lens button. This opens the Material/Map Browser.
3. From the browser list, choose Render Subset of Scene/Masking (mi). The Lens button label now shows the name of the map.
4. Open the Material Editor.
5. Drag the Lens button to a sample sphere in the Material Editor. Confirm the Instance choice. This displays the Render Subset of Scene/Masking (mi) Parameters rollout in the Material Editor.
6. Specify an object list or material to render and make any necessary additional settings.
TIP If you specify a material, choose it from the scene (set Browse From to Scene).

7 Render the scene.
   Only the specified objects render.

Interface

Object List The object or objects to be rendered. Use the Add, Replace, and Delete buttons to edit the list.

Material Specifies a material to render.

NOTE If you specify a material but no objects, all objects containing that material will render. If you specify a material as well as several objects with different materials, only objects with the specified material will render.

NOTE The Render Subset of Scene/Masking shader does not support the Multi/Sub-Object material on page 6120. However, it does support component materials of a Multi/Sub-Object material.
**Mask Only** Outputs only the mask color (see following) in the specified objects’ locations; this is very fast. Use this if you only want to locate the objects in the scene.

Rays not hitting any objects return the Background color, and rays hitting any object not in the subset return the Other Objects color.

**Mask Color** The color returned for specified objects when Mask Only is on.

**Color of Background** The color returned for the background when Mask Only is on.

**Color of Other Objects** The color returned for non-specified objects when Mask Only is on.

**Calculate FG on All Objects (Entire Image)** Determines whether the final gather (FG) preprocessing should apply to all objects, or only those in the subset. Because FG blends neighboring FG samples, a given object might use information in FG points coming from nearby objects not in the subset. This is especially true if the objects are coplanar. Therefore it is advised to let the FG prepass “see” the entire scene.

Turning off this option and creating FG points only for the subset of objects is faster, but there is a certain risk of boundary artifacts, especially in animations. If the scene uses a saved FG map, this option can be left off.

### Output Shaders

The topics in this section describe shaders for managing motion blur as a post process.

### Motion Vector Export (mi)

Render Setup dialog > Renderer panel > Camera Effects rollout > Camera Shaders group > Output button > Material/Map Browser > Motion Vector Export (mi)

**NOTE** Shaders appear in the Browser only if the mental ray renderer is the currently active renderer.

This shader is intended for those who wish to do compositing work before applying motion blur, or to use a specific third-party motion-blur shader. Its purpose is to export motion in pixel space (mental ray’s standard motion vector format is in world space) encoded as a color.
Most third-party tools expect the motion vector encoded as colors where red is the X axis and green is the Y axis. To fit into the confines of a color (especially when not using floating point and a color range extends only from black to white), the motion is scaled by a factor (here called Max Displace) and the resulting value range, which is -1 to 1, is mapped to the color channel’s 0 to 1 range. The shader also support a couple of different floating point output modes.

**Interface**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Max Displace (pixels)</strong></td>
<td>Sets the maximum encoded motion vector length. Motion vectors of this number of pixels or above are encoded as the maximum value that is possible to express within the limit of the color (that is, white or black). To maximally utilize the resolution of the chosen image format, it is recommended that you use a Max Displace value of 50.0 (the default) for eight-bit images (which are not really suitable for this purpose) and a value of 2000.0 for 16-bit images. The shader outputs an informational statement of the maximum motion vector encountered in a frame to aid in tuning this parameter. For details, consult the documentation for your third-party motion-blur shader. If Max Displace is 0.0, motion vectors are encoded relative to the image resolution. For example, for an image 600 pixels wide and 400 pixels high, a movement of 600 pixels in positive X is encoded as 1.0 in the red channel, while a movement 600 pixels in negative X is encoded as 0.0. A movement in positive Y of 400 pixels is encoded as 1.0 in the blue channel etc.</td>
</tr>
<tr>
<td><strong>Blue Channel is Magnitude</strong></td>
<td>When on, the blue color channel represents the magnitude of the blur, and the red and green channels encode the 2D direction only. When off, the blue channel is unused and the red and green channels encode both direction and magnitude.</td>
</tr>
<tr>
<td><strong>Floating Point Format</strong></td>
<td>When not set to 0, the shader writes real, floating-point motion vectors into the red and green channels. They are not normalized to...</td>
</tr>
</tbody>
</table>
the max displace length, not clipped, and contain both positive and negative values. When this option is used, neither Max Displace nor Blue Channel Is Magnitude have any effect.

The floating-point format options are:

1. The actual pixel count is written as-is in floating point.
2. The pixel aspect ratio is taken into account such that the measurement of the distance the pixel moved is expressed in pixels in the Y direction, and the X component will be scaled by the pixel aspect ratio. This format is compatible with Autodesk Toxik.

**Blur Environment/Background** When on, motion vectors are generated for the empty background area controlled by the camera movement.

**NOTE** This option does not work when the Scanline rendering algorithm on page 6743 is enabled.

**HDR Image Motion Blur (mi)**

Render Setup dialog > Renderer panel > Camera Effects rollout > Camera Shaders group > Turn on Output. > Output button > Material/Map Browser > HDR Image Motion Blur (mi)

**NOTE** Shaders appear in the Browser only if the mental ray renderer is the currently active renderer.

This shader applies fast, grain-free motion blur as a post process. It works by using pixel motion vectors stored in the rendering phase and “smearing” these into a visual simulation of motion blur.

Like using the rasterizer, this means that features such as mirror images or even objects seen through foreground transparent object will “streak” together with the foreground object. Furthermore, since the motion frame buffer only stores one segment, the “streaks” are always straight, never curved.

The major advantage of this method is rendering speed. Scene or shader complexity has no impact. The blur is applied as a mental ray “output shader” that is executed after the main rendering pass. The execution time of the output shader depends on how many pixels need to be blurred, and how far each pixel needs to be “smeared.”
NOTE Because the shader works in post, it does not blur shadows or reflections of moving objects. If these effects are necessary, use standard motion-blur methods.

Interface

<table>
<thead>
<tr>
<th>HDR Image Motion Blur [mi] Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shutter Duration (frames) .................. 0.5</td>
</tr>
<tr>
<td>Shutter Falloff (Blur Softness) .......... 2.0</td>
</tr>
<tr>
<td>Blur Environment/Background ................. ✔</td>
</tr>
<tr>
<td>Calculation Color Space (Gamma) ............. 2.2</td>
</tr>
<tr>
<td>Min. Motion Threshold (pixels) .............. 1.0</td>
</tr>
<tr>
<td>Background Distance ......................... 100000.0</td>
</tr>
<tr>
<td>Blur More Objects Near Camera ............... ❌</td>
</tr>
</tbody>
</table>

Shutter Duration (frames) The amount of time the shutter is “open.” In practice this means that after the image has been rendered the pixels are smeared into streaks in both the forward and backward direction. Each smear length is half the distance the object moves during the shutter time.

Shutter Falloff (Blur Softness) The drop-off speed of the smear; that is, how quickly it fades to transparent. This setting controls the “softness” of the blur.

NOTE The perceived length of the motion blur diminishes as the Falloff value increases, so it might be necessary to compensate by increasing the Shutter Duration value slightly.

Thus, falloff is especially useful for creating the effect of over-bright highlights “streaking” convincingly: By using an inflated shutter length (above the cinematic default of 0.5) and a higher falloff, over-brights have the potential to smear in a pleasing manner.

Blur Environment/Background Determines whether the camera environment (that is, the background) should be blurred by the cameras movement or not. When on, pixels from the environment are blurred, and when off they are not.

NOTE This option does not work when the Scanline rendering algorithm on page 6743 is enabled.
Calculation Color Space (Gamma) Defines the gamma color space in which blur calculations occur. Because mental ray output shaders act on written frame buffers, and these buffers (unless floating point) already have any gamma correction applied, it is important to apply post effects with the appropriate gamma.

Min. Motion Threshold (pixels) The minimum motion-vector length (measured in pixels) an object must move for blur to be added. If set to 0.0, it has no effect, and every object with even sub-pixel movement will have a slight amount of blur. While this is technically accurate, it might cause the image to be perceived as overly blurry.

Background Distance The distance to the background, which helps the algorithm calculate the depth layout of the scene. This value should be about the same as the scene depth; anything farther from the camera than this distance would be considered “far away” by the algorithm.

Blur More Objects Near Camera When on, the blurring of objects closer to the camera is more opaque than that of more-distant objects. Because this can result in the blurs of objects very close to the camera to be unrealistically opaque, use this option only when necessary; that is, when the blurs of more-distant objects overwrite those of closer objects.

Normal Bump Map

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser > Normal Bump

The Normal Bump map lets you use a texture-baked Normals map (see Baked Texture Elements on page 6848). Typically you assign it to a material's Bump component, Displacement component, or both. Using the map for Displacement can correct edges that otherwise look unrealistically smooth; however, this adds faces to the geometry.

TIP A Normals map for the indicated material component is generated automatically if you turn on Output Into Normal Bump in the Selected Elements Unique Settings group of the Render To Texture dialog's Output rollout on page 6878.
Interface

Normal As a rule, contains a Normals map generated by Render To Texture on page 6843.
Use the toggle to enable or disable use of the map (default=on). Use the spinner to increase or decrease the map’s effect.

Additional Bump This optional component can contain an additional map to modify the bump or displacement effect. It is treated as a regular bump map on page 6049.
Use the toggle to enable or disable use of the map (default=on). Use the spinner to increase or decrease the map’s effect.

Channel Direction group

By default, the Normals map's red channel indicates left versus right, while green indicates up versus down (and blue indicates vertical distance). The controls in this group let you adjust that interpretation.

Flip Red (X) Flips the red channel so that left and right are reversed.

Flip Green (Y) Flips the green channel so that up and down are reversed.

Swap Red & Green Swaps the red and green channels so that normal mapping rotates 90 degrees.
Method group

The Method group lets you choose which coordinate to use on the normals. These controls are the same as those in the Projection Options dialog on page 6888.

- **Tangent**  (The default.) Project at a tangent to the target object’s surface. This is the method to use for objects that both move and deform, such as animated characters.

- **Local XYZ**  Project using the object’s local coordinates. This method can be used for stationary or moving objects, but not for objects that deform: if the object deforms, the projection will appear incorrect at some frames.

- **Screen**  Project using screen coordinates; that is, flat projection in the Z axis. X is horizontal, increasing in a positive direction to the right; Y is vertical, increasing in a positive direction upward; and Z is perpendicular to the screen, increasing in a positive direction toward the viewer. This method is useful mainly for stationary objects seen only from a single angle; for example, a statue seen through a window.

- **World**  Project using world coordinates. This is useful mainly for objects that don’t move or deform; otherwise, a moving object with world-projected normals will appear to “swim” through the texture.

Camera Map Per Pixel Map

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser > Camera Map per Pixel

The Camera Map Per Pixel map lets you project a map from the direction of a particular camera. It is meant as an aid to 2D matte painting: You can render a scene, adjust the rendering using an image-editing application, then use this adjusted image as a matte that is projected back onto the 3D geometry.

**TIP**  Final rendering can be slow. Script-driven network rendering on page 6905 can help improve performance.
Limitations

The Camera Map Per Pixel does not handle these situations:

- Animated objects.
  The projection does not use UVW mapping.
- Animated textures.
- Occlusion based on a Z-depth channel is handled in a limited way only.

Procedures

To use Camera Map Per Pixel:

1. Create the 3D model.
2. Set up a camera.
3. Set up the rendering resolution you want.
   To get good results, the plate should be at least 2K pixels; 3K to 6K, or higher is recommended.
4. Render the scene to an editable image format such as TIFF on page 7880.
5. Render the scene again, this time to a format such as RPF on page 7875 that has a Z-depth component. Make sure the Z option is turned on.
6. Use an image-editing application to make changes you want to the editable image.
7. Apply Camera Map Per Pixel to the diffuse component on page 6031 of the geometry on which you want the matte to appear. Use these settings:
   - Set Camera to the same camera you used for the renderings.
   - Set Texture to the matte image you edited.
   - Set ZBuffer Mask to the Z-depth rendering (the RPF or RLA file).
     Adjusting (which usually means increasing) the value of ZFudge can improve the quality of edges of the projection.
     Usually it is a good idea to have Remove Back Face Pixels turned on.
     Another way to adjust the projection edge is to adjust this control’s Angle Threshold.

TIP If you have persistent problems with seams, try generating a mask with an alpha channel and using it to clean up the edge of the projection.
If you have multiple mattes to project, you might need to slice geometry to make each map’s target a separate object.

**Interface**

<table>
<thead>
<tr>
<th>Map Channel</th>
<th>Sets which map channel to use. Default=1.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Camera:</td>
<td>None</td>
</tr>
<tr>
<td>Texture:</td>
<td>None</td>
</tr>
<tr>
<td>ZBuffer Mask:</td>
<td>None</td>
</tr>
<tr>
<td>ZFudge:</td>
<td>1.0</td>
</tr>
<tr>
<td>Mask:</td>
<td>None</td>
</tr>
<tr>
<td>Mask Uses the Camera Projection</td>
<td></td>
</tr>
<tr>
<td>Remove Back Face Pixels</td>
<td></td>
</tr>
<tr>
<td>Angle Threshold:</td>
<td>90.0</td>
</tr>
</tbody>
</table>

**Map Channel** Sets which map channel to use. Default=1.

**Camera** Click to turn on, and then choose a camera in the scene by selecting it in a viewport, or press H to use the Pick Object dialog on page 206.
Once you have assigned a camera, its name appears on this button.
This camera should be the one used to render the map used in the Texture and ZBuffer Mask components.

**Texture** Click to assign the texture to project. You can assign any kind of map, but typically this is a Bitmap on page 6213 that contains an image file that you first rendered from the same camera, and then possibly edited with a different application.

**ZBuffer Mask** Click to assign a map that contains Z-depth data used to mask the projection from unwanted surfaces. Typically this is an RPF file on page 7875 or an RLA file on page 7873 rendered using the same camera, with the Z channel option turned on.
Use the toggle to turn use of the ZBuffer Mask on or off. By default, it is off, and it is not turned on automatically when you assign the ZBuffer Mask.

- **ZFudge**  
  ZFudge values other than 1.0 add a margin of deviation to the use of the Z-depth data, letting you fine-tune the Z-Buffer masking. Default=1.0.

- **Mask**  
  Behaves like the mask in the Mask map on page 6338 by letting you view one map through another. Black areas of the mask are transparent, white areas are opaque, and gray areas are partially transparent, based on the percentage of the gray.

- **Mask Uses the Camera Projection**  
  When on, the mask uses the same camera projection as the Texture and ZBuffer Mask. When off, it uses the object’s UVW coordinates. Default=on.

- **Remove Back Face Pixels**  
  When on, sets the projection to exclude surfaces that face away from the camera, based on the value of Angle Threshold. Default=on.

- **Angle Threshold**  
  Specifies the angle to use as a cutoff when removing backface pixels. Default=90.0. At the default of 90 degrees, faces perpendicular to the camera, or at a greater angle, are not projected.

### Material, Mapping, and Vertex Color Utilities

The topics in this section describe various tools and utilities for managing vertex color, materials, and maps.

#### Viewport Canvas

Tools menu > Viewport Canvas

Viewport Canvas provides tools for painting onto an object’s texture on page 8741 directly in the viewport. It turns the active viewport into a two-dimensional canvas that you can use to paint on and then apply the result to the object’s texture. There is also an option to export the current view, so you can modify it in a paint program such as Adobe Photoshop, and then save the file and update the texture in 3ds Max.
You start by choosing a brush and activating one of the painting tools: Paint or Clone. You then paint on the screen, and when you are happy with the results you right-click to exit the tool. The system then calculates the resulting map, which can take a few seconds depending on the size of the new texture. The system updates only parts of the texture that you painted on, so you don't lose resolution in other parts of the texture.

For maximum accuracy, use TIFF-format textures; this ensures lossless save files. Also, set the viewport display of textures to the highest possible resolution. You can do that by going into Customize > Preferences > Viewports > Configure Driver and turning on Match Bitmap Size As Closely As Possible. We also recommend that you use Direct3D as a viewport driver for the most accurate results when painting.

When using the clone tool you can pick clone points from anywhere in the viewport, so you could, for example, clone from a background image in the viewport or from the texture of another model. You can make custom brushes to work with Viewport canvas, and if you do these brushfiles should be in TIFF format. Read more about creating custom brushes below.

An important consideration when working with Viewport Canvas is to paint at such a distance from the object that the screen pixels and texture pixels are roughly the same size. If the screen pixels are much larger the result could become pixelated. If you are zoomed in too close you might lose some of the painted detail, because the texture doesn’t contain enough pixels to represent the painted detail. If the screen pixels are much larger than the texture pixels, you will get gaps in the paint.

The general rule is that there should be, at most, 10 texture pixels for every screen pixel. Because circumstances vary, you’ll probably need to use trial and error to determine the best distance for your situation.

**NOTE** To paint on an object surface successfully, its UVW mapping must be inside the boundaries of the UVW limits (0.0 to 1.0). For example, if Real-World Map Size on page 6188 is enabled for a primitive before converting it to editable poly, first adjust the mapping to be within those limits.

**IMPORTANT** When using the clone tool to pick up paint from the canvas, we recommend that you set the viewport driver > Texel Lookup on page 8330 to Nearest, if possible. This provides the sharpest representation of the texture in the viewport, thus producing more accurate results when the paint is projected. This is because you can clone only from what is visible in the viewport.
Procedures

To use the Clone tool in Viewport Canvas:

1 Set up the scene with the following:
   ■ An object to paint on. The object must be an editable poly on page 2240 and have a Standard material on page 5962 applied that uses a bitmap for the Diffuse map. Alternatively, you can use Setup on page 6464 to create the Standard material and Diffuse bitmap texture automatically.
   ■ One or more images to clone from. These can be a background image or textures applied to objects in the scene, including the object you’re painting on. The images must be visible in the viewport.

   NOTE You can clone only from areas of the image or images that are visible in the viewport. If the image is truncated because it extends beyond the viewport edge, you cannot clone from the area outside the viewport. Also, any foreshortening of the original image due to the viewing angle is reproduced in the cloned image. For best results, paint in an orthographic viewport.

2 In a shaded viewport, select the object to paint on.

3 Click the Clone button.
   The objects in the viewport become unshaded. Cloning textures always applies unshaded images.
   You’re now ready to pick the texture to clone.

4 Position the mouse cursor over the texture to clone in the active viewport, press and hold Alt, click the left mouse button, and release Alt.
   You’re now ready to paint using the cloned image.

5 Move the mouse to the object to paint on, and then press and hold the left mouse button and drag to paint.
   Painting starts with the part of the image you cloned initially, and continues to surrounding areas as you drag. If you release the mouse, move it, and then start painting again, the painting continues with the same offset from the original. To paint from a different part of the cloned texture, repeat steps 4 and 5.

6 To finish using Clone, right-click in the viewport or click the Clone button again to toggle it off.
Interface
Setup Opens the Object Setup dialog on page 6464, with settings for generating a texture map automatically.

Paint group

Current Brush  Shows the current brush image at the actual size (within the limits of the dialog width).

Select Brush  Opens the Brush Selection dialog, which lets you choose a different brush image.

Here you can choose from one of the provided images or from any number of custom brushes that you define. You can also first set the brush size, which is reflected in the main Size setting (see following).

To create a custom brush, make a square, black-and-white image (white is opaque, shades of gray produce degrees of transparency, and black is completely transparent) in a paint program. Save it as a TIFF image file in the folder that opens when you click the Browse Custom Brush Directory button.
The new brush then shows up the next time you open the Brush Selection dialog.

**Size** The size of the brush in pixels.

**Brush Type** Choose the painting method:

- **Airbrush** The paint is applied continuously.
- **Layer** Adds a solid layer of paint at the current opacity.

**Blending Mode** Photoshop-type blend modes on page 6336 that determine how the paint is applied to the canvas. The available modes are Normal (regular color), Multiply, Screen, Overlay, Hard Light, Darken, Lighten, Hue, Saturation, Color, Luminosity, Dodge, and Burn. The Dodge and Burn tools affect the existing color on the canvas and do not add color.

**Paint** Starts the Paint tool. This tool can work only on a single editable object, and the object must have a Standard material containing a bitmap as the Diffuse map. The object also needs UVW coordinates.

On startup, the Paint tool sets up the viewport so that it is ready to draw on. The model is unshaded so that you see only the texture.

You can paint anywhere on the model, changing the color, opacity, brushes and so on. You can have **Edged Faces** on page 8377 enabled for reference but those edges will be painted over unless you turn on Draw Wireframe (see following). While this tool is active you cannot navigate the viewport.

The following options are available while using Paint:

- **Normal** Paints strokes with the current color.
- **Shift** Eraser: Erases parts of what you have drawn during the current activation of the tool. You can set the eraser opacity independent of the brush opacity.
- **Ctrl** Samples color from the canvas; picks a single pixel from the center of the brush.
- **Ctrl+Shift** Hold and drag vertically to resize the current brush interactively.
- **Right-click** Exits the tool and applies the paint to the model's texture. A progress bar updates in the interface during calculations. If you do not want to apply the paint to the model, first turn off Apply Paint. Right-clicking then simply exits the tool.
Clone  Starts the Clone tool. This tool can work only on a single editable poly object, and the object must have a Standard material containing a bitmap as the Diffuse map. The object also needs UVW coordinates.

To use Clone, first press and hold Alt while clicking a point on the screen to clone from, then release Alt and paint on the selected object. The paint is sampled from the point you first clicked. For more information, see this procedure on page 6457.

On startup, the Paint tool sets up the viewport so that it is ready to draw on. The model is unshaded so that you see only the texture.

You can paint anywhere on the model, changing the color, opacity, brushes and so on. You can have Edged Faces on page 8377 enabled for reference but those edges will be painted over unless you turn on Draw Wireframe (see following). While this tool is active you cannot navigate the viewport.

The following options are available while using Clone:

- **Alt**  Use to choose a location in the viewport to sample from (press and hold, click, release). You can redefine the source location whenever you want by picking another point.

- **Normal**  Clone parts of the viewport by painting on the selected object.

- **Shift**  Eraser: Erases parts of what you have drawn during the current activation of the tool. You can set the eraser opacity independent of the brush opacity.

- **Ctrl+Shift**  Hold and drag vertically to resize the current brush interactively.

- **Right-click**  Exits the tool and applies the paint to the model's texture. A progress bar updates in the interface during calculations. If you do not want to apply the paint to the model, first turn off Apply Paint. Right-clicking then simply exits the tool.

**Color**  Click the color swatch to open the Color Selector on page 371, which lets you change the paint color.

**Black/White**  Set the paint color to black or white by clicking the upper or lower button, respectively.

**Sample Color**  Lets you sample a color from the active viewport. Activate the tool and click in the viewport to pick a color. Hold and drag to choose a
color interactively while the color is updated in the interface. Right-click to exit the tool. For best results, do not rotate or pan the viewport while the tool is active.

**Opacity** Sets the opacity for the current brush, for both the Paint and Clone tools. A value of 100 is fully opaque.

**Eraser Opacity** Sets the opacity for the eraser, for both the Paint and Clone tools. To activate the eraser, press and hold Shift while painting. A value of 100 is fully opaque.

**Apply Paint** When on, exiting Paint or Clone mode applies the paint to the model texture. When off, the tool simply exits.

**Undo/Redo** Undoes and redoes the last projection to the model. Not available while a painting tool is active.

**Export View group**

Use these tools to capture the current viewport and save it as a file that you can edit in an external paint program. After saving the file with the changes, click the Update Texture button to apply the paint to the model’s texture. To prevent edges from showing up in the texture, turn off *Edged Faces display mode* on page 8130 when using this tool.

**Capture View** Captures the current view as an image and prompts you to save it as a TIFF-format image file.

**Update Texture** Applies changes in the saved image to the model’s texture.

**Options group**

Various options for working with Viewport Canvas.

**Generate Alpha Mask** Produces a black-and-white image where the white pixels represent parts that have been changed in the model’s texture and the black pixels are untouched areas. You could use this image to mask a layer in a paint program containing the painted texture, if, for example, you cloned away some seams and only want the cloned parts visible in a layer.

The maskfile has the same disk location as the model’s texture map and the same filename, but with "_mask" added to the end of the file name.

**Live Brush Preview** When on, the brush cursor displays a preview of what will be painted. This is particularly useful when using the Clone brush, to see which part of the source will be cloned.
Draw Wireframe  When on while using the painting tools, the wireframe of the object is drawn. The wireframe can be a useful reference for where you are painting on the model. When off, you can still have the wireframe showing when you enter a painting tool, but the wireframe will be painted over.

File Handling  Lets you choose how the generated texture is handled when you exit Paint or Clone mode:

- **Auto Update Diffusemap**  The model’s current texture map is automatically updated and shown on the model in the viewport.

- **Show In Frame Buffer**  The model’s texture is not overwritten; instead, the new texture is shown in a separate window (the virtual frame buffer), from which you can save the texture.

Object Setup Dialog

Tools menu > Viewport Canvas > Click Setup.

This dialog sets up an object for painting with Viewport Canvas tools. When you click Setup, it assigns a Standard material to the selected object, with a Bitmap map assigned to Diffuse coloring. You can use an existing bitmap or let Setup create one for you. If your object already has a Standard material with a Bitmap Diffuse map, it is not necessary to use this dialog.
Interface

Assign new texture Creates a new texture. Use the Assign Texture group controls to set the size and background color, and the Save New Texture To controls to specify the path and file name for the texture, and then click Setup.

Use existing texture Use this option to create a new Standard material with an existing Bitmap Diffuse map. Use the the Pick Texture button to specify the graphics file to use for the texture, and then click Setup.

Assign Texture Use these controls to specify the size and background color for the new texture. Available only when Assign New Texture is chosen.

Save new texture to Enter the new texture path and file name (with legitimate extension) in the text field, or click the “…” button to specify the path and file name using a file dialog. Available only when Assign New Texture is chosen.

Pick texture Click to designate an existing graphics file to use as the texture for the new material. Available only when Use Existing Texture is chosen.
**Render Surface Map**

Rendering menu > Render Surface Map

This dialog provides a set of tools for creating bitmaps based on an object’s UVW mapping. The bitmaps display certain surface properties of the object. There’s also a Bitmap Select function for selecting sub-objects based on mapping attributes.

**NOTE** These tools work only with editable poly objects. If you attempt to use one with another type of object, even if it has an Edit Poly modifier applied, nothing happens.

Also, the object must have a map channel on page 8627 (typically 1) corresponding to the current Map Channel setting on the Render Surface Map dialog. If the object has no map channel, an error message informs you of this fact. To provide a map channel, apply an Unwrap UVW on page 1837 or UVW Map on page 1932 modifier and then convert the object to an editable poly.

**Procedure**

**Example: To use Render Surface Map:**

This procedure describes how to create a surface map and then use it in a material.

1. From the Rendering menu, choose Render Surface Map.
   This opens the Render Surface Map dialog.

2. Select the editable poly object for which to generate the surface map.

3. Set the Map Channel parameter on the Render Surface Map dialog to that of the object.
IMPORTANT Make sure the object has a mapping channel and that Map Channel is set to that channel. If you attempt to render a surface map and encounter a message that says that the map channel does not exist, either set Map Channel to the correct value, or, if the object has no mapping, create mapping for it. To do so, apply a mapping modifier such as Unwrap UVW on page 1837 or UVW Map on page 1932 and then collapse on page 2022 the modifier stack.

Also, for best results, make sure mapping clusters do not overlap. For example, in the Unwrap UVW modifier, use the Flatten Mapping on page 1876 tool.

4 Click one of the top four buttons on the Render Surface Map dialog: Cavity Map on page 6469, Density Map on page 6469, Dust Map on page 6470, or SubSurface Map on page 6471.

For example, to generate a texture that makes the object look dirty in concave areas, use Cavity Map.

After a brief pause, the generated texture opens in a separate window. The texture type (such as Cavity Map) appears in the window’s title bar.

5 On the output window toolbar, click the Save Image button. Specify a name, type (graphics format), and location for the file, and then click Save.

6 Use the Material Editor to assign the saved image file as a Diffuse map in a material, and then assign the material to the object you used to generate the map.
Interface

W/H The width and height of the bitmap to generate.

TIP When generating bitmaps for use in real-time-rendering applications, such as games, both dimensions should be powers of 2, such as 256 or 512.

Size Choose a size from the list of presets.

Map Channel The map channel to use when generating the bitmap.
Seam Bleed  Determines how many pixels are added at UVW borders as “padding.” These bled pixels will never overwrite the pixels within UVW seams. This value has no effect in SelectionToBitmap.

Bitmap Type

Cavity Map  Generate a grayscale image that displays how convex or concave the surface of an editable poly object is at a given point. The more concave the surface is the darker the pixels will be and the more convex the surface is the more white is added to the pixels. This image can be used as a cavity or "dirt" map, or as a base for further texture painting.

Contrast  Determines how much extra contrast is added. In a very high resolution mesh the surface does not change much from polygon to polygon, so in such cases it might be neccessary to increase the contrast to get the difference in concavity/convexity to show clearly.

Density Map  Generates a grayscale image that displays how dense the editable poly mesh is at a given point. White areas represent the smallest distance between vertices and black represents the greatest distance.
A Density map created from a character head

**Dust Map** Generates a grayscale image that the extent to which each point in the surface faces the world Z direction. White represents vertices pointing fully in the Z direction and black represents vertices pointing 90 degrees from the Z axis (that is, parallel to the world XY plane) or below.
A Dust map created from a character head

SubSurface Map Generates a grayscale image that displays an estimation of the relative volume of a poly object at a given point. White represents the thinnest parts and black represents the thickest parts. You can then use this map to simulate greater translucency in thin areas.

The resulting map does not necessarily represent accurately how light would pass through the surface but can be useful for simulating this.
SubSurface maps created from a poly mesh, showing different Blur values

The upper two images use flat shading so that only the texture is visible.

**Blur** The degree of blurring applied to the generated map.

In the preceding illustration, the top rendering has Blur set to 4, while the center one has Blur set to 40. The bottom rendering shows the poly object without a texture map.

**SelectionToBitmap** Generates a black-and-white bitmap based on the current sub-object selection and displays it in a window from which you can save it. White areas in the output image indicate selected sub-objects at that location. At the vertex level each vertex gets a white dot. At the edge level each edge gets a dot in the middle of the edge. At the polygon level each polygon is filled with white color.

You can use a bitmap generated with SelectionToBitmap for selecting sub-objects with the Bitmap Select tool (see following).
NOTE You can assign CUI shortcuts on page 8249 (PolyTools category) for SelectionToBitmap. When assigned as shortcuts, the image is generated as follows:

- **Normal (no key)** Creates a 256x256 bitmap.
- **Shift** Creates a 512x512 bitmap.

---

**Texture Wrap**

This tool creates a texture map from an input texture and wraps it around the selected object in a way that creates no texture seams and with a uniform texture scale across the surface. It projects the input texture from all directions and blends the result based on surface normal. A good use for this tool is to provide a base texture for a model. For example, you can create a basic skin texture and wrap that around the whole character model in a seamless way. Another use is for complex shapes such as a tree and all its branches.

To use Texture Wrap, first click Pick Texture to specify a texture file, then select the object to wrap and click Texture Wrap.
TIP For complex objects, use the Flatten Mapping on page 1893 feature of the Unwrap UVW modifier to create UVW coordinates for all parts of a mesh. You can then use Texture Wrap to wrap a texture around that object with good results across texture seams.

NOTE This tool might not produce ideal results with very-low-resolution models that have many sharp angles between faces. It works best with organic surfaces that have some curvature.

Pick Texture Opens a file dialog for specifying an image file to wrap as the texture.

Tile The number of times the texture will be repeated across the object, both horizontally and vertically.

Texture Wrap With an editable poly object selected, click to wrap the texture.

Bitmap Select

Enables you to select parts of the model based on a bitmap image.

Bitmap Select Opens the Bitmap Select dialog.
Bitmap Select Dialog

Rendering menu > Render Surface Map > Bitmap Select

With Bitmap Select you can select sub-objects in the model based on a bitmap image. Bitmap Select applies the chosen bitmap for selection purposes based on the model's UVW mapping (it need not be part of a material applied to the object), and uses it to select parts of the mesh that correspond to a defined color. For example, you can select all polygons that have the color white in the chosen bitmap.

This way you can save a sub-object selection that will survive any topology changes, and quickly select hard-to-reach areas of the model. You can also have many selections stored in the same bitmap, because every color in the bitmap can be defined as a separate selection. It is recommended that you use lossless formats for the bitmap, such as Targa or or BMP, because a format such as compressed JPEG can lose color information in the compression.

Bitmap Select works at all sub-object levels. The software uses the following guidelines to determine a sub-object's color:

■ At the Vertex level, the vertex must have the specified color to be selected.
■ At the Edge level, the center of the edge must have the specified color to be selected.
■ At the Polygon level, the center of the polygon must have the specified color to be selected.

IMPORTANT Bitmap Select uses the bitmap as tiled once on each texture axis (U/V/W) and applied to the object using its UVW mapping. Even if, for example, you’ve applied the bitmap to the object’s material’s Diffuse map and used the Tiling settings to repeat it across the surface, Bitmap Select treats it as untiled (Tiling=1.0) for the purposes of selecting sub-objects. Also, even if you’ve modified the tiling with the UVW Map modifier, Bitmap Select works only within the basic UVW space (0,1).

Procedure

To use Bitmap Select:

1 Use the map slot buttons to choose from one to four bitmaps to use for selection.
**TIP** To see a bitmap on the object, apply it as a Diffuse map to an unused material and apply the material temporarily to the object. Leave the Tiling values at their defaults (1.0, 1.0).

2 Set the Use Mapslot value to the number of the map slot to use for selection. Also, if necessary, change the map channel value.

3 Set Get Selection From to the color to use for making the selection. Any sub-objects with that color will be selected.

4 Select an editable poly object and access the sub-object level, such as Vertex or Polygon, at which you want Bitmap Select to work.

5 Click GO to make the selection.

**Interface**

![Bitmap Select Interface](image)

- **Map1-Map4** Use these mapslot buttons to specify bitmaps to use in getting the selection. Clicking a button opens the Material/Map Browser on page 5724. Use the C button next to a mapslot to clear the map assigned to that slot.

- **Use Mapslot** The map slot (1-4) Bitmap Select uses for making the selection.

- **Mapchannel** The map channel to use in making the selection.

- **Get selection from** Determines which bitmap color Bitmap Select uses for getting the selection. For example, if you choose White at the Polygon...
sub-object level, all polygons that have a corresponding white color in the bitmap, based on the UVW layout, will be selected.

To use a color other than white or black, choose Color and then click the color swatch. Use the Color Selector to choose the color to use in getting the selection.

**NOTE** There is a slight tolerance for the color so the color does not have to be exact but is allowed to differ slightly.

**Go** Makes the selection based on the supplied criteria.

---

### Assign Vertex Colors Utility

Utilities panel > Utilities rollout > More button > Utilities dialog > Assign Vertex Colors

The Assign Vertex Colors utility assigns vertex colors based on the material assigned to the object and the lighting in the scene. The utility applies a **VertexPaint modifier** on page 1959 to the object when Assign To Selected is clicked. Once the VertexPaint modifier has been applied to the object, go to the Modify panel or click Edit to access the VertexPaint tools.

**TIP** To render vertex colors, you must apply a material that has a **Vertex Color map** on page 6355 in its diffuse component. To view vertex colors in viewports, right-click the object, choose **Object Properties** on page 283 from the quad menu, and then turn on Vertex Channel Display in the Display Properties group and make sure the drop-down option is set to Vertex Color.

The Assign Vertex Colors utility supports light inclusion or exclusion when using the Scene Lights option.

All of the commands found within the Assign Vertex Color utility are also available from the Modify panel when a VertexPaint modifier has been applied to an object.

**Vertex Colors and Radiosity**

The Vertex Colors utility supports **radiosity** on page 6615. If you use radiosity with assigned vertex colors, be sure to turn on the option Re-Use Direct Illumination From Radiosity Solution. This option is in the Rendering Parameters rollout. See **Radiosity Controls** on page 6634. When this option is on, the renderer simply displays the vertex colors assigned by the radiosity solution: strictly speaking, it is not rendering at all.
The additional option Render Direct Illumination, also on the Rendering Parameters rollout, causes direct lighting not to be saved in the corresponding mesh. This corresponds to the options Radiosity, Render Direct Illumination, in which case Assign Vertex Colors gets indirect illumination from the radiosity mesh but renders direct illumination separately; or Radiosity, Indirect Illumination Only, in which case Assign Vertex Colors doesn't apply direct illumination to vertices at all.

See also:

- VertexPaint Modifier on page 1959
- Vertex Color Map on page 6355

Procedures

To use the Assign Vertex Colors utility:

1. Assign materials to the objects you want to affect. These can be mapped or unmapped materials.
2. Light the objects.
3. Select the objects you want to affect.
4. Open the Object Properties dialog for each object, click to turn off the By Layer button, turn on Vertex Channel Display, and click OK.
5. Expand the Display Properties rollout in the Display panel and turn on Vertex Colors.
6. Access the Assign Vertex Colors utility.
7. Choose one of the Light Model options.
8. Choose one of the Color Assignment choices.
9. Click Assign to Selected.

VertexPaint modifiers are applied to the selected objects, and the vertex colors for the objects are taken from their materials and from the lighting in the scene, depending on the options you choose under Light Model.

Changing the material or the lighting in the scene won’t change the vertex colors. To do this, click the Update All button.
NOTE The new vertex colors are stored in the Vertex Paint modifier. If you want to access them, go to the Modify panel and access the parameters in the rollouts there. You can also use the tools found in the Vertex Paint floating dialog to create layers, paint, blur or adjust color. The Vertex Paint floater launches when you go to the Modify panel and the object is selected.

Example: To use the Assign Vertex Colors utility on a specific object:

1. Create a sphere with 24 segments.
2. Apply a mapped material to the sphere, and turn on Show Map In Viewports.
   The mapped sphere is displayed in the viewport.
3. Apply a mapped material to the sphere.
   NOTE Choose a simple, well-defined map with large, easily-distinguished areas.
4. Open the Object Properties dialog for the sphere, turn on Vertex Colors, and click OK.
5. Open the Object Properties dialog for the sphere, click to turn off the By Layer button, turn on Vertex Channel Display, and click OK. The sphere turns white because you’re now displaying its vertex colors, and they’re all white as a default.
6. With the sphere selected, open the Assign Vertex Colors utility.
7. Choose Shaded and turn on Use Maps.
8. Turn on Mapping.
9. Click Assign To Selected.
   A blurred version of the mapping appears on the sphere. The vertices are now colored based on the material and the lighting in the scene. The mapping is blurred because the resolution of the mesh at 24 segments is much lower than the pixel resolution of the map.
10. Go to the Modify panel and note the VertexPaint modifier.
11. Move down in the Stack to the creation parameters, click Yes at the warning prompt, and increase the Segments to 70.
   The new vertices shift the already assigned vertices.
Return to the VertexPaint level of the stack, and click Assign in the Assign Vertex Colors rollout. Had we returned to the Utilities panel, we would have added another Vertex Paint modifier to the stack; clicking Assign in the VertexPaint Modifier only updates that modifier.

**TIP** Vertex colors will only show up in a rendered scene if you assign the Vertex Color map to the diffuse channel. However, if you do this, you can't properly update your vertex colors with the Assign Vertex Colors utility. The solution is to assign a Blend material to your object. Assign the straight diffuse bitmap to Material 1, and the Vertex Color map to Material 2 of the Blend. Switch to 100 percent of Material 2 when rendering, and 100 percent of Material 1 when updating the vertex colors.
Channel group

Here you'll find tools to choose which channel type the vertex color utility will assign. If you choose map channel, you can also specify the map channel ID number.

- **Vertex Color**  Choose this to assign a vertex color layer.
- **Vertex Illum**  Choose this to assign a vertex lighting layer.
- **Vertex Alpha**  Choose this to assign a vertex transparency layer.
- **Map Channel**  Choose this to assign a specifically numbered map channel.
  - **Map channel spinner**  Use this to define the channel number. Available only when Map Channel is chosen.

**Name**  If a channel has a name defined, it will appear here. Channels can be named using the Channel Info Utility on page 6486.

**NOTE**  Although the Color, Illum, and Alpha channels have specific names, in fact 3ds Max does not enforce what kind of data is saved in them, and any of the three channels can contain four-channel (RGBA) vertex color data.

Light Model group

Provides options that let you specify how the surface of the object appears to be illuminated.
**Lighting + Diffuse**  Uses the current scene lighting and materials to affect the vertex colors.

**Lighting Only**  Uses only lighting to assign vertex colors, ignoring material properties.
When this option is chosen, Shadows and Mapping are disabled in the Rendering Options rollout.

**Diffuse**  Uses the material's diffuse color, ignoring the lighting.

**Color Assignment group**

Lets you specify how colors are interpolated across surfaces.

**Color by Face**  (The default.) Colors are interpolated between the center of each face. Color By Face samples fewer points, so it is the quicker method. On the other hand, results are less accurate.

**Color by Vertex**  Colors are interpolated between vertices. For each face, this method uses three points instead of one, so it is slower but usually more accurate. An exception can occur when an object's shadow falls between two vertices: in such a case, the object should occlude lighting, but because only vertices are taken into account, the shadow is not calculated and a “light leak” occurs.
Rendering Options group

The options in this group let you choose whether to include shadows, texture maps, or a radiosity solution in vertex colors.

**NOTE** You can save a radiosity solution in vertex colors, but not Light Tracer on page 6601 illumination, which is not stored in the scene's geometry.

**Shadows** When on, shadows are used when the vertices are shaded. Default=off.

**TIP** You can soften the shadow edge by using the VertexPaint modifier’s Paint or Blur tools.

**Mapping** When on, texture maps are used when the vertices are shaded. Default=off.
The radio buttons specify how to use radiosity data.

- **No Radiosity**  (The default.) Do not use the radiosity solution when assigning vertex colors.

  NOTE This option is the only one available unless a radiosity solution on page 6615 is present in the scene.

- **Radiosity, Reuse Direct Illum. from Solution**  Includes radiosity in the vertex color assignments, and uses the direct illumination from the solution.
  This is comparable to the choice Re-Use Direct Illumination From Radiosity Solution on the Rendering Parameters rollout on page 6653.
  This choice disables the Shadows toggle, because shadows don’t need to be recomputed.

- **Radiosity, Render Direct Illumination**  Includes radiosity in the vertex color assignments, but uses a separate pass to render direct illumination.
  This is comparable to the choice Render Direct Illumination on the Rendering Parameters rollout on page 6653.

- **Radiosity, Indirect Illum. Only**  Includes only indirect illumination from the radiosity solution in the vertex color assignments.
  This choice disables the Shadows toggle, because shadows don’t need to be recomputed.

**Reminder field**  Displays a message that says whether regathering is enabled or disabled. Regathering provides the most accurate radiosity results, but it can add considerable time to radiosity calculations.

**Radiosity Setup**  Click to display the Advanced Lighting panel on page 6600 of the Render Setup dialog, where you can set up and generate a radiosity solution.
If the mental ray renderer is the active renderer, this button is not available.

---

**Assign to Selected**  Assigns vertex colors to the selected objects based on the assigned material, and the choices specified in the preceding group boxes.
Assign to Selected creates a VertexPaint modifier and adds it to the stack of the selected objects.
Edit Click to display the VertexPaint Paintbox on page 1969, the floating dialog that holds the vertex painting tools. This button is unavailable if you haven’t yet clicked Assign To Selected.

Channel Info Utility

Utilities panel > More button > Channel Info > Click Channel Info button.
Tools menu > Channel Info

The Channel Info utility gives game artists and others direct access to objects' channel information that might not otherwise be easily available. All objects in 3ds Max have mapping channels, which hold information pertinent to texture mapping as well as vertex color, illumination, and alpha. Mesh objects also have geometry and vertex-selection channels. The Channel Info utility lets you view an object’s channels, give them meaningful names, delete unused channels, and copy information between channels.

The utility’s Map Channel Info dialog shows all the channel data for selected objects. It displays the number of channels, the number of vertices per channel, and how much memory the channel uses. It also lets you name channels, as well as clear (or delete), copy, and paste channels. Each of these commands except renaming puts a modifier on the stack to achieve the results.

**NOTE** Channel Info supports mesh, polygon, and patch objects. It does not support NURBS objects.

See also:

- Vertex Color Map on page 6355
- Skin Utilities on page 4213
- Select By Channel Modifier on page 1654
- UVW Mapping Add Modifier on page 1954
- UVW Mapping Clear Modifier on page 1954
- UVW Mapping Paste Modifier on page 1955
Procedures

To use the Channel Info utility:

1 Select an object or objects to use with the utility.

2 Open the utility.
   The Map Channel Info dialog opens.

3 To create a map channel, click any channel and then click the Add button.
   The new, empty channel appears at the end of the list.

4 Most channels have three components. For example, a mesh or map channel has X, Y, and Z components, and an alpha channel has R, G, and B components. To expand all three-component channels, click the SubComp button. To collapse all expanded channels, click SubComp again.

5 To copy one channel to another, click the source channel, click Copy, and then click the destination channel and click Paste.
   In some cases, you might need to expand or collapse the component display (see previous step). For example, when copying a vertex selection (vsel) channel to a map channel, you must paste the vsel channel to a component channel.

6 To minimize a channel's memory footprint, click the channel and then click the Clear button.
   This removes most all or of the data from the channel, so first make sure the data is unnecessary or is available elsewhere. If the cleared channel is the last one in the list, it might be deleted from the list.
Interface

The primary user interface of the Channel Info utility is the Map Channel Info dialog, which you open by clicking the utility's Channel Info button on the command panel. This modeless dialog shows information about all map channels belonging to the current selection, at the object level. If you change the selection, the dialog automatically updates to reflect the selection.

The dialog consists of two parts: a button toolbar at the top, and a tabular display of map channels belonging to each object in the current selection.

Channel Info toolbar

**Copy** Copies the channel data from the highlighted channel to the copy buffer, where it becomes available for pasting. After you copy a channel, its name appears on the line below the button toolbar.

**Paste** Pastes the contents of the copy buffer to the highlighted channel. You can copy and paste only between channels with the same topology, or you can copy from any channel to a channel with no vertices.

Source and destination channels need not be of the same type. For instance, you can copy from a mesh channel to a map channel, and vice-versa.

**Name** Lets you rename the highlighted channel. Click this button to open a small dialog that displays the current channel name and lets you edit this name or enter a new one from the keyboard.

**Clear** Use this function to remove channels or delete data from a map channel (including alpha, illumination, and vertex color channels). Clear has no effect on geometry or vertex selection channels.
The specific result depends on the type of object and which channel you clear. In terms of reducing the object's memory footprint, the utility is most effective with Editable Poly objects.

- **Geometric primitive or Editable/Edit Mesh object**  Deletes the highlighted texture map channel if it is the last map channel in the object, and it's not the default map channel (1:map). If the highlighted channel is not the last, Clear deletes all vertices in the channel. The faces remain, so the memory-footprint reduction is partial.

  **NOTE** This also applies to objects that collapse to editable mesh, such as Loft objects.

- **Editable Poly object**  Deletes the highlighted texture map channel if it is the last map channel in the object, and it's not the default map channel. If the highlighted channel is not the last, Clear deletes all vertices and faces in the channel.

- **Patch object**  Deletes the highlighted texture map channel if it is the last map channel in the object, and it's not the default map channel. If the highlighted channel is not the last, Clear has no effect.

  **NOTE** When you use the Clear function, 3ds Max adds a UVW Mapping Clear modifier to the object's modifier stack. You can recover the deleted data by removing the modifier from the stack, or changing its Map Channel setting.

**Add** Appends a new map channel to the object's channel list. If multiple objects are selected, Add becomes available only after you click a track, so 3ds Max knows which object to add the channel to.

  **NOTE** If you apply mapping with a channel number higher than any existing channels, 3ds Max automatically creates all intermediate channels. For example, if you apply a UVW Mapping modifier to a standard object and set Map Channel to 5 in the modifier, 3ds Max adds map channels 2, 3, 4, and 5.

**SubComp** Toggles display of the channels' subcomponents. When displayed, you can rename, copy, and paste each subcomponent independently of its parent channel.

Each channel except vsel has three subcomponents. Mesh and map channels' subcomponents are labeled X, Y, and Z; those of alpha, illumination, and vertex color channels are R, G, and B (red, green, and blue).

**Lock** Retains the current mapping data information in the table even if you change the selection.
For example, if you want to see mapping data for a specific object or objects constantly, first select the objects and then click Lock. Thereafter, if you select different objects in the viewport, the table continues to display the data for the selection when you clicked Lock. If you turn off Lock, the table updates to show data only for the current selection.

If you click Update when Lock is on, 3ds Max will refresh the table contents to reflect the current selection, and then retain that data.

**Update** Refreshes the displayed data to reflect any changes in the objects or mapping, or, when Lock is on, the selection.

For example, if you apply mapping to an object, or change its mapping, click Update to display the changes in the Map Channel Info dialog.

### Channel Info Table

The table functions similarly to a spreadsheet. If not all rows or columns are visible, you can scroll the table using standard methods, including rolling the mouse wheel for vertical scrolling. To highlight a row, click anywhere in the row. You can highlight only one row at a time. To resize a column, drag the vertical divider at the right of the column heading. To automatically set a column's width to the size of the longest entry, double-click the vertical divider to the right of the column heading.

Following is a brief explanation of each of the columns in the table:

**Object Name** The name of the object. If you change the name in the Modify panel, click the dialog's Update button to display the new name in the dialog.

**ID** The type of channel. The available channel types are:

- **mesh/poly** The object's mesh or poly data, depending on whether it's a mesh or poly object: vertices and faces. You can copy this channel and paste it to any other three-component channel.
  
  This channel is not available for patch objects.

- **vsel** The vertex selection. You can copy this channel and paste it to other channels' subcomponents.
  
  This channel is not available for patch objects.

- **-2:Alpha** The vertex alpha channel. You can transfer all vertex alpha values between objects with the same topology by copying and pasting this channel.
  
  You can apply vertex alpha information to objects with the VertexPaint modifier on page 1959, and to editable surfaces with the Vertex Properties settings (editable poly on page 2268) and Surface Properties (editable mesh on page 2208 and editable patch on page 2379).
The vertex illumination channel. You can transfer all vertex illumination values between objects with the same topology by copying and pasting this channel.

You can apply vertex illumination information to objects with the VertexPaint modifier on page 1959, and to editable surfaces with the Vertex Properties settings (editable poly on page 2268) and Surface Properties (editable mesh on page 2208 and editable patch on page 2379).

The vertex color (vc) channel. You can transfer all vertex color values between objects with the same topology by copying and pasting this channel.

You can apply vertex color information to objects with the VertexPaint modifier on page 1959, and to editable surfaces with the Vertex Properties settings (editable poly on page 2268) and Surface Properties (editable mesh on page 2208 and editable patch on page 2379).

The default mapping channel. You can transfer all UVW mapping information between objects with the same topology by copying and pasting this channel.

You can create additional mapping channels by various means, including with the Channel Info utility.

**Channel Name** The name of the channel. By default, a channel has no name, as indicated by the entry “-none-”. To name or rename the channel, click the channel to highlight it and then click the Name button at the top of the dialog, or right-click the channel and choose Name from the right-click menu.

**NOTE** Most channels can be split into subcomponents on page 6489. You can name the subcomponents separately from the channel itself.

**Num Verts** The number of vertices in the channel. To paste one channel to another, they must have the same number of vertices.

Some channels have faces but no vertices. This is typically the case with Alpha, Illumination, and vertex color channels in newly created non-poly objects. In such cases, these channels function as placeholders for the corresponding data should you add it later. They do consume a small amount of memory, so if you have no intention of using a channel, you can save some memory by converting the object to Editable Poly.

**Num Faces** The number of faces in the channel.

If a channel has faces but not vertices, that means it's a placeholder. See Num Verts, above, for more information.
Dead Verts The number of unused map vertices in the channel. Such vertices can be left over from sub-object editing.

Size (KB) The approximate amount of memory consumed by the channel. Use this figure to check for unused channels that are using up memory.

**Clean MultiMaterial Utility**

Material Editor > Utilities menu > Clean MultiMaterial

Select an object. > Utilities panel > More button > Clean MultiMaterial > Click Find All button.

The Clean MultiMaterial utility parses Multi/Sub-Object materials and displays any that contain sub-materials are not assigned to any material IDs in the scene. You can then choose to remove any unused sub-materials, thus consolidating your Multi/Sub-Object materials.

This utility searches an entire scene. You do not need to select objects or materials.

**Procedures**

**To clean all materials:**

1. Open a scene.

2. On the Material Editor, open the Utilities menu and choose Clean MultiMaterial.

   The Clean Multi-Materials dialog opens, displaying the following:
The dialog displays a list of all Multi/Sub-Object materials that contain unassigned sub-materials. All the Multi/Sub-Object materials are automatically turned on, and thus subject to cleaning.

3 Click the OK button.
   All unused sub-materials are deleted and the dialog closes.

To clean specific Multi/Sub-Object materials:

When you create a Multi/Sub-Object material, you might create extra sub-materials in anticipation of objects that haven't been added to the scene yet. In such cases, you can prevent the utility from removing the extra sub-materials.

1 Open a scene.
2 On the Material Editor, open the Utilities menu and choose Clean MultiMaterial.

The Clean Multi-Materials dialog opens.

3 In the list, turn off any Multi/Sub-Object materials you do not want to clean.
4 Click OK.

All unused sub-materials are deleted from the indicated materials and the dialog closes.
Interface

The Clean dialog presents you with a list of all Multi/Sub-Object materials in the scene that contain unassigned sub-materials. You can then select materials from which to remove unassigned sub-materials.

The dialog consists of two parts: a status field at the top and a list of Multi/Sub-Object materials.

Status Field

The Status Field is not interactive. It displays prompts about the unused materials.
Materials list

This list displays Multi/Sub-Object materials that have sub-materials that are not currently being used in the scene. When the Clean MultiMaterial utility opens, it lists all Multi/Sub-Object materials with unused sub-materials and turns them on to be cleaned. Click the check box next to a material name to turn it off and prevent the utility from cleaning it.

**Clean** Deletes unused sub-materials from Multi/Sub-Object materials that are turned on.

**Cancel** Cancels the operation.

Instance Duplicate Maps Utility

Material Editor > Utilities menu > Instance Duplicate Map

Utilities panel > More button > Instance Duplicate Maps > Click Find All button.

The Instance Duplicate Maps utility searches an entire scene for materials that have duplicate Bitmap maps and give you the option to instance them. If your scene has different materials that use the same texture maps, creating instances will reduce the load on your video card, which can improve viewport performance.

For example, if you render a scene containing three materials that reference the texture map *MyMap.bmp*, 3ds Max searches for that texture map three times: once for each material it is used in. However, if you use the Instance Duplicate Maps utility, you can create instances of the duplicate maps so the renderer will find the first reference to *MyMap.bmp* and use it for any subsequent material that uses the same maps.

This utility searches an entire scene. You do not need to select objects or materials.

**NOTE** In order to be eligible for instancing, the Bitmap maps must be identical in all aspects with regard to their initial settings. For example, if two materials use the same bitmap image applied as Diffuse maps, but have different initial Tiling settings, their maps aren’t eligible for instancing.

Animation is not supported as a criterion for determining duplication, so any differences in the animation of Bitmap map parameters will be lost from the use of this utility. For example, if two materials use the same bitmap image applied as Diffuse maps, and have the same initial Tiling settings, but their
Tiling settings are animated to different subsequent values, after using the utility both maps will have the same animation as the first map.

**Procedures**

**To instance all duplicate maps:**

1. Open a scene.

2. On the Material Editor, open the Utilities menu and choose Instance Duplicate Map.

   The Instance Duplicate Maps dialog opens, displaying the following:

   ![Instance Duplicate Maps dialog](image)

   - Duplicated Textures: 13
   - Duplicates: 3
   - Map Name: Cement porc (Standard)
   - Parent Material: Material #61178 (Standard)
   - Material #61180 (Standard)

   The dialog displays a list of all texture maps found to have exact duplicates in the scene. The search will include all copies found to have identical paths and settings.

3. Click the Instance All button.

   All identical maps are instanced and the dialog closes.
To instance only specific maps:

Perhaps you only want to instance a few of the texture maps found in specific materials.

**NOTE** You have to select at least two maps from the Duplicates list.

1. Open a scene.
2. On the Material Editor, open the Utilities menu and choose Instance Duplicate Map.

The Instance Duplicate Maps dialog opens.

3. From the Duplicated Textures list, click the arrow button to open the list of duplicated textures and choose a texture you want to instance.
4. From the Duplicate list, select at least two map entries.
If you don't select at least two entries, you will see a warning in the status field at the top of the dialog.

5 Click Instance.
Since all three of the maps were instanced, the dialog now shows there are 42 duplicated textures.

6  Continue instancing texture or click Close when you are done.
Interface

The primary user interface of the Instance Duplicate Maps utility is the Instance Duplicate Maps dialog, which you open from the Utilities menu in the Material Editor. This utility works globally, so you do not need to select objects or materials in order to use it.

The dialog consists of three parts: a status field at the top, a drop menu containing duplicated texture maps and a list of map names and the materials that belong to.

Status Field

The Status Field is not interactive. It shows you prompts and warnings about the duplicate textures and maps. Some of the messages displayed in this section include:

- “No duplicate textures were found in the scene.” – when the utility is run in a scene containing no duplicates.
“Select duplicates and press “Instance” to consolidate.” – when the utility is run in a scene containing duplicates.

“The selected duplicates contain parameters that are animated. Animation is not supported as criteria for determining duplication so differences in the animation will be lost.” – when animation is present in a set of duplicates.

“At least two maps must be selected in order to proceed.” – when the Instance button is pressed with one or no duplicates selected.

**Duplicated Textures list**

This drop-down list contains all the maps in the scene found to be identical in every way, including texture map path and name, and initial parameter settings. The number after “Duplicated Textures” indicates how many sets were found in the scene. This list appears with the first entry visible and once active can be scrolled using the up/down arrow keys.

**Duplicates list**

When you choose a texture in the Duplicated Textures list, 3ds Max displays its duplicates in the Duplicates list, showing the map name and the name of the parent material. The number after “Duplicates” indicates how many copies were found in the scene. Textures in this list can be chosen individually. Only duplicates chosen in this list will be consolidated into the final instance if you click the Instance button. The name of the resulting instance is that of the first chosen duplicate in the list.

**Instance All** Performs the consolidation on all duplicates in the scene regardless of selections made from the Duplicated Textures or Duplicates lists.

**Instance** Performs the consolidation on only the duplicates chosen on the Duplicates list. Selected duplicates will disappear from this list after consolidation. If all are selected, the corresponding texture will disappear from the first list as well.

**Close** Closes the operation at its current point.
Rendering

Rendering shades the scene's geometry using the lighting you've set up, the materials you've applied, and environment settings, such as background and atmosphere. You use the Render Setup dialog on page 6506 to render images and animations and save them to files. The rendered output appears in the Rendered Frame Window on page 6513, where you can also render and do some setup.

Rendering “fills in” geometry with color, shadow, lighting effects, and so on.

NOTE In Autodesk 3ds Max 2010, bitmap paging is always active and is managed automatically, enabling you to render scenes with large bitmaps, a large number of bitmaps, or very high resolution images (for example, 5,000 x 5,000 pixels or more).
NOTE 3ds Max does not append any color-space information to rendered output. If necessary, you can apply a color space such as sRGB to output images in an image-editing program like Adobe Photoshop.

Environments and Rendering Effects

A variety of special effects, such as film grain, depth of field, and lens simulations, are available as rendering effects. Another set of effects, such as fog, are provided as environment effects.

Environment settings on page 7163 let you choose a background color or image, or choose an ambient color value for when you render without using radiosity. One category of environment settings is the exposure controls on page 7207, which adjust light levels for display on a monitor.

Rendering effects on page 7057 provide a way for you to add blur or film grain to a rendering, or to adjust its color balance.

See also:
- Rendering Effects on page 7057
- Environment and Atmosphere Effects on page 7162

Object-Level Rendering Controls

You can control rendering behavior at the object level. See Object Properties on page 283.

Render Setup Dialog

Rendering menu > Render Setup
Main toolbar > Render Setup button
Keyboard > F10

Rendered Frame Window > Render Setup button
Rendering creates a 2D image or animation based on your 3D scene. It shades the scene's geometry using the lighting you've set up, the materials you've applied, and environment settings such as background and atmosphere.

The Render Setup dialog has multiple panels. The number and name of the panels can change, depending on the active renderer. These panels are always present:

- **Common panel** on page 6568
  Contains the main controls for any renderer, such as whether to render a still image or an animation, setting the resolution of rendered output, and so on.

- **Renderer panel** on page 6585
  Contains the main controls for the current renderer.

Additional panels whose presence depends on the active renderer include:

- **Render Elements panel** on page 6807
  Contains the controls for rendering various image information into individual image files. This can be useful when you work with compositing, image-processing, or special-effects software.

- **Raytracer panel** on page 6666
  Contains global controls for ray-traced maps and materials.

- **Advanced Lighting panel** on page 6600
  Contains controls for generating radiosity and light tracer solutions, which can provide global illumination for your scene.

- **Processing** on page 6675 and **Indirect Illumination** on page 6760 panels
  Contain special controls for the mental ray renderer on page 6675.

At the bottom of the Render Setup dialog are controls that, like those in the **Common Parameters rollout** on page 6568, apply to all renderers. These are described in this topic's “Interface” section, below.

---

**NOTE** In Autodesk 3ds Max 2010, bitmap paging is always active and is managed automatically, enabling you to render scenes with large bitmaps, a large number of bitmaps, or very high resolution images (for example, 5,000 x 5,000 pixels or more).
Choice of a Renderer

Three renderers are provided with 3ds Max. Additional renderers might be available as third-party plug-in components. The renderers provided with 3ds Max are:

- **Default scanline renderer** on page 6589
  - The scanline renderer is active by default. It renders the scene in a series of horizontal lines.
  - Global illumination options available for the scanline renderer include light tracing on page 6601 and radiosity on page 6615.
  - The scanline renderer can also render to textures ("bake" textures), which is especially useful when preparing scenes for game engines.

- **mental ray renderer** on page 6675
  - The mental ray renderer created by mental images is also available. It renders the scene in a series of square "buckets."
  - The mental ray renderer provides its own method of global illumination, and can also generate caustic lighting effects.
  - In the Material Editor, a variety of mental ray shaders provide effects that only the mental ray renderer can display.

- **VUE file renderer** on page 6805
  - The VUE file renderer is a special-purpose renderer that generates an ASCII text description of the scene. A view file can include multiple frames, and specify transforms, lighting, and changes of view.

Standard and ActiveShade Renderers

In 3ds Max, there are two different types of renderings. Production rendering is active by default, and is typically the one you use for finished renderings. This type of rendering can use any of the three aforementioned renderers. The second type of rendering is called ActiveShade on page 6550. An ActiveShade rendering uses the default scanline renderer to create a preview rendering that can help you see the effects of changing lighting or materials; the rendering updates interactively as you change your scene. Rendering with ActiveShade is, in general, less precise than production rendering.

Another advantage of production rendering is that you can use different renderers, such as the mental ray or VUE file renderer.
To choose between production and ActiveShade rendering, use the radio buttons described in the Interface section, following. To change the renderer assigned to production rendering, use the Assign Renderer rollout on page 6582.

See also:

■ Render Setup on page 6539

Procedures

To render a still image:

1 Activate the viewport to render.

2 Click Render Setup.
   The Render Setup dialog opens, with the Common panel active.

3 On the Common Parameters rollout, check the Time Output group to make sure the Single option is chosen.

4 In the Output Size group, set other rendering parameters or use the defaults.

5 Click the Render button at the bottom of the dialog.
   By default, rendered output appears in the Rendered Frame Window on page 6513.

   TIP To render a view without using the dialog, click Render on page 6548.

To render an animation:

1 Activate the viewport to render.

2 Click Render Setup.
   The Render Setup dialog opens, with the Common panel active.

3 On the Common Parameters rollout on page 6568, go to the Time Output group and choose a time range.
4 In the Output Size group, set other rendering parameters or use the defaults.

5 In the Render Output group, click Files.

6 On the Render Output File dialog on page 6529, specify a location, name, and a type for the animation file, and then click Save. Typically, a dialog appears that lets you configure options for the chosen file format. Change settings or accept the defaults, and then click OK to continue.

   The Save File check box turns on.

7 Click the Render button at the bottom of the dialog.

   **NOTE** If you set a time range and do not specify a file to save to, the animation is rendered only to the window. This can be a time-consuming mistake, so an alert warns you about it.

   **TIP** Once you have rendered the animation this way, you can render it again without using the dialog by clicking Render or pressing F9.

**Interface**

![Render Setup Default: Scanline Renderer]

[rendering mode]

- **Production/Iterative** Choose whether to render in production on page 6548 or iterative on page 6548 mode. (This is the default.)

- **ActiveShade** Choose to use ActiveShade on page 6550.
**Preset** From this drop-down list you can choose a set of preset rendering parameters, or load or save rendering parameter settings. See Preset Rendering Options on page 6561.

**Viewport** Chooses the viewport to render. By default, this is the active viewport. You can use this drop-down list to choose a different one. The list contains only currently displayed viewports.

**Lock View** When on, locks the view to the one shown in the Viewport list. This enables you to adjust the scene in other viewports (which become active as you use them), and then click Render to render the viewport you originally chose. When off, Render always renders the active viewport.

**Render** Renders the scene.

When ActiveShade is chosen, the name of this button changes to ActiveShade, and clicking it opens a floating ActiveShade window on page 6550.

If the scene you're rendering contains bitmaps that cannot be located, a Missing External Files dialog on page 7612 opens. This dialog lets you browse for the missing maps, or continue to render the scene without loading them.
Rendering Progress dialog

```
Rendering

Total Animation:                Pause  Cancel

Current Task:  Rendering Image

 Rendering Progress:

Frame # 0
1 of 1 Total
Pass # 1/1

Last Frame Time: 0:00:00
Elapsed Time: 0:00:00
Time Remaining: ???:???

Common Parameters

- Render Settings:
  Viewport: Camera.View.P1  Width: 320
  Start Time: 0  Height: 240
  End Time: 0  Pixel Aspect Ratio: 1.00000
  Nth Frame: 1  Image Aspect Ratio: 1.33333
  Hidden Geometry: Hide  Render to Fields: No
  Render Atmosphere: No  Force 2-Sided: No

- Output Settings:
  File Name:
  Device Name:
  File Output Gamma 1.00  Nth Serial Numbering: No
  Video Color Check: No  Dither Paletted: Yes
  Super Black: No  Dither True Color: Yes

Scene Statistics:

Objects: 652  Lights: 67
Faces: 60589  Shadow Mapped: 0
Memory Used: P:523.7M V:540.2M  Ray Traced: 0
```

6512 | Chapter 18  Rendering
When you click Render, a rendering progress dialog shows the parameters being used, and a progress bar. The rendering dialog has a Pause button to the left of the Cancel button. When you click Pause, the rendering pauses, and the button's label changes to Resume. Click Resume to continue with the rendering.

**NOTE** The mental ray renderer does not support the Pause button. You can cancel a mental ray rendering, but you can't pause it.

**Rendered Frame Window**

Main toolbar > Rendered Frame Window

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Render > Rendered Frame Window opens.

Rendering menu/main toolbar > Render > Rendered Frame Window opens.

Rendering menu > View Image File > Choose a file to view. > Open > Rendered Frame Window (reduced functionality) displays the file.

The Rendered Frame Window displays rendered output.

This window has controls to:

- Set the area to render (region, etc.).
- Choose the viewport to render.
- Choose a render preset.
- Render the scene.
- Save the image to a file.
- Place a copy of the rendered image on the Windows clipboard, ready for pasting into another graphics application.
- Create a clone of the window. This displays a new window so you can create another rendering and compare it with the previous one.
- Open a new Rendered Frame Window.
- Toggle display of the red, green, and blue color channels.
- Display the [alpha channel](#) on page 8502.
Display only monochrome (gray scale).
Clear the image from the window.
Print the rendered output.
Change a number of mental ray-specific settings.

NOTE The Rendered Frame Window interface has been redesigned for Autodesk 3ds Max 2010. When rendering with mental ray, the Render button and Production/Iterative switch now appear on the lower panel on page 6524 with the rest of the mental ray-specific controls; otherwise, they remain in their previous location on the upper panel. Also, the lower panel has been streamlined for greater ease of use. And most important, new global tuning sliders let you temporarily override the precision of reflections, refractions, and soft shadows for faster or higher-quality rendering.

When you choose the View Image File command from the Rendering menu, 3ds Max displays still images and image sequences in a feature-reduced version of the Rendered Frame Window. When you view sequentially numbered image files or images in an IFL file on page 7841, this window displays navigation arrows that let you step through the images.

The Rendered Frame Window Title Bar

The title bar of the Rendered Frame Window includes this information:

- Viewport name
- Frame number

- The display gamma value, if gamma has been enabled. If the color-correction method you use is a look-up table, then when the table is enabled the title bar shows the file name of the table, with no path. See Gamma and LUT Preferences on page 8330.

- Image type and color depth

- Image aspect ratio

This portion of the caption has changed in Autodesk 3ds Max 2010 to be more readable. For example, a full-color image with an alpha channel will show “RGBA Color 16 Bits/Channel”; a bitmap with a limited color depth might show “Indexed Color 8 Bits/Pixel,” and so on.
Procedures

To zoom and pan in the Rendered Frame Window:

You can zoom in and out and pan the image in the Rendered Frame Window. You can even do this while a scene is rendering.

- To zoom in, hold down Ctrl and then click. To zoom out, use Ctrl+right-click.
- To pan, hold down Shift and then drag.

If you have a wheel mouse, you can use the wheel to zoom and pan:

- To zoom in or out, roll the wheel.
- To pan, press the wheel and drag.

NOTE You can use any third-button pointing device to pan the image. To enable this, open the Customize menu > Preferences dialog. Go to the Viewports panel on page 8308, and in the Mouse Control group choose the Pan/Zoom option (this is the default).

Interface

This first section documents the controls on the main Rendered Frame Window. For information about the additional control panel that appears below the main window when using mental ray, see mental ray Rendering Options on page 6524.
Rendered Frame Window Rendering Controls

These controls provide access to rendering settings such as presets and the viewport to render, as well as the Render command. To toggle display of these controls, click the Toggle UI button at the right end of the Rendered Frame Window toolbar.

**Area to Render** This drop-down list provides the available Area to Render on page 6542 options. Choose View, Selected, Region, Crop, or Blowup.

When using Region, Crop, or Blowup, set the region with the Edit Region control (see following). Alternatively, you can set the region automatically to the current selection with the Auto Region Selected option (also see following).

**Edit Region** Enables manipulation of the region window: resize by dragging the handles, and move by dragging inside the window. When Area To Render is set to Region, you can edit the region both in the Rendered Frame Window and in the active viewport.

If Area To Render is set to View or Selected, clicking Edit Region switches to Region mode.

When Area To Render is set to Crop or Blowup, you can edit the region only in the active viewport, because in those cases the Rendered Frame Window doesn’t necessarily reflect the same area as the viewport. Hence, also in Crop and Blowup modes, a warning icon on page 6518 appears to the right of the Auto Region Selected. The icon’s tool tip suggests that you edit the region in
the viewport. A warning also appears in Region mode if the Rendered Frame Window area doesn’t match the active viewport.

Turning on Edit Region automatically activates the Show Safe Frames function in the active viewport.

NOTE 3ds Max maintains two separate render regions: one for Region and Crop, and another for Blowup. Changing the Area To Render option activates the relevant render region.

Auto Region Selected When on, sets the region for Region, Crop, and Blowup automatically to the current selection. This auto-region is calculated at render time and does not overwrite the user-editable regions.

If Area To Render is set to View or Selected, clicking Auto Region Selected switches to Region mode.

TIP Alternatively, when rendering with mental ray, use Subset Pixels (see following) for greater accuracy.

Subset Pixels (of selected objects) When on, rendering the scene applies only to selected objects. Available only when rendering with mental ray.

This option differs from the Area to Render > Selected option in that it takes into account all scene elements that affect its appearance. This includes shadows, reflection, direct and indirect lighting, and so on. Also, Selected replaces the entire contents of the Rendered Frame Window (except for selected objects) with the background color, but Subset Pixels replaces only pixels used by the re-rendered, selected objects.

Subset Pixels rendering is particularly useful when performing iterative rendering while adjusting lighting, shadows, and other scene elements for a particular object or set of objects in the scene. It lets you re-render repeatedly to view the results of isolated changes without disturbing the rest of the rendered output.

TIP Objects rendered in Subset Pixels mode at low antialiasing settings might show objectionable outlines. To eliminate any such outlines, increase the antialiasing setting on page 6525. For best results, use Medium antialiasing (Min 1/4, Max 4) or better.

The equivalent Render Setup dialog control is Render changes to selected objects only on page 6745.
This warning symbol appears when Area to Render on page 6516 is set to Crop or Blowup, accompanied by a tool tip that tells you to edit the Crop or Blowup region in the viewport. It also appears in Region mode if the Rendered Frame Window doesn’t show the same area as the viewport (that is, if you previously rendered in Crop or Blowup mode).

**Viewport** Shows the viewport that renders when you click the Render button. The drop-down list contains all visible viewports. To specify a different viewport to render, choose it from the list or activate it in the main user interface.

Activating a different viewport in the main interface automatically updates this setting if Lock To Viewport is off.

**Lock To Viewport** When on, only the viewport active in the Viewport list renders, even if you activate a different viewport in the main interface. However, you can still choose a different viewport to render from the list. When off, activating a different viewport in the main user interface updates the Viewport value.

**Render Preset** Choose a preset rendering option on page 6561 from the drop-down list.

**Render Setup** Opens the Render Setup dialog on page 6506.

**Environment and Effects Dialog (Exposure Controls)** Opens the Environment and Effects dialog to the Environment panel on page 7163. You can set an exposure control on the Exposure Control rollout.

**Production/Iterative** Choose the result of clicking the Render button:

- **Production** Renders using all the current settings on the Rendered Frame Window, Render Setup, dialog, and so on.

- **Iterative** Ignores network rendering, rendering of multiple frames, file output, export to MI files, and email notification. Also, with the scanline renderer, rendering Selected on page 6544 leaves the rest of the Rendered Frame Window intact in Iterative mode.
Use this option when doing quick iterations on the image, usually in parts; for example, working on final gather settings, reflections, or specific objects or areas of the scene.

This choice is also available from a drop-down in the bottom-left corner of the Render Setup dialog. And you can render in either mode from the render flyout on page 6547 on the main toolbar.

**NOTE** When rendering with mental ray, the Production/Iterative switch moves to the lower panel for easier access after adjusting settings.

**Render** Renders the scene using the current setup.

**NOTE** When rendering with mental ray, the Render button moves to the lower panel for easier access after adjusting settings.

**Rendered Frame Window toolbar**

**Save Image** Allows you to save the rendered image displayed in the Rendered Frame Window.

**Copy Image** Places an exact copy of the visible portion of the rendered image on the Windows clipboard, ready for pasting into a paint program or bitmap editing software. The image is always copied as displayed, so, for example, if the Monochrome button on page 6520 is on, the copied data consists of an eight-bit grayscale bitmap.

**NOTE** No HDR (high-dynamic-range) data is copied.

**Clone Rendered Frame Window** Creates another window containing the displayed image. This allows you to render another image to the Rendered Frame Window and compare it with the previous, cloned image. You can clone the Rendered Frame Window any number of times. The cloned window uses the same initial zoom level as that of the original.

**NOTE** A cloned window provides minimal functionality, and cannot be re-rendered or cloned.
Print Image Sends the rendered image to the default printer as defined in Windows (in Windows XP, see Start menu > Settings > Printers And Faxes). The background prints as transparent.

Clear Clears the image from the Rendered Frame Window.

Enable Red Channel Displays the red channel of the rendered image. When turned off, the red channel is not displayed.

Enable Green Channel Displays the green channel of the rendered image. When turned off, the green channel is not displayed.

Enable Blue Channel Displays the blue channel of the rendered image. When turned off, the blue channel is not displayed.

Display Alpha Channel Displays the alpha channel on page 8502.

Monochrome Displays an 8-bit grayscale of the rendered image.

Channel Display List Lists any channel rendered with the image. When you choose a channel from the list, it is displayed in the Rendered Frame Window. For most kinds of files, only the RGB and alpha channels are available. If you render an RPF file on page 7875 or RLA file on page 7873, additional channels can be present.

The Rendered Frame Window displays nonvisual channels, such as Material ID or the G-Buffer, using colors it assigns at random to distinct values.

Color Swatch Stores the color value of the last pixel you right-clicked. You can drag this color swatch to other color swatches in 3ds Max. Clicking the color swatch displays the Color Selector on page 371, which displays more information about the color.

You can leave the Color Selector displayed while you right-click over other pixels in the Rendered Frame Window. (Changing the current value in the Color Selector changes the color swatch on the Rendered Frame Window's toolbar, but it does not change the color of pixels in the rendered image.)
**Toggle UI Overlays** When on, displays the frame that shows the Region, Crop, or Blowup area when one of those options is active. To disable display of the frame, turn off this toggle.

**NOTE** The frame is still active when not displayed.

**Toggle UI** When on, all controls are available. When off, disables display of the rendering controls at the top of the dialog as well as the mental ray controls on the separate panel below the dialog. To simplify the dialog interface and allow it to take up less space, turn this off.

**TIP** When off, you can resize the window smaller than is possible when Toggle UI is on.

**Layer** This setting appears on the Rendered Frame Window toolbar when you render to the RPF on page 7875 or RLA on page 7873 file format. It lets you see the information at different layers of the following channels:

- Z Depth
- Normal
- Non-Clamped Color
- Coverage
- Node Render ID
- Color
- Sub-Pixel Weight
- Sub-Pixel Mask

Layer shows no additional information for other channels. It is useful primarily when the scene contains objects that occlude each other, and you have turned on the Render Occluded Objects toggle for these objects. (See Object Properties on page 283.) Be aware that rendering occluded objects increases render time.

**TIP** Rendering occluded objects can help you create 3D effects when you composite images with the Autodesk Combustion software.
Frame-Steps (arrows) When viewing sequentially numbered files (such as image0005.jpg) or IFL files, the arrows display the next or the previous file in the sequence. To jump to the first image or the last image in the sequence, hold down Ctrl and click an arrow.

Available only when you use the View Image File command on the File menu.

Pixel Data

When you right-click the Rendered Frame Window, the color swatch is updated, and information about the rendering and the pixel beneath the mouse is displayed.

If you hold the right mouse button down while dragging, the information changes with each new pixel the mouse crosses.

<table>
<thead>
<tr>
<th>Image</th>
<th>Extra Pixel Data (G-Buffer Data)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width: 320</td>
<td>Z-Depth: -Infinity</td>
</tr>
<tr>
<td>Height: 240</td>
<td>Material ID: 0</td>
</tr>
<tr>
<td>Type: RGBA Color 16</td>
<td>Object ID: 0</td>
</tr>
<tr>
<td>Bits/Channel</td>
<td>UV Coordinates: 0.000, 0.000</td>
</tr>
<tr>
<td>Pixel (141, 122)</td>
<td>Normal: -1.000, -1.000, -1.000</td>
</tr>
<tr>
<td>1/65535 Real</td>
<td>Non-Clamped Color: 0.5723, 0.5879, 0.5957</td>
</tr>
<tr>
<td>Red: 37400</td>
<td>Coverage: 0</td>
</tr>
<tr>
<td>Green: 38499</td>
<td>Node Render ID: 65535</td>
</tr>
<tr>
<td>Blue: 38912</td>
<td>Color: 145, 149, 151</td>
</tr>
<tr>
<td>Alpha: 0</td>
<td>Transparency: 255, 255, 255</td>
</tr>
<tr>
<td>Mono: 38270</td>
<td>Velocity: 0.000, -0.000</td>
</tr>
<tr>
<td>0.000000</td>
<td>Sub-Pixel Weight: 0, 0, 0</td>
</tr>
<tr>
<td>0.583968</td>
<td>Sub-Pixel Mask: 65535</td>
</tr>
</tbody>
</table>

The display includes the following information:

**Image group**

Width The width of the image in pixels.

Aspect The pixel aspect ratio.

Height The height of the image in pixels.

Gamma The gamma value carried in the bitmap file. This value is always 1.0, because once the image is rendered and saved to memory or a file, no
correction is applied. You can see the gamma value used to display the image, if any, in the title bar of the Rendered Frame Window.

**Type** The type of image, based on color depth.

The Type field has changed in Autodesk 3ds Max 2010 to be more readable. For example, a full-color image with an alpha channel will show “RGBA Color 16 Bits/Channel”; a bitmap with a limited color depth might show “Indexed Color 8 Bits/Pixel,” and so on.

**Pixel group**

Pixel information includes the pixel location in the bitmap, in parentheses following the Pixel group heading. The counting starts at 0. For example, in the above illustration, the pixel in question is the 308th from the left edge and the 141st from the top edge. Also shown in this group are channel values for red, green, blue, alpha, and monochrome, both as 16-bit integers (0 to 65535) and as floating-point values between 0.0 and 1.0.

**NOTE** With high-dynamic-range images, the floating-point values can be greater than 1.0 or less than 0.0.

**Red** The red component value (0 to 65535) and the floating-point value.

**Green** The green component value (0 to 65535) and the floating-point value.

**Blue** The blue component value (0 to 65535) and the floating-point value.

**Alpha** The alpha component value (0 to 65535) and the floating-point value.

**Mono** The monochrome values of the pixel, using the same formula used by monochrome material map channels such as bump and opacity maps.

**Extra Pixel Data (G-Buffer Data) group**

If the rendering output uses a format that contains additional channels, such as RPF on page 7875 or RLA on page 7873, the informational pop-up shows this data in the Extra Pixel Data group. The group includes all the possible channels. If a channel is not present, its value is displayed as "N/A," for "not applicable."

**Z Depth** Displays Z-Buffer information in repeating gradients from white to black. The gradients indicate relative depth of the object in the scene.

**Material ID** Displays the Effects Channel used by a material assigned to an objects in the scene. The Effects Channel is a material property set in the Material Editor.
Object ID Displays the object’s G-Buffer Object ID on page 293.

UV Coordinates Displays the range of UV mapping coordinates.

Normal Displays the orientation of normal vectors.

Non-Clamped Color Displays the “real” color value delivered to the renderer in RGB order. The renderer uses a floating-point range of 0.0 to 1.0 to represent the range of each color channel. Thus, 1.0 is 100%, or 65535 (real color values can be greater than 1, but are clamped by the renderer to 1).

Coverage Displays the coverage of the surface fragment from which other G-Buffer values (Z Depth, Normal, and so on) are obtained. Z-Coverage values range from 0 to 255.

Node Render ID Displays an object’s G-Buffer Object channel.

Color Displays the color returned by the material shader for the fragment.

Transparency Displays transparency returned by the material shader for the fragment.

Velocity Displays the velocity vector of the fragment relative to the screen.

Sub-Pixel Weight Displays the sub-pixel weight of a fragment. The channel contains the fractions of the total pixel color contributed by the fragment. The sum of all the fragments gives the final pixel color. The weight for a given fragment takes into account the coverage of the fragment and the transparency of any fragments that are in front of a given fragment.

Sub-Pixel Mask Displays the sub-pixel alpha mask. This channel provides a mask of 16 bits (4x4) per pixel, used in antialiased alpha compositing.

mental ray Rendering Options

Rendered Frame Window on page 6513 (with mental ray active) > bottom panel

This additional panel appears below the Rendered Frame Window when mental ray is the active renderer. It allows for easy adjustment of important settings related to reflection, refraction, final gathering, and more.
The controls on this panel have been streamlined and enhanced for ease of use in Autodesk 3ds Max 2010. Sliders and check boxes have been combined, precision controls have been added for reflections, refractions, and soft shadows, and the Subset Pixels switch has moved to the upper panel. Also, the Production/Iterative switch and the Render button now appear here for easier access when adjusting mental ray-related settings.

Most of the controls on this panel have equivalent controls on the Render Setup dialog, as linked to in the descriptions in this topic. Changing a setting here makes the same adjustment to the respective Render Setup control, and vice versa.

Please note: If you change a setting here, the equivalent Render Setup dialog setting updates automatically, but the reverse is not true. If you change a setting on the Render Setup dialog, to see the change on this panel, you must first click the panel to refresh its display.

See also:

- Subset Pixels on page 6517 is the only mental ray-specific control that appears in the main (upper) Rendered Frame Window interface.

Interface

Image Precision (Antialiasing) Provides presets for a number of recommended combinations of minimum and maximum Samples Per Pixel settings. For details, see Samples per Pixel group on page 6736.

Soft Shadows Precision A global multiplier for the Shadow Samples setting in all lights casting soft shadows. This includes all photometric lights on page 5348 (Target Light, Free Light, mr Sky Portal), as well as mr Sun on page 5524, mr Area Omni on page 5418, and mr Area Spot on page 5421. Typically the light should be set to cast ray traced shadows, although in some cases shadow maps work too.
Possible multiplier values are 0.125, 0.25, 0.5, 1, 2, 4, 8, and 16. The leftmost slider position (“Soft Shadows off”) is equivalent to turning on Area Lights/Shadows as Points on page 6575. The remaining slider positions are also available as the Global Tuning Parameters rollout > Soft Shadows Precision on page 6732 control. For an example, see this illustration on page ?.

**Final Gather Precision** Provides a range of quick, easy preset solutions for final gathering on page 6760. The default presets are: Draft, Low, Medium, High, Very High, and Custom (the default choice). Available only when Final Gather is on. For details, see FG Precision Presets on page 6764.

**NOTE** The leftmost position of the slider disables final gathering, and is the equivalent of the Enable Final Gather on page 6763 toggle when off.

**Glossy Reflections Precision** Controls reflection quality globally and, at the leftmost position, disables all reflections (see Enable Reflections on page 6745). To improve performance when you don’t require reflections, drag the slider all the way to the left.

At other positions, the slider determines the quality of reflections in all instances of the Arch & Design material on page 5858 and related materials in the scene. The slider setting acts as a multiplier to each material’s Reflection group > Glossy Samples on page 5863 setting. This setting is also available for most ProMaterials on page 5772 on the Performance Tuning Parameters rollout on page 5857. For an example, see this illustration on page ?.

**NOTE** This slider adjusts each material’s Glossy Samples setting temporarily for rendering purposes only; it does not change the materials. For example, if the scene contains three Arch & Design materials with Reflection > Glossy Samples settings of 32, 20, and 8, and you set Glossy Reflections Precision to 0.5X (Low), the resultant values as rendered will be 16, 10, and 4. However, the original material settings remain intact, and are restored for rendering purposes when you set the slider back to 1.0X - Default.

The equivalent Render Setup dialog controls are Glossy Reflections Precision on page 6526 and Enable Reflections on page 6745.

**Glossy Refractions Precision** Controls refraction quality globally and, at the leftmost position, disables all refraction (see Enable Refractions on page 6745). To improve performance when you don’t require refraction, drag the slider all the way to the left.
At other positions, the slider determines the quality of refractions in all instances of the Arch & Design material on page 5858 and related materials in the scene. The slider setting acts as a multiplier to each material's Refraction group > Glossy Samples on page 5866 setting. This setting is also available for some ProMaterials on page 5772 on the Performance Tuning Parameters rollout on page 5857.

**NOTE** This slider adjusts each material's Glossy Samples setting temporarily for rendering purposes only; it does not change the materials. For example, if the scene contains three Arch & Design materials with Refraction > Glossy Samples settings of 32, 20, and 8, and you set Glossy Reflections Precision to 0.5X (Low), the resultant values as rendered will be 16, 10, and 4. However, the original material settings remain intact, and are restored for rendering purposes when you set the slider back to 1.0X - Default.

The equivalent Render Setup dialog control is Glossy Refractions Precision on page 6526 and Enable Refractions on page 6745.

**Traces/Bounces Limits**

**Max. Reflections** Sets the maximum number of times a ray can be reflected. At 0, no reflection occurs. At 1, the ray can be reflected once only. At 2, the ray can be reflected twice, and so on. Default=4.

The equivalent Render Setup dialog control is Max. Reflections on page 6745.

**Max. Refractions** Sets the maximum number of times a ray can be refracted. At 0, no refraction occurs. At 1, the ray can be refracted once only. At 2, the ray can be refracted twice, and so on. Default=6.

The equivalent Render Setup dialog control is Max. Refractions on page 6745.

**FG Bounces** Sets the number of times mental ray calculates diffuse light bounces for each diffuse ray. Default=0.

The equivalent Render Setup dialog control is Diffuse Bounces on page 6766.

**Reuse group**

These commands let you save rendering time by reusing translated geometry and final gather solutions. The Final Gather controls are available only when Final Gather on page 6526 is on.

**Lock Geometry Translation** Determines whether changed geometry is retranslated to mental ray format at render time. When on, sub-object-level
changes such as vertex editing or adjusting a modifier such as Bend are ignored
and don’t cause retranslation. However, object-level changes such as moving
or rotating an object are retranslated.

The equivalent Render Setup dialog control is Translator Options rollout >
Geometry Caching group > Lock Geometry Translation on page 6792.

Geometry When on, rendering uses geometry caching. During the first render,
the translated geometry is saved to the cache file. Then, in subsequent
renderings of the same scene, the renderer uses the cached geometry for any
unchanged objects instead of retranslating it. Any changed geometry is
retranslated. Default=off.

The equivalent Render Setup dialog control is Translator Options rollout >
Geometry Caching group > Enable on page 6792.

NOTE Network rendering does not support this option.

Clear Geometry Cache Deletes the cached geometry.

The equivalent Render Setup dialog control is Translator Options rollout >
Geometry Caching group > Clear Geometry Cache on page 6792.

Lock Final Gather Determines whether or not mental ray uses the
final gather map (FGM) file or files as is. When off, mental ray can add new
final gather points if necessary. When on, mental ray uses only the data in
the specified file, and does not generate any new final gather points during
the pre-processing stage. Available only when Reuse > Final Gather is on (see
following). Default=off.

To create the FGM files, use Generate Final Gather Map Now on page 6784 or
the drop-down list next to it ( ).

The equivalent Render Setup dialog control is Read FG Points Only from
Existing Map Files on page 6782.

Final Gather When on and Lock Final Gather is off (see preceding), generates
or updates a final gather map (FGM) file. If Lock Final Gather is on as well,
mental ray does not perform final gathering, but instead uses cached final
gather map data to save rendering time.

If no FGM file is specified on the Render Setup dialog > Final Gather rollout
(see Final Gather Map group on page 6782), 3ds Max uses the file name temp.fgm.
The equivalent Render Setup dialog control, when Lock Final Gather is off, is Incrementally Add FG Points to Map Files on page 6782.

Clear Final Gather Cache Deletes the cached final gather solution.
The equivalent Render Setup dialog control is Reuse rollout > Final Gather Map group > Delete File on page 6784.

NOTE The following two controls move to the Rendered Frame Window lower panel from the upper panel when the mental ray renderer is active.

Production/Iterative Choose the result of clicking the Render button:
■ Production Renders using all the current settings on the Rendered Frame Window, Render Setup, dialog, and so on.
■ Iterative Ignores network rendering, rendering of multiple frames, file output, export to MI files, and email notification. Also, with the scanline renderer, rendering Selected on page 6544 leaves the rest of the Rendered Frame Window intact in Iterative mode. Use this option when doing quick iterations on the image, usually in parts; for example, working on final gather settings, reflections, or specific objects or areas of the scene.

This choice is also available from a drop-down in the bottom-left corner of the Render Setup dialog. And you can render in either mode from the render flyout on page 6547 on the main toolbar.

Render Renders the scene using the current setup.

Render Output File Dialog

Rendering menu > Render Setup > Render Setup dialog > Common panel > Common Parameters rollout > Render Output group > Click Files. > Render Output File

The Render Output File dialog lets you assign a name to the file that the rendering will output. You can also determine the type of file to render. Depending on your choice of file type, you can also set up options such as compression, and color depth and quality.
See also:
- Image File Formats on page 7831

Procedures

To name the render output file:

1. Choose Rendering > Render Setup, and then in the Render Output group of the Common Parameters rollout, click Files. This opens the Render Output File dialog.
2. Use the Save In field near the top of the dialog to choose the directory in which to save the rendered file.
3. In the File Name field, enter the name for the file to be rendered.
   
   **TIP** If you enter a filename extension as well (for instance: `myimage.bmp`) and then press Tab, the Setup button activates and you can click it to change the file settings.

4. Choose the type of file you want to render from the Save As Type drop-down list.
   
   **TIP** If you entered the filename extension as part of the file name, you can skip this step.

5. Click Save to close the Render Output File dialog. Clicking Save also opens a dialog that lets you set the options for the file format you chose. Adjust these settings (or leave them at their defaults), and then click OK.

6. On the Render Setup dialog, click the Render button to render the scene and save the file.
   
   **NOTE** If a file of the same name already exists, a dialog opens to let you confirm overwriting it. This dialog also provides a check box for automatically overwriting render-output files without being prompted for the duration of the session.
To set up options for the render-output file:

1. Choose Rendering > Render and then in the Render Output group of the Common Parameters rollout, click Files. The Render Output File dialog opens.

2. In the File Name field, enter the name for the file to be rendered.

3. Navigate the Save In field to choose the directory where you want the rendered file to be saved.

4. Choose the type of file you want to render from the Save As Type drop-down list, then click Save.
   
   A dialog is displayed that lets you set the options for the file format you chose. Adjust these settings (or leave them at their defaults), and then click OK.

   **NOTE** You can also view the setup dialog by clicking Setup, if this button is available.

   **WARNING** Make sure the file name extension in the File Name field matches the file type in the Save As Type field. Changing the file type *does not update* the file name automatically. The file options dialog depends on the type indicated by the file name, *not* the type indicated by Save As Type.

5. If the Render Output File dialog is still open, click Save.
Interface

History Displays a list of the most recent directories searched. Whenever an image is selected, the path used is added to the top of the history list as the most recently used path.

The history information is saved in the 3dsmax.ini on page 60 file.

Save In Opens a navigation window to browse other directories or drives.

Up One Level Moves you up a level in the directory structure.

Create New Folder Lets you create a new folder while in this dialog.
View Menu

Provides several options for how information is displayed in the list window:

- **Thumbnails:** Displays the contents of a directory as thumbnails, without the details.

- **Tiles:** Displays the contents of a directory as large icons, without the details. If you widen the dialog, these tile across the width.

- **Small Icons:** Displays the contents of a directory as small icons, tiled across the width, without the details.

- **List:** Displays the contents of a directory without the details.

- **Details:** Displays the contents of a directory with full details such as size and date.

**List of files** Lists the contents of the directory, in the format specified by the View menu.

**TIP** When the active display format is Details, the contents of the directory are displayed with Name, Size, Type, Date Modified, and Attributes. You can sort the list according to a column's contents by clicking that column's label.

---

**File name** Displays the file name of the file selected in the list.

**Save as type** Displays all the file types that can be saved. This serves as a filter for the list.

**NOTE** The choice in this field determines the file type saved, regardless of the file name extension entered in the File Name field.

**Save** Sets the file information for saving upon rendering. Closes the dialog if you haven't changed the output file type. If you've changed the file type, clicking Save opens the Setup dialog for the specified file type. Change the settings as necessary, and then click OK to close both the Setup and the Output dialogs, or click Cancel to return to the Output dialog.

**Cancel** Cancels the file save and closes the dialog.
Devices Let you choose the hardware output device, for example, a digital video recorder. To use the device, the device, its driver, and its 3ds Max plug-in must all be installed on your system.

Setup Displays controls for the selected file type. These vary with each different file format. Change the settings as necessary, and then click OK or Cancel.

Info If you highlight an existing file in the list, clicking Info displays expanded information about the file such as frame rate, compression quality, file size, and resolution. The information here depends on the type of information saved with the file type.

View If you highlight an existing file in the list, clicking View displays the file at its actual resolution. If the file is a movie, the Media Player is opened so the file can be played.

Gamma group

To set up gamma options for the output file, Enable Gamma Correction must be on in the Gamma panel on page 833 of the Preferences dialog (Customize > Preferences > Gamma). Otherwise, the Gamma controls are unavailable in the Render Output File dialog.

- **Use Image’s Own Gamma** This option is not available in this dialog.
- **Use System Default Gamma** Uses the system default gamma, as set in the Gamma panel of the Preferences dialog.
- **Override** Defines a new gamma for the bitmap that differs from the system default. Using Override is not recommended for bitmaps that you render. It is better to set a system default value, based on the graphic display you use, and use this same gamma value for all your renderings.

Sequence This is not available in the Render Output File dialog.

**NOTE** To render a sequence of still images, choose the Active Time Segment or define a range of frames in the Common Parameters rollout of the Render Setup dialog. If you have selected a still image file type, each frame will append a four-digit number to the name you have selected, incremented with each frame.
Preview When on, enables display of the image as a thumbnail.

Image thumbnail Displays a thumbnail of the selected file. Preview must be turned on.

Statistics Displays the resolution, color depth, file type, and number of frames of the selected file.

Location Displays the full path for the file.

View Image File

Rendering menu > View Image File


If you choose an IFL file in the file dialog, the Info button displays the contents of the text file in Windows Notepad.

You can zoom in and out and pan the image. If you have a wheel mouse, you can use its wheel button to zoom and pan. See the following procedures.

If you choose an animation file (AVI on page 7832 or QuickTime MOV on page 7849), 3ds Max starts the Windows Media Player so that you can play it. The Media Player has its own Help system.

Procedures

To view a file:

1 Choose Rendering > View Image File.
2 Choose a file type from the Files Of Type list.
3 Choose a file to view.

NOTE The View File dialog uses the last location where a file was chosen, rather than the default Images path defined on the Configure User Paths dialog.
To zoom in the Rendered Frame Window:

■ Press Ctrl and click.
■ Using a wheel mouse, roll the wheel forward (away from you).

To zoom out in the Rendered Frame Window:

■ Press Ctrl and right-click.
■ Using a wheel mouse, roll the wheel backward (towards you).

To pan the Rendered Frame Window:

■ Press Shift and drag.
■ Using a wheel mouse, drag with the wheel button held down. (You can use any three-button device to pan the image.)
Interface

Whenever an image is selected, the path used is added to the top of the history list as the most recently used path.

File selections from other areas of the interface, such as Views > Viewport Background, are stored here also. The history information is saved in the 3dsmax.ini on page 60 file.

History Whenever an image is selected, the path used is added to the top of the history list as the most recently used path.

File selections from other areas of the interface, such as Views > Viewport Background, are stored here also. The history information is saved in the 3dsmax.ini on page 60 file.

Look In Browses drives and directories.

File Name Displays the name of the selected file.

Files of type Selects the type of files to list in the directory window.
Devices Lets you choose the hardware output device, for example, a digital video recorder. To use the output device, the device, along with its driver, and its plug-in must all be installed on your system.

Setup This is unavailable in View Image File.
This option is available only in file dialogs like the Render Output File dialog or the Viewport Background dialog. Displays a dialog to specify image attributes for saved files or, in the Select Background Image dialog, the arguments for creating an IFL file.

Info Displays image information.

View View the selected image or animation.

Gamma group

Selects the type of gamma to be used for the selected file. Available only when Enable Gamma Selection is turned on in the Gamma panel on page 8330.

Use Image's Own Gamma Uses the gamma of the incoming bitmap.

Use System Default Gamma Ignores the image's own gamma and uses the system default gamma instead, as set in the Gamma panel on page 8330.

Override Defines a new gamma for the bitmap that is neither the image's own, nor the system default.

Sequence This is unavailable in View Image File. This option is available in the Views > Viewport Background > Files > Select Background Image dialog on page 137. It is used in conjunction with Setup to create IFL files.

Preview Toggle the image preview display.

Preview Window Displays the selected image.

[statistics box]

Displays file statistics and the file's full directory path.

Rendering Commands

The main commands for rendering are on the main toolbar on page 8035 and the Rendered Frame Window on page 6513. Another way to invoke some of
these commands is to use the default Rendering menu on page 8028, which contains other commands related to rendering.

See also:
- Rendering Effects on page 7057
- Environment and Atmosphere Effects on page 7162
- Network Rendering on page 6905

Render Setup

Main toolbar > Render Setup
Rendering menu > Render Setup
Keyboard > F10

This command opens the Render Setup dialog on page 6506, which lets you set the parameters for rendering. Rendering creates a still image or an animation. It shades the scene’s geometry using the lighting you’ve set up, the materials you’ve applied, and environment settings such as background and atmosphere.

Rendering "fills in" geometry with color, shadow, lighting effects, and so on.

Rendering is multi-threaded and multi-processed on multiple-processor configurations. A two-processor or dual-core system can render in nearly half the time a single-processor system can.

Rendering can also take place on multiple systems by using a network. See Network Rendering on page 6905. For the mental ray renderer, also see Distributed Bucket Rendering Rollout (mental ray Renderer) on page 6797.
Missing Mapping Coordinates

If the renderer finds a parametric object that requires mapping, it automatically
sets its Generate Mapping Coordinates toggle before rendering the scene. The
toggle remains set after the rendering is done.

In the following cases, however, 3ds Max is unable to supply mapping
coordinates automatically:

- Non-parametric objects, such as imported meshes, don't have built-in
  coordinates.
- Some third-party (plug-in) objects aren't provided with mapping
  coordinates.

In these cases, 3ds Max is unable to render the scene completely. It displays
a Missing Mapping Coordinates dialog on page 6198 that lists the objects the
renderer couldn't map. To resolve the problem apply a UVW Map modifier
on page 1932 to the objects that the dialog lists.

NOTE If a material has Show Map In Viewport set when that material is assigned
to an object, the object's Generate Mapping Coordinates toggle is set, if it was
not previously set. (The state of Show Map In Viewport is saved with each material.)

Procedures

To render a still image:

1. Activate the viewport to render.

2. Click Render Setup.
   The Render Setup dialog on page 6506 appears.

3. In the Time Output group, make sure Single is on.

4. In the Output Size group, set other rendering parameters or use the
defaults.

5. Click Render.
   By default, the rendering appears in a window.
To render a view without using the dialog, click Render on page 6548 or use Render Last on page 6564 (press F9).

To render an animation:

1. Activate the viewport to render.

2. Click Render Setup.
   The Render Setup dialog on page 6506 appears.

3. Open the Common Parameters rollout on page 6568. Choose a time range in the Time Output group.

4. In the Output Size group, set other rendering parameters or use the defaults.

5. In the Render Output group, click Files.

6. A Render Output File dialog on page 6529 is displayed.

7. Use the file dialog to specify a name and a type for the animation file, and then click Save.
   A configuration dialog opens that lets you set the options for the file format you chose. Adjust these settings or leave them at their defaults, and then click OK.
   The configuration dialog closes, and on the Render Setup dialog > Common Parameters rollout, the Save File toggle is now available and on.

8. Click Render.

   **NOTE** If you set a time range and do not specify a file to save to, the animation is rendered only to the window. This can be a time-consuming mistake, so an alert warns you about it.

To render a view without using the dialog, click Render Production on page 6548 or use the Keyboard Shortcut F9 to Render Last on page 6564.
Area to Render

Rendered Frame Window > Area to Render drop-down list

The Area To Render list on the Rendered Frame Window on page 6513 lets you specify the portion of the scene that will be rendered.

Procedures

To render only selected objects:

1. Open the Rendered Frame Window.
2. From the Area To Render drop-down list in the top-left corner of the window, choose Selected.
3. Activate the viewport to render.
4. Select the objects to render.
5. Render the scene.

3ds Max displays a progress dialog that shows the progress of rendering and the rendering parameter settings. To stop rendering, click Cancel in this dialog, or press Esc.
To render a region:

1. Activate the viewport to render, or choose it from the Viewport drop-down list on the Rendered Frame Window.

2. On the Rendered Frame Window, click the Edit Region button. This automatically sets the Area To Render option to Region, and displays the region window in the Rendered Frame Window and the active viewport. The window has editing handles and a close box (X).

3. To move the region window, drag inside it. To adjust its size, drag the handles. To preserve the window's aspect ratio, press and hold Ctrl before you drag a handle.

4. Render the scene. 3ds Max renders the region only. In Production mode, the Rendered Frame Window is cleared before rendering, but in Iterative mode, the area of the window outside the region remains intact.

To render a blowup:

1. Open the Rendered Frame Window and choose the viewport to render.

2. Choose Blowup from the Area To Render list.

3. To move the window, drag inside it. To adjust the window size, drag its handles. The window is constrained to the aspect ratio of the current output size.

4. Render the scene.
3ds Max displays a progress dialog that shows the progress of rendering and the rendering parameter settings. To stop rendering, click Cancel in this dialog, or press Esc.

**Interface**

The following choices are available on the Area To Render drop-down list.

| NOTE | The Box Selected, Region Selected, and Crop Selected options previously available before 3ds Max 2009 are no longer necessary and have been removed. To achieve the equivalents, combine an Area To Render option with the Auto Region Selected option on the Rendered Frame Window. |

| View (The default.) | Renders the active viewport. |

| Selected | Renders the currently selected object or objects only. Rendering a selection with the scanline renderer leaves the remainder of the Rendered Frame Window intact. However, mental ray renders the background first, thus effectively clearing the rest of the frame. |

| TIP | Rendering Selected renders the selection in isolation, without any contribution from the rest of the scene, such as shadows, reflections, etc. When rendering with mental ray, to render a selection with full contribution from the other scene contents, use the Subset Pixels option instead. |
TIP To remove any existing image from the window when rendering with the scanline renderer, use the Clear button before rendering.

**Region** Renders a rectangular region within the active viewport. Using this option leaves the remainder of the Rendered Frame Window intact except when rendering an animation, in which case it clears the window first. Use the Region option when you need to test-render a part of the scene.

When you choose Region from the Area To Render list, the Edit Region on page 6516 control activates. This causes an editable version of the region to appear in both the Rendered Frame Window and the active viewport. To move the region or change its size, drag either region box or its handles, respectively. If you turn off Edit Region, the region remains visible in the Rendered Frame Window, but is no longer editable. Alternatively, to set the region to the current selection automatically, turn on Auto Region Selected on page 6517.

TIP To remove any existing image from the window, use the Clear button before rendering.

**NOTE** Region rendering is meant to create a draft rendering of a selected area of a view. As such, Region rendering uses only an Area filter for antialiasing, regardless of which antialiasing is chosen in the Render Setup dialog.
Crop Lets you specify the size of the output image using the same region box that appears for the Region option.

After you choose Crop from the Area To Render list, turn on Edit Region on page 6516 to cause a rectangular render region to appear in the active viewport. To move the region or change its size, drag the region box or its handles, respectively. Alternatively, to set the region to the current selection automatically, turn on Auto Region Selected on page 6517.
Blowup  Renders a region within the active viewport and enlarges it to fill the output display.

After you choose Blowup from the Area To Render list, turn on Edit Region on page 6516 to cause a rectangular render region to appear in the active viewport. To move the region or change its size, drag the region box or its handles, respectively. Alternatively, to set the blowup region to the current selection automatically, turn on Auto Region Selected on page 6517.

Render Flyout

Main toolbar > Render flyout

The Render flyout provides a few different rendering options.

The Render flyout lets you choose among these buttons:

- ![Render Production](image)  Render Production on page 6548

- ![Render Iterative](image)  Render Iterative on page 6548
The Render buttons let you render the scene using the settings without using the Render Setup dialog on page 6506. Choosing one of these buttons also changes which rendering settings are active on the Render Setup dialog.

Invoking the Render command from the Rendering menu or by pressing Shift+Q uses the active mode on the Render flyout.

By default, all the rendering options use the default scanline renderer on page 6589. You can change the renderer assigned to Production or ActiveShade by using the Assign Renderer rollout on page 6582 on the Render Setup dialog > Common panel.

### Render Production

Main toolbar > Render flyout > Render Production

The Render Production command, available on the Render flyout on page 6547 on the main toolbar, renders the scene using the current production render settings without opening the Render Setup dialog on page 6506. You can activate Production rendering mode without rendering from the drop-down list in the bottom-left corner of the Render Setup dialog, and in the top-right corner of the Rendered Frame Window.

You assign which renderer to use for production rendering on the Assign Renderer rollout on page 6582 of the Render Setup dialog > Common panel.

See also:

- Render Iterative on page 6548
- ActiveShade on page 6549

### Render Iterative

Main toolbar > Render flyout > Render Iterative
The Render Iterative command, available from the Render flyout on page 6547 on the main toolbar, renders the scene in iterative mode without opening the Render Setup dialog on page 6506. You can activate Iterative rendering mode without rendering from the drop-down list in the bottom-left corner of the Render Setup dialog, and in the top-right corner of the Rendered Frame Window.

Iterative rendering ignores file output, network rendering, rendering of multiple frames, export to MI files, and email notification. Use this option when doing quick iterations on the image, usually in parts; for example, working on final gather settings, reflections, or specific objects or areas of the scene.

Also, when rendering in Iterative mode, rendering Selected on page 6544 or Region on page 6545 leaves the rest of the Rendered Frame Window intact.

See also:
- Render Production on page 6548
- ActiveShade on page 6549

ActiveShade

Main toolbar > Render flyout > ActiveShade

Keyboard > Shift+Q (Uses the Render mode currently active on the toolbar: either Production or ActiveShade)

The ActiveShade button, available from the Render flyout on page 6547, creates an ActiveShade on page 6550 rendering in a floating window.

You assign which renderer to use for ActiveShade rendering on the Assign Renderer rollout on page 6582 of the Render Setup dialog on page 6506 > Common panel.

See also:
- Render Production on page 6548
- Render Iterative on page 6548
Rendering with ActiveShade

Main toolbar > Render flyout > Render (ActiveShade)

Click or right-click the Point-Of-View (POV) viewport label. > POV viewport label menu on page 8122 > ActiveShade

ActiveShade gives you a preview rendering that can help you see the effects of changing lighting or materials in your scene. When you adjust lights or materials, the ActiveShade window interactively updates the rendering.

ActiveShade preview of material changes

Above left: Before the update
Above right: After changing the material for the fabric to a mapped material and increasing the highlights on the material for the wood
ActiveShade preview of lighting changes
Above left: Before moving a light in a viewport
Above right: After moving the light

There are two ActiveShade options:

- **Viewport**  The ActiveShade rendering appears in the active viewport.

- **Floater**   The ActiveShade rendering appears in its own window.

Only one ActiveShade window can be active at a time. If you choose one of the ActiveShade commands while an ActiveShade window is already active, you get an alert that asks whether you want to close the previous one. If the...
previous ActiveShade window was docked in a viewport, the viewport reverts
to the view it previously showed.

**TIP** You can drag and drop materials from the Material Editor on page 5641 to
ActiveShade windows and viewports, as you can with other viewports.

**NOTE** You can't make a maximized viewport an ActiveShade window, or
maximize an ActiveShade window.

**ActiveShade Commands**

When you right-click an ActiveShade window, the quad menu on page 8052
displays an ActiveShade menu. This menu contains a number of ActiveShade
commands on page 6558.

**ActiveShade and Object Selection**

If you select an object before you invoke ActiveShade, ActiveShade is done
only for that object. This can greatly increase the speed of ActiveShade.

Similarly, once the ActiveShade window is open, the initialize and update
steps on page 8497 (whether automatic or manual) are done only for the selected
object.

In a "docked" ActiveShade viewport, you can select objects by right-clicking,
turning on Select Object in the Tools (lower-right) quadrant of the quad menu,
then clicking the object you want to select. In an ActiveShade viewport, only
one object at a time can be selected.

**TIP** When an object in an ActiveShade window has a mapped material, select it
before you change a map or adjust its parameters.

**What ActiveShade Does and Doesn't Do**

For the sake of interactivity, the ActiveShade window is limited in what it can
update interactively. An ActiveShade rendering is typically less precise than
a final production rendering.
**TIP** When you change geometry by transforming it or modifying it, right-click the ActiveShade window and choose Tools > Initialize from the quad menu (lower-right quadrant). This updates the ActiveShade rendering.

- Moving an object does not update the ActiveShade window.
- Applying a modifier or otherwise changing object geometry does not interactively update the ActiveShade window.
- Reflections are rendered only in the Initialize pass.
- Materials are displayed as RGBA data with 8 bits per channel.
- Multiple changes to a material might lead to deterioration in image quality. If you see this happening, right-click the ActiveShade window and choose Tools > Initialize from the quad menu (lower-right quadrant).
- Masks are reduced from 8x8 to 4x4 subdivisions per pixel. The mask is corrected to 6-bit opacity (0 to 63 rather than 0 to 255). This might result in some visual noise around object edges.
- Because of the preceding item, filters are coarser than in full-scale renderings, but they still have significant subpixel information.
- There is a limitation of 16 subdivisions per pixel. Because of this, any objects behind the sixteenth occluding object for a given pixel will be ignored. Rendered back faces count as separate objects.
- Reshading uses compressed normals and other direction vectors. This should have no visible effect.
- ActiveShade does not render atmospheric effects, rendering effects, or ray-traced shadows (the only shadows it can render are shadow-mapped shadows).

**Procedures**

**To display an ActiveShade window in a viewport:**

- Click or right-click the Point-Of-View (POV) viewport label. From the POV viewport label menu on page 8122, choose ActiveShade.

**NOTE** You can’t make a maximized viewport an ActiveShade window, or maximize an ActiveShade window.
To display a free-floating ActiveShade window:

- Choose ActiveShade from the Render flyout on page 6547.

**NOTE** As with the Render command, the ActiveShade window respects the Output Size setting from the Render Setup dialog on page 6506. To use a different render size, set it first with Render Setup, and then open the ActiveShade window.

To update an ActiveShade window after moving an object or changing object geometry:

1. Right-click the ActiveShade window.
2. In the Tools (lower-right) quadrant of the quad menu, choose Initialize.

To see the toolbar in an ActiveShade viewport:

1. Click the viewport to make it active.
2. Press the Spacebar to display the toolbar.
   - Pressing spacebar again toggles the toolbar off, and so on.
   - You can also turn toolbar display on or off by right-clicking and using the quad menu.

To change an ActiveShade viewport to another kind of viewport:

1. Turn on the toolbar in the ActiveShade viewport.
2. Right-click the toolbar.
3. In the pop-up menu, choose the type of view to display.
   - You can also restore the viewport to its previous status by right-clicking the viewport and choosing View (upper-left) quad > Close.

To zoom and pan in an ActiveShade window:

You can zoom in and out and pan the image in the ActiveShade window. You can even do this while a scene is rendering.

1. Hold down Ctrl and then click to zoom in, right-click to zoom out.
2. Hold down Shift and then drag to pan. (The window must be zoomed in.)
If you have a three-button mouse, you can use its third button or wheel to zoom and pan:

1. Roll the wheel to zoom in or out.
2. Press the wheel, and drag to pan.

**NOTE** You can use any third-button pointing device to pan the image. To enable this, choose the Pan/Zoom option on the Viewports panel on page 8308 of the Preferences dialog.

**Interface**

Both the viewport and floating versions of the ActiveShade window have the same controls as a Rendered Frame Window on page 6513. In an ActiveShade viewport, the toolbar is off by default. In a floating ActiveShade window, the toolbar is always visible.

**TIP** In an active ActiveShade viewport, you can toggle toolbar display by pressing the Spacebar. (This is a main user interface shortcut, so the Keyboard Shortcut Override Toggle can be either on or off.)
TIP If you clear the image, you can redisplay it by right-clicking the ActiveShade window and choosing Tools > Initialize or Tools > Update Shading from the lower-right quadrant of the quad menu.

**ActiveShade Floater**

Main toolbar > Render flyout > ActiveShade

To create an ActiveShade rendering in its own window, choose the ActiveShade command from the Render flyout on the main toolbar.

You can open only one ActiveShade window at a time. If you change a viewport to an ActiveShade view while a floating ActiveShade window is open, you get a message that asks whether you want to close the floating window or stop the operation.

See also:

- Rendering with ActiveShade on page 6550
ActiveShade Viewport

Right-click viewport label. > Views > ActiveShade

Creates an ActiveShade rendering that is "docked" in a viewport.

Only one ActiveShade rendering can be displayed at a time. If you try to display a floating ActiveShade window while an ActiveShade viewport is displayed, you get a message that asks whether you want to close the docked ActiveShade rendering, or stop the operation. If you go ahead and close the docked ActiveShade rendering, the viewport reverts to the view it previously showed.

ActiveShade Commands

When you right-click an ActiveShade viewport, the quad menu displays an ActiveShade menu. This menu contains a number of ActiveShade commands.

ActiveShade and Object Selection

If you select an object before you invoke ActiveShade, ActiveShade is done only for that object. This can greatly increase the speed of ActiveShade.

Similarly, once the ActiveShade window is open, the initialize and update steps on page 8497 (whether automatic or manual) are done only for the selected object.

In a "docked" ActiveShade viewport, you can select objects by right-clicking, turning on Select Object in the Tools (lower-right) quadrant of the quad menu, then clicking the object you want to select. In an ActiveShade viewport, only one object at a time can be selected.

TIP When an object in an ActiveShade window has a mapped material, select it before you change a map or adjust its parameters.
Procedures

To display the toolbar for the ActiveShade viewport:

- Press the Spacebar.
  The Spacebar toggles the toolbar display. In viewports, the toolbar is off by default.
  (This is a main user interface shortcut, so the Keyboard Shortcut Override Toggle can be either on or off.)

The controls on the toolbar for an ActiveShade viewport are the same as for a floating ActiveShade window on page 6556.

To change the ActiveShade viewport to another kind of viewport, do one of the following:

- Right-click the ActiveShade viewport, and choose Close from the View (upper-left) quadrant of the quad menu.
  The viewport reverts to the view it previously showed.

- If the toolbar is not visible, press the Spacebar to display it, then right-click the toolbar and choose the kind of view to display.

ActiveShade Commands (Quad Menu)

When you right-click an ActiveShade window, the lower-left quadrant of the quad menu displays a set of commands for ActiveShade on page 6550.

Interface

```
<table>
<thead>
<tr>
<th>Options</th>
<th>Tools</th>
</tr>
</thead>
<tbody>
<tr>
<td>Act Only on Mouse Up</td>
<td>✓</td>
</tr>
<tr>
<td>Auto Initialization</td>
<td>✓</td>
</tr>
<tr>
<td>Auto Update</td>
<td>✓</td>
</tr>
</tbody>
</table>
```
**Render quadrant (upper right)**

These are general-purpose commands.

**Show Last Rendering** Displays the last rendering in a Rendered Frame Window on page 6513. Not available if no rendering has been made during this session.

**Render Setup** Displays the Render Setup dialog on page 6506. When you use the ActiveShade quad menu, Render Setup is set to render the ActiveShade window initially.

**Render Last** Repeats the last render, using the last viewport from which you rendered.

**Material/Map Browser** Opens a modeless Material/Map Browser on page 5703 dialog.

**Material Editor** opens the Material Editor on page 5641.

**Tools quadrant (lower right)**

These are the commands that perform ActiveShade operations.

**Draw Region** When on, lets you draw a rectangular region of the ActiveShade window. While it is active, only the region is updated by interactive reshading. This can save time, and also help you concentrate on just a portion of the image to be rendered. Default=off.

To turn off Draw Region, click outside the rectangular region. The entire ActiveShade window is updatable again.

**Initialize** Initializes the ActiveShade window. To keep the ActiveShade window current, you need to choose Initialize after transforming, modifying, or otherwise changing geometry. If you have turned off Automatic Reinitialization, you also need to choose Initialize after you update a mapped material.

Rendering can be slow. The initialize pass is meant to take care of the most time-consuming portions of rendering, to allow the update pass to take place as quickly as possible. Initialization includes the following steps:

- Evaluate the scene geometry into meshes.
- Apply space warps.
- Do transformations and clipping.
- Evaluate textures and shade materials.
Perform optimizations to speed later processing, such as merging fragments from the same surface that are in the same pixel.

The result of initialization is a buffer. This is a compressed rendering that, like a G-Buffer on page 8589, contains the rendering plus additional information used by the second step, updating.

During the initialize pass, progress is indicated by a row of pixels (white by default) that traverses the top edge of the ActiveShade window.

**Update** Updates the ActiveShade window. Updating shading takes the buffer created by the first pass, initialization, and uses information in that buffer to change the color of pixels when you make changes to lights and materials in the scene.

During the update pass, progress is indicated by a row of pixels (white by default) that descends the right edge of the ActiveShade window.

To keep the ActiveShade window current, you need to choose Update Shading if you have previously turned off Automatic Shading Update.

**Select Object** (viewports only) When on, you can select an object in the ActiveShade window by clicking. You can select only one object at a time.

When an objects is selected in the ActiveShade window, the Initialize pass resamples textures for that object alone. This improves the window’s rendering speed, and is useful when you are adjusting texture display.

**Toggle Toolbar** (viewports only) Toggles display of the ActiveShade window toolbar in viewports.

Keyboard shortcut: Spacebar

---

NOTE The Keyboard Shortcut Override toggle on page 8420 must be on for the spacebar to toggle the ActiveShade toolbar.

---

**Options quadrant (lower left)**

These commands control how the ActiveShade window behaves.

**Act Only On Mouse Up** When on, changes you make to light and material parameters (for example, the RGB or Multiplier spinners) update the ActiveShade window only after you release the mouse. When off, changes to these parameters are updated immediately, as you drag the mouse. Default=on.
Turning off Act Only On Mouse Up can make the ActiveShade window more responsive to changes, but it can also slow performance.

**Auto Initialization** When on, changes you make to textures (mapped materials) automatically cause the ActiveShade window to initialize. Default=on.

Initialization can be time consuming in complex scenes. To save time, you can turn off Automatic Reinitialization, or use Draw Region to restrict initialization and shading updates to only a portion of the scene.

**Auto Update** When on, changes you make to lighting, and materials without maps, automatically cause an update of the ActiveReshade window. Default=on.

**View quadrant (upper left)**

**Close** Closes the ActiveShade window. If the ActiveShade window was docked in a viewport, the viewport reverts to the view it previously displayed.

---

**Preset Rendering Options**

Render Setup dialog > Preset drop-down list (near the bottom of the panel)

Rendered Frame Window > Render Preset drop-down list (in the top row of controls)

**Render Shortcuts toolbar** on page 8042 > drop-down list

Preset rendering options are available on the Render Setup dialog on page 6506, the Rendered Frame Window on page 6513, and the Render Shortcuts toolbar on page 8042. Some of the presets are tailored for relatively quick, preview renderings; others are for slower but higher quality renderings. You can save and load presets as RPS files.
In addition to the default presets that ship with 3ds Max, you can create your own. At the bottom of the Preset list, two choices let you use and create your own custom presets:

**Load Preset** When you choose Load Preset, 3ds Max opens a file selector dialog that lets you choose the RPS file to load.

Each category corresponds to one panel of the Render Setup dialog. Choose which panel's settings you want to load from the RPS file, and click Load. Once you load a custom preset file, its name appears on the drop-down list, along with the default choices.
IMPORTANT Although you assign the renderer on the Common panel of the Render Setup dialog, the renderer assignment is not among the Common category settings in the RPS file. Instead, each preset has a separate category for the current renderer assignment. For example, if the current renderer is the Default Scanline Renderer, the Select Preset Categories dialog will have a category labeled Default Scanline Renderer.

Save Preset When you choose Save Preset, 3ds Max first opens a file selector dialog that lets you name the RPS file. After that, the Select Preset Categories dialog opens.

Each category corresponds to one panel of the Render Setup dialog. Choose which panel’s settings you want to save, and then click Save. Once you save a custom preset file, its name appears on the drop-down list, along with the default choices.

IMPORTANT Even though the renderer is assigned on the Common panel of the Render Setup dialog, the renderer assignment is not saved with the Common category in the RPS file. The renderer assignment has its own category on the Select Preset Categories dialog. For example, if the current renderer is the Default Scanline Renderer, the Select Preset Categories dialog will have a category labeled Default Scanline Renderer.

The RPS files that provide the default presets are in the renderpresets subfolder of 3ds Max folder. We recommend you save your own presets in this subfolder as well. If you choose a different location, 3ds Max saves the full path name. (You can also use the Configure User Paths dialog > File I/O panel on page 8287 > RenderPresets setting to specify a custom location.)
Render Last

Keyboard > F9

The Render Last command repeats the last render (whether a render view, render region, render blowup, or render selected) using the last viewport from which you rendered.

**WARNING** Render Last does not save to a file, even if the previous rendering did so.

Print Size Wizard

Rendering menu > Print Size Assistant

The Print Size Wizard feature is useful when you plan to print a rendered image. It lets you specify output size, resolution, and orientation in terms of the printed image; that is, using a standard measuring system rather than pixels. It also indicates the approximate uncompressed size of the image file. You can render directly from the wizard on your computer or over a network, or transfer the settings to the Render Setup dialog on page 6506.

Procedures

To use the Print Size wizard:

1. Set up a scene to render.
2. From the Rendering menu, choose Print Size Assistant.
3. Choose a preset paper size, or specify a custom size in inches or millimeters. Alternatively, specify an image size in pixels.
4. Choose or specify a DPI (dots per inch) ratio for the printed output.
5. Choose an output orientation: Portrait or Landscape.
6. When ready to render to a file, turn on Save File, click the Files button, and use the resulting Select TIFF File dialog to specify an output image file.
7. Do one of the following:
   - To render immediately, click Render.
   - To set further rendering properties, click Render Setup.
Interface

Paper Size group

drop-down list The Paper Size drop-down list lets you choose from several standard print resolutions and aspect ratios. Choose one of these formats, or leave it set to Custom to use the other controls in the Paper Size group. These are the options you can choose from on the list:

- Custom
- A - 11 x 8.5 in. (at 300 dpi)
- B - 17 x 11 in. (at 200 dpi)
- C - 22 x 17 in. (at 150 dpi)
- D - 34 x 22 in. (at 100 dpi)
- E - 44 x 34 in. (at 75 dpi)
- A0 - 1189 x 841 mm (at 75 dpi)
- A1 - 841 x 594 mm (at 100 dpi)
- A2 - 594 x 420 mm (at 150 dpi)
- A3 - 420 x 297 mm (at 200 dpi)
- A4 - 297 x 210 mm (at 300 dpi)
- A5 - 210 x 148 mm (at 300 dpi)
- Letter (11 x 8.5 in. at 300 dpi)
- Legal (14 x 8.5 in. at 300 dpi)
- Tabloid (17 x 11 in. at 300 dpi)

**TIP** You can customize the Paper Size list by editing the file `plugcfg/printwiz.ini`. If you choose to edit the file, first be sure to save a backup copy of the original.

**Portrait/Landscape** Choose Portrait for vertically oriented output or Landscape for horizontal output. The window image provides a graphic depiction of the orientation.

**NOTE** Changing between Portrait and Landscape simply switches the Width and Height settings. The actual orientation depends on the image dimensions. For example, if you choose Portrait, and then specify a custom size whose width is greater than its height, the resulting orientation will be horizontal.

**TIP** After changing this setting, be sure to preview the image using the Show Safe Frames on page 8127 function on the Point-Of-View (POV) viewport label menu on page 8122. This shows how the output orientation corresponds to the viewport.

**Choose Unit** Lets you specify whether the measurement units for Paper Width and Paper Height are in millimeters (mm) or inches.

**Choose DPI Value** Provides four buttons for commonly used dots-per-inch settings: 72, 150, 300, and 600. Click one to set it in the DPI property, below.

**Paper Width/Height** Specifies the output width and height in mm (millimeters) or inches, depending on which is chosen under Choose Unit.

**NOTE** Changing either setting also changes the corresponding Image size setting.
Image Width/Height  Specifies the output width and height in pixels.

NOTE  Changing either setting also changes the corresponding Paper size setting.

DPI  Specifies the output resolution in dots per inch. The easiest way to set this is by clicking one of the buttons under Choose DPI Value. If you're using a different resolution, set it here manually.

Only TIFF files on page 7880 support DPI information. If you render to a different image format, you might have to later adjust the image resolution using an image-processing application.

NOTE  Changing the DPI setting also changes the Image Width/Height settings, keeping the same aspect ratio.

Uncompressed File Size  Displays the size of the rendered TIFF image file if no compression is used.

Rendering group

Rendering directly from the Print Size Wizard allows you to output the current frame to a disk file in TIFF format on page 7880. This format is commonly used in the publishing industry. To render to a different format, use the wizard's Render Setup button.

Save File  When on, 3ds Max saves the rendered image to disk when you render. Save File is available only after you specify the output file using the Files button. Default=off.

Files  Opens the Select TIFF File dialog, which lets you specify the output file name and location. If, during the current session, you already rendered an image to disk using the Render Setup dialog on page 6506, the last file name you used appears in this field.

Save Alpha Channel  When on, 3ds Max includes an eight-bit alpha channel on page 8502 in the rendered TIFF file on page 7880. Default=off.

Compress File  When on, uses compression when saving the file.

Render Setup  Opens the Render Setup dialog on page 6506 and transfers any settings (such as image size) you've made in the Print Size Wizard. Here you can make further changes and then render the scene.

Render  Renders the scene to the Rendered Frame Window on page 6513. Also renders to a disk file if you've turned on Save File and specified a file name.
Common Panel (Render Setup Dialog)

*Render Setup dialog* on page 6506 > Common panel

The Common panel of the Render Setup dialog contains controls that apply to any rendering, regardless of which renderer you have chosen, and that lets you choose renderers.

Common Parameters Rollout (Render Setup Dialog)

Rendering menu > Render Setup > Render Setup dialog > Common panel > Common Parameters rollout

The Common Parameters rollout sets parameters common to all renderers.

**Procedures**

To set the size of the image, do one of the following:

1. In the Output Size group, click one of the preset resolution buttons.
2. In the Output Size group, choose one of the pre-formatted film or video formats from the drop-down list.
3. In the Output Size group, choose Custom from the drop-down list, and then adjust the Width, Height, and Aspect Ratio values manually.

**TIP** Smaller images render much more quickly. For example, you can use 320 x 240 to render draft images, then change to a larger size for your final work.

To save the rendered still image in a file:

1. In the Render Output group, click Files.
2. In the file dialog, specify a name and a type for the image file, and then click OK. The Save File toggle turns on.
   You can later turn off Save File if you want only to view the rendering on screen.

6568 | Chapter 18  Rendering
The file dialog has a Setup button. This displays a subdialog that lets you choose options specific to the file type you are saving to.

To alter the pixel aspect ratio:

■ In the Output Size group of the Render Setup dialog > Common panel > Common Parameters rollout, adjust the Pixel Aspect setting to fit the requirements of your output device.
  The Image Aspect field updates to show the aspect ratio of the rendered output.
  If you alter the pixel aspect ratio but also render to a window or a file, the rendered image might appear distorted.

To speed up rendering time for the purpose of a test (or draft) rendering:

1 In the Options group of the Common Parameters panel, turn on Area Lights/Shadows As Points.
2 Set any other parameters and click Render.
  All area and linear lights in the scene are treated as point lights during the rendering. This reduces rendering time, however some quality is lost. When you are ready to render at high quality, you can simply turn off Area Lights/Shadows As Points and render again.

NOTE Scenes with radiosity on page 6615 are not affected by the Area Lights/Shadows As Points toggle, as area lights do not have a significant effect on the performance of a radiosity solution.
Interface

Common Parameters

- Time Output:
  - Single
  - Active Time Segment: 0 To 100
  - Range: 0 To 100
  - File Number Base: 0
  - Frames: 1,3,5,12

- Output Size:
  - Custom
  - Aperture Width (mm): 350
  - Width: 840, 320x240, 720x486
  - Height: 640, 640x480, 900x600
  - Image Aspect: 1.333
  - Pixel Aspect: 1.0

- Options:
  - Atmospherics
  - Effects
  - Displacement
  - Video Color Check
  - Render to Fields
  - Render Hidden Geometry
  - Area Lights/Shadows as Points
  - Force 2-Sided
  - Super Black

- Advanced Lighting:
  - Use Advanced Lighting
  - Compute Advanced Lighting when Required

- Bitmap Proxies:
  - Using Bitmap Proxies for Rendering [Setup]

- Render Output:
  - Save File
  - Put Image File List(s) in Output Path(s) [Create Now]
  - Autodesk 3ds Max Image Sequence File (ims)
  - Legacy 3ds max Image File List (iml)
  - Use Device [Devices]
  - Rendered Frame Window
  - Net Render
  - Skip Existing Images

6570 | Chapter 18  Rendering
**Time Output group**

Select which frames you want to render.

**Single** Current frame only.

**Active Time Segment** The *Active Time Segment* on page 8496 is the current range of frames as shown in the time slider.

**Range** All the frames between and including the two numbers you specify.

**Frames** Nonsequential frames separated by commas (for example, 2,5) or ranges of frames, separated by hyphens (for example, 0-5).

- **File Number Base** Specifies the base file number, from which the file name will increment. Range= -99,999 to 99,999. Available only for Active Time Segment and Range output.

- **Every Nth frame** Regular sample of frames. For example, type 8 to render every 8th frame. Available only for Active Time Segment and Range output.

For example, if the Range of frames is set to 0-3, Every Nth Frame is 1, and the File Number Base is 15, the output files are file0015, file0016, file0017, file0018.

You can specify a negative number base, as well. For example, if you're rendering frames 50-55, and set the File Number Base to -50, the result is file-050, file-051, file-052, file-053, file-054, file-055.

**NOTE** If you begin render a range of frames, but haven't assigned a file in which to save the animation (using the Files button on page 6576), an alert box appears to warn you about this. Rendering animations can take a long time, and usually it doesn't make sense to render a range without saving all frames to a file.

**Output Size group**

Select one of the predefined sizes or enter another size in the Width and Height fields (in pixels). These controls affect the image's aspect ratio on page 8511.

**Drop-down list** The Output Size drop-down list lets you choose from several standard film and video resolutions and aspect ratios. Choose one of these formats, or leave it set to Custom to use the other controls in the Output Size group. These are the options you can choose from on the list:

- **Custom**

- **35mm 1.316:1 Full Aperture (cine)**
- 35mm 1.37:1 Academy (cine)
- 35mm 1.66:1 (cine)
- 35mm 1.75:1 (cine)
- 35mm 1.85:1 (cine)
- 35 MM Anamorphic (2.35:1)
- 35 MM Anamorphic (2.35:1) (Squeezed)
- 70mm Panavision (cine)
- 70mm IMAX (cine)
- VistaVision
- 35mm (24mm X 36mm) (slide)
- 6cm X 6cm (2 1/4" X 2 1/4") (slide)
- 4" X 5" or 8" X 10" (slide)
- NTSC D-1 (video)
- NTSC DV (video)
- PAL (video)
- PAL DV (video)
- HDTV (video)

**NOTE** The values of the Image Aspect and Width and Height buttons can change, depending on which output format you select from this list.

**Aperture Width (mm)** Lets you specify an aperture width for the camera that creates the rendered output. Changing this value changes the camera's Lens value. This affects the relationship between the Lens and the FOV values, but it doesn't change the camera's view of the scene.

For example, if you have a Lens setting of 43.0 mm, and you change the Aperture Width from 36 to 50, when you close the Render Setup dialog (or render), the camera Lens spinner has changed to 59.722, but the scene still looks the same in the viewport and the rendering. If you use one of the preset formats rather than Custom, the aperture width is determined by the format, and this control is replaced by a text display.
**Width and Height** Let you set the resolution of the output image by specifying the width and the height of the image, in pixels. With Custom format, you can set these two spinners independently. With any other format, the two spinners are locked to the specified aspect ratio, so adjusting one alters the other. The maximum width and height is 32,768 x 32,768 pixels.

**Preset resolution buttons (320x240, 640x480, and so on)** Click one of these buttons to choose a preset resolution. You can customize these buttons: right-click a button to display the **Configure Preset dialog** on page 6577, which lets you change the resolution specified by the button.

**Image Aspect** Lets you set the aspect ratio of the image. Changing this value changes the Height value to maintain the correct dimensions for the active resolution. When you use a standard format rather than Custom, you can’t change the aspect ratio, and this control is replaced by a text display.

In 3ds Max, the Image Aspect value is always expressed as a multiplier value. In written descriptions of film and video, often aspect ratio is also described as a ratio. For example, 1.33333 (the default Custom aspect ratio) is often expressed as 4:3. This is the standard aspect ratio for broadcast video (both NTSC on page 8654 and PAL on page 8674) when letterboxing is not used. (Letterboxing shows the full width of a wide-screen film format, framed by black regions above and below.)

![Image Aspect](image)

When using a custom output size, the lock button to the left of Image Aspect locks the aspect ratio. When it is on, the Image Aspect spinner is replaced by a label, and the Width and Height spinners are locked to each other; adjusting one alters the other to maintain the aspect-ratio value. In addition, when the aspect ratio is locked, altering the Pixel Aspect value alters the Height value to maintain the aspect-ratio value.

**NOTE** In viewports, the camera’s cone changes to reflect the image aspect ratio you set in the Render Setup dialog. This change takes place when you exit the Render Setup dialog.

**Pixel Aspect** Sets the aspect ratio of the pixels for display on another device. The image might look squashed on your display but will display correctly on the device with differently shaped pixels. If you use one of the standard formats rather than Custom, you can’t change the pixel aspect ratio and this control is disabled.
The lock button to the left of Pixel Aspect locks the pixel-aspect ratio. When it is on, the Pixel Aspect spinner is replaced by a label, and you can't change the value. This button is available only with the Custom format.

Images with different pixel aspects appear stretched or squashed on a monitor with square pixels.

**NOTE** For standard NTSC on page 8654, the pixel aspect ratio is 0.9. If you are creating 16:9 (0.778) anamorphic images for NTSC, the pixel aspect ratio should be 1.184. (As in the previous discussion of Image Aspect, this assumes the image is not letterboxed.)

**Options group**

**Atmospherics** Renders any applied atmospheric effects, such as volume fog, when turned on.

**Effects** Renders any applied rendering effects, such as Blur, when turned on.

**Displacement** Renders any applied displacement mapping.
**Video Color Check** Checks for pixel colors that are beyond the safe NTSC on page 8654 or PAL on page 8674 threshold and flags them or modifies them to acceptable values.

By default, "unsafe" colors render as black pixels. You can change the color check display by using the Rendering panel on page 8342 of the Preference Settings dialog on page 8298.

**Render to Fields** Renders to video fields on page 8570 rather than frames when creating animations for video.

**Render Hidden Geometry** Renders all geometric objects in the scene, even if they are hidden.

**Area Lights/Shadows as Points** Renders all area lights or shadows as if they were emitted from point objects, speeding up rendering time.

When mental ray is the active renderer, this switch is also available on the Rendered Frame Window > lower panel as the leftmost position of the Soft Shadows Precision on page 6525 slider. Alternatively, you can use the slider to adjust soft shadows globally, so that you can still see soft shadows while speeding up rendering.

**TIP** This option is useful for draft renderings, as point lights render much faster than area lights.

**NOTE** Scenes with radiosity on page 6615 are not affected by this toggle, as area lights do not have a significant effect on the performance of a radiosity solution.

**Force 2-Sided** 2-Sided rendering on page 8493 renders both sides of all faces. Usually, you'll want to keep this option off to speed rendering time. You may want to turn it on if you need to render the inside as well as the outside of objects, or if you've imported complex geometry in which the face normals are not properly unified.

**NOTE** This switch does not apply to objects that use the mental ray material Arch & Design on page 5858. In such cases, turn on the material’s Advanced Rendering Options rollout > Back Face Culling check box on page 5887.

**Super Black** Super Black rendering on page 8735 limits the darkness of rendered geometry for video compositing. Leave off unless you're sure you need it.

**Advanced Lighting group**

**Use Advanced Lighting** When on, 3ds Max incorporates a radiosity solution on page 6615 or light tracing on page 6601 in the rendering.
Compute Advanced Lighting When Required When on, 3ds Max computes radiosity when required on a per-frame basis.

Normally, when rendering a series of frames, 3ds Max calculates radiosity only for the first frame. If, in an animation, it might be necessary to recalculate the advanced lighting in subsequent frames, turn this option on. For example, a brightly painted door might open and affect the coloring of a nearby white wall, in which case the advanced lighting should be recalculated.

Bitmap Proxies group

Displays whether 3ds Max is using full-resolution maps or bitmap proxies for rendering. To change this setting, click the Setup button.

Setup Click to open the Global Settings and Defaults for Bitmap Proxies dialog on page 7601.

Render Output group

Save File When on, 3ds Max saves the rendered image or animation to disk when you render. Save File is available only after you specify the output file using the Files button.

Files Opens the Render Output File dialog on page 6529, which lets you specify the output file name, format, and location.

You can render to any of the still or animated image file formats on page 7831 that are writable.

If you render multiple frames to a still-image file format, the renderer renders individual frame files and appends sequence numbers to each file name. You can control this with the File Number Base setting on page 6571.

Put Image File List(s) in Output Path(s) Turn on to create an image sequence (IMSQ) file on page 7847, and save it in the same directory as the rendering. Default=off.

3ds Max creates one IMSQ file (or IFL file) per render element on page 6807. The files are created when you click Render or Create now. They are generated before the actual rendering.

Image sequence files can be created by the following kinds of rendering:

- The Render Setup dialog
- The Render command
- Batch rendering
- Command-line rendering
They are not created by the following kinds of rendering:

- Rendering to textures
- Video Post rendering
- Rendering a panorama

Create Now Click to create the image sequence file “by hand.” You must first choose an output file for the rendering itself.

[**image sequence file type**] Choose either of the following:

- **Autodesk ME Image Sequence File (.imsq)** When chosen (the default), creates an Image Sequence (IMSQ) file on page 7847.

- **Legacy 3ds max Image File List (.ifl)** When chosen, creates an Image File List (IFL) file on page 7841 of the kind created by previous versions of 3ds Max.

Use Device Sends the rendered output to a device such as a video recorder. First click the Devices button to specify the device, for which an appropriate driver must already be installed.

Rendered Frame Window Displays the rendered output in the Rendered Frame Window on page 6513.

Net Render Enables network rendering on page 6905. If this is on, when you render you’ll see the Network Job Assignment dialog on page 6953.

Skip Existing Images When activated and Save File is on, the renderer will skip images in a sequence that have already been rendered to disk.

**Configure Preset Dialog**

Main menu > Render Setup > Render Setup Dialog > Common panel > Common Parameters rollout > Output Size group > Right-click a preset resolution button. > Configure Preset dialog
This dialog lets you change the preset resolution on a button in the Output Size group of the Common Parameters rollout.

**Interface**

![Configure Preset dialog](image)

**Width** Sets the output width, in pixels.

**Height** Sets the output height, in pixels.

**Pixel Aspect** Sets the output pixel aspect ratio.

**Get Current Settings** Gets the current Width, Height, and Pixel Aspect settings from the Output Size group, and assigns them to the spinners on this dialog.

### Email Notifications Rollout

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Common panel > Email Notifications rollout

This rollout lets a rendering job send email notifications, as network rendering does. Such notifications can be useful when you launch a lengthy render, such as an animation, and don't care to spend all your time near the system doing the rendering.
Enable Notifications When on, the renderer sends an email notification when certain events happen. Default=off.

Categories group

Notify Progress Sends emails to indicate rendering progress. An email is sent every time the number of frames specified in Every Nth Frame has completed rendering. Default=off.

Every Nth Frame The number of frames used by Notify Progress. Default=1.

TIP If you turn on Notify Progress, almost certainly you want this value to be greater than the default!

Notify Failures Sends an email notification only if something occurs to prevent the completion of a rendering. Default=on.

Notify Completion Sends an email notification when a rendering job is complete. Default=off.

Email Options group

From Enter the email address of the person who initiates the rendering job.
To Enter the email address of the person who needs to know the rendering status.

SMTP Server Enter the numeric IP address of the system you use as a mail server.

**Scripts Rollout (Render Setup Dialog)**

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Common panel > Scripts rollout

The Scripts rollout lets you specify scripts to run before and after rendering.

The script to execute can be:

- A MAXScript file (MS)
- A macro script (MCR)
- A batch file (BAT)
- An executable file (EXE)

If relevant to its format, the script can have command-line arguments.

The pre-render script is executed before rendering (but after any other MAXScript scripts that are registered using the #preRender callback mechanism). The post-render script is executed after rendering has completed. You can also use the “Execute Now” buttons to run the scripts “by hand.”
Interface

Pre-Render group

Specifies a script to run before you render.

Enable When on, the script is enabled.

Execute Now Click to execute the script “by hand.”

File name field When a script is selected, this field shows its path and name. You can edit this field.

File Click to open a file dialog and choose the pre-render script to run.

Delete File Click to remove the script.

Execute Locally (Ignored by Network Rendering) When on, the script must run locally. If you use network rendering, the script is ignored. Default=off.

Post-Render group

Specifies a script to run after you render.

Enable When on, the script is enabled.

Execute Now Click to execute the script “by hand.”

File name field When a script is selected, this field shows its path and name. You can edit this field.
**Assign Renderer Rollout**

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Common panel > Assign Renderer rollout

The Assign Renderer rollout displays which renderers are assigned to the production and ActiveShade categories, as well as the sample slots in the Material Editor.

The Render flyout on the toolbar also lets you choose which renderer to use:

- The Render Production and Render Iterative buttons use the production renderer.

- The ActiveShade button uses the ActiveShade renderer.

These are the renderers that ship with 3ds Max:

- Default Scanline Renderer on page 6589
- mental ray Renderer on page 6675 (not available for ActiveShade)
- VUE File Renderer on page 6805 (not available for ActiveShade)

Additional renderers might be available if you’ve installed them as plug-ins.
Interface

For each rendering category, the rollout shows the name of the renderer currently assigned, and a button that lets you change the assignment.

Choose Renderer (“…”): Click the button with the ellipsis to change the renderer assignment. The button displays a Choose Renderer dialog on page 6584.

- **Production**: Chooses the renderer used to render graphic output.
- **Material Editor**: Chooses the renderer used to render sample slots on page 5650 in the Material Editor.
  
  By default, the sample slot renderer is locked to be the same as the production renderer. You can turn off the lock button to assign a different renderer for sample slots.

- **ActiveShade**: Chooses the ActiveShade on page 6550 renderer used to preview the effects of lighting and material changes in the scene. The only ActiveShade renderer that ships with 3ds Max is the default scanline renderer.

---

**Save as Defaults** Click to save the current renderer assignments as defaults, so they will be active the next time you restart 3ds Max.
Choose Renderer Dialog

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Common panel > Assign Renderer rollout > Click a Choose Renderer ("...") button.

This dialog appears when you click one of the Choose Renderer ("...") buttons on the Assign Renderer rollout on page 6582.

Procedures

To change the renderer assigned to the category you picked, do one of the following:

- Highlight another renderer's name in the list, and then click OK.
- Double-click another renderer's name in the list

Interface

![Choose Renderer dialog image]
The scrollable list shows the names of renderers that you can assign, exclusive of the renderer that is currently assigned to the rendering category you are reassigning.

**Renderers**

The topics in this section describe the renderers that are provided with 3ds Max, and the controls associated with them.

**Renderer Panel (Render Setup Dialog)**

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Renderer panel

The Render Setup dialog > Renderer panel contains the main controls for the active renderer. Depending on which renderer is active, additional panels can become available.

**TIP** The default scanline renderer on page 6589 and the mental ray renderer on page 6675 have different and unique capabilities. Based on these, you decide which renderer you want to use for each scene. It is a good idea to design materials with a particular renderer in mind. The mental ray Connection rollout on page 5763 lets you add features unique to the mental ray renderer to basic 3ds Max materials.
Interface

When the Default Scanline Renderer Is Active

The Renderer panel contains a single rollout:

Default Scanline Renderer Rollout on page 6589

Additional panels are:

- Advanced Lighting Panel on page 6600
- Raytracer Panel on page 6666
- Render Elements panel on page 6807
When the mental ray Renderer Is Active

The renderer panel contains these rollouts:

- **Sampling Quality Rollout (mental ray Renderer)** on page 6735
- **Rendering Algorithms Rollout (mental ray Renderer)** on page 6741
- **Camera Effects Rollout (mental ray Renderer)** on page 6747
- **Shadows & Displacement Rollout (mental ray Renderer)** on page 6756

Additional panels are:

- Indirect Illumination panel
  - **Caustics and Global Illumination Rollout (mental ray Renderer)** on page 6771
  - **Final Gather Rollout (mental ray Renderer)** on page 6760
  - **Reuse (FG and GI Caching) Rollout (mental ray Renderer)** on page 6778

- Processing panel
When the VUE File Renderer Is Active

The Renderer panel contains a single rollout:

VUE File Renderer on page 6805

Default Scanline Renderer

The topics in this section describe controls that are specific to the Default Scanline Renderer.
Default Scanline Renderer Rollout

Main toolbar/Rendering menu > Render Setup > Render Setup dialog > Assign
Renderer rollout > Choose Default Scanline Renderer as the production
renderer. > Renderer panel > Default Scanline Renderer rollout

This rollout sets parameters for the default scanline renderer on page 8709.

NOTE If your scene includes animated bitmaps (e.g., AVI files), including materials,
projector lights, environments, and so on, each animation file is reloaded once
per frame. If your scene uses multiple animations, or if the animations are
themselves large files, this reloading can hamper rendering performance. To
improve performance, use image sequences (each animation frame in a separate
image file) instead.

Environment Alpha Toggle and Filtering

To control whether or not the renderer uses the environment map's alpha
channel in creating the alpha for the rendered image, choose Customize >
Preferences > Rendering on page 8342, and then turn on Use Environment Alpha
in the Background group. If Use Environment Alpha is off (the default), the
background receives an alpha value of 0 (completely transparent). If Use
Environment Alpha is on, the alpha of the resulting image is a combination
of the scene and the background image's alpha channel. Also, when you render
to TGA files on page 7878 with premultiplied alpha on page 8690 turned off,
turning on Use Environment Alpha prevents incorrect results.

You can also control whether or not a background image is affected by the
renderer's antialiasing filter. Choose Customize > Preferences > Rendering,
and then turn on Filter Background in the Background group. Default=off.

TIP If you plan to composite 3ds Max objects in another program such as
Combustion or Photoshop, render the objects against a black background.
Otherwise, a fringe of environment or background color can appear around the
3ds Max objects.

Plate Match Filtering

This section describes the Plate Match/MAX R2 antialiasing filter (see
Antialiasing group on page 6593 for descriptions of other filtering options).

In versions of 3ds Max prior to R2.5, antialiasing affected only geometric
edges, with the filtering of bitmaps being controlled in the Bitmap Map
parameters (pyramidal, summed area, or no filtering). Current antialiasing
filters affect every aspect of the object, filtering textures along with geometric edges.

While the method used in R2.5 and subsequent versions provides superior results, this method also produces inconsistencies when rendering objects that are supposed to match the environment background, because the antialiasing filters do not affect the background by default (FilterBackground=0 in the [Renderer] section of the 3dsmax.ini on page 60 file or Customize menu > Preferences > Rendering tab > Background group > Filter Background). In order to correctly match an object’s map to an unfiltered background image, you need to use the Plate Match/MAX R2 filter so the texture is not affected by the antialiasing.

There are three ways you can render objects to blend seamlessly into a background environment:

- Assign a matte/shadow material on page 6099.
- Assign a 100% self-illuminated diffuse texture to an object using Camera Mapping on page 1180.
- Assign a 100% self-illuminated diffuse texture using Environment/Screen projection (see Coordinates Rollout (2D) on page 6201). Use Plate Match/MAX R2 antialiasing when you need to match foreground objects with an unfiltered background, or when you need to match the antialiasing qualities of the 3ds Max 2 renderer.

Procedures

To set up an object for motion blurring:

1. Select the object to blur.
2. Right-click the object, and then choose Properties from the quad menu. The Object Properties dialog is displayed.
3. In the Motion Blur group, click By Layer to change it to By Object. The other Motion Blur controls are now enabled.
4. In the Motion Blur group, choose either Object or Image.
5. If you chose Image, you can adjust the Multiplier spinner. This increases or decreases the length of the blurred object's streak.
6. Click OK.
To add motion blur when you render the animation:

1. Click Render Setup. The Render Setup dialog appears.

2. On the Default Scanline Renderer rollout, turn on Apply in the Object Motion Blur group or the Image Motion Blur group.
   ■ For Object Motion Blur, set Duration, Duration Subdivisions, and Samples.
   ■ Increase Duration to exaggerate the motion blur effect. Decrease it to make the blur more subtle.
   ■ If Samples is less than Duration Subdivisions, the slices used are selected randomly, giving a grainy look to the blur. If Samples equals Duration Subdivisions, the blur is smooth. The smoothest blur results from larger, equal values of these two parameters, but be aware that this can slow down rendering by a factor of three to four.
   ■ For Image Motion Blur, adjust Duration and Apply to Environment Map.
   ■ Increase Duration to exaggerate the streaking. Decrease it to make it more subtle.

3. Turn on Apply to Environment map to have camera orbit movement blur the environment map. This works only with Spherical, Cylindrical, or Shrink-Wrapped environments.

4. Set other rendering parameters, and then click Render.
Interface

Default Scanline Renderer

Options:
- Mapping
- Auto-Reflect/Refraction
- Shadows
- Noise Wipe
- Enable SSE
- Wire Thickness: [1.0]

Antialiasing:
- Antialiasing
- Filter: Area
- Filter Maps
  - Filter Size: [1.5]
  - Computes Antialiasing using a variable size area filter.

Global SuperSampling
- Disable all Samplers
- Enable Global Supersampling
  - Supersample Maps
  - Max 2.5 Star
  - 5 samples, star pattern

Object Motion Blur:
- Apply
  - Duration (frames): [0.5]
  - Samples: [10]
  - Duration Subdivisions: [10]

Image Motion Blur:
- Apply
  - Duration (frames): [0.5]
  - Transparency
  - Apply to Environment Map

Auto Reflect/Refract Maps
- Rendering Iterations: [1]
- Color Range Limiting
  - Clamp
  - Scale

Memory Management:
- Conserve Memory

6592 | Chapter 18  Rendering
Options group

**Mapping** Turn off to ignore all mapping information to speed up rendering for tests. Affects automatic reflections and environment maps as well as material mapping. Default=on.

**Auto Reflect/Refract and Mirrors** Ignores automatic reflection/refraction maps to speed up rendering for tests.

**Shadows** When off, cast shadows aren't rendered. This can speed up rendering for tests. Default=on.

**Force Wireframe** Set to render all surfaces in the scene as wireframes. You can choose the thickness of the wireframe in pixels. Default=1.

**Enable SSE** When on, rendering uses Streaming SIMD Extensions (SSE). (SIMD stands for Single Instruction, Multiple Data.) Depending on the CPU (or CPUs) of your system, SSE can improve render time. Default=off.

Antialiasing group

**Antialiasing** Antialiasing on page 8501 smoothes the jagged edges that occur along the edges of diagonal and curves lines when rendering. Turn off only when you are rendering test images and greater speed is more important than image quality.

Turning off Antialiasing disables the Force Wireframe setting. Geometry renders according to the material assigned it even if Force Wireframe is turned on.

Turning off Antialiasing also disables render elements on page 6807. If you need to render elements, be sure to leave Antialiasing on.

**Filter drop-down list** Lets you select a high-quality table-based filter to apply to your rendering. Filters are the last step in antialiasing. They work at the sub-pixel level and allow you to sharpen or soften your final output, depending on which filter you select. Below the controls in this group, 3ds Max displays a box with a brief description of the filter and how it is applied to your image.

---

**TIP** Render Region and Render Selected give reliable results only when rendered with the Area filter.
The following table describes the available antialiasing filters.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Area</td>
<td>Computes antialiasing using a variable-size area filter.</td>
</tr>
<tr>
<td></td>
<td>This is the original 3ds Max filter.</td>
</tr>
<tr>
<td>Blackman</td>
<td>A 25-pixel filter that is sharp, but without edge enhancement.</td>
</tr>
<tr>
<td>Blend</td>
<td>A blend between sharp area and Gaussian soften filters.</td>
</tr>
<tr>
<td>Catmull-Rom</td>
<td>A 25-pixel reconstruction filter with a slight edge-enhancement effect.</td>
</tr>
<tr>
<td>Cook Variable</td>
<td>A general-purpose filter. Values of 1 to 2.5 are sharp; higher values blur the image.</td>
</tr>
<tr>
<td>Cubic</td>
<td>A 25-pixel blurring filter based on a cubic spline.</td>
</tr>
<tr>
<td>Mitchell-Netravali</td>
<td>Two-parameter filter; a trade-off of blurring, ringing, and anisotropy. If the ringing value is set higher than .5 it will impact the alpha channel of the image.</td>
</tr>
<tr>
<td>Plate Match/MAX R2</td>
<td>Uses the 3ds Max 2 method (no map filtering) to match camera and screen maps or matte/shadow elements to an unfiltered background image. See the section “Plate Match Filtering,” above, for a discussion of how and why you might want to use this filter.</td>
</tr>
<tr>
<td>Quadratic</td>
<td>A 9-pixel blurring filter based on a quadratic spline.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Sharp Quadratic</td>
<td>A sharp nine-pixel reconstruction filter from Nelson Max.</td>
</tr>
<tr>
<td>Soften</td>
<td>An adjustable Gaussian softening filter for mild blurring.</td>
</tr>
<tr>
<td>Video</td>
<td>A 25-pixel blurring filter optimized for NTSC and PAL video applications.</td>
</tr>
</tbody>
</table>

Filter Maps Turns on or off the filtering of mapped materials. Default=on.

TIP Leave Filter Maps turned on unless you are making test renderings and want to speed up rendering time and save memory.

Filter Size Allows you to increase or decrease the amount of blur applied to an image. This option is available for only some of the Filter choices. Setting the Filter Size to 1.0 effectively disables the filter.

NOTE Some filters show additional, filter-specific parameters below the Filter Size control.

When you render separate elements on page 6807, you can explicitly enable or disable the active filter, on a per-element basis.

Global SuperSampling group

Disable all Samplers Disables all supersampling on page 8735. Default=off

NOTE SuperSampling settings are ignored by the mental ray Renderer on page 6675, which has its own sampling method.

Enable Global Supersampler When on, applies the same supersampler to all materials. When turned off, materials set to use the global settings are controlled by the settings appearing in rendering dialog. All other controls in the Global SuperSampling group of the rendering dialog will become disabled, except for the Disable All Samplers. Default=on.

Supersample Maps Turns on or off supersampling for mapped materials. Default=on.
TIP  Leave Supersample Maps on unless you are making test renderings and want to speed up rendering time and save memory.

**Sampler drop-down list**  Lets you choose which supersampling method to apply. Default=Max 2.5 Star.

The options for a supersampling method are the same as those that appear on the SuperSampling rollout on page 5759 in the Material Editor. Some methods offer expanded options that let you better control the quality of the supersampling and the number of samples taken during rendering.

**Object Motion Blur group**

You determine which objects have object motion blur on page 8658 applied to them by setting Object in the Motion Blur group of the Properties dialog for that object. Object motion blur blurs the object by creating multiple "time-slice" images of the object for each frame. It takes camera movement into account. Object motion blur is applied during the scanline rendering process.

**Apply**  Turns object motion blur on or off globally for the entire scene. Any objects that have their Object Motion Blur property set are rendered with motion blur.

**Duration**  Determines how long the "virtual shutter" is open. When this is set to 1.0, the virtual shutter is open for the entire duration between one frame and the next. Longer values produce more exaggerated effects.

The effect of changing duration.
Samples  Determines how many Duration Subdivision copies are sampled. The maximum setting is 32.
When Samples is less than Duration, random sampling within the duration occurs (which is why there might be a slight granular look to the motion blur). For example, if Duration Subdivision=12 and Samples=8, there are eight random samples out of 12 possible copies within each frame.
When Samples=Duration, there is no randomness (and if both numbers are at their maximum value (32), you get a dense result (which costs between 3–4 times the normal rendering time for that specific object). If you want to obtain a smooth blur effect, use the maximum settings of 32/32. If you want to cut down rendering time, values of 12/12 will give you much smoother results than 16/12.
Because sampling happens within the duration, the Duration value always has to be less than or equal to Samples.

Duration Subdivisions  Determines how many copies of each object are rendered within the Duration.

Left: Same value for Samples and Subdivisions.
Right: Samples value is less than Subdivisions.
Image Motion Blur group

You determine which objects have image motion blur on page 8606 applied to them by setting Image in the Motion Blur group of the Properties dialog for that object. Image motion blur blurs the object by creating a smearing effect rather than multiple images. It takes camera movement into account. Image motion blur is applied after scanline rendering is complete.

The coin on the right has Image Motion Blur applied

You can’t put image motion blur on objects that change their topology.

TIP When blurred objects overlap, sometimes blurring doesn’t work correctly and there are gaps in the rendering. Because image motion blur is applied after rendering, it can’t account for object overlap. To fix this problem, render each blurred object separately, to a different layer, and then composite the two layers using the Alpha Compositor in Video Post.
NOTE  Image motion blur doesn't work for NURBS objects that are animated so their tessellation (surface approximation on page 2737) changes over time. This happens when sub-objects are animated independently of the top-level NURBS model on page 8656. Nor does image motion blur work on any of the following:

- Anything with an Optimize.
- Any primitive with animated segments.
- MeshSmooth of any type with a "Smoothness" value (under iterations) other than 1.
- MeshSmooth on polygons with Keep Faces Convex on.
- Anything with Displacement Material.

In general, if you have objects with changing topology, use scene or object motion blur rather than image motion blur.

**Apply**  Turns image motion blur on or off globally for the entire scene. Any objects that have their Image Motion Blur property set are rendered with motion blur.

**Duration**  Specifies how long the "virtual shutter" is open. When this is set to 1.0, the virtual shutter is open for the entire duration between one frame and the next. The higher the value, the greater the motion blur effect.

**Apply to Environment Map**  When set, image motion blur is applied to the environment map as well as to the objects in the scene. The effect is noticeable when the camera orbits.

The environment map should use Environment mapping: Spherical, Cylindrical, or Shrink-Wrap. The image motion blur effect doesn't work with Screen-mapped environments.

**Transparency**  When on, image motion blur works correctly with transparent objects that overlap. Applying image motion blur to transparent objects can increase rendering time. Default=off.

**Auto Reflect/Refract Maps group**

**Rendering Iterations**  Sets the number of inter-object reflections in non-flat automatic reflection maps. Although increasing this value can sometimes enhance image quality, it also increases rendering time for reflections.
Color Range Limiting group

Color Range Limiting allows you handle over-brightness by toggling between either Clamping or Scaling color components (RGB) that are out of range (0 to 1). Typically, specular highlights can cause color components to rise above range while using filters with negative lobes can cause color components to be below range. You choose one of two options to control how the renderer handles out of range color components:

- **Clamp**  To keep all color components in range Clamp will change any color with a value greater than 1 down to 1 while any color below 0 will be clamped at 0. Any value between 0 and 1 will not change. Very bright colors tend to render as white when using Clamp since hue information can be lost in the process.

- **Scale**  To keep all color components in range Scale will preserve the hue of very bright colors by scaling all three color components so that the maximum component has a value of 1. Be aware that this will change the look of highlights.

Memory Management group

Conserve Memory When on, rendering uses less memory at a slight cost of memory time. Memory saved is in the range of 15 to 25 percent. The time cost is about four percent. Default=off.

Advanced Lighting Panel

Rendering menu > Render Setup > Render Setup dialog > Assign Renderer rollout > Set Production to Default Scanline Renderer. > Advanced Lighting panel > Select Advanced Lighting rollout

Main toolbar > Render Setup > Render Setup dialog > Assign Renderer rollout > Set Production to Default Scanline Renderer. > Advanced Lighting panel > Select Advanced Lighting rollout

The Advanced Lighting rollout lets you select one of the advanced lighting options that accompany the default scanline renderer on page 6589: either the Light Tracer on page 6601 or Radiosity on page 6615.

The Light Tracer provides soft-edged shadows and color bleeding for brightly-lit scenes such as outdoor scenes. Radiosity provides physically accurate modeling of the light in a scene.
**Interface**

Until you choose an advanced lighting option, the Advanced Lighting panel displays a single rollout, Select Advanced Lighting.

**List of plug-ins** Choose an advanced lighting option from this drop-down list. Default=No advanced lighting chosen.

**Active** When an advanced lighting option is chosen, use Active to toggle whether the advanced lighting is used when you render your scene. Default=On.

**Light Tracer**

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Choose Default Scanline Renderer as the active production renderer. > Advanced Lighting panel > Select Advanced Lighting rollout > Choose Light Tracer from the drop-down list.

The Light Tracer provides soft-edged shadows and color bleeding for brightly-lit scenes such as outdoor scenes. It is typically used in conjunction with a Skylight on page 5412. Unlike radiosity on page 6615, the Light Tracer does not attempt to create a physically accurate model, and can be easier to set up.
Outdoor scene lit by Skylight and rendered with light tracing
Character lit by Skylight and one spotlight, and rendered with light tracing
Model by Sonny Sy — orange_3D@yahoo.com — www.geocities.com/orange_3D
**TIP** While you can use light tracing for indoor scenes, radiosity is usually the better choice in such cases.

**Previewing the Effect of Light Tracing**

- To get a quick preview of the effect the Light Tracer will have, lower the values of Rays/Sample and Filter Size. The result will be a grainy version of the full effect.
- Another way to get a quick preview is to make sure Adaptive Undersampling is turned on. In this group, set the Initial Sample Spacing sampling and the Subdivide Down To setting to the same value. In the General Settings group, lower the value of Rays/Sample, and set Bounces equal to 0.0. This gives a rather blotchy but fast preview of the rendering. Increase the Rays/Sample and Filter Size values to improve the image quality. In general, you can get good, fairly quick results with a lower Filter Size value as long as Rays/Sample has a high value and Adaptive Undersampling is on.

**Other Tips for Using the Light Tracer**

- To improve rendering time, use the Object Properties dialog on page 283 to disable light tracing (or radiosity solving) for objects that don't have a great impact on the final effect.
  
  **TIP** You can also use the Advanced Lighting Override material on page 6166 to alter the effect of light tracing on particular objects. For example, if you encounter visual artefacts with a bump-mapped material, convert it to an Advanced Lighting Override material and reduce the Indirect Light Bump Scale value.

- Experiment with the Adaptive Undersampling group settings, which restrict light tracing to the areas of your scene that need it.
- To increase the amount of color bleeding, increase the values of both Bounces and Color Bleed. Color bleeding is usually a subtle effect.
- If there are glass objects in the scene, increase the Bounces value to an amount greater than 0. But be aware that this increases rendering time.
- If the main scene lighting is a Skylight on page 5412, and you need specular highlights in your scene, add a second light: for example, a Directional light that parallels the Skylight. Make sure Shadows are turned on for this
light, and on the light's Advanced Effects rollout on page 5457, turn off Diffuse.
If the objects with highlights don't greatly affect shadows or color bleeding, you can leave Diffuse on for this light, and use Object Properties to exclude the objects from light tracing.

- Set Key filters are not taken into account when you animate Light Tracer settings. If you wish to use Set Key to create keys for animating the Light Tracer parameters, Shift+right-click the spinner to create those keys.

**IMPORTANT** If you use a texture map with the Skylight, you should use an image-processing program to thoroughly blur the map before using it. This helps reduce variance and the number of rays needed for light tracing. You can blur the map beyond recognition, and it will still look correct when used for regathering.

### Procedures

**To set up a scene for the Light Tracer:**

This is a typical use case:

1. Create the geometry for an outdoor scene.
2. Add a Skylight on page 5412 to illuminate it.
   One or more spotlights can also work well. If you use the physically based IES Sun or IES Sky lights, using an exposure control on page 7207 is essential.
   This opens the Render Setup dialog to the Advanced Lighting panel and activates Light Tracer.
4. Adjust the Light Tracer parameters, activate the viewport to render, and then activate the Common panel.
5. Adjust your rendering settings, and then click the Render button at the bottom of the dialog.
   The scene renders with soft-edged shadows and color bleeding.
**Interface**

**General Settings group**

**Global Multiplier** Controls the overall lighting level. Default=1.0.
Object Multiplier  Controls the level of light reflected by objects in the scene. Default=1.0.

NOTE  This setting has little effect unless Bounces is greater than or equal to 2.

Sky Lights [toggle]  When on, enables regathering from the Skylights in the scene. (A scene can contain more than one Skylight.) Default=on.

Sky Lights [amount]  Scales the intensity of the Skylights. Default=1.0.

Color Bleed  Controls the strength of color bleeding. Color bleeding results when light is interreflected among scene objects. Default=1.0.
NOTE  This setting has little effect unless Bounces is greater than or equal to 2.

Above: Excessive color bleeding
Below: Color bleeding eliminated by setting Color Bleed to 0.0

Rays/Sample  The number of rays cast per sample (or pixel). Increasing this value increases the smoothness of the effect, at a cost of render time. Decreasing this value results in a grainier effect, but renders more quickly. Default=250.

TIP  To get a “first draft” preview of the effect of light tracing, reduce the value of Rays/Sample and the Filter Size.
Changing the number of rays per sample
The higher the value, the less grain

**Color Filter** Filters all light falling on objects. Set to a color other than white to tint the overall effect. Default=white.

**Filter Size** The size, in pixels, of the filter used to reduce noise in the effect. Default=0.5.

**TIP** Filter Size is especially useful when Adaptive Undersampling is turned off, and Rays/Sample has a low value.
Changing the Filter Size value

Increasing Filter Size reduces noise in the rendering.

**Extra Ambient** When set to a color other than black, adds that color as extra ambient light on objects. Default=black.

**Ray Bias** Ray Bias, like **Shadow Bias** on page 8718, adjusts the positioning of the bounced light effects. Use it to correct rendering artifacts, such as the banding that can occur when an object casts shadows on itself. Default=0.03.

**Bounces** The number of light-ray bounces that are traced. Increasing this value increases the amount of color bleeding. Lower values give faster results with less accuracy, and typically produce darker images. Higher values allow more light to flow through the scene, resulting in brighter, more accurate images at a cost of rendering time. Default=0.

When Bounces equals 0, the Light Tracer disregards volumetric lighting.

---

**TIP** If your scene has transparent objects such as glass, increase Bounces to be greater than zero. Be aware that this increases rendering time.
Increasing the number of bounces increases the level of global illumination and the amount of color bleeding in the rendering.

Cone Angle Controls the angle used for regathering. Reducing this value can result in slightly higher contrast, especially in regions where lots of small geometry casts shadows on a larger structure. Range=33.0 to 90.0. Default=88.0.

All rays initially cast are limited by the cone angle

Volumes [toggle] When on, the Light Tracer regathers light from volumetric lighting effects such as Volume Light on page 7196 and Volume Fog on page 7188. Default=on.
For volumetric lighting to work with light tracing, Bounces must be greater than 0.
Volumes [amount] Multiplies the amount of light regathered from volumetric lighting effects. Increase to increase their impact on the rendered scene, decrease to decrease their effect. Default=1.0.

Increasing the Volumes value increases the effect of volumetric lighting in the rendering.

Adaptive Undersampling group

These controls can help you speed up rendering time. They reduce the number of light samples taken. The ideal settings for undersampling vary greatly from scene to scene.

Undersampling initially takes samples from a grid superimposed on the pixels of the scene. Where there is enough contrast between samples, it subdivides that region and takes further samples, down to the minimum area specified by Subdivide Down To. Lighting for areas not directly sampled is interpolated.
Initial sampling uses a regular grid.

Adaptive undersampling concentrates on transition areas.

**TIP** If you use adaptive undersampling, try adjusting the Subdivision Contrast value to obtain the best results. The effect of this control depends on the value of Rays/Sample.
Adaptive Undersampling When on, the Light Tracer uses undersampling. When off, it samples every pixel. Turning this off can increase the detail of the final rendering, but at a cost of rendering time. Default=on.

Initial Sample Spacing The grid spacing for the initial samples of the image. This is measured in pixels. Default=16x16.

![Initial sample spacing values](image)

Subdivision Contrast The contrast threshold that determines when a region should be further subdivided. Increasing this value causes less subdividing to occur. Too low a value can cause unnecessary subdividing. Default=5.0.

![Subdivision Contrast](image)

Decreasing the subdivision contrast threshold can reduce noise in soft shadows and bounced lighting.

Subdivide Down To The minimum spacing for a subdivision. Increasing this value can improve render time at a cost of accuracy. Default=1x1.

Depending on the scene geometry, grids larger than 1x1 might still be subdivided below this specified threshold.
**Show Samples** When on, sample locations render as red dots. This shows where the most sampling has taken place, which can help you choose the optimal settings for undersampling. Default=off.

**Modeling Global Illumination with Radiosity**

Radiosity is rendering technology that realistically simulates the way in which light interacts in an environment.

This topic provides you with a conceptual overview of what radiosity is and how this global illumination technique relates to other rendering techniques available in 3ds Max. This information will help you decide which technique is most suitable for the visualization task you want to perform. By more accurately simulating the lighting in your scene, radiosity offers you significant benefits over standard lights:

- **Improved Image Quality**: The radiosity technology of 3ds Max produces more accurate photometric simulations of the lighting in your scenes. Effects such as indirect light, soft shadows, and color bleeding between surfaces produce images of natural realism that are not attainable with standard scanline rendering. These images give you a better, more predictable representation of what your designs will look like under specific lighting conditions.

- **More Intuitive Lighting**: In conjunction with radiosity techniques, 3ds Max also provides a real-world lighting interface. Instead of specifying lighting intensity with arbitrary values, light intensity is specified using photometric units (lumens, candelas, and so on). In addition, the characteristics of real-world lighting fixtures can be defined using industry-standard Luminous Intensity Distribution files (such as IES on page 5376, CIBSE on page 8532, and LTLI on page 8625), which are obtainable from most lighting manufacturers. By being able to work with a real-world lighting interface, you can intuitively set up the lighting in your scenes. You can focus more on your design exploration than on the computer graphic techniques required to visualize them accurately.
Top: A scene rendered without radiosity.

Bottom: The same scene rendered with radiosity.
Computer Graphics Rendering

The 3D models created in 3ds Max contain geometric data defined in relationship to a 3D Cartesian coordinate system, referred to as *world space* on page 8769. The model also contains other information about the material of each of the objects and the lighting in the scene. The image on a computer monitor is made up of many illuminated dots, called *pixels* on page 8687. The task in creating a computer graphics image of a geometric model is to determine the color for each pixel based on the model information and a specific viewpoint (camera).

The color of any specific point on a surface in a model is a function of the physical material properties of that surface and the light that illuminates it. Two general shading algorithms: *local illumination* and *global illumination* are used to describe how surfaces reflect and transmit light.

Local Illumination

Local illumination algorithms describe only how individual surfaces reflect or transmit light. Given a description of light arriving at a surface, these mathematical algorithms, called *shaders* in 3ds Max, predict the intensity, color, and distribution of the light leaving that surface. In conjunction with a material description, different shaders will determine, for example, if a surface will appear like plastic or metal or if it will appear smooth or rough. 3ds Max provides a robust interface for defining a wide array of different surface materials.

After defining how an individual surface interacts with light at the local level, the next task is to determine where the light arriving at the surface originates. With the standard *scanline rendering system* on page 8709 of 3ds Max, only the light coming directly from the light sources themselves is considered in the shading.

For more accurate images, however, it is important to take into account not only the light sources, but also how all the surfaces and objects in the environment interact with the light. For example, some surfaces block light, casting shadows on other surfaces; some surfaces are shiny, in which case we see in them the reflections of other surfaces; some surfaces are transparent, in which case we see other surfaces through them; and some surfaces reflect light onto other surfaces.

Global Illumination

Rendering algorithms that take into account the ways in which light is transferred between surfaces in the model are called *global illumination*.
algorithms. 3ds Max offers two global illumination algorithms as an integral part of its production rendering system: ray-tracing and radiosity.

Before an explanation of how ray-tracing and radiosity work, it’s useful to understand how light is distributed in the physical world. Consider, for example, the room shown in the illustration below.

This kitchen above has two light sources. One theory of light considers the light in terms of discrete particles called photons, that travel from the light source until they encounter some surface in the kitchen. Depending on the surface material, some of these photons are absorbed and others are scattered back out into the environment. The fact that photons traveling at a particular wavelength are absorbed while others are not is what determines the color of the surface.

Surfaces that are very smooth reflect the photons in one direction, at an angle equal to the angle at which they arrive at the surface, the angle of incidence. These surfaces are known as specular surfaces, and this type of reflection is known as specular reflection. A mirror is an example of a perfectly specular surface. Of course, many materials display some degree of both specular and diffuse reflection.
The way in which the photons are reflected from a surface depends primarily on the smoothness of the surface. Rough surfaces tend to reflect photons in all directions. These are known as diffuse surfaces, and this type of reflection is known as diffuse reflection (shown above). A wall painted with flat paint is a good example of a diffuse surface.

The final illumination of the kitchen is determined by the interaction between the surfaces and the billions of photons emitted from the light source. At any given point on a surface, it is possible that photons have arrived directly from the light source (direct illumination) or else indirectly through one or more bounces off other surfaces (indirect illumination). If you were standing in the kitchen, a very small number of the photons in the room would enter your eye and stimulate the rods and cones of your retina. This stimulation would, in effect, form an image that is perceived by your brain.

In computer graphics we replace the rods and cones of a retina with the pixels of the computer screen. One goal of a global illumination algorithm is to re-create, as accurately as possible, what you would see if you were standing in a real environment. A second goal is to accomplish this task as quickly as
Ray-Tracing

One of the first global illumination algorithms developed is known as ray-tracing. The ray-tracing algorithm recognizes that although billions of photons may be traveling about the room, the photons we primarily care about are the ones that enter the eye. The algorithm works by tracing rays backward, from each pixel on the screen into the 3D model. In this way, we compute only the information needed to construct the image. To create an image using ray-tracing, the following procedure is performed for each pixel on the computer screen.

1. A ray is traced back from the eye position, through the pixel on the monitor, until it intersects with a surface. We know the reflectivity of the surface from the material description, but we do not yet know the amount of light reaching that surface.

2. To determine the total illumination, we trace a ray from the point of intersection to each light source in the environment (shadow ray). If the ray to a light source is not blocked by another object, the light contribution from that source is used to calculate the color of the surface.

3. If an intersected surface is shiny or transparent, we also have to determine what is seen in or through the surface being processed. Steps 1 and 2 are repeated in the reflected (and, in the case of transparency, transmitted) direction until another surface is encountered. The color at the subsequent intersection point is calculated and factored into the original point.

4. If the second surface is also reflective or transparent, the ray-tracing process repeats, and so on until a maximum number of iterations is reached or until no more surfaces are intersected.
Ray-tracing: Rays are traced from the camera through a pixel, to the geometry, then back to their light sources.

The ray-tracing algorithm is very versatile because of the large range of lighting effects it can model. It can accurately account for the global illumination characteristics of direct illumination, shadows, specular reflections (for example, mirrors), and refraction through transparent materials. The main disadvantage of ray-tracing is that it can be very slow for environments of even moderate complexity. In 3ds Max, ray-tracing is used selectively on objects with ray-trace materials on page 6064 that specify ray-tracing as their shading option. Ray-tracing can also be specified for light sources as the method for rendering the shadows they cast.

A significant disadvantage of both ray-tracing and scanline rendering is that these techniques do not account for one very important characteristic of global illumination, diffuse inter-reflections. With traditional ray-tracing and scanline rendering, only the light arriving directly from the light sources themselves is accurately accounted for. But, as shown in the room example, not only does light arrive at a surface from the light sources (direct lighting), it also arrives from other surfaces (indirect lighting). If we were to ray-trace an image of the kitchen, for example, the areas in shadow would appear black because they
receive no direct light from the light sources. We know from experience, however, that these areas would not be completely dark because of the light they would receive from the surrounding walls and floor.

In scanline rendering and traditional ray-tracing (versions of 3ds Max prior to v5), this indirect illumination is usually accounted for simply by adding an arbitrary *ambient light* value that has no correlation to the physical phenomena of indirect illumination and is constant throughout space. For this reason, scanline and ray-traced images can often appear very flat, particularly renderings of architectural environments, which typically contain mostly diffuse surfaces.

**Radiosity**

To address this issue, researchers began investigating alternative techniques for calculating global illumination, drawing on thermal engineering research. In the early 1960s, engineers developed methods for simulating the radiative heat transfer between surfaces to determine how their designs would perform in applications such as furnaces and engines. In the mid-1980s, computer graphics researchers began investigating the application of these techniques for simulating light propagation.

Radiosity, as this technique is called in the computer graphics world, differs fundamentally from ray-tracing. Rather than determining the color for each pixel on a screen, radiosity calculates the intensity for all surfaces in the environment. This is accomplished by first dividing the original surfaces into a mesh of smaller surfaces known as *elements*. The radiosity algorithm calculates the amount of light distributed from each mesh element to every other mesh element. The final radiosity values are stored for each element of the mesh.
Radiosity: A ray of light that hits a surface is reflected by multiple diffuse rays, which can themselves illuminate other surfaces. Surfaces are subdivided to increase accuracy of the solution.

In early versions of the radiosity algorithm, the distribution of light among mesh elements had to be completely calculated before any useful results could be displayed on the screen. Even though the result was view-independent, the preprocessing took a considerable amount of time. In 1988, progressive refinement was invented. This technique displays immediate visual results that can progressively improve in accuracy and visual quality. In 1999, the technique called stochastic relaxation radiosity (SRR) was invented. The SRR algorithm forms the basis of the commercial radiosity systems provided by Autodesk.
An Integrated Solution

Although the ray-tracing and radiosity algorithms are very different, they are in many ways complementary. Each technique has advantages and disadvantages.

<table>
<thead>
<tr>
<th>Lighting Algorithm</th>
<th>Advantages</th>
<th>Disadvantages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ray-Tracing</td>
<td>Accurately renders direct illumination, shadows, specular reflections, and transparency effects. Memory Efficient</td>
<td>Computationally expensive. The time required to produce an image is greatly affected by the number of light sources. Process must be repeated for each transparency effect.</td>
</tr>
<tr>
<td>Radiosity</td>
<td>Calculates diffuse interreflections between surfaces. Provides view independent solutions for fast display of arbitrary views. Offers immediate visual results.</td>
<td>3D mesh requires more memory than the original surfaces. Surface sampling algorithm is more susceptible to imaging artifacts than ray-tracing. Doesn’t account for specular reflections or transparency effects.</td>
</tr>
</tbody>
</table>

Neither radiosity nor ray-tracing offers a complete solution for simulating all global illumination effects. Radiosity excels at rendering diffuse-to-diffuse inter-reflections, and ray-tracing excels at rendering specular reflections. By integrating both techniques with a production quality scanline rendering system, 3ds Max offers the best of both worlds. After you create a radiosity
solution, you can render a two-dimensional view of it. In your 3ds Max scene, ray-tracing adds effects in addition to those that radiosity provides: lights can provide ray-traced shadows, and materials can provide ray-traced reflections and refractions. The rendered scene combines both techniques, and appears more realistic than either technique alone could provide.

By integrating ray-tracing and radiosity, 3ds Max offers a full range of visualization possibilities, from fast, interactive lighting studies to images of exceptional quality and realism.

See also:

- Radiosity Preferences on page 8362
- Advanced Lighting Override Material on page 6166

How Radiosity Works in 3ds Max

This topic provides an overview of how radiosity works in 3ds Max.

These are the overall steps:

1. Object by object, 3ds Max loads a copy of the scene into the radiosity engine.

2. 3ds Max subdivides each object according to the Global Subdivision Settings in the Radiosity Meshing Parameters rollout, or according to the object's individual object properties, if those differ from the global settings.

3. 3ds Max emits a certain amount of rays, based on the average scene reflectance and number of polygons. The brightest light source will have more rays to emit than the weakest light source.

4. These rays bounce around randomly in the scene and deposit energy on the faces.

5. 3ds Max updates the viewports by taking all the energy from the faces and spreading it to the closest vertex.

See the section that follows, “Refinement Steps for Radiosity,” for a more detailed description of the solution process.
**Refinement Steps for Radiosity**

The radiosity process involves three stages of increasing refinement. The first two stages occur during the primary radiosity processing, and the third stage can be used during the final rendering.

Within each of the first two stages, you can stop and start the processing at any time. This can be useful for evaluating interim results or increasing the level of accuracy you desire. For example, you can interrupt the Initial Quality stage at 50% and jump ahead to the Refine stage if you wish. However, once you enter the Refine stage, you cannot continue further iterations of Initial Quality unless you restart the solution.

The stages of a radiosity solution are Initial Quality, Refine, and then Regathering.

1. Initial Quality
In the Initial Quality stage, the distribution of diffuse lighting in the scene is calculated by essentially mimicking the behavior of real photons. Rather than tracing the path of an essentially infinite number of photons, statistical methods are used to choose a much smaller set of “photon rays” whose distribution in space is representative of the actual distribution. As with any statistical sampling process, the greater the number of rays used in the approximation, the greater the accuracy of the solution. During the initial quality stage, the overall appearance of the lighting level of the scene is established. The results can be interactively displayed in shaded viewports.

The initial quality stage performs repeated passes, which are shown in the dialog’s progress bar.

2 Refine Iterations (All Objects) and Refine Iterations (Selected Objects)

Because of the random nature of the sampling during the initial quality stage, some of the smaller surfaces or mesh elements in the scene might miss being hit by enough rays (or any rays at all). These small surfaces remain dark, and result in the appearance of “variance” or dark spots. To alleviate these artifacts, the Refine stage “regathers light” at every surface element.

You can perform the Refine stage for the entire scene, or for selected objects in the scene.

3 Regathering

Even after the Refine stage, it is still possible for visual artifacts to appear in a scene because of the topology of the original model. These artifacts sometimes appear as shadow or light “leaks.” To eliminate even these model-based artifacts, a third, optional refinement stage known as Pixel Regathering occurs at the time of image rendering. This involves a final “regather” process for each pixel of the image. Regathering can add a considerable amount of time to the rendering of a final image, but it also produces the most detailed and artifact-free images possible.

One benefit of using Regathering is that it means the initial modeling and mesh resolution don’t need to be nearly as “refined” or “tight” as would otherwise be required.

**Radiosity Workflows**

This topic describes how to set up a scene for use with radiosity.
Set Units Correctly Before Processing Radiosity

For imported geometry, you must make sure that units are consistent in your scene before processing radiosity (for example, a wall is 8 feet high, not 8 kilometers high). Units in 3ds Max must match the units of the model because the radiosity engine always uses an inverse square falloff for lights. Therefore, distance is crucial.

To make sure your units are setup correctly, use the Units Setup dialog on page 8366. The Scene Unit is the most important unit in this dialog. This is the unit that 3ds Max uses for its calculations. The Display Unit is just a tool that lets you customize how units are displayed in the user interface.

The following two scenarios show how to set unit scales after importing geometry that has been created using different units than what is currently set in 3ds Max:

Example 1: You import a table that was created in AutoCAD using metric scale. The table is 9 units long, which corresponds to an actual length of 90 centimeters. When the table is imported into 3ds Max, it will measure 9 scene units. Therefore, in the Units Setup dialog, you must set Scene Unit Scale to 1 Unit=10 centimeters. Your table is now the correct units because it is 90 centimeters long in 3ds Max model.

Example 2: You have an AutoCAD model that was created using Architectural Units. The model is a room measuring 20'-4” long. In AutoCAD, Architectural Units are stored as inches. Therefore, before importing the model to 3ds Max, make sure to set the Scene Unit Scale to 1 Unit=1 inch. Once imported to 3ds Max, the room will measure 244 units long (20'*12+4”).

**TIP** Use the Measure Distance tool on page 2881 to quickly check dimensions in 3ds Max.

Physically Based Workflow

Use radiosity on page 6615 to create physically based lighting simulations. When doing so, keep in mind the following:

- **Scene dimensions**: Make sure your scenes are accurately dimensioned, with consistent units (a light bulb in a room 120 meters high would look a lot different than it would in a room 120 inches high).

- **Lights**: You should work exclusively with Photometric lights on page 5348. You should also make sure that the light intensities are within a normal range.
Natural Lighting: To simulate natural light, you should only use IES sun on page 5506 and IES Sky on page 5509. These provide accurate photometric representations of sunlight and skylight based on a specified location, date and time.

Material Reflectance: You should ensure that the materials you use in your scene have a reflectance value on page 5669 within the range of the physical materials they represent. For example, a painted white wall should have a maximum reflectance of approximately 80%; however, a pure white color material (RGB:255, 255, 255) would have a reflectance of 100%. This means that the material reflects 100% of the energy received.

Exposure Control: The exposure control is the equivalent of the aperture of a camera. Make sure you enable the exposure control and set a value that provides the final results you desire.

To process radiosity for photometric lights using a physically based workflow:

1. Ensure that your geometry is set to a physically correct scale and that the materials have valid reflectance values.

2. Place photometric lights in your scene. The benefit of this workflow is that it allows you to place lights in your scene the same way you would in the real world. You can create new photometric lights or, using the asset browser on page 7614, drag and drop preset luminaire objects on page 271 from the included library. You can also refer to Common Lamp Values on page 5357.

3. Choose Rendering > Environment to display the Environment panel on page 7163. Select the type of exposure control you want to use (typically Logarithmic on page 7215).

4. To preview the lighting, click Render. At this stage, no processing of radiosity occurs, but you can quickly confirm that the direct lighting is correct. If you like, adjust the position of the lights.

5. Choose Rendering > Advanced Lighting > Radiosity, and then confirm any alerts that appear. On the Select Advanced Lighting rollout, make sure Active is on.

6. To process radiosity, on the Radiosity Processing Parameters rollout, click Start.
Once the Radiosity calculation has been completed, you should see your results in the viewports. The light levels are stored with the geometry and you can navigate the model interactively without reprocessing the scene.

Click Render again.

The renderer calculates the direct lighting and shadows and then integrates the radiosity solution (indirect lighting) as a modulated ambient light.

**Lighting Analysis**

After you generate a radiosity solution, you can use the Lighting Analysis tool on page 6664 to analyze the lighting levels in your scene. This dialog provides data on material reflectance, transmittance, and luminance.

You can also visualize the light levels in the scene interactively with the Pseudo Color Exposure Control on page 7228. Rendering to the Rendered Frame Window displays an additional rendered frame with a legend below the image. The legend correlates lighting levels and color values.

If you need to generate a lighting report, you can use the Lighting Data Exporter utility on page 7234 to export the luminance and illuminance data to a 32-bit LogLUV TIFF file on page 7880 or a pair of PIC files on page 7861 (one each for luminance and illuminance).

**NOTE** To obtain the most accurate quantitative analysis of lighting levels, avoid using colored materials and diffuse maps.

**Non-Physically Based Workflow**

You don’t necessarily have to work with physically based lights and materials in order to incorporate radiosity effects into your renderings. But there are a number of issues that you need to consider:

- **Lights:** Because the radiosity engine is physically based, the engine interprets Standard lights on page 5398 as Photometric lights on page 5348. For example, a Standard Spot light with a multiplier value of 1.0 is translated as a Physically Based Spot light with an intensity value of 1500 candelas (default value). This translation value corresponds to the Physical Scale value in the various exposure controls.
In addition, if your Standard lights use custom attenuation settings (for example, no attenuation, manual attenuation, or linear decay), the radiosity engine always solves for these lights using inverse square attenuation, which is physically correct. This means that the amount of energy that bounces between surfaces might not be equivalent to the way the Standard lights render.

- **Natural Lighting:** To simulate natural lighting without using the physically based workflow described above, you can use only a Direct Light on page 5405 for the Sun and Skylight on page 5412 to produce skylight on page 8723.

- **Exposure Control:** Standard lights are not physically based, so use the Logarithmic Exposure Control on page 7215 for the radiosity solution. Be sure to turn on Affect Indirect Only. The Brightness and Contrast controls of the exposure control will affect only the radiosity solution and your lights will render as usual.

**To process radiosity with standard lighting:**

1. Ensure that your geometry is set to a physically correct scale.

2. On the Create panel, click Lights. Create and position standard lights on page 5398 in your scene.

3. To preview the lighting, click Render.
   
   At this stage, the radiosity is not processed, but you can quickly confirm that the direct lighting is correct. Adjust the position of the lights if desired.


5. To process radiosity, on the Radiosity Processing Parameters rollout, click Start. Once the Radiosity calculation has been completed, you should see your results in the viewports.

6. To display the Environment panel on page 7163, where you set exposure controls, in the Interactive Tools group of the Radiosity Processing Parameters rollout, click Setup.
When working with non-physically based lights, always use the Logarithmic Exposure Control on page 7215. On the Logarithmic Exposure Control Parameters rollout, turn on Affect Indirect Only. This causes the exposure control to affect only the results of the radiosity solution. This way you maintain the way your direct lights render without radiosity. Use the Brightness and Contrast controls of the exposure control to adjust the intensity of the radiosity solution to match the lighting at an appropriate level.

**TIP** You can use the thumbnail preview to adjust brightness and contrast interactively.

To render the scene after radiosity processing, click Render.

**Summary**

The following table is designed to help you obtain good results with radiosity.

<table>
<thead>
<tr>
<th>Lights</th>
<th>Physically Based Workflow</th>
<th>Non-Physically Based Workflow</th>
</tr>
</thead>
<tbody>
<tr>
<td>Photometric Lights</td>
<td>Standard Lights on page 5398</td>
<td></td>
</tr>
<tr>
<td>IES Sun on page 5506 and IES Sky on page 5509</td>
<td>Directional Light on page 5405 and Skylight on page 5412</td>
<td></td>
</tr>
<tr>
<td>Any</td>
<td>Logarithmic on page 7215 – turn on Affect Indirect Only.</td>
<td></td>
</tr>
</tbody>
</table>

| Units                  | Make sure your scene is set to the appropriate scale. | Make sure your scene is set to the appropriate scale. |
Animation with Radiosity

By default, a radiosity solution on page 6615 is calculated at the current frame. If you are animating objects and you want to perform a radiosity solution at every frame, turn on Compute Advanced Lighting When Required in the Render Setup dialog > Common panel > Common Parameters rollout on page 6568 > Advanced Lighting group.

Once the renderer starts processing each frame of your animation, it computes the radiosity solution for each frame as required. This occurs, for example, when an object moves or a light intensity changes. If nothing changes in the scene from one frame to the next, the radiosity engine does not recalculate the solution.

NOTE Due to the random statistical sampling used by the radiosity engine, there might be some flickering between frames. If this occurs, increase the value of Initial Quality or the number of Refine Iterations to solve the problem.

TIP Before launching a lengthy animation with radiosity, process a radiosity solution manually for a single frame to make sure the results are acceptable.

TIP If you animate only the camera as in an architectural walkthrough, you can save time by calculating a radiosity solution for only the first frame of the animation. You can then reuse it in all subsequently rendered frames by turning off Compute Advanced Lighting When Required on the Common Parameters rollout of the Render Setup dialog.

Avoid using the Automatic Exposure Control on page 7210 for animations. This exposure control can change from frame to frame, creating a flickering effect.

Object Animation

The radiosity solution is calculated for each frame if any object is animated in the scene (the default is to calculate the current frame only). You specify the parameters (goals/quality) you want to reach on the Advanced Lighting panel. Before rendering the entire animation, we recommend first running a solution to verify that it's successful. These parameters are then reprocessed for each frame.

You go to the Render Setup dialog > Common Parameters rollout and enable the option Compute Advanced Lighting When Required, and then render the scene. The radiosity is processed for the first frame and then rendered. 3ds Max then moves to the next frame, processes radiosity, renders, and so on.
Camera Animation

If objects remain static in the scene and only the camera moves, you can solve radiosity at frame 0, and when you render the animation, turn off Compute Advanced Lighting When Required.

Radiosity Controls

Render Setup dialog > Choose Default Scanline Renderer as the production renderer. > Advanced Lighting panel > Choose Radiosity.

Rendering menu > Advanced Lighting > Radiosity > Render Setup dialog > Advanced Lighting panel > Radiosity is chosen.

Radiosity is a technique to calculate indirect light. Specifically, radiosity calculates the interreflections of diffuse light among all the surfaces in a scene. To make this calculation, radiosity takes into account the lighting, materials, and environment settings in the scene.

Radiosity processing is distinct from the rendering process. You can render without radiosity. However, to render with radiosity, you must calculate radiosity first.

Once a radiosity solution for a scene exists, you can use it in multiple renderings, including multiple frames of an animation. If the scene contains moving objects, radiosity might need to be recalculated; see Animation with Radiosity on page 6633.

For an overview of radiosity and how radiosity works in 3ds Max, see Radiosity Solution on page 6615.

For suggestions regarding workflow for using radiosity, see Radiosity Workflows on page 6627.

NOTE Radiosity is a method for global illumination.

IMPORTANT If the dimensions of your scene are not realistic, then radiosity cannot show realistic lighting.

See also:

- Modeling Global Illumination with Radiosity on page 6615
- How Radiosity Works in 3ds Max on page 6625
Procedures

To set units correctly:

Follow these steps if your scene does not already use real-world units.

1. Right-click 3D Snap Toggle and on the Snaps panel, turn off all the settings. Then turn on Vertex to enable vertex snapping. Close the dialog.

2. Use Tools > Measure Distance to measure some object in the scene for which you know the size; for example, a door or window. The distance displays in the Coordinate Display of the status bar.

3. Choose Customize > Units Setup and adjust the Scene Unit Scale.
   For example, if your object measures 35 scene units long, and your model uses US Standard measurement, then you would enter 1 for the scale, and choose Inches from the drop-down list. This would give you an object 35 inches long.
   If your object measures 90 scene units long, and your model uses Metric measurement, then you would enter 1 for the scale, and select Centimeters from the drop-down list. This would give you an object 90 centimeters long.

Example: To process radiosity with photometric lighting:

1. Use a scene that has geometry set to the correct scale. For more information, see To set units correctly on page 6635.
   For example, if the ceiling is 96 scene units high in the model, make sure the units are set to US Standard (inches) and not Metric.

2. On the Create panel, click Lights.
3 Choose Create > Photometric Lights > Target Point Light.

4 Choose Photometric from the drop-down list. (The default is Standard.)

5 In the Object Type rollout, click Target Point.

6 Drag in a viewport. The initial point of the drag is the location of the light, and the point where you release the mouse is the location of the target.

The light is now part of the scene.

7 Set the creation parameters.

**TIP**  You can use the Move transform to adjust the location of the light or its target.

8 On the Modify panel, adjust the light's settings.

9 To preview the lighting, click Render.

Make any changes you need to adjust the rendering.

10 Choose Rendering menu > Environment to open the Environment panel on page 7163 of the Environment And Effects dialog.

11 On the Exposure Control rollout of the Environment panel, choose Logarithmic Exposure Control from the drop-down list. Click Render Preview.

The thumbnail preview shows the effect of exposure control.

12 On the Logarithmic Exposure Control rollout on page 7215, adjust the settings until the scene lighting is acceptable. For example, a brightness of 65 and a contrast of 50 can be good values for interior scenes.

The thumbnail preview updates as you adjust settings.

13 Choose Rendering > Advanced Lighting > Radiosity to display the Advanced Lighting panel with Radiosity chosen as the advanced lighting type.

The rollouts for radiosity are displayed.

14 Choose Rendering > Radiosity to display the Radiosity panel.

15 On the Radiosity Processing Parameters rollout on page 6639, click Start to begin processing radiosity.

16 To render the scene after radiosity processing completes, click Render.
**Example: To process radiosity with standard lighting:**

Photometric lights are recommended for use with radiosity. But if you are working on a scene that already contains standard lights, you can follow these guidelines.

1. Create or load a scene containing the appropriate geometry for lighting. There is no need to adjust any scale factors.

2. On the Create panel, click Lights. Standard is the default choice of light type.

3. In the Object Type rollout, click a light type such as Target Spot.

4. Drag in a viewport. The initial point of the drag is the location of the spotlight, and the point where you release the mouse is the location of the target.
   The light is now part of the scene.

5. Set the creation parameters for the light.

6. To preview the lighting, click Render. Make any changes you need to adjust the rendering.

7. Choose Rendering > Advanced Lighting to display the Advanced Lighting panel. On the Select Advanced Lighting rollout, choose Radiosity as the advanced lighting type.
   The rollouts for radiosity are displayed.

8. Choose Rendering > Advanced Lighting > Radiosity to display the Advanced Lighting panel with Radiosity chosen as the advanced lighting type.
   The rollouts for radiosity are displayed.

9. On the Radiosity Processing rollout, under Interactive Tools, click Setup to display the Environment panel on page 7163 where you set exposure controls.
NOTE The exposure controls allow you to control only the intensity of the indirect lighting. 3ds Max retains the original intensity and effect for the direct lighting.

10 On the Exposure Control rollout of the Environment panel on page 7163, choose Logarithmic Exposure Control from the drop-down list.

11 On the Logarithmic Exposure Control rollout on page 7215, turn on Affect Indirect Only.

12 On the same rollout, use the Physical Scale setting to assign the standard light a photometric value in candelas.

13 Render the scene again after radiosity processing.

Interface

Radiosity controls appear as rollouts on the Advanced Lighting panel of the Render Setup dialog. To choose radiosity, use the Select Advanced Lighting rollout on page 6600.
Radiosity Processing Parameters Rollout

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Choose Default Scanline Renderer as the active production renderer. > Advanced Lighting panel > Select Advanced Lighting rollout > Choose Radiosity from the drop-down list. > Radiosity Processing Parameters rollout

Contains the main controls for processing a radiosity solution.

Interface

**Reset All** When you click Start, a copy of the 3ds Max scene is loaded into the radiosity engine. Clicking Reset All clears all the geometry from the engine.
**Reset** Clears the light levels from the radiosity engine, but doesn’t clear the geometry.

**Start** Starts the radiosity processing. Once the radiosity solution has reached the percentage amount specified by Initial Quality, this button changes to Continue.

If you click Stop before reaching the full Initial Quality percentage, then clicking Continue causes radiosity processing to resume, until the full percentage is reached, or you click Stop once more. You can click Stop and then Continue more than once.

In addition, you can calculate radiosity up to an Initial Quality less than 100 percent, then later increase the value of Initial Quality, click Continue, and resume solving radiosity.

In either case, Continue saves time by avoiding regenerating the radiosity solution from scratch.

Once the full Initial Quality percentage has been reached, clicking Continue has no effect.

**Stop** Stops the radiosity processing. The Start menu changes to Continue. You can later click Continue to resume radiosity processing, as described for the Start menu.

Keyboard shortcut: Esc

**Process group**

The options in this group set the behavior of the first two stages of the radiosity solution, Initial Quality and Refine.

**Initial Quality** Sets the quality percentage at which to stop the Initial Quality stage, up to 100%. For example, if you specify 80%, you will get a radiosity solution that is 80% accurate in energy distribution. A goal of 80 to 85% is usually sufficient for good results.

During the Initial Quality stage, the radiosity engine bounces rays around the scene and distributes energy on surfaces. Between each iteration, the engine measures the amount of variance (noise between surfaces) that was computed.

Most of the brightness of the scene is distributed in the early iterations. The contribution to the scene’s average brightness decreases logarithmically between iterations. After the first few iterations, the brightness of the scene does not increase much, but subsequent iterations reduce the variance in the scene.
NOTE The “quality” refers to the accuracy of energy distribution, not to the visual quality of the solution. Even at a high Initial Quality percentage, the scene can still show considerable variance. This variance is resolved by the subsequent stages of the solution.

Increasing the percentage value of Initial Quality.

Increasing quality does not greatly increase the average brightness of the scene, but it decreases the variance between different surfaces in the scene, such as the faces of the sphere.

Refine Iterations (All Objects) Sets the number of Refine iterations to perform for the scene as a whole. The Refine Iterations stage increases the quality of the radiosity processing on all objects in the scene. Gathers energy from each face in order to reduce the variance between faces using a different process from the Initial Quality stage. This stage does not increase the brightness of the scene, but it improves the visual quality of the solution and significantly reduces variance between surfaces. If you don’t reach an acceptable result after processing a certain number of Refine iterations, you can increase the number and continue processing.
TIP If you plan to use Regathering at render time, you generally don’t need to perform the Refine stage to get good-quality final renderings.

NOTE After 3ds Max processes Refine Iterations, Initial Quality is disabled and you can’t change it until you click Reset or Reset All.

Large image with no iterations has areas of uneven illumination.
Inset images: After a number of iterations, the uneven areas have been corrected.

Refine Iterations (Selected Objects) Sets the number of Refine iterations to perform for selected objects, using the same method as Refine Iterations (All Objects). Make an object selection and then set the number of iterations you require. Refining selected objects rather than the entire scene can save a lot of processing time. Typically, this option is useful for objects that have a lot
of small surfaces and show a lot of variance, such as railings or chairs or highly subdivided walls.

**NOTE** After 3ds Max processes Refine Iterations, Initial Quality is disabled and you can't change it until you click Reset or Reset All.

**Process Refine Iterations Stored in Objects** Each object has a radiosity property called Refine Iterations. Each time you refine an object selection, the number of steps stored with these objects is incremented.

When you reset the radiosity solution and then start it again, the steps for each objects are refined automatically, provided this toggle is turned on. This is useful when you are creating animations, when the radiosity needs to be processed at every frame, and the same level of quality between frames has to be maintained.

**Update Data When Required on Start** When on, the radiosity engine must be reset and then recalculated if the solution is invalidated. In this case, the Start menu changes to read Update & Start. When this is pressed, the radiosity solution is reset and the calculation starts over again.

When this toggle is off, the radiosity solution does not need to be reset if it is invalidated. You can continue processing your scene with the invalid solution.

**NOTE** The radiosity solution is invalidated any time an object or light is added, removed, moved, or altered in any way.

**Interactive Tools group**

The options in this group help you adjust the display of the radiosity solution in the viewport and in the rendered output. These controls take effect immediately on an existing radiosity solution and do not require any additional processing for you to see their effects.

**Indirect Light Filtering** Reduces the amount of noise between surface elements by averaging the indirect lighting levels with the surrounding elements. A value of 3 or 4 is usually sufficient. If you use too high a value, you risk losing detail in the scene. Because Indirect Light Filtering is interactive, you can readily evaluate the result and adjust it as you need.

**Direct Light Filtering** Reduces the amount of noise between surface elements by averaging the direct lighting levels with the surrounding elements. A value of 3 or 4 is usually sufficient. If you use too high a value, you risk losing detail in the scene. Direct Light Filtering is interactive, so you can readily evaluate the result and adjust it as you need.
NOTE Direct Light Filtering works only when you use Shoot Direct Lights on page 6650. If you’re not using Shoot Direct Lights, everything is considered indirect lighting.

For a 65% quality solution, increasing the Indirect Light Filtering value from 0 to 3 creates a smoother diffuse light. The results are comparable to a much higher-quality solution.

No Exposure Control Selected Displays the name of the current exposure control.

(When you change the exposure control by choosing Rendering menu > Environment, the name display in the Radiosity dialog updates automatically.)

Setup Click to display the Environment panel on page 7163, where you access the Exposure Control rollout; there, you can choose the exposure control and set its parameters.

Display Radiosity in Viewport Toggles the display in the viewports between radiosity and standard 3ds Max shading. You might want to do turn off radiosity shading to increase display performance.
Radiosity Meshing Parameters Rollout

Render Setup dialog > Choose Default Scanline Renderer as the active production renderer. > Advanced Lighting panel > Select Advanced Lighting rollout > Choose Radiosity from the drop-down list. > Radiosity Meshing Parameters rollout

Controls the creation of a radiosity mesh and its size in world units.

In order to create the lighting of a scene, 3ds Max calculates the intensity for discrete points in the environment by subdividing the original surfaces into elements which are part of a *radiosity mesh*. This rollout allows you to determine whether you want a mesh or not, and to specify the size of the mesh elements in world units. For quick tests, you might want to turn off the mesh globally. The scene will look flat, but the solution will still give you a quick impression of the overall brightness.

The finer the mesh resolution is, the more accurate the lighting detail will be. But there is a trade-off in time and memory.

Meshing (shown in light red) subdivides flat surfaces in the scene.
Left: No mesh. The solution looks very flat.
Middle: Coarse mesh, every 24 inches. The lighting improves.
Right: Fine mesh, every 4 inches. The lighting reveals more subtle effects.

NOTE A tight meshing is not necessary when you use the regathering feature on the Rendering Parameters rollout on page 6653.
NOTE You can override the subdivision settings in this group with the Advanced Lighting panel on page 295 of the Object Properties dialog. This allows you to have a different mesh resolution on some objects. For example, you might want to have a finer mesh on an important wall surface that you know will have a lot of detail. To display the Object Properties dialog, right-click a selected object and choose Properties from the quad menu.
Global Subdivision Settings group

Enabled  Turn on the radiosity mesh for the entire scene. Turn off the mesh when you want to perform quick tests.

- Use Adaptive Subdivision  Turns adaptive subdivision on and off.
  Default=on.

**NOTE** The Mesh Settings group parameters Minimum Mesh Size, Contrast Threshold, and Initial Meshing Size are available only when Use Adaptive Subdivision is on.

Left: A simple box with no subdivision

Middle Left: The box faces are subdivided

Middle Right: The box faces are subdivided with a smaller Meshing Size

Right: The box faces are subdivided with Adaptive Subdivision
Mesh Settings group

Adaptive Subdivision using the default mesh and light settings

**Max Mesh Size** The size of the largest faces after adaptive subdivision. Default=36” for imperial units and 100cm for metric units.

When Use Adaptive Subdivision is turned off, Max Mesh Size sets the size of the radiosity mesh in world units.

**Min Mesh Size** Faces are not divided smaller than the minimum mesh size. Default=3” for imperial units and 10cm for metric units.

**Contrast Threshold** Faces that have vertex illuminations that differ by more than the Contrast Threshold settings are subdivided. Default=75.0.

Radiosity solutions with different Contrast Threshold values. The best solution is at the center, with Contrast Threshold=60.
Initial Meshing Size When improving the face shape, faces that are smaller than the Initial Meshing Size are not subdivided. The threshold for deciding whether a face is poorly shaped also gets larger as the face size is closer to the Initial Mesh Size. Default=12 inches (1 foot) for US Standard units and 30.5cm for metric units.

Light Settings group

Shoot Direct Lights When adaptive subdivision or shoot direct lights is on, the direct lighting on all of the objects in the scene is calculated analytically, based on the following switches. Lighting is analytically computed without modifying the object’s mesh which produces lighting that is less noisy and more pleasing to the eye. This switch is implicitly enabled when using adaptive subdivision since it is a requirement. Default=on. This switch is available when the Use Adaptive Subdivision switch is turned off.

NOTE Lighting from lights that are not included while shooting direct light are calculated using random sampling. These lights also are not able to affect the adaptive subdivision of objects.
Include Point Lights in Subdivision Controls whether point lights are used when shooting direct lights. If this switch is off, then point lights are not included in illumination calculated directly at vertices. Default=on.

Include Linear Lights in Subdivision Controls whether linear lights are used when shooting direct lights. If this switch is off, then linear lights are not used in calculating the illumination at vertices. Default=on.

Include Area Lights in Subdivision Controls whether area lights are used when shooting direct lights. If this switch is off, then area lights are not used in illumination calculated directly at vertices. Default=on.

Include Skylight When turned on, skylight is used when shooting direct lights. If this switch is turned off, then skylight is not used in illumination calculated at vertices directly. Default=off.

Include Self-Emitting Faces in Subdivision This switch controls how self-emitting faces are used when shooting direct lights. If this switch is turned off, then self-emitting faces are not used in illumination calculated at vertices directly. Default=off.

- Minimum Self-Emitting Size This is the minimum size that a self-emitting face will be subdivided when calculating its illumination. Minimum size is used rather than the number of samples to allow larger faces to be sampled more than smaller ones. Default=6.0.

This setting is unavailable unless Include Self-Emitting Faces In Subdivision is on.

Light Painting Rollout (Radiosity)

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Choose Default Scanline Renderer as the active production renderer. > Advanced Lighting panel > Select Advanced Lighting rollout > Choose Radiosity from the drop-down list. > Light Painting rollout

The light painting tools in this rollout allow you to touch up shadowed and illuminated areas manually. You can use these tools to touch up shadow and light-leak artifacts without having to do additional remodeling or radiosity processing. Using Pick Illumination, Add Illumination, and Remove Illumination, you can add or remove illumination on one selection set at a time.

To use the light painting tools, you first select objects, and then choose a light painting tool: Pick Illumination, Add Illumination, or Remove Illumination. The active button is highlighted in yellow, and when it is over a selected
object, the cursor changes to a crayon icon for the Add and Remove Illumination tools, or to an eyedropper icon for Pick Illumination.

You can pick, add, or remove illumination through objects. For example, if you select the floor as an object, you can work under the bookshelf, by working through it. Once in light painting mode, you can't select another object unless you cancel the operation.

**Interface**

![Light Painting Interface]

**Intensity** Specifies the intensity of the illumination in lux or candelas depending on the units you have selected in the Customize > Units Setup dialog on page 8366.

**Pressure** Specifies the percentage of the sampled energy to be used when you add or remove illumination.

**Add Illumination** Adds illumination starting at the vertex of a selected object. 3ds Max adds illumination based on the amount in the Pressure spinner. The pressure amount corresponds to a percentage of the sampled energy. For example, if a wall has about 2,000 lux on it, Add Illumination adds 200 lux to the surface of the selected object.

**Remove Illumination** Removes illumination starting at the vertex of a selected object. 3ds Max removes illumination based on the amount in the Pressure spinner. The pressure amount corresponds to a percentage of the sampled energy. For example, if a wall has about 2,000 lux on it, Remove Illumination removes 200 lux from the surface of the selected object.

**Pick Illumination** Samples the amount of illumination from a surface that you select. To save you from inadvertently making bright or dark spots, Pick Illumination uses an amount of illumination relative to the surface illumination you sample. Click the button, and move the eyedropper cursor...
over the surface. When you click a surface, the amount of illumination in lux or candelas is reflected in the Intensity spinner. For example, if you used Pick Illumination over a wall that has 6 lux of energy, then 0.6 lux displays in the Intensity spinner. The amount of illumination 3ds Max adds or removes on the surface will be this value multiplied by the Pressure value.

**Clear** Clears all the changes you made. Processing additional radiosity iterations or changing the filtering amount will also discard any changes to the solution you made with the light painting tool.

![Image](image.png)

Using light painting to add or remove light in a radiosity solution.

**Rendering Parameters Rollout (Radiosity)**

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Choose Default Scanline Renderer as the active production renderer. > Advanced Lighting panel > Select Advanced Lighting rollout > Choose Radiosity from the drop-down list. > Rendering Parameters rollout

Provides parameters for controlling how to render the radiosity-processed scene.
By default, when you render, 3ds Max first recalculates the shadows from light objects, and then adds the result of the radiosity mesh as ambient light.

The first two options on the rollout control how the renderer treats direct illumination. Re-Use Direct Illumination From Radiosity Solution provides a quick render that displays colors from the radiosity mesh. Render Direct Illumination uses the scanline renderer to provide direct illumination and shadows. This second option is usually slower but more accurate. With Render Direct Illumination, the radiosity solution provides only the indirect lighting.

When you choose the Render Direct Illumination method, you can turn on regathering to correct artifacts and shadow leaks. Regathering provides the slowest but the best-quality rendering.

**NOTE** Regathering is extremely intensive for your CPU and uses a lot of RAM, so it might not be practical for print-resolution images (for example, 4000 x 4000 pixels).

**Interface**

![Rendering Parameters](image)
**Re-Use Direct Illumination from Radiosity Solution** 3ds Max doesn’t render direct lights, but uses the direct lighting stored in the radiosity solution. If you turn on this option, the Regather Indirect Illumination option is disabled. The quality of shadows in the scene depends on the mesh resolution. Capturing fine shadow details might require a fine mesh, but in some situations this option can speed up overall rendering time, especially for animations, because the lights don’t have to be recalculated by the scanline renderer.

If you are using the **Assign Vertex Colors utility** on page 6477, turn this option on.

![Left: Direct light only is stored in the radiosity mesh.](image1)

![Middle: Indirect light only is stored in the radiosity mesh.](image2)

![Right: Direct and indirect light both stored in the radiosity mesh (the shadows are usually very coarse).](image3)

**WARNING** If you choose this option but haven’t generated a radiosity solution, rendering generates a completely black image.

**Render Direct Illumination** 3ds Max renders shadows from the lights at each rendering frame, and then adds indirect light from the radiosity solution. This is the default rendering mode.

![Left: Direct light calculated only by the scanline renderer.](image4)
Regather Indirect Illumination In addition to recalculating all the direct lighting, 3ds Max recalculates the indirect lighting at each pixel by regathering illumination data from the existing radiosity solution. Using this option can produce the most accurate, artifact-free images, but it can add a considerable amount of rendering time.

**NOTE** If you know that you want to use the regathering option, then typically you don’t need as dense a mesh for the radiosity solution. Even if you don’t subdivide the surfaces at all and do an Initial Quality of 0%, the regathering will work, and might provide an acceptable visual result (useful for quick tests as well). However, accuracy and subtle details depend on the quality of the radiosity solution stored in the mesh. The radiosity mesh is the foundation for the regathering process.

In the following illustrations, solutions were processed with an Initial Quality of 0%. There is a high variance between small surfaces when a dense mesh is used. Regathering gives acceptable results regardless of mesh density. But more subtle details appear with a denser mesh; for example, at the base of the sculpture.

---

Middle: Indirect light calculated only by the radiosity mesh.
Right: Direct and indirect light combined.

**NOTE** If you know that you want to use the regathering option, then typically you don’t need as dense a mesh for the radiosity solution. Even if you don’t subdivide the surfaces at all and do an Initial Quality of 0%, the regathering will work, and might provide an acceptable visual result (useful for quick tests as well). However, accuracy and subtle details depend on the quality of the radiosity solution stored in the mesh. The radiosity mesh is the foundation for the regathering process.

In the following illustrations, solutions were processed with an Initial Quality of 0%. There is a high variance between small surfaces when a dense mesh is used. Regathering gives acceptable results regardless of mesh density. But more subtle details appear with a denser mesh; for example, at the base of the sculpture.
Coarse mesh
Left: Model subdivision
Middle: Viewport result
Right: Result of regathering

Fine mesh
Left: Model subdivision
Middle: Viewport result
Right: Result of regathering

**Rays per Sample** The number of rays 3ds Max casts for each sample. 3ds Max casts these rays randomly in all directions to calculate (“regather”) the indirect illumination from the scene. The more rays per sample, the more precise the sample will be. Fewer rays per sample produce more variance, creating a more grainy effect. Processing speed and precision are affected by this value. Default=64.

**Filter Radius (pixels)** Averages each sample with its neighbors in order to reduce the noisy effect. Default=2.5 pixels.
NOTE Pixel radius varies according to the output resolution. For example, a 2.5 radius is OK for NTSC resolution, but it might be very large for smaller images, or too precise for very large images.

Pixel radius of 2
Left: 10 rays per sample
Middle: 50 rays per sample
Right: 150 rays per sample

Pixel radius of 5
Left: 10 rays per sample
Middle: 50 rays per sample
Right: 150 rays per sample
Pixel radius of 10
Left: 10 rays per sample
Middle: 50 rays per sample
Right: 150 rays per sample

Increasing the number of rays per sample can greatly increase rendering time. The images on the right can take nearly six times as long to render as the images on the left. Increasing the filter radius also increases render time, but not as dramatically.

Clamp Values (cd/m^2) This control is expressed as a luminance value. Luminance (candelas per meter squared) represents how brightly you perceive a material. Clamp Value sets an upper limit on the luminance that will be considered in the Regathering stage. Use it to avoid the appearance of bright spots.
Bright polygons in the scene can create a “sparkle” effect of bright spots.

These bright spots are artifacts not of the number of samples cast, but rather of the presence of bright polygons in your scene. During the Initial Quality stage, this bright energy gets bounced in random directions, leading to a “sparkle” effect. Typically you can detect these polygons before regathering.

During the final Regathering stage, bright spots can be avoided by setting Clamp Values somewhat below the luminance of these bright surfaces and spots.
Bright spots have been reduced by clamping.

**TIP** You can query the luminance of these surfaces by using the Lighting Analysis tool on page 6664.

**TIP** Use Render Region on page 6542 to render just the area of the bright spots to find rapidly the right clamp value to use.

Be careful with this control: Clamp Values let you clamp any intensity, and the rendering might become darker than it should be because you have clamped indirect illumination that is to be expected, thus dimming the effect of the radiosity solution.
**Adaptive Sampling group**

These controls can help you shorten rendering times. They reduce the number of light samples taken. The ideal settings for adaptive sampling vary greatly from scene to scene.

Adaptive sampling initially takes samples from a grid superimposed on the pixels of the scene. Where there is enough contrast between samples, it subdivides that region and takes further samples, down to the minimum area specified by Subdivide Down To. Lighting for areas not directly sampled is interpolated.

**TIP** If you use adaptive sampling, try adjusting the Subdivision Contrast value to obtain the best results.

**Adaptive Sampling** When on, the radiosity solution uses adaptive sampling. When off, it does not. Turning off adaptive sampling can increase the detail of the final rendering, but at a cost of rendering time. Default=off.

**Initial Sample Spacing** The grid spacing for initial samples of the image. This is measured in pixels. Default=16x16.

**Subdivision Contrast** The contrast threshold that determines when a region should be further subdivided. Increasing this value causes less subdividing to occur. Reducing this value can cause unnecessary subdivide. Default=5.0.

**Subdivide Down To** The minimum spacing for a subdivision. Increasing this value can improve render time at a cost of accuracy. Default=2x2. Depending on the scene geometry, grids larger than 1x1 might still be subdivided below this specified threshold.

**Show Samples** When on, sample locations render as red dots. This shows where the most sampling has taken place, which can help you choose the optimal settings for adaptive sampling. Default=off.

**Statistics Rollout (Radiosity)**

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Choose Default Scanline Renderer as the active production renderer. > Advanced Lighting panel > Select Advanced Lighting rollout > Choose Radiosity from the drop-down list. > Statistics rollout

This rollout lists information about the radiosity processing.
Interface

### Radiosity process group

Lists the current level of quality and number of refine iterations in the radiosity process.

**Solution Quality** The current level of quality in the radiosity process.

**Refine Iterations** The number of refine iterations in the radiosity process.

**Elapsed Time** The time spent processing the solution since the last reset.

### Scene Information group

Lists information on the radiosity processing of the scene.

**Geometric Objects** Lists the number of objects processed.

**Light Object** Lists the number of light objects processed.

**NOTE** Self-illuminated objects count as one light per face.

**Meshing Size** Lists the size of radiosity mesh elements in world units.

**NOTE** Transparent, 2-sided, and translucent objects’ faces are counted twice.

**Mesh Elements** Lists the number of elements in the mesh processed.
Lighting Analysis

Select an object that has radiosity solution information. > Rendering menu > Advanced Lighting > Lighting Analysis

To query light levels, analyze the data, and produce reports, use the Lighting Analysis dialog. This dialog provides rendering data on material reflectance, transmittance, and luminance.

For example, a lighting engineer might need to know if light fixtures in a scene provide an even level of illumination on the walls of a building. The engineer uses the Lighting Analysis dialog after placing the lights in the ceiling and processing radiosity. The engineer inspects the light levels and material reflectance in the scene and then adjusts the brightness of lights, changes units, or reduces material reflectance.

To use the Lighting Analysis tools, a radiosity solution must be calculated and displayed in the scene. For better feedback, use it in conjunction with the Pseudo Color Exposure Control on page 7228. This tool maps luminances or illuminances to pseudo colors that show the brightness of the values 3ds Max converts.

TIP You can also export LogLUV TIFF files on page 7880 or PIC files on page 7861 for analysis by other software; do this by using the Lighting Data Exporter utility on page 7234.

See also:

- Modeling Global Illumination with Radiosity on page 6615
- Radiosity Workflows on page 6627
- Radiosity Controls on page 6634
- Radiosity Preferences on page 8362
- Lighting Data Exporter Utility on page 7234
Interface

Statistics group

Displays the radiosity solution lighting statistics for the object you select.

Quantity Indicates the desired photometric value:

■ Luminance The amount of energy leaving a surface.

■ Illuminance The amount of energy arriving at a surface.

Point The luminance or illuminance at the point on the object where you clicked.

Point Reflectance The reflectance of the surface material at the point on the object where you clicked.

Point Transmittance The transmittance of the surface material at the point on the object where you clicked.

Object Avg The amount of light intensity for the object as a whole.

Object Min The object’s minimum luminance or illuminance value.

Object Max The object’s maximum luminance or illuminance value.

Scene Max The scene’s highest luminance or illuminance value.
Selection Information group

Object Name The name of the selected object.
Object Area The area size of the selected object.
Point Location The X,Y,Z coordinate of the point on an object you clicked.

Raytracer Panel

The topic in this section describes the Raytracer Global Parameters rollout, which has global settings for raytraced materials, maps, and shadows.

Raytracer Global Parameters Rollout

Rendering menu > Raytracer Settings

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Choose Default Scanline Renderer as the active production renderer. > Raytracer panel > Raytracer Global Parameters rollout

These parameters control the raytracer globally. That is, they affect all Raytrace materials and Raytrace maps in your scene. They also affect the generation of Advanced Ray-traced shadows on page 8696 and Area shadows on page 8510.

NOTE These controls adjust ray-trace settings for the scanline renderer only. The settings of these controls have no impact on the mental ray renderer, which has its own ray-tracing controls.
Interface

Ray Depth Control group

Ray depth, also known as recursion depth, controls how many times the renderer allows a ray to bounce before it is considered lost or trapped.
Upper left: Ray depth is zero
Upper right: Ray depth of 2
Lower middle: Extremely high ray depth

Maximum Depth Sets the maximum recursion depth. Increasing this value potentially increases the realism of your rendered scene, at a cost of rendering time. You can reduce this value to reduce rendering time. Range=0 to 100. Default=9.

Cutoff Threshold Sets a cutoff threshold for adaptive ray levels. If the contribution of any ray to the final pixel color drops below the cutoff threshold, the ray is terminated. Default: 0.05 (5% of the final pixel color). This can speed up your rendering time considerably.

Color to use at Max Depth As a rule, when a ray reaches the maximum depth, it is rendered the same color as the background environment. You can override the color returned at maximum depth by either selecting a color, or setting an alternative environment map. This can make the "lost" ray invisible in the scene.
TIP  If you are having trouble with getting complex objects to render, especially glass, specify the maximum recursion color to something obvious, like magenta, and your background color to something that contrasts, like cyan. The chances are that a lot of your rays are getting lost in either maximum recursion or just being shot off into the world, totally missing anything you think they should strike. Try rendering the scene again. If this is the problem, try reducing the Maximum Depth value.

- **Specify**  Specifies what color the raytracer returns when the ray is considered lost or trapped. Click the color swatch to change this color.

- **Background**  (The default.) Returns the background color when the ray is considered lost or trapped. For Raytrace material, the background color is the global environment background or the environment specified locally for the material. For Raytrace map, the background color is either the global environment background, or is set locally in the Raytracer Parameters rollout on page 6366.

**Global Ray Antialiaser group**

Controls in this group let you set global antialiasing for raytraced maps and materials.
Above: No antialiasing
Below: Antialiasing of reflections

**TIP** Turning on Supersample for a Raytraced material (in the Raytrace Basic Parameters rollout on page 6065) usually provides adequate antialiasing. Use one of the raytrace antialiasers (Fast Adaptive or Multiresolution Adaptive) when you want to blur reflections or refractions.

**On** When on, uses antialiasing. Default=off.

**Drop-down list** Chooses which antialiasing settings to use. There are two options:

- **Fast Adaptive Antialiaser** Uses the Fast Adaptive antialiaser, regardless of the global setting. Click ... to open the Fast Adaptive Antialiaser dialog on page 6095.

- **Multiresolution Adaptive Antialiaser** Uses the Multiresolution Adaptive antialiaser, regardless of the global setting. Click ... to open the Multiresolution Adaptive Antialiaser dialog on page 6097.
**Global Raytrace Engine Options group**

These options are comparable to the local options on [Extended Parameters rollout](page 6074) and the [Raytracer Controls rollout](page 6079). Their setting affects all Raytrace materials and Raytrace maps in the scene, unless you set local overrides.

**Enable Raytracing** Turns the raytracer on or off. Default=on.

Even with raytracing off, Raytrace material and Raytrace map still reflect and refract the environment, including both the environment map for the scene, and the environment map assigned to the Raytrace material.

**Raytrace Atmospherics** Turns the raytracing of atmospheric effects on or off. Atmospheric effects include fire, fog, volume light, and so on. Default=on.

**Enable Self Reflect/Refract** Turns self reflection/refraction on or off. Default=on.

Can an object reflect itself? For example, a teapot's body reflects the teapot's handle, but a sphere will never reflect itself. If you don't need this effect, you can improve render time by turning off this toggle.

**TIP** If you have a transparent object such as glass, and Enable Self Reflect/Refract is on, you don't have to make the object [2-sided](page 8493) on page 8493. The raytracer sees back faces when exiting refractive objects.

**Reflect/Refract Material IDs** When on, the material reflects effects assigned to material IDs in the renderer's G-buffer on page 8589 on or off. Default=on.

By default, Raytrace material and Raytrace map reflect effects assigned to a material's ID, so that G-buffer effects are not lost. For example, if a raytraced object reflects a lamp made to glow with the Video Post Glow filter (Lens Effects Glow), the reflection glows as well.

**Render objects inside raytraced objects** Toggles the rendering of objects inside raytraced objects. Default=on.

**Render atmospherics inside raytraced objects** Toggles the rendering of atmospheric effects inside raytraced objects. Atmospheric effects include fire, fog, volume light, and so on. Default=on.

**Enable Color Density / Fog Effects** Toggles the color density and fog features.

**Acceleration Controls** Opens the [Raytracing Acceleration Parameters dialog](page 6091).

**Exclude** Opens the [Raytrace Exclude/Include dialog](page 6092), which lets you exclude objects from ray-tracing.
Show Progress Dialog When on, rendering displays a window with progress bars titled Raytrace Engine Setup. Default=on.

Show Messages When on, displays a window, Raytrace Messages, that shows status and progress messages from the raytrace engine. Default=off.

**Using Multi-Pass Rendering Effects**

Create panel > Cameras > Target button or Free button > Parameters rollout > Multi-Pass Effect group

Multi-pass rendering effects use multiple renderings of the same frame, with slight camera movement between each rendering. The multiple passes simulate the blurring that film in a camera would register under certain conditions.

The included multi-pass effects are provided:

- **Depth of field** on page 5590 (Default Scanline Renderer)
Multi-pass depth of field

Top: Focus is in the middle distance; near and far objects are blurred.

Bottom left: Focus on near objects, far objects are blurred.

Bottom right: Focus on far objects, near objects are blurred.

- Motion blur on page 5594 (Default Scanline Renderer)
Above: Motion blur applied to wings of the flying dragon

Below: Multiple passes appear in successive refreshes of the Rendered Frame Window.

- Depth of Field (mental ray) on page 5589

See also:
- Motion Blur with the mental ray Renderer on page 6693
- Depth of Field with the mental ray Renderer on page 6694
mental ray Renderer

The mental ray® renderer from mental images® is a general-purpose renderer that can generate physically correct simulations of lighting effects, including ray-traced reflections and refractions on page 6690, caustics on page 6700, and global illumination on page 6706.

NOTE mental images and mental ray are registered trademarks, and photon map is a trademark of mental images GmbH & Co. KG, Berlin, Germany.

Scene rendered with the default 3ds Max scanline renderer
The second rendering, done with the mental ray renderer, shows caustics cast by refraction through the martini glass. Caustics are also visible in the reflection on the cocktail shaker.

The mental ray renderer in 3ds Max supports the mental ray version 2 (mi2) and version 3 (mi3) formats. It does not support the mental ray version 1 (mi1) format.

**Differences Between the mental ray Renderer and the Default Scanline Renderer**

Compared to the default 3ds Max scanline renderer, the mental ray renderer relieves you of the need to simulate complex lighting effects "by hand" or by generating a radiosity solution. The mental ray renderer is optimized to use multiple processors and to take advantage of incremental changes for efficient rendering of animations.

Unlike the default 3ds Max renderer, which renders scanlines from the top of the image downward, the mental ray renderer renders rectangular blocks called buckets. The order in which the buckets are rendered can vary, depending on the method you choose. By default, mental ray uses the Hilbert method, which picks the next bucket to render based on the cost of switching to the next
Because objects can be discarded from the memory to render other objects, it’s important to avoid having to reload the same object multiple times. This is especially important when you have enabled placeholder objects (see the Processing panel > Translator Options rollout on page 6787).

If you use distributed rendering to render a scene, it might be hard to understand the logic behind the rendering order. In this case, the order has been optimized to avoid sending lots of data over the network. Each CPU is assigned a bucket as the bucket becomes available, so different buckets can appear in the rendered image at different times. See the Renderer panel > Sampling Quality rollout on page 6735.

**NOTE** The mental ray renderer can also be run in a standalone fashion, using a command-line interface based on the mi2 or mi3 scene description format. This is described in the manual *mental ray Programming*, which is written for programmers writing custom shaders on page 8716.

**Procedures**

To use the mental ray renderer:

1. Choose Rendering menu > Render Setup. The Render Setup dialog opens.
2. On the Common panel, open the Assign Renderer rollout, and then click the “...” button for the Production renderer.
   The Choose Renderer dialog opens.
3. On the Choose Renderer dialog, highlight *mental ray Renderer* and then click OK.

   **TIP** After you make the mental ray renderer the active production renderer, you can make the mental ray renderer the default renderer for all new scenes by clicking Save As Defaults. This is a convenient way to avoid extra setup time.

Now the Render Setup dialog contains the mental ray controls. You can choose to render the scene with the built-in mental ray renderer, or simply to translate the scene and save it in an Mi on page 8639 file that you can render later, perhaps on a different system. Controls for choosing whether to render, save to an Mi file, or both, are on the Translator Options rollout on page 6787.
Rendering with the mental ray Renderer

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Common panel > Assign Renderer rollout > Choose mental ray Renderer as the Production renderer.

To use the mental ray translator and renderer, you must first choose mental ray as the production renderer, as described in the "Procedures" section below. Once you have chosen mental ray rendering, the Render Setup dialog displays panels and rollouts that control the mental ray renderer.

Common Parameters Rollout

When you render with mental ray, controls on the Render Setup dialog > Common panel > Common Parameters rollout remain the same, and function just as they do with the default scanline renderer.

Limitations

The mental ray renderer does not support certain rendering features, as described here.

- Output dithering options aren't supported (in Main menu > Customize > Preferences > Preference Settings dialog > Rendering panel > Output Dithering group).

- The mental ray renderer does not fully support G-buffer options in post processing and image file output. The mental ray renderer generates all required G-buffer channels, but does not include transparency information. If two transparent objects overlap each other, the mental ray renderer generates information only for the frontmost object.

- When you use a bitmap as an environment (that is, as a background), the mental ray renderer samples and filters it. This can result in unwanted blurring. To prevent background blurring, render the scene against a solid-color background, and then composite the rendered scene with the background image.

- Sometimes when you render objects that have no thickness, or an Extrude modifier with zero thickness, the mental ray renderer generates rendering artifacts that appear as streaks. In some cases, you can fix this by turning on Force 2-Sided on the Render Setup dialog's Common Parameters rollout. If the streaks persist, give the object or the Extrude modifier a nonzero thickness.
See also:

- Sampling Quality Rollout (mental ray Renderer) on page 6735
- Camera Effects Rollout (mental ray Renderer) on page 6747
- Caustics and Global Illumination Rollout (mental ray Renderer) on page 6771
- Final Gather Rollout (mental ray Renderer) on page 6760
- Shadows & Displacement Rollout (mental ray Renderer) on page 6756
- Rendering Algorithms Rollout (mental ray Renderer) on page 6741
- Translator Options Rollout (mental ray Renderer) on page 6787
- Distributed Bucket Rendering Rollout (mental ray Renderer) on page 6797

Procedures

To use the mental ray renderer:

1. Choose Rendering menu > Render Setup. The Render Setup dialog opens.

2. On the Common panel, open the Assign Renderer rollout, then click the “...” button for the Production renderer.
   The Choose Renderer dialog is displayed.

3. On the Choose Renderer dialog, highlight mental ray Renderer and then click OK.

Now, when you render, the Render Setup dialog appears with the mental ray controls. You can choose to render the scene with the built-in mental ray renderer, or simply to translate the scene and save it in an MI file that you can render later, perhaps on a different system. Controls for choosing whether to render, save to an MI file, or both, are on the Translator Options rollout.

To make the mental ray Renderer the default renderer for new scenes:

- After you make the mental ray renderer the active production renderer, click Save As Defaults on the Assign Renderer rollout.
Getting Good Results with mental ray Rendering

Although the mental ray renderer is relatively easy to use once you've set it up correctly, there are several "gotchas" that you might encounter immediately, especially if you're primarily accustomed to the 3ds Max scanline renderer and its workflow. For example, see 3ds Max Materials in mental ray Renderings on page 6683. Following are some basic rules of thumb for using mental ray in 3ds Max:

Using Lights with the mental ray Renderer

When you set up a scene for rendering with the mental ray renderer, keep the following tips in mind:

- The Overshoot parameter for lights doesn't work when you use mental ray to render shadow-mapped shadows. To use Overshoot, use ray-traced shadows.

- Excluding an object from shadow casting doesn't work when you use mental ray to render shadow-mapped shadows. To exclude objects from shadow casting, use ray-traced shadows. (The Exclude button is on a light's General Parameters rollout.)

- When you assign a map to object shadows in the light's Shadow Parameters rollout, the mental ray renderer does not recognize the toggle for the map (to the left of the Map button), and renders the map whether the toggle is on or off. To stop using the map, you must click the Map button and in the Material/Map Browser, assign NONE as the map type.

- Using the default scanline renderer, you can set a light to have a value of zero, with a shadow color of white, and a shadow density of –1. With these settings, the light casts shadows but does not illuminate the scene. To get the same effect using the mental ray renderer, the light value must not be zero. Instead, set it to a value close to zero (for example, 0.001 or –0.001).

- The mental ray renderer disregards the bias parameters in the Shadow Map Params rollout and the Ray Traced Shadow Params rollout.

Ray Tracing

The mental ray ray tracer is fast and provides excellent quality images, but it's important to use it correctly.
The mental ray renderer does not fully support cubic maps for Reflect/Refract maps on page 6375. It uses them if they have already been generated by the default scanline renderer, but it does not generate them. If Source > From File is active and the mental ray renderer can find the six cubic maps, it uses them. If Source > Automatic is active, or if the cubic maps cannot be found, the mental ray renderer generates ray-traced reflections or refractions instead.

**Ray Tracing Setup**

On the rendering menu, Ray Tracer Settings and Raytrace Global Include/Exclude are disabled while the mental ray renderer is active. These controls adjust ray-trace settings for the scanline renderer only. The settings of these controls have no impact on the mental ray renderer. The ray-tracing controls for mental ray appear on the Renderer panel > Rendering Algorithms rollout on page 6741.

**TIP** While the mental ray renderer ignores the global inclusion or exclusion settings for the ray tracer, you can enable or disable ray-tracing at the local level of a Raytrace material or map.

**Ray Tracing Rules of Thumb**

Say you’re rendering a (lathed) wineglass, with an inner and outer surface and a piece of geometry representing the wine. The wine geometry is just slightly smaller than the inner surfaces of the wineglass, and capped with a flat top. Now, you go to render the glass. After rendering the scene, however, there’s something wrong: the inner surfaces of the glass don’t seem reflective enough, and the wine isn’t refracting properly. What’s wrong?

It’s possible that you have the number of reflections and refractions set too low for the number of surfaces you have. To check this, go to the Renderer panel > Rendering Algorithms rollout on page 6741 and look at the Maximum Trace Depth settings. If you haven’t changed the parameters, then you should see Max. Reflections and Max. Refractions set to the default of 6, and Max. Depth set to 6.

There’s the problem: you actually have six surfaces that need to be traced by the light rays for both reflections and refractions. The way to always calculate the number of rays needed for a scene is to take the ray-traced objects in your scene and draw an imaginary line through them, originating at the point of view. Then, count the number of surfaces the line intersects.
For the wineglass and wine, you need at least six reflections and refractions that correspond to the following surfaces:

- Near outer glass surface (“near” relative to your Camera viewpoint)
- Near inner glass surface
- Near wine surface
- Far wine surface
- Far inner glass surface
- Far outer glass surface

Therefore, increase the value of Max. Depth to 12.

**Caustics and Global Illumination**

Before rendering with caustics, there are several things you need to set up in your scene:

- For caustics to work properly, the generating object must use a material that contains some degree of shininess, reflectivity, or refraction. Assign a Raytrace or other map as either a Reflection map or Refraction map before you render caustics.

- Most often, you’ll be using very shiny, highly reflective materials (such as chrome and other metals), or transparent or translucent materials (such as glass goblets or water), to generate caustics in your scene. If you’re using a glassy material, make sure it’s double-sided to create the proper results.

- Make sure you have object properties on page 300 set to Receive Caustics or Generate Caustics (or both). To set up these properties, right-click an object and choose Properties. For example, if you’re rendering a wineglass on a tabletop, you probably want the wineglass both to generate and receive caustics (so that caustics are scattered within the glass itself), and the tabletop only to receive caustics (unless it’s chrome, say, instead of wood).

- If the rendering of your scene is washed out by light, double-check the Multiplier settings: one in the Basic group of the Final Gather rollout on page 6760, and one each in the Caustics and Global Illumination (GI) groups of the Indirect Illumination panel > Caustics And Global Illumination rollout on page 6771. These apply to all lights in the scene. Reducing the Multiplier values can eliminate washout.
If a single light object is causing the problem, you can reduce the Energy multiplier’s value in that light object’s mental ray Indirect Illumination rollout on page 5461, available on the Modifier panel.

- To improve the quality of caustics, go to the Caustics group on page 6773 of the Caustics And Global Illumination rollout on page 6771 and increase the Max Num. Photons Per Sample setting.

- Be careful of the total number of photons you’re emitting: A very high number (100,000 and above) can dramatically increase your rendering time. Then again, for some simple scenes, you might actually be able to set these to 1,000,000 and still render in an acceptable amount of time.

**WARNING** The number of photons specified for each light indicates the number of photons that need to be stored for each light, not the number of photons to be shot. This is an important distinction: If a light points in a direction where there is no surface, the mental ray renderer might shoot photons forever. In the Messages Window on page 6689, the mental ray renderer displays warnings that no photons are being stored. To avoid the slowdowns related to this issue, make sure that every light points in the direction of a surface (this is sometimes impossible to do with omni lights). Another way to avoid this problem is to add a big sphere around your entire model.

- In general, use an exposure control. The mr Photographic Exposure Control on page 7219 works particularly well for adjusting overall exposure.

**Coincident Faces**

When it encounters coincident faces, the mental ray renderer can produce artifacts, because it can’t decide which face is nearer the camera (neither is). To fix this, move or scale one of the objects so faces are no longer coincident.

**Backface Culling**

mental ray rendering correctly performs backface culling, and renders one-sided faces much as the scanline renderer does.

**3ds Max Materials in mental ray Renderings**

For the most part, the mental ray renderer treats 3ds Max maps and materials the same way the default scanline renderer does. The exceptions are listed
below. In general, if the mental ray renderer does not recognize a map or material, it renders it as opaque black.

**WARNING** The mental ray renderer does not necessarily support maps or materials provided as plug-ins from third-party vendors. It supports third-party maps and materials only if the vendor has explicitly used the mental ray SDK to add support for the mental ray format. Unless the third-party vendor clearly specifies mental ray support, you should assume the map or material is unsupported, and will render as black.

See also:

- mental ray Renderer on page 6675
- Getting Good Results with mental ray Rendering on page 6680

**Issues for Reflections and Refractions**

The maps used to create reflections or refractions, Flat Mirror, Raytrace, Reflect/Refract, and Thin Wall Refraction, are supported by the mental ray renderer. However, the mental ray renderer simply uses these maps as indications to use its own ray-tracing method, leading to some restrictions on which parameters are supported, as described in the sections “Materials” and “Maps,” below.

**Map Blurring**

When reflections and refractions are ray traced, applying Blur (or Distortion, in Flat Mirror) does not apply to reflections or refractions of environment maps. In general, Blur and Distortion render differently than they do with the default scanline renderer, and you might have to experiment with parameter values to get a comparable rendering result.

**TIP** If Blur effects are not rendering well with the mental ray renderer, try increasing the Maximum number of samples in the Renderer panel > Sampling Quality Rollout on page 6735.

**Materials**

The mental ray renderer does not support these materials:

- Advanced Lighting Override material
- Morpher material
Raytrace Material

The mental ray renderer supports all Raytrace material settings except for the antialiasing parameters and the settings found under Rendering > Raytracer Settings and Rendering > Raytrace Global Include/Exclude. All these options are specific to the default scanline renderer.

**TIP** While the mental ray renderer ignores the global inclusion or exclusion settings for the ray tracer, you can enable or disable ray-tracing at the local level of a Raytrace material or map.

Maps

- **Bitmap**
  The mental ray renderer can't use the Progressive JPEG (`.jpg`) format as a bitmap. Also, Summed Area filtering is not supported (in the Filtering group of the Bitmap Parameters rollout).
  PSD files are supported, but are translated into binary data, and because of this, consume a lot of memory and increase render time. To reduce the time involved, convert the PSD file to a format such as BMP.
  The same is true of TIFF files. In addition, there are certain TIFF subformats that the mental ray renderer does not support; specifically, LZW, CCITT (fax), or JPEG compression; non-RGB color models such as CMYK, CIE, or YCbCr; or multiple images in the same file (in this case, only the first image is used). The mental ray renderer does support bilevel (1-bit), grayscale (4- or 8-bit), color map (4- or 8-bits), RGB(A) (8-, 16-, or 32-bit) TIF images, and TIF files with image strips.

- **Combustion map**
  The mental ray renderer doesn't support this map.

- **Flat Mirror map**
  Flat Mirror is supported by the mental ray renderer, except for the First Frame Only and Every Nth Frame parameters.

- **Raytrace map**
  The mental ray renderer supports all Raytrace map settings except for the antialiasing parameters.

- **Reflect/Refract map**
  This map tells the mental ray renderer to use ray-traced reflections and refractions. Most parameters are supported, but the parameters Blur Offset, First Frame Only, Every Nth Frame, and Atmosphere Ranges are not supported.
NOTE The mental ray renderer does not fully support cubic maps for Reflect/Refract maps. It uses cubic maps if they have already been generated by the default scanline renderer, but it does not generate them. If Source > From File is active and the mental ray renderer can find the six cubic maps, it uses them. If Source > Automatic is active, or if the cubic maps cannot be found, the mental ray renderer generates ray-traced reflections or refractions instead.

Enhancements to Standard Features

The primary interface to the mental ray renderer consists of rollouts on the Render Setup dialog. To choose the mental ray renderer, use the Assign Renderer rollout on page 6582, as described in this procedure on page 6677.

In addition, object properties, lights, and the Material Editor have additional controls to support mental ray rendering. Last but not least, 3ds Max offers a special mr Proxy object for speeding up rendering of large, complex scenes.

Object Properties Enhancements

Parameters on the mental ray panel on page 300 of the Object Properties dialog support displacement as well as the mental ray indirect illumination features: final gather on page 6760, caustics on page 6700, and global illumination on page 6706.

mental ray Proxy Object

When working with high-resolution geometry, you can save memory and translation time by using the special mr Proxy object on page 562 as a stand-in for your models.

Light Object Enhancements

Along with the mental ray renderer, mental ray-specific area light objects and light settings are provided.

Light Objects

The area light on page 8507 is a feature of the mental ray renderer. Instead of a point source, it emits light from a broader area around the source. There are two basic types of mental ray area light: mr Area Omni Light on page 5418 and
mr Area Spotlight on page 5421. An additional, special-purpose mental area light is the mr Sky Portal on page 5537. Area lights create soft-edged shadows. This can help improve the realism of your rendering.

**NOTE** To render soft-edged shadows, shadows must be ray-traced, not shadow-mapped: see the Renderer panel > Shadows & Displacement Rollout on page 6756.

In 3ds Max, area lights are created and supported by the MAXScript scripts, light-mentalray_areaoomni.ms and light-mentalray_areaspot.ms. Both scripts are found in the \stdplugs\stdscripts\ folder within 3ds Max install directory. Because of this, when you create an area light, you actually create a target spot or omni light for which the mental ray renderer uses the parameters on the Area Light Parameters rollout. If you render with the default scanline renderer, the light behaves like any other target spot or omni light. (You can change a light from one type to another using the Type drop-down list on the light's General Parameters rollout.)

For area lights rendered with the mental ray renderer, you can still set and use other lighting parameters, such as color, the Multiplier value, the spotlight cone, and so on. Shadow maps are an exception. The mental ray renderer ignores the light's local shadow map settings. Area lights always use ray-traced shadows.

**TIP** You can use a MAXScript utility to convert standard 3ds Max light objects to area lights, as described in this procedure on page 5419.

**Light Settings**

The mental ray Indirect Illumination rollout on page 5461 has been added to light objects to support the mental ray renderer's indirect illumination effects of caustics on page 6700 and global illumination on page 6706.

The mental ray Light Shader rollout on page 5464 has been added so you can add mental ray light shaders to light objects.

**IMPORTANT** To see the mental ray rollouts for lights, you must use mental ray Preferences on page 8363 to enable mental ray extensions. These rollouts appear only on the Modify panel, not on the Create panel.

**Camera Enhancements**

On the Parameters rollout on page 5570, a “Depth Of Field (mental ray)” choice appears on the Multi-Pass Effect drop-down list to support the mental ray
renderer's depth-of-field effects. To use this, turn on both Enable in the camera's Multi-Pass Effect group (default=off), and Depth Of Field on the Render Setup dialog > Renderer panel > Camera Effects rollout on page 6747.

You can also assign mental ray lens, output, and volume shaders to cameras. These controls are also on the Render Setup dialog > Camera Effects rollout. (This rollout also contains some contour-shading controls.)

**NOTE** When you use the mental ray renderer, reflected or refracted light rays do not always respect a camera's clipping planes (set in the Clipping Planes group of the Parameters rollout). Also, large clipping-plane values can cause poor quality in the rendering of shadow maps. To fix this, narrow the clipping range or switch to ray-traced shadows.

### Material Editor Enhancements

The Material Editor works as it does with the default scanline renderer. Certain materials and maps, or some of their controls, aren't supported by the mental ray renderer; see 3ds Max Materials in mental ray Renderings on page 6683.

By default, the Material Editor sample slots use the currently active renderer: typically this is either the default scanline renderer or the mental ray renderer. You assign the renderer for sample slots with the Render Setup dialog > Common panel > Assign Renderer rollout on page 6582.

When mental ray extensions are enabled (using mental ray Preferences on page 8363) and the mental ray renderer is active, the Material Editor displays these additional mental ray features:

- A mental ray Connection rollout on page 5763 lets you add mental ray shaders to 3ds Max materials.

- When you click a material's Type button, the Material/Map Browser displays additional mental ray materials on page 5772.

- When you click a map or shader button, the Material/Map Browser displays additional mental ray shaders on page 6385. Shaders are provided in shader library (MI) files on page 8639. Some shaders are customized for 3ds Max, some are provided by the lume library, and most are provided by mental images libraries. Settings for the custom 3ds Max shaders are provided in this reference. Settings for the third-party lume and mental images shaders are provided in their own help files. This reference links to those descriptions; see Shaders in the LumeTools Collection on page 6391 and mental images Shader Libraries on page 6388.
mental ray Messages Window

Rendering menu > mental ray Message Window

The mental ray Messages window displays log messages (other than debug messages) generated by the mental ray renderer.

Interface

Example of mental ray Messages window

Three status fields appear above the messages area:

- **Num. CPUs**  Shows the number of CPUs in use.
- **Num. threads**  Shows the number of threads being rendered.
- **mental ray version**  Shows the current mental ray renderer version, in detail.

The options beneath the messages area are equivalent to options on the mental ray Preferences dialog on page 8363.

**Information**  When on, the mental ray renderer generates information messages. Default=off.

This is equivalent to the preference, Show/Log Information Messages.

**Progress**  When on, the mental ray renderer generates progress messages. Default=off.

This is equivalent to the preference, Show/Log Progress Messages.
Debug (Output to File) When on, the mental ray renderer generates debug messages. Default=off. This is equivalent to the preference, Log Debug Messages (To File).

NOTE Debug messages are never displayed by the Messages Window. They are numerous, and would make it difficult to find or read other messages.

Open on Error When on, the Messages Window is displayed if the mental ray renderer logs an error message. Default=off. This is equivalent to the preference, Open Message Window On Error.

Clear Click to clear all messages from the messages area.

mental ray Concepts

These topics describe what the mental ray renderer can do, and explain how it accomplishes these effects. For more technical detail about mental ray capabilities, see the mental ray Reference, available from Help menu > Additional Help, and the books Programming mental ray and Rendering with mental ray, both by Thomas Driemeyer.

Ray-Traced Reflections and Refractions with the mental ray Renderer

The mental ray renderer can generate reflections and refractions by ray tracing. Ray tracing traces the path of rays sampled from the light source. Reflections and refractions generated this way are physically accurate.
Ray-traced reflections and Refractions

To reduce the time required to generate reflections and shadows, rays are limited by *trace depth*. Trace depth limits the number of times a ray can be reflected, refracted, or both.

You can turn off ray tracing. In this case, the mental ray renderer uses scanline rendering only. Turning off ray tracing makes the controls for all the effects that are specific to mental ray unavailable in the Renderer’s rollouts.

Ray tracing uses one of two ray-trace acceleration methods on page 8696.

You enable ray tracing and set trace depth with the Render Setup dialog > Renderer panel > Rendering Algorithms rollout on page 6741 controls.

**Shadows with the mental ray Renderer**

The mental ray renderer can generate shadows by ray tracing. Ray tracing traces the path of rays sampled from the light source. Shadows appear where rays have been blocked by objects. Ray-traced shadows have sharp edges.
Ray-traced shadows

Turning off caustics makes the outlines of shadows in this scene easier to see.

You can tell the mental ray renderer to use shadow maps on page 8719 instead of ray-traced shadows. This can improve performance at a cost of accuracy.

Shadow controls are on the Render Setup Dialog > Renderer panel > Shadows & Displacement rollout on page 6756.

Shadow Generators and the mental ray Renderer

Light objects in 3ds Max let you choose a shadow generator: Ray Traced, Advanced Ray Traced, Shadow Map, and so on. Because the mental ray renderer supports only two kinds of shadow generation, ray tracing and shadow maps, some of the 3ds Max shadow generators aren't fully supported.

In 3ds Max, a special shadow generator type, mental ray Shadow Map, is provided to support the mental ray renderer. If shadows are enabled (on the Shadows & Displacement rollout on page 6756 of the Render Setup dialog) but shadow maps are not enabled, then shadows for all lights are generated using the
mental ray ray-tracing algorithm. If shadow maps are enabled, then shadow generation is based on each light’s choice of shadow generator:

- **mental ray Shadow Map**  
  Shadows are generated using the mental ray shadow-map algorithm.

- **Shadow Map**  
  Settings on the Shadow Parameters rollout are translated into a mental ray equivalent before shadows are generated. The quality of shadows generated this way might not always meet expectations.

- **Area Shadows, Advanced Ray Traced Shadows, or Ray Traced Shadows**  
  Shadows are generated using the mental ray ray-tracing algorithm.

### Motion Blur with the mental ray Renderer

Motion blur is a way to enhance the realism of a rendered animation by simulating the way a real-world camera works. A camera has a shutter speed, and if significant movement occurs during the time the shutter is open, the image on film is blurred.

![Motion blur added to rendering of an animated wheel as it speeds up and rolls forward](image)
To render motion blur with the mental ray renderer, you must turn on ray tracing (the Ray Trace parameter) on the Render Setup dialog > Renderer panel > Rendering Algorithms rollout on page 6741.

The mental ray renderer uses a Shutter parameter to control motion blur. This simulates the shutter speed of a camera. At 0.0, there is no motion blurring. At 1.0, the maximum amount of motion blurring occurs. Values between zero and one adjust the amount of motion blur. The closer to 1.0, the greater the blurring.

You turn on motion blur and adjust shutter speed on the Render Setup Dialog > Renderer panel > Camera Effects rollout on page 6747.

If you render using shadow maps on page 8719, then by default mental ray applies motion blur to these as well. See the Render Setup dialog > Renderer panel > Shadows & Displacement rollout on page 6756.

**TIP** mental ray motion blur is not recommended for use with particle systems, as this can increase rendering time considerably. Use a Particle MBlur map on page 6308 instead.

**NOTE** Motion blur with the mental ray renderer does not always follow curving trajectories. Increasing the value of Motion Segments can help, but this works better for rotary motion than for traveling motion.

### Depth of Field with the mental ray Renderer

Depth of field is a way to enhance the realism of a rendering by simulating the way a real-world camera works. With a broad depth of field, all or nearly all of a scene is in focus. With a narrow depth of field, only objects within a certain distance from the camera are in focus.
Scene rendered using no depth of field
All apples are equally in focus.
Same scene using depth of field to control focus

The middle apple is clearer than the other two.

To render depth-of-field effects with mental ray, ray tracing (the Ray Trace toggle) must be enabled on the Render Setup dialog > Renderer panel > Rendering Algorithms rollout on page 6741. You must also enable depth of field for the camera: in the camera's Multi-Pass Effect group, choose “Depth Of Field (mental ray)” as the depth-of-field type. (If you choose the scanline renderer's Depth Of Field option, the rendering that results can be out of focus.)

The mental ray renderer uses the camera's target distance and f-Stop parameters to control the depth-of-field effect.

The camera's target distance determines the focus plane. The focus plane is the distance from the camera at which the scene is completely in focus.
Focus plane in relation to a camera

Here it is set to the middle apple, as in the previous renderings.
Focus plane in relation to a camera
Here it is set to the nearest apple, as in the renderings that follow.

The f-stop controls the amount of blurring at distances other than the focus plane distance. In a real-world camera, the f-stop measures the size of the lens’s aperture. The lower the f-stop value, the larger the aperture and the narrower the depth of field. So increasing the f-stop value broadens the depth of field, and decreasing the f-stop value narrows the depth of field.

Decreasing the f-stop to narrow depth of field
Focal plane set at the nearest apple, and f-stop set to 0.1.
Increasing the f-stop to broaden depth of field
Focal plane in same location, f-stop increased to 1.0.

You set the f-Stop in the camera’s Depth Of Field rollout. See Depth of Field Parameter (mental ray Renderer) on page 5589.

NOTE For Perspective viewports, which have no camera, the Render Setup dialog > Renderer panel > Camera Effects rollout on page 6747 has explicit Focus Plane and f-Stop settings.

**Caustic Lighting Effects**

*Caustics* are the effects of light cast onto an object via reflection off or refraction through another object.
Swimming pool rendered without caustics
Reflective caustics added to swimming pool

To calculate caustics, the mental ray renderer uses the photon map technique on page 8684. (Ray tracing can't generate accurate caustics, and they aren't provided by the default scanline renderer.)

You enable caustics on the Render Setup dialog > Indirect Illumination panel > Caustics And Global Illumination rollout on page 6773. In addition, you must designate:

■ Which light objects can create caustics.
■ Which renderable objects can generate caustics.
■ Which renderable objects can receive caustics.

The settings for generating and receiving caustics are on the Object Properties dialog > mental ray Panel on page 300.
Refractive caustics rendered with the default of Radius turned off.
Radius size is based on scene extents; specifically, 1/100 the radius of the full scene.
Radius value explicitly set to 1.0
Radius value increased to 2.5.
Filter type changed to Cone.
Photon count increased to 50,000 (in Global Light Properties group) for greater detail in the caustics.

Global Illumination with the mental ray Renderer

Global illumination enhances the realism in rendered images by simulating all light interreflection effects in a scene (except caustics on page 6700). It generates such effects as “color bleeding,” where for example, a white shirt next to a red wall appears to have a slight red tint.

The mental ray renderer offers two distinct toolsets for achieving global illumination: photon tracing on page 6775 and final gathering on page 6760. The primary difference between the two is that photon tracing goes from the light source toward the ultimate illuminated target (taking bounces into account), and final gathering goes the opposite way: from the illuminated surface toward the light source. You can use either of these toolsets separately, or combine them for optimal rendered results.
Scene rendered without global illumination
Same scene with global illumination
Global illumination made smoother by final gather

To calculate global illumination, the mental ray renderer uses the photon map technique on page 8684.

**NOTE** The mental ray renderer generates global illumination without requiring you to generate a radiosity solution. A photon map is a model of global illumination in its own right.

**NOTE** In order to use global illumination in mental ray, the photons must be able to bounce among two or more surfaces. This can be accomplished by having a single object with some concavity in its surface that’s exposed to the light source, or at least two objects, and at least one object must be set to receive global illumination (see mental ray Panel (Object Properties Dialog) on page 300). Otherwise you’ll receive error messages and no photons will be stored.

Using a photon map can cause rendering artifacts such as dark corners and low-frequency variations in the lighting. You can reduce or eliminate these artifacts by turning on final gathering on page 6760, which increases the number of rays used to calculate global illumination.

You enable global illumination on the Render Setup dialog > Indirect Illumination panel > Caustics And Global Illumination rollout on page 6771,
and final gathering on the Final Gather rollout on page 6760. In addition, you must designate:

- Which light objects can generate global illumination.
- Which renderable objects can generate global illumination.
- Which renderable objects can receive global illumination.

The settings for generating and receiving global illumination are on the Object Properties dialog > mental ray Panel on page 300. By default, all objects in 3ds Max are set to generate and receive global illumination.

**mental ray Volume Shading**

Volume shading shades a three-dimensional volume, rather than a surface. Typically, volume shaders provide atmospheric effects such as mist and fog.
There are two ways to assign a volume shader:

- To a camera
  This effectively makes the entire scene a single volume.

- To a material
  This makes a volume out of objects to which the material is applied.
  Usually when you assign a volume shader to a material, you want to make its surface transparent so the shading within the volume is visible. You can do this with the mental images Transmat shader.

To assign a volume shader to a camera, use the Render Setup dialog. To assign a volume shader to a material, use the material's Volume shader component. This component is found on the mental ray Connection rollout on page 5763, and in the mental ray material on page 5951 itself. See the “Procedures” that follow.
Procedures

To apply volume shading to a camera:

1. On the main toolbar, click Render Setup.
   If the active renderer is not already the mental ray renderer, go to the Common panel, and on the Assign Renderer rollout, click the “…” button for the Production renderer. A Choose Renderer dialog is displayed. Highlight “mental ray Renderer” in the list, and then click OK.

2. Click the Renderer tab to go to the Renderer panel. On the Camera Effects rollout, find the Camera Shaders group, and click Volume. The Material/Map Browser on page 5724 is displayed.

3. Choose a volume shader from the list in the Browser, and then click OK.

To apply volume shading to an object:

1. Choose Customize > Preferences. Go to the mental ray panel, and turn on Enable Mental Ray Extensions.

2. On the main toolbar, click Render Setup.
   If mental ray is not already the active renderer, go to the Common panel, and on the Assign Renderer rollout, click the “…” button for the Production renderer. The Choose Renderer dialog opens. Highlight “mental ray Renderer” in the list and then click OK.
   Leave the Render Setup dialog open, or minimize it.

3. Open the Material Editor. Use the mental ray Connection rollout on page 5763 to assign a volume shader to the Volume component. Another technique would be to use the mental ray material on page 5951, and assign a shader to the Volume component.

4. Also on the mental ray Connection rollout, click the lock button to unlock the Surface component. Click the shader button (“None”) and use the Browser to assign the Transmat (physics) shader to the surface. (If you are using the mental ray material, you don’t need to first unlock the Surface component.)
mental ray Displacement

Displacement shading with the mental ray renderer is similar to displacement mapping on page 6059 of standard materials. One advantage of using mental ray displacement is that the additional polygons of displaced surfaces are stored only in the mental ray scene database, not in your 3ds Max scene, so they do not increase the memory requirements of your scene, except at render time. This can be a big improvement in performance over displacement mapping with standard materials and the scanline renderer.

Procedures

To add displacement to a mental ray rendering:

1. Choose Customize > Preferences. Go to the mental ray panel, and turn on Enable Mental Ray Extensions.

2. On the main toolbar, click Render Setup.
   If the active renderer is not already the mental ray renderer, go to the Common panel, and on the Assign Renderer rollout, click the “…” button for the Production renderer. A Choose Renderer dialog is displayed. Highlight “mental ray Renderer” in the list, and then click OK. Leave the Render Setup dialog open, or minimize it.

3. Open the Material Editor.

4. On the mental ray Connection rollout, click the lock button to unlock the Displacement component. Click the shader button (“None”) and use the Browser to assign a displacement shader to the surface.

   WARNING  This overrides any displacement assigned to the base material as a standard map.

Another technique would be to use the mental ray material on page 5951, and assign a shader to the Displacement component. (If you are using...
the mental ray material, you don’t need to first unlock the Displacement component.)

5 Apply the material to objects you wish to show the displacement.

mental ray Contour Shading

Contour shading lets you render vector-based contour lines. Contours are similar to the ink component on page 6142 of the Ink ’n Paint material.

Model rendered without contours
You add contour rendering by assigning one of the contour shaders to the Contour component of a material. This component is found on the mental ray Connection rollout on page 5763 of most materials and on the mental ray material's Advanced Shaders rollout on page 5958. Then when you render, use the Contours group on page 6752 controls on the Camera Effects rollout on page 6747 to enable contours.

On the Camera Effects rollout, additional shaders can modify the contours, or control how they are rendered. For example, to render only the contours, but not the shaded model, assign a Contour Only shader to the Contour Output component.
Contours Only output shader, background set to white

**NOTE** Contour shading does not work with distributed bucket rendering.

**Procedures**

**To add contours to a mental ray rendering:**

1. Choose Customize > Preferences. Go to the mental ray panel, and turn on Enable Mental Ray Extensions.

2. On the main toolbar, click Render Setup.
   If mental ray is not already the the active renderer, go to the Common panel, and on the Assign Renderer rollout, click the “...” (Choose Renderer) button for the Production renderer. The Choose Renderer dialog opens. Highlight “mental ray Renderer” in the list, and then click OK.
   Leave the Render Setup dialog open, or minimize it.

3. Open the Material Editor. For the materials of objects you want to render with contours, use the mental ray Connection rollout on page 5763 to assign a shader to the Contour component.
   Another technique would be to use the mental ray material on page 5951, and assign shaders to both the Surface and Contour components.
   **TIP** The Simple contour shader renders uniform lines whose color and width you can control. The other contour shaders provide variant contour styles with more direct user controls.

4. On the Render Setup dialog, go to the Renderer panel. On the Camera Effects rollout, turn on Enable in the Contours group.
   To simply add contour lines to a rendering, leave the shaders in the Camera Effects rollout set to their defaults. For other options, see Camera Effects Rollout (mental ray Renderer) on page 6747.

**Combi Contour Shader**

mental ray material > Advanced Shaders rollout > Click Contour button. > Choose Combi (contour).
Other material > mental Ray Connection rollout > Advanced Shaders group > Unlock Contour if necessary. > Click Contour button. > Choose Combi (contour).

The Combi contour shader is a combination of the Depth Fade on page 6720, Layer Thinner on page 6723, and Width from Light on page 6727 shaders.

**TIP** Use a Tape helper object on page 2855 to determine the Z depth of your view.

The following illustration shows a blue line crossing the glass pane held by the character. This blue line is the reflection of the edge of the floor, behind the camera.

![Illustration of blue line crossing glass pane](image)

The line is blue (Near Color), because the distance considered is not the distance of the eye ray bouncing in the glass; rather, it is the distance between the camera and the edge itself.
Interface

Near Z The minimum distance.
Near Color The color of the contour at and below the minimum distance.
Near Width (%) The width at and below the minimum distance.
Far Z The maximum distance.
Far Color The color of the contour at and beyond the maximum distance.
Far Width (%) The width at and beyond the maximum distance.
Depth Factor The factor for thinning the contour at each layer.
   For example, to get contours that are 2 percent wide when the material is on top, 1 percent wide when the material is behind one other (semitransparent) material, 0.5 percent wide when the material is behind two materials, and so on, set Width (%) to 2.0 and Depth Factor to 0.5.
Light To specify a scene light source for use in determining contour thickness, click this button and then select a light. After you specify a light, its name appears on the button.
   To remove the specified light source from the shader's influence, click the Clear button.
Light Min Width Factor The minimum factor by which the light-dependency decreases the contour width.
For example, for contours that are interpolated between 2 percent wide at the Near Z distance and 1 percent wide at the Far Z distance, and get half as wide for each layer of material beyond Far Z, and where the width also depends on the direction to the specified light source, set Light Min Width Factor to 0.5.

**Curvature Contour Shader**

mental ray material > Advanced Shaders rollout > Click Contour button. > Choose Curvature (contour).

Other material > mental Ray Connection rollout > Advanced Shaders group > Unlock Contour if necessary. > Click Contour button. > Choose Curvature (contour).

The Curvature contour shader traces a line whose thickness depends on the angle between normals of adjacent faces.

So if two normals are in nearly opposite directions, there is a contour of width close to Max Width between them. As the angle between them decreases, the width of the contour decreases almost to Min Width.
Interface

![Curvature (contour) Parameters](image)

**Color** The color used for rendering the contour lines.

**Min Width (%)** The minimum contour width, in percent of the image size.

**Max Width (%)** The maximum contour width, in percent of the image size.

### Depth Fade Contour Shader

mental ray material > Advanced Shaders rollout > Click Contour button. > Choose Depth Fade (contour).

Other material > mental Ray Connection rollout > Advanced Shaders group > Unlock Contour if necessary. > Click Contour button. > Choose Depth Fade (contour).

The Depth Fade contour shader changes the line width and color based on Z depth, in world units.

If a contour point is more distant than Far Z, the contour gets color Far Color and the width gets Far Width. If a point is nearer than Near Z, the contour gets color Near Color and the width gets Near Width. If the depth is in between, the color and width are linearly interpolated.

**TIP** Use a Tape helper object on page 2855 to determine the Z depth of your view.
Interface

Near Z The minimum distance.
Near Color The color of the contour at and below the minimum distance.
Near Width (%) The width at and below the minimum distance.
Far Z The maximum distance.
Far Color The color of the contour at and beyond the maximum distance.
**Far Width (%)** The width at and beyond the maximum distance.

**Factor Color Contour Shader**

mental ray material > Advanced Shaders rollout > Click Contour button. > Choose Factor Color (contour).

Other material > mental Ray Connection rollout > Advanced Shaders group > Unlock Contour if necessary. > Click Contour button. > Choose Factor Color (contour).

The Factor Color shader uses the color of the material as rendered by mental ray, as opposed to the diffuse color.

In the following illustration, the materials are all self-illuminating to ensure a constant color. The shader does the rest.
Interface

Factor The multiplier for the material color. If the factor is 0, a black contour results. If the factor is between 0 and 1, a dark contour of the same hue as the material results. If the factor is 1, the contour gets the same color as the material at that location. If the factor is larger than 1, brighter contours of the same hue as the material result.

Width (%) The contour width as a percent of the image size.

Layer Thinner Contour Shader

mental ray material > Advanced Shaders rollout > Click Contour button. > Choose Layer Thinner (contour).

Other material > mental Ray Connection rollout > Advanced Shaders group > Unlock Contour if necessary. > Click Contour button. > Choose Layer Thinner (contour).

The Layer Thinner bases the contour lines' thickness on the trace depth as determined by the Contour Contrast Function Levels shader.

In the following illustration, the glass pane is semi-transparent. The shader detects that situation and makes the lines thinner when they are drawn inside the glass pane.
Interface

Color The color used for rendering the contour lines.

Width (%) The thickness of the contour lines at the top layer.

Depth Factor The factor for thinning the contour at each layer.

For example, to get contours that are 2 percent wide when the material is on top, 1 percent wide when the material is behind one other (semitransparent) material, 0.5 percent wide when the material is behind two materials, and so on, set Width (%) to 2.0 and Depth Factor to 0.5.
Simple Contour Shader

mental ray material > Advanced Shaders rollout > Click Contour button. > Choose Simple (contour).

Other material > mental Ray Connection rollout > Advanced Shaders group > Unlock Contour if necessary. > Click Contour button. > Choose Simple (contour).

The Simple contour shader draws all lines the same width.

Interface

<table>
<thead>
<tr>
<th>Simple (contour) Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color</td>
</tr>
</tbody>
</table>

Color The color used for rendering the contour lines.

Width (%) The relative thickness of the contour lines.
**Width from Color Contour Shader**

mental ray material > Advanced Shaders rollout > Click Contour button. > Choose Width from Color (contour).

Other material > mental Ray Connection rollout > Advanced Shaders group > Unlock Contour if necessary. > Click Contour button. > Choose Width from Color (contour).

The Width from Color shader bases the thickness of contours on the brightness of the color of your materials. The brighter the color, the thinner the contour.

**IMPORTANT** The color used by the shader is not the diffuse color of the material, but instead the rendered color, so lighting has an influence here.

Although the name of the shader uses the word "Color," it would be probably more appropriate to call this shader "Width from Brightness," because only the brightness of a color is taken in consideration.
Interface

Color The color used for rendering the contour lines.

Min Width (%) The relative thickness of the thinnest contour lines, where rendered material colors are brightest.

Max Width (%) The relative thickness of the thickest contour lines, where rendered material colors are darkest.

**Width from Light Contour Shader**

mental ray material > Advanced Shaders rollout > Click Contour button. > Choose Width from Light (contour).

Other material > mental Ray Connection rollout > Advanced Shaders group > Unlock Contour if necessary. > Click Contour button. > Choose Width from Light (contour).

The thickness of contours generated by the Width from Light shader are based on the direction of a light you can specify in your scene.
Light source is on the left side of the scene.

**Interface**

<table>
<thead>
<tr>
<th>Width From Light (contour) Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color</td>
</tr>
<tr>
<td>Min Width (%)</td>
</tr>
<tr>
<td>Max Width (%)</td>
</tr>
<tr>
<td>Light</td>
</tr>
</tbody>
</table>

**Color** The color used for rendering the contour lines.

**Min Width (%)** The relative thickness of the thinnest contour lines, where illumination is brightest.

**Max Width (%)** The relative thickness of the thickest contour lines, where illumination is darkest.
Light

To specify a scene light source for use in determining contour thickness, click this button and then select a light. After you specify a light, its name appears on the button.

To remove the specified light source from the shader’s influence, click the Clear button.

**Width from Light Direction Contour Shader**

mental ray material > Advanced Shaders rollout > Click Contour button. > Choose Width from Light Dir (contour).

Other material > mental Ray Connection rollout > Advanced Shaders group > Unlock Contour if necessary. > Click Contour button. > Choose Width from Light Dir (contour).

The Width from Light Dir shader modifies the thickness of contours based on the direction specified by a "virtual light vector" as defined in the shader. The virtual light is used only to calculate the contours; it does not affect the scene in any other way.

The virtual light direction is controlled by the Light Direction value. It’s a vector parameter, which means it has three value fields, which correspond to the world X, Z, and Y axes, respectively. For example, the following illustration comprises three separate renders, in which Light Direction is set to (1,0,0), (0,1,0), and (-1,0,0), respectively.

Left to right: Light Direction=(1,0,0);(0,1,0);(-1,0,0)
Interface

Color  The color used for rendering the contour lines.

Min Width (%)  The relative thickness of the thinnest contour lines, where illumination from the virtual light is brightest.

Max Width (%)  The relative thickness of the thickest contour lines, where illumination from the virtual light is darkest.

Light Direction  Use these three vector fields to specify the position of the virtual light shines for defining the relative contour thickness. The first field specifies the world X axis; the second, the world Z axis; and the third specifies the world Y axis. For example, to have the light shining from the right, so that the contour lines are thinnest on the right side of scene objects as viewed from the front, set Light Direction to (1,0,0). A negative number reverses the position, so using (-1,0,0) would position the light on the left side.

mental ray Renderer Interface

Render Setup dialog on page 6506 > Renderer panel/Indirect Illumination panel/Processing panel

Topics in this section cover the Render Setup dialog panels that are specific to mental ray rendering.

For information on the common rendering panels, see:

- Common Panel (Render Setup Dialog) on page 6568
- Render Elements Panel and Rollout on page 6807
Renderer Panel (mental ray)

Render Setup dialog on page 6506 > Renderer panel

Note: The Renderer panel appears only when mental ray is the active renderer.
The Renderer panel includes settings for optimizing mental ray rendering as well as controls for camera effects, shadows, and displacement shading.

Global Tuning Parameters Rollout (mental ray Renderer)

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Renderer panel > Global Tuning Parameters rollout

Note: The Global Tuning Parameters rollout appears only when the mental ray renderer is the currently active renderer.

The Global Tuning Parameters parameters give you high-level control of the quality of mental ray shaders for soft shadows, glossy reflections, and glossy refractions. These controls let you adjust overall rendering quality without having to modify individual light and material settings. In general, lowering a global tuning parameter value decreases rendering time, and raising it increases rendering time.

WARNING Because these parameters act as multipliers, certain combinations of global tuning settings and the values they modify can yield non-useful results. For example, if the Reflection > Glossy Samples setting in an Arch & Design material is 8 and you set Glossy Reflections Precision to 0.1, the result is a Glossy Samples value of 0.8, which is equivalent to 0, thus turning off glossiness and producing mirror reflections.

You can find an example of these controls in use in the following illustration, which contains three separate renderings. In each image, each goblet contains an Arch & Design material using the Chrome template. All Chrome settings are the defaults, except the Reflection > Glossiness settings were changed to 0.6, 0.4, and 0.2 respectively (from left to right), and the Reflection > Glossy Samples settings were all changed to 8. For the renderings, Glossy Reflections Precision was set to 0.25, 1.0, and 5.0, respectively (from top to bottom). The highest-quality rendering took 15 times longer than the lowest-quality.
Glossy Reflections Precision affects all Arch & Design materials in the scene.

**Interface**

![Interface Image]

**Soft Shadows Precision** A global multiplier for the Shadow Samples setting (or similar-named, as noted following) in all lights casting soft shadows. This includes all photometric lights on page 5348 (Target Light, Free Light, mr Sky Portal), as well as mr Sun on page 5524 (Softness Samples), mr Area Omni on page 5418 (Samples), and mr Area Spot on page 5421 (Samples). Typically the light
should be set to cast ray-traced shadows, when available, although in some cases shadow maps work too.

Possible multiplier values are 0.125, 0.25, 0.5, 1, 2, 4, 8, and 16.

The following illustration comprises three separate renders of a scene containing two photometric spotlights and two cylinders. Both spotlights have disc-shaped emitters of radius 10.0 and cast ray-traced shadows, but the one on the left has Shadow Samples set to 64 while the one on the right has Shadow Samples set to 8. From top to bottom, the scenes were rendered with Soft Shadows Precision set to 0.125, 1.0, and 4.0, respectively.

Soft Shadows Precision affects all lights casting soft shadows in the scene.
NOTE This setting adjusts each light’s Shadow Samples setting temporarily for rendering purposes only; it does not change the actual setting. For example, if the scene contains three lights with Shadow Samples settings of 64, 32, and 8, and you set Soft Shadows Precision to 0.5, the resultant values as rendered will be 32, 16, and 4. However, the original settings remain intact, and are used for rendering purposes when you set Soft Shadows Precision back to the default 1.0.

The equivalent Render Frame Window control is the Soft Shadows Precision on page 6525 slider, with one exception: This control, unlike the slider, does not disable soft shadows at its lowest value.

Glossy Reflections Precision Controls reflection quality globally.

Glossy Reflections Precision determines the quality of reflections in all instances of the Arch & Design material on page 5858 and related materials in the scene. The value acts as a multiplier to each material’s Reflection group > Glossy Samples on page 5863 setting. This setting is also available for most ProMaterials on page 5772 on the Performance Tuning Parameters rollout on page 5857.

NOTE This setting adjusts each material’s Glossy Samples setting temporarily for rendering purposes only; it does not change the materials. For example, if the scene contains three Arch & Design materials with Reflection > Glossy Samples settings of 32, 20, and 8, and you set Glossy Reflections Precision to 0.5, the resultant values as rendered will be 16, 10, and 4. However, the original material settings remain intact, and are used for rendering purposes when you set Glossy Reflections Precision back to the default 1.0.

The equivalent Render Frame Window control is the Glossy Reflections Precision on page 6526 slider, with one exception: This control, unlike the slider, does not disable reflections at its lowest value.

Glossy Refractions Precision Controls refraction quality globally.

Glossy Refractions Precision determines the quality of refractions in all instances of the Arch & Design material on page 5858 and related materials in the scene. The value acts as a multiplier to each material’s Refraction group > Glossy Samples on page 5866 setting. This setting is also available for some ProMaterials on page 5772 on the Performance Tuning Parameters rollout on page 5857.
NOTE This setting adjusts each material’s Glossy Samples setting temporarily for rendering purposes only; it does not change the materials. For example, if the scene contains three Arch & Design materials with Refraction > Glossy Samples settings of 32, 20, and 8, and you set Glossy Refractions Precision to 0.5, the resultant values as rendered will be 16, 10, and 4. However, the original material settings remain intact, and are used for rendering purposes when you set Glossy Refractions Precision back to the default 1.0.

The equivalent Render Frame Window control is the Glossy Refractions Precision on page 6526 slider, with one exception: This control, unlike the slider, does not disable refraction at its lowest value.

### Sampling Quality Rollout (mental ray Renderer)

Render Setup dialog on page 6506 > Renderer panel > Sampling Quality rollout

Note: The Sampling Quality rollout appears only when the mental ray renderer is the currently active renderer.

The controls on this rollout affect how the mental ray renderer performs sampling on page 8705 for antialiasing rendered images.

### Procedures

#### To use low sampling for previews:

- Leave the Minimum and Maximum values at their default settings of 1/4 and 4, or reduce them to 1/16 and 1/4.

  **TIP** Do not assign Minimum and Maximum the same value.

#### To use high sampling for final renderings:

- Increase the Minimum and Maximum values to 4 and 16, respectively, or to higher values.

  **TIP** Do not assign the same value to both Minimum and Maximum.

#### To view the sampling pattern:

- On the Diagnostics rollout on page 6795, choose Sampling Rate, then render the scene.
Instead of rendering the image, mental ray draws a diagram that shows the range of applied sampling values. White lines indicate edges in the scene, where the mental ray renderer took the maximum number of samples. If fractional sample limits are used (sampling down), lighter dots indicate the higher value while darker dots indicate the lower value.

To assist with analysis, View Samples also draws red lines around each bucket, or separately rendered block.

When the Minimum and Maximum number of samples are equal, the diagram shows all buckets as white.

**Interface**

![Interface](image)

**Samples per Pixel group**

Set the minimum and maximum sample rates for antialiasing the rendered output.

**NOTE** Presets for several sample rate combinations are available on the Rendered Frame Window as the Image Precision (Antialiasing) slider on page 6525.

**Minimum** Sets the minimum sample rate. The value represents the number of samples per pixel. A value greater than or equal to 1 indicates that one or more samples are computed per pixel. A fractional value indicates that one sample is computed for every N pixels (for example, 1/4 computes a minimum of one sample for every four pixels). Default=1/4.
**Maximum** Sets the maximum sample rate. If neighboring samples find a difference in contrast that exceeds the contrast limit, the area containing the contrast is subdivided to the depth specified by Maximum. Default=4.

The values of the Minimum and Maximum lists are "locked" together so that the value of Minimum can't exceed the value of Maximum.

**Filter group**

**Filter type** Determines how multiple samples are combined into a single pixel value. Can be set to Box, Gauss, Triangle, Mitchell, or Lanczos. Default=Box.

**TIP** For most scenes the Mitchell filter gives the best results.

- **Box filter:** Sums all samples in the filter area with equal weight. This is the quickest sampling method.
- **Gauss filter:** Weights the samples using a Gauss (bell) curve centered on the pixel.
- **Triangle filter:** Weights the samples using a pyramid centered on the pixel.
- **Mitchell filter:** Weights the samples using a curve (steeper than Gauss) centered on the pixel.
- **Lanczos filter:** Weights the samples using a curve (steeper than Gauss) centered on the pixel, diminishing the effect of samples at the edge of the filter area.

**Width and Height** Specify the size of the filtered area. Increasing the value of Width and Height can soften the image, however it will increase rendering time.

Default=Depends on the Filter type you choose:

- **Box filter:** Width=1.0, Height=1.0
- **Gauss filter:** Width=3.0, Height=3.0
- **Triangle filter:** Width=2.0, Height=2.0
- **Mitchell filter:** Width=4.0, Height=4.0
- **Lanczos filter:** Width=4.0, Height=4.0
Spatial Contrast group

This control sets the contrast value used as thresholds to control sampling. Spatial contrast applies to each still image.

If neighboring samples in a frame differ by more than this color, the mental ray renderer does recursive supersampling (that is, more than one sample per pixel), up to the depth specified by the Maximum samples per pixel on page 6737 value. Increasing the Spatial Contrast values decreases the amount of sampling done, and can speed the rendering of a scene at the cost of image quality.

- **R, G, B** Specify the threshold values for the red, green, and blue components of samples. These values are normalized, and range from 0.0 to 1.0, where 0.0 indicates the color component is fully unsaturated (black, or 0 in eight-bit encoding) and 1.0 indicates the color component is fully saturated (white, or 255 in eight-bit encoding). Default=(0.05, 0.05, 0.05).

- **A** Specifies the threshold value for the alpha component of samples. This value is normalized, and ranges from 0.0 (fully transparent, or 0 in eight-bit encoding) to 1.0 (fully opaque, or 255 in eight-bit encoding). Default=0.05.

- **[color swatch]** Click to display a Color Selector on page 371 to let you specify the R, G, and B threshold values interactively.

Options group

**Lock Samples** When on, the mental ray renderer uses the same sampling pattern for every frame of an animation. When off, the mental ray renderer introduces a quasi-random (Monte Carlo) variation in the sample pattern from frame to frame. Default=on.

Varying the sample pattern reduces rendering artifacts in animations.

**Jitter** Introduces a variation into sample locations; see Sampling on page 8705. Turning on Jitter can help reduce aliasing. Default=on.

**Bucket Width** Determines the size of each bucket in pixels. Range=4 to 512 pixels. Default=48 pixels.

To render the scene, the mental ray renderer subdivides the image into rectangular sections, or “buckets.” Using a smaller bucket size causes more image updates to be generated during rendering. Updating the image consumes a certain amount of CPU cycles. For scenes with little complexity, smaller buckets can increase the rendering time, while larger buckets can make things render faster. For more complex scenes, the reverse is true.
**Bucket Order** Lets you specify the method by which mental ray chooses the next bucket. If you are using placeholders or distributed rendering, use the default Hilbert order. Otherwise, choose a method based on how you prefer to see the image appear as it renders in the Rendered Frame Window.

- **Hilbert (best)** (The default.) The next bucket chosen is the one that will trigger the fewest data transfers.

  **TIP** Always use Hilbert order when you use placeholders (see the Translator Options rollout on page 6787) or distributed rendering (see the Distributed Bucket Rendering rollout on page 6797).

- **Spiral** The buckets begin at the center of the image, and spiral outward.

- **Left to right** Buckets are rendered in columns, from bottom to top, left to right.

- **Right to left** Buckets are rendered in columns, from bottom to top, right to left.

- **Top-down** Buckets are rendered in rows, from right to left, top to bottom.

- **Bottom-up** Buckets are rendered in rows, from right to left, bottom to top.

**Frame Buffer Type** Lets you choose the bit depth of the output frame buffer:

- **Integer (16 bits per channel)** Outputs 16 bits per channel of color information. This is the default output format.

- **Floating-Point (32 bits per channel)** Outputs 32 bits per channel of color information. This method supports high-dynamic-range imagery (HDRI).
NOTE When you render an image with floating-point, 32-bit output, you might see jagged edges in bright areas such as self-illuminated objects or reflections of light sources. The reason is that in floating-point rendering, the brightness of a pixel can be greater than 1 ("whiter than white," so to speak).
Above: In a 16-bit rendering, bright highlights are muted.

Below: In a 32-bit rendering, bright highlights (on the lamp chains and the mirror), are strong and jagged.

For example, suppose a pixel is sampled four times, and an object occludes the pixel one of those times. In a 16-bit rendering, this results in a 25 percent grayscale value for the pixel. The same thing happens in a 32-bit rendering, unless the object is bright. In that case, the pixel might be 20 times brighter than its surroundings, so the result does not blend into its surroundings, and the rendered highlight appears to be jagged or “aliased.” While this effect is apparent in the 3ds Max Rendered Frame Window, it is only apparent: if you use the image in a compositing program that handles HDRI images, for example, or open it and adjust its levels in an image-processing program such as Photoshop, the image appearance will be correct.

---

**Rendering Algorithms Rollout (mental ray Renderer)**

*Render Setup dialog on page 6506 > Renderer panel > Rendering Algorithms rollout*

The controls in this rollout let you choose whether to render using ray-tracing, scanline rendering, or both. You can also choose the method used to accelerate ray-tracing.

The Trace Depth controls the number of times each ray can be reflected, refracted, or both.

**Procedures**

**To set trace depth for reflections and refractions:**

1. Count the number of times you want an object to be reflected or refracted in the scene.

2. On the mental ray: Rendering Algorithms rollout, turn on Enable Reflections and enable Refractions.

3. Set Max. Reflections to the number of reflections you want, and Max. Refractions to the number of refractions you want.
4 Set Max. Trace Depth to the sum of the values for Max Reflections and Max Refractions.

The greater the number of reflections and refractions, the more slowly your scene will render. On the other hand, too low a value for Max. Reflections or Max. Refractions (or Max. Trace Depth, controlling both) can make your rendering look unrealistic.

Interface

By default, both Scanline and Ray Tracing are enabled, which lets the mental ray renderer use the two methods in combination to render the scene. Scanline
rendering is used for direct illumination (“primary rays”) only; ray tracing is
used for indirect illumination (caustics and global illumination) as well as
depth of field, or indirect lighting. Default=on.

Use Fast Rasterizer (Rapid Motion Blur) When on, uses a fast rasterizer
method to generate the first generation of rays to trace. This can improve
rendering speed. Default=off.

This option works well with object motion blur, and also with scenes that
have no motion blur.

The following settings are available for the fast rasterizer:

■ Samples per Pixel Controls the number of samples per pixel used by the
  fast rasterizer method. More samples result in greater smoothness, at a cost
  of render time. Range=1 to 225. Default=16.

■ Shades per Pixel Controls the approximate number of shading calls per
  pixel. Greater values result in more accurate renderings, at a cost of render
  time. Range=0.1 to 10000 (ten thousand). Default=2.0.

NOTE mental ray provides a Time Samples setting specifically for motion blur in
the fast rasterizer. When Use Fast Rasterizer is on, the Camera Effects rollout >Time
Samples on page 6751 label changes to Time Samples (Fast Rasterizer) to indicate
that this version of Time Samples is now in effect.

Ray Tracing group

Enable When on, mental ray uses ray tracing to render reflections, refractions,
lens effects (motion blur and depth of field), and indirect lighting (caustics
and global illumination). When off, the renderer uses the scanline method
only. Ray tracing is slower but more accurate and more realistic. Default=on.

To render reflections, refractions, depth of field, and indirect lighting (caustics
and global illumination), Ray Tracing must be enabled.
**Use Autovolume** When on, uses the mental ray *autovolume* mode. This lets you render nested or overlapping volumes such as the intersection of two spotlight beams. Autovolume also allows a camera to move through the nested or overlapping volumes. Default=off.

To use Autovolume, Ray Trace must be on, Scanline must be off, and the shadow mode must be set to Segments. (You set the shadow mode on the Shadows And Displacement rollout on page 6756.) If these conditions aren’t met when you click to turn on Autovolume, an alert warns you about this, and gives you the option of making the appropriate setting changes.

### Raytrace Acceleration Group

**Method** The drop-down list sets which algorithm to use for raytrace acceleration on page 8696. The other controls in this group box change, depending on which acceleration method you choose. These are the alternatives:

- **BSP**
  - (The default.) The BSP method has Size and Depth controls. See Ray-Trace Acceleration: Parameters for the BSP Method on page 6746.
  - This method is the fastest on a single-processor system. Use it for small-to-medium size scenes (less than one million triangles) on a single processor. BSP is also the best method to use when ray tracing is turned off.

- **BSP2**
  - The BSP2 method is configured automatically by mental ray and has no controls. This method is optimized for large scenes containing more than a million triangles.
  - BSP2 requires less memory than BSP and is able to flush memory when necessary. However, there could be a small performance loss when using it with smaller scenes.

### Reflections/Refractions group

Trace depth controls the number of times a light ray can be reflected or refracted. At 0, no reflection or refraction occurs. Increasing these values can increase the complexity and realism of a scene, at a cost of greater rendering time.
TIP In some cases, you might want to set Max. Refractions high and Max. Reflections low. For example, you might have the camera looking through several glasses that are lined up, so they're overlapping from the camera's point of view. In this situation, you might want the light rays to refract twice for each glass (once for each layer), so you'd set Max. Refractions to 2 x [number of glasses]. However, to save rendering time, you could set Max. Reflections to 1, resulting in accurate multi-layer refraction with a relatively fast rendering time.

Max. Trace Depth Limits the combination of reflection and refraction. Tracing of a ray stops when the total number of reflections and refractions reaches the Max. Trace Depth. For example, if Max. Trace Depth is set to 3 and the two trace depths are both set to 2, a ray can be reflected twice and refracted once, or vice-versa, but it can’t be reflected and refracted four times. Default=6.

Enable Reflections When on, mental ray traces reflections. Turn off to improve performance when you don’t require reflections.

This control is also available on the Rendered Frame Window > lower panel, as the leftmost position of the Glossy Reflections Precision on page 6526 slider.

Max. Reflections Sets the number of times a ray can be reflected. At 0, no reflection occurs. At 1, the ray can be reflected once only. At 2, the ray can be reflected twice, and so on. Default=4.

This control is also available on the Rendered Frame Window > lower panel, as the Max. Reflections on page 6527 parameter.

Enable Refractions When on, mental ray traces refraction. Turn off to improve performance when you don’t require refraction.

This control is also available on the Rendered Frame Window > lower panel, as the leftmost position of the Glossy Refractions Precision on page 6526 slider.

Max. Refractions Sets the number of times a ray can be refracted. At 0, no refraction occurs. At 1, the ray can be refracted once only. At 2, the ray can be refracted twice, and so on. Default=6.

This control is also available on the Rendered Frame Window > lower panel, as the Max. Refractions on page 6527 parameter.

These controls are also available on the Rendered Frame Window, as Include In Render > Refractions and Max on page 6526.

Subset Pixel Rendering group

Render changes to selected objects only When on, rendering the scene applies only to selected objects. Unlike using the Selected on page 6544 option for rendering, however, using this option takes into account all scene elements
that affect its appearance. This includes shadows, reflection, direct and indirect lighting, and so on. Also, unlike Selected, which replaces the entire contents of the Rendered Frame Window (except for selected objects) with the background color, this option replaces only pixels used by the re-rendered selected objects.

Subset pixel rendering is particularly useful when performing iterative rendering and refinement of lighting, shadows, and other scene elements for a particular object or set of objects in the scene. It lets you re-render repeatedly to view the results of isolated changes without disturbing the rest of the rendered output.

This setting is also available on the Rendered Frame Window, as Subset Pixels (of selected objects) on page 6517.

**Ray-Trace Acceleration: Parameters for the BSP Method**

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Renderer panel > Rendering Algorithms rollout > Raytrace Acceleration group > Choose BSP as the Raytrace Acceleration method.

When you choose BSP as the Raytrace Acceleration method on the Rendering Algorithms rollout on page 6741, the parameters described here are displayed. BSP stands for Binary Space Partitioning.

**NOTE** If the scene contains too many faces (triangles) to fit in a tree of the size specified by the Size and Depth parameters, mental ray disregards the Size value and creates larger leaf nodes. This can significantly slow down rendering. To avoid this problem, increase the value of Depth.

**Interface**

![Interface Diagram](image)

**Size** Sets the maximum number of faces (triangles) in the leaf of a BSP tree. Increasing the Size value reduces memory consumption but increases rendering time. Default=10.
**Depth** Sets the maximum number of levels in the BSP tree. Increasing the Depth value reduces rendering time, but increases memory consumption and preprocessing time. Default=40.

**TIP** For large scenes, increasing the Depth value to 50 or more can greatly improve rendering time.

---

**Camera Effects Rollout (mental ray Renderer)**

*Render Setup dialog* on page 6506 > Renderer panel > Camera Effects rollout

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Renderer panel > Camera Effects rollout

Note: The Camera Effects rollout appears only when the mental ray renderer is the currently active renderer.

The controls in this rollout are for the camera effects depth of field on page 6694 and motion blur on page 6693, as well as for contour shading on page 6714 and adding camera shaders.

**Procedures**

**To use depth of field for a Camera view:**

1. On the camera’s Parameters rollout, in the Multi-Pass Effect group, turn on Enable and choose Depth Of Field (mental ray).
2. Set the camera’s target distance to the range at which you want objects to be clearly in focus. For a Target camera, you can select the camera’s target object and move it. For a Free camera, you adjust the Target Distance on the Parameters rollout.
3. On the Camera’s Depth Of Field rollout, decrease the f-Stop value to narrow the depth of field, or increase the f-Stop value to broaden the depth of field. You might need to experiment with f-Stop values to get the effect you want.
4. Render the scene.
To use depth of field for a Perspective view:

1. On the Render Setup dialog, go to the Renderer panel > Camera Effects rollout, and in the Depth Of Field (Perspective Views Only) group, turn on Enable.

2. Set the Focus Plane distance to the range at which you want objects to be clearly in focus.

3. Decrease the f-Stop value to narrow the depth of field, or increase the f-Stop value to broaden the depth of field.
   You might need to experiment with f-Stop values to get the effect you want. If you have trouble getting good results with f-Stop, use the drop-down list to change the method to In Focus Limits, then adjust the Near and Far values to enclose the region of the scene you want to be clearly in focus.

4. Render the scene.

To use motion blur:

1. Select each object you want to be blurred by motion, right-click and choose Properties, then on the Object Properties dialog > General panel, make sure that in the Motion Blur group, Enable is turned on and Object is chosen.
   The mental ray renderer won't generate motion blur if Image is the chosen type.

2. On the Render Setup dialog, go to the Renderer panel > Camera Effects rollout, and in the Motion Blur group turn on Enable.
   
   **NOTE** With the mental ray renderer, don't use Motion Blur as a Multi-Pass Effect.

3. Increase the Shutter value to increase the blurriness caused by motion blur.

4. On the Render Setup dialog, go to the Rendering Algorithms rollout, and make sure Ray Trace is turned on.
   Motion blur is not rendered when the mental ray renderer uses scanlines only.

5. Render the scene.
To render with contours:

1 Use the mental ray Connection rollout to assign a contour shader to an object's material.
   The mental ray material also lets you assign a contour shader.

2 On the Render Setup dialog > Renderer panel > Camera Effects rollout, in the Contours group, turn on Enable.

3 Change the contour shaders if you wish.

   **NOTE** A number of Contour Output shaders are available, but by default, only one Contour Contrast and one Contour Store shader are provided with 3ds Max. You can adjust the contour contrast shader's settings; the contrast store shader has no parameters.

4 Render the scene.

To assign a camera shader:

1 Click the button for a camera Lens, Output, or Volume shader.
   The Material/Map Browser is displayed.

2 Choose a shader from the Browser list, and then click OK.

To adjust the settings for a contour or camera shader assigned on this rollout:

1 Open the Material Editor.
   If you need to, arrange the open dialogs so you can see the Material Editor and the Render Setup dialog at the same time.

2 Drag the shader button from the Render Setup dialog to an unused sample slot in the Material Editor.
   An Instance (Copy) Map dialog is displayed. **Be sure to choose Instance**, and then click OK.
   If you don’t choose Instance, changes you make to the shader settings in the Material Editor won’t have any effect on the Render Setup dialog.

   **TIP** If you forgot to choose Instance, change the shader settings as you choose, and then drag the shader's sample slot or its Type button back to the button in the Render Setup dialog. This updates the Render Setup dialog copy of the shader.
The Material Editor displays the shader parameters rollout.

3 Adjust the parameters.

**Interface**

![Image of Camera Effects interface]

**Motion Blur group**

**TIP** mental ray motion blur is not recommended for use with particle systems, as this can increase rendering time considerably. Use a Particle MBlur map on page 6308 instead.
NOTE Motion blur with the mental ray renderer does not always follow curving trajectories. Increasing the value of Motion Segments can help, but this works better for rotary motion than for traveling motion.

The Rendering Control Properties (lower-right) quad of the rendering quad menu (Ctrl+Alt+right-click) has a Motion Blur toggle for a single, selected object. You can turn on Motion Blur for lights and cameras: moving lights and cameras can generate motion blur when rendered with mental ray.

**Enable** When on, the mental ray renderer calculates motion blur on page 6693. Default=off.

**Blur All Objects** Applies motion blur to all objects, regardless of their object property setting. Default=on.

**Shutter Duration (frames)** Simulates the shutter speed of a camera. At 0.0, there is no motion blurring. The greater the Shutter Duration value, the greater the blurring. Default=0.5.

**Shutter Offset (frames)** Sets the beginning of the motion-blur effect relative to the current frame. The default value, –0.25, centers the blurring slightly before the current frame for a photorealistic effect. Default=–0.25.

**Motion Segments** Sets the number of segments for calculating motion blur. This control is for animations. If motion blur appears to be tangential to the actual motion of an object, increase the Motion Segments value. Larger values result in more accurate motion blur, at a cost of rendering time. Default=1.

**Time Samples** When the scene uses motion blur, controls the number of times the material is shaded during each time interval (set by Shutter Duration on page 6751). Range=0 to 100. Default=5.

By default, the material is shaded only once, and then blurred. If the material changes rapidly during the shutter interval, it might be useful to increase this value, in order to obtain more accurate motion blur. Rapid changes in reflections or refractions might require a higher Time Samples value.

NOTE When Rendering Algorithms rollout > Use Fast Rasterizer on page 6743 is on, the label for this parameter changes to Time Samples (Fast Rasterizer) to indicate that this version of Time Samples is now in effect. The default value for the Fast Rasterizer version of Time Samples is 1, and the range is 1 to 128. If you change the value for either version, 3ds Max remembers the changed setting when you switch.
**Contours group**

These controls enable contours, and let you use shaders to adjust the results of a contour shader on page 6714. You assign the primary contour shader to the Contour component of the mental ray Connection rollout on page 5763 or a mental ray material (see Advanced Shaders Rollout (mental ray Material) on page 5958).

**NOTE** Contour shading does not work with distributed bucket rendering.

**Enable** When on, enables rendering of contours. Default=off.

To change a shader assignment for adjusting contours, click a button. Default shaders are already assigned to the three components, as the button labels indicate.

**Contour Contrast** The contour contrast component can be assigned the following shader:

<table>
<thead>
<tr>
<th>Shader</th>
<th>Library</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Contour Contrast Function Levels</em></td>
<td>contour</td>
</tr>
</tbody>
</table>

**Contour Store** This component stores the data on which contours are based. It can be assigned the following shader, which has no parameters to set:

<table>
<thead>
<tr>
<th>Shader</th>
<th>Library</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Contour Store Function</em></td>
<td>contour</td>
</tr>
</tbody>
</table>

**Contour Output** The contour output component can be assigned one of these shaders:

<table>
<thead>
<tr>
<th>Shader</th>
<th>Library</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Contour Composite</em></td>
<td>contour</td>
</tr>
<tr>
<td><em>Contour Only</em></td>
<td>contour</td>
</tr>
<tr>
<td><em>Contour PS (PostScript)</em></td>
<td>contour</td>
</tr>
</tbody>
</table>

To adjust the settings for a shader assigned to one of these components, drag the shader's button to an unused Material Editor sample slot. When prompted to use an instance or a copy, be sure to choose Instance. (If you edit a copy of
the shader, you will have to drag the sample slot back to the shader button on the Camera Effects rollout before you see any changes take effect.)

**Camera Shaders group**

These controls let you assign mental ray camera shaders. Click a button to assign a shader to that component. After a shader is assigned, its name appears on the button. Use the toggle on the left to temporarily disable a shader that has been assigned.

**Lens** Click to assign a lens shader. This component can be assigned one of these shaders:

<table>
<thead>
<tr>
<th>Shader</th>
<th>Library</th>
</tr>
</thead>
<tbody>
<tr>
<td>Distortion</td>
<td>lume</td>
</tr>
<tr>
<td>mr Physical Sky on page 5532</td>
<td>3ds Max</td>
</tr>
<tr>
<td>Night</td>
<td>lume</td>
</tr>
<tr>
<td>Render Subset of Scene/Masking (mi) on page 6444</td>
<td>3ds Max</td>
</tr>
<tr>
<td>Shader List on page 6420 (Lens)</td>
<td>3ds Max</td>
</tr>
<tr>
<td>Utility Gamma &amp; Gain (mi) on page 6443</td>
<td>3ds Max</td>
</tr>
<tr>
<td>Wrap Around</td>
<td>lume</td>
</tr>
</tbody>
</table>

**Output** Click to assign a camera output shader. These are the output shaders you can assign:

<table>
<thead>
<tr>
<th>Shader</th>
<th>Library</th>
</tr>
</thead>
<tbody>
<tr>
<td>Glare Shader (mental ray) on page 6408 (The default.)</td>
<td>lume</td>
</tr>
<tr>
<td>HDR Image Motion Blur (mi) on page 6448</td>
<td>3ds Max</td>
</tr>
</tbody>
</table>
Volume

Click to assign a volume shader to the camera. These are the volume shaders you can assign:

<table>
<thead>
<tr>
<th>Shader</th>
<th>Library</th>
</tr>
</thead>
<tbody>
<tr>
<td>Beam</td>
<td>lume</td>
</tr>
<tr>
<td>Material to Shader</td>
<td>3ds Max</td>
</tr>
<tr>
<td>Mist</td>
<td>lume</td>
</tr>
<tr>
<td>mr Physical Sky</td>
<td>3ds Max</td>
</tr>
<tr>
<td>Parti Volume</td>
<td>physics</td>
</tr>
<tr>
<td>Shader List</td>
<td>3ds Max</td>
</tr>
<tr>
<td>Submerge</td>
<td>lume</td>
</tr>
</tbody>
</table>

NOTE You can also assign Volume shaders to the Volume component of the mental ray Connection rollout on page 5763 and the mental ray material (see Material Shaders Rollout (mental ray Material) on page 5951).

Depth of Field (Perspective Views Only) group

These controls are comparable to the depth-of-field controls for cameras. They apply only to Perspective viewports. You can render depth-of-field effects for either Camera or Perspective views. Depth-of-field effects don’t appear when you render orthographic viewports.

For a Perspective view, use the controls in this group. For a Camera view, choose “Depth Of Field (mental ray)” as the multi-pass rendering effect, then
adjust the f-Stop setting. See Depth of Field Parameter (mental ray Renderer) on page 5589.

Enable When on, the mental ray renderer calculates depth-of-field on page 6694 effects when rendering a Perspective view. Default=off.

[method drop-down list] Lets you choose the method for controlling depth-of-field. Default=f-Stop.

■ f-Stop Controls depth-of-field with the f-Stop setting.

■ In Focus Limits Controls depth-of-field with the Near and Far values.

In most cases, the f-Stop method is easier to use. The In Focus Limits method can help when the scale of objects in the scene makes it difficult to control depth of field using the f-Stop value alone.

Focus Plane For Perspective viewports, sets the distance from the camera, in 3ds Max units, at which the scene is completely in focus. Default=100.0. For Camera viewports, the focus plane is set by the camera's target distance.

f-Stop When f-Stop is the active method, sets the f-stop for use when you render Perspective views. Increasing the f-stop value broadens the depth of field, and decreasing the f-stop value narrows the depth of field. Default=1.0. The f-Stop can have a value less than 1.0. This is not realistic in terms of an actual camera, but it can help you adjust the depth of field for scenes whose scale does not use realistic units.

Near and Far When In Focus Limits is the active method, these values set the range, in 3ds Max units, within which objects are in focus. Objects lose focus when they are closer than the Near value or farther than the Far value. These values are approximate, because the transition from in-focus to out-of-focus is gradual, not abrupt.

The Near and Far values are related to each other and to the value of Focus Plane. Changing the value of Near changes Far as well, and vice versa. Specifically, if
H = Hyperfocal distance, the Focus Plane value at which the Far limit becomes infinity
D = The Focus Plane distance
Dn = The Near distance
Df = The Far distance

Then
Dn = HD / (H + D)
Df = HD / (H − D)

**Shadows & Displacement Rollout (mental ray Renderer)**

*Render Setup dialog* on page 6506 > Renderer panel > Shadows & Displacement rollout

Note: The Shadows & Displacement rollout appears only when the mental ray renderer is the currently active renderer.

The controls in this rollout affect *shadows* on page 6691 and *displacement* on page 6713.

**NOTE** You can disable displacement globally by turning off Displacement in the Options group on the *Common Parameters rollout* on page 6568.
Interface

**Shadows group**

**Enable** When on, the mental ray renderer renders shadows. When off, no shadows are rendered. Default=on.
When Enable is off, the other shadow controls are unavailable.

**Mode** The shadow mode can be Simple, Sort, or Segments. Default=Simple.

- **Simple** Causes the mental ray renderer to call shadow shaders in a random order.
- **Sort** Causes the mental ray renderer to call shadow shaders in order, from the object to the light. Sort applies to third-party, external shadow shaders on page 8716.
- **Segments** Causes the mental ray renderer to call shadow shaders in order along the light ray from the volume shaders to the segments of the light ray between the object and the light.

**TIP** Choose Simple for regular shadows, Segments for volume shadows.
Shadow Maps group

These controls specify a shadow map on page 8719 used to render shadows. When you specify a shadow map file, the mental ray renderer uses the shadow map instead of ray-traced shadows.

To stop using a shadow map and use ray-traced shadows, delete the map's name from the file name field.

Enable When on, the mental ray renderer renders shadow-mapped shadows. When off, all shadows are ray-traced. Default=on.

When Enabled is off, the other controls in this group are unavailable.

If shadows are enabled but shadow maps are not enabled, then shadows for all lights are generated using the mental ray ray-tracing algorithm. If shadow maps are enabled, then shadow generation is based on each light’s choice of shadow generator:

- **mental ray Shadow Map**  Shadows are generated using the mental ray shadow-map algorithm.

- **Shadow Map**  Settings on the Shadow Parameters rollout are translated into a mental ray equivalent before shadows are generated. The quality of shadows generated this way might not always meet expectations.

- **Area Shadows, Advanced Ray Traced Shadows, or Ray Traced Shadows**  Shadows are generated using the mental ray ray-tracing algorithm.

Motion Blur When on, the mental ray renderer applies motion blur on page 6693 to shadow maps. Default=on.

**WARNING** Turning on Motion Blur for both cameras and shadows can cause shadows to shift position. To avoid this effect, turn on motion blur for cameras only.

Rebuild (Do Not Re-Use Cache) When on, the renderer saves the recalculated shadow map (.zt) file on page 8771 to the file specified by the Browse button. Default=on.

- **Use File**  When on, the mental ray renderer either saves the shadow map to a ZT file, or loads an existing file. The state of Rebuild determines whether the ZT file is saved or loaded.

  This option is unavailable until you click the ellipsis button (see following) to provide a name for the ZT file.
... [browse]  Click to display a file selector dialog, which lets you specify a name for the shadow map ZT file and the folder where it is saved.

File name  After you specify a shadow map file (see preceding), this field displays its name and path.

Delete File  Click to delete the current ZT file.

Displacement group

View  Defines the space for displacement. When View is on, the Edge Length specifies the length in pixels. When off, the Edge Length is specified in world space units. Default=on.

Smoothing  Turn off to have the mental ray renderer correctly render height maps. Height maps can be generated by normal mapping; see Creating and Using Normal Bump Maps on page 6856.

When using only height maps in the scene, make sure this option is off. If some objects in the scene use height maps while others use standard displacement, apply smoothing on a per-object basis (see mental ray Panel (Object Properties Dialog) on page 300).

When on, mental ray simply smoothes the geometry using the interpolated normals, making the geometry look better. This result, however, cannot be used for height map displacement because smoothing affects geometry in a way that is incompatible with height mapping.

Edge Length  Defines the smallest potential edge length due to subdivision. The mental ray renderer stops subdividing an edge once it reaches this size. Default=2.0 pixels.

Max. Displace  Controls the maximum offset, in world units, that can be given to a vertex when displacing it. This value can affect the bounding box of an object. Default=20.0.

TIP  If displaced geometry appears to be “clipped,” try increasing the value of Maximum Displace.

NOTE  When using placeholders (see the Translator Options rollout on page 6787), if this value is larger than it needs to be, it can reduce performance. If you experience slow rendering times with displaced objects when Use Placeholder Objects is on, try lowering the Max. Displace value.
Max. Subdiv. Controls the extent to which mental ray can recursively subdivide each original mesh triangle for displacement. Each subdivision recursion potentially divides a single face into four smaller faces. Choose the value from the drop-down list. Range=4 to 64K (65,536). Default=16K (16,384). For example, using the default value means that mental ray can subdivide each displaced mesh triangle into as many as 16,384 smaller triangles.

Indirect Illumination Panel

Render Setup dialog on page 6506 > Indirect Illumination panel

Note: The Indirect Illumination panel appears only when mental ray is the active renderer.

The Indirect Illumination panel controls provide methods for rendering bounced light within an environment, including final gathering, caustics, and photons.

Final Gather Rollout (mental ray Renderer)

Render Setup dialog on page 6506 > Indirect Illumination panel > Final Gather rollout

Note: The Indirect Illumination panel appears only when the mental ray renderer is the currently active renderer.

Final gathering is a technique for estimating global illumination for a given point by either sampling a number of directions over the hemisphere over that point (such a set of samples is called a final gather point), or by averaging a number of nearby final gather points since final gather points are too expensive to compute for every illuminated point. In the former case, the hemisphere orientation is determined by the surface normal of the triangle on whose surface the point lies.

For diffuse scenes, final gathering often improves the quality of the global illumination solution. Without final gathering, the global illumination on page 6775 on a diffuse surface is computed by estimating the photon density (and energy) near that point. With final gathering, many new rays are sent out to sample the hemisphere above the point to determine the incident illumination. Some of these rays strike diffuse surfaces, and the global illumination at those points is then computed by the material shaders at these point, using illumination from the photon map, if available, and from other
material properties. Other rays strike specular surfaces and do not contribute to the final gather color (since that type of light transport is a secondary caustic). Tracing many rays (each with a photon map lookup) is very time-consuming, so it is done only when necessary. In most cases, interpolation and extrapolation from nearby final gathers is sufficient.

Final gathering is also useful without photon tracing; in fact, this is the recommended method of indirect lighting for non-expert users. By default it takes only first-bounce indirect light into account, but you can obtain physically accurate results by increasing the number of bounces to between 3 and 7 and using a high values for density and ray count.

Final gathering is useful in scenes with slow variation in the indirect illumination, such as purely diffuse scenes. For such scenes, final gathering eliminates photon map artifacts such as low-frequency noise and dark corners. With final gathering, fewer photons are needed in the photon map and, because each final gather averages over many values of indirect illumination, lower accuracy is sufficient.

In film production work, final gathering increasingly replaces photon mapping, except for caustics. Without multiple-bounce effects, which are performed by photons by default and by final gathering only if the shaders adjusts the trace depth, tends to have far less impact on the final image than the first bounce that final gathering supports by default. Although physical correctness is lost, this is often sufficient for film production, and final gathering is easier to

---

Interior rendered with final gathering only, lit by daylight only

Final gathering is useful in scenes with slow variation in the indirect illumination, such as purely diffuse scenes. For such scenes, final gathering eliminates photon map artifacts such as low-frequency noise and dark corners. With final gathering, fewer photons are needed in the photon map and, because each final gather averages over many values of indirect illumination, lower accuracy is sufficient.

In film production work, final gathering increasingly replaces photon mapping, except for caustics. Without multiple-bounce effects, which are performed by photons by default and by final gathering only if the shaders adjusts the trace depth, tends to have far less impact on the final image than the first bounce that final gathering supports by default. Although physical correctness is lost, this is often sufficient for film production, and final gathering is easier to
control than photons emanating from distant light sources. However, for accurate indoor illumination simulations and other CAD-related applications, photon mapping is still the method of choice.

**Procedure**

You can find additional procedures for using final gather in rendering animations here on page 6779.

**To use an environment map as a final gather light source:**

Illumination from which final gathering is derived can be provided by an actual light source, of course, but it can also be provided by an object to which a self-illuminated material is applied, or even an environment map. In the latter case, follow this procedure:

1. Add a skylight on page 5412 to the scene.
2. Do either of the following:
   - On the Skylight Parameters rollout, make sure Sky Color (the default) is chosen, click the map button (“None”) to open the Material/Map Browser dialog and then choose a map.
   - On the Skylight Parameters rollout, choose Use Scene Environment. Use the Environment panel on page 7163 controls to assign an environment map.

Thereafter, rendering with final gather enabled take the skylight map into account when calculating final gather illumination.

**TIP** For extra realism, use an HDR image on page 7866 as a Bitmap map image on page 6213.

**Interface**

**NOTE** The Final Gather Map controls, previously found on this rollout, have moved to the new Reuse (FG and GI Caching) rollout on page 6778.
Basic group

**Enable Final Gather** When on, the mental ray renderer uses final gathering on page 8576 to create global illumination or to improve its quality. Default=on.

The leftmost position of the **Final Gather Precision** on page 6526 slider on the lower panel of the Render Frame Window also turns off Enable Final Gather.
**TIP** Without final gathering, global illumination can appear to be patchy, but final gathering increases rendering time. Leave Enable Final Gather off to preview the scene, and then turn it on for the finished rendering. (Increasing the number of photons used to calculate global illumination can also improve global illumination.)

**Multiplier/color swatch** Adjust these settings to control the intensity and color of the indirect light accumulated by final gathering. The default values, 1.0 and white, produce physically correct rendering. These settings are useful for adjusting the contribution of the final gather effect, thus improving the quality of an image.

**FG Precision Presets** Provides a quick, easy solution for final gather. The default presets are: Draft, Low, Medium, High, Very High, and Custom (the default choice). Available only when Enable Final Gather is on. The presets affect the following settings:

- Initial FG Point Density
- Rays per FG Point
- Interpolate Over Num. FG Points

The preset settings are defined in the text file `mentalray_fg_presets.ini`, found in the `\plugcfg` folder in 3ds Max installation. You can modify the existing presets and add new ones by editing this file.

This setting is also available on the Rendered Frame Window, as **Final Gather Precision** on page 6526.

**Project FG Points** Choose a method for avoiding or minimizing the final-gather “flickering” that can result from rendering an animation with a still or moving camera, especially when the scene also contains moving light sources and/or moving objects.

- **Project FG Points From Camera Position** Distributes final gather points from a single viewpoint. Use this when the camera from which you’re rendering the animation does not move, thus saving rendering time.

- **Project Points from Positions Along Camera Path** Distributes final gather points across multiple viewpoints. Use this when the camera from which you’re rendering an animation moves, especially if you’re seeing flickering in areas that are lit mainly by final gathering. This method can result in slightly longer rendering times.
Also, when using this method, set the Divide Camera Path by Num. Segments parameter to an appropriate value, and increase the Initial FG Point Density setting (see following).

**NOTE** This method is most effective for relatively brief shots from a camera that doesn’t move very quickly. If you’re rendering an animation in which the camera moves a significance distance between frames, such as 30-frame dolly shot of a large stadium, you might achieve better results by using the Final Gather Map on page 6782 feature, generating a map for every frame, by itself, or combined with “Project Points ...”.
For procedures that describe how to achieve flicker-free animations in different situations, see this section on page 6779.

**NOTE** When you use this method, before rendering each animation frame, the Rendered Frame Window shows the final-gathering precalculation for all segments.

### Divide Camera Path by Num. Segments
Choose from the drop-down list the number of segments into which to divide the camera path when using the Project Points from Positions Along Camera Path option (see preceding).
The available values are squares of the numbers 1 to 10. You’ll need to determine the best value experimentally, but as a rule of thumb, set the number of segments to at least one per 15 or 30 frames.
Also, when increasing this setting, be sure to set Initial FG Point Density higher. Again, you’ll need to experiment, as the optimal setting depends very much on the scene contents, lighting, and so on. Start with a low value and increase until the results look good.

**Initial FG Point Density** A multiplier for the density of final gather points. Increasing this value increases the density (and thus the quantity) of final gather points in the image. The points will therefore be closer together and more numerous. This parameter is useful for solving geometry problems; for example, near edges or corners. Default=1.0.

**TIP** When adjusting final render settings it’s often helpful to visualize the final gather points; to do so, turn on Diagnostics on page 6795 and choose the Final Gather option.

**Rays per FG Point** Sets how many rays are used to compute indirect illumination in a final gather. Increasing this value makes global illumination less noisy, but also increases rendering time. Default=250.
**Interpolate Over Num. FG Points** Controls the number of final gather points that are used for an image sample. It is useful for solving noise problems and getting smoother results.

For each final gather point, mental ray interpolates (averages) indirect light values over the nearest N final gather points, with N specified by the value of this parameter, as opposed to points within the specified radii as with the alternate method on page 6770. Increasing the value increases the smoothness of the result, and the required number of calculations, hence the render time (but not as much as you might expect).

This setting is unavailable when Use Radius Interpolation Method on page 6770 is enabled.

**Diffuse Bounces** Sets the number of times mental ray calculates diffuse light bounces for each diffuse ray. Default=0.

Like Maximum Reflections and Maximum Refractions, this value is subject to the restriction of Max Depth. If you set Diffuse Bounces higher than Max Depth, the latter setting is automatically raised to the Diffuse Bounces value in the MI output file, but this is not reflected in the 3ds Max interface.

This setting is also available on the Rendered Frame Window, as FG Bounces on page 6527.

**NOTE** When Global Illumination on page 6775 is on, changing this setting has no effect.

**Weight** Controls the relative contribution of the diffuse bounces to the final gather solution. The value scales from "using no diffuse bounces" (value=0.0) to "use full diffuse bounces" (value=1.0). Default=1.0.

**Advanced group**

**Noise Filtering (Speckle Reduction)** Applies a median filter using neighboring final gather rays that are shot from the same point. This parameter lets you choose a value from a drop-down list. The options are None, Standard, High, Very High, and Extremely High. Default=Standard.

The practical effect of increasing the Noise Filtering value is to make the scene illumination smoother, at a cost of render time. However, increasing filtering can also make the illumination somewhat darker.

Noise Filtering works by eliminating stray rays that are considerably brighter than most of the rest. For example, in a situation in which most of the rays are within 10 percent of each others’ brightness, but a few are 50 percent brighter than the rest, using Noise Filtering will tend to disregard the latter rays in computing the Final Gather solution.
As a result, in low-light situations, setting Noise Filtering=None can greatly increase the overall illumination. In the following rendered image, an interior scene, lit only by skylight entering through the window, is very dark with Noise Filtering set to Standard (Diffuse Bounces=1).

Noise Filtering=Standard

In the next illustration, the same scene renders much brighter with Noise Filtering set to None. Note, however, the unevenness of the illumination.
Noise Filtering=None

In cases like this, you can achieve superior results with slightly longer rendering times by setting Noise Filtering to Standard and using a sky portal on page 5537 in the window opening, as shown in the following illustration:
Noise Filtering=Standard + Sky Portal

The above illustration is also improved by the realistic shadows cast by the chair and table legs from the Sky Portal light.

Draft Mode (No Precalculations) When on, final gathering skips the precalculation phase. This results in a rendering with artifacts, but begins rendering more quickly, so it can useful when you want to do a series of trial renderings. Default=off.

Trace Depth group

The Trace Depth controls are similar to those for calculating reflections and refractions, but they refer to the light rays used by final gathering, rather than to rays used in diffuse reflection and refraction.

Max. Depth Limits the combination of reflection and refraction. Reflection and refraction of a light ray stop when the total number of both equals the Maximum Depth setting. For example, if Maximum Depth equals 3 and the trace depths each equal 2, a ray can be reflected twice and refracted once, or vice versa, but it can’t be reflected and refracted four times. Default=2.
**Max. Reflections** Sets the number of times a ray can be reflected. At 0, no reflection occurs. At 1, the ray can be reflected once only. At 2, the ray can be reflected twice, and so on. Default=5.

**Max. Refractions** Sets the number of times a ray can be refracted. At 0, no refraction occurs. At 1, the ray can be refracted once only. At 2, the ray can be refracted twice, and so on. Default=5.

**Use Falloff (Limits Ray Distance)** When on, uses the Start and Stop values to limit the length of light rays used for regathering before using the environment color. This can help improve regathering time, especially for scenes that are not fully enclosed by geometry. Default=off.

- **Start** Specifies the distance, in 3ds Max units, at which rays begin. You can use this value to exclude geometry that is too close to the light source. Default=0.0.

- **Stop** Specifies the maximum length, in 3ds Max units, of a light ray. If the ray reaches this limit without encountering a surface, then the environment is used for shading. Default=0.0.

**FG Point Interpolation group**

These settings provide access to the legacy method of final gather point interpolation.

**Use Radius Interpolation Method** When on, makes the remaining controls in this group available. Also makes the Interpolate Over Num. FG Points check box on page 6766 unavailable, indicating that these controls override that setting.

**Radius** When on, sets the maximum radius within which final gathering is applied. Reducing this value can improve quality at a cost of rendering time. If Radii In Pixels is off, the radius is specified in world units, and defaults to 10 percent of the maximum circumference of the scene. If Radii In Pixels is on, default=5.0 pixels.

If both Radii In Pixels and Radius are off, the maximum radius is the default value of 10 percent of the maximum scene radius, in world units.

**Radii in Pixels** When on, the radii values are specified in pixels. When off, radii units depend on the value of the Radius toggle. Default=off.

**Min. Radius** When on, sets the minimum radius within which final gathering must be used. Decreasing this value can improve render quality but increase rendering time. Unavailable unless Radius is turned on. Default=0.1. If Radii In Pixels is on, default=0.5.
In general, increasing the point density on page 6765 is better than decreasing Min. Radius.

To minimize flickering in animations, keep the two Radius values as close to each other as possible.

Caustics and Global Illumination Rollout (mental ray Renderer)

Render Setup dialog on page 6506 > Indirect Illumination panel > Caustics and Global Illumination rollout

Note: The Indirect Illumination panel appears only when the mental ray renderer is the active renderer.

The controls in this rollout are for the effects of caustics on page 6700 and global illumination on page 6706.

Procedures

To render with caustics:

1. Select each object you want to generate caustics, either by reflection or refraction. Right-click and choose Properties, then on the mental ray panel of the Object Properties dialog, turn on Generate Caustics.

   Objects receive caustics by default. If you think this value might have changed for the objects you want to receive caustics, use those objects’ Object Properties dialog to make sure Receive Caustics is turned on. Also, to speed rendering time, you might want to turn off Receive Caustics for those objects that don’t need to show them.

2. On the Render Setup dialog, go to the Caustics And Global Illumination rollout and turn on Caustics.

3. Adjust the caustics parameters to get the effect you want.

4. Render the scene.
To render with global illumination:

Objects generate and receive global illumination by default. If you think these settings might have changed for any objects in the scene, use the Object Properties dialog to make sure the proper settings are enabled.

1 Select each object you want to generate and/or receive global illumination. Right-click and choose Properties, then on the mental ray panel of the Object Properties dialog, turn on Generate Global Illumination and/or Receive Global Illumination. Also, to speed rendering time, you might want to turn off Receive Global Illumination for those objects that don’t need it.

2 On the Render Setup dialog, go to the Indirect Illumination panel > Caustics And Global Illumination rollout > Global Illumination (GI) group and turn on Enable.

3 Adjust the global illumination parameters to get the effect you want.

4 For the final rendering, turn on Final Gather as well as Global Illumination. See Final Gather Rollout (mental ray Renderer) on page 6760.

5 Render the scene.

Interface

NOTE The Photon Map controls, previously found on this rollout, have moved to the new Reuse (FG and GI Caching) rollout on page 6778.
Caustics group

**IMPORTANT** For caustics to render, you must also make sure to set up these other conditions in your scene:

- At least one object must be set to generate caustics. This is off by default.
At least one object must be set to receive caustics. This is on by default.

At least one light must be set to generate caustics. This is off by default.

The settings for generating and receiving caustics are located on the Object Properties dialog > mental ray Panel on page 300.

Enable When on, the mental ray renderer calculates caustics effects. Default=off.

Multiplier/color swatch Use these to control the intensity and color of the indirect light accumulated by caustics. The defaults, 1.0 and white, produce physically correct rendering.

This is useful for adjusting the contribution of the caustics effect, thus improving the quality of an image.

Maximum Num. Photons per Sample Sets how many photons are used to compute the intensity of the caustic. Increasing this value makes caustics less noisy but also more blurry. Decreasing this value makes caustics more noisy but less blurry. The larger the Samples value, the greater the rendering time. Default=100.

TIP To preview a caustic, set Samples to 20, then increase the value for a final rendering.

Maximum Sampling Radius When on, the spinner value sets the size of photons. When off, each photon is calculated to be 1/100 of the radius of the full scene. Maximum Sampling Radius default=off; value default=1.0.

In many cases, the default photon size (Radius=off) of 1/100 the scene size gives useful results. In other cases, the default photon size might be too large or too small.

When photon reflections overlap, the mental ray renderer uses sampling to smooth them together. Increasing the number of samples increases the amount of smoothing and can create more natural-looking caustics. When photons have a small radius and don’t overlap, the Samples setting has no effect. Low Radius values with a large number of photons result in dotty caustics.

Filter Sets the filter to use for sharpening caustics. Can equal Box, Cone, or Gauss. The Box option requires less rendering time. The Cone option makes caustics appear sharper. Default=Box.

The Gauss filter uses a Gauss (bell) curve, and can be smoother than the Cone filter.

Filter Size Controls the sharpness of caustics when you choose Cone as the caustic filter. This value must be greater than 1.0. Increasing the value makes
caustics more blurry. Decreasing the value makes caustics sharper, but also slightly more noisy. Default=1.1.

**Opaque Shadows when Caustics Are Enabled** When on, shadows are opaque. When off, shadows can be partially transparent. Default=on.

Opaque shadows render more quickly than transparent shadows.

### Global Illumination (GI) group

These settings let you control the usage of photons by mental ray for generating global illumination on page 6706. By default, all objects generate and receive global illumination. The settings for generating and receiving GI are located on the Object Properties dialog > mental ray Panel on page 300.

**NOTE** In order to render global illumination in mental ray, the photons must be able to bounce among two or more surfaces. This can be accomplished by having a single object with some concavity in its surface that’s exposed to the light source, or at least two objects, and at least one object must be set to receive global illumination (see mental ray Panel (Object Properties Dialog) on page 300). Otherwise you’ll receive error messages and no photons will be stored.

**Enable** When on, the mental ray renderer calculates global illumination. Default=off.

**Multiplier/color swatch** Use these to control the intensity and color of the indirect light accumulated by global illumination. The defaults, 1.0 and white, produce physically correct rendering. This is useful for adjusting the contribution of the GI effect, thus improving the quality of an image.

**Maximum Num. Photons per Sample** Sets how many photons are used to compute the intensity of the global illumination. Increasing this value makes global illumination less noisy but also more blurry. Decreasing this value makes global illumination more noisy but less blurry. The larger the Samples value, the greater the rendering time. Default=500.

**TIP** To preview global illumination, set Samples to 100, then increase the value for a final rendering.

**Maximum Sampling Radius** When on, the numeric value sets the size of photons. When off, each photon is calculated to be 1/10 of the radius of the full scene. Default=off, 1.0.
In many cases, the default photon size (Maximum Sampling Radius=off) of one-tenth the scene size gives useful results. In other cases, the default photon size might be too large or too small.

When photons overlap, the mental ray renderer uses sampling to smooth them together. Increasing the number of samples increases the amount of smoothing and can create more natural-looking caustics. When photons have a small radius and don't overlap, the Samples setting has no effect. For global illumination, photons should overlap. To get good results, you might need to turn on Maximum Sampling Radius and increase the photon size.

**Merge Nearby Photons (saves memory)** Enables reduction of the memory footprint of the photon map. When on, use the numeric field to specify the distance threshold below which mental ray merges photons. The result is a smoother, less-detailed photon map that uses significantly less memory. Default=off, 0.0.

**NOTE** Loading a legacy file uses the default value of 0.0. Also, using a value of 0.0 is equivalent to turning the feature off.

**Optimize for Final Gather (Slower GI)** If turned on before you render the scene, the mental ray renderer computes information to speed up the regathering process. Specifically, each photon stores additional information about how bright its neighbors are. This is particularly useful when combining Final Gather with Global Illumination, in which case the additional information allows Final Gather to quickly determine how many photons exist in a region. The fast lookup computation can take a long time, but it can greatly reduce the total rendering time. Default=off.

The fast lookup computation can be stored as additional data inside a photon map file on page 8687, and then reused in subsequent renderings.

**Volumes group**

The controls in this group and the ones that follow are for the photon maps on page 8684 used to calculate caustics and global illumination. This group controls volumetric caustics. Volumetric caustics require a material to have a volume shader assign to its Photon Volume component.

**Maximum Num. Photons per Sample** Sets how many photons are used to shade the volume. Default=100.

**Maximum Sampling Radius** When on, the numeric setting determines the size of photons. When off, mental ray calculates each photon to be one-tenth the size of the scene extents on page 8710. Default: off; value=1.0.

The numeric setting is unavailable when the check box is off.
**Trace Depth group**

The Trace Depth controls are similar to those for calculating reflections and refractions, but they refer to the photons used by caustics and global illumination, rather than to rays used in diffuse reflection and refraction.

**Max. Depth** Limits the combination of reflection and refraction. Reflection and refraction of a photon stop when the total number of both equals the Maximum Depth setting. For example, if Maximum Depth equals 3 and the trace depths each equal 2, a photon can be reflected twice and refracted once, or vice versa, but it can’t be reflected and refracted four times. Default=10.

**Max. Reflections** Sets the number of times a photon can be reflected. At 0, no reflection occurs. At 1, the photon can be reflected once only. At 2, the photon can be reflected twice, and so on. Default=10.

**Max. Refractions** Sets the number of times a photon can be refracted. At 0, no refraction occurs. At 1, the photon can be refracted once only. At 2, the photon can be refracted twice, and so on. Default=10.

**Light Properties group**

Controls in this group affect how lights behave when calculating indirect illumination. By default, the energy and photon settings apply to all lights in a scene. Use the mental ray Indirect Illumination rollout on page 5461 for light objects to adjust an individual light either by multiplying the global values, or by setting local values (using multipliers is the recommended method).

**Average Caustic Photons per Light** Sets the number of photons emitted by each light for use in caustics. This is the number of photons in the photon map on page 8684 used for caustics. Increasing this value increases the accuracy of caustics, but also increases the amount of memory used and the length of render time. Decreasing this value improves memory usage and render time, and can be useful for previewing caustic effects. Default=10000.

**Average GI Photons per Light** Sets the number of photons emitted by each light for use in global illumination. This is the number of photons in the photon map used for global illumination. Increasing this value increases the accuracy of global illumination, but also increases the amount of memory used and the length of render time. Decreasing this value improves memory usage and render time, and can be useful for previewing global-illumination effects. Default=10000.

**Decay** Specifies how photon energy decays as it moves away from each light source. This value is given by \( \frac{1}{(\text{distance} \times \text{decay})} \), where \( \text{distance} \) is the distance
between the light source and an object, and \textit{decay} is the value of this setting. Default=2.0.

The most common values are:

- **0.0** The energy doesn't decay, and photons can provide indirect illumination throughout the scene.

- **1.0** The energy decays at a linear rate, proportionally to its distance from the light. That is, a photon's energy is \(1/distance\), where \(distance\) is the distance from the light source.

- **2.0** (The default.) The energy decays at an inverse square rate. That is, a photon's energy is the inverse of the square of the distance from the light source: \(1/distance^2\).

In the real world, light decays at an inverse square rate (Decay=2.0), but this gives strictly realistic results only if you provide a realistic value for the energy of the light. Other values of Decay can help you adjust indirect illumination without worrying about physical accuracy.

**NOTE** Decay values of less than 1.0 are not recommended, and can cause rendering artifacts.

### Geometry Properties group

**All Objects Generate & Receive GI and Caustics** When on, at rendering time, all objects in the scene can generate and receive caustics and global illumination, regardless of their local object properties settings. When off, an object's local object properties determine whether it generates or receives caustics or global illumination. Turning this on is an easy way to ensure that caustics and global illumination are generated, though it can increase rendering time. Default=off.

This setting does not alter the object's local object properties settings for mental ray. When you turn off All Objects Generate & Receive GI And Caustics, the prior object properties settings are in effect once again.

### Reuse (FG and GI Caching) Rollout (mental ray Renderer)

[Render Setup dialog on page 6506 > Indirect Illumination panel > Caustics and Global Illumination rollout]
Note: The Indirect Illumination panel appears only when the mental ray renderer is the active renderer.

The Reuse rollout gathers together all controls for generating and using final gather map (FGM) and photon map (PMAF) files, and adds the ability to reduce or eliminate flickering in rendered animations by interpolating among final gather map files.

Calculating final gather and photon map solutions often requires extensive calculation, so, when appropriate, caching the solutions as separate files can save a great deal of rendering time, especially when re-rendering an animation after, for example, adjusting the camera. Using cached solutions can also save time when rendering over a network; you can generate the cache files once, and then make them accessible to all machines on the network so they can dedicate themselves to the work of simply rendering the frames.

For FGM files, you can choose to accumulate all final gather map points into a single file, or generate separate files for individual animation frames. With the latter method, you can then reduce animation flicker by interpolating among the map files when rendering.

See also:
- Final Gather Rollout (mental ray Renderer) on page 6760
- Caustics and Global Illumination Rollout (mental ray Renderer) on page 6771

Procedures

To generate and then use a final gather solution when rendering a still image or walkthrough animation:

This method uses a single final gather map file and is best for when objects don’t move in the scene.


2. Set the Final Gather Map method to Incrementally Add FG Points To Map Files.
   This automatically sets the default file name and path. You can use those, or change them by clicking the [...] (browse) button next to the file name field.

3. Click Generate Final Gather Map File Now.
3ds Max calculates the final gather solution for all frames and saves it to the specified file.

4. Set the Final Gather Map method to Read FG Points Only From Existing Map Files, and then render the scene.

Now, as long as you don’t change the lighting or move objects in the scene, you can re-render as many times as you like without having to recalculate the final gather solution, thus saving a significant amount of rendering time.

To generate and then use a final gather solution when rendering an animation with moving objects:

This method uses multiple final gather map files and is best for when objects in the scene move during the animation. You can minimize final gather flickering by interpolating among the final gather solutions.

When rendering an animation that contains both a moving camera and moving objects/lights, a special option is available for projecting final-gather points from regular intervals along the camera path; see step 1.

1. If the camera does not move during the animation, skip to step 2. However, if the camera moves through the scene during the animation, on the Final Gather rollout, choose Project Points from Positions Along Camera Path on page 6764 and set Divide Camera Path by Num. Segments on page 6765 to an appropriate value, based on the length of the camera path. Also, if you’re using a large number of segments, increase the Initial FG Point Density setting on page 6765.

2. On the Reuse rollout, set Mode to One File Per Frame.

3. Set the Final Gather Map method to Incrementally Add FG Points To Map Files.

This automatically sets the default file name and path. You can use those, or change them by clicking the [...] (browse) button next to the file name field.

4. Click Generate Final Gather Map File Now.

3ds Max calculates the final gather solution for each frame and saves it in a separate numbered file (for example: temp0000.fgm, temp0001.fgm, and so on).

5. Set the Final Gather Map method to Read FG Points Only From Existing Map Files.
To reduce final-gather flicker, set a value greater than 0 for Interpolate Over N Frames.

This value determines the number of frames before and after the current frame over which the interpolation occurs. For example, the interpolation for frame 5 with Interpolate=2 uses the cached final gather solutions for frames 3 to 7, inclusive.

The higher the Interpolate value, the greater the flicker reduction. However, if objects and/or lights move very quickly during the animation, a high interpolation value can reduce the accuracy of the final gather solution.

Render the animation.

Now, as long as you don’t change the lighting or the way objects move in the scene, you can re-render as many times as you like without having to recalculate the final gather solution, thus saving a significant amount of rendering time.

Interface
Mode Choose the method by which 3ds Max generates the cache files. The choices are:

- **Single File Only (Best for Walkthrough and Stills)** Creates one FGM file that contains all final gather map points, whether you use Generate Final Gather Map File Now or the accompanying drop-down that lets you generate every Nth frame within the current range. Use this method when rendering a still image, or an animation in which only the camera moves. Typically the single FGM file generated with this method is significantly larger than the files created with the One File Per Frame method (see following).

- **One File Per Frame (Best for Animated Objects)** Creates a separate FGM file for each animation frame. Use this method when objects in the scene move around during the animation, which can cause the final-gather solution to vary from frame to frame.
  For best results with this method, generate the FGM files first, then, before rendering, choose the Read FG Points Only ... option and specify an interpolation value.

**Calculate FG/GI and Skip Final Rendering** When on and you render the scene, mental ray calculates final gather and global illumination solutions when render the scene, but does not perform the actual rendering.

This saves FGM files only if the Final Gather Map > Incrementally Add FG Points ... option is active, and PMAP files only if the Caustics And Global Illumination Photon Map > Read/Write Photons option is active. Alternatively, use the respective Generate ... Map File Now buttons.

**Final Gather Map group**

[method] Choose the method for generating and/or using final gather map files:

- **Off** Rendering with Enable Final Gather does not generate final gather map files.

- **Incrementally Add FG Points to Map Files** Creates cache files as necessary when rendering or generating FGM files. Uses data from existing files and updates them as necessary with new final-gather points generated while rendering.

- **Read FG Points Only from Existing Map Files** Uses final gather data previously saved in FGM files for rendering without generating any new
data. To create the FGM files, use Generate Final Gather Map Now on page 6784 or the drop-down list next to it ( ).

**NOTE** If any final gather map files are unavailable when you render using this method, the software issues warnings via the mental ray Messages window on page 6689, but proceeds with the rendering.

This setting is available on the Rendered Frame Window as Reuse > Lock Final Gather on page 6528.

To reduce or eliminate final-gather flickering in rendered animations, use this method with the interpolation option (see following).

**NOTE** If you choose the Incrementally Add FG Points To Map File or Read FG Points Only From Existing Map Files option or turn on Rendered Frame Window > Reuse group > Final Gather on page 6528 without first generating final gather map files, the software specifies the default map-file base name temp.fgm in the \sceneassets\renderassets\ path in the current project folder on page 7583. You can change the path and file name by clicking the Browse [...] button to the left of the file name field.

**Interpolate Over N Frames** The number of FGM files before and after the current frame to use for interpolation. Use this with the Read FG Points Only... method (see preceding).

For example, if this setting is 2, then mental ray uses for the current frame the average of the final gather solutions from five final gather map files: the two frames preceding the current frame, the current frame, and the two frames following the current frame.

**TIP** When preparing for rendering using interpolation of FGM files, keep the required frame range in mind. For example, if you use the default Interpolate Over N Frames value of 2, and start rendering at frame 0, for best results you'll need FGM files starting at -2. So before you generate the FGM files, set the start of the output frame range on page 6571 to -2, and then set it back to 0 for rendering.

... [Browse] Click to display a file selector dialog, which lets you specify a name for the final gather map (FGM) file, and the folder where it is saved.

If Final Gather Map is set to Off (Do Not Cache Map to Disk), specifying a map file name automatically chooses the Incrementally Add FG Points To Map Files option.
[file name] After you specify a final gather map file using the browse control (see preceding), the name field displays its name and path. If no file name is currently specified, the software fills in this field automatically with the default path and the file name temp.fgm when you choose the Incrementally Add FG Points To Map File or Read FG Points Only From Existing Map Files option (see preceding), or by turning on the Rendered Frame Window > Reuse group > Final Gather on page 6528 check box.

Delete File Click to delete the current FGM file(s). If no files exist, you’re notified; if files do exist, you’re prompted to confirm the deletion.

Generate Final Gather Map Now Processes the final gather pass for all animation frames (as specified in the Common Parameters rollout > Time Output group on page 6571). Generates the maps to the specified file without rendering the scene. Available only when the method on page 6782 is set to Incrementally Add FG Points to Map Files or Read FG Points Only from Existing Map Files.

If Mode on page 6782 is set to Single File Only, mental ray saves all final gather points to the same file. If Mode is set to One File Per Frame, however, clicking this button generates a separate FGM file for each animation frame.

TIP To generate, instead, a single frame or a noncontinuous range of FGM files at regular intervals, click the button next to this button (see following).

To reduce flicker when rendering an animation, use this function first to generate a separate final gather map file for each frame, choose Read FG Points Only from Existing Map Files on page 6782, and specify an interpolation amount on page 6783 greater than 0 before rendering.

[drop-down list] This drop-down list offers a choice of frame ranges to use for generating final gather maps without rendering. Choosing an item from the list begins the map-generation process immediately.

The choices are as follows:

- The active frame output setting, reflected from the Common Parameters rollout > Time Output group on page 6571 choice. For example: Frame 0 to 100; Frames: 1,3,5-12.
- Current Frame: Generates one frame only
[The active time segment on page 3387] Every N Frame(s), where N can be 1, 3, 5, 10, or 20.
For example, if the active time segment is 0 to 100 (the default), and you choose Every 5 Frame(s), the output is [file name]000.fgm, [file name]005.fgm, [file name]010.fgm, ... [file name]100.fgm.
This option is most useful when Mode on page 6782 is set to Single File Only, for example, to bake every fifth frame into one file. Alternatively, you can use it to generate FGM files for interpolating final gather solutions in an animation, but the scene doesn’t change very much throughout the animation.

Caustics and Global Illumination Map group

These controls tell mental ray how to calculate and use photon map files for indirect illumination. These controls are available only if Caustics or Global Illumination is enabled on the Caustics And Global Illumination rollout on page 6771.

**NOTE** If you've specified a photon map here, mental ray continues to use that map instead of generating a new one. To cause the photon map file to be rebuilt, delete the existing file.

**[method]** Choose the method for generating caustics and photon map files:

- **Off (Do not Cache Map to Disk)** Photon maps are calculated as necessary while rendering; cached maps are not written or read.

- **Read/Write File** If the specified photon map (PMap on page 8687) file does not yet exist, mental ray generates a new map file when rendering. If the specified file does exist, mental ray loads and uses the file.
  Before using this option, click Browse (“...”) and provide a name for the PMap file.

- **Read Photons Only from Existing Map Files** Uses cached photon maps from a PMap file while rendering. No calculation of photon maps takes place.
  Before using this option, click Browse (“...”) and provide a name for the PMap file.

... **[browse]** Click to display a file selector dialog, which lets you specify a name and path for the photon map (PMap) file. This automatically turns on Read/Write File.
After you use the [...] button to specify a photon map file, this field displays its name and path.

Delete File Click to delete the current PMAP file.

Generate Photon Map Now Processes the photon-mapping pass for all animation frames (as specified in the Common Parameters rollout > Time Output group on page 6571). Generates the photon maps to the specified file without rendering the scene. To reduce flicker when rendering an animation with a networked render farm, use this function first to generate the GI solution for all frames, and then make sure Read/Write File or Read Photons Only from Existing Map Files (see preceding) is on before rendering.

Processing Panel

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Processing panel

Note: The Processing panel appears only when mental ray is the active renderer. The Processing panel is an additional Render Setup dialog on page 6506 panel whose controls relate to managing how the renderer operates. It also lets you generate diagnostic renderings in pseudo color.
Interface

Translator Options Rollout (mental ray Renderer)

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Processing panel > Translator Options rollout

Note: The Processing panel appears only when the mental ray renderer is the currently active renderer.

Controls in this rollout affect the operation of the mental ray renderer with respect to translation of the scene to the format the renderer requires. They also let you save the translated scene to an MI file on page 8639, which you can then use with a standalone renderer. The translated output uses the mental...
ray version 3 (mi3) format. The translator does not support mental ray version 1 (mi1).

See also:
- Distributed Bucket Rendering Rollout (mental ray Renderer) on page 6797

Procedures

To save the mental ray renderer settings:
- When you have a set of rendering settings you want to keep, go to the Render Setup dialog and open the Preset drop-down list at the bottom. Choose Save Preset (at the bottom of the list), enter a file name, and click Save. Next, use the Select Preset Categories dialog to highlight the parameter categories to store in the preset and click Save. Thereafter you can choose your custom setup from the Preset drop-down list.

To create a rendering from multiple passes:

1. Use the Render Type on page 6542 > Selected option to choose only a portion of the scene to render.
2. On the Translator Options rollout, in the Render Passes group, click the ellipsis [...] button next to Save.
3. A Save As dialog is displayed. Use it to enter a name and location for the PASS file.
4. Click Render. The partial rendering is saved in the PASS file you specified.
5. Repeat steps 1 through 4 until you have generated all the passes for the rendering (or all the passes but the last).

**WARNING** If your scene includes an environment, render it only in the final pass. Rendering the environment in multiple passes is time consuming, and can lead to artifacts such as unwanted color changes to the background. Render all passes but the last one using a default black background.

6. In the Render Passes group, click Add to add the various pass files to the list.
7. Turn on Merge.
At this point, you might also want to turn off Save, unless you want the final result to be saved as a PASS file as well as a rendering.

8 Click Render.

The rendering consists of all the passes merged into one.

**TIP** For some purposes, you might want to create the passes, then create a new 3ds Max scene with no objects, set the rendering resolution to match the passes, you created, then merge the passes as described in steps 7 and 8 above.

**Interface**

![Interface Diagram](image_url)
Memory Options group

Use Placeholder Objects When on, 3ds Max sends geometry to the mental ray renderer only on demand. Initially, the mental ray scene database is populated only with the sizes (bounding box) and positions of objects in the 3ds Max scene. An object’s geometry is sent to the rendering engine only when mental ray renders a bucket that contains the object. Default=off.
This option can improve rendering speed when a large amount of the scene’s geometry is outside of the view you are rendering.
When the mental ray renderer is low on memory, Use Placeholder Objects enables it to increase available memory by deleting object geometry from the scene database. This can dramatically reduce memory usage, but at a possible cost in rendering speed.

Use mental ray Map Manager When on, maps (typically file-based bitmap images) used in materials and shaders are read from disk and if necessary, translated to a format that the mental ray renderer can read. When off, maps are accessed directly from memory, and translation is unnecessary. Default=off.
Following is a complete list of differences between turning this option on and off:
When on:
■ mental ray reads textures directly from disk (mental ray is able to flush textures out of memory when memory is low). Also, textures are loaded only if needed.
■ mental ray uses its built-in pyramid filtering system. These pyramid lookup tables can be flushed out of memory when memory is low.
■ Texture formats not supported directly by mental ray are read by 3ds Max and sent, before rendering begins, as binary data to mental ray.

When off:
■ 3ds Max reads the textures from disk, and then sends individual pixel colors to mental ray as they are needed.

NOTE 3ds Max reads the textures from disk and keeps them stored in memory between renders. This can make renders faster, because the bitmaps don’t need to be reloaded every time. 3ds Max will not read the texture from disk if it was already loaded previously (for example, in a previous render, for a Material Editor preview, or for displaying the map in a viewport).
- Rendering uses a pyramid filter shader that is identical to the standard 3ds Max pyramid filter system.

Turning this option on is useful for large scenes that take a lot of memory to render. Turning it off is quicker, because textures already loaded in memory don’t have to be reloaded by mental ray.

**NOTE** Turning the option on and off might result in very small differences between rendered images because of the different algorithms used in the mental ray map manager and the 3ds Max map manager.

You *must* turn on “Use mental ray Map Manager” when performing these actions:

- Using distributed bucket rendering.
  See Distributed Bucket Rendering Rollout (mental ray Renderer) on page 6797.

  When rendered with distributed bucket rendering and the mental ray map manager, images with textures can look different than when rendered with 3ds Max alone, because the filtering technique is different.

- Exporting to an MI file.
  See Export to .mi File group on page 6793.

**Conserve Memory** Tells the translator to be as memory efficient as it can. This can slow down the translation process, but reduces the amount of data being sent to the mental ray renderer. Default=off.

This option is useful when you are trying to render a huge scene and time is not necessarily an issue. When you render to an MI file, this option can also help reduce the size of the output file.

When on, this toggle also tells the mental ray renderer to save frames as temporary .map files. This allows you to render extremely large frames without running out of random-access memory.

The location of the temporary map files is chosen in the following order:

1. If the file \[program folder]\mentalray\rayrc contains a registry entry called _MI_REG_FBDIR, the renderer uses this directory.

   The entry should have the form

   ```
   registry "{_MI_REG_FBDIR}" value "<path>" end registry
   ```

   where <path> is the directory you want to use.
2 If the rayrc file has no registry entry, the renderer uses the directory specified by the TMPDIR environment variable.

3 If there is no TMPDIR environment variable, the renderer uses the directory specified by the TEMP environment variable.

**Geometry Caching group**

Geometry caching lets you save the translated scene contents to a temporary file for reuse in subsequent renders. This can save time by omitting the translation step, especially with geometry-heavy scenes. Two levels of caching are available: standard and locked.

**Enable** When on, rendering uses geometry caching. During the first render, the translated geometry is saved to the cache file. Then, in subsequent renderings of the same scene, the renderer uses the cached geometry for any unchanged objects instead of retranslating it. Any changed geometry is retranslated. Default=off.

This control is available on the Rendered Frame Window lower panel as Reuse > Geometry on page 6528.

**Lock Geometry Translation** When on, sub-object-level changes such as vertex editing or adjusting a modifier such as Bend are ignored and don’t cause retranslation. However, object-level changes such as moving or rotating an object are retranslated.

This control is available on the Rendered Frame Window lower panel as Reuse > Lock Geometry Translation on page 6527 (button).

**Clear Geometry Cache** Deletes the cached geometry.

This control is available on the Rendered Frame Window lower panel as Reuse > Clear Geometry Cache on page 6528.

**Material Override group**

Material Override allows you to render a scene with all its materials replaced by a single master material. For example, if you need to do a wireframe pass, you can create a Wire material and then specify it here. When you render, all surfaces will use the Wire material.
Enable When on, rendering uses the override material for all surfaces. When off, surfaces are rendered with the material applied to them in the scene. Default=off.

Material Click to display the Material/Map Browser on page 5724 and choose a material to use as the override. Once you have chosen an override material, this button displays the material name.

Export to .mi File group

These controls let you save the translated scene in a mental ray MI file on page 8639. Before exporting, you must specify an export file by clicking the ellipsis [...] button.

NOTE Exporting to an MI file is not available when you render to texture on page 6843.

Export on Render When on, saves the translated file to an MI file instead of rendering when you click Render. Available only after you have clicked the ellipsis [...] button to specify an MI file. Default=off.

Un-compressed When on, the MI file is not compressed. When off, the file is saved in a compressed format. Default=on.

Incremental (Single File) When on, exports an animation as a single MI file that contains a definition of the first frame and descriptors of the incremental changes from frame to frame. When off, exports each frame as a separate MI file. Default=off.

When you export an animation, turning on Incremental can save a considerable amount of disk space.

■ ... [browse] Click to display a file selector dialog, which lets you specify a name for the MI file, and the folder where it is saved.

■ File name After you’ve used the ellipsis [...] button to specify an MI file, this field displays its name and path.

Render Passes group

Controls in this group let you create a rendering out of multiple passes that render portions a scene. This can be a useful way to render large scenes or scenes that have complex effects. It can also be a way to divide the labor on a compositd (“merged”) rendering. See the “Procedures” section, above, for more information.
Save When on, saves the image currently being rendered (prior to merging) inside the specified PASS file.

- ... [browse] Click to display a file selector dialog, which lets you specify a name for the PASS file and the folder where it is saved.

- File name After you have specified a PASS file, the name field displays its name and path.

If you are rendering a time segment (that is, an animation), the PASS files are created with sequence numbers appended to the main file name (for example, test0000.pass, test0001.pass, and so on).

Merge When on, the PASS files specified in the list will be merged into the final rendering.

- List of PASS files Lists the PASS files that will be merged into the final rendering (possibly including the pass that is currently being rendered and saved).

- Add Click to add a PASS file to the list.
  If you choose a PASS file with a sequence number appended to its name, 3ds Max asks if you want to use the individual file or the entire sequence.

- Delete Click to delete the highlighted PASS file from the list.

Merge Shader Lets you choose the shader used to merge the PASS files. Clicking the shader button displays a Material/Map Browser so you can choose the shader (when a shader is chosen, its name appears on the button). When the toggle is on, this shader is used for merging.

**IMPORTANT** No merge shaders are provided with 3ds Max. This option is provided for users who plan to write a custom merge shader appropriate to their particular compositing project.

Mapping group

Skip Maps and Textures When on, rendering ignores maps and textures, including projection maps, and uses only surface colors (diffuse, specular, and so on). Default=off.

Turning off maps can be useful, and save time, when you are adjusting global illumination.
Diagnostics Rollout (mental ray Renderer)

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Processing panel > Diagnostics rollout

Note: The Processing panel appears only when the mental ray renderer is the currently active renderer.

The tools on the Diagnostics rollout can help you understand why the mental ray renderer is behaving in a certain way. The Sampling Rate tool, in particular, can help explain the renderer's performance.

Each of these tools generates a rendering that is not a photorealistic view, but a schematic representation of the functionality you have chosen to analyze.

Interface

Enable When on, the renderer renders the graphic representation for the tool you have chosen.

Sampling Rate When chosen, renders an image that shows where samples were collected during rendering; see Sampling (mental ray Renderer) on page 8705. This can help you adjust the contrast and other sampling parameters.

Coordinate Space Renders an image that shows the coordinate space of objects, the world, or camera.

- **Object** Shows local coordinates (UVW). Each object has its own coordinate space.
World  Shows world coordinates (XYZ). The same coordinate system applies to all objects.

Camera  Shows camera coordinates, which appear as a rectangular grid superimposed on the view.

Size  Sets the size of the grid. Default=1.0.

TIP  To avoid busy moiré patterns in the grid, increase the value of Size.

Photon  Renders the effect of a photon map in the screen. This requires that a photon map be present (to render caustics or global illumination). If no photon map is present, the Photon rendering looks just like the nondiagnostic rendering of the scene: the mental ray renderer first renders the shaded scene, then replaces it with the pseudocolor image.

Density  Renders the photon map as it is projected into the scene. High density is displayed in red, and lower values render in increasingly cooler colors.

Irradiance  Similar to the Density rendering, but shades the photons based on their irradiance. The maximum irradiance is rendered in red, and lower values render in increasingly cooler colors.

BSP  Renders a visualization of the parameters used by the tree in the BSP ray-trace acceleration method on page 6746. If a message from the renderer reports excessively large depth or size values, or if rendering seems unusually slow, this can help you locate the problem.

Depth  Shows the depth of the tree, with top faces in bright red, and increasingly deep faces in increasingly cool colors.

Size  Shows the size of leaves in the tree, with differently sized leaves indicated by different colors.

NOTE  The BSP diagnostic works with the BSP method only; the BSP2 method does not support it.

Final Gather  Renders the scene with pre-processing final-gather points displayed as green dots, and tile-rendering (final render) final-gather points displayed as red dots.

For animation purposes, the presence of red dots is undesirable. To resolve this, use the Interpolate Over Num. FG Points setting on page 6766 instead of the Radius Interpolation Method on page 6770, or, if you prefer the latter, keep
the Min. Radius setting as close as possible to the Radius setting; that is, the maximum radius.

**Distributed Bucket Rendering Rollout (mental ray Renderer)**

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Processing panel > Distributed Bucket Rendering rollout

Note: The Processing panel appears only when the mental ray renderer is the currently active renderer.

Controls on this rollout are for setting up and managed distributed bucket rendering. With distributed rendering, multiple networked systems can all work on a mental ray rendering. Buckets are assigned to systems as they become available.

While distributed bucket rendering can be used for offline rendering of animation frames, as in standard network rendering, it's best suited for speeding up the rendering of single images as you work. Especially when rendering high-resolution still images, you can get much faster results with distributed bucket rendering.

**TIP** When you use distributed bucket rendering, be sure to:

- Turn on Use Placeholder Objects on the Translator Options rollout on page 6787. When placeholder objects are enabled, geometry is sent to the renderer only on demand.
- Leave Bucket Order set to Hilbert on the Sampling Quality rollout on page 6735. With Hilbert order, the sequence of buckets to render uses the fewest number of data transfers.

**NOTE** Contour shading does not work with distributed bucket rendering.

**NOTE** You cannot use distributed bucket rendering when you render to texture on page 6843.
IMPORTANT To use distributed bucket rendering, you must set up host systems that are capable of running the mental ray renderer. There are two ways to do so: set up satellite systems, or install mental ray standalone licensing on remote hosts.

**Satellite Systems**

“Satellite” processors allow any owner of a 3ds Max license to freely use up to eight slave CPUs to render an image using distributed bucket rendering (not counting the one, two, or four processors on the “master” system that runs 3ds Max).

Each satellite system must have the following files installed:

- rayrc
- raysat_3dsmax<X>.bat
- raysat_3dsmax<X>.exe
- raysat_3dsmax<X>server.exe

where <X> is the current 3ds Max version number.

You can use the 3ds Max installation program to install these files: see the Installation Guide for more information.

In addition, information about each satellite should be stored in the RAYHOSTS file on page 8697. You can set up satellite systems by using the Add button on the Distributed Bucket Rendering rollout, as described in the “Interface” section, below.

**Host Systems with SPM Licenses**

When you use mental ray SPM licenses, remote hosts (that is, all systems other than the one running 3ds Max) must have the mental ray renderer (ray.exe) and a mental ray SPM license server running. To obtain this, you must run the mental ray installer on all remote hosts, then configure and run the SPM license server. Instructions about how to do so are provided with the mental ray renderer sold by mental images.

Once the remote hosts have been configured to run a licensed instance of ray.exe, you can use them for distributed rendering simply by naming them in the RAYHOSTS file on page 8697. You can add hosts to the RAYHOSTS file using the Add button described in the “Interface” section, below, just as you would add a satellite processor.
Batch Rendering (Using Backburner or the Command Line)

You can launch distributed bucket rendering from the command line, using `3dsmaxcmd.exe`.

If you use satellite processors, you cannot use Backburner to manage distributed bucket rendering. When host processors have SPM licenses, you can use Backburner to manage distributed bucket rendering.

You can use the environment variable `MRMAX_OFFLINE_DBR_OVERRIDE` to control whether batch rendering uses distributed bucket rendering. The state of this variable overrides the "DBR enable" flag. If it is set to "yes," "true," or "on," distributed bucket rendering is enabled; if it is set to "no," "false," or "off," distributed bucket rendering is disabled. All other values of this variable are ignored.

See also:

- Translator Options Rollout (mental ray Renderer) on page 6787

Procedures

To use mental ray distributed rendering:

1. On the Render Setup dialog, go to the Processing panel. On the Distributed Bucket Rendering rollout, turn on Distributed Render.

   **NOTE** The Net Render option on the Common Parameters rollout has no effect on distributed bucket rendering.

2. Click to select the names of those satellite or host systems you want to use for distributed rendering.
   
   You can click All to select all the host names in the list, or None to select none of the hosts.

3. If other host systems have maps installed on them, with exactly the same file names and path names as on your local host, turn on Distributed Maps.

   With Distributed Maps turned on, remote renderers can use their local copy of maps, which saves time.

4. Render the scene.

   Each system renders the buckets assigned to it. The final rendering appears on your local system, with buckets “arriving” in an indeterminate order.
Example: To use mental ray distributed bucket rendering with Backburner:

This procedure demonstrates how to multiply the number of CPUs used for rendering without having to purchase mental ray standalone licenses, using the 3ds Max satellite technology.

If you have a few machines with 3ds Max licensed, and many machines without, you can use both the distributed rendering technology and Backburner so a rendering job would use 8 CPUs per Backburner server, thereby increasing the rendering speed.

For the purpose of this procedure, we’re using a render farm comprising three machines named A, B, and C, each running a licensed copy of 3ds Max.

NOTE The number of machines you can use depends on the number of machines running licensed copies of 3ds Max. You are able to use only eight external (or satellite) CPUs per licensed copy of 3ds Max: four dual-processor machines or eight single-processor machines (or equivalent).

1. Choose which machines (other than machines A, B, and C) will serve as satellites, install 3ds Max on each, and write down each machine’s IP address.

2. Use the Windows Notepad program or a text editor to open the max.rayhosts file on machine A, located in mentalray subdirectory within 3ds Max folder.

3. In the max.rayhosts file, under the “localhost” entry enter the IP address of each satellite CPU to be used; up to eight in all (see Figure 1).

   Example of a rayhost file

4. Repeat the previous step on machines B and C with the remaining IP addresses.
5 Launch Backburner Manager on the machine submitting the job or any other machine. Launch the Backburner Server on machines A, B, and C.

**WARNING** It is necessary for the machine running the Backburner Server to have 3ds Max licensed. A mental ray standalone license will not enable you to use the distributed bucket rendering feature, and Backburner will prompt you with a license error.

6 On the machine submitting the job choose mental ray as the renderer, and then turn on Use Placeholder Objects, Use mental ray Map Manager (see Figure 2), and the Distributed Render (see Figure 3).
Submit the job to the Backburner network rendering farm. The job is submitted to the network rendering farm and is picked up by machines A, B, and C. Each machine uses its internal CPU as well as its satellite CPUs to render the job.
Interface

Distributed Render When on, the mental ray renderer can use multiple satellite or host systems for distributed rendering. The list specifies which systems to use. Default=off.

NOTE The Net Render option on the Common Parameters rollout has no effect on distributed bucket rendering.

The other distributed rendering controls are unavailable unless Distributed Render is on.

Distributed Maps When on, specifies that all texture maps can be found on each of the slave machines doing distributed rendering. This saves time by avoiding the necessity for mental ray to distribute all the maps to each slave via TCP/IP. When off, specifies that all maps used in rendering reside on the local system; that is, the system on which you start rendering. Default=off.

If Distributed Maps is on but the maps are not found on the slaves, those maps simply will not render on the slaves, and rendered output will be incorrect. Also, an error message will appear in the mental ray message window.

If you are doing local rendering only, this setting has no effect.

Maps on all systems in distributed rendering must have exactly the same name and directory path.
[name field] Displays the RAYHOSTS file's name and path.

[list of hosts] After you choose a RAYHOSTS file, this list shows the host systems available for distributed mental ray rendering. You can use this list to choose only those hosts you want to use for this particular rendering. When you render with Distributed Render on, the mental ray renderer uses only the hosts whose names are highlighted in this list. Click a host name to select it. To deselect a selected host name, click it again.

**NOTE** The RAYHOSTS file, and therefore the host list, can contain duplicate entries. However, before you render you must select only processors that are not duplicates; otherwise, at render time 3ds Max will display an error message.

If Distributed Render is on but the list of hosts is empty when you click Render, 3ds Max will not perform distributed bucket rendering.

**All** Highlights all system names in the hosts list.

**None** Clears the highlight from all system names in the hosts list.

**Add** Click to display the Add/Edit DBR Host dialog on page 6805, which lets you add a host processor to the RAYHOSTS file.

**Edit** Click to display the Add/Edit DBR Host dialog on page 6805, and edit the highlighted host processor's entry in the RAYHOSTS file. Available only when a single list entry is highlighted.

**Remove** Click to remove the currently highlighted host processors from the list and the RAYHOSTS file. Available only when one or more list entries are highlighted.

Clicking Remove displays a Remove Selected Hosts dialog, which warns you that the host descriptors will be removed from both locations:

![Remove Selected Hosts dialog](image)

The selected hosts will be removed from the list AND from the rayhosts file!

To restore a host that you have removed, use the Add button once again.
Add/Edit DBR Host Dialog

The Add/Edit DBR (Distributed Bucket Rendering) Host dialog opens when you click Add on the Distributed Bucket Rendering rollout on page 6797. It lets you add a host (or “satellite”) processor to use when you render using distributed buckets. As the text on the dialog reminds you, the new host is added to the text of the RAYHOSTS file on page 8697.

Interface

Port Number

Let you enter a port number for the processor. This control is unavailable unless you turn off Use Default Port. When Use Default Port is off, the default port value appears in this field.

Name or IP Address

Enter the name or the numeric IP address of the processor you want to add.

Use Default Port

When on, 3ds Max assigns a port number to the new processor. The Port Number control is unavailable while Use Default Port is on. Default=on.

VUE File Renderer

Rendering menu > Render Setup > Render Setup dialog > Common panel > Assign Renderer rollout > Choose VUE File Renderer as the active production renderer. > Renderer panel > VUE File Renderer rollout
The VUE File Renderer creates VUE (.vue) files. VUE files on page 8758 use an editable ASCII format.

**Procedures**

**To create a .vue file:**

1. Use the Render Setup dialog > Assign Renderer rollout to assign the VUE File Renderer as the Production renderer.
   You can’t assign the VUE File Renderer to be the ActiveShade renderer.

2. Activate a camera viewport.
   **NOTE** You must render from a camera viewport in order to include the coordinates for the camera itself.

3. Use the VUE File Renderer rollout to specify a file name.

4. Render the scene.
   The VUE file is written to disk. The Rendered Frame Window on page 6513 is displayed, but it doesn't display an image.

**Interface**

... [Browse] Click to open a file selector dialog and then specify a name for the VUE file to create.

[File name] The text field displays the name of the file.

**Rendering Elements Separately**

Rendering to elements lets you separate various types of information in the rendered output into individual image files. This can be useful when you work with some image-processing, compositing, and special-effects software.
Render Elements Panel and Rollout

These are the elements you can choose to render separately:

- **Alpha**: A grayscale representation of the alpha channel, or transparency, of the scene. Transparent pixels appear in white (value=255) and opaque in black (value=0). Translucent pixels appear in gray. The darker the pixel, the more transparent it is. The alpha channel can be useful when you composite elements.

- **Atmosphere**: The atmospheric effects in the rendering.

- **Background**: The background of the scene. Other elements do not include the scene background. Include this element if you want to use the background in compositing. The background is not trimmed against geometry, so elements should be composited over the background. See Compositing Rendered Elements on page 6811.

- **Blend**: A custom combination of the previous elements. The Blend element displays an additional Blend Element Parameters rollout on page 6824.

- **Diffuse**: The diffuse component of the rendering. The Diffuse element displays an additional Diffuse Texture Element rollout on page 6825.

- **Hair And Fur**: The component of the rendering created by the Hair And Fur Modifier (World Space) on page 1073. See Hair And Fur Render Element on page 6825.

- **Illuminance HDR Data**: Generates an image containing 32-bit floating-point data that can be used for analyzing the amount of light that falls on a surface perpendicular to its normal. See Illuminance HDR Data Element Parameters Rollout on page 6826.

- **Ink**: The Ink component (borders) of Ink 'n Paint materials on page 6132.

- **Lighting**: The effect of direct and indirect lights and shadows in the scene.
The Lighting element displays an additional Lighting Texture Element rollout on page 6827.

- **Luminance HDR Data**: Generates an image containing 32-bit floating-point data that can be used for analyzing the perceived brightness of a surface after light has been “absorbed” by the material of the surface. See Luminance HDR Data Element Parameters Rollout on page 6828.

- **Material ID**: Renders the material ID information assigned to an object. This information is useful when you are making selections in other image-processing or special-effects applications, such as Autodesk Combustion. For example, you could select all of the objects with a given material ID in Combustion. The material ID corresponds to the value you set for the material with the material ID channel. Any given material ID will always be represented by the same color. The correlation between a specific material ID and a specific color is the same in Combustion. See Material ID Channel Flyout on page 5694.

- **Matte**: Renders a matte mask, based on selected objects, material ID channel (effects IDs), or G-Buffer IDs. The Matte element displays an additional Matte Texture Element rollout on page 6829.

- **mr A&D**: These elements render various components of the Arch & Design material to HDR compositors such as Autodesk Toxik. For details, see mr A&D Elements on page 6830.

- **mr Labeled Element**: Renders a branch of a map tree that you specify using a label. For details, see mr Labeled Element Parameters Rollout on page 6835

- **mr Shader Element**: Outputs the raw contribution of any mental ray shader in the scene. This includes standard 3ds Max materials and maps that are converted to mental ray shaders in the translation process. For details, see mr Shader Element Parameters Rollout on page 6837

- **Object ID**: Renders the object ID information assigned to the object. See Object ID Element Rollout on page 6839.

- **Paint**: The Paint component (surfaces) of Ink ’n Paint materials on page 6132.

- **Reflection**: The reflections in the rendering.

- **Refraction**: The refractions in the rendering.

- **Self-Illumination**: The self-illumination component of the rendering.
- **Shadow:** The shadows in the rendering. This element saves black-and-white shadows only. See Compositing Rendered Elements on page 6811.

  NOTE The mental ray renderer does not include shadows created by global illumination on page 6771 and final gathering on page 6760 in the Shadow render element output.

- **Specular:** The specular component of the rendering.

- **Velocity:** The motion information which can be used in other applications for things such as creating motion blur or retiming an animation. The Velocity element displays an additional Velocity Element Parameters rollout on page 6840.

- **Z Depth:** A grayscale representation of the Z depth, or depth within the view, of objects within the scene. The nearest objects appear in white, and the depth of the scene in black. Intermediate objects are in gray, the darker the deeper the object is, within the view. The Z Depth element displays an additional Z Element Parameters rollout on page 6842.

When you render one or more elements, a normal complete rendering is also generated. In fact, the element renderings are generated during the same rendering pass, so rendering elements costs little extra render time.

Rendering to elements is available only when you do production rendering with the default scanline renderer on page 6589 or the mental ray renderer on page 6675.

NOTE The default scanline renderer supports a maximum of 32 render elements per scene. The mental ray renderer does not limit the number of render elements. If you’re using a third-party renderer, check the product documentation for a possible limit on the number of render elements.

NOTE When using the default scanline renderer, Antialiasing on page 6593 must be on in order to render elements. With Antialiasing off, rendering elements is disabled.

**Example**

Here is a rendering of a fountain, against a checkered background, and various elements.
On the right is the fully rendered fountain.
On the left, from top to bottom, are diffuse, specular, shadow, and reflection elements.

Two more elements not directly related to the objects in the scene, but important when compositing the image to other sources:
  on the left is the background, on the right is the alpha channel.
On the left is an atmosphere element, in this example, a light fog on the back side of the fountain.

On the right is the Z-depth. The fog uses the depth of the image and objects to determine its density. The Z-depth element contains these depth values.

**Compositing Rendered Elements**

In general, you can composite elements using additive composition, which is independent of the compositing order.

The main exceptions are the background element, atmospheres, and shadows.

- **Background**: The background is not trimmed against geometry, the background should be composited *under* the other elements.
- **Atmosphere**: The atmosphere element should be composited *over* all other elements.
- **Black-and-white shadows**: Black-and-white shadows should be composited over the rest of the image (aside from the atmosphere), to dim color in the shadowed areas. This technique does not take colored lighting into account.

In other words, the layers when you composite using black-and-white shadows appear like this:

- **Top**: Atmosphere
- **Second from top**: Shadow element
- **Middle**: Diffuse + Specular + ... (other elements)
- **Bottom**: Background
"Screen" Compositing for Specular and Reflection Elements

The other exception to additive composition is when specular or reflection elements have been generated by certain material shaders. These shaders generate specular and reflection elements you must composite differently:

- Anisotropic
- Multi-Layer
- Oren-Nayar-Blinn

Shaders are assigned on a per-material basis, in the Material Editor. If you render specular or reflection elements in a scene that uses these shaders, then composite them with the diffuse and other foreground components (aside from colored shadows, as described above), by overlaying them using an operation called "Screen" in some compositing programs.

Screen compositing uses this formula to combine elements:

\[ \text{Background} \times (1 - \text{Foreground}) + \text{Foreground} \]

The background is multiplied by the inverse of the foreground color, and then the foreground color is added to the result.

For more information, see the documentation for the compositing program you use.

Procedures

To have the Render Elements dialog assign names to the rendered element files automatically:

1. Assign an output file name and file type for the (entire) rendered scene using the Files button on page 6576 on the Common Parameters rollout of the Render Setup dialog.

2. On the Render Elements rollout, use the Add button to specify elements for rendering (see following procedure).

To render elements to files without rendering the entire scene to a file, follow this procedure, and then turn off Common panel > Common Parameters rollout > Render Output group > Save File.

To add an element for rendering:

1. Click Add.
On the Render Elements dialog, do one of the following:

- Highlight the name of an element, and then click OK.
- Double-click the name of an element.

If you have assigned a file name for the entire rendering, the new element is assigned a file name automatically. Otherwise, use the Files button in the Selected Element Parameters group to assign an output file name and file type for the element rendering.

If the element is one (such as Blend or Z Buffer) that has additional parameters, adjust these parameters in the appropriate rollout.

To render the separate elements:

1. Add the elements you want to render.

   **TIP** You can use the Enable button (in the Selected Element Parameters rollout) to disable individual elements for a particular rendering pass.

2. If you haven’t assigned file names automatically (see the first procedure, preceding), use the Browse [...] button in the Selected Element Parameters group to assign an output file name and file type for the element rendering.

3. Make sure Elements Active (at the top of the Render Elements rollout) is turned on, and then click Render to render the scene.

   The rendered elements are also displayed on the desktop, each in its own window. (The windows cascade on top of each other.)

To generate a Combustion™ workspace (CWS) file that contains the rendered elements:

1. In the Output to Combustion group, turn on Enable.

   If you have assigned a file name for the entire rendering, the new element is assigned a file name automatically. Otherwise, use the Files button in the Output to Combustion group to assign an output file name for the CWS file.

2. If you want to change the file or pathname click ... [ellipsis].

3. Do one of the following:

   - Render the scene. The CWS file is created at the time of the rendering.
   - Create Combustion Workspace Now.
Use this button to create a Combustion workspace at any time. You do not have to render for the workspace to be created.

**NOTE** This only works if there is at least one Render Element selected and if your Render Output file type (set on the Common panel) is AVI, RPF, CIN, JPG, PNG, MOV, RGB, RLA, TGA, TIF, or EXR.
Add Click to add a new element to the list. This button displays the Render Elements dialog on page 6818.
Merge Click to merge the render elements from another 3ds Max scene. Merge displays a file dialog so you can select the scene file to get the elements from. The list of render elements in the selected file is added to the current list.

Delete Click to delete the selected elements from the list.

Elements Active When on, clicking Render renders the separate elements. Default=on.

Display Elements When on, each rendered element is displayed in its own window, which is a feature-reduced version of the Rendered Frame Window on page 6513. When off, the elements are rendered to files only. Default=on. The windows for each rendered element open cascaded on top of each other. Move one element’s window to see another’s.

Element Rendering list

This scrollable list shows the elements to render separately, and their status. To resize the columns in the list, drag the border between two columns.

<table>
<thead>
<tr>
<th>Name</th>
<th>Enabled</th>
<th>Filter Enabled</th>
<th>Type</th>
<th>Output Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specular</td>
<td>On</td>
<td>On</td>
<td>Specular</td>
<td>F:\models\shop\Vest</td>
</tr>
<tr>
<td>Diffuse</td>
<td>On</td>
<td>On</td>
<td>Diffuse</td>
<td>F:\models\shop\Vest</td>
</tr>
<tr>
<td>Self-Illumination</td>
<td>On</td>
<td>On</td>
<td>Self-Illumination</td>
<td>F:\models\shop\Vest</td>
</tr>
<tr>
<td>Reflection</td>
<td>On</td>
<td>On</td>
<td>Reflection</td>
<td>F:\models\shop\Vest</td>
</tr>
<tr>
<td>Refraction</td>
<td>On</td>
<td>On</td>
<td>Refraction</td>
<td>F:\models\shop\Vest</td>
</tr>
</tbody>
</table>

The list includes the following columns:

Name Shows the name of the element. You can change the default name of elements, in the Selected Element Parameters group.

To select an element, click its name in the list. Use Ctrl+click to select additional elements, or Shift+click to select a contiguous group of additional elements.

Enabled Shows whether the element is enabled.

Filter Shows whether the active antialiasing filter is enabled for the element.

Type Shows what type of element this is.
This field is useful if you have changed the name of an element.

Output Path Shows the path and file name for the element.
**Selected Element Parameters group**

These controls are for editing selected elements in the list.

**Enable** Turn on to enable rendering the selected elements. Turn off to disable rendering. Default=on.

The Enabled column of the elements list shows whether or not an element is enabled.

**Enable Filtering** When on, applies the active antialiasing filter on page 6593 to the rendered element. When off, the rendered element does not use the antialiasing filter. Default=on.

The Filter column of the elements list shows whether or not the filter is enabled for an element.

Disabling antialiasing can improve rendering time, although the rendered element that results might appear jagged.

**NOTE** Turning off Enable Filter disables only general antialiasing and map filtering. Edge blending still occurs when this switch is off.

**Name** Shows the name of the currently selected element. You can type in a custom name for the element.

This control is unavailable when multiple elements are selected.

[...](Browse) The text box lets you enter a path and file name for the element. Alternatively, click the [...] (ellipsis) button to open the Render Element Output File dialog on page 6819, which lets you choose a folder, file name, and file type for the element.

This control is available only when a single element is highlighted.

**NOTE** If you first assign a file name and path for the complete rendering on the Render Setup dialog > Common Parameters rollout on page 6568, the render elements feature uses this name and path automatically as the basis for names of the various elements. It appends an underscore (_) and then the name of the element to the basic file name.

For example, if the render file name is "C:\render\image.jpg", when you add a Specular render element, the default path and file name for the rendered specular element is "C:\render\image_specular.jpg".

Similarly, when you enable output to a Combustion workspace (CWS) file on page 7835, the file name you assigned is the default name of the CWS file.

For example, if the render file name is "C:\image.jpg", when you enable Combustion output, the default path and file name is "C:\image.cws".
Output to Combustion group

When on, generates a Combustion Workspace (CWS) file on page 7835 that contains the elements you are rendering. You can use this file in the Combustion software, and you can use Combustion workspaces in the Combustion map on page 6229.

**WARNING** If you are rendering elements to composite over a background, make sure that the file format for the Diffuse, Shadows, and Alpha elements supports an alpha channel. The formats we recommend for this purpose are: RLA on page 7873, RPF on page 7875, PNG on page 7862, or TGA on page 7878.

**WARNING** 3ds Max supports some file types that Combustion does not. For use with Combustion, do not render elements as EPS files. If you render to this format, the CWS file is not saved. See your Combustion documentation for more information on supported file formats.

**Enable** When on, creates a CWS file that contains the elements you have rendered.

[...](Browse) The text box lets you enter a path and file name for the CWS file. Alternatively, click the [...] (ellipsis) button to open the Save To Combustion dialog, which lets you choose a folder and file name for the CWS file.

**Create Combustion Workspace Now** When clicked, creates a Combustion workspace (CWS file). This button makes it possible to create a Combustion workspace without rendering.

**NOTE** You must add at least one render element for this file to be created and the Render Output type on the Common panel must be set to AVI, RPF, CIN, JPG, PNG, MOV, RGB, RLA, TGA, TIF, or EXR.

---

**Render Elements Dialog**

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Render Elements panel > Render Elements rollout > Add button > Render Elements dialog

This dialog lets you choose elements to render.
Procedures

To choose an element to render separately, do one of the following:

- Highlight the element's name in the list, and then click OK.
- Double-click the element's name in the list.

To highlight multiple elements, do any of the following and then click OK:

- To highlight non-contiguous elements, click an element's name in the list, and then Ctrl+click further elements.
- To highlight contiguous elements, drag from the first to the last.
- To highlight contiguous elements, click the first element's name in the list, and then Shift+click another element.

Interface

The scrolling list shows the names of elements you can render separately. These are described in Render Elements Panel and Rollout on page 6807.

Render Element Output File Dialog

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Render Elements panel > Render Elements Rollout > Selected Element Parameters group > Browse ([...]) button

The Render Element Output File dialog lets you assign a name to a file that saves one element of the rendering. You can also determine the type of file...
to render, and set up options such as compression, color depth, and quality, depending on the file type.

See also:

- Image File Formats on page 7831

Procedures

To specify the render element output file and its settings:

1 Choose Rendering > Render Setup, and then, on the Render Elements rollout, in the Selected Element Parameters group, click the Browse ([...]) button.
   The Render Element Output File dialog opens.

2 In the File Name field, enter the name for the file to be rendered.

3 Navigate the Save In field to choose the directory where you want the rendered file to be saved.

4 In the Save As Type field, choose the type of file you want to render.

5 Click Save to open the Setup dialog for the specified output file type.
   Thereafter, the Setup button becomes available on the Render Element Output File dialog; you can click this to change the settings.

6 Change any settings as necessary, and then click OK to close the Render Element Output File dialog. Alternatively, clicking Cancel returns you to the Render Element Output File dialog.

7 Click Render to render and save the file.
Interface

**History** Displays a list of the most recent directories searched. Whenever an image is selected, the path used is added to the top of the history list as the most recently used path.

The history information is saved in the *3dsmax.ini* file on page 60.

**Save In** Opens a drop-down list to browse other directories or drives.

**Up One Level** Moves to the next-highest level in the directory structure.

**Create New Folder** Lets you create a new folder while in this dialog.

**View Menu** Provides several options for how information is displayed in the list window:

- **Thumbnails**: Displays the contents of a directory as thumbnails, without the details.
- **Tiles**: Displays the contents of a directory as large icons, without the details. If you widen the dialog, these tile across the width.
Small Icons: Displays the contents of a directory as small icons, tiled across the width, without the details.

List: Displays the contents of a directory without the details.

Details: Displays the contents of a directory with full details such as size and date.

List of files Lists the contents of the directory, in the format specified by the View menu.

TIP When the active display format is Details, the contents of the directory are displayed with Name, Size, Type, Date Modified, and Attributes. You can sort the list according to a column’s contents by clicking that column’s label.

File Name Displays the file name of the file selected in the list.

Save as File Type Displays all the file types that can be saved. This serves as a filter for the list.

NOTE The choice in this field determines the file type saved, regardless of the extension entered in the File Name field.

Save Sets the file information for saving upon rendering. Closes the dialog if you haven’t changed the output file type.

If you’ve changed the file type, clicking Save opens the Setup dialog for the specified file type. Change the settings as necessary, and then click OK to close both the Setup and the Output dialogs, or click Cancel to return to the Output dialog.

Cancel Cancels the selection and closes the dialog.

Devices Lets you choose the hardware output device, for example, a digital video recorder. To use this function, the device, its driver, and its 3ds Max plug-in must all be installed on your system.

Setup Click to open a dialog with controls for the output file type. These vary with each different file format.

NOTE The Setup button becomes available after you specify a file name or type. If you first choose a type from the Save As Type drop-down list, click anywhere on the dialog to activate Setup. If you first enter a file name and extension (such as test.png), press Tab to activate Setup. Also, clicking Setup uses the filename extension, even if it doesn’t agree with the Save As Type setting.
**Info** Displays expanded information about a highlighted file such as frame rate, compression quality, file size, and resolution. The information available depends on the file type.

**View** Displays the file at full resolution. If the file is a movie, Windows Media Player opens to play the file.

**Sequence** This is not available in the Render Element Output File dialog.

**NOTE** To render a sequence of still images, choose the Active Time Segment or define a range of frames on the Common Parameters rollout of the Render Setup dialog. If you are rendering to a still-image file type, 3ds Max appends a four-digit frame number to the file name, incremented with each frame.

**Preview** When on, enables display of the image as a thumbnail in the Image Window.

**Image Window** Displays a thumbnail of the selected file, when Preview is turned on.

**Gamma group**

To set up gamma options for the output file, Enable Gamma Correction must be on in the Gamma panel on page 8330 of the Preferences dialog (Customize > Preferences > Gamma). Otherwise, the Gamma controls are unavailable in the Render Output File dialog.

- **Use Image’s Own Gamma** This option is not available in this dialog.

- **Use System Default Gamma** Uses the system default gamma, as set on the Gamma panel of the Preferences dialog on page 8330.

- **Override** Defines a new gamma for the bitmap that differs from the system default. Using Override is not recommended for element bitmaps. Using the system default gamma value ensures that all elements have consistent renderings.

**Statistics/Location**

**Statistics** Displays the resolution, color depth, file type, and number of frames of the highlighted file.

**Location** Displays the full path and name of the highlighted file.
Individual Render Elements

These topics describe individual render elements, especially those that display a rollout with options.

Blend Element Parameters Rollout

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Render Elements panel > Render Elements rollout > Add button > Render Elements dialog > Add Blend element to the elements list (or select an existing Blend element in the list).

The Blend element is a custom combination of several other elements. By default, all elements are turned on in this rollout, and the Blend rendering is identical to the full, normal rendering, except for the scene background. Use the check boxes to choose your own combination of elements to appear in the Blend rendering.

Interface

<table>
<thead>
<tr>
<th>Blend Element Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓ Ambient</td>
</tr>
<tr>
<td>✓ Diffuse</td>
</tr>
<tr>
<td>✓ Specular</td>
</tr>
<tr>
<td>✓ Self-Illumination</td>
</tr>
<tr>
<td>✓ Reflection</td>
</tr>
</tbody>
</table>

Ambient When on, include the ambient color component. Default=on.

Diffuse When on, include the diffuse color component. Default=on.

Specular When on, include the specular color component. Default=on.

Self-Illumination When on, include self-illumination. Default=on.

Reflection When on, include reflections. Default=on.

Refraction When on, include refractions. Default=on.

Apply Atmosphere When on, include atmospheric effects. Default=on.

Apply Shadows When on, include shadows. Default=on.
**Paint** When on, include the Paint component of Ink 'n Paint materials on page 6132. Default=on.

**Ink** When on, include the Ink component of Ink 'n Paint materials. Default=on.

## Diffuse Texture Element Rollout

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Render Elements panel > Render Elements rollout > Add button > Render Elements dialog > Add Diffuse element to the elements list (or select an existing Diffuse element in the list).

The Diffuse render element displays the diffuse color component of objects in the scene.

### Interface

**Lighting** When on, the diffuse render element displays the color of objects *after* lighting has been applied.

When Lighting is turned off, the element displays the diffuse color of objects before the lighting gets applied. For textured objects, this will look like a 3D projection of the texture. However, objects with a single color will look “flat”.

## Hair And Fur Render Element

Rendering menu/main toolbar > Render Setup > Render Elements panel > Add > Render Elements dialog > Hair And Fur

The Hair And Fur render element produces an additional image that depicts only the elements in the scene generated by the Hair And Fur modifier on page 1073. This image can be used for compositing.

**NOTE** The Hair And Fur render element supports only the “buffer” rendering method on page 7064 using the default scanline and mental ray renderers.
Illuminance HDR Data Element Parameters Rollout

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Render Elements panel > Render Elements rollout > Add button > Render Elements dialog > Add Illuminance HDR Data element to the elements list (or highlight an existing Illuminance HDR Data element in the list).

Generates an image containing 32-bit floating-point data that can be used for analyzing the amount of light that falls on a surface perpendicular to its normal. The illuminance data ignores material characteristics such as reflectance and transmittance.

Illuminance is not related to surface properties.

For best results, render with mental ray or another renderer that supports 32-bit floating-point output and set the output format to PIC, HDR, or EXR. If using the scanline renderer or another renderer that doesn’t support 32-bit floating-point output, set the Scale Factor parameter, which acts as a multiplier, to adjust the range of values for the output data.
Interface

![Image of Interface](image)

**Scale Factor** When you use a renderer that does not support floating-point output, set Scale Factor to a value less than 1.0. Default=1.0 (no scaling).

Lighting Texture Element Rollout

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Render Elements panel > Render Elements rollout > Add button > Render Elements dialog > Add Lighting element to the elements list (or highlight an existing Lighting element in the list).

The lighting element contains the effects of lighting within the scene, including color, shadows, direct and indirect light.

This rollout lets you determine which parts of the lighting are included in the rendering.

Interface

![Image of Interface](image)
Direct Light On  When on, the render element includes information from any direct lights in the scene. The light’s color and projection map should appear.

NOTE  The final color for direct lighting takes surface normals into consideration.

Indirect Light On  When on, the render element includes information from ambient or bounced lighting in the scene.

NOTE  When using radiosity, expect effects such as color bleed.

Shadows On  When on, the render element includes shadows.

Luminance HDR Data Element Parameters Rollout

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Render Elements panel > Render Elements rollout > Add button > Render Elements dialog > Add Luminance HDR Data element to the elements list (or highlight an existing Luminance HDR Data element in the list).

Generates an image containing 32–bit floating-point data that can be used for analyzing the perceived brightness of a surface after light has been “absorbed” by the material of the surface. The luminance data considers material characteristics such as reflectance and transmittance.

Luminance takes surface properties into account.
For best results, render with mental ray or another renderer that supports 32-bit floating-point output and set the output format to PIC, HDR, or EXR. If using the scanline renderer or another renderer that doesn't support 32-bit floating-point output, set the Scale Factor parameter, which acts as a multiplier, to adjust the range of values for the output data.

**Interface**

![Luminance HDR Data Element Parameters](image)

**Scale Factor** When you use a renderer that does not support floating-point output, set Scale Factor to a value less than 1.0. Default=1.0 (no scaling).

**Matte Texture Element Rollout**

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Render Elements panel > Render Elements rollout > Add button > Render Elements dialog > Add Matte element to the elements list (or highlight an existing Matte element in the list).

The Matte render element displays a matte mask for a selected object, material ID channel (effect ID) on page 5694, or G-Buffer ID on page 8589. Each matching element is represented with a white pixel on the mask.

For more info on matte behavior, see **Matte Object** on page 8636.

**WARNING** The Matte render element does not work for objects to which the mental ray material on page 5951 is applied.
Interface

Effect ID  Sets the material ID channel on page 5694 to include in the Matte render element.

G-Buffer ID Sets the G-Buffer ID on page 8589 to include in the Matte render element.

Include  Opens the Exclude/Include dialog on page 5445, where you can select objects in the scene to exclude or include in your Matte mask.
When including, all selected objects are rendered with white pixels.
When excluding, all pixels are white, by default. Selected objects are rendered as black pixels.

WARNING If you use Exclude, make sure the Effect ID and G-Buffer ID parameters are not on. These modes provide inferior results when used in combination.

mr A&D Elements

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Render Elements panel > Render Elements rollout > Add button > Render Elements dialog > Add one or more mr A&D elements to the elements list (or highlight an mr A&D entry in the list).

The mr A&D elements let you specify as render elements the most important components of the Arch & Design material on page 5858, generally in three different contribution types: raw, level, and output. You can save these as HDR image files for subsequent compositing in a program such as Autodesk Toxik.
NOTE As their names suggest, these render elements pertain only to objects to which the Arch & Design material on page 5858 is applied, rendered with mental ray.

With most of the elements, raw is the unscaled contribution, and level is the scaling, and the output component, calculated by multiplying the raw and level components, is the resultant contribution of the element to the full rendered output. The level is often related to an input parameter (or combinations thereof), and has been modified to abide by the energy-conservation feature of the Arch & Design material.

Hence the elements contain some redundancy: For example, if you just want the current reflections in a separate channel, use the Output Reflections element, but if you want more control over the amount of reflections in post-production, you can instead use Raw Reflections and Level Reflections,
multiplying them (with optional, additional processing) in the compositing phase prior to adding them to the final color.

Reflections: Raw (left) * Level (center) = Output (right)

**NOTE** In order to maintain a correct compositing equation, the effects of the mr Photographic exposure control on page 7219 are intentionally excluded from the A&D render elements output.

**TIP** When rendering mr A&D elements for compositing in an HDR application like Toxik, be sure to set Frame Buffer Type on page 6739 to Floating-Point (32 bits per channel), which allows raw-element values to exceed 1.0, and save output files in the OpenEXR format on page 7850.

**List of All Outputs**

Following is a list of all available render elements for the Arch & Design material (each has the “mr A&D” prefix):

- **Output: Beauty** The main, blended output. It is identical to the single output of the Arch & Design material.

- **Diffuse Direct Illumination** Output is the resulting diffuse on page 5861 component after lighting, including textures. Raw is the diffuse lighting itself, without textures, and Level Diffuse is the diffuse texture color adjusted by the energy conservation.

- **Diffuse Indirect Illumination** Output is the resulting indirect illumination, including ambient occlusion on page 5878 effects, multiplied by the diffuse color. Raw is the raw result from indirect illumination. There is no Level component.

- **Ambient Occlusion** Raw is the raw contribution of the ambient occlusion on page 5878.
■ **Diffuse Indirect Illumination with AO**  Xtra is the indirect illumination affected by ambient occlusion but *without* being multiplied by the diffuse color.

■ **Opacity**  Output (Opacity Background) is the final contribution of any background of the object as a result of the input cutout on page 5892 opacity (as determined by the assigned map) being less than 1.0. Raw contains the background without scaling by the opacity. If the cutout opacity is 1.0, these outputs contain black, because no transparency is rendered in such cases. The Level output contains the actual opacity itself. Care must be taken if opacity equals zero, because this mean that the material has performed no shading whatsoever and none of the other outputs will contain any value at all.

■ **Reflections**  Output is the resulting Reflection group on page 5862 component. Raw is the unalloyed (full-intensity) reflection, and Level is the actual reflectivity, including reflection color and BRDF on page 5871 settings.

*WARNING* The Arch & Design material samples very-low-level reflections in the rendering phase at low quality (for performance), so avoid doing huge modifications to reflection intensity in post.

■ **Self Illumination**  Output contains the Self Illumination (Glow) on page 5873 component.

■ **Specular**  Output is the resulting specular component. Raw is determined by the Reflection > Glossiness on page 5863 value and the Anisotropy on page 5870 settings, while Level is determined by the BRDF on page 5871 settings, the Reflectivity on page 5862 and Reflection > Color on page 5863 values, and the Relative Intensity of Highlights on page 5885 value.

■ **Translucency**  Translucency is the combined result of the Weight on page 5868 and Color on page 5869 settings. Output is the resulting translucency component, Raw is the raw translucency, and Level is the actual translucency level, adjusted by the energy conservation.

■ **Transparency**  Transparency is the combined result of the Refraction group on page 5883 settings, including the Translucency settings. Output is the resulting transparency component, Raw is the raw transparency, and Level is the actual transparency level, adjusted by the energy conservation.
Proper Compositing

Due to the redundancy available in the outputs, there are several ways to composite them to yield the same result as the beauty render. Here we outline two compositing pipelines in equation form. You can use these in Autodesk Toxik and other HDR compositing applications.

First we have the “simple” variant, which is simply a sum of the various result parameters. This version allows only minimal post-production changes to the overall balance between the materials. Its advantage is in not needing as many files, as well as working reasonably well in non-floating-point compositing.

\[
\text{Beauty} = \text{Output Diffuse Direct Illumination} + \text{Output Diffuse Indirect Illumination} + \text{Output Specular} + \text{Output Reflections} + \text{Output Transparency} + \text{Output Translucency} + \text{Self Illumination}
\]

Then we have the more “complex” variant, which uses the various raw and level outputs, thus allowing much greater control in post production.

Note that the raw outputs need to be stored and composited in floating point to maintain the dynamic range. The level outputs always stay in the 0.0-1.0 range and do not require floating-point storage.

\[
\text{Beauty} = \text{Level Diffuse} \times (\text{Raw Diffuse Direct Illumination} + (\text{Raw Diffuse Indirect Illumination} \times \text{Raw Ambient Occlusion})) + \text{Level Specular} \times \text{Raw Specular} + \text{Level Reflections} \times \text{Raw Reflections} + \text{Level Transparency} \times \text{Raw Transparency} + \text{Level Translucency} \times \text{Raw Translucency} + \text{Self Illumination}
\]

Interface

All mr A&D render elements have the same settings:

**Multiplier** Scales the brightness of the output.
When rendering A&D elements for compositing in Autodesk Combustion, bear in mind that Combustion does not support HDR imagery, so to avoid clamping it will be necessary to adjust the Multiplier value for each element.

**Apply Shadows** When on, the output includes shadows cast on the surface.

**mr Labeled Element Parameters Rollout**

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Render Elements panel > Render Elements rollout > Add button > Render Elements dialog > Add mr Labeled Element to the elements list (or highlight an mr Labeled Element entry in the list).

The mr Labeled Element is a render element that lets you output one or more branches of a material tree to a custom render element. (A branch comprises a map or shader and any sub-elements, such as maps assigned to the map’s map slots.)

To use this element, assign the *mr Labeled Element shader* on page 6414 as the parent of the branch to render, give it a label, and then use the same label for the render element. For details, see the following procedure.

**Procedure**

**To use the mr Labeled element:**

1. In the Material Editor, determine which branch of a material to output as a separate element. For example, an Arch & Design material might contain a Gradient map assigned as a Diffuse > Color shader, and one of the Gradient maps could be assigned a Checker map, and one of the Checker maps could be assigned a Noise map. This procedure will assume you want to render the Checker map and its constituent Noise map to an element.

   So the material structure would be like this:

   A&D material > Gradient (Diffuse Color) > Checker (Gradient Color #1) > Noise (Checker Color #1)

2. In the Material Editor, click the map button at the top of the branch you want to output. In this example, you’d click the Diffuse > Color map button in the Arch & Design material to open the Gradient map settings. You’d then click the first map button (Color #1) on the Gradient Parameters rollout to open the Checker map settings.
3 Click the map button just above the map rollouts on the right side of the Material Editor (in this example, Checker) to open the Material/Map Browser.

4 On the Material/Map Browser, double-click the mr Labeled Element item. This opens the Replace Map dialog.

5 Make sure “Keep old map as sub-map?” is chosen, and then click OK.

6 You now see the mr Labeled Element Parameters rollout. If you click the Shader/Map To Store (Passthrough) button, labeled “M”, you can access the branch that will be output to the render element: the Checker map containing the Noise map.

7 If you clicked the M button, go back up to the parent mr Labeled Element shader, and then enter a name for the element in the Label field. In this example, the name could be **checker/noise branch**. The material structure would now be like this (new map in italics):
   
   A&D material > Gradient (Diffuse Color) > mr Labeled Element shader (Gradient Color #1) > Checker (mr Labeled Element shader map) > Noise (Checker Color #1)

8 On the Render Setup dialog > Render Elements panel > Render Elements rollout, click Add. Choose the mr Labeled Element item from the list.

9 On the Parameters rollout for the element, enter the name you specified in step 7 in the Label field.

10 Set up the other Render Element parameters as necessary and then render the scene.

   Your custom element is rendered to an image file.

   The following illustration shows the example described in the preceding procedure. The left-hand image shows the full material, with the Noise inside the Checker inside the Gradient, and the right-hand image shows a labeled element containing only the Noise inside the Checker. The element renders only the part of the Checker map that is used by the Gradient map.
Interface

**Label** Enter the name of the element you specified in the Mr Labeled Element Shader > Label field.

**Multiplier** Scales the brightness of the rendered output.

**Apply Shadows** When on, the output includes shadows cast on the surface.

### mr Shader Element Parameters Rollout

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Render Elements panel > Render Elements rollout > Add button > Render Elements dialog > Add mr Shader Element to the elements list (or highlight an mr Shader Element entry in the list).

The mr Shader element outputs the raw contribution of any mental ray shader in the scene. This includes standard 3ds Max materials and maps that are converted to mental ray shaders in the translation process. The output of this element does not figure into the final rendered output.

For example, you could use the mr Shader element to render a few different ambient occlusion passes (see mental images Shader Libraries on page 6388).
NOTE The mr Shader element is intended primarily for rendering shaders, not full materials. While you can, in most cases, most "material-style" shaders might contain their own code to write to render elements, and in some circumstances this can cause odd conflicts. For example, piping a Standard material through a Material To Shader shader on page 6412 into the mr Shader element is not recommended because it could cause the Standard material’s render element to collide with the original render elements from the main render.

Procedure

To use the mr Shader element:

1. In the Material Editor, determine which shader to output as a separate element. For example, an Arch & Design material might contain a Gradient map assigned as a Diffuse > Color shader, and one of the Gradient maps could be assigned a Checker map, and one of the Checker maps could be assigned a Noise map. This procedure will assume you want to render the Checker map and its constituent Noise map to an element.

So the material structure would be like this:

A&D material > Gradient (Diffuse Color) > Checker (Gradient Color #1) > Noise (Checker Color #1)

2. On the Render Setup dialog > Render Elements panel > Render Elements rollout, click Add. Choose the mr Shader Element item from the list.

3. On the Parameters rollout for the element, click the Shader button; this opens the Material/Map Browser dialog.

4. Make sure Browse From on the dialog is set to Scene. If the object to which the shader is applied is selected, you could also choose Selected. In the material tree, highlight the shader to output as an element.

NOTE Any subordinate shaders are also included in the element output.

5. Set up the other Render Element parameters as necessary and then render the scene.

Your Shader element is rendered to an image file.

The following illustration shows the example described in the preceding procedure. The left-hand image shows the full material, with the Noise inside the Checker inside the Gradient, and the right-hand image shows a Shader element containing only the Noise inside the Checker. The
element renders the entire Checker map even though only part of it is used by the Gradient map.

![Left: Full rendering; Right: Shader element](image)

**Interface**

<table>
<thead>
<tr>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shader: None</td>
</tr>
<tr>
<td>Multiplier: 1.0</td>
</tr>
<tr>
<td>Apply Shadows</td>
</tr>
</tbody>
</table>

**Shader** The shader to render as an element. Click the button and then choose a shader or material from the list in the Material/Map Browser. Typically you’d want the element to output a shader in the scene, so you’d make sure Browse From is set to Selected or Scene.

**Multiplier** Scales the brightness of the rendered output.

**Apply Shadows** When on, the output includes shadows cast on the surface.

**Object ID Element Rollout**

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Render Elements panel > Render Elements rollout > Add button > Render Elements dialog > Add Object ID element to the elements list (or highlight an existing Object ID element in the list).

Renders the object ID information assigned to the object.
Roughly comparable to the material ID, the object ID information is useful for selecting objects based on an arbitrary index value in another image-processing or special-effects application. If you know that you will want to select several objects at once, at a later time, you can assign them all the same object ID in 3ds Max. By rendering with the object ID, this information will be available in other applications.

You assign the object ID with the Object Properties dialog > General panel > Object Channel parameter on page 293. A given object ID is always represented by the same (arbitrary) color. The correlation between a specific material ID and a specific color is the same in Combustion.

When an Object ID entry is highlighted in the element rendering list on page 6816, the Object ID Element rollout appears on the Render Elements panel. This rollout lets you choose whether to base the render color of a given object ID on the object color or the Object ID. If you choose Object Color, the render color is the object's base color, as shown on the Create panel > Name And Color rollout and at the top of the other command panels, and is not based on the Object ID. If you choose Object ID, an arbitrary color is assigned to each object based on its Object ID.

**Interface**

![Object ID Element](image)

**Render Color Based On**
- **Object Color** Renders colors based on object colors.
- **Object ID** (The default.) Renders colors based on Object IDs.

**Velocity Element Parameters Rollout**

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Render Elements panel > Render Elements rollout > Add button > Render Elements dialog > Add Velocity element to the elements list (or highlight an existing Velocity element in the list).
The Velocity element generates a rendering that contains information about the motion of objects in the frame. You can use the Velocity rendering to generate motion blur when you use a composition application such as Combustion or Flame. There are plug-ins for compositors that generate motion blur; for example, those created by RE:Vision Effects, Inc.

The advantages of rendering a Velocity element are that the composition application might give you finer control over the motion blur than 3ds Max does; you can render a “beauty” frame that does not contain motion blur; and the Velocity element is quicker to render than using one of the 3ds Max motion-blur effects.

Another use of the Velocity element is to re-time clips rendered in 3D. There are specialized applications that allow you to re-time an image sequence, using velocity data to generate more accurate inbetween frames.

In the Velocity rendering, the motion information is saved as RGB color information:.red saves movement on the X axis, green saves Y-axis movement, and blue saves Z-axis movement, relative to the plane of the rendered frame.

The mental ray renderer supports this element, but the mental ray Motion Blur camera effect must be turned off. Also, some mental ray materials do not support render elements.

Controls on the element’s rollout let you improve the precision of the motion data saved in the rendering. See the procedure, following.

**Procedures**

**To render a velocity element for an animation sequence:**

1. On the Render dialog > Render Elements panel > Render Elements rollout, click Add. In the Render Elements dialog that appears, highlight Velocity, and then click OK.
2. Highlight the Velocity element in the Element Rendering list.
3. On the Velocity Element Parameters rollout, turn on Update, then render several test frames. (Choose frames where object velocity appears to be the greatest.)
4. After each test frame, make a note of the Maximum Velocity value. If you need to do so, enter the largest of these values as the Maximum Velocity to use.

Having a specific Maximum Velocity value will give you more accurate velocity data.
5  Turn off Update.
   Now the Maximum Velocity will remain constant.

6  Render the animation.

Interface

Maximum Velocity  Enter a Maximum Velocity value based on the result collected by Update. Setting a Maximum Velocity increases the precision of the motion information. See the procedure, above: Procedures on page 6841. Default=1.0.

Update  Turn on when you render test frames, as described in the above procedure. After each rendering, Maximum Velocity is set to the value recorded by update. Use the largest of these values, and then turn off Update before you render the full animation. Default=off.

NOTE  The Update control does not work with mental ray distributed bucket rendering.

Z Depth Element Parameters Rollout

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Render Elements panel > Render Elements rollout > Add button > Render Elements dialog > Add Z Depth element to the elements list (or select an existing Z Depth element in the list).

The Z-depth element is a grayscale representation of the Z depth, or depth within the view, of objects within the scene. The nearest objects appear in white, and the depth of the scene in black. Intermediate objects are in gray. The darker the gray, the deeper the object is, within the view.

This rollout lets you adjust what portion of the scene is shown in the Z-depth rendering. By default, the rendering includes objects near the front of the view (Z Min=100.0), and extends for 300 3ds Max units into the scene (Z
If your scene is deeper than 300 units, you need to increase the value of Z Max.

You can use the Update option to let 3ds Max automatically determine the depth extents of objects in the rendered view.

**Interface**

- **Z Min** The minimum distance to include in the Z-depth rendering. This is a value in 3ds Max units, and cannot be less than 0.0. Default=100.0
- **Z Max** The maximum distance to include in the Z-depth rendering. This is a value in 3ds Max units. Default=300.0
- **Update** Lets 3ds Max automatically determine the depth range of objects in the rendered view. When on, after completion of a rendering, 3ds Max changes the Z Min and Z Max values to reflect what the renderer determined. Typically, you would make a single test rendering with this on, and then turn off the check box.

**Render to Texture**

Make sure the default scanline renderer or the mental ray renderer is the active renderer.  > Select one or more objects.  > Rendering menu > Render To Texture

Rendering to texture, or "texture baking," allows you to create texture maps based on an object's appearance in the rendered scene. The textures are then "baked" into the object: that is, they become part of the object via mapping, and can be used to display the textured object rapidly on Direct3D devices such as graphics display cards or game engines.

You can render to textures using the mental ray renderer on page 6675

**Typical Texture Baking Method**

1. Set up a scene with lighting.
2 Select the objects whose textures you want to bake.

3 Choose Rendering > Render To Texture.

4 A Render To Texture dialog on page 6869 appears. In this dialog, you choose which elements on page 6848 of the rendering you want to bake. Elements are aspects of the rendering such as diffuse color, shadows, alpha (transparency/opacity), and so on.

In this dialog, you can also choose various display options on page 6855 for showing the baked texture in shaded viewports.

TIP If you have a Direct3D graphics display driver, you can use DirectX viewport shaders on page 5771 to view the baked texture in shaded viewports. They show how the baked texture will appear on DirectX devices.
After you click Render in the Render To Texture dialog, a number of things happen. (This is a typical set of events; the dialog gives you a lot of control over how texture baking actually occurs.)

- The elements you chose are rendered, each to its separate bitmap file.

Lighting map of the banana

By default, the texture type is Targa on page 7878, and the element maps are placed in the \images subfolder of the folder where you installed 3ds Max. The new textures are “flat”: In other words, they are organized according to groups of object faces.

- In the modifier stack, a new modifier is applied to the object. It is called Automatic Flatten UVs. It is simply an Unwrap UVW modifier on page 1837, automatically applied. This modifier manages the mapping of the flattened texture to faces of the object, and lets you adjust that mapping if necessary.
A **Shell material** on page 6174 is applied to the object. This material is a container for both the object’s original material (you don’t lose those maps and settings), and the newly created baked material, with its new textures. The Shell material lets you access both materials and adjust their settings, if necessary. It also lets you choose which material to view, the original material or the texture-baked material, in shaded viewports or in renderings.

New shell material contains the banana’s original material (below left) and the baked texture (below right).
Rendered light map applied to the banana

With the light map, banana appears lit even when lights are turned off.

That is texture baking in a nutshell.

For best results, Logarithmic exposure control is recommended for Render To Texture.

If Linear or Automatic exposure controls are used, each object will have different lighting levels, generating a different histogram. Each object renders as if it had a different light level and in some cases, you may not get a rendering at all. This happens because Linear and Automatic exposure controls are view dependent.
Logarithmic Exposure Control is not view dependent, and will reproduce the image correctly. See the Exposure Controls on page 7207 topic for more information about Linear, Automatic and Logarithmic exposure controls.

See also:
- Shell Material on page 6174
- DirectX Manager Rollout on page 5771
- LightMap Shader Rollout on page 6179
- Metal Bump Shader Rollout on page 6180

Baked Texture Elements

Select objects. > Rendering menu > Render to Texture > Render to Texture dialog > Output rollout > Click Add. > Add Texture Elements dialog > Choose elements to render.

When you render to texture or “bake” a texture, you choose one or more elements to render. These elements save aspects of the rendered scene: its geometry, lighting, shadows, and so on. Some texture elements can display in shaded viewports; others require a DirectX viewport shader on page 5771 to view in 3ds Max.

When you add an element to render, it appears in a list in the Objects To Bake on page 6872 rollout. In the list, you can disable or enable rendering of that individual map, or select it to adjust which components it will include.

NOTE Automatically generated reflections and refractions do not work well with rendered textures, although they are included in the Complete and Blend texture maps.

The available element maps are described in the sections that follow.

Limitations of Composite and Blend Materials

If the object has a Composite or Blend material applied to it, only certain elements render correctly. Which elements render correctly depend on the renderer you are using.
The default scanline renderer renders only these elements of a Composite or Blend material correctly:

- Diffuse color
- Specular color
- Reflections
- Ambient color
- Self-illumination color
- Refractions

The mental ray renderer renders only these elements of a Composite or Blend material correctly:

- Lighting
- Shadows
- Normals

Component Options (Unique Settings)

Many element maps let you choose to include or not include components of the rendered scene. When your element to render is highlighted in the list, these options appear on the Selected Element Unique Settings group.

See also:

- Render to Texture on page 6843
- Render to Texture Dialog on page 6869

Complete Map

A complete map saves most surface properties of the rendered object; specifically:

- Lighting
- Diffuse color
- Specular color
Reflections
Shadows
Ambient color
Self-illumination color
Refractions

**Component Options (Selected Elements Unique Settings)**
For a complete map, you can choose not to render shadows.

**Specular Map**
A specular map saves only the specular color of the object.

**Component Options (Selected Elements Unique Settings)**
For a specular map, you can choose not to render lighting or shadows.

**Diffuse Map**
A diffuse map saves only the diffuse color of the object.

**Component Options (Selected Elements Unique Settings)**
For a diffuse map, you can choose not to render lighting or shadows.

**Shadows Map**
A shadows map saves only the shadows cast onto the object.

**Component Options (Selected Elements Unique Settings)**
There are no unique settings for a shadows map.

**Lighting Map**
A lighting map saves only the lighting cast onto the object.
Component Options (Selected Elements Unique Settings)

For a lighting map, you can choose not to render shadows, direct light, or indirect light.

Normals Map

A normals map saves a color gradient that indicates the direction of normals on the surface of the object. With a normals map, Direct3D rendering can make simple geometry appear more complex.

With DirectX 8, you can view a normals map in shaded viewports by using the Metal Bump Direct3D viewport shader on page 6180.

With DirectX 9, you can view a normals map in any shaded viewport.

Component Options (Selected Elements Unique Settings)

There are two unique settings for a normals map:

Output into Normal Bump When on, assigns a Normal Bump map to the Target Map Slot, and places the rendered Normal Bump map in the Normal component of the Normal Bump map on page 6450. Default=off.

Render Height Map into Alpha Channel When on, renders a grayscale height map and assigns it to the alpha channel of the Normal map. If you are rendering to a file type that doesn’t have an alpha channel, this setting has no effect. Default=off.

Height Map

A height map is a grayscale map that stores the relative height of the source object when you render with normal projection. (See Creating and Using Normal Bump Maps on page 6856.) You can use the height map as a displacement map on the target object. This is a way to add detail to the edges of the low-resolution object, because edges are not affected by the normal bump map itself.

**NOTE** When using a height map as a displacement map with the mental ray renderer, be sure to use the Height Map Displacement shader on page 6411. Also, turn off Smoothing, either globally on page 6759 or for the individual object on the Object Properties dialog > mental ray panel on page 300. In addition, when rendering with mental ray, if you’re applying the height map to a standard material, apply the map as a Displacement map on the mental ray Connection rollout on page 5763 (unlock the map first), not on the Maps rollout.
TIP Using a paint program such as Adobe Photoshop on a height map is possible, but prone to error. The values in the height map depend on the shapes of both the low-resolution and high-resolution models, and it’s easy to damage the mathematical accuracy. If you paint any changes onto the map, be careful to preserve the faceted look, and avoid the temptation to blur away the facets. You might try painting in Additive or Subtractive mode, to add to or subtract from the displacement, because Normal mode will set a fixed displacement, making it difficult for an artist to control the result.

Component Options (Selected Elements Unique Settings)

There are no unique settings for a height map.

Blend Map

A blend map is like a complete map, except that all its components, not just shadows, are optional.

Component Options (Selected Elements Unique Settings)

For a blend map, you can choose not to render any of the following components:

- Lighting
- Diffuse color
- Specular color
- Reflections
- Shadows
- Ambient color
- Self-illumination color
- Refractions

Alpha Map

An alpha map saves only the alpha channel of the rendered object.

Component Options (Selected Elements Unique Settings)

There are no unique settings for an alpha map.
Ambient Occlusion (MR) Map

Use an ambient occlusion map when you want the surface information to describe how much ambient light the surface can receive. The ambient occlusion map considers the obstruction of the light by surface contours and surrounding objects. By using the ambient occlusion map when rendering, you do not need to set up special lighting, replace materials on the objects, or use with global overrides because the ambient occlusion map already accounts for these settings.

You can use ambient occlusion maps with or without a Projection modifier and for many different purposes. Use them to mask layers in Adobe Photoshop, for items such as painted edits and texture maps. Also use them as dirt maps, or as masks for reflections or specular light.

**NOTE** By default, the shader used by the Ambient Occlusion bake element excludes the low-resolution object from the ambient occlusion calculations whenever performing projection-mapped texture baking. However, if the Projection Mapping option Include Working Model on page 6891 is enabled, then the occlusion rays will include the working model. In this case, projection rays also include the working model. No undesired blank areas appear on the map, because there are no cases where a projection ray passes through the lo-res model to hit a point on the high-res model that is completely occluded by the low res.

**NOTE** This map is available only when the mental ray renderer is active.
Original scene surrounded by rendered-to-texture ambient occlusion maps of the floor object
Top left: Samples=8; Spread=0.8
Top right: Samples=32; Spread=0.8
Bottom left: Samples=16; Spread=0.5
Bottom right: Samples=16; Spread=0.99

Component Options (Selected Elements Unique Settings)

For an ambient occlusion map, you can set the following unique settings:

**Samples**  Sets the number of rays cast. More rays results in a smoother image. Default=16.
**Spread** Sets the spread of the ray, creating a cone shape. With a value of 0.0 a single point is sampled; with a value of 1.0 the entire hemisphere is sampled. Range=0.0–1.0. Default=0.8.

**NOTE** You can set Spread to values greater than 1.0, but only values within the specified range are useful.

**Bright** Sets the color in the map where no occlusion occurs. The default color is white. Click the swatch to change the color.

**Max distance** Sets the range within which geometry is probed. A value of 0.0 samples the entire scene. For non-zero values, only objects within this range are sampled. Default 0.0.

**Dark** Sets the color in the map where complete occlusion occurs. The default color is black. Click the swatch to change the color.

**NOTE** Colors between the Bright and Dark values are used to indicate partial occlusion.

**Falloff** Defines the amount of falloff of the ray. The greater the value, the greater the falloff. Default=1.0.

### Target Map Slot Assignments

Select objects. > Rendering menu > Render to Texture > Render to Texture dialog > Output rollout > Target Map Slot: drop-down list > Specify how baked textures appear in the material.

When you bake textures (render to texture), you have more control for how the baked texture displays in shaded viewports. You set these in the **Output rollout** on page 6878 of the Render To Texture dialog. Using the Target Map Slot assignments, you can specify in detail which maps will be rendered to which slots of the existing material.

**NOTE** The first time you use Render To Texture, all Target Map Slot assignments are blank. After you set them and render the baked texture, those settings become the default Target Map Slot settings for future modelling sessions. 3ds Max stores the Target Map Slot assignments in the `texturebake.ini` file in the `plugcfg` folder within the 3ds Max directory.
Creating and Using Normal Bump Maps

Normal bump mapping is a way of adding high-resolution detail to low-polygon objects. It is especially useful for real-time display devices such as game engines, and it can also be used in rendered scenes and animations.

A normals map is a three-color map, unlike the grayscale maps used for regular bump mapping (see Bump Mapping on page 6049). The red channel encodes the left-right axis of normal orientation, the green channel encodes the up-down axis of normal orientation, and the blue channel encodes vertical depth.

Basic Workflow

3ds Max provides a number of different ways to create and use normal bump mapping, but the most straightforward and simplest workflow involves these steps:

1. Create a detailed, high-resolution model.
2. Create a simpler, low-resolution model.
   The low-resolution model should have the general shape and outlines of the high-resolution model, and typically it should be a bit smaller, so that projected detail in the high-res model will appear to be above its surface.
3. Select the low-res model.
4. Choose Rendering > Render to Texture.
   The Render To Texture dialog appears.
5. On the Objects To Bake rollout, in the Projection Mapping group, click Pick.
   A selection dialog appears.
6. Choose the high-res object, and then click Add.
   3ds Max applies a Projection modifier on page 1596 to the low-res object.
7. In the Projection Mapping group, turn on Enable.

NOTE At this stage, often you will click Options to display the Projection Options dialog on page 6888, which has a variety of settings for how to generate the projection.
8 On the Output rollout, add a NormalsMap element (see Baked Texture Elements on page 6848). Assign Bump as its target map slot.

9 In the Selected Elements Unique settings group, turn on Output Into Normal Bump.

10 Click Render.

3ds Max renders the Normals map, which stores normals data from the high-res object. As for other kinds of texture baking, it creates a Shell material and applies that to the low-res object, with the Normals map assigned as the bump component.

Components of Normal Bump Mapping

In the 3ds Max interface, controls for normal bump maps appear in three locations:

- The Render To Texture dialog
  Specifically, normal projection controls are found on the Objects To Bake rollout on page 6872 and the Output rollout on page 6878.

- The Projection modifier on page 1596
  You can apply a Projection modifier yourself, or let Render To Texture do so automatically.

- The Normal Bump map type on page 6450
  Render To Texture creates this automatically if you turn on Output Into Normal Bump (step 9, above).

Viewing Normal Bump Maps

If your display driver uses DirectX 8, you can view normal maps in viewports by using the Metal Bump shader on page 6180. If your graphics driver is DirectX 9, you can view normal maps in any shaded viewport. See Direct3D Driver Setup Dialog on page 8323.

If your display driver is Software or OpenGL, you can't view normal maps in viewports. However, you can still render them and use normal mapping in renderings.

Normal Projection with Sub-Object Selections

You can associate different sub-object selections with different high-resolution geometry. See Reference Geometry Rollout (Projection Modifier) on page 1601.
Troubleshooting Normal Bump Maps

Because of the variety of geometry and different situations that can arise, normal bump maps sometimes give unexpected results. Usually there is a workaround for the problem, or more than one. This topic describes some situations that can arise, and ways to correct them.

Parallel Projection Loses Detail

If the projection cage is set up so projected rays run parallel to part of the high-resolution geometry, that portion of geometry can be lost in the normal bump map.

For example, in this scene, the normal bump map is based on a high-resolution cylinder that has indentations at the top and bottom.
Default cage around high-res cylinder

However, the normal bump map does not show the end indentations.
Indentation is missing from top and bottom of the cylinder's normal bump map.

The reason is that with the default projection cage, the rays parallel the sides of the indentation, and so details are lost.

Projection rays (shown in red) parallel the sides of the indentation.
To correct the problem, you can move the end of the cage upward, and scale it inward a little, so the rays don’t run so nearly parallel to the side of the indentation.

When the cage is adjusted this way, the indentation appears in the normal bump map.
With the corrected cage, the upper indentation appears correctly in the normal bump map.

**TIP** In situations like this, another solution can be to use Break on the vertices in the region of the low-resolution object where detail is missing from the map. This increases the number of vertices in the cage, and reduces the chances of geometry being missed. If you use this method, it is likely you will need to make further adjustments to the projection cage, as well.
Breaking low-res vertices causes the indentations to render in the normal bump map. However, projection now misses some areas of the geometry, so the cage needs to be adjusted further.

Flipped Seams in Tangent Space

When you use tangent space for your normal bump map, usually the values used for the tangents are consistent between the hardware shader, renderers, and third-party applications. However, sometimes portions of the geometry are flipped, relative to each other, causing discontinuities when you render or use a hardware shader. Tangent space is the default option for normal bump mapping, and it is the method you should use for objects that both move and deform, such as animated characters. This problem does not arise when you use the other coordinate spaces: world, screen, or local.

For example, in the following scene, the pants show discontinuities. They are flipped relative to each other, as the arrows show.
Flipped seams in rendering of pants

Left: Left side shows a discontinuous red stripe
Right: Right side shows a discontinuous blue stripe
The arrows show how the maps are misaligned.

When you render a normal bump map, you can generally see flipped areas as showing a “flare” of reddish color to the right, and of bluish color to the left.
Uncorrected normal bump map shows blue and red “flares.”

The solution is to use the UVW Unwrap modifier’s Flip Horizontal command for those sub-object selections that show flaring, or an excess of red areas.
Normal bump maps corrected using Flip Horizontal
Red and blue are more evenly distributed, with blue predominating.

With the maps corrected, the full rendering, whether with 3ds Max or a hardware renderer, looks better.
Corrected normal maps render more smoothly, without discontinuity. The arrows show how the maps are correctly aligned to wrap around the pant legs.

**Noise when Rendering a Normal Bump Map with the mental ray Renderer**

If you use the mental ray renderer to render a normal bump map, and the model has overlapping faces (for example, where the low-resolution and high-resolution objects overlap in space), then the normal bump map can show noise where the faces overlap.
Red areas show noise from overlapping faces

The workaround is to adjust either the high-res or the low-res object so that faces are not coincident. One way to do so is to use a Push modifier on page 1640. After you have generated the normal map, you can turn off the Push modifier.

**TIP** If another object in the scene continues to cause problems with the map rendering, you can make it invisible to normal projection by going to its Object Properties dialog, and in the Rendering Control group, turning off Visible To Reflection/Refraction.
Overlapping UV Coordinates

Overlapping UV coordinates can cause rendering errors in Render To Texture. The problem is especially noticeable on objects that have mirrored UVs, or symmetrical mapping. If you are working with a character or other model that has mirrored UVs, we recommend that you follow this procedure:

1. Either add an Unwrap modifier or go into an existing Unwrap modifier where the symmetry exists.
2. Move half of the overlapping texture coordinates on the W axis so that they’re slightly offset from the other half. Render To Texture will use the texture coordinates with the higher W value.

Edit Normals Modifier Makes Normal Bump Mapping Incorrect

Don’t apply an Edit Normals modifier on page 1322 to the low-res object. Normal bump projection relies on the low-res object having standard normals, and altering them causes normal bump maps to have unpredictable results.

Render to Texture Dialog

Rendering menu > Render To Texture > Render to Texture dialog

Rendering to texture, or “texture baking,” is controlled by this dialog. Most of this dialog’s controls are contained in its rollouts.

Procedures

To bake an object’s texture:

There are a lot of options for rendering to textures. These are the basic overall steps.

1. Select an object.
   Ideally, the object will have a texture assigned to it, or lights and shadows that fall on it, and so on.
2. Choose Rendering > Render To Texture.
3. In the same dialog, go to the Output rollout.
4 Click Add, and in the Add Texture Elements dialog, choose the element(s) you want to render.

5 Set Target Map Slots, if necessary.

6 Click Render.
   The elements you chose to render are rendered to files, and the baked texture is displayed in shaded viewports.

To bake the texture of multiple objects:

1 Set up the texture-baking parameters of each object you want to bake. This corresponds to steps 2 through 5 of the previous procedure.

2 In the Objects To Bake rollout, change All Selected to All Prepared.

3 Click Render.
   Textures are rendered for all the objects you previously set up.

Interface

**Render** Renders the scene, or the elements listed in the Objects To Bake rollout.

**Unwrap Only** Applies the Automatic Flatten UVs modifier to all selected objects without rendering anything.

**Close** Closes the dialog and saves any changes to settings you have made.

**Original/Baked** When set to Views, the original or baked material is displayed in the viewports. When set to Render, the original or baked material is used in the rendering.
Render to Texture: General Settings Rollout

Rendering menu > Render To Texture > Render to Texture dialog > General Settings rollout

This rollout has the texture-baking controls for the current scene. It lets you control automatic unwrapping of the baked textures, map size, render settings, and where texture renderings are saved.

See also:

- Render to Texture on page 6843
- Render to Texture Dialog on page 6869
- Render to Texture: Objects To Bake Rollout on page 6872
- Render to Texture: Output Rollout on page 6878
- Render to Texture: Baked Material Rollout on page 6882
- Render to Texture: Automatic Mapping Rollout on page 6885

Interface

Output group

Text field Specifies the folder where the rendered texture will be saved. You can enter a different folder name in this field. Default=the \images subfolder of the folder where you installed 3ds Max.
Click the ellipsis button to display a dialog that lets you browse to the directory where you want the rendered texture to be saved.

**Skip Existing Files**  Allows you to render only those maps that do not already exist.

**Rendered Frame Window**  When on, displays the complete map in a *Rendered Frame Window* on page 6513 as the elements are rendered. When off, does not open the Rendered Frame Window. Default=on.

**NOTE**  The Rendered Frame Window does not open when you use Render To Texture with the mental ray renderer. Instead, 3ds Max displays a progress dialog.

**Render Settings group**

These controls let you choose and set up Render Presets as well as activate network rendering.

**Drop menu**  Lets you choose *Load Preset* on page 6561. A Render Presets Load dialog appears where you can select an RPS file.

**Setup**  Displays the *Render dialog* on page 6506, where you can adjust production settings, draft settings, or both.

**Network Render**  When on, you can assign the rendering task to Server systems. If you click Render, the *Network Job Assignment dialog* on page 6953 displays where you can specify a server, or multiple servers, to take on the task. Default=off.

3ds Max can use the *Split Scan Lines option* on page 6958 when rendering to textures with a render farm. However, if you enable projection mapping and turn on Sub-Object Levels, this option is unavailable.

**Render to Texture: Objects to Bake Rollout**

This rollout has controls for the texture baking of individual objects. It lets you choose which map channel the texture will use, which elements will be rendered, and at what sizes. It also lets you control filename generation, and assign the format of rendered texture elements.
See also:

- Render to Texture on page 6843
- Render To Texture Dialog on page 6869
- Render To Texture: General Settings Rollout on page 6871
- Render To Texture: Output Rollout on page 6878
- Render To Texture: Baked Material Rollout on page 6882
- Render to Texture: Automatic Mapping Rollout on page 6885
## Interface

### Objects to Bake

**Object and Output Settings**

- **Preset:** [Dropdown]

<table>
<thead>
<tr>
<th>Name</th>
<th>Object Channel</th>
<th>Sub-Object Channel</th>
<th>Edge Padding</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plane01</td>
<td>3</td>
<td>2</td>
<td></td>
</tr>
</tbody>
</table>

**Selected Object Settings**

- **Enabled**
- **Padding:** [Input: 2]

**Projection Mapping**

- **Enabled**
- **(No Projection Modifier)**
- **Options...**
  - **Object Level**
  - **Sub-Object Levels**
  - **Put to Baked Material**
  - **Put to Baked Material**
  - **Full Size**
  - **Proportional**

**Mapping Coordinates**

- **Object:**
  - Use Existing Channel
  - Use Automatic Unwrap
  - **Channel:** [Input: 3]

- **Sub-Objects:**
  - Use Existing Channel
  - Use Automatic Unwrap
  - **Channel:** [Input: 4]

- **Clear Unwrappers**

- **Individual**
- **All Selected**
- **All Prepared**
Object and Output Settings group

This drop-down list lets you save presets comprising all current Render To Texture settings, including map types and sizes, from a single object and then load a preset onto any number of objects. Render To Texture presets use the RTP filename extension. Presets contain all settings on the Objects to Bake and Output on page 6878 rollouts and the Projection Options dialog on page 6888. The only exceptions are the Object Level and Sub-Object Levels radio buttons in the Objects To Bake rollout > Projection Mapping group and the Use Automatic Unwrap > Channel numeric values in the Objects To Bake rollout > Mapping Coordinates group.

Preset Use the upper part of the drop-down list to choose an existing preset to load. The preset is applied to all objects in the objects list. The list contains up to the last 10 maps in the order that they were loaded or saved, with the most recent at the top.

After you choose a preset to load, a dialog appears showing you the path and name of the file containing the preset. Confirm or deny loading the preset by clicking Continue or Cancel, respectively.

In addition, if Projection Mapping is enabled, the dialog might contain related messages. For example, if the target object needs a Projection modifier, the dialog suggests that you use the Pick function to add one.

Load Object Preset Lets you load a preset that's not on the list. The preset is applied to all objects in the objects list. This command appears only when the list of objects contains one or more entries.

Save Object Preset Lets you save the current settings to a preset for later reuse.

NOTE You can save a preset only when the list of objects contains a single entry.
Object list

List of objects  Shows all selected objects. Because the dialog is modeless, you can change the selection while it’s open, and the list updates dynamically.
- Name column  Lists the object’s name.
- Map Channel column  Lists the object’s current map channel setting.
- Edge Padding column  Lists the object’s current edge padding setting.

Selected Object Settings group

Enable  When on, the Channel and Padding controls are used for individual, all selected, and all prepared objects. When off, only selected object texture rendering uses these settings; “whole scene” rendering does not. Default=off.

Padding  The amount, in pixels, that edges are allowed to overlap in the flattened (“unwrapped”) texture. Default=2 pixels.
If the baked texture shows visible seams when you view it in shaded viewports or renderings, try increasing this value.

Projection Mapping group

This group contains the controls for generating a normal bump projection. See Creating and Using Normal Bump Maps on page 6856

Enabled  When on, normal bump projection is enabled using a Projection modifier on page 1596. When off, the Projection modifier is not used. Default=off.
To generate a normal map rather than a normal bump map, leave Enabled turned off.

Modifier drop-down list  When an object has been chosen, this list shows the Projection modifier. If multiple Projection modifiers have been assigned, their names are visible in the list as well.

Pick  Click to designate the high-resolution object from which the Projection modifier will derive normals. This opens the Add Targets dialog, which works like the Select From Scene dialog on page 206 to let you select one or more objects on which to base the normal map.

Options  Click to open the Projection Options dialog on page 6888, which contains various normal bump projection settings. When Individual is chosen (at the bottom of the Objects To Bake rollout), the options affect the selected object; when All Selected or All Prepared is chosen, the options apply to all selected or prepared objects.
Object Level When on, projects from the object level of the high-resolution object. Default=on.

- **Put to Baked Material** (The default.) When chosen, the object-level projection is rendered in the baked material.

Sub-Object Levels When on, uses the active sub-object selection, and makes the Mapping Coordinates group > Sub-Objects controls available. Default=on.

- **Put to Baked Material** When chosen, the sub-object level projection is rendered in the baked material.

The following options apply to sub-object rendering, when only a portion of the geometry is being rendered to the normal bump map:

- **Full Size** (The default.) When chosen, the size of the normal bump map is the same as if all geometry were being rendered.

- **Proportional** When chosen, the size of the normal bump map is fitted to the size of sub-object selection. The Proportional Multiplier on the Projection modifier's Reference Geometry rollout on page 1601 can change the default size of the proportional map.

For example, consider a plane that is 4 segments x 4 segments. Each "poly" in the plane is a separate sub-object, for a total of 16 sub-objects. If the output Map Size is 64, the object rendering output is 64 x 64 pixels. If Full Size is chosen, each sub-object rendering is also 64 x 64 pixels. If Proportional is chosen, each sub-object rendering is 16 x 16 pixels. If you change Proportional Multiplier to 2.0 in the Projection modifier, each sub-object rendering is now 32 x 32 pixels.

**Mapping Coordinates group**

Object These controls are for basing the rendered texture on the object level of the source object.

- **Use Existing Channel** When chosen, unwrapping uses an existing map channel.

- **Channel** When Use Existing Channel is active, lets you choose the channel to use for unwrapping.

- **Use Automatic Unwrap** (The default.) When chosen, uses automatic unwrapping, and applies an “Automatic Flatten UVs” (Unwrap UVW) modifier on page 1837 to the objects whose texture is being rendered.
Sub-Objects These controls are for basing the rendered texture on a sub-object selection of the source object.

- **Use Existing Channel** When chosen, unwrapping uses an existing map channel.

- **Channel** When Use Existing Channel is active, lets you choose the channel to use for unwrapping.

- **Use Automatic Unwrap** (The default.) When chosen, uses automatic unwrapping, and applies an “Automatic Flatten UVs” (Unwrap UVW) modifier on page 1837 to the objects whose texture is being rendered.

Clear Unwrappers Clears the unwrap modifiers from the stack.

---

The radio buttons at the bottom of the rollout let you choose which objects to bake. See Render To Texture Dialog on page 6869 for procedures.

- **Individual** Allows you to select each object and choose a set of output maps and targets for it. The list will display all selected objects.

- **All Selected** (The default.) Displays all the selected objects.

- **All Prepared** The list will display all visible and unfrozen objects in the scene, selected or not, which have unwrapped mapping on them.

## Render to Texture: Output Rollout

Rendering menu > Render To Texture > Render to Texture dialog > Output rollout.

This rollout lets you specify the elements to render and their attributes.

**See also:**

- **Render to Texture** on page 6843
- **Render to Texture Dialog** on page 6869
- **Render to Texture: General Settings Rollout** on page 6871
- **Render to Texture: Objects To Bake Rollout** on page 6872
- **Render to Texture: Baked Material Rollout** on page 6882
- **Render to Texture: Automatic Mapping Rollout** on page 6885

**Interface**

![Render to Texture Dialog](image)
**Output List** Shows maps names, element names, map sizes and designated map slots.

- **File Name column**  Lists the name of the map that will be generated.
- **Element Name column**  Shows the element corresponding to the map.
- **Size column**  Displays the map size.
- **Target Map Slot column**  Shows which map slot will be occupied by the baked texture in the material.

The output list can display entries in black, gray and blank. If a group of objects is selected that has already has output assignments, maps that are shared by all will appear black, maps not shared by all will appear gray. If resolutions or target types are shared they will appear black, if not they will be blank.

**Add**  Click to display an Add Texture Elements dialog on page 6887 to choose one or more element types to add to the list.

See Baked Texture Elements on page 6848 for a description of the different element choices.

**Delete**  Click to remove the currently highlighted element from the list.

**Selected Element Common Settings group**

**Enable**  When on, renders this element. When off, disables rendering of this element. Default=on.

**Name**  Enter the element component of the file name. Default=the name of the element type.

**File Name and Type**  Enter the file name of the rendered texture. Default=the object name followed by the element name, and TGA format on page 7878. This field is disabled if All Selected or All Prepared is turned on in the Objects To Bake rollout on page 6872.

Click this button to display a file dialog you use to choose a name, directory, and file format for the rendered texture.

**NOTE**  The File Name and Type setting specifies the path and filename only for the selected element. To set a folder where all baked textures will be stored, set the path in the Output group on the General Settings rollout on page 6871.
**Target Map Slot** Display all Map Types available to the materials assigned to the objects selected minus the ones already slated for output in the current Render To Texture session.

If more than one object is selected the all map types common to all the selected objects will be listed. If you choose to Create New Baked on page 6882, then the slots for the new baked material type will be displayed.

**Element Type** This read-only field displays the type of element, such as CompleteMap, that you specified when you added the element.

By default, the element name is the same as its type, but you can change it using the Name field. Element Type remains constant.

**Element Background** Lets you set the background color of the rendered output for the highlighted element.

**Use Automatic Map Size** When on, sets the texture size automatically, using the values on the General Settings rollout on page 6871. When off, the texture is the size specified by the following controls in this rollout. Default=off.

**Width/Height** Lets you specify dimensions for the texture. Range=0 to 8192. Default=256.

**NOTE** Increasing texture resolution increases render time.

To force the texture to be square, often a requirement with real-time 3D rendering engines, click the lock button next to Height.

**Preset resolution buttons (128x128, ...)** Click a button to specify a preset resolution for the texture.

**Selected Element Unique Settings group**

The contents of the Selected Element Unique Settings group vary depending on the active element. But the group always shows a list of toggles for various components of a scene, and by default, all toggles are on.

The following table shows which components apply to which elements (if the table shows “none,” the Selected Elements Unique settings group is not displayed):

<table>
<thead>
<tr>
<th>Map Type</th>
<th>Components</th>
</tr>
</thead>
<tbody>
<tr>
<td>Complete</td>
<td>Shadows</td>
</tr>
<tr>
<td>Map Type</td>
<td>Components</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------------------------------------------</td>
</tr>
<tr>
<td>Specular</td>
<td>Lighting</td>
</tr>
<tr>
<td></td>
<td>Shadows</td>
</tr>
<tr>
<td>Diffuse</td>
<td>Lighting</td>
</tr>
<tr>
<td></td>
<td>Shadows</td>
</tr>
<tr>
<td>Shadows</td>
<td>(none)</td>
</tr>
<tr>
<td>Lighting</td>
<td>Shadows</td>
</tr>
<tr>
<td></td>
<td>Direct Light On</td>
</tr>
<tr>
<td></td>
<td>Indirect Light On</td>
</tr>
<tr>
<td>Normals</td>
<td>Output into Normal Bump</td>
</tr>
<tr>
<td></td>
<td>Render Height Map into Alpha Channel</td>
</tr>
<tr>
<td>Blend</td>
<td>Lighting</td>
</tr>
<tr>
<td></td>
<td>Diffuse</td>
</tr>
<tr>
<td></td>
<td>Specular</td>
</tr>
<tr>
<td></td>
<td>Reflection</td>
</tr>
<tr>
<td></td>
<td>Shadows</td>
</tr>
<tr>
<td></td>
<td>Ambient</td>
</tr>
<tr>
<td></td>
<td>Self-Illumination</td>
</tr>
<tr>
<td></td>
<td>Refraction</td>
</tr>
<tr>
<td>Alpha</td>
<td>(none)</td>
</tr>
<tr>
<td>Height</td>
<td>(none)</td>
</tr>
</tbody>
</table>

For a fuller description of the rendered texture elements, see Baked Texture Elements on page 6848.

**Render to Texture: Baked Material Rollout**

Rendering menu > Render To Texture > Render to Texture dialog > Baked Material rollout
Material Baking operates on the entire Render To Texture session. It is not set per individual object.

**NOTE** When you use Network Rendering, the Render To Baked Material option is disabled.

See also:

- Render to Texture on page 6843
- Render To Texture Dialog on page 6869
- Render to Texture: General Settings Rollout on page 6871
- Render to Texture: Objects To Bake Rollout on page 6872
- Render to Texture: Output Rollout on page 6878
- Automatic Mapping Rollout on page 6885

**Interface**

![Render to Texture Dialog](image)
Baked Material Settings group

Output Into Source When on, replaces any target map slot in the object’s existing material. Care should be used with this option, because the material replacement cannot be undone.

**NOTE** If a selected object to be rendered has a multi/sub-object material assigned to it, the workflow will not change and the results will be as follows: output into source will put the resulting map in all sub-material slots that match, instancing all identical maps, if a sub-material doesn’t have the selected output type it will be ignored; duplicate in baked will duplicate the entire Multi/Sub-Object Material into the baked material and perform the above output; create new baked will create a new single standard material.

Save Source (Create Shell) Makes a new Shell material and assigns it to the object. When this option is turned on, you can then choose to either Duplicate Source To Baked, or to Create New Baked.

Duplicate Source To Baked Makes a copy of the existing material as the Baked material.

Create New Baked Puts a new material in the Baked Material slot. The type of the new material is set by the drop-down list below and subsequently determining the available Target Map Slots in the Output rollout.

Shader list Allows you to specify a shader to be used for the newly baked texture.

Update Baked Materials Builds a Shell material for all selected objects, and populates the baked material according to the current Render To Texture settings.

Clear Shell Materials Removes the Shell material on page 6174 applied to the texture-baked object, and replaces it with either the original material or the texture-baked material.

The radio buttons below Clear Shell Materials give you a choice of which material in the Shell material to retain:

- **Keep Source Materials** When chosen, the original material replaces the Shell material.
- **Keep Baked Materials** When chosen, the baked material replace the Shell material.
NOTE If you have already rendered a baked texture and decide you want to render with a different shader from the list, you must first click Clear Shell Materials and then re-render.

Render to Files Only When turned on, the baked texture files are rendered to the folder you’ve specified in the Output Path field of the General Settings rollout on page 6871. Default=off

Render to Texture: Automatic Mapping Rollout

Rendering menu > Render To Texture > Render to Texture dialog > Automatic Mapping rollout

These options specify how Render To Texture should behave when it automatically flattens UVs or chooses the map size of a baked texture.

See also:

- Render to Texture on page 6843
- Render To Texture Dialog on page 6869
- Render to Texture: General Settings Rollout on page 6871
- Render to Texture: Objects To Bake Rollout on page 6872
- Render to Texture: Output Rollout on page 6878
- Render to Texture: Baked Material Rollout on page 6882
Interface

Automatic Unwrap Mapping group

These are options for how to flatten UVs when Use Automatic Map is chosen in the Objects To Bake rollout's Mapping Coordinates group.

NOTE These controls are also provided by the Unwrap UVW modifier's Flatten Mapping dialog on page 1893.

**Rotate Clusters** Controls whether clusters are rotated to minimize the size of their bounding box. For example, the bounding box of a rectangle rotated 45 degrees occupies more area than one rotated 90 degrees. Default=on.

**Threshold Angle** The angle used to determine the face clusters to be mapped. Default=45.0.

As faces are gathered to be mapped, the modifier uses this parameter to determine which faces get put in a cluster. This is the maximum angle that can exist between faces in a cluster. The higher this number, the larger the clusters will be, with consequently greater distortion introduced as a result of texture faces' proportions deviating from their geometry-equivalent faces.

**Fill Holes** When turned on, smaller clusters will be placed in empty spaces within larger clusters to take the most advantage of the available mapping space. Default=on.

**Spacing** Controls the amount of space between clusters. Default=0.02. The higher this setting, the larger the gap that appears between clusters.
**Automatic Map Size group**

Rendering to texture can choose a map size for you. Automatic map sizing is enabled or disabled by a toggle on the Output rollout on page 6878. The controls in this group specify how to create the map, when Automatic Map Size is enabled. Automatic map sizing computes the total surface area of all objects in the selection, then multiplies that value by Scale, and creates a square texture map of those dimensions.

**Scale** The amount by which to scale the total surface area of generated texture. Default=0.01.

**Nearest power of 2** When on, rounds the map dimensions (length and width) to the nearest power of 2. Default=off.

**Min** The minimum size, in pixels, of the length and width of the automatically sized map. Default=32.

**Max** The maximum size, in pixels, of the length and width of the automatically sized map. Default=1024.

**Render to Texture: Add Texture Elements Dialog**

Rendering menu > Render To Texture > Render to Texture dialog > Output rollout > Click Add to add a texture element. > Add Texture Elements dialog

This dialog lets you choose which elements will be part of a baked material. Each element is an individual bitmap. When you display a baked texture in shaded viewports, some elements might not display.

**NOTE** If the Direct3D display driver on page 8325 is active, you can use a DirectX viewport shader on page 5771 to enhance baked texture display.
Interface

Available Elements Lists the elements available for rendering. See Baked Texture Elements on page 6848 for a description of the available elements. Click an element to select it. Use Ctrl+click to select (or deselect) additional elements individually. Use Shift+click to select a group of contiguous elements.

You can also double-click a single element name to add it to the list and close the dialog.

Add Elements Click to add these elements to the list in the Objects To Bake rollout on page 6872 of the Render To Texture dialog.

Render to Texture: Projection Options Dialog

Rendering menu > Render To Texture > Render to Texture dialog > Objects To Bake rollout > Projection Mapping group > Click Options. > Projection Options dialog
This dialog displays options for normal bump projection.

**Interface**

![Projection Options dialog](image)

**Objects and Sources group**

The text field displays the name of the projection's source object. If more than one object is selected, it displays the source option chosen in the Render To Texture dialog: a single object name for Individual, or “All Selected” (the default), or “All Prepared.”
**Synch All** Click to set all Render-To-Texture sources to use the active source object and the other current Projection Options settings. This button is available only when there is an individual source object.

**Filtering Options group**

**Crop Alpha** Removes antialiasing from the alpha channel.

**Global Supersampler** When the default scanline renderer is active, the text field shows the type of global supersampling that is currently in use. When the mental ray renderer is active, it shows the number of samples per pixel. Default=None.

- **Setup** Click to set up global sampling. When the default scanline renderer is active, clicking Setup displays the Render dialog's Default Scanline Renderer rollout on page 6589, whose Global Supersampling group lets you globally enable supersampling, and choose the supersampling method. When the mental ray renderer is active, clicking Setup displays the Render dialog's Sampling Quality rollout on page 6735, which lets you adjust the level of sampling.

**Method group**

These controls let you choose how to use normals from the source object.

- **Raytrace** (The default.) When chosen, normals are ray-traced between the source and target objects. The objects need to be perfectly aligned in world space on page 8769. When you view both high-res and low-res objects in viewports, they must line up with each other exactly. There are no special requirements for the mapping coordinates of the high-res objects.

- **UV Match** When chosen, normals are obtained by matching the target object's local UV coordinates to those of the source. The objects' UV coordinates on page 8754 need to be perfectly aligned. If you look at the objects using the Unwrap UVW modifier's Edit UVWs dialog on page 1856, the low-res and high-res objects must be lined up with each other exactly. The high-res object needs to have mapping coordinates on the same map channel you are using for the low-res object. Typically, the high-res object will have an Unwrap UVW modifier assigned to it, but this is not required.

  With this option, the high-res object does not need to be in the same physical location as the low-res object.
TIP You can reset the cage (on the Cage rollout on page 1603), because UV Match does not use it.

Use Cage When on, bases projection on the Projection modifier's cage sub-object. When off, uses an offset instead. Default=on.

Offset Enabled only when Use Cage is turned off. Offset is the distance above the surface of the source object from which normals are projected. Default=10.0 units.

Resolve Hit group

The two radio buttons are for scenes that have semitransparent objects, in which case more than one hit can be found for each ray. The remaining controls in this group are additional projection controls.

- Closest If there are multiple hits, use the closest object.
- Furthest (The default.) If there are multiple hits, use the farthest object.

Hit Only Matching Material ID When on, projection is only between material IDs that match. Turning this option on enables a single map to contain normal bump projections from different high-res source geometry. Default=off.

Include Working Model When on, bakes from the source object if no target object can be found. Default=off.

Turning on Include Working Model can be a quick fix when a lot of the projected rays miss the target object (the Ray Miss Color will be apparent in the rendered normals map). However, if the low-res object occludes the high-res object, then Include Working Model will not have the desired effect, and the normal map will not show high-res details that you want it to. In this case, adjust the Projection modifier's cage.

This toggle is also useful when the high-res geometry is discontinuous (for example, a lattice or an array of cylinders).

Ray miss check When on, bakes missed rays as well as rays that hit into the rendered texture, using the Ray Miss Color. Default=on

- Ray miss color This color is baked into the texture when projection fails to hit the target geometry. Click the color swatch to display a Color Selector on page 371 and change the color used for missed rays. Default=red.
Normal Map Space group

There are four methods for projecting the normals:

■ **World**  Project using world coordinates. This is useful mainly for objects that don't move or deform; otherwise, a moving object with world-projected normals will appear to “swim” through the texture.

■ **Screen**  Project using screen coordinates; that is, flat projection in the Z axis. This method is useful mainly for stationary objects seen from a single angle only; for example, a statue seen through a window.

■ **Local XYZ**  Project using the object's local coordinates. This method can be used for stationary or moving objects, but not for objects that deform: if the object deforms, the projection will appear incorrect at some frames.

■ **Tangent**  (The default.) Project at a tangent to the target object’s surface. This is the method to use for objects that both move and deform, such as animated characters.

**Orientation**

The orientation settings determines what the red and green colors will indicate in your normal map. The orientation settings are different for the Tangent method than for the other methods.

The correct setting for red and green depend on what kind of hardware shader or texture will be used to view the map. Different shaders have different requirements. The Normal Bump map has controls to flip the red and green; the Normal Bump texture should work correctly if the map was created with the default X and Y or Left and Right settings, but if the map was created with different settings, change the Normal Bump settings to make the map render correctly, instead of rendering a whole new map.

**Orientation: Tangent**

For the Tangent method red indicates normals that are pointed either left or right and green indicates normals that are pointed up or down.
As an example, if you use Tangent mode with Red set to right and Green set to down, areas that are red in your normal map would indicate that the normals were facing towards the right and areas that were green would indicate that your normals were facing downwards.

The following are the possible values for the Tangent method:

- **Red** Can be Left or Right. Default=Right.
- **Green** Can be Up or Down. Default=Down.

**Orientation: World, Screen, and LocalXYZ**

<table>
<thead>
<tr>
<th>Orientation:</th>
<th>Red:</th>
<th>Green:</th>
</tr>
</thead>
<tbody>
<tr>
<td>World</td>
<td><img src="image1.png" alt="Image" /></td>
<td><img src="image2.png" alt="Image" /></td>
</tr>
<tr>
<td>Screen</td>
<td><img src="image3.png" alt="Image" /></td>
<td><img src="image4.png" alt="Image" /></td>
</tr>
<tr>
<td>LocalXYZ</td>
<td><img src="image5.png" alt="Image" /></td>
<td><img src="image6.png" alt="Image" /></td>
</tr>
</tbody>
</table>

For World, Screen, and LocalXYZ, red indicates that the normals are pointed toward either a positive or negative X value, while green indicates that the normals are pointed toward either a positive or negative Y value.

For example, if you use World mode with Red set to \(-X\) and Green set to \(-Y\), areas that are red in your normal map indicate that the normals face toward \(-X\), and green areas indicate that the normals face toward \(-Y\).

The following are the possible values for World, Screen, and Local XYZ methods:

- **Red** Can be \(-X\) or \(+X\). Default=\(+X\).
- **Green** Can be \(-Y\) or \(+Y\). Default=\(+Y\).

**Height Map group**

- **Min Height** Sets a minimum height for displaced normals. Default=0.0 units.
- **Max Height** Sets a maximum height for displaced normals. Default=10.0 units.

**Min and Max Height eyedropper** Enable the eyedropper to pick the minimum or maximum height for the displaced normals by picking or dragging in a viewport. With the button enabled, click at the desired height. You can also drag this value until the desired result is achieved. The minimum or maximum height value is updated based on your selection.

**Buffer min Height** After you render a normal bump projection, this value is set to the minimum distance that a projection ray travelled. Default=0.0.
Buffer max Height After you render a normal bump projection, this value is set to the maximum distance that a projection ray travelled. Default=0.0. If you want to use the Height Map texture element, you can render a normal bump map to obtain the Buffer values, and then set Min Height and Max Height accordingly, in order to get the best-looking possible Height Map.

Rendering Previews

A preview is an AVI file on page 7832 that can help you preview the animation in your scene. The preview uses lighting but not materials, so it renders much more quickly than a fully rendered animation.

The preview commands are on the Animation menu on page 8023.

Make Preview

Animation menu > Make Preview

Make Preview displays the Make Preview dialog, enabling you to create an AVI file on page 7832 or custom file type preview of the animation in the current viewport. You can also render a preview to a specified device.

When the preview is complete, 3ds Max starts the Media Player with the preview _scene.avi file ready to play. (If you don't want the Media Player to start, choose Customize > Preferences > General and, in the UI Display group, turn off Autoplay Preview File on page 8299.)

Procedures

To create a preview:

1 Choose Animation menu > Make Preview.
   The Make Preview dialog appears.

2 Change the preview parameters or accept the defaults, and then click OK.
   If the output type is AVI, 3ds Max renders the preview and saves it in a file called _scene.avi, in the path specified by Configure User Paths > File I/O on page 8287 > Preview. Immediately after rendering the preview, 3ds Max runs Media Player with this animation loaded.

3 View the preview by clicking Play in Media Player.
If you dismiss Media Player and then want to view the preview again, choose Animation > View Preview. This restarts Media Player with _scene.avi.

You can save the preview under a different name, so it won't be overwritten the next time you make a preview. To do so, use Animation > Rename Preview on page 6897.

Interface
**Preview Range group**

Specifies the frames to be included in the preview, either the active time segment on page 8496 or a custom range of frames.

**Frame Rate group**

Specifies the playback frame rate on page 8585 in frames per second. Use Every Nth Frame to preview a regular sampling of the animation. For example, a value of 8 includes only every eighth frame in the preview.

**Image Size group**

Sets the resolution of your preview as a percentage of the current output resolution. You set the output resolution on the Render Setup dialog. For example, if the rendering output resolution is 640x480, and you set Percent Of Output to 50, the preview resolution is 320x240.

**NOTE** The size of the preview image is limited by the size of the viewpanel region (the region that contains the viewports). The setting is clamped to the maximum value that allows the preview image to fit in the viewpanel region.

**Display in Preview group**

Specifies the types of objects to include in the preview. Frame Numbers prints a frame number in the upper-left corner of each frame of the AVI file. Background includes the assigned viewport background in the preview.

**Camera View group**

Specifies whether the preview should include multi-pass rendering effects on page 6672.

**Rendering Level group**

**Rendering Level drop-down list** Specifies the viewport rendering method on page 8376 to use in the preview.

**Output group**

Specifies the preview output format.

**AVI** When chosen, the preview is output as an AVI file. The button to the right displays the current AVI codec on page 8533. Click it to adjust the assigned
codec, or choose a different codec. The quality of your output AVI file depends on the type of codec you use and the codec settings, which vary. For the highest visual quality, choose the highest compression quality. The higher the compression quality, the lower the compression, and the larger the resultant file.

**Custom File Type** Outputs the preview to the specified file format. When this option is chosen, and the Create button is clicked, a file selector appears, where you name the file and specify the output file type. For example, you can output the preview as a Quicktime movie by specifying a file name with a .mov extension. If you specify a single-image format, such as .tga, the preview is output as a series of sequentially numbered files.

**Use Device** Lets you output the preview to an external device, such as a digital recorder. The button at right displays the name of the currently assigned device. Click it to either change the settings of the device, or assign a different device.

**Render Viewport** This list shows the names of the currently visible viewports, letting you choose which viewport to render from within the Make Preview dialog. Default=active viewport.

### View Preview

Animation menu > View Preview

View Preview displays the Windows-standard Media Player to view the current preview file.

When you use Make Preview, 3ds Max stores the output preview in a file called _scene.avi by default. View Preview loads this file. If you want to keep the preview file, use Rename Preview to save it under another file name, otherwise, the next Make Preview will overwrite _scene.avi.

The Media Player has its own Help system.

### Rename Preview

Animation menu > Rename Preview

Rename Preview renames the _scene.avi preview file.

When you use Make Preview, 3ds Max stores the output preview in a file called _scene.avi by default. View Preview loads this file. If you want to keep the
preview file, use Rename Preview to save it under another file name; otherwise, the next Make Preview will overwrite _scene.avi.

**Procedures**

**To rename the preview file:**

2. Specify a folder and a name for the preview file.
3. Click Save.

**Panorama Exporter Utility**

Rendering menu > Panorama Exporter
Utilities panel > Utilities rollout > More button > Utilities dialog > Panorama Exporter

The Panorama Exporter is a rendering utility that lets you create and then view 360 degree spherical panoramas.
NOTE You need at least one camera in your scene to use the Panorama Exporter.

Panorama Exporter creates a 360-degree spherical rendering.

Interface

- Panorama Exporter
  
  Render...
  
  Viewer...
The Panorama Exporter rollout has two buttons, which let you create or view a panoramic rendering.

**Render** Opens the [Render Setup dialog](#) on page 6900 for the Panorama Exporter.

**Viewer** Opens the [Panorama Exporter viewer](#) on page 6903.

---

**Panorama Exporter Render Setup Dialog**

Rendering menu > Panorama Exporter > Render button

Utilities panel > Utilities rollout > More button > Utilities dialog > Panorama Exporter > Render button

The Panorama Exporter Render Setup dialog is a modal on page 8641 version of the [Render Setup dialog](#) on page 6506 specially configured for generating panoramic output.

---

**NOTE** You need at least one camera in your scene to use the Panorama Exporter.

**TIP** For best results, high resolutions might be necessary. We recommend a resolution of 2048x1024 or higher unless you're working on drafts.

---

**Interface**

This topic covers the main rollout parameters. Additional rollouts might be available depending on the current renderer. For more information, see [Render Setup dialog](#) on page 6506.
Output Size group

Choose one of the predefined sizes or enter another size in the Width and Height fields (in pixels). These controls affect the image's aspect ratio on page 8511.

**Width and Height** Lets you set the resolution of the output image by specifying the width and the height of the image, in pixels.

**Preset resolution buttons (512x256, 1024x512, and so on)** Click one of these buttons to choose a preset resolution.

**Aperture Width** Lets you specify an aperture width for the camera that creates the rendered output. Changing this value changes the camera's Lens value. This affects the relationship between the Lens and the FOV values, but it doesn't change the camera's view of the scene.

For example, if you have a Lens setting of 43.0 mm, and you change the Aperture Width from 36 to 50, when you close the Render Setup dialog (or render), the camera Lens spinner has changed to 59.722, but the scene still looks the same in the viewport and the rendering. If you use one of the preset formats rather than Custom, the aperture width is determined by the format, and this control is replaced by a text display.
Options group

**Atmospherics** Renders any applied atmospheric effects, such as volume fog, when turned on.

**Render Hidden Geometry** Renders all geometric objects in the scene, even if they are hidden.

**Effects** Renders any applied rendering effects, such as Blur, when turned on.

**Area/Linear Lights as Point Lights** Renders all area or linear lights as if they were point lights, speeding up rendering time.

**Displacement** Renders any applied displacement mapping.

**Force 2-Sided** Renders both sides of all faces. Usually, you'll want to keep this option off to speed rendering time. You might want to turn it on if you need to render the inside as well as the outside of objects, or if you've imported complex geometry in which the face normals are not properly unified. Default=off.

**Video Color Check** Checks for pixel colors that are beyond the safe NTSC on page 8654 or PAL on page 8674 threshold and flags them or modifies them to acceptable values. By default, "unsafe" colors render as black pixels. You can change the color check display by using the Rendering panel on page 8342 of the Preference Settings dialog on page 8298.

**TIP** This is useful for draft renderings, as point lights render much faster than area lights.

**NOWE** Scenes with radiosity on page 6615 are not affected by this toggle, as area lights do not have a significant effect on the performance of a radiosity solution.

**Super Black** Super Black rendering on page 8735 limits the darkness of rendered geometry for video compositing.

**TIP** Leave this off unless you're sure you need it.

Advanced Lighting group

**Use Advanced Lighting** When on, 3ds Max incorporates a radiosity solution on page 6615 or light tracing on page 6601 in the rendering.

**Compute Advanced Lighting When Required** When on, 3ds Max computes radiosity when required on a per-frame basis.
Normally, when rendering a series of frames, 3ds Max calculates radiosity only for the first frame. If, in an animation, it might be necessary to recalculate the advanced lighting in subsequent frames, turn this option on. For example, a brightly painted door might open and affect the coloring of a nearby white wall, in which case the advanced lighting should be recalculated.

**Render Output group**

**Save File** Saves the rendered panorama to disk. This is unavailable until you have defined a file name by clicking the Files button.

**Files** Lets you specify the name, location, and file type for the rendered panorama file.

**Rendered Frame Window** Enables or disables the panorama exporter's rendering display.

**Display Viewer** When on, the Panorama Exporter viewer on page 6903 opens upon rendering the panoramic rendering.

**Viewport** Chooses the camera viewport to render. When you render a panorama, this drop-down list shows only the cameras in the scene.

**Render** Click to render the panorama.

**Cancel** Click to cancel the rendering.

**Close** Click to close the dialog, saving any changes you've made.

### Panorama Exporter Viewer

Rendering menu > Panorama Exporter > Viewer button

Utilities panel > Utilities rollout > Panorama Exporter > Viewer button

The Panorama Exporter viewer lets you navigate a rendered panorama. You can use the viewer to export the panorama rendering with a cylindrical, spherical, or QuickTime VR format.
NOTE Exporting to QTVR format requires that QuickTime® 5 or higher be installed on your system. You can download the latest version from http://www.apple.com/quicktime/download. For QTVR export, you must choose the “Recommended Install” rather than a custom or minimal installation. In particular, your installation must include these components:

- QuickTime Authoring
- QuickTime Internet Extras
- QuickTime Essentials

Procedures

To navigate a rendered panorama:

1. Hold down the left button to rotate the camera around the panorama. If you move the mouse, the camera rotates in that direction until you move the mouse again. (The view of the panorama moves in the opposite direction from the mouse and camera.)

2. Hold down the middle button and move the mouse up and down to zoom in and out.

3. Hold down the right button and move the mouse to rotate the camera around the panorama. With the right button, you must drag the mouse to see any movement, and the view of the panorama moves in the same direction as the mouse.

To export a rendered panorama:

1. Open a rendered panorama in the Panorama Exporter Viewer.

2. Click File > Export.
   Choose Cylinder, Sphere, or QuickTimeVR to set the format for your exported file.

A dialog opens, prompting you to enter the name, location, and type of file.
Network Rendering

Network rendering is a means of mass-processing multiple rendering tasks or jobs. In order to facilitate network rendering, Autodesk Backburner™ is installed with 3ds Max. The Backburner software is responsible for coordinating how job assignments are processed.

You can perform network rendering with both the default scanline and mental ray renderers. In its most efficient form, network rendering uses multiple computers, connected over a network, to perform rendering tasks; typically the rendering of animations with hundreds or thousands of frames. Even a small network of three or four PCs can save substantial rendering time and help you meet deadlines.

However, network rendering can be equally useful if you have only a single PC and need to render a number of images. You can assign the jobs that need to be rendered and Backburner can manage the rendering of each job while you’re away from the computer. Commonly, jobs are assigned submitted just before you leave the office. when you arrive the next morning, all your rendering are waiting for you to review.

Network rendering is designed to render whatever is set up in your scene; that is, it will render the viewport, part of a viewport, camera view, and so on, as saved in the scene file. You can also pass batch-rendering tasks to Backburner from the Batch Render tool on page 7026. You can queue up tasks from any number of cameras in a scene. Each task can load a save scene state or use a particular rendering preset.

The requirements and procedures presented here assume you are the administrator of a closed network set up exclusively for network rendering. In practice, you can use the network for file sharing and other purposes, but if conflicts arise, you might need to cancel those uses. The easiest network to set up, operate, and maintain is one dedicated to rendering.

**NOTE** For specific information about setting up network rendering on a single system, refer to Basic Procedure 1: Single-System Network Rendering on page 6910.

If you’re a system administrator for a more complex network, you can use the information in this file as a guideline. The basic approach is the same for any network.

**IMPORTANT** It is strongly recommended that you follow these procedures for setting up and running network rendering. Do not attempt network rendering without reading the instructions that follow.
The links on this page are ordered like chapters in a manual: a sequence of major topics containing more specific nested topics. Links marked Next Step indicate the next topic in the sequence. Moving from one topic to the next takes you through the necessary steps to set up your network for rendering.

**NOTE** Network rendering functions are also available from MAXScript. See “Network Render Interface” and “Interface: NetRender” in the MAXScript Help.

### About Backburner

Network rendering is performed by software named Backburner. Functionality is primarily the same as in previous versions of 3ds Max with the addition of the following:

- The Batch Render tool on page 7026 can pass a queue of rendering tasks to the Network Job Assignment dialog. When submitted, Backburner manages the rendering of all the active tasks and

- You can now assign various servers to groups in Backburner. From the Network Job Assignment dialog you can choose a group as the current set of servers.

### Backburner Documentation

The following table summarizes the Backburner Documentation set.

<table>
<thead>
<tr>
<th>For Information About:</th>
<th>See:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using Autodesk Backburner with 3ds Max</td>
<td>This Network Rendering section.</td>
</tr>
<tr>
<td>Autodesk Backburner User Interface (Manager, Server, and Monitor), Troubleshooting, and Administering Autodesk Backburner</td>
<td><em>Autodesk Backburner User’s Guide</em> (In 3ds Max go to Help &gt; Additional Help &gt; Backburner User’s Guide)</td>
</tr>
<tr>
<td>Autodesk Backburner Configuration</td>
<td><em>Autodesk Backburner Installation Guide</em> (In 3ds Max go to Help &gt; Additional Help &gt; Backburner Installation Guide)</td>
</tr>
<tr>
<td>Installing Autodesk Backburner with 3ds Max</td>
<td><em>3ds Max Install Guide</em> (Click the Documentation link on the Autodesk Autodesk 3ds Max 2010 Install DVD 1.)</td>
</tr>
</tbody>
</table>
About Mental Ray

Network rendering with the mental ray Renderer

The mental ray renderer supports network rendering via Backburner and the command line. The steps for setting up and submitting jobs are exactly the same as those you'd use for the scanline renderer. No additional licensing or fees are necessary.

Next Step

How Network Rendering Works on page 6907

How Network Rendering Works

Rendering networks are sometimes called “render farms.” In 3ds Max, one computer is set up as the network Manager. The Manager “farms out” or distributes the work to rendering Servers. You can also have the same computer function simultaneously as both Manager and Server, so computing cycles don't go to waste.

Once rendering is underway, the Queue Monitor program lets you directly monitor and control the operation of the network rendering workload. The Queue Monitor allows you to edit job settings as well as to activate, deactivate, and reorder both jobs and servers involved in your render farm.

Important: When rendering using a render farm, it is recommended to render with single-frame formats such as BMP or PNG. Movie file formats such as AVI output all frames into a single file which cannot be split between different servers to take advantage of network rendering.

How Work Is Divided

3ds Max breaks up the task of network rendering among the rendering Servers, assigning one frame at a time to each Server. The completed output of the Servers accumulates in a common, shared directory.

Rendered frame files can also be written to a local directory on each machine, if the same path defines the directory. Frame files are sequentially numbered, making them easy to assemble later.

The Manager takes a number of different factors into account in determining how to assign frames and jobs, always striving for the most efficient usage of the rendering network. An idle rendering Server is automatically detected by
the Manager and is considered for job or frame assignment. If a Server goes off-line for some reason, the Manager reclaims the Server's current frame and reassigns the frame to the next available rendering Server.

The Basic Process

Following is a step-by-step description of the sequence of events when you use network rendering:

1. The user submits a job to the network Manager.
2. On the submitting machine, the MAX file gets zipped up. If the user turned on Include Maps, all maps and XRefs are also zipped up.
3. Once the file is zipped up, the ZIP file is copied to the Manager machine's Backburner\Network\Jobs\<jobname> folder. In the folder is an XML file describing the job itself, specifying frame size, output filename, frame range, render settings, etc.
4. Once the Manager receives the ZIP and XML files, it looks to see which servers are sitting idle and can render jobs. It assigns the job to four servers at a time. (This is the Max Concurrent Assignments setting on the Manager General Properties dialog. See Starting Network Rendering on page 6922).
5. Each Server machine receives the ZIP and XML files into the Backburner\Network\jobtemp folder.
6. The MAX file gets unzipped, along with the maps and XRefs if they were included.
7. 3ds Max is launched and loads the MAX file. If the maps and XRefs were not included, the Server searches for them as they are defined in the MAX file. For instance, if an XRef is in d:\foo\xref.max, the Server will look for xref.max in d:\foo\ on the local machine. If there are additional map paths set in the 3dsmax.ini on page 60 file on the rendering server, it will search in those paths as well. If it does not find the maps and XRefs, the server fails for that particular job.
   This is why it is important to use UNC paths for all maps and XRefs in your scene file, so that all render servers can find them. However, if the maps and XRefs were included, then 3ds Max will get the ones that were unzipped into the jobtemp folder.
8. When a frame is finished rendering, 3ds Max on the Server saves the frame to the location specified via the Render Setup dialog before you submitted it.
9 Once a Server successfully renders one frame, the Manager assigns a block of frames to the server to render; it might assign 20 consecutive frames. This minimizes the amount of communication needed between the Server and Manager.

10 The Server continues rendering frames for the job until the job is done.

11 The Server then closes 3ds Max, and goes idle. If the queue contains additional jobs, the Server picks up the next job and starts the process all over again.

You can use this explanation to help determine the basic requirements for your network rendering setup, based on the type of usage. If your frames render quickly, you'll need a fast file server machine to handle the constant output from a number of different rendering servers. The same holds true of your scene uses a large quantity of map files that are stored in a central location. If you typically render large files, rendering will take longer, and most of the bandwidth will be required at the start, when the files are distributed to the rendering servers.

Next Step

Checking Requirements on page 6933

Basic Procedures for Network Rendering

This topic contains basic procedures to follow when network rendering with 3ds Max.

The following conditions are assumed:

- 3ds Max has been installed on all machines to use as rendering servers. Note: You needn't license 3ds Max on machines to be used only as rendering servers.
- All network communications and protocols are installed and operating correctly.
- The computers run Windows XP Pro, Windows 2000, or NT 4.0. Limitations of other operating systems could cause network rendering to be unreliable.
- All of the computers have names that start with letters. Machine names that start with a number will fail.
You haven't previous attempted network rendering. If you have already attempted network rendering and want to return to the original state, delete everything in the \Program Files\Autodesk\Backburner\Network folder except nres.dat.

Manager and Server have not been installed as services.

Summary of Procedures

- Procedure 1 - Use this procedure for configuring a single system to render jobs to itself; in other words, to perform batch rendering that is managed by Backburner.
- Procedure 2 - Use this procedure for configuring a Backburner Manager system to render to one or more Backburner Server systems. The Manager system will not be involved in the rendering tasks.
- Procedure 3 - Use this procedure for configuring the Backburner Manager and Backburner Server systems to render tasks together.

Special Consideration for Procedures 2 and 3

To use a render farm, you must output a frame sequence in a still-image file format; for example, a series of BMP files. You cannot render animated file formats such as AVI or MOV to multiple systems. You must render animated files to a single system. When rendering to an animated file format, the Use All Servers check box in the Network Job Assignment dialog is unavailable.

Basic Procedure 1: Single-System Network Rendering

This procedure describes usage of network rendering on a single computer. The main advantage to this method over standard rendering is that you can submit multiple rendering jobs for the computer to render. In effect, this lets you perform batch rendering.

1. Go to Start menu > Programs > Autodesk > Backburner and choose the Manager menu item.
   This starts Manager and creates the backburner.xml file in the Backburner\Network folder.
   When you run Manager for the first time, you will see the Backburner Manager General Properties dialog, shown below.
2 Click OK to accept the default settings. The Backburner Manager dialog displays.

3 Go to Start menu > Programs > Autodesk > Backburner and choose the Server menu item.

This starts Server and creates the server data that is stored in the `backburner.xml` file.

You will see the Backburner Server General Properties dialog, shown below, when you run Server for the first time.

---

Basic Procedures for Network Rendering | 6911
4 Click OK to accept the default settings.
   The Backburner Server dialog displays. After a few moments, messages appear in both the Server and Manager windows indicating that the Server has successfully registered with the Manager.

5 Start 3ds Max and load the first scene you want to render.

6 From the Rendering menu, choose Render Setup, or click the toolbar Render Setup button.

7 Set the rendering parameters and specify an output file name. In the Render Output group on the Common tab, turn on Net Render, and then click the Render button.
   The Network Job Assignment dialog appears.
Network Job Assignment dialog showing the server station that is also running Manager.

8 Enter a job name (it's a good idea to change the default name) and then click the Connect button.

The name of your computer (that is, the Server) appears in the Server window to the right. It has a green dot next to it meaning that it is a Server system that is ready to start rendering.

9 Click the Server name to highlight it in the list window, and then click the Submit button.

The Manager submits the job to the Server, both running only on this system, and the Server begins rendering each still frame or the animation.
To render additional jobs, load each into 3ds Max, and then repeat steps 6 to 9.

You can submit as many jobs as you like. The Manager will queue the jobs up and render them in the order that you submitted them.

**Basic Procedure 2: Network Rendering from Server (not Manager)**

When rendering across a network, you first assign one machine to be Manager, and then any number of others as Servers. In this procedure, you won’t use the Manager as a rendering Server.

1. Go to Start menu > Programs > Autodesk > Backburner and choose the Manager menu item.
   
   This starts Manager and creates the `backburner.xml` file in the `Backburner\Network` folder.

   When you run Manager for the first time, you will see the Backburner Manager General Properties dialog, shown below; this is normal.
2 Click OK to accept the default settings. The Backburner Manager dialog displays.

3 Move to a Server system.

4 Go to Start menu > Programs > Autodesk > Backburner and choose the Server menu item. This starts Server and creates the server data that is stored in the backburner.xml file.
You will see the Backburner Server General Properties dialog box, shown below, when you run Server for the first time.

![Backburner Server General Properties dialog](image)

5 Click OK to accept the default settings.

The Backburner Server dialog displays. After a few moments, messages appear in both the Server and Manager windows indicating that the Server has successfully registered with the Manager.

6 Repeat steps 3-5 on all the Server systems you intend to make available for your rendering jobs.

7 Return to the Manager system, start 3ds Max, and load the first scene you want to render.

8 From the Rendering menu, choose Render Setup, or click the toolbar Render Setup button.

9 Set the rendering parameters and specify an output path and file name.
TIP So that the Servers can find the output path, specify the path in the Render Output File dialog starting with Save In > My Network Places. Then navigate to the output folder, specify a file name and output format (Save As Type), and click Save.

10 In the Render Output group, turn on Net Render, and then click the Render button.

The Network Job Assignment dialog appears.

![Network Job Assignment dialog showing all the server stations. The manager station is excluded.](image)

11 Enter a job name (it's a good idea to change the default name) and then click the Connect button.
The names of all Servers appear in the Server window to the right. Those with green dots next to their names are ready to start rendering.

By default, all the Servers that are listed will take part in the rendering job. To assign a specific Server to render a job, first turn off Use All Servers in the Options group, and then highlight the server(s) that you want to render the job.

12 Click the Submit button.

The Manager submits the job to the Servers, which begin rendering.

At this point, you can load and submit additional scenes. When the first job is complete, the next job will automatically begin rendering on the Servers.

**Basic Procedure 3: Network Rendering from Manager and Servers**

When rendering across a network, you first assign one machine to be Manager, and then any number of others as Servers. In this procedure, you'll use the Manager computer as a rendering Server as well.

1 Go to Start menu > Programs > Autodesk > Backburner and choose the Manager menu item.

This starts Manager and creates the `backburner.xml` file in the `Backburner\Network` folder.

When you run Manager for the first time, you will see the Backburner Manager General Properties dialog, shown below; this is normal.
2 Click OK to accept the default settings.
The Backburner Manager dialog displays.

3 On the same computer, go to Start menu > Programs > Autodesk > Backburner and choose the Server menu item.
This starts Server and creates the server data that is stored in the `backburner.xml` file.
You will see the Backburner Server General Properties dialog box, shown below, when you run Server for the first time.
4 Click OK to accept the default settings. The Backburner Server dialog displays. After a few moments, messages appear in both the Server and Manager windows indicating that the Server has successfully registered with the Manager.

5 Repeat steps 3-4 on all the Server systems you intend to make available for your rendering jobs.

6 Return to the Manager system, start 3ds Max, and load the first scene you want to render.

7 From the Rendering menu, choose Render Setup, or click the toolbar Render Setup button.

8 Set the rendering parameters and specify an output path and file name.

TIP So that the Servers can find the output path, specify the path in the Render Output File dialog starting with Save In > My Network Places. Then navigate to the output folder, specify a file name and output format (Save As Type), and click Save.
9 In the Render Output group, turn on Net Render, and then click the Render button.

   The Network Job Assignment dialog appears.

![Network Job Assignment dialog showing all the server station plus the manager station that is running Server.](image)

10 Enter a job name (it's a good idea to change the default name) and then click the Connect button.

   The names of all Servers appear in the Server window to the right. Those with green dots next to their names are ready to start rendering.

   By default, all the Servers that are listed will take part in the rendering job. To assign a specific Server to render a job, first turn off Use All Servers.
in the Options group, and then highlight the server that you want to render the job.

11 Click the Submit button.
   The Manager submits the job to the Servers, which begin rendering.
   At this point, you can load and submit additional scenes. When the first job is complete, the next job will automatically begin rendering on the Servers.

Starting Network Rendering

Once you've set up the network rendering system and software on page 6946, there are two steps to starting a network rendering session:

- Start the Manager program on one machine and the Server program on every other machine in the network. See Basic Procedures for Network Rendering on page 6909. The machine being used as a manager can also be used as a rendering server.

- Start a rendering job from 3ds Max on a networked machine with an authorized copy of 3ds Max.

The Manager and Server programs need to be started and left running during a network rendering session. Either program remains in operation until you shut it down or shut down the machine.

When you've set up the Manager and Server network services, you're ready to submit an animation to the network rendering queue. There are two stages to starting network rendering:

- On the Render dialog, set all desired rendering parameters, including resolution and rendered output file type, and render the scene. In 3ds Max, you can render from the Render Setup dialog on page 6506, or the Render To Texture dialog on page 6869.

- In the Render dialog, set all desired rendering parameters, including resolution and rendered output file type, and render the scene.

- Turn on Net Render, found in the Render Output, Render Settings or Output groups, and then click Render to open the Network Job Assignment dialog on page 6953, which lets you make final decisions about the job and submit your animation to the rendering servers.
Procedures

These procedures explain how to start and submit a network rendering job in 3ds Max.

This procedure explains how to render a job over the network, once the Backburner Manager and Server are running. (See the Autodesk Backburner Installation Guide for information on setting up the Backburner Manager and Server.)

To start the Manager program:

1. Run the Manager program from the Start menu > Programs > Autodesk > Backburner folder.
   
The first time you run the Manager after installation or after deleting the backburner.xml file, the Manager Properties dialog appears. In most cases, you can accept the default settings and click OK to continue.
   
   Thereafter, when you start the Manager, its window appears and the "Starting Network Manager" message is displayed in the window. The machine is now running the Manager in Desktop mode. You can leave this window open to see messages relating to what the Manager and Servers are doing as they appear, or you can minimize it, whereupon it resides in the taskbar tray. To reopen the window when minimized, click its icon in the taskbar tray.

   **NOTE** If you're running Windows 2000 and have the NetBEUI protocol installed, and you have unplugged your network cable, when you start the manager, you'll see an error message, "Error starting network subsystem, cannot start manager." If this happens, reconnect the network cable and try again.

2. Alternatively, you can run the Manager as a service, as described in “Setting Up Backburner Manager as a Windows Service” in the Autodesk Backburner Installation Guide. Once set up, the Manager automatically starts when you boot the system and it's always available.
To start the Server program:

1. Run the Server program from the Start menu > Programs > Autodesk > Backburner folder.

   The first time you run the Server after installation or after deleting the `backburner.xml` file, the Server Properties dialog appears. By default, Automatic Search is turned on, and the subnet mask is set to 255.255.255.0. This should work with most networks. Alternatively, turn off Automatic Search and enter the manager name or its IP address in the Manager Name or IP Address field.

   Thereafter, when you start the Server, its window appears and the "Starting Backburner Server" message is displayed in the log window. After a few seconds you should also see the "Registration to (manager IP address) accepted" message in the Server window. This message indicates that the server has found the manager and is correctly communicating with it. If you do not see the "Registration to ..." message in the Server window, see "Troubleshooting Backburner" in the *Autodesk Backburner User’s Guide*.

   The machine is now running as a rendering Server in Desktop mode. You can leave this window open to see other messages as they appear, or you can minimize it to the taskbar tray. To reopen the window when minimized, click its icon in the taskbar tray.

2. Alternatively, you can run the Server as a service, as described in *Network Rendering Server* on page 8653. Just running the Manager as a service, once it's installed and started, it's always available, even after rebooting.

To start a network rendering job:

1. Start the Backburner Manager and Backburner Server.

2. Start 3ds Max on a machine with an authorized copy of 3ds Max.

3. Open the scene you want to render.

4. Choose Rendering menu > Render Setup to display the Render Setup dialog.

   You can also render from the Execute Video Post dialog or the Render To Texture dialog.

5. In the Render Output group, click the ellipsis button to display the Render Output File dialog.
In the File Name field, enter the **Universal Naming Convention (UNC)** on page 8753 name of the output directory, followed by the name of the output file. For example:
\`\`machine1\project1\images\output.tga\`\`

As an alternative to entering the UNC name from the keyboard, you can go to Save In > My Network Places and navigate to the machine and shared directory where you want the servers to write the rendered frames. After selecting the machine and shared directory in the Map Network Drive dialog, enter the output file name (for example, `output.tga`), and then click OK. 3ds Max automatically converts the shared directory to the UNC format.

If the output directory is mounted, enter the name and extension of the output file and choose the drive mounted for the output directory from the Save In list.

Click OK to display the Setup Options dialog for the file format type you have selected.

Make the desired settings and click OK.

Click OK again to return to the Render Setup dialog.

Save File is turned on once you assign an output file.

After setting any other rendering parameters, turn on Render Output group > Net Render and click Render.

The Network Job Assignment dialog appears.

If you use Video Post, set the file location with an Add Image Output Event. After you click Execute Sequence, be sure to turn on Net Render before you click Render.

**To submit a network rendering job:**

1. Start the Backburner Manager and Backburner Server.
2. On the Network Job Assignment dialog, make sure the Automatic Search option is on, and then click Connect.
   
   In most cases, 3ds Max detects the Manager machine and displays its attached Servers in the Server list. If auto-detect fails, turn off Automatic Search and manually enter the name or IP address of the network machine acting as the Manager, and then click Connect.

   All rendering Servers running under the network Manager should be listed with green dots next to them. Even if a server is running an
interactive session of 3ds Max, it will still render an assigned job by launching a second copy of 3ds Max.

3 By default, the job will use all available Servers. To use only specific Servers, turn off Use All Servers and choose the machines you want to use from the Server list.

4 Click Submit.

The job is submitted to the Manager, which then distributes the job to the machines assigned in the Network Job Assignment dialog. Network rendering begins.

When network rendering begins on a rendering Server, the Rendering dialog appears on machines running serverapp.exe. If a machine is running the service version, no dialog appears.
Troubleshooting Guide

This is a guide to solving common problems associated with network rendering. Solutions to these problems vary, depending on whether you are using the
network rendering programs as installed Windows Services, or running them in Desktop mode. Also see “Troubleshooting Backburner” in the *Autodesk Backburner User’s Guide.*

**PROBLEM:** When I try to assign a job in the Network Job Assignment dialog, some of the servers display a gray or yellow icon.

**SUGGESTION**

Regardless of their state in the Network Job Assignment dialog, servers can always be assigned new jobs.

The gray icon means that the server is currently not available to render a job. This state can occur for several reasons, including:

- The server has not been correctly started. (See “Setting Up Backburner Server” in the *Autodesk Backburner Installation Guide.*

- The server has been disallowed for the current time period in the Properties dialog of the Monitor. (See “Setting the Availability for Rendering Nodes” in the *Autodesk Backburner User’s Guide.*

- The server has experienced abnormal termination.

  If you've checked for and corrected these conditions and the servers are still unavailable, stop running Server on each of the problem machines, and restart the service after a few seconds. This "purges" the server and may solve the problem. Then click Refresh in the Network Job Assignment dialog to display the most recent information about the server.

The yellow icon means that the server is busy rendering another job. If the server should not be busy, verify that the queue is clear of jobs by opening the Queue Monitor and connecting to the Manager. If the queue is clear of rendering jobs and the server is still flagged as busy, stop running server on each of the problem machines, and restart the service after a few seconds.

**PROBLEM:** When I submit a job to be rendered, the server fails.

**SUGGESTION**

Servers can fail for a variety of reasons during a network render job. Many of these reasons are covered in “Troubleshooting” in the *Autodesk Backburner User’s Guide.* One reason that is specific to 3ds Max which can cause a server to fail is the presence of a scene which does not contain texture coordinates.
All errors are recorded in the appropriate log file. You can learn more about log files in “Configuring Backburner Log Files” in the Autodesk Backburner User’s Guide.

Here are some of the error messages related to 3ds Max, along with a likely cause, that you will see in the Errors tab of the Queue Monitor when a failed server is selected:

**ERR: ----- Render Error:**

**ERR: D:\MAPS\3DS.CEL** [where this is the location of a map in the submitted scene]

The Server could not find 3ds.cel in the local path specified, which means that the path to this map is not been correct for network rendering. To fix the problem, do one of the following:

- If all maps are being shared from a single directory, make sure the directory is correctly shared with full permissions. See Sharing a Directory on page 6949.

- Make sure that you have used either the full UNC path name for the bitmaps or that the maps directory has been mounted to the same drive letter on each machine. In this case, verify that particular path has been added to the Configure User Paths dialog > External Files panel on page 8289 of every server’s local version of 3ds Max or that the particular path was used when assigning bitmaps in the scene to be rendered.

- Verify the bitmaps still reside in the shared directory.

- Add an Alternate Map Path on the Network Job Assignment dialog that points to the folder containing the missing map.

**ERR: Object (UVW 1): Sphere01 requires texture coordinates and may not render correctly**

Open the scene and make sure the errant object is assigned texture coordinates. This can be as simple as adding a UVW Map modifier to the object.

**ERR: Frame error**

Texture coordinates must be applied to the specified object to render it on the server.

**ERR: Load Error: Missing DLL’S**

Following this error, you will also receive a listing of each of the missing DLLs in the scene. Files needed by the server are not available to render the job.
Make sure that all the plug-in DLLs used in a job reside on each of the servers rendering the job.

**ERR: Job not found. Ok if just deleted**

When you delete a job, the Manager sends out a notification to all clients (Monitors) telling that the job has changed. This is the same message sent when the job completes, gets suspended, resumed, etc. The monitors in turn request the job status from the manager. The manager doesn’t find the job (it was just deleted) and returns this error to the monitor.

**ERR: Targa - The device is not ready. (0x15)**

**ERR: Frame error**

The server could not write the output file. "Targa" represents the file output type, and will change depending on the output file type you selected. This problem can occur for several reasons: If you are running the Backburner Server as an installed Windows service, make sure that the user account that the service is logged to has adequate permissions. Administrative permissions are recommended.

- Check to make sure the target output directory is shared, with both read and write permissions.
- Verify that the path for saving file output on the Render Setup dialog (or the Output Event dialog in Video Post) is set to a valid UNC path name.
- If you are writing to a shared directory mounted locally on each server, verify that the directory is mounted to the same drive letter on each server, and that the file output path is set for that drive letter.

**PROBLEM: The Server fails to render a frame and displays the following error:**

Rebooting 3ds Max by force due to load timeout.

**SUGGESTION**

The Server has exceeded either the Wait For 3ds Max To Load or Wait For 3ds Max To Render value. This is usually caused by attempting to render large files over the network. Increase these values in the Advanced Settings dialog on page 6970.
PROBLEM: I cannot assign more than one server to a job in the Network Job Assignment dialog.

If the output of a network-rendering job is an AVI or MOV file, or a single user device, the job can be assigned to a single server only. The Network Job Assignment dialog changes, depending on the file output type of a job. For example, if you are network rendering to one of the file formats above, the All and None buttons do not appear and the dialog title bar contains the word "Single."

If a job that has an AVI or MOV file output type is stopped for any reason (to deactivate it, or because a machine goes down), re-rendering the file restarts at the first frame. Frames cannot be appended later to these file types.

SUGGESTION

To take advantage of the distributed power of network rendering we suggest you first render to a series of Targa files. Then use the Targa files as either an animated background in an empty 3ds Max scene, or as an image input event in Video Post and render the sequence out to the desired output type (for example, AVI).

PROBLEM: When I click the Render button on the Render Setup dialog, I get an error dialog stating:

Error Retrieving Configuration File

This error usually is the result of a corrupt installation of the Backburner applications which caused an errant registry setting.

SUGGESTION

Try reinstalling the Backburner components of 3ds Max or manually edit the system registry.

Editing the registry:

2. Enter RegEdit and click OK
4. Check the CfgPath entry. Make sure the value is set to c:\Program Files\Autodesk\Backburner\Network\nrapi.conf.
5 Close the Registry Editor.

**PROBLEM: Backburner not found message when clicking Render button:**

Cannot network render. Backburner not found or not installed.

This error dialog appears because the path to Backburner is either not set properly in the Path environment variable or Backburner is missing altogether.

**SUGGESTION**

Verify that the Path variable is set properly and make sure you've installed the latest version of Backburner.

**PROBLEM: Clicking Render button results in Backburner plugin error:**

Error creating 3ds Max plugin instance for Backburner.

The path to 3ds Max is not set in the PlugPath section of the \Backburner\Network\nrapi.conf file.

**SUGGESTION**

Verify the presence of the \Backburner\Network\nrapi.conf file and check the PlugPath. It should look like this:

```
PlugPath=C:/Program Files/Autodesk/Backburner/
```

**PROBLEM: The manager and server windows display strange, garbled text:**

Your error message includes @#$@@.

This error occurs if the nrres.dat file is missing or damaged. This file is located in: C:\Program Files\Autodesk\Backburner\Network

**SUGGESTION**

Copy the nrres.dat file from another system that is not exhibiting the problem, or reinstall Backburner.
System Setup

The topics in this section describe how to check system requirements, and how to set up a network for rendering.

Checking Requirements

Setting up even a small render farm can require a substantial amount of time. As a first step, verify that your proposed network meets the basic requirements. You should also be acquainted with the software required to render over the network.

Hardware Requirements

- One machine on the network must have 3ds Max set up and authorized. This system is used to submit network rendering jobs.

- One machine runs a network manager to communicate with rendering servers. You can set up any machine in the network for this purpose. No authorization is required if this machine will not run as a 3ds Max Workstation.

- To install 3ds Max, at least one machine needs a DVD-ROM drive mounted for access over the network. Instructions for setting up the network-rendering software are found in the Setting Up Rendering Software on page 6946 section.

- Other machines operate as rendering servers. No authorization is required on these machines. Rendering servers should meet the minimum requirements for running 3ds Max. To improve rendering performance, use machines with faster processors, additional memory, and more swap space. A rendering server does not require a monitor while rendering, although it’s helpful to have one for setup. Display adapters and accelerators make no difference in rendering performance.

Network Requirements

For operating system requirements, see “System Requirements” in the Autodesk Backburner Installation Guide. You must also be connected over a network with TCP/IP protocol properly installed. See Instructions for configuring TCP/IP for network rendering on page 6938.
Software Requirements

One authorized copy of 3ds Max is the minimum requirement. With this one copy, you can set up 3ds Max on multiple machines for the purpose of network rendering. Later topics provide explicit details for doing a custom setup on each machine. During this setup, programs required to render over a network are installed and registered.

Four separate programs interact to accomplish network rendering. The following descriptions identify these programs and provide an overview of their use.

- **3dsmax.exe**
  3ds Max is used to launch job assignments. You submit a network rendering job from the Render Setup, Render to Texture, or Execute Video Post dialog. The application is also used by the rendering servers to render the job.

- **manager.exe**
  When run, this application sets up one computer as a network manager. Alternatively, you can run Manager as a service by installing managersvc.exe. See Installing Network Services on page 6976.
  The manager program manages communication with the rendering servers during a network rendering job. This can be set up on any machine in the network. However, if large files are to be submitted and many rendering servers are going to be used, a fast computer with a large amount of disk space is the best choice. In almost all network-rendering scenarios, you only have a single manager running on the entire network.

- **server.exe**
  When run, this application sets up the computer it’s run on to be used as a rendering server. Alternatively, you can run Server as a service by installing serversvc.exe. See Installing Network Services on page 6976.
  The server program sends its local IP address to the Manager program, which in turn registers the Server so it will be available for network rendering a job assignment. When the server receives a job from the network manager, it launches a local copy of 3ds Max to perform the rendering. The server then sends the completed frame to a target directory and begins rendering the next frame sent to it by the manager. The server shuts down the 3dsmax.exe|dsview.exe process when it is no longer needed.

- **monitor.exe**
  This standalone program, named Queue Monitor, provides a Windows interface that lets you monitor and schedule network rendering. Since the Queue Monitor is a standalone program, you can start it at any time from
Setting Up for Network Rendering

Whenever different groups need to cooperate on a project, accurate communication and common procedures are essential. A rendering farm is such a project. Network setup can be difficult to configure, but you need to do it only once. Take your time to get the right setup. Read each topic in order, and complete the steps described.

These instructions are for creating a new network dedicated specifically to network rendering. If you are configuring network rendering for an existing network or for a network that will be used for other purposes, these instructions are intended as a reference example only.

Next Step

Setting Up TCP/IP on page 6935

See also:

■ Setting Up Rendering Software on page 6946
■ Setting Up Directories on page 6947
■ Initial Setup for Manager and Server Programs on page 6974

Setting Up TCP/IP

3ds Max uses the standard network protocol, TCP/IP, for network rendering. TCP/IP is a two-part acronym. TCP (Transport Control Protocol) communicates data between applications. IP (Internet Protocol) communicates data between an application and the physical network. Each computer in your rendering network needs to be configured for this protocol.
Before continuing, be sure that:

- You have administrative privileges on each machine.
- The network is operational, with network adapter cards installed in each machine.

The TCP/IP protocol requires a device, called a network adapter or Network Interface Controller (NIC), to bind with in order to communicate with other machines. Typically, the network adapter is a network card, but if you are linked to the Internet by modem, a dial-up adapter (the modem) is used.

TCP/IP uses IP addresses to identify the computers on a network. For convenience, you can assign real names to computers. An IP address is a serial number of four integers separated by periods, for example, 192.100.100.1.

IP addresses can be fixed (as in the example above) or automatic, supplied dynamically each time you connect to the network by a system known as DHCP (Dynamic Host Configuration Protocol).

3ds Max uses the NIC number, which can be thought of a unique serial number assigned to each network card, to identify each machine in the network. This allows the use of DHCP since the IP address usually changes when a machine using DHCP is rebooted.

In some cases, you may want to specify a fixed IP address, for example:

- When you have more than one Manager running on the same network, each with its own set of dedicated Servers, you need to specify which Manager to use. DHCP can be used in this case, but you will have to specify the Manager name instead of its IP address.

- The second case is when the Server or Queue Monitor is outside the local network (as in the case of a WAN or a multi-segmented network connected through a router). In this case, Servers connected to the same network can still use DHCP, provided the Manager has a fixed name and IP address.

- If your network is set peer-to-peer without an NT server (as is the case with most home networks), it is easier to set the machines with permanent, fixed IP addresses.

- Finally, you can use batch rendering on page 7021 without being connected to a network. In that case, you will need to set up a fixed TCP/IP address and configure the Microsoft Loopback adapter.

In the case of fixed addresses, it is important that IP addresses be properly assigned. In this step, you make up a list of machine names and their
corresponding IP addresses to use during TCP/IP configuration. The list will also be used when installing the 3ds Max rendering services.

Using the Manager name is particularly useful when its IP address is assigned dynamically via DHCP, and can change from session to session.

On a closed network, you don't have to worry much about conflicts with the IP addresses of other network domains. However, the addresses need to follow a consistent pattern and each must be unique within your network.

**WARNING** On an open network, such as those in many large corporations, do not alter IP addresses in any way. In such cases, to avoid potentially disastrous consequences, always work with your system administrator to make IP address changes.

**Procedures**

**To create machine names and IP addresses:**

- Create a list of machine names and IP addresses.
  
  Unless you have specific needs for later compatibility with another network, use the following list as a model.

  Since the Manager machine can also act as a server, start naming your servers to match their IP addresses as shown in the list below. Remember, any one machine can act as a manager under network rendering. Like an IP address, each name must be unique. Also keep in mind that you must not use the numbers 0 or 255 in the last group (or octet) of an IP address as they are reserved.

  **WARNING** Machine names should not start with numbers or have spaces or underscores in them, as those will result in illegal names in TCP/IP. This will cause unexpected behavior in the network rendering system.

<table>
<thead>
<tr>
<th>Machine Name</th>
<th>IP Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>server001</td>
<td>192.100.100.1</td>
</tr>
<tr>
<td>server002</td>
<td>192.100.100.2</td>
</tr>
<tr>
<td>server003</td>
<td>192.100.100.3</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
</tr>
</tbody>
</table>
### Configuring TCP/IP

From the previous step, Setting Up TCP/IP on page 6935, you should have a list of machine names and IP addresses. With that list, go to each machine and follow these procedures.

On an open network, such as those in many large corporations, do not alter IP addresses, machine names, workgroup names, or domain names in any way. In such cases, to avoid potentially disastrous consequences, always work with your system administrator to make IP address changes.

#### Procedures

Some of the following procedures are for Windows XP Professional; others are for Windows 2000. Find your operating system at the end of the procedure heading and follow that set of instructions.

**NOTE** During the writing of these procedures, Windows XP was set to display a Classic Windows interface.

**To assign a name and workgroup or domain (Windows 2000):**

1. From the Windows taskbar, open Start menu > Settings > Control Panel > System.
   
   This displays the System Properties dialog.

2. Click the Network Identification tab, and then click the Properties button to display the Identification Changes dialog.

   If you've already assigned a name to the computer, the name should appear in the Computer Name field on the Network Identification tab. Check this name against your list.
3 To change the name, in the Computer Name field, enter a name for the machine.
   ■ The first character of a valid machine/host name must not be a numeral.
   ■ Do not use underscores or spaces in the machine/host name.

4 In the Member Of group, enter either a workgroup or domain name, depending on how your network is going to be set up.
   Workgroup  An organizational unit that is used to group computers that don't belong to a domain. If you are setting up a simple network for the purpose of Network Rendering, use the Workgroup option.
   Domain A more complex way of grouping servers that share a common security policy and user account database. A domain requires you to set up a Primary Domain controller. You should select the Domain option only if your Network Administrator has a Domain already set up and functioning correctly.

To assign a name and workgroup or domain (Windows XP):

1 From the Windows taskbar, open Start menu > Settings > Control Panel > System.
   This displays the System Properties dialog.

2 Click the Computer Name tab, and then click the Change button to display the Computer Name Change dialog.
   If you've already assigned a name to the computer, the name should appear in the Computer Name field on the Computer Name tab. Check this name against your list.

3 To change the name, in the Computer Name field, enter a name for the machine.
   ■ The first character of a valid machine/host name must not be a numeral.
   ■ Do not use underscores or spaces in the machine/host name.

4 In the Member Of group, enter either a workgroup or domain name, depending on how your network is going to be set up.
   Workgroup  An organizational unit that is used to group computers that don't belong to a domain. If you are setting up a simple network for the purpose of Network Rendering, use the Workgroup option.
**Domain** A more complex way of grouping servers that share a common security policy and user account database. A domain requires you to set up a Primary Domain controller. You should select the Domain option only if your Network Administrator has a Domain already set up and functioning correctly.

**To add the TCP/IP protocol (Windows 2000):**

1. From the Windows taskbar, open Start menu > Settings > Network and Dial-up Connections > Local Area Connection. This opens the Local Area Connection Status dialog.

2. Click the Properties button. This opens the Local Area Connection Properties dialog.

3. Check the list for "Internet Protocol (TCP/IP)". If you find this listing, TCP/IP is installed on this machine. Go on to either of these procedures in the current topic:
   - **To configure TCP/IP in DHCP mode** on page 6941
   - **To configure TCP/IP with fixed IP addresses** on page 6942

   If TCP/IP is not installed, make sure none of the list items is highlighted (click in a blank area of the list), and complete the remaining steps in this procedure.

4. Click the Install button. This opens the Select Network Component Type dialog.

5. In the list, click Protocol, and then click the Add button.

6. In the Select Network Protocol dialog, select Internet Protocol (TCP/IP), and then click OK. A message appears: "Do you want to use DHCP?". Consult your system administrator to see if your network is DHCP-compatible; if it is, click "Yes". If you are unsure, click "No" and proceed to set your workstations with fixed IP addresses. TCP/IP is added to the list of installed protocols.

7. Click the Close button.
To add the TCP/IP protocol (Windows XP):

1. From the Windows taskbar, open Start menu > Settings > Network Connections.
   This opens the Network Connections dialog.

2. Right-click Local Area Connection and click the Properties button.
   This opens the Local Area Connection Properties dialog.

3. Check the list for "Internet Protocol (TCP/IP)".
   If you find this listing, TCP/IP is installed on this machine. Go on to either of these procedures in the current topic:
   - To configure TCP/IP in DHCP mode on page 6941
   - To configure TCP/IP with fixed IP addresses on page 6942
     If TCP/IP is not installed, make sure none of the list items is highlighted (click in a blank area of the list), and complete the remaining steps in this procedure.

4. Click the Install button.
   This opens the Select Network Component Type dialog.

5. In the list, click Protocol, and then click the Add button.

6. In the Select Network Protocol dialog, select Internet Protocol (TCP/IP), and then click OK.
   A message appears: "Do you want to use DHCP?". Consult your system administrator to see if your network is DHCP-compatible; if it is, click "Yes". If you are unsure, click "No" and proceed to set your workstations with fixed IP addresses.
   TCP/IP is added to the list of installed protocols.

7. Click the Close button.

To configure TCP/IP in DHCP mode (Windows 2000):

1. From the Windows taskbar, open Start menu > Settings > Network and Dial-up Connections > Local Area Connection.
   This opens the Local Area Connection Status dialog.

2. Click the Properties button.
   This opens the Local Area Connection Properties dialog. You should see your network adapter card listed as "Connect Using" at the top of this
dialog. If your adapter is not listed, follow the instructions in Windows 2000 documentation on adapter setup.

3 In the list, highlight Internet Protocol (TCP/IP) and click Properties. The Internet Protocol (TCP/IP) Properties dialog appears.

4 Make sure the option "Obtain an IP address automatically" is chosen.

5 Click OK to close each dialog in turn. Windows 2000 finishes configuring the connection.

6 Reboot the computer to complete the configuration.

7 Repeat all the steps on this page on every machine in your network.

To configure TCP/IP in DHCP mode (Windows XP):

1 From the Windows taskbar, open Start menu > Settings > Network Connections. This opens the Network Connections dialog.

2 Right-click Local Area Connection and click the Properties button. This opens the Local Area Connection Properties dialog. You should see your network adapter card listed as "Connect Using" at the top of this dialog. If your adapter is not listed, follow the instructions in Windows XP documentation on adapter setup.

3 In the list, highlight Internet Protocol (TCP/IP) and click Properties. The Internet Protocol (TCP/IP) Properties dialog appears.

4 Make sure the option "Obtain an IP address automatically" is chosen.

5 Click OK to close each dialog in turn. Windows XP finishes configuring the connection.

6 Reboot the computer to complete the configuration.

7 Repeat all the steps on this page on every machine in your network.

To configure TCP/IP with fixed IP addresses (Windows 2000):

1 From the Windows taskbar, open Start menu > Settings > Network and Dial-up Connections > Local Area Connection. This opens the Local Area Connection Status dialog.

2 Click the Properties button.
This opens the Local Area Connection Properties dialog. You should see your network adapter card listed as "Connect Using" at the top of this dialog. If your adapter is not listed, follow the instructions in Windows 2000 documentation on adapter setup.

3 In the list, highlight Internet Protocol (TCP/IP) and click Properties. The Internet Protocol (TCP/IP) Properties dialog appears.

4 Choose “Use The Following IP Address”.

5 In the box for IP Address, enter the address for that machine. Check your list to make sure the entry is correct.

6 In the box for Subnet Mask, type these numbers (these are the same for every machine):

   255.255.255.0

   If you are on a large corporate network, this subnet mask might be different. In this case, use the mask that your network administrator specified. Also, change the network mask when setting up a server to connect to a manager as well as in the Network Job Assignment dialog to match the subnet mask in order for Automatic Search to work.

7 Click OK to close each dialog in turn. Windows 2000 finishes configuring the connection.

8 Reboot the computer to complete the configuration.

9 Repeat all the steps on this page on every machine in your network. Remember that each machine needs to have a unique IP Address and machine name so no conflicts arise.

**To configure TCP/IP with fixed IP addresses (Windows XP):**

1 From the Windows taskbar, open Start menu > Settings > Network Connections. This opens the Network Connections dialog.

2 Right-click Local Area Connection and click the Properties button. This opens the Local Area Connection Properties dialog. You should see your network adapter card listed as "Connect Using" at the top of this dialog. If your adapter is not listed, follow the instructions in Windows 2000 documentation on adapter setup.

3 In the list, highlight Internet Protocol (TCP/IP) and click Properties.
The Internet Protocol (TCP/IP) Properties dialog appears.

4 Choose “Use The Following IP Address”.

5 In the box for IP Address, enter the address for that machine.
   Check your list to make sure the entry is correct.

6 In the box for Subnet Mask, type these numbers (these are the same for every machine):
   255.255.255.0
   If you are on a large corporate network, this subnet mask might be different. In this case, use the mask that your network administrator specified. Also, change the network mask when setting up a server to connect to a manager as well as in the Network Job Assignment dialog to match the subnet mask in order for Automatic Search to work.

7 Click OK to close each dialog in turn.
   Windows XP finishes configuring the connection.

8 Reboot the computer to complete the configuration.

9 Repeat all the steps on this page on every machine in your network.
   Remember that each machine needs to have a unique IP Address and machine name so no conflicts arise.

Creating a Special User Account

If you run the Server as a Service, you should create a special user account, which gives the Server the right to access other machines on the network for necessary maps, xrefs and output directories. This account must be identical across all rendering server machines.

By assigning a user to the rendering Server service, you configure the rendering server to operate with the permissions and access rights of that user account. Without this assignment, the rendering server operates with system permissions, which do not let the server service access map, xref, image, or output directories on other machines.

NOTE These steps require you to have administrative privileges on every machine where you set up this account.

For the following procedures, Windows XP was set to display a Classic Windows interface.
Procedures

To create a new user (Windows 2000 and XP):

1. From the Start menu, select Settings > Control Panel > Administrative Tools > Computer Management.
2. In the Computer Management dialog, go to System Tools > Local Users and Groups > Users.
3. In the right-hand pane, right click in a blank area and choose New User to display the New User dialog. If the New User option is unavailable, you don’t have the required administrative privileges.
4. In the New User dialog, do the following:
   - Enter a user name for the new account in the Username text box. This can be any name, but it should be the same across all network rendering machines.
   - Enter a password for the new account in the Password and Confirm Password boxes. Like the user name, this password needs to be the same for all rendering servers.
   - Turn off “User Must Change Password At Next Logon” and turn on “Password Never Expires”. This will bypass errors when you assign this special user account to the rendering service.
   - Click Create to create the new user and password.
   - Click Close.

5. Do not close Administrative Tools.

To assign a user to a rendering service (Windows 2000 and XP):

Do the following on every computer used as a rendering server:

1. Make sure each server system is set up with the Network Rendering Server on page 6989 running as a service.
2. From the Administrative Tools windows, choose Services to display the Services dialog.
3 From the Service list, right-click the Backburner Server item.
4 Choose Properties to display the Properties dialog.
5 On the Log On tab, choose This Account and enter the name of the new user you created for the special user account.
   If a user account was created on the domain, you would enter [domain name]\[user name] as This Account, or you can browse the domain for the user.
6 In Password and Confirm Password fields, enter the password for the special user account.
7 Click OK to exit the Properties dialog.
8 If the service is started, stop it by right-clicking the item and choosing Stop.
9 Right-click the item and choose Start to restart the service with the newly assigned user.

   **NOTE** If you did not turn off “User Must Change Password At Next Logon” when setting up the new account, you will encounter errors. You will need to re-login the newly assigned user so you can first change the password. Once the password is changed, the Backburner Server should start.

10 Close the Services dialog

### Setting Up Rendering Software

When you've configured the computers on your rendering network for TCP/IP, you're ready to load 3ds Max.

You need to install 3ds Max on each system you plan to use for network rendering. After you've installed 3ds Max on all the systems, at least one of them needs to be authorized. This is the copy of 3ds Max that you will run interactively and use to submit jobs for network rendering.

Refer to the Installation Guide for details about installing 3ds Max.

**NOTE** A system using the scanline renderer, that is intended to act a dedicated rendering server, does not require authorization for 3ds Max.
Setting Up Directories

During network rendering, common directories (directories that are shared across the network) allow access to files needed by all the rendering servers. You can organize, share, and (if necessary) mount these directories.

There are two types of common directories:

- **Map directories** One or more directories where maps and images are stored. These can be both project-specific and general locations.

- **Output directory** A single directory where completed frames are sent from each rendering server, also called the target directory. You specify this directory for each job. This can also be a local directory on each machine.

The network rendering system uses the Universal Naming Convention (UNC) to identify directories and files. UNC names begin with a double backslash and do not include a drive letter. This is the convention:
```
\machine_name\directory\subdirectory\filename
```

**IMPORTANT** To simplify network rendering, use UNC names whenever possible within a 3ds Max scene, even if the directory is on the local machine.

**TIP** When entering UNC names, omit the `\` before the computer name until you've entered the entire path and file name. This eliminates search delays when entering UNC path names into file selection dialogs.

Some networks require drive letters instead of UNC names. Directories on such networks can be mounted as drive letters and shared over the network. See Mounting a Directory on page 6950.

Organizing Directories

Correctly organizing directories is critical to the success of your rendering farm. Every element in a scene needs to be available to each server for a complete rendering. The goal is to give every machine in your network the same "picture" of where files are located. Follow these rules when organizing your directories:

- **Share directories** on page 6949 to make them available to the network.

- Use UNC file specification when assigning maps files and output directories, even when the directory is on a local machine.
Creating Map Directories

As you assign materials in a scene, 3ds Max stores the complete path to each map you use. 3ds Max searches for that particular location. If necessary, 3ds Max continues to look through the directory containing the scene file and its subdirectories.

Maps, specific to a project, should be kept in a dedicated directory that has been set up for that project. You can create subdirectories below this directory to organize files. This directory needs to be shared using Windows Explorer.

Maps for general use, such as texture libraries, can be organized as you choose. The computers containing such libraries need to be on the network, and the directories need to be shared.

Creating a Common Output Directory

A common output directory is a single directory on one hard disk where rendered frames accumulate during network rendering. When creating a common output directory, follow these guidelines:

■ Decide on a machine to accept final output. It should have enough disk space to store the largest completed animation file you’re likely to render.

■ Create or choose a directory for final output.

■ Share that directory as a resource available to the network.

Creating a Local Output Directory

A local output directory lets you use available storage on each rendering server. Rendered frame files are sequentially numbered when assigned by the network manager. When you collect the finished frames, they automatically sort in the proper order. When creating a local output directory, follow these guidelines:

■ Use the same path and name for all local directories. For example, use \3dsmax_files\images\.

■ Use the same path and name for all local directories. For example, use \Program Files\Autodesk VIZ 2008\images.

■ Specify this path for the output directory when you start network rendering. All rendering servers will then send their output to this local directory.
On any one rendering job, use either a common or local output directory. They cannot be mixed.

See also:
- Mounting a Directory on page 6950
- Using Configure User Paths on page 6951

Sharing a Directory

You share a directory from the machine where the directory is located. This gives other machines on your network access to that directory. The instructions below are general. See your Windows Vista, Windows XP, or Windows 2000 documentation for details.

Next Step

Initial Setup for Manager and Server Programs on page 6974

See also:
- Mounting a Directory on page 6950
- Using Configure User Paths on page 6951

Procedures

To share a directory:

1. Go to the machine that contains the directory you want to share.
2. In Windows Explorer, right-click the directory to share, and then choose Sharing from the right-click menu.
3. If using Windows XP or Windows 2000, on the Sharing tab, choose the Share This Folder option.
4. If using Windows NT4, on the Sharing tab, select the Shared As option.
5. Use the default Share Name.
6. Click Permissions and make sure permissions are set to Everyone/Full Control. Click OK to exit the Permissions dialog.
7 Click OK to accept the changes.

**NOTE** If you plan to use more than 10 rendering servers, both the output path and location of all scene maps should be on a system running Windows XP or Windows 2000 Server, as both Windows XP Professional and Windows 2000 Professional have a limit of 10 simultaneous connections.

---

**Mounting a Directory**

You can mount a directory to a drive letter as an alternative to using UNC names on page 8753. In mixed UNIX/XP/2000 networks, for example, you might need to mount the output directory.

For network rendering, you mount (or map) the directory on all machines in the network. This gives all rendering servers access to the shared directory.

Before beginning this setup, choose a common drive letter for all servers to mount. If you have other drives mounted, you might need to switch assignments to free the drive letter for this mount.

If a Map or Target directory is on a rendering server, mount the directory on this machine like all the others, even if the directory is on the local disk.

When using a mounted directory, be sure that the directory to be mounted is correctly shared. When assigning bitmaps, always use the path with the common drive letter.

The steps below are general. See your Windows XP or 2000 documentation for more details.

**NOTE** During the writing of these procedures, Windows XP was set to display a Classic Windows interface.

---

See also:

- **Sharing a Directory** on page 6949
- **Using Configure User Paths** on page 6951
Procedures

To map a directory to a drive letter (Windows 2000 or XP):

1. In Windows Explorer, choose Tools > Map Network Drive to display the Map Network Drive dialog.

2. Set the Drive drop-down menu value to the common drive letter you've chosen.

3. In Folder, enter the exact location of the output directory, using UNC convention.

You can also map a directory to a drive letter by choosing the machine and shared directory with the Browse button in the Map Network Drive dialog.

4. Click Finish to complete the mount.

**NOTE** If the drive maps to a server on a large corporate network, you may be required to enter your user name and password to gain access.

Using Configure User Paths

Render-only machines do not require any form of authorization. However, you cannot use unauthorized versions of 3ds Max to access the Configure User Paths dialog on page 8284 to specify alternative locations for servers to search for bitmap files.

If you do not want to concern yourself with configuring paths on render-only machines (servers), then turn on the Use Alternate Map Path or Include Maps option on the Network Job Assignment dialog on page 6953.

The Use Alternate Map Paths option lets you specify an alternate folder where the rendering server can look for bitmaps if they are not found in the primary bitmap path.

If using Include Maps, network rendering will take care of making copies of the bitmaps and send them to the server assigned for rendering. When the rendering job is done, the copies are erased from the server hard drive. The files are placed in a \network\serverjob subdirectory of 3ds Max.

If a server cannot find a bitmap image in the path specified in the file, it then searches the paths listed in its own Bitmaps panel. Only after searching in all locations will the server fail due to missing maps. If you have followed
instructions in the previous topics (Setting Up Directories on page 6947, Sharing a Directory on page 6949, and Mounting a Directory on page 6950), then you know that a common map directory on the network is the best way to proceed. Use the following steps to properly configure your paths on the machine running the authorized copy of 3ds Max and on the servers meant for render-only purposes.

See also:
- Sharing a Directory on page 6949
- Mounting a Directory on page 6950

Procedures

To add bitmap paths to the External Files panel from within 3ds Max:

1. Run 3ds Max on a machine running an authorized copy of 3ds Max.
2. Choose Customize > Configure User Paths to open the Configure User Paths dialog, and then click the External Files tab, if necessary.
3. Use the Add button to specify the paths (UNC or mounted) to every directory on the network where bitmap files are stored for rendering. Make sure you use UNC or mounted directories, even if the maps are on the local drive.
4. Click OK.

To add bitmap paths to render-only machines using the initialization file:

Use the following steps if you do not want to authorize 3ds Max on the server machine(s).

1. Install the 3ds Max core software on the server station(s).
2. Copy the 3dsmax.ini on page 60 file from your authorized 3ds Max workstation to the 3ds Max directory of each of your servers.

If you followed the previous procedure, the copied initialization file contains information about UNC or mounted directories that stores the required bitmap files.
NOTE To prevent mishaps, it is usually a good idea to edit the INI file once it is copied to the server. Remember that the server machine can be configured differently than your 3ds Max workstation: The drive letter, program directory, and subdirectories may be different. Use a word processor to edit all entries under the [Directories] section to match entries of the server machine.

For example:

```
[Directories]
Fonts=d:\3dsmax\fonts
Scenes=d:\3dsmax\scenes
Import=d:\3dsmax\meshes
Export=d:\3dsmax\meshes
...
```

Network Job Assignment Dialog

Rendering menu > Render Setup > Render Setup dialog > Turn on Net Render (Render Output group) > Render

Rendering menu > Render To Texture > Render To Texture dialog > Turn on Net Render (Render Settings group) > Render

Rendering menu > Video Post > Set up a sequence with an Image Output Event > Turn on Net Render (Output group) > Render

Use the Network Job Assignment dialog to name rendering jobs, specify the computers that will participate in the rendering, and submit jobs to the rendering servers.

You can submit as many jobs as you like in a single session. Open each file you want to render and submit it following the standard procedure. Each job is placed behind the last one submitted. If you submit a job in which the frame output name is the same as another job in the queue, a warning dialog asks you if you want to overwrite the output frames from the other job.

You can divide the work of rendering a single image among any number of rendering servers. This is particularly useful when rendering a single, extremely high-resolution image intended for print. To use this feature, turn on the Split Scan Lines option on page 6958.
Procedures

To use the Network Job Assignment dialog:

The Network Job Assignment dialog is accessible when you turn on the Net Render toggle. The Net Render toggle can be accessed from three different dialogs used for rendering.

1. Rendering menu > Render Setup > Render Setup dialog > Render Output group
2. Rendering menu > Render To Texture > Render Setup dialog > Render Settings group
3. Video Post dialog > Execute Sequence > Execute Video Post dialog > Output group
4. In the Render Setup dialog > Render Output group, click the ellipsis button and then specify an output file name and path using Universal Naming Convention (UNC) on page 8753. The easiest way to specify a UNC path is to start with Save In > My Network Places.
5. Turn on Net Render.
6. Click the Render button.
   The Network Job Assignment dialog appears.
7. On the Network Job Assignment dialog, specify a job name.
   By default, this is the file name of the current scene. Click the plus (+) button next to the Job Name field to increment the job name. Unlike the plus button in the file dialogs, this button does not automatically launch the job.

   **NOTE** 3ds Max does not let you submit multiple jobs with the same name.

8. Determine whether to find the Manager automatically or manually. By default, 3ds Max searches automatically for the Manager using a network mask that you specify in the dialog. Alternatively, turn on Manual Search and enter the name or IP address of the computer running the Manager program.
9. Click Connect to continue.
   You see a listing of all servers available for network rendering. Each server is marked with a colored icon to denote its current status:
   **Green** Running and not rendering any jobs.

   **Yellow** Running and currently rendering a job.

   **Gray** Offline and not accepting new jobs.
Yellow Rendering another job. You can assign jobs to busy servers, and the jobs will be rendered in the order received.

Red Failed. Try rebooting the server or see Troubleshooting on page 6927 for more information on failed servers.

Gray Absent. Verify that the server is currently running and that it has not been "Disallowed" in the Week Schedule. See “Scheduling the Availability of a Render Node Using the Backburner Monitor” in the Autodesk Backburner User’s Reference.

If a rendering server is running on a workstation that also has an interactive session of 3ds Max, you can still select that machine for rendering. A second copy of 3ds Max is launched to execute the network render.

You can view statistics of a particular server by right-clicking its name and choosing Properties.

10 Determine whether you will use the selected server, all servers, or a group of servers.

11 Click Submit to send the job to the rendering queue.
**Interface**

**Job Name** Provides a field for you to name the job (mandatory). The + button beside the field adds incremental numbering (Job01, Job02, and so on).

**NOTE** 3ds Max does not let you submit multiple jobs with the same name.

**Description** Enter an optional description of the job.

**Enter Subnet Mask/Enter Manager Name or IP Address group**

**Enter Manager Name or IP Address** When Automatic Search is turned off, enter the name of the Network Manager on page 8651 machine or its IP address.
**Enter Subnet Mask** When Automatic Search is on, enter a subnet mask for automatic search. For information on using subnet masks, see Configuring TCP/IP on page 6938.

**Connect/Disconnect** Connects to the network Manager. 3ds Max preserves the connection as a global setting so that you need to change it only when you want to specify an alternative Manager. If connected to the network manager, click Disconnect to disconnect from the current manager so you can choose a different manager.

**Automatic Search** Determines whether 3ds Max connects to a specific manager or searches for one using a subnet mask when you click Connect. When off, 3ds Max attempts to connect to the manager you specify in this group. When on, it searches the network for a manager using the specified subnet mask.

**Refresh** Updates the Server and Job lists.

By default, all servers are used for the job. When the Options group > Use All Servers check box is turned off, you can choose one or more servers to render the job. If rendering to a multiple-frame file format, such as an AVI or MOV file, you can choose only one server.

**Priority group**

**Priority** Specifies a priority ranking for the job. The lower this setting, the higher the job priority. Default=50.

For example, consider a job with priority 1 (Job B) that is submitted to a network manager that's already rendering a job with priority 2 (Job A). Because Job B has a higher priority, Job A will be suspended and Job B rendered. When Job B is finished, 3ds Max will resume rendering Job A.

If two or more jobs have the same priority, they're executed in order of submission.

**Critical** Sends the job to the head of the queue, preempting the existing jobs. If a server is currently rendering and a critical job is sent to the queue, the server will stop rendering its current job and begin rendering the new, critical job. When finished with the critical job, the server returns to the next job it has been assigned in the queue.

**Dependencies** Opens the Job Dependencies dialog on page 6963, which you can use to specify existing jobs that must finish before the current job can start.
Options group

**Enabled Notifications** Lets 3ds Max send rendering-related messages via email. When this is on, its Define button becomes available. For information, see the Notifications dialog on page 6965 topic.

**Define** Opens the Notifications dialog, which lets you set notifications parameters.

**Split Scan Lines** Lets you subdivide the rendering of each frame among the rendering servers. This is useful when rendering a single, extremely high-resolution image intended for printing. For information, see the Strips Setup dialog on page 6967 topic.

When Split Scan Lines is on, its Define button becomes available.

**NOTE** This feature does not support Render Elements. Also, it’s unavailable when rendering to textures with projection mapping enabled and Sub-Object Levels on.

**Define** Opens the Strips Setup dialog, which lets you set parameters for the Split Scan Lines option.

**Ignore Scene Path** When off, the server attempts to copy the scene file from the manager to the server. If the manager is running on Windows 2000 Professional, only 10 servers will copy the file from the manager; any machines over the limit 10 will use TCP/IP to retrieve the file. When turned on, the servers get the file via TCP/IP only. Default=off.

**Rendered Frame Window** During rendering, displays the Rendered Frame Window on all servers running serverapp.exe (not serversvc.exe). Default=on.

**Include Maps** Archives the scene, with all of its maps, any inserted Xrefs and their maps, into a proprietary-format compressed file. The compressed file is sent to each Server, where it is uncompressed into a temporary directory named serverjob in the \network subdirectory of 3ds Max and rendered. Default=off.

Use this feature if you have access only to Servers that exist over the Internet or if you have a slow network setup. It is not meant for heavy production use. However, if you don’t use it, you must first ensure that all network servers have access to all map and Xref paths referred to in the scene.

**Initially Suspended** Adds the named job to the queue in an inactive state. The job is not started until you activate it manually from the Backburner Monitor. See “Monitoring and Managing Jobs” in the Autodesk Backburner User’s Guide.
Server Usage Group

You choose between using all available servers, all servers in a group, or selected servers. See “Configuring Server Groups” in the *Autodesk Backburner User’s Guide* for an explanation of how to set up server groups. In a 3ds Max setup it can be useful to set up servers in groups. For example, during busy times you can assign high priority jobs to a group of high performance servers.

**Use Selected** Uses only the servers that you have highlighted in the Server list.

**Use Group** Uses all of the servers in a group.

**TIP** Note that the servers are assigned to a group in the Autodesk Backburner monitor.

**Group drop-down list** Choose the group of servers that you want to use for your render.

**Use All Servers** Uses all Servers in the active Server group for rendering the job. Available only after you submit a multi-frame rendering job.

Path File Group

**Use Alternate Path File** Allows you to specify an alternate path file in the MXP format that rendering servers can use to find bitmaps that are not found on the primary map paths. When on, you can manually enter the path and file name in the field below the check box, or click the ellipsis button and browse to the MXP file.

**NOTE** Create MXP files with *Configure User Paths* on page 8284.

Status group

Displays text messages describing the current status of the job assignment.

Server list

The Server list, located on the upper-right side of the Network Job Assignment dialog, displays all network rendering servers on page 8653 registered with the
network manager after you connect to the manager. There are two types of tabs in the Server list:

- **All Servers**  Lists all of the available servers that can be used for your render. When this tab and Use All Servers are enabled, all servers will be used to render the job.

- **[group name]**  Lists all of the servers assigned to a group. When this tab and Use Group are enabled, all servers listed on the tab will be used to render the job.

**NOTE** If a server is unavailable it will be skipped and the next available server will be used.

If more groups are available than can fit in the space above the list, arrow buttons for scrolling the group list horizontally appear above the list's top-right corner. Click these arrow buttons to scroll the list left or right to view additional group tabs.

By default, each Server is marked with a colored status icon:

- **Green**  Running and not rendering any jobs.

- **Yellow**  Rendering another job. You can assign jobs to busy Servers, and the jobs will be rendered in the order received.

- **Red**  Failed. Try rebooting the Server or see Troubleshooting on page 6927 for more information on failed Servers.

- **Gray**  Absent. Verify that the network Server is currently running and that it has not been "Disallowed" in the Backburner Monitor. See “Launching the Backburner Monitor” in the Autodesk Backburner User’s Guide for information on viewing activities in the monitor.

**NOTE** You can change the height of the server list window relative to the job list window below it by dragging the partition vertically.

**Server list right-click menu**

By default, servers are listed by name only. To see more information about a server, right-click its name in the list. A menu appears with these options:

- **Properties**  Displays the Server Properties dialog, which shows aspects of the server hardware and operating system, including memory and disk space.
**All Server Details** This toggle, when on, displays all details about each server to the right of its name. When off, restores the last saved set of partial server details unless the last saved set was All Server Details, in which case it restores the default set: name only. See the following item for the list of available details.

**NOTE** You can see more details by scrolling the list with the horizontal scroll bar at the bottom, or by widening the dialog by dragging its right side with the mouse.

**Partial Server Details** Opens the Set Server Property Tabs dialog, which lets you specify which details are shown in the Server list. The dialog provides check boxes for turning on and off the display of these details:

- Status: See [Server list](#) for status details.
- Number of CPUs
- Total Physical Memory - in bytes
- Operating System
- Work Disk Space - in megabytes
- Historical Performance Index - see note below
- Handle - a hexadecimal identification number for the machine
- User - current user name

**NOTE** The Historical Performance Index value, listed under the Perf. Index heading in the Server list window, offers information on the relative speed of the listed servers. The fastest machine is rated at 1.0, while the other servers are rated as fractions of the fastest. A machine whose average is twice as long would receive a 0.5 index. Each machine is rated by measuring the time it takes to complete each frame, and the accumulated time is divided by the number of frames, resulting in the average time per frame, in seconds.

Several factors can affect a machine's performance. CPU power isn't necessarily a concern when large file transfers are involved. For example, if a certain job uses several map files from a centralized server, the performance of the network throughput plays a much larger part than CPU performance, as most machines will spend the majority of the time reading maps. On the other hand, if the machine has all maps locally it will have a huge advantage (local access versus network access) regardless of which CPU it is using. The performance index provides you with information regarding your servers' rendering performance.
to help analyze your network rendering setup and better distribute the workload.

Job list

The job list, located on the lower-right side of the Network Job Assignment dialog, displays all jobs submitted to the network manager. Also shown are each job’s priority, status, and output file path.

To change job settings and manage jobs, use the Backburner Monitor. See “Modifying Job Settings” and “Monitoring and Managing Jobs” in the Autodesk Backburner User’s Guide.

---

Advanced Opens the Advanced Settings dialog on page 6970, where you can make settings for Per-Job Timeouts, TCP port number, Pre-Render MAXScripts and Job Handling.

Submit Click Submit to exit this dialog and send the current job to the Network Manager, which places it in the queue for rendering.

When you submit a rendering job, if the output file name to be used by the job is the same as that used by an existing job, you're asked if you want to overwrite the existing file(s). Also, if the name of the submitted job replicates one already in the rendering queue, an alert notifies you; click OK, change the job name, and submit it again.

NOTE Submitting a job creates a folder for the job on the manager machine in the \Program Files\Autodesk\Backburner\Network\jobs\ folder. In that folder is a compressed file with a .maz extension containing the scene file. You can extract the scene from the command prompt using the maxunzip.exe program, found in the 3ds Max program directory. For example, to extract a file named testfile.maz, assuming 3ds Max is installed in a folder named \Autodesk 3ds Max 2010\, open the command prompt, navigate to the \Program Files\Autodesk\Backburner\Network\jobs folder, and enter this: “\Program Files\Autodesk\Autodesk 3ds Max 2010\maxunzip' testfile.maz. You must specify the .maz file-name extension; otherwise you’ll get an error message.

Cancel Discards changes and exits the dialog.
Job Dependencies Dialog

Rendering menu > Render Setup > Render Setup dialog > Turn on Net Render (Render Output group). > Render > Network Job Assignment dialog > Connect to a Manager. > Priority group > Dependencies

Rendering menu > Render To Texture > Render To Texture dialog > Turn on Net Render (Render Settings group) > Render > Network Job Assignment dialog > Connect to a Manager. > Priority group > Dependencies

Rendering menu > Video Post > Set up a sequence with an Image Output Event > Turn on Net Render (Output group) > Render > Network Job Assignment dialog > Connect to a Manager. > Priority group > Dependencies

This dialog lets you specify jobs that shouldn't begin rendering until other jobs finish. Use the two lists and the Add and Remove buttons to build a list of jobs that must finish rendering before the current job can start.
**Existing Jobs list** Lists all previously submitted jobs. To specify a dependency for the current job, add one or more of these to the Jobs Your Job Depends On list.

**Add** Select one or more jobs your job is to depend on, and then click Add to add them to the Jobs Your Job Depends On list.

**Add All** Adds all jobs in the Existing Jobs list to the Jobs Your Job Depends On list.

**Remove** Removes highlighted jobs from the Jobs Your Job Depends On list.

**Remove All** Removes all jobs from the Jobs Your Job Depends On list.
Jobs Your Job Depends On list Lists all previously submitted jobs. To specify a dependency for the current job, add one or more of these to the Jobs Your Job Depends On list.

Notifications Dialog

Rendering menu > Render Setup > Render Setup dialog > Turn on Net Render (Render Output group) > Render > Network Job Assignment dialog > Options group > Turn on Enabled Notifications. > Define

Rendering menu > Render To Texture > Render To Texture dialog > Turn on Net Render (Render Settings group) > Render > Network Job Assignment dialog > Options group > Turn on Enabled Notifications. > Define

Rendering menu > Video Post > Set up a sequence with an Image Output Event > Turn on Net Render (Output group) > Render > Network Job Assignment dialog > Options group > Turn on Enabled Notifications. > Define

This dialog lets a network rendering job send notifications via email. Such notifications can be useful when you launch a lengthy render, such as an animation, and don't care to spend all your time near the network manager system.

See also:

- “Configuring Backburner Log Files” in the Autodesk Backburner User's Guide
Interface

Notifications

Categories group

Notify Progress Triggers a notification to indicate rendering progress. A notification is triggered every time the number of frames specified in Every Nth Frame has completed rendering. Default=off.

Every Nth Frame The number of frames used by Notify Progress. Default=1.

Notify Failures Sends an email notification only if something occurs to prevent the completion of a rendering. Default=on.

Notify Completion Sends an email notification when a rendering job is complete. Default=on.
Email Options group

Send Email Notifies via email.

Include Summary Includes a summary of the network rendering progress with the notification email. Available only when Send Email is turned on.

From Enter the email address of the person who initiates the rendering job.

To Enter the email address of the person who needs to know the rendering status.

SMTP Server Enter the numeric IP address of the system you use as a mail server.

Strips Setup Dialog

Rendering menu > Render Setup > Render Setup dialog > Common tab > Turn on Net Render (Render Output group) > Render > Network Job Assignment dialog > Options group > Turn on Split Scan Lines. > Define

The Strips Setup dialog lets you specify how to split up the rendering of a single, large image among several different servers on the network. 3ds Max automatically subdivides the rendering based on settings you provide, and then fits the pieces together into the final image.

NOTE A version of this feature was known as Region Net Render in versions of 3ds Max prior to version 8.

Procedures

To render a large image with a networked render farm:

1 Set up a scene to render.

2 Set up your system for network rendering on page 6905.

3 From the Rendering menu, choose Render Setup.
   The Render Setup dialog opens, with the Common tab active.

4 In the Output Size group, specify the size to render.

5 In the Render Output group, specify an output file name and location, and turn on Net Render.

6 Click the Render button.
The Network Job Assignment dialog appears.

7 In the Options group, turn on Split Scan Lines, and then click Define. The Strips Setup dialog appears. The dialog displays the output resolution, and lets you determine how to split up the rendering job by specifying the number of horizontal strips into which the image will be subdivided.

8 Specify the vertical size of each strip in pixels or as a percentage of the total image height, or set the number of strips. Changing one also changes the other.

9 Set the overlap in pixels or as a percentage. Using overlap isn’t always necessary, but if you notice anomalies where the strips meet, increase this value.

10 Connect to the manager, specify a job name, choose one or more servers on which to render, and then click Submit. The job is sent to the network rendering manager, which supervises the network rendering job. The job consists of first rendering each slice, and then combining, or “stitching,” the slices into the final image.

11 Monitor the job via the Backburner Monitor. See “Monitoring and Managing Jobs” in the Autodesk Backburner User’s Guide. Rendering and stitching passes are designated “Slice Pass” and “Stitch Pass,” respectively. When all slices are finished, the job status will be Complete.
### Interface

![Strips Setup](image)

**Output Resolution** This read-only field displays the horizontal and vertical resolution of the final image, in pixels.

**Strip Height** Sets the height of each horizontal strip in pixels or as a percentage of the total height. Default=10 percent of the total image height, in pixels. This setting is interdependent with and inversely proportional to the Number Of Strips setting; increase one, and 3ds Max decreases the other.

**Number of Strips** Sets the number of horizontal strips to be rendered by the available servers. Default=10. The value determines the maximum number of machines to which the job can be farmed out. For example, if you use the default setting of 10 strips, the job can be performed by 10 machines at most. In that case, assuming equal performance of all 10, rendering would take approximately one-tenth the time required by one machine.

---

Network Job Assignment Dialog | 6969
TIP  For optimal results with render farms that comprise machines of different speeds, use a value high enough that the job can be completed most efficiently. For example, consider a two-server network with one machine four times as fast as the other. If you set Number Of Strips to 2, the job won’t be finished until the slower machine renders its half of the final image. But if you set Number Of Strips to 4, the faster machine can render three of the strips while the slower machine renders one, effectively halving the total render time.

This setting is interdependent with and inversely proportional to the Strip Height setting; increase one, and 3ds Max decreases the other.

Overlap  Set the amount by which each strip overlaps the adjoining one(s). You can set this in pixels or as a percentage of the final image height. A certain amount of overlap is necessary to compensate for image artifacts created by antialiasing and render effects. If you notice anomalies where the image slices meet, try increasing the Overlap setting.

Pixels/Percentage  Determines whether the Strip Height and Overlap settings represent pixels or as a percentage of the final image height. Choosing a different option automatically changes the two values accordingly.

Delete Temporary Images Upon Completion  Deletes the “slice” images after the final image is created. Default=off.

Advanced Settings Dialog

Rendering menu > Render Setup > Render Setup dialog > Render Output group > Turn on Net Render > Render > Network Job Assignment dialog > Advanced

Rendering menu > Render To Texture > Render To Texture dialog > Turn on Net Render (Render Settings group) > Render > Network Job Assignment dialog > Advanced

Rendering menu > Video Post > Set up a sequence with an Image Output Event > Turn on Net Render (Output group) > Render > Network Job Assignment dialog > Advanced

The Advanced Settings dialog lets you set job timeouts on a per-job basis, assign the TCP port number, specify pre-render scripts and affect job handling and archive settings.
**Interface**

**Per Job Timouts Group**

**Enable**  Turns on the ability to set timeouts on a per-job basis. The remaining settings in this group become available only when Enable is turned on.

**Wait for MAX to Load** Specifies the amount of time after a job is submitted that the Manager waits for a server to report that it received the frame and is
rendering. If this value is exceeded, an error message is logged for a failed frame, and the frame is assigned to a different server.

**Wait for MAX to Render** Specifies the amount of time the manager waits between when a server reports that it has started and finished rendering a frame. If a server exceeds the specified value, it is flagged as "failed" by the manager, and no more frames from that job are sent to it.

**Wait for MAX to Unload** When a job is complete, the manager tells the server to unload 3ds Max, then waits for a reply from the server saying 3ds Max is down and it's ready for a new job. This spinner specifies the amount of time the Manager will wait for the Server to reply to this notification. If a server exceeds the specified value, it is flagged as "failed" by the manager, and no more frames are sent to it.

**Connection to Manager group**

Use this setting to specify the Manager for this job.

**TCP Port Number** Specifies the port number of the Manager to which this job is to report.

**Submit Job As radio button** Specifies which platform your scene is rendered on. Use this button when you want to render your scene on a different platform (either 32- or 64-bit) from the platform where you created your scene. This is particularly useful in situations where you are working on a given platform which differs from the platform of the render farm. The most consistent results are achieved when you submit jobs are created and rendered on the same platform.

**NOTE** This is an advanced option provided to accommodate specific render farm configurations. By default this option is set to the most compatible platform that avoids rendering to platforms where data-loss may result.

**Server Assignment Limit**

**Enable Limit** Sets the maximum number of servers that will be allocated for a specific job. This limit can be overridden with the Use Server Limit field in the Backburner Manager General Properties dialog, so that the administrator of a render farm can control job sharing globally.

**MAX server count** Specifies the number of servers.
Job Handling group

Enable Task Blocking Allows the job to override the task blocking set in the Manager. Some jobs will have their frames processed more efficiently if task blocking is turned off. Default=on.

Override Global Settings This switch lets you override job archiving settings made in the Backburner Manager General Properties dialog. It lets you set the archive settings for the job about to be submitted. When Override Global Settings is turned on, the After Job Is Successfully Completed options become active. Default=off.

NOTE Any setting made while Override Global Settings is turned on, remains active from one 3ds Max session to the next. For example, if you choose to leave jobs in the queue, submit the job and exit 3ds Max, the setting will be active when you choose to submit jobs in the future.

After job is successfully completed These options choose the archive settings when Override Global Settings is turned on.

■ Do Nothing Tells the network manager to leave the job in the queue without deleting it or archiving it.
You might use Do Nothing if you are submitting a job that might need to be re-rendered at a higher resolution without making any other changes to the scene.

■ Delete It Upon completion, the job is deleted from the queue.
If the scene you're network rendering is just a test shot and you're just doing a quick test of the scene, you don't really want to keep the job in the queue once it's completed. Before you submit the job, choose Delete It.

■ Delete After X day(s) Deletes the job after the specified number of days. Default=7.

■ Archive It Archives the job when the rendering is complete. Default=on.
Archiving is useful when you submit a final version of the scene and you know that there won't be any more changes to the scene. Before you submit the job, choose Archive It.

■ Archive After X day(s) Archives the job after the specified number of days. Default=4.

Defaults Returns all settings to their defaults.
Manager and Server

The topics in this section describe how to set up and use the network Manager and Server systems.

Initial Setup for Manager and Server Programs

The files necessary for network rendering are copied to the Backburner root directory when you install 3ds Max. Two of these files, manager.exe and server.exe, require initialization before they can be run. Set up the Manager program first, then the Server. When you're finished, you can start network rendering. After setup, you can run both Manager and Server as services by installing managervsc.exe and serversvc.exe, respectively.

You need to initialize only one machine as network Manager. This can be any machine on the network, and can be used on a machine running the Server, 3ds Max, or both.

You need to initialize every machine used as a rendering Server. This is done once to establish the connection between the rendering Server and the network Manager.

The Manager and Server programs can be run in application mode as explained in the procedures that follow, or as Windows 2000 or XP services, in which case they run in the background and provide less feedback on the progression of the rendering job. To learn more about installing these programs as services, see Installing Network Services on page 6976.

Initialization is done only once for each service. Each initialization process creates or updates the following:

- A subdirectory called \Network under the Backburner root directory, containing several further subdirectories, including \Jobs, \Servers, and \ServerJob. By default, the Backburner directory is called Backburner, and is found in the \Program Files\Autodesk\ directory.

- A file with initialization parameters (backburner.xml).

- A log file that keeps track of what the services do (backburner.log).
Next Step

Starting Network Rendering on page 6922

Procedures

To initialize the Manager program:

Run the Manager program from the Start menu > Programs > Autodesk > Backburner menu.

The first time you launch the Manager, it creates the backburner.xml file, which stores the manager configuration settings.

The Backburner Manager General Properties dialog also appears the first time you run Manager. In most cases, you can safely proceed by accepting the default settings and clicking OK. Thereafter, you can modify the configuration settings by choosing Edit menu > General Settings to open the General Properties dialog. For the new settings to take effect, you need to close the manager and restart it.

The settings in the General Properties dialog are described in depth in Backburner Manager General Properties Dialog on page 6985.

To initialize the Server program:

1. Run the Network Rendering Server program from the Start menu > Programs > Autodesk > Backburner menu.
   The first time you run Server, its General Properties dialog appears.

2. By default, the Subnet Mask field is set to 255.255.255.0 with the Automatic Search option turned on. In most cases, you should leave this option on. Backburner detects the machine acting as the manager.
   At this point, do not make any other changes in the Backburner Server General Properties dialog. Settings in the this dialog are described in detail in Backburner Server General Properties Dialog on page 6993.

3. Click OK on the Backburner Server General Properties dialog to save the current configuration.

4. The Server starts, and attempts to connect to a Manager automatically. If no Manager is found on the network, the Server times out and reports that the Manager is not responding.

Manager and Server | 6975
5 If the Server eventually fails to connect to the Manager:

- Check the subnet mask setting in your TCP/IP network configuration. If it is set to something other than 255.255.255.0, in the Server application, go to Edit menu > General Settings, in the dialog, set the subnet mask to match it and click OK. You will need to shut down the Server application and restart it for the changes to take effect.

- If you do not want the Server to connect automatically or the Server will not connect automatically to the Manager, go to Edit menu > General Settings and turn off Automatic Search. Click in the Manager Name Or IP Address field and enter the name or IP address of the workstation running Manager, and then click OK. You will need to shut down the Server application and restart it for the changes to take effect.

This updates the backburner.xml on page 6981 file, which now stores the Server configuration settings. The next time the Server is run, the application is launched and the configuration settings are used.

This completes Server initialization.

**Installing Network Services**

This topic describes how to install the network Manager and network Server as network services under Windows 2000 or XP.

Start by doing the following:

1. Run the Application versions of the Manager and Server to properly configure the applications and make your rendering network operational.

2. Use your network in production so you are sure it is running reliably. Do not proceed unless these conditions are met.

Installing the network Manager and rendering Servers as Windows 2000 or XP services allows background rendering and is convenient, but it also means that you have less information on the rendering server’s screen about problems when they occur. This is why your network needs to be running smoothly before taking this step. Running the Manager and Server as services does not change the information shown in the Queue Monitor.

In the procedures that follow, the Manager and Server services are installed and registered under Windows 2000 or XP. This installation replaces the use
of application mode (running the Manager and Server manually each time you want to use them). The services are started automatically every time you boot the computer, but can also be set for manual startup. The \Network subdirectory and initialization and LOG files from application mode remain in place, but the services operate under Windows 2000 or XP instead of in a separate process.

You can run the Manager and Server as services directly from a Command Prompt window or the Run dialog using the -i switch (install as a service). Then go to Services and start the Manager and/or Server, or reboot.

To remove the Manager or Server once it has been installed as a service, you must run 3ds Max directly from a Command Prompt window or the Run dialog using the -r switch (remove service).

See also:
- Creating a Special User Account on page 6944

Procedures

To set up the Manager as a service:

1. Go to the machine on which you will install the Manager as a service.
2. Open a Command Prompt window and change the directory to the Backburner root directory: for example, \Program Files\Autodesk\Backburner\.
3. Type managersvc -i
   The following message should be displayed:
   Backburner Manager ... Service Installed
4. Go to Windows Control Panel > Administrative Tools > Services, right-click Backburner Manager, and choose Start.
   If you choose Properties from the right-click menu, you can also set users, passwords, and other parameters.

To set up the Server as a service:

1. Go to the machine on which you will install the Server as a service.
2. Open a Command Prompt window and change the directory to the Backburner root directory.
3. Type serversvc -i
The following message should be displayed:
Backburner Server ... Service Installed

4 Go to Windows Control Panel > Administrative Tools > Services, right-click Backburner Server, and choose Start.
If you choose Properties from the right-click menu, you can also set users, passwords, and other parameters.

5 Repeat these steps on every machine on which you want to set up Server as a service.

Logging Properties Dialog

Windows Start menu > Programs > Autodesk > Backburner > Manager or Server > Edit menu > Log Settings
The Logging Properties dialog lets you specify the types of messages that appear in the list window on the Manager or Server window and those that are sent to a log file. Each type of log message is explained below.

Log Message Types

Error

Fatal errors that halt a server's rendering of a job. These errors are preceded by a red "ERR" in the Manager or Server list window, and include the following:

- Failed Renderings and Frame Errors (caused by missing bitmaps, missing texture coordinates, invalid output directory, etc.)
- Manager not found
- Error registering server(s)
- Error writing output file
- Error Starting 3ds Max
- Loading timeouts

NOTE You can see a more detailed explanation for server failure in the Queue Monitor's Server list window.
Warning

Non-fatal warning information. These errors are preceded by a brown "WRN" in the Manager or Server list window, and include the following:

■ Manager and/or Servers shutting down
■ Server(s) flagged as failed
■ Loading timeout set too low
■ Rendering timeout set too low

Info

General information about the current status of the Manager or Server. These errors are preceded by a aqua "INF" in the Manager or Server list window, and include the following:

■ Booting Network Manager/Server
■ Connection to Server(s)
■ Registration to Manager
■ Job Submitted
■ Job Received
■ Frame Complete

Debug and Debug Extended

Detailed information about TCP/IP packets and the current state of the Manager and Server. Debug Extended provides a more verbose listing than Debug. When in doubt, use both. These messages are preceded by a blue "DBG" in the Manager or Server list window, and include the following:

■ TCP/IP Packets sent and received
■ TCP/IP Packet collection
■ Command Line Arguments used to launch 3ds Max
■ Frames Assigned
■ Log files creation and sent
Interface

**Log To Screen group**

The Log To Screen options determine which types of messages are displayed in the list window of the Manager or Server window. Turn on each type of message that you want to be displayed. Error, Warning, and Info are on by default.

**Log To File group**

The Log To File options determine which messages saved to log files. These are the same messages that appear on the screen. Turn on any of the following categories to save it in a log file. When any one of these categories is turned on, a *manager.log* file or *server.log* file is created in your *\network* directory. Error, Warning, and Info are on by default.

**Buffer Limit** Specifies the maximum size of the buffer holding the messages.

**Clear Log** Clears the buffer holding the messages in the list window.
Clear Log File  Deletes the associated manager.log and/or server.log file.

**WARNING** Log files are cleared only when you click the Clear Log File button. When categories are enabled for either or both log files, the files will continue to grow in size each time you render.

**The backburner.xml File**

When you run the Manager, Server, or Queue Monitor application, or access the Network Job Assignment dialog, these programs create or update an initialization file named backburner.xml in the \Network subdirectory of the Backburner directory.

You can change most of the settings in the backburner.xml file using the Manager Properties dialog on page 6985 and Server Properties dialog on page 6993.

You can change the parameters listed here only by editing the XML file in a text editing application, such as Notepad. Do so only if you are experiencing network problems with the network renderer.

Make sure the Manager and Server applications are shut down (or services uninstalled) before editing the backburner.xml file. The changes will take place when the Manager and/or Server are restarted.

*backburner.xml*

- **MaxBlockSize**  Located under the <GeneralCfg> heading, this value is the maximum size of a data packet sent when transferring large blocks, such as projects. For slow connections like modems, it uses a smaller packet size, for example, 1024.

- **Acknowledgment Timeout**  Located under the <TimerCfg> heading as AckTimeout, this value is the amount of time (in seconds) that the system will wait for an acknowledgment of commands (like Ping) sent back and forth between the Manager and Server. Default=20 seconds.

- **Acknowledgment Retries**  Located under the <TimerCfg> heading as AckRetries, this value determines how many times the sender retries if no acknowledgment is received. The default is six tries. After that, the machine is considered down and is put off-line.
Network Rendering Manager

Windows Start menu > Programs > Autodesk > Backburner > Manager

The application version of the network rendering Manager provides a graphical user interface for control and monitoring purposes. It runs as a foreground process on your desktop, and remains active unless specifically shut down. Its components include a menu bar, list window, and status bar.

Once you initially set up the Manager using the application version, you can run it as a service from then on. The service version provides no user interface, but once it's installed as a service and started, it's always available when the system is booted. Whichever version you use, you can monitor and control the rendering queue and system with the Queue Monitor on page 6995.

To start the Manager service, execute the following from a Command Prompt window or the Start menu > Run function:

```
[drive letter]:\Program Files\Autodesk\Backburner\managersvc.exe -i
```

Replace "[drive letter]" with the letter of the drive Backburner is installed on. If you used a different install path, change the command line accordingly.

Then either reboot the computer or go to Control Panel > Administrative Tools > Services and start the service. Thereafter the service will remain resident and active, even surviving reboots.

**NOTE** When you run the Manager program, you might see this warning message: “Job share not defined.” This happens if neither the 3ds Max folder nor the drive on which it resides is shared on page 6949. Normally, the servers copy files to be network rendered from the source machine using standard Windows file-copy routines, which require sharing to be in effect. If sharing is not in effect, the manager issues the warning, and then the servers use TCP/IP to copy the files. To avoid getting the warning message, you can implement sharing, but it's not really necessary.

To remove the manager service from memory, execute the following from a Command Prompt window or the Start menu > Run function:

```
[drive letter]:\Program Files\Autodesk\Backburner\managersvc.exe -r
```
**TIP** You can run multiple Managers on the same network. This is especially useful when using many rendering Servers, to lessen the burden on individual Managers. When using multiple Managers, it is best to turn off Automatic Search on the rendering servers and specify a Manager to which to connect, otherwise the rendering servers will connect to the first Manager they find.

### Interface

#### Menu bar

The menu bar provides access to the functions available in the Network Rendering Manager application.

#### File menu

- **Close** Closes the window and minimizes the application to the taskbar tray. The application remains active when you close it with this menu item or the close box (X) in the upper-right corner.
- **Shutdown** Quits the application and removes it from memory.

#### Edit menu

- **General Settings** Opens the Backburner Manager General Properties dialog on page 6985.
- **Log Settings** Opens the Backburner Manager Logging Properties dialog on page 6978, which lets you filter the types of messages to appear in the list.
window, and specify whether the messages are sent to the list window or a log file.

**View menu**

**Status Bar** Toggles the display of the status bar, which appears at the bottom of the Server window. When on, a check mark appears next to this menu item. Default=on.

**Font Size** Lets you choose the size of text that appears in the list window. Choices range from Smallest to Largest.

**Autoscroll List** Toggles automatic scrolling of the list window. When on, new items that appear in the list window cause previous contents to scroll up. When off, you must scroll the window manually to see the latest entries after it fills up. Default=on.

**Help menu**

**About Manager** Displays information about the Manager program, including version and copyright.

**List Window**

This area of the Manager interface lists different types of information regarding the current status of the Manager. Depending on the selections made in the **Logging Properties dialog** on page 6978, messages are displayed alerting the user, for example, to the following:

- Connection and registration between the Manager and Server(s)
- New job assignments
- Which machine is the queue controller (that is, running Queue Monitor)
- Frames assigned/rendered
- Acknowledge packets sent between the Manager and Server(s)
- Manager/Server(s) shutting down
- Any rendering errors encountered

This information can be filtered using the **Logging Properties dialog** on page 6978.
Manager General Properties Dialog

Windows Start menu > Programs > Autodesk > Backburner > Manager > Edit menu > General Settings > General Properties dialog

The Manager Properties dialog contains the configuration settings for the Network Manager. The default settings should work in most cases, but certain situations may require adjustments. The information specified in the Manager Properties dialog is written to and contained in `backburner.xml` (in the `\Network` subdirectory). If you run the Manager and the `backburner.xml` file does not exist, you're prompted to configure it with this dialog. When configuration is complete, click OK to run the Manager.
Interface

TCP/IP group

The two spinners in the TCP/IP group box specify the port numbers to be used by the Manager and Servers. These numbers must be unique, but every Server must have the same number.

Manager Port Specifies the port number used by the network Manager.

Server Port Specifies the port number used by the network Server(s).
NOTE Port numbers are like extensions for different users of the same phone number. They represent two channels of communication between the Server and the Manager. Only a trained network administrator should change these settings.

**General group**

**Max(imum) Concurrent Assignments** Specifies the number of jobs the Manager sends out at once. This number is dependent upon the speed of the processor on the Manager machine, the size of the jobs being sent out, and the speed of the network system. Generally, a default value of 4 is adequate. You may want to decrease the value in case the jobs are huge and you have a modest setup. Similarly, you may want to increase this value if you have a high-end setup and the jobs are small. Be aware that too high a value may result in an increased number of timeouts because the jobs are sent faster than the Servers can handle them. In such a case, decrease the value or leave it at the default.

**User Server Limit** Sets the maximum number of servers that will be allocated for a specific job. This feature overrides the server limit settings in the 3ds Max Advanced Settings Dialog on page 6970.

**Task Error Limit** Defines the number of times a server will retry a task before suspending the task. This option is available only in the Manager General Properties dialog.

**Failed Servers group**

This option allows the Manager to automatically restart Servers that have failed jobs.

**Restart Failed Servers** Activate to enable automatic Server restarting. If this option is turned off, the Server will not attempt to render the job again after the first failure. Default=on.

**Number of Retries** Specifies the number of times the Manager attempts to restart a failed Server. Default=3. Range=1 to 1024.

**Seconds Between Retries** The time, in seconds, between each retry. Default=30.
NOTE The state of a Server is kept on a per-job basis. If Restarts Failed Servers is turned on, the Manager keeps track of when a Server fails a particular job. The Manager regularly goes through the list of Servers for that job, checking for failures. If one is found, the Manager checks how long it has been since it failed. If the time elapsed is greater than the specified Seconds Between Retries, the Manager decreases the Number of Retries by one and resets the failed flag from the Server.

If a Server fails repeatedly on a specific job (failures are monitored on a per-job basis), the failure count reaches the specified Number of Retries, and the Manager stops trying to restart that Server for that particular job. If, on the other hand, a Server restarts and completes a frame, it is flagged as active and resumes rendering until the job is complete.

Direct Access To Jobs Path group

Job paths can be useful when dealing with situations where it’s not conducive to have jobs placed on the manager system. Such situations might be as follows:

- You have a lack of drive space on the C: drive where Backburner is installed. Drive D: has plenty of space so you set up a folder called MyJobs where jobs will be placed when submitted. Enter a UNC path such as \machinename\MyJobs.

- You’re running a large render farm that causes a lot of network traffic on the manager system that you use concurrently to build models. To alleviate the traffic, you set up a shared job folder, backburnerJobs for example, on a file server that is separate from the manager system. The UNC job path would be set to \fileserver\backburnerJobs and jobs you submit will be placed on the file server.

Use Jobs Path Turning on this switch allows you to define the location of jobs to be somewhere other than on the manager machine. This tells the render servers to get the job files from the new location, therefore minimizing the file I/O traffic on the manager.

Win32 Path Enter the path where jobs are located into this field or click the Browse button to the right to search your system for the job location.

Unix Path This field functions the same as the Win32 path except you can enter a Unix path structure.
Default Job Handling group

The settings in the Default Job Handling group allow a user to archive a completed job to a specified location after $x$ number of days, delete a completed job after $x$ number of days or just leave the job indefinitely in the queue.

Using these controls lets you maintain the job queue, clearing completed jobs that can cause excess overhead and stress to the manager system, thus instigating performance problems. The archiving functionality allows you to automatically store files used for completed jobs.

**NOTE**  These settings can be overridden from the Advanced Settings dialog on page 6970 accessed from the Network Job Assignment dialog on page 6953.

**Do Nothing** When turned on, a completed job is left in the queue.

Use this switch if you are submitting a job that may need to be re-rendered at a higher resolution without making any other changes to the scene.

**Delete It** Upon completion, the job is deleted from the queue when this switch is turned on.

If the scene you’re rendering is just a test shot and you’re just doing a quick test of the scene, you don’t really want to keep the job in the queue once it’s completed.

**Delete After ... Day(s)** Upon completion, the job is kept in the queue for the specified number of days. Once the number of days are exceeded, the job is then deleted from the queue.

**Archive It** When turned on, the job is archived when the rendering is complete. Default=on.

Archiving is useful when you submit a final version of the scene and you know that there won’t be any further changes.

**Archive After ... Day(s)** Upon completion, the job is kept in the queue for the specified number of days. Once the number of days are exceeded, the job is archived.

**Network Rendering Server**

Windows Start menu > Programs > Autodesk > Backburner > Server

The application version of the network rendering Server provides a graphical user interface for control and monitoring purposes. It runs as a foreground
process on your desktop, and remains active unless specifically shut down. Its components include a menu bar, list window, and status bar.

Once you initially set up the server using the application version, you can run it as a service from then on. The service version provides no user interface, but once it's installed as a service and started, it's always available when you boot the system. Whichever version you use, you can monitor and control the rendering queue and system with the Queue Monitor on page 6995.

To start the server service, execute the following from a Command Prompt window or the Start menu > Run function:

```
[drive letter]:\Program Files\Autodesk\Backburner\serversvc.exe
```

Replace "[drive letter]" with the letter of the drive Backburner is installed on. If you used a different install path, change the command line accordingly.

Then either reboot the computer or go to Control Panel > Administrative Tools > Services and start the service. Thereafter the service will remain resident and active, even surviving reboots.

---

**NOTE** In order for the rendering servers to be able to save the frames to the specified location, set the logon for the installed service to a user name and password that exists on the network. Also, that user name must have sufficient read/write permissions to get the required bitmaps and xrefs for the scene to render as well as write the frames to specified location.

To remove the server service from memory, execute the following from a Command Prompt window or the Start menu > Run function:

```
[drive letter]:\Program Files\Autodesk\Backburner\serversvc.exe
```

**Procedures**

**To start/stop the server service upon logoff/logon:**

If you work on a computer that's part of a render farm, you probably don't want the computer to be available for rendering while you're using it. By following this procedure, you can have the computer automatically turn off the server service while you're logged on, and turn it back on when you log off.

1. Install the Backburner Server as a service that starts automatically at startup, as described above. This is the default setup for the server service. You'll start by creating two batch files.

2. Open a text editor such as Notepad and enter the following line:
3 Save this as a text file named **Netstart_BB_Server.bat**.

4 Create a new file containing the following line:
   ```
   net stop backburner_srv_200
   ```

5 Save this as a text file named **Netstop_BB_Server.bat**.
   Next, you'll to edit the logon and logoff policy for the system.

6 Go to the Windows Start menu, choose the Run command, and enter `gpedit.msc`.
   The Group Policy dialog appears. It lets you edit and manage the Group Policy for the system.

7 In the dialog, expand User Configuration > Windows Settings, and then click Scripts (Logon/Logoff).
   The right-hand pane lists Logon and Logoff.

8 In the right pane, right-click Logon and choose Properties.

9 In the Properties dialog, click Add, click Browse, and browse to the `Netstop_BB_Server.bat` file you created. Click OK twice to close the Logon Properties dialog.

10 Similarly, open the Properties dialog for Logoff and specify the `Netstart_BB_Server.bat` file.

11 Close the Group Policy dialog.
   You have now set up the system to stop the Backburner service at any user logon, and to start it at any user logoff.
Interface

Menu bar

The menu bar provides access to the functions available in the Network Rendering Server application.

File menu

Close Closes the window and minimizes the application to the taskbar tray. The application remains active when you close it with this menu item or the close box (X) in the upper-right corner.

Shutdown Quits the application and removes it from memory.

Edit menu

General Settings Opens the Network Server General Properties dialog on page 6993.

Log Settings Opens the Network Server Logging Properties dialog on page 6978, which lets you filter the types of messages to appear in the list window, and specify whether the messages will be sent to the list window, a log file, or both.
**View menu**

**Status Bar** Toggles the display of the status bar, which appears at the bottom of the Server window. When on, a check mark appears next to this menu item. Default=on.

**Font Size** Lets you choose the size of text that appears in the list window. Choices range from Smallest to Largest.

**Autoscroll List** Toggles automatic scrolling of the list window. When on, new items that appear in the list window cause previous contents to scroll up. When off, you must scroll the window manually to see the latest entries after it fills up. Default=on.

**Help menu**

**About Server** Displays information about the Server program, including version and copyright.

**List Window**

This area of the Server interface lists different types of information regarding the current status of Server. Depending on the selections made in the [Logging Properties dialog](#) on page 6978, messages are displayed alerting the user, for example, to the following:

- Connection and registration between the Manager and Server(s)
- New job assignments
- Frames assigned/rendered
- Acknowledge packets sent between the Manager and Server(s)
- Manager/Server(s) shutting down
- Any rendering errors encountered
  This information can be filtered using the [Logging Properties dialog](#) on page 6978.

**Server General Properties Dialog**

Windows Start menu > Programs > Autodesk > Backburner > Server > Edit menu > General Settings > General Properties dialog
The Server General Properties dialog contains configuration settings for the Network Rendering Servers. The default settings in this dialog work in most cases, but certain situations may require adjustment of these settings, mostly the Manager or IP settings in case the Automatic detection fails. The information specified in the Server Properties dialog is contained in the backburner.xml file (in the \Network subdirectory). If you run Server and the backburner.xml file does not exist or does not contain information pertinent to the Server, the backburner.xml file is created or updated.

Interface

TCP/IP group

Manager Port Specifies the port number used by the Network Manager.

Server Port Specifies the port number used by the Network Server(s).

These settings specify the port number to be used by TCP/IP. These numbers must be unique, but every Server must have the same number.

NOTE Port numbers are like extensions for different users of the same phone number. They represent two channels of communication between the Server and the Manager. Only a trained network administrator should change these settings.

Automatic Search When on, starting the Server searches for a Manager using the default subnet mask of 255.255.255.0. In most cases, you should leave
this option on. The Server will detect the machine acting as a Manager. The Server may fail to detect a Manager if the network subnet mask (in the Windows TCP/IP Network Configuration dialog) is set to some other value than the standard 255.255.255.0.

If that is the case, change the subnet mask setting in the Server General Properties dialog to match the system setting. Start the Server again and it should detect the Manager. When multiple Managers are running on the same network, you may want to turn off Automatic Search and specify which Manager the Server should connect to. Otherwise, the Server connects to the first Manager it finds.

**Enter Subnet Mask/Manager Name or IP Address** With Automatic Search turned on, specifies the subnet mask used to search for the Manager. With Automatic Search turned off, specifies the IP address or DNS name of the Manager to which to connect. Use the Manager system's name or IP address when multiple Managers are running on the same subnet. Use the Manager system's IP address to avoid any problems or conflicts caused by improper implementation of the Domain Name System.

### The Queue Monitor Application

Windows Start menu > Programs > Autodesk > Backburner > Monitor

The Queue Monitor application (*monitor.exe*) lets you manage, view, and receive status updates about all jobs currently submitted to the network rendering queue. This executable file is copied to the Backburner root directory during setup, and is available from the Start menu.

**NOTE** In previous versions of 3ds Max, this program was called Queue Manager.

Queue Monitor helps you adapt to changing needs and priorities. Jobs can be activated, deactivated, reordered, and removed, and servers can be unassigned to free up resources on workstations, or brought back online as they become available again.

You can run Queue Monitor from any computer connected to the rendering network. Once started, you can connect to any available network Manager. You can launch as many Queue Monitors as you want from anywhere on your network and connect to a Manager machine. All except the first Queue Monitor connecting to the Manager appear in "read only" mode. If there is already a Queue Monitor connected to the Manager, subsequent connections alert you that you are in read-only mode, and "Read Only" appears in the title bar.
read-only mode, you can view network render activity, but cannot change anything in the queue unless you obtain queue control on page 6999.

To view all current jobs in the rendering queue, you first connect to the Manager that all of the servers are “talking to.” To do this, you can either connect automatically to the Manager by searching with a subnet mask, or connect to a specific Manager by supplying the IP address or machine name of the machine where you started the Manager.

See also:
- Viewing Jobs and Servers with the Queue Monitor on page 7013
- Activating and Deactivating Jobs in the Queue on page 7017
- Activating and Deactivating Servers in the Queue on page 7018
- Managing Jobs in the Queue on page 7019

Procedures

To view all current jobs in the rendering queue:

1. On the Queue Monitor toolbar, click the Connect button.
   The Connect To Manager dialog appears.

2. After you connect to a Manager once, the dialog remembers the Manager information and you can just click OK to connect to the same Manager. If this is the first time you're connecting, or you're connecting to a different Manager, and you're using Automatic Search, just click OK. If you're not using Automatic Search, you need to specify the Manager to connect to. In the text field, enter the name or IP address of a network Manager. This is the same information you specified in the Server General Properties dialog on page 6993.

3. Click OK.
   The Queue Monitor connects to the network Manager and activates its various display windows.
To suspend a job:

As requirements change, you can temporarily deactivate an active or pending job in the rendering queue, or reverse the process and restart jobs that are inactive.

When you suspend a job, the Servers assigned to the job either drop the frame they are rendering or finish writing the frame, depending on where they are in the rendering process. The next pending job becomes active and begins to render.

**NOTE** You can activate or deactivate multiple jobs at the same time.

1. Select one or more active or pending jobs in the Job list.
2. Do one of the following:
   - Click the Suspend button on the toolbar.
   - Choose Suspend from the Jobs menu.
   - Right-click a highlighted job name in the Job list to display a pop-up menu, and then choose Suspend.

   If necessary, use Refresh to view the new queue status.

To activate a suspended job:

1. Select the suspended job (denoted by a gray movie-frame icon).
   - The Activate button on the toolbar becomes active.
2. Click Activate, or use the menu bar or right-click menu.
   - The job becomes either Started or pending in the queue (Active), depending on whether or not another job is currently rendering.
Interface

The Queue Monitor user interface comprises a menu bar, a toolbar, a status display, and four windows: job list, job information, server tree view (or hierarchical list), and server list.

Menu bar

The menu bar includes these menus and functions:

Manager menu

Use to control aspects of the Queue Monitor and the network Manager.

Connect Connects to a Manager using the Connect To Manager dialog. In the dialog, turn on Auto Search to search for a Manager using the specified subnet mask, or turn off Auto Search to search for a Manager using a specific Manager name or IP address. Click OK to perform the search, or Cancel to exit without connecting.

If the Manager is found, current Servers and jobs appear in their respective lists in the Queue Monitor. If the Manager cannot be found, an alert appears.

Disconnect Disconnects from the current Manager. Available only after a connection is made.
Auto-Connect When this switch is turned on, you can automatically connect to a manager without the Connect To Manager dialog appearing. Whatever setting have been made in the Connect To Manager dialog will be used.

Request Queue Control Lets you gain control over the rendering queue. Available only when Queue Monitor is running on two or more machines in the network, and your copy was not the first one run.

When you request queue control, a dialog appears on the controlling machine informing that user of the request. The dialog counts down 10 seconds, and if no response is made during that time, or the OK button is clicked, control transfers to the requesting Queue Monitor, which then informs the requestor of the transfer. If the request is denied, the requesting user is informed of that fact.

Request Client List Displays a dialog listing the rendering servers on the network, and showing which is the controller (i.e., the active Queue Monitor) and the user name. Use this to determine which server is currently controlling the queue.

Auto-Refresh When on, Queue Monitor automatically updates the information in its windows every 20 seconds, or whenever information changes if information changes less frequently. When off, to update the windows you must click the toolbar Refresh button on page 7002. Default=on.

Unless you are the only person managing the queue, we recommend leaving Auto-Refresh on. The danger of turning it off is the possibility of getting out of sync with the state of the queue. For instance, if another person deletes a job and you decide to edit that job, when you finish editing that job, the Manager will send you an error message saying the job no longer exists.

Module Info Report Choosing this command opens the Module Info Report dialog on page 7006. For troubleshooting purposes, this command lets you generate a delimited file that shows you the version and location of Backburner plug-ins and the Backburner application itself for each network rendering system.

Properties Opens a window that displays information about the current setup of the machine that is running the network Manager, including job and server statistics, the Manager's system configuration, and TCP/IP statistics.

Exit Quits the Queue Monitor program.
Jobs menu

Use to obtain information about rendering jobs. Most Jobs menu functions are available only when at least one job is highlighted in the Job list, and many require that only one job be highlighted.

These commands are also available by right-clicking a job in the job list.

Edit Settings Opens the Job Settings dialog on page 7008, with settings for job-related functions such as frame range and output size.

Change Priority Opens the Change Job Priority dialog, which lets you set a new priority or set the job to be critical.

If you change a job’s priority so that a different job moves to the beginning of the list, the Queue Monitor pauses the current job and begins rendering the newly elevated job.

Clone Job Makes an identical copy of the highlighted job and adds it to the end of the list.

Dependencies Opens the Job Dependencies dialog on page 6963, which you can use to specify existing jobs that must finish before the current job can start.

Report Opens the Job Report dialog on page 7014 for generating text files containing job reports.

Column Chooser Opens the Job Columns dialog, with additional columns you can drag into the Job list title row. As you drag a column over the title row, arrows appear indicating where the column will be inserted.

To remove a column, right-click its title and then choose Remove This Column. You cannot remove the Job or Order column.

Activate Starts a suspended job or jobs.

Suspend Pauses an active job or jobs.

Restart Job Starts a job over at the first frame set in Job Settings.

Archive Job Archives a job currently stored in the queue. Archived jobs are removed from the Job queue and stored in the Job Archives.

Job Archives Accesses the Job Archives where jobs are stored after clicking the Archive Jobs command or if they’re assigned to automatically archive upon completion. Choosing this command opens the Job Archive dialog on page 7016 where you can choose to Delete, Activate or Refresh jobs.

Delete Removes the highlighted job or jobs from the queue.
Servers menu

Use to control and obtain information about job servers.

These commands are also available by right-clicking a server in the server list.

Assign to Selected Jobs Assigns the highlighted servers or servers to the highlighted job or jobs.

Remove from Selected Jobs Removes the highlighted job or jobs from the highlighted servers or servers.

Remove from Selected Group Removes the highlighted server or servers from the highlighted group in the tree view.

Column Chooser Opens the Server Columns dialog, with additional columns you can drag into the Server list title row. As you drag a column over the title row, arrows appear indicating where the column will be inserted.

To remove a column, right-click its title and then choose Remove This Column.

You cannot remove the Job or the Order column.

Week Schedule Opens the Week Schedule dialog on page 7020 for the highlighted server, for defining when the server is available to render jobs.

Delete Server Lets you remove the current server from the server list, making it unavailable for rendering jobs.

Properties Opens a window that displays information about the current setup of the machine that is running the network Manager, including job and server statistics, the Manager's system configuration, and TCP/IP statistics.

Reset Server Index Lets you set the Performance parameter back to 0. Use this if you've changed the server setup (for instance, you've added memory or substituted a faster machine) and want to reevaluate the servers' relative performance during a rendering job.

View menu

Toolbar Toggles display of the Queue Monitor toolbar.

Status Bar Toggles display of the Queue Monitor status bar. When on, the status bar appears at the bottom of the Queue Monitor window and displays status prompts on page 7006.

Save View... Saves the current window view with column and filter settings.

Load View... Loads a saved view.
Help menu

About Queue Monitor Displays information about the Queue Monitor program, including version and copyright.

Toolbar

Contains buttons for performing various common Queue Monitor functions.

Connect See Connect on page 6998.

Disconnect See Disconnect on page 6998.

Refresh Forces the Queue Monitor to update the information shown in its windows.
The Queue Monitor automatically refreshes the windows every 10 seconds when information is changing.

Delete Removes the highlighted job or jobs from the queue.

Activate Starts a suspended job or jobs.

Suspend Pauses an active job or jobs.

Assign Server Assigns the highlighted servers or servers to the highlighted job or jobs.

Remove Server Removes the highlighted job or jobs from the highlighted servers or servers.
Job List

The Job List window lists all current jobs, along with progress and status. Additionally, a status icon before each job's name provides a graphical indication of its status. See Viewing Jobs and Servers with the Queue Monitor on page 7013.

Right-click a job name to access the Jobs menu on page 7000.

Click a column title to sort the list by the column contents (alternating clicks sort in ascending and descending order). Right-click a column title to access a menu that lets you sort the column, specify its alignment, remove the column (if it's optional), access the Column Chooser for adding optional columns, and display only the default columns.

Job Information Window

The Job Information window contains tabs for viewing information about different aspects of a single highlighted job in the Job List window. If no job is highlighted or multiple jobs are highlighted, this window is blank.

You can sort and filter columns in the Job Information Window. Click in the column you wish to filter and select the Column Filter options.

Job Summary  Lists important job-related information, including Job Options settings and Output settings.

Task Summary  Lists frames in the job (under “Task ID”), along with each frame's status, rendering time, rendering server, and date and time of assignment.

Right-click the frame you wish to view under “Task ID” to view its output file. This is available only for completed tasks.
Job Details Lists the job's rendering parameters, scene statistics, and gamma settings.

Errors Lists each frame for which an error occurred, which server registered the error, and a description of the error, including missing maps, missing texture coordinates, and invalid output directories.

Server Tree View

This window presents a hierarchical list of all Server groups, lets you create, delete, and rename global and local Server groups, and see which Servers can render your job.

Server groups are logical combinations of Servers that you can use to easily assign specific Servers to render a job. Global groups are available to all machines in the rendering network, while local groups are available only on the computer on which they are created. To create a global or local Server group, right-click any item in the Server Tree view, and choose Create Global Group or Create Local Group. After you choose either command, the new group appears in its respective category with the name New Global/Local Group; at this point, you can rename it by typing a new name.

After you define a group, its name shows up as a tab in the Server list in the Network Job Assignment dialog on page 6953. Only global groups appear on machines other than the one on which they're created.

To remove a Server group, right-click its name in the Server Tree view and choose Delete Group. To rename a Server group, right-click its name in the Server Tree view, choose Rename Group, and then enter a new name.

Following is a list of default list entries in the view. Click the item for the described result.

All Servers Shows all Servers assigned to the current manager.

Global Groups Click the + icon next to this entry, if it exists, to display global Server groups. To see the Servers in a global group, click the group name.

Local Groups Click the + icon next to this entry, if it exists, to display local Server groups. To see the Servers in a local group, click the group name.

Plugins Shows which applications can be controlled with the render network. Click the + icon next to this entry, if it exists, to display applications available on the render network. To see the Servers that have a particular rendering application installed, click the renderer name.
Server List

The Server List window shows all Servers in the current group (selected in the Server Tree view). For each listed server, the window displays, by default, its status, the job it's currently rendering (if any), and the last message it sent to the Manager. Additional, optional details can be shown using the Column Chooser command.

Click a column title to sort the list by the column contents (alternating clicks sort in ascending and descending order). Right-click a column title to access a menu that lets you sort the column, specify its alignment, remove the column (if it's optional), access the Column Chooser for adding optional columns, and display only the default columns.

You can sort and filter columns in the Server List Window. Click in the column you wish to filter and select the Column Filter options.

A status icon before each server's name provides a graphical indication of its status. See Viewing Jobs and Servers with the Queue Monitor on page 7013.

Right-click a server name to access the Servers menu on page 7001.
Visible at the bottom of the Queue Monitor window, the status prompt provides a non-interactive display of activity in the Queue Monitor and provides help information on the command over which the mouse cursor is positioned.

**Module Info Report Dialog**

Windows Start menu > Programs > Autodesk > Backburner > Monitor > Highlight a job. > Jobs menu > Report  
You can generate delimited ASCII reports containing detailed statistics about the version and location of Backburner plug-ins and the Backburner application itself for each network rendering system.
Interface

Header group

Specifies the type of header to include in the report file, in addition to the body information.

Long Adds a heading to the report.
Short Includes only the column titles in the report.

Record Delimitation group

Specifies the type of delimiter used between the fields. For example, if you use a tab delimiter, the report will import correctly into Microsoft's Excel or Access applications.

Tab Inserts a tab between fields in the report.
Space Inserts a space between fields in the report.
Comma Inserts a comma between fields in the report.
Use Quotes Brackets each field with double quotes.

Output File group

(Text Field) Specifies the report's file name. You can specify a complete path, if you want. By default, the path is the directory containing the monitor.exe file.
TIP If you use a shortcut icon to launch Queue Monitor, you can specify the path for your report’s output file in the Start In field in the Properties dialog for the shortcut.

Browse Displays a file selector where you can specify a file path for the report.

Queue Monitor: Job Settings Dialog

Windows Start menu > Programs > Autodesk > Backburner > Monitor > Highlight a job. > Jobs menu > Edit Settings

Windows Start menu > Programs > Autodesk > Backburner > Monitor > Highlight a job. > right-click menu > Edit Settings

NOTE This topic covers the 3ds Max-specific aspects of the Queue Monitor on page 6995.

Use the Job Settings dialog to change job-related settings such as frame range, output size, and output directory, without having to use the Render Setup dialog and resubmit the job.

You can change job settings for a job while it's suspended or while it's rendering. By default in either case, after you click OK to exit the dialog, the rendering job restarts from the first frame. You can turn this feature off with the Restart Job option.

Most settings are either toggle switches or editable from the keyboard. To change a toggle setting, double-click its entry (in the right-hand column). If a setting is editable, its value turns green when you click it. To change an editable setting, click it to get the keyboard cursor, and then enter a new value from the keyboard. If you double-click the value when it's green, it highlights, and anything you type replaces it.

NOTE Your machine must have control of the network for this Job Settings Dialog to be accessible.
# Interface

The Queue Monitor Application |

<table>
<thead>
<tr>
<th>Interface Settings</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Job Name</td>
<td></td>
</tr>
<tr>
<td>Job Description</td>
<td></td>
</tr>
<tr>
<td>Render Job</td>
<td>Yes</td>
</tr>
<tr>
<td>Override Global Blocking Tasks</td>
<td>Yes</td>
</tr>
<tr>
<td>Enable Docking Tasks</td>
<td>Yes</td>
</tr>
<tr>
<td>User-Defined Variables</td>
<td>Yes</td>
</tr>
<tr>
<td>Server Limit</td>
<td>0</td>
</tr>
<tr>
<td>Site area: Internal Settings</td>
<td></td>
</tr>
<tr>
<td>Frame Sequence Range</td>
<td></td>
</tr>
<tr>
<td>First Frame</td>
<td></td>
</tr>
<tr>
<td>Last Frame</td>
<td></td>
</tr>
<tr>
<td>Entry MB</td>
<td>1</td>
</tr>
<tr>
<td>Frames</td>
<td></td>
</tr>
<tr>
<td>Vertical</td>
<td>Yes</td>
</tr>
<tr>
<td>Height</td>
<td>480</td>
</tr>
<tr>
<td>Render Options</td>
<td></td>
</tr>
<tr>
<td>Show Starting Prefix</td>
<td>No</td>
</tr>
<tr>
<td>Display Name</td>
<td>Yes</td>
</tr>
<tr>
<td>View Correction</td>
<td>Disabled</td>
</tr>
<tr>
<td>Mode Center</td>
<td>0.0000</td>
</tr>
<tr>
<td>Output Center</td>
<td>0.0000</td>
</tr>
<tr>
<td>Post-Process File</td>
<td>0.0000</td>
</tr>
<tr>
<td>Render Elements</td>
<td>Enabled</td>
</tr>
<tr>
<td>Video Color Enabled</td>
<td>No</td>
</tr>
<tr>
<td>Text Color</td>
<td>No</td>
</tr>
<tr>
<td>Render Hidden</td>
<td>No</td>
</tr>
<tr>
<td>Render Aliases</td>
<td>Yes</td>
</tr>
<tr>
<td>Super MB</td>
<td>No</td>
</tr>
<tr>
<td>Other MB</td>
<td>Yes</td>
</tr>
<tr>
<td>Other Text Color</td>
<td>Yes</td>
</tr>
<tr>
<td>Display Effects</td>
<td>Yes</td>
</tr>
<tr>
<td>Scene Effects</td>
<td>Yes</td>
</tr>
<tr>
<td>Ambient Lighting</td>
<td>Yes</td>
</tr>
<tr>
<td>Use Area Lighting</td>
<td>Yes</td>
</tr>
<tr>
<td>Use Advanced Lighting</td>
<td>Yes</td>
</tr>
<tr>
<td>Compute Advanced Lighting</td>
<td>No</td>
</tr>
<tr>
<td>Field Order</td>
<td>Osl</td>
</tr>
<tr>
<td>Outputs</td>
<td></td>
</tr>
<tr>
<td>Output Path</td>
<td>0</td>
</tr>
<tr>
<td>Output Dir</td>
<td>0.0000</td>
</tr>
<tr>
<td>Render Elements</td>
<td></td>
</tr>
<tr>
<td>Shadowing</td>
<td></td>
</tr>
<tr>
<td>Render T Transparency</td>
<td></td>
</tr>
<tr>
<td>Render T Interpolation</td>
<td>Enabled</td>
</tr>
<tr>
<td>Render T Transparency</td>
<td>Enabled</td>
</tr>
<tr>
<td>Render T Shadows</td>
<td>Not Applied</td>
</tr>
<tr>
<td>Render Elements</td>
<td></td>
</tr>
<tr>
<td>Element T Transparency</td>
<td></td>
</tr>
<tr>
<td>Render T Interpolation</td>
<td>Enabled</td>
</tr>
<tr>
<td>Render T Shadows</td>
<td>Not Applied</td>
</tr>
<tr>
<td>Alternate Paths</td>
<td></td>
</tr>
<tr>
<td>Alternate Depth Path</td>
<td></td>
</tr>
<tr>
<td>Alternate Front Path</td>
<td></td>
</tr>
<tr>
<td>Timers</td>
<td></td>
</tr>
<tr>
<td>Wait to Load</td>
<td>20</td>
</tr>
<tr>
<td>Wait to Unload</td>
<td>30</td>
</tr>
<tr>
<td>Wait to Render</td>
<td>30</td>
</tr>
<tr>
<td>Notification</td>
<td></td>
</tr>
<tr>
<td>Enable Notifications</td>
<td>No</td>
</tr>
<tr>
<td>Notify Failed</td>
<td>Yes</td>
</tr>
<tr>
<td>Notify Progress</td>
<td>Yes</td>
</tr>
<tr>
<td>Notify Completion</td>
<td>Yes</td>
</tr>
<tr>
<td>Notify Progress</td>
<td>No</td>
</tr>
<tr>
<td>Notify Failed</td>
<td>No</td>
</tr>
<tr>
<td>Notify Completion</td>
<td>No</td>
</tr>
<tr>
<td>Alert Threshold</td>
<td>10</td>
</tr>
<tr>
<td>Alert Deactivate</td>
<td>Yes</td>
</tr>
<tr>
<td>Alert Event Type</td>
<td></td>
</tr>
</tbody>
</table>
Job Name group

The job name cannot be changed from this dialog.

Job Description Displays a brief description of the job. Editable from keyboard.

Restart Job When on (Yes), changing one or more job settings in the middle of a rendering job causes the job to restart at the first frame in the range, so all frames are rendered with the same settings. When off (No), the job continues rendering without restarting. Toggled by double-clicking the entry. Default=No.

You might want to turn this off if you're rendering an animation test and change a relatively minor setting, such as Video Color Check, in the middle of a job. For final renderings, you should always restart a job from the beginning after changing job settings.

Override Global Blocking Tasks This setting corresponds with the Override Global Settings as set in the Advanced Setting dialog on page 6970. Default=Yes.

Enable Blocking Tasks A Yes/No toggle that controls task blocking as set in the Advanced Setting dialog. When set to Yes, the task blocking set in the Manager General Properties dialog is active. Toggled by double-clicking the entry. Default=Yes.

Use All Available Servers Uses all servers in the active Server group for rendering the job.

[program name] General Settings group

Frame Sequence This toggle setting alternates between Frames and Range, and, by default, uses the Range and Frames settings in the Render Setup dialog on page 6506. When set to Range, the job uses the First/Last Frame and Every Nth settings; when set to Frames, the job uses the Frames setting. Toggled by double-clicking the entry. Default=Range.

First Frame Displays the first frame in the range to be rendered. Defaults to the first frame as submitted. Editable from keyboard.

Last Frame Displays the last frame in the range to be rendered. Defaults to the last frame as submitted. Editable from keyboard.

Every Nth Regular sample of frames. For example, enter 8 to render every 8th frame. Editable from keyboard.

Frames Non-sequential frames separated by commas (for example, 2,5) or ranges of frames separated by hyphens (for example, 0-5). Editable from keyboard.
**Width/Height** Lets you set the resolution of the output image by specifying the width and the height of the image, in pixels. Defaults to the output size as submitted. Editable from keyboard.

**Render Options group**

These settings are the same as those found on the Render Setup dialog > Options group on page 6574, with several additions:

**Skip Existing Frames** When on, the Queue Monitor checks the output path for existing rendered frames, and doesn't render them again. When off, starting or restarting a job always begins rendering with the first frame, overwriting any existing frames. Toggled by double-clicking the entry. Default=No.

**Display RFW** Displays the Rendered Frame Window on all servers during rendering. Toggled by double-clicking the entry. Default=Yes.

**Gamma Correction** When enabled, lets you defines a new gamma for the bitmap, using the Input/Output Gamma settings. Toggled by double-clicking the entry. Default=Disabled.

**Input/Output Gamma** Change system input and output gamma settings for processing bitmaps. See Gamma Preferences Settings on page 8330 > Bitmap Files group. Editable from keyboard.

**Pixel Aspect Ratio** Sets the shape of the pixels for display on another device. The image may look squashed on your display but will display correctly on the device with differently shaped pixels. Editable from keyboard.

**Render Elements** When enabled, renders any render elements on page 6818 in the scene. Toggled by double-clicking the entry. Default=Enabled.

**Video Color Check** Checks for pixel colors that are beyond the safe NTSC or PAL threshold. Toggled by double-clicking the entry. Default=No.

**Two Sided** 2-Sided rendering renders both sides of all faces. Toggled by double-clicking the entry. Default=No.

**Render Hidden** Renders all geometric objects in the scene, even if they are hidden. Toggled by double-clicking the entry. Default=No.

**Render Atmosphere** Renders any applied atmospheric effects, such as volume fog, when set to Yes. Toggled by double-clicking the entry. Default=Yes.

**Super Black** Limits the darkness of rendered geometry for video compositing. Toggled by double-clicking the entry. Default=No.
**Dither 256** Intersperses pixels when rendering to an eight-bit image format for a greater apparent color range. Toggled by double-clicking the entry. Default=Yes.

**Dither True Color** Intersperses pixels when rendering to a 24-bit (or higher) image format for a greater apparent color range. Toggled by double-clicking the entry. Default=Yes.

**Render Fields** Renders to video fields rather than frames when creating animations for video. Toggled by double-clicking the entry. Default=No.

**Displacements** Any displacement mapping is rendered. Toggled by double-clicking the entry. Default=Yes.

**Scene Effects** Any applied rendering effects, such as Blur, are rendered when turned set to Yes. Toggled by double-clicking the entry. Default=Yes.

**Multithread** Causes the Queue Monitor to treat the rendering task as separate threads. This option works with multiprocessor systems. Toggled by double-clicking the entry. Default=Yes.

**Field Order** Selects the field on page 8570 order of rendered images when the Render Fields option is turned on. Default=Odd.

Some video devices require that the even field be first, other video devices require that the odd field be first. Determine the correct field order for your video device. If the video output of your device is strobing or appears jittery, it may be due to incorrect field order. Try changing this parameter and re-rendering your animation.

**Alternate Paths group**

Comparable to setting the alternate paths in the Network Job Assignment dialog on page 6953.

**Alt Bitmap Path** Lets you enter an alternate path where the servers search for bitmaps. Editable from keyboard.

**Alt XRef Path** Lets you enter an alternate path where the servers search for XRefs. Editable from keyboard.

**Timeouts group**

These settings are covered in Advanced Settings Dialog on page 6970.
Notifications group

These settings are covered in Notifications Dialog on page 6965.

Viewing Jobs and Servers with the Queue Monitor

All rendering jobs submitted to the network rendering queue are shown in the Job list window, located on the upper-left side of the Queue Monitor dialog, immediately below the toolbar. Below it is the Server list window, which shows all servers attached to the manager and their status.

Interface

Each job is denoted by an icon reflecting its current status. The servers are also denoted by specific icons that reflect their current status.

Job Icons

Job is started and has rendered one or more frames. The job is either currently rendering or is awaiting an available server.

Job is active, but has not yet rendered any frames.

Job is suspended. The job was submitted as suspended or was suspended with the Queue Monitor. Suspended jobs must be manually reactivated to give them a started or active status.

Job is in an error condition. In the Queue Monitor, check the Errors tab in job information window, to the right of the jobs list, for details regarding the error, such as missing bitmaps, plug-ins, texture coordinates. See Troubleshooting on page 6927.

Job is completed. All frames in the sequence have been rendered successfully. You may delete this job from the queue if you want.
Server Icons

A bar through the server icon indicates that it's assigned to the currently highlighted job or jobs.

Server is active.
The server is rendering the current started job.

Server is absent.
The server is assigned to the rendering task but is not currently rendering. This can occur, for example, when the server is turned off or is not running the Server application.

Server is in an error condition.
Check the Server list Job Status column in the Queue Monitor for details regarding the error, such as missing bitmaps, plug-ins, texture coordinates. See Troubleshooting on page 6927.

Server is idle.
The server can be assigned the highlighted job with the toolbar Assign Server button.

Job Report Dialog

Windows Start menu > Programs > Autodesk > Backburner > Monitor > Highlight a job. > Jobs menu > Report

You can generate ASCII reports containing detailed statistics about a particular job selected in the Job Queue list.

See also:

■ Week Schedule Dialog on page 7020
Interface

Header group

Specifies the type of header to include in the report file, in addition to the body information.

Long Includes information above the body of information, including Job Name, Submitted by, Frame Start/End, Output Width/Height, Pixel Aspect Ratio, and Image Aspect Ratio.

Short Includes only the column titles in the report.

Record Delimitation group

Specifies the type of delimiter used between the fields. For example, if you use a tab delimiter, the report will import correctly into Microsoft’s Excel or Access applications.

Tab Inserts a tab between fields in the report.

Space Inserts a space between fields in the report.

Comma Inserts a comma between fields in the report.

Use Quotes Brackets each field with double quotes.
**Output File group**

(Text Field) Specifies the report's file name. You can specify a complete path, if you want. By default, the path is the directory containing the *monitor.exe* file.

**TIP** If you use a shortcut icon to launch Queue Monitor, you can specify the path for your report's output file in the Start In field in the Properties dialog for the shortcut.

**Browse** Displays a file selector where you can specify a file path for the report.

**Job Archives Dialog**

Windows Start menu > Programs > Autodesk > Backburner > Monitor > Highlight a job. > Jobs menu > Job Archives

Windows Start menu > Programs > Autodesk > Backburner > Monitor > Highlight a job. > right-click menu > Job Archives

Use the Job Archives dialog to delete, activate and refresh jobs that have been archived. Jobs are placed here when you select a job from the Job list on the Queue Monitor and click the Archive Job command. This brings up the Backburner Job Archives dialog Jobs are also placed in the Job Archives if you set them to automatically archive when the rendering is completed.

**Interface**

This dialog consists of a toolbar and list of archived jobs.
**Toolbar**

The Job Archives toolbar has three commands.

**Delete** Deletes a selected job from the archive. You are warned and must accept confirmation before the deletion to occur. This button is active only when a job is selected.

**Activate** When you select a job from the list, you can click the Activate button. When a job is activated, it is removed from the Job Archives and placed back in the Job list in the Queue Monitor on page 6995. Then you can choose to Edit Settings on page 7008 and restart the job.

**Refresh** Forces the Job Archives dialog to update the information shown in the job list.

**Job List**

The Job List shows the Job Name, Owner, Description, Type (render plugin), original Submission date, and Completion date. Unlike other lists in the Queue Monitor, you cannot add or remove columns. You can make multiple selections of jobs by holding down either the SHIFT or CTRL keys.

**Activating and Deactivating Jobs in the Queue**

As requirements change, you can deactivate an active or pending job in the rendering queue, or reverse the process and restart jobs that are inactive.

When you deactivate a job, the servers assigned to the job either drop the frame they are rendering or finish writing the frame, depending on where they are in the rendering process. The next pending job becomes active and begins to render.

You can reactivate a suspended job, or a job that was submitted as Initially Suspended from the Network Job Assignment dialog.

**Procedures**

**To deactivate a job:**

1. Select a started or active job in the Job list.
2 Do one of the following:
   ■ Click the Suspend button on the toolbar (the red light-bulb icon).
   ■ Choose Jobs menu > Suspend.
   ■ Right-click the job name to display a pop-up menu, and then choose Suspend.
     If necessary, click the toolbar Refresh button to view the new queue status.

To activate a suspended job:
1 Select the inactive job (denoted by a gray box).
   The Activate button on the toolbar becomes active.
2 Click Activate, or use the menu bar or right-click menu.
   The job becomes either started or active in the queue, depending on whether or not another job is currently rendering and whether or not any of the job's frames have already rendered.

Activating and Deactivating Servers in the Queue

When prioritizing jobs and dividing up the network render load, you might need to pull individual servers off one job and place them on another.

When you remove a server from the current rendering job, and the server is assigned to another started or active job, it is used by that job. If the server has no further job assignments, it stops rendering.

You can assign machines that become available for network rendering to any job.

You can tell whether a server is assigned to a particular job by highlighting the job in the Queue Monitor > Job list and looking at the server's icon in the Server list. If a horizontal bar appears through the server icon, then it is assigned to the job; if no bar appears, then it isn't assigned to the job.

Alternatively, just highlight the job and then click Selected Job in the Server Tree view, to list only servers assigned to that job.

Next Step

Managing Jobs in the Queue on page 7019
Procedures

To remove a server or servers from the highlighted rendering job or jobs:

- Highlight the server in the Server list and click the Remove Server icon on the toolbar.

To assign an unassigned server or servers to highlighted rendering job(s), do one of the following:

1. Highlight the unassigned server(s) in the servers list and choose Assign To Selected Jobs from the Servers menu.
2. Right-click the server name in the queue list to display the pop-up menu and choose Assign To Selected Jobs.

Managing Jobs in the Queue

Reordering lets you change the job order in the queue to meet changing deadlines or priorities. You can delete jobs from the queue at any time.

Procedures

To re-order a job in the queue:

1. In the Job list window of the Queue Monitor, right-click the job to move.
2. Choose Change Priority, and use the Change Job Priority dialog to set a new Priority value.

**NOTE** You can reorder multiple jobs at the same time. They will end up with the same priority.

To delete a single job from the job queue, do one of the following:

1. Highlight the job and then click Delete on the toolbar.
2. Use the right-click menu > Delete command.

You can delete multiple jobs by first highlighting the jobs by using the CTRL or SHIFT keys and then clicking the Delete button or Jobs menu > Delete.
Week Schedule Dialog

Queue Monitor > Highlight a Server and right-click. > Week Schedule
Queue Monitor > Highlight a Server. > Servers menu > Week Schedule

By default, all servers are available at all times. Using the Queue Monitor’s Week Schedule feature, you can arrange the hours during which each server is available for network rendering.

You can specify certain hours for any day of the week. This is useful, for example, if the server is used as a modeling workstation during normal business hours and you do not want it being used as a network render server during this time.

Procedures

To schedule a set of active hours for a server or servers:

1. In Queue Monitor's Server list, right-click a Server and choose Week Schedule, or select one or more Servers and choose Servers menu > Week Schedule.
2 In the dialog that appears, select a time using one of the following methods:
   - Select a one-hour block for network rendering by clicking one of the top buttons.
   - Select an entire day by clicking a side button.
   - Select the entire week by clicking the large top-left button.
     The selection is shown in white.

3 Click the Allow button. The selection is shown in green. (By default, all hours are allowed).

4 To apply the time selection to the selected Server, click OK.

**To schedule hours when servers are unavailable:**

1 In Queue Monitor's Server list, right-click a Server and choose Week Schedule, or select a Server and choose Servers menu > Week Schedule.

2 In the dialog that appears, select a time using one of the following methods:
   - Select a one-hour block for network rendering by clicking one of the top buttons.
   - Select an entire day by clicking a side button.
   - Select the entire week by clicking the large top-left button.
     The selection is shown in white.

3 Click the Disallow button. The selection is shown in red.

4 To apply the time selection to the selected Server, click OK.

**Batch Rendering**

“Batch rendering” is a term used to describe the process of rendering a series of tasks or jobs that have been assigned to a queue. Batch rendering is useful when you need to render images without supervision or when you want to render a number of test studies showing different day or night lighting, or for producing shadow studies of various sun angles. Batch rendering can also be used when you want to see how your project looks from different camera viewpoints.
Several methods for setting up batch rendering are available in 3ds Max. These methods entail using the Batch Render tool on page 7026 or network rendering on page 6905 with Backburner, or a combination of the two.

The three available methods for setting up batch rendering are as follows:

- Build a queue of camera tasks that are managed by the Batch Render tool. If you have a MAX file that contains one or more cameras and saved scene states on page 7915, you can set up a camera queue to render different camera viewpoints. Each camera can be set to automatically load a scene state to give you several visualizations of your model.

- Set up a series of jobs as network rendering assignments to be coordinated by Backburner. If you have a number of separate scenes that are part of a single project or part of several projects, use network rendering even if you’re rendering to a single computer. Use this method also if you have scenes that don’t have a camera set up and you want to render a Perspective, Front, Left or Right viewport view.

- Use the Batch Render tool to set up a queue of camera tasks to render different views and pass them to Backburner for rendering management. The Batch Render tool has an option to send each camera task in the batch render list as a separate network rendering job. Use this method if you want to split the rendering of the different views among multiple computers.

**Quick Start Batch Rendering**

This topic provides bare-bone steps on how to set up and use the Backburner Manager and Server utilities to perform batch rendering.

If your system is already properly configured for TCP/IP protocols (for example, your computer has an internet connection), information in this topic will help you get started with batch rendering in a few basic steps.

**Procedures**

**To render in batch mode:**

You need Windows XP (Home or Professional) Service Pack 1 (or higher) or Windows 2000 Service Pack 4.
1 Run the Backburner Manager and Server applications from the Start menu, in the same program group as 3ds Max.

2 Start 3ds Max, and load the first scene you want to batch render.

3 Open the Render Setup dialog and adjust the various rendering parameters for the way you want to render the scene, including active viewport, file output, etc.

4 Turn on Net Render in the Render Output group, and then click Render.

5 In the resulting Network Job Assignment dialog on page 6953, click the Connect button.

6 Click the Submit button.

7 Load the next scene you want rendered, and then repeat steps 4 through 7.

Once you’ve submitted all rendering jobs, you can exit 3ds Max, if you want. If power is lost before all jobs are rendered (either by accident or by intentional powering down of your computer), when you restart the Backburner Manager and Server programs, the rendering process will resume where it left off.

Using Backburner for Batch Rendering

Using Backburner for batch rendering is a simple matter of starting 3ds Max, running the Backburner Manager and Server programs, specifying the scenes you want rendered, and then proceeding with the rendering. In this case, Backburner coordinates a series of rendering tasks that are network rendered on a single computer.

The process is very similar to rendering over a network. With network rendering, the scenes you submit to the rendering queue are called 'jobs'. The following steps show how to submit multiple jobs to the rendering queue.
Your system has to be properly configured in the TCP/IP protocol (see “TCP/IP Settings” in the Autodesk Backburner Installation Guide) to perform Backburner batch rendering. If you do not have a network card or if you are not connected to the internet, then you may need to configure TCP/IP with the Microsoft Loop Back Adapter.

**NOTE** Batch rendering by means of Backburner differs from batch rendering with the Batch Render tool on page 7026. However, you can use the Batch Render tool to create a queue of rendering tasks and then pass the tasks to Backburner to coordinate the rendering process.

**Network Files**

When Backburner Manager begins a job, a series of files are created in the \network\jobs folder of your Backburner folder. Among other things, this means that you can shut down your computer completely (either on purpose or by accidental power failure), and when you next start Backburner Manager and Server, they’ll pick up where they left off and continue with your rendering queue.

**NOTE** The exception to the above rule is when rendering multiframe file formats, such as AVI and MOV. Due to limitations in these file formats, if you stop in the middle of rendering one of these files, when you begin rendering again, the entire file will have to be rendered from the beginning.

**Procedures**

**To batch render several jobs:**

1. Start 3ds Max.
2. Start Backburner Manager.
   The Backburner Manager window appears. Its window displays the words: “Starting Network Manager.”
   The Backburner Server window appears. Its window displays the words: “Starting Backburner Server,” followed by additional startup messages.
4. In 3ds Max, load the first scene you want rendered.
5. Activate the viewport you want rendered, and click the Render Setup button on the toolbar.
6 Set up the various rendering parameters as you would if you were rendering only this scene.

7 In the Render Output group, turn on Net Render.

8 Click Render.

To assign network jobs:

At this point, the Network Job Assignment dialog on page 6953 appears. Its main purpose is submit the current job to the Backburner Manager with all its render settings, including job name and net rendering specifics. The Backburner Manager then takes over and begins the rendering process.

1 In the Job Name field, either accept the default name (the name of the scene), or specify a new one.

2 Click the Connect button to connect 3ds Max to the Manager. After a moment, your TCP/IP address appears in the field over the window, and the Server appears in the window.

3 Click the server in the window so that its icon displays a green circle with an arrow through it.

4 Click the Submit button.

**NOTE** Each job should have a unique output file name and/or path to avoid overwriting output files. If you get an alert dialog that says, "Another job is using the same output name...", you can click the No button, click Cancel to exit the Network Job Assignment dialog, and then change the output name and/or path. Otherwise, you can click the Yes button and let the job overwrite the frames from the other job in the queue.

5 The Job Assignment dialog goes away, and the rendering begins. The Manager reports: "Job (job name) submitted." The Server reports that it has received the job, and then begins reporting each frame it's completed.

6 At this point, you can open the next scene to be rendered, and then repeat the steps, beginning with step 4 in the previous procedure.

Once you've submitted the jobs you want rendered, you can exit 3ds Max (do not shut down the Backburner Manager or Server), or you can begin working on a new scene, or editing an old scene. Keep in mind, however, that your processor is spending most of its time working on rendering, so your computer will slower than usual.
If you need to monitor the batch render processes, you can use the Backburner monitor for that purpose. (See “Understanding the Backburner Monitor” in the Autodesk Backburner User’s Guide.)

**Batch Rendering: Batch Render Dialog**

Rendering menu > Batch Render

The Batch Render tool offers you an efficient, visual approach to setting up a sequence of different tasks or scene states to render automatically. From the Batch Render dialog, you control the following:

- Image resolution, pixel aspect ratio or time sequence if it differs from the default rendering settings found on the Render Setup dialog on page 6506.
- Whether to render a specific camera view or the active viewport.
- Which camera view to render.
- The output path where rendered images get stored.
- Which scene state on page 7915 is restored prior to rendering.
- Which rendering preset on page 6561 is used per rendered view.
- Whether all the batch rendering tasks should be sent to Backburner for network rendering on page 6905 by multiple systems for even faster rendering.
- Exporting the batch rendering tasks and all parameters set in the Batch Render dialog to a BAT file for later command line rendering on page 7035.

**NOTE** The Batch Rendering dialog is for rendering different aspects of the same scene, such as views from different cameras. To batch-render a number of different scenes, use Backburner on page 7023 or command-line rendering on page 7035.

**Batch Render Completed**

If a problem is encountered by the Batch Renderer, you will be notified by means of the Batch Render Completed dialog. This is an error dialog that appears and notifies you about which batch renders did not complete and, if possible, provides a description of why the failure occurred.
If the cause of the error cannot be identified, then the error entry will simply state *Failed*. The most common causes for failure are:

- **Missing texture maps for materials that are assigned to objects in the scene.** This shows up as *Failed. Missing External File*. Once the texture map is found or map paths are properly set, this error will not occur.

- **Missing UVW coordinates for objects that have texture mapped materials assigned to them.** This is reported as *Failed. Missing Map Coordinates on Object* and can be alleviated by making sure new objects are created with the Generate Mapping Coords switch turned on and by assigning a UVW Map modifier to the object that is not displaying its texture mapping.

**Procedures**

**To use the Batch Render tool:**

1. Open or create a MAX scene.
2. Choose Rendering menu > Batch Render.
   The Batch Render dialog opens.
3. On the Batch Render dialog, click the Add button. This adds your first rendering task to the batch render queue.
   By default, the Camera parameter is set to Viewport, which means that the task will render the active viewport. To change to a set view, make sure the scene contains at least one camera, and then choose the camera view to render from the Camera drop-down list on page 7032.
Review the Selected Batch Render Parameters settings and, if necessary, turn on Override Preset and then change the Frame Start, Frame End, Width, Height, and Pixel Aspect settings.

Click the Output Path button to set a drive location, file name and file format for the rendered image.

If you've saved any scene states with the model, you can choose which one is loaded during the rendering operation by opening the Scene State drop list.

Repeat steps 3 through 6 to continue adding rendering tasks to the batch render queue, as necessary.

When all your tasks are set, click the Render button.

To use the Batch Render tool with Backburner:

Before attempting to use the Batch Render tool with Backburner for network rendering, make sure the Backburner Manager is running on your managing workstation and that Backburner Server is running on all the other workstations that will receive the rendering assignments. For more information on setting up Backburner Network Rendering, refer to Network Rendering on page 6905.

1. Set up a series of rendering tasks in the Batch Render queue as documented in the previous procedure.

2. Turn on Net Render and then click the Render button.
   The Network Job Assignment dialog opens.

3. Enter a subnet mask, or, with Automatic Search off, enter the Manager name or IP address, and then click Connect.
   The available rendering servers show up in the list on the right side of the Network Job Assignment dialog.

4. Click the Submit button to send all the Batch Render camera tasks to Backburner for network rendering to all the workstations that are running Backburner Server.
   If you are running the Backburner Queue Monitor, you’ll see all the camera tasks listed as rendering jobs in the Job section of the Queue Monitor.
Interface

**Add** Adds a new rendering task to the queue, using the default settings. By default, a new task is set to render the active viewport. To set it to render a particular camera, choose the camera from the Camera drop-down list on page 7032.

**Duplicate** Adds a copy of the highlighted rendering task to the queue. All rendering parameters that were part of the original task are duplicated for the new task.

**Delete** Deletes the highlighted rendering task.
No warning appears to confirm deletion and you cannot undo a deletion.

**[Task Queue]** This is a listing of all the camera tasks that have been chosen for batch rendering. The task queue consists of eight columns that show all the parameters that have been set for a particular camera task. You can control which tasks are rendered by toggling the check boxes in the list.

<table>
<thead>
<tr>
<th>Name</th>
<th>Camera</th>
<th>Output Path</th>
<th>Range</th>
<th>Resolution</th>
<th>Pixel Aspect</th>
<th>Frame Rate</th>
<th>Preset</th>
</tr>
</thead>
<tbody>
<tr>
<td>Camera02 View01</td>
<td>Camera02</td>
<td>hallway_01..</td>
<td>0-5</td>
<td>1280x720</td>
<td>1:000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Camera01 View03</td>
<td>Camera01</td>
<td></td>
<td>0-3</td>
<td>1280x720</td>
<td>1:000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Camera02 View03</td>
<td>Camera02</td>
<td>hallway_01..</td>
<td>Default</td>
<td>Default</td>
<td>Default</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Selected Batch Render Parameter group**

By default, any tasks you've designated for batch rendering use the current Time Output and Output Size parameters from the Render Setup dialog on page 6506.

For example, if the Output Size settings on the Render Setup dialog shows that you have a Time Output settings of Single and an of 800 width and 600 height, when you add a camera, its Selected Batch Render Parameters will mimic those settings. Likewise, if the Render Setup dialog has a Time Output set to Range and frame 0 to 25, the Frame Start and Frame End settings on the Batch Render dialog will default to those Time Output settings.

This group gives you access to changing those default parameters.

**Override Preset** When on, you can override any of the default settings for the highlighted task via the Frame Start, Frame End, Width, Height, and Pixel Aspect settings. Default=off.

**Frame Start** The first frame to be rendered for the highlighted task. The default setting for this parameter matches the Time Output group settings on the Common panel of the Render Setup dialog.

**Frame End** The last frame to be rendered for the highlighted task. Its default state also matches the Time Output group settings on the Common panel of the Render Setup dialog.

The default Frame Start and Frame End parameters correspond to the Render Setup dialog parameters as follows:

<table>
<thead>
<tr>
<th>Render Setup dialog &gt;Time Output</th>
<th>Batch Render dialog Frame Start/End</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single</td>
<td>Defaults to the frame set by the time slider.</td>
</tr>
<tr>
<td>Render Setup dialog &gt;Time Output</td>
<td>Batch Render dialog Frame Start/End</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>---------------------------------------</td>
</tr>
<tr>
<td><strong>Active Time Segment</strong></td>
<td>Defaults to 0 (zero) and the last frame of the animation as set in the Time Configuration dialog on page 8106.</td>
</tr>
<tr>
<td><strong>Range</strong></td>
<td>Defaults to the range of frames specified, such as 0 (zero) To 14 or 6 To 11.</td>
</tr>
</tbody>
</table>

The Frame Start and End settings also conform to the current time configuration format; i.e. Frames, SMPTE, Frame:Ticks, or MM:SS:Ticks.

**Width** Allows you to specify a new image width setting if Override Preset is on. If Override Preset is off, this value matches the width set on the Render Setup dialog.

**Height** Allows you to specify a new image height setting if the Override Preset is on. If Override Preset is off, this value matches the height set on the Render Setup dialog.

**Pixel Aspect** Sets the aspect ratio of the pixels for display on another device. The image might look squashed on your display but will display correctly on the device with differently shaped pixels. By default, this mimics the value set on the Render Setup dialog.

**Name** Lets you change the default name of the highlighted task. The default naming structure for camera tasks uses “View” plus an incremented view number, such as View01 or View02. If you want, you can change the task's name to something more descriptive.

**NOTE** After changing the name, you must press Enter for the change to register.

**NOTE** If you’re rendering elements on page 6807 as part of the batch, the task name is appended to each rendered element's specified file name. For example, if the task name is View01 and the render element output file name is Test_Diffuse.tga, then the batch-rendered element output becomes Test_Diffuse_View01.tga.

If you’re rendering an element without specifying a file name for the element, the batch renderer appends the element type to the batch output file name.
For example, if the batch output file name is *MyBatch.png*, and you're rendering an Atmosphere element, then the element output name becomes *MyBatch_Atmosphere.png*.

**Output Path** The ellipsis (...) button opens the Render Output File dialog on page 6529 where you can specify the output path, file name and file format for the rendered image of the selected camera task.

Once set, the output path and file name appears in the output path field and the file name appears in the Output Path column of the task queue.

**X [Clear Output Path]** Removes the output path and file name from the Output Path field and task queue.

**Camera** This drop-down list shows any cameras in the scene.

By default, a task is set to render the active viewport, as indicated by the “Viewport” entry in the Camera column of the task queue. You can use this list choose a camera from any in the scene for the highlighted task. The new camera is shown in the Camera column of the task queue.

To set the highlighted task to render the active viewport, choose the dashed line (-------------------------) from the top of the drop-down list.

Choose the dashed line to render the active viewport.

**NOTE** Choosing a camera changes only the camera the task uses. It does not change the name of the task.

**Scene State** This drop-down list displays the scene states on page 7915, if any, that you can assign to the highlighted task. If no scene state is active then current scene settings are used.

**Preset** Lets you choose a render preset for the highlighted task. If no render preset is active and there is no override, then the current render settings are used.

If you choose Load Preset from the drop-down list, the Render Presets Load dialog opens.

**Net Render** When on, opens the Network Job Assignment dialog on page 6953 when you click the Render button.
Each camera task in the Batch Render dialog is passed to the Network Job Assignment dialog as an individual rendering job instead of a single job. By default, the Network Job Assignment dialog uses the name of the MAX file as its job name, and it then appends the name of the camera task. For example, if you have a scene named Athena_High_Rise and camera tasks for three cameras, the jobs will look like this in the monitor: *Athena_High_Rise Camera02 View01*, *Athena_High_Rise Camera01 View02*, and *Athena_High_Rise Camera01 View03*.

**Export to .bat** Creates a batch file for command line rendering. This button opens the Batch Render Export To Batch File dialog where you can specify a drive location and name for the batch file that is saved.

**Render** Starts the batch rendering process or opens the Network Job Assignment dialog if Net Render is turned on.

### Batch Render Tool: Batch Render Warning Dialog

Rendering menu > Batch Render > Click Render to render tasks that do not have an output path set.

Rendering menu > Batch Render > Click Render to render tasks that could overwrite previously saved files.

The Batch Render Warning dialog informs you of certain conditions you might have overlooked while assigning the rendering tasks.

The dialog that displays is context-sensitive, meaning that the warning will indicate when either of these two conditions exist:

- When you risk overwriting an existing file or if you have not specified an output path and output file name.
- When the output path that was specified has been renamed or no longer exists.

**Interface**

**Task Queue**

Both formats of the Batch Render Warning dialog include the Task Queue columns that are shown in the in the Batch Render dialog. The key difference is the exception of the check boxes that let you specify which cameras are used in the render. This Task Queue only shows the cameras that may overwrite a
saved file, or do not have a path/file name set for output, or if they show an output path that is invalid.

**Missing Output Path/Filename or File Overwrite**

This version of the Batch Render Warning dialog appears if you click the Render button on the Batch Render dialog and one or more of the tasks to be rendered does not include an output path/file name. The dialog also appears if there is a chance you will overwrite a previously rendered image.

<table>
<thead>
<tr>
<th>Name</th>
<th>Camera</th>
<th>Output Path</th>
<th>Range</th>
<th>Resolution</th>
<th>Pixel Aspect</th>
<th>Scene State</th>
<th>Fr</th>
</tr>
</thead>
<tbody>
<tr>
<td>Camera1 View</td>
<td>Camera1</td>
<td>Default</td>
<td>Default</td>
<td>Default</td>
<td>Default</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Camera2 View</td>
<td>Camera2</td>
<td>0 - 0</td>
<td>320x240</td>
<td>1,000</td>
<td></td>
<td>Bank Wells</td>
<td></td>
</tr>
</tbody>
</table>

**OK** Allows you to continue with the batch rendering tasks even though there are some tasks without an output path/file name or some files could be overwritten. Tasks without an output path/file name are not automatically saved and only appear in the Rendered Frame Window on page 6513.

**Cancel** Cancels the batch rendering.

**Invalid Output Path**

This version of the Batch Render Warning dialog only appears if you are rendering to a file that has invalid output paths. For example, if you’re rendering a client’s model and they’ve set their own output paths.
Update Path Allows you to browse to a new directory and reassign the output path for all the entries in the Task Queue. The specified output file name remains the same.

NOTE If you don’t want to assign the same path to all the cameras shown in the dialog, you should Cancel and set the correct paths for each camera from the Batch Render dialog.

Continue Allows you to continue with the batch rendering tasks even though there are some tasks without an output path. Tasks without an output path are not automatically saved and only appear in the Rendered Frame Window on page 6513.

Cancel Cancels the batch rendering.

Command-Line Rendering

The command-line rendering tool lets you perform batch rendering jobs without having to manipulate parameters by hand in a MAX file. Simple, “one-shot” rendering jobs can be submitted from the Start > Run dialog. More elaborate, batched jobs can be rendered through the use of text files; for example, MyRender.bat or MyRender.xml. The ability to edit text files is what provides the power to this tool. You can quickly make changes to your rendering parameters, or output formats, simply by opening your text editor and editing the batch settings.

Command-line rendering is provided by the 3dsmaxcmd.exe program, found in your program install folder.
You can submit command-line rendering jobs that are rendered on a single workstation, or you can take advantage of network rendering on page 6905 and let the Backburner utility manage the jobs across multiple systems.

The Batch Render tool on page 7026 is another way to quickly create BAT files that can be used with the command-line rendering. The Batch Render tool lets you create a queue of camera tasks with specific output parameters, rendering presets or automatic loading of scene states. Once your queue is complete, you can export the tasks to a BAT file that is stored in the \scenes folder.

**WARNING** Command-line rendering is a professional feature and can perform destructive operations. You will not see messages or warning dialogs informing you about potential mistakes, such as overwriting an existing frame on your drive.

See also:
- Command-Line Rendering Switches on page 7039

### Procedures

**To view the 3dsmaxcmd help file:**

The 3dsmaxcmd.exe file contains a built-in help system that you can access from a command prompt.

1. Open a command prompt window (for example, Windows Start > Run > enter CMD).
2. Enter the following: “c:\program files\autodesk\[program folder name]\3dsmaxcmd” -? and press Enter.
   The list of switches and options will scroll on to the window.

**To view a list of sample command lines with descriptions of what they do:**

The 3dsmaxcmd.exe file also has an extensive list of sample text strings that describe many of the most common scenarios you’d use command-line rendering to accomplish.

1. Open a command prompt window.
2. Enter the following: “c:\program files\autodesk\[program folder name]\3dsmaxcmd” -x and press Enter.
Setting up the simplest rendering:

In its simplest form, just a render command using all the settings that are stored with a scene, would look like this:

1. Open a command prompt window.
2. Enter the following: “c:\program files\autodesk\[program folder name]\3dsmaxcmd” “c:\program files\autodesk\[program folder name]\scenes\myscene.max” and press Enter.

Example: Rendering to a JPG file at 800x600 resolution:

Perhaps the last time you rendered your scene, you had the output resolution set to 320x240 and rendered a BMP file. Re-rendering the scene using different output settings is fast and efficient with command-line rendering.

1. Open a command prompt window.
2. Enter the following:
   “c:\program files\autodesk\[program folder name]\3dsmaxcmd” -outputName:“c:\program files\autodesk\[program folder name]\renderoutput\myImage.jpg” -w 800 -h 600 “c:\program files\autodesk\[program folder name]\scenes\myscene.max” and press Enter.

**NOTE** The specified output path must already exist. If it doesn’t, the image doesn’t render and you get an error message.

Network rendering from the command line:

If you have your system networked and have access to other systems, you can take advantage of network rendering.

**NOTE** A command-line job cannot be run on a system already running the Backburner server.

1. Open a command prompt window.
2. Enter the following:
   “c:\program files\autodesk\[program folder name]\3dsmaxcmd” -submit “c:\program files\autodesk\[program folder name]\scenes\myscene.max” and press Enter.
Example: Rendering from a text file:

Command-line rendering gives you the ability to set a series of common switches that can be quickly re-used for rendering a single job from Start > Run, or for rendering a group of scenes specified in a BAT file. You can build your text file using any text editor.

NOTE A TXT file can specify only a single scene to render. For multiple scenes, use a BAT file.

1. Open your text editor.
2. Enter your list of commands, such as:
   - `bitmapPath=\mapServer\maps\myMaps`
   - `cam=myCamera`
   - `width=800`
   - `height=600`
   - `vfb=true`
   - `frames=all`
   - `force2Sided=true`
3. Once all the switches are entered, save the files as a TXT file, such as `myrender.txt`.
4. To render the scene, open the Windows Start > Run dialog.
5. Enter the following:
   
   ```
   `c:\program files\autodesk\[program folder name]\3dsmaxcmd`
   @c:\myrender.txt -o="c:\program files\autodesk\[program folder name]\renderoutput\myImage.tga"  "c:\program files\autodesk\[program folder name]\scenes\myscene.max"
   ```
   and click OK.

   Using a TXT file that contains your favorite settings, in conjunction with a command line that specifies the output file format and scene of your choice, gives you the flexibility to re-use the TXT file without having to edit it each time you want to render. You can create several TXT files with settings for different stages of scene development, such as `testrender.txt` or `finalrender.txt`.

Example: Rendering from a BAT file:

If you want to render several scenes in a batch process, you can create a BAT file containing all the scenes and switches needed to get the results you want. Just like a text file, you can build your BAT file using any text editor. For this
example, let's say you have three scenes, in various stages, and you want each rendered using different settings.

1  Open your text editor.

2  On the first line, enter the following text. This example assumes that the scene is far from finished, but that you want to test a chunk of animation.
   
   ```
   "c:\program files\autodesk\[program folder name]\3dsmaxcmd -o="c:\program files\autodesk\[program folder name]\renderoutput\scene1.jpg" -w=320 -h=240 -frame=1-33 "c:\program files\autodesk\[program folder name]\scenes\scene1.max"
   ```

   The second scene is almost ready, but you need to test the look of some materials and do a video color check:
   
   ```
   "c:\program files\autodesk\[program folder name]\3dsmaxcmd -o="c:\program files\autodesk\[program folder name]\renderoutput\scene2.jpg" -w=640 -h=480 -force2Sided=true -videoColorCheck=true "c:\program files\autodesk\[program folder name]\scenes\scene2.max"
   ```

   The last scene is complete, and you want to render a higher-resolution image using settings you've saved in a TXT file that you always use for final renderings:
   
   ```
   "c:\program files\autodesk\[program folder name]\3dsmaxcmd @c:\finalrender.txt -o="c:\program files\autodesk\[program folder name]\renderoutput\scene3.jpg" "c:\program files\autodesk\[program folder name]\scenes\scene3.max"
   ```

3  After entering these three command lines, save your file as a BAT file.

4  From the Windows Start > Run dialog, browse to the BAT file and click Open.

5  Click OK to start rendering.

### Command-Line Rendering Switches

In order to use command-line rendering, you should be familiar with DOS and understand the structure of command lines.
Command-Line Switches

You can use the following switches after `3dsmaxcmd` on the command line of a command prompt window, or as entries in a text file. The following tables show switches and their effects.

---

**NOTE** Switches are not case sensitive.

At Verbosity level 5, the output message from command-line rendering includes both a timestamp and a date stamp. The timestamp is separated from the main message by a semicolon, and the elapsed time message is separated from the Frame Completed message by a semicolon. This lets you pipe the message to a file, and then open it in a spreadsheet program with appropriate columns by setting the delimiter character.

**Separators**

Many switches are displayed in the following charts with trailing colons, such as `-w:` or `-h:`. The use of a colon separator is optional, and can be replaced with a space or an equal sign (=). Therefore, command lines such as:

```
"c:\program files\autodesk\[program folder name]\3dsmaxcmd"
-outputName:"c:\program files\autodesk\[program folder name]\renderoutput\myImage.jpg" -w:640 -h:480 "c:\program files\autodesk\[program folder name]\scenes\myscene.max"
```

will give you the same results. The use of the equal sign can give your command-line files more of an INI file appearance.

---

**NOTE** The switch `-submit:[manager_name]` is the only case where a colon is necessary.
**On/Off Command-Line Switches**

Many of the switches you'll use are simple on/off toggles, such as the `-rfw` and `-renderFields:` switches. If you prefer, instead of using a 1 or 0 to designate their states, you can use True or False. For example, to render a scene to a specified file type and display the Rendered Frame Window, your command line might look like this;

```
"c:\program files\autodesk\[program folder name]\3dsmaxcmd"
-outputName="c:\program files\autodesk\[program folder name]\renderoutput\myImage.jpg" -rfw=true "c:\program files\autodesk\[program folder name]\scenes\myscene.max"
```

**Basic Options**

<table>
<thead>
<tr>
<th>Switch</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>-?</td>
<td>Displays a list of these switches in the DOS window.</td>
</tr>
<tr>
<td>-x</td>
<td>Shows a list of example command lines.</td>
</tr>
<tr>
<td>-v:#</td>
<td>Sets the verbosity level, where # is an integer from 0 (least verbose) to 5 (most verbose).</td>
</tr>
<tr>
<td>@command_file or -cmdFile:command_file</td>
<td>Points to a separate file containing command-line options.</td>
</tr>
<tr>
<td>-preset:&lt;filename&gt; or -rps:&lt;filename&gt;</td>
<td>Uses a render preset file where &lt;filename&gt; is the name of the preset file.</td>
</tr>
<tr>
<td>-sceneState:&lt;scene-state-name&gt;</td>
<td>Loads the specified scene state file before rendering the image.</td>
</tr>
<tr>
<td>-batchRender</td>
<td>Renders all enabled tasks in the Batch Render dialog.</td>
</tr>
<tr>
<td><strong>Switch</strong></td>
<td><strong>Effect</strong></td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>-batchRender:&lt;batch-render-name&gt;</td>
<td>Renders batch renders in the file named batch-render-name.</td>
</tr>
<tr>
<td>-preRenderScript:&lt;filename&gt; or -script:&lt;filename&gt;</td>
<td>Uses a pre-render script where &lt;filename&gt; is the name of the script file.</td>
</tr>
<tr>
<td>-postRenderScript:&lt;filename&gt;</td>
<td>Uses a post-render script where &lt;filename&gt; is the name of the script file.</td>
</tr>
<tr>
<td>-workPath:&lt;path-name&gt;</td>
<td>Root location for job data folders.</td>
</tr>
<tr>
<td>-pathFile:&lt;path-name&gt;</td>
<td>Path configuration file (MXP format).</td>
</tr>
<tr>
<td>-bitmapPath:&lt;path-name&gt;</td>
<td>(obsolete) Provides an extra bitmap path. Multiple paths can be entered and UNC naming conventions can be used.</td>
</tr>
<tr>
<td>-xrefPath:&lt;path-name&gt;</td>
<td>(obsolete) Lets you specify extra XRef paths. Multiple paths can be entered and UNC naming conventions can be used.</td>
</tr>
<tr>
<td>-split:&lt;strips, overlap&gt;</td>
<td>Split render: number of strips, overlap amount.</td>
</tr>
<tr>
<td>-strip:&lt;strips, overlap, strip&gt;</td>
<td>Split render: number of strips, overlap amount, strip number (starting with 1). This is similar to the -split switch, but lets you render a specific, individual strip.</td>
</tr>
</tbody>
</table>
**NOTE** The strip value has no effect when submitting the job to Backburner. The job will still render all strips. Split and Stitch functionality is intended for local rendering only.

**Switch** | **Effect**
--- | ---
-stitch:<strips, overlap> | Stitches strips (see above), combining them into a single image: number of strips, overlap amount. Stitch functionality is intended for local rendering only.
-date-Format:<date-format> | Specifies a date format to be used in message timestamp, at verbosity level 5. Defaults to locale-dependent format. For details, use the `3dsmaxcmd3dsvizcmd`-x option.
-time-Format:<time-format> | Specifies a time format to be used in message timestamp, at verbosity level 5. Defaults to locale-dependent format and 24-hour clock. For details, use the `3dsmaxcmd`-x option.

**Render Parameters**

**NOTE** Any command-line switches that are on/off toggles can be switched by entering either 1, 0, on or off.

**Switch** | **Effect**
--- | ---
-outputName:<filename> or -o:<filename> | Sets an output file name and format.
<table>
<thead>
<tr>
<th>Switch</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>-camera:&lt;string&gt; or -cam:&lt;string&gt;</td>
<td>Specifies a camera name.</td>
</tr>
<tr>
<td>-width:&lt;integer&gt; or -w:&lt;integer&gt;</td>
<td>Sets the output width in pixels.</td>
</tr>
<tr>
<td>-height:&lt;integer&gt; or -h:&lt;integer&gt;</td>
<td>Sets the output height in pixels.</td>
</tr>
<tr>
<td>-pixelAspect:&lt;number&gt;</td>
<td>Sets the pixel aspect ratio.</td>
</tr>
<tr>
<td>-start:&lt;integer&gt;</td>
<td>Sets the rendering sequence start frame.</td>
</tr>
<tr>
<td>-end:&lt;integer&gt;</td>
<td>Sets the rendering sequence end frame.</td>
</tr>
<tr>
<td>-nthFrame:&lt;integer&gt;</td>
<td>Sets the Every Nth Frame value.</td>
</tr>
<tr>
<td>-frames:&lt;string&gt;</td>
<td>Lets you specify a frame list; for example, (1,3,5-12) or all.</td>
</tr>
<tr>
<td>-stillFrame or -sf</td>
<td>Indicates that this is a still-frame render; no frame suffix will be added.</td>
</tr>
<tr>
<td>-imageSequence-File:&lt;0/1/2&gt;</td>
<td>Image-sequence file creation: 0=none; 1=.imsq; 2=.iff</td>
</tr>
<tr>
<td>-gammaCorrection:&lt;1/0&gt;</td>
<td>Toggles gamma correction. “1”=On, “0”=Off.</td>
</tr>
<tr>
<td>-gammaValueIn:&lt;number&gt;</td>
<td>Sets the Input Gamma value.</td>
</tr>
</tbody>
</table>
**Switch** | **Effect**
---|---
-gammaValueOut:<number> | Sets the Output Gamma value.
-continueOnError | If an error is encountered, 3ds Max attempts to continue rendering.
-videopostJob:<1/0> | Turns Video Post on page 7247 on or off for the job.

**Render Flags**

| Switch | Effect |
---|---|
-showRFW:<1/0> or -rfw:<1/0> | Toggles the Rendered Frame Window. “1”=On, “0”=Off. |
-videoColorCheck:<1/0> | Toggles Video Color Check. “1”=On, “0”=Off. |
<table>
<thead>
<tr>
<th>Switch</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>-fieldOrder:even or odd</td>
<td>Toggles Field Order. Default=“Odd”.</td>
</tr>
<tr>
<td>-effects:&lt;1/0&gt;</td>
<td>Toggles Render Effects. “1”=On, “0”=Off.</td>
</tr>
<tr>
<td>-useAreaLights:&lt;1/0&gt;</td>
<td>Toggles area lights/shadows. “1”=On, “0”=Off.</td>
</tr>
</tbody>
</table>
**Backburner Job Submission**

These switches concern submitting a rendering job for network rendering. For further information, see Network Rendering on page 6905. Also, for a different method of network rendering via the command line, see Backburner Command Line Control on page 7052.

<table>
<thead>
<tr>
<th>Switch</th>
<th>Effect</th>
</tr>
</thead>
</table>
| -submit[:manager_name] or -s[:manager_name] | Submits the scene, `<filename>` to a specific manager system for network rendering.  
**NOTE** This is the only switch that requires a colon separator. |
| -port:<integer> | Specifies a manager port number. |
| -netmask:<string> | Lets you specify a network mask other than 255.255.255.0. |
| -jobName:<string> | Lets you specify a job name to render. |
| -priority:<integer> | Sets job priority. |
| -suspended:<1/0> | Toggles initially suspended.  
“1”=Yes, “0”=No. |
| -writeJobFile | Writes all job settings to an XML file. The file uses the same name as the MAX file, so, for example, `test.max` produces `test.xml`. |
| -readJobFile:<filename> | Reads all job settings from an XML file. |
| -waitLoad:<integer> | The amount of time to wait for 3ds Max to load, in minutes. Default=20. |
### Switch

<table>
<thead>
<tr>
<th>Switch</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>-waitRender:&lt;integer&gt;</td>
<td>The amount of time to wait for 3ds Max to render, in minutes. Default=600.</td>
</tr>
<tr>
<td>-waitUnload:&lt;integer&gt;</td>
<td>The amount of time to wait for 3ds Max to unload, in minutes. Default=10.</td>
</tr>
<tr>
<td>-platform:32 or 64</td>
<td>The platform (either 32- or 64-bit) that your scene will be rendered on. Use this switch when you want to render your scene on a different platform from the platform where you created your scene.</td>
</tr>
</tbody>
</table>

### Bitmap Parameters

<table>
<thead>
<tr>
<th>Switch</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>-BMP_TYPE:2 or 8</td>
<td>Sets the type of BMP file being rendered. “2”=paletted, “8”=true 24-bit.</td>
</tr>
<tr>
<td>-JPEG_QUALITY:1 to 100</td>
<td>Sets the JPG quality value. Ranges from 1 to 100.</td>
</tr>
<tr>
<td>-JPEG_SMOOTHING:1 to 100</td>
<td>Sets the JPG smoothing value. Ranges from 1 to 100.</td>
</tr>
<tr>
<td>-TARGA_COLORDEPTH:16, 24 or 32</td>
<td>Sets the color depth for TGA files.</td>
</tr>
</tbody>
</table>
### EffectSwitch

<table>
<thead>
<tr>
<th>Switch</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>-TIF_DPI:&lt;number&gt;</td>
<td>Sets the dots-per-inch value for TIF files.</td>
</tr>
</tbody>
</table>

For each of the following -RLA_xxxx switches, there is a corresponding -RPF_xxxx option.

### Switch | Effect
--- | ---
-RLA_COLORDEPTH:<8, 16 or 32> | Sets the RLA color bitdepth. |
-RLA_DESCRIPTION:<string> | Lets you specify an RLA description (in quotes). |
<table>
<thead>
<tr>
<th>Switch</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>-RLA_AUTHOR:&lt;string&gt;</td>
<td>Lets you specify an RLA author name (in quotes).</td>
</tr>
<tr>
<td>-RLA_UVCHANNEL:&lt;1/0&gt;</td>
<td>Toggles RLA UV Coordinates Channel. “1”=On, “0”=Off.</td>
</tr>
</tbody>
</table>
The following -RPF xxxx switches do not have corresponding -RLA xxxx options.

<table>
<thead>
<tr>
<th>Switch</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>-RPF_NODERENDERID-CHANNEL</td>
<td>Turns on RPF Node Render ID Channel.</td>
</tr>
<tr>
<td>-RPF_COLORCHANNEL</td>
<td>Turns on RPF Color Channel.</td>
</tr>
<tr>
<td>-RPF_TRANSPCHANNEL</td>
<td>Turns on RPF Transparency Channel.</td>
</tr>
<tr>
<td>-RPF_VELOCCHANNEL</td>
<td>Turns on RPF Velocity Channel.</td>
</tr>
<tr>
<td>-RPF_WEIGHTCHANNEL</td>
<td>Turns on RPF Sub-Pixel Weight Channel.</td>
</tr>
<tr>
<td>-RPF_MASKCHANNEL</td>
<td>Turns on RPF Sub-Pixel Mask Channel.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Switch</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>-EXR_USEEXPONENT</td>
<td>EXR use exponent on/off</td>
</tr>
<tr>
<td>-EXR_EXPONENT</td>
<td>EXR exponent value (decimal)</td>
</tr>
<tr>
<td>-EXR_PREMULTALPHA</td>
<td>EXR premultiplied alpha on/off</td>
</tr>
<tr>
<td>-EXR_ALPHA</td>
<td>EXR save alpha component on/off</td>
</tr>
<tr>
<td>-EXR_RED</td>
<td>EXR save red component on/off</td>
</tr>
<tr>
<td>Switch</td>
<td>Effect</td>
</tr>
<tr>
<td>-------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>-EXR_GREEN</td>
<td>EXR save green component on/off</td>
</tr>
<tr>
<td>-EXR_BLUE</td>
<td>EXR save blue component on/off</td>
</tr>
<tr>
<td>-EXR_BITDEPTH</td>
<td>EXR bit depth: 0=8-bit integers; 1=half float; 2=float</td>
</tr>
<tr>
<td>-EXR_USEFRAMENUMDIGITS</td>
<td>EXR use number of frame digits on/off</td>
</tr>
<tr>
<td>-EXR_FRAMENUMDIGITS</td>
<td>EXR number of frame digits (integer)</td>
</tr>
<tr>
<td>-EXR_COMPRESSIONTYPE</td>
<td>EXR compression type: 0=no compression; 1=RLE; 2=ZIP (1 scan-line); 3=ZIP (16 scan-lines); 4=PIZ</td>
</tr>
<tr>
<td>-EXR_USEREALPIX</td>
<td>EXR use RealPix RGB data on/off</td>
</tr>
</tbody>
</table>

**Backburner Command Line Control**

The Backburner command line plug-in allows you to submit batch, executable, or script files to Backburner as “custom” jobs. This `cmdjob.exe` tool, found in the Backburner program folder, provides more flexibility in running custom jobs than is offered by the 3ds Max 3dsmaxcmd.exe plug-in.

For a list of the command-line switches that you can use with the Backburner command line plug-in, see Command-Line Rendering Switches on page 7039. Some examples of how these commands can be used with 3ds Max are listed below.
NOTE In order to use command-line rendering, you should be familiar with DOS and understand the structure of command lines.

Examples of a CmdJob Usage

Please see the online version of the Help for details.

See also:

- Command-Line Rendering on page 7035
Effects and Environments

Several special effects, such as film grain, depth of field, and lens simulations, are available as rendering effects on page 7057. Other effects, such as fog, are provided as environment effects on page 7162. Also available in the environment settings are exposure controls on page 7207, also known as tone mappers.

The fog environment effect adds atmosphere to a street scene.

In 3ds Max, rendering effects and environments are accessed from a single Environment and Effects dialog on page 7056.
Environment and Effects Dialog

Rendering menu > Environment
Rendering menu > Effects
Rendered Frame Window > Environment and Effects Dialog Toggle

You apply effects and environments by using the Environment and Effects dialog.

Interface

The Environment and Effects dialog has two panels, described in the following topics:
Rendering Effects

Rendering Effects enable you to add post-production effects without having to render the scene to see the results. Through the Effects panel on page 7058 on the Environment and Effects dialog, you can add various effects and view them prior to final rendering of an image or animation.

Rendering Effects let you work interactively. As you adjust an effect's parameters, the Rendered Frame Window on page 6513 is updated with the final output image of both the scene geometry and the applied effects. You can also choose to continually work with an effect and then update the effect manually.

Rendering Effects and 32-bit Floating-Point Output

Most rendering effects in 3ds Max are not compatible with 32-bit floating-point output, such as that provided optionally by the mental ray renderer (see Frame Buffer Type on page 6739). If you render using one or more unsupported effects, the following dialog appears:

```
Unsupported Render Effects

The following render effects are not compatible with the bitmap format selected for rendering. The selected bitmap format is:

32 Bits per Channel Floating-Point (RGBA)

- Hair and Fur
- Lens Effects
- Blur
- Brightness and Contrast
- Depth of Field
- Film Grain
- Motion Blur

[Continue]  [Cancel]  [Don't display this message]
```
You can choose to continue rendering without the unsupported effects, or cancel the render.

The only supported effects are File Output and Color Balance; the rest (shown in the dialog above) are unsupported.

**Rendering Effects Command**

Rendering menu > Effects > Environment and Effects dialog > Effects panel

Effects displays the [Effects panel](#) on page 7058 on the Environment And Effects dialog, which lets you set parameters for post-rendering effects.

From this panel, you can select and assign a class of plug-in called Render Effect, which is a post-rendering image-processing effect. This lets you apply image processing without using Video Post.

Render Effects have the added advantage of allowing animated parameters and references to scene objects. You can also adjust and view the effects interactively.

**Effects Panel and Rollout**

Rendering menu > Effects > Environment and Effects dialog > Effects panel

Rendered Frame Window > Environment and Effects Dialog Toggle > Effects panel

The Effects rollout, on the Effects panel, lets you assign and manage rendering effects.

You can use the Effects panel to:

- Assign a Render Effects plug-in.
- Apply image processing without using Video Post.
- Adjust and view effects interactively.
- Animate parameters and references to scene objects.
The Effects panel has one main rollout, Effects, with the following options:

Effects Displays a list of selected effects.

Name Displays the name of the selected effect. Edit this field to rename the effect.

Add Displays a dialog listing all available rendering effects. Select the effect you want added to the window list, and then click OK.

Delete Removes a highlighted effect from the window and from the scene.

Active Specifies whether the selected effect is active in the scene. On by default; you can deactivate an effect without actually removing it by selecting it in the window and turning off Active.

Move Up Moves the highlighted effect up in the window list.
Move Down Moves the highlighted effect down in the window list.

Merge Merges rendering effects from scene (.max) files. Clicking Merge displays a file dialog from which you can choose a .max file. A dialog then appears listing all rendering effects in that scene.

Preview group

Effects When All is chosen, all of the active effects are applied to the preview. When Current is chosen, only the highlighted effects are applied to the preview.

Interactive When on, changes occur interactively in the Rendered Frame Window on page 6513 as you adjust the parameters of an effect. When Interactive is not activated, you can click one of the update buttons to preview the effect.

Show Original/Show Effects toggle Click Show Original to display the original rendered image without any of the effects applied. Click Show Effects to display the rendered image with the effects.

Update Scene Updates the Rendered Frame Window with all changes made in Rendering Effects as well as any changes made to the scene itself.

Update Effect Manually updates the preview Rendered Frame Window when Interactive is not on. What is shown in the Rendered Frame Window is only an update of any changes made in Rendering Effects. Any changes made to the scene itself will not be rendered.

Merging Effects

Rendering menu > Effects > Environment and Effects dialog > Effects panel > Merge

The Merge button on the Effects panel on page 7058 lets you merge effects from other 3ds Max (.max) scene files.

See also:

- Merge on page 7572
- Replace on page 7578
- Merge Animation on page 4126
Procedures

To merge an atmospheric effect:
1. Choose Rendering menu > Effects to display the Effects panel.
2. On the Effects rollout, click Merge.
   A Merge Effect dialog appears for file selection.
3. Choose a MAX file.
   A Merge Atmospheric Effects dialog lists the effects in the specified file.
4. Select one or more of the effects, and then click OK to merge them into the scene.
   Only atmospheric effects appear in the merge list, but when an effect is merged, any lights or gizmos bound to the effect are merged as well.

To resolve conflicts when merged effects have the same name:

- If an effect of the same type and name already exists in the scene, an alert appears. Choose from among these options:
  - Name field  Allows you to rename the incoming effect.
  - Merge  Results in two effects in the scene with the same name.
  - Delete Old  Removes the existing effect in the scene.
  - Apply To All Duplicates  Performs the same action on all subsequent matching effects.

Hair And Fur Render Effect

Rendering menu > Effects > Environment And Effects dialog > Effects panel
> Add > Add Effect dialog > Hair And Fur

Hair And Fur modifier > Tools rollout > Render Settings button

To render hair, the scene must contain a Hair And Fur render effect. The render effect is automatically added to the scene the first time you apply the Hair And Fur modifier to an object, or 3ds Max adds one (with default values) at render time if an active Hair And Fur modifier is applied to an object.
If for some reason the render effect doesn’t exist in the scene, you can add one by clicking the Render Settings button. This opens the Environment And Effects dialog and adds a Hair And Fur render effect. You can change the settings, or simply accept the default settings by closing the dialog after it opens.
Interface

<table>
<thead>
<tr>
<th>Hair Rendering Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hairs: buffer</td>
</tr>
<tr>
<td>Lighting: native</td>
</tr>
<tr>
<td>m Voxel Resolution: 5</td>
</tr>
<tr>
<td>Replace Reflections:</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Motion Blur</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duration: 1.5</td>
</tr>
<tr>
<td>Interval: middle</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Buffer Rendering Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Over-sampling: low</td>
</tr>
<tr>
<td>Tile Memory Usage: 70 Mb</td>
</tr>
<tr>
<td>Transparency Depth: 30</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Composite Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
</tr>
<tr>
<td>Gif</td>
</tr>
<tr>
<td>Normal</td>
</tr>
<tr>
<td>GBuffer</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Occlusion Objects</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto</td>
</tr>
<tr>
<td>All</td>
</tr>
<tr>
<td>Custom</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Global Illumination</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.0</td>
</tr>
<tr>
<td>5.0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Lighting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shadow Density: 1.0</td>
</tr>
<tr>
<td>Use all lights at render time: on</td>
</tr>
<tr>
<td>Add hair properties</td>
</tr>
<tr>
<td>Remove hair properties</td>
</tr>
</tbody>
</table>
Hair Rendering Options group

Hairs Sets the method to be used for rendering hair:

- **buffer** (The default) Procedural hair generated by Hair at render time based on the modifier parameters. Buffer hair is generated by a special renderer within Hair and offers the benefit of being able to create millions of hairs with minimal memory requirements. Only one hair is in memory at a time. Also, using Buffer render offers a variety of compositing options (described below).

- **geometry** Creates actual geometry for the rendered hair at render time. This geometry is assigned the material ID set by the Hair And Fur modifier > Geom Mat ID parameter on page 1125.

  **NOTE** “Geometry” hair derives its texture from the growth object, not from any maps applied via the Material Parameters rollout. Compositing options aren’t available with “geometry” hair.

  The “geometry” option works with both the default scanline renderer and the mental ray renderer.

- **mr prim** Hair is generated by a procedural mental ray shader that generates mental ray curve primitives directly into the mental ray rendering stream at render time.
  
  Choose this option only when you are rendering hair with the mental ray renderer on page 6675.

  **mr Voxel Resolution** Available only for the “geometry” and “mr prim” Hairs options. At render time, hair boundaries are subdivided into volume cubes or “voxels.” 3ds Max calculates which hairs are in each voxel, and when a ray enters a voxel, it calculates for those hairs. This allows unneeded voxels to be removed from memory during calculation.

  With “geometry” rendering, voxels are used only for calculating instanced hairs.

  This value gives the resolution of the subdivision. For example, a value of 3 subdivides the volume into 3 x 3 x 3 voxels, for a total of 27. The higher this value, the more efficient calculations can be. Default=5.

Lighting

- **native** (The default.) Uses standard 3ds Max calculations for light falloff.

- **emulation** Performs a simpler internal calculation for light falloff within the buffer render. It applies only to the buffer hair rendering itself, not the 3ds Max scene. This mode omits features such as illumination textures on
the hair, and light falloff calculation might be slightly inaccurate, but rendering is somewhat faster.

**Raytrace the Reflections/Refractions** Available only for the “buffer” Hairs option. When on, reflections and refractions are ray-traced. When off, they are calculated as usual. Turning this option on can increase realism at the cost of render time. Default=off.

**Motion Blur group**

In order to render motion-blurred hairs, Motion Blur must be enabled for the growth object.

**Duration** The number of frames over which motion blur is calculated for each frame.

**Interval** The point in the duration at which the “snapshot” of the hair is captured, before blurring. The choices are “start”, “middle”, and “end”. The default is “middle”, which causes blurring to occur at the start and end of the duration.

**Buffer Rendering Options group**

This setting applies only to the “buffer” rendering method on page 7064.

**Oversampling** Controls the level of antialiasing applied to the Hair “buffer” render. The available choices are “draft”, “low”, “medium”, “high”, and “maximum”. The “draft” setting uses no antialiasing; “high” is suitable for most final renders; in extreme cases, use “maximum”. The higher the Oversampling level, the greater the memory requirements and render time. Default=“low.”

**Tile Memory Usage** Sets the maximum amount of main memory to be used by a “tile.” Hair And Fur renders hair one tile at a time. Default = 70 Megabytes.

**TIP** We recommend that you increase the value of Tile Memory Usage to 100.

**Transparency Depth** Sets a maximum depth for rendering transparent or translucent hairs. Default=30.
Composite Method group

This option lets you choose the method by which Hair composites hair with the rest of the scene. Compositing options are available only with the “buffer” rendering method.

- **None** Renders the hair only, with occlusion. The resulting image is ready to composite.
- **Off** Renders hair shadows but not the hair.
- **Normal** (The default.) Does standard rendering and composites the occluded hair with the rest of the scene in the Rendered Frame Window. Because of the occlusion, hair will not appear behind (through) transparent objects.
- **GBuffer** Buffer-rendered hair appears behind most transparent objects. Transparent refractive objects aren’t supported.

Occlusion Objects group

This setting lets you choose which objects will occlude hair in the scene; that is, if the object is closer to the camera than part of the hair array, the hairs behind it won’t render. By default, all objects in the scene occlude hair behind them.

- **Auto** (The default.) All renderable objects in the scene occlude hair behind them.
- **All** All objects in the scene, including non-renderable objects, occlude hair behind them.
- **Custom** Lets you specify the objects that will occlude hair. Choosing this option makes the buttons on the right slide of the list available. If you choose Custom but don’t specify any occlusion objects, no objects will occlude the hair; that is, the hair will appear in front of all objects, whether or not it’s closer to the camera than the objects.

**List** The list of custom occlusion objects. To edit this list, choose Custom and then use the buttons on the right side of the list.

**Add** Adds a single object to the list. Click Add and then in a viewport, click the object to add.
Add List Adds multiple objects to the list. Click Add List and then in a viewport, click each object to add in turn. To finish, right-click the viewport or click Add List again to turn it off.

Replace To replace an object in the list, highlight its name in the list, click Replace, and then in a viewport click the replacement object.

Delete To remove an object from the list, highlight its name in the list and then click Delete.

Global Illumination group

Apply Skylight When on, Hair And Fur supports takes sky light into account, provided it is present in the scene. Default=off.

Multiplier Available only when Skylight is turned on. This Multiplier value lets you adjust the amount of sky light that is used when rendering hair.

Lighting group

These settings control the illumination of hair and shadow-casting from hair by supported lights in the scene.

The following light types are not supported when rendering hair with the “buffer” method: Skylight, mr Area Omni, mr Area Spot, IES Sun, IES Sky, mr Sky and mr Sun. However, mr Area Omni, mr Area Spot, mr Sky, and mr Sun are supported for hair when you use the “mr prim” method and the mental ray renderer.

NOTE For the purposes of rendering shadows in hair, Direct lights are treated as point (omni) lights.

Shadow Density Specifies the relative darkness of the shadows. At the default, highest value, 100.0, shadows are darkest. At the lowest value, 0.0, shadows are fully transparent, so they don't render. Range=0.0 to 100.0. Default=100.0.

Use all lights at render time When on, causes all supported lights in the scene to illuminate and cast shadows from hair when the scene is rendered. (Shadows are cast only from lights whose Shadows toggle is on.) When off, for a light to cast shadows from hair, you explicitly must add hair properties. In either case, shadow maps for hair use the settings from the Hair Light Attributes rollout on page 5443 Default=on.

NOTE These settings apply only to “buffer”-rendered hair (the default type, set in the Hair Rendering Options group, as described above).
Add hair properties  Adds the Hair Light Attributes rollout on page 5443 to selected lights in the scene. If you want to assign hair-specific shadow properties on a per-light basis, this rollout is necessary. Available only when at least one supported light is selected.

When Use All Lights At Render Time is off, only lights with hair properties can illuminate hair.

Remove hair properties  Removes the Hair Light Attributes rollout on page 5443 from selected lights in the scene. Available only when at least one light with hair properties added is selected.

Lens Effects Rendering Effects

Rendering menu > Effects > Environment and Effects dialog > Effects panel > Add > Add Effect dialog > Lens Effects


Lens flares added as lens effects
Procedures

To add an effect:

1 Select the desired effect from the list on the left side of the Lens Effects Parameters rollout.
2 Click the (>) arrow button to move it into the column on the right.

To delete an applied effect:

1 Select the effect from the list on the right side of the Lens Effects Parameters rollout.
2 Click the (<) arrow button to remove it from the list.

Interface

Lens Effects Parameters rollout

The Lens Effects system allows you to apply effects to your rendered image by choosing a particular effect from the list on the left and adding it to the list on the right. Each effect has its own rollout of parameters, but all effects share two panels of global parameters.
Lens Effects Globals rollout, Parameters panel

**Load** Displays the Load Lens Effects file dialog that enables you to open an LZV file. The LZV file format contains information saved from a previous configuration of Lens Effects. This allows you to load and use Lens Effects that have been saved from previous sessions of 3ds Max.

**Save** Displays the Save Lens Effects file dialog that enables you to save an LZV file. The LZV file format contains information saved from a previous configuration of Lens Effects. This allows you to save several types of Lens Effects and use them in multiple 3ds Max scenes.

**NOTE** Saving an effect as an LZV file will only save the attributes of the effect on the frame that it is saved at. The LZV file format doesn’t save the animation keys of an animated parameter.

**Size** Affects the size of the overall Lens Effect. This value is a percentage of the size of the rendered frame.

**Intensity** Controls the overall brightness and opacity of the Lens Effect. Higher values produce a bright, more opaque effect, and lower values produces a dim, transparent effect.
Seed Gives the random number generator in Lens Effects a different starting point, which creates a slightly different Lens Effect without changing any settings. Using Seed guarantees a different Lens Effect, even if the differences are very small. For example, if you set up a Ray effect, you will get slightly different rays in the lens flare if you adjust the seed value.

Angle Affects the amount that the Lens Effect rotates from its default position, as the position of the effect changes relative to the camera.

Squeeze Squeezes the size of the overall Lens Effect, either horizontally or vertically to compensate for different frame aspect ratios. Positive values stretch the effect horizontally, and negative values stretch it vertically. The value is a percentage of the size of the flare. Range=100 to -100.

Lights group

Allows you to choose lights to apply Lens Effects to.

Pick Light Enables you to select a light directly through the viewports. You can also select a light by pressing H to open the Pick Object dialog.

Remove Light Removes a selected light.

Drop-down list Provides quick access to lights that you have added to the Lens Effect.
Lens Effects Globals rollout, Scene panel

Affect Alpha Specifies whether or not the Lens Effect affects the alpha channel of an image when the image is rendered in a 32-bit file format. The alpha channel is an extra 8 bits of color (256 colors) that indicate transparency in an image. Alpha channels are used to composite one image seamlessly over the top of another. If you want to composite a Lens Effect, or an image that contains a Lens Effect, over the top of another image, enable this option. If you are not rendering to a 32-bit file, do not enable this option.

Affect Z Buffer Stores an object's distance from the camera. The Z-Buffer is useful for optical effects. When this option is enabled, the linear distance of the Lens Effect is recorded, and can be used in special effects that make use of the Z-Buffer.

Distance Affects Allows distance from the camera or viewport to affect the size and/or the intensity of the effect.

Off-Center Affects Allows an effect that is off-center from the camera or viewport to affect the size and/or the intensity of the effect.

Direction Affects Allows direction of spot lights with respect to the camera or viewport to affect the size and/or the intensity of the effect.
The size and intensity of the effect are at a maximum when the light is pointed at the camera (or viewport).

**Occlusion group**

Occlusion is used to determine when a Lens Effect will be affected by an object that comes between the effect and the camera. By using two spinners to determine occlusion you can have scene objects realistically affect the look of your effect. The outer radius will determine when another scene object will begin to occlude and the inner radius will determine when the scene object will cause the effect to reach maximum occlusion.

**Inner Radius** Sets the inner radius around the effect that another scene object must intersect in order to completely occlude the effect.

**Outer Radius** Sets the outer radius around the effect that another scene object must intersect in order to begin to occlude the effect.

**Size** Decreases the size of the effect when being occluded.

**Intensity** Decreases the intensity of the effect when being occluded.

**Affected by Atmosphere** Allows Atmospheric Effects to occlude Lens Effects.

**Glow Lens Effect**

Rendering menu > Effects > Environment and Effects dialog > Effects panel > Add > Add Effect dialog > Lens Effects > Choose Glow, and click the (>) arrow button.

Glow lets you add a glowing aura around any assigned object. For example, for an exploding particle system, adding a glow to the particles makes them seem as though they are brighter and hotter.
Adding glow to the light

**WARNING** This effect is not supported by the mental ray renderer on page 6675.
Interface

Glow Element rollout, Parameters panel

Name Displays the name of the effect. With Lens Effects you can have many different effects under one instance of Lens Effects. To keep them in order, it is often necessary to name them to make sure that when you change parameters you are changing the parameters to the correct effect.

On Applies the effect to the rendered image when activated.

Size Determines the size of the effect.
**Intensity** Controls the overall brightness and opacity of the individual effect. Higher values produce a bright, more opaque effect, and lower values produce a dim, transparent effect.

**Glow Behind** Gives the effect the ability to be displayed behind objects in your scene.

**Occlusion** Determines how much the Lens Effects Scene Occlusion parameters will affect the particular effect. The value entered determines what percentage of occlusion set in the Lens Effects Globals panel will be applied.

**Squeeze** Determines whether the effect will be squeezed. When activated the effect will be squeezed according to Lens Effects Globals under the Parameters panel in the Squeeze spinner.

**Use Source Color** Mixes the source color of the light or object you are applying the effect to and the color or mapping set in the Radial Color or Circular Color parameters. A value of 0 uses only the values set in the Radial Color and Circular Color parameters while a value of 100 uses only the light or objects source color. Any value between 0 and 100 will render a mix between the source color and the effect’s color parameters.

### Radial Color group

The Radial Color settings affect the inner and outer colors of the effect. You can set the color swatches to set the inner and outer colors of the Lens Effect. You can also use bitmaps such as Gradient or Cellular to determine the radial color.

**Falloff Curve** Displays the Radial Falloff dialog on page 7133 in which you can set weights for the colors used in Radial Color. By manipulating the Falloff Curve you can make the effect use more of one color or map than the other. You can also use a map to determine the falloff when a light is used as a Lens Effects source.

### Circular Color group

Circular Color determines the color of the effect by using four different color swatches that are matched to the four quadrants of the effect. A map can also be used to determine circular color.

**Mix** Mixes colors set in Radial Color and colors set in Circular Color. Setting the spinner at 0 will only use values set in Radial Color while setting the spinner at 100 will only use values set in Circular Color. Any value between 0 and 100 will mix between the two values.
**Falloff Curve** Displays the Circular Falloff dialog on page 7126 in which you can set weights for the colors used in Circular Color. By manipulating the Falloff Curve you can make the effect use more of one color or map than another. You can also use a map to determine the falloff when a light is used as a Lens Effects source.

**Radial Size group**

Determines the radial size around the particular Lens Effect. Clicking the Size Curve button displays the Radial Size dialog on page 7137. Using the Radial Size dialog you can create points on a line and move those points along a graph to determine where the effect should be placed around the light or object. You can also use a map to determine where the effect should be placed. A check box is used to activate the map.

**Glow Element rollout, Options panel**

![Glow Element rollout](image-url)
**Apply Element To group**

**Lights** Applies the effect to lights picked in Lens Effects Globals under the Parameters tab in the Lights group box.

**Image** Applies the effect to the rendered image using parameters set in Image Sources.

**Image Centers** Applies to the center of an object or to portions of an object as determined by the Image Filters.

**Image Sources group**

**Object ID** Applies the Lens Effect to particular objects in your scene that have a corresponding G-Buffer on page 8589 (or Object) ID. The G-Buffer is a geometry buffer and can be defined when you right-click any object and select Properties from the menu. Then, set the Object Channel ID under the G-Buffer ID controls.

**Material ID** Applies the Lens Effect to an object or part of an object with a specific Material ID channel assigned to it. Assign the channel with the Material Editor > Material ID channel flyout on page 5694. The effect is applied only to areas of the geometry where that ID channel is present.

**TIP** In some cases you might want to apply different Lens Effects settings to different pieces of geometry or IDs. To accomplish this, add additional Lens Effects entries to the Lens Effects Parameters list. Then set each different Lens Effect entry to affect a different Material ID or Object ID and proceed.

**Unclamp** An unclamped color is brighter than pure white (255,255,255). 3ds Max keeps track of these "hot" areas which tend to show up when your scene contains bright metallic highlights or explosions. This spinner lets you determine the lowest pixel value that the Lens Effect is applied to. Pure white has a pixel value of 1. When this spinner is set to 1, any pixels with a value above 255 will be glowed. You can invert this value by clicking the I button to the right of the spinner.

**Surf Norm** Applies the Lens Effect to part of an object, based on the angle of the surface normal to the camera. A value of 0 is coplanar, or parallel to the screen. A value of 90 is normal, or perpendicular to the screen. If you set Surf Norm to 45, only surfaces with normal angles greater than 45 degrees will be glowed. You can invert this value by clicking the I button to the right of the spinner. This parameter can be animated.

**Whole** Applies the Lens Effect to the whole scene, not just a particular piece of geometry. This, in effect, makes each pixel in the scene a potential Lens
Effect source. The areas of the scene that have the Lens Effect applied to them are determined by the settings in the Image Filters group box.

**Alpha** Applies the Lens Effect to the alpha channel of an image. The transparency of an alpha channel is interpreted opposite that of the Mask channel. Range=0 to 255.

**Z Hi/Z Lo** Highlights objects based on their distance (Z-Buffer distance) from the camera. The Hi value is the maximum distance and the Lo value is the minimum. Any objects between these two Z-Buffer distances will be highlighted.

**Image Filters group**

Filters the Image Sources selections to let you control how the Lens Effect is applied. For example, you can have ten spheres in your scene, each with the same Object ID, but different colors. If you set the Image Source as the Object ID of the spheres, which selects all of the spheres, these will be the only objects in the scene that Lens Effects will apply an effect to.

However, now that Lens Effects knows where the pixels are that effects can be applied, it needs to know which ones to actually apply the effect to. Lens Effects uses the filter controls to find out which source pixels to apply the effect to.

**All** Selects all source pixels in the scene and applies the Lens Effect to them.

**Edge** Selects all source pixels along a boundary edge and applies the Lens Effect to them. Applying a Lens Effect along the edges of objects produces a soft halo that exists on both inside and outside edges of your object.

**Perimeter Alpha** Applies the Lens Effect only to the perimeter of an object based on its alpha channel. Selecting this option applies the effect only on the outside of an object without any spill on the interior. Whereas filtering by Edge produces a spill onto the object, Perimeter Alpha keeps all of the edges clean because it relies on the scene alpha channel to derive its effect.

**Perimeter** Applies the Lens Effect only to the perimeter of an object based on Edge interference. Although not as precise as Perimeter Alpha, you might need to use the Perimeter option at times when the alpha channel is unavailable.

**Bright** Filters the source objects based on their brightness values. The effect is only applied to objects with a brightness above the spinner setting. This option can be inverted by clicking the I button next to the spinner.
Hue Filters the source objects by their hue. Select the hue by clicking the color swatch next to the spinner. You can choose hue values from 0 to 255. The spinner beside the Hue color swatch lets you enter a variance level so that the glow can find several different hues in the same range as the chosen color.

**Additional Effects group**

Additional Effects allows you to apply maps such as Noise to your Lens Effect. You can display the Material/Map browser by clicking the long button next to the Apply check box.

Apply Applies the selected map when activated.

Radial Density Determines where and how much you would like the additional effects applied. Clicking the Radial Density button displays the Radial Density dialog on page 7130. Using the Radial Density dialog you can create points on a line and move those points along a graph to determine where the additional effect should be placed around the light. You can also use a map to determine where the additional effect should be placed.

**Ring Lens Effect**

Rendering menu > Effects > Environment and Effects dialog > Effects panel > Add > Add Effect dialog > Lens Effects > Choose Ring, and click the (>) arrow button.

The ring is a circular color band that surrounds the center of the source object.
Adding a ring to the light

**WARNING** This effect is not supported by the mental ray renderer on page 6675.
Interface

Ring Element rollout, Parameters panel

Name: Displays the name of the effect. With Lens Effects you can have many different effects under one instance of Lens Effects. To keep them in order, it is often necessary to name them to make sure that when you change parameters you are changing the parameters to the correct effect.

On: Applies the effect to the rendered image when activated. Default = on.

Size: Determines the size of the effect.
Intensity Controls the overall brightness and opacity of the individual effect. Higher values produce a bright, more opaque effect, and lower values produces a dim, transparent effect.

Plane Sets the location of the effect along the axis of the effect which extends from the center of the effect through the center of the screen.

Thickness Determines the thickness, in pixels, of the effect.

Glow Behind Gives the effect the ability to be displayed behind objects in your 3ds Max scene.

Occlusion Determines how much the Lens Effects Scene Occlusion parameters will affect the particular effect. The value entered determines what percentage of occlusion set in the Lens Effects Globals panel will be applied.

Squeeze Determines whether the effect will be squeezed. When activated the effect will be squeezed according to Lens Effects Globals under the Parameters panel in the Squeeze spinner.

Use Source Color Mixes the source color of the light or object you are applying the effect to with the color or mapping set in the Radial Color or Circular Color parameters. A value of 0 uses only the values set in the Radial Color and Circular Color parameters while a value of 100 uses only the light or objects source color. Any value between 0 and 100 will render a mix between the source color and the effect's color parameters.

Radial Color group

The Radial Color settings affect the inner and outer colors of the effect. You can set the color swatches to set the inner and outer colors of the Lens Effect. You can also use bitmaps such as gradient or cellular to determine the radial color.
Falloff Curve Displays the Radial Falloff dialog on page 7133 in which you can set weights for the colors used in Radial Color. By manipulating the Falloff Curve you can make the effect use more of one color or map than the other. You can also use a map to determine the falloff.

Circular Color group

Circular Color determines the color of the effect by using four different color swatches that are matched to the four quadrants of the effect. A map can also be used to determine circular color.
Ring using circular colors as seen in lower right inset

**Mix** Mixes colors set in Radial Color and colors set in Circular Color. Setting the spinner at 0 will only use values set in Radial Color while setting the spinner at 100 will only use values set in Circular Color. Any value between 0 and 100 will mix between the two values.
Ring using radial and circular colors mixed 50/50

**Falloff Curve** Displays the *Circular Falloff dialog* on page 7126 in which you can set weights for the colors used in Circular Color. By manipulating the Falloff Curve you can make the effect use more of one color or map than another. You can also use a map to determine the falloff when a light is used as a Lens Effects source.

**Radial Size group**

Determines the radial size around the particular Lens Effect. Clicking the Size Curve button displays the *Radial Size dialog* on page 7137. Using the Radial Size dialog you can create points on a line and move those points along a graph to determine where the effect should be placed around the light or object. You can also use a map to determine where the effect should be placed. A check box is used to activate the map.
Ring Element rollout, Options panel

Apply Element To

Lights  Applies the effect to lights picked in Lens Effects Globals under the Parameters tab in the Lights group box.

Image  Applies the effect to the rendered image using parameters set in Image Sources.

Image Centers  Applies to the center of an object or to portions of an object as determined by the Image Filters.

Image Sources group

Object ID  Applies the Lens Effect to particular objects in your scene that have a corresponding G-Buffer on page 8589 (or Object) ID. The G-Buffer is a geometry buffer and can be defined when you right-click any object and select Properties from the menu. Then, set the Object Channel ID under the G-Buffer ID controls.

Material ID  Applies the Lens Effect to an object or part of an object with a specific Material ID channel assigned to it. Assign the channel with the Material Editor > Material ID channel flyout on page 5694. The effect is applied only to areas of the geometry where that ID channel is present.
TIP In some cases you might want to apply different Lens Effects settings to different pieces of geometry or IDs. To accomplish this, add additional Lens Effects entries to the Lens Effects Parameters list. Then set each different Lens Effect entry to affect a different Material ID or Object ID and proceed.

Unclamp An unclamped color is brighter than pure white (255,255,255). 3ds Max keeps track of these "hot" areas which tend to show up when your scene contains bright metallic highlights or explosions. This spinner lets you determine the lowest pixel value that the Lens Effect is applied to. Pure white has a pixel value of 1. When this spinner is set to 1, any pixels with a value above 255 will be glowed. You can invert this value by clicking the I button to the right of the spinner.

Surf Norm Applies the Lens Effect to part of an object, based on the angle of the surface normal to the camera. A value of 0 is coplanar, or parallel to the screen. A value of 90 is normal, or perpendicular to the screen. If you set Surf Norm to 45, only surfaces with normal angles greater than 45 degrees will be glowed. You can invert this value by clicking the I button to the right of the spinner.

Whole Applies the Lens Effect to the whole scene, not just a particular piece of geometry. This, in effect, makes each pixel in the scene a potential Lens Effect source. The areas of the scene that have the Lens Effect applied to them are determined by the settings in the Image Filters group box.

Alpha Applies the Lens Effect to the alpha channel of an image. The transparency of an alpha channel is interpreted opposite that of the Mask channel. Range=0 to 255.

Z Hi/Z Lo Highlights objects based on their distance (Z-Buffer distance) from the camera. The Hi value is the maximum distance and the Lo value is the minimum. Any objects between these two Z-Buffer distances will be highlighted.

Image Filters group

Filters the Image Sources selections to let you control how the Lens Effect is applied. For example, you can have ten spheres in your scene, each with the same Object ID, but different colors. If you set the Image Source as the Object ID of the spheres, which selects all of the spheres, these will be the only objects in the scene that Lens Effects will apply an effect to.

However, now that Lens Effects knows where the pixels are that effects can be applied, it needs to know which ones to actually apply the effect to. Lens
Effects uses the filter controls to find out which source pixels to apply the effect to.

**All** Selects all source pixels in the scene and applies the Lens Effect to them.

**Edge** Selects all source pixels along a boundary edge and applies the Lens Effect to them. Applying a Lens Effect along the edges of objects produces a soft halo that exists on both inside and outside edges of your object.

**Perim(eter) Alpha** Applies the Lens Effect only to the perimeter of an object based on its alpha channel. Selecting this option applies the effect only on the outside of an object without any spill on the interior. Whereas filtering by Edge produces a spill onto the object, Perimeter Alpha keeps all of the edges clean because it relies on the scene alpha channel to derive its effect.

**Perim(eter)** Applies the Lens Effect only to the perimeter of an object based on Edge interference. Although not as precise as Perimeter Alpha, you might need to use the Perimeter option at times when the alpha channel is unavailable.

**Bright** Filters the source objects based on their brightness values. The effect is only applied to objects with a brightness above the spinner setting. This option can be inverted by clicking the I button next to the spinner.

**Hue** Filters the source objects by their hue. Select the hue by clicking the color swatch next to the spinner. You can choose hue values from 0 to 255. The spinner beside the Hue color swatch lets you enter a variance level so that the glow can find several different hues in the same range as the chosen color.

**Additional Effects group**

Additional Effects allows you to apply maps such as Noise to your Lens Effect. You can display the Material/Map browser by clicking the long button next to the Apply check box.

**Apply** Applies the selected map when activated.

**Radial Density** Determines where and how much you would like the additional effects applied. Clicking the Radial Density button displays the Radial Density dialog on page 7130. Using the Radial Density dialog you can create points on a line and move those points along a graph to determine where the additional effect should be placed around the light. You can also use a map to determine where the additional effect should be placed.
Ray Lens Effect

Rendering menu > Effects > Environment and Effects dialog > Effects panel > Add > Add Effect dialog > Lens Effects > Choose Ray, and click the (>) arrow button.

Rays are bright lines that radiate from the center of the source object, providing the illusion of extreme brightness for the object. Rays let you emulate scratches in the lens elements of a camera.

Adding rays to the light
Interface

Ray Element rollout, Parameters panel

Name: Displays the name of the effect. With Lens Effects you can have many different effects under one instance of Lens Effects. To keep them in order, it is often necessary to name them to make sure that when you change parameters you are changing the parameters to the correct effect.

On: Applies the effect to the rendered image when activated. Default = on.

Lens Effects Rendering Effects | 7091
**Size** Determines the size of the effect.

**Intensity** Controls the overall brightness and opacity of the individual effect. Higher values produce a bright, more opaque effect, and lower values produces a dim, transparent effect.

**Num** Specifies the overall number of rays that appear in the lens flare. Rays are randomly spaced around the radius.

**Angle** Specifies the angle for the rays. You can enter both positive and negative values so, when animated, the rays rotate in a clockwise or counterclockwise direction.

**Sharp** Specifies the overall sharpness of the rays. Higher numbers produce crisp, clean, and clear rays. Lower numbers produce more of a secondary glow look. Range=0 to 10.

**Glow Behind** Gives the effect the ability to be displayed behind objects in your 3ds Max scene.

**Occlusion** Determines how much the Lens Effects Scene Occlusion parameters will affect the particular effect. The value entered determines what percentage of occlusion set in the Lens Effects Globals panel will be applied.

**Squeeze** Determines whether the effect will be squeezed. When activated, the effect will be squeezed according to Lens Effects Globals under the Parameters panel in the Squeeze spinner.

**Use Source Color** Mixes the source color of the light or object you are applying the effect to and the color or mapping set in the Radial Color or Circular Color parameters. A value of 0 uses only the values set in the Radial Color and Circular Color parameters while a value of 100 uses only the light or objects source color. Any value between 0 and 100 will render a mix between the source color and the effect’s color parameters.

**Radial Color group**

The Radial Color settings affect the inner and outer colors of the effect. You can set the color swatches to set the inner and outer colors of the Lens Effect. You can also use bitmaps such as Gradient or Cellular to determine the radial color.

**Falloff Curve** Displays the Radial Falloff dialog on page 7133 in which you can set weights for the colors used in Radial Color. By manipulating the Falloff Curve you can make the effect use more of one color or map than the other. You can also use a map to determine the falloff when a light is used as a Lens Effects source.
Circular Color group

Circular Color determines the color of the effect by using four different color swatches that are matched to the four quadrants of the effect. A map can also be used to determine circular color.

Mix Allows you to mix between colors set in Radial Color and colors set in Circular Color. Setting the spinner at 0 will only use values set in Radial Color while setting the spinner at 100 will only use values set in Circular Color. Any value between 0 and 100 will mix between the two values.

Falloff Curve Displays the Circular Falloff dialog on page 7126 in which you can set weights for the colors used in Circular Color. By manipulating the Falloff Curve you can make the effect use more of one color or map than another. You can also use a map to determine the falloff when a light is used as a Lens Effects source.

Radial Size group

Determines the radial size around the particular Lens Effect. Clicking the Size Curve button displays the Radial Size dialog on page 7137. Using the Radial Size dialog you can create points on a line and move those points along a graph to determine where the effect should be placed around the light or object. You can also use a map to determine where the effect should be placed. A check box is used to activate the map.
**Ray Element rollout, Options panel**

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Options</th>
</tr>
</thead>
</table>

**Apply Element To group**

- **Lights** Applies the effect to lights picked in Lens Effects Globals under the Parameters tab in the Lights group box.
- **Image** Applies the effect to the rendered image using parameters set in Image Sources.
- **Image Centers** Applies to the center of an object or to portions of an object as determined by the Image Filters.

**Image Sources group**

- **Object ID** Applies the Lens Effect to particular objects in your scene that have a corresponding G-Buffer on page 8589 (or Object) ID. The G-Buffer is a geometry buffer and can be defined when you right-click any object and select Properties.
from the menu. Then, set the Object Channel ID under the G-Buffer ID controls.

**Material ID** Applies the Lens Effect to an object or part of an object with a specific Material ID channel assigned to it. Assign the channel with the Material Editor > Material ID channel flyout on page 5694. The effect is applied only to areas of the geometry where that ID channel is present.

**TIP** In some cases you might want to apply different Lens Effects settings to different pieces of geometry or IDs. To accomplish this, add additional Lens Effects entries to the Lens Effects Parameters list. Then set each different Lens Effect entry to affect a different Material ID or Object ID and proceed.

**Unclamp** An unclamped color is brighter than pure white (255,255,255). 3ds Max keeps track of these "hot" areas which tend to show up when your scene contains bright metallic highlights or explosions. This spinner lets you determine the lowest pixel value that the Lens Effect is applied to. Pure white has a pixel value of 1. When this spinner is set to 1, any pixels with a value above 255 will be glowed. You can invert this value by clicking the I button to the right of the spinner.

**Surf Norm** Applies the Lens Effect to part of an object, based on the angle of the surface normal to the camera. A value of 0 is coplanar, or parallel to the screen. A value of 90 is normal, or perpendicular to the screen. If you set Surf Norm to 45, only surfaces with normal angles greater than 45 degrees will be glowed. You can invert this value by clicking the I button to the right of the spinner.

**Whole** Applies the Lens Effect to the whole scene, not just a particular piece of geometry. This, in effect, makes each pixel in the scene a potential Lens Effect source. The areas of the scene that have the Lens Effect applied to them are determined by the settings in the Image Filters group.

**Alpha** Applies the Lens Effect to the alpha channel of an image. The transparency of an alpha channel is interpreted opposite that of the Mask channel. Range=0 to 255.

**Z Hi/Z Lo** Highlights objects based on their distance (Z-Buffer distance) from the camera. The Hi value is the maximum distance and the Lo value is the minimum. Any objects between these two Z-Buffer distances will be highlighted.

**Image Filters group**

Filters the Image Sources selections to let you control how the Lens Effect is applied. For example, you can have ten spheres in your scene, each with the
same Object ID, but different colors. If you set the Image Source as the Object ID of the spheres, which selects all of the spheres, these will be the only objects in the scene that Lens Effects will apply an effect to.

However, now that Lens Effects knows where the pixels are that effects can be applied, it needs to know which ones to actually apply the effect to. Lens Effects uses the filter controls to find out which source pixels to apply the effect to.

**All** Selects all source pixels in the scene and applies the Lens Effect to them. **Edge** Selects all source pixels along a boundary edge and applies the Lens Effect to them. Applying a Lens Effect along the edges of objects produces a soft halo that exists on both inside and outside edges of your object.

![Edge filter applied to rays emanating from object](image)

**Perimeter Alpha** Applies the Lens Effect only to the perimeter of an object based on its alpha channel. Selecting this option applies the effect only on the outside of an object without any spill on the interior. Whereas filtering by Edge produces a spill onto the object, Perimeter Alpha keeps all of the edges clean because it relies on the scene alpha channel to derive its effect.

**Perimeter** Applies the Lens Effect only to the perimeter of an object based on Edge interference. Although not as precise as Perimeter Alpha, you might need to use the Perimeter option at times when the alpha channel is unavailable.

**Bright** Filters the source objects based on their brightness values. The effect is only applied to objects with a brightness above the spinner setting. This option can be inverted by clicking the I button next to the spinner.
Hue Filters the source objects by their hue. Select the hue by clicking the color swatch next to the spinner. You can choose hue values from 0 to 255. The spinner beside the Hue color swatch lets you enter a variance level so that the glow can find several different hues in the same range as the chosen color.

**Additional Effects group**

Additional Effects allows you to apply maps such as Noise to your Lens Effect. You can display the Material/Map browser by clicking the long button next to the Apply check box.

Apply Applies the selected map when activated.

Radial Density Determines where and how much you would like the additional effects applied. Clicking the Radial Density button displays the Radial Density dialog on page 7130. Using the Radial Density dialog you can create points on a line and move those points along a graph to determine where the additional effect should be placed around the light. You can also use a map to determine where the additional effect should be placed.

**Auto Secondary Lens Effect**

Rendering menu > Effects > Environment and Effects dialog > Effects panel > Add > Add Effect dialog > Lens Effects > Choose Auto Secondary, and click the (>) arrow button.

Secondary flares are the small circles you would normally see coming out from the source of the lens flare along an axis relative to the camera position. These are caused by light refracting off the different lens elements in the camera. As the camera position changes relative to the source object, the secondary flares move.
Adding secondary flares to the light
Interface

Auto Secondary Element rollout, Parameters panel

Name Displays the name of the effect. With Lens Effects you can have many different effects under one instance of Lens Effects. To keep them in order, it
is necessary to name them to make sure that when you change parameters you are changing the parameters to the correct effect.

**On** Applies the effect to the rendered image when activated. Default = on.

**Min** Controls the minimum size of secondary flares in the current set. This number is defined as a percentage of the overall image.

**Max** Controls the maximum size of secondary flares in the current set. This number is defined as a percentage of the overall image.

**Axis** Defines the overall length of the axis the automatic secondary flares will be distributed along. Increasing the value creates more space between the flares, while decreasing the value creates less space between the flares. You can set the axis from 0 to 10 degrees.

**Intensity** Controls the overall brightness and opacity of the individual effect. Higher values produce a bright, more opaque effect, and lower values produces a dim, transparent effect.

**Qty** Controls the number of secondary flares that appear in the current set of flares.

**Use Source Color** Mixes the source color of the light or object you are applying the effect to with the color or mapping set in the Radial Color or Circular Color parameters. A value of 0 uses only the values set in the Radial Color and Circular Color parameters while a value of 100 uses only the light or objects source color. Any value between 0 and 100 will render a mix between the source color and the effect’s color parameters.

**Sides** Controls the shape of the secondary flares for the current set. The default is circular, but you can choose from 3- to 8-sided secondary flares.

**Occlusion** Determines how much the Lens Effects Scene Occlusion parameters will affect the particular effect. The value entered determines what percentage of occlusion set in the Lens Effects Globals panel will be applied.

**Presets (drop-down list)** Displays a list of preset values that can be selected and applied to the rendered scene.

**Squeeze** Determines whether the effect will be squeezed. When activated, the effect will be squeezed according to Lens Effects Globals under the Parameters panel in the Squeeze spinner.

**Radial Color group**

The Radial Color settings affect the inner and outer colors of the effect. You can set the color swatches to set the inner and outer colors of the Lens Effect.
Each color swatch has a percentage spinner that determines at what point that color should stop and the next should start. You can also use bitmaps such as gradient or cellular to determine the radial color.

**Falloff Curve** Displays the Radial Falloff dialog on page 7133 in which you can set weights for the colors used in Radial Color. By manipulating the Falloff Curve you can make the effect use more of one color or map than the other. You can also use a map to determine the falloff when a light is used as a Lens Effects source.

**Circular Color group**

Circular Color determines the color of the effect by using four different color swatches that are matched to the four quadrants of the effect. A map can also be used to determine circular color.

**Mix** Allows you to mix between colors set in Radial Color and colors set in Circular Color. Setting the spinner at 0 will only use values set in Radial Color while setting the spinner at 100 will only use values set in Circular Color. Any value between 0 and 100 will mix between the two values.

**Falloff Curve** Displays the Circular Falloff dialog on page 7126 in which you can set weights for the colors used in Circular Color. By manipulating the Falloff Curve you can make the effect use more of one color or map than another. You can also use a map to determine the falloff when a light is used as a Lens Effects source.

**Radial Size group**

Determines the radial size around the particular Lens Effect. Clicking the Size Curve button displays the Radial Size dialog on page 7137. Using the Radial Size dialog you can create points on a line and move those points along a graph to determine where the effect should be placed around the light or object. You can also use a map to determine where the effect should be placed. A check box is used to activate the map.
Auto Secondary Element rollout, Options panel

Apply Element To group

Lights Applies the effect to lights picked in Lens Effects Globals under the Parameters tab in the Lights group box.

Image Applies the effect to the rendered image using parameters set in Image Sources.

Image Centers Applies to the center of an object or to portions of an object as determined by the Image Filters.

Image Sources group

Object ID Applies the Lens Effect to particular objects in your scene that have a corresponding G-Buffer on page 8589 (or Object) ID. The G-Buffer is a geometry buffer and can be defined when you right-click any object and select Properties.
from the menu. Then, set the Object Channel ID under the G-Buffer ID controls.

**Material ID** Applies the Lens Effect to an object or part of an object with a specific Material ID channel assigned to it. Assign the channel with the Material Editor > Material ID channel flyout on page 5694. The effect is applied only to areas of the geometry where that ID channel is present.

**TIP** In some cases you might want to apply different Lens Effects settings to different pieces of geometry or IDs. To accomplish this, add additional Lens Effects entries to the Lens Effects Parameters list. Then set each different Lens Effect entry to affect a different Material ID or Object ID and proceed.

**Unclamp** An unclamped color is brighter than pure white (255,255,255). 3ds Max keeps track of these "hot" areas which tend to show up when your scene contains bright metallic highlights or explosions. This spinner lets you determine the lowest pixel value that the Lens Effect is applied to. Pure white has a pixel value of 1. When this spinner is set to 1, any pixels with a value above 255 will be glowed. You can invert this value by clicking the I button to the right of the spinner.

**Surf Norm** Applies the Lens Effect to part of an object, based on the angle of the surface normal to the camera. A value of 0 is coplanar, or parallel to the screen. A value of 90 is normal, or perpendicular to the screen. If you set Surf Norm to 45, only surfaces with normal angles greater than 45 degrees will be glowed. You can invert this value by clicking the I button to the right of the spinner.

**Whole** Applies the Lens Effect to the whole scene, not just a particular piece of geometry. This, in effect, makes each pixel in the scene a potential Lens Effect source. The areas of the scene that have the Lens Effect applied to them are determined by the settings in the Image Filters group box.

**Alpha** Applies the Lens Effect to the alpha channel of an image. The transparency of an alpha channel is interpreted opposite that of the Mask channel. Range=0 to 255.

**Z Hi/Z Lo** Highlights objects based on their distance (Z-Buffer distance) from the camera. The Hi value is the maximum distance and the Lo value is the minimum. Any objects between these two Z-Buffer distances will be highlighted.

**Image Filters group**

Filters the Image Sources selections to let you control how the Lens Effect is applied. For example, you can have ten spheres in your scene, each with the
same Object ID, but different colors. If you set the Image Source as the Object ID of the spheres, which selects all of the spheres, these will be the only objects in the scene that Lens Effects will apply an effect to.

However, now that Lens Effects knows where the pixels are that effects can be applied, it needs to know which ones to actually apply the effect to. Lens Effects uses the filter controls to find out which source pixels to apply the effect to.

**All** Selects all source pixels in the scene and applies the Lens Effect to them.

**Edge** Selects all source pixels along a boundary edge and applies the Lens Effect to them. Applying a Lens Effect along the edges of objects produces a soft halo that exists on both inside and outside edges of your object.

**Perimeter Alpha** Applies the Lens Effect only to the perimeter of an object based on its alpha channel. Selecting this option applies the effect only on the outside of an object without any spill on the interior. Whereas filtering by Edge produces a spill onto the object, Perimeter Alpha keeps all of the edges clean because it relies on the scene alpha channel to derive its effect.

**Perimeter** Applies the Lens Effect only to the perimeter of an object based on Edge interference. Although not as precise as Perimeter Alpha, you might need to use the Perimeter option at times when the alpha channel is unavailable.

**Bright** Filters the source objects based on their brightness values. The effect is only applied to objects with a brightness above the spinner setting. This option can be inverted by clicking the I button next to the spinner.

**Hue** Filters the source objects by their hue. Select the hue by clicking the color swatch next to the spinner. You can choose hue values from 0 to 255. The spinner beside the Hue color swatch lets you enter a variance level so that the glow can find several different hues in the same range as the chosen color.

**Additional Effects group**

Additional Effects allows you to apply maps such as Noise to your Lens Effect. You can display the Material/Map browser by clicking the long button next to the Apply check box.

**Apply** Applies the selected map when activated.

**Radial Density** Determines where and how much you would like the additional effects applied. Clicking the Radial Density button displays the Radial Density dialog on page 7130. Using the Radial Density dialog you can create points on a line and move those points along a graph to determine
where the additional effect should be placed around the light. You can also use a map to determine where the additional effect should be placed.

**Manual Secondary Lens Effect**

Rendering menu > Effects > Environment and Effects dialog > Effects panel > Add > Add Effect dialog > Lens Effects > Choose Manual Secondary, and click the (>) arrow button.

Manual secondary flares are additional secondary flares that are individually added to the lens flare. These can be used in addition to, or in place of auto secondary flares on page 7097.

You use Manual Secondary flares when you want to add unique flares that you don't want repeated.
Interface

Manual Secondary Element rollout, Parameters panel

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>Manual Secondary</td>
</tr>
<tr>
<td><strong>Size</strong></td>
<td>50.0</td>
</tr>
<tr>
<td><strong>Plane</strong></td>
<td>150.0</td>
</tr>
<tr>
<td><strong>Sides</strong></td>
<td>Circular</td>
</tr>
<tr>
<td><strong>Rainbow</strong></td>
<td>None</td>
</tr>
</tbody>
</table>

Radial Color

<table>
<thead>
<tr>
<th>Radial Color</th>
<th>90.0</th>
<th>92.0</th>
<th>95.0</th>
<th>98.0</th>
</tr>
</thead>
</table>

**Radial Map:** None

Faloff Curve: None

Circular Color

<table>
<thead>
<tr>
<th>Mix</th>
<th>0.0</th>
</tr>
</thead>
</table>

**Circular Color:** None

Faloff Curve: None

Radial Size

| Size Curve | None |

**Name** Displays the name of the effect. With Lens Effects you can have many different effects under one instance of Lens Effects. To keep them in order, it
is necessary to name them to make sure that when you change parameters you are changing the parameters to the correct effect.

**On** Applies the effect to the rendered image when activated. Default = on.

**Size** Determines the size of the effect.

**Intensity** Controls the overall brightness and opacity of the individual effect. Higher values produce a bright, more opaque effect, and lower values produces a dim, transparent effect.

**Plane** Controls the distance, in degrees, between the flare source and the manual secondary flare. By default, the flare plane exists at the center of the chosen node source. Positive values place the flare in front of the source, while negative values place the flare behind the flare source.

**Use Source Color** Mixes the source color of the light or object you are applying the effect to and the color or mapping set in the Radial Color or Circular Color parameters. A value of 0 uses only the values set in the Radial Color and Circular Color parameters while a value of 100 uses only the light or objects source color. Any value between 0 and 100 will render a mix between the source color and the effect’s color parameters.

**Sides** Controls the shape of the secondary flares for the current set. The default is circular, but you can choose from 3- to 8-sided secondary flares.

**Occlusion** Determines how much the Lens Effects Scene Occlusion parameters will affect the particular effect. The value entered determines what percentage of occlusion set in the Lens Effects Globals panel will be applied.

**Presets (drop-down list)** Displays a list of preset values that can be selected and applied to the rendered scene.

**Squeeze** Determines whether the effect will be squeezed. When activated, the effect will be squeezed according to Lens Effects Globals under the Parameters panel in the Squeeze spinner.

**Radial Color group**

The Radial Color settings affect the inner and outer colors of the effect. You can set the color swatches to set the inner and outer colors of the Lens Effect. You can also use bitmaps such as gradient or cellular to determine the radial color.

**Falloff Curve** Displays the Radial Falloff dialog on page 7133 in which you can set weights for the colors used in Radial Color. By manipulating the Falloff Curve you can make the effect use more of one color or map than the other.
You can also use a map to determine the falloff when a light is used as a Lens Effects source.

**Circular Color group**

Circular Color determines the color of the effect by using four different color swatches that are matched to the four quadrants of the effect. A map can also be used to determine circular color.

**Mix** Mixes colors set in Radial Color and colors set in Circular Color. Setting the spinner at 0 will only use values set in Radial Color while setting the spinner at 100 will only use values set in Circular Color. Any value between 0 and 100 will mix between the two values.

**Falloff Curve** Displays the Circular Falloff dialog on page 7126 in which you can set weights for the colors used in Circular Color. By manipulating the Falloff Curve you can make the effect use more of one color or map than another. You can also use a map to determine the falloff when a light is used as a Lens Effects source.

**Radial Size group**

Determines the radial size around the particular Lens Effect. Clicking the Size Curve button displays the Radial Size dialog on page 7137. Using the Radial Size dialog you can create points on a line and move those points along a graph to determine where the effect should be placed around the light or object. You can also use a map to determine where the effect should be placed. A check box is used to activate the map.
Manual Secondary Element rollout, Options panel

**Apply Element To group**

**Lights** Applies the effect to lights picked in Lens Effects Globals under the Parameters tab in the Lights group box.

**Image** Applies the effect to the rendered image using parameters set in Image Sources.

**Image Centers** Applies to the center of an object or to portions of an object as determined by the Image Filters.

**Image Sources group**

**Object ID** Applies the Lens Effect to particular objects in your scene that have a corresponding G-Buffer on page 8589 (or Object) ID. The G-Buffer is a geometry buffer and can be defined when you right-click any object and select Properties.
from the menu. Then, set the Object Channel ID under the G-Buffer ID controls.

**Material ID** Applies the Lens Effect to an object or part of an object with a specific Material ID channel assigned to it. Assign the channel with the Material Editor > Material ID channel flyout on page 5694. The effect is applied only to areas of the geometry where that ID channel is present.

**Tip** In some cases you might want to apply different Lens Effects settings to different pieces of geometry or IDs. To accomplish this, add additional Lens Effects entries to the Lens Effects Parameters list. Then set each different Lens Effect entry to affect a different Material ID or Object ID and proceed.

**Unclamp** An unclamped color is brighter than pure white (255,255,255). 3ds Max keeps track of these "hot" areas which tend to show up when your scene contains bright metallic highlights or explosions. This spinner lets you determine the lowest pixel value that the Lens Effect is applied to. Pure white has a pixel value of 1. When this spinner is set to 1, any pixels with a value above 255 will be glowed. You can invert this value by clicking the I button to the right of the spinner.

**Surf Norm** Applies the Lens Effect to part of an object, based on the angle of the surface normal to the camera. A value of 0 is coplanar, or parallel to the screen. A value of 90 is normal, or perpendicular to the screen. If you set Surf Norm to 45, only surfaces with normal angles greater than 45 degrees will be glowed. You can invert this value by clicking the I button to the right of the spinner.

**Whole** Applies the Lens Effect to the whole scene, not just a particular piece of geometry. This, in effect, makes each pixel in the scene a potential Lens Effect source. The areas of the scene that have the Lens Effect applied to them are determined by the settings in the Image Filters group box.

**Alpha** Applies the Lens Effect to the alpha channel of an image. The transparency of an alpha channel is interpreted opposite that of the Mask channel. Range=0 to 255.

**Z Hi/Z Lo** Highlights objects based on their distance (Z-Buffer distance) from the camera. The Hi value is the maximum distance and the Lo value is the minimum. Any objects between these two Z-Buffer distances will be highlighted.

**Image Filters group**

Filters the Image Sources selections to let you control how the Lens Effect is applied. For example, you can have ten spheres in your scene, each with the
same Object ID, but different colors. If you set the Image Source as the Object ID of the spheres, which selects all of the spheres, these will be the only objects in the scene that Lens Effects will apply an effect to.

However, now that Lens Effects knows where the pixels are that effects can be applied, it needs to know which ones to actually apply the effect to. Lens Effects uses the filter controls to find out which source pixels to apply the effect to.

**All** Selects all source pixels in the scene and applies the Lens Effect to them.

**Edge** Selects all source pixels along a boundary edge and applies the Lens Effect to them. Applying a Lens Effect along the edges of objects produces a soft halo that exists on both inside and outside edges of your object.

**Perimeter Alpha** Applies the Lens Effect only to the perimeter of an object based on its alpha channel. Selecting this option applies the effect only on the outside of an object without any spill on the interior. Whereas filtering by Edge produces a spill onto the object, Perimeter Alpha keeps all of the edges clean because it relies on the scene alpha channel to derive its effect.

**Perimeter** Applies the Lens Effect only to the perimeter of an object based on Edge interference. Although not as precise as Perimeter Alpha, you might need to use the Perimeter option at times when the alpha channel is unavailable.

**Bright** Filters the source objects based on their brightness values. The effect is only applied to objects with a brightness above the spinner setting. This option can be inverted by clicking the I button next to the spinner.

**Hue** Filters the source objects by their hue. Select the hue by clicking the color swatch next to the spinner. You can choose hue values from 0 to 255. The spinner beside the Hue color swatch lets you enter a variance level so that the glow can find several different hues in the same range as the chosen color.

### Additional Effects group

Additional Effects allows you to apply maps such as Noise to your Lens Effect. You can display the Material/Map browser by clicking the long button next to the Apply check box.

**Apply** Applies the selected map when activated.

**Radial Density** Determines where and how much you would like the additional effects applied. Clicking the Radial Density button displays the Radial Density dialog on page 7130. Using the Radial Density dialog you can create points on a line and move those points along a graph to determine
where the additional effect should be placed around the light. You can also use a map to determine where the additional effect should be placed.

**Star Lens Effect**

Rendering menu > Effects > Environment and Effects dialog > Effects panel > Add > Add Effect dialog > Lens Effects > Choose Star, and click the (>) arrow button.

A Star is larger than a Ray effect on page 7090 and is composed of 0 to 30 spokes, instead of hundreds like a ray.

![Adding a star to the light](image)

*Adding a star to the light*
**Interface**

**Star Element rollout, Parameters panel**

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Star</td>
</tr>
<tr>
<td>On</td>
<td>On</td>
</tr>
<tr>
<td>Size</td>
<td>200.0</td>
</tr>
<tr>
<td>Width</td>
<td>8.0</td>
</tr>
<tr>
<td>Taper</td>
<td>0.5</td>
</tr>
<tr>
<td>Qty</td>
<td>6</td>
</tr>
</tbody>
</table>

- **Name**: Displays the name of the effect. With Lens Effects, you can have many different effects under one instance of Lens Effects. To keep them in order, it is necessary to name them to make sure that when you change parameters you are changing the parameters to the correct effect.

- **On**: Applies the effect to the rendered image when activated.
**Size** Determines the size of the effect.

**Intensity** Controls the overall brightness and opacity of the individual effect. Higher values produce a bright, more opaque effect, and lower values produces a dim, transparent effect.

**Width** Specifies the width of the individual spokes, as a percentage of the overall frame.

**Angle** Sets the starting angle in degrees in which the star spokes point. You can enter both positive and negative values so, when animated, the star spokes rotate in a clockwise or counterclockwise direction.

**Taper** Controls the taper of the individual spokes of the star. Taper widens or narrows the tips of the individual star points. Low numbers create a sharp point, while high numbers flare the points.

**Sharp** Specifies the overall sharpness of the star. Higher numbers produce crisp, clean, and clear stars. Lower numbers produce more of a secondary glow look. Range=0 to 10.

**Qty** Specifies the number of spokes in the star effect. The default is 6. Spokes are spaced at equidistant points about the center of the flare.

**Glow Behind** Gives the effect the ability to be displayed behind objects in your 3ds Max scene.

**Occlusion** Determines how much the Lens Effects Scene Occlusion parameters will affect the particular effect. The value entered determines what percentage of occlusion set in the Lens Effects Globals panel will be applied.

**Squeeze** Determines whether the effect will be squeezed. When activated, the effect will be squeezed according to Lens Effects Globals under the Parameters panel in the Squeeze spinner.

**Use Source Color** Mixes the source color of the light or object you are applying the effect to and the color or mapping set in the Radial Color or Circular Color parameters. A value of 0 uses only the values set in the Radial Color and Circular Color parameters while a value of 100 uses only the light or objects source color. Any value between 0 and 100 will render a mix between the source color and the effect’s color parameters.

**Radial Color group**

The Radial Color settings affect the inner and outer colors of the effect. You can set the color swatches to set the inner and outer colors of the Lens Effect.
You can also use bitmaps such as gradient or cellular to determine the radial color.

**Falloff Curve** Displays the Radial Falloff dialog on page 7133 in which you can set weights for the colors used in Radial Color. By manipulating the Falloff Curve you can make the effect use more of one color or map than the other. You can also use a map to determine the falloff when a light is used as a Lens Effects source.

**Section Color group**

Selection Color determines the color of the effect by using three different color swatches that are matched to the three sections of the effect. A map can also be used to determine section color.

**Mix** Mixes colors set in Radial Color and colors set in Section Color. Setting the spinner at 0 will only use values set in Radial Color while setting the spinner at 100 will only use values set in Section Color. Any value between 0 and 100 will mix between the two values.

**Falloff Curve** Displays the Circular Falloff dialog on page 7126 in which you can set weights for the colors used in Section Color. By manipulating the Falloff Curve you can make the effect use more of one color or map than another. You can also use a map to determine the falloff when a light is used as a Lens Effects source.

**Radial Size group**

Determines the radial size around the particular Lens Effect. Clicking the Size Curve button displays the Radial Size dialog on page 7137. Using the Radial Size dialog you can create points on a line and move those points along a graph to determine where the effect should be placed around the light or object. You can also use a map to determine where the effect should be placed. A check box is used to activate the map.
Star Element rollout, Options panel

### Apply Element To group

- **Lights** Applies the effect to lights picked in Lens Effects Globals under the Parameters tab in the Lights group box.
- **Image** Applies the effect to the rendered image using parameters set in Image Sources.
- **Image Centers** Applies to the center of an object or to portions of an object as determined by the Image Filters.

### Image Sources group

- **Object ID** Applies the Lens Effect to particular objects in your scene that have a corresponding G-Buffer on page 8589 (or Object ID). The G-Buffer is a geometry buffer and can be defined when you right-click any object and select Properties.
from the menu. Then, set the Object Channel ID under the G-Buffer ID controls.

**Material ID** Applies the Lens Effect to an object or part of an object with a specific Material ID channel assigned to it. Assign the channel with the Material Editor > Material ID channel flyout on page 5694. The effect is applied only to areas of the geometry where that ID channel is present.

**TIP** In some cases you might want to apply different Lens Effects settings to different pieces of geometry or IDs. To accomplish this, add additional Lens Effects entries to the Lens Effects Parameters list. Then set each different Lens Effect entry to affect a different Material ID or Object ID and proceed.

**Unclamp** An unclamped color is brighter than pure white (255,255,255). 3ds Max keeps track of these "hot" areas which tend to show up when your scene contains bright metallic highlights or explosions. This spinner lets you determine the lowest pixel value that the Lens Effect is applied to. Pure white has a pixel value of 1. When this spinner is set to 1, any pixels with a value above 255 will be glowed. You can invert this value by clicking the I button to the right of the spinner.

**Surf Norm** Applies the Lens Effect to part of an object, based on the angle of the surface normal to the camera. A value of 0 is coplanar, or parallel to the screen. A value of 90 is normal, or perpendicular to the screen. If you set Surf Norm to 45, only surfaces with normal angles greater than 45 degrees will be glowed. You can invert this value by clicking the I button to the right of the spinner.

**Whole** Applies the Lens Effect to the whole scene, not just a particular piece of geometry. This, in effect, makes each pixel in the scene a potential Lens Effect source. The areas of the scene that have the Lens Effect applied to them are determined by the settings in the Image Filters group box.

**Alpha** Applies the Lens Effect to the alpha channel of an image. The transparency of an alpha channel is interpreted opposite that of the Mask channel. Range=0 to 255.

**Z Hi/Z Lo** Highlights objects based on their distance (Z-Buffer distance) from the camera. The Hi value is the maximum distance and the Lo value is the minimum. Any objects between these two Z-Buffer distances will be highlighted.

**Image Filters group**

Filters the Image Sources selections to let you control how the Lens Effect is applied. For example, you can have ten spheres in your scene, each with the
same Object ID, but different colors. If you set the Image Source as the Object ID of the spheres, which selects all of the spheres, these will be the only objects in the scene that Lens Effects will apply an effect to.

However, now that Lens Effects knows where the pixels are that effects can be applied, it needs to know which ones to actually apply the effect to. Lens Effects uses the filter controls to find out which source pixels to apply the effect to.

**All** Selects all source pixels in the scene and applies the Lens Effect to them.

**Edge** Selects all source pixels along a boundary edge and applies the Lens Effect to them. Applying a Lens Effect along the edges of objects produces a soft halo that exists on both inside and outside edges of your object.

**Perimeter Alpha** Applies the Lens Effect only to the perimeter of an object based on its alpha channel. Selecting this option applies the effect only on the outside of an object without any spill on the interior. Whereas filtering by Edge produces a spill onto the object, Perimeter Alpha keeps all of the edges clean because it relies on the alpha channel to derive its effect.

**Perimeter** Applies the Lens Effect only to the perimeter of an object based on Edge interference. Although not as precise as Perimeter Alpha, you might need to use the Perimeter option at times when the alpha channel is unavailable.

**Bright** Filters the source objects based on their brightness values. The effect is only applied to objects with a brightness above the spinner setting. This option can be inverted by clicking the I button next to the spinner.

**Hue** Filters the source objects by their hue. Select the hue by clicking the color swatch next to the spinner. You can choose hue values from 0 to 255. The spinner beside the Hue color swatch lets you enter a variance level so that the glow can find several different hues in the same range as the chosen color.

### Additional Effects group

Additional Effects allows you to apply maps such as Noise to your Lens Effect. You can display the Material/Map browser by clicking the long button next to the Apply check box.

**Apply** Applies the selected map when activated.

**Radial Density** Determines where and how much you would like the additional effects applied. Clicking the Radial Density button displays the Radial Density dialog on page 7130. Using the Radial Density dialog you can create points on a line and move those points along a graph to determine
where the additional effect should be placed around the light. You can also use a map to determine where the additional effect should be placed.

**Streak Lens Effect**

Rendering menu > Effects > Environment and Effects dialog > Effects panel > Add > Add Effect dialog > Lens Effects > Choose Streak, and click the (>) arrow button.

A streak is a wide band that runs through the center of the source object. In real camera work, it is produced when using anamorphic lenses to film a scene.

*Adding a streak to the light*
Interface

Streak Element rollout, Parameters panel

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name: Streak</td>
<td>☑ On</td>
</tr>
<tr>
<td>Size 50.0</td>
<td>Intensity 30.0</td>
</tr>
<tr>
<td>Width 2.0</td>
<td>Angle 0.0</td>
</tr>
<tr>
<td>Taper 0.5</td>
<td>Sharp 3.8</td>
</tr>
<tr>
<td>Glow Behind</td>
<td>Occlusion 100.0</td>
</tr>
<tr>
<td>Squeeze</td>
<td>Use Source Color 100.0</td>
</tr>
</tbody>
</table>

- Radial Color
  - Blue
  - White
  - None
  - Falloff Curve
  - None

- Section Color
  - Black
  - White
  - Black
  - None
  - Falloff Curve
  - None

- Radial Size
  - Size Curve
  - None

**Name** Displays the name of the effect. With Lens Effects, you can have many different effects under one instance of Lens Effects. To keep them in order, it is necessary to name them to make sure that when you change parameters you are changing the parameters to the correct effect.

**On** Applies the effect to the rendered image when activated.

**Size** Determines the size of the effect.
Intensity Controls the overall brightness and opacity of the individual effect. Higher values produce a bright, more opaque effect, and lower values produce a dim, transparent effect.

Width Specifies the width of the streak, as a percentage of the frame.

Angle Specifies the angle for the streak. You can enter both positive and negative values so, when animated, the streak rotates in a clockwise or counterclockwise direction.

Taper Controls the taper of the individual spokes of the streak. Taper widens or narrows the tips of the individual streak points. Low numbers create a sharp point, while high numbers flare the points.

Sharp Specifies the overall sharpness of the streak. Higher numbers produce crisp, clean, and clear streaks. Lower numbers produce more of a secondary glow look. Range=0 to 10.

Glow Behind Gives the effect the ability to be displayed behind objects in your 3ds Max scene.

Occlusion Determines how much the Lens Effects Scene Occlusion parameters will affect the particular effect. The value entered determines what percentage of occlusion set in the Lens Effects Globals panel will be applied.

Squeeze Determines whether the effect will be squeezed. When activated, the effect will be squeezed according to Lens Effects Globals under the Parameters panel in the Squeeze spinner.

Use Source Color Mixes the source color of the light or object you are applying the effect to and the color or mapping set in the Radial Color or Circular Color parameters. A value of 0 uses only the values set in the Radial Color and Circular Color parameters while a value of 100 uses only the light or objects source color. Any value between 0 and 100 will render a mix between the source color and the effect's color parameters.

Radial Color group

Falloff Curve Displays the Radial Falloff dialog on page 7133 in which you can set weights for the colors used in Radial Color. By manipulating the Falloff Curve you can make the effect use more of one color or map than the other. You can also use a map to determine the falloff when a light is used as a Lens Effects source.
Section Color group

Section Color determines the color of the effect by using three different color swatches that are matched to the three sections of the effect. A map can also be used to determine section color.

Mix  Mixes colors set in Radial Color and colors set in Section Color. Setting the spinner at 0 will only use values set in Radial Color while setting the spinner at 100 will only use values set in Section Color. Any value between 0 and 100 will mix between the two values.

Falloff Curve  Displays the Circular Falloff dialog on page 7126 in which you can set weights for the colors used in Section Color. By manipulating the Falloff Curve you can make the effect use more of one color or map than another. You can also use a map to determine the falloff when a light is used as a Lens Effects source.

Radial Size group

Determines the radial size around the particular Lens Effect. Clicking the Size Curve button displays the Radial Size dialog on page 7137. Using the Radial Size dialog you can create points on a line and move those points along a graph to determine where the effect should be placed around the light or object. You can also use a map to determine where the effect should be placed. A check box is used to activate the map.
**Apply Element To group**

- **Lights**: Applies the effect to lights picked in Lens Effects Globals under the Parameters tab in the Lights group box.
- **Image**: Applies the effect to objects that have a corresponding Object ID channel.
- **Image Centers**: Applies to the center of an object or to portions of an object as determined by the Image Filters.

**Image Sources group**

- **Object ID**: Applies the Lens Effect to particular objects in your scene that have a corresponding G-Buffer on page 8589 (or Object) ID. The G-Buffer is a geometry buffer and can be defined when you right-click any object and select Properties.
from the menu. Then, set the Object Channel ID under the G-Buffer ID controls.

**Material ID** Applies the Lens Effect to an object or part of an object with a specific Material ID channel assigned to it. Assign the channel with the Material Editor > Material ID channel flyout on page 5694. The effect is applied only to areas of the geometry where that ID channel is present.

**TIP** In some cases you might want to apply different Lens Effects settings to different pieces of geometry or IDs. To accomplish this, add additional Lens Effects entries to the Lens Effects Parameters list. Then set each different Lens Effect entry to affect a different Material ID or Object ID and proceed.

**Unclamp** An unclamped color is brighter than pure white (255,255,255). 3ds Max keeps track of these "hot" areas which tend to show up when your scene contains bright metallic highlights or explosions. This spinner lets you determine the lowest pixel value that the Lens Effect is applied to. Pure white has a pixel value of 1. When this spinner is set to 1, any pixels with a value above 255 will be glowed. You can invert this value by clicking the button to the right of the spinner.

**Surf Norm** Applies the Lens Effect to part of an object, based on the angle of the surface normal to the camera. A value of 0 is coplanar, or parallel to the screen. A value of 90 is normal, or perpendicular to the screen. If you set Surf Norm to 45, only surfaces with normal angles greater than 45 degrees will be glowed. You can invert this value by clicking the I button to the right of the spinner.

**Whole** Applies the Lens Effect to the whole scene, not just a particular piece of geometry. This, in effect, makes each pixel in the scene a potential Lens Effect source. The areas of the scene that have the Lens Effect applied to them are determined by the settings in the Image Filters group box.

**Alpha** Applies the Lens Effect to the alpha channel of an image. The transparency of an alpha channel is interpreted opposite that of the Mask channel. Range=0 to 255.

**Z Hi/Z Lo** Highlights objects based on their distance (Z-Buffer distance) from the camera. The Hi value is the maximum distance and the Lo value is the minimum. Any objects between these two Z-Buffer distances will be highlighted.

**Image Filters group**

Filters the Image Sources selections to let you control how the Lens Effect is applied. For example, you can have ten spheres in your scene, each with the
same Object ID, but different colors. If you set the Image Source as the Object ID of the spheres, which selects all of the spheres, these will be the only objects in the scene that Lens Effects will apply an effect to.

However, now that Lens Effects knows where the pixels are that effects can be applied, it needs to know which ones to actually apply the effect to. Lens Effects uses the filter controls to find out which source pixels to apply the effect to.

**All** Selects all source pixels in the scene and applies the Lens Effect to them.

**Edge** Selects all source pixels along a boundary edge and applies the Lens Effect to them. Applying a Lens Effect along the edges of objects produces a soft halo that exists on both inside and outside edges of your object.

**Perimeter Alpha** Applies the Lens Effect only to the perimeter of an object based on its alpha channel. Selecting this option applies the effect only on the outside of an object without any spill on the interior. Whereas filtering by Edge produces a spill onto the object, Perimeter Alpha keeps all of the edges clean because it relies on the scene alpha channel to derive its effect.

**Perimeter** Applies the Lens Effect only to the perimeter of an object based on Edge interference. Although not as precise as Perimeter Alpha, you might need to use the Perimeter option at times when the alpha channel is unavailable.

**Bright** Filters the source objects based on their brightness values. The effect is only applied to objects with a brightness above the spinner setting. This option can be inverted by clicking the I button next to the spinner.

**Hue** Filters the source objects by their hue. Select the hue by clicking the color swatch next to the spinner. You can choose hue values from 0 to 255. The spinner beside the Hue color swatch lets you enter a variance level so that the glow can find several different hues in the same range as the chosen color.

**Additional Effects group**

Additional Effects allows you to apply maps such as Noise to your Lens Effect. You can display the Material/Map browser by clicking the long button next to the Apply check box.

**Apply** Applies the selected map when activated.

**Radial Density** Determines where and how much you would like the additional effects applied. Clicking the Radial Density button displays the [Radial Density dialog](#) on page 7130. Using the Radial Density dialog you can create points on a line and move those points along a graph to determine...
where the additional effect should be placed around the light. You can also use a map to determine where the additional effect should be placed.

**Lens Effects Dialogs**

The topics in this section describe support dialogs that are common to the various lens effects.

**Circular Falloff Graph (Lens Effects)**

Rendering menu > Effects > Environment and Effects dialog > Effects panel > Add > Add Effect dialog > Lens Effects > Choose any effect, and click the (>) arrow button. > Parameters tab of the rollout for that effect > Falloff Curve (under the Circular or Section Color group)

The Circular Falloff graph allows you to add weight to a particular color applied to your Lens Effect. By weighting the colors that you apply you can choose to display more of one color than another. You can also make the transition of colors gradual from one color to the next or you can create a sharp edge to the transition.
The Circular Falloff graph has controls at the top for creating and moving points on a curve on the graph below. The curve represents the range of colors you have selected in the Circular Color group box to apply to the current Lens Effect. When you open the graph you will notice that there is already a line with a point on each end which represents the linear transition from one color to the next. By placing points along the curve, you can drag these points to increase or decrease a color's intensity or to eliminate it altogether.

Rings with different Circular Falloff settings
Buttons are available at the bottom of the graph that allow you to change the display of the graph. You can also manually enter a horizontal or vertical position by entering a value into the two entry boxes.

**Interface**

- **Move flyout**
  - **Move** Moves a selected point in any direction, limited by the unselected points on either side.
  - For a Bezier smooth point, you can move the point or either handle.
  - The Move function remains active until you click another button. The button is highlighted (by default, in yellow) while it is active.
  - **Move** Constrains movement to the horizontal.
  - **Move** Constrains movement to the vertical.

- **Scale Point button**
  - **Scale Point** Scales a point vertically. Click once to enable Scale Point.
The Scale Point function remains active until you click another button. The button is highlighted (by default, in yellow) while it is active.

**Add Point flyout**

*Add Point* Adds a Bezier corner point anywhere along the Circular Falloff curve. The point makes a sharp angle when moved.

Click once to enable Add Point. The Add Point function remains active until you click another button. The button is highlighted (by default, in yellow) while it is active.

*Add Point* Adds a Bezier smooth point anywhere along the Circular Falloff curve. Handles attached to the point create smooth curves when moved.

**TIP** When either Add Point button is active, you can use Ctrl+click to create the other type of point. This is an alternative to using the flyout.

**Delete Point button**

*Delete Point* Deletes the selected points.

**Navigation controls (Status bar)**

*Horizontal Position* Allows you to manually enter a horizontal position value for a selected point.

*Vertical Position* Allows you to manually enter a vertical position value for a selected point.

*Pan* Allows you to click and drag the Circular Falloff graph window to move it left and right or up and down. Click once to enable panning. Pan remains active until you click another button. The button is highlighted (by default, in yellow) while it is active.
**Zoom Extents** Fits the curve within the graph window both vertically and horizontally so that the entire curve is visible.

**Zoom Horizontal Extents** Fits the curve horizontally within the graph window so that the full length of the curve is visible.

**Zoom Vertical Extents** Fits the curve vertically within the Circular Falloff graph window so that the full height of the curve is visible.

**Zoom Horizontally** Scales the Circular Falloff graph horizontally.

**Zoom Vertically** Scales the Circular Falloff graph vertically.

**Zoom** Zooms in and out of the entire Circular Falloff graph window.

**Zoom Region** Allows you to drag a region in the Circular Falloff graph window and scale that region to fill the window.

### Radial Density Dialog (Lens Effects)

Rendering menu > Effects > Environment and Effects dialog > Effects panel > Add > Add Effect dialog > Lens Effects > Choose any effect, and click the (>) arrow button. > Options tab of the rollout for that effect > Radial Density (under the Additional Effects group)

The Radial Density dialog allows you to add weight to any additional effect applied to the Lens Effect. By weighting the density of the additional effect that you apply you can choose particular areas in the effect to display more of the additional effect or to eliminate it altogether. You can also use Radial Density to gradually fade the additional effect from maximum density down to zero or you can create a sharp edge to the transition.
The Radial Density dialog has controls at the top for creating and moving Points on a curve on the graph below. The curve represents the density of the additional effect being applied to the Lens Effect. When you open the dialog you will notice that there is already a line with a Point on each end which represents the density of the effect. The default falloff is a fade from a density value of 1 starting from the center of the effect toward the outer edges which has a value of 0. This produces an effect with more density being rendered at the center of the effect and a gradual fading out to no density at the edges. By placing Points along the curve, you can drag these points to increase or decrease the density of an additional effect or eliminate it in some areas altogether.

Buttons are available at the bottom of the dialog that allow you to change the display of the dialog. You can also manually enter a horizontal or vertical position by entering a value into the two entry boxes.
Interface

Toolbar

**Move** Moves selected points in any direction. Click and hold the Move button to display the flyout where you can select a button to move in any direction, move only in the horizontal direction, or move only in the vertical direction. The Move function remains active until you click another button. The button is yellow while it is active.

**Scale Point** Vertically scales a point up or down. Click once to enable Scale Point. The Scale Point function remains active until you click another button. The button is yellow while it is active.

**Add Point** Allows you to add points anywhere along the Radial Density curve. Click and hold the Add Point button to display the flyout where you can select a button to add either a Corner Point or a Bezier Point. Click once to enable Add Point. The Add Point function remains active until you click another button. The button is yellow while it is active.

**Delete Point** Deletes selected points.

Status Bar

**Horizontal Position** Allows you to manually enter a horizontal position value for a selected point.

**Vertical Position** Allows you to manually enter a vertical position value for a selected point.

**Pan** Allows you to click and drag the Radial Density dialog window to move it left and right or up and down. Click once to enable panning. Pan remains active until you click another button. The button is yellow while it is active.

**Zoom Extents** Fits the curve within the dialog window both vertically and horizontally so that the entire curve is visible.
**Zoom Horizontal Extents** Fits the curve horizontally within the dialog window so that the full length of the curve is visible.

**Zoom Vertical Extents** Fits the curve vertically within the Radial Density dialog window so that the full height of the curve is visible.

**Zoom Horizontally** Scales the width of the Radial Density dialog window.

**Zoom Vertically** Scales the length of the Radial Density dialog window.

**Zoom** Zooms in and out of the entire Radial Density dialog window.

**Zoom Region** Allows you to drag a region in the Radial Density dialog window and scale that region to fill the window.

---

**Radial Falloff Dialog (Lens Effects)**

Rendering menu > Effects > Environment and Effects dialog > Effects panel > Add > Add Effect dialog > Lens Effects > Choose any effect, and click the (> arrow button. > Parameters tab of the rollout for that effect > Falloff Curve (under the Radial Color group)

The Radial Falloff dialog allows you to add weight to a particular color applied to your Lens Effect. By weighting the colors that you apply you can choose to display more of one color than another. You can also make the transition of colors gradual from one color to the next or you can create a sharp edge to the transition.
Rings with different Radial Falloff settings

The Radial Falloff graph has controls at the top for creating and moving Points on a curve on the graph below. The curve represents the range of colors you have selected in the Radial Color group box to apply to the current Lens Effect. When you open the dialog you will notice that there is already a line with a Point on each end which represents the linear transition from one color to the next. The default falloff is a fade from one color at a value of one to the other color which ends at a value of zero. This produces an effect with more intensity on the first color and a considerable fading out of the second color.
By placing Points along the curve, you can drag these points to increase or decrease a color's intensity or to eliminate it altogether.

Buttons are available at the bottom of the dialog that allow you to change the display of the dialog. You can also manually enter a horizontal or vertical position by entering a value into the two entry boxes.

Interface

Toolbar

- **Move** Moves selected points in any direction. Click and hold the Move button to display the flyout where you can select a button to move in any direction, move only in the horizontal direction, or move only in the vertical direction. The Move function remains active until you click another button. The button is yellow while it is active.

- **Scale Point** Vertically scales a point up or down. Click once to enable Scale Point. The Scale Point function remains active until you click another button. The button is yellow while it is active.

- **Add Point** Allows you to add points anywhere along the Circular Falloff curve. Click and hold the Add Point button to display the flyout where you can select a button to add either a Corner Point or a Bezier Point. Click once to enable Add Point. The Add Point function remains active until you click another button. The button is yellow while it is active.
Delete Point Deletes selected points.

Status Bar

Horizontal Position Allows you to manually enter a horizontal position value for a selected point.

Vertical Position Allows you to manually enter a vertical position value for a selected point.

Pan Allows you to click and drag the Radial Falloff graph to move it left and right or up and down. Click once to enable panning. Pan remains active until you click another button. The button is yellow while it is active.

Zoom Extents Fits the curve within the dialog window both vertically and horizontally so that the entire curve is visible.

Zoom Horizontal Extents Fits the curve horizontally within the dialog window so that the full length of the curve is visible.

Zoom Vertical Extents Fits the curve vertically within the Radial Falloff graph so that the full height of the curve is visible.

Zoom Horizontally Scales the width of the Radial Falloff graph.

Zoom Vertically Scales the length of the Radial Falloff graph.

Zoom Zooms in and out of the entire Radial Falloff graph.

Zoom Region Allows you to drag a region in the Radial Falloff graph and scale that region to fill the window.
Radial Size Dialog (Lens Effects)

Rendering menu > Effects > Environment and Effects dialog > Effects panel > Add > Add Effect dialog > Lens Effects > Choose any effect, and click the (>) arrow button. > Parameters tab of the rollout for that effect > Falloff Curve (under the Radial Size group)

The Radial Size dialog gives you the ability to determine the size of your Lens Effect. The Radial Size dialog displays a curve with a point on each end which represents the Radial Size of your Lens Effect. The default position of the curve is one which means the Lens Effect will have the same radius around the center of the effect.
Objects with different Radial Sizes settings applied to Glow

By adding and moving points along the curve you can make areas of the effect extend further by moving a point above a value of one on the graph. You can also diminish areas of the effect by moving a point between one and zero on the graph. Finally, you can eliminate areas of the effect by moving a point below zero on the graph.
Buttons are available at the bottom of the dialog that allow you to change the display of the dialog. You can also manually enter a horizontal or vertical position by entering a value in the two entry boxes.

Interface

Toolbar

- **Move** Moves selected points in any direction. Click and hold the Move button to display the flyout where you can select a button to move in any direction, move only in the horizontal direction, or move only in the vertical direction. The Move function remains active until you click another button. The button is yellow while it is active.

- **Scale Point** Vertically scales a point up or down. Click once to enable Scale Point. The Scale Point function remains active until you click another button. The button is yellow while it is active.

- **Add Point** Allows you to add points anywhere along the Radial Size curve. Click and hold the Add Point button to display the flyout where you can select a button to add either a Corner Point or a Bezier Point. Click once to enable Add Point. The Add Point function remains active until you click another button. The button is yellow while it is active.

- **Delete Point** Deletes selected points.
**Status Bar**

**Horizontal Position** Allows you to manually enter a horizontal position value for a selected point.

**Vertical Position** Allows you to manually enter a vertical position value for a selected point.

Pan Allows you to click and drag the Radial Size graph to move it left and right or up and down. Click once to enable panning. Pan remains active until you click another button. The button is yellow while it is active.

Zoom Extents Fits the curve within the dialog window both vertically and horizontally so that the entire curve is visible.

Zoom Horizontal Extents Fits the curve horizontally within the dialog window so that the full length of the curve is visible.

Zoom Vertical Extents Fits the curve vertically within the Radial Size graph so that the full height of the curve is visible.

Zoom Horizontally Scales the width of the Radial Size graph.

Zoom Vertically Scales the length of the Radial Size graph.

Zoom Zooms in and out of the entire Radial Size graph.

Zoom Region Allows you to drag a region in the Radial Size graph and scale that region to fill the window.
Blur Rendering Effect

Rendering menu > Effects > Environment and Effects dialog > Effects panel > Add > Add Effect dialog > Blur

The Blur effect allows you to blur your image in three different methods: Uniform, Directional, and Radial. Blur works on individual pixels according to selections made in the Pixel Selections panel. You can blur an entire image, non-background scene elements, by luminance value, or by using a map mask. Blur can give your animation added realism by rendering the illusion of object or camera movement.

Object before and after adding midrange Blur effect.
Interface

Blur Parameters rollout, Blur Type panel

<table>
<thead>
<tr>
<th>Blur Type</th>
<th>Pixel Radius (%)</th>
<th>Affect Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>Uniform</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Directional</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10.0</td>
<td>U Pixel Radius (%)</td>
<td>0.0</td>
</tr>
<tr>
<td>10.0</td>
<td>V Pixel Radius (%)</td>
<td>0.0</td>
</tr>
<tr>
<td>0</td>
<td>Rotation (°)</td>
<td></td>
</tr>
<tr>
<td>Radial</td>
<td></td>
<td></td>
</tr>
<tr>
<td>20.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>32.0</td>
<td>X Origin</td>
<td></td>
</tr>
<tr>
<td>24.0</td>
<td>Y Origin</td>
<td></td>
</tr>
<tr>
<td>Use Object Center</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Affect Alpha</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Uniform Applies the Blur effect evenly across the entire rendered image.

Pixel Radius Determines the intensity of the Blur effect. Increasing the value increases the number of surrounding pixels that each pixel will use to compute its blur. The more pixels used means a greater blur for the image.

Affect Alpha Applies the Uniform Blur effect to the alpha channel when turned on.

Directional Applies the Blur effect in any direction according to the Directional parameters. The U Pixel Radius and Trail blur the pixels horizontally while the V Pixel Radius and Trail blur the pixels vertically. Rotation is used to rotate the axis of the horizontal and vertical blurring.

U Pixel Radius Determines the horizontal intensity of the Blur effect. Increasing the value increases the number of surrounding pixels that each pixel will use to compute its blur. The more pixels used means a greater horizontal blur for the image.
U Trail Adds “direction” to your blur by weighting more blur to either side of the U axis. This adds a streaking effect and creates the illusion that your objects or your camera are rapidly moving in a particular direction.

V Pixel Radius Determines the vertical intensity of the Blur effect. Increasing the value increases the number of surrounding pixels that each pixel will use to compute its blur, and creates a greater vertical blur for the image.

V Trail Adds “direction” to your blur by weighting more blur to either side of the V axis. This adds a streaking effect and creates the illusion that your objects or your camera are rapidly moving in a particular direction.

Rotation Rotates the axis of the U and V pixels that will be blurred by the U and V Pixel Radius spinners. By using Rotation with the U and V Pixel Radius spinners you can have the Blur effect applied to any direction in your rendered image. When rotation is 0, U corresponds to the image’s X axis and V corresponds to the image’s Y axis.

Affect Alpha Applies the Directional Blur effect to the Alpha channel when turned on.

Radial Applies the Blur effect radially. Using the Radial parameters you can define a point within your rendered image to use as the center of the Radial Blur. You can use an object as the center or an arbitrary location set by the X and Y Origin spinners. The Blur effect will apply the least amount of blur to the center origin of the effect and gradually increase the blur to the pixels further away from the center. This can be used to simulate motion blur caused by camera zoom.

Pixel Radius Determines the intensity of the Radius Blur effect. Increasing the value increases the number of surrounding pixels that each pixel will use to compute its blur. The more pixels used means a greater blur for the image.

Trail Adds “direction” to your blur by weighting more or less blur toward the center of the Blur effect. This adds a streaking effect and creates the illusion that your objects or your camera are rapidly moving in a particular direction.

X/Y Origin Specifies the center of the blur, in pixels, with respect to the dimensions of the rendered output.

None Lets you specify an object whose center serves as the center of the blur effect. Click this, select an object, and then turn on Use Object Center. The object name appears on the button.

Clear Removes the object name from the button above.

Use Object Center When on, the object specified by the None button (tooltip: Pick an object to center on.) serves as the center of the blur effect. If no object
is specified and Use Object Center is on, no blur is added to the rendered image.

**Affect Alpha** Applies the Radial Blur effect to the Alpha channel when turned on.
Blur Parameters rollout, Pixel Selections panel

<table>
<thead>
<tr>
<th>Blur Type</th>
<th>Pixel Selections</th>
</tr>
</thead>
<tbody>
<tr>
<td>Whole Image</td>
<td>Brighten (%)</td>
</tr>
<tr>
<td>0.0</td>
<td>100.0</td>
</tr>
<tr>
<td>Non-Background</td>
<td>Brighten (%)</td>
</tr>
<tr>
<td>0.0</td>
<td>10.0</td>
</tr>
<tr>
<td>Luminance</td>
<td>Brighten (%)</td>
</tr>
<tr>
<td>0.0</td>
<td>100.0</td>
</tr>
<tr>
<td>Map Mask</td>
<td>Brighten (%)</td>
</tr>
<tr>
<td>None</td>
<td>Luminance</td>
</tr>
<tr>
<td>0.0</td>
<td>100.0</td>
</tr>
<tr>
<td>Object ID</td>
<td>Add</td>
</tr>
<tr>
<td>Delete</td>
<td>0.0</td>
</tr>
<tr>
<td>Material ID</td>
<td>Add</td>
</tr>
<tr>
<td>Replace</td>
<td>0.0</td>
</tr>
<tr>
<td>Delete</td>
<td>0.0</td>
</tr>
</tbody>
</table>
Whole Image  Affects the entire rendered image when chosen. This is useful when the Blur effect dims your rendered image. By using Brighten and Blend you can maintain the original colors of the scene.

Brighten  Brightens the entire image.

Blend  Blends the Blur effect and the Whole Image parameters with the original rendered image. This can be used to create a soft-focus effect.

Non-Background  Affects everything but the background image or animation when chosen. This is useful when the Blur effect has dimmed your scene objects but not the background. By Using Brighten, Blend, and Feather Radius, you can maintain the original colors of the scene.

Brighten  Brightens the rendered image except for the background image or animation.

Blend  Blends the Blur effect and the Non-Background parameters with the original rendered image.

Feather Radius  Feathers the Blur effect applied to the Non-Background elements of your scene. When using Non-Background as a Pixel Selection you will notice that the scene objects have a hard edge to their blur since the objects are being blurred but the background is not. Use the spinner to feather the blur and eliminate the hard edge of the effect.

Luminance  Affects any pixels that have luminance values that fall between it’s Min and Max spinners.

Brighten  Brightens pixels that fall between the Minimum and Maximum luminance values.

Blend  Blends the Blur effect and the Luminance parameters with the original rendered image.

Min  Sets the minimum luminance value necessary for each pixel in order for the Blur effect to be applied to the pixel.

Max  Sets the maximum luminance value a pixel can have in order for the Blur effect to be applied to the pixel.

Feather Radius  Feathers the Blur effect applied to pixels that fall between the Minimum and Maximum luminance values. When using Luminance as a Pixel Selection the Blur effect can create a hard edge on the effect. Use the spinner to feather the blur and eliminate the hard edge of the effect.

Map Mask  Applies the Blur effect according to the channel selected and mask applied through the Material/Map Browser. After selecting a mask you must
select a channel from the Channel list. Blur then examines the mask and channel according to the values set in the Minimum and Maximum spinners. Any pixels in the mask that are of the selected channel and between the Min and Max values will have the Blur effect applied. This is useful for blurring selected portions of a scene such as a winter morning as seen through a frost covered window.

**Channel** Selects a channel that the Blur effect will be applied to. After selecting a particular channel, use the minimum and maximum spinners to determine the value a mask pixel must have in order to have the effect applied to it.

**Brighten** Brightens the portions of the image that the Blur effect is applied to.

**Blend** Blends the Map Mask Blur effect with the original rendered image.

**Min** The minimum value (RGB, Alpha, or Luminance) a pixel must have in order to have the Blur effect applied to it.

**Max** The maximum value (RGB, Alpha, or Luminance) a pixel can have for the Blur effect to be applied to it.

**Feather Radius** Feathers the Blur effect applied to pixels that fall between the Minimum and Maximum channel values. When using map mask as a Pixel Selection, the Blur effect can create a hard edge on the effect. Use the spinner to feather the blur and eliminate the hard edge of the effect.

**Object ID** Applies the Blur effect to an object or part of an object with a specific Object ID (in the G-Buffer on page 8589), if the object matches the Filter settings. To add or replace an Object ID, use the spinners or enter a value in the ID text box and then click the appropriate button.

**Min Lum** The minimum luminance value a pixel must have in order to have the Blur effect applied to it.

**Max Lum** The maximum luminance value a pixel can have for the Blur effect to be applied to it.

**Brighten** Brightens the portion of the image that the Blur effect is applied to.

**Blend** Blends the Object ID Blur effect with the original rendered image.

**F. Radius** Feathers the Blur effect applied to pixels that fall between the Minimum and Maximum luminance values. When using Luminance as a Pixel Selection, the Blur effect can create a hard edge on the effect. Use the spinner to feather the blur and eliminate the hard edge of the effect.
Material ID Applies the Blur effect to a material or part of a material with a specific Material ID Channel on page 5694, if the material matches the Filter settings. To add or replace a Material ID channel, use the spinners or enter a value in the ID text box and then click the appropriate button.

Min Lum The minimum luminance value a pixel must have in order to have the Blur effect applied to it.

Max Lum The maximum luminance value a pixel can have for the Blur effect to be applied to it.

Brighten Brightens the portion of the image that the Blur effect is applied to.

Blend Blends the Material Blur effect with the original rendered image.

F. Radius Feathers the Blur effect applied to pixels that fall between the Minimum and Maximum luminance values. When using Luminance as a Pixel Selection, the Blur effect can create a hard edge on the effect. Use the spinner to feather the blur and eliminate the hard edge of the effect.

General Settings group
**Feather Falloff control curve**

The Feather falloff curve allows you to determine the feather falloff off the Blur effect based on a graph. You can add points to the graph to create a falloff curve, and adjust the interpolation in those points.

**Move** Lets you move the points on the graph. This button is a flyout, providing free movement (the default), horizontal, and vertical movement.

**Scale Point** Lets you scale the points on the graph. This moves each selected point vertically, in proportion to its previous value. Click a point to scale, or draw a selection rectangle around several contiguous points to select them, and then drag any point in the selection to scale them all.

**Add Point** Lets you create additional points on the falloff curve. This button is a flyout, providing linear points (the default) and Bezier points with handle.

**Delete Point** Removes points from the graph.

**Brightening** These radio buttons let you select additive or multiplicative brightening. Additive brightening is brighter and more distinct than multiplicative brightening. Additive brightening is useful when you use blur in combination with a **Glow effect** on page 7073. Multiplicative brightening provides a soft highlight to the Blur effect.

**Brighten Curve** Lets you edit the brightening curve in the Feather Falloff curve graph.

**Blend Curve** Lets you edit the blend curve in the Feather Falloff curve graph.

---

**Brightness and Contrast Rendering Effect**

Rendering menu > Effects > Environment and Effects dialog > Effects panel > Add > Add Effect dialog > Brightness and Contrast

Brightness And Contrast allows you to adjust the contrast and brightness of an image. This can be used to match rendered scene objects with background images or animations.
Above: Original rendering is too dark.
Below: Increasing both brightness and contrast improves clarity of the rendering.

**Interface**

The Brightness and Contrast Parameters rollout contains the following parameters.

**Brightness** Increases or decreases all color components (red, green, and blue). Range=0 to 1.0.

**Contrast** Compresses or expands the latitude between maximum black and maximum white. Range=0 to 1.0.
Ignore Background Applies the effect to everything in your 3ds Max scene except the background.

**Color Balance Rendering Effect**

Rendering menu > Effects > Environment and Effects dialog > Effects panel > Add > Add Effect dialog > Color Balance

The Color Balance Effect allows you to manipulate additive/subtractive color tinting through independent control of RGB channels.

Above: Color balance effect used to correct the color cast.
Below: Original rendering has a yellow cast.
Interface

The Color Balance Parameters rollout contains the following parameters:

Cyan/Red Adjusts the red channel.

Magenta/Green Adjusts the green channel.

Yellow/Blue Adjusts the blue channel.

Preserve Luminosity When on, retains the luminosity of the image while correcting the color.

Ignore Background When on, allows you to image correct a model without affecting the background.

File Output Rendering Effect

Rendering menu > Effects > Environment and Effects dialog > Effects panel > Add > Add Effect dialog > File Output

File Output allows you to take a “snapshot” of a rendering before some or all of the other Render Effects are applied, depending on the placement of File Output in the Render Effects stack. You can save different channels such as Luminance, Depth, or Alpha to a separate file while rendering an animation.
You can also use File Output to convert an RGB image into a different channel and send that image channel back into the Render Effects stack. The rest of the effects can then be applied to that channel.

**Interface**

![File Output Parameters](image)

**Destination group**

**Files** Opens a dialog so you can save the rendered image or animation to disk. The rendered output can be a still image or an animation, in one of the following file formats:

- [AVI File](#) on page 7832 (AVI)
BMP Image file on page 7834 (BMP)
Encapsulated PostScript on page 7839 format (EPS, PS)
JPEG File on page 7848 (JPG)
Kodak Cineon on page 7834 (CIN)
MOV QuickTime file on page 7849 (MOV)
PNG Image File on page 7862 (PNG)
RLA Image File on page 7873 (RLA)
RPF Image File on page 7875 (RPF)
SGI Image File Format on page 7877 (RGB)
Targa Image File on page 7878 (TGA, VDA, ICB, UST)
TIF Image File on page 7880 (TIF)

Devices  Opens a dialog so you can send the rendered output to a device such as a video recorder.

Clear  Clears any file or device selected in the Destination group box.

**Driver group**

These buttons are available only when you choose a device as the image source.

About  Provides information on the source of the image-handler software used to bring the image into 3ds Max.

Setup  Displays a setup dialog specific to the plug-in. Some plug-ins may not use this button.

**Parameters group**

Channel  Lets you choose which channel you wish to save or send back in to the Render Effects stack. Choose Whole Image, Luminance, Depth, or Alpha to display more options in the Parameters group box.

Affect Source Bitmap  When activated, this will take in an image with any effects previously applied, convert it to the channel selected, and send it back into the stack for the rest of the effects to be applied. Your rendered image will be saved in the channel selected. This parameter is not available to the Whole Image channel.

Active  Turns the File Output feature on and off. Unlike the Active check box available in the Render Effects rollout, this check box is animatable allowing you to save only desired portions of a rendered scene.
**Depth Parameters**

When Depth is selected as a channel, new parameters are available for determining what parts of the scene should be rendered into the Depth channel image.

**Copy** After choosing a camera with the None button, click Copy to use the camera’s clipping planes to determine which part of the scene should be rendered into the Depth channel image file.

**None** Enables you to select a camera to use for copying clipping planes. Click the none button to activate it. The None button will turn green until a camera has been selected in the viewport. The camera’s name will then be displayed on the button instead of None.

**Near Z** Specifies the beginning distance from the camera that should be used in determining where to start rendering the scene’s geometry in the depth channel image file.

**Far Z** Specifies the ending distance from the camera that should be used in determining where to stop rendering the scene’s geometry in the depth channel image file.

**Fit Entire Scene** Makes all other Depth parameters unavailable and will render the entire viewport’s scene geometry in the Depth channel image file, automatically calculating the near and far Z required.

---

**Film Grain Rendering Effect**

Rendering menu > Effects > Environment and Effects dialog > Effects panel > Add > Add Effect dialog > Film Grain

Film Grain is used to recreate the look of film grain in your rendered scene. Film Grain also allows you to match film grain from source material used as a background, such as an AVI, to the rendered scene created in 3ds Max. When applied, Film Grain automatically randomizes to create the look of moving frames.
Before and after applying Film Grain to a scene
Interface

The Film Grain Parameters rollout contains the following controls.

**Grain** Sets the amount of grain added to your image. Range=0 to 10.0.

**Ignore Background** Masks the background so that grain is applied only to geometry and effects in the scene. Choose this option when you use film (which already contains grain) as the background image.

**Motion Blur Rendering Effect**

Rendering menu > Effects > Environment and Effects dialog > Effects panel > Add > Add Effect dialog > Motion Blur

Motion Blur applies an image motion blur on page 8606 to your rendered scene by blurring moving objects or the entire scene. Motion blur can enhance the realism of a rendered animation by simulating the way a real-world camera works. A camera has a shutter speed, and if significant movement of objects in the scene, or of the camera itself, occurs during the time the shutter is open, the image on film is blurred.
Motion blur enhances the movement of the sword.

**NOTE** In addition, you must set motion-blur characteristics for objects to be blurred using the Object Properties dialog on page 293.

**Interface**

The Motion Blur Parameters rollout contains the following controls.

**Work with transparency** When on, motion blur is applied to objects behind transparent objects. When off, objects behind transparent objects receive no motion blur. Turning off this toggle can improve rendering speed. Default=on.
Duration Specifies how long the “virtual shutter” is open. When this is set to 1.0, the virtual shutter is open for the entire duration between one frame and the next. The higher the value, the greater the motion blur effect. Default=1.0.

Depth of Field Rendering Effect

Rendering menu > Effects > Environment and Effects dialog > Effects panel > Add > Add Effect dialog > Depth of Field

The Depth-of-Field effect simulates the natural blurring of foreground and background scene elements when viewed through a camera lens. Depth of Field works by separating the scene in Z order into foreground, background, and in-focus images. The foreground and background images are then blurred according to the values set in the Depth of Field effect parameters and the final image is composited from the processed originals.

NOTE When additional Render Effects are being applied to an image or animation, the Depth-of-Field effect should be the last effect to be rendered. The order of the rendered effects is listed in the Effects tab of the Environment and Effects dialog.
**TIP** To minimize sampling artifacts in out-of-focus areas with the default scanline renderer, try using the Blend filter in the Render Setup dialog on page 6506 > Renderer panel > Antialiasing group.

Before and after applying Depth of Field effect to scene.
Interface

The Depth of Field Parameters rollout contains the following parameters.

**Affect Alpha** Affects the alpha channel of the final rendering when on.

**Cameras group**

**Pick Cam** Enables you to interactively select from the viewport which camera you want the Depth of Field effect applied to.
Remove  Deletes the camera currently selected in the drop-down list.

Camera Selection List  Lists all of the cameras to be used in the effect. You can use this list to highlight a specific camera and remove it from the list using the Remove button.

**Focal Point group**

Pick Node  Enables you to select an object to use as the focal node. When activated you can select an object directly from the viewports to use as the focal node. You can also press H to display the Pick Object dialog, which lets you select a focal node from a list of objects in the scene.

Remove  Removes the object selected as the Focal Node.

Use Camera  Specifies that the focal length from the camera selected in the Camera Selection list be used to determine the focal point.

**Focal Parameters group**

Custom  Uses the values set in the Focal Parameters group box to determine the properties of the Depth of Field effect.

Use Camera  Uses the values from the camera highlighted in the Camera Selection list to determine focal range, limit, and blur.

Horiz Focal Loss  Determines the amount of blur along the horizontal axis when Custom has been chosen.

Vert Focal Loss  Controls the amount of blur along the vertical axis when Custom has been chosen.

Focal Range  Sets the Z distance, in units, to either side of the focal point in which the image will remain in focus when Custom has been chosen.

Focal Limit  Sets the Z distance, in units, to either side of the focal point where blur will reach its maximum as specified by the Loss spinners when Custom has been chosen.

**Environment and Atmosphere Effects**

Rendering menu > Environment > Environment and Effects dialog > Environment panel

Environment displays the Environment panel on page 7163, which is used for setting up atmospheric and background effects.
You can use the environment functions to:

- Set and animate the background color.
- Use an image in the background of the rendered scene (screen environment) or use texture maps as spherical, cylindrical, or shrink-wrap environments.
- Set and animate the ambient light on page 8504.
- Use atmospheric plug-ins, such as volumetric light, in the scene.
- Apply exposure controls to renderings.

**Atmospheres**

Atmospheres are plug-in on page 8687 components that create lighting effects such as fog, fire, and so on. See Environment dialog on page 7163 for all environment parameters.

**Exposure Controls**

One of the limitations of rendering perceptually accurate images is the limited dynamic range of computer monitors. Dynamic range is the ratio of the highest to lowest intensity a monitor can produce. In a dark room this ratio is approximately 100 to 1. In a bright room, this drops to approximately 30 to 1. Real environments can have dynamic ranges of 10,000 to 1, or larger.

Exposure Controls on page 7207 map light-energy values to colors in a process known as tone mapping. They affect the brightness and contrast of both rendered images and viewport displays. They don't affect the actual lighting levels in the scene, but only how those levels are mapped to a valid display range.

**Environment Panel**

Rendering menu > Environment > Environment and Effects dialog > Environment panel

Rendered Frame Window > Environment and Effects Dialog Toggle > Environment panel

The Environment panel lets you assign and adjust environments such as the scene background and atmospheric effects. It also provides the exposure controls.
Use the Environment panel to:

- Set and animate the background color.
- Use an image in the background of the viewport and rendered scene (screen environment) or use texture maps as spherical, cylindrical, or shrink-wrap environments.
- Set and animate the tint and ambient light globally.
- Use atmospheric plug-ins, such as volumetric light, in the scene. Atmospheres are plugins on page 8687 that create light effects such as fire on page 7171, fog on page 7182, volume fog on page 7188, and volume light on page 7196.
- Apply exposure controls on page 7207 to renderings.

Procedures

To access environment functions, do one of the following:

2. On the Environment and Effects dialog, click the Environment tab.

To set the background color:

   The Environment panel appears.
2. In the Background group, click the color swatch.
   A Color Selector on page 371 appears.
3. Use the Color Selector to change the background color.
   The Renderer now uses this color as a background.

To choose an environment map:

1. Open the Material Editor on page 5641 (press M).
   You adjust the map's parameters with the Material Editor.
2. Choose Rendering > Environment (or press 8).
3 In the Background group on the Environment panel, do one of the following:
   ■ Click the Environment Map button. The Material/Map Browser appears. Choose a map type from the list.
   ■ Drag a map to the Environment Map button. You can do this from a map displayed in one of the Material Editor's sample slots, or from any map button that has been assigned, either in the Material Editor or from a projection light, and so on.

On the Environment panel, the name of the Environment Map button changes to show the type of map you chose, and Use Map turns on.

After setting up the map, you can test-render the scene without the mapped background by turning off Use Map.

You have set up the environment map, but to assign a bitmap or adjust map parameters, you need to use the Material Editor.

You can also create a standalone map in the Material Editor first, and then choose it with the Material/Map Browser.

**TIP** After you specify an environment map, you can set it to display in the active viewport or all viewports: Press Alt+B to open the Viewport Background dialog on page 128, turn on Use Environment Background, turn on Display Background, in the Apply Source And Display To group, choose All Views or Active Only, and click OK.

**To put the map in the Material Editor:**

■ Drag the Environment Map button to a sample slot. The map is now in the Material Editor where you can adjust it by changing its parameters.

**To change the color and tint of global lighting:**

1 Choose Rendering > Environment.
2 Click the color swatch labeled Tint. A Color Selector on page 371 appears.
3 Use the color selector to set the tint applied to all lighting except ambient light.
4 Use the Level spinner to multiply the overall lighting of the scene.
Shaded viewports update to show global lighting changes.

5 Close the Environment dialog.
   3ds Max uses the global lighting parameters when you render the scene.

**To change the color of ambient light:**

**TIP** You don’t need to adjust ambient light if you are using *radiosity* on page 6615.

1 Choose Rendering > Environment.
2 Click the color swatch labeled Ambient.
   A *Color Selector* on page 371 appears.
3 Use the color selector to set the ambient color.
   Shaded viewports update to show ambient color changes.
   3ds Max also uses the new ambient color when you render the scene.
   The color of ambient light tints the scene. For most renderings, the color of ambient light should be black.
4 Close the Environment dialog.

**To change the intensity of ambient light:**

**TIP** You don’t need to adjust ambient light if you are using *radiosity* on page 6615.

1 Choose Rendering > Environment.
2 Click the color swatch labeled Ambient Light.
   A *Color Selector* on page 371 appears.
3 Change the Value setting (the V component of the ambient light’s HSV description) to increase or decrease intensity.
   Shaded viewports update to show changes in the ambient light intensity.
4 Close the Color Selector.
   The intensity of ambient light affects contrast as well as overall illumination (the higher the intensity of ambient light, the lower the contrast). This is because ambient light is completely diffuse, so the angle of incidence is equal for all faces. Ambient light alone cannot show depth.
NOTE 3ds Max has a default ambient light setting. You can change the default by using the Rendering panel of the Preference Settings dialog.

To add an atmospheric effect:

1 Choose Rendering > Environment.
   The Environment and Effects dialog is displayed, with the Environment panel visible.

2 Under Atmosphere on the Environment panel, click Add.
   The Add Atmospheric Effect dialog appears.

3 Choose the kind of effect you want to use, and then click OK.
   The effect has now been added. Use the Atmosphere rollout to adjust parameters.

Interface

Common Parameters rollout

Background group

Color Sets the color for the scene background. Click the color swatch, then select the color you want in the Color Selector. You can animate the color effect by changing the background color at a nonzero frame with the Auto Key button on.
**Environment Map** The button for *Environment Map* on page 8561 displays the name of the map, or “None” if none has been assigned. The map must use Environmental *mapping coordinates* on page 8628 (spherical, cylindrical, shrink wrap, and screen).

To assign an environment map, click the button and use the Material/Map Browser to choose a map, or drag a map from a sample slot or map button in the Material Editor (or anywhere else in the interface; for example, a Projector Map button) and drop the map on the Environment Map button. A dialog asks if you want the environment map to be a copy (independent) or an instance of the source map.

**NOTE** If your scene includes animated bitmaps, including materials, projector lights, environments, and so on, the animation file is reloaded once per frame. Rendering performance slows down when your scene uses multiple animations, or the animations are themselves large files.

To adjust the environment map’s parameters, for example to assign a bitmap or change the coordinate settings, open the Material Editor, drag the Environment Map button, and drop it over an unused sample window.

**Use Map** Uses a map for the background rather than the background color.

**Global Lighting group**

**Tint** Tints all lights in the scene (except for ambient light) if this color is anything other than white. Click the color swatch to display the Color Selector, on which you can choose the tint color. You can animate the tint color by changing it at a nonzero frame with the Auto Key button on.

**Level** Multiplies all lights in the scene. A Level of 1.0 preserves the original, individual light settings. Increasing the Level raises the lighting for the overall scene, and decreasing the Level lowers the overall lighting. This parameter is animatable. Default=1.0.

**Ambient** Sets the color for the ambient light. Click the color swatch, and choose the color you want in the Color Selector. You can animate the light effect by changing the ambient light color at a nonzero frame with the Auto Key button on.
Atmosphere rollout

**Effects** Shows the queue of effects that were added. The effects are evaluated in linear order within the scene during rendering. Depending on the selected effect, the Environment dialog adds the appropriate rollout for the effect’s parameters.

**Name** Gives a custom name to effects in the list.
For example, you might have different custom settings for different kinds of fire, that you could name Spark and Fireball.

**Add** Displays the Add Atmospheric Effect dialog (all currently installed atmospheric effects). Select an effect and click OK to assign an effect to the list.
**Delete** Deletes a selected atmospheric effect from the list.

**Active** Sets the on/off state for the individual effects in the list. This is a convenient way to isolate effects within a list of complicated atmospheric functions.

**Move Up / Move Down** Moves the selected item in the list up or down to change the order in which the atmospheric effects are applied.

**Merge** Merges effects from other 3ds Max scene files. When you click Merge, the Merge Atmospheric Effects dialog appears. Choose a 3ds Max scene, and then click Open. The Merge Atmospheric Effects dialog then lists the effects in the scene that can be merged. Select one or more of the effects, and then click OK to merge them into the scene.

The list shows the names of the atmospheric effects only, but when you merge an effect, the lights or gizmos bound to that effect are merged as well. If one of these objects you're merging has the same name as one already in the scene, an alert appears giving you the following choices:

- You can rename the incoming object by changing its name in the editable field.
- You can Merge the incoming object without renaming, resulting in two objects in the scene with the same name.
- You can delete the existing object in the scene by selecting the Delete Old button.

- You can select Apply To All Duplicates, which performs the same action to all subsequent matching objects.

**NOTE** To control whether or not the renderer uses the environment map's alpha channel in creating the alpha for the rendered image, choose Customize > Preferences > Rendering, and then turn on Use Environment Alpha in the Background Antialiasing group.

If Use Environment Alpha is turned off (the default) the background receives an alpha of 0 (completely transparent). If Use Environment Alpha is turned on, the alpha of the resulting image is a combination of the scene and background image's alpha. Also, when writing TGA files with Pre-Multiplied Alpha set to off, turning on Use Environment Alpha prevents incorrect results. Note that only background images with alpha channels or black backgrounds are supported when compositing in other programs such as Photoshop®.

**NOTE** To control whether or not a background image is affected by the renderer's antialiasing filter, choose Customize > Preferences > Rendering and then turn on Filter Background in the Background Antialiasing group. Default=off.

**Fire Environment Effect**

Rendering menu > Environment > Environment and Effects dialog > Environment panel > Atmosphere rollout > Add > Fire Effect

Use Fire to produce animated fire, smoke, and explosion effects. Possible uses for Fire effects include campfires, torches, fireballs, clouds, and nebula.
Scene using fire

You can add any number of fire effects to a scene. The order of effects is important because effects near the bottom of the list are layered in front of effects near the top of the list.

Each effect has its own parameters. When you select a fire effect in the Effects list, its parameters appear in the Environment dialog.

Fire renders only in Camera or Perspective views. Orthographic or User views don’t render Fire effects.

**TIP** Fire doesn’t support completely transparent objects. Set the transparency of Fire objects accordingly. Use visibility rather than transparency to make Fire objects disappear.

**NOTE** The Fire effect does not cast any light or shadows in the scene. To simulate illumination, you must also create lights. To cast shadows, you need to go to the Shadows Parameters rollout on page 5448 of your lights, and turn on Atmosphere Shadows.
Procedures

To create fire effects:

1. Create one or more atmospheric apparatus objects to locate the fire effect in your scene.
2. Define one or more fire atmospheric effects on the Environment panel.
3. Assign atmospheric apparatus objects to the fire effects.

Example: To create a campfire:

1. Click Helpers on the Create panel and choose Atmospheric Apparatus on page 7236 from the subcategory list.
2. Click Sphere Gizmo. Drag the cursor in the Top viewport to define an apparatus radius of about 20 units. Turn on the Hemisphere check box in Sphere Gizmo Parameters.
3. Click Non-Uniform Scale. Click Yes in the Warning dialog (this warning doesn't apply to atmospheric gizmos), and scale the apparatus 250 percent along its local Z axis only. You can then model logs, embers, and rocks around the base of the apparatus.
4. Open the Modify panel of the Sphere Gizmo. On the Atmosphere rollout, click Add and choose Fire from the Add Atmosphere dialog.
5 Highlight Fire in the Atmospheres list under the Atmospheres & Effects rollout. Click Setup.

6 Set the following parameters under Shape and Characteristics:
   ■ Flame Type=**Tendril**
   ■ Stretch=0.8
   ■ Flame Size=18.0
   ■ Flame Density=30.0

7 Turn on Auto Key and advance to the end of the animation.

8 Set the following parameters under Motion:
   ■ Phase=300.0
   ■ Drift=200.0

The Fire effect doesn’t cast any light in the scene. If you want to simulate illumination from the fire effect, you must create lights as well.

Example model with fire
Interface

Fire Environment Effect | 7175
You create a fire apparatus, or "gizmo," to position the effect in your scene and to define the maximum boundaries of the effect. The apparatus is a Helper object found in the Atmospheric Apparatus subcategory.

There are three kinds of apparatus: BoxGizmo on page 7237, SphereGizmo on page 7243, and CylGizmo on page 7240.

You can move, rotate, and scale the apparatus, but you cannot apply modifiers. Using non-uniform scale is a good way to change the shape of the apparatus for effects. (You will see a warning when you use this transform. Because you don't modify atmospheric apparatus, you can safely ignore the warning.)

**Fire Parameters rollout**

You must assign an atmospheric apparatus to a fire effect before you can render the effect. Use buttons in the Gizmos area to manage the list of apparatus objects.
**Pick Gizmo** Click to enter Pick mode and click an atmospheric apparatus in the scene. The apparatus displays the fire effect when you render. The name of the apparatus is added to the apparatus list.

Multiple apparatus objects can display the same fire effect. For example, torches on a wall can all use the same effect. Assign a different seed to each apparatus to vary the effect.

You can assign single apparatus to multiple fire effects. For example, one apparatus can display both a fireball and a tendril flame effect.

You can choose multiple gizmos. Click Pick Gizmo and press H. This opens the Pick Object dialog, which lets you choose multiple objects from the list.

**Remove Gizmo** Removes the gizmo selected in the gizmo list. The gizmo remains in your scene but it no longer displays the fire effect.

**Gizmo List** Lists apparatus objects assigned to the fire effect.

**Colors group**

You can set three color properties for a fire effect using the color swatches under Colors. Click a color swatch to display 3ds Max Color Selector on page 371.

**Inner Color** Sets the color of the densest part of the effect. For a typical fire, this color represents the hottest part of the flame.

**Outer Color** Sets the color of the sparsest part of the effect. For a typical fire, this color represents the cooler, dissipating edge of the flame.

The fire effect is colored using a gradient between the inner and outer colors. The dense areas of the effect use the inner color and gradually blend to the outer color near the edges of the effect.

**Smoke Color** Sets the color of smoke for use with the Explosion option.

If you turn on Explosion and Smoke, the inner and outer colors animate to the smoke color. If you turn off Explosion or Smoke, the smoke color is ignored.

**Shape group**

You control the shape, scale, and pattern of flames within the fire effect using controls under Shape.

Two options set the direction and general shape of flames.
**Tendril** Creates directional pointed flames with veins along their center. The flames orient along the local Z axis of the fire apparatus. Tendril creates campfire-like flames.

**Fireball** Creates round puffy flames. Fireballs are well suited for explosions.

**Stretch** Scales flames along the Z axis of the apparatus. Stretch works best with Tendril flames, but you can use it to give Fireballs an oval shape. Values less than 1.0 compress flames, making them shorter and thicker. Values greater than 1.0 stretch flames, making them long and skinny. You can combine Stretch with non-uniform scaling of the apparatus. Use non-uniform scale to change the boundary of the effect and scale the shape of the flames.

Use the Stretch parameter to scale only the flames inside the apparatus. You can also use Stretch values to reverse the effect that scaling the apparatus had on the flames.

**Effect of changing Stretch**

Value=0.5, 1.0, 3.0

**Non-uniform scaling of an apparatus**

Stretch=0.5, 1.0, 3.0
**Regularity** Modifies how the flames fill the apparatus. Range=1.0 to 0.0. A value of 1.0 completely fills the apparatus. The effect fades near the edges of the apparatus, but the overall shape is still very noticeable. A value of 0.0 produces a very irregular effect that might occasionally reach the boundary of the apparatus, but usually gets trimmed back and is smaller.

**Effect of changing Regularity**

Value=0.2, 0.5, 1.0

**Characteristics group**

You set the size and appearance of flames using parameters under Characteristics. All of these parameters depend on the apparatus size and are interdependent on each other. Changing one parameter affects the behavior of the other three.

**Flame Size** Sets the size of individual flames inside the apparatus. The size of the apparatus affects the flame size. A larger apparatus requires a larger flame size. Use a range from 15.0 to 30.0 for the best results. Large values work best for Fireballs. Small values work best for Tendrils. If the flame size is very small, you might need to increase Samples to see individual flames.
Effect of changing Flame Size
Value=15.0, 30.0, 50.0
Radius of apparatus=30.0

**Flame Detail** Controls the amount of color change and edge sharpness seen within each flame. Range=0.0 to 10.0.
Low values produce smooth, fuzzy flames and render faster.
High values produce patterned, sharp flames and render slower.
Use higher detail values for large flame sizes. If the detail value is greater than 4, you might need to increase Samples to capture the detail.

Effect of changing Flame Detail
Value=1.0, 2.0, 5.0

**Density** Sets the opacity and brightness of the fire effect. The size of the apparatus affects the density. A large apparatus with the same density as a small apparatus appears more opaque and brighter because of its larger size.
Low values make the effect less opaque and use more of the outer color. High values make the effect more opaque and brighten the effect by gradually replacing the inner color with white. The higher the value, the more white the center of the effect is.
If you turn on Explosion, Density animates from 0.0 at the start of the explosion to the set density value at the peak of the explosion.

Effect of changing Flame Density
Value=10, 60, 120

**Samples** Sets the rate at which the effect is sampled. Higher values produce more accurate results but take longer to render.

You might consider raising the samples value under the following conditions:

- Flame Size is small.
- Flame Detail is greater than 4.
- Any time you see color banding in the effect. The chance of color banding increases if a flat surface intersects the fire effect.

NOTE 100 percent transparent objects that intersect the effect become partially visible. To use particles with Fire, consider using 3D particles instead of opacity-mapped particles.

**Motion group**

Use the parameters in the Motion group to animate the churning and rise of flames.

**Phase** Controls the rate of change for the fire effect. Turn on Auto Key and change the phase value at different times.

**Drift** Sets how flames are rendered along the Z axis of the fire apparatus. The value is the amount of rise in units.

Low values give a slow-burning, cool fire.

High values give a fast-burning, hot fire.
For the best fire effects, drift should be a multiple of the height of the fire apparatus.
You can also animate the location and size of the fire apparatus and most of the fire parameters. For example, a fire effect can animate color, size, and density.

**Explosion group**

Use the parameters in the Explosion group to automatically animate explosions.

**Explosion** Animates size, density, and color automatically based on the animation of the Phase value.

**Smoke** Controls whether or not the explosion creates smoke.
When on, fire colors change to smoke between Phase values 100 to 200. Smoke clears between Phase values 200 to 300. When off, fire colors remain at full density between Phase values 100 to 200. Fire fades away between Phase values 200 to 300.

**Fury** Varies the churning effect of the Phase parameter.
Values greater than 1.0 cause faster churning. Values less than 1.0 cause slower churning.

**Set Up Explosion** Displays the Set Up Explosion Phase Curve dialog. You enter a start time and end time, and then click OK. The Phase value animates automatically for a typical explosion effect.

**Fog Environment Effect**

Rendering menu > Environment > Environment and Effects dialog > Environment panel > Atmosphere rollout > Add > Fog

This plug-in on page 8687 effect gives the appearance of fog or smoke. Fog can cause objects to appear to fade as they increase in distance from the camera (standard fog), or can be layered fog that envelops all or parts of objects in a blanket of mist.
Fog added to a scene

Fog renders only in Camera or Perspective views. Orthographic or User views don't render Fog effects.

Procedures

To use standard fog:

1. Create a Camera view of your scene.
2. In the camera's creation parameters, turn on Show in the Environment Ranges group.
   Standard fog is based on the camera's environment range values.
3. Set Adjust Near Range and Far Range to include the objects you want to fog in your rendering.
   As a general guideline, set Far Range just beyond the objects, and Near Range to intersect the object geometry closest to the camera.
The Add Atmospheric Effect dialog is displayed.

6 Choose Fog, and then click OK.
7 Make sure you choose Standard as the type of fog.

To use layered fog:

1 Create a Camera or Perspective view of your scene.
2 Choose Rendering > Environment.
3 Under Atmosphere on the Environment panel, click Add.
   The Add Atmospheric Effect dialog is displayed.
4 Choose Fog, and then click OK.
5 Choose Layered as the fog type.
6 Set the parameters for layered fog.
   You can have multiple fog layers in the scene by adding multiple Fog entries to the list and choosing Layered.
The Fog Parameters rollout appears when you select Fog under Effects in the Environment dialog. The Fog Parameters rollout has the following controls.

**Fog group**

**Color** Sets the color for the fog. Click the color swatch, and then select the color you want in the Color Selector on page 371. You can animate the color...
effect by changing the fog color at a nonzero frame with the Auto Key button on.

**Environment Color Map** Derives the fog color from a map. You can map the background and the fog color, you can animate the procedural map parameters in Track View or Material Editor, and you can opacity-map the fog.

The large button displays the name of the color map, or None if no map is assigned. The map must use Environmental mapping coordinates on page 8628 (spherical, cylindrical, shrinkwrap, and screen).

To assign the map you can drag a map from a Sample slot or Map button in the Material Editor (or anywhere else in the interface; for example, a projector map button) and drop it on the Environment Color Map button. A dialog asks if you want the environment map to be a copy (independent) or an instance of the source map.

Clicking the Environment Color Map button displays the Material/Map Browser, where you can choose a map type from the list. To adjust the environment map's parameters, open the Material Editor and drag the Environment Color Map button over an unused sample slot.

**Use Map** Toggles the effect of this map on or off.

**Environment Opacity Map** Alters the density of the fog.

You assign the opacity map, edit it, and toggle its effect in the same way as the Environment Color Map.

**Fog Background** Applies the fog function to the background of the scene.

**Type** When you choose Standard it uses the parameters in the Standard section and when you choose Layered is selected it uses the parameters in the Layered section.

**Standard** Enables the Standard group.

**Layered** Enables the Layered group.

**Standard group**

Thins and thickens the fog based on the distance from the camera.

**Exponential** Increases density exponentially with distance. When turned off, density increases linearly with distance. Activate this check box only when you want to render transparent objects in volume fog.

**TIP** If you turn on Exponential, this increases the Step Size value to avoid banding.
**Near %** Sets the density of the fog at the Near Range (Camera Environment Range parameter).

**Far %** Sets the density of the fog at the Far Range (Camera Environment Range parameter).

**Layered group**

Thins and thickens the fog between an upper and lower limit. You can have multiple layers of fog by adding multiple fog entries to the list. Because you can animate all the fog parameters, you can also animate fog rising and falling, changing density and color, and add horizon on page 8602 noise.

**Top** Sets the upper extent (in world units) of the fog layer.

**Bottom** Sets the lower extent (in world units) of the fog layer.

**Density** Sets the overall density of the fog.

**Falloff (Top/Bottom/None)** Adds an exponential falloff effect so that the density is reduced to 0 at either the Top or Bottom of the fog extent.

**Horizon Noise** Turns on the horizon noise system. Horizon Noise perturbs just the horizon of the fog layer to add realism.

**Size** Scale factor applied to the noise. Larger scale values make the fog tendrils larger. Default=20.

- **TIP** If you want tendrils to really pop out, try making the density greater than 100.

**Angle** Determines the affected angle off the horizon line. For example, if the angle is set to 5 (a reasonable value), then starting at 5 degrees below the horizon, the fog will begin to break up.

This effect is mirrored above and below the horizon, which can produce strange results when the height of the fog layer traverses the horizon. Typically you’d want the fog to be either above or below the actual camera horizon. (You can use the horizon line in the camera parameters as an aid to help you position this.)

**Phase** Animating this parameter animates the noise. If Phase is moving in the positive direction, then the fog tendrils will drift upward (and deform at the same time). If your fog is above the horizon you may want to animate Phase in the negative direction to make the tendrils fall downward.
Volume Fog Environment Effect

Volume Fog provides a fog effect in which the fog density is not constant through 3D space. This plug-in on page 8687 provides effects such as puffy, cloudy fog that appears to drift and break up in the wind.

Volume fog added to a scene

Volume Fog renders only in Camera or Perspective views. Orthographic or User views don’t render Volume Fog effects.

Procedures

To use volume fog:

1. Create a Camera or Perspective view of your scene.
2. Choose Rendering > Environment.
The Add Atmospheric Effect dialog is displayed.

4 Choose Volume Fog, and then click OK.

5 Set the parameters for volume fog.

**NOTE** If there are no objects in your scene, rendering shows only a solid fog color. Also, with no objects and Fog Background turned on, volume fog obscures the background.

To create a volume fog gizmo:

1 In the Helpers category of the Create panel, choose Atmospheric Apparatus from the pop-up menu.

2 Click one of the buttons to choose a gizmo shape: SphereGizmo, CylGizmo, or BoxGizmo.

3 Drag the mouse in the viewport to create the gizmo.

You create Gizmos in much the same way as their matching geometry types. Drag the mouse to create the initial dimensions. The Sphere gizmo
has an additional Hemisphere check box that turns the sphere into a hemisphere.

In addition, each gizmo has a Seed spinner and a New Seed button. Different seed values generate different patterns. Clicking the New Seed button randomly generates a new seed value for you.

To assign volume fog to a gizmo from an apparatus modify panel:

1. Open the Modify panel of an apparatus.
2. Open the Atmospheres & Effects rollout.
3. Click Add.
4. Select Volume Fog from the Add Atmospheres dialog and click OK.
5. Highlight Volume Fog from the Atmospheres list and click setup to adjust the Volume Fog parameters.

To assign a gizmo to volume fog from the Environment panel:

1. On the Volume Fog Parameters rollout, click the Pick Gizmo button.
2. Click a gizmo in the viewport.
   The name of the gizmo appears in the list field at right.
   When you render, the volume fog will be confined to the shape of the gizmo.

To remove an assigned gizmo:

1. In the Environment dialog, go to the Volume Fog Parameters rollout.
2. Select the gizmo name from the pop-up list.
3. Click Remove Gizmo.
   This action doesn’t delete the gizmo from the scene, but simply unbinds it from the fog effect.
The Volume Fog Parameters rollout appears when you select Volume Fog under Effects in the Environment dialog. The Volume Fog Parameters rollout has the following controls.
By default, volume fog fills the entire scene. However, you can choose a gizmo (an atmospheric apparatus) to contain the fog. The gizmo can be a sphere, a box, a cylinder, or some combination of these.

**Pick Gizmo** Click to enter Pick mode and click an atmospheric apparatus in the scene. The apparatus contains the volume fog when you render. The name of the apparatus is added to the apparatus list.

Multiple apparatus objects can display the same fog effect.

You can pick multiple gizmos. Click Pick Gizmo and then press H. This opens the Pick Object dialog, which lets you choose multiple objects from a list.

Changing the dimensions of a gizmo changes the region that fog affects, but doesn't change the scale of the fog and its noise. For example, reducing the radius of a spherical gizmo crops the fog, and moving the gizmo changes the fog's appearance.

**Remove Gizmo** Removes a gizmo from the volume fog effect. Select the gizmo in the list, and then click Remove Gizmo.

**Soften Gizmo Edges** Feather the edges of the volume fog effect. The higher the value, the softer the edges. Range=0 to 1.0.

**TIP** Don't set this value to 0. At 0, Soften Gizmo Edges can cause aliased edges.

**Volume group**

**Color** Sets the color for the fog. Click the color swatch, and then select the color you want in the Color Selector on page 371.

You can animate the color effect by changing the fog color at a nonzero frame with Auto Key on.

**Exponential** Increases density exponentially with distance. When turned off, density increases linearly with distance. Activate this check box only when you want to render transparent objects in volume fog.

**TIP** If you turn on Exponential, increase the Step Size value to avoid banding.

**Density** Controls the fog density. Range=0 to 20 (anything over that tends to obliterate the scene).
Left: Original scene
Right: Increased fog density

**Step Size** Determines the granularity of the fog sampling; the "fineness" of the fog. A large step size creates coarse (and to some extent, aliased) fog.

**Max Steps** Limits the amount of sampling so that computing the fog doesn't take forever (literally). This is especially useful when the fog is of low density. When both Step Size and Max Steps have low values, aliasing results.

**Fog Background** Applies the fog function to the background of the scene.
**Noise group**

Left: Original scene  
Right: Noise added to the fog

Noise options for volume fog are comparable to the noise options for materials.  
**Type** Choose one of three types of noise to apply.  
**Regular** The standard noise pattern.  
**Fractal** An iterative fractal noise pattern.  
**Turbulence** An iterative turbulence pattern.  
**Invert** Reverses the noise effect. Dense fog becomes translucent and vice versa.  
**Noise Threshold** Limits the noise effect. Range=0 to 1.0. When the noise value is above the Low threshold and below the High threshold, the dynamic range stretches to fill 0-1. This makes for a smaller discontinuity (First order instead of 0 order) at the threshold transition, and thus produces less potential aliasing on page 8501.  
**High** Sets the high threshold.  
**Low** Sets the low threshold.
Left: Fog with noise

Right: Changing uniformity creates "blobby" fog

**Uniformity** Ranges from -1 to 1 and acts like a high-pass filter. The smaller the value, the more transparent the volume is with discrete blobs of smoke. Around -0.3 or so your image begins to look like specks of dust. Because the fog becomes thinner as this parameter gets smaller, you'll probably need to increase the density or the volume will start to disappear.

**Levels** Sets the number of times the noise is iteratively applied. Range=1 to 6, including fractional values. Enabled only for Fractal noise or Turbulence.

**Size** Determines the size of the tendrils of smoke or fog. Smaller values give smaller tendrils.
Phase Controls the speed of the wind. If you have Wind Strength also set to
greater than 0, the fog volume animates in accordance with the wind direction.
With no Wind Strength, the fog churns in place. Because there's an animation
track for phase, you can use the Function Curve editor to define precisely how
you want your wind "gusts" to occur.

Wind Strength Controls how fast the smoke moves away from the wind
direction, relative to phase. As mentioned above, if the phase is not animated
then the smoke won’t move, regardless of the wind strength. By having the
phase animate slowly with a large wind strength, the fog moves more than it
is churns.

Wind from the Defines the direction the wind is coming from.

Volume Light Environment Effect

Rendering menu > Environment > Environment and Effects dialog >
Environment panel > Atmosphere rollout > Add > Volume Light

Volume Light provides light effects based on the interaction of lights with
atmosphere (fog, smoke, and so on).
Volumetric light used in a complex environment with shadows and noise.

This plug-in on page 8687 provides effects such as radial glows for omni lights on page 8661, conical glows for spotlights, and parallel beams of fog for directional lights. Objects within the light volume can cast shadows within the spotlight’s cone, if using shadow maps as a shadow generator.

A simplified example where the light cone is clearly visible on the right.

Volume Light renders only in Camera and Perspective views. Orthographic or User views don’t render Volume Light effects.
Procedures

To use Volume Light:

1. Create a scene with lights.
2. Create a Camera or Perspective view of your scene.

**TIP** Avoid making the view axis parallel to the cone of a spotlight. This tends to create only a washed-out scene, possibly with rendering artifacts.

5. Choose Volume Light, and then click OK.
6. Click Pick Light, and then select a light in a viewport to add the light to the list of volume lights. You can also use the Pick Object dialog to select multiple lights from a list. Click Pick Light, and then press `H` to open the dialog.
7. Set the parameters for volume light.

To add a light to the list:

1. Click Pick Light.
2. Click the light in a viewport.

To remove a light from the list:

1. Open the list of volume lights.
2. Choose the light you want to remove the volume light effect from.
3. Click Remove Light.

To assign volume light to a light through the Modify panel:

1. Open the Modify panel of a light.
2. Open the Atmospheres & Effects rollout.
3. Click Add.
4 Select Volume Light from the Add Atmosphere or Effect dialog and click OK.

5 Highlight Volume Light from the Atmospheres & Effects list and click setup to adjust the Volume Light parameters.

NOTE Volume Lights don’t support negative multiplier values.
Interface

The Volume Light Parameters rollout appears when you select Volume Light under Effects in the Environment dialog. It has the following controls.

The Volume Light Parameters rollout appears when you select Volume Light under Effects in the Environment dialog. It has the following controls.
Lights group

Pick Light Click the light that you want to enable for volume light in any viewport.
You can pick multiple lights. Click Pick Light and then press H. This opens the Pick Object dialog, which lets you choose multiple lights from a list.

Remove Light Deletes a light from the list.

Volume group

Fog Color Sets the color for the fog that makes up the volume of the light. Click the color swatch, and then choose the color you want in the Color Selector on page 371.
You can animate the color effect by changing the fog color at a nonzero frame with the Auto Key button on.
Unlike the other fog effects, this fog color combines with the color of the light. Possibly the best effect is to use white fog and then color it with a colored light.

Attenuation Color Attenuates volume light over distance. The volume light ramps from the Fog Color to the Attenuation color over the light’s Near and Far attenuation distances. Clicking the color swatch displays a color selector so you can change the attenuation color.
Attenuation Color interacts with Fog Color. For example, if your fog color is red and your attenuation color is green, in the rendering your fog will shade to purple. Typically the attenuation color should be very dark and neutral—black is a good choice.

Use Attenuation Color Makes attenuation color active.

Exponential Increases density exponentially with distance. When turned off, density increases linearly with distance. Activate this check box only when you want to render transparent objects in volume fog.

Density Sets the density of the fog. The denser the fog, the more the light reflects off it inside the volume. Densities of 2 to 6 percent probably make the most realistic fog volumes.
Max Light% Represents the maximum glow effect that you can achieve (defaults to 90 percent). By turning this down, you can limit the brightness of the glow so that it doesn't get denser and denser as it gets farther away from the light and "whites out."

NOTE When your scene includes transparent objects inside a volume light, set Max Light to 100 percent.

Min Light% Similar to an ambient light on page 8504 setting. If Min Light% is greater than 0, areas outside the light volume will glow also. Note that this means areas of open space (where the light ray can travel forever) will end up the same as the fog color (just as with normal fog).

Without objects behind the fog, the scene will always be as bright as the fog color if the Min Light% is greater than 0 (no matter what the actual value is). This is because the fog goes to infinity and is accumulated infinitely. If you're going to use min light% values greater than 0, you should make sure that you enclose your scene by geometry.


Filter Shadows Allows you to get better quality volume-light rendering by increasing the sampling rate (at the cost of some increased rendering time). These are the options:
Low The image buffer is not filtered but directly sampled instead. This option is fine for 8-bit images, AVI on page 7832 files, and so on.

Medium Adjacent pixels are sampled and averaged. This produces a very significant improvement in cases where you're getting banding types of artifacts. It is slower than Low.

High Adjacent pixels and the diagonal pixels are sampled, and each are given different weights. This is the slowest method and provides somewhat better quality than Medium.

Use Light Smp Range Blurs the shadows cast in the volume based on the Sample Range value in the light's shadow parameters. Because increasing the Smp Range value blurs the shadow cast by the light, this makes shadows in the fog better match cast shadows, and helps prevent aliasing in the fog shadows.

TIP With the Use Light Smp Range option, the higher the light's Smp Range value, the slower the rendering. However, with this option you can usually get good results with a lower Sample Volume % setting (such as 4), which reduces rendering time.

Sample Volume % Controls the rate at which the volume is sampled. Ranges 1 through 10,000 (where 1 is the lowest quality and 10,000 is the highest quality).

Auto Controls the Sample Volume % parameter automatically and disables the spinner (this is the default). The preset sampling rates are as follows: low=8; medium=25; high=50

Because the parameter ranges up to 100 there's still room to set it higher. Increasing the Sample Volume % parameter definitely slows things down, but in some cases you may want to increase it (for extremely high sample quality).
Attenuation group

The controls in this section are contingent upon the settings of the Start Range and End Range attenuation on page 8513 parameters for the individual light.

NOTE Rendering Volume Light at some angles can introduce aliasing problems. To eliminate aliasing problems, activate the Near and Far Attenuation settings in the light object that the Volume Light applied to.

Start % Sets the start attenuation of the light effect, relative to the actual light parameter's attenuation. It defaults to 100 percent, which means that it starts attenuating at the Start Range point. When you reduce this parameter, it starts attenuating the light at a reduced percentage of the actual Start Range value that is, closer to the light itself.

Because you usually want a smooth falloff on page 8604, you can keep this value at 0, and no matter what the light's actual Start Range, you'll always get a smooth glow without hotspots on page 8604.

End % Sets the end attenuation of the lighting effect, relative to the actual light parameter's attenuation. By setting this lower than 100 percent, you can have a glowing attenuating light that casts light much farther than it actually glows. Default=100.
Left: Original scene
Right: Attenuation limits the range of the light.

**Noise group**

*Noise On* Turns the noise on and off. When noise is on there is a slight increase in render time.

*Amount* The percentage of noise applied to the fog. If the amount is 0, there is no noise. If the amount is 1, the fog becomes pure noise.
**Link To Light** Links the noise effect to its light object, rather than to world coordinates.

Usually you want noise to look like fog or dust motes in the atmosphere, in which case, as the light moves, the noise should remain with the world coordinates. For certain special effects, however, you might want the noise linked to the light's coordinates. In these cases, turn on Link to Light.

**Type** Choose one of three types of noise to apply.
- **Regular** The standard noise pattern.
- **Fractal** An iterative fractal noise pattern.
- **Turbulence** An iterative turbulence pattern.

**Invert** Reverses the noise effect. Dense fog becomes translucent and vice versa.

**Noise Threshold** Limits the noise effect. When the noise value is above the Low threshold and below the High threshold, the dynamic range stretches to fill 0-1. This makes for a smaller discontinuity (first order instead of 0 order) at the threshold transition and thus produces less potential aliasing on page 8501.
- **High** Sets the high threshold. Range=0 to 1.0.
- **Low** Sets the low threshold. Range=0 to 1.0.

**Uniformity** Acts like a high-pass filter: the smaller the value, the more the volume is transparent with discrete blobs of smoke. By around -0.3 or so your image begins to look like specks of dust. Because the fog becomes thinner as this parameter gets smaller, you'll probably need to increase the density or the volume will start to disappear. Range=-1 to 1

**Levels** Sets the number of times the noise is iteratively applied. This parameter is animatable. Enabled only for Fractal noise or Turbulence. Range=1 to 6, including fractional values.

**Size** Determines the size of the tendrils of smoke or fog. Smaller values give smaller tendrils.
Phase Controls the speed of the wind. If you have Wind Strength also set to greater than 0, the fog volume animates in accordance with the wind direction. With no Wind Strength, the fog churns in place. Because there's an animation track for phase, you can use the Function Curve editor to define precisely how you want your wind "gusts" to happen.

Wind Strength Controls how fast the smoke moves away from the wind direction, relative to phase. As mentioned above, if the phase is not animated then the smoke won’t move, regardless of the wind strength. By having the phase animate slowly with a large wind strength, the fog moves more than it churns.

Wind from the Defines the direction the wind is coming from.

**Exposure Controls**

Rendering menu > Environment > Environment and Effects dialog > Environment panel > Exposure Control rollout

Exposure controls are plug-in components that adjust the output levels and color range of a rendering, as if you were adjusting film exposure. This process is known as tone mapping. These controls are especially useful for renderings that use radiosity on page 6615, and when dealing with high-dynamic-range (HDR) imagery.
Exposure control compensates for the limited dynamic range of computer displays, which is typically about two orders of magnitude: The brightest color that appears on a display is about 100 times brighter than the dimmest. The eye, by comparison, can perceive a dynamic range of about 16 orders of magnitude. In other words, the brightest color we can perceive is about 10 million-billion times brighter than the dimmest. Exposure control adjusts colors so they better simulate the eye's great dynamic range, while still fitting within the color range that can be rendered.

The exposure controls included with 3ds Max are: Automatic Exposure Control on page 7210, Linear Exposure Control on page 7212, Logarithmic Exposure Control on page 7215, mr Photographic Exposure Control on page 7219, and Pseudo Color Exposure Control on page 7228.

**IMPORTANT** The mental ray renderer on page 6675 supports only the Logarithmic, mr Photographic, and Pseudo Color exposure controls.

---

Left: Linear exposure control maps intensity evenly.

Right: Logarithmic exposure control maps most intensities to low and mid tones.

**Tips:**

- If the primary lighting from your scene comes from standard lights (rather than photometric lights), use the Logarithmic exposure control and turn on Affect Indirect Only.

- Use Automatic exposure control for rendering still images. This method is also useful for first-draft renderings.

- Use Logarithmic exposure control for animations with a moving camera. (Automatic and Linear exposure control with a moving camera can cause excessive flickering.)

- For rendering high-dynamic-range images with mental ray, use the mr Photographic exposure control.

- For outdoor scenes that use the Daylight system, turn on the Exterior toggle to prevent overexposure.
Exposure and Attenuation for Standard Lights

When you use standard lights that are not attenuated, renderings tend to have a low dynamic range, because light intensities don't vary greatly across the scene. In this situation, adjusting light values might be all you need to do to get a good rendering.

On the other hand, when lights are attenuated the illumination might be too bright on near surfaces or too dim on distant surfaces. In this situation, the Automatic exposure control can help, because it adjusts the larger dynamic range of the (simulated) physical scene, into the smaller dynamic range of the display.

Interface

Drop-down list Choose the exposure control to use.

Active When on, the exposure control is used in rendering. When off, the exposure control is not applied.

Process Background and Environment Maps When on, the scene background and environment maps are subjected to exposure control. When off, they are not.

Preview thumbnail The thumbnail displays a preview of the rendered scene with the active exposure control applied. Once a preview has been rendered, it updates interactively when you changed exposure control settings.

If gamma correction or look-up table (LUT) correction on page 8330 is active, 3ds Max applies the correction to this preview thumbnail.

Render Preview Click to render the preview thumbnail.
Automatic Exposure Control

Rendering menu > Environment > Environment and Effects dialog > Environment panel > Exposure Control rollout > Choose Automatic Exposure Control from the list. > Automatic Exposure Control rollout

Automatic Exposure Control samples the rendered image and builds a histogram to give good color separation across the entire dynamic range of the rendering. It can enhance some lighting effects that would otherwise be too dim to see.

Auto exposure can affect the lighting of the whole image.

NOTE Automatic Exposure Control should not be used in animations, because every frame will have a different histogram, causing your animation to flicker.

IMPORTANT The mental ray renderer on page 6675 does not support the Automatic exposure control.

See also:

- Environment Panel on page 7163
Interface

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brightness</td>
<td>Adjusts the brightness of the converted colors. Range=0 to 100. Default=50. This parameter is animatable.</td>
</tr>
<tr>
<td>Contrast</td>
<td>Adjusts the contrast of the converted colors. Range=0 to 100. Default=50. This parameter is animatable.</td>
</tr>
<tr>
<td>Exposure Value</td>
<td>Adjusts the overall brightness of the rendering. Range=–5.0 to 5.0; Negative values make the image darker, and positive values make it brighter. Default=0.0. The exposure value is comparable to the exposure compensation setting in cameras with automatic exposure. This parameter is animatable.</td>
</tr>
<tr>
<td>Physical Scale</td>
<td>Sets a physical scale for exposure control to use with lights that are not physically based. The result is an adjustment of the rendering that approximates the eye's response to the scene. Each standard light's Multiplier on page 8649 is multiplied by the Physical Scale value to give a light intensity value in candelas. For example, with the default Physical Scale of 1500, a standard omni light is treated by the renderer and radiosity as a photometric isotropic light of 1500 candelas. Physical Scale is also factored into reflections, refractions, and self-illumination. TIP You need to set the Physical Scale when you use ray-tracing with self illumination. Set this value to the equivalent of the brightest light source in the scene. This will set the appropriate conversion scale for reflections, self-illumination, and all other non-physically based elements a material offers. In some cases, an object might reflect or emit more light than the brightest light object in the scene; in this case, use the object’s Luminance value as the Physical Scale.</td>
</tr>
</tbody>
</table>

Range=0.001 to 200,000.0 candelas. Default=1500.0.
A single candle is approximately 1 candela (the unit can also be called a "candle"). A 100-Watt (W) incandescent light bulb is approximately 139 candelas (cd). A 60W bulb emitting in all directions is about 70 cd, while the same bulb with a reflector is about 4500 cd because the light flux is concentrated into a narrow angle.

Photometric lights are unaffected by the Physical Scale value. This parameter is animatable.

**Color correction check box and color swatch** When the check box is turned on, color correction shifts all colors so the color displayed in the color swatch appears as white. Default=off.

Clicking the color swatch displays a [Color Selector](#) on page 371 so you can choose the color to adapt to.

You can use this control to simulate how the eye adjusts to lighting. For example, even when the light in a room has a yellow hue from an incandescent light bulb, we will continue to perceive objects that we know to be white, such as printed pages, as white.

**TIP** For the best results, use a very pale color correction color, such as a pale blue or pale yellow.

**Desaturate Low Levels** When on, renders dimly lit colors as if the light were too dim for the eye to distinguish between colors. When on, renders even dimly lit colors. Default=off.

Desaturate Low Levels simulates the eye's response to dim lighting. In dim lighting, the eye does not perceive colors and sees tones of gray instead.

The effect of this setting is not apparent except at very low light levels, below 5.62 footcandles (lumens per square foot). When the illuminance is less than 0.00562 footcandles, the scene is completely gray.

**NOTE** 1 footcandle (fc) equals 10.76 lux (lumens per square meter).

**Linear Exposure Control**

Rendering menu > Environment > Environment and Effects dialog > Environment panel > Exposure Control rollout > Choose Linear Exposure Control from the list. > Linear Exposure Control rollout

Linear Exposure Control samples the rendered image and uses the average brightness of the scene to map physical values to RGB values. Linear Exposure Control is best used for scenes with a fairly low dynamic range.
NOTE  Linear Exposure Control should not be used in animations, because every frame will have a different histogram, causing your animation to flicker.

IMPORTANT  The mental ray renderer on page 6675 does not support the Linear exposure control.

See also:

■  Environment Panel on page 7163

Interface

Brightness  Adjusts the brightness of the converted colors. Range=0 to 100. Default=50.
This parameter is animatable.

Contrast  Adjusts the contrast of the converted colors. Range=0 to 100. Default=50.
This parameter is animatable.

Exposure Value  Adjusts the overall brightness of the rendering. Range= -5.0 to 5.0. Negative values make the image darker, and positive values make it brighter. Default=0.0.
The exposure value can be thought of as an exposure compensation setting in cameras with automatic exposure control.
This parameter is animatable.

Physical Scale  Sets a physical scale for exposure control to use with lights that are not physically based. The result is an adjustment of the rendering that approximates the eye's response to the scene.
Each standard light’s Multiplier on page 8649 is multiplied by the Physical Scale value to give a light intensity value in candelas. For example, with the default

Exposure Controls | 7213
Physical Scale of 1500, a standard omni light is treated by the renderer and radiosity as a photometric isotropic light of 1500 candelas. Physical Scale is also factored into reflections, refractions, and self-illumination.

**TIP** You need to set the Physical Scale when you use ray-tracing with self illumination. Set this value to the equivalent of the brightest light source in the scene. This will set the appropriate conversion scale for reflections, self-illumination, and all other non-physically based elements a material offers. In some cases, an object might reflect or emit more light than the brightest light object in the scene; in this case, use the object's Luminance value as the Physical Scale.

Range=0.001 to 200,000.0 candelas. Default=1500.0.

A single candle is approximately 1 candela (the unit can also be called a "candle"). A 100-Watt (W) incandescent light bulb is approximately 139 candelas (cd). A 60W bulb emitting in all directions is about 70 cd, while the same bulb with a reflector is about 4500 cd because the light flux is concentrated into a narrow angle.

Photometric lights are unaffected by the Physical Scale value. This parameter is animatable.

**Color Correction check box and color swatch** When the check box is turned on, color correction shifts all colors so the color displayed in the color swatch appears as white. Default=off.

Clicking the color swatch displays a [Color Selector](#) on page 371 so you can choose the color to adapt to.

You can use this control to simulate how the eye adjusts to lighting. For example, even when the light in a room has a yellow hue from an incandescent light bulb, we will continue to perceive objects that we know to be white, such as printed pages, as white.

**TIP** For the best results, use a very pale color correction color, such as a pale blue or pale yellow.

**Desaturate Low Levels** When on, renders dimly lit colors as if the light were too dim for the eye to distinguish between colors. When on, renders even dimly lit colors. Default=off.

Desaturate Low Levels simulates the eye's response to dim lighting. In dim lighting, the eye does not perceive colors and sees tones of gray instead. The effect of this setting is not apparent except at very low light levels, below 5.62 footcandles (lumens per square foot). When the illuminance is less than 0.00562 footcandles, the scene is completely gray.
Logarithmic Exposure Control

Rendering menu > Environment > Environment and Effects dialog > Environment panel > Exposure Control rollout > Choose Logarithmic Exposure Control from the list. > Logarithmic Exposure Control rollout

Logarithmic Exposure Control uses brightness, contrast, and whether the scene is outdoors in daylight to map physical values to RGB values. You can use it with either the default scanline renderer on page 6589 or the mental ray renderer on page 6675. Logarithmic Exposure Control is best for scenes with a very high dynamic range.

Left: The intensity of an IES Sun light completely overexposes a scene.
Right: Logarithmic exposure control corrects the overexposure.

Logarithmic Exposure Control is the best type of exposure control for animations because it doesn’t use histograms.

TIP If you’re rendering to texture on page 6843, use the Logarithmic exposure control, not the Automatic or Linear control.

See also:
- Environment Panel on page 7163


**Interface**

<table>
<thead>
<tr>
<th>-</th>
<th>Logarithmic Exposure Control Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brightness: 88.6</td>
<td>□ Color Correction:</td>
</tr>
<tr>
<td>Contrast: 50.0</td>
<td>□ Desaturate Low Levels</td>
</tr>
<tr>
<td>Mid Tones: 1.0</td>
<td>□ Affect Indirect Only</td>
</tr>
<tr>
<td>Physical Scale: 1500.0</td>
<td>□ Exterior daylight</td>
</tr>
</tbody>
</table>

**Brightness** Adjusts the brightness of the converted colors. Range=0 to 200. Default=50.

This parameter is animatable.

**Contrast** Adjusts the contrast of the converted colors. Range=0 to 100. Default=50.

This parameter is animatable.

**Mid Tones** Adjusts the mid-tone values of the converted colors. Range=0.01 to 20.0. Default=1.0.

This parameter is animatable.

---

**Adjusting the value of mid tones**

**Physical Scale** Sets a physical scale for exposure control to use with lights that are not physically based. The result is an adjustment of the rendering that approximates the eye's response to the scene.

Each standard light's **Multiplier** on page 8649 is multiplied by the Physical Scale value to give a light intensity value in candelas. For example, with the default Physical Scale of 1500, a standard omni light is treated by the renderer and...
radiosity as a photometric isotropic light of 1500 candelas. Physical Scale is also factored into reflections, refractions, and self-illumination.

**TIP** You need to set the Physical Scale when you use ray-tracing with self illumination. Set this value to the equivalent of the brightest light source in the scene. This will set the appropriate conversion scale for reflections, self-illumination, and all other non-physically based elements a material offers. In some cases, an object might reflect or emit more light than the brightest light object in the scene; in this case, use the object's Luminance value as the Physical Scale.

**NOTE** The mental ray renderer treats Physical Scale in the same way the scanline renderer does in terms of its effect on reflections and refractions. Physical Scale does affect the appearance of self-illuminated materials.

Range=0.001 to 200,000.0 candelas. Default=1500.0.

A single candle is approximately 1 candela (the unit can also be called a "candle"). A 100-Watt (W) incandescent light bulb is approximately 139 candelas (cd). A 60W bulb emitting in all directions is about 70 cd, while the same bulb with a reflector is about 4500 cd because the light flux is concentrated into a narrow angle.

Photometric lights are unaffected by the Physical Scale value.

This parameter is animatable.

**Color Correction check box and color swatch** When the check box is turned on, color correction shifts all colors so the color displayed in the color swatch appears as white. Default=off.

Clicking the color swatch displays a Color Selector on page 371 so you can choose the color to adapt to.

You can use this control to simulate how the eye adjusts to lighting. For example, even when the light in a room has a yellow hue from an incandescent light bulb, we will continue to perceive objects that we know to be white, such as printed pages, as white.

**TIP** For the best results, use a very pale color correction color, such as a pale blue or pale yellow.
Color correction can remove the color “cast” that comes from a light source.

**Desaturate Low Levels** When on, renders dimly lit colors as if the light were too dim for the eye to distinguish between colors. When off, renders even dimly lit colors. Default=off.

Desaturate Low Levels simulates the eye’s response to dim lighting. In dim lighting, the eye does not perceive colors and sees tones of gray instead. The effect of this setting is not apparent except at very low light levels, below 5.62 footcandles (lumens per square foot). When the illuminance is less than 0.00562 footcandles, the scene is completely gray.

**NOTE** 1 footcandle (fc) equals 10.76 lux (lumens per square meter).

**Affect Indirect Only** When on, Logarithmic Exposure control is applied only to areas of indirect lighting. Default=off.

Turn on this toggle when the primary lighting for your scene comes from standard lights rather than photometric lights. When you use standard lights and turn on Affect Indirect Only, radiosity and exposure control yield results similar to the default scanline renderer. When you use standard lights but leave Affect Indirect Only off, radiosity and exposure control yield results that can be quite different from the default scanline renderer.

In general, you don’t need to turn on Affect Indirect Only when the primary lighting for your scene comes from photometric lights.

**Exterior daylight** When on, converts colors for an outdoor scene. Default=off.
The exterior daylight setting compensates for the extreme intensity of an IES sun light.

**mr Photographic Exposure Control**

Set mental ray as the renderer. > Rendering menu > Environment > Environment and Effects dialog > Environment panel > Exposure Control rollout > Choose mr Photographic Exposure Control from the list. > mr Photographic Exposure Control rollout

The mr Photographic Exposure Control lets you modify rendered output with camera-like controls: either a general exposure value or specific shutter speed, aperture, and film speed settings. It also gives you image-control settings with values for highlights, midtones, and shadows. It’s intended for high-dynamic-range scenes rendered with the mental ray renderer on page 6675.

**NOTE** The mr Photographic Exposure Control contains a built-in gamma corrector (gamma 2.2), but this correction is disabled if the 3ds Max gamma correction on page 8330 is enabled on the Preferences dialog, letting the Rendered Frame Window apply the view gamma instead.

The Logarithmic exposure control on page 7215 also has a curve similar to a gamma correction, but unlike the Photographic exposure control, it is not designed to disable its gamma correction when overall gamma correction is on. For that reason, combining gamma correction with the Logarithmic exposure control is discouraged, whereas using it together with the Photographic exposure control is encouraged.
TIP  To see a definition of any numeric parameter on this rollout, hover the mouse cursor over the parameter’s spinner.

Exposure group

This group comprises a drop-down list of exposure presets plus a choice of Exposure Value or Photographic Exposure and associated parameters. Choosing one method makes the other's setting or settings unavailable, but they still change based on adjustments you make to the available method. For example,
when Exposure Value is active, adjusting its value also changes the Photographic Exposure > Shutter Speed setting.

**Preset** Choose from the available options based on setting and lighting conditions. The presets affect all of the remaining settings in this group.

**Exposure Value (EV)** Choose this option to specify a single Exposure Value setting that corresponds to a combination of the three Photographic Exposure values (see following). Each increment or decrement in the EV value corresponds to halving or doubling, respectively, the effective exposure, as expressed in the resultant change in the Shutter Speed value. Thus, higher values yield darker images, and lower values yield brighter images.

For example, as shown above, the combination of a shutter speed of 1/125 of a second, f/16, and ISO 100 results in an EV of 15. The same EV results from halving the shutter speed to 1/250 second and doubling the aperture size to f/11.

**Photographic Exposure** Lets you set the exposure using standard camera-oriented controls. These controls affect exposure only: Shutter Speed has no effect on motion blur; Aperture doesn’t influence depth of field; and Film Speed has no effect on graininess.

- **Shutter Speed** The duration, in fractions of a second, that the “shutter” is open. The higher this value, the greater the exposure.
- **Aperture** The size of the opening of the “camera iris,” expressed as a ratio. The higher this value, the lower the exposure.
- **Film Speed (ISO)** The sensitivity of the “camera film,” expressed as an index. The higher this value, the greater the exposure.

**Image Control group**

Use these controls to adjust the relative brightness or highlights, midtones, and shadows in the rendered image. The combination of these three settings is depicted in the graph on the right side of the rollout. Additional controls available here let you adjust color saturation, whitepoint, and vignetting.
Rendering with default settings (with final gathering)

**Highlights (Burn)** Controls the level of the brightest areas of the image. Higher values yield brighter highlights, while lower values darken the highlights.
Darkened (burnt-in) highlights

**Midtones** Controls the level of the areas of the image whose brightness lies between the highlights and the shadows. Higher values yield brighter midtones, while lower values darken the midtones.
Elevated midtones

**Shadows** Controls the level of the darkest areas of the image. Lower values yield lighter shadows, while higher values darken the shadows.
Lightened shadows

**Color Saturation** Controls the intensity of colors in the rendered image. Higher values result in more intense colors.
Color Saturation=2.0

**Whitepoint** Specifies the main color temperature of the light sources. This is similar to white balance controls on digital cameras. For daylighting, a value of 6500 is recommended, for incandescent lighting, a value of 3700 is recommended.

For example, photographs taken indoors might be lit by incandescent lights, which are relatively orange compared to daylight. Defining "white" as daylight will give unacceptable results when attempting to color-correct a photograph taken with incandescent lighting.

**Vignetting** Reduces the image brightness in the image periphery compared to the image center, resulting in a circular fully exposed area in the center, with darker edges.
Physical Scale Determines how 3ds Max calculates pixel values when outputting HDR (high-dynamic-range) images. You can use the physical scale inherent in the scene, or set an arbitrary physical scale for non-physically-based lighting situations.

- **Physical Units: (cd/m²)** Outputs physically correct HDR pixel values in candelas per square meter. Use this option when lighting the scene with photometric light sources.

  **TIP** When you use this option, the renderer interprets all non-physical (standard) illumination values in units of cd/m². If you use as a background image or texture map an HDR image with pixels correctly calibrated to cd/m², it will be correct in the scene. However, if you attempt to use a low-dynamic-range photo such as a JPEG photo, it will appear too dark in the rendered output. (The renderer interprets a white pixel in such an image as "1 cd/m²" by default, which is darker than the deepest dungeon.) So you need to increase the output on page 6192 of the image to match a useful cd/m² value. The sky can be around 3,000 cd/m².

- **Unitless** Lets you define how the renderer interprets the illumination from standard lights, which are not physically based. Use the numeric
setting to set the apparent illumination from these lights and the output pixel values based on the scene lighting. For example, with the default Physical Scale of 1500, a standard omni light is treated by the renderer as a photometric isotropic light of 1500 candelas. Physical Scale is also factored into the environment map and self-illumination.

**NOTE** This value does not affect apparent illumination of the rendered scene with photometric lights. However, it does affect the apparent illumination cast by non-physical (standard) lights. For predictable results, illuminate the scene only with photometric or standard lights (not a mix), and use Physical Units or Unitless, respectively.

**Gamma/LUT Settings** This group comprises text showing the status of the current Gamma/LUT settings, and a Setup button that opens the Preference Settings dialog to the Gamma and LUT panel on page 8330 so you can change the settings.

**Pseudo Color Exposure Control**

Rendering menu > Environment > Environment and Effects dialog > Environment panel > Exposure Control rollout > Choose Pseudo Color Exposure Control from the list. > Pseudo Color Exposure Control rollout

Pseudo Color Exposure Control is actually a lighting analysis tool that provides you with an intuitive way of visualizing and evaluating the lighting levels in your scenes. It maps luminance on page 8625 or illuminance on page 8606 values to pseudo colors that show the brightness of the values being converted. From darkest to brightest, the rendering shows blue, cyan, green, yellow, orange, and red. (Alternatively, you can choose a grayscale where the brightest values are white, and the darkest are black.) The rendering includes the colored or grayscale spectrum bar as a legend for the image.

After rendering the scene with pseudo color, 3ds Max displays a Rendered Frame Window on page 6513 labeled “Illuminance,” with a legend of illuminance values below the rendered image.

**NOTE** The Illuminance frame is not displayed if antialiasing is turned off.

**NOTE** You can use the Pseudo Color exposure control with the mental ray renderer on page 6675.
Pseudo color exposure of a scene with radiosity. Areas in red are overlit, areas in blue are underlit, and areas in green have a good lighting level.

In the Rendered Frame Window labeled “illuminance,” a legend appears below the image.

If you render a scene using this exposure control, 3ds Max creates a special render element on page 6818 named Illuminance that helps obtain accurate luminance and illuminance data.

**TIP** If you get a file write error when you try to render a pseudo color image, check the path and file name of the Illuminance element, or the permissions of the PNG file that saves the illuminance data.
Three spheres at an equal distance from a light source. The sphere on the left has a matte material, the sphere in the middle is glossy, and the sphere on the right is glossy but has a much darker color.

A display of illuminance shows that it is the same for all three spheres.

A display of luminance shows that the two spheres on the left reflect about the same amount of light, but the darker sphere on the right reflects little light except for its highlight.
See also:

- Environment Panel on page 7163

Interface

![Pseudo Color Exposure Control](image)

**Display Type group**

**Quantity** Chooses the value being measured.
- Illuminance (the default) displays values of light incident on surfaces.
- Luminance displays values of light reflected off surfaces.

**Style** Chooses the way to display values.
- Colored (the default) shows a spectrum.
- Grayscale shows gray tones that range from white to black.
  The spectrum bar displays the values the rendering will use.
Pseudo color display style:
Left: Grayscale
Right: Colored scale

Scale  Chooses the technique used to map values.
- Logarithmic (the default) uses a logarithmic scale.
- Linear uses a linear scale.
  The Logarithmic scale is useful when the illumination of the surfaces of interest is low compared to the maximum illumination in the scene.

Display Range group

Minimum (Min.)  Sets the lowest value to measure and represent in the rendering. Values at this quantity or below it all map to the leftmost display color (or grayscale level).

Maximum (Max.)  Sets the highest value to measure and represent in the rendering. Values at this quantity or above it all map to the rightmost display color (or grayscale value).
**Physical Scale** Sets a physical scale for exposure control to use with lights that are not physically based. The result is an adjustment of the rendering that approximates the eye's response to the scene.

Changing the value of Physical Scale is an optional step. Use it as a last resort when the materials or maps are not rendering correctly. Changing this setting will not affect anything in the scene unless your scene has an Ambient Color different than black. If you do adjust it, set the Physical Scale value to the equivalent of the brightest light source in the scene.

3ds Max multiplies each standard light's **Multiplier** on page 8649 by the Physical Scale value to produce a light intensity value in candelas. For example, with the default Physical Scale of 1500, a standard omni light is treated by the renderer and radiosity as a photometric isotropic light of 1500 candelas. Physical Scale is also factored into reflections, refractions, and self-illumination.

**TIP** When you use ray-tracing with self illumination, set Physical Scale to the equivalent of the brightest light source in the scene. This sets the appropriate conversion scale for reflections, self-illumination, and all other non-physically based elements a material offers. In some cases, an object might reflect or emit more light than the brightest light object in the scene; in this case, use the object's Luminance value as the Physical Scale.

Range=0.001 to 200,000.0 candelas. Default=1500.0. A single candle is approximately 1 candela (the unit can also be called a "candle"). A 100-Watt (W) incandescent light bulb is approximately 139 candelas (cd). A 60W bulb emitting in all directions is about 70 cd, while the same bulb with a reflector is about 4500 cd because the light flux is concentrated into a narrow angle.

Photometric lights are unaffected by the Physical Scale value. This parameter is animatable.
Above: Correct range for a scene
Middle: Too narrow a range
Below: Too great a range

Narrowing the range to focus on a single object

General Guidelines for Physical Scale Values

■ If you use only Photometric lights on page 5348, IES Sun on page 5506, and IES Sky on page 5509, the Physical Scale value is disregarded, and you don’t need to change it.

■ If you use Standard lights on page 5398, the Physical Scale value acts as a conversion scale that the radiosity engine uses to calculate energy. Set it to the equivalent of the brightest light source in the scene. This will set the appropriate conversion scale for reflections, self-illumination, and all other non-physically based elements a 3ds Max material offers. However, if you use the Affect Indirect Only flag in the Logarithmic Exposure Control on page 7215, you don’t need to worry about the physical scale setting.

Spectrum bar Shows the spectrum-to-intensity mapping. The numbers below the spectrum range from the Minimum to the Maximum settings.
When rendering with pseudo color, the spectrum bar is displayed beneath the pseudo color image, labeled either Luminance or Illuminance.

Lighting Data Exporter Utility

Utilities panel > Utilities rollout > More button > Utilities dialog > Choose Lighting Data Export. > Click OK. > 2D Lighting Data Exporter rollout

The Lighting Data Exporter renders the active viewport to images that include luminance on page 8625 and illuminance on page 8606 data that can be used for lighting analysis.

The Lighting Data Exporter does not render the files unless you have applied an exposure control on page 7207 to the scene.
You can render to either the TIFF file on page 7880 format. If you export to a TIFF file, the utility renders a single image file that has separate channels for luminance and illuminance (the file is of the 32-bit SGI LogLUV image type).

You can also render to the PIC file on page 7861 format. If you export to a PIC file, the utility renders two images: one containing luminance data, and the other containing illuminance data (see the description of the File Name button, below).

**Interface**

![2D Lighting Data Exporter](image)

**File Name** Click the button to specify a file name for the rendering.

When you export to the PIC format, the Lighting Data Exporter renders two files. It appends the string “_Illuminance” to the name of one file, and “_Luminance” to the other. For example, if you type `house` as the file name, the exporter renders to `house_illuminance.pic` and `house_luminance.pic`.

**Image Size group**

**Width** Sets the output width, in pixels. Default=640.

**Height** Sets the output height, in pixels. Default=480.

---

**Export** Click to render luminance and illuminance data.

**WARNING** Unlike the renderer, if you click Export more than once, this overwrites previously rendered files.
Atmospheric Apparatuses

Create panel > Helpers > Atmospheric Apparatus (from drop-down list)

You can create three types of atmospheric apparatuses, or gizmos on page 8593: box, cylinder, and sphere. These gizmos contain the fog or fire effect in your scene.

See also:
- Fire Environment Effect on page 7171
- Fog Environment Effect on page 7182
- Volume Light Environment Effect on page 7196

Add Atmosphere Dialog

Select Atmospheric Apparatus object. > Modify panel > Atmospheres & Effects rollout > Add button

The Add Atmosphere dialog lets you associate an atmosphere with the Atmospheric Apparatus on page 7236.
Interface

List of atmospheres Displays the atmospheres that you can associate with the apparatus.

New or existing group

These radio buttons choose between new or existing atmospheres.
New Lists only new atmospheres.
Existing Lists only atmospheres that have been already assigned to other apparatuses in the scene.
Adding an existing atmosphere creates a new atmosphere whose settings are initially identical to the previous one.

BoxGizmo Helper

Create panel > Helpers > Atmospheric Apparatus (from drop-down list) > BoxGizmo
Create menu > Helpers > Atmospherics > BoxGizmo
BoxGizmo lets you create a box-shaped gizmo in your scene. Clicking the BoxGizmo button displays the Box Gizmo Parameters rollout.

Box gizmo with volume fog

Procedures

To create the BoxGizmo:

1. Drag in a viewport to define the initial length and width, then release the mouse and drag vertically to set the initial height.
2. Click to end BoxGizmo creation.

To add a new atmosphere:

1. Select the apparatus gizmo.
2. In the Modify panel, on the Atmospheres & Effects rollout, click Add. This displays the Add Atmosphere dialog on page 7236.
3. Choose an atmosphere from the list.
4. Click OK.
This associates a new atmosphere with the apparatus.

**To add an existing atmosphere:**

1. Select the apparatus gizmo.
2. In the Modify panel, on the Atmospheres & Effects rollout, click Add. This displays the *Add Atmosphere dialog* on page 7236.
3. In the dialog, choose Existing.
4. Choose an atmosphere from the list.
5. Click OK.

This creates a duplicate atmosphere for the apparatus. Its settings are initially identical to the atmosphere you chose. You can adjust them using Setup.

**Interface**

**Name and Color rollout**

The *Name and Color rollout* on page 8182 lets you rename objects and change their wireframe color.

**Box Gizmo Parameters rollout**

*Length, Width, and Height* Set the dimensions of the box gizmo.
Seed  Sets a base value used to generate the atmospheric effect. Each apparatus in the scene should have a different seed. If more than one apparatus uses the same seed and same atmospheric effect, they will produce nearly identical results.

New Seed  Click to generate a random number automatically and place it in the seed field.

**Atmospheres & Effects rollout**

The Atmospheres & Effects rollout, available from the Modify panel, allows you to add and set up atmospheres directly to the gizmo.

**Add**  Displays the Add Atmosphere dialog on page 7236 from which you can add an atmosphere to the BoxGizmo.

**Delete**  Deletes a highlighted atmospheric effect.

**Setup**  Displays the Environment panel on page 7163, where you can edit the highlighted effect.

**CylGizmo Helper**

Create panel > Helpers > Atmospheric Apparatus (from drop-down list) > CylGizmo

Create menu > Helpers > Atmospherics > Cylinder Gizmo
CylGizmo lets you create a cylinder-shaped gizmo in your scene. Clicking the CylGizmo button displays the Cylinder Gizmo Parameters rollout.

Cylinder gizmo with volume fog

Procedures

To create the CylGizmo:

1. Drag in a viewport to define the initial radius, then release the mouse and drag vertically to set the initial height.
2. Click to end CylGizmo creation.

To add a new atmosphere:

1. Select the apparatus gizmo.
2. In the Modify panel on the Atmospheres & Effects rollout, click Add. This displays the Add Atmosphere dialog on page 7236.
3. Choose an atmosphere from the list.
4. Click OK.
This associates a new atmosphere with the apparatus.

**To add an existing atmosphere:**

1. Select the apparatus gizmo.
2. In the Modify panel on the Atmospheres & Effects rollout, click Add. This displays the *Add Atmosphere dialog* on page 7236.
3. In the dialog, choose Existing.
4. Choose an atmosphere from the list.
5. Click OK.

This creates a duplicate atmosphere for the apparatus. Its settings are initially identical to the atmosphere you chose. You can adjust them using Setup.

**Interface**

**Name and Color rollout**

The *Name and Color rollout* on page 8182 lets you rename objects and change their wireframe color.

**Cylinder Gizmo Parameters rollout**

![Image of Cylinder Gizmo Parameters rollout]

**Radius and Height** Set the dimensions of the cylinder gizmo.

**Seed** Sets a base value used to generate the atmospheric effect. Each apparatus in the scene should have a different seed. If more than one apparatus uses the
same seed and same atmospheric effect, they will produce nearly identical results.

**New Seed** Click to generate a random number automatically and place it in the seed field.

**Atmospheres & Effects rollout**

The Atmospheres & Effects rollout, available from the Modify panel, allows you to add and set up atmospheres directly to the gizmo.

**Add** Displays the Add Atmosphere dialog on page 7236 from which you can add an Atmosphere to the CylGizmo.

**Delete** Deletes a highlighted atmospheric effect.

**Setup** Displays the Environment panel on page 7163, where you can edit the highlighted effect.

**SphereGizmo Helper**

Create panel > Helpers > Atmospheric Apparatus (from drop-down list) > SphereGizmo

Create menu > Helpers > Atmospherics > Sphere Gizmo
SphereGizmo lets you create a sphere- or hemisphere-shaped gizmo in your scene. Clicking the SphereGizmo button displays the Sphere Gizmo Parameters rollout.

Sphere gizmo with volume fog

**Procedures**

**To create the SphereGizmo:**

1. Drag in any viewport to define the initial radius.
2. Adjust the radius with the spinner.

**To add a new atmosphere:**

1. Select the apparatus gizmo.
2. In the Modify panel on the Atmospheres & Effects rollout, click Add. This displays the Add Atmosphere dialog on page 7236.
3. Choose an atmosphere from the list.
4. Click OK.
This associates a new atmosphere with the apparatus.

**To add an existing atmosphere:**

1. Select the apparatus gizmo.
2. In the Modify panel on the Atmospheres & Effects rollout, click Add. This displays the Add Atmosphere dialog on page 7236.
3. In the dialog, choose Existing.
4. Choose an atmosphere from the list.
5. Click OK.

This creates a duplicate atmosphere for the apparatus. Its settings are initially identical to the atmosphere you chose. You can adjust them using Setup.

**Interface**

**Name and Color rollout**

The Name and Color rollout on page 8182 lets you rename objects and change their wireframe color.

**Sphere Gizmo Parameters rollout**

![Sphere Gizmo Parameters](image)

**Radius** Sets the radius of the default sphere.

**Hemisphere** When turned on, the bottom half of the SphereGizmo is discarded, creating a hemisphere.
**Seed** Sets a base value used to generate the atmospheric effect. Each apparatus in the scene should have a different seed. If more than one apparatus uses the same seed and same atmospheric effect, they will produce nearly identical results.

**New Seed** Click to generate a random number automatically and place it in the seed field.

**Atmospheres & Effects rollout**

The Atmospheres & Effects rollout, available from the Modify panel, allows you to add and set up atmospheres effects directly to the gizmo.

**Add** Displays the Add Atmosphere dialog on page 5455 from which you can add an Atmosphere to the SphereGizmo.

**Delete** Deletes a highlighted atmospheric effect.

**Setup** Displays the Environment panel on page 7163, where you can edit the highlighted effect.
Video Post, available from the Rendering menu, lets you combine (composite) and render output of various types of events, including the current scene, bitmap images, image-processing functions, and so on.

A video post queue can include scene geometry, background images, effects, and masks for compositing them.
Video Post is a self-contained, modeless dialog, similar in appearance to Track View. The edit window of the dialog shows when each event occurs in the finished video. Each event is associated with a track that has a range bar.

The Video Post dialog contains the following window components:

Video Post Queue on page 7248: Shows the sequence of post-production events.
Video Post Status Bar/View Controls on page 7250: Shows information about the active Video Post controls and lets you control the display of tracks in the event tracks area.
Video Post Toolbar on page 7271: Provides Video Post commands.

Video Post Queue

Rendering menu > Video Post > Video Post window > Video Post Queue

Video Post Queue provides a hierarchical list of the images, scenes, and events to be composited.
The Video Post queue in the Video Post dialog is similar to other hierarchical lists in the Track View and Material Editor. In Video Post, the list items are images, scenes, animations on page 8505, or external processes that together make up the queue. The items in the queue are called events.

The order that the events appear in the queue is the order in which they are executed, from top to bottom. Consequently, to correctly composite an image, the background bitmap must appear before, or above, the image that is to overlay it.

There is always at least one item in the queue (a placeholder labeled Queue). It is the queue's parent event.

The queue can be linear, but some kinds of events, such as Image Layer, combine other events and become their parent.

Procedures

To add an event to the queue:

- Click an event button.

  When you add an event, a dialog displays where you can specify settings for that event. The settings offered on the dialog depend on the type of event; some events have different kinds of subtypes.

  In general, the new event appears at the end of the queue - but some kinds of events require that you first select one or more events in the queue. An
Event button is unavailable if the selection in the queue (or the absence of one) is not legal input to the button's type of event.

To highlight an event already in the queue, click its icon, label, or range-bar area.

To delete any event in the queue:
- Select the event and press the Delete key.
  You can delete both enabled and disabled events, which are unavailable.

To switch the positions of two events in the queue:
1. Highlight both events.
2. Click Swap.
   This operation might not be allowed if the result would be impossible to execute. At the top level of the queue, you can almost always swap events; at lower levels, an event's output must be legal input to its parent event.

To edit an event in the queue, do one of the following:
1. Select the event and click Edit Current Event on page 7273.
2. Double-click the event name.
3. Double-click the event's range-bar area in the edit window.
   Use one of the second two methods for disabled events.

**Video Post Status Bar / View Controls**

Rendering menu > Video Post > Video Post Status Bar

The Video Post Status Bar contains an area for prompt and status information and for buttons to control the display of tracks in the event tracks area.

**Interface**

**Prompt Line**

```
Edit In/Out Points, pan event.
```
Displays instructions for using the currently selected function.

**Status (Start, End, Frames, Width, Height)**

| S:0 | E:201 | F:202 | W:720 | H:486 |

Displays the Start frame and End frame for the current event, the total number of frames and the output resolution of the entire queue.

**S/E** Shows start and end frames of the selected track. If no track is selected, shows the start and end frames of the entire queue.

**F** Shows the total frames in the selected track or for the entire queue.

**W/H** Shows the width and height of the image that results from the rendering of all the events in the queue.

**Pan**

![Pan](image)

Lets you drag horizontally in the event tracks area to shift the view left and right.

**Zoom Extents**

![Zoom Extents](image)

Adjusts the size of the event-track area horizontally so that all the frames of the longest track bar are visible.

Use Zoom Extents to quickly reset the display to show all frames after zooming in on a selection of frames with the Zoom Time button.

**Zoom Time**

![Zoom Time](image)

Displays a greater or lesser number of frames in the event tracks area, allowing you to scale or zoom the display. The time ruler displays the current time display unit.

Drag horizontally in the event tracks area to zoom time.

Drag right to display fewer frames in the track area (zoom in).

Drag left to display more frames in the track area (zoom out).
Zoom Region

Magnifies a region that you define by dragging a rectangle in the event tracks area.

Troubleshooting Video Post

While Video Post offers many useful functions and creative effects, invariably you will set up a queue that looks like it should work or even appears to render correctly only to give you an animation that does not include the desired effect. Here are some troubleshooting tips to reference when a queue just isn't doing what you expect.

There are two key things that can cause a Video Post queue to fail. The first is incorrect ordering and nesting of events in the queue. The second is faulty positioning and/or overlapping of the range bars.

When you come up again a problem, especially if you're attempting to set up a very complex queue, the best way to diagnose the problem is to create a new queue that should only result in the effect that is failing. If you can get the simplified queue to work, you can compare it to the structure of the failing queue to see what might be out of order.

Here are two very common scenarios that look like they should work but ultimately don't give you the result you expected. These examples are shown in their simplified state, but could very easily be buried in more complex queues.

- The object simply disappears instead of fading out.
  The first example illustrates a problem where you expect the scene to render for fifteen frames before fading to black to finish the animation. However, at frame sixteen, the scene abruptly goes black.
This queue shows all the correct events in the proper order in the queue. The problem is the timing and positioning of the range bars. The most likely cause of this problem is using the Abut Selection on page 7282 when it's not necessary. In order for the Fade event to work properly, it needs to overlap the animation for the amount of time you want to fade to occur. You need to take into account the number of frames where the scene actually fades.

To fix this queue, you have to decide how many frames over which the fade will occur. Let's say you want the scene to fade to black over ten frames. You would need to drag the right end of the Perspective event range bar ten frames to the right to overlap the Fade event.

- The object glows during rendering, but not in the animation.
  This second example is even more misleading than the first. The infuriating thing about this problem is that while the scene is rendering, the object in the scene shows the glow effect. When the resultant animation is played back, the Glow effect is not present.
Once again, this queue shows all the correct events, but the problem here is the ordering of the events in the queue. This problem is commonly caused when an event is selected while other events are being added. In this case, the Perspective event was select when the Lens Effects Glow and output events were added.

There are two ways to create this queue to give you the correct results. You can recreate the queue and add each event so there is no nesting, or you remove the current output event and add it again, making sure no other events are selected. The following images show the two ways this queue could be set up to successfully show the glowing object.
Useful Video Post Procedures

Rendering menu > Video Post

There are some tasks that you will use Video Post for more than others. This primer describes some of the more common sequences you'll find yourself using Video Post to create. The procedures are outlined in their simplest forms.

The following procedures are outlined:

- Make an object glow on page 7256
- Create an animation from a series of still images on page 7257
- Render a scene with a starfield on page 7258
- Set up a simple cross fade between two images on page 7259
- Resize a series of images on page 7261
- Composite two image sequences on page 7262
- Render a scene over an image sequence or an animation on page 7264
- Join two animations – end to end on page 7266
- Switch between views on page 7267
- Render a scene in reverse on page 7269
Procedures

Example: Make an object glow:

One of the most common things you'll want to do with the Glow filter is make an object glow. Here's how to do it in its simplest form.

1. In the Perspective viewport, create a Sphere with a radius of about 30.
2. Choose Rendering > Video Post.

3. Click Add Scene Event on page 7282 and set the view to Perspective. Click OK to close the Add Scene Event dialog.

4. Click Add Image Filter Event on page 7295 and choose Lens Effects Glow from the Filter Plug-In list. Click OK to close the Add Image Filter Event dialog.

5. Click Add Image Output Event on page 7302 and then click Files.
6. Set the output file format to BMP Image File and enter a filename like MyGlow. Click Save when you've set the name and format.

7. Click OK to accept the default setting on the BMP configuration dialog. Then click OK to close the Add Image Output Event dialog.

8. Right-click the Sphere to bring up the Quad Menus and select Properties.
9. Set the Object Channel in the G-Buffer group to 1 and click OK.

10. Click the Execute Sequence button on page 7276.

11. Click Render on the Execute Video Post dialog. You'll see the glowing sphere in the render window.
Example: Create an animation from a series of still images:

Another common process you'll use Video Post to achieve is taking a series of still images you've rendered and convert them to an animation. To accomplish this task, you need an IFL file on page 7841.

1. Use the IFL Manager Utility on page 7845 to create an IFL file containing the sequentially number image files you want to process.

2. Choose Rendering > Video Post.

3. Click Add Image Input Event on page 7288 and then click Files.
   Choose the IFL file you created at step 1 and then click Open to close the selection dialog.

4. Click OK to close the Add Input Image Event dialog.

5. Click Add Image Output Event on page 7302 and then click Files.

6. Set the output file format to AVI File on page 7832 and enter a filename like MyAnimation.
   Click Save when you've set the name and format

7. Select a codec on page 8533 from the Video Compression dialog and click OK.
   Then click OK to close the Add Image Output Event dialog.
Click the **Execute Sequence** button on page 7276.

Click **Render** on the Execute Video Post dialog. The final product is an animation.

**Example: Render a scene with a starfield:**

At some time, you’ll want to create a night scene that requires a starry sky. The key thing to remember when creating a star field is adding a camera to the scene. The Starfield filter only works with a camera. Here are the steps to set that up.

1. In the Top viewport, create a Sphere with a radius of about 30 and a Target Camera. Place the camera to one side and have it pointing at the center of the sphere.
2. Right-click in the Perspective viewport and press C to change the viewport display to Camera01.
3. Choose Rendering > Video Post.

4. Click **Add Scene Event** on page 7282 and make sure the view is set to Camera01. Click OK to close the Add Scene Event dialog.

5. Click **Add Image Filter Event** on page 7295 and choose Starfield from the Filter Plug-In list.
6 Click the Setup button to open the Stars Control dialog. Make sure Source Camera (at the top) is set to Camera01, and then click OK.

7 Click OK to close the Add Image Filter Event dialog.

8 Click Add Image Output Event on page 7302 and then click Files.

9 Set the output file format to BMP Image File and enter a filename like MyStarfield.
   Click Save when you've set the name and format

10 Click OK to accept the default setting on the BMP configuration dialog.
   Then click OK to close the Add Image Output Event dialog.

11 Click the Execute Sequence button on page 7276.

12 Set the time output to Single and click Render on the Execute Video Post dialog.
   The final product is a rendered image of a sphere against a starry background.

Set up a simple cross fade between two images:
Sometimes you want to transition from one view or animation to another. This set of steps with show you how to set up a cross fade from one image to another. For this example the complete cross fade will occur over 20 frames.
displaying the first image for five frames, cross fade for ten frame and then display the second image for the last five frames.

The resulting animation produced by this process could be used as an Image Input Event for a different Video Post sequence.

1 Choose Rendering > Video Post.

2 Click Add Image Input Event on page 7288 and then click Files. Choose your first image and click Open and then click OK to close the Add Image Input Event dialog.

3 Click Add Image Input Event again and click Files. Choose your second image and click Open and then click OK to close the Add Image Input Event dialog.

4 Click Add Image Output Event on page 7302 and then click Files. Set the output file format to MOV File and enter a filename like MyXDае. Click Save when you've set the name and format.

5 Click OK to accept the default setting on the Compression Settings dialog. Then click OK to close the Add Image Output Event dialog.

6 Select the first Image Input Event and then hold down the Ctrl key while selecting the second Image Input Event. Both events will highlight in gold.

7 Click Add Image Layer Event on page 7298 and choose Cross Fade Transition from the list of compositors and transitions. Click OK to close the Add Image Layer Event dialog. Notice how the Image Layer Event becomes the parent of the two Image Input Events.

8 Click Zoom Extents to view the entire set of tracks.

9 On the Queue track bar, click and drag the right-hand end of the range-bar to frame 20. This adjusts all the tracks.
11 Select the Cross Fade Transition event and drag the left-hand end of the range-bar to frame 5 and then drag the right-hand end of the range-bar to frame 15. This sets the period in time when the cross fade occurs.

12 Select the track for the first Image Input Event and the right-hand end of the range-bar to frame 8. By setting the end to frame 8 instead of 5, you'll have three frames during which the first image will fade to black.

13 Select the track for the second Image Input Event and the left-hand end of the range-bar to frame 12. Similarly, setting this end to frame 12 ensures that the second image will fade in over three frames and display in full color for the last five frame of the transition.

14 Click the Execute Sequence button on page 7276.

15 Click Render on the Execute Video Post dialog.

**Example: Resize a series of images:**

Perhaps you've rendered a series of still images but it turns out they were at the wrong resolution. You might normally think you have to re-render the entire scene again which will tie up all the systems to do the same work they just completed. Video Post can be used to resize the images without having to use all the systems.

1 Use the IFL Manager Utility on page 7845 to create an IFL file containing the sequentially number image files you want to resize.
2 Choose Rendering > Video Post.

3 Click Add Image Input Event on page 7288 and then click Files. Choose the IFL file you created at step 1 and then click Open to close the selection dialog.

4 Click OK to close the Add Input Image Event dialog.

5 Click Add Image Output Event on page 7302 and then click Files.

6 Set the output file format for the new set of still images to TGA and enter a filename like MyResize. Click Save when you've set the name and format.

7 Click OK to accept the default setting on the Targa Image Control dialog. Then click OK to close the Add Image Output Event dialog.

8 Click the Execute Sequence button on page 7276.

9 On the Execute Video Post dialog, set the new output resolution you want for the images and then click Render. When the rendering is complete, you will have a new series of resized images that have a name prefix of MyResize. So, if there were ten images listed in the IFL file, there will be ten new images named MyResize0000.tga through MyResize0009.tga stored in your image folder.
Example: Composite two image sequences:

Compositing two sets of images together is one of the “workhorse” operations of Video Post. This is commonly done when a project is nearing completion and it lets you combine all the images your artists have been rendering.

1. Use the IFL Manager Utility on page 7845 to create an IFL file for each set of images sequences you want to composite.

2. Choose Rendering > Video Post.

3. Click Add Image Input Event on page 7288 and then click Files. Choose your first IFL file and click Open and then click OK to close the Add Image Input Event dialog.

4. Click Add Image Input Event again and click Files. Choose your second IFL file and click Open and then click OK to close the Add Image Input Event dialog.

5. Click Add Image Output Event on page 7302 and then click Files.

6. Set the output file format to MOV File and enter a filename like MyComposite. Click Save when you've set the name and format.

7. Click OK to accept the default setting on the Compression Settings dialog. Then click OK to close the Add Image Output Event dialog.

8. Select the first Image Input Event and then hold down the Ctrl key while selecting the second Image Input Event. Both events will highlight in gold.

9. Click Add Image Layer Event on page 7298 and choose Alpha Compositor on page 7385 from the list of compositors and transitions. Click OK to close the Add Image Layer Event dialog. Notice how the Image Layer Event becomes the parent of the two Image Input Events.

10. Click the Execute Sequence button on page 7276.

11. Click Render on the Execute Video Post dialog.
Example: Render a scene over an image sequence or an animation:

This process is similar to the last one except you might have an animation or series of still images you want to use as the background for your existing scene.

1. Use the IFL Manager Utility on page 7845 to create an IFL file for the set of images that will be the background for your current scene.

2. Choose Rendering > Video Post.

3. Click Add Image Input Event on page 7288 and then click Files.
   Choose your IFL file or animation and click Open and then click OK to close the Add Image Input Event dialog.

4. Click Add Scene Event on page 7282 and set the view to Perspective or a Camera you have in the scene.
   Click OK to close the Add Scene Event dialog.

5. Click Add Image Output Event on page 7302 and then click Files.

6. Set the output file format to AVI File and enter a filename like MyScene.
   Click Save when you've set the name and format.

7. Select a codec on page 8533 from the Video Compression dialog and click OK.
   Then click OK to close the Add Image Output Event dialog.
8 Select the first Image Input Event and then hold down the Ctrl key while selecting the Scene Event.
   Both events will highlight in gold.

9 Click Add Image Layer Event on page 7298 and choose Pseudo Alpha on page 7386 from the list of compositors and transitions.
   Click OK to close the Add Image Layer Event dialog. Notice how the Image Layer Event becomes the parent of the two Image Input Events.

10 Click the Execute Sequence button on page 7276.

11 Click Render on the Execute Video Post dialog.

Notice that the Image Input Event in this example is only ten frames long. Normally, you'd choose a set of background images that equals the number of frames in your scene. When this sequence is executed, as is, the images in the IFL file will only appear for the first ten frames and then disappear.

12 Select the Image Input Event just under the Pseudo Alpha layer event.

13 Add a Loop Event and set the number of times to 4.
   The Image Input Event becomes further nested in the queue. If you want, you can use the default Loop setting or change it to Ping Pong then click OK to close the Add Loop Event dialog.

14 Click the Execute Sequence button again and render the scene.
Join two animations end to end:

If you're working in a production environment, you probably do not work on an entire animation by yourself. Instead, you might work on one part while other artists are working on other parts. At the end of the project, everyone's animations need to be joined together.

1. Choose Rendering > Video Post.

2. Click Add Image Input Event on page 7288 and then click Files. Choose your first animation file and click Open and then click OK to close the Add Image Input Event dialog.

3. Click Add Image Input Event again and click Files. Choose the next animation file and click Open and then click OK to close the Add Image Input Event dialog.

4. Repeat the last step for any other animations that need to be joined.

5. Click Add Image Output Event on page 7302 and then click Files.

6. Set the output file format to MOV File and enter a filename like MyFinal. Click Save when you've set the name and format.

7. Click OK to accept the default setting on the Compression Settings dialog. Then click OK to close the Add Image Output Event dialog.
8 Select the first Image Input Event and then hold down the Ctrl key while selecting the second Image Input Event. Both events will highlight in gold.

9 Click the Abut Selected button on page 7282.

10 Repeat the last two step with subsequent Image Input Events.

11 Click Zoom Extents to view the entire set of tracks.

12 Select the Image Output Event and drag the right end of the range-bar to match the total number of frames in the queue.

13 Click the Execute Sequence button on page 7276.

14 Click Render on the Execute Video Post dialog.

Switch between views:

It's not often that a final scene shows views from only one viewpoint. Either the camera moves or there are multiple cameras from which images are rendered. This sequence shows you how to switch from one camera view to another.

1 In the Perspective viewport, create a Box with a length of 15, a width of 30 and a height of 15.

2 In the Top viewport, create two Target Cameras pointing at the box from different angles.
3 Click or right-click the Point-Of-View (POV) viewport label in the Left viewport. From the **POV viewport label menu** on page 8122, choose Views > Camera01.

4 Click or right-click the POV viewport label in the Perspective viewport. From the **POV viewport label menu** on page 8122, choose Views > Camera02.

5 Choose Rendering > Video Post.

6 ![Click](image) Click **Add Scene Event** on page 7282 and set the view to Camera01. Click OK to close the Add Scene Event dialog.

7 ![Click](image) Click Add Scene Event again and set the view to Camera02. Click OK to close the Add Scene Event dialog.

8 Select the first Scene Event and then hold down the Ctrl key while selecting the second Scene Event. Both events will highlight in gold.

9 ![Click](image) Click the **Abut Selected button** on page 7282.

10 Click in an empty part of the queue to deselect the two Scene Events.

11 ![Click](image) Click **Add Image Output Event** on page 7302 and then click Files.

12 Set the output file format to MOV File and enter a filename like **MyViews**. Click Save when you’ve set the name and format.

13 Click OK to accept the default setting on the Compression Settings dialog. Then click OK to close the Add Image Output Event dialog.

14 ![Click](image) Click the **Execute Sequence button** on page 7276.

15 Click Render on the Execute Video Post dialog.
Render a scene in reverse:

It's not commonly done but when you need to render a scene in reverse you could spend hours trying to accomplish it. Video Post makes it easy.

1. Choose Rendering > Video Post.

2. Click Add Scene Event on page 7282 and set the view to Perspective or a camera in the scene.

3. In the Scene Range group, turn off Lock To Video Post Range and set the Scene Start value to the last frame of animation.

4. Turn off Lock Range Bar To Scene Range and set the Scene End value to 0.
5 Click OK to close the Add Input Image Event dialog.

6 Click Add Image Output Event on page 7302 and then click Files.

7 Set the output file format to AVI File and enter a filename like MyReverse. Click Save when you've set the name and format.

8 Select a codec on page 8533 from the Video Compression dialog and click OK.
Then click OK to close the Add Image Output Event dialog.

9 Click the Execute Sequence button on page 7276.
10 Click Render on the Execute Video Post dialog.

**Video Post Toolbar**

Rendering menu > Video Post toolbar

The Video Post Toolbar contains tools for handling Video Post files (VPX files on page 8758) and for managing the individual events displayed in the Video Post queue and event tracks area.

![Video Post Toolbar]

**New Sequence**

Rendering menu > Video Post > Video Post toolbar > New Sequence

The New Sequence button creates a new Video Post sequence by clearing existing events from the queue. You'll be prompted to confirm the deletion of any entries in the current queue.

**Procedures**

To create a new Video Post file:

- Click New Sequence.
WARNING This command erases all the current Video Post data.

Use New Sequence after you have saved to a different Video Post (VPX) file. Choosing Video Post from the Rendering menu displays the Video Post data (if any) saved with your 3ds Max scene.

Open Sequence

Rendering menu > Video Post > Video Post toolbar > Open Sequence

The Open Sequence button opens a Video Post sequence stored on disk. Video Post sequences contain all the information relating to the queue and all associated settings and references. VPX files on page 8758 have the file extension .vpx and are stored by default in the \3dsmax\vpost folder.

Procedures

To open an existing Video Post file:

- Click Open Sequence.
  Use the file selection dialog that appears to choose the VPX file you want to execute or edit.

To import an existing Video Post sequence:

You can also use Open Sequence to import the Video Post queue from a 3ds Max scene (MAX file).

1. Click Open Sequence.
2. On the Open Sequence dialog, change the Files Of Type setting to All Files (*.*)
3. Browse to the folder where you store your MAX files.
4. Select the MAX file that contains the Video Post sequence you want to execute or edit and click Open.
   Video Post loads only the Video Post data from the existing .max file, leaving your current scene unchanged.
Save Sequence

Rendering menu > Video Post > Video Post toolbar > Save Sequence

The Save Sequence button saves the current Video Post sequence to disk.

All of the Video Post configuration data, the queue events themselves, and any queue event external data are saved in the MAX file. You can also save the Video Post sequence to a separate file for sharing with other 3ds Max users.

Video Post sequence files contain all the information relating to the queue and all associated settings and references. VPX files on page 8758 have the file extension .vpx and are stored by default in the \3dsmax\vpost folder.

Procedures

To save the active Video Post data:

- Click Save Sequence.
  
  A file selection dialog appears to let you enter a name for the new Video Post file.
  
  By default, Save Sequence stores the VPX file to the \3dsmax\vpost subdirectory. You can change the default path to another directory via the Configure User Paths dialog > File I/O panel on page 8287.

Edit Current Event

Rendering menu > Video Post > Video Post window > Select an event. > Video Post toolbar > Edit Current Event

The Edit Current Event button displays a dialog that lets you edit the properties of the selected event. The dialog depends on the type of event you've selected. The controls in the edit dialogs are the same as those in the dialog you use to add that type of event.

The top field in each event dialog is an editable label field. If the field is left blank, the event uses its assigned label. If you enter an event name, the Video Post Queue displays your event name in the field.

You can edit the following types of events:
Add Scene Event on page 7282
Add Image Input Event on page 7288
Add Image Filter Event on page 7295
Add Image Layer Event on page 7298
Add Image Output Event on page 7302
Add External Event on page 7305
Add Loop Event on page 7308

Procedures

To edit an event in the queue, do one of the following:

1. Select the event and then click the Edit Current Event button.
2. Double-click the event name.
3. Double-click the event's range-bar area in the edit window.

Use the second or third method above with disabled events.

Delete Current Event

Rendering menu > Video Post > Video Post window > Select an event. > Video Post toolbar > Delete Current Event

The Delete Current Event button deletes the selected event from the Video Post Queue.

You'll be asked to confirm event deletion.

Procedures

To delete any event in the queue:

- Select the event and press the Delete key.

You can delete both enabled and disabled events, which are unavailable.
Swap Events

Rendering menu > Video Post > Video Post window > Select two events. > Video Post toolbar > Swap Events

The Swap Events button switches the position of two selected events in the queue.

This is useful if you have images in the wrong order for compositing. The background image has to be first and the foreground image with the alpha channel on page 8502 has to be second.

Procedures

To switch the positions of two events in the queue:

1. Highlight both events.
2. Click Swap.

Swap Events might not be allowed if the result would be impossible to execute.

In this sample queue, the two top level events, Front and Fade, could be swapped. You can almost always swap events at the top level.
However, at lower levels, where events start getting nested, the output of a lower level event must be valid input to its parent event. In the sample queue, the output of the Loop Once event would not be recognized by the Fade event, so the Swap Events button remains inactive and you cannot swap them.

**Execute Sequence**

Rendering menu > Video Post > Video Post toolbar > Execute Sequence

You execute the Video Post queue as the final step in creating a post-produced video. Execution is different from rendering because rendering is done for scenes only and you can use Video Post to composite images and animations without including the current 3ds Max scene.

Although the Execute Video Post controls are similar to those of the Render Setup dialog, the setting are independent, and do not affect each other.

During execution, you can move or close the rendered frame window, but you cannot use the rest of 3ds Max until the execution is completed or cancelled.

The rendering time for the last rendered frame in the Video Post sequence is displayed in the prompt line of the main 3ds Max window.

**Procedures**

To execute the queue:

1. Click Execute Sequence.
   
   An Execute Video Post dialog appears.

2. Set the time range and output size, and then click Render to create the video.

3. When execution is done, click Close to dismiss the Video Post progress dialog if it is still open.
Interface

Time Output group

Select the frames to execute:

**Single** Current frame only. You can execute a single frame only if it falls within the current range.

**Range** All the frames between and including the two numbers.

**Every Nth frame** Regular sample of frames. For example, enter 8 to execute every 8th frame.

Output Size group

**Format** Choose Custom or a standard film or video format from the list. For Custom, you can set the aperture width of the camera, the rendering output resolution, and the image aspect ratio or pixel aspect ratio. When you choose a standard format, the aperture width and aspect ratios are locked, but you can change the resolution.

**Width/Height** Specify the width and height of the image, in pixels. For Custom, you can set these two spinners independently. For other formats, the two spinners are locked to the specified aspect ratio, so changing one changes the other.

**Resolution Buttons** Specifies a preset resolution. Right-click a button to display a subdialog on page 7278 that lets you change the resolution specified by that button.
Image Aspect Sets the aspect ratio of the image. As you alter the Image Aspect, you also alter the Height value to maintain the correct aspect ratio. For standard formats, the image aspect ratio is locked, and this spinner is replaced by a text display.

If you lock the Image Aspect (by clicking the Lock button), Width and Height are locked to each other, so that changing one changes the other to maintain the image aspect ratio, and changing the Pixel Aspect value changes the Height value to maintain the image aspect ratio.

Pixel Aspect Sets the aspect ratio of the pixels of the image. For standard formats, the pixel aspect ratio is determined by the format and this spinner is replaced by a text display.

If you lock the pixel aspect ratio (by clicking the Lock button), the Pixel Aspect spinner is replaced by a text display. The Lock button is available only for the Custom format.

Output group

Keep Progress Dialog Forces the Video Post Progress dialog to remain displayed when the Video Post sequence has finished executing. By default, it closes automatically. If this option is selected, you must click the Close button to close the dialog.

Rendered Frame Window Displays the Video Post execution in a window on the screen.

Net Render Enables network rendering on page 8652. If Net Render is turned on, when you render you'll see the Network Job Assignment dialog on page 6953.

Configure Presets

Rendering menu > Video Post > Video Post toolbar > Execute Sequence > Right-click any Resolution button > Configure Presets dialog

If you use the Custom format for Execute Sequence on page 7276, you can change the values for any preset resolution button by right-clicking the button.

If you use one of the standard formats, the Width and Height spinners are locked to the standard's image aspect ratio, and the Aspect Ratio spinner is replaced by a text display.

After you change these values and exit the Configure Presets dialog, you must click the button to apply the new values to the Execute Sequence dialog.
Interface

Width Specifies the width of the image, in pixels.

Height Specifies the height of the image, in pixels.

AspectRatio Sets the aspect ratio of the image. As you alter the Image Aspect value, you also alter the Height value so that the correct aspect ratio is maintained for the resolution.

Edit Range Bar

Rendering menu > Video Post > Video Post toolbar > Edit Range Bar

The Edit Range Bar provides editing functions for the range bars that appear in the event tracks area.

When Edit Range Bar is on, you can:

- Select any event by clicking its range bar (it turns red when selected).
- Move the range bar while maintaining its range by dragging in the middle of the bar.
- Change the start or end frame of the range by dragging either end of its bar.

Procedures

To select a range bar, do one of the following:

1. Click the range bar in the event tracks area.
2. Click the associated event name or icon in the queue.
To select multiple range bars:
1. Click a range bar.
2. Hold down Ctrl and click additional range bars.

To select multiple contiguous range bars:
1. Click a range bar.
2. Hold down Shift and click another range bar.

Both range bars you clicked and all range bars between them, if any, are selected.

NOTE In a multiple selection, the last range bar you select becomes the current event, displayed with red squares in its endpoints. The align commands use the current event.

To move a range bar:
- Click and drag the center of the range bar left or right.

To change the length of a range bar:
- Click and drag one of range bar's endpoints left or right.
  If multiple range bars are selected, dragging one endpoint changes all selected range bars.

To change the number of frames in an event:
1. Double-click the range bar in the event tracks area or select the event and click the Edit Current Event button.
2. Change the VP Start Time or VP End Time values.

Align Selected Left

Rendering menu > Video Post > Video Post window > Select two or more range bars. > Video Post toolbar > Align Selected Left

The Align Selected Left button left-aligns two or more selected range bars.
When you select two or more range bars, the last one selected is the current event. The end boxes of the other events are white, while the end boxes of the current event are red. When you click Align Selected Left, the current event stays in place, and the remaining selected events are aligned to its left end.

**Procedures**

To change the number of frames in an event, do one of the following:

1. Double-click the range bar in the event tracks area.
2. Click the Edit Current Event button in the toolbar.

**Align Selected Right**

Rendering menu > Video Post > Video Post window > Select two or more range bars. > Video Post toolbar > Align Selected Right

The Align Selected Right button right-aligns two or more selected range bars.

When you select two or more range bars, the last one selected is the current event. The end boxes of the other events are white, while the end boxes of the current event are red. When you click Align Selected Right, the current event stays in place, and the remaining selected events are aligned to its right end.

**Procedures**

To change the number of frames in an event, do one of the following:

1. Double-click the range bar in the event tracks area.
2. Click the Edit Current Event button in the toolbar.

**Make Selected Same Size**

Rendering menu > Video Post > Video Post window > Select one or more events. > Video Post toolbar > Make Selected Same Size
The Make Selected Same Size button makes all selected events the same size as the current event.

When you select two or more range bars, the last one selected is the current event. The end boxes of the other events are white, while the end boxes of the current event are red. When you click Make Selected Same Size, the current event stays in place, and the remaining selected events are expand or shrink to cover the same number of frames.

**Procedures**

To change the number of frames in an event, do one of the following:

1. Double-click the range bar in the event tracks area.
2. Click the Edit Current Event button in the toolbar.

**Abut Selected**

Rendering menu > Video Post > Video Post window > Select events in the queue. > Video Post toolbar > Abut Selected

The Abut Selected button places the selected events end-to-end, so that when one ends the next one starts.

The selected events are placed end-to-end according to their order in the queue.

**Add Scene Event**

Rendering menu > Video Post > Video Post window > Make sure no events are selected in the queue. > Video Post toolbar > Add Scene

Rendering menu > Video Post > Video Post window > Select a scene from the Video Post Queue. > Video Post toolbar > Edit Current Event

The Add Scene Event button adds the scene in the selected camera viewport to the queue. A Scene event is a view of the current 3ds Max scene. You can choose which view to display and how to synchronize the scene with the final video. Like Image Input events, Scene events place an image in the queue, but a Scene event is the current 3ds Max scene and it must be rendered when you execute the Video Post queue. The scene is rendered exactly as it would be by
the scanline renderer on page 8709, with the additional options listed below. The resulting scene image has an alpha channel on page 8502.

You can use multiple Scene events to show two views of the same scene simultaneously or to cut from one view to another. If you have more than one Scene event in the queue, and they occupy the same time range, composite them with an Image Layer event on page 7298 such as Cross Fade or Simple Wipe. Otherwise, the second Scene Event overwrites the first even though your system has spent the time processing both events.

Procedures

To add a Scene event:

1. Make sure no events are selected in the queue.

2. Click Add Scene. An Add Scene Event dialog appears.

3. Choose a view to use from the View list.

4. Click Render Setup to change rendering settings from the way you have set them in the Render Setup dialog.

**NOTE** Unlike settings in the Execute Video Post dialog, changes you make to the Scene event rendering options change the Render Setup dialog settings, and vice-versa.

5. Set the Scene Range options and click OK.

   The Scene event appears at the end of the queue.

To match the scene’s frames with Video Post frames:

- Make sure Lock To Video Post Range is selected.

Lock To Video Post Range is the default. Frames in the scene match Video Post frames and have the same frame number. That is, frame 0 in the scene is frame 0 in the Video Post dialog, frame 15 in the scene is frame 15 in Video Post, and so on. The range bar for the Scene event represents which portion of the scene is selected. If the range bar covers Video Post frames 25 to 35, executing the queue renders scene frames 25 to 35. Moving the range bar for the scene is like moving a time window within the scene.

Other Scene Range options are disabled when Lock To Video Post Range is selected.
To offset the scene in time:

- Select Lock Range Bar To Scene Range.
  The Scene Start control is enabled but the Scene End control remains disabled: synchronization is controlled by the Scene Start value and the length of the range bar.
  The Scene Start value is the scene frame number where playback begins. If Scene Start is 0, frame 0 of the scene is the first frame played back; if Scene Start is 12, frame 12 is the first frame to play, and so on.
  The range bar length determines how many frames of the scene to play. Dragging the end point of the range bar changes the length of the playback range. Although Scene End is unavailable, its value updates to show the frame number of the last scene frame that will be played.
  Dragging the range bar changes where the scene is played within the final video. For example, if you set Scene Start to 5 and move the range bar to begin at Video Post frame 20, frame 5 is played at frame 20 of the final video, and so on.

To offset the scene and change scene playback rate:

- Turn off Lock Range Bar To Scene Range.
  With Lock Range Bar to Scene Range off, both Scene Start and Scene End are enabled. As before, Scene Start specifies the first scene frame to play. Scene End specifies the last scene frame to play, and the length of the range bar determines playback speed.
  If the range bar specifies the same number of Video Post frames as there are corresponding scene frames, then playback is at the scene's playback rate. If the range bar specifies fewer frames, the scene is sped up. If the range bar specifies more frames, the scene is slowed down. When it executes, Video Post automatically skips frames or adds frames to control the speed of scene playback.
  For example, if Scene Start is frame 5 and Scene End is frame 35, the range bar represents 30 frames overall. If the range bar covers only 10 Video Post frames, scene playback is sped up to fit 30 frames into 10 of the final video. If on the other hand, the range bar covers 120 frames, scene playback is stretched to slow it down.

To render the full scene backwards:

1. Turn off Lock To Video Post Range.
2. Turn off Lock Range Bar To Scene Range.
3 Set Scene Start to the last frame in the scene.

4 Set Scene End to the first frame in the scene.
   The length of the range bar also determines the playback speed of the
   reversed scene.

**To add scene motion blur:**

1 Select Scene Motion Blur in the Scene Event dialog.

2 Set the scene motion blur parameters.
   The Scene event generates motion blur by simulating a camera with an
   open shutter. It interpolates and then renders movement within a frame,
   to generate a series of images of the moving object, instead of the default
   single image.

**Interface**

The Add Scene Event and Edit Scene Event dialogs have the same controls.
View group

**Label** Lets you edit the event name. A unique name can make the scene event easier to distinguish in a long list of events.

**Viewport** Select the viewport you want to render.

Scene Options group

Enables various rendering effects.

**Render Setup** Displays a subset of the Render Setup dialog on page 6506 parameters. Changes you make here affect the Render Setup dialog as well.
Scene Motion Blur  Turns on the scene motion-blur on page 8710 effect for the whole scene. This is different from object motion blur on page 8658, which creates motion blur for individual objects in the scene.

When you render with Scene Motion Blur activated, the Render Progress dialog tells you which subsample is being rendered. The information appears in parentheses to the right of the "Rendering Image" text.

**Duration**  Sets the virtual shutter speed for motion blur. When set to 1.0, the virtual shutter is open for the entire duration between one frame and the next. When set to a smaller number, such as 0.25, the number of subdivisions specified in the Duration Subdivision field will be rendered within the specified portion of the frame (in this example, in the first fourth of the duration between one frame and the next).

**Duration Subdivisions**  Determines how many sub-frame slices are rendered within the Duration. The default is 2 slices, but you'll want at least 5 or 6 to get a decent effect.

**Dither %**  Sets the amount of dithering on page 8553 between blurred pixels of overlapping frame slices. If Dither % is set to 0, no dithering occurs.

**Scene Range group**

**Scene Start/End**  Sets the range of scene frames to be rendered.

**Lock Range Bar to Scene Range**  Becomes available when you deselect Lock To Video Post Range. When it's available, the End spinner is disabled and locked to the Video Post range. When you change the Start spinner it automatically updates the End spinner based on the Video Post range set for this event.

If you turn off Lock Range Bar To Scene Range, you can change either Start or End spinners to whatever you want. This allows you to keep your scene range locked to its native length, and still provides flexibility for mapping an arbitrary scene range to an arbitrary Video Post range.

**Lock to Video Post Range**  Renders the same range of scene frames as Video Post frames. You can set the Video Post range in the Execute Video Post dialog.

**Video Post Parameters group**

**VP Start Time/End Time**  Sets the starting and ending frames for the selected event within the overall Video Post queue. Video Post renders the event over the number of frames specified here.
Enabled Toggles the event. When off, the event is disabled and Video Post ignores it when rendering the queue. You must disable each event individually. For example, disabling a composite layer event does not disable the composited image events. The range bars of disabled events are unavailable in the event track area.

Add Image Input Event

Rendering menu > Video Post > Video Post window > Make sure no events are selected in the queue. > Video Post toolbar > Add Image Input Event

Rendering menu > Video Post > Video Post window > Select an Image Input Event. > Video Post toolbar > Edit Current Event

The Add Image Input Event adds a still or moving image to the scene. Image Input events place an image in the queue, but unlike Scene events, the image is either a file that was saved beforehand or a device-generated image.

The image can be in one of the following file formats:

- AVI Files on page 7832
- BMP Files on page 7834
- CIN (Kodak Cineon) Files on page 7834
- CWS (Combustion Workspace) Files on page 7835
- GIF Files on page 7841
- Radiance Image Files on page 7866
- IFL Files on page 7841
- MOV (QuickTime Movie) Files on page 7849
- MPEG Files on page 7850
- JPEG Files on page 7848
- PNG Files on page 7862
- PSD Files on page 7863
- RLA Files on page 7873
- RPF Files on page 7875
- RGB (SGI Image) Files on page 7877
**Procedures**

**To add an Image Input event:**

1. Make sure no events are selected in the queue.

2. Click Add Image Input Event.
   
   An Add Image Input Event dialog appears.

3. Click Files to choose a bitmap or animation as the image, or click Devices to choose an image-generating device.
   
   If you click Files, a file dialog appears to let you choose the bitmap or animation file.
   
   If you choose Devices, a Select Image Input Device dialog appears. This dialog has a list of installed device options.

4. Click Options to choose the size and placement of the image in the final video frames.
   
   An Image Input Options dialog appears.

5. Adjust other Image Input settings, and then click OK.
   
   The Image Input event appears at the end of the queue.

---

**TIP** Think of images that share the same time range as layers, comparable to matted film images in a compositor. Images that share a time range must be composited with an Image Layer event on page 7298; otherwise, the second image in the queue "overwrites" the first.

---

**To align the input image, do one of the following in the Image Input Options dialog:**

1. Choose Presets and then click one of the preset alignment buttons.

2. Choose Coordinates and then enter the X,Y coordinates for the image's location.
The upper-left corner is (0,0) for both the input image and the output frame. Increasing X moves the image to the right, and increasing Y moves the image down. Negative values move the image in the opposite direction. X and Y values specify pixels.

To set the input image size, do one of the following in the Image Input Options dialog:

1. Choose Do Not Resize to maintain the image's original resolution.
2. Choose Resize To Fit to change the image size to match the output frame. This can change the image resolution, causing it to be rescaled for every frame.
3. Choose Custom Size and then enter the width and height of the image in the output frame.

To control playback of an animated image:

1. In the Frames group of the Image Input Options dialog on page 7292, set the input animation frame range and speed.
2. Turn on Loop At The End if you want the animation to repeat. Turn off Loop At The End if you want the animation to stop after playback. This option applies only when the input animation is shorter than the final video.

Interface

The Add Image Input Event and Edit Image Input Event dialogs have the same controls.
Image Input group

**Label** Lets you give the event a unique name. A unique name can make the image event easier to distinguish in a long list of events.

**Files** Lets you choose the bitmap or animation image file.

**Devices** Lets you choose an installed hardware input device; for example, a digital disk recorder.

**Options** Displays the [Image Input Options dialog](#) on page 7292 to allow you to set up alignment, size, and frame range for the input image.

**Cache** Stores a bitmap in memory. If you are using a single-image bitmap, you can choose this option. Video Post won't reload or scale the image for each frame.

Image Driver group

These buttons are available only when you choose a device as the image source.
About Provides information on the source of the image-handler software used to bring the image into 3ds Max.

Setup Displays a setup dialog specific to the plug-in. Some plug-ins might not use this button.

Video Post Parameters group

VP Start Time/End Time Sets the starting and ending frames for the selected event within the overall Video Post queue. Video Post renders the event over the number of frames specified here.

Enabled Enables or disables the event. When this box is off, the event is disabled and Video Post ignores it when rendering the queue. Each event must be disabled individually. For example, disabling a composite layer event does not disable the composited image events. The range bars of disabled events are unavailable in the event track area.

Image Input Options

Rendering menu > Video Post > Video Post window > Make sure no events are selected in the queue. > Video Post toolbar > Add Image Input Event > Select a file for input. > Options

The Image Input Options dialog contains controls for setting the image's size and placement relative to the frames of video output. For animated input, you also use it to synchronize the Image Input event with the frame sequence of video output. The same dialog appears when you click Options from the Mask area of the Filter Event and Layer Event dialogs.

Procedures

To align the input image, do one of the following in the Image Input Options dialog:

1. Choose Presets and then click one of the preset alignment buttons.
2. Choose Coordinates and then enter the X,Y coordinates for the image's location.
   
   The upper-left corner is (0,0) for both the input image and the output frame. Increasing X moves the image to the right, and increasing Y moves the image down. Negative values move the image in the opposite direction. X and Y values specify pixels.
To set the input image size, do one of the following in the Image Input Options dialog:

1. Choose Do Not Resize to maintain the image's original resolution.
2. Choose Resize to Fit to change the image size to match the output frame. This can change the image resolution, causing it to be rescaled for every frame.
3. Choose Custom Size and then enter the width and height of the image in the output frame.

To control playback of an animated image:

1. In the Frames group, set the From, To and Step values.
2. Select Loop at the End if you want the animation to repeat. Clear Loop at the End if you want the animation to stop after playback. This option applies only when the input animation is shorter than the final video.
Interface

Alignment group

**Presets** Positions the image according to one of the preset buttons: Top-left, Center, Top-right, and so on. Mutually exclusive with Coordinates.

**Coordinates** Positions the image according to coordinates you enter. Mutually exclusive with Presets.

Size group

**Do Not Resize** Retains the image's original, stored dimensions.

**Resize to Fit** Resizes the image to the size of the Video Post rendered image (default).

**Custom Size** Resizes the image according to width and height units you enter.
Frames group

From/To Specifies the range of frames to use if the image input file is an animation or video.

Step Sets the interval between the frames you want to use. For example, if this spinner is set to 7, 3ds Max uses every seventh frame.

Loop at End Plays the frames from the beginning when the last frame is reached. This will take effect if the frame range used is less than the Video Post frame range.

Add Image Filter Event

Rendering menu > Video Post > Video Post window > Make sure no events are selected in the queue. > Video Post toolbar > Add Image Filter Event

Rendering menu > Video Post > Video Post window > Select a filter from the Video Post Queue. > Video Post toolbar > Edit Current Event

The Add Image Filter Event provides image processing for images and scenes. Several kinds of image filters are provided, see list below. For example, the Negative filter inverts the colors of an image and the Fade filter fades an image in or out over time.

An Image Filter event is usually a parent event with a single child (which can itself be a parent with children), for example, a Scene event, an Image Input event, a Layer event that contains Scene or Image Input events, or a Filter event that contains Scene or Image Input events. You can also add an Image Filter without a child event, in which case the Image Filter processes the result of the previous events in the queue.

Available Image Filters

Contrast Filter on page 7311
Fade Filter on page 7312
Image Alpha Filter on page 7313
Lens Effects Filters on page 7314
Negative Filter on page 7377
Pseudo Alpha Filter on page 7379
Simple Wipe Filter on page 7379
Starfield Filter on page 7381

Procedures

To add an image filter event:

1  Either select a valid child event, or make sure no event is selected in the queue.

2  Click Add Image Filter Event.
    An Add Image Filter Event dialog appears.

3  Choose the kind of filter you want from the Filter Plug-In list.

4  If the Setup button is enabled for this kind of filter, click Setup to set the filter options.

5  Choose a mask if you want the filter to be masked or if the kind of filter you're using requires it.

6  Adjust other Image Filter settings, and then click OK.
    If you selected a child event, the Image Filter event becomes its parent.
    If no event was selected, the Image Filter event appears at the end of the queue.

To choose the mask file:

1  Click Files.

2  Use the file dialog to choose the mask file, and then click OK.

3  Choose the channel to use from the drop-down list of channels.

To position or resize the mask:

- Click Options.
  An Image Input Options dialog appears, identical to the dialog you use with Image Input events.
  If the mask is animated, you also use this dialog to specify its time range and playback speed.
Interface

The Add Image Filter Event and Edit Filter Event dialogs have the same controls.

**Filter Plug-In group**

**Label** Lets you give the event a unique name. A unique name can make the filter event easier to distinguish in a long list of events.

**Filter List** Lists the filter plug-ins on page 8687 you have installed. See the separate help topics for a description of the filters that come with 3ds Max by clicking any of the filters listed above.

**About** Provides version and source information specific to the plug-in.

**Setup** Displays a setup dialog specific to the plug-in. Some plug-ins might not use this button.
Mask group

Channels If you are using a bitmap as the mask file, you can use the Alpha channel, the Red, Green, or Blue channel, Luminance, Z-Buffer, Material ID channel, or Object ID.

Files Select a file to use as a mask. The name of the selected file appears above the Files button.

Options Displays an Image Input Options dialog on page 7292 where you can set alignment and size, relative to the frames of video output. For animated images, you can also synchronize the mask with the frame sequence of video output. This is the same dialog used for Image Input Event options.

Enabled Enables the mask. If turned off, Video Post ignores any other mask settings.

Inverted When turned on, the mask is inverted.

Video Post Parameters group

VP Start Time/End Time Set the starting and ending frames for the selected event within the overall Video Post queue. Video Post renders the event over the number of frames specified here.

Enabled Enables or disables the event. When turned off, the event is disabled and Video Post ignores it when rendering the queue. Each event must be disabled individually. For example, disabling a composite layer event does not disable the composited image events. The range bars of disabled events are unavailable in the event track area.

Add Image Layer Event

Rendering menu > Video Post > Video Post window > Make sure the two child events are in the order you want the Image Layer event to use them. > Select the two events. > Video Post toolbar > Add Image Layer EventRendering menu > Video Post > Video Post window > Select a Layer Event. > Video Post toolbar > Edit Current Event

The Add Image Layer Event adds a compositing plug-in on page 8687 to layer the selected images in the queue.

Provides compositing plug-ins that use the previous event in the queue as a source, and composite the next event, using the parameters of the plug-in.
compositor. The list might include plug-ins for special transformations, such as wipes, and so on.

An Image layer event is always a parent event with two children. The children can themselves be parent events with children. The children of an Image Layer event can be Scene events, Image Input events, Layer events that contain Scene or Image Input events, or Filter events that contain Scene or Image Input events.

**Available Image Layer Event Filters**

- Alpha Compositor on page 7385
- Cross Fade Compositor on page 7385
- Pseudo Alpha Compositor on page 7386
- Simple Additive Compositor on page 7387
- Simple Wipe Compositor on page 7388

**Procedures**

**To add an image layer event:**

1. Make sure the two child events are in the order you want the Image Layer event to use them.

2. Select the two events.
   - Click to select the first event, then hold Ctrl and click to select the second.

3. [Click Add Image Layer Event.](#) An Add Image Layer Event dialog appears.

4. Choose the kind of layer event you want from the Layer Plug-In drop-down list.

5. If the Setup button is enabled for this kind of layer event, click Setup to set the options.

6. Choose a mask if you want the layer event to be masked.

7. Adjust other Image Layer settings, and then click OK.
   - The Image Layer event becomes the parent of the two child events you selected.
To choose the mask file:

1. Click Files.
2. Use the file dialog to choose the mask file, and then click OK.
3. Choose the channel to use from the drop-down list of channels.

To position or resize the mask:

- Click Options.
  
  An Image Input Options dialog appears, identical to the dialog you use with Image Input events.
  
  If the mask is animated, you also use this dialog to specify its time range and playback speed.

Interface

The Add Layer Image Event and Edit Layer Event dialogs have the same controls.
Layer Plug-In group

**Label** Lets you give the event a unique name. A unique name can make it easier to distinguish the layer event in a long list of events.

**Layer List** Selects the compositor 3ds Max uses for layering the rendered images in the queue. Alpha is the default compositor, but you can also choose from any others you have installed. See the separate help topics for descriptions of the compositors that come with 3ds Max.

**About** Provides version or source information specific to the plug-in on page 8687.

**Setup** Displays a setup dialog specific to the plug-in. Some plug-ins might not use this button.

Mask group

**Channels** If you are using a bitmap as the mask file, you can use the Alpha channel, the Red, Green, or Blue channel, Luminance, Z-Buffer, Material ID channel, or Object ID.

**Files** Select a file to use as a mask. The name of the selected file appears above the Files button.

**Options** Displays the Image Input Options dialog on page 7292 where you can set alignment and size, relative to the frames of video output. For animated images, you can also synchronize the mask with the frame sequence of video output. This is the same dialog used for Image Input Event options.

**Enabled** Enables the mask. If turned off, Video Post ignores any other mask settings.

**Inverted** When turned on, the mask is inverted.

Video Post Parameters group

**VP Start Time/End Time** Set the starting and ending frames for the selected event within the overall Video Post queue. Video Post renders the event over the number of frames specified here.

**Enabled** Enables or disables the event. When turned off, the event is disabled and Video Post ignores it when rendering the queue. Each event must be disabled individually. For example, disabling a composite layer event does not disable the composited image events. The range bars of disabled events are unavailable in the event track area.
Add Image Output Event

Rendering menu > Video Post > Video Post toolbar > Add Image Output Event

Rendering menu > Video Post > Video Post window > Select an Image Output event. > Video Post toolbar > Edit Current Event

The Add Image Output Event provides controls for editing an output image event.

Image Output events send the result of executing the Video Post queue to a file or a device. You must add an Image Output event to the end of the queue if you want to save the final video. Otherwise, the results are displayed in the rendered frame window only. The Image Output event’s range bar must include the entire range of frames you want to output.

The rendered output can be a still image or an animation, in one of the following file formats:

- **AVI Files** on page 7832
- **BMP Files** on page 7834
- **CIN (Kodak Cineon) Files** on page 7834
- **EPS and PS (Encapsulated PostScript) Files** on page 7839
- **Radiance Image Files** on page 7866
- **JPEG Files** on page 7848
- **PNG Files** on page 7862
- **MOV (QuickTime Movie) Files** on page 7849
- **RLA Files** on page 7873
- **RPF Files** on page 7875
- **RGB (SGI Image) Files** on page 7877
- **TGA (Targa) Files** on page 7878
- **TIFF Files** on page 7880

You also have the option to direct the output to a VTR controller output device. If you have multiple output image events, you can output to different devices. This lets you monitor your queue with VTR output devices and view your output at any level of the Video Post queue during rendering.
Procedures

To add an image output event:

1. Click Add Image Output Event.
   Image Output disregards whether any events in the queue are selected or not.

2. Click Files to save the final video in a file, or Devices to send the video to a device.
   If you click Files, a file dialog appears to let you choose the bitmap or animation file.
   If you choose Devices, a Select Image Output Device dialog appears. This dialog has a drop-down list of installed device options.

3. Adjust other parameters, and then click OK.
   The Image Output Event appears at the end of the queue.
   If you choose a device, its configuration controls are enabled:

Interface

The Add Image Output Event and Edit Output Image Event dialogs have the same controls.
**Image File group**

**Label** Lets you give the event a unique name. A unique name can make it easier to distinguish the output event in a long list of events.

**Files** Lets you choose the output image file and its format.

**Devices** Lets you choose the hardware output device; for example, a digital video recorder. The device, its driver, and its 3ds Max plug-in must all be installed on your system to use device output.

**Image Driver group**

The two buttons in this area are available only when you choose a device as the image source.

**About** Provides information on the source of the image-handler software used to create the image from 3ds Max.

**Setup** Displays device-specific setup options.
Video Post Parameters group

VP Start Time/End Time Set the starting and ending frames for the selected event within the overall Video Post queue. Video Post renders the event over the number of frames specified here.

Enabled Enables or disables the event. When turned off, the event is disabled and Video Post ignores it when rendering the queue. Each event must be disabled individually. For example, disabling a composite layer event does not disable the composited image events. The range bars of disabled events are unavailable in the event track area.

Add External Event

Rendering menu > Video Post > Video Post toolbar > Add External Event

Rendering menu > Video Post > Video Post window > Select an External event. > Video Post toolbar > Edit Current Event

An External event is typically a program that performs image processing. It can also be a batch file or utility that you want to run at a specific point in the queue, or a way to transfer images from or to the Windows clipboard.

An External event is always a child event. If you select an event in the queue before you add the External event, the External event becomes the selected event's child. Child events are evaluated before their parents.

Procedures

To add an external event:

1. Select an event.

2. Click Add External Event.
   An Add External Event dialog appears.

3. Click Browse.
   A file dialog appears.

4. Use the file dialog to choose the external program you want to execute, and then click OK.
If the external program accepts command-line options, enter these in the Command Line Options field.

If you want the external program to read the current Video Post image, turn on Write Image To Clipboard.

If you want Video Post to use the result of the external program, turn on Read Image From Clipboard.

Click OK.

If you selected an event, the External event becomes its child. If no event was selected, the External event appears at the end of the queue.

WARNING The image that the External event reads from the clipboard is placed in the Video Post queue. If the external program does not do what you want, this can erase or overwrite the result of all Video Post post-processing.

Interface

The Add External Event and Edit External Event dialogs have the same controls.
External Event group

**Label** Lets you give the event a unique name. A unique name can make the external event easier to distinguish in a long list of events.

**Browse** Lets you select an external program. For example, you can specify Adobe Photoshop™ or another image-processing application.
Command-Line Options group

For external programs that accept command-line options, lets you send real-time data to the external program. 3ds Max parses three special commands. When found in a string, these commands are replaced with real-time data, as follows:

- %f is replaced with a 4-digit frame number (for example, 0001)
- %w is replaced with a 4-digit image width (for example, 0640)
- %h is replaced with a 4-digit image height (for example, 0480)

For example, if the given command-line option is:
-w%w -h%h -oframe%f.tga
The string sent to the external program might be:
-w0640 -h0480 -oframe0001.tga

Write image to clipboard When on, writes the current rendered image to the Windows clipboard for retrieval by an external application.

Read image from clipboard When on, reads the contents of the Windows clipboard after processing by the external application. When the processed image is saved to the clipboard, it automatically appears in Video Post. With an automated script, it is possible to run the image through any external image processor and get it back automatically.

Video Post Parameters group

VP Start Time/End Time Set the starting and ending frames for the selected event within the overall Video Post queue. Video Post renders the event over the number of frames specified here.

Enabled Enables or disables the event. When turned off, the event is disabled and Video Post ignores it when rendering the queue. Each event must be disabled individually. For example, disabling a composite layer event does not disable the composited image events. The range bars of disabled events are unavailable in the event track area.

Add Loop Event

Rendering menu > Video Post > Video Post toolbar > Add Loop Event
Rendering menu > Video Post > Video Post window > Select a Loop event. > Video Post toolbar > Edit Current Event

Loop events cause other events to repeat over time in the output video. They control sequencing, but perform no image processing.

A Loop event is always a parent event with a single child. The child itself can be a parent with children. Any type of event can be the child of a Loop event, including another Loop event.

The Loop event's range bar displays the original duration of the child event's playback in color and the range of looped events in gray. You can change the duration of the child event's playback by dragging the child's frame range or the child's original range in the Loop event's track, but you can adjust the full length of the loop (the gray part of the range bar) only by changing the Number of Times parameter in the Edit Loop Event dialog.

**Procedures**

**To add a loop event:**

1. Select the child event.

2. ![Icon](image) Click Add Loop Event.

   An Add Loop Event dialog appears.

3. Choose the loop settings, and then click OK.

   The Loop event appears as the parent of the selected event.

   The Loop event repeats the child event over the course of the Loop event's range.

**Interface**

The Add Loop Event and Edit Loop Event dialogs have the same controls.
Order group

Label  Lets you give the event a unique name. A unique name can make it easier to distinguish the loop event in a long list of events.

- Loop  (The default.) Repeats the child event by starting it over when the child event reaches the end of its range.

- Ping Pong  Repeats the child event by playing it first forward, then backward, then forward, and so on. The last frame of the child event is not repeated.

Number of Times group

Specifies the number of times to repeat the loop or ping pong, in addition to the first time that the child event is played.
Video Post Parameters group

VP Start Time/End Time Set the starting and ending frames for the selected event within the overall Video Post queue. Video Post renders the event over the number of frames specified here.

Enabled Enables or disables the event. When turned off, the event is disabled and Video Post ignores it when rendering the queue. Each event must be disabled individually. For example, disabling a composite layer event does not disable the composited image events. The range bars of disabled events are unavailable in the event track area.

Filter Events

Filter events provide image processing for images and scenes. The topics in this section describe the filter events that are available in Video Post.

Contrast Filter

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event > Choose Contrast Filter from the Filter Plug-In list.

Rendering menu > Video Post > Video Post window > Select a Contrast Filter. > Video Post toolbar > Edit Current Event > Setup

The Contrast filter allows you to adjust the contrast and brightness of an image.
Interface

Contrast Set the spinner between 0 and 1.0. This compresses or expands the latitude between maximum black and maximum white by creating a 16-bit look-up table for any given gray value in the image. The computation of the gray value depends on whether you select Absolute or Derived.

Brightness Set the spinner between 0 and 1.0. This increases or decreases all color components (red, green, and blue).

Absolute/Derived Determines the computation of the gray value for Contrast. Absolute uses the highest value of any of the color components. Derived uses an average of the three color components.

Fade Filter

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event > Choose Fade Filter from the Filter Plug-In list.

Rendering menu > Video Post > Video Post window > Select a Fade Filter. > Video Post toolbar > Edit Current Event > Setup

The Fade filter fades an image in or out over time. The rate of the fade is determined by the length of the Fade filter's time range.
Fade fades out to black or in from black, over time.

**Interface**

In  Fade in.

Out  Fade out.

**Image Alpha Filter**

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event > Choose Image Alpha Filter from the Filter Plug-In list.

Rendering menu > Video Post > Video Post window > Select an Alpha Filter. > Video Post toolbar > Edit Current Event

The Image Alpha filter replaces the image's alpha channel with the channel specified by the filter mask.

The filter takes whatever channel is selected in the channel options under Mask (including g-buffer on page 8589 channel data) and applies it to the queue's alpha channel, thereby replacing what's there.
If you don't choose a mask, this filter has no effect.
There are no setup options for this filter.

**Procedures**

**To set an object's G-Buffer ID:**

1. Select the object.
2. Right-click the object and then choose Properties on page 283 from the popup menu.
3. In the Object Properties dialog, set G-Buffer Object Channel to a nonzero value, and then click OK.
   - The G-Buffer ID can be any positive integer.
   - If you give the same G-Buffer ID value to more than one object, all these objects will be post-processed.

**Lens Effects Filters**

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event > Choose a Lens Effects Filter from the Filter Plug-In list.

The Lens Effects filters add realistic camera flares, glows, gleams, glimmers, and depth-of-field blurring to your scenes. Lens Effects can affect an entire scene or can be generated around specific objects in your scene.

Lens Effects are applied through the Video Post interface. To learn about adding scene and image filter events to the video post queue, see Add Scene Event on page 7282, and Add Image Filter Event on page 7295.

Lens Effects includes the following filters:

- **Lens Effects Flare** on page 7316: Creates the optical effect that occurs when a bright light reflects across the lens of a camera.

- **Lens Effects Focus** on page 7339: Creates a blur on objects based on their distance from the camera. Tracks an object’s distance from the camera using a Z-Buffer. Focus uses the Z-Buffer information from the scene to create its blurring effects.

- **Lens Effects Glow** on page 7343: Creates a glowing light around any assigned object, such as a laser beam or the thruster on a space ship.
Lens Effects Highlight on page 7354: Creates a bright cross star effect on a designated object.

**WARNING** When you animate Lens Effects parameters, this creates pointers into the actual scene, so Lens Effects animation is lost if you save the Video Post queue in a VPX file on page 8758. To preserve the animation, save the Video Post data, including Lens Effects animation, in the MAX file.

**Procedures**

Lens Effects like Glow and Highlight can be set to affect specific objects in your scene based on their G-Buffer ID on page 8589. This lets you apply glows and highlights to the object, or to the material, or both.

**To set an object’s G-Buffer ID:**

1. Select the object.
2. Right-click the object and then choose Properties from the quad menu.
3. In the Object Properties dialog, set G-Buffer Object Channel to a nonzero value, and then click OK.
   
   The G-Buffer ID can be any positive integer.
   
   If you give the same G-Buffer ID value to more than one object, all these objects will be post-processed.

**Animating Lens Effects Properties**

Lens Effects let you use Track View to control parameters that can be animated while Video Post remains open. Any parameter with a green arrow button next to it can be animated.

When the Auto Key button is selected, the associated spinner or variable is displayed in Track View and can be animated. If it is not selected, the green button turns gray to indicate the parameter can no longer be animated.

There are two ways to set Lens Effects parameters for use in animation:

- Enable the Auto Key button, set the frame in which you want to create a key, and set the value.
Use Track View.

Using Track View

To use Track View with Lens Effects, one of the Lens Effects dialogs for a particular filter must be open when you start Track View.

**NOTE** If you open Track View without one of the Lens Effects dialogs being open, the first Lens Effects object does not appear in the Track View List. If you have more than one Lens Effects object in the scene, you will see multiple Lens Effects objects in Track View.

When Track View is open, the Lens Effects filters you have applied are listed under Video Post on the left side of the Track View interface. Under each filter are the parameters which can be animated. These are displayed individually. You can animate only the parameters you need to.

When viewing Gradients in Track View, notice that the first two flags have only a color track associated with them. This is because they are the start and end points of the gradient and never move. Any flags created after the first two will also have a position track associated with them. This means that you can animate not only the color of any flag in any gradient, but also its position over time as well.

If you disable the animation capabilities for a particular lens flare parameter, the corresponding entry in Track View immediately disappears. For more information, see Track View on page 3790.

**WARNING** When you animate Lens Effects parameters, this creates pointers into the actual scene, so Lens Effects animation is lost if you save the Video Post queue in a VPX file on page 8758. To preserve the animation, save the Video Post data, including Lens Effects animation, in the MAX file.

Lens Effects Flare Filter

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event > Choose Lens Effects Flare from Filter Plug-In list. > Setup

The Lens Effects Flare dialog lets you add lens flare effects as a post process to rendering. Flares are usually applied to lights in your scene. The lens flare will then be generated around that object. You can control all aspects of the lens flare in the Lens Effects Flare dialog.
Procedures

To save your flare settings, do one of the following:

You can save all of your lens flare settings to a file, so you can reload them any time. Lens Effects Flare files are saved to an LZF file on page 8625 (.lzf).

1. Click the Reset button.
   This resets Lens Effects Flare to its default settings.

2. Click the Load button.
   This displays a Windows-standard file open dialog from which you can select the settings file you want to load.

3. Click the Save button.
   This displays a Windows-standard Save As dialog in which you specify a directory and filename.

Interface
Preview group

The large black window in the left corner is the main preview window. To the right of this window are smaller preview windows for each part of the flare. You can generate continual previews by clicking the Preview button under the main preview window.

There are nine Lens Effects Flare preview windows. The main preview window in the upper left corner of the Lens Effects dialog shows you the complete scene. The eight smaller preview windows in the upper right corner show the individual parts of the lens flare. Each small preview window has a check box below the window to display the flare effect.

You might notice that an individual part of the lens flare effect might not appear as bright in the smaller preview windows, compared to the main preview. This is because the brightness of a lens flare in the main preview is a result of combining the brightness of multiple effects, the total brightness being greater than a single part.

All of the preview windows are multi-threaded to increase redraw speed and take advantage of multi-processor systems. When you make an adjustment to a lens flare property and the preview window is active, the preview updates automatically. A white line at the bottom of the main preview window indicates that it is updating a change made within the lens flare dialog.

Preview When you click the Preview button, the window displays your flare in the upper left corner if your flare has automatic or manual secondary elements. If your flare does not contain these elements, the flare is centered in the preview window. If the VP Queue button is not on, the preview displays a generic flare to which you can make adjustments. Each time you change a setting, the preview automatically updates. A white line appears at the bottom of the preview window to indicate the preview is updating.

Update Redraws the entire Main Preview window, as well as the smaller windows each time you click this button. This function is critical when you need to view changes you have made in the Video Post queue, such as moving the Time Slider to a different frame, changing your geometry or a light, or changing another filter that precedes the current one in the Video Post queue. The VP Queue button must be on to preview the contents of the Video Post queue. In this case, clicking the Update button causes a small dialog to appear, with an indicator showing the progress of the update.

VP Queue Displays the contents of the Video Post queue in the main preview window. The Preview button must also be turned on. Rather than having to test render every time you want to see the result of the effect in the scene, VP
Queue displays a final composite, combining the effect you are editing with the contents of the Video Post queue.

**NOTE** If you leave the Preview and VP Queue buttons active when you exit Lens Effects Flare, it will take several seconds to re-render the scene in the main preview window the next time you start Lens Effects Flare.

The view in the main preview window also depends upon which lens flare options you have set in the Preferences panel on page 7322.

**Lens Flare Properties group**

Specifies global settings for the flare, such as the source for the flare(s), the size, seed number, rotation, and so on.

**Seed** Gives the random number generator in Lens Effects a different starting point, which creates slightly different lens flares without changing any settings. Using Seed guarantees a different lens flare, even if the differences are very small. For example, if you set up a ray effect for your lens flare, you will get slightly different rays in the lens flare if you adjust the seed value.

**Size** Affects the size of the overall lens flare. This value is a percentage of the size of the rendered frame. Default = 45.

Other parts of the lens flare, such as glow, ring, and so on, also have size adjustments, but this size setting affects the entire lens flare, including secondary flares. Adjusting individual sizes does not affect this size variable, or vice versa. This parameter can be animated on page 7315. Animating the Size parameter causes flares to grow or diminish in size over the course of your animation.

**Hue** If Apply Hue Globally is selected, it controls the amount of Hue applied to the Lens Flare effect. This parameter can be animated.

**Apply Hue Globally** Globally applies the Hue of the Node Source to the other Flare effects.

**Angle** Affects the amount that the flare rotates from its default position, as the position of the flare changes relative to the camera. This parameter can be animated. The lock button to the right of the Auto Key button locks the secondary flares so they do rotate. When the button is disabled, the secondary flares will not rotate.

Animating the Angle parameter does not animate the manual and automatic secondary flares unless you turn on the L button. The default behavior mimics a camera, in which the aperture does not rotate.
Rays, stars, and streaks don’t animate either unless you turn on their individual Auto Rotate toggles.

**Intensity** Controls the overall brightness and opacity of the flare. Higher values produce bright, more opaque flares, and lower values produce dim, transparent flares. This parameter can be animated.

**Squeeze** Squeezes the size of the lens flare, either horizontally or vertically to compensate for different frame aspect ratios. You can set Squeeze from 100 to -100. Positive values stretch the flare horizontally, and negative values stretch it vertically. The value is a percentage of the size of the flare. This parameter can be animated.

For example, if you convert a film for use on TV, applying Squeeze would cause the lens flare to look correct on the smaller screen, and not thin and tall, although a wide-screen 35-MM film image is much wider than a regular TV.

Although Squeeze is a global setting, you can apply this effect to selected portions of your flare through the Preferences panel on page 7322 so that only the flare elements you want are distorted. The Squeeze spinner value is given as a percentage of the size of the flare.

**Node Sources** Lets you select the source object for the lens flare effect. The source of the lens flare may be any object in the scene, but is generally a light, such as a target spot light, or an omni light. Clicking this button displays the Select Flare Objects dialog. You must select a source for the flare to key off.

**NOTE** If you select a source object, then rename the object later, you must reselect the object to ensure the correct generation of the lens flare.

**Lens Flare Effects group**

Controls specific effects for the flare, such as fades, brightness, softening, and so on.

**Brighten** Lets you set an overall brightness that affects the whole image. When a bright effect, such as a lens flare, appears in an image, the whole image should appear brighter. This effect is available only when the Brighten option is enabled under the Render section of the Preferences panel. This parameter can be animated on page 7315. Animating the Brighten spinner is an easy way to create flares that “flash” the scene as they appear.

**Dist Fade** Causes the effect of the lens flare to fade with its distance from the camera. This option is used only when the Dist Fade button is turned on. The values are in 3ds Max world units. This option is used when you want to create the effect of flares disappearing at a certain point away from the camera.
Cent Fade Fades the secondary flares near the center of the row of flares along the main axis of the flare. This is an effect that can be seen in many lens flares seen through a real camera lens. This value is in 3ds Max world units. This setting is only active when the Cent Fade button is selected.

Dist Blur Blurs the flare based on its distance from the camera. This value is in 3ds Max world units. This parameter can be animated.

Blur Int Controls the strength of the blur when it is applied to the lens flare. The value set in this spinner takes full effect as the flare reaches the Dist Blur distance in your scene. Flares closer to the camera plane get a percentage of the intensity setting. This parameter can be animated.

Soften Provides an overall softening effect for the lens flare. This parameter can be animated.

Flare Parameter tabs

Let you create and control the lens flare. Each of the nine tabs controls a specific aspect of the lens flare.

WARNING When you animate Lens Effects parameters, this creates pointers into the actual scene, so Lens Effects animation is lost if you save the Video Post queue in a VPX file on page 8758. To preserve the animation, save the Video Post data, including Lens Effects animation, in the MAX file.

A flare is composed of eight basic parts. Each part of a flare is controlled on its own panel in the Lens Effects Flare interface. Each part of the lens flare can be individually activated and deactivated to create different effects.

Prefs on page 7322: This page lets you control which parts of a lens flare are active and how they effect the overall image.

Glow on page 7325: A general glow centered around the source object of the flare. You can control the color, size, shape, and other aspects of the glow.

Ring on page 7326: A circular color band that surrounds the center of the source object. You can control the color, size, shape, and other aspects of the ring.

A Sec on page 7327: Auto Secondary Flares. The small circles you would normally see coming out from the source of the lens flare. As the camera position changes relative to the source object, the secondary flares move. The secondary flares are automatically generated when this option is active.

M Sec on page 7329: Manual Secondary Flares. Additional secondary flares added to the lens flare effect. They appear in the same axis as the automatic secondary flares and look very similar.
**Rays** on page 7331: Bright lines that radiate out from the center of the source object, providing the illusion of extreme brightness for the object.

**Star** on page 7333: Bright lines that radiate out from the center of the source object, generally composed of 6 or more spokes, (instead of hundreds, like a ray). Stars are generally thicker and extend out farther from the center of the source object than rays.

**Streak** on page 7335: Wide horizontal bands that run through the center of the source object.

**Inferno** on page 7337: Lets you add special effects, such as explosions, to your flare effect.

**Flare Preferences**

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event > Choose Lens Effects Flare from Filter Plug-In list. > Setup > Prefs tab

In the Prefs panel, you can control whether or not specific parts of the lens flare, such as the rays or the star are rendered by turning them on or off. You can also control the axial transparency of the lens flare.
Interface

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Affect Alpha</td>
<td>Specifies whether or not the lens flare affects the alpha channel of an image, when the image is rendered in a 32-bit file format. The alpha channel is an extra 8 bits of color (256 colors) that indicate transparency in an image. Alpha channels are used to composite one image seamlessly over the top of another. If you want to composite a lens flare, or an image that contains a lens flare, over the top of another image, enable this option. If you are not rendering to a 32-bit file, do not enable this option.</td>
</tr>
<tr>
<td>Affect Z Buffer</td>
<td>The Z-Buffer stores an object’s distance from the camera. The Z-Buffer is useful for optical effects such as fog. When this option is enabled, the linear distance of the lens flare is recorded, and can be used in special effects that make use of the Z-Buffer, for example, the Focus effect. To use Focus with a lens flare, enable this option.</td>
</tr>
<tr>
<td>Occlusion Radius</td>
<td>A radius around the center of the flare that determines when the lens flare effect will begin to fade as it passes behind another object. This radius is measured in pixels. When the lens flare or scene is animated and the source of the lens flare goes behind another object, if occlusion is enabled, the flare dies down and fades away.</td>
</tr>
</tbody>
</table>

Lens Effects Filters
disappears until the source object reappears on the other side of the hiding object. The radius makes the flare gently fade when it is occluded, instead of blinking out.

**Motion Blur** Determines whether or not an animated lens flare is rendered using Motion Blur. Motion Blur renders multiple copies in short increments to the same frame, which gives the illusion of a blurred object in motion. When an object is moving rapidly across the screen, it animates more smoothly if motion blur is turned on. Using motion blur can add considerable time to your rendering.

You can set the amount of blur with the Motion Blur spinner. Values range from 0 to 100, and are based on the number of samples the motion blur should use.

**Axial Transparency** A standard circular transparency gradient that affects the transparency of the lens flare secondary elements along their axis and relative to their source. This lets your secondary elements be brighter on one side than the other, adding extra realism to your flare effects.

**Render** Specifies whether or not each part of the lens flare is rendered in the final image. Use this set of check boxes to turn parts of the lens flare on and off.

**NOTE** Effects such as secondary flares are available in sets. The Render button and Off Scene determine whether the secondary flares are present in the scene. The individual secondary flare sets are controlled on their respective pages.

**Off Scene** Specifies whether or not lens flares that have their sources outside the scene will affect the image. For example, if a lens flare source is just off the edge of a frame, the secondary flares, and possibly the star or ring, could still be showing on the screen. Without Off Scene, the lens flare does not appear at all. You can turn this option on or off for each part of the flare.

**Squeeze** Specifies whether the Squeeze setting affects a particular part of the lens flare. This setting depends on the Squeeze setting in the lens flare properties.

**Inferno** Defines whether the inferno on page 7337 settings are active for this portion of the lens flare.

**Occlusion** Defines the percentage of the flare part that appears when it is occluded by another object. A value of 100 indicates that the whole object will disappear. Lower settings cause the lens flare to wrap around the occluding object, making it fade, but not disappear entirely. For example, if you look at a cylinder with a bright light behind it, the light makes the cylinder appear thinner at the brightest areas.
NOTE The Occlusion spinners work in conjunction with the Occlusion Radius spinner in the top right of the Preferences panel.

Flare Glow Parameters

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event > Choose Lens Effects Flare from Filter Plug-In list. > Setup > Glow tab

The glow of a lens flare is centered around the source object of the flare. The parameters on the Glow panel let you control each aspect of the glow.

Interface

Size

Specifies the diameter of the glow of the lens flare as a percentage of the overall size of the frame. This value is separate from the overall size value set in the Flare Properties on page 7316. This parameter can be animated on page 7315.
Hue Specifies the gradation of color for the glow. Clicking the green arrow button lets you animate this control. This parameter can be animated.

Hide Behind Geometry Places the glow behind the geometric forms.

Gradients Use radial, circular, transparency, and size gradients on page 7370. Glow gradients are subtler than flare gradients, because they are glowing an area larger than a pixel.

Flare Ring Parameters

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event > Choose Lens Effects Flare from Filter Plug-In list. > Setup > Ring tab

The ring is a circular color band that surrounds the center of the source object. You set ring options on the Ring panel of the Lens Effects Flare dialog.

Interface
**Size** Specifies the overall size of the ring as a percentage of the overall frame and represents the diameter of the ring. The ring radius should be larger than the glow radius to make the lens flare look convincing. This parameter is separate from the overall size spinner in the Lens Flare Effects section of the dialog. This parameter can be animated on page 7315.

**Thick** Specifies the overall thickness of the ring, as a percentage of the overall size of the frame. When the ring is fairly thick, the size of the ring is measured to the inner radius. The thickness controls how thick the ring is from that point outward. This parameter can be animated.

**Hue** Specifies the gradation of color for the ring. This parameter can be animated.

**Gradients** Use radial, circular, transparency, and size gradients on page 7370.

### Automatic Secondary Flare Parameters

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event > Choose Lens Effects Flare from Filter Plug-In list. > Setup > A Sec tab

Secondary flares are the small circles you would normally see coming out from the source of the lens flare along an axis relative to the camera position. These are caused by light refracting off the different lens elements in the camera. As the camera position changes relative to the source object, the secondary flares move. These secondary flares are automatically generated when this option is selected in the Preferences section of the dialog.

You create sets of secondary elements that share common parameters instead of building them one at a time. Many of the controls on the A Sec panel are for individual sets of elements, not all sets.
Interface

Min Controls the minimum size of secondary flares in the current set. This number is defined as a percentage of the overall image. This parameter can be animated on page 7315.

Max Controls the maximum size of secondary flares in the current set. This number is defined as a percentage of the overall image. This parameter can be animated on page 7315.

Sets Specifies which set of secondary flares you are working with. You can have as many sets of automatic secondary elements as you wish, each having their own properties. By default, seven sets are available. You can scroll through them by clicking the forward and reverse arrow icons beside the name of the set.

To add another set to your flare, click the Add button beneath the On check box. To delete a set, click the Del button.

Axis Defines the overall length of the axis the automatic secondary flares will be distributed along. Increasing the value creates more space between the flares, while decreasing the value creates less space between the flares. You can set the axis from 0 to 5 degrees. This parameter can be animated on page 7315.
On Defines whether a group or set of secondary flares is active or not.

Fade Determines whether or not axial fade is active for the current set of secondary flares.

Hue Specifies the gradation of color of the secondary flares. This parameter can be animated.

Qty Controls the number of secondary flares that appear in the current set of flares. This parameter can be animated.

Shape Controls the shape of the secondary flares for the current set. The default value is circular, but you can choose from 3 to 8 sided secondary flares.

Gradients Defines the gradient on page 7370 for the secondary flare.

**Manual Secondary Flare Parameters**

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event > Choose Lens Effects Flare from Filter Plug-In list > Setup > M Sec tab

Manual secondary flares are additional secondary flares that are individually added to the lens flare. These can be used in addition to, or in place of automatic secondary flares on page 7327.

You use Manual secondary flares when you want to add unique flares that you don't want repeated.

You can have groups of secondary flares, instead of just one set. Many of the controls in this dialog are for a specific set of flares, not all sets.
Interface

Size Controls the size, as a percentage of the overall image, of the manual secondary lens flare. This parameter can be animated on page 7315.

Plane Controls the distance, in degrees, between the flare source and the manual secondary flare. By default, the flare plane exists at the center of the chosen node source. Positive values place the flare in front of the source, while negative values place the flare behind the flare source. This parameter can be animated.

TIP In live camera work, there are often one or two secondary elements behind the light source, so you should have one or two as well.

On Turns manual secondary flares on or off. This option must be selected in both the Manual Secondary and Preferences tabs for the manual secondary flares to render.

Fade Specifies whether or not the current set of secondary flares has axial fade.

Sets Specifies which set of secondary flares you are working with. You can have as many sets of manual secondary elements as you wish, each having
their own properties. By default, seven sets are available. You can scroll through them by clicking the forward and reverse arrow buttons next to the name of the set.

To add another set to your flare, click the Add button beneath the On check box. To delete a set, click the Del button.

**Hue** Specifies the gradation of color of secondary flares. This parameter can be animated.

**Scale** Specifies how to scale secondary flares. This parameter can be animated.

**Shape** This menu controls the overall shape of the secondary flares.

**Gradients** Defines the gradient on page 7370 for the secondary flare.

### Flare Ray Parameters

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event > Choose Lens Effects Flare from Filter Plug-In list. > Setup > Rays tab

Rays are bright single-pixel lines that radiate from the center of the source object, providing the illusion of extreme brightness for the object. Rays let you emulate scratches in the lens elements of a camera.

You control the parameters for rays in the Rays panel of the Lens Effects Flare dialog.
**Interface**

Size Specifies the overall length of the rays as they radiate from the center, as a percentage of the frame size. This parameter can be animated on page 7315.

Angle Specifies the angle for the rays. You can enter both positive and negative values so, when animated, the rays rotate in a clockwise or counterclockwise direction. This parameter can be animated.

Group Forces the grouping of rays into eight equidistant groups of equal size. Rays that are part of a group are evenly distributed within that group. Increasing the number of rays makes each grouping more dense, and therefore more bright.

Number Specifies the overall number of rays that appear in the lens flare. Rays are randomly spaced around the radius. This parameter can be animated.

Auto Rotate Adds the angle specified in the Angle spinner on the Rays panel to the angle set in the Angle spinner under Lens Flare Properties. Auto Rotate also ensures that the rays maintain their relative position to the flare as it is being animated.
**Hue** Specifies the gradation of the color of the rays. This parameter can be animated.

**Sharp** Specifies the overall sharpness of the rays. Higher numbers produce crisp, clean, and clear rays. Lower numbers produce more of a secondary glow look. Values range from 0 to 10. This parameter can be animated.

**Gradients** Defines the gradient on page 7370 for the rays.

### Flare Star Parameters

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event > Choose Lens Effects Flare from Filter Plug-In list. > Setup > Star tab

A Star is larger than a ray effect and is composed of six or more spokes, instead of hundreds like a ray. Stars are thicker and extend out farther from the center of the source object than rays. You control the settings for stars on the Star panel of the Lens Effects Flare dialog.
Interface

Size Specifies the overall size of the star effect, as a percentage of the overall frame. This parameter can be animated on page 7315.

Angle Sets the starting angle in degrees in which the star spokes point. You can enter both positive and negative values, so, when animated, the star spokes rotate in a clockwise or counterclockwise direction. This parameter can be animated.

Random Enables random spacing of star spokes around the flare center.

Qty Specifies the number of spokes in the star effect. Default = 6. Spokes are spaced at equidistant points about the center of the flare. This parameter can be animated.

Width Specifies the width of the individual spokes, as a percentage of the overall frame. This option can be animated.

Auto Rotate Adds the angle specified in the Angle spinner on the Rays panel to the angle set in Angle spinner under Lens Flare Properties. Auto Rotate also
ensures that the stars maintain their relative position to the flare as it is being animated.

**Hue** Specifies the gradation of the color of the star. This parameter can be animated.

**Sharp** Specifies the overall sharpness of the star. Higher numbers produce crisp, clean, and clear stars. Lower numbers produce more of a secondary glow look. This parameter can be animated. Range = 0 to 10.

**Taper** Controls the taper of the individual spokes of the star. Taper widens or narrows the tips of the individual star points. Low numbers create a sharp point, while high numbers flare the points. This parameter can be animated. Default = 0.

**Gradients** The gradients on page 7370 are the same for the Star effect as for others, except for two gradients: **Section Color** and **Section Transparency**. These options are useful when you want to create a "soft" look to the spokes. Both gradients work from the center of each spoke to the outer edge of the spoke.

### Flare Streak Parameters

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event > Choose Lens Effects Flare from Filter Plug-In list. > Setup > Streak tab

A streak is a wide horizontal band that runs through the center of the source object. In real camera work, it is produced when using anamorphic lenses to film a scene. You set streak options on the Streak panel of the Lens Effects Flare dialog.
Interface

Size Specifies the overall size of the streak, as a percentage of the overall frame. This parameter can be animated on page 7315.

Angle Specifies the angle for the streak. You can enter both positive and negative values so, when animated, the streak rotates in a clockwise or counterclockwise direction. This parameter can be animated.

Axial Align Forces the streak to align itself to the axis of the secondary flares and the lens flare itself.

Width Specifies the width of the streak, as a percentage of the frame. This parameter can be animated.

Auto Rotate Adds the angle specified in the Angle spinner on the Streak panel to the angle set in Angle spinner under Lens Flare Properties. Auto Rotate also ensures that the stars maintain their relative position to the flare as it is being animated.

Hue Specifies the gradation of the color of the streak. This parameter can be animated.
**Sharp** Specifies the overall sharpness of the streak. Higher numbers produce crisp, clean, and clear streaks. Lower numbers produce more of a secondary glow look. Valid values are from 0 to 10. This parameter can be animated.

**Taper** Controls the taper of the individual spokes of the streak. Taper widens or narrows the tips of the individual streak points. Low numbers create a sharp point, while high numbers flare the points. Default = 0. This parameter can be animated.

**Gradients** The gradients on page 7370 are the same for the Streak effect as for others, except for two gradients: **Section Color** and **Section Transparency**. These options are useful when you want to create a “soft” look to the streak spokes. Both gradients work from the center of each spoke to the outer edge of the spoke.

**Flare Inferno Parameters**

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event > Choose Lens Effects Flare from Filter Plug-In list. > Setup > Inferno tab

Infernos let you use lens flare to create explosions, fire, and smoke effects and add a bit of fractal noise to any part of the lens flare. This noise comes in three types: Gaseous, Electric, and Fiery.

**Interface**

![Inferno Interface](image-url)
You add the Inferno effect to other lens flare effects. Inferno is selected in the Preferences panel. The lens flare effect you are adding Inferno to, such as glow, must also be selected for Inferno to work correctly. The Inferno panel is divided into two sections: Settings and Parameters.

**Settings group**

**Gaseous** A loose and soft pattern, often used for clouds and smoke.

**Fiery** Fractal patterns with bright, well-defined areas, often used for fires.

**Electric** Long, well-defined tendril pattern that can be used to produce arcing electricity, when animated. By adjusting the quality of the pattern to 0, you can create the effect of water reflection.

**Lock Effect** Locks the inferno effect to the lens flare. When the lens flare moves across the screen, the inferno effect moves with it. Use this option when you want the noise pattern to move with the flare for effects like torches.

**Lock Noise** Locks the inferno noise patterns into the screen. When the lens flare is animated and moving across the screen, the noise pattern stays in one spot and the flare moves through it. This is often used for creating plasma trails and cloud patterns.

**Motion** When you animate the inferno, motion specifies how fast the inferno patterns move in the direction set by the Direction spinner. For example, if you want to simulate a raging fire, you want the fractal patterns to move upward. This parameter can be animated on page 7315.

**Direction** Specifies the direction, in degrees, of the inferno effect motion. By default, 0 is aligned in the 12 o'clock position, and works clockwise. This parameter can be animated.

**NOTE** The Motion and Direction spinners control the motion of the fractal pattern in the X and Y directions. You can control the Z direction using the Speed option under Inferno Parameters.

**Quality** Specifies the overall quality of the fractal noise patterns in the inferno effect. Higher values result in more iterations of the fractals, more detail in the effect, and slightly longer render times. This parameter can be animated.

**Reseed** The number that the fractal routines use as a starting point. Set this spinner to any number to create different fractal effects. The Reseed button randomly selects a new number.
Parameters group

Size  Specifies the overall size of the fractal patterns. Smaller numbers produce small, grainy fractals. Higher numbers produce larger patterns. This option can be animated.

Speed  Sets the overall speed of the turbulence in the fractal patterns as they are animated. Higher numbers produce faster turbulence in the pattern. This parameter can be animated.

Base  Specifies the brightness of the colors in the inferno effect. Higher values result in brighter color ranges and brighter infernos. Lower values result in dark, softer effects. The Base spinner only affects Fiery and Electric inferno types. This parameter can be animated.

Amplitude  With the Base spinner, controls the maximum brightness for each portion of the fractal inferno patterns. Higher values result in fractal patterns with brighter colors. Lower values result in the same patterns, with muted colors. This parameter can be animated.

Bias  Shifts the colors of the effect toward one end of the color range or the other. At a setting of 50, Bias has no effect. Above 50, the colors are brighter, and below 50, they are darker and softer. This parameter can be animated.

Edge  Controls the contrast between the light and dark areas of the fractal patterns. High values produce a high contrast and more well-defined fractal patterns. Low values result in less defined, subtler effects. This parameter can be animated.

Radial Density  Controls the density of the inferno effect in a radial fashion from the center of the effect to the edge. Wherever there is white in the gradient, you only see inferno noise. Where the gradient is black, you can see the underlying flare. If you set the right side of the gradient to black and the left side to white, and apply the Inferno to the Glow effect of a flare, the inferno effect appears toward the outer edges of the glow, while the center of the glow is still visible.

Lens Effects Focus Filter

Video Post toolbar > Add Image Filter Event > Choose Lens Effects Focus from Filter Plug-In list. > Setup

The Lens Effects Focus dialog lets you blur objects based on their distance from the camera. Focus uses the Z-Buffer information from the scene to create
its blurring effects. You can use Focus to create effects such as foreground elements in focus and background elements out of focus.

Like Flare, Glow, and Highlight, you can load and save your focus settings for future use. Focus settings are saved to LZO files on page 8626 (.lzo).

**WARNING** This filter is not supported by the mental ray renderer on page 6675.

**Procedures**

To save your focus settings, do one of the following:

You can save all of your lens focus settings to a file, so you can reload them any time. Lens Effects Focus settings are saved as LZO files.

1. Click the Reset button.
   This resets Lens Effects Focus to its default settings.

2. Click the Load button.
   This displays a Windows-standard file open dialog from which you can select the settings file you want to load.

3. Click the Save button.
   This displays a Windows-standard Save As dialog in which you specify a directory and filename.
Interface

The Lens Effects Focus dialog contains a preview window, and an area below to control the parameters of Focus.
**Preview group**

**Preview window** Lets you quickly preview the Focus effect.

**Preview** Displays a generic scene to which you can quickly set up a Focus effect. Appears light green when selected.

**VP Queue** Lets you preview the scene in the Video Post queue. Preview must be selected for the VP Queue function to work.

**Focus Control group**

The settings on the left side of the panel let you select a method for blurring your scene. The settings on the right side of the dialog let you determine how much blurring is applied to the scene.

**Scene Blur** Applies the blurring effect to the entire scene, not just a portion of it.

**Radial Blur** Applies the blurring effect to the entire scene in a radial fashion, starting at the center of the frame. This is useful for emphasizing fish-eye lens effects and effects where the edges of the frame are blurred. This type of Focus depends on the Focal Range and Limit settings.

**Focal Node** Lets you select a specific object in the scene as the focal point for blurring. The selected objects remains in focus, while objects outside of the set **Focal Limit** are blurred.

**Select** Displays the Select Focal Object dialog so you can select a single 3ds Max object to use as the focal object. The object you select can be animated over time, which results in animated follow focus effects. You can also choose your camera target as the focal object so its depth in the scene determines the focus.

**Affect Alpha** When this option is selected, the blur effect is also applied to the Alpha channel of the image when you render to a 32-bit format. Select this option to composite the blurred image over another.

**Horiz. Focal Loss** Specifies the amount of blur applied to the image in the horizontal (X-axis) direction. Values range from 0 to 100% focal loss. This parameter can be **animated** on page 7315.

**Lock** Locks the horizontal and vertical loss settings together. When selected, the vertical focal loss is automatically updated to match your changes to the horizontal loss.
Vert. Focal Loss Specifies the amount of blur applied to the image in the vertical (Y-axis) direction. Values range from 0 to 100% focal loss. This parameter can be animated.

Focal Range Specifies how far away from the center of the image (Radial Blur) or from the camera (Focal Object) the blur effect begins. Increasing values move the radius of the effect farther away from the camera or the center of the image. This parameter can be animated.

Focal Limit Specifies the distance from the center of the image (Radial Blur) or the distance from the camera (Focal Object) at which the blur effect is at full strength. Setting a high Focal Limit with a low Focal Range, produces a gradual increase in the amount of blur in the scene, while setting Focal Limit and Range close together produces a rapid blur effect over a short distance. This parameter can be animated.

NOTE Do not set Focal Range and Focal Limit to the same value. This produces an abrupt change from a blur to a sharp focus, producing an undesirable visual effect.

WARNING When you animate Lens Effects parameters, this creates pointers into the actual scene, so Lens Effects animation is lost if you save the Video Post queue in a VPX file on page 8758. To preserve the animation, save the Video Post data, including Lens Effects animation, in the MAX file.

Button group

Reset Resets Lens Effects Flare to its default settings.

Load Displays a Windows-standard file open dialog from which you can select the settings file you want to load.

Save Displays a Windows-standard Save As dialog in which you specify a directory and filename. Lens Effects Focus settings are saved as LZO files.

Lens Effects Glow Filter

Video Post toolbar > Add Image Filter Event > Choose Lens Effects Glow from Filter Plug-In list. > Setup

The Lens Effects Glow dialog lets you add a glowing aura around any assigned object. For example, for an exploding particle system, adding a glow to the particles makes them seem as though they are brighter and hotter.
The Lens Effects Glow module is multi-threaded and will take advantage of multi-processing machines.

**Procedures**

To save your glow settings, do one of the following:

You can save all of your lens glow settings to a file, so you can reload them any time. Lens Effects Glow settings are saved to LZG files on page 8626 (.lzg).

1. Click the Reset button.
   This resets Lens Effects Glow to its default settings.

2. Click the Load button.
   This displays a Windows-standard file open dialog from which you can select the settings file you want to load.

3. Click the Save button.
   This displays a Windows-standard Save As dialog in which you specify a directory and filename.
The Lens Effects Glow dialog contains a preview window, and an area below to control the parameters of Glow.
**Preview group**

**Preview window** Lets you quickly preview the glow effect. The preview window is multi-threaded to take advantage of systems with multiprocessors, and updates every time you make a change to any of the glow settings that might affect the scene.

**Preview** Displays a generic scene to which you can quickly set up a Glow effect. Appears light green when selected.

**VP Queue** Lets you preview the scene in the Video Post queue. Preview must be selected for the VP Queue function to work.

**Focus Control tabs**

The Lens Effect Glow dialog contains four tabs:

- Properties on page 7346, Preferences on page 7350, Gradients on page 7370, and Inferno on page 7352

**Button group**

**Reset** Resets Lens Effects Glow to its default settings.

**Load** Displays a Windows-standard file open dialog from which you can select the settings file you want to load.

**Save** Displays a Windows-standard Save As dialog in which you specify a directory and filename. Lens Effects Glow settings are saved as LZG files.

**Glow Properties**

Video Post toolbar > Add Image Filter Event > Choose Lens Effects Glow from Filter Plug-In list. > Setup > Properties tab

The Lens Effects Glow properties let you determine which pieces of geometry in your scene will exhibit the effects of the glow filter, as well as how much of a glow is applied.

**Procedures**

**To set a material ID Channel:**

1. In the Material Editor, make the material you want to be post-processed the active material.
2 Choose a non-zero ID from the Material ID Channel flyout. The ID Channel can range from 1 to 15.
If you give the same ID Channel value to more than one material, all these materials will be post-processed.

**NOTE** For Multi/Sub-Object materials, post-processing applies at the sub-object/sub-material level. The ID Channel of the parent Multi/Sub-Object material is ignored.

To set up an RLA file so it saves Object and Material ID channel data:

1 Place an Image Output Event in the Video Post Queue.
2 In the Image Output Event dialog, click Files.
3 Choose the .rla file type on page 7873 and a file name, and then click Setup.
4 In the RLA Image File Format dialog, select Object, Material ID, and then click OK.
5 Click OK.

When the RLA file has saved the Object and Material ID channels, you can use the rendered scene file as an Image Input event or a Filter or Layer mask, and continue to use the Object or Material ID Channel data.

**Interface**

<table>
<thead>
<tr>
<th>Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Source</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Filter</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

Lens Effects Filters | 7347
The Properties panel is divided into two sections: **Source** and **Filter**.

### Source group

Specifies the objects in the scene to which a glow is applied. You can select more than one source option at a time.

**Whole** Applies a glow to the whole scene, not just a particular piece of geometry. This makes each pixel in the scene a potential glow source. The areas of the scene that have glow applied to them are determined by the settings in the Filter section of the dialog.

**Object ID** Lets you apply the glow to an object or part of an object with a specific Object ID (in the G-buffer on page 8589), if the object matches the Filter settings. To apply an Object ID glow for an object, right-click the object and select properties from the menu. Then, set the Object Channel ID. Set this field to match, and Lens Effects glow will apply the glow to that object and any other objects with the same ID. This parameter can be animated on page 7315.

**Effects ID** Lets you apply the glow to an object or part of an object with a specific ID channel, if the object or part of the object matches the Filter settings. You apply an ID channel in the Material Editor by assigning the material to one of the available Material ID channels. This parameter can be animated.

The glow will be applied only to areas of the geometry where the ID is present.

**NOTE** To apply different glow settings to different pieces of geometry or IDs, add more glow entries to the video post queue. Set each glow entry to affect a different Material or Object ID, and set the appropriate settings. This process will call the glow routine multiple times, increasing your rendering time. Try to keep the number of glow routines to a minimum per frame.

**Unclamped** An unclamped color is brighter than pure white (255,255,255). 3ds Max keeps track of these “hot” areas which tend to show up when your scene contains bright metallic highlights or explosions. This spinner lets you determine the lowest pixel value that is glowed. Pure white has a pixel value of 1. When this spinner is set to 1, any pixels with a value above 255 will be glowed. You can invert this value by clicking the I button to the right of the spinner. This parameter can be animated.

**Surf Norm** Glows part of an object, based on the angle of the surface normal to the camera. A value of 0 is coplanar, or parallel to the screen. A value of 90 is normal, or perpendicular to the screen. If you set Surf Norm to 45, only surfaces with normal angles greater than 45 degrees will be glowed. You can
invert this value by clicking the I button to the right of the spinner. This parameter can be animated.

**Mask** Glows the mask channel of an image. The spinner value represents the level of grayscale present in a Mask. When this is set, any part of the Mask images larger than the set value will be glowed in the final image. You can invert this value by clicking the I button to the right of the spinner. This parameter can be animated. Range = 0 to 255.

**Alpha** Glows the alpha channel of an image. The transparency of an alpha channel is interpreted opposite that of the Mask channel. This parameter can be inverted, and can also be animated. Range = 0 to 255.

**Z Buffer Hi and Lo** Glows objects based on their distance (Z-Buffer distance) from the camera. The Hi value is the maximum distance and the Lo value is the minimum. Any objects between these two Z-Buffer distances will be glowed. These parameters can be animated.

**Filter group**

Filters the Source selections to let you control how the glow is applied. For example, you can have ten spheres in your scene, each with the same Object ID, but different colors. If you set the **Source** as the Object ID of the spheres, which selects all of the spheres, that is the only place in your scene that Glow applies an effect.

However, now that Glow knows where the pixels are that can be glowed, it needs to know which ones to actually apply the Glow to. Glow uses the filter controls to find out which source pixels to apply a glow to.

**All** Selects all source objects in the scene and applies a glow to them.

**Edge** Selects all source objects along a boundary edge and applies a glow to them. Applying a glow along the edges of objects produces a soft halo that exists on both inside and outside edges of your object.

**Perimeter Alpha** Applies a glow only to the perimeter of an object based on its alpha channel. Selecting this option glows only the outside of an object without any spill on the interior. Perimeter Alpha keeps all the edges clean because it relies on the scene alpha channel for its effect.

**Perimeter** Applies glow effect only to the perimeter of an object based on Edge inferencing. Although not as precise as Perimeter Alpha, you might need to use the Perimeter option at times when the alpha channel is unavailable.
**Bright** Filters the source objects based on their brightness values. Only objects with a brightness above the spinner setting are selected and glowed. This option can be inverted. This parameter can be animated.

**Hue** Filters the source objects by their hue. Select the hue by clicking the color swatch next to the spinner. The spinner beside the Hue color swatch lets you enter a variance level so that the glow can find several different hues in the same range as the chosen color. This parameter can be animated. Range = 0 to 255.

**Glow Preferences**

Video Post toolbar > Add Image Filter Event > Choose Lens Effects Glow from Filter Plug-In list. > Setup > Preferences tab

Glow Preferences define the size of the glow, its occlusion, and whether or not it affects the Z-Buffer or alpha channels.

**Interface**

The Preferences panel is divided into four sections: Scene, Distance Fade, Effect, and Color.
Scene group

**Affect Alpha** Specifies whether or not the glow affects the alpha channel of the image, when rendered to a 32-bit file format.

**Affect Z Buffer** Specifies whether or not the glow affects the Z-Buffer of the image. When this option is enabled, the linear distance of the glow is recorded, and can be used in special effects that make use of the Z-Buffer. For example, Lens Effects Focus blurs objects based on their Z-Buffer information. To use Focus with a glow, you must enable this option.

Distance Fade group

These controls fade the glow effect, based on its distance from the camera. This is the same as distance fade for the lens flare.

**Bright** Lets you fade the brightness of the glow effect based on the distance from the camera. This is ideal for submarine running lights and any other effect where you want your glow to disappear into the distance. This parameter can be animated on page 7315.

**Size** Lets you fade the size of the glow effect based on the distance from the camera. In most circumstances, you want the overall size of the glow to diminish as it gets farther away from the camera. This parameter can be animated.

**Lock** When selected, locks the Bright and Size values together, so that the size and brightness fading is synchronized.

Effect group

**Size** Sets the size of the overall glow effect. This parameter can be animated.

**Softness** Softens and blurs the glow effect. Values range from 0 to 100. This control is enabled only when you use Gradients as the color method (see the next section). Softness is only available when the Gradient option in the Color area is selected. This parameter can be animated.

Color group

**Gradient** Creates the glow based on the settings in the Gradients panel. When you use this method, you can use the Softness spinner in the Effect area.

**Pixel** Creates the glow based on the pixel color of the object. This is the default method. It is very fast.
**User** Lets you select a color for the glow effect. Click the color swatch to display the Color Selector on page 371 and choose a color.

**Intensity** Controls the intensity or brightness of the glow effect. Values range from 0 to 100. This control is enabled only when Pixel or User is the chosen color method.

### Glow Inferno

Video Post toolbar > Add Image Filter Event > Choose Lens Effects Glow from Filter Plug-In list. > Setup > Inferno tab

The Inferno panel lets you create explosions, fire, and smoke effects by combining the lens flare glow with black and white fractal noise.

The Glow inferno effect is like the Inferno effect in Lens Flare on page 7337, but it is applied to the Glow through the R, G, and B color channels.

### Interface

The Inferno panel is divided into two sections: Settings and Parameters.

#### Settings group

- **Gaseous** A loose and soft pattern, often used for clouds and smoke.
- **Fiery** Fractal patterns with bright, well-defined areas, often used for fires.
**Electric** Long, well-defined tendril pattern that can be used to produce arcing electricity, when animated. By adjusting the quality of the pattern to 0, you can create the effect of water reflection.

**Reseed** The number that the fractal routines use as a starting point. Set this spinner to any number to create different fractal effects. The Reseed button randomly selects a new number.

**Motion** When you animate the inferno, motion specifies how fast the inferno patterns move in the direction set by the Direction spinner. For example, if you want to simulate a raging fire, you want the fractal patterns to move upward. This parameter can be animated on page 7315.

**Direction** Specifies the direction, in degrees, of the inferno effect motion. By default, 0 is aligned in the 12 o'clock position, and works clockwise. This parameter can be animated.

---

**NOTE** The Motion and Direction spinners control the motion of the fractal pattern in the X and Y directions. You can control the Z direction using the Speed option under Inferno Parameters.

**Quality** Specifies the overall quality of the fractal noise patterns in the inferno effect. Higher values result in more iterations of the fractals, more detail in the effect, and slightly longer render times. This parameter can be animated.

**Red/Green/Blue** Selects the color channel to use for the Inferno effect.

**Parameters group**

**Size** Specifies the overall size of the fractal patterns. Smaller numbers produce small, grainy fractals. Higher numbers produce larger patterns. This option can be animated.

**Speed** Sets the overall speed of the turbulence in the fractal patterns as they are animated. Higher numbers produce faster turbulence in the pattern. This parameter can be animated.

**Base** Specifies the brightness of the colors in the inferno effect. Higher values result in brighter color ranges and brighter infernos. Lower values result in dark, softer effects. The Base spinner only affects Fiery and Electric inferno types. This parameter can be animated.

**Amplitude** With the Base spinner, controls the maximum brightness for each portion of the fractal inferno patterns. Higher values result in fractal patterns with brighter colors. Lower values result in the same patterns, with muted colors. This parameter can be animated.
Bias  Shifts the colors of the effect toward one end of the color range or the other. At a setting of 50, Bias has no effect. Above 50, the colors are brighter, and below 50, they are darker and softer. This parameter can be animated.

Edge  Controls the contrast between the light and dark areas of the fractal patterns. High values produce a high contrast and more well-defined fractal patterns. Low values result in less defined, subtler effects. This parameter can be animated.

Radial Density  Controls the density of the inferno effect in a radial fashion from the center of the effect to the edge. Wherever there is white in the gradient, you only see inferno noise. Where the gradient is black, you can see the underlying glow. If you set the right side of the gradient to black and the left side to white, and apply the Inferno to the Glow effect of a flare, the inferno effect appears toward the outer edges of the glow, while the center of the glow is still visible.

Lens Effects Highlight Filter

Video Post toolbar > Add Image Filter Event > Choose Lens Effects Highlight from Filter Plug-In list. > Setup

The Lens Effects Highlight dialog lets you assign bright, star-shaped highlights. Use it on objects that have shiny materials. For example, a shiny, red car might show highlights in bright sunlight.
Another good example of an effect perfect for Highlight is the creation of pixie dust. If you create a particle system and animate it moving in a straight line with small four-point Highlight stars applied to each pixel, it will look a lot like twinkling magic.

The Lens Effects Highlight module is multi-threaded and will take advantage of multi-processing machines, making it one of, if not the fastest highlight routines available.

**Procedures**

**To save your highlight settings:**

You can save all of your lens highlight settings to a file, so you can reload them any time. Lens Effects Highlight settings are saved as LZH files on page 8626 (.lzh). Do one of the following:

1. Click the Reset button.
   - This resets Lens Effects Highlight to its default settings.

2. Click the Load button.
This displays a Windows-standard file open dialog from which you can select the settings file you want to load.

3 Click the Save button.

This displays a Windows-standard Save As dialog in which you specify a directory and filename.
When you select Lens Effects Highlight from the Image Filter Event drop-down list and click Setup, the Highlight dialog is displayed.
The Lens Effects Highlight interface is almost identical to the Glow module, with a large preview window, and tabs to control every aspect of your highlight effects.

**Preview group**

**Preview window** Lets you quickly preview the glow effect. The preview window is multi-threaded to take advantage of systems with multiprocessors, and updates every time you make a change to any of the glow settings that might affect the scene.

**Preview** Activates a generic cross star filter so you can quickly set up a Highlight effect. However, as with the Glow module, it is more effective seeing your entire scene and how your effect will interact with your geometry.

**VP Queue** Lets you preview the scene in the Video Post queue. Preview must be selected for the VP Queue function to work.

**Highlight Control tabs**

Similar to the Glow settings, Highlight is also broken down into tabbed sections for fine control over each aspect of the Highlight effect. The four tabs are:

- **Highlight Properties** on page 7358
- **Highlight Geometry** on page 7363
- **Highlight Preferences** on page 7368
- **Lens Effects Gradients** on page 7370

**Button group**

**Reset** Resets Lens Effects Highlight to its default settings.

**Load** Displays a Windows-standard file open dialog from which you can select the settings file you want to load.

**Save** Displays a Windows-standard Save As dialog in which you specify a directory and filename. Lens Effects Highlight settings are saved as LZH files.

**Highlight Properties**

Video Post toolbar > Add Image Filter Event > Choose Lens Effects Highlight from Filter Plug-In list > Setup > Properties tab
The Lens Effects Highlight properties enable you to determine which parts of your scene will have highlights applied to them, as well as how the highlights are to be applied.

Interface

The Properties panel is broken down into two sections: Source and Filter.

Source group

The Source section lets you select any G-Buffer data in the scene that will have a highlight applied to it. Lens Effects Highlight will begin the process by finding the source pixels from your scene that you want to glow.

Whole Lets you apply highlights to the whole scene, not just a particular piece of geometry. This, in effect, makes each pixel in the scene a potential highlight source. The areas of the scene that have highlights applied to them are determined by the settings in the Filter section of the dialog.

Object ID The Object ID Lets you apply highlights to particular objects in your scene that have a corresponding G-Buffer (or Object) ID. The G-Buffer is a geometry buffer and can be defined when you right-click any 3ds Max object and select Properties from the menu. Then, set the Object Channel ID under the G-Buffer ID controls. This parameter can be animated on page 7315.

Effects ID The Effects ID lets you apply the highlight to an object or part of an object with a specific Material ID assigned to it. Material IDs are applied
in the Material Editor. See G-Buffer on page 8589. This parameter can be animated.

The highlights are then only applied to areas of the geometry where that particular ID is present.

**NOTE** In many instances, you might want to apply different highlight settings to different pieces of geometry or IDs. To accomplish this, add additional Lens Effects Highlight entries to the Video Post queue. Then set each different Highlight entry to effect a different Material or Object ID and proceed.

**Unclamped** An unclamped color is brighter than pure white (255,255,255). 3ds Max keeps track of these "hot" areas which tend to show up when your scene contains bright metallic highlights or explosions. This spinner lets you determine the lowest pixel value that is highlighted. Pure white has a pixel value of 1. When this spinner is set to 1, any pixels with a value above 255 will be glowed. You can invert this value by clicking the I button to the right of the spinner. This parameter can be animated.

**Surf Norm** Highlights part of an object, based on the angle of the surface normal to the camera. A value of 0 is coplanar, or parallel to the screen. A value of 90 is normal, or perpendicular to the screen. If you set Surf Norm to 45, only surfaces with normal angles greater than 45 degrees will be glowed. You can invert this value by clicking the I button to the right of the spinner. This parameter can be animated.

**Mask** Highlights the mask channel of an image. The spinner value represents the level of grayscale present in a Mask. When this is set, any part of the Mask images larger than the set value will be glowed in the final image. You can invert this value by clicking the I button to the right of the spinner. This parameter can be animated. Range = 0 to 255.

**Alpha** Highlights the alpha channel of an image. The transparency of an alpha channel is interpreted opposite that of the Mask channel. Values range from 0 to 255. This parameter can be inverted by clicking the I button to the right of the spinner, and can also be animated.

**Z Buffer Hi and Lo** Highlights objects based on their distance (Z-Buffer distance) from the camera. The Hi value is the maximum distance and the Lo value is the minimum. Any objects between these two Z-Buffer distances will be highlighted. These parameters can be animated.

**Filter group**

Filters the Source selections to let you control how the highlight is applied. For example, you can have ten spheres in your scene, each with the same...
Object ID, but different colors. If you set the **Source** as the Object ID of the spheres, which selects all of the spheres, that is the only place in your scene that Highlight will apply an effect.

However, now that Highlight knows where the pixels are that can be highlighted, it needs to know which ones to actually apply the highlights to. Highlight uses the filter controls to find out which source pixels to apply the highlight to.

**All** Selects all source pixels in the scene and applies a highlight to them.

**Edge** Selects all source pixels along a boundary edge and applies a highlight to them. Applying a highlight along the edges of objects produces a soft halo that exists on both inside and outside edges of your object.

![Edge highlights](image)

**Perimeter Alpha** Applies a highlight only to the perimeter of an object based on its alpha channel. Selecting this option highlights only the outside of an object without any spill on the interior. Whereas highlighting by **Edge** produces a spill onto the object, Perimeter Alpha keeps all of the edges clean because it relies on the scene alpha channel to derive its effect.
Perimeter alpha highlights

**Perimeter** Applies highlight effect only to the perimeter of an object based on Edge inferencing. Although not as precise as Perimeter Alpha, you might need to use the Perimeter option at times when the alpha channel is unavailable.
Perimeter highlights

**Bright** Filters the source objects based on their brightness values. Only objects with a brightness above the spinner setting are selected and highlighted. This option can be inverted by clicking the I button next to the spinner. This parameter can be animated.

**Hue** Filters the source objects by their hue. Select the hue by clicking the color swatch next to the spinner. You can choose hue values from 0 to 255. The spinner beside the Hue color swatch lets you enter a variance level so that the glow can find several different hues in the same range as the chosen color. This parameter can be animated.

**Highlight Geometry**

Video Post toolbar > Add Image Filter Event > Choose Lens Effects Highlight from Filter Plug-In list > Setup > Geometry tab

The Geometry panel is where you set the initial rotation of the highlights as well as how the elements are affected over time. The Geometry panel consists of three areas: Effect, Vary, and Rotate.
**Interface**

<table>
<thead>
<tr>
<th>Geometry</th>
</tr>
</thead>
</table>

- **Effect**
  - Angle: 30.0
  - Clamp: 4
  - All Rays: 50.0

- **Vary**
  - Size
  - Reseed
  - Angle: 1234

- **Rotate**
  - Distance
  - Pan

**Effect group**

**Angle** Controls the angle of the highlight points over the course of the animation. This parameter can be animated on page 7315.

**Clamp** Determines the number of pixels highlight must read to place a single highlight effect. In many cases, you want to key your highlight effects off the brightness of objects that can produce a lot of pixels to generate from. The end result is something that looks like stadium lights from a Monday Night Football game, where each pixel has the highlight cross drawn on top of it, which blurs the overall effect. When you want only one or two highlights, use this spinner to adjust how highlight processes the chosen pixels. This parameter can be animated.
Clamp value of 5

Clamp value of 15
As you can see, the Clamp value lets you maximize or minimize the overall number of highlights drawn over the same image. This can be a tremendous time saver.

**Alt. Rays** Alternates the lengths of points around the highlight. It works on every other ray point, changing from the ray's full length to a smaller one based on the percentage spinner beneath it. This parameter can be animated.
Alt. Rays turned on and set to 40%

**Vary group**

The Vary group of controls adds randomness to your Highlight effects. You can quickly adjust your effects so that no two look alike. In many instances, you want to avoid having your Highlights rotate in formation, and the Size and Angle buttons control that.

**Size** Varies the overall size of the individual Highlights.

**Angle** Varies the initial orientation of the individual Highlights.

**Reseed** Forces Highlight to use a different random number to generate parts of its effects.

**Rotate group**

These two buttons let you have your highlights automatically rotate based on their relative position in the scene.

**Distance** Automatically rotates the individual highlight elements as they recede into the distance. The faster your elements recede, the faster they will rotate.
**Pan** Automatically rotates the individual Highlight elements as they move laterally across the screen. If you have objects in your scene that are passing by the camera, they can be automatically rotated based on their position. The faster your elements move across the screen, the faster they will rotate.

### Highlight Preferences

Video Post toolbar > Add Image Filter Event > Choose Lens Effects Highlight from Filter Plug-In list > Setup > Preferences tab

The Preferences panel defines the size and number of points on the highlight, occlusion settings, and whether or not it affects the Z-Buffer or alpha channels.

#### Interface

<table>
<thead>
<tr>
<th>Scene</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>Affect Alpha</td>
<td>Size</td>
</tr>
<tr>
<td>Affect Z Buffer</td>
<td>Points</td>
</tr>
</tbody>
</table>

#### Scene group

**Affect Alpha** Determines whether or not the highlight settings affect the alpha channel of the image when you render to a 32-bit file format.

**Affect Z Buffer** Determines whether or not the highlight affects the Z-Buffer of the image. When this option is selected, the linear distance of the highlight is recorded, and can be used in special effects that make use of the Z-Buffer. For example, the Focus module that ships with Lens Effects blurs objects based on their Z-Buffer information. If you want to use Focus to blur a highlight,
you must select this option. If you are not sure about whether or not to select this option, leave it disabled, because you probably don't need it.

**Distance Fade group**

**Bright** Lets you fade the brightness of the highlight effect based on the distance away from the camera. This parameter can be animated on page 7315.

**Lock** Locks the Bright and Size spinner values together.

**Size** Lets you fade the size of the highlight effect based on the distance from the camera. In most circumstances, you want the overall size of your highlights to diminish as they get farther from the camera. This option takes care of that for you. This parameter can be animated.

**Effect group**

**Size** Lets you determine the overall size of the highlight effect, and is calculated in pixels. This parameter can be animated.

**Points** Controls the number of points to be generated for a highlight effect. This parameter can be animated.

**Color group**

**Gradient** Lets you create the highlight based on the settings in the Gradients panel.

**Pixel** Lets you create the highlight color based on the pixel color of the highlighted object. This is the default method for Lens Effects Highlight and is exceptionally fast.

**User** Lets you select a specific color for the highlights through the standard 3ds Max Color Selector on page 371. The color swatch shows you the currently selected color.

**Intensity** Lets you control the intensity or brightness of the highlights. Values range from 0 to 100. This spinner functions only when you are using either the Pixel or User color methods to control the brightness of the highlight effect. This parameter can be animated.
Lens Effects Gradients

Video Post toolbar > Add Image Filter Event > Choose Lens Effects Highlight from Filter Plug-In list > Setup > Gradients tab

A gradient is a smooth linear transition from one color or brightness to another, as shown below. Lens Effects use gradients to control aspects of the lens flares, such as colors and transparency. Lens Effects use several gradient types on page 7375.

Lens Effects Gradients are always interpreted from left to right.

Gradient Flags

Gradients use Flags to indicate points along the gradient bar where you want different colors or brightness values to be. The colors between the flags are interpolated automatically by Lens Effects. Each Gradient inside Lens Effects can contain up to 100 flags. The current flag is highlighted and green. The position number above the gradient bar indicates the position of the current flag, in relation to the overall length of the gradient.

A gradient always has non-moveable start and end flags. You can add up to 98 intermediate flags to alter the overall appearance of your gradients. You can also change the color or brightness of the end flags to suit your needs.

When you place two gradient flags on top of one another, you create a sharp break in the gradient. When a third flag is placed on top of the second flag, a sharp edge appears in the gradient.

WARNING When you animate Lens Effects parameters, this creates pointers into the actual scene, so Lens Effects animation is lost if you save the Video Post queue in a VPX file on page 8758. To preserve the animation, save the Video Post data, including Lens Effects animation, in the MAX file.
Procedures

To add an intermediate flag:

- Click the gradient bar where you want to place the new flag.
  The flag uses the color of the gradient at the point where you placed it. To
  adjust the color, double-click to display the Color Selector on page 158.

To adjust the position of a flag:

- Drag the flag left or right.
  The gradient updates to show you the changes.

To delete a flag:

- Drag the flag outside the gradient bar.
  The flag turns red, and the mouse point changes to a down arrow pointing
  to a bucket. When you let go of the mouse button, the flag is deleted.

To change a flag’s properties:

1. Right-click the flag to display a menu.
2. Click Properties and change any settings you want.

Interface

Right-clicking a gradient flag and selecting Edit Properties displays the Flag
Properties dialog. To change gradient options on page 7372, right-click the
gradient bar, not the flags.
The Flag Properties dialog lets you change the name of the flag, its color, and its position.

**Name** By default, flags are named Flag #. You can enter a different name for the current flag. The arrows to the right of the name box let you choose other flags on the same gradient.

**Color** The Color swatch lets you control the color or brightness component of the gradient at the position where the flag is located. Click the color swatch to display the color picker and choose a different color. The green arrow to the left of the color swatch indicates that this flag parameter can be animated on page 7315.

**Position** Each gradient has 100 possible positions from left to right. The number in the spinner represents the position of the flag along the gradient. Gradients are read from left to right so a value of zero aligns the flag with the left edge of the gradient. This flag parameter can be animated.

**Gradient Options**

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event > Choose a Lens Effects Filter from the Filter Plug-In list. > Setup > Gradient tab

Each gradient in Lens Effects has a set of common options. Right-clicking the gradient bar displays a shortcut menu with the following options.
Interface

<table>
<thead>
<tr>
<th>Gradient Control</th>
<th>Default Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Radial Color</td>
<td>R=255, G=255, B=255, Pos=0, High</td>
</tr>
<tr>
<td>Radial Transparency</td>
<td>Val=255, Pos=0, High</td>
</tr>
<tr>
<td>Circular Color</td>
<td>R=0, G=0, B=0, Pos=0, High</td>
</tr>
<tr>
<td>Circular Transparency</td>
<td>Val=0, Pos=0, High</td>
</tr>
<tr>
<td>Radial Size</td>
<td>Val=255, Pos=0</td>
</tr>
</tbody>
</table>

**Reset** Resets the gradient back to its default parameters. This action cannot be undone.

**Load Gradient** Displays a file open dialog in which you can load a particular gradient. Gradients are saved with a `.dgr` extension.

**Save Gradient** Displays a file save as dialog where you specify the path and filename for the gradient.

**Load UV Map** Lets you load a bitmap image and use each row of pixels of the bitmap as an animated gradient. When a bitmap is loaded into a gradient control, Lens Effects reads the first 100 pixels across the top row of the image (for the 100 divisions of its gradient controls) and makes them the gradient. With each successive frame, Lens Effects reads in the next row of pixels as the gradient. When you scrub the animation slider, you can see the gradient change over time.

**NOTE** If the animation is longer than the chosen bitmap is tall, then the bitmap pattern is repeated.

**Load Bitmap** Displays a 3ds Max file browser so you can select a bitmap to use as your gradient. Unlike UV Map, the Load Bitmap option only reads the first row of pixels for the entire animation. This is a good option when you need to have a complex but static gradient.
**Flag Mode** Indicates you are using flags to set the colors of your gradient instead of using a bitmap as the source. Flag Mode is selected by default.

**Compositing Methods**

The last five options on the shortcut menu are different types of compositing methods. When you work with Color and Transparency gradient controls in any of the Lens Effects filters, you must be aware of both the Radial and Circular gradients. Both Lens Effects color gradients and both Transparency gradients are "locked together" and will work together based on the compositing method you choose to create an effect.

Each compositing method works on a pixel-by-pixel basis on the positional value in both gradients. The compositing methods define how the colors and brightness values are combined to form a single color. When combining the colors, the algorithms evaluate each color channel of the color to find the end result. This lets you create five very different looking effects with the same two gradients.

**High Value** When this option is selected, the higher color or brightness value between the two gradients is selected. For example, if you had a color with RGB values of 255,210,255 and another with 225,240,225, the resulting color would be 255,240,255. This option generally results in a slightly brighter lens flare than the default settings.

This is the most common way of using only one gradient. Set one gradient to the color or brightness you desire, then set the other gradient to pure black. This assures that all of the values you set in one gradient are used exclusively to achieve the effect.

**Average** Calculates an average value between the colors. In the example above, the resulting color would be 175, 225, 225. This option is good if you want to mix gradient values and results in effects that are not as bright as High Value.

**Low Value** Selects the lower color values, resulting in a less intense lens flare and a more subtle overall effect. In the example above, the resulting color would be 100,210,295.

**Additive** Adds colors values together, pushing their composite value toward pure white, producing the brightest but most washed-out effects. Additive compositing is good when you want to burn effects out.

**Subtractive** Subtracts colors values from each other, resulting in slightly muted and less intense colors.
These compositing methods may be applied to all types of gradients, except size gradients. The type of compositing being used for a gradient is noted above the gradient bar. Compositing methods are applied to every gradient. Some gradients are linked together, so if you assign a specific compositing method to one, the compositing method is automatically assigned to the other.

**Types of Gradients**

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event > Choose a Lens Effects Filter from the Filter Plug-In list. > Setup > Gradient tab

There are two different kinds of gradients in Lens Effects, Radial and Circular. Between the two types, you can achieve almost limitless effects.

**Interface**

**Radial** Radial gradients work from the center point to the outer edge of a Lens Effects feature, changing color or brightness in a straight line from left to right as you scan the gradient bar. The left edge of the gradient is aligned with the center of the effect and the right edge is aligned with the outer edge of the effect.

![Scheme of a radial gradient](image)
Circular Changes colors in a circular manner, working clockwise around a Lens Effects feature. If you mark North, East, South, and West on a circle, these points represent the 0%, 25%, 50%, and 75% marks of the gradient. Each parameter panel in Flare, Glow, and Highlight that utilizes gradients contain five gradient controls. The five controls are:

![Diagram of a circular gradient]

**Scheme of a circular gradient**

**Color (Radial and Circular)** Defines the colors used on page 7377 for an effect. This is based on the RGB color system, but can also be set with HSV. Within each set of gradient controls, there is a Radial and Circular Color gradient. Radial Color works with Circular Color to produce the overall color for the Lens Effects element.

**Transparency (Radial and Circular)** Varies the visibility of parts of the effect. The transparency gradients only make use of brightness (or luminance) values, which are essentially grayscale values. This black-to-white ramp of values provides you with 256 levels of transparency for your effects. Just like the Color gradients, both Transparency gradients are tied together to generate the overall visibility of effect. See **Gradient Options** on page 7372.

**Size** Varies the size of specific parts of the Lens Effect. Most size gradients are used to affect the radius of a lens flare part, such as a glow. Like transparency
gradients, only the brightness values are used to provide you with 256 different sizes.
The Radial Size gradient, for example, works both like a Radial and Circular gradient. This gradient is applied in a clockwise fashion, starting at 12 o'clock. The values in the gradient are applied from the center of the effect toward the outer edge, with brighter values producing bigger sizes and darker values producing shorter sizes.

Gradient Colors

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event > Choose a lens effects filter from the Filter plug-in list. > Setup > Gradient tab

Colors in 3ds Max are interpreted in two different ways: RGB and HSV. In RGB (red, green, blue), you can select one of 256 shades of red, green, and blue, giving you a palette of 16.7 million colors (24 Bit). In HSV (Hue, Saturation, Value), you can select one of 256 hues of color, then adjust the saturation or the value of the color. The saturation can also be considered the blackness of a color and value can be considered the whiteness of a color.

For transparent and size gradients, you adjust the vertical whiteness slider just to the left of the RGB and HSV sliders. The white triangle on the right side of the vertical bar is the slider. This controls the overall value of the color in terms of HSV. In RGB terms, it is the same as adjusting all three colors equally at the same time. Higher values on the whiteness scale represent more transparency, or smaller sizes.

See also:

■ Color Selector Dialog on page 371

Negative Filter

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event > Choose Negative Filter from the Filter Plug-In list.

Rendering menu > Video Post > Video Post window > Select a Negative Filter. > Video Post toolbar > Edit Current Event > Setup

The Negative filter inverts the colors in the image, making it negative like a negative color photograph.
Effect of negative filter

When you click the Setup button in the Edit Filter Event dialog for the Negative filter, the Video Post dialog is replaced by a modeless Negative Filter dialog with a Blend spinner. You can turn on Auto Key, move the time slider, and change the Blend value to create keys. (You can also use other 3ds Max functions; for example, you can create objects.) When you've set all the keys you want, click the OK button to return to Video Post.

After creating keys from the Video Post filter, you'll find the track for the new keys as a child of the Video Post track in the Track View – Curve Editor. Specifically, in the above example, you'll find the following hierarchy in the Curve Editor:
Interface

Blend Sets the amount of blending that occurs.

**Pseudo Alpha Filter**

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event > Choose Pseudo Alpha Filter from the Filter Plug-In list.

Rendering menu > Video Post > Video Post window > Select a Contrast Filter. > Video Post toolbar > Edit Current Event

The Edit Pseudo Alpha filter creates an alpha channel for the image based on the image's first pixel (the upper-left corner pixel). All pixels that have the same color as this pixel become transparent.

Because only one pixel color becomes clear, edges of the opaque areas are aliased. The main use for this filter is when you want to composite a bitmap whose format does not have an alpha channel.

There is also a layer event called the Pseudo Alpha Compositor on page 7386. There are no setup options for this filter.

**Simple Wipe Filter**

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event > Choose Simple Wipe Filter from the Filter Plug-In list.

Rendering menu > Video Post > Video Post window > Select a Simple Wipe Filter. > Video Post toolbar > Edit Current Event > Setup
The Simple Wipe filter reveals or erases the foreground image with a wipe transition. Unlike the Wipe Layer compositor on page 7388, Wipe Filter wipes across a fixed image.

Wipe reveals an image by wiping from one side to the other, over time.

This filter wipes from image to image (or from an image to black). The filtered image stays in place, but is revealed or erased with a wipe across the image. If you're using a Wipe as a filter event, you'll usually want to use an Alpha Compositor as a layer event as well.

A typical queue sequence would be: Alpha Compositor (layer)

-->Image #1

-->Simple Wipe (filter)

------>Image #2

The rate of the wipe is determined by the length of the Wipe filter's time range. The area not covered by the image renders as black unless you use an Image Layer event to composite the Wipe filter with another image.
Interface

Direction group

Right-pointing arrow Wipes from left to right.
Left-pointing arrow Wipes from right to left.

Mode group

Push Reveals the image.
Pop Erases the image.

Starfield Filter

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event > Choose Starfield Filter from the Filter Plug-In list.

Rendering menu > Video Post > Video Post window > Select a Starfield Filter. > Video Post toolbar > Edit Current Event > Setup

The Starfield filter generates a realistic starfield with optional motion blur. The Starfield filter requires a camera view. Any motion of the stars is a result of camera motion.
Procedures

To use the Starfield filter:

1. Create a camera and (optionally) animate the camera's or target's position, field of view, and roll.

2. Choose Rendering > Video Post and add a Scene Event, using the camera for the view.

3. Select the Scene Event in the queue, click Add Image Filter, select the Starfield filter, and click the Setup button.

4. In the Stars Control dialog, make sure that the selected camera matches the camera used in the Scene Event.
   If these don't match, the stars will not match the camera's motion. If there is only one camera in the scene, the field will default to that camera.

5. Set the starfield parameters, then exit the Stars Control dialog and the Edit Filter Event dialog.

6. Execute the Video Post sequence to see stars.
**Interface**

**Source Camera group**

*Source Camera* Lets you choose from a list of cameras in the scene. Choose the same camera as the one being used to render the scene.

**General group**

Set the brightness range and size of the stars.

*Dimmest Star* Specifies the dimmest star. Range = 0 to 255.

*Brightest Star* Specifies the brightest star. Range = 0 to 255.

*Linear/Logarithmic* Specifies whether the range of brightness is calculated linearly or logarithmically.
Star Size (Pixels) Specifies the size of the stars, in pixels. Range = 0.001 to 100.

Motion Blur group
These settings control the streaking effect of the stars when the camera moves.
Use When on, the starfield uses motion blur. When off, the stars appear as dots, no matter what the camera's motion.
Amount The percentage of the frame time that the camera "shutter" is open. Default = 75%.
Dimming Determines how the streaked stars will dim as their trails lengthen. The default of 40 provides a good effect for video, dimming them a bit so they don't appear to flash.

Star Database group
These settings specify the number of stars in the starfield.
Random Generates the number of stars indicated by the Count spinner, using the random number Seed to initialize the random number generator.
Seed Initializes the random number generator. By using the same Seed value in different animations, you're guaranteed identical starfields.
Count Specifies the number of stars generated when Random is chosen.

Custom Reads the file specified. A provided star database, earth.stb, contains the brightest stars in Earth's sky.

Compositing group
Background (The default.) Composites the stars in the background.
Foreground Composites the stars in the foreground.
Layer Events

Layer events composite two events. They can also create a transition from one event to the event that follows. The topics in this section describe the layer events that are provided with Video Post.

Alpha Compositor

Rendering menu > Video Post > Video Post window > Make sure the two child events are in the order you want the Image Layer event to use them. > Select the two events. > Video Post toolbar > Add Image Layer Event > Choose Alpha Compositor from the Layer Plug-in list.

Rendering menu > Video Post > Video Post window > Select an Alpha Compositor > Video Post toolbar > Edit Current Event

The Alpha compositor composites the two images using the alpha channel on page 8502 of the foreground image. The background image appears in areas where the foreground image's alpha channel is transparent.

Procedures

To use the Alpha Compositor filters:

1. Add two Scene or Image Input events to the queue.
2. Select both events and assign an Image Layer event consisting of the Alpha Composite Filter.

Cross Fade Compositor

Rendering menu > Video Post > Video Post window > Make sure the two child events are in the order you want the Image Layer event to use them. > Select the two events. > Video Post toolbar > Add Image Layer Event > Choose Cross Fade Compositor from the Layer Plug-in list.

Rendering menu > Video Post > Video Post window > Select a Cross Fade Compositor. > Video Post toolbar > Edit Current Event
The Cross Fade compositor composites the two images over time, cross-fading from the background image to the foreground image. The rate of the cross fade is determined by the length of the Cross Fade Transition filter's time range.

Cross Fade fades one image into another over time.

There are no setup options for this compositor.

**Procedures**

**To use the Cross Fade Compositor:**

1. Add two Scene or Image Input events to the queue.
2. Select both events and assign an Image Layer event consisting of the Cross Fade Compositor.

**Pseudo Alpha Compositor**

Rendering menu > Video Post > Video Post window > Make sure the two child events are in the order you want the Image Layer event to use them. > Select the two events. > Video Post toolbar > Add Image Layer Event > Choose Pseudo-Alpha Compositor from the Layer Plug-in list.

Rendering menu > Video Post > Video Post window > Select a Pseudo-Alpha Compositor. > Video Post toolbar > Edit Current Event

The Pseudo-Alpha compositor composites a foreground image against the background by creating an alpha channel for the foreground image based on the foreground image's upper-left-corner pixel. All pixels in the foreground image that use this color become transparent.
Pseudo Alpha compositing

Because only one pixel color becomes transparent, edges of the opaque areas in the foreground image are aliased. Use this method when the foreground image is a bitmap whose format does not have an alpha channel.

There are no setup options for this compositor.

There is also a Pseudo Alpha filter event on page 7379.

Procedures

To use the Pseudo Alpha Compositor:

1. Add two Scene or Image Input events to the queue.
2. Select both events and assign an Image Layer event consisting of the Pseudo Alpha Composite Filter.

Simple Additive Compositor

Rendering menu > Video Post > Video Post window > Make sure the two child events are in the order you want the Image Layer event to use them. > Select the two events. > Video Post toolbar > Add Image Layer Event > Choose Simple Additive Compositor from the Layer Plug-in list.

Rendering menu > Video Post > Video Post window > Select a Simple Additive Compositor. > Video Post toolbar > Edit Current Event

The Simple Additive compositor composites the two images using the second image's intensity (HSV value) to determine transparency. Areas of full intensity (255) are opaque; areas of zero intensity are transparent; and areas with intermediate transparency are translucent.
Additive compositing

This layer event can be useful when the second image is a bitmap whose format does not have an alpha channel.

There are no setup options for this compositor.

**Procedures**

To use the Simple Additive Compositor:

1. Add two Scene or Image Input events to the queue.
2. Select both events and assign an Image Layer event consisting of the Simple Additive Compositor.

**Simple Wipe Compositor**

Rendering menu > Video Post > Video Post window > Make sure the two child events are in the order you want the Image Layer event to use them. > Select the two events. > Video Post toolbar > Add Image Layer Event > Choose Simple Wipe Compositor from the Layer Plug-in list.

Rendering menu > Video Post > Video Post window > Select a Simple Wipe Compositor. > Video Post toolbar > Edit Current Event

The Simple Wipe compositor reveals or erases the foreground image with a wipe transition. Unlike the Wipe filter on page 7379, the Wipe layer event moves the image, sliding it in or out.

The rate of the wipe is determined by the length of the Wipe compositor's time range.
Wipe reveals an image by wiping from one side to the other, over time.

Procedures

To use the Simple Wipe compositor:

1. Add two Scene or Image Input events to the queue.
2. Select both events and assign an Image Layer event consisting of the Simple Wipe Compositor.
4. Click Setup to display the Simple Wipe Compositor Setup dialog.

Interface
Direction group

Right-pointing arrow Wipes from left to right.
Left-pointing arrow Wipes from right to left.

Mode group

Push Reveals the image.
Pop Erases the image.
Managing Scenes and Projects

These topics are concerned with managing scenes, projects, and the files that make them up.

**Working with AutoCAD, Revit, and AutoCAD Architecture**

3ds Max contains many features designed to streamline the design visualization workflow. See [Working with Drawing Files](#) on page 7492. The [File Link Manager](#) on page 7538 allows you to create a live link to a DWG file. You can then apply materials and animations in 3ds Max, but still update your geometry if any changes are made to the original file.
A house model created in Revit becomes a detailed rendering in 3ds Max

File-Handling Commands

The principal commands for handling files on page 7431 are found on the Application menu on page 7989.

File-Handling Utilities

Several utilities help you manage files:

- The Asset Browser on page 7614 provides another way to find and preview files and use them in 3ds Max scenes.
- The Bitmap / Photometric Path Editor utility on page 7629 lets you view bitmap paths or remove them from the scene file.
- The File Finder on page 7634 is another resource for finding 3ds Max scenes.
- The Resource Collector on page 7637 copies or moves a scene's bitmaps into a single directory.
- The **Fix Ambient utility** on page 7639 resolves lighting issues with older versions of scene files.

- The **Bitmap Pager Statistics dialog** on page 7642 provides information that helps you resolve issues with scenes that require large amounts of memory for texture maps.

- The **Substitute modifier** on page 1759 lets you replace linked AutoCAD Architecture objects with native 3ds Max geometry and objects.

**Geometry File Formats**

You can import a variety of geometry file formats on page 7645 into a scene.

**Image File Formats**

You can use image file formats on page 7831 in a variety of ways: as textures for materials, as backgrounds to viewports, as background environments, as Image Input events in Video Post, and as images projected from a light.

**External References (XRefs) to Objects and Scenes**

External references on page 7447 to objects and scenes are another powerful way to manage a project, especially when it involves multiple contributors.
Objects in a scene can be externally referenced, created and maintained by other users.

**RAM Player**

You can preview images by using the View File command on page 6535, or by using the more interactive RAM Player on page 7882.

**Scene Explorer**

Scene Explorer on page 7888 is a powerful tool for organizing scene elements, selecting object based on various criteria, changing object display properties, and creating and modifying object hierarchies.
Scene States

The Scene States on page 7922 feature provides a fast way to save different scene conditions with various properties that can be restored at any time and rendered to produce different interpretations of a model.

Schematic View

Schematic View on page 7926 displays the scene as a graphic schema instead of as geometry. It gives you an alternate way to select or rename the objects in your scene, and to navigate among modifiers. It is especially useful for viewing objects in a hierarchy.

Layers

Layers on page 7953 are like transparent overlays on which you organize and group different kinds of scene information. The objects you create have common properties including color, renderability, and display.

Container

Create panel > Helpers > Standard > Object Type rollout > Container

The Container on page 8536 helper lets you organize scene contents into logical groups that can then be handled as a single object. You can transform all of a Container's constituent objects by transforming the Container helper object on page 8599. The Container differs from other grouping tools in 3ds Max primarily in its ability to save the contents to disk for collaborative purposes, and the ability to set rules to limit fellow team members' access to the inner workings of the Container.

Containers are useful in a wide variety of digital-content-creation contexts. For example, in a games pipeline users will typically build parts of a level,
buildings, and character models each in Container. The Containers are then assembled in a scene, where they are lit.

Work can begin on scene assembly, while the buildings and other components are still in progress, since the updates to the Containers are regularly refreshed in the assembled scene.

To ensure that objects are exported from their original files with the correct light map on page 8618, all of the Containers can be edited in the level scene, and light maps and UVs can be added, then written back to the source buildings with Edit In Place. The original building will now be ready to export.

Containers also help you organize large scenes, like cities for example. You can put each block in a Container, then unload those blocks not being edited, thereby greatly reducing scene loading, saving, and evaluation time.

In many cases, scene visibility is organized by groups, with trees, cars and buildings on their own layers on page 8617. You can override object visibility by controlling its visibility in the Container with Override Object Properties. In other words, specific Containers can show all their contents, even though some of its objects are defined as hidden in their layer.

Containers created by others and inherited, or imported, into a scene are referred to as Source Containers on page 8725. When you inherit a Source Container, your scene references the Container’s content from its source file. You can open and edit the Source Container contents if its author has set the required edit permission.

Containers created on your workstation are local. Local Containers on page 8620 can exist in an unsaved state in a scene, and are used much like groups and layers to organize objects.

Using Containers

In general, these are the reasons to use Containers:

- To reduce scene complexity by grouping objects into a larger component. If you select, transform, delete, unload, or hide a Container, you do the same to all its objects. (Selecting an open Container does not select its contents, unless you double-click it.)

- To easily identify groups of objects. Rather than finding all the objects required for a hand, for example, you can select a “hand” Container.

- To improve scene performance by reducing the time required to load and save your work.
When you close a Container, its objects are saved in a MAXC file and referenced by the scene.

- To inherit any changes made by the Container's author without any prior familiarity with the content or changes. (Each time you refresh a referenced Container, you inherit any changes made by its author.)
- To promote collaboration in a production pipeline. In a collaborative environment, you can load a Container with edit permission into a scene, make changes, then save the Container. All users who reference the Container now inherit those changes as well. They in turn can make changes and have their updates reflected in the Container contents.

**Container Workflows**

This topic describes typical scenarios in which you can use Containers.

**Using Containers to Copy and Update Scene Content (Local Referencing)**

Workflow: Group objects into a Container, translate them as a single entity, make copies, update the copies in a single step, and branch off for separate development.

1. Create a Container on page 7416 in a scene.
   The Container displays in an open state. Open Containers are fully editable.

2. Add scene objects on page 7416 to the Container.
   The added objects are parented to the Container.
Two apartment models added to a Container

3 Translate the Container.
Any changes made to the Container affect its contents as well.

Container contents repositioned in a scene
4 Close the Container on page 7418 and save it as Block_A.maxc.
   While still visible in the viewports, the Container contents are removed from the scene. The scene now references the Block_A.maxc file from its saved location.

5 Make two copies of the Container, then reposition each one where needed in the scene.
   All Containers reference the same Block_A.maxc file.

   ![The original Block_A Container (far left) and its two copies (middle and right)](image)

6 Create another object in the scene, add it to an open Container, and click Save.
   Because the copied Containers reference the same MAXC file, they update as well.

   ![All Containers receive the added object](image)

7 Open one of the Container copies and save it on page 7418 to a unique name, Block_B.maxc.
The Block_B Container is now branched off for its own development.

Block_B Container (far right) is branched off. It is unaffected by updates to Block_A Containers (left and middle).

Using Containers to Share and Edit Externally-Created Content (In-Place Editing)

Workflow: Inherit content from others, pass changes back to the original creator, and branch off from referenced Containers for local development.

1. User B goes to the Container Explorer on page 7428, clicks Inherit Container on page 7420, and chooses the Block_A.max file from the Inherit Container dialog.

The Container is placed in the same coordinates as User A’s scene.
Container from User A (left) is inherited by User B (right)

2 User A makes changes to a building in the Container and turns on Enable Update When Closed.

Changes to User A’s building (left) before closing the Container
3 User A closes the Container on page 7418. User B automatically inherits the latest changes. The Container is automatically saved as it closes. Any time the Container is saved, User B inherits the changes, whether User A closes it or not.

User B’s Container (right) after inheriting changes from User A

4 User A is now ready to make his Container editable by others. He turns on Allow Edit In Place on page 7426.

5 User B goes to the Manage Container rollout and clicks Edit In Place.

6 User B makes her edits and clicks Edit In Place again. The Container is closed and User A’s source definition is overwritten. The next time the author (or anyone else referencing the Container) clicks Reload they will see the changes made by User B.
User A inherits changes made by User B

NOTE It is important to use version control software, such as Perforce or Source Safe, to make sure no two people simultaneously working on the same Container overwrite changes made by the other.

7 User B needs to make a copy of the Container and use it for another project.

In the Inherited Content rollout, she clicks **Merge Source Definition** on page 7427. The copied Container is now local and behaves as if it was created from scratch in the current scene, rather than inherited from an external source. The Container is now branched off and no longer references anything.
Using Containers to Manipulate Content and Set Visibility in a Complex Scene

Workflow: Close a Local Container on page 8620, unload the Container to remove its contents from the scene, translate the Container helper to another area in the scene, and reload the Container so its contents display in their new location.

1. Create three Containers in a scene, close them, and save each under its own name.

   The Containers are saved to disk and their contents, while still visible in the viewports, are removed from the scene. Scene performance is improved: it now takes less time to autosave, as well as save and reload the scene file.
2  Click Unload to close one Container and hide its contents.

3  Move the unloaded Container helper to a new position, then click Load. The Container contents redisplay at their new location.
This is a fast way to toggle content in and out of a complex or data heavy scene.

**Using Containers to Control Content Editability (Manage Merge and Make Unique)**

Workflow: Create a Container and place second Container inside it, allow edits to the master Container, then inherit the nested Container to prevent edits by others.

1. User A creates a Container on page 7416 and adds the contents on page 7416 of a city block to it.
2 User A creates a second Container, adds a skyscraper to it, saves the Container on page 7418, and adds it to the first Container.
User A now has a master Container, with another Container nested inside.
3 User A selects the master Container, turns on *Allow Edit In Place* on page 7426, and saves the Container.

4 User A wants to protect the Skyscraper Container from edits by others, so he selects the Skyscraper Container, inherits it, and saves the master Container again.

5 User B inherits the master Container in her scene, then clicks *Merge Source Definition* on page 7427. This places the Container in the same state as it is in the author’s scene. (The open Container is editable, but the closed nested Container is referenced and therefore uneditable.)
6 User B decides she also needs access to the uneditable Container, so she clicks Make All Content Unique on page 7426. The previously uneditable Container opens but it no longer references the author’s Source Container on page 8725. User B can now modify its contents locally for her own scene.

User B continues to work locally, building upon the work of User A

Using Containers to Control the Display of Objects In a Scene

Workflow: Set up Container display so you can work on specific Containers and hide the rest of the scene contents. Change the display setup without permanently changing the display organization of the scene.

1 Turn on Expand Bounding Box for each Container in the scene. This makes it easier to identify which objects belong to which Container.
2 In the Layer Manager on page 7956, set object display properties so that only certain types of objects can be viewed and worked on.

3 Right-click a Container and set its Object Properties to By Layer.

4 With the Container still selected, turn on Override Object Properties.

5 Turn on Override Object Properties for all Containers.
You can easily override object properties of selected Containers from the Container Explorer or the Tools > Containers sub menu.

6 Right-click a Container, choose Object Properties, then set Display Properties to By Object and See-Through.

![Left Container object display properties set to See-Through, in order to see objects behind it](image)

7 In the Layer Manager on page 7956, click Render to turn off the renderability of the Containers to the left and right, so you can quickly render only the part of your scene.

![Renderability of left and right Containers turned off](image)

The renderable content of the scene is determined not by individual object or layer settings, but by Container.

**Circular Referencing**

Workflow: User A inherits Container from User B, User B inherits Container from User A, each user clicks Update to keep abreast of the other's work. They click Allow Edit In Place to their own Containers to permit changes by an external user.

1 User A is modeling a group of buildings in one Container. User B is working on vehicle animation in a different Container.
Both users inherit on page 7420 one another’s Containers.

Users A and B can now work in parallel. They are developing their own components of a scene, while at the same time being able to see the progress of their colleague’s work.
User A (top) and User B (bottom) inherit one another's scene components.

3  User B selects her Local Container on page 8620 and turns on Allow Edit In Place on page 7426.

4  User B selects the Container inherited from User A, and clicks Update. She then adds keys to User A's Container to sync the movement of the animated cars.
User B adds keys to extend animation into User A’s part of the city

5 User A clicks Update to see the recent changes made by User B.

User A inherits the changes made by User B
Working With Containers

This topic provides useful tips when working with Containers.

■ Because Containers can be inherited by others and added to their own scenes, make sure no dependencies in your scene exist outside of a Container. To ensure a Container can be properly referenced by others, nest the Container and all its dependencies inside one another.

■ It is strongly recommended you have a good source control system in place, or good personal communication as a minimum, to prevent any two users working on the same Container from overwriting one another’s work.
If two users intend to work on the same Container, the following procedure is suggested:
- User A saves the Container, with Edit In Place on.
- User B inherits the Container, turns off Allow Edit In Place and saves the Container.
- User B continues to edit to the Container. With Allow Edit In Place turned off, he is the only one who can edit the Container.
- User B finishes his edits, turns Allow Edit In Place back on, and saves the Container.

■ If you plan to share a Container with others, make sure you are all using the same system units.

■ You cannot instance on page 8611 Containers. Alternatively, you can copy a Container one or more times, edit the Container, save its changes, then click Reload so that all its copies inherit the changes.

■ Containers are parents of their contents, so any transformations you make to the Container affect all objects inside it.

■ You can create a parent/child relationship between two objects inside a Container. However, if you unlink an object, it will be unlinked from its parent, as well as removed (unlinked) from the Container.

■ You cannot add Xref on page 8771 materials or controllers to objects in a Container.

■ Before placing animated rigs in Containers, make sure all objects in the rig are un-hidden and un-frozen and that the Container is centered at the origin (X=0, Y=0, Z=0). When adding rigs to a Container, make sure to include all dependencies as well.
You can open a Container file as you would a regular MAX scene file to troubleshoot its contents. Simply rename the Container file’s MAXC suffix to MAX.

If you clone a closed, inherited Container, you cannot undo the action. If you clone an open Container that has Edit In Place on, you can undo the action.

**Procedures**

**To create a Container:**

1. On the Create panel, click Helpers.
2. On the Object Type rollout, click Container.
3. Click and drag in a viewport to create the Container helper object.
4. Right-click to end the object creation.

When first created, the Container is open. Open Containers are editable.

**To create a Container from selected objects:**

- Do one of the following:
  - In a viewport, select the objects you want to place in the Container and from the Tools menu choose Containers > Create Container From Selection.
  - Open a Container Explorer on page 7428, Scene Explorer on page 7888, or Container Toolbar on page 7429, select the objects you want to place in the Container, and from the toolbar click Create Container From Selection.

A Container displays in the scene with the selected objects placed inside.

**To add objects to a Container:**

- Do one of the following:
  - In a viewport, select an open Container you want to add objects to, then on the Modify panel > Local Content rollout, click Add. On the
Add Container Node dialog, select the objects you need, and click Add.

- In a viewport, select the objects you want to add to the Container, then from the Tools menu, choose Containers > Local Content > Add Selected To Container. From the Select Container To Add To dialog, select an open Container you want to add the objects to.

- Open a Container Explorer on page 7428, Scene Explorer on page 7888, or Container Toolbar on page 7429, select the objects you want to add, and from the toolbar click Add Selected To Container. On the Select Container To Add To dialog, select the Container, and click Add To Container.

The added objects remain visible in the viewports, but they are removed from the scene and referenced in the Container’s MAXC file.

To remove objects from a Container:

- Do one of the following:

  - In a viewport, select an open Container you whose objects you want to remove. (You cannot select objects from Containers that are closed.) On the Modify panel > Local Content rollout click Remove. On the Remove Container Node dialog, select the objects you need to remove and click Remove.

  - In a viewport, select the objects you want to remove, then from the Tools menu, choose Containers > Local Content > Remove Selected From Container.

  - Open a Container Explorer on page 7428 or Scene Explorer on page 7888, select the objects in the Container you want to remove, and from the toolbar click Remove Selected From Container.

The object is removed from its Container and added to the scene.

To identify which Container an object belongs to:

1. Select the object in a scene whose Container you want to identify.
2. From the Tools menu, choose Containers > Select Content’s Container. The object’s Container is selected in the scene.
To close and save a Container:

1 Do one of the following:
   ■ In a viewport, select the Container you want to close, then on the Modify panel > Manage Container rollout, click Close.
   ■ In a viewport, select the Container you want to close, then from the Tools menu, choose Containers > Close Container.

   ![Image](image.png) Open a Container Explorer on page 7428, Scene Explorer on page 7888, or Container Toolbar on page 7429, select the Container you want to close, and from the toolbar click Close Container.

2 If this is the first time you are closing and saving the Container:
   ■ Use the Container Definition File dialog to navigate to the location where you want to save the Container file.
   ■ In the File Name box, give the Container a file name.
   ■ Click Save.

The Container helper changes from an open to closed state. By default, each time you close and save a Container, it cannot be edited by anyone other than yourself. To learn about how to make your Container editable, refer to To allow edits to a Container: on page 7421.

Objects in Containers that have been closed are removed from the scene but remain visible. They are now referenced by the scene from the saved Container’s file location. Closed Containers can be an effective way to improve scene performance.

To save a Container:

➤ Do one of the following:
   ■ In a viewport, select the Container you want to save, then on the Modify panel > Local Content rollout, click Save.
   ■ In a viewport, select the Container you want to save, then from the Tools menu, choose Containers > Local Content rollout, click Save Container.
To reload a Container:

➤ Do one of the following:

- In a viewport, select an open Container you want to reload, then on the Modify panel > Local Content rollout, click Reload.
- In a viewport, select an open Container you want to reload, then on the Tools menu, choose Containers > Local Content > Reload Container.

This refreshes the open Container to their most recently saved version. This is used to abandon changes to your Container without saving them, or to refresh copies of Containers.

To update a Container:

➤ Only Containers with inherited content can be updated. To update an inherited Container, do one of the following:

- In a viewport, select the Container you want to update, then on the Modify panel > Local Content rollout, click Update.
- In a viewport, select the Container you want to update, then from the Tools menu, choose Containers > Update.

This is used to abandon changes to your Container without saving them, or to refresh copies of Containers.

If this is the first time you are saving the Container, you are prompted to save the Container as a MAXC file on the Container Definition File dialog.
This updates the Container to its most recently-saved version.

**To inherit a Container:**

1. Do one of the following:
   - From the Tools menu, choose Containers > Inherit Container.
   - Open a Container Explorer on page 7428, Scene Explorer on page 7888, or Container Toolbar on page 7429, and click Inherit Container.

2. On the Inherit Container dialog, navigate to the MAXC file of the Container you want to inherit in your scene.

3. Click Open.
   - If the author of the Container has **provided edit permission** on page 7421 and you click Edit In Place, you can **edit its contents** on page 7420.

**To inherit the contents of a Container:**

1. In a viewport, select the Container to receive the inherited contents, then on the Modify panel > Manage Container rollout, click Inherit Content.

2. On the Inherit Content dialog, navigate to the MAXC file of the Container whose objects and display properties you want to inherit.

3. Click Open.
   - Any contents in the current Container is deleted and replaced with contents of the Container you selected to inherit.
   - If the author of the Container has provided permission and you click Edit In Place, you can **edit its contents** on page 7420.

**To edit an inherited Container:**

- You can edit an inherited Container only if the author has **provided edit permission** on page 7421.

  If edit permission has been granted, do one of the following:

  - In a viewport, select the Container you want to edit, then on the Modify panel > Manage Container rollout, click Edit In Place. Make your changes, then click Edit In Place again to save your work and close the Container.
In a viewport, select the Container you want to edit, then from the Tools menu, choose Containers > Edit Container. Make your changes, then click Edit Container again to save your work and close the Container.

Open a Container Explorer on page 7428, Scene Explorer on page 7888, or Container Toolbar on page 7429, select the Container you want to edit, and from the toolbar click Edit Container. Make your changes, then click Edit Container again to save your work and close the Container. Anyone who subsequently references the Container will inherit the changes.

To allow edits to a Container:

1. Select an open Container.
2. On the Modify panel > Local Content rollout > When Content Is Inherited group, turn on Allow Edit In Place.

The Container can now be edited by someone else. Anyone who subsequently references the Container will inherit the changes.

To make a Container unique:

➤ Do one of the following:

■ In a viewport, select the closed Container in your scene whose referenced contents you want to make unique, then on the Modify panel > Manage Container rollout, click Make All Content Unique.

■ In a viewport, select the closed Container in your scene whose referenced contents you want to make unique, then from the Tools menu, choose Containers > Make All Content Unique.

■ Open a Container Explorer on page 7428, Scene Explorer on page 7888, or Container Toolbar on page 7429, select the closed Container in your scene whose referenced contents you want to make unique, and from the toolbar click Make All Content Unique.

The Container helper object changes from closed to open and all its contents are loaded into the scene. The contents are no longer referenced.
from the MAXC file; any changes you now make to the Container contents are done locally.

**To merge a Container in your scene:**

➤ Do one of the following:

- In a viewport, select a closed Container that is inheriting contents from an externally referenced Source Container on page 8725, then on the Modify panel > Inherited Content rollout, click Merge Source Definition.

- In a viewport, select a closed Container that is inheriting contents from an externally referenced Source Container on page 8725, then from the Tools menu, choose Containers > Inherited Content > Merge Container Source.

- Open a Container Explorer on page 7428, Scene Explorer on page 7888, or Container Toolbar on page 7429, select a closed Container that is inheriting content from an externally-referenced source, and from the toolbar click Merge Container Source.

The Container is loaded with the most recent version of the Source Container on page 8725, and changes from closed to open. The Container is now local and any changes you make to the Container no longer affect the source.

**To override content display settings:**

➤ Do one of the following:

- In a viewport, select the Container whose object display properties you want to override, then on the Modify panel > Display rollout, click Override Obj Properties.

- In a viewport, select the Container whose object display properties you want to override, then from the Tools menu, choose Containers > Override Object Properties.

- Open a Container Explorer on page 7428, Scene Explorer on page 7888, or Container Toolbar on page 7429, select the Container whose object display properties you want to override, and from the toolbar click Override Object Properties.
The individual display properties of all objects in the selected Container, including display color, show/hide, and renderability, are overridden and replaced by the display properties set for the Container.

To delete a Container:

1. In a viewport or Explorer, select the Container you want to delete.
2. From the main menu, choose Edit > Delete.
   When you delete a Container, all its contents are deleted as well.

Container Commands

The 3ds Max interface provides Container commands from the Application menu, Command panel, Tools menu, floating toolbars, and Explorers.

Commands from the menus and toolbars are useful when working with more than one Container. Commands for a single, selected Container are activated from the Modify panel.

This topic summarizes each Container command group in the interface.

Application menu

- Application menu > References > Inherit Container command.
  This command inserts a Source Container into your scene. The scene now references the Container from its source file.

Command panel

- Select Container. > Modify panel.
  Rollouts provide all the controls you need to work with a selected Container. For a description of each command, refer to Interface on page 7424.

Container toolbar

- Right-click main toolbar. > Containers.
  Right-clicking an empty region of the main toolbar and choosing Containers opens a Container Toolbar with buttons that activate a number of Container commands.
Menu bar

Tools menu > Containers.

The Containers submenu on page 8001 displays commands that let you inherit Containers and edit selected Containers in your scene.

Container Explorer

Tools menu > Open Explorer: Container Explorer.

The Container Explorer on page 7428 is a customized version of the Scene Explorer on page 7888. It features a Container Toolbar on page 7429 that lets you inherit Containers and edit selected Containers in your scene.

Right-clicking anywhere in the table view opens a submenu of Container commands.

If the Container Explorer does not display in the Tools menu, do the following:

1. From the Tools menu, choose Manage Scene Explorer.
2. On the Manage Scene Explorer dialog, click Load.
3. On the Load Scene Explorer dialog, highlight the Autoload file folder and click Open.
4. Highlight the ContainerExplorer.ini file and click Open.

The Container Explorer now displays in the Tools menu.

Scene Explorer

Any new or saved Scene Explorer.

Right-clicking anywhere in the table view opens a submenu of Container commands.

To display a Container Toolbar on page 7429 in a regular Scene Explorer on page 7888, go to the Scene Explorer menu bar and choose Customize > Toolbars > Container.

Interface

This section describes each command in the Container Modify panel. Many of these commands are duplicated in the Scene Explorer on page 7888 and Container Explorer on page 7428 toolbars and submenus, as well as the Tools > Container submenu.

7424 | Chapter 21  Managing Scenes and Projects
Manage Container rollout

The Manage Container rollout lets you open, close, inherit, save, and update Containers in your scene, as well as set their editability. It also lets you convert a Source Container on page 8725 into a Unique Container on page 8752.

Inherit Content Loads the content of a MAXC Container file, including all its properties, into a selected Container. If content already exists in the inheriting Container, it will be deleted.

Unload/Load Displays as Unload when a Container is open and Load when a Container is closed.

Click Unload to save the Container and remove its contents from the scene.

Click Load to load the latest saved version of a Container into the scene and display its contents.

Close/Open Click Close to save the Container and prevent any edits or additions to its contents. (The Container itself can still be selected, translated, copied, and so on.)

When closed, the Container becomes a Source Container on page 8725. Its contents are saved to a MAXC file and referenced by the scene. Closed Containers can improve scene performance.

Click Open to edit Container content. This option is not available if Allow Edit In Place is turned off.

Auto Update When Closed Automatically updates closed Containers each time their source file is changed.

This option eliminates the need to press Update each time you need to view an up-to-date version of the Container.
**Update** Empties the selected Container and reloads contents from the Container’s source file into the scene. Any changes made to the source Container since its last update, including changes to edit permissions, are now present in the updated Container.

The Update option is not applicable for **Unique Containers** on page 8752.

**Make All Content Unique** Converts the selected Container, and all other Containers nested inside, to a **Unique Container** on page 8752 in your scene. Unique Containers can be edited and no longer reference a MAXC file.

**Edit In Place** Click to edit the contents of a Container originating from another user. Clicking Close or Edit In Place again will save your changes and close the Container. Anyone referencing the Container will inherit your edits.

**Local Content rollout**

The Local Content rollout lets you edit, refresh, and save Containers created locally from your workstation. It also lets you set edit permission so the Container can be modified by others.

This rollout is hidden if the Container is referenced from an external source.

**Add** Displays a pick list that lets you choose objects in the scene to add to your Container. To highlight list contents, use the mouse button, optionally in conjunction with Shift or Ctrl. Added contents remain visible in the viewports but are removed from the scene and added to the Container’s MAXC source file. If the Container is deleted from the scene, all objects within it are deleted from the scene as well.
**Remove** Displays a pick list that lets you choose objects to remove from the selected Container. Objects removed from the Container are added to the scene.

**Saved Local Definition**: Displays the MAXC file name of the most recent locally saved version of the Container.

**Save** If Allow Edit In Place is on, this saves any edits you make to an open Container.

**Save As** Saves the selected Container as a new MAXC file.

**Reload** Resets an open Container to its most recently saved version. Use Reload to refresh local copies of Containers that share definitions, or abandon recent changes.

**When Content Is Inherited group**

**Allow Edit In Place** Permits a user other than the Container's author to open and edit its contents.

**Inherited Content rollout**

The Inherited Content rollout identifies the path and name of the currently selected Source Container on page 8725 and lets you merge its contents into your scene.

This rollout is hidden if the Container was created locally.

![Inherited Content](image)

**Source Definition** Displays the path and name of the MAXC source file that the currently selected Container is referencing.

**Merge Source Definition** Loads the most recently saved version of the Source Container on page 8725 into the scene, but does not open and make available for edit any nested Containers that may be inside.
Display rollout: Container group

The Container group lets you set the display properties of the Container helper in your viewports.

Label When on, displays the name of the Container in the viewport.

Expand Bounding Box When on, a bounding box expands to encompass the contents of the currently-selected Container. When off, the bounding box encompasses only the selected Container helper object gizmo.

Icon Sets the size of the currently selected Container helper object gizmo.

Contents group

Override Obj Properties Click to ignore the display settings of individual objects in a Container, and instead use the display settings defined for the Container helper object.

If the Container display properties are controlled by layer, only objects in a Container which are part of other layers will obey the Container layer.

Container Explorer

Menu bar > Tools > Open Explorer: Container Explorer

The Container Explorer is a modeless dialog for viewing, sorting, and selecting Containers and their contents. It contains all the functionality of the Scene Explorer on page 7888, plus additional Container commands available from the Container Toolbar on page 7429.
The Container Explorer displays a default set of column headings that provide information on and the means to edit Containers and their contents. For a description of the column headings and how they can be edited, refer to Scene Explorer Columns on page 7896.

When working on a scene, you open the Container Explorer from the Tools menu > Open Explorer: Container Explorer command.

**Container Toolbar**

This toolbar is available from the Container Explorer, as well as from the Scene Explorer on page 7888 with the Customize > Tools > Container option active, and by right-clicking the main toolbar and choosing Containers.

- **Inherit Container** Loads a Source Container on page 8725 stored on disc into the scene.
  This command is also available from the Application Menu on page 7989 > References submenu.

- **Create Container From Selection** Creates a Container and places selected objects inside it.
Add Selected To Container Displays a pick list that lets you choose objects in the scene to add to your Container.

Remove Selected From Container Displays a pick list that lets you choose objects to remove from the selected Container.

Load Container Loads a Container into the scene and displays its contents.

Unload Container Saves the Container and removes its contents from the scene.

Open Container Makes a Container editable (if edit permission is given).

Close Container Saves the Container to disc and prevents any further edits or additions to its contents.

Save Container Saves any edits made to an open Container.

Update Container Empties the selected Container and reloads contents from the Container’s MAXC source file into the scene.
Reload Container  Resets a Local Container on page 8620 to its most recently-saved version.

Make All Content Unique  Takes the Container displayed in the Source Definition box and converts it, and any other Containers nested inside, to a Unique Container on page 8752.

Merge Container Source  Loads the most recently saved version of the Source Container on page 8725 into the scene, but does not open any nested Containers that may be inside.

Edit Container  Permits edits of a Container originating from another user (if permission given). Clicking Close or Edit Container again will save any changes and close the Container. Anyone referencing the Container will inherit the edits.

Override Object Properties  Ignores the display settings of individual objects in a Container, and uses the display settings of the Container helper object instead.
If the Container display properties are controlled by layer, only objects in a Container which are part of other layers will obey the Container layer.

**File-Handling Commands**

The main file-handling commands are on the Application menu on page 7989. Buttons for some of the most important appear on the Quick Access toolbar on page 7995, as well. These commands are for creating, opening, and saving scenes; importing and exporting other 3D file formats; exiting 3ds Max; and other operations.
New clears the contents of the current scene without changing system settings (viewport configuration, snap settings, Material Editor, background image, and so on). The New command also gives you the option, when you use it while a populated scene is active, to reuse objects from the current scene in the new one.

**Procedures**

To create a new scene:

1. Either click the New button, choose Application menu > New, or press Ctrl+N.
2. In the New Scene dialog, specify the types of objects to keep, if any.
3. Click OK.
Interface

NOTE If you use the Application menu, you can choose one of the new options directly from New > submenu.

The New Scene dialog has the following controls:

**Keep Objects and Hierarchy** Keeps the objects and the hierarchical links on page 8599 between them, but removes any animation keys on page 8616.

**NOTE** If the current scene has any file links, 3ds Max performs a Bind operation on all linked files.

**Keep Objects** Keeps the objects in the scene, but removes any links between them and any animation keys.

**WARNING** This option should not be used when working with a scene containing linked or imported objects.

**New All (Default)** Clears the contents of the current scene.

**Reset**

Application menu on page 7989 > Reset

Reset clears all data and resets 3ds Max settings (viewport configuration, snap settings, Material Editor, background image, and so on). Resetting restores the
startup defaults, saved in the file `maxstart.max`, and removes any customization you might have done during the current session.

Resetting has the same effect as exiting and restarting 3ds Max.

**TIP** To change the startup defaults, start 3ds Max and make the adjustments you would like to see at startup. Then save the file to your `scenes/` directory as `maxstart.max`.

### Procedures

If you have made changes since the last Save operation, a dialog prompts you whether you want to save your changes.

**To reset 3ds Max:**

1. Choose Application menu > Reset.
   
   If you have made any changes since the last Save operation, a dialog prompts you to save them. As further protection against data loss, a confirmation dialog appears.

2. When asked if you really want to reset, click Yes.
   
   Clicking No on this dialog cancels the Reset operation.

---

**Open**

- **Application menu** on page 7989 > Open
- **Quick Access toolbar** on page 7995 > Open button
- **Keyboard** > Ctrl+O

Open a scene file (MAX file), character file (CHR file), or VIZ Render file (DRF File on page 7650) from an Open File dialog. You can also choose a previously opened file and use **command-line options** on page 7985.

The MAX file type is a complete scene file.

A CHR file is a character file saved with Save Character. For more information on the CHR file format, see **Character Assembly** on page 254 and **Save Character** on page 279.
A DRF file is a scene file from VIZ Render, a rendering tool included with AutoCAD Architecture (formerly Autodesk Architectural Desktop). The DRF file type is similar to MAX files saved using Autodesk VIZ.

If the file you're loading was created using plug-ins that are not installed, a dialog lists them. You can still load the file, but any entities in the scene that were created by the missing plug-ins are replaced with stand-ins: non-rendering boxes or placeholder modifiers. You can safely delete these from the scene, unless you are sharing the scene with a user who has the plug-ins installed.

If the file you are loading contains bitmaps that cannot be located, a Missing External Files dialog on page 7612 appears. This dialog lets you browse for the missing maps, or continue opening the file without loading them.

Automatic Unit Conversion

When Respect System Units In Files is turned on in the System Unit Scale group of the System Unit Setup dialog on page 8366, loaded files that have a different scene unit scale display a File Load: Units Mismatch dialog on page 8372. This dialog lets you rescale the loaded scene to the current scene unit scale, or change the current scene unit scale to match the one in the loaded file. No conversion is done when loading files created in 3ds Max 1.x.

- If you choose to match the units in the loaded file, the System Unit Scale setting in the System Unit Setup dialog is changed to the setting in the scene file.
  This is the recommended choice, and it is the default in 3ds Max.
  For example, if the current system unit scale is set to 1 unit = 1 inch, and the incoming file was set to 1 unit = 1 foot, a sphere with a radius of 100 feet remains 100 feet.

- If you rescale the file objects, the objects are scaled as if they had been created using the current scene unit scale.
  For example, if the current system unit scale is set to 1 unit = 1 inch, and the incoming file was set to 1 unit = 1 foot, a sphere with a radius of 100 feet becomes 1200 inches in radius (assuming the unit display is set to generic units).

If Respect System Units In Files is off (which is not recommended), 3ds Max disregards the units chosen in the loaded scene file.

For example, a 100-unit radius sphere that was created in a 1 unit = 1 foot scene becomes a 100-inch sphere in a 1 unit = 1 inch scene.
Procedures

To reopen a previously opened file, do one of the following:

- Click Open File on the Quick Access toolbar on page 7995.

- On the Application menu > Recent Documents page on page 7992, click the file name.
  You set the number of files listed here by changing the Recent Files In File Menu on page 8305 field on the Files panel of the Customize > Preferences dialog.

- Choose Application menu > Open, then use the file dialog to choose the scene file.

To start 3ds Max and open a specific file:

- In a command prompt window, specify the file name after the executable name. For example:
  “c:\Program Files\Autodesk\Autodesk 3ds Max 2010\3dsmax.exe” myproject.max

To start 3ds Max and open the last file you worked on:

- In a command prompt window, type -L after the executable name:
  “c:\Program Files\Autodesk\Autodesk 3ds Max 2010\3dsmax.exe” –l
The Open File dialog has standard Windows file open controls. At the right, the Thumbnail area shows a preview of the scene whose file name is highlighted in the list on the left.

**TIP** You can resize the dialog by dragging an edge or a corner.

Clicking the plus button appends a sequence number to the file name you entered, or increments the sequence number if the name already has one, and then opens the file of that name, if it is present.

For example, if you have highlighted a file named `test00.max`, clicking the + button changes the name to `test01.max` and then opens that file.

**Opening an Obsolete File**

When opening a scene created in an earlier version of 3ds Max, you will see an Obsolete File dialog.
If you resave the scene, you will overwrite the file. You can still edit it using 3ds Max, but you will no longer be able to edit it in earlier versions of 3ds Max.

**Don’t display this message** When turned on, you will not see the Obsolete File dialog. The dialog is also controlled by the Display Obsolete File Message switch on the Customize > Preferences > Files panel.

**NOTE** If you still need to open the scene using an earlier version of 3ds Max, use File > Save As on page 7441 and save the file using a different name. Then you will be able to open the original file with the earlier version.

### Open from Vault

**Application menu** on page 7989 > Open > Open from Vault 2009 or Open from Vault 2010

The Open From Vault commands let you open a MAX file directly from Autodesk Vault, the data-management provider included with 3ds Max. This allows for secure control and versioning of assets used in the digital-content creation process without the need to use the Vault client. Choose the version of Vault that you used to store the scene.

**NOTE** Open From Vault appears on the Application menu only if you installed the Vault plug-in, an optional part of the 3ds Max software installation.

**See also:**

- Asset Tracking on page 7585
Procedures

To use Open From Vault:

1. Open the Application menu and choose Open > Open From Vault 2009 or Open From Vault 2010. Choose the version of Vault that you used to store the scene.

2. If you’re not logged in to a Vault provider, you’re asked to log in via the Vault Log In dialog on page 7591. Fill out the form and then click OK.

3. Use the Open File From Vault dialog to browse the vault and choose a MAX file to open.

4. At this point, one of two things happens:
   - If the file is available for checkout, a dialog opens letting you know that the file is under version control and asking you if you want to check it out before making edits. Click Yes.
   - If another user has the file checked out, a dialog opens notifying you of this and telling you that you won’t be able to save edits. Click OK to open the file in read-only mode. If you attempt to save this file, a dialog appears notifying you that the scene file is read-only and will not be overwritten.

5. If you attempt to open a different file or use the New or Reset command while the file is checked out, a dialog appears asking if you want to check the files back in. Enter a comment, if appropriate, and then click OK to check the file in.

   Alternatively, if you just want to create a new version on the provider, turn on Keep Checked Out and then click OK. A new version will be created, but the file will still be checked out to you.

Interface

NOTE If you haven’t set a working folder, the following dialog appears when you attempt to open a file from the vault:
After you click OK, the Browse For Folder dialog opens, which you can use to specify a working folder.

Save

Application menu on page 7989 > Save
Quick Access toolbar on page 7995 > Save button
Keyboard > Ctrl+S

Save updates the scene file by overwriting the previously saved version of the scene. If no scene was previously saved, this command works like Save As on page 7441.

See also:
■ Save As on page 7441
■ Save Copy As on page 7443

Saving to an Obsolete File

When you open a file that was created with an earlier version of 3ds Max, and then attempt to save it, 3ds Max opens a warning that you are about to overwrite the obsolete file.
Choose Yes to go ahead and overwrite the original file, No to stop the Save.
If you choose No, you can use Save As on page 7441 to save the file under a different name.

If you save to the original file name, you can still edit it using the current version of 3ds Max, but you will no longer be able to edit it in earlier versions of 3ds Max.

**Interface**

When you save a scene, you also save the 3ds Max settings. When you open the file again, it opens with the same viewport configuration, view and zoom levels, snap and grid settings, and so on.

You can incrementally number saved files, and make automatic backup files at specified time intervals. These options, Increment On Save and Backup On Save, are on the Files panel on page 8305 of the Preference Settings dialog.

**TIP** Another useful option on the Files panel is Compress On Save; when on, saved scene files are significantly smaller, which speeds transferring them by email and similar means.

---

**Save As**

_Application menu on page 7989 > Save > Save As_

Save As lets you save the current scene file in MAX or CHR format under a different file name.
A CHR file is a character file saved with Save Character. For more information on the CHR file format, see Character Assembly on page 254 and Save Character on page 279.

NOTE 3ds Max lets you number saved files incrementally and make automatic backup files at specified time intervals. The options to set up Increment On Save and Backup On Save are on the Files panel on page 8305 of the Preference Settings dialog.

See also:
- Save on page 7440
- Save Copy As on page 7443

Procedures

To save a file to a different name:

1. Choose Application menu > Save > Save As.
2. Do one of the following:
   - Enter a name in the File Name field.
   - Click the Increment button.

Interface

![Save File As dialog box](Image)
The Save File As dialog has standard Windows file save controls. At the right, the Thumbnail area shows a preview of the scene whose file name is highlighted in the list on the left.

**TIP** You can resize the dialog by dragging an edge or a corner.

+ Clicking the plus button appends a sequence number to the file name you entered, or increments the sequence number if the name already has one, and then saves the file to that name.

For example, if you have highlighted a file named `test00.max`, clicking the plus button changes the name to `test01.max` and then saves `test01.max`.

**Save Copy As**

**Application menu** on page 7989 > Save > Save Copy As

Save Copy As allows you to save a copy of the current scene under a different file name. It does not change the name of the file being worked on.

**WARNING** Save Copy As does not update the original file name as Save does, and Save does not update the file you last saved using Saved Copy As. For example, if you make edits to a 3ds Max scene named `filename.max`, then use Save Copy As with the file name `filename01.max`, make additional edits, and then click Save, your second set of edits will be saved as `filename.max` but not as `filename01.max`.

See also:

- Save on page 7440
- Save As on page 7441
- Auto Backup on page 8305

**Procedures**

To save a copy of the file to a different name:

1. Choose Application menu > Save Copy As.
2. Browse or type the name of the file you want to create or update.
3. Click the Save button.
Interface

Save Copy As displays a standard Windows save dialog. Save Copy As increments the number at the end of the file name in order to propose unique but similarly-named files each time the command is used.

Clicking the Save button saves the file to the name displayed in the File Name text box.

**TIP** You can resize the dialog by dragging an edge or a corner.

Clicking the plus button saves the file with a name ending in a number one increment greater than that displayed in the File Name text box.

Save Selected

**Application menu** on page 7989 > Save > Save Selected

Save Selected saves the selected geometry as a scene file under a different file name.

Identically named bitmaps with different properties are stored as different files. Objects linked to a selected object are also saved. The following dependencies are preserved for a Save Selected operation:

- Ancestors of selected child objects are saved, all the way to the root of the hierarchy.
- Space Warps to which selected objects are bound are saved.
- IK follow objects to which selected objects are bound are saved.

**Procedures**

**To save selected objects to a new file:**

1. Select one or more objects.
2. Choose Application menu > Save > Save Selected.
3. Enter a name in the File Name field.
4. Click Save.

**Archive**

**Application menu** on page 7989 > Save > Archive

Archive creates a compressed archive file or a text file listing the scene bitmaps and their path names.

3ds Max automatically finds the files referenced in the scene and creates the archive file in the executables folder. During the archiving process, a log window is displayed.

Compressed archive files are created using an external program. You specify the name and location of the **archive program** on page 8305 you want to use in the Files tab of the Preferences dialog.

**Procedures**

**To set up an external archive program:**

1. Choose Customize > Preferences.
2. Click the Files tab to display the Files panel.
3. In the Archive System group, enter the full path and executable file name, and any command-line option you want for your external archive program in the Program field.
To archive a file:

1. Choose Application menu > Save > Archive.

2. Enter a name for the archive in the File Name field. Include the appropriate file extension (for example .zip).

3. Choose a file type: 3ds Max Archive or List Of Files.
   - To create an archive file, choose 3ds Max Archive in the Save As Type list. The archive file contains the scene plus all bitmaps used for the scene, including Video Post bitmaps.
   - To create a text file, choose List Of Files (*.txt) in the Save As Type list. The resulting file is an ASCII list of scene files.

Import

Application menu on page 7989 > Import

Import loads or merges geometry files that are not 3ds Max scene files. See the following procedure for a complete list of file types you can import.

Procedures

To import a file:

1. Choose Application menu > Import.

2. Choose an import file type from the Files Of Type list in the file selector dialog. To see more than one file type at a time, choose the All Files file type.
   - Autodesk (FBX) on page 7706
   - 3D Studio Mesh (3DS, PRJ) on page 7655
   - Adobe Illustrator (AI) on page 7662
   - Autodesk Collada (DAE) on page 7706
   - LandXML /DEM /DDF (DEM, XML, DDF) on page 7753
   - AutoCAD Drawing (DWG) on page 7666
   - Legacy AutoCAD (DWG) on page 7685
3 Choose a file to import.

4 For some file types, a second dialog appears, with options specific to that file type. Choose the import options you want.

External References (XRefs)

You can use two kinds of externally referenced files (XRefs): XRef Objects on page 7450 and XRef Scenes on page 7477. Using these external references allows for a team approach to animation, where the modeling, materials, transform controllers, and animation can be handled in separate files by different artists. It can also make large files much easier to deal with through the use of proxy objects.

You access the XRef Objects and XRef Scenes commands from the Application menu on page 7989.
The two types of references have distinct purposes:

- An externally referenced scene displays the entire contents of an external MAX file in the current scene. The objects within the external file are visible as a reference but cannot be selected. This prevents accidental changes to the referenced scene while allowing functionality such as Snap, AutoGrid, and Clone and Align to position local objects in context, as well as to pick objects as the target location for the clones. If you need to move, rotate or scale the referenced scene, you can bind it to a local object. Transforming the object the externally referenced scene was bound to will transform all objects in the externally referenced scene. Scene externally referenced objects can also be used as reference coordinate system on page 922. When changes to the externally referenced file are saved (such as objects added, edited or deleted), an Update of Xref Scene will inherit those changes locally.

- Externally referenced objects appear in the scene and can be animated. Depending on the object's XRef settings, you might or might not be able to edit the object's entities such as its transforms, materials, manipulators, or modifiers. You can add modifiers and apply transform animation to the referenced objects, but you cannot inadvertently change the model's structure. Referenced objects allow for the substitution of a proxy object, so you can animate a low-polygon version of a complex model and then render the polygon-intensive version. You can also reference transform controllers externally in addition to materials. This is part of the process of referencing objects, or you can also use the special XRef controller on page 3570 or XRef material on page 6183, respectively. By default, when referencing an object, its material and transform controller is also referenced. Alternatively, you can create an XRef controller or an XRef material that allows for referencing a transform controller or a material from an external MAX file. These external references can be assigned to any object in the scene, whether or not the object is externally referenced.

NOTE Any atmospherics applied in an XRef object's source file will be carried into the scene. Render Effects assigned to XRef objects are not externally referenced.

The use of referenced objects and scenes allows several people to work collaboratively on the same objects as the work progresses, without having to wait for the objects to be finalized. You can choose to have the objects update automatically, as soon as changes are saved to the original file, or to update manually, on demand.
There are also tools for easy conversion of scene objects into referenced objects, and a button to merge referenced objects into the scene as normal objects.

Objects in a scene can be externally referenced, created and maintained by other users.

**Missing XRef Paths Dialog**

_Aplication menu_ on page 7989 > Open > Open a file that references missing files.

If you load or render a scene with XRefs, but the originally specified path of the XRef object or scene can’t be found, or if the XRef object name doesn’t match the object name in the source file, an alert appears telling you this.
alert works in the same way as the missing bitmap dialog, and provides you with two options, described below.

**Interface**

![Missing XRefs dialog](image)

**OK** Lets you open the file. The referenced scene will have placeholders, but will not exist in the scene.

**Browse** Displays the Configure XRefs Paths dialog which you can use to specify the correct file path. This lets you modify, delete, add, and change the list position of the paths 3ds Max uses to look for missing files.

This panel is similar to the one displayed by choosing Customize > Configure User Paths > XRefs on page 8292.

If this problem occurs during network rendering, the dialog doesn’t appear, but the errors are written to the network log file.

**XRef Objects**

**Application menu** on page 7989 > References > XRef Objects

Externally referenced objects, *XRef objects*, appear in your master (current) scene, but are actually referenced from external 3ds Max files. As a result, the *source* objects are protected from modifications you make to the XRef objects. Updates or changes made to the *source* objects are also updated in the master file when the source scene is reloaded. However, if an XRef object’s entities are merged, the controls are local and can be modified. Therefore, they no longer reference the original attributes.
For example, if you set the Modifiers option on page 7462 of the XRef Objects dialog on page 7456 to XRef or Ignore, the only entry in the modifier stack will be “XRef Object.” You can add additional modifiers to the object, but you cannot access the original ones unless you merge the XRef object into the scene. If you merge the modifiers into the master scene, you can edit them in the stack. However, changes that you make to the modifier stack in the master file have no effect in the source file.

An externally referenced object can be animated in the master file only if its transform controller has been merged. In other words, no animation can be added or blended with an XRef controller. However, an offset can be added, but it then applies to the whole animation, and the offset cannot be animated.

NOTE The XRef behavior of world-space modifiers is different than the object-space modifiers. World-space modifiers are not externally referenced. They are always merged.

Transforms and manipulators in your source file will be treated according to the Merge Transforms and Merge Manipulators setting in the XRef Objects dialog.
Objects in a scene can be XRefs from other scenes. They can be transformed and positioned in the scene using a local offset.

When an XRef object is loaded into the master file, it can have an XRef material on page 6183 as well as an XRef controller on page 3570 assigned to it. You can either merge the material and transform information or you can maintain it as a live connection with the source file.

XRef objects can be modified or transformed in your master scene just like any other object. XRef objects also allow the use of proxy objects to stand in or substitute for geometry. Use XRef objects to manage the complexity of your master scene during animation by substituting “lightweight” proxy objects for more complex geometry.

You can create a proxy by simplifying a clone of your existing model or you can build simple substitute objects like boxes or cylinders, or you can save a
copy of the model in the early stages of modeling before you add the detail. 
You can even use an object from another scene.

A proxy object is substituted in the scene, but the reference to the real object is always available.

Choosing XRef Objects displays the XRef Objects dialog on page 7456, where you add externally referenced objects, transforms, and materials to your master scene, and control their visibility, merge states, and other options.

If your XRef object relies on another object in the source scene, the relationship will not be automatically preserved in the destination file. Examples of this include objects with path constraints, atmospherics, particle arrays with object emitters, or space warps bound to an object. To preserve the relationship between the source objects in the master file, in the XRef Merge dialog, enable Display Influences and select the object’s influences. Objects that influence each other must be referenced in the same record to maintain the relationship.

NOTE Render effects such as glow or flare are not carried in XRefs. To use render effects from the source file, merge them in using the Merge buttons found in the Environment And Effects dialog.
Procedures

To add an XRef object:

1. Choose Application menu on page 7989 Import > XRef Objects.
   The XRef Objects dialog enables you to choose to Merge Transforms, Merge Materials, and Merge Manipulators.

   **NOTE** If you want to maintain externally referenced entities (transforms, materials, manipulators, or modifiers), make sure Merge Transforms, Merge Materials, and Merge Manipulators are off and the Modifiers setting is set to XRef before you proceed to the next step.

   **TIP** To include all objects, including influences, transforms, and materials, and bypass the XRef Merge dialog, turn on Include All on the XRef Objects dialog before you click Create XRef Record From File.

2. Click the Create XRef Record From File button in the XRef Objects dialog. The Open File dialog appears. Choose the file you want by highlighting it in the list, then click Open. The XRef Merge Dialog on page 7471 appears.
   If the Merge Manipulators toggle is off before you click Create XRef Record From File, manipulators applied to XRef objects are linked to the (externally referenced) source file. In a similar way, the Modifiers drop-down list gives you three alternatives for how to handle object modifiers.
   If the Merge Materials toggle is off before you click Create XRef Record From File, materials applied to XRef objects are linked to the (externally referenced) source file. If Merge Materials is on, the materials are merged with the master scene.
   If the Merge Transforms toggle is off before you click Create XRef Record From File, transforms applied to XRef objects are linked to the (externally referenced) source file and cannot be keyframed in the master file. If Merge Transforms is on, the transforms are merged with the master scene and can be keyframed.

3. Select the objects that you’d like to appear in your master scene as XRef objects.
   You can choose as many as you want by holding down the Ctrl key and highlighting them in the list. If the source scene has a lot of object types you don’t need to include, you can filter the list by using the List Types
radio buttons. Use the All button to select all of the entries, the None button to select no entries and the Invert button to highlight the opposite of your current selection. You can also choose to display Influences and Select Influences.

4 The XRef record appears in the upper list of the XRef Objects dialog and has the same name as its source file. The externally referenced entities appear in the lower list, where an entity can be either an object, a controller, or a material. Make additional choices at this time if you like. You can control how the objects will update (either automatically or on demand). Updating is done at the XRef record level: all objects, transforms, and materials from a single XRef record are updated at the same time.

**To substitute an XRef object with a proxy object:**

With proxy objects, you can avoid loading your detailed model in memory, and speed up the time of test renderings.

1 Select an XRef object.

2 On the Modify panel > Proxy rollout, click the Browse button, and use the File Open dialog to choose the file that contains the proxy. The XRef Merge dialog appears.

3 Pick the object to use as a proxy.

   When you have picked the proxy object, the Enable toggle should turn on.

4 Turn on Use In Rendering to use the proxy object in renderings.

**To add objects to an XRef record:**

1 In the XRef Objects dialog, highlight an XRef record (in the top list) that contains objects that have not already been added to the scene.

2 On the Entities List toolbar (the lower toolbar), click Add Objects. This button is not available if all of the objects in the source file have already been added to the XRef record. The XRef Merge dialog appears.

3 Highlight the objects that you want to add as XRefs, and then click OK.
The selected objects are added. Depending on the dialog settings, transforms and materials might also be added as external references.

To change an XRef object into a scene object:

Highlight the XRef object in the Entities list (the lower list), and then click Merge In Scene. The XRef object becomes a full-fledged object in the scene, giving you access to its modifier stack.

**TIP** This button is also available in the upper Records list, where it merges **all** entities from the highlighted source record into the master (current) scene.

---

**XRef Objects Dialog**

*Application menu* on page 7989 > References > XRef Objects > XRef Objects dialog

The XRef Objects dialog provides the interface for loading XRef entities into your master scene (the scene where you create the XRefs) from a source scene (the scene file that contains the entities that you want to externally reference). XRef entities can be XRef objects, transform controllers, materials, and manipulators. An XRef record can be made up of one or more XRef entities.

The XRef Objects dialog is divided into the XRef Record section at the top and the XRef Entities section at the bottom. The XRef Objects dialog provides controls to add and remove XRef objects, controllers, and materials.

When you create XRefs, the mapping between each externally referenced item and their source items is unique. This allows correct external referencing of source items with identical node names. However, if you retarget an externally referenced item by choosing a source object name that is not unique in the source scene, 3ds Max might not map the externally referenced item to the desired source object.
Interface

TIP You can resize the XRef Objects dialog. This can be useful if you want to see all of the columns in the XRef Entities list. You can also adjust the relative height of the two lists in the dialog: Drag the horizontal line that is just above the XRef Entities toolbar (the lower of the two toolbars).

XRef Record toolbar

Use these tools to create and update XRef records.

- **Create XRef Record from File** Launches an Open File dialog so you can select the source file for your XRef record. When you select a file, the XRef Merge dialog on page 7471 appears.

  Any transform animation assigned to the source objects can be merged along with the XRef object, but it will not be updated with the source object.

  NOTE If you want to maintain externally referenced transforms, materials, and manipulators, make sure Merge Transforms, Merge Materials, and Merge Manipulators in the XRef Objects dialog are off before you click Create XRef Record from File.
Remove XRef Record  Deletes the highlighted XRef record(s) after you confirm the action. All entities associated with the highlighted record(s) are removed from the scene.

NOTE Once you have removed an XRef record, you cannot undo this action.

Combine XRef Records  Click to combine the contents of more than one XRef record from the same source file into one record. This is useful when you want to clean up the organization of your XRef records. Rather than having multiple records of the same file, you can group all of the objects, controllers, and materials from that file under the same record. This button is available only when you highlight two records that refer to the same file name and path; both records must have identical settings. XRef records must refer to the same file with the same XRef entities. Combine XRef Records only allows you to consolidate all of the entities of one file into one XRef record entry. It does not allow you to combine the contents of different files, even if the files have the same name.

NOTE Nested externally referenced records cannot be combined.

Update  Refreshes the contents of the selected XRef record. If the objects, controllers, materials, or manipulators referenced have changed in the source scene, you will see these changes in your master scene.

NOTE The changes must be saved in the source file before you see them in the master file. If you remove externally referenced entities from the master file using the Delete XRef Entity button, these entities will not be externally referenced when you update the XRef record, even though they continue to exist in the source scene.

NOTE Reloading XRef items works correctly even when an object in the source scene has been renamed, or deleted and then re-created with the exact same name, including character case. However, if the source scene contains several nodes with the same name, an XRef item corresponding to a node whose name is not unique in the source scene might not necessarily resolve as you expect during the update process. For best results, maintain unique names for all nodes in the source scene.
WARNING If you update an XRef in a scene with radiosity on page 6615, probably this will invalidate the radiosity solution. After you update the XRef, reset the radiosity solution and then recalculate it.

**Merge In Scene** Converts all XRef entities of the highlighted record into native (local) entities in your master scene. The objects, controllers, materials, and manipulators are no longer referenced from the source file but become part of your master scene. A prompt appears so you can confirm the action. Since a merged XRef entity becomes part of the scene and is no longer an XRef entity, its name is removed from the XRef Entities list. This works on a XRef record basis, so all entities belonging to the highlighted XRef record are converted. The contents of the source file are not affected by this button. Merging an XRef object loads the full modifier stack of the source object into the master scene (your current scene), while maintaining any additional stack items that were added while the object was an external reference. Thus, you can use Merge In Scene to update an object that has been modified as an external reference. Similarly, merging an XRef controller into the master scene maintains any offset transformation you might have applied to the controller in the master scene.

**Convert Selected Object(s) to XRefs** Creates a source file for currently selected objects. This means that you can select objects in the current scene, including their transform controllers and materials, and then save them to a separate scene file. This file is then listed as an XRef record that contains the entities you selected.

**NOTE** This option can be used on both—native (local) objects or externally referenced objects. If you use it for an object that is already an XRef object, it creates a nested XRef. Nested XRefs still behave as you expect, but they can reduce performance when you open a scene or render it.

**Select** Selects all entities that belong to the currently highlighted XRef record or records. To add highlighted records’ entities to the selection, hold Ctrl while clicking Select. To remove highlighted records’ entities from the selection, hold Alt while clicking Select.

**Select by Name** Opens the Select Objects dialog on page 206, which lists all objects and highlights those belonging to the currently highlighted
XRef record, as well as objects selected in the scene. Use this dialog to select XRef objects.

**Highlight Selected Objects' XRef Records** Based on the object(s) selected in the scene, the corresponding record(s) that contain these objects are highlighted in the XRef Objects dialog.

**XRef Record list**

Displays the names of the source files that contain the source objects used as XRef objects in the current scene. These files are added using the Create XRef Record button and removed using the Remove XRef Record button.

To see the full path of the source file, move the cursor over the name of an XRef record. The full path is displayed in a tool tip.

If a source file itself contains external references, a plus/minus icon appears to the left of its name. Click the icon to expand or collapse the display of nested XRef entries. Nested XRef records that are missing and unresolved are displayed in gray.

Right-clicking the XRef Record list displays a pop-up menu on page 7466 that has additional options for managing the list and its records.

---

**Enabled** Turn off to disable all XRef objects referenced from the MAX files currently highlighted in the XRef Record list. Disabled external reference files and objects are not loaded into memory. Default=on.

**Include All** If you turn this on before you add an XRef record, all the objects in the source file are included as external references. This option bypasses the XRef Merge dialog. Default=off.

If you create an XRef record when Include All is turned off, only those entities selected for that XRef record (in the XRef Merge dialog) will be a part of the record: any new objects created in the source file will not be part of the record.

If Include All is turned on when you create a record, any new objects created in the source file will be included in the XRef record when you reopen or Update the master file. If Include All is turned on before a record is updated (after the first XRef), all new objects will be included in the XRef, but turning if off later will not remove them from the record.

If the source scene includes nested external references, using Include All can cause some confusion if you are not careful about your tree of scenes. Consider the following arrangement:
master.max (Include All) --> a.max (Include All) --> b.max

If you later open b.max, create objects, and save it, then open master.max without first opening and saving a.max, you won’t see the new objects created in b.max. The scene master.max is simply reading a.max, and since a.max hasn’t changed, the new objects aren’t present.

Automatic Update When on, changes made to externally referenced objects, controllers, materials, and manipulators in the source scene are automatically updated in the master file as soon as the source file is saved. There's no need to click Update. Default=off.

NOTE You can change the state of Enabled, Include All, and Automatic Update after a record is created.

Merge Transforms When on, combines all objects' externally referenced transform controllers from the source file into the master file. This means that the transform controllers will be loaded in the master file but will then no longer have a live connection with the source file. This is useful if you don't require the live connection, and want to alter the transform controllers in the master scene without losing your edits upon Update. Default=off.

To use Merge Transforms, you must turn on this option before you add the XRef record (source) file.

Merge Materials When on, combines all externally referenced materials from the source file into the master file. This means that the materials will be loaded in the master file but will then no longer have a live connection with the source file. This is useful if you don't require the live connection, and want to alter the materials in the master scene without losing your edits upon Update. Default=off.

To use Merge Materials, you must turn on this option before you add the XRef record (source) file.

When Merge Materials is on and there are name conflicts between materials in the target scene and materials in the XRef source scene (or between materials in two XRef records), 3ds Max displays a Duplicate Name dialog on page 5713 so you can resolve the conflicts.

Merge Manipulators When on, any manipulator on page 2861 applied to the XRef object in the source file is combined into the scene. Manipulators are applied to the XRef object and can be changed. However, these changes have no effect in the XRef source file. Default=off.

To use Merge Manipulators, you must turn on this option before you add the XRef record (source) file.
Modifiers

Determines how modifiers from the source file will be loaded into your master file. Modifiers are not listed as XRef entities. To see an XRef modifier on the Modify panel, you must use the Merge option. Otherwise, you have the choice of either not merging the modifier information at all (with the Ignore option) or merging the information with the object with the XRef Modifiers option.

You must choose the Modifiers option before you add the XRef record (source) file.

- **XRef**  
  Modifiers are contained within the XRef object and cannot be changed in the master scene. When you load the external reference file, you will see the results of the modifier but they will not be listed separately from the object on the Modify panel. Additional modifiers can be applied to the XRef object, and will be a part of the scene; however, they will not be reflected back to the source file.

  **NOTE**  
  World-space modifiers remain at the top of the modifier stack and are not merged with XRef objects.

- **Merge**  
  Modifiers assigned to the XRef object (in the source file) are merged into the master scene. When you load the external reference file, you will see the changes caused by the modifier and they will appear in the modifier stack on the Modify panel. The modifiers are copies of the original source modifiers. Although they inherit their original state, updates to the XRef will not overwrite changes made in the master scene. However, these changes are not reflected in the source file.

- **Ignore**  
  Any modifiers assigned to the XRef object (in the source file) are disregarded and the base object is brought into the master scene as an XRef object. When you load the external reference file, the modifiers are not applied to the object so the modifications in the source file will not be reflected in the master file.

Although the Merge Transforms, Merge Materials, Merge Manipulators, and Modifiers settings are disabled after you add a record, when you highlight the record in the XRef Record list, the toggles and list field show the settings used when the record was created.

**XRef Entities toolbar**

- **Add Objects**  
  Click to add further entities to the highlighted XRef record. This button is available only when the highlighted XRef record contains...
objects that you have not yet referenced externally. The XRef Merge dialog appears, with a list of the available objects. Highlight the objects to reference externally, and then click OK.

**NOTE** If new objects have a relationship in the source file with objects that are already in a record in the master file, update the record after Add Objects to refresh the relationship. For example, if a car is referenced in a master scene, and the car is later constrained to a new path in the source scene, adding the path with Add Objects will not put the master car on the path. To do that, update the record.

**Delete XRef Entity** Click to delete the highlighted XRef. An alert prompts you to confirm the action. All highlighted entities are removed from the scene. You can delete XRef objects, controllers, or materials.

**NOTE** Deleting XRef controllers is equivalent to merging them into the master scene. The reason for this is that nodes must have a transform controller at all times, in order to be positioned in the scene. Deleting XRef materials is equivalent to merging them into the master scene. This action could impact all objects in the master scene that use an XRef material, and could have implications difficult to be foreseen.

**Merge In Scene** Merges the current selection in the XRef Entities list into the master scene (the current scene). Use this button to change XRef objects, controllers, or materials into objects, controllers, or materials that are native to the current scene. The connection between the external entity from the source scene and your master scene is broken, and the object, controller, or material that you merged is no longer updated when the source scene changes.

Since a merged XRef object becomes part of the scene and is no longer an XRef object, its name is removed from the list.

Merging an XRef object loads the full modifier stack of the original object, while maintaining any additional stack items that were added while the object was an XRef object. Thus, you can use Merge to update an original object that has been altered as an external reference. If you do this, use Convert Selected Object(s) to XRefs to save out the “improved” original into a file, which then can be merged back into the original source.
NOTE It is also possible to merge into the master scene nested XRef entities. Once they are merged, all externally referenced nesting levels are removed and the scene entity from the lowest level source scene is merged into the master scene. In case of XRef objects, modifiers applied in a nested source file are all merged and present in the master scene.

**List Objects** When on, shows the XRef objects for the current XRef record in the XRef Entities list.

**List Materials** When on, shows the XRef materials for the current XRef record in the XRef Entities list.

**List Controllers** When on, shows the XRef controllers for the current XRef record in the XRef Entities list.

NOTE You can enable any combination of the List buttons to show certain types of entities and hide others.

**Select** Selects in the scene the XRef entities currently highlighted in the XRef Entities list. To add highlighted entities to the selection, hold Ctrl while clicking Select. To remove highlighted entities from the selection, hold Alt while clicking Select.

**Select by Name** Opens the Select Objects dialog on page 206, which lists all objects and highlights the XRef objects selected in the XRef Entities list, as well as any objects selected in the scene. If an XRef controller or XRef material is highlighted in the XRef Entities list, the Select Objects dialog highlights the object to which the XRef controller or material belongs to.

**Highlight Selected Object’s XRef Records** When XRef objects are selected in the scene, the XRef record to which they belong is highlighted in the XRef Record list and the XRef objects and their XRef entities are highlighted in the XRef Entities list.
XRef Entities list

Displays the XRef objects, controllers, and materials that belong to the record that is currently highlighted in the XRef Record list. If no source file is highlighted, this list is empty.

Right-clicking the XRef Entities list displays a pop-up menu on page 7469 that has additional options for managing the list as well as the objects, controllers, and materials in it.

The XRef Entities list includes the following information for each XRef entity:

- **Scene Name**  Name of the entity in the master (current) scene. By default, the name of the entity in the master scene is the same as the name of the entity in the source file. If you change the name of the entity on the command panel on page 8182, the name will update in the XRef Entities list.

- **Source Name**  Name of the entity in the source file. You cannot change this name from the master file. If the name of the entity changes in the source file, the XRef in the master file will become unresolved.

- **Type**  Whether the entity is an XRef object, controller, or material.

- **Status**  Usually this field displays “XRef Resolved” to indicate that the XRef is valid. When an external reference is unresolved this field displays “Unresolved XRef.” An unresolved XRef indicates that there is no longer a connection between the entity in your master file and the source file. This can happen for a number of reasons. For example, the entity in the source file might have been renamed or deleted, or the file cannot be found.

  **NOTE**  If you resolve the cross reference, the XRef will be resolved again when you click Update.

- **Proxy**  Whether a proxy is enabled for the entity. You enable and disable proxies for XRef entities on the Proxy Object rollout. Displays “—” when the proxy is disabled and “Enabled” when the proxy is enabled. You can assign a proxy object using the Proxy Object rollout on page 7475.

- **Proxy Render**  Whether the proxy will be used in the rendering. Displays “—” when the XRef object will be rendered and “Enabled” when the proxy object will be rendered.

- **Proxy Name**  Name of the proxy object that will be used as the XRef object.
Proxy File Name  Name of the file that contains the proxy object to use for the XRef object.

Proxy Path  Path of the file for the proxy object to use for the XRef object.

XRef Record List Right-Click Menu

Application menu on page 7989 > References > XRef Objects > XRef Objects dialog > Right-click the list of XRef Record list.

This contextual menu appears in the XRef Objects dialog on page 7456 when you right-click the XRef Record list. It provides additional options for managing the list.

Some of the options on this menu are unavailable unless you have highlighted an XRef record.

Interface

Create XRef Record from File  Launches an Open File dialog so you can select the source file for your XRef record. When you a select a file, the XRef Merge dialog on page 7471 appears.

Any transform animation assigned to the source objects can be merged along with the XRef object, but it will not be updated with the source object.

NOTE  If you want to maintain externally referenced transforms, materials, and manipulators, make sure Merge Transforms, Merge Materials, and Merge Manipulators in the XRef Objects dialog are off before you click Create XRef Record from File.

Remove XRef Record  Deletes the highlighted XRef record(s) after you confirm the action. All entities associated with the highlighted record(s) are removed from the scene.

NOTE  Once you have removed an XRef record, you cannot undo this action.

File Submenu

Open  Opens the source file. If you have not saved changes to the (current) master file, 3ds Max prompts you to do so.
Browse Displays the Open File dialog that enables you to browse for a new source file. The file you choose replaces the highlighted XRef record in the XRef Objects dialog. Available only when a single file is highlighted.

Reveal Location in Explorer Launches Windows Explorer, open to the folder in which the highlighted source file resides with the source file highlighted. Available only when a single file is highlighted.

Strip Path Removes path information from the file name, saving only the file name. The source file location is saved relative to the master file location.

WARNING If you strip the path before you have saved the master file, the record's XRefs can become unresolved. This is because there is no location for the Untitled, unsaved MAX scene.

Resolve Path to UNC Location If the record's file name has had its path stripped, this option restores the full path name.

Combine XRef Records Click to combine the contents of more than one XRef record from the same source file into one record. This is useful when you want to clean up the organization of your XRef records. Rather than having multiple records of the same file, you can group all of the objects, controllers, and materials from that file under the same record. This option is available only when you highlight two records that refer to the same file name and path; both records must have identical settings. XRef records must refer to the same file with the same XRef entities. Combine XRef Records only allows you to consolidate all of the entities of one file into one XRef record entry. It does not allow you to combine the contents of different files, even if the files have the same name.

NOTE Nested externally referenced records cannot be combined.

Update Refreshes the contents of the selected XRef record. If the objects, controllers, materials, or manipulators referenced have changed in the source scene, you will see these changes in your master scene.

NOTE The changes must be saved in the source file before you see them in the master file. If you remove externally referenced entities from the master file using the Delete XRef Entity button, these entities will not be externally referenced when you update the XRef record, even though they continue to exist in the source scene.
WARNING  If you update an XRef in a scene with radiosity on page 6615, probably this will invalidate the radiosity solution. After you update the XRef, reset the radiosity solution and then recalculate it.

---

Select  Selects the entities that belong to the currently highlighted XRef record.

Select by Name  Opens the Select Objects dialog on page 206, which lists all objects and highlights those belonging to the currently highlighted XRef record. Use this dialog to select XRef objects.

---

Highlight Selected Objects’ XRefs Records  Based on the object(s) selected in the scene, the corresponding record(s) that contain these objects are highlighted in the XRef Objects dialog on page 7456.

---

Highlight All  Highlights all XRef records in the XRef Record list.

Highlight Inverse  Highlights all XRef records in the XRef Record list except the currently highlighted record(s).

Highlight None  Turns off highlighting for any XRef records currently highlighted in the XRef Records list.

Hide All Unresolved  Hides all unresolved XRef records in the XRef Record list.

Select All Unresolved  Highlights all unresolved XRef records in the XRef Record list.

---

Merge In Scene  Converts all XRef entities of the highlighted record into native (local) entities in your master scene. The objects, controllers, materials, and manipulators are no longer referenced from the source file but become part of your master scene. A prompt appears so you can confirm the action. Since a merged XRef entity becomes part of the scene and is no longer an XRef entity, its name is removed from the XRef Entities list. This works on a XRef record basis, so all entities belonging to the highlighted XRef record are converted. The contents of the source file are not affected by this option.
Merging an XRef object loads the full modifier stack of the original object into the master scene (your current scene), while maintaining any additional stack items that were added while the object was an external reference. Thus, you can use Merge In Scene to update an object that has been modified as an external reference. Similarly, merging an XRef controller into the master scene maintains any offset transformation you might have applied to the controller in the master scene.

**Convert Selected Object(s) to XRefs** Creates a source file for the currently selected objects. This means that you can select objects in the current scene, including their transform controllers and materials, and then save them to a separate scene file. This file is then listed as an XRef record that contains the entities you selected.

**NOTE** This option can be used on both-native (local) objects or externally referenced objects. If you use it for an object that is already an XRef object, it creates a nested XRef. Nested XRefs still behave as you expect, but they can reduce performance when you open a scene or render it.

**XRef Entities List Right-Click Menu**

(Application menu on page 7989 > References > XRef Objects > XRef Objects dialog > Right-click the list of XRef entities (objects and materials).

This contextual menu appears in the XRef Objects dialog on page 7456 when you right-click the XRef Entities list. It provides additional options for managing the list.

Some of the options on this menu are unavailable unless you have highlighted an XRef entity.

**Interface**

**Add Objects** Displays the XRef Merge dialog on page 7471 so you can add entities to the XRef Entities list.

If all entities in the source scene are already externally referenced, this choice has no effect.

**Delete XRef Entity** Deletes the highlighted XRef entities from the scene.

An alert prompts you to confirm the action.
NOTE Deleting XRef controllers is equivalent to merging them into the master scene. The reason for this is that nodes must have a transform controller at all times, in order to be positioned in the scene. Deleting XRef materials is equivalent to merging them into the master scene. This action could impact all objects in the master scene that use an XRef material, and could have implications difficult to be foreseen.

Select Selects in the scene the XRef entities currently highlighted in the XRef Entities list.

Select by Name Opens the Select Objects dialog on page 206, which lists all objects and highlights the XRef objects selected in the XRef Entities list. If an XRef controller or XRef material is selected in the XRef Entities list, the Select Objects dialog highlights the object to which the XRef controller or material belongs to.

Highlight Selected Objects’ XRefs When XRef objects are selected in the scene, the XRef record to which they belong is highlighted in the XRef Record list and the XRef objects and their XRef entities are highlighted in the XRef Entities list.

Highlight All Highlights all XRef entities in the XRef Entities list.

Highlight Inverse Highlights all XRef entities in the XRef Entities list except the currently highlighted XRef entities.

Highlight None Turns off highlighting for any XRef entities currently highlighted in the XRef Entities list.

List Objects Toggles the display of XRef objects for the current XRef record in the XRef Entities list.

List Materials Toggles the display of XRef materials for the current XRef record in the XRef Entities list.

List Controllers Toggles the display of XRef controllers for the current XRef record in the XRef Entities list.

The state of List Objects, List Materials, and List Controllers is the same as the state of the toolbar buttons in the XRef Objects dialog. Changing the state in the menu changes the button state, and vice versa.

Merge In Scene Merges the current selection in the XRef Entities list into the master scene (the current scene). Use this option to change XRef objects or materials into objects that are native to the current scene. The connection between the external entity from the source scene and your master scene is
broken, and the object, controller, or material that you merged is no longer updated when the source scene changes.

3ds Max prompts you to confirm the merge.

Since a merged XRef object becomes part of the scene and is no longer an XRef object, its name is removed from the list.

Merging an XRef object loads the full modifier stack of the original object, while maintaining any additional stack items that were added while the object was an XRef object. Thus, you can use Merge to update an original object that has been altered as an external reference. If you do this, use Convert Selected Object(s) to XRefs to save out the “improved” original into a file, which then can be merged back into the original source.

**NOTE** It is also possible to merge into the master scene nested XRef entities. Once they are merged, all externally referenced nesting levels are removed and the scene entity from the lowest level source scene is merged into the master scene. In case of XRef objects, modifiers applied in a nested source file are all merged and present in the master scene.

**Apply XRef Material(s) to Object(s)** Applies the original, externally referenced material(s) to the highlighted objects. This can be useful if you have assigned a local material to the object (for example, to use in renderings of the master scene) and now want to restore the object’s original material. It can also restore the externally referenced source material if the material was originally merged into the master scene.

**Apply XRef Controller(s) to Object(s)** Applies the original, externally referenced controller(s) to the highlighted objects. This can be useful if you have assigned a local controller to the object (for example, to use in renderings of the master scene) and now want to restore the object’s original controller. It can also restore the externally referenced source controller if the controller was originally merged into the master scene.

**Reset PRS Offset** Sets the PRS transformation on page 3572 of the XRef object to its transformation defined in the source file.

**NOTE** You can undo this action.

**XRef Merge Dialog**

**Application menu** on page 7989 > References > XRef Objects > XRef Objects dialog > Create XRef Record From File button > Open File > XRef Merge dialog
The XRef Merge dialog lets you choose which objects to add as XRef objects to the scene. This behaves similarly to the Merge command on page 7572. Controls on this dialog are similar to those on the Selection Floater on page 209.

The Merge dialog lets you load and save influences with or without their dependents. In many cases, objects should be referenced with their influences, but the display only makes you aware of the relationships, it does not force you to externally reference them.

When you select an item in the list window and click Influences, the object’s influences are selected in the list window. When you select an item in the list window and Display Influences is on, the object’s influences are shown in blue in the list window. When you select an item in the list window and Select Influences is on, the object’s influences are also selected in the list window.

Procedures

To show an object’s influences in the XRef Merge dialog:

■ Select an object in the list window and enable Display Influences. The influences are shown in blue.

To select an object’s influences in the XRef Merge dialog, do either of the following:

■ Select an object in the list window and click Influences.
■ Select an object in the list window and enable Select Influences.
Interface

XRef Merge Objects list

Objects are listed according to the current Sort and List Types selections.

**Influences** When you select an object in the list window and then click the Influences button, the selected object's influences are highlighted as well.

**All, None, and Invert** These buttons alter the pattern of selection in the list window.

**Display Influences** When this is on and you select an item in the list window, all of its influences are shown in blue. If you want to highlight these influences, click Influences.
Select Influences When this is on and you select an item in the list window, all of its influences are highlighted as well.

**XRef Object Rollout**

Select an XRef object. > Modify panel > XRef Object rollout

When you've selected an XRef object in a scene, the XRef Object rollout appears along with the Proxy Object rollout on page 7475 on the Modify panel. The modifier stack for the XRef object simply displays “XRef Object.”

**Interface**

These controls let you change the file path, file name, and object name of the source of the XRef object.

**IMPORTANT** The specified file must contain an object of the specified name, or no XRef object will appear in your scene. Instead, a small X appears as a placeholder.

Highlight Corresponding XRef Record in the XRef Objects Dialog Click to open the XRef Objects dialog on page 7456, with the selected object’s record highlighted.
**File name field** Displays the path and file name of the scene file containing the source of the XRef object. You can edit this to point to a different path and file.

**File name display** Displays the file name only, without the path.

**Path button** Click to display the Open File dialog from which you can specify a different path and file name for the source file.

**Object name field** Displays the name of the source object pointed to in the source file. You can edit the name field to reference another object.

**Object name display** Displays the name of the source object.

**Path button** Click to display the XRef Merge dialog on page 7471 pointing to the scene in the XRef File Name field. Here, you can specify a different object to be used as the XRef object.

---

**Proxy Object Rollout**

Select an XRef object. > Modify panel > Proxy Object rollout

When you've selected an XRef object in a scene, the Proxy Object rollout appears along with the XRef Object rollout on page 7474 on the Modify panel. Use these controls to specify a low-resolution object to replace the original XRef object for easier handling in the viewports, and optionally for test rendering.
Interface

Enable  When on, displays the specified proxy object in the viewports. When off, displays the original XRef object. Note: If you turn this on when no proxy object has been specified, the XRef object appears in the viewports as a small X.

Use in Rendering  When on, the proxy object is also displayed in the rendering. When off, the original XRef object is rendered.

File Name field  Specify the path and file name of the scene file containing the proxy object.

Path button  Click to display the Open File dialog from which you can specify the scene file containing the proxy object.

Object Name field  Specifies the name of the proxy object in the specified scene.

Path button  Click to display the XRef Merge dialog listing the objects in the specified scene file. From here, you can select an object to be used as the proxy.
An externally referenced scene, or XRef scene, appears in your current file, but is actually loaded temporarily from another MAX file. As a result, the source scene is protected from any modifications you might make to the XRef scene via the master scene. Updates or changes made to the source scenes are also updated in the master file once the changes are made and saved to the source file.

The XRef scene feature allows team members working on the same project to have access to each other’s work without the risk of changing the files. A modeler can create a setting, while a second modeler might create a character. The animator can externally reference the setting as a scene and animate the character in the setting without being able to make changes to the setting. If the setting file is changed, those changes will be reflected in the animator’s scene.

Objects loaded in the master file via XRef scenes cannot be selected nor modified, and do not appear in the Select From Scene dialog or Scene Explorer on page 7888, the modifier stack, or the Track View. You can animate them in the current file only by using the Bind To Parent function in the XRef Scenes window.

You can snap to externally referenced scene entities. You can use Snap, AutoGrid, and Clone and Align to position local objects in context, as well as to pick objects as the target location for the clones. If you need to move, rotate or scale the referenced scene, you can bind it to a local object. Transforming the object the externally referenced scene was bound to transforms all objects in the externally referenced scene. You can also use externally referenced objects in the scene as the reference coordinate system on page 922. When you save changes to the externally referenced file (such as objects added, edited, or deleted), updating the XRef Scene inherits those changes locally.
Importing the whole village model into the building model as an XRef

Radiosity solution data cannot be part of an XRef if objects have duplicate names. To solve this, change the duplicate names. Also, to reference radiosity data externally, the Save Scene Information In MAX File switch must be on in the Radiosity panel on page 8362 of the Preferences dialog. (It is on by default.)

Be aware that render effects are not carried into the master scene by XRef scenes. To use the render effects (such as glow or flare) from the XRef file, merge them in using the Merge buttons found in the Environment And Effects dialog.

**NOTE** Atmospheric effects assigned to objects in the source file are carried into the master file when the source file is used as an XRef scene.

Choosing XRef Scene displays the **XRef Scenes dialog** on page 7485.
Overlays

Overlays allow multiple scene references without the risk of creating circular dependencies. The scene XRef marked as overlay is loaded only into the master scene that references it, and is not visible in other scenes that might XRef the master file that uses the overlay. Consider two scenes that reference each other:

```
Ordinarily, 3ds Max would recognize this as a circular dependency, and disallow it. However, you can set up such a combination of XRefs by following these steps:

1  In scene 2, XRef scene 1 and use the toggle to flag it as an overlay.
2  Save scene 2.
3  Open scene 1, and XRef scene 2.
   Scene 2 is externally referenced into scene 1, without pulling scene 1 in as a nested external reference.
```

The previous example is not particularly practical. But suppose you want to mask off part of your scene so other artists who XRef the scene will not see it. For example, you are working on a building and have XRefed a CAD file that lays out the plumbing of the building, as well as a scene of ground terrain that contains some XRefs to some trees. The XRef scene graph might look like this:
The building scene XRefs the terrain and the plumbing data. The terrain scene XRefs the trees. You decide you are the only one who needs to see the CAD plumbing data. The CAD plumbing data is needed only to line up where the sinks need to be in the building, so you set up the CAD plumbing data XRef to be an overlay. Other scenes that include the building scene won’t see the plumbing. For example, another artist who is responsible for the lighting and cameras sets up an XRef to the building scene. Now the XRef graph looks like this:
In this case, an overlay is used to simply hide data information from other master scenes. Another use of overlays is to avoid circular XRefs. For example, picture four artists working on a scene of a city block. Two of them are working on individual buildings, one is working on a sky bridge that connects the two buildings, and the fourth artist is setting up the cameras and the lights. The graph of externally referenced scenes might look like this:
But the artists working on Building A and the artist working on the sky bridge need to see each other’s work to make sure everything lines up. The obvious solution would be to externally reference each other’s scene file:
However, 3ds Max detects a circular external reference and won’t allow this, unless both the Building A scene and the Sky Bridge scene flag their external reference as an Overlay.
WARNING If you turn off the Overlay flag for an existing XRef scene, you can cause circular external references to occur, that aren’t detected until you or another user tries to open one of the scenes in the project.

Procedures

To add an XRef scene:

1. Choose Application menu on page 7989 > Import > XRef Scene.
2. Click the Add button. An Open File dialog appears that lets you locate the MAX file you wish to reference. A thumbnail display is provided to help you identify your file.
3. Click Open to bring the XRef scene into the current scene.
4 The path and file name of the selected file appears in the XRef Files window.
You can add as many files as you like; each one appears in the XRef Files window.

5 Make additional choices in the XRef Scenes dialog if you want.
You can affect the display of the XRef scene, making it visible or not, or making objects in the referenced scene appear as bounding boxes. You can ignore the file's lights, cameras, shapes, helpers, or animation. You can control when the file updates, either automatically or on demand. You can have the file enabled or disabled, or you can merge it, severing the XRef relationship and inserting the scene into your current file. You can bind the scene to a Parent object to reposition or animate the XRef scene.

To scale, rotate, or reposition an XRef scene:
1 Create an object in your current scene to be the parent object.
2 Choose the XRef scene from the XRef File window.
3 Click Bind (in the Parent group), and then select the parent object by clicking it in the viewport.
4 Transform the parent object. The XRef scene will follow.
   This works best if both the parent object and the XRef scene have their pivot points positioned near the scene's origin (0,0,0).
   If the XRef scene was created a large distance from the origin, you can run into a problem. As you scale the parent object, the XRef scene will move away from the center. To counteract this problem, you can create a second parent object centered over the XRef scene. Then select and link the original parent object to the centered parent object. You can then scale the centered parent object and the XRef will not move toward or away from the origin and use the original parent object to move the externally referenced scene.
   An alternative method for scale problems is to use the Rescale World Units Utility on page 2884 on the original file.

XRef Scenes Dialog

Application menu on page 7989 > References > XRef Scene > XRef Scenes dialog
The XRef Scenes dialog lets you add and remove XRef scenes. It also gives you tools to control the display of the XRef scene, options to ignore various components of the scene, and the ability to bind to a parent object so you can scale, rotate, or move the XRef scene.

**Accessing XRef Scenes**

Although XRefs are inaccessible “boxes” in the scene, they can be accessed in various ways.

- Cameras and lights in the XRef scenes can be accessed in the Viewports list and assigned to viewports in the current scene.
- Objects from the XRef scenes are included in the Summary Info dialog.
- Objects can be snapped to or used for alignment purposes with AutoGrid and Align.
- AutoGrid works on XRef scene objects.
- You can use objects from XRef scenes as target for cloning or reference systems.

**Nesting XRef Scenes**

XRef scenes can be nested. That is, an XRef scene can contain other XRef scenes, which can in turn contain other XRef scenes.

---

**NOTE** For a nested XRef scene to update automatically, all of its parent scene files (files that include it as an XRef) must have Auto Update turned on.
Interface

**XRef File list** Displays all XRef scenes in the current scene, and lets you select them for operations. XRefs that have been disabled (by turning off Enabled)
are listed in gray rather than black. If an XRef is listed in red, that means its file could not be loaded. Either the file is corrupted, or the path is not pointing to the correct directory or file name.

**XRef File path field** Lets you change the path or file pointed to by a selected XRef scene. To use, choose one of the XRef scenes in the list, and then change the information in the field. You can either directly enter a new file name or path, or you can click the Browse button to the right of the field, and then choose a new file from the Open File dialog. The new XRef scene that you choose replaces the one currently highlighted in the list.

Add Displays the Open File dialog from which you can choose a MAX scene file to be loaded into the current scene as an XRef. The selected scene appears in the list at left, and the geometry appears in the viewports.

You can also add a scene by dragging a MAX file from the Windows Explorer into the list, or by dragging a MAX file into a 3ds Max viewport, whereupon you're presented with a menu with the following options: Open File, Merge File, XRef File, and Cancel.

Convert Selected Lets you take any selected objects in your scene and create XRefs from them. Basically, this does a Save Selected for the objects, which are automatically cut from the MAX file and pasted into a new file. A file dialog lets you name the new file. They remain in the current scene but are now scene XRefs.

Remove Removes the XRef scene currently chosen in the list, and removes it from the current scene. To use, choose one or more XRef scenes in the list, and then click the Remove button.

**Select buttons**

These standard buttons change the pattern of selection in the list.

All Selects all items in the list.

None Deselects all items in the list.

Invert Inverts the current selection pattern in the list.

**XRef File group**

Enabled Turn this off to disable the highlighted XRef. When an XRef is disabled, it's listed in gray in the list, and it's not loaded into memory.

Overlay When on, treats the referenced source scene as an overlay on page 7479. Default=off.
Overlays allow multiple scene references without the risk of creating circular dependencies. The scene XRef marked as overlay is loaded only into the master scene that references it, and is not visible in other scenes that might XRef the master file that uses the overlay. See Overlays on page 7479 for more information.

**WARNING** If you turn off the Overlay flag for an existing XRef scene, you can cause circular XRefs to occur, that aren’t detected until you or another user tries to open one of the scenes in the project.

**Merge** Click this to merge selected XRefs into the scene as real geometry. A prompt appears so you can confirm the action. Since a merged XRef becomes part of the scene and is no longer an XRef, its name is removed from the list.

**Update File group**

Determines how and when the XRef scenes are updated. These options are applied to the selected XRefs; for example, one XRef can have automatic updating, while another can have manual updating (using the Update Now button).

**WARNING** If you update an XRef in a scene with radiosity on page 6615, you will likely invalidate the radiosity solution. After you update the XRef, reset the radiosity solution and then recalculate it.

**Automatic** When this check box is turned on, the selected XRef scene is automatically updated when its source scene is saved.

**Update Now** Click this to update a selected XRef scene when you’re not using Automatic (or when several XRef scenes are selected and some of them are not set to Automatic). When you click Update Now, the XRef is updated to match the latest saved version of the source scene.

**Display Options group**

These options let you specify how the selected XRefs are displayed in viewports. These options have no effect on the rendered scene.

**Visible** Turn on or off to display or hide the selected XRefs. This affects the visibility of the XRef in the viewports only (not in renderings). Note, also, that this behavior is different from the “Enabled” check box. Turning off Visible does not remove the XRef from memory.

**Box** Turn this on to display the selected XRefs as bounding boxes. Turn off to display the full geometry.
Ignore group

This group box lets you specify categories that you do not want included with the XRef scene. For example, if you turn on Lights, the lights in the XRef source scene are not included in the current, target scene. You can switch these categories on and off at any time, but if you Merge an XRef scene while a category is turned off, that category of objects will not be merged into the scene.

**Lights** Turn this on to ignore the lights.

**Cameras** Turn this on to ignore the cameras.

**Shapes** Turn this on to ignore the shapes.

**Helpers** Turn this on to ignore the helpers.

**Animation** Turn this on to ignore the animation. All animation in the scene is disabled and the scene appears as it would at frame 0 of the source scene.

**WARNING** Children of an ignored object are also ignored. For example, if you have mesh objects linked as children to a dummy object and ignore Helpers, then the mesh objects are ignored as well.

Parent group

These controls let you position and animate XRef scenes within the current scene by binding the XRef scene to a parent object.

**Parent Name field** Displays the name of the parent for the currently selected XRef.

**Bind** Click this, and then pick an object in the current scene to become the parent of the highlighted XRefs. Once an XRef is bound to a parent object, the transforms of the parent are inherited by the XRef. Thus, you can animate the XRef by animating the transforms of the parent.

**Unbind** Click to unbind the highlighted XRefs from whichever parent they’d been bound to.

Binding XRefs to objects is similar to linking objects, as performed with the Link/Unlink buttons on the toolbar.

If you Merge a linked XRef scene, converting it to objects in the current scene, the objects in the XRef scene become linked children of the binding parent. At this point, you could Unlink them (using the toolbar command), and they’ll maintain their offset position to the parent.

**Close** Click to close the dialog.
Data synchronization between drawing files created with AutoCAD, AutoCAD Architecture (ACA), or Revit and 3ds Max is implemented using the File Link Manager, which keeps drawing data linked to the scenes.

File Link is best understood through a few simple principles:

- **Changes in AutoCAD, AutoCAD Architecture, or Revit can change the data viewed in 3ds Max, but changes in 3ds Max never change the data in AutoCAD, AutoCAD Architecture or Revit.**

  Creating a file link is a one-way process that supports the central role of AutoCAD, AutoCAD Architecture or Revit in developing and keeping a record of your core design database. Many changes made in AutoCAD, AutoCAD Architecture, or Revit will appear in 3ds Max after a file link reload. These include adding or removing objects, moving objects, changing material assignments (specific to ACA and Revit drawings), and enabling Live Section objects (specific to ACA drawings). Changes made in 3ds Max, such as moving objects, changing material assignments, and adding lights, will never appear in your AutoCAD, AutoCAD Architecture, or Revit drawing.

- **Changes you can make in AutoCAD, AutoCAD Architecture, or Revit should be made in AutoCAD, AutoCAD Architecture, or Revit.**

  Changes that you make in AutoCAD, AutoCAD Architecture, or Revit become part of that database, whereas changes you make in 3ds Max appear only in the renderings you produce.

- **Changes in AutoCAD, AutoCAD Architecture, or Revit aren’t reflected in 3ds Max unless you choose them to be.**

  When you make changes to drawing files, those changes will not appear in 3ds Max unless you use the **Reload command** on page 7538 on the File Link Manager. When you reload a link in 3ds Max, you can choose to update just the geometry from AutoCAD, AutoCAD Architecture, or Revit, you can reload only specific objects, or (with AutoCAD Architecture and Revit drawings) you can choose to update both the geometry and the material assignments.

**NOTE** After changing your Revit project, you must export a new DWG file and then reload that file into 3ds Max. 3ds Max cannot link a native Revit project, RVT file, directly.

You can transform (move, rotate, or scale) AutoCAD, AutoCAD Architecture, or Revit objects and blocks that appear in 3ds Max, and these types of
changes are not lost upon reload. If you have moved, rotated, or scaled linked objects and want the objects to resume the position and scale they have in the original drawing file, use the **Reset Position function** on page 7504.

- **3ds Max integrates linked AutoCAD, AutoCAD Architecture, or Revit data with non-AutoCAD, AutoCAD Architecture, or Revit data.**
  In addition to the linked AutoCAD, AutoCAD Architecture, or Revit geometry and material assignments, 3ds Max allows you to create or merge into your scene many types of data from other sources, including:

  - **Lighting objects** for simulating light fixtures and daylight conditions.
  
  - **Entourage objects** such as surrounding buildings, terrain, trees, cars, and people.

  - **Advanced rendering material effects** that simulate the rich visual variety of any imaginable material. You can take advantage of materials that appear on objects created in 3ds Max, and you can create your own material effects using the Material Editor. Materials created with the Material Editor can be assigned to any component in your scene.

  - **Bitmaps** for use as environment backgrounds. You can use still images in a variety of formats, or even animated movies, as a rendering background to create stunning photomontages that appear to place your proposed design right into the actual location.

See also:
- **Resetting Transforms on Linked AutoCAD Objects** on page 7504

### Working with Drawing Files

You can attach any **DWG file** on page 8556 (or **DXF file** on page 8556) with the **File Link Manager** on page 7538. This feature allows you to work in another design software’s environment, such as AutoCAD®, Autodesk® AutoCAD Architecture, or Autodesk Revit® while maintaining a single design database.

**NOTE** For this documentation, the term “drawing” refers to DWG or DXF files created with AutoCAD and AutoCAD Architecture, or exported from Revit.
Creating Links to Files

You can establish, reload, and detach links to any number of linked files. You can also edit out unnecessary information by using layers and other filters. The File Link Manager defines which geometry is included in the scene from the linked file, how the geometry is organized, and when it's regenerated. You can also create links to files using the drag and drop feature. The objects that you bring in from linked files behave just like any other object created in 3ds Max. You can scale, rotate, and move them as well as attach modifiers and materials.

When 3ds Max stores linked file data, you'll need to decide how the objects from the linked files will be organized in the scene. For example, drawings are commonly organized by layers, blocks, and objects, and 3ds Max scenes are organized by hierarchies of objects. For translating between systems, 3ds Max includes object types called VIZBlocks on page 8758 and Block/Style Parents on page 8525.

Working with VIZBlocks and Block/Style Parents

A VIZBlock and a Block/Style Parent is like a nested block; it has an object/sub-object or parent/child hierarchy structure. In many cases, linked drawing data initially appears as a VIZBlock or Block/Style Parent (depending on the Derive AutoCAD Primitives By options on page 7555 you choose). Using VIZBlocks is helpful when you're working with layering and color schemes. You can create multiple links to the same linked file, so you can use the same geometry in different combinations.

Dynamic Blocks in 3ds Max

Dynamic Blocks give blocks flexibility and intelligence. A dynamic block reference can easily be changed in a drawing while you work. You can manipulate the geometry through custom grips or custom properties.

The File Link Manager handles dynamic blocks much the same way as any other block found in a DWG file. Dynamic block instances, even those that have been grip-edited, display certain types of instance behavior such as material propagation. For more detailed information about dynamic block handling in 3ds Max, see Blocks on page 7528.

Reloading, Binding and Detaching Links to Files

You can also reload or detach linked files. When you reload a linked file, any changes you've made to the linked file are applied to the reloaded geometry in your scene. Note, however, that 3ds Max won't edit or change your original
linked file. The integrity of your other software’s design database is never compromised by the File Link Manager. Finally, if you decide to break a link to a linked file, there are two options. You can use Bind to keep the objects from the linked file in your scene, or you can use Detach to have them removed along with the link. For more information, see File Link Tips on page 7495.

**NOTE** Both Detach and Bind are available from the Files panel of the File Link Manager.

### ObjectDBX Objects

3ds Max supports the display and use of custom AutoCAD objects. These custom objects are created using the ObjectDBX™ or ObjectARX® APIs. Applications and products that work with either of these APIs can read and write to AutoCAD drawings, and ObjectARX products can extend the available feature set of AutoCAD.

**NOTE** To improve file performance, some of the ObjectDBX rules have been updated. This means that some DXF files, ones built by non-Autodesk products or very old DXF files, may no longer import or file link into 3ds Max.

### Object Enablers

AutoCAD and AutoCAD vertical applications, such as AutoCAD Architecture (formerly Architectural Desktop or ADT), have custom objects that are unique to the product. In order to view them in 3ds Max, you need the appropriate Object Enabler (OE). Object Enablers let you access, display, and manipulate these objects in 3ds Max, as well as the other vertical applications, including 3ds Max.

When you use the File Link Manager to Attach a DWG file to your scene, you may encounter a Proxy Objects Detected dialog. This means there are custom objects in the drawing that require special Object Enablers before you can edit the objects in 3ds Max.
Do not show this message again  Check this option to not display this message the next time proxy objects are detected.
For a list of downloadable OEs, see the Autodesk Web site

NOTE  Drawings that are exported from Revit do not require Object Enablers.

File Link Tips

This topic offers some tips for choosing File Linking options and avoiding common pitfalls.

Linked Data and Face-Normal Conventions

Face normals on page 8654 can be a source of confusion when linking to AutoCAD, AutoCAD Architecture, or Revit drawing files. In 3ds Max, every face has a front and a back, corresponding to the inside or outside surface of a solid object. In a cube, for example, there is seldom the need to view the
inside surface of any of the six squares that make up the cube. So for many viewing and rendering operations, 3ds Max ignores a face if it’s facing away (that is, if its face normal is directed away) from a point of view.

When you create objects in AutoCAD, AutoCAD Architecture, or Revit, 3ds Max generally understands which way faces should be oriented and manages face normals accordingly. However, occasionally you may encounter linked drawing geometry that displays correctly in AutoCAD, AutoCAD Architecture, or Revit, but doesn’t strictly respect face-normal conventions. This can make it appear as though elements visible in the drawing file are missing or appear “inside-out” in 3ds Max.

If this happens, try one of these four options:

■ During file link or import of the DWG file, turn on the Unify Normals switch in either the Basic panel of the File Link Settings dialog or the Geometry Options group of the AutoCAD DWG/DXF Import Options dialog.

■ If the drawing is already linked or imported, assign a Normal modifier on page 1551 to the object that is not displaying properly. Turn on the Unify Normals switch to force all the normals to face the same direction. If the object then appears to be “inside-out,” turn on the Flip Normals switch as well.

■ To render the faces correctly, turn on the Render Setup dialog on page 6506 > Force 2-Sided switch. Also, to display the faces correctly in the viewports, turn on Viewport Configuration dialog > Rendering Method panel on page 8374 > Force 2-Sided.

■ Apply a material with the 2-Sided switch turned on.

**NOTE** Using the Force 2-Sided options can result in slower performance, particularly when rendering. Using either of the Unify Normals options is the preferred method of handling face normals.

If you experience a high volume of face normal problems in a particular file, verify that the File Link Settings dialog on page 7549 > Weld switch is on, and then reload the drawing. Weld forces nearby faces to share edges and vertices. Welding can still result in groups of face normals that are flipped in 3ds Max, in which case, turn on Unify Normals as well.

**NOTE** The disadvantage of welding is that it can be time-consuming when you attach and reload the linked file. The time penalty is much greater when 3ds Max is creating objects that have very large numbers of individual faces.
Linking Files with High Numbers of Linear Line Segments

Two-dimensional elements in drawing files, such as lines, polylines, circles, and arcs, are represented as splines in 3ds Max. These splines carry much more information at each vertex than typical AutoCAD 2D structures. Since some drawing files contain large quantities of 2D data, exercise caution when linking files containing a high number of discrete line segments. There are two ways these elements can be left out of your 3ds Max scene:

- by freezing their layers in AutoCAD, AutoCAD Architecture, or Revit before you start 3ds Max and before each subsequent reloading process.
- by excluding specific layers during the File Link Attach/Reload process or Import process so you do not have to freeze layers in the drawing. This is the preferred workflow.

If you need this type of 2D geometry in your visualization, try to use polylines instead of connected lines to get cleaner geometry in 3ds Max and to reduce the final size of your scene.

Linked 3D Solids Objects

3D Solids objects that you link from a drawing file into 3ds Max are tessellated; that is, turned into mesh objects with faces. The fineness of the tessellation is controlled by the **Maximum Surface Deviation For 3D Solids setting** on page 7552on the File Link Settings dialog. A high value results in coarser tessellation. 3ds Max uses less memory in the scene, but poor approximations of curved surfaces could result. For acceptable performance, keep this value as high as possible.

**TIP** You can change the value of the Surface Deviation For 3D Solids control at any time by turning on **Show Reload Options** on page 7547on the Files panel of the File Link Manager dialog, and then adjusting when you reload the file.

Linked Spline Objects

Splines are not rendered in 3ds Max unless they have rendering parameters applied. Normally, you have to collapse a shape to an editable spline object in order to apply rendering parameters; however, this is not possible with spline objects from AutoCAD.

Instead, you can apply a **Renderable Spline modifier** on page 1647 to the spline. This lets you set rendering properties without having to collapse to an editable spline.
**External References and Block Names**

A linked AutoCAD or AutoCAD Architecture drawing can include xrefs that reference files but use the same block names. 3ds Max keeps the blocks distinct by prepending xref names to block names.

In Revit, a DWG, DXF or RVT file can be linked to the project. This kind of link is called a **RVT Link** on page 8703. When the project is exported to a DWG file, this type of link is represented in the exported drawing as an external referenced drawing. In this case, more than one drawing file may be created, with one referencing the other(s).

**Circular References**

An xref file that contains a sequence of nested references that refers back to the xref file is considered a circular reference. 3ds Max resolves xrefs until it detects a circular reference. For example, if you have the circular reference A|B|C|A, 3ds Max detects and breaks the circularity between C and A. This is consistent with the way AutoCAD and AutoCAD Architecture handle circular xref dependencies.

**Overlay External References**

3ds Max treats overlay xrefs in the same way as AutoCAD when resolving xrefs.

For more information regarding overlay xrefs, refer to your AutoCAD User Reference.

**Cloning Actively Linked Objects**

If you want to clone actively linked objects, you should only use the Copy option. Creating references or instances of actively linked objects is not recommended, as reliability issues can arise when the instanced or referenced object is deleted in the linked file.

When you copy actively linked objects, linked through the **File Link Manager** on page 7538, the copies are automatically converted to editable mesh or editable spline objects. If your selection contains several objects which instance another object, the resulting copies also instance the same object.

**Compound Objects Containing Actively Linked Objects**

If you use an actively linked object as part of a compound object, you should always choose Copy when you specify how the linked object is transferred to
the compound object. Choosing Reference or Instance can cause instability in 3ds Max.

**Attaching Actively Linked Objects to an Editable Mesh, Poly, Patch, or Spline Object**

Actively linked objects should *not* be attached to editable objects, as this introduces instability to 3ds Max. Instead, make a copy of the actively linked object, and attach the clone to the editable object.

**Creating Hierarchies with Actively Linked Objects**

Creating parent-child links between actively linked objects AND 3ds Max objects can cause unpredictable results. For this reason, 3ds Max does not allow you to link an actively linked object to a 3ds Max object. However, you can link a 3ds Max object to an actively linked object.

The existing hierarchies of linked objects cannot be broken in 3ds Max. This would compromise the structure of Blocks and Styles. Any changes must be made in the original DWG file.

Similarly, actively linked objects cannot be included in the creation of Group on page 258 or Assembly on page 263 objects in 3ds Max.

**Controller Assignments**

Actively linked objects should not be included in any IK animation chains, as they will cause unpredictable results. Likewise, animation controllers should not be applied to actively linked objects.

Assignments to avoid include:

- **HI IK Solver** on page 3680
- **IK Limb Solver** on page 3732
- **Spline IK Solver** on page 3733
- **HD IK Solver** on page 3710
- **Inherit Link Info** on page 3789
- **Link Inheritance Utility** on page 3660
- **Assign Controller** on page 3897
Interpreting Layer Data from AutoCAD, AutoCAD Architecture, and Revit

3ds Max has its own Layer system that looks and operates like a simplified version of the system you are familiar with from AutoCAD or AutoCAD Architecture (formerly Architectural Desktop). As in AutoCAD or AutoCAD Architecture, you can hide and unhide layers, freeze and unfreeze them, and change the display color for all objects on the layer.

**NOTE** Categories in your Revit project are similar to Layers in AutoCAD. When you export your project to a DWG, categories are mapped to AutoCAD Layers via the Export Layers table. For more information regarding Export Layers, refer to your Autodesk Revit Help file.

Layer operations are accessed through the tools on the Layers toolbar, and also on an object-by-object basis using the quad menu on page 8052.

Unlinked objects, such as 3ds Max objects or drawing geometry that has been bound into the scene using the Bind command, may be assigned to any layer you choose, including layers created by the File Link Manager.

Linked objects from AutoCAD, AutoCAD Architecture, or Revit, with some minor exceptions, will be assigned to the same layers they occupy in program where the drawing was created.

Any changes made to the layer settings in 3ds Max (hidden/unhidden, frozen/unfrozen, display color) affect linked objects just as they do unlinked objects. Also, any changes you make to the layers are not reset when you reload the drawing.

You can rename layers created by the File Link Manager. When the next reload occurs, the renamed layer is not affected by the File Link Manager. Objects on the renamed layer are updated; however, they remain on the same layer. The original layer is only recreated when a new object has been created in the DWG file. New objects are never placed on the renamed layer. You can also delete layers imported by the File Link Manager on page 7538; but only if they don't contain any objects.

You can move actively linked objects between layers in 3ds Max. When the next reload occurs, the objects are updated; however, they are not moved back to their original layers. You can also place non-linked objects, such as 3ds Max objects or drawing geometry that has been bound into the scene, on any of the imported layers.
Objects contained in layers that are frozen in AutoCAD or AutoCAD Architecture are not linked to 3ds Max. Objects that were originally linked to 3ds Max are removed if their layer is frozen in AutoCAD or AutoCAD Architecture and the link is reloaded, but they are added again, upon reload, after their layer is unfrozen in the program where the drawing is created.

**NOTE** This is only the case if Skip All Frozen Layers is active on the Select Layers dialog on page 7568. If you select the layers individually from a list, you can bring in data on frozen layers.

See also:
- Using Layers to Organize a Scene on page 7953

**Scale Synchronization**

3ds Max automatically manages the scale conversion on linked geometry and materials. 3ds Max has its own *system unit* for internal representation of geometrical scale.

If you find that any geometry is not shown at the size you intended it to be, it is because it was created at the improper scale in the originating program.

See also:
- Using Units on page 2784

**Working with AutoCAD, AutoCAD Architecture, and Revit Files**

3ds Max produces rich visualizations based on your drawing design data. In order to produce high-quality visualizations, you need to add and adjust many design variables that affect the visual impact of your design, but don’t really belong in your core AutoCAD, AutoCAD Architecture, or Revit data. You might want to test your design under different lighting conditions, experiment with different texture and material effects, animate components, or move through a space. 3ds Max allows you to enhance your design with this “extra” data while maintaining the integrity of the underlying AutoCAD, AutoCAD Architecture, or Revit design.
Using the File Link Manager on page 7538, 3ds Max maintains a live data link to AutoCAD, AutoCAD Architecture, or drawings exported from Revit that allows you to use the linked object data in your 3ds Max scene. You can perform various operations on this linked data in 3ds Max for visualization purposes, but nothing you do in 3ds Max will change the base data you see in the source application. The data link allows you to periodically refresh your 3ds Max scene with revised drawing data.

If a live data link is not important to you, the DWG/DXF Import functionality processes drawings, exported from Revit, in the same intelligent way as the File Link Manager. You just don't have the benefit of the live data link.

See also:

- Using Layers to Organize a Scene on page 7953
- File Link on page 7491
- Interpreting Layer Data from AutoCAD, AutoCAD Architecture, and Revit on page 7500
AutoCAD Geometry in 3ds Max

The basis of your model in 3ds Max is the geometry of the objects, blocks, and other entities that are transferred through the file linking functionality. In many cases, these objects behave just like the editable meshes and splines you create in 3ds Max. But because the link to the source drawing plays such a central role in your workflow, 3ds Max has special rules and tools for handling linked AutoCAD geometry.

When you are working with linked objects and blocks from AutoCAD, you will find that these are composed as groups of related objects in 3ds Max. These groups are organized hierarchically below a 3ds Max VIZBlock object. VIZBlocks are special objects created by the file linking functionality that are used to contain other file linked objects in a group. VIZBlocks don't contain any geometry directly, so for example it is meaningless to apply modifiers to them. However, they do reference the components below them so that transforms applied to a VIZBlock will be applied to all the component objects it contains.

See also:
- Styles on page 7535
- Instanced Objects on page 7527
- Blocks on page 7528

AutoCAD Entities and Blocks in 3ds Max

AutoCAD blocks in 3ds Max are treated similarly to AutoCAD objects, though the rules for propagation of transforms are slightly different to mirror the behavior of blocks in AutoCAD.

As with AutoCAD objects, linked AutoCAD blocks, of any type, and externally referenced drawings appear in 3ds Max as objects hierarchically grouped below a VIZBlock to reflect the structure of the block or xref in AutoCAD.

When non-nested blocks, of any type, are linked to a scene, the naming for the incoming block instances are based on the original block definition in the form of Block: block_name where block_name is the actual name of the block definition. For example, if you link a drawing containing a series of blocks named office chair, their name will show as Block: office chair in 3ds Max.
Nested blocks in AutoCAD will be analogously nested in 3ds Max under nested VIZBlocks. The grouping and naming follows the parent-child structure of `xref drawing name:block name:nested block name:entity`.

**NOTE** Entities that lie on layer 0 of an AutoCAD block definition will appear as `Layer:0` in 3ds Max, even though they may appear to reside on a different layer when they are inserted in AutoCAD.

With linked AutoCAD Architecture objects, material assignments to linked AutoCAD blocks can propagate automatically to all other instances of those block components in the 3ds Max scene, depending on how Propagate Materials To Instances on page 5674 is set. Modifiers applied to block components, however, propagate automatically to all other block instances, regardless of how Propagate Materials To Instances is set.

If you transform (move, rotate, or scale) the top-level VIZBlock that contains a block reference, all the components of that block will be transformed together and no other VIZBlocks will be affected. If, however, you transform a block component, including a nested VIZBlock, that transformation will automatically propagate to all other instances of that block in the scene. This mirrors the behavior of blocks in AutoCAD when reference-editing a block definition.

See also:
- Blocks on page 7528

**Resetting Transforms on Linked AutoCAD Objects**

Select a linked AutoCAD object. > Modify panel > Linked Geometry rollout > Reset Position

You can move, rotate, or scale linked AutoCAD objects in 3ds Max, and these transformations will remain intact even after the linked AutoCAD drawing has been reloaded. But you can choose to eliminate the transforms on an object-by-object basis using the Reset Position function, available on the Modifier panel.

**NOTE** The Reset Position functionality is only available for linked files. It is *not* available when you Import a DWG file, or when you have bound a linked file.

Every linked AutoCAD object and component has a Reset Position function associated with it. Clicking this button automatically resets all transformations that have been applied to this object or component in 3ds Max, so that the
component resumes the location, rotation, and scale it held in the linked AutoCAD drawing when it was last reloaded.

**WARNING** Transforms applied to block components are applied to all instances of that component in all other linked block insertions in the 3ds Max scene. Resetting the transformation of *any* instance will reset *all* of them.

To reset the transforms applied to a linked AutoCAD object:

1. Select a linked object in your scene.
2. On the Command panel, click the Modify tab to display the Modify panel.
   The name of the linked object appears at the top of the Modify panel, and the modifiers that have been added to the object (if any) are shown on the modifier stack.
3. At the bottom of the list of applied modifiers, click either *Linked Geometry*, *VIZBlock*, or *Block/Style Parent*, whichever appears, if it is not already highlighted.
   A Linked Geometry rollout appears at the bottom of the Modify panel.
4. Click the Reset Position button
   The linked object reverts back to its original location, rotation, and scale in the linked AutoCAD drawing.

**NOTE** When Reset Position is applied to a linked object that has been animated (in other words, has transform keys for different frames) only the transform for frame 0 is reset.

See also:

- File Link on page 7491

**Interface**

![Linked Geometry]

- Reset Position
Reset Position  Resets the selected object’s transforms to those of the original AutoCAD object when the drawing was last reloaded.

Restrictions on Editing AutoCAD Geometry

Many operations that are allowed on mesh, spline, or shape objects in 3ds Max are not allowed on linked AutoCAD geometry, and other operations behave differently.

The following operations are not allowed on linked geometry:

- Deletion
- Altering the parent-child hierarchy
- Collapsing the linked geometry into an editable mesh or an editable spline

If you must perform any of these operations, you must either do them in AutoCAD or else bind the drawing data to 3ds Max, which breaks the link back to AutoCAD.

Applying Modifiers to Linked AutoCAD Geometry

You can apply modifiers to linked AutoCAD geometry and these modifiers will persist when you reload the geometry. This can be a very powerful way to intelligently manage your design intent, but it can also lead to some unexpected results, especially when using topology-dependent modifiers.

“Topology-dependent” simply means that the modifier is relying on the particular arrangement and number of faces and vertices that comprise the mesh representation of the object. It is common, for example, for the modifier to cause an action to be performed on the nth element it encounters, say the “twelfth” face or the “fourth through the twentieth” vertex. It is easy to perform edits on the base object in AutoCAD that would cause the definition of the nth element to change, which would result in the modifier yielding unexpected results when the drawing is reloaded in 3ds Max.

Not all modifiers are topology-dependent. When you attempt to use a topology-dependent modifier on linked AutoCAD geometry, a warning dialog is displayed that gives you an opportunity to continue or abort the operation.

When you use modifiers on linked AutoCAD objects and blocks, remember that the VIZBlock object you see in 3ds Max does not contain any geometry directly; applying modifiers to VIZBlocks will never have any visible effect.
Instead, apply modifiers to the component objects below the VIZBlock in the 3ds Max object hierarchy.

**Copying Actively Linked Objects**

You can copy actively linked objects in 3ds Max; the copies are automatically converted to editable mesh objects. If your selection contains several objects that instance another object, the resulting copies also instance the same object.

However, it is recommended that you do not instance or reference actively linked objects, as this can introduce instability to the scene.

*See also:*

- [Using Modifiers](#) on page 1040

**AutoCAD Architecture Files**

DWG files from AutoCAD Architecture (formerly Architectural Desktop or ADT) often contain additional information, such as special objects, material definitions, and styles. 3ds Max is thoroughly compatible with AutoCAD Architecture, and it recognizes all of these specialized objects and definitions during the file link process.

**AutoCAD Architecture Objects in 3ds Max**

Each instance of an AutoCAD Architecture (formerly Architectural Desktop or ADT) object is represented by multiple objects in 3ds Max. Whenever the file link process detects a useful distinction between elements of an AutoCAD Architecture object, it automatically separates, names, and groups the elements in 3ds Max to make them easier to work with.

The new objects created in 3ds Max through file linking are grouped together hierarchically below a special object called a VIZBlock, allowing you to deal with individual objects in the hierarchy or with all of them as a group. You can view this hierarchy, but you cannot change it in 3ds Max. You can only change the hierarchy indirectly by editing the objects in AutoCAD Architecture, and then reloading them into 3ds Max using the File Link Manager on page 7538.
Criteria for Subdividing AutoCAD Architecture Objects

The File Link Manager divides an AutoCAD Architecture object into multiple objects in 3ds Max if it detects distinctions based on the following features:

- Component name
- Component subtype (for example, in sectioned bodies)
- Layer
- Material assignment

So, for example, if a window object in AutoCAD Architecture contained a mullion component, but a portion of the component had a different material assignment than the rest of it, the mullion component would appear as two separate objects when linked into 3ds Max. The objects will be linked together with all the other components of the window, but you could modify the material properties of the two mullion objects separately. If you changed the material assignments in AutoCAD Architecture so that the entire mullion component only had one material assignment, then when you reloaded the drawing in 3ds Max there would only be one mullion object present.

**NOTE** Material assignment and Layer are two of the properties used to separate one component from another. When these are changed in the AutoCAD Architecture drawing, new objects are created in 3ds Max, or geometry may move from one object to another. In either case, some scene properties are changed, such as assigned material or scene layer.

3ds Max organizes and names file linked objects to reflect their structure in AutoCAD Architecture, using a parent-child hierarchy. The parent object will be a VIZBlock named `object class <style>`, and this VIZBlock will have one or more child objects named `object class <style name> component1, object class <style name> component2`, and so forth. Objects that originate in an xref drawing in AutoCAD Architecture are grouped together under a VIZBlock that is named for the xref drawing.

The following table lists some examples of the naming conventions of AutoCAD Architecture objects that are file linked in 3ds Max.

<table>
<thead>
<tr>
<th>Name in 3ds Max</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Xref:Drawing1XRef:5701</td>
<td>A VIZBlock containing one or more objects found in <code>drawing1.dwg</code>, which is an xref in...</td>
</tr>
</tbody>
</table>
### Name in 3ds Max   Remarks

<table>
<thead>
<tr>
<th>Name</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>the linked AutoCAD Architecture drawing.</td>
<td></td>
</tr>
<tr>
<td>Window &lt;Picture-Arched&gt;</td>
<td>A VIZBlock for an object of class=Window and style=Picture-Arched. There will one or more components that belong to this object instance, which will be child objects with the VIZBlock as their parent.</td>
</tr>
<tr>
<td>Window &lt;Picture-Arched&gt; Frame</td>
<td>A component to the object, named Frame.</td>
</tr>
</tbody>
</table>

**NOTE** It is possible for instances of the same AutoCAD Architecture object to subdivide differently into 3ds Max objects. AutoCAD Architecture objects are considered instances of the same object if their type, style name, and component name are exact matches, and this will affect their instancing behavior for 3ds Max functions such as substitution as well as material propagation.

See also:

- Instanced Objects, Elements, Blocks, and Styles on page 7526
- Styles on page 7535

## Materials and Linked AutoCAD Architecture Objects

Materials in 3ds Max are vital to making your visualizations compelling and realistic. The native material attributes that 3ds Max relies on are those that tell it how to render the surface of an object given certain lighting conditions. Those material properties that are so central to architectural visualization (that convey surface coloring, surface texture, transparency, and so forth) are only one of many sets of properties covered in an AutoCAD Architecture (formerly Architectural Desktop or ADT) material definition.

To make your work more efficient, the rendering material properties stored and assigned in AutoCAD Architecture are designed to flow transparently to 3ds Max through the File Link Manager on page 7538.
Assigning Materials to Linked AutoCAD Architecture Objects

Material assignments exhibit special behavior on linked AutoCAD Architecture objects and blocks, and the behavior is controlled by the Propagate Materials To Instances toggle on page 5674.

In the default state, assigning a material to any component of any linked AutoCAD Architecture object or block is equivalent to assigning the same material to every instance of that component of that object or block throughout your scene.

As an example, let's say you have multiple instances of a block named Telephone in your AutoCAD Architecture drawing, which consists of two nested blocks named Handset and Base. If you assign a material to one Handset anywhere in your scene, all the Handsets in all the Telephones throughout the scene will receive that material.

If you want to keep materials from propagating between instances in your scene, turn off the Propagate Materials To Instances toggle on page 5674.

See also:

- Instanced Objects on page 7527
- Blocks on page 7528

Making Changes to AutoCAD Architecture Materials

AutoCAD Architecture (formerly Architectural Desktop) object components frequently appear in 3ds Max carrying rendering material assignments that were made in AutoCAD Architecture. You can use these materials, adjust them, or replace them with new rendering materials for use in 3ds Max.

If you modify or replace the materials in 3ds Max, or if they change in the linked AutoCAD Architecture drawing, you can choose either to retain the current material in 3ds Max or else to revise the material assigned in 3ds Max.
with the current material in AutoCAD Architecture when you use the File Link Manager on page 7538 to reload the linked drawing.

**NOTE** When 3ds Max encounters additional material references among xref files that use a material name that is already in use, it compares the properties of the two material definitions in an attempt to determine whether they really represent identical materials. If the two materials appear to be the same material being used in different drawings, 3ds Max will use only one of the material definitions for all objects assigned either material. But if 3ds Max determines that this is merely a naming conflict between two different materials, it will slightly modify the name of one of the materials and keep the materials and their assignments distinct.

**Legacy Materials in AutoCAD Architecture**

Longtime users of AutoCAD may be familiar with an older form of material creation and assignment associated with the RMAT command in AutoCAD that is still present in AutoCAD Architecture. Materials developed in this way can be viewed in AutoCAD Architecture and rendered with the legacy AutoCAD renderer. Any assignments of these materials to geometry in AutoCAD Architecture that is made through the RMAT command or its Material dialog in AutoCAD Architecture will be ignored in 3ds Max.

In theory, RMAT materials could be assigned to AutoCAD Architecture objects (not AutoCAD objects) by incorporating them into AutoCAD Architecture material definitions, and using these material definitions in edits to AutoCAD Architecture styles or object overrides. Materials created and assigned in this way would appear in 3ds Max assigned to the linked AutoCAD Architecture objects. However, this practice is not recommended because the native 3ds Max Architectural materials have more complete information on the surface characteristics of objects, and are easier to create and share. In other words, you work faster, share easier, and get better results using native 3ds Max rendering materials in both AutoCAD Architecture and 3ds Max.

See also:
- Material Editor, Materials, and Maps on page 5619

**UVW Mapping in AutoCAD Architecture Objects**

An important consideration in how many materials render is how they are “mapped” to the surfaces of the objects they are assigned to. This is especially
important for materials that use bitmaps on page 8523 to define the diffuse color of a material, or the bump and cutout special effects.

As an example, you might have scanned a picture of wood grain for use in a material, but when the material is applied to an object, how large should the image of the wood grain be? Which way do you want the grain to run, and how do you want the grain to wrap around the corners of a three-dimensional object?

How two-dimensional maps are applied to three-dimensional surfaces is represented by mapping coordinates on page 8628, which are stored as UVW coordinates on page 8754. In cases where mapping coordinates are likely to be important to the rendered appearance of an object, AutoCAD Architecture (formerly Architectural Desktop) assigns UVW coordinates to object components. 3ds Max translates these coordinates and stores them in the object mesh that is displayed and rendered in the 3ds Max scene. You can adjust these coordinates in 3ds Max using the UVW Xform modifier on page 1955, or you can redefine them all at once using the UVW Map modifier on page 1932.

**IMPORTANT** Make sure that Rescale is turned on in the Attach Panel of the File Link Manager dialog. Otherwise, if the units do not match, the UVW coordinates will be incorrectly scaled when linked to 3ds Max.

---

### Drawings Exported from Revit

The Export function in Autodesk Revit lets you export models to DWG or DXF file formats. In Revit 6.1 and 7.0, the exported drawing entities contain additional information, "Revit data," such as their originating Category, Family, Type, and Material.

The File Link Manager on page 7538 and DWG/DXF Import functionality looks for and processes this additional information. When “Revit data” is found with an object, the object is treated differently by the import/file link process. The primary differences are:

- object naming conventions
- scene organization of incoming geometry (how the objects are combined)
- parent-child hierarchy of scene objects
- possible automatic material assignments
IMPORTANT 3ds Max cannot directly import (or link) a native Revit project (RVT). You must first export a DWG or DXF file from Revit before you can import the model into 3ds Max. The imported or linked file will contain scene objects that correspond directly to individual Revit objects. In addition, most materials are translated and assigned to the objects, giving Revit customers a head start toward better visualization and faster rendering of their models.

See also:
- Revit Elements in 3ds Max on page 7513
- Materials and Linked Revit Objects on page 7521

Revit Elements in 3ds Max

Whenever you use the File Link Manager or DWG/DXF Import functionality, 3ds Max detects a useful distinction between categories of a Revit elements. It automatically separates names and groups the elements in 3ds Max to make them easier to work with.

The new objects created in 3ds Max through file linking are grouped together hierarchically below a special object called a Block/Style Parent on page 8525, allowing you to deal with individual objects in the hierarchy or with all of them as a group. This hierarchy is similar to the one created when AutoCAD Architecture objects are linked.

You can view this hierarchy, but you cannot change it in 3ds Max. You can change the hierarchy only indirectly by editing the elements in Revit, exporting an updated DWG, and then reloading the drawing.

Criteria for Subdividing Revit Elements

The File Link Manager organizes Revit elements into multiple 3ds Max objects based on the following classification of elements:

- **Categories**  Categories are the most general class of element. They are subdivided into *model categories* and *annotation categories*. Model categories include doors, windows, walls, and furniture. Annotation categories include dimensions, grids, levels, and text notes.

- **Families**  Families are classes of elements within a category that group elements with a common set of parameters (properties), identical use, and similar graphical representation. Different elements within a family may
have different values of some or all properties, but the set of properties—their names and meaning—is the same. For example, six-panel colonial doors are one family, although the doors that compose the family come in different sizes and materials. Most families are component family files, which means you can load them into your project or create them from family templates. You can determine the set of properties and the graphical representation of the family. Other families are called system families and are not available for loading or creating in Revit. Autodesk Revit predefines the set of properties and the graphical representation of system families; they include walls, dimensions, ceilings, roofs, floors, and levels.

Besides being a class of elements, families are also a template that allows you to generate new types of items that belong to this family.

■ **Types** Types, also called a family types, are a class of elements within a family that have the exact same values for all type properties. For example, all 32x78 six-panel doors belong to one type, while all 24x80 six-panel doors belong to another type. Like a family, a type is also a template that generates new instances of this type.

■ **Instances** Instances are the actual items that have specific locations in the building (model instances) or on a drawing sheet (annotation instances).

3ds Max organizes and names file linked objects to reflect their structure in Revit, using a parent-child hierarchy. The parent object is a Block/Style Parent named `category <family : type>`, and the Block/Style Parent has one or more child objects named `category <family : type> subcategory1`, `category <family : type> subcategory2`, and so forth.

For example, if a single-flush door object in Revit is linked to 3ds Max, it will have a parent-child hierarchy displayed as a parent object, `Doors <Single-Flush : 34” x 80”>`, with three children, `(2) Doors <Single-Flush : 34” x 80”> Frame/Mullion` and a `Doors <Single-Flush : 34” x 80”> Panel`. The objects will be linked together with all the other components of the door, but you could modify the material properties of the two frame/mullion objects separately. If you changed the material assignments in Revit so that the entire frame/mullion component only had one material assignment, then when you reloaded the drawing in 3ds Max there would only be one frame/mullion object present.

When working in Revit, you also have the ability to link AutoCAD drawings or other Revit projects to your current project. This is comparable to using exrefs in AutoCAD. Objects that originate as a linked drawing in Revit are
grouped together as Linked Geometry that is named for the linked drawing. In this case, the parent object is named Import Symbol <drawing.dwg> and its children are named Import Symbol <drawing.dwg> subcategory1, Import Symbol <drawing.dwg> subcategory2, and so on. The subcategories are derived from the layers that the objects reside on in the drawing.

The following table lists some examples of the naming conventions of Revit objects that are imported or file linked in 3ds Max.

<table>
<thead>
<tr>
<th>Imported/File Linked Name</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Door &lt;Single-Flush : 34” x 80”&gt;</td>
<td>A Block/Style Parent for an object of category=Door, family=Single-Flush and type=34” x 80”. This parent object has one or more components, that are child objects displayed as Linked Geometry.</td>
</tr>
<tr>
<td>Window &lt;Casement with Trim : 24” x 48”&gt; Frame/Mullion</td>
<td>A component to an object named, Window &lt;Casement with Trim : 24” x 48”&gt;. This is a child object and is displayed as Linked Geometry. In Revit, the Frame/Mullion is a subcategory of Windows.</td>
</tr>
<tr>
<td>Casework &lt;Base Cabinet-4 Drawers : 18”&gt;</td>
<td>A Block/Style Parent object named, Casework &lt;Base Cabinet-4 Drawers : 18”&gt; and the two, child components, Casework &lt;Base Cabinet-4 Drawers : 18”&gt; and Casework &lt;Base Cabinet-4 Drawers : 18”&gt; Cabinet</td>
</tr>
<tr>
<td>Import Symbol &lt;drawing1.dwg&gt;</td>
<td>This object is Linked Geometry containing one or more components found in drawing1.dwg, which is a drawing that is linked to the Revit</td>
</tr>
</tbody>
</table>
Remarks

Linked Name
drawing. This linkage is comparable to an xref in AutoCAD.

NOTE It is possible for instances of the same Revit element to subdivide differently into 3ds Max objects. Revit elements are considered instances of the same element if their category, family, and type name are exact matches, and this will affect their instancing behavior for 3ds Max functions such as material propagation.

Revit Cameras and Views

In order to navigate a Revit drawing more efficiently, you might have set up a series of 3D views by means of placing cameras at different viewpoints around the drawing. The File Link Manager and Import functions of 3ds Max allow camera views to be treated as 3ds Max cameras.

You must meet two conditions in order for 3ds Max to understand Revit camera views.

- A camera view must be active before you export the DWG file from Revit.
  
  NOTE Only the active camera view is exported.

- You have to make sure you've turned on the Views (cameras) switch in the Basic File Link Settings dialog on page 7549.

When the drawing is linked to 3ds Max, that camera and its target appear in the scene named Camera:viewname and Camera:viewname.Target.

Light Sources

Drawing files, exported from Revit, can contain light sources, however, they do not export with the DWG or DXF files. What does get exported is the 3D mesh geometry representing the light fixture. Therefore, when you import or link the drawing to 3ds Max, the light object is strictly geometry, not an actual light source like a spotlight or omni light that you can adjust.

These pieces of geometry are still useful in that you can use them as reference points for placing and aligning lights you add in 3ds Max.
**DXF Files**

Along with the ability to export DWG files, Revit can also export to the DXF file format. The only difference is in how they handle drawings that are linked (RVT links) to the Revit drawing.

When exporting to DXF, the linked drawings are automatically bound to the drawing. Therefore, while exporting to a DWG honors the linked drawings and treats them as AutoCAD xrefs, an exported DXF file will not have xrefs. Instead, the linked drawings are converted to blocks.

The resulting scene organization will be slightly different when linking or importing a DXF as opposed to a DWG, but only when RVT links are present in the drawing.

**See also:**
- Instanced Objects, Elements, Blocks, and Styles on page 7526
- Styles on page 7535

**Suggested Settings and Workflow**

The topics in this section described suggested settings for Revit projects, and the suggested workflow from Revit to 3ds Max.

**Suggested Settings for Revit Projects**

The File Link Manager and DWG/DXF Importer have many settings that you can adjust so you get the best results when linking or importing a drawing that you've exported from Revit. In this section, you'll find some recommended settings that you can use when linking or importing your DWG files. These settings are found on the Basic File Link Settings dialog on page 7549, the Advanced File Link Settings dialog on page 7553, the Spline Rendering File Link Settings dialog on page 7561, and the AutoCAD DWG/DXF Import Options dialog on page 7666.

**Use the Revit Preset**

3ds Max includes a preset named “Revit” that you can use when using File Link to link a drawing that is exported from Revit. The Revit preset has many of the following suggested settings turned on by default. Or, you can use the
Revit preset as a basis for your own customized Revit preset containing the settings you prefer.

The Revit preset can be assigned from the Preset list on the Attach panel of the File Link Manager on page 7538. You can edit the preset on page 7567 by choosing the Revit preset shown on the Presets panel of the File link Manager.

If you plan on creating your own presets or modifying the Revit preset, use these settings to streamline the file linking process.

**Turn on Weld and set a Weld Threshold**

- Weld and Weld Threshold are found on the Basic panel of the File Link Settings dialog or in the Geometry Options group of the AutoCAD DWG/DXF Import Options dialog.

When Revit exports model geometry to a DWG file, objects are translated as multiple surface meshes. For example, a single wall is made up of 6 or more AutoCAD entities: each a polyface mesh with vertices that overlap their neighbors. When the meshes get linked to 3ds Max, the File Link Manager or DWG/DXF Importer recombines them back to a single object. However, when the meshes are recombined, their vertices are not welded, so you end up with a larger and less elegant model than expected. By turning on the Weld option and setting an appropriate Weld Threshold (like 0.1" or smaller), coincident vertices are welded together and the file structure is more efficient.

**NOTE** This is particularly important if you plan to do radiosity rendering because gaps in the model can cause leaks that greatly increase the rendering time.

**Turn on Views (cameras)**

- Views (cameras) is found in the Include group on the Basic panel of the File Link Settings dialog and the AutoCAD DWG/DXF Import Options dialog.

If you've set up one or more cameras in your Revit project, the File Link Manager or DWG/DXF Importer will recognize and link a camera when the Views (cameras) option is turned on. There is, however, a catch. Before you export a DWG from Revit, the camera view must be active and only the active camera will be exported.
Avoid Entity and Entity, Blocks as Node Hierarchy

On the Advanced File Link Settings dialog, when choosing a Derive AutoCAD Primitives By option, avoid Entity and Entity, Block as Node Hierarchy.

Elements are occasionally missing Revit embedded data. When this data is missing, the objects are "derived" according to the Derive AutoCAD Primitives By setting. Deriving by either of the Entity choices will not, generally, give you the end result you want and could result in a scene in 3ds Max that contains a vast number of individual objects. In particular, these settings can cause issues with railing balusters.

Use Layer, Blocks as Node Hierarchy

On the Advanced File Link Settings dialog, use Layer, Block as Node Hierarchy, when choosing a Derive AutoCAD Primitives By option.

The Layer, Blocks as Node Hierarchy derive by option, often gives the best results for linking DWG files, especially when the Revit project has other drawings, RVT links on page 8703, linked to it. Combining by Layer (node hierarchies or not) is the preferred setting. RVT links get exported to the DWG as xrefs. If you want the File Link Manager to preserve color and material assignments of those objects, Layer, Blocks as Node Hierarchy is the setting to use.

Turn on Material Definitions and Assignments

The Use Scene Material Definitions and Use Scene Material Assignments on Reload switches are on the Advanced File Link Settings dialog.

These two switches are quite important when you've got materials assigned in your Revit project.

When the Use Scene Material Definitions switch is turned on, 3ds Max checks the scene for any currently used materials matching the exact same name as a material name in the linked DWG file. If a match is found, File Link does not translate the drawing's material, and instead uses the material defined in the scene.

When turned off, the File Link Manager always uses the material definitions contained in the DWG file, and will overwrite scene materials with the same name, regardless of which objects the material is applied to. In addition,
material definitions are always reloaded from the DWG file, so if you make changes to a linked material, then reload, those changes will be lost.

If the Use Scene Material Assignments on Reload switch is turned on, linked objects with a material already assigned to them in the 3ds Max scene will not have that material assignment changed. When turned off, linked objects have their material assignment ‘coordinated’ with the drawing, so that the two are in-sync.

**Determine how you want SplinesHandled**

- The settings on the Spline Rendering File Link Settings dialog control how shapes and splines are linked or imported into 3ds Max.

In your original project, you may have used 2D lines to represent joints between sidewalk pavers or as mullions separating sections of a curtain wall. The settings on the Spline Rendering panel let you use those lines more advantageously.

When you turn on Enable In Renderer and/or Enable In Viewport, lines are visible when you render the scene or are treated as selectable objects in the scene. You can also adjust the appearance of lines by having them display as radial or rectangular geometry.

**TIP** Using the *Sweep modifier* on page 1776 with 2D splines or shapes lets choose a cross-sectional shape that is swept along the spline resulting in much more scene detail.

**Suggested Workflow for Revit to 3ds Max Projects**

Most of the work you do on your Revit project will be done in Revit. The initial design, layout and modeling all occurs from within the Revit program. 3ds Max comes into play when you're ready to produce some higher-end renderings and perhaps add some final details.

Following is a basic description of the expected workflow between Revit and 3ds Max:

1. You've completed most of the design work in Revit and you're ready to add finishing touches and create some presentation renderings.

2. From Revit, export a DWG file.
Exporting to a DWG file is necessary because the File Link Manager cannot accept the “native” Revit project (RVT) files.

3 Start 3ds Max and use the File Link Manager to link the DWG file. Link the drawing using presets that include the linking settings you want as described in the Suggested Settings for Revit Projects on page 7517 section.

4 Adjust materials or make final modifications in 3ds Max in preparation for rendering. Depending on the results at this stage, you may find that the Revit project needs to be changed and updated.

5 In Revit, make changes to the project like moving walls, adding new doors and windows or adding/removing objects. For structural changes like adjusting walls, doors, windows, and so on., it's best to make these changes in Revit because those changes need to be included in the originating project. File Link is a one way link so any changes you can make in Revit, should be made in Revit. Otherwise, you’d have to remember to make the same changes in both 3ds Max and Revit.

6 When the changes are completed, export another DWG file with the same name as the original DWG file you exported in step 2. If you give a new name to the exported DWG, the File Link Manager will not show that the currently linked file has been updated.

7 In 3ds Max, open the File Link Manager and review the Files panel. Select the updated file link and click the Reload button — Turn on Show Reload Options if you want to change link settings. The changed model reloads to 3ds Max and changes made to the model in 3ds Max prior to the reload are retained.

The 🔄 symbol means the DWG file has been updated.

### Materials and Linked Revit Objects

When you export a DWG or DXF from Revit projects, materials are translated into a format that 3ds Max can understand. Revit creates materials in the same format as used by AutoCAD Architecture, VIZ Render and 3ds Max.

There are two kinds of materials associated with the Revit project; AccuRender materials and Revit materials. When a Revit material references an AccuRender
material, the AccuRender material’s parameters are used; otherwise, the Revit material parameters are used.

There is an important caveat to this. AccuRender materials that reference a bitmap file are translated in 3ds Max without any problems, while AccuRender materials that are considered “procedural” are only translated at the most basic level.

Therefore, an AccuRender material that uses a bitmap image in the base texture definition will provide a more accurate translation to 3ds Max.

**NOTE** There are some limitations on what is translated between Revit/AccuRender materials and 3ds Max materials because there is not a one-to-one correlation between the two material definitions.

**Material Assignments**

The Revit DWG Exporter puts embedded information on each object it exports. Amongst this information are identifiers specifying material assignments. Revit creates the same kind of material definitions used by AutoCAD Architecture, VIZ Render and 3ds Max. When imported or linked, 3ds Max uses this information to translate and maintain the material assignment to the resulting scene object.

Because the material identifier is embedded, if you opened the DWG in AutoCAD, you would not see the applied materials.

Revit offers many options for specifying a material to an object or class of objects. Likewise, there are many ways where material assignments can be overridden. The results you see in the 3ds Max scene, in terms of how the materials are applied, match what you see in the Revit model.

The exception to the rule would be if many of the materials are AccuRender procedural materials. In these cases, you will see only the diffuse color.

**Texture Coordinates**

Material textures on imported or linked objects have the same appearance as within Revit or AccuRender. Of course, the exception to this rule is when AccuRender procedural textures are used.

When materials from Revit are viewed in the 3ds Max Material Editor, you’ll notice that some settings are not translated or they are not set as you’re used to seeing in 3ds Max. For example, if the texture map of a flooring material has a rotation of 45 degrees in the Revit project, the rotation setting does not
translate when the model is linked/imported to 3ds Max. The rotation for the texture map is set to zero in the 3ds Max Material Editor.

**Map Scaling**

The scale of material textures is of primary importance. The File Link Manager or DWG/DXF Importer attempts to read and translate the offset and tiling of the materials so the texture maps appear in 3ds Max as they do in Revit.

However, map scaling may differ because the Tile Size settings in Revit are measured in decimal feet or meters even if your Project Units are set to Decimal Inches or Millimeters. Once the model is linked or imported to 3ds Max, you can turn on Use Real-World Scale and match the Tile Size settings. The main thing is to pay attention to the Tile Size settings when you create the material in Revit.

As an example, let’s say you’ve created a material in Revit that uses a brick texture map with an X: Tile Size set to 20 and a Y: Tile Size set to 16. If you open that material in the 3ds Max Material Editor, you will find that the Width and Height Size settings are automatically set to 20’ and 16’ respectively. The texture mapping will always be scaled correctly in the scene. How a material is displayed in the Material Editor depends on whether Use Real-World Scale is turned on or off.

**See also:**

- Propagate Materials to Instances on page 5674

**Applying Materials to Linked Revit Objects**

As with models that are imported or linked from AutoCAD Architecture, there are special behaviors exhibited with materials assigned to linked Revit objects. The behavior is controlled by the Propagate Materials To Instances toggle on page 5674.

When applying materials to a linked drawing in 3ds Max, family and type plays an important role in material management. Assigning a material to any component of any linked Revit object is equivalent to assigning the same material to every instance of that component in every object with the same family and type throughout your scene.

As an example, say you have multiple instances of a Doors <Single-Flush : 34” x 80”> door in your drawing, which consists of three components: two Frame/Mullion components representing the inside and outside trim and a
Panel component. If you assign a material to one Panel component anywhere in your 3ds Max scene, all the Panels for all the Doors of that family and type throughout the scene will receive the new material.

If you want to keep materials from propagating between instances in your scene, turn off the Propagate Materials To Instances toggle on page 5674 from the Material Editor's Options menu.

See also:
- Instanced Objects on page 7527
- Blocks on page 7528

Editing Revit Materials in 3ds Max

Once a drawing is linked or imported to 3ds Max, you can modify or replace the materials. The File Link Manager maintains a list of materials that it links to 3ds Max. If you change the properties of an assigned material while working in 3ds Max, the new properties can get overwritten the next time you reload an updated drawing, exported from Revit.

During a File Link reload, if the Show Reload Options switch is turned on, you can control how materials are handled by using the Use Scene Material Definitions or Use Scene Material Assignments on Reload options.

AccuRender Materials

AccuRender materials consist of one or more base materials. For each base material you can set attributes such as color, reflectivity, transparency, index of refraction, bump maps, and image maps.

The Procedures list displays the simple materials that combine to form your final material definition and the rules for combining them. For simple materials, there is only one item in the list: Base. For complex materials, a tree indicates how the components combine. For example, the marble procedure consists of a Base material and a Vein material. While the Base material is considered a 'procedure', it is translated because it's at the bottom level of the material. The Vein material is ignored.

AccuRender materials that are applied to objects in the Revit drawing are translated when you link or import the drawing to 3ds Max. If the texture used for the material is a digital bitmap like a BMP or JPG file, the texture will be included with the material.
However, if the texture being used is one of the Procedures, the texture is not translated when the drawing is brought into 3ds Max. In these cases, you will see only the diffuse color.

See also:

- Material Editor, Materials, and Maps on page 5619

Procedures

To retain material settings made in 3ds Max during a reload:

1. On the Files panel of the File Link Manager, make sure the Show Reload Options switch is active.
2. Select the updated DWG file from the Linked Files list and click Reload.
3. Open the Advanced tab and turn on Use Scene Material Definitions and then click OK.

The updated DWG file is reloaded and Revit materials retain the setting changes you made in 3ds Max.

UVW Mapping on Revit Elements

An important consideration in how many materials render is how they are “mapped” to the surfaces of the objects they are assigned to. This is especially important for materials that use bitmaps to define the diffuse color of a material, or the bump and cutout special effects.

As an example, you might have scanned a picture of wood grain for use in a material, but when the material is applied to an object, how large should the image of the wood grain be? Which way do you want the grain to run, and how do you want the grain to wrap around the corners of a three-dimensional object?

How two-dimensional maps are applied to three-dimensional surfaces is represented by mapping coordinates, which are stored as UVW coordinates on page 8754. Revit assigns UVW coordinates to object components, so in cases where mapping coordinates are important to the rendered appearance of an object, 3ds Max translates these coordinates and stores them in the object mesh that is displayed and rendered in the 3ds Max scene.
Using Revit Materials on 3ds Max Geometry

After you've linked a DWG file that has been exported from Revit, you may find that some of the materials that were created in Revit could be used on new geometry you're adding while working on the model in 3ds Max. Reusing a material is often easier than creating a brand new one.

For example, let's say a wall element in the Revit project has a brick material that you'd like to use on an object you added to the model while working in 3ds Max. If you simply apply the material to the new object, you'll find that the texture map does not show as it does on the wall that came from Revit. This is because UVW coordinates of the new object are not set up to coordinate with the Tiling parameters of the Revit material.

When using Revit materials with objects created in 3ds Max, there are really two things to keep in mind:

- All materials from Revit use real-world scaling.
- Real-world scaling must be active for objects you've created in 3ds Max.

There are a few ways to make sure your 3ds Max objects are using real-world scale.

- If you're working with a primitive object, like a box or cylinder, make sure Real-World Map Size is active.
- For more complex objects, apply a UVW Map modifier on page 1932 and make sure Real-World Map Size is active.
- Assign the object a MapScaler modifier on page 1487.

Instanced Objects, Elements, Blocks, and Styles

The primary structural entities you will find in a model or project that is linked/imported to 3ds Max from AutoCAD, AutoCAD Architecture, or Revit are style-based objects on page 7535 (in ADT models), family elements (in Revit projects) or blocks on page 7528 (in both ADT and AutoCAD files). Each style-based object, family element, or block will most likely have many instances on page 7527 in the 3ds Max scene.

- Instances are multiple occurrences of objects such as style-based objects or blocks that are clone instances. When you link a model or drawing that
contains instanced objects to 3ds Max, those objects remain instances of one another.

- **Family Elements** in a Revit project represent different items of a building and are separated into two general categories; Model and Annotation. The Model category includes such elements as walls, doors, windows and stairs while the Annotation category includes dimensions, text notes and section tags. When a DWG is exported from Revit and linked to 3ds Max, elements appear in the Modifier panel as **Block/Style Parents** on page 8525, meaning you've selected the element at its topmost level, or as **Linked Geometry** on page 8620, meaning one of the element's subcomponents.

- **Blocks** are reusable objects made in AutoCAD or Architectural Desktop. Blocks are made of one or more objects that can be inserted into a scene at different locations, scales and orientations. Blocks can also be an amalgam of other blocks. A block that is made of other blocks is referred to as a **nested block**. Once linked to 3ds Max, blocks appear in the Modifier panel as VIZBlocks, meaning you've selected the block at its topmost level, or as Linked Geometry, meaning one of the block's subcomponents.

**NOTE** If you use one of the “node hierarchy” Derive By settings, you will see Block/Style Parent objects in the Modifier panel and not VIZBlocks.

- **AutoCAD Architecture style-based objects** are complex objects like Doors and Windows whose components rely on style definitions to control how they appear in the scene. For example, style definitions for a door set the type of door, the door thickness, the materials assigned to the various components, and so forth. Altering the style definitions changes the appearance of the object in the scene.

See also:

- **Object Properties** on page 283

### Instanced Objects

Instanced objects are AutoCAD, Revit, or AutoCAD Architecture objects or blocks that you can drag and drop into 3ds Max.

Modifiers and materials that are applied and assigned to an instanced object propagate throughout all instances of the object. For example, if all the doors in a scene have glass panes and you change the glass material of one door, all
the doors of the same style will adopt that material. Propagation of materials can be controlled by toggling Propagate Materials To Instances on page 5674.

Once you link a model to 3ds Max, instanced objects can be transformed (moved, rotated, or scaled). If you don’t like the way an object is transformed, you can use the Undo command or Reset Transform button on page 7504 on the Modify panel.

**Family Elements**

When modifiers and materials are assigned to family elements that are imported or linked to 3ds Max, they propagate throughout all instances of the element if their family and type match exactly.

For example, one particular part of your model shows a room with three doors. Two of the doors are *Doors <Single-Flush : 32” x 80”>* and the third is a *Doors <Single-Flush : 36” x 80”>*. If you change the panel material of one of the *Doors <Single-Flush : 32” x 80”>* doors, the panel of the other *Doors <Single-Flush : 32” x 80”>* door will also change because their family, *Doors*, and type, *Single-Flush : 32” x 80”*, are identical.

Propagation of materials can be controlled by toggling the Auto Material Propagation Toggle on page 5674.

**Blocks**

The concept of blocks originated in AutoCAD. Blocks allow you to combine one or more objects into a single reusable object. As you work in AutoCAD or AutoCAD Architecture, you can insert blocks repeatedly in the drawing at various locations, orientations, and scales. If you change a block, the changes propagate automatically to all instances of that block throughout the drawing.

You then link the DWG file to 3ds Max, where your goal is to beautify the scene in preparation for rendering. Some of those preparations include such procedures as selecting a block instance so you can apply or adjust a material, applying texture mapping coordinates, unifying or flipping normals, and setting rendering properties. These procedures affect all other block instances in the scene.

The structure of nested blocks, blocks that are made from multiple sub-blocks, is maintained when you link an AutoCAD or AutoCAD Architecture drawing to 3ds Max. For example, if the block *Desk1* is made using several blocks, *Desk*, *Chair* and *Return*, you will be able to select any of *Desk1*’s sub-blocks to alter
their rendering properties or materials. You can only access rendering properties for block components that appear as Linked Geometry on the Modifier panel. Blocks or sub-blocks, that appear as VIZBlocks in the Modify panel, do not have rendering properties because they are not renderable.

**NOTE** A change to the drawing in AutoCAD or AutoCAD Architecture is reflected in 3ds Max when you reload the linked model. Changes made in 3ds Max do not propagate back to AutoCAD or AutoCAD Architecture.

**Block and Modifying Linked Geometry**

Linked objects show up as *linked geometry* objects in the modifier stack. These objects don't allow access to sub-object levels where minor editing can occur at Vertex or Face levels. You must first add an Edit Mesh modifier to the object in order to access sub-object levels where you can perform operations like welding vertices or deleting faces. If you add a modifier to a block, the modifier is applied to all instances of that block. Likewise, any sub-object level editing to the originally selected block propagates to all other instances.

**NOTE** Any modifiers you apply to a block or block component in 3ds Max are preserved if you reload the file with the [File Link Manager](#) on page 7538.

If you move, rotate, or scale blocks or block components in 3ds Max, their new transform is preserved even if the linked model is reloaded from AutoCAD. Transforms applied to linked geometry in 3ds Max are relative to the transforms applied to the same objects in AutoCAD. Further, the transform propagates to all instances of that block or component. For example, if you move the *Chair* component of *Desk1*, the *Chair* component of all *Desk1*s in the scene will be moved. If the transform is undesirable, you can use the [Reset Transform button](#) on page 7504 on the Modify panel to put the block or component back to its original position.

When a modifier is applied to a block or block component, it propagates throughout all instances of the block or block component in the scene.

**Limitations of Blocks**

Blocks have some limitations when you link a drawing to 3ds Max.

- You cannot change the structure of actively linked blocks or their components in 3ds Max. In order to delete a block or component, you will have to bind the file, breaking the link.
You cannot change the color of linked blocks or their components. Their color is set by layer when they're built in AutoCAD or AutoCAD Architecture.

You can only access rendering properties for block components that appear as Linked Geometry on the Modifier panel. Blocks or sub-blocks, that appear as VIZBlocks in the Modify panel, do not have rendering properties because they are not renderable.

You cannot collapse the modifier stack of an actively linked object.

Layer assignments of linked geometry cannot be changed in 3ds Max if an object is actively linked. Layers can be reassigned if the model is bound.

Cloning a block or block component is not possible if it is actively linked. You cannot select a block and use Shift+drag to duplicate it. This is also true for tools like Array, Mirror, and the Spacing Tool. Once a block or block component is bound, you can clone it.

Blocks and Materials

When assigning a material in 3ds Max to an instance of a block or block component, all the instances of that block or component are assigned the same material automatically. This is called automatic material propagation. This feature helps align 3ds Max behavior with that of AutoCAD Architecture.

If you find that a material you've assigned to a block or block component is not what you wanted, you can undo the material assignment by choosing Edit menu > Undo or pressing Ctrl+Z. If you undo a material assignment, the undo will propagate to all instances of the objects to which you assigned the material.

NOTE When assigning a material to a block or block component, you are not prompted to accept or cancel the material propagation. You can only control propagation of materials by toggling Propagate Materials To Instances on page 5674.

For more information about working with materials and assigning materials to blocks in 3ds Max, see the Material Editor, Materials, and Maps on page 5619 topic.
Multi-View Blocks (MVBlocks)

3ds Max accommodates both AutoCAD blocks and AutoCAD Architecture multi-view blocks through the file linking functionality, and for the most part, the two block types behave similarly in 3ds Max with some exceptions.

The structure of AutoCAD Architecture multi-view blocks is expressed differently than AutoCAD blocks in 3ds Max. Rather than peer into the internal structures of multi-view blocks, as is done with AutoCAD blocks, 3ds Max relies on the multi-view block's own ability to draw its own 3D view, much as it does in the AutoCAD Architecture Object Viewer. Because of this, you will notice that multi-view blocks never exhibit nesting in their object structure when they are file linked into 3ds Max.

Behavior of instanced AutoCAD Architecture multi-view objects is different from that of AutoCAD blocks as well. Multiple instances of multi-view blocks require more memory in 3ds Max than do multiple instances of AutoCAD blocks. But multiple instances of multi-view blocks are better behaved when being cut by live section objects than their AutoCAD counterparts.

Dynamic Blocks

The File Link Manager handles dynamic blocks the same way as other blocks found in a DWG file. When linked to a scene, the naming for the incoming dynamic block instances are based on the original dynamic block definition in the form of Block: block_name where block_name is the actual name of the dynamic block definition.

Dynamic block instances, even those that have been grip-edited, display certain types of instance behavior such as material propagation, if the setting is activated from the Material Editor Options menu on page 5666. Below is a table showing instance behavior of dynamic blocks.

<table>
<thead>
<tr>
<th>Property</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modifiers</td>
<td>Modifiers applied to one component are applied to the same component in other instances, but only when those instances have the same grip property values.</td>
</tr>
<tr>
<td>Materials</td>
<td>When material propagation is turned on, materials are applied to all block instances. When turned off, materials...</td>
</tr>
</tbody>
</table>
BehaviorProperty

are applied only to the current selection set.

NOTE If you use the Entity, Blocks as Node Hierarchy Derive By setting for drawings containing dynamic blocks, materials may propagate to some block instances and not to others.

<table>
<thead>
<tr>
<th>Property</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node Properties</td>
<td>Changes to node properties are not propagated to block instances.</td>
</tr>
</tbody>
</table>
| Transforms (on compon-
| ents)                | Transforms, like move, rotate and scale, of one component will affect that same component in other block instance only when those instances have the same grip property values. |

Keep in mind that elements of a dynamic block can be turned on and off by certain grip-edit operations depending on the way the dynamic block is defined. When one instance has a component and another doesn't, instance behaviors cannot occur between them because they are treated as instances of one another.

**Modifier behavior of Dynamic Blocks during a File Link Reload**

There is no change in modifier behavior for dynamic blocks that have not been grip-edited between one Reload and the next. All properties (materials, modifiers, node properties) are preserved. Dynamic blocks that have been grip-edited preserve their node name, node properties, scene-applied transform, and materials, but may lose applied modifiers and/or may inherit modifiers. This table shows the behavior of modifiers during a File Link Reload before and after dynamic block editing.

<table>
<thead>
<tr>
<th>The Block Insert ...</th>
<th>... has unique parameter values</th>
<th>... has unique parameter values</th>
<th>... shows this modifier behavior upon Reload.</th>
</tr>
</thead>
</table>

| Chapter 21   Managing Scenes and Projects |
Blocks and Interactive Selection and Navigation

Once blocks and block components are linked to 3ds Max, you can begin adjusting their materials and properties. In a drawing for a small apartment, blocks are pretty easy to locate because the drawing is not very congested. You can simply select a block or one of its components in the viewport and alter it.

With complex drawings, finding the block or block instance you want can pose a problem. For example, a common block you might add to a drawing is a table. If you're designing a corporate headquarters that makes use of several different types of tables, finding the one you want to change becomes more difficult. There are several ways for you to find and select a block more precisely in 3ds Max.

One way is by means of the block's name. When you link a drawing to 3ds Max, file linking creates a name such as Block: ConferenceTable. The first part of the name identifies the object's type, Block. The second part of the
name indicates the block name, *ConferenceTable*. With this sort of naming breakdown, you can easily find a block using the Select From Scene dialog on page 206.

- Another selection method uses the Layer or Color setting you made for your block when you created it in AutoCAD Architecture. Because layer and color data is also linked to 3ds Max, you can select entire groupings of blocks using Select By Color or Select By Layer.

- Finally, you can select blocks by the type of material that's applied to them. Take care when selecting blocks this way because the material assigned to the block may also be assigned to other objects in the scene. Once you've selected a block or set of block instances, you can isolate them from the remainder of the model to work on them more efficiently.

**To select a block by color:**
1. Choose Edit menu > Select By > Color.
2. Select a block in the scene.
   All blocks that share that color are selected.

**To select blocks by name:**
1. Choose Edit menu > Select By > Name, or press the H key to open the Select From Scene dialog on page 206.
2. While holding down the Ctrl key, select blocks with common names.
   You can also enter the block name in the name field at the top of the dialog.
3. Click Select.
   All blocks that share the specified name are selected.

**To select blocks by layer:**
1. Choose Edit menu > Select By > Layer.
2. Select a block in the scene.
   All the blocks sharing that layer are selected.

**To isolate selected objects:**
1. Using one of the previous selection methods, select some blocks.
Choose Tools menu > Isolate Selection.
This hides all objects except for the selected blocks. A dialog is opens, indicating that isolation mode is active.

**Styles**

Styles are sets of parameters that you can assign to objects in AutoCAD Architecture to determine their appearance. This means an AutoCAD Architecture object references a style in order to determine certain aspects of its appearance.

For example, a door style determines the type of door represented in the drawing, such as single or double hung, bifold or hinged, solid core or glass pane. You can assign one style to more than one object, and you can modify the parameters of that style to change all the objects that have the same style assigned to them.

For more information about how to work with styles in AutoCAD Architecture, refer to the *AutoCAD Architecture Reference*.

A style is made up of components. Each component defines dimensions and display properties per view. For example, the hatch pattern defined for component1 in Plan view can be different from the hatch pattern for the same component in Model view. Styles are grouped in categories that mirror the categories of AutoCAD Architecture objects. You perform model management, such as creating and deleting styles and style-components in AutoCAD Architecture, and reload the modified scene into 3ds Max using the File Link Manager utility on page 7538.

When a model is linked to 3ds Max from AutoCAD Architecture, styles play an important role in assigning render materials and texture coordinates to AutoCAD Architecture object components described by style components.

Components of an AutoCAD Architecture object often have predefined materials in their style definitions. This means that if you have many instances of an object in your drawing, you can quickly replace materials on all the objects without having to select each instance of the object.

'Style-based objects' is a more common term for AutoCAD Architecture objects that reference styles.
Limitations of Styles

Styles-based AutoCAD Architecture objects do have some limitations when a model is linked to 3ds Max.

- Changes to styles and their components performed in 3ds Max will not propagate back into AutoCAD Architecture.
- You cannot use any transform commands (Move, Rotate, or Scale) to clone an object that has an actively linked style. You have to make that type of change in AutoCAD Architecture.
- The structure of a style-based object in 3ds Max cannot be changed. You cannot add components to or delete them from a linked object.
- Objects on frozen layers in AutoCAD Architecture will not be displayed when the model is linked to 3ds Max.

**NOTE** This is not the case when Skip All Frozen Layers is turned off in your File Link settings.

Styles and Materials

The primary purpose of linking a model from AutoCAD Architecture to 3ds Max is preparing the scene for presentation to your clients and rendering. AEC Objects are made up of components that have default architectural materials assigned through their styles. You can select components from the Select From Scene dialog on page 206 or the Scene Explorer on page 7888, and you can assign new materials or alter the existing material in the Material Editor.

For example, a door that is assigned the “Hinged – Single – Full Lite” style is made up of five components in AutoCAD Architecture: the Frame, Panel, Stop, Glass, and Muntins. Each component has a material assigned to it. For instance, the default material assigned to the Panel component of this type of door is “finish carpentry.wood.mahogany.” To change the Panel material in 3ds Max, you can select the Panel component and drag a new material to it from the Material Editor.

Because the Panel material is part of the door’s style, your new material automatically propagates to any other door in the scene that is assigned the “Hinged – Single – Full Lite” style.
NOTE If you need to apply a material to individual objects, or object selections, rather than to all objects of the same style, you can use the command Propagate Materials To Instances on page 5674.

For more information about working with materials and assigning materials to objects in 3ds Max, see Materials on page 5619.

**Styles and Interactive Selection and Navigation**

Architectural drawings range from simple sketches to highly complex floor plans, so finding different components of a drawing can be difficult. Style-based objects from AutoCAD Architecture all have styles associated with them. So if you link a drawing to 3ds Max, objects with styles will be associated with them both in AutoCAD Architecture and in 3ds Max. Furthermore, in 3ds Max, the name of the object will contain the AutoCAD Architecture object category name (Door, for example), style name (Double Hinged) and component name (Panel).

You make most object and component selections in 3ds Max by selecting objects in the viewports. However, in complex models where objects and components may be spread across multiple layers or located in congested areas, style definitions help streamline the selection of reusable components in a drawing.

Once objects and components are selected, you can also isolate them from the remainder of the model to work on them more efficiently.

**To select objects by style:**

The Select Similar command has the same function in 3ds Max as it does in AutoCAD Architecture.

1. In a scene imported or linked from AutoCAD Architecture, select an object that contains the style of interest.
2. Choose Edit menu > Select Similar.
   All objects or components that share that style, as defined in AutoCAD Architecture, are selected.

**To select objects or components by color:**

1. Choose Edit menu > Select By > Color.
2. Select an object in the scene.
   All objects or components that share that color are selected.
To select objects or components by name:

1  Choose Edit menu > Select By > Name, or press the H key to open the Select From Scene dialog.
   Alternatively, you could use the Scene Explorer on page 7888, accessed from the Tools menu. While functionally similar to the Select From Scene dialog, the Scene Explorer is modeless and can remain open while you're working.

2  While holding down the Ctrl key, select objects or components with common names.
   You can also enter the object or component name in the name field at the top of the dialog.

3  Click Select.
   All objects or components that share the specified name are selected.

To select objects or components by layer:

1  Choose Edit menu > Select By > Layer.

2  Select an object in the scene.
   All objects or components that share that layer are selected.

To isolate selected objects:

1  Using one of the previous selection methods, select some objects.

2  Choose Tools menu > Isolate Selected.
   All objects are hidden except for the selected objects or components. A dialog appears indicating that isolation mode is active.

File Link Manager Utility

Utilities panel > Utilities rollout > Click the More button. > Utilities dialog > File Link Manager

Application Menu on page 7989 > References > File Link > File Link Manager

The File Link Manager utility allows you to work in either another design software's environment (such as AutoCAD) or in 3ds Max while maintaining a single design database. If you use AutoCAD drawings, this feature works
with drawings from AutoCAD Release 12 through AutoCAD 2005, including
the AutoCAD Mechanical/Architecture and Revit applications.

You can establish, refresh, and break links to any number of linked files. You
can also edit out unnecessary information by using layers and other filters.
The File Link Manager defines which geometry is included in the 3ds Max
scene from the linked file, how the geometry is organized, and when it's
regenerated.

The objects that you bring in from linked files behave just like any other object
created in 3ds Max. You can scale, rotate, and move them, as well as attach
modifiers and materials.

You can also refresh or break links to linked files. When you refresh a linked
file, any changes you've made to the linked file are applied to geometry in
your scene. Note, however, that 3ds Max won't edit or change your original
linked file. The integrity of your other software's design database is never
compromised with the File Link Manager.

Finally, if you decide to break a link to a linked file, you can either keep the
objects from the linked file in your scene or have them removed along with
the link.

TIP For optimal speed when bringing a DWG file that contains a lot of text into
3ds Max, use Import on page 7666 rather than File Link.

See also:

■ File Link on page 7491

■ File Link Tips on page 7495

■ Working with AutoCAD, AutoCAD Architecture, and Revit Files on page
  7501

Support of Multiple Materials on Linked ACIS Solids

3ds Max supports multiple materials per object in DWG files exported as ACIS
solids from Revit Architecture/Structure/MEP 2008 and later, as well as solid
primitives created in AutoCAD Architecture 2008 (formerly ADT) and later.
Linked solids can have Multi/Sub-Object materials on page 6120 that you can
view and manipulate in the Material Editor.
NOTE Previous versions of 3ds Max supported multiple materials for polymeshes but only one material ID for each ACIS solid when linking a DWG file, regardless of how many material IDs had been assigned to the solid.

Process

When 3ds Max links a ACIS solid DWG file from AutoCAD or Revit Architecture (version 2008 and later) with either the Layer, Blocks as Node Hierarchy, Split by Material” or the Entity, Blocks as Node Hierarchy derivation methods, multiple material IDs are read and editable as Multi/Sub-Object materials in the Material Editor.

3ds Max reads each face of a linked ACIS solid to determine if it contains any material IDs that it can read. If more than one material ID is read from a solid, each material ID is translated to a material ID on file link and re-assigned to the object.

3ds Max creates Multi/Sub-Object materials only if more than one material ID is found; if an ACIS solid contains only one material ID, a standard architectural material is created and assigned instead.

NOTE 3ds Max first evaluates the linked file to find any Revit material IDs, and then looks for AutoCAD material IDs.

NOTE If you link a DWG file with the Layer, Blocks as Node Hierarchy, Split by Materials” derivation method, the solid is not split to reflect its materials set.

Multi/Sub-Object Material Naming

In earlier versions, 3ds Max read the material ID information from the color ID of the AutoCAD/Revit material ID’s face. Now, 3ds Max creates a Multi/Sub-Object material for every translated per face material ID each time you link a DWG file that contains an AutoCAD/Revit solid.

When 3ds Max finds multiple materials assigned to an ACIS solid and creates a Multi/Sub-Object material, it consists of instances of standard architectural scene materials.

Naming Conflicts

Material IDs are unique within one DWG file. However, the same material ID can appear in two different files, such as Basic Wall: Generic – 12” Masonry. If a naming conflict arises when two scenes are merged, 3ds Max applies the last loaded material used in the Multi/Sub-Object material.
For example, if file1.dwg and file2.dwg both contain a material named Brick, and they are both linked, the Brick material used is the one from the second file (file2.dwg).

Or, if file1.dwg contains a material named Brick that is internally stored as material ID 222 and file2.dwg contains a different material stored as ID 222, the material used in the scene when they are linked is file2.dwg’s material.

If two solids share the same material ID, they will share the same Multi/Sub-Object material.

**Non-AutoCAD Materials**

3ds Max does not link non-AutoCAD material IDs. The only non-AutoCAD Architecture IDs it preserves are the Color IDs.

**ACIS Solids**

DWG ACIS solids link as solid objects in 3ds Max. You cannot separate faces of an ACIS solid object unless you apply the Edit Poly on page 1332 or Edit Mesh on page 1321 modifier.

**TIP** You can access the material ID value assigned to this face with the Edit Poly modifier.

**ACIS Solids and Materials**

ACIS solid materials display in the Material Editor along with any other linked material.

When you apply a bitmap material to an ACIS solid, it is applied to every side of the object. For example, a brick bitmap material that you apply to a wall object appears on both sides and all edges of the wall. If you want to apply a material to each face ID, you can use a multi/sub object material so you can assign sub-materials to each face ID.

When you link ACIS solids into 3ds Max, procedural textures are not supported, only materials. For example, a brick wall in Revit may have mortar lines procedurally drawn on it in red, but if the object is an ACIS solid, the mortar lines, which are procedural hatches, are lost in 3ds Max.

When an ACIS object’s materials display as Multi/Sub-Object materials in the Material Editor, each material name appears in the Material/Map Browser, for example, Default wall or Basic Wall: Generic – 12” Masonry.
**Polymesh**

Polymesh DWGs link as polymesh geometry in 3ds Max. Unlike ACIS solids, you can modify and edit any polymesh object's face.

**Polymesh Objects and Materials**

When you link a polymesh DWG file, each polymesh face is considered as a separate entity, with one material permitted per entity, which allows it to contain multiple materials.

You can apply a bitmap material to the different faces of polymesh geometry, unlike ACIS solids, where you would need to use a Multi/Sub-Object material to create the same effect. For example, you can select the outside face of a wall and apply a brick bitmap material and also apply a diffuse material on the inside wall to simulate white paint.

When you link a polymesh DWG file, every material used in the scene appears in the Material Editor as a separate material where you can edit it.

When a polymesh object's materials are shown in the Material Editor, each material name appears in the Material/Map Browser, for example, Default wall or Basic Wall: Generic – 12” Masonry.

**Procedures**

**To link a drawing file:**

You can link drawings in the form of DWG or DXF files. A DWG is the native file format for AutoCAD and AutoCAD Architecture, but you must first export a DWG when working from a Revit project. The File Link Manager does not recognize RVT files.

1. Choose **Application Menu** on page 7989 > Import > File Link.
2. On the Attach panel, click Files to select a file from the appropriate directory on either your local or network system, and click Open.
3. Choose a Preset from the pull-down list, if you have one defined.
   
   **TIP** If this is your first File Linking, and you have not defined any presets, you may want to create one on the **Presets panel** on page 7564 of the dialog.

4. Turn on the Rescale switch and adjust the Incoming File Units, if necessary.
5. Click Attach This File.
To reload a drawing:

Reload is most often used when your drawing or project has been changed in AutoCAD, AutoCAD Architecture, or Revit, or if the linked drawing file has been moved and you have to tell the File Link Manager where to find the drawing.

**NOTE** If your Revit project has been updated, remember to export a new DWG file that can be reloaded.

1. On the Files panel of the File Link Manager, click the file name in the Linked Files list and click Reload.

   Linked files that have been changed are prefaced with the symbol.

   **TIP** Turn on the Show Reload Options switch if you want to make changes to the settings used to link the drawing. Otherwise, the reload process will use the same settings you originally used when creating the link.

2. If Show Reload Options is turned on, the File Link Settings dialog on page 7549 is displayed where you can change your settings in the Basic and Advanced panels.

   **NOTE** You cannot change the sorting or layer options when reloading a drawing.

3. Click OK to reload the file.

Interface

The File Link Manager dialog contains three panels for listing linked files:

- **Attach** on page 7544
- **Files** on page 7546
- **Presets** on page 7548

These panels let you attach files, update attachments and settings, and change presets used by File Link. The terminology is similar to the terminology for managing AutoCAD external references, or xrefs on page 8770.
NOTE An xref is an AutoCAD external reference. This is different from a 3ds Max Xref on page 8771, which is an externally referenced file that can be a 3ds Max object or scene.

## Attach panel

![File Link Manager](image)

**File** Displays an Open dialog that you can use the browse for DWG and DXF files that you want to link. When a file is selected, its path and name appears in the File list.

**File list** The file to be attached to your scene. You can enter the file location, or you can expand the list to display a history of the last ten attached files.

**NOTE** You can resize the File Link Manager dialog by dragging any corner or edge. This is useful for viewing a file path if it's too long to fit in the file list field.

**Preset** Displays a list of preset settings you can choose to use when attaching the file. Each list entry in this list represents a unique collection of attach and reload settings. You can create additional presets in the Presets panel of the File Link Manager dialog.

**Rescale** Alters the scale of the geometry from a linked file to match the system unit scale on page 8370 in 3ds Max. When Rescale is on, you can specify what the base units should be for the geometry in the linked file. For example, if the length of a line in the linked file is 2 units, you can specify that these units...
be considered as any of the units listed under File Units (below), such as inches, millimeters, or parsecs.
When Rescale is on, and the units you specify are different from the system units currently set in the 3ds Max scene, the incoming objects are scaled appropriately. For example, if a door measures 914 units in the linked file, and you specify millimeters to convert from, the door will measure 36 inches in the 3ds Max scene.

**NOTE** You can't change units when you reload a linked file.

**NOTE** By default, system units are inches in 3ds Max. Consider carefully before changing the default system units. For more information, see Using Units on page 2784.

**Incoming File Units** Displays the unit of measure found in the original drawing file and lists the units to which you can choose to rescale the attached file. This is only active when Rescale is on.

**Select Layers to Include** Displays the Select Layers dialog on page 7568, which you use to select the layers to import from the linked file.

**Attach This File** Attaches the selected file to your scene, using the settings selected in the Preset list, if one was selected.
To cancel the File Link operation press Esc. You can do this at any time during the process.
Cancelling the File Link operation removes every object the process has linked to the scene until the moment you press Esc.

**Close** Cancels all changes to settings and closes the dialog.
Files panel

**Linked Files** Lists linked files. The File Link Manager displays an icon next to the path name of each linked file. The icon reflects the status of the linked file, as described below:

- ![Icon](image)
  - The linked file hasn't changed and there are no errors.

- ![Icon](image)
  - The linked file can't be found at the specified location.

- ![Icon](image)
  - The linked file has changed or another file has been selected by changing the path or using the browser from this list. If you want to update your scene with the changes in this file, you must **reload** on page 7546 your link.

You can change the path name by highlighting it and clicking again to enter its location. This also displays a file browser button to the right of the file name that you can use to locate a file. If the directory of a linked file is no longer valid, then you must enter a new, valid path name.

**Reload** Refreshes the link between the file and the 3ds Max session. This feature is useful when the file has been modified and you want to see the changes reflected in your 3ds Max scene. If you turn on Show Reload Options, the **File Link Settings dialog** on page 7549 displays when you click this button. Changes that have been made to the base file will be applied to the objects at the bottom of the 3ds Max modifier stack. If you have 3ds Max materials...
applied to walls in a floor plan in your scene, the same materials are applied
to the walls when you reload an updated version of the linked file.
To cancel the File Link operation press Esc. You can do this at any time during
the process.
Cancelling the File Link operation removes every object the process has linked
to the scene until the moment you press Esc.

**NOTE** This option is available only when the file is highlighted in the Linked Files
list.

**Detach** Removes an existing link to a file. Detach also removes all geometry
associated with or dependent on the link.
When you click this button, you receive a warning that you're about to remove
all objects associated with the linked file. You can either proceed or cancel
the operation.

**NOTE** This option is available only when the file is highlighted in the Linked Files
list.

**Bind** Removes the link to the file. The geometry in the scene remains
unchanged, but it's no longer linked back to the original file and, if the original
file changes, it can't be updated using Reload.
When you click this button, you receive a warning that you're about to break
the link between the objects in the current 3ds Max scene and the file.

**NOTE** This option is available only when the file is highlighted in the Linked Files
list.

**Show Reload Options** Displays the File Link Settings dialog on page 7549 when
you click Reload, and uses these settings for reloading. When you turn off this
option, the File Link Manager uses the reload settings stored in the current
scene.

**Close** Cancels all changes to settings and closes the dialog.
Presets panel

- **Named Presets** Lists all existing presets.
- **Modify** Opens the File Link Settings dialog on page 7549, letting you change the settings of the selected preset.
- **New** Opens the New Settings Preset dialog on page 7564, creating a new preset with default settings.

**NOTE** New is only available when no preset is selected in the list. If a preset is selected, this button changes to Copy.

- **Copy** Opens the New Settings Preset dialog on page 7564, creating a new preset with the same settings as the currently selected preset.

**NOTE** Copy is only available when a preset is selected in the list. If no preset is selected, this button changes to New.

- **Rename** Opens the Rename Settings Preset dialog on page 7566, letting you change the name of the selected preset.
- **Delete** Deletes the selected preset.
- **Close** Cancels all changes to settings and closes the dialog.
File Link Settings Dialog

Application Menu on page 7989 > References > File Link > File Link Manager > Files tab > Turn on Show Reload Options. > Click Reload.

Utilities panel > Utilities rollout > More button > File Link Manager > Files tab > Turn on Show Reload Options. > Click Reload.

The File Link Settings dialog gives you control over the detailed aspects of how geometry is translated from DWG or DXF files and interpreted in 3ds Max. It also allows you to control whether only a portion of the 3ds Max objects will be affected by subsequent reloading. The File Link Settings dialog is displayed when Show Reload Options is turned on in the File Link Manager dialog, or when editing a file link Preset.

The File Link Settings dialog lets you:

- View and exclude layers in a linked file.
- Control how geometry is converted.
- Define how linked objects are converted to 3ds Max objects, referred to as VIZBlocks.

The selections you make in the File Link Settings dialog can affect the amount of memory used by 3ds Max to hold the linked data. Use the Select Layers To Include option on page 7558 to reduce the amount of information added to your scene.

In some cases, it might be more efficient to create multiple links to the same file, making different file link settings for each file.

See also:

- File Link Tips on page 7495

Basic File Link Settings

File Link Manager > Reload a linked file with Show Reload Options turned on. > File Link Settings dialog > Basic panel

File Link Manager > Presets panel > Highlight a preset and click Modify. > File Link Settings dialog > Basic panel
The Basic panel of the File Link Settings dialog on page 7549 defines how 3ds Max converts the linked file's objects into corresponding 3ds Max objects.

**Interface**

![File Link Settings: DWG Files](image)

- **Weld nearby vertices** Sets whether to weld nearby vertices of converted objects according to the Weld Threshold setting. Welding smooths across seams and unifies normals of objects with coincident vertices. Welding occurs only on vertices that are part of the same object.

---

7550 | Chapter 21  Managing Scenes and Projects
**Weld threshold** Sets the distance that determines whether vertices are coincident. If the distance between two vertices is less than or equal to the weld threshold, the vertices are welded together. To use the Weld Threshold, turn on Weld.

**Auto-smooth adjacent face** Assigns smoothing groups on page 8724 according to the Smooth-angle value. Smoothing groups determine whether faces on an object render as a smooth surface or display a seam at their edges, creating a faceted appearance.

**Smooth-angle** Controls whether smoothing occurs between two adjacent faces. If the angle between the two face normals is less than or equal to the smooth angle, the faces are smoothed (that is, put in the same smoothing group).

**Orient normals of adjacent faces consistently** Analyzes the face normals of each object and flips normals where necessary, so they all point in a direction that is consistent with adjoining faces. If the imported geometry isn't properly welded, or if the AutoCAD geometry did not contain or specify normal information, normals might be oriented in the wrong direction. Use the Edit Mesh on page 1321 or Normal on page 1551 modifiers to flip normals.

When Unify Normals is off, normals are calculated according to the face vertex order in the linked file. Face normals for AutoCAD solids are already unified. Turn off Unify Normals when importing only AutoCAD solid models from AutoCAD Architecture.

**Cap closed splines** Applies an Extrude modifier on page 1425 to all closed objects, and selects the Cap Start and Cap End options of the modifier. The Extrude modifier Amount value for a closed object with no thickness is set to 0. Capping makes closed objects with thickness appear solid and closed objects without thickness appear flat. When Cap Closed Objects is off, the Extrude modifier Cap Start and Cap End options for closed objects with thickness are clear. No modifiers are applied to closed objects without thickness.

**TIP** Unless you chose the One-to-One sorting option, you won't immediately see the Extrude modifier when selecting an object. To see it, look through the modifier stack for the VIZBlock on page 8758 sub-objects. In a nested VIZBlock, the Extrude modifiers appear at the bottom of the stack. You can then edit the Extrude modifier parameters.

**Texture Mapping** The texture mapping setting can reduce the loading time of models that have many objects with stored UVW Coordinates for texture mapped materials.
NOTE This setting applies only to geometry that is stored as a mesh in the scene. Spline shapes marked as renderable have separate controls for UVW coordinate generation; these are found on the Spline Rendering panel on page 7561.

- **Generate Coordinates For All Objects**  Automatically generates UVW coordinates for all objects when the drawing is linked. This option tells the File Link Manager to create UVW coordinates, but loading time is increased while the coordinate generation occurs.

- **Generate Coordinates On Demand**  Does not generate texture coordinates for linked mesh objects. Actively linked objects generate UVW coordinates on demand, so if you assign a material to an object and the material requires texture coordinates, the texture coordinates are silently assigned to that object. If the material or texture map is set to display in viewport, the coordinates are assigned as soon as the material is applied; if not, the coordinates are assigned when the scene is rendered.

  This option gives you faster loading speed, but no UVW coordinate generation.

NOTE Objects in drawings created in AutoCAD Architecture pass texture coordinates explicitly to 3ds Max when you attach the drawing. If you specify on-demand coordinate generation, they might not match the coordinates that were specified in the original drawing. The map scaling is the same, but the texture offsets may be altered.

**Curve steps** For objects such as splines, the number of knot points determines the spline’s shape and curvature. The Curve steps value defines the number of segments between knot points. A low value gives you a more linear interpolation between the knot points; a higher number gives you a more accurate curve.

**Maximum surface deviation for 3D solids** Specifies the maximum allowable distance from the 3ds Max surface mesh to the parametric AutoCAD solid surface. Small numbers produce more accurate surfaces with a greater number of faces. Large numbers produce less accurate surfaces with fewer faces.

**Include group**

This group allows you to toggle the inclusion of specific parts of a DWG file during the file link process.

**External references** Imports xrefs attached to the DWG file.
Lights Imports lights from pre-AutoCAD 2007 DWG files.

Sun and Sky Imports Sun and Shadows position from the drawing file (AutoCAD / AutoCAD Architecture 2008 and Revit 2008 only).

**NOTE** You must set mental ray as the default renderer for you to see the Sun and Sky effect. To set mental ray as the default renderer, see Choose Renderer Dialog on page 6584.

Hatches Imports hatches from the DWG file.

**WARNING** This stores each line or dot in the hatch pattern as a separate spline that defines the hatch; this can create a very large number of objects in your scene.

Views and Camera Imports named views from the DWG file, and converts them to 3ds Max cameras.

**NOTE** Orthographic views do not translate correctly in imported DWG files. However, there are no problems with Perspective views.

Points Imports points from the DWG file.

**NOTE** The imported point objects are represented in 3ds Max as Point Helper on page 2853 objects.

UCSs (grids) Imports user coordinate systems (UCS) from the DWG file and converts them to 3ds Max grid objects.

**Advanced File Link Settings**

**Application Menu** on page 7989 > References > File Link > File Link Manager > Reload a linked file with Show Reload turned on. > File Link Settings dialog > Advanced panel

**Application Menu** on page 7989 > References > File Link > File Link Manager > Presets panel > Select an existing preset and click Modify. > File Link Settings dialog > Advanced panel

**Application Menu** on page 7989 > References > File Link > File Link Manager > Presets panel > Create a new preset. > Select the newly created preset and click Modify > File Link Settings dialog > Advanced panel
Utilities panel > Utilities rollout > More button > File Link Manager > Reload a linked file with Show Reload turned on. > File Link Settings dialog > Advanced panel

Utilities panel > Utilities rollout > More button > File Link Manager > Presets panel > Highlight an existing preset and click Modify. > File Link Settings dialog > Advanced panel

Utilities panel > Utilities rollout > More button > File Link Manager > Presets panel > Create a new preset. > Highlight the newly created preset and click Modify > File Link Settings dialog > Advanced panel

The Advanced panel of the File Link Settings dialog on page 7549 controls how 3ds Max derives AutoCAD primitives and whether 3ds Max uses the scene material definitions when linking to or reloading the AutoCAD drawing. It also lets you selectively reload your scene, so that you reload only specific objects, not the entire file.
Interface

Derive AutoCAD primitives by: Lists the options for deriving objects from the linked DWG file. This setting is available only when modifying a preset on page 7567.

NOTE This applies only to standard AutoCAD primitives. Specialized objects, such as those from AutoCAD Architecture, are handled differently.

TIP For best results, use the Layer, Blocks as Node Hierarchy or Entity, Blocks as Node Hierarchy options, except in special circumstances.
There are six options to choose from:

- **Layer, Blocks as Node Hierarchy**  Linked objects on a given layer in the AutoCAD drawing that aren’t in blocks are combined into a single Editable Mesh or Editable Spline object in 3ds Max. The name of each linked object is based on the AutoCAD object’s layer. The linked object name has a “Layer:” prefix and is followed by the layer name. For example, all AutoCAD objects residing on the layer Walls become part of the Editable Mesh named Layer:Walls after they are linked in 3ds Max.

Each block is linked separately as a hierarchy, with the block itself as the parent object and its constituent parts as child objects. The child objects of the block are combined by layer.

**TIP** This is usually the best option for file linking. It preserves all ADT information, and generally maintains the same granularity as you would expect in AutoCAD.

- **Layer, Blocks as Node Hierarchy, Split by Material**  This works the same as the Layer, Blocks as Node Hierarchy option, with the following additional functionalities: The combination of non-block objects by layer, followed by material and support for multiple materials assigned to ACIS solid and polymesh geometry.

  - Non-block object layer combination:

    For example, take an AutoCAD file with six objects in layer A: three have a Brick material and three have a Stone material. Using this option, this file would be linked to in the form of two objects, or nodes, one containing the Brick material and the other with the Stone material.

    Each block is linked to separately as a hierarchy, with the block itself as the parent object and its constituent parts as child objects. The child objects of the block are combined by layer.

- **Multiple material support**

  On import, ACIS solids and polymesh geometry can support multiple materials. For polymesh geometry, one material is supported per face. For an ACIS solid, if the solid has more than one material associated with it, a multi/sub object material is created that contains the materials used. If the solid has only one material associated with it, a standard/architectural material is assigned instead.
**NOTE** Multiple material support for ACIS solids applies to DWG files imported or file linked from Revit Architecture 2008 or AutoCAD Architecture (formerly Architectural Desktop or ADT) 2008 and later.

**NOTE** This derivation method is intended for use with AutoCAD 2007 (and later) format files. Using this method with DWG files created with previous versions of AutoCAD could result in data loss.

- **Entity, Blocks as Node Hierarchy** Every linked object not in a block is represented as a separate object in the 3ds Max scene, without regard to layers. The nodes are then placed on scene layers that correspond to the drawing layers. Each block is imported separately as a hierarchy, with the block itself as the parent object and its constituent parts as child objects. The child objects of the block are combined by layer.
  One benefit of this option is that you can apply *instanced animation controllers* on page 3399 to block subcomponents and thus, by transforming a single member, transform all members at once. For example, in a scene containing a conference table with six chairs around it, you could move all of the chairs simultaneously by moving a single chair.
  Another advantage is that all geometry is instanced, so edited UVs and normals and other modifications need be done only once.

  **NOTE** This derivation method might cause unreliable material propagation when importing drawings containing dynamic blocks. Materials might propagate to some block instances and not to others.

**WARNING** This option has the potential to create an enormous number of objects in your scene.

Multiple materials per object are supported with this option, if needed. If the object is an ACIS solid, and has more than one material associated with it, a multi/sub object material is created containing the materials that can be edited in the Materials Editor. If the solid has only one material associated with it, a standard/architectural material is assigned instead. If the object is polymesh geometry, one material per face is supported.

**NOTE** Multiple material support for ACIS solids applies on the DWG files imported or file linked from Revit Architecture 2008 or AutoCAD Architecture (formerly Architectural Desktop or ADT) 2007 and later.

- **Layer** Linked objects are combined in 3ds Max according to their layer. Objects in each of the associated application's layers are combined into
one object, with the exception of blocks, each of which is represented as an individual VIZBlock (not a hierarchy). Multiple inserts of the same block are represented using instances in the scene. Material assignments are lost but material IDs are preserved.

- **Color**  Linked AutoCAD objects are combined in 3ds Max according to their color. All objects of the same color are combined into one object, with the exception of blocks, each of which is represented as an individual VIZBlock (not a hierarchy). Multiple inserts of the same block are represented using instances in the scene. Material assignments are lost but material IDs are preserved.

  **NOTE**  Blocks can contain objects with different colors. However, when sorting, 3ds Max considers only the color of the block itself. Also, 3ds Max objects can only display one color, unless a material is applied.

- **Entity**  Provides a one-to-one correspondence between AutoCAD objects and 3ds Max objects. For each linked object or block in the imported file, the File Link Manager creates an independent object or VIZBlock, respectively, in the scene. Material assignments are lost but material IDs are preserved.

  **WARNING**  This option has the potential to create an enormous number of objects in your scene.

  **NOTE**  When working with drawings exported from Revit, it is recommended that you do not use this setting.

- **One Object**  All linked objects are combined into a single VIZBlock. Material assignments are lost but material IDs are preserved.

**Select Layers to Include**  Displays the Select Layers dialog on page 7568, which you use to choose layers to import from the linked file. Available only when reloading a linked file.

**TIP**  Excluding unnecessary objects from linking can improve the performance of the reload operation.

**Create Helper at Drawing Origin**  When on, 3ds Max inserts the user coordinate system icon as an origin point helper. 3ds Max places this helper at the world origin of the linked file. It's a reference point for all the geometry of the linked file. After attaching, the helper is selected, allowing you to easily
move, rotate, or scale all the geometry that was just added to the scene. Each linked file gets a unique helper object.

This setting is available only when modifying a preset on page 7567.

**Use Extrude Modifier to Represent Thickness** When on, linked objects with thickness receive an Extrude modifier to represent the thickness value. You can then access the parameters of this modifier and change the height segments, capping options, and height value.

When off, objects with thickness (and closed capped objects) are converted directly to a mesh.

This setting is available only when modifying a preset on page 7567, and not using the Derive option Layer, Blocks as Node Hierarchy.

**Create One Scene Object for Each ADT Object** AutoCAD Architecture (formerly Architectural Desktop or ADT) objects are linked as a single object instead of being separated into their constituent components. This means that if you link an AutoCAD Architecture door object, the door is represented as one object instead of three. Turning on this switch make linking faster and the scene size is smaller.

This setting is available only when modifying a preset on page 7567.

**NOTE** This switch presents several modeling concerns that you need to be aware of.

- Material assignments from AutoCAD Architecture are not translated during the file link process.
- If you want to assign materials to these objects, use Multi/Sub-Object materials.
- Depending on the Texture Mapping option you choose, UVW coordinates are translated correctly.

**Use Scene Material Definitions** When on, 3ds Max checks the current scene for any currently used materials with the exact same name as a material name in the linked DWG file. If a match is found, File Link does not translate the drawing’s material, but instead uses the material defined in the scene.

When off, the File Link Manager always uses the material definitions contained in the DWG file, and will overwrite scene materials with the same name, regardless of which objects the material is applied to. All material definitions stored in the DWG file are reloaded (even when using a selective reload). If you make changes to a linked material, in 3ds Max, then reload, those changes will be lost (if the switch is off).
If Use Scene Material Assignments on Reload is on at the same time as Use Scene Material Definitions, standard/architectural materials, material assignments, and face material IDs are left as they are.

If Use Scene Material Assignments on Reload is off at the same time as Use Scene Material Definitions, only the material assignments and face material IDs are updated and standard/architectural materials are not translated.

**TIP** When reloading a file, most of the materials from the DWG file will have already been created in the scene by 3ds Max; they may not need to be re-translated. If you want to update a scene material with the definition contained in the drawing, turn this switch off.

**NOTE** Material name comparison is case-sensitive.

**Use Scene Material Assignments on Reload** When on, linked objects with a material already assigned to them in the 3ds Max scene will not have that material assignment changed. This is the case regardless of whether the material was assigned automatically by the File Link Manager or manually by the user. When off, linked objects have their material assignment “coordinated” with the drawing, so that the two are in sync.

If Use Scene Material Definitions is on at the same time as Use Scene Material Assignments on Reload, standard/architectural materials and material assignments are left unchanged.

If Use Scene Material Definitions is off while Use Scene Material Assignments on Reload is on, only standard/architectural materials are retranslated. Any material assignments and Face Material IDs are left unchanged, so Multi/Sub object materials are not retranslated but some sub-materials may have changed.

**Selective Reload** Lets you perform a partial reload of your linked file. Use a partial reload when you know what has changed in the linked file, and want to speed up the time it takes to reload the geometry.

The following options are available:

- **Selected in Scene** Reloads only the objects currently selected in your scene.

- **Selected in List** Reloads only the objects that you choose from a named list. This list is defined by clicking Linked Objects.

**Linked Objects** Allows you to reload only objects that you choose from a named list. The list is created from the objects linked in the file. When you click Linked Objects, the Select Linked Object dialog on page 7571 is displayed.
Spline Rendering File Link Settings

Application Menu on page 7989 > References > File Link > File Link Manager > Reload a linked file with Show Reload turned on. > File Link Settings dialog > Spline Rendering panel

Application Menu on page 7989 > References > File Link > File Link Manager > Presets panel > Select an existing preset and click Modify. > File Link Settings dialog > Spline Rendering panel

Application Menu on page 7989 > References > File Link > File Link Manager > Presets panel > Create a new preset. > Select the newly created preset and click Modify > File Link Settings dialog > Spline Rendering panel

Utilities panel > Utilities rollout > More button > File Link Manager > Reload a linked file with Show Reload turned on. > File Link Settings dialog > Spline Rendering panel

Utilities panel > Utilities rollout > More button > File Link Manager > Presets panel > Highlight an existing preset and click Modify. > File Link Settings dialog > Spline Rendering panel

Utilities panel > Utilities rollout > More button > File Link Manager > Presets panel > Create a new preset. > Highlight the newly created preset and click Modify > File Link Settings dialog > Spline Rendering panel

The Spline Rendering panel of the File Link Settings dialog on page 7549 controls how shapes will appear in the scene once the DWG or DXF file is linked. You can control the appearance of the shape, its smoothing, mapping coordinates and if they can be rendered.
Interface

The controls on this panel are identical in name and operation to those found on the Rendering rollout on page 580 for splines. The values of these settings are set for all imported shapes. Once the import is complete, you can change the settings as necessary for each object.

Enable in Renderer When on, the shape is rendered as a 3D mesh using the Radial or Rectangular parameters set for Renderer.

Enable in Viewport When on, the shape is displayed in the viewport as a 3D mesh using the Radial or Rectangular parameters set for Renderer.
Use **Viewport settings** lets you set different rendering parameters, and displays the mesh generated by the Viewport settings. Available only when Enable In Viewport is on.

**Generate Mapping Coords** Turn this on to apply mapping coordinates. Default=off.

3ds Max generates the mapping coordinates in the U and V dimensions. The U coordinate wraps once around the spline; the V coordinate is mapped once along its length. Tiling is achieved using the Tiling parameters in the applied material. For more information, see [Mapping Coordinates](page 5636).

**Real-World Map Size** Controls the scaling method used for texture mapped materials that are applied to the object. The scaling values are controlled by the Use Real-World Scale settings found in the applied material's [Coordinates rollout](page 6201). Default=on.

**Auto Smooth** If Auto Smooth is turned on, the spline is auto-smoothed using the threshold specified by the Threshold setting below it. Auto Smooth sets the smoothing based on the angle between spline segments. Any two adjacent segments are put in the same smoothing group if the angle between them is less than the threshold angle.

**Threshold** Specifies the threshold angle in degrees. Any two adjacent spline segments are put in the same smoothing group if the angle between them is less than the threshold angle.

**Viewport** Turn this on to specify Radial or Rectangular parameters for the shape as it will display in the viewport when Enable in Viewport is turned on.

**Renderer** Turn this on to specify Radial or Rectangular parameters for the shape as it will display when rendered or viewed in the viewport when Enable in Viewport is turned on.

**Radial** Displays the 3D mesh as a cylindrical object.

**Thickness** Specifies the diameter of the viewport or rendered spline mesh. Default=1.0. Range=0.0 to 9999.0.
Splines rendered at thickness of 1.0 and 5.0, respectively

**Sides** Sets the number of sides (or facets) for the spline mesh in the viewport or renderer. For example, a value of 4 results in a square cross-section.

**Angle** Adjusts the rotational position of the cross-section in the viewport or renderer. For example, if the spline mesh has a square cross-section you can use Angle to position a "flat" side down.

**Rectangular** Displays the spline's mesh shape as a rectangle.

**Length** Specifies the size of the cross-section along the local Y axis.

**Width** Specifies the size of the cross-section along the local X axis.

**Angle** Adjusts the rotational position of the cross-section in the viewport or renderer. For example, if you have a square cross-section you can use Angle to position a "flat" side down.

**Aspect** Sets the aspect ratio for rectangular cross-sections. The Lock check box lets you lock the aspect ratio. When Lock is turned on, Width is locked to Length that results in a constant ratio of Width to Length.

**New Settings Preset Dialog**

*Application Menu* on page 7989 > References > File Link > File Link Manager > Presets panel > Copy or New

Utilities panel > Utilities rollout > More button > File Link Manager > Presets panel > Copy or New

The New Settings Preset dialog creates a new preset in the *File Link Manager* on page 7538. The settings of the new preset either use default values (if you
clicked New), or they inherit the values of a selected preset (if you clicked Copy).

After creating the preset, you can change its settings by clicking Modify.

Procedures

To create a new preset:

1 On the Presets panel of the File Link Manager, click New.

   **NOTE** New is available only if no named presets are highlighted.

2 On the New Settings Preset dialog, enter a name for your preset, and click OK.
   A new preset is created with default settings.

To copy a preset:

1 On the Presets panel of the File Link Manager, choose a named preset.
2 Click Copy.

   **NOTE** Copy is available only if a named preset is highlighted.

3 In the New Settings Preset dialog, rename the preset, and click OK.
   A new preset is created with the same settings as the selected preset.

   **NOTE** If you do not rename the preset, it will cancel the command.
Interface

New Name The name of your preset.
Format The file type for the preset.

Renew Settings Preset Dialog

Application Menu on page 7989 > References > File Link > File Link Manager > Presets panel > Click a preset > Rename
Utilities panel > Utilities rollout > More button > File Link Manager > Presets panel > Click a preset > Rename

The Rename Settings Preset dialog lets you rename your preset.

NOTE You cannot use names beginning with 'Preset', so names like “Preset 1” or “Preset with Welding” are not allowed.
Interface

New Name The name of your preset.

Format The file type for the preset.

NOTE By default, presets can be created only for AutoCAD file types (DWG, DXF). Other file types might be available, depending on the third-party plug-ins you have installed.

Preset Editing

Application Menu on page 7989 > References > File Link > File Link Manager > Presets panel > Click a preset > Modify

Utilities panel > Utilities rollout > More button > File Link Manager > Presets panel > Click a preset > Modify

After you've created a preset, you can use this function to adjust its settings. For instance, you might want to make sure Weld is on, or perhaps to include lights or views (cameras).

Procedures

To edit or modify a preset:

1 On the Presets panel of the File Link Manager, choose a named preset.

2 Click Modify.

   The File Link Settings dialog on page 7549 is displayed.

3 From the Basic, Advanced and Spline Rendering panels, make the settings you want associated with the preset and click Save.
Differences Between Layers and Blocks in AutoCAD and 3ds Max

AutoCAD has special handling for objects in the block definition that are associated with layer 0. When a block contains objects on layer 0, and those objects have a color property of "ByLayer" or "ByBlock", the color of the object is determined either by the color of the block or by the layer assigned to the block reference on page 8524 in AutoCAD. When blocks are nested, this color system can get complex.

Select Layers Dialog

Application Menu on page 7989 > References > File Link > File Link Manager > Files panel > Reload button > File Link Settings dialog > Advanced panel > Select Layers to Include button

Utilities panel > Utilities rollout > More button > File Link Manager > Files panel > Reload button > File Link Settings dialog > Advanced panel > Select Layers to Include button

This dialog lets you toggle a layer's include/exclude status and choose other options, as described in this topic.

NOTE You toggle the include/exclude status of a layer by clicking anywhere on a row in the list of layers. The dialog lists included layers with a check mark to the left of the layer name. This list of included layers is retained for subsequent reloads of the linked file. For informational purposes, the property icons display the state of the layers' properties, but you can’t change their status in this dialog.

See also:

- Layer Properties Dialog on page 7966
Interface

**Select Layers**

- **Skip all frozen layers**: Excludes all layers frozen in the linked file. All active files are included.
- **Select from list**: Lets you select individual active layers to include/exclude. A check mark beside the layer name indicates the layer is selected.
- **All**: Includes all layers in the linked file by selecting all of them. You can then deselect just the layers you want to exclude.
- **None**: Excludes all layers in the linked file by deselecting all of them. You can then select just the layers you want to include from importing.
- **Invert**: Reverses the current selection of layers in the linked file.

---

**Resolve External Reference File Dialog**

The Resolve External Reference File dialog is displayed when 3ds Max can't find the externally referenced files it needs in an attached DWG file.

**See also:**

- File Link Tips on page 7495
Interface

**Resolve External Reference File**

<table>
<thead>
<tr>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Xref Stored File Name</td>
<td>D:\design_project\mezzanine1.dwg</td>
</tr>
<tr>
<td>Referenced by</td>
<td>D:\Design_Projects\desk_planview2.dwg</td>
</tr>
<tr>
<td>As Block Name</td>
<td>mezzanine1</td>
</tr>
<tr>
<td>File Name for File Link</td>
<td></td>
</tr>
<tr>
<td><strong>Browse</strong></td>
<td></td>
</tr>
</tbody>
</table>

- **All Xref Files**
  - Prompt Only if File Cannot be Found
  - Do Not Resolve any Xrefs

**Xref Stored File Name** Displays the external reference path stored in the attached drawing.

**Referenced by** Displays the path of the attached drawing.

**As Block Name** Displays the name of the block reference in the attached drawing. The block name is usually the same as the xref name, but it can be different.

**File Name for File Link** When 3ds Max can’t locate the linked file, use this field to enter another path and file name. 3ds Max verifies that the file exists at that location and reports its status in the lower left of the dialog.

**Browse** Lets you use the file system to find another file for the link. Choosing a file this way enters file path and name in the File Name For File Link field.

**All Xref Files group**

Controls whether and how 3ds Max resolves external references from File Link.

**Prompt Only if File Cannot be Found** Searches for the externally referenced file and all unresolved external references from File Link in the attached
drawing by using the stored file name in the locations listed in this dialog and in the order they appear.

**Do Not Resolve any Xrefs** Doesn't resolve this externally referenced file or any other unresolved external references from File Link in the attached drawing. However, any external references from File Link resolved before you turn on Do Not Resolve Any Xrefs will still be resolved.

**OK** Resolves this externally referenced file.

**Don't Resolve This File** Doesn't resolve this externally referenced file, but will prompt for any other external references from File Link to resolve.

## Select Linked Objects Dialog

*[Application Menu on page 7989]* > References > File Link > File Link Manager > Files panel > Select file to reload. > Reload button > File Link Settings dialog > Advanced panel > Turn on Selective Reload. > Linked Objects

Utilities panel > Utilities rollout > More button > File Link Manager > Files panel > Select file to reload. > Reload button > File Link Settings dialog > Advanced panel > Turn on Selective Reload. > Linked Objects

The Select Linked Objects dialog displays the linked objects associated with the selected linked file, including VIZBlocks on page 8758, lights, and cameras. You use this dialog when reloading a linked file so that you can include/exclude specific objects from the reloading process. You might want to do this in order to reload only the objects that have changed.
Interface

List of Objects Lists the VIZBlocks, cameras, and lights associated with the selected linked file. A check mark beside the object name indicates the object is selected; an X mark indicates the object is deselected.

All Selects all linked objects in the linked file. You can then deselect specific linked objects by clicking their rows.

None Deselects all linked objects in the linked file. You can then select specific linked objects by clicking their rows.

Invert Reverses the current selection of linked objects in the linked file.

Merge

Application Menu on page 7989 > Import > Merge

Merge allows you to load objects from saved scene files into the current scene. You can also use Merge to combine an entire scene with another. This behaves similarly to the XRef Merge dialog on page 7471.
The Merge dialog lets you load and save influences on page 8609 with or without their dependents. In many cases, objects should be referenced with their influences, but the display only makes you aware of the relationships, it does not force you to externally reference them.

When you select an item in the list window and click Influences, the object’s influences are selected in the list window. When you select an item in the list window and Display Influences is on, the object’s influences are shown in blue in the list window. When you select an item in the list window and Select Influences is on, the object’s influences are also selected in the list window.

**Automatic Unit Conversion**

When Respect System Units in Files is on in the Units Setup dialog on page 8366, in the System Unit Scale group, merged objects from a file with a different scene unit scale are scaled to maintain their correct size in the new scene. No conversion is done when merging files created in 3ds Max 1.x.

**NOTE** If Respect System Units is off (which is not recommended), a 100-foot radius sphere that was created in a 1 unit = 1 foot scene becomes a 100-inch sphere in a 1 unit = 1 inch scene.

**Resolving Name Conflicts**

**Object Name Conflicts**

When one or more incoming objects have the same name as objects in the scene, an alert gives you the following options:

**Merge** Merges the incoming object using the name in the field at the right. To avoid having two objects with the same name, type a new name before proceeding.

**Skip** Does not merge the incoming object.

**Delete Old** Deletes the existing object before merging the incoming one.

**Apply to All Duplicates** Treats all subsequent incoming objects with duplicate names the same way you specified for the current object. No further alerts will appear. This option is not available if you renamed the current object.

**Cancel** Cancels the merge operation.
Material Name Conflicts

When one or more materials assigned to incoming objects have the same name as materials in the scene, an alert gives you the following options:

Rename Merged Material  Defines the name for incoming material.

Use Merged Material  Assigns the characteristics of the incoming materials to the same-named scene materials.

Use Scene Material  Assigns the characteristics of the scene materials to the same-named incoming materials.

**NOTE**  Only top-level material names (not sub-materials) are checked for duplicates.

Auto Rename Merged Material  Automatically renames the incoming materials to new names. Uses Material number names based on the next available Material number.

Apply to All Duplicates  Treats all subsequent incoming Materials with duplicate names the same way you specified for the current object.

Parent Name Conflicts

When you merge an object that’s linked to a parent object in a source scene, and an object of the same name as the original parent exists in the current scene, the Merge File dialog on page 7577 opens, giving you the option to re-create the same hierarchy.

See also:

- Merge Animation on page 4126
- Merging Effects on page 7060
- Open on page 7434
- Replace on page 7578

Procedures

To merge items:

This is the general procedure. Detailed steps follow.

1. Choose Application Menu on page 7989 > Import > Merge.
2 Select a file from which to merge items.
3 Choose a group or an item to merge.

To specify object types to list, do any of the following:
1 Display or hide the subtree. If the subtree is not displayed, you can sort items in the list alphabetically or by type or color.
2 Select the object types that you want displayed in the list box.
3 Click All or None to select or clear all of the object types.

To select objects to merge, do any of the following:
1 Enter the name of an item, or use wildcard characters to specify multiple items that share a set of characters in their names.
2 Click to select single objects.
3 Press Ctrl and click to add and remove single objects from the selection.
4 Press Shift and click to select all objects between the previously selected object and the current object.
5 Click All or None to select or deselect the entire list.
6 Click and drag to select items to merge from the list on the left.

Interface
Use the Merge File dialog to open the scene file to merge. This opens the Merge dialog, whose controls are similar to those on the Selection Floater on page 209.
Merge Objects list

Objects are listed according to the current Sort and List Types selections.

All/None/Invert These buttons alter the pattern of selection in the list window.

Influences When you select an object in the list window and then click the Influences button, the selected object's influences are highlighted as well.

Display Influences When this is on and you select an item in the list window, all of its influences are shown in blue. If you want to highlight these influences, click Influences.

Select Influences When this is on and you select an item in the list window, all of its influences are highlighted as well.
Merge File Dialog

Application Menu on page 7989 > Import > Merge > Choose a file to merge. > Choose objects to merge.

When you merge an object that’s linked to a parent object in a source scene, and an object of the same name as the original parent exists in the current scene, you can re-create the same hierarchy using this dialog.

Interface

If you merge an object that’s linked to a parent object in a source scene, and an object of the same name as the original parent exists in the current scene, a dialog appears asking if you want to link the incoming object to the existing parent object.

![Merge File Dialog](image)

Yes Reparents the specified object and continues prompting for all subsequent merging objects that might need reparenting.

Yes To All Reparents the specified object and all subsequent merging objects that need reparenting.

No Merges the specified object without reparenting, but continues to prompt for subsequent objects.

Merge | 7577
No To All Doesn’t reparent any of the incoming objects. When an object is merged without reparenting, it becomes a child of the world. This feature can also be used to reconnect parent objects to children in the scene.

Replace

Application Menu on page 7989 > Import > Replace

Replace lets you substitute the geometry of one or more objects in a scene by merging objects with duplicate names. Use Replace when you want to work with less complex geometry to set up your scene and animation, and then replace it with more detailed geometry before rendering.

- When you replace an object in your scene, you replace its geometry, including its modifiers, but not its transforms, space warps, hierarchy, or materials.
- To replace the object with all its characteristics, use Merge on page 7572.
- If the object that you’re replacing has instances in the scene, all of the instances are replaced with the new object.
- All objects in the scene with the same name as the incoming object are replaced by that object. If you have more than one object in the scene with the same name as the incoming object, all of those objects are replaced.

See also:

- Merging Effects on page 7060
- Merge Animation on page 4126

Procedures

To replace items:

1. Choose Application Menu on page 7989 > Import > Replace to display the Replace File dialog. To see more than one file type at a time, choose the All Files file type.
2. Select a file from which to choose replacement items.
3 On the Replace dialog for that file, choose a group or a replacement item. (See the following procedure.) An alert asks if you want to replace the materials along with the objects.

- If yes, the materials from the incoming objects replace the current materials.
- If no, only the geometry is replaced, while the material assigned to the original object is retained.

To select objects to replace, do one of the following:

1 Enter the name of an item, or use wildcard characters to specify multiple items that share a set of characters in their names.

2 Click to select single objects.

3 Press Ctrl and click to add and remove single objects from the selection.

4 Press Shift and click to select all objects between the previously selected object and the current object.

5 Click All or None to select or deselect the entire list.

Interface

When you choose replace, a standard file selector dialog is displayed. Use the file selector to choose the scene file with the replacement objects. After you click Open, the Replace dialog is displayed.

**TIP** In the file selector, you can see more than one file type at a time by choosing the All Files file type.
In the Replace dialog, select the objects to replace. Either enter the object name or select the object from the list.

**All** Selects all objects in the list.

**None** Deselects all objects in the list.

**Invert** Inverts the current list selection.

**Influences** Click to Select the influences on page 8609 of the currently selected object.

When the Select Influences toggle is on, influences are always selected.

**Display Subtree** Displays object hierarchies in an indented format.

When this option is off, the Sort group is enabled.
Select Subtree When this option is on, all items indented below the selected one are also selected.

Display Influences When on and you highlight an object with influences on page 8609, the names of the influential objects appear in blue.

Select Influences When on and you highlight an object with influences on page 8609, the influential objects are also selected.
The Influences button selects influential objects on a one-time basis.

Find Case Sensitive When on, distinguishes between upper and lower case in object names.

Sort group

These are options for sorting the object list. If the Display Subtree check box is on, these options are not available.

Alphabetical Sorts from A at the top to Z at the bottom.

By Type Sorts by category, using the same order as the check boxes in List Types.

By Color Sorts by object wireframe color.

List Types group

Determines which object types are displayed in the list: geometry, shapes, lights, cameras, helpers, space warps, or bone objects.

All Turns on all check boxes in the group.

None Turns off all check boxes in the group.

Invert Inverts the current state of the check boxes.

Export

Application menu on page 7989 > Export

Application menu on page 7989 > Export > Export to DWF

Export converts and exports 3ds Max scenes in various formats. See the following procedure for a complete list of file types you can export.
Procedures

To export a file:

1 Choose Application menu > Export.

2 Choose an export file type from the Files Of Type list in the file selector dialog:
   - Autodesk (FBX) on page 7706
   - 3D Studio (3DS) on page 7659
   - Adobe Illustrator (AI) on page 7662
   - ASCII Scene Export (ASE) on page 7663
   - Autodesk Collada (DAE) on page 7706
   - Publish to DWF (DWF) on page 7700
   - AutoCAD (DWG) on page 7690
   - AutoCAD (DXF) on page 7694
   - Flight Studio OpenFlight (FLT) on page 7707
   - Motion Analysis HTR File (HTR) on page 7766
   - IGES (IGS) on page 7734
   - JSR-184 (M3G) on page 7737
   - Lightscape Files (LP, LS, and Other Formats) on page 7756
   - gw::OBJ-Exporter (OBJ) on page 7786
   - StereoLitho (STL) on page 7784
   - Shockwave 3D Scene Export (W3D) on page 7769
   - VRML97 (WRL) on page 7800

3 Enter a name in the File Name field.
Depending on the file type you choose, you might be presented with options available for that export choice. If a second dialog appears, choose the export options you want.

**Export Selected**

Select one or more objects. 

Export Selected exports selected geometry in a variety of formats. For details, see Export on page 7581.

When you choose Export Selected, a file dialog appears, from which you can choose a type of format from the Save as type list. The list of formats available with Export Selected is a subset of the Export list.

**Procedures**

To export selected objects to a file:

1. Select one or more objects.
2. Choose Application menu on page 7989 > Export > Export Selected.
3. Enter a name in the File Name field.
4. From the Save As Type drop-down list, choose a file format.
5. Click the Save button.

**Set Project Folder**

The project folder provides a simple way of keeping all of your files organized for a particular project.

When you start 3ds Max for the first time, the default project folder is My Documents\3dsmax\, but you can use Set Project Folder to specify a different
location. You can also set the project folder from the Asset Tracking Dialog on page 7586 > Paths menu.

When you set the project folder, 3ds Max automatically creates a series of folders within it such as scenes and renderOutput. Saving or opening files from the browser uses this location by default. Using a consistent project folder structure among team members is good practice for both organizing and sharing files.

NOTE Among the files installed along with 3ds Max are a number of material libraries as well as maps used by these libraries. These files are placed by default in the program folder, in the \materiallibraries and \maps subpaths, respectively. Should you wish to use any of the material libraries in a project, we recommend that you copy the library files into the project \materiallibraries folder. Also, if necessary, use the External Path Configuration on page 8289 feature to add the \maps path along with its subpaths (turn on Add Subpaths when adding the \maps path).

Procedures

To set the project folder:

1. Do one of the following:
   - Click Project Folder on the Quick Access toolbar.
   - Choose Application menu on page 7989 > Manage > Set Project Folder.

2. Choose a path from the browser and click OK to set your project folder.
Interface

Use the browser controls to navigate the disk structure to the project folder to use, highlight the folder name, and then click OK.

Make New Folder Click this to create a folder named New Folder within the highlighted folder. When first created, the folder name is highlighted so that you can edit it; use the keyboard to rename the folder, or press Enter to accept the default name.

Asset Tracking

The Asset Tracking feature provides direct access within 3ds Max to asset tracking systems (ATS), also known as providers. You use asset tracking systems to share files such as scene files and bitmaps used in materials with other members of your development team.
Asset tracking provides full support for the Autodesk Vault data-management solution, and basic version-control support for other providers, such as Perforce and Microsoft SourceSafe. In general, asset tracking supports version-control providers that are capable of integrating into Microsoft Visual Studio, sometimes referred to as MSSCC support. This topic assumes usage of Autodesk Vault. Autodesk Data Management Server and Autodesk Vault Explorer are available to subscription customers and are also shipped with certain other Autodesk softwares. See Manage Files with Autodesk Vault on page 8438. The Vault Plug-ins are included with 3ds Max.

NOTE When you have Vault installed, you can open files directly from the Vault database with the Application menu on page 7989 command Open from Vault on page 7438. This command mimics the File Open process, but browses the vault instead of the file system. In addition to opening the scene file, it downloads or updates any dependent scene files, such as bitmaps and XRefs. You see Open from Vault in the Application menu only if you have installed the Vault Plug-in.

Asset Tracking with Autodesk Vault

The 3ds Max Vault Plug-in works with 3ds Max by adding data-management tools to the interface. Through the Vault Plug-in, you can add files to a vault, and check files out and in. The add-in works with many different types of files including MAX and image files. The recommended method for performing Vault operations depends upon your working environment.

When you work on a file that is checked out of the vault, you work on a local copy of the file and not the original. At no point do you ever work on the actual vaulted file. When you check a modified file back into the vault, the modifications are available as the latest version in the vault. All past versions of a file are maintained in the vault.

See also:
- Open from Vault on page 7438

Asset Tracking Dialog

Application menu on page 7989 > Manage > Asset Tracking

With the Asset Tracking dialog, you can check files in and out, add files to the Asset Tracking System (ATS), get different versions of files, and so on, all from 3ds Max without the need to use separate client software.
Another important function of the Asset Tracking dialog is for repathing; locating missing files. For example, if you move bitmap files used by materials in your scene to the same folder as the scene file, the bitmaps will be loaded when you open the scene file, but the materials will still use the original, non-longer-valid path for the bitmap files, and the Asset Tracking dialog will show the files as missing. To resolve the incorrect paths, you can use the tools available from the Paths menu.

Asset tracking provides full support for the Autodesk Vault data-management solution, and basic version-control support for other providers, such as Perforce and Microsoft SourceSafe. In general, asset tracking supports version-control providers that are capable of integrating into Microsoft Visual Studio, sometimes referred to as MSSCC support. This topic assumes usage of Autodesk Vault.

The Asset Tracking dialog provides the principal functionality for working with the Vault data-management solution from within 3ds Max, but you can also work directly with Vault using the Vault Explorer client software, which is included with 3ds Max. To run Vault Explorer, go to Windows Start menu > Autodesk > Autodesk Data Management and choose Autodesk Vault Explorer. To learn more about using Vault Explorer, open the Autodesk Vault Explorer Help menu and choose Autodesk Vault Help Topics, or simply press F1 while the Vault Explorer window is active.

See also:
- Asset Tracking on page 7585

Filtering Files

You can configure individual asset-tracking-system providers via the provider configuration file, ATSProviders.xml, which resides in \plugcfg in the 3ds Max install folder. 3ds Max reads this file, but doesn’t write to it.

The primary configuration function is filtering. Filters define criteria 3ds Max uses to determine whether a file should be excluded from a provider’s control. If a file is determined to be excluded from a provider, the file is never sent to the provider for status check or any other action. This feature is useful when using multiple providers within the same pipeline or if your studio still uses file servers for certain file types.

When a file is excluded, its icon is grayed out and its status message indicates that it is excluded. You can also toggle the display of excluded files in the dialog window with the Display Excluded Files option on page 7599.
A example filter file, `\plugcfg\ATSProviders_Example.xml` is included with 3ds Max, in the 3ds Max install folder. The file includes comments, so you can load it into a text editor to see how it works and edit it. If you're using Autodesk Vault as your provider, you can rename the provider field (in the `<Provider>` section, near the beginning of the file) to Autodesk Vault, as follows:

Change:

```xml
<Name>Sample Provider Name Example</Name>
```

to:

```xml
<Name>Autodesk Vault</Name>
```

One of the effects of the example file is to exclude FX files, as shown in the following illustration:

<table>
<thead>
<tr>
<th>Autodesk Vault</th>
<th>\max_scene_file</th>
<th>Logged In</th>
</tr>
</thead>
<tbody>
<tr>
<td>sph_fy.max</td>
<td>C:\max_scene_fy</td>
<td>Checked Out</td>
</tr>
<tr>
<td>Maps / Shaders</td>
<td></td>
<td></td>
</tr>
<tr>
<td>fur.fy</td>
<td>C:\max_scene_fy</td>
<td>Excluded - No FX Files</td>
</tr>
<tr>
<td>test_noise.dds</td>
<td>C:\max_scene_fy</td>
<td>Ok</td>
</tr>
</tbody>
</table>

**Procedures**

If you are using Vault as your asset management system, you will need to login into the Vault the first time you access it, otherwise you will not be able to check files in and out.

**To start and login into the Vault from 3ds Max:**

1. In 3ds Max choose Application menu on page 7989 > Manage > Asset Tracking.

2. Select the version of Autodesk Vault that you want to login to from the Autodesk Vault Version box.

3. In the Asset Tracking dialog choose Server > Log in.
4 In the Log in dialog box enter the following:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Name</td>
<td>The name for the vault account. Default=Administrator</td>
</tr>
<tr>
<td>Password</td>
<td>The password associated with the vault account. Default=&lt;left blank&gt;</td>
</tr>
<tr>
<td>Server</td>
<td>The name of the computer on which the vault server is installed. Use “localhost” if the server is installed on the same machine as the client. Use localhost if the server is installed on the same machine as the client. For more information, see your system administrator or if this does not work.</td>
</tr>
<tr>
<td>Database</td>
<td>The name of a vault database located on the specified server. The default is “Vault”. Click the browse button to select from a list of available databases on the server. Default=Vault</td>
</tr>
</tbody>
</table>

**NOTE** Enable Use this settings next session if you want to be automatically logged in future sessions.

Click OK when you have entered values in all fields.

**NOTE** Your system administrator may provide you with your own account values which you will use instead of the defaults. If you are experiencing problems, speak with your system administrator.

**To set up a local working folder when using Vault:**

When you are working with files in Autodesk Vault you need to have a **working folder** set up. The working folder houses your files while you are working on them (between checking files out of the vault and checking them back in to the Vault). The working folder can be a folder on your local machine or a folder on the network. Typically a system administrator will set up the working folder on the network.
NOTE If your system administrator has enforced a network working folder, you may receive a message notifying you of this. You will not need to set your working folder, though you may need to map the drive location that has been set up for your working folder. For further information, speak with your system administrator.

1 In 3ds Max choose Server > Login and login on page 7591 to the Vault.

NOTE Make sure the version of Vault that you want to work with is selected in the Autodesk Vault Version box.

2 Choose Server > Options.

3 Browse to the folder that you want to use and click OK to confirm.

To coordinate local files with Vault files:

For optimal coordination between your files and those in the Vault, you need to maintain a one-to-one correspondence between the folder structure in the database and the structure in your working folder and its subdirectories.

Create a local folder structure for Vault files and then use Options to map the top of the local structure to the top of the Vault structure (i.e., Vault($)).

1 Create a working folder on a local drive to contain all files to be coordinated with other users via the Vault. For example, you could call the working folder My_Vault.

2 Open the Asset Tracking dialog and log in to the tracking database if necessary.

3 On the Asset Tracking dialog, choose Server menu > Options.

4 On the Vault Options dialog, click the Change button and then use the Browse For Folder dialog to choose the folder you created in step 1.

TIP You can also use the Browse For Folder dialog to create this folder.

Now, when you open a file from the Vault on page 7438, the folder structure in which the file resides in the Vault is replicated in your local folder, if necessary. Likewise, when you add a file to the Vault, the local structure
is replicated in the Vault, if necessary. For example, if you open a character mesh from `Vault($)`/max_files/characters/ and the file uses a bitmap stored in `Vault($)`/max_files/characters/face_maps/, the character mesh is stored locally in `My_Vault`/max_files/characters/ and the map file is stored locally in `My_Vault`/max_files/characters/face_maps/.

Interface

![Asset Tracking Interface](image)

Menu bar

The menu bar provides access to most Asset Tracking functions. Most of the menu functions are also available from the right-click menu available in the dialog window.

**NOTE** If you highlight and then Ctrl+right-click one or more assets all of which reside in the same directory, a version of the Windows Explorer context menu opens. This lets you perform such functions as cutting or copying the file, or sending it to the desktop as a shortcut for easy access.

Server menu

**Log in** Displays the Vault Log In dialog. Enter your user name, password, server name, and database, and then click OK. After entering a server name, you can click the ellipsis (…) button display all available databases and choose one from the dialog.
You can log in automatically in future sessions without having to use the Vault Log In dialog if you turn on “Use these settings next session.” This also turns on Options > “Log in using saved settings.” The login settings are stored in the file `plugcfg\ATSVaultLogin.ini` in the 3ds Max install folder.

**Log out** Logs you out of the database.

**Options** Opens the Vault Options dialog, where you can view the *working folder* and specify a new one (click the Change button). Available only when logged in.

**IMPORTANT** The working folder is a folder on your local drive that mirrors the top-level folder of the provider database structure. For further information, see this procedure on page 7590.
You can log in automatically in future sessions, bypassing the Vault Log In dialog, if you turn on “Log in using saved settings.” This also turns on Vault Log In > “Use these settings next session.”

Launch Provider Opens the database client program. This is the same as running the client program from the Start menu. It doesn't necessarily open to the same database you're using in 3ds Max.

File menu

Most of the File menu commands are available only when you're logged in.

Checkout Lets you check out the highlighted assets in the Asset Tracking dialog list of assets, if the assets are available for checking out. This opens a dialog that lets you confirm the checkout, specify whether to replace the local copies with the checked-out version, and enter a comment.

If you enter a comment, it's copied to the Working Comment dialog on page 7594.

TIP Always be sure to check out an asset before modifying it, even if you have a writable version on a local drive. This prevents other users from modifying the file at the same time, and lets you maintain strict version control over the asset.

Checkin Lets you check in the highlighted assets in the Asset Tracking dialog list of assets. This opens a dialog that lets you confirm the checkin, specify whether to keep the assets checked out, and enter a comment. Also, if the assets have been edited but not saved locally, you're prompted to save first.

Checking in an asset increments the current version number of the asset as stored in the database, and saves the current Comment text along with the asset.

Undo Checkout Reverses a checkout, setting the highlighted assets' status to checked in, without saving any changes.

Add Files Lets you add files in the scene, such as bitmaps used in materials, to the provider database. To add a file, load it (such as a scene file) or add it to the scene (such as a bitmap used in a material), highlight it in the Asset Tracking dialog, and then use Add Files.

You can add multiple files at the same time.
NOTE You cannot add a file that doesn't exist on a local drive, such as an unsaved scene file. Also, you cannot add a file that's not in the working folder, as specified via Options on page 7592. For best results, before adding a file, make sure it exists in a local folder within a structure that mirrors the one in the Vault. For details, see this procedure on page 7590.

Get Latest Downloads the most recent (highest-numbered) version of the highlighted asset from the database. Use this when a teammate has updated an asset such as a bitmap.

History Opens a History dialog from which you can get any version of the highlighted asset. When the dialog opens, highlight the version to get by clicking it and then click Get Version. You can also right-click the asset and choose Get Version from the context menu.

Properties Opens a read-only dialog that shows information about the highlighted asset such as vault and local locations, versions, and check-out status.

Get From Provider Lets you copy files from the database to the local working folder. Use the Get Files dialog to navigate to the folder from which to get files, highlight any number of files, and then click Open. The highlighted files and any dependent files, such as bitmaps and XRefs, are copied to the local folder, using the same folder hierarchy as that of the database.

Working Comment Opens a dialog that containing a common text buffer for the current session.

When you check out a file, any comment you enter in the Asset Tracking dialog is copied to the Working Comment dialog. You can edit this text at any point during the session. When you check a file back in, all Working Comment text appears in the Asset Tracking dialog; you can edit it as necessary without affecting the original text before completing the check in. The checked-in comments remain with that version of the file in the Vault.

Browse Lets you browse the local directories for missing files such as bitmaps. Use the Browse dialog to find the file, and then click Open.

View Image File Opens a window showing the highlighted image file. The file must be present in a local directory.

Reveal In Explorer Opens a Windows Explorer dialog showing the location of the highlighted asset.

Custom Dependencies Opens a dialog that lets you specify files to be dependents of the current scene; files that aren't necessarily present in the current scene but should be associated with it. On the Custom Dependencies
dialog, click the Add button and then use the Add Custom Dependencies file browser to open dependent files.

The Custom Dependencies function lets you associate files that aren’t true scene dependencies. A true dependent file is required for rendering, animation, exporting, and so on. A custom dependency might be reference art work, a text file with scene documentation or tasks to accomplish, custom scripts, and so on. Basically, any collection of files that should “travel along” with the scene.

One potential use for a custom dependency is as a way to perform simple project management. For example, you could add a file called GameTitle-A.txt as a custom dependency to any scene file associated with GameTitle-A. You could then instruct the provider client, such as Vault Explorer, to display all files that are dependent on GameTitle-A.txt, which would give you a list of files associated with that project.

**Refresh** Reloads the asset listing from the local scene and updates the window contents.

**Paths menu**

The tools on this menu help you resolve file-path issues such as missing files. They include functionality also available in the Bitmap/Photometric Path Editor Utility on page 7629, but their integration into the Asset Tracking dialog helps speed the workflow of managing scene assets.

**Highlight Editable Assets** Highlights all assets whose paths can be affected by the remaining commands on this menu.

For example, if your scene materials use bitmaps from a number of different folders, you could copy all the bitmaps to a common directory within your working folder, use Highlight Editable Assets to highlight all the bitmap assets, and then use Set Path (see following) to designate the common directory.

**Set Path** Opens a dialog for editing the scene's record of the highlighted asset's or assets' path and, in the case of a single asset, the file name. Both versions of the dialog include drop-down history lists for reverting to a previous path or file name.

The primary function for this command is to change the path pointed to by 3ds Max for existing assets whose locations have changed. However, for output files such as rendered images and render elements, you can also use Set Path to create and use new output directories. If you change an output path to one that doesn't exist, you're prompted to confirm that you want to create the folder(s). If you confirm, the output paths are changed in all appropriate locations, such as the Render Setup dialog.
The version of the dialog that appears depends on the number of highlighted assets:

- If a single asset is highlighted, you can change the path and the file name. The following dialog appears.

  ![Specify Asset Path](image)

  To change the path, edit the Path field or use the ellipsis [...] button to browse for a new path. This changes the path only.
  To revert to a previous path, choose it from the drop-down list.
  To change the file name, edit the File field or choose a name from the drop-down history list. Note that this changes only the name of the asset file as pointed to in the scene; it doesn’t change the actual asset file name. Use this to update the scene if the asset file name has changed.

- If multiple assets are highlighted, you can change the path but not file names. The following dialog appears.

  ![Specify Asset's Path](image)

  The dialog shows the portion of the current path that the highlighted assets and lets you specify a new one, either by editing the Specify Path field contents or by clicking the ellipsis [...] button and browsing to a different path.
  For example, if two assets are highlighted, and one asset’s path is `c:\max_files\maps1\` while the other’s is `c:\max_files\maps2\`, the Specify Path field will show `c:\max_files\`. Changing this changes the complete path for all highlighted assets. Of course, they must all be present there for Asset Tracking to find them.
  To revert to a previous path, choose it from the drop-down list.
To change only the portion of the path that all highlighted assets have in common, use Retarget Common Root (see following).

**Retarget Common Root** Lets you change only the part of the path that all highlighted assets have in common. This command opens a version of the Specify Assets path dialog that shows the common path prefix for the highlighted assets and lets you specify a new one, either by editing the Specify New Common Path Prefix field contents or by clicking the ellipsis [...] button and browsing to a different path. Use Retarget Common Root for repathing multiple files, particularly those in different directories within the common root.

For example, if all maps were originally in various subdirectories within `c:\maps\` and the entire subdirectory structure was moved to `d:\resources\maps\`, you could repath all files simultaneously using Retarget Common Root.

To revert to a previous path, choose it from the drop-down list.

If you change the common root for output files to a path that doesn't exist, you're prompted to confirm that you want to create the folder(s). If you confirm, the output paths are changed in all appropriate locations, such as the Render Setup dialog.

**Strip Path** Strips all path information from the highlighted assets, leaving only the file names.

Stripped path information is saved in the Set Paths dialog drop-down list. To restore stripped paths, highlight the assets, choose Paths menu > Set Paths, and then choose the desired path to restore from the drop-down list.

**Make Path Absolute** Gives the complete path of the found asset file. This is useful when a relative path is displayed and you want to see the entire path.

**Make Path Relative to Project Folder** This takes the current path of the found asset file and makes it relative to your project folder on page 7583.
**Resolve Path to UNC Location** Resolves highlighted paths that point to mapped drives to *Universal Naming Convention (UNC) format* on page 8753.

**Set Project Folder** See *Set Project Folder* on page 7583.

**Configure User Paths** Opens the *Configure User Paths dialog* on page 8284, which you can use to resolve locations for support files such as bitmaps.

**NOTE** This option makes it simple to share files between different users, even if you are not using the same project folder. If user A loads a file from user B and they do not have the same project folder, this will not be a problem.

**Preferences** Use this submenu to toggle these options:

- **Convert file paths to UNC** When on, paths shown in the Asset Tracking dialog for any added assets present on a mapped drive use *Universal Naming Convention (UNC) format* on page 8753. When off, each path starts with the mapped drive letter (e.g., \w:). This switch is linked to the *Convert file paths to UNC* on page 8305 switch on the Preferences dialog > Files panel. Toggling either one toggles both.

  **NOTE** This switch affects only newly added paths. Toggling it has no effect on existing paths. For example, if you add an asset from a mapped drive with the switch on, turning it off does not change the path to the mapped version.

- **Convert local file paths to Relative** When on, converts the file paths of all newly added assets in a scene so that they are relative to the project folder. Default=off. This switch is linked to the *Convert local paths to Relative* on page 8306 switch on the Preferences dialog > Files panel. Toggling either one toggles both.

**Proxies menu**

The Proxy system lets you determine how 3ds Max should create and use proxy versions of bitmaps incorporated in materials. Proxies are intended for use primarily in the viewports when building and editing scenes to reduce the amount of memory required by the bitmapped textures, but you can also use them at render time.

**Enable Proxy System** Toggles the Proxy system globally. When on, 3ds Max replaces all bitmaps used in materials with proxies as specified on the *Bitmap Proxies dialog* on page 7601. When off, the original bitmaps are used.

**Global Settings** Opens the *Bitmap Proxies dialog* on page 7601.
Set Proxy Resolution Opens the Per-Bitmap version of the Bitmap Proxies dialog on page 7601 for setting the resolution for proxies of only those bitmap assets highlighted in the Asset Tracking dialog. Available only when one or more bitmap assets are highlighted.

Generate Selected/Stale Proxies Generates the proxy image files as specified. When one or more image assets are highlighted in the Asset Tracking dialog list, the command is Generate Selected Proxies, and applies only to those assets. When no asset is highlighted, the command is Generate Stale Proxies, and applies to all assets whose settings, such as proxy resolution, have changed since the previous generation, as well as any assets whose proxies are missing.

Options menu

Disable Asset Tracking Turns off asset-tracking functionality. Choosing this command logs you out of the database and makes most asset-tracking functions unavailable. To restore asset tracking, turn off Disable Asset Tracking and then log back in.

Prompts Opens the Prompts dialog on page 7604, which lets you toggle two different options for each of various actions in the Asset Tracking dialog: actions and prompts.

Auto Login Logs you in to the Vault, if necessary, whenever you cause a MAX scene file to be present in memory; for example when you load or save a scene. You can bypass the Vault Log In dialog If you've turned on Options dialog > "Log in using saved settings" or Vault Log In > “Use these settings next session.”

Display Excluded Files Displays files that are set to Excluded status. When off, these files aren't shown in the dialog window. For information about excluding files, see Filtering Files on page 7587. You can also set output files to Excluded status; see following.

Exclude Output Files Sets output files such as rendered images to Excluded status; you can prevent the dialog from displaying such files by turning off Display Excluded Files (see preceding).

Tree View Displays a simplified, hierarchical listing of the assets in the current scene. You can expand and collapse hierarchy branches by clicking the + and - icons to the left of the branch names.

Table View Displays listing of the assets in the current scene in tabular format along with the full path and for the local version of each asset. The branches are hierarchical, but cannot be expanded or collapsed.
**Toolbar**

**Refresh** Reloads the asset listing from the local scene and updates the window contents.

**Status Log** Opens a read-only window showing all status messages received from the Vault during the current session.

**Tree View** Displays a simplified, hierarchical listing of the assets in the current scene without path or status information. You can expand and collapse hierarchy branches by clicking the + and - icons to the left of the branch names.

**Table View** Displays listing of the assets in the current scene in tabular format along with the full path and status for the local version of each asset. The branches are hierarchical, but cannot be expanded or collapsed.

**Folders**

[folders] If the system administrator created files folders in Autodesk Vault, they appear in the Asset Tracking dialog and help you maintain organization of files.

[library folders] If your system administrator set library folders up in Autodesk Vault, they appear in the Asset Tracking dialog. The system administrator sets these folders up on the network and they can act as multiple network workspaces for a team. Your team can use them to organize different types of files. For example, you may have a library folder for materials, for maps, for animations, and so on. Since these library folders are stored on the network, files that are shared between team members can reside on the network at all times, rather than on a user's local workspace. Library folders can also be used to protect files because the system administrator can set up read/write permissions so that only certain users can make changes to files. See your system administrator for further details.

**NOTE** A regular folder looks the same as a library folder from the Asset Tracking dialog. Different icons distinguish the two types of folders inside Autodesk Vault.
The Asset Tracking dialog window lists all assets in the current scene in a tree or table view, depending on the current setting. Listed assets include the scene file, any images used by the scene in materials, and so on, XRefs, and photometric files. By default, output files such as rendered images also appear in the window listing; you can turn off on page 7599 display of these if you wish.

Also shown are icons for each assets showing the type of asset (3ds Max scene file, map branch, and so on) and status, as appropriate. Most status icons are documented in the Vault Explorer Help > Autodesk Vault Explorer Icon Reference topic. For a reference to the most common icons, see Asset Tracking Dialog Icons on page 7605.

**NOTE** No status icons appear if you don’t have any version-control provider installed.

In general, status errors can be resolved by being careful to coordinate the local folder/file structure with that of the Vault, as described in the above procedure.

You can access most dialog commands by right-clicking an asset in the window; the commands applicable to the asset are available in the context menu. These commands are the same as those documented above.

**Global Settings and Defaults for Bitmap Proxies Dialog**

Render Setup dialog > Common panel > Common Parameters rollout > Bitmap Proxies group > Setup

Asset Tracking dialog > Proxies menu > Global Settings
This dialog lets you determine how 3ds Max should create and use proxy versions of bitmaps incorporated in materials. Proxies are intended for use primarily in the viewports when building and editing scenes to reduce the amount of memory required by the bitmapped textures, but you can also use them at render time.

**NOTE** When you open this dialog using either of the Set Proxy Resolution commands cited at the top of this topic, the title changes to Per-Bitmap Resolution for Bitmap Proxies, the Enable Proxy System check box changes to Use Global Settings, and you can set only the proxy resolution on page 7603.

### Interface

#### Proxy Resolution group

The label and function of the first check box on the dialog depends on whether you invoked it with the Setup/Global Settings command or Set Proxy Resolution:

- **Enable Proxy System**  Toggles usage of the proxy system. When off, 3ds Max uses only the original, full-resolution maps. Available only on the Global version of the dialog (see note on page 7602).

- **Use Global Settings**  When on, the proxy system applies the same settings to all bitmaps subject to proxy substitution, as set via the Global version.
of the dialog (see note on page 7602). When off, use the Downscale Map ... setting (see following) to specify resolution only for bitmaps highlighted before invoking Set Proxy Resolution. Available only on the Per-Bitmap version of the dialog.

Downscale map to ... original size. Use the drop-down list to choose the fraction to which the proxy system reduces the bitmap(s): Full (no reduction), Half, Third, Quarter, or Eighth. The greater the reduction, the greater the memory savings and speed improvement, especially in a scene with many maps, but the less recognizable the map.

Proxy System group

These settings are available only when you open the dialog using the Setup or Global Settings commands cited at the top of this topic.

Use proxy only if the original map’s largest dimension is greater than ... pixels. Lets you indicate that bitmaps smaller than the size you specify are not to be reduced. Downscaling smaller maps isn’t particularly efficient or useful.

To ensure that the system creates proxies for all bitmaps, set this to 0.

Render Mode Lets you determine whether to use the proxies at render time. The options, available from the drop-down list, are self-descriptive:

■ Render with Proxies (High Performance, Low Memory)
■ Render with Full Resolution Images and Keep them In Memory (High Performance, High Memory)
■ Render with Full Resolution Images and Free them from Memory (Low Performance, Low Memory)

Proxy Cache Folder This read-only field displays the path in which 3ds Max stores proxy bitmap files. To change the path, go to Configure User Paths > File I/O on page 8287 and edit the BitmapProxies entry.

OK, Generate Proxies Now Generates proxy bitmaps as specified by the dialog settings and closes the dialog.

OK, Generate Proxies Later Saves the dialog settings and closes the dialog but does not generate proxy bitmaps. You must generate the proxies manually.
using the Generate Selected/Stale Proxies command on page 7599 from the Asset Tracking dialog.

**Cancel** Closes the dialog without saving any changed settings.

**Prompts Dialog**

**Application menu** on page 7989 > Manage > Asset Tracking > Asset Tracking dialog > Options menu > Prompts

The Prompts dialog lets you specify what happens when you perform a number of different functions via the Asset Tracking dialog on page 7586.

For each message, you can choose an action and toggle the prompt using a right-click menu. If you turn off the prompt, the option you set on the top part of the menu takes place automatically.
Procedures

To set prompts for asset tracking:

1. From the Asset Tracking dialog > Options menu, choose Prompts.

2. Right-click the message to set prompts for.
   The right-click menu shows check marks next to the active settings. For each message, you have two options:
   - Yes/No or Ok/Cancel
   - Prompt/No Prompt

3. Change the options to suit your preferences.
   For example, if you know that you always want to keep files checked out that you add to the vault, set the option “When adding files, keep files checked out?” to Yes and No Prompt.
   The changed settings are saved with 3ds Max.

Asset Tracking Dialog Icons

The Asset Tracking dialog on page 7586 uses a number of icons to indicate the status of assets listed in the dialog window.

The following table lists these icons and describes their functions:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>If no icon is displayed, the file is under version control, but you do not have a local copy of the file on your computer.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>File is under version control and available to be checked out. The version in your working folder is the same as in the provider. Also referred to as the Latest Version.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>File is under version control and available to be checked out, but the local version is newer than the latest version. This typically</td>
</tr>
<tr>
<td>Icon</td>
<td>Meaning</td>
</tr>
<tr>
<td>------</td>
<td>---------</td>
</tr>
<tr>
<td></td>
<td>means that your local file was changed without checking it out.</td>
</tr>
<tr>
<td></td>
<td>File is under version control and available to be checked out, but the local copy is out of date.</td>
</tr>
<tr>
<td>✔️</td>
<td>File is checked out to you and the local version is the latest.</td>
</tr>
<tr>
<td></td>
<td>File is checked out to you and the local copy is newer than the latest version. This typically means that you made changes to the file since it was checked out but have not checked it back in.</td>
</tr>
<tr>
<td>✗</td>
<td>File is checked out by someone else, and the local copy is the same as on the provider. Also referred to as the Latest Version.</td>
</tr>
<tr>
<td>✗</td>
<td>File is checked out to someone else, but the local copy is newer than the latest version.</td>
</tr>
<tr>
<td>✗</td>
<td>File is checked out to someone else, but the local copy is older than the latest version.</td>
</tr>
<tr>
<td></td>
<td>File is checked out by someone else in a setup where the working folder is shared and the local copy is the same as on the provider.</td>
</tr>
<tr>
<td></td>
<td>File is checked out by someone else in a setup where the working folder is shared on the network, but the local copy is newer than the latest version.</td>
</tr>
<tr>
<td>Icon</td>
<td>Meaning</td>
</tr>
<tr>
<td>------</td>
<td>---------</td>
</tr>
<tr>
<td>🟠</td>
<td>File is checked out by someone else in a setup where the working folder is shared on the network, and the local copy is older than the latest version.</td>
</tr>
<tr>
<td>🟡</td>
<td>Status for the file could not be obtained. This typically means you are not logged into the provider.</td>
</tr>
<tr>
<td>❓</td>
<td>The file is not under version control.</td>
</tr>
<tr>
<td>🟡</td>
<td>You are not logged into the provider.</td>
</tr>
<tr>
<td>🟢</td>
<td>You are logged in to the provider.</td>
</tr>
</tbody>
</table>

Summary Info

*Application menu* on page 7989 > Properties > Summary Info

Summary Info displays statistics about the current scene.
Interface

The Summary Info dialog includes the following information:

**Scene Totals** Number of objects in your scene listed by type.

**Mesh Totals** Total number of vertices and faces in the scene.

**Memory Usage** Physical and virtual memory used and available.

**Rendering** Time spent rendering the last frame, animation, and video post.

**Description** Lets you enter notes about the scene. Information that you add to the Comments field on the File Properties dialog on page 7609 will appear in the Description field and vice-versa.

**Summary Info** Lists materials in the scene. The information is sorted by category and includes object name, assigned material name, type of material, object vertex and face counts, and so on. Materials are listed at the bottom of the list. Bitmaps used by the materials are listed with the materials. Environmental and atmospheric maps are listed separately. The Other Maps category lists all other maps used in the scene, such as Displace maps, and any maps assigned by third-party plug-ins. Video Post maps are not included.

The buttons at the bottom of the Summary Info dialog have the following functions:
Save to File Saves the contents of the dialog and descriptive text to a .txt file.

Plug-In Info Displays a subdialog with information about the plug-ins on page 8687 used in the scene. By default, the subdialog shows the name and a brief description of each plug-in.

Show Details Shows information about all of the classes supported by each plug-in.

Show Used Only Restricts the view to only those plug-ins that have been used in the scene.

File Properties

Application menu on page 7989 > Properties > File Properties

File Properties allows you to enter information about a scene that can later be read by Windows NT 4.0 or later and Windows 98 or later, using a program such as Windows Explorer to view the properties of the scene file.

This information can also be used to locate scene files with the File Finder utility on page 7634.

The Properties dialog comprises three tabs:

- The Summary panel displays predefined fields that are commonly used.
- The Contents panel displays scene information available after the scene had been saved.
- The Custom panel enables you to create new fields that can also be used by the File Finder utility.
Interface

Summary panel

Summary provides fields for entering information related to the saved scene. Many commonly used fields are available from the Summary tab. If there is a field you would like that is not represented in the Summary tab you can use the Custom tab to define new fields for information.

Title Enter the title of your scene or animation here.

Subject Enter the subject of your scene or animation here.

Author Enter the author of your scene or animation here.
Manager Enter the manager of your scene or animation here.

Company Enter the name of your company here.

Category Enter the category of your scene or animation here.

Keywords Enter keywords that identify your scene here.

Comments Enter personal comments here. Information that you add to the Description field on the Summary Info dialog on page 7607 will appear in the Comments field and vice-versa.

Contents panel

When a scene is saved, a summary list of everything contained in the scene is generated and displayed in the Contents tab. If a scene has not been saved, the Contents tab remains empty.

**NOTE** There is currently a bug in Windows NT 4.0 that causes the information in the Contents tab to look garbled when you view a MAX file in Windows Explorer. The problem has been corrected in Windows 98. Although the information looks garbled, it is internally correct and the File Finder utility can still read it.

Custom panel

The Custom panel lets you create custom fields. Custom is useful when there is more information that needs to be entered into the properties of a scene but there is no field or no room in the Summary panel.

Name Enter the name of a custom field. You can manually enter anything you want into the Name field. A drop-down list provides commonly used field types.

Type Specifies the type of information to be entered into the Value field: choose from Text, Date, Number, and Yes or No. This dictates the type of information to be entered into the Value field.

Value Enter the data here.

Add Adds the Custom properties entered into the Name, Type, and Value fields to the Properties list.

Delete Removes a selected Custom property from the Properties list.

Properties Displays all Custom properties entered into the scene.
Exit

Application menu on page 7989 > Exit 3ds Max

Click the standard Windows Close button (X) at the far right of the Caption bar on page 7988.

Exit closes 3ds Max. If you have unsaved work, you'll be asked if you want to save it.

Procedures

To exit 3ds Max:

1. Choose Application menu on page 7989 > Exit 3ds Max.
   If the scene has unsaved changes, a prompt asks, “Do you want to save your changes?”

2. Click the Yes, No, or Cancel button.
   If you click Yes the scene is saved, if you click No the scene is not saved, if you click Cancel the Exit operation is canceled.

NOTE You can also click the Close button (the X) in the upper-right corner of the 3ds Max window to exit.

Missing External Files Dialog

This dialog appears when you attempt to open or render a scene with bitmaps on page 8523 or photometric files (IES on page 5376, CIBSE on page 8532, LTLI on page 8625) whose path is no longer current. This can happen if the bitmaps have been moved or deleted, or if the scene has been placed on a system with a different drive mapping than the system on which it was created.

See also:

- External Path Configuration on page 8289
- Bitmap / Photometric Path Editor Dialog on page 7630
Interface

Two slightly different versions of the dialog exist: One appears when you load a scene that references missing files, and the other appears when you attempt to render such a scene.

Top: This dialog appears at load time.
Bottom: This dialog appears at render time.

[List of external files] Lists the bitmaps or photometric files that cannot be located, along with their path names.
Continue Opens or renders the file anyway, without loading the missing bitmaps or photometric files. If you continue rendering the scene, the bitmaps do not appear, or the lights assigned missing photometric files will render using the default isotropic distribution.

Cancel Cancels the render. This button appears only at render time.

Browse Displays a Configure External File Paths dialog, to let you add the missing files' paths to the search sequence. This dialog has the same controls as the Configure User Paths dialog > Configure External Files Paths panel on page 8289.

Don't Display This Message at Render Time Appears only when loading a scene with missing files. When on, 3ds Max does not display this dialog if you render the scene without resolving the missing files.

Don't Display This Message Appears only at render time. When on, 3ds Max does not display the dialog the next time external files cannot be found.

**File-Handling Utilities**

The topics in this section describe a number of utilities that are provided to help you manage files, especially external files such as bitmaps, photometric web (IES) files, and so on.

**Asset Browser Utility**

Utilities panel > Utilities rollout > Asset Browser button

The Asset Browser provides access from your desktop to design content on the World Wide Web. From within the Browser you can browse the Internet for texture samples and product models. This includes bitmap textures (BMP, JPG, GIF, TIF, and TGA), or geometry files (MAX, DWG, and so on).

You can drag these samples and models into your scene for immediate visualization and presentation. You can use the Ctrl key to drag geometry into predefined locations. You can also use the Asset Browser to browse thumbnail displays of bitmap textures and geometry files on your hard disk or shared network drives. Then you can either view them or drag them into your scene or into valid map buttons or slots.

7614 | Chapter 21  Managing Scenes and Projects
NOTE The thumbnail display of a geometry file is a bitmap representation of a view of the geometry. Since the thumbnail display is not a vector-based representation, you can't rotate it or perform zooms on it.

You can drag most graphic images that are embedded in a Web page into your scene. The exception is images or regions of a Web page that are tagged as hyperlinks or other HTML controls (such as when a bitmap is tagged as a button with hypertext links).

IMPORTANT Downloaded content might be subject to use restrictions or license of site owner. User is responsible for obtaining all content license rights.

Drag and Drop

You can assign files represented by the thumbnail images by dragging the thumbnails over various parts of the Asset Browser or the 3ds Max user interface. There are three basic methods of using drag in the Asset Browser:

Local Drag and Drop: You can drag thumbnails to the directory tree, and you can copy or move files from one directory to another. As the default, when you drag to a folder within the same partition or device, you perform a move. If you drag beyond the current partition or device (to another drive, for example), you perform a copy. If you hold down the Ctrl key, you perform a copy regardless of the destination. If you hold down the Shift key, you perform a move. You can manipulate bitmap, 3ds Max scene, and DWG thumbnails in this way.

Bitmap Drag and Drop: You can drag the thumbnails that represent bitmap files to any bitmap or map slot in the interface or onto any object in a viewport. You can also drag the thumbnails into the viewport background. When you drag a bitmap onto an object, 3ds Max creates a new standard material with the bitmap as the diffuse map and assigns the material to that object.

Scene Drag and Drop: You can drag the thumbnails representing .max scene files directly over an active viewport to merge the scene with the current scene. When you drag the thumbnail over the active viewport and release the mouse, the objects in the file appear attached to the mouse. Place them where you want them, and then click the mouse. Choose from the menu whether you want to open the file, merge the file to the current scene, or XRef the file. To cancel, you can select from the menu, or right-click. If you hold down the Ctrl key, and drag the thumbnail over the active viewport, when you release the mouse button the objects in the dragged file will snap into their old location in their original file.
When you drop scene files into your current scene, you can use AutoGrid on page 2792 to position the geometry file on an object.

Procedures

To drag scene files from the World Wide Web:

1. In the Address bar, enter the URL of the scene files on the World Wide Web.
2. Select the thumbnail of the scene file with your mouse and drag it over the active viewport.
   The Internet Download dialog on page 7626 appears.
3. If you want objects placed in the viewport automatically, then in the Options group, turn off Place Objects When Download Completes.
4. If you skipped step 3 (that is, if Place Objects When Download Completes is still on), then when you release the mouse, the objects in the file appear attached to the mouse. Place them where you want them, and then click the mouse. Choose from the menu whether you want to open the file, merge the file to the current scene, or XRef the file. To cancel, you can select from the menu, or right-click. If you hold down the Ctrl key when you drag the thumbnail, the objects in the file are placed at the world space origin of the current scene.

To drag thumbnails to the directory tree:

1. In the Asset Browser directory tree, make sure the place you want to copy or move the thumbnail to is visible.
2. Select the thumbnail with your mouse and drag it to the directory tree destination.
3. As a default, if you drag to a folder within the same partition or device, a move is performed. If you drag beyond the current partition or device (to another drive, for example), a copy is performed. If you hold the Ctrl key down, a copy is performed, regardless of the destination. If you hold the Shift key down, a move is performed.

To drag bitmaps onto a map slot in the Material Editor:

1. Open the Material Editor and click the Maps rollout.
2 Open the Asset Browser and select the thumbnail of a bitmap with your mouse.

3 Drag the thumbnail to the map button of your choice on the Material Editor Maps rollout.
   This assigns the bitmap as a map type for use in the Material Editor.

To drag a bitmap onto an object in a viewport:

1 Select a thumbnail of the bitmap with your mouse and drag it onto an object in a viewport.

   **NOTE** If you miss the object, the bitmap becomes the viewport background image.

The Bitmap Viewport Drop dialog is displayed:

![Bitmap Viewport Drop dialog](image)

- **A viewport background** Puts the bitmap into the viewport as a background.
- **An environment map** Includes the bitmap when you render the viewport.

2 A new standard material is created. The bitmap is assigned to its diffuse component, and the new material is applied to that object.
To drag scene files from a local or shared disk:

1. From the Asset Browser’s menu bar, choose Filter and then a geometry filter such as All Geometry, Importable Files, or 3ds Max Files.

2. Select the thumbnail of the geometry file with your mouse and drag it over a viewport.

3. When you drag the thumbnail over the active viewport and release the mouse, the merged objects appear attached to the mouse. Place them where you want them, and then click the mouse. Choose from the menu whether you want to open the file, merge the file to the current scene, or XRef the file. To cancel, you can select from the menu, or right-click. If you hold down the Ctrl key when you drag the thumbnail, the objects in the file are placed at the world space origin of the current scene.

Interface

When you first start the Asset Browser, a window appears displaying the home page that is installed locally on your computer system.

**NOTE** You can’t change the home page on page 7623 for the Asset Browser.

Each subsequent time that you start the Asset Browser, it displays what was displayed last in the previous Asset Browser session.
The Asset Browser window contains:

- A menu bar on page 7619.
- A toolbar on page 7623.
- An address bar on page 7624.
- A pane on the left displaying your computer system's directory hierarchy.
- A pane on the right displaying a Web page, thumbnails, or an Explorer view of file names.

At the bottom of the window, there is also a tabbed favorites bar on page 7624 (by default, it first contains a Startup button) and a status bar on page 7622.

**Asset Browser menu bar**

Contains the menus for the Asset Browser.
**File menu**

Contains commands for managing files.

**Preferences** Displays the Preferences dialog on page 7625, with which you can manage the cache directory and control drag-and-drop operations.

**Properties** Displays information about the file of the selected thumbnail.

**Show Image** Displays the currently selected bitmap thumbnail in a Rendered Frame Window on page 6513. You can also double-click a thumbnail. This does not work for geometry thumbnails.

**Print** Prints the page displayed in the Web pane. Print is available only when a Web page is displayed.

**Exit** Closes the Asset Browser window.

**Filter menu**

Filters the display of thumbnails according to the category or file type you select.

**All images** Displays thumbnails of all supported bitmap files, such as BMP, JPG, GIF, TIF, and TGA.

**All geometry** Displays thumbnails of all supported geometry files, such as DWG and MAX.

**All in cache** Displays thumbnails of all images stored in your cache directory. When turned on, the left pane displaying the directory tree goes away, and the thumbnails you see might be in various directories. Because the thumbnails point to the correct directories, you can still use them to access the files and display or drag them to areas in the 3ds Max user interface.

---

**IMPORTANT** If a file has been subsequently renamed, deleted, or moved from the directory it was in when its thumbnail was first created, then the thumbnail represents only the thumbnail bitmap itself. If you assign that image to a map slot in 3ds Max, you’ll be assigning the thumbnail bitmap rather than the original image.

**All files (*.*)** Displays thumbnails for all files.

See the following topics for information on the file types listed on the Filter menu:

- AutoCAD DWG Files on page 8556
- IGES Files on page 8605
AVI Animation File on page 7832
BMP Image File on page 7834
Kodak Cineon on page 7834
CWS (Combustion Workspace) Files on page 7835
GIF Image File on page 7841
Radiance Image File (HDRI) on page 7866
IFL Image File on page 7841
JPEG File on page 7848
PNG Image File on page 7862
Adobe PSD File Reader on page 7863
MOV QuickTime File on page 7849
MPEG Files on page 7850
SGI's Image File Format on page 7877
RLA Image File on page 7873
RPF Image File on page 7875
Targa Image File on page 7878
TIF Image File on page 7880
YUV Image File on page 7882

**Thumbnails menu**

Sorts and sets the size of the displayed thumbnails.

Create Thumbnails Creates thumbnails for bitmap and geometry files.

Sort by Name Sorts by file names.

Sort by Type Sorts by file extensions.

Sort by Size Sorts by file size.

Sort by Date Sorts by file creation date.

Large (200X200) Sets the size to large (200 by 200 pixels).

Medium (100X100) Sets the size to medium (100 by 100 pixels).

Small (50X50) Sets the size to small (50 by 50 pixels).
Display menu

Controls the display of:

- The left pane, where the directory tree displays your computer system's folders.
- The right pane, which can display files as thumbnails (a Thumbnail pane), or Web pages (a Web pane).
- The Favorites and status bars located at the bottom of the Asset Browser window.
- Any available manufacturer data in the Product Information dialog that appears over the right pane.

Directory Tree  Turns the directory tree in the left pane on or off. The directory tree displays the available directories on your system. You can navigate and select the directories where you want to view images. When you select and enter a directory containing valid bitmaps, the Browser displays their thumbnails in the Thumbnail pane to the right. Right-clicking in the directory tree pane displays a menu allowing you to change directories, delete directories, and add a directory to your Favorites list.

TIP  To refresh the contents of the directory tree, press Shift+F5.

Favorites Bar  Turns the Favorites bar on or off. The Favorites bar is located at the bottom of the Asset Browser window.

Status Bar  Turns the status bar on or off. The status bar is located at the bottom of the Asset Browser window.

Thumbnail Pane  Displays valid bitmaps and geometry files of a selected directory as thumbnails in the right pane. Thumbnail bitmaps for MAXScript files (.ms, .mcr, and .mse), dropScript files (.ds), and zipped script files (.mzp) display in the Thumbnail pane. By right-clicking the thumbnail, you can view the file, look at its properties, run the script, or open it in the Web Pane. By double-clicking the thumbnails for .ms, .mcr, and .ds files, you can open them in the MAXScript editor window. Double-clicking .mzp files will open them in the associated zip utility.

Explorer Pane  Displays valid bitmaps and geometry files of a selected directory as file name icons in the right pane. This is similar to how Windows displays file name icons in the Explorer.
**Web Pane** If there’s a file named *maxindex.htm* in the selected directory, the Asset Browser displays it as a Web page in the right pane. You can use the *.htm* file to display selected bitmaps as a Web page. Also if you enter a URL in the address bar, the Asset Browser displays the page in this pane.

**Favorites menu**

Adds and deletes Web sites and path names to the Favorites menu and the Favorites bar.

*Add to Favorites* Displays the Favorite Location dialog on page 7628.

*Delete All Favorites* Removes all Web site and path name shortcuts from the Favorites menu and the Favorites bar.

**Browse menu**

Allows you to refresh thumbnails and Web pages, to move forward and backward between recently viewed Web pages, to return to your home page, and to stop loading a Web page.

*Refresh* For a Thumbnail pane, rereads the directory and redraws the thumbnails. For a Web pane, rereads the URL and redisplays the Web page.

*Forward* For a Web pane, displays a Web page you viewed before clicking the Back button.

*Back* Returns to the last Web page viewed in the Web pane.

*Home* Returns to the local copy of the home page that is installed on your computer system. This is the page that displays when you first start the Asset Browser.

*Stop* Stops loading a Web page. Use this button when a page you’re trying to view takes too long to load.

**Toolbar**

The buttons on the toolbar provide some of the same functions as the menu items on the menu bar.

† Back to previous page Returns to the last Web page viewed in the Web pane.
**Forward to next page** Displays a Web page you viewed before clicking Back to previous page.

**Stop** Stops loading a Web page. Use this button when a page you're trying to view takes too long to load.

**Refresh content** For a Thumbnail pane, rereads the directory and redraws the thumbnails. For a Web pane, rereads the URL and redisplay the Web page.

**Homepage** Returns to local copy of the Browser home page that is installed on your computer system. This is the page that displays when you first start the Asset Browser.

**Add to Favorites Bar** Displays the Favorite Location dialog that allows you to add Web sites and path names to the Favorites menu and the Favorites bar. When you want to open that page or view the files from a path name, you can click the appropriate shortcut button from the Favorites bar, or click the appropriate menu item from the Favorites menu.

**Address** Displays the current path name or URL. Clicking the history arrow at the right end of the address bar displays a list of recently viewed sites. You can select one of these to return to that site.

**Favorites Bar**

The Favorites bar is at the bottom of the Asset Browser window. It displays tabbed buttons for the startup page and for any shortcuts to directories and Web pages that you added to your favorites list. Right-clicking over a favorites tab that you’ve added displays a menu that you can use to modify on page 7628 or delete the favorites.

**Startup** Returns to the directory or Web page where the Asset Browser started in the current session.

**Status Bar**

The status bar is under the Favorites bar at the bottom of the Asset Browser window. The bar is divided into three sections. The first section displays a
progress meter when the Asset Browser loads thumbnails. The second section displays the current filter selection (such as "All in cache"). The third section displays messages, file names, or Web page shortcut labels when you move your cursor over such items.

Preferences Dialog (Asset Browser)

Utilities panel > Utilities rollout > Asset Browser button > File menu > Preferences

Contains the settings with which you can manage the Asset Browser's cache directory and control drag and drop operations.

Interface

![Preferences Dialog](image)

Cache Directory group

Provides settings and controls for the cache directory.
Browse Displays the Choose Cache Directory dialog where you can specify a new directory to use for your cache. The adjacent text box displays the path of the cache directory where the thumbnail images are stored. You can change the path either by editing the field or choosing a directory from the pane below the Folders field.

NOTE When you change directories, you’re asked if you want to clear the cache from the previous directory. If you choose to do so, the Asset Browser erases all thumbnail files from the cache directory you were using previously.

Delete Files Removes all thumbnail files from your cache directory.

Maximum Disk Space Sets the maximum size of the cache directory. When you exit Asset Browser, the Asset Browser selects the size of the cache directory. If it's over the maximum size, the Asset Browser deletes the oldest thumbnail files until the total size is 50 percent of the Maximum Disk Space setting.

Drag and Drop group

Provides controls for importing or linking files after dragging and dropping them into a viewport.

Show the merge/import/XREF dialog Displays the merge/import/XREF dialog after you drop a file into a viewport.

Always merge/import the file Imports the file without prompting for confirmation after you drop it into a viewport.

Always XREF the file Links the file as an XREF without prompting for confirmation after you drop it into a viewport.

Ask me each time Displays a popup menu to confirm importing or linking after you drop a file into a viewport.

Internet Download Dialog

Utilities panel > Utilities rollout > Asset Browser button > Address bar > Enter URL of geometry files on World Wide Web. > Drag thumbnail over active viewport.

Menu bar > Tools > Asset Browser > Address bar > Enter URL of geometry files on World Wide Web. > Drag thumbnail over active viewport.
When you drag geometry files from the World Wide Web using the Asset Browser, the Internet Download dialog appears. How long this dialog remains on-screen depends on the size of the file you're downloading.

**Interface**

<table>
<thead>
<tr>
<th>Internet Download</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Download Information</strong></td>
</tr>
<tr>
<td>Uniform Resource Locator (URL): [Link]</td>
</tr>
<tr>
<td>Connection status: [Link]</td>
</tr>
<tr>
<td>Downloading file 1 of 1</td>
</tr>
<tr>
<td>Downloaded 166171 of 253440 bytes</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>□ Place objects when download completes</td>
</tr>
</tbody>
</table>

**Download Information group**

Displays the URL of the download, the pathname of the file being saved, and a meter indicating the bytes downloaded.

**Uniform Resource Locator (URL)** Displays the URL and file name that you're downloading.

**Saved as Local File** Displays the pathname of the file being saved as a result of the download.
**Options group**

Specifies whether or not to place the objects when the download is complete. If you leave this option selected, 3ds Max allows you to position the mouse at the location of your choice.

**Favorite Location Dialog**

Utilities panel > Utilities rollout > Asset Browser button > Favorites menu > Add to Favorites

Menu bar > Tools > Asset Browser > Favorites menu > Add to Favorites

The Favorite Location dialog allows you to add Web sites and path names to the Asset Browser Favorites menu and Favorites bar.

When you want to open that page or view the files from a pathname, you can click the appropriate shortcut button from the Favorites bar, or click the appropriate menu item from the Favorites menu.

**Interface**

![Favorite Location dialog](image)
Custom Label

The button displays the Load Custom Icon dialog. Use this dialog to select an icon file to associate with the Web site or path name you're adding to the Favorites. You must use icon files that have an .ico extension.

The text box adjacent to the button displays the URL of the Web page, or the path name that you're adding to the Favorites. You can edit this to wording of your choice. The unedited URL or pathname displays in the label below the Custom Label group.

Add to favorites pull down menu When you turn this on, Web site or path-name shortcuts are added to the Favorites menu. When this box is not selected, the Web site or path-name shortcuts are added only to the Favorites bar.

Bitmap/Photometric Path Editor Utility

Utilities panel > Utilities rollout > More button > Utilities dialog > Bitmap/Photometric Path Editor

The Bitmap/Photometric Path Editor lets you change or remove the paths of bitmaps on page 8523 and photometric distribution files (IES) used in the scene. It also lets you see which objects use a resource in question.

By default, 3ds Max stores a path with the name of the files it references. This can be a problem when you share scenes among different users. Another user might have the same scene and resources, in the same directory structure, but on a different disk drive; this will cause the scene to "lose" the resources.

Removing paths from resource references eliminates this problem. When paths are not saved with the resource file, they are searched for in these directories:

1. The directory of the current scene.
2. The paths listed in the External Files panel on page 8289, starting at the top of the list.

Removing paths from bitmap and photometric references can be useful for network rendering on page 6905 as well.

See also:

- Asset Browser Utility on page 7614
Configure Paths on page 8283

Resource Collector Utility on page 7637

Interface

Edit Resources
Click to display the Bitmap/Photometric Path Editor dialog on page 7630. Most of this utility's functionality is provided by this dialog.

Include Materials Editor
When on, the Bitmap Path Editor dialog shows materials in the Material Editor, as well as those assigned to objects in the scene. Default=on.

Include Material Library
When on, the Bitmap Path Editor dialog shows materials in the current material library, as well as those assigned to objects in the scene. Default=off.

Close
Click to close this utility.

Bitmap / Photometric Path Editor Dialog

Utilities panel > Utilities rollout > More button > Utilities dialog > Bitmap/Photometric Paths > Edit Resources button

This dialog is the main part of the interface to the Bitmap / Photometric Path Editor utility on page 7629.

See also:

Asset Browser Utility on page 7614
Procedures

To correct the path name for a missing map:

You must first locate the missing bitmap or photometric files. The Windows Search program can help you with this.

1. On the Bitmap / Photometric Path Editor dialog, click Select Missing Files.
2. Click to select a single missing file in the list.
   If a group of missing files are in the same directory, you can leave all of them selected.
3. Click Strip Selected Paths.
4. Click Set Path.
5. Enter the correct path in the New Path field, or click the "..." button to browse to the correct path in a Windows file dialog.
   The Bitmap/Photometric Path Editor updates the selected maps' path to use the new path.
Interface

List of maps and photometric files  Shows all bitmaps and photometric files (IES on page 5376, CIBSE on page 8532, LTti on page 8625) used in the scene, along with their current path.

When no file is selected in the list, the only controls available in the dialog are Close, Select Missing Maps, and Strip All Paths.

Close  Click to close the dialog.

Info  Click to display a Resource Information dialog on page 7633.

This button is available only when a single file is selected in the list.

Double-clicking a name in the list is another way to display the Resource Information dialog.

Copy Files  Copies the selected files to a directory you choose. This button displays a Windows file dialog that lets you choose the destination directory.

Select Missing Files  Highlights the names of missing files in the list.

Find Files  Click to search for the maps or photometric files in the current selection. This button displays an alert that shows how many files are findable, how many files are missing.

Strip Selected Paths  Click to strip the path from the selected files. An alert appears to warn you that the scene will lose this information.
Strip All Paths Click to strip the path from all files in the list. An alert appears to warn you that the scene will lose this information.

Set Path Click to apply the New Path field to the selected files.

If the New Path field is identical to the selected file or files, clicking Set Path clears New Path.

New Path Lets you enter a path for the currently selected file or files.

Default=The path of the currently selected file, or none if multiple files with differing paths are selected.

"..." button (To the right of the New Path field.) Displays a Windows file dialog to let you browse for a path.

Resource Information Dialog

Utilities panel > Utilities rollout > More button > Utilities dialog > Bitmap/Photometric Path Editor > Edit Resources button > Select a single bitmap or photometric file name. > Info button

Utilities panel > Utilities rollout > More button > Utilities dialog > Bitmap/Photometric Path Editor > Edit Resources button > Double-click a bitmap or photometric file name.

The Resource Information dialog displays information about where a bitmap is used in other materials or photometric distribution files and shows an image of the bitmap.
Interface

Referenced by Nodes Lists the objects ("nodes") that are assigned materials that use this bitmap or use a given photometric distribution file on page 5348.

Close Closes the dialog.

View Bitmap Displays a Rendered Frame Window on page 6513 that shows the bitmap. This button is unavailable if the file is a photometric file, and it has no effect if the map is missing.

MAX File Finder Utility

Utilities panel > Utilities rollout > More button > Utilities dialog > MAX File Finder

Run maxfind.exe in the 3ds Max root directory.

The MAX File Finder utility lets you search for MAX files containing specific properties.

For example, the MAX File Finder can:

- Search the hard drive for all MAX files containing the "Pink Carpet" material.
- Search the 3ds Max program directory and below for all MAX files using the raymtl.dlt plug-in.
Search the `c:\Program Files\Autodesk\VIZ2008` directory and below for all MAX files using the `raymtl.dlt` plug-in.

The utility comes in two formats: a standard utility, and a standalone executable. Both work identically.

File Finder demonstrates how to read a MAX file's properties from an external application. These properties include predetermined data such as object and plug-in names, plus information you provide via the Application menu on page 7989 > Properties > File Properties dialog on page 7609. You can also view this data from outside 3ds Max with Windows Explorer or an equivalent program by viewing a file's properties.

**TIP** You can combine this tool with the powers of the Properties dialogs. If you have a team of animators, you can have the individual animators use the File menu > Properties dialog to create Categories, Keywords, and Comments that you can search for using the File Finder. They can also use the Contents and Custom Tabs as well. All are searchable using the Finder.

You can also create similar structures at the Object level. The Object Properties dialog on page 283 has a User Defined tab to enter any properties you like, and use that to organize your projects.
Interface

File menu

Reset Clears the list box of any files previously found.

Exit Exits the application

Help menu

About Displays something fun to play with while Finder is searching for files. The search continues in the background while this dialog is active.
Program window

Search Text Specifies the text to search for. If you leave the field empty, all files that contain the specified property will be found.

File Spec Specifies which file types to search through. The predefined file type is *.max. You can enter a different file type, such as *.dwg. To search through all files, use *. *

Property Specifies the property you want to search for. Use All to search for any property.

Start Activates the search. During a search, the button title switches to Cancel. Click Cancel to abort the search.

Browse Specifies the directory for the search, using the standard Windows Browse for Folder dialog.

Include Subfolders When on, Finder searches the current directory and all subdirectories. When off, only the current directory is searched.

File List Lists all files that were found and match the current search criteria. Double-click a found file in this list to display the property viewer for the file. The information presented in this dialog is the same that is displayed with Application menu > Properties on page 7609 inside 3ds Max. Use the << and >> buttons to step to the previous or the next file in the found list.

While in the property viewer, the search continues in the background.

Resource Collector Utility

Utilities panel > Utilities rollout > More button > Utilities dialog > Resource Collector

The Resource Collector gathers the resource files used by a scene (bitmaps on page 8523, photometric distribution files (IES), and optionally, the scene itself into a single directory.

WARNING The Resource Collector does not collect maps used for displacement mapping or as light projections.

See also:

- Bitmap/Photometric Path Editor Utility on page 7629
Interface

Output Path Displays the current output path. This can be changed using the Browse button.

Browse Click to display a Windows file dialog that lets you choose the output path.

Resource Options group

Collect Bitmaps/Photometric Files When on, the Resource Collector places the scene's bitmaps, and photometric files, in the output directory. Default=on.

Include MAX File When on, the Resource Collector places the scene itself (the .max file) in the output directory. Default=off.
Compress Files When on, compresses the files into a ZIP file, saved in the output directory. Default=off.

Copy or Move Choose Copy to make a copy of the files in the output directory. Choose Move to move the files (they are deleted from the directory in which they originally were saved). Default=Copy.

Update Materials When on, updates material paths. Default=off.

Begin Click to collect the resource files according to the settings above this button.

**Fix Ambient Utility**

Utilities panel > Utilities rollout > More button > Utilities dialog > Fix Ambient

The Fix Ambient utility solves a compatibility problem that sometimes occurs when you use 3ds Max to open files from earlier versions of 3ds Max or Autodesk VIZ.

In 3ds Max, the ambient on page 8504 and diffuse on page 8552 color channels are locked for standard materials. However, this was not always the case with earlier versions of 3ds Max and Autodesk VIZ. As a result, files might render differently than expected.

The Fix Ambient utility looks for standard materials in the current scene whose ambient and diffuse colors are different, presenting you with the option to copy the diffuse color to the ambient color channel. This will ensure that your renderings are consistent with earlier versions of products.
Interface

This utility is used to lock standard materials’ diffuse and ambient colors when they are different.

After scanning for the materials to be changed, you will be able to remove materials that you wish to remain the same.

Find All  The utility searches the entire scene for materials with different ambient and diffuse colors.

Find Selected  The utility searches the current selection for materials with different ambient and diffuse colors.

Help  Opens the help file to this topic.

Different Ambient and Diffuse Materials

This dialog appears after clicking Find All or Find Selected.
Status Message: This area displays a message indicating whether your scene (or selection) has materials with different ambient and diffuse values.
Material List  Lists all of the materials with different ambient and diffuse values.

Fix Selected  Locks the ambient and diffuse channel for the materials selected in the dialog.

Cancel  Closes the dialog without making any changes.

## Bitmap Pager Statistics Dialog

Customize menu > Customize User Interface > Category: All Commands or Render > Action: Bitmap Pager Statistics Toggle > Assign to a hotkey, menu, or toolbar button.

The Bitmap Pager Statistics dialog provides information to help you resolve issues with scenes that require large amounts of memory for texture maps. It is intended for advanced users to debug scenes and help shorten render times.

By default, the dialog is not available in the interface; it must be added as a hotkey, menu item, or toolbar button via Customize User Interface on page 8249 functionality.

### Interface

![Bitmap Pager Statistics](image)

**Memory Usage**

- Total Paged: 0 MB
- In Memory: 0 MB
- On Disk: 0 MB
- Non Paged: 1 MB

**Number of Pages**

- Total: 0
- In Memory: 0
- On Disk: 0

**Activity**

- Num. Flushes: 0
- Dirty Flushes: 0
- Num. Loads: 0

- Bytes Written: 0 MB
- Bytes Read: 0 MB

**Settings**

- Memory Limit: 4095 MB
The read-only dialog shows statistics in four categories:

- Memory Usage
- Number of Pages
- Activity
- Memory Limit

NOTE As of Autodesk 3ds Max 2010, bitmap paging is always active, and managed automatically, so there is no need to set an explicit Memory Limit. See also, System Paths on page 8294.

Internet Access

The Asset Browser on page 57 can locate locally or network-stored materials, textures, geometry, and other 3D assets that can be easily dragged and dropped into the 3ds Max workspace. The Browser can also access the Internet to do the same.

The Asset Browser provides embedded Web browser functionality, so you can go directly to the Internet to capture 2D and 3D content for use in 3ds Max. For example, a visit to any of several manufacturers' sites, such as www.formica.com, can yield flooring, countertop, or other samples in bitmap form. Provided a site encourages such use of its content (and most do), these thumbnails can be dragged into 3ds Max with a single mouse movement and dropped onto objects in a scene for instantaneous "what if" visualizations of different textures and treatments. They can also be saved for later use.

2D and 3D geometry can also be captured off the Internet and put to immediate use in 3ds Max scenes. You can also use the Asset Browser with topographical maps, detailed aerial and satellite photos, and any design data in MAX or STL form. In this way, you are assured instant access to the latest design content, free from leading vendors around the world, without leaving your desktop.

For Web Content Providers

Any Web page that uses standard HTML source code can easily be enhanced so that 3ds Max users can access it for content. Making bitmap textures (.BMP, .JPG, .GIF, .TIF, and so on) available for downloading requires no special HTML
coding, but there are guidelines you should follow for optimum utility to 3ds Max users. Making geometry (MAX) files (.max) available to 3ds Max users requires some simple modifications to your HTML source code.

i-drop Indicator

In order to support the World Wide Web as a primary source of product information, Autodesk has introduced the i-drop™ Indicator. This enables manufacturers and design professionals to publish and acquire design data using standard Web pages.

The i-drop Indicator is used to transfer content from the World Wide Web by means of a drag-and-drop operation. The content can be any type of file (such as a geometry or a raster file) that the content producer has made available and that the application will accept.

For example, imagine that you are a lighting designer and require a specific fixture to embed within your 3ds Max scene. Now imagine that a lighting company such as ERCO has a Web site containing a library of their fixtures online. You can browse this library, then drag and drop the appropriate fixture into your scene. You don't need to download the file and then insert it. Now you can drag any MAX file from an i-drop-enabled web site and drop its geometry directly into your Autodesk product.

In addition to geometry, you can drag and drop photometric data, cost information, materials, and so on.

An i-drop object in a Web page is an open gateway between the content provider's server and the Autodesk software user's desktop. Web pages that contain i-drop objects can be designed to look and behave exactly like standard Web pages in a standard Web browser. You simply drag the i-drop object from the provider's Web page and drop it onto a desktop or into an application.

The desktop or application is the i-drop target. The i-drop target requests the data in one or more specific clipboard formats and receives the content. This is called being "i-drop aware." i-drop can also deliver data in any of the system default clipboard formats. What the application gets depends on what clipboard format it requires. For example, if the user drags to the desktop, the desktop takes a file. If the user drags to a text editor, the text editor takes textual data. What the desktop or application takes is independent of i-drop.

For more information, see http://idrop.autodesk.com.
Geometry File Formats

The Import on page 7446 and Export on page 7581 commands on the Application menu on page 7989 let you share 3D geometry with other 3D modeling programs. 3ds Max can import and export a variety of file formats.

3ds Max can also open DRF Files on page 7650, which are created in VIZ Render, a rendering tool packaged with AutoCAD Architecture.

See also:
■ Asset Browser Utility on page 7614
■ Internet Access on page 7643
■ i-drop Indicator on page 7644

Compatible File Formats

MAX Files (from Autodesk VIZ) on page 7647
VIZ Render (DRF) Files on page 7650

Importing Geometry

In addition to using the Import command on page 7446 on the Application menu on page 7989, you can import geometry by dragging and dropping. If the scene to which you’re importing already contains geometry, 3ds Max usually asks whether you want to merge the imported geometry with the existing scene, or replace the scene entirely.

Importing Geometry by Dragging and Dropping

You can import geometry by dragging from a file browser into a 3ds Max viewport. When you use this method, typically 3ds Max does not prompt you to merge or replace the scene, but merges the imported geometry with what is already there.

**IMPORTANT** 3ds Max orients the imported geometry to the viewport into which you drop it, so choose the viewport carefully. Typically dropping the file into a Top or Perspective viewport will preserve the orientation of the imported geometry.
For most file formats, after you release the mouse in the viewport, you can move the geometry to position it. Click once to set the position of the imported geometry.

**Importing Geometry into an Existing Scene**

When you use the Import command on page 7446 to import geometry into a scene that already contains geometry, in most cases 3ds Max opens a dialog that asks whether you want the imported geometry to be added to the scene, or to replace the scene entirely.

For example:

![AI Import dialog](image)

**Merge objects with current scene** Merges imported data with the current scene.

**Completely replace current scene** Completely replaces the current scene with the imported data.

In general, once you respond to this dialog, a second dialog with geometry-specific options is displayed, as described in the topics that follow. (For some geometry formats, only one dialog appears, and these options are merged with the geometry-specific options.)
Working with MAX Files from Autodesk VIZ

Although they share the same file type, 3ds Max files and Autodesk VIZ files are quite a bit different. This topic describes some of the differences, and recommends ways to obtain the desired results from your files.

See also:
- Working with Drawing Files on page 7492

Defaults

3ds Max ships with several market-specific defaults sets. If you are working on design visualization types of files, you should load the DesignVIZ default settings. For more information on how to do this, see Market-Specific Defaults on page 8246.

Objects

AEC objects (walls, doors, windows, and so on) in an Autodesk VIZ file retain all their original properties as AEC objects when opened in 3ds Max. Autodesk VIZ models can also contain File Link created objects that appear as VIZBlocks or Linked Geometry.

File Linked VIZBlocks in 3ds Max

A VIZBlock is a compound object similar to a nested AutoCAD or Architectural Desktop block. If a drawing containing nested blocks is file linked to Autodesk VIZ, the block objects display in the Modify panel as VIZBlocks. 3ds Max recognizes VIZBlocks when you open a MAX file created in Autodesk VIZ. You can access the sub-object hierarchy, rename sub-object components and even extract sub-objects of the VIZBlock. You are also allowed to add modifiers on top of the sub-objects. You cannot attach objects to a VIZBlock as you could in Autodesk VIZ.
The VIZBlock user interface on the Modify panel

**NOTE** VIZBlocks can contain both mesh and spline geometry. This can cause some confusion when applying modifiers like Edit Mesh. If a spline component is closed, it will be converted to a mesh with no extrusion. If a spline is not closed, it will disappear and leave behind stray vertices in the mesh.

VIZBlocks are assigned a special controller called a LinkTM controller. If a sub-object component is extracted and converted to an Editable Mesh or
Editable Spline, the LinkTM controller is replaced with a PRS controller. Likewise, if an entire VIZBlock is converted to an Editable Mesh or Spline, the LinkTM controller for the node is replaced with a PRS controller.

When using Track View, sub-object components of VIZBlock do not display. Data pertaining to the LinkTM controller is not displayed, however, you can access the PRS subcontroller.

While working on VIZBlocks, it is very possible that you might lose portions of the original data organization of the scene, for example, when a sub-object component is extracted from an instanced VIZBlock, the extracted object is not instanced the same number of times.

**File Linked Geometry in 3ds Max**

This file linked object type appears in Autodesk VIZ when you use the Entity Combine-By option or if you extract a component from a VIZBlock. These objects display in the Modify panel as Linked Geometry. If a linked geometry object is moved, rotated, or scaled, you can use the Reset Position option.

3ds Max recognizes Linked Geometry objects when you open a MAX file created in Autodesk VIZ. Since Linked Geometry objects offer no parameters on the Modify panel, you have to modify these objects by converting them to Editable Mesh or Splines or applying modifiers on top of them.
Linked Geometry objects are also assigned a LinkTM controller. If the object is converted to an Editable Mesh or Editable Spline, the LinkTM controller is replaced with a PRS controller.

**File Link Reloading**

If you plan on working on an Autodesk VIZ scene in 3ds Max, you should download the latest service pack for the product. The latest service pack includes functionality that makes 3ds Max more compatible with Autodesk VIZ.

**Materials**

In 3ds Max, the *ambient* on page 8504 and *diffuse* on page 8552 color channels are locked for standard materials, however this is not the case in Autodesk VIZ. As a result, MAX files from Autodesk VIZ may render differently in 3ds Max.

To solve this issue, use the **Fix Ambient utility** on page 7639.

**Missing Maps**

Many times, when you open a MAX file from Autodesk VIZ, you will be presented with a **Missing External Files dialog** on page 7612. To locate the missing files, click Browse and then add the appropriate Autodesk VIZ directories to the **Configure External File Paths dialog** on page 8289.

**VIZ Render (DRF) Files**

DRF is the file format for VIZ Render, a rendering tool formerly included with AutoCAD Architecture. The DRF file type is similar to MAX files from previous versions of Autodesk VIZ.

This file format is available only when you use the **Application menu** on page 7989 > **Open** on page 7434 command. All DRF files must be saved as MAX files in 3ds Max. Likewise, DRF files cannot be imported or merged into 3ds Max scenes.

---

**NOTE** You can open DRF files using drag-and-drop functionality.

**Saving DRF Files**

DRF files must be saved as MAX files in 3ds Max.

---

7650 | Chapter 21  Managing Scenes and Projects
Defaults
3ds Max ships with several market-specific defaults sets. If you are working on design visualization types of files, you should load the DesignVIZ default settings. For more information on how to do this, see Market-Specific Defaults on page 8246.

Units
In VIZ Render, you can use only meters as your system unit. However, 3ds Max lets you define your own system unit, and how units are displayed. For more information on units, see Using Units on page 2784 and Units Setup Dialog on page 8366.

Missing Maps
Many times, when you open a DRF file, you will be presented with the Missing External Files dialog on page 7612. To locate the missing files, add the appropriate VIZ Render directories to the Configure User Paths dialog > External Files panel on page 8289.

Handling Linked Geometry in 3ds Max
Linked objects show up as Linked Geometry objects on the Modify panel. These objects don't allow access to sub-object levels where minor editing can occur. If a linked geometry object is moved, rotated or scaled you do have the option to Reset Position.
3ds Max recognizes Linked Geometry objects when you open a MAX file created in VIZ Render. Since linked geometry objects offer no parameters on the Modify panel, you must first add an Edit Mesh modifier to the object or collapse the linked geometry object to an Editable Mesh in order to access sub-object levels. If you add a modifier to linked geometry, the modifier is applied to all instances of that object.

Linked Geometry objects are assigned a special LinkTM controller. If the object is converted to an Editable Mesh, Poly, NURBS or Editable Spline, the LinkTM controller is replaced with a PRS controller.

**Substituted Objects**

There is no substitution modifier in 3ds Max. However, if you open a DRF file with substituted objects, 3ds Max will recognize the substitutions and will add the substituted objects into the scene.

**User Interface Changes**

Some of the user interface elements in 3ds Max are not where you would expect them if you are coming from VIZ Render. For example, the viewport controls on page 8113 are in the bottom-right corner, instead of the top-left.

For more information on the user interface, see User Interface on page 7981.
Render Presets

The Render Presets in 3ds Max are very different from the presets in VIZ Render. For more information on using them, see Preset Rendering Options on page 6561.

Working with DRF Files in 3ds Max

This topic presents tips on how to work with DRF files.

Saving DRF Files

DRF files must be saved as MAX files in 3ds Max.

IMPORTANT Once you save a DRF file in 3ds Max, it becomes a MAX file and you can no longer open it in VIZ Render.

Defaults

3ds Max ships with several market-specific defaults sets. If you are working on design visualization types of files, you should load the DesignVIZ default settings. For more information on how to do this, see Market-Specific Defaults on page 8246.

Units

In VIZ Render, you can only use meters as your system unit. However, 3ds Max lets you define your own system unit, and how units are displayed. For more information on units, see Using Units on page 2784 and Units Setup Dialog on page 8366.

Missing Maps

Many times, when you open a DRF file, you will be presented with the Missing External Files dialog on page 7612. To locate the missing files, add the appropriate VIZ Render directories to the Configure User Paths dialog > External Files panel on page 8289.

Handling Linked Geometry in 3ds Max

Linked objects show up as Linked Geometry objects on the Modify panel. These objects don't allow access to sub-object levels where minor editing can
occur. If a linked geometry object is moved, rotated or scaled you do have the option to Reset Position.

3ds Max recognizes Linked Geometry objects when you open a MAX file created in VIZ Render. Since linked geometry objects offer no parameters on the Modify panel, you must first add an Edit Mesh modifier to the object or collapse the linked geometry object to an Editable Mesh in order to access sub-object levels. If you add a modifier to linked geometry, the modifier is applied to all instances of that object.

Linked Geometry objects are assigned a special LinkTM controller. If a the object is converted to an Editable Mesh, Poly, NURBS or Editable Spline, the LinkTM controller is replaced with a PRS controller.

Substituted Objects

There is no substitution modifier in 3ds Max. However, if you open a DRF file with substituted objects, 3ds Max will recognize the substitutions and will add the substituted objects into the scene.

User Interface Changes

Some of the user interface elements in 3ds Max are not where you would expect them if you are coming from VIZ Render. For example, the viewport controls on page 8113 are in the bottom-right corner, instead of the top-left.
For more information on the user interface, see User Interface on page 7981.

**Render Presets**

The Render Presets in 3ds Max are very different from the presets in VIZ Render. For more information on using them, see Preset Rendering Options on page 6561.

---

### 3D Studio Mesh (3DS, PRJ) Files

The topics in this section describe how to work with mesh files from 3D Studio®, the DOS-based predecessor to 3ds Max.

#### Importing 3DS Files

Application menu on page 7989 > Import > Select File To Import dialog > Files Of Type > 3D Studio (*.3DS)

3DS is the 3D Studio® (DOS) mesh-file format. You can import 3DS files into 3ds Max.

When you import a 3DS file, you can merge the imported objects with the current scene or replace the current scene completely. If you choose to merge the objects with the current scene, you are asked whether you want to reset the length of the animation in the scene to the length of the imported file (if the imported file contains animation).

When you import a 3DS file, the following information is imported:

- Backgrounds (solid, gradient, and bitmap).
- Fog, Layered Fog, and Distance Cue.
- Ambient light level.
- Subtractive transparency is converted to 3ds Max "Filter" transparency and the filter color is set equal to the diffuse color.
- Transparency falloff settings.
- All map channels that are enabled. Map channels that are turned off in the 3DS file do not import into 3ds Max.
All map parameters, including UV transforms, Negative, Mirror, and Rotation. Some Map parameters such as Blur, Luma, RGB, and Alpha work much differently in 3ds Max. These values are converted to new values that produce a similar affect.

- Mask bitmaps are imported as 3ds Max mask textures.

- When materials with both Texture 1 and Texture 2 are imported, a composite texture is created and added to the Standard material’s Diffuse channel.

- Reflection maps, auto-cubics, and mirrors.

- Automatic reflection map Nth frame and Map Size settings.

- SXP translation for Marble and Noise materials.

- 3DS/DOS R4 IK joint parameters.

- 3D Surfer patch data.

When you import a PRJ file, all of the above items are imported, plus shapes. When you import a 3DS file, the following information is *not* imported:

- Morph keys.

- Keyframer instances.

- Map channels that are turned off.

- Custom .cub-format cubic maps.

- Decal transparency using the RGB color of the upper-left pixel of the map.
Interface

Merges imported data with the current scene.

Completely replaces the current scene with the imported data.

When turned on, 3ds Max assumes units in the imported file to be in inches, and converts them to the current system of units. When turned off, 3ds Max assumes the units in the imported file match the current scene unit and doesn't convert the units.

Importing PRJ Files

Application menu on page 7989 > Import > Select File To Import dialog > Files Of Type > 3D Studio Project (*.3DS, *.PRJ)

PRJ is the 3D Studio (DOS) project-file format.

When you import a PRJ file, you can merge the imported objects with the current scene or replace the current scene completely. If you choose to merge the objects with the current scene, you'll be asked whether you want to reset the length of the animation in the scene to the length of the imported file (if the imported file contains animation).
You'll also be asked how you want 3ds Max to handle shapes on page 8720 in the incoming file: to make them into a single object or multiple objects.

**Interface**

When you import a PRJ file, you first see a 3DS Import dialog on page 7655. This is identical to the dialog you see when you import a 3DS file. When you have set the options and clicked OK in the 3DS Import dialog, you then see a Shape Import dialog.

![Shape Import Dialog](image)

When importing PRJ files, 3ds Max converts polygons to shape objects. You choose an option in the Shape Import dialog to set how the shape objects are created:

**Import Shapes** Turn on this option if you don't want to import shapes from a .prj file.

**Single Object** All polygons in the .prj file are converted to Bezier splines and placed inside a single composite shape object.

**Multiple Objects** Each polygon in the .prj file is converted to a Bezier spline and placed inside an independent shape object.
Exporting to 3DS

Application menu on page 7989 > Export > Select File To Export dialog > Save As Type > 3D Studio (*.3DS)

3DS is the 3D Studio (DOS) mesh file format. You can export 3ds Max files to this format.

When you export a 3DS file, the following information is exported:

- Position, Rotation and Scale animation. If the controller is a TCB controller, the TCB, Ease In, and Ease Out values are also saved. If the controller is any other type of key controller, the keys are saved but the tangent information is lost. If the controller is not a key controller, only the object's transformation at frame 0 is saved.
- Basic material color/parameters from the Standard material.
- Single maps with their amount, offsets, scales, and so on.
- Auto-cubics and Mirrors.
- Target cameras, target spotlights and omni lights.
- Most "static" parameters for cameras and lights, and animation tracks for Roll, Falloff, Hotspot, and FOV.

When you export a 3DS file, the following information is not exported:

- Composite and procedural maps.
- Grouped object transformations. There's no concept of group hierarchy in the 3D Editor. Groups export to the Keyframer because the Keyframer understands hierarchies.
- Global shadow parameters.

When you export a 3DS file, the following occur:

- All non-mesh geometry, such as procedural primitives and patches, is collapsed to meshes before export.
- Objects are exported as they exist on the frame 3ds Max displays at export time.
  If you want to output morph targets, go to each frame and export the target to a different file name.
■ Meshes are saved with edge display information and smoothing groups.

■ 3ds Max instances are saved as Keyframe instances.

■ Modifier and morph animation is frozen at the current frame, collapsed, and exported as a simple mesh.

**Interface**

When you choose 3DS as the export file format, enter a file name, and click Save, an Export Scene To 3DS File dialog is displayed. This dialog has a single option:

*Preserve MAX’s Texture Coordinates* When on, preserves mapping coordinates. When off, mapping information is discarded. Default=on.

**Importing SHP Files**

*Application menu* on page 7989 > Import > Select File To Import dialog > Files Of Type > 3D Studio Shape (*.SHP)

SHP is the 3D Studio (DOS) shape file format. You can import these files into 3ds Max.

A SHP file contains polygons created in the 2D Shaper in 3D Studio.

When importing an SHP file that contains multiple shapes, 3ds Max gives you the option to either merge them all into one object or make multiple incoming objects.

The shape importer looks at the vectors on incoming splines, and if they’re collinear within a couple of percentage points, it changes the angle to a smoothed Bezier (otherwise, it’s a Bezier corner).
Interface

When you import an SHP file, you first see a 3DS Import dialog on page 7655. This is identical to the dialog you see when you import a 3DS file. When you have set the options and clicked OK in the 3DS Import dialog, you then see a Shape Import dialog.

**Import Shapes** When on, imports the shape objects. When off, does not import them. Default=on.

**Import Shapes As group**

**Single Object** (The default.) When chosen, imports all shapes in the SHP file as a single editable spline object on page 620.

**Multiple Objects** When chosen, imports each shape in the SHP file as an individual editable spline object.

Adobe Illustrator Files

The topics in this section describe how to share files with Adobe Illustrator.


Importing Adobe Illustrator 88 Files

Application menu on page 7989 > Import > Select File To Import dialog > Files Of Type > Adobe Illustrator (*.AI)

You can import Adobe Illustrator (AI88) files into 3ds Max.

Interface

When importing AI88 files, 3ds Max converts polygons to shape objects. You choose an option in the Shape Import dialog to set how the shape objects are created:

**Single Object** All polygons in the .ai file are converted to Bezier splines and placed inside a single composite shape object.

**Multiple Objects** Each polygon in the .ai file is converted to a Bezier spline and placed inside an independent shape object.

Exporting to Adobe Illustrator

Application menu on page 7989 > Export > Select File To Export dialog > Save As Type > Adobe Illustrator (*.AI)

You can export shapes that can be converted to Bezier splines on page 8519. 3ds Max exports these shapes in 2D only. It uses only the X and Y coordinates of the shape's local coordinate system, discarding the Z coordinates.
Procedures

To export a file to Adobe Illustrator:

1. Select one or more shape objects.
2. Choose Application menu on page 7989 > Export.
3. Select Adobe Illustrator (*.AI) as the file format.
4. Enter a file name, and click Save.

Exporting to ASCII

Application menu on page 7989 > Export > ASCII Scene Export (*.ASE)

When you choose ASCII Scene Export (*.ase) as the Save As type, the exported file is an ASCII representation of your scene. A dialog lets you specify which scene components are included, and how they're output. This is helpful if you are writing a program that requires you to parse the ASCII file.

Interface
**Output Options group**

Provides check boxes to specify which general options are included in the ASCII file.

- **Mesh Definition** Exports the definition of each mesh, including vertex and face information for geometric objects. In addition, turning this on enables the items in the Mesh Options group box, described below.

- **Materials** Includes the material description. If a material is not assigned to an object, its wireframe color is exported. All levels of a material tree are included, so this can produce a lot of text.

- **Transform Animation Keys** Includes the transform animation data for the objects. If the object is a target camera or spotlight, this will include target animation data.

- **Animated Mesh** Exports a complete mesh definition of every n frames. The frequency is specified by the Controller Output spinner, described below. Each block contains the same information specified in the Mesh Options group box, described below. Turning this on can result in a huge file, even for small scenes.

- **Animated Camera/Light Settings** Exports the animation data for cameras and lights, such as color, intensity, falloff, map bias, and so on. Outputs a block every n frames, as specified by the Controller Output spinner.

- **Inverse Kinematics Joints** Exports the IK joint settings in the Hierarchy branch.

**Mesh Options group**

These items are enabled only when Mesh Definition is turned on in the Output Options group box.

- **Mesh Normals** Exports the face and vertex normals. The normal of the face is listed first, followed by the normals of the three vertices supporting the face. Turning this on results in a much larger file.

- **Mapping Coordinates** Exports a list of mapping vertices and faces, according to the TVert and TVFace structures described in the 3ds Max Software Development Kit. If an object uses face mapping, a face map list is exported containing UVW coordinates for each face.

- **Vertex Colors** Exports vertex colors.
Object Types group

The items here let you specify which category of object you want included in the output. You can include geometric objects, shapes, cameras, lights, and helper objects.

Static Output group

Frame # Lets you specify which frame of the animation will be used to export all static data, whether or not you output controller animation data.

Precision group

Decimals Lets you specify the precision (the number of digits after the decimal) of the values exported to the ASCII file.

Controller Output group

Use Keys Exports key values. If the controller doesn't use keys, then the Force Sample method is used. In the case of transform controllers, the Use Keys option works only if all of the transform controllers are either Linear/TCB or Bezier. If one of the transform tracks uses a different type of controller, then the Force Sample method is used for all transform tracks.

Force Sample Samples controller values based on the frequency specified in the Frames per Sample Controller.

Frames per Sample group

Controllers Specifies the frequency, in frames, with which to sample controller values for export.

Animated Objects Specifies the frequency, in frames, with which to output animation settings and mesh definitions.

AutoCAD (DWG) Files

The topics in this section describe how to share files with AutoCAD and other programs that use the DWG format, such as Autodesk Revit.

See also:

- File Link Manager on page 7538
Importing AutoCAD Drawing Files

Application menu on page 7989 > Import > AutoCAD Drawing (*.DWG, *.DXF)

In most cases, when using the same data with two or more different Autodesk products, it’s preferable to use the File Link Manager on page 7538 to connect to drawing files; this lets you maintain a “live” link between the applications. However, if you prefer you can also use the Import command to bind to the drawing file immediately.

When you import a drawing file, 3ds Max converts a subset of the AutoCAD, AutoCAD Architecture (formerly Architectural Desktop), or Revit objects to corresponding 3ds Max objects.

After you select a drawing file to import, the AutoCAD DWG/DXF Import Options dialog is displayed. After choosing options and proceeding with the import, you are presented with editable meshes, editable splines, and PRS controllers. Each nested block maintain its parent-child hierarchy and is imported as “Block/Style Parent”. In addition, if a single drawing object creates both mesh and spline geometry, you will find objects referred to as “Linked Geometry” in the scene. Block/Style Parent and Linked Geometry objects appear in the modifier stack on the Modify panel.

NOTE If you import multiple drawings, the importer merges the drawings together.

If you are using AutoSurf or AutoCAD Designer, use the AutoCAD command 3DSOUT to export mechanical models to 3ds Max. You can also explode the mechanical models and then import the resulting file, but some data will not appear in the AutoCAD drawing file.

IMPORTANT AutoCAD and its vertical applications, such as AutoCAD Architecture (formerly ADT), have custom objects that are unique to the product. In order to view them in 3ds Max, you need the appropriate Object Enabler (OE). Object Enablers let you access, display, and manipulate these objects in AutoCAD, as well as the other vertical applications, including 3ds Max. For a list of downloadable OEs, see the Autodesk Web site.

Legacy DWG Importer

The current DWG import utility contains many improvements, including enhanced DWG compatibility and greater user control and customizability; however, some features were lost from the DWG Importer found in previous versions of 3ds Max. For this reason, 3ds Max retains the legacy DWG Import functionality on page 7685.
Support of Multiple Materials on Imported ACIS Solids

3ds Max supports multiple materials per object in DWG files exported as ACIS solids from Revit Architecture/Structure/MEP 2008 and later, as well as solid primitives created in AutoCAD Architecture 2008 (formerly ADT) and later. Imported solids can have Multi/Sub-Object materials on page 6120 that you can view and manipulate in the Material Editor.

NOTE Previous versions of 3ds Max supported multiple materials for polymeshes but only one material ID for each ACIS solid when importing a DWG file, regardless of how many material IDs had been assigned to the solid.

NOTE Legacy AutoCAD DWG import does not support multiple materials on ACIS solids.

Process

When 3ds Max imports a DWG file from AutoCAD or Revit Architecture (version 2008 and later) with either the Layer, Blocks as Node Hierarchy, Split by Material” or the Entity, Blocks as Node Hierarchy derivation methods, multiple material IDs are readable and editable as Multi/Sub-Object materials in the Material Editor.

3ds Max reads each face of an imported AutoCAD/Revit solid to determine if it contains any material IDs that can be imported. If 3ds Max reads more than one material ID from a solid, it translates each material ID on import and re-assigns it to the object.

3ds Max creates Multi/Sub-Object materials only if it finds more than one material ID; if an ACIS solid contains only one material ID, 3ds Max creates and assigns a standard/architectural material instead.

NOTE 3ds Max first evaluates the imported file to find any Revit material IDs, and then looks for AutoCAD material IDs.

NOTE If you import a DWG file with the Layer, Blocks as Node Hierarchy, Split by Materials derivation method, it does not split the solid to reflect its materials set.

Multi/Sub-Object Material Naming

In earlier versions, 3ds Max read the material ID information from the color ID of the AutoCAD/Revit material ID’s face. Now, it creates a Multi/Sub object material for every translated per face material ID each time you import a DWG file that contains an AutoCAD/Revit solid.
When 3ds Max finds multiple materials assigned to an ACIS solid and creates a Multi/Sub-Object material, the Multi/Sub-Object material consists of instances of standard architectural scene materials.

**Naming Conflicts**

Material IDs are unique within one DWG file. However, the same material ID may appear in two different files, such as Basic Wall: Generic – 12” Masonry. If a naming conflict arises when two scenes are merged, 3ds Max applies the last loaded material used in the Multi/Sub object material.

For example, if you import two files, file1.dwg and file2.dwg, and they both contain a material named Brick; the Brick material used is the one from the second file (file2.dwg).

Or, if file1.dwg contains a material named Brick that is internally stored as material ID 222 and file2.dwg contains a different material stored as ID 222, the material used in the scene when they are imported is file2.dwg’s material.

If two solids share the same material ID, they will share the same Multi/Sub-Object material.

**Non-AutoCAD Materials**

3ds Max does not import non-AutoCAD material IDs. The only non-AutoCAD Architecture IDs it preserves are Color IDs.

**ACIS Solids**

DWG ACIS solids import as solid objects in 3ds Max. You cannot separate faces of an ACIS solid object unless you apply the Edit Poly on page 1332 or Edit Mesh on page 1321 modifier.

**TIP** You can access the material ID value assigned to this face with the Edit Poly modifier.

**ACIS Solids and Materials**

ACIS solid materials display in the Material Editor, along with any other imported materials.

When you apply a bitmap material to an ACIS solid, it is applied to every side of the object. For example, a brick bitmap material that you apply to a wall object appears on both sides and all edges of the wall. If you want to apply a
material to each face ID, you can use a Multi/Sub Object material so you can assign sub-materials to each face ID.

When you import ACIS solids into 3ds Max, procedural textures are not imported, only materials. For example, a brick wall in Revit may have mortar lines procedurally drawn on it in red, but if the object is an ACIS solid, the mortar lines, which are procedural hatches, are lost in 3ds Max.

When an ACIS object’s materials are shown as a Multi/Sub-Object material in the Material Editor, each material name appears in the Material/Map Browser, for example, Default wall or Basic Wall: Generic – 12” Masonry.

**Polymesh**

Polymesh DWGs import as polymesh geometry in 3ds Max. Unlike ACIS solids, you can modify and edit any face of a polymesh object.

**Polymesh Objects and Materials**

When you import a polymesh DWG file, 3ds Max considers each polymesh face as a separate entity, with one material permitted per entity, which allows it to contain multiple materials.

You can apply a bitmap material to the different faces of polymesh geometry, unlike ACIS solids, where you would need to use a Multi/Sub-Object material to create the same effect. For example, you can select the outside face of a wall and apply a brick bitmap material and also apply a diffuse material on the inside wall to simulate white paint.

When you import a polymesh DWG file, every material used in the scene appears in the Material Editor as a separate material, where you can edit it.

When the Material Editor shows a polymesh object’s materials, each material name appears in the Material/Map Browser, for example, Default wall or Basic Wall: Generic – 12” Masonry.

**Procedures**

**To import a DWG or DXF file:**

1. Choose Application menu on page 7989 > Import.
2. Choose AutoCAD Drawing (*.DWG, *.DXF) in the Files of Type list.
3. Specify the file to import and click Open.
4. Set options in the AutoCAD DWG/DXF Import Options dialog.
Click OK to perform the import.

**Interface**

The Import Options dialog contains three panels, documented in the following topics:

- DWG/DXF Import: Geometry Panel on page 7670
- DWG/DXF Import: Layers Panel on page 7680
- DWG/DXF Import: Spline Rendering Panel on page 7682

**A Note on Large-Scale Drawings**

If you attempt to import geometry that is created very far from the origin or contains a very large bounding box in tools like AutoCAD, the 3ds Max viewports and transform tools do not respond properly. When you use them, the cursor does not move smoothly.

For example, if you have a file that is a mile wide, but your system units are millimeters, you have a scene width of 1.6 million units, which is too great a value. If you change your system unit to feet, this is less taxing on the system.

If any side of the scene's bounding box measures larger than 1,000,000 system units, you will see the following dialog:

**DWG/DXF Import: Geometry Panel**

*Application menu* on page 7989 > Import > AutoCAD Drawing (*.DWG, *.DXF) > Geometry panel

The Geometry panel of the Import Options dialog controls how 3ds Max derives AutoCAD primitives and whether 3ds Max uses the scene material
definitions when linking to or reloading the AutoCAD drawing. It also presents options for geometry translation and for toggling inclusion of certain elements in the DWG or DXF file.
Interface

AutoCAD DWG/DXF Import Options

C:\S017\HOUSE2007\rtv-3D\iew-3D.dwg

<table>
<thead>
<tr>
<th>Geometry</th>
<th>Layers</th>
<th>Spline Rendering</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Model Scale

- **Incoming file units:** Inches
- **Rescale**
- **Resulting model size:** 355.565 x 613.357 x 391.318

- **Derive AutoCAD Primitives by**
  - Layer, Blocks as Node Hierarchy, Split by Material
  - Use Extrude modifier to represent thickness
  - Create one scene object for each AutoCAD Architecture one
  - Use scene material definitions

- **Geometry Options**
  - Weld nearby vertices
  - Auto-smooth adjacent faces
  - Orient normals of adjacent faces consistently
  - Cap closed splines

- **Texture mapping:** Generate coordinates for all objects
  - Curve steps: 1.0
  - Maximum surface deviation for 3D solids: 1.0

- **Include**
  - External references (xrefs)
  - Hatches
  - Points
  - Lights:
    - Sun and sky
    - Views and Cameras
    - UCS's (grids)

[OK] [Cancel]
Model Scale group

Incoming file units This drop-down list lets you specify the base units in the incoming file. Available only when Rescale is on.

Rescale Allows rescaling the incoming geometry by a factor corresponding to the most common unit type used. The importer tries to detect the units of the DWG file being imported, compares those units with the 3ds Max system units, and then provides the appropriate conversion factor.

For example, if a drawing file is built in millimeters and 3ds Max has its System Units set to inches, the AutoCAD DWG/DXF Import Options dialog automatically has Rescale on and the Incoming File Units set to millimeters.

When there is a scale disparity, it’s generally advisable to rescale an incoming drawing to more realistic units to account for the precision limitations of 3ds Max compared to AutoCAD. For instance, if you import an airport designed in millimeters in AutoCAD, set Incoming File Units to Feet or Meters. For further information, see A Note on Large-Scale Drawings on page 7670.

NOTE If the units are unspecified in the drawing, the drop-down list is blank. In this case, if you click OK to perform the import with Rescale on, you are prompted to select a value for Incoming File Units, and are then returned to the AutoCAD DWG/DXF Import Options dialog.

Resulting model size Incoming geometry is evaluated to determine its bounding box size. This field displays the scene extents based on three factors:

- Incoming file units
- System units in 3ds Max
- Display units in 3ds Max

NOTE If 3ds Max cannot determine the size, the field shows “(Drawing Extents Not Known)”.

Derive AutoCAD Primitives By group

This group box contains options for translating the geometry in the DWG or DXF file to 3ds Max format.

[derivation method] Choose the method for deriving imported AutoCAD primitives from this drop-down list. The options are as follows:

- Layer, Blocks as Node Hierarchy All objects on a given layer in the AutoCAD drawing that aren’t in blocks are combined into a single Editable Mesh or Editable Spline object when imported into 3ds Max. The name
of each imported object is based on the AutoCAD object’s layer. The imported object name has a “Layer:” prefix and is followed by the layer name. For example, all AutoCAD objects residing on the layer Walls become part of the Editable Mesh named Layer:Walls after they are imported to 3ds Max.

Each block is imported separately as a hierarchy, with the block itself as the parent object and its constituent parts as child objects. The child objects of the block are combined by layer.

- **Layer, Blocks as Node Hierarchy, Split by Material** This works the same as the Layer, Blocks as Node Hierarchy option, with the following additional functionalities: the combination of non-block objects by layer, followed by material and support for multiple materials assigned to ACIS solid and polymesh geometry.
  - **Non-block layer combination**

For example, take an AutoCAD file with six objects in layer A: three have a Brick material and three have a Stone material. Using this option, this file would be imported in the form of two objects, or nodes, one containing the Brick material and the other with the Stone material.

Each block is imported separately as a hierarchy, with the block itself as the parent object and its constituent parts as child objects. The child objects of the block are combined by layer.

- **Multiple material support**

On import, ACIS solids and polymesh geometry can support multiple materials. For polymesh geometry, one material is supported per face. For an ACIS solid, if the solid has more than one material associated with it, a multi/sub object material is created that contains the materials used. If the solid has only one material associated with it, a standard/architectural material is assigned instead.

**NOTE** Multiple material support for ACIS solids applies to DWG files imported or file linked from Revit Architecture 2008 or AutoCAD Architecture (formerly Architectural Desktop or ADT) 2007 and later.

**NOTE** This derivation method is intended for use with AutoCAD 2007 (and later) format files. Using this method with DWG files created with previous versions of AutoCAD may result in data loss.

- **Entity, Blocks as Node Hierarchy** Every imported object not in a block is represented as a separate object in the 3ds Max scene, without regard to
layers. The nodes are then placed on scene layers that correspond to the
drawing layers. Each block is imported separately as a hierarchy, with the
block itself as the parent object and its constituent parts as child objects.
The child objects of the block are combined by layer.
One benefit of this option is that you can apply instanced animation
controllers on page 3399 to block subcomponents and thus, by transforming
a single member, transform all members at once. For example, in a scene
containing a conference table with six chairs around it, you could move
all of the chairs simultaneously by moving a single chair.
Another advantage is that all geometry is instanced, so edited UVs and
normals and other modifications need be done only once.
Multiple materials per object are supported with this option, if needed. If
the object is an ACIS solid, and has more than one material associated
with it, a multi/sub object material is created containing the materials that
can be edited in the Materials Editor. If the solid has only one material
associated with it, a standard/architectural material is assigned instead. If
the object is a Polymesh, one material per face is supported.

NOTE Multiple material support for ACIS solids applies on the DWG files
imported or file linked from Revit Architecture 2008 or AutoCAD Architecture
(formerly Architectural Desktop or ADT) 2007 and later.

NOTE This derivation method setting might cause unreliable material
propagation when importing drawings containing dynamic blocks. Materials
may propagate to some block instances and not to others.

WARNING This option has the potential to create an enormous number of
objects in your scene.

■ Layer Imported objects are combined in 3ds Max according to their layer.
Objects in each of the associated application’s layers are combined into
one object, with the exception of blocks, each of which is represented as
an individual VIZBlock (not a hierarchy). Multiple inserts of the same block
are represented using instances in the scene. Material assignments are lost
but material IDs are preserved.

■ Color Imported AutoCAD objects are combined in 3ds Max according
to their color. All objects of the same color are combined into one object,
with the exception of blocks, each of which is represented as an individual
VIZBlock (not a hierarchy). Multiple inserts of the same block are
represented using instances in the scene. Material assignments are lost but
material IDs are preserved.
NOTE  Blocks can contain objects with different colors. However, when sorting, 3ds Max considers only the color of the block itself. Also, 3ds Max objects can only display one color, unless a material is applied.

- **Entity**  Provides a one-to-one correspondence between AutoCAD objects and 3ds Max objects. For each imported object or block in the imported file, the importer creates an independent object or VIZBlock, respectively, in the scene. Material assignments are lost but material IDs are preserved.

**WARNING**  This option has the potential to create an enormous number of objects in your scene.

NOTE  When working with drawings exported from Revit, it is recommended that you do not use this setting.

- **One Object**  All imported objects are combined into a single VIZBlock. Material assignments are lost but material IDs are preserved.

**Use Extrude modifier to represent thickness**  When on, objects with thickness receive an Extrude modifier to represent the thickness value. You can then access the parameters of this modifier and change the height segments, capping options, and height value. Unavailable with the Layer, Blocks As Node Hierarchy option.

When off, objects with thickness (and closed capped objects) are converted directly to mesh objects.

**Create one scene object for each ADT object**  AutoCAD Architecture (formerly Architectural Desktop or ADT) objects are imported as a single object instead of being separated into their constituent components. This means that if you import an ADT door object, the door is represented as one object instead of three (frame, step, door). Turning on this switch makes importing faster and the scene size smaller.
NOTE This switch presents several modeling concerns that you should be aware of:

- Material assignments from ADT are not translated during the import process.
- If you want to assign materials to these objects, use Multi/Sub-Object materials. The assigned material IDs match the color indices specified in ADT (red=1, white=7, and so on).
- Depending on the Texture Mapping option you choose, UVW coordinates are translated correctly.

Use scene material definitions When on, 3ds Max checks the current scene for any currently used materials with the exact same name as a material name in the incoming DWG file. If a match is found, the importer does not translate the drawing’s material, but instead uses the material defined in the scene. When off, the File Link Manager always uses the material definitions contained in the DWG file, and will overwrite scene materials with the same name, regardless of which objects the material is applied to. All material definitions stored in the DWG file are reloaded (even when using a selective reload). If you make changes to a linked material, in Autodesk VIZ, then reload, those changes will be lost (if the switch is off).

Geometry Options group

Weld nearby vertices Sets whether coincident vertices of converted objects are welded, according to the Weld Threshold setting. Welding smoothes across seams and unifies normals of objects with coincident vertices.

Weld threshold Sets the distance that determines whether vertices are coincident. If the distance between two vertices is less than or equal to the Weld Threshold, the vertices are welded together.

Auto-smooth adjacent faces Assigns smoothing groups on page 8724 according to the Smooth Angle value. Smoothing groups determine whether faces on an object render as a smooth surface or display a seam at their edges, creating a faceted appearance.

Smooth-angle Controls whether smoothing occurs between two adjacent faces. If the angle between the two face normals is less than or equal to the smooth angle, the faces are smoothed.

Orient normals of adjacent faces consistently Analyzes the face normals of each object and flips normals to make their directions consistent. If the
imported geometry is not properly welded, or if 3ds Max can’t determine the object’s center, normals might be oriented in the wrong direction. Use the Edit Mesh or Normal modifiers to flip normals.

When this option is off, 3ds Max calculates normals according to the face vertex order in the drawing file. Face normals for solid objects are already unified. Make sure this option is off when importing drawings containing solid objects.

You should also make sure this option is off when working with AutoCAD Architecture files.

AutoCAD solids will never have their normals unified, regardless of the setting of this import toggle. Solids generate faces and normals correctly.

**Cap closed splines** Applies an Extrude modifier to all closed objects, and turns on the Cap Start and Cap End options of the modifier. The Extrude modifier Amount value for a closed entity with no thickness is set to 0. Capping makes closed entities with thickness appear solid and closed entities without thickness appear flat. When Cap Closed Objects is turned off, the Extrude modifier Cap Start and Cap End options for closed entities with thickness are turned off. No modifiers are applied to closed entities without thickness, except for Circle, Trace, and Solid.

**NOTE** If Use Extrude Modifier to Represent Thickness on page 7676 is off, 3ds Max does not apply an Extrude modifier to closed objects.

**Texture mapping** The texture mapping settings affect the loading time of models that have many objects with stored UVW Coordinates for texture mapped materials.

**NOTE** This setting only applies to geometry that is stored as a mesh in the scene. Spline shapes marked as renderable have separate controls for UVW coordinate generation on the Spline Rendering panel.

- **No mapping coordinates** When No Mapping Coordinates is used, 3ds Max does not generate texture coordinates for the mesh objects that are imported.

When drawings are imported, objects are added to the scene as Editable Mesh objects that do not have UVW coordinate assignments. Before assigning materials to imported objects, you’ll need to apply a UVW Map modifier on page 1932 to add texture coordinates. When you then apply the material and the material or texture map is set to Show Map in Viewport, the texture map is displayed if the viewport is set to Smooth + Highlights. If the UVW Map modifier is not applied, the object turns gray and you'll
see a Missing Map Coordinates dialog on page 6198 when you render the scene.
This option gives you faster loading speed, but no UVW coordinate generation.

- **Generate coordinates for all objects**  This option forces all objects to have UVW coordinates generated when the drawing is imported. This option tells the DWG/DXF Importer to create UVW coordinates, but loading time is increased while the coordinate generation occurs.

**Curve steps** Adjusts how smoothly an arc or curve appears when the drawing is imported. Larger numbers result in smoother curves. Default=10.

**Maximum surface deviation for 3D solids** Specifies the maximum allowable distance from the 3ds Max surface mesh to the parametric 3D solid surface. Small numbers produce more accurate surfaces with a greater number of faces. Large numbers produce less accurate surfaces with fewer faces. In most cases, the default value suffices. Default=1.0.

Imported 3D solid with different Surface Deviation settings
- **Top:** Surface Deviation=10.0
- **Center:** Surface Deviation=1.0 (the default)
Bottom: Surface Deviation=0.1

Include group

This group allows you to toggle the inclusion of specific parts of a drawing file during the import process.

External References (xrefs) Imports xrefs attached to the drawing file.

Lights Imports lights from pre-AutoCAD 2007 drawing files.

Sun and Sky Imports Sun and Shadows position from the drawing file (AutoCAD / AutoCAD Architecture 2008 and Revit 2008 only).

NOTE You must set mental ray as the default renderer for you to see the Sun and Sky effect. To set mental ray as the default renderer, see Choose Renderer Dialog on page 6584.

Hatches Imports hatches from the drawing file.

WARNING This stores each line or dot in the hatch pattern as a separate component of the VIZBlock that defines the hatch; this can create a very large number of objects in your scene.

Views and Cameras Imports named views and cameras from the drawing file, and converts named views to 3ds Max cameras.

NOTE Orthographic views do not translate correctly in imported DWG files. However, there are no problems with Perspective views.

Points Imports points from the drawing file.

NOTE The imported point objects are represented in 3ds Max as Point Helper objects.

UCSs (grids) Imports user coordinate systems (UCS) from the drawing file and converts them to 3ds Max grid objects.

**DWG/DXF Import: Layers Panel**

Application menu on page 7989 > Import > AutoCAD Drawing (*.DWG, *.DXF) > Layers panel
The Layers panel of the Import Options dialog lets you choose specific layers for importing from the DWG or DXF file.

**Interface**

**Layers panel**

This interface is very similar to the Layer Manager on page 7956. Layer names remain the same as specified in the drawing file.

**Skip all Frozen Layers** Excludes the import of objects on frozen layers.

**Select from List** Allows you to choose specific layers to import. A check mark beside the layer name indicates the layer will be imported. Click the layer to toggle the check mark.
**All** The All button is only active when Select From List is turned on. It quickly lets you select all the layers in the list.

**None** The None button is only active when Select From List is turned on. It deselects any layers you’ve selected.

**Invert** The Invert button is only active when Select From List is turned on. Clicking this button reverses the selection set: currently selected layers are unselected and unselected layers are selected.

**Layer list** This field displays all the layers that make up the drawing and shows their status such as hidden/displayed or frozen/unfrozen.

---

**DWG/DXF Import: Spline Rendering Panel**

_Application menu_ on page 7989 > Import > AutoCAD Drawing (*.DWG, *.DXF) > Spline Rendering panel

The Spline Rendering panel of the Import Options dialog lets you determine how spline objects imported from DWG and DXF files are displayed in the viewports and how they're treated by the 3ds Max renderer.

**Interface**

**Spline Rendering panel**

The controls on this panel are identical in name and operation to those found on the Rendering rollout of _editable spline_ on page 620 and _Edit Spline_ on page 1424 objects. The values of these settings apply to all imported shapes. Once the import is complete, you can change the settings as necessary for each object with the Modify panel controls.
Enable In Renderer When on, the shape is rendered as a 3D mesh using the Radial or Rectangular parameters set for Renderer.
**Enable In Viewport** When on, the shape is displayed in the viewport as a 3D mesh using the Radial or Rectangular parameters set for Renderer.

**Use Viewport settings** Lets you set different rendering parameters, and displays the mesh generated by the Viewport settings. Available only when Enable in Viewport is turned on.

**Generate Mapping Coords** Turn this on to apply mapping coordinates. Default=off.

3ds Max generates the mapping coordinates in the U and V dimensions. The U coordinate wraps once around the spline; the V coordinate is mapped once along its length. Tiling is achieved using the Tiling parameters in the applied material. For more information, see Mapping Coordinates on page 5636.

**Real-World Map Size** Controls the scaling method used for texture mapped materials that are applied to the object. The scaling values are controlled by the Use Real-World Scale settings found in the applied material’s Coordinates rollout on page 6201. Default=on.

**Auto Smooth** If Auto Smooth is turned on, the spline is automatically smoothed using the threshold specified by the Threshold setting below it. Auto Smooth sets the smoothing based on the angle between spline segments. Any two adjacent segments are put in the same smoothing group if the angle between them is less than the threshold angle.

**Threshold** Specifies the threshold angle for smoothing, in degrees. Any two adjacent spline segments are put in the same smoothing group if the angle between them is less than the threshold angle.

**Viewport** Choose this to specify Radial or Rectangular parameters for the shape as it will display in the viewport. Available only when Enable in Viewport and Use Viewport Settings are on.

**Renderer** Choose this to specify Radial or Rectangular parameters for the shape as it will display when rendered or viewed in the viewport when Enable in Viewport is turned on.

**Radial** Displays the 3D mesh as a cylindrical object.

**Thickness** Specifies the diameter of the viewport or rendered spline mesh. Default=1.0. Range=0.0 to 100,000,000.0.
Splines rendered at thickness of 1.0 and 5.0, respectively

**Sides** Sets the number of sides (or facets) for the spline mesh in the viewport or renderer. For example, a value of 4 results in a square cross section.

**Angle** Adjusts the rotational position of the cross-section in the viewport or renderer. For example, if the spline mesh has a square cross section you can use Angle to position a "flat" side down.

**Rectangular** Displays the spline’s mesh shape as a rectangle.

**Length** Specifies the size of the cross-section along the local Y axis.

**Width** Specifies the size of the cross-section along the local X axis.

**Angle** Adjusts the rotational position of the cross-section in the viewport or renderer. For example, if you have a square cross-section you can use Angle to position a "flat" side down.

**Aspect** Sets the aspect ratio for rectangular cross-sections. The Lock check box lets you lock the aspect ratio. When Lock is turned on, Width is locked to Length that results in a constant ratio of Width to Length.

**Legacy AutoCAD Import**

(Application menu on page 7989 > Import > Legacy AutoCAD (*.DWG)

The new AutoCAD DWG/DXF Import Options dialog on page 7666 contains many improvements, including enhanced DWG compatibility and greater user control and customizability; however, some things were also lost from the DWG Import found in previous versions of 3ds Max. For this reason, 3ds Max retains the legacy DWG Import functionality.)
Differences Between New and Legacy DWG Import

Features Unique to the new DWG Import System

■ Support for AutoCAD, AutoCAD Architecture and Revit Sun and Shadows information.
■ Support for AutoCAD Architecture mapped UV textures on objects.
■ Support of multiple materials on ACIS solids from files imported or linked from Revit Architecture 2008 or AutoCAD Architecture (formerly Architectural Desktop or ADT) 2007 and later.
■ Support for all ObjectARX custom objects (ignored by the Legacy importer).
■ Specialized support for AutoCAD Architecture and Revit objects, including style/component grouping and naming, style associations for material and modifier propagation, and material translation and assignment.
■ Specialized support for AEC Civil contour objects (translated into a Terrain object).
■ Support for Raster objects.
■ Support for axonometric named views (translated into cameras with the Orthogonal toggle turned on). Both importers can translate perspective views.
■ Support for attached drawing xrefs.
■ Support for DXF files.
■ Rescaling to imported drawings created with units that differ from the 3ds Max system units.
■ Ability to skip frozen layers, or to select specific layers to import (or exclude) from a list.
■ Ability to set shape rendering parameters before importing to 3ds Max.
■ Ability to maintain layer assignments from the drawing file.

Features Unique to the Legacy DWG Import System

■ AutoCAD primitives are translated into 3ds Max primitives.
■ Support for Text (though not MText).
Imported blocks are represented as groups.

### Interface

*Derive Objects By group*

**Layer** Names each 3ds Max object based on the object layers specified in the drawing file. The layer name is followed by a number for each object from that layer. For example, an object on the layer BASE becomes BASE.01. If Convert To Single Objects is turned on, objects on the same layer become a single 3ds Max object.

**Color** Derives the name of each 3ds Max object based on the object's layer color in the drawing. The AutoCAD color number is followed by a number for each object using that layer color. For example, objects on a layer that is set to the color red (Color number 001) become COLOR001.01. Colors assigned by object are ignored in favor of colors assigned by layer. If Convert To Single
Objects is turned on, objects assigned the same layer color become a single 3ds Max object.

**Entity** Names each 3ds Max object based on the object type. The object type name is followed by a number for each object converted. For example, a Line object becomes Line.01. Drawings can contain thousands of entities, so deriving objects by entity can create many 3ds Max objects.

**General Options group**

**Convert to Single Objects** Combines multiple objects in the drawing file into a single 3ds Max object. Objects are combined according to the current Derive Objects By setting and their 3ds Max object type. Explicit mesh objects are combined. Shapes with no Z axis extrusion are combined, as are shapes with the same Z axis extrusion amount. Shapes with differing amounts of Z axis extrusion are assigned an Extrude modifier and are not combined.

**Convert Blocks to Groups** Places all objects in a block entity into a 3ds Max group that uses the name of the block entity and the number .01. For example, a block entity named CHAIR becomes a collection of 3ds Max objects inside a group named [CHAIR.01].

Multiple insertions of the block entity are converted to instances of the 3ds Max group. For example, a second insertion of the block, CHAIR, becomes an instance of [CHAIR.01] named [CHAIR.02].

When Convert Blocks To Groups is turned off, block definitions are ignored and block insertions are treated as separate objects, similar to exploding blocks in AutoCAD.

**Skip Off and Frozen Layers** Excludes the import of objects on layers that are hidden or frozen.

**Skip Hatches and Points** Excludes the import of hatch patterns and point objects.

Hatch patterns are made of many short line segments and points. Importing all the objects in hatch patterns can overload your 3ds Max scene.

**NOTE** Hatch patterns are stored in drawings as anonymous blocks. Skip Hatches And Points skips any other anonymous blocks in the drawing file. Hatch patterns created in AutoCAD R14 are skipped regardless of this setting.

**Group Common Objects** Puts imported objects into a common group, based on how they are derived. In other words, the group would include all objects on a common layer, or color, and so on.
Geometry Options group

**Weld** Sets whether coincident vertices of converted objects are welded according to the Weld Threshold setting. Welding smoothes across seams and unifies normals of objects with coincident vertices. To use the Weld option, first turn on Convert To Single Objects, because welding occurs only for vertices that are part of the same object.

**Weld Threshold** Sets the distance that determines whether vertices are coincident. If the distance between two vertices is less than or equal to the Weld Threshold setting, the vertices are welded together.

**Auto-Smooth** Assigns smoothing groups according to the Smooth Angle setting. Smoothing groups determine whether faces on an object render as a smooth surface or display a seam at their edges, creating a faceted appearance.

**Smooth Angle** Controls whether smoothing occurs between two adjacent faces. If the angle between the two face normals is less than or equal to the Smooth Angle setting, the faces are smoothed.

**Unify Normals** Analyzes the face normals of each object and flips normals where necessary, so they all point out from the center of an object. If the imported geometry is not properly welded, or if 3ds Max can't determine the object's center, normals might be oriented in the wrong direction. Use the Edit Mesh or Normal modifiers to flip normals.

When Unify Normals is turned off, normals are calculated according to the face vertex order in the drawing file. Face normals for 3D Solids are already unified. Turn off Unify Normals when importing 3D Solid models.

**Cap Closed Entities** Applies an Extrude modifier to all closed entities, and turns on the Cap Start and Cap End options of the modifier. The Extrude modifier Amount value for a closed entity with no thickness is set to 0. Capping makes closed entities with thickness appear solid and closed entities without thickness appear flat. When Cap Closed Entities is turned off, the Extrude modifier Cap Start and Cap End options for closed entities with thickness are turned off. No modifiers are applied to closed entities without thickness, except for Circle, Trace, and Solid.

AutoCAD 3D Solids Group

**Surface Deviation** Specifies the maximum allowable distance from the 3ds Max surface mesh to the parametric 3D solid surface. Small numbers produce more accurate surfaces with a greater number of faces. Large numbers produce less accurate surfaces with fewer faces.
Exporting AutoCAD DWG Files

Application menu on page 7989 > Export > AutoCAD (*.DWG)

When you export an AutoCAD drawing file, you convert your 3ds Max objects into AutoCAD objects. Because AutoCAD doesn't support animation, the exporter produces objects in a static state defined by the current frame set by the time slider.

If you used layers, instances, or colors to organize objects in the scene, that structure is maintained when the model is exported.

Exported objects with modifiers assigned to them are affected by the current state of the modifier. For instance, if the Taper modifier assigned to a box is turned off, the exported scene shows a non-tapered box.

**NOTE** Layers created in 3ds Max are not exported to AutoCAD.

**NOTE** Exporting to an AutoCAD R14 drawing file is not supported. If you are working with AutoCAD R14, export to 3DS or DXF file format.

What to Expect When Opening the DWG File

When you open an exported drawing in AutoCAD, you are presented with an isometric (3/4) view looking toward the positive XY direction instead of a Front elevation view.
The isometric view of an exported model opened in AutoCAD

The exporter also sets two AutoCAD system variables:

- INSUNITS, Insert Units, sets the drawing-unit value for blocks or images inserted from AutoCAD Design Center. Therefore, if you have the units of a model in 3ds Max set to millimeters, INSUNITS will be set to 4.

- MEASUREMENT sets the drawing units either to English or Metric.

See also:

- Exporting to DXF Files on page 7694

Procedures

To export a DWG file:

1. Choose Application menu on page 7989 > Export.
2. From the Files Of Type drop-down list, choose AutoCAD (*.DWG).
3. Specify a file name to export.
4 Set options in the Export to AutoCAD File dialog (described following).

**Interface**

![Export to AutoCAD File dialog](image)

**Export version**


**NOTE** When exporting to AutoCAD 2010, all entities from the 3ds Max scene are collapsed to an "end-of-stack" mesh and exported as a MESH object in the DWG file. The MESH object is set to Subdivision level 0.

This new MESH object type is implemented in the context of AutoCad 2010 for Subdivision Surfaces workflows. It removes some of the current limitations of the PolyFace object:

- The MESH object is not limited to 32K vertices so it can handle complex 3ds Max meshes.
- The MESH object provides tools within AutoCAD to convert as true ACIS Solid entities.

The next option lets you choose to export everything in the current scene or only selected objects:

- **Entire Scene**  All objects in the scene are exported. This is the default setting.
- **Selected Objects** Only selected objects are exported. Choosing this is equivalent to using File > Export Selected on page 7583.

---

7692 | Chapter 21  Managing Scenes and Projects
Geometry Options group

**Convert Instances To Blocks** Converts instances to AutoCAD block insertions. The block definition uses the same name as the first instance converted. When turned off, each instance is converted as a separate AutoCAD object. References are always exported as separate objects.

**Skip Hidden Objects** Toggles export of hidden objects. When on, hidden objects are not exported.

**Ignore Extrude Capping** When on, exports shapes with Extrude modifiers as 2D AutoCAD objects with a thickness property, and ignores the state of the Cap Start and Cap End parameters. When off, shapes with Extrude modifiers that also have Cap Start or Cap End on are exported as polyface 3D meshes. Extruded circles, donuts, and rectangle objects export as AutoCAD circles, donuts, and trace objects with a thickness property.

AutoCAD Interchange (DXF) Files

Most commonly, DXF files are used to import and export modeling data to and from CAD programs that have support for DXF but not DWG files. The topics in this section describe how to work with the DXF format.

**Importing DXF Files**

[Application menu](#) on page 7989 > Import > Select File To Import dialog > Files Of Type > AutoCAD (*.DXF)

If using a DWG file is not an option, the DXF file format is the next best method of getting design data to and from 3ds Max. Most commonly, DXF files are used to import and export modeling data to and from CAD programs that have support for DXF but not DWG files.

When you import an DXF file, 3ds Max converts a subset of AutoCAD objects to corresponding 3ds Max objects. Importing DXF files employs the same methods as importing DWG files. For more information, see [Importing AutoCAD Drawing Files](#) on page 7666.
Exporting to DXF Files

Application menu on page 7989 > Export > Select File To Export dialog > Save As Type > AutoCAD (*.DXF)

DXF files are used to import and export objects to and from AutoCAD (and other programs that support this file format).

NOTE The DXF Exporter can export only mesh data. Therefore, all shapes and splines on page 8720 are exported as mesh objects. Consequently, any open splines (which cannot be converted to mesh objects) in your scene will not be exported.

See also:
- Exporting AutoCAD DWG Files on page 7690

Interface

Export version

Export version list Lets you choose the AutoCAD version to export. You can export to AutoCAD 2010, AutoCAD 2007, AutoCAD 2004, AutoCAD 2000, or AutoCAD R12 DXF format.
- Entire Scene (The default.) All objects in the scene are exported.
Selected Objects When chosen, only the selected objects are exported. Choosing this option is comparable to using File > Export Selected on page 7583.

Geometry Options group

Convert Instances To Blocks Converts instances to AutoCAD block insertions. The block definition uses the same name as the first instance converted. When turned off, each instance is converted as a separate AutoCAD object. References are always exported as separate objects.

Skip Hidden Objects Exports hidden objects. When turned off, hidden objects are not exported.

Ignore Extrude Capping When turned on, exports shapes with Extrude modifiers as 2D AutoCAD objects with a thickness property, and ignores the state of the Cap Start and Cap End parameters. When turned off, shapes with Extrude modifiers that also have Cap Start or Cap End turned on, are exported as polyface 3D meshes. Extruded Circles, Donuts, and Rectangles export as AutoCAD Circles, Donuts and Traces with a thickness property.

Importing Autodesk Inventor Files

Application menu on page 7989 > Import > Select File To Import dialog > Files Of Type > Autodesk Inventor (*.IPT, *.IAM)

IPT and IAM are the native Autodesk Inventor® file formats for parts (IPT) and assemblies (IAM). You can import both file formats into 3ds Max.

The components of models that you import into 3ds Max retain their object naming as assigned in Autodesk Inventor and appear as editable meshes on page 2192. Once imported, you can edit the model just as you would any other type of object that you construct. You can apply modifiers, alter materials, add lighting and cameras, create animations, and so on.

Requirements and Limitations

In order to be able to import models that originate from Autodesk Inventor, Inventor 8, or later, is required to be installed along with 3ds Max on the system.
At this time, there are some limitations to the Inventor Importer. They are as follows:

- Camera animation paths are not converted to 3ds Max cameras so any animation you’ve set up in Inventor is lost during import.
- Any lighting from brightness and ambience settings created in the Inventor file are not imported. You will have to relight the scene once the import is complete.
- A model that is set up with constraints to limit the movement of parts will lose those constraints upon import. You will need to use inverse kinematics (IK) on page 3661 to restore the constraints.
- Dragging and dropping an Inventor file into 3ds Max uses the settings last set on the Inventor File Import dialog with the except for Mesh Resolution, which always resets to 0.
- 3ds Max uses the last version of Inventor that was opened to set the Import version. For instance, let’s say you have both Inventor 8 and Inventor 10 on your system. If the last version of Inventor you ran was Inventor 8, you cannot import Inventor 10 files. Inventor 8 must be closed and Inventor 10 opened, at least once, in order for you to successfully import Inventor 10 files.

**Material Handling**

Materials and material assignments made to the original Inventor model are retained and imported along with the geometry. Materials are imported as Architectural materials on page 6148 or if a single object has several materials assigned to it, they are imported as a Multi/Sub-Object material on page 6120.

**Procedures**

**To import an IAM or IPT file:**

1. Choose Application menu on page 7989 > Import.
2. Choose Autodesk Inventor (*.IPT, *.IAM) in the Files of Type list.
3. Specify a file name to import.
4. Set options in the Autodesk Inventor File Import dialog.
**Interface**

**Merge / Replace Options group**

**Merge With Current Scene** Incoming geometry is merged with any existing geometry that is already present in the scene. This setting is useful if you have several separate files that contains components that you want to combine into a single model.

**Completely Replace Current Scene** The file you're importing will completely replace any existing geometry that is in the current scene. If your current scene has not been saved, you are given the opportunity to save your changes to the current scene before the import process continues. Default=on.

Importing Autodesk Inventor Files | 7697
Material Options group

**Import Inventor Materials** When turned on, all Inventor materials and texture maps are translated and imported into the scene. If turned off, no materials are imported with the model.

**Assign Material IDs** Lets you control whether material IDs are assigned to objects that are imported from Inventor. You can assign different materials to different surfaces of the same object while working in Inventor. When these objects are imported to 3ds Max, material IDs are assigned to the faces of single objects to which multiple materials are applied.

For example, you’ve created a single object that represents a knob that has a threaded shaft and you’ve applied a black, plastic material to the knob and a silver, metal material to the threaded shaft. If Assign Material IDs is turned on when you import the model into 3ds Max, the faces of the object that have the plastic material are assigned material ID #1 and the faces that have the metal material are assigned material ID #2. If you choose to try different materials while working in 3ds Max, you can quickly make sub-object selections on page 199 based on the material IDs or apply a Multi/Sub-Object material on page 6120 that contains materials that correspond to the IDs assigned to the faces.

Mesh Resolution group

**Mesh Resolution** This slider lets you determine the degree of refinement applied to mesh objects by the importation process. When set to 0 (zero), the geometry is imported as it appears in Autodesk Inventor. When set less than zero, the mesh is optimized with fewer faces thus reducing detail. If the mesh resolution is set higher than zero, the mesh is tessellated with more faces, giving you greater detail.

The mesh resolution slider is always set to 0 when you initiate an import.
Left: Mesh Resolution=−7.
Center: Mesh Resolution=0.
Right: Mesh Resolution=+7.

**NOTE** The option to adjust mesh resolution is available only for models imported from Autodesk Inventor 10 or later.

**Inventor File Vertical Direction group**

This option determines the model’s orientation upon import. You can choose which axis of the Inventor model is vertical.

- **X Axis** The X axis of the model, as seen in Inventor, is rotated so it is vertical when the model is imported.
- **Y Axis** The model is imported with the Y axis oriented as the vertical axis.
- **Z Axis** The imported model is rotated so its Z axis is the vertical axis.
Exporting 3D DWF Files

Application menu on page 7989 > Export > Export to DWF

Application menu on page 7989 > Export > Choose Publish To DWF from the Save As Type drop-down list.

With 3D DWF publishing, you can export Design Web Format™ (.DWF™) files of your three-dimensional models with nearly the same visual fidelity as in rendered scenes. DWF files are relatively small files that you can easily share with team members who might not have 3ds Max.

DWF also provides a fast way to view models without having to spend time animating and rendering them, because you can use the Orbit feature in the DWF viewer to fly around the model.
For example, a DWF file of your scene can allow you and others to quickly view an interactive model as well as the properties of each object.

Recipients of 3D DWF files can view and print them using Autodesk® Design Review, which is an optional part of the 3ds Max install program. For more information about using the viewer, see the Autodesk Design Review help system.

**Feature Support with 3D DWF Export**

- 2D and 3D splines. The Enable In Viewport setting on the Rendering rollout on page 580 does not need to be enabled in order to export splines.
- 3D geometry
- Texture-mapped materials with a diffuse map channel, UV mapping channels, and material IDs

**NOTE** Materials that have Use Real-World Scale on page 6188 enabled display more accurately in the Autodesk Design Review program.

- Procedural materials, but only as a rough, low-resolution approximation. Real-World Map Size should be off for objects with procedural materials.
- Materials that have transparency are correctly exported and their opacity values are recognized by the Autodesk Design Review program. Even when you orbit the view, objects that pass behind other objects with transparent materials are still visible.

**Limitations of 3D DWF Export**

**Materials and Environments**

- Environment backgrounds do not export; the Design Review program uses its own background color setting.
- Environmental effects such as fog do not export.
- Materials using reflection maps such as Flat Mirror do not produce reflections when exported.
- Two-sided materials are not supported. However, you can get around this by turning on Force 2-Sided on the Render Setup dialog.
**NOTE** Turning on Force 2-Sided affects the entire scene. This can slow down the performance of Design Review because it has to process the two-sided display of everything in scene.

- Materials from third-party suppliers and mental ray materials are not exported. Objects that have unsupported materials display in their diffuse colors in the viewer. AutoCAD Architecture materials are displayed in their ambient color.

- Export doesn’t support all material parameters, even with supported materials. Therefore, materials you export to Design Review might not look as they do in a rendered image.

**Lights**

- You cannot export scene lighting.

**Cameras and Animation**

- Named camera views are exported. The exporter creates a DWF view for each camera in the scene. You can choose these views from the Views panel in the Autodesk Design Review program, but the cameras are not otherwise visible as objects in the scene.

- Animations are not supported, however, the frame at the time of the export is published.

**Procedures**

**To export a 3D DWF file:**

1. Set up the scene in the active viewport as you want it displayed in the Autodesk Design Review program.
   
   If you want to publish particular objects or layers, make a selection set of those objects. Hide those objects or layers you do not want published.

   **NOTE** You can also isolate objects in the viewer you want to hide or make transparent.

   **TIP** If you have a camera in the scene and want that view exported, make sure the Camera viewport is active when you publish the DWF file.
2 Choose Application menu on page 7989 > Export > Export To DWF. You can also simply choose Export, and then choose Publish To DWF (*.DWF) from the Save As Type list in the file selector dialog.

3 Specify a file name to export.

4 Click Save.

5 Use the DWF Publish Options dialog to make the desired settings, and then click OK.

6 If you turn on Save Log file but do not want the existing log file to be overwritten, enter a new name or specify a different folder.
Interface

DWF Publish Options

Grouping Options
- Group by Object
- Group by Layer

Publishing Options
- Publish Object Properties
- Publish Materials
- Publish Selected Objects Only
- Publish Hidden Objects

General
- Show DWF in Viewer
- Rescale Bitmaps
  Maximum Resolution (pixels) 512
- Use Default DWF Lights
- Save Log File:
  [C:\Program Files\Autodesk VIZ 200]

Help  OK  Cancel
Grouping Options group

Group by Object When on, objects are listed on the Navigator Pane in Design Review by object name or group name.

Group by Layer When on, objects are grouped on the Navigator Pane of Design Review by their respective layers.

Publishing Options group

Publish Object Properties When on, object property data is exported and displayed in Design Review and reported in the log file if Save Log File is enabled. The displayed properties are name, layer name, face count, vertex count, and whether the object is frozen or hidden.

Publish Materials Exports objects with their assigned materials in Design Review. When off, exports objects in their basic object colors. Material names are not exported.

Publish Selected Objects Only Exports only objects that are selected when you export.

Publish Hidden Objects Hidden objects are exported and displayed in the viewer. When off, objects that are hidden or on layers that are hidden do not appear. Hidden objects are listed in the log file if Save Log File is enabled.

NOTE Frozen objects and frozen layers are exported.

General group

Show DWF in a Viewer When on, Autodesk Design Review automatically opens the exported DWF file. When off, you must run Design Review and open the file manually.

Rescale Bitmaps When on, bitmap textures are automatically rescaled in the DWF file to the size set for pixels for Maximum Resolution. When using large texture files, turn this on to reduce the DWF file size.

NOTE This setting has no effect when Publish Materials is off.

Maximum Resolution (pixels) Sets the maximum length, in pixels, of the longest edge of all the bitmap images that are used as textures.

NOTE All bitmap images exported to the DWF file are compressed to JPG on page 7848 format in order to create small DWF files.
Use Default DWF Lights  Lets you control whether Design Review adds its own default lighting. When turned off, the scene is displayed without lights in the viewer, which can result in the scene objects being flat shaded making them appear two dimensional. Turn Use Default DWF Lights off if the scene contains lights that are already baked into textures with Render to Texture on page 6843, otherwise it is recommended that DWF lights are used. Default=on.

NOTE  When exporting a scene with all the lighting baked into the texture maps after using Render to Texture, if Use Default DWF Lights is turned on the scene may actually appear darker in Design Review, and the built-in DWF lights will cause the scene lighting to change as you orbit around the objects in the scene. With it turned off, the lighting will be constant as you move through the scene.

Save Log File  When enabled, 3ds Max creates a text file with the .log file extension that lists objects, their layers, face and vertex counts that are exported as well as the time and date of the export. Objects that were not selected or hidden are also listed as not as not being exported. The log file is overwritten each time a DWF file is created unless the log file name or file location is changed. Default=on.

FBX Files: Data Sharing with Maya, MotionBuilder, Revit, Softimage, and Toxik

Application menu on page 7989 > Import/Export > [Files of type]=Autodesk (*.FBX, *.DAE)

FBX is the file format native to Autodesk MotionBuilder, a system used for the creation, editing, and blending of motion capture and keyframe animation. It is also the file format to use for sharing data with Autodesk Revit Architecture. You can import and export files in this format with 3ds Max. Maya, Softimage, and Toxik can also use the FBX format, making it a bridge among all these applications.

NOTE  The FBX importer/exporter also supports the Collada (DAE) file format.

Interface

For the current version of the 3ds Max FBX Plug-in Guide, click the ? (Help) button on the FBX Importer/Exporter dialog.
The FBX plug-in changes often, with the result that Autodesk updates it more frequently than it does 3ds Max. Be sure to check regularly for updated versions by clicking the Check For Web Updates button on the Import/Export dialog.

OpenFlight (FLT) Files

**Application menu** on page 7989 > Import/Export > [Files of type]=OpenFlight (*.FLT)

The OpenFlight® format is commonly used in visual-simulation systems. You can import and export OpenFlight files. With the **Flight Studio® utility** on page 7716, you can also create and edit objects and attributes in OpenFlight files.

![An OpenFlight scene](image)

This topic introduces some of the details that are necessary to understand how OpenFlight files are converted to 3ds Max structures, and then on export converted back into an OpenFlight file.


**IMPORTANT** 3ds Max supports import of OpenFlight files from version 14.2 through 15.8.

The following sections describe some of the exact data translation that happens when you import or export OpenFlight files.
Translation and Attributes

Taking an OpenFlight file and importing its structures into 3ds Max is not an exact fit. There are many aspects of OpenFlight that are appropriate for military visual simulations but in one way or another do not match 3ds Max methodology. There can be a mapping from OpenFlight to 3ds Max and then back to OpenFlight, but it takes some care to understand how each part of the scene graph is treated. Once you understand this translation, using Flight Studio will become much more efficient and productive.

Unless otherwise noted, any description in the following Import sections is also valid for the Export section. This means that any particular setting or parameter that is used on import is also used on export.

Attribute editing in Flight Studio is meant to be a combination of value editing and making use of various 3ds Max features. The attribute list for any node on page 8653 might not exactly reflect those attributes found in the OpenFlight specification. Great care has been taken to expose only those attributes for editing that are not found in any 3ds Max feature. This means that on export, some of the attributes will be set automatically, even though you have no direct means of changing those values.

All OpenFlight objects are represented as 3ds Max groups, except for geometry. On import, all 3ds Max group objects are opened for editing and are also hidden in the 3ds Max viewports. This allows the easy editing of any geometry and provides a clean viewport display.

Faces

Import

On import, OpenFlight faces must be translated into the 3ds Max mesh structure. This is accomplished by an algorithm that combines all OpenFlight vertices into a list and then creates a 3ds Max mesh. Part of the import translation's parameters are based on the Vertex Weld threshold and the Trivial Area threshold. See the [IMPORT XREF] for more details. In addition, all coplanar multisided (more than three edges) faces that are found are triangulated. Face colors, vertex UVs, vertex render state, and normals are maintained on import.

The import procedure also preserves materials and textures. The separate meshes that are created respect the following criteria: similar vertices, similar meshes and maps. The resulting 3ds Max mesh object is named according to the first face in that mesh.

7708 | Chapter 21  Managing Scenes and Projects
There is an additional attribute in the face node upon import. Use Max Normals is set to Yes if normals were found in the file. It is set to No if no normals were found.

**Export**

On export, the 3ds Max mesh geometry structure is written as OpenFlight faces. Each resulting face is given a derivative of the mesh name. The Comment field in the face node will be copied to each of the resulting faces in the OpenFlight file.

Faces that are colored using the 3ds Max VertexPaint modifier on page 1959 are exported as standard OpenFlight vertex colors.

On export, if Use Max Normals is set to No, then no normals will be sent to the file.

If the face has a material, its exported color is set to the diffuse component of that material. If not, the exported color is set to the wireframe color. If the face has a material and the Has FLT Material option is set to Yes, the 3ds Max material is exported to the OpenFlight file.

**Textures and Maps**

**Import**

The basic OpenFlight texture and maps are imported into the 3ds Max Material Editor.

Materials (via the vertex attribute settings) that have maps that are found to have an opacity channel are treated slightly differently. The map is copied to the material's opacity map channel. This will cause the 3ds Max viewport to display correctly. This opacity channel setting in the material is done only so the display of the model will appear as you expect. Transparent materials will appear as such.

Multi-textures are stored as a Standard material with a Composite map applied to its Diffuse map channel. At most, the Composite map will have eight sub-maps corresponding to the layers in the OpenFlight file. A map channel to store the UVs is created for each of the sub-maps; channels are given corresponding numerical assignments. For example, the first texture is associated with map channel 1. Unused composite maps are set but turned off. Also, any texture map that contains a "bump" or "custom" setting (via the vertex) will also be turned off. This is done to allow the proper viewing in the 3ds Max viewports.
IMPORTANT: 3ds Max uses a unique method for displaying materials and texture maps in viewports. It is not possible for 3ds Max to display all texture maps simultaneously for all types of materials. You might find that the viewport display does not visually match the materials in the OpenFlight file. The internal structures in Flight Studio maintain all of the material settings on import and export, but they might not all be visible at the same time in the 3ds Max viewports.

Texture maps are imported based on their path. First, the true path (the path that is stored in the OpenFlight file) is used to find the texture. If that fails, then Flight Studio looks in the same directory as the imported OpenFlight file. If the map is not found, then Flight Studio displays an error dialog. If the texture map is not found, its original path is maintained on export.

Export

Only maps that appear in the material's Diffuse channel will be exported. The previously discussed maps in the opacity map channel are not exported. Composite maps will be exported as OpenFlight multiple material textures.

If a material has a Composite map in its Diffuse channel, a multi-texture is created. All composite sub-maps and their corresponding UV maps are exported, no matter which map channel they are associated with. Keeping the map channels within the range of 1 to 8 will help keep the same indexing scheme over successive imports and exports.

The Shell Material is also supported on export. This material is created during a Render-to-Texture operation. Materials that correspond to the newly created baked texture maps are exported.

Light Sources and Light Points

Import

Light Sources in an OpenFlight file are imported as Omni, Spot, and Directional lights. Light Points (light strings) have a special mapping. The light point node is imported and its parameters are available for editing. For each particular light point (the individual points) a diamond-shaped mesh is generated and placed as a child of the light point node. That geometry represents the specific light point. Light strings that contain the OpenFlight replicate bead will be converted to individual light points.
Export

Light Points (light strings) will be exported as independent light points. As mentioned above, each light point is represented by geometry. On export, the position of any light point will be located at the center of the axis-aligned bounding box that encompasses the mesh. Any geometry can be used to represent the light point, as long as it resides as a child of the Light Point node in the hierarchy view.

If a Light Point node has no children (it is empty), then the node won't be exported to the file.

External References

Import

All external reference nodes are optionally read on import. Once imported, you are free to make edits to any geometry structure. Editing the file location in the External Reference does not cause the importer to read another file. Units are preserved across multiple external reference nodes. Any successive externally referenced file will be scaled to the units of the file imported first. Transformations associated with the External Reference node are maintained on import and export.

On import, any transformations associated with the External Reference node are maintained.

Export

Only the original (top) file that was imported will be exported. In other words, the standard export will start at the Scene Root node and recursively trace through the entire scene graph. Any nodes below the External Reference will not be exported. If you wish to export any nodes located below an External Reference node, use File > Export Selected.

If the imported External Reference node contained transformations, these will be combined and a ‘general matrix’ will be set on export.

Miscellaneous

LOD Node

When the Freeze attribute is set to Yes on an LOD (level-of-detail) node, the Center XYZ values located in the attribute panel are written to file on export.
Otherwise, these attributes are derived from the 3ds Max pivot point of the node.

**DOF Node**

When importing a DOF (degree-of-freedom) node, the Origin, Position On X-Axis, and Position On XY Plane attributes are used to set the 3ds Max pivot point for an object. The pivot point is then used to derive these values on export.

**Non-OpenFlight Objects**

All objects in 3ds Max will appear in the hierarchy view. Many 3ds Max objects do not have a corresponding representation in OpenFlight, but will appear in the hierarchy view. These non-OpenFlight objects will not be exported.

**Importing OpenFlight (FLT) Files**

*Application menu* on page 7989 > Import > [Files of type]=OpenFlight (*.FLT)

You can import OpenFlight files directly into 3ds Max.

You can edit and adjust the imported OpenFlight scene by using the *Flight Studio® utility* on page 7716.

**Procedure**

**To import an OpenFlight file:**

1. Within 3ds Max, choose File > Import.
2. In the Import dialog, use the Files Of Type drop-down menu to change the file type to OpenFlight (*.FLT).
Choose the file you want to import, and click Open.

The OpenFlight file, including textures, materials, geometry, and externals, is imported. Large files might load slowly, so be patient.

**IMPORTANT** 3ds Max supports import of OpenFlight files from version 14.2 through 15.8.

### Interface

![Flight Studio Import](image)

**Read External References** This check box enables the importer to recursively read all files that are externally referenced. When it is off, only the file chosen will be loaded. Default=on.

**Vertex Threshold** During the import process, all OpenFlight faces are converted to mesh structures. See the section Faces on page 7708. Any adjacent vertices that fall within the given linear distance threshold will be merged into a single vertex.

**Trivial Area** During the import and vertex welding process, a triangulation of each face occurs if the face contains four or more vertices. This setting sets
the minimum amount of surface area that will be accepted. If, after triangulation, a given face is smaller than the given area it will be discarded.

After you click OK, the import of the file begins. During the import process, a progress bar indicating the percentage of import completed displays at the bottom of the main 3ds Max window. You can cancel the import by clicking the Cancel button that appears to the right of the progress bar. Part of the file will have been imported, so if you click Cancel, we suggest you then choose File > Reset to clear out incomplete OpenFlight data.

**Exporting OpenFlight (FLT) Files**

*Application menu* on page 7989 > Export > [Files of type]=OpenFlight (*.FLT)

There are two ways to export your scene to an OpenFlight file.

The default method is to choose Export from the 3ds Max *Application menu* on page 7989. The steps are described in the procedure that follows.

You can also choose File > Export Selected. Use this if you want to export only selected objects from your 3ds Max scene to the OpenFlight format.

**Procedure**

To export a scene to an OpenFlight file:

1. In 3ds Max, choose File > Export.

2. In the Export dialog, use the Files Of Type drop-down menu to change the file type to OpenFlight (*.FLT).

3. Type in the name of the file you want to export, then click Save.
Interface

<table>
<thead>
<tr>
<th>Flight Studio Export</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Version</strong></td>
</tr>
<tr>
<td><em>OpenFlight 15.8</em></td>
</tr>
<tr>
<td><strong>Real World Location</strong></td>
</tr>
<tr>
<td><strong>Projection</strong></td>
</tr>
<tr>
<td><em>Flat Earth</em></td>
</tr>
<tr>
<td><strong>Ellipsoid</strong></td>
</tr>
<tr>
<td><em>WGS 1984</em></td>
</tr>
<tr>
<td><strong>Units</strong></td>
</tr>
<tr>
<td><em>Meters</em></td>
</tr>
<tr>
<td><strong>Latitude</strong></td>
</tr>
<tr>
<td><strong>Longitude</strong></td>
</tr>
<tr>
<td><em>0° 0' 0.00&quot; N</em></td>
</tr>
<tr>
<td><em>0° 0' 0.00&quot; E</em></td>
</tr>
<tr>
<td><strong>Origin</strong></td>
</tr>
<tr>
<td><strong>Lambert Upper</strong></td>
</tr>
<tr>
<td><em>45° 0' 0.00&quot; N</em></td>
</tr>
<tr>
<td><strong>Lambert Lower</strong></td>
</tr>
<tr>
<td><em>33° 0' 0.00&quot; N</em></td>
</tr>
<tr>
<td><strong>Options</strong></td>
</tr>
<tr>
<td><em>Auto Group</em></td>
</tr>
<tr>
<td><em>Copy Textures to Output Directory</em></td>
</tr>
<tr>
<td><em>Auto Object</em></td>
</tr>
</tbody>
</table>

**Version** This drop-down list sets the version of OpenFlight that the model will be exported to. You can export to versions 14.2 through 15.8. The list shows all possible options.

**Real World Location group**

**Projection** This drop-down list chooses the cartographic projection of the coordinate system. You can choose from Flat Earth, Trapezoidal, Round Earth, Lambert Conic, UTM, Geocentric, and Geodetic projection methods. Default = Flat Earth.

**Ellipsoid** This drop-down list defines the ellipsoid (also known as “the Datum”) of the coordinate system. You can choose from WGS 1984, WGS 1972, Bessel, Clarke 1866, and NAD 1927. Default = WGS 1984.
Units This drop-down list chooses the units of measure of the coordinate system for the exported model. You can choose from Meters, Kilometers, Feet, Inches, or Nautical Miles. Be aware that Kilometers and Nautical Mildes are not 3ds Max units. This field setting will be written to the header node of the OpenFlight file. Default=Meters.

Origin These fields set the latitude and longitude of the origin of the database.

Lambert Upper This field sets the latitude of the upper Lambert parallel. This field is active and available only when the Projection method is set to Lambert Conic.

Lambert Lower This field sets the latitude of the lower Lambert parallel. This field is active and available only when the Projection method is set to Lambert Conic.

Options group

Auto Group When off, the OpenFlight exporter will create an OpenFlight Group only when there is a 3ds Max group object. 3ds Max objects that are children of other 3ds Max objects will be siblings in the OpenFlight hierarchy. When on, an OpenFlight group will be created whenever a 3ds Max object is the child of another 3ds Max object. Default=on.

Auto Object When off, a 3ds Max object that is composed of multiple polygons will have only the polygons exported. When on, a 3ds Max object that is composed of multiple polygons will be placed under a common OpenFlight Object record. Default=on.

Copy Textures to Output Directory If the OpenFlight file is exported to a different directory, then when this option is on, any textures will be copied to the same destination directory. When off, the textures are not copied. Default=on.

Flight Studio Utility

Utilities panel > Utilities rollout > More button > Utilities dialog > Flight Studio

With the Flight Studio utility, you can manage OpenFlight models from within 3ds Max.
Procedures

To access the Flight Studio utility:

1. On the Utility panel, click the More button.
2. In the Utilities dialog, click to choose Flight Studio, and then click OK.
To make Flight Studio available from a button on the Utilities panel:

1. On the Utilities panel, click Configure Button Sets. 3ds Max opens the Configure Button Sets dialog on page 8225.

2. If you wish, increase the Total Buttons number so you don’t overwrite an existing utility button.

3. Drag the Flight Studio entry from the Utilities list on the left to a button in the button group on the right, and then click OK.

Interface

![Flight Studio Interface](image)

**Modify Hierarchy/Attributes** Click to open the Hierarchy Browser dialog on page 7719.
Level Of Detail group

These buttons use the OpenFlight level-of-detail (LOD) range to display more or less detail in 3ds Max viewports.

**More Detail** Increases by one level the amount of detail shown.

**Less Detail** Decreases by one level the amount of detail shown.

**Most Detail** Shows the most detail in the imported model.

**Least Detail** (The default.) Shows the least detail in the imported model.

---

**Use .rgb loader** When on, Flight Studio uses its own implementation of the RGB file on page 7877 loader. This loader supports RGB, RGBA, ATTR, INT, and INTA files. To use the original 3ds Max RGB bitmap plug-in, turn off this check box. Default=off.

**WARNING** Flight Studio might not function correctly when you use the original 3ds Max RGB bitmap plug-in.

---

**Hierarchy Browser Dialog (Flight Studio Utility)**

Utilities panel > Utilities rollout > More button > Utilities dialog > Flight Studio > Flight Studio rollout > Modify Hierarchy/Attributes button > Hierarchy Browser dialog

The Hierarchy Browser dialog allows you to arrange, select, and edit the OpenFlight scene and attributes of its nodes.

The Hierarchy Browser is nonmodal: You can leave it open while you edit objects in viewports and elsewhere in the 3ds Max interface.

**Procedures**

**To view the hierarchy:**

1. Import an OpenFlight file.
   - See OpenFlight (FLT) Files on page 7707 for general information, and Importing OpenFlight (FLT) Files on page 7712 for a specific user-Interface description.

2. Open the Flight Studio utility on page 7716.
3 Click the Modify Hierarchy/Attributes button. This opens the Hierarchy Browser.

4 The Hierarchy window displays a single node, called Scene Root. Click the plus (+) icon to the left of Scene Root to expand the scene graph.

**To select a node and all its children:**

1 On the Hierarchy Browser toolbar, turn on Subtree.

2 Select a node by clicking its icon in the Hierarchy window. The node and all its children are now selected.

**To copy a Hierarchy Browser selection to 3ds Max viewports:**

1 Select a node or nodes in the Hierarchy window.

2 ![Select Set](image) Click Select Set.

**To copy a 3ds Max viewport selection to the Hierarchy Browser:**

1 Select an object or objects in 3ds Max.

2 ![Select Get](image) Click Select Get.

**To change attribute values:**

1 Select a node in the Hierarchy window by clicking its icon.

2 In the Node Attributes window, click the Value field to the right of the Attribute name.

3 Change the attribute value by typing or choosing from the drop-down list.

4 Press Enter.

**To change a node name:**

1 Select a node in the Hierarchy window by clicking its icon.

2 Click the text of the node name. The name becomes an editable text field.
3  Type in the name change, then press Enter or click outside the edit field.

**To move a node in the hierarchy:**

1  Select a node in the Hierarchy window by clicking its icon.
2  Drag the node to the name of another node that will become the parent.
3  Drop the node by releasing the mouse.
   The node you dragged is now a child of the node over which you dropped.
   If the parent has multiple children, the node you moved becomes the last child.

**To create a new node:**

1  Select a node in the hierarchy by clicking its icon.
   The selected node will be the parent of the new node. (To create a top-level node, first select *Scene Root*.)
2  Choose the node type from the drop-down list at the right end of the Hierarchy Browser toolbar.
3  Click Create.
Interface

Toolbar

Controls on the toolbar manage node selection, interact with the current 3ds Max selection set, and let you create new nodes.

Refresh This button is active only after you have made a change to the 3ds Max scene. Any change to the scene invalidates the scene graph in the Hierarchy window, and scene graph navigation and editing is disabled until you click Refresh.

Up Arrow Click to move a selected node in the hierarchy up, relative to its siblings.

Down Arrow Click to move a selected node in the hierarchy down, relative to its siblings.

Expand Click to expand the selected node’s hierarchy.

Collapse Click to collapse the selected node’s hierarchy.
Select Get After selecting objects in a 3ds Max viewport, click Select Get to replicate that selection group in the hierarchy list. Nodes in the Hierarchy view will now also be selected and expanded.

Select Set After selecting objects in the Hierarchy view, click Select Set. The selection in 3ds Max viewports will now match those selected in the Hierarchy view.

Search Click Search to search for common node attributes. To begin, select a node in the Hierarchy view. Then select an attribute by clicking the name of that attribute. Next, click Search. All of the nodes that have the same attribute name will now be highlighted and selected in the Hierarchy view.

Switch This button is active while you have selected a Switch node in the Hierarchy view. Click to open the Switch Attributes dialog on page 7726, which lets you edit the Switch node mask data.

Global check box When on, changes made in the Attribute window affect all selected nodes.

Subtree check box When on, any node selection in the hierarchy browser window will cause all children to be selected. When off, clicking selects only the parent node.

Create button and Node Type list Click to create a node of the type you have chosen from the associated drop-down list.

To create a new node, follow these steps:
1. Use the drop-down list to choose the type of node you want to create.
2. In the Hierarchy window, click to select the node that will become the parent of the new node.
3  Click Create.

**Hierarchy window**

On the left side of the Hierarchy Browser dialog, the Hierarchy window displays a list of the nodes in your scene. You can click the plus and minus icons to expand or collapse the list of nodes that have children.

Node names in the Hierarchy window are also their 3ds Max object names.

Node types are visually represented in the hierarchy using the following icons:

- **Scene Root**
  The Scene Root has no attributes, and does not respond to drag and drop. It is simply a placeholder to represent the entire scene graph.

- **Header**

- **External Reference**

- **Group**

- **Face**

- **Object**

- **Level of Detail (LOD)**

- **Switch**

- **Degree of Freedom (DOF)**

- **Binary Space Partition (BSP)**

- **Clip Region**

- **Direct Light**

- **Point Light**

- **Omni Light**

- **Spot Light**
Non-OpenFlight object

The Hierarchy list shows the entire node structure as it was imported from the OpenFlight file.

For details about these OpenFlight node types, see http://www.multigen.com/products/standards/openflight/index.shtml. Also see OpenFlight (FLT) Files on page 7707 for information on how nodes are imported into 3ds Max.

The scene graph list is formatted to show the parent-child node relationships. Child nodes are always positioned below and indented to the right of their parents. Nodes that are on the same indentation level are considered siblings. If a node contains a small plus or minus (+/-) icon to the left of the node icon, this indicates the presence of children nodes. Clicking on the + or - will cause the list of the node's children to be expanded or collapsed.

If the Hierarchy list is too long for the window size, then scroll bars will appear on the left or bottom of the Hierarchy window, to let you scroll and view the entire scene graph.

To select a node, click its name. To select more than one node, use Ctrl+click. Clicking a node that is already highlighted deselects it.

You can use drag and drop to change a node's position in the hierarchy. Select a single node (drag and drop is supported only for a single node), drag its icon to another place in the hierarchy, then release the mouse to drop the node on top of its intended new parent. The node will then be placed at the bottom of the list of the parent's children.

To change a node name, select a node by clicking its icon, and then click the node name text. This opens an edit box that lets you change the text. When you are done, press Enter or click outside the edit box to confirm the change.

You can use the keyboard arrow keys to change the node selection. First, select a node in the hierarchy. Then press up-arrow or down-arrow to move the selection either up or down.

Node Attributes window

This group, on the right of the Hierarchy Browser dialog displays information about a node, including the node name, Comments field, and node attributes. You can edit some of this information.

Name Displays the type of the selected node, and its name. Node names in the Hierarchy Browser are also their 3ds Max object names.
If you have selected multiple nodes, you can use the arrows to the right of this field to scroll among them.

This field is for informational purposes only, and is not editable. You can change a node name by using the Hierarchy window, as described in the previous section.

**Comment** After you have selected a node, this field displays the text in the node's Comment. You can edit the contents of the Comment: simply type in the changes and then press Enter to confirm the changes.

**Attribute/Value columns** These columns display each node attribute, on the left, and the attribute's value, on the right. You can edit attribute values here: click the value itself to open the field for editing.

There are different types of value fields. Some are text-entry fields that require you to type in an explicit numeric value or string. Others have a drop-down list so you can choose from a set of predefined values.

Whether the attribute requires you to type in an entry or choose from a list, after you have changed the value, press Enter to confirm the change.

**Switch Attributes Dialog (Flight Studio Utility)**

Utilities panel > Utilities rollout > More button > Utilities dialog > Flight Studio > Flight Studio rollout > Modify Hierarchy/Attributes button > Hierarchy Browser dialog > Hierarchy window > Click to select an OpenFlight Switch node. > Click Switch on the toolbar. > Switch Attributes dialog

The Switch Attributes dialog lets you edit the mask data of a selected Switch node.

**Interface**
**Value field** Shows the current mask value. The mask is a string that can include only 1 and 0. You can enter a new mask value in this field.

**Mask Index** This spinner shows the index of the mask that is selected for editing. The selected mask controls the display of the children of the Switch node in 3ds Max, based on the state of the Show Mask In Viewport check box.

**Show Mask in Viewport** When on, the display of the models in 3ds Max viewports corresponds to the current mask.

**New** Click to add a new mask to the Switch node. Initially, all bits are set to zero (0, off).

**Delete** Click to delete the selected mask. Masks with higher indices automatically move down to fill the empty index position.

**Set** Click to turn on the display of all the children of the Switch node. Clicking Set changes all mask bits to one (1).

**Clear** Click to turn off the display of all the children of the Switch node. Clicking Clear changes all mask bits to zero (0).

**Invert** Click to toggle each bit in the mask. Each child that was previously zero is changed to one, and each child that was previously one is changed to zero. This inverts the display of the children of the Switch node.

---

**IGES Files**

The topics in this section describe how to use IGES (Initial Graphics Exchange Specification) files with 3ds Max.

**Overview of IGES in 3ds Max**

The Initial Graphics Exchange Specification (IGES) is an ANSI standard that defines a neutral form for the exchange of information among dissimilar computer-aided design (CAD), computer-aided manufacturing (CAM), and computer visualization systems.

3ds Max implements the IGES standard for translating files between 3ds Max and IGES file formats used by the mechanical engineering and entertainment industries. Using the IGES import/export feature, you can read in and write out native NURBS on page 8655 data between 3ds Max and programs such as Mechanical Desktop release 3.0, Maya™, Pro/ENGINEER®, SOFTIMAGE®,
CATIA®, and others. For complete details on the IGES standard, see The Initial Graphics Exchange Specification (IGES) Version 5.3.

What IGES Translates

The ideal file translation preserves the appearance and functionality of objects (called entities in IGES) contained in a file. This process has limits. You should be aware that some 3ds Max objects are not supported or not fully supported by IGES. Similarly, be aware that some IGES entities are not supported by 3ds Max. For example, you can’t translate animation data and mapping coordinates, as these elements are not supported by IGES.

As with all translations, concepts that can be expressed succinctly in one language might not have exact equivalents in another language; conversely, concepts common to two languages might be expressed differently by each.

Even when the objects you translate don’t have an equivalent in the target system, a one-time translation to or from IGES might not pose a serious problem. However, data loss can become a concern if you maintain objects that will be repeatedly translated in and out of different formats through IGES. By becoming familiar with the details of the systems and the IGES translators you use, you can learn to structure files to minimize information loss.

WARNING The conversion of objects during translation is not fully symmetrical. If you import an IGES file that you created by exporting to IGES, the resulting objects might not be identical to the original.

NURBS

When you import an IGES file into 3ds Max, IGES meshes are converted to NURBS on page 2416 surfaces, rather than to 3ds Max mesh objects. An IGES file with multiple meshes imports as a single NURBS model. Each IGES mesh is a surface sub-object within the model.

Each surface sub-object based on an IGES mesh is initially a rigid surface on page 2436. To edit the surface and its CVs on page 8543, you must first make the rigid surface independent. The following procedure explains how to do this.

Future Compatibility

The group that maintains and updates the IGES standard, the IGES/PDES (Product Data Exchange Standard) consortium, attempts to keep IGES upwardly compatible. It’s likely that files generated by 3ds Max will be compatible with future versions of IGES.
Procedures

To make rigid imported NURBS surfaces independent:

1. Select the object.

2. Go to the Modify panel.

3. In the Modifier Stack rollout, choose Surface as the sub-object level.

4. Select the surface sub-object you want to edit.

5. In the Surface Common rollout, click Make Independent.

NOTE Making rigid imported NURBS surfaces independent can take a long time if there are complicated surfaces in the file, or if the file is large. Avoid selecting all surfaces and then clicking Make Independent. Rather, save your file immediately after successfully importing it, and then use Make Independent with care.

IGES Log Files

During the translation process, 3ds Max creates log files containing detailed information about the processing of the model. This information includes error messages and entity-mapping statistics. You can use this log file to understand what occurred during the translation.

3ds Max places log files in the directory where the IGES file is either imported from or exported to. The log file name has the prefix name of the 3ds Max file name, with the extension of .xli (input) for import, and .xlo (output) for export.
The log file provides the following information:

- Name of the file processed.
- Number and severity of errors encountered, a description of them, and an explanation of what can be done, or what was done to the data in error. (3ds Max attempts to fix many errors itself.)
- Summary of entities processed.
- List of the entity types encountered and those created.

See also:

- [Overview of IGES in 3ds Max](#) on page 7727
- [3ds Max to IGES Export Table](#) on page 7736
- [Exporting IGES Files](#) on page 7734
- [IGES to 3ds Max Import Table](#) on page 7732
- [Importing IGES Files](#) on page 7730

### Importing IGES Files

**Application menu** on page 7989 > Import > IGES (*.IGE, *.IGS, *.IGES)

IGES files are used to import and export NURBS objects to and from 3ds Max (and other programs that support this file format). For more information, see **Overview of IGES in 3ds Max** on page 7727. In some cases, when you import an IGES file, the translation doesn't produce exact replicas. To understand what happens to each entity when it's translated, review the **IGES import table** on page 7732.

3ds Max imports an object containing multiple surfaces as a single NURBS object. To work with a single surface of the object, detach it in sub-object NURBS and work with only that object. This releases the rest of the object from memory. For more information, see **NURBS** on page 7728.

When you import IGES files, 3ds Max creates a log file containing detailed information about the processing of the model. The name of the file has the form of *filename.xli*. For more information, see **IGES Log files** on page 7729.
NOTE 3ds Max creates and uses a few temporary files during translation. Temporary files can be large. If there has been a computer or IGES translation failure and temporary files remain on your system, they might need to be removed to free up disk space. For storage of these temporary files in Windows, 3ds Max uses the directory specified by the TEMP environment variable, or the current directory if TEMP is not set.

See also:

- 3ds Max to IGES Export Table on page 7736
- Exporting IGES Files on page 7734
- IGES Log Files on page 7729
- IGES to 3ds Max Import Table on page 7732
- Importing IGES Files on page 7730

Procedures

To import an IGES file:

1. Choose Application menu on page 7989 > Import.
2. Specify the IGES file to import from the file selector dialog.
   You can choose IGES (*.IGE, *.IGS, *.IGES) from the Files Of Type list to display only IGES files.
3. From the IGES Import dialog, select Merge Objects With Current Scene or Completely Replace Scene.
4. To review the translation process, read the .xli log file with your preferred text editor.
Interface

The IGES Import dialog has the following controls:

**Merge objects with current scene** Merges imported data with the current scene.

**Completely replace scene** Completely replaces the current scene with the imported data.

**IGES to 3ds Max Import Table**

This topic presents a table that lists IGES entities and the 3ds Max objects they translate to when you import them. Any IGES entities not listed here do not import.

<table>
<thead>
<tr>
<th>IGES entity number</th>
<th>IGES entity name</th>
<th>3ds Max</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>Circular Arc</td>
<td>Arc Shape</td>
</tr>
<tr>
<td>102</td>
<td>Composite Curve</td>
<td>Spline Shape</td>
</tr>
<tr>
<td>104</td>
<td>Conic Arc</td>
<td>Spline Shape</td>
</tr>
<tr>
<td>IGES entity number</td>
<td>IGES entity name</td>
<td>3ds Max</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------</td>
<td>---------</td>
</tr>
<tr>
<td>106</td>
<td>Copious Data</td>
<td>Spline Shape</td>
</tr>
<tr>
<td>108</td>
<td>Plane</td>
<td>NURBS Surface (unbounded converts to construction plane)</td>
</tr>
<tr>
<td>110</td>
<td>Line</td>
<td>Spline Shape</td>
</tr>
<tr>
<td>112</td>
<td>Parametric Spline Curve</td>
<td>NURBS Curve</td>
</tr>
<tr>
<td>114</td>
<td>Parametric Spline Surface</td>
<td>NURBS Surface</td>
</tr>
<tr>
<td>116</td>
<td>Point</td>
<td>Point Helper</td>
</tr>
<tr>
<td>118</td>
<td>Ruled Surface</td>
<td>NURBS Surface</td>
</tr>
<tr>
<td>120</td>
<td>Surface of Revolution</td>
<td>NURBS Surface</td>
</tr>
<tr>
<td>122</td>
<td>Tabulated Surface</td>
<td>NURBS Surface</td>
</tr>
<tr>
<td>126</td>
<td>Rational B-spline Curve</td>
<td>NURBS Curve</td>
</tr>
<tr>
<td>128</td>
<td>Rational B-spline Surface</td>
<td>NURBS Surface</td>
</tr>
<tr>
<td>130</td>
<td>Offset Curve</td>
<td>NURBS Curve</td>
</tr>
<tr>
<td>140</td>
<td>Offset Surface</td>
<td>NURBS Surface</td>
</tr>
<tr>
<td>141</td>
<td>Boundary Curve</td>
<td>NURBS Surface</td>
</tr>
<tr>
<td>142</td>
<td>Curve on Parametric Surface</td>
<td>NURBS Surface</td>
</tr>
<tr>
<td>144</td>
<td>Trimmed Parametric Surface</td>
<td>NURBS Surface</td>
</tr>
</tbody>
</table>
The 3ds Max objects translated from IGES can have surface sub-objects. IGES import supports name and color mappings to 3ds Max names and colors. When you import IGES files, names are mapped by using the level name followed by a colon, and then the object name.

**See also:**
- 3ds Max to IGES Export Table on page 7736
- Exporting IGES Files on page 7734
- IGES Log Files on page 7729
- IGES to 3ds Max Import Table on page 7732
- Importing IGES Files on page 7730

### Exporting IGES Files

**Application menu** on page 7989 > Export > IGES (*.IGS)**

IGES files are used to import and export objects to and from 3ds Max (and other programs that support this file format). For more information, see **Overview of IGES in 3ds Max** on page 7727.

In some cases, when you export 3ds Max objects to an IGES file, the translation doesn't produce exact replicas. To understand what happens to each object when it's translated, review the **IGES export table** on page 7736.
When you export IGES files, 3ds Max creates a log file containing detailed information about the processing of the model. The name of the file has the form of filename.xlo. For more information, see IGES Log files on page 7729.

**NOTE** If there are modifiers applied to surfaces in your scene, it's best to collapse the stack before exporting to IGES. When 3ds Max exports to an IGES file, it skips any surface that has any modifiers applied.

See also:
- 3ds Max to IGES Export Table on page 7736
- IGES Log Files on page 7729
- IGES to 3ds Max Import Table on page 7732
- Importing IGES Files on page 7730
- Overview of IGES in 3ds Max on page 7727

**Procedures**

To export an IGES file:

1. Select the objects to export.
2. Choose Application menu on page 7989 > Export.
3. Choose IGES (*.IGS) from the Save as type list in the file selector dialog.
4. Specify a file name to export.
5. Click Save.
6. From the IGES Export dialog, select Export Hidden Objects or Export Selected Objects Only.
7. To review the translation process, read the .xlo log file with your preferred text editor.
Interface

IGES Export

The IGES Export dialog has the following controls:

Export Hidden Objects Exports objects that are currently hidden in the 3ds Max scene.

Export Selected Objects Only Exports only objects that are currently selected.

3ds Max to IGES Export Table

This topic presents a table that lists 3ds Max objects and the IGES ID and IGES Type they translate to when you export them. Any 3ds Max objects not listed here do not export.

NOTE The convention for denoting the type of IGES entity is the numerical construction type:form. For example, 214:2 is the IGES entity number 214, form 2. Form numbers can also be signed (given a positive or negative value).

<table>
<thead>
<tr>
<th>3ds Max object</th>
<th>IGES entity name</th>
<th>IGES entity number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Surface</td>
<td>Rational B-spline Surface</td>
<td>128</td>
</tr>
</tbody>
</table>

7736 | Chapter 21  Managing Scenes and Projects
<table>
<thead>
<tr>
<th>3ds Max object</th>
<th>IGES entity name</th>
<th>IGES entity number</th>
</tr>
</thead>
<tbody>
<tr>
<td>NURBS Surface</td>
<td>Bounded Surface</td>
<td>143</td>
</tr>
<tr>
<td>Trimmed Surface</td>
<td>Bounded Surface</td>
<td>143/144</td>
</tr>
<tr>
<td>Curve</td>
<td>Rational B-spline Curve</td>
<td>126</td>
</tr>
<tr>
<td>Point</td>
<td>Point</td>
<td>116</td>
</tr>
<tr>
<td>Group</td>
<td>Group</td>
<td>402:7</td>
</tr>
<tr>
<td>Instance</td>
<td>Subfigure Definition</td>
<td>308</td>
</tr>
<tr>
<td>Instance(s)</td>
<td>Subfigure Definition(s)</td>
<td>408</td>
</tr>
</tbody>
</table>

**Notes**

When 3ds Max exports IGES, it supports name and color mappings to IGES names and colors.

Since IGES requires unique names per element, 3ds Max will append a unique identifier to multiple objects with the same name.

**See also:**

- Exporting IGES Files on page 7734
- IGES Log Files on page 7729
- IGES to 3ds Max Import Table on page 7732
- Importing IGES Files on page 7730
- Overview of IGES in 3ds Max on page 7727

**JSR-184 Files**

Application menu on page 7989 > Export > JSR-184 (*.M3G)
3ds Max provides support for developing mobile games using the JSR-184 format. JSR-184 is a Java standard used to create 3D applications for mobile phones. Once you have exported your scene to JSR-184 format, you can preview the animation using the JSR-184 Standalone Player on page 7749.

Procedures

To export an M3G file:

1. Choose Application menu > Export.
2. Choose JSR–184 (*.M3G) in the Files Of Type list.
3. Specify a file name to export, and then click Save. This opens the JSR-184 dialog, displaying the scene hierarchy for your 3ds Max scene. By default, all of the elements in your scene are also listed for export in the JSR-184 scene.

   NOTE If you wish to export a particular object in your scene, use File > Export Selected, or delete the objects you do not wish to export by clicking . If an object is a descendant within an hierarchy, it will be exported with its hierarchy. The same applies for objects in a group.

4. Modify the parameters of objects exported to JSR–184. See JSR-184 Object Parameters on page 7741 for more info.
5. Click Export.
6. Preview your exported JSR-184 scene in the JSR-184 Standalone Player on page 7749.
Interface

The 3ds Max scene hierarchy is shown on the left of the dialog, and the hierarchy of the JSR-184 scene to be exported is displayed on the right. Object parameters for the JSR-184 scene are displayed on the far right-hand side of the JSR-184 Export dialog. The exported m3g file contains all of the objects and parameters included in the JSR-184 scene. Many of the parameters for the objects in the JSR-184 scene can be modified prior to exporting the file. See JSR-184 Object Parameters on page 7741 for more details.

Menu options:

- **New JSR-184 Scene** Creates an empty JSR-184 scene
- **Add 3ds Max Scene** Adds all objects that can be converted to the JSR-184 format to the JSR-184 scene.
**Add World Object** Adds a World Object to the JSR-184 scene file. A World Object contains sub-object hierarchies and has two special sub-objects: Active Camera and Background.

**Add Group** Adds an empty Group. Use this option to group objects in your scene without the need to create a World Object.

**Convert Mesh to Sprite3D** Converts a selected 3ds Max plane object into a JSR-184 Sprite3D object. If you do not select this option, by default all plane objects are converted to JSR-184 mesh objects.

**Texture Tool** All the textures of objects in your 3ds Max scene are placed in the Material Table level of JSR184 image file. Use the JSR-184 Texture Tool on page 7746 to edit texture properties.

**Remove Object** Removes the selected object from the JSR-184 scene.

**Export Settings:**

- **Authoring Message** This message is required by the JSR-184 file format standard and is usually reserved for entering copyright notice information. This message is stored in the header portion of the M3G file.

- **Project Root** Sets the location of the root of the project. If you do not enter a path in this field, all external references within the M3G file are loaded from the same location as the current file.

- **Show Hidden Objects** Shows all the hidden objects in the 3ds Max scene hierarchy.

- **Compress M3G File** Compresses all the data in the exported M3G file.

- **Auto Assign User IDs** Automatically assigns unique User ID values to all exported objects.
JSR-184 Object Parameters

Application menu on page 7989 > Export > JSR-184 (*.M3G).

The JSR-184 data file is represented as the root object of your scene. Many of the parameters of objects in the JSR-184 data file can be adjusted to optimize the output of your scene. You can preview your exported scene using the JSR-184 Standalone Player on page 7749.

NOTE All editable parameters are displayed in italic.

The JSR-184 Data File

Material Table

Material Table is a special object that contains all the materials and textures used in the JSR-184 scene. The Material Table has a two-level structure: the 3ds Max material name is the first level and its associated textures comprise the second level. The Material Table is represented as [Material Table] in the JSR-184 scene tree.

The 3ds Max level displays the following parameters:

■ **Approx.Object Size**: Shows the object size with sub-objects.

■ **User-defined ID**: Displays the user ID for the object.

■ **Layers**: Sets the rendering layer for the JSR-184 Appearance Object. When rendering a World, Group, or Mesh, submeshes and sprites are rendered in the order of ascending layers.

The texture level displays the following parameters:

■ **Approx.Object Size**: Shows the object size with sub-objects.

■ **User-defined ID**: Displays the user ID for the object.

■ **Blending**: Specifies how to combine the filtered texture color with the incoming fragment color in a texturing unit. This is equivalent to the texture environment mode in OpenGL. Options are Add, Blend, Decal, Modulate, and Replace.

■ **WrappingS and WrappingT**: The Repeat and Clamp texture wrapping modes define the treatment of coordinate values that are outside the [0,1] range.
Level Filter: Sets the texture filtering. Options are Nearest, Linear, and Base Level.

Image Filter: Sets the image filtering. Options are Nearest, Linear, and Base Level.

**World**

World is a special Group node that is a top-level container for scene graphs. A World Object is represented as `<<World>>` in the JSR-184 scene tree. Every world object has three sub-objects: [Background], [Active Camera], and [Ambient Light]. A World object has the following parameters:

- **Approx.Object Size**: Shows the object size with sub-objects.
- **User-defined ID**: Displays the user ID for the object.
- **Enable Rendering**: Sets the picking enable flag of this node. The effective rendering enable status for this node is the logical AND of the enable flags on this node and all of its ancestors. This means that the World node is disabled if any of its ancestors are disabled. The status of the World node has an effect only if all its ancestors are enabled. If the effective status is set to True, this node is enabled. If it is False, it is disabled.
- **Enable Picking**: Sets the picking enable flag of this node. The effective rendering enable status for this node is the logical AND of the enable flags on this node and all of its ancestors. This means that the World node is disabled if any of its ancestors are disabled. The status of the World node has an effect only if all its ancestors are enabled. Options are True and False.
- **Alpha Factor**: Allows groups of mesh objects to fade in and out conveniently, provided that certain preconditions related to their appearance are met. The Alpha Factor is defined for each node, and its value is between 0 and 255.
- **Scope**: Allows the scene graph nodes to form conceptual groups independent of the scene graph hierarchy. By default, all objects are visible to all cameras and lit by all light sources. The scope is an integer bitmask set to -1 by default.

**Background**

Every world object has two sub-objects: [Background] and [Active Camera]. The only parameter available for the Active Camera is selecting an active
camera from sub-objects of the current World Object. Background parameters are listed below:

- **Approx.Object Size**: Shows the object size with sub-objects.
- **User-defined ID**: Displays the user ID for the object.
- **Image Mode X and Image Mode Y**: Sets the background image repeat mode for the X and Y directions. Image mode can be set to either Border or Repeat.
- **Depth Clear Enabled**: Enables or disables depth buffer clearing. If depth buffer clearing is enabled, the portion of the depth buffer that corresponds to the viewport is cleared to the maximum depth value. Set this parameter to True to enable depth buffer clearing. Set it to False to disable.
- **Color Clear Enabled**: Enables or disables color buffer clearing. If color buffer clearing is enabled, the portion of the color buffer that corresponds to the viewport is cleared with the background image and/or the background color. Set this parameter to True to enable color buffer clearing. Set it to False to disable.

**Group**

Group is a scene graph node that stores an unordered set of nodes as its children. A Group object is represented as `<<Group>>` in the JSR-184 scene tree.

**NOTE** Since most JSR-184 objects cannot contain any sub-objects, the JSR-184 exporter uses the Group object to represent the 3ds Max hierarchy. In this case, the Group object is assigned a name such as `<<ObjectName Group>>`, where ObjectName is the name of the 3ds Max object with sub-objects. Parameters available for Group objects are the same as parameters for World objects.

**Camera**

Camera is a scene graph node that defines the position of the viewer in the scene and the projection from 3D to 2D. A Camera object is assigned the same name as its counterpart in the original 3ds Max scene.

- **Approx.Object Size**: Shows the object size with sub-objects.
- **User-defined ID**: Displays the user ID for the object.
- **Scope**: Allows scene graph nodes to form conceptual groups independent of the scene graph hierarchy. The default scope is -1, implying that all
nodes are in the same scope. By default, all objects are visible to all cameras and are lit by all light sources.

- **Projection Type**: Sets the projection mode for the Camera. Options are Parallel and Perspective.

**Ambient Light**

Ambient light represents the ambient light color from the 3ds Max environment setting. Ambient light parameters are the same as Light parameters.

**Light**

Light is a scene graph node that represents different kinds of light sources. A Light object is assigned the same name as its counterpart in the original 3ds Max scene.

- **Approx.Object Size**: Shows the object size with sub-objects.
- **User-defined ID**: Displays the user ID for the object.
- **Enable Rendering**: Sets the light to On or Off. Options are True and False.
- **Scope**: Allows scene graph nodes to form conceptual groups independent of the scene graph hierarchy. The default scope is -1, implying that all nodes are in the same scope. By default, all objects are visible to all cameras and are lit by all light sources.

**Sprite3D**

Sprite3D is a scene graph node that represents a 2–dimensional image with a 3D position. The only way to create a Sprite3D object is to convert a two-polygon 3ds Max mesh object. A Sprite3D object is named “Sprite, ObjectName,” where ObjectName is the name of the corresponding 3ds Max mesh object.

- **Approx.Object Size**: Shows the object size with sub-objects.
- **User-defined ID**: Displays the user ID for the object.
- **Enable Rendering**: Sets the rendering enable flag of this node. The effective rendering enable status for this node is the logical AND of the enable flags on this node and all of its ancestors. This means that this node is disabled if any of its ancestors are disabled. The status of this node has an effect
only if all its ancestors are enabled. If the effective status is set to True, this node is enabled. If it is False, it is disabled.

- **Scope**: Allows scene graph nodes to form conceptual groups independent of the scene graph hierarchy. The default scope is –1, implying that all nodes are in the same scope. By default, all objects are visible to all cameras and are lit by all light sources.

**Mesh**

- **Approx.Object Size**: Shows the object size with sub-objects.
- **User-defined ID**: Displays the user ID for the object.
- **Scope**: Allows scene graph nodes to form conceptual groups independent of the scene graph hierarchy. The default scope is –1, implying that all nodes are in the same scope. By default, all objects are visible to all cameras and are lit by all light sources.
- **Projection Type**: Sets the projection mode for the Camera. Options are Parallel and Perspective.

**Morphing Mesh**

Morphing mesh is a scene graph node that represents a vertex-morphing polygon mesh. A morphing mesh object is assigned the same name as its counterpart in the original 3ds Max scene. Morphing mesh parameters are the same as mesh object parameters.

**NOTE** Morphing animation is not supported. A Morphing mesh is exported with morph targets. If you wish to export a morphing mesh animation, set animated weights to morph targets during playback.

**Skinned Mesh**

Skinned Mesh is a scene graph node that represents a skeletally-animated polygon mesh. A skinned mesh object in the JSR-184 scene is assigned the same name as its counterpart in the original 3ds Max scene. Skinned mesh parameters are the same as Mesh Object parameters.

**NOTE** Biped meshes are not supported.
JSR-184 Texture Tool

Application menu on page 7989 > Export > JSR-184 (*.M3G). > Name your file and click OK. > Select a texture in your scene. > Click the Texture Tool button to edit the texture properties.

You can edit the parameters that are exported for the textures in your JSR-184 scene. The Texture Tool dialog displays a preview of the texture with its current settings. When you select different options, the preview is updated to reflect the changes. You can modify the parameters described in this topic.

NOTE If the image is not a texture, then you can choose any palette in the Image Format group.

Interface

Image Width group

The JSR-184 format requires that texture sizes use the “power of two rule,” and supports texture sizes less than or equal to 256². You can select either 2, 4, 8, 16, 32, 64, 128, or 256.

If you want to modify the image width of all of the textures in your JSR-184 scene, turn on Apply To All; otherwise, the changes affect only the selected texture.
Image Height group

These are the same options as Image Width: you can select either 2, 4, 8, 16, 32, 64, 128, or 256.

If you want to modify the image height of all of the textures in your JSR-184 scene, turn on Apply To All; otherwise, the changes affect only the selected texture.

Image Format Group

Changes the color model of all textures in your JSR-184 scene.

If you want to modify the image format of all of the textures in your JSR-184 scene, turn on Apply To All; otherwise, the changes affect only the selected texture.

- **RGB 24 bit (16.7 Million of colors)**  Changes the color model to RGB color.
- **Grayscale 8 bit (256 grayscales)**  Changes the color model to grayscale.
- **Optimized Palette (256 colors adaptive palette)**  Changes the color model to a limited 256-color palette. The Optimized Palette option is available only when the Save To External File option is on. This palette does not support an alpha channel.

Save to External File

When on, saves the texture as an external file (in PNG format) in the same directory as the M3G file. If you do not select this option, the texture is saved as part of the M3G file only.

Alpha Channel

When on, saves the alpha channel with the texture.

JSR-184 Log Files

*Application menu* on page 7989 > Export > JSR-184 (*.M3G).
When you export an M3G file, the JSR-184 Export feature creates a log file. This log file is an HTML file, saved in the same directory as the M3G file. The table contains an entry for all the objects exported to the M3G file format.

- **Object #** Indicates the root object value. When multiple root objects exist in the M3G file, this value is used by the JSR-184 Load object to load the correct object.

- **Object Name** Contains the name of the corresponding 3ds Max object.

- **Object Type** Indicates the type of saved object.

- **User ID** Displays the User ID for the object.

- **Object Size** Shows the object size (in kilobytes) for the object.

- **Comments** Displays additional information such as errors and warnings.

Below is a sample of a simple log file:

<table>
<thead>
<tr>
<th>Object #</th>
<th>Object Name</th>
<th>Object Type</th>
<th>User ID</th>
<th>Object Size</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Vertex Array</td>
<td>0</td>
<td>161</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Vertex Array</td>
<td>0</td>
<td>89</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Vertex Buffer</td>
<td>0</td>
<td>48</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Triangle Strip Array</td>
<td>0</td>
<td>213</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Material</td>
<td>0</td>
<td>30</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Appearance</td>
<td>0</td>
<td>33</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Object #</td>
<td>Object Name</td>
<td>Object Type</td>
<td>User ID</td>
<td>Object Size</td>
<td>Comments</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
<td>-------------</td>
<td>---------</td>
<td>-------------</td>
<td>----------</td>
</tr>
<tr>
<td></td>
<td>Box01</td>
<td>Mesh</td>
<td>0</td>
<td>78</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Group</td>
<td>0</td>
<td>66</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Camera01</td>
<td>Camera</td>
<td>0</td>
<td>89</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Omni01</td>
<td>Light</td>
<td>0</td>
<td>90</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Group</td>
<td>0</td>
<td>26</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Light</td>
<td>0</td>
<td>50</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Background</td>
<td>0</td>
<td>40</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>World</td>
<td>0</td>
<td>58</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**JSR-184 Standalone Player**

Start menu > Programs > Autodesk > Autodesk 3ds Max 2010 [installed version] > JSR184 Viewer

Once you have exported your 3ds Max scene to JSR-184 format, you can preview how the animation is displayed on various mobile screens.
Interface

File menu

- **Open**  Opens an M3G file for viewing in the JSR-184 player.
- **Reopen**  Displays a list of recently opened files. The list displays the most recently opened files at the top.
- **Exit**  Closes the JSR-184 viewer window.

Tools menu

- **Handsets**  Allows you to add or edit phone profiles. You can modify the vendor, model, screen width, screen height, and screen color depth.

**NOTE** You can also modify the handset profiles directly in the `terminals.xml` file in the `c:\Program Files\Autodesk\3ds Max 9\JSR` directory.
**Player controls**

The player is controlled by the following buttons on the toolbar:

- Opens the Choose Objects for Rendering dialog. This dialog allows you to select the JSR-184 world object in the scene hierarchy in the event that there are multiple world objects in the JSR-184 data file.

- Steps one frame backward through the animation.

- Plays the animation.

- Stops the animation and returns to the first frame.

- Pauses the animation.

- Steps one frame forward in the animation.

**Phone Profiles** Displays the phone profiles defined in the Tools > Handsets dialog.

**Use Free Camera** Switches to viewing the scene from the free camera. The camera is controlled by the following keyboard shortcuts:

<table>
<thead>
<tr>
<th>Key</th>
<th>Camera Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left Arrow</td>
<td>Rotate Left</td>
</tr>
<tr>
<td>Right Arrow</td>
<td>Rotate Right</td>
</tr>
<tr>
<td>Up Arrow</td>
<td>Rotate Up</td>
</tr>
<tr>
<td>Down Arrow</td>
<td>Rotate Down</td>
</tr>
<tr>
<td>A</td>
<td>Move Left</td>
</tr>
</tbody>
</table>
LandXML (XML, DEM) Files

The topics in this section describe how to use land development data with 3ds Max. Land data typically comes from civil engineering projects, and can use a few different file formats.

Importing LandXML/DEM Models

LandXML/DEM Model Import lets you import land development data into 3ds Max. Civil engineering data, from XML, DEM (digital elevation model), or DDF files, is used to create a 3ds Max model.
The LandXML/DEM Model Import dialog on page 7753 allows for interoperability with Autodesk products such as Land Development Desktop 3, Land Development Desktop 2005, Civil 3D™, and CAiCE Visual PE. Once imported, the models are ready for high-quality photorealistic rendering and animations.

**LandXML File Types**

There are three file types you can import with the LandXML/DEM Model Import dialog: XML, DEM, and DDF.

- **XML** is the most robust file type for LandXML import. In addition to surface elevation data, XML files can also contain Alignment (road) and Parcel data.

- The **DEM** (digital elevation model) file type is the most commonly available large area surface data type supplied by the USGS and other government and private organizations. DEM files contain only surface data.

- The **DDF** file type is an SDTS (spatial data transfer standard) format grid surface. DDF files are very similar to DEM files; however, DDF information is shared across multiple files. The LandXML/DEM Model Import utility searches for the key DDF file in the selected directory, which is identified by the following pattern: `xxxxCEzz`, where `xxxx` is usually numeric and `zz` typically 'L0'. Like DEM files, DDF files only contain surface data.

**LandXML/DEM Model Import Dialog**

Application menu on page 7989 > Import > Select File to Import dialog > Files of Type > LandXML/DEM (*.DEM, *.XML, *.DDF)

In the LandXML/DEM Model Generator, you determine which parts of your land development data are imported to 3ds Max. 3ds Max then creates separate objects for each of the land features, including terrain surfaces, road alignments, and parcels.
Object List Lists the terrain surfaces, alignment data, and parcel data in the file to be imported. You can toggle the import of individual objects or entire groups with their corresponding check boxes.

Three types of civil engineering data stored in LandXML files are supported:

- **Surfaces** 3D TIN ground and finished surface model. Terrain surface data is imported to 3ds Max as an editable mesh.

- **Alignments** 2D road centerlines. Alignment data is imported to 3ds Max as a Shape object.

  **NOTE** DEM and DDF files do not contain Alignment data.

- **Parcels** 2D legal parcel or lot boundaries. Parcel data is imported to 3ds Max as a Shape object.

  **NOTE** DEM and DDF files do not contain Parcel data.

  **NOTE** 2D Alignment and Parcel shapes are created on top of the highest terrain surface.
File Data group

The File Data group displays information about the file to be imported, including date of creation, author, the application used to create the file, and the units.

Object Creation Options group

The Object Creation Options group lets you set the import properties for selected objects.

Color The color of the object when it is imported into 3ds Max. To change this setting, click the color swatch and select a new color from the Color Selector.

Smooth Surface Applies smoothing to the geometry, based on the Smoothing Angle setting. Edges between faces that have an angle between them that is greater than the specified smoothing angle will appear faceted in the scene. Edges between faces that are below or equal to the specified angle are smoothed.

NOTE This option is only available for terrain surface objects.

Smooth Angle Determines the size of the smoothing angle.

NOTE This option is only available for terrain surface objects.

Model Creation Options group

Set Scene Units from file Changes the 3ds Max Scene Unit to match the units of the incoming file.

NOTE This setting is only available when the 3ds Max scene is empty. If there is geometry in your scene, this setting is not available.

The units setting of the incoming file is displayed in the drop-down list.

Vertical Exaggeration Scale Artificially exaggerates the terrain surface to enhance subtle details by applying a scale factors to the vertical dimensions.

TIP This can be useful for very flat surface models.
Lightscape is a visualization application that uses radiosity and ray tracing to create accurate lighting for 3D models. You can export 3ds Max scenes to Lightscape formats, or import Lightscape files.

**NOTE** Lightscape support is being retired. For more detailed information about Lightscape export and import, you can refer to the 3ds Max 8 reference. You can download the v8 reference from the Autodesk Web site: go to www.autodesk.com, choose Support, pick the product Autodesk 3ds Max, and then choose Documentation.

The Lightscape Preparation (*.lp) file is the main format Lightscape uses. Other Lightscape file formats save selected portions of the information in the LP file. These are the additional Lightscape file formats you can export:

- View file (*.vw): Exports the active view, or selected camera views.
- Block file (*.blk): Exports materials, lights, and geometry. Blocks in a block file can be selectively loaded into Lightscape.
- Parameter file (*.df): Exports processing parameters.

You can import *.lp and *.vw files. You can also import the Lightscape Solution (*.ls) file format.

**Exporting Lightscape Files**

**Overall Workflow for Exporting a Lightscape Preparation (LP) File**

1. Select the object to be exported.
2. Open the Export Lightscape Preparation File dialog.
3. If your scene uses standard lights, set the units and scale, and then set the light conversion method.
4. If you are exporting an animation, select the frames to be exported.
5. If your scene uses daylight, set the daylight parameters.
6. Select the cameras to be exported.
Procedures

To export a Lightscape file:

1. Choose File > Export.
   
   The Select File To Export Dialog is displayed.

2. Use the Save As Type list to choose which kind of Lightscape file format you are exporting.

3. Use the Save In list to navigate to the appropriate directory.

4. In the File Name field, enter the name of the file that you want to create, and then click Save.

To get version information about the Lightscape exporter:

1. Export one of the Lightscape file types.
   
   A dialog with options for that file type is displayed.

2. Click About.
   
   An About dialog is displayed. The dialog shows the version of the Lightscape exporter.
Importing Lightscape Files

Overall Workflow for Exporting Lightscape Files (LP, VW, or LS)

The steps to import a Lightscape file include:

■ Accessing the import dialog.
■ Choosing to replace the current scene.
■ Choosing how to group the imported objects.
■ (LS files.) Specifying a prefix for imported Lightscape objects.
■ (LS files.) Choosing which Lightscape objects to import.
■ (LS files.) Choosing the conditions for importing Lightscape lights.
■ (LS files.) Choosing the radiosity mapping settings.

NOTE The Lightscape importer does not convert Lightscape layers into 3ds Max scene layers, because it was written before the 3ds Max layers feature was implemented.

Procedures

To import a Lightscape (LS, VW, or LP) file:

1. Choose File > Import.
   The Select File To Import dialog is displayed.

2. Choose Lightscape (*.LS, *.VW, *LP) from the Files Of Type drop-down list.

3. Use the dialog's controls to browse to the directory that contains the file you want to use. Highlight the name of that file, and then click Open. Depending on the type of file you chose, an Import Lightscape Preparation dialog or an Import Lightscape Solution dialog is displayed. No dialog is displayed when you import a Lightscape view (VW) file.
To replace the current scene:

When you import a Lightscape Solution or Preparation file, you can choose to add the imported objects to the current scene, or to replace entire scene.

1. In the Import Lightscape Preparation dialog, turn on Replace Current Scene.
2. In the Import Lightscape Solution dialog, turn on Replace Scene Contents.

To group imported objects:

- In the Import Lightscape Preparation or the Import Lightscape Solution dialog, use the controls in the Entity Grouping group to choose how imported Lightscape objects are grouped.
  See each dialog's description for details about these options.

To get version information about the Lightscape file importer:

1. Access the Import Lightscape Solution dialog.
2. Click About.
   An About Lightscape LS File Import dialog is displayed. This shows the version of the importer that is currently installed.

Lightscape Materials Utility

Utilities panel > Click More. > Utilities dialog > Choose Lightscape Materials. > Lightscape Materials rollout

With the Lightscape Materials utility, you can add the Lightscape material to multiple objects, and remove the Lightscape radiosity material from multiple objects.
**Interface**

Selected Object group

Displays the name of the currently selected object. If no objects are selected, displays None Selected. If more than one object is selected, displays Multiple Selected.

---

**Add to All** Click to add a Lightscape material to all materials used by all objects in the scene.

An object's previous material, if any, becomes the Lightscape material's base material. If a material is already using a Lightscape material, it remains unchanged.
You set the new Lightscape material's values in the Radiosity Mapping group, described below.

**Add to Selected** Clicking to add a Lightscape material to all materials used by the current selection.

An object's previous material, if any, becomes the Lightscape material's base material. If a material is already using a Lightscape material, it remains unchanged.

You set the new Lightscape material's values in the Radiosity Mapping group, described below.

**Remove from All** Click to remove the Lightscape material from all materials used by all objects in the scene.

Each material's base material becomes the top-level material. If a material is not using a Lightscape material, it remains unchanged.

**Remove from Selected** Click to remove the Lightscape material from all materials used by the current selection.

Each material's base material becomes the top-level material. If a material is not using a Lightscape material, it remains unchanged.

These parameters are used only when you add the Lightscape materials. They set the initial values of the new Lightscape material.

**Radiosity Mapping group**

**Brightness** Controls the brightness of the displayed image on your monitor. The setting of this control does not affect the actual lighting levels in the model. Default=50.0.

**Contrast** Controls the contrast between light and dark regions in the model. Default=50.0.

**Ambient Light** Controls the amount of 3ds Max ambient light that will be mixed in with the radiosity calculations. If the value is 0.0, none of the 3ds Max ambient light is used. If the value is 1.0, the full 3ds Max ambient light is added into the radiosity calculations. Default=0.0.

**Daylight** Determines whether you want natural daylight to be used in the calculation. Default=on.

**Exterior Scene** Used for exterior daylight simulations. Default=off.
**Motion Analysis Files (HTR/HTR2, TRC)**

The topics in this section describe how to use motion-capture files in the HTR (Hierarchical Translation-Rotation) format.

**Importing HTR/HTR2 Files**

*Application menu* on page 7989 > Import > Motion Analysis HTR File (*.HTR)

The Motion Analysis HTR (Hierarchical Translation-Rotation) motion-capture file format is an alternative to the BVH format because it provides flexibility in data types and ordering. It also has a complete base pose specification, which consists of indicating the starting point for both rotations and translations.

The stored data is grouped by segments; all motions from the first segment are read, then those from the next segment, and so on.

The HTR format contains four sections: Header, Segment Names & Hierarchy, Base Position, and the motion data section.

**NOTE** All section titles are displayed between square brackets ([ ]).

**NOTE** Comments within the HTR file are denoted by a hash mark (#).

The header section contains global parameter information:

- File type
- Data type
- File version
- Number of segments
- Number of frames
- Data frame rate
- Euler rotation order
- Calibration units
- Rotation units
- Global axis of gravity
HTR2 is nearly identical to HTR, except that the data from the motion section is organized differently in order to better suit a streaming data input (a sample-major ordering is used to present the motion information).

On import, 3ds Max constructs a FK hierarchy rig from the incoming data. The resulting bone skeleton is linked to a dummy object named after the HTR file.

**Interface**

**Skeleton group**

*Create* Choose this option to build a new bone skeleton from the incoming data. Default=on.

*Segment Size* Set this value to modify the scale factor for the weight and height of all bones from the motion capture data. Only available if Create is active.

**NOTE** This does not change the skeleton’s scale.

*End Effectors* Toggle this option to import end effectors on page 8560 from the incoming data, if they exist. Only available if Create is active.

*Apply* Choose this option to map the incoming data onto the children of the selected skeleton root in your scene.
Keyframe Options group

Base Position  When on, imports only the keys of the base pose.

Animation  When on, imports all animation keys. Default=on.

Rotation Controller group

Euler/TCB  Choose one of the two rotation controllers on page 3453 to apply to the imported data.

Time Options group

These options (except Set Frame Rate) are only functional if the Animation option in the Keyframe Options group is enabled.

All/Range  Choose between using the entire animation range from the motion capture file, or a defined portion.

From/To  These values represent the start and end frames of the defined range. Only available if Range is active.

Offset  Sets the number of inserted empty frames before the imported animation starts.

NOTE  This does not affect the Base Position setting (in the Keyframe Options group), which sets a key at frame 0.

Set Frame Rate  When on, the frame rate on page 8585 from the HTR file overwrites the current one in the Time Configuration dialog on page 8106.

Scale group

Global  Sets the size of the resulting skeleton.

NOTE  The scale value within 3ds Max remains 100.

---

Ok  Proceeds with HTR/HTR2 import, using the current settings.

Cancel  Cancels HTR/HTR2 import.
Importing TRC Files

Application menu on page 7989 > Import > Motion Analysis TRC File (*.TRC)

The Motion Analysis TRC motion-capture file format represents the raw form (in ASCII) of tracking output. It contains a header section and a motion section. All tracking markers stored in a TRC file contain global positioning data and do not share parent-child relationships among themselves.

On import, 3ds Max converts the incoming data as either spheres or points, which are named according to the markers names.

You can convert an imported TRC motion into CSM format on page 4156 using the MACUtilities utility on page 4156 in order to map it onto a biped.

Interface

Cloud group

Create Choose this option to build a new set of marker objects. Default=on.

Apply Choose this option to map the incoming data onto the marker children of the selected root in your scene.

NOTE The marker objects must be named to match the imported data.

Options group

Selected Items Only Imports the motion data only relative to the selected objects in your scene. Available only if the Apply option (in the Cloud group) is active.
Root Node  Includes a root dummy on file import. Available only if the Create option (in the Cloud group) is active.

Geometry group

These settings are available only if the Create option (in the Cloud group) is active.

Sphere/Point  Choose between creating spheres or point helpers to illustrate markers.

Size  Sets the sphere diameter or point size, based on your choice above.

Time Options group

All/Range  Choose between using the entire animation range from the motion capture file, or a defined portion.

To/From  These values represent the start and end frames of the defined range. Only available if Range is active.

Offset  Sets the number of inserted empty frames before the imported animation starts.

Set Frame Rate  When on, the frame rate on page 8585 from the TRC file overwrites the current one in the Time Configuration dialog on page 8106.

Scale group

Global  Sets the size of the resulting skeleton.

NOTE  The scale value within 3ds Max remains 100.

Ok  Proceeds with TRC import, using the current settings.

Cancel  Cancels TRC import.

Exporting HTR/HTR2 Files

Application menu on page 7989 > Export > Motion Analysis HTR File (*.HTR)

The Motion Analysis HTR (Hierarchical Translation-Rotation) motion capture file format is an alternative to the BVH on page 8520 format because it provides
flexibility in data types and ordering. It also has a complete base pose specification, which consists of indicating the starting point for both rotations and translations.

The stored data is grouped by segments; all motions from the first segment are read, then those from the next segment, and so on.

The HTR format contains four sections: Header, Segment Names & Hierarchy, Base Position, and the motion data section.

**NOTE** All section titles are displayed between square brackets ([ ]).

**NOTE** Comments within the HTR file are denoted by a hash mark (#).

The header section contains global parameter information:

- File type
- Data type
- File version
- Number of segments
- Number of frames
- Data frame rate
- Euler rotation order
- Calibration units
- Rotation units
- Global axis of gravity
- Bone length axis
- Scale factor

HTR2 is nearly identical to HTR, except that the data from the motion section is organized differently in order to better suit a streaming data input (a sample-major ordering is used to present the motion information).

On export, the root object is named after your file name.

**NOTE** To have a successful export, you have to select the root of the desired skeleton.
NOTE You can only export one bone hierarchy at a time.

Interface

Base Position group

Saved Pose Choose this option to use the skeleton's pose at frame 0 as base position data. Default=on.

Current Pose Choose this option to use the skeleton's pose at the current frame as base position data.

Options group

Export Animation Enable to export all animation keys. Otherwise, only the base position is exported.

Parent Transforms Enable to include the root object's animation data in the export file.

Time Options group

These options are only functional if the Export Animation option in the Options group is enabled.

Slider/Range Choose between using your scene's time slider on page 8068 range or a defined portion.

From/To These values represent the start and end frames of the defined range.

Offset The exported animation starts after the number of frames set by this value.
Scale group

Global  Sets the bone length scale factor in the export file.

____

Ok  Proceeds with HTR/HTR2 export, using the current settings.

Cancel  Cancels HTR/HTR2 export.

Exporting to Shockwave 3D

You can set up 3D scenes and animations in 3ds Max, and then export them in Shockwave 3D (W3D) format for use in interactive presentations in Macromedia Director. To start this process, choose Application menu on page 7989 > Export, and choose Shockwave 3D Scene Export (*.W3D) as the file type. Choosing this format opens the Shockwave 3D Scene Export Options dialog on page 7770.

The Shockwave exporter in 3ds Max offers significant differences from the 3ds Max exporter previously available from Macromedia. When you prepare a scene for exporting to Director, please be aware of the following:

■ Bones require special consideration when being exported to Shockwave 3D format. See “Exporting Bones” below.

■ Hidden objects are not exported. However, bones are exported whether hidden or not.

■ The exporter supports specular lighting for light sources with Specular turned on in the General Parameters rollout > Affect Surfaces group.

■ Some types of mapping distort or disappear on export. Whenever possible, use Multi/Sub-Object materials rather than maps.

Exporting Bones

The exporter supports character animation using bones and the Skin modifier, or a character studio® biped with the Physique® modifier. Bones are exported not as geometry, but as Shockwave 3D bones.
If the bones deform a mesh with the Skin modifier, the scene must be arranged in a specific manner to cause the bones and mesh to export properly:

- All bones for each mesh object must be linked, and linked contiguously. In other words, each bone must link to another bone, with one bone acting as the root for the entire hierarchy.

- You'll get the best results if all bones are created in the same viewport, and bones are created individually (not copied or mirrored).

- All vertices in the skinned mesh must be assigned to at least one bone, even if they constitute a part of the mesh that isn't animated. Otherwise, the mesh will distort on export.

- You must group the bones and the skinned mesh with the Group menu > Group command prior to export. If you have more than one set of bones with skinned meshes, create a separate group for each.

- You can also export animation on IK chains and dummy objects. These objects must be grouped with the skin and bones to export correctly.

For more tips on working with bones animation and the Shockwave 3D Exporter, visit the Macromedia Web site. Also, search the Macromedia site for “bones shockwave export” (without the quotes).

**Shockwave 3D Scene Export Options Dialog**

*Application menu* on page 7989 > Export > Select File To Export dialog > Save As Type > Shockwave 3D Scene Export (*.W3D)

This dialog appears when you choose the Shockwave 3D format as the export format for your scene.
Resources to Export group

**Scenegraph hierarchy** Controls whether or not the parent-child hierarchy between all geometry, light, group, and camera resources is written to the Shockwave 3D file. This option should always be selected when exporting an entire scene from 3ds Max. The Shockwave 3D scenegraph contains:

- Information on parent-child relationships.
- Information about what resources each scene element uses (for example, the model resource used by a model in the scenegraph).
- Controls for any modifiers associated with the geometry resources.

Exporting to Shockwave 3D | 7771
Information about any cameras, lights, and groups in the scene. Shockwave 3D treats cameras, lights, and groups as less important resources, and stores information about them only in the scenegraph.

The scenegraph hierarchy is the glue that binds most of the scene assets in the Shockwave 3D file. If this option is turned off, only shader, texture, model, and motion resources will be written to the W3D file, and all the other information that specifies how objects exist in the scene, how the scene is laid out, how the scene is lit, and how the scene is viewed will be missing. For this reason, turn this option off only when exporting libraries of animations or texture maps.

NOTE The exporter will remember this setting from one export to the next. Be sure to turn on this option again before trying to export an entire scene. If you do not, the result will be unusable (except as an object and texture library).

Geometry resources Exports all meshes and their associated bones to the Shockwave 3D file. If this option is turned off, the preview window will be completely black. All other designated resources will be written to the W3D file.

Animations Writes out the animation on all objects supported by the exporter to the Shockwave 3D file. The preview window is useful in quickly showing which animations the exporter is capturing.

By default, the Shockwave 3D Exporter captures the animation of all objects in the scene in every frame. This data is compressed into a streaming format as the file is written. There may be times, however, when you only want to capture part of an animation, or sample it more coarsely than once a frame. If this option is cleared, the full scene will be displayed in the preview window without any animations.
NOTE 3ds Max supports direct animation of cameras and lights. If you animate a camera or light, that animation will be exported, but an extra geometry node will be inserted into the scene during the export process. This geometry node has the animation of the camera or light applied to it, and the camera or light is made a child of this extra node.

The exporter does this because the Shockwave 3D runtime engine supports keyframes only on geometric nodes. The extra node that the exporter creates is named "Dummy Animation Node xyz", where xyz is the name of the animated camera or light. This dummy geometry node also has a dummy material applied to it named Dummy Material, and the geometry is invisible.

Lingo™ programmers should note that the camera or lights transform is now relative to the dummy geometry node, that is, its parent.

IMPORTANT Animation export compression collapses non-bone-based hierarchies (simple linked hierarchies in 3ds Max), so only animation assigned to the root exports properly. For example, in a simple head animation where the eyes and eyelids are linked to the skull, the skull movements export but the eye and eyelid animations do not. Because 3ds Max groups do not collapse on export, you should link each element of your chain, and then group each element with its parent starting from the bottom of the chain and working to the top. Arrange each group's pivot point, and then animate only the group objects, and not their contained elements.

Material resources Exports all basic materials associated with all objects supported by the exporter to the Shockwave 3D file. Materials represent the most basic properties that can be assigned to a surface, such as diffuse color, opacity, and specular color.

We strongly recommend that you leave this option on when exporting any geometry, shader, or texture map resources. Turn this option off only when exporting just the animation in a scene; otherwise, the W3D file will not work correctly with Director.

Texture map resources Exports all texture maps associated with all objects supported by the exporter to the Shockwave 3D file. Texture maps in Shockwave 3D are bitmap images or 2D procedural maps, such as Tile and Gradient Ramp. All bitmap images used in 3ds Max are transformed by Shockwave 3D into streaming JPEG images.
NOTE The terms "Texture," "Map," and "Texture Map" are used interchangeably. If this option is turned off, models will be untextured when first loaded into Director, because they will have no texture information (despite their being visible and fully shaded in the preview window). Once textures are assigned to the proper shaders with Lingo, the models will look properly textured.

**Shaders** Exports all shaders in the Shockwave 3D file. Shaders are the highest-level entities that describe surface properties. They bear no relationship to the shaders used in 3ds Max. Shockwave 3D does not distinguish among Blinn, Phong, Anisotropic, or any other shader algorithm that determines the rendered look of materials and maps. Only Gouraud shading, which is most closely emulated by the standard shaders in 3ds Max, is supported. Shockwave 3D shaders are primarily pointers to texture map resources on page 7773 and material resources on page 7773.

NOTE The Shaders option should be used in conjunction with the Texture Map Resources and Material Resources options. If this option is turned off, models will be invisible when first loaded into Director, because they will have no shading information (despite their being visible and fully shaded in the preview window). Once shaders are assigned to the models with Lingo (Director's scripting language), the models will become visible and look properly shaded.

**Enable Toon and SDS** When turned off, this option prevents the writing of geometry data used by some of the more advanced Shockwave 3D technologies, and thus reduces the overall file size.

If turned off, Toon and Subdivision Surfaces (SDS) data is not included in the export file, which means that the Toon and Subdivision Surfaces modifiers cannot be applied to the model in Director. A model missing this geometry data can be used with all other Shockwave 3D technologies, however. Leave this option turned on unless it is expedient to reduce the size of the W3D file.

NOTE There is no way to tell if a W3D file was exported with this option enabled or disabled until you try to apply the Toon or SDS modifiers in Director. For this reason, if you turn off this option, use a special naming convention to indicate that a model doesn't have the Toon or SDS data in it.

**Light resources** Exports all lights in the scene to the Shockwave 3D file. Turning this option off doesn't do anything unless the scenegraph hierarchy option is also turned off. The only time you should turn this option off is when exporting just the animation, geometry, or texture data in a scene.
Camera  Determines the viewpoint used for the scene in Director. This option defaults to Active Viewport, but if any cameras exist in the scene, you can choose one from the drop-down list.

**NOTE** In order to preview or export an animated camera, you must select that camera from the list. Selecting Active Viewport with an animated camera will not export that camera’s animation.

### Compression Settings group

The Shockwave 3D file contains all scene assets in a proprietary compressed and streaming format. You can control the order in which data streams with the user properties. The amount of compression of the scene assets is set by three controls: Geometry Quality, Texture Quality, and Animation Quality. The controls have values that range from 0.1 to 100.0, with higher values giving less compression and better quality (a more faithful representation of the original model).

A value of 100 means that the scene assets will be represented at the best quality possible, but with some degree of compression still present. It does not represent the value at which compression does not occur. Also, the compression controls do not have a linear scale, so a setting of 20.0 doesn’t necessarily mean that the quality level of the resulting data is twice as good as that produced with a setting of 10.0.

**Geometry quality** Controls how much the scene geometry data (such as vertex positions and normals and texture coordinates) is compressed. The default of 25.0 generally produces a good compromise between data accuracy and space savings.

**Texture quality** Controls the compression of textures (images) in the scene.

**Animation quality** Controls the compression of animation data in the scene. Higher compression levels (lower quality) tend to remove the finer motions authored in the scene, especially motion-capture data, while occasionally introducing small noise artifacts.

**NOTE** You might need to use larger values of the [Animation Sampling Interval control](#) on page 7776 (below) along with greater values of this setting to minimize the file space consumed by animation while still maintaining acceptable motions.

### Texture Size Limits group

The Texture Size Limits setting lets you reduce the size of the W3D file by limiting the size of the texture maps in the export.
The reduced size of the texture maps will usually look fine on the model, because the model’s UVW texture coordinates will have already taken into account the non-square dimensions of the image. Use the smaller settings if, after tuning the compression settings and simplifying the scene in 3ds Max, the W3D file is still too large. If the scene contains no textures, or only small textures, limiting the texture size will not help to reduce the size of the W3D file.

No limits on texture size Exports all texture maps in the scene at the full resolution of the image as used in 3ds Max. For example, a 2048 X 4096-pixel image will be written to the W3D file at these dimensions (compressed, of course).

512 by 512 pixels maximum Exports the texture maps so that no image exceeds 512 X 512 pixels. A 2048 X 4096-pixel image will be scaled to a 512 X 512-pixel image; a 128 X 1024-pixel image will be scaled to a 128 X 512-pixel image.

256 by 256 pixels maximum Exports the texture maps so that no image exceeds 256 X 256 pixels. A 2048 X 4096-pixel image will be scaled to 256 X 256 pixels; a 128 X 1024-pixel image will be scaled to 128 X 256 pixels.

Animation Options group

The Animation Options group contains the controls to change how an animation is captured.

Sampling interval This setting is used to capture object animation once every specified number of frames.

Range These Start and End controls indicate which frames of the scene animations are to be captured. By default, these values are set to capture the entire animation interval specified in 3ds Max, sampling all animations in the scene every frame.

Export Controls

Author Check Opens a window displaying warning messages about possible problems found converting the scene to the W3D file format. If no errors are found, the window is blank.

These messages, which do not necessarily indicate problems with the scene, can be useful in debugging problems such as why the scene looks different in the preview window than it does in 3ds Max. If the scene uses any 3ds Max features that are not supported by the exporter, they will be listed here.
Analyze Opens the Shockwave 3D File Analysis window on page 7779, displaying a graphic breakdown of the data in the W3D file.

Preview Opens the Shockwave 3D Export Preview window on page 7777, showing the scene as it will be exported.

File Opens the Choose Export File dialog, which lets you specify the name and location of the file to be exported. When you click Save, you're returned to the Export Options dialog; the file name and path you specified appear in the field next to the File button.

**NOTE** Clicking the Save button does not save the W3D file; you must click the Export button to create the file.

Export Exports the Shockwave 3D file, using the path and name specified next to the File button.

View after export After you export a file, this option lets you view it in the Preview window on page 7777.

**Shockwave 3D Export Preview**

Application menu on page 7989 > Export > Select File To Export dialog > Save As Type > Shockwave 3D Scene Export (*.W3D) > Preview

This window displays the scene as it has been captured by the Shockwave 3D Exporter. This view lets you quickly identify scene elements that are not supported by the Shockwave 3D Exporter.
In many cases the export preview window will display scene resources you had decided not to export. Remember that this window displays the scene as captured by the exporter and not necessarily how it is written to the W3D format. Only those scene assets indicated under the export options and supported by the exporter will be written to the W3D file.

Export with a Top, Front, Right, or orthographic viewport active in 3ds Max, and the scene will be viewed through an orthographic camera. Export with a Perspective or Camera viewport active in 3ds Max, and the scene will be viewed through a perspective camera.

**NOTE** When navigating a scene, keep in mind that only the parts of models that are in front of the camera will be rendered. Parts of models that penetrate the camera plane and are behind the camera will not render, resulting in visual artifacts ("black holes" or "tearing") in the model. This is particularly noticeable when you dolly an orthographic camera forward, because the lack of perspective effects does not hide models as the camera passes them. Dolly the camera back, and any visual artifacts should disappear.

You can navigate the export preview window using the following controls.
Rotation

- Drag (move the mouse with the left button held down)=orbit
- Y+drag=rotating the camera with "Y-up" (particularly useful if the scene was created in the "Y-up" environment)
- Shift+drag=roll; vertical movement is ignored

Dolly

- Ctrl+drag=dolly
- Ctrl+Shift+drag=dolly faster

Pan

- Spacebar+drag=pan
- Shift+Spacebar+drag=constrain the movement to be either horizontal or vertical, depending on the initial direction when you start dragging

Shockwave 3D File Analysis Window

Application menu on page 7989 > Export > Select File To Export dialog > Save As Type > Shockwave 3D Scene Export (*.W3D) > Analyze

This window provides a graphic breakdown of the data in the W3D file. Click OK to close the window.
Interface

**Pie Chart** Graphic display of the proportion of the file used by all of the W3D file data types. Refer to the color-coded Categories list, which gives a percentage and an absolute size in kilobytes of each asset:

- **Geometry**  (in the initial load segment, if a model has a zero priority in the sw3d_stream_priority user property, or in the streamable portion of the file, if a model has a non-zero streaming priority)
- **Shaders**  (only in the initial load segment)
- **Textures**  (in the initial load segment, if the model that uses the texture has a zero priority in the sw3d_texture_stream_priority user property, or in the streamable portion of the file, if a model has a non-zero streaming priority)
- **Materials**  (only in the initial load segment)
- **Lights**  (only in the initial load segment)
- **Animations**  (only in the initial load segment)

**NOTE** Large animations can greatly lengthen the time it takes to see the start of a Shockwave 3D animation, because they must fully download before any of the scene can becomes visible.
- **Nodes** or scenegraph hierarchy data (only in the initial load segment)
- **Unknown** includes, for example, streaming priorities, names, and block sizes.

**File Organization** Graphic display of the size of the entire file and its initial load segment (ILS) portion. The ILS, in orange, consists of all the data that must be loaded before Shockwave will display the scene (scenegraph data, animations, shaders, and any textures or geometry with a streaming priority of zero). The rest of the file, in light blue, represents all of the streamable data with a non-zero streaming priority. This data will continue to load and fill out the detail of the scene as the download proceeds.

**Runtime Texture Information** Approximate texture memory that will be required at runtime to display the textures in the scene. Scenes requiring more than a few megabytes of texture memory will require accelerated graphics cards to display textures at their full resolution.

### Stereolithography (STL) Files

The topics in this section describe how to import and export stereolithography (STL) files.

**Importing STL Files**

- **Application menu** on page 7989 > Import > StereoLitho (*.STL)

An STL file saves object data in a format used for stereolithography. STL files have a filename extension of .stl. There is an ASCII STL format as well as a binary STL format. You can choose which to create when you export a 3ds Max scene.

STL files are generally used for purposes of rapid prototyping. A variety of methods use the STL format to construct prototypes. For example, many STL machines use a liquid polymer and harden it in small slices, creating a solid plastic model. Other STL machines use metal powder to create a model in steel. Still other machines use a special wax.

You can import and export STL files. See **Exporting to STL** on page 7784.
Chapter 21  Managing Scenes and Projects

Interface
**Name** Enter a name for the 3D Studio object created from the STL file. Default is the file name (without extension) or the name saved internally in the STL file.

**Weld Vertices group**

Welds coincident vertices in the STL file into single vertices in the 3D Studio mesh.

**Weld Threshold** Determines the size of the area which vertices must occupy to be welded. Vertices with distances equal to or less than this value are welded into a single vertex.

**Weld** Turns on the Weld Vertices function. In most cases, you should leave this box turned on because unwelded objects can’t be unified or smoothed.

**Use Threshold** If on, STL import uses the standard 3D Studio welding method. This can be a very slow process.

**Quick Weld** If on, STL import uses a welding algorithm optimized for the STL format. This is up to thirty times faster than standard 3D Studio welding, and is highly recommended.

**Auto-Smooth group**

**Auto-Smooth** Applies smoothing groups on page 8724 to the geometry based on the smoothing angle set by the smooth angle spinner. Edges between faces that have an angle between them that is greater than the specified smoothing angle will appear faceted in the rendered image. Edges between faces that are below the specified angle are smoothed.

**Smooth Angle** Determines the size of the smoothing angle.

**Auto-Smooth** Turns on the Auto-Smooth function.

**Miscellaneous group**

**Remove Double Faces** Removes one of the pair wherever two faces are occupying the same location. Recommended.

**Unify Normals** Forces the normals on page 8654 of all faces on each object to face the same way (usually out). If, when you render your scene, the face normals are pointing in the wrong direction, use the Normal modifier to flip them. For best results, leave this box turned on.
Exporting to STL

Application menu on page 7989 > Export > StereoLitho (*.STL)

An STL file saves object data in a format used for stereolithography. STL files have a file-name extension of .stl. There is an ASCII STL format as well as a binary STL format. You can choose which to create when you export a 3ds Max scene.

STL files are generally used for purposes of rapid prototyping. A variety of methods use the STL format to construct prototypes. For example, many STL machines use a liquid polymer and harden it in small slices, creating a solid plastic model. Other STL machines use metal powder to create a model in steel. Still other machines use a special wax.

An STL object must define a complete and closed surface. You can check whether the geometry you want to export satisfies this criterion by using the STL Check modifier on page 1746.

You can also import STL files. See Importing STL Files on page 7781.
Interface

**Object Name** Enter a name for the object you want to save in STL format.

**Binary/ASCII** Choose whether the STL output file will be binary or ASCII (character) data. ASCII STL files are much larger than binary STL files.

**Selected Only** Exports only objects that you selected in the scene.

Wavefront (OBJ) Files

3ds Max can import and export the text-based (ASCII) Wavefront format OBJ. An OBJ file contains geometry descriptions, while the associated MTL file format contains material descriptions.

**NOTE** The OBJ/MTL export/import plug-in is provided by software from GuruWare. Import and export of independent Wavefront MTL (material) files is not provided. Export and import of MTL files attached to OBJ files is fully supported.
Exporting Wavefront Object (OBJ) Files

Application menu on page 7989 > Export > Save as type > gw::OBJ-Exporter (*.OBJ)

The ASCII-based OBJ format makes it possible to exchange graphical data between many applications. Both polygons and freeform geometries such as curves are supported with this format. You can export 3ds Max files to this format.

See also:
■ Importing Wavefront Object (OBJ) Files on page 7789
■ Map-Export Dialog (OBJ) on page 7796

Procedure

To export scene geometry to an OBJ file:

1. From the Application menu on page 7989, choose Export. Or, to export only the current selection, choose Export Selected.
   The Select File To Export dialog opens.

2. Enter the file name, optionally with the .obj file name extension. If you don’t enter the extension, open the Save As Type drop-down list and choose gw::OBJ-Exporter (*.OBJ).

3. Click Save.
   The exporter dialog opens.

4. Set parameters manually, or choose the name of the target program from the Preset drop-down list. Optionally click Map-Export and set map-export parameters.

5. Click Export.
   During export, a dialog showing progress and the names of exported objects opens. When the export is finished, click DONE to return to 3ds Max.
Interface

Geometry group

Flipped YZ-axis When on, transfers all Y-axis values to the Z axis and vice-versa. Use this when exporting to Poser and other programs that use Y as the vertical axis and Z as the depth axis.

Shapes/lines Enables export of splines and NURBS curves.

NOTE NURBS curves are exported as splines.

Hidden Objects When on, hidden objects are exported.

Faces Choose whether the mesh faces are stored as triangles, quadrangles, or polygons.
Texture coordinates When on, texture coordinates are stored with the exported file. When you import the file in another application you will be able to use this information if it is supported.

Normals  When on, the normal information on page 8654 for the mesh is stored.

Smoothing groups When on, the information about color transition between groups is stored. See Viewing and Changing Smoothing on page 383.

Scale Determines the scaling for the contents of the OBJ file. The default value of 1.0 means no scaling is performed.

Material group

Use material Determines whether the materials associated with the scene objects are also exported to the OBJ file.

Create mat-library Determines whether the exporter creates a separate file to store information about the materials. This creates a MTL library file in the same directory as the OBJ file.

If Use Material is on but Create Mat-library is off, the OBJ file contains a reference to a like-named MTL file, but the MTL file is not saved. Use this to save time if the MTL file already exists.

Force black ambient Sets the Ambient component of exported materials to black.

Map-Export Click to open the Map-Export dialog on page 7796

Output group

Target Sets the target operating system of the computer on which the exported data is to be used. Technically, this setting determines the line-end characters for the ASCII OBJ file.

Relative numbers Causes face vertex indices in exported files to be expressed as relative (i.e., negative) numbers. This can cause compatibility issues when importing with certain programs. If you're unable to import an OBJ file, make sure this option is off and export again.

Precision The precision of the exported vertex data, as expressed by the number of decimal places.
Optimize group

Optimize  Removes duplicate elements of the indicated type or types: vertices, face normals, and texture coordinates.

Write log to Export-folder  Saves a log file to the same folder as the OBJ file when exporting via script.

Preset  When exporting to a specific application, choose that application from the list. Presets comprise all export settings, including geometry and materials.

[edit presets]  Click to open a dialog that lets you edit the presets. To change the map path for a preset, edit the map-path setting manually or click the folder button at the right end of the row and navigate to the new path.

While the Presets dialog is open, you can choose a preset by clicking its name (the row highlights) and then clicking OK.

Export  Saves the exported files (OBJ + optional maps and material library) according to the current settings.

During the export, a dialog shows the progress and saved files. When it’s finished, click DONE to close the dialog.

Cancel  Cancels the OBJ export.

Help  Opens the help file to this topic.

About  Opens a small dialog with information about this plug-in. To close the dialog, click the image.

Importing Wavefront Object (OBJ) Files

Application menu  on page 7989 > Import > Files of type > gw::OBJ-Importer (*.OBJ)

Geometry imported from OBJ files appears in 3ds Max as editable mesh or editable poly objects. Import of associated materials and maps is supported.

NOTE  When you import an OBJ file by dragging and dropping on page 7645, by default the importer does not display the OBJ Import Options dialog. To see the dialog, hold down the Ctrl key while you drag and drop.
Procedure

To import an OBJ file:

1. From the Application menu on page 7989, choose Import. The Select File To Import dialog opens.
2. Choose an OBJ file to open and click Open. The importer dialog opens.
3. Choose the objects to import and set the import parameters. For details, see the Interface section, following.
4. Click Import. During import, a dialog showing progress and the names of imported objects opens. If a name conflict occurs, a dialog opens giving you the opportunity to skip or rename the object.
Interface

Wavefront (OBJ) Files | 7791
“LED” Icons for Options

The dialog indicates which features are in the OBJ file by means of red and green icons that look like LEDs.

- Green icon: This feature is present in the OBJ file.
- Red icon: This feature is not present in the OBJ file.

Objects group

Reset scene  Deletes the current scene from memory before importing the OBJ file.

Prefix  The importer prepends any text entered here to the name of each imported object.

Import as single mesh  When on, the importer combines the contents of the OBJ file into a single editable mesh object, and gives the object the same name as the file (without the file name extension).

For example, if you import as a single mesh a file named `window_parts.obj`, all separate objects in the OBJ file are combined into a single editable mesh object named “window_parts”.

Import as Editable Poly  When on, imports the Wavefront geometry as Editable Poly objects rather than Editable Mesh objects. Default=off.

Retriangulate Polygons  When on, ensures that imported polygons are triangular, as in Editable Poly surfaces. This can be useful when you import meshes from a modeling program that doesn’t ensure triangular polygons. Default=on.

WARNING  Retriangulate Polygons can alter the vertex order, so when this option is on, exporting a mesh back to the OBJ format won’t match the original mesh exactly. Some applications, such as Mudbox and ZBrush®, depend on vertex order: if you are working with one of these, be sure to turn off Retriangulate Polygons.

TIP  When you import and export OBJ files used with a particular application, use presets on page 7796 to ensure consistency.
[file info] Just above the list of objects in the file, appearing as read-only fields, are the name of the OBJ file and the total number of faces in the file.

[object list] The objects in the imported OBJ file appear in this scrolling list. Each entry consists of an object name and the number of faces in the object, plus a check box to the left of the object name for enabling and disabling import per object.

By default, import is enabled for all objects in the file. To toggle import for an individual object, click its check box in the list. You can also use the controls at the bottom of the list to enable and disable import (see following).

All/None/Invert Use these buttons to modify the state of the import enable/disable check boxes. All enables all objects in the list; None disables all objects; Invert reverses the state of each check box.

[text field] Enter search phrases with wild cards into the editable text field to the right of the Invert button to enable only objects that satisfy the search criteria. For example, to enable all list items whose names start with “Sphere”, enter sph*.

You can also use the standard search character ? to represent a single character. For example, to enable all four-character names starting with “Box”, use the search string box?.

Geometry group

Flip ZY-axis When on, transfers all Y-axis values to the Z axis and vice-versa. Use this when importing from Poser and other programs that use Y as the vertical axis and Z as the depth axis.

Center Pivots Positions the pivot of each imported object at its center. When off, the pivots are positioned at the world center: (0,0,0).

Shapes/Lines Enables import of splines.

Texture coordinates When on, texture coordinates are loaded from the imported file, if present, and associated with the geometry.

Smoothing groups When on, the information about color transitions between groups is loaded. See Viewing and Changing Smoothing on page 383.
Normals Group

These controls affect how normals are imported (or generated, if necessary).

- **Import from file** (The default.) Imports the normals used in the OBJ file. If the OBJ file does not have normals, generates normals using the imported smoothing groups. If the OBJ file does not specify smoothing groups, generates normals by assigning all faces smoothing group 1.

- **From SM group** Generates normals from imported smoothing groups. If the OBJ file does not specify smoothing groups, or you turn off Geometry > Smoothing Groups, generates normals by assigning all faces smoothing group 1.

- **Auto Smooth** Generates smoothing groups based on the angle between faces.
  
  [value] The threshold angle for generating smoothing groups: if the angle between two faces is less than this value, both are assigned to the same smoothing group. If the angle is greater than this value, the two faces are assigned to separate smoothing groups. Default=30.0.

- **Faceted** All faces are assigned to smoothing group 0: that is, no smoothing is applied, and the imported mesh has a faceted appearance.

Flip Normals Flips the normal of all imported faces. It doesn’t matter whether the normals are imported or generated.

This option is mainly for use when you are importing a model that appears “inside out” if you don’t flip the normals. Such models usually result when geometry is exported by an application other than Maya or 3ds Max.

Units/Scale group

- **convert** Turn on to enable unit conversion. Default=off.

- **Model Units** Choose the unit to use when importing the model. Most often, you will set this to the unit used in the original OBJ file.

Object Scale When Convert is off, determines the scaling for the contents of the OBJ file on import. The default value of 1.0 means no scaling is performed.
Material group

Unique Wire Color Determines the wireframe colors assigned when importing multiple objects without materials. When on, each object is assigned a different wireframe color. When off, each object is assigned the same wireframe color, picked at random.

Import Materials When on, imports materials from the MTL file associated with the OBJ file. Default=on. When off, the remaining controls in this group are disabled.

Prefix Prepends the indicated text to the name of each imported material. Enter the prefix in the editable text field to the right of the Prefix check box.

Default bump The default amount of bump maps if the value is not specified in the MTL file.

Force black ambient Sets the Ambient component of imported materials to black.

Import into Mat-Editor Brings imported materials into the Material Editor. If this is off at import time and you later want to edit a material, you need to use Get Material on page 5687 first.

Show maps in viewport Turns on Show Map In Viewport on page 5696 for imported materials’ Diffuse maps.

Copy maps to project folder When on, copies maps used by the OBJ file to the \scenassets\images subfolder of the current 3ds Max project folder. Default=off.

Overwrite Images When Copy Maps To Project Folder is on, turning on this option causes maps from the OBJ file to overwrite existing images that have duplicate names. Default=off. When Copy Maps is on but this option is turned off, 3ds Max displays the names of any maps it didn’t copy.

Write log to Import-folder Saves a log file to the same folder as the OBJ file when importing via script.
**Preset Group**

**Preset** When importing from a specific application, choose that application from the list. Presets comprise all export settings, including geometry and materials.

[edit presets] Click to open a dialog that lets you edit the presets. To change the map path for a preset, edit the map-path setting manually or click the folder button at the right end of the row and navigate to the new path.

While the Presets dialog is open, you can choose a preset by clicking its name (the row highlights) and then clicking OK.

---

**Import** Loads the designated files (OBJ + materials and maps) according to the current settings.

During the import, a dialog shows the progress. If a name conflict occurs, a dialog appears giving you the option to skip the duplicate object or rename it.

**Cancel** Cancels the OBJ import.

**Help** Opens the help file to this topic.

---

**Map-Export Dialog (OBJ)**

*Application menu* on page 7989 > Export > Save as type > gw::OBJ-Exporter (*.OBJ) > Material group > Map-Export button

The Map-Export dialog provides settings for exporting maps as part of material definitions along with exported OBJ files.

See also:

- Exporting Wavefront Object (OBJ) Files on page 7786
- Importing Wavefront Object (OBJ) Files on page 7789
Interface

use map-path When off (the default), uses the same folder as the OBJ file for maps. When on, uses the designated folder (see following), relative to the folder containing the OBJ file, for maps.

[map path] When Use Map-Path is on, specifies the folder relative to the folder containing the OBJ file where the exporter should save maps. Edit the path from the keyboard, or click the folder button to the right of the text box and navigate to the desired folder.

Map Channel Specify a map channel using the numeric field, or, to set the channel automatically, click Auto (disables the numeric field).

extended map-params When on, stores the Bump Amount value and UVW offsets in the MTL file.

convert bitmaps When on, resaves existing bitmaps used in materials according to the Format setting and, optionally, the Size setting (see following). When off, uses the original bitmaps without resaving.

Resaved maps go in the same path as the OBJ file, or, if Use Map-Path is on (see preceding), in the designated folder.
When converting bitmaps, you can optionally turn on either of the following two options:

- **resize** When on, saves bitmaps at the resolution specified by the Size settings.
- **2n** Scales each dimension of converted bitmaps to the nearest power of two. For example, resizes a bitmap of resolution 200 x 900 to 256 x 1024. Use this option when your target is a real-time 3D graphics engine.

**render procedurals** Creates bitmap images of procedural textures such as Checker on page 6227, using the specified Format and Size settings. Use this option when the intended target program doesn’t support 3ds Max procedural maps.

**Format** Choose a file format for converted bitmaps. Choices are BMP on page 7834, JPG on page 7848, PNG on page 7862, TGA on page 7878, and TIF on page 7880.

**Setup** Opens the setup dialog for the active file format. For details, click a link in the Format definition, preceding.

**Size** For converted, resized bitmaps and rendered procedurals, sets the output resolution on the horizontal and vertical dimensions.

**Close** Closes the dialog, saving any changes.

---

**VRML Files**

The topics in this section describe how to work with VRML (Virtual Reality Modeling Language) files in 3ds Max.

**Importing VRML Files**

**Application menu** on page 7989 > Import > Select File To Import dialog > Files Of Type > VRML (*.WRL, *.WRZ)

You can import VRML 1.0, VRBL, and VRML 2.0/VRML 97 files into 3ds Max. 3ds Max imports geometry, materials (including diffuse texture maps), lights, perspective cameras and viewpoints, transformations, and grouping nodes created by other VRML tools. Once they are in the scene file, you can edit, modify, and animate these objects.

3ds Max also imports basic transform animations, such as position, rotation, and scale. Also included are animated color and light. These correspond to...
the basic animation that is exported by the VRML 1.0/VRBL and VRML97 exporters. Helper objects are not created upon import. Lighting effects are somewhat simplified from the full VRML lighting model.

- VRML97 files don’t indicate the duration of an animation. If you import animation from a VRML97 file, you might want to set the animation length in 3ds Max manually.
- More elaborate forms of animation and simulation, including Script nodes, MovieTexture nodes, and sensor nodes, are not supported.
- The VRML 1.0 WWW Inline works only if the URL refers to a local file residing in the same folder as the .WRL file. Internet URLs are not supported.

Interface

Reset Scene Deletes any existing scene upon import. If you turn off this option, the imported VRML world is merged into the 3ds Max scene.

Turn to 3DS Coordinates Rotates the imported VRML world from Y, which is "up" in VRML, to Z, which is "up" in 3ds Max. If you turn off this option, VRML X, Y, and Z coordinates are imported without change.

Create Primitives Converts the VRML Box/Cube, Cone, Cylinder, and Sphere nodes to corresponding 3ds Max primitives, if possible. If the VRML object has a texture on it, or if only part of the VRML object is to be created, a general triangular mesh object will be created instead. If you turn off this option, 3ds Max will convert these objects to triangular mesh objects.
Exporting to VRML97

Application menu on page 7989 > Export > Select File To Export dialog > Save As Type > VRML97 (*.WRL)

3ds Max scenes can be exported to VRML97 file format. 3ds Max exports .wrl files, which can be viewed in any VRML97 browser.

Make sure that you have the most current version of your VRML browser and check its documentation to insure that it supports VRML97.

NOTE The VRML97 exporter plug-in is named vrmlexp.dle.

VRML97 Specification

You can find the complete VRML97 specification at http://www.web3d.org/x3d/vrml/index.html. This document describes the entire VRML97 language and provides technical details on the behavior of exported VRML97 worlds.

Supported Entities

The VRML97 exporter supports the following:

Lights All VRML97 light types: direct, omni, and spot.

Cameras Free and targeted cameras.

Primitives Sphere, cone, box, and cylinder primitive objects. These objects export as VRML97 primitive objects. This helps reduce the size of VRML97 files.

Animation All position, rotation, and scale animation on objects, as well as animated hierarchies, inverse kinematics, and all controller types. Select Coordinate Interpolators on page 7800 in the Export dialog to export animated meshes, such as an animated Bend modifier or character studio Physique animations.

Procedures

To set up a VRML scene using 3ds Max:

1 Create the objects that make up the scene.

2 On the Create panel, choose Helpers.
3 Use the tools in the VRML97 Helpers on page 7809 to add actions and triggers and prepare the scene.

4 Export the scene to the VRML97 format.

5 Open the VRML97 file in the browser and test it.

To export a file to VRML97:

1 Choose Application menu on page 7989 > Export.

2 Choose VRML97 (WRL) as the file format.

3 Enter a file name, and click Save.

4 In the VRML97 Exporter dialog, set options as described below.
Chapter 21   Managing Scenes and Projects
Generate group

Turning on any of these options increases the size of the VRML97 file generated by the export process.

Normals Generates real normals for objects. Some browsers need normals to do smoothing properly. Check this box if you are exporting geometry that uses smoothing groups in 3ds Max, to see the correct shading. Default=off.

Coordinate Interpolators Exports animation effects that involve actual modifications of the mesh objects, and not just move, rotate, and scale. Examples include modifiers whose parameters can be animated the Taper, Bend, and Twist modifiers, and space warps. This option can generate large files, because the exporter has to calculate the position of every vertex for this kind of animation.

If your animations aren't exporting correctly, try exporting with this option chosen. An example of animation motion requiring Coordinate Interpolators is a stick figure made up of simple rectangular boxes that have bones linked to the boxes as a skeleton. Even though these boxes move through space without any noticeable shape morphing, their motion will not be exported without the use of Coordinate Interpolators, because their motion isn't derived from simple transforms. Any animation achieved using the modifier stack or object parameters needs Coordinate Interpolators. This includes animated XForm modifiers.

Certain types of animations are not possible with Coordinate Interpolators; for example, when the mesh being animated changes size between frames. An example of this is animating the number of segments in a sphere. 3ds Max warns you if it detects this type of animation on export.

Indentation Indents the VRML97 source code so it is easy to read. Default=on.

Export Hidden Objects Exports hidden objects. Default=off.

Primitives Exports VRML97 primitives, which reduces the file size because these primitives are described very simply (for example, a sphere is described by its radius). To see how many polygons are in the scene, turn off this box to export 3ds Max primitives, which have an indexed face set for each object. Default=on.

Flip-Book Exports the scene to multiple files. The sample rate is set in the in the Flip-Book section of the Sample Rates dialog. The file name you specify becomes the base for the sequence of files. For example, if you specify the file name test.wrl, choose one file per animation frame, and have five frames, 3ds Max exports the following:

test.txt contains general info, start/stop times, and number of frames.
test0.wrl through test4.wrl are snapshots of the animation in frames 0 through 4.

**Color Per Vertex** Exports the vertex colors of geometry. If this is turned on, the Color Per Vertex Source lets you choose the source of the vertex color.

**Polygons Type**

Determines how geometric faces are written out as VRML97 IndexedFaceSet nodes.

- **Ngons** Writes faces with as many edges as possible.
- **Quads** Writes quadrilateral faces where possible (otherwise triangles).
- **Triangles** Writes only triangular faces.

**Visible Edges** Breaks faces at internal edges that are marked as being visible.

**Initial View**

Sets the entry camera for the scene and controls what first appears in the browser. If there are no cameras in the scene, the scene appears with a default viewpoint (which may give only a partial view).

All scenes should have at least one camera, so you can control how the scene initially renders. Add more cameras to the scene than you might ordinarily use, so the viewer can switch between cameras if his VRML97 browser allows it. This lets you set up your scene with pre-installed vantage points. Otherwise, if the world is very large, it can overpower the viewer’s system and make navigation difficult. Some browsers animate camera moves, so the extra cameras can make viewing the scene more pleasant.

**Initial Navigation Info**

Specifies the Navigation Info helper object on page 7813 to use when the world loads in the browser.

**Initial Background**

Specifies the Background helper object on page 7824 to use when the world loads in the browser.
Initial Fog

Specifies the Fog helper object on page 7814 to use when the world loads in the browser.

Digits of Precision

Sets the number of decimal points used for calculating dimensions. The default of 4 is usually sufficient. Set this number greater than 4 if parts of your world were created 100,000 units away from the center of the scene. Setting the value to 3 reduces the file size.

Show Progress Bar

Gives you the option to view a progress bar as the scene is exported.

Vertex Color Source group

Lets you choose the source for the vertex color when Color Per Vertex is turned on.
- Use Max's  Exports the current vertex color of the object defined in the scene.
- Calculate on Export Calculates the diffuse color at the vertices during export, based on the current lighting and the objects’ materials.

Bitmap URL Prefix group

Lets you specify a URL prefix for bitmaps assigned to objects in the scene. You must keep all your texture bitmaps in either the same directory as the WRL file or in one other location, which you specify here. If your maps are stored in other locations, you will have to manually search for the map in the WRL and change its location. Not all browsers will display error messages if the maps aren’t found on the WWW server.
- Use Prefix  Enables the prefix mechanism. If this box is turned off, image maps must be in the same location as the WRL file.
- Prefix  Adds the prefix you enter here to the names of all assigned bitmaps. The name can be a full URL (beginning with HTTP), or it can be a relative path (a subdirectory of the location of the VRML97 file). For example, if you enter “Maps” for the prefix, when the browser opens a VRML97 file that has a texture map assigned to it, it will look for the subdirectory “Maps.” “Maps” must be a directory that is directly under the directory where the VRML97 file resides.
Use forward slashes (not backslashes) to enter longer paths; for example: \Myfiles/maps.

**Sample Rate**

Displays a dialog that lets you specify sample rates for controller-based and coordinate-interpolated animation, as well as the Flip-Book output rates. Setting sample rates lets you trade off between animation fidelity and file size. The default values give good results in most cases. For the greatest animation precision, use a lower number (a higher sampling rate).

**World Info**

Lets you enter information about the world. This has no effect on the visual appearance or behavior of the world. Some browsers can display what you enter in the Title field, for example, in the browser window’s title bar. You can use the Info field to provide author, version, and copyright information.

**VRML97 Tips**

The tips presented in this topic will help you make your work look as good as possible and display and move as fast as possible.

**Geometry**

**Use small texture maps, and use them sparingly. Keep the polygon count of your objects down to achieve good performance.** A complete scene with a maximum of 5,000 to 10,000 polygons is manageable for most computers. The Level of Detail on page 7818 helper lets you manage the polygon count of objects in the scene. You can also use the 3ds Max Optimize modifier to simplify objects before exporting them to VRML97.

**Use primitives whenever possible.** For example, a scene containing only a sphere exports to a VRML97 file of about 400 bytes, but if you apply an edit mesh modifier and move one vertex on the sphere, the VRML97 file is about 7,400 bytes.

**Use Show Statistics on page 2760** to keep track of the number of faces in your scene.

Call your VRML97 .wrl files from a standard HTML page and constrain the viewer to a limited window on the screen using the embed command. This decreases the number of pixels that must be rendered on every frame and
makes the VRML97 environment more responsive. Many users use high resolution (800x600 or more), so the number of pixels during rendering and navigation can be large and the video display may slow down. Frames may be dropped as the browser attempts to keep up its real-time rendering, and navigating the scene will become "chunky." Use the embed command to avoid this, for example, `<embed SRC=myworld.wrl WIDTH=300 HEIGHT=200>`

**Hide faces on an object in 3ds Max, then export the object.** The hidden faces appear as a hole in the object. While the VRML97 plug-in can export hidden objects, it does not export hidden faces. Hide faces that you know will never be visible in the scene, such as the backs of objects or the bottom faces of objects resting on a surface.

**Use instances** to reduce file size for objects that have the same geometry.

**Whenever you use a Mirror transform, use the Reset Transform utility immediately afterward.** You can also use a Normal modifier immediately followed by Unify Normals. VRML97 does not allow mirror transforms (negative scales). The Reset Transform utility modifies the data in the actual mesh object to create the mirroring effect.

**Don’t change units when modeling for VRML97.** To model in meters, keep the units set to the default and use one world unit as one meter.

**Animation**

**Beware of large file sizes when you use transform animation and coordinate-interpolated animation.** The VRML97 plug-in exports transform animation (move, rotate, and scale), and coordinate-interpolated animation. For example, you can animate modifiers such as Taper and Bend and you can animate changing parameters, such as increasing or decreasing the radius of a sphere.

**When scenes using the Inherit Links function are exported to VRML97, child objects always inherit their parents’ transforms.** Inverse kinematics export correctly to VRML97 with the exception of the Inherit Links function, which determines whether child objects inherit the transforms of parent objects.

**Always use TCB controllers for VRBL animations.** These controllers provide precise control and generate the smallest possible file size. Other kinds of controllers, such as the default Bezier controller, create larger VRML97 files that do not perform as well.

**Make sure your animations never change the face or vertex count over time.** VRML97 can not add or delete faces or vertices over time. CoordinateInterpolators support morphing a mesh only, not changing the number of vertices or faces.
To trigger an animation that is not on an object at the top-level of the 3ds Max linking hierarchy, use a TimeSensor helper object. If you trigger an animation directly from a TouchSensor or ProximitySensor, without a TimeSensor, you can animate only top-level objects. Animating from TimeSensors does not have this limitation.

**Turn off the Generate Primitives toggle in the Export dialog** if you animate the parameters of primitives (like the radius of a sphere), and want the animation exported with CoordinateInterpolators. This applies to box, sphere, cylinder and cone primitives only.

**Materials**

You can export only standard and multi/sub-object materials, and only the following components of the material:

- Diffuse, ambient, and specular color
- One texture map, which must be in the Diffuse channel
  Use JPEG or PNG format for your maps, because they are recognized by all VRML97-compliant browsers and generally create the smallest files. (Some older browsers may recognize GIF format and not PNG.) Multi/sub-object materials export colors and textures. If an object has a multi/sub-object material with textures, it exports as separate objects in VRML97, since VRML97 does not support more than one texture map per object. Texture maps slow down the browser and increase download time. Use them sparingly.
- Shininess (but not shininess strength)
- Opacity
- Wire frame

Make sure that all large flat surfaces have enough vertices in them that a few vertices can be seen from all reasonable vantage points in your scene. Some browsers cannot display textures on an object where all of its vertices are outside the current viewport.

**If you have several lights in you scene, lower the default multiplier value on all the lights in the scene.** Lights can oversaturate the scene and make all your geometry wash out toward white. Always add at least one camera and one light to a scene exported to VRML97.
**Helper Objects**

**Insert VRML helper objects into your scene in the top viewport.** You can insert VRML helper objects in any view, but if you insert them in the top viewport, they appear properly oriented in the front viewport.

**VRML97 Helper Objects**

Create panel > Helpers > VRML97 > Object Type rollout

The VRML97 helpers let you create online 3D scenes and interaction using Virtual Reality Markup Language. Insert a VRML 97 Helper into the scene by clicking and dragging at the desired location.

**NOTE** Some helper objects (for example, Billboard and Level Of Detail) are position-sensitive, so be careful how and where you insert them. Usually, you have the most control by creating the helper object in the Top viewport.

**Anchor VRML97 Helper**

Create panel > Helpers > VRML97 > Object Type rollout > Anchor

The Anchor helper lets you specify a click-to-play trigger in the scene. This trigger will be linked to a currently existing object in the scene. This allows you to add links to other HTML pages, VRML97 worlds, or alternate cameras in your VRML97 world.

**Procedures**

**To set up an Anchor to jump to another VRML world:**

1. Add an Anchor helper object by clicking the Anchor button and then dragging in the Top viewport to create its icon.

2. Pick a Trigger Object in the scene that will be the object the viewer clicks while browsing.

3. Choose Hyperlink Jump and designate a URL to jump to.

4. When the user clicks the Trigger Object geometry, the browser will replace the current scene with the designated URL.
The Anchor rollout contains the following options:

**Pick Trigger Object** Specifies the geometry that will be the trigger for this anchor. Click this button, then select the geometry.
**Description** Lets you enter a text description or message that will appear in the browser's status bar when the mouse is over an object that has an Anchor action defined for it.

**Hyperlink Jump** Creates an Anchor that jumps to a URL.

**URL** Specifies the location for Hyperlink Jump. Use your Bookmarks list, or enter a location manually. If the URL points to another VRML97 world (a .wrl file) you can append "#CameraName" to the end of the URL to have the browser use the viewpoint named "CameraName" as the initial view.

**Bookmarks** Lets you select a URL location from a list of bookmarks. Click Import List to import the list of bookmarks defined in your browser, or manually enter new URLs into the list.

**Parameter** Lets you specify additional browser parameters for the hyperlink jump. See the VRML97 specification ([http://www.web3d.org/x3d/vrml/index.html](http://www.web3d.org/x3d/vrml/index.html)) for the uses of this field.

**Set Camera** Creates an Anchor that jumps to a given camera in the current VRML97 world.

**Camera** Specifies the name of the camera for Set Camera.

**Icon Size** Determines the size of the helper in the scene.

---

**ProxSensor VRML97 Helper**

Create panel > Helpers > VRML97 > Object Type rollout > ProxSensor

The ProxSensor helper creates a VRML97 ProximitySensor node. This lets you set up a rectangular region in space, so that entering the region in a VRML97 browser starts a set of objects animating.

**Procedures**

**To create a Proximity Sensor object:**

1. Add a Proximity Sensor object by clicking the ProxSensor button and then click-dragging in the Top viewport to create its icon.

2. Select the geometry, camera, or sound to control.
   When the user navigates inside the box, the specified objects animate or the sound plays.
The Prox Sensor rollout contains the following options:

**Length/Width/Height** Specifies the dimensions of the bounding box that triggers the action.

**Enable** Activates the Proximity Sensor. When this check box is turned off, the sensor has no effect, even if objects have been selected.

**Pick Action Objects** Specifies the objects in the scene to control with this helper. The objects can be animated geometry, cameras, lights, or AudioClips. Click this button then click the objects in the viewports.

**Delete** Deletes an object from the list of picked objects.
NavInfo VRML97 Helper

Create panel > Helpers > VRML97 > Object Type rollout > NavInfo

The NavInfo helper lets you create a VRML97 NavigationInfo node. This tells the browser how to navigate around the VRML97 world.

Procedures

To create a NavInfo helper:

1. Add a NavInfo helper by clicking the NavInfo button and then click-dragging in the Top viewport to create its icon.
2. Use the controls to adjust the behavior of the helper.

Interface

The NavigationInfo rollout contains the following options:
**Type** Specifies the type of movement (Walk, Examine, Fly, and None) for navigating the world. Implementation of these movement types may vary from browser to browser.

**Headlight** Places a directional light at the viewpoint. The light always points in the direction the user is looking.

**Tip** Don’t use this option if you have lights in the scene.

**Visibility Limit** Sets the far clipping plane. Any geometry beyond this point is invisible. The smaller this value is, the closer the clipping plane is to the camera. The larger this value is, the more of your scene is visible to the camera. A value of 0 turns off the effect, making everything in the scene visible. Use this option to show just part of large scenes.

**Speed** Determines the speed of navigation in units per second. Use this option to allow the user to travel faster, if you’re building a large world (like a cityscape), and slower, if you’re building a small world (like a room).

**Avatar Size** Specifies the user's physical dimensions in the world, to detect collision distance and follow terrain.

**Collision** Specifies the allowable distance between the user's position and any collision geometry before a collision is detected. For example, you can set this so that a collision is detected one unit in front of a wall.

**Terrain** Specifies the height above the surface to maintain when following terrain.

**Step Height** Specifies the highest object that can be "stepped over." If an object like a staircase has steps that are lower than this value, the user can go up.

**Icon Size** Adjusts the size of the helper object in the viewports.

**Fog VRML97 Helper**

Create panel > Helpers > VRML97 > Object Type rollout > Fog

The Fog helper lets you specify the color and range of fog in your VRML97 world. You can simulate atmospheric effects by blending objects with a color based on the objects’ distances from the viewer. For the best visual results, the background (which is unaffected by the fog) should be the same color as the fog.
Procedures

To create a VRML 97 Fog helper:

1. Add a Fog helper by clicking the Fog button, then click-drag in the Top viewport to create its icon.

2. Use the controls to adjust the type of fog in your VRML environment.

Interface

The Fog rollout contains the following options:

Type Specifies the fog type (linear or exponential). Linear means that the amount of blending is a linear function of the distance, resulting in a depth-cueing effect. Exponential uses an exponential increase in blending, resulting in a more natural fog appearance.

Color Lets you select the fog color from the Color Selector dialog.

Visibility Range Specifies the distance from the viewer at which objects are totally obscured by the fog. The smaller this value is, the closer the fog is to the camera, and the less your scene is visible. The larger this value is, the more of your scene is visible to the camera. A value of 0 turns off the effect, making everything in the scene visible. A value of 0 means that there is no fog effect.

Icon Size Adjusts the size of the helper object in the viewports.

Sound VRML97 Helper

Create panel > Helpers > VRML97 > Object Type rollout > Sound
The Sound helper lets you place 3D (spatial) or ambient sounds in a scene. The sound can be located at a point and emit sound in a spherical or ellipsoid pattern. The ellipsoid is pointed in a particular direction and may be shaped to provide more or less directional focus from the location of the sound. The sound node can also be used to describe an ambient sound that tapers off at a specified distance from the sound node.

The red ellipsoid of the helper represents the outermost range for which the sound can be heard. The blue ellipsoid represents the range of the maximum strength of the sound. The area between the red and blue ellipsoids represents a falloff area in which the volume varies in intensity. The helper’s arrow points in the direction toward which the sound is emanating.

**NOTE** The Sound helper object must be linked to an existing audio clip in the scene. Therefore, you must have an AudioClip on page 7827 helper object in the scene in order for the Sound helper to play.

**Procedures**

**To create a Sound helper object:**

1. Add a Sound helper by clicking the Sound button, then click-drag in the Top viewport to create its icon.
2. Press Pick Audio Clip and select an AudioClip helper object in the scene.
3. Rotate the icon to determine the direction in which the sound is emanated.
4. Use the controls to adjust the range and strength of the playback sound.
Interface

The Sound rollout contains the following options:

**Intensity** Sets the loudness of the sound. 1.0 is full volume.

**Priority** Sets the relative importance of the sound, if you have more than one sound in the scene and the browser cannot play all of them. 0 is least important. 1 is most important.

**Spatialize** Makes the sound 3D. A spatial sound has a particular source location in the scene. If this box is turned off, the sound is ambient.

**Min Back/Front, Max Back/Front** Displays red and blue ellipsoids that allow you to set the area of the sound effect. Inside the blue ellipsoid, the sound is at full volume. Outside the red ellipsoid, the sound is inaudible. Between the blue and red ellipsoids is a falloff area in which the volume varies in intensity.
Pick Audio Clip  Lets you choose an audio clip. Click this button, then click an AudioClip helper object. The audio clip must already be in the scene and have a sound file associated with it.

Icon Size  Determines the size of the helper in the scene.

LOD VRML97 Helper

Create panel > Helpers > VRML97 > Object Type rollout > LOD

The Level of Detail (LOD) helper lets you specify objects with varying face counts that are appropriate for different viewing distances. Browsers display the less detailed objects when the viewer is far away from them and substitute the more detailed objects at closer ranges.

Use LOD objects to speed up rendering of scenes in which highly detailed objects are often far away from the viewer.

Objects used for LOD do not have to be of the same type or size, so you can accomplish a crude form of morphing by using different objects as the LOD components. For example, a tree might seem to grow if taller trees with more limbs are substituted as the viewer gets closer.

Procedures

To create a Level of Detail helper object:

1. Create the objects to which you want to add level of detail.
2. Click the LOD button.
3. Click and drag in the scene to create a helper object.
4. Add the objects to the list with Pick Objects.
5. Use the Hide and Unhide commands, or the H key, to help pick the objects and add them to the LOD list.
6. Select the objects in the list and use the Distance spinner to set the distance.

To create all the objects and the LOD helper object at exactly the same coordinates:

1. Create the LOD helper object.
2 You can use Snap and create the helper object at the origin (0,0,0 coordinates), or use the Keyboard Entry rollout for a Standard Primitive to specify an exact object origin.

3 Create the object with the most detail at the same coordinates. Name it (for example, hicapsule).

4 Choose Edit/Clone.
   In the Clone Options dialog, choose Copy and name the new object (for example, medcapsule).

5 Repeat step 3 to create the other objects (for example, locapsule).
   For the medium and low resolution objects, apply an Optimize modifier to reduce the face count.
   For primitives, you can reduce the face count by changing the creation parameters in the modifier stack.

Interface

The Level of Detail rollout contains the following options:
**Pick Objects** Selects objects of different face counts to substitute for the LOD helper object. Create all the objects and the LOD helper object at exactly the same coordinates.

**Distance** Sets the distance from the camera at which the user sees the selected object. The distance specified for the object appears next to the object name. For example:

hicapsule - 100 medcapsule - 300 locapsule – 500

Hicapsule is displayed when the distance between it and the camera is within 100 units. The lower resolution object (medcapsule) is displayed when the camera is between 100 and 300 units. The lowest resolution object (locapsule) is displayed when the camera is beyond 300 units. The greatest distance (500 in this case) is not actually used, but must be supplied.

**Delete** Deletes the selected object from the list.

**Icon Size** Sets the size of the LOD helper object.

---

**TouchSensor VRML97 Helper**

Create panel > Helpers > VRML97 > Object Type rollout > TouchSensor

The TouchSensor helper lets you set up an object so that selecting it in a VRML97 browser starts a set of objects animating.

**Procedures**

**To set up an object as a TouchSensor trigger:**

1. Add a Touch Sensor object by clicking the Touch Sensor button and then click-dragging in the Top viewport to create its icon.
2. Select the geometry to control.
   
   When the user clicks the trigger geometry, the geometry, camera or light animates, or the sound plays.
The Touch Sensor rollout contains the following options:

**Pick Trigger Object** Specifies the geometry that will be the trigger for this TouchSensor. Click this button, then select the geometry.

**Enable** Activates the Touch Sensor. When this box is turned off, the sensor has no effect, even if objects have been selected.

**Pick Action Objects** Specifies the objects in the scene to control with this helper.

**Delete** Deletes an object from the list of picked objects.

**Icon Size** Determines the size of the Touch Sensor helper in the scene.
TimeSensor VRML97 Helper

Create panel > Helpers > VRML97 > Object Type rollout > TimeSensor

The TimeSensor helper lets you add time-based animation controls, such as the start and end frames for a particular object’s animation, and looping. Use this helper to split up an object’s animation keys over several triggers, to automatically start an animation upon loading the .wrl file, or to make animation endlessly loop.

Procedures

To assign an object to a TimeSensor helper:

1. Add a Time Sensor object by clicking the Time Sensor button and then click-dragging in the Top viewport to create its icon.
2. Press Pick Objects and select the (animated) geometry to control.
3. Use the controls to adjust the start and end times of the animation, and to loop the animation.
The Time Sensor rollout contains the following options:

**Loop** Repeats the animation from the start-time frame to the stop-time frame.

**Start on World Load** Starts the animation so that it will be running when the file is loaded into the browser.

**NOTE** This option is only available when Loop is turned on. Otherwise, the animation will start and stop at the specified times.

**Start Time/Stop Time** Specifies the range of frames to play.

**NOTE** If the start time is after the end time, the animation will play from the earliest frame to the last frame. It will not play the animation backward.
**Pick Objects** Lets you select the objects to control with this TimeSensor.

**Delete** Deletes an object from the list of picked objects.

**Icon Size** Adjusts the size of the helper object in the viewports.

---

**Background VRML97 Helper**

Create panel > Helpers > VRML97 > Object Type rollout > Background

The Background helper has Sky Color, Ground Color, and Images rollouts. Use these rollouts to specify colors and images for the sky and ground in your VRML97 world.

**Procedures**

To create a Background helper object:

1. Add a Background helper object by clicking the Background button, then click-drag in the Top viewport.

2. Use the controls to adjust the colors and layout of the background.
**Interface**

**Sky Colors rollout**

Let's you provide a colored background to the world's sky using a gradient of up to three colors. The sky is an infinite sphere that encloses the objects of the scene.

**Number of Colors** Specifies whether the sky is one solid color or a gradient of two or three colors.

**Color One/Two/Three** Lets you select the colors from the Color Selector. Color One is the base color.
Angle Specifies the angle at which Color Two and Color Three merge with the base color, in degrees from the North pole of the sky (straight up from the viewer).

Icon Size Adjusts the size of the helper object in the viewports.

**Ground Colors rollout**

<table>
<thead>
<tr>
<th>Number Of Colors</th>
<th>Color One</th>
<th>Color Two</th>
<th>Color Three</th>
</tr>
</thead>
<tbody>
<tr>
<td>One</td>
<td>Color:</td>
<td>Color:</td>
<td>Color:</td>
</tr>
<tr>
<td>Two</td>
<td></td>
<td>Angle:</td>
<td>Angle:</td>
</tr>
<tr>
<td>Three</td>
<td></td>
<td>45.0</td>
<td>90.0</td>
</tr>
</tbody>
</table>

Lets you provide a colored background to the world’s ground plane using a gradient of up to three colors. The ground appears inside the sky sphere and below the objects of the scene.

**Number of Colors** Specifies whether the ground is one solid color or a gradient of two or three colors.

**Color One/Two/Three** Lets you select the colors from the Color Selector. Color One is the base color.
Angle Specifies the angle at which Color Two and Color Three merge with the base color, in degrees from the South pole of the sky (straight down from the viewer).

Images rollout

Let you specify a set of images that define a background panorama between the ground/sky backdrop and the objects in the scene. The panorama consists of six images, each of which is mapped onto a face of an infinitely large cube centered in the local coordinate system.

Image URLs Specifies the location/file names of the images to use. The images can be JPEG files or PNG files with or without transparency. Some browsers also support GIF files.
See the VRML97 specification (http://www.web3d.org/x3d/vrml/index.html) for diagrams of the typical image configuration.

 AudioClip VRML97 Helper

Create panel > Helpers > VRML97 > Object Type rollout > AudioClip
The AudioClip helper lets you specify the name and characteristics of an audio file that can be used by the Sound helper.
Procedures

To create an AudioClip helper:

1. Press the AudioClip button, and click-drag in the Top viewport to create the helper.
2. Enter the location of the sound file (`.wav` or `.mid`) you want to use in the URL text box.

Interface

The rollout contains the following options:

**URL** Specifies the location/file name of the sound to use. Either `.wav` (waveform) or `.mid` (MIDI) files can be used, but MIDI sound files may not be spatialized. Some browsers do not support MIDI.

**Description** Lets you enter a text description of the sound, which is displayed by some browsers.

**Pitch** Sets the relative pitch of the sound. 1.0 is normal pitch, and 0.5 is one octave lower than normal.

**Loop** Repeats the sound.

**Start On World Load** Starts the sound when the world loads.

**Icon Size** Adjusts the size of the icon.
Start on World Load Starts playing the sound as soon as the world is loaded into the browser.

Icon Size Determines the size of the AudioClip helper in the scene.

Billboard VRML97 Helper

Create panel > Helpers > VRML97 > Object Type rollout > Billboard

The Billboard helper lets you create geometry that is camera-aligned in the VRML97 browser. The objects always align to the viewpoint in the VRML97 browser.

Any geometry linked to the Billboard helper will rotate about the local Z axis of the helper object to face the viewer. Since it rotates about the location of the Billboard, it is best to center the Billboard on the object that you will link to it.

The direction of the negative Y axis of the object, which will be its front, is aligned with the negative Y axis of the helper, and will be the Billboard surface that always faces the viewer. This is the side usually seen from the default camera position.

Procedures

To create a Billboard helper object:

1. Press the Billboard button and click-drag in the Top viewport to create the helper.
2. Link object(s) to the billboard to keep them aligned with the camera.

Interface

The Billboard rollout contains the following option:
**Screen Alignment** Keeps the geometry linked to the Billboard helper aligned, even when the viewer elevates, pitches, and rolls.

**Icon Size** Determines the size of the Billboard helper in the scene.

---

**Inline VRML97 Helper**

Create panel > Helpers > VRML97 > Object Type rollout > Inline

The Inline helper lets you reference another VRML97 file that is included in your world when you load it into your VRML97 browser. These inline objects are like instance objects, but they function at the browser level.

**Procedures**

To create an Inline helper object:

1. Click the Inline button.
2. Click and drag in one of the viewports.
   
   You can modify the helper object with the tools in the VRML Inline rollout.

**Interface**

If you create the objects in the scene to be inserted off-center (away from the origin), they will appear in the browser off-center as well. Align the original scene and the scene to be inserted correctly, in relation to the origin.
The VRML Inline rollout contains the following options:

**Insert URL** Specifies the URL of the .wrl files to insert in place of the helper object. The URL must be another VRML97 file.

**Bookmarks** Displays a dialog that lets you select a location from a list of bookmarks. Click Import List to import the list of bookmarks defined in your browser. Most browsers store bookmarks in a file called `bookmark.htm`.

**Bounding Box** Specifies whether an explicit bounding box size will be exported. If you select “Use Icon Size,” the diameter of the icon will be written into the VRML97 file for the width, length, and height of the bounding box; the actual contents of the inline file should fit within that bounding box. If you select “Calculate in Browser,” no bounding box size is exported and the VRML browser will determine the size of the inline geometry.

**Icon Size** Sets the size of the helper object. You can transform this object like any other object in 3ds Max. The scene that replaces the helper object will be moved, rotated, or scaled in the same manner. The size shown is the radius of the icon.

### Image File Formats

Image files, also known as bitmaps, have a variety of uses in 3ds Max scenes. You can use bitmaps as textures for materials, as backgrounds to viewports,
as environment maps, as Image Input events in Video Post, or as images projected from a light.

An image file can be a single still image, or a sequence of images that form a video sequence or animation. When you assign an animation for use as a bitmap, then the image changes over time when you render the 3ds Max scene.

**NOTE** Bitmaps are reloaded automatically after they have been changed and resaved by a graphic editing program. See the Reload Textures On Change toggle in File Preferences on page 8305.

When you render a scene, you can render a still image or an animation. You can render to most of the formats listed below. Some of the formats support various options. If there are output options, these appear in a dialog that is described along with the image file's format.

**NOTE** To save loading time, if a map with the same name is in two different locations (in two different paths), it is loaded only once. This poses a problem only if your scene includes two maps that have different content but the same name. In this case, only the first map encountered will appear in the scene.

### AVI Files

The AVI (Audio-Video Interleaved) format is the Windows standard for movie files. The .avi file-name extension indicates a Windows AVI movie file.

3ds Max creates an AVI created when you make a preview animation on page 6894. You can also render your final output to an AVI file. Although 3ds Max produces its highest-quality output by rendering single-frame TGA files or rendering directly to a digital disk recorder, you can still get good results rendering AVI files.

AVI files can be used as input to 3ds Max in several ways, for example:

- As animated materials in the Material Editor
- As viewport backgrounds for rotoscoping
- As input images for compositing in Video Post
Interface

When AVI is the chosen output format, clicking Render or Setup on the Render Output File dialog on page 6529 displays the Video Compression dialog.

Compressor Use the drop-down list to choose the codec on page 8533 (compressor/decompressor) you want to use to compress the file. You can use any codec that's installed on your system.

Alternatively, you can render uncompressed frames and then use an external application to compress the animation. Video-file compression is a complex subject, with many aspects to consider.

Compression Quality Available only for certain codecs. When available, use the slider to specify the quality you want. The higher you set the quality, the larger the file size will be.

Keyframe Rate Available only for certain codecs. When available, use this setting to specify the interval between the delta keyframes used to compare one frame with another and generate in-between frames. Too large an interval will create loss of quality in the AVI file as a whole.
Setup  Available only for certain codecs. Click this button to see any additional options that are specific to the codec. These are vendor specific and vary from codec to codec.

BMP Files

BMP files are still-image bitmap files in the Windows bitmap (.bmp) format.

Interface

When BMP is chosen as the output format, clicking Render or Setup on the Render Output File dialog on page 6529 displays the BMP Compression dialog.

8 Bit Optimized palette (256 Colors)  Choose to render a smaller, 8-bit color file.

RGB 24 bit (16.7 Million Colors)  Choose to render a larger, true color (24-bit) file.

CIN (Kodak Cineon) Files

A file format that stores a single frame of a motion picture or video data stream. Each frame is saved as cineon version 4.5 with a CIN file-name extension. The file contains no user-defined data such as a thumbnail, and supports 10-bit log, and three colors per pixel. Alpha channels are not supported.
Interface

When CIN is chosen as the output format, clicking Render or Setup on the Render Output File dialog on page 6529 displays the Cineon Image File Format dialog.

![Cineon Image File Format dialog](image)

**Printing Density Adjustment** Represents the transfer function from printing density (10-bit log) to 16-bit linear with the white point mapped to a maximum code value of 65535.

Conversion of logarithmic printing density to a linear representation requires both a scaling and an anti-log operation. With 16-bits linear, it is possible to maintain the full printing density range. The 90% white card at code value 685 is mapped to maximum code value of 65535.

The **White Pt** and **Black Pt** spinners let you adjust the 90% white code and the 2% black code.

**CWS (Combustion Workspace) Files**

The file format for the Combustion™ software from Autodesk. CWS is a resolution-independent, vector/raster file format.

You can use CWS files in conjunction with the Combustion map on page 6229. You can't use a CWS file as a general-purpose bitmap. You can also generate
a CWS file by using the Render Elements option on page 6807 when you render a scene.

**IMPORTANT** Only Combustion 2.1 and later formats are supported. Maps in the Combustion 1 format are not supported in 3ds Max.

## DDS Files

The DirectDraw® Surface (DDS) file format is used to store textures and cubic environment maps, both with and without mipmap levels. This format can store uncompressed and compressed pixel formats, and is the preferred file format for storing DXTn compressed data. Microsoft® is the developer of this file format.

You can use DDS files as texture maps.

With Direct3D 9, you can render to the DDS format. (With DX8 or DX9, DDS files can be rendered using the Metal Bump shader on page 6180, as well.) If your system does not support DX9, you can use DDS files as textures, but you can't render them.
DDS supports a variety of output formats, which vary in the number of pixels allocated to the red, green, and blue (RGB) channels, to the optional alpha channel (transparency), and to possible unused bits. There is also a set of compressed formats.

- **A8 R8 G8 B8**: 32 bits per pixel: 8 bits each for the RGB and alpha channels.
- **A1 R5 G5 B5**: 16 bits per pixel: 5 bits each for the RGB channels, and one bit for the alpha channel.
- **A4 R4 G4 B4**: 16 bits per pixel: 4 bits each for the RGB and alpha channels.
- **R8 G8 B8**: 24 bits per pixel: 8 bits each for the RGB channels; no alpha.
- **R5 G6 B5**: 16 bits per pixel: 5 bits each for the R and B channels, 6 bits for the G channel; no alpha.
<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A2 R10 G10 B10</td>
<td>32 bits per pixel: 10 bits each for the RGB channels; 2 bits for the alpha channel.</td>
</tr>
<tr>
<td>X8 R8 G8 B8</td>
<td>32 bits per pixel: 8 bits each for the RGB channels; 8 bits unused; no alpha.</td>
</tr>
<tr>
<td>X1 R5 G5 B5</td>
<td>16 bits per pixel: 5 bits each for the RGB channels; 1 bit unused; no alpha.</td>
</tr>
<tr>
<td>R3 G3 B2</td>
<td>8 bits per pixel: 3 each for the R and G channels, 2 bits for the B channel; no alpha.</td>
</tr>
<tr>
<td>A8 R3 G3 B2</td>
<td>16 bits per pixel: 3 each for the R and G channels, 2 bits for the B channel; 8 bits for the alpha channel</td>
</tr>
<tr>
<td>X4 R4 G4 B4</td>
<td>16 bits per pixel: 4 each for the RGB channels and 4 unused bits.</td>
</tr>
<tr>
<td>A16 B16 G16 R16</td>
<td>64 bits per pixel: 16 bits each for the RGB and alpha channels.</td>
</tr>
<tr>
<td>A16 B16 G16 R16F</td>
<td>64-bit floating-point format using 16 bits each for each channel: alpha, blue, green, red.</td>
</tr>
<tr>
<td>A32 B32 G32 R32F</td>
<td>128-bit floating-point format using 32 bits each for each channel: alpha, blue, green, red.</td>
</tr>
<tr>
<td>DXT1</td>
<td>Compressed format with 1-bit alpha.</td>
</tr>
<tr>
<td>DXT2</td>
<td>Compressed format with 4-bit premultiplied alpha on page 8690.</td>
</tr>
<tr>
<td>DXT3</td>
<td>Compressed format with 4-bit alpha, no premultiplication.</td>
</tr>
<tr>
<td>DXT4</td>
<td>Compressed format with interpolated premultiplied alpha.</td>
</tr>
<tr>
<td>DXT5</td>
<td>Compressed format with interpolated alpha but no premultiplication.</td>
</tr>
</tbody>
</table>

---

**Generate Mipmaps** When on, mipmaps are generated for the image. Default=off.

Mipmaps are a set of lower-detail bitmaps. The first is half the size of the original image, the next is half the size of that, and so on down to a single pixel. (You can think of them as being arranged like a pyramid.) They are used to optimize display time and reduce aliasing on page 8501 when the texture is to be displayed at less than full size. For example, if your original DDS image...
is 512 x 512 pixels, but the area in which it would be displayed is only 100 pixels square, the display device would interpolate between the 128 x 128 mipmap and the 64 x 64 mipmap.

**EPS and PS (Encapsulated PostScript) Files**

3ds Max can render images to Encapsulated PostScript format files, which have the .eps or .ps extension.

PostScript is an Adobe page-description language for encoding graphics images. It is supported by many printing devices and is widely used in desktop publishing and graphic design as a means of porting images from one platform to another. You can not view PostScript files with 3ds Max or use them as bitmaps in materials or environments.

**Interface**

When PostScript is the chosen output format, clicking Render or Setup on the Render Output File dialog on page 6529 displays the EPS File Output Options dialog.
Units Select inches or millimeters.

Image Orientation Select portrait (tall) or landscape (wide).

Data Format Select binary or ASCII.

File Type Select color or grayscale.

Preview Check to generate a thumbnail image so that file browsers can preview the contents of the PostScript file.

Page Size Set width and height measurements.

Resolution Set width and height resolution in dots per inch (dpi).
GIF Files

GIF is an 8-bit (256-color) format developed by Informix for the CompuServe® information service. It was originally designed to minimize file transfer times over telephone lines.

GIF is supported only as an input file format. You can use GIF files as general-purpose bitmaps, but you can't render to a GIF file.

IFL Files

An IFL (Image File List) file is an ASCII file that constructs an animation by listing single-frame bitmap files to be used for each rendered frame. When you assign an IFL file as a bitmap, rendering steps through each specified frame, resulting in an animated map.

(In a similar way, if you assign an AVI file or MOV file as a bitmap, rendering steps through each frame of the animation.)

For example, if you assign a 10-frame animation of a blinking red "Danger" sign to a material's diffuse component, apply the material to a cube, and then render a 30-frame animation, the cube displays the blinking red Danger animation three times.

The .ifl file lists the bitmap files to be used with each frame. You can append an optional numeric argument to each file name to specify the number of frames of rendered animation on which it is used. For example:

The IFL file listed above specifies sand.tga to be used for the first 20 frames, pebble.tga to be used for the next 40 frames, stone.tif to be used for 20 frames, and boulder.tif to be used for 20 frames.

TIP Specify only the file names in your IFL files. The file paths can be derived from the map paths established in your preferences. See External Path Configuration on page 8289. IFL files with path names can be used only on the system on which you create them.

See also:

- Image File List Control Dialog on page 7844
- IFL Manager Utility on page 7845
Sequentially Numbered Files

You can use incrementally numbered bitmap files (for example, frame001.bmp, frame002.bmp, and so on) to construct an IFL file. Either use the IFL Manager Utility on page 7845, or use the Sequence check box in a file selector dialog, as described in the following procedures.

Notes

- If the IFL generator has a name conflict with an existing IFL file, it will increment the new file's name to avoid overwriting the existing file.
- If the IFL generator has any problems with write access while trying to create the IFL file, the process will fail and the IFL file won't be created. Therefore, automatic IFL generation won't work when reading bitmaps from a CD-ROM. You need to copy them to a directory on your hard disk first. Likewise, automatic IFL generation won't work on network drives to which you don't have write access.

Procedures

To construct an IFL file from sequentially numbered files:

1. In the file selector dialog, navigate to a directory that has a sequence of incrementally numbered bitmaps.
2. Choose the name of one of the sequential files (for example, image01.bmp). The Sequence check box becomes available.
3. Turn on the Sequence check box. The Setup button becomes available.
4. Click Setup to display the Image File List Control dialog on page 7844.
5. In the Image File List Control dialog, choose the options you want, and then click OK.
   
   **TIP** Use the Browse button to set the Target Path to a directory on your hard disk. Do not set this path to a CD-ROM drive, because you cannot save the file there.

   The Image File List (IFL) file is saved to the target directory.
6. In the file selector dialog, click OK. This assigns the newly created IFL file as the bitmap.
Example: To select a set of still images as a viewport background:

1. Activate the viewport where you want the animated background.
2. Choose Views menu > Viewport Background.
3. In the Background Source group, click Files.
   A Viewport Background dialog is displayed.
4. On Select Background Image dialog, use the Look In field to navigate to the directory containing the files you want to use for the sequence.
   If necessary, change the file type to match the file name extension of the sequence, or choose All Formats.

   **NOTE** The Select Background Image File dialog uses the last location where a bitmap was chosen, rather than the default bitmap path defined in Customize menu > Configure User Paths.

5. Construct an IFL file as described in the previous procedure.
6. On the Select Background Image dialog, click OK.
   The IFL file now provides the background for the viewport.

   **TIP** The viewport background does not render. To render the IFL file's animation, assign the IFL file as a rendering environment. (See the following procedure.)

To render the frames in an IFL file as a movie (AVI or MOV format):

2. On the Environment dialog, click Environment Map.
3. On the Material/Map Browser, choose Bitmap, and then click OK.
4. On the Select Bitmap Image File dialog, choose the IFL file, and then click OK.

   ![Icon] Click Time Configuration, and use the Time Configuration dialog to make the animation length match the number of frames specified in the IFL file.

5. Render a viewport to a movie-format file.
The aspect ratio of the rendered movie should match the aspect ratio of the frames in the IFL file.

Image File List Control Dialog

Views menu > Viewport Background > Select Background Image dialog > Choose a directory with sequentially numbered files. > Sequence > Setup > Image File List Control dialog

The Image File List Control dialog provides controls for creating an Image File List (IFL file) on page 7841, which lists sequential still image files for rendering into backgrounds or materials. It is particularly useful if you are choosing a sequence of files that are on a CD-ROM, because you can redirect the IFL file to a different directory on your hard disk.

This dialog duplicates the functionality found in the IFL Manager utility on page 7845.

Interface

Target Path Sets the directory where the IFL file is saved.

Browse Use this to navigate to the correct directory.

Options Sets additional options for creating the IFL file.
Start Frame Determines which file in the sequence will be the first frame. Use this when you have a sequence but you don’t want to start with the first image in the sequence.

End Frame Determines which file will be the last frame listed in the IFL list.

Nth Frame Skips frames in the image file list. Use this to match the length of the sequence to the length of the animation.

Multiplier Increases the frames in the image file list. Each frame in the file list can be repeated by this value to stretch out the length of the sequence.

Include Image Path Includes the path in the image file list.

**IFL Manager Utility**

Utilities panel > Utilities rollout > More button > Utilities dialog > IFL Manager

The IFL Manager utility generates an image file list (IFL) file on page 7841 from an image file you choose from a numbered file sequence.

**NOTE** You can also generate an IFL file in a file selector dialog by selecting a numbered bitmap, turning on Sequence, and then clicking Setup to display an Image File List Control dialog on page 7844.

See also:

- Image File List Control Dialog on page 7844

**Procedures**

To use the IFL Manager utility:

1. Open the IFL Manager.
2. Click the Select button to display a file selector.
3. Select any of the sequentially numbered image files that you want included in the list, and click Open.
   
   The prefix name of the file appears in the Working File Prefix group box, and the spinners in the IFL Manager panel become enabled.

4. Set the Start spinner to specify the first numbered file in the sequence. For example, set this to 5 to begin with file tree0005.jpg.
5 Set the End spinner to specify the last numbered file in the sequence. The Start and End spinners default to the first and last number in the existing numbered files.

**NOTE** You can invert the Start and End values (setting the greater value in Start and the lesser in End) to create a reversed list in the .ifl file.

6 Click Create to display a file dialog where you can name and then save your IFL file.

7 Click the Edit button to display a file dialog where you can choose an IFL file, which then appears in the Windows Notepad.

**Interface**
**Working File Prefix group**

After you use the Select button to select a sequentially numbered file, the prefix name of the file appears here. For example, if the files are `tree0000.jpg`, `tree0001.jpg`, `tree0002.jpg`, and so on, the title in this group box would be `tree`.

**Spinners group**

Start Displays the number of the first image file in the selected sequence. Increase to specify a different starting image for the IFL file.

End Displays the number of the last image file in the selected sequence. Decrease to specify a lower ending image for the IFL file.

Every nth Set to a number greater than 1 to skip a specified number of images in the list.

Multiplier Adds a multiplier after each file in the IFL list. If you set to 3, each image is used three times before the next image in the list is used.

**Button set**

Select Displays a file dialog that lets you select a file in a sequential list. The number appended to the file doesn't matter, as long as the prefix and file name extension are the same. After selecting the file, the spinners in the IFL Manager are enabled.

Create Displays a file dialog where you can name and save your IFL file.

Edit Displays a file dialog where you can select an IFL file. The selected file is then displayed in the Windows Notepad editor.

Close Closes the utility.

**IMSQ Files**

The Autodesk ME Image Sequence (IMSQ) format is an XML file used by the Autodesk products Cleaner and Toxik. You generate IMSQ files in the Render Output group of the Render Setup dialog > Common Parameters rollout on page 6568 by turning on Put Image File List(s) In Output Path(s) and then clicking Create Now.

The IMSQ file stores information about the rendering, including:

- The name of the rendering file
The format of the rendering file

The range of frames
   (Nonsequential frame sequences, such as 1, 7, 12–19, are not supported.)

The frame rate

The pixel aspect ratio

The output type, aperture width, and resolution (width x height)

The render element type and name

The camera name (when rendering a Camera view)

3ds Max generates a separate IMSQ file for each render element.

JPEG Files

JPEG (.jpeg or .jpg) files follow the standards set by the Joint Photographic Experts Group. These files use a variable compression method that is called lossy compression because of the loss of image quality as you increase the compression. However, the JPEG compression scheme is extremely good and you can sometimes compress the file up to 200:1 without severe loss of image quality. JPEG is consequently a popular format for posting image files on the Internet for minimum file size and fast download time.

Interface

When JPEG is the chosen output format, clicking Render or Setup in the Render Output File dialog on page 6529 displays the JPEG Image Control dialog.
Quality Move the slider to the level of quality you want: the higher the quality, the larger the file size. In general, files compressed with the slider set to Best have compression ratios between 5:1 and 15:1.

File Size Move the slider to the size of file you want: the larger the file, the higher the quality.

Smoothing Move the slider to the level of smoothing you want: the higher the level of smoothing, the larger the file size.

**MOV (QuickTime Movie) Files**

QuickTime® is a standard file format created by Apple® for storing common digital media types such as audio and video. When you choose QuickTime (*.mov) as the Save as Type, your animation is saved as a .mov file.
You can export animations to .mov for both rendering and previews. You can also export audio if an audio track is present in Track View. You can download the QuickTime movie player from http://www.apple.com/quicktime/download.

**NOTE** The plug-in does not allow for the direct import of audio from a QuickTime file.

**Interface**

When you create a new QuickTime file or choose Setup for an existing one, you see a dialog that is typically titled Compression Settings. This dialog is provided by the QuickTime codec on page 8533 installed with your system, and can change depending on the version of QuickTime you've installed.

**MPEG Files**

The MPEG format is a standard for movie files. MPEG stands for Moving Picture Experts Group. MPEG files can have a .mpg or .mpeg file name extension. MPEG is supported only as an input file format. You can use MPEG files as texture maps.

**NOTE** 3ds Max supports all MPEG variants that are also supported by your Windows system. To use an unsupported MPEG file, install the necessary codec.

**OpenEXR Files**

3ds Max can both read on page 7857 and write on page 7852 image files in the OpenEXR format. OpenEXR is both an image file format and a general open-source API for reading and writing such files.

The best place to look for information on OpenEXR itself is the official Website. The following is taken directly from the OpenEXR home page:

OpenEXR is a high dynamic-range (HDR) image file format developed by Industrial Light & Magic for use in computer imaging applications.

OpenEXR is used by ILM on all motion pictures currently in production. The first movies to employ OpenEXR were Harry Potter and the Sorcerer's Stone, Men in Black II, Gangs of New York, and Signs. Since then, OpenEXR has become ILM's main image file format.
OpenEXR’s features include:

- Higher dynamic range and color precision than existing 8- and 10-bit image file formats.
- Support for 16-bit floating-point, 32-bit floating-point, and 32-bit integer pixels. The 16-bit floating-point format, called "half," is compatible with the half data type in NVIDIA’s Cg graphics language and is supported natively on their new GeForce FX and Quadro FX 3D graphics solutions.
- Multiple lossless image compression algorithms. Some of the included codecs can achieve 2:1 lossless compression ratios on images with film grain.
- Extensibility. New compression codecs and image types can easily be added by extending the C++ classes included in the OpenEXR software distribution. New image attributes (strings, vectors, integers, and so on) can be added to OpenEXR image headers without affecting backward compatibility with existing OpenEXR applications.

The OpenEXR Bitmap I/O software goes beyond the “standard” OpenEXR format, taking advantage of the flexibility of the format itself. It can write channels and attributes as well as general RGBA data in formats that many OpenEXR file importers cannot understand, due to implementation limits as well as limits to the current set of standards. The full-latitude 32-bit floating point RGBA files that the output function can write is one example. While the OpenEXR API itself fully supports this capability, and these files are written using the standard set of OpenEXR libraries, most software only reads the 16-bit “half” floating point RGBA files that are considered standard EXR files.

**TIP** To take best advantage of the OpenEXR format’s 32-bit support, use the mental ray renderer with the Frame Buffer Type on page 6739 set to Floating-Point (32 bits per channel).

**NOTE** When you render with floating-point, 32-bit output, bright areas such as self-illumination or reflections of light sources might appear to be jagged. See Frame Buffer Type on page 6739 for more information.

**Configuration File Usage**

Most bitmap I/O plug-ins, including those integrated into 3ds Max, store their configuration information in a binary CFG file that cannot be edited. To allow external scripting support as well as ordinary preferences, the OpenEXR software uses a standard INI file format to store its configuration data. The
file is named openexr.ini and is found in the plugcfg folder in the 3ds Max directory. The file is generated automatically the first time you edit the OpenEXR configuration settings, and is updated each time you modify an EXR loader. It is a standard text file and can be modified with any text editor.

When the INI file is written, it automatically generates a companion “help” text file named openexr_ini_help.txt. This file contains the valid ranges for various INI settings, as well as the various text strings used to specify compression type and bit depth. This file is just a guide; editing it has no effect, and it is overwritten whenever the INI file is updated.

To restore the default settings after editing the INI file, simply delete the openexr.ini file and a new one with the original defaults will be generated the next time you edit the configuration settings.

**Saving OpenEXR Files**

Render Setup dialog > Common panel > Common Parameters rollout > Render Output group > Click Files. > Enter file name and set type to OpenEXR Image File > Click Save. > OpenEXR Configuration dialog

Rendered Frame Window > Click Save Bitmap. > Enter file name and set type to OpenEXR Image File > Click Save. > OpenEXR Configuration dialog

Use the OpenEXR Configuration dialog dialog to set output parameters for OpenEXR files. You can specify the format for saving the RGBA data as well as which of the four standard channels should be saved. An option is available to use RealPixel unclamped color information for Render Output saving. Also available are color transforms to be applied, file compression type, and additional attributes.
Interface

Compression Type

Lets you choose the method of file compression. The OpenEXR API provides for three general types of lossless compression, including two different methods of Zip compression. For most images without a lot of grain, the two Zip compression methods seem to work best, while the PIZ compression algorithm is better suited to grainy images. The following options are available:

- **None**  Disables all compression.
- **Run Length Encoding (RLE)**  A basic form of compression comparable to that used by standard Targa files.
- **Zip (per scanline)**  Zip-style compression applied to individual scanlines.
- **Zip (16 scanline blocks)**  Zip-style compression applied to blocks of 16 scanlines at a time. This tends to be the most effective style of compression to use with rendered images that do not have film grain applied.
- **PIZ (wavelet compression)**  Uses a combined wavelet/Huffman compression. This form of compression is best for grainy images.

Standard Channels group

The standard channels in an image are: red, green, blue, and alpha (transparency). This group lets you choose the general type of OpenEXR file to save, as well as which of the four channels to save with the file. The most widely supported format is Half Float - 64 bpp format. This stores each channel of the image in a separate slice in the file using half-type 16-bit floating-point data. The OpenEXR distribution has features that allow easy implementation of reading and writing this type of file, and it is considered a standard OpenEXR file.
Format Choose one of the following from the drop-down list:

- **Integer - 32 bpp** This non-standard OpenEXR format contains only a single 32-bit integer channel. It uses a packedIntRGBA image type in order to support old-style bit depths, such as 32-bit Targa files. Only this plug-in can read this format.

- **Half Float - 64 bpp** This 16-bit-per-channel “half-float” format is standard OpenEXR. Any software that supports OpenEXR can use this format.

- **Float - 128 bpp** The 32-bit-per-channel “full-float” format is encoded using standard OpenEXR channel tags. Most OpenEXR implementations will have no problems reading this format.

**R/G/B/Alpha** Let you specify the channels to save: red, green, blue, and alpha.

**Use RealPixel RGB Data** When on, compresses the essential data of floating-point color into 32 bits. For technical information, see the RealPixel Struct Reference topic in the 3ds Max SDK Help.

**NOTE** Image motion blur is not applied to the RealPixel RGBA data by the renderer. If you are using Image motion blur, you will not be able to save RealPixel unclamped color data.

**Exponent** Enables and sets the power function exponent to use. This is effectively a gamma curve, but the exponent is presented in an inverse manner from typical gamma. The default value is what exrdisplay expects for input.

**Pre-Multiply Alpha** When on, 3ds Max uses premultiplied alpha on page 8690 when saving the file. Pre-multiplying saves computation time if you later use this image in compositing.

---

**Plugin About** Opens a dialog that shows information about the OpenEXR plug-in.

**Extra Channels and Attributes** Opens a sub-dialog on page 7855 that lets you specify additional information to save with the OpenEXR image file.

**OK** Accepts any changes and closes the dialog.

**Cancel** Discards any changes and closes the dialog.
Extra Channels and Attributes

To specify an extra attribute or channel to be included in the saved OpenEXR file, click the corresponding + button and then choose the attribute or channel from the list. To delete an attribute or channel, highlight it in the list and then click the corresponding X button.

General Notes on Extended Attributes and Channels

Please note the following:

- You can view the extended information via the File Info button on page 7860 on the input dialog.

- A default File Tag string is provided when you add an attribute/channel. You can change the file tag by highlighting the entry in the list and then editing the File Tag field immediately below the list. You can also enable and disable the attribute/channel with the check box to the left of the File Tag field.

  NOTE Each saved attribute or channel must have a unique file tag. If you specify multiple instances of a file tag, only the first attribute or channel with that file tag is used.

- All the current attributes are String type attributes that are stored in the header for the file, and can be read in plain text via the exrheader.exe utility (available from the official Website > Downloads page).
Attributes and channels are stored in the file in alphabetical order according to the ASCII file tag.

While this plug-in can write most of the 3ds Max G-Buffer channels, there is no software that can utilize them yet.

Attributes and channels are identified by plain-text (ASCII) strings. There can be only one instance of a string tag in any file. Attributes are data that is stored per frame, not per pixel, and they are embedded in the file's header. Channels are data that is stored per pixel. In order to maximize flexibility with other software, this plug-in lets you edit the file tags. You should only do this if you know the tag required by some other software; otherwise it is best to leave the file tags at their default values.

Channels that create multiple “slices” in the EXR file require multiple file tags. In this case, the file tag in the user interface comprises several sub-tags denoted by square brackets. For example, the Normal channel generates three slices in the EXR file: one for the Normal vector x data, 1 for y, and 1 for z. In this instance, the tag string in the user interface would read [NX][NY][NZ], and generate slices with the file tags "NX", "NY", and "NZ". The file tag is used by software that is reading the EXR file to identify the intended use of the channel data. Even standard image channels are encoded this way, with the tags "R", "G", "B", and "A" used to denote red, green, blue, and alpha channels respectively.

Extended Attributes

Comment A general-purpose comment string defined by the user. To define the comment, highlight the Comment entry in the list and then edit the Comments field immediately below the list.

Computer Name The name of the computer the image was saved from. In the case of standard render output during a net render, this is the machine that rendered the frame.

System Time The UTC (GMT) system time and date when the file was written.

Local Time The local time and date (corrected for the time zone) when the file was written.

Version OpenExr The plug-in version, OpenEXR API version, and ZLib version in plain text form.

Version 3dsMax The release version of 3ds Max itself, the API number, and the SDK revision used when the build of 3ds Max was compiled. This also reports whether the file was generated using 3ds Max or Autodesk VIZ.
**Extended Channels**

**Z-Buffer** The standard buffer depth channel. (16-bit or 32-bit floating point)

**Object ID** The object ID from the Object Properties dialog on page 283. (32-bit unsigned integer)

**Material ID** The **material ID channel number** on page 5694. (32-bit unsigned integer)

**Node Render ID** A unique object ID set by the renderer. All objects in the scene have a unique Render ID, though the value stored varies from renderer to renderer. (32-bit unsigned integer)

**UV Coords** The UV coordinates for the object. Only one UV channel is stored. (two slices, 16-bit or 32-bit floating point)

**Velocity** The 2D velocity vector for the pixel in screen space. (two slices, 16-bit or 32-bit floating point)

**Normal** The surface normal. (three slices, 16-bit or 32-bit floating point)

**Coverage** The pixel coverage of the foremost object in the pixel. (32-bit unsigned integer, 16-bit floating point, or 32-bit floating point)

---

**Opening OpenEXR Files**

Any command that opens an image file, such as View Image File > Specify an EXR file. > Click Open. > OpenEXR Configuration dialog

This version of the OpenEXR Configuration dialog appears whenever you open an EXR file. It lets you specify various color transformations to be applied to the loaded image, designate the internal storage format to use, and preview the loaded image with the color transforms applied. There is also a histogram for viewing the brightness distribution in the image and adjusting the white and black points interactively.
Interface

To view the histogram, click the Preview button. The histogram displays a detailed bar graph of the distribution of brightness throughout the image. The horizontal axis of the histogram defines the luminance value, and the vertical axis indicates the percentage of the image covered by pixels of that brightness. Histogram features are:

- The histogram supports several display modes, which you can choose by right-clicking the histogram display window. The menu lets you choose between linear and logarithmic display, automatic or manual x-axis scaling, y-axis scale options, and which channel is graphed: luminance, red, green, or blue. The menu entries X-Axis Scale and Y-Axis Scale are simply labels, and are thus unavailable for choosing.

Histogram

To view the histogram, click the Preview button. The histogram displays a detailed bar graph of the distribution of brightness throughout the image. The horizontal axis of the histogram defines the luminance value, and the vertical axis indicates the percentage of the image covered by pixels of that brightness. Histogram features are:
■ The vertical scale slider on the left side of the histogram lets you adjust the automatically computed vertical scale.

■ To modify the luminance “window,” set X-Axis Scale to Manual and adjust the minimum and maximum values in the numeric fields below either end of the graph.

■ The background coloration indicates several pieces of information:
  ■ The area between the black and white points is shaded gray.
  ■ The area below 1.0 (low dynamic range) is a lighter shade of gray than the area with luminance greater than 1.0, the high dynamic range region.
  ■ The background of the region outside the currently selected blackpoint/whitepoint region is tinted pink.
  ■ The vertical dotted lines indicate integer spacing (for example, 1...2...3...4). To see these, the maximum luminance value must be greater than 1.0.

■ You can drag whitepoint/blackpoint markers in the histogram to place them visually. The hot-spot is two pixels to either side of the marker line. White point selection is tested first, so if the two lines are right next to each other, the white point will be selected.

■ You can set the display itself to linear or logarithmic mode. Logarithmic display remaps all values greater than 1.0 to a logarithmic curve. The dotted spacing indicators are supplemented by heavier dotted lines that indicate when the scale has changed by a factor of 10. This is useful for most HDR images, as the HDR data is usually spread out over a wide range.

■ Setting X-Axis Scale to Auto mode causes the histogram to encompass the entire spectrum of the image. If you switch back and forth, previous manually set values are preserved and restored.

File Loading Parameters group

Storage Buffer Format Specifies the format in which the image data is stored within 3ds Max. The base types are variations on 8-bits-per-channel and 16-bits-per-channel integer formats. There are two forms of each: one with alpha (RGBA) and one without alpha (RGB). If you are loading an image with
an alpha channel but don’t require the alpha data, choose the RGB version to save some memory. If you choose a storage type that supports alpha, but load an image without alpha, no memory is allocated for the alpha channel; the loader detects the situation and reverts to the alpha channel-free storage option with equivalent RGB bit depth.

The options supports the HDR bitmap storage options. This allows storage of the high-dynamic-range data within 3ds Max in three different HDR formats: 24- and 32-bit LogLUV formats and 32-bit RealPixel format. EXR files loaded using these storage modes are suitable for use as environment maps for reflections and skylight.

**Color Transform** Because EXR images often contain values brighter than “white,” it is often desirable to change the luminance range in the source image over which black to white occurs; that is, to remap the color data. When Color Transform is on, you can adjust these luminance and general brightness controls:

**Exponent** The exponent to apply when loading the file

**Black Point** Where black should be in the luminance range of the image

**White Point** The white point

**RGB Level** A standard multiplier for the RGB data

**RGB Offset** An additive offset for the RGB data

**Preview** The Preview window provides for interactive previewing of color-transform options for loading EXR files. After choosing an EXR file to open, click Preview to enable the preview window. The image file is loaded into the preview window, and from then on any changes to the Color Transform options update the thumbnail in real time. The preview window ignores the aspect ratio of the image to make the most of the small screen space available.

---

**Plugin About** Opens a dialog that shows information about the OpenEXR plug-in.

**File Info** Opens the File Information dialog on page 7861, which lets you view file statistics plus any attributes and channels stored in the file.

**OK** Accepts any changes, closes the dialog, and opens the image file.

**Cancel** Discards any changes and closes the dialog without loading the image file.
File Information dialog

This read-only dialog displays basic file statistics including date, time, size, and resolution, plus any attributes and channel information stored with the file. See Extra Channels and Attributes on page 7855.

<table>
<thead>
<tr>
<th>File Tag</th>
<th>Type</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>comment</td>
<td>string</td>
<td>rendered sphere</td>
</tr>
<tr>
<td>localTime</td>
<td>string</td>
<td>21d/7m/2005   15h:14m:37s</td>
</tr>
<tr>
<td>systemTime</td>
<td>string</td>
<td>21d/7m/2005   22h:14m:37s</td>
</tr>
</tbody>
</table>

Attribute List

PIC Files

3ds Max can import and export Radiance Picture (PIC) files. The PIC file is a lighting-analysis format used for the same purpose as LogLUV TIFF files on page 7880. The PIC format differs from the LogLUV TIFF format by creating
separate files for luminance on page 8625 and illuminance on page 8606 channel data (the LogLUV TIFF format creates one file containing both channels).

One way to create PIC files is with the Lighting Data Exporter utility on page 7234. You specify a file name by clicking the File Name button. When you click Export, the Lighting Data Exporter renders two files. The string “_Illuminance” is appended to the name of one file, and “_luminance” is appended to the other. For example, if you type house as the file name, the exporter renders to house_illuminance.pic and house_luminance.pic.

You can also open and save high-dynamic-range images in the PIC format using the Radiance Image File format in input and output file browsers in 3ds Max. For further information, see Radiance Image Files on page 7866.

See also:

- Radiosity Workflows on page 6627

PNG Files

PNG (Portable Network Graphics) is a still-image file format developed for use with the Internet and World Wide Web.

Interface

Clicking Render or Setup in the Render Output File dialog on page 6529 displays the PNG Configuration dialog.
Optimized palette (256) Choose to render a smaller, 8-bit color file.

RGB 24 bit (16.7 Million) Choose to render a true color (24-bit) file.

RGB 48 bit (281 Trillion) Choose to render a 48-bit color file.

Grayscale 8 bit (256) Choose to render a grayscale image with 256 shades.

Grayscale 16 bit (65,536) Choose to render a grayscale image with 65,536 shades.

Alpha Channel Turn on to save the alpha channel with the file.

Interlaced Turn on to make the file interlaced for faster display in Web browsers.

**PSD Files**

PSD is the file-name extension for graphics files native to Adobe Photoshop. This image format supports multiple layers of images superimposed to get the final image. Each layer can have any number of channels (R, G, B, Mask, and so on). It is a powerful file format because multiple layers can contribute to a variety of special effects.
Adobe provides many different modes of superimposing layers, including normal, darken, lighten, difference, multiply, screen, dissolve, hard light, hue, saturation, color, luminosity, overlay, and soft light.

You can use PSD files as bitmaps, viewport backgrounds, and so on. You can’t render to a PSD file.

3ds Max supports Photoshop 6.0 format, and allows you to use image layers as bitmaps, as well as the entire composited graphic.

Limitations

Bits Per Channel Photoshop supports images with 1, 8, and 16 bits per channel (1-, 24-, and 48-bit RGB images, respectively). 3ds Max supports PSD images with 8 or 16 bits per channel. (In practice, there are very few images with 1 bit per channel.) While Photoshop can load images with 16 bits per channel, layers are always 8 bits per channel.

Modes 3ds Max supports .psd files saved in the following modes:

■ RGB
■ Grayscale

3ds Max doesn’t support the following Photoshop modes:

■ Indexed Color
■ Bitmap
■ Duotone
■ CMYK Color
■ Lab Color
■ Multichannel

Non-Image Layers Layers other than image layers (for example, text layers) are not supported. In Photoshop, you can “rasterize” a non-image layer to make it an image.

Compositing Options Compositing options between image layers, which require processing by Photoshop, are not supported.
Interface

When you open a PSD file as a bitmap, a dialog appears that lets you choose how to use the image.

Collapsed Layers displays the entire image.

Collapsed Layers (The default.) Uses the entire composited image.

Individual Layer Uses a single layer of the image. When you choose this, the dialog shows a list of the layers, with a thumbnail of each, and the layer names. Click a layer to choose it, then click OK.
Individual Layer displays list of layers to choose from.

**Full Frame** When on, uses the entire layer as the bitmap. When off, uses only that portion of the layer occupied by image data. Default=on.

### Radiance Image Files

The Radiance image file format is used for high-dynamic-range images (HDRI). Most cameras don’t have the capability to capture the dynamic range (the gamut of luminances between dark and bright regions) that is present in the real world. However, the range can be recovered by taking a series of pictures.
of the same subject with different exposure settings, and combining them into one image file.

Radiance image files, also known as radiance map files, have an .hdr or a .pic extension (they’re both the same format). Each Radiance-format file contains all the data from all the pictures, so a wide luminance range is present, from bright, white highlights to the darkest black.

Radiance files are useful as backgrounds for compositing, and as reflection maps on composited objects. When using a Radiance image as a skylight, use the parameters in the Exposure group to control the brightness of the scene.

**IMPORTANT** When incorporating HDR images in your scene, it is highly recommended that, instead of the Radiance format, you use the OpenEXR format on page 7850. Its advantages include:

- Support for alpha (transparency) data, which other formats lack.
- The best image format for interoperating with Autodesk Toxik.
- Can be opened in Photoshop.

**TIP** To take best advantage of the HDR or PIC format, use the mental ray renderer with the Frame Buffer Type on page 6739 set to Floating-Point (32 bits per channel).

**NOTE** When you render with floating-point, 32-bit output, bright areas such as self-illumination or reflections of light sources might appear to be jagged. See Frame Buffer Type on page 6739 for more information.

**Procedures**

**To use a Radiance image as a background, or as a diffuse or reflection map:**

1. In the Material Editor, choose Bitmap as the map type.

2. On the Select Bitmap Image File dialog, under Files Of Type, choose Radiance Image File (HDRI). Open the Radiance file to use.

3. On the HDRI Load Settings dialog, look at the Measured Min/Max values to see the luminance range for the image.

4. Turn on Black Point.
5 Adjust the Black Point and White Point values until the red lines on the histogram encompass the majority of the graph, and the preview image is satisfactory.

**TIP** For the Internal Storage option, use the default choice of 16 bit/chan Linear (48bpp) unless you have a specific reason for doing otherwise.

6 When you have finished adjusting values, note the Linear White Point value, and click OK to accept the settings.

7 In the Material Editor, expand the Output rollout. Set the RGB Level to the same value as the Linear White Point value on the HDRI Load Settings dialog.

The result is a map with a wide range of deep blacks and very white highlights. If such an image is used as both a background in the rendering and a reflection map on an object, the object will appear to be extremely shiny and reflective.

**Interface**

**HDRI Load Settings dialog**

When you open a Radiance file as a bitmap, the HDR Load Settings dialog appears. This dialog allows you to specify the luminance range to use from the image, and the method for storing the data.
**Histogram** This graph shows the image's luminance values in a logarithmic scale. The red lines indicate the current Black Point and White Point values. The graph is visible only for luminance levels with substantial representation in the image. In other words, if a luminance level only applies to one or two pixels in the image, there will be no corresponding graph line on the histogram. Compare with Measured Min/Max, which gives the entire range of luminance levels in the image.

In general, the resulting image will have the most dramatic effect when the histogram is used to set the Black Point and White Point range values, rather than using the full range expressed by Measured Min/Max.
Exposure group

**Black Point** When this option is turned on, you can set the luminance value that you would like to be treated as the darkest color, or “black”. The value can be set as a logarithm (Log) or as a linear value (Linear). All values below this value will be clamped to black. When this option is turned off, the lowest possible value is used as the Black Point.

**Measured Min/Max** Displays the actual minimum and maximum luminance values in the image, expressed as both the logarithmic and linear values. Using these values for the Black Point and White Point will result in the image's full luminance range being used. However, the histogram might show that the majority of the luminance levels fall into a much smaller range.

**White Point** Sets the luminance value that you would like to be considered the brightest color, or “white”, either as a logarithm (Log) or linear value (Linear). All luminance values in the image that are above this value will be clamped to white. White pixel values inside HDR files can be much larger than a Linear value of 1.

The image's extended luminance range is used only when the White Point's Linear value is set above 1.0. In other words, setting White Point at or below a Linear value of 1.0 will not use any of the HDR image's special luminance properties, and will give results similar to other bitmap formats such as TIF and JPG.

**Log** Sets the Black Point or White Point as a logarithmic value ranging from −128 to 127. Changing this value changes the Linear parameter to the corresponding value.

**Linear** Sets the Black Point or White Point as a linear value ranging from 0 to over 1 trillion. Changing this value changes the Log parameter to the corresponding value.

---

**Preview window** Displays the selected HDR image.

**Internal Storage group**

**Real Pixels (32 bpp)** Compresses the luminance selections into a color space with 32 bits per pixel. Premultiplied Alpha and Motion Blur do not work with this option.
Def Exposure When on, the image will load as is without applying any changes to the colors. When off, you can use the parameters in the Exposure group to remap colors. Available only with the Real Pixels option.

16 bit/chan Linear (48 bpp) Compresses the luminance selections into 16-bit color space, at 48 bits per pixel. This is the recommended setting. To decompress the luminance for use in the scene, set the RGB Level on the image’s Output rollout on page 6192 to the same value as the linear white value on this dialog.

8 bit/chan Linear (24 bpp) Compresses the luminance selections into 8-bit color space, at 24 bits per pixel. This compression method uses less memory than other methods, but it is generally not adequate to display the range of luminance in a HDR image, and can result in banding or other artifacts.

Display scaled colors by When on, this value scales the preview image’s luminance value by the specified amount.

L Locks the preview luminance scale to the white linear value. When off, you can change the value manually. Default=on.

Mark White clamp Masks the white-clamped values in the preview window with the color indicated by the color swatch. Click the color swatch to change this color.

Mark Black clamp When Black Point is on, this option masks the black-clamped values in the preview window with the color indicated by the color swatch. Click the color swatch to change this color.

HDRI Save Settings dialog

3ds Max can render and save images with 32-bit floating-point channels. Among the useful applications for this type of imagery are:

■ Compositing: Using 16-bit images in a compositing pipeline can quickly become a problem as colors are manipulated. For example, banding may appear.

■ HDR images are not bound to a specific range (such as 0–255 or 0–65535); they have a dynamic range. As such, high-contrast and physically accurate values can be stored in 32-bit floating-point pixels.

■ Because of their large range of values, HDR images can easily be modified, and effects can be reapplied long after rendering, without affecting the
quality of the image. For example, changing the contrast/brightness/exposure of a 16-bit image could cause banding, which would require re-rendering the image. However, the same operation on an HDR image should not affect its quality.

Clicking Save or Setup in the Render Output File dialog on page 6529 displays the HDR Save Settings dialog.

![HDRI Save Settings Dialog]

The dialog lets you choose the source of the values used for output:

- Higher dynamic range and color precision than existing 8- and 10-bit image file formats.
- Support for 16-bit floating-point pixels. The pixel format, called "half," is compatible with the half data type in NVIDIA's Cg graphics language and is supported natively on their new GeForce FX and Quadro FX 3D graphics solutions.
- Multiple lossless image compression algorithms. Some of the included codecs can achieve 2:1 lossless compression ratios on images with film grain.
- Extensibility. New compression codecs and image types can easily be added by extending the C++ classes included in the OpenEXR software distribution. New image attributes (strings, vectors, integers, and so on) can be added to OpenEXR image headers without affecting backward compatibility with existing OpenEXR applications.
RLA Files

The RLA format is a popular SGI format that supports the ability to include arbitrary image channels. While setting up a file for output, if you select RLA Image File from the list and click the Setup button, you'll go to the RLA setup dialog. Once there, you can specify what channels (and what format) you want to write out to the file.

See also:

■ RPF Files on page 7875

Interface

When RLA is the chosen output format, clicking Render or Setup on the Render Output File dialog on page 6529 displays the RLA Image File Format dialog.

Standard Channels group

The standard channels are RGB color and the alpha (transparency) channel.

Bits per Channel Choose 8, 16, or 32 Floating Point as the number of bits per channel. Default=8.

Store Alpha Channel Choose whether to save the alpha channel. Default=on.

Premultiply Alpha When on, premultiplies the alpha channel. Default=on. Premultiplying saves computation time if you later use this image in compositing. For more information, see Premultiplied Alpha on page 8690.
Optional Channels group

For output RLA files, there are eight additional channels that you can generate (and view in the Rendered Frame Window):

**Z Depth** Displays Z-Buffer information in repeating gradients from white to black. The gradients indicate relative depth of the object in the scene.

**Material ID** Displays the Effects channel used by materials assigned to objects in the scene. The Effects channel is a material property set in the Material Editor and used during Video Post compositing. Each Effects Channel ID is displayed using a different random color.

**Object ID** Displays the **G-Buffer** on page 8589 Object Channel ID assigned to objects using the Object Properties dialog. The G-Buffer ID is used during Video Post compositing. Each G-Buffer ID is displayed using a different random color.

**UV Coordinates** Displays the range of UV mapping coordinates as a color gradient. This channel shows where mapping seams might occur.

---

**NOTE** UV Coordinates will not be displayed on objects that have the UVW Map Modifier applied unless a map has been applied that uses the coordinates.

**Normal** Displays the orientation of normal vectors as a grayscale gradient. Light gray surfaces have normals pointing toward the view. Dark gray surfaces have normals pointing away from the view.

**Non-Clamped Color** Displays areas in the image where colors exceeded the valid color range and were corrected. The areas appear as bright saturated colors usually around specular highlights.

**Coverage** This saves the coverage of the surface fragment from which other G-buffer values (Z Depth, Normal, and so on) are obtained. Z-Coverage values range from 0 to 255. To see Z Coverage, render to an RLA file after first checking Z Coverage in the Setup subdialog, then choose Z-Coverage in the Rendered Frame Window’s Viewing Channel drop-down list.

The Z-Coverage feature is provided primarily for developers, and should aid in the antialiasing of Z-buffers.

Descriptive Information group

This information is saved with the file.

**Description** You can enter descriptive text here.

**Author** You can enter your name here.
RPF Files

RPF (Rich Pixel Format) is the format that supports the ability to include arbitrary image channels. While setting up a file for output, if you select RPF Image File from the list, you'll go to the RPF setup dialog. Once there, you can specify what channels you want to write out to the file.

RPF files replace RLA files as the format of choice for rendering animations requiring further post-production or effects work. Many channels available in RPF files are exclusive to this format.

TIP When you create a scene you plan to render as an RPF file for use with the Autodesk Combustion™ product, turn on Render Occluded Objects (on the Object Properties dialog on page 283) for objects in the scene. This is important if you want to use the Combustion G-Buffer Extract feature. When Render Occluded Objects is enabled and you extract an object in Combustion, the objects behind it are drawn correctly. If Render Occluded Objects is disabled (the default), objects behind the extracted object appear with black holes where they were occluded.

Interface

When RPF is the chosen output format, clicking Render or Setup on the Render Output File dialog on page 6529 displays the RPF Image File Format dialog.

Standard Channels group

The standard channels are RGB color and the alpha (transparency) channel.

Bits per Channel Choose 8, 16, or 32 Floating Point as the number of bits per channel. Default=8.
**Store Alpha Channel** Choose whether to save the alpha channel. Default=on.

**Premultiply Alpha** When on, premultiplies the alpha channel. Default=on. Premultiplying saves computation time if you later use this image in compositing. See *Premultiplied Alpha* on page 8690 for more information.

**Optional Channels group**

For output RPF files, there are additional channels that you can generate (and view in the Rendered Frame Window):

**Z Depth** Saves Z-Buffer information in repeating gradients from white to black. The gradients indicate relative depth of the object in the scene.

**Material ID** Displays the Effects channel used by materials assigned to objects in the scene. The Effects channel is a material property set in the Material Editor and used during Video Post compositing. Each Effects Channel ID is displayed using a different random color.

**Object ID** Displays the G-Buffer on page 8589 Object Channel ID assigned to objects using the Object Properties dialog. The G-Buffer ID is used during Video Post compositing. Each G-Buffer ID is displayed using a different random color.

**UV Coordinates** Saves the range of UV mapping coordinates as a color gradient. This channel shows where mapping seams might occur.

**NOTE** UV Coordinates will not be displayed on objects that have the UVW Map Modifier applied unless a map has been applied that uses the coordinates.

**Normal** Saves the orientation of normal vectors as a grayscale gradient. Light gray surfaces have normals pointing toward the view. Dark gray surfaces have normals pointing away from the view.

**Non-Clamped Color** Saves areas in the image where colors exceeded the valid color range and were corrected. The areas appear as bright saturated colors usually around specular highlights.

**Coverage** Saves the coverage of the surface fragment from which other G-buffer values (Z Depth, Normal, and so on) are obtained. Z-Coverage values range from 0 to 255. To see Z Coverage, render to an RLA file after first checking Z Coverage in the Setup subdialog, then choose Z-Coverage in the Rendered Frame Window’s Viewing Channel drop-down list. The Z-Coverage feature is provided primarily for developers, and should aid in the antialiasing of Z-buffers.
Node Render ID Saves each object as a solid color according to its G-Buffer Object channel (found under Object Properties).

Color Saves the color returned by the material shader for the fragment. This channel displays any transparent fragment as a solid color.

Transparency Saves transparency returned by the material shader for the fragment. Any fragment with any degree of transparency will be rendered as a solid gray object.

Velocity Saves the velocity vector of the fragment relative to the screen in screen coordinates.

Sub-Pixel weight Saves the sub-pixel weight of a fragment. The channel contains the fractions of the total pixel color contributed by the fragment. The sum of all the fragments gives the final pixel color. The weight for a given fragment takes into account the coverage of the fragment and the transparency of any fragments that are in front of a given fragment.

Sub-Pixel Mask Saves the sub-pixel alpha mask. This channel provides a mask of 16 bits (4x4) per pixel, used in antialiased alpha compositing. This mask is especially useful with the Combustion compositing product.

Descriptive Information group

This information is saved with the file.

Description You can enter descriptive text here.

Author You can enter your name here.

RGB (SGI Image) Files

The SGI™ Image File format is a bitmap file type created by Silicon Graphics®. SGI Image File support in 3ds Max lets you load and save files in both 8- and 16-bit color depth, with alpha channels, and RLE Compression.

Interface

Clicking Render or Setup in the Render Output File dialog on page 6529 displays the RGB Image File Format dialog.
Channel Bit Depth group

8 Bit Saves the RGB file as 8-bit color.

16 Bit Saves the RGB file as 16-bit color.

Use Alpha toggle

Use Alpha Saves Alpha channels with the RGB file.

TGA (Targa) Files

The Targa (TGA) format was developed by Truevision for their video boards. The format supports 32-bit true color; that is, 24-bit color plus an alpha channel, and is typically used as a true color format.

Targa files are widely used to render still images and to render sequences of still images to video tape.

Some Targa files created by other applications have different file-name extensions. 3ds Max can render the .vda, .icb, and .vst variants as well as .tga.

Interface

Clicking Render or Setup in the Render Output File dialog on page 6529 displays the Targa Image Control dialog.
When you render to a Targa file, you have the following options:

**Image Attributes group**

**Bits-Per-Pixel** Choose the color depth: 16-bit, 24-bit, or 32-bit.

**Compress** Applies lossless compression to the file.

**Alpha Split** Creates a separate file for the alpha channel. The file name created for the alpha-channel file starts with a_ and then appends the full file name. For example, if you check this box and render the file greek004.tga, 3ds Max creates the file a_greek004.tga for the alpha channel. (Sometimes the name will be longer than 8 characters.)

**Pre-Multiplied Alpha** When on, pre-multiplies the alpha channel. Pre-multiplying saves computation time if you later use this image in compositing. See Premultiplied Alpha on page 8690.

**Additional Information group**

**Author Name, Job Name/ID, Comments** These fields are available for you to add information about the file.
NOTE To control whether or not the renderer uses the environment map’s alpha channel in creating the alpha for the rendered image, choose Customize > Preferences > Rendering, and then turn on Use Environment Alpha in the Background Antialiasing group.

If Use Environment Alpha is turned off (the default) the background receives an alpha of 0 (completely transparent). If Use Environment Alpha is turned on, the alpha of the resulting image is a combination of the scene and background image's alpha. Also, when writing TGA files with Pre-Multiplied Alpha set to off, turning on Use Environment Alpha prevents incorrect results. Note that only background images with alpha channels or black backgrounds are supported when compositing in other programs such as Photoshop.

**TIFF Files**

TIFF (Tagged Image File Format) is a multiplatform bitmap format originating on the Macintosh® and in desktop-publishing applications. TIFF is a common choice if you plan to send your output to a print service bureau or import the image into a page-layout program.

There are several classes of TIFF files, each varying in the color depth and color palette that they support.

You can render TIFF files with alpha, luminance on page 8625, and UV color coordinate information, which describes illuminance on page 8606. You also have the option to render a compressed image. Luminance and illuminance data are rendered by the Lighting Data Exporter utility on page 7234.

**Interface**

To open the TIF Image Control dialog, click Save or Setup on the Render Output File dialog on page 6529.
When you render to a TIFF file, you have the following options:

**Monochrome** Creates an 8-bit grayscale image.

**Color** Creates a 24-bit color image (no alpha channel).

**Image Type group**

Lets you choose the method for saving image information:

- **8-bit Greyscale** Creates an 8-bit grayscale image.
- **8-bit Color** Creates an 8-bit color image.
- **16-bit Color** Creates a 16-bit color image.
- **16-bit SGI LogL** Creates a color image that includes a logarithmic encoding of the luminance channel.
- **32-bit SGI LogLUV** Creates a color image that includes a logarithmic encoding of the luminance channel and UV color coordinate information.

**Store Alpha Channel** When on, stores the alpha channel along with other image data. Alpha data adds 8 bits per pixel to the image type you selected.

**Compression Type group**

Lets you render a compressed TIFF file. Default=No Compression.

- **No Compression** Does not compress the rendered image.
- **Packbits** Uses the TIFF Packbits algorithm to compress the file.
**Dots Per Inch** Sets the dots per inch (dpi) for the saved image. This setting does not change the resolution of the final image, but can affect the way it prints in documents.

**YUV Files**

YUV files are still-image graphics files in the Abekas Digital Disk format. YUV is supported only as an input file format. You can use YUV files as general-purpose bitmaps, but you can’t render to a YUV file.

**RAM Player**

Rendering menu > RAM Player

The RAM Player loads a frame sequence into RAM and plays it back at selected frame rates. The RAM Player has a channel A and a channel B. Two different sequences can be loaded into the channels to play back together, giving you the ability to compare them.

Clicking and dragging in the channel display window allows you to set the A/B divider between the two channels. The right mouse button “scrubs” the animation through all of its frames. Hold the right mouse button and move the mouse left to move the animation back to the first frame. Move the mouse right to advance the animation to its end.

For best RAM Player performance, Gamma should not be enabled in Customize > Preferences > Gamma.
Interface

Channel A/B

Open Channel Displays an Open File dialog that lets you select a file to load into the channel. After you have selected a file, the RAM Player Configuration dialog on page 7886 appears that allows you to set height, width, and memory usage for that channel.

Open Last Rendered Image Loads the last rendered image into the channel. Nothing is displayed if there is no last rendered image available.

Close Channel Unloads the image in the channel and frees up your memory.

Save Channel Displays a Save File dialog that lets you save the animation or image from the respective channel. You can save the animation as a .avi file or a numbered sequence of images.

NOTE The RAM Players converts everything it loads into 24-bit RGB which means that some information may be lost when it is loaded. This may affect a file saved in the RAM Player.
**Channel A** When selected, this button will show the file loaded into channel A. Split screen markers are displayed if both channels are enabled. The split screen markers are represented by two triangles. These markers indicate where channel A ends and channel B begins. You can move the divider using the left mouse button.

**Channel B** When selected, this button will show the file loaded into channel B. Split screen markers are displayed if both channels are enabled. The split screen markers are represented by two triangles. These markers indicate where channel A ends and channel B begins. You can move the divider using the left mouse button.

**Horizontal/Vertical Split Screen** Toggles between the view of the two channels side-by-side or one on top of the other.

**Frame Controls**

**First Frame** Automatically returns the RAM Player to the first frame of the animation. If the RAM Player is at the first frame, First Frame returns the animation to the last frame.

**Previous Frame** Backs up the RAM Player to the previous frame in the animation. If the RAM Player is at the last frame, Previous Frame returns the animation to the first frame.

**Playback Reverse** Plays the frames in the animation in reverse order. The flyout contains an option to play the animation once and then stop.

**Playback Forward** Plays the frames in the animation in rendered order. The flyout contains an option to play the animation once and then stop.
Next Frame Advances the RAM Player to the next frame in the animation.

Last Frame Automatically places the RAM Player at the last frame of the animation.

Frame Rate Control Sets the desired frame rate in frames per second. When playing back a movie, you see the frame rate displayed in the title bar of the RAM Player. You can select a predefined frame rate or type in your own frame rate value.

Color Selector Ctrl+right-clicking the mouse in the display window displays the color of the pixel in the color selector swatch. Stop the animation to get a correct pixel reading. The RGB of the pixel is also displayed in the title bar of the RAM player.

Double Buffer Selecting Double Buffer ensures that the two frames in channels A and B are synchronized. Enabling this function has a substantial impact on the maximum frame rate.

RAM Player Keyboard Shortcuts

The following keyboard shortcuts are available for the RAM Player.

<table>
<thead>
<tr>
<th>RAM Player Function</th>
<th>Keyboard Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Go To Start Frame</td>
<td>Home</td>
</tr>
<tr>
<td>Go To End Frame</td>
<td>End</td>
</tr>
<tr>
<td>Go To Previous Frame</td>
<td>Left Arrow</td>
</tr>
<tr>
<td>Go To Next Frame</td>
<td>Right Arrow</td>
</tr>
<tr>
<td>Playback Reverse</td>
<td>Up Arrow</td>
</tr>
<tr>
<td>Playback Forward</td>
<td>Down Arrow</td>
</tr>
</tbody>
</table>
### RAM Player Function

<table>
<thead>
<tr>
<th>Function</th>
<th>Keyboard Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stop Playback</td>
<td>Esc or Ctrl+C</td>
</tr>
<tr>
<td>Toggle Playback or Stop</td>
<td>Spacebar</td>
</tr>
<tr>
<td>Toggle Channel A On/Off</td>
<td>A</td>
</tr>
<tr>
<td>Toggle Channel B On/Off</td>
<td>B</td>
</tr>
<tr>
<td>Open File in Channel A</td>
<td>Ctrl+A</td>
</tr>
<tr>
<td>Open File in Channel B</td>
<td>Ctrl+B</td>
</tr>
<tr>
<td>Open Last Rendered Image in Channel A</td>
<td>Alt+A</td>
</tr>
<tr>
<td>Open Last Rendered Image in Channel B</td>
<td>Alt+B</td>
</tr>
<tr>
<td>Scrub Animation</td>
<td>Ctrl+left mouse button or right mouse button</td>
</tr>
</tbody>
</table>

### RAM Player Configuration Dialog

Rendering menu > RAM Player > Load a file into either channel. > RAM Player Configuration dialog

The RAM Player Configuration dialog contains controls for resolution, frames, memory usage, and alpha channel for playing back animations.
Interface

Resolution group

Width Defines the width at which the file is loaded.

Height Defines the height at which the file is loaded.

Lock Aspect Ratio When turned on, Lock Aspect Ratio forces the file to load at the same aspect ratio, regardless of the Width and Height values you enter. If you change the Width of the file, the Height adjusts according to the file's original aspect ratio. Adjusting the Height does the same to the Width value.

Filter Input When turned on, Filter Input filters the image or animation so that it best maintains the quality of the original file. When turned off, filtering does not occur, and the image or animation could be distorted.

Frames group

Start Frame Specifies a certain frame in an animation where you want the RAM Player to begin loading. A value of 1 would start the animation at its rendered beginning. A value of 5 would start the animation on frame five and any frame before that would not be loaded.
**Num Frames** Specifies the total number of frames to be loaded into the RAM Player.

**Memory Usage group**

**Maximum** Lets you configure the maximum amount of memory to use for the RAM player. This value includes both channels.

**Alpha group**

**Load Into Other Channels** When turned on, this option loads a grayscale alpha channel into the other channel. This allows you to wipe between an RGB channel of the animation and the alpha channel of the animation.

**Scene Explorer**

Menu bar > Tools > New Scene Explorer

Menu bar > Tools > Open Explorer: [name of most recently used explorer]

Menu bar > Tools > Saved Scene Explorers > Choose a saved scene explorer.

Scene Explorer provides a modeless dialog for viewing, sorting, filtering, and selecting objects in 3ds Max, as well as additional functionality for renaming, deleting, hiding, and freezing objects, creating and modifying object hierarchies, and editing object properties en masse.

When working on a new scene, you open the Scene Explorer dialog with the Tools menu > New Scene Explorer command. Each subsequent invocation of this command opens a separate, additional Scene Explorer dialog. All Scene Explorers persist in the scene, even if closed. You can open the most recently used Scene Explorer with the Tools menu > Open Explorer command, or any Scene Explorer with the Tools menu > Saved Explorer submenu.

**TIP** In a new scene, the keyboard shortcut Alt+Ctrl+O (letter O) creates a new Scene Explorer. But when one or more Scene Explorers exist in the scene, the same shortcut opens the most recently used Explorer.

All active Scene Explorers are saved and loaded with the scene. To save and load Scene Explorers separately, and delete and rename them, use the Manage Scene Explorer dialog on page 7908.

The Scene Explorer interface consists of a menu bar, toolbars, and a table view of objects in the scene, with a row for each object and a column for each
displayed object property. The default layout displays only object names. You can customize the layout to show additional properties. You can save customized Scene Explorer setups, and set any custom setup to be the default view.
Chapter 21  Managing Scenes and Projects
Scene Explorer Features

Following are some of the notable features of Scene Explorer:

- Customize the dialog by setting any configuration of columns, hidden and displayed categories, and so on.
- Open as many separate instances of the dialog as you like, each with a different configuration.
- Synchronize selection between Scene Explorer and the scene.
- Save and load different configurations.
- Set any configuration as the default.
- Scene Explorer setup is saved with your MAX scene file.
- Use scripting to create custom columns such as an editable Radius field on page 7894.
- Create and edit object hierarchies by dragging and dropping.
- Sort on single or multiple columns.
- Change object settings singly or en masse.
- Powerful, sophisticated search and filtration features.

Using Scene Explorer

This topic includes procedures for using general functionality in the Scene Explorer window on page 7888. You can find additional procedures for specific Scene Explorer features in Scene Explorer Columns on page 7896, Advanced Search Dialog on page 7909, and Advanced Filter Dialog on page 7912.

To highlight objects in Scene Explorer:

- Optionally, set the object-type filters to show only object types you’re interested in. These filter buttons are on the left-hand toolbar by default. They are also available from the menu choice Display > Object Types.

- Next, do any of the following:
- Click in the Find field, if necessary, and then, on the keyboard, enter enough characters to distinguish the object or objects you want to select from the rest. For example, if the scene contains several spheres
and several boxes, you can highlight all the spheres simply by typing S (assuming the spheres still have their default names).

**TIP** The Scene Explorer dialog always opens with the keyboard focus in the Find field, so in general you don’t need to click the field before entering a search phrase.

- **Use the mouse:**
  - To highlight a single item, click its name.
  - To highlight multiple contiguous list entries, drag vertically in any column. Alternatively, click the first item and then Shift+click the last.
  - To highlight noncontiguous items, hold down the Ctrl key as you click. To remove highlighting from an item, Ctrl+click it.
  - On the upper toolbar, click Select All, Select None, or (after making a selection), Select Invert.

- **If any named selection sets** on page 217 exist, choose one from the Selection Set drop-down list on the upper toolbar.

- **Use the Advanced Search function** on page 7909: From the Scene Explorer > Select Menu, choose Search, set any number of Boolean search terms, and then click Select.

---

**To edit properties for multiple objects:**

1. Highlight several objects, as described in the preceding procedure.

2. Change a property for any of the highlighted objects. For example, turn on Hidden, or change an object name. All highlighted objects receive the changed value or property.

**TIP** You can toggle an on/off-type property, such as Hidden, by clicking anywhere in the cell, not just in the check box.

**NOTE** Clicking a highlighted item’s row doesn’t remove highlighting from other highlighted rows.
To synchronize selection between the scene and Scene Explorer:

Do any of the following:

■ Make a selection in Scene Explorer, and then right-click a selected item in the list and choose Select In Scene.

■ On the Scene Explorer > Select menu, turn on Sync Selection. When this is on, selecting an object in the viewport highlights it in Scene Explorer and vice versa.

■ Make a selection in the viewport, and then right-click any cell in Scene Explorer and choose Pull Selection from Scene.

To delete objects from the scene:

■ Highlight one or more items in Scene Explorer, and then right-click a highlighted item in the list and choose Delete From Scene. The objects are deleted from Scene Explorer and the scene.

TIP To undo such a deletion with the keyboard shortcut Ctrl+Z, first change the focus from Scene Explorer to the main application by activating a viewport or clicking an empty part of the Caption bar or the command panel.

To edit hierarchies with Scene Explorer:

■ To link one object to another (child to parent), drag an object’s icon (to the left of its name) to another object. The first object will become a child of the second object. When a yellow arrow appears to the left of the target object, release the mouse button.

■ To unlink a child object from its parent, drag the object’s icon to the Scene Root node at the top of the list.

To remove a column from the table:

1 Drag the column heading downward until the mouse cursor changes to an X icon.

2 Release the mouse button.
To edit multiple items:

1. Make sure the value or values you want to change are exposed in the Scene Explorer interface. If not, add them with the Column Chooser on page 5748.
2. Highlight multiple list entries.
3. Change a value for one of the entries.
   Scene Explorer sets the same value for all of the highlighted entries.

To rename an object:

This method applies to editing any text field, such as the custom Radius field demonstrated in the next procedure.

1. Select the object in the list by clicking its name (or the field you want to edit). Alternatively, select multiple list entries. The editing is applied to all highlighted entries.
   The last item you highlighted explicitly has a yellow background; any others have blue backgrounds.
2. Do any of the following:
   ■ Press F2.
      This highlights the name of the item with the yellow background.
   ■ Click the entry with the yellow background.
      This highlights the object name and places a blinking insert cursor at its start.
3. Edit the name using the keyboard and, optionally, the mouse. To replace the name, just type. To change part of it, click where you want to edit, or drag over part of the name. After doing so, you can move the cursor with the arrow keys.
4. When finished, press Enter or Tab, or click a different part of the dialog.
   If you rename several items, the items other than the one you edited explicitly take on numbered versions of the name (for example, door01, door02, etc.)

Example: To customize Scene Explorer:

With some knowledge of MAXScript, you can add custom fields to Scene Explorer that lets you view and edit object properties of your choice. In this
example, you'll add an editable Radius column that applies to object primitives such as Sphere, Cylinder, and Teapot.

1. Open a text editor and enter the following (you can copy and paste this listing):

```
showinterface sceneexplorermanager
function getter node=(return getuserprop node "user")
function setter node value=(setuserprop node "user" value)
sceneexplorermanager.addproperty "User" getter setter
function getrad node=(if isProperty node "radius" then return node.radius)
function setrad node value=(if isProperty node "radius" then
  node.radius=value as float)
sceneexplorermanager.addproperty "Radius" getrad setrad
```

2. Save the file in text format in the Scripts folder in your program installation. Use the file name `radius.ms`.

3. In 3ds Max, create some teapots and spheres.

4. From the MAXScript menu, choose Run Script, and then find and highlight the script file from step 2 and open it.
   This adds a new item to the Configure Columns list.

5. Open a new Scene Explorer window, right-click a column heading, and choose Configure Columns.

6. Scroll down to the bottom of the Configure Columns dialog, and then drag the Radius item to one of the current column headings.
   The new Radius column shows and lets you edit the Radius values for the teapots and spheres. You can now, for example, highlight several of the objects by dragging in the Radius column, press F2 to edit the first item you clicked on, and enter a new value; this sets all highlighted items to the new Radius value.

Using groups with Scene Explorer

- By default, `group` on page 258 members do not appear in the Scene Explorer list. To show group members, `open` on page 260 the group. When the group is closed, only the group itself appears in the list.

   TIP You can open a group directly in Scene Explorer by right-clicking the group entry, then choosing Groups > Open Group.
Scene Explorer does not support grouping functionality by dragging and dropping items. However, with the right-click menu > Groups submenu commands, you can group items, open, close, and ungroup groups, and detach (exclude) group members.

Scene Explorer Columns

The Scene Explorer columns provide information on and means to edit various properties of scene contents in 3ds Max. These include text strings, check boxes, numeric quantities, and more. You can also sort the Scene Explorer listing by clicking a column heading (a second click reverses the sort). Additional methods for using columns are available; see the Procedures section that follows.

Procedures

To add columns to the table:

1. Do either of the following:
   - Right-click a column heading and then choose Configure Columns from the context menu.
   - From the Customize menu, choose Column Chooser. This opens the Column Chooser dialog.

2. Drag a column heading from the Chooser dialog to one of the Scene Explorer column headings.

   The new column is inserted to the left of the existing column.
3 Continue adding columns as desired. When finished, close the Column Chooser.

**To replace a column in the table:**

1 Right-click a column heading and then move the mouse cursor to Replace Column.
   This opens a list of available column headings.

2 Choose a heading to replace the current one.
   The heading is replaced.

**To remove a column from the table:**

1 Drag the column label downward until the mouse cursor changes to an X icon.

2 Release the mouse button.

**NOTE** Even if you remove the Name column, the hierarchy remains at the left side of the window. You can’t remove the Name column if it is the only column in the table.

**To sort the list based on a column or columns:**

1 Click a column heading.
   This performs a single-level sort based on the column contents, in ascending order, as indicated by up arrow on the right side of the heading.
   For example, clicking the Name column sorts the table in ASCII order, starting with punctuation, then numbers, then letters.

   **NOTE** Object hierarchies remain together when the list is sorted. Child objects at the same level are sorted only with respect to one another, not objects on other hierarchical levels.

2 To reverse the sort order, click the same column heading again.
   Alternatively, right-click a column heading and choose Sort Ascending or Sort Descending. You can sort any number of different columns this way to perform a multi-level sort. For example, you could sort by type, and then, within that sort, by whether the objects are hidden.
To rearrange columns:
- Drag a column heading on top of another one. This moves the column to the left of the target column.

To resize a column:
- Drag the divider on the right side of the column heading.
  Alternatively, to auto-resize a column, double-click the divider on the right side of the heading.

Interface

This section lists the available columns, briefly describes each column's function, and notes whether the column appears by default in Scene Explorer.

Name The name on page 8182 of the object. Default column.

Type The type of object, such as Geometry, Shape, Light, and so on.

Color The wireframe color on page 8182 of the object. To change the color, click the color swatch; this opens the Color Selector dialog on page 371.

Faces The number of faces in the object. By default, this is the number of triangular faces, but with polygon-type objects such as editable poly, it's the number of polygons. For example, the default box primitive has 12 faces, but if you convert it to editable poly, the Faces column value changes to 6. Other modifiers can also change this value.

Hidden Shows whether the object is hidden (quad menu, Display panel, or Display floater). The names of hidden objects display as italics.

Frozen Shows whether the object is frozen (quad menu, Display panel, or Display floater). The names of frozen objects display as gray text.

See-Through Shows whether the object is see-through (Object Properties).

Display as Box Shows whether the object has box display (Object Properties).

Cull Back Faces Shows whether the object has culled backfaces (Object Properties).
Edges Only Shows whether the object is set to display only edges (Object Properties).

VertexTicks Shows whether the object displays vertex ticks (Object Properties).

Trajectory Shows whether the object has trajectory display (Object Properties).

Ignore Extents Shows whether the object’s extents are ignored when zooming (Object Properties).

Show Frozen in Gray Shows whether the object is shown as gray when it is frozen (Object Properties).

Display Vertex Channel Shows whether vertex channel display is active for editable mesh, poly, and patch objects (Object Properties).

Viewport Lighting Shows whether viewport lighting and shading is active for the object (quad menu).

Viewport Locked Lighting For a light, shows whether viewport lighting is locked (quad menu).

Viewport Shadows For a light, shows whether viewport shadows are active (quad menu).

Light Color Shows the color that a light casts (Modify panel).

Light Intensity For a light, shows the intensity (Multiplier) value (Modify panel).

Light On Shows whether the light is turned on (Modify panel)

Shadow On Shows whether the light casts shadows (Modify panel).

Shadow Type Shows the type of the shadow.

Light Map Bias For shadows, shows the value of the shadow bias on page 8718 setting that adjusts the shadow position.

Shadow Sample Range For shadow-mapped shadows, shows the sample range on page 8704 setting.

Has Material Shows whether the object has a material (Material Editor).

Revit Category If the object is imported from Revit, shows its user-defined Category tag.

Revit Family If the object is imported from Revit, shows its user-defined Family tag.
**Revit Level** If the object is imported from Revit, shows its user-defined Level tag.

**Revit Type** If the object is imported from Revit, shows its user-defined Type tag.

**Application Origin** If the object is imported from an application other than 3ds Max, shows the originating application.

**Inherited?** For a Container on page 7395, shows whether the contents are inherited.

**Loaded?** For a Container on page 7395, shows whether its contents are currently loaded in the scene.

**Local Definition** For a Container on page 7395, shows whether its definition is local on page 8620 to the scene.

**Open?** For a Container on page 7395, shows whether it is currently open. If the container is a Source Container on page 8725 that does not allow you to edit it, this field shows a check mark but is disabled.

**Container Override** For a Container on page 7395, shows whether Override Object Properties on page 7431 has been turned on.

**Source Definition** For a Source Container on page 8725, shows the path and file name of the source.

**Source Rules** For a Source Container on page 8725, shows the rules provided with the Source Container.

**Scene Explorer Menus**

Scene Explorer on page 7888 > Menu bar

The principal Scene Explorer menus are available on the dialog menu bar. In addition, several context menus are available by right-clicking different user-interface elements on the dialog.
**Select menu**

**Select All** Highlights all objects in the list.

**Select None** Removes highlighting from all objects in the list.

**NOTE** One entry in the Scene Explorer table remains highlighted after you choose Select None, but no objects are selected in the scene.

**Select Invert** Highlights objects that weren’t highlighted and vice-versa.

**Select Children** When on, highlighting a parent object also highlights its children.

**Select Influences** When on and you highlight an object with influences on page 8609, the influencing objects also highlight. Choosing this command turns off Select Dependents, if on.

**Select Dependents** When on and you highlight an object that influences another, the object’s dependents on page 8549 also highlight. Choosing this command turns off Select Influences, if on.

**Find Case Sensitive** When on, searching with the Find field results in only exact matches with the case in the search phrase.

**Find Using Wildcards** When on, searching with the Find field lets you use standard wildcards: ? stands in for a single character, while * stands in for multiple characters. For example, if you have objects named Set11, Set21, Set31, and Set34, using the search phrase “Set?1” with Find Using Wildcards on will highlight the first three but not the fourth. Searching for “Set*” will highlight all four.

**Find Using Regular Expressions** When on, you can use in the Find field. For example, to highlight all items that do not start with upper-case “A”, turn on Find Case Sensitive and Find Using Regular Expressions, and use this search term: [^A]. Or to highlight all items that start with “sph” and end with “1”, turn on Find Using Regular Expressions, and use this search term: sph.*1. Similarly, to find all light targets, use .*Target.
Sync Selection  When on, selecting an object in the viewport highlights it in Scene Explorer and vice-versa.

NOTE  When Sync Selection is on, if multiple objects are selected they appear as highlighted entries in Scene Explorer. If you click one of these highlighted entries in Scene Explorer, that object remains selected, but the others are deselected.

Search  Opens the Advanced Search dialog on page 7909, which lets you set up and use complex Boolean search terms.

Display menu

Object Types  Choices on this menu correspond to the object-type buttons that by default are displayed in the left-hand toolbar of the Scene Explorer. See Left-hand (Display) toolbar on page 7905.

Display Children  When chosen, displays linked objects as parent-child hierarchies, with the children as expandable branches below their parent objects. When not chosen (the default), lists all objects in the specified sort order with no regard to hierarchies.

Display Influences  When chosen and you highlight an object with influences on page 8609, contents of any text-based fields of the influential objects appear in blue. Default = Not chosen.

Configure Advanced Filter  Opens the Advanced Filter dialog on page 7912, which lets you set up and use complex Boolean filter terms.

Enable Advanced Filter  Activates the filter specified with the Advanced Filter dialog on page 7912.

Filter Selection Set  When chosen, the table shows only the currently selected selection set. Default=off.
These choices control the hierarchy display.

- **Collapse All** Collapses the entire hierarchy.
- **Collapse Selected** Collapses the hierarchy of selected entries.
- **Expand All** Expands the hierarchy to display all entries.
- **Expand Selected** Expands the hierarchy of selected entries.

**Display in Track View** Choose this to open a Track View window on page 3790. If an object in the selection has an animated track, Track View displays the object in the Controller window; otherwise, when 3ds Max opens Track View, the Controller window is empty.

**Display Dependencies** When chosen, the name of an object and any object dependent on the selected object (that is, instances and references) are shown in bold in the Name column when the Modify panel is active. Default = Not chosen.

The Modify panel must be active and you must have turned on Views > Show Dependencies. Otherwise, choosing Display Dependencies has no effect.

**Edit menu**

These choices let you cut, copy, and paste objects.

- **Cut Nodes** Cuts the currently selected objects from the scene and places their data on a clipboard.
- **Copy Nodes** Copies the currently selected objects and places their data on a clipboard.
Paste Nodes Pastes cut or copied objects from the clipboard into the scene as children of the highlighted object. If multiple objects are highlighted, only the first one is used.

NOTE Before pasting is accomplished, the Clone Options dialog on page 992 opens. Change settings or accept the defaults and then click OK.

Customize menu

Toolbars submenu The choices on this submenu let you toggle display of individual toolbars.

- Find Toggles display of the Find field. Default=on.
- View Toggles display of the View field.
- Selection Toggles display of the Selection controls (by default, the lower toolbar). Default=on.
- Tools Toggles display of the Lock Cell Editing button. Default=on.
- Display Toggles display of the object-type buttons (by default, most of the buttons in the left-hand toolbar). Default=on.
- Container Toggles display of the Container toolbar on page 7429. Default=off.

Column Chooser Opens the Column Chooser dialog, which lets you add columns by dragging new column headings to the existing column headings.

Layout Lets you change the layout of the Scene Explorer.

- Vertical (The default.) Uses a vertical layout for the Selection tools, as described in Scene Explorer Toolbars on page 7904.
- Horizontal Uses a horizontal layout for the Selection tools, similar to the Scene Explorer layout in releases prior to Autodesk 3ds Max 2010.

Scene Explorer Toolbars

Scene Explorer on page 7888 > Upper, left, and lower toolbars

The Scene Explorer has various toolbars for finding and selecting items and setting display filters. By default these are displayed as an upper toolbar, a vertical toolbar to the left of the table, and a lower toolbar.
NOTE  This topic describes the default layout. You can customize the Scene Explorer layout using controls on the Customize menu on page 7904.

Upper toolbar

**Find** Entering a search phrase here highlights search results in the list in real time. By default, Scene Explorer uses a simple text-search method, but you can alternatively use regular expressions by turning on Select Menu > Find Using Regular Expressions.

**View** Use the drop-down list to choose a different Scene Explorer, or click in the text field to edit the name of the current explorer.

Left-hand (Display) toolbar

These buttons are arranged vertically along the left-hand side of the Scene Explorer window. Most of them choose the type of objects that are displayed in the table. When on (pushed in, orange background), a button enables display of its object type; when off (pulled out, gray background), Scene Explorer doesn't list that type of object. The object types are:

- Display Geometry
- Display Shapes
- Display Lights
- Display Cameras
- Display Helpers
The next three buttons manage the object-type buttons.

- **Display All** Turns on all display filters; that is, display of all object types is enabled.
- **Display None** Turns off all display filters; that is, display of all object types is disabled.
- **Invert Display** Toggles display of all object types; those that were enabled are disabled, and vice-versa.
The last three buttons on the left-hand toolbar control advanced filtering and cell editing.

**Toggle Advanced Filter** Activates the filter specified with the Advanced Filter dialog on page 7912.

**Advanced Filter Setup** Opens the Advanced Filter dialog on page 7912, which lets you set up and use complex Boolean filter terms.

**Lock Cell Editing** When on, prevents you from changing any names, settings, and so on. All selection functionality remains intact.

**Lower (Selection) toolbar**

![Selection Set: Utilities](image)

**Selection Set** If any object-level named selection sets on page 185 exist in the scene, use this list to choose one. This selects all objects in the set.

**NOTE** After you choose a selection set from this list, its name persists in the Selection Set field even after you change the current selection. To create a new selection set, use the Named Selection Sets field on page 217 on the main toolbar.

**Select All** Highlights all objects.

**Select None** Deselects all objects and removes highlighting from the selection in the Scene Explorer.

**NOTE** One entry in the Scene Explorer table remains highlighted after you click Select None, but no objects are selected in the scene.
**Select Invert** Toggles all highlighting; highlights non-highlighted objects and vice versa.

**Sync Selection** When on, selecting an object in the viewport highlights it in Scene Explorer and vice versa.

**Filter Selection Set** When on, the table displays only the selection set you have chosen in the Selection Set drop-down list.

### Manage Scene Explorer

Tools menu > Manage Scene Explorer

Use the Manage Scene Explorer dialog to save and load custom Scene Explorers, delete and rename existing instances, and set your favorite Scene Explorer as the default.

**Interface**
When you first open the Manage Scene Explorer dialog, it lists all current Scene Explorers. To highlight one or more list items, use standard mouse-based methods, including clicking, dragging, and Ctrl+clicking.

**Load** Opens a file dialog named Load Scene Explorer. Highlight an INI file and then click Open.

If the file isn’t a valid saved Scene Explorer file, you receive an error message and nothing is loaded.

**Save** Lets you save the highlighted Scene Explorer as an INI file. Available only when a single Scene Explorer is highlighted.

**TIP** The default folder for saving Scene Explorers is the \plugcfg folder, but because it already contains a number of INI files, if you use this feature much you might want to create a dedicated folder for saving Scene Explorers.

**Delete** Eliminates all highlighted Scene Explorer instances from memory. This is not undoable.

**Rename** Opens a small Rename Scene Explorer dialog, with the name highlighted in an editable field. Available only when a single Scene Explorer is highlighted.

**Set as Default** Makes the configuration of the highlighted Scene Explorer the default configuration, so when you add a new Scene Explorer 3ds Max uses this configuration. Available only when a single Scene Explorer is highlighted.

---

**Advanced Search Dialog**

**Scene Explorer** on page 7888 > Select menu > Search

The Advanced Search dialog lets you highlight objects in the Scene Explorer list using combinations of search phrases to specify Boolean searches. For example, you can use Advanced Search to show only hidden non-geometry objects of a specific color whose name begins with “S”.

**Procedure**

**To use the Advanced Search dialog in Scene Explorer:**

1. From the Property drop-down list, choose a property for your search.
   This choice determines the available options in the Condition and Reference Value lists.
2 Choose the Condition.
For example, if you set Property=Name, then you could choose
Condition=Contains String to be able to search for a text string anywhere
in the object names.

3 Set the Reference Value. With some properties, such as Name, you enter
the value from the keyboard. With others, such as Type and Color, you
use the mouse to choose the Reference Value from a list.

4 Click Add.
This adds the search term to the dialog list.

5 Add enough search terms to create the search you want to perform.
For example, if you want to find all objects other than Helper objects
whose name begins with “House”, your search would look like this:

<table>
<thead>
<tr>
<th>Property</th>
<th>Condition</th>
<th>Reference Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Starts With</td>
<td>Auto</td>
</tr>
</tbody>
</table>

TIP
If you add a search term and then later decide you don’t want to use it,
highlight it in the list and then click Remove.

6 When you’ve set up the search you want, click Search.
This closes the Advanced Search dialog and highlights items that meet
the search criteria.

Interface
Use the dialog controls to specify one or more search phrases and then initiate
the search. Successful search results can meet all or any specified criteria.
New in Advanced Search is the ability to modify an existing search phrase in the list, as shown in the following illustration. Click a term and modify it using the applicable method (mouse or keyboard). When editing a field with the keyboard, press Tab or Enter to accept the changed entry, or Esc to cancel.

**Property** Choose the desired property to search for from the drop-down list.

**Condition** Based on the Property choice, choose an available condition.

**Reference Value** Enter a search term or choose one from the drop-down list, depending on the Property choice.

**Match All/Match Any** To use all terms for the search, choose Match All. To highlight items that match any of the search terms, choose Match Any. In Boolean terms, Match All is an AND search and Match Any is an OR search.

**Add** Click to add the search phrase to the list.

**Remove** Deletes the highlighted search phrase from the list.

([list of search phrases]) When you click Add, the current combination of search conditions (the *search phrase*) is added to this list.

**Select** Closes the dialog and performs the search, highlighting all objects in the Scene Explorer list that satisfy the combination of search conditions.

**Cancel** Closes the dialog without performing a search.
Advanced Filter Dialog

Scene Explorer on page 7888 > Display toolbar > Advanced Filter Setup button
Scene Explorer on page 7888 > Display menu > Configure Advanced Filter button

The Advanced Filter dialog lets you limit object display in Scene Explorer based on combinations of filter conditions (filter phrases). For example, you can use Advanced Filter to list only hidden non-geometry objects of a specific color whose name begins with “S”.

Procedure

To use the Advanced Filter dialog in Scene Explorer:

1. From the Property drop-down list, choose a property for your filter. This choice determines the available options in the Condition and Reference Value lists.
2. Choose the Condition. For example, if you set Property=Name, then you could choose Condition=Contains String to be able to filter for a text string anywhere in the object names.
3. Set the Reference Value. With some properties, such as Name, you enter the value from the keyboard. With others, such as Type and Color, you use the mouse to choose the Reference Value from a list.
4. Click Add. This adds the filter phrase to the dialog list.
5. Add enough terms to create the filter you want to perform. For example, if you want to show only objects other than Helper objects whose name begins with “House”, your setup would look like this:
TIP

If you add a phrase and then later decide you don’t want to use it, highlight it in the list and then click Remove.

6 When you’ve set up the filter you want, click OK. This closes the Advanced Search dialog and activates the filter, with the result that only items that meet the criteria you specified appear in the Scene Explorer list.

7 One way that you can tell the filter is active is that the Toggle Advanced Filter button on the left-hand toolbar is on:

To return to displaying the full list, turn off Toggle Advanced Filter.

Interface

Use the dialog controls to specify one or more filter phrases and then initiate the search. Successful search results can meet all or any specified criteria.
New in Advanced Filter is the ability to modify an existing filter phrase in the list, as shown in the following illustration. Click a term and modify it using the applicable method (mouse or keyboard). When editing a field with the keyboard, press Tab or Enter to accept the changed entry, or Esc to cancel.

**Property** Choose the desired property to filter for from the drop-down list.

**Condition** Based on the Property choice, choose an available condition.

**Reference Value** Enter a term or choose one from the drop-down list, depending on the Property choice.

**Match All/Match Any** To use all phrases for the filter, choose Match All. To filter for items that match any of the search phrases, choose Match Any. In Boolean terms, Match All is an AND search and Match Any is an OR search.

**Add** Click to add the filter phrase to the list.

**Remove** Deletes the highlighted filter phrase from the list.

**[list of filter phrases]** Shows all active filter phrases. When you click Add, the current combination of filter conditions is added to this list.

**OK** Closes the dialog and activates the filter, displaying only objects in the Scene Explorer list that satisfy the combination of filter conditions.

**Cancel** Closes the dialog without activating the filter.
Scene States

Tools menu > Manage Scene States

Right-click to open the quad menu. > Display (upper-right) quadrant > Manage Scene States

The Scene States feature provides a fast way to save different scene conditions with various lighting, camera, material, environment, and object properties that can be restored at any time and rendered to produce numerous interpretations of a model.

You save and restore scene states with the Manage Scene States dialog on page 7917, which makes it a convenient way to quickly compare how different parameter settings affect how each scene looks. Because scene states are saved with the MAX file, they are easily accessible to everyone on a design team.

Scene states also allow you to experiment with different scene setups without having to save the entire MAX file each time a change is made. This means you don't need to open and close files in order to render different conditions of the same model. As well, scene states do not add to the size of the file.

When you save a scene state, you can choose which aspects of the scene to record:

- **Light Properties**  Light parameters such as color, intensity, and shadow settings are recorded with the scene for each light or luminaire.

- **Light Transforms**  Transforms such as position, orientation, and scale are recorded for each light.

- **Object Properties**  Current Object Properties values are recorded for each object. This includes settings for Advanced Lighting and mental ray.

- **Camera Transforms**  Camera transform modes such as position, orientation and scale are recorded for each camera.

- **Camera Properties**  Camera parameters such as FOV and depth of field, including any corrections made by the Camera Correction modifier on page 5607 are recorded for each camera.

- **Layer Properties**  Records the settings for each layer in the Layer Properties dialog at the time the scene state is saved.

- **Layer Assignment**  Records each object's layer assignment.

- **Materials**  All materials and material assignments used in the scene are recorded.
Environment  Records these Environment and Atmosphere Effects on page 7162 settings: Background, Ambient, and Tint colors; Global Lighting > Level; Environment Map; Environment Map on/off state; Exposure Control rollout settings.

Tips for Managing Scene States

- When first becoming familiar with scene states, minimize changes to make it easier to keep track of what each scene state contains.
- Saving all scene aspects in a scene state allows you more flexibility when restoring. When you include all the parts of the scene, you can choose to restore all or just a few of the aspects that were originally saved.
- Additions made to a scene after a scene state has been saved affect how the restored scene will render. For example, say you already have a scene state named *Omni* that contains omni lights. You then decide to save another scene state named *Free Spot* that contains a free spot light. When you restore the *Omni* scene state, the scene will contain both the omni lights and the free spot light.
  
  If you decide to add other lights to the scene that you don't want to render with the existing lights, you need to remember to turn off the new lights and overwrite any existing scenes that have Light Properties saved. See Saving Changes to an Existing Scene State on page 7919 on how to overwrite an existing scene state.
- Use descriptive names for scene states. If scene state names are too long to see in the dialog, resize the Manage Scene States dialog or use the scroll bar at the bottom of the dialog.
  
  If you select individual parts to be saved with a scene state, it is useful to note in the scene state name which parts are recorded.
- If the scene contains more than one camera, restore the desired scene state first, then change the viewport to the desired camera view.

Scene State Limitations

- Even though you can select multiple scene states from the Manage Scene State dialog, only one scene state can be restored at a time.
- The currently restored scene state name is not displayed in the user interface. It's helpful to save rendered scenes by their scene state name as a reference.
Materials must be reopened in the Material Editor after a scene state containing objects with material assignments is restored.

If part of a scene state is later deleted or hidden, a warning does not display when the scene state is restored indicating that there are missing parts or that the scene will not be restored as it was when originally recorded.

Likewise, if you delete one or more scene states from the Manage Scene States dialog, you are not presented with a warning that you are about to delete them. However, you can restore deleted scene states with Undo.

Viewport configurations are not saved as part of the scene state. Therefore, you cannot use scene states to control which viewport is active or whether viewports are minimized or maximized.

**Scene States and Batch Render**

Scene states do not store viewport layouts, such as which camera view is active, so you can use the Batch Render tool on page 7026 to coordinate rendering from any camera that is saved with the model. With each camera task that you assign to the batch render tool, you can specify a saved scene state that will be automatically loaded and rendered.

See also:

- Batch Rendering on page 7021
- Batch Rendering: Batch Render Dialog on page 7026

**Manage Scene States Dialog**

Tools menu > Manage Scene States

Right-click to open the quad menu. > Display (upper-right quadrant) > Manage Scene States

The Manage Scene States dialog is a modeless dialog where you can select, save, rename, and delete scene states on page 7915.

**Procedures**

To save a scene state:

1. Set up the scene in the viewport.
**TIP** It is best to first render the scene to see if it is set up the way you want before saving it. If it isn’t, make the desired changes and render again before proceeding to the next step.

2 Right-click in a viewport and choose Save Scene State from the quad menu.

3 In the Save Scene State dialog, highlight the parts you want saved in the scene state, then enter a descriptive name. For descriptions of these parts, see Managing Scene States on page 7915.

4 Click the Save button. This saves the scene state to the MAX file.

**To restore a scene state:**

1 Right-click in a viewport and choose Restore Scene State from the quad menu.

2 Choose the scene state to restore from the flyout list.

3 Highlight the parts you want restored with the scene state. Only the parts that were originally saved with the scene state are listed.

4 Click Restore.
   The scene state is restored in the viewport.

**To rename a scene state:**

1 Right-click in a viewport and choose Manage Scene States from the quad menu.

2 In the scene state list, highlight the scene state you want to rename.

3 Click the Rename button.

4 In the Rename Scene State dialog, enter a new name for the scene state.

5 Click OK. The new name is displayed in the scene state list.

**To delete a scene state:**

1 Right click in a viewport and choose Manage Scene States from the quad menu.

2 In the scene state list, highlight the scene state you want to delete.

3 Click the Delete button. The scene state is deleted from the MAX file.
NOTE You can undo to restore the deleted scene state.

To save changes to an existing scene state:

1. In the Manage Scene States dialog, highlight the scene state you want to overwrite.
2. Click the Save button.
   The Scene State Manager displays a message confirming if you want to overwrite the scene state.
3. Click OK.

Interface

The dialog lists all the scene states that are saved in the MAX file.

Save Opens the Save Scene State dialog on page 7920 where you enter a name for the current scene state. To select a continuous range of parts, drag or Shift+click. To make a noncontinuous selection, use Ctrl+click.

Restore Opens the Restore Scene State dialog on page 7921 for the selected scene state.

Rename Opens the Rename Scene State dialog on page 7922 for the selected scene.
Delete  Deletes the highlighted scene state(s) without first warning you if you are sure you want to delete the scene. To select a continuous range of entries, drag or Shift+click. To select noncontinuous entries, use Ctrl+click.

Close  Closes the Manage Scene States dialog.

Save Scene State

![Save Scene State dialog](image)

**Enter a Scene State name**  A text field where you enter a descriptive name for the scene state.

**Select Parts**  Lists the parts you can save in the scene state. By default, all parts are highlighted except for Materials and Environment. When you make a different selection set, it is “sticky,” which means the next time the dialog is displayed, the parts you highlighted previously are highlighted.

**Save**  Saves the scene state with the name you supplied and the parts you selected. The scene state is saved in the MAX file.

**Cancel**  Closes the dialog without saving the scene state.
**Restore Scene State**

![Restore Scene State dialog](image)

**Enter a Scene State name** Displays the scene name that was selected in the Manage Scene States dialog. Use the drop-down list to select a different scene state to restore.

**Select Parts** Displays a list of scene parts from which you can restore for the scene state. To highlight a continuous range of parts, drag or Shift+click. To highlight noncontinuous items, use Ctrl+click.

**Restore** Click to restore the scene state in the active viewport.

**Cancel** Closes the dialog without restoring the selected scene state.
Rename Scene State

Enter a Scene State Name Enter a new name in the Name field for the highlighted scene state. Click OK to accept the change or Cancel to close the dialog without renaming the scene state.

Schematic View

Menu bar > Graph Editors > New Schematic View
Menu bar > Graph Editors > Saved Schematic Views > Choose a saved schematic view.
Main toolbar > Schematic View button
The Schematic View is a node-based scene graph that gives you access to object properties, materials, controllers, modifiers, hierarchy, and non-visible scene relationships such as wired parameters and instancing.
Here, you can view, create, and edit relationships between objects. You can create hierarchies, assign controllers, materials, modifiers, or constraints.
You can use the Schematic View Display floater to control what entities and relationships you want to see and work with. Use Schematic View to navigate complex hierarchies or scenes with large numbers of objects. Use Schematic View to understand and explore the structure of files you didn't create yourself.

One powerful feature is the list view. You can see the nodes in a text list which you can sort by criteria. The list views can be used to navigate extremely complex scenes quickly. You can use the relationship or instance viewer within Schematic View to see light inclusions or parameter wirings within the scene. You can control the display of instances or see a list of object occurrences.

Schematic View also allows for background image or grid, and automatic arrangement of nodes based on physical scene placement. This makes arranging nodes for character rigs easier.

Choose between a variety of arrangement selections so you can auto-arrange, or work in a free mode. The layout of the nodes is saved with the named Schematic View window. You can load a background image as a template for laying out the nodes in the window.

**Schematic View Features**

Here are some of the notable features of Schematic View:

- Layouts are saved with the named Schematic View file.
- Text remains readable during window navigation.
Schematic View includes tools for displaying and arranging nodes including a free mode.

- You can use a background image or grid in the Schematic View window.
- You can see and edit wired parameters.
- A modeless display floater lets you turn on and off node display by category.
- The Relationship List Viewer enables quick navigation and selection of nodes. Relationships displayed includes Lights inclusion/exclusion, all parameter wires, constraints, controllers, and modifier relationships such as path deform paths and morph targets.
- You can copy and instance controllers.
- You can assign controller types.
- Schematic View offers extensive MAXScript exposure.
- Ability to drill down to more properties (such as static values and custom attributes).

**How the Components of Schematic View Behave**

Everything displayed in the Schematic View window is shown as a box with a name. There are various conventions to indicate different states regarding these objects.

**Solid End** Signifies that the entity is arranged.
Open end Signifies that the entity is free.

Red Border Signifies that the entity is animated.

End Arrow Signifies that the entity shares a relationship with another entity.

White Fill Signifies that the entity is selected in the Schematic View window.

White Border Signifies that the entity is selected in the viewport.

Up Arrow Collapses the entity it springs from and all child entities thereof up into the parent entity.

Down Arrow Expands the next child entity down from the entity that the arrow springs from.

Overlap Schematic View will prevent newly visible nodes from overlapping with existing nodes. This applies to free mode: make an object, free it, make another object and it will fall on top but to the right of the original object so both can be accessed and moved.

Instances Schematic View will bold the text of instanced entities, for nodes this will show up on the base object entity. In the example illustrated, Box02 and Box03 are instances.
Procedures

See Using Schematic View on page 7926

Interface

See the following topics describing the Schematic View user interface.

Schematic View Menus on page 7930
Schematic View List Views on page 7934
Schematic View Preferences Dialog on page 7936
Schematic View Toolbars on page 7942
Schematic View Display Floater on page 7946

Using Schematic View

This topic includes procedures for using the Schematic View window on page 7922.

To create hierarchies with Schematic View:

1. Select the objects you want to work with in the viewport.
2. Use Zoom Extents Selected to display these objects in the Schematic View window.
3 On the Schematic View toolbar, click the Connect button.

4 In the Schematic View window, drag from the child object to the parent. A dotted line follows your cursor. Click to set the linkage.

If you are in Hierarchy mode, the children will arrange themselves into an indented list under the parent as you create linkages.

To assign controllers with Schematic View:

1 On the Schematic View toolbar, click Display. The Display floater appears. It lets you control what you see in the Schematic View window.

2 On the Display floater, in the Relationships group, click Controllers. In the Entities group, click Controllers as well. The buttons indent to show they are active. The Transforms now appear in the Schematic View window.

3 In the Schematic View window, select the transform of the object you want to assign a controller to.

4 Right-click the transform, from on the Tools quad, choose Assign Controller.

5 Choose the controller you want to apply from the list, then click OK.

To wire parameters with Schematic View:

1 Using the Display Floater, turn on Param Wires in the Relationships group.

2 In the Schematic View window, select one of the objects you want to wire.

3 Right-click the selected object and choose Wire Parameters.

4 In the pop up that appears select the component you want to wire, either a Transform or an Object parameter, for instance.

5 Drag to the other object you want to wire to.

6 Again in the pop up that appears, select the component you need to wire to.
The Wire Parameters dialog appears. Make the necessary selections and connect the wires.

Once the wiring is established you can edit the wiring by double-clicking the wire in Schematic View.

To save a Schematic View layout:
1. When you have a layout you like, name the layout using the Schematic View name field in the toolbar, just to the right of the Preferences button.
2. Close the Schematic View window.
3. To load the saved view, go to Graph Editors > Saved Schematic View and choose the schematic view from the history list.

To add a background image:
1. On the Schematic View Options menu, choose Preferences.
2. In the Background Image group, click the File: button to launch the File Browser.
3. In the Browse Images for Input dialog, find and highlight the bitmap you want to use, then click Open.
4. On the Schematic View Preferences dialog, in the Background group, turn on Show Image.
   The Background bitmap show up in the Schematic View window.

   **TIP** Turn on Lock Zoom Pan, if you want to zoom in or pan the background image.

To navigate complex scenes:
Complex scenes can be navigated quickly by using the list viewer combined with the pan or zoom to selected option. For example suppose you need to locate all the bones within a certain character.

1. Open Schematic View
2. Press \( H \) on the keyboard and enter the name of the object you’re looking for in the Select Objects field. Press Enter to select the object by name.
3. In the window navigation tools group, click Zoom Selected.
The Schematic View window now clearly shows the object node.

On the List Views menu, choose Show Occurrences.
The List viewer displays the Object Occurrences dialog.
This is a sortable list. You can click the header title to sort by it.

**NOTE** Object Occurrence is being used as an example here. You can use any of the List View menu choices to display a list of objects based on a certain relationship.

On the Views menu choose Pan To Selected. Now click through the nodes in the list.
The Schematic View window updates to display each node as you click.
This method makes navigation of very complex scenes much more convenient. Also when working with lists such as relationships or instances you have the additional ability to detach the relationship or make the instance unique.

**To arrange the nodes in Schematic View to match the viewport:**

It can be useful sometimes to arrange the nodes in the Schematic View the same as in the viewport. There is a script that can do this for you. In this example we’ll use the bones of a character rig.

1. Using Windows Explorer, copy \3dsmax\scripts\maxscripttools\macro_schematicviewtools.mcr into \3dsmax\ui\macroscripts.
2. Restart 3ds Max.
3. On the Customize menu, choose Customize User Interface.
4. Click the Quads tab, then choose the Schematic View category from the drop-down list on the right
5. Drag the action named Project into Schematic View in the Schematic View quad menu (any quad you like).
6. Drag the Spacing Tool item into Schematic View’s quad menu.
7. On the Graph Editors menu, choose New Schematic View.
8. In any viewport (other than Perspective or User), select the bones of the rig that you want to arrange.
In the Schematic View window, right-click and choose Project Into Schematic View from the quad menu.

A new Schematic View named Projection shows the selected bones arranged as in the viewport.

**TIP** If the components appear on top of one another, right-click again and choose Spacing Tool from the quad menu. Drag the spacing slider to the right to add space between the objects. If necessary manually reposition components as needed.

### Schematic View Menus

- **Menu bar > Graph Editors > New Schematic View > Menu bar**
- **Menu bar > Graph Editors > Saved Schematic Views > Choose a saved schematic view. > Menu bar**
- **Main toolbar > Schematic View button > Menu bar**

Schematic View has several menus, which appear on the menu bar of the Schematic View window.

**Edit menu**

- **Connect** Activates the connect tool. The connect tool in Schematic View can be used to create any relationship or constraint, are can be used to assign modifiers.
- **Unlink Selected** Disconnects the selected entities.
- **Delete** Removes entities from Schematic View and from the scene. Disconnects selected relationships.
- **Assign Controller** Lets you assign controllers to transform nodes. Only available when controller entities are selected. Opens the standard assign controller dialog.
- **Wire Parameters** Lets you wire parameters using Schematic View. This is active only when entities are selected. This launches the standard Wire Parameters dialog.
- **Object Properties** Displays the Object Properties dialog on page 283 for the selected nodes. Has no effect when no node is selected.
Select menu

Select Tool  Activates the Select tool when in Always Arrange mode and Select and Move tool when not.

Select All  Selects all entities in the current Schematic View.

Select None  Deselects all entities in the current Schematic View.

Select Invert  Deselects selected entities and selects unselected entities in the current Schematic View.

Select Children  Selects all children of currently selected entities.

Deselect Children  Deselects children of all selected entities. Parent and child must be selected for child to become unselected.

Select to Scene  Selects in viewport all nodes that are selected in Schematic View.

Select from Scene  Selects in Schematic View all nodes that are selected in viewport.

Sync Selection  When on, selecting objects in Schematic View also selects them in the viewport, and vice-versa.

List Views menu

See Schematic View List Views on page 7934.

Layout menu

Align  Lets you define the following alignment options for selected entities in the Schematic View window:

■ Left  Aligns selected entities to the left edge of the selection, leaving vertical positioning intact.

■ Right  Aligns selected entities to the right edge of the selection, leaving vertical positioning intact.

■ Top  Aligns selected entities to the top edge of the selection, leaving horizontal positioning intact.

■ Bottom  Aligns selected entities to the bottom edge of the selection, leaving horizontal positioning intact.

■ Center Horizontal  Aligns selected entities to the horizontal center of the selection, leaving vertical positioning intact.
**Center Vertical**   Aligns selected entities to the vertical center of the selection, leaving horizontal positioning intact.

**Arrange Children** Arranges the display of children based on set arrangement rules (align options) below the selected parent.

**Arrange Selected** Arranges the display of children based on set arrangement rules (align options) below the selected parent.

**Free Selected** Frees all selected entities from arrangement rules, tags them with a hole icon on their left end and leaves them in place. Use this to freely arrange selected objects.

**Free All** Frees all entities from arrangement rules, tags them with a hole icon on their left end and leaves them in place. Use this to freely arrange all objects.

**Shrink Selected** Hides all selected entities’ boxes, keeping arrangement and relationships visible.

**UnShrink Selected** Makes all selected shrunk entities visible.

**UnShrink All** Makes all shrunk entities visible.

**Toggle Shrink** When on, shrinking entities works normally. When off, shrunk entities are fully visible, but not unshrunk. Default=on.

**Options Menu**

**Always Arrange** Causes Schematic View always to arrange all entities based on the chosen arrangement preference. Displays a pop-up warning before doing so. Choosing this activates the toolbar button.

**Hierarchy Mode** Sets Schematic View to display entities as a hierarchy instead of reference graph. Children appear indented below the parent. Switching between Hierarchy and Reference mode is nondestructive.
**Reference Mode** Sets Schematic View to display entities as a reference graph instead of hierarchy. Switching between Hierarchy and Reference mode is nondestructive.

**Move Children** Sets Schematic View to move all children of parent being moved. When this mode is on, the toolbar button is activated.

**Preferences** Opens the Schematic View Preferences Dialog on page 7936, which lets you control what displays in the window by filtering for categories and setting display options.

**Display menu**

**Display Floater** Displays or hides the Display Floater which controls what is displayed in the Schematic View window.

**Hide Selected** Performs the action of hiding whatever is selected in the Schematic View window.

**Unhide All** Reveals any hidden items.

**Expand Selected** Displays all child entities of selected entity.

**Collapse Selected** Hides all children of selected entity, leaving the selected entity visible.

**View Menu**

**Pan** Activates the Pan tool, which lets you move horizontally and vertically in the window by dragging the mouse.

**Pan to Selected** Centers selected entities in the window. If no entity is selected, centers all entities in the window.

**Zoom** Activates the zoom tool. Lets you move closer to or further from the Schematic display by dragging the mouse.
**Zoom Region** Lets you zoom to a specific area by dragging a rectangle in the window.

**Zoom Extents** Zooms the window so all the nodes in the Schematic View are visible.

**Zoom Extents Selected** Zooms the window so that all selected nodes are visible in the display.

**Show Grid** Displays a grid in the background of the Schematic View window. Default=on.

**Show Background** Displays an image in the background of the Schematic View window. Set the image via Preferences on page 7936.

**Refresh View** Redraws the contents of the Schematic View window with all changes made to it or with changes made in the scene.

---

**Schematic View List Views**

Menu bar > Graph Editors > New Schematic View > Menu bar

Menu bar > Graph Editors > Saved Schematic Views > Choose a saved schematic view. > Menu bar

Main toolbar > Schematic View button > Menu bar

Schematic View supports several list views that display objects and their relationships in a list. These include list views for instances, object occurrences, and relationships. Use these lists to quickly edit your parameter wiring, detach relationships, or make instances unique. Use the List options to synchronize the list with the viewport or the node display in the Schematic View window.
Interface

**List view displaying relationships**

**All Relationships** Opens or redraws List View with all relationships of currently displayed Schematic View entities.

**Selected Relationships** Opens or redraws List View with all relationships of currently selected Schematic View entities.

**All Instances** Opens or redraws List View with all instances of currently displayed Schematic View entities.

**Selected Instances** Opens or redraws List View with all instances of currently selected Schematic View entities.

**Show Occurrences** Opens or redraws List View with all entities that share a property or relationship type with currently selected entities.

**All Animated Controllers** Opens or redraws List View with all entities that have or share animated controllers.

**Make Unique** In the All Instances and Selected Instances views, this makes the selected entity a copy and takes it out of the list.

**Detach** In the All Relationships and Selected Relationships views, eliminates the selected relationship and takes it out of the list.

**Options Menu in the List View Dialogs**

Options for list view let you synchronize the list selection with the viewport and the Schematic View window.

**Sync selection** When this is turned on, Schematic View selection corresponds to selections made in the list.
Pan to Selected When this is turned on, Schematic View pans to put the entity selected in the list into the center of the Schematic View within the existing zoom factor. For Instances and Occurrences this will be single entities, for Relationships it will be two entities.

Zoom to Selected When this is turned on, Schematic View zooms extents around the entity selected in the list. For Instances and Occurrences this will be single entities, for Relationships it will be two entities

Respect display When this is turned on, the List View will only show entities turned on for display by the Display Floater.

Schematic View Preferences Dialog

Schematic View on page 7922 > toolbar > Preferences button
Schematic View on page 7922 > Options menu > Preferences

The Schematic View Preferences dialog controls what is shown and what is hidden based on categories. You can filter the objects appearing in the Schematic View window, so you see only what you need to.

You can add a grid or background image into your Schematic View window. Here you can also choose the arrangement method and determine the synchronization between viewport selection and Schematic view window selection. You can also set the style for the node connections. By selecting the appropriate filters in this dialog you can make working with Schematic View more controllable.
Interface

**Include in Calculation**

Schematic View can traverse the entire scene, including materials, maps, controllers, and so on. The Include In Calculation settings control which scene components Schematic View will know about. The Display Floater then controls what is displayed. So, if you don't Include Materials, you can't display materials. If you don't include controllers, you can't display controllers, constraints, or parameter-wiring relationships.

If you have a huge scene and are interested only in using Schematic View for selection, you can turn everything off except Base Objects. If you are interested only in materials, you can turn off controllers, modifiers, and so on.
**Base Objects** Turns on and off the display of the base objects. Use this to remove clutter in the Schematic View window.

**Modifier Stack** Turns on and off the display of modifier nodes.

**Materials/Maps** Turns on and off the display of material nodes in the Schematic View window. Hide the materials when you are animating and don’t need to see them, display them when you want to select materials or make changes to the material of various objects.

**NOTE** Schematic View does not support the ability to manipulate maps. You cannot paste a map from one material to another.

**Controllers** When this is turned on, controller data is included in the display. When this is turned off Controllers, Constraints and Param Wires relationships and entity buttons are unavailable in the Display floater. When this is on, you can assign controllers or wire parameters using the tools quad of the Schematic View right-click menu.

**Static Values** When this is turned on, unanimated scene parameters are included in the Schematic View display. Turn this off to prevent the window from filling up with everything seen in Track View.

**Master Point Controller** When this is on, sub-object animation controllers are included in the Schematic View display. This button prevents the window from filling up with too many controllers in cases in which sub-object animation is present.

**Skin Details** When this is turned on, four controllers for each bone in the Skin modifier are included in the Schematic View display (when Modifiers and Controllers are also included). This button prevents the window from stretching out around too many Skin controllers with normal use of the Skin modifier.

**Include Only group**

**Selected Objects** Filters the display of selected objects. Check this box if you have a lot of objects and only want Schematic View to display the viewport selection.

**Visible Objects** Limits the display in Schematic View to the visible objects. Hide objects you don’t need to display, then check this box to contain clutter in Schematic View.

**Animated Objects** When this is turned on, then only objects that have keys and their parents will be included in the Schematic View display.
Hide By Category group

These toggles control the display of objects and their children, by category. The categories are:

- **Geometry**  Hides or displays geometric objects and their children.
- **Shapes**  Hides or displays shape objects and their children.
- **Lights**  Hides or displays lights and their children.
- **Cameras**  Hides or displays cameras and their children.
- **Helpers**  Hides or displays helper objects and their children.
- **Space Warps**  Hides or displays space warp objects and their children.
- **Bone Objects**  Hides or displays bone objects and their children.

Be aware that if you have a hierarchy linked to a helper such as a dummy, and you hide the dummy, you’ll also hide the children.

Link Style group

**Bezier Lines**  Displays the reference lines with arrowheads as Bezier curves.

![Bezier Lines Example](image1.png)

**Straight Lines**  Displays the reference lines as straight lines instead of Bezier curves.

![Straight Lines Example](image2.png)

**Circuit Lines**  Displays the reference lines as orthogonal lines instead of curves.
None  When this is chosen, link relationships will not appear in the Schematic View display.

**Grid group**

This group controls the display and use of a grid in the Schematic View.

**Show Grid** Displays a grid in the background of the Schematic View window.

**Snap to Grid** When this is on, all moved entities and children of those entities will snap their upper left corners to the nearest grid point. Entities not snapped to a grid point when snap is enabled will not snap until they are subsequently moved.

**Grid Spacing:** Sets the spacing units of the Schematic View grid. This uses the standard that entities are 20 grid units high and 100 grid units long.

**Arrange Method group**

Arranging always takes place within the confines of the positive X and negative Y space which is delineated by the darker grid lines.

**Stacked** When this is turned on, arranging via Always Arrange, Arrange Children or Arrange Selected will result in the hierarchies being stacked below a width that is determined by the extents of the highest entities in the view.

**Horizontal** When this is turned on arranging using Always Arrange, Arrange Children or Arrange Selected will result in the hierarchies being distributed along and below the y=0 line. Arranging always takes place within the confines of the positive X and negative Y space.

**Vertical** When this is turned on arranging using Always Arrange, Arrange Children or Arrange Selected will result in the hierarchies being distributed along and to the right of the x=0 line. Arranging always takes place within the confines of the positive X and negative Y space.
Sync Selection group

Viewports When this is chosen, node entities selected in Schematic View will have their corresponding nodes selected in the viewports. Likewise, nodes selected in the viewports will have their corresponding entities selected in Schematic View.

Everything When this is chosen, all entities selected in Schematic View will have their corresponding entities selected in the appropriate places in the interface, given that those places are open. For instance, selecting a material in Schematic View will select it in the material editor if it is open and the material is present, selecting a modifier in Schematic View will select it in the stack if the Modify panel is open. Likewise, entities selected in the scene will have their corresponding entities selected in Schematic View.

None When this is chosen, changes in the viewport selection do not affect the Schematic View display, and selection changes in the Schematic View display do not affect the viewport selection.

Background Image group

Show Image When on, the background bitmap (if one is chosen) is displayed. When off, it is not displayed.

By default, the background image displays at screen resolution at the current zoom factor of Schematic View.

Lock Zoom/Pan When this is turned on, zooming and panning resizes the background image accordingly. When turned off, the bitmap will remain or revert to actual pixels at screen resolution.

File button Click to choose an image file for the background of Schematic View.

When no background image has been chosen, this button displays “None.” If an image has been chosen, it shows the name of the bitmap file.

Preferences group

Double Buffer Allows for double buffer display to control viewport performance.

Zoom About Mouse Pointer When this is turned on you can zoom into wherever you place your cursor. You can also zoom with the zoom wheel, or hold Ctrl and press the middle mouse button.
Pan to Added Nodes When this is turned on the Schematic View window will alter itself to accommodate new objects or nodes as they are added to the scene. When this is turned off the view is unchanged. Leave this off and turn off Auto arrange, and Schematic view will not disturb the layout of the nodes.

Use Wireframe Color Uses the wireframe color to shade the node in the Schematic View window.

Display Layout Warning When this is on, Schematic View will show a layout warning when Always Arrange is first turned on.

Only Update On Focus When this is turned on, Schematic View only updates with additions or changes to the scene when it is given focus. This lets you avoid constant redraws when making changes in the viewport to the scene objects.

Move Children When this is turned off you can move the parent without affecting the children. When this is turned on, moving a parent also moves the children.

Show Tooltips Toggles the display of tooltips when the cursor is over the node in the Schematic View window.

Snap Floaters Enables floating dialogs (Display and List) to snap to the edges of the Schematic View window.

Relative Floaters Enables floating dialogs to move and resize as the Schematic View window is moved and resized.

**Schematic View Toolbars**

Menu bar > Graph Editors > New Schematic View > Top and bottom toolbars

Menu bar > Graph Editors > Saved Schematic Views > Choose a saved schematic view. > Top and bottom toolbars

Main toolbar > Schematic View button > Top and bottom toolbars

Schematic View has two toolbars, one at the top and the other at the bottom of the Schematic View window.

The Schematic View toolbar at the top of the window contains the following buttons:

Display Floater Displays or hides the Display Floater. Active button means floater is open, inactive button means it’s hidden.
Select  Lets you select objects in the Schematic View window and in the viewport. Selecting objects in the Schematic View window turns the node yellow. Selecting the objects in the viewport, outlines their Schematic View representation box in white, but doesn’t select it in the Schematic View window. If you want to the selection in Schematic view passed into the viewport use the Sync Selection button. Whatever is selected in Schematic view will become selected in the viewport as well.

Connect  Lets you create hierarchies. Just as you link objects in the viewports, you can create linkages in Schematic View. Click the child and connect to the parent. You also use this to add modifiers to objects, and to wire parameters.

Unlink Selected  Unlinks whatever is selected in the Schematic View window.

Delete Objects  Deletes whatever is selected in Schematic View. The deleted selection disappears in the viewport and the Schematic View window.

Hierarchy Mode  Shows the parent/child relationships in a cascading display. The parents are to the left and up, the children are indented toward the right and down.

References Mode  Shows relationships based on instances and references rather than hierarchy. Use this to view materials and modifiers.

Always Arrange  Sets Schematic View to always arrange all entities based on arrangement preference (alignment options). Displays a pop-up warning before doing so. When this mode is on it activates the toolbar button.

Arrange Children  Arranges the display of children based on set arrangement rules (align options) below the selected parent.
Arrange Selected Arranges the display of children based on set arrangement rules (align options) below the selected parent.

Free All Frees all entities from arrangement rules, tags them with a hole icon on their left end and leaves them in place. Use this to freely arrange all objects.

Free Selected Frees all selected entities from arrangement rules, tags them with a hole icon on their left end and leaves them in place. Use this to freely arrange selected objects.

Move Children Sets Schematic View to move all children of parent being moved. When this mode is on, the toolbar button is activated.

Expand Selected Reveals the display of all child entities of selected entity.

Collapse Selected Hides the display of all children of selected entity, leaving the selected entity visible.

Preferences Displays the Schematic View Preferences dialog. This lets you control what is displayed and hidden in the Schematic View window by category. Various options are here to filter and control the display within the Schematic View window. See Schematic View Preferences Dialog on page 7936.

Schematic View Name field Use this field to give the particular configuration of Schematic View a name. Simply typing the name and hitting enter will add the named view to the list of Saved Schematic View windows available from the Graph Editors menu.

Bookmark Name field Let's you define a selection of entities in the Schematic View window as a bookmark, so you can easier return to them in a complex scene with many objects.
Go to Bookmark Zooms and pans the Schematic View window so the bookmarked selection is displayed.

Delete Bookmark Removes the bookmark name that is displayed in the Bookmark name field.

Buttons on the Lower Toolbar

Zoom Selected Viewport Object Zooms in on whatever is selected in the viewport. You can also type in the name in the text field next to this button.

Selected Object text entry window Lets you type in the name of the object you are looking for. Then click the Zoom Selected Viewport Objects button and that object will appear in the Schematic View window selected.

Prompt Area Provides a one-line instruction to tell you how to use the highlighted tool or button or provides you with details such as how many objects are currently selected.

Pan Lets you move horizontally or vertically in the window. You can also achieve the same effect by using the scroll bars at the right and bottom of the Schematic View window, or by using the middle mouse button.

Zoom Lets you move closer to or further from the Schematic display. When you first open your Schematic View window you will spend a moment zooming and panning to gain the appropriate view of the objects in the display. The display of the nodes changes as you move in or out.

You can also zoom by holding Ctrl and pressing the middle mouse button. To zoom at the cursor, turn on Zoom About Mouse Point in the Schematic View Settings dialog, accessed by click the Preferences button.

Zoom Region Lets you draw a zoom window on the area of the Schematic view you want to see up close.
**Zoom Extents** Zooms the window back so all the nodes in the Schematic View are visible.

**Zoom Extents Selected** Zooms the window back so that all the selected nodes are visible in the display.

**Pan to Selected** Pans the window to include the selected objects, within the same zoom factor, so that all selected entities are visible within current extents of the window.

### Schematic View Display Floater

The Display Floater controls by category what is displayed in the Schematic View window. The Schematic View Preferences dialog also filters that display of the window. Use these to manage the clutter of the window, and the performance speed.

Note that unless you display the correct entity and relationship, you will not be able to perform certain operations. If you want to wire parameters, for instance, you must have Param Wires turned on. If you want to wire the parameters of a material, you must also have Materials chosen.
Interface

Relationships group

Lets you choose which of the following relationships you want to display or create: Constraints, Controllers, Parameter wiring, Light inclusion, and Modifiers.

Entities group

Selects which types of entities are displayed or edited:

- **Base Objects** When active, all base object entities will display as children of the node entities. When Sync Selection is on and the Modifier stack is open, clicking on a base object will activate that level of the object’s stack.
Modifier Stack  When active, all modifiers in the object’s stack will display as children, beginning with the Modified Object base entity. Modifiers can be copied, instanced or moved between objects by using the Connect tool. For example, connecting XForm to Box01, will display the Attach Modifier dialog where you can choose between Copy, Move or Instance. Deleting the modifier from the Schematic View will also remove it from the object’s stack in the Modify panel.

Materials  When active, all materials and maps assigned to the objects will display as children of the objects. Materials can be instanced between objects by using the Connect tool on the Schematic View toolbar. For example, drag material Default1 to Box01. Double clicking on a material will bring up the Material editor if the Material is already in an sample material slot.

Controllers  When this is active, all controllers other than position, rotation and scale will display as children of the objects’ transform controller, which also displays. Controllers can be added to objects only when this is active. Controllers can be copied or instanced between objects by using the Connect tool. For example dragging PositionXYZ from Box01 to Position List for Box02, for instance, will open the Attach Controller dialog, where you can choose to Copy, Move or Instance this controller.

PRS  Lets you choose to display any combination of the three transform types (position, rotation, or scale).

Expand  When turned on, entities that are activated will be displayed in Schematic View. When turned off, only the triangle child indicator on the bottom of the nodes will display. This toggle only applies at activation time, it will not expand or contract entities that are already displayed.

Focus  When this is turned on, only those entities that are related to others and have their relationships displayed will be filled with their color, all others will be displayed unshaded.
Schematic View Selection Right-Click Menu

Schematic View on page 7922 > Select any node. > Right-click.

The Schematic View right-click menu contains controls for selecting, displaying, and manipulating selections of nodes. It gives you quick access to List Views, Display Floater and lets you switch between Reference and Hierarchy Mode quickly.

Interface

Options quadrant

Display Floater Opens the Display floater and activates the corresponding toolbar button.

Move Children Sets Schematic View to move all children of parent being moved. When this mode is on, the toolbar button is activated.
Reference Mode  Sets Schematic View to display entities as a reference graph instead of hierarchy. Switching between Hierarchy and Reference mode is nondestructive.

Hierarchy Mode  Sets Schematic View to display entities as a hierarchy instead of reference graph. Children appear indented below the parent. Switching between Hierarchy and Reference mode is nondestructive.

Always Arrange  Sets Schematic View to always arrange all entities based on the chosen arrangement preference. Displays a pop-up warning before doing so. Choosing this activates the toolbar button.

Select quadrant

Select Tool  Activates the Select tool when Always Arrange is turned on. Activates the Select and Move tool when Always Arrange is off.

Select All  Choose Select All to select everything in the window.

TIP  Hold down the Ctrl key to add objects to selections or remove them from it.

Select None  Choose Select None to deselect everything.

Select Invert  Deselects selected entities and selects all other entities in the current Schematic View.

Select Children  Selects all children of the current selection.

Deselect Children  Deselects children of all selected entities. Parent and child must be selected for child to become unselected.

Sync Selection  Synchronizes the selection in the Schematic View window with the viewport. Whatever you have selected in the Schematic View window becomes selected in the viewport. Whatever you select in the viewport becomes selected in Schematic View. It’s a two-way street.

Layout quadrant

Shrink  Shrinking hides all selected entities’ boxes, but keeps arrangement and relationships visible. This option displays a submenu:

- Toggle Shrink  Changes the state of entity shrinkage. Shrunk entities become unshrunk, and the other way around.

- Unshrink All  Makes all shrunk entities visible.

- Unshrink Selected  Makes all selected shrunk entities visible.
- **Shrink Selected**  Hides all selected entities' boxes, keeps arrangement and relationships visible.

**Free All** Frees all entities from arrangement rules, tags them with a hole icon on their left end and leaves them in place. Use this to freely arrange all objects.

**Free Selected** Frees all selected entities from arrangement rules, tags them with a hole icon on their left end and leaves them in place. Use this to freely arrange selected objects.

**Arrange Children** Arranges the display of children based on set arrangement rules (align options) below the selected parent.

**Arrange Selected** Arranges the display of the selection based on the arrangement preferences.

**Expand Selected** Reveals the display of all child entities of selected entity.

**Collapse Selected** Hides the display of all children of selected entity, leaving the selected entity visible.

**Unhide All** Displays all the nodes in the scene. If the resulting Schematic View is too cluttered to work with, try using Preferences to remove what you don't need to see. Or make individual selections and hide upstream or downstream to unclutter the display.

**Hide Selected** Hides the selection in the Schematic View window.

**Edit quadrant**

**Connect** Activates the connect tool. This tool in Schematic View can be used to create many Schematic View relationships such as parent, constraint, copy modifier, copy controller, or copy material.

**Unlink Selected** Disconnects the selected entities

**Delete Selected** Deletes entities from Schematic View and from the scene. This also can be used to disconnect selected relationships.

**Assign Controller** Displays the Assign controller dialog. This is available only when controller entities are selected.

**Object Properties** Displays the Object Properties dialog for the selected objects.

**Wire Parameters** Lets you wire parameters using Schematic View. This is active only when entities are selected. This launches the standard Wire Parameters dialog.
Collect Parameters Opens the Parameter Collector on page 325.

List Views

This submenu has choices for managing List Views on page 7934.

Selected Occurrences Opens or redraws List View with all entities that share a property or relationship type with currently selected entities

Selected Instances Opens or redraws List View with all instances of currently selected Schematic View entities.

All Instances Opens or redraws List View with all instances of currently displayed Schematic View entities.

Selected Relationships Opens or redraws List View with all relationships of currently selected Schematic View entities.

All Relationships Opens or redraws List View with all relationships of currently displayed Schematic View entities.

Schematic View Commands

The Schematic View commands are for managing Schematic View windows. They are available from the 3ds Max Graph Editors menu on page 8027.

New Schematic View

Menu bar > Graph Editors > New Schematic View

New Schematic View creates a new Schematic View window on page 7922. You might want to create multiple Schematic view windows filtered in different ways that you recall for quick access to multiple objects. Name the new schematic view using the Schematic View name field.

Delete Schematic View

Select a schematic view. > Menu bar > Graph Editors > Schematic View > Delete Schematic View
Delete Schematic View opens the Delete Schematic View dialog. This dialog displays all saved schematic views. Choose the view to be deleted from the list, and then click the OK button.

For information on the Schematic View buttons and controls, see Schematic View on page 7922.

**Saved Schematic Views**

Graph Editors menu > Saved Schematic Views > Schematic views by name

Saved Schematic Views displays a list of schematic views by name that were previously created by New Schematic View on page 7952.

**Using Layers to Organize a Scene**

Layers are like transparent overlays on which you organize and group different kinds of scene information. The objects you create have common properties including color, renderability, and display. An object can assume these properties from the layer on which you create it.

Using layers makes it easier to manage the information in your scenes. Layers are used primarily to control the visibility of objects in your scene, however they also controls the color of objects' wireframe and the frozen on page 191 and hidden state of objects, as well as their radiosity properties.

For example, you might want to set up a layer that will contain detailed, custom furniture. To do this, you create a layer and set Viewport Display to Bounding Box. Then you set the object's display properties to ByLayer (in the Object Properties dialog on page 283). This will keep the viewport display quick. Then, whenever you want to import new furniture, switch to this layer. You don't need to set up your viewport display every time you import new furniture. Also, if you don't want to render the furniture, you can turn off that layer's Renderable property.

---

**NOTE** When you link an AutoCAD file into 3ds Max, any layers that are frozen (and all objects that reside on these layers) are not imported.

**NOTE** Objects can be hidden and frozen on a per-object basis; however, an object residing on a hidden or frozen layer will always adopt the hide/freeze state of its layer.
TIP If you set lights’ render control to ByLayer (in the General panel of the Preferences dialog), you can use the Render column in the Layer Manager to quickly turn lights on or off in your scene.

Layers can help organize the contents of a scene.

Layer-Object Relationships

The Layer Manager on page 7956 displays layers, as well as their associated objects. This makes it very easy to organize, and make changes to objects in a scene. With the Layer Manager, you can adjust property settings at either the layer level, or individually for each object. Each property can be toggled between various states, including the ByLayer state on page 8530. When an object’s property is set to ByLayer, the object inherits that setting from the layer it is associated with.

NOTE The Hide and Freeze states of an object cannot be set to ByObject. Objects can be hidden or frozen on a per-object basis; however, they will always follow the behavior of their layer when it is hidden or frozen.

Special Layer 0

When you begin a new scene, 3ds Max creates a special layer named 0 (default). By default, objects on layer 0 have their visibility settings on, renderability is on, and viewport display is set. You can’t delete or rename layer 0.
If you haven’t created any layers, 3ds Max places objects you create on layer 0 by default. After you create objects, you can reassign them to different layers, including those residing on layer 0.

**Display Properties**

In the Layer Properties dialog on page 7966, you can specify layer visibility individually for each viewport. If you don’t want to display a certain layer, you can hide that layer. 3ds Max hides the layer in the viewport, but not in any output rendered image of the scene.

**NOTE** For hidden geometry to render, Render Hidden Geometry must be on on the Render Setup dialog > Common Parameters rollout on page 6568.

You can specify layers to display objects shaded on page 8117, in wireframe mode on page 8766, as a bounding box on page 8528, or as whatever is set on the Viewport Properties menu on page 8117. Using this method, you can have different objects displayed differently in the same scene.

You can display layers in See-Through mode on page 7969. See-Through mode temporarily displays selected objects in translucent form so you can see through them without applying special materials. You can toggle See-Through mode for all objects per layer.

**NOTE** You can control whether newly created objects adopt the default layer settings on a per-object basis by using Default To By Layer For New Nodes in the General Preferences panel on page 8298.

You can also Freeze, Hide, or Isolate the layer of a selected object using the corresponding command in the display quadrant of the quad menu.

**Layer Names**

You can create and name a layer for each conceptual grouping (such as walls or terrain) and assign common properties to those layers. By grouping objects into layers, you can control their display and make changes quickly and efficiently. When you name layers, you can use names of variable length up to 255 characters. These names can contain letters, digits, blank spaces, and the special characters dollar sign ($), hyphen (-), and underscore (_).

**NOTE** Any layers from a linked AutoCAD file are automatically imported to 3ds Max. 3ds Max names the converted layers based on the layer names from the AutoCAD drawing.
Layer Manager

Main toolbar > Layer Manager

Layers toolbar on page 8040 > Layer Manager

Tools menu > Layer Manager

The Layer Manager, available from the main toolbar, is a modeless dialog where you can create and delete layers. You can also view and edit the settings for all of the layers in your scene, as well as the objects associated with them. You can specify the name, visibility, renderability, color, and objects' and layers' inclusion in the radiosity solution from this dialog.

Objects are organized by layer in the dialog, in an expandable list. By clicking ‘+’ or ‘−’, you can expand or collapse (respectively) the object list for each layer. You can also sort the layers by clicking any of the column heads.

Another useful tool is the ability to open the Object Properties dialog on page 283 and Layer Properties dialog on page 7966 for one or more highlighted objects or layers directly from the Layer Manager by clicking the corresponding icon.

NOTE You can change the property settings for each layer or object by clicking the corresponding icon in the dialog. With each click, the icons cycle through the various states of the property, including Off ( ) and By Layer on page 8530 ( ), and, in the Render, Color, and Radiosity columns, By Object. When a property is set to By Layer, the object inherits the property setting from its associated layer.

Procedures

To create a new layer:

When you create new layers, 3ds Max names them sequentially by default: Layer01, Layer02, and so on. After creating a layer, you can rename it. 3ds Max assigns a random color to all new layers. You can accept the default settings or specify other colors.

1 On the main toolbar, click Layer Manager.

2 In the Layer Manager, click Create New Layer.
3ds Max displays a new layer in the list with the temporary name *Layer01*.

3 Click the Layer to enter a new name.

4 To create more than one layer, click New again and enter the new layer name.

**TIP** If an existing layer is highlighted when you create a new layer, the new layer inherits the properties of the highlighted layer. You can modify the properties of the new layer, if necessary, as illustrated in the following procedures.

---

**To make a layer current:**

1 On the main toolbar, click Layer Manager.

2 In the Layer Manager dialog, click the second column next to the layer name.
   ✓ A check box appears indicating that the layer is current.

**NOTE** The current layer is also displayed in the title bar of the Layer Manager.

**To make a layer current (alternate method):**

- On the Layers toolbar > Layer List, select a layer.
  The highlighted layer becomes the current layer.

**To hide a layer:**

1 On the Layers toolbar, click Layer Manager.

2 In the Layer Manager, select the layers you want to hide.

3 In the Hide column, click Off to turn Hide on for the highlighted layer(s).
   🎨 The hide icon displays.
You can hide all layers by clicking Hide/Unhide All Layers on the Layer Manager toolbar.

To freeze a layer:
Freezing layers is useful when you want to edit objects associated with particular layers but also want to view, without editing, objects on other layers. You can’t edit or select objects on a frozen layer; however, the objects are still visible if the layer is on. You can make a frozen layer current, and you can add new objects to the frozen layer.

1. On the main toolbar, click Layer Manager.
2. In the Layer Manager, highlight the layers you want to freeze.
3. In the Freeze column, click Off to turn Freeze on for the highlighted layer(s).

The Freeze icon displays.

You can freeze all layers by clicking Freeze/Unfreeze All Layers on the Layer Manager toolbar.

To assign a color to a layer:
You can assign a color to a layer using the Layer Manager dialog. For example, you can assign the color red to a layer named HVAC to help you identify the mechanical equipment in your scene.

1. On the main toolbar, click Layer Manager.
2. In the Layer Manager, select a layer and click the Color icon.
3. In the Layer Color dialog, select a color, and then click OK.
To rename a layer:
You might want to rename a layer to better define how it’s used in your scene. You can rename a layer at any time during a 3ds Max session. However, you can’t rename Layer 0.

1. On the main toolbar, click Layer Manager.
2. In the Layer Manager, select a layer to rename.
3. Click the layer’s name again and enter a new name.

To delete a layer:
You can delete an empty layer at any time during a 3ds Max session. However, you can’t delete the current layer, Layer 0, or a layer that contains objects.

1. On the main toolbar, click Layer Manager.
2. In the Layer Manager, select one or more layers, and then click Delete Empty Layer.

To open the Object Properties dialog for an object selection:

1. On the main toolbar, click Layer Manager.
2. Highlight one or more objects in the Layer Manager.
3. Click the Object Properties icon to open the Object Properties dialog on page 283 for the highlighted objects.

To open the Layer Properties dialog for a layer selection:

1. On the main toolbar, click Layer Manager.
2. Highlight one or more layers in the Layer Manager.
3. Click the Layer Properties icon of any of the highlighted layers (each layer’s icon is immediately to the left of the layer name in the list). This opens the Layer Properties dialog on page 7966 for the highlighted layers.
NOTE If you click the Layer Properties icon of an unhighlighted layer, the dialog opens for that layer only.

Interface

Title Bar

The title bar displays the word “Layer” followed by the name of the active Layer. For example, if Layer02 is the active layer, the title bar will read Layer: Layer02.

Layer Manager toolbar

Create New Layer Creates a new layer containing any selected objects. The new layer's name is generated automatically ("Layer01", "Layer02", and so on) but you can change it by clicking the label.
NOTE The new layer becomes the current layer.

Delete Highlighted Empty Layers Deletes highlighted layers if they are empty.

NOTE This button is unavailable if the highlighted set of layers contains any of the following: nothing (that is, no layers are highlighted), the active layer, objects, Layer 0, or non-empty layers.

Add Selected Objects to Highlighted Layer Moves currently selected objects into the highlighted layer.

NOTE This button is unavailable if nothing is selected or if more than one layer is highlighted.

Select Highlighted Objects and Layers Selects all of highlighted objects, as well as all objects contained in any highlighted layers.

NOTE This button is unavailable if nothing is highlighted.

Highlight Selected Objects' Layers Highlights layers containing the currently selected objects and automatically scrolls so that highlighted layers are visible in the layer manager.

NOTE This button is unavailable if nothing is highlighted.

Hide/Unhide All Layers Toggles the display of all layers.

TIP This is most useful if you hide all layers and then display only the layers you want to work on.

Freeze/Unfreeze All Layers Toggles the frozen state of all layers.

TIP This is most useful if you freeze all layers and then unfreeze only the layers you want to work on.
List of layers

Displays layers, their associated objects, and their properties. To expand or collapse the object list for each layer, click ‘+’ or ‘−’, respectively. To modify a property, click its icon. To select all layers quickly, right-click and choose Highlight All. To open the Object/Layer Properties dialog, click on the icon next to the layer or object.

Each property has a unique icon to indicate that it is turned on, while all properties share the same icon for the off (☐) and By Layer (☐) states.

NOTE By Layer is available only at the object level, in the Render, Color, and Radiosity columns.

TIP You can sort the layers by any of their properties by clicking the column name.

Layers Displays the names of the layers/objects. Click a name to select the layer, or to rename the layer.

NOTE Clicking the layer icon opens the Layer Properties dialog on page 7966 for all highlighted layers.

Clicking the object icon opens the Object Properties dialog on page 283 for all highlighted objects.

☐ Current Layer Toggle The unlabeled column to the right of the layer name indicates the current layer and lets you make a different layer current.

A check mark appears next to the current layer. Click the check box next to another layer name to make it current.

☐ Hide Hides and unhides layers. When a layer is hidden, it's invisible. You might want to hide layers that contain construction or reference information.

☐ Freeze Freezes layers. You can’t select or edit objects on a frozen layer. Freezing a layer is useful if you want to view information on a layer for reference but don’t want to edit objects on that layer.

☐ Render When on, objects appear in the rendered scene. Non-rendering objects don’t cast shadows or affect the visual component of the rendered scene. Like dummy objects, non-rendering objects can manipulate other objects in the scene.
**Shape objects** on page 572 have the Render option turned on by default. In addition, they have a Renderable check box in their creation parameters. When both check boxes are on, the shape is renderable. If either check boxes are off, the shape isn’t renderable. If you apply a modifier that converts the shape into a mesh object, such as a Lathe on page 1474 or Extrude on page 1425 modifier, the shape automatically becomes renderable regardless of the state of its local Renderable check box.

For shapes, the Renderable toggle in the Object Properties dialog on page 283 affects the main object, so it also affects all instances of and references to the shape.

**Color** Changes the color associated with the highlighted layers. You can select another color by clicking the color swatch to display either the Object Color dialog on page 368 (for objects), or the Layer Color dialog (for layers).

You can set an object’s color independently, or turn on ByLayer in the Object Color dialog to use the associated layer’s color.

**Radiosity** When on, objects are included in the radiosity solution on page 6615. Objects not included in the radiosity solution do not contribute to indirect illumination. If these objects are lights, only their direct contribution will be used for rendering.

**NOTE** Removing objects from the radiosity solution can significantly decrease radiosity processing and rendering time, however it does sacrifice some accuracy in the solution. It can be useful for creating quick test renders.
Layer Manager Right-Click Menu

<table>
<thead>
<tr>
<th>Rename</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut</td>
</tr>
<tr>
<td>Paste</td>
</tr>
<tr>
<td>Collapse All</td>
</tr>
<tr>
<td>Expand All</td>
</tr>
<tr>
<td>Create New Layer (add Selection)</td>
</tr>
<tr>
<td>Delete</td>
</tr>
<tr>
<td>Add Selected Objects</td>
</tr>
<tr>
<td>Select</td>
</tr>
<tr>
<td>Highlight Selected Objects' Layers</td>
</tr>
<tr>
<td>Highlight All Layers</td>
</tr>
<tr>
<td>Layer Properties…</td>
</tr>
<tr>
<td>Object Properties…</td>
</tr>
</tbody>
</table>

A standard popup menu is displayed over the Layer Manager by right-clicking anywhere in the Layer Manager dialog. The menu contains a variety of layer management and focus operations.

Some of the operations involve highlighted items or selected objects in your scene. If the right-click is on a non-highlighted row, the highlight switches to that row and the subsequent operation applies to the newly highlighted item. If the right-click is on a highlighted row (or a group of highlighted rows), all of the highlights are preserved and the subsequent operation applies to all of the highlighted items.

**NOTE** To apply an operation to a group of objects or layers, you must hold Ctrl when you right-click. If you have highlighted a group of objects and right-click on one of them (without holding Ctrl), the selection group is cleared and only that object will be highlighted.

**Rename** Initiates text editing mode for the highlighted layer’s name. Unique names are enforced. If a non-unique name is typed in, a modal dialog pops up, stating “Invalid Layer Name. Layer names must be unique.”
NOTE Rename is available only for layers; objects cannot be renamed in the Layer Manager. Likewise, Rename is only available when a single layer is highlighted.

Cut Stores references to highlighted objects in memory so they can be pasted into another layer.
Cut is only available when objects are highlighted; if there are no objects highlighted or if a layer is part of a multiple selection, it is not available.

NOTE Objects are not actually cut from their assigned layer until they are pasted to another one.

TIP If you cut a layer, 3ds Max cuts all objects in the layer.

Paste Moves cut objects into the highlighted layer.
Paste is available only when a single layer is highlighted and one or more objects have been cut.

Collapse All Closes all expanded layers, hiding the object lists.

Expand All Expands all layers, displaying the objects within each.

Create New Layer Creates a new layer containing any currently selected objects.
The new layer becomes the current layer. Its name is generated automatically ("Layer01", "Layer02", and so on) but can be changed by clicking its label.

Delete Deletes any empty highlighted layer.

NOTE This does not delete objects. Likewise, this command is not available when your selection includes Layer0, any objects, or any layer containing objects.

Add Selected Objects Places objects currently selected in your scene into the highlighted layer.

NOTE This command is available only when a single layer is highlighted.

Select Selects all of the currently highlighted objects or layers in the Layer Manager.

NOTE If you use this command on a layer, all objects in that layer are selected.

Highlight Selected Objects' Layers Highlights all layers that contain objects in the current scene selection.

Highlight All Layers Highlights all of the layers in your scene.
NOTE This command does not highlight any objects.

Layer Properties Opens the Layer Properties dialog on page 7966 for the currently highlighted layers.

Object Properties Opens the Object Properties dialog on page 283 for the currently highlighted objects.

Layer Properties Dialog

Main toolbar > Layer Manager > Select one or more layers. > Click Layer icon.

Layer Manager > Right-click a layer. > Layer Properties

The Layer Properties dialog is similar to the Object Properties dialog on page 283. Here, you can change the rendering, motion blur, and display settings of one or more selected layers. In addition, you can also change the advanced lighting settings or hide/freeze one or more selected layers.
Interface

Layer Properties Dialog

Layer Information
- Name: 0 (default)
- Active Color: [a color swatch]
- Display: Viewport

General
- Interactivity:
  - Hide
  - Freeze

Display Properties
- See-Through
- Display As Box
- Backface Cull
- Edges Only
- Vertex Ticks
- Trajectory
- Ignore Extents
- Show Frozen in Gray
- Vertex Colors

Advanced Lighting
- Rendering Control
  - Visibility: [a slider]
  - Renderable
  - Inherit Visibility
  - Visible to Camera
  - Visible to Reflection/Refraction
  - Receive Shadows
  - Cast Shadows
  - Apply Atmospherics
  - Render Occluded Objects

Motion Blur
- Multiplier: [a slider]
- Enabled
  - None
  - Object
  - Image
Layer Information group

Controls layer information for objects on the selected layer.

Name Displays the selected layer name, which you can edit. The name can contain up to 255 characters, including letters, digits, blank spaces, and the special characters dollar sign ($), hyphen (-), and underscore (_).

Active Color Displays the color of the selected layer. You can select another color by clicking the color to display the Layer Color dialog, which is identical to the Object Color dialog on page 368, except that it doesn't have the By Layer/By Object toggle.

Display Controls the display of the objects on the selected layer.

Viewport Displays the objects on the selected layer using the current settings chosen in the viewport label menus on page 8117.

Bounding Box Displays the objects on the selected layer as a bounding box on page 8528.

Wireframe Displays the objects on the selected layer in wireframe mode on page 8766.

Shaded Displays the objects on the selected layer in Smooth+Highlight mode on page 8117.
General panel

Interactivity group

Hide Hides the selected layer.

Freeze Freezes the selected layer.

Display Properties group

Provides controls that alter the display of objects on the selected layer.

See-Through Makes objects on the selected layer translucent in viewports. This setting has no effect on rendering, it simply lets you see what's behind an object in a crowded scene, and especially to adjust the position of objects behind or inside the See-Through object.

Display As Box Toggles the display of objects on the selected layers, including 3D objects and 2D shapes as bounding boxes on page 8528. Produces minimum geometric complexity.
**Backface Cull** For objects on the selected layer, toggles the display of faces with normals pointing away from view. When on, you see through the wireframe to the back faces. Applies only to Wireframe viewport display.

**Edges Only** For objects on the selected layer, toggles the display of face edges. When set, only faces appear. When off, all mesh geometry appears. Applies only to Wireframe viewport display.

**Vertex Ticks** Displays the vertices in objects on the selected layer as tick marks. If the current selection has no displayed tick marks, the check box is clear. If some of the vertices in the current selection display tick marks, the check box contains a gray X. If all vertices in the current selection display tick marks, the check box contains a black X.

**Trajectory** Toggles trajectory display for objects on the selected layer. You can display an object's trajectory wherever you are in 3ds Max.

**Ignore Extents** When turned on, objects on the selected layer are ignored when you use the display control Zoom Extents on page 8144.

**Show Frozen in Gray** When on, the object turns gray in viewports when you freeze it. When off, viewports display the object with its usual color or texture even when it is frozen.

**Vertex Colors** Affects editable mesh objects on page 2192 on the selected layer. Displays the assigned vertex colors in the viewport. You assign vertex colors at the vertex or face sub-object levels.

**Shaded** Affects editable mesh objects on page 2192 on the selected layer. When on, if the editable mesh has vertex colors, shaded viewports use vertex colors to shade the mesh. When off, colors are unshaded.

**Rendering Control group**

Controls rendering settings for objects on the selected layer.

**Visibility** Controls the rendered visibility of the object. At 1.0, the object is fully visible. At 0.0, the object is completely invisible when rendered. Default=1.0.

**Renderable** Makes objects on the selected layer appear or disappear from the rendered scene. For more information, see Renderable on page 7962.

---

**NOTE** This has the same functionality as the Render toggle in the layer list on page 7974.
Inherit Visibility Causes objects on the selected layer to inherit the visibility of their parents (as determined by the parent's Visibility track in Track View). When a group parent is assigned a visibility track, Inherit Visibility is automatically turned on for all children in the group. Transparent materials and hidden objects have no effect on this function.

Visible to Camera When on, the object is visible to cameras in the scene. When off, cameras do not view this object.

Visible to Reflection/Refraction When on, the object is used in calculating reflections and refractions. When off, the object does not appear in reflections or refractions.

Receive Shadows When on, objects on the selected layer can receive shadows.

Cast Shadows When on, objects on the selected layer can cast shadows.

Apply Atmospherics When on, atmospheric effects are applied to the object. When off atmospheric effects do not change the rendered appearance of this object.

Render Occluded Objects Allows special effects to affect objects in the scene that are occluded by this object. The special effects, typically applied by plug-ins on page 8687 such as Glow on page 7073, use G-Buffer on page 8589 layers to access occluded objects. Turning on this control makes the object transparent for the purposes of special effects. This makes no difference when you render to most image files. When you render to either the RLA on page 7873 or RPF on page 7875 file format, however, occluded objects appear with the effect applied on their designated G-buffer layer.

Motion Blur group

Controls motion blur for objects on the selected layer.

Multiplier Affects the length of the motion blur streak.

Enabled When on, enables motion blur for this object. When off, motion blur is disabled regardless of the other blur settings. Default=on.

None Turns off the state of motion blur for objects on the selected layer.

Object Object motion blur on page 8658 provides a time-slice blur effect for objects on the selected layer.

Image Image motion blur on page 8606 blurs the image of each object on the selected layer, based on the velocity of each pixel.
Adv. Lighting panel

Radiosity Properties group

Exclude from Radiosity Processing When on, objects on a selected layer are included in the radiosity solution. Objects not included in the radiosity solution do not contribute to indirect illumination. If these objects are lights, their direct contribution will only be used for rendering.

NOTE This has the same functionality as the Radiosity toggle in the Layer List.

Cast Shadows Determines whether objects on the selected layer will cast shadows.

Receive Illumination Determines whether objects on the selected layer will receive illumination.

Diffuse (reflective & translucent) When on, objects on the selected layer are treated as diffuse (rough) in the radiosity process.
Specular (reflective & transparent) When on, objects on a selected layer are treated as specular (smooth) in the radiosity process.

Exclude from Regathering When on, objects on a selected layer are excluded from the regathering process of the radiosity solution.

For more information on the Radiosity Properties group, see Radiosity Control Panel on page 6634.

Object Subdivision Properties group

Use Global Subdivision Settings When on, the object’s meshing settings correspond to the global subdivision settings on the Radiosity Control Panel. When off, you can change the meshing settings for each object. Default=on.

- **Subdivide** When on, a radiosity mesh is created for the objects regardless of the global meshing state. The subdivision that is performed is determined by the Use Adaptive Subdivision switch. When off, the settings in the Mesh Settings group are unavailable. Default=on.

- **Use Adaptive Subdivision** Turns adaptive subdivision on and off. Default=on.

**NOTE** The Mesh Settings group parameters Contrast Threshold, Min Mesh Size, and Initial Mesh Size are available only when Use Adaptive Subdivision is turned on.

Mesh Settings group

**Max Mesh Size** The size of the largest faces after adaptive subdivision. Default=36” for imperial units and 100cm for metric units.

When Use Adaptive Subdivision is turned off, Max Mesh Size sets the size of the radiosity mesh in world units.

**Min Mesh Size** Faces are not divided smaller than the minimum mesh size. Default=3” for imperial units and 10cm for metric units.

**Contrast Threshold** Faces that have vertex illuminations that differ by more than the Contrast Threshold settings are subdivided. Default=75.0.

**Initial Mesh Size** When improving the face shape, faces that are smaller than the Initial Mesh Size are not subdivided. The threshold for deciding whether a face is poorly shaped also gets larger as the face size is closer to the Initial Mesh Size. Default=12” for imperial units and 30cm for metric units.
Layer List

Layers toolbar on page 8040 > Layer List

The Layer List, available from the Layers toolbar on page 8040, displays layer names and their properties. You can control the properties of layers by clicking the property icons. You can make a layer current by simply selecting it from the list.

The controls available in the Layer List are a subset of the controls available in the Layer Manager. For more information, see Layer Manager on page 7956.

TIP The Layer List is most useful in conjunction with the other tools available on the Layers toolbar on page 8040.

See also:

■ Using Layers to Organize a Scene on page 7953

Procedures

To make a layer current:

1 Click Layers toolbar > Layer List to display the list.

2 Click in the first (left) column next to the layer you want to make current. A check mark appears next to the current layer.

3 Click the layer list again to collapse it.

4 Select the layer you want to make current from the list. It is now the current layer.

To change the layer of a selected object:

1 Click Layers toolbar > Layer List to display the list.

2 Select the desired destination layer to make it current.

3 On the Layers toolbar, click Add Selected Objects To Current Layer.
To change a layer's properties:

1. Click Layers toolbar > Layer List to display the list.
2. Click the layer property icon that you want to set.
   You can change the following properties from the layer list: hide/unhide, freeze/unfreeze, renderable/non-renderable, and color.
3. Click the Layer List again to collapse it.

Interface

You can change the following properties from the layer list: hide/unhide, freeze/unfreeze, renderable/non-renderable, and color.

Unlike the Layer Manager, where one icon is used for all Off states, the 'Off' icons for each property on the Layer List are unique.

The following are the On and Off icons for each toggled property in the Layer List:

<table>
<thead>
<tr>
<th>Property</th>
<th>On</th>
<th>Off</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide/Unhide</td>
<td>🅓 (Hidden)</td>
<td>🅴 (Visible)</td>
</tr>
<tr>
<td>Freeze/Unfreeze</td>
<td>🅏 (Frozen)</td>
<td>🅴 (Editable)</td>
</tr>
<tr>
<td>Renderable/Non-Render-able</td>
<td>🅔 (Renderable)</td>
<td>🅴 (Non-renderable)</td>
</tr>
</tbody>
</table>

Create New Layer

Layers toolbar on page 8040 > Create New Layer

Layers toolbar on page 8040 > Layer Manager > Create New Layer
Create New Layer creates a new layer the layer containing the currently selected objects. The new layer's name is automatically generated (“Layer01”, “Layer02”, and so on) but may be changed in the Layer Manager on page 7956.

Add Selection to Current Layer

Layers toolbar on page 8040 > Add Selection to Current Layer

Add Selection To Current Layer moves the current object selection to the current layer.

Select Objects in Current Layer

Layers toolbar on page 8040 > Select Objects in Current Layer

Select Objects In Current Layer selects all of the objects contained in the current layer.

Set Current Layer to Selection's Layer

Layers toolbar on page 8040 > Set Current Layer to Selection's Layer

Set Current Layer To Selection's Layer changes the current layer to the layer which contains the currently selected objects.

NOTE This button is not available if your selection includes objects that reside on different layers.
Utilities

This section contains links to the various utilities provided with 3ds Max.

See also:
- Utilities Panel on page 8223
- Utilities Dialog on page 8225
- Configure Button Sets Dialog on page 8225

List of Available Utilities

The table of contents for this help lists utilities alongside the features they support. This topic provides a consolidated, alphabetical list.

- Asset Browser Utility on page 7614
- Assign Vertex Colors Utility on page 6477
- Batch ProOptimizer Utility on page 2768
- Bitmap/Photometric Path Editor Utility on page 7629
- Camera Match Utility on page 5609
- Camera Tracker Utility on page 4158
Material XML Exporter Utility on page 5638
MAX File Finder Utility on page 7634
Measure Utility on page 2882
Motion Capture Utility on page 4137
Panorama Exporter Utility on page 6898
Rescale World Units Utility on page 2884
Reset XForm Utility on page 912
Resource Collector Utility on page 7637
Shape Check Utility on page 665
Skin Utilities on page 4213
Strokes Utility on page 8417
Surface Approximation Utility (NURBS) on page 2748
UVW Remove Utility on page 6200
Visual MAXScript Utility (See MAXScript Help) on page 8231
MAXScript Utility on page 21
reactor Utility on page 4219

See also:
- Track View Utilities on page 3919
The 3ds Max user interface provides multiple ways to achieve the same goals. You can hide, float on page 8555 or dock on page 8555, resize and rearrange the user interface elements into your own personal design. For more information, see Customizing the User Interface on page 8235.

See the topics referenced below for detailed information on the major elements of the user interface.
Additional Keyboard Commands

This topic describes some commands that are provided only as customizable actions. You can assign them to a keyboard shortcut, a menu, or a button by using the Customize User Interface dialog on page 8249.

See also:

- Keyboard Shortcuts on page 8419
- Unwrap UVW Shortcuts on page 1879

Keyable Property

Keyable Property Toggle

Default key: None

In Track View, if you select any track or group of tracks, this command turns the keyable property on page 3864 on or off. If a selected track is not keyable, its children (sub-animations), if any, are toggled. For example, if you select a transform controller track, this command toggles the keyable property of all position, rotation, and scale tracks. If you select an object's track, its transform, parameter, and material tracks are all toggled. If the object is part of a hierarchy, all its child objects' tracks are also toggled.

This action can be undone.

Set Key

Clear Set Key Mode Buffer

Default key: None

While in Set Key mode, if you transform an object but haven't yet clicked Set Key, this shortcut undoes the transformation and restores the viewport to show the animation that existed before the change.

Another way to accomplish this is to move the time slider or to turn on Play.

Transforms

Create Position Lock Key and Create Rotation Lock Key

Default keys: None
A lock key is a key with Linear interpolation. If you create the lock key while an existing key is selected, it changes that key’s interpolation from Smooth to Linear. (Different types of interpolation are described in Bezier Controllers on page 3432.) You can create a lock key for position or for rotation.

Lock keys are useful when you want an object to be stationary, but smooth interpolation is causing it to “wobble” on its stationary spot.

**Position to Zero**

Default key: None

Like its counterparts on the Animation quad menu on page 8058, this shortcut restores the object’s position to the initial “frozen” pose (0,0,0).

**NOTE** Position To Zero works only if you have previously invoked Freeze Transform on page 8060 on the Animation quad menu.

**Viewport Navigation**

**Pan Viewport**

Default key: I (the letter “i”)

Pans the active viewport, centering it on the current location of the cursor.

You can use this shortcut while another command, such as Move, is active.

This action can be undone, using Shift+Z.

**Toggling Dialogs**

In most cases, you can close a dialog with the same command used to open it. This applies to any combination of input methods, including menu, toolbar button, and keyboard shortcuts. For example, you can open the Render Setup dialog by choosing Rendering > Render Setup, and then close it by pressing F10 (default keyboard shortcut). If a dialog is available from a menu, a check mark appears next to the respective command while it’s open.

If a dialog is minimized, invoking its command opens the dialog, and invoking it a second time closes the dialog.

In addition, the keyboard shortcut Ctrl+~ (tilde) toggles display of any open dialogs, in most cases.
The dialogs affected by this functionality are:

- Asset Browser
- Bone Tools
- Channel Info Editor
- Clone and Align dialog
- Display Floater
- Environment and Effects dialog
- Grid and Snap Settings dialog
- Layer Manager
- Light Lister
- Material Editor
- Material/Map Browser (modeless version)
- mental ray Messages Window
- Parameter Collector
- Parameter Editor
- Rename Objects
- Render dialog
- Render to Texture
- Rigid Body Property editor
- Selection Floater
- Spacing Tool
- Transform Type-In
- Video Post

The one exception is Particle View, which is toggled by its keyboard shortcut (6), but is not toggled by the Modify panel > Particle View button.
Starting 3ds Max from the Command Line

You can start 3ds Max from the command line in a Command Prompt window, or include the command line in a batch file. There are a number of switches that you can use on the command line.

To start 3ds Max from the command line:

1. Open a Command Prompt window.
2. Change directory to the 3ds Max root directory, if this directory is not in your PATH statement.
3. Type `3dsmax` to start 3ds Max. Optionally, add a command-line switch (see below).

Command-Line Switches

You can use the following switches after `3dsmax` on the command line.

<table>
<thead>
<tr>
<th>Switch</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>-c othercui</code></td>
<td>Starts program using <code>othercui.cui</code> instead of <code>maxstart.cui</code>.</td>
</tr>
<tr>
<td><code>-d</code></td>
<td>Causes Track View to use a double-buffered display, which is smoother than the single-buffered display but uses more system resources.</td>
</tr>
<tr>
<td><code>-g</code></td>
<td>Makes background white (instead of gray) in the following dialogs: Track View, RAM Player, Video Post, Loft, and Falloff Curve. Useful for screen captures when using a display mode less than 24 bits deep, for avoiding background patterns.</td>
</tr>
<tr>
<td><code>-i otherfile</code></td>
<td>Starts program using <code>otherfile.ini</code> instead of <code>3dsmax.ini</code>.</td>
</tr>
<tr>
<td>Switch</td>
<td>Effect</td>
</tr>
<tr>
<td>----------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>-l</td>
<td>Loads the last .max file automatically.</td>
</tr>
<tr>
<td>-ma</td>
<td>Open maximized.</td>
</tr>
<tr>
<td>-mi</td>
<td>Open minimized.</td>
</tr>
<tr>
<td>-n</td>
<td>Disables network mode.</td>
</tr>
<tr>
<td>-p other-file</td>
<td>Starts program using otherfile.ini instead of plugin.ini.</td>
</tr>
<tr>
<td>-q</td>
<td>Starts program &quot;quietly,&quot; without the splash screen.</td>
</tr>
<tr>
<td>-s</td>
<td>Starts program in server mode.</td>
</tr>
<tr>
<td>-u</td>
<td>Opens utility.</td>
</tr>
<tr>
<td>-v</td>
<td>Loads a display driver. See details following, under &quot;Using the −V Option.&quot;</td>
</tr>
</tbody>
</table>

**NOTE** It is not possible to select which version of Direct3D you will use with this switch.

| -z       | Writes version number to file. See details following, under "Using the −Z Option." |

A space must separate 3ds Max executable name and the command-line switch.

Examples:

3dsmax −l
3dsmax −i otherfile
3dsmax anyscene
3dsmax –c MaxCustom

See also:
- Startup Files and Defaults on page 59
- Saving and Loading Custom User Interfaces on page 8276
- Graphics Driver Setup Dialog on page 8313
- Running Scripts from the Command Line on page 8232

Using the -V Option

You use the -V option to load a different display driver at startup. This option overrides the setting in 3dsmax.ini.

Follow the -V with one of these letters for the driver you want to use:
s: Loads the software driver.
o: Loads the OpenGL driver.
d: Loads the Direct3D driver.
n: Loads a null driver.

For example, if you ordinarily run OpenGL and want to switch to the software driver for a session, you would type: 3dsmax –vs

Using the -Z Option

If you call product support, the representative might ask you to run this option to determine the exact version of your software. This option only writes to a file; it does not start 3ds Max.

Follow the -Z with a file name:
3dsmax –z id.txt

The file (in this example, id.txt) is written to the 3ds Max root directory.
Caption Bar

The Caption bar or title bar of the 3ds Max window contains commonly used controls for managing your files and for finding information.

Interface

Application button

Click the Application button to display the Application menu on page 7989 for file-handling commands.

Quick Access toolbar

The Quick Access toolbar on page 7995 provides buttons for commonly used commands for managing your scene files.

InfoCenter

The InfoCenter on page 7997 gives you access to information about 3ds Max and other Autodesk products.

Window controls

As in all Windows applications, the right of the caption bar has three buttons to control the window:

- Minimize
  Minimizes the window.

- Maximize/Restore
  Maximizes the window, or restores it to its previous dimensions.

- Close
  Closes the application.
Quick Access toolbar > Click the Application button. > Application menu
Keyboard > Alt+F

The Application menu that appears when you click the Application button provides file-management commands.
NOTE Most submenus of the Application menu fit onto one page. If there are more options than the page has room, a bar with an arrow appears at the top or bottom of the page, to let you scroll among the submenu choices.

Scrolling arrow at the bottom of the Recent Documents page
Recent Documents page

When you first open the Application menu, and when no other menu choice is active, the Application menu shows a list of files you have edited recently. The scene files are organized by date, and you can collapse or expand the list for each day, using the arrow icon at the right of each date's title bar.

**TIP** When you open the Application menu by using the keyboard shortcut Alt+F, it displays the associated shortcuts for menu choices, so you can easily press the key for the choice you want. If you move the mouse instead of pressing another key, the menu reverts to its usual appearance, but pressing Alt+F again restores the shortcut display.

**Icon or Image display** Click this control to display a submenu that lets you choose which icons to use on the Recent Documents page.

- **Small Icons** (The default.) Displays a small application icon before each file name.
- **Large Icons** Displays a larger application icon before each file name.
Medium Images  Displays a small version of the viewport thumbnail image on page 8306 that by default is saved with the scene.

Large Images  Displays a larger version of the viewport thumbnail image on page 8306 that by default is saved with the scene.

Pinning a file to the list The pushpin icons let you keep a file in the recent files list. In the Recent Documents list, one of these icons appears to the right of each file name. 3ds Max limits the number of files to display as Recent Documents. By default, the number is 10. You can change this value on the Files panel of the Customize User Interface dialog: see Recent Files in File Menu on page 8307.

If the pushpin is in its default state of off, and if you open more files than the limit (by default, the eleventh file), then the oldest file is removed from the list.

If you click the pushpin icon to turn it on, then 3ds Max won’t remove the file from the list. If the limit is reached, then an unpinned file is removed from the list, even if it is newer than the pinned file. If all files in the list are pinned and you reach the limit, then opening a new file does not add the new file to the list.

All pages

Two buttons always appear at the bottom of the Application menu:

Options on page 8298
Exit 3ds Max on page 7612

Menu items

NOTE  File dialogs (such as Open, Save, Save As) uniformly remember the previous path you used, and default to that location.
New on page 7432
- New All
- Keep Objects
- Keep Objects and Hierarchy

Reset on page 7433

Open >
- Open on page 7434
- Open from Vault on page 7438

Save on page 7440

Save As >
- Save As on page 7441
- Save Copy As on page 7443
- Save Selected on page 7444
- Archive on page 7445

Import >
- Import on page 7446
- Merge on page 7572
- Replace on page 7578

Export >
- Export on page 7581
- Export Selected on page 7583
- Export to DWF on page 7700
Quick Access Toolbar

3ds Max > Quick Access toolbar

The Quick Access toolbar provides some of the most commonly used file-management commands, as well as Undo and Redo.

**NOTE** As with other toolbars, you can customize the Quick Access toolbar on the Toolbars panel on page 8252 of the Customize User Interface panel.

You can also delete a button directly from the toolbar by right-clicking it and choosing Remove From Quick Access Toolbar. In addition, you can add any button from the modeling ribbon on page 2025 by right-clicking the button and choosing Add To Quick Access Toolbar.

Interface
New Scene  Click to begin a New on page 7432 scene.

Open File  Click to Open on page 7434 a saved scene.

Save File  Click to Save on page 7440 the currently open scene.

Undo Scene Operation  Click to undo the previous operation. Click the down-arrow to display an ordered list of previous operations, so you can choose the point from which to undo your work. See Undo/Redo on page 240.

Redo Scene Operation  Click to redo the previous operation. Click the down-arrow to display an ordered list of previous operations, so you can choose the point from which to redo your work. See Undo/Redo on page 240.

Project Folder  Click to open a dialog that lets you set the project folder on page 7583 for the current scene.

Quick Access toolbar drop-down menu  Click to display a drop-down menu for managing Quick Access toolbar display.

TIP  You can also customize the Quick Access toolbar, like any other 3ds Max toolbar, with the Toolbars panel on page 8252 of the Customize User Interface dialog.

Customize Quick Access Toolbar:

- [Quick Access toolbar choices]  Each choice toggles display of a button on the Quick Access toolbar.
- Hide Menu Bar  Choose this to hide or show the menu bar on page 7998.
- Show Below/Above the Ribbon  Choose this to display the Quick Access toolbar either just below the modeling ribbon on page 2025, as a part of the ribbon, or “above” it in the default location on the Caption bar.
NOTE This option is available only when the modeling ribbon is open using the horizontal format, and attaches the Quick Access toolbar to the ribbon. If you then close the ribbon, the toolbar closes as well. To restore it, open the ribbon.

Quick Access Toolbar Right-Click Menu

When you right-click a button on the Quick Access toolbar, 3ds Max opens a drop-down menu with several choices.

Remove from Quick Access Toolbar Turns off display of the button you clicked. This is the same as turning off its display by using the Quick Access toolbar drop-down menu. You can turn display of the button back on by using that same drop-down menu.

Add Separator Adds a separator, a vertical line (usually gray), to the right of the button. This can help make the toolbar more legible.

To remove a separator, right-click it and choose Remove From Quick Access Toolbar.

Show Quick Access Toolbar Above/Below the Ribbon Choose this to display the Quick Access toolbar either just below the modeling ribbon on page 2025, as a part of the ribbon, or “above” it in the default location on the Caption bar.

NOTE This option is available only when the modeling ribbon is open using the horizontal format, and attaches the Quick Access toolbar to the ribbon. If you then close the ribbon, the toolbar closes as well. To restore it, open the ribbon.

InfoCenter

The InfoCenter gives you access to information about 3ds Max and other Autodesk products. It appears toward the right of the Caption bar.

Interface

Search field Enter text to search for. See Search For and Receive Information on page 8421.

Use the arrow to the left of the Search Field to either hide or display this field.
Search: After you enter text in the Search Field, click Search to find help topics and Web pages that contain this text. See Search For and Receive Information on page 8421.

Subscription Center: Click to access subscription services. See Access Subscription Center on page 8437.

Communication Center: Click to access the Communication Center. See Overview of Communication Center on page 8427.

Favorites: Click to view the Favorites panel. See Save and Access Favorite Topics on page 8429.

Quick Help menu: Click the question-mark button to display the 3ds Max help. Click the down-arrow to access other commonly used help files. The main help and the choices on this menu are available from the 3ds Max Help menu on page 8032 as well.

Menu Bar

The menu bar is located directly under the main window’s title bar. The title of each menu indicates the purpose of the commands on the menu. Each menu uses standard Microsoft Windows conventions.

NOTE: File functions and related commands are available from the Quick Access toolbar on page 7995 and Application menu on page 7989, which are separate from the menu bar.

Interface

When you click a menu name, a number of commands are listed below it.

As an alternative to using your mouse (or other pointing device), each menu name includes an underlined character. Pressing that character key while
holding down the Alt key opens the menu, unless that particular key combination is assigned to a keyboard shortcut. Some commands and subheadings in the open menu have an underlined character as well. While the menu is open, pressing that character key invokes the command. While navigating menus with the keyboard, you can also use the arrow keys to move the highlighting and the Enter key to activate a command or open a submenu.

An ellipsis (…) after a command name indicates that invoking the command opens a dialog.

A right-pointing triangle after a command name indicates that a submenu will appear.

If a command has a keyboard shortcut, the menu displays it to the right of the command name.

If a menu command is an on/off toggle, a check mark indicates its status: If a check mark is present, the command is active.

**Edit Menu**

Menu bar > Edit

The Edit menu contains commands for selecting and editing objects in a scene.

**Interface**

*Undo/Redo* on page 240

*Hold/Fetch* on page 242

*Delete* on page 243
*Clone* on page 992

*Move* on page 914
*Rotate* on page 915
*Scale* on page 917
Transform Type-In on page 899
Transform Toolbox on page 936

Select All on page 227
Select None on page 227
Select Invert on page 228

Select Similar on page 228
Select Instances Selects all instances on page 8611 of the selected object. Unavailable if the object has no instances, or if multiple objects are selected.

Select By on page 229>
- Name on page 229
- Layer on page 230
- Color on page 229

Selection Region on page 230>
- Rectangular Region on page 230
- Circular Region on page 231
- Fence Region on page 232
- Lasso Region on page 233
- Paint Selection Region on page 234
- Window/Crossing on page 239

Manage Selection Sets on page 224
Tools Menu

Menu bar > Tools

The Tools menu displays dialogs that help you change or manage objects, especially collections of objects, in your 3ds Max scene.

Interface

Open Scene Explorer on page 7888 (Opens the most recently accessed scene explorer)

New Scene Explorer on page 7888

Manage Scene Explorer on page 7908

Saved Scene Explorers on page 7888 (when one or more scene explorers exist)

Containers submenu on page 8003

Isolate Selection on page 198

Display Floater on page 8218

Manage Layers on page 7956

Manage Scene States on page 7915

Light Lister on page 5343
Mirror on page 940
Array on page 944
Align submenu on page 8003
Snapshot on page 950

Rename Objects on page 306

Assign Vertex Colors on page 6477
Color Clipboard on page 378
Camera Match on page 5609

Viewport Canvas on page 6455

Grab Viewport on page 125

Grids and Snaps submenu on page 8004
Measure Distance on page 2881

Channel Info on page 6486

Graphite Modeling Tools on page 2025
Containers Submenu

Menu bar > Tools > Containers

The Containers submenu provides functions for grouping and managing scene content with the Container on page 7395 helper object.

Interface

- Inherit Container on page 7429
- Create Container From Selection on page 7429
- Select Content’s Container on page 7417
- Load Container on page 7430
- Unload Container on page 7430
- Open Container on page 7430
- Close Container on page 7430
- Update Container on page 7430
- Edit Container on page 7431
- Make All Content Unique on page 7431
- Override Object Properties on page 7431
- Local Content on page 7426
- Add to Container on page 7426
- Remove from Container on page 7427
- Save Container on page 7427
- Reload Container on page 7427
- Inherited Content on page 7427
- Merge Container Source on page 7427

Align Submenu

Menu bar > Tools > Align
The Align submenu contains functions for aligning objects in the scene, as well as for creating aligned objects.

**Interface**

- Align on page 967
- Quick Align on page 972
- Spacing Tool on page 953
- Clone and Align on page 961

---

- Align to View on page 979
- Normal Align on page 973
- Align Camera on page 978
- Place Highlight on page 976

### Grids and Snaps Submenu

Menu bar > Tools > Grids and Snaps

The Grid And Snaps submenu contains commands for using grids and snapping tools to help lay out scenes precisely.

**TIP** You can access many of these commands from the main toolbar on page 8035, with keyboard shortcuts, or with right-click options. For example, you can display the Grid And Snap Settings dialog by right-clicking the Snaps buttons on the main toolbar.

**Interface**

- Grid and Snap Settings on page 2819

---

- Show Home Grid on page 2796
- Activate Home Grid on page 2797
- Activate Grid Object on page 2797
Group Menu

Menu bar > Group

The Group menu contains functions for grouping and ungrouping objects in the scene.

See also:
- Using Groups on page 243
- Using Assemblies on page 247

Interface

Group on page 258
Ungroup on page 261

Open on page 260
Close on page 260

Attach on page 263
Detach on page 262

Explode on page 261
Views Menu

Menu bar > Views

This menu contains commands for setting up and controlling viewports. For ease of use, some of the commands found on this menu also appear on the viewport label menus on page 8117.

**NOTE** The following commands, also influencing viewport behavior, are accessed from a different menu:

- **Units Setup Dialog** on page 8366
- **Grid and Snap Settings** on page 2819

Interface

**Undo View Change / Redo View Change** on page 126

Viewport Configuration on page 8374

Redraw All Views on page 154
Set Active Viewport on page 8126
Save Active View on page 127
Restore Active View on page 128

ViewCube submenu on page 88 (also see ViewCube configuration on page 8400)
SteeringWheels submenu on page 97

Create Camera From View on page 150

Show Materials in Viewport As on page 5696

Viewport Lighting and Shadows >

- **Auto Display Selected Lights**  When on, light from selected lights is automatically displayed in shaded viewports. Default=off. This option is equivalent to the same option in the Lighting And Shadows tab on page 8392 for viewport configuration: changing the setting here changes the active setting in the preferences dialog, and vice versa.

- **Lock Selected Lights**  Locks the selected lights. To “lock” a light means that the light will stay on until it is unlocked, whether or not the light casts shadows. When a light is locked, choosing Display Only Selected Lights or Auto Display Selected Lights does not turn it off.

- **Unlock Selected Lights**  Unlocks the selected lights.

**NOTE**  See also Previewing Shadows and Other Lighting in Viewports on page 5335.
Create Menu

Menu bar > Create

The Create menu provides a way to create geometry, lights, cameras, and helper objects on page 2839. It is organized into various submenus.

See also:
- Create Panel on page 8182
Interface

Standard Primitives >
- Box on page 389
- Cone on page 392
- Sphere on page 396
- GeoSphere on page 401
- Cylinder on page 403
- Tube on page 406
- Torus on page 409
- Pyramid on page 413
- Teapot on page 416
- Plane on page 419

Extended Primitives >
- Hedra on page 423
- Torus Knot on page 426
- Chamfer Box on page 430
- Chamfer Cylinder on page 433
- Oil Tank on page 436
- Capsule on page 439
- Spindle on page 442
- L-Extrusion on page 445
- Gengon on page 448
- C-Extrusion on page 451
- RingWave on page 453
- Hose on page 460
- Prism on page 458
AEC Objects >
- Foliage on page 474
- Railing on page 482
- Wall on page 491
- Pivot Door on page 535
- Sliding Door on page 537
- BiFold Door on page 539
- Straight Stair on page 519
- L-Type Stair on page 511
- U-Type Stair on page 522
- Spiral Stair on page 514
- Awning Window on page 549
- Casement Window on page 552
- Fixed Window on page 554
- Pivoted Window on page 556
- Sliding Window on page 560
- Projected Window on page 558

Compound >
- Morph on page 667
- Scatter on page 674
- Conform on page 688
- Connect on page 695
- BlobMesh on page 701
- ShapeMerge on page 709
- Boolean on page 713
- Terrain on page 730
Loft on page 742
Mesher on page 794
ProBoolean on page 801
ProCutter on page 823

Particles >
Particle Flow Source on page 3034
Spray on page 3306
Snow on page 3310
Blizzard on page 3319
PAarray on page 3331
PCloud on page 3324
Super Spray on page 3315

Patch Grids >
Quad Patch on page 2410
Tri Patch on page 2413

NURBS >
CV Surface on page 2460
Point Surface on page 2456
CV Curve on page 2473
Point Curve on page 2466

Dynamics >
Damper on page 842
Spring on page 849
mental ray >
- mr Proxy on page 562

Shapes >
- Line on page 584
- Rectangle on page 588
- Circle on page 590
- Ellipse on page 591
- Arc on page 592
- Donut on page 596
- NGon on page 597
- Star on page 599
- Text on page 600
- Helix on page 605
- Section on page 607

Extended Shapes >
- WRectangle on page 611
- Channel on page 613
- Angle on page 615
- Tee on page 617
- Wide Flange on page 618

Lights >
- Photometric Lights >
  - Target Light on page 5351
- Free Light on page 5354
- mr Sky Portal on page 5537

- Standard Lights >
  - Target Spotlight on page 5399
  - Free Spotlight on page 5402
  - Target Directional on page 5405
  - Directional on page 5407
  - Omni on page 5410
  - Skylight on page 5412
  - mr Area Spot on page 5421
  - mr Area Omni on page 5418
  - Add Default Lights to Scene on page 152

- Daylight System on page 5491

- Cameras >
  - Free Camera on page 5554
  - Target Camera on page 5556
  - Create Camera From View on page 150

- Helpers >
  - Dummy on page 2840
  - Expose Transform on page 2841
  - Grid on page 2847
  - Point on page 2853

- Container on page 7395

Create Menu | 8013
Tape Measure on page 2855
Protractor on page 2858
Compass on page 2860
Camera Point on page 5615
Delegate on page 5154
Crowd on page 5162
Atmospherics >
  Box Gizmo on page 7237
  Cylinder Gizmo on page 7240
  Sphere Gizmo on page 7243
Manipulators >
  Slider on page 2868
  Plane Angle on page 2865
  Cone Angle on page 2861
Particle Flow >
  Speed by Icon on page 3112
  Find Target on page 3247
  Particle Paint on page 3197
  Birth Texture on page 3057
  Initial State on page 3069
  Group Select on page 3078
Space Warps >

- Forces >
  - Motor on page 2898
  - Push on page 2894
  - Drag on page 2908
  - Vortex on page 2903
  - Path Follow on page 2919
  - PBomb on page 2914
  - Displace on page 2930
  - Gravity on page 2923
  - Wind on page 2926

- Deflectors >
  - PDynaFlect on page 2941
  - POmniFlect on page 2935
  - SDynaFlect on page 2948
  - SOmniFlect on page 2946
  - SDeflector on page 2953
  - UDynaFlect on page 2951
  - UOmniFlect on page 2948
  - UDeflector on page 2956
  - Deflector on page 2959

- Geometric/Deformable >
  - FFD (Box) on page 2962
  - FFD (Cyl) on page 2969
  - Wave on page 2979
The Modifiers menu provides a way to apply frequently used modifiers quickly. It is organized into submenus. The availability of items on this menu depends on the current selection. If a modifier doesn’t apply to currently selected objects, it is unavailable in the menu.
See also:
- Modify Panel on page 8184
- Modifier Stack Controls on page 8187
- Object-Space Modifiers on page 1159
- World-Space Modifiers (WSMs) on page 1067

Interface
Selection >
- FFD Select on page 1441
- Mesh Select on page 1500
- Patch Select on page 1562
- Poly Select on page 1582
- Select by Channel on page 1654
- Spline Select on page 1741
- Volume Select on page 1992

---
Patch/Spline Editing >
- Cross Section on page 1299
- Delete Patch on page 1307
- Delete Spline on page 1308
- Edit Patch on page 1329
- Edit Spline on page 1424
- Fillet/Chamfer on page 1442
- Lathe on page 1474
- Normalize Spline on page 1554
- Renderable Spline on page 1647
Mesh Editing >

- Cap Holes on page 1185
- Delete Mesh on page 1305
- Edit Mesh on page 1321
- Edit Normals on page 1322
- Edit Poly on page 1332
- Extrude on page 1425
- Face Extrude on page 1428
- MultiRes on page 1537
- Normal Modifier on page 1551
- Optimize on page 1557
- ProOptimizer on page 1614
- Quadify Mesh on page 1641
- Smooth on page 1733
- STL Check on page 1746
- Symmetry on page 1803
- Tessellate on page 1812
- Vertex Paint on page 1959
- Vertex Weld on page 1957
Conversion >
- Turn to Mesh on page 1825
- Turn to Patch on page 1827
- Turn to Poly on page 1830

Animation >
- Attribute Holder on page 1163
- Flex on page 1445
- Linked XForm on page 1484
- Melt on page 1496
- Morpher on page 1518
- PatchDeform on page 1567
- PatchDeform (WSM) on page 1150
- PathDeform on page 1569
- PathDeform (WSM) on page 1150
- Skin on page 1667
- Skin Morph on page 1706
- Skin Wrap on page 1717
- Skin Wrap Patch on page 1726
- SplineIK Control on page 1738
- SurfDeform on page 1774
- SurfDeform (WSM) on page 1159
——

**Cloth >**
- Cloth on page 1204
- Garment Maker on page 1266
- Welder on page 2004

——

**Hair and Fur >**
- Hair and Fur (WSM) on page 1073

——

**UV Coordinates >**
- Camera Map on page 1180
- Camera Map (WSM) on page 1067
- Map Scaler (WSM) on page 1147
- Projection on page 1596
- Unwrap UVW on page 1837
- UVW Map on page 1932
- UVW Mapping Add on page 1954
- UVW Mapping Clear on page 1954
- UVW XForm on page 1955

——

**Cache Tools >**
- Point Cache on page 1574
- Point Cache (WSM) on page 1156
Subdivision Surfaces >
- HSDS Modifier on page 1464
- MeshSmooth on page 1505
- TurboSmooth on page 1818

Free Form Deformers >
- FFD 2x2x2 on page 1431
- FFD 3x3x3 on page 1431
- FFD 4x4x4 on page 1431
- FFD Box on page 1436
- FFD Cylinder on page 1436

Parametric Deformers >
- Affect Region on page 1159
- Bend on page 1165
- Displace on page 1313
- Lattice on page 1479
- Mirror on page 1516
- Noise on page 1544
- Physique on page 5013
- Push on page 1640
- Preserve on page 1590
- Relax on page 1643
- Ripple on page 1650
- **Shell** on page 1655
- **Slice** on page 1727
- **Skew** on page 1664
- **Stretch** on page 1749
- **Spherify** on page 1736
- **Squeeze** on page 1744
- **Twist** on page 1833
- **Taper** on page 1807
- **Substitute** on page 1759
- **XForm** on page 2010
- **Wave** on page 2000

---

**Surface >**

- **Disp Approx** on page 1310
- **Displace Mesh (WSM)** on page 1068
- **Material** on page 1490
- **Material by Element** on page 1492

---

**NURBS Editing >**

- **DispApprox** on page 1310
- **SurfDeform** on page 1774
- **Surface Select** on page 1555
Animation Menu

Menu bar > Animation

The Animation menu provides a set of commands related to animation, constraints and controllers, and inverse-kinematics solvers. Also present here are controls for custom attributes and parameter wiring, as well as for creating, viewing, and renaming animation previews.

Interface

Load Animation on page 4107
Save Animation on page 4122

IK Solvers >

HI Solver on page 3680
HD Solver on page 3710
IK Limb Solver on page 3732
Spline IK Solver on page 3733
Constraints >
- Attachment Constraint on page 3575
- Surface Constraint on page 3607
- Path Constraint on page 3596
- Position Constraint on page 3602
- Link Constraint on page 3580
- LookAt Constraint on page 3585
- Orientation Constraint on page 3592

Transform Controllers >
- Link Constraint on page 3580
- Position/Rotation/Scale on page 3526
- Script on page 3552

Position Controllers >
- Audio on page 3425
- Bezier on page 3432
- Expression on page 3456
- Linear on page 3496
- Motion Capture on page 3509
- Noise on page 1544
- Quaternion (TCB) on page 3563
- Reaction on page 3527
- Spring on page 3558
- Script on page 3552
Rotation Controllers
- Audio on page 3425
- Euler XYZ on page 3453
- Linear on page 3496
- Motion Capture on page 3509
- Noise on page 3519
- Quaternion (TCB) on page 3563
- Reaction on page 3527
- Script on page 3552
- Smooth on page 3558
- LookAt Constraint on page 3585
- Orientation Constraint on page 3592

Scale Controllers
- Audio on page 3425
- Bezier on page 3432
- Expression on page 3456
- Linear on page 3496
- Motion Capture on page 3509
- Noise on page 3519
- Quaternion (TCB) on page 3563
- Reaction on page 3527
- **Script** on page 3552
- **XYZ** on page 3550

---

**Parameter Editor** on page 307  
**Parameter Collector** on page 325

---

**Wire Parameters >**
- **Wire Parameters** on page 3610  
- **Parameter Wire Dialog** on page 3612

---

**Animation Layers** on page 3467

---

**Reaction Manager** on page 3533

---

**Bone Tools** on page 871

---

**Set as Skin Pose** on page 280  
**Assume Skin Pose** on page 280  
**Skin Pose Mode** on page 280

---

**Make Preview** on page 6894  
**View Preview** on page 6897  
**Rename Preview** on page 6897
Toggle Limits Toggles all Limit controllers on page 3484 in the current scene. If all Limit controllers are off, Toggle Limits turns them on, and if all are on, it turns them off. If some are on and the rest are off, Toggle Limits turns them all on.

Delete Selected Animation on page 8059

Walkthrough Assistant on page 5599

reactor submenu on page 4225

Graph Editors Menu

Menu bar > Graph Editors

The Graph Editors menu gives you access to graphic sub-windows for managing a scene and its hierarchies and animation.

Interface

Track View – Curve Editor on page 3804
Track View – Dope Sheet on page 3805
New Track View on page 3989
Delete Track View on page 3990
Saved Track Views on page 3991

New Schematic View on page 7952
Delete Schematic View on page 7952
Saved Schematic Views on page 7953
The Rendering menu contains commands for rendering scenes, setting up environmental and render effects, compositing scenes with Video Post, and accessing the RAM Player.

**NOTE** The presence on the menu of certain commands depends on which renderer is currently active, as noted here.

### Interface

- **Render** on page 6547
- **Render Setup** on page 6506
- **Rendered Frame Window** on page 6513

### Indirect Illumination

- **Indirect Illumination** on page 6760 (mental ray Renderer)
- **Radiosity** on page 6634 (Default Scanline Renderer)
- **Light Tracer** on page 6601 (Default Scanline Renderer)

### Exposure Control

- **Exposure Control** on page 7207

### Environment

- **Environment** on page 7162
- **Effects** on page 7058
Raytracer Settings on page 6666 (Default Scanline Renderer)
Raytrace Global Include/Exclude on page 6092 (Default Scanline Renderer)

Render to Texture on page 6843
Render Surface Map on page 6466

Material Editor on page 5641
Material/Map Browser on page 5724
Material Explorer on page 5734

Video Post on page 7247

View Image File on page 6535

Panorama Exporter on page 6898
Batch Render on page 7026
Print Size Assistant on page 6564

mental ray Message Window on page 6689 (mental ray Renderer)
Gamma/LUT Setup on page 8330
RAM Player on page 7882

**Customize Menu**

Menu bar > Customize
The Customize menu contains commands for customizing the 3ds Max user interface (UI).

You can create a custom user interface layout, including custom keyboard shortcuts, colors, menus, and quad menus. You can load or save all of these things individually in the Customize User Interface dialog, or you can load or save all of them at once, using schemes. Schemes allow you to load all customized features of the UI at one time.

You can hide, float or dock, resize, and rearrange some UI elements into your own personal design. You can also lock the UI once you’ve got it set. Tools are provided in the Customize menu to load and save these custom UI files, or to revert to the startup user interface.

System preferences such as keyboard shortcuts, viewport configuration, units setup, grid and snap settings, and many important default settings, are also on the Customize menu.

**TIP** You can access many of these commands with keyboard shortcuts or right-click options. For example, you can display the Viewport Configuration dialog by clicking or right-clicking the General viewport label ([+]), and then choosing Configure from the general viewport label menu on page 8117.

---

**Interface**

*Customize User Interface* on page 8249

---

*Load Custom UI Scheme* on page 8279  
*Save Custom UI Scheme* on page 8280  
*Revert to Startup Layout* on page 8283  
*Lock UI Layout* on page 8242

---

*Show UI* on page 8241

---

*Custom UI and Defaults Switcher* on page 8244
MAXScript Menu

Menu bar > MAXScript
Utilities panel > MAXScript

MAXScript on page 21 is the 3ds Max built-in scripting language. Its main interface, the MAXScript menu, contains commands for creating and working with scripts.

In addition, the status bar on page 8064 contains a MAXScript Mini Listener on page 8065, and MAXScript functionality is also available from the Utilities panel on page 8223.

For detailed information about MAXScript, open the MAXScript Help, available from Help menu > MAXScript Help.

Interface

New Script on page 8228
Open Script on page 8228
Run Script on page 8229
MAXScript Listener on page 8229

MAXScript Editor Toggles the MAXScript Editor window. For details, see the MAXScript Help, available from Help menu > MAXScript Help.

Macro Recorder on page 8230

Visual MAXScript Editor on page 8231

MAXScript Debugger Dialog on page 8231

Help Menu

Menu bar > Help

The Help menu provides access to the 3ds Max online help, and to other learning resources.

See also:

- Using the 3ds Max Help on page 8441

Interface

Autodesk 3ds Max Help Opens the 3ds Max Help.

Essential Skills Movies Opens a dialog that provides access to movies for learning the essentials of using 3ds Max. If you are new to 3ds Max, these movies can be a good way to start learning concepts before you look at the more complex tutorials, or begin a larger project.

How-To Movies Opens your Web browser with a page with links to learning videos. The How-To movies cover more advanced concepts than the
Essential Skills movies, but they are shorter and take less time than the 3ds Max tutorials.

Learning Path Opens your Web browser to a page of resources for learning how to use 3ds Max.

Tutorials Displays the online tutorials for 3ds Max.

What’s New Opens 3ds Max Help to the new features section.

MAXScript Help Displays the MAXScript Help online. See About MAXScript on page 21.

Additional Help Opens a dialog that lets you choose to display the help for installed third-party plug-ins and for add-on products from Autodesk. By default, this command looks for additional help files in the \help subdirectory. That location might have changed if you've edited plug-in path settings. See 3rd Party Plug-Ins Path Configuration on page 8296.

Keyboard Shortcut Map Opens a Web page with a Flash animation that shows default keyboard shortcuts.

Data Exchange Solutions Opens your Web browser to a page about software for exchanging data among applications.

Customer Involvement Program When activated, lets Autodesk collect anonymous information about your usage of 3ds Max to help us improve 3ds Max. No personal information is collected. Choose whether or not to participate, and then click OK.

3ds Max on the Web Displays a submenu whose options display Web pages with additional information about 3ds Max, customer involvement, product support, and so on.
Activate 3ds Max  Starts the 3ds Max registration wizard, which lets you enter a new license authorization code. For example, you need to reauthorize 3ds Max if you're changing from a trial license to a permanent license.

License Borrowing  If you are using a network-licensed version of 3ds Max, use the commands on this submenu to borrow or return a license. For details, see the AutoCAD License Borrowing help, which is available as the file acad_brw.chm, installed in the \program files\common files\autodesk shared\enu folder on your local drive (typically, drive C:).

Diagnose Video Hardware  Lets you determine whether your system supports certain display-related features. See Diagnose Video Hardware on page 156.

About 3ds Max  Displays copyright and license information about your copy of 3ds Max.

### Toolbars

Many of the commands in 3ds Max are available as buttons on various toolbars. By default, only the main toolbar on page 8035 is open, docked at the top of the interface.

Several additional toolbars are hidden by default, including Axis Constraints on page 8039, Layers on page 8040, Extras on page 8041, Render Shortcuts on page 8042, Brush Presets on page 8044, and Snaps on page 8043. To toggle a toolbar, right-click a blank area of the main toolbar and choose the toolbar’s name from the list. See Customize Display Right-Click Menu on page 8239 for more information.

You can open and close toolbars and place them wherever you want; for more information, See Customizing the User Interface on page 8235.

See also:
- Quick Access Toolbar on page 7995
Main Toolbar

The main toolbar provides quick access to tools and dialogs for many of the most common tasks in 3ds Max.

Interface

The main toolbar, split in two for this illustration

- Select and Link on page 3631
- Unlink Selection on page 3632
- Bind to Space Warp on page 2893
- Selection Filter List on page 214
- Select Object on page 204
- Select From Scene on page 206
Selection Region Flyout on page 212

Window/Crossing Selection Toggle on page 239

Select and Move on page 914

Select and Rotate on page 915

Select and Scale on page 917

NOTE Right-clicking the move, rotate, or scale button opens the Transform Type-In dialog on page 899.

Reference Coordinate System on page 922
Use Center Flyout on page 930

Select And Manipulate on page 2838

Keyboard Shortcut Override Toggle on page 8420

2D Snap, 2.5D Snap, 3D Snap on page 2807

Angle Snap Toggle on page 2810

Percent Snap Toggle on page 2811

Spinner Snap Toggle on page 2811

Edit Named Selection Sets on page 224

Named Selection Sets on page 217

Mirror on page 940
Align Flyout on page 966

Layer Manager on page 7956

Graphite Modeling Tools (Open) on page 2025

Curve Editor (Open) on page 3804

Schematic View (Open) on page 7922

Material Editor on page 5641

Render Setup on page 6506

Rendered Frame Window on page 6513

Render flyout:

Render Production on page 6548
Axis Constraints Toolbar

Right-click unused area of any toolbar > Axis Constraints

The axis constraint buttons and flyouts appear on the Axis Constraints toolbar. See Using the Axis Constraints on page 910.

Interface

![Axis Constraints Toolbar](image)

**NOTE** The default UI does not display this toolbar: to see it, right-click an empty portion of any toolbar, and choose Axis Constraints from the menu.

- **Restrict to X**
- **Restrict to Y**
- **Restrict to Z**

**Restrict to Plane flyout**

- **XY** Restrict to XY Plane
Restrict to YZ Plane

Restrict to ZX Plane

Snaps Use Axis Constraints Toggle on page 2833

Layers Toolbar

Right-click any toolbar > Layers

The Layers toolbar simplifies interaction with the layer system in 3ds Max, allowing you to easily organize the layers in your scene. Most of these operations are available from the Layer Manager on page 7956, however the Layers toolbar provides shortcuts to several common actions, as well as the advantage of being able to work directly in the viewports.

Interface

The Layers toolbar provides the following controls:

Layer Manager on page 7956

Layer List on page 7974

Create New Layer on page 7975

NOTE The default UI does not display this toolbar; to see it, right-click an empty portion of any toolbar, and choose Layers from the menu.
reactor Toolbar

The reactor toolbar provides quick access to many of the objects and commands for the reactor dynamics toolset. For more information, see reactor on page 4219.

**NOTE** The default UI does not display this toolbar; to see it, right-click an empty part of any toolbar, and then choose reactor from the menu. When activated, the reactor toolbar is docked on the left side of your interface by default.

For more information, see Customize Display Right-Click Menu on page 8239 and Customizing the User Interface on page 8235.

Extras Toolbar

The Extras toolbar contains several miscellaneous tools for working with your 3ds Max scene.

**Interface**
NOTE The default UI does not display this toolbar; to open it, right-click an empty portion of any toolbar, and choose Extras from the menu.

AutoGrid on page 2792

Array Flyout on page 943

Render Shortcuts Toolbar

Right-click the unused (gray) portion of the main toolbar or another toolbar. > Render Shortcuts

The Render Shortcuts toolbar lets you assign settings to three custom preset buttons. You can then use these buttons to switch among various render presets.

Procedures

To define the presets for a button:

1. Choose one of the default shortcuts from the Presets drop-down list, or use Load to load the presets from an RPS file.
   The Select Preset Categories dialog appears. See Preset Rendering Options on page 6561.

2. Choose the categories you want, and then click Save.
   The preset render settings are now active.

3. Shift+click the button you want to define.
   3ds Max assigns the presets to the file that corresponds to the button: a.rps, b.rps, or c.rps.
To use a saved preset:

1  Click one of the buttons you defined. The button’s name appears in the field above the drop-down list: “a,” “b,” or “c.”
   If the button has not yet been defined, clicking it has no effect, and no name appears in the preset field.

2  On the main toolbar, click Render. The scene is rendered using the presets you chose.

Interface

Render Preset Slot A, B, and C  Click a button to make its presets active.
If you haven’t assigned presets to a button, clicking it has no effect. If presets are assigned, then after you click the button, its name appears in the field above the drop-down list: “a,” “b,” or “c.”
After assignment, each button has its own render preset (RPS) file: a.rps, b.rps, and c.rps. These are saved in the \renderpresets folder in the 3ds Max root directory. The active preset status is not saved with the MAX scene, but it is saved in the 3dsmax.ini file.

Render Presets drop-down list  Lets you choose from among a set of preset rendering parameters, or load or save rendering parameter settings. See Preset Rendering Options.
This list is the same as the one that appears at the bottom of the Render Setup dialog.

Snaps Toolbar

Right-click unused area of any toolbar. > Snaps
The Snaps toolbar provides access to the most common Snaps settings.
To toggle display of the Snaps toolbar, right-click an empty area of the main toolbar, such as the section under the Reference Coordinate System drop-down, and choose Snaps. For details on the button functions, see Standard Snaps on page 2823 and Snap Options on page 2828.

### Animation Layers Toolbar

Right-click unused area of any toolbar. > Animation Layers

The animation layers toolbar provides quick access to commands related to the Layer controller, such as enabling, adding, and collapsing layers. Some of these commands are also accessible through the Layer Controller dialog on page 3465. For more information, see Animation Layers on page 3467.

### Container Toolbar

Right-click unused area of any toolbar. > Containers

Scene Explorer > Customize menu > Toolbars > Container

The containers toolbar provides commands for handling Containers. For more information, see Container Toolbar on page 7429.

### Brush Presets Toolbar

Right-click unused area of any toolbar. > Brush Presets
The Brush Presets toolbar gives you quick access to up to 50 different brush settings for use with paint-oriented tools.

Brush settings on this toolbar apply to the following tools:

- **Paint Deformation** on page 2333 (Edit/Editable Poly)
- **Paint Soft Selection** on page 2021 (Edit/Editable Poly)
- **VertexPaint modifier** on page 1959
- **Skin modifier** on page 1667

You can also use the toolbar to create new presets and to open the Brush Preset Manager on page 8047, which lets you edit presets, and save and load groups of presets. The current group of presets is saved when you quit 3ds Max and is restored the next time you start 3ds Max.

**NOTE** Only one set of presets is available at a time. The Brush Presets feature stores context-specific features, such as the VertexPaint color, but a given preset has the same size (or size range) in *every* context. Other context-independent settings are Strength and Mirror options (set via the Painter Options dialog on page 1989).

**Procedures**

**To use the Brush Presets toolbar:**

1. Access any of the brush tools listed above.
   The tool starts with a default brush.

2. Right-click an empty area on a toolbar, such as the main toolbar below the Named Selection Sets drop-down list, and choose Brush Presets.
This opens the Brush Presets toolbar.

3 Do either of the following:
   ■ Click any of the presets to use it instead of the default brush.
   ■ Change brush settings and click Add New Preset to add a new button with the current settings.

4 Paint with the brush.

5 If you change brush settings with a preset brush active, the preset will remember the changes between sessions. Common setting changes such as Size will apply to use of the brush with any tool.

6 To change a preset’s name, copy it, delete it from the toolbar, or save or load all brush presets, click Brush Preset Manager on page 8047.

Interface
The Brush Preset toolbar controls are available only when a brush tool such as Paint Deformation on page 2333 is active.

**Brush Preset Manager** Opens the Brush Preset Manager on page 8047 dialog, which lets you add, duplicate, rename, delete, save, and load brush presets.

**Add New Preset** Adds a new preset with the current brush settings to the toolbar, first prompting you for a name for the brush. If you attempt to exceed the maximum number of brush presets (50), a dialog alerts you.

*brush presets* Each preset is available on a button with a grayscale bitmap showing its shape and relative size. Click a preset to activate it and use its settings. Each preset contains all settings pertinent to the current tool, such as Mode for Paint Deformation brushes. You can see a preset name by hovering the mouse cursor over it; the tooltip that appears shows its name.

To deactivate a preset, click its preset again on the toolbar. Its settings remain active, but changing the settings no longer modify the preset.

By default, the toolbar contains five brush presets, but you can add up to a total of 50. To activate and use a preset, click its button on the toolbar. 3ds Max remembers any changes you make to the brush settings while a preset is active and automatically restores these at the start of the following session.

The button image updates automatically to reflect changes to the size (by default, up to 40.0) and the falloff, which is depicted as a gradient on the button image. Set the falloff with the Painter Options dialog on page 1989.

---

**NOTE** Changing a value for a setting the preset has in common with other contexts, such as Size, changes it for all contexts. For example, if you set a preset brush’s size to 11.6, the brush will be that size when used with any other tool.

---

**Brush Preset Manager**

**Brush Presets toolbar** on page 8044 > Activate a brush tool. > Brush Preset Manager

The Brush Preset Manager lists all brush presets, showing the context-specific settings and lets you change contexts. It also lets you rename, add, copy, and delete presets, and set the range for the depiction of brush sizes on the toolbar.
Lastly, it lets you save and load custom collections of brush presets using the BPR file format.

The Brush Presets feature recognizes four contexts:

- **VertexPaint modifier** on page 1959
- **Paint Deformation** on page 2333 (Edit/Editable Poly)
- **Paint Soft Selection** on page 2021 (Edit/Editable Poly)
- **Skin modifier** on page 1667

**Procedures**

**To use the Brush Preset Manager:**

1. Access any of the brush tools listed above.
   The tool starts with a default brush.

2. Right-click an empty area on a toolbar, such as the main toolbar below the Named Selection Sets drop-down list, and choose Brush Presets.

   ![Brush Presets toolbar](image)

   This opens the Brush Presets toolbar.

3. On the toolbar, click Brush Preset Manager.
Interface

Context Choose the context for the settings in the list window. The Brush Presets feature recognizes four contexts and shows the current context as active:

- **VertexPaint (modifier)** on page 1959
- **PaintDeform (Paint Deformation; Edit/Editable Poly)** on page 2333
- **PaintSoftSel (Paint Soft Selection; Edit/Editable Poly)** on page 2021
- **Paint Skin Weights (Skin modifier)** on page 1667

Icon Size Min/Max Sets the range of the brush size depicted on the toolbar. Changing the actual brush size between the minimum and maximum settings changes the image of the brush as depicted on its button to show its size relative to the other presets. Changes to the brush size outside these limits are not reflected on the toolbar buttons.

Add Adds a new preset to the list, using the current brush settings. When you click Add, you're prompted to enter a name for the new preset. Edit the name and then click OK to create the new preset. The new preset appears highlighted at the end of the list and the toolbar.

**NOTE** If 50 presets already exist, you won't be able to add any new ones.

Duplicate Adds a copy of the highlighted preset to the list. When you click Duplicate, you're prompted to enter a name for the new preset. Edit the name
and then click OK to create the new, duplicate preset. The preset appears highlighted at the end of the list and the toolbar.

**NOTE** If 50 presets already exist, you won't be able to add any new ones via duplication.

**Delete** Deletes the brush preset highlighted in the list from both the list and the toolbar.

**Load** Lets you load a saved Preset (BPR) file. Click Load to open the Load Brush Preset File dialog, click a BPR file to load, and then click Open. The loaded Preset file replaces the current presets.

**Save** Lets you save a custom Preset (BPR) file, containing all current brush presets. Click Save to open the Save Brush Preset File dialog, specify a BPR file to save, and then click Save. You can then load the Preset file into 3ds Max at any time.

**[presets list]** Shows all presets in a scrollable list. Each list entry shows a small version of the button image, the preset name, ranges for Strength and Size, Mirror and Mode settings, and other settings depending on the context.

To rename a button preset, double-click its name and then edit or enter a new one. Other settings are available from the applicable rollout and the Painter Options dialog on page 1989. For example, you can set the brush strength and size on the applicable rollout, but to set the range, which is used by a pressure-sensitive input device such as a pen and tablet, you must use the Painter Options dialog. Mirror options are also available only from this dialog.

The list shows the following general and contextual information:

- General (all contexts):
  - **Strength** (with range)
  - **Size** (with range)
  - **Mirror** on/off (with axis and offset, if on)
  - **Falloff** values (set via the Painter Options graph, displayed as a gradient in the button image)

- **VertexPaint** on page 1959
  - **Mode** (brush state: Paint, Erase, Blur Brush)
  - **Color**
Right-Click Menu for Scripted Toolbar Buttons

Any toolbar > Right-click a button that is implemented by a script. > Pop-up button menu

When you right-click a toolbar button that is implemented by a macro script, a pop-up menu appears.

- **Edit Button Appearance**
- **Delete Button**
- **Edit Macro Script**
- **Customize…**

**Edit Button Appearance** Displays the Edit Macro Button dialog, which lets you change the button’s appearance and its tooltip. This is documented in the MAXScript Help: see Customizing MacroScript Buttons.

**Delete Button** Deletes the button from the toolbar.
NOTE There is no Undo for Delete Button, although Customize > Revert To Startup Layout will restore the toolbar to its original appearance.

**Edit Macro Script** Opens a MAXScript Editor window, which lets you edit the button's script.

**Customize** Opens the Toolbars panel on page 8252 of the Customize User Interface dialog, which lets you customize the contents of the current toolbar (or any other toolbar).

## Quad Menu

When you click the right mouse button anywhere in an active viewport, except on the viewport label (see Viewport Label Menus on page 8117), a *quad menu* is displayed at the location of the mouse cursor. The quad menu can display up to four quadrant areas with various commands. These commands can be customized on the Quads panel on page 8259 of the Customize User Interface dialog on page 8249.

The quad menu allows you to find and activate most commands without having to travel back and forth between the viewport and rollouts on the command panel.

The two right quadrants of the default quad menu display generic commands, which are shared between all objects. The two left quadrants contain context-specific commands, such as mesh tools and light commands. Each of these menus provides convenient access to functions found in the command panel. You can also repeat your last quad menu command by clicking the title of the quadrant.

The quad menu contents depend on what is selected, as well as any customization options you may have selected in the Quads panel of the Customize UI dialog. The menus are set up to display only the commands that are available for the current selection; therefore, selecting different types of objects displays different commands in the quadrants. Consequently, if no object is selected, all of the object-specific commands will be hidden. If all of the commands for one quadrant are hidden, the quadrant will not be displayed.

Cascading menus display submenus in the same manner as a right-click menu. The menu item that contains submenus is highlighted when expanded. The submenus are highlighted when you move the mouse cursor over them.
Some of the selections in the quad menu have a small icon next to them in the quad menu. Clicking this icon opens a dialog where you can set parameters for the command.

To close the menu, right-click anywhere on the screen or move the mouse cursor away from the menu and click the left mouse button. To reselect the last selected command, click in the title of the quadrant of the last menu item. The last menu item selected is highlighted when the quadrant is displayed.

Additional, specialized quad menus become available when you are working in ActiveShade on page 6550, the Edit UVWs dialog on page 1856, or when you press any combination of Shift, Ctrl, or Alt while right-clicking in any standard viewport. For more information, see Additional Quad Menus on page 8057.

**Interface**

The following are the default commands for the right-click menu. You can add, edit, or remove any of these commands in the Quads panel on page 8259 of the Customize User Interface dialog.
Default quad menu for an editable poly object at the Vertex sub-object level

**Transform quadrant**

These options are available from the Transform quadrant:

**Move** Lets you move objects. This is the same as clicking Select And Move on page 914 on the main toolbar.
You can open the Transform Type-In on page 899 by clicking the icon to the right of Move on this menu.

**Rotate** Lets you rotate objects. This is the same as clicking Select And Rotate on page 915 on the main toolbar.
You can open the Transform Type-In on page 899 by clicking the icon to the right of Rotate on this menu.
Scale Lets you scale objects. This is the same as clicking Select And Scale on page 918 on the main toolbar. If one of the other Select And Scale flyout on page 917 buttons is active on the maintoolbar, that tool becomes active when you click Scale on the quad menu.

You can open the Transform Type-In on page 899 by clicking the icon to the right of Scale on this menu.

Select Lets you select objects.

Select Similar Automatically selects objects similar to the current selection. See Select Similar on page 228

Clone Lets you clone objects. This is the same as choosing Clone on page 992 from the Edit menu.

Object Properties Opens the Object Properties dialog on page 283 for a selected object. This command is available only if an object is selected when you open the quad menu.

Curve Editor Opens and displays the selected object at the top of the Track View Hierarchy. This command is visible only if an object is selected when you open the quad menu.

Dope Sheet Opens and displays the Dope Sheet on page 3805.

Wire Parameters Starts a wire parameter on page 3610 from the selected object. This command is available only if an object is selected when you open the quad menu.

Convert To This submenu lets you convert the selected object to an editable mesh on page 2192, an editable patch on page 2360, an editable spline on page 620, a NURBS surface on page 2454, or an editable poly on page 2240. This command is available only if an object is selected when you open the quad menu.

Display quadrant

These options are available from the Display quadrant:

Viewport Lighting and Shadows

- Unlock Selected Lights Unlocks the selected lights.
- Lock Selected Lights Locks the selected lights.

To “lock” a light means that the light will stay on until it is unlocked, whether or not the light casts shadows. When a light is locked, choosing Display Only Selected Lights or Auto Display Selected Lights does not turn it off.
Auto Display Selected Lights  When on, light from selected lights is automatically displayed in shaded viewports. Default=off. This option is equivalent to the same option in the Lighting And Shadows tab on page 8392 for viewport configuration: changing the setting here changes the active setting in the preferences dialog, and vice versa.

NOTE See also Previewing Shadows and Other Lighting in Viewports on page 5335.

Isolate Selection  The Isolate Selection tool on page 198 lets you edit your selection while hiding the rest of the scene.

TIP  You can use this iteratively to delve into a large selection set.

Isolate Selection’s Layer  Isolates the layer of the selected object.

Unfreeze All  Unfreezes all frozen objects.

Freeze Selection  Freezes the selected objects. Frozen objects are visible in the viewports, but cannot be manipulated.

Freeze Selection’s Layer  Freezes the layer of the selected object.

Unhide by Name  Displays a version of the Select From Scene dialog on page 206 you can use to choose objects from a list to unhide.

NOTE  You cannot unhide an object on a hidden layer. If you select and object on a hidden layer, a dialog will prompt you to unhide the layer first.

Unhide All  Unhides all hidden objects.

Hide Unselected  Hides all visible objects that are not selected. Hidden objects still exist in the scene, but do not appear in the viewports or in rendered images.

Hide Selection  Hides the selected objects.

Hide Selection’s Layer  Hides the layer of the selected object.

Save Scene State  Opens the Save Scene State dialog where you enter a name for the current scene and select the options you want saved with the scene.

Manage Scene States  Opens the Manage Scene States dialog. This is a modeless dialog where you can select, save, restore, rename, and delete scene states. See Manage Scene States Dialog on page 7917.
Tools quadrants

The two quadrants on the left side of the default quad menu are called Tools 1 and Tools 2. These quadrants contain commands specific to various geometries and modifiers such as: lights, editable geometries, and cameras. These quadrants appear only if one of the corresponding geometries or modifiers is selected when you open the quad menu.

Additional Quad Menus

Several specialized quad menus are available when you are working in certain modes, such as ActiveShade on page 6550, Edit UVWs on page 1856, Track View on page 3790, or when you press any combination of Shift, Ctrl, or Alt while right-clicking any standard viewport.

The ActiveShade quad menu provides many useful commands such as Render, Draw Region, Update, as well as access to the Material Editor on page 5641. Similarly, the Unwrap UVW quad menu contains many common UVW commands.

You can create or edit any of these menus from the quad set list in the Quads panel on page 8259, on the Customize User Interface dialog; however, they cannot be deleted.

These are the additional quad menus and their default settings:

**Biped** Appears when you right-click any selected biped on page 4487 part. The two left-hand quadrants, Tools 1 and Tools 2, provide quick access to many commonly used biped tools, including Track Selection rollout commands and Layers rollout commands.

**ActiveShade** Appears when you right-click an ActiveShade viewport or window on page 6550. This menu provides quick access to many of the commonly used actions in ActiveShade, including Draw Region, Initialize, and Update, as well as access to the Material Editor.

**Unwrap UVW** Appears when you right-click an Edit UVWs dialog. This menu provides quick access to many of the commonly used UVW actions.

**Track View Key** Appears when you right-click any Track View dialog. This menu provides quick access to common key actions, such as Move, Add, Scale, and Reduce Keys.

**Shift+right-click** Provides access to snap options and settings. See Snap Settings on page 2819 and Snaps Shortcut Menu on page 8062.
Alt+right-click Provides several animation tools, letting you set the coordinate system, set and assume skin poses, and set key frames.

Ctrl+right-click Provides several modeling tools that let you create and edit many geometries, including standard primitives and editable geometries.

Shift+Alt+right-click Contains many reactor commands. For more information, see reactor on page 4219.

Shift+Ctrl+right-click Available for assignment. Use the Quads panel to customize it.

Ctrl+Alt+right-click Provides several lighting and rendering commands. The default actions let you render your scene, access render effects and environmental effects, and toggle object properties for the current selection.

Shift+Ctrl+Alt+right-click Available for assignment. Use the Customize menu > Customize User Interface > Quads panel to customize this menu.

There is also a Track View quad menu on page 3870 that appears only while you are using Track View.

Animation Quad Menu

Alt+right-click a viewport. > Animation quad menu

The Alt+right-click quad menu has commands to assist in animation.

See also:

- Animation on page 3367
- Additional Keyboard Commands on page 7982
Interface

Coordinates quadrant

Lets you change the active reference coordinate system on page 922.

Set quadrant

Keyframe Sets a key at the current frame. Set Key or Auto Key do not need to be on.

Show Trajectories Toggle Toggles the display of trajectories on page 3411.

Reaction Manager Opens the Reaction Manager dialog on page 3533.

Delete Selected Animation Deletes any existing animation keys for all selected objects, as well as any sub-object animation. Each object remains in its state at the frame in which you use this command.

Pose quadrant

Set Pref Angles For a hierarchy with history-independent (HI) IK applied to it, sets the preferred angle for each bone in the chain.

Assume Pref Angles For a hierarchy with history-independent (HI) IK applied to it, copies the X, Y, and Z preferred angle channels of each bone and places them into its FK rotation subcontroller.
Set as Skin Pose Stores the selected objects' current position, rotation, and scale as the skin pose. See Skin Pose Commands on page 280.

Assume Skin Pose Causes the selected objects to take on the stored skin pose. See Skin Pose Commands on page 280.

Transform quadrant

Commands in this quadrant are meant primarily as aids to character animation. Use the Freeze commands to set the character's initial pose. Then you can later use the “to Zero” options to return to that initial pose.

Freeze Transform Replaces the selected object’s or objects’ current Position and Rotation controllers with List controllers on page 3497 containing the Freeze Transform setup. This setup comprises a Frozen Position (Bezier)/Rotation (Euler XYZ) controller followed by a “Zero ...” controller, which uses the default controller for the transform (Position XYZ and Euler XYZ, respectively). Once you’ve “frozen” an object’s transform, you can return to its position and orientation as frozen with the Transform To Zero command (see following).

Controller setup before (left) and after (right) applying Freeze Transform
**TIP** You can use this command to apply List controllers for position and rotation to multiple objects simultaneously, which is not possible with the standard Assign Controller feature. This is particularly useful when you want to use parameter wiring or expressions to animate members of a hierarchy. If a transform has only one controller, animating it (or the first controller in a list) via wiring or an expression always uses the coordinate system of the parent object (which, if the object has no parent, is the World coordinate system), whereas most such situations call for animation in the object’s Local coordinate system. The latter requires wiring to the second controller in a controller list, and because “freezing” an object’s transform creates a two-controller lists for position and rotation, in which the second controller is the default for its transform, it then becomes easy to wire to the second controller. Or, to use an expression, replace the second controller with an Expression controller.

**Freeze Rotation** Replaces the selected object’s or objects’ current Rotation controllers with List controllers on page 3497 containing the Freeze Rotation setup. This setup comprises an Euler XYZ controller labeled “Initial Pose” followed by a second Euler XYZ controller labeled “Keyframe XYZ.” Once you’ve “frozen” an object’s rotation, you can return to its orientation as frozen with the Rotation To Zero command (see following).

**TIP** You can use this command to apply List controllers for rotation to multiple objects simultaneously, which is not possible with the standard Assign Controller feature. This is particularly useful when you want to use parameter wiring or expressions to animate the rotation of members of a hierarchy. If a transform has only one controller, animating it (or the first controller in a list) via wiring or an expression always uses the coordinate system of the parent object (which, if the object has no parent, is the World coordinate system), whereas most such situations call for animation in the object’s Local coordinate system. The latter requires wiring to the second controller in a controller list, and because “freezing” an object’s rotation creates a two-controller list for rotation, in which the second controller is the default for its transform, it then becomes easy to wire to the second controller. Or, to use an expression, replace the second controller with an Expression controller.

**Transform to Zero** Returns the object to the zero pose established by Freeze Transform (see preceding). Transform To Zero works only if you have previously invoked Freeze Transform or Freeze Rotation.

**NOTE** The Position to Zero on page 7983 CUI action returns the object to the zero position only (no rotation). You can use Position To Zero by creating a keyboard shortcut or other custom user interface element for it.
Rotation to Zero  Transforms the object back to the zero rotation established by Freeze Rotation (see preceding).
Rotation To Zero works only if you have previously invoked Freeze Transform or Freeze Rotation.

Snaps Shortcut Menu

Hold down the Shift key and right-click a viewport. > Snaps Shortcut menu
The Snaps shortcut menu is a quad menu that lets you quickly access various snap options.

See also:
- Using Snaps on page 2804

Interface

Snap Override quadrant
This quadrant lets you choose snap override on page 2826 settings for temporary use.

NURBS  Displays a submenu that lets you choose a NURBS snap setting for one-time use. See NURBS snaps on page 2825.

Standard  Displays a submenu that lets you choose a standard snap setting for one-time use. See Standard snaps on page 2823.
None  Turns off all snap settings for the next mouse action. This option is not available until you have chosen a snap setting.

Last  After you have used snap override, this option displays the last snap override setting you chose. Choosing it turns that snap setting back on for one-time use. This option is not available until you have chosen a snap setting.

Snap Toggles quadrant

This quadrant shows several of the most commonly used snap setting so you can choose them quickly.

Snap Options quadrant

Grid and Snap Settings  Toggles display of the Grid And Snap Settings dialog on page 2819.

Snaps To Frozen Objects  This is a toggle. Turn it on to enable snapping to frozen objects. Default=off.

Snaps Use Axis Constraints  This is a toggle. Turn it on to use the current transform constraints. Default=off.

For example, if you’re moving a vertex with Restrict To XY Plane on and want to snap the vertex to a point removed on the Z axis, turn this off, if necessary.

Tools 1 Quadrant for Light Objects

Select a single light object. > Right-click a viewport. > Quad menu > Tools 1 (upper-left) quadrant

The Tools 1 (upper-left) quadrant for viewport lighting appears when a single light object is selected in the scene.

Interface

<table>
<thead>
<tr>
<th>Ambient Only</th>
<th>Affect Specular</th>
<th>Affect Diffuse</th>
<th>Cast Shadows</th>
<th>Light On</th>
<th>Select Light Target</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>✓</td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**Ambient Only** When on, the light object affects only ambient light in viewports.

**Affect Specular** When on, the light object affects specular color in viewports.

**Affect Diffuse** When on, the light object affects diffuse color in viewports.

**Cast Shadows** Turns on shadows for the light, for viewport display. This setting does not change the value of the light’s Shadows toggle, so it doesn’t affect the rendered scene.

**Light On** Toggles whether the light is on or off.

**Select Light Target** This option appears only if you have selected a target light. Choose it to select the light’s target and reposition it.

## Status Bar Controls

The 3ds Max window contains an area at the bottom for prompt and status information about your scene and the active command. There is a coordinate display area in which you can type transform values, and on the left, a two-line interface to the MAXScript Listener.

**See also**

- [Animation and Time Controls](#)
- [Viewport Navigation](#)

### Time Slider and Track Bar

![Time Slider](#)

**Time Slider** on page 8089

**Show Curves** Click to display a version of the Track View Curve Editor on page 3804 in place of the time slider and track bar.

When curves are displayed, you can click the Close button at upper left to return to a view of the time slider and track bar on page 8071.
Status Bar

Prompt Line

Status bar > Prompt line

The prompt line, located at the bottom of the window under the status line, provides ongoing feedback, based on the current cursor position and the current program activity. When you don’t know what to do next, look down here for instructions.

Depending on what you are doing, the prompt line displays instructions that tell you what 3ds Max expects or what you can do next. For example, when you click the Move button, the prompt line reads "Click and drag to select and move objects."

Tooltips are also displayed on the prompt line as your cursor passes over icons in any toolbar and the status bar.

MAXScript Mini Listener

Click the tag bar, to the left of the status and prompt lines, and drag it to the right to display the MAXScript Mini Listener.

The MAXScript Mini Listener is a single-line view of the contents of the MAXScript Listener window on page 8229.

The MAXScript Listener window is divided into two panes: one pink, and one white. The pink pane is the MacroRecorder pane. When the MacroRecorder is enabled, everything that is recorded is displayed in the pink pane. The pink line in the Mini Listener shows the latest entry into the MacroRecorder pane.

The white pane is the Scripter window where you can create scripts. The last line you type in the white area of the Listener will appear in the white area of the Mini Listener. Use the arrow keys to scroll the display in the Mini Listener.
You can type directly into the white area of the Mini Listener, and the command executes in the viewports.

Right-click either of the Mini Listener lines to open the floating MAXScript Listener window. It will also display a list of the last 20 commands recorded. You can choose any of these commands and press Enter to execute them.

For more information about the MAXScript Listener window, as well as about creating scripts, see the MAXScript Help: choose Help > MAXScript Help.

**Procedures**

**Example: To create a sphere using the Mini Listener:**

1. Click the tag bar at the left end of the status bar, and drag it to the right to expand the Mini Listener.
2. In the Scripter (white, lower) line, type `sphere radius: 50` and press Enter. A sphere appears in the viewports.

**Example: To redo a command using the Mini Listener:**

1. Click the tag bar at the left side of the status bar, and drag it to the right to expand the Mini Listener.
2. Right-click the Mini Listener and choose Open Listener Window.
3. From the MacroRecorder menu, choose Enable.
4. Using the command panel, create a sphere in the perspective viewport.
5. Convert the sphere to an Editable Mesh.
6. Delete the sphere.
7. Make a box.
8. Right-click the MacroRecorder (pink, upper) line and choose `macros.run "Modifier Stack" "Convert_to_Mesh"` from the list. The box has been collapsed to an editable mesh.

**Example: To make a script and add it to a toolbar:**

For this very simple example, you’ll make a script that collapses an object to an editable mesh, and then create a toolbar icon to run the script.

1. Right-click the Mini Listener, and choose Open Listener Window.
2. From the MacroRecorder menu, choose Enable. Close the listener window.

3. Create a box in the Perspective viewport.

4. Right-click the box and choose Convert to: > Editable Mesh from the quad menu.

5. Left-click in the MacroRecorder line.
   The MacroRecorder line goes blank because the cursor goes to the last line.

6. Press the upper-arrow key on the keyboard to move up the list of recorded command scripts.

7. Click and highlight the `macros.run "Modifier Stack" "Convert_to_Mesh"` line.
   Highlight the command script as you would highlight a line of text in a text editor by clicking at the start of the line and dragging along the entire length.

8. Click and drag the highlighted script from the Mini Listener to a toolbar.

**Interface**

**MacroRecorder Line** The pink, upper line displays the last thing recorded by the MacroRecorder. If the MacroRecorder is not enabled, nothing will appear in this line.

**Scripter Line** The white, lower line displays the last entry typed into the Scripter window. You can type directly into this line and execute the commands in the viewports.

**History List** Right-clicking either of the Mini Listener lines displays a history of the last twenty commands recorded by the Macro Recorder (provided it has been enabled). Click any of these commands to execute them in the viewports.

**Open Listener Window** Right-clicking either of the Mini Listener lines displays a dialog that allows you to open the MAXScript Listener window. You can also open the Listener using the Utilities panel > MAXScript rollout. You can display the Listener window in a viewport by clicking or right-clicking the Point-Of-View (POV) viewport label, then on the **POV viewport label menu** on page 8122, choosing Extended > MAXScript Listener.
NOTE When you open the MAXScript Listener in this way, and then change the viewport POV, 3ds Max opens the Listener in a window of its own.

Status Line

Status bar > Status line

The status line displays the number and type of object or objects selected. The status line is located at the bottom of the screen, just above the prompt line on page 8065.

1 Object Selected

If multiple objects are selected and all are of the same type, the number and type of the objects are displayed: "2 cameras, 3 lights" for example. If multiple objects of different types are selected, the status line displays the number plus the word 'objects': "6 objects" for example.

Time Slider

Status line > Time Slider

The time slider shows the current frame and lets you move to any frame in the active time segment on page 8496. Right-clicking the slider bar opens the Create Key dialog on page 3383, which lets you create position, rotation, or scale keys without using the Auto Key button.

When you are in Auto Key on page 8090 mode, you can right-click and drag the time slider to create a key that has the source at the initial time slider position, and the destination at the subsequent time slider position.

In Set Key mode on page 8093, holding down the right mouse button and dragging the time slider allows you to move a pose in time without losing it in the viewport.

To move one frame back or forward, click the arrow on the left or right side of the time slider, respectively. Or simply place your cursor anywhere on the time line, click and the time slider will jump to your cursor position. In Key Mode on page 8105, clicking an arrow jumps to the adjacent key.
The Track View Key window displays a time slider as well. The movement of the two time slider is synchronized. Moving the time slider in the Track View window also moves the time slider below the viewports, and vice versa.

**Procedures**

**To move to a specific frame in the animation, do one of the following:**

1. Drag (scrub) the time slider right or left until the frame number is displayed on the time slider.

2. Type the frame number into the current frame field in the time controls, and then press Enter.

**To move ahead or back a frame or a key at a time, do one of the following:**

By default, Key Mode on page 8105 is off, and these controls move a frame at a time. To move by keys, click the Key Mode Toggle button; this turns on Key Mode. When Key Mode is on, the button looks like this:

1. Click the < or > button at either end of the time slider.

2. Press the < or > key on the keyboard.

3. When Key Mode is off, click the Next Frame or Previous Frame button in the time controls.

4. When Key Mode is on, click the Next Key or Previous Key button in the time controls.

**To move ahead or back many frames at a time:**

- Click in the empty track to either side of the time slider. The time slider will jump to your cursor position. This is a faster way of moving in time than dragging the time slider.
To move to the first or last frame of the active time segment:

- Use the time control buttons Go To Start or Go To End.

To display SMPTE time code on the time slider:

- Click Time Configuration in the time controls, and then under Time Display, choose SMPTE.

To display subframes on the time slider:

- Click Time Configuration in the time controls, and then under Time Display choose Frames:TICKS or MM:SS:TICKS.
  Each frame is divided into subframes.

To use the time slider to adjust animation, do one of the following:

1. To copy a pose from one frame to another, with Auto Key on or off, and Set Key off, right-click the time slider and drag to a new location. The Create Key dialog appears with Source Time set to the frame you were on when you right-clicked, and Destination Time set to the frame to which you moved the time slider. Toggle the Position, Rotation, and Scale check boxes as necessary and then click OK to create a key at the destination frame for the pose at the source frame.

2. In Set Key mode, if you have posed your character on the wrong frame, right-click and drag the time slider. The pose is moved in time to the new time slider position. Click the Set Key button to set the keys.

To scrub the animation with the mouse but without dragging:

1. Go to Customize > Customize User Interface. On the Keyboard panel, click in the Action list and then press T to jump to the T section. Scroll down to find Time Slider Capture Toggle and click it.

2. Click the Hotkey field and then press a keyboard combination to assign as a keyboard shortcut; for instance, Ctrl+T. Click the Assign button.

3. Close the Customize User Interface dialog and then press your hotkey for Time Slider Capture Toggle.
4  Move the mouse left and right without pressing any buttons. The time slider moves in tandem with the mouse.

5  To exit this mode, press the hotkey again or click any mouse button.

Interface

By default, the active time segment is from frame 0 to frame 100. The slider displays time in frames, SMPTE numbers on page 8725, or other measurements, depending on the current setting in the Time Configuration dialog on page 8106.

The slider bar displays the current frame, followed by a slash (/), followed by the total frames in the active time segment. For example 25/100 means frame 25 of 100 frames. The current frame also appears in the current frame field. If animation on page 8505 exists in the scene, it’s played back as you drag the time slider.

The buttons on either side of the time slider bar move one frame to the left and one frame to the right, like the Previous Frame and Next Frame buttons in the time controls. If Key Mode on page 8105 is on, these buttons duplicate the Previous Key and Next Key buttons.

Key Mode can jump to all the keys or only the transform keys, depending on the Key steps setting in the Time Configuration dialog.

TIP  Right-click the slider bar to open the Create Key dialog. This lets you create Position, Rotation, or Scale keys without using the Auto Key button. It also lets you copy keys easily from one frame to another.

Track Bar

The track bar is located below the viewports, between the time slider and the status bar.

The track bar provides a timeline showing the frame numbers (or appropriate display units). It provides a quick alternative to Track View for moving, copying, and deleting keys, and changing key properties. Select an object to view its animation keys on the track bar. The track bar also displays keys for multiple selected objects.
The displayed keys use color coding, so you can easily determine what kind of key exists at that frame. Position, rotation and scale keys are red, green, and blue, respectively, and non-transformational keys such as modifier parameters are gray. You can customize the colors in the Customize User Interface dialog on page 8249, and depends on the selected/unselected state of the key. The frame indicator is a similar bar displayed in blue.

A key on the track bar can represent any number of animated parameters for the selected objects. Transformations, modifiers, and animated material parameters can all have keys at a particular frame.

To display a list of all keyed values for a key on the track bar, right-click the key. Choose a key type from the right-click menu to display its key properties dialog. Delete keys and filter the track bar display using options on the right-click menu.

The track bar right-click menu contains a submenu that lists any procedural controllers (list controllers, expression, reactors, springs, noise, and so on) assigned to the current object selection. If you select one of the controllers from the submenu, the properties dialog for that controller displays in a modeless dialog.

The track bar can display a waveform (.wav file) that has already been assigned to the sound object in Track View. To display this feature, right-click the track bar and choose Configure > Show Sound Track. If no waveform is currently assigned to the sound object or if you are using a third-party sound object plug-in that is not compatible with the waveform display, this part of the track bar is unavailable.

You can modify the active time segment on page 8496 by pressing Ctrl and Alt while dragging the track bar. Hold the left mouse button to slide the start of the range, the right mouse button to slide the end of the range, and the middle mouse button to change both the start and end frames together. A tooltip at the cursor and a status bar message will indicate the range you are setting.

NOTE While the Auto Key button is depressed, the time slider background is highlighted red, to indicate that 3ds Max is in automatic keyframing mode.
You can expand the track bar to show curves. Click the Open Mini-Curve Editor button at the left end of the track bar. The time slider and track bar are replaced with the controller and key windows, and Track View toolbars. You can resize the track bar window by dragging the border between the menu bar and the toolbars (do this in an empty toolbar area).

Procedures

To select keys on the track bar:

1. Click a key to select it.

2. Drag a window around a selection of keys to region-select multiple keys. If the track bar right-click menu > Configure > Show Selection Range option is on, when you select multiple keys, the range of the selected keys is shown in the selection range bar at the bottom of the track bar. You can then scale the selected keys proportionally by dragging either end of the selection range bar, or move the keys by dragging the center of the bar.
To move or clone keys on the track bar:

While keys are moved or cloned, small lines on the track bar mark the original position of the keys. All keys at a particular frame are moved simultaneously using the following procedures.

1. Drag a key selection to move it in time.
2. Hold down Shift, then drag a key(s) to clone keys.
3. Right-click to abort a move or clone operation.

To move a single key from a frame with multiple keys:

If, for example, a frame has both a transform key and a material key for the selected object, and only the transform key must move, display the Transform Properties dialog and use the Time parameter to move the transform key.

1. Right-click a key on the track bar and choose a key on the pop-up window key list.
   A Key Properties dialog is displayed.
2. Change the Time parameter in the Key Properties dialog.
The key slides along the track bar to a new location.

To delete keys on the track bar:

1. Make a key selection on the track bar and press Delete.
   All selected keys are deleted.
2. Make a key selection on the track bar, right-click anywhere on the track bar to display the track bar menu, and then choose Delete Selected Keys on the pop-up window.
   All selected keys are deleted.

To delete a single key type on a frame with multiple keys:

An object can have many keys for different animated parameters at a particular frame. Use this procedure to delete a key for a single parameter.

1. Right-click over a selected or unselected key on the track bar.
   A pop-up window displays.
2. Move the mouse over Delete Key, then choose a key to delete in the submenu.
To change the length of the active time segment:
You can change the animation length using track bar.

- Hold Ctrl+Alt and drag on the track bar:
  - *With the left mouse button* to change the active time segment's start frame.
  - *With the right mouse button* to change the active time segment end frame.
  - *With the center mouse button* to change the active time segment start and end frames simultaneously.

To hide or show the track bar:

- Choose Customize > Show UI > Show Track Bar.
  This menu item is a toggle: a check mark shows that the track bar is currently displayed.

To show curves on the track bar:

- Click the Open Mini Curve Editor button at the left hand side of the track bar.
  The track bar keys are replaced with a menu bar, toolbars and the controller and key windows.

Interface

Track Bar

- Make an object selection in the viewports to display the object's keys on the track bar.
Selected transformation keys are white; unselected keys are other colors.

Drag from an empty area of the track bar to region-select keys.

Drag a key to move it in time.

Hold Shift and drag a key to clone it.

Hold Ctrl+Alt and drag the track bar to change the active time segment, that is, the animation range displayed on the track bar. Dragging with the left mouse button will change the start of the range, dragging with the right mouse button will change the end of the range, and dragging with the middle mouse button will change both the start and the end of the range.

Right-click to abort a move or clone operation.

During a move or clone operation, short, vertical, gray lines represent the original key locations.

The cursor changes to a cross when over unselected keys.

The cursor changes to a two-sided arrow over selected keys, signifying a move operation is possible.

Right-click anywhere on the track bar to display the track bar right-click menu. Right-click over a key to access its keyed values from the right-click menu, as well as other track bar-related commands.

Click the Open Mini Curve Editor button to expand the track bar. When the track bar is expanded it displays the Track View menu, toolbars, controller and key windows. You can hide or unhide UI Elements such as scroll bars as well when this is expanded.

**Track bar menu**

Right-click a key on the track bar to display the track bar menu.
List Displays the object name and key type for all keys at the current position. Choose any of the keys in the list at the top of the track bar menu to display a key properties dialog. For more information on this dialog, see Key Info (Basic) on page 3418 and Key Info (Advanced) on page 3422.

- A key with a check next to the name indicates the key is shared with other instances in the list. Two selected objects might share the same Twist modifier, for example.

- The list displays keys for all selected objects. If there are more than 10 keys, then the list turns to a submenu under Key Properties in the track bar menu.

- If there is no key properties dialog for a key type, the key is unavailable.

Controller Properties Displays a submenu that contains a list of all of the procedural controllers (list controllers, expression controllers, reactors, springs, noise, and so on) assigned to the object selection.

Delete Key Displays a submenu identical to the key properties list at the top of the track bar menu. Choose a key type or choose All to delete one or all of the keys.

All Deletes all keys at the current position.

Keys do not need to be selected on the track bar in order to use Delete Key. Keys are deleted from the track bar key over which you right-clicked.

Delete selected keys Deletes the keys selected on the track bar. If no keys are selected, this option is unavailable.

Track Bar | 8077
Filter

Filter Displays a Filter submenu. Choose a filter to filter the track bar display; showing only transformation keys, for example.

Right-click anywhere on the track bar, place the cursor over Filter in the track bar menu to display the Filter submenu, then choose filter settings. The settings determine which keys appear on the track bar.

The upper section of the Filter submenu lets you choose one of the following:

- **All Keys** Displays all keys.
- **All Transform Keys** Displays only keys for position, rotation and scale.
- **Current Transform** Displays only keys that use the currently selected transform: position, rotation or scale.
- **Object** Displays object modifier keys. Excludes transformation and material keys.
- **Material** Displays material keys for the material assigned to the selected objects.

The lower section of the Filter submenu lets you toggle each of the following, for any combination of these filter options:

- **Keyable Tracks Only** Controls the display of keyable tracks on the track bar.
- **Parameter Collector Keys** Filters keys related to the Parameter Collector on page 325.
- **List Controller – Active Only** This filter lets you see only the keys on the active control in a List Controller. Otherwise, you see all the keys on all the controls.
- **List Controller – Hide Weights** This filter hides the weight parameter keys of a List Controller from the track bar.
Layer Controller – Active Only
This filter lets you see only the keys of the active Layer controller on page 3467. Otherwise, you see all the keys of all Layer controllers.

Layer Controller – Hide Weights
This filter hides the weight parameter keys of a Layer controller on page 3467 from the track bar.

Configure

Configure Displays a submenu that lets you change the track bar display and behavior.

<table>
<thead>
<tr>
<th>Configure</th>
<th>Show Frame Numbers</th>
<th>Show Selection Range</th>
<th>Show Sound Track</th>
<th>Snap To Frames</th>
</tr>
</thead>
<tbody>
<tr>
<td>Go to Time</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The Configure options are:

- **Show Frame Numbers**  Displays frame numbers in the track bar.
- **Show Selection Range** Displays a selection range bar below the track bar, whenever multiple keys are selected. You can scale all selected keys by dragging either end of the selection range. This lets you change the length of an animation segment while maintaining the relative distance between animation keys. You can also move the selected keys in time by dragging the selection range bar.
- **Show Sound Track**  Displays the waveform (.wav file) that is assigned to the sound object in Track View.
- **Snap to Frames**  Keys snap to frame numbers when moved. If turned off, you can place keys between frames.

Go to Time Moves the time slider to the cursor position.
Right-click anywhere on the track bar, and then click Go To Time.

Selection Lock Toggle

Status bar > Selection Lock Toggle
Selection Lock Toggle turns selection locking on and off. Locking the selection prevents you from inadvertently selecting something else in a complex scene.

When your selection is locked, you can click or drag the mouse anywhere in the viewports without losing your selection. When you want to deselect or alter your selection, click Selection Lock Toggle again to unlock the selection.

If you want to select something but cannot, it’s frequently because you have locked your selection.

This button is off by default.

To turn on Selection Lock Toggle, click the button (it turns yellow). When Selection Lock Toggle is on, you can click anywhere in a viewport and 3ds Max maintains the current selection. This is useful when you want to keep objects selected while you make a different viewport active or when the selection is tiny, or crowded and difficult to select.

Procedures

To transform an object without touching it:

1. Use the Selection Floater from the Tools menu, the Select By Name button on the main toolbar or press the H key to select the object by name.

2. Click a transform button (Move, Rotate, or Scale) on the main toolbar.

3. On the status bar, turn on Selection Lock Toggle or press the Spacebar to lock the selection set.

4. Drag anywhere in the viewport.
   
   The object transforms even though you are not touching it.

To avoid accidentally canceling a selection:

1. Make your object selection.

2. Click Selection Lock Toggle on the status line, or press Spacebar to lock the current selection.
To exit sub-object selection mode, do one of the following:

1. In the Modifier Stack display, choose the object level.
2. Open another command panel. This turns off Sub-Object selection.
   If you’ve turned off Sub-Object selection and object selection is still not restored, one of the following circumstances might be in effect:
   ■ Your selection is locked. Turn off the Selection Lock toggle on the status line.
   ■ You’ve set the Selection Filter in the toolbar to a specific category of object, so you can’t select any of the other categories. To fix this, choose All in the Selection Filter list.

Coordinate Display

Status bar > Coordinate Display area

The Coordinate Display area shows the position of the cursor or the status of a transform, and allows entry of new transform values.

The information in these fields varies, depending on what you are doing:

■ When you are simply moving the mouse in a viewport, these fields show the current cursor location in absolute world coordinates on page 8768.
■ While you are creating an object, these fields also show the current cursor location in absolute world coordinates.
■ While you are transforming an object by dragging in a viewport, these fields always show coordinates relative to the object’s coordinates before the transformation was started. While you are transforming an object, these fields change to spinners on page 49, and you can type values directly in them, as described below in “Using the Coordinate Display for Transform Type-In.” This is an easy alternative to using the Transform Type-In dialog on page 899.
■ While a transform button is active and a single object is selected, but you are not dragging the object, these fields show the absolute coordinates for the current transform. See “Interface,” below.
While a transform button is active and multiple objects are selected, these fields are blank.

When no object is selected and the cursor is not over the active viewport, these fields are blank.

See also:

Units Setup Dialog on page 8366

Procedures

To display the position of the mouse in feet or metric units:

1. Choose Customize > Units Setup.

2. Turn on one of the main categories (Metric, US Standard, Custom, or Generic Units) and choose from the drop-down list.

The coordinate display is now in labeled units.

Example: To position an object in the center of the world:

1. Select an object in the viewport.

2. Right-click and choose Move from the quad menu.

3. Select the value in the x coordinate field, then enter 0. Press Tab.

4. Type 0 in the Y coordinate field, and press Tab.

5. Type 0 in the Z coordinate field.

TIP: Right-clicking the spinner arrows for a coordinate sets the value to zero.

Interface
When you are transforming an object, you can type coordinates directly in the Coordinate Display fields. You can do this in two modes, Absolute or Offset.

- **Absolute** sets the exact coordinates of the object in world space.
- **Offset** transforms the object relative to its existing coordinates.

Click the Absolute or Offset button to toggle between the modes:

While you are typing in the Coordinate Display fields (X,Y,Z), you can use the Tab key to move from one coordinate field to another.

When you transform an object, the information shown by these fields depends on the type of transform:

- **Move** displays the offset XYZ coordinates based on the current coordinate system. For example, if you're moving an object and you're constrained to the X axis, only the X readout will change, displaying the offset of the move along the local X axis.
- **Rotate** displays the offset angle in degrees about the axis or axes the rotation is performed around. This is dependent on both the axis coordinate system, and the local:center toggle button.
- **Scale** displays the offset XYZ scale in percentages.

You can get the absolute as well as offset information through the Transform Type-In dialog on page 899 available from the Tools menu or by right-clicking a transform button that has been selected on the toolbar.

---

**Adaptive Degradation Button**

Status bar > Adaptive Degradation button

Turns adaptive degradation on or off. See Adaptive Degradation on page 123 for more information.
Grid Setting Display

Status bar > Grid Setting Display

The grid setting display shows the size of one grid square.

![Grid Setting Display](image)

This value is constant in the active viewport. It does not change if you zoom in very close or zoom out very far.

**Procedures**

**To change the size of one grid square:**

1. Right-click the Snaps Toggle button on the main toolbar to open the Grid And Snap Settings dialog. Alternatively, choose Tools menu > Grid and Snaps > Grid And Snap Settings.
2. On the Home Grid panel, in the Grid Dimensions group, change the Grid Spacing value.
   The new value is displayed in the grid setting display.
3. Exit the dialog by clicking the Close button (X) at the top-right corner of the dialog.

Time Tag

Status bar > Add Time Tag

Time tags are text labels that you can assign to any point in time in your animation.

![Add Time Tag](image)

They let you easily jump to any point in your animation by selecting its tag name. The tags can be locked to be relative to other time tags so that the movement of one time tag will update the time position of another.
The time tags are not attached to keyframes. They are simply a way to name events that occur in your animation and navigate to them. If you move your keyframes, you will need to update your time tags accordingly.

**Interface**

Left-click or right-click the Time Tag box to display a menu with the following items:

- **Add Tag** Displays the Add Time Tag dialog on page 8085 that lets you define a tag name for the current location in time.
- **Edit Tag** Displays the Edit Time Tag dialog on page 8087 that lets you rename, delete, or edit any defined tag.

The remainder of the menu displays frame numbers and their tag names. Choose a tag name to jump to the spot in time defined by the tag.

**Add Time Tag Dialog**

Status bar > Click in the Time Tag box. > Add Tag

Use the Add Time Tag dialog to define a time tag on page 8084 for the current spot in time.

**Procedures**

**To use time tags:**

1. Move to the spot in time where you want to add a tag.
2. Click in the Time Tag box, and choose Add Tag from the menu.
3. In the Add Time Tag dialog, enter the name of the tag. Choose whether to lock it to time and whether to make it relative to another tag, and click OK.

   The name of the tag appears in the tag slot, and will reappear whenever you go to that spot in time.

   - To jump to a defined tag, click the Time Tag slot and choose the tag name from the list.
   - To rename, delete, or change the properties of a tag, click the Time Tag field and choose Edit Tag on page 8087.
Interface

![Add Time Tag](image)

Tag Time Displays the current frame, to which the tag will be assigned.

Tag Name Enter the name of the tag. You can create a long tag name in this field, but the tag slot will display only 15 characters.

Lock Time Locks the tag to the current frame, regardless of subsequent scaling of time.

For example, with Lock Time off, if you have a tag named "Forty" at frame 40, and you scale time up 200 percent, the Forty tag will be at frame 80. If Lock Time is on, the Forty tag remains at frame 40.

Relative To Lets you assign another tag to which the current tag will maintain a relative offset.

For example, if you have a tag at frame 10 called First and you create a second tag at frame 30 called Second, if you move the position of First to frame 25, Second will move to frame 45 to maintain the 20-frame offset between the two tags.

This is a one-way offset. If you change the time position of the second tag in the example, the first tag is not affected. Circular dependencies are not allowed: you can't have First relative to Second and Second relative to First.
Use the Edit Time Tag dialog to alter the properties of any of the defined time tags on page 8084.

**Procedures**

To edit a time tag:

1. Click in the Time Tag box and choose Edit Tag from the menu.
2. Choose the time tag you want to edit from the list.
3. Use controls in the Edit Time Tag dialog to rename it, or move it in time relative to another time tag.
All of the current tags, along with their associated frame numbers, appear in the window at the top of the Edit Time dialog. Select the tag to edit, then adjust the controls below the window.

**Tag Name** Use this field to rename the selected tag. You can create a long tag name in this field, but the tag slot will display only 15 characters.

**Time** Lets you change the time where the tag is assigned.

**Lock Time** Locks the tag to the current frame, regardless of subsequent scaling of time. For example, with Lock Time off, if you have a tag named Forty at frame 40, and you scale time up 200 percent, the Forty tag will be at frame 80. If Lock Time is on, the Forty tag remains at frame 40.
Relative To  Lets you assign another tag to which the current tag will maintain a relative offset. For example, if you have a tag at frame 10 called First and you create a second tag at frame 30 called Second, if you move the position of First to frame 25, Second will be moved to frame 45 to maintain the 20-frame offset between the two tags.

This is a one-way offset. If you changed the time position of the second tag in the previous example, the first tag is not affected. In addition, circular dependencies are not allowed. You can’t have First relative to Second and Second relative to First.

Delete Tag  Deletes the selected tag.

Animation and Time Controls

The animation controls are found at the bottom of the program window, between the status bar and the viewport navigation controls, along with the time controls for animation playback within viewports.

See also:

- Animation on page 3367
- Animation Quad Menu on page 8058

Animation Controls

Auto Key Animation Mode on page 8090 and Set Key Animation Mode on page 8093

Default In/Out Tangents For New Keys on page 8098

Go To Start on page 8101
Auto Key Animation Mode

Status bar > Time controls > Auto Key (Toggle Auto Key Mode)

Keyboard > N

The Auto Key button toggles the keyframing mode on page 8616 called Auto Key. While Auto Key is on, changes to objects’ position, rotation, and scale are automatically keyframed (recorded). When Auto Key is off, these changes are applied to frame 0.

Alternatively, you can create keyframes manually with Set Key mode on page 8093, which allows you to add keyframes explicitly with the Set Keys button.

When Auto Key mode is active, the Auto Key button is red, as are the active viewport outline and the time slider. These indicators serve to remind you
that you are in Animate mode, and that you are setting keyframes with your actions.

**WARNING** Be sure to turn off Auto Key after keyframing, or you will inadvertently create unwanted animation. Use Undo to remove the unwanted animation. Be careful; it’s easy to forget.

Within an existing animation, you can create keyframes for transforms without the use of Auto Key mode by right-clicking the time slider and then setting the source and destination time. For example, you can use this function to copy an existing Move key to a later frame, so an object pauses its motion momentarily (to keep the object still, you must use linear or step interpolation). You can also set keyframes for other animatable parameters in Track View and the Motion panel without using Auto Key.

See also:

- Using Auto Key Mode  on page 3373
- Set Key Animation on page 8093
- Using Set Key Mode on page 3376

**Procedures**

**To animate an object using Auto Key:**

1. **Auto Key** Turn on the Auto Key button.
   The Auto Key button, the time slider, and the highlight border around the active viewport all turn red.

2. Drag the time slider to a time other than 0.

3. Do one of the following:
   - Move, scale, or rotate an object.
   - Change an animatable parameter.

   For example, assume you start with a cylinder that has not been animated yet and therefore has no keys. You turn on Auto Key, go to frame 20, and rotate the cylinder 90 degrees about its Y axis. This action creates rotation keys at frames 0 and 20. The key at frame 0 stores the original orientation of the cylinder, while the key at frame 20 stores the animated rotation.
of 90 degrees. When you play the animation in the viewport, the cylinder rotates 90 degrees about its Y axis over 20 frames.

4. Turn off the Auto Key button when you are done.

Example: To animate an object between three points using Auto Key:

1. Turn on the Auto Key button.

2. Drag the time slider (to frame 25, for example).

3. Move the object from point A to point B.
   A Move key is created at frames 0 and 25. The establishing key at frame 0 describes the object’s position at point A. The key at frame 25 describes the object’s position at point B.

4. Drag the time slider (to frame 50, for example).

5. Move the object from point B to point C.
   A Move key is created at frame 50 that describes the object’s position at point C.

6. Click the Playback button.
   The object moves from point A to point B over frames 0 to 25, then proceeds to point C over frames 26 to 50.

7. The Playback button turns into a Stop button. Click it to stop playback.
   The position of the object in between the keyframes is determined by the interpolation type used by the controller. Right-click the keys in the track bar and select the transform key to see the controls for adjusting the timing of the in-betweens.

8. Turn off the Auto Key button.
To remove the animation from a scene and start again:

➤ Choose Application menu on page 7989 > New > Keep Objects And Hierarchy.

All the objects remain in the scene, but all keyframes have been removed.

**TIP** To remove the animation from just certain objects, delete their keys in Track View.

Example: To animate a deformation curve of a loft object:

1. Turn on the Auto Key button.
2. Set a current frame with the time slider.
3. Select one or more control points in the deformation curve of a loft object.
4. Use the Move Control Point or Scale Control Point buttons to transform the control points.

To animate a hierarchy with IK interactively:

1. Select any hierarchy that does not already have an IK Solver applied.
2. Click IK on the Hierarchy panel.

3. Turn on the Auto Key button.
4. On the Inverse Kinematics rollout, turn on Interactive IK.
5. Select and move objects in the IK structure on different frames.

**NOTE** This will work on linked hierarchies and bones that do not already have an HI, HD, or Limb Solver applied. This technique allows you to animate hierarchies using IK methods on page 3661 without applying any IK solver on page 3669.

---

**Set Key Animation Mode**

Set Key Animation mode allows you to create keys for selected objects individual tracks using a combination of the Set Keys button and Key Filters.
Unlike Auto Key, Set Key mode gives you control over what you key and when. It allows you to pose a character (or transform any object) and then if you like it, use that pose to create keys. If you move to another point in time without keying, your pose is discarded. Set Key also works with object parameters.

You can try out different values and then when you have what you like use it to create keys. Combine this with keyable tracks in the Curve Editor to create keys on just the object parameters you want to key.

**Set Key Workflow**

To animate something using Set Key mode, you first turn on Set Key Mode. You can then select the object you want to animate and use the Key Filters button to set which tracks you want to keyframe. You can also use Show Keyable icons in Track View edit windows to make individual tracks keyable or not. With all this setup work completed, you can create keys by clicking the Set Key button (the large button with the key icon) or using Keyboard shortcut (K). Move ahead in time, then make changes to your character or object (transforms or parameter changes) and click Set Keys to use those changes to create keys.

If you do not click the Set Keys button and move to another frame the object changes will be lost, as if you had never made them. This is fundamentally different behavior from Auto Key mode, where you would need to use undo to lose the changes you made. Use the right mouse button on the time slider to drag a pose or transform to a different point in time.

For faster workflow you can define keyboard shortcuts for the Key Filters and Show Keyable tools by going to Customize menu > Customize User Interface and assigning keystroke combinations in the Main UI group.

**Procedures**

**To animate using Set Key mode:**

1. **Set Key** Turn on Set Key mode.

2. Select the objects you want to keyframe, and then right-click and choose Curve Editor.
3. On the Track View toolbar, click Show Keyable Icons, then use the keyable icons in the controller window to define which tracks will be keyed.

- A red key means the track will be keyed. Click a key to toggle keyable status.

4. Click Key Filters and then turn on the tracks you want to keyframe. By default, Position Rotation, Scale, and IK Parameters are on. For this example, turn off Rotation and Scale.

5. Go to a frame at which you want to set a key.

6. Move an object.

7. Click the Set Keys button.

The Set Key button flashes red to show that it has set a key, and a key appears on the track bar.
Repeat this process, moving the time slider and setting keys.

To keyframe all parameters using Set Key mode:

1. Turn on Set Key mode.

2. In the viewport, select the objects to which you want to add keyframes.

3. Click Key Filters and then turn on the Key All.

4. Move the time slider to the frame where you wish to set keys.

5. Click the Set Keys button.

Keys will be added to all keyable parameters.

To move a pose or position in time without update:

1. Turn on Set Key.
2. Move to a particular frame (let's say frame 20).
3. Pose your character or position your object(s).
4. Move your cursor over the time slider, then press the right mouse button down and drag.
   The time slider moves, but the position does not change. The pose or position is maintained and transferred to the new point in time.
5. When you are at the appropriate frame, set the pose or position keys by clicking Set Keys.

Interface

Set Key Toggles Set Key mode.

Set Keys Click this to set a key. This button will create a key on tracks for the selection set. It checks that the tracks are keyable, and that Key filters allow the tracks to be keyed. If both these are satisfied, a key is set. Set Keys also sets keys in Auto Key mode, and in Layout mode (the mode when neither Auto Key nor Set Key is turned on). Keyboard shortcut default for this command is K.

Key Filters Displays the Set Key Filters dialog where you can define which type of tracks will be allowed or disallowed keys.

Selection List Gives quick access to named selection sets on page 217 and track sets on page 3974 while working with Set Key. Lets you easily swap among different selection sets and track sets.

NOTE Choosing a selection set from the list does not select objects in the viewports. To accomplish this, use the Named Selection Sets on page 217 feature.

NOTE Selection set names appear between braces (example: {Biped Arms}) while track set names appear between square brackets (example: [Throw Baseball]).

Set Key Filters dialog Turn on the tracks you want to key. Default=Position, Rotation, Scale and IK Parameters.
The following options are available:

- **All** allows for a quick way to key all tracks. When All is turned on, the other toggles are unavailable. Clicking Set Keys with the All filter turned on will result in a key placed on all keyable tracks.

- **Position** allows for position keys to be created.

- **Rotation** allows for rotation keys to be created.

- **Scale** allows scale keys to be created.

- **IK Parameters** allows inverse kinematic parameters to be keyframed.

- **Object Parameters** allows object parameters to be keyframed.

- **Custom Attributes** allows custom attributes to be keyframed.

- **Modifiers** allows modifiers to be keyframed. Note that you should turn on Object parameters when you turn on modifiers, so you can keyframe gizmos.

- **Materials** allows material properties to be keyframed.

- **Other** allows for other parameters that don't fall in the above categories to be keyframed using the Set Key technique. This includes such things as helper properties and look-at controller tracks for target cameras and lights.
WARNING If you turn on Object Parameters, all the object parameters of an object will then receive keys, unless you have turned off the tracks using Keyable on the Controller menu of Track View – Curve Editor. The same advice applies to Materials.

TIP You can also set keys on spinners by holding down the Shift key and right-clicking a spinner.

Default In/Out Tangents For New Keys

Status bar > Animation controls > Default In/Out Tangents For New Keys flyout

This flyout provides a quick way to set a default tangent type on page 3420 for new animation keys created with Set Key Mode on page 8093 or Auto Key Mode on page 8090. You can also access the tangent types on page 3420 from the Key Info (Basic) rollout on page 3418 and the Curve Editor’s Key Tangency toolbar on page 3873.

NOTE Changing tangent types does not affect existing keyframes, only new ones.

On each new set keyframe, the Key Tangent flyouts on the Key Info (Basic) rollout updates with the current default tangent type.

When you set a default tangent type, both the in and out tangents are set to match that type. If you set different in and out tangents via the Controller Defaults group of the Animation Preferences panel on page 8346, the current flyout icon changes to a question mark.

NOTE Setting a default tangent type stores it in the 3dsmax.ini on page 60 file, from which it is restored after a scene reset or session change.

See also:

■ Specifying Default Controllers on page 3400
Procedures

Example: To set a default tangent type:

1 Create a sphere.

2 Turn on Auto Key, go to frame 10, and move the sphere on all three axes.

3 Right-click the sphere. From the quad menu, choose Curve Editor.

4 Choose the Linear tangent type (second icon from the top) from the Default In/Out Tangents For New Keys flyout.
5 Go to frame 20 and move the sphere elsewhere in your scene.
The curve starts curvy at frame 10 but straightens out near frame 20. Its interpolation transitions from an Flat out tangent to a Linear in tangent.

6 Go to frame 30 and move the sphere again.
The curve interpolation from frame 20 to 30 is straight because both keys have tangents set to Linear.
Go To Start

Status bar > Time controls > Go To Start
Keyboard > Home

Go To Start moves the time slider to the first frame of the active time segment on page 8496. The active time segment is set in the Start Time and End Time fields of the Time Configuration dialog on page 8106.

Previous Frame/Key

Status bar > Time controls > Previous Frame
Keyboard > , (comma)

Previous Frame moves the time slider on page 8068 back one frame.

If Key Mode on page 8105 is on, the time slider moves to the previous keyframe on page 8616. Keyframe options are set in the Key Steps group of the Time Configuration dialog on page 8106.
If Time Configuration dialog > Use TrackBar is on, Previous Key jumps to the previous key of any kind. If Use TrackBar is off, Previous Key jumps to the previous transform key, ignoring any other type of keys.

Play/Stop

Status bar > Time controls > Play
Status bar > Time controls > Stop
Keyboard > / (to play); Esc (to stop)

The Play button plays the animation in the active viewport. If you click another viewport to make it active, the animation continues playing in that viewport. When the animation is playing, the Play button becomes a Stop button. The Play button is a flyout for playing only the animation of selected objects.

TIP You can play the animation in all the viewports simultaneously by turning off Active Viewport Only in the Time Configuration dialog on page 8106.

Procedures

To play the animation in the viewport:

1. Activate the viewport where you want to play the animation.

2. Click the Play button.
   
   The animation plays in the viewport. The Play button becomes a Stop button.

3. Click Stop to end the playback.
   
   The speed of the animation playback is determined by the settings in the Time Configuration dialog, the complexity of the scene and the speed of the graphics card and processor.
To play the animation looped backward:

1. Click the Time Configuration button on the status bar.
2. In Time Configuration dialog > Playback group, turn off Real Time. The Direction buttons are now available.
3. Turn on Reverse and click OK.
4. Click the Play button. The animation plays backward.
5. To play the animation front-to-back and then back-to-front in a continuous loop, turn on Ping-Pong as the Direction.

To play the animation of a selected object only:

1. In a viewport, select a single animated object or a set of animated objects.
2. Click Play Selected on the Play/Stop flyout. Only the selection is animated in the viewport.
3. To end playback, click the Stop button or press Esc.

Interface

The Play/Stop flyout contains two buttons. Both buttons become a Stop button when in use.

- **Play** Plays the animation in the currently active viewport.
- **Play Selected** Plays the animation for selected objects only in the currently active viewport.
- **Stop Animation** Replaces the Play button when an animation is playing. Click to stop the playback.
Stop Animation (Selected) Replaces the Play Selected button when an animation is playing. Click to stop the playback.

Next Frame/Key

Status bar > Time controls > Next Frame
Keyboard > . (period)
Next Frame moves the time slider on page 8068 ahead one frame.

If Key Mode on page 8105 is on, the time slider moves to the next keyframe on page 8616. Keyframe options are set in the Key Steps group of the Time Configuration dialog on page 8106.

If Time Configuration dialog > Use TrackBar is on, Next Key jumps to the next key of any kind. If Use TrackBar is off, Next Key jumps to the next transform key, ignoring any other type of keys.

Go To End

Status bar > Time controls > Go To End
Keyboard > END
Go To End moves the time slider on page 8068 to the last frame of the active time segment on page 8496. The active time segment is set in the Start Time and End Time fields of the Time Configuration dialog on page 8106.

Current Frame (Go To Frame)

Status bar > Time controls > Current Frame (and Go To Frame)
Current Frame displays the current frame number, indicating the position of the time slider on page 8068. You can also enter a frame number in this field to go to that frame.
Procedures

To move to a particular frame, do one of the following:

1. To go to the specified frame, type the frame number and press Enter.
2. Move the time slider and observe the frame number updating on the time slider.
3. To change the value in the frame number field, click or drag the spinner.

Key Mode

Status bar > Time controls > Key Mode

Key Mode lets you jump directly between keyframes on page 8616 in your animation. By default, Key Mode uses the keys visible in the track bar below the time slider. Other options are available on the Time Configuration dialog on page 8106 in the Key Steps group.

When the Auto Key button is on and you change an object’s creation parameters or performed a transform on page 8750, or change a material or modifier applied to that object, 3ds Max automatically creates a keyframe.

Key Mode can respect all keyframes, or you can restrict it to move only to transform keys via the Key Steps options on the Time Configuration dialog. When Key Steps > Use TrackBar is on, Key Mode jumps to keyframes of any type. When Use TrackBar is off, Key Mode respects only transform keys.

Procedures

To use Key Mode:

1. Turn on Key Mode.
   - The button turns blue when Key Mode is active.

2. Use the Previous Key on page 8101 and Next Key on page 8104 buttons to move from one keyframe to the next.
   - If the current frame does not jump to the keys, make sure the object is selected in the viewport.
If it still doesn’t seem to be working, configure Key Mode to Use TrackBar, as described in the following procedure.

To configure Key Mode:

1. Click Time Configuration, or right-click any animation-control button, including Key Mode.
   The Time Configuration dialog opens.

2. Choose options in the Key Steps group.
   If you turn on Use TrackBar and turn Key Mode on, then clicking Next Key advances to the next key for the selected object. This will respect every type of key that appears in the track bar. If you turn Use TrackBar off, only transform keys are used by key mode.

**Time Configuration**

Status bar > Time controls > Time Configuration > Time Configuration dialog

The Time Configuration dialog provides settings for frame rate, time display, playback, and animation on page 8505. You use this dialog to change the length of your animation, or stretch or rescale it. You also use it to set the start and end frames of the active time segment on page 8496 and your animation.

See also:

- Setting Time Segments on page 3387

**Procedures**

To define the active time segment:

1. Click Time Configuration.

2. In the Time Configuration dialog > Animation group, set Start Time to specify the beginning of your active time segment.
3 Do one of the following:
   ■ Set End Time to specify the end of your active time segment.
   ■ Set Length to specify the amount of time in the active time segment
     and automatically set the correct End Time.
     You can enter positive or negative values in any spinner, but you must
     use the same format used by the time display.
     You can change the active time segment without affecting the keys
     you've created. For example, if you have keys scattered over a range
     of 1000 frames, you can narrow your active time segment to work on
     only frames 150 to 300. You can only work on the 150 frames in the
     active segment, but the remainder of the animation stays intact.
     Returning the active segment from 0 to 1000 restores access and
     playback of all the keys.
     Changing the active time segment has the following effects: it restricts
     the range of time you can use with the time slider, and it restricts the
     range of time displayed when using the animation playback buttons.
     The default setting for the active time segment runs from frames 0 to
     100, but you can set it to any range.

To stretch out your existing animation over a longer time:

1 In the Time Configuration dialog > Animation group, click Re-scale Time.
2 Change the value in Length to be the number of frames you want the
   action to fill.
3 Click OK.
   The animation is rescaled to the new number of frames.
   This also works to compress animations into a shorter space of time. To
   avoid losing frames during the rescaling, see “To use sub-frame animation”
   in this set of procedures.

To add frames onto your existing animation:

This procedure adds new frames to the end of your animation, without
affecting your existing work.

1 In the Time Configuration dialog > Animation group > End Time field,
   enter the number of the last frame of the animation.
   For example, if your existing animation is 100 frames long and you want
   to add 50 frames, enter **150**.
2 Click OK.
   The number you entered is now the new length of the animation, shown on the time slider.

To move to an exact time in your animation:
- In the Time Configuration dialog > Animation group, enter the frame number in the Current Time field, and press Enter.
  The viewport updates to this frame.

To set the frame rate of your animation:
In the Time Configuration dialog > Frame Rate group, do one of the following:
1 Choose one of the standard frame rates such as PAL or NTSC.
2 Choose Custom, and specify a frame rate in the FPS (frames-per-second) field.

To configure viewport playback:
- In the Time Configuration > Playback group, turn on or off the Real Time and Active Viewport Only boxes.

To play your animation in reverse or back and forth:
1 In the Time Configuration > Playback group, turn off the Real Time.
2 Choose the direction of the animation playback by selecting Forward, Reverse, or Ping-Pong.
3 Play the animation in the viewport using the Play button or the / key.

To play your animation only once:
1 In the Time Configuration > Playback group, turn off Loop.
2 Choose the direction of the animation playback by selecting Forward, Reverse or Ping-Pong.
3 Play the animation in the viewport using the Play button or the / key.
   The animation will play once and stop.
To play your animation in multiple viewports:

1. In the Time Configuration > Playback group, turn off Active Viewport Only. Click OK.
2. Play your animation.
   The animation now plays in all four viewports.

To use sub-frame animation:

1. In the Time Configuration > Time Display group, turn on FRAME:TICKS or MM:SS:TICKS. Click OK.
2. Move the time slider to set keyframes in between keys.

TIP Use this when you scale an animation down from a longer length to insure that you won’t lose any keys. You can then move the keys to frames and revert to frames without ticks.

To play an animation with sound:

- In the Time Configuration > Playback group, be sure you have Real Time turned on. If Real Time is not on, the sound will not play back during the animation.

Interface

These are the controls for the Time Configuration dialog. You can display this dialog by right-clicking any of the time control buttons to the right of the Auto Key button.
Frame Rate group

These four option buttons, labeled NTSC on page 8654, Film, PAL on page 8674, and Custom let you set the frame rate on page 8585 in frames-per-second (FPS). The first three buttons force the standard FPS for that choice. The Custom button lets you specify your own FPS by adjusting the spinner.

FPS (Frames Per Second) Sets the frame rate of your animation in Frames per Second. Use frame rates of 30 fps for video, 24 for film, and lower rates for web and media animations.
**Time Display group**

Specifies the method for displaying time in the time slider and throughout 3ds Max. Choices are Frames or in minutes, seconds and ticks.

For example, if the time slider is at frame 35, and the Frame Rate is set to 30 fps, the time slider would display the following numbers for the different Time Display settings:

- **Frames**: 35
- **SMPTE**: 0:1:5
- **FRAME: TICKS**: 35:0
- **MM:SS: TICKS**: 0:1:800

SMPTE is the *Society of Motion Picture Technical Engineers* standard used to measure time for video and television production.

**Playback group**

**Real Time**  
*Real Time* on page 8697 causes viewport playback to skip frames to keep up with the current Frame Rate setting. A choice of five playback speeds is available: 1x is normal speed, 1/2x is half speed, and so on. The speed settings affect only the playback in the viewports. These speed settings can also be used with the *Motion Capture utility* on page 4137.

When Real Time is off, viewport playback occurs as rapidly as possible and displays all frames.

**Active Viewport Only** Causes playback to occur only in the active viewport. When off, all viewports display animation.

**Loop** Controls whether the animation playback occurs only once, or repeatedly. When on, playback repeats until you stop it by clicking an animation control button or the time slider channel. When off, the animation plays once and then stops. Clicking Play rewinds to the first frame and plays again.

**Direction** Set the animation to play forward, reverse, or ping-pong (forward and then reverse, repeating). This affects only the playback in the interactive...
It does not apply when rendering to any image output file. These options are available only when Real Time is off.

You can recall these settings automatically upon startup or reset by saving a maxstart.max file. See Startup Files and Defaults on page 59.

**Animation group**

**Start Time/End Time** Sets the active time segment on page 8496 displayed in the time slider. Choose any time segment before or after frame 0. For example, you can set an active time segment from –50 to 250.

**Length** Displays the number of frames in the active time segment. If you make this greater than the total frames in the active segment, the End Time field increases accordingly.

**Frame Count** The number of frames that will render. Always the length plus one.

**Current Time** Specifies the current frame for the time slider. As you adjust this, the time slider moves accordingly and the viewport updates.

**Re-scale Time** Stretches or shrinks the animation for the active time segment to fit into the new time segment you specify. Relocates the position of all keys on page 8616 in all tracks. As a result, the animation plays over a greater or lesser number of frames, making it faster or slower.

**Key Steps group**

Controls in this group let you configure the method used when you turn on Key Mode on page 8105.

**Use TrackBar** Allows key mode to honor all keys in the track bar. This includes any parameter animation in addition to transform keys.

To make the following controls available, turn off Use TrackBar.

**Selected Objects Only** Considers only the transforms on page 8750 of selected objects when you use Key Steps mode. If you turn this off, the transforms of all (unhidden) objects in the scene are considered. Default=on.

**Use Current Transform** Disables Position, Rotation, and Scale and uses the current transform in Key Mode. For example, if the Rotate button is selected in the toolbar, you stop at each rotation key. If none of the three transform buttons are on, Key Mode considers all transforms.

To make the following control available, turn off Use Current Transform.

**Position, Rotation, Scale** Specifies which transforms are used by Key Mode.
Clear Use Current Transform to make the Position, Rotation, and Scale check boxes available.

**Viewport Controls**

You can choose different views to display in these four viewports as well as different layouts from the viewport label menus on page 8117.

**See also:**
- Viewport Configuration on page 8374
- Viewport Label Menus on page 8117

**Viewport Layouts**

You can choose from other layouts different from the default configuration. To choose a different layout, click or right-click the General viewport label ([+]), and from the General viewport label menu on page 8117, choose Configure. Click the Layout tab of the Viewport Configuration dialog to see and choose the alternative layouts.

**Typical viewport layout**
NOTE The viewport layout is saved with your MAX file.

TIP You can change the default viewport layout by saving a maxstart.max file with the desired viewport configuration and placing it in the \defaults folder on page 8246.

Active Viewport Borders

When four viewports are visible, one viewport, marked with a highlighted border, is always active. This is where commands and other actions take effect. Only one viewport at a time can be active. Other viewports are for observation only; unless disabled, they simultaneously track actions taken in the active viewport. When Auto Key or Set Key is on, the active viewport border changes from yellow to red.

In general, a viewport becomes active as you work in it. You can move an object in one viewport, and then drag the same object in another viewport to continue the move. To activate a viewport without changing the selection, right-click it. If you left-click a viewport, the viewport is activated and whatever you click is selected, or, if you click an empty area, everything is deselected. You can restore previous selections with Undo.

Viewport Labels

Viewports are labeled in the upper-left corner. You can control many aspects of a viewport by using the viewport label menus on page 8117.

Dynamic Resizing of Viewports

You can resize the four viewports so they are of unequal proportions. To do so, drag the intersection of two, three, or four viewports, on the splitter bars. To return to the original layout, right-click an intersection of the dividing lines and choose Reset Layout from the right-click menu.

The new viewport proportions are saved in the scene. However, changing the viewport layout on page 8379 always resets them.

World-Space Tripod
The three-color world-space tripod is visible in the lower-left corner of each viewport. The colors correspond to the three axes of world space: red=X, green=Y, and blue=Z. The axes are labeled in these same colors. The tripod always refers to world space, regardless of the current reference coordinate system.

The world-space tripod is on by default. To turn off this feature, see “To turn off the world-space tripod in all viewports” in the following procedures.

**Viewport Tooltips for Object Names**

When you’re working with objects in a viewport and pause the cursor over any unselected object, a tooltip appears with the name of that object. If you need to select something or link to something, wait until you see the tooltip to be sure you have selected the object you want. These tooltips are disabled when you work in sub-object mode.

Tooltips on page 8299 are on by default. To turn off this feature, see **To turn off object name tooltips** on page 8116, below.

**See also:**
- Viewport Navigation on page 8135
- The 3ds Max Window on page 42

**Procedures**

**To make a viewport active, do one of the following:**

1. Click any viewport.
   - If you click an object in the viewport, it is selected. If you click a space where there are no objects, any selected objects are deselected.

2. Right-click any viewport.
   - Right-click activates a viewport without changing the selection state of objects. (You can also do this by left-clicking the viewport label.)

**To switch between single and multiple viewports:**

Activate the viewport you want to minimize or maximize, and do one of the following:

1. On the keyboard, press the W key.
2 On the keyboard, press Alt+W.

3 Click the Maximize Viewport Toggle button in the lower-right corner of the 3ds Max window.

To resize the viewports:

1 Drag the intersection of two, three, or four viewports to move the horizontal and vertical splitter bars.

2 Move the intersection to any new location.
   If you don’t drag a corner, you can move the borders horizontally or vertically only.

3 To reset the viewports, right-click an intersection and choose Reset Layout from the right-click menu.

To change the number of viewports and their arrangement:

1 In any viewport, click or right-click the General viewport label (+). 3ds Max opens the General viewport label menu on page 8117. Choose Configure.

2 On the Viewport Configuration dialog, click the Layout tab.

3 Choose a layout from the choices at the top of the dialog.

4 Assign what each viewport will display in the lower window of the dialog by clicking or right-clicking a viewport representation and choosing from the right-click menu.

5 Click OK to make the change.

To turn off the world-space tripod in all viewports:

1 Choose Customize menu > Preferences to display the Preferences dialog.

2 Click the Viewports tab.

3 In the Viewport Parameters group, turn off Display World Axis.

4 Click OK to make the change.

To turn off object-name tooltips:

1 Choose Customize menu > Preferences to display the Preferences dialog.
2 Click the General tab.

3 In the UI Display group, turn off Enable Viewport Tooltips.

4 Click OK to make the change.

Viewport Label Menus

Click or right-click one of the three labels in the upper-left corner of a viewport. > General Viewport Label menu, Point-Of-View (POV) Viewport Label menu, or Shading Viewport Label menu

In the upper-left corner of each viewport is a label bar that consists of three labels. Each label is a clickable shortcut menu to control viewport display.

**TIP** If the viewport menu label bar becomes disabled, you can restore it by refreshing the UI scheme. Use Customize menu > Load Custom UI Scheme on page 8279 to load a different CUI file, then reload the original CUI file again. The label bar will become available after either the new or original UI scheme is loaded.

General Viewport Label Menu

Click or right-click the General label in the upper-left corner of a viewport. The text of this label is “[+]”. > General Viewport Label menu

The General viewport label ( [+ ] ) menu provides options for overall viewport display or activation. It also gives you access to the Viewport Configuration dialog.

**NOTE** You can customize this menu. On the Menus panel of the Customize User Interface dialog, choose Viewport Menu Label Bar from the menu list on the right. This menu is named “General Viewport Label Menu.”

Procedures

To access the Viewport Configuration dialog, do one of the following:

- Choose Customize menu > Viewport Configuration.
- Click or right-click the General viewport label ([+]), and choose Configure.
To access the Layout panel, do one of the following:

- Choose Customize menu > Viewport Configuration, then click the Layout tab.
- Click or right-click the General viewport label ([+]), and choose Configure, then click the Layout tab.

To toggle display of the home grid in the active viewport, do one of the following:

- Choose Views menu > Grids, and click Show Home Grid.
- Click or right-click the General viewport label ([+]), and then click Show Grid.
- Press G.

**Interface**

<table>
<thead>
<tr>
<th>Maximize Viewport</th>
<th>Alt+W</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active Viewport</td>
<td></td>
</tr>
<tr>
<td>Disable Viewport</td>
<td>D</td>
</tr>
<tr>
<td>Show Statistics</td>
<td>7</td>
</tr>
<tr>
<td>Show Grids</td>
<td>G</td>
</tr>
<tr>
<td>ViewCube</td>
<td></td>
</tr>
<tr>
<td>SteeringWheels</td>
<td></td>
</tr>
<tr>
<td>Configure…</td>
<td></td>
</tr>
</tbody>
</table>

**Maximize Viewport / Minimize Viewport** This entry either maximizes or minimizes the viewport. It is equivalent to the Maximize Viewport toggle on page 8139.

Keyboard shortcut: Alt+W

**Active Viewport** Lets you choose the active viewport from a submenu list of the viewports that are visible in the current viewport configuration.
Disable Viewport Prevents the viewport from updating with changes made in other viewports. While the disabled viewport is active, it behaves normally. However, when you change the scene in another viewport, the view in the disabled viewport does not change until you activate the viewport again. Use this control to speed up screen redraws when you are working on complex geometry.

While a viewport is disabled, the text “<Disabled>” appears to the right of the viewport label menus.

Keyboard shortcut: D

Show Statistics Toggles the viewport display of statistics on page 2760 for the entire scene, your current selection, or both.

Keyboard shortcut: 7

Show Grids Turns on and off the display of the home grid. Does not affect other grid display.

Keyboard shortcut: G

Select Camera / Select Light If the viewport is showing a Camera or a Light view (see Point-Of-View (POV) Viewport Label Menu on page 8122), this option appears. It lets you select the Camera or Light object that displays the view.

Select Camera Target / Select Light Target If the viewport is showing a Camera or a Light view (see Point-Of-View (POV) Viewport Label Menu on page 8122), and that Camera or Light has a target, this option appears. It lets you select the Camera Target or Light Target object associated with the Camera or Light that displays the view.

ViewCube Displays a submenu on page 8120 with options for ViewCube display.

SteeringWheels Displays a submenu on page 8121 with options for SteeringWheels display.

Configure Displays the Viewport Configuration dialog on page 8374.
ViewCube submenu

NOTE If you are using the software display driver on page 8317, the ViewCube is not displayed, and this submenu is empty.

This submenu provides options for displaying and using the ViewCube on page 86.

Show for Active View Displays the ViewCube only in the active viewport.

Show for All Views Displays the ViewCube in all viewports, whether active or not.

Home Displays the Home view of the model. See Define the Home View on page 93.
Keyboard shortcut: Alt+Ctrl+H

Orthographic Changes the view to an Orthographic view. See Set the View Projection Mode on page 92.

Perspective Changes the view to a Perspective view. See Set the View Projection Mode on page 92.
NOTE  Choosing this option also changes the setting of the POV menu.

---

**Set Current View as Home** Defines the current view in this viewport as the Home view for the scene.

**Set Current View as Front** Defines the current view as the Front view of the model.

**NOTE** You first need to orient the view using a view tool so that you are looking at what you consider to be the Front of the model with its Top facing upward and then choose Set Current View as Front.

**Reset Front** Restores the Front view to the original Front view of the scene.

---

**Configure** Displays the ViewCube panel on page 8400 of the Viewport Configuration dialog.

**SteeringWheels submenu**

**NOTE** If you are using the software display driver on page 8317, SteeringWheels are not displayed, and this submenu is empty.

<table>
<thead>
<tr>
<th>SteeringWheels</th>
<th>Shift+W</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Object Wheel</td>
<td></td>
</tr>
<tr>
<td>Tour Building Wheel</td>
<td>Shift+Ctrl+J</td>
</tr>
<tr>
<td>Full Navigation Wheel</td>
<td></td>
</tr>
<tr>
<td>Mini View Object Wheel</td>
<td></td>
</tr>
<tr>
<td>Mini Tour Building Wheel</td>
<td></td>
</tr>
<tr>
<td>Mini Full Navigation Wheel</td>
<td></td>
</tr>
<tr>
<td>Configure...</td>
<td></td>
</tr>
</tbody>
</table>

This submenu provides options for displaying and using SteeringWheels on page 93.

**Toggle SteeringWheels** Toggles SteeringWheels display for this viewport. Keyboard shortcut: Shift+W
View Object Wheel Displays the View Object wheel on page 99.

Tour Building Wheel Displays the Tour Building wheel on page 100.

Full Navigation Wheel Displays the Full Navigation wheel on page 101.

Mini View Object Wheel Displays the mini version of the View Object wheel on page 99.

Mini Tour Building Wheel Displays the mini version of the Tour Building wheel on page 100.

Mini Full Navigation Wheel Displays the mini version of the Full Navigation wheel on page 101.

Configure Displays the SteeringWheels panel on page 8402 of the Viewport Configuration dialog.

Point-Of-View (POV) Viewport Label Menu

Click or right-click the Point-Of-View label in the upper-left corner of a viewport. The text of this label shows the current point of view; for example, “[ Perspective ]”. > Point-Of-View (POV) Viewport Label menu

The Point-Of-View (POV) viewport label menu provides mainly options that change what is displayed in the viewport: the POV, and also graph editor windows you might choose to dock in a viewport. A few other options change the viewport display without changing the POV.

TIP Another method for switching viewpoints is the ViewCube on page 86.

NOTE You can customize this menu. In the Menus tab of the Customize User Interface dialog, choose Viewport Menu Label Bar from the menu list on the right. This menu is named “POV Viewport Label Menu.”
Procedures

To change a viewport to Camera view:

This procedure requires at least one camera object in your scene. As an alternative, to create a camera and set it to a viewport at the same time, activate a Perspective viewport and then press Ctrl+C.

1  Click or right-click the POV viewport label.

2  Choose Camera > camera name.

This assigns the camera to the viewport and changes the POV label to the camera name.

A camera viewport tracks the view through the POV of that camera. As you move the camera (or target) in another viewport, you see the view change accordingly. If you alter the camera's field of view on page 8146, you see the changes as they are applied.

TIP  You can also press C as a shortcut to change any active viewport to an existing camera view.

To change a viewport to a shape view:

This procedure requires at least one shape object in your scene. (If the shape is not selected, or if you select 3D geometry instead, the resulting view appears distorted.)

1  Select the shape you want to view.

2  Click or right-click the POV viewport label.

3  Choose Shape from the menu.

To use viewport clipping:

1  Click or right-click the POV viewport label.

2  Choose Viewport Clipping.

The viewport displays the viewport clipping controls.

3  Move the lower slider up until the geometry is clipped in the viewport by the near clipping plane.

4  Adjust the upper slider to clip the geometry with the far clipping plane.
To display Schematic View in a viewport:
1 Click or right-click the POV viewport label.
2 Choose Schematic > New, or choose the name of the Schematic View to display.

To display Track View in a viewport:
1 Click or right-click the POV viewport label.
2 Choose Track > New, or choose the name of the Track View to display.

To display the Asset Browser or MAXScript Listener in a viewport:
1 Click or right-click the POV viewport label.
2 Choose Extended > Asset Browser or MAXScript Listener.
   The window you chose is displayed in the viewport.
   To return to a Geometry view, or change to another editor window, right-click the menu bar or toolbar and choose the POV.

   **NOTE** When you open the MAXScript Listener in this way, and then change the viewport POV, 3ds Max opens the Listener in a window of its own.

To display the Biped Animation Workbench or the Motion Mixer in a viewport:
1 Click or right-click the POV viewport label.
2 Choose Extended > Biped Animation Workbench or Motion Mixer.
   The window you chose is displayed in the viewport.

   **NOTE** If you haven’t selected a biped before you choose Biped Animation Workbench, the viewport displays a warning to that effect. Selecting a biped body part in another viewport updates the Workbench view.

   To return to a Geometry view, or change to another editor window, right-click the menu bar or toolbar and choose the POV.

To display the Material/Map Browser or Material Explorer in a viewport:
1 Click or right-click the POV viewport label.
2 Choose Extended > Material Browser or Material Explorer.
The window you chose is displayed in the viewport.

To return to a Geometry view, or change to another editor window, right-click the menu bar or toolbar and choose the POV.

To turn on safe frame display, do one of the following:

■ Click or right-click the POV viewport label, and then choose Show Safe Frames.

■ Press Shift+F.

■ Choose Customize menu > Viewport Configuration > Safe Frames panel, and turn on Show Safe Frames In Active View.

See Safe Frames on page 8380.
Interface

Cameras If the scene contains cameras, the menu lists these in a submenu. Choosing a camera name changes the viewport to the camera POV. See also Camera Viewport Controls on page 8154.

Lights If the scene contains spotlights or directional lights, the menu lists these in a submenu. Choosing a light name changes the viewport to the light POV. See also Light Viewport Controls on page 8165.

Standard POV These options list the standard POV choices for viewports:
- Perspective
Keyboard shortcut: P
- Orthographic
  Keyboard shortcut: U
- Top
  Keyboard shortcut: T
- Bottom
  Keyboard shortcut: B
- Front
  Keyboard shortcut: F
- Back
- Left
  Keyboard shortcut: L
- Right

See also Perspective and Orthographic Viewport Controls on page 8141.

Viewport Clipping Lets you set a near and far visibility range for the viewport interactively. Geometry within the viewport clipping range is displayed. Faces outside the range are not displayed. This is useful in complex scenes where you want to work on details that are obscured from view.

This option is a toggle: the first time you choose it, Viewport Clipping is turned on. Choosing the option a second time turns Viewport Clipping off, and so on.

When you turn on Viewport Clipping, the viewport displays two yellow slider arrows on the right side. Adjusting the lower arrow sets the near end of the range, and adjusting the upper arrow sets the far end. Tick marks on the range slider indicate the extents of the viewport.

You can also toggle Viewport Clipping on the Viewport Configuration dialog on page 8374.

Show Safe Frames Turns on and off the display of safe frames on page 8380. You define the safe frames in the Viewport Configuration dialog on page 8374. The safe frame proportions conform to the Width and Height of the output size of your rendering image output.
**Undo View Change** Undoes the last viewport change.
Keyboard shortcut: Shift+Z

**TIP** To redo a view change, press Shift+Y.

---

**Track [View]** Displays a submenu that lists existing Track Views on page 3790, if any. Choose a Track View to display it in the viewport.
The submenu also has a New option that lets you create a new Track View.
To change the viewport from a Track View back to another POV, right-click the menu bar and choose a different viewpoint.

**Schematic [View]** Displays a submenu that lists existing Schematic Views on page 7922, if any. Choose a Schematic View to display it in the viewport.
The submenu also has a New option that lets you create a new Schematic View.
To change the viewport from a Schematic View to another POV, right-click the menu bar and choose a different viewpoint.

**Grid** Displays a submenu that changes the POV based on the active grid. These options are meant mainly for use with Grid objects on page 2789. If no Grid object is activated, they operate on the Home grid on page 2787.

**WARNING** Changing the Grid POV also changes the default Perspective view.

- Front
  Changes the view to a Front view for the grid.

- Back
  Changes the view to a Back view for the grid.

- Top
  Changes the view to a Top view for the grid.

- Bottom
  Changes the view to a Bottom view for the grid.

- Left
  Changes the view to a Left view for the grid.

- Right
  Changes the view to a Right view for the grid.
Display Planes
Changes the view to the active display plane for the grid. You set the active plane on the Modify panel > Parameters rollout > Display group > XY Plane, YZ plane, or ZX plane.

See also Viewing Grid Objects on page 2791.

Extended These options let you dock additional graph editors or other windows in the viewport.
To change the viewport from the docked window to another POV, right-click the menu bar or toolbar, and choose a different viewpoint.

■ Asset Browser on page 7614

■ Biped AnimationWorkbench on page 4823
If you haven’t selected a biped before you choose this option, the viewport displays a warning to that effect. Selecting a biped body part in another viewport updates the Workbench view.

■ Motion Mixer on page 4002

■ MAXScript Listener on page 8229

NOTE When you open the MAXScript Listener in this way, and then change the viewport POV, 3ds Max opens the Listener in a window of its own.

■ Material Explorer on page 5734

Shape Aligns the view to the extents of a selected Shape object on page 572 and its local XY axes
If you have not selected a Shape object before you choose Shape, this option can have peculiar results.

WARNING The Shape option changes the default Perspective view.

ActiveShade Changes the viewport to render with ActiveShade on page 6550. This option does not change the viewport POV.
To exit ActiveShade, right-click the shaded viewport and choose Close from the View (upper-left) quadrant of the ActiveShade quad menu.
Shading Viewport Label Menu

Click or right-click the Shading label in the upper-left corner of a viewport. The text of this label shows the current shading style; for example, “[Wireframe]” or “[Smooth + Highlights]”. The Shading viewport label menu lets you choose how objects are displayed in the viewport. It includes options for xView on page 2873.

**NOTE** You can customize this menu. In the Menus tab of the Customize User Interface dialog, choose Viewport Menu Label Bar from the menu list on the right. This menu is named “Shading Viewport Label Menu.”

---

**Interface**

![Shading Viewport Label Menu]

**Shading styles** Lets you choose from among the most commonly used shading styles.

- **Smooth + Highlights** Displays objects as shaded, with highlights that come from the scene’s lighting. In a viewport with Smooth + Highlights shading, you can also display maps on the surface of objects. See Show Standard/Hardware Map in Viewport on page 5696. This happens on a map-by-map basis, but you can display as many maps as you want simultaneously in the viewport. Maps display only on objects that have mapping coordinates. Also, Show Map In Viewport must be turned on for each map individually in the Material...
NOTE This and other shaded viewport options support self-illuminated materials and up to 32 lights (depending on the display mode and your graphics card).

- **Hidden Line**  Displays objects as wireframes: that is, as edges only. In Hidden Line mode hides faces and vertices whose normals point away from the user's point of view, This mode also hides any parts of objects that are obscured by closer objects.

  In Hidden Line shading, the wireframe color is determined by the Hidden Line Unselected color, not the object color or material color. You can set the Hidden Line Unselected color on the Customize User Interface dialog > Colors Panel on page 8272: choose Viewports from the Elements list, and then highlight Hidden Line Unselected to change its color.

- **Wireframe**  Displays objects as edges only, as if they were made from wire. All edges are displayed. By default, the wireframe color is determined by the object color.

  The Display Color rollout on page 158 lets you choose to display wireframes using the material color instead of the object color.

  **TIP** Wireframe mode can also display the vertex colors, if any are assigned, of editable poly, editable patch, or editable mesh objects. To enable this, use the Object Properties dialog on page 283.

- **Flat**  Shades each polygon with its raw diffuse color, disregarding any contribution from ambient lighting or light sources. This shading mode is useful when it's more important to see each polygon than to see its shading. It's also a good way to check the results of bitmaps created with Render to Texture on page 6843.

- **Edged Faces**  Displays the wireframe edges of objects along with shaded surfaces. This is helpful when you want to edit meshes in a shaded display. This option is unavailable when one of the wireframe modes is active. It is independent of the shaded modes: Smooth + Highlights or Flat. For example, when Smooth + Highlights is active and you choose Edged Faces, the viewport displays both surfaces and edges. The Shading label changes to indicate this: for example, “[ Smooth + Highlights + Edged Faces ].” You can also use Edged Faces in combination with the other shaded options available under Other Visual Styles on this menu.

  Edges are displayed using the object wireframe color, while surfaces use material colors (if assigned). This lets you create contrasting colors between...
the shaded surfaces and the wireframe edges. You can switch these assignments on the Display Color rollout on page 158.

---

**Lighting and Shadows** Displays a submenu on page 8133 with options for lighting and shadow previews in viewports.

**Transparency** Sets the quality of transparency display in the viewport:
- **Best**  Highest quality transparency display; longer redraw time.
- **Simple**  Less accurate transparency display, however viewport redraw is considerably faster with Simple.
- **None**  Transparency is not displayed in the viewport.

**NOTE** The Transparency setting only affects viewport display, and does not affect renderings.

---

**xView** Displays the xView submenu on page 2873.

---

**Other Visual Styles** Displays a submenu with other shading modes. These include:
- **Smooth**  Displays smoothing, but doesn’t show highlights.
- **Facets + Highlights**  Displays highlights, but doesn’t show smoothing.
- **Facets**  Shades faces, but doesn’t display smoothing or highlights.
- **Lit Wireframes**  Displays edges as wireframe, but shows lighting.
- **Bounding Box**  Displays each object as a bounding box on page 8528 only.

---

**Viewport Background** Displays a submenu on page 8134 with options for displaying a background in the viewport.
**Lighting and Shadows submenu**

Viewport lighting affects viewports only: it has no effect on how the scene is rendered.

**NOTE** If you are using the software display driver on page 8317 or the OpenGL driver on page 8319, shadow and ambient occlusion previews are not supported, and most options on this submenu have no effect on viewport display.

<table>
<thead>
<tr>
<th>Option</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Illuminate with Scene Lights</strong></td>
</tr>
<tr>
<td><strong>Illuminate with Default Lights</strong></td>
</tr>
<tr>
<td><strong>Enable Hardware Shading</strong></td>
</tr>
<tr>
<td><strong>Enable Exposure Control in Viewport</strong></td>
</tr>
<tr>
<td><strong>Enable Shadows</strong></td>
</tr>
<tr>
<td><strong>Enable Ambient Occlusion</strong></td>
</tr>
<tr>
<td><strong>Configure...</strong></td>
</tr>
</tbody>
</table>

**Illuminate with Scene Lights** When chosen, the viewport uses lighting from light objects in the scene.

**Illuminate with Default Lights** (The default.) When chosen, the viewport uses lighting from the default lights.

The choices that follow are toggles.

**Enable Hardware Shading** When on, the viewport is displayed using your system’s hardware shader.

Keyboard shortcut: Shift+F3

**Enable Exposure Control in Viewport** When on, viewports display a preview of the active exposure control on page 7207. Default=on.

**NOTE** Although Enable Exposure Control In Viewport is on by default, you won’t see its effect in the viewport unless an exposure control is active: either because you assigned exposure control by using Rendering > Exposure Control, or enabled exposure control when you created a photometric light.

**Enable Shadows** When on, the viewport previews shadows. See Previewing Shadows and Other Lighting in Viewports on page 5335.
Enable Ambient Occlusion When on, the viewport previews ambient occlusion on page 5850.

Configure Displays the Lighting And Shadows panel on page 8392 of the Viewport Configuration dialog. This lets you turn hardware shading on or off, and change other options.

Viewport Background submenu

<table>
<thead>
<tr>
<th>Show Background</th>
<th>Alt+B</th>
</tr>
</thead>
<tbody>
<tr>
<td>Viewport Background...</td>
<td></td>
</tr>
<tr>
<td>Update Background Image</td>
<td>Alt+Shift+Ctrl+B</td>
</tr>
<tr>
<td>Reset Background Transform</td>
<td></td>
</tr>
</tbody>
</table>

Show Background Toggles the display of any viewport background image or animation.

Viewport Background Opens the Viewport Background dialog on page 128, which lets you choose a background image for the viewport.

Keyboard shortcut: Alt+B

Update Background Image Reloads the background image or animation. This option can be useful if you have edited the file in an application outside of 3ds Max.

This option is disabled if no background image has been assigned.

Reset Background Transform When Lock Zoom/Pan is turned on in the Viewport Background dialog on page 128, choosing this option undoes zooming and panning you might have applied to the background, and restores its original position. This option affects the background only: it doesn't undo the actual viewport POV changes.

This option is disabled if no background image has been assigned.
Viewport Navigation

At the right end of the status bar are the buttons that control the display and navigation of the viewports.

Some of the buttons change for camera and light viewports. The Field Of View button changes for Perspective viewports.

The state of the navigation-button flyouts for all viewport types is saved in the [Performance] section of the 3dsmax.ini on page 60 file.

Viewport Navigation Controls

The navigation controls depend on the active viewport. Perspective, orthographic, camera, and light viewports all have specialized controls. The term “orthographic” refers to User viewports as well as viewports like Top, Front, and so on. The Zoom Extents All flyout and Maximize Viewport Toggle, available in all viewports, are included with the Perspective and orthographic viewport controls.

Many of these controls are modal on page 8641, meaning they stay on for repeated use. The buttons highlights when on. To turn them off, press Esc, right-click in a viewport, or choose another tool.

Controls Available in All Viewports

Zoom Extents All, Zoom Extents All Selected on page 8138

Maximize Viewport Toggle on page 8139

Perspective and Orthographic Viewport Controls

Perspective and Orthographic Viewport Controls on page 8141
**Zoom Viewport** on page 8142

**Zoom All** on page 8143

**Zoom Extents / Zoom Extents Selected** on page 8144

**Field-of-View Button** on page 8146 (Perspective) or **Zoom Region** on page 8149

**Pan View** on page 8150

**Walk Through** on page 115

**Orbit, Orbit Selected, Orbit Sub-Object** on page 8152

**Camera Viewport Controls**

**Camera Viewport Controls** on page 8154

**Dolly Camera, Target, or Both** on page 8155

**Perspective** on page 8157

**Roll Camera** on page 8159

**Field-of-View Button** on page 8146
Light Viewport Controls

Dolly Light, Target, or Both on page 8167

Light Hotspot on page 8169

Roll Light on page 8171

Light Falloff on page 8173

Truck Light on page 8175

Orbit/Pan Light on page 8177
Controls Available in All Viewports

The topics in this section describe viewport controls that are available in all viewports: orthographic, perspective, camera, and spotlight or directional light.

Zoom Extents All, Zoom Extents All Selected

Activate any viewport. > Viewport Navigation controls > Zoom Extents All flyout

Keyboard > Shift+Ctrl+Z

The Zoom Extents All flyout is available in all viewports. It lets you zoom extents for all objects or for selected objects.

The flyout has two options:

■ **Zoom Extents All** centers all visible objects in all viewports. This control is useful when you want to see every object in a scene in every available viewport.

■ **Zoom Extents All Selected** centers a selected object, or set of objects, in all viewports. This control is useful when you want to navigate to small objects lost in a complex scene.

**Procedures**

**To zoom all objects in a scene:**

1. Activate any viewport.

2. Click Zoom Extents All.

   The viewports display all objects in the scene.
To zoom to a specific object:

1. In any viewport, select the object by clicking it, or press H to select it by name.

2. Click Zoom Extents All Selected.
   The viewports display the selected object.

**Interface**

- **Zoom Extents All** Centers and magnifies views so all the visible objects in the scene are shown in all viewports.

- **Zoom Extents All Selected** Centers and magnifies views so just the selected objects or sub-object selections in the scene are shown in all viewports. If no objects are selected, the effect is the same as Zoom Extents All.

**Maximize Viewport Toggle**

Activate any viewport. > Viewport navigation controls> Maximize Viewport Toggle

Keyboard > Alt+W

The Maximize Viewport Toggle switches any active viewport between its normal size and full-screen size.

**TIP** The keyboard shortcut Alt+W is especially useful for quick toggles.

**Walkthrough Controls for Perspective and Camera Viewports**

The topics in this section describe Walkthrough controls, which are available for perspective and camera viewports.
Pan/Truck and Walkthrough Flyout

In Perspective and Camera viewports, this flyout lets you choose between Walkthrough navigation or Pan/Truck.

- Walk Through
- Pan or Truck

The Walk Through button on page 8140 is one way to turn on walkthrough navigation on page 115. The use of the Pan or Truck button depends on which kind of viewport you are in:

- Perspective viewports (Pan) on page 8150
- Camera viewports (Truck Camera) on page 8161

This flyout doesn't appear for orthographic viewports or spotlight viewports. These viewports don't provide walkthrough navigation.

Walk Through Button

The Walk Through button is one way to begin walkthrough navigation on page 115. (The other is to press Up Arrow.) It is available on the Pan/Truck And Walkthrough flyout on page 8140.

The flyout and button don't appear for orthographic viewports or for spotlight viewports. These don't provide walkthrough navigation.
Perspective and Orthographic Viewport Controls

Click or right-click the Point-Of-View (POV) viewport label. > POV viewport label menu on page 8122 > Choose Perspective or Orthographic. You can also choose a specific orthographic view such as Front, Top, Left, Right, and so on.

Click or right-click the Point-Of-View (POV) viewport label. > POV viewport label menu on page 8122 > Grid > Grid submenu > Choose a grid view.

Select a shape. > Click or right-click the Point-Of-View (POV) viewport label. > POV viewport label menu on page 8122 > Shape

Keyboard > V (to open the Viewports quad menu), then P (Perspective), U (User), F (Front), K (Back), T (Top), B (Bottom), L (Left)

Perspective, orthographic, user, grid, and shape viewports all share the same viewport controls.

Perspective and orthographic viewport controls include the following. Two of these controls are available in all viewports.

Zoom Viewport on page 8142
Zoom All on page 8143
Zoom Extents / Zoom Extents Selected on page 8144 (available in all viewports)
Field-of-View Button on page 8146
Zoom Region on page 8149
Pan View on page 8150
Orbit, Orbit Selected, Orbit Sub-Object on page 8152
Maximize Viewport Toggle on page 8139 (available in all viewports)

Procedures

To undo changes to a Perspective or orthographic viewport, do one of the following:

- Click or right-click the Point-Of-View (POV) viewport label. From the POV viewport label menu on page 8122, choose Undo View Change. This menu choice shows the previous view change: for example, Undo Zoom Extents.
■ Press Shift+Z.

**NOTE** This differs from camera and light viewports, which require the use of the standard Undo function.

---

**Zoom Viewport**

Activate a Perspective or orthographic viewport. > Viewport Navigation controls > Zoom

Keyboard > Alt+Z turns on Zoom ; [ zooms in; ] zooms out

Keyboard > Ctrl+Alt+middle mouse button (drag)

Roll your mouse scroll wheel.

When Zoom is active, you can adjust the view magnification by dragging in a Perspective or orthographic viewport. By default, zooming occurs from the center of the viewport.

**TIP** If you use a wheel mouse, you can turn the wheel to zoom the active viewport in and out without first activating Zoom. The zoom center is the center of the viewport.

Zooming takes place incrementally, based on the distance between the viewpoint and its “virtual target,” an inaccessible hidden target used for calculation purposes only. Use the Ctrl and Alt keys, respectively, to increase or decrease the increments. You can move the virtual target by holding down the Shift key during a zoom operation. Otherwise you will zoom increasingly closer to the target, which does not move.

**Procedures**

To zoom a view:

1. Activate a Perspective or orthographic viewport.

2. Click Zoom.

   The button highlights when it is on.
3 Drag in a viewport to change magnification:
   ■ Drag upward to increase magnification.
   ■ Drag downward to decrease magnification.

4 To exit Zoom mode, press Esc or right-click in a viewport.

To increase zoom speed:
   ■ Hold down Ctrl as you drag in a viewport.

To decrease zoom speed:
   ■ Hold down Alt as you drag in a viewport.

To turn on an automatic zoom mode:
   ■ On the keyboard, hold down Ctrl+Alt, then hold down the middle mouse button and drag in a viewport. This does not activate the Zoom button.

To zoom from the keyboard:
   ■ On the keyboard, press [ (left bracket) to zoom in, and ] (right bracket) to zoom out.

Zoom All

Activate a Perspective or orthographic viewport. > Viewport Navigation controls > Zoom All

Zoom All lets you adjust view magnification in all Perspective and orthographic viewports at the same time.

By default, Zoom All zooms in and out of the center of the viewports.

Procedures

To zoom all views:
   1 Activate a Perspective or orthographic viewport.
2 Click Zoom All.  
The button highlights when it is on.

3 Drag in a viewport to change magnification in all viewports.  
   ■ Drag upward to increase magnification.  
   ■ Drag downward to decrease magnification.

4 Press Esc or right-click to turn off the button.

To zoom all viewports except the Perspective viewport:

1 Click Zoom All.

2 Hold down Shift and drag in a viewport to zoom all the viewports except the Perspective.

   NOTE You can drag in a Perspective viewport, but you only see the zoom in orthographic viewports.

---

**Zoom Extents / Zoom Extents Selected**

Activate a Perspective or orthographic viewport. > Viewport Navigation controls > Zoom Extents flyout

The Zoom Extents flyout displays the Zoom Extents button and the Zoom Extents Selected button.

![Zoom Extents](image)

**Zoom Extents** centers all visible objects in an active Perspective or orthographic viewport. This control is useful when you want to see every object in a scene in a single viewport.

![Zoom Extents Selected](image)

**Zoom Extents Selected** centers a selected object, or set of objects, in an active Perspective and orthographic viewport. This control is useful when you want to navigate to small objects lost in a complex scene.
Procedures

To zoom all objects in one viewport:

1. Activate the Perspective or orthographic viewport you want to zoom.
2. Click Zoom Extents.
   The viewport displays all objects in the scene.

To zoom on a specific object:

1. Activate the Perspective or orthographic viewport you want to zoom.
2. Select the object by clicking it, or press H to select it by name.
3. Click Zoom Extents Selected.
   The viewport displays the selected object.

To exclude an object from Zoom Extents:

Use this procedure, for example, to ignore lights that are far away from the other objects in the scene.

1. Click an object to select it.
2. Right-click the object and choose Properties.
3. In the Display Properties group, make sure properties are set to By Object.
4. Turn on Ignore Extents.
   The object will now be excluded by Zoom Extents and Zoom Extents Selected.

Interface

Zoom Extents Centers and magnifies views so all the visible objects in the scene are shown in a single viewport.
Objects can be excluded from zoom extents all if the Ignore Extents box is turned on under Object Properties.
Zoom Extents Selected  Centers and magnifies views so just the selected objects or sub-object selections in the scene are shown in a single viewport. If no objects are selected, the effect is the same as Zoom Extents.

Field of View Flyout

Activate Perspective viewport. > Status bar > Viewport controls > Field of View flyout

The Field Of View flyout is available only for Perspective viewports. It lets you change the field of view, or zoom to a particular region.

The flyout has two options:

- Field of View (FOV) on page 8146: Adjusts the amount of the scene that is visible in a viewport and the amount of perspective flare.

- Zoom Region on page 8149: Magnifies a rectangular area you drag within a viewport.

Field-of-View Button

Activate a Camera viewport. > Viewport controls > Field-of-View

Activate a Perspective viewport. > Viewport controls > Field-of-View (on Field-of-View flyout)

Field-of-View (FOV) adjusts the amount of the scene that is visible in a viewport and the amount of perspective flare. The effect of changing FOV is similar to changing the lens on a camera.

- As the FOV gets larger, you see more of your scene and the perspective becomes distorted, similar to using a wide-angle lens.

- As the FOV gets smaller, you see less of your scene and the perspective flattens, similar to using a telephoto lens.
Although the effect of Field-of-View appears similar to a zoom, the perspective is actually changing, resulting in increased or decreased distortion in the viewport.

In a Perspective viewport, Field-of-View defines the width of your view as an angle with its apex at your viewpoint and the ends at the sides of the view.

In a Camera viewport, Field-of-View controls the width of the area a camera views, and represents the arc of the camera’s horizon in degrees. For a selected camera, you can adjust its FOV and Lens parameters on page 5570 directly to fine-tune the FOV you set in the viewport. See “To use FOV with Camera parameters” in the following procedures.

**Procedures**

**To adjust the field of view in a viewport:**

1. Activate a Perspective or Camera viewport.

2. Click Field-of-View.
The button highlights in gold when it is on.

3 Drag in the viewport to adjust the FOV angle.
   ■ Dragging down widens (increases) the FOV angle, reduces lens length, displays more of your scene, and exaggerates perspective.
   ■ Dragging up narrows (decreases) the FOV angle, increases lens length, displays less of your scene, and flattens perspective.

4 To turn off the button, press Esc or right-click.

To enter an FOV value in a Perspective view:

1 Activate a Perspective viewport.

2 Right-click Field-of-View to display the Viewport Configuration dialog.

3 Click the Rendering Method tab.

4 In the Perspective User View group, enter an angle in the FOV field.

5 Click OK to make the change.

To use FOV with Camera parameters:

1 Activate a Camera viewport.

2 Press H and select the viewport’s camera in the Select From Scene dialog on page 206.

3 Open the Modify panel to view the camera’s Parameters rollout.

4 As you drag Field-of-View in the viewport, the FOV and Lens parameters update interactively.

5 Set the FOV and Lens parameters directly, or click a button in the Stock Lenses group.

NOTE Only the FOV value is saved with the camera. The Lens value (focal length) is another way to express and select the FOV.

See Common Camera Parameters on page 5570.
NOTE Using the Perspective button on page 8157 in a Camera viewport also changes the FOV in concert with dollying the camera.

Zoom Region

Activate an orthographic viewport. > Viewport navigation controls > Zoom Region

Activate a Perspective viewport. > Viewport navigation controls > Zoom Region (from Field of View flyout)

Keyboard > Ctrl+W

Zoom Region magnifies a rectangular area you drag within a viewport. This control is available only when the active viewport is an orthographic on page 8668, Perspective on page 8681 or User-Axonometric view on page 8515. It is not available for Camera viewports.

Zoom Region stays active until you right-click or select another command.

Procedures

To zoom a region:

1. Activate an orthographic or Perspective viewport.

2. Click Zoom Region or press Ctrl+W.

   When you zoom a region in a perspective viewport, select Zoom Region from the Field of View flyout.

3. Drag a rectangular region in any viewport displaying a non-camera view.

   When you release, the region is magnified to fill the viewport.

   NOTE When using the Zoom Region in Perspective view, the zoom rectangle is at a fixed distance from the camera. For this reason, if you draw the rectangle large enough, you can zoom out from the scene.
**Pan View**

Activate a Perspective or orthographic viewport. > Viewport Navigation controls > Pan View

Keyboard > Ctrl+P; I pans so the cursor location becomes the center of the viewport.

Middle mouse button > Drag in the viewport with the middle mouse button for instant access to pan the viewport.

Pan moves the view parallel to the current viewport plane.

Pan is modal on page 8641: it stays active until you right-click or select another command.

To constrain panning of any viewport to a single axis, hold down the Shift key. The pan is constrained to the axis you first move while the Shift key is down.

To accelerate panning, hold down the Ctrl key.

You can also pan by dragging in a viewport while pressing the middle button of a three-button mouse. This lets you pan without turning on the Pan button.

**Procedures**

**To pan a viewport:**

1. Activate a Perspective or orthographic viewport, and then click Pan View.
2. Drag in the viewport in the direction you want to move.
3. To turn off the button, press Esc or right-click.

**To pan a non-Camera viewport:**

1. Activate a Perspective or orthographic viewport.
2  Do one of the following:

  ■  Click Pan View.
  ■  Press Ctrl+P.
  ■  Press the middle mouse button.

3  Drag in the viewport in the direction you want to move.

To accelerate panning:

  ■  Hold down the Ctrl key as you pan.

To constrain panning to a single axis:

  ■  Hold down the Shift key as you pan.
    The pan is constrained to the first axis you use.
    If you drag vertically at first, the pan or orbit is constrained to be vertical;
    if you drag horizontally at first, the constraint is horizontal.

**Orbit Flyout**

Activate a Perspective or orthographic viewport. > Viewport Navigation controls > Orbit flyout

Keyboard > Alt+middle mouse button

The Orbit flyout contains the Orbit, Orbit Selected, and Orbit Sub-Object buttons. Use these to rotate your viewpoint around the view.

For more information on these tools, see Orbit, Orbit Selected, Orbit Sub-Object on page 8152.
Orbit, Orbit Selected, Orbit Sub-Object

Activate a Perspective or orthographic viewport. > Viewport Navigation controls > Orbit flyout

Keyboard > Alt+middle mouse button

The Orbit buttons, on the Orbit flyout on page 8151, spin the viewpoint freely around a center. Three variants are available: Orbit, Orbit Selected, and Orbit Sub-Object.

The Orbit function is modal on page 8641: It remains active until you right-click or choose another command.

Orbit respects Angle Snap on page 2810. If you turn on Angle Snap, the Orbit mouse pointer displays a magnet, and the rotation snaps by the Viewport Orbit Snap Angle setting on page 8358.

Orbiting uses a hidden “virtual target” as center of rotation. Holding down the Ctrl key in Orbit mode has a special behavior: It performs a rotation of the scene around the screen’s X and Y axis (at the position of the virtual target). Moving the mouse horizontally yields rotation around world-coordinates referential Z axis. Moving the mouse vertically yields rotation around world-coordinates referential X axis. This differs from standard Orbit, in which horizontal mouse movement rotates around screen-coordinates referential Y axis.

**TIP** An alternative method for orbiting the viewport is the ViewCube on page 86

**Procedures**

To use Orbit:

1. Activate a Perspective or orthographic viewport.

2. Click any of the three Orbit buttons.

   A view-rotation “trackball” is displayed as a yellow circle with handles placed at the quadrant points.
3 Drag the mouse on and around the trackball to produce different types of view rotations. The cursor changes to indicate the type of rotation in effect:

- To rotate the view freely within the viewport, drag inside the trackball. The free rotation continues while dragging even if the cursor crosses outside the trackball.
- To constrain the rotation to the horizontal or vertical axis, drag the trackball handles. Drag horizontally on the side handles, or vertically on the top or bottom handle.
- To rotate the view about the depth axis that is perpendicular to the screen, drag outside the trackball. When the cursor crosses inside the trackball during dragging, free rotation occurs. When the cursor crosses back outside the trackball, spinning rotation is again in effect.

4 To exit the Orbit function, press Esc or right-click within the viewport.

**To constrain rotation to a single axis:**

- Hold down the Shift key as you rotate. The rotation is constrained to the first axis you use.

**To rotate with keyboard and mouse:**

- Hold down the Shift key as you rotate. The rotation is constrained to the first axis you use.

**Interface**

- **Orbit** Uses the view center as the center of rotation. If objects are near the edges of the viewport, they might rotate out of view.

- **Orbit Selected** Uses the center of the current selection as the center of rotation. The selected object remains at the same position in the viewport while the view rotates around their center.

- **Orbit SubObject** Uses the center of the current sub-object selection as the center of rotation. The selection remains at the same position in the viewport while the view rotates around its center.
Camera Viewport Controls

Click or right-click the Point-Of-View (POV) viewport label. > POV viewport label menu on page 8122 > Cameras > Cameras submenu > Choose a camera.

Keyboard > C

A Camera viewport shows the view from a camera, looking in the direction the camera is aimed.

Camera viewport controls include the following. Two of these controls are available in all viewports.

Dolly Camera, Target, or Both on page 8155
Perspective on page 8157
Roll Camera on page 8159
Zoom Extents All, Zoom Extents All Selected on page 8138 (available in all viewports)
Field-of-View Button on page 8146
Truck Camera on page 8161
Orbit/Pan Camera on page 8162
Maximize Viewport Toggle on page 8139 (available in all viewports)

Activate a Camera view from the Point-Of-View (POV) viewport label menu on page 8122. If the scene contains more than 10 cameras, the last entry in the list is "More Cameras." Choose this to display the Choose A View dialog, which shows the complete list.

If a single camera is selected and you press C, the active viewport switches to the view from that camera. If, when you press C, the scene contains more than one camera and no camera or multiple cameras are selected, the Select Camera dialog appears; choose a camera from the list.
Procedures

To undo changes to a Camera viewport, do one of the following:

- Click Undo on the Quick Access toolbar on page 7995.
- Press Ctrl+Z.

NOTE This behavior differs from that of orthographic viewports, which require the use of Views menu > Undo, or Shift+Z.

Dolly Camera, Target, or Both

Activate a Camera viewport. > Viewport navigation controls > Dolly Camera or Dolly Target or Dolly Camera + Target

The buttons on this flyout replace the Zoom button when a Camera viewport is active. Use them to move the camera and/or its target along the camera's main axis, toward or away from what the camera is pointing at.
Dollying a camera

A free camera moves along its depth axis in the direction its lens is pointing. Unlike a target camera, its target distance remains fixed, no matter how far you dolly.

NOTE The three buttons of the Dolly Camera flyout are available when a target camera viewport is active. When a free camera viewport is active, the button appears as a flyout, but only Dolly Camera is available for this type of camera. If you activate a target camera viewport, the three buttons are again available.

See also:
- Dolly Light, Target, or Both on page 8167

Procedures

To dolly a camera:

1. Activate a Camera viewport.
2. Click one of the buttons on the Dolly Camera flyout.
3 Drag to move the camera.
   ▪ Drag up to move the camera forward along its line of sight.
   ▪ Drag down to move the camera backward along its line of sight.

4 Press Esc or right-click to turn off the button.

**Interface**

The Dolly Camera flyout consists of the following individual buttons:

- **Dolly Camera** Moves only the camera to and from its target. If you go past the target, the camera flips 180 degrees and moves away from its target.

- **Dolly Target** Moves only the target to and from the camera. You see no visual change in the camera viewport, unless you dolly the target to where it passes through the camera to the other side, at which point the camera view is reversed. However, changing the relative position of the target to the camera affects other adjustments, such as Orbit Camera, which uses the target as its rotational pivot.

  This option is available only if the viewport’s camera is a target camera.

- **Dolly Camera + Target** Moves both the target and the camera to and from the camera.

  This option is available only if the viewport’s camera is a target camera.

**Perspective**

Activate a Camera viewport. > Viewport navigation controls > Perspective
Perspective performs a combination of FOV on page 8569 and Dolly on page 8155 for target cameras and free cameras. It increases the amount of perspective flare, while maintaining the composition of the scene.

Adjusting perspective

**NOTE** This button replaces the Zoom All button when a Camera viewport is active.

**TIP** Hold down the Ctrl key to magnify the effect of the mouse on perspective adjustment.

A target camera can pass through its target object while you are using Perspective. When this happens, the FOV reaches its maximum angle of 180 degrees at the target location and cursor motion is reversed until you release the drag.

A free camera continues moving along an infinite path but uses an implied target position to control the FOV change rate. This implied target is defined as a point specified by the Target Distance field in the Parameters rollout for the free camera.
Procedures

To change perspective for a camera:

1. Activate a Camera viewport.

2. Click Perspective.
   The button turns yellow when it is on.

3. Drag to change FOV and dolly simultaneously.
   - Drag up to move the camera closer to its target, widen the FOV, and increase perspective flare.
   - Drag down to move the camera away from its target, narrow the FOV, and decrease perspective flare.

4. Press Esc or right-click to turn off the button.

Roll Camera

Activate a Camera viewport. > Viewport navigation controls > Roll Camera
Roll Camera rotates a target camera about its line of sight, and rotates a free camera about its local Z axis.
Rolling a camera

NOTE This button replaces the Zoom Extents button when a Camera viewport is active.

Procedures

To roll a camera:

1. Activate a Camera viewport.

2. Click Roll Camera.
   The button highlights when it is on.

3. Drag horizontally to roll the view.

4. Press Esc or right-click to turn off the button.
Truck Camera

Activate a Camera viewport. > Viewport navigation controls > Truck Camera

Truck Camera moves the camera parallel to the view plane.

Trucking a camera

For a target camera, dragging the mouse moves both the camera and its target parallel to the Camera view.

This button replaces the Pan button when a Camera viewport is active.

Procedures

To truck a camera:

1. Activate a Camera viewport.

2. Click Truck Camera.

   The button highlights when it is on.
3 Drag to move the camera and its target. The camera and its target move parallel to the view plane, which is perpendicular to the camera's line of sight.

4 Press Esc or right-click to turn off the button.

To truck with the middle mouse button:

■ Hold down the middle mouse button and drag.

To constrain trucking to a single axis:

■ Hold down the Shift key. The truck is constrained to the first axis you move while the Shift key is down.

To accelerate trucking:

■ Hold down the Ctrl key.

Orbit/Pan Camera

Activate a Camera viewport. > Viewport navigation controls > Orbit Camera

Orbit Camera rotates a camera about the target. Pan Camera rotates the target about the camera.
Orbiting a camera

Panning a camera
NOTE This button replaces the Orbit button when a Camera viewport is active.

You can constrain the rotation to a single axis by first pressing Shift before beginning the rotation. The rotation is constrained to the axis you begin rotating about.

To accelerate panning, hold down the Ctrl key before you pan.

Procedures

To pan a camera:

1. Activate a Camera viewport.

2. Click Pan Camera.
   The button highlights when it is on.

3. Drag to rotate the view about the camera.
   - Dragging rotates the view freely using the world X and Y axes.
   - Press Shift and drag horizontally to lock view rotation about the world Y axis. This produces a horizontal pan.
   - Press Shift and drag vertically to lock rotation about the world X axis. This produces a vertical pan.

4. Press Esc or right-click to turn off the button.

To orbit a camera:

1. Activate a Camera viewport.

2. Click Orbit Camera.

3. Drag to rotate the view around the target.
   - Dragging rotates the view freely using the world X and Y axes.
   - Press Shift and drag horizontally to lock view rotation about the world Y axis. This produces a horizontal orbit.
   - Press Shift and drag vertically to lock rotation about the world X axis. This produces a vertical orbit.
Press Esc or right-click to turn off the button.

**Interface**

- **Orbit Camera** Rotates a target camera about its target. Free cameras use the invisible target, set to the target distance specified in the camera Parameters rollout.

- **Pan Camera** Rotates the target about a target camera. For a free camera, rotates the camera about its local axes.

**Light Viewport Controls**

Click or right-click the Point-Of-View (POV) viewport label. > *POV viewport label menu* on page 8122 > Lights > Lights submenu > Choose a light.

Keyboard > $

A Light viewport shows the view from a spotlight or directional light, looking at its target.

Light viewport controls include the following. Two of these controls are available in all viewports.

- **Dolly Light, Target, or Both** on page 8167
- **Light Hotspot** on page 8169
- **Roll Light** on page 8171
- **Zoom Extents All, Zoom Extents All Selected** on page 8138 (available in all viewports)
- **Light Falloff** on page 8173
- **Truck Light** on page 8175
- **Orbit/Pan Light** on page 8177
Maximize Viewport Toggle on page 8139 (available in all viewports)

For photometric lights on page 5348, the Light Hotspot control actually adjusts the beam angle. At the beam angle, the light is 50 per cent of the maximum intensity.

Targeted photometric lights can be used as views only when the light's distribution is set to spotlight.

WARNING Switching to or from a light view clears the Undo/Redo lists.

Procedures

To set a Light viewport:

1. Activate the viewport you want to show the view from a spotlight or directional light in the scene.
2. Do one of the following:
   - Press the keyboard shortcut $.
   - Click or right-click the Point-Of-View viewport label. 3ds Max opens the POV viewport label menu on page 8122. Choose Lights and then choose the light from the Lights submenu.
3. If you have more than one spotlight or directional light in the scene (and none is selected), the Select Light dialog is displayed: choose the light you want.
4. If there are more than 10 lights listed, the last entry is "More Lights." Choose this to display the Choose a View dialog, which shows the complete list.

To undo changes to a Light viewport, do one of the following:

1. Click Undo on the Quick Access toolbar on page 7995.
2. Press Ctrl+Z.

NOTE This is different from orthographic viewports, which require the use of Views menu > Undo, or Shift+Z.
Dolly Light, Target, or Both

Activate a Light viewport. > Viewport navigation controls > Dolly Light

Dolly Light, on the Dolly Light flyout (see below) moves the light or its target or both along the light’s main axis, toward or away from what the light is pointing at. A free light moves along its depth axis in the direction its lens is pointing. On a target light, the target distance remains fixed, no matter how far you dolly.

Dollying a light

When you dolly a light, the light source moves closer to and away from its target. Because spotlights have conical beams, dollying a spotlight closer to its target shrinks the area illuminated at the target. Similarly, dollying a spotlight away from its target expands the area illuminated at the target.

The three buttons of the Dolly Light flyout are available when a target light viewport is active. When a free light viewport is active, the button appears as a flyout, but only Dolly Light is available for this type of light. If you activate a target light viewport, the three buttons are again available.
The buttons on this flyout replace the Zoom button when a Light viewport is active.

See also:
- Dolly Camera, Target, or Both on page 8155

Procedures

To dolly a light:

1. Activate a Light viewport.
2. Click Dolly Light.
   The button highlights when it is on.
3. Drag to move the light.
   - Drag up to move the light forward along its line of sight.
   - Drag down to move the light backward along its line of sight.
4. Press Esc or right-click to turn off the button.

Interface

The Dolly Light flyout consists of the following buttons:

- **Dolly Light** Moves only the light to and from its target. If you go past the target, the light flips 180 degrees and moves away from its target.

- **Dolly Target** Moves only the target to and from the light. You see no visual change in the light viewport, unless you dolly the target to where it passes through the light to the other side, at which point the light view is reversed. However, changing the relative position of the target to the light
affects other adjustments, such as Orbit Light, which uses the target as its rotational pivot. This option is available only if the viewport’s light is a target light.

**Dolly Light + Target** Moves both the target and the light to and from the light. This option is available only if the viewport’s light is a target light.

**Light Hotspot**

Activate a Light viewport. > Viewport navigation controls > Light Hotspot

Light Hotspot lets you adjust the angle of a light's hotspot on page 8604. This button replaces the Zoom All button when a light viewport is active.

![Light Hotspot Diagram]

The floodlight has a narrow hotspot but a wide falloff area.
Widening the hotspot creates a brighter light.

Click this button, then move the mouse in the light viewport to make the cone of the hotspot narrower or wider (the hotspot cone is shown in blue, the falloff on page 8604 cone is in gray).

Hold down the Ctrl key while moving the mouse to lock the initial angle separation of the hotspot and falloff cones.

You can't adjust the hotspot larger than the falloff, because that would change the falloff value. Likewise, when you reduce the falloff, it stops at the hotspot size (in both cases, separated by the Angle Separation on page 8342, specified on the Rendering page of the Preferences dialog).

To override the separation of the hotspot and falloff parameters and cause the parameters to affect each other, hold down the Shift key.

For more information on the hotspot and falloff parameters, see Spotlight Parameters on page 5439 and Directional Parameters on page 5436.

**NOTE** If the light is a photometric light on page 5348 with spotlight distribution, this button controls the light's beam angle. At the beam angle, the light's intensity has fallen to 50 per cent (rather than 100 per cent at the hotspot angle for a standard light).
Procedures

To change a light’s hotspot:

1. Set up a Perspective viewport so you can see the light in 3D space.
3. Press **H** to display the Select From Scene dialog on page 206. Select the light.
   The light and its cones should be visible in the Perspective viewport.
4. Click Light Hotspot.
   The button highlights when it is on.
5. Drag in the Light viewport to change the hotspot angle.
   The blue hotspot cone expands and contracts as you drag.
   - Drag down to widen (increase) the hotspot angle and illuminate more of the scene. The hotspot grows inside the falloff as its angle increases. By default, the hotspot can be no larger than the falloff cone.
   - Hold down **Shift** as you drag to override the default. This lets the falloff cone increase in size as you increase the size of the hotspot cone.
   - Drag up to narrow (decrease) the hotspot angle and illuminate less of the scene.
   - Hold down **Ctrl** as you drag to lock the initial angle separation of the hotspot and falloff cones.
6. Press **Esc** or right-click to turn off the button.

Roll Light

Activate a light viewport. > Viewport navigation controls > Roll Light

Roll Light rotates the light about its own line of sight (the light’s local Z axis). Although Roll does change the light view, it affects the light object only if the light casts a rectangular beam or is a projector on page 8693.
Rolling a light

Drag the mouse horizontally to roll a target light or rotate a free light about its local Z axis.

This button replaces the Zoom Extents button when a light viewport is active.

Procedures

To roll a light:

1. Activate a Light viewport.

2. Click Roll Light.
   
   The button highlights when it is on.

3. Drag horizontally to roll the view.

4. Press Esc or right-click to turn off the button.
Light Falloff

Activate a Light viewport. > Viewport navigation controls > Light Falloff

Light Falloff adjusts the angle of a light’s falloff on page 8604. This button replaces the Zoom Region button when a light viewport is active.

The light has a narrow hotspot but a wide falloff area.
Click Light Falloff, then move the mouse in the light viewport to make the falloff narrower or wider (the falloff extents are shown in gray, the hotspot on page 8604 is in blue).

Hold down the Ctrl key while moving the mouse to lock the initial angle separation of the hotspot and falloff cones.

You can't adjust the hotspot larger than the falloff, because that would change the falloff value. Likewise, when you reduce the falloff, it stops at the hotspot size (in both cases, separated by the angle separation on page 8342, specified on the Rendering page of the Preferences dialog).

To override the separation of the hotspot and falloff parameters and cause the parameters to affect each other, hold down the Shift key.

For more information on the hotspot and falloff parameters, see Spotlight Parameters on page 5439 and Directional Parameters on page 5436.
Procedures

To change a light’s falloff:

1. Set up a Perspective viewport so you can see the light in 3D space.
3. Press H to display the Select Object dialog. Select the light.
   The light and its cones should be visible in the Perspective viewport.
4. Click Light Falloff.
   The button highlights when it is on.
5. Drag in the Light viewport to change the falloff angle.
   The gray falloff cone expands and contracts as you drag.
   - Drag down to widen (increase) the falloff angle and illuminate more of the scene.
   - Drag up to narrow (decrease) the falloff angle and illuminate less of the scene. As its angle decreases, the falloff shrinks around the hotspot. By default, the falloff cone can be no smaller than the hotspot cone.
   - Hold down Shift as you drag to override the default. This lets the hotspot cone decrease in size as you decrease the size of the falloff cone.
   - Hold down Ctrl as you drag to lock the initial angle separation of the hotspot and falloff cones.
6. Press Esc or right-click to turn off the button.

Truck Light

Activate a light viewport. > Viewport navigation controls > Truck Light
Truck Light moves a target light and its target parallel to the light view, and moves a free light along its XY axis.
Trucking a light

To constrain trucking of any viewport to a single axis, hold down the Shift key. The truck is constrained to the first axis you move while the Shift key is down.

To accelerate trucking, hold down the Ctrl key.

NOTE This button replaces the Pan button when a light viewport is active.

Procedures

To truck a light:

1. Activate a Light viewport.
2. Click Truck Light.
   The button highlights when it is on.
3. Drag to move the light and its target.
The camera and its target move parallel to the view plane, which is perpendicular to the camera's line of sight.

4 Press Esc or right-click to turn off the button.

To truck with the middle mouse button:
- Hold down the middle mouse button and drag.

To constrain trucking to a single axis:
- Hold down the Shift key.
  The truck is constrained to the first axis you use.

**Orbit/Pan Light**

Activate a light viewport. > Viewport navigation controls > Orbit/Pan Light flyout

Orbit rotates a light about the target. Pan rotates the target about the light.
Orbiting a light
Panning a light

To constrain panning or orbiting to a single axis, hold down the Shift key. The pan or orbit is constrained to the axis you first move while the Shift key is down.

To accelerate panning or orbiting, hold down the Ctrl key before you pan or orbit.

**NOTE** This button replaces the Orbit button when a light viewport is active.

**Procedures**

To orbit a light:

1. Activate a Light viewport.

2. Click Orbit Light.  
   The button highlights when it is on.
3 Drag to rotate the view around the target.
   ■ Dragging rotates the view freely using the world X and Y axes.
   ■ Press Shift and drag horizontally to lock view rotation about the world Y axis. This produces a horizontal orbit.
   ■ Press Shift and drag vertically to lock rotation about the world X axis. This produces a vertical orbit.

4 Press Esc or right-click to turn off the button.

To pan a light:
1 Activate a Camera or Light viewport.

2 Click Pan Light.
The button highlights when it is on.

3 Drag to rotate the view about the camera or light.
   ■ Dragging rotates the view freely using the world X and Y axes.
   ■ Press Shift and drag horizontally to lock view rotation about the world Y axis. This produces a horizontal pan.
   ■ Press Shift and drag vertically to lock rotation about the world X axis. This produces a vertical pan.

4 Press Esc or right-click to turn off the button.

Interface

 Orbit Light Rotates the light about its target. Free lights use the invisible target, set to the target distance specified in the Modify panel > Spotlight Parameters or Directional Parameters rollout.

 Pan Light For a target light, rotates the target about the light. For a free light, rotates the light about its local axes.
Command Panel

The command panel comprises six user-interface panels that give you access to most of the modeling features of 3ds Max, as well as some animation features, display choices, and miscellaneous utilities. Only one panel is visible at a time. To display a different panel, you click its tab at the top of the command panel.

These are the panels:

- **Create panel** on page 8182
  Contains controls for creating objects: geometry, cameras, lights, and so on.

- **Modify panel** on page 8184
  Contains controls for applying modifiers to objects and editing editable objects such as meshes and patches.

- **Hierarchy panel** on page 8213
  Contains controls for managing links in a hierarchy, joints, and inverse kinematics.

- **Motion panel** on page 8215
  Contains controls for animation controllers and trajectories.

- **Display panel** on page 8217
  Contains controls that let you hide and unhide objects, along with other display options

- **Utilities panel** on page 8223
  Contains miscellaneous utility programs.

By default, the command panel appears at the right of the 3ds Max window. You can "dock" it along other edges of 3ds Max window, or make it a floating panel. See Customizing the User Interface on page 8235.
Object Name and Wireframe Color

Create panel > Any object category > Name And Color rollout
Modify, Hierarchy, Motion, Display, or Utilities panel > Name field and color swatch

The name and color fields appear at the top of all command panels other than the Create panel. On the Create panel, the fields are contained in a rollout. You can change an object's name or color from any of these locations.

Interface

Name (text field) Displays the name of the selected object and lets you enter a new name from the keyboard. Available only when a single object is selected.

Color (swatch) Displays the selected object's wireframe color and lets you select a new one. The wireframe color is the one used to display the object in viewports. Click the color swatch to display the Object Color dialog on page 368.

Create Panel

Command panels > Create panel

The Create panel provides the controls for creating objects. This is the first step in building a new scene in 3ds Max. Most likely, you will continue to add objects throughout an entire project. For example, when it is time to render a scene you might need to add more lights.
Villa with a swimming pool was created using a variety of geometry.

The Create panel groups the kinds of objects you create into seven categories. Each category has its own button. Within each category there can be several different subcategories of objects. A drop-down list lets you choose among object subcategories, and each kind of object has its own button, which you click to begin creation.

These are the categories of objects that the Create panel provides:

- **Geometry** on page 357
  Geometry is the renderable geometry of the scene. There are geometry primitives such as Box, Sphere, Pyramid, and more advanced geometry such as Boolean, Lofts, and particle systems, as well as Doors and Stairs, AEC Extended objects such as Terrain and Railing.

- **Shapes** on page 572
  Shapes are splines or NURBS curves. They have only one local dimension, although they can exist in 2D space, such as a Rectangle shape, or 3D space, such as a Helix.
You can give shapes a thickness so they will render, but primarily you use them for constructing other objects such as Lofts, or for motion trajectories.

- **Lights** on page 5314
  Lights illuminate the scene and improve its realism. There are several kinds of lights, each of which models different types of lighting in the real world.

- **Cameras** on page 5545
  Camera objects provide a view of the scene. The advantages of cameras over the views in the standard viewports are that cameras have controls similar to real-world cameras, and that you can animate a camera's position.

- **Helpers** on page 2837
  Helper objects are aids to constructing a scene. They help you position, measure, and animate the scene's renderable geometry.

- **Space Warps** on page 2887
  Space warps produce various kinds of distortions in the space surrounding other objects. Some space warps are meant especially for use with particle systems.

- **Systems** on page 856
  Systems combine objects, controllers, and hierarchies to provide geometry associated with some kind of behavior. Also contains Sunlight and Daylight systems that simulate sunlight in your scenes.

**Modify Panel**

Command panels > Modify panel

From the Create panel of 3ds Max, you place basic objects in your scene, including 3D geometry, 2D shapes, lights and cameras, space warps, and helpers. Each object you add has its own set of creation parameters, which define its geometry and other characteristics, depending on the type of object. Once placed in a scene, objects carry their creation parameters with them. You can change these parameters on the Modify panel.
You also use the Modify panel to assign modifiers on page 8643. Modifiers are tools for reshaping an object. While they mold the final appearance of the object, modifiers do not change its underlying creation parameters.

You use the Modify panel to:

- Change the creation parameters for existing objects.
- Apply modifiers to adjust the geometry of an object or a set of objects.
- Change the parameters of modifiers and choose their components.
- Delete modifiers.
- Convert a parametric object to an editable object; see Modifier Stack Controls on page 8187.

NOTE Some space warps can be created as modifiers. See World Space Modifiers (WSMs) on page 1067.

The Modify panel stays in view until you dismiss it by clicking the tab of another command panel. The top section of the panel always contains name and color controls, optionally the current modifier set on page 8209 buttons, the Modifier List, and the modifier stack and related controls. The remaining contents of the panel (various rollouts with options and controls) update when you select an object, giving you access only to what you can modify about that object.

What you can modify depends on whether an object is classed as a geometric primitive like a sphere, or as another kind of object, such as a light or a space warp. Each category has its own range of possibilities. The contents of the Modify panel are always specific to the category as well as to the selected object. When you make a change from the Modify panel, you immediately see the results transferred to the object.

You can change or delete modifiers by using the Modifier Stack Controls on page 8187.

See also:

- Object-Space Modifiers on page 1159
- World-Space Modifiers (WSMs) on page 1067
Procedures

To use the Modify panel:

1. Select an object.

2. On the Command panel, click the Modify tab to display the Modify panel.
   The name of the object appears at the top of the Modify panel, and the remainder of the panel displays settings for the object or the modifier at the top of its stack.

3. You can now do any of the following:
   - Change the parameters for the object. As you change these parameters, the object updates in the viewports.
   - Apply a modifier to the object.
   - Change the parameters for a modifier. As you change these parameters, the object updates in the viewports.
   - Collapse the stack to create an editable surface such as an editable mesh on page 2192.

To apply a modifier from the Modify panel:

1. Select an object.

2. On the Command panel, click the Modify tab to display the Modify panel. On the Modify panel, click Modifier List to open the list of modifiers.

3. Scroll through the list to find the modifier you want. You can use any standard method:
   - From the keyboard, press Up Arrow or Down Arrow to scroll one item at a time, or press Page Up or Page Down to scroll in screen-height increments, or use Home or End to jump to the top or bottom of the list. The name of the chosen modifier is highlighted, and the name appears at the top of the list.
TIP If you know the modifier name, you can jump to its section by pressing the keyboard key corresponding to first letter of the name. To cycle through all modifiers starting with that letter, press the key repeatedly.

■ With the mouse, slide the scroll bar on the right side of the list, or turn the mouse wheel.

4 Apply the modifier. If using the keyboard, press Enter to apply the highlighted modifier. If using the mouse, simply click the modifier name to apply it.

**Modifier Stack Controls**

Make selection. > Modify panel

The modifier stack controls appear near the top of the Modify panel, just below the Modifier List. The modifier stack ("stack" for short) contains the accumulated history of an object, including its creation parameters and the modifiers applied to it. At the bottom of the stack is the original object. Above the object are the modifiers, in order from bottom to top. This is the order in which modifiers are applied to the object's geometry.
Instances and References in the Modifier Stack Display

In the modifier stack display, objects and modifiers appear in normal type unless they are an instance or a reference. Here is how instances and references appear in the stack display:

- The name of an instanced object appears in boldface.
- The name of a modifier appears in boldface if it is part of an instanced pipeline.

Top: Plain object displayed in plain text
Bottom: Object instance displayed in boldface

Top: Pipeline displayed in plain text
If a modifier is applied to two or more pipelines, it is called an instanced modifier. Its name appears in italic.

If a modifier is instanced and part of an instanced pipeline, its name appears in boldface and italic.

A referenced object appears with a dark bar above it. Modifiers below the bar are part of the current pipeline. Modifiers above the bar are unique to the reference object.

**NOTE** You can also create instances of a reference. In this case, the modifier above the reference bar apply to the reference and to its instances.

A modifier above the reference object bar can itself be an instance and appear in other pipelines, in which case its name would be italic (either plain or boldface).
The **Make Unique button** on page 8206 makes a pipeline or a modifier instance unique. When you highlight the base object and then click Make Unique, the whole pipeline becomes unique. When you highlight a bold modifier and then click Make Unique, this also makes the pipeline unique. If the modifier is an instanced modifier that belongs to an instanced pipeline (it appears in boldface and italic), clicking Make Unique makes the modifier unique but not the entire pipeline (the modifier's name is no longer italic, but it is still bold).

**See also:**
- **How Instanced Modifiers Work** on page 1063
- **Transforms, Modifiers, and Object Data Flow** on page 1034

**Most-Recently Used Modifiers**

3ds Max caches the results of evaluating most-recently used modifiers. This means that in general, you can see results more quickly as you move among modifiers on the stack.

To conserve memory use, the list of most-recently used modifiers has a fixed length. Once the list is full, adding a new modifier removes the oldest modifier in the list. By default, the list length is 1. You can increase it by adding an MRUModSize entry to the [Performance] section of the `3dsmax.ini` file. For example:

```
MRUModSize=10
```

A good rule of thumb for this value is 10, but results will vary depending on how much main memory your system has.

**Procedures**

**To adjust an object's creation parameters:**

1. Choose the object by clicking its name in the stack.
   
   Primitive objects have a Parameters rollout. Other kinds of objects (such as meshes and NURBS) have a variety of rollouts.

2. Use the rollout controls to adjust the object.
To apply a modifier to an object:

1 Select the object.

2 Do one of the following:
   - Choose a modifier from the Modifier List. This is a drop-down list near the top of the Modify panel.

     **Tip**  In many cases, multiple modifiers' names start with the same letter. You can go directly to a particular modifier if you type the first few letters (enough for a unique combination) in the desired modifier's name quickly. For example, say you want to assign the Mirror modifier to an object. Pressing M goes to Mesh Select, which isn't anywhere near Mirror in the Modifier list, but typing MI goes directly to Mirror.

   - Choose a modifier from the Modifiers menu. This menu is organized into sets by functionality. Not all modifiers appear on the Modifiers menu.

   - If the modifier buttons are visible on the Modify panel and the modifier you want is one of them, click the button.

     If the buttons are not visible but you want to use them, click the Configure Modifier Sets button on page 8210 (below the modifier stack display) and choose Show Buttons. A set of buttons with the names of modifiers appears between the modifier list and the stack display. Click Configure Modifier Sets again, choose the set of modifiers you want to use (for example, Free-Form Deformations), and then click the button for the modifier you want to apply.

     Rollouts are now displayed below the modifier stack display, showing settings for the modifier. As you change these settings, the object updates in viewports.

To remove a modifier, do one of the following:

- Choose the modifier by clicking its name in the stack, and then click Remove Modifier From The Stack. This button is one of the tools beneath the display of the modifier stack.

- Right-click the modifier's name in the stack and then choose Delete.
To turn the effect of a modifier off, do one of the following:

- Click the light-bulb icon to the left of the modifier's name in the stack.
- Right-click the modifier in the stack display, and choose Off.

To turn the effect of a modifier back on, do one of the following:

- Click the light-bulb icon to the left of the modifier's name in the stack.
- Right-click the modifier in the stack display, and choose On.

To change the size of the modifier stack display:

1. Position the cursor over the shaded bar below the tool buttons beneath the stack list.
   
   The cursor changes to an up-and-down resize arrow (as it does on the horizontal edges of a resizable window).

2. Drag the bar up or down to change the size of the stack display in the Modify panel.

To change a modifier's position in the stack, do one of the following:

**NOTE** The original object is always at the bottom of the stack, and world-space modifiers are always at the top.

1. Drag the modifier to a different location in the stack.

2. 1. Right-click the modifier's name in the stack, and choose Cut.
    
    2. Right-click the name of the modifier you want the modifier to appear before (that is, above), and choose Paste.

To use the modifier buttons:

- Click Configure Modifier Sets, and choose Show Buttons.
  
  This menu item is a toggle. It is either on or off. When you turn on Show Buttons, the current button set appears between the drop-down modifier list and the stack display.
To convert the modified object to an editable mesh, do one of the following:

- Right-click the modifier stack, and choose Collapse All.
  A dialog opens, warning you that the collapse operation cannot be undone, and gives you the option of performing a Hold on page 242 before converting the object.

```
Warning

Warning: This will remove everything in the stack of all selected objects, including creation parameters and any animation applied to creation or modifier parameters.

Are you sure you want to continue?

Do not show this message again  Hold/Yes  Yes  No
```

- Right-click the object in a viewport, and choose Convert To > Convert to Editable Mesh from the quad menu.

  **TIP** You can also convert a modified object to an editable patch or editable polygon surface. Use the quad menu to do this.

To adjust a modifier’s component such as its gizmo or center point:

1. Expand the modifier’s hierarchy by clicking the plus-sign icon.
2. Click the component you want to adjust, such as the Gizmo. The component highlights to show it is active.
3. Adjust the component.
   For example, you might use transforms to move a gizmo or a center point.
4. When done, you can hide the hierarchy display by clicking the minus-sign icon. The modifier itself is highlighted again.
To go to a sub-object level for complex objects:

1. Click the plus-sign icon to display the object's hierarchy.

2. Choose the sub-object level you want to adjust.
   The sub-object level highlights to show it is active.
   Keyboard shortcut: Insert cycles through the different sub-object levels.

3. Adjust sub-objects.
   When you add a new sub-object type, the modifier stack updates to show
   the new sub-object levels. For example, when you add a point curve
   sub-object to a NURBS surface, the Point and Curve sub-object levels
   appear in the stack.

4. To leave the sub-object level, click to select the name of the top-level
   object or a different top-level object.

   TIP You can also view the entire hierarchy by right-clicking the stack and
   choosing Show All Subtrees, and view only objects and modifiers with Hide
   All Subtrees.
Interface

The Modifier Stack

Modifier List

The Modifier List lets you choose a modifier to add to the stack. When you choose an object-space modifier on page 1159 from this list, it appears above the object, or above the modifier currently highlighted in the stack. When you choose a world-space modifier on page 1067 from this list, it appears at the top of the stack.

Use Pivot Points The first item in the Modifier List is the Use Pivot Points toggle. It is available only when multiple objects are selected.

When Use Pivot Points is on, 3ds Max uses the pivot point of each object as the center of a modifier's operation. For example, if you bend a line of trees around the Z axis, they all bend along their trunks.

When Use Pivot Points is off, 3ds Max calculates a central pivot point for the entire selection set and modifies the selection as a whole. For example, if you bend a line of trees around the Z axis, trees at the end of the line deform more than those at the center where the pivot is located.

The Use Pivot Points setting persists, so that applying modifiers to different sets of objects during the current session always uses the same setting.
NOTE Be sure to set Use Pivot Points to the desired value before you apply the modifier to multiple objects. You can't change the setting afterward, although you can delete the modifier and start over without deselecting the selection set.

Modifier Buttons

Between the Modifier List and the stack display, you can optionally display up to 32 buttons. The buttons are a shortcut way to add modifiers to the stack.

To display the modifier buttons, click Configure Modifier Sets (below the stack display) and choose Show Buttons.

To customize the button set, click Configure Modifier Sets (below the stack display) and choose Configure Modifier Sets on page 8210.

When a modifier's button is visible, clicking the button adds the modifier to the stack. Object-space modifiers are applied immediately above the currently selected object or modifier. World-space modifiers are applied at the top of the stack.
Stack Display

The modifier stack is organized as follows:

- At the bottom of the stack, the first entry always lists the object type. Click this entry to display the object's creation parameters so you can adjust them. When you click to choose an entry in the modifier stack, its background highlights to show that the entry is current, and that the object's or modifier's parameters are available for adjusting, in rollouts that appear beneath the stack display.

- Above the object itself are entries for object-space modifiers. Click a modifier entry to display the modifier's parameters so you can adjust them. This section lets you go back to any modifier you've applied and adjust its effect on the object. You can also delete the modifier from the stack, canceling its effect.

  NOTE 3ds Max applies transforms after it applies object-space modifiers but before it applies space warps or world-space modifiers.

- The top of the stack shows which space warps and world-space modifiers the object uses. For example, if the object were bound to a Ripple space warp, an entry in the top section would read Ripple Binding.

  To the left of each modifier in the stack is a light-bulb icon. When the bulb appears white, the modifier is applied to the stack below it. When the bulb appears gray, the modifier is turned off. Click to toggle the on/off state of the modifier.

  NOTE You can also turn off the effect of modifiers in viewports but not in renderings, or vice versa. The light-bulb icon changes to show these states as well. See Modifier Stack Right-Click Menu on page 8200.

  If the modifier has sub-controls such as a center or a gizmo, the stack also shows a small plus/minus icon. Click this icon to open or close the hierarchy.
Opening a modifier’s hierarchy to access sub-controls

When the hierarchy is open, you can select a sub-control, such as a gizmo, and then adjust it. The available sub-controls vary from modifier to modifier.

Objects that have a sub-object hierarchy, such as editable meshes on page 2192 and NURBS on page 2416, also show a collapsible hierarchy in the modifier stack.

To work at a sub-object level, click to open the hierarchy, then click to select the sub-object level. Controls for that particular level or type of sub-object appear in rollouts below the stack display.

(Certain types of sub-objects display an icon at the right of the stack, to help you see which sub-object type you are adjusting.)
Opening an object’s hierarchy to access sub-object levels

Tool Buttons

Below the stack display is a row of buttons for managing the stack.
Pin Stack  Locks the stack to the currently selected object so it remains with that object regardless of subsequent changes in selection. The entire Modify panel is locked to the current object as well. Pin Stack is useful for transforming another object while keeping your place in the modified object’s stack.

Show End Result  Shows the selected object as it will appear after all modifications in the stack have taken place, regardless of your current position in the stack. When this toggle is turned off, the object appears as modified up to the current modifier in the stack.

Make Unique  Converts an instanced modifier to a copy that’s unique to the current object. See Make Unique on page 8206.

Remove Modifier  Deletes the current modifier or unbinds the current space warp.

Configure Modifier Sets  Click to display the pop-up Modifier Sets menu on page 8209.

Modifier Stack Right-Click Menu

Modify panel > Modifier stack display > Right-click a modifier or object.

Some commands for managing modifiers are available by right-clicking the modifier stack display. Some options are unavailable if they don’t apply to the current modifier. For example, Make Unique is available only if you select an instanced modifier.

The main uses of the right-click menu for the modifier stack are:

- Renaming modifiers
- Rearranging modifiers with the cut, copy, and paste functions

You can cut, copy, and paste multiple modifiers at one time. You can also cut and copy discontiguous selections of modifiers.

- Creating instances of modifiers
Collapsing the stack into a surface object such as an editable mesh

Controlling whether modifiers are on or off, off in viewports, or off in renderings

Collapsing the Stack

Collapsing the stack removes modifiers from the object. Collapsing a stack typically converts an object into an editable version of the original object (unless the object was editable to begin with, such as a NURBS model). Collapse To is unavailable unless you select one or more modifiers in the stack. Using Collapse To removes all stack items from the creation parameters to and including the uppermost selected stack item.

NOTE You can preserve custom attributes on page 8205 when collapsing the stack.

Following are suitable reasons to collapse a stack:

- To simplify the scene geometry.
- To discard applied modifiers, and convert the object to an editable object while retaining the results of any applied modifiers.
- To conserve memory.

After you collapse an object's stack, you can no longer parametrically adjust either its creation parameters or its individual modifiers. Animation tracks that were assigned to such parameters also disappear.

Procedures

To move one or more modifiers:

1. Select one or more modifiers in the modifier stack display.
   To select multiple modifiers, click to select one modifier, then hold down Ctrl and click to select the others. Holding down Shift selects the two modifiers you click and all modifiers in between them.

2. Right-click and choose Cut.

3. Select a modifier above which to paste the cut modifiers. (This can also be the object at the bottom of the stack.)

4. Right-click and choose Paste. The modifiers are pasted above the current selection.
To copy one or more modifiers:

1. Select one or more modifiers in the modifier stack display.
   To select multiple modifiers, click to select one modifier, then hold down Ctrl and click to select the others. Holding down Shift selects the two modifiers you click and all modifiers in between them.

2. Right-click and choose Copy.

3. Select an item above which to paste the cut modifiers.

4. Right-click and choose Paste. The copied modifiers are pasted above the current selection. Choose Paste Instanced to make the pasted modifiers instances of those you copied.

To copy modifiers from one object to another:

1. Select one or more modifiers in the modifier stack display of the first object.
   To select multiple modifiers, click to select one modifier, then hold down Ctrl and click to select the others. Holding down Shift selects the two modifiers you click and all modifiers in between them.

2. Right-click and choose Copy.

3. Select the second object.

4. In the second object’s modifier stack display, select an item above which to paste the copied modifiers.

5. Right-click and choose Paste.
   The modifiers from the first object are pasted above the current selection in the second object. Choose Paste Instanced to make the pasted modifiers instances of those you copied.
Interface

<table>
<thead>
<tr>
<th>Rename</th>
<th>Delete</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut</td>
<td>Copy</td>
</tr>
<tr>
<td>Paste</td>
<td>Paste Instanced</td>
</tr>
<tr>
<td>Make Unique</td>
<td></td>
</tr>
<tr>
<td>Collapse To</td>
<td>Collapse All</td>
</tr>
<tr>
<td>Preserve Custom Attributes</td>
<td></td>
</tr>
<tr>
<td>On</td>
<td>Off in Viewport</td>
</tr>
<tr>
<td>Off in Renderer</td>
<td></td>
</tr>
<tr>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>Make Reference</td>
<td></td>
</tr>
<tr>
<td>Show All Subtrees</td>
<td>Hide All Subtrees</td>
</tr>
</tbody>
</table>

**Rename** Let you change the name of the modifier. For example, you might change the name Bend to the more specific "First 45-degree bend." After choosing Rename, enter the new name in the stack display, and then press Enter. Pressing Esc cancels the name change.

**Delete** Deletes the modifier from the stack. The modifier is not available for pasting.

**Cut** Cuts the modifier from the stack. The modifier is removed, but is available for pasting.

**Copy** Makes a copy of the modifier that is available for pasting.

**Paste** Pastes the modifier into the stack. The modifier appears above the currently selected object or modifier, unless it is a world space modifier, in which case it is pasted at the top of the stack.

You can paste a modifier from one object into the stack of a different object. Paste is unavailable when more than one modifier is selected in the stack.
**Paste Instanced** Pastes an instance of the modifier into the stack. The modifier instance appears above the currently selected object or modifier, unless it is a world space modifier, in which case it is pasted at the top of the stack.

You can paste a modifier instance from one object into the stack of a different object.

Paste Instanced is unavailable when more than one modifier is selected in the stack.

**Make Unique** Converts an instanced modifier to a copy that's unique to the current object. This button is unavailable unless the modifier you right-clicked is instanced. See Make Unique on page 8206.

**Collapse To** Collapses a portion of the stack. Collapse To is unavailable unless you select one or more modifiers in the stack. Using Collapse To collapses all stack items from the object itself, up to and including the uppermost selected stack item. If there are modifiers above the uppermost selection, they are not changed.

The resultant object type depends on the uppermost modifier that outputs a specific geometry type, if any. If the stack contains no such modifier, the result is an editable mesh on page 2192. If the collapsed portion of the stack contains a modifier that outputs a specific geometry type, and no other such modifier is above it, the result is that type of object. For example, if the topmost such collapsed modifier is Edit Poly, the resultant object is Editable Poly.

**Collapse All** Collapses the entire stack.

The resulting stack list shows a single entry: Editable Mesh, unless any modifiers on the stack output a different type of geometry. For example, if the topmost such modifier is Edit Poly, the resultant object is Editable Poly.

---

**NOTE** World-space modifiers on page 1067 don't collapse along with the rest of the stack.

**Convert To** This menu item appears if no modifiers are applied to the object. Choose one of the Convert To options:

- Editable Mesh
- Editable Spline
- Editable Patch
- Editable Poly
- NURBS
NOTE Depending on the object type, not all Convert To options might be available.

**Preserve Custom Attributes** When on, collapsing an object’s modifier stack or converting it a different format such as Editable Poly preserves any custom attributes on page 307 present in the stack.

**On** Turns on the effect of modifiers in both viewports and the renderer.

The light-bulb icon to the left of the modifier name shows "on."

**Off in Viewport** Turns off the currently selected modifiers in viewports only. Allows you to work in the viewport without the effects of the modifiers. You see the effects when you render.

The light-bulb icon to the left of the modifier name shows "off in viewports."

**Off in Renderer** Turns off the currently selected modifiers in renderings only. The effect of the modifiers is visible in viewports but not in renderings.

The light-bulb icon to the left of the modifier name shows "off in Renderer."

**Off** Turns off the currently selected modifiers without deleting them. This can help you see the object without the effect of its modifiers.

The light-bulb icon to the left of the modifier name shows "off."

**Make Reference** If the object is an instance, converts it to a reference. This option is available only when the base object is an instance.

When you make an instanced object into a reference, a heavy, "derived object" bar appears at the top of the stack. You can select this bar and apply modifiers above it. Modifiers applied above the bar affect the reference object only, and not its parent object.
Gray bar denotes a reference object at the base of the stack

**Show All Subtrees** Expands the display of every hierarchical item in the stack display, so that all items in the stack are visible, including sub-objects.

**Hide All Subtrees** Hides the subtree of every hierarchical item in the stack display, so that only objects, modifiers, and space warp bindings are visible.

**Make Unique**

Modify panel > Tool buttons > Make Unique

Modify panel > Right-click an instanced modifier in the stack display. > Make Unique

Right-click an instanced object. > Make Unique

Make Unique lets you convert an instanced object to a copy that’s unique. A object is instanced when it is cloned (Shift+Move or Shift+Rotate). If you make changes to an instanced object the changes are also reflected in the other instances in your scene. Making objects unique lets you adjust or change those objects independently without affecting any other objects in the scene.

**TIP** If you drag a material to a unique object and see the other instanced object updating as well, turn off Automatic Material Propagation. Go to Customize menu > Customize UI and choose Category: Instance Manager, then drag Automatic Material Propagation to a toolbar or assign a keyboard shortcut to it. Using this tool will allow the unique object to act uniquely.
Procedures

Example: To use the Make Unique options with an instanced modifier:

1. Create a cylinder with some height segments, and then use Shift+Move to create three copies, resulting in four identical cylinders.

2. Select all four cylinders, apply the Bend modifier, and adjust the Angle setting just enough to see the results of the bend. You now have four cylinders with a single instance of a Bend modifier applied to them.

3. Choose Edit menu > Hold. This lets you return to the current state of the scene at any time without using Undo.

4. Select two of the cylinders and click Make Unique.

5. Choose Yes in the resulting dialog. At this point, the two selected cylinders each have unique Bend modifiers, while the remaining two cylinders share the original Bend. You can see this by selecting each cylinder and changing the Bend Angle setting.

6. Choose Edit menu > Fetch, and answer Yes.

7. Select two cylinders again, and click Make Unique.

8. Choose No in the resulting dialog. The two selected cylinders now share an instance of a Bend modifier, but it's a different instance than that shared by the other two cylinders. Again, you can see this by selecting each of the cylinders and changing the Bend Angle spinner. You can also turn on Show Dependencies on page 148 in the Views menu to see the relationship between the four cylinders and the Bend modifier.

Example: To use Make Unique with an instanced object/modifier combination:

1. Create a cylinder with some height segments.

2. Apply a Bend modifier and adjust the Angle just enough to see the results of the bend.

3. Use Shift+Move with the Instance option to create an instanced object/modifier combination.
4 Change the Bend Angle setting on one of the instances to demonstrate that the cylinders and modifiers are truly instanced. Both cylinders bend.

5 Select one of the instances, and then, in the modifier stack choose either the Bend modifier or the cylinder itself.

6 Click Make Unique. When you change the Bend Angle setting or cylinder base parameters for one of the objects, the other doesn’t change.

**NOTE** When you instance an object/modifier combination, all duplicates are instances of a *single* master node containing the original object and modifier. In such cases, you cannot selectively make the object or its modifier unique. Clicking Make Unique for one or the other, makes both unique.

**Interface**

**Make Unique** Detaches objects and modifiers (and combinations) logically from the master node of which they’re instances or references.

Go to the object or modifier level in the stack for an instanced or referenced object or modifier (respectively), and click Make Unique.

For instanced object/modifier combinations, in the modifier stack, choose either the modifier or the object itself.

**Making New Instances**

When you click Make Unique for a selection of two or more objects, a dialog appears that asks: Do you want to make the selected items unique with respect to each other? This gives you a choice of how you want to make the objects unique.

- **Yes** Makes the instanced modifiers assigned to the objects in the selection unique for each object in the selection.
- **No** All instanced modifiers assigned to the objects in the selection remain instanced across the selected objects, but become unique from other objects not in the selection.
Modifier Sets Menu

Modify panel > Configure Modifier Sets button

The button sets menu gives you options for managing and customizing shortcut buttons for applying modifiers.

Procedures

To display the current button set on the Modify panel:

- Click Configure Modifier Sets, and then choose Show Buttons to turn on this item. This item is a toggle. Choosing Show Buttons a second time turns off the button display, and so on.

To configure a new modifier set:

- Click Configure Modifier Sets, and then choose Configure Modifier Sets on page 8210.

To change from one button set to another:

- Click Configure Modifier Sets, and then choose the modifier set name from the lower part of the menu.
Interface

Configure Modifier Sets

Show Buttons: on
Show All Sets in List: on

Selection Modifiers:
- Patch/Spline Editing
- Mesh Editing
- Animation Modifiers
- UV Coordinate Modifiers
- Cache Tools
- Subdivision Surfaces
- Free Form Deformations
- Parametric Modifiers
- Surface Modifiers
- Conversion Modifiers

Configure Modifier Sets Displays the Configure Modifier Sets dialog on page 8210 to let you create a new, customized button set.

Show Buttons When on, buttons for the current modifier set are displayed between the modifier list and the stack display. Default=off.

Show All Sets in List When on, the Modifier List is organized by sets. When off, the Modifier List is organized simply into World-Space Modifiers and Object-Space Modifiers, and is otherwise alphabetical except that the current set appears at the top of the list. Default=off.

Saved button sets The bottom part of the Button Sets menu lists the names of saved button sets. Choose one of these sets to make it the current button set. The current set is displayed as buttons when Show Buttons is on. The Modifier List drop-down is organized by sets when Show All Sets In List is on.

Configure Modifier Sets Dialog

Modify panel > Configure Modifier Sets button > Configure Modifier Sets
This dialog lets you create custom modifier and button sets for the Modify panel.

**Procedures**

**To choose a modifier and button set to edit:**
- Choose a button set from the Sets drop-down list.

**To create a new modifier and button set:**
1. Create a custom button set in the Modifiers group box. You use these controls:
   - Use Total Buttons to change the number of buttons.
   - Drag a modifier from the Modifiers list to a button.
   - Highlight a button, and then double-click a modifier in the Modifiers list. (When you assign a button by double-clicking, the highlight moves to the next button in the Modifiers group.)
2. Enter the new set's name in the Sets edit field.
3. Click Save.
4. Click OK to leave the Configure Modifier Sets dialog.

**To customize the current modifier and button set:**
1. Use Total Buttons to choose the number of buttons in the set.
2. Assign buttons by dragging the names of modifiers in the dialog's Modifiers list to buttons in the Modifiers group box.
3. Click OK.
4. 3ds Max updates the Modifiers list. You can customize the set without saving it, but if you save a new set under a new name, you can use it later.
Modifiers Lists all modifiers currently available. It's organized into these categories: Channel Info, Max Edit, Max Standard, Deformations, Max Surface, Surface Tools, Modifiers, Radiosity, LIGHT, Max Additional, Shell, Spline Edits, World Space Modifiers, and others. To add a modifier to the current button set, drag the modifier's name from this list onto a button in the Modifiers group box.

Sets This edit field and drop-down list lets you choose the modifier set to edit. To create a new button set, enter the name in the edit field, and then click Save.

Save Saves the current button set.

Delete Deletes the current button set.

IMPORTANT You can't undo deleting a button set.
**Total Buttons** Sets the number of buttons in the button set. A button set can have up to 32 buttons.

**Modifiers group**

Previews how the button set will appear on the Modify panel. Because the box shows only 16 buttons at a time, a scroll bar on the right lets you see any remaining buttons.

To change a button, drag the name of a modifier from the Modifiers list to a button in this group box, or click the button (its border highlights) and then double-click the modifier name.

---

**Hierarchy Panel**

Command panels > Hierarchy panel

The Hierarchy panel provides access to tools to adjust the hierarchical linkage between objects. By linking one object to another, you create a parent-child relationship. Transformations applied to the parent are also transmitted to the child. By linking more objects to both parent and child objects you can create complex hierarchies.
Gyroscope assembled as a hierarchy.
The parent is the outer ring with handle.
The flywheel is the lowest child.

Common uses of linking are:

- Creating complex motions.
- Simulating jointed structures.
- Providing the basis for inverse kinematics.
- Setting rotational and sliding parameters for Bones.

The Hierarchy panel is divided into three areas:

- [Pivot](#) on page 3762
- [IK](#) on page 3772
- [Link Info](#) on page 3787
NOTE For important background information on hierarchies and kinematics, see Animating with Forward Kinematics on page 3642 and Inverse Kinematics (IK) on page 3661.

Motion Panel

Select an object. > Command panels > Motion panel

The Motion panel provides tools to adjust the motion of the selected object. Key timing and easing in and out of a key are parameters that you can adjust with tools on the Motion panel, for example. The Motion panel also provides an alternative to Track View for assigning animation controllers.

Additional rollouts display in the Motion panel if an assigned animation controller has parameters. If a Path constraint is assigned to the position track of an object, then a Path Parameters rollout is added to the Motion panel. A Link constraint displays a Link Parameters rollout, a Position XYZ controller displays a Position XYZ Parameters rollout, and so on.

Trajectories

Click Trajectories to chart a path that an object will travel along in the viewports. Yellow dots along the path represent frames, giving you an idea of velocity and easing. By turning on Sub-Object Keys, keys can be moved in space, key properties can be changed, the trajectories will reflect all the adjustments you make. You can also convert to and from splines and collapse transforms using trajectories.

Interface

Parameters

Provides an alternative to Track View on page 3790 for adjusting transform controllers and key information.

Assign Controller Rollout on page 8216
PRS Parameters Rollout on page 3416
Key Info (Basic) Rollout/Dialog on page 3418
Key Info (Advanced) Rollout/Dialog on page 3422
Trajectories

Provides tools for working with objects' trajectories.

Trajectories on page 3411

Assign Controller Rollout

Select an object. > Motion panel > Parameters > Assign Controller rollout

The Assign Controller rollout assigns and appends different transform controllers to individual objects. You can also assign controllers in Track View.

Animation controllers on page 3424 are plug-ins that handle all of the animation tasks in 3ds Max. For a complete list of available animation controllers, see Assign Controller (Track View) on page 3897.

Procedures

Example: To assign a TCB Rotation controller:

1 Select an object.

2 On the Motion panel, click Parameters, and open the Assign Controller rollout.

3 Highlight the Rotation track in the Assign Controller list.

4 Click the Assign Controller button, choose TCB Rotation from the Assign Rotation Controller dialog, and then click OK to close the dialog and accept the change.

The default Euler XYZ Rotation controller is replaced with the TCB Rotation controller.
Interface

Assign Controller Displays the Assign Controller dialog. If no track is highlighted, the Assign Controller button is unavailable.

Assign Controller dialog Choose a controller from a list of available controllers in this dialog.
Depending on the type of track you've selected, the Choose Controller dialog displays a subset of the different types of controllers. Rotation controllers, for example, are available only for rotation tracks.

Display Panel

Command panels > Display panel
The Display panel provides access to tools that control the display of objects in the scene.
Use the Display panel to hide and unhide on page 8599, freeze and unfreeze on page 8587 objects, alter their display characteristics, speed up viewport displays, and simplify your modeling procedures.
NOTE A target is considered part of its light or camera for purposes of hiding and unhiding.

Display Panel Rollouts

- Display Color Rollout on page 158
- Hide By Category Rollout on page 159
- Hide Rollout on page 161
- Freeze Rollout on page 163
- Display Properties Rollout on page 164
- Link Display Rollout on page 169

Display Floater

Tools menu > Display Floater

This modeless dialog contains most of the functions on the Display panel. You can leave the Display floater up while you work in your scene, making it easier to change viewport displays without changing the current command panel.

Interface

The Display floater has two panels: Hide/Freeze and Object Level.

Hide/Freeze panel

NOTE These functions are also available on the Display panel on page 8217 and from the Display quadrant on page 8055 of the default quad menu.
**Hide group**

**Selected** Hides the selected object(s).

**Unselected** Hides all visible objects except the selected ones. Use this to hide all the objects except the one you are working on.
By **Name** Lets you select the objects to hide by name.

By **Hit** Causes any object you click in the viewport to be hidden. If you hold the Ctrl key while selecting an object, that object and all of its children are hidden. To exit Hide by Hit mode, right-click, press Esc, or select a different function. This mode is automatically turned off if you hide all objects in the scene.

**Unhide group**

**All** Unhides all hidden objects. The unhide buttons are only available when you have specifically hidden one or more objects. They won't unhide objects hidden by category.

By **Name** Displays a dialog in which you can unhide objects you select from a list.

**NOTE** You cannot unhide objects on a hidden layer. If you select an object on a hidden layer, you will be prompted to unhide the object's layer.

**Freeze group**

**Selected** Freezes the selected object(s) so they cannot move in the viewport.

**Unselected** Freezes all visible objects except the selected ones. Use this to quickly freeze all the objects except the one you're working on.

By **Name** Lets you select the objects to freeze by name.

By **Hit** Causes any object you click in the viewport to be frozen. If you hold the Ctrl key while selecting an object, that object and all of its children are frozen. To exit Freeze By Hit mode, right-click, press Esc, or choose a different function. This mode is automatically turned off if you freeze all objects in the scene.

**Unfreeze group**

**All** Unfreezes all frozen objects.

By **Name** Displays a dialog in which you can unfreeze objects you select from a list.

By **Hit** Causes any object you click in the viewport to be unfrozen. If you hold the Ctrl key while selecting an object, that object and all of its children are unfrozen.
NOTE You cannot unfreeze objects on a frozen layer. If you select an object on a frozen layer, you will be prompted to unfreeze the object’s layer.

Hide Frozen Objects Toggles display of frozen objects on and off. You don’t have to unfreeze objects to hide them; you can use Hide Frozen Objects instead to hide or unhide frozen objects in a single step.

Object Level panel

Hide by Category group

Toggles the display of objects by their category (objects, cameras, lights, and so on). Choose the check boxes to hide objects of that category. Use the All, None, and Invert buttons to change the settings of the check boxes.
NOTE These functions are also available on the Display panel on page 8217.

Display Properties group

Provides controls that alter the display of selected objects.

NOTE These options are also available on the Display panel on page 8217 and in the Display Properties group on page 288 of the Object Properties dialog.

Display as Box Toggles the display of selected objects, including 3D objects, 2D shapes, and particle systems, as bounding boxes on page 8528. Produces minimum geometric complexity. Particle systems appear as bounding boxes when adaptive degradation takes effect. Since particle systems naturally exist in world space, their bounding box is always oriented parallel to the world planes.

Backface Cull Toggles the display of faces with normals on page 8654 pointing away from view. When selected, you see through the wireframe to the back faces.

Edges Only Toggles the display of hidden edges and polygon diagonals on page 8551. When on, only outside edges appear. When off, all mesh geometry appears. Applies to Wireframe viewport display mode, as well as other modes with Edged Faces turned on.

Vertex Ticks Displays the vertices in the selected geometry as tick marks. If the current selection has no displayed tick marks, the check box is clear. If some of the vertices in the current selection display tick marks, the check box contains a gray X. If all vertices in the current selection display tick marks, the check box contains a black X.

Trajectory Toggles trajectory display on page 8746 for the selected object so you can display its trajectory wherever you are in 3ds Max.

See-Through When on, makes the object or selection translucent in viewports. This setting has no effect on rendering: it simply lets you see what's behind or inside an object in a crowded scene, and especially to adjust the position of objects behind or inside the see-through object. Use this when you need to see inside an object, such as a character with bones inside. Default=off. You can customize the color of see-through objects by using the Colors panel on page 8272 of the Customize > Customize User Interface dialog on page 8249. Choose Geometry from the Elements list, and then choose See-Through. Keyboard shortcut (default): Alt+X
Ignore Extents Allows an object to be excluded from a zoom extents operation. Choose this when you have lights or other distant objects that you don’t want to use when you do a Zoom Extents on page 8144.

Show Frozen in Gray When on, the object turns gray in viewports when you freeze it. When off, viewports display the object with its usual color or texture even when it is frozen. Default=on.

Never Degrade When on, the object is not subject to adaptive degradation on page 8498.

Utilities Panel

Command panels > Utilities panel

The Utilities panel gives you access to a variety of utility programs. 3ds Max utilities are provided as plug-ins on page 8687. 3ds Max ships with the utilities listed below. Some utilities are available from third-party developers, so your setup of 3ds Max might include utilities not described here. Look for documentation describing these additional plug-ins by choosing Help > Additional Help.

NOTE Documentation for MAXScript and Visual MAXScript is provided in a separate help system. To access the MAXScript Help, choose Help > MAXScript Help. See About MAXScript on page 21.

See also:

- List of Available Utilities on page 7977
Interface

The Utilities panel contains one rollout for managing and invoking utilities. While a utility is running, additional rollouts can appear. Some utilities use a dialog rather than rollouts.

The Utilities rollout contains the following controls at the top:

**More** Displays a Utilities dialog that lists all utilities not already displayed in buttons on the Utilities panel. Highlight a utility in the list and then click OK to display its controls in the Utilities panel. (You can also double-click the utility’s name.)

**Sets** Displays a list of button sets to choose from. By default, there is only one button set, called MAX Default. You can create custom button sets by clicking Configure Button Sets.

**Configure Button Sets** Displays the Configure Button Sets dialog on page 8225, where you can create custom button sets of up to 32 buttons.

**Named utility buttons** These buttons show a selection of utilities. Click one of these buttons to run a utility. The utility’s parameters can appear in rollouts below the Utilities rollout. Some utilities use a dialog rather than rollouts.

While a utility is running, its button remains active until you click it again to turn it off and close the utility, or when you click a different utility’s button. Many utilities have a Close button that appears at the bottom of their rollout. This is another way to close a utility. If the utility controls appear in a dialog rather than a rollout, closing the dialog closes the utility.
Utilities Dialog

Utilities panel > Utilities rollout > More... button

This dialog lists all utilities that are not already displayed in current button set of the Utility rollout.

Procedures

To run a utility shown in the Utilities dialog, do one of the following:

1. Choose a utility in the list and then click OK.
2. Double-click the utility’s name.

Interface

![Utilities Dialog](image)

Configure Button Sets Dialog

Utilities panel > Utilities rollout > Configure Button Sets button
This dialog lets you create custom button sets for the Utilities panel. Once created, these utility sets are available from the Sets button on the Utilities panel.

**Procedures**

To customize the current button set:

1. Use Total Buttons to choose the number of buttons in the set.
2. Assign buttons by dragging the names of utilities in the Utilities list to buttons in the Utilities group box.
3. Clear buttons by dragging them to the Utilities list on the left.
4. Click OK.

3ds Max updates the Utilities rollout. You can customize the button set without saving it, but if you save a new button set under a new name, you will be able to use it later.

**TIP** Don't alter the Default button set. Create a new one instead.

To create a new button set:

1. Create a custom button set as described in the previous procedure.
2. Enter a new button set name in the Sets edit field.
3. Click Save.

To choose a button set to modify:

- Choose a button set from the Sets drop-down list.
Interface

Utilities List This lists all the utilities currently available to 3ds Max. It is organized into a number of categories, including MAX STANDARD, Channel Info, NURBS, Radiosity, Skin Tools, Strokes, MAXScript Tools, Internet Extensions, Realviz Products, and reactor. To add a utility to the current button set, drag the utility’s name from this list to the Utilities group box.

Sets edit field and drop-down list Lets you choose the button set to modify. By default, there is a single button set called MAX Default.

TIP Don’t alter the Default button set. Create new sets as the need arises.

Save Saves the current button set.

Delete Deletes the current button set.

WARNING You can’t undo the deletion of a button set.

Total Buttons Sets the number of buttons in the button set. A button set can have up to 32 buttons.
Utilities group

This group previews how the button set will appear in the Utilities rollout. A scroll bar on the right lets you see other buttons when the set has more than eight.

To change a button, drag the name of a utility from the Utilities list to a button in this group.

MAXScript Interface

Menu bar > MAXScript
Utilities panel > MAXScript

MAXScript on page 21 is the 3ds Max built-in scripting language. Its main interface, the MAXScript menu, contains various commands for creating and working with scripts. In addition, the status bar on page 8064 contains a MAXScript Mini Listener on page 8065, and MAXScript functionality is also available from the Utilities panel on page 8223.

For detailed information about MAXScript, open the MAXScript Help, available from Help menu > MAXScript Help.

New Script

MAXScript menu > New Script
Utilities panel > Click MAXScript. > MAXScript rollout > New Script

New Script opens a new MAXScript Editor window. Use this window for writing a new script.

For detailed information about the MAXScript utility, open the MAXScript Help, available from Help menu > MAXScript Help.

Open Script

MAXScript menu > Open Script
Utilities panel > Click MAXScript. > MAXScript rollout > Open Script
Open Script opens a common file open dialog for choosing an existing script. A new MAXScript Editor window then displays the selected script.

For detailed information about the MAXScript utility, open the MAXScript Help, available from Help menu > MAXScript Help.

Run Script

MAXScript menu > Run Script
Utilities panel > Click MAXScript. > MAXScript rollout > Run Script

Run Script opens a common file open dialog for choosing an existing script. MAXScript then reads and executes the selected script. Any output is printed to the Listener window.

For detailed information about the MAXScript utility, open the MAXScript Help, available from Help menu > MAXScript Help.

MAXScript Listener

MAXScript menu > MAXScript Listener
Mini Listener > Right-click menu > Open Listener Window
Utilities panel > Click MAXScript. > MAXScript rollout > Open Listener
Keyboard > F11

The MAXScript Listener window is an interactive interpreter for the MAXScript language. It is similar to a DOS command-prompt window. You enter MAXScript commands in this window, and when you press Enter they are executed immediately.

The Listener window is appropriate for performing interactive work and developing small code fragments. Each command you execute in the Listener is actually an expression with a result that the Listener prints out after each execution. You can enter any MAXScript expression or sub-expression in the Listener for evaluation, and the Listener prints out its result.

The Listener is divided into two panes. The top (pink) pane is the Macro Recorder pane, and the bottom (white) pane is the output pane. When the Macro Recorder is enabled, everything recorded is displayed in the Macro Recorder pane. The output of results from scripts are displayed in the output pane. The output of code executed in the Macro Recorder pane is always
directed to the output pane so as not to clutter the recordings. Both panes allow you to cut-and-paste, drag-and-drop, edit, select, and execute code. You can resize the panes by dragging the split bar between them.

The left-end of the status bar contains a resizable Mini Listener. If the Mini Listener is not visible, drag on the vertical split bar at the left end of the status bar to reveal the Mini Listener. The Mini Listener panes act as single-line sliding windows for the current line in the corresponding Listener panes. The Mini Listener panes always show what you are typing or where the edit cursor is placed in the Listener panes. Conversely, anything you type into a Mini Listener pane is entered into the corresponding Listener pane at the current edit cursor position.

![The MAXScript Mini Listener on the Status Bar](image)

You can display the Listener in a viewport by clicking or right-clicking the Point-Of-View viewport label, then choose Extended > MAXScript Listener from the POV viewport label menu on page 8122.

NOTE When you open the MAXScript Listener in this way, and then change the viewport POV, 3ds Max opens the Listener in a window of its own.

For detailed information about the MAXScript utility, open the MAXScript Help, available from Help menu > MAXScript Help.

**Macro Recorder**

MAXScript menu > Macro Recorder

The MAXScript Macro Recorder captures many of the actions performed by the user, and generates the MAXScript commands that correspond to those actions. Output from Macro Recorder is displayed in the Macro Recorder pane of the MAXScript Listener window. Several filtering options are available that control what types of user actions are recorded, whether the generated MAXScript commands contain explicit object references or are selection-relative, and whether the generated MAXScript commands contain absolute or relative transforms and coordinates. These options are set using the MacroRecorder menu in the Listener window. The default option settings
are specified in the MAXScript page of the 3ds Max Preferences dialog, as described in MAXScript Preferences on page 8358. You can also make and change these settings by editing the [MAXScript] section of the 3dsmax.ini file.

While many areas in 3ds Max generate Macro Recorder output, there are also many areas that do not. In general, most of the buttons on the 3ds Max menu bar, toolbars, status bar, Create panel, and Modify panel will generate Macro Recorder output. If the button invokes a secondary dialog, changing settings or performing actions in the secondary dialog typically do not generate Macro Recorder output. In the Create and Modify panels, Macro Recorder output is typically generated if the object or modifier can be created by MAXScript. In rare cases, the plug-ins implementing an object or modifier have not been updated to support Macro Recorder, so that object or modifier does not generate Macro Recorder output.

MAXScript supports text drag-and-drop onto toolbars to create Macro Script buttons. You can select and drag text from any text window, such as the Listener window panes or Editor window, onto any visible toolbar. The cursor changes to an arrow with a + sign when it is permissible to drop the text. Dropping it at that point adds a Macro Script button to the toolbar with the dropped text as the body of the Macro Script. A typical usage of this would be to drag text from the Macro Recorder pane onto a toolbar to make a button that does the sequence of events just recorded.

For detailed information about the MAXScript utility, consult the MAXScript Help, available from Help menu > MAXScript Help.

**Visual MAXScript Utility (See MAXScript Help)**

Utilities panel > Utilities rollout > More button > Visual MAXScript

Visual MAXScript is a powerful interface to the 3ds Max scripting language, making the MAXScript feature easier to learn and use. With Visual MAXScript, you can quickly create UI elements and layouts for scripting.

For detailed information about Visual MAXScript, open the MAXScript Help, available from Help menu > MAXScript Help.

**MAXScript Debugger Dialog**

MAXScript menu > Debugger Dialog
Running Scripts from the Command Line

3ds Max allows you to enter MAXScript commands directly on the command line. When you launch 3ds Max from a DOS command line, you can have it run a specified launch script. This can be useful for tasks such as unattended batch rendering.

This capability uses the existing -U command line switch that names a utility to be run when 3ds Max is started. The -U switch allows an optional extra argument which, for MAXScript, is taken to be the name of the launch script to run. The case (capitalization) of MAXScript must be as shown in the following example (entered after you CD to 3ds Max directory):

See the online Help to view this code sample.

This example command line would launch the 3ds Max executable, start MAXScript, and then have it run the launch script rendercams.ms.

The following example launch script loads two scenes, renders frames from each of the cameras in them, and then quits 3ds Max:

See the online Help to view this code sample.

This example makes use of the quitMax() method to exit 3ds Max when the script is finished. Launch scripts need not be batch scripts as in this example, but may be used to condition 3ds Max for interactive use, for example by loading a scene file and setting some user-interface options.

The normal startup scripts, startup.ms and those in the \scripts\startup directory, are run before the launch script. It is also possible to install scripts into individual scene files that run automatically when that scene is open or closed or at certain other events.
NOTE Command line -U MAXScript startup scripts are run after 3ds Max has completely booted and the standard scripts and startup scripts have been run.

MAXScript Command-Line Switches

The following switches work specifically with MAXScript files and functions.

<table>
<thead>
<tr>
<th>Switch</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>-mip</td>
<td>Starts 3ds Max in a minimized mode – but never allows you to open the window for interactive usage.</td>
</tr>
<tr>
<td>-mxs</td>
<td>This switch is essentially the same as -U MAXScript file.ms, but avoids the need for the .ms file. You can follow the switch with MAXScript commands.</td>
</tr>
<tr>
<td>-silent</td>
<td>Comparable to the MAXScript command, setSilentMode, this switch suppresses all MAXScript and 3ds Max UI dialogs so that batch scripts specified by the -U command do not get interrupted.</td>
</tr>
<tr>
<td>-u MAX-Script &lt;filename&gt;</td>
<td>Opens a specified MAXScript file.</td>
</tr>
</tbody>
</table>

Examples of desired syntax usage:

See the online Help to view these code samples
Customizing the User Interface

You can rearrange the components of the 3ds Max user interface, including the menu bar, toolbars, and command panel. You can also dynamically resize the viewport windows. You can specify which toolbars should appear and which should not, and create your own keyboard shortcuts, custom toolbars, and quad menus. You can also customize the colors used in the User Interface.

For procedures that tell how to rearrange and resize UI components, see Useful Customization Techniques on page 8235. Various other customization options are available from the Customize menu on page 8029.

See also:
■ Revert to Startup Layout on page 8283

Useful Customization Techniques

This topic offers procedures for customizing the 3ds Max user interface, including methods for rearranging and resizing UI components. Various other customization options are available from the Customize menu on page 8029.
Procedures

To switch between a single-viewport and multi-viewport layout:

1. By default, 3ds Max starts with a multi-viewport. To switch to a single-viewport layout, activate a viewport and click the Min/Max Toggle on page 8139.

2. By default, 3ds Max starts with a single viewport. To switch to a multi-viewport layout, click the Min/Max Toggle on page 8139.

To resize the windows in a multi-viewport layout:

- With your cursor, click the splitter bar between any two viewports, or at the intersection of all four viewports, and drag to a new location. When you release the mouse, the new viewport layout is defined. The dividers are saved in the scene, but are reset when you change the layout. This feature does not allow you to define new layouts, only to adjust the proportions of the currently existing ones.

To reset the viewport windows to the default layout:

1. Right-click the splitter bar between the viewports. The Reset Layout button is displayed.
2. Click this button to restore the viewports to the default multi-viewport layout.

To rearrange the order of rollouts in the command panel:

- Click the rollout title bar, and drag to another location on the command panel. A thick line indicates where the rollout will be placed. When you release the mouse button, the rollout is moved to the indicated location, and the other rollouts are shifted appropriately. The order of rollouts is saved in the text file rolluporder.cfg, which is located in the \ui subdirectory.
To float a toolbar, do one of the following:

1. Click the tag bar of the docked toolbar (a narrow line displayed when the toolbar is docked) and drag it away from its location. The toolbar is now floating; you can reposition, resize, or dock it.

2. Right-click the tag bar of the docked toolbar (a narrow line displayed when the toolbar is docked), and then choose Float.

To float the command panel, do one of the following:

1. Right-click the blank area at the upper-right corner of the command panel, and then choose Float.

2. Click a corner of the upper portion of the command panel and drag it into the viewport.

**TIP** If you find you tend to float the command panel accidentally, use Lock UI Layout on page 8242.

To resize the docked command panel horizontally:

- Move the cursor over the edge of the docked command panel that is nearest the viewports. The cursor changes to a double arrow. Drag the cursor to increase or decrease the width of the command panel. The command panel grows or shrinks in column increments. Unless the command panel is hidden, there is always at least one column. When the command panel is docked, the columns must fit within the main 3ds Max window.
Multiple command panels are useful when working with objects such as particle systems, which have many controls.

To resize the floating command panel horizontally:

■ Move the cursor over the left or right edge of the floating command panel. The cursor changes to a double arrow. Drag the cursor to increase or decrease the width of the command panel. The command panel grows or shrinks in column increments. Unless the command panel is hidden, there is always at least one column. When the command panel is floating, you can display as many columns as you want.

To resize the floating command panel vertically:

■ Move the cursor over the top or bottom edge of the floating command panel. The cursor changes to a double arrow. Drag the cursor to increase or decrease the height of the command panel as you do for other windows on the desktop.
To dock a floating UI element, do one of the following:

1  Drag the panel by its title bar to the top, bottom, left, or right edge of the 3ds Max window. The mouse cursor and the panel outline change shape at a docking location. Release the mouse.

2  Right-click the title bar, choose Dock from the pop-up menu, and then choose Top, Bottom, Left, or Right.

3  Double-click the handle or title bar.
   A UI element docks automatically when it approaches a "dockable" location. The toolbars and menu bar can dock at the top or bottom, left or right of the viewports. They can also dock on either side of the Command panel.

To hide a panel or toolbar, do one of the following:

• When a panel or toolbar is floating, you can hide it by clicking the X control in the upper-right corner.

**Customize Display Right-Click Menu**

The Customize Display right-click menu displays when you right-click over a blank area of a toolbar (not when the cursor is over a button). It is also available when the cursor is immediately above, below, or to the right of the command panel tabs: in these locations, the cursor changes to look like a stack of two sheets of paper. In addition, the menu displays when you right-click at the right edge of the command panel when docked, or, when floating, at the right or left edge.
Right-click a blank area of a toolbar to open the Customize Display right-click menu.

Use this menu to toggle the display of various user-interface elements, customize the display of toolbars, and dock or float items such as the command panel.

**Interface**

The following options are displayed in all cases:

- **Customize** Opens the Customize User Interface dialog on page 8249, which lets add commands and macro scripts to new and existing toolbars.
- **Command Panel** Toggles the command panel display. Default=on.
- **Main Toolbar** Toggles the main toolbar on page 8035. Default=on.
- **Axis Constraints** Toggles the Axis Constraints toolbar on page 8039. Default=off.
- **Layers** Toggles the Layers toolbar on page 8040. Default=on.
- **Reactor** Toggles the reactor toolbar on page 8041. Default=off.
Extras Toggles the Extras toolbar on page 8041. Default=off.

Render Shortcuts Toggles the Render Shortcuts toolbar on page 8042. Default=off.

Snaps Toggles the Snaps toolbar on page 8043. Default=off.

Additional Options: Docking and Floating

Depending on the cursor location when you right-click, the menu can also display these options:

Dock Docks the active item to the specified location: Top, Bottom, Left, or Right.

NOTE For more information on docking toolbars, see Customizing the User Interface on page 8235.

Float Floats the active item.

NOTE This option is available only for docked items.

Show UI

Customize menu > Show UI

The Show UI submenu lets you add or remove UI (user interface) elements from the workspace, so that you can customize your screen as you work. You can turn these elements on and off as you need by selecting them from the menu, maximizing the efficiency of your workspace. The settings are stored in the maxstart.cui file, so they will remain after you shut down and restart 3ds Max.

- Show Command Panel
- Show Floating Toolbars
- Show Main Toolbar Alt+6
- Show Track Bar

Choosing a UI element from the Show UI submenu toggles the display of that element. The submenu displays a check mark next to the UI element when it is currently being displayed.

Keyboard shortcuts for turning on and off UI elements are displayed next to their corresponding UI elements in the Show UI menu.
You can use the Show UI menu to hide or display the following UI elements:

- **Command Panel** on page 8181
- Floating Toolbars (toggles all toolbars other than the main toolbar, including the **Axis Constraints Toolbar** on page 8039, **Layers Toolbar** on page 8040, and **Extras Toolbar** on page 8041)
- **Main Toolbar** on page 8035
- **Track Bar** on page 8071

## Lock UI Layout

Customize menu > Lock UI Layout

When the Lock UI Layout toggle is active, you cannot modify the user interface layout by dragging interface elements. (You can still use the right-click menu to do so, however.) Use this command to prevent user interface changes or inadvertent actions, such as floating toolbars, from happening due to mouse clicks.

**TIP** Use this command if you find you are inadvertently selecting and floating UI elements such as the Command panel.

### Procedures

To lock the UI layout:

- Choose Lock UI Layout from the Customize menu.
  You can no longer move or resize the UI elements. Use this command to prevent user interface changes or if you find yourself accidentally floating toolbars or the command panels on mouse clicks.

## Plug-In Manager

Customize menu > Plug-in Manager

The Plug-in Manager lets you manage plug-ins dynamically without any initialization required. The Plug-in Manager provides a list of all plug-ins found in the 3ds Max plug-in directories, including the plug-in description, type (object, helper, modifier, and so on), status (loaded or deferred), size, and path. The Plug-in Manager provides options to load any plug-in, regardless
where it resides on disk. The Plug-in Manager is similar to Summary Info on page 7607, but with more options.

See also:
- 3rd Party Plug-Ins Path Configuration on page 8296

Interface

When you start the Plug-in Manager, it scans through all the plug-in paths specified in the plugin.ini file and lists them in the Plug-in Manager dialog. The information is divided up into columns as described following.

Tag Use the right-click menu and select Tag Selected to add a check mark for selected plug-ins. Tagging plug-ins lets you perform right-click menu actions on them. Thus you can tag multiple plug-ins and perform a single operation on all of them.

Name The filename of the plug-in.

Description A description of the plug-in.

Status Indicates whether the plug-in is loaded (green) or deferred (yellow).

Size File size of the plug-in.

Full Path The disk location of the plug-in file.
Plug-in Directories

3ds Max uses the plug-in directories listed in plugin.ini. You can also configure these paths with the 3rd Party Plug-Ins panel on page 8296 of the Configure User Paths dialog. You can display or hide all the plug-ins in a directory by toggling the check box.

Description Shows directory description from plugin.ini file.

Load Path The path of the plug-in directory.

Right-Click Menu

The right-click menu for the Plug-in Manager works in the list of plug-ins, and in the blank area beneath the list. It does not work in the list of plug-in directories. The commands apply to two possible states for the listed plug-ins: selected (that is, highlighted) and tagged (a check mark appears to the left of the plug-in name).

Selected Plug-ins To load plug-ins, highlight one or more plug-ins, choose this item, and then choose Load.

Clear Selection Removes highlighting from all items in the list.

Tagged Plug-ins To load tagged plug-ins, choose this item, and then choose Load.

Tag Selected Tags all highlighted plug-ins.

Clear Tags Clears all tags.

Load New Plug-in Loads a plug-in from the hard drive. Use the file dialog to locate the plug-in, and then click Open.

Refresh View Refreshes the list of plug-ins.

Custom UI and Defaults Switcher

Customize menu > Custom UI and Defaults Switcher

Artists and designers in different industries use 3ds Max in different ways. The Custom UI and Defaults Switcher lets you quickly change your program defaults and UI scheme to more closely match the type of work you are doing.

The Initial settings for tool options control the default settings for various features in 3ds Max, while the UI Schemes control how the 3ds Max interface looks.
The dialog displays a detailed explanation for each of the four default sets and two UI Schemes that ship with 3ds Max. If you create your own defaults or UI Scheme, they also appear in the list. However, you cannot edit the general description of custom default sets or UI schemes.

See also:

- Market-Specific Defaults on page 8246

Interface

Initial settings for tool options

This list contains different sets of default settings for various tools in 3ds Max. Highlight the set that corresponds to the tools you are using.
3ds Max ships with four default sets:

- **Max** contains the set of default settings for general animation use without the mental ray renderer on page 6675.
- **Max.mentalray** contains the set for general animation use with the mental ray renderer.
- **DesignVIZ** contains the set for design visualization use without the mental ray renderer.
- **DesignVIZ.mentalray** contains the set for design visualization use with the mental ray renderer.

Highlight any of these sets to see detailed explanations of the affected settings. For information on creating or editing default sets, see Market-Specific Defaults on page 8246.

**NOTE** To apply new defaults, restart 3ds Max.

**UI Schemes** This list contains all of the UI schemes defined in the \Ui folder. 3ds Max ships with two UI schemes: DefaultUI, and ModularToolbarsUI, which has the main toolbar on page 8035 broken up into smaller toolbars. Highlight the name of the UI scheme in the list to see a description (and image) of the interface.

This list also contains any UI schemes you have saved with the Save Custom UI Scheme dialog on page 8280. However, no description or image is displayed for these schemes.

**Set** Applies the selected default settings and UI scheme to 3ds Max.

**NOTE** To apply new defaults, restart 3ds Max.

**Cancel** Closes the dialog without applying any changes.

## Market-Specific Defaults

3ds Max is used in many different professional markets, including film, design, and visualization, and games. The workflow and performance requirements for users from these markets vary tremendously. As a result, different default settings are ideal for different types of scenes.

For example, a typical animation scene has a small number of lights; shadow maps on page 8719 provide a fast, accurate solution to generating shadows. On
the other hand, a typical design visualization scene can contain hundreds of
lights, in which case shadow maps can cause memory issues. For this type of
scene, ray-traced shadows on page 8696 are much more appropriate.

In order to provide an efficient working environment for both project types,
3ds Max offers four sets of market-specific defaults, tailored specifically for
general animation scenes and for design visualization projects (both with and
without the use of the mental ray renderer on page 6675). The sets are each
located in their own subdirectories of the \defaults directory. These
subdirectories each contain an INI file (currentdefaults.ini), which contains the
global parameter defaults, a default material library (medit.mat), which
populates the Material Editor at startup, and a startup file (maxstart.max),
which is the file that opens when 3ds Max is started or when you reset. You
can edit any of these files, and you can also create your own sets, however
each set must be in a separate subdirectory of \defaults. in addition, each file
in the directory should have the same names (currentdefaults.ini, medit.mat, and
maxstart.max). If one of these files is not present in a custom defaults directory
that you have created, 3ds Max uses the corresponding file from the
\defaults\max directory in its place.

**NOTE** For your protection, both of the preset default directories have a subdirectory
named \factorydefaults, which contains the original files for each set. You can use
these files in the event that you have changed your defaults and are unhappy with
the results. They are also a useful starting point for creating your own set; copy
them to a new directory and edit them. It is highly recommended that you do not edit
the files in the \factorydefaults directories.

Default sets are assigned through the Custom UI and Defaults Switcher on
page 8244.

**Procedures**

**To change the current set of defaults:**

1. Choose Customize menu > Customize UI And Defaults Switcher.
2. Select one of the default sets from the Initial settings for tool options list and
   click Set.
3. Restart 3ds Max to load the new default parameters.
Interface

Include the following files in your default directory. If one or more of these files is not present in the current *Defaults* directory, 3ds Max uses the corresponding file from `\defaults\max` in its place.

*currentdefaults.ini*

The following table describes all of the sections that can be set in a default INI file. Any parameter with a blank or invalid value uses the hard-coded default.

**NOTE** See the online *User Reference* to view this table.

*medit.mat*

*medit.mat* is the default material library in your scene.

*maxstart.max*

The *maxstart.max* file is loaded when you start or reset 3ds Max.

COM/DCOM Server Control Utility

Utilities panel > Utilities rollout > More button > COM/DCOM Server Control

The COM/DCOM Server Control utility supports plug-ins and third-party programs that use the COM (Component Object Model). The idea behind the COM is to expose the core of 3ds Max so applications can invoke 3ds Max to generate images.

The COM facility is intended for application developers. For more information about applications development with 3ds Max, see the description of the COM object interface in the help file (*3dsMaxSDKFull.chm*) for the 3ds Max Plug-In Software Development Kit (SDK).
Procedures

To register 3ds Max as a DCOM server:

1. Start 3ds Max and go to the Utilities panel. Click More, choose COM/DCOM Server Control, and then click OK.

2. If the button in the COM/DCOM Server Control rollout says Register, then click it. If it says Unregister, then do nothing, as 3ds Max is already registered.

   Now 3ds Max is registered as a DCOM server and an instance of it can be created from any COM client.

   **NOTE** Not all products include this utility. You can build it from the source located in `\maxsdk\samples\utility\comsrv\`. Copy the resulting `comsrvui.dlu` to the 3ds Max `\plugins` directory.

It is also possible to register and unregister from the command line. There are two command-line options that can be passed to 3ds Max:

```
3DSMAX -RegisterMAXRenderer
3DSMAX -UnregisterMAXRenderer
```

Customize User Interface Dialog

Customize menu > Customize User Interface

The Customize User Interface dialog lets you create an entirely customized user interface, including shortcuts, quad menus, menus, toolbars, and colors. You can also add commands and macro scripts by selecting either a text or icon button to represent the command or script on the toolbar.

Most commands in the 3ds Max interface appear in this dialog as action items. An action item is simply a command that you can assign to a keyboard shortcut, toolbar, quad menu, or menu. The Keyboard, Toolbars, Quads, and Menus panels of this dialog show tables of action items that you can assign. (Tables in the Colors panel list UI elements, instead.)

**NOTE** A few action items do not correspond to any elements in the default user interface. See Additional Keyboard Commands on page 7982.
Keyboard Panel

Customize menu > Customize User Interface > Keyboard tab

The Keyboard panel lets you create your own keyboard shortcuts. You can assign shortcuts to most commands available in 3ds Max.

The same shortcuts can be assigned to multiple commands, as long as they occur in different contexts. For example, in Video Post, the shortcut Ctrl+S is assigned to Add Scene Event; however, in the Main UI, it is assigned to Save File.

When you use a keyboard shortcut, 3ds Max looks for a context-specific shortcut first. If none is found it then looks for the appropriate command in the Main UI shortcuts.

for the context-specific shortcuts to work properly, the Keyboard Shortcut Override toggle on page 8420 must be on (the default). If it is off, only the Main UI keyboard shortcuts are available.

See also:

- Keyboard Shortcuts on page 8419

Procedures

To create a keyboard shortcut:

1. Choose Customize menu > Customize User Interface > Keyboard panel.
2. Use the Group and Category lists to find the action for which you want to create a shortcut.
3. Click action in the Action list to highlight it.
4. In the Hotkey field, enter the keyboard shortcut you want to assign to the action.
NOTE: If the keyboard shortcut you enter is already assigned to an action, that action name appears in the Assigned To field.

5  Click Assign.

**Interface**

**Group** Displays a drop-down list that lets you select the context you want to customize, such as Main UI, Track View, Material Editor, and so on.

**Active** Toggles availability of context-specific keyboard shortcuts. When on, you can use duplicate shortcut keys between contexts within the overall user interface. For example, A can be the shortcut for Angle Snap toggle within the Main UI, and also a shortcut for Assign Material to Selection when you are working in the Material Editor. When Active is off, the shortcuts defined for the appropriate context are not available. Default=on.
Category Displays a drop-down list of all the available categories of user interface actions for the selected context.

Action list Displays all the available actions and shortcuts, if defined, for the selected group (context) and category.

Hotkey Allows you to enter a keyboard shortcut. Once the shortcut is entered, the Assign Button is active.

Assigned To Displays the action a shortcut is assigned to if the shortcut you entered is already assigned.

Assign Activates when you enter a keyboard shortcut in the Hotkey field. When you click Assign, it transfers the shortcut information to the Action list on the left side of the dialog.

Remove Removes all shortcuts for the selected action in the Action list on the left side of the dialog.

Write Keyboard Chart Opens the Save File As dialog, where you can save changes you made to keyboard shortcuts in a TXT file that you can print.

Overrides Active When on, holding keys for boldface shortcuts in the Edit Poly and Editable Poly groups overrides standard functionality. For example, while editing an Editable Poly object at the Polygon sub-object level, pressing and holding Shift+Ctrl+B activates the Bevel tool temporarily, overriding the current operation.

Delay To Override The delay before which the active keyboard shortcut overrides the current operation (see Overrides Active, preceding).

Load Displays the Load Shortcut File dialog. Allows you to load custom shortcuts, from a KBD file into your scene.

Save Displays the Save Shortcut File As dialog. Allows you to save any changes you’ve made to the shortcuts to a KBD file.

Reset Restores the shortcuts to the default setup (defaultui.kbd).

**Toolbars Panel**

Customize menu > Customize User Interface > Toolbars tab

The Toolbars panel lets you edit existing toolbars and create your own custom toolbars. You can add, remove, and edit buttons on existing toolbars, or you can delete the toolbars entirely. You can also create custom toolbars with both 3ds Max commands and scripts.
Procedures

To create and populate a toolbar:

1. Choose Customize menu > Customize User Interface > Toolbars tab.
2. Click New.
   The New Toolbar dialog appears.
3. Enter the name of the toolbar and click OK.
   The new toolbar appears as a small floater. Like any floating toolbar, you can resize it and change proportions by dragging the corners and edges.
4. Use any of these three methods to add commands to the toolbar:
   - Drag a command to the toolbar from the Customize User Interface dialog > Action list. If the action has a default icon assigned to it (it appears next to the command in the action list), the icon will appear as a button on your toolbar. If no icon is assigned to the command, the name of the command will appear as a button on the toolbar.
   - To copy an existing button, Ctrl+drag the button from any toolbar onto your toolbar.
   - To move an existing button, Alt+drag the button from any toolbar onto your toolbar.
5. If you don’t want the new toolbar to appear in the interface by default, choose it from the drop-down list on the right side of the Customize User Interface dialog, and then turn on the Hide check box. Thereafter you can toggle the custom toolbar by right-clicking a blank area of any toolbar and choosing the toolbar name from the context menu.

To add commands to a toolbar:

1. Choose Customize menu > Customize User Interface > Toolbars panel. Alternatively, right-click the label of a toolbar and then choose Customize.
2. If necessary, open the toolbar to customize using either of the following methods:
   - Right-click a blank area of any toolbar and choose the toolbar name from the context menu.
   - Choose the toolbar name from the toolbars drop-down list on the right side of the dialog and then turn off the Hide check box.
3 Use any of these three methods to add commands to the toolbar:

- Drag a command to the toolbar from the Customize User Interface dialog > Action list. If the action has a default icon assigned to it (it appears next to the command in the action list), the icon will appear as a button on your toolbar. If no icon is assigned to the command, the name of the command will appear as a button on the toolbar.

- To copy an existing button, Ctrl+drag the button from any toolbar onto your toolbar.

- To move an existing button, Alt+drag the button from any toolbar onto your toolbar.

To record a script and add it to a toolbar:

Use this method to record a series of commands into a MAXScript command sequence and then turn the script into a toolbar button. You can then re-invoke that sequence at any time. No scripting knowledge is necessary.

1 Choose Customize menu > Customize User Interface > Toolbars panel. Alternatively, right-click the label of a toolbar and then choose Customize.

2 Open a MAXScript Listener window by any of the following methods:
   - Press F11.
   - Choose MAXScript menu > MAXScript Listener.
   - Choose Utilities panel > MAXScript > MAXScript rollout > Open Listener.
   - Click or right-click the POV viewport label, and then from the POV viewport label menu on page 8122, choose Extended > MAXScript Listener.

3 Choose MAXScript menu > Macro Recorder, or, from on the Listener dialog, choose MacroRecorder > Enable.

4 Perform the actions you want to record.
   The Macro Recorder records the actions you perform as a script in the upper portion of the Listener dialog (pink background).

5 Highlight the lines you want in the recorded script, and then drag those lines directly onto a toolbar.
NOTE Your macro might require some minor editing to remove extraneous steps or to refine the procedure.

You can edit the appearance of the text or icons on your toolbars with the Edit Button Appearance on page 8258 command, which is available when you right-click the toolbar button.

To add a button to the Quick Access toolbar:

- Drag an action from the Action list and drop it on the list in the Quick Access Toolbar group.
  The toolbar updates to show the new button. If the action you chose doesn’t have an associated icon, a generic button appears on the toolbar. See Edit Button Appearance Dialog on page 8258.

To remove a button from the Quick Access toolbar:

1. Click an item in the Quick Access toolbar list to highlight it.
2. Click Remove.
   3ds Max removes the button from the list and the Quick Access toolbar.
Group Displays a drop-down list that lets you choose the functional context you want to customize. Contexts include Main UI (user interface), Track View, and Material Editor.

Category Displays a drop-down list of available categories of user-interface actions for the chosen group.

Action list Displays all available actions for the chosen group and category.

[toolbars drop-down list] Displays all existing toolbars.

New Opens the New Toolbar dialog. Enter the name of the toolbar you want to create and click OK. The new toolbar appears as a small floater.

Once you’ve created a toolbar, there are three ways to add commands:

- Drag actions from the Action Window in the Toolbars panel of the Customize User Interface dialog onto your toolbar.
■ Ctrl+drag buttons from any toolbar onto your toolbar. This action creates a copy of the button on your toolbar.

■ Alt+drag buttons from any toolbar onto your toolbar. This action moves the button from the original toolbar onto your toolbar.

Delete Deletes the toolbar item displayed in the Toolbars list.

Rename Displays the Rename Toolbar dialog. Select a toolbar from the Toolbars list to activate the Rename button. Click Rename, change the name of the toolbar, and click OK. The toolbar name changes in the toolbar floater.

Hide Toggles the display of the chosen toolbar in the toolbars list.

Quick Access Toolbar group

[List of buttons] Shows the buttons that currently appear on the Quick Access toolbar.

You can add a button to this list by dragging and dropping from the Action list.

Move Up Moves the selected button up in the list, which moves it to the left on the toolbar.

Move Down Moves the selected button down in the list, which moves it to the right on the toolbar.
**Remove** Removes the selected button from the list and the toolbar.

---

**Load** Displays the Load UI File dialog. Allows you to load custom user interface files into your scene.

**Save** Displays the Save UI File As dialog. Allows you to save any changes to the user interface in a CUI file.

**Reset** Restores the default setup (*defaultUi.cui*).

---

**Edit Button Appearance Dialog**

Right-click any button on a custom toolbar. > Edit Button Appearance

Use this dialog to change the appearance of the selected button. You can substitute a different icon for the button, or change to a text button instead. You can also customize the tooltip.

**Custom Icons**

To make a custom icons, you need a series of four files, each beginning with the same prefix which designates the icon group. You can create these images in any paint program.

- A 24x24 image for use when large icons are displayed. Suffix: _24i.bmp.
- A 24x24 grayscale image showing the transparency of the 24x24 image, with black pixels indicating see-through areas where the gray button background shows through. Suffix: _24a.bmp.
- A 16x15 image for use when small icons are displayed. Suffix: _16i.bmp.
- A 16x15 grayscale image showing transparency of the 16x16 image. Suffix: _16a.bmp

To use a file with multiple icons, arrange the icons in series, one after the other. For example, if you want three icons to appear, the file that ends in _24i.bmp would be 72 pixels wide and 24 pixels high, and contain the three icons arranged in a row with no space between them.

After you create the icon files, copy them to the *UI/icons* folder and restart 3ds Max. This lets 3ds Max find and display the group when you access the Edit Button Appearance dialog.
TIP For examples of how to arrange custom icons in image files, look at some of the existing BMP files in the UI/icons folder.

Interface

Tooltip You can add your own tooltips to the buttons. The tooltip displays when the mouse is over the tool button. You can edit this text to describe the tool.

Text Button Lets you assign text to the button. You can enter whatever text you like for the button.

Image Button Lets you assign an image (icon) to the button. You can use any predefined icon that you want by selecting it from the display on the right.

Group Displays a list of button categories. The groups of icons change with each category selection.

Odd Only Certain icon sets, including Internal, Classic, Main toolbar, and others, are designed in pairs. In each pair, one icon depicts the button when enabled, and the other shows how it looks when disabled. When Odd Only is on, the interface displays only the odd-numbered icons (enabled), when Odd Only is off, all of the icons, enabled and disabled, are displayed.

Quads Panel

Customize menu > Customize User Interface > Quads tab

The Quads panel lets you customize the quad menus on page 8052. You can create your own quad menu sets, or you can edit existing sets. In the Quads
panel, you can customize menu labels, functionality, layout, and shortcuts. The advanced quad menu options on page 8264 let you modify the color and behavior of the quad menu system. You can also save and load custom menu sets.

See also:
■ Additional Quad Menus on page 8057

Procedures

To create a quad set:

1. Choose Customize menu > Customize User Interface > Quads tab.
2. Click New.
   The New Quad Set dialog appears.
3. Enter the name of the quad set and click OK.
   The new set appears in the Quad set list.

To add a command to a quad set:

1. Choose Customize menu > Customize User Interface > Quads tab.
2. Choose the quad set you want to edit from the upper-right drop-down list.
   If you want to change the name of the quad set, click Rename and enter a new name in the Rename Quad Set dialog.
3. Select the quadrant where you want to place the command.
   You can edit the name of the quadrant by changing the text in the Label area.
4. Choose the appropriate Group and Category from the respective drop-down lists.
5. Choose a command from the action list and drag it into the Quad Menu window.
   Use the same procedure to add menus and separators to your quad set.
To delete a quad set:

**NOTE** You cannot delete any of the default quad sets.

1. Choose Customize menu > Customize User Interface > Quads tab.
2. Choose the quad set you want to delete from the upper-right drop-down list.
3. Click Delete.

To remove a command from a quad set:

1. Choose Customize menu > Customize User Interface > Quads tab.
2. Choose the quad set you want to edit from the upper-right drop-down list.
3. Choose the command you want to remove.
4. Press the Delete button.
   Use the same procedure to remove menus and separators from your quad set.

To move a command in a quad set:

- Choose the command in the quad set list and drag it to a new position in the list.
Interface

**Group** Displays a drop-down list that lets you select the context you want to customize, such as Main UI, Track View, Material Editor, and so on.

**Category** Displays a drop-down list of the available categories of user interface actions for the selected context.

**Action list** Displays all the available actions for the selected group and category. To add an action to a specific quad set, select it and drag it to the quad menu window on the right side of this dialog. Right-click an action in this window to edit the macro script that defines the action (if there is one).

**Separator list** Displays a separator line that you can use to separate groups of menu items in a quadrant. To add a separator line to a specific quad set, select it and drag it to the quad menu window on the right side of this dialog.
**Menus list** Displays the names of all 3ds Max menus. To add a menu to a specific quad set, select it and drag it to the quad menu window on the right side of this dialog. Right-click a menu in this window to delete the menu, rename it, or create a new, empty menu.

**Quad set list** Displays the available quad sets.

**Additional quad menus** on page 8057 appear in this list. They can be edited, renamed, and reorganized; however, they cannot be deleted.

**New** Opens the New Quad Set dialog. Enter the name of the quad set you want to create and click OK. The new quad set appears in the Quad set list.

**Delete** Deletes the item displayed in the Quad set list. Available only for user-generated quad sets.

**Rename** Opens the Rename Quad Set dialog. To activate the Rename button, choose a quad set from the list. To change the name, click Rename, edit the name of the quad set, and then click OK.

**Quad Shortcut** Allows you to define a keyboard shortcut for displaying the quad set. Enter the shortcut and click Assign to make the change.

**Show All Quads** When on, a viewport right-click shows all four quad menus. When off, a viewport right-click shows only one quad at a time.

**Label** Displays the label for the highlighted quadrant (shown in yellow to the left of the Label).

**Quad Menu Window** Displays the menu options for the currently selected quad menu and quad set. To add menus and commands, drag options from the Action and Menus windows to this window.

Items included in the quad menu are displayed only when they are available. For example, if your quad menu contains Track View Selected, the command will display only if a selection exists when you open the quad menu. If none of the commands are available when you open the quad menu, the quadrant does not appear.

When you right-click an item in the quad menu window, several actions become available:

**Delete Menu Item** Removes the highlighted action, separator, or menu from the quad menu.

**Edit Menu Item Name** Opens the Edit Menu Item Name dialog. To edit the name, the Customize Name check box must be on. Enter the desired name in the name text field and click OK. The item name is changed in the quad menu, but not in the quad menu window.
Flatten Sub-Menu Displays contents of selected submenu on top level of quad. If you choose this item, the menu name is followed by the string: [FLAT].

Edit MacroScript Opens the macro script for the selected action in a MAXScript editor window.

Advanced Options Opens the Advanced Quad Menu Options dialog on page 8264.

Load Displays the Load Menu File dialog. Allows you to load custom menu files into your scene.

Save Displays the Save Menu File As dialog. Allows you to save changes to the quad menus in a MNU file.

Reset Restores the default setup (defaultui.mnu).

Advanced Quad Menu Options

Customize menu > Customize User Interface > Quads panel > Advanced Options

The Advanced Quad Menu Options dialog lets you customize the size and colors of your quad menus. You can also customize other quad menu behaviors such as repositioning, type font, and cursor behavior.
Interface

Save group

**Load**  Lets you load a quad options (.qop) file.

**Save**  Saves your settings to a .qop file.

**Save as Startup**  Saves your current settings as the startup settings.

**Reset to Startup**  Resets options to default settings (*defaultui.qop*).
Colors group

The colors group allows you to customize the colors of your quad menus.

**Starting Quadrant**  Lets you select which quadrant your cursor starts in when you open the quad menu.

**Color list**  Lists customizable elements of the quad menu and separates them by quadrant. Click the color swatch to open a color selection dialog. If the colors for a quad menu element are locked (indicated by a pressed “L” button), each of the separate quadrants share the same color; when you change the color in one quadrant, it changes all of the quadrants’ colors.

You can customize each quadrant separately by turning off the lock button for the selected quad menu element.
Display group

Uniform Quad Width When on, all displayed quadrants are the same width. The widest quadrant determines the width.

Mirror Quads When on, text in the quad menus is justified to the inside edge of the menu: The text in the right quadrants is left-justified, and text in the left quadrants is right-justified.

When off, all text in the quad menus is left-justified.

Vertical Margins Sets the vertical spacing between commands in the quad menu.

Opacity Amount Sets the opacity of the quad menu.

Opacity is not available in systems running on Windows NT.

Positioning group

Reposition Quad When Off Screen Automatically repositions the quad menu when you open it with part of the menu off the edge of the screen. The menu is moved so that the entire menu is displayed on the screen.

Move Cursor When Repositioned Moves your cursor to the new location of the quad menu when it is repositioned.
When off, hold down the mouse button when you right-click to display the quad menu. After you move the cursor over the menu, release the mouse button.

Return Cursor After Repositioned After you have selected an action from the quad menu, the cursor is returned to the location on the screen where the original right-click was made.

Fonts group

Title Font Sets the font of the quadrant titles.
Size Sets the font size of the quadrant titles.
Menu Font Sets the font of the text inside the quadrants.
Size Sets the font size of the text inside the quadrants.

Animation group

Type Sets the animation type for the quad menu from the following options:
- None Quad menus display immediately upon right-clicking.
- Stretch Quad menus open by expanding one quadrant at a time, in a clockwise manner. They close similarly, contracting one quadrant at a time, in a counterclockwise manner.
Quad menus open by fading in from transparent to opaque, and close by fading out from opaque to transparent.

**Steps** The number of frames used to complete the animated display of the quad menu.
As this value becomes larger, the transition (small to large, transparent to opaque, and so on) becomes more gradual.

**Pause** The time between frames during the animated display of the quad menu.
As this value becomes larger, the animated display of the quad menu slows down.

### Menus Panel

Customize menu > Customize User Interface > Menus tab

The Menus panel lets you customize the menus in 3ds Max. You can edit existing menus or create your own. You can customize menu labels, functionality, and layout.

**Procedures**

**To create a menu:**

1. Choose Customize menu > Customize User Interface > Menus tab.
2. Click New.
   The New Menu dialog appears.
3. Enter the name of the menu, and click OK.
   The new menu appears in the menu list.

**To add a command to a menu:**

1. Choose Customize menu > Customize User Interface > Menus tab.
2. Choose the menu you want to edit from the drop-down list.
   If you want to change the name of the menu, click Rename, and enter a new name in the Rename Menu dialog.
3. Choose the appropriate Group and Category from the respective drop-down lists.
4 Choose a command from the action list and drag it into the Menu window.

Use the same procedure to add menus and separators to your menu.

**To delete a menu:**

1 Choose Customize menu > Customize User Interface > Menus tab.
2 Choose the menu you want to delete from the drop-down list.
3 Click Delete.

**To remove a command from a menu:**

1 Choose Customize menu > Customize User Interface > Menus tab.
2 Choose the menu you want to edit from the drop-down list.
3 Choose the command you want to remove.
4 Press the Delete key.

Use the same procedure to remove menus and separators from your menus.

**To move a command in a menu:**

- Choose the command in the menu window and drag it to a new position in the window.
Interface

**Group** Displays a drop-down list that lets you select the context you want to customize, such as: Main UI, Track View, Material Editor, and so on.

**Category** Displays a drop-down list of the available categories of user interface actions for the selected context.

**Action Window** Displays all the available actions for the selected group and category. To add an action to a specific menu, select it and drag it to the menu window on the right side of this dialog. Right-click an action in this window to edit the macro script that defines this action (if there is one).

**Separator Window** Displays a separator line that can be used to separate groups of menu items. To add a separator to a specific menu, select it and drag it to the menu window on the right side of this dialog.

**Menu Window** Displays the names of all menus. To add a menu to another menu (shown in the Menu List), select and drag it to the menu window on
the right side of this dialog. Right-click a menu in this window to delete the menu, rename it, or create a new, empty menu.

**Menu List** Displays the default menus as well as any new ones you create or load.

**New** Displays the New Menu dialog. Enter the name of the menu you want to create and click OK. The new menu appears in the menu window on the left side of the dialog as well as in the Menu List.

**Delete** Deletes the item displayed in the menu list window.

**Rename** Displays the Edit Menu Item Name dialog. Select a command in the menu list window and click Rename. This dialog lets you specify a custom name to be displayed in the menu. If you precede a letter in the custom name with the “&” (ampersand) character, that letter is used as a menu accelerator.

**Menu Window** Displays the menu options for the menu currently selected in the menu list. To add menus and commands (actions), simply select and drag the options from the Action and Menus windows to this window. There are several actions available when you right-click any item in the menu window:

**Delete Menu Item** Removes the selected action, separator, or menu from the menu.

**Edit Menu Item Name** Opens the Edit Menu Item Name dialog. The Customize Name check box must be on to edit the name. Enter the desired name in the name text field and press OK. The item name is changed in the menu, but not in the menu window. If you precede a letter in the custom name with the “&” (ampersand) character, that letter is used as a menu accelerator.

**Edit MacroScript** Opens the script for the selected action in a MAXScript editor window.

**Load** Displays the Load Menu File dialog. Allows you to load custom menu files into your scene.

**Save** Displays the Save Menu File As dialog. Allows you to save changes to the menus in an MNU file.

**Reset** Restores the default setup (*defaultui.mnu*).

**Colors Panel**

Customize menu &gt; Customize User Interface &gt; Colors tab
The Colors panel of the Customize User Interface dialog allows you to customize the look of the 3ds Max interface. You can adjust the colors for almost every element in the interface, giving you the freedom to design your own unique style.

The quad menu colors cannot be customized from the Color panel. To customize quad menu colors, use the Advanced Quad Menu Options dialog on page 8264.

Procedures

To change an interface element color:

1  From the Elements drop-down list, choose the category of the interface element whose color you intend to change.

2  In the list below the Elements field, highlight the element whose color you intend to change.
   The Color swatch shows the current color of the element.

3  Click the Color swatch and then use the Color Selector dialog to choose a new color. Click the Close button to set the color.
   To restore the color that was active at the time that you opened the dialog, highlight the element and click Reset.

4  Continue choosing elements and changing colors as necessary.

5  To finish and apply the color changes to the interface, close the dialog by clicking the X button in the upper-right corner.

TIP  If you change several colors and then want to restore all colors to the default values, click the Load button and open DefaultUI.clr.
Interface

Elements Displays a drop-down list that lets you select from the various high-level groupings: Character, Geometry, Gizmos, Viewports, and more.

[UI elements list] Displays a list of the available elements in the active category.

Color Displays the color for the selected category and element. Click to display the Color Selector, where you can change the color. After choosing a new color, click Apply Colors Now to make the change in the interface.

Reset Resets the color of the highlighted element to the value that was active when you opened the dialog.

Intensity Sets a grayscale value for the display of the grid lines. 0 is black and 255 is white.
This control is available only when you choose the Set By Intensity option from the Grids element, and affects the intensity of the grid lines in the viewports.

**Invert** Inverts the grayscale value for the display of grid lines. Dark gray becomes light gray and vice-versa.
This control is available only when you choose the Set By Intensity option from the Grids element.

**Scheme** Allows you to choose whether the main UI colors are set to the default Windows colors or whether they can be customized. If Use Standard Windows Colors is active, all of the elements in the UI Appearance list are disabled, and you are unable to customize the UI colors.

**[UI appearance list]** Displays all the elements in the user interface that can be changed.

**Color** Displays the color for the selected UI appearance item. Click to display the Color Selector dialog, where you can change the color. After choosing a new color, click Apply to make the change in the interface.

**Reset** Restores the highlighted UI appearance item to its color when you first opened the dialog.

**Saturation** Sets a saturation scale of enabled or disabled icons in the UI. The higher the saturation, the less gray the color. See Red, Green, Blue / Hue, Saturation, Value on page 8698.
This control is only available when Icons: Enabled or Icons: Disabled is highlighted in the UI Appearance list.

**Value** Sets the value scale of enabled or disabled icons in the UI. The higher the value, the brighter the color. See Red, Green, Blue / Hue, Saturation, Value on page 8698.
This control is available only when Icons: Enabled or Icons: Disabled is highlighted in the UI Appearance list.

**Transparency** Sets the transparency value scale of enabled or disabled icons in the UI. The higher the value, the more opaque the icon.
This control is only available when Icons: Enabled or Icons: Disabled is highlighted in the UI Appearance list.

**Invert** Inverts the RGB value for the display of enabled or disabled icons in the UI.
This control is available only when Icons: Enabled or Icons: Disabled is highlighted in the UI Appearance list.
Contrast Adjusts the scale of contrast boost for graphic buttons (buttons with an icon).

This control is available only when Icons: Enabled or Icons: Disabled is highlighted in the UI Appearance list.

Contrast and Gradient Map are meant to improve button appearance. Typically, they default to 100 for a dark color scheme such as `ame-dark.clr`, and to 0 for a light color scheme such as `ame-light.clr`.

### Gradient Map

Adjusts the scale of color gradient mapping for graphic buttons (buttons with an icon).

This control is available only when Icons: Enabled or Icons: Disabled is highlighted in the UI Appearance list.

Contrast and Gradient Map are meant to improve button appearance. Typically, they default to 100 for a dark color scheme such as `ame-dark.clr`, and to 0 for a light color scheme such as `ame-light.clr`.

#### Apply Colors Now

Activates any changes in the user interface.

#### Load

Displays the Load Color File dialog. Allows you to load custom color files into your scene.

#### Save

Displays the Save Color File As dialog. Lets you save changes to the user interface colors in a CLR file.

#### Reset

Restores the default setup (`defaultui.clr`).

---

## Saving and Loading Custom User Interfaces

You can customize your workspace by saving and loading custom user interface (UI) schemes.

A custom UI scheme is saved as a set of six files:

- **.cui**: Stores toolbar and panel layouts.
- **.clr**: Stores all color settings (except quad menu colors).
- **.mnu**: Stores menu bar and quad menu contents.
- **.qop**: Stores quad menu colors, layout, and behavior.
- **.kbd**: Stores keyboard shortcut assignments.
- **.ui**: Stores the icon scheme (Classic or 2D Black and White).
You can load and save each of these files individually from their respective panels in the Customize User Interface dialog on page 8249. You can also load an entire set of UI scheme files at once with the Load Custom UI Scheme dialog on page 8279, and you can save the current UI scheme as a complete set with the Save Custom UI Scheme dialog on page 8280.

By default, two sets of UI schemes are present in the 3dsmax\UI folder: maxstart and defaultUI. Upon startup, 3ds Max uses the maxstart file series if it exists; if not, it uses the defaultUI series.

**WARNING** Do not save over any files that begin with defaultUI, as doing so permanently overwrites the default UI scheme.

**Procedures**

**To load a custom UI scheme:**

1. Set up the custom UI scheme within 3ds Max using the options on the Customize menu > Customize User Interface dialog on page 8249.

2. Save the custom UI scheme with Customize menu > Save Custom UI Scheme.

3. During your current 3ds Max session or any later session, choose Customize menu > Load Custom UI Scheme.

4. In the Load Custom UI Scheme dialog, select a type of customization file (.cui, .mnu, .clr, .kbd, .qmo, or .ui) from the Files of Type drop-down list.

5. Choose any file with the appropriate extension. 3ds Max will search for (and load) any other type of UI scheme file with the same base file name. If you choose a UI scheme for which one of the six file types is not present, the part of the user interface for which there is no file will not be changed.

**To return to the default UI scheme:**

If you start 3ds Max and its user interface has an unfamiliar layout, you can always return to the default UI scheme.

1. Choose Customize > Load Custom UI Scheme.

2. From the Load UI File dialog that displays, choose defaultui.cui, and click Open.

   All the default UI files begin with the base file name defaultui. When you choose defaultui.cui, 3ds Max loads all default UI scheme files.
To start 3ds Max with a custom user interface:

1. Arrange the user interface as you would like it to appear when you start 3ds Max.

2. Choose Customize menu > Save Custom UI Scheme, and save your custom UI scheme with the base file name `maxstart`.

   The next time you start 3ds Max, 3ds Max uses the current UI scheme.

   **NOTE** If the Save UI Configuration On Exit option on the Customize menu > Preferences > General tab is on (which it is by default), the state of the user interface when you close 3ds Max overwrites the `maxstart` UI scheme files.

To start 3ds Max with a custom user interface from the command line:

1. Save your custom UI scheme with a descriptive base file name with the Save Custom UI Scheme dialog.

2. Right-click the 3ds Max icon on the Windows desktop, and choose Properties.

3. In the Target field, change `3dsmax.exe` to `3dsmax.exe -c`, followed by the name of your `.cui` file.

   Example: `3dsmax.exe -c myfile.cui`. Be sure to leave a space both before and after the `-c`.

If you want to move the UI scheme to a different computer, copy all the files in the `3dsmax\UI\` folder that start with the custom UI scheme base name to the new `3dsmax\UI\` folder. Alternately, you can add the path name to the command line.

To save a single UI scheme file:

1. Choose Customize menu > Customize User Interface.

2. Access the panel for the type of user interface item you want to save.

3. On the panel, click Save.

To change the icon display from Classic to 2D Black and White:

1. Choose Customize menu > Save Custom UI Scheme, enter a filename, and click Save.
2 On the Custom Scheme dialog, next to Icon Type, choose the type of icon you want to display.

3 Click OK to close the dialog and save the scheme.

4 Choose Customize menu > Load Custom UI Scheme and then open the UI scheme you saved.

**Load Custom UI Scheme**

Customize menu > Load Custom UI Scheme

On the Load Custom UI Scheme dialog, you specify the base file name of the custom UI scheme you want to load. You can select any type of UI scheme file from the dialog, and 3ds Max will load any other type of UI scheme files with the same base file name.

To save a custom UI scheme, use the Save Custom UI Scheme dialog on page 8280.

For more information on saving and loading custom user interfaces, see Saving and Loading Custom User Interfaces on page 8276.

You can also load a custom UI scheme with the Custom UI and Defaults Switcher on page 8244.

**Interface**

**TIP** You can resize the dialog by dragging an edge or a corner.
Use the Look In field to navigate to other directories. Click the folder to choose it. The files display in the window.

Use the Files of type drop-down list to search for other types of customization files. The default is .cui, but you can also search for .clr, .mnu, .kbd, .qop, and .ui files. When you choose a filename, all files with that base file name are loaded.

**Save Custom UI Scheme**

Customize menu > Save Custom UI Scheme

This standard Windows file save dialog lets you save your customized UI scheme.
This dialog works differently from other dialogs that save files. In this dialog, after you enter a base file name and click Save, the Custom Scheme dialog appears. On the Custom Scheme dialog, you set the types of user interface schemes to save. A file is saved for each type of scheme you select, each with a specific extension for that type of scheme. When you load any one of the custom UI scheme files with the Load Custom UI Scheme dialog on page 8279, the entire set of files with the same base file name are loaded.

On the Save Custom UI Scheme dialog, the base name of the current UI scheme is filled in by default. You can enter the name of the base file name in the File Name field, or click in the list to choose an existing base file name. You can click a file with any UI scheme extension to save to the base file name from that file.

If you want the current UI to load automatically every time you load 3ds Max, you can save to the base file name maxstart. Alternately, you can turn on the Save UI Configuration On Exit option on the Customize menu > Preferences > General tab on page 8299. This causes the UI scheme that is current at the time you close 3ds Max to be saved to the base file name maxstart. This option is on by default.

**WARNING** Do not save over the base file name defaultUI, as doing so permanently overwrites the default UI scheme files.
For more information on saving and loading custom user interfaces, see Saving and Loading Custom User Interfaces on page 8276.

**Interface**

After you enter a file name and click Save, the Custom Scheme dialog opens, letting you define which parts of the UI scheme will be saved.

![Custom Scheme Dialog]

**TIP** You can resize the dialog by dragging an edge or a corner.

- **Interface Layout (.cui)** When on, saves the current toolbar and panel layout to a CUI file with the UI Scheme base file name.
- **Keyboard Shortcuts (.kbd)** When on, saves the current keyboard shortcuts to a KBD file with the UI Scheme base file name.
- **Menus (.mnu)** When on, saves the menu layout to an MNU file with the UI Scheme base file name.
- **Quad Options (.qop)** When on, saves the quad menus to a QOP file with the UI Scheme base file name.
- **Colors (.clr)** When on, saves the current color definitions to a CLR file with the UI Scheme base file name.

**Icon Type** Selects the icon scheme for all toolbars, and saves this information in a file with the extension .ui after the UI Scheme base file name.
NOTE The icon scheme you choose is saved as part of the file set, regardless of whether the chosen icon scheme matches the current scheme displayed on your screen.

All Turns on all of the controls described preceding.
None Turns off all of the controls described preceding.
OK Closes the dialog, and saves all of the selected UI Scheme files.
Cancel Closes the dialog without saving any UI Scheme files.

Revert to Startup Layout

Customize menu > Revert to Startup Layout

Revert To Startup layout automatically loads _startup.ui, which returns the user interface to its startup settings. This temporary system file is created automatically when you start 3ds Max. Use this option to return the UI to startup settings.

For information on how to load different UI schemes on startup, see Load Custom UI Scheme on page 8279.

If the Preferences dialog > General panel on page 8299 > Save UI Configuration On Exit switch is on when you exit 3ds Max, the current UI file is overwritten.

Configure Paths

Customize menu > Configure User Paths
Customize menu > Configure System Paths

You can configure the paths used for 3ds Max scenes, plug-in components, external files such as bitmaps or MAXScript scripts, and so on.

Configure Paths functionality is available in two dialogs:

- Paths that you use to specify locations for bitmaps, scenes, and so on, are found on the Configure User Paths dialog on page 8284. In addition, the latter dialog now lets you save, load, and merge path-configuration files, which makes it easier for content-creation teams to set up the same folders for all team members to use.
Paths used by 3ds Max for purposes such as loading fonts and defaults are accessible on the Configure System Paths dialog on page 8293.

See also:
- Asset Tracking dialog > Paths menu on page 7595

**Configure User Paths**

Customize menu > Configure User Paths

3ds Max uses stored paths to locate different kinds of user files, including scenes, images, DirectX effects (FX), photometric, and MAXScript files. You use the Configure User Paths command to display the Configure User Paths dialog and customize these paths. This command is useful when you add new folders to help you organize your scenes, images, plug-ins, backups, and so on.

You can save, load, and merge the paths that the Configure User Paths dialog manages in MXP (max path) files. This capability makes it easy for all members of content-creation teams to keep projects organized and work efficiently by using the same paths.

See also:
- Configure System Paths on page 8293

**Procedures**

In general, these procedures are common to all panels on the Configure User Paths dialog. When you change a setting, it is written to the 3dsmax.ini file, and is effective immediately.

To modify a path:

1. Click a path entry to highlight it.
2. Click Modify.
3. Use the Choose Directory dialog to do one of the following:
   - Enter a path in the Path field.
   - Navigate to locate a path.
4 Optional step (3rd Party Plug-Ins panel only): Edit the description of the path in the Label field. This description then appears in the path list.

5 Click Use Path. The new path takes effect immediately.

To share User paths with team members:

1 Use the Configure User Paths dialog to set up all necessary user paths.

2 Click the Save As button and then use the Save Paths To File dialog to save the path configuration as an MXP file.

3 Make the path configuration file available to other team members.

4 Each team member then opens the Configure User Paths dialog and uses Load or Merge to open the path configuration file. The new path configuration is now the same on each team member’s machine.

   NOTE Using Load eliminates the existing path configuration; using Merge overwrites only paths that exist in both the current configuration and the new one.

To share files with team members using relative paths:

1 Ensure the Convert local file paths to Relative preference is enabled.

2 As you work, all files are saved relative to your project folder.

3 Give your scene to another user.

4 The second user opens the scene on a machine with a different project folder and now 3ds Max searches for all files related to the scene file in the second user’s project folder.

   NOTE The Convert local file path to Relative preference is set when you create the file. For example, if I load a material into my scene with this preference on, this material is always treated as relative to the project folder.
Interface

The Configure User Paths dialog comprises three panels:

- **External Files** on page 8289
- **File I/O** on page 8287
- **XRefs** on page 8292

In addition, the dialog provides command buttons on the right side and across the bottom:

**Project Folder** Lets you set the project folder on page 7583.

**Modify** Lets you change the highlighted path.

**Make Relative** Lets you change an absolute or complete file path into a path relative to the project folder on page 7583.

**NOTE** For relative paths within the project folder, a leading “." represents the project folder path. On the other hand, one or more instances of “.\" preceding the path indicates that the path is in a sibling folder to the project folder, as opposed to a subfolder. For example, if your project folder is `c:\MyProject\Project1` and the asset location is `c:\Resources\myresource.jpg`, then the relative path from the project folder to the resource is `..\Resources\myresource.jpg`. If the asset was in `c:\MyProject\Resources\myresource.jpg`, then the relative path would be `..\Resources\myresource.jpg`. 

---

8286 | Chapter 24  Customizing the User Interface
**Make Absolute** Lets you make the path absolute, where a relative path is currently being used. For example, if ".\" represents your project folder in the path name, then when you make the path absolute the full name is used instead.

**Move Up/Down** Lets you change the position of the highlighted path in the list to alter its search priority. Available only on the External Files and XRefs panels.

**Save as** Lets you save the path configuration as an MXP file for sharing with team members.

**Load** Loads a path configuration from an MXP file. The loaded configuration completely replaces the existing one.

**Merge** Merges a path configuration from an MXP file. The merged configuration adds paths that exist only in the new file and replaces any existing paths.

For example, if your File I/O panel > Scenes path is set to \scenes (relative path) and you merge a path configuration file in which the Scenes path is set to the UNC path \scene_server\max\scenes, the former path is replaced by the latter one.

**OK** Exits the dialog and saves any changes.

**Cancel** Exits the dialog without saving changes.

---

**File I/O Path Configuration**

Customize menu > Configure User Paths > Configure User Paths dialog > File I/O panel

The File I/O panel of the Configure User Paths dialog contains most of the file directories in which users store files.

For descriptions of the general dialog controls, see Configure User Paths on page 8284.

**NOTE** By default these paths are relative to the project folder on page 7583.
Procedures

To modify a file path:

1. On the Configure User Paths dialog, click File I/O, and then choose a path entry.
2. Click Modify.
3. In the Choose Directory dialog, do one of the following:
   - Enter a path in the Path field.
   - Navigate to locate a path.
4. Optional step: Enter a description of the path in the Label field. This description later appears in the path list.
5. Click Use Path.
   The new path takes effect immediately.

Interface
Animations Path for animation files, including XAF, XMM, BIP, FIG, MFE, and so on.

Archives Path for archive files.

AutoBackup Sets the default path for automatic backup files. If you use the Auto Backup feature on page 8305, use either the \autoback directory, which is specific to each running version of 3ds Max, or a directory not shared by any other machine.

BitmapProxies Path for proxy bitmaps. See Global Settings and Defaults for Bitmap Proxies Dialog on page 7601.

Downloads Path for i-drop on page 7644 files.

Export Path for exported files.

Expressions Path for text files used by expression controllers.

Images Path for image files.

Import Path for imported files.

Materials Path for material library (MAT) files.

MaxStart Path for maxstart.max, which provides initial 3ds Max scene settings.

Photometric Path for photometric files, which define various characteristics of Photometric lights on page 5348

Previews Path for preview renders.

RenderAssets Path for mental ray and other rendering asset files, including shadow maps, photon maps, final gather maps, MI files, and render passes.

RenderOutput Path for rendered output.

RenderPresets Path for Render Preset files.

Scenes Path for MAX scene files.

Sounds Loads sound files.

VideoPost Loads and saves Video Post queues.

---

**External Path Configuration**

Customize menu > Configure User Paths > Configure User Paths dialog > External Files panel
On the External Files panel of the Configure Paths dialog, you can add or modify path directories for bitmaps on page 8523, DirectX effects (FX) files, on page 8589, and downloads; that is, files transferred from the Internet with i-drop on page 7644. Bitmaps are used for background images and mapped materials on page 8631 (textures, bump maps, displacement maps, and so on). FX files are used by the DirectX Shader material on page 6175.

**NOTE** By default the paths for \Maps\fx, \Maps, and the root folder are all relative to the root directory of 3ds Max whereas the \downloads folder is relative to the project folder by default.

3ds Max stores the path of any file you load. When the file is reloaded, the search order is as follows:

1. The path saved with the file.
2. The directory of the current scene.
3. The paths listed in the External Files panel, starting at the top of the list.

**NOTE** To save loading time, if a map with the same name exists in two different locations (paths), 3ds Max loads it only once. This can cause a problem only if your scene includes two different maps with the same name. In this case, only the first map encountered will appear in the scene.

4. Every subdirectory under the directory of the current scene.
For descriptions of the general dialog controls, see Configure User Paths on page 8284.

Procedures

To modify a file path:

1. On the External Files panel, choose a path entry.
2. Click Modify.
3. In the Choose Directory dialog, do one of the following:
   - Enter a path in the Path field.
   - Navigate to locate a path.
4. Click Use Path.
   The new path takes effect immediately.

To add a path for a file:

1. On the External Files panel, click Add.
2. On the Choose New Bitmap Path dialog, do one of the following:
   - Enter a path in the Path field.
   - Navigate to locate a path.
3. If you want to include subdirectories in this path, turn on Add Subpaths.
4. Click Use Path.
   The new path takes effect immediately.

To delete a path for a file:

1. On the External Files panel, choose a path entry.
2. Click Delete.
   The path location is removed.
3. Click Cancel to restore the path.
   This closes the Configure Path dialog without saving any path changes.
To move a path up or down in the list:

1. On the External Files panel, choose a path entry.
2. Do one of the following:
   - Click Move Up to move the entry closer to the top of the list, giving it a higher priority in the search process.
   - Click Move Down to move the entry closer to the bottom of the list, giving it a lower priority in the search process.

**XRefs Path Configuration**

Customize menu > Configure User Paths > Configure User Paths dialog > XRefs panel

On the XRefs panel of the Configure User Paths dialog, you can modify, delete, or add to the directory locations 3ds Max searches for XRef objects and XRef scenes. You can also use either relative or absolute paths.

You expand the default locations of external reference files by adding paths to this panel. Use this technique to identify the directories most often used in your scenes.

3ds Max stores the path of any external reference file you load. When the external reference file is reloaded, the search order is as follows:

1. The path saved with the external reference file.
2. The directory of the current scene.
3. The paths listed in the Configure User Paths dialog > XRefs panel, starting at the top of the list.

**NOTE** By default, this path is relative to the project folder.

For descriptions of the general dialog controls, see Configure User Paths on page 8284.

**Procedures**

To modify an external reference file path:

1. On the XRefs panel, choose a path entry.
2 Click Modify.
3 On the Choose Directory dialog, do one of the following:
   ■ Enter a path in the Path field.
   ■ Navigate to locate a path, and click Use Path.

To add an XRef path:
1 On the XRefs panel, click Add.
2 On the Choose New XRef Path dialog, do one of the following:
   ■ Enter a path in the Path field.
   ■ Navigate to locate a path.
3 Click Use Path.
   The new path takes effect immediately.

To delete an external reference file path:
1 On the XRefs panel, choose a path entry.
2 Click Delete.
   The path location is removed.
3 Click Cancel to restore the path.
   This closes the Configure User Paths dialog without saving any path changes.

To move a path up or down in the list:
1 On the XRefs panel, choose a path entry.
2 Do one of the following:
   ■ Click Move Up to move the entry closer to the top of the list.
   ■ Click Move Down to move the entry closer to the bottom of the list.

Configure System Paths

Customize menu > Configure System Paths
3ds Max uses paths to locate different kinds of files, including defaults, fonts, and startup MAXScript files. You use the Configure System Paths command to open the Configure System Paths dialog and customize these paths.

3ds Max saves the paths that the Configure System Paths command manages in the *3dsmax.ini* file.

**See also:**
- [Configure User Paths on page 8284](#)

**Interface**

The Configure System Paths dialog comprises two panels:
- [System Paths on page 8294](#)
- [3rd Party Plug-ins on page 8296](#)

**System Paths**

Customize menu > Configure System Paths > Configure System Paths dialog > System panel

This dialog is especially useful if you are programming your own scripts for 3ds Max.
When you start 3ds Max, it checks these folders and runs or otherwise uses the corresponding files:

<table>
<thead>
<tr>
<th>File Type</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional Icons</td>
<td>Path for additional icons</td>
</tr>
<tr>
<td>Additional Macros</td>
<td>Path for additional macros</td>
</tr>
<tr>
<td>Additional Scripts</td>
<td>Path for additional scripts</td>
</tr>
<tr>
<td>Additional Startup Scripts</td>
<td>Path for additional startup scripts</td>
</tr>
<tr>
<td>Page File</td>
<td>Path for automatic bitmap paging</td>
</tr>
<tr>
<td>Temp</td>
<td>Path for temporary files</td>
</tr>
</tbody>
</table>

**TIP** The Path File entry defaults to the \autobackup subfolder of the 3ds Max program folder. However, if you plan to do large renderings, it is a good idea to reassign this path to a dedicated, high-performance drive that can serve as a scratch disk for bitmap caching.

**Procedures**

**To modify a path:**

1. Click a path entry to highlight it.
2. Click Modify.
3. Use the Choose Directory dialog to do one of the following:
   - Enter a path in the Path field.
   - Navigate to locate a path.
4. Click Use Path.
   The new path takes effect immediately.
3rd Party Plug-Ins Path Configuration

Customize menu > Configure System Paths > Configure System Paths dialog > 3rd Party Plug-Ins panel

On the 3rd Party Plug-Ins panel of the Configure System Paths dialog, you can add or modify the directory paths of plug-ins on page 8687 supplied by third parties and independent software developers. You can also store plug-ins in separate directories and use this panel to add the paths of those directories. Changing the list order specifies the search order. Put the most frequently used plug-ins at the top.

Path information is stored in the plugin.ini file.

**NOTE** To change the path for standard plug-ins included with 3ds Max, use the Configure System Paths on page 8293 function.

For descriptions of the general dialog controls, see Configure User Paths on page 8284.

**Procedures**

**To modify a plug-in path:**

1. On the 3rd Party Plug-Ins panel, choose a path entry.
2. Click Modify.
3. On the Choose Directory dialog, do one of the following:
   - Enter a path in the Path field.
   - Navigate to locate a path.
4. Click Use Path.
   - The new path takes effect immediately.

**To add a plug-in path:**

1. On the 3rd Party Plug-Ins panel, click Add.
2. On the Choose Directory dialog, do one of the following:
   - Enter a path in the Path field.
   - Navigate to locate a path.
3 Type a description in the Label field.
4 If you want to include subdirectories in this path, turn on Add Subpaths.
5 Click Use Path.
   The new path takes effect immediately.

To delete a path:
1 On the 3rd Party Plug-Ins panel, choose a path entry.
2 Click Delete.
   The path location is removed.

Network Plug-In Configuration

You can include paths to additional INI files within the local plugin.ini file; 3ds Max processes these files as if they were part of the original plugin.ini. This capability is helpful in settings where several systems on a network are using the same plug-ins. The network administrator maintains only a single remote INI file, rather than having to update each machine individually.

Procedures

Example: To add remote INI files to your local plugin.ini:

1 Open your local copy of plugin.ini with your preferred text editor.
2 At the bottom of the file, type [Include] and press Enter.
3 After [Include], type these two lines:
   myremote=\remote_dir\remote_plugin.ini
   anotherdir=d:\test\extra_plugin.ini
NOTE You can give any title to the directory (in this case, *myremote* or *anotherdir*) and the directory can be any local or remote directory. In addition, the INI file can have any name.

4. Save `plugin.ini` and exit the text editor.

The next time you start 3ds Max, it will load plug-ins from the directories defined in `plugin.ini`, as well as plug-ins in any remote INI file specified in `plugin.ini`.

You can add as many remote INI files as you need, making it easy to organize groups of plug-ins.

## Preferences

**Application menu** on page 7989 > Options button

Customize menu > Preferences

3ds Max offers many options for its display and operation. These options are available on the Preference Settings dialog in a series of tabbed panels.
General Preferences

Customize menu > Preferences > Preferences dialog > General tab

On the General panel of the Preference Settings dialog, you set options for the user interface and for interactivity.

*Interface* on page 8300

**Procedures**

**To set and toggle spinner snap:**

1. Do one of the following:
   - Choose Customize menu > Preferences > Preference Settings dialog > General tab.
   - Right-click the Spinner Snap button on the main toolbar.

Either method brings up the General tab. The two controls for spinner snap are in the Spinners area of this panel.
2 Enter a value in the Spinner Snap field.
3 Turn on Use Spinner Snap.
   When you exit the dialog, Spinner Snap is on.
4 As you work, use the Spinner Snap button to toggle the use of this setting.

To set the Undo level:
1 Choose Customize menu > Preferences > Preference Settings dialog >
   General panel.
2 Change the value of Scene Undo Levels.
   The higher the value of Undo Levels, the more system resources are
   required. The default value is 20.

Interface
**Scene Undo group**

**Levels** Sets the number of operations you can undo.

**Reference Coordinate System group**

**Constant** Sets one coordinate system and transform center for Move, Rotate, and Scale on the Main toolbar. The coordinate system displayed in the coordinate dropdown list on page 922, and the transform center selected from the Use Center flyout on page 930, are used for all transforms. Normally, each transform switches to the coordinate system and transform center used the last time the transform was active.

**UI Display group**

**Enable Viewport Tooltips** When on, and not at a sub-object level, this function displays a tooltip when the cursor pauses over a non-selected object in the viewport.

**AutoPlay Preview File** Starts the Media Player automatically at the end of a Make Preview on page 6894.

**Display Cross Hair Cursor** Displays the mouse cursor as full-viewport cross hairs, vertical and horizontal lines extending the full extent of the active viewport.

Each movement of the mouse is redrawn, so the cross hairs are relatively slow. If you want to create a keyboard shortcut, find Cross Hair Cursor toggle in Customize menu > Customize User Interface > Keyboard panel and specify the keys to use for the shortcut. To change the color of the cross-hairs cursor, go to Customize menu > Customize User Interface > Colors panel > Viewports > Cross Hair Cursor and use the color selector to change the cursor color.

**Display Topology Dependence Warning** Toggles the topology dependence warning. This warning appears when you choose to edit a modifier or the base object at the bottom of the modifier stack of an object with modifiers and sub-object selections. The warning occurs because this action can affect the object topology adversely. You can also turn off the warning on the warning dialog. Default=on.

**Display Stack Collapse Warning** Toggles the stack collapse warning, which appears if you choose to collapse the modifier stack. You can also turn off the warning on the warning dialog. Default=on.
Save UI Configuration on Exit Restores panels and toolbars to the positions they were in the last time you used 3ds Max. Turn off this switch to restore panels to the state they were in before turning on this option.

Use Large Toolbar Buttons Toggles between large and small toolbar buttons.

Horizontal Text in Vertical Toolbar Ensures that text buttons are displayed horizontally. If you create a vertical custom toolbar that uses text rather than image buttons, you can use this option to display either horizontal or vertical text.

Fixed Width Text Button Specifies the maximum width of text buttons. To use this feature, turn on the Horizontal Text In Vertical Toolbar switch, turn on this option, and then set a maximum display size for the text button in pixels. For custom vertical toolbars with text buttons, this option limits the size of the text display.

Flyout Time Sets the pause, in milliseconds, between the mouse click and the flyout popping up from the button. Increase this setting only if you need an extra-long delay. Don't decrease the setting much or you might not be able to execute button commands before the flyout takes over.

Color Selector Choose the default color selector on page 371, or a third-party plug-in color selector in the list. The color selector you choose here is used throughout 3ds Max whenever you specify a color.

Plug-In Loading group

Load Plug-Ins When Used When on, loads plug-ins on demand, as they are needed.

Sub-Materials group

Assign Automatically Enables the automatic creation of a Multi/Sub-Object material when you assign a material to a selection of face sub-objects in an editable object. Default=on.

When on, the assigned material becomes part of the new Multi/Sub-Object material, and is assigned to the face selection. When off, the assigned material is assigned to the entire object.

NOTE If the face selection comprises faces with different material IDs, assigning a material to the selection with Assign Automatically enabled results in 3ds Max assigning the first unused material ID to all selected faces, thus changing their IDs.

See also Drag and Drop Sub-Object Material Assignment on page 5659.
Scene Selection group

Auto Window/Crossing by Direction When on, the direction that you drag a selection area determines whether it is a window or crossing selection on page 237. This works for any selection area (rectangle, circle, fence, or lasso). You can select which direction causes a window selection and which causes a crossing selection in the Scene Selection group. When you drag a window selection, the selection region is displayed with a solid line; when you drag a crossing selection, the selection region is displayed with dashed lines.

Right-> Left => Crossing When you drag a selection region from right to left, it is a crossing selection. Conversely, when you drag left to right, it is a window selection.

Left-> Right => Crossing When you drag a selection region from left to right, it is a crossing selection. Conversely, when you drag right to left, it is a window selection.

Paint Selection Brush Size Sets the size of the brush used by Paint Selection Region on page 234.

Spinners group

Precision Sets the number of decimal places displayed in a spinner edit field. Range=0 - 10 (where 0 is no decimal places).

Snap Sets the click increment and decrement values for all of the spinners in 3ds Max.

Use Snap Toggles spinner snap on and off.

Wrap Cursor Near Spinner Limits cursor wrapping to an area close to the spinner when you drag to adjust spinner value.

Command Panel group

Rollout Threshold The number of pixels in a rollout that should be scrollable in the command panel before the rollout is shifted into a separate command panel column.

This option is applicable only when the command panel displays multiple columns.
Layer Defaults group

Default to By Layer for New Nodes When on, 3ds Max sets rendering, motion blur, display, and advanced lighting properties for all new objects to By Layer on page 8530.

New Lights Renderable By Layer When on and you create a light, 3ds Max gets its Object Properties on page 283 > Renderable setting from the properties of the active layer.

Propagate Unhide/Unfreeze Commands to Layers? When you unhide or unfreeze an object on a hidden or frozen layer, this choice determines whether the command affects the object or its layer.

- Propagate Unhiding or unfreezing an object in a layer unhides or unfreezes the layer.
- Do Not Propagate Unhiding or unfreezing an object in a hidden or frozen layer affects only the object.
- Ask When this option is active and you unhide or unfreeze objects, a dialog appears asking if you want to apply the operation to the associated layers. If you do, the associated layers are unhidden or unfrozen. Otherwise the operation is applied only to the specified objects.

Vertex Normal Style group

Use Legacy R4 Vertex Normals By default, 3ds Max uses a new, more accurate method for computing vertex normals from smoothing groups, which improves the way geometry displays in viewports and in rendered output. To use the method from older versions of 3ds Max, for compatibility, turn on this check box.

Texture Coordinates group

Use Real-World Texture Coordinates Controls whether real-world texture coordinates are active or if the legacy method of applying texture coordinates is in use. When off, texture-coordinate behavior reverts to the legacy method and texture tile values have a default value of 1, and Real-World Map Size for primitives is off. Default=off.

When Use Real-World Texture Coordinates is on, the Use Real-World Scale on page 6208 (for 2D maps) and Real-World Map Size options are also on. Real-World Map Size is available for objects such as primitives and modifiers such as UVW Map.
File Preferences

Customize menu > Preferences > Preference Settings dialog > Files tab

On the Files panel of the Preference Settings dialog, you set options relating to file handling. You can choose the program used for archiving and control the options for log file maintenance. And the Auto Backup function lets you save your work automatically at defined intervals.

Interface

File Handling group

Convert file paths to UNC When on, paths shown in the user interface for any files present on a mapped drive use Universal Naming Convention (UNC) format on page 8753. When off, each path starts with the mapped drive letter (for example, w:\).
This check box is linked to the Convert file paths to UNC on page 8305 switch on the Asset Tracking dialog > Paths menu. Toggling either one toggles both.

**NOTE** This switch affects only newly added paths. Toggling it has no effect on existing paths. For example, if you load an image file into a Bitmap map on page 6213 from a mapped drive with the switch on, turning it off does not change the file path to the mapped version.

**Convert local paths to Relative** Converts the file paths of all newly added assets in a scene so that they are relative to the project folder on page 7583. Default=off.

**NOTE** This is a system setting and is not saved with the scene file.

**Backup on Save** Creates a backup file if a file of the same name already exists. The existing file is renamed `maxback.bak` and placed in the `autoback` directory before the save occurs. You can edit the automatic backup settings in the Auto Backup group on page 8307. Default=on.

**Increment on Save** Creates a new copy of the file in the same directory whenever you save the file. The name of the new file is incremented by 1 (filename01.max, filename02.max, and so on). Default=off.

**Compress on Save** Saves the 3ds Max file in a compressed format. Depending on the details of the file, the compressed file can be as small as one-fifth the size of its uncompressed equivalent. Default=off.

You can determine whether a 3ds Max file is compressed or not by bringing up Properties for the file in Windows Explorer. On the Contents panel, under General, you'll see whether the file is compressed or uncompressed.

**Save Viewport Thumbnail Image** Saves a 64-pixel thumbnail of the active viewport when you save each MAX file. The Asset Browser reads thumbnails. Saving thumbnails adds about 9K to each MAX file. Default=on.

**Save Schematic View** When on, the active schematic view is saved with the MAX file. Default=on.

**Save File Properties** When on, any data entered in the File Properties dialog on page 7609 is saved with the scene file and can be accessed with Windows Explorer and File Finder on page 7634. When off, the file properties information is not stored with the file. Default=on.

**Display Obsolete File Message** Turns off the "Obsolete data format found - Please resave file" alert that is displayed when you load a MAX file created in an earlier version of 3ds Max. Default=on.
There is a matching "Do not display this message" check box in the alert itself, and you can also turn off the alert from there.

**Reload textures on change** When on, reloads bitmapped textures if the date of the bitmap file has been updated. Default=on.

**Recent Files in File Menu** Sets the maximum number of recently edited MAX files to display in the list File > Open Recent. Range=0 to 50. Default=10.

**Auto Backup group**

Auto Backup saves your work periodically. In the event of a power failure, if you have not saved your work, you can load in an auto backup (autoback) file from the autoback subdirectory in 3ds Max directory (or under \My Documents\3dsmax\) and continue working with little lost work.

Auto Backup creates auto backup files based on a time interval. The name of an auto backup file is **AutoBackupN.max**, where **AutoBackup** is the main part of the name (**AutoBackup** is the default), and **N** is an integer from 1 to 99.

For example, if you've set Auto Backup to create three auto backup files at one-minute intervals, Auto Backup will create **AutoBackup1.max**, and then a minute later **AutoBackup2.max**, and then **AutoBackup3.max**. At the fourth minute, the system overwrites **AutoBackup1.max**, and so on.

**Enable** Toggles Auto Backup.

**Number of Autobak Files** The number of backup files to write before overwriting the first one. Range=1 to 99. Default=3.

**Backup Interval (minutes)** The number of minutes between backup file generation. Default=5.0.

**NOTE** This interval takes effect only when the scene changes; for example, if you move an object or apply a modifier. If nothing changes, for example, if you leave your computer for a while, then no backups are created. Also, if you save the scene file manually, Auto Backup resets the Backup Interval timer.

**Auto Backup File Name** Lets you enter an alternative name for the auto backup file. Auto backup files with a different name still have the filename extension .max. Default=AutoBackup.

**Log File Maintenance group**

The following controls affect the max.log file.
Never Delete Log Determines how long the log file is maintained. When you choose Never Delete, the max.log file remains on the hard disk and continues to grow.

Maintain Only...Days Resets the file to zero bytes after it reaches the number of days specified in this field.

Maintain Only...Kbytes Resets the file to zero bytes after it reaches the number of kilobytes specified in this field.

Errors Writes fatal errors to the max.log file instead of generating Alert dialogs. Alerts halt network rendering for one or more servers.

Warnings Writes warning messages to the max.log file instead of generating Alert dialogs.

Info Writes general information to the max.log file instead of generating Alert dialogs.

Debug Writes debug messages to the max.log file instead of generating Alert dialogs.

The type of errors covered by these four categories include maps that can't be found, missing UV coordinates, missing output directories, full disks, missing DLLs, disks to which you don't have access, invalid meshes, and obsolete MAX files.

Import Options group

Zoom Extents on Import Automatically zooms all viewports to scene extents after importing a file.

Archive System group

Program Specifies the name and location of the program to use for archiving. The archive program must be independently installed on your system. You can add command-line arguments to follow the executable file name. For example, for the PKZIP program, the arguments might be:

project1.zip c:proj0?.max -o

Viewport Preferences

Customize menu > Preferences > Preference Settings dialog > Viewports tab
On the Viewports panel of the Preference Settings dialog, you set options for viewport display and behavior.

You can also set the current Display Driver.

See also:
- **Strokes** on page 8405
- **Graphics Driver Setup Dialog** on page 8313
- **Configure Driver** on page 8317

**Interface**

![Preference Settings dialog](image_url)
**Viewport Parameters group**

**Use Dual Planes** Uses the front/back plane system when redrawing the viewport. The selected object is manipulated in the front plane and is redrawn, while other objects remain on the back plane and are not redrawn. This default setting provides the fastest redraws under normal circumstances. If your assigned display driver doesn't support dual planes, this option is not available. Turn off this setting to improve redraw speed if you are rotating the whole scene or moving a camera through the scene (usually situations in which the whole viewport needs to be redrawn anyway).

**Show Vertices As Dots** When on, 3ds Max displays vertices in mesh and patch objects as small, solid-color squares, whose size you can set with the Size parameter. When off, the vertex display is a tick mark.

**Size** Lets you specify the vertex size displayed in the viewports. Range=2 to 7. Default=2.

**Handle Size** Lets you specify the display size for handles attached to patch vertices and spline vertices. Range=2 to 7. Default=3.

**Draw Links as Lines** Displays the hierarchical links on page 8599 between parent and child objects as plain lines, rather than shapes when Display panel > Link Display rollout > Display Link is on.

**Backface Cull on Object Creation** Determines whether to display faces with normals on page 8654 pointing away from view. When on, you see through the wireframe to the backfaces. This option applies to wireframe viewport displays only. In most cases, keep this switch enabled. However, when modeling with NURBS surfaces, which consist of single-sided planes, it's easier to view the geometry from all angles when backface culling is off.

- This control affects only the created objects, and you can reverse the effect on each object by changing the Backface Cull setting in the Object Properties dialog for that object. You might turn off Backface Cull On Object Creation before creating your NURBS, and then turn it on again when your finished.

- You can globally change the display of backface culling in the viewports by turning on Force 2-Sided on page 8374 on the Rendering Method panel of the Viewport Configuration dialog.

**Attenuate Lights** Turns the display of attenuation effects on page 8513 on or off from start to end in the interactive viewport renderer. When off, attenuated lights behave as though unattenuated. Default=off.
**Mask Viewport to Safe Region** By default, the viewport area outside the outermost safe frame displays the contents of the viewport. When this switch is on, that area is left blank.

**Update Background While Playing** Turns on the updating of bitmaps in the viewport background when you play an animation. This capability lets you check your action against a 2D rotoscoped on page 8702 background, even if your animation plays at 1 frame per second. When on, an IFL file on page 7841, AVI file on page 7832, or MOV file on page 7849 updates on each frame when you click the Play button. To use this feature, turn off the real-time on page 8697 switch on the Time Configuration dialog on page 8106.

The viewport updates not only when you click Play, but also when you drag the time slider.

**Filter Environment Backgrounds** Affects the background displayed in the viewport only when the Viewport Background dialog > Use Environment Background switch on page 135 is on.

When you turn on Filter Environment Backgrounds, the environment background is filtered in the viewport, resulting in an antialiased image. When you turn it off, the background image is not filtered, resulting in an aliased, pixelated image.

Note the following:

- Filtering slows down the recalculation of the viewport background image about 30 to 40 percent. Unless you really need that smooth display, it's best to leave the option off.

- This option doesn't affect the rendered background image, and doesn't effect the viewport backgrounds when you turn on Use Environment Background.

**Low Res Environment Background** Reduces the size of the environment background map by half, and then magnifies it to the size needed for the viewport. This results in a chunkier, pixelated appearance, but speeds the rendering in the viewport by four times (because it halves the width and the height of the original image).

**TIP** Unless you need fine detail in your environment background, keep this switch enabled.

**Display World Axis** When on, displays a world axis in the lower-left corner of all viewports. Default=on.
Grid Nudge Distance  Sets the nudge distance for the Nudge Grid Down and Nudge Grid Up functions, which you can use to move an active grid helper object into position. See To nudge a grid object up or down: on page 2851.

Non Scaling Object Size  Sets the display size of cameras, lights, and other nonscaling objects. Default=1.

Display Drivers group

Currently Installed Driver  Displays the name of the currently installed driver.

Choose Driver  Displays the Display Driver Setup dialog on page 8313. Use this dialog to select a different software display driver, or to switch drivers if you installed a hardware accelerator card.

Configure Driver  Displays the Configure Driver dialog on page 8317, where you can change the driver options for your currently selected driver.

Ghosting group

Ghosting Frames  Specifies the number of ghost images that appear before and after the current frame when you choose Show Ghosting from the Views menu. If you display ghosts both before and after the current frame, the total number of ghosts is twice this number.

Display Nth Frame  Specifies the number of frames between the appearance of each ghost. The smaller this number, the closer the ghost images appear to each other.

Ghost Before Current Frame  Displays only ghost images that occur before the current frame. This makes the ghosts trail the object.

Ghost After Current Frame  Displays only ghost images that occur after the current frame.

Ghost Before and After  Displays ghosts both before and after the current frame.

Ghost in Wireframe  Displays ghosts in black wireframe in shaded viewports. When off, the ghosts appear as shaded objects, using the same colors as the wireframe ghosts.

Show Frame Numbers  Displays a frame number in the upper-left corner of each frame.
Mouse Control group

Middle Button Pan/Zoom Sets the middle mouse button to pan in the viewport if you have a three-button mouse. If you have a Microsoft Intellimouse, you can also roll the middle wheel to zoom the viewport. To Zoom with a three button mouse, press Ctrl+Alt and drag the center button.

NOTE By default, the Intellimouse slows the speed of the mouse when you hold down the wheel button. You can increase the mouse speed in the Mouse Properties dialog in the Windows Control Panel. Choose the Wheel tab, click the Settings button in the Wheel Button group, and turn the slider up to Fast.

Stroke Assigns command shortcuts to stroke patterns applied by dragging with the middle mouse button. See Strokes on page 8405.

Zoom About Mouse Point (Orthographic) When on, viewports zoom about the point where you click the mouse. When off, viewports zoom about the center of the view. Applies to orthographic viewports only.

Zoom About Mouse Point (Perspective) When on, viewports zoom about the point where you click the mouse. When off, viewports zoom about the center of the view. Applies to perspective viewports only.

Right Click Menu Over Selected Only Limits the right-click menu display over a selected object. Default=off. When this option is off, you can right-click anywhere in the viewports to display a menu.

Wheel Zoom Increment Determines the sensitivity of the zoom when you use the wheel on the mouse. Increase sensitivity up to a maximum value of 100 or reduce it to a minimum of 0.01. Default=1.0.

Graphics Driver Setup Dialog

Customize menu > Preferences > Preference Settings dialog > Viewports tab > Display Drivers group > Choose Driver button

(With Direct3D active) Customize menu > Preferences > Preference Settings dialog > Viewports tab > Display Drivers group > Choose Driver button > Direct3D Driver Setup dialog > Revert From Direct3D button

You choose and configure graphic display drivers on the Viewports panel of the Preference Settings dialog. This topic explains driver options available on the Display Driver Setup dialog and analyzes tradeoffs in performance.
You can also change the graphics driver when you start 3ds Max by going to the Start menu and choosing Programs > Autodesk > Autodesk 3ds Max 2010 [installed version] > Change Graphics Mode.

See also:
- Configure Driver on page 8317
- Configure Software Display Driver Dialog on page 8317
- Configure OpenGL Dialog on page 8319
- Configure Direct3D Dialog on page 8325
- Direct3D Driver Setup Dialog on page 8323

Custom

Choose this if you have a custom driver installed on your system. Such custom drivers don't use the software display driver (Heidi), OpenGL, or Direct3D. If you don't have such a driver installed, this option is not available.

Interface

![Graphics Driver Setup](image)

8314 | Chapter 24  Customizing the User Interface
On the Display Driver Setup dialog, some options are unavailable if the corresponding driver is not installed in the system. The currently installed driver is listed in the Display Driver group.

**NOTE** The first time you launch 3ds Max Direct3D is selected be default.

**Software Display Driver**

Choose this if you’re using software rather than hardware acceleration. This choice is always available.

**OpenGL**

Choose this option if you’re using any form of hardware acceleration. 3ds Max will use whatever driver has been installed in your operating system.

The OpenGL driver supports geometry acceleration as well as rasterization acceleration. It offers the optimum display performance for animated deforming meshes. It's tightly integrated into Windows NT and Windows 2000, and many 3D display cards were specifically designed to accelerate OpenGL operations. OpenGL implementations have all of the scene data necessary to optimize the entire 3D display process.

Because OpenGL is most efficient when run on systems with at least rasterization acceleration, the software display driver/SZB option might work best on systems with an ordinary 2D display card. However, with a 3D-enabled card, you may see dramatic acceleration using the OpenGL driver.

The disadvantages of the Open GL driver are as follows:

- All potentially visible scene data must be transferred to the driver, and this can cause a communication bottleneck across the system bus. In particular, this slows down the display of individual primitives (as opposed to strips or polylines, like wireframe displays).

- Because the OpenGL design supports a wide variety of display systems, there is no guarantee that either incremental scene update methods (partial window *blits* (Block Image Transfers) or dual planes) will work with a particular implementation of OpenGL.

- Because lighting and texturing are restricted to OpenGL-specified semantics, mismatches between 3ds Max scene lighting and texturing and what appears in an OpenGL viewport can occur. This applies especially to attenuated lights and non-tiled texture display.)
Direct 3D

Choose this if you have a Direct3D (D3D) driver installed on your system. If you don't have DirectX 8.1 or above installed, this option is unavailable.

To configure the Direct3D driver, click the Advanced Direct3D button. This button, which is available only when Direct3D is the active option, opens the Configure Direct3D dialog on page 8325.

To switch to a different display driver when Direct3D is the active driver, click the Choose Driver button on the Viewports tab of the Preference Settings dialog to open the Direct3D Driver Setup dialog on page 8323, click Revert From Direct3D, and then choose the new driver from the Graphics Driver Setup dialog.

The Microsoft Direct3D API supports both rasterization and 3D scene-level calls. It offers the optimum display performance for large modeling tasks, and pixel and vertex shading. (3ds Max supports only D3D Version 8 or above, which is included in DirectX 8.1.) D3D calls are accelerated if the display hardware supports this.

Many inexpensive 3D display cards can use this driver efficiently. This driver supports scene data culling efficiently, accelerates texture display (depending on the specific display card), and performs perspective correction.

The driver works with high-color displays, which provide a good trade-off between display quality and memory overhead. Incremental display update works efficiently.

The disadvantages of the Direct3D driver are as follows:

- The driver currently runs only under Windows 98, Windows Millennium, Windows 2000, and Windows XP. (There is no multi-processor Windows NT support.)
- Dual-plane operations are slow (if available), and there can be some additional overhead in minimizing/maximizing viewports due to the way D3D allocates video memory.

You can download D3D drivers from this location:
Configure Driver

Customize menu > Preferences > Preference Settings dialog > Viewports tab > Display Drivers group > Configure Driver button

You configure the current display driver using the Viewports panel of the Preference Settings dialog.

Changes to a driver's configuration take effect immediately, and the configuration persists between sessions. However, data downloaded to the graphics card is not regenerated. For example, if you change the texture resolution, the hardware continues to use the previous resolution until you use the Material Editor to reload the texture.

The options in the driver configuration dialog vary, depending on which driver is in use. This reference describes the options for the software display driver on page 8317, Direct3D driver on page 8325, and OpenGL driver on page 8319.

If you use a custom driver, the options depend on what the driver's manufacturer provides. See the manufacturer's documentation for further information.

See also:

- Graphics Driver Setup Dialog on page 8313
- Configure Software Display Driver Dialog on page 8317
- Configure OpenGL Dialog on page 8319
- Configure Direct3D Dialog on page 8325

Configure Software Display Driver Dialog

Customize menu > Preferences > Preference Settings dialog > Viewports tab > Display Drivers group > Configure Driver button (when Software Display Driver is the current driver)

The software display driver does not require hardware acceleration.

**WARNING** The software display driver does not support some 3ds Max features. In particular, the ViewCube and SteeringWheels don't display; viewports cannot display hardware maps, and they cannot preview shadows or ambient occlusion.
Interface

**Redraw Scene On Window Expose** Redraws the whole scene when a dialog over the viewports is moved, resulting in smoother dragging of dialogs such as the Material Editor or Track View.

If your 3ds Max display easily becomes messy or "corrupted," turn this option on and then redraw viewports by choosing Views > Redraw All Views (the default keyboard shortcut for this is the ` (accent grave) key, on the left side of the “1” key).

**Use Triangle Strips** Strips the geometry, which can more than double the display speed. In some cases, such as when topology is constantly changed, the time taken to strip the geometry can cause a slowdown instead. In such cases, turn off this option. Otherwise, leave it on for speed.

**Download Texture Size group**

*64, 128, 256, 512* These buttons specify the size of the bitmaps used to map surfaces in the viewports. The larger the size, the better the resolution but the slower the speed. High speed produces jagged maps and slower speeds produce smooth maps.
NOTE When Match Bitmap Size As Closely as Possible is on, these buttons are overridden, however they are still available. The value is still used when procedural textures are converted to bitmaps for viewport texture display.

**Match Bitmap Size as Closely as Possible** To allow the viewport to show actual texture resolutions, bitmaps are individually resized in the display. This means that small bitmaps don’t get overexpanded and large bitmaps retain their resolution (but potentially use a lot more video RAM).

NOTE Bitmaps can be no larger than 4000 x 4000 pixels (or they will be scaled down to this size) and no smaller than 32 x 32 (or they will be scaled up to this size). Default=off.

### Configure OpenGL Dialog

Customize menu > Preferences > Preference Settings dialog > Viewports tab > Display Drivers group > Configure Driver button (when OpenGL is the current driver)

The OpenGL display driver provides options that support hardware acceleration.

**WARNING** The OpenGL driver cannot preview shadows or ambient occlusion in viewports.
Interface

**Implementation-Specific Settings group**

**Redraw Scene On Window Expose** Redraws the whole scene when a dialog over the viewports is moved, resulting in smoother dragging of dialogs such
as the Material Editor or Track View. However, redrawing takes some time. Default=on.

If your 3ds Max display easily becomes messy or "corrupted," turn this option on and then redraw viewports by choosing Views > Redraw All Views (the default keyboard shortcut for this is the "1" key).

This option has two subordinate options. How you should set them depends on how the display card handles its back buffer, which is used for refreshing the screen. Turn on one or the other, as appropriate.

**Full Screen SwapBuffers Destroys Back Buffer** If, after updating the screen, the display card destroys the back buffer only when there's a single viewport, turn on this sub-option. The OpenGL driver redraws the scene when a single viewport is visible, but doesn't have to redraw when multiple viewports are visible. Default=off.

**Windowed SwapBuffers Destroys Back Buffer** If, after updating the screen, the display card destroys the back buffer when multiple viewports are visible, turn on this sub-option. Default=off.

**Use Triangle Strips** Strips all geometric data before sending it to the driver. In some cases, such as when topology is constantly changed, the time taken to strip the geometry can cause a slowdown instead. In such cases, turn off this option. Otherwise, leave it on for speed. Default=on.

This option has one subordinate option:

**Display Wireframe Objects Using Triangle Strips** Default=off.

**Allow Dual Plane Support** Uses the front/back plane system when redrawing the viewport. The selected object is manipulated in the front plane and is redrawn, while other objects remain on the back plane and are not redrawn. This default setting provides the fastest redraws under normal circumstances. If your assigned display driver doesn't support dual planes, this option is not available.

Turn off this setting to improve redraw speed if you are rotating the whole scene or moving a camera through the scene (usually situations in which the whole viewport needs to be redrawn anyway).

**Use Incremental Scene Updates** Redraws only those scene objects that have changed, or that intersect a region changed by another moving object. When off, the entire scene is redrawn for each new frame. Default=on.

If the display becomes messy or "corrupted" as a result of incremental updates, turn this option off and then redraw viewports by choosing Views > Redraw All Views (the default keyboard shortcut for this is the ` [accent grave] key).
Use BGRA Pixel Format When on, sends bitmaps using BGRA (blue-green-red-alpha) ordering for pixels. This is the default order for Windows. By default, OpenGL expects RGBA ordering. Because of this, under default conditions, loading textures or backgrounds requires the pixels to be reordered. OpenGL supports an extension that allows it to receive pixels in BGRA order. This means that bitmaps can be displayed directly, without reordering each pixel. Thus, assuming the OpenGL driver has efficient hardware support for BGRA pixels, turning on this option makes loading textures and background images much faster. Default=on.

Use Generalized Vertex Arrays When on, enables 3ds Max to use custom driver code to render smoothly shaded objects. Typically this is much faster than using standard OpenGL code, but has an effect only when the driver has hardware-specific custom code. Default=on.

Use Wireframe Faces When on, makes wireframe display accessible to hardware acceleration. Default=on.

This option is intended to allow display-card manufacturers to accelerate 3ds Max wireframe displays in a way that is specific to the underlying display hardware. Check with your display-card manufacturer to see if enabling this option will yield faster wireframe rendering with your display card.

Appearance Preferences group

Enable Anti-Aliased Lines in Wireframe Views Draws lines slightly thicker and much smoother. This is best used for wireframe-only views, and especially if you're making a preview of wireframe objects.

Background Texture Size Unlike the Software Display driver, which uses bitmaps to display viewport backgrounds directly, the OpenGL driver uses a texture-mapped background rectangle. This allows for smoother zooms and pans in orthographic views and can take less memory than the direct bitmap method. However, background bitmap resolution may be lost. Increase the resolution if you're using a maximized viewport to digitize.

Download Texture Size Lets you choose the size of the texture map that's downloaded to the driver for texture-mapped scene objects. Larger maps look better, but use more display card memory.

NOTE When Match Bitmap Size As Closely as Possible is on, these buttons are overridden, however they are still available. The value is still used when procedural textures are converted to bitmaps for viewport texture display.

Match Bitmap Size as Closely as Possible To allow the viewport to show actual texture resolutions, bitmaps are individually resized before they are
downloaded to the driver. This means that small bitmaps don’t get overexpanded and large bitmaps retain their resolution (but potentially use a lot more video RAM).

**NOTE** Bitmaps can be no larger than 4000 x 4000 pixels (or they will be scaled down to this size) and no smaller than 32 x 32 (or they will be scaled up to this size). Default=off.

**Texel Lookup** Specifies whether to use the nearest pixel on page 8687 or to linearly interpolate the pixel value from the four closest texels on page 8741. Using the nearest pixel is faster, but using texels produces a higher-quality display. Default=Nearest.

**MipMap Lookup** Specifies whether to use one version of the texture map (None) or to interpolate between a pyramid of progressively smaller maps. With Nearest chosen, the texel lookup is done on the map level nearest the ideal one, and with Linear, the texel values from the two closest map levels are interpolated. Default=None.

**NOTE** When both Texel and MipMap lookup are set to Linear, a true trilinear weighting of 8 texel values is used for a single pixel display. This is very accurate and helps eliminate aliasing, but it is time consuming if the texture-mapping hardware is not accelerated.

**Direct3D Driver Setup Dialog**

Customize menu > Preferences > Preference Settings dialog > Viewports tab > Display Drivers group > Choose Driver button (if Direct3D is the active driver)

Customize menu > Preferences > Preference Settings dialog > Viewports tab > Display Drivers group > Choose Driver button > Graphics Driver Setup dialog > Choose Direct3D. > Advanced Direct3D button

When using the Direct3D display driver with 3ds Max, this dialog lets you make some basic choices for setting up the driver. Further Direct3D configuration options are available from the Configure Direct3D dialog on page 8325.

To switch to a different display driver when Direct3D is the active driver, click the Choose Driver button on the Viewports tab of the Preference Settings dialog, click Revert From Direct3D, and then choose the new driver from the Graphics Driver Setup dialog.
Interface

Direct3D Version The available option is whichever version is currently active in your system.

Direct3D Device The default option is Hardware (HAL). The Software (RefRast) option is for use by software developers, and is unavailable unless the debug version of DirectX is installed in your system.

Direct3D Use Flags The default option is Release. The Debug option is for use by software developers, and is unavailable unless the debug version of DirectX is installed in your system.

Revert from Direct3D Click this button to display the Graphics Driver Setup dialog on page 8313, which lets you choose a different driver.
Configure Direct3D Dialog

Customize menu > Preferences > Preference Settings dialog > Viewports tab > Display Drivers group > Configure Driver button (when Direct3D is the current driver)

The Direct3D display driver provides options that support DirectX drivers.

You can download D3D drivers from this location: http://www.microsoft.com/windows/directx/.

DirectX 10 Version

When DirectX 10 is active on your system, the dialog uses a simpler, more straightforward interface:

[Diagram of Configure Direct3D dialog]

The parameters are identical to those with the same names listed previously in this topic, and one setting has been added:
Maximum number of active lights Lets you define the number of active lights used in the lighting calculations. Setting this too high can affect performance.
Interface

Configure Direct3D

Implementation-Specific Settings:

Geometry

- Display All Triangle Edges
- Use Cached D3D/XMeshes
- Use Wireframe Faces
- Use Triangle Strips
  - For Wireframe Objects

Window Updates:

- Redraw Scene On Window Expose
- Redraw In Maximized Viewport
- Redraw In UnMaximized Viewports
- Use Incremental Scene Updates

Appearance Preferences:

- Enable Antialiased Lines in Wireframe Views

Background Texture Size:

- 128
- 256
- 512
- 1024
- Match Bitmap Size as Closely as Possible

Download Texture Size:

- 64
- 128
- 256
- 512
- Match Bitmap Size as Closely as Possible

Texel Lookup:

- Nearest
- Linear
- Anisotropic

Mipmap Lookup:

- None
- Nearest
- Linear

OK  Cancel
Implementation-Specific Settings: Geometry group

Display All Triangle Edges When on, all triangle edges are displayed in shaded viewports. When off, triangle edges are not displayed. Default=on.

Turning off this option can improve viewport appearance, but at a cost of display performance.

Use Cached D3DXMeshes When on, enables 3ds Max to use custom driver code to render smoothly shaded objects. Typically this is much faster than using standard Direct3D code, but has an effect only when the driver has hardware-specific custom code. Default=on.

Use Wireframe Faces When on, makes wireframe display accessible to hardware acceleration. Default=on.

This option is intended to allow display-card manufacturers to accelerate 3ds Max wireframe displays in a way that is specific to the underlying display hardware. Check with your display-card manufacturer to see if enabling this option will yield faster wireframe rendering with your display card.

Use Triangle Strips Strips all geometric data out before sending it to the driver. In some cases, such as when topology is constantly changed, the time taken to strip the geometry can cause a slowdown instead. In such cases, turn off this option. Otherwise, leave it on for speed. Default=on.

This option has one subordinate option:

■ For Wireframe Objects When on, uses triangle strips for wireframe objects. Default=off.

Implementation-Specific Settings: Window Updates group

Redraw Scene On Window Expose Redraws the whole scene when a dialog over the viewports is moved, resulting in smoother dragging of dialogs such as the Material Editor or Track View. However, redrawing takes some time. Default=on.

If the display becomes messy or "corrupted," turn this option on and then redraw viewports by choosing Views > Redraw All Views (the default keyboard shortcut for this is 1 on the numeric keypad).

This option has two subordinate options. How you should set them depends on how the display card handles its back buffer, which is used for refreshing the screen. Turn on one or the other, as appropriate.

■ Redraw In Maximized Viewport If, after updating the screen, the display card destroys the back buffer only when there's a single viewport, turn on this sub-option. The Direct3D driver redraws the scene when a single
viewport is visible, but doesn't have to redraw when multiple viewports are visible. Default=off.

- **Redraw In UnMaximized Viewports** If, after updating the screen, the display card destroys the back buffer when multiple viewports are visible, turn on this sub-option. Default=off.

**Allow Dual Plane Support** Uses the front/back plane system when redrawing the viewport. The selected object is manipulated in the front plane and is redrawn, while other objects remain on the back plane and are not redrawn. This default setting provides the fastest redraws under normal circumstances. If your assigned display driver doesn't support dual planes, this option is not available.

Turn off this setting to improve redraw speed if you are rotating the whole scene or moving a camera through the scene (usually situations in which the whole viewport needs to be redrawn anyway).

**Use Incremental Scene Updates** Redraws only those scene objects that have changed, or that intersect a region changed by another moving object. When off, the entire scene is redrawn for each new frame. Default=on.

If the display becomes messy or "corrupted" as a result of incremental updates, turn this option off and then redraw viewports by choosing Views > Redraw All Views (the default keyboard shortcut for this is 1 on the numeric keypad).

**Appearance Preferences group**

**Enable Antialiased Lines in Wireframe Views** Draws lines slightly thicker and much smoother. This is best used for wireframe-only views, especially if you're making a preview of wireframe objects.

**Background Texture Size** Unlike the software display driver, which uses bitmaps to display viewport backgrounds directly, the Direct3D driver uses a texture-mapped background rectangle. This allows for smoother zooms and pans in orthographic views and can take less memory than the direct bitmap method. However, background bitmap resolution may be lost. Increase the resolution if you're using a maximized viewport to digitize.

**Match Bitmap Size as Closely as Possible** Displays background at full resolution. This allows the viewport to behave like the Rendered Frame Window on page 6513, in regards to zoom and pan. Default=off.

**Download Texture Size** Lets you choose the size of the texture map that's downloaded to the driver for texture-mapped scene objects. Larger maps look better, but use more display card memory.
NOTE  When Match Bitmap Size As Closely as Possible is on, these buttons are overridden, however they are still available. The value is still used when procedural textures are converted to bitmaps for viewport texture display.

**Match Bitmap Size as Closely as Possible** To allow the viewport to show actual texture resolutions, bitmaps are individually resized before they are downloaded to the driver. This means that small bitmaps don’t get overexpanded and large bitmaps retain their resolution (but potentially use a lot more video RAM).

NOTE  Bitmaps can be no larger than 4000 x 4000 pixels (or they will be scaled down to this size) and no smaller than 32 x 32 (or they will be scaled up to this size). Default=off.

**Texel Lookup** Specifies whether to use the nearest pixel on page 8687, to linearly interpolate the pixel value from the four closest texels on page 8741, or to use anisotropic filtering. Using the nearest pixel is faster, but using texels produces a higher-quality display. The Anisotropic filter compensates for the distortion caused by the difference in angle between the texture polygon and the plane of the screen. Default=Nearest.

**MipMap Lookup** Specifies whether to use one version of the texture map (None) or to interpolate between a pyramid of progressively smaller maps. With Nearest chosen, the texel lookup is done on the map level nearest the ideal one, and with Linear, the texel values from the two closest map levels are interpolated. Default=None.

NOTE  When both Texel and MipMap lookup are set to Linear, a true trilinear weighting of 8 texel values is used for a single pixel display. This is very accurate and helps eliminate aliasing, but it is time consuming if the texture-mapping hardware is not accelerated.

**Gamma and LUT Preferences**

Customize menu > Preferences > Preference Settings dialog > Gamma and LUT tab

On the Gamma And LUT panel of the Preference Settings dialog, you set options to adjust the Gamma on page 8592 and lookup-table (LUT) values for input and output images and for the monitor display.
TIP  If you use the mental ray renderer, the Gamma & Gain shader provides an alternate way to adjust gamma on a per-material basis. See Utility Gamma & Gain (mi) on page 6443.

See also:
- Gamma Pipeline on page 8341

Lookup-table (LUT) Correction

Lookup-table (LUT) correction provides compatibility with the same feature used in other Autodesk Media & Entertainment products such as Combustion and the Vfx suite: Inferno, Flint, Smoke, and so on. This feature allows studios to implement a consistent way of displaying colors, assuming that their monitors are calibrated to the same reference. Thus 3D artists can produce results that are closer to what the compositor expects by eliminating a variable in the equation: the way colors are displayed on screen.

NOTE  The lookup table controls available here do not affect exposure control or lighting of the scene. While they do affect the colors of the final image, this is with regard to the display only. By having a reference across a studio (with calibrated monitors), using standardized lookup tables minimizes variability in rendered output.

Also, please note that the LUT system of the systems suite is complex and offers a variety of controls and flavors of lookup tables. This feature integrates the View LUTs only, such as that found in Combustion, where only the displayed images are modified.

Gamma Correction

Gamma correction compensates for the differences in color display on different output devices, so that images look the same when viewed on different monitors, or are used as bitmaps or in printed matter.

The calculation of “gamma” is output_intensity = input_intensity(1/gamma). That is, the result is the original value raised to the power of the inverse of the gamma value. One result of this calculation is that a gamma value of 1.0 does not adjust the image at all.
Gamma = 1.0: no correction

$I$ stands for Intensity.

Another result of the gamma calculation is that black is not affected by the adjustment, and neither is white (or any fully saturated color). Gamma adjustment affects only the midtones of an image.

Left: gamma = 1.8
Right: gamma = 2.2, the standard

The horizontal axis represents input (the original value) and the vertical axis represents output (the gamma-corrected value).
Computer monitors don't display color in a linear way (as in the first illustration). Also, the brightness of a monitor tends to make an image seem brighter than its intensity values really specify. Gamma correction fixes this problem, and can ensure consistency between different applications or different monitors. When you set gamma, find a value that makes middle gray on your own monitor match a true middle (50 percent) gray.

![Gamma value comparison]

**Changing gamma value to match a monitor's middle gray**

The standard gamma value is 2.2. This is the theoretically correct value, making the linear color space stored in the bitmap and used by the renderer appear to be linear on screen.

However, because the response of photographic film isn’t linear either, some users find that this theoretically correct value looks too bright and washed out. A common compromise is to render to a gamma of 1.7 or 1.8, making things look more photographic; that is, as if the image had been shot on photographic film and then developed.

We recommend that you *always* turn on gamma correction when you share bitmaps between different computers, between different applications on the same computer, or create renderings to use in printed matter.

**NOTE**

If the only other applications that use your renderings are also Autodesk Media & Entertainment products, you might want to use LUT correction instead of gamma correction.
Two common mistakes have to do with gamma correction:

- Not applying gamma correction when it should be used. This results in renderings or bitmaps that are too dark.
- Inadvertantly applying gamma correction twice. This results in renderings or bitmaps that are too bright.

See the Procedures section below for more detailed instructions.

**Gamma and LUT Settings Mismatch Dialog**

Gamma And LUT correction settings are saved with the market defaults for the current custom UI. See Custom UI and Defaults Switcher on page 8244. If you open or merge a scene whose gamma or LUT settings differ from the settings active for 3ds Max, you see a dialog that gives you the choice of using the current settings, or adopting those of the file you are loading. For example:
Procedures

To set the gamma for renderings you will use as bitmaps or in printed matter:

1. Choose Customize > Preferences.
2. Turn on Enable Gamma/LUT Correction.
3. In the Display group at the left-hand side of the panel, choose Gamma.
4. Use the Gamma spinner to adjust the Gamma value until the gray square in the center of the display shows no contrast with the surrounding border.
Above: A bad gamma value

Below: A good gamma value

The value you choose can vary, depending on your system's monitor.

5 Once you have a good gamma value, change Output Gamma in the Bitmap Files group on the right-hand side of the tab to the same value as Display gamma.

6 Click OK.
To set the gamma for incoming bitmaps generated (or edited) by other applications:

1 Find out whether the other application has its own gamma correction.

2 If it does, choose Customize > Preferences > Gamma And LUT. Turn on Enable Gamma/LUT Correction, and choose an Input Gamma value that matches the application’s.

   If the file type (for example, Targa) has an embedded gamma value, you might need to set Input Gamma to the inverse (1/gamma) of the file’s embedded gamma, to avoid applying gamma correction twice.

3 If it does not, choose Customize > Preferences > Gamma And LUT. Turn on Enable Gamma/LUT Correction, then in the Bitmap Files group, change the Input Gamma to a suitable value.

   ![Image of Bitmap Files settings]

   Input gamma set to a value suitable for a different application

   It might take some experimentation to find the gamma value that best adjusts the bitmaps created by the other application. The bitmap should appear the way it does in the other application: if it appears too light or too dark in 3ds Max, try a different Input Gamma value.

   **IMPORTANT** If you use bitmaps from multiple applications, and these different applications have different ideal Input Gamma values, then turn on gamma correction, but leave Input Gamma set to 1.0. Instead, for each bitmap you read, use the individual Select Bitmap Image File dialog to set the gamma value appropriate to the program that created the bitmap.

Example: To use gamma correction with Adobe Photoshop:

1 In Photoshop, make sure Edit > Color Settings is set to “North America General Purpose Defaults”, with Working Space > RGB set to “sRGB IEC61966-2.1”.

   Gamma and LUT Preferences | 8337
This is the default color correction in Photoshop.

2 Also in the Photoshop Color Settings dialog, change Color Management Policies > RGB to “Convert To Working RGB”.

3 In Photoshop, click OK and then save the bitmap file.

4 In 3ds Max, choose Customize > Preferences > Gamma And LUT.

5 On the Gamma And LUT tab, turn on Enable Gamma/LUT Correction. In the Display group, choose Gamma, then set the gamma value to 2.2.

6 In the Materials And Colors group, turn on both Affect Color Selectors and Affect Material Editor.

7 In the Bitmap Files group, set both Input Gamma and Output Gamma to 2.2.

8 Click OK to close the Preferences dialog.

Now when you use a bitmap saved by Photoshop, the colors in 3ds Max should preserve the bitmap’s original colors.

To use gamma with video hardware:

Video devices such as video tape recorders usually have their own hardware gamma-correction circuitry.

- If your video device has its own hardware gamma correction, do not turn on gamma correction in 3ds Max.

- If your video device does not perform gamma correction automatically, follow the preceding steps for setting Input Gamma and Output Gamma, using values appropriate to your video device. Typically these will be Input Gamma = 0.45 and Output Gamma = 2.2.

![Bitmap Files](image)

Typical input and output gamma settings for video that has no hardware gamma correction
Enable Gamma/LUT Correction  Makes available the controls for adjusting gamma or LUT correction. Turn off to disable gamma/LUT correction. Default=off.

Display group

Display gamma correction or lookup tables applies to viewports and the Rendered Frame Window on page 6513. Use the controls in this group to load an Autodesk View LUT or adjust gamma numerically.

Autodesk View LUT  Click the Browse button and then use the Load LUT File dialog to find and open a LUT file. Thereafter the LUT file name appears in the text field to the right of the button.

NOTE  3ds Max does not support generation of LUT files, and no LUT files are included with 3ds Max. To create a LUT file, use a program such as Combustion.
**Gamma** (The default.) Adjusts the gamma display for 3ds Max. The spinner value increases or decreases the value (lightness or darkness) of the solid gray center square. Adjust the value until the center square is as close as possible in value to the surrounding checkered border. Range = 0.1 to 5.0. Default=2.2.

If you're creating bitmaps or renderings that will be sent to someone else, set Output Gamma to match the correct Display Gamma value. This ensures that the image will look correct at the destination site.

You can also display these gamma settings from the Gamma button in the File Browser dialog; for example, when you are rendering a scene to an image file.

**Materials and Colors group**

By default, the Gamma setting affects the viewport display and rendered frames, but not the Color Selector or the Material Editor. These switches can enable gamma correction for either or both of these dialogs.

**Affect Color Selectors** When on, the Gamma setting affects the display of colors on the standard 3ds Max Color Selector. This setting has no effect on the Object Color dialog.

**Affect Material Editor** When on, the Gamma setting affects the display of colors on the Material Editor dialog.

**Bitmap Files group**

**Input Gamma** Adjusts bitmaps that you load (for example, texture maps), provided that the bitmap type doesn't override the gamma with its own gamma value. Range = 0.1 to 5.0. Default=2.2.

In the case of Targa files, for example, the file's inherent gamma will override the 3ds Max Input Gamma. In this case, set Input Gamma to the inverse (1/gamma) of the incoming gamma correction. This avoids applying gamma correction twice, which will make the bitmap too bright.

**Output Gamma** The gamma correction applied to bitmaps that you render. Set this to match the correct Display Gamma value. Range = 0.1 to 5.0. Default=2.2.
Gamma Pipeline

To maintain consistent gamma handling when rendering scenes that contain a combination of low-dynamic-range and high-dynamic-range images, follow this procedure, as outlined in the following diagram:

![Recommended Gamma Pipeline Diagram]

Procedure

To handle gamma with input and output of images containing different dynamic ranges, when rendering with mental ray:

1. Consider each source image (used in a material, as a background, reflection map, etc.):
   - If using a low-dynamic-range image as anything other than a bump, displacement, or normal map, save it from Adobe Photoshop or a similar program using the sRGB working space (see this procedure on page 8337), use it as an input shader within the Utility Gamma & Gain (mi) shader on page 6443, and make sure Gamma is set to 2.2 and the Reverse Gamma Correction (De-Gamma) switch is on. (These are the default settings.)

   **NOTE** As an alternative to using the Utility Gamma & Gain shader, turn on Enable Gamma/LUT Correction on page 8339 and then, each time you load an image, set Select Bitmap Image File Dialog > Gamma Group on page 6225 > Override to 2.2. This method has the added benefit of showing the gamma correction in the viewports, and is supported by the default scanline renderer as well as mental ray (the shader works with mental ray only).

   - If the image contains a high dynamic range, no gamma correction is necessary.
If using a low-dynamic-range image as a bump, displacement, or normal map, no gamma correction is necessary.

2 Consider the output:

■ If you want the output image to contain a low dynamic range (for example, JPEG, BMP, or PNG), use an exposure control (preferably the mr Photographic exposure control) on page 7219 and set Output Gamma on page 8340 to 2.2.

■ To output a high-dynamic-range image (such as OpenEXR), don’t use gamma correction or an exposure control.

3 Render the scene.

**Rendering Preferences**

Customize menu > Preferences > Preference Settings dialog > Rendering tab

On the Rendering panel of the Preference Settings dialog, you set options for rendering, such as the default color of ambient light in rendered scenes. The many choices available enable you to reassign the renderers used for production and draft rendering.

**NOTE** This panel no longer contains Bitmap Pager controls. As of Autodesk 3ds Max 2010, bitmap paging is always active, and managed automatically.
**Interface**

**Video Color Check group**

Some pixel colors are beyond the safe NTSC on page 8654 or PAL on page 8674 threshold. You can choose to flag or modify them to acceptable values.

**Flag with Black** Flags all illegal pixels with black to show you the illegality of your image. This mode teaches you how to make correct colors, instead of depending on Scale options. Scale options force a natural discontinuity in the color values. In some cases, that discontinuity can cause visible aliasing on page 8501.

**Scale Luma** Scales the luminance to bring the color into range, and maintains saturation. This generally makes the illegal areas appear darker than they should be.

**Scale Saturation** Scales the chroma to bring the color into range, and maintains saturation. Because this option keeps the brightness levels of the pixels fairly equal to the unscaled ones, this is the more useful of the two scale methods.
NTSC/PAL Determines the standard for the video color check. See NTSC (Glossary) on page 8654 and PAL (Glossary) on page 8674.

Output Dithering group

Sets output dithering on page 8553 for all file types.

True Color Toggles dithering for any true color output device. For 24-bit work, turn on True Color. For paletted work, turn it off.

Paletted Turns dithering on or off for any 8-bit paletted device.

Field Order group

Odd/Even Selects the field order of rendered images when the Render To Fields option is enabled on the Render Setup dialog. Some video devices require that the even field be first, other video devices require that the odd field be first. Determine the correct field order for your video device. If the video output of your device is strobing or appears jittery, it may be due to incorrect field on page 8570 order, try changing this parameter and re-rendering your animation.

Super Black group

Threshold Keeps the super black on page 8735 threshold above a certain level primarily for luminance keying.

HotSpot/Falloff group

Angle Separation Locks the spotlight hotspot on page 8604 and falloff on page 8604 cones at the angle separation defined by the spinner (degrees). This option constrains the hotspot angle so that it can't equal the falloff and cause aliasing artifacts.

Background group

Don't Antialias Against Background Ensures that the edges of rendered geometry are not antialiased against the background. The inside of the geometry is still antialiased. Keep this control off unless you're creating sprites for game development, or require special compositing techniques because the background will not be rendered. In these cases, turning on this option helps avoid generating alpha antialiasing on the outlines of the geometry. Default=off.
NOTE When Don’t Antialias Against Background is on, render only against a black background.

Filter Background Controls whether the antialiasing filter of the renderer affects the background image. See Plate Match /MAX R2.5/VIZ R2 Filter Types in Default Scanline Renderer Rollout on page 6589 for detailed information of filtering background and antialiasing.

Use Environment Alpha Controls whether or not the renderer uses the environment map’s alpha channel in creating the alpha for the rendered image. When off, the background is transparent. When on, the alpha of the resulting image is a combination of the scene and image alpha.

NOTE Only background images with alpha channels or black backgrounds are supported when compositing in other programs such as Photoshop.

Default Ambient Light Color group

Click the color swatch to change the default ambient light on page 8504 color for renderings. This setting defines the darkest color for rendered shadows in the scene.

Output File Sequencing group

Nth Serial Numbering Specifies whether output frame files generated using a frame-step value other than 1 are numbered sequentially (on) or according to their true frame numbers (off).

Render Termination Alert group

Beep Beeps when the rendering has finished. You can set the frequency and the duration.

Play Sound Plays a sound file when the rendering has finished.

Choose Sound Opens the Open Sound browser dialog, select a sound file using the browser. You can test sound files with the Play button in the Open Sound dialog. Press ESC to turn off the sound.

GBuffer Layers group

Maximum Number Limits the number of layers that are stored in the G-buffer during rendering. Default=10; Range=1 to 999.
Memory requirements might dictate that you limit the number of G-buffer layers. The RLA and RLF image formats, used for compositing, can store many G-buffers for object Z buffer information, material ID, transparency, and so on.

**Multi-threading group**

On Causes 3ds Max to treat the rendering task as separate threads. This option works with multiprocessor systems. Each processor in your computer handles a different thread, which makes full use of available processing power and speeds up rendering to its maximum level. When off, 3ds Max treats a rendering task as a single processing task and doesn't divide it up.

**Animation Preferences**

Customize menu > Preferences > Preference Settings dialog > Animation tab

On the Animation panel of the Preference Settings dialog, you set options relating to animation on page 8505. Options include displaying animated objects in wireframe viewports, the assignment of sound plug-ins, and controller defaults.

**Procedures**

**To change the default transform center:**

1. Choose Customize menu > Preferences > Preference Settings dialog > Animation tab.
2. Turn off Local Center During Animate in the Animate group.
   This changes the default and activates all the transform center buttons. You can now move about the selection, coordinate center, or local pivot.

**To set the key bracket display:**

1. Choose Customize menu > Preferences > Preference Settings dialog > Animation tab.
2. Use the controls in the Key Bracket Display group to specify how you want key brackets displayed in wireframe viewports.
To specify default controller settings:

1. Choose Customize menu > Preferences > Preference Settings dialog > Animation tab.

2. Click Set Defaults in the Controller Defaults group.
   The Set Controller Defaults dialog appears.

3. Choose a controller type from the list of available controllers and click the Set button.
   A dialog containing the default settings supported by the selected controller type appears, for example, the In and Out tangents for a Bezier controller.

4. Make changes to the controller settings.
   Once you click OK in the Set Controller Defaults dialog, the controller defaults are changed.
   Changes to the controller default settings are written to your 3dsmax.ini file and become the defaults for all newly assigned controllers and all new scenes.
   If you decide that you want to revert to the original 3ds Max defaults for all controllers, you can click Restore To Factory Settings.
Interface

Key Bracket Display group

When you move to a frame, 3ds Max displays white brackets around objects that have transform keys on page 8616 at that frame, including cameras and lights. These key brackets appear only in wireframe viewports.

All Objects/Selected Objects/None Specifies which objects display key brackets.

Use Current Transform Displays brackets only on those frames containing keys for the active transform tool on page 8750 (Move, Rotate, or Scale). If no transform tool is active, brackets appear in frames containing any of the three transforms.

To define which types of transform display brackets, turn off Use Current Transform and use the Position/Rotation/Scale switches (see following).

NOTE When actively scrubbing the frame slider, brackets always appear for all transforms.
**Position/Rotation/Scale** Specifies which types of transform display brackets. For example, if only Rotation is on, brackets appear only on those frames containing Rotation keys. These check boxes become available when Use Current Transform is off.

**Animate group**

**Local Center During Animate** Locks the center method to local on page 8621. Turn off if you want to animate around a non-local center such as world or selection.

**MIDI Time Slider Control group**

Enables use of a MIDI device to control the time slider. Choose On to use the MIDI device specified in the MIDI Time Slider Control Setup dialog on page 8350, which is displayed with the Setup button.

**Sound Plug-In group**

Assign Displays a dialog listing all sound plug-ins installed in the system. Select a new plug-in to replace the current one.

**Controller Defaults group**

Sets the default values for animation controllers capable of supporting default settings. For example, set the default values for tension, continuity and bias in the TCB float controller.

**Override Parametric Controller Range By Default** When on, new parametric controllers are active throughout the timeline, independent of their animation range. Otherwise, they respect it and are only active within their range. Refer to Ignore Animation Range on page 3900 and Respect Animation Range on page 3901 for more details. Default=on.

**Spring Quick Edit** Toggle to increase the accuracy of all spring controllers in the scene. To be used with the Rollback input field. Default=off.

**NOTE** This option is saved in the *3dsmax.ini* file as *SpringsQuickEdit*.

**NOTE** Turning on this option can impact scene performance.

**Rollback** Sets the number the frames a spring controller goes back before becoming invalid. Default=6.
NOTE This option is saved in the 3dsmax.ini file as SpringsRollingStart.

NOTE Setting a high number can impact scene performance.

Set Defaults Displays a dialog listing all controllers that can have their default values changed. The Set button becomes available when you choose a controller class from the list. Highlight a controller class, click Set, edit the default key values, and then click OK.

Restore To Factory Settings Prompts you to verify if you want to reset all controllers to the 3ds Max default settings. If you choose Yes, the defaults are reset for all controllers currently in the system.

Auto Key Default Frame group

On When on, using Auto Key mode to set a key at a frame other than the start frame (0 or 1) also creates a key at the start frame. When off, no key is created at the start frame.

[default frame] When Auto Key Default Frame is on, this setting specifies the start frame at which 3ds Max sets a key when you use Auto Key to set a key at a frame other than the start of the animation.

The available settings are 0 and 1. When you set the default frame to 1, 3ds Max uses the equivalent in the current time display system, set via the Time Display setting on page 8111 on the Time Configuration dialog. For instance, if Time Display is set to MM:SS:TICKS, the equivalent to frame 1 is 0:0:160.

MIDI Time Slider Control Setup Dialog

Customize menu > Preferences > Preference Settings dialog > Animation tab > MIDI Time Slider Control group > Setup button

With the MIDI Time Slider Control Setup dialog you can specify and set up a MIDI device to control animation playback.

Procedures

To use a MIDI device to control the animation time slider:

1. Choose Customize menu > Preferences > Preference Settings dialog > Animation tab.

2. In the MIDI Time Slider Control group, choose On.
3 Click Setup.

4 Set the MIDI device options and click OK.

**Interface**

![MIDI Time Slider Control Setup](image)

**Presets** Specifies the type of MIDI device used. You can choose the Media Control Station 2, which is a MIDI device containing standard VCR-style playback buttons along with a jog wheel, or you can choose Custom, which specifies note events in the spinners. You can also use Custom to customize the buttons used by the Media Control Station.

**Channel** Specifies the channel to which your MIDI device is assigned.

**Note Number group**

With the controls in this group you can specify which note event triggers which function.

**Start Frame** Goes to the start frame (the Rewind button in the Media Control Station).
End Frame  Goes to the end frame (the Fast-Forward button in the Media Control Station).

Step Forward  Moves one frame forward (the Fast-Forward button and Option button in the Media Control Station).

Step Backward  Moves one frame back (the Rewind button and Option button in the Media Control Station).

Stop  Stops playback (the square button).

Play  Plays the animation (the arrow button).

Jog Wheel  Controls the time slider with the jog wheel.

Sensitivity  Controls the number of ticks that the time slider moves in response to one unit of movement from the jog wheel. A lower value provides more precise positioning of the time slider, while a higher value makes the time slider move faster. If you set your time display to show ticks and set the sensitivity to 1, you can move one tick at a time with the jog wheel.

Inverse Kinematics Preferences

Customize menu > Preferences > Preference Settings dialog > Inverse Kinematics tab

On the Inverse Kinematics panel of the Preference Settings dialog, you set options for both applied and interactive inverse kinematics on page 8612.

Procedures

To prevent transforming unlinked objects while working in IK mode:

1  Choose Customize menu > Preferences > Preference Settings dialog > Inverse Kinematics tab.

2  On the Inverse Kinematics panel, turn off the option labeled Always Transform Children Of The World.

Single, unlinked objects are hierarchies of one object. An unlinked object is its own root and also a child of the world, so turning off Always Transform Children Of The World prevents you from transforming single objects in IK mode.
Applied IK/Interactive IK group

The threshold and iterations settings are a trade-off between accuracy and speed. With the two groups of settings you can individually tune the behavior of Interactive IK and Applied IK. Interactive IK provides fast, real-time response, so you should set Interactive IK preferences for speed. Applied IK provides the IK solution on page 8606 to match the follow objects on page 8583 very closely. You should set applied IK preferences for accuracy.

**Position** Sets how close the end effector has to get to the follow object or cursor position for the object to be considered a valid solution. The value represents a distance in the current display unit system. Small values increase accuracy but take longer to solve.

**Rotation** Sets how accurately the end effector has to match the orientation of the follow object to be considered a valid solution. The value represents a rotation angle in degrees. Small values increase accuracy but take longer to solve.

**Iterations** Sets the maximum number of times 3ds Max repeats the IK calculations to find a valid solution. A high iterations value increases the
chance that 3ds Max can calculate a valid IK solution, but the calculation takes longer to complete.

**Ungrouped controls**

**Use Secondary Threshold** Compares the second derivative of the end effector on page 8560 to a very small threshold. If the derivative is within the threshold, IK is terminated.

**Always Transform Children Of The World** Applies in both move and rotate modes when IK is on. It affects only an object that is a direct child of the world when the object is selected.

For example, if the root of an IK chain is a child of the world, and you're manipulating an object at the end of the chain (the root object itself isn't selected), 3ds Max observes any constraints set for the root object. However, if you select the root object and try to move it, its constraints will be ignored.

**Gizmos Preferences**

Customize menu > Preferences > Preference Settings dialog > Gizmos tab

You set the display and behavior of the Transform gizmos on page 889 on the Gizmos panel of the Preference Settings dialog.
Interface

**Transform Gizmos group**

**On** When on, 3ds Max uses the Transform gizmo to enable more powerful move, rotate, and scale options. When off, a basic tripod is displayed, with no axis specificity.

**Show Axis Labels** Toggles the display of the axis labels on the Transform gizmo.

**NOTE** Functionality is maintained when Show Axis Labels is off.

**Allow Multiple Gizmos** Toggles the display of more than one gizmo at a time.

When off, a transform gizmo is displayed for only one object at a time in a selection set.
When on and the Use Center flyout > Use Pivot Point Center on page 931 setting is active, each object in a selection set has its own transform gizmo.

**Size** Sets the size of the Transform gizmo as a percentage of the viewport size. Range=1 to 100.

**Move Gizmo group**

**Relative Size (%)** Sets the size of the Move gizmo, relative to the Size value of the Transform gizmo. Range= 0.0 to 500.0.

**Plane Handles group**
The plane handles let you constrain object movement along combinations of any two axes.

**On** Toggles the use of plane handles on the Transform gizmo.

**Size** Sets the size of the plane handles, as a percent of the distance from the Offset to the tripod axis. Range=0.0 to 100.0.

**Offset** The percentage of the distance from the gizmo's tripod axis to the outer extent of the Primary axis handles.

For example, 0 = no plane handles; 100 = plane handles extend as far as the Primary axis handles.

**Center Box Handle group**
The center box can be used as a handle for translations constrained parallel to a viewport.

**Move in Screen Space** Toggles the use of the center box handle.

**Rotate Gizmo group**

**Relative Size (%)** Sets the size of the Rotate gizmo, relative to the Size value of the Transform gizmo. Range= 0.0 to 500.0.

**Free Rotation** Toggles the ability to rotate about any combination of axes.

When off, you can rotate only about a specific axis, or, if Screen Handle is on (see following), parallel to the screen.

**Show Tripod** Toggles display of an axis tripod at the pivot point. This tripod also highlights the selected axis while rotating.

**Screen Handle** Toggles display of the screen orbit, which lets you rotate an object parallel to a viewport.
Show Pie Slice When on, a shaded pie slice acts as a visual indicator of the direction and amount of rotation.

NOTE If you rotate more than 360°, the slice overlaps and the shading becomes increasingly intense.

Angle Data When on, numerical feedback appears in the viewport during single-axis rotation, indicating the amount of rotation around the X, Y, or Z axis.

Rotation Method Sets the rotation method for the gizmo:

■ Linear Roll: Rotate the virtual trackball by dragging in a single direction, tangent to the Rotate gizmo.

NOTE A tangent handle appears to show the best direction to drag the mouse.

■ Circular Crank: Rotate the virtual trackball by dragging around the Rotate gizmo, in a circular manner.

■ Legacy R4: Turns off virtual trackball behavior, and uses the rotation method from 3ds Max 4.

Planar Angle Threshold Determines when the Circular Crank rotation method automatically switches to Linear Roll to prevent loss of control over the gizmo. This occurs when a Primary axis is nearly 90 degrees to the view plane, making it different to circle around. Any angle to the view plane that is higher than this setting will use Crank mode, but any angle equal to or less than this setting will always function as a Linear Roll.

Scale Gizmo group

Relative Size (%) Sets the size of the Move gizmo, relative to the Size value of the Transform gizmo. Range= 0.0 to 500.0.

Uniform Handle Size (%) Sets the size of the handle for uniform scaling (the distance from the transform center to the edge of the uniform handle), as a percentage of the scale gizmo size.

2–Axis Handle Size (%) Sets the size of the handle for non-uniform scaling along 2–axes (the distance from the edge of the uniform handle to the edge of the 2–axis handle), as a percentage of the scale gizmo size.

Uniform 2–Axis Scaling Forces scaling using a 2–axis plane handle to be uniform.
**Move/Rotate Transforms group**

Controls the way you can move selected objects with the mouse in a non-orthographic view such as Perspective.

**Intersection** Shoots a ray from the mouse point into the screen. This makes moving objects easier, but as you move toward the horizon, the object moves great distances.

**Projection** Projects the motion of the mouse onto the plane. This ensures that there are no singularities at the horizon, and that motion is always smooth and stable. However, it can become difficult to move objects when the plane is not parallel to the screen.

**Persp Sens** Sets mouse sensitivity for projection transforms.

**Rotation Increment** Specifies the amount of rotation generated by moving the mouse 1 pixel. Lower this value for angular rotations smaller than the default .5 degrees. The lower this value, the more mouse movement is needed to rotate objects.

**Viewport Orbit Snap Angle** Sets the viewport rotation increment in degrees. Turn on Angle Snap on the main toolbar, and then use Orbit to rotate a viewport. The viewport rotation snaps by the value set here. The Orbit cursor displays a small magnet in the upper left to indicate that Angle Snap is on.

---

**MAXScript Preferences**

Customize menu > Preferences > Preference Settings dialog > MAXScript tab

On the MAXScript panel of the Preference Settings dialog, you set MAXScript and Macro Recorder preferences, enable or disable auto-loading of scripts, set the initial heap size, change font style and size used in the MAXScript editor, and manage all the settings for the Macro Recorder.

You can also change these settings by editing the [MAXScript] section of the `3dsmax.ini` file.
NOTE Two paths to support auto-startup scripts are on the Configure User Paths dialog on page 8284 and Configure System Paths dialog on page 8293: ..\scripts and ..\scripts\startup. If you prefer to start scripts from a different directory, you can change these default directories with the corresponding Customize menu commands.

Choose Help > MAXScript Help for details on MAXScript.

Interface

Startup group

You can start scripts automatically in two ways. You can create a file named startup.ms that contains your startup code. MAXScript searches for this file in the scripts directory first, then the 3ds Max root directory, and finally the directories specified in the Windows PATH environment variable. MAXScript stops searching after it finds the first occurrence of startup.ms.
You can also place the script files you want auto-loaded into the `\startup` directory inside the `\scripts` directory. MAXScript loads any script file with the file name extension `.ms` or any encrypted script file with file name extension `.mse`.

If you have both a `startup.ms` file and auto-load files in the `\startup` directory, MAXScript always loads `startup.ms` first.

**Load Startup Scripts** Loads scripts automatically when 3ds Max starts.

**Load/Save Scene Scripts** Enables Scene Script loading and saving.

**Load/Save Persistent Globals** Enables load and save Persistent Globals. MAXScript supports a limited form of variables. You declare that a particular global is persistent and the value it contains is always saved to and restored from scene files as they are opened and closed. In this way you can, for example, keep direct references to objects in the scene in variables. Those references will move across scene save and reload.

**MAXScript Windows group**

**Font** Choose a font for the MAXScript editor

**Font size** Choose a font size for the MAXScript editor.

**Auto Open Listener On Output** Opens the Listener if a script sends output to a WindowStream value with no associated window. This would require a MAXScript extension.

**Runtime group**

**Use Fast Node Name Lookup** When on, MAXScript indexes scene node names in a cache, resulting in significantly faster resolution of non-wildcard pathname values (for example, `$box01`) to node values. When off, the scene nodes are enumerated as MAXScript looks for a scene node name that matches the pathname, resulting in slower lookups.

Turn this off if you encounter an incompatibility with an existing script.

**Memory group**

**Initial Heap Allocation (Mbytes)** Sets the initial heap allocation.

MAXScript carves its own working memory (called a heap) out of the memory that 3ds Max allocates. You can add to the heap at any time by increasing the value here.
**Macro Recorder Group**

**Enable Macro Recorder** Enables the Macro Recorder.
3ds Max starts with the macro recorder disabled and a minimized Macro-Recorder pane in the MAXScript listener window.

You can also enable the Macro Recorder by turning on MAXScript > Macro Recorder or by turning on Enable in the Macro Recorder menu on the MAXScript Listener toolbar.

This state is stored in the 3dsmax.ini file. Turning it on once keeps it enabled across restarts of 3ds Max.

**Code Filters group**

**Command Panel Switchings** Displays command panel switchings in the code.

**Tool Selections** Displays tool selection in the code.

**Menu Item Selections** Displays menu selection in the code.

**Code Generation group**

The Code Generation parameters refer to whether or not the script emitted is made selection-relative, if possible, or if it contains object references. By making the script selection-relative, you can apply the recorded script to a different selection, thereby making it more general. Absolute mode always works on the same objects regardless of the current selection.

**Explicit Scene Object Names** Uses scene object names in the code.

**Selection-relative Scene Object Names** Makes Scene Object Names relative in the code. Default=on.

**Explicit Sub-object Sets** Uses explicit sub-object sets in the code.

**Selection-relative Sub-object Sets** Uses selection relative sub-object sets in the code. Default=on.

**Absolute Transform Assignments** Uses absolute transforms in the code.

**Relative Transform Operations** Uses selection relative transform operations in the code.
Radiosity Preferences

Customize menu > Preferences > Preference Settings dialog > Radiosity tab

On the Radiosity panel of the Preference Settings dialog, you set options for the radiosity solution on page 6615.

See also:

- Modeling Global Illumination with Radiosity on page 6615
- Radiosity Controls on page 6634

Interface

**Material Editor group**

Display Reflectance & Transmittance Information When on, reflectance and transmittance values on page 5669 are displayed in the Material Editor.

**NOTE** In order to make this change effective, you need to close and restart the Material Editor.
**Interactive Display group**

*Display Radiosity in Viewports* When on, radiosity effects are displayed in the viewports.

**Radiosity Processing group**

*Automatically Process Refine Iterations Stored in Geometric Objects* When on, all refine iterations stored in geometric objects are automatically processed.

**Start/Reset Behavior**

*Display Reset Warning* When on, a warning message is displayed whenever you reset the radiosity solution in your scene.

*Update Data When Required on Start* When on, the radiosity engine must be reset and then recalculated if the solution is invalidated. In this case, the Start button changes to read Update & Start. When this is pressed, the radiosity solution is reset and the calculation starts over again.

When this toggle is off, the radiosity solution does not need to be reset if it is invalidated. You can continue processing your scene with the invalid solution.

**NOTE** The radiosity solution is invalidated any time an object or light is added, removed, moved, or altered in any way.

**File Save group**

*Save Scene Information in MAX file (Decreases Load Time)* The light levels from the radiosity solution are always saved with the file, however when this is on, some additional radiosity information is saved with your scene.

### mental ray Preferences

Customize menu > Preferences > mental ray panel

This panel sets preferences for using the mental ray Renderer on page 6675 and its associated materials and shaders.
Interface

![Interface settings window]

**General group**

**Enable mental ray Extensions** When on, enables certain features that provide additional support for the mental ray renderer. When off, these features do not appear in the interface. Default=off.

These are the features enabled as mental ray extensions to 3ds Max:
- **mental ray Connection rollout** on page 5763 for materials (Material Editor)
- **mental ray Light Shader rollout** on page 5464 (Modify panel for lights)

**WARNING** If you have assigned shaders and adjusted their settings using the mental ray Connection rollout, turning off Enable mental ray Extensions will **lose all these assignments and settings**. The same applies to light shader assignments.

**Rendering group**

**Show Brackets on Current Buckets** Displays white selection brackets at the corners of the bucket currently being rendered. Default=on.
**Show Visual Final Gather Progress** When on, the Rendered Frame Window on page 6513 displays a coarse image of the final gather points as those points are being calculated. This provides visual feedback of the final gather solution in progress. Default=on.

If you prefer that the final render directly overwrite the previous one in the Rendered Frame Window for comparison purposes, turn this off.

![Visual display of final gather calculation in progress](image)

**Clear Frame Window Before Rendering** When on, before rendering the Rendered Frame Window on page 6513 turns to a gray shade by clearing every other scanline. This makes it easier to see the progress of rendering. On the other hand, it can make it more difficult to see the effect of small changes to the model or the view. Default=on.

**Messages group**

**Open Message Window on Error** Whenever the mental ray renderer detects an error, it generates an error message. When this option is on, the Messages Window is displayed and the error message appears in it. Default=on.
**Show/Log Information Messages** When on, displays informational messages in the Messages Window. Default=off.

**Show/Log Progress Messages** When on, displays progress messages in the Messages Window. Default=off.

**Log Debug Messages (to file)** When on, writes debug messages to the log file, if one has been specified. Default=off.

Debug messages are never displayed in the Messages Window. The mental ray renderer generates a large number of them, which would make the window hard to read.

**Write Messages to File** When on, generates a mental ray log file on page 8624. Default=off.

The other log file options are unavailable unless you turn on Write Messages To File:

- **Append to File** When on, appends messages to the existing file. When off (or if the named file is not found), only new messages are written to the file. Default=off.

- **File** Click to display a file dialog that lets you choose the name and location of the .log file.

- **File name field** When you have specified a log file, this field shows its name and its path.

### Units Setup Dialog

Customize menu > Units Setup > Units Setup dialog

The Units Setup dialog establishes the unit display method, giving you the choice between generic units and standard units (feet and inches, or metric). You can also create custom units, which are used whenever you create an object.

The units that you set up are used to measure geometry in your scene. In addition to these units, 3ds Max also uses system units as an internal mechanism. System units should only be changed before you create your scene or import a unitless file. Do not change the system unit in an existing scene.

You can also set the lighting units using this dialog.
System vs. Display Units

It is important to note the distinction between System and Display units. Display units only affect how geometry is displayed in the viewports. System units determine the actual scale of geometry. For example, if you import a DXF file (unitless) containing a 1 x 1 x 1 Box, 3ds Max could import the box's dimensions in inches or miles, depending on the System unit. This can have a significant impact on your scene, which is why you should always set up the system unit before you import or create geometry.

Procedures

To change units to feet and inches:

2. Choose from among the display options on the drop-down list.
   - If you want to display measurements as feet with inches, choose how inches should appear: fractional or decimal. Also choose, for Default Units, Feet or Inches
   - If you choose one of the Fractional display options, choose the fraction on the drop-down list to the right.

To enter fractions in numeric fields:

- When you enter fractions in numeric fields, they are converted to the correct units. For example, if units are set to Feet w/ Decimal Inches, and Default Units is set to Feet, type $37/45$ and press Enter for the result 0'9.867", or 37/45'.

To enter a fraction and a units specifier, place the specifier after the divisor. For example, type $17/5'$, but not $17'/5$.

To convert between unit types:

- You can convert between unit types by entering any valid unit specifier, along with the number, and then pressing Enter. The number is converted to the current unit display type. For example, if units are set to Meters, type $1/2$ to get the result 0.5M. However, if you type $1/2'$ or $6''$ the result is 0.152M.
System Unit Setup Click to display the System Unit Setup dialog on page 8370 and change the system unit scale.

**WARNING** Change the system unit value only before importing or creating geometry. Do not change the system unit in an existing scene.
Display Unit Scale group

Choose a unit scale option (Metric, US Standard, Custom, or Generic Units) to activate its settings.

**Metric** Choose this option and then choose a metric unit: Millimeters, Centimeters, Meters, or Kilometers

**US Standard** Choose this option and then choose a US Standard unit. If you choose a fractional unit, the adjoining list activates to let you select the fractional component. The decimal units require no additional specification. The US Standards are as follows:

- Fractional Inches
- Decimal Inches
- Fractional Feet
- Decimal Feet
- Feet w/ Fractional Inches
- Feet w/ Decimal Inches

For the last two items, you can specify which unit is assumed when you enter a value in a numeric field and press Enter without including a units specifier, such as ' for feet or " for inches.

For example, if Feet is the default, typing 5 followed by Enter results in 5 feet. Typing 5" followed by Enter results in 0'5". If Inches is the default, typing 5 followed by Enter results in 0'5". Typing 5' followed by Enter results in 5 feet.

**Custom** Fill in the fields to define a custom unit of measurement.

**Generic Units** (The default.) A Generic or “system” unit in 3ds Max is equal to one inch. You can treat it as an arbitrary unit of your own definition, unless your scene uses features that depend on real-world measurements, such as photometric lights, Use Real-World Scale for bitmaps, and so on.

**WARNING** If you are modeling an object that includes details whose dimensions are very much less than one inch, treat the Generic unit as an arbitrary unit that is smaller than one inch: for example, 1 unit = 1/50 of an inch. Otherwise, you might encounter problems with your model that are due to roundoff error.
Lighting Units group

The Lighting Units group lets you choose whether light values are displayed in American or International units.

System Unit Setup Dialog

Customize > Units Setup > Click System Unit Setup.

This dialog appears when you click System Unit Setup in the Units Setup dialog on page 8366.

**WARNING** You should only change the system unit value *before* importing or creating geometry. Do not change the system unit in an existing scene.

Because of the nature of digital floating-point calculations, distances that are extremely large or extremely small can cause round-off error. Symptoms of round-off error include trouble navigating (zooming and panning become too fast or too slow), unwanted viewport clipping, and unexpected flipping of normals. Here are some general guidelines to avoid these problems:

- Make sure your scene is roughly centered around the origin (0,0,0). Round-off error increases at large distances from the origin.
- Make sure no significant detail in the scene is smaller than one generic 3ds Max unit.

**NOTE** The Rescale World Units utility on page 2884 alters the scale of world units throughout the entire scene, or selected objects.

Procedures

To change the system unit:

1. Choose Customize menu > Units Setup.
2. Click System Unit Setup.
3. Change the System Unit Scale value, and click OK.
   - The system unit is immediately reset. This setting remains in effect until you change it.
Interface

Unit and Measurement fields Change the scale of the 3ds Max unit. The system unit is the standard measurement throughout 3ds Max. You should only change the system unit value before importing or creating geometry.

Respect System Units in Files When on, if you open, merge, XRef, or drag and drop geometry from file that has different system unit settings, a File Load: Units Mismatch dialog on page 8372 is displayed. This dialog gives you the choice of rescaling the geometry to match the current system units, or adopting the units used in the file. When off, the dialog is not displayed, and the file is assumed to have the same units as the current 3ds Max session. Default=on.

Origin Slider, Distance from Origin, Accuracy

These controls provide a system unit calculator to help you determine the unit scale for your project. The resolution of measurement diminishes as the distance to the origin of space increases, so you need to consider space granularity when you choose a scale for your project. If you’re modeling an island, for example, this calculator can help you determine the smallest object
you should model on the island. In other words, don't use a unit scale of millimeters if you plan on modeling an island that's many miles across.

When you use the slider or the text field to enter a distance from the origin, the Resulting Accuracy changes to show what the round-off error will be at that distance.

These controls don't change the unit settings in 3ds Max. They don't reflect the extents of the current scene, either.

**Origin Slider** Move the slider for interactive feedback of distance and accuracy. Right-click the scale to reset the slider to 0. Dragging the slider displays the last slider position as a small square on the scale markings.

The slider covers distances from 0 to the maximum distance that's accurate to one system unit.

**Distance from Origin** Enter the maximum distance you want to use in your project to determine the maximum accuracy, which is displayed in the Accuracy field. Values consider current settings for system scale and unit.

**NOTE** When you type a distance, you must press ENTER to update the Resulting Accuracy field. Pressing TAB simply moves focus to Resulting Accuracy, without doing the calculation.

**Resulting Accuracy** Enter the minimum resolution you will use to determine the maximum size or distance that's most practical. Values consider current settings for system scale and unit.

For example, if units are in feet and decimal inches in Customize menu > Units Setup, and you type (1', 1 foot) in the Accuracy field, a value of 22369620'0.0" is displayed in the Distance From Origin field. If you move an object that's one foot across, at this distance away from the origin of space, a round-off error will occur, and the shape of the object will be compromised.

### File Load: Units Mismatch Dialog

Change the system unit scale. > Open, Merge, XRef, or drag geometry from a file with a different unit scale.

This dialog appears when you open or merge a file that has been saved with system unit settings that are different from those of your current 3ds Max session. The default system unit setting is Inches.

If you open a file with the system unit set to meters, for example, you will see this dialog.
When this happens, you have two options:

- **Rescale the File Objects to the System Unit Scale**: You can choose to rescale the objects from the incoming file to match the current system unit. This changes the size of the incoming geometry.

- **Adopt the File’s Unit Scale**: This changes the system unit in your 3ds Max installation to match that of the incoming file. This setting will persist between the current and future 3ds Max sessions until you reset your system unit on page 8370. This is the default option. Choosing File > Reset will not reset your system unit. You must either change it using Customize > Units Setup > System Unit Setup, or manually edit your 3dsmax.ini file.

**NOTE** This dialog appears only if Respect System Units In Files is enabled on the System Unit Setup dialog on page 8370.

**Interface**

![File Load: Units Mismatch Dialog]

**Rescale the File Objects to the System Unit Scale**: Objects from the file are rescaled to the current session's system unit scale.
NOTE Many features depend on the scale of the scene, so choosing to rescale the file objects can have unpredictable results, particularly in scenes using radiosity. Reset and recalculate radiosity if you have rescaled the file objects.

TIP Use the Zoom Extents All button if the geometry is no longer visible in the viewport after rescaling.

Adopt the File's Unit Scale The system unit scale is changed to match that of the other file. This is the default option.
Choosing Adopt The File's Unit Scale adds two settings to your 3dsmax.ini file: UnitType= and UnitScale=. For this reason, this change is persistent between sessions until you reset it manually.
To get back the default System Unit Scale, you can edit your 3dsmax.ini file and remove those settings; or go to Customize > Units Setup > System Unit Setup and change the units back to the default scale, Inches.

TIP Objects with a UVW Unwrap may lose their texture coordinate information when you choose this option. If this occurs, choose the Rescale option rather than the Adopt option.

Viewport Configuration

Views menu > Viewport Configuration
Click or right-click the General viewport label (“[ + ]”). > General viewport label menu on page 8117 > Configure > Viewport Configuration dialog
The Viewport Configuration command displays the Viewport Configuration dialog. You use controls on this dialog to set options for viewport control.
All the configuration options are saved with the MAX scene file. To configure startup settings for your file, you can save a maxstart.max file. If this file exists, 3ds Max uses it to determine the viewport configuration and settings when 3ds Max is loaded or reset.

Rendering Method

Views menu > Viewport Configuration > Viewport Configuration dialog > Rendering Method tab
Click or right-click the General viewport label (“[ + ]”) > General viewport label menu on page 8117 > Configure > Viewport Configuration dialog > Rendering Method tab

You set the rendering method for either the current viewport or all viewports on the Rendering Method panel of the Viewport Configuration dialog.

**NOTE** These controls operate on all objects depicted in the viewports; you can also control display properties on a per-object basis.

### Procedures

**To set the viewport rendering method:**

1. Choose Views menu > Configure > Viewport Configuration dialog > Rendering Method tab.

2. In the Rendering Level group, choose the desired rendering level and any options available for that level.

3. In the Apply To group, choose how to apply the rendering level to viewports:
   - Active Viewport Only applies the rendering method to the active viewport. This choice is the default.
   - All Viewports applies the rendering method to all configured viewports.
   - All But Active applies the rendering method to all viewports except the active one.

   **TIP** This option lets you work in full detail in the current view and easily set other views to Wireframe or Bounding Box for quicker interactive display.

**To enter an FOV value in a Perspective viewport:**

1. Right-click a Perspective viewport label and choose Configure. It isn’t necessary to activate the viewport first.

   This opens the Viewport Configuration dialog. If necessary, click the Rendering Method tab.

2. In the Perspective User View group > Field Of View field, enter an angle.
### Interface

When you open this dialog, the settings reflect the current viewport settings.

**NOTE** The settings in the Rendering Level and Transparency groups are also available from the Shading Viewport Label menu on page 8130.

#### Rendering Level group

Determines how 3ds Max displays objects.

- **Smooth+Highlights** Renders objects with smooth shading and displays specular highlights. To toggle quickly between Smooth+Highlights and Wireframe, press F3.
- **Smooth** Renders objects with smooth shading only.
- **Facets+Highlights** Renders objects with flat shading and displays specular highlights.
- **Facets** Renders polygons as flat surfaces, shaded but with no smoothing or highlights.
- **Flat** Renders each polygon in its raw, unshaded diffuse color, disregarding any contribution from ambient lighting or light sources. This rendering method is useful when it's more important to see each polygon than to see its shading.

---

8376 | Chapter 24  Customizing the User Interface
It's also a good way to check the results of bitmaps created with Render to Texture on page 6843.

**Hidden Line** A wireframe mode that hides faces and vertices with normals on page 8654 pointing away from the viewpoint, as well as any parts of objects that are obscured by closer objects. In this display mode only, the wireframe color is determined by the Viewports > Hidden Line Unselected color, not the object or material color. See Colors Panel on page 8272.

**Lit Wireframes** Renders objects as wireframes with flat shading.

**Wireframe** Draws objects as wireframes with no shading applied. To toggle quickly between Wireframe and Smooth+Highlights, press F3.

**Bounding Box** Draws objects as bounding boxes with no shading applied. A bounding box on page 8528 is defined as the smallest box that completely encloses an object.

**Edged Faces** Available only when the current viewport is in a shaded mode, such as Smooth, Smooth+Highlights, Facets+Highlights, or Facets. When Edged Faces is on in these modes, the wireframe edges of objects appear along with the shaded surfaces. This is helpful for editing meshes in a shaded display. To toggle Edged Faces display, press F4.

Edges are displayed using the object wireframe color, while surfaces use material colors (if a material is assigned). This lets you create contrasting colors between the shaded surfaces and the wireframe edges. You can switch these around with the Display Color rollout on page 158 settings on the Display panel.

**Transparency group**

**None** Objects with transparency assigned appear completely opaque, regardless of the transparency settings.

**Simple** Objects with transparency assigned are displayed with a “screen door” transparency effect.

**Best** Objects with transparency assigned are displayed with a two-pass transparency effect.

This option is smoother and closer to rendered transparency effects.

**Apply To group**

Applies the current settings to the active viewport only, to all viewports, or to all the viewports except the active one.
NOTE This applies to the currently active viewport only; it is not a dynamic function.

Rendering Options group

These check boxes modify either the shading modes or the wireframe modes. They refer to the viewport renderer on page 8757 only, not to the scanline renderer on page 8709 or any other renderer.

Disable View Disables the Apply To viewport selection. A disabled viewport behaves like any other viewport while active. However, when you change the scene in another viewport, the view in the disabled viewport does not change until you next activate it. Use this function to speed up screen redraws when you are working on complex geometry.

Disable Textures Select to turn off display of texture maps on page 8631 assigned to objects. Turn off to show the maps assigned to objects.

Texture Correction This option is enabled only when you are using the software display driver on page 8317. When on, 3ds Max redraws the viewport using pixel interpolation (perspective-corrected). The redrawn image remains until you force the viewport to redraw for any reason. This option has an effect only when the viewport is shaded and at least one object’s map is displayed.

Z-Buffer Wireframe Objects Draws the wires ordered according to depth in the scene. Otherwise wires may be drawn out of order to speed the viewport display. This option is generally needed only when sub-object selections are "hidden" by lines drawn out of order. For example, you select the front edges of a box, but they don’t appear highlighted in red, because the white lines from the rear may get drawn last. Activate this only if you find that selections are obscured or if you need the viewport redrawn from back to front.

Force 2-Sided Set to render both sides of faces. See 2-Sided on page 8493. Turn off to render only faces with normals on page 8654 toward the viewer. Usually, you'll want to keep this option off to speed redraw time. You might want to turn it on if you need to see the inside as well as the outside of objects, or if you've imported complex geometry in which the face normals are not properly unified.

NOTE This switch has no effect when the Direct3D graphics driver on page 8313 is active. In this case, to control the visibility of backfacing faces in the viewports, use the Display Properties > Backface Cull on page 166 switch.
Shade Selected Faces  When on, selected faces viewport display in a red semitransparent state. This makes it easier to see selected faces in shaded viewports. Keyboard shortcut=F2.

Use Selection Brackets  Toggles the display of white selection brackets in the viewport display. Turn this off in complex scenes when the display of multiple selection brackets obscures the required view of selected objects.

Display Selected with Edged Faces  Toggles the display of highlighted edges for selected objects when the viewport is in a shaded mode, such as Smooth, Smooth+Highlights, Facets+Highlights, or Facets. When on in these modes, the wireframe edges of selected objects appear along with the shaded surfaces. This is helpful when selecting multiple objects or small objects.

Viewport Clipping  When on, interactively sets a near and far range for viewport display. Two arrows at the edge of the viewport allow you to determine where the clipping occurs. Tick marks correspond to the extents of the viewport, the lower tick is the near clipping plane, and the upper tick sets the far clipping plane. This does not affect the rendering to output, only the viewport display.

Fast View Nth Faces  When on, speeds screen redraw by displaying fewer faces. The Nth Faces spinner sets the number of faces that are displayed when the Fast View mode is active. For example, a setting of 3 displays every third face.

Perspective User View group

Field Of View  Sets the field of view angle for a Perspective viewport. This spinner is not available when any other viewport type is active. You can change the Camera field of view in the Modify panel.

Viewport Layout

Views menu > Viewport Configuration > Viewport Configuration dialog > Layout tab

Click or right-click the General viewport label ("[ + ]") > General viewport label menu on page 8117 > Configure > Viewport Configuration dialog > Viewport Layout tab

You specify the division method of viewports, and assign specific types of views to each viewport on the Layout panel of the Viewport Configuration dialog.
The layout is saved with the MAX scene file, so you can store different layouts in separate scene files. Load the file you want, then merge in the contents of other files to maintain the layout.

**TIP** Through MAXScript, there are commands to set the current layout to any of the 14 available setups. You can also activate any viewport and set the view type. This enables you to create macros and custom user interface buttons to set any layout you choose.

**Interface**

The Layout panel is arranged in two general areas. At the top are icons representing the possible division methods. Below these is a screen representation of the currently selected layout. Click an icon to select the division method, which appears in the larger screen representation.

To assign specific views, click or right-click a viewport in the larger screen representation. Choose a viewport type from the menu that appears.

**Safe Frames**

Views menu > Viewport Configuration > Viewport Configuration dialog > Safe Frames tab
Click or right-click the General viewport label ("[ + ]") > General viewport label menu on page 8117 > Configure > Viewport Configuration dialog > Safe Frames tab

Keyboard > Shift+F

You toggle the status of the video safe frame on page 8703 for the current viewport and adjust its parameters on the Safe Frames panel of the Viewport Configuration dialog.

Safe frame borders show which portions of a viewport will be visible when rendered to video.

Video Safe Frame displays a series of concentric rectangular frames in the viewport. Use Safe Frame to see the proportions of your rendered output within the viewport. This is particularly useful when you are rendering to output that doesn’t match the viewport’s aspect ratio.

The primary purpose of Safe Frames is to suggest safe areas for work intended for display on TV monitors. It is likely that the bezel will cover about 10% of the image so you don’t want important objects or action to fall outside the Action Safe area. High contrast titles falling outside the Title Safe area are likely to bleed or be obstructed by the bezel of the TV screen.
When Safe Frames are displayed in the viewport and a bitmap image is assigned as a viewport background on page 128 using either the Match Viewport or Match Rendering Output options, the image is confined to the Live area of the safe frames and matches the rendered background. This assumes that the same bitmap is assigned to the Environment background using Environment/Screen coordinates.

You can toggle the status of safe frames on page 8703 on or off for the current viewport, and use the Safe Frames panel of the Viewport Configuration dialog to adjust the parameters.

When Safe Frame is displayed in the viewport and a bitmap image is assigned as a background, and Show Background is on, the image is confined to the Live area of the safe frame. If you are using a background image in your rendering, make sure that your rendering output size matches the background image size. This avoids distortion.

**Interface**

- **Setup**
  - Live Area
  - Region (when Region Rendering)

- **Percent Reductions**
  - Action Safe: 10.0
  - Title Safe: 20.0
  - User Safe: 30.0
  - 12:Field Grid: 4 x 3, 12 x 9

- **Application**
  - Show Safe Frames in Active View

---

8382 | Chapter 24  Customizing the User Interface
Setup group

The Safe Frames panel contains settings for the following frame types:

Live Area (mustard) The area that will actually be rendered, regardless of the size or aspect ratio of the viewport.

Action Safe (cyan) The area in which it's safe to include your rendered action. The Lock check box lets you lock the aspect ratio of the Action frame. When Lock is on, use the Both spinner to set the percentage of the live area that's trimmed within the safe frame. When Lock is off, you can use the Horizontal and Vertical spinners to set these parameters independently. Default=10% of Live Area.

Title Safe (light brown) The area where it's safe to include titles or other information. When used correctly, this is smaller than the Action frame. The Lock check box lets you lock the aspect ratio of the Title frame. When Lock is on, use the Both spinner to set the percentage size of the title frame relative to the action area. When Lock is off, you can use the Horizontal and Vertical spinners to set these parameters independently. Default=20% of Live Area.

User Safe (magenta) Displays an additional safe frame that you can use for any custom requirements. The Lock check box lets you lock the aspect ratio of the User frame. When Lock is on, use the Both spinner to set the percentage size of the user frame relative to the action area. When Lock off, you can use the Horizontal and Vertical spinners to set these parameters independently. Default=20% of Live Area.

12-Field Grid Displays a grid of cells (or fields) in the viewport. In this case, "fields" are cells in the grid, and not scanline fields.

The "12-field grid" is a method used by video directors to refer to specific areas of the screen. A director might ask you to move an object two fields to the left and four fields down. The 12-field grid is a reference for this type of placement.

4 x 3/12 x 9 Lets you choose between two matrices of either 12 or 108 cells.

Application group

Show Safe Frames in Active View Toggles the frame displays on or off for the current viewport. This option is duplicated by the Show Safe Frames option on the POV viewport label menu on page 8122.

Default Settings Resets all values to the default values.
Adaptive Degradation Options

Status bar > Right-click the Adaptive Degradation button.

Views menu > Viewport Configuration > Viewport Configuration dialog > Adaptive Degradation tab

Click or right-click the General viewport label (“[ + ]”) > General viewport label menu on page 8117 > Configure > Viewport Configuration dialog > Adaptive Degradation tab

You adjust the adaptive viewport redraw methods on the Adaptive Degradation panel of the Viewport Configuration dialog. The adaptive degradation on page 8498 settings are saved with your MAX scene file.

To toggle adaptive degradation, click the Adaptive Degradation button on the prompt line, or press O.

This is handy when you're adjusting lights and want to see their effect, real time, in a shaded viewport. Or you might be adjusting the camera and need to see complex geometry exactly as it is.
Example showing four degrees of adaptive degradation, depending on distance from camera
Interface

Adapt Object Display by Priority

- Use Current Display Mode
- Fast Shaded
- Wireframe
- Bounding Box
- Point Helper
- Hide Objects

Maintain Frames Per Second: 10.0

- Draw Backfaces during Degrade
- Never Degrade Selected
- Degraded to Default Lighting
- Never Redraw After Degrade

Prioritize Scene Objects

Distance from Camera: 0.10

Force objects displayed smaller than 40 pixels to the lowest priority

Maintain Frames Per Second

Lets you set the frame rate on page 8585 in frames per second that adaptive display will attempt to maintain. If the frame rate drops below this, 3ds Max will increase the amount of degradation based on the other settings on this panel.

Draw Backfaces during Degrade

When on, forces 3ds Max to draw polygons facing away from the point of view during degradation. Applies only to wireframe views. When off, can improve performance by culling backfaces during degradation.

Never Degrade Selected

When on, selected objects are not subject to degradation.
TIP  You can use the Never Degrade object property on page 291 to specify that 3ds Max should not subject an object to degradation, regardless of its selection status.

Degrade to Default Lighting  When on, improves performance by turning off all viewport lights and enabling default lighting during degradation.

Never Redraw After Degrade  When off, viewport display will restore as frame rate improves, redrawing all degraded objects. If this takes too long, turn it on. When on, objects will degrade but never redraw on mouse up, always displaying at the most recent level of degradation.

NOTE  As viewport degradation occurs, the Adaptive Degradation button on the status bar turns aqua, as shown here. Normally, when the degradation stops, the color returns to gold, but when Never Redraw After Degrade is on, the background remains aqua, even when active degradation is not happening. To resolve this, either turn off Adaptive Degradation or turn off Never Redraw After Degrade. Then, to redraw the screen, press ~.

Prioritize Scene Objects group

Distance from Camera/Screen Size  Use this slider to specify whether 3ds Max gives higher priority to objects based on their distance from the camera or their screen size, regardless of distance from the camera. The two criteria, represented by either end of the scale, are defined as follows:

■ Distance from Camera  This sets the priority for each object based on its distance from the camera or screen. The farther the object, the lower its priority and the faster it will degrade. Higher values display closer objects regardless of their size.

■ Screen Size  The size of the bounding box in pixels. The smaller the object, the lower its priority and the faster it will degrade. Higher values degrade smaller objects regardless of their distance.

If you move the slider all the way to either end of the scale, 3ds Max sets priorities based exclusively on that criterion. However, because it’s a sliding scale, you can use both criteria on a weighted basis. For example, if you set one end to 0.66, the other is set to 0.34, meaning that 3ds Max takes both criteria into account in determining priorities, but gives the criterion set to 0.66 about twice as much weight as the other.
To return this parameter to its default setting (0.10/0.9), indicated by the tick mark on the scale, right-click the slider.

**Force objects displayed smaller than ... pixels to the lowest priority** Objects smaller than the specified size on the screen, in pixels, always use the lowest available priority setting (in the Adapt Object Display By Priority group) during degradation.

## Regions

Views menu > Viewport Configuration > Viewport Configuration dialog > Regions tab

Click or right-click the General viewport label (“[ + ]”). > General viewport label menu on page 8117 > Configure > Viewport Configuration dialog > Regions tab

On the Regions panel of the Viewport Configuration dialog, you specify default selection rectangle sizes for the Blowup Region and the Sub Region, and the parameters for setting up a virtual viewport.

The rectangular selection region appears when you render with either Blowup or Region selected in the **Render Type List** on page 6542. You can change the size of the region by dragging its handles.

The Virtual Viewport options let you zoom in on a sub-region of the current viewport, creating a “virtual viewport” where you can perform any standard navigation, but in a zoomed-in area. This function works only when you're using an OpenGL driver. If you're using the software driver, these controls are disabled.

You can use the virtual viewport on any type of viewport, but it's primarily designed for zooming in on camera views. This lets you perform close-up work, such as tracing, without distorting the relationship between the geometry and a bitmap background. (See Lock Zoom/Pan in **Viewport Background** on page 128 for similar functionality in orthographic views.)

Because you're actually zooming the viewport image itself, the viewport label might be hidden from display, but you can still right-click in the upper-left area of the viewport to display the menu. This takes advantage of zooming features in the Open GL driver so that 3ds Max does not compute the display change internally.
Procedures

To use the virtual viewport:

1. Make sure you're using an OpenGL driver on page 8313 for your display.

2. Activate the viewport to convert to a virtual viewport (typically a camera viewport that is displaying a bitmap background).

3. Choose Views menu > Viewport Configuration and click the Regions tab.

4. Click Use Virtual Viewport. A reduced image of the viewport displays in the dialog, along with a white zoom rectangle representing the virtual viewport.

5. Use the Zoom, X Offset, and Y Offset spinners to adjust the size and position of the virtual window, or drag the white window anywhere within the image.

6. Click OK.

   The viewport is converted to a virtual viewport and displays the area of viewport represented by the white rectangle. All viewport navigation methods work the same, except that you're seeing only the zoomed portion of the viewport.

7. To close the virtual viewport, go to Viewport Configuration > Region Tab and turn off virtual viewport. You can get to the Viewport configuration menu by right-clicking any of the viewport navigation tools or by going to Views menu > Viewport Configuration.
The Regions panel contains spinners for setting the four corners of the region (in pixels), and the following options.

**Virtual Viewport**

Use **Virtual Viewport** Enables the virtual viewport. A reduced image of the viewport appears in the dialog, along with a white zoom rectangle representing the virtual viewport.

**Zoom, X Offset, and Y Offset** Adjusts the size and position of the virtual window. You can also drag the white window anywhere within the image.

**Statistics**

Views menu > Viewport Configuration > Viewport Configuration dialog > Statistics tab
Click or right-click the General viewport label ("[ + ]") > General viewport label menu on page 8117 > Configure > Viewport Configuration dialog > Statistics tab

Use these controls to display statistics in the viewports concerning the number of vertices, polygons, and so on. Statistics can pertain to the scene or the active selection; they can also display a real-time count of the number of frames per second displayed. To toggle display of the statistics in a viewport on the fly, right-click the General viewport label menu on page 8117 and choose Show Statistics.

**Interface**

![Statistics Interface]

**Setup group**

**Polygon Count** Enables the polygon count display.

**Triangle Count** Enables the triangle count display.

**Edge Count** Enables the edge count display.

**Vertex Count** Enables the vertex count display.

**Frames Per Second** Enables the FPS count display.

**Total** Displays only the statistics for the entire scene.

**Selection** Displays only the statistics for the current selection.
Total + Selection Displays the statistics for the entire scene and current selection.

Application group

Show Statistics In Active View Enables the statistics display.

Default Settings Returns all options to the original settings.

Lighting and Shadows

Views menu > Viewport Configuration > Viewport Configuration dialog > Lighting And Shadows tab

Click or right-click the General viewport label (“[ + ]”). > General viewport label menu on page 8117 > Configure > Viewport Configuration dialog > Lighting And Shadows tab

Click or right-click the Shading viewport label. > Shading viewport label menu on page 8130 > Lighting and Shadows > Configure > Lighting and Shadows tab

The Lighting And Shadows tab sets preferences for lighting and shadow display in shaded viewports. See Previewing Shadows and Other Lighting in Viewports on page 5335.
Interface

Viewport Lighting Options (Viewport Shading) group

Illuminate Scene With subgroup

- **Scene Lights**  (The default.) Illuminates the viewport using light objects in the scene.

- **Default Lights**  Illuminates the viewport using the default lights. If no lights exist in the scene, the default lighting is used automatically, even when Scene Lights is chosen. Sometimes the lighting you create in the scene can make objects difficult to see in the viewport. The default lighting displays the objects with even illumination. You can use either one or two lights. By default, 3ds Max uses one default light.

- **1 Light**  (The default.) Provides an over-the-shoulder light with 20% faster redraws at the expense of less natural illumination.
A single default light is linked to the camera and moves when you change your viewport point of view.

- **2 Lights**  Provides more natural illumination, but slower viewport performance.
Two default lights are placed opposite to each other.

The key light, A, is in front of the object, on the upper-left side, while the fill light, B, is behind on the lower-right side.

**Enable Hardware Shading** When on, the viewport is displayed using your system’s hardware shader. Default=off.

Most of the remaining settings on this panel are available only when Enable Hardware Shading is on.

**Auto Display Selected Lights** When on, light from selected lights is automatically displayed in shaded viewports. Default=off.

Available only when Enable Hardware Shading is on.
Apply To subgroup

These options set the scope of the settings in the main Viewport Lighting Options group.

■ **Active Viewport Only**  (The default.) Settings apply only to the active viewport.

■ **All Viewports**  Settings apply to all viewports in the current configuration.

■ **All but Active**  Settings apply to other viewports in the current configuration, but not the active viewport.

Shadow Options subgroup

These options are available only when Enable Hardware Shading is on in the Viewport Lighting Options group.

Enable Ambient Occlusion  When on, previews the effect of ambient occlusion on page 5850 in the viewport. Default=off.

You need to be using the Best (SM3.0) option to preview ambient occlusion.
Top: Viewport ambient occlusion off

Bottom: Viewport ambient occlusion on, using default settings. Note the realistic shadowing in the corners and around the teapot.

**NOTE** Viewport ambient occlusion is a global effect, and is not affected by material and other local settings.

- **Quality slider**  
  Sets the quality of the ambient occlusion preview. You can choose Low, Medium, or High. Default=Low.

- **Sample Radius**  
  Sets the sample radius, in 3ds Max units, to use when looking for occluding objects. Default=30.0.

**Enable Shadows** When on, previews shadows in viewports. (See Previewing Shadows and Other Lighting in Viewports on page 5335.) Default=off.
Top: Viewport shadows with hard edges
Bottom: Viewport shadows with soft edges

- **Hard Shadow**  (The default.) Uses hard edges for shadow previews.
- **Soft Shadow**  Uses soft edges for shadow previews. You need to be using the Best (SM3.0) option to preview soft-edged shadows.

These options are available only when Enable Hardware Shading is on in the Viewport Lighting Options group.

- **Use Environment Background Color**  When on, displays the viewport using the environment background color. Default=off. This option does not support background environment maps.

- **Enable Exposure Control in Viewport**  When on, displays the viewport using the active exposure control on page 7207. Default=off. You need to be using the Best (SM3.0) option to preview exposure control.
Top: Viewport without exposure control
Center: Viewport with exposure control
Bottom: Rendered output (without final gathering)

Global Settings (applies to All Viewports) group

These options are available only when Enable Hardware Shading is on in the Viewport Lighting Options group.

Quality / Hardware Support subgroup

- **Good (SM2.0 Option)** Displays shadows at the SM2.0 level.
- **Best (SM3.0 Option)** Displays shadows at the SM3.0 level, with opacity mapping.
  Only the Best level allows you to preview soft-edged shadows, ambient occlusion, or tone mapping.

Viewport Shadows and Ambient Occlusion subgroup

Viewport Shadow Intensity Sets the intensity of shadows in the viewport preview, with 1.0 being full intensity, and zero being no intensity (shadows are invisible). Default=1.0.

Transparency Support in Ambient Occlusion When on, the ambient occlusion preview takes into account the transparency of objects. Default=on.

**NOTE** When you render using ambient occlusion, transparency is always used in the calculation.

ViewCube

Views menu > ViewCube > Configure
Right-click the ViewCube. > Configure
Views menu > Viewport Configuration > Viewport Configuration dialog > ViewCube tab
Click or right-click the General viewport label (“[ + ]”). > General viewport label menu on page 8117 > ViewCube > Configure > ViewCube tab

8400 | Chapter 24  Customizing the User Interface
These controls affect interaction with the ViewCube feature on page 86. Any changes in settings persist between sessions.

**Interface**

![Image of ViewCube interface options]

**Display Options group**

**Show the ViewCube** Lets you choose whether to display the ViewCube in all visible viewports, or only in the active viewport.
- In All Views
- Only in Active View

**ViewCube Size** Choose a size from the drop-down list. The choices are Tiny, Small (the default), Normal, and Large. At Tiny, the cube does not contain labels.

**Inactive Opacity** Sets the opacity of the ViewCube when not in use. Choose an opacity value from the drop-down list. The choices are 0%, 25%, 50%, 75%, and 100%. At 0%, the ViewCube is visible only when the mouse cursor is over its location. At 100%, the ViewCube is solid at all times. At lower opacities, the ViewCube obscures the viewport contents to a lesser extent.
When Dragging on the ViewCube group

Snap to closest view When on and you drag the ViewCube to rotate the view, the viewpoint will snap to one of the fixed views when its angle is close to that of one of the fixed views.

When Clicking on the ViewCube group

These settings apply specifically to clicking the ViewCube, not dragging it.

Fit-to-View on View Change When on, clicking the cube (face, corner, or edge) automatically zooms the view to fit the current selection. When off, no zooming is performed when clicking the cube.

Use Animated Transitions when Switching Views When on, and you change the view by clicking the cube, the new view rotates into place. When off, the new orientation snaps into view instantly. The latter mode is faster and is recommended for experienced users, but new users should keep this switch on to stay better oriented within the scene.

Keep Scene Upright Prevents the scene from appearing to flip over partially or fully. For example, with this off, going to the Top view and then clicking the upper edge of the ViewCube causes the scene to appear to rotate 45 degrees upside-down. But with Keep Scene Upright on, doing so simply rotates to an angled-down view.

Compass group

Show the Compass below the ViewCube When on, displays a compass below the ViewCube for determining the view orientation in a geographic context.

Angle of North (degrees) Lets you specify the compass orientation. For example, to rotate the compass a quarter-turn clockwise, set Angle of North to 90.0.

SteeringWheels

Views menu > SteeringWheels > Configure

Click the Wheel menu button at the lower-right corner of the SteeringWheels. > Configure

Views menu > Viewport Configuration > Viewport Configuration dialog > SteeringWheels tab
Click or right-click the General viewport label ("[ + ]") > General viewport label menu on page 8117 > SteeringWheels > Configure > SteeringWheels tab

These controls affect interaction with the SteeringWheels feature on page 93. Any changes in settings persist between sessions.

**Interface**

[Image of the SteeringWheels interface]

**Display Options group**

**Big Wheels** Use the sliders to specify the size and opacity of the standard-size wheels. The changes take place when you click OK.

- **Size** Sets the size of the Full Navigation Wheel, View Object Wheel, and Tour Building Wheel.

- **Opacity** Sets the opacity of the Full Navigation Wheel, View Object Wheel, and Tour Building Wheel.

**Mini Wheels** Use the sliders to specify the size and opacity of the small wheels. The changes take place when you click OK.

- **Size** Sets the size of the Mini Navigation Wheel, Mini View Object Wheel, and Mini Tour Building Wheel.
Opacity  Sets the opacity of the Mini Navigation Wheel, Mini View Object Wheel, and Mini Tour Building Wheel.

Show Tool Messages  Toggles the display of tool messages such as “Press the arrow keys to move” for the Look tool.

NOTE  Not all tools have tool messages.

Show Tool Tips  Toggles the display of the tool tips that display when you hover the mouse cursor over a control.

Always Show the Pinned Wheel on Start  When on, and you first start 3ds Max, the SteeringWheels automatically appear at the mouse cursor position. When off, the SteeringWheels must be activated manually. Default=off.

Look Tool group

Invert Vertical Axis  Affects how vertical mouse dragging controls view movement with the Look tool. When on, dragging upward moves the viewpoint upward, and dragging downward moves the viewpoint downward. When off, dragging upward moves the viewpoint downward, and dragging downward moves the viewpoint upward. Default=off.

Walk Tool group

Constrain Walk Movement Angle to Ground Plane  When on, constrains Walk motion (Forward, Backward, Left, Right, Up, and Down) relative to the world XY plane regardless of the current Look Direction. When off, Walk motion occurs perpendicular to the view plane. Default=on.

Speed Factor  Sets the relative rate of Walk motion. Range=0.1 to 10.0. Default=10.0.

Zoom Tool group

Incremental Zoom-in  When on, and you’re using the Zoom tool on page 113 on the Full Navigation wheel on page 101, you can zoom in by a factor of 25 percent by clicking. When off, you must drag to zoom using the Zoom tool on the Full Navigation wheel.

Orbit Tool group

Keep the Scene Upright  Prevents the scene from rotating so that it appears to be upside down when using the Orbit tool on page 107.
Selection Sensitivity When on, using the Orbit tool on page 107 rotates the view around the current selection, rather than a predefined center.

Strokes

Customize menu > Preferences > Preference Settings dialog > Viewports tab > Mouse Control group > Stroke

Strokes are a way to assign command shortcuts to mouse or tablet drag patterns. For many operations, strokes are more convenient than keyboard shortcuts because they can select an object and apply a command to it.

For example, you can assign Orbit to a downward stroke. When you draw this stroke, 3ds Max changes to Orbit mode. You can assign a circular stroke to the Hide Selected command so that it both selects the objects and then hides all the objects in the bounding extents of the stroke pattern.

You can use strokes in two ways:

■ If you have a middle mouse button, you can define and use strokes by specifying the Stroke option for the middle mouse button in the Viewports tab on page 8308 of the Customize menu > Preferences dialog.

■ To define and use strokes with the left mouse button, use the Strokes utility on page 8417 and turn on Draw Strokes.

Using the Keyboard with Strokes

The same stroke pattern can perform four different functions by holding Shift, Alt, or Shift+Alt when drawing the stroke:

■ Drawing a vertical line is one type of stroke.

■ Holding Shift while drawing the same line is another type.

■ Holding Alt while drawing it is a third type.

■ Holding both Shift and Alt while drawing the line is a fourth type. Holding Ctrl while drawing a stroke indicates that you want to define a new stroke, rather than use an existing stroke.

NOTE Changes you make to the set of strokes are saved with 3ds Max and persist from session to session.
Procedures

To define and use strokes with the middle mouse button:

1. Choose Customize menu > Preferences > Preference Settings dialog > Viewports tab.
2. In the Mouse Control group, turn on Stroke.
   You must turn on this option for all Stroke functions to work with the middle mouse button.
3. Hold the middle mouse button and drag in a viewport to make a stroke. If the stroke hasn’t been defined, a dialog appears where you can click Define to define the stroke. If the stroke has already been defined, the corresponding function is executed.
   See Defining Strokes on page 8407 for information on defining and editing strokes.

To define and use strokes with the left mouse button:

1. Choose Utilities panel > Utilities rollout > More button > Utilities dialog > Strokes.
2. Turn on Draw Strokes.
3. Hold the left mouse button and drag in a viewport to make a stroke. If the stroke hasn’t been defined, a dialog appears where you can click Define to define the stroke. If the stroke has already been defined, the corresponding function is executed.
   See Defining Strokes on page 8407 for information on defining and editing strokes.

Example: To assign Object Properties to a stroke:

1. Use one of the first two procedures to activate strokes.
2. Hold down Ctrl, and drag from top to bottom and then back up to the starting point.
3. The Define Stroke dialog appears, and the name of the stroke is "HKKH."

NOTE Depending on how you drew your stroke sequence, it might be defined by different letters. This is fine, as long as you use the same sequence to enact the stroke after you have finished defining it.
If an alert appears, you've either drawn the stroke incorrectly, or this stroke has already been assigned. Continue with the following steps to replace the defined stroke.

4 Choose the Properties command from the Command To Execute list.

5 The option enabled is Single Object At Start Of Stroke, because that's the logical choice for the Object Properties command.

6 Click OK.

7 Drag vertically down and back up over any object in the scene to display the Object Properties dialog for that object.

**Example: To assign Hide Selection to a stroke:**

1 Use one of the first two procedures to activate strokes.

2 Hold down Ctrl, and drag vertically from top to bottom.

3 In the alert that appears, click Yes to redefine the stroke and display the Define Stroke dialog.
   The name of this stroke is HK.

   **NOTE:** Depending on how you drew your stroke sequence, it might be defined by different letters. This is fine, as long as you use the same sequence to enact the stroke after you have finished defining it.

4 Choose Hide Selection from the list.

5 Choose All Objects in the Selection Set.

6 Click OK.

7 Load a scene containing several objects, and select two or more objects.

8 Drag vertically from top to bottom in the viewport.
   The selected objects are all hidden.

---

**Defining Strokes**

Hold down Ctrl and the middle mouse button and drag in a viewport to create the shape of an unused stroke. > Define Strokes dialog
Hold down the middle mouse button alone or with Shift, Alt, or both, and drag in a viewport to create the shape of an unused stroke. > Define > Define Strokes dialog

Utilities panel > Utilities rollout > More button > Utilities dialog > Strokes > Draw Strokes > Hold down the left mouse button alone or with Shift, Alt, or both, and drag in a viewport to create the shape of an unused stroke. > Define > Define Strokes dialog

You define a stroke by creating the stroke in a viewport, then choosing the command that the stroke defines. The next time you perform the stroke, the command will be executed. You can define strokes to work in conjunction with the Shift key, the Alt key, or both Shift and Alt.

You can define strokes with either the left or middle mouse button. If you want to use your middle mouse button to define and use strokes, you must first turn on Customize menu > Preferences > Preference Settings dialog > Viewports tab on page 8308 > Mouse Control group > Stroke. To define and use strokes with the left mouse button, choose Utilities panel > Utilities rollout > More button > Utilities dialog > Strokes on page 8417 > Draw Strokes, then draw the strokes.

In the Define Stroke dialog, you can see how the strokes are analyzed by examining the grid under Stroke to Define. When you complete the drawing of a stroke, a nine-square grid is centered around the stroke and fit to its extents. The inner segments of the grid are assigned unique letters. Where the stroke crosses a segment, the letter associated with that segment is added to the stroke name. Thus, the direction and the shape of the stroke matter, but the size of the stroke has no effect.

The stroke is always centered within the grid. If you draw a stroke vertically from top to bottom, the stroke is named HK because it crossed the segments labeled H and K, in that order. Had you drawn the stroke from bottom to top, it would have been named KH.

**TIP** You can define more than one stroke for the same command. For example, you might assign a U-shape stroke to Undo, but find that you sometimes draw a J shape when attempting the U. By assigning both the U and the J strokes to Undo, you don’t have to worry about missing that stroke.

The Command Should Operate On group of options is important. If the command applies to selections, leave this option set to Single Object at Start of Stroke, or change it to All Objects in the Selection Set. However, if the command doesn't apply to selections, such as Orbit or Activate Grid Object, change it to No Objects Just Execute the Command.
See also:

- Reviewing and Editing Strokes on page 8412
- Stroke Preferences Dialog on page 8414
- Viewport Preferences on page 8308
- Strokes Utility on page 8417

Procedures

To define a stroke using the Ctrl key:

1. Hold down the Ctrl key while drawing a stroke.
2. If the stroke already exists, a message asks you if you want to replace the old stroke. Click Yes.
3. On the Define Stroke dialog that appears, assign the stroke.

To define a stroke by example:

1. Draw a stroke that doesn't exist.
3. In the Define Stroke dialog that appears, assign the stroke.
Interface

Stroke to Define group

Displays the name of the stroke and displays the stroke you just drew as a series of white Xs connected by white lines. A green X represents the start of the stroke and a red X represents the end. The labeled grid shows you how it recognizes the stroke. Where the stroke crosses the labeled segments in the grid, a letter is added to the name of the stroke.

Command to Execute group

Lists all commands to which you can assign a stroke. Select a command and click OK to assign the stroke displayed in the grid to the selected command. Depending on the type of command you choose in this list, various options become available in the Command Should Operate On group.
Currently assigned to stroke Displays the name of the stroke currently assigned to the selected command. If you pressed Shift or Alt when the stroke was drawn, they’re added to the name. For example: "Shift + HK" or "Alt + HK."

Command Should Operate On group

Provides a number of options that specify which objects (if any) are affected by the command. These options are enabled or disabled depending on the type of command you’ve selected in the list window.

No Objects Just Execute the Command This text is displayed when you choose a command that’s not specific to selected objects, such as Orbit. When you select a command that can be applied to selected objects, the following options become enabled:

Single Object at Start of Stroke Causes the command to act on the object beneath the first stroke point in the active viewport.

All Objects in the Selection Set Causes the command to act on all objects in the current selection set.

Multiple Objects Based On The Stroke Boundary group

Choosing one of the options in this group lets you use the stroke itself to select multiple objects and then apply the command.

All Objects in Rectangle Extents Selects all objects defined by the rectangular bounding of the stroke.

All Objects in Circular Extents Selects all objects defined by the largest circle that fits within the rectangular bounding of the stroke.

Window/Crossing When you choose either of the previous two options, these two options become available. Window selects only those objects entirely within the rectangular or circular region. Crossing selects all objects within or crossing the region.

Current Stroke Set group Displays the name of the current stroke set, so you can review the strokes defined in that set. You can create and save a number of different stroke sets. See Stroke Preferences on page 8414.

Review Click to display the Review Strokes dialog on page 8412, in which you can choose from a list of defined strokes and then see the stroke itself. You cannot edit strokes this way. To view, change, and delete strokes, draw the Review Strokes stroke (by default, a horizontal line from left to right).
Reviewing and Editing Strokes

Define Strokes dialog > Click Review.

Draw the Review Strokes stroke. By default, this is a horizontal line from left to right.

You can view defined strokes in the Review Strokes dialog. Depending on how you display this dialog, you can also change or delete defined strokes.

■ Click the Review button in the Define Strokes dialog on page 8407 to view strokes, but not change or delete them.

■ Draw the Review Strokes stroke (by default, a horizontal line from left to right) to view, change, and delete strokes. You can redefine the Review Strokes stroke in the Review Strokes dialog.

Procedures

To change the command assigned to a stroke (or vice versa):

1 Select a command (or stroke) from the list.
2 Click Change. The Define Strokes dialog appears.
3 Select the new stroke to assign.
4 Click OK in the Define Strokes dialog to assign the selected stroke to the command currently highlighted in the Review Strokes dialog.
Interface

Defined Strokes

Displays a list of commands that currently have strokes assigned to them and the name of the current stroke set.

Make Camera Active Point at a single camera (not the target), draw the stroke, and that camera becomes active in the viewport in which you draw the stroke.

Change Light Color You can stroke this command over one or more lights. The color selector appears, so you can change the color of the selected lights.

Light On/Off Toggle Stroke over a light to toggle it on and off. If you stroke over two or more lights, all the lights are set to a common state, either all on or all off.

Set Constraints Displays a small dialog with the available axis constraints. Double-click to change the axis constraints for the current transform mode.

Move Mode (Set Constraints) Switches to Move transform mode and displays a small dialog with the available axis constraints. Double-click to change the axis constraints for the current transform mode.
Rotate Mode (Set Constraints) Switches to Select and Rotate mode and displays a small dialog with the available axis constraints. Double-click to change the axis constraints for the current transform mode.

Scale Mode (Set Constraints) Switches to Select and Scale mode and displays a small dialog with the available axis constraints. Double-click to change the axis constraints for the current transform mode.

Review Strokes Displays the Review Strokes dialog.

Stroke Preferences Displays the Stroke Preferences dialog on page 8414.

Show As

Provides two options that specify how commands are displayed in the list.

Command Name Displays the assigned strokes by command name (for example, Play Animation).

Stroke Name Displays the assigned strokes by their stroke name (for example, HK).

Change Assigns a different stroke to the command, or vice versa, depending on whether commands or strokes are displayed in the list.

NOTE This command is only available when the dialog is accessed by drawing the Review Strokes stroke.

Delete Removes the selected command (or stroke) from the list, and the command is no longer assigned to the stroke.

NOTE This command is only available when the dialog is accessed by drawing the Review Strokes stroke.

Information on Selected Stroke

Displays the name and shape of the stroke selected in the list window.

Stroke Preferences Dialog

Draw the Stroke Preferences stroke. By default, this is an inverse L, drawn vertically from bottom to top, and then horizontally from left to right.

Set up a stroke to access the Stroke Preferences dialog > Use the stroke
With the Stroke Preferences dialog you can save sets of strokes and set other stroke properties.

**NOTE** This dialog is available only by drawing its stroke (by default, an inverse L, drawn vertically from bottom to top, and then horizontally from left to right). You can redefine the Stroke Preferences stroke in the Review Strokes dialog on page 8412.

**NOTE** By default, the Strokes Preferences dialog is available only if you assign a stroke to it, then use the stroke to access the dialog. See the following procedure.

**Procedures**

**To access the Strokes Preferences dialog:**

1. Set up strokes for your left or middle mouse button. See Strokes on page 8405 for information how to do this.

2. To define the stroke, hold down Ctrl and drag an inverted L shape (drag vertically from bottom to top, and continue from left to right). The name of this stroke is JGAB.

3. On the Define Strokes dialog, choose Stroke Preferences from the list.

4. Click OK to close the dialog.

5. Drag an inverted L shape to access the Strokes Preferences dialog.
Interface

Current Stroke Set group

Displays the name and number of strokes in the current set.

- To create a new set, enter a new name in the field and click Save.
- To choose a different set, choose it from the list and click OK.

Save Saves the set displayed in the list.
Delete Deletes the set displayed in the list.
Review Strokes Default Show As Order group

Specifies whether commands or strokes are initially listed in the Review Strokes dialog.

Show Grid Time (ms)

The time it takes, in milliseconds, for the stroke analysis grid to appear in the viewports when you complete a stroke. Set it to 0 to hide the grid. Default=300 (about 1/3 of a second); Range=0 to 2000.

Show Extents Time (ms)

The time it takes, in milliseconds, for the extents of the stroke to appear in the viewports. Range=0 to 2000. Set it to 0 to disable this feature. Default=300 (about 1/3 of a second).

Strokes that operate on the First Point display a small X. Strokes that operate on items in the bounding box of the stroke display the bounding box. Strokes that operate on the circular extents display a circle that fits inside the square bounding box of the stroke. Window selections appear solid. Crossing selections appear dotted.

Stroke Point Size

The size, in pixels, of Xs drawn in the viewports that allow you to visualize the stroke shape. Default=4; Range=3 to 20.

Strokes Utility

Utilities panel > Utilities rollout > More button > Utilities dialog > Strokes

The Strokes utility lets you launch commands by dragging left-button mouse patterns in a viewport. When you launch the Strokes utility, a modeless dialog appears containing a single Draw Strokes button. When the Draw Strokes button is active, you can define and use strokes with the left mouse button.
The Strokes system is also available as an option for the middle mouse button that doesn't require the utility or the modeless dialog. This option can be found on the Viewports tab on page 8308 of the Preferences dialog. For details, see Strokes on page 8405.

Procedures

Example: To define a stroke pattern for Orbit:

1. On the Utilities panel, click the More button, and choose Strokes from the list.
2. On the modeless dialog, click Draw Strokes.
3. Hold down the left mouse button and drag the mouse straight down from top to bottom, then release the mouse button. The length of the stroke doesn't matter, but the direction does. A dialog appears asking you to define the pattern or continue.
4. Click Define to display the Define Stroke dialog.
5. Choose Orbit from the Command To Execute list and then click OK. The pattern is now defined for Orbit.

Example: To turn on Orbit using the Strokes utility:

1. Turn on Draw Strokes in the modeless dialog.
2. In any viewport, hold down the left mouse button and drag the mouse straight down from top to bottom. The length of the stroke doesn't matter, but the direction does. As you drag the mouse, small X's appear, displaying your stroke. When you release the mouse, a 3x3 grid appears briefly, and then 3ds Max switches to Orbit mode.
   If a Stroke Not Found message appears, click Continue, and then repeat step 2.
Keyboard Shortcuts

Keyboard shortcuts are keyboard alternatives you can use to initiate actions (commands or tools) normally accessed with the mouse. For example, to open the Select From Scene dialog, you can press the H key, or you can change the active viewport to a view from the bottom by pressing B. Keyboard shortcuts let you work faster and more efficiently.

Many keyboard shortcuts are already set for most commonly used actions. Throughout this reference, command descriptions include the default shortcut, if there is one: look for the path annotation (with a gray background) at the top of the page.

To modify or add new shortcuts, use the Keyboard panel on page 8250 of the Customize User Interface dialog on page 8249. Keyboard shortcuts are separated by Groups or Categories of groups and they organize Actions.

Groups organize the Actions for which you can set shortcuts. Default=Main UI.

Categories offer a further breakdown of the Actions in a Group to specific categories. This lets you quickly find an Action so you can assign or adjust a shortcut.

Actions are commands or tools.

In most cases you can close a dialog with the same command used to open it. In general this applies to any combination of input methods, including menu, toolbar button, and keyboard shortcuts. For more information, see Toggling Dialogs on page 7983.

Viewing the Assigned Shortcuts

To see the currently assigned keyboard shortcuts, you can create a text (TXT) file of all the actions and their shortcuts. Go to the Keyboard panel on page 8250 of the Customize User Interface dialog on page 8249, and then click Write Keyboard Chart. All actions that can have a shortcut assigned to them are listed. For actions with no default shortcut assigned, the Shortcut column entry is blank.

If you click Reset on the Keyboard panel before you click Write Keyboard Chart, the text files shows the default keyboard shortcut assignments. However, this loses any custom shortcuts you might have created before.
Keyboard Shortcut Override Toggle

Main toolbar > Keyboard Shortcut Override Toggle

The Keyboard Shortcut Override Toggle lets you toggle between using only the "Main User Interface" shortcut keys and using both the main shortcuts and shortcut keys for groups such as Edit/Editable Mesh, Track View, NURBS, and so on.

When the Override toggle is off, only the Main User Interface shortcuts are recognized. When Override is on, both Main UI and functional area shortcuts are recognized; however, if there is a conflict between a shortcut assigned to a feature and one assigned to the Main UI, when Override is on, the feature's shortcut takes precedence.

You can customize keyboard shortcuts on the Keyboard panel on page 8250 of the Customize User Interface dialog on page 8249. The lists in the keyboard panel show which shortcuts have been assigned to which command or feature.

See also:

- Keyboard Shortcuts on page 8419
Find the Information You Need

There are various ways to find information about how to use this program, and multiple resources are available.

This program is a powerful application with tools that help you work with a high level of efficiency and productivity. You install this software with the Installation wizard that starts automatically when you insert the product CD.

This application is often intuitive, but when you do need to look something up, you can save time and avoid frustration if you use the Help system to find information. The Help system is organized in a structured design that makes information easy to locate.

Search For and Receive Information

In the upper right-side of the application window, on the Caption bar on page 7988, you can use InfoCenter to search a variety of information sources with one query. You can also easily access product updates and announcements.

Overview of Searching for and Receiving Information

In the upper right-side of the application window, on the Caption bar on page 7988, you can use InfoCenter to search for information through key words (or by entering a phrase), display the Communication Center panel for product updates and announcements, or display the Favorites panel to access saved topics.

Left: Search field and collapse/expand arrow
When you enter key words or a phrase and then press ENTER or click the InfoCenter Search button, you search multiple Help resources in addition to any files that have been specified in the InfoCenter Settings dialog box. The results are displayed as links on a panel. You can click any of these links to display the Help topic, article, or document.

**NOTE** It is recommended that you use key words to search for information, as key words often produce better results. In case of a misspelled word, spelling suggestions are displayed.

When you click the Communication Center button, the Communication Center panel is displayed. It displays links to information about product updates and product announcements, and may include links to Subscription Center, CAD Manager specified files, and RSS feeds.

When you click the Favorites button, a panel displays saved links to topics or web locations.
Use the Next and Previous buttons to browse search results. Click and drag categories or groups to rearrange them.

Click the pushpin button to make the search panel (or any other InfoCenter panel) remain visible while you use other controls in the application.

While the pushpin is on, the panel does not disappear when you use other application controls. If you click the pushpin button to turn it off again, the panel rolls up when it is not in use.
To rearrange the topics displayed on a panel

1. Display a panel by doing one of the following:

   - In the upper-right side of the application, in the InfoCenter box, enter a keyword or phrase. Then press ENTER or click the InfoCenter Search button.
   - In the upper-right side of the application, on the InfoCenter box, click the Communication Center button.
   - In the upper-right side of the application, on the InfoCenter box, click the Favorites button.

2. Click and drag a category or group header to the desired position.

3. Release the mouse button.

**NOTE** Categories can be rearranged only within a group and cannot be moved into other groups.

To browse search results displayed on a panel

- On the InfoCenter Search Results, Communication Center, or Favorites panel, on the right side of the category header, do one of the following:

  - Click the Next button.
  - Click the Previous button.
Search for Information

You can use InfoCenter to search multiple sources (for example, Help, the New Features Workshop, web locations, and specified files) at one time, or search a single file or location.

When you enter key words or a phrase in the InfoCenter box, and then press ENTER or click the InfoCenter Search button, you search the contents of multiple Help resources as well as any additional documents and web locations that have been specified in the InfoCenter Settings dialog box or through the CAD Manager Control Utility. The results are displayed as links on the InfoCenter Search Results panel. You can click any of these links to display the topic, article, or document.

NOTE It is recommended that you use key words to search for information, as key words often produce better results. In case of a misspelled word, spelling suggestions are displayed.

You can also search a single location by clicking the arrow next to the InfoCenter Search button, and selecting a location or file from the list.

In addition, you can add a location (file or document) to search by clicking the arrow next to the InfoCenter Search button, and selecting Add Search Location from the list.

When you use InfoCenter to search for information, you can use the following special symbols (wild cards) in your query to refine or expand it. These symbols can be used alone or can be combined.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>*</td>
<td>Replaces one or more characters when used at the beginning, middle, or end of a word. For example, “<em>lish”, “p</em>lish”, and “pub*” will all find “publish”. Also, “anno*” will find “annotative”, “annotation”, “annoupdate”, “annore-set”, and so on.</td>
</tr>
<tr>
<td>?</td>
<td>Replaces a single character. For example, “cop?” will find “copy”, but not “copybase”</td>
</tr>
</tbody>
</table>
Symbol | Description
---|---
− | Expands the tense of the word at the beginning or end of a word. For example, “plotting−” will find “plots”, “plotted”, and so on. Also, “−plot” will find “preplot”, “replot”, and so on.

When searching for multiple words in topics, use double quotation marks (" ") to enclose words that must appear next to each other in the specified sequence. For example, enter "specifying units of measurement" to find only topics with all those words in that order. You can also use the previously mentioned symbols (wild cards) in a text string that is enclosed in double quotation marks.

See also:
- Specify InfoCenter Settings on page 8430
- Using the 3ds Max Help on page 8441

To search multiple sources for information
1. In the InfoCenter box, enter a keyword or phrase.
2. Press ENTER, click the InfoCenter Search button, or click the arrow next to the InfoCenter Search button and select All Search Locations.
   The search results are displayed on the Search Results panel.

To search a single location for information
1. In the InfoCenter box, enter a keyword or phrase.

   2. Click the arrow next to the InfoCenter Search button.
   3. Select a location from the list to search.
   4. The search results from that location are displayed on the Search Results panel.
To add a location to search

1. In the upper right-side of the application, on the InfoCenter box, click the arrow next to the InfoCenter Search button.
2. Click Add Search Location.
3. In the Add Search Location dialog box, specify a document or a file location to search.
4. Click Add.

Receive Product Updates and Announcements

Communication Center provides up-to-date product information, software updates, product support announcements, and other product-related announcements.

Overview of Communication Center

To open Communication Center, click the Communication Center button on the InfoCenter box in the upper right-side of the application.

Communication Center provides the following kinds of announcements:

- **Product Support Information**. Get breaking news from the Product Support team at Autodesk, including when Live Update maintenance patches are released.

- **Subscription Announcements**. Receive subscription announcements and subscription program news, as well as links to e-Learning Lessons, if you are an Autodesk subscription member (available in countries/regions where Autodesk subscriptions are offered). For more information about Autodesk Subscription, see Access Subscription Center on page 8437.

- **Articles and Tips**. Be notified when new articles and tips are available on Autodesk websites.

- **CAD Manager Channel**. Receive information (RSS feeds) published by your CAD manager.
- **RSS Feeds.** Receive information from RSS feeds to which you subscribe. (An RSS feed is information published by a website to which you subscribe. RSS feeds generally notify you when new content is posted.) Several default RSS feeds are automatically subscribed to when you install the program.

- **Live Update Maintenance Patches.** Receive automatic notifications whenever new maintenance patches are released from Autodesk.

- **Featured Technologies and Content.** Learn more about third-party developer applications and content.

You can customize the items that display on the Communication Center panel. For more information, see *Specify InfoCenter Settings* on page 8430.

**Communication Center Online Privacy**

Communication Center is an interactive feature that must be connected to the Internet in order to deliver content and information. Each time Communication Center is connected, it sends your information to Autodesk so that you receive the correct information. All information is sent anonymously to Autodesk to maintain your privacy.

The following information is sent to Autodesk:

- Product name (in which you are using Communication Center)
- Product release number
- Product language
- Country/region (specified in the Communication Center settings)
- Your subscription contract number (if you’re a subscription customer)

Autodesk compiles statistics using the information sent from Communication Center to monitor how it is being used and how it can be improved. Autodesk maintains information provided by or collected from you in accordance with the company’s published privacy policy, which is available on http://www.autodesk.com/privacy.

**See also:**

- *Specify InfoCenter Settings* on page 8430
- *Access Subscription Center* on page 8437
Receive New Information Notifications

Whenever new information is available, Communication Center notifies you by displaying a balloon message below the Communication Center button on the InfoCenter box.

Click the link in the balloon message to open the article or announcement. If you prefer not to be notified by Communication Center, you can turn off Balloon Notification in the InfoCenter Settings dialog box. You can also customize the transparency of balloon messages as well as the length of time they are displayed.

See also:
- Specify InfoCenter Settings on page 8430

Save and Access Favorite Topics

In InfoCenter, you can save links as favorites and easily access them later.

Any link that displays on the InfoCenter Search Results panel or Communication Center panel can be marked as a favorite. Links that are marked as favorites are displayed on the Favorites panel. You display the Favorites panel by clicking the Favorites button on the InfoCenter box, in the upper right-side of the application.

A link that is marked as a favorite displays a star icon when the link is displayed on the Search Results panel or the Communication Center panel. You can click the star icon to remove the link’s “favorite” status, which removes it from the Favorites panel.

To display the InfoCenter Favorites panel

In the upper right-side of the application, on the InfoCenter box, click the Favorites button to display the Favorites panel.
**NOTE** The links displayed on the Favorites panel are organized into the same groups or categories from which they were added.

**To save a link in InfoCenter as a favorite**

1. Display a panel by doing one of the following:
   - In the upper right-side of the application, in the InfoCenter box, enter a keyword or phrase. Then press ENTER or click the InfoCenter Search button.
   - In the upper right-side of the application, on the InfoCenter box, click the Communication Center button.

2. Click the Star icon that appears next to the link that you want to save as a favorite.

**To remove a favorite link from the InfoCenter Favorites panel**

1. In the upper right-side of the application, on the InfoCenter box, click the Favorites button to display the Favorites panel.

2. Click the Star icon that is displayed next to the link that you want to remove from the Favorites panel.

**Specify InfoCenter Settings**

You can specify InfoCenter Search and Communication Center settings in the InfoCenter Settings dialog box.

In the InfoCenter Settings dialog box, you can specify the following settings:

- **General.** Your current locations, how often to check for new online content, animated transition effects for panels.
■ **Search Locations.** Locations (documents, web locations and files) to search for information, as well as the name that displays for each location and the number of results to display for each. Also, you can add or remove search locations. The Web Locations checkbox provides access to important information on the Autodesk website, including the Knowledge Base and discussion groups. When you add document locations, you can specify files on your local drive or files on a network.

**NOTE** User-specified CHM files must be located on your local drive. InfoCenter can search CHM files located on network drives.

■ **Communication Center.** Maximum age of the articles displayed on the Communication Center panel and the location and name of the CAD Manager Channel.

■ **Autodesk Channels.** Channels to display in the Communication Center panel as well as the number of articles to display for each channel.

■ **Balloon Notification.** Notifications for new product information, software updates, product support announcements, and Did You Know messages. Also, you can customize the transparency and the display time of the balloon.

**NOTE** Did You Know balloons displayed below the Communication Center button on the InfoCenter box provide knowledge base information and general instructional messages such as tips. You can click on the text or the Expand icon to expand the balloon to view the detailed information.

■ **RSS Feeds.** RSS feed subscriptions. You can add or remove RSS feeds. (An RSS feed is information published by a website to which you subscribe. RSS feeds generally notify you when new content is posted.) Several default RSS feeds are automatically subscribed to when you install the program.

**To specify locations to search for information**

1. **In the upper right-side of the application, on the InfoCenter box, click the arrow next to the InfoCenter Search button.**

2. **Click Search Settings.**
3  In the InfoCenter Settings dialog box, Search Locations panel, in the right pane, select or clear the search locations you want to include or exclude when you search for information.

**NOTE** You can click directly on the search location name to change the name in the right pane of the Settings dialog box.

4  Click OK.

**NOTE** The Search all available languages option allows you to specify whether to search default language or all available languages. This option is deselected by default.

To add a new location to search for information

1  In the upper right-side of the application, on the InfoCenter box, click the arrow next to the InfoCenter Search button.

2  Click Search Settings.

3  In the InfoCenter Settings dialog box, do one of the following:
   ■ On the Search Locations panel, in the right pane, click Add.
   ■ On the Search Locations panel, in the right pane, right-click anywhere in the pane. Click Add.

4  In the Add Search Location dialog box, specify a file location to search.

**NOTE** You can specify a file on your local drive or on a network.

5  Click Add.

6  Click OK.

To remove a location to search for information

1  In the upper right-side of the application, on the InfoCenter box, click the arrow next to the InfoCenter Search button.
2 Click Search Settings.

3 In the InfoCenter Settings dialog box, do one of the following:
   - Select a location to remove, and then click Remove.
   - Right-click a search location. Click Remove.

4 In the Remove Search Location dialog box, click Yes to remove the selected location.

5 Click OK.

To specify the channels to display in the Communication Center panel

1 In the upper right-side of the application, on the InfoCenter box, click the arrow next to the InfoCenter Search button.

2 Click Search Settings.

3 In the InfoCenter Settings dialog box, in the left pane, click Autodesk Channels.

4 In the right pane, select or clear the channels you want to display in the Communication Center panel.

5 Click OK.

To specify InfoCenter balloon notification settings

1 In the upper right-side of the application, on the InfoCenter box, click the arrow next to the InfoCenter Search button.

2 Click Search Settings.

3 In the InfoCenter Settings dialog box, in the left pane, click Balloon Notification.

4 In the right pane, select or clear the options to turn balloon notification on or off.
NOTE You can turn off the balloon notification for Did You Know messages in the InfoCenter Settings dialog box.

5 Enter the number of seconds to set the length of time for balloon notifications to display.

NOTE The default value for the balloon display time is 5 seconds.

6 Enter the transparency value of the balloon or set the value using the slider.

7 Click OK.

To turn on the display of Did You Know hidden messages

1 Click Tools menu ➤ Options.

2 In the Options dialog box, System tab, under General Options, click the Hidden Message Settings button.

3 In the Hidden Message Settings dialog box, select the InfoCenter Did You Know Balloons option to turn on the display of all hidden messages.

4 Click OK.

To add an RSS feed to Communication Center

1 In the upper right-side of the application, on the InfoCenter box, click the arrow next to the InfoCenter Search button.

2 Click Search Settings.

3 In the InfoCenter Settings dialog box, in the left pane, click RSS Feeds.

4 In the right pane, do one of the following:
   ■ Click Add.
   ■ Right-click anywhere in the right pane. Click Add.

5 In the Add RSS Feed dialog box, enter the location of the RSS feed you want to add.

6 Click Add.
To remove an RSS feed from Communication Center

1 In the upper right-side of the application, on the InfoCenter box, click the arrow next to the InfoCenter Search button.

2 Click Search Settings.

3 In the InfoCenter Settings dialog box, in the left pane, click RSS Feeds.

4 In the right pane, do one of the following:
   ■ Click Remove.
   ■ Right-click an RSS feed. Click Remove.

5 In the Remove RSS Subscription dialog box, click Yes to remove the selected RSS feed.

6 Click OK.

Learn the Product

Training programs and products from Autodesk help you learn the key technical features and improve your productivity. For the latest information about Autodesk training, visit http://www.autodesk.com/training or contact your local Autodesk office.

Autodesk Authorized Training Centers

The Autodesk® Authorized Training Center (ATC®) network delivers Autodesk-authorized, instructor-led training to design professionals who use Autodesk software. Autodesk Authorized Training Centers use experienced and knowledgeable instructors. More than 1,200 ATC sites are available worldwide to meet your needs for discipline-specific, locally based training.

To find a training center near you, contact your local Autodesk office or visit http://www.autodesk.com/atc.
**Autodesk Official Training Courseware**

Autodesk Official Training Courseware (AOTC) is technical training material developed by Autodesk. Designed for traditional 1/2-day to 5-day, instructor-led classroom training and used by Authorized Training Centers and other Autodesk partners, AOTC is well-suited for self-paced, stand-alone learning. The manuals cover key concepts and software functionality with hands-on, step-by-step, real-world exercises. You can purchase AOTC from your local reseller or distributor, or you can order it online from the Autodesk Store at [http://www.autodesk.com/aotc](http://www.autodesk.com/aotc).

**e-Learning**

Autodesk e-Learning for Autodesk Subscription customers features interactive lessons organized into product catalogs. Each lesson is 20-40 minutes in length and features hands-on exercises, with an option to use a simulation of the product or the actual application. You can also use an online evaluation tool that identifies gaps in skills, determines what lessons will be most helpful, and gauges learning progress.

If you are a member of Autodesk subscription, you can access e-Learning and other subscription services from within your Autodesk product. For more information about how to access e-Learning in the product, see [Access Subscription Center](http://www.autodesk.com/subscriptioncenter) on page 8437. For more information about Autodesk subscription resources, visit [http://www.autodesk.com/subscriptioncenter](http://www.autodesk.com/subscriptioncenter).

**Autodesk Developer Network**

The Autodesk Developer (ADN) program for ADN members provides support for full-time, professional developers who want to build software based on Autodesk products. As an ADN member, you will receive the business, software, support, and training you need to be successful. If you are a developer, visit [http://www.autodesk.com/adn](http://www.autodesk.com/adn).

**Autodesk Consulting**

Autodesk Consulting provides services that help set up processes and provide critical training that will help increase productivity so you can capitalize on the power of your products. For more information on general consulting, systems integration, or custom training services, visit [http://www.autodesk.com/consulting](http://www.autodesk.com/consulting).
Partner Products and Services

Autodesk works together with thousands of software partners around the world. These partners provide products and services that enhance Autodesk products for design professionals. Visit the Partner Products & Services page at http://www.autodesk.com/partnerproducts for a list of resources available for your Autodesk product and your industry.

Access Subscription Center

The Subscription Center is available to subscription members from within the product. If you are a subscription member, you can access subscription services by clicking the Communication Center button on the InfoCenter box, in the upper right-side of the application, and then clicking a Subscription Center link. To learn more about Autodesk subscription membership, visit http://www.autodesk.com/subscriptioncenter.

Overview of Subscription Center

With Autodesk Subscription, you get the latest releases of Autodesk software, incremental product enhancements, personalized web support from Autodesk technical experts, and self paced e-Learning. Subscription services are available to subscription members only.

By clicking the Communication Center button in the upper right-side of the application, on the InfoCenter box, members have access to the following options (under Subscription Center):

- **Subscription status.** Checks your subscription status.
- **Create support request.** Provides direct one-to-one communication with Autodesk support technicians. You receive fast, complete answers to your installation, configuration, and troubleshooting questions.
- **View support requests.** Tracks and manage your questions and responses through Autodesk's state-of-the-art support system.
- **Edit Subscription Center profile.** Sets up and maintains your subscription account.
View e-Learning catalog. Features interactive lessons organized into product catalogs.

e-Learning Lessons. (For subscription members only.) Each lesson is 15–30 minutes and features hands-on exercises, with an option to use a simulation instead of the software application. You can use an online evaluation tool that identifies gaps in skills, determines what lessons will be most helpful, and gauges learning progress.

Subscription Resources and Privacy

Subscription resources provide interactive product features over the Internet. Each time you access subscription resources (such as e-Learning or Create Support Request) from Communication Center in an Autodesk product, product information (such as the serial number, version, language, and the subscription contract ID) is sent to Autodesk for verification that your product is on subscription.

Autodesk compiles statistics using the information sent to subscription resources to monitor how they are being used and how they can be improved. Autodesk maintains the information provided by or collected from you in accordance with Autodesk’s published privacy policy, which is available at http://www.autodesk.com/privacy

To access the Subscription Center in the program

1. In the InfoCenter box, click the Communication Center button.

2. On the Communication Center panel, under Subscription Center, click the subscription resource you want to access.

NOTE Subscription Center is not available to all product users. If subscription resources are not available in your product, your product is not entitled to subscription benefits.

Manage Files with Autodesk Vault

If you are a subscription customer, you have access to Autodesk Vault, a file management tool that provides a repository where documents and files are stored and managed. Autodesk Vault is also shipped with certain other Autodesk softwares. Autodesk Vault gives you more power to manage files and track changes. Versioned copies of master files are maintained, allowing
you to easily revert to earlier versions of files. You can check files out for editing and later check them back in. The master copy is never directly edited. During the check-in process, you can add comments regarding the edits you've made to inform other designers of your changes. You are able to quickly understand a project's developmental flow and history.

Autodesk Vault consists of three required components: the Vault Plug-in, the Autodesk Data Management Server, and the Vault Client. The Vault Plug-in is shipped with 3ds Max. The Autodesk Data Management Server and the Vault Client are available on the Autodesk Subscription site.

For information about using the Vault, refer to the Vault Help system.

The Autodesk Data Management Server

The Autodesk Data Management Server stores the master copies of all your documents and designs. By storing all your data in a common, centralized location, you can easily share and manage information with your design team.

The Vault Client

The Vault Client software includes Autodesk Vault Explorer. The Vault Explorer is a stand-alone application that provides tools you use to access data stored on the Autodesk Data Management Server. From within 3ds Max, you can log in, log out, and open and attach files directly from the Vault. You can also access the Vault using the Vault Explorer. With the Vault Explorer you can

- Manage the Vault
- Manage Vault user accounts
- Set working folders
- Create folders in the Vault
- Add, check in, and check out files (including non-Inventor and non-DWG files; exception is AutoCAD Electrical files)
- Move files in the Vault
- Rename files in the Vault
- View the history of design changes
- Create file associations within the Vault by attaching two or more files
- Check out the latest version of a file
Join the Customer Involvement Program

You are invited to participate in helping guide the direction of Autodesk design software.

If you participate in the Customer Involvement Program, specific information about how you use 3ds Max is forwarded to Autodesk. This information includes what features you use the most, problems that you encounter, and other information helpful to the future direction of the product.

See the following links for more information.

- Learn more about the Autodesk Customer Involvement Program: [http://www.autodesk.com/cip](http://www.autodesk.com/cip)
- Read the Autodesk Privacy Statement: [http://www.autodesk.com/cipprivacy](http://www.autodesk.com/cipprivacy)

**To turn the CIP on or off**

1. On the InfoCenter toolbar, to the right of the Help button, click the drop-down arrow.
2. Click Customer Involvement Program.
3. In the Customer Involvement Program dialog box, select a level of participation.
4. Click OK.
Using the 3ds Max Help

The 3ds Max Help (this document) gives you information about every aspect of 3ds Max. Each topic contains an overview discussion, typically preceded by a path annotation showing how to access the feature in 3ds Max, and followed by a "Procedures" section with steps for using a command or feature, and an “Interface” section detailing controls and parameters for the user interface.

- **Path Annotation**: Gives one or more sequences of steps indicating how to access the feature in the user interface.
- **Topic Overview**: Tells you the name of the feature, command, user-interface control, or concept, and gives you a description.
- **Procedures**: Contains steps for tasks that illustrate the typical use of the feature.
- **Interface**: Describes the controls for this feature as they appear in the user interface, with a description of their behaviors and settings.

**Important Notes**

New features are indicated in this help by the "New" icon shown at the beginning of this paragraph. This makes it easy to see what’s new in 3ds Max as you use the reference. You can also identify topics containing information on new features in 3ds Max using the Index. Double-click the "new feature" entry to display a list of topics describing new program features. Double-click the entry "changed feature" to see which existing features have changed.

Keypresses, both individual and combination, are indicated in this document using a special text style. For example:

- To open the Select From Scene dialog, press H.
- To undo the most recent action, press Ctrl+Z.

When you click a “book” icon on the Contents tab, the Topic pane on the right side immediately displays the introductory or first topic in that section. This differs from previous
behavior, in which the first topic was a separate entry in the table of contents and needed to be accessed separately from the “book” container.

The screen shots in this document show the default user interface colors. Other color sets for the user interface are available. You can choose them, or create your own, using the Colors tab on page 8272 in the Customize User Interface dialog on page 8249.

See also:
- Help Menu on page 8032

Finding Information Fast

Use the Navigation pane in the Help Window to get to information quickly. It contains tabs that let you use Contents, Index, or Search techniques to get to topics you need.

Contents Tab

The Contents tab displays the main sections of this online system as book icons. When you click a book, it expands to show the list of topics contained within it, like chapters in hardcopy books.

To go to a topic from the Contents tab:

1. Click the Contents tab to display the Table of Contents view.

2. Click the book icon representing the area for which you want information.
   The Topic pane on the right displays the introductory topic for that section. In most cases, the topic contains an overview of the section contents plus a list of relevant links. In some cases, the topic consists exclusively of links to other topics in the section.
   The page icons for the book expand below representing all the topics for the book's feature area.

3. Click a link in the introductory topic to go to that topic.
   Alternatively, you can view a list of the section's topics and sub-sections by clicking the + icon to the left of the book icon in the table of contents or double-clicking the book icon or section title. This expands the section and shows its contents.
4 Continue navigating through the table of contents until you find the topic you want and then click its icon.

Index Panel

The index is an alphabetical listing of keywords found in the help. A single keyword might be linked to more than one topic. Scroll through the list, or to jump to an index entry that matches what you're looking for, type the first few letters of the subject in the editable field above the list.

To go to a topic from the Index panel:
1 Click the Index tab to display the Help index.
2 In the form at the top of the Index, type the subject you want, or scroll through the alphabetical list to find the term for which you need information.
3 Click the term, then click Display to see the topic for that term, or double-click the term to see its topic.

The topic displays in the right pane and may show links to related topics.

Search Tab

The Search tab summons a full-text search engine that operates on a database of every word in the help system, created when the HTML Help system was compiled. You can use tools on the Search tab to find the help topics on page 8446 containing any word or phrase.

Favorites Tab

Use tools on the Favorites tab to create and store a set of topics you use often; you can name them as you choose.
Using the HTML Help Viewer

This online information system is a compiled HTML help (CHM) file; you view it using Microsoft's HTML Help Viewer, powered by Internet Explorer. The HTML Help Viewer is a three-pane window:

■ The Navigation pane on page 8442 is on the left side of the window. It contains four navigational tabs, for Contents on page 8442, Index on page 8442, Search on page 8446, and Favorites on page 8452.

■ The Topic pane is on the right side of the window. It displays the selected help topic, or the default help topic. It's the window you're reading from right now.

■ The toolbar on page 8452 is the third pane, located below the help window title bar.
Here are some tips on how to find more information when using the HTML Help Viewer:

■ To link to another topic or a list of other topics, click the colored, underlined words in the Topic pane.

■ If you use a particular help topic often, you can add it to your favorites list on page 8452.

■ Right-click the Contents or Favorites tab or the Topic pane for shortcut menu commands.

Comments

Each topic in the online version of this document ends with a Comments link. When you click Comments, the Help Viewer opens an electronic form you can use to send us comments or requests about that topic. We'll use that information when we revise the documentation set for a future release.

TIP Check the downloads section on the 3ds Max support site regularly for updated releases of the online help. Access it from Help menu > 3ds Max on the Web > Online Support.

See also:

■ Finding Information Fast on page 8442
■ Searching for Help Topics on page 8446
Most of information about using the HTML Help Viewer has been supplied directly by Microsoft. It has been made freely available for inclusion in HTML help projects such as this one. This information has been edited and reformatted to match that of the other online information systems shipping with 3ds Max.

Procedures

To find a help topic:

1 In the Navigation pane, click one of the following tabs:
   - To browse through a table of contents, click the Contents tab. The table of contents is an expandable list of important topics.
   - To see a list of index entries, click the Index tab, and then type a word or scroll through the list. Topics are often indexed under more than one entry.
   - To locate every occurrence of a word or phrase that may be contained in a help file, click the Search tab, and then type the word. For details on searching, see Searching for Help Topics on page 8446.

2 Double-click the contents entry, index entry, or search results entry to display the corresponding topic.

To copy a help topic:

1 In the Topic pane, right-click the topic you want to copy, and then click Select All.

2 Right-click again, and then click Copy. This copies the topic to the Clipboard.

3 Open the document you want to copy the topic to.

4 Position your cursor where you want the information to appear.

5 On the Edit menu, click Paste.

To copy only part of a topic:

- Select the text you want to copy, right-click, and then click Copy.
To print the current help topic:

- Right-click a topic, and then click Print.
  If you print from the Contents tab (by right-clicking an entry, and then clicking Print) you will see options to print only the current topic, or the current topic and all subtopics.

To hide or show the Navigation pane:

- On the toolbar, click Hide or Show to close or display the Navigation pane, which contains the Contents, Index, Search, and Favorites tabs.
  If you close the Help Viewer with the Navigation pane hidden, it will appear that way when you open the Help Viewer again.

To see where the current topic fits in the information hierarchy (contents):

- Press Alt+C.
  The Contents pane displays, with the current topic highlighted.

Searching for Help Topics

A basic search consists of the word or phrase you want to find. You can use Boolean, wildcard, and nested expressions. You can also limit the search to previous results, match similar words, or search topic titles only to further define your search.

The basic rules for formulating queries are as follows:

- Searches are not case-sensitive, so you can type your search in uppercase or lowercase characters.
- You may search for any combination of letters (a through z) and numbers (0 through 9).
- Punctuation marks such as the period, colon, semicolon, comma, and hyphen are ignored during a search.
- Group the elements of your search using double quotes on page 8447 or parentheses on page 8449 to set apart each element. You cannot search for quotation marks.
NOTE If you are searching for a file name with an extension, you should group the entire string in double quotes, ("filename.ext"). Otherwise, the period will break the file name into two separate terms. The default operation between terms is AND, so you will create the logical equivalent to "filename AND ext."

**Searching for Words or Phrases: Using Wildcards**

You can search for words or phrases and use wildcard expressions. Wildcard expressions allow you to search for one or more characters using a question mark or asterisk. The table below describes the results of these different kinds of searches.

<table>
<thead>
<tr>
<th>Search for</th>
<th>Example</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>A single word</td>
<td>select</td>
<td>Topics that contain the word &quot;select.&quot; (You will also find its grammatical variations, such as &quot;selector&quot; and &quot;selection.&quot;).</td>
</tr>
<tr>
<td>A phrase</td>
<td>&quot;new operator&quot; or new operator</td>
<td>Topics that contain the literal phrase &quot;new operator&quot; and all its grammatical variations. Without the quotation marks, the query is equivalent to specifying &quot;new AND operator,&quot; which will find topics containing both of the individual words, instead of the phrase.</td>
</tr>
</tbody>
</table>
| Wildcard expressions| esc* or 80?86 | Topics that contain the terms "ESC," "escape," "escalation," and so on. The asterisk cannot be the only character in the term. Topics that contain the terms "80186," "80286," }
**Search for** | **Example** | **Results**
---|---|---
"80386," and so on. The question mark cannot be the only character in the term.

Turn on Match Similar Words to include minor grammatical variations for the phrase you search.

**Defining Search Terms: Using Boolean Expressions**

The AND, OR, NOT, and NEAR operators enable you to precisely define your search by creating a relationship between search terms. The following table shows how you can use each of these operators. If no operator is specified, AND is used. For example, the query "spacing border printing" is equivalent to "spacing AND border AND printing."

<table>
<thead>
<tr>
<th>Search for</th>
<th>Example</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>Both terms in the same topic.</td>
<td>dib AND palette</td>
<td>Topics containing both the words &quot;dib&quot; and &quot;palette.&quot;</td>
</tr>
<tr>
<td>Either term in a topic.</td>
<td>raster OR vector</td>
<td>Topics containing either the word &quot;raster&quot; or the word &quot;vector&quot; or both.</td>
</tr>
<tr>
<td>The first term without the second term.</td>
<td>ole NOT dde</td>
<td>Topics containing the word &quot;OLE,&quot; but not the word &quot;DDE.&quot;</td>
</tr>
<tr>
<td>Both terms in the same topic, close together.</td>
<td>user NEAR kernel</td>
<td>Topics containing the word &quot;user&quot; within eight words of the word &quot;kernel.&quot;</td>
</tr>
</tbody>
</table>

**NOTE** The |, &, and ! characters don’t work as Boolean operators (you must use OR, AND, and NOT).
Using Nested Expressions When Searching

Nested expressions allow you to create complex searches for information. For example, "control AND ((active OR dde) NEAR window)" finds topics containing the word "control" along with the words "active" and "window" close together, or containing "control" along with the words "dde" and "window" close together.

The basic rules for searching help topics using nested expressions are as follows:

- You can use parentheses to nest expressions within a query. The expressions in parentheses are evaluated before the rest of the query.
- If a query does not contain a nested expression, it is evaluated from left to right. For example: "Control NOT active OR dde" finds topics containing the word "control" without the word "active," or topics containing the word "dde." On the other hand, "control NOT (active OR dde)" finds topics containing the word "control" without either of the words "active" or "dde."
- You cannot nest expressions more than five levels deep.

Procedures

To go to a topic from the Search tab:

1. Click the Search tab, and then type the word or phrase you want to find.
2. To add Boolean operators to your search (not necessary if you're searching for a single term), click the Boolean button to the right of the text field, and then one of the operator names.
3. Click List Topics, choose the topic you want, and then click Display.
4. To sort the topic list alphabetically, click the Title column heading.

You can precisely define a search by using wildcard expressions, nested expressions, and Boolean operators.

You can request similar word matches, search only the topic titles, or search the results of a previous search.

You can set the Help Viewer to highlight all instances of search terms that are found in topic files. Click the Options button, and then click Search Highlight On.
To highlight words in searched topics:

When searching for words in help topics, you can have each occurrence of the word or phrase highlighted in the topics that are found.

- To highlight all instances of a search word or phrase, click Options on the toolbar, and then click Search Highlight On.
  To turn off this option, click Options on the toolbar, and then click Search Highlight Off. Another way to turn off highlighting without changing the Search Highlight ... setting is to go to the Contents tab, and then click the highlighted topic entry.
  If you are viewing a long topic, only the first 500 instances of a search word or phrase will be highlighted.

To search for words in the titles of HTML files:

1. Click the Search tab, type the word or phrase you want to find, and then turn on Search Titles Only.
2. Click List Topics, choose the topic you want, and then click Display.
   If you use this option, all HTML topic files will be searched, including any that are not listed in the table of contents.

To find words similar to your search term:

This feature enables you to include minor grammatical variations for the phrase you search. For example, a search on the word "add" will find "add," "adds," and "added."

1. Click the Search tab, type the word or phrase you want to find, and then turn on Match Similar Words.
2. Click List Topics, choose the topic you want, and then click Display.
   This feature only locates variations of the word with common suffixes. For example, a search on the word "add" will find "added," but it will not find "additive."

To search only the last group of topics you searched:

This feature enables you to narrow a search that results in too many topics found. You can search through your results list from previous search by using this option.

1. On the Search tab, turn on Search Previous Results.
2. Click List Topics, choose the topic you want, and then click Display.
If you want to search through all of the files in a help system, this check box must be off.

If you previously used this feature, the Search tab opens with this check box turned on.

To repeat an earlier search:

- Click the down arrow on the text-entry field and choose a previously used search string, and then click List Topics.

Browsing Help Topics

The title bar of a topic contains both browse buttons and contextual links. You can use the three buttons in the upper-right corner of the Topic pane to browse the help. The button with the left arrow goes to the previous topic, and the button with the right arrow goes to the next topic. The upward-pointing arrow goes to the parent topic; if there is no parent, this button is blank.

When you move your cursor over one of these buttons, the Help viewer displays the name of the topic that the button points to.

In addition, a series of links appear above the topic title. These show the path of the topic within the 3ds Max help.

The first link on the left, “Autodesk 3ds Max Help,” goes to the graphic Welcome page. The next link is the chapter (top-level topic) that contains the
topic you are reading. If there are additional container topics, these appear in order after the chapter link. Click any one of these links to go directly to the topic it names.

**Favorites Tab**

Use tools on the Favorites tab to create a set of topics you use often; you can name them as you choose.

**Procedures**

**To create a list of favorite help topics:**

1. Locate the help topic you want to make a favorite topic.
2. Click the Favorites tab, and then click Add.

**To return to a favorite topic:**

1. Click the Favorites tab.
2. Choose the topic, and then click Display.

**To rename a topic in the Favorites list:**

- Choose the topic, and then enter a new name in the Current topic box.

**To remove a favorite topic:**

- Choose the topic, and then click Remove.

**HTML Help Viewer Toolbar**

The Help Viewer toolbar contains several options.

![Toolbar](image)

**Hide/Show** Click this toggle to hide the Navigation pane when it is displaying, or show it when it's hidden.
**Back/Forward** Click to move to the previously viewed topic, or forward to the following previously viewed topic.

**Print** Prints the current topic (if the Topic pane is active). If the table of contents is active on the Navigation pane, you can choose to print the current topic, or the topic and its subtopics. This is a way of printing a collection of topics.

**Options** Displays the options menu:

- **Hide/Show Tabs** Same as Hide/Show buttons, described above.
- **Back/Forward** Same as Back/Forward buttons, described above.
- **Home** Displays the main topic of this online system.
- **Stop** Halts display of a topic.
- **Refresh** Redraws the Help Viewer display.
- **Internet Options** Displays a dialog to change Internet Explorer (IE) settings. Changes you make here do not affect the online help or tutorials, but do affect your IE browser settings. We do not recommend you use this option.
- **Print** Same as the Print button, described above.
- **Search Highlight On/Off** Toggles highlighting of each instance of a word or phrase found with a search.
HTML Help Viewer Right-Click Menus

There are several commands on the shortcut menu that you can use to display information.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Right-click in the table of contents, and then click Open All.</td>
<td>Opens all books or folders in the table of contents. This command only works if the Contents tab is displayed.</td>
</tr>
<tr>
<td>Right-click in the table of contents, and then click Close All.</td>
<td>Closes all books or folders. This command only works if the Contents tab is displayed.</td>
</tr>
<tr>
<td>Right-click in the Topic pane, or an entry in the table of contents, and then click Print.</td>
<td>Prints the topic.</td>
</tr>
<tr>
<td>Right-click an entry in the Favorites tab.</td>
<td>Choose to display, add, remove, or rename a topic.</td>
</tr>
</tbody>
</table>

Keyboard Shortcuts in the Help Viewer

The following keyboard shortcuts can be used for navigation in the HTML Help Viewer, or the Contents on page 8455, Index on page 8456, Search on page 8456, or Favorites on page 8457 tabs on the Navigation pane.

**Help Viewer**

<table>
<thead>
<tr>
<th>To</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close the Help Viewer.</td>
<td>Alt+F4</td>
</tr>
<tr>
<td>Switch between the Help Viewer and other open windows.</td>
<td>Alt+Tab</td>
</tr>
<tr>
<td>Display the Options menu.</td>
<td>Alt+O</td>
</tr>
<tr>
<td>To</td>
<td>Press</td>
</tr>
<tr>
<td>------------------------------------------------------------------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>Hide or show the Navigation pane.</td>
<td>Alt+O, and then press T</td>
</tr>
<tr>
<td>Print a topic.</td>
<td>Alt+O, and then press P, or right-click in the Topic pane and choose Print.</td>
</tr>
<tr>
<td>Move back to the previous topic.</td>
<td>Alt+Left Arrow, or Alt+O, and then press B. Or, if the Topic pane is active, press Backspace.</td>
</tr>
<tr>
<td>Move forward to the next topic (provided you have viewed it just previously).</td>
<td>Alt+Right Arrow, or Alt+O, and then press F</td>
</tr>
<tr>
<td>Turn on or off search highlighting.</td>
<td>Alt+O, and then press O</td>
</tr>
<tr>
<td>Return to the home page (help authors can specify a home page for a help system).</td>
<td>Alt+O, and then press H</td>
</tr>
<tr>
<td>Switch between the Navigation and Topic panes.</td>
<td>F6</td>
</tr>
<tr>
<td>Scroll through a topic.</td>
<td>Up Arrow and Down Arrow, or Page Up and Page Down</td>
</tr>
<tr>
<td>Scroll through all the links in a topic.</td>
<td>Tab</td>
</tr>
</tbody>
</table>

**Contents Tab**

<table>
<thead>
<tr>
<th>To</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display the Contents tab.</td>
<td>Alt+C</td>
</tr>
<tr>
<td>Tip: Use this shortcut to see where a topic fits in the information hierarchy.</td>
<td>Click plus sign or minus sign next to book icon, or Left Arrow and Right Arrow</td>
</tr>
<tr>
<td>Open and close a book or folder.</td>
<td></td>
</tr>
</tbody>
</table>
### Index Tab

<table>
<thead>
<tr>
<th>To</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choose a topic.</td>
<td>Down Arrow and Up Arrow</td>
</tr>
<tr>
<td>Display the selected topic.</td>
<td>Enter</td>
</tr>
</tbody>
</table>

### Search Tab

<table>
<thead>
<tr>
<th>To</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display the Search tab.</td>
<td>Alt+S</td>
</tr>
<tr>
<td>Type a keyword to search for.</td>
<td>Alt+W, and then type the word</td>
</tr>
<tr>
<td>Start a search.</td>
<td>Alt+L</td>
</tr>
<tr>
<td>Choose a topic in the results list.</td>
<td>Alt+T, and then Up Arrow and Down Arrow</td>
</tr>
<tr>
<td>Display the selected topic.</td>
<td>Alt+D</td>
</tr>
<tr>
<td>Search for a keyword in the result list of a prior search.</td>
<td>Alt+U and press Enter</td>
</tr>
</tbody>
</table>
### To | Press
--- | ---
Search for words similar to the keyword. For example, to find words like "running" and "runs" for the keyword "run." | Alt+M and press Enter
Search through topic titles only. | Alt+R and press Enter

### Favorites Tab

| To | Press |
--- | --- |
Display the Favorites tab. | Alt+I |
Add the currently displayed topic to the Favorites list. | Alt+A |
Choose a topic in the Favorites list. | Alt+P, and then Up Arrow and Down Arrow |
Display the selected topic. | Alt+D |
Remove the selected topic from the list. | Alt+R |

### Notes

- There are also shortcut menu commands on page 8454 that can be accessed through the keyboard.
- The Match Similar Words check box, on the Search tab, will be turned on if you used it for your last search.
This section describes a collection of problematic situations and what you can do to diagnose and fix them. These include many common problems that are reported to Autodesk Product Support, and the things you can try in order to resolve the problems yourself.

When starting to diagnose a problem, by yourself or with the intent of contacting Product Support, you should take stock of the situation by answering the following questions.

- What's changed since the last time I ran 3ds Max?
- Has the 3ds Max display configuration been changed?
- Was an updated video driver or new operating system service pack installed recently?
- Has 3ds Max been running successfully without lockups or crashes?

Handling File Corruptions

Few things are more aggravating when attempting to open a scene then encountering an Assertion Failed error, File Open Failed error, or perhaps no error at all. The file just does not load. This typically occurs when the file is corrupt.

A number of factors can cause file corruption, including the following:

- Some component built in another program has been imported or referenced with an XRef.
- The scene failed to save properly due to a power failure or system crash.
- A poorly coded plug-in corrupted an object in the scene.
Problems and Resolutions

Assertion Failed Errors

The assertion failed error occurs commonly when you try to load a corrupt file. The error gives you a line number and filename where the corruption occurred. You are then left with the options to retry or cancel.

Unfortunately, the line number and filename often don't help because that isn't necessarily where the error is actually occurring. Most people click the Retry option a couple of times then give up, fearing they've lost many hours of work. Don't panic yet. There are a number of things you can try before you have to start rebuilding.

The first thing to try is keep clicking the Retry button. If there is a corruption to the vertices of an object, you might have to parse through each vertex until you bypass the object completely. For example, Autodesk Product Support once received a file that returned an Assertion Failed error referencing a `tab.h` file. The scene recently had an AutoCAD component imported that 3ds Max couldn't understand. However, after the support technician clicked the Retry button 88 times, the scene finally opened. After resaving the scene, it opened without incident.

Merging Corrupt Files

If normal attempts to open a scene fail, another thing you can try is merging the scene. If the file is not too corrupted, you would be able to access the Merge dialog which shows a list of the components in the scene. This is a good sign because, with a little effort, you can fix the file yourself. You now need to narrow down which object, or objects, are causing the load failure.

1. Start 3ds Max.
2. Choose Application menu on page 7989 > Import > Merge.
3. Browse to the folder containing the model, select the model and click the Open button.
   The Merge dialog is displayed, showing all the components in the scene.
You'll start by seeing if any of the objects or shapes in the scene are corrupt.

4 In the List Types group, on the right, turn off everything except Geometry, Shapes, and Groups/Assemblies.

5 Click the All button at the lower left, and then click OK.

If the objects appear in the viewports, you know the scene components are fine and you'll have to repeat these steps with other List Types turned on.

If the objects merge successfully, and you have to try merging in other objects, be sure to first save what you've just merged as a basis for rebuilding the scene.
If you receive an error message, you know one of the objects is the offending item. Then, do as follows.

1. Reset 3ds Max.
   You now have to narrow down exactly which object in the previous list is corrupt.

2. Once again, choose File > Merge and turn off everything except Geometry, Shapes, and Groups/Assemblies.

3. Select the first 10 objects in the list of components and click OK.
   If those objects merge successfully, save the scene and repeat the Merge operation with the next set of 10 objects. Eventually, one of the sets of objects you try to merge will report the error message.

4. Keep refining the number of objects you are merging until you have singled out the object that reports the error.

5. Once you've found the corrupt object, reset 3ds Max and merge all the objects and components except for the object you've singled out.

6. After everything is merged, save the scene and rebuild the object that was corrupt.

Granted, this can be a long process, but it's well worth it if you can salvage most of your previous work.

**Remember Backup Files**

By default, the 3ds Max automatic backup feature is active, and writes a backup file every five minutes while you're editing the scene for a total of three files. The files are stored in the `\autoback` folder. By default, this folder is stored in `\My Documents\3dsmax\`. Using backup files is especially helpful if your file became corrupt due to a system crash or power outage.

1. Start 3ds Max and verify that you cannot load the scene.

2. Open Windows Explorer and browse to the `\autoback` folder.

3. Start by highlighting `AutoBackup01.max` and then copy the file (Edit > Copy or Ctrl+C).

4. Browse to the `\scenes` folder, found in `\My Documents\3dsmax\` or in the program install folder, and paste the file.
   If you want, you can rename it.
5 In 3ds Max, choose File > Open and try loading the file you just copied from the `\autoback` folder.
If it opens, save the scene and rebuild what you lost in the last five minutes.

If you'd like to adjust the Auto Backup settings, you'll find them on the Files panel on page 8305 of the Preference Settings dialog, available via the Preferences command on the Customize menu.

# Fixing Boolean Problems

Boolean operations are a powerful addition to your modeling toolbox; however, they can sometimes give strange or unexpected results. The Boolean button is found on the Create panel in the Compound Objects list; it allows you to join, subtract, intersect, and cut objects. Following is a list of problem scenarios and steps you can follow to fix them.

**TIP** The ProBoolean compound object on page 801 represents a significant improvement over the legacy Boolean compound object in a number of ways. In most cases, it's highly recommended that you use ProBoolean rather than Boolean.

**TIP** Before performing a Boolean operation, you should save your scene or use Edit > Hold. That way, you can quickly recover should anything not appear as expected.

## Problems and Resolutions

### Boolean Objects Disappear

If you mistakenly perform an Intersection Boolean operation on two objects that look like they intersect, but actually don't, you can end up in a situation where the object completely disappears. In the Operands group, you see both your objects listed but nothing on-screen.

1. Click the Undo button to retract the Operand B selection.
2. Right-click to exit the Boolean operation.
3. Verify that the objects intersect by checking them in two viewports, like the Top and Left.
4. Click Boolean to turn on the operation, and click Pick Operand B.
Click the intersecting object.

**Creases or Ridges Show in Boolean Objects**

Creases or ridges might be caused by a Boolean operation between an object that has very few faces and an object that has considerably more faces, for example, when you subtract a complex freeform object from a simple box. 3ds Max tessellates the surface of the box so there are additional faces for the subtraction. Unfortunately, the faces are usually generated as long, slivered faces that sometimes overlap and form creases or ridges in the resulting scene, when rendered.

Before attempting the Boolean operation, try these steps.

1. Select the object that has the lower face count.
   In this example, it would be the box.

2. Change the Length, Width or Height Segments of the surfaces where the subtraction will occur.

3. From the Compound Objects buttons, click Boolean.

4. Perform the subtraction as you originally wanted.

By subdividing the surface with more faces, the Boolean operation has more faces and edges to work with. This results in fewer long, sliver-like faces that can produce creases or ridges.

**Consecutive Booleans Results in Disappearing Components**

Booleans are programmed to work with two operands, Operand A and Operand B. If you plan to join or subtract many objects from the object that you've selected as Operand A, you must click the Boolean button after each Operand B selection. If you don't, and simply click the Pick Operand B button and pick the next object, the previous operation is negated and the previous Operand B disappears.

The most efficient means to use when joining or subtracting a large number of objects to or from a single object is to attach all the objects before attempting the Boolean operation.

As an example, let's say you're building a metal plate that has a circle of bolt holes. So far, you have a flat box, Operand A, and ten cylinders, Operand B, passing through it.
1. Select one of the cylinders.

2. Right-click and convert it to an Editable Poly. This automatically opens the Modify panel.

3. From the Edit Geometry rollout, click Attach List.
This is the little button next to Attach.

4 From the Attach List dialog, select all the other Cylinders and click the Attach button.

All the cylinders are a single object.

5 Select the Box and make sure it has Length, Width, or Height Segs values that are greater than 1. See Creases or ridges show in Boolean objects on page 8464.

6 Open the Create panel and from the drop-down menu that shows Standard Primitives, choose Compound Objects.

7 Click the Boolean button and in the Parameters rollout > Operations group, make sure Subtraction (A-B) is turned on.

8 On the Pick Boolean rollout, click Pick Operand B, and select the Cylinders.
The cylinders are subtracted to form holes in the box.

You only have to perform Boolean operations once instead of several times. This method is far more efficient and less prone to errors. It is also very useful for cutting rough openings for doors and windows into a wall if you're already working with 3D geometry. Next, you'll find an example for working with 2D spline objects.

**Splines and Boolean Operations**

Performing Boolean operations on splines made from the Create panel > Shapes menu can be confusing. 2D spline shapes do not use the Boolean operation you'd use for 3D geometry. Shapes, converted to Editable Splines, offer Boolean functionality from the Modify panel > Geometry rollout. Unlike Boolean operations performed on two separate pieces of 3D geometry, Boolean operations can only be performed on single splines.

Therefore, one of two things must be done before you can perform Boolean operations to spline shapes.

- When originally creating the shapes, make sure Start New Shape is turned off on the Create panel > Shapes > Object Type rollout. When turned off,
you can create several overlapping shapes that are treated as a single shape made up of several splines.

<table>
<thead>
<tr>
<th>Object Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>AutoGrid</td>
</tr>
<tr>
<td>Start New Shape</td>
</tr>
<tr>
<td>Line</td>
</tr>
<tr>
<td>Rectangle</td>
</tr>
<tr>
<td>Circle</td>
</tr>
<tr>
<td>Ellipse</td>
</tr>
</tbody>
</table>

Start New Shape in the OFF state (it is on, by default.)

- If you didn't turn off Start New Shape, you'll have to attach all the spline shapes to create a single shape comprised of multiple splines.

To illustrate the most common situation, let's say you've got three overlapping rectangles and you want to subtract the two outer rectangles from the central rectangle. You also forgot to turn off Start New Shape.

1. Start by selecting the central rectangle.
2 Right-click and choose Convert To > Convert to Editable Spline from the quad menu. The Modify panel automatically opens.

3 In the Geometry rollout, click the Attach button and pick the two outer rectangles. Now, you’ve got a single shape made up of three sub-object splines.
4 Turn off Attach and scroll up to the Selection rollout.

5 Turn on the sub-object Spline mode, and select the central rectangle.
6 Scroll down the Geometry rollout and click the Boolean button. Also click the Subtraction button to the right.

7 Pick the two outer rectangles.
Tips for Successful Boolean Operations

Here, you’ll find some general tips that will ensure that you’re Boolean operations work the first time.

■ Add a modifier and collapse the stack.
  If a set of operands never seems to produce desired results, try adding a modifier and collapsing the stack to create an Editable Mesh or Editable Poly. You can also collapse objects to editable meshes and polys without first applying modifiers. If you do this, use Edit > Hold or File > Save As on the scene; you will not be able to adjust the parameters of the existing modifiers in the stack.

■ Create objects with more faces.
  In general, create objects that have more faces than you might normally use. For instance, increase the Height, Width, and Length segments of a Box, especially if the other object is more complex. Try to make the face count of both operands similar in number. With a larger number of faces, the edges created by the Boolean operation tend to be smoother and more
refined. Once the Boolean operation gives you the results you want, apply the Optimize modifier to reduce the number of faces on the object.

- Apply the STL-Check modifier.
  One way to check the validity of objects that you intend to use as operands is by applying the STL-Check modifier. This modifier is primarily used to verify that an object is a complete and closed surface in preparation for exporting to STL files. Because Boolean operations work best with objects that meet the same criteria, use STL-Check on your operands. After applying the STL-Check to an object, turn on Check. The Status group tells you if errors are present.

**Performance Issues While Running 3ds Max**

Slow or sluggish performance while running 3ds Max can usually be attributed to either a video configuration conflict or a memory allocation problem. The hard thing about performance problems is narrowing down the culprit. Here are some common situations that can hamper operation of 3ds Max and steps to take to rectify them.

**Problems and Resolutions**

**3ds Max Doesn't Start Quickly**

Autodesk Product Support often encounters an increase of this situation around the time a new version or upgrade of the software is released. The question usually posed by the customer is, “Why does the new version take longer to start than the last version?” There are several reasons.

- The size of the executable that starts 3ds Max and the additional overhead needed to load the new features of a new release can cause a slowdown. Code in a new executable may use the system processors in a different way than the last version so a slowdown may be noticed. The important thing is how 3ds Max performs once it is running.

- Each version of 3ds Max is programmed and optimized to use newer video technology than what was previously available. If you haven’t upgraded your video card in the last year, or at least updated video drivers, there is a very good chance 3ds Max will not start as quickly as in previous versions. You can also try a different 3ds Max video configuration.
If you have not defragmented your system recently, 3ds Max could exhibit a slower start time. Defragmenting the system can also streamline the loading of large files that tend to swap to virtual memory.

Files Take a Long Time to Open

The size of a file often defines how quickly it loads into 3ds Max. However, if you notice an increase in load time from one design session to another, it could be an indication that 3ds Max is not finding enough memory to operate efficiently or that the file needs to be optimized.

The first thing to check is your system memory allocation. Per the 3ds Max system requirements, you should have a minimum of 512 MB of physical memory (RAM) and 300 MB of swap space. Recommended RAM is 1 GB with a 2 GB swap file. Here's how to check your memory and swap-file allocations.

To check RAM and swap-file allocation on Windows 2000:

1. Right-click the My Computer icon on your desktop and choose Properties from the menu.
   This opens the System Properties dialog.
   On the General panel, you should see information about your computer. The amount of RAM should be listed on this panel.

   **NOTE** The RAM might be displayed in kilobytes (KB) instead of megabytes (MB).

2. Open the Advanced panel, and click the Performance Options button. The Performance Options dialog is displayed.
3. Check the “Total Paging File Size For All Drives” setting in the Virtual Memory group. If you have 512 MB of RAM, you should set the Virtual Memory to approximately three times the RAM, or 1536 MB.

To check RAM and swap-file allocation on Windows XP:

1. Right-click the My Computer icon on your desktop and choose Properties from the menu.
   This opens the System Properties dialog.
   On the General tab, you should see information about your computer. The amount of RAM should be listed on this panel.
2  Open the Advanced tab and click the Performance Settings button. The Performance Options dialog is displayed.

3  Click the Advanced tab, and check the “Total Paging File Size For All Drives” setting in the Virtual Memory group.

If the physical and virtual memory are set appropriately, then you'll have to check the model. If the model does eventually open, do the following:

■ From the Application menu on page 7989, choose Save > Save As, and save the scene under a different name. Then try opening the new file to see if it loads faster.

■ Review some of the objects you know have large modifier stacks. Performance can be improved if you collapse the stacks of objects that you've completed.

■ If the model uses XRefs, make sure the XRefs are locally accessible. If they're located on a network server, the long load time could be due to high network traffic.

**Slow Response to Open or Drag Dialogs**

This situation is exhibited when you click a command that opens a dialog, like the Material Editor or graph window, like Track View. After you click, you notice an appreciable time lag until the dialog or window opens. If you then attempt to drag it to a new location, the dialog or window does not smoothly follow your cursor.

The usual cause for this is a video driver conflict or display configuration issue because opening or dragging a dialog causes your graphic card to refresh the screen. Try these steps to diagnose the problem.

1  Start 3ds Max.

2  From the Customize menu, choose Preferences.

3  Open the Viewports panel and check the Current Installed Driver. Most likely, it will be set to OpenGL or Direct3D.

4  If set to OpenGL or Direct3D, click the Choose Driver button and choose Software.

   The Software setting is a generic driver that works for all video cards. It doesn't have any video enhancements but it's a good place to begin diagnostics.
NOTE If you're switching from Direct3D, you first have to use Revert From Direct3D before choosing the Software configuration.

5 Click OK to close the Graphic Driver Setup dialog. You will be informed that you have to restart 3ds Max for the change to take effect.

6 Close the Preferences dialog and exit 3ds Max.

7 Restart 3ds Max.

Try opening or dragging dialogs around to see if performance has improved. If it has, do the following:

- If the software was originally configured for OpenGL, try configuring 3ds Max for Direct3D and see if performance is improved. Or vice-versa.
- Verify that your graphic card supports your preferred display configuration choice. Some cards do not fully support OpenGL or Direct3D.
- Visit the Web site of your graphic card manufacturer and see if they have any newer video drivers that you can download and install.

**Sluggish Command Response**

Sluggish command response is closely related to the previous situation. If you create an object such as a Box, you might notice that the cursor suddenly slows down when you drag it into a viewport. Clicking the corners to set the length, width and height is equally time-consuming. Once again, the likely cause is video-related.

1 Start 3ds Max.

2 From the Customize menu, choose Preferences.

3 Open the Viewports panel and check the Current Installed Driver.

4 Make sure you have 3ds Max configured for the software display driver.

5 Click OK to close the Graphic Driver Setup dialog. You will be informed that you have to restart 3ds Max for the change to take effect.

6 Close the Preferences dialog and exit 3ds Max.

7 Restart 3ds Max.
Try using the command that was giving you trouble and see if it works correctly now.

**Problems Caused by Unit Settings**

The unit settings of a model can often get you into trouble. Understanding some of the common problems can help you avoid them. This section addresses the two most common problems that modelers encounter.

**Problems and Resolutions**

**Objects Disappear When the Camera Gets Close**

This situation can happen when you model things on a very tiny scale and then have to get very close to them in a Camera or Perspective viewport. Architectural walkthrough animations are notorious for this kind of behavior. You've got a camera moving along a path and at some point it gets too close to a wall and you're suddenly able to see through to a room on the other side.

**NOTE**

This problem is quite common for designers working with the metric system when you want to use real world metric units and you change the System Unit Scale to 1 unit=1 meter. You don't have to change the System Unit Scale to metric to work in Metric units; just change the units.

There are two solutions that often fix this problem.

**Turn on the manual viewport clipping:**

You can turn on the manual viewport clipping and adjust it to see the entire object. Viewport clipping has a Near and Far range setting, if a camera gets closer to an object than the Near Clip value, you will see through that object. Likewise, objects that are located beyond the Far Clip value, will be invisible to the camera.

1. Open the problematic scene and select the camera.
2. In the Parameters rollout > Clipping Planes group, turn on Clip Manually.
3. Adjust the Near or Far Clip value, or both.
   - When you can see the object again, your clipping plane is set properly.
Scale the entire scene:
If it doesn't matter what units you work in, scale the entire scene so objects are not affected by viewport clipping.

1. Open the problematic scene and select everything.

2. On the toolbar, click Select And Uniform Scale.

3. Enlarge the entire scene.

    Not only do the objects in the scene get larger but the distance between objects increases. So, the larger you scale the scene, the further your camera is located from the surrounding objects.

If you need to work in real world units, such as inches or meters, you should set the scale of the scene before you begin modeling by changing the System Unit Scale value from the default of 1 unit=1 inch to something like 1 unit=0.1 inch or even 0.01 inch.

If you change the System Unit Scale after you have begun modeling, you will need to use the Rescale World Units utility to rescale the scene.

Zooming and Panning Are Too Fast or Slow

If zooming and panning are too fast or too slow, the most likely cause is the System Unit Scale. 3ds Max can exhibit round-off errors when dealing with extremely large or small distances. These round-off errors can also cause normals to be flipped or strange viewport clipping. 3ds Max does not have the numerical resolution to zoom infinitely from some remote corner of the solar system down to an ant on your doorstep.

If you're going to change the System Unit Scale, you should change it before beginning any modeling. If you do have to set it later, it's best to rescale the entire scene with Rescale World Units. For example, if working on a tiny scale, like modeling coins, you might change the System Unit Scale from the default of 1 unit=1 inch to something like 1 unit=0.1 or 0.01 inch. For larger scaled scenes, like an airport, increase the System Unit Scale.

As a rule of thumb, keep the scale such that the smallest detail is not less than one generic unit. If this makes the scene too big to work with comfortably and efficiently, you can create separate scenes for models that include cameras for "close" and "far" shots.
User Interface Problems and Recovery

It can be frustrating when you can't find something on the user interface, especially when you saw it a few minutes ago and now it's gone missing. Of course, you've been so engrossed in your modeling that you forget what you might have done to cause the button, element or dialog to disappear. This section addresses several common user-interface situations and how you can fix them.

Problems and Resolutions

Large Fonts and 3ds Max

While some users like to configure their systems to use large fonts, this setting is not recommended with 3ds Max. The 3ds Max user interface was designed to operate with your system set to small fonts. Small fonts are the default setting for both Windows 2000 and Windows XP.

If you have your system set to use large fonts, some of the most common anomalies you can expect while running 3ds Max are as follows:

- Buttons might be missing from the command panels.
- Some text-entry fields may not allow you to type in them.
- Garbled text appears in some dialogs.
- Text labels in dialogs and rollouts might be cut off or overlap other fields.
- Dialogs show cascading text fields and spinners.

To remedy these problems, set your system font back to small fonts.

1. Exit 3ds Max.
2. Go to Start > Settings > Control Panel, and click Display.
   You can also right-click anywhere in the open desktop and choose Properties.
3. Open the Settings panel and click the Advanced button.
4. In the Display group of the General panel, click the arrow to open the Font Size list and choose:
   - Small Fonts, if running Windows 2000
   - Normal Size, if running Windows XP
5 Click OK to exit the Display Properties dialog.
You will most likely have to reboot the system for these changes to take affect.

Lost Dialogs and Windows

3ds Max has many dialogs or windows that float when you open them. This feature allows you to drag them anywhere on your desktop. You can greatly improve your design efficiency by positioning dialogs out of the way of the main 3ds Max interface, such as on a second monitor if you have dual-monitor functionality.

However, there are times when a dialog gets lost. Either you drag it someplace and inadvertently let go of it, or some data is written incorrectly to an initialization file and you end up with a lost dialog.

There are a couple of ways to recover a lost dialog; both entail working with the 3dsmax.ini file.

Thorough Method

In this example, let's say you've got a single monitor that's configured for 1280x1024 resolution and you've lost your Rendering Progress dialog.
It was visible the last time you rendered, but that was awhile ago and someone else has been using the system.

1 Make sure 3ds Max is not running.
   The 3dsmax.ini file is constantly being updated while 3ds Max is running.

2 Use the Windows Search function to find the 3dsmax.ini file and browse to its location.
3  Open a text editor and load 3dsmax.ini.

4  Scroll down the list of entries until you find the data block:
   [RenderProgressDialogPosition]
   Dimension=-425 152 379 866

   A dialog's position is based off the location of the upper-left corner, anchored by the first pair of digits. Therefore, in this example, the upper-left corner of the dialog is -425 pixels from the left edge of the screen and 152 pixels from the top. The second pair of digits describe the horizontal and vertical size of the dialog, so this dialog is 379 pixels wide and 866 pixels tall.

   Since this example assumes a single monitor, configured for 1280x1024 resolution, this dialog is off-screen to the left. If the first number were greater than 1280, the dialog would be off-screen to the right.

5  Place your cursor on the “Dimension” line and scroll over to the problem number.

   The problem number is usually the first or second, since the last two set the width and height of the dialog.

6  Change the problem number to a value that is positive and within 1280x1024.

7  Save the 3dsmax.ini file and start 3ds Max.

   The next time you render, the Rendering Progress dialog appears on-screen.

   This is the preferred method, because it causes no loss to other custom configuration settings that are stored in the 3dsmax.ini file.

**Quick Method**

There are really only two reasons you'd use this method:

1  ■ You've just installed 3ds Max and haven't made any customized settings that get stored in the 3dsmax.ini file.

   ■ You're in a hurry and don't care about the customized settings that you have stored in the 3dsmax.ini file.

2  Make sure 3ds Max is not running.

3  Use the Windows Search function to find the 3dsmax.ini file and browse to its location.
4 Delete the 3dsmax.ini file.

5 Restart 3ds Max. A new 3dsmax.ini file is automatically created using default settings.

You need to be careful when using this method, because you don’t necessarily know what custom settings are saved in the 3dsmax.ini file. Perhaps you have 3ds Max set to display the command panel on the left and you’ve changed the viewport background color. Furthermore, if you have third-party plug-ins installed, they sometimes write information to the 3dsmax.ini file. If you delete the file, you will losing all those settings.

If you’re not sure about customized settings that are stored in the 3dsmax.ini file, you can rename the file to something like old3ds.ini. When you restart 3ds Max, you can continue working and, at a later time, compare the two files and copy the data you need from the old one to the new one.

Material Editor Defaults to Architectural Materials

When you open the Material Editor, you encounter Architectural Materials instead of original Autodesk VIZ Standard materials.

3ds Max allows you to set default user interfaces. If you build architectural models or require photorealistic rendering, you can set the user interface to default to features more relevant to the way you work. This is a new feature that is set from the Customize menu > Custom UI and Defaults Switcher dialog on page 8244.

The program saves this setting to the 3dsmax.ini file and you have to restart 3ds Max after using the defaults switcher.

Missing Command Panel

The command panel normally appears along the right side on the user interface. If you start 3ds Max and notice that the command panel is missing, there are usually three causes.

■ The command panel is turned off.

■ You floated the command panel to another monitor and attempted to drag it to a new location. When you released the mouse button, the command panel disappeared.

■ A custom user interface is active that places the command panel off-screen.
All of these situations can be quickly fixed by using the following steps.

1. Start 3ds Max.
2. From the main menu, choose Customize > Revert To Startup Layout. You're warned that all UI settings you've made during the current session of 3ds Max will be reset.
3. Click Yes. The original user interface is restored.

**Missing Transform Gizmos**

Whenever you move, rotate or scale an object, the standard, red axis tripod is replaced by a special purpose transform gizmo. It's possible to lose the transform gizmo, but it's easy to get it back. If you find you've lost your transform gizmo, try these steps.

1. Start 3ds Max.
2. Press the X key. This is the keyboard shortcut that toggles the transform gizmo on and off.
3. Press the = key. This keyboard shortcut increases the size of the transform gizmo. The – key reduces the size.
4. Open the Customize > Preferences > Gizmos panel, and match your setting to the default settings shown in the following image.
Multiple or Missing Buttons on the Toolbars

This is another tricky situation. You open a toolbar and find that there are duplicate buttons present or the button you expect to find is no longer there.

**NOTE** This is generally caused by holding the Ctrl key and dragging a button on the toolbar.

![Three Select And Move buttons.](image)

User Interface Problems and Recovery | 8485
This is clearly a user-interface problem, so reverting to the startup layout will fix this problem.

1. Start 3ds Max.
2. From the Customize menu, choose Revert To Startup Layout, and confirm the change.

If you have multiple buttons and don't want to reset the entire UI, you can remove duplicate buttons manually by doing the following:

- Hold down the Alt key and drag the duplicate button out of the toolbar. Click Yes when asked to confirm the deletion of the button.

If buttons are missing, use Revert To Startup Layout.

**Video Driver and Display Problems**

Because 3ds Max heavily relies upon the graphics card in your system, many problems that you may encounter while using the program can be attributed to the video. Such problems could be slow performance, refresh delays, user interface discrepancies, and so forth.

**Problems and Resolutions**

**Basic Troubleshooting Start Point**

As a rule of thumb, before attempting to diagnose any problem with 3ds Max, you can be more efficient in your diagnostics by resetting the display configuration to its default value. After you first install and start 3ds Max, it runs by default in Direct3D mode, but if you use the Start menu > Change Graphics Mode command, you're presented with the Graphics Driver Setup dialog:
If you're configured for OpenGL, Direct3D, or Custom, choose the Software driver. By configuring for the Software driver, you can disqualify the video card or drivers if the problem you're encountering persists while running 3ds Max.

- Resetting the configuration from within 3ds Max.
  - Choose Customize menu > Preferences.
  - Open the Viewport panel and check your currently installed driver. If it's not the Software driver, proceed. Otherwise, you can cancel and begin the diagnostics elsewhere.
  - If set to OpenGL, Direct3D, or a custom driver, click the Choose Driver button.
    The Graphics Driver Setup dialog is displayed.
  - Choose Software and click OK. You'll see a message that the changes will take effect the next time you start 3ds Max.
  - Exit 3ds Max and restart the program.
  - Try performing the task that was giving you problems.
Resetting the configuration before starting 3ds Max.

1. From the Windows Start menu, navigate to the 3ds Max submenu and choose Change Graphics Mode.
   3ds Max starts up and displays the Graphics Driver Setup dialog.

2. Choose the Software driver and try performing the task that was giving you problems once the program opens.

If the problem does not persist, you know that you've encountered a display problem. If this is the case, check the following with regards to your video card:

- Verify that the video card supports the driver you attempted to use. Some cards don't fully support OpenGL or Direct3D.
- You might not have the latest video drivers for the card. Contact the board manufacturer for updated drivers.
- If you were originally configured for OpenGL, try Direct3D, or vice versa. The driver for the graphics card may have better support for one driver than other.

**Direct3D Failed to Initialize Message**

You may need to update your video card drivers. Refer to your video card vendor's website or contact your vendor directly for further information about the DirectX support of your video card.

**Receive DirectX Message Listing Missing dlls or Other Components**

When configuring the display settings, you choose DirectX 9 or 10 (depending on your system) and start 3ds Max only to receive a message that lists missing dlls or other components.

Since certain components for DirectX are missing you should reinstall DirectX. Refer to the *Installation Guide* for complete information about downloading the correct version of DirectX.

**Direct3D Reports a Memory Warning**

You may encounter a memory warning when starting 3ds Max if you've configured the program to use the Direct3D driver.
This warning dialog usually appears if you have several programs, that heavily impact the video memory of your graphics card, running and you have the 3ds Max interface maximized or stretched to cover most of the display.

Your quickest options for bypassing this warning are as follows:

- Shut down some of the other programs that are concurrently running with 3ds Max.
- Reduce the size of the 3ds Max interface.
- Reconfigure 3ds Max to use a different display driver.

**Dual-Monitor Configuration**

Many board manufacturers are building graphic cards that support multi-monitor configurations. The cards might advertise hardware features like “Dual Head” or “Multi-Head” that have two monitor ports built into them. Other manufacturers choose to handle dual configuration through video drivers that let you configure your system display in “Wide” mode. Here are the details of what you need to watch out for when configuring a multi-monitor system.

- **Hardware “Dual Head” Solution**
  
  Many newer video cards offer this hardware solution for setting up a dual-monitor system.
  
  After installing the card and drivers, you want to follow the manufacturer’s instructions for configuring your system. Configuration is done through your system’s Display Properties dialog > Settings panel.
You are presented with a diagram for each monitor and you can set the resolutions independently by selecting a monitor and adjusting the screen Area slider. You will also often find utilities included with the drivers that enable special features for the graphics card.

The disadvantage to this configuration is that one monitor is a primary while the other secondary, so performing some tasks can only be done on applications positioned on the primary monitor. For instance, if you use screen-capture software, you can have that program open on the secondary monitor, but if you want to capture an image, you can only capture images of applications that are located on the primary monitor.

- **Software Driver Solution**
  The software solution to multi-monitor configuration is often found in older graphic cards that fit into your PCI slots. Each board has a single port.
to accept a monitor and the video drivers give you the option to configure a single display in “Wide” mode to encompass multiple displays. Also, because you have four PCI slots in your system, you could theoretically drive four monitors. However, in order for these cards to operate at the best resolutions, each card needs to have the same amount of video RAM (vRAM) installed. So, if your had two cards and one had 32 MB of vRAM and the other only had 8 MB, you can only configure to the highest resolution supported by the 8 MB card.

Display configuration is normally done through the video drivers so you have the option to configure wider screen areas. For example, instead of configuring each display individually to 1280x1024, as described above, you would treat both monitors as a single display and configure the screen area to 2560x1024 pixels.

Spanning Across Monitors
Whenever, you start 3ds Max, the user interface spans across both monitors. You find yourself constantly resizing the program to fit on one screen so you can see the programs located on the other screen.

This is usually a problem on systems that let you configure both monitors as one, in “Wide” mode. The utility software that loads with the graphic card manufacturer’s drivers probably has a feature that forces programs to open across the entire expanse of the display. You can turn off this feature and programs will open in the last position and size you gave them.

Viewport Transparency
After starting 3ds Max, the user interface appears but you can see the system desktop through each of the viewports. This problem normally occurs if you have the display configuration set to either OpenGL or Direct3D and your graphics card does not completely support OpenGL or Direct3D.
If configured for Direct3D, you might also see this problem coupled with the "Direct3D initialization failed" message.

To remedy this problem, follow the steps outlined in Basic troubleshooting start point on page 8486 and configure for Software. If 3ds Max opens correctly in this mode, check the video card manufacturers for updated drivers for the display mode you'd prefer to use.
Glossary

This section of the 3ds Max help contains explanations of concepts and terms used in the reference, arranged alphabetically.

2-Sided (Double Sided)

In 3ds Max, faces on page 8568 are one-sided. The front is the side with the surface normal on page 8654. The back side of the face is invisible to the renderer; meaning the face appears to be missing when viewed from the back. Objects are usually created with the surface normals facing outward, but it is possible to create objects with the faces flipped or to import complex geometry in which the face normals are not properly unified.

Rendering of a box with a double-sided material, and same box with a single-sided material

There are two ways to render both sides of a face. Either turn on the Force 2-Sided on page 6575 option in the Render dialog, or apply a two-sided material to the geometry.

Usually, you want two-sided rendering turned off since it slows rendering time. However, if you want to render the inside as well as the outside of objects, or if you've imported complex geometry (for example, from AutoCAD) in which the face normals are not properly unified, you can use one of the
preceding methods to render each face regardless of its normal's orientation. You can also unify normals explicitly by using the Normal modifier on page 1551.

**2D Map**

A two-dimensional image or pattern. A 2D map requires mapping coordinates on page 8628 to render and appear in viewports. See 2D Maps on page 6200.

**3D DWF**

From *Design Web Format*. A highly compressed file format that is created from a MAX file on page 8638. DWF files are easy to publish and view on the Web using the Autodesk Design Review program, included with 3ds Max.

**3D Map**

A pattern generated procedurally in three dimensions. A 3D map does not require mapping coordinates on page 8628 in order to render. However, a 3D map will appear in viewports only if the object to which it is applied has mapping coordinates. See 3D Maps on page 6278

**3DS and PRJ Files**

3DS is the 3D Studio mesh-file format and PRJ is the 3D Studio (for DOS) project-file format. You can import both these types of files into 3ds Max, as well as DXF and SHP files. You can export 3DS files and DXF files.

See also:

- Importing 3DS Files on page 7655
- Importing PRJ Files on page 7657
- Exporting to 3DS on page 7659
Action

Operators on page 8665 and tests on page 8741 in Particle Flow on page 2997 are known collectively as actions.

Commands that you can create custom user interface on page 8249 elements for are also known as actions or action items.

Active Link

When you use the File Link Manager utility on page 7538 to link a drawing to 3ds Max, the objects have an active link with the original drawing in AutoCAD or Autodesk Architectural Desktop. This means that any edit made to the drawing in AutoCAD or Architectural Desktop can be immediately updated in 3ds Max by reloading the link.

File Link Manager showing an actively linked drawing.

The red flag in the file list means the drawing has been changed in AutoCAD or Architectural Desktop and you should click the Reload button to update the scene in 3ds Max.

The Detach button will cause the drawing file that is linked to 3ds Max to be removed from the scene and removed from the File Link Manager utility.

Clicking the Bind button will bind the drawing to 3ds Max and sever the active link with AutoCAD or Architectural Desktop.
Active Time Segment

The active time segment is the total range of frames on page 8585 that you can access using the time slider on page 8068.

By default, the active time segment runs from frames 0 to 100, but you can set it to any range from the Time Configuration dialog on page 8106. In addition, the active time segment can include negative frame numbers, so you can create keys on page 8616 before frame 0 and work in negative time.

You can change the active time segment whenever you want without affecting the keys you've already created. You might think of it as a window in time, specifying only that portion of your animation in which you want to work. Thus, if you have keys scattered over a range of 1000 frames, you can narrow your active time segment to work on only frames 200–300 without affecting the keys outside of the segment.

Active/Inactive Footsteps

When you first create footsteps for a biped in Footstep mode on page 4774, they are inactive. You must activate these footsteps using the Create Keys For Inactive Footsteps button. Active footsteps have keys to animate the biped. Inactive footsteps have not been given keys by character studio on page 4465.

You can make active footsteps inactive by clicking Deactivate Footsteps.

Both these buttons are on the Footstep Operations rollout on page 4778.

In the Track View – Dope Sheet on page 3805 editor, inactive footsteps are displayed with a distinctive color to indicate they are inactive.

If you have upper body animation added to a biped, and you deactivate the footsteps, then re-activate you will lose the existing upper body keys. Use Adapt Locks on the Dynamics and Adaptation on page 4755 rollout to control which tracks on page 8744 are affected by the create keys process.
ActiveShade Initialize and Update

ActiveShade rendering on page 6550 is a two-step process:

- Initialize pass
- Update shading pass

The Initialize Pass

Rendering can be slow. The initialize pass is meant to take care of the most time-consuming portions of rendering, to allow the update shading pass to take place as quickly as possible. Initialization includes the following steps:

- Evaluate the scene geometry into meshes.
- Apply space warps on page 2887.
- Do transformations and clipping.
- Evaluate textures and shade materials.
- Perform optimizations to speed later processing, such as merging fragments from the same surface that are in the same pixel.

The result of initialization is a buffer. This is a compressed rendering that, like a G-Buffer on page 8589, contains the rendering plus additional information used by the second step, update shading.

During the initialize pass, progress is indicated by a row of pixels (white by default) that traverses the top edge of the ActiveShade window.

The Update Shading Pass

Updating shading takes the buffer created by the first pass, initialization, and uses information in that buffer to change the color of pixels when you make changes to lights on page 5314 and materials on page 5758 in the scene.

During the update pass, progress is indicated by a row of pixels (white by default) that descends the right edge of the ActiveShade window.
Adapt Locks

By default, character studio on page 4465 automatically adapts biped keys when you edit footsteps in a footstep animation on page 4515. You can avoid this adaptation by using the Adapt Locks toggles on the Dynamics & Adaptation rollout on page 4755. Each toggle locks a specific track so that character studio doesn't adapt it when you edit footsteps.

Adapt Locks applies only to footstep animation, not to freeform animation on page 4571.

Adaptation

In the Motion Mixer on page 8647, when the same clip is used more than once on tracks on page 8744, the clip versions are either instances on page 8611 or adaptations of one another.

The same clip used more than once for one biped on page 8521, or for different bipeds of the same size, is an instance. The same clip used for different-sized bipeds is an adaptation.

These terms are used because the Mixer adapts each loaded clip to the biped's size. The first time a clip is loaded, the Mixer adapts the clip as needed. When the clip is cloned or loaded again, the Mixer adapts the new clip to the biped as needed, then compares the change to previously loaded versions to see if it's the same. If so, the new clip and its previous versions are instances of one another. If not, the new clip and previous versions are adaptations of one another.

In footstep animation on page 4515, the term adaptation refers to keys on page 8616 generated for a footstep sequence. When you edit active footsteps on page 8496, body and leg keys are adapted automatically. By analogy, the footsteps become a kind of “gizmo” for manipulating the keyframes of your character's animation. In most cases, edits you make to footsteps will act upon your keys in an intuitive fashion.

Adaptive Degradation

When you turn on Adaptive Degradation on page 123, 3ds Max can change the way it displays objects to keep up with the current operation. For example, while you are zooming a viewport, some objects might change from shaded...
to bounded boxes on page 8528 during the zoom operation, and then switch back to shaded display when you finish zooming. The settings on the Adaptive Degradation panel on page 8384 of the Viewport Configuration dialog on page 8374 control how adaptive degradation occurs.

When Adaptive Degradation is off, viewports retain their display settings at all times, but operations such as zooming or animation playback cause a slow screen refresh rate. In this state, animation playback might have to drop frames to keep up with real-time on page 8697 playback.

You can set the parameters that control the trade-off between display quality and display speed. The levels you activate determine which rendering levels 3ds Max falls back to when it cannot maintain the desired display speed. You can choose as many levels as you want, but for best results choose only one or two levels.

**Additive Opacity**

An additive process adds two values together, such as two colors. When you add colors in 3ds Max, the result is brighter than either of the two original colors.
Additive Opacity

Sphere on the right uses additive opacity.

Additive opacity brightens the colors behind the material by adding the material's colors to the background colors. Additive opacity is good for special effects such as light beams or smoke. You specify the use of additive opacity on the Extended Parameters rollout on page 6013.

Additive Opacity and the Alpha Channel

By default, additive opacity does not generate an alpha value on page 8502. In other words, the alpha value is zero, indicating no transparency. This gives correct results with backgrounds in renderings, but if you want to composite objects with additive opacity using video post or a compositing program, you might want to have additive opacity render with transparency. To do so, add the following line to the [Renderer] section of the 3dsmax.ini file, and then restart 3ds Max:

```
AlphaOutOnAdditive=1
```
To revert to the default method of rendering additive opacity, in the `3dsmax.ini` file, change the value of `AlphaOutOnAdditive` back to 0 (zero), and then restart 3ds Max.

**See also:**
- **Subtractive Opacity** on page 8733

---

### Adjust Talent Pose

When you animate a biped with motion capture, after you load a marker file, you can use Adjust Talent Pose to correct the biped’s position relative to the motion-capture markers. Align the biped limbs to the markers, then click Adjust Talent Pose to compute this offset for all the loaded marker data. This button is on the **Motion Capture rollout** on page 4925.

### Affine Transformation

A geometric transformation such as move, rotation, or scale, that can alter distances between points or angles between lines, but preserves straight lines and the parallel relation between parallel lines. **Transform** operations are affine transformations. **NURBS** are invariant under affine transformations.

### Airborne Period

In footstep animation, a "ballistic gait" is defined as any footstep pattern in which there are periods with no feet on the ground, causing the biped to become airborne, or ballistic. For example, running, hopping, and jumping are ballistic gaits with airborne periods.

### Aliasing/Antialiasing

Aliasing is the staircase effect at the edge of a line or area of color when it’s displayed by an array of discrete pixels.
Pyramid is aliased on left, antialiased on right.

Antialiasing smoothes the staircase effect that occurs when diagonal or curved lines or borders are drawn on raster displays consisting of square or rectangular pixels. Antialiasing can be either on or off. Turn this off only when you’re rendering test images and want greater speed. Leave it on at all other times.

You can also turn antialiasing off for the Material Editor on page 5641 sample slots to speed up redraw of the sample objects. Click the Options button in the Material Editor and turn on the Antialias toggle on the Material Editor Options dialog. Default=off.

NOTE To control whether or not a background image is affected by the renderer's antialiasing filter, choose Customize > Preferences > Rendering and then turn on Filter Background in the Background group. Default=off.

**Alpha Channel**

Alpha is a type of data, found in 32-bit bitmap on page 6213 files, that assigns transparency to the pixels in the image.
A 24-bit truecolor file contains three channels of color information: red, green, and blue, or RGB on page 8698. Each channel has a particular intensity or value at each pixel. The intensity of each channel determines the color of the pixel in the image.

By adding a fourth, alpha channel, the file can specify the transparency, or opacity, of each of the pixels. An alpha value of 0 is transparent, an alpha value of 255 is opaque, and values in between are semi-transparent. Transparency is important for compositing on page 8534 operations, such as those in Video Post on page 7247, where several images are blended together in layers.

An alpha channel is particularly useful for the partly transparent pixels around the aliased on page 8501 edge of an object in a rendered image. These pixels are used for compositing. An image such as the one shown above can be composited smoothly onto a different background if an alpha channel is produced and saved with the image.

Each channel of a truecolor bitmap file is defined by 8 bits, providing 256 levels of intensity. Thus, an RGB file is 24-bit with 256 levels each of red, green, and blue. An RGBA file (red, green, blue, alpha) is 32-bit, with the extra 8 bits of alpha providing 256 levels of transparency.

3ds Max creates the alpha channel automatically when you render. Any background pixels in the rendered image are fully transparent, and the alpha channel also accounts for any other transparency that you create via materials, etc. You can see this in the rendered frame window on page 6513 by clicking the Display Alpha Channel button on the toolbar: In the resulting display, black pixels are fully transparent, white pixels are opaque, and gray pixels
show degrees of transparency. To return to the regular display, click Display Alpha Channel again.

To output a rendered image with alpha, save in an alpha-compatible format such as TIFF or Targa. With Targa, the default settings include saving alpha; with TIFF, be sure to turn on the Store Alpha Channel check box.

**Ambient Color**

Ambient color is the color of an object where it is in shadow. This color is what the object reflects when illuminated by ambient light rather than direct light.

Ambient color areas in the scene will not appear any darker than the ambient light setting.

You can lock a material's ambient color to its diffuse so that changing one automatically changes the other.

**Ambient Light**

Ambient light is the general light that illuminates the entire scene. It has a uniform intensity and is uniformly diffuse. It has no discernible source and no discernible direction.

By default, there's no ambient light in a scene. If you examine the darkest shadows on your model with the default ambient light setting, you cannot

---

8504 | Glossary
make out the surface because it's unlit by any light. Shadows in your scene will not appear any darker than the ambient light color, which is why you usually keep ambient light set to black (or a very dark color).

If you use photometric lights on page 5348 and a radiosity solution on page 6615, ambient light is accurately calculated. The other advanced lighting option, light tracing on page 6601, also generates ambient lighting.

If you use standard lights on page 5314 a good lighting test is to set your ambient lighting to black (the default), set up all your lights, and then decide at the end if you need to increase the ambient light.

**Animated Texture**

An animated texture is a material on page 8635 whose properties change over time. One example of this is assigning a multi-frame bitmap (for example, an AVI file or an IFL image-file sequence) as a map on page 8631.

Animated textures can also be materials with keyframed parameters. In addition, in the context of particle systems on page 8678, a material that uses the Particle Age map on page 6306 or the Particle MBlur map on page 6308 is considered to be animated.

In general, when applying an animated texture to particles in Particle Flow, be sure incorporate it in a Material Dynamic operator on page 3168.

**Animation**

Animation is based on a principle of human vision. If you view a series of related still images in quick succession, your brain perceives them as continuous motion. Each image is called a frame.

Historically, the major difficulty in creating animations has been that the animator must produce a large number of frames. Depending on the quality you want, one minute of animation might require between 720 and 1800 separate still images. Creating images by hand is a big job. That's where keyframing comes in.

Most of the frames in an animation are routine, incremental changes from the previous frame directed toward some predefined goal. Early animation studios quickly realized they could increase the productivity of their master artists by having them draw only the important frames, called keyframes.
Assistants could then figure out the frames that were required in between the keyframes. These frames were (and still are) called *tweens*.

Use 3ds Max as your animation assistant. As the master animator, you create the keyframes that record the beginning and end of each transformation. The values at these keyframes are called *keys*. 3ds Max calculates the interpolated values between each key value, resulting in tweened animation.

3ds Max is not limited to animating transformations (such as position, rotation, and scale). It can animate just about any parameter you can access. Thus, you can animate modifier parameters, such as a Bend or a Taper angle, material parameters, such as the color or transparency of an object, and much more.

Early animation studios also had to employ artists to add the ink and color to each frame. Even today, production of a cartoon usually requires hundreds of crafts people and artists to generate the thousands of images. With 3ds Max, the renderer takes over the job of shading and rendering each frame and storing it as you direct. The end result is a high-quality finished animation.

The quickest way to animate is to turn on Auto Key on page 3373 and start transforming objects at different frames. Each time you transform an object, you set a key. Then you can play the animation onscreen on page 8102, or render it to a file on page 6529.

### Animation Controllers/Transform Controllers

All animation in 3ds Max is performed through animation controllers on page 3391. The most common animation controllers, those for move (position), rotate, and scale, are also referred to as *transform controllers* on page 3406.

Each animation track on page 8745 has its own controller, and each controller can be different.

In the hierarchy list, the controller tracks are represented by controller icons. The icons can appear differently depending on the controller that is assigned, for instance a Noise on page 3519 Float icon differs from a Bezier on page 3432 Float icon. You can also see which specific controllers are assigned to each track by turning on the controllers display in the Track View on page 3790 (on the Track View toolbar, right-click Filters and choose Controller Types from the list). The controller names appear beside the tracks to which they're assigned.

You can assign different controllers to the tracks, affecting the way they respond. The Bezier Controller, assigned by default to all the Position tracks, lets you move objects using the Select and Move transform tool, and converts...
those movements into Bezier splines. You can adjust the splines in Function Curve on page 8588 editing mode.

**Animation Layers**

When you animate a biped on page 4468 or other object, you can add layers of animation above the original animation. This is a powerful way of making global changes to your animation. For example, if you add a layer to a biped animation and rotate the spine forward at any frame on page 8585, a run cycle becomes a crouched run. The original biped motion is kept intact and can be viewed by switching back to the original layer.

You can view layers individually or as a composite of all the animation in all the layers. Layers with bipeds behave like a freeform animation on page 4571; the object can adopt any position.

Layers used in conjunction with Biped let you easily adjust raw motion-capture data on page 4925, which contains keys on page 8616 at every frame. You do this by adding a layer and keyframing the biped.

Layer controls for Biped are on the Layers rollout on page 4741. For other objects, use the Animation Layers toolbar on page 8044.

**Applied IK**

A type of inverse kinematics on page 3661 where parts of the IK structure follow another animated object exactly. After the scene is set up, Applied IK generates transform keys on page 8616 for every object in the IK chain.

See Animating with Applied IK on page 3750.

**Area Lights (mental ray Renderer)**

Area lights are a feature of the mental ray renderer on page 6675. Instead of emitting light from a point source, they emit light from a broader area around the source. Area lights create soft-edged shadows. This can help improve the realism of your rendering.
Scene rendered with area light turned off
Shadows are ray-traced.
The yellow cube indicates the light’s location.
Scene rendered with area light turned on, showing soft shadows
The light in this rendering is a 2D (spot) area light.
Scene rendered with a 3D (omni) area light
The light uses the default radius of 20.0.

**NOTE** To render soft-edged shadows, shadows must be ray-traced on page 8696, not shadow-mapped on page 8719. See the Render Setup Dialog > Renderer panel > Shadows & Displacement rollout on page 6756.

Area lights support global illumination on page 6706, caustics on page 6700, and other features of the mental ray renderer.

**TIP** Area lights take longer to render than point lights. If you are interested in creating a quick test (or draft) rendering, you can use the Area Lights/Shadows As Points toggle to speed up your rendering. This toggle is on the Render Setup dialog > Common panel > Common Parameters rollout on page 6568.

### Area Shadows

Area shadows simulate shadows generated by a light with area or volume.
The shape of the shadow-casting region changes the shape of area shadows.

**Aspect Ratio**

Aspect ratio describes the proportions of a still image or the frames on page 8585 in a movie, expressed as the ratio of width to height, regardless of the image's resolution on page 8701.
Various aspect ratios

Aspect ratio is usually expressed either as a ratio of width to height (for example, 4:3) or as a real value relative to 1 (for example, 1.333). For example, pre-1950s movies and non-HD TV shows have an aspect ratio of 4:3.

The aspect ratio is used wherever a bitmap on page 6213 is created or used. For example:

- When preparing to render, you can specify an aspect ratio for your rendered images with the Image Aspect parameter on the Render Setup dialog on page 6506.
- When setting up a viewport background on page 136 you can specify whether to use the viewport, bitmap or rendering output aspect ratio to display the bitmap.
When you make a spotlight a projector on page 5457, you can use the Bitmap Fit option to match the spotlight's aspect ratio to the bitmap's, and thus prevent the bitmap from distorting.

Attachments (IK)

In biped on page 4468 animation, the biped hands and feet can be linked to the world on page 8769, another object in the scene, or to the biped's own body. This linking is also called IK attachment on page 4616. Attachment can be blended: this lets you start with one attachment and end with another. For example, if the biped is catching a ball, you can start with the hand in body space on page 8527 and end with the hand in the coordinate space on page 8541 of the ball.

Attenuation

In the real world, the intensity of light diminishes over distance. Objects far from the light source appear darker than objects near the source. This effect is known as attenuation.

Image on right rendered with attenuation

In nature, light attenuates at an inverse square rate; that is, its intensity diminishes in proportion to the square of the distance from the light source. It is common for attenuation to be even greater when light is occluded by small particles in the atmosphere, especially when there are clouds or fog present.
**Attenuation and Photometric Lights**

Photometric lights always attenuate at the inverse square rate. This is one of the reasons it is important for scenes with a radiosity solution to use real-world dimensions and units.

**Attenuation and Standard Lights**

By default, standard lights don't attenuate. Consequently, an object's distance from the light doesn’t matter, and only the angle of light to the surface has any effect on illumination unless you turn on attenuation. You can manually control the rate of attenuation for standard lights. You can also use attenuation with the Raytrace map. If your scene uses standard lights, you should consider adding attenuation whenever possible, for two reasons:

- Attenuation provides greater subtlety and realism in your lighting.
- You can reduce rendering time, since attenuated lights don’t have to be calculated for surfaces that are beyond the attenuation range.

For standard lights, you can explicitly set where attenuation begins and ends. This is partly so you don’t have to worry about setting up strictly realistic distances between light objects and the objects they illuminate. More importantly, this feature lets you fine-tune the effect of attenuation. In outdoor scenes, attenuation can enhance the effect of distance. In an indoor setting, attenuation is useful for low-intensity light sources such as candles.

For standard lights, you set attenuation parameters on the light’s Intensity/Color/Attenuation rollout on page 5431. For the Raytrace map, you set the parameters on the map’s Attenuation rollout on page 6369.

**AutoGrid**

AutoGrid is an option on the 3ds Max Create panel on page 360 that lets you create an object on the surface of another object. You can turn on AutoGrid when you create a biped on page 4468, in order to position the biped on another object.

You can also use AutoGrid when creating footsteps manually on page 4527 to place the footsteps on an uneven terrain.
Avoid Behavior

In crowd animation on page 5104, the Avoid behavior on page 5209 lets you specify any object or objects that delegates on page 8549 must keep away from. As delegates approach designated objects during the crowd simulation, they steer clear of them while turning or braking as necessary. This behavior uses three different methods to let delegates avoid each other and other objects: Steer To Avoid (the preferred method), Repel, and Vector Field. See Obstacle Avoidance on page 5123.

Avoidance Behavior

In crowd animation on page 5104, avoidance behavior consists of any combination of slowing down, turning, and stopping. See Obstacle Avoidance on page 5123.

Axonometric View

A projected view of 3-dimensional space that displays from one to three sides of an object. The lines in an axonometric view do not converge to vanishing points as they do in a perspective view on page 8681, so lines that are parallel in 3D space are parallel in the view. For this reason, diagonal and curved lines can appear to be distorted.
Axonometric view of model

Isometric on page 8614 and orthographic on page 8668 views are special cases of axonometric views.

B-Spline

B-spline (basis spline) is a way to construct a curve that is interpolated between three or more points, it is a kind of spline generated by so-called basis functions. The advantage of B-splines over Bezier curves on page 8519 is that the control vertices (CVs) on page 8539 of a B-spline affect only their local region of the curve or surface. B-splines also compute faster than Bezier curves.

Balance Factor

Balance Factor positions a biped's weight anywhere along a line that extends from the center of mass on page 4663 to the biped's head, affecting the degree to which the hips or head (or both) swing away from their original vertical alignment when the biped is bent over.
Balance Track

Each biped added to the Motion Mixer on page 4002 is automatically assigned a balance track. You don't place motion clips on page 8646 on this type of track as you do with transition tracks on page 8751 and layer tracks on page 8617. The weight curve on page 8762 on the balance track is the only adjustable parameter.

By default, the Motion Mixer compensates for differences in upper and lower body motion that might cause the biped to go off balance over the course of the animation. It accomplishes this by changing the COM on page 4663, pelvis and spine animation.

When the weight curve across the balance track is set to 1.0 (the default), balance compensation is enabled for the entire animation. You can adjust nodes on the weight curve to disable balance compensation over all or part of the animation. See Adjusting Biped Balance in the Mixer on page 4038.

Ballistic Gait

A "ballistic gait" is defined as any footstep on page 4515 pattern in which there are airborne periods (periods with no feet on the ground) such as a jumping or running pattern.

Ballistic Tension

Controls the amount of spring or tension when the biped lands or takes off from a jump or run step. See Adjusting Vertical Motion on page 4555.

Barycentric Coordinates

Given a triangle between points A, B, and C, each point X on the surface of the triangle can be represented by a weighted sum of the corners:

\[ X = a \cdot A + b \cdot B + c \cdot C \]

where a, b, and c are numbers between 0 and 1 and a+b+c = 1.
These numbers are called the *barycentric coordinates* of the point X. There is one unique set of barycentric coordinates for each point on the triangle.

**Examples**

The center of gravity of the triangle is given by the barycentric coordinates $(1/3, 1/3, 1/3)$: $X = 1/3 A + 1/3 B + 1/3 C = (A+B+C)/3$.

If one of the barycentric coordinates is zero, the point X must lie on the opposite edge. For instance:

if $a=0$, $X = b*B + c*C$

where $b+c=1$

This means that X is on the line segment BC.

If $a=1$, on the other hand, then $b=c=0$, and X must be exactly the point A.

**Behaviors**

In *crowd animation* on page 5104, behaviors simulate a range of activities. Seek, avoid, path follow, surface follow, repel, orientation, scripted, space warp, surface arrive, wall repel, wall seek, and wander are all behaviors available in a crowd simulation. See *Crowd Behaviors* on page 5162.

Behaviors let you assign procedural activity types to delegates on page 8549 and objects linked to delegates. You can associate any number of behaviors with each Crowd object, and then link delegates and teams of delegates to each behavior. A specific behavior assigned to a Crowd object belongs only to that crowd; it cannot be assigned to any other crowds.

**Bend Links**

When you turn on Bend Links Mode (on the *Bend Links rollout* on page 4700), rotating a single chain link causes the other links to bend following a natural curvature. When Bend Links Mode is off, rotating one link rotates all its children links by the same amount.
Bend Links Mode active (left) and Bend Links Mode inactive (right)

**TIP** Bend Links works well on the biped on page 4468 spine, neck, tail and ponytail links.

**Bezier Curve**

A segment on an editable spline on page 634 that has its vertices set to Bezier or Bezier Corner is considered a Bezier Curve.

A curve modeled using a parametric polynomial technique. Bezier curves can be defined by many vertices. Each vertex is controlled by two other points that control the endpoint tangent vectors. Bezier curves were developed by P. Bezier for computer modeling in automobile design.
A vertex on a Bezier Curve affects the entire curve in that area. Compare with B-splines on page 8516, where the control vertices (CVs) on page 8539 affect only their local region of the curve or surface.

**BioVision Files**

The BioVision™ file format stores motion-capture information. A BVH file contains the "actor's" skeletal and limb/joint rotation data, and uses the .bvh file name extension.

*NOTE* For the BVH file specification, see the BVH.rtf document on 3ds Max disc.

**BIP Files**

BIP files contain skeletal size and limb rotation data for bipeds on page 4468. This is the native character studio motion file format.
Biped

Biped is a 3ds Max system provided with the character studio product. It provides the armature used to pose a character, and facilities to animate it using either footsteps on page 4515 or freeform animation on page 4571. See Biped on page 4487.

Biped Dynamics

Biped dynamics calculate a biped’s airborne trajectory, the bending of its knee or knees on landing, and the biped position so it maintains balance when the spine is rotated. When the position or animation of the biped change, dynamics cause the biped to adapt.

There are six parameters that affect biped dynamics. Three are in the Body section of the Key Info rollout on page 4704:

- Balance Factor on page 8516
- Dynamics Blend on page 8557
- Ballistic Tension on page 8517

The other three are on the Dynamics & Adaptation rollout on page 4755:

- GravAccel on page 8597
- Biped Dynamics
- Spline Dynamics on page 8730

Birth Event

A birth event is a special type of local event on page 8623 that always comes at the start of a particle flow on page 8581, immediately after the global event on page 8594. Its first action on page 8495 is a Birth operator on page 3052 or Birth Script operator on page 3056. The birth event can contain any number of additional actions, and can be succeeded by any number of additional events.
Birth event (highlighted)
Bitmap

A bitmap is a still image produced by a fixed matrix of colored pixels on page 8687, like a mosaic. You can use bitmaps as textures for materials on page 6213, as backgrounds to viewports on page 128, and as rendered environments on page 7168.

You can use an animation or video file as a bitmap, in which case the material or background changes over time.

Bitmaps can be reloaded automatically after they have been changed and resaved by a graphic editing program. See the Reload Textures On Change toggle in Preferences Settings > Files panel on page 8305.

3ds Max can use the following image file formats as bitmaps:

- avi on page 7832
- bmp on page 7834
- cin on page 7834
- cws on page 7835
- dds on page 7836
- gif on page 7841
- Radiance Image File: (hdr on page 7866, pic)
- ifl on page 7841
- jpg on page 7848
- mov on page 7849
- mpg on page 7850
- png on page 7862
- psd on page 7863
- rgb on page 7877
- rla on page 7873
- rpf on page 7875
- tga on page 7878
- tif on page 7880
- yuv on page 7882
NOTE  3ds Max can also render to some of these formats, but not to all of them. See the topic for the individual image format for details.

**Blend Object**

A dependent NURBS object that connects two curves or two surfaces. The curvature of the blend is controlled by the objects it connects, and by two tension parameters that control the "length" of effect of the tangent for each of the "parent" objects.

![NURBS blend surface](image)

**Block Reference**

In AutoCAD, a compound object that is inserted into a drawing and displays the data stored in a block definition. A block reference is also sometimes referred to as a Block Instance. Refer to the AutoCAD, Autodesk Architectural Desktop, or Autodesk Mechanical Desktop help files for further information regarding Blocks, Block Instances, and Block References.
Block/Style Parent

A Block/Style Parent is closely related to a VIZBlock on page 8758 in that it is a compound object similar to a nested AutoCAD block. Just like the VIZBlock, it is used for organizing linked data from DWG files on page 8556. When linking DWG data to 3ds Max, you need to decide how the incoming entities are to be organized in the scene. Objects in DWG files are commonly organized by layers, blocks on page 7528, and entities, while 3ds Max scenes are organized by parent/child hierarchies on page 3618 of objects.

The main difference between a Block/Style Parent and a VIZBlock is that a Block/Style Parent allows for a parent/child hierarchy of “components,” but does not display any of its own geometry. A VIZBlock displays its own geometry and lists a set of “components,” or sub-objects.

Blur/Blur Offset

The Blur and Blur Offset controls determine how a 2D map on page 6200 is blurred, or how it is softened in the rendering. You can’t see their effect is visible only when rendering on page 6505 final output.
The Blur setting blurs the map based on its distance from the view. The farther away the map is, the greater the blurring. You should always use some blurring on your maps to avoid the type of scintillation, or aliasing that can occur when pixel details are reduced off in the distance. This effect typically occurs when you use detailed bitmaps viewed at a distance, and is particularly apparent during animations. The Blur default is 1.0, which is a good setting for most purposes.

Blur Offset blurs the map without regard to depth. That is, all the pixels in the map are blurred equally, regardless of how close or how far they are from the camera.

Whereas the Blur value is primarily used to avoid aliasing, Blur Offset is useful when you want to soften, or defocus the details in a map. It’s the equivalent of blurring the bitmap in an image-processing program before applying it as a material map.
NOTE For bump mapping on page 6049, lower Blur and higher Blur Offset values give better results.

Body Space

A biped on page 4468 limb can be put into world space on page 8769, into the coordinate space on page 8541 of an object in the scene as well as body space. Body space moves the biped limbs when the biped moves; if you rotate the biped’s hips, the feet, in body space, move as well.

Boolean Operation

A Boolean object on page 713 combines two objects by performing a Boolean operation on them. In 3ds Max, a Boolean object is made from two overlapping objects. The original two objects are the operands on page 8665 (A and B) and the Boolean object itself is the result of the operation.

The fence is operand A, and the cat is operand B.
For geometry, the Boolean operations are:

- **Union**: The Boolean object contains the volume of both original objects. The intersecting or overlapping portion of the geometry is removed.

- **Intersection**: The Boolean object contains only the volume that was common to both original objects (in other words, where they overlapped).

- **Subtraction (or difference)**: The Boolean object contains the volume of one original object with the intersection volume subtracted from it.

**Bound Vertex**

Binding **spline** on page 8729 vertices via the Refine and Bind functions in **Editable Spline (Vertex)** on page 634 is useful for connecting splines when building a spline network for use with the **Surface Modifier** on page 1763.

Bound vertices are black, allowing them to be easily distinguished from standard vertices. You cannot move a bound vertex directly. However, changing the **segment** on page 8714 length by scaling it or by moving a connected vertex causes the bound vertex to shift its position in order to remain at the segment's midpoint. You can change a bound vertex's type (right-click the vertex, and then choose the type from the bottom of the right-click menu), and if you convert it to a Bezier or Bezier corner, you can manipulate its handles. See **Connect** on page 638.

**Bounding Box**

The bounding box is the smallest box that encloses the maximum dimensions or **extents** on page 8567 of an object.
Bounding box shows the extents of the model boat.

You can display selected objects in the scene as bounding boxes to speed up screen redraw. Use the Object Properties dialog on page 283.

The Align command on page 967 uses the maximum and minimum extents of the object's bounding box to align objects.

Bulge

Physique on page 4944 allows you to “bulge” a mesh based on the orientation of a limb. Bulging the mesh on page 8638 is used to simulate muscle contraction. See Bulges on page 4990.

Bulge Angle

In Physique on page 4944, a bulge angle is a control that sets the limb angle where the bulge will occur. Typically you first orient the limb, and then set
the bulge angle. After setting the bulge angle, you then deform the mesh on page 8638 to make it bulge.

**BVH Files**

BVH is the file name extension for the BioVision™ on page 8520 motion-capture file format. A BVH file contains the 'actor's' skeletal and limb/joint rotation data.

**NOTE** For the BVH file specification, see the BVH.rtf document on 3ds Max disc.

**By Layer**

By Layer icon in the Layer Manager dialog

ByLayer is a property setting available to objects listed in the Layer Manager on page 7956, as well as from the Object Properties dialog on page 283. When By Layer is set, the object inherits settings for the selected property from its associated layer.

**Center of Mass (COM)**

The parent or root object of a biped on page 4468. Transforming the center of mass moves the entire biped. The center of mass can move outside of the biped body; for example, moving the center of mass forward can help simulate lifting a heavy object. The center of mass uses three animation tracks on page 8745 to animate the biped. Two of these tracks, Body Vertical and Body Horizontal, contain biped dynamics on page 8521 parameters. See Track Selection Rollout on page 4686.

**CGFX File**

CGFX is a shader description format developed by nVidia. It is compatible with DirectX (DX9 and DX10), and also with OpenGL (however, 3ds Max doesn't support hardware shading in OpenGL viewports). The DirectX Shader
material on page 6175 can apply CGFX shaders to objects, and display them with hardware shading in viewports.

By default, DirectX shaders, including CGFX files, are saved in \maps\fx\ in the 3ds Max program directory.

**Chamfer**

A dependent NURBS on page 2417 object that is a line segment on page 8714 connecting two curves. It is controlled by the curves it connects, and by two length parameters that control the distance back from the point of apparent intersection of the “parent” curves.

![NURBS chamfer curves](image)

**character studio Marker Files**

The character studio marker (CSM) file format stores motion-capture data on page 4916 in ASCII (text) format. It uses positional markers on page 8632 rather than limb rotation data. When you import a raw marker file, only marker
position data is stored in the motion-capture buffer on page 4934. character
studio uses the marker data to extract limb rotation data to position the biped.

NOTE For the CSM file specification, see the CSM.rtf document on 3ds Max disc.

CIBSE Files

The CIBSE file type is the file format for photometric data adopted by the Chartered Institution of Building Services Engineers. It is used primarily in Great Britain.

Clip Controller

In crowd animation on page 5104, the GlobalMotionClip and MasterMotionClip controllers are used to create animation for multiple objects. Birds, butterflies, schools of fish, and bugs can be animated using these tools. Clip controllers can be created either as block controllers on page 3436 in Track View on page 3790, or more directly in the Crowd helper on page 5162 controls on the Global Clip Controllers rollout on page 5257. Use clip controllers to animate non-biped creatures in crowds.

Clipping Planes

Clipping planes let you exclude some of a scene's geometry to view or render on page 6505 only certain portions of the scene. Each camera on page 5545 has a near and a far clipping plane. Objects closer than the near clipping plane or farther than the far clipping plane are invisible to the camera.
Clipping planes are useful for rendering selected portions of a scene that have a lot of complex geometry. They can also help you create cutaway views.

Clipping plane settings are part of the camera's creation parameters. The location of each clipping plane is measured along the camera's line of sight (its local Z axis) in the current units for the scene.

Clipping planes are part of a camera’s general parameters on page 5570.

Viewports can also have clipping planes. You set a viewport’s clipping planes via the viewport right-click label on page 8117.

**Codec**

Short for compressor/decompressor. An algorithm for compressing and decompressing digital video data, and the software that implements that algorithm.
Cognitive Controller

In crowd animation on page 5104, the Cognitive Controller editor on page 5199 lets you sequence different behaviors on page 5115 using state diagrams, where conditionals written in MAXScript impose changes in behavior. For example, you can specify that a character or object is to wander aimlessly until it comes within a certain distance of another object, whereupon it heads straight for that object. Or you can specify that one character is to avoid another only when the second character is avoiding the first.

Composite

(noun) A still image or a motion picture created by overlaying one image or motion picture with another.

The mailbox with its shadow is composited with the wall and sidewalk to make the finished scene.

(verb) To combine still images or motion pictures by laying one over the other. Compositing often makes use of an image’s alpha channel on page 8502.
Compound Materials

Compound (or complex) materials on page 8635 let you create a material consisting of two or more sub-materials.

House on right uses a compound material.  
(House on left uses the default standard material).

The real power in using compound materials is that each sub-material can be as complex as any standard material on page 5962.

The Multi/Sub-Object on page 6120 compound material lets you assign different materials to different sub-objects, at the sub-object level of your geometry.

You load or create compound materials using the Material/Map Browser on page 5724.

For more information about the types of compound materials you can create, refer to Compound Materials on page 6106.

Constrained Point

A NURBS Point on page 2417 that is dependent on either another Point, Curve, or Surface, and whose position is either on the parent object or relative to it. The relative cases are XYZ-relative, along a normal on page 8654, or along a tangent on page 8737 (or set of tangents for a surface-dependent constrained point).
Contact Object

In Particle Flow on page 2997, in the context of the Shape Mark operator on page 3149, a contact object is the object that will receive the marks created by the operator on page 8665.

Container

A Container is a helper object that lets you organize scene contents into logical groups that can then be handled as a single object. Because Containers and their contents can be saved as a MAXC file, they can be shared among multiple users.

Contents of each city block is grouped in its own Container

Containers are designed to:

- Reduce scene complexity by representing a collection of objects as a single entity.
- Improve scene performance by temporarily removing (unloading) unused Containers.
- Share scene content by allowing others to reference saved Containers, and inherit that content into their scene.
- Make some Container content available to others for edit, while locking other content.

A Container that is created locally and used to organize scenes is referred to as a Unique Container on page 8752. There is no content inherited from an external source.
A **Source Container** on page 8725 is a Container you inherit from someone else. The source content is updated each time the Container is saved. Source Containers cannot be edited unless access is granted by its author.

**See also:**
- **Local Container** on page 8620
- **Source Container** on page 8725
- **Unique Container** on page 8752

**Containers**

Containers are **Track View** on page 3790 items with multiple branches that provide a complete definition of something in your scene.

Container items that appear in Track View include:
- Materials definitions with all parameters, maps, and sub-materials.
- Maps containers with all map types and map parameters.
- Single Map containers with a single map type and its associated parameters.
- Object containers directly below a named object item defining the creation parameters of an unmodified object.
- Modified Object containers holding all of the modifiers applied to an object as well as the creation parameters.

**Continuity**

A property of curves, including **NURBS curves** on page 2464. A curve is continuous if it is unbroken.

**Continuity Level**

The level of **continuity** on page 8537 is a way to describe curvature. A curve with an angular cusp is C0 continuous. The curve is continuous but its derivative is not. A curve whose curvature changes has C1 continuity. The curve and its
derivative are both continuous but its second derivative is not. A curve with uninterrupted, unchanging curvature has \( C^2 \) continuity. NURBS curves must have at least \( C^0 \) continuity; a continuity level greater than \( C^2 \) is unnecessary for most 3D computer modeling.

Levels of curve continuity:
Left: \( C^0 \), because of the angle at the top
Middle: \( C^1 \), at the top a semicircle joins a semicircle of smaller radius
Right: \( C^2 \), the difference is subtle but the right side is not semicircular and blends with the left

**Control Lattice**

In NURBS modeling on page 2416, the lattice described by the CVs on page 8539 that specify a CV Curve or CV Surface. In viewports, this appears as a dotted yellow framework when you edit the curve or surface at the CV sub-object level. You can also choose to display the control lattice in viewports at all times. See CV Sub-Objects and Point Sub-Objects on page 2429.
Control Point

In Physique on page 4944, a vertex used to control the cross sections of envelopes, bulges, and tendons. See Using Physique on page 4946.

Control Vertex (CV)

In NURBS modeling on page 2416, a vertex that controls a CV Curve on page 2473 or CV Surface on page 2460. The 3D location of each CV on page 8539 affects the shape of the curve or surface. CVs aren’t constrained to lie on the curve or surface. Each CV has a rational weight that can be used to adjust the influence of the CV on the curve’s or surface’s shape.
Control vertices in the lattice surrounding a NURBS surface

Controller

Software that controls animation. Controllers handle the following functions:

- Storing animation key values
- Storing procedural animation settings
- Interpolating between animation key values

Convex Hull Property

The property of NURBS curves and surfaces whereby the control lattice described by CVs forms a convex hull surrounding the curve or surface.
Cool

It's useful to be able to edit a material in the Material Editor on page 5641 and have it immediately updated in the scene. Sometimes you want to work on a material without affecting the scene. You want to adjust a material until you're sure that it's what you want, and then reassign it. In other words, you want to cool a hot material on page 8603.

You cool a material by copying it in the Material Editor sample slots. You can copy a material in two ways:

- Use the Copy Material button on page 5692.
- Drag and drop to copy the material.

When you drag to copy a sample, you end up with two materials with the same name, but one is cool while the other is hot. In the Material Editor, you can have up to 24 materials with the same name, but every material in your scene must have a unique name.

You can now adjust the cool material, and compare it with the hot material. If you like the changes you've made, you can update the scene.

Coordinate Space

A 3D world is described in terms of 3D Cartesian coordinates. In 3ds Max, the main coordinate space, used to describe the scene as a whole, is known as the World coordinate system on page 8768. When you create or transform an object, you can use other coordinate spaces, such as coordinates particular to a viewport, local to the object itself, or defined by a Grid object on page 2789. See Reference Coordinate System on page 922 for more details.

Coordinate Spaces in Biped

In character studio on page 4466 biped animation, the three most-used coordinate spaces are world, object, and body space on page 8527. These are often used to control the biped's hands and feet.

Another coordinate system is used for the footstep on page 4515 gizmos themselves: a foot on a footstep is in that footstep's coordinate space. If the footstep is moved, the foot moves also. (A sliding footstep is a footstep that moves relative to the coordinate system of the corresponding footstep gizmo.)
CPY Files

CPY files are used with character studio Bipeds on page 4468. They contain postures, poses, and tracks you have copied and saved on the Copy/Paste rollout on page 4726. You can load a CPY created with one biped to another biped. See Copying and Pasting Postures and Poses on page 4619 and Copying and Pasting Tracks on page 4649.

Creation Parameters

An object’s creation parameters are settings, typically available on its Parameters rollout, that you make when you first add the object to the scene. You can later adjust these settings by accessing the object at the bottom of its modifier stack on page 8184. For example, a Box primitive’s creation parameters on page 391 are its size and number of segments in each of the three dimensions. You can usually adjust an object’s size without scaling it by changing its creation parameters.

If you collapse on page 2022 an object, its creation parameters are lost, and can no longer be adjusted.

Cross Section

In Physique on page 4944, envelopes on page 8561, bulges on page 8529, and tendons on page 8738 all have cross sections. Envelope cross sections can be moved and scaled to encompass more or less of the character's skeleton. In bulges, shaping the cross sections controls the amount of bulging and the appearance of the bulge. In tendons, cross sections provide connections between links and the mesh skin.

Crowd

The Crowd helper object on page 5162, available from Create panel > Helpers, serves as the command center for setting up and solving crowd simulations on page 5104. The Crowd helper object also lets you add behaviors on page 5115 to the scene, choose the current behavior from a list, and modify that behavior.
Crowd System

In crowd animation on page 5104, a crowd system comprises the Crowd helper on page 5162, one or more Delegate helpers on page 5154, a Vector Field space warp on page 5258, and Motion Flow mode on page 4886. These are used in combination to animate characters or other objects.

CSM Files

The CSM (character studio marker) file format stores motion-capture data on page 4916. It is an ASCII (text) file that uses positional markers on page 8632 rather than limb rotation data. When you import a raw marker file, only marker position data is stored in the motion-capture buffer on page 4934. 3ds Max uses the marker data to extract limb rotation data to position a biped.

**NOTE** For the CSM file specification, see the CSM.rtf document on 3ds Max disc.

Curve View

Curve View is the area of the Animation Workbench on page 4823 that displays function curves for the parts of the biped on page 4468. Curve View is quite similar to the Key Window on page 3797 in the Track View – Curve Editor on page 3951. The same navigation and key manipulation toolbars are used in both Curve View and the Key Window. Both Curve View and the Key Window let you add or delete, move or scale keys selected on the curves.

Curve View differs from the Key Window in that it also displays errors found by the Analyzer panel on page 4832, functionality which is not available in the standard Track View. Curve View doesn't use soft-selection like the Key Window, instead it has a specialized Show Layered Edit on page 4821 command for the equivalent of soft selection on biped keys.

CV

Short for control vertex.

In NURBS modeling on page 2417, a vertex that controls a CV Curve on page 2473 or CV Surface on page 2460. The 3D location of each CV affects the shape of the curve or surface. CVs aren't constrained to lie on the curve or surface. Each
CV has a rational weight that can be used to adjust the influence of the CV on the curve's or surface's shape.

CVs (control vertices) in the lattice surrounding a NURBS surface

**CV Curve**

A NURBS curve on page 2464 defined by CVs on page 8543. The CVs don't necessarily lie on the curve. Instead, they form a control lattice on page 8538 that affects the curvature of the curve. See CV Curve on page 2473.
CV Surface

A NURBS surface on page 2454 defined by CVs on page 8543. The CVs don’t necessarily lie on the surface. Instead, they form a control lattice on page 8538 that affects the curvature of the surface. See CV surface on page 2460.
Deformable Envelope

In Physique on page 4944, envelopes on page 8561 follow the Physique deformation spline on page 8547 that runs through the joints in the skeleton's hierarchy. A deformable (as opposed to rigid) envelope is one that moves the mesh vertices it encloses as the skeleton moves.

A link can have both a deformable and a rigid envelope. When it has both, the effect of the two is averaged, creating a less flexible skin.

In character animation, you typically use deformable envelopes; however, some portions of the body, such as the head, might look best if they are rigid. See Deformable and Rigid Envelopes on page 4970.

NOTE Because of game-engine restrictions, if you are developing for certain engines, you might want to use rigid envelopes exclusively.
**TIP** If your model consists of articulated rigid segments, such as a marionette, you might not need to use Physique at all. Simply link each part to the corresponding biped object.

---

**Deformation**

The effect caused by Physique on page 4944 on a mesh. Envelopes, bulges, link parameters, and tendons all affect how a mesh deforms. See Physique Sub-Objects on page 5059.

**Deformation Spline**

The deformation spline on page 5069 is created when you initialize Physique on page 4944. It is a continuous curve through several points. The deformation spline is a smooth curve that runs from joint to joint.
The deformation spline displays as a yellow curve that runs through the mesh.

The Bend, Bias, and Tension spinners can change the shape of the deformation spline. See Link Settings Rollout on page 5070.
The deformation spline also takes into consideration twisting and scaling of the skeleton’s links. At the Link sub-object level on page 5068, you take control of the behavior of the deformation spline, and subsequently gain full control of the skin's behavior relative to the skeleton’s movement.

Degree

The degree of a curve is the highest exponent in the equation used to represent it. A linear equation is degree 1, a quadratic equation degree 2. NURBS curves typically are represented by cubic equations and have a degree of 3.

Delegates

In crowd animation on page 5104, the Delegate helper on page 5154 serves as an agent for the motion created by a Crowd object on page 5162 and its behaviors. The Crowd object controls a delegate or delegates, whose motion can then be imparted to a biped on page 4468 or other object.

In viewports, the delegate object takes the shape of a pyramid. By default, the point of the pyramid indicates the delegate's forward direction. Delegates cannot be rendered.

Dependent

A dependent is an object whose behavior or appearance can be influenced by other objects. Dependents include instances on page 8611, references on page 8699, and objects sharing a common modifier on page 8643 (the same objects that appear green when Show Dependencies on page 148 is on in the View menu). Also, an object whose motion is constrained on page 3574 by another’s is a dependent of the constraining object.

See also:

■ Select Dependents on page 7901 in the Scene Explorer dialog
Dependent (NURBS)

Describes a NURBS sub-object on page 2417 whose definition depends on other NURBS sub-objects. For example, a Blend Curve on page 2562 depends on the two curves that you select when you create it.

Depot

The depot is the section of the Particle View dialog on page 3015 that holds the Particle Flow on page 2997 actions on page 3046. In effect, it serves as a library of Particle Flow functionality. Display of the depot can be toggled with the Particle View menu command Display > Depot.

To add an action to the particle system, drag it from the depot to the event display on page 3027. To view a description of an action in the description panel on page 8551, click its entry in the depot.
Description Panel

The description panel, found to the right of the depot on page 8550 in Particle View on page 3015, displays a text description of any action on page 3046 whose name you click in the depot. Display of the depot can be toggled with the Particle View menu command Display > Description.

Diagonal

A diagonal is a line that connects polygon vertices in editable poly and Edit Poly on page 1359 objects. Its function is primarily to resolve the polygon into triangles at render time, especially if the polygon becomes non-planar via transformation of its vertices. Such transformation and certain other operations can, incidentally, cause automatic rearrangement of a polygon’s diagonals.
Diagonals on the default Cylinder primitive

Diagonals are normally invisible, but in 3ds Max they appear as dashed lines when you use the Turn or Edit Triangulation tool. Unlike edges, diagonals cannot be transformed, or acted upon with tools like Chamfer. This is different from the hidden edges in editable mesh/Edit Mesh objects, which are actual edges and can be made visible, transformed, and manipulated with any editing tool.

**Diffuse Color**

The diffuse color is the color that an object reflects when illuminated by "good lighting," that is, by direct daylight or artificial light that makes the object easy to see.
When we describe an object’s color in conversation, we usually mean its diffuse color.

The choice of an ambient color on page 8504 depends on the kind of lighting: for moderate indoor lighting it can be a darker shade of the diffuse color, but for bright indoor lighting and for daylight, it should be the complement of the primary (key) light source. The specular color on page 8728 should be either the same color as the key light source, or a high-value low-saturation version of the diffuse color.

## Dithering

When converting an image with a palette of a greater number of colors to an image with a palette of fewer colors, dithering is a means of simulating colors not in the more limited palette, by mixing different-colored pixels on page 8687 together.
Square on the right shows dithering.

Dithering is also a method of smoothing the edges between two color regions by mixing their pixels so the edges appear to blend together.

If you are rendering on page 6505 for the limited colors of an 8-bit display (256 colors), you have the option of turning on dithering. Dithering can help prevent a banding effect in color gradients. Dithering does increase the size of 8-bit files and can slow the playback speed of animations. You might want to try applying maps on page 6185 to the flat areas in the scene to see if that eliminates banding before you turn on dithering.

By default, 3ds Max renders 64-bit color output. Consequently, you also have the option of setting dithering for truecolor (24 or 32-bit color) on page 8752. The Dither True Color option ensures that you get the best quality on truecolor displays.

You turn dithering on and off in the Rendering panel on page 8342 of the Preferences dialog. You can also set dithering for scene motion blur in Video Post on page 7247. Here, dithering provides a smoothing effect between the separate images making up the “blur.” Video Post dither is set as a percentage of total dither in the Add Scene Event dialog on page 7287.
Dock and Float

These terms describe manipulations to user-interface on page 7981 elements, such as toolbars.

You *dock* a toolbar, for example, when you align it with the edge of another interface element, typically a window or panel.

You *float* a toolbar when you detach it from a stationary position, and reposition it elsewhere on the desktop.

Double Support Period

In *footstep animation* on page 8584, a period where both of the *biped's* on page 4468 feet are on the ground.

Dummy Object

A dummy object is a non-rendering object that you use as an animation helper. The primary use of the *dummy helper object* on page 2840 is to assist you in creating complex motions and building complex hierarchies. Because dummies are invisible in the rendered scene, they are an excellent choice for offset joints, connectors between objects, and handles for manipulating complex hierarchies.

Breaking complex motions into simple components often makes it easier to go back and edit your animations. For example, consider animating a bouncing ball moving around your scene. You could animate the ball by properly positioning it throughout the scene on many *frames* on page 8585. The drawback is that it would be very difficult for you to go back and adjust the height of the bounce or the path the ball takes through the scene. You would have to edit the motion of the ball on many frames to make even a simple change.

Using a *dummy object* on page 3651 easily solves this problem by breaking the motion into two simple components. One component is the bounce of the ball. The other is the path through the scene.
**DWG Files**

The DWG file is the primary, native file format of drawing files created by AutoCAD, Autodesk Architectural Desktop, and Autodesk Mechanical Desktop®. It is a binary format used for importing and exporting AutoCAD drawing files.

You can also use the File Link Manager on page 7538 to create a live link between a drawing file that can be open in AutoCAD and 3ds Max. Changes that are made to the drawing can automatically be updated in 3ds Max without having to reload scenes or re-import drawings.

**DXF Files**

DXF files are used to import and export objects to and from AutoCAD (and other programs that support this file format).

Keep the following in mind when you are creating your DXF geometry, and when you are deciding whether to convert by layer, color, or entity:

- With AutoCAD Release 12, if you are using the AutoCAD Advanced Modeling Extension (AME), use the SOLMESH command on your AME models prior to saving the .dxf file.
- After importing a DXF file, you might want to divide the resulting 3ds Max file into smaller objects.

Entities that are frozen or turned off are ignored.

The successful unification of face normals depends on the welding of coincident vertices on page 7677. Sometimes, depending upon the precision of the model as it was created in AutoCAD, the vertices may not be close enough to be considered "coincident." They will not be welded, and the faces will not be properly unified. In this case, increase the Weld Threshold value in the Import DXF File dialog.

Converting by layer can result in objects consisting of many elements. In certain cases, some of these elements may have all of their face normals flipped the wrong way. You can detect this in 3ds Max by turning off Backface Cull on page 166 in the Display panel, or by rendering the objects. Use the Normal modifier on page 1551 to correct this.

If you do not want to flip normals, you can either use 2-sided materials, or turn on the Render Setup dialog > Force 2-Sided option on page 6575.
If you are loading a large scene containing thousands of entities (such as 3D faces) and have chosen to load an object by entity, the conversion can take a long time. It also produces a huge number of objects to handle in 3ds Max. To avoid this, organize your DXF file so that these kinds of entities are grouped by layer, then make the conversion by layer rather than by entity.

**Dynaflector**

A space warp on page 8727 that lets particles on page 2997 affect objects in a dynamics situation.

Three kinds of space warps are in the dynaflector category:

- **PDynaFlect Space Warp** on page 2941
- **SDynaFlect Space Warp** on page 2948
- **UDynaFlect Space Warp** on page 2951

See also:

- **Omniflector** on page 8663

**Dynamics**

Biped Dynamics on page 8521 calculate a biped's on page 4468 airborne trajectory, the bending of its knee or knees on landing, and the biped position so it maintains balance when the spine is rotated. When parameters change, dynamics cause the biped to adapt.

**Dynamics Blend**

A parameter in the Body section of the Key Info rollout on page 4704, used with freeform animation on page 8586. Blends between biped on page 4468 and spline dynamics on page 8730. Select the Body Vertical track on page 4686 (the vertical track of the biped's center of mass), and use Dynamics Blend to control the amount of gravity in an airborne period, such as in a running or jumping gait on page 4524. Dynamics Blend has no effect on a walking motion where footsteps overlap.
Ease Curve

Ease curves vary the timing of a function curve on page 8588. An unaltered function curve charts the value of an animated parameter over time. An ease curve charts changes to the timing of the function curve. Changing ease curve values shifts the time of the original track on page 8744 left or right.

The horizontal scale of an ease curve represents normal time, just as it does for all function curves. The vertical scale of an ease curve represents the time scale of the function curve the ease curve is applied to. Changing the shape of an ease curve changes the way time is interpreted by the affected function curve.

The value of the ease curve at a particular frame on page 8585 is a frame value from the original track. For example, if the ease curve is 0 at frame 0 and 10 at frame 10, the original track plays at its original speed. If the ease curve value at frame 10 increases to 20, the original track plays to frame 20 by frame 10: it has been sped up by a factor of two.

An Ease Curve Example

Suppose you have animated a bird flying around the sky. After viewing the animation you decide that you want to change the position of the bird so it moves quickly at the beginning of the animation and then slows to a leisurely pace toward the end.

You could accomplish this change by editing position keys, ranges, and function curves but it would require more work than using an Ease curve. Applying an Ease curve on page 3964 to the Position track provides a quick and easy solution.

Dragging the Ease curve causes time to compress near the beginning of the animation and stretch out near the end. You can tell that the bird's motion starts out fast and then slows down by looking at the effect the Ease curve has on the Position function curves.

See also:

- Multiplier Curve on page 8651
Edge

An edge is a straight or curved line that connects two vertices on a mesh or a spline. You can modify object shapes by transforming its edges; in effect, by doing so you're moving two vertices simultaneously.

Editable Mesh

An editable mesh is a type of deformable object. An editable mesh is a trimesh: that is, it uses triangular polygons. Editable meshes are useful for creating simple, low-polygonal objects or control meshes for MeshSmooth and HSDS modelling. You can convert a NURBS or patch surface to an editable mesh. Editable meshes require little memory, and are a natural method of modeling with polygonal objects.

An actively linked object cannot be collapsed to an editable mesh. Using the File Link Manager, you have to Bind the object first.

Editable Poly

An editable poly is a type of deformable object. An editable poly is a polygonal mesh; that is, unlike an editable mesh, it uses more than three-sided polygons. Editable polys are useful in that they avoid invisible edges. For example, if you use a cut-and-slice operation with editable polys, 3ds Max doesn't insert extra vertices along any invisible edge. You can convert NURBS surfaces, editable meshes, splines, primitives, and patch surfaces to editable polys.

Element

An element is one of two or more individual mesh objects (that is, groups of contiguous faces grouped together into one larger object). For example, if you attach one box to another, you create one mesh object from the two boxes. Each box is now an element of the object. Any function you perform on that object affects all its elements. However, you can manipulate the elements independently at the Element sub-object level.
The antler is one element of the moose head.

**Emitter**

An emitter is an object that emits particles; particles are born, or first enter the scene, at the emitter's location. By default, Particle Flow uses the source icon on page 3034 as an emitter, but alternatively any other object in the scene can emit particles using the Position Object operator on page 3089. See Particle System on page 2997.

**End Effector**

In history-dependent inverse kinematics (HD IK) on page 3710, the end effector is the pivot point on page 8686 of the selected child object at the end of a kinematic chain on page 8616.

The kinematic chain is a single branch of a hierarchy used for animation with inverse kinematics (IK) on page 8612. The chain starts with the selected child object and travels up through ancestors until it reaches the start of the chain.
When you move the end effector, the HD IK solver then uses IK calculations to move and rotate all other objects in the kinematic chain to react to the object you moved.

The end effector has two transforms: one that connects it to its parent, and another that connects it to the End Effector Parent. By default, the End Effector Parent is none (equivalent to World); you can assign this in the Motion panel. See End Effectors Group on page 3718.

**NOTE** You can move the end effector away from the child object, which causes the IK chain to straighten out. When you move the end effector back toward the child object, joints in the IK chain will bend again.

See also:
- IK Goal on page 8605

### Envelopes

In Physique on page 4944, the envelope on page 4970 is the primary tool for controlling skin deformation. An envelope defines an area of influence about a single link on page 8620 in the hierarchy. If the envelope is deformable on page 8546, mesh vertices within that envelope follow the movement of the Physique deformation spline on page 8547. An envelope has a pair of inner and outer bounds; the envelope's influence is strongest at the inner bound, and falls off toward the outer bound. By default, each envelope has four cross sections. You can reshape the cross sections, or add new ones, to change the envelope's geometry.

In the Skin modifier on page 1667, the envelope plays a similar role with respect to bones on page 857. Each bone has its own envelope with two or more cross-sections that allow you to shape the envelope to fit the surrounding mesh.

Typically, the envelopes of adjacent links or bones overlap each other. Vertices that fall in the overlap area are weighted to produce smooth blending at joint intersections.

### Environment Map

Texture coordinates lock a map on page 8631 to geometry. Environment coordinates, on the other hand, lock a map to the world. If you move the
object, the map remains in place. If you move the view (or camera), the map changes. This type of mapping system is used with reflection, refraction, and environment maps.

Above: Image uses a picture in screen coordinates as a background.
Below: Image shows spherical mapping coordinates applied using a checker map.

There are four types of environment coordinates:

- Spherical
The first three are the same as those used by the UVW Map modifier on page 1932. If you imagine a sphere, infinite in size, surrounding your scene and mapped with spherical mapping coordinates on page 8628, you can visualize the effect you get with spherical environment mapping. Shrink-wrap wraps the map around a giant sphere, leaving only one singularity. Cylindrical is like a giant cylinder.

The Screen system maps the image directly to the view, with no distortion. It's similar to planar, in that it's like a giant backdrop hung in the scene. Unlike the other environment mapping methods, Screen is locked to the view. When you move the camera, the map moves with it. Therefore, you can only use it for still renderings, or animations in which the camera doesn't move.

To use a bitmap on page 6213 with any environmental mapping system other than Screen, you need a high-resolution map because of the size of the virtual sphere, or cylinder.

An environment map is not assigned in the Material Editor on page 5641, because it's not applied to the geometry of an object, but rather to the scene itself. Environment maps appear in the background, as seen from the camera or perspective view.

When you assign a map to the environment, it's the same as if you'd assigned a mapped material to an object in your scene. To edit or adjust the assigned map, you need to place it in one of the sample slots in the Material Editor. You can do that in one of two ways:

- Click the Get Material on page 5687 button in the Material Editor, and then get the map from the scene.

- Put the map from the Environment dialog on page 7163 to one of the sample slots in the Material Editor. You can do this by dragging and dropping from the Environment dialog map button to the sample slot.
NOTE To control whether or not the renderer uses the environment map’s alpha channel on page 8502 in creating the alpha for the rendered image, choose Customize > Preferences > Rendering, and then turn on Use Environment Alpha in the Background Antialiasing group. If Use Environment Alpha is turned off (the default) the background receives an alpha of 0 (completely transparent). If Use Environment Alpha is turned on, the alpha of the resulting image is a combination of the scene and background image’s alpha. Also, when writing TGA files on page 7878 with Pre-Multiplied Alpha set to off, turning on Use Environment Alpha prevents incorrect results. Note that only background images with alpha channels or black backgrounds are supported when compositing in other programs such as Photoshop.

Event

The event is the basic unit of organization in a Particle Flow particle diagram on page 8677. There are two types of events: global on page 8594 and local on page 8623. A birth event on page 8521 is a specialized type of local event.
1. Global event
2. Birth event
3. Local event

Each event contains one or more actions, which can affect particle behavior or appearance. You can use tests to send particles to other events if the particles meet certain qualifications. A single chain of linked events as shown in Particle View is known as a flow.
Event Display

The event display, the main window in the Particle View on page 3015 dialog, contains the particle diagram on page 8677. This is where you build and edit the particle system.
Event Level

In Particle Flow, you can select particles at the Event level or at the Particle level on page 8678, using controls on the Modify panel > Selection rollout on page 3039. An Event-level selection can be passed to the Particle level for processing by the particle system by means of the Selection rollout > Get From Event Level command.

Extents

An object's extents are its maximum dimensions in X, Y, and Z. These are the dimensions of the rectangular bounding box on page 8528 that surrounds the object.

Bounding box shows the extents of the model boat.
**Face/Polygon**

When you render a scene containing geometry, 3ds Max uses the faces and polygons in a *mesh object* to draw the object surfaces. Essentially, faces and polygons are planar objects that fill in the gaps between edges in the object structure. A face typically has three sides; a polygon can have three or more sides. You can treat a polygon as a single object while modeling, but at *render time*, 3ds Max breaks down all polygons into triangular faces.

**Faceted**

Faceted shading provides a constant shading across each facet, or co-planar surface of the object. The result has the appearance of so-called “flat” shading, except that it provides *specular highlights*.
Turn on Faceted to provide a faceted look to your geometry without having to explicitly change the smoothing groups on page 383 in the object with the Edit Mesh modifier on page 1321.

Both Standard on page 5962 and Raytrace on page 6064 materials provide a Faceted toggle.

**FFD**

FFD stands for *free-form deformation*. It is used in computer animation for effects like dancing cars and gas tanks. You can use it as well for modeling rounded shapes such as chairs and sculpture.

An FFD modifier on page 1431 surrounds the selected geometry with a lattice box or cylinder. By adjusting the control points of the lattice, you deform the enclosed geometry.

**NOTE** You can use Physique on page 4944 to control an FFD space warp. Physique actually deforms the space warp’s control points on page 8539, which in turn deform the model.

**FGM File**

An FGM file (.*fgm) is a final gather map file. It is used by the mental ray renderer on page 6675 to save the results of a final gathering on page 8576 pass. Generating and saving an FGM file can speed up subsequent renderings on page 6505.

**Field of View**

Field of View on page 8146 defines the width of your view as an angle with its apex at your viewpoint and the ends at the sides of the view. The effect of changing FOV is similar to changing the lens on a camera. As the FOV gets larger you see more of your scene and the perspective becomes distorted, similar to using a wide-angle lens. As the FOV gets smaller you see less of your scene and the perspective flattens, similar to using a telephoto lens.
A Perspective view on page 8681 uses an imaginary camera with only one setting, FOV. The FOV angle for the active Perspective view is displayed in the Rendering Methods panel on page 8374 of the Viewport Configuration dialog. You can type a value in the FOV field of the dialog to precisely set FOV for the active Perspective view.

Use Field of View (FOV) to change the amount of the scene visible and the amount of perspective flare applied to a Perspective or Camera view. The Field of View button appears in the viewport navigation control panel when a Perspective or Camera view is active.

**Fields**

Your animations might ultimately be viewed on television monitors. Standard video signals display animation by breaking it down within time segments (frames on page 8585). The image for each frame is split into horizontal lines (scan lines). A special method for conveying frame information on a video signal has been developed. This method is called field interlacing. Television monitors display a video signal by separately scanning two portions of each
frame called fields. One field contains the odd scan lines of a frame, the other field contains the even scan lines. Television monitors scan and display the fields of each frame separately. The fields are alternately cycled through every other horizontal line on the screen so that they "layer" together to form a single interlaced image.

Two fields combine to make a single frame.

**Render to Fields**

On the Render Setup dialog, in the Common Parameters rollout on page 6568 > Options group, the Render To Fields check box sets whether the renderer renders full frames at the specified frame rate, or renders fields at twice that rate. When Render To Fields is on, the renderer renders an extra sub-frame image between every two frames, and composites each frame and the following sub-frame into a single image with two fields. The result is a 60 fields-per-second animation suitable for play on an NTSC on page 8654 television monitor.

**Field Order**

When you render to fields, you also specify a field order to identify which field comes first. The Field Order configuration setting is found in Preferences.

Glossary | 8571
on page 8342, on the Rendering page. A frame's scan lines are numbered and each field contains either the odd or even scan lines. The video source (for example, broadcast transmitter, video tape recorder, or digital video recorder) determines which group of scan lines is in each field and which group is delivered to the display first. The fields are referred to as Field 1 (F1) and Field 2 (F2); either could contain the odd numbered (1st, 3rd, 5th, and so on) scan lines or the even numbered (2nd, 4th, 6th, and so on) scan lines in the frame.

Using the default setting of Odd as your Field Order preference, 3ds Max renders the first field image (F1) to the odd scan lines. If the field order preference is set to Even, then the first field image is rendered to the even scan lines. For an image to display properly, the field order and the video device field order must match.

Some video systems require odd lines to be rendered first, and others require the even lines to be recorded first. The Field Order parameter is set to Odd by default. If you observe incorrect strobing in your video output, change the parameter to Even.

**Figure Mode**

When you work with a biped on page 4487, you use Figure mode on page 4758 to fit the biped to the mesh or mesh objects on page 8638 that represent your character. You should have Figure mode turned on when you attach the mesh to the biped with Physique on page 4944. Figure mode is also used to scale a biped that has a mesh attached to it, to make biped "fit" adjustments after Physique is applied, and to correct posture for motion files that need a global posture change.

When Figure mode is turned on, the biped jumps from its animated position to its Figure mode pose. Animation is preserved when you exit Figure mode.

The parameters on the Structure rollout on page 4762 are active only in Figure mode, and at creation time.

**Fillet**

A dependent NURBS object on page 2464 that is an arc connecting two curves. It is controlled by the objects it connects, and by a radius parameter.
Filter Color / Filter Opacity

Filter opacity tints the colors behind the material using a specified transmission color.
Filter opacity is the default system, because it provides a more realistic transparency effect. When the Filter option is set in the Extended Parameters rollout on page 6013, the color used by the Filter Color swatch tints the transparency of the material.

In life, a transparent material, such as colored glass, affects the colors behind it not by the diffuse on page 8552 or ambient on page 8504 colors (which are reflected colors), but by the transmission color.

The transmission color is that property of a substance that filters certain colors, and allows others to pass. For example, a sheet of red cellophane is a filter that blocks all light not in the red wavelength of the spectrum. By using filter opacity, you can specify a transmission color and achieve strong, saturated colors, no matter how transparent the material.

**Filtering (Antialiasing)**

Filtering is a technique of antialiasing on page 8501 the bitmaps on page 8523 in mapped materials on page 8628 by averaging pixels. The Pyramidal and Summed
Area options provide two methods of pixel averaging. Only one can be active at a time.

Both methods require approximately the same rendering time. Summed-area filtering generally yields superior results but requires much more memory. Pyramidal filtering requires 3ds Max to allocate memory equal to approximately 133% of the size of the bitmap. By comparison, summed-area filtering requires 3ds Max to allocate approximately 400% of the size of the bitmap.

Use summed-area filtering only for smaller bitmaps, and avoid using any more such bitmaps in a scene than necessary.

Pyramidal filtering is quite adequate for most purposes. However, because it applies filtering as a function of distance, irregular antialiasing might occur on detailed texture maps that are applied to a plane receding into the distance. The effect of pyramidal filtering on extreme perspectives such as this is even more noticeable in animations, where portions of the texture map appear to "swim." If this occurs, turn on summed-area filtering for the material.

**NOTE** To control whether or not a background image is affected by the renderer’s antialiasing filter, choose Customize > Preferences > Rendering on page 8342 and then turn on Filter Background in the Background Antialiasing group.

**Filtering (Character Animation)**

Filtering is the action of using selected data, rather than all data.

In the Motion Mixer on page 4002, you use the trackgroup on page 8745 filter to select the biped on page 4468 parts that will be affected by motion clips on page 8646 and transitions on tracks within the trackgroup. See Filtering Mixer Tracks on page 4018.

Filtering is also a motion-capture technique on page 4916. Motion-capture and marker data typically have keys on page 8616 at every frame. Filtering motion-capture data reduces the number of keys, making the job of altering or personalizing the motion data simpler. Other filtering options include footstep extraction, applying the skeletal structure stored in the motion-capture file to the biped, looping the data, importing a portion of the motion capture file, and selecting tracks to load. See Filtering Motion-Capture and Marker Data on page 4919.
Final Gathering (mental ray Renderer)

Final gathering is an optional, additional step to calculating global illumination on page 6706. Using a photon map on page 8684 to calculate global illumination can cause rendering artifacts such as dark corners and low-frequency variations in the lighting. You can reduce or eliminate these artifacts by turning on final gathering, which increases the number of rays used to calculate global illumination.

Scene rendered with global illumination but no final gather
Same scene with final gather used to smooth the global illumination
Final gathering can greatly increase rendering time. It is most useful for scenes with overall diffuse lighting, less useful for scenes with bright spots of indirect illumination such as focused caustics on page 6700.

You turn on final gathering on the Render Setup dialog > Indirect Illumination panel > Final Gather rollout on page 6760.

**First Vertex**

When you create a spline on page 584 object, 3ds Max numbers the vertices on page 8757 from 1 to the total number of vertices in the spline, according to the order of creation. When the spline is displayed in viewports, the first vertex has a box around it.
First vertex of a spline

The first vertex is commonly used as an alignment marker when you place two or more shapes on different path levels when lofting. If you place different shapes on different path levels and you don't align their first vertices, the resulting mesh object on page 8638 is twisted.

To avoid twisting, you can align the first vertices by rotating the splines as necessary. Alternatively, you can change the position of a spline's first vertex by using the Make First button in the Edit Spline on page 634 modifier (at the Vertex sub-object level).

Flat Mirror

If you want to create a flat, mirrored surface in a scene, such as a highly polished floor, you must use a flat mirror reflection map on page 6358.
Flat mirror map reflects the ice-cream shop's interior.

Flat mirror reflection maps must be assigned to your geometry in a specific way, and work only on flat surfaces.

When you use flat-mirror reflection maps, keep the following in mind:

The flat-mirror material must be assigned to connected, coplanar faces on page 8568 on a flat surface of the object. If your flat-mirror reflection doesn't work, it's probably because non-coplanar faces have been assigned the flat-mirror material. This can happen during the selection process, if one or more non-coplanar faces are included in the selection set. It can also happen if you've already assigned the same material on page 8635 elsewhere on the object (coplanar faces are two or more adjacent faces that are on the same two-dimensional plane, such as the surface of a floor).

If you want to reflect in multiple planes of the same object, detach on page 1423 each plane into a separate object before you assign the material.
Flow

A particle system on page 8678 can contain any number of separate particle flows. Each flow consists of an isolated chain or sequence of events on page 8564, as depicted in Particle View on page 3015. A flow typically contains a global event on page 8594 and a birth event on page 8521, and any number of additional local events on page 8623.

Fluorescence

Fluorescence is light emitted from an object when it absorbs radiation (for example, ultraviolet light) from another source.
Glass on the right has a light green fluorescence.

Raytrace materials have the ability to simulate fluorescence.

Flyout

A flyout is an icon-based menu available from any button that has a small black triangle in the lower-right corner. To access the flyout, click the button and hold or drag a short distance. Then, to activate a flyout menu item, drag to the item and release. As you drag, you can see each item's name on the prompt line of the status bar on page 8064.
Follow Object

You can bind an object in your hierarchy to any other object (often an object not in the same hierarchy). This other object is called the follow object.

The bound object tries to match the position and orientation of its pivot point to the position and orientation of the follow object's pivot point.

For example, you might want to animate a figure that always points to another object. Bind the hand of the figure to the other object. Turn IK on and as you move the object the hand and arm of the figure move to point at it. See Position/Orientation?Bind to Follow Object (HD Solver) on page 3774.

Foot States

The biped feet can be in one of four states: plant, lift, move, and touch:

- **Plant**  The biped foot state in full contact with the footstep.
- **Lift**   The biped foot state just before leaving a footstep.
- **Move**  The biped foot state between footsteps; an airborne period.
- **Touch** The biped foot state at which a biped foot first contacts a footstep.
Footstep Animation

Biped's on page 4468 patented footstep-driven keyframe animation feature allows animators to use footsteps to create broad, global brush strokes for character movement. Once footsteps are in place, keyframes on page 8616 are generated automatically to produce an initial sketch of the 3D character's motion. Throughout edits and revisions, the original nuances of the character are preserved; Biped remembers everything about how a character moves, and it makes all of the appropriate adjustments if the footsteps are changed. See Footstep Animation on page 4515.

Footsteps Method

Footsteps provide a way to animate a biped on page 4487. In viewports, footsteps represent support periods in space for the biped's feet. Moving or rotating footsteps in space is done in the viewports. The footstep position and orientation in the viewport controls where the biped will step. See Footstep Animation on page 4515.

In Track View — Dope Sheet on page 3805, each footstep appears as a block that represents a support period in time for each of the biped's feet. Moving footsteps in time is done in Track View — Dope Sheet.

TIP  
To see the footsteps, you must turn on Edit Keys on page 3906 in the Dope Sheet.

There are three ways to create footsteps for the biped. The first way is to place footsteps individually, one at a time. The second way is to invoke Biped's multiple footstep creation tools to create a walk, run, or jump animation. The third way is to extract footsteps from raw motion-capture data on page 4916.

A big advantage of the footstep method is the natural adaptation of the biped that occurs when the footsteps are edited in time and space. Also, you can reposition all of the footsteps to move the entire animation.
Forward Kinematics

The default method of manipulating a hierarchy on page 3618 uses a technique called “forward kinematics”. The basic principles employed by this technique are:

- Hierarchical linking from parent to child
- Placement of pivot points on page 8686 to define the connecting joint between linked objects
- Inheritance of position, rotation, and scale transforms from parent to child

In forward kinematics, when a parent object moves, its children must follow. If the child wants to go off on its own, the parent remains behind. For example, in a hierarchical linkage of a human figure, when the torso (the parent) bends over, the head (the child) moves along with it, but you can turn the head without affecting the torso.

Forward Kinematics (Bipeds)

Using an arm to move a hand is an example of forward kinematics. Using the hand to move the arm is an example of inverse kinematics on page 8612. When you use freeform animation on page 8586 to animate a biped on page 4487, you can use both kinds of kinematics.

By planting a hand or foot, you use another object (object space on page 8659) or the world (world space on page 8769) to control IK motion. In this method, the IK Blend parameter in the Key Info rollout on page 4704 determines how forward kinematics and inverse kinematics are blended to interpolate intermediate positions.

Frame/Frame Rate

Animations are made up of a series of still images. When viewed in quick succession these images produce continuous motion. Each images is called a frame.

The frame rate of an animation is generally expressed in frames per second (fps). This is the number of frames displayed for every second of real time on page 8697.
Different recording devices output different frame rates, but the standard rates are as follows:

**Film** 24 frames per second

You can change the frame rate for your output at any time, outputting the correct number of frames to maintain the correct playback speed for your animation.

For example, if you create a 90-frame animation for video, using an NTSC frame rate of 30 frames per second, the result will be three seconds of animation.

If you later discover you need to output to PAL video (at 25 frames per second), you can switch to the PAL frame rate. The 90 frames are automatically converted to 75, producing the same total animation time with a different number of frames. You can later switch back to NTSC frame rate to restore the original 90 frames of animation.

You can switch back and forth between frame rates at any time without losing animation data.

**NTSC video** 30 frames per second

**PAL video** 25 frames per second

### Freeform Animation

character studio gives you the option to animate *biped* on page 4487 poses both with and without the aid of *footsteps* on page 4515. *Freeform animation* on page 4571 does not use footsteps. In freeform animation, you set all the keys yourself.

### Freeform Method

In *freeform mode* on page 4571 (without *footsteps* on page 4515), you can pose every joint of your *biped* on page 4487 exactly as you like using traditional keyframe methods. You can even blend dynamically between *forward kinematics* on page 8585 and *inverse kinematics* on page 8612 to introduce higher-level control in just the cases you need it to simulate your character's particular motion.
Freeze/Unfreeze

You can freeze any selection of objects in your scene. By default, frozen objects, whether wireframe or rendered, turn a dark gray. They remain on screen, but can't be selected, and therefore can't be directly transformed or modified. Freezing lets you protect objects from accidental editing and speeds up redraws.

On the right, the trash can and streetlight are frozen.

Frozen objects are similar to hidden objects. Linked, instanced, and referenced objects behave when frozen just as they would if unfrozen. Frozen lights and cameras and any associated viewports continue to work as they normally do. See Freeze Rollout on page 163.

You can choose to have frozen objects retain their usual color or texture in viewports. Use the Show Frozen In Gray toggle in the Object Properties dialog on page 283.
Function Curve

Function curves are editable splines on page 8729 that represent animation values in a line-graph format. They provide a valuable way of both visualizing and editing your animation tracks.

Function curves appear in the Track View on page 3790, and provide the best method of viewing and editing animation tracks. With the function curve display, you can actually see the characteristics of the animation as they change over time. The steepness of the curve indicates the velocity of an object in the scene. If the curve steepens, the object is accelerating. If the curve flattens out, the object is slowing.

You can display key dots in function curves, as well as in the key editing displays. In function curves, the key dots appear as small, black squares. The two ways to turn on their display are to click the green icon beside the track label, or to click the function curve itself.

There are two basic ways to edit function curves. You can either change the position of the key dots, thereby altering the curve, or you can edit the tangents and the values of the keys themselves.

Fusing

In NURBS on page 2416 curves and surfaces, fusing connects a point to a point or a CV on page 8543 to a CV. (You can't fuse a CV to a point, or vice versa.) This is one way to connect two curves or surfaces. It is also a way to change the shape of curves and surfaces.

Fused points behave as a single point or CV until you unfuse them. Fusing points does not combine the two point objects or CV sub-objects. They are connected but remain distinct sub-objects that you can unfuse later.

Fused CVs behave much like a single point, but the property of multiplicity for coincident CVs also applies. The fused CVs have proportionally more influence on the curve, which can become more sharply curved in the fused CVs' vicinity, or even angular if more than two CVs are fused together. See Editing Curve CV Sub-Objects on page 2508.
**FX File**

An FX file defines a DirectX (DX9 or DX10) shader. It is a text file created using the Higher-Level Shading Language (HLSL) standard. The DirectX Shader material on page 6175 can apply DirectX shaders to objects, and display them with hardware shading in viewports.

By default, DirectX shaders are saved in `\maps\fx\` in the 3ds Max program directory.

**IMPORTANT** For a DirectX shader’s parameter to be visible in the DirectX Shader material’s interface, the FX file must contain code to label the parameter, define its type, and (optionally) limit its range. (A few other UI settings are also provided.) You can find examples of files that contain this code in `\maps\fx\` in the 3ds Max program directory.

**G-Buffer**

G-Buffer (graphics buffer) is a type of rendering channel. Two file formats output by 3ds Max, RLA on page 7873 and RPF on page 7875, can incorporate masks that are based on graphics buffer (G-Buffer) channels instead of the more widely used RGB and alpha channels on page 8502. In addition, some kinds of Filter and Layer events as well as certain rendering effects on page 7057 can post-process objects or materials designated by the G-Buffer.
You can set two kinds of these channels in the scene to identify and group objects or materials for a particular post-processing effect.

- You set an **Object ID** on page 293 to identify that object to receive a particular rendering or post-processing effect or file mask, or to receive a particular map when using the **Multi/Sub-Map shader** on page 6414.

- You set a material’s **Material ID Channel** on page 5694 value to identify that material to receive a particular post-processing effect.

You create object-specific or material-specific post-processing by following this general procedure:

1. Assign a particular **Object Channel ID** or **Material ID Channel** to the objects or the materials you want to be post-processed or affected by rendering effects.
2 In the Image Filter or Image Layer event or in each rendering effect's Options tab, choose the channel ID that associates the event with the ID value you assigned in the scene.

3 When you render the scene or execute the Video Post queue, 3ds Max singles out objects or materials that have the designated ID, and performs its post-processing only on those objects or materials.

WARNING The mental ray renderer on page 6675 does not recognize Z-depth with G-buffers. G-buffer data is saved on a single layer. Also, the mental ray renderer does not support the following effects:
- Glow lens effect on page 7073 (rendering effect)
- Ring lens effect on page 7080 (rendering effect)
- Lens effects Focus filter on page 7339 (Video Post)

Gait Pattern

In footstep animation on page 8584, the pattern created by a gait: walk, run, or jump. When you create new footsteps, the timing for the footsteps is determined by the gait you have chosen and the parameters for that gait. Gait parameters are on the Motion panel in the Footstep Creation rollout on page 4774.

Gait Type

In footstep animation on page 8584, character studio on page 4465 can create three types of gaits; walk, run, or jump.

- In a walk, at least one foot is always in contact with the ground. The periods when one or both feet are in contact with the ground are known as support periods.
- In running, there is a period between each support period in which the body is airborne.
- Jumping is a special case of running. Both feet are in contact with the ground at the same time, or airborne at the same time.
Gamma Correction

Gamma correction compensates for the differences in color display on different output devices, so that images look the same when viewed on different monitors.

A gamma value of 1 corresponds to an "ideal" monitor; that is, one that has a perfectly linear progression from white through gray to black.

Gamma = 1.0: no correction

I stands for Intensity.

However, the ideal display device doesn't exist. Computer monitors are "nonlinear" devices. The higher the gamma value is set, the greater the degree of nonlinearity. The standard gamma correction value is 2.2. Depending on the monitor, gamma values in the range of 1.5 to 2.2 are common.
The horizontal axis represents input (the original value) and the vertical axis represents output (the gamma-corrected value).

Computer and video monitors don’t display color in a linear way (as in the first illustration). Also, the brightness of a monitor tends to make an image seem brighter than its intensity values really specify. Gamma correction fixes this problem, and can ensure consistency between different applications or different monitors. When you set gamma, find a value that makes middle gray on your own monitor match a true middle (50 percent) gray.

For more information, see Gamma and LUT Preferences on page 8330.

**Geometric Primitives**

Simple primitive objects such as, spheres, boxes, cylinders, and so on. See Standard Primitives on page 388.

**Gizmo/Center**

A gizmo is geometry that appears in viewports, but not in the scene. You manipulate a gizmo to modify the scene geometry or other effects. There are gizmos for transforms on page 889, modifiers on page 1031, atmospheric apparatus on page 7236, and some directly modifiable geometry such as spotlight cones on page 5439. See Gizmos Preferences on page 8354.
Examples of gizmos:
Left: Gizmo for a Bend modifier
Right: Gizmo for UVW mapping

For modifiers, a gizmo acts like a kind of container that transfers the modification to the object to which it's attached. You can move, scale, and rotate the gizmo as you would any object, altering the effect of the modifier on the object.

With bipeds on page 4468, the footsteps in footstep animation on page 8584 are gizmos that let you edit the position of the biped's feet over time. Physique on page 4944 uses gizmos to visually identify bulge angles.

Some modifiers with gizmos also have a Center sub-object, which can be manipulated independently of the gizmo to specify the point about which the deformation, etc., takes place. For example, moving the Bend modifier on page 1165 center parallel to the plane of the bend effect changes the size of the bend circle and the location of the modified object within the bend circle.

**Global Event**

The first event on page 8564 in a particle flow on page 8581 is always a global event, whose contents affect all particles in the flow; the rest are local events on page 8623. Although a global event has the same name as the Particle Flow source icon, selecting the source icon on page 3034 in a viewport doesn't
highlight the global event, nor does highlighting a global event select the corresponding source icon.
By default, the global event contains a single Render operator on page 3194 that specifies rendering properties for all particles in the flow. You can add other operators on page 3050 here to have them act globally, such as Material, Display, and Speed.

**NOTE** A global event is the only event that can be wired to another event without using a test on page 8741. It’s almost always wired directly to a birth event on page 8521.

**IMPORTANT** When you use an operator globally, be sure not to use the same operator locally (that is, in any other events in the system) to avoid potential conflicts.

### Global Motion Clip Controller

In crowd animation on page 5104, a controller that contains the animation necessary to animate a non-bipedal crowd of objects. It consists of a list of motion clips on page 8646 and the logic needed to instance and blend these motion clips for a crowd animation. The Global Motion Clip Controller is accessed via the Crowd helper object on page 5162.

### Glossiness and Specular Level Settings

A material’s glossiness (or dullness) depends on the size and intensity of its specular highlight on page 8728. In the Material Editor on page 5641, the Glossiness spinner affects the size of the specular area, and the Specular Level spinner affects the intensity of the glossiness.

![Glossiness and Specular Level settings](image)

Extremes of the Glossiness and Specular Level settings (Phong shader):

- **Top sphere**: Glossiness=100; Specular Level=100
- **Left sphere**: Glossiness=50; Specular Level=50

8596 | Glossary
When the Specular Level is too high, and Glossiness is too low, you can get harsh backlights on your surfaces. The Soften option mitigates this.

**GravAccel**

In *footstep animation* on page 8584, the GravAccel (for gravitational acceleration) parameter lets you scale the height of airborne periods. The greater this value, the greater the height. If the biped appears to be going too high, reduce this value; if the *biped* on page 4468 goes too low, increase it. Each biped has its own Gravitational Acceleration value. The default is based on the height of the biped.

For example, if the active *unit* on page 8366 is feet and the biped is 5 feet 10 inches tall, then Gravitational Acceleration equals 32, for 32 ft. per second per second. For other biped heights, 3ds Max scales this value to fit the scene. The Gravitational Acceleration value also changes to agree with other unit systems, such as metric.

GravAccel is located on the *Dynamics & Adaptation rollout* on page 4755.

**Gravity**

In *footstep animation* on page 8584, *character studio* on page 4465 calculates the effect of gravity for those periods when a *biped* on page 4487 is airborne (a biped becomes airborne when it moves with a running or jumping *gait* on page 8591). You can use the *GravAccel* on page 8597 setting to scale the effect of gravity.

**Grid Object**

A grid object is a type of *helper object* on page 2837 you can create whenever you need a local reference grid or construction plane somewhere other than the *home grid* on page 8600.
One grid establishes the pitch of the boat, another the pitch of the ship.

You can have any number of grid objects in your scene, but only one can be active at a time. When active, a grid object replaces the home grid in all viewports.

You can freely move and rotate grid objects, placing them at any angle in space, or attach them to objects and surfaces. You can also change viewports to display a plan or top view of any active grid object.

Grid objects can be named and saved like other objects, or used once and deleted.

**Head Object**

A head object is a component of a Target Camera on page 5556, Sunlight or Daylight system on page 5491, or a Tape helper on page 2855. These objects comprise two components: the target that the camera, sun, or tape points at, and the head that represents the camera, sun, or tape. The head object always points at the center of the target.
Helper Object

3ds Max helper on page 2837 objects are used to help you set up an animation, but do not render. Crowd animation on page 5104 uses two kinds of specialized helper objects: Crowd on page 5162 and Delegate on page 5154.

Hide/Unhide

You can hide any objects in your scene and you have the option to hide any selection of objects or to hide anything except your current selection of objects. Hidden objects differ from frozen on page 8587 objects in that they disappear from the viewport instead of turning dark gray. If you are working on a scene that includes many objects or you have many objects in a very tight area, hiding some of them gives you more access to the unhidden objects and speeds up redraws.

You can hide an object that includes a target (such as target cameras, tape helpers, or suns) by choosing either the head on page 8598 or the target object and then selecting hide.

Hide and Unhide are accessible from the Display panel on page 8217 or from the Display quadrant on page 8055 of the Quad Menus.

Hierarchical Linkage

3ds Max uses a family-tree analogy to describe the relationship between objects linked together in a hierarchy on page 3618.

Ancestors The parent and all of the parent's parents of a child object.

Branch A path through the hierarchy from a parent to a single descendent.

Child An object controlled by its parent. A child object can also be a parent to other children. An object that doesn't have any parent is by default a child of the world. (The "world" is an imaginary object that acts as the root of all other objects in the scene.)

Descendants The children and all of the children's children of a parent object.

Hierarchy The collection of all parents and children linked together in a single structure.
**Leaf** A child object that has no children of its own. The lowest object in a branch.

**Link** The invisible connection between a parent and its child. The link is a conduit for transmitting position, rotation, and scale information from parent to child.

**Parent** An object that controls one or more children. A parent object is often controlled by another superior parent object.

**Pivot** Defines the local center and coordinate system for each object. You can think of links as connecting the pivot of a child object to the pivot of its parent.

**Root** The single parent object that is superior to all other objects in the hierarchy. All other objects are descendents of the root object.

**Subtree** All of the descendents of a selected parent.

## Home Grid

Grids are two-dimensional arrays of lines similar to graph paper, except that you can adjust the spacing and other features of the grid to the needs of your work.
Using the home grid to position houses

Grids have these primary uses:

- As an aid in visualizing space, scale, and distance
- As a construction plane where you create and align objects in your scene
- As a reference system for using snap on page 2804

The home grid is the basic reference system, defined by three fixed planes on the world coordinate axes on page 68. The home grid is visible by default when you start 3ds Max, but can be turned off with an option in the right-click viewport menu. You can use any view of the home grid as a construction plane or you can create a grid object on page 8597 and use that as a construction plane instead.
Horizon

The horizon of a scene is the edge of vision at the height of the camera, parallel with the world coordinate plane. You can view the horizon in camera viewports.

A camera is level when it and its target are the same height from the world coordinate plane. In other words, the camera's local Z axis is parallel to the world plane. When the camera is level, the horizon line is centered in the viewport. As the camera tilts up, the horizon line lowers; as it tilts down, the horizon line raises.

The horizon line can help you match the perspective of your scene to the perspective of a still image. In general, matching perspective involves the following steps:

- Display the horizon line. Use it to help you adjust the camera and target so they are level.
- Display the image in the camera viewport. Use Views menu > Background Image.
Display the image in the camera viewport. Use Views menu > Viewport Background.

Orbit the camera until the perspective of the scene roughly matches that of the still image.

Adjust the camera’s perspective to fine-tune the perspective match.

Move the camera or target to position the scene against the background.

If you raise or lower the camera, raise or lower the target by an equal amount, in order to keep them level and maintain the horizon. See Using the Horizon to Match Perspective on page 5583.

**Hot**

A *hot material* on page 8635 is one that is instanced in both the scene and the Material Editor. When you get a material from an object, that material is hot. Any changes you make to the hot material are reflected in the scene wherever that material is applied.

![Hot material example](image)

To edit a material without changing the scene, you can get the hot material from an object, then make a copy of it. The term for the copied material is *cool* on page 8541.

White triangular tabs in each corner of the Material Editor on page 5641 sample slots on page 5650 show that the materials in those slots are hot.

In the Material Editor, the only time you need to select an object is when you're assigning a material to an object. When you're adjusting a material, object selection doesn't matter.
Hotspot/Falloff

You've seen how a flashlight or a theater follow spot casts a circle of light. Depending on the quality of the flashlight, or the adjustment of the follow spot, the edge of the cast pool of light is either blurred or sharp.

In the case of a blurred pool of light, the bright circle in the center is the hotspot on page 8169, which has an even intensity. The outer extremity of the light, where it meets the darkness, is the falloff on page 8173. The difference in circumference between the hotspot and the falloff determines the relative sharpness of the pool of light. For example, if the hotspot and falloff are nearly the same size, the pool of light has a sharp edge.

The hotspot angle of a spotlight must always be smaller than the falloff angle. Put another way, the hotspot must always be inside the falloff.

You can hold down the Shift key to have the hotspot and falloff values affect each other. If you increase the hotspot to be larger than the falloff, the falloff is increased as well. Likewise, if you reduce the falloff to be smaller than the hotspot, the hotspot is also reduced.
IGES (Initial Graphics Exchange Specification)

The Initial Graphics Exchange Specification (IGES on page 7727) is an ANSI standard that defines a neutral form for the exchange of information among dissimilar computer-aided design (CAD), computer-aided manufacturing (CAM) systems, and computer visualization systems.

3ds Max implements the IGES standard for translating files to 3ds Max from IGES file formats used by the mechanical engineering and entertainment industries. Using the IGES import feature, you can read in native NURBS on page 8655 data between 3ds Max and other programs such as Autodesk Mechanical Desktop® (release 3.0 or later), Maya®, Pro/ENGINEER®, SOFTIMAGE®, CATIA®, and others. For complete details on the IGES standard, see The Initial Graphics Exchange Specification (IGES) Version 5.3.

IK Blend

In biped on page 4468 freeform animation on page 8586, the IK Blend parameter determines how forward kinematics on page 8585 and inverse kinematics on page 8612 are blended to interpolate an intermediate position. Using an arm to move a hand is an example of forward kinematics. Using the hand to move the arm is an example of inverse kinematics.

This parameter is located in the IK section of the Key Info rollout on page 4704.

IK Goal

In history-independent inverse kinematics (HI IK) on page 3680 and the IK Limb Solver on page 3732, the IK goal is the object associated with the end joint of a kinematic chain on page 3666. By default, its name is IK Chain01.

The kinematic chain is a single branch of a hierarchy used for animation with inverse kinematics (IK) on page 8612. The chain starts with the end joint and travels up through ancestors until it reaches the start joint. When you move the IK goal, the IK solver then uses IK calculations to move and rotate all other objects in the kinematic chain to react to the object you moved.

NOTE You can move the IK goal away from the end joint, which causes the IK chain to straighten out. When you move the goal back toward the end joint, joints in the IK chain will bend again.
See also:

- End Effector on page 8560

**IK Solution**

Inverse kinematics (IK) on page 8612 uses a goal-directed method where the animator positions a child object and 3ds Max calculates the position and orientation of the parent objects. The final position of the hierarchy after all of the calculations have been solved is referred to as the IK solution.

Applied IK on page 3750 requires that one or more parts of your IK structure be pinned to animated follow objects on page 8583. Once pinned, you select any object in your kinematic chain on page 3666 and click the Apply IK button. 3ds Max then calculates the IK solution for each frame of the animation and places transform keys for every object in the IK chain.

**Illuminance**

Illuminance is the luminous flux on page 8625 incident on a surface of unit area. It measures how much energy has fallen on a surface.

This quantity is useful for describing the level of illumination incident on a surface without making the measurement dependent on the size of the surface itself. The lux (lx) is the International System (SI) unit of illuminance. The American System (AS) unit for illuminance is the footcandle (fc), equivalent to 1 lumen per square foot. Illuminance is a function of the distance from the light source. To specify the illuminance of a light, you must enter a value in lx, and the distance at which that illuminance is measured.

**Image Motion Blur**

Motion blur can enhance the realism of a rendered animation by simulating the way a real-world camera works. A camera has a shutter speed, and if significant movement occurs during the time the shutter is open, the image on film is blurred.
Image motion blur has been applied to the falling coin on the right.

3ds Max provides a couple of ways to generate motion blur. Image motion blur is one. Scene motion blur on page 8710, a Video Post Scene Event on page 7282 effect, is another. For most purposes, image motion blur gives better results than scene motion blur. Scene motion blur is a more exaggerated effect. You can use both image and scene motion blur in the same rendering.

You can also apply image motion blur as a render effect on page 7157.

(Another option, object motion blur on page 8658, is not meant to simulate a camera, but to improve the rendered appearance of fast-moving objects.)

Applying image motion blur is a two-step process:

1. Turn on image motion blur for the object you want to blur, using the Object Properties dialog on page 283.
   You cannot apply both image motion blur and object motion blur to the same object in the same rendering.

2. Before you render, turn on image motion blur in the Default Scanline Renderer rollout on page 6589 of the Render Setup dialog.
**Tips and Limitations**

Image motion blur smudges the object by creating a smearing effect, instead of superimposing multiple images the way object motion blur does. It considers camera movement. Image motion blur is applied after scanline rendering is complete.

- Because image motion blur is applied after rendering, it can't account for object overlap. When blurred objects overlap, blurring doesn't work correctly and there are gaps in the rendering. To fix this problem, render each blurred object separately, to a different layer, and then composite the two layers using the Alpha Compositor on page 7385 in Video Post or another compositing tool. The overlap problem also applies to objects behind an object rendered with raytrace refraction.

- Image motion blur doesn't work with objects that change topology. This includes NURBS objects that are animated so their tessellation (surface approximation on page 2737) changes. Regular tessellation doesn't change in this way. This also includes Displacement mapping and Optimization.

- Image motion blur can yield strange results with objects that have a MeshSmooth modifier on page 1505 applied to them. If you see this happening, turn off the MeshSmooth modifier's Keep Faces Convex toggle (in the Settings rollout). This will fix the problem.

- Image motion blur is not applied to reflections of objects. It is applied only to actual geometry.

**In Place Mode**

When you play an animation of a biped character on page 4487 that travels, you can use In Place mode to keep the biped visible in the viewports. Use this for biped key editing, or adjusting envelopes with Physique on page 4944. In Place mode prevents XY movement of the biped's center of mass on page 8530 during playback; motion along the Z-axis is preserved.

This control is a three-button flyout: you can also restrict X movement without restricting Y movement, or vice versa.

The state of In Place Mode is saved with the MAX file.

The In Place flyout is located on the expanded Biped rollout on page 4669.
Independent

Describes a NURBS object or sub-object on page 2417 that is not dependent on any other object in a NURBS model. For example, a NURBS curve created using the Create command panel on page 8182 does not depend on other objects.

Influence

An influence is the object that is required for the behavior or appearance of another object to be correct. For example, take an “eye” object that should follow the motion of a tennis ball in a match. One way to animate this is to apply a LookAt Constraint on page 3585 to the eye, with the tennis ball as the target. In this case the tennis ball is an influence of the eye, while the eye is a dependent on page 8549 of the tennis ball.

See also:

- Select Influences on page 7901 and Display Influences on page 7902 in the Scene Explorer dialog
- Select Influences on page 7474 in the XRef Merge dialog

Initial Pose

When you apply Physique on page 4944 to a skeleton, the initial pose is the original position of the mesh on page 8638 relative to the skeleton. Some of the Physique sub-object levels on page 5059 have an Initial Skeleton Pose control that temporarily puts the mesh into its initial pose.

Initialize

In Physique on page 4944, when you attach a mesh on page 8638 to a skeleton such as a biped on page 4468, the modifier is initialized. This process creates the links of the deformation spline on page 8547, the envelopes on page 8561 around the links to control the mesh, and so on.
Inputs: Event

In Particle Flow, you create a particle diagram on page 8677 by connecting events on page 8564 using wires on page 8763. Each wire links an output on page 8671 with an event input, which is the connector sticking up from the top of an event.
Instance

An instance is an interchangeable clone of the original. You can instance objects, modifiers on page 8643, controllers on page 3391, materials on page 8635, and maps on page 8631. Changing an attribute of an instanced item also changes the same attribute of all instances. See Overview of Copies, Instances and References on page 982.

Object instances are not only alike in geometry, but also share modifiers, materials and maps, and animation controllers. When you change one instance by applying a modifier, for example, all the other instances change with it.

Each instance has its own set of transforms, object properties and space warp bindings; these are not shared among instances.

Within 3ds Max, instances derive from the same master object. What you're doing is applying a single modifier to a single master object. In the viewport, what you see as multiple objects are multiple instances of the same definition.

If you wanted to create a school of swimming fish, you might begin by making many instanced copies of a single fish. You could then animate the swimming motion by applying a ripple modifier to any fish in the school. The whole school would swim with exactly the same motions.

Instance (Motion Mixer)

The term instance has two meanings in 3ds Max. One is the standard definition on page 8611; the other is specific to clips in the Motion Mixer.

In general, an instance is a completely interchangeable clone of the original object. Modifying an instanced object is the same as modifying the original.

In the Motion Mixer on page 8647, when the same clip is used more than once on tracks, the clip versions are either instances or adaptations on page 8498 of each other.

The same clip used more than once for one biped, or for different bipeds of the same size, is an instance. The same clip used for different-sized bipeds is an adaptation.

For example, suppose you scene contains two bipeds that are exactly the same size, and you use the same clip in both bipeds' mixes. The clips within one biped's mix are instances of one another, and clips within the mixes of the two same-sized bipeds are also instances of one another. Instances have the same number appended to the ends of their clip names in the Mixer.
Suppose you then add a third biped of a different size, and use the same clip in that biped's mix. The new version of the clip is an adaptation of the clip used on the first two bipeds. An incremental number is added to the end of the clip name in the Mixer.

These terms are used because the Mixer adapts each loaded clip to the biped's size. The first time a clip is loaded, the Mixer adapts the clip as needed, but no distinction is made between instances and adaptations at that point because the clip appears only once.

When the clip is cloned or loaded again, the Mixer adapts the new clip to the biped as needed, then compares the change to previously loaded versions. If the change is the same, the new clip and its previous versions are instances of one another. If not, the new clip and previous versions are adaptations of one another.

**Interactive Renderer**

Another term for the Viewport Interactive Renderer on page 8757.

**Interpolation**

Interpolation is the calculation of intermediate values. For example, when you set two keyframes on page 8616 for a moving object, the object's position on intermediate frames on page 8585 is determined by interpolation.

**Inverse Kinematics**

Inverse kinematics (IK) is a positioning and animation method that is built on top of the concepts of hierarchical linking. To understand how IK works you must first understand the principles of hierarchical linking and forward kinematics.

Inverse kinematics starts with linking and pivot placement as its foundation and then adds the following principles:

- Joints are constrained with specific positional and rotational properties.
- Position and orientation of parent objects is determined by the position and orientation of child objects.
Because of these added constraints, IK requires greater thought about how you link your objects and place pivots. Where many different solutions for linking objects might be suitable for forward kinematics, there are usually just a few good solutions for any given IK approach. The best solution depends on consideration of both the nature of the hierarchy, and how that hierarchy will be animated.

Inverse kinematics is often easier to use than forward kinematics and you can quickly create complex motions. However, you sacrifice some of your control to the automation of the IK functions.

**Inverse Kinematics (Biped)**

When you work with a biped by moving the hands or feet in freeform animation. For example, you can position an arm by moving the hand.

A biped has three inverse kinematics parameters that you can vary during the limb's motion by setting them at each key of the arm and leg tracks. As the limb moves through each key:

- **IK Blend** Sets the motion interpolation to be a blend of forward and inverse kinematics. This will allow you to blend swinging motions with directed hand or foot motions. The default is 0.0, or full forward kinematics.

- **Body or Object** Determines the reference coordinate space of the IK path. This allows you to move the IK path with your character's body, or temporarily attach a hand or foot to follow another object or be attached to world space. The default is Body.

- **Join to Previous IK Key** Determines if the key should be part of the previous key (with the same reference position as the previous key).

These controls are in the IK section of the Key Info rollout.

**Iso Line**

Iso is short for isoparametric.

In NURBS modeling, a line of constant parameter value, similar to a contour line. You can use iso lines to display a NURBS surface. You can also create dependent NURBS curves based on a surface's U-dimension or V-dimension iso lines.
Isometric View

A special type of axonometric view on page 8515, where the sides of the object are equally inclined to the screen, producing equal foreshortening along the edges. You can create an isometric view by rotating a User view.
Keyframe Mode

Keyframe mode is active while the Auto Key button on page 8090 is turned on. While you are in Keyframe mode, transforming an object or sub-object, or changing the value of an animatable parameter, creates an animation key.

**WARNING** When you use freeform animation on page 8586 to animate a biped, always use the biped-specific Set Key button and other key controls on the Key Info rollout on page 4704, not the standard 3ds Max animation controls.

See also:
- Layout Mode on page 8618
- Keyframes/Keys on page 8616
Keyframes/Keys

Keyframes record the beginning and end of each transformation of an object or element in the scene. The values at these keyframes are called keys.

The red boxes indicate keyframes, the dotted line shows the interpolated trajectory.

For example, if you have an object representing an elevator that has not been animated, no keyframes (or keys) exist for it. If you turn on the Auto Key button, move to frame 20, and move the elevator along the Z axis to the second floor, Position keys are created at frames 0 and 20. The key at frame 0 represents the position of the elevator before it was moved, while the key at frame 20 represents the position of the elevator after it was moved along the Z axis. When you play the animation, the elevator moves from the ground floor to the second floor over 20 frames.

Kinematic Chain

Inverse kinematics calculates the position and orientation of objects in a kinematic chain.
The kinematic chain is defined as a single branch of the hierarchy that starts with a selected child object and continues up through its ancestors until it reaches the base of the chain. The base of the chain is either the root of the entire hierarchy or an object that you specify as a terminator for the chain.

3ds Max automatically determines the kinematic chain when you select and transform an object with the IK button turned on.

**Knot**

A value in an array or "knot vector" associated with a NURBS curve. The knots specify the region of influence of the CVs on the curve. You can't see or directly alter knots.

**Launch Script**

A launch script is a MAXScript script that you run from the command line with the -U switch, instead of from the Utilities command panel.

You use a launch script to run batch operations in 3ds Max. For example, you might have a batch rendering in which the script opens a sequence of files, sets up shots in each, and renders them, all without using the user interface.

**Layer Track**

A Motion Mixer track for a series of motions that do not require transitions between them. Compare with a Transition track on page 8751, which allows you to stack clips on top of one another and to create automatic transitions between them. When a biped is added to the Motion Mixer, it is automatically assigned a Layer track. See Adding Tracks to the Mixer on page 4007.

**Layers**

Layers are like transparent overlays, and allow you to organize and group different types of scene information. The objects you create have common properties including color, visibility, renderability, and display. An object can assume these properties from the layer on which you create it.
You can adjust layer properties from the Layers toolbar on page 8040 and the Layer Manager.

**See also:**
- Using Layers to Organize a Scene on page 7953
- Layer Manager on page 7956
- Layer Properties Dialog on page 7966
- Animation Layers on page 8507

### Layout Mode

Layout mode is active while the Auto Key button on page 8090 and Set Key button on page 8093 are both turned off. While you are in Layout mode, you can transform objects and sub-objects, and change the values of animatable parameters, without generating animation keys.

**See also:**
- Keyframe Mode on page 8615
- Keyframes/Keys on page 8616

### Lift

In footstep animation on page 8584, the state of a foot at the frame when it is about to lift away from a footstep.

### Light Map

A light map or lighting map is a bitmap on page 8523 that stores the lighting levels (intensity and color) falling on an object in the scene. Typically, you create a light map by rendering to a texture (texture baking) on page 6843. Light maps are primarily for use in game engines, but you can also use them to speed up renderings.
If you use the DirectX Manager on page 5771, you can display light maps interactively in viewports, using either the LightMap shader on page 6179 or the Metal Bump shader on page 6180.

See also:

- DirectX Manager Rollout on page 5771
Linked Geometry

Linked geometry is a by-product of importing or linking a drawing file to 3ds Max. It is a child object, or subcomponent, associated with VIZBlocks or Block/Style Parents.

When you select a linked geometry object, it offers no parameters on the Modify panel. You must first add an Edit Mesh modifier to the object or collapse the linked geometry object to an editable mesh in order to access sub-object levels. If you add a modifier to linked geometry, the modifier is applied to all instances of that object.

The only direct control you have over linked geometry objects is the Reset Position option that is used to negate and basic move, rotate or scale transforms.

Links

Links are the segments of the Physique deformation spline on page 8547. Links follow the hierarchy of the skeleton, such as a biped, that has been attached to the mesh on page 8638. Link parameters in Physique allow you to bend, twist, change sliding behavior, and radially scale the mesh.

Listener Window

In MAXScript, the Listener Window is a command-line window that lets you type in and execute MAXScript commands interactively. In other words, you run the script as you go along, rather than running a pre-saved text file.

You open the listener window using the MAXScript Listener command on the MAXScript menu or from the Utilities > MAXScript > MAXScript rollout > Open Listener command.

Local Container

A Local Container is a Container on page 8536 that is open. Local Containers can be created locally on your workstation (this type of Container is also referred to as a Unique Container on page 8752). A Container can also be open, and therefore local, when it is inherited with edit permission from an external
source (this type of Container is also known as a Source Container on page 8725).

Local Container helper object displays as an open box

See also:
- Container on page 8536
- Source Container on page 8725
- Unique Container on page 8752

Local Coordinate System

The local coordinate system is the coordinate system that relates specifically to the selected object.
A book in object space rests on a table in world space. The book has its own local coordinate system.

Each object has its own local center and coordinate system as defined by the location and orientation of the object’s pivot point. The local center and coordinate system of an object combine to define its object space.

The direction of the object’s X, Y, and Z axes depend on the current transforms of the object. Contrast with the world coordinate system.

You can see the difference between the two coordinate systems when you unintentionally rotate an object, such as a wheel on a car model, around the world axis instead of the object’s local axis. The wheel immediately flies off in a large arc because the center of the rotation is at the origin of the world coordinates.

To rotate the wheel correctly, first change the coordinate system to Local, using the pop-up list on the toolbar. The wheel then rotates around its own hub, which is the origin of its local coordinates.
Local Event

Particle Flow uses two types of events on page 8564: global on page 8594 and local. All events in a flow on page 8581 except the first are called local events, because the actions on page 8495 they contain take effect only while particles are in that event. The birth event on page 8521 is a special type of local event that always comes immediately after a global event.

Lofting

Lofting is an important method for 3D object creation. You create shape objects to serve as a path and any number of cross-sectional shapes. The path becomes the framework that holds the cross-sections forming your loft object.

A circle is lofted along a path to construct a tubular shape.

Once you create a loft object you can change and animate its parameters and sub-objects:

- Add and replace cross-section shapes or replace the path.
Change or animate the parameters of the path and shapes.

Change or animate the surface parameters of the loft object.

The lofting process first requires that you create shape objects to serve as the path and cross-sections of your loft object.

The term lofting comes from early shipbuilding. A large framework called a loft was built to hold the hull of a ship while it was assembled. The process of hoisting the ribs (cross-sections) of the hull into the loft became known as lofting.

A traditional method for building three-dimensional models of a modern vehicle design is to draw cross-sections at a number of key points. These cross-sections are cut out to form two-dimensional templates that are then placed on a rail. The model builders fill in the space between the templates to generate the surface of the model.

You create loft objects using a similar process. You first create two or more spline objects. One of these splines will be the rail, which is referred to as the path. The rest of the splines are the cross-sections of your object, which are called shapes. As you arrange your shapes along the path, 3ds Max generates a surface between the shapes.

Log File (mental ray Renderer)

The log file (.log) is an ASCII text file that contains messages generated by the mental ray renderer. You specify a name and location for the log file, and the "verbosity" level of the messages it contains, in the mental ray preferences on page 8363.

Look At Object

In the context of the Shape Facing operator on page 3139, a Look At object is the camera or object toward which particles face.

In the context of the Look At controller on page 3502 or LookAt constraint on page 3585, the Look At object is the object toward which the controlled or constrained object is oriented.
**LTLI Files**

The LTLI file type is the file format for photometric data created by the Danish Illuminating Laboratory. It is used primarily in Scandinavian countries.

**Luminance**

Luminance is the value of light reflected off a surface. It is a measure of how bright or dark we perceive the surface.

**Luminous Flux**

Luminous flux is the quantity of light energy per unit time arriving, leaving, or going through a surface. The lumen (lm) is the unit of luminous flux in both the International System (SI) of units and in the American System (AS) of units. If you think of light as particles (photons) moving through space, then the luminous flux of a light beam arriving at a surface is proportional to the number of particles hitting the surface during a time interval of 1 second.

**Luminous Intensity**

Luminous intensity is the light energy per unit time emitted by a point source in a particular direction. Luminous intensity is used to describe the directional distribution of a light source, that is, to specify how the luminous intensity of a light source varies as a function of the outgoing direction. The Candela (cd) is the unit of luminous intensity.

**LZF Files**

LZF (Lens Effects Flare) files allow you to store all of the settings for a Flare effect in one file. The settings are also saved with the MAX file; however, saving them to a separate file allows you to use the same Lens Effects settings in different scenes, and also allows you to share settings with other 3ds Max users.
**LZG Files**

LZG (Lens Effects Glow) files allow you to store all of the settings for a Glow effect in one file. The settings are also saved with the MAX file; however, saving them to a separate file allows you to use the same Lens Effects settings in different scenes, and also allows you to share settings with other 3ds Max users.

**LZH Files**

LZH (Lens Effects Highlight) files allow you to store all of the settings for a Highlight effect in one file. The settings are also saved with the MAX file; however, saving them to a separate file allows you to use the same Lens Effects settings in different scenes, and also allows you to share settings with other 3ds Max users.

**LZO Files**

LZO (Lens Effects Focus) files allow you to store all of the settings for a Focus effect in one file. The settings are also saved with the MAX file; however, saving them to a separate file allows you to use the same Lens Effects settings in different scenes, and also allows you to share settings with other 3ds Max users.

**LZV Files**

LZV files allow you to store the settings for several Lens Effects in one file. You can save all of your settings for Glow, Ring, Ray, Auto-Secondary, Manual Secondary, Star, and Streak effects in one file. The settings are also saved with the MAX file; however, saving them to a separate file allows you to use the same Lens Effects settings in different scenes, and also allows you to share settings with other 3ds Max users.
Map Channel

When you turn on Generate Mapping Coordinates for an object, the coordinates use map channel 1. You can assign new map channels with new mapping coordinates by applying a UVW Map modifier on page 1932 to the object. Map channel values can range from 1 to 99.

Left: Scene uses different map channels to place different copies of the same maps in different locations.

Right: The three maps used to create the streets and the traffic markers painted on them

A map channel associates a map with an object's mapping coordinates. Texture-baked maps on page 6843 also use map channels.

For NURBS on page 2416 surface sub-objects, you can assign a map channel without applying UVW Map. The surface sub-object has a different set of mapping coordinates for each map channel you use.

A map's map channel value identifies which of an object's mapping coordinates to use. Different map channels allow maps for the same object to use different coordinates. For example, you might use one channel for diffuse mapping on page 6031 and a different one for bump mapping on page 6049. Map channels also let different maps use different coordinates within a compound material on page 6106, a compositor map on page 6331, or a multi/sub-object on page 6120 material.

Different map channels can have different U and V tiling values, different U and V offsets, and so on. In the UVW Map modifier, you can also set different map channels to have different mapping types (planar, cylindrical, spherical, and so on).

If you apply a map that uses a certain map channel to an object that has no mapping coordinates for that channel, the map doesn't appear on the object.
When you render, a Missing Map Coordinates dialog appears to warn you of the problem. The dialog lists the map channel and the object name.

See also:
- Coordinates Rollout (2D) on page 6201
- Coordinates Rollout (3D) on page 6278

### Mapped Material

A mapped material is a material that contains one or more maps. Typically, it contains a bitmap as a Diffuse map, but having any map or maps applied qualifies a material as mapped.

In order for a mapped material containing a 2D map to appear properly in the viewports and in the rendered image, any object to which it’s applied generally needs mapping coordinates. By default, most parametric objects in 3ds Max already have mapping coordinates applied; you can also use the UVW Map modifier or Unwrap UVW modifier to provide mapping coordinates.

**NOTE** Objects with materials that contain only 3D maps do not need mapping coordinates.

### Mapping Coordinates

Mapping coordinates specify the placement, orientation, and scale of a map on the geometry. Coordinates are often specified in terms of U, V, and W, where U is the horizontal dimension, V is the vertical dimension, and W is the optional third dimension, representing depth.
Decoration on the vase is a map positioned by rotating the UVW Map Modifier gizmo.

If you apply a mapped material to an object that has no mapping coordinates, the Renderer assigns default mapping coordinates. The built-in mapping
coordinates are designed for each object type. The box mapping coordinates place a duplicate map on each of its six sides. For the cylinder, the image is wrapped once around its sides, and duplicates of the image are distorted at the end caps. A sphere has the image wrapped once around the sphere, and then gathered at the top and bottom. Shrink-wrap mapping is also spherical, but truncates the corners of the map and joins them all at a single pole, creating only one singularity.

3ds Max provides a number of ways to apply mapping coordinates:

- Use the Generate Mapping Coords option in the creation parameters rollout of any standard primitive. This option, which is on by default for most objects, provides mapping coordinates specifically designed for each primitive. They require additional memory, so turn the option off if you don’t need them.

- Apply a UVW Map modifier on page 1932. You choose from several types of mapping coordinate systems and customize the placement of the mapping coordinates on the object by positioning a mapping icon. In addition, you can animate the transformations of the mapping coordinates.

- Use special mapping coordinate controls for special objects. For example, Loft objects provide built-in mapping options that let you apply mapping coordinates along their length and around their perimeter.

- Apply a Surface Mapper modifier. This world-space modifier takes a map assigned to a NURBS on page 2416 surface and projects it onto the modified object or objects. Surface Mapper is especially useful for seamlessly applying a single map to a group of surface sub-objects within the same NURBS model. You can also use it for other kinds of geometry.

There are three cases where you don’t need mapping coordinates:

- Reflection/refraction maps and environment maps
  These use an environmental mapping system, in which the placement of the map is based on the rendered view, and fixed to the world coordinates in the scene.

- 3D procedural maps (such as Noise or Marble)
  These are procedurally generated, based on the local axis of the object.

- Face-mapped materials
  The maps are placed based on the facets in the geometry.
Maps

The images you assign to materials are called maps. 3ds Max provides several different map types. They include standard bitmaps (such as .bmp, .jpg, or .tga files), procedural maps, such as Checker or Marble, and image-processing systems such as compositors and masking systems.

Front left sphere: Marble bitmap
Front right sphere: Clouds bitmap
Back left sphere: Noise procedural map
Back right sphere: Marble procedural map

You can assign maps to most of the components that make up a material. Materials that contain one or more images are called mapped materials. By assigning maps to different attributes of the materials, you can affect the color, the opacity, the smoothness of the surface, and much more.

Maps offer the level of realism you look for in materials. The different types of maps you can use range from the common bitmap, to the flexible procedural map.

For many map types, the renderer needs instructions telling it where the map should appear on the geometry. These instructions are called mapping coordinates on page 8628.

Marker Data

Data from a motion-capture device on page 4916. Rather than limb rotational data, marker data uses marker positions to specify limb position.
Marker Files

A file from a motion-capture device. character studio can read two marker file formats:

- **CSM (character studio marker)** on page 8531
  This is the native marker file format of character studio.
- **BVH (BioVision)** on page 8520

Markers

In a motion-capture session, markers are reflective objects placed on the “actor” or “talent.” The markers enable motion-capture hardware to record the position of various parts of the talent’s body while performing motions.

Master Motion Clip Controller

In crowd animation on page 5104, a controller (similar to the Block controller) that consists of a list of motion clips. When instanced, these motion clips can blend from one animation to another. The Master Motion Clip controller is accessed via the Crowd helper on page 5162.

Match Frame

For the purposes of combining inverse kinematic (IK) on page 8612 and forward kinematic (FK) on page 8585 animation, this is a collection of keyframes that allow a seamless blend between IK and FK control, or vice versa. On the IK goal on page 8605, this includes IK keys for:

- Position
- Enabled state
- Swivel angle

On the IK bones, a match frame includes FK keys for:

- Rotation
Material ID

A sub-object’s (face or polygon) material ID is the value that determines which sub-material the sub-object uses when you apply a Multi/Sub-Object material on page 6120 to the object to which the surface belongs. Also, when you assign a material with a Multi/Sub-Map shader on page 6414 to several objects, the material IDs can determine where the sub-maps go.

Geometric primitives have default material identification number assignments, just as they have default smoothing groups. The default material ID assignment depends on the type of geometry. Most curved objects such as spheres have a single material ID. Boxes have six IDs, one for each side. Cylinders have three: ID number 1 and 2 for the two caps, and ID number 3 for the sides. Hedra have three: one for each of their P, Q, and R axes.
When you convert a primitive to editable mesh or editable poly format, these IDs are retained, or you can then change IDs with controls on the Surface Properties rollout on page 2218 or Polygon: Material IDs rollout on page 2309, respectively. In addition, you can use the Material modifier on page 1490 to assign material ID numbers.

When you assign a Multi/Sub-Object material or a material with a Multi/Sub-Map shader to an object, 3ds Max matches the material’s sub-material or sub-map ID numbers to the material ID numbers on the faces of the object. Each face stores its ID number, not the material name. In other cases, the material is assigned to the object’s entire surface.

Assigning some defining material ID number to each object before they become compound-object on page 667 operands can be a useful technique for being able to select the separate pieces after they’re combined.

You can use material IDs for continuous surfaces that require separate paints or finishes: for example, a car constructed from different types of materials, such as a colored metal body, chrome parts, glass windows, and so on.

Material/Map Hierarchy

The Material Editor could be called the Material and Map Editor, because you can use it to design both materials and maps, and any combination of the two. In addition, you can create material or map hierarchies.
A material hierarchy is a material that consists of other materials (or maps). Similarly, a map hierarchy is a map consisting of other maps. Materials that consist of other materials are called compound materials on page 8535. Maps consisting of maps are compound maps.

Materials

A material is data that you assign to the surface or faces of an object so that it appears a certain way when rendered. Materials affect the color of objects, their glossiness, their opacity, and so on.
Spheres with variations of the standard material type (no maps used):

- **Green sphere**: High Glossiness
- **Red sphere**: Constant shading
- **Blue sphere**: 60% opacity
- **Yellow sphere**: Wireframe mode, slight self-illumination

A standard material consists of ambient, diffuse, and specular components. You can assign maps to the various components of a standard material.

The standard material is the default material in the six sample slots of the Material Editor. However, you can change the type of material you're working on by clicking the button labeled Type below the sample slots. This displays the Material/Map Browser, and lets you select from a list of alternative material types.

You can also change the type of material you're working on by clicking the Get Material button below the sample slots. This displays the Material/Map Browser, and lets you select from a list of alternative material types.

---

**Matte Object**

A matte object is invisible but blocks any geometry behind it. However, it does not block the background.
Matte object reveals part of the background, making the hamburger geometry appear to be inside the oven.

For example, you might make a complex scene for the background of your animation, render it once, then assign the resulting bitmap as a background using only a few animated objects during the rendering of the animation. If you then needed one of your objects to appear from behind some portion of the background, such as a building, you would create a matte object that matches the building. You then place the animated object behind it. The bitmap image of the building appears, but the animated object is blocked until it moves from behind the matte object.

Matte objects, though invisible, can cast shadows.

Matte objects can also receive shadows. When the Matte/Shadow material’s Affect Alpha check box is set, shadows cast on the matte object are applied to the alpha channel. This lets you render maps with alpha shadows that you can composite later. To properly generate shadows on a matte object, turn off the Opaque Alpha check box and then set the Affect Alpha check box.
MAX Files

The MAX file format is the native format used when saving and loading scenes in 3ds Max. A MAX file contains all scene elements, including geometry, materials, lights, cameras, animation, and so on. However, it does not contain files that externally reference the scene, such as XRefs and bitmap images. When you use the Open, Save, and Save As commands, the software uses the MAX file format.

MAXScript

MAXScript is the general-purpose scripting language for 3ds Max and related products. While it works the same for all products, some functions are specific to each. You can use MAXScript to automate many tasks, including modeling, animation, material construction, and rendering. You can also use MAXScript to add custom command-panel rollouts to the user interface.

The interface to MAXScript is on both the MAXScript menu on page 8031 and the Utilities panel on page 8223.

Mesh

A mesh is a type of geometric model of a three-dimensional object in which the basic shape is made up of points, or vertices, connected by edges. The renderable surface of the mesh object is made up of faces or polygons that connect the vertices and edges. Examples of mesh objects in 3ds Max are primitives such as Sphere and Teapot, as well as Editable Mesh and Editable Polygon objects.

In 3ds Max you can edit a mesh by transforming, adding, and deleting the various elements, or sub-objects: vertices, edges, faces, and polygons. You can also apply various changes with modifiers.

Metaballs

A type of object that joins itself to other objects with a connecting surface. When one metaball object moves within a certain distance of another, a connecting surface is formed between the two. Metaballs are ideal for
simulating liquids and thick, viscous substances such as mud, soft foods, or molten metal.

You can create metaballs with the BlobMesh compound object on page 701.

**MFE Files**

A MFE file contains a motion flow graph on page 4891 and any scripts created for the graph. See Saving, Loading, and Appending Motion Flow Graphs on page 4861.

**MI Files**

The MI file (.mi, stands for “mental images”) contains a mental ray scene description that a mental ray renderer can use to render your 3ds Max scene. When you render with the mental ray renderer, you can export to a text (ASCII) MI file. (There is a binary MI format as well. The mental ray renderer in 3ds Max does not generate this format.) The exporter always generates mi3 (mental ray version 3) format. It does not support mental ray version 1 (mi1).

You specify a name and location for the MI file on the Render Setup dialog > Processing panel > Translator Options rollout on page 6787.

See the mental ray manual, Programming mental ray, for a complete description of the mental ray scene description language.

**Mirroring**

When working with a biped on page 4487, the Mirror control in the Keyframing Tools rollout on page 4717 allows you to mirror the entire biped animation.

**Mix**

Data in the Motion Mixer on page 4002 for a single biped. The term mix refers to the arrangement of elements in Motion Mixer (clips on page 8646, transitions on page 8750, balance information on page 8517) as well as the result of the arrangement. A mix is sometimes called a raw mix to distinguish it from a mixdown on page 8640.
You can save a mix to a **MIX file** on page 8640.

### MIX Files

A MIX file contains data from the Motion Mixer, including information on **trackgroups** on page 8745, **tracks** on page 8744, **clips** on page 8646, **transitions** on page 8750 and **balance information** on page 8517. Compare with a **mixdown** on page 8640, which contains the same data, but in a collapsed format; the data is no longer separated into tracks and clips.

You can save a MIX file in the Motion Mixer by choosing Mix menu > Save Mix File, or by clicking Save File on the Mixer rollout.

### Mixdown

A mixdown is a collapsed version of data in the Motion Mixer. In general, a mixdown contains the same data as the **raw mix** on page 8639, with one difference. During the process of computing a mixdown, any transitions involving planted feet are corrected to prevent the feet from sliding.

After a mixdown is computed, it is placed on its own track in the Mixer. You can turn the mixdown on and off by clicking it. When the mixdown is turned on, the biped performs the motions in the mixdown; when it is turned off, the biped does the motions in the raw mix. See Exporting Animation to the Biped on page 4043.

### MNM Files

An MNM file (Marker Name file) is a **character studio** file format that matches custom names in a motion-capture **marker file** on page 8632 with the preset list of known, supported marker names that are recognized by bipeds. See **BVH Files** on page 8530 and **CSM Files** on page 8543 for descriptions of how these two motion-capture file formats work with MNM files.
**Modal/Modeless**

Modal is a command state or dialog that affects all operations. You must change the mode or dismiss the dialog before doing any operations that don't pertain to that mode.

Modeless means a nonexclusive command state or dialog. You can do other operations and commands without changing the mode or dismissing the dialog.

For example, the Track View and Material Editor dialogs are modeless, while the Open File dialog is modal.

**Modifier Stack**

The modifier stack on page 8187 is the key to managing all aspects of object modification.

Example: Modifier stack display of cylinder with two modifiers applied to it
Example: Stack display of mesh showing its sub-object hierarchy, and Edge sub-object level chosen

You use the stack to:

■ View and manipulate the sequence of modifiers
■ Find a particular modifier
■ Adjust a modifier's parameters
■ Select a modifier's gizmo or center
■ Activate or deactivate a modifier
■ Delete or disable a modifier

The effect of modifiers is directly related to their sequence, or order, in the stack.

Where you put a modifier in the stack is critical, because 3ds Max applies modifiers in their stack order, beginning at the bottom, and carries the cumulative change upward.

By clicking any entry in the stack, you go back to the point where you made that modification. You can then rework your decisions or discard the modification entirely by deleting it. You can also insert a new modifier in the stack at that point.
Modifiers

Modifiers on page 1040, as the name implies, modify an object's geometrical structure, deforming it in some way. When you apply a taper modifier on page 1807 to the end of a cylinder, for example, the vertices near the end move closer together. Modifiers make changes in the geometry that stay in effect until you adjust or delete the modifier.

Example: effects of the twist modifier on an object

Morphing

Morphing is a term derived from *metamorphosis*, which means to change physical shape or form.
Morphing makes the clock appear to melt.

The purpose of the morph object in 3ds Max is to create an animated object that changes shape by morphing between two or more objects. Although it appears that a single object is changing form, in reality the morphing process translates the position of the vertices from their arrangement in one object to the arrangement in another, relative to their local coordinate system.

Consequently, all objects chosen to make up a morph object must have the same number of vertices. Typically, you achieve this by cloning an object, and then altering the geometry of the clones without changing their vertex count.

**Motion Blending**

When working with motion flow on page 4848, you use transitions to blend clips together. By default, a transition is calculated with a method known as “minimum motion loss.” If optimized transitions are used, then a sophisticated algorithm that minimizes foot sliding is used. This alternative method is computationally expensive.

**Motion Blur**

Motion blur can enhance the realism of a rendered animation by simulating the way a real-world camera works. A camera has a shutter speed, and if significant movement occurs during the time the shutter is open, the image on film is blurred.
Motion blur enhances the movement of the sword.

3ds Max provides a variety of ways to apply motion blur:

- **Image Motion Blur** on page 8606 applies motion blur to entire frames of an animation.
- **Motion Blur Rendering Effect** on page 7157 lets you apply image motion blur as a rendering effect on page 7057.
- **Multi-Pass Rendering Effect** on page 5587 applies motion blur to frames by offsetting the camera in multiple rendering passes. You can preview multi-pass rendering effects in camera viewports.
- **Particle Motion Blur** on page 3300 uses a material map to blur moving particles in a particle system.
- **Scene Motion Blur** on page 8710 lets you apply motion blur as a Video Post effect.
- **Object Motion Blur** on page 8658 applies motion blur to specified moving objects in a scene. Object motion blur is best for making fast-moving objects appear to move more smoothly.
Motion Capture

The process of digitizing the movements of a live “actor” or “talent.” This requires a motion-capture device.

Motion Clip

A motion clip is a sequence of motion on a biped or other objects. A motion clip can be a BIP file, or a portion of a 3ds Max animation used in a crowd sequence.

BIP files used in Motion Flow on page 8647 and the Motion Mixer on page 8647 are called motion clips. You can use these tools to combine several motion clips and make a longer or different animation. A BIP motion clip can be created by saving animation on page 4638 you have made on the biped, or by importing motion-capture data on page 4918.

When you create a crowd animation on page 5104 that uses motion synthesis on page 8648 on non-biped objects, a motion clip is a portion of a 3ds Max animation used by the synthesis. You specify that a range of frames in the animation is to be used when the delegate meets certain criteria, such as turning upward to exceed a certain pitch.

One animation sequence can contain all the motion clips necessary to animate the crowd. For example, a bird animation might have three motion clips: flap, glide, and land. You could specify that when the delegate is pitched upward, the range of frames that animate the flap motion are used in the simulation. Motion clips are used by the Global Motion Clip Controller on page 8596 and the Master Motion Clip Controller on page 8632.

Motion Files

character studio can load these types of motion files:

- BIP files on page 8520
- BVH files on page 8530
- CSM files on page 8543
Motion Flow

In Motion Flow mode on page 4848, you combine BIP files on page 8520 to create longer character animation. You also use motion flow along with crowd animation on page 5104 to automatically generate crowd behavior.

One motion can transition into another. To generate a transition, character studio uses either velocity-interpolated transitions (“minimum motion loss”), or an algorithm to minimize sliding feet.

Motion Flow Editor

In Motion Flow mode on page 4848, the Motion Flow Editor allows you to manually create a transition between two clips. You set the start frame and transition duration for both clips, and the orientation of the destination clip.

Motion Flow Scripts

When using motion flow on page 4848, a script is a sequence of motion files that are played to create a character’s motion. Scripts are created either manually or automatically.

Motion Mixer

The Motion Mixer is a window where you can mix motion clips (BIP files) on a biped. The clips are placed on various tracks on page 8744 within the mixer.
In the Motion Mixer, you can use trackgroups on page 8745 to affect different body parts with different clips. Each trackgroup can contain transition tracks on page 8751 and layer tracks on page 8617, which hold the motion clips.

Each biped in the Motion Mixer is assigned a balance track on page 8517, which automatically compensates for differences in balance between upper and lower body motion.

To make the motion in the Mixer affect the biped in the scene, you must turn on Mixer Mode in the Biped rollout on page 4669.

See Using the Motion Mixer on page 4002.

**Motion Synthesis**

In crowd animation on page 5104, motion synthesis is the process of animating bipeds by combining motions (clips) automatically. Clips are added to the Motion Flow Graph, and transitions are created between appropriate clips. In the Crowd system, delegates are animated. During synthesis (solving the motion), the delegates' speed and direction are analyzed by character studio. Based on the analysis, clips are selected to animate the bipeds.
MSP (MAXScript Package) Files

A MAXScript Package (MSP) combines the set of files that make up a scripted tool into a single file. An MSP file can contain bitmaps, script sources, icons, and so on.

For more information about MSP files, see the MAXScript Help: Help menu > MAXScript Help.

Multiplicity

In NURBS modeling, multiplicity is the property of coincident or nearly coincident CVs that reduces the continuity level of the curve or surface. Two coincident CVs locally increase curvature. Three coincident CVs (or more) create an angular cusp. Fusing CVs shows the effect of multiplicity.

Effects of multiplicity:
On the left, three coincident CVs create a sharp angle.
On the right, only two coincident CVs in the same location create a gentler curve.

Multiplier

The Multiplier value in every light lets you increase the intensity, or brightness of the light beyond its standard range.
Since increased Multiplier values tend to wash out, or "burn" portions of the image, you're better off adding lights, or reducing the intensity of other lights when you need to adjust the brightness of areas in your scene. Remember that you can adjust the intensity of a light using its V(value) spinner. In most cases, it's better to adjust the V spinner than to alter the default Multiplier value.

An unusual characteristic of the Multiplier is that you can use negative values to create negative light. You can use negative lights to further control the lighting in your scene. For example, you might want a darker area in the corner of a room.

A negative Multiplier value reverses the color of the light, so a red light would become cyan (the complementary color). In addition, the map image in a projector light becomes a negative image.
Multiplier Curve

Multiplier curves are special function curves that you use to apply animated value displacements to other function curves.

When you edit keys and function curves, you apply localized changes to your animation at specific times. By applying a multiplier curve to the original track, you affect the entire range of the original animation.

A multiplier curve shifts the value of the original track up or down. At a given frame, the value of a multiplier curve is a scale factor applied to the value of the original function curve.

■ The default value of a Multiplier curve is a horizontal line with a value of 1.0.
■ Values greater than 1.0 increase the value of the function curve.
■ Values below 1.0 decrease the value of the function curve.
■ Values less than 0.0 negatively scale the value of the function curve.

See also:
■ Ease Curve on page 8558

N Links

In Physique on page 4944, by default, any number of overlapping envelopes can influence vertices. This is specified by the N Links option on the Vertex-Link Assignment rollout on page 5046 of the Physique Initialization dialog, or at the Vertex sub-object level on page 5096.

Typically, N Links is the preferred choice. For special purposes, such as developing for a game engine that has limited support of overlap, you can limit the number of links (with their envelopes) that can affect a vertex.

Network Manager

The Network Manager service (Network Manager) is a service that must be installed on at least one computer in each group of computers that will participate in network rendering.
The Network Manager communicates with a specified group of Network Rendering Servers to assign jobs and monitor rendering progress. The Network Manager also handles the scheduling of jobs and the configuration of servers through the Queue Monitor client.

It's often best to place the Network Manager on a computer that isn't in use as a workstation and isn't shut down regularly. The Manager Service can impact CPU and network performance when network rendering is taking place, and the Network Manager must be present at all times for network rendering to work.

The ideal place to install the Network Manager is on a file server. If you have a PC already set up as a texture-map file server, this would be an ideal place for it.

You specify which PC is to be the Network Manager in the Network Job Assignment dialog, a subdialog of the Render Setup and Video Post Execute Sequence dialogs.

**Network Rendering**

Network Rendering is the rendering of animations using more than one computer connected by a network.

Large and complex animations take many hours to render, even on the fastest PCs. Network rendering allows you to use the power of other computers to speed up the process. Any network-connected PCs that have 3ds Max installed can participate. You can even render using computers connected only by the Internet.

Setting up network rendering involves installing three kinds of programs:

- The Network Manager, which should be installed on a central file-server PC.
- The Network Rendering Server, which must be installed on all participating PCs.
- The Queue Monitor client provides a user-interface to monitor and control network rendering. It can be installed on any of the participating PCs.
Network Rendering Server

The Network Rendering Server must be running on any computer dedicated to rendering a job remotely.

The Server communicates with the Network Manager and starts 3ds Max on that computer to render network processes. The Server has no user interface itself, but you can set various options for it from the Queue Monitor client. For example, you can specify the times of day that the Server is available to do network rendering.

You specify which PCs are to be servers in the Job Assignment dialog on page 6953, a subdialog of Render Setup.

Newton

In the metric system, the newton is the unit of force required to accelerate a mass of one kilogram one meter per second. In 3ds Max, you can use the newton in dynamic simulations with objects such as the spring on page 849 and damper on page 842.

Node

Every object in a 3ds Max scene is represented in memory (that is, in the data structure of the scene) as a node, which acts as a container for an object’s geometry, its transform controllers, assigned materials and modifiers, etc. Nodes also provide the building blocks for hierarchies, in which parent/child relationships are created by linking objects node to node. Two tools that display nodes are Track View and Schematic View.

"Node" is distinct from the term “object,” because the “object” refers more narrowly to geometry: the mesh, or NURBS surface, spline, or patch, and so on. The same instance of an object’s geometry can be shared by multiple nodes. Each node in the scene is unique and can be identified as such by the commands and tools 3ds Max or plug-ins implement.
Normal

A normal is a vector that defines which way a face or vertex is pointing. The direction of the normal indicates the front, or outer surface of the face or vertex.

The normal of each face can point in a different direction.

You can manually flip or unify face normals to fix surface errors caused by modeling operations or by importing meshes from other programs.

See also:

- Normal modifier on page 1551

NTSC

NTSC (National Television Standards Committee) is the name of the video standard used in North America, most of Central and South America, and Japan. The frame rate is 30 frames per second (fps) or 60 fields on page 8570 per
second, with each field accounting for half the interleaved scan lines on a television screen.

NURBS

NURBS (Non-Uniform Rational B-Splines) are a technique for interactively modeling 3D curves and surfaces.

Fountain basin modeled as a NURBS surface

NURBS Curve

A curve object created by NURBS modeling on page 8655. NURBS Curves can be either Point Curves or CV Curves. You can use them as you do spline curves in Shape objects.
NURBS Model

A NURBS object consisting of one or more sub-objects. The 3ds Max documentation uses "NURBS model" to emphasize the final result of NURBS modeling using a variety of sub-objects and techniques.

Fountain modeled using NURBS surfaces

NURBS Surface

A surface object created by NURBS modeling. NURBS Surfaces can be either Point surfaces or CV Surfaces.

NURMS

NURMS stands for Non-Uniform Rational Mesh Smooth. You can create meshes smoothed by this method with the MeshSmooth modifier on page 1505. NURMS
smoothing is also provided by the Graphite Modeling Tools: see Use NURMS Panel on page 2084.

**Object**

"Object" means an object in the scene, such as primitive geometry like boxes and spheres, more complex geometry such as Booleans, and so on. Geometric objects are renderable. A scene can also contain non-renderable objects such as lights, cameras, helpers, and space warps.

*An assortment of geometric primitive objects*

You add objects to a scene by selecting the Create menu or from the Create panel.

**Object Instance**

In 3ds Max, an instance is a completely interchangeable clone of the original object. Modifying an instanced object is the same as modifying the original.
Instances are not only alike in geometry, but also share modifiers and materials. When you change one instance by applying a modifier, for example, all the other instances change with it.

Each instance has its own set of transforms, object properties, and space warp bindings. These are not shared among instances.

Within 3ds Max, instances derive from the same master object. What you’re doing is applying a single modifier to a single master object. In the viewport, what you see as multiple objects are multiple instances of the same definition.

For example, if you wanted to create a school of swimming fish, you might begin by making many instanced copies of a single fish. You could then animate the swimming motion by applying a Ripple modifier to any fish in the school. The whole school would swim with exactly the same motions.

**Object Motion Blur**

Object motion blur applies a blur effect to make fast-moving objects appear to move more smoothly in animations. It is a form of "temporal antialiasing."

Left: Object motion blur. Right: Object motion blur with dithering.
TIP For simulating the blur created by a moving camera image motion blur on page 8606 or scene motion blur on page 8710 works better than object motion blur.

Applying object motion blur is a two-step process:

1 Turn on object motion blur for the object you want to blur, using the Object Properties dialog on page 283.
   You cannot apply both image motion blur and object motion blur to the same object in the same rendering.

2 Before you render, turn on object motion blur in the Default Scanline Renderer rollout on page 6589 of the Render Setup dialog.

Object motion blur works by rendering multiple copies of the object in between frames and then rendering them together. It is not affected by camera movement.

Object Space

Object space is the coordinate system unique to each object in your scene, as opposed to world space on page 8769. It tracks the location of everything applied to an object. The location of object vertices, the placement of modifiers, mapping coordinates, and materials are all defined in object space.
A book in object space rests on a table in world space.

Each object has its own local center and coordinate system as defined by the location and orientation of the object’s pivot point. The local center and coordinate system of an object combine to define its object space.

When you choose Use Pivot Point Centers from the toolbar or Use Pivot Points from the Modifier List, you are telling 3ds Max to use the Object Space origin of one or more selected objects as the center of a transform or modifier effect.

When you choose Local from the Reference Coordinate System list on page 922 (on the main toolbar), you tell 3ds Max to use a selected object’s object space for the orientation of the active coordinate axes.

Most modifiers on page 8643 operate in object space. See Object-Space Modifiers on page 1159.

In discussions of texture mapping, object-space coordinates are expressed as UVW coordinates.
Object Space (Biped)

When you use freeform animation on page 8586 to animate a biped, you can place a biped limb into the space of another object, or into world space. For example, if the biped's hands are in the space of a ball, then wherever the ball moves the hands move with it. If the biped's feet are in world space, then when you move the center of mass, the feet stay planted in the same location.

Obstacle-Avoidance Behavior

In crowd animation on page 5104, an important part of crowd behavior is avoidance of obstacles. Think of an obstacle as anything that impedes a crowd member's progress. Examples of obstacles include walls, telephone poles, and fences, as well as other crowd members. Encountering such objects can cause avoidance behavior, which consists of any combination of slowing down, turning, and stopping.

Object-Space Modifiers

Object space is the coordinate system unique to each object in your scene. An object-space modifier, as opposed to a world-space modifier on page 8770, directly affects an object using the object's local coordinates.

Object-space modifiers appear directly above the object in the modifier stack on page 8641, and their effect can depend on the order they appear in the stack.

Omnidirectional Light

Omnidirectional (omni) lights are standard light objects on page 5398 that provide a point source of illumination that shoots out in all directions. They're easy to set up, but you can't restrict the focus of their beam. You can, however restrict which objects are illuminated by an omni light.
When no lights exist in your scene, two invisible omni lights are turned on by default to provide overall illumination in the scene. However, as soon as you create your own light in the scene, the two default lights are turned off. You can apply attenuation to omni lights.
**Omniflector**

A space warp on page 8727 that deflects particles. Omniflectors are also capable of refracting particles and generating spawned particles.

Three kinds of space warps are in the omniflector category:
- POmniFlect Space Warp on page 2935
- SOmniFlect Space Warp on page 2946
- UOmniFlect Space Warp on page 2948

See also:
- Dynaflector on page 8557

**Opacity Falloff**

Real transparent surfaces vary their opacity, depending on the angle of the material to your point of view. For example, a bottle appears more transparent at its center than at its edge because you’re looking through more glass at its edge.

In the Extended Parameters rollout, you can specify the falloff of the transparency, based on the angle of the face normals to the view. If a face is perpendicular to the viewer, the angle of its normal is 0 degrees. If the face is edge-on to the viewer, its normal angle is 90 degrees.

Falloff is either inward or outward:
- **In** Transparency increases as the normal angle approaches 0 degrees and decreases as the angle approaches 90 degrees. This gives the appearance of a hollow object such as a glass ball or bottle.
Inward opacity falloff
Top: None
Bottom: 100%

Outward opacity falloff
Top: None
Bottom: 100%

Transparency increases as the normal angle approaches 90 degrees and decreases as the angle approaches 0 degrees. This gives the appearance of a solid object such as a cloudy glass marble.

The falloff amount never makes the object less opaque than the value of the Opacity spinner. For example, if Opacity were set to 50, and Falloff set to In,
the inner portions would remain at 50 percent opacity, and the Amt. spinner would change the outer edges, until they became opaque at 100.

**Operand**

An operand is one of a set of objects upon which an operation such as Boolean on page 713 is to be done. The Boolean operation takes two operands: the first operand is called operand A, and the second operand is called operand B.

**Operator**

In Particle Flow on page 2997, the operator is the basic element of the particle system; you combine operators into events on page 8564 to specify the particles' characteristics over a given period of time. Operators let you describe particle speed and direction, shape, surface properties, and more.

A list of all operators in Particle Flow is available in the Operators topic on page 3050.

See also:

- Test on page 8741

**Operator Icon**

In Particle Flow on page 2997, adding a Find Target test on page 3247 or a Speed By Icon operator on page 3112 to a particle system creates a special viewport icon used by the action. This icon is known as an operator icon. In the 3ds Max scene, an operator icon functions as a Helper object, and, in fact, you can also add these two actions from the Create panel by choosing Helpers > Particle Flow.
Optical Markers

Reflective markers used by certain motion-capture equipment. In a motion-capture session, markers are reflective objects placed on the “actor” or “talent.” The markers enable motion-capture hardware to record the position of various parts of the talent's body while performing motions.
Orientation Behavior

In crowd animation on page 5104, the Orientation behavior lets you control whether and how delegates rotate, independent of their direction of motion. Normally, a delegate always faces in the direction it's moving. You can use the Orientation behavior to specify limits to the delegate's rotational activity without affecting its path, which is generated by other behaviors. Use these settings, for example, to keep delegates facing in one direction while moving in another.

**NOTE** These settings do not affect the path a delegate takes, which is produced by other behaviors such as Seek and Avoid. Orientation influences only the direction the delegate faces as it traverses the path.

Origin

A coordinate system assigns an arbitrary point in space as the origin, and sets each axis at that point to zero.

In the world coordinate system on page 8768, numbers increase from the origin to the right along the X axis, upward along the Y axis, and away from you on the Z axis. Numbers decrease (−1, −2, −3, and so on) to the left along the X axis, downward along the Y axis, and toward you along the Z axis. The distance between each whole number is called a unit of measurement (a 3ds Max unit).
Origin is the 0,0,0 point where the X, Y, and Z axes intersect.

You can combine the measurements of all three axes to mark specific locations in 3D space. The combined measurements are called coordinates. Thus, at the origin, the coordinates are X=0, Y=0, Z=0, which can be expressed more simply as the vector (0,0,0).

From the origin, the coordinates at a location 100 units to the right, 150 units up, and 60 units away are X=100, Y=150, Z=60, or (100,150,60).

**Orthographic View**

Whether produced on computer or paper, most 3D design relies on 2D representations for accurate description of objects and their positioning. Maps, plans, cross-sections, and elevations are all examples of 2D representations. Each of these views represents an orthographic view. In familiar terms, you might think of these views as "flat" or "straight-on," or as "looking at right angles."
Orthographic views of a model
Orthographic views are two-dimensional, each defined by two world coordinate axes. Combinations of these axes produce three pairs of orthographic views: top and bottom; front and back; left and right.

Orthographic views are a special case of axonometric views on page 8515. You can set viewports to the various orthographic views using the Point-Of-View (POV) viewport label menu on page 8122 or keyboard shortcuts on page 8419.

### Out-of-Range Types

When you specify values and keys for a controller, you are defining animation over a range of time. You choose Out-of-Range Types to determine how the animation continues outside a specified range. Out-of-Range choices include holding a constant value, and various ways of repeating the animated range.

![Out-of-Range Types dialog](image)

The easiest way to work with Out-of-Range Types is in the Track View Function Curve mode.

You use the Parameter Out-of-Range dialog to project the pattern of the key dots in the selected track. These patterns are applied to the animation outside the range of all keys in the track. This is why they’re called out-of-range types.

By default, tracks use a constant out-of-range type. This means that the track values before and after the range of keys remain constant. For example, in a 100-frame animation with keys up to frame 20, the X, Y, and Z values after frame 20 remain the same for the rest of the animation. The objects in this example do not move from frame 20 to frame 100.
Applying the Cycle out-of-range type will make the key pattern in frames 0–20 repeat cyclically for the remaining 80 frames.

**Outputs: Source / Test**

In Particle Flow, you create a particle diagram on page 8677 by connecting events on page 8564 using wires on page 8763. Each wire links an output with an event input on page 8610. There are two different types of outputs:

- The connector sticking down from the bottom of a global event on page 8594 is a source output.
- The connector sticking out from the side of a test on page 8741 is a test output.
The Overshoot option causes a spotlight to flood beyond its falloff area, and cast light in all directions. With Overshoot turned on, the spotlight casts light in all directions but casts shadows only within its falloff cone.
The Overshoot control effectively turns the spotlight into a hybrid between an Omni light and a spotlight. With Overshoot set, the spotlight casts light in all directions as an Omni light does but still casts shadows or projections as other spotlights do. The shadows and projections are limited to the falloff region: outside the cone of the spotlight, Overshoot casts light but does not cast shadows or projections.
Overshoot is useful when you want to light a large area but need to cast shadows in only a small part of that area. Set the falloff to include the area where shadows must appear, and then turn on Overshoot to light the rest of the scene. This technique can reduce the size of shadow maps and thereby improve rendering speed.

**PAL**

PAL (Phase Alternate Line) is the video standard used in most European countries. The frame rate is 25 frames per second (fps) or 50 fields on page 8570 per second, with each field accounting for half the interleaved scan lines on a television screen.

**Parameter Space**

NURBS objects have, in addition to their existence in 3D space, a parameter space that includes the array of knot values. NURBS curves have a single $U$ dimension in parameter space. NURBS surfaces have two dimensions, $U$ and $V$, in parameter space.

**Parameters Panel**

The parameters panel, found to the right of the event display on page 8566 in Particle View on page 3015, displays the parameters of any action whose name you click in the depot. The panel uses the same format and editing methods as the command panel in 3ds Max. Display of the parameters panel can be toggled with the Particle View menu command Display > Parameters.
Parameter/Parametric

A parameter is a setting or value that you can change. Many objects in 3ds Max have parameters that you can change to alter the size or shape of the object. This type of object can be described as parametric.
A tube is one example of a parametric object. Varying its parameters creates varying geometry.

Unlike physical building blocks, which have a fixed shape and size, the geometric primitives (box, sphere, torus, and so on) are parametric; you can change their dimensions, segment settings, and other features after you create them. Parametric objects respond to changes in their parameters by dynamically updating their properties.

Changing a parameter can dramatically alter the structure and appearance of an object. For example, you can turn a cylinder into a prism by reducing the number of sides and turning the Smooth option off. Alternately, you can turn a cone into a four-sided pyramid using the same technique.

Objects that you merge from other scenes or from Autodesk VIZ allow you to access parametric values. Objects in drawings that you link from Autodesk Architectural Desktop should be edited in Architectural Desktop, then relinked to 3ds Max with the File Link Manager on page 7538.

You can animate almost all creation parameters for geometric primitives, and interactively change their settings during animation playback.

**Parent Particle**

A parent particle is an existing particle from which the particle system generates spawn particles on page 8727. You can use the Spawn test on page 3281 to create spawn particles arbitrarily, or the Collision Spawn test on page 3241 to create spawn particles as the result of physical interaction between a parent particle and a deflector.
Particle Diagram

The particle diagram is the graphical depiction of the particle system on page 8678 in Particle View on page 3015. It uses events on page 8564 and wires on page 8763 to represent the system's elements and logic. You edit the system by clicking actions on page 8495 and events in the diagram and changing their values, by adding new actions and events, and by creating wires between events.
**Particle Level**

In Particle Flow, you can select particles at the Event level on page 8567 or at the Particle level, using controls on the Modify panel > Selection rollout on page 3039. At the Particle level, you select particles using standard 3ds Max methods, such as clicking or dragging a region. A Particle-level selection can be acted upon by the Delete operator on page 3067 and the Split Selected test on page 3290.

**Particle System**

Particle systems are objects that generate non-editable sub-objects, called particles, for the purpose of simulating snow, rain, dust, and so on.

The particle system object generates the particles over time. You use particle systems primarily in animations.

3ds Max provides several built-in particle systems, including Spray and Snow. Your configuration might have other plug-in particle systems installed.

The Deflector, Gravity, and Wind space warps are for use with particle systems. (Gravity and Wind also work with Dynamics.)

3ds Max also offers an event-driven particle system called Particle Flow on page 2997.

**Particle System (Particle Flow)**

A particle system in Particle Flow consists of all flows on page 8581 defined in Particle View, as well as parameters defined for all Particle Flow sources on page 3034. In effect, it’s the totality of settings in Particle Flow.

**PASS File**

A PASS (.pass) file saves the result of a single mental ray rendering on page 6675 pass. You can create a final rendering by merging multiple passes. The PASS file format includes Z-buffer information to aid in merging passes.

Controls for creating and merging PASS files are on the Render Setup dialog > Processing Panel > Translator Options rollout on page 6787.
**Patch**

A patch is a type of deformable object. A patch object is useful for creating gently curved surfaces, and provides very detailed control for manipulating complex geometry.

**Example of a patch model**

When you apply an *Edit Patch modifier* on page 1329 to an object or convert it to an *editable patch* on page 2360 object, 3ds Max converts the object's geometry into a collection of separate Bezier patches. Each patch is made up of three or four vertices connected by edges, defining a surface. Patches also have interior vertices that you can control, or let 3ds Max control for you.

You control a patch surface's shape by manipulating the vertices and edges. The surface is the renderable geometry of the object.

**Patch-Based Objects**

Objects made from patches. *Physique* on page 4944 can work with meshes, patches, NURBS, splines, and FFD space warps.

**Path**

A path is the line (or other shape) along which shapes are lofted to create 3D *Loft objects* on page 742.
The Path constraint on page 3596 also lets you assign a line or other shape as a motion path. A motion path is a form of trajectory on page 8746.

**Get Path (Lofting)**

A circle is lofted along a path to construct a tubular shape. Get Path chooses the path spline.

You use Get Path as a loft creation method when you want the path to move to the location of the selected shape. For example, you use this method if you have created a shape at the exact location where you want the base of your loft object to be. You use Get Path to create a loft at that location.

Get Path causes the path shape to move and rotate to align itself with the first shape on the path:

- The first vertex on the path is located at the first shape's pivot point.
- The tangent to the first vertex on the path is aligned with the positive Z axis of the first shape.
- The local Z axis of the path is aligned with the local Y axis of the first shape.
The local coordinate system of the resulting loft object equals the local coordinate system of the path after it has been aligned with the first shape.

Sometimes, aligning the tangent of the path with the positive Z axis of the first shape does not produce the result you want. You can flip the orientation of the path by pressing Ctrl while getting the path. Pressing Ctrl aligns the path so that the tangent to the first vertex of the path is aligned with the negative Z axis of the shape.

Path Follow Behavior

In crowd animation on page 5104, the Path Follow behavior lets you direct delegates to traverse a specified path during a crowd simulation. Delegates can move forward or backward along paths, and when they reach the end, they can loop back to the start or reverse direction, or even continue in the same general direction.

If the delegate's start position isn't on the path at the start of the simulation, it moves to the path before following the path. During the solution, character studio intermittently displays an optional target icon to show the delegate's immediate goal; this changes as the simulation proceeds.

Period

When you animate a biped, a freeform period is a period between footsteps where you can animate the biped any way you want. Biped dynamics on page 8521 are suspended during this period. See Freeform Animation Between Footsteps on page 4565.

Perspective View

Perspective views most closely resemble human vision. Objects appear to recede into the distance, creating a sense of depth and space. For most 3D computer graphics, this is the view used in the final output that the client sees onscreen or on the page.
Perspective view of the ice-cream shop

There are three ways to create a perspective view in a viewport: perspective view, camera view, and light view.

A perspective viewport, labeled Perspective, is one of the default viewports. You can change any active viewport to this eye-like point of view by pressing the keyboard shortcut P.

A camera view requires that you first create a camera object in your scene. The camera viewport tracks the view through the perspective of that camera. As you move the camera (or target) in another viewport, you see the scene swing accordingly. If you alter the camera's field of view on the Modify command panel, you see the changes as they are applied.

The light view works much like a targeted camera view. You first create the spotlight or directional light and then set the viewport to that light. What you see in the viewport is the view from the light looking into the scene. This is very useful for adjusting the correct distances of hotspot and falloff for the light.
Phases of Leg Motion

A leg's motion has four phases, beginning with the foot on the ground. Then the foot lifts, moves through the air, and returns to the ground again. Biped divides this motion into four phases, as follows:

- **Touch**: Occurs at the leg keyframe where the leg's foot first touches the ground and always corresponds with the start frame of a footstep in Track View — Dope Sheet.

- **Plant**: Occurs after touching, and before lifting. It is always in between the start and end frames of a footstep in Track View — Dope Sheet.

- **Lift**: Occurs at the keyframe where the leg's foot lifts off the ground, and always corresponds to the end frame of each footstep in Track View — Dope Sheet.

- **Move**: Occurs while the foot is in the air and is always in the intervals in between steps in Track View — Dope Sheet. In walking, while one foot moves, the body is supported by the other leg. In running or jumping, while a foot moves there is a period where the body is not supported, and moves in midair.

Photometry

When you use photometric lights on page 5348, 3ds Max provides physically based simulation of the propagation of light through an environment. The results are not only highly realistic renderings, but also accurate measurements of the distribution of light within the scene. The measurement of light is known as photometry. This topic introduces the quantities used for defining and measuring light.

There are several theories that describe the nature of light. For this discussion, we define light as radiant energy capable of producing a visual sensation in a human observer. When we design a lighting system, we’re interested in evaluating its effect on the human visual response system. Thus photometry was developed to measure light, taking into account the psychophysical aspects of the human eye/brain system. Four photometric quantities are used in the lighting simulation system:

- **Luminous flux**
- **Illuminance**
Luminance

Luminous intensity

Luminous flux is the quantity of light energy per unit time arriving, leaving, or going through a surface. The unit of luminous flux is the lumen (lm), which is used in both the International System (SI) of Units and in the American System (AS) of Units. If we think of light as particles (photons) moving through space, then the luminous flux of a light beam arriving at a surface is proportional to the number of particles hitting the surface during a time interval of 1 second.

Illuminance is the luminous flux incident on a surface of unit area. This quantity is useful for describing the level of illumination incident on a surface without making the measurement dependent on the size of the surface itself. The SI unit of illuminance is the lux (lx), which is equal to 1 lumen per square meter. The corresponding AS unit is the footcandle (fc), equivalent to 1 lumen per square foot.

Part of the light incident on a surface is reflected back into the environment. The light reflected off a surface in a particular direction is called luminance, the quantity that is converted to display colors to generate a realistic rendering of the scene. Luminance is measured in candelas per square meter or candelas per square inch. The candela was originally defined as the luminous intensity emitted by a single wax candle.

Finally, luminous intensity is the light energy per unit time emitted by a point source in a particular direction. The unit of measure of luminous intensity is the candela. Luminous intensity is used to describe the directional distribution of a light source, that is, to specify how the luminous intensity of a light source varies as a function of the outgoing direction.

Because 3ds Max works with these physically based photometric values, it can accurately simulate real-world lighting and materials.

Photon Map

A photon map™ is a technique to generate the indirect illumination effects of caustics on page 6700 and global illumination on page 6706 when you render with the mental ray renderer on page 6675. When it calculates indirect illumination, the mental ray renderer traces photons emitted from a light. The photon is traced through the scene, being reflected or transmitted by objects, until it strikes a diffuse surface. When it strikes a surface, the photon is stored in the photon map.
Generating photon maps is time-consuming. To improve performance, you must explicitly specify:

- Which lights emit photons for indirect illumination.
- Which objects can generate caustics or global illumination.
- Which objects can receive caustics or global illumination.

The settings for generating and receiving caustics are on the Object Properties dialog > mental ray Panel on page 300.

The photon map stores photons only for objects that can receive caustics, global illumination, or both.

To further reduce the time required to generate a photon map, photons are limited by the Trace Depth controls. These limit the number of times a photon can be reflected, refracted, or both.

In animations, another way to save time is to reuse the photon-map file. If lighting doesn’t change over the course of an animation, use the Photon Map controls on page 6785.

The mental ray renderer saves photon maps as PMAP files on page 8687. Photon map controls are on the Render Setup Dialog > Indirect Illumination panel > Caustics And Global Illumination rollout on page 6771.

**PHY Files**

You can save Physique on page 4944 data to a Physique (PHY) file. This saves data common to all objects that share a given Physique modifier.

Later, you can reload the PHY file, either to restore the data that belongs to a particular skin or portion of skin, or to transfer the Physique of one skin (or portion of it) to a different one.

**Physique**

Physique on page 4944 is a modifier that, when applied to a mesh, allows the movements of an underlying skeleton to seamlessly move the mesh like bones and muscle under a human skin. Physique will work on any point-based object, including geometric primitives, editable meshes, patch-based objects, NURBS, and FFD space warps. It will attach to any skeleton structure, including a biped on page 4487, bones, splines, or any hierarchy.
NOTE For NURBS and FFDs, physique deforms the control points (control vertices), which, in turn deform the model.

**Pivot Point**

The transform center, or pivot point, is the spot about which a rotation takes place, or to and from which a scale occurs.

---

**Pivot point sets hand to the center of the clock face.**

All objects have a pivot point. You can think of the pivot point as representing an object's local center and local coordinate system.

The pivot point of an object is used for a number of purposes:

- As the center for rotation and scaling when the Pivot Point transform center is selected.
- As the default location of a modifier center.
- As the transform origin for linked children.
As the joint location for IK.

You can display and adjust the position and orientation of an object's pivot point at any time using the Pivot functions in the Hierarchy command panel. Adjusting an object's pivot has no effect on any children linked to that object.

**Pixel**

A pixel (short for *Picture Element*) is a single point in a graphic image. Graphics monitors display pictures by dividing the screen into thousands (or millions) of pixels, arranged in rows and columns.

**Plant**

In *footstep animation* on page 8584, the state of the biped foot when it is flat on a footstep.

**Plug-Ins**

A plug-in is a feature or functionality supplied by an independent program or component. Plug-ins can be supplied by third-party vendors or independent software developers.

For example, several Video Post filter and layering plug-ins ship with 3ds Max. The open architecture provides an API (application programming interface) designed to make it easy for other companies to write plug-ins that extend the core functionality of 3ds Max.

**PMAP File**

A PMAP (.pmap) file is a mental ray *photon-map* on page 8684 file. This is a binary file that the *mental ray renderer* on page 6675 uses to generate the effects of *caustics* on page 6700 and *global illumination* on page 6706. You specify a name and location for the PMAP file on the Render Setup dialog > Indirect Illumination panel > *Caustics And Global Illumination rollout* on page 6771.
**Point**

A point in three-space, created when you use NURBS modeling to create a Point Curve or Point Surface, or when you create an individual point sub-object. Points that are part of a Point Curve or Point Surface are constrained to lie on the curve or surface.

Points behave somewhat like vertices for spline objects on page 577, but their behavior is not identical and they are a distinct object type. Helper object points on page 2853 are also a distinct object type. You can't use spline vertices or helper points as NURBS points (though you can convert a spline to a NURBS curve).

**Point Curve**

A curve defined by points. The points are constrained to lie on the curve. (Or you can think of the curve as being dependent on its point locations.) More than one NURBS solution is possible for a Point Curve; occasionally this can cause unexpected results.
Point Surface

A surface defined by points. The points are constrained to lie on the surface. (Or you can think of the surface as being dependent on its point locations.) More than one NURBS solution is possible for a Point Surface; occasionally this can cause unexpected results.

Poses

When you work with a biped on page 4487, the pose is the stance of the entire biped. You can copy and paste poses. See Copy/Paste Rollout on page 4726.

Positional Markers

In a motion-capture session, positional markers are reflective objects placed on the “actor” or “talent.” The markers enable motion-capture hardware to
record the position of various parts of the talent's body while performing motions.

**Posture**

When you work with a [biped](#) on page 4487, the posture refers to the position of selected biped parts, as opposed to the overall [pose](#) on page 8689. You can copy and paste postures. See [Copy/Paste Rollout](#) on page 4726.

**Precedence**

You control an [IK solution](#) on page 8606 by setting joint precedence to determine which joints contribute the most to the IK solution and which joints contribute the least.

Joints with high precedence values are calculated first, and, therefore, contribute more motion to the IK solution. Joints with low precedence values are calculated last, and, therefore, contribute the least motion to the IK solution.

Joints with equal precedence values are calculated by their order in the hierarchy. Joints deeper in the hierarchy (closer to the end effector) are calculated first and joints closer to the root are calculated last.

**Premultiplied Alpha**

There are two methods of storing alpha in a bitmap: premultiplied and nonpremultiplied.

To composite an image that is in nonpremultiplied format, the alpha must be multiplied by each of the R, G, and B channels before adding it to the color of the background image. This provides the correct transparency effect, but it must be done each time you composite. With premultiplied alpha, you store the R, G, and B components with the alpha already multiplied in, so compositing is more efficient.

This is not the only reason that 3ds Max stores images in the premultiplied format. When you render an image, you typically want the edges of the objects to be antialiased. This effect is achieved by determining the fractional coverage of pixels on the edge of the object, and then adjusting the alpha of the pixel.
to reflect this. For example, a pixel that is 30% covered by the object will have an alpha of 0.30.

To antialias the edges, the alpha must be premultiplied to darken these edge pixels. (This is equivalent to compositing the image over a black image). So it is natural, in a sense, for rendered images to have premultiplied alpha. If you do not premultiply the alpha of a rendered image, then just looking at the RGB you will see jaggies on the edges of objects. You would need to composite it against black using the alpha channel whenever you wanted to display it.

NOTE To control whether or not the renderer uses the environment map's alpha channel in creating the alpha for the rendered image, choose Customize > Preferences > Rendering, and then turn on Use Environment Alpha in the Background Antialiasing group.

If Use Environment Alpha is turned off (the default), the background receives an alpha value of 0 (completely transparent). If Use Environment Alpha is turned on, the alpha of the resulting image is a combination of the scene and background image's alpha channel. Also, when you render to TGA files on page 7878 with Pre-Multiplied Alpha set to off, turning on Use Environment Alpha prevents incorrect results.

TIP If you plan to composite objects in another program such as Combustion or Photoshop, render the objects against a black background. Otherwise, a fringe of environment or background color can appear around the objects.

Procedural Maps

Unlike a bitmap, which is an image produced by a fixed matrix of colored pixels like a mosaic, a procedural map is generated by a mathematical algorithm. Consequently, the types of controls you might find for a procedural map will vary depending on the capabilities of the procedure.
Three procedural maps (bricks, Perlin marble, and splat), with variations
A procedural map can be generated in two dimensions, or in three. For example, Wood has a grain that goes through the assigned geometry. If you cut away part of an object with wood assigned as its texture, the grain in the cutaway portion matches the grain on the object’s exterior: it is all generated by the same procedure.

**Projector Light**

By adding a map to a light, you turn it into a projector. You can assign a single image, or you can assign an animation to create the effect of either a slide projector or a movie projector.

![Shadows created by projecting image of palm trees](image)

You can also use projector maps to project black and white bitmaps to simulate shadows seen through leaves or window frames, in the same way that gobos are used in theater lighting.

You’re not limited to circular projectors. Since you’re usually projecting a rectangular image, you can use a rectangular light to project it. You can use
the Bitmap Fit option to adjust the aspect ratio of the light beam to match that of the projected image.

When you use projection lights, it's often helpful to adjust their roll angle. You can do this with the navigation controls or with the roll angle manipulator on page 5430.

**ProMaterials Library for mental ray**

The ProMaterials™ library contains mental ray ProMaterials on page 5772 based on manufacturing-supplied data and professional images. This includes building and design materials such as professional wall paint with glossy or matte finishes, solid glass, and concrete. The library actually contains multiple library (MAT) files. When you use the Material/Map Browser to browse libraries, you see names such as `autodesk.max.promaterials.ceramic.mat`, `autodesk.max.promaterials.concrete.mat`, and so on.

**Prop Bone**

The CSM marker file format on page 8543 supports a prop bone in either or both hands. There are six additional markers for the top, bottom, and middle of the two props. If these tracks are detected, character studio creates a 3ds Max dummy object.

The length of the prop is the average distance between the top and bottom prop marker during animation. The prop will be oriented in the plane of the three prop markers, and its origin will be at the bottom prop marker.

**Quadtree**

A quadtree is a data structure used to calculate ray-traced shadows on page 8696. The quadtree represents the scene from the point of view of the light. The root node of the quadtree lists all objects that are visible in that view. If too many objects are visible, the node generates four other nodes, each representing a quarter of the view, each with a list of objects in that portion. This process continues adaptively, until each node has only a small number of objects, or the quadtree’s depth limit (which can be set for each light) is reached.
Each shadow-casting light ray needs to test intersection with the objects in only one of the leaf nodes of the quadtree. This helps speed up the ray-tracing process. In general, increasing the maximum quadtree depth can speed up ray-tracing at a cost of memory.

The maximum size of a quadtree is the square of two to the power of the maximum quadtree depth. At a depth of 7, the largest quadtree has 128 x 128 leaf nodes; at a depth of 10, the largest quadtree has a size of 1028 x 1028 leaf nodes, and so on. (On the other hand, because each successive node contains fewer objects, the size of a node's record decreases the deeper it is in the tree.)

**NOTE** An omni light can generate up to ten quadtrees, so omni lights that cast ray-traced shadows use more memory at render time than spotlights do.

---

**Queue Monitor**

The Queue Monitor is a standalone network-administration tool that provides a user interface to monitor and control network rendering.

The Queue Monitor can connect to any computer to which you have network access with the appropriate security permissions, and a Network Manager running on it. You can install the Queue Monitor separately. It will function correctly on any Intel-based computer running Windows NT with appropriate TCP/IP networking services, including over the Internet. In other words, you can monitor and control network rendering services from any computer connected to the Internet, in addition to using the Internet as a wide-area backbone for a network rendering farm.

**Radiosity**

A technique to calculate indirect light to illuminate a scene. Radiosity calculates the interreflections of diffuse light among all the surfaces in your scene. The result is the *radiosity solution* on page 8695. See Modeling Global Illumination with Radiosity on page 6615.

**Radiosity Solution**

The calculation of the *radiosity* on page 8695 effect in a scene. You compute the radiosity solution as a separate step from rendering. Once the solution is
computed, it can be used for multiple renderings. See Modeling Global Illumination with Radiosity on page 6615.

Ray-Trace Acceleration (mental ray Renderer)

The mental ray renderer on page 6675 provides two different methods of accelerating the process of ray tracing. The methods are:

- BSP (Binary Space Partitioning). This method performs best for most purposes.
- BSP2. This method can perform better with large scenes and situations with limited memory.

You set the raytrace acceleration method on the Render Setup Dialog > Renderer panel > Rendering Algorithms rollout on page 6741.

Ray-Traced Shadows

Ray-traced shadows are generated by tracing the path of rays sampled from a light source. Ray-traced shadows are more accurate than shadow-mapped shadows on page 8719. They always produce a hard edge.

Example of ray-traced shadows

Ray-traced shadows are more realistic for transparent and translucent objects. Also, only ray-tracing can generate shadows for wireframe objects.
Because ray-traced shadows are calculated without a map, you don’t have to adjust resolution as you do for shadow-mapped shadows. The parameters for ray-traced shadows adjust the shadow’s position (known as shadow bias on page 8718) and the depth of the quadtree on page 8694 used to calculate ray tracing.

Advanced ray-traced shadows are the same as ray-traced shadows, however they provide antialiasing on page 8501 control, letting you fine-tune how ray-traced shadows are generated.

**RAYHOSTS File**

The RAYHOSTS file is a text (ASCII) file that lists the name of host systems capable of mental ray rendering on page 6675 in a distributed network. You turn on distributed rendering on the Render Setup dialog > Processing panel > Distributed Bucket Rendering rollout on page 6797.

Each line in the RAYHOSTS file contains the name of a host system. The host name can be followed by a semicolon and a port number of the service to connect to. The host name with or without the port number can also be followed by white space and a list of mental ray command-line parameters.

See the manual, Rendering with mental ray, for descriptions of the mental ray command-line options.

When you click Add on the Distributed Bucket Rendering rollout and use the Add/Edit DBR Hosts dialog on page 6805 to add a host or satellite processor, this updates the RAYHOSTS file. So does clicking Remove to remove a processor.

The RAYHOSTS file is named max.rayhosts. By default, it is located in the \mentalray directory inside 3ds Max folder. You can change the default location by creating an environment variable named MAX<X>_MI_ROOT, where <X> is the 3ds Max version number, and setting the variable’s value to the path of the max.rayhosts file you want to use.

**Real Time**

By default, viewport animations play in real time, skipping frames where necessary.

You can turn this off by clicking Time Configuration in the time controls, and then turning off Real Time in the Playback group box of the Time Configuration dialog on page 8106.
When Real Time is turned off, all frames are displayed during playback. The playback may appear slow, but you'll know that you're seeing every frame. You can also speed viewport animation by minimizing your viewports to quarter size.

**Recognize Scene-Loading Technology**

Recognize™ is an FBX-based scene-loading feature used for importing geometry, lights, materials and cameras from Revit 2009. This feature includes the numerous settings on the FBX Importer (and Exporter) dialog. Refer to the FBX Plug-in Help for complete details.

**Red, Green, Blue / Hue, Saturation, Value**

There are two sets of color sliders in the Color Selector on page 371: the red/green/blue (RGB) set and the hue/saturation/value (HSV) set. You can use either set or both to mix a particular color. As you adjust the color sliders, their RGB and HSV numeric values appear in the spinners.

There are separate RGB and HSV spinners as light parameters on page 5314.

**RGB Sliders**

Each of the RGB sliders is a band of red, green, or blue (the primary light colors) shaded from black to the full intensity of the color. When you move any slider, it mixes with the values of the other two, and the result appears in the swatch beneath the sliders.
For example, if you move the Red slider all the way to the right (value 255) and leave the other two at the left (0), the active swatch turns red. If you then move the Green slider all the way to the right, the swatch turns yellow. If you move all three sliders to 0, the result is black; if all three are at 255, the result is white; and all three at any point of equal value produce shades of gray.

**HSV Sliders**

If you prefer the hue/saturation/value color system, you can use the HSV sliders to mix color. First move the Hue slider to the color band you want (if the Value and Saturation sliders are set to low values, you don't see an immediate result in the swatch). Move the Value slider to set the brightness, or intensity of the color. Move the Saturation slider to determine the purity of the color. The higher the saturation, the less gray the color.

**Reference**

References are like "one-way" instances. Referenced objects are based on the original object, as are instances, and can have their own unique modifiers. Any modification made to the original object is passed on to its references, but any modification made to a reference is not passed back to the original. The one-way effect is useful, since you can maintain an original that will affect all its references, while the references themselves can take on individual characteristics.

If you are modeling heads, for example, you might want to keep a family resemblance in your characters. You could model basic features on the original, then model specifics on each reference.
In the modifier stack, a solid line separates the reference from its parent object, so you can see that the effect of modifiers on the reference will not affect the parent object or other references to it.

**Reference Object**

In *Particle Flow* on page 2997, a reference object is a geometry object or collection of objects used as particles by the *Shape Instance operator* on page 3142. It can be a single object, a group, a hierarchy, or even a compound object consisting of several elements.

**Refine**

In NURBS modeling, refining means to increase the number of CVs on a curve or surface. Refining does not change the curvature of the curve or surface.

**Reinitialize**

In *Physique* on page 4944, when you need to reset vertex, envelope, and other skin parameters, click Reinitialize to display the *Physique Initialization dialog* on page 5026. Using controls in this dialog, you select which category to update, and apply the new global settings you specify.

For example, if you've added a new bone to the hierarchy and want it included and influenced by the Physique modifier, you'd use reinitialization. Or maybe you've repositioned the biped structure relative to the mesh, or scaled both; you'd need to reinitialize Physique settings to recognize those changes.

**Repel Behavior**

In *crowd animation* on page 5104, the Repel behavior lets you specify any object or objects (sources) that will force delegates to move away from them. This is basically the opposite of the Seek behavior. If you want delegates to back away from an object, as opposed to turning to face the direction they're moving, use Repel in conjunction with the Orientation behavior.
Reservoir

The Reservoir is a storage area for clips (BIP files on page 8520) used by the Motion Mixer on page 8647. The Reservoir contains a single entry for each clip adaptation on page 8498 used in the Mixer. You can use the Reservoir to load previously used clips, save adaptations to new BIP files, or view a clip's adaptation data. See Using the Reservoir on page 4047.

The purpose of the Reservoir is to save memory. Instead of storing the animation and adaptation data for each clip inside the clip, it is stored in the Reservoir. When a clip is used more than once in the Mixer, the clip occurrences can share the data from the Reservoir, saving memory.

Resolution

The horizontal and vertical number of pixels in a 2D image. For example, a 640x480 resolution describes an image that is 640 pixels across by 480 pixels down. Resolution can also refer to an image's bit depth, such as 24-bit or 32-bit.

You set the resolution of the image you are going to render on the Render Setup dialog on page 6506.

Reveal Rendering

Reveal™ is used to perform iterative rendering by isolating regions, selections or calculations to improve rendering speed while working on specific elements to complete a final image. Access the Reveal feature set in the Render Setup Dialog on page 6506, directly in the Rendered Frame Window and the Viewport.

Review

Review is a previewing feature that can be used to view multiple maps simultaneously in the Viewport. You can preview photometric lights (including IES files) to see how real luminaries will affect the environment and real-time shadowing of objects that use Arch&Design materials. Access the Review feature from the right-click menu in the viewports.
Rotoscoping

Rotoscoping is the process of bringing video frames into a scene to use as the background for matching objects.

The boat is a 3ds Max object composited over a video of a breaking wave.

The way to use rotoscoping is to specify a digital disk recorder or movie file and read the frames into the viewport using the Animation Synchronization controls in the Viewport Background dialog. Once you've specified your source device or file in the Viewport Background dialog, one frame of the video displays for each scene frame by default. Remember to turn on Animate Background as well as Show Background to have your video frames appear in sequence in the viewport.

To produce the composited, rendered image, use Video Post or a compositing application to composite the background image and the rendered scene together.

Rubber-Band Mode

When you work with a biped on page 4487, Rubber-Band mode provides a way to proportion the arm and leg links simultaneously, by moving the link with the Move transform, instead of using scale. Rubber-Band mode scales both the link and its child in a single step.

This is particularly useful when fitting a biped to a skin prior to applying the Physique modifier on page 4944. For example, rubber-banding the upper arm rescales the upper and lower arm objects and moves the elbow link without affecting the position of the shoulder or the wrist. If you've spent a lot of time getting the fingers in the right place, you can reposition the elbow by rubber-banding, without affecting the hands.
RVT Link

When working on Revit projects, you can import/link DWG, DXF, DGN, RVT and image files. These files can contain 2D and 3D geometry to help in the construction of your projects. Raster images can be imported as background images into your Autodesk Revit project or as visual aids needed during the creation of a model.

When you’ve exported the project to a DWG file, RVT links are comparable to xrefs in an AutoCAD drawing.

For more information about the Import/Link features of Revit, refer to the Autodesk Revit Help file.

Safe Frame

The Safe Frame provides a guide to help avoid rendering portions of your image that might be blocked in the final output.

Safe frame borders show which portions of a viewport will be visible when rendered to video.

For example, to ensure that no unintentional black areas are visible on a television screen, broadcasters intentionally "overscan" the video image. The result is that portions of an image around the edges are not visible on a typical
set. In addition, portions of images on 35mm slides can be partially covered by the slide mounts.

You can adjust the size of the safe frame as a percentage of the outer display rectangle with the Safe-Frame controls on the Viewport Configuration dialog. Depending upon its size, the safe frame can be used as the equivalent of a "title safe frame" (the area inside which it is safe to display titles), or an "action safe frame" (the area inside which action may occur without significant loss of information).

To view the frames, choose Show Safe Frames from the Point-Of-View (POV) viewport label menu on page 8122. Three rectangles, one yellow, one green, and one pale blue, appear in the camera viewport. The outer, yellow video rectangle shows the area and aspect ratio of your current display. The middle, green rectangle represents the action safe zone. The inner, pale blue rectangle shows the title safe zone.

To turn off the display, choose Show Safe Frames again.

See also:

■ Safe Frames on page 8380

Sample Range

Sample Range affects the softness of the edge of shadow-mapped shadows on page 8719. The sample range determines how much area within the shadow is averaged.

Low sample range can cause jagged-edged shadows.
Higher sample range causes soft-edged shadows.

Small values reduce the area that is averaged, effectively bringing the edge of the shadow inward, producing sharper-edged shadows. Sharper edges can cause aliasing.

Large values extend the area that is averaged, effectively bringing the edge of the shadow outward, producing softer-edged shadows. Soft-edged shadows have more antialiasing. The effect is somewhat like the falloff of a soft-edged spotlight.

The default Sample Range value is 4. The Sample Range value can be any floating-point number from 0 to 20. Values of 2 to 5 are recommended. Values below 3 can produce coarse-edged shadows. You can reduce this effect by increasing the map size.

Values greater than 5 can produce streaking and moiré patterns. You can reduce this effect by increasing the map size or the Bias value.

Rendering time increases exponentially as the Sample Range value increases.

**Sampling (mental ray Renderer)**

Sampling is an antialiasing technique. It provides a "best guess" color for each rendered pixel. The mental ray renderer on page 6675 first samples the scene color at locations within the pixel or along the pixel's edge, then uses a filter to combine the samples into a single pixel color.
(In 3ds Max, this technique is called "supersampling." Because the mental ray renderer performs sampling on a scene basis, in the Material Editor, you don't need to turn on supersampling for materials rendered using mental ray.)

Scene rendered with low sampling is jagged and inaccurate.
Sampling range: 1/64 to 1/4
Same scene rendered with higher sampling shows smooth edges.

Sampling range: 1 to 16

The mental ray renderer provides five filter methods: Box, Gauss, Triangle, Mitchell, or Lanczos. Box, the default, is also the quickest. Mitchell is often the most accurate. The Box filter combines samples evenly, without weighting them. Each of the other filters uses a particular curve to weight samples before combining them.

Curves used to weight samples (these are approximate)

You choose the sampling filter and set other sampling options on the Render Setup dialog > Renderer panel > Sampling Quality rollout on page 6735.
NOTE Area lights (Area Omni Light on page 5418 and Area Spot Light on page 5421) have their own sampling controls. These affect only shadows cast by the area light. They are independent of the sampling used to render the scene as a whole.

Rendering the Sampling Rate

To help you choose a sampling filter, you can render a scene with diagnostics enabled and Sampling Rate chosen on the Render Setup dialog > Processing panel > Diagnostics rollout on page 6795. The Sampling Rate diagnostic tool gives a schematic rendering that shows how the sampling method behaves with your scene.

The intensity of each pixel indicates the number of samples collected within it and on its lower and left edges. The brighter the pixel, the greater the number of samples. Overall, the View Sample rendering is normalized so the brightest pixels have the maximum number of samples. Also, red boundaries indicate the boundaries of sampling tasks.
Lock Samples and Animation

By default, the mental ray renderer introduces a pseudo-random (quasi Monte Carlo) variation in the sampling pattern from frame to frame. This reduces rendering artifacts in animations.

You can turn off the sampling variation by turning on Lock Samples on the mental ray: Sampling Quality rollout on page 6735.

Jittering

"Jitters" samples by introducing a variation into sample locations. Turning on Jitter can help reduce aliasing. Default=off.

The Jitter control is also on the Sampling Quality rollout on page 6735.

Scale Stride

In footstep animation on page 8584, the Scale parameter lets you change the length or width of a footstep selection (or both at once). This setting is on the Footstep Operations rollout on page 4778.

The selected footsteps are scaled around the first footstep in the selection.

Scanline Renderer

The scanline renderer on page 6589 is the default renderer. By default, you use the scanline renderer when you render a scene from the Render Setup dialog on page 6506 or from Video Post. The Material Editor also uses the scanline renderer to display materials and maps.

The image produced by the scanline renderer displays in the rendered frame window on page 6513, a separate window with its own controls.

As the name implies, the scanline renderer renders the scene as a series of horizontal lines. 3ds Max additionally provides the interactive viewport renderer to provide a quick and simple rendered view of your scene as you work on it. You might also have other plug-in or third-party renderers that you’ve installed to work with 3ds Max.
**Scene Extents**

Just as an object's extents on page 8567 are its maximum dimensions in X, Y, and Z, the extents of a scene are its maximum dimensions in these three axes, and define a box that encloses the entire scene.

**Scene Motion Blur**

Motion blur can enhance the realism of a rendered animation by simulating the way a real-world camera works. A camera has a shutter speed, and if significant movement occurs during the time the shutter is open, the image on film is blurred.
Above: Scene motion blur creates an effect of movement. (The background is blurred because of slow camera panning.)

Below: The same scene with no blurring

3ds Max provides several ways to generate motion blur. Scene motion blur is one. Image motion blur is another. For most purposes, image motion blur on page 8606 or multi-pass motion blur on page 5594 give better results than scene motion blur. Use scene motion blur whenever you want to strongly emphasize rapid motion. You can use both image and scene motion blur in the same rendering.

(Another option, object motion blur on page 8658, is not meant to simulate a camera, but to improve the rendered appearance of fast-moving objects.)
You apply scene motion blur in Video Post on page 7247. It is one of the options for a Scene Event on page 7282. In the Add or Edit Scene Event dialog, turn on Scene Motion Blur in the Scene Options group, and then adjust the parameters.

Scene motion blur creates trails behind all moving objects by rendering the entire scene at multiple time increments within each frame, and then creating the frame by compositing the multiple images together.

**Schematic View**

Schematic View on page 7926 is a window that lets you see everything in your scene as a node on a graph. The nodes on page 8653 are repositionable to create custom configurations.

Use Schematic View to see and select all nodes that share a relationship, such as a material or instanced modifier. You can perform basic operations on the nodes such as rename, cut and paste modifiers or materials, or create hierarchical linkages. You can use Schematic View to see and edit other relationships such as wired parameters and constraints.

**Script**

A sequence of instructions used to automate a task. Scripts are typically text files containing coded instructions for a particular application.

In 3ds Max, the MAXScript utility supports a scripting language.

MAXScript scripts have the file name extension `.ms`. By default, they are saved in the `scripts` folder.

**Script Editor Window**

A text editing window provided with the MAXScript scripting system. A script editor window can edit any kind of ASCII text file, but is particularly suited to building and modifying MAXScript script files.

You open a script editor using the Open Script or New Script commands from the MAXScript menu.
Scripted Behavior

A behavior defined by MAXScript. When you use the cognitive controller on page 5199 with crowd animation on page 5104, you can add conditional expressions written in MAXScript that impose changes in behavior.

Scripted Utility Panel

A scripted utility panel is a custom command-panel rollout created using the MAXScript scripting language. They let you create a graphical user interface to a MAXScript script.

Scripted utility panels are available through the Utilities drop-down menu in the MAXScript rollout of the Utilities panel.

Scripts (Motion Flow)

In motion flow mode on page 4848, a script is a list of clips (BIP files) that are executed sequentially to animate a character. You can create scripts either manually or automatically using crowd animation on page 5104.

Scripting

A scripting language is a programming language embedded in a host application, and used to automate tasks within the application. 3ds Max provides MAXScript as its scripting language.

MAXScript controls are located on the Utilities panel.

Seed Value

In NURBS sub-objects, a location in parameter space that is used to resolve ambiguities in some kinds of sub-object creation. The seed value is a location on a parent object, and the location nearest to the seed value that satisfies the creation condition is the one that 3ds Max chooses. For a curve, the seed value is a U location in the curve's parameter space. For a surface, the seed location is a pair of UV coordinates in the surface's parameter space.
Seek Behavior

In crowd animation on page 5104, the Seek behavior lets you specify any object or objects as a stationary or moving target for delegates. Delegates move toward the target during the crowd simulation while turning as necessary.

Segment

The portion of a NURBS point curve between two of its control points, or the portion of a spline between two vertices. (NURBS CV curves don't have segments, as their control vertices don't lie on the curve.)

Self-Illumination

Self-Illumination creates the illusion of incandescence by replacing any shadows on the surface with the diffuse color. At 100 percent, the shadows
are completely replaced by the diffuse color, creating the illusion of self-illumination.

The lamp on the right uses self-illumination to brighten the bulb and the glass panes.

Unless you use environmental effects or global illumination, lights only illuminate your scene: they don't appear in the rendering. You can use self-illuminated materials on objects that represent lights to provide things like car headlights, and so on.

A self-illumination map lets you use a map to affect the intensity in different areas of the self-illuminated surface. Like many other map types, only the intensity of the map values affects self-illumination. White provides the most, while black blocks the illumination completely.

It's often a good idea to design a self-illumination map to match your diffuse map. For example, the diffuse map might have small, yellow rectangles to represent windows, while the self-illumination map consists of matching white rectangles against black to illuminate the yellow windows.
To have an object behave as an actual light source (for example, a spline that models a neon light), use the scanline renderer on page 6589, photometric lights on page 5348 with a radiosity solution on page 6615, and assign an Advanced Lighting Override material on page 6166 to make the object luminous.

Shaders (mental ray Renderer)

In mental ray, a shader is a function that calculates light effects. There can be shaders for lights, cameras (lens shaders), materials, shadows, and so on.

In 3ds Max, the mental ray translator provides the functionality of light and camera shaders. Material shaders correspond to 3ds Max materials.

A number of shaders are provided with 3ds Max. See mental ray Shaders on page 6385, mental ray Connection Rollout on page 5763, and mental ray Materials on page 5772.

The mental ray manual, Programming mental ray, describes how to write custom shaders.

Shaders (Standard Materials)

For a standard material on page 5962, the shader is the algorithm that controls how the material responds to light. Shaders especially control how highlights appear. They also provide a material's color components, and control its opacity, self-illumination, and other settings. Shaders are often named for their inventors; they can also be named for the effect they provide. See Shading Type on page 5960.
Samples of different shading for a standard material
1. Anisotropic
2. Blinn
3. Metal
4. Multi-layer
5. Oren-Nayar-Blinn
6. Phong
7. Strauss
8. Translucent

For each material, one of the available shaders is always active. You choose the shader on the material’s Shader Basic Parameters rollout on page 5969.
The raytrace material on page 6064 uses a subset of the standard material shaders: Anisotropic, Blinn, Metal, Oren-Nayar-Blinn, and Phong. You choose the raytrace material's shader on the material's Raytrace Basic Parameters rollout on page 6065.

The other types of materials in 3ds Max don't give you a choice of shader.

Materials (and lights and cameras) used with the mental ray renderer on page 6675 can use mental ray shaders, which are not the same as the standard material shaders. See Shaders (mental ray Renderer) on page 8716.

**Shadow Bias**

Map bias moves the shadow toward or away from the shadow-casting object (or objects).

On the right, increased map bias makes the dog appear to float.

For ray-traced shadows on page 8696, the control is labeled Ray Bias; for shadow-mapped shadows on page 8719, it is labeled simply Bias.

By default, this value is 1.0 world coordinate unit. Increasing the bias moves the shadow away from the object, and decreasing the bias moves the shadow closer to the object. The Map Bias value can be any positive floating-point number.

For example, if a shadow-casting object intersects another object but its shadow doesn't meet properly at the intersection, the bias is too high. This effect varies with the angle of the spotlight to the object. Extremely shallow spotlight angles usually require higher bias values.

Another purpose of bias is to avoid problems with objects that cast shadows onto themselves. If you see streaks or moiré patterns on the surface of the object, the bias value is too low. If you increase the bias so much that the
shadow becomes disconnected from the object, reduce the bias (and for shadow-mapped shadows, also increase the shadow map Size value).

Shadow Map

A shadow map is a bitmap that the renderer generates during a pre-rendering pass of the scene. Shadow maps don't show the color cast by transparent or translucent objects. On the other hand, shadow maps can have soft-edged shadows, which ray-traced shadows cannot.

Example of shadow-mapped shadows

A shadow-map is projected from the direction of the light. This method provides a softer edge and can require less calculation time than ray-traced shadows, but it's less accurate.

Each light object has its own shadow-map settings. You can adjust these settings to achieve a sharper shadow. This involves changing the resolution and the pixel sampling of the shadow's bitmap. Because shadow-map shadows are only bitmaps, you need to keep in mind their resolution in relation to your distance from the shadow, and the detail required by the shadow. If the resolution is too low, and the camera too close, the shadow might look more like sooty smudges.

If shadows appear too coarse when you render them, increase the map size. The size can range from 0 to 10,000. However, be aware that greater size requires more memory and can take longer to generate. A 4096-line shadow map occupies 64 MB of memory (4096 x 4096 x 4).
If you have enough RAM to hold the entire scene including shadow maps, shadows don’t affect performance, but if the renderer has to use a virtual memory swap file, rendering time can slow considerably.

The default shadow map size is 512.

For a spotlight, the bitmap used by shadow maps must fill the area covered by the falloff of the light. The wider the falloff, the coarser the shadow appears. Keep the falloff as tight as possible given the requirements of your scene.

The mental ray renderer saves shadow maps as ZT files on page 8771. In addition to the settings for individual lights, the mental ray renderer includes shadow map controls on the Render Setup dialog > Renderer panel > Shadows & Displacement rollout on page 6756.

**Shapes and Splines**

A shape is an object made up of one or more splines. A spline is a collection of vertices and connecting segments that form a line or curve. By adjusting values in the vertices, you can make portions of the line curved or straight.
Shapes don't usually appear in the rendered scene. They're used for the following purposes:

■ As the foundation for extruded objects, by applying an Extrude modifier to the shape.

■ As the foundation for a spun object, by applying a Lathe modifier to a shape.

■ As the components that make up a Loft object, by combining a shape as a path, and one or more shapes as cross-sections along the path.

■ As an animation path for an object by assigning a path constraint to the object, and then picking a shape as the path.

■ As one method of linkage for inverse kinematic chains.

You can make shapes renderable to create tubular forms in the rendering. Renderable shapes don't appear any different in viewports.

Shapes can also be NURBS curves on page 2416. You can use NURBS curves in exactly the way you use spline-based shapes. You can also use a NURBS curve as the basis for a NURBS model that includes multiple curve and surface sub-objects.
Get Shape (Lofting)

A circle is lofted along a path to construct a tubular shape. Get Shape chooses the contour spline.

You use Get Shape as a loft creation method when you want the shape to move to the location of the selected path. For example, you use this method if you have created a path at the exact location where you want your loft object to be. You use Get Shape to create a loft at that location.

Get Shape causes the shape to move and rotate to align itself with the current level of the path. The exact orientation of the shape is controlled by two other loft settings named Contour and Banking.

The following describes the orientation of the first shape at level 0:

- The pivot point of the shape is located on the path at the current path level.
- The positive Z axis of the shape is aligned with the tangent to the path at the current path level.
- The local Y axis of the shape is aligned with the local Z axis of the path.
Sometimes, aligning the positive Z axis of the shape with tangent of the path does not produce the result you want. You can flip the orientation of the shape by pressing Ctrl while getting the shape. Pressing Ctrl aligns the shape so that the negative Z axis of the shape is aligned with the tangent to the path.

**SHP Files**

SHP is the 3D Studio R4 (DOS) shape-file format. You can import these files into 3ds Max.

The `.shp` file contains polygons created in the 2D Shaper in 3D Studio.

When importing an SHP file that contains multiple shapes, 3ds Max gives you the option to either merge them all into one object or make multiple incoming objects.

The shape importer looks at the vectors on incoming splines, and if they're collinear within a couple of percentage points, it changes the angle to a smoothed Bezier (otherwise, it's a Bezier corner).

**Skylight**

In the real world, daylight does not just come from direct sunlight; it also comes from skylight that is scattered through the atmosphere. 3ds Max offers great realism and accuracy by calculating not only sunlight, but calculating this scattered light as well.

In 3ds Max, the sky is modeled as a dome of infinite radius placed around the scene. Daylight computes the illumination of a point in the scene with reference to all directions around the point where the sky is visible. The sky brightness is not constant over the sky dome, but rather it changes depending upon the position of the sun.

**See also:**

- **Sunlight** on page 8734
- **Sunlight and Daylight Systems** on page 5491
Sliding Footstep

In footstep animation on page 8584, changing biped foot key parameters enables the biped feet to move or slide during a footstep period. This feature is also available for motion-capture file import to allow the biped feet to slide or pivot. In the viewports, a sliding footstep is displayed as a footstep with a line through the middle.

Smoothing Groups

Smoothing groups define whether a surface is rendered with sharp edges or smooth surfaces.

![Smoothing Groups Diagram]

Left: The bottle has no smoothing.
Middle: Smoothing is assigned only to the highlighted group of faces.
Right: The bottle is smoothed using three different smoothing groups: on the body, the neck, and the top edge.

Smoothing groups are numbers assigned to the faces or patches of an object. Each face or patch can carry any number of smoothing groups up to the
maximum of 32. If two faces or patches share an edge and share the same
smoothing group, they will render as a smooth surface. If they don’t share the
same smoothing group, the edge between them will render as a corner.

You can manually change or animate the threshold values for smoothing
group assignments using such tools as Editable Poly (Polygon/Element) editable
polygon/element on page 2296 and the Edit Mesh modifier on page 1321.

**SMPTE**

SMPTE (Society of Motion Picture and Television Engineers) is the standard
time display format for most professional animation work.

From left to right, the SMPTE format displays minutes, seconds, and frames,
delineated by colons. For example: 2:16:14

represents 2 minutes, 16 seconds, and 14 frames.

As you move through time in a SMPTE display, when the seconds field
increments, the frames field recycles to 0 and starts over. For example, given
an NTSC frame rate of 30 frames per second, as you move through time, the
frames field counts from 0 to 29, at which point the seconds field increments
by 1, and the frames field begins again at 0.

As with the Frames display format, the SMPTE format lets the time slider move
at single-frame increments.

**Source Container**

A Source Container is a type of Container on page 8536 that you inherit from
someone else. If the author has provided edit permission, you can open the
Container and make changes to its contents. When saved, your changes
become part of Source again.

The author may prohibit edits to the Source Container to prevent others from
modifying its content. Source Containers with no edit permission remain in
a closed state.
Space Warp Behavior

In crowd animation on page 5104, the Space Warp behavior lets you assign a space warp, such as Wind or Gravity, to one or more delegates. The Space Warp behavior can use any space warp in the Forces category. These space warps treat delegates on page 8549 as if they were particles.

You can also use the Space Warp behavior to bind delegates to the Vector Field space warp on page 5258 provided with character studio. This space warp causes delegates to avoid an object while following its contours.
Space Warps

Space warps on page 2887 are objects that provide a variety of "force field" effects on other objects in the scene.

Space warps themselves are not renderable. You use them to affect the appearance of other objects, sometimes a large number of objects at the same time. Some space warps deform object geometry by generating ripples, waves, or explosions. Other space warps are meant specifically for use with particle systems, and simulate natural effects such as wind blowing snow or rain about, or a rock in the path of a waterfall.

Space warps behave somewhat like modifiers, except that a space warp influences world space, rather than object space as geometric modifiers do.

When you create a space warp object, viewports show a representation of it. You can transform the space warp as you do other 3ds Max objects. The position, rotation, and scale of the space warp affect its operation.

To have an object or selection set be affected by a space warp, you bind the object to the space warp. A space warp has no effect on objects unless the objects are bound to it. When an object is bound to a space warp, the warp binding appears at the top of the object's modifier stack. A space warp is always applied after any transforms or modifiers.

When you bind a space warp to multiple objects, the space warp's set of parameters affects all the objects equally. However, each object's distance from the space warp or spatial orientation to the warp can change the warp's effect. Because of this spatial effect, simply moving an object through warped space can change the warp's effect.

You can also use multiple space warps on a single object or objects. Multiple space warps appear in an object's stack in the order you apply them.

Spawn Particles

In Particle Flow on page 2997, spawn particles are new particles that are generated from existing particles (parent particles on page 8676) in a process called spawning. You can use the Spawn test on page 3281 to create spawn particles arbitrarily, or the Collision Spawn test on page 3241 to create spawn particles as the result of physical interaction between a parent particle and a deflector.
Specular Color

Specular color is the color of highlights on a shiny surface. The highlights are reflections of the lights that illuminate the surface. For a naturalistic effect, set the specular color to the same color as the key light source, or make it a high-value, low-saturation version of the diffuse color.

![Image of spacecraft with different specular colors]

Changing specular color tints highlights on the shiny surface of the spacecraft.

In 3ds Max, you can set the specular color to match the diffuse color. This gives a matte effect, making the material appear less shiny.

![Image of spacecraft with specular color matched to diffuse color]

Matching specular color to the diffuse color makes the surface less shiny.

Speed Vary Behavior

In crowd animation on page 5104, the Speed Vary behavior is useful for objects whose velocity changes as they move, such as strolling tourists who might occasionally slow down to do some sightseeing.
Splice

The term *splice* means to cut a sequence, insert a segment and join the cut ends to the segment. It can also mean a simple joining of ends to a segment.

In character studio, you can splice a footstep sequence. You do this by copying a footstep sequence, then moving it to the middle or end of another footstep sequence and placing it there. The ends of the segments are joined automatically to make a smooth footstep sequence.

You can use splicing to extend your footstep animation or build a cyclic sequence.

Spline

A type of curve that is interpolated between two endpoints and two or more tangent vectors. The term dates from 1756, and derives from a thin wood or metal strip used for drafting curves in architecture and ship design.

Top: Spline
Middle: A segment of the spline
Spline Dynamics

Spline Dynamics is a biped dynamics on page 8521 option located on the Dynamics & Adaptation rollout on page 4755. Choosing Spline Dynamics creates keys for the biped’s center of mass without calculating gravity or balance (Dynamics Blend=0.0 and Balance Factor=0.0).

Startup Script

When 3ds Max first starts, MAXScript searches for any startup script files, which it then automatically loads and runs. This feature is useful if you have function libraries you always use and want preloaded, or if you want to establish custom UI settings, define scripted plug-ins, or load scripted utility rollouts.

MAXScript first searches for .mcr (macroScript definition files) in the ui\macroscripts directory. These macroScript definitions are not compiled at this time; rather they are just scanned to identify the macroScripts that have been defined.

MAXScript next searches for .ms, .mse, and .mzp files in the plug-in path directories (defined on the Configure System Paths dialog on page 8293 and Configure User Paths dialog on page 8284) and their subdirectories, and compiles these files. The base scene and user interface have not been created at this point, so no viewport or scene commands should be executed in these files. These files should primarily define scripted plug-ins and utility functions.

Any utility functions used by the macroScripts defined when reading the ui\macroscripts directory should be defined in a .ms or .mse file in one of these directories. You can prevent a nested directory from being scanned by placing its name in parentheses, for example "(old-versions)", allowing you to enable and disable scripts in handy directory-based groupings.

At this point, 3ds Max creates the base scene and user interface. Any macro scripts used by buttons in the user interface are compiled at this time.

The automatic loading of the following startup script files can be deactivated by turning off the Auto Start MAXScript option in the MAXScript page of the Preferences dialog, as described in MAXScript Preferences on page 8358.
MAXScript first searches for a file named `startup.ms` in the following directories, in this order:

1. The Scripts directory (defined on the Configure User Paths dialog > File I/O panel)
2. The Startup Scripts directory (defined on the Configure System Paths dialog)
3. The 3ds Max executable main directory
4. The Windows NT 32-bit system directory (`system32`)
5. The Windows 16-bit system directory (`system`)
6. The `Windows` directory
7. The directories that are listed in the PATH environment variable

MAXScript stops searching when it finds the first occurrence of `startup.ms`. MAXScript then recursively scans the Startup Scripts directory (defined on the Configure System Paths dialog) and any nested directories for `.ms`, `.mse`, and `.mzp` script files and loads them. In this pass, any script files with the name `startup.ms` are ignored. You can prevent a nested directory from being scanned by placing its name in parentheses, for example `"(old-versions)"`, allowing you to enable and disable scripts in handy directory-based groupings.

If you specify a script to run in the command line (`-U MAXScript script_name`), the script is executed at this point. (See the MAXScript Help topic “Running Scripts from the Command Line”).

**SteeringWheels Navigation**

The SteeringWheels® on page 93 3D navigation controls are tracking menus that are divided into different sections known as wedges. Each wedge on a wheel represents a single navigation tool. You can pan, zoom, or manipulate the current view of a model in different ways.

SteeringWheels, also known as wheels, combine many of the common navigation tools into a single interface. Wheels are specific to the context that a model is being viewed in. The SteeringWheels feature is on by default.
Sub-Object

A sub-object is a subset of an object's geometry. Many objects have various types of sub-objects that you can work with independently. For example, an editable mesh object's sub-object levels are Vertex, Edge, Face, Polygon, and Element. To access sub-objects, go to the Modifier panel. In the modifier stack display, click the plus-sign button to display an object's hierarchy, and then choose the sub-objects level from the hierarchy. At the sub-objects level you can select sub-objects, transform the selections, apply modifiers, and so on.

Left: A selection of face sub-objects
Middle: A selection of edge sub-objects
Right: A selection of vertex sub-objects

Many topics in the online reference deal with sub-objects. To see a list of sub-object-related topics, search on the term “sub-object” (include the quote marks in the keyword).
Sub-Object Level

Some types of objects let you change to a sub-object level to edit their component parts. For example, editable meshes on page 2192 have Vertex, Edge, Face, Polygon, and Element sub-object levels. NURBS models on page 2416 can have Surface, Curve, Point, Surface CV, Curve CV, and Import sub-object levels.

Edge sub-objects level chosen while editing a mesh.

You change the active sub-object level using the Modifier Stack display on page 8187 on the Modify panel.

Subtractive Opacity

Subtractive opacity darkens colors behind the material by subtracting the material's colors from the background colors.
Sphere on the right uses subtractive opacity.

If you simply want to reduce the apparent opacity of a material, while maintaining the color values of its diffuse (or mapped) properties, use subtractive opacity.

See also:

- Additive Opacity on page 8499

Sunlight

The Sun is modeled as a parallel light source, which makes the incident direction of sunlight constant over all surfaces in the scene. You can specify the direction and intensity of the sun directly. Alternatively, the direction and intensity of the sun can be calculated based on geographical location, time, and sky condition settings.

See also:

- Skylight on page 8723
Super Black

Super Black limits the darkness of rendered geometry. This option is used for video compositing. When compositing, you need pure black for the background, but overlying objects need to be less than pure black so that you can still see exactly where they are. Also, some video systems have problems with black that has RGB values of 0,0,0, and consider it an “illegal” color. Unless you’re sure you need it, leave the Render Setup dialog > Super Black check box off.

The scanline and mental ray renderers use the value of the Super Black > Threshold preference setting on page 8344 to determine the maximum darkness of the rendered scene. For example, if you’re rendering a heavily shadowed object against a black background, although the background will be rendered as pure black, the deepest shadows on the object will be no darker than the intensity level specified by the Threshold setting (default is 15).

NOTE Setting the Threshold value too high can artificially raise low-blended values. This can ruin antialiasing effects in the renderer.

Supersampling

Supersampling is one of several antialiasing techniques that 3ds Max performs. Textures, shadows, highlights, and raytraced reflections and refractions all have their own preliminary antialiasing strategies. Supersampling is an optional additional step that provides a “best guess” color for each rendered pixel. The supersampler’s output is then passed on to the renderer, which performs a final antialiasing pass.

See also:

■ SuperSampling Rollout on page 5759
Support Period

In footstep animation on page 8584, the period where one or both of the biped feet are on the ground.

Surface Arrive Behavior

In crowd animation on page 5104, the Surface Arrive behavior is similar to the Seek behavior: it lets you specify one or more objects as a stationary or moving target for delegates. The principal difference is that you can use the Approach settings to specify an intermediate target. After reaching this location, the delegates will then make their final approach to the ultimate target surface. An example would be birds flying over a row of telephone poles, and then each one dropping to land on top of a different pole.

Surface Follow Behavior

In crowd animation on page 5104, the Surface Follow behavior moves delegates with respect to object surfaces. Target objects can be animated. For example, you can apply an animated Noise modifier to a patch grid to simulate a choppy water surface, and objects guided by Surface Follow will stay on top.

Synthesis, Synthesize

Synthesizing is the process of computing (solving) motions for crowd simulations on page 5104. The resulting simulation is a synthesis.

Talent Figure Mode

When you work with motion capture on page 4916, after you load a raw marker file on page 8632, you can turn on Talent Figure mode to scale the biped relative to the markers. Calibration for the entire marker file takes place when you exit Talent Figure mode.
Tangents

The tangent of a function curve affects the interpolated values between the keys of an animation. Most animation controllers use fixed tangents to define the function curve at a key location.

By default, 3ds Max assigns smooth tangents to the keys in a Position function curve. This is the reason that an animated object moves in smooth curves through the key frames. 3ds Max assigns smooth tangents because they usually provide the most natural motion.

Of course, you also need a way to add some corners and abrupt turns when you need them. The Linear controller on page 3496 uses a discontinuous tangent that points at the preceding and following keys, producing an abrupt change in motion at that key.

The two large flyout buttons at the bottom of the Key Info dialog provide five different types of predefined tangent types on page 3420, plus a sixth type that lets you create your own custom tangents.

If you look at a single key dot and the line running through it, the line on the left side of the key dot is the incoming tangent, and the line on the right is the outgoing tangent. Using the tangent flyout buttons, you can assign a different tangent type to the incoming and the outgoing lines for each key dot.

The button on the left assigns the incoming tangent at the left side of the selected key dot, and the button on the right assigns the outgoing tangent on the right side of the selected key dot.

TCB (Biped)

TCB is short for Tension, Continuity, and Bias. These parameters quantify the traditional animation technique of ease in and ease out (also known as “slow in and slow out”). In freeform animation on page 8586 of a biped, you can use them to change the timing of a limb’s movement from key to key.

The TCB controls are in the TCB section of the Key Info rollout on page 4704.
TCB (Tension, Continuity, Bias)

The TCB Position controller provides Tension, Continuity, and Bias controls of the splines of a function curve.

**TCB Controllers** on page 3563 also produce curve-based animation much like the **Bezier controllers** on page 3432. However, TCB controllers do not use tangent types or adjustable tangent handles. They use numeric values to adjust the Tension, Continuity, and Bias of the animation.

**Bias** Controls where the animation curve occurs with respect to the key. High Bias pushes the curve beyond the key. This produces a linear curve coming into the key and an exaggerated curve leaving the key. Low Bias pulls the curve before the key. This produces an exaggerated curve coming into the key and a linear curve leaving the key. The default value of 25 distributes the curve evenly to both sides of the key.

**Continuity** Controls the tangential property of the curve at the key. The default setting is the only value that produces a smooth animation curve through the key. All other values produce a discontinuity in the animation curve causing an abrupt change in the animation. High Continuity values create curved overshoot on both sides of the key. Low Continuity values create a linear animation curve. Low continuity creates a linear curve similar to high tension except without the Ease To and Ease From side effect. The default value of 25 creates a smooth continuous curve at the key.

**Tension** Controls the amount of curvature in the animation curve. High Tension produces a linear curve. It also has a slight Ease To and Ease From effect. Low Tension produces a very wide, rounded curve. It also has a slight negative Ease To and Ease From effect. The default value of 25 produces an even amount of curvature through the key.

Tendons

When you use **Physique** on page 4944, after you adjust envelope parameters for good mesh deformation, you can use **tendons** on page 5090 to control the amount of skin stretching across multiple links. While envelopes provide
smooth skin deformations, tendons provide additional stretching in much the same way that actual human tendons might create pulling in the wrist (several joints away) when the fingers are moved.

**Tension, Continuity, Bias (Biped)**

Tension, Continuity, and Bias (TCB) are parameters that quantify the traditional animation technique of ease in and ease out (also known as “slow in and slow out”). In **freeform animation** on page 8586 of a biped, you can use them to change the timing of a limb's movement from key to key.

The TCB controls are in the TCB section of the **Key Info rollout** on page 4704.

**Terrain**

Creates **terrain objects** on page 730 from contour line data. You select editable splines representing elevation contours and 3ds Max creates a mesh surface over the contours. You can also create a "terraced" representation of the terrain object so that each level of contour data is a step, resembling traditional study models of land forms.
Using contours to build a terrain

When you import an AutoCAD drawing file to use as contour data, 3ds Max names each object based on the AutoCAD object's layer, color, or object type. 3ds Max appends a number after each name. For example, an AutoCAD object on the layer BASE becomes BASE.01.

After importing the contour data, selecting the objects and clicking the Terrain button, 3ds Max moves all the selected objects out of the scene and into the terrain object. Other splines in the selection are treated in the same way as by the Move copy method. You can only use these splines as operands of the terrain object. This is appropriate if you create splines in order to create a terrain object and have no further use for them.
**Test**

The basic function of a test in Particle Flow is to determine whether particles satisfy one or more conditions, and if so, make them available for sending to another event. When a particle passes a test, it is said to “test True.” To send eligible particles to another event, you must wire on page 8763 the test to that event. Particles that don’t pass the test (“test False”) remain in the event and are repeatedly subjected to its operators and tests. Or, if the test isn’t wired to another event, all particles remain in the event.

A list of all tests in Particle Flow is available in the Tests topic on page 3233.

**See also:**

- Operator on page 8665

**Texel**

A texel (short for Texture Element) is the base unit of a textured graphic, which defines the surface of a three-dimensional object. The base unit of the surface of a 3D object would be a texel, while a 2D object would consist of pixels on page 8687.

**Texture**

A texture, also known as a texture map, is an image used to add color and patterns to an object surface. For example, you could use a photo of sand to make an object look like a beach or desert. Typically, a texture takes the form of a bitmap on page 8523 used as the Diffuse map on page 6031 in a material on page 8635. More generally, a texture is any map used to lend variety to a surface.

**Ticks**

Ticks are the way 3ds Max views increments of time. There are 4800 ticks in a second, so you can actually access time down to 1/4800th of a second.

Given a standard, NTSC video frame rate, there are 30 frames in a second, and therefore 160 ticks in each frame.
When you use the FRAME:TICKS display format, time is shown in frames and ticks, delineated by a colon. This format lets you adjust the time slider in sub-frame increments of 1/160th of a frame. As you move through time, the ticks field counts from 0 to 159, at which point the frames field increments by one, and the ticks field returns to 0.

You can step forward or backward at single increments by clicking the single-frame buttons among the playback buttons.

When you use the MM:SS:TICKS Display format, you see minutes (MM), seconds (SS), and ticks, each separated by colons.

As you move through time in this display format, the ticks field counts from 0 to 4799, at which point the seconds field increments and the ticks field returns to 0.

You can step forward or backward at single increments by clicking the single-frame buttons on either side of the playback button.

**Tile/Mirror**

Tiling and mirroring are useful for creating patterns based on a simple image. Use them when you need wallpaper and other repetitive designs.

Left: A bitmap
Middle: Tiling the bitmap
The Tile option in the Material Editor is on by default, repeating the image along the U and V directions. You can use the Tiling values to scale the map image. Setting negative Tiling values increases the size of the image.

You can also set tiling values in the UVW Map modifier. These settings are in addition to the tiling values you set for the map in the Material Editor. If the map's base tiling parameter has a value of 2.0 and the UVW Map modifier has a tiling value of 3.0 for the same axis, the net result is $2.0 \times 3.0 = 6.0$. To avoid confusion about where the tiling is coming from, you may want to set the map's tiling in its base parameters or with the UVW Map modifier, but not in both locations.

The Mirror option is a variation on the Tile option. Tile repeats the image side-by-side, while Mirror flips the image repeatedly.

### Topology

When objects and shapes are created, each vertex and/or face is assigned a number. These numbers are used internally to determine which vertices or faces are selected at any given time. This numerical arrangement is called *topology*.

When you select vertices or faces and apply a modifier to the selection, the modifier stack keeps track of which faces/vertices the modifier affects. If you later return to the selection level of the stack and change the selection, you change the topology to which the modifier is applied.

The term *topology* refers to the structure of faces and vertices as well as their numbers.

For example, by carefully setting various parameters, you could make a box and a cylinder with the same number of vertices. You might then think you could use the box as a morph target for the cylinder. However, because the two objects are created with such different methods, the vertex numbers on these objects would be ordered very differently. Morphing causes each numbered vertex to go to its corresponding place on the morph target. In a case such as this, with two objects with such different topology, morphing from one to the other would cause the object to crumple or turn inside out as it morphs.
Topology-Dependent Modifier

Topology-dependent modifiers perform operations on explicit, topological sub-object selections. The Edit Mesh and Mesh Select modifiers are examples of modifiers that perform operations or selections on explicit vertex or face numbers. When these modifiers are present in the stack, you can adversely affect their results if you visit previous stack operations and change the topology (the number and order of faces and vertices) being passed to them. When you do this, a topology-dependence warning alerts you to the situation.

Touch

In footstep animation on page 8584, the state of the biped foot on the first frame of a footstep.

Track

A track is a linear representation of animation occurring over time. You can think of a track as a long, straight railroad track, with the animation start time at one end, and the finish time at the other. Keys are placed on the track at intervals that correspond to the time along the track.

The term track is used in several areas of character studio, including the following:

- Each animatable object and parameter in 3ds Max and character studio has its own animation track, which you can view and edit in Track View on page 4575.
- Tools are available especially for working with biped tracks. The center of mass is unique in that it has separate tracks for horizontal and vertical animation, which you can select on the Motion panel > Track Selection rollout on page 4686. You can copy and paste tracks on page 4649 on biped objects to other bipeds with the Copy/Paste rollout on page 4726.
- In the Keyframing Tools rollout on page 4717, you can clear all animation or just selected tracks.
- In the Motion Mixer on page 4002, the linear areas that hold motion clips are called tracks. Several tracks can be stacked on top of one another to use animation from all tracks at the same time.
Track View

Track View provides a visual representation of animation keys, allowing you to view, edit, copy and adjust one or several keys at a time. This is where you control the timing of your animation, through the manipulation of keys, curves and ranges. You can also assign animation controllers to interpolate or control all the keys and parameters for the objects in your scene.

Track View has two windows, a Controller window and a Key window. The Controller window shows the hierarchy of linked objects, as well as the modifier stack and transform tracks. The Key window displays keys, curves and ranges. Keys are color coded to show what is animated.

Track View uses two different modes. Curve Editor mode on page 3804 displays key interpolation as curves, and allows you to edit the curves. Dope Sheet mode on page 3805 displays the animation as a spreadsheet of keys and ranges. Dope Sheet has two modes, Edit Key and Edit Ranges.

Trackgroup

In the Motion Mixer, motions are placed on tracks, and the tracks are organized into trackgroups. In other words, each trackgroup is a holder for one or more tracks. Each trackgroup can be filtered so the tracks within it affect only certain parts of the biped, such as its arms or legs. Every biped in the Motion Mixer can have multiple trackgroups, each with its own selection of biped parts. See Adding Tracks to the Mixer on page 4007 and Filtering Mixer Tracks on page 4018.

Tracks

A track is a linear representation of animation occurring over time. You can think of a track as a long, straight railroad track, with the animation start time at one end, and the finish time at the other. Keys are placed on the track at intervals that correspond to the time along the track. Every item in the Track View hierarchy has a track that displays what happens to the item over time.
There are two types of tracks:

- Range tracks indicate the range of time over which the animation occurs. In 3ds Max, range display is turned off by default. To display the range, select the keys in the track bar, then right-click and choose Configure> Show Selection Range.

- Range tracks indicate when items below the track are animated. A range bar in the track displays the range of time over which the animation occurs.

- Animation tracks contain the actual animated values for an item. Only controller items have an animation track.

The values in an animation track are usually displayed as keys. Some controllers don't use keys and instead display their values as a range bar or some other graphic symbol. For example, the Wave Form item displays a sound file as a two-channel sound wave.

Animation tracks are also the only track type that can be displayed as a function curve.

**Trajectory**

Whenever an object moves through world space, you can view its trajectory. A trajectory is the visible path the object makes because of its movement. You can think of a trajectory as a three-dimensional function curve for the Position track of an object.
Scooter following a trajectory

Object trajectories appear with the following properties:

- The trajectory curve is drawn in blue.
- Frame increments are displayed as yellow dots on the curve.
- Position keys are displayed as white boxes surrounding the appropriate frame dot on the curve.
- Selected keys are displayed in gray.

In 3ds Max trajectories are created from animated objects. You must animate the object first in order to create the trajectory.

The Path constraint on page 3596 lets you pick a spline in the scene to use as a motion path for an object. The spline becomes the object's explicit trajectory.
**Trajectory (Biped)**

The path an object follows as it moves through space. In 3ds Max, you can think of a trajectory as a three-dimensional function curve for the Position track of an object.

When you animate a biped, you can turn on the display of its trajectory. See Trajectory Display on page 4657.

**Transform Gizmo**

A gizmo that is displayed in viewports and provides a visual aid when you transform objects.
Rotate gizmo

Scale gizmo
Transforms

When you create any object, 3ds Max records its position, rotation, and scale information in an internal table called a transformation matrix. Subsequent position, rotation, and scale adjustments are called transforms.

Moving, rotating, and scaling a figure

An object’s actual position within the world coordinate system is always calculated in relation to its internal, or local coordinate system, which is based on the object’s transformation matrix. The origin of the local coordinate system is the center of the object's bounding box on page 8528.

An object can carry any number of modifiers, but only one set of transforms. Although you can change transform values from frame to frame, each object always has only one position, one rotation, and one scale transform.

You can animate your transforms by turning on the Auto Key button and then performing the transform at any frame other than frame 0. This creates a key for that transform at the current frame.

Transition

In the Motion Mixer and in Motion Flow, a transition is a gradual change between two motion clips. You can set the frames at which the transition starts and ends in each clip.

To find out how to use transitions in the Motion Mixer, see Working with Transitions on page 4026. For information on transitions in Motion Flow, see Customizing Transitions on page 4865.
Transition Track

A Motion Mixer track that allows you to stack clips on top of one another, and to create automatic transitions between them. Transitions on these tracks are similar to those in a Motion Flow network. Compare with a Layer track on page 8617, which allows cuts only between clips. See Adding Tracks to the Mixer on page 4007.

Translucency

A translucent material transmits light, but unlike a transparent material, it also scatters the light so those objects behind the material cannot be seen clearly.

Glass on the right has a light green translucency.

Raytrace materials on page 6064 can simulate translucency. A Raytrace material's Translucency color component ignores surface normal directions, giving the effect of light scattering.
You can also obtain translucency effects using the Standard material's on page 5962 Translucent shader on page 5988.

**Truecolor**

Describes hardware and software that can support up to 16 million color values. Also known as 24-bit color, or 32-bit color when saved with alpha channel data on page 8502.

**Twist Links**

When you turn on Twist Links Mode (on the Bend Links rollout on page 4700), a rotation in local X applied to a single chain link is incremented equally throughout the rest of the chain. The remaining two axes (Y and Z) are not affected by this rotation.

![Twist Links Mode active (left) and Twist Links Mode inactive (right)](image)

**Unique Container**

A Unique Container is a Container on page 8536 created from your workstation, or merged into your scene from a Source Container on page 8725. You use Unique Containers to organize scenes in ways that are similar to the uses of...
groups or layers. These types of Containers let you collect a group of objects and work with them as a single entity.

See also:
- **Container** on page 8536
- **Local Container** on page 8620
- **Source Container** on page 8725

**Universal Naming Convention (UNC)**

The 3ds Max network rendering system uses the Universal Naming Convention (UNC) to identify directories and files. UNC names begin with a double backslash and do not include a drive letter. This is the convention:

```
\machine_name\directory\subdirectory\filename
```

To simplify network rendering, use UNC names whenever possible within a 3ds Max scene, even if the directory is on the local machine.
When entering UNC names, leave off the \ before the file name until you've entered the entire path and file name. This eliminates search delays when entering UNC path names into file selection dialogs.

Some networks require drive letters instead of UNC names. Directories on such networks can be mounted as drive letters and shared over the network. See Mounting a Directory on page 6950.

UVW Coordinates

Most material maps are a 2D plane assigned to a 3D surface. Consequently, the coordinate system used to describe the placement and transformation of maps is different from the X, Y, and Z axis coordinates used in 3D space. Specifically, mapping coordinates use the letters U, V, and W; the three letters preceding X, Y, and Z in the alphabet.

Local UV coordinates shown on a surface

The U, V, and W coordinates parallel the relative directions of X, Y, and Z coordinates. If you look at a 2D map image, U is the equivalent of X, and represents the horizontal direction of the map. V is the equivalent of Y, and
represents the vertical direction of the map. \( W \) is the equivalent of \( Z \) and represents a direction perpendicular to the UV plane of the map.

You might question why you need a depth coordinate like \( W \) for a 2D plane. One reason is because it’s sometimes useful to be able to flip the orientation of a map, relative to its geometry. To do this, you need the third coordinate. The \( W \) coordinate also has a meaning for 3-dimensional procedural materials.

**Vector Field**

In [crowd animation](#) on page 5104, a vector field is a special type of space warp that crowd members can use to move around irregular objects such as a curved, concave surface. The vector field gizmo, a box-shaped lattice, is placed and sized so that it surrounds the object to be avoided. The vectors are generated from the lattice intersections. These vectors are, by default, perpendicular to the surface of the object to which the field is applied; if necessary, you can smooth them out with a blending function. The crowd members move around the object by traveling perpendicular to the vectors.

**Vector Field Space Warp**

In [crowd animation](#) on page 5104, you can use the Vector Field space warp on page 5258 as a space warp behavior. A vector field allows crowd members to move automatically around obstacle objects of any shape, following the object contours. It also lets crowd members move within the confines of an enclosed space, such as a room, while avoiding the walls. You can also use Vector Field space warps to control particle motion.

The Vector Field space warp works by generating a number of vectors that surround an object and are perpendicular to its surface. Crowd animation then uses these vectors to guide delegates around the object by moving them perpendicular to the vectors.

**Vectors and Vector Handles**

Vectors are secondary control points connected to vertices on a spline or patch object. They are also referred to as handles or vector handles.
Kinds of vector handles:
1. Corner
2. Smooth
3. Bezier
4. Bezier corner

Vector handles are visible as small green squares when you select a vertex. However, if the Vectors filter is checked (for a patch object), handles can be selected and transformed without selecting a vertex first. A transform cursor appears when you move onto a vector.

Each vertex in a shape can be one of four types:

**Bezier** Provide handles, but forces the segments into a tangent through the vertex.

**Bezier Corner** Provides handles, and allows the segments on either side of the vertex to be any angle.

**Corner** Allows the segments on either side of the vertex to be at any angle.

**Smooth** Forces the segments into a smooth curve tangent to the vertex.
**Velocity Interpolation**

One method of interpolation used in motion flow editing on page 4848. By default, in a transition between two motion clips, velocity is interpolated to blend smoothly between clips. If transitions are optimized, then a sophisticated algorithm is used that minimizes sliding feet.

**Vertex**

A vertex (plural form: vertices) is a single point whose sole property is its position in 3D space, which is typically defined by values for the X axis, Y axis, and Z axis. Vertices form the basic structure of geometric objects in 3ds Max, including mesh objects, splines, NURBS, and patches.

**ViewCube Navigation System**

The ViewCube® on page 86 3D navigation system is a navigation tool that appears in viewports, and allows you to switch between various standard and isometric views. The ViewCube is on by default.

**Viewport (Interactive) Renderer**

The interactive renderer, used for the viewports, is designed for speed so you can easily manipulate your objects in a shaded environment. It's not the same as the production renderer, which is used for your final images. Therefore, a number of effects that are available to the production renderer will not show up in the viewports.

When you design your materials, for example, you have four levels of visual feedback. The lowest level is the shaded viewport. The next level is an ActiveShade viewport (or floater). The next level is the sample slot, which uses the production renderer to display the sample sphere. The highest level is the rendered scene, which uses the production renderer to display the scene.

A single material can contain any number of maps.

Because viewing mapped materials slows the viewport display, it's up to you to decide which map (if any) you want to display. To display a specific map, you go to that map's level in the Material Editor, and then turn on its display.
VIZBlock

A VIZBlock is a compound object similar to a nested AutoCAD block. It is used for organizing linked data from DWG files. When AutoCAD data is linked to 3ds Max, you need to decide how the AutoCAD entities are to be organized in the scene. AutoCAD drawings are commonly organized by layers, blocks, and entities, and 3ds Max scenes are organized by hierarchies of objects.

VPX Files

VPX (Video Post sequence) files contain all the information relating to the queue and all associated settings and references. They have the file extension .vpx and are stored by default in the 3ds Max \vpost folder.

All of the Video Post configuration data, queue events, and queue event external data is saved with the MAX file also, however saving it to a separate file allows you to use the same Video Post settings in different scenes, and also allows you to share sequences with other 3ds Max users.

VUE File

A VUE (.vue) file is an editable ASCII file. You create a VUE file using the VUE file renderer instead of the default scanline renderer.

A VUE file contains a sequence of frames to render. Each frame is described by a sequence of commands, beginning with a "frame" command, which specifies the frame number, and ending with a viewport command, which specifies the view to render (such as "top" or "camera"). Between these two commands, there can be any number of "transform", "light", and "spotlight" commands.

NOTE VUE files created with 3DS DOS could also contain "morph" commands. This is not supported in 3ds Max because the 3ds Max exporter doesn't export morph targets.

The VUE file commands are as follows:
frame <n>
transform <object name> <transform matrix>
light <light name> <x> <y> <z> <r> <g> <b>
spotlight <light name> <x> <y> <z> <tox> <toy> <toz> <r> <g> <b> <hot angle> <falloff angle> <shadow flag>
top <x> <y> <z> <width>
bottom <x> <y> <z> <width>
left <x> <y> <z> <width>
right <x> <y> <z> <width>
front <x> <y> <z> <width>
back <x> <y> <z> <width>
user <x> <y> <z> <horiz> <vert> <roll> <width>
camera <x> <y> <z> <tox> <toy> <toz> <roll> <focal>

**Frame Command**

Begins each frame description. Has a single parameter: the frame number.

**Transform Command**

Transforms the specified object.

The first parameter is the name of the object. This is the name as it appears when you use 3ds Max, but enclosed in double quotes.

The second parameter is a transform matrix. This consists of 12 real numbers:

T1 T2 T3 0
T4 T5 T6 0
T7 T8 T9 0
T10 T11 T12 1

The VUE file treats these as if they were arranged in a 4 x 4 matrix (M):

T1 T2 T3 0
T4 T5 T6 0
T7 T8 T9 0
T10 T11 T12 1

The first nine values, T1–T9, describe rotation and scaling. The last three, T10–T12, describe a move, in world coordinates.
The VUE file renderer transforms the points of the object by post-multiplication:

\[
\begin{bmatrix}
X' & Y' & Z' & 1
\end{bmatrix} = \begin{bmatrix}
X & Y & Z & 1
\end{bmatrix} \cdot M
\]

**Omni Light Command**

Controls the location and color of an Omni light.

The first parameter is the name of the light. This is the name as it appears when you use 3ds Max, but enclosed in double quotes.

The next three parameters, \(<x>, <y>, <z>\), are the light’s location.

The next three parameters, \(<r>, <g>, <b>\), are the light’s color. The color values are normalized to range between 0.0 and 1.0.

The last parameter, \(<shadow flag>\), parameter is 1 if the light casts shadows, 0 otherwise.

**Spotlight Command**

Controls the location, color, and other characteristics of a target spotlight.

The first parameter is the name of the light. This is the name as it appears when you use 3ds Max, but enclosed in double quotes.

The next three parameters, \(<x>, <y>, <z>\), are the light’s location.

The next three parameters, \(<tox>, <toy>, <toz>\), are the location of the light’s target.

The next three parameters, \(<r>, <g>, <b>\), are the light’s color. The color values are normalized to range between 0.0 and 1.0.

The \(<hot angle>\) parameter is the angle of the light’s hot spot, in degrees.

The \(<falloff angle>\) parameter is the falloff angle, in degrees

The \(<shadow flag>\) parameter is 1 if the light casts shadows, 0 otherwise.

**Orthogonal Viewport Commands**

These commands render a particular view—top, bottom, left, right, front, or back.

The \(<x>, <y>, <z>\) parameters are the coordinates of the center of the view.

The \(<width>\) parameter is the width of the rendered image, in world units.
**User Viewport Command**

Renders the user view.

The \(<x>, <y>, <z>\) parameters are the coordinates of the center of the view. 
The \(<\text{horiz}>\) parameter is the horizontal angle, in degrees. 
The \(<\text{vert}>\) parameter is the vertical angle, in degrees. 
The \(<\text{roll}>\) parameter is a placeholder for the roll angle—but this is an "empty," unused parameter that must always be zero. To use roll in a VUE file, use a camera view instead of a user view. 
The \(<\text{width}>\) parameter is the width of the rendered image, in world units.

**Camera View Command**

Renders a camera view. 

The \(<x>, <y>, <z>\) parameters are the camera’s location. 
The \(<\text{tox}>, <\text{toy}>, <\text{toz}>\) parameters are the location of the camera's target. 
The \(<\text{roll}>\) parameter is the camera roll angle, in degrees. 
The \(<\text{focal}>\) parameter is the camera's focal length, in millimeters.

**Walking Gait**

One of the predefined biped gaits available in footstep animation on page 8584 (the others are running and jumping). In a walking gait, at least one foot is always in contact with the ground.

**Walkthrough Assistant**

Walkthrough Assistant lets you easily create a predefined walkthrough animation of your scene by placing a camera on a path and setting the height, turning the camera, and viewing a preview. This feature is available on the Animation Menu.

In a scene, create a path for the camera to follow using a spline or NURBS curve. Then choose Walkthrough Assistant from the Animation menu. With Walkthrough Assistant you can automatically create a camera and animate it along the path. Change a Perspective viewport into the Camera viewport to
view the result. You can adjust the eye height and head tilt. You can animate turning the camera by turning on the Auto Key button. For more information see Walkthrough Assistant on page 5599.

**Wall Repel Behavior**

In crowd animation on page 5104, the Wall Repel behavior uses a grid object to repel delegates. When influenced by the Wall Repel force, delegates turn until they're heading away from the grid. This behavior is useful for keeping objects inside an enclosed, straight-sided enclosure, such as a room in a building.

**Wall Seek Behavior**

In crowd animation on page 5104, the Wall Seek behavior uses a grid object to attract delegates. When influenced by the Wall Seek force, delegates turn until they're heading toward the grid. This behavior is useful for moving objects toward a rectangular area, such as a doorway.

You can set the grid to attract from either side or both sides, and optionally specify a maximum distance for attraction. You can also set the behavior to act as though the grid extends infinitely along its plane.

**Wander Behavior**

In crowd animation on page 5104, the Wander behavior imparts a random motion to delegates, letting you simulate meandering activity in which delegates move and turn in a haphazard manner. The behavior works by randomly picking a new direction, and then turning and moving in that direction. You can specify how often to pick a new direction, how far to turn, and how fast or slow to turn while moving.

**Weight Curve**

In the Motion Mixer on page 8647, weight curves define the amount of influence a clip on page 8646 or track on page 8744 has on the mixed animation.

On a layer track on page 8617, each clip has its own weight curve. On a transition track on page 8751, one curve defines the influence for the entire track. On a
balance track on page 8517, the weight curve determines the degree of automatic balance compensation applied to the biped motion.

**Wire**

Particle Flow uses wires to show connections between events in Particle View on page 3015. There are two types of wires: one that connects a global event on page 8594 to a birth event on page 8521, represented by a dashed blue line; and one that connects a test on page 8741 to a local event on page 8623, represented by a solid blue line.
To wire a test to an event, drag from its *test output*, the blue dot that by default sticks out to the left of the test, to the event’s *event input*, which sticks out from the top, or vice-versa. Similarly, you can wire a global event to a birth event by dragging between the *source output* on the bottom of the global event and the event input.
The mouse cursor resembles the first image when you can begin this operation: the bottom portion is the top of a small square. The cursor resembles the second image when you can complete the operation: the square at the bottom has become an arrow.

To delete a wire, right-click it and choose Delete Wire, or click it (it highlights in yellow) and then press the Delete key. Or, with a wire between a test and an event, drag from either connector to a blank area of the event display on page 8566.

**Wireframe Color**

An object’s wireframe color, also known as its *object color*, is the color assigned to it by 3ds Max at random when you first create it. 3ds Max uses this color to display the object in the viewports, both wireframe and shaded, until you assign a material to it. The wireframe color is useful for various purposes, including organization and identification, and you can even use the color as a material component.
Wireframe color applied as ink color in the Ink ‘n Paint material using the Object Color shader

Following are some topics that cover usage of the wireframe color:

- Object Name and Wireframe Color on page 8182
- Object Color Dialog on page 368
- Select By Color on page 229
- Display Color Rollout on page 158
- Object Color Shader (mental ray) on page 6418

**Wireframe Mode**

Wireframe is a viewport display setting that lets you view objects in a given viewport as a wire mesh. This is the default setting for non-Perspective
viewports. You change this setting from the Shading viewport label menu on page 8130.

**Wireframe mode display of a director’s chair and megaphone**

In addition, you can set the Standard and Raytrace materials to render as wires. Use the Extended Parameters rollout to set the size of the wire, and specify its measurement in either pixels or units.

When you use pixels, the thickness of the wire is based on the screen pixels. Therefore, it's absolute, and remains the same, regardless of its distance from the camera. If you use units, the thickness is based on world units, and varies depending on the distance from the camera. It's easier to compare the effect of pixels and units if you first adjust the camera view to give a greater sense of distance. You can most easily do this with the Perspective viewport navigation tool, which dollies the camera in one direction while changing the field of view in the other.

**Workbench**

The Animation Workbench is a customized version of the Track View function curve editor designed to be used with bipeds. It contains a Curve View that displays keys on function curves which you can edit similar to the way you work in Track View. It also contains a set of four panels for selecting bipeds, analyzing their motion tracks for error conditions, and fixing those tracks individually or in groups.

The Workbench can be used to assign SubAnim controllers to multiple biped body parts at once through the display of the Controllers window.

Workbench filters can be used to smooth, blur or boost position and rotation curves, and can also be used to apply controllers or remove keys.
The Workbench uses many of the same toolbars found in Track View for key manipulation and track navigation. It uses manual navigation as the default behavior. When multiple biped body parts are selected it does not display all curves as a default, so you can perform error analysis and correction on many tracks without displaying all the curves simultaneously.

**Workflow**

A series of steps to perform a task.

**World Coordinate System**

The coordinate system for world space or the model space as a whole.

A book in object space rests on a table in world space. The table uses the world coordinate system.

World space is the universal coordinate system for all objects in the scene. When you look at the home grid in the viewports, you see the World Space coordinate system. World space is constant and immovable.
In the world coordinate system seen from the front, the X axis runs in a positive direction to the right, the Z axis runs in a positive direction upward, and the Y axis runs in a positive direction away from you.

**World Space**

World space is the universal coordinate system used to track objects in the scene, as opposed to **object space** on page 8659. When you look at the home grid in the viewports, you see the world-space coordinate system. World space is constant and immovable.

A book in object space rests on a table in world space.

All objects in your scene are located in world space by their position, rotation, and scale (their transforms).

Some modifiers on page 8643 operate in world space. See **World-Space Modifiers (WSMs)** on page 1067.

**Space warps** on page 8727 also operate in world space. A space warp defines an area in world space that is affected by the space warp’s parameters. Any object
that is bound to the space warp is affected as it moves through the space warp's area of world space.

**World Space (Biped)**

When you use freeform animation on page 8586 to animate a biped, you can place a biped limb into the space of another object, or into world space. For example, if the biped's feet are in world space, then when you move the center of mass, the feet stay planted in the same location.

**World-Space Modifiers (WSM)**

World space is the universal coordinate system that applies to the entire scene. A world-space modifier, as opposed to an object-space modifier on page 8661, affects an object but uses world coordinates.

A world-space modifier always appears at the top of the modifier stack on page 1045. Its effect is independent of its order in the stack.

**See also:**

- World-Space Modifiers (WSMs) on page 1067

**xref (AutoCAD External Reference)**

An AutoCAD external reference. An xref is a variation on a block. A block is a collection of geometry that is identified by a unique name, is stored in the AutoCAD symbol table, and essentially behaves as if it is a single object. Xrefs share block characteristics, and they are similarly defined in the symbol table. However, unlike blocks, the geometry associated with an xref definition is not stored in the current AutoCAD drawing; it is stored in another AutoCAD drawing file. Like a block, there can be many instances of an xref in a AutoCAD drawing, but only one definition.

Typically, xrefs are used to display the geometry of a common base drawing in the current AutoCAD drawing without expanding its size. This allows changes to the reference drawing to be reflected in any host AutoCAD drawings that refer to it.
See also:

■ XRef (3ds Max Externally Referenced File) on page 8771

**XRef (3ds Max Externally Referenced File)**

An XRef in 3ds Max is an externally referenced file or object. XRefs allow multiple animators and modelers to work on one scene at the same time without interfering with each other's work.

There are two ways to XRef another scene:

■ **XRef Scene** on page 7477
  The File > XRef Scene command XRefs an entire scene. For example, a classic use of this command is to bring in a scene that appears as a “set” for an animation you create.

■ **XRef Objects** on page 7450
  The File > XRef Objects command XRefs individual objects or materials. For example, you might be working on the model of a building, and fill it with furniture created by other artists.
  You can also XRef the manipulators and modifiers associated with the objects you XRef.

**XSML File**

An XSML file stores one or more shaders in the MetaSL format developed by mental images. You can develop MetaSL shaders using the mental mill application. The DirectX Shader material on page 6175 can apply XSML shaders to objects, and display them using hardware shading in viewports.

**IMPORTANT** For a MetaSL shader to work with mental ray, you must save it as a phenomenon. Phenomena are described in the mental mill Artist Edition User Guide.

**ZT File**

A ZT (.zt) file is a mental ray shadow map file on page 8719. This is a binary file that the mental ray renderer uses to accelerate the generation of shadows. You
specify a name and location for the .zt file on the Render Setup dialog > Renderer panel > Shadows & Displacement rollout on page 6756.
Index

_recover.max files 62
-v command-line option 7987
-z command-line option 7987
.mfe file
    append 4861
    file types 4888
    load 4861
    save 4861
+ viewport label menu 8117

1-rail sweep surface 2663
2 3 4 links 5024, 5096
2 feet down 4774, 4791
2-point perspective 5607
2-rail sweep surface 2673
2-sided 8378, 8493
2.5D snap 2807
2D
    2D coordinates rollout 6201
    2D images 7831
    2D maps 6200
    2D snap 2807
2D map
    glossary 8494
32-bit floating-point output 7866
3D
    3D coordinates rollout 6278
    3D maps 6278
    3D snap 2807
    viewing and navigating 3D space 65
3D displacement shader (mental ray) 6394
3D DWF
    exporting 7700
    glossary 8494
3D map
    glossary 8494
3DS files
    3DS import dialog 7655
    exporting 7659
    importing 7655
3ds Max
    bones 4470, 4958
    documentation set 17
    export table to IGES 7736
    getting started 26
    knowledge of 4467
    lighting in 5328
    main window 42
    materials 6683
    troubleshooting 8459
3dsmax.ini file 59–60

A

about
    about MAXScript 21
    buttons 5013
    footstep animation 4515
    freeform animations 4571
    absolute 5096
    absolute snap 2807, 2819
    absolute/offset coordinate display 8082
    abut selected (video post) 7282
    acceleration (raytrace) 6091
    acceleration techniques (raytracer) 6666
    acceleration test (particle flow) 3285
    accuracy 3008
    AccuRender materials
        in 3ds Max 7524
    actions (particle flow) 3046, 8495
    action recovery 3010
    adding 3027
    and order/priority 3014
    and time frames 3046
    editing parameters 3027
    order of 3013, 3024
    activate options 4741
    activating
        grid object 2797
        home grid 2797
        jobs in the queue 7017

8773 | Index
joint axes 3757
servers in the queue 7018
activating footsteps 4531
active 5070
active link (glossary) 8495
active time segment 3387
active time segment (glossary) 8496
active viewport 66
active/inactive footsteps 8496
activeshade
    render in viewport 8122
ActiveShade 6550
    commands (quad menu) 6558
    floater 6556
    glossary 8497
    quick render 6549
    viewport 6557
actual stride height 4781, 4787
actual stride length 4781, 4787, 4791
actual stride width 4781, 4787, 4791
adapt locks 4542, 4755, 8498
adaptation 8498
adapting
    keyframes to edits 4542
    keys to footstep edits 4542
    adaptive antialiaser dialogs 6095, 6097
    adaptive control 383, 1733, 6097, 6364
    adaptive degradation 123
    glossary 8498
    viewport configuration dialog 8384
adaptive subdivision dialog 1472
add
    alpha compositor (video post) 7385
    atmosphere 5455, 7236
    contrast filter (video post) 7311
    cross fade compositor (video post) 7385
    default lights to scene 152
    effect 5455
    external event (video post) 7305
    fade filter (video post) 7312
    image alpha filter (video post) 7313
    image filter event (video post) 7295
    image input event (video post) 7288
    image layer event (video post) 7298
image output event (video post) 7302
lens effects filter (video post) 7314
loop event (video post) 7308
negative filter (video post) 7377
note track (Track View) 3903
pseudo alpha compositor (video post) 7386
pseudo alpha filter (video post) 7379
scene event (video post) 7282
simple additive compositor (video post) 7387
simple wipe compositor (video post) 7388
simple wipe filter (video post) 7379
starfield filter (video post) 7381
time tag dialog 8085
visibility track 3910
add change option 5018
add keys
    function curves 3956
    Track View toolbar 3917
add layer 3467, 3483
add selection to current layer 7976
add texture elements dialog 6887
add to track set 3977
add twist pose 4695
add/edit DBR host dialog 6805
adding
    comments (particle system) 3031
    editable spline vertices 634
    footsteps 4527
    poses 4994
    splines 646, 655
adjust controllers to bipeds 4590
adjust animation range (track bar) 8071
adjust color dialog
    vertexpaint modifier 1982
adjust pivot rollout 3763
adjust talent pose option 4925
adjust transform rollout 3770
adjusting
    default envelope shape 4974
    keys in Track View 4549
link parameters 4986
normals and smoothing 380
object transforms 3656
pivots 3633

talent pose 4925, 8501
ADN (Autodesk Developer Network) 8436
Adobe Illustrator files
exporting 7662
importing AI 88 format 7662
advanced effects rollout 5457
advanced file link settings 7553
advanced key info 3422
advanced lighting
object properties 295
select advanced lighting rollout 6600
advanced lighting override material 6166
advanced quad menu options 8264
advanced ray-traced parameters rollout 5468
advanced rollout 1667
advanced shaders rollout
mental ray material 5958
advanced surface approximation dialog 2747
AEC design elements 468
AEC extended 467–468
editing wall objects 500
foliage 474
railing 482
wall 491
affect region 1159
soft selection rollout (EMesh) 2014
soft selection rollout (NURBS) 2541
affine transformation (glossary) 8501
after trajectory 4684
age test (particle flow) 3235
AI import dialog 7646
airborne option 4774, 4787, 4791
airborne periods 4555, 8501
aliasing/antialiasing
alias against background 8342
and supersampling 5759
fast adaptive 6095
filters 1180, 6589
glossary 8501
multiresolution adaptive 6097
align 967
align geometry dialog (edit poly) 1422
and pivot point 3763
camera 978
dialog 967
editable mesh objects 2220
editable mesh vertices 2220
flyout 966
grid to view 2798
keys (Track View) 3909
normals 973, 2803
objects 2799
selected left (video post) 7280
selected right (video post) 7281
to view (dialog) 979
to view (toolbar) 979
align commands 8003
align panel 2151
align submenu 8003
aligning objects 8003
alignment 2799
all bipeds 4684
all links 5096
allow non-vertical jambs 468
alpha channel 7163, 8502
alpha compositor (video post) 7385
alpha map (baking) 6852
alternate 4781, 4787, 4791
altitude (sunlight and daylight systems) 5499
ambient
and diffuse map lock 6021
and raytrace materials 6065
color (glossary) 8504
light 5322, 5328, 5330, 8504
lighting (rendered environment) 7163
mapping 6029
ambient occlusion
displaying in viewports 8130
promaterials 5850
ambient occlusion map (baking) 6853
analysis of lighting 6664
analyze errors 4832
analyze panel 4832
analyzing
  Shockwave 3D files 7779
  W3D files 7779
analyzing geometry 2873
anatomy of biped 4492
anchor (VRML97 helpers) 7809
anchor patches 2360
anchors 4717
angle 615, 4934
  transition editor 4900
angle of incidence 5322, 5328
angle separation 8342
angle snap 2810
angular dashpot 4277
animatable IK attachments to 3ds Max objects 4616
animated
  bitmap 5709
  material previews 5708
  reference objects (particle flow) 3142
  texture 8505
animating
  a biped with footsteps 4515
  a tablecloth (FFD(cylinder) space warp) 2969
attachment 3658
cameras 5585, 5599
texture 8505
lens effects properties (video post) 7315
lights 5339
links 3653
materials 5707
NURBS models 2453
parameters 3010
scene 40
shift+rotate 1005
shift+scale 1005
sub-object geometry 2196
transforms 902
vertices 3505
with applied IK 3750
with IK solvers 3680, 3710, 3732
with interactive IK 3747
animating a quadruped 4615
animating hair 1080, 1126, 1136
animation
  and particle system time frames 3012
  auto key default frame 8350
  auto key mode 3373
  auto key start frame 8350
  combining animations 4848
  concepts 3368
  constraints 3574
  controllers 3424, 8506
dynamics & adaptation rollout 4755
expanding tracks 4571
glossary 8505
hair and fur modifier 1080, 1126, 1136
importing and exporting 4640
importing from another scene 4126
insert animation 277
layers 3465, 8507
loading 4107
mapping 4110, 4112, 4115, 4117
methods 3368
NURBS 2439
preferences settings 8346
previewing animations after attaching Physique 4968
sample animations in this release 4638
saving 4122
selecting and moving tracks 4571
show ghosting 144
tips (NURBS) 2453
toggle animation mode 3373
utilities 4134
with radiosity 6633
animation controls 8089
animation layer weight 3465, 3467
animation layers 3465, 3467, 3482–3483, 8044, 8507
animation layers toolbar 8044
animation menu 8023
bone tools 871
explode 269
open 267
assembly
open 267
assembly commands 263
assembly heads helper objects 271
assembly menu
assemble 263
attach 270
detach 270
disassemble 269
explode 269
asset browser 7614
internet download dialog 7626
preferences 7625
using 57
asset tracking
dialog 7586
icons 7605
open from vault 7438
asset tracking dialog 4638, 7586
asset tracking dialog icons 7605
asset tracking prompts 7604
assign
controller (Track View) 3897
controller rollout (motion panel) 8216
material to selection 5690
object effects dialog 4205
random colors 370
vertex colors utility 6477
assign controller rollout (character studio) 4666
assign random colors 370
assign to link 4982, 5096
assigning
colors to objects 367
controllers 3397
materials 5626, 5641
associate bipeds with delegates 5185
associate objects with delegates 5179
assume skin pose 280
asterisk (in modifier stack) 1057
atmospheres and effects
adding atmosphere 7171
and raytracing 6666
atmospheric effect 7163, 7182, 7188, 7196
for atmospheric apparatus 7236
for lights 5453
atmospheric apparatus 7236
BoxGizmo 7237
CylGizmo 7240
SphereGizmo 7243
attach
attach options 2233
attaching and importing 3ds Max objects 2490
controls dialog (block controller) 3442
editable mesh edges 2220
editable mesh vertices 2220
editable patch object 2394
object 2360, 2397
splines 630, 634, 655
to assembly 270
to groups 263
attach points/tendon 5090
attach to deforming mesh
constraint 4406
attach to group 206
attach to node 5013
attach to rigid body constraint 4404
attached links 5090
attaching
mesh to a biped using
Physique 5013
tendon to another link 4995
attachment
animating 3658
constraint 3575
attachments (IK) 8513
attenuation 5322, 5328, 8513
and lights 8308
parameters 5431
raytrace attenuation rollout 6369
attribute holder attenuation rollout 6369
attribute holder modifier 1163
attributes (custom) 307
audio
default sound 3833
ProSound 3835
audio controller 3425–3426
AudioClip (VRML97 helpers) 7827
auto 4934
auto clip names 4850
auto expand
    animated 3858
    base objects 3858
    keyable 3858
    materials 3858
    transforms 3858
    xyz components 3858
auto key 3373
    and set key 3377
    default frame 8350
    start frame 8350
auto key default frame 8350
auto termination rollout 3786
auto timing 4781, 4787, 4791
AutoCAD
    blocks 7526, 7528
    importing DWG and DXF files 7666
    importing DXF files 7693
    instanced objects 7526
AutoCAD Architecture
    files 7507
    materials 7509
    objects 7507, 7535
    select families or types 228
    select similar 228
    styles 7535
AutoCAD blocks in 3ds Max 7503
AutoCAD DWG/DXF import options
dialog 7666
AutoCAD, AutoCAD Architecture, and Revit
    working with 7501
Autodesk Authorized Training Centers 8435
Autodesk Channels 8430
Autodesk Consulting 8436
Autodesk Data Management Server 8439
Autodesk Developer Network (ADN) 8436
Autodesk e-learning program 8436
    autodesk inventor files
    importing 7695
Autodesk Official Training Courseware 8436
Autodesk products
    information resources 8435
Autodesk Vault 7585, 8438
Autodesk VIZ
    lighting in 5328
autogrid 8514
AutoGrid 2792
automatic
    auto archive 8305
    auto backup 61, 8305
    auto secondary (lens effects) 7097
    auto termination (IK) 3786
    automatic exposure control 7210
    unit conversion 8299
automatic mapping rollout
    rendering to texture 6885
autoplay preview file 8299
AVI files 6894, 7832
avoidance behavior 5123, 5209, 8515
    preventing collisions 5256
awning window 549
axis constraints 910, 8039
    and hierarchies 3788
    and rollouts 3788
    and snaps 2819
axis constraints toolbar 8039
axis order 4631, 4693
axis ordering 4823
axis tripod 143
    and transform managers 904
axonometric views 72, 8515
azimuth (sunlight and daylight system) 5499

B
B-spline (glossary) 8516
backburner
    network rendering 7021, 7033
Backburner 6905
backburner command line control 7052
backburner.xml file 6981
backface cull on object creation 8308
backfacing - ignore 2192, 2220, 2235
| Surface Follow | 5233, 8736 |
| Wall Repel | 5236, 8762 |
| Wall Seek | 5239, 8762 |
| Wander | 5242, 8762 |
| Bend | 4778, 5070 |
| Bend Links Mode | 4587, 4669, 4700, 8518 |
| Bend Modifier | 1165 |
| Bend Parameters (Links) | 4986 |
| Center of Mass Track | 4628 |
| Footstep Path | 4537 |
| Bevel | 4695, 4706, 4986, 5070 |
| Bevel Modifier | 1169 |
| Bevel Profile Modifier | 1176 |
| Deformation | 777 |
| Faces and Polygons | 2220 |
| Patches | 2394 |
| Types of Beveling | 777 |
| Bevel Polygons Dialog | 2337 |
| Bezier | 4490, 8521 |
| Controllers | 3432 |
| Handle Control | 3958 |
| Bezier Curves | 8519 |
| Bias | 4695, 4706, 4986, 5070 |
| Mental Ray Shadow Maps | 5482 |
| Shadow Bias (Glossary) | 8718 |
| Bifold Door | 539 |
| Billboard (VRML97 Helpers) | 7829 |
| Binding | 4490 |
| Objects | 3665, 3711, 3773 |
| To Space Warp | 2893 |
| Vertices | 634 |
| BioVision Motion Capture Data Files | 4925 |
| BIP Files | 4636, 4638, 4925, 5299, 8520 |
| Adding to Motion Mixer | 4007 |
| Adjust Time in Motion Mixer | 4011 |
| Adjusting in Motion Mixer | 4023 |
| Combining Motions | 4015 |
| Combining with Mixer | 4045 |
| Export with Motion Mixer | 4002 |
| Filtering in Motion Mixer | 4043 |
| Loading | 4018 |
| Path | 4018 |
| Saving | 4018 |
| Transitions in Motion Mixer | 4026 |

Index | 8781
bone tools 871
   bone editing 872
   fin adjustment 875
   object properties 877
bones 857, 4958
   and IK solvers 3669, 3732
   bone base 4684
   bone tip 4684
   display 4510
   exporting 7769
   floating bones rollout
      (Physique) 5021
   linking to follow objects 3710
   spline IK solver 3740
   stretch factor 879
   used with physique 4956, 4963
   using objects as 870, 3669
   using unlinked bones with
      Physique 4964
Boolean controller 3449
Booleans
   alignment 713
   and editable splines 655
   Boolean objects 713, 801, 823
   Boolean operation (glossary) 8527
   colinear edges 713
   combining objects that have
      materials 728
   complexity between operands 713
   coplanar faces 713
   face normals 713
   inverted meshes 713
   material IDs 713
   overlapping elements 713
   surface topology 713
   troubleshooting problems
      with 8463
      with maps and materials 713
   border edges panel 2115
   bound vertex 634, 8528
   boundary conditions (and
tendons) 5090
   bounding box (and envelope
creation) 5024
   bounding box (glossary) 8528
   bounds (inner/outer) 4970
box
   BoxGizmo 7237
      standard primitive 389
   box caustics filter 6771
   box method 5259
   branching events (particle flow) 3013
   break
      spline at selected vertex 634
      vertices 2220
   breathe option (links) 4986, 5070
   bricks 6269
   bridge dialog 2339
   bridge edges dialog 2341
   brightness and contrast effect 7149
   browse 4934
   browse buttons
      HTML help viewer 8451
   browser
      material/map 5724
      browsing from 3ds Max 7614
   brush
      styling hair with a 1099
      brush options 1989
      brush preset manager 8047
      brush presets 8044
      BSP method 6746
      BSP method, raytrace acceleration 8696
      bubble motion rollout (PArray) 3356
      bubble motion with Particle Flow 3012
      buckets, distributed rendering 6797
      buffer mode 4669
      build face 2220
   bulge angle display properties
      dialog 5053
   bulge angles 5029, 5080, 8529
      adding 4993
      changing 4993
      choosing for editing 4993
      color 5080
      deleting 4993
      parameters 5029
      setting 4993
   bulge editor 4994, 5013, 5029, 5068, 5080
   bulge sub-object 5053, 5080
bulges 5024, 5026, 8529
creating 4991
fine-tuning 4994
overview 4990
shaping 4994
workflow 4991
bump combiner
mental ray utility material 5947, 5949
bump mapping 6049, 6157
bump shader (mental ray) 6397
button
2.5D snap 2807
2D snap 2807
3D snap 2807
ActiveShade floater 6556
align 967
align camera 978
align to view 979
angle snap 2810
arc rotate 8152
array 944
bind to space warp 2893
button sets (utilities) 8225
crossing 239
current frame 8104
dolly camera 8155
dolly light 8167
dolly target 8155, 8167
edit current event 7273
edit scene event (video post) 7282
full screen 8139
get material 5687
go forward to sibling 5702
go to end 8104
go to frame 8104
go to parent 5702
go to start 8101
light falloff 8173
light hotspot 8169
lock selection 3909
make unique (Material Editor) 5692
material and map type 5706
Material Editor 5663
Material Editor options 5681
maximize viewport 8139
mirror 940
new sequence 7271
next frame 8104
normal align 973
open sequence 7272
orbit/pan camera 8155
orbit/pan light 8177
pan (Track View) 3984
pan (user interface) 8150
percent snap 2811
perspective 8157
pick material from object 5705
place highlight 976
play/stop 8102
previous frame 8101
quick align 972
quick render 6549
render scene 6539
roll camera 8159
roll light 8171
save sequence 7273
scale keys 3916, 3954
scale values 3955
select and link 3631
select and manipulate 2838
select and move 914
select and rotate 915
select and uniform scale 918
select by material 5686
select by name 206
select object 204
selection center 933
selection lock 8079
sets of modifiers 8210
show curves 8075
show end result 5701
spacing tool 953
spinner snap 2811
squash 920
transform coordinate center 934
tuck camera 8161
tuck light 8175
unlink selection 3632
use pivot point center 931
zoom 8142
zoom (Track View) 3987
zoom all 8143
zoom extents 8144
zoom extents all 8138
zoom extents all selected 8138
zoom extents selected 8144
zoom horizontal extents 3985
zoom region 8149
zoom region (Track View) 3988
zoom selected object 3972
zoom value extents 3986
button appearance 8258
BVH files 4636, 4918, 4925, 5299, 8530
by color panel 2192
by half panel 2189
by layer 8530
by normal panel 2187
by numeric panel 2191
by perspective panel 2187
by pivot distance panel 2190
by random panel 2188
by surface panel 2186
by symmetry panel 2191
by view panel 2190
bylayer 7953

C
C-Ext 451
cache operator (particle flow) 3178
CAD Manager Channel 8427
CAL files 4934
calculation order (joint precedence) 3721
calculator 46
calibrating marker files 4925
camera correction modifier 5607
camera effects rollout 6747
camera map modifier
object space 1180
world space 1067
camera map per pixel map 6452
camera match
camera match utility 5609
camera tracker
batch track rollout 4176
camera tracker utility 4158
error thresholds rollout 4175
match move rollout 4180
motion trackers rollout 4168
move smoothing rollout 4183
movie rollout 4163
movie stepper rollout 4173
movie window 4165
object pinning rollout 4185
position data rollout 4179
requirements for camera tracking 4163
troubleshooting 4189
camera viewports 119, 8154
cameras 5545, 5558
align camera button 978
animating 5585, 5599
camera object icons 5545
camera view 72
camera viewport controls 8154
choosing for vertical views 5545
common parameters 5570
create camera from view 150
depth of field parameters (mental ray renderer) 5589
dolly or target 8155
free 5554
match camera to view 978
multi-pass parameters 5590, 5594
orbit/pan 5585, 8162
placing 36
roll 8159
setting lens size 5570
target 5556
truck 8161
using clipping planes to exclude geometry 5582
using horizon to match perspective 5583
using move and rotate to aim 5581
using transforms to aim 5581
with target 5556
zoom 5585
candela 8625
canopy mode 474
cap holes modifier 1185
cap surface 2643
capsule 439
capture viewport 125
car paint material and shader 5922
car-wheel constraint 4326
cartoon shading 6132
casement window 552
category, hiding and unhiding objects by 195
caucistics 6700, 6771
caucistics (mental ray) 6680
caucistics and global illumination rollout 6771
cavity map 6469
CCB files 1984
cellular map 6279
center 907
center of mass 4468, 4663, 8530
object 4492
selecting tracks 4575
shadow 4492
shadow object 4665
shifting balance with 4550
tracks in Track View 4686
ceramic promaterial 5773
chains (kinematic) 3729, 8616
chamfer
and editable splines 634
chamfer curve (NURBS) 2569
ChamferBox 430
ChamferCyl 433
editable mesh edges 2220
glossary 8531
chamfer dialog 2344
change of value over time 3951
changed feature 42, 801, 1240, 1245, 1263, 1863, 3017, 3137, 4442, 6175, 6226, 6513, 6524, 6762, 7209, 7643, 7789, 7896, 7900, 7904, 8063, 8117, 8122, 8130, 8334, 8342, 8392, 8401, 8404
changed name 6506, 8151–8152
changing
biped body parameters 4490
biped name 4494
controller properties 3395
initial biped anatomy 4494
light objects 5334
link inheritance 3659
smoothing 383
video system 5678
changing biped to bones 4640
channel 613
channel (map) 8627
channel info
skin utilities 4213
channel info utility 6486
character 274
character assembly 254
and parameter wiring 258
create character 274
destroy character 278
insert animation 4126
insert character 279
lock/unlock 279
save character 279
skin pose 280
character modeling 1763
character studio
assign controller rollout 4666
definition 4466
file formats 5299
space warp behavior 5226
checker map 6227
child overlap 5060
children
don’t affect 3771
choose directory dialog 8284, 8293
choose renderer dialog 6584
choosing
child-to-parent precedence 3724
colors for realism 5965
parent-to-child precedence 3726
playback speed and frame rate 3390
transform center 907
CIBSE files 8532
CIE sky model 5531
cineon image file format dialog 7834
CIP (Customer Involvement Program) 8440
circle 590
circular falloff graph 7126
circular arrays 1022
circulating materials 5674
clean multimaterial utility 6492
clean remove 1378, 2112, 2279
clean up particle flow 3045
clear UVW mapping 1954
clip motion 8646
clip ratio 4023
clip replace 4061
clip timing 4023
clip transition 4896
clip controllers 5148, 8532
clip frame numbers
  motion mixer 4023
clip mode 4850
clip properties dialog 4850, 4891, 4914
clipping planes 5570, 5582, 8532
clips
  combining 4848
  create 4850
  looping with motion-capture filtering 4918
  menu 4059
  move 4850
  path 4883
ClipState dialog 5280
clone 992
clone and align tool 961
clone options dialog (particle flow) 3029, 3035
cloning 992
  clone 992
  materials 5674
  objects 985, 1007
  shape sub-object selections 620
  shift+move 998
  shift+rotate 1000
  shift+scale 1003
  sub-object geometry 2196
cloning characters 4642
close
  assembly 268
group (group menu) 260
close curve dialog 2714, 2730
cloth 4364
  cloth modifier 1204
  cloth simulation 1189
collection 4372
collision detection 1190
dT messages during simulation 1218
effect of geometry on 1201
fabric behavior 1206
garment maker modifier 1266
how it works 1200
mesh density 1202
modifier 4365
object properties 1222
overview 1189
tearing 1207
troubleshooting and error codes in garment maker 1298
  units of measure 1205
cloth modifier 1204
clothing design 1198
CLR files 8272
cmdjob.exe 7052
codec (glossary) 8533
cognitive controller 8534
  state dialog 5202
  state transition dialog 5203
cognitive controller editor 5199
cognitive controllers 5133
coincident - making splines 1763
collapse
  collapse utility 2022
  stack 1049, 2022
  vertices 2220
collapse controller tool (Track View) 3850
collapse layer 3467, 3482
collapsing
  animation tracks 4571
  layers 4741
collections
  cloth 4372
  creating and deleting 4726
deforming mesh 4396
loading and saving 4726

Index | 8787
rigid body 4261
rope 4392
soft body 4384
collision 3305
collision detection 4581
cloth 1190
collision tests (particle flow)
collision 3236
collision spawn 3241
collisions
storing and accessing 4358
collisions rollout 4427, 5256
color
and light 5322, 5328, 5424
and particle view display
operator 3028
and program state 46
and realism 5965
assigning to objects 367
balance (render effect) 7151
bleeding 6706
changing vertex color 2216
color bleeding 6601
color selector 371
copying 378, 5711
correction 6346
display 158
illegal video colors 5678
name and color rollout 8182
object color dialog 368
parameters 5431
selecting vertices by 1359, 2258
temperature (light color) 5322
color clipboard files 1984
color clipboard utility 378
color coding 4686
color controls 5991
color correction map 6346
color modifier maps 6345
color palette
vertexpaint modifier 1984
color RGB controller 3451
color selector 371, 8299
color space 6505
colors
assign random 370
biped IK/FK keys 4806
biped keys in Track View 4690
biped trajectories 4806
footsteps 4538
in Track View 4684
vertex type 4982
colors panel (customize UI) 8272
COM 4663
shadow object 4665
COM/DCOM server control utility 8248
combining animations 4848
combining motions
motion mixer 4002
combining objects 713, 801, 823
Combustion
adding workspace 6813
combustion map 6229
combustion workspace file 7835
command line
rendering 7035, 7039, 7052
startup options 7985
command panel
troubleshooting when missing 8479
command panels
create 8182
display 8217
hierarchy 8213
modify 8184
motion 8215
overview 8181
command-line options
(MAXScript) 8232
command-line options (starting 3ds
Max) 7985
command-line rendering 7035, 7052
backburner command line 7052
batch render 7035
DOS 7039
pre-render scripts 7035, 7052
commands provided only from the
keyboard 7982
comments
particle system 3031, 3193
comments on the documentation 8444
common panel
render scene dialog 6568
common parameters rollout 6568
common procedures
   video post 7255
commonality 1059
Communication Center
   accessing 8422
   opening 8427
   receiving announcements 8429
   settings 8430
compare dialog (loft objects) 792
compass helper object 2860
complete map (baking) 6849
component color - specular 8728
components
   hair and fur 1074
composite
glossary 8534
   map 6331
   material 6111
composite materials
   limitations when baking
      textures 6848
compositor
   compositor maps 6331
compound materials
glossary 8535
   kinds of 6106
compound objects 667
   BlobMesh 701
   Boolean 713, 801, 823
   conform 688
   connect 695
   mesher 794
   morph 667
   ProBoolean 801
   ProCutter 823
   scatter 674
   ShapeMerge 709
   terrain 730
compound rigid bodies 4259
concepts 6690
concrete promaterial 5780
cone 392
cone (spotlight) 5439
cone angle manipulator 2861
cone caustics filter 6771
configuration
   network rendering 6909
   configuration settings 6787
configure
   Direct3D 8325
   driver 8308, 8317
   key mode 8106
   modifier sets 8210
   OpenGL 8319
   presets (video post) 7278
   software display driver 8317
   SteeringWheels 8402
   system paths 8293
   TCP/IP (network rendering) 6938
   time 8106
   track bar 8071
   user paths 8284
   utilities button sets 8225
   ViewCube 8400
   viewports 8374
configure paths 8283
configure preset dialog 6577
configure system paths 8293
plug-ins path configuration 8296
configure user paths 8284
   bitmaps 6951
   external files 8289
   file i/o path configuration 8287
   FX files 8289
   using 6951
configure viewports
   general (+) viewport label
      menu 8117
configure weather data 5500
conform
   compound object 688
   space warp 2987
conform compound object 688
connect
   to child link 5090
   to parent link 5090
connect compound object 695
connect edges dialog 2345
connect parameter to shader dialog
   (mental ray) 6392
constant
  coordinate system 8299
  facet shading 8568
constrained point
glossary 8535
constraint solver 4283
constraint spaces 4266
constraints 3392, 3574, 4264
  and bones 857
  and cloth 1207
  angular dashpot 4277
  attachment 3575
  axis constraints 910, 8039
  breakable 4282
  car-wheel 4326
  concepts 4265
  constraint solver 4283
  constraint spaces 4266
  cooperative constraints 4281
  deformable constraints 4398
  hinge 4307
  linear dashpot 4273
  link 3580
  look-at 3585
  orientation 3592
  path 3596
  point-path 4333
  point-point 4313
  position 3602
  prismatic 4320
  rag doll 4286
  simple constraints 4268
  spring 4269
  surface 3607
contact object (particle flow) 8536
contacting us 17
container 7395, 8536
  local container 8620
  source container 8725
  unique container 8752
container commands 8003
containers (glossary) 8537
containers submenu 8003
continuity 4706, 4986, 5070, 8537
  continuity level (glossary) 8537
  NURBS concepts 2440
continuous time frame 3046
contour shading
  mental ray 6714
contrast filter (video post) 7311
contrast sampling thresholds 6735
control lattice (glossary) 8538
control objects (IK) 3661, 3680
control points 5029, 5060, 5080, 5090,
  8539
  and bulges 4994
  and envelopes 4979
  rotating 4979
control vertex (CV) 8543
controller 8540
controller menu, Track View 3849
controller toolbar, Track View 3884
controller type 3482–3483
controller window, Track View 3817
controllers 3401, 3403, 3405, 3424,
  3558, 4590
  assigning 3397
  audio 3425
  barycentric morphing 3429
  bezier 3432
  block 3436
  Boolean 3449
  categories of 3392
  changing length 3792
  changing properties 3395
  changing range 3792
  collapsing procedural
    controllers 3850
  color RGB 3451
  copy 3894
  default settings 8346
  Euler XYZ rotation 3453
  expression 3456
  float script 3552
  frame duration 3792
  general-purpose controllers 3401
  limit 3484
  linear 3496
  list 3497
  local euler XYZ rotation 3501
  look at 3502
make unique 3902
master point 3505
morph 3410
motion capture 3509
noise 3519
on/off 3522
paste 3895
point3 script 3552
point3 XYZ 3451
position script 3552
position XYZ 3524
properties 3918
PRS 3526
reaction 3527
rotation script 3552
scale script 3552
scale XYZ 3550
script 3552
slave 3436
smooth rotation 3558
specifying default 3400
TCB 3563
time duration 3792
transform script 3552
types of 3391, 3897
understanding 3392
viewing types 3392
waveform 3566
working with 3391
xref 3570
controlling
colors 3409
display performance 81
flipping on path 3596
IK precision 3713
object display 158
position 3407
rotation 3408
time 3385
transforms 3406
viewport rendering 79
controls
camera viewport 8154
light viewport 8165
perspective and orthographic 8141
special 46
viewport 8135
conversion modifier
turn to mesh 1825
turn to patch 1827
turn to poly 1830
convert 4669
between footstep and freeform
animations 4570
data in motion capture buffer 4925
from buffer 4925
to freeform 4571
to freeform/footsteps dialogs 4795
convert curve dialog 2708
convert surface dialog 2711
convert to mesh 3194
converting
event-level selection to particle
level 3040
TRC into CSM 4156
convex hull property (glossary) 8540
cool (glossary) 8541
cooperative constraints 4281
coordinate display (mouse
position) 8081
coordinate space 8541
biped 8541
coordinate system 922
coordinates
absolute/offset display 8082
barycentric (glossary) 8517
coordinate display 8081
coordinate system 922
coordinates rollouts 6201, 6278
mapping 5636
copies 982
creating 981
overview 982
copy 5080, 5090
a material, map, bitmap, or
color 5647
footsteps 4778
pose 4717
poses and postures 4619
posture 4717
selected cross section 5029
copy biped animation to clip
dialog 4063
copy controller 3894
copy keys 3953
copy layer 3465, 3467
copy map dialog 5710
copy tangent handles 634
copy time (Track View) 3933
copy tracks 4649
copy/paste rollout 4726
copying
  actions, events (particle flow) 3019, 3029, 3032
  and pasting items/objects 3946, 3948
  colors 378, 5711
  copy controller (Track View) 3894
  copy time (Track View) 3933
  copy track (Track View) 3933
  joint parameters 3780
  materials 5641, 5674
  modifiers 3894
  patch surface 2360
  presets 7564
  splines 655
  transform keys 3382
  correcting geometry 2873
  CPY files 5299
  crash recovery 62
  create
    at link's joint 5077
    at parent's joint 5077
  clip 4850, 4891
  envelopes 5024
  footsteps 4774
  keys for inactive footsteps 4531, 4778
  layer 4741
  random motion 4868, 4907
  script 4858, 4896
  separate tracks for biped arms 4755
  shared motion flow 4876, 4909
  transition 4891, 4900
  unified motion 4873
  create assembly dialog 263
  create biped roll out 4490
  create bitmap 6466
  create camera from view 150
  create character 274
  create key dialog 3383
  create layer 3467, 3483
  create material preview dialog 5711
  create menu 730, 8008
    AEC objects 474, 482, 491, 511, 514, 519, 522, 535, 537, 539, 549, 552, 554, 556, 558, 560
    cameras 5545, 5554, 5556
    compound objects 674, 695, 701, 709, 713, 742
    extended primitives 421
    lights 5314
    NURBS 2456, 2460, 2466, 2473
    particles 3292
    patch grids 2408, 2410, 2413
    shapes 572, 584, 588, 590–592, 596–597, 599–600, 605, 607, 611, 613, 615, 617–618
    standard lights 5398–5399, 5402, 5405, 5407, 5410
    standard primitives 388
    create method rollout 5259
    create multiple footsteps 4774, 4781
      jump 4774, 4791
      run 4774, 4787
      walk 4774, 4781
    create new layer 7975
    create new map files 3479
    create out of range keys 3867
    create out-of-range keys utility (Track View) 3923
    create panel 360, 8182
      cameras 5545
      helpers 2837
      lights 5314, 5348
      space warps 2887
      systems 856
    create position lock key 3432
    create rotation lock key 3432
    create shape (editable patch) 2397

8792 | Index
creating
1-rail sweep surface  2663
2-rail sweep surface  2673
a script  4888
an object  364
animated material previews  5708
arrays  981
biped character  4490
biped skin  4946
blend surface  2614
bulges  4991
cap surface  2643
chamfer curve  2569
circular and spiral arrays  1022
copies  981
crowd system  5105
curve sub-objects  2549
custom sample object  5660
CV curve on surface  2593
CV curve sub-object  2552
CV surface  2460
CV surface sub-object  2606
dependent curve point  2698
dependent curve-curve point  2704
dependent curves  2549
dependent offset point  2696
dependent surface point  2701
dependent surface-curve point  2707
dependent surfaces  2603
editable mesh edges from
shapes  2209
editable mesh vertices  2220
extrude surface  2628
tenders
fillet curve  2574
fillet surface  2689
footsteps  4527
footsteps automatically  4526
freeform animations  4571
independent surfaces from NURBS
  curve objects  2480
individual footsteps  4527
iso curve  2584
lathe surface  2631
linear arrays  1018
mirror curve  2566
mirror surface  2624
models with NURBS  2444
multicurve trim surface  2684
multiple footsteps  4526
multiple slices  2235
multisided blend surface  2683
normal projected curve  2586
NURBS curves from splines  2481
NURBS CV curve  2473
NURBS models  2419
NURBS point curve  2466
NURBS sub-objects  2423
NURBS surfaces  2454, 2483
objects (basics)  358
offset curve  2564
offset surface  2621
particle emitter  3297
particle system  3295
particles  3052, 3056
physique links and envelopes  5024
physique modifier  4966
point curve on surface  2597
point curve sub-object  2556
point curve with curve fit  2558
point sub-objects  2417, 2694
point surface  2456
point surface sub-object  2610
primitives from the keyboard  386
ruled surface  2640
shapes  572
skin  4946
special user account (network
  rendering)  6944
sub-objects  2603
surface edge curve  2601
surface offset curve  2582
surface sub-objects  2603
surface-surface intersection
curve  2578
tendons  4995
transform curve  2560
transform surface  2612
U loft surface  2646
UV loft surface  2656
vector projected curve  2589
creation method rollout  745
creation parameters 4490
glossary 8542
cross fade compositor (video post) 7385
cross section editor viewport options 5080
cross sections 607, 611, 613, 615, 617–618, 1299, 1763, 5018, 5029, 5060, 5080, 5090, 8542
and bulges 4994
and envelopes 4979
and tendons 5090
initialization 5048
parameters 5029
view (bulge editor) 4994
cross-hairs cursor 8299
crossing selection 239
CrossSection modifier 1299
crowd behaviors 5115, 5123
creating crowd systems 5105
crowd object 5110
definition 8542
delegate object 5115
keyboard shortcuts 5153
with bipeds 5136
crowd animation and bipeds 5162
ClipState dialog 5280
motionclip parameters dialog 5278
orientation behavior 5213
path follow behavior 5217
repel behavior 5221
scripted behavior 5223
seek behavior 5224
speed vary behavior 5227
surface arrive behavior 5229
surface follow behavior 5233
synthesis dialog 5268
user interface 5152
vector field space warp 5258
wall repel behavior 5236
wall seek behavior 5239
wander behavior 5242
working with 5104
crowd behaviors
path follow 5120
seek 5120
wall seek 5120
crowd helper object 5162, 8542
crowd object
associate bipeds with delegates dialog 5185
behavior assignments and teams dialog 5188
behavior rollout 5208
collisions rollout 5256edit multiple delegates dialog 5182
geometry rollout 5257
global clip controller 5257
icon size 5257
object/delegate associations dialog 5179
priority rollout 5248
scatter objects dialog 5165
select behavior type dialog 5196
select delegates dialog 5198
set start frames dialog 5251
setup rollout 5163
smoothing rollout 5253
solve rollout 5244
state dialog 5202
state transition dialog 5203
crowd simulation
avoid behavior 5209
cognitive controller 5199
solving 5129
crowd system 8543
CS amplitude option (links) 4986, 5070
CSM files 4636, 4918, 4924–4925, 5299, 8543
cube method 5259
cubic morph controller 3410
CUI files 8276, 8279–8280
current bulge angle 5029, 5080
current event (video post) 7274
current frame 8068, 8104
current value editor 3867, 3928
currentdefaults.ini 8246
currently assigned links only 5096
currently installed driver 8308
curve editor 3790, 3804, 4801
display menu 3862
Index | 8795
IES sun 5506
DDS files 7836
deactivate footsteps 4531, 4778
deactivating
  jobs in the queue 7017
  servers in the queue 7018
decay 5431
default
  controller settings 3400, 8346
  controllers 3400
  heights 2782
  keyboard shortcuts 1879, 3810, 4811, 5022, 5153, 8419
  lighting 5314, 5319
  material settings 5691
  tangent types 8098
default color 5080
default material 5858
default scanline rollout 6589
default sound 3833
default tangent types 8098
defaults
  setting 8246
  setting and changing 59
  switching 8244
define
  append 4896
  inser below 4896
  insert above 4896
  script 4896
defining
  search terms (HTML help viewer) 8446
time tags 8085
deflector space warp 2959
deflector space warps
deflector 2959
PDynaFlect 2941
POmniFlect 2935
SDeflector 2953
SDynaFlect 2948
SOmniFlect 2946
UDeflector 2956
UDynaFlect 2951
UOmniFlect 2948
deform
  deform bevel 777
  deform fit 779
  deform scale 771
  deform teeter 774
  deform twist 773
deformable bodies 4363
cloth 4364
  constraints 4398
  deforming meshes 4394
  ropes 4386
  soft bodies 4374
  soft selection 4408
deformable constraints 4398
  attach to deforming mesh 4406
  attach to rigid body 4404
  fixing vertices 4401
  keyframe points 4402
deformable envelopes 4470, 4970, 4984, 5018, 5024, 5060, 8546
deformation 4965, 8547
deformation spline 4966, 4970, 4986, 5068, 8547
deformations (and loft objects) 781
deforming meshes 4394
collection 4396
degree 2440, 8549
degree of freedom and rotating
  links 4581
delegate
  adjusting parameters 5115
  geometry parameters rollout 5155
  motion parameters rollout 5156
delegates 5110
  definition 8549
  helper objects 5154, 8549
  using bipeds with 5136
delete 243, 5080, 5090
  biped 4510
  bulge angle 5029, 5080
  bulge angles 4993
  bulge cross sections 4994
  clip/transition 4850, 4891
  control points 5029
  controller 3899
cross section slice 5029
current event (video post) 7274
footsteps 4537, 4778
key 4609, 4706, 4717
keys 3906–3907, 8071
layers 4741
maps 5726
material 5726
mesh modifier 1305
operator (particle flow) 3067
patch modifier 1307
Schematic View 7952
script 4858, 4896
selected keys (track bar) 8071
spline modifier 1308
tendons 4995
time (Track View) 3932
Track View 3990
transition 4900
transitions 4865
delete keys 3792, 3907
delete selected animation 8059
delete time (Track View) 3932
delete Track View 3990
delete twist pose 4695
delete UVW mapping 1954
deleting
blocks of time 3932
editable mesh edges 2220
editable mesh vertices 2220
isolated editable mesh vertices 2220
jobs in the queue 7019
particles 3067
patch surfaces 2360
splines 655
vertices 634
density map 6469
dent map 6286
dependencies (views menu) 148
dependent 8549
dependent sub-objects 2433, 8550
depot (particle view)
display of 3023
glossary 8550
depth of field 5563, 5590, 6694, 6747, 7159
description panel (particle view)
display of 3023
glossary 8551
deselect all 227
Design Web Format 7700
designing clothing (garment maker) 1198
designing materials 5620
destination clip
transition editor 4900
destination directory 4943
destroy character 278
detach 5090
detach (assembly) 270
detach (group menu) 262
detach dialog (edit poly) 1423
detach dialog (NURBS curve/surface) 2715
editable mesh vertices 2220
editable patches 2394
patch surface 2360
dgs material shader (mental ray) 6398
diagnostics
mental ray renderer 6795
dialog
asset tracking 7586
bevel polygons 2337
bitmap pager statistics 7642
chamfer 2344
color selector 371
connect edges 2345
extrude polygons 2349
filter selected euler tracks (Track View) 3926
flatten mapping 1893
MAXScript debugger 8231
mixer transition editor 4072
normal mapping 1895
pelt map parameters 1898
pick nodes 4077
pivot selection 4711
prompts 7604
relax tool 1906
render UVs 1910
select objects 206
shared motion flow 4876, 4909
<table>
<thead>
<tr>
<th>spline map parameters</th>
<th>1916</th>
</tr>
</thead>
<tbody>
<tr>
<td>track sets editor</td>
<td>3977</td>
</tr>
<tr>
<td>unfold mapping</td>
<td>1926</td>
</tr>
<tr>
<td>unwrap options</td>
<td>1927</td>
</tr>
<tr>
<td>weight tool</td>
<td>1697</td>
</tr>
<tr>
<td>XRef objects</td>
<td>7456</td>
</tr>
<tr>
<td>dialogs</td>
<td></td>
</tr>
<tr>
<td>bitmap proxies</td>
<td>7601</td>
</tr>
<tr>
<td>global settings and defaults for bitmap proxies</td>
<td>7601</td>
</tr>
<tr>
<td>toggling</td>
<td>7983</td>
</tr>
<tr>
<td>Did You Know balloon messages</td>
<td>8431</td>
</tr>
<tr>
<td>dielectric material shader (mental ray)</td>
<td>6403</td>
</tr>
<tr>
<td>different ambient and different diffuse materials dialog</td>
<td>7639</td>
</tr>
<tr>
<td>diffuse</td>
<td></td>
</tr>
<tr>
<td>diffuse color (glossary)</td>
<td>8552</td>
</tr>
<tr>
<td>diffuse distribution</td>
<td>5368</td>
</tr>
<tr>
<td>diffuse level</td>
<td>5999</td>
</tr>
<tr>
<td>diffuse level mapping</td>
<td>6033</td>
</tr>
<tr>
<td>diffuse mapping</td>
<td>6031</td>
</tr>
<tr>
<td>roughness mapping</td>
<td>6035</td>
</tr>
<tr>
<td>diffuse map (baking)</td>
<td>6850</td>
</tr>
<tr>
<td>diffuse parameters rollout</td>
<td>6825</td>
</tr>
<tr>
<td>diffuse texture element rollout</td>
<td>6825</td>
</tr>
<tr>
<td>direct manipulation mode</td>
<td>2241</td>
</tr>
<tr>
<td>Direct3D driver</td>
<td>8313, 8323, 8325</td>
</tr>
<tr>
<td>Direct3D driver setup dialog</td>
<td>8323</td>
</tr>
<tr>
<td>directional parameters</td>
<td>5436</td>
</tr>
<tr>
<td>directories</td>
<td></td>
</tr>
<tr>
<td>for network rendering</td>
<td>6947</td>
</tr>
<tr>
<td>mounting</td>
<td>6950</td>
</tr>
<tr>
<td>sharing</td>
<td>6949</td>
</tr>
<tr>
<td>DirectX 10</td>
<td>8325</td>
</tr>
<tr>
<td>DirectX 9 shader material</td>
<td>6175</td>
</tr>
<tr>
<td>DirectX 9 shaders, FX file</td>
<td>8530, 8589, 8771</td>
</tr>
<tr>
<td>DirectX shaders</td>
<td>5771, 6175, 6179</td>
</tr>
<tr>
<td>dirt map</td>
<td>6469</td>
</tr>
<tr>
<td>disable layer</td>
<td>3465, 3467</td>
</tr>
<tr>
<td>disable particle system</td>
<td>3009</td>
</tr>
<tr>
<td>disabling playback</td>
<td>4968</td>
</tr>
<tr>
<td>disassemble</td>
<td>269</td>
</tr>
<tr>
<td>disc (circular) area light</td>
<td>5421</td>
</tr>
<tr>
<td>displace</td>
<td></td>
</tr>
<tr>
<td>disp approx modifier (OSM)</td>
<td>1310</td>
</tr>
<tr>
<td>displace mesh (world space)</td>
<td>1068</td>
</tr>
<tr>
<td>displace modifier (OSM)</td>
<td>1313</td>
</tr>
<tr>
<td>displace NURBS (world space)</td>
<td>1071</td>
</tr>
<tr>
<td>displace space warp</td>
<td>2930</td>
</tr>
<tr>
<td>displacement mapping</td>
<td>1310, 6059, 6157</td>
</tr>
<tr>
<td>displacement shading</td>
<td></td>
</tr>
<tr>
<td>mental ray renderer</td>
<td>6713</td>
</tr>
<tr>
<td>display</td>
<td></td>
</tr>
<tr>
<td>backface cull</td>
<td>8218</td>
</tr>
<tr>
<td>coordinate display</td>
<td>8081</td>
</tr>
<tr>
<td>cross-hairs cursor</td>
<td>8299</td>
</tr>
<tr>
<td>display controls for NURBS models</td>
<td>2486</td>
</tr>
<tr>
<td>display driver (specifying at startup)</td>
<td>7985</td>
</tr>
<tr>
<td>display floater</td>
<td>8218</td>
</tr>
<tr>
<td>display floater (Schematic View)</td>
<td>7946</td>
</tr>
<tr>
<td>display image</td>
<td>6535</td>
</tr>
<tr>
<td>display operator (particle flow)</td>
<td>3186</td>
</tr>
<tr>
<td>display performance</td>
<td>81</td>
</tr>
<tr>
<td>display plane</td>
<td>2791</td>
</tr>
<tr>
<td>display properties rollout</td>
<td>164</td>
</tr>
<tr>
<td>grid settings</td>
<td>8084</td>
</tr>
<tr>
<td>hide/unhide (glossary)</td>
<td>8599</td>
</tr>
<tr>
<td>hide/unhide objects</td>
<td>8218</td>
</tr>
<tr>
<td>key bracket display</td>
<td>8346</td>
</tr>
<tr>
<td>layer properties</td>
<td>7955</td>
</tr>
<tr>
<td>line parameters for NURBS</td>
<td></td>
</tr>
<tr>
<td>surfaces</td>
<td>2489</td>
</tr>
<tr>
<td>marker</td>
<td>4925</td>
</tr>
<tr>
<td>material color</td>
<td>158</td>
</tr>
<tr>
<td>nth frame</td>
<td>8308</td>
</tr>
<tr>
<td>NU scale warning</td>
<td>8299</td>
</tr>
<tr>
<td>object color</td>
<td>158</td>
</tr>
<tr>
<td>options/preferences</td>
<td>4494, 4510, 4659, 4684, 4983, 5060, 5080</td>
</tr>
<tr>
<td>properties</td>
<td>8218</td>
</tr>
<tr>
<td>reflectance</td>
<td>5669</td>
</tr>
<tr>
<td>selection floaters</td>
<td>209</td>
</tr>
<tr>
<td>stack collapse warning</td>
<td>8299</td>
</tr>
<tr>
<td>topology-dependence warning</td>
<td>8299</td>
</tr>
<tr>
<td>track bar</td>
<td>8079</td>
</tr>
<tr>
<td>trajectories</td>
<td>4657</td>
</tr>
</tbody>
</table>
pseudo alpha compositor (video post) 7386
pseudo alpha filter (video post) 7379
range bar (video post) 7279
ranges (Track View) 3943
scene event (video post) 7282
simple additive compositor (video post) 7387
simple wipe compositor (video post) 7388
simple wipe filter (video post) 7379
starfield filter (video post) 7381
tag 8087
time 3929, 4801
time tag dialog 8087
transition 4896
transitions 4865
edit commands 239, 5060
and envelopes 4979
edit curve on surface dialog 2716
edit geometry rollout
   editable mesh 2220
   editable poly 1409, 2311
edit keys 4801
edit keys (Track View) 3860, 3906, 3916
edit keys mode 3807
edit macro button dialog 8258
edit menu 7999
   clone 992
delete 243
   edit named selections 219
fetch 242
hold 242
move 914
object properties 283
region 237
rotate 915
scale 917
select all 227
select by 229
select by color 229
select by layer 230
select by name 229
select invert 228
select none 227
select region crossing 237
select similar 228
selection method 235
transform type-in 899
undo/redo 240
edit menu (particle view) 3018
edit menu (Schematic View) 7930
edit modifiers
   and editable objects 1052
   edit mesh modifier 1321
   edit poly modifier 1332
edit multiple delegates dialog 5182
edit named selections 219
edit normals
   edit normals modifier 1322
edit object dialog 4205
edit object list dialog 4211
edit poly
   align geometry dialog 1422
   bevel polygons dialog 2337
   border 1389
   bridge borders/polygons dialog 2339
   bridge edges dialog 2341
   chamfer dialog 2344
   connect edges dialog 2345
   detach dialog 1423
   edge 1368
   extrude edges dialog 2350
   extrude polygons along spline dialog 2347
   extrude polygons dialog 2349
   extrude vertices dialog 2350
   hinge from edge dialog 2352
   inset polygons dialog 2353
   meshsmooth selection dialog 2354
   object 1357
   paint deformation rollout 2333
   polygon/element 1395
   preserve map channels dialog 2355
   preview selection 1356, 2254
   relax dialog 2357
   tessellate selection dialog 2358
   vertex 1359
   weld dialog 2359
   weld edges dialog 2359

Index | 8801
weld vertices dialog 2359
edit poly modifier 1332
    selection rollout 1346
edit ranges 3943
edit ranges mode (Track View) 3808, 3860
edit soft selection 2019
edit texture surface dialog 2719
edit time mode (Track View) 3860, 3929
edit time tag 8087
edit track set 3977
edit UVWs dialog 1856
    menu bar 1871
edit wire 3612
editable mesh 2192, 8559
    aligning 2220
    edge 2209
    edit geometry rollout 2220
    element 2216
    exploding 2220
    face 2216
    object 2200
    polygon 2216
    vertex 2203
editable objects and edit modifiers 1052
editable patch 2360
    attach 2394
    changing vertex type 2394
    deleting vertices 2394
    detach 2394
    edge 2382
    element 2391
    geometry rollout 2394
    handle 2380
    object 2370
    patch 2385
    vector 2380
    vertex 2373
    visibility of 2397
editable poly 2240
    bevel polygons dialog 2337
    border 2289
    bridge borders/polygons
        dialog 2339
    bridge edges dialog 2341
    chamfer dialog 2344
    connect edges dialog 2345
    constraints 1410, 2313
    edge 2269
    edit geometry rollout 1409, 2311
    extrude edges dialog 2350
    extrude polygons along spline
        dialog 2347
    extrude polygons dialog 2349
    extrude vertices dialog 2350
    glossary 8559
    hinge from edge dialog 2352
    inset polygons dialog 2353
    meshsmooth selection dialog 2354
    object 2256
    paint deformation rollout 2333
    polygon/elemen 2296
    preserve map channels dialog 2355
    preview selection 1356, 2254
    relax dialog 2357
    selection information 1357, 2256
    selection rollout 2245
    sub-object constraints 1410, 2313
    subdivision displacement
        rollout 2330
    subdivision surface rollout 2325
    tessellate selection dialog 2358
    vertex 2258
    weld dialog 2359
    weld edges dialog 2359
    weld vertices dialog 2359
editable spline 620, 1763
    and overlapping vertices 620
    attaching to 646
    general rollout (for object and
        sub-objects) 620
    identification numbers and 620
    object 630
    rendering options 620
    segment 646
    setting vertex type 634
    spline 655
    vertex 634
    vertex area selection 620
editing
    action parameters (particle
        view) 3027
active footsteps in time 4542
animation 3418
bones 872, 875
curve cv sub-objects 2503
curve sub-objects 2518
fins (bones) 875
footstep placement 4537
footsteps 4774
footsteps in time 4538
footsteps in Track View 4538
modifier stack 1049
named selection sets 185
point sub-objects 2496, 2694
strokes 8412
surface cv sub-objects 2509
surface sub-objects 2530
time (Track View) 3929
time tags 8087
wall objects 500
editing track sets 3974
editor
cognitive controller 5199
editable patch
selection rollout 2366
effects 7055
auto secondary lens effects 7097
blur lens effects 7141
brightness and contrast lens effects 7149
color balance lens effects 7151
depth of field lens effects 7159
effects (rendering menu) 7058
effects panel 7058
environment and effects
dialog 7056
file output lens effects 7152
film grain lens effects 7155
glow lens effects 7073
lens effects 7068
manual secondary lens effects 7105
ray lens effects 7090
rings lens effects 7080
star lens effects 7112
streak lens effects 7119
elements 8559
of rendered textures 6848
rendering 6806
elements panel 2120
elipse 591
email notification
network rendering 6965
rendering 6578
emission rollout (particle view) 3037
emit start/stop values, and frame rate 3055
emitter (particle flow) 3034, 8560
empty flow (particle flow) 3232
enable ease or multiplier curve toggle 3966
enable layer 3467
encapsulated PostScript files 7839
end effector 4958
end effectors 3665, 3669, 3714, 3729, 8560
animating 3710
linking to parent 3710
entering frames 3982
entire link 5029, 5080
entities
AutoCAD 7503
envelope parameters 5060
envelope sub-object 5049, 5057
exclude envelopes dialog 5051
envelopes 5060, 8561
adjusting shapes 4974
and control points 4979
and cross sections 4979
and edit commands 4979
and weighted vertices 4470
blending types 4974
choosing default fit 4966
choosing default types 4966
copying 4974
copying to mirrored link 4979
display options 4983
exclude for selected links 5051
excluding influence 4974
overview 4970
scaling size 4974
selecting 4974
types of 4970
upating display manually 4983
using transforms with 4974
working with 4984
working with both envelope types 4985
working with rigid 4985
environment 7162
and raytrace materials 6065
environment map (glossary) 8561
environment panel 7163
exposure controls 7207
environment and effects dialog 7056
effects panel 7058
environment panel 7163
environment effect
  fire 7171
  fog 7182
  volume fog 7188
  volume light 7196
environment map
  assigning 7167
  definition 8561
  final gather light source 6762
environment probe/chrome ball (mi) shader 6440
environment probe/gray ball (mi) shader 6441
environment shader (mental ray) 6406
environment/background camera map (mi) shader 6437
environment/background switcher (mi) shader 6435
environments 7055
  environment and effects dialog 7056
EPS files 7839
epw file 5500
  select time period 5502
error threshold (camera tracker) 4175
errors 62
garment maker 1298
euler filter 3926
euler rotation 4631, 4693
controller 4581
Euler XYZ rotation controller 3453
euler/tangent 4631
events (particle flow)
  and action sequence 3013
  branching 3013
  event display 3027, 3031, 8566
  event level 8567
glossary 8564
  inputs 8610
  local 8623
  notating 3193
  properties 3031
events (video post) 7276
every step update script (particle flow) 3042
exclude
  exclude left end point (Track View) 3938
  exclude right end point (Track View) 3940
  exclude/include lights 5341, 5445
  exclude envelopes dialog 5051
  exclude left end point (Track View) 3938
  exclude option 4974, 5051
  exclude right end point (Track View) 3940
excluding layers 7568
excluding particles from lighting 3009
execute network rendering 6922
execute sequence (video post) 7276
exit command (file menu) 7612
expanding animation tracks 4571, 4575
expert mode 157
explicit axis keys 3404, 3526
explode
  assemblies 269
  editable mesh
    objects/sub-objects 2220
  explode angle threshold 2220
  groups 261
  objects into faces 2991
  particle system 2914
  splines 655
  explode angle threshold 2220
  exploding objects 2914
  explosion 2914
  explosions 3008
extruded shapes 445, 451
eyedropper tool 5705

F
f-curves 4475, 4816
f-stop 5562, 6694, 6747
face - definition 8568
face extrude modifier 1428
face/edge thresholds (optimize modifier) 1557
faces
assigning to smoothing groups 2216
beveling and extruding 2220
creating 2220
dividing 2220
tessellating 2220
faceted (glossary) 8568
facial animation 5003
facial expression 1518
fade filter (video post) 7312
fade in/out (lights) 5431
falloff 5024, 5060, 5070, 5439
falloff map 6294
glossary 8604
light falloff 8173
family elements
from Revit 7528
rendering properties 7528
fast adaptive antialiaser 6095
fast view display mode 8374
favorite location dialog 7628
favorites
asset browser 7628
HTML help viewer 8452
Favorites links (InfoCenter) 8429
FBX
exporting 7706
importing 7706
FBX files 4640
feedback about the documentation 17, 8444
fence selection region 232
fetch (edit menu) 242
FFD soft bodies 4381
FFD(box) space warp 2962
FFD(cyl) space warp 2969
FFDs 4470, 8569
and physique 5011
FFD 2x2x2 1431
FFD 3x3x3 1431
FFD 4x4x4 1431
FFD modifier 1431
FFD select modifier 1441
FFD(box) modifier 1436
FFD(box) space warp 2962
FFD(cyl) modifier 1436
FFD(cylinder) space warp 2969
FGM files 8569
field of view
flyout 8146
glossary 8569
field-of-view
field-of-view button 8146
fields (glossary) 8570
FIG (figure) files 4669, 4934
saving and loading 4513
FIG files 5299
loading 4680
saving 4676
figure mode 4470, 4669, 4758, 4762, 8572
figure structure 4934
file corruption 8459
file formats 4636, 5299
file i/o path configuration 8287
file link 8495
advanced settings 7553
basic settings 7549
basics 7491
excluding layers 7568
file link settings dialog 7549, 7561
including layers 7568
presets 7549, 7553
tips for using 7495
working with drawing files 7492
xref resolution 7569
file management
Autodesk Vault 8438
file menu 7431
archive 7445
exit 7612
export 7581
export selected 7583
file properties 7609
import 7446
load animation 4107
merge 7572
merge animation 4126
new 7432
open 7434
replace 7578
reset 7433
save 7440
save animation 4122
save as 7441
save copy as 7443
save selected 7444
summary info 7607
view image file 6535
XRef objects 7450
XRef scene 7477
file output 7152
file properties 7609
file types
.mfe file 4888
BIP 4638, 8520
BVH 8530, 8632
CAL 4934
CSM 4924, 8531, 8543, 8632
CWS 6813
FIG 4669, 4934
MNM 4919, 4924
MOC 4925, 4934
PHY 4997, 5013, 8685
STP 4646
file-handling commands 7431
files
backup and saving 8305
compressed 8305
finding 7634
incremental saves 8305
managing 51
mismatched units 8372
motion flow editor 4883
preferences settings 8305
recent in file menu 8305
fillet
and editable splines 634
fillet curve 2574
fillet surface 2689
fillet/chamfer modifier 1442
glossary 8572
film grain effect 7155
filter color mapping 6043
filter color/filter opacity (glossary) 8573
filtering 4475
euler tracks (Track View) 3926
motion capture and marker data 4934
trackgroups 4086, 4088
tracks in motion mixer 4018
filtering bitmaps 8574
filtering character animation 8575
filters 6735
add filter event (video post) 7295
cautics 6771
creating custom 187
destroy filter event (video post) 7295
evironment backgrounds (viewports) 8308
euler tracks (Track View) 3926
filter (track bar) 8071
filter combinations dialog 215
filtering selections 214
filters button (Track View) 3888
filters dialog (Track View) 3889
key 8093
sampling 8705
filters panel 4843
final gather map (FGM file) 8569
final gather maps 6778
final gather rollout 6760
final gathering 6706, 6760, 8576
caching 6778
evironment map as light source 6762
flicker reduction 6764
final step update script (particle flow) 3042
find target test (particle flow) 3247
finding errors 4823
finding, next/previous key 4706
fine-tuning envelopes 4979
fingers option 4494
fins (bones) 857, 875
fire environment effect 7171
first vertex 634, 8578
fit 5060, 5090
fit (deformation) 779
fit to existing 4934
fix ambient utility 7639
fix panel 4838
fix vertices constraint 4401
fixed
  transition editor 4900
fixed width text button 8299
fixed window 554
fixing errors 4475, 4823, 4838
fixing motion errors 4843
fixing problems 8459
flag properties dialog (Material Editor) 6264
flag with black 8342
flat mirror map 6358, 6683, 8579
flatten footsteps 4934
flatten mapping 1875, 1893
flatten sides 2220
flex modifier 1445, 1462
flexibility (neck and spine) 4494
flight studio openflight 7707
flip normals 380, 2216
float controllers 3405
float limit controller 3484
float script controller 3552
floaters 899, 8218
  bone tools 871
  display floaters 8218
  Schematic View display floater 7946
  selection floaters 209
  transform type-in 899
floating 8555
floating bones 4964, 5021
flows (particle flow) 3229
  glossary 8581
  preset 3230
FLT files 7707
fluorescence (glossary) 8581
flyouts 46
  align 966
  arc rotate 8152
  default tangent types 8098
  dolly camera/target 8155
  dolly light/target 8167
  field of view 8146
  flyout (glossary) 8582
  orbit/pan light 8177
  quick render 6547
  select and scale 917
  selection region 212
  timing preferences 8299
  use center 930
  zoom extents 8144
  zoom extents all 8138
focus plane 6694
fog
  VRML97 helper 7814
fog environment effect 7182
folder
  motion flow editor 4883
  foliage 468, 474
follow object
  binding to 3711
  glossary 8583
follow/bank utility 4134
foot states 4468, 4669, 4724, 8583
footcandle 8606
footstep
  adaptation 4774
  animation (glossary) 8584
  animation workflow 4515
  converting to freeform 4570
  creation 4527
  edge selection 4797
  editing 4774
  keys 4535
  leg states 4535
  timing (gait parameters) 4524
footstep creation 4468, 4669, 4774
  create multiple footsteps
    (jump) 4791
  create multiple footsteps (run) 4787
  footstep operations 4778
footstep extraction 4934
footstep keys
  body horizontal 4535
  body turning/rotation 4535
  body vertical 4535
footstep method 4468
footstep mode 4669, 4774
footstep operations rollout 4669, 4778
footsteps 4795
  activating 4531
  airborne period 4565
  appending 4527
  bending path 4537
  convert to 4795
  creating 4527
  creating automatically 4526
  creating multiple 4526
  deleting 4537
  display 4510
  editing in time 4538
  editing placement 4537
  footstep mode dialog 4797
  freeform period between 4565
  moving and rotating 4537
  saving 4563
  selecting in Dope Sheet mode 4538
  selecting in viewports 4537
  timing 4538
  timing gait parameters 4524
footsteps method 8584
force operator (particle flow) 3189
force space warps
  displace 2930
  drag 2908
  gravity 2923
  motor 2898
  path follow 2919
  PBomb 2914
  push 2894
  vortex 2903
  wind 2926
forward kinematics 4704, 8585
  and IK 3661
  manipulating hierarchies with 3642
forward kinematics and bipeds 8585
FOV
  field-of-view button 8146
fps 2760
fracture 4349
  tips 4356
fragmentation (particle flow) 3008
frame
  transition editor 4900
frame rate 3390, 8106, 8585
  and emit start/stop values (particle flow) 3055
frames (snapping) 3907
frames per second 8390
free camera 5554
free directional light 5407
free key defaults 4706
free lights
  direct 5407
  directional 5407
  spot 5402
free-form deformation (FFD)
  box 2962
  box/cyl modifier 1436
  cylinder 2969
  modifier 1431
  select modifier 1441
freeform 4795
  animation 4602
  convert to 4795
  converting to footsteps 4570
  inserting period between footsteps 4565
  method 4468
  setting period in footstep animations 4565
freeform animation 4571, 4801, 8586
freeform method 8586
freeform modeling 2155
freeze
  freeze rollout (display panel) 163
  freeze/unfreeze (glossary) 8587
  freezing/unfreezing objects 191, 8218
  rotation 8061
  transform 8060
freeze non-selected curves (Track View) 3970
freeze rotation 8061
freeze transform 8060
frequently asked questions
reactor 4447
frizz animation
hair and fur modifier 1080, 1126
frizz parameters rollout
hair and fur modifier 1126
from z level 4934
full screen 8139
function curve editor 3804, 3873
function curves 4475, 4816, 4823
  add keys mode 3956
glossary 8588
show tangents 3958
Track View 3951
funnel-like objects 2903
fuse vertices 634, 646, 655
fusing (glossary) 8588
FX files 8530, 8589, 8771

general settings rollout
  render to texture 6871
generate colors 4684
generic promaterial 5786
gengon 448
geographic location dialog 5503
generic/primitive space warps
  bomb 2991
  conform 2987
  FFD(box) 2962
  FFD(cyl) 2969
  ripple 2983
  wave 2979
game engine - edit normals 1322
gamma and hdr/ldr images 8341
gamma correction (glossary) 8331, 8592
gamma pipeline 8341
gamma preferences 8330
garment maker
  troubleshooting and error codes 1298
garment maker modifier 1266
  using 1198
general (+) viewport label menu 8117
  general parameters (standard lights) 5361, 5424
general parameters rollout
  hair and fur modifier 1111
general preferences settings 8299
G
G-buffer
  layers (rendering preferences) 8342
gait pattern 8591
gait type 8591
game engine - edit normals 1322
gamma and hdr/ldr images 8341
gamma correction (glossary) 8331, 8592
gamma pipeline 8341
gamma preferences 8330
garment maker
  troubleshooting and error codes 1298
garment maker modifier 1266
  using 1198
general (+) viewport label menu 8117
  general parameters (standard lights) 5361, 5424
general parameters rollout
  hair and fur modifier 1111
general preferences settings 8299
cylinder atmospheric apparatus 7240
gizmo/center (glossary) 8593
preferences 8354
sphere atmospheric apparatus 7243
tracker 4165
types of 7236
using transform gizmos 889
gizmos rollout 1667
glare shader (mental ray) 6408
glazing promaterial 5792
global and local exclude/include dialog (for raytraced maps and materials) 6092
global clip 5148, 5268
global clip controller 5257, 8596
global event (particle flow) 8594
global illumination 6615, 6634, 6706, 6771, 8576
global illumination (mental ray) 6680
global lighting (rendered environment) 7163
global motion clip 5148
global raytracer settings dialog 6666
global settings and defaults for bitmap proxies dialog 7601
global shadow parameters (Track View) 3817
global tuning parameters rollout 6731
global viewport rendering setting 155
glossary 8493
glossiness mapping 6039, 8596
glow render effect 7073
go to rotation test 3258
go to settings Material Editor 5702
time 8079, 8101, 8104
goal (and IK chain) 3669
goniometric diagrams 5372
grab viewport 125
gradients
  gradient map 6253
  gradient mapping 3175
  gradient ramp map 6258
lens effects gradient colors (video post) 7377
lens effects gradient options (video post) 7372
lens effects gradient options (video post) 7375
lens effects gradients (Video Post) 7370
graph editors menu 8027
delete schematic view 7952
delete Track View 3990
new schematic view 7922, 7952
new Track View 3989
saved schematic views 7922, 7953
saved Track View 3991
Track View 3990
Track View - curve editor 3790
Track View - dope sheet 3790
graphics driver setup dialog 8313
Graphite Modeling Tools 2025
graphite modeling tools tab 2045
GravAccel (gravitational acceleration) 4492, 4555, 4755, 8597
gravity 8597
computation 4555
gravity space warp 2923
green
  line 5029
  rigid vertices 5096
grid
  autogrid 2792
  grid and snap settings 2819
  grid nudge distance 8308
  grid setting display 8084
  home grid settings 2833
  options 2828
  snap override 2826
  snaps 2819
  user grids settings 2836
grid commands 8004
grid method, raytrace acceleration 8696
grids 2796, 8004, 8597
activating 2797
align to view 2798
aligning to 2220
hair and fur
and lighting 1079, 7061
components 1074
rendering options 7064
hair and fur modifier 1073
animation 1080, 1126, 1136
display rollout 1143
dynamics 1080, 1126, 1136
dynamics rollout 1136
frizz animation 1080, 1126
frizz parameters rollout 1126
general parameters rollout 1111
growth objects 1075
guide hairs 1076, 1095
instanced hair 1084
kink parameters rollout 1131
material parameters rollout 1118
mr parameters rollout 1125
multi strand parameters rollout 1134
quad menu 1109
selection rollout 1082
splines 1075
styling hair 1077, 1095
styling rollout 1095
surfaces 1075
tools rollout 1084
hair and fur render effect 7061
hair and fur render element 6825
hair light attributes 5443
handle display size 8310
hardware display
with maps 155
without maps 155
hardware requirements 6933
hardwood promaterial 5796
haze sky model 5529
HD IK solver 3669, 3710, 3721, 3773–3774, 3778, 3780, 3782
HD solver 3782
HD Solver 3711, 3713, 3723, 3727, 3729, 3773–3774, 3778, 3780
HDI image motion blur (mi) 6448
HDR file format 7866
HDRI files 7866
head object 271

H

hair
brush for styling 1099
compositing method 7066
cutting 1099
light attributes 5443
shadows 7067
styling 1095
styling rollout 1095

H

and resolution of patch model
surface 2405
grid and snap settings 2819
grid helper object 2847
show home grid 2796
using 2785, 2789
viewing 2791
grids and snaps submenu 8004
ground plane (and collision
detection) 4581

H

group
script 4896
group menu 258, 268, 8005
attach 263
close 260
detach 262
explode 261
group 258
open 260
ungroup 261

groups
and attaching physique 4966
and selection sets 8005
closing nested groups 260
detach from 270
explode 261
smoothing 383
using 8005
using with scene explorer 7895
grow 1702
growth objects
hair and fur modifier 1075
guide hairs
hair and fur modifier 1076, 1095

H

hair
brush for styling 1099
compositing method 7066
cutting 1099
light attributes 5443
shadows 7067
styling 1095
styling rollout 1095

H
hinge polygons from edge dialog  2352
history list  6535, 7928
history-dependent IK solver  3669
history-independent IK solver  3669, 3680
hold (edit menu)  242
home grid  68
glossary  8600
settings  2833
using  2787
views based on the world coordinate axes  68
hopping (dynamics of)  4555
horizon (glossary)  8602
horizontal (move key)  3953
horizontal bezier handle control  3958
horizontal text in vertical toolbar  8299
hose  460
hosts file  6797
hot (glossary)  8603
hot keys  1879, 3810, 4811, 5022, 5153, 8419
hotspot  5439, 8169, 8604
how many  4781, 4787, 4791
how to (NURBS)
  fix objects  2451
  improve performance  2452
  make things  2444
how tos  5300
HSDS modifier  1198, 1202, 1464, 1472
HSV (glossary)  8698
HTML help viewer
  browse buttons  8451
  favorites tab  8452
  keyboard shortcuts  8454
  right-click menus  8454
  searching in  8446
toolbar  8452
using  8444
HTR/HTR2
  exporting  7766
  importing  7762
hue/saturation/value (glossary)  8698

i-drop Indicator  7644
IAM files
  importing  7695
ICB targa files  7878
icons
  color scheme  8280
  path for additional  8294
  reactor  4226
ID
  material ID channel  5694
IES  5376
  IES sky  5509
  IES sun  5506
IFL files  7841
  and view file command  6514, 6535
  IFL manager utility  7845
  image file list control dialog  7844
IGES
  and NURBS surfaces  7727
  export/import log file  7729–7730, 7734
  exporting to  7736
  file translation  7727
  glossary  8605
  history  7727
  IGES import dialog  7730
  import table to 3ds Max  7732
  log files  7729
  overview  7727
  temporary files  7730
ignore animation range  3900
ignore backfacing  2192, 2220, 2235
IK
  and control objects  3661
  and set key  3377
  animating with interactive IK  3747
  IK joints  3665
  IK solution (glossary)  8606
  overlapping chains  3680
  preferences  8352
IK blend  4710, 8605
IK constraints  4598, 4602
IK limb solver  3669, 3732
IK object  4704

8814  Index
IK only option 4754
IK rollouts 3772
  auto termination 3786
display options 3704
IK solver rollout 3695
inverse kinematics 3784
object parameters 3773
  spline IK solver rollouts 3743
IK solvers 3669, 3680, 3710, 3732
illegal video colors 5678
illuminance 8606
image alpha filter (video post) 7313
image file formats 7831
image file list
  IFL control dialog 7844
  IFL manager utility 7845
image filter event (video post) 7295
image input event (video post) 7288
image input options (video post) 7292
image layer event (video post) 7298
image motion blur (glossary) 8606
image output event (video post) 7302
image sequence 6514
images (2D) 7831
import
  animations 4126
  file menu 7446
  IGES files 7730, 7732
  import options 7781
  merge animation 4126
importing
  3DS files 7655
  Adobe Illustrator 88 files 7662
  and attaching 3ds Max objects 2490
  animation 4640
  DDF 7752
  DEM Models 7752
  DWG and DXF files 7666
  DXF files 7693
  FBX 7706
  FLT files 7707
  HTR/HTR2 7762
  IAM files 7695
  IGES files 7730
  IPT files 7695
  landXML 7752

marker file 4919
motion-capture file 4919
OBJ files 7789
PRJ files 7657
scenes 54
SHP files 7660
STL files 7781
TRC 7765
VRML files 7798
importing geometry 7646
  merge or replace scene 7646
importing motion-capture data 4647
IMSQ files 7847
in
tangent 8098
in place mode 4656, 4669, 8608
  using to adjust keyframes 4657
include new bones 5024
include/exclude lights 5341
including layers 7568
incremental saves 61, 8305
independent 7727, 8609
index of refraction 6013, 6054, 6065,
  6155, 6294, 6382
indirect illumination 6771, 8684
influence 209, 5029, 5080, 7473, 7576,
  8609
  areas of and envelopes 4970
influenced vertices 5090
infocenter 7997
InfoCenter
  access 8422
  favorite links 8429
  search wildcards 8425
  searching for information 8425
  settings 8430
inheriting
inherit rollout 3789
inheritance 3659
initial graphics exchange specification
  (IGES) 7727, 8605
initial pose 5024, 5026, 5060, 5080,
  5090, 5096, 8609
initializing
  and ActiveShade 8497
  manager program 6974
  server program 6974
isolate selection tool 198
isometric views 72
isotropic light distribution 5367
iteration setting (HD IK solver) 3713

J
jambs 468
jitter (antialiasing control) 6735, 8705, 8709
job archives
  job archives dialog 7016
  manager 6985
  network job assignment 6970
  network rendering 6905
  queue monitor 6995
job dialogs (network rendering) 6953, 7014
job settings (network rendering) 7008
join dialogs (NURBS) 2723, 2725
join to previous ik key option 4710
joint intersections 5018
parameters 4991, 4998
joint intersections rollout 5077
joint rotation data (in BVH files) 4918
joints
  activating joint axes 3757
  joint limits (hierarchies) 3630
  joint parameters 3754, 3780
  joint precedence 3721, 3723, 3778
  joint resistance and spring back 3720
  limiting joint action 3760
  path 3754
  rotational 3754
  setting joint precedence 3721
  setting joint resistance 3720
  setting parameters 3754
  sliding 3754
  sliding and rotational 3782
  surface 3754
  using default joint precedence 3723
JPEG files 7848
JSR-184
  editing parameters 7741
export/import files 7737, 7741, 7746
log files 7747
m3g player 7749
texture parameters 7746
JSR-184 player 7749
jump 4669, 4774
jumping
  dynamics of 4555
  parameters 4524

K
KBD files 8250, 8276
keep apart operator 3131
key filters 3974, 8093
key info
  Bezier controllers 3432
  key info rollouts 3418, 3422
  master track key info dialog 3507
  key info rollout 4704
  key interpolation 4468
  key mode 8105
  key modes (links) 3653
  key reduction settings 4934
  using motion-capture filtering 4918
key tangents toolbar 3873
keyable icons 3864
keyboard
  additional commands 7982
  creating primitives from 386
  keyboard entry rollout 386
  keyboard panel (customize UI) 8250
  keyboard shortcuts 1879, 3810, 4811, 5022, 5153, 8250, 8419
  edit soft selection 2019
  HTML help viewer 8454
  override toggle 8420
  keyframe interpolation 3420
  keyframe mode
glossary 8615
keyframe vertices constraint 4402
keyframes
  adapting to edits 4542
  adjusting with in place mode 4657
keyframing
  the biped 4468
keyframing tools 4717
keys
  adding 3917
  aligning 3909
  colors in Biped 4690, 4806
  create out of range 3867
  create out-of-range 3923
  default tangent types 8098
  delete 3792, 3907
  editing 3906
  glossary 8616
  interpolating 3420
  key mode 8105
  key properties (track bar) 8071
  key statistics (Track View) 3983
  key time display (Track View) 3982
  master track 3505
  moving 3913, 3953
  moving a group of 3914
  moving horizontal and vertical (Track View) 3953
  randomize 3867
  randomize utility 3921
  reducing 3941
  select 3792
  select by time 3867, 3925
  soft selection manager 3867
keys (setting) 4609
keys menu
  Track View 3853
keys toolbar (curve editor) 3873
keys windows (Track View) 3795
kinematic chains 3665, 8616
kink parameters rollout
  hair and fur modifier 1131
knot (glossary) 8617
Kodak Cineon 7834

label menus
  viewports 8117
landXML importer 7752
landXML/DEM model import dialog 7753
lasso selection region 233
lateral ratio 4038
lathe
  lathe modifier 1474
  lathe surface (NURBS) 2631
lattice modifier 1479
lattice parameters rollout 5260
launch script (glossary) 8617
layer controller dialog 3465
layer defaults 8299
layer list 7974
layer manager 7956
layer properties 3482
layer properties dialog 7966
layer track 4007
layers 283, 4741, 7953
  animation 8507
  AutoCAD and 3ds Max 7568
  excluding in file linking 7568
  from AutoCAD 7500
  from AutoCAD Architecture 7500
  from Revit 7500
  glossary 8617
  including in file linking 7568
  layer event (video post) 7298
  layer list button 7974
  layer manager 7956
  layer properties dialog 7966
  select dialog 7568
layers toolbar 8040
  add selection to current layer 7976
  create new layer 7975
  select objects in current layer 7976
  set current layer to selection's layer 7976
layout (viewports) 76, 8379
layout menu (Schematic View) 7931
layout mode
  glossary 8618
leg link 4762
leg states 4535

L

L-Ext 445
L-Extrusion 445
l-type stair 511
legacy DWG import 7685
length 4778
transition editor 4900
lens effects 7068
  auto secondary 7097
  blur 7141
  brightness and contrast 7149
  color balance 7151
  depth of field 7159
  file output 7152
  film grain effect 7155
  glow 7073
  gradients 7370
  manual secondary 7105
  ray 7090
  ring 7080
  star 7112
  streak 7119
lens effects (video post)
  animating properties 7315
  automatic secondary flare parameters 7327
  flare 7316
  flare glow parameters 7325
  flare inferno parameters 7337
  flare preferences 7322
  flare ray parameters 7331
  flare ring parameters 7326
  flare star parameters 7333
  flare streak parameters 7335
  focus 7339
  glow 7343
  glow inferno 7352
  glow preferences 7350
  glow properties 7346
  gradient colors 7377
  gradient options 7372
  gradient types 7375
  highlight 7354
  highlight geometry 7363
  highlight preferences 7368
  highlight properties 7358
  manual secondary flare parameters 7329
lens effects filters (video post) 7314
lens size (cameras) 5570
level of detail
  utility 2762
  VRML97 helpers (LOD) 7818
lift 4669, 4724, 8618
  leg state 4535
  lift dynamics 4555
light distribution
  diffuse 5368
  isotropic 5367
  spotlight 5369
  web 5371
light include/exclude tool 5341
light lister 5343
light map 8618
light painting rollout (radiosity) 6651
light parameters
  mental ray indirect illumination rollout 5461
  mental ray light shader rollout 5464
light shader rollout 5464
light shaders
  mental ray 5464
light tracer 6600-6601
light viewports 72, 119, 8165
lighting
  displaying in viewports 8130
  exclude/include dialog 5445
  general parameters 5361
  general parameters (standard lights) 5424
  guidelines 5330
  hair and fur 1079, 7061
  in 3ds Max 5328
lighting analysis 6664, 7228, 7861
lighting analysis dialog 6664
lighting data exporter utility 7234
lighting exclusion 3009
lighting map (baking) 6850
lighting parameters rollout 6827
lighting texture element rollout 6827
lightmap shader 6179
lights 5314, 5348
  add default lights to scene 152
  advanced effects rollout 5457
  and atmospheres 5455
  and effects 5455
and materials 5625
and shading 5625
and shadows 5328
animating 5339
atmospheres and effects for 5453
dolly 8167
free direct 5407
free directional 5407
free spotlight 5402
light falloff 8173
light include/exclude tool 5341
light lister 5343
mental ray shadow maps 5482
mr sky 5527
mr sky portal 5537
mr sun 5524
name and color rollout 5317
omni 5410
orbit/pan 8177
photometric lights 5348
placing 36
positioning 5334
properties of 5322
quad menu 8063
roll 8171
standard 5398
target direct 5405
target directional 5405
target spotlight 5399
tools 1 quadrant 8063
truck 8175
types of 5314, 5348
viewport controls 8169, 8173
working with 5319
lights name and color rollout 5317
Lightscape import
Lightscape Materials utility 7759
Lightscape Materials utility 7759
limit controller 3484
limiting animation ranges 3484
limiting joint action 3760
line 584
linear arrays (creating) 1018
linear controller 3496
linear dashpot 4273
linear exposure control 7212
link 5060, 5080, 5090
biped hand to an object 4710
blending 5018
envelopes list (left side) 5051
length 5024
length as basis for envelope creation 4966
linking drawing files 8703
linking objects to biped 4511
name 5096
scale 4986, 5070
sub-object 5068
to root attach node 5013
link constraint 3580
link rollouts 169, 3787
link info inherit 3789
link info locks 3788
link settings rollout 5070
link sub-object level
joint intersections rollout 5077
link settings rollout 5070
linkage, hierarchical 8599
linked objects
assigning materials to 7510, 7523
conversion settings 7549, 7561
selecting when file linking 7571
linked XForm modifier 1484
linking
and unlinking objects 3630
animatable parameters 3610, 3612
bones to follow objects 3710
end effectors to parent 3710
strategy 3623
links 8620
adding and deleting 3653
adjusting parameters 4986
and joint settings 5024, 5026
and pivots 3642
animating links 3653
blending between 4966, 4970
changing link inheritance 3659
displaying 3630
link inheritance (selected) utility 3660
main toolbar 3631
moving 4578
parameters 4986
radial scale parameters 4986
rotating 4581
scaling 4505
setting parameters 4986
sliding parameters 4986
twist parameters 4986
lip sync 1518
list
layers 7974
list controller 3497
named selection sets 217
selection filter 214
transformation axis coordinate system 922
list views (Schematic View) 7934
listener
listener window (glossary) 8620
MAXScript listener 8229
Live Update maintenance 8427
load 4934
.mfe file 4861
buffer only 4925, 4934
file option 4669
marker name file 4925
motion capture file 4925
motion flow editor 4861
parameters 4934
specification 5013, 5044
load animation 4107
load custom UI scheme 8279
load envelopes 1693
load/save presets rollout (PArray) 3364
loading
BIP files 4680
biped figure files 4513
biped step files 4646
FIG files 4680
motion files 4638
STP files 4680
loading animation 4103
local
working folder 7586
local biped curve 4823
local center during animate 8346
local container 8620
local coordinate system (glossary) 8621
local euler XYZ rotation controller 3501
local event (particle flow) 8623
local illumination 6615
locate vertical center of mass keys 4686
lock
character 279
lock selection 3909
lock time tag 8085
lock UI layout 8242
locking object transforms 3657
selection lock 8079
lock assignments 4982, 5096
lock com keying 4686
lock selection
status bar 8079
Track View 3909
locks rollout 3788
LOD
level of detail utility 2762
thresholds 2767
VRML97 helpers 7818
loft object 742
creation method rollout 745
deform bevel 777
deform fit 779
deform scale 771
deform teeter 774
deform twist 773
deformation dialog 781
path commands 790
path parameters rollout 750
shape commands 790
skin parameters rollout 753
surface parameters rollout 746
lofting
glossary 8623
shapes 572
log file 6797, 8624
log files
IGES 7729
network rendering 6978
logarithmic exposure control 7215
logging properties dialog 6978
LogLUV format (TIFF files) 7234
look at controller 3502
look at object
look at constraint 8624
look at controller 8624
particle flow 8624
look-at constraint 3585
loop 1702
loop tools dialog 2143
looping 4919, 4934
    animation 3961
    animation (Track View) 3938, 3940
loop event (video post) 7308
loops panel 2130
low res environment background 8308
low-polygon modeling 2760
lower bound 5090
LS colors 1145
LS colors modifier 1145
LS mesh modifier 1486
LTLI files 8625
lume shaders 6391
lumen 8625
LumeTools shaders 6391
luminaire helper object 271
luminance 8625
luminous flux (glossary) 8625
luminous intensity (glossary) 8625
LUT preferences 8330
lux 8606
LZF files 8625
LZG files 8626
LZH files 8626
LZO files 8626
LZV files 8626

make controller/object unique (Track View) 3902
make curve on surface dialog 2710
make loft dialog 2727
make material copy 5692
make point curve dialog 2730
make point dialog 2729
make preview 5679, 6894
make relative 8286
make selected same size (video post) 7281
make unique 1049, 1063, 3950, 8206
    Material Editor 5692
    particle view 3019, 3031
manage scene states 7915
manage scene states dialog 7917
manager
    brush presets 8047
manager (network rendering) 6922,
    6933, 6974, 6982, 6985
manager menu (queue monitor) 7006
managers (transform) 904
managing
    files 51
    jobs in the queue 7019
    scenes and projects 7391
managing containers 8003
manipulator 2861
manipulator helper objects
    cone angle 2861
    plane angle 2865
    slider 2868
manipulators
    built-in 2838
    select and manipulate 2838
manual secondary flares 7105
manual update (envelopes) 5060
map animation 4110
    map track to track rollout 4115
    motion mapping parameters rollout 4112
    retargeting rollout 4117
map channel info dialog 6486
map shortcut button 5645
map track to track rollout 4115
mapped material
glossary 8628
mapping
ambient color 6029
anisotropy 6045
box 1853
bump 6049
coordinates (glossary) 8628
cutout 6164
cylindrical 1853
diffuse color 6031
diffuse level 6033
diffuse roughness 6035
displacement 6059
filter color 6043
flatten 1893
glossiness 6039
map network drive dialog 6950
mapping coordinates 5636
mapping operator (particle flow) 3175
metalness 6048
normal 1895
opacity 6042
orientation 6046
pelt 1853, 1898
planar 1853
planar (quick) 1852
reflection 6052
refraction 6054
self-illumination 6041
shininess 6039
shininess strength 6038
specular color 6037
specular level 6038
spherical 1853
spline 1853, 1916
unfold 1926
mapping biped motion 4640
maps 6278, 6797, 7612
"other" (in the material/map browser) 6358, 6364, 6375, 6382, 6388, 6391, 6393–6394, 6397–6398,
6403, 6406, 6411–6412, 6420, 6422, 6430, 6434, 6450, 6452
2D 6200
3D 6278
camera map per pixel 6452
cellular 6279
checker 6227
color correction 6346
color modifier 6345
combustion 6229
composite 6331
compositor maps 6331
custom 3ds Max mental ray shaders 6393–6394, 6397–6398, 6398, 6403, 6406, 6411–6412, 6414, 6420, 6422,
6430, 6434
cutout mapping 6164
deleting 5726
dent 6286
displaying in viewports 155
dragging and dropping 5657
falloff 6294
flat mirror 6358
glossary 8631
gradient 6253
gradient ramp 6258
hierarchy (glossary) 8634
light map 8618
lume shaders 6391
map channel (glossary) 8627
map types 6185
mapped materials 3300, 5696
maps rollout 6021
marble 6300
mask 6338
mental ray shaders 6388
mix 6339
noise 6303
normal bump 6450, 6856
output 6351
particle age 6306
particle MBlur 6308
Perlin marble 6310
procedural 8691
and attaching objects 2233
and blocks 7528
and particle array 3297
and particle system events 3014
and particle systems 3300, 3302
and set key 3377
and styles 7535
animating 5707
applying in particle flow 3156
applying to an object 5626
applying to objects 5641
arch & design (mental ray) 5858
Architectural Desktop 7510
assign to selection 5690
assigning 7510, 7523
AutoCAD Architecture 7509–7510
blend 6107
blocks 7530
car paint (mental ray) 5922
changing 7510, 7524
combined when attaching
  objects/splines 630, 2220
components 5624
composite 6111
compound materials 6106
copying 5641
default material settings 5691
deleting 5726
designing 5620
DirectX 9 shader 6175
double-sided 6113
dragging and dropping 5657
exporting 5638
get 5687
getting from library 5641
glossary 8635
hierarchy (glossary) 8634
ID channel 5694
ink ‘n paint 6132
library 5733
loading from scene 5641
make copy 5692
material blending (morpher
  material) 6116
material library 5733
material name field 5706
material properties rollout
  (NURBS) 2544
matte/shadow 6099
mental ray 5951
morpher 6116
multi/sub-object 6120
name 5621, 5641
pick from object 5705
promaterials 5772
propagation 5674
put to library 5694
put to scene 5689
raytrace 6064
Revit 7521, 7523–7524
saving 5638, 5641
scene 5689
select by 5686
shell 6174
shellac 6127
show end result 5701
SSS materials (mental ray) 5946
standard 5962
subsurface scattering (SSS) materials
  (mental ray) 5946
top-bottom 6129
type 5623, 5758
type button (Material Editor) 5706
types of 5758
updating 5689
using 34
using maps to enhance 5627
matte object (glossary) 8636
matte texture element rollout 6829
matte/shadow material 6099
matte/shadow/reflection (mi)
  material 5930
max clips 4095
MAX file 8638
MAX file finder utility 7634
MAX files and Autodesk VIZ 7647
max object
  add to motion mixer 4007
  max objects to mix dialog 4081
  maximum angular/positional deviation
    for a track 4934
maximum concurrent assignments
(network rendering) 6985
MAXScript 3008
  about MAXScript 21
  and particle flow 3196, 3280
  command-line 8232
  glossary 8638
  listener 8229
  MAXScript listener 8229
  menu 8031, 8228
  mini listener 8065
  open MAXScript 8228
  preferences settings 8358
  run script 8229
  sample script
    particleFloat (particle flow) 3190
  visual MAXScript utility 8231
MAXScript debugger dialog 8231
MAXScript menu 8031, 8228
  macro recorder 8230
  MAXScript listener 8229
  new script 8228
  open script 8228
  run script 8229
maxstart.cui file 46, 59
Maya
  data sharing with 3ds Max 7706
  measure distance 2881
  measuring 2855, 2878, 2882
  melt modifier 1496
  memory management 7642
  mr proxy object 562
  memory use 6746
mental ray
  add/edit DBR host dialog 6805
  antialiasing 6735
  arch & design material 5858, 5893, 5907
  cache translated geometry 6792
  car paint material and shader 5922
  distributed bucket rendering 6805
  distributed bucket rendering rollout 6797
  geometry caching 6792
  global tuning parameters 6731
  material 5951
  object properties 300
  photographic exposure control 7219
  reflection and refraction 6741
  rendering options 6524
  satellite processors 6805
  satellites 6797
  sky portal 5537
  subset pixel rendering 6745
  subsurface scattering materials 5946
  Sun & Sky 5513
  mental ray Connection rollout 5763
  mental ray indirect illumination rollout 5461
  mental ray light shader rollout 5464
  mental ray material
    advanced shaders rollout 5958
    material shaders rollout 5951
    mental ray materials 5772
    matte/shadow/reflection 5930
    mental ray messages 6797
    mental ray renderer 6675, 8576
    contour shading 6714
    diagnostic tools 6795
    displacement shading 6713
    feature enhancements 6686
    FGM file 8569
    final gather map 8569
    materials 5772
    messages window 6689
    MI files 8639
    object properties 300
    PASS file 8678
    photon map 8684
    preferences 8363
    processing panel 6786
    shadow map rollout 5482
    volume shading 6710
  mental ray shaders 5763, 6385, 6388
  3D displacement 6394
  bump shader 6397
  car paint shader 5922
  connect parameter to shader dialog 6392
  custom 3ds Max shaders 6393
dgs material shader 6398
dielectric material shader 6403
environment shader 6406
glare 6408
height map displacement 6411
material to shader 6412
mr labeled element shader 6414
mr physical sky 5532
multi/sub-map shader 6414
object color shader 6418
shader list 6420
third-party shaders 6387
uv coordinate 6430
uv generator 6422
uv generator parameters rollout 6422
uv generator shaders rollout 6427
XYZ coordinate 6434
XYZ generator 6430
XYZ generator parameters rollout 6431
XYZ generator shaders rollout 6433
mental ray Sun and Sky 5513
mental ray utility materials
  bump combiner 5947
  displace combiner 5949
menu bar
  curve editor 3849
  dope sheet 3849
  Material Editor 5666
  particle view 3017
  Track View 3849
menus
  align 8003
  animation 8023
  containers 8003
  controller 3849
  create 8008
  customize 8029
  edit 7999
  graph editors 8027
  grids and snaps 8004
  group 8005
  help 8032
  material editor copy and paste 5647
  MAXScript 8031, 8228
  menu bar 7998
menus panel (customize UI) 8269
modifiers 8016
particle view 3017
reactor 4225
rendering 8028
Schematic View 7930
tools 8001
views 8006
merge 7572
animation (file menu) 4126
custom sections 1799
insert tracks command 4126
merge dialogs 5715–5716, 7471, 7572, 7577
scenes 54
shapes 1799
merge from file
  sweep modifier 1799
merge xref controller 3570
merging characters 4642
mesh
  editable mesh 2192
  mesh select modifier 1500
  meshsmooth modifier 1505
  skin morph modifier 1706
  skin wrap modifier 1717
  skin wrap patch modifier 1726
turbosmooth modifier 1818
  working with mesh sub-objects 2196
mesh - definition 8638
mesh conversion 3194
mesh density, and cloth 1202
mesh editing 1957
mesh object (as Physique skin) 4946
mesh size (reducing) 5001
meshing parameters rollout (radiosity) 6645
meshsmooth modifier 1505
MeshSmooth modifier and cloth 1198
meshsmooth selection dialog 2354
messages 6797
metaballs 701, 8638
metal bump shader 6180
metal highlights 6008
metal promaterial  5808
metal shader  5980
metallic paint promaterial  5821
metalness mapping  6048
methods (IK)  3667
MFE files  4102, 4636, 5299
folder  4883
MI file  6787, 6797
MI files  8639
Microsoft TCP/IP properties dialog  6938
middle button pan/zoom (viewports preferences)  8308
MIDI time slider control (animation preferences)  8346, 8350
mini listener (MAXScript)  8065
mini Track View (track bar)  8071
minimum key spacing  4934
mirror  940, 4625, 4717, 5060, 5080, 5090
main toolbar  940
mirror curve (NURBS)  2566
mirror dialog  940
mirror modifier  1516
mirror surface (NURBS)  2624
mirroring joint parameters  3780
mirroring objects  1026
splines  655
mirror dialog  940
mirror parameters rollout  1667
mirror promaterial  5824
mirror selected cross section  5029
mirrored link
  copying envelope settings to  4979
mirrored UVs  6869
mirroring  8639
mirroring motion  4625
missing external files dialog  7612
missing map coordinates dialog  6198
missing XRef paths dialog  7449
MIX files  4668, 5299
mix map  6339
mix menu  4052
mixdown  4043
mixer
  and BIP files  4645
load mix  4102
mode  4102
rollout  4102
save mix  4102
mixer clip source options dialog  4061
mixer transition editor dialog
  biped object  4066
  non-biped object  4072
MNM file  8640
MNM files  4636, 4919, 4924–4925, 5299
MNU files  8259, 8269, 8276
mobile gaming
  editing JSR-184 parameters  7741
  exporting JSR-184 files  7737
MOC files  4925, 4934
modal (glossary)  8641
mode
  motion flow  4848, 4886
modeless (glossary)  8641
modeling
  freeform  2155
  objects  33, 1763
modeling ribbon
  docking  2036
  floating  2036
  freeform tab  2155
  graphite modeling tools tab  2045
  introduction  2025
  loop tools dialog  2143
  maximizing  2032
  minimizing  2032
  resizing  2038
  scrolling  2038
  select by panels  2186
  selection tab  2180
  symmetry tools dialog  2062
  topology dialog  2057
modeling ribbon panels
  align  2151
  border edges  2115
  by color  2192
  by half  2189
  by normal  2187
  by numeric  2191
  by perspective  2187
  by pivot distance  2190
  by random  2188
multires 1537
noise 1544
normal 1551
normalize spline 1554
NSurf sel 1555
object space 1159
patch select 1562
PatchDeform 1150, 1567
PathDeform 1150, 1569
point cache 1156, 1574
poly select 1582
preserve 1590
projection 1596, 1598, 1601, 1603, 1607–1608, 1610
projection holder 1614
ProOptimizer 1614
push 1640
quadify mesh 1641
reactor cloth 4365
reactor rope 4387
reactor soft body 4375
relax 1643
renderable spline 1647
ripple 1650
select by channel 1654
shell 1655
skew 1664
skin 1667
skin morph 1706
skin wrap 1717
skin wrap patch 1726
slice 1727
smooth 1733
spherify 1736
spline IK control modifier 1738
spline select 1741
squeeze 1744
STL check 1746
stretch 1749
substitute 1759
surface 1763
surface mapper (world space) 1156
SurfDeform 1159, 1774
sweep 1776, 1796, 1798
symmetry 1803
taper 1807
tessellate 1812
topology dependent 8744
trim/extend 1815
turbosmooth 1818
turn to mesh 1825
turn to patch 1827
turn to poly 1830
turn-to modifiers 1825, 1827, 1830
twist 1833
unwrap UVW 1837
UVW map 1932, 7511, 7525
UVW mapping add 1954
UVW mapping clear 1954
UVW mapping paste 1955
UVW Xform 7511, 7525
UVW XForm 1955
vertexpaint 1959
volume select 1992
wave 2000
welder 2004
world space 1067
WSM 1067
modifiers menu 8016
animation modifiers 1159, 1484, 1567, 1569, 1774
cache tools 1574
free-form deformers 1431, 1436
mesh editing 1185, 1305, 1321, 1425, 1428, 1551, 1557, 1733, 1746, 1803, 1812, 1957, 1959
nurbs editing 1159, 1310, 1774, 2454
parametric deformers 1159, 1165, 1313, 1479, 1516, 1544, 1590, 1640, 1643, 1650, 1664, 1727, 1736, 1744, 1807, 1833, 2000
patch/spline editing 1299, 1307–1308, 1442, 1474, 1554, 1763, 1776, 1796, 1798, 1815
radiosity modifiers 1156, 1756
selection modifiers 1500, 1562, 1741, 1992
subdivision surfaces 1505, 1756
surface 1310, 1492
UV coordinates 1067, 1147, 1156, 1180, 1932, 1955
modify child keys 3861
modify child keys (Track View) 3809
modify panel 1041, 8184
modify selection panel 2063
modify subtree (Track View) 3809, 3860
modifying
at sub-object level 1054
multiple objects 1059
NURBS models 2423
objects (basics) 358
module info report (queue monitor) 7006
morph 667
morph controllers 3410
morpher material 6116
morpher modifier 1518
morphing (glossary) 8643
motion
combining BIP files 4645
mapping 4640
mirroring 4625
Motion Analysis 4156, 7762, 7765–7766
motion blending 8644
motion blur 3011, 3300, 5594, 6693, 6747, 6756, 7157, 8606, 8658, 8710
and particle flow 3168
motion capture 3509, 4137, 4916, 4923, 4925
batch file conversion dialog 4943
buffer 4919, 4925, 4934
conversion parameters dialog 4934
converting data from buffer 4925
file 4934
importing files 4919
introduction to importing 4647
rollout 4919, 4925
motion clip 5268, 8646
motion clips
Track View pick dialog 5279
motion clips panel 5269
motion damper 2908
motion editing 4823
motion files 4636, 8646
information saved in 4638
loading motion files 4638
samples 4638
motion flow 4476, 8647
and BIP files 4645
BIP file location 4638
clip properties dialog 4891
center compare with motion mixer 4002
director file 4888
graph 4850, 4853, 4888, 4891
mode 4669, 4848, 4858, 4886, 4888, 4896
optimize transition 4913
random motion 4868
random motion flow 4876, 4909
rollout 4888
script 4848, 4850, 4896
shared 4909
shared motion flow 4876, 4909
transition 4853
unified motion 4873
workflow 4886
motion flow editor 8647
append 4861
files 4883
load 4861
save 4861
motion flow graph
optimize 4913
motion flow mode 4669
motion fow scripts 8647
motion mapping parameters
rollout 4112
motion mixer 4001
adding bipeds 4007
adding max objects 4007
adding tracks 4007
adjusting balance 4038
clip timing 4023
cloning clips 4015
compare with motion flow 4002
director 4090
export animation 4043
filtering biped parts 4086
how to use 4002
multiplier out-of-range types (Track
View) 3968
multires modifier 1537
multiresolution adaptive
antialiaser 6097
multisided blend surface 2683
multithreading and rendering 8346
MVBlocks 7531

N
N blend surface 2683
n links 5024, 5096
N links 8651
name
object name 8182
name and color rollout 8182
for lights 5317
named selection sets 185, 217, 219, 1057
names
material 5621
selecting by (Track View) 3973
naming layers 7953
naming materials 5641
natural light 5330
navigating
3D space 65
blocks 7533
camera and light views 119
hierarchies 3618, 3640
navigation tools 103
rendered panorama 6903
SteeringWheels 93
ViewCube 86
viewport 8135
navigating the workbench 4818
navigator (material/map) 5703
NavInfo (VRML97 helpers) 7813
neck link 4762
negative filter (video post) 7377
nested expressions (HTML help
viewer) 8446
net render control (common parameters
rollout) 6678
network
working folder 7586

network plug-in configuration 8297
network rendering 6905, 6909, 6974,
8697
advanced settings 6970
Backburner 6905
configuration 6909
e-mail notification 6965
error messages 6927
glossary 8652
how it works 6907
installing 3ds Max for 6946
installing network services 6976
job archives 7016
job dependencies 6963
job dialogs 6953
job handling 6970
job settings 7008
log files 6978
manager 6982, 6985, 8651
monitor.exe 6933
per-job timeouts 6970
pre-render MAXScript 6970
pre-render scripts 6905
queue monitor 6995
rendering queue 6995
server 6974, 6989, 6993
server (glossary) 8653
server.exe 6933
set up 6909
setting up 6935
single computer 7023
starting 6922
TCP post number 6970
troubleshooting 6927
user account 6944
network services - installing 6976
never degrade 168, 291, 8223
new
new command (file menu) 7432
new Schematic View 7952
new script 8228
new sequence (video post) 7271
new Track View 3989
new feature 816–817, 936, 993, 1090,
1207, 1211, 1232, 1235, 1243,
1250–1251, 1265, 1290, 1297,
normal projected curve 2586
normalize spline modifier 1554
normalized 5096
normals 380
adjusting 380
aligning 973, 2803, 3763
ingediting 1322
flipping 380
normal modifier 1551
scaling vertex and face 2192
unifying 380
viewing and changing 380
normals map (baking) 6851
note keys 3903
note track 3903, 3906
notes
adding 3178, 3193
notes operator 3193
notes dialog (parameter collector) 337
NSurf sel modifier 1555
nth serial numbering 8342
NTSC 8342, 8654
numbers
of links that can affect a vertex 4470
show/hide all 4684
numeric calculator 46
numerical expression evaluator 46
NURBS 4470
and animation 2439
and modifiers 2436
animation tips 2453
blend curve 2562
blend surface 2614
cap surface 2643
chamfer curve 2569
concepts 2440
creating models 2444
curve approximation 2736
curve fit 2558
curve point 2698
curve sub-objects 2518
CV curve 2473
CV surface 2460
definition 2440
extrude surface 2628
fixing problems with models 2451

new preset 7564
new settings preset dialog 7564
new Track View 3989
newton (glossary) 8653
next frame 8104
next key 8104
next key-previous key 4706
next transition
transition 4900
next/previous 5060, 5080
next/previous key 4706
NGon 597
no blending 5024, 5096
no footsteps 4934
no key reduction 4934
node (glossary) 8653
node track (glossary) 8653
noise
and terrain effects 1549
noise controller 3519
noise map 6303
noise modifier 1544
noise rollout (2D) 6211
noise threshold 6253, 6258, 6303, 7182, 7196
non-biped object
mixer transition editor 4072
pick nodes dialog (motion mixer) 4077
non-vertical jambs 468
nonrelational NURBS surfaces 2484
nonscaling object size 8308
normal bump map 6450
normal bump maps 6856
troubleshooting 6858
normal mapping 1875, 1895
glossary 8655
improving performance 2452
introduction 2416
lathe surface 2631
mirror curve 2566
mirror surface 2624
offset curve 2564
offset surface 2621
point 2695
point curve 2466
point point 2696
point surface 2456
ruled surface 2640
sub-object clone options
dialog 2734
surf point 2701
surface approximation 2737
tips 2444, 2453
transform curve 2560
transform surface 2612
U and V iso curves 2584
U loft surface 2646
using toolbox to create
sub-objects 2426
working with models 2419
NURBS curve/surface
detach dialog 2715
NURBS curves 2464
creating from splines 2481
fillet 2574
glossary 8655
NURBS models 2417
creating 2419
creating sub-objects 2423
dependent sub-objects 2433
display controls for 2486
glossary 8656
modifying 2423
objects and sub-objects 2417
overview 2419
sub-object selection 2428
working with 2419
NURBS surfaces 2454
and IGES 7727
creating from geometric
primitives 2483
display line parameters 2489
glossary 8656
making rigid imported surfaces
independent 7727
surface approximation 2737
NURMS 1505, 2203
glossary 8656
OBJ
exporting 7786
importing 7789
obj files (wavefront) 7785
object bounding box 5024
object color 8765
changing 8182
displaying 158
object color dialog 368
object color shader 6418
object data flow 1034
object display 158
object fragmentation (particle flow) 3008
object ID 293
object instance 8657
object motion blur (glossary) 8658
object motion inheritance rollout
(PArray) 3355
object name 8182
object parameters rollout 3773
copying/pasting/mirroring joint
parameters 3780
position/orientation/bind to
follow 3774
precedence 3778
sliding and rotational joints 3782
object properties 283, 6680
advanced lighting panel 295
cautics and global illumination 302
cloth 1222
edit menu 283
final gather 301
general panel 283
mental ray displacement 302
mental ray panel 300
user defined panel 303
object selection (introduction) 172
object space 8659
object space (biped) 8661
object space modifiers 8661
object transforms 3656–3657
object-layer relationships 7953
object-space modifier 1159
MapScaler 1487
object/delegate associations dialog 5179
objects 358, 4710, 5334
aligning 2799
arraying 1009
binding 3711
color 368
combining 713, 801, 823
copies/instances/references 982
creating 364
exporting 7583
freezing and unfreezing 191
glossary 8657
make controller unique (Track View) 3902
modeling 33
modifying multiple objects 1059
mr proxy 562
object properties 283
select and manipulate 2838
select and move 914
select and rotate 915, 917
selecting 171–172, 204
selecting by material 5686
techniques for cloning 985
using as bones 870
objects to bake rollout 6872
obsolete file alert 7440, 8305
obstacle avoidance 5123
obstacle parameters rollout 5261
obstacle-avoidance behavior 8661
odd/even 8342
offset
offset curve 2564
offset point 2696
offset surface 2621
offset/absolute coordinate display 8082
oiltank (extended primitive object) 436
omni light 5410, 8661
omnidirectional light 8661
omniflector 2935, 2946, 2948, 8663
on selected objects/on all objects 4943
on/off controller 3522
once time frame 3046
online help
using HTML help viewer 8444
online reference
introduction 8441
searching in 8446
using HTML help viewer 8444
only extract footsteps within
tolerance 4934
opacity 5997
falloff (glossary) 8663
mapping 6042
open
assembly 267
file (file menu) 7434
from vault 7438
group (group menu) 260
new bitmap file 6222
particle view dialog 3036
script (MAXScript menu) 8228
video post sequence 7272
open assembly 267
open dialog 4680
open from vault 7438
open physique file 5013
open physique file button 4997
OpenEXR files
format 7850
opening 7857
saving 7852
openflight 7707
OpenGL driver 8313, 8319
opening screen 59
operands 713, 801, 823, 8665
operator icon 8665
operators 3050
birth paint 3222
glossary 8665
mapping 3175
material dynamic 3168
material frequency 3166
paint soft selection panel 2056
paint weights 1989
paintbox 1984
vertex paint modifier 1969
painter options 1989
PAL 8342, 8674
palette 1984
vertex paint modifier 1984
paletted 8342
pan 84
panning views 84
particle view 3022, 3034
Track View 3984
viewport controls 8150
pan view 8150
panels
create 8182
customize UI 8250, 8252, 8259, 8269, 8272
display 8217
hierarchy 8213
modify (command panel) 1041, 8184
motion 8215
render scene 6634, 7058
scripted utility 8713
panorama exporter 6898
render setup dialog 6900
viewer 6903
pants (cloth) 1191
parallel projection 72
parameter (glossary) 8675
parameter animation 3010
parameter collector 325
menu bar 334
parameter collector menu bar 334
parameter collector notes dialog 337
parameter curve out-of-range types (Track View) 3961
parameter editor 307
parameter space (glossary) 8674
parameter wiring 258, 3610, 3612
parameters
  custom attributes 307
  HD Solver 3773
  notes 337
parameter collector 325
parameter collector menu bar 334
parameter editor 307
wiring 3610
parameters panel (particle view) display of 3023
glossary 8674
parameters rollout 1667
parametric (glossary) 8675
parametric stride length 4781, 4787, 4791
parametric stride width 4781, 4787, 4791
parent overlap 5060
PArray 3331, 3334, 3338, 3342, 3352, 3355–3356, 3358, 3364
partial blending 4988, 5060
particle age map 3011, 3168, 6306
particle collision 3305
particle deflector
deflector 2959
SDeflector 2953
UDeflector 2956
particle emission 3056
particle flow clean up 3045–3046
  frequently asked questions 3005
  helpers 3044
  introduction 2997, 3000
  keyboard shortcuts 3044
  new features 2998
  particle paint 3197
  particle paint helper 3197
  preset manager 3026
  repair cache system 3025
  reset particle view 3046
  source 3034
particle flow flows
  empty flow 3232
  standard flow 3232
particle flow operators
  birth 3052
  birth script 3056
  cache 3178
  delete 3067
  display 3186
ping-pong (playback direction setting) 8103

pivot
   adjust pivot rollout 3763
   adjust transform rollout 3770
   adjusting 3633
   alternative 3766
   resetting 3633
   working 3766

pivot door 535
pivot point 3762
pivot points 4710
   glossary 8686
   use pivot point center 931
   using 1059

pivot selection dialog 4711
pivoted window 556
pivots
   and links 3642
pivots (IK extensions) 4610
pixel 8687
pixel data (rendered frame window) 6522
place highlight 976, 5334
planar
   constraints 910
   make edges 2220
   make vertices 2220
   threshold 1500, 2192
plane 419, 4338
plane angle manipulator 2865
plant 4669, 4724, 8687
leg state 4535
planted key defaults 4706
plastic/vinyl promaterial 5826
plate match 6589
plate match/MAX R2.5 antialiasing 1180
play selected 8102
playback 4510, 4669
   real-time 3179
playback speed 3390
playing
   animated material previews 5708
   animation 8102
   preview 5679

plug-ins
   color selector (general preferences) 8299
   glossary 8687
   plug-in manager 8242
   sharing over a network 8297
   system path configuration 8296
plugin.ini file 59
PMAP file 8687
PNG file 7862
point 2695, 4934
   glossary 8688
   helper object 2853
   sub-object 2429, 2695
point cache modifiers 1156, 1574
point curve 2466
   glossary 8688
   on surface 2597
   sub-object 2556
point point 2696
point surface 2456
   glossary 8689
   sub-object 2610
point-of-view (POV) viewport label menu 8122
point-path constraint 4333
point-point constraint 4313
point3 script controller 3552
point3 XYZ controller 3451
polar snapping mode 2814
poly select modifier 1582
polydraw tools 2156
polygon - definition 8568
polygon count 2760, 8390
polygon modeling panel 2045
polygons panel 2120
polyhedra 423
POmniFlect space warp 2935
ponytails 4762
pose
   copying and pasting 4726
   pose adjustment 4934
poses 8689
   adding 4994
   copying between bipeds 4619
   reference 4946
posing bipeds 4496
position
  changing 885
  controlling 3407
  ranges (Track View) 3944
position constraint 3602
position data (in CSM files) 4918
position operators
  position icon 3086
  position object 3089
position ranges (Track View) 3944
position script controller 3552
position XYZ controller 3524
position/orientation/bind to follow object 3774
position/rotation threshold (IK) 3713
position/rotation/scale (PRS) controller (Track View) 3526
  parameters (motion panel) 3416
positional markers 8689
posture
  copying and pasting 4726
postures 4619
POV viewport label menu 8122
power 5029, 5080
pre-calculating particle motion 3007
pre-render scripts
  advanced settings 6905
  command-line rendering 7039
  network rendering 6953
precedence 3778
  child-to-parent 3724
  glossary 8690
  parent-to-child 3726
  setting manually 3727
precedence, and keyboard shortcuts 8420
precision and drawing aids 2781
preferences 8298
  accuracy 8299
  animation 8346
  asset browser 7625
  files 8305
  gamma 8330
  general settings 8299
  gizmos 8354
inverse kinematics 8352
MAXScript preferences 8358
mental ray renderer 8363
MIDI time slider control 8350
motion mixer 4099
preference settings dialog 8299
radiosity settings 8362
reference coordinate system 8301
rendering 8342
Schematic View 7936
strokes 8405, 8414
sub-materials 8299
texture coordinates 8304
viewports 8308
preferences (display) 4659
premultiplied alpha 7878
premultiplied alpha (glossary) 8690
preserve map channels dialog 2355
preserve modifier 1590
preset rendering options 6561
preset views 72
presets 6561, 7564
  brush 8044
  configure (video post) 7278
  rendering 6561
preview
  animated material previews 5708
  make 5679
  play 5679
  renderings 6894
  save 5679
preview and animation rollout 4422
preview selection 1356, 2254
preview window 4436
previewing
  biped motion 4654
  motion 4968
  Shockwave 3D files 7777
  W3D files 7777
previous frame 8101
previous key 8101
previous link/next link 5029, 5090
previous transition
  transition 4900
primitives
  creating with keyboard 386
extended 421
standard 388
print size assistant 6564
print size wizard 6564
priority of actions (particle flow) 3014
priority rollout 5248
prism 458
prismatic constraint 4320
privacy 8428, 8438
PRJ files 7657, 8494
problems 8459
problems caused by unit settings 8477
ProBoolean 801
procedural maps
dent 6286
glossary 8691
wood 6322
procedures 5300
process options rollout 6797
processing panel
mental ray 6786
processing parameters rollout
(radiosity) 6639
ProCutter 823
product support 8427
production render 6548
production shaders
environment probe/chrome ball
(mi) 6440
environment probe/gray ball
(mi) 6441
environment/background camera map
(mi) 6437
environment/background switcher
(mi) 6435
HDI image motion blur (mi) 6448
introduction 6434
motion vector export (mi) 6446
render subset of scene (mi) 6444
utility gamma & gain (mi) 6443
productivity 4468
profile 5080
profile view 5029
program window 42
progressive morphing 1534
project file format 7657
project folder 7583
project mapping projector 1610
project workflow in 3ds Max 26
projected window 558
projection - preferences 8308
projection holder modifier 1614
projection modifier 1596, 6856
cage rollout 1603
project mapping rollout 1610
projection rollout 1608
reference geometry rollout 1601
selection check rollout 1607
selection rollout 1598
projection options dialog 6888
projector light 5457, 8693
projectors
project mapping 1610
projects
managing 7391
promaterials 5772
ambient occlusion 5850
ceramic 5773
cement 5780
generic 5786
glazing 5792
hardwood 5796
masonry/CMU 5804
metal 5808
metallic paint 5821
mirror 5824
performance tuning 5857
plastic/vinyl 5826
round corners 5855
solid glass 5830
stone 5835
wall paint 5843
water 5848
ProMaterials library for mental ray
profile 5080
predictive rendering
batch utility 2768
modifier 1614
ProOptimizer modifier 1614
border options 1621
compact faces option 1639
queue monitor 6995
  client (glossary) 8695
  job archives 7016
  module info report 7006
  report generator 7014
queue monitor job settings 7008
quick align 972
quick render
  ActiveShade 6549
  flyout 6547
quick start (batch rendering) 7022
quickslice 1416, 2319
QuickTime movies 7849

R
radial dialogs
  density 7130
  falloff 7133
  size 7137
radial scale 5060, 5070
  parameters (links) 4986
radiance file format 7866
radiance map 7866
radiance picture files 7861
radiosity 5328, 6615
  and animation 6633
  and architectural materials 6159
  choosing radiosity 6600
  controls 6634
  how it works 6625
light painting rollout 6651
lighting analysis 6664
lighting analysis dialog 6664
meshing parameters rollout 6645
preferences settings 8362
processing parameters rollout 6639
rendering parameters rollout 6653
skylight 5412
statistics rollout 6662
workflows 6627
radiosity solution 6615, 6625
radius 5090
rag doll constraint 4286
railing 468, 482
RAM player 7882, 7886
random motion
  create 4868, 4907
  motion flow 4868
  script 4868, 4907
  transition 4868
random placement difficulty dialog 5178
randomize keys 3867
randomize keys utility (Track View) 3921
range bar (video post) 7279
ranges
  editing 3943
  positioning 3944
  realigning with keys 3945
  recoupling 3945
ranges toolbar
  Track View - dope sheet 3886
ray
  render effect 7090
ray tracing 6680, 6741
ray-traced
  reflections and refractions 6690
  shadows 6691, 6756
ray-traced shadows
  glossary 8696
  parameters 5484
RAYHOSTS file 6797, 8697
  specifying name and path 6797
raytrace
  acceleration parameters 6091
  adaptive antialiaser dialogs 6095
  attenuation rollout 6369
  basic material extensions rollout 6371
  basic parameters rollout 6065
  dynamics properties rollout 6089
  extended parameters rollout 6074
  global settings 6666
  map 6364
  map and material 6092
  maps rollout 6082
  material 6064
  messages 6666
  raytracer controls rollout 6079
  refractive material extensions rollout 6373
raytrace acceleration 6741, 8696
parameters for BSP method 6746
raytrace material 6680, 6683
raytracing parameters rollout 6366
raytracing acceleration parameters dialog 6091
re-attachment 5026
reaction controllers 3527, 3533
reaction manager
dialog 3533
reaction manager dialog 3533
reactor
analyze world 4432
angular dashpot 4277
car-wheel constraint 4326
cloth 4364
cloth collection 4372
cloth modifier 4365
collisions rollout 4427
compound rigid bodies 4259
constraint solver 4283
constraints 4264
cooperative constraints 4281
create animation 4422
defeasible bodies 4363
defeasible constraints 4398
defoming mesh collection 4396
defoming meshes 4394
display rollout 4430
FFD soft bodies 4381
fracture 4349
frequently asked questions 4447
gravity 4424
hinge constraint 4307
icons 4226
introduction 4219
linear dashpot 4273
menu 4225
motor 4339
plane 4338
point-path constraint 4333
point-point constraint 4313
preview 4436
preview and animation rollout 4422
prismatic constraint 4320
properties rollout 4435
quad menu 4226
rag doll constraint 4286
rigid body collection 4261
real-time preview 4436
reduce keys 4432
rigid bodies 4248
rigid body collection 4261
rope collection 4392
rope modifier 4387
ropes 4386
scale 4234
scripts 4440
setup scripts 4440
simple constraints 4268
soft bodies 4374
soft body collection 4384
soft body modifier 4375
solver 4421
special features 4235
spring 4269
storing and accessing collisions 4358
toolbar 4225
toy car 4342
troubleshooting 4452
utilities 4432
utility 4420
utils rollout 4432
water 4411
water space warp 4412
wind 4416
world rollout 4424
reactor helpers 4246
real time (glossary) 8697
real-time playback 3179, 4968
real-time preview 4436
real-world map size 6188
real-world mapping 6188
reassign globally 5018
reassigning vertices 4982
rebuild dialogs
CV curve 2731
CV surface 2732
texture surface 2733
Recognize

glossary 8698
recorder (MacroRecorder) 8230
recouple ranges (Track View) 3945
recovered file 62
rectangle 588
rectangular area light 5421
rectangular region 8149
rectangular selection region 230
recursion depth 6667
red
dehormable vertices 5096
line 5029
red/green/blue (glossary) 8698
redefine
script 4896
redo 126, 240
redraw all views 154
reduce keys (Track View) 3941
reduce mesh resolution 1537
reducing mesh size 5001
reference biped 4741
reference coordinate system 922
preferences 8301
specifying 906
reference objects 3142, 8700
reference pose 4946
references 982, 3950
glossary 8699
overview 982
using XRefs 7447
refine
editable spline segments 646
deditable spline vertices 634
glossary 8700
refining curves and surfaces (concept) 2440
reflect/refract map 6375, 6683
reflectance display 5669
reflection maps 6052, 6358
reflections 6690
refraction maps 6054, 6358
refractions 6690
refresh viewport display 154
regathering 6634
region 181
selection 181, 212, 230–234
selection method (edit menu) 237
selection preferences 8388
zoom region (particle view) 3023
zoom region (viewport control) 8149
region net render 6967
reinitialize 8700
reinitialize (physique) 4998, 5013, 5026
reinitialize selected links 4986, 5070
relative scale 5096
relative snap 2807, 2819
relax dialog 2357
relax mesh 2394
relax modifier 1643
relax tool dialog 1906
relaxing texture coordinates 1906
remap locally 5018
remove
ease or multiplier curve (Track View) 3965
note track (Track View) 3906
remove from link 4982, 5096
remove from track set 3977
remove note track 3906
rename objects tool 306
rename preview 6897
rename settings preset dialog 7566
render 6548
ActiveShade 6549, 6556–6557
areas to render list (rendered frame window) 6542
blowup 6542
common parameters rollout 6568
default scanline 6589
dialogs 5718, 6506, 6529, 7877
presets 6561
production 6548
render operator (particle flow) 3194
render scene 6506, 6539
rendered output 7163
rendering elements separately 6806
scripts rollout 6580
selected objects 6542
surface map 6466
to texture 6843
vertex coloring 6355
VUE files 6805
render effects 3817, 7057–7058, 7068, 7073, 7080, 7090, 7097, 7105, 7112, 7119, 7141, 7149, 7151–7152, 7155, 7157, 7159
hair and fur 7061
render elements 6806, 6818–6819
hair and fur 6825
mr A&D 6830
mr labeled element 6835
mr shader element 6837
velocity 6840
render scene dialog
advanced lighting panel 6600
common panel 6568
render panel 6506
renderer panel 6585
render shortcuts toolbar 8042
render subset of scene (mi) shader 6444
render surface map 6466
render to texture 6843, 6848, 6855, 6872, 6878, 6882, 6885, 6887–6888
normal bump mapping 6856
render to texture dialog 6869
add texture elements dialog 6887
automatic mapping rollout 6885
baked material rollout 6882
general settings rollout 6871
objects to bake rollout 6872
output rollout 6878
projection options dialog 6888
render UVs dialog 1910
render UVW Template 1910
renderable spline modifier 1647
rendered frame window 6513
rendered output 6903
render
configure preset dialog 6577
renderer panel
render scene dialog 6585
renderers 6584, 6589, 6805
interactive 8757
panorama exporter 6898
photorealistic 8709
scanline 8709
viewport 8757
rendering 6505, 6678
and multithreading 8346
batch 7021–7023, 7033
bones 857
command line 7035, 7039, 7052
commands 6538
don’t alias against background 8342
elements separately 6818
email notification 6578
on multiprocessor systems 8346
portions of scene 5582
preferences settings 8342
presets 6561
reactor toolbar 8041
render farms 6907
render operator (particle flow) 3194
rendering method 8374
rendering queue 7019
scene 41
shapes 572
surface map 6466
to texture 6843, 6848, 6855
with caustics (mental ray) 6680
with global illumination (mental ray) 6680
with motion blur 6693
with shadow maps 6693
rendering algorithms rollout 6741
rendering commands
render last 6564
rendering effects
multi-pass (cameras) 5587
rendering for print 6967
rendering menu 8028
ActiveShade floater 6556
ActiveShade viewport 6557
advanced lighting 6600
effects 7058
environment 7162–7163
lighting analysis 6664
Material Editor 5641
material/map browser 5724
print size assistant 6564
radiosity 6634
RAM player 7882
raytrace global exclude 6092
raytrace settings 6666
render 6539
render scene 6539
render to texture 6869
video post 7247
rendering parameters rollout (radiosity) 6653
rendering properties
  family elements 7528
  instanced objects 7527–7528
rendering queue 6995
renderingmenu
  panoramic exporter 6898
reparameterize dialog 2733
repathing 7585
repel behavior 5221, 8700
replace (file menu) 7578
replace clip 4061
replace dialogs 5721, 7578
replace keys 3953
replacing scenes 54
report generation (network rendering) 7014
requirements
  for camera tracking 4163
  for network rendering 6933
  system (see Installation Guide) 17
rescale world units utility 2884
reservoir 4047, 4095
reservoir file groups dialog 4065
reset 7433
  reset background transform (viewport image) 143
  reset material settings to default 5691
  reset XForm (transform) utility 912, 3656
reset position 7504
reset tangents 634
rescale 6550, 6558
resizing arms 4507
resolution 5029, 5080, 5090
glossary 8701
resolve externally referenced file dialog 7569
resource collector utility 7637
resource information dialog 7633
respect animation range 3901
restore
  active view (views menu) 128
  to default settings (animation controllers) 8346
restrict to axis buttons 910
restrict to x 910
restrict to xy plane 910
restrict to y 910
restrict to yz plane 910
restrict to z 910
restrict to zx plane 910
restructure biped to match file 4669, 4925
retarget 4741
retargeting rollout 4117
reuse rollout (mental ray) 6778
Reveal
glossary 8701
reverse knees (creating characters with) 4581
reverse time (Track View) 3936
revert to startup UI layout 8283
Review
glossary 8701
reviewing and editing strokes 8412
Revit
data sharing with 3ds Max 7706
  files 7512
  materials 7521
  objects 7513
  select families or types 228
  select similar 228
  settings 7517
  workflow 7520
Revit material
  3ds Max objects 7526
RevitL white paper on DXF 7665
RGB (glossary) 8698
RGB files 7877
RGB maps
  multiply 6343
tint 6354
right-click menus 8052
additional quad menus 8057
animation 8058
customize display 8239
display option 8308
display preference setting 8308
event display (particle view) 3031
HTML help viewer 8454
material editor copy and paste 5647
modifier stack 8200
morpher modifier 1518
named selection sets 223
NURBS 2424
sample slot 5654
Schematic View selection 7949
snaps 2819
spinner 3380
Track View 3825, 3870
Track View toolbar 3999
XRef entities list (XRef object dialog) 7469
XRef files list (XRef object dialog) 7466
rigid bodies 4248
basics 4249
collection 4261
compound 4259
constraints 4264
fracture 4349
properties 4249
storing and accessing collisions 4358
rigid envelopes 4470, 4970, 4985, 5018, 5024, 5060
rigid surfaces (NURBS) 2436
ring 1702
    render effect 7080
ring array 880
ringwave 453
ripple
    modifier 1650
    space warp 2983
RLA files 7873
RMAT materials in 3ds Max 7511
roll angle manipulator 5430
roll viewport controls
    camera 8159
    light 8171
rollout
    distributed bucket rendering 6797
twist poses 4695
rollouts 46, 3772
    adjust pivot rollout 3763
    inverse kinematics 3784
    maps 6021
    materials 5989
    paint deformation 2333
    PArray rollouts 3334, 3338, 3342, 3352, 3355–3356, 3358, 3364
    selection 2245
    soft selection 2014
    working pivot 3766
root name 4494, 4762
ropes 4386
    collection 4392
    modifier 4387
rotate 915
rotating
curling fingers 931
editable mesh edges 2220
elbows and knees 4581
hierarchy 931
lights 5339
links 4581
multiple biped links 4587
multiple linked objects 931
particles 3097
spine 4581
views 84
rotation
    and collision rollout (PArray) 3352
go to rotation test 3258
    increment (viewport preference) 8308
    rotation operator 3097
    rotational joints 3760, 3782
rotation script controller 3552
rotation to zero 8062
rotoscoping (glossary) 8702
roughness 6001

Index | 8851
roughness mapping 6035
round corners
promaterials 5855
RPF files 7875
RPS files 6561
RSS feeds 8427, 8430
rubber band mode 4507, 4550, 4669
rubber-band mode 8702
rubber-banding
arms and legs 4507
ruled surface sub-object 2640
run 4669, 4774
run footstep 4774, 4787
run script 8229
running
  dynamics of 4555
  in place 4656
  parameters 4524
RVT link 8703

S

safe frame (glossary) 8703
safe frames 8125, 8380, 8703
display in viewport 8122
safe video threshold 5678
sample object 5673
preview 5679
UV tiling 5676
video color check 5678
sample range (glossary) 8704
sample rate 6735
sample slot 5650, 5654
active 5690
  adding bitmap 6213
  and material name 5621
background 5675
backlight 5674
cool 5692
default 5691
display adjustment 5681
hot 5692
right-click menu 5654
sample type
cube 5673
cylinder 5673
sphere 5673
sample UV tiling 5676
samples
  animations 4638
  motion files 4638
  samples threshold (motion capture) 4137
sampling 8705
  filters 6735
  sampling quality rollout 6735
  thresholds 6735
sampling quality rollout 6735
satellites 6797
save
  .mfe file 4861
  motion flow editor 4861
save animation 4122
save as dialog 4676
save commands
  hold 242
  save (file menu) 7440
  save active view (views menu) 127
  save as (file menu) 7441
  save character 279
  save copy as (file menu) 7443
  save custom UI scheme 8280
  save preview (Material Editor) 5679
  save selected (file menu) 7444
  save sequence (video post) 7273
  scene/settings in buffer 242
save copy as 7443
save custom UI scheme 8280
save file 4669
save parameters 4934
save physique file 5013
save reservoir items dialog 4098
save segment 4669
save talent figure structure 4925
save talent pose adjustment 4925
saved schematic views 7953
saving
  backup on save 8305
  BLP files 4638, 4676
  biped figure files 4513
  biped step files 4646
  compressed file 8305
FIG files 4676
files from previous versions 7440
material 5638
materials 5641
physique data 4997
STP files 4676
thumbnail image 8305
UI configuration on exit 8299
saving animation 4103
scale 917, 4778, 5080
  a biped 5026
  factor 4934
  in reactor 4234
  stride 4669, 8709
  tail keys 4724
scale operator (particle flow) 3102
scale script controller 3552
scale synchronization between AutoCAD and 3ds Max 7501
scale test (particle flow) 3277
scale values (Track View) 3955
scale weight 1702
scaling 918–919
  a biped 4762
  a node 4986
  and system units 5000
  arm 4507
  changing 885
  characters 5002
  deformation 771
  face and vertex normals 2192
  function curves 3954
  height 4555
  keys (Track View) 3916, 3954
  links 4505
  particles 3102
  rendering preferences 8342
  scale XYZ controller 3550
  time (Track View) 3937
  values (Track View Curve Editor) 3955
scaling objects 917
scanline renderer 6589, 8709
scanline rendering 6741
scatter 674
scatter objects dialog 5165
scene event (video post) 7282
scene explorer 7888
  adding columns 5748, 5755, 7896
  changing columns 7897
  column chooser 5748, 5755, 7896
  columns 7896
  customize menu 7904
  customizing 7894
  deleting objects 7893
  display menu 7902
  display toolbar 7905
  edit menu 7903
  editing a value 7894
  editing multiple items 7894
  editing object hierarchies 7893
  find 7905
  groups 7895
  left-hand toolbar 7905
  linking and unlinking objects 7893
  lower toolbar 7907
  menus 7900
  procedures 7891
  rearranging columns 5750, 5757, 7898
  removing columns 5749, 5756, 7893, 7897
  renaming an object 7894
  replacing columns 7897
  select menu 7901
  selecting objects 7891
  selection toolbar 7907
  sorting 5749, 5756, 7897
  syncing selection 7893
  toolbars 7904
  upper toolbar 7905
  using 7891
  view 7905
scene extents 8710
scene motion blur (glossary) 8710
scene state
  camera properties 7915
  camera transforms 7915
  delete 7917
  environment 7915
  layer assignments 7915
  layer properties 7915
light properties 7915
light transforms 7915
materials 7915
object properties 7915
rename 7917
restore 7917
save 7917
selected parts 7915
scenegraph 7771
scenes 32
animating 40
archiving 61
backing up 61
importing 54
managing 7391
merging 54
rendering 41
replacing 54
scheduling server activity 7020
schematic view
display in viewport 8122
Schematic View
delete Schematic View 7952
display floater 7946
glossary 8712
list views 7934
menus 7930
new Schematic View 7952
preferences dialog 7936
right-click menu (selection) 7949
saved schematic views 7953
Schematic View window 7922
selecting with 190
toolbars 7942
using 7926
screen 8139
script
and scripting definitions 8712–8713
motion flow 4848
random motion 4868, 4907
script controller 3552
shared motion flow 4876, 4909
script rollout (particle flow) 3042
script wiring 3031, 3132
scripted behavior 5223, 8713
scripting
birth operator 3056
script operator 3196
script test 3280
script wiring (particle flow) 3132, 3190
scripts 4858
and controlling particles 3008
assigning target objects according to particle speed 3249
debugging 8231
define script 4858
path for additional 8294
sample script
particleFloat (particle flow) 3190
start frame 4858
start position x 4858
start position y 4858
start position z 4858
start rotation 4858
scripts group
clip mode 4896
copy 4896
create 4896
cut 4896
define script 4896
delete script 4896
go to frame 4896
group 4896
paste 4896
random motion 4896
redefine 4896
start frame 4896
start position x 4896
start position y 4896
start position z 4896
start rotation 4896
unified motion 4896
scripts in motion flow 8713
scripts rollout 6580
scrolling panels/toolbars 46
SDeflector space warp 2953
SDynaFlect space warp 2948
searching
defining search terms 8446
for files 7634
for help topics 8446
InfoCenter 8425, 8430
using nested expressions 8446
section 607
section view 5029
sections 5080, 5090
seed value (glossary) 8713
seek behavior 5120, 5224, 8714
segment (glossary) 8714
segments 5029
segments shadow mode 6756
select 920, 5096
and rotate control points 5029
and scale control points 5029
and translate cross section 5029
by link 4982, 5096
clip/transition 4850, 4891
multiple biped links 4587
nearest bulge angle 4993, 5029, 5080
select all (edit menu) 227
select and link button 3631
select and manipulate 2838
select background image dialog 137
select bitmap image file dialog 6222
select from scene dialog 206
select invert (edit menu) 228
select keys by time (Track View) 3925
select layers dialog 7568
select linked objects dialog 7571
select network protocol dialog 6938
select none (edit menu) 227
select object (main toolbar) 204
select parent 206
select similar 228
select space warp 206
select time (Track View) 3930
selection floater 209
select and move 914
select and non-uniform scale 919
select and rotate 915
select and scale 917
select and squash 920
select and transform buttons
move 914
non-uniform scale 919
rotate 915
scale flyout 917
squash 920
uniform scale 918
select and uniform scale 918
select behavior type dialog 5196
select bitmap image file dialog 6222
select button 4982
select by 229
color 229
layer 230
material 5686
material ID 646, 655, 2216, 2385, 2736
name 206, 3973
name (button) 206
name (edit menu) 229
select similar 228
smoothing group 2216, 2385
time (Track View) 3925
vertex color 2203
select by channel modifier 1654
select by color 2192
select by half 2189
select by name 184, 206
select by normal 2187
select by numeric 2191
select by panels 2186
select by perspective 2187
select by pivot distance 2190
select by random 2188
select by surface 2186
select by symmetry 2191
select by view 2190
select delegates dialog 5198
select emitter objects dialog 3093
select from scene dialog 206
select keys 3792
select keys by time 3867
select menu (particle view) 3020
select menu (Schematic View) 7931
select objects dialog 206
select objects in current layer 7976
| set twist pose | 4695 | shadow types | 5424, 6601 |
| set weight | 1702 | shadows | 6691 |
| setting keys | 4609 | displaying in viewports | 8130 |
| setting up |  | shadow bias (glossary) | 8718 |
| directories | 6947 | shadow maps | 6693, 6756, 8719, 8771 |
| for network rendering | 6935 | shadow modes | 6756 |
| manager and server programs | 6974 | shadows rollout | 6756 |
| rendering software | 6946 | shadows and rendering | 5362, 5425 |
| TCP/IP (network rendering) | 6935 | shadows from hair | 7067 |
| your scenes | 32 | shadows map (baking) | 6850 |
| settings |  | shape check utility | 665 |
| Revit | 7517 | shape commands (loft objects) | 790 |
| SteeringWheels | 8402 | shape operators (particle flow) |  |
| ViewCube | 8400 |  |
| setup rollout | 5163 |  |
| setup rollout (particle view) | 3036 |  |
| SGI image file formats | 7877 |  |
| shade selected (views menu) | 147 |  |
| shaded viewports | 158 |  |
| shader basic parameters rollout | 5969 |  |
| shader list | 6420 |  |
| shaders | 5969, 5971, 5978–5980, 5982–5985, 5988, 6045 |  |
| car paint (mental ray) | 5922 |  |
| custom 3ds Max | 6393 |  |
| DirectX | 5771 |  |
| for standard materials | 8716 |  |
| lume | 6391 |  |
| LumeTools | 6391 |  |
| mental ray | 6385, 6388, 6393, 6412, 6414, 6420, 8716 |  |
| mental ray (third party) | 6387 |  |
| mr physical sky | 5532 |  |
| multi/sub-map | 6414 |  |
| object color | 6418 |  |
| production shaders | 6434 |  |
| viewport | 5771 |  |
| shading and lights | 5625 |  |
| shading type | 5623, 5960 |  |
| shading viewport label menu | 8130 |  |
| shading, cartoon | 6132 |  |
| shadow (center of mass) | 4492 |  |
| shadow bias (glossary) | 8718 |  |
| shadow maps | 5486, 8719 |  |
| mental ray | 5482 |  |
| shadow parameters (lights) | 5448 |  |
shifting
  center of mass  4550
shininess  6153
shininess and shininess strength  6038–
  6039, 8596
shirt (cloth)  1191
Shockwave 3D files
  analyzing  7779
  exporting  7769–7770
  previewing  7777
shortcuts  8419
  Biped  4811
  Crowd  5153
  particle flow  3044
  Physique  5022
shortcuts - default keyboard
  Track View  3810
  unwrap UVW  1879
show
  show curves button  8075
  show dependencies (views
    menu)  148
  show end result (Material
    Editor)  5701
  show end result (modifier
    stack)  1048
  show frame numbers (viewports
    preference)  8308
  show ghosting (views menu)  144
  show home grid (views menu)  2796
  show key times (views menu)  145
  show map in viewport (Material
    Editor)  5696
  show safe frame  8703
  show selected key statistics (Track
    View)  3983
  show tangents (Track View)  3958
  show UI  8241
  show vertices as dots (viewports
    preference)  8308
  transform gizmo  143
show buffer  4925
  to show original motion  4919
  trajectory  4925
show entire trajectory  4684
show graph
  motion flow  4888
  show grid  8119
  show hardware map in viewport  5696
  show icon control  5418, 5421
  show map in viewport  5696
  show markers  4925, 4943
  show prop markers  4943
  show recognized markers  4943
  show safe frame  8380
  show selected key statistics (Track
    View)  3983
  show standard map in viewport  5696
  show statistics  2760
  show tangents (Track View)  3958
  show time  4684
  show unrecognized markers  4943
  show/hide all  4684
  SHP files  7660, 8723
  shrink  1702
  shutter speed  5563, 6747
  sibling
    go forward  5702
    go to  5702
  sides  5080
  simple additive compositor (video
    post)  7387
  simple constraints  4268
  simple shadow mode  6756
  simple wipe compositor (video
    post)  7388
  simple wipe filter (video post)  7379
  simulation, cloth  1189
  single-axis constraints  910
  size
    of particle view icons  3037
    of particle view logo  3037
    or particles  3102
  size of grid square  8084
  size test (particle flow)  3277
  skeletal deformation tool  1667
  skeletons  4468
    and physique  4956
    structure  4470
    used with physique  4963
  sketch tool dialog  1914
sketch UVWs 1874
skew modifier 1664
skin
  attaching to skeleton 4944
  creating 4946
  defined 4944
  deformable 4944
  mesh 5001
  optimizing 5001
  rigid 4944
  save/load envelopes 1685
  save/load vertex weights 1685
  sliding 5018
  sliding parameters 4986
  valid types 4946
skin modifier 1667
  paint weights 1989
  weight table 1704
skin morph modifier 1706
skin parameters rollout (loft objects) 753
skin pose commands 280
skin pose mode 280
skin utilities 4213
skin wrap modifier 1717
skin wrap patch modifier 1726
skirt (cloth) 1191
sky
  IES sky light 5509
  mr physical sky 5532
  mr sky 5527
  mr sky portal 5537
sky models
  CIE 5531
  haze 5529
  perez 5530
sky portal 5537
skylight 5412
  radiosity 5412
  skylight (glossary) 8723
slave controller 3436
slave parameters dialog (block controller) 3446
sleeves (cloth) 1191
slice
  editable mesh edges 2220
  editable mesh vertices 2220
modifier 1727
slide keys 3914
slider manipulator 2868
slider, time/frame 8068
sliding 5070
  angle 4934
  distance 4934
  footsteps 4923, 8724
  parameters (links) 4986
sliding and rotational joints (HI IK solver) 3706
sliding angle 4934
sliding distance 4934
sliding door 537
sliding joints 3757, 3760, 3782
sliding key defaults 4706
sliding window 560
smart scale 917
smart select 204, 212
smoke map 6313
smooth 5024
smooth modifier 1733
smooth rotation controller 3558
smooth twist mode 4700
smoothing groups 7549, 8724
  assigning faces to 2216
  assigning patches to 2385
  viewing and changing 380, 383
smoothing rollout 5253
SMPTE (glossary) 8725
snap frames (Track View) 3907
snap options 2816
snap set key 4741
snapping commands 8004
snaps 8004
  2D/2.5D/3D 2807
  and cuts 2235
  grid and snap settings 2819
  options/settings 2816, 2828
  ortho 2812
  polar 2814
  setting standard 2804
  snap commands 2807
  snap override 2826
snaps toggle
  angle 2810
color mapping 6037
level mapping 6038
specular highlight 5982
specular highlights
anisotropic 6004
Blinn 6006
metal 6008
multi-layer 6009
Oren-Nayar-Blinn 6006
Phong 6006
specular map (baking) 6850
speed 4781, 4787, 4791
speed operators (particle flow)
  keep apart 3131
  speed 3108
  speed by icon 3112
  speed by surface 3122
speed test (particle flow) 3285
speed vary behavior 5227, 8728
sphere
  object 396
  SphereGizmo helper 7243
spherical area omni light 5418
spherical deflector 2953
spherify modifier 1736
spin operator (particle flow) 3099
spindle 442
spine
  flexibility 4494
spine link 4762
spinner right-click menu 3380
spinners 46
  spinner precision 8299
  spinner snap 2811, 8299
spiral stair 514
splash screen 59
splash.bmp file 59
splat map 6316
spline dynamics 4468, 4515, 4755, 8730
spline IK
  animating with spline IK
    solver 3733
  control modifier 1738, 3733
  spline IK solver dialog 3740
  spline IK solver rollouts 3743
spline map parameters dialog 1916
spline select modifier 1741
spline-based deformation in
  physique 4965
splines 577, 1763
  adding 646, 655
  arc 592
  attach 634, 655
  circle 590
  cleaning up segments 655
  copying (outline) 655
  deleting 655
  donut 596
  editable splines 620, 630, 646, 646,
  655
  ellipse 591
  explode 655
  glossary 8729
  helix 605
  line 584
  making coincident 1763
  mirror 655
  NGon 597
  rectangle 588
  star 599
  text 600
  used with physique 4963
split mesh 2220
split scan lines 6967
split tests (particle flow)
  split amount 3288
  split selected 3290
  split source 3291
splitting particle stream 3288, 3290–
  3291
spotlights
  parameters 5439
  spotlight distribution (photometric
  lights) 5369
spray 3306
spring 4269
spring back - setting (IK) 3720
spring controller 3558
spring dynamics object 849
spring options (flex modifier) 1462
squash 920
squeeze modifier 1744
SSS materials (mental ray) 5946
stack 1045, 1049, 1057, 8641
stack updates 5010, 5018
stack. modifier stack 8187
stairs 468, 506
  l-type 511
  spiral 514
  straight 519
  u-type 522
standard display
  with maps 155
  without maps 155
standard flow (particle flow) 3232
standard helpers
  compass 2860
  dummy 2840
  expose transform 2841
  exposetm 2841
  grid 2847
  point 2853
  protractor 2858
  tape 2855
standard lights 5314, 5398
skylight 5412
standard material 5962
standard materials
  shaders (glossary) 8716
standard primitives 388
  box 389
  cone 392
  cylinder 403
  GeoSphere 401
  plane 419
  pyramid 413
  sphere 396
  teapot 416
  torus 409
  tube 406
standard snaps 2804
standard user grids 2847
star 599
  lens effects 7112
  starfield filter (video post) 7381
start after last footstep 4781, 4787, 4791
start at current frame 4781, 4787, 4791
start frame
  scripts 4896
  transition editor 4900
start left 4781, 4787, 4791
start position x
  scripts 4896
start position y
  scripts 4896
start position z
  scripts 4896
start right 4781, 4787, 4791
start rotation
  scripts 4896
starting
  manager and server (network rendering) 6922
  network rendering 6922
startup files 59
startup layout - return to 8283
startup screen 59
startup script (glossary) 8730
startup scripts
  path for additional 8294
startup.ms file 59
state dialog 5202
state filters 4724
state panel 5272
state transition dialog 5203
statistics 8390
statistics rollout (radiosity) 6662
status bar controls
  main window 8064, 8068
  Track View 3971
  video post 7250
SteeringWheels
  center tool 103
  configure 8402
  forward tool 104
  full navigation wheel 101
  glossary 8731
  look tool 105
  navigation tools 103
  orbit tool 107
  overview 93
  pan tool 109
  rewind tool 109
settings 8402
chant building wheel 100
types 98
up/down tool 111
view object wheel 99
walk tool 112
wheel menu 97
zoom tool 113
step files 4646, 4669
step update scripts (particle flow) 3042
steps
and editable patch 2394
and editable spline 620
stereolithography (STL) 7781
stick 4934
stick figures
transition editor 4900
stitch tool dialog 1924
stitch UVWs 1874
STL
exporting files 7784
importing files 7781
STL check modifier 1746
stone promaterial 5835
stop animation playback 8102
stored selections panel 2184
STP files 4636, 4646, 5299
loading 4680
saving 4563, 4676
straight stair 519
Strauss basic parameters rollout 5985
streak
render effect 7119
strength 5060
stretch 4986, 5070, 5090
stretch bias 5090
stretch modifier 1749
stretcher 1898
strokes 8417
defining 8407
preferences 8405, 8414
reviewing and editing strokes 8412
viewport preferences 8308
structure rollout 4758, 4762
stucco map 6318
styles
and Architectural Desktop
objects 7535
propagation 5674
styling hair
hair and fur modifier 1077, 1095
styling rollout
hair and fur modifier 1095
sub-object
chamfer curve (NURBS) 2569
common controls 2494
glossary 8732–8733
material assignment 5659
preview selection 1356, 2254
selection 199, 1054, 1057, 2196, 2245, 2428
sub-objects
Physique 5059
subanim controller 4590
subdivide 2220, 2235, 2394
subdivide modifier 1756
subdivide modifier (world space) 1156
subdivision displacement rollout
editable poly 2330
subdivision panel 2147
subdivision surface rollout
editable poly 2325
subdivision surfaces 1464, 2013
Subscription Center
overview 8437
subset pixel rendering 6745
substeps 4232
substitute modifier 1759
subsurface map 6471
subsurface scattering (SSS) materials
(mental ray) 5946
subtractive opacity (glossary) 8733
subtree - modifying (Track View) 3860
summary info 7607
sun 5506
sun & sky with mental ray 5513
sunlight 5491
sunlight (glossary) 8734
super black 8342, 8735
super spray 3315
superimposed material 6127
supersampling 5759, 8735
support period 8736
surf point 2701
surface approximation 2737, 2747–2749
surface arrive behavior 5229, 8736
surface constraint 3607
surface follow behavior 5233, 8736
surface joints 3757, 3760
surface map, render 6466
surfaces
  NURBS surfaces 2454
  surface approximation (NURBS) 2737, 2748–2749, 2759
  surface deform (SurfDeform) 1159
  surface edge curve 2601
  surface mapper (world space) 1156
  surface modifier 1299, 1763
  surface offset curve 2582
  surface parameters (loft objects) 746
  surface point 2701
  surface properties rollout (editable objects) 655, 2200, 2203, 2209, 2216, 2385
  surface sub-objects - creating 2603
  surface tools 1299, 1763
  surface trimming 2420
  surface-curve intersection point 2707
  surface-surface intersection curve 2578
  SurfDeform modifiers 1774
  SurfDeform modifiers 1159, 1774
swap
  colors 5711
  events (video post) 7275
  maps 5710
sweep modifier 1776
  extract 1798
  merge from file 1799
  pick shape 1796
swirl map 6266
swivel angle 3685, 3732
symbols
  wildcard characters 8425
symmetrical tracks 4686
symmetry modifier 1803
symmetry tools 2062
symmetry tools dialog 2062
synchronizing animated bitmap with the scene 5709
synthesis control dialog 5148
synthesis dialog 5148
  motion clips panel 5268–5269
  state panel 5272
  synthesis panel 5275
synthesis panel 5275
synthesis/synthesize 8736
system paths 8294
system unit
  setup dialog 8370
  units mismatch dialog 8372
system units and scaling 5000
systems 856
  bones 857
  daylight 5491
  ring array 880
  sunlight 5491
T
tags (time) 8084–8085
tails
  adding 4494
talent definition area 4934
talent figure mode 4919, 4925, 8736
tangent handles 634
tangent types 3420
tangents
  glossary 8737
  locking 3960
  type of 3432
tape helper object 2855
taper modifier 1807
targa files 7878
targa files (glossary) 8690
target
  and particles 3247
  camera 8155
  lights 5399, 5405
target camera 5556
target direct light 5405
target directional light 5405
target distance 6694
target map slot 6855
target objects - look at controller 3502
TCB 4706
  controllers 3563
glossary 8738
TCB (biped) 8737
tcb rotation
  controller 4581
TCP/IP protocol 6935, 6938
tapot 416
tearing cloth 1207
technical support 8427
techniques
  cloning objects 985
  NURBS 2444
tee 617
teeter deformation 774
temp
  path for 8294
temporary
  buffer 242
  IGES files 7730	
tendon display options dialog 5055
tendons 4944, 5018, 5024, 5026, 5090, 8738
  adding 4995
  adjusting 5090
  and fixed attach points 5090
  attach points 5090
  attached links 5090
  attaching to another link 4995
  attaching to link 4995
  boundary conditions 5090
  creating 4995
  cross sections 5090
  deleting 4995
  inserting 4995
  overview 4995
  using 4995
  workflow 5090
tendons sub-object 5055
tension/continuity/bias 4706, 5068
tension/continuity/bias (glossary) 8738
tension/continuity/bias in biped 8739
terminating chains 3729
terminators 3665
terminology (inverse kinematics) 3665
terrain 730
  creating effects with noise
  modifier 1549
glossary 8739
tessellate
  and displace space warp 2930
  faces 2220
  tessellate modifier 1812
  tessellate selection dialog 2358
test outputs (particle flow) 8671
test time frames 3046
tests (particle flow) 3233, 8741
  acceleration 3285
  age 3235
  circular travel 3285
  collision 3236
  collision spawn 3241
  distance from target 3247
  find target 3247
  go to rotation 3258
  lock/bond 3264
  scale 3277
  script 3280
  send out 3280
  size 3277
  spawn 3281
  speed 3285
  split amount 3288
  split group 3084
  split selected 3290
  split source 3291
  time 3235
  velocity 3285
texel (glossary) 8741
text 600
  baked elements 6848
  baking 6843
  rendering to 6843, 6848, 6855
  target map slot 6855
texture
  baking - shell material 6174
texture baking - shell material 6174
texture map (glossary) 8741
textures
and animated NURBS models 2453
and imported mask bitmaps 7655
and material properties 2544
and NURBS models 2453
baking 6869
disable texture map display 8374
painting onto objects 6455
pick texture option (edit UVWs
dialog) 1856
pinning 1837
TGA files 7878
thickness map 6471
thin wall refraction map 6382, 6683
three-DOF limb 4695
threshold 383, 1733
adaptive control 6097, 6364
and HD IK solver 3714
color 6316, 6318
dedge visibility 2209
error (camera tracker) 4175
eexplode angle 2220
LOD 2762
motion capture samples 4137
noise 6253, 6258, 6303, 7182, 7196
optimize 1557
planar 1500, 2192
position/rotation (IK) 3713
reduce keys 3941
safe video 5678
sound 3426
super black 8342
supersampling 5795
use secondary (IK) 8352
weld 634, 1763, 1856, 1927, 2220,
7677, 7781
thumbnails
open file 7434
viewport image 8305
ticks (glossary) 8741
TIFF files 7234, 7880
tile/mirror (glossary) 8742
tiles map 6269
time 4706
controlling 3385
copy (Track View) 3933
cutting 3932
deleting 3932
editing 3929
fitting into 3937
in particle flow 3006
insert (Track View) 3937
moving through 3388
paste (Track View) 3934
removing 3937
rescaling active time segment 3388
reverse (Track View) 3936
scale (Track View) 3937
selecting 3930
setting time segments 3387
specifying active time segment 3387
time configuration button 8106
time ruler (Track View) 3810
time slider 3810, 3909, 8068
time tags 8084–8085, 8087
time controls 8089
time frames 3046
time in the air 4555
time menu, Track View 3856
time paste (Track View) 3934
time reverse (Track View) 3936
time ruler (Track View) 3810
time steps 4230
time to next footstep 4781, 4787, 4791
time warps 4034
TimeSensor (VRML97 helpers) 7822
timing parameters 4774
tips
adjusting radiosity 6159
animation and textures
(NURBS) 2453
camera correction 5608
copying keys between frames 8071
flipping face normals 2219
magnifying camera
adjustment 8158
maintaining consistent camera lens
size 5571
NURBS 2444
output size and rendering
speed 6568
playing animations in all viewports 8102
propagating layer properties 7957
radiosity and walkthroughs 6633
selecting faces to hide 2200
testing radiosity 6633
textures (NURBS) 2453
turning off material propagation 8206
updating information in light lister 5344
using file link manager 7495
VRML97 7806
toes option 4494
toggles
  adaptive degradation 123
  angle snap 2810
  animation mode 3373
  auto key mode 3373
  auto material propagation 5674
  enable ease or multiplier curve 3966
  full screen 8139
  key mode 8105
  maximize viewport 8139
  percent snap 2811
  selection lock 8079
  shortcut keys 8420
  spinner snap 2811
  window/crossing 239
toggling
events (particle view) 3028
operators (particle view) 3028
toggling dialogs 7983
tolerance 4934
tone mapping
  automatic exposure control 7210
  exposure controls 7207
  linear exposure control 7212
  logarithmic exposure control 7215
  mr photographic exposure control 7219
  pseudo color exposure control 7228
toolbars 8034, 8258
axis constraints 8039
brush presets 8044
controller toolbar 3884
curve editor 3873
displaying toolbars 8239
dope sheet 3879
extras 8041
extras dope sheet toolbar 3887
HTML help viewer 8487
icon scheme 8280
layers 8040
main 8035
ranges toolbar 3886
reactor 4225, 8041
render shortcuts 8042
Schematic View 7942
snaps 8043
toolbars panel (customize UI) 8252
troubleshooting when missing 8479
video post 7271
toolbox (NURBS) 2426
tools
  for low-polygon modeling 2760
  Material Editor 5663
  precision 2782
  rename objects 306
tools menu 8001
  align 967, 8003
  align camera 978
  align to view 979
  array 944
  camera match 5609
  clone and align tool 961
color clipboard 378
containers 8003
display floater 8218
floaters 8218
grab viewport 125
grids 2796
grids and snaps 8004
isolate selection 198
light lister 5343
measure distance 2881
mirror 940
new scene explorer 7888
normal align 973
open explorer 7888
place highlight 976
quick align 972
Index | 8867
rename objects 306
saved scene explorers 7888
selection floater 209
spacing tool 953
transform tools 936
tools menu (particle view) 3025
tools rollout
  hair and fur modifier 1084
tooltips 3030, 8065
tooltips in viewports
  preferences 8299
toon shader 6132
top/bottom material 6129
topology (glossary) 8743
topology dependent modifier 8744
topology dialog 2057
torus 409
torus knot 426
total statistics 2760
touch 4669, 4724, 8744
touch dynamics 4555
TouchSensor (VRML97 helpers) 7820
Toxik
  data sharing with 3ds Max 7706
toy car 4342
trace depth 6741, 6771, 8684
track
  copying 3933
glossary 8745
  note 3903, 3906
track bar 8071
track selection 4686
  using motion-capture filtering 4918
track selection in workbench 4829
track selection rollout 4575
track sets editor 3977
track sets list 3974
track view
  display in viewport 8122
Track View 4797, 4801
  assign controller 3897
  biped colored keys 4806
  concepts 3794
  controller menu 3849
  controller toolbar 3884
controller window 3795, 3817
curve editor 3790, 3804
curves menu 3855
customization 3992
delete Track View 3990
dope sheet 3790
editing biped keys 4549
extras dope sheet toolbar 3887
glossary 8745
hierarchy 3817
hierarchy icons (glossary) 3824
hierarchy of biped objects 4571
key time display 3982
keys menu 3853
keys window 3795
menu bar 3849
modes menu 3849
new Track View 3989
opening 4571
Options menu 3856
pan 3984
pasting time 3934
pick dialog 5279
pick dialog (block controller) 3448
properties 3918
ProSound 3835
ranges toolbar 3886
selecting with 189
shortcuts 3810
sound options 3833
status bar/view controls 3971
time menu 3856
tracks menu 3853
utilities 3919, 3921, 3923, 3925–3926
utilities menu 3867
value display 3983
view menu 3867
working with 3794
workspace 3795
zoom 3987
zoom horizontal extents 3985
zoom region 3988
zoom selected object 3972
zoom value extents 3972

8868 | Index
Track View utilities
  current value editor 3928
tracker gizmo 4165
trackgroup
  filter 4086, 4088
trackgroup filter dialog 4055, 4086, 4088
trackgroups
  adjusting balance 4038
  creating and filtering 4018
  menu 4055
tracks
  adding to motion mixer 4007
  copying and pasting 4726
  menu 4057
  selecting workbench 4821
tracks menu, Track View 3853
training
  authorized programs and products 8435
trajectories 4706
  display 4510, 4657
  glossary 8746
  motion panel 3411
trajectories (biped) 8748
trajectory key editing 4628
transform coordinates and coordinate center 922, 934
transform gizmo 8748
transform gizmos
  preferences 8354
  show transform gizmo 143
  using 889
transform script controller 3552
transform to zero 8061
transform tools 935–936
transform type-in 899, 8082
transformation axis coordinate system list 922
transforms
  adjusting 3656
  and envelopes 4974
  and light objects 5334
  and mesh sub-objects 2196
  and modifiers 1041
  animating 902
  applying 885
  commands 913
  controllers (glossary) 8506
  curve 2560
  curve sub-object 2560
  glossary 8750
  locking 3657
  locking axes 3788
  managers 904
  resetting AutoCAD objects 7504
  surface 2612
  surface sub-object 2612
  transform tools 935
  using 886
  viewing and copying keys 3382
transition 4853
  clip 4896
  create 4853
  create all 4853
  customize 4865
  edit 4853, 4865, 4896
  focus 4026
  motion mixer 4026
  optimize 4026, 4079
  optimize transition 4913
  random motion 4868
transition editor 4853
  angle 4900
  ease in 4900
  ease out 4900
  fixed 4900
  frame 4900
  length 4900
  mixer (biped object) 4066
  mixer (non-biped object) 4072
  optimize 4900
  probability 4900
  rolling 4900
  start frame 4900
transition optimization dialog 4913
  motion mixer 4079
transition track 4007
  motion mixer 4026
transitions
  menu 4060
  state transition dialog 5203
translate only 6797
translation file (specifying name and path) 6797
translator options rollout 6787
translucency 6002, 6153
glossary 8751
translucent highlights 6012
translucent shader 5988
transmittance display 5669
transparency 6153
TRC
convert into CSM 4156, 7765
importing 7765
tri patch 2413
triangle count 2760, 8390
triangle pelvis 4762
and physique 4494
triangulation panel 2149
trigometric functions 349
trim clips
motion mixer 4023
trim overlapping segments 655
trim/extend modifier 1815
tris panel 2149
troubleshooting
3ds Max 8459
assertion failed errors 8459
automated error reporting 8459
basic troubleshooting start point 8486
Boolean objects 8463
camera match 5609
camera tracker 4189
creases or ridges in Boolean objects 8463
Direct3D failed to initialize message 8486
Direct3D reports a memory warning 8486
dual monitor configuration 8486
error reporting 8459
garment maker errors 1298
large font problems 8479
lost dialogs 8479
merging corrupt files 8459
missing command panel 8479
missing gizmos 8479
multiple or missing buttons on toolbars 8479
network rendering 6927
normal bump maps 6858
objects disappear when the camera gets close 8477
reactor 4452
remember back up files 8459
slow file opening 8473
slow response to open or drag dialogs 8473
slow startup time 8473
sluggish command response 8473
spanning across monitors 8486
splines and Boolean operations 8463
tips for successful Boolean operations 8463
unit scale and movement resolution relationship 8477
video post 7252
viewport transparency 8486
truck camera 8161
tuck light 8175
true/false, setting test results (particle view) 3029
truecolor 8342, 8752
tube 406
turbo smooth modifier 1818
turn to mesh modifier 1825
turn to patch modifier 1827
turn to poly modifier 1830
turning on/off actions, events (particle view) 3031
particle system 3036
tweens 3369
twist 4695, 5070
deformation 773
twist modifier 1833
twist individual mode 4700
twist links 4513, 4762
twist links mode 4587, 4700, 8752
twist parameters (links) 4986
twist poses 4513
two-DOF limb 4695

8870 | Index
two-point perspective 5607
two-sided 8378
type-in weights 5096
types of
dynamics objects 841
space warps 2887
transforms 886

U

U and V iso curves 2584
U loft surface and sub-object 2646
u-type stair 522
UDeflector space warp 2956
UDynaFlect space warp 2951
UI 8029, 8235, 8241–8242, 8249, 8279–8280, 8283, 8374, 8379
        customizing 8276
UI files 8276
unbinding
    objects 3711, 3773
    vertices 634
UNC 8753
understanding
crowds 4478
motion flow 4476
motion mixer 4001
workbench 4475, 4816
understanding crowd behaviors 5115
undo 46, 126, 240
undo levels 8299
unexpected particle spawning 3012
unfold mapping 1875, 1926
unfreezing objects 191, 8218
ungroup 261
unhide 161, 8599
unhide all 5096
unified motion
    create 4873
uniform scale 918
unify normals 380, 7549
unique container 8752
units
    and display of mouse position 8082
    automatic unit conversion 7434
    file load units mismatch 8372
    mismatch 8372
    setup 8366
    synchronizing between
        programs 7501
        system setup 8370
        troubleshooting problems
            with 8477
unit scale preference 8299
using 2784
universal deflector 2956
universal naming convention
    (UNC) 8753
unlink selection 3632
unlock
    character 279
    lock assignments 5096
unlock interior edges (of selected
    patches) 2360
unwrap UVW 1837, 1879
    automatic mapping 1875
    Edit UVWs dialog 1856
    multiple instanced modifiers 1839
    multiple objects 1839
    options dialog 1927
    pack UVs dialog 1897
    relax tool dialog 1906
UOmniFlect space warp 2948
up vector 4934
update 3007
    ActiveShade 8497
    background image 142
    background while playing 8308
    during spinner drag 156
    particle shape 3149
    scene materials 5722
    update types (particle flow) 3024
upper bound 5090
use center flyout 930
    use pivot point center 931
    use selection center 933
    use transform coordinate center 934
use dual planes (viewport
    preference) 8308
use key reduction 4934
use large toolbar buttons
    preference 8299
user interface
  customizing 8235
  introduction 7981
  menu bar 7998
  problems and recovery 8479
user reference 8441
user views 72
user-defined object properties 303
using
  asset browser 57
  auto key button 3373
  axis constraints 910
  batch rendering 7023
  bend links mode 4587
  bipeds with crowd delegates 5136
  clipping planes to exclude geometry 5582
  configure paths 6951
  create panel 360
  default joint precedence 3723
  dummy objects 3651
  grid objects 2789
  grids 2785
  groups 8005
  help 8441
  home grid 2787
  horizon to match perspective 5583
  HTML help viewer 8444
  IK keyframe parameters 4598
  in place mode to adjust keyframes 4657
  interparticle collision 3305
  layers 4626
  mapped materials with Particle Systems 3300
  maps to enhance a material 5627
materials 34
materials with particle array 3297
modifier stack 1045
modifier stack at sub-object level 1057
modify panel 1041
move and rotate to aim 5581
multi/sub-object materials with particle systems 3302
multiple computers 6905
named selection sets 185
network manager window 6982
network server window 6989
NURBS toolbox to create sub-objects 2426
online reference 8441
queue monitor module info report 7006
queue monitor report generator 7014
Schematic View 7926
select by name 184
selection filters 187
shapes 572
shift+clone 996
spawned particles 3303
standard view navigation 82
transform gizmos 889
transforms 886
transforms to aim a camera 5581
units 2784
using crowds
  behaviors 5120
  crowd helper 5110
  delegate helper 5110
using props 4594
using the track sets list 3974
utilities
  3ds Max file finder 7634
  animation 4134
  asset browser 7614
  assign vertex colors 6477
  Batch ProOptimizer 2768
  camera match 5609
  camera tracker 4158
  channel info 6486
clean multimaterial 6492
collapse 2022
color clipboard 378
create out-of-range keys (Track View) 3923
dialog 8225
dynamics 4190
filter selected euler tracks (Track View) 3926
fix ambient 7639
Flight Studio 7707
follow/bank 4134
IFL manager 7845
instance duplicate maps 6497
level of detail 2762
lighting data exporter 7234
Lightscape Materials 7759
link inheritance (selected) 3660
LOD 2762
MACUtilities 4156
material xml exporter 5638
MAXScript 8031, 8228
measure 2882
motion capture 4137
panorama exporter 6898
randomize keys (Track View) 3921
rescale world units 2884
reset XForm (transform) 912
resource collector 7637
select keys by time (Track View) 3925
shape check 665
skin utilities 4213
strokes 8417
surface approximation 2748
Track View 3919
utilities menu, Track View 3867
UVW remove utility 6200
visual MAXScript 8231
utility gamma & gain (mi) shader 6443
utils rollout 4432
UV coordinates 5636
uv generator shader (mental ray) 6422
uv generator shader parameters rollout (mental ray) 6422
uv generator shaders rollout (mental ray) 6427
UVW coordinates 5636
coordinates (glossary) 8754
edit UVWs dialog menu bar 1871
map modifier 1932
mapping in AutoCAD Architecture objects 7511
mapping in Revit objects 7525
remove utility 6200
XForm modifier 1955
UVW mapping add modifier 1954
UVW mapping clear modifier 1954
UVW mapping paste modifier 1955

v

v command-line option 7987
value display 3983
Vault 7585, 8438
setting working folder 7589
Vault client software 8439
Vault Data Management Server 8439
Vault Explorer 8439
VDA targa files 7878
vector
  editable patch handle
    sub-object 2380
    handles and editable patch vertex
      sub-objects 2394
  introduction 352
  vector handles (glossary) 8755
  vector projected curve 2589
  vector field 8755
  vector field space warp 5258, 8755
  create method rollout 5259
  lattice parameters rollout 5260
  obstacle parameters rollout 5261
  velocity element parameters
    rollout 6840
  velocity interpolation 8757
verbosity (messages)  6797
versioning  7585
vertex  4982
    operations  5096
    settings  5024, 5026
    vertex sub-object  5096
vertex - definition  8757
vertex alpha  1963
vertex color  1959
    rendering  6355
vertex color map  6355
vertex count  2760, 8390
vertex display size  8310
vertex illumination  1963
vertex normals (scaling)  2192
vertex to link assignment
    initialization  5046
vertex type  2373
vertex weld modifier  1957
vertex-link assignments  5024, 5026
vertexpaint modifier  1959
    adjust color dialog  1982
    brush options  1989
    color palette  1984
    paintbox  1969
    palette  1984
vertical (move key)  3953
vertical motion
    dynamics of  4555
vertices
    adding  634, 646
    align  2220
    attach/detach  2220
    breaking  2220
    changing type  4982
    checking assignments  4982
    checking for alignment in loft objects  792
    choosing type  4982
    creating  2220
    deleting  634, 2220
    inserting  630, 655
    make planar  2220
    making rigid  4982
    manually assigning deformable blended  4982
manually overriding assignments  4982
painting  1959
reassigning manually  4982
removing deformable  4982
selecting by color  1359, 2258
slice  2220
weld  2203, 2220
working with  4982
vertices panel  2100
video color check  5678
video driver and display problems  8486
video post  7247, 7255
abut  7282
    add external event  7305
    add image input event  7288
    add layer event  7298
    add loop event  7308
    add output event  7302
    add scene event  7282
    align left  7280
    align right  7281
    alpha compositor  7385
    alpha filter  7313
    animating lens effects  7315
    automatic secondary flare parameters  7327
    common procedures  7255
    composite image sequences  7255
    composite scene over image sequence  7255
    configure presets  7278
    contrast filter  7311
    create animation from still images  7255
    create starfield  7255
    cross fade compositor  7385
    edit current event  7273
    edit external event  7305
    edit image input event  7288
    edit layer event  7298
    edit loop event  7308
    edit output event  7302
    edit range bar  7279
    edit scene event  7282
    execute sequence  7276
fade filter 7312
flare glow parameters 7325
flare inferno parameters 7337
flare lens effect 7316
flare preferences 7322
flare ray parameters 7331
flare ring parameters 7326
flare star parameters 7333
flare streak parameters 7335
focus lens effect 7339
glow inferno 7352
glow lens effect 7343
glow preferences 7350
glow properties 7346
highlight geometry 7363
highlight lens effect 7354
highlight preferences 7368
highlight properties 7358
image input event 7292
image input options 7292
join two animations 7255
lens effects 7315
lens effects filters 7314
lens effects gradient colors 7377
lens effects gradient options 7372
lens effects gradient types 7375
make an object glow 7255
make same size 7281
manual secondary flare
   parameters 7329
negative filter 7377
new sequence 7271
open sequence 7272
pseudo alpha compositor 7386
pseudo alpha filter 7379
queue 7248
render in reverse 7255
resize images 7255
save sequence 7273
simple additive compositor 7387
simple cross fade 7255
simple wipe compositor 7388
simple wipe filter 7379
starfield filter 7381
status bar 7250
swap events 7275
switch views 7255
toolbar 7271
troubleshooting 7252
view controls 7250
video post compositors
alpha compositor 7385
cross fade compositor 7385
pseudo alpha compositor 7386
simple additive compositor 7387
simple wipe compositor 7388
video post filters
alpha filter 7313
animating lens effects 7315
automatic secondary flare
   parameters 7327
contrast filter 7311
dead filter 7312
flare glow parameters 7325
flare inferno parameters 7337
flare lens effect 7316
flare preferences 7322
flare ray parameters 7331
flare ring parameters 7326
flare star parameters 7333
flare streak parameters 7335
focus lens effect 7339
glow inferno 7352
glow lens effect 7343
glow preferences 7350
glow properties 7346
highlight geometry 7363
highlight lens effect 7354
highlight preferences 7368
highlight properties 7358
image input event 7292
image input options 7292
join two animations 7255
manuaip secondary flare
   parameters 7329
negative filter 7377
new sequence 7271
open sequence 7272
pseudo alpha compositor 7386
pseudo alpha filter 7379
queue 7248
render in reverse 7255
resize images 7255
save sequence 7273
simple additive compositor 7387
simple cross fade 7255
simple wipe compositor 7388
simple wipe filter 7379
starfield filter 7381
view
   align to view button 979

Index | 8875
axonometric views 72
camera views 72
light views 72
navigation 82
perspective views 72
preset 72
view file dialog 6535
view image file (file menu) 6535
view preview (rendering menu) 6897
view change 126
view controls
  video post 7250
view image file 6535
view menu
  Track View 3867
view menu (Schematic View) 7933
view samples 8705
view steps 2405
view-handling commands 126
ViewCube 86
  changing view 89
  configure 8400
glossary 8757
home view 93
menu 88
settings 8400
using 89
view projection mode 92
viewing
  3D space 65
  and changing normals 380
  grid objects 2791
  jobs in the queue 7013
  portions of scene 5582
  servers in the queue 7013
  smoothing 383
  the queue 7013
  transform keys 3382
viewing sample biped animations 4638
viewport canvas 6455
viewport clipping 5582, 8117, 8374
viewport configuration 8374
  adaptive degradation 8384
  layout 8379
  lighting and shadows 8392
regions 8388
rendering method 8374
safe frames 8380
viewport configuration dialog 8374
viewport controls 8135
viewport display, particles 3186
viewport label menus
  ambient occlusion 8130
camera view 8122
configure viewports 8117
general (+) menu 8117
lighting display 8130
orthographic views 8122
perspective view 8122
point-of-view (POV) menu 8122
shaded display 8130
shading menu 8130
shadow display 8130
SteeringWheels display 8117
ViewCube display 8117
wireframe display 8130
xView 8130
viewport navigation
  walkthrough 115, 8140
viewport renderer (glossary) 8757
viewport rendering 8374
viewport shaders 5771
  lightmap 6179
  metal bump 6180
viewport shading 8374
viewports 66
  and display of modifier effect 8187
  arc rotate snap angle preference 8308
  background 128
  configuring 8374
  controlling rendering 79
  create snapshot of 125
  DirectX manager rollout 5771
displaying maps in 155
general concepts 66
  grab 125
  layout 8379
  navigating 8135
  preferences 8308, 8313, 8317
  previewing shadows 5335
wave
  wave modifier 2000
  waveform controller 3566
wave space warp 2979
wavefront files (obj) 7785
Wavefront object files 7786
waves map 6320
weather data 5500
weather data file 5500
  select time period 5502
web distribution 5371–5372
web site
  getting content from 7614
  week schedule dialog 7020
weight 5029, 5080, 5096
  assignments (Skin modifier) 1697
  assignments (vertex) 4988
  vertices (Skin modifier) 1667
weight table 1704
weight tool dialog 1697
weighted vertices 4470, 5060
weld 1957
  editable mesh edges 2220
  editable mesh vertices 2203, 2220
threshold 634, 1763, 1856, 1927, 2220, 7677, 7781
  vertices 634
weld vertices/edges dialog 2359
welder modifier 2004
what you should know to use character studio 4467
white paper
  Revit and DXF 7665
white paper, swivel angle and HI IK
  solver 3685
wide flange 618
width 4778
wildcard characters
  searching with 8425
wind 4416
wind space warp 2926
window/crossing toggle 239
windows 468, 541
  3ds Max 42
  awning 549
  casement 552
fixed 554
  pivoted 556
  projected 558
  sample preview 5650
  sliding 560
wire editor 3612
wire parameters 3610, 3612
  expression techniques 339
wireframe color 8765
  changing 8182
  displaying 158
wireframes 144, 158, 8766
wiring
  particle view 3032
  wiring (particle flow) 3032, 8763
  wiring parameters 3610
  wiring tests to events (particle view) 3028
wood map 6322
workbench 4475, 4816
  analyze panel 4832
  analyzing curves 4822
  animation 4823
  curve view 8543
  filters panel 4843
  fix panel 4838
  fixing curves 4823
  navigating 4818
  select panel 4829
workflow 8768
  and biped 4487
  applying physique 4966
  creating bulges 4991
  footstep animation 4515
  in character studio 4480
  motion capture 4919
  motion flow 4886
  procedures in this reference 5300
  Revit 7520
  tendons 5090
workflows
  designing materials 5620
  edit poly 1339
  editable poly 2241
  project workflow in 3ds Max 26
  radiosity 6627
set key 8094
sub-object selection (NURBS) 2429
working folder 7586, 7589
working pivot rollout 3766
working with
crowd animation 5104
workbench 4816
working with AutoCAD, AutoCAD
Architecture and Revit
files 7501
working with biped 4487
working with crowd animation 5104
working with drawing files 7492
world axis 926
world coordinate system (glossary) 8768
world rollout 4424
world space 4710, 8769
world space (biped) 8770
world-space modifier 1067
camera map 1067
displace mesh 1068
displace NURBS 1071
glossary 8770
LS colors 1145
MapScaler 1147
PatchDeform 1150
PathDeform 1150
subdivide 1156
surface mapper 1156
SurfDeform 1159
wrap cursor near spinner 8299
wrectangle 611
WSM modifier 1067, 1145
camera map 1067
displace mesh 1068
displace NURBS 1071
MapScaler 1147
PatchDeform 1150
PathDeform 1150
subdivide 1156
surface mapper 1156
SurfDeform 1159
XAF files 4103
adding to motion mixer 4011
adjust time in motion mixer 4023
adjusting in motion mixer 4015
combining with mixer 4002
filtering in motion mixer 4018
transitions in motion mixer 4026
XLI files 7729–7730
XLO files 7729, 7734
XMM files 4103
xref 4635
add offset 3570
xref biped 4635
xref controller 3407, 3570
xref ik chain 3661
xref material 6183
XRef object
proxy object 7475
XRef objects dialog
entities list right-click menu 7469
files list right-click menu 7466
XRef objects dialog 7456
xref scenes
overlays 7479, 7488
xref systems 856
Xrefs
glossary 8770
resolving in file linking 7569
resolving paths 7553
XRefs
and paths 7449, 7485
glossary 8771
scenes 7485
user path configuration 8292
using XRefs 54
XRef merge dialog 7471
XRef objects 7447, 7450, 7456, 7474
XRef scenes 7447, 7477
xView 2873
viewport menu 8130
XYZ controllers 3451, 3453, 3501, 3524, 3550
XYZ coordinate shader (mental ray) 6434

Index | 8879
XYZ generator shader (mental ray) 6430–6431, 6433
xyz position 4709
XYZ to UVW option (UVW map modifier) 1932

Y
YUV file 7882

Z
z element parameters rollout 6842
zero all 4700
zero twist 4700
zoom
  about mouse point
    (preference) 8308
  no zoom (particle view) 3023
  region zoom (particle view) 3034
  zoom 8142
  zoom (particle view) 3023, 3034
  zoom (Track View) 3987
  zoom all 8143
  zoom extents (particle view) 3023
  zoom extents all/all selected 8138
  zoom extents/extents selected 8144
  zoom horizontal extents/extents keys
    (Track View) 3985
  zoom region (particle view) 3023
  zoom region (Track View) 3988
  zoom selected object (Track View) 3972
  zoom value extents (Track View) 3986
  zooming views 84
  zoom selected object option (Track View) 4571
  zoom value extents (Track View) 3986
  zoom value extents range (Track View) 3986
ZT file 8771